
Washington DC ServiceNow AI 
Platform Capabilities

Last updated: 12/16/2025

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.



Some examples and graphics depicted herein are provided for illustration only.
No real association or connection to ServiceNow products or services is intended or 
should be inferred.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks
are trademarks and/or registered trademarks of ServiceNow, Inc., in
the United States and/or other countries. Other company and
product names may be trademarks of the respective companies
with which they are associated.

Please read the ServiceNow Website Terms of Use at
www.servicenow.com/terms-of-use.html

Company Headquarters
2225 Lawson Lane
Santa Clara, CA 95054
United States
(408) 501-8550

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

http://www.servicenow.com/terms-of-use.html
http://www.servicenow.com/terms-of-use.html


Table of Contents

Extend ServiceNow AI Platform  capabilities.......................................................................................5

Configuration Management.............................................................................................................................. 9

Configuration Management Database (CMDB)................................................................................11

Common Service Data Model............................................................................................................ 656

Application services...............................................................................................................................746

Integrating third-party data into CMDB..........................................................................................800

Conversational Interfaces............................................................................................................................1571

Conversational Interfaces Console.................................................................................................1572

Virtual Agent............................................................................................................................................1636

Now Assist  in Virtual Agent............................................................................................................... 2577

Agent Chat............................................................................................................................................... 2612

Sidebar...................................................................................................................................................... 2677

Conversational Interfaces  Diagnostic Tool..................................................................................2709

Additional resources for Conversational Interfaces................................................................. 2718

Manage instance data sources.................................................................................................................2719

Entity View Action Mapper................................................................................................................2720

Instance Data Replication..................................................................................................................2733

MetricBase..............................................................................................................................................2809

MID Server.............................................................................................................................................. 2855

Remote tables.........................................................................................................................................3107

Manage content capabilities.....................................................................................................................3124

Document Services.............................................................................................................................. 3125

Knowledge Management.................................................................................................................. 3200

Now Assist  in Knowledge Management.......................................................................................3553

Response templates............................................................................................................................3562

Manage service capabilities...................................................................................................................... 3571

Self-service..............................................................................................................................................3572

Service Administration....................................................................................................................... 3580

Service Catalog..................................................................................................................................... 3878

Hermes Messaging Service............................................................................................................. 4254

Password Reset.................................................................................................................................... 4285

Notify.........................................................................................................................................................4438

Manage people and work capabilities................................................................................................. 4499

Advanced Work Assignment............................................................................................................ 4501

Skills Management.............................................................................................................................. 4606

Omnichannel Callback....................................................................................................................... 4627

Zoom extension for Omnichannel Callback...............................................................................4636

Proactive Triggers.................................................................................................................................4643

Interaction Management................................................................................................................... 4665

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

iii



Live Feed Core UI.................................................................................................................................4674

E-signature.............................................................................................................................................. 4744

ServiceNow  Voice.................................................................................................................................4748

ServiceNow AI Platform  Legacy Capabilities.......................................................................................4791

Connect.................................................................................................................................................... 4792

Classic Orchestration.........................................................................................................................4843

Legacy: Chat........................................................................................................................................... 5135

Legacy Notify...........................................................................................................................................5167

Task Communications Management..............................................................................................5196

Classic Workflow....................................................................................................................................5212

ATF Test Generator and Cloud Runner................................................................................................ 5433

ATF Test Generator and Cloud Runner  overview.....................................................................5434

Setting up cloud user......................................................................................................................... 5436

Generating the tests............................................................................................................................5437

Executing the tests using Cloud Runner.....................................................................................5442

Scheduling test execution................................................................................................................5444

ATF Test Generator and Cloud Runner  reference................................................................... 5445

HTTP Response Headers.......................................................................................................................... 5448

Configure HTTP response headers...............................................................................................5450

Response templates....................................................................................................................................5454

Activate response templates........................................................................................................... 5456

Create or modify a response template........................................................................................ 5459

Policy as Code Engine  (PaCE).................................................................................................................5463

Understanding PaCE...........................................................................................................................5463

Install PaCE............................................................................................................................................ 5465

Administer PaCE  policies..................................................................................................................5466

How to write and test custom PaCE  policies.............................................................................. 5521

About policy exceptions.................................................................................................................... 5529

Integrating PaCE  with other applications.................................................................................... 5533

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

iv



Extend ServiceNow AI Platform  capabilities

Extend the ServiceNow AI Platform  with additional applications and features.

Get started

Choose one of these tiles to get started.

Manage the Configuration 
Management 

Database (CMDB)

Configure connected 
devices, apps, and 

services you use 
with a powerful 

decision support tool.

Create Conversational 
Interfaces

Empower the ServiceNow 
AI Platform to resolve user 
issues with the AI-powered 

Virtual Agent chatbot.

Manage Instance 
Data Sources

Handle all your 
data efficiently 

across instances, 
databases, and more.

Manage Content

Create and share 
documents and knowledge 

articles with your users.

Manage Services

Manage service-
related applications 
like self-service, and 
the service catalog.

Manage People and Work

Take care of administrative 
and management 

demands in one place.

Legacy  Capabilities

Review the legacy
apps and plugins 

with capabilities for 
existing customers.
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Manage the CMDB

Control your organization's infrastructure by tracking assets, services, and the relationships 
between them in the CMDB. Use configuration strategies and consistent modeling in the CMDB 
to work with all ServiceNow  products on the ServiceNow AI Platform.

Create Conversational Interfaces

Provide optimal conversational experiences for your users in the chat channels that they prefer 
(live agents, virtual agents, or both) using ServiceNow®  Conversational Interfaces.

Manage Instance Data Sources

Ensure clear oversight of all data in your instances, databases, and third-party applications using 
ServiceNow  tools to manage data retrieval, storage, sharing, standardization, and monitoring.
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Manage Content

Give your users access to the information that they need quickly and easily using the content 
management suite with products for document and knowledge base management.

Manage Services

Give your customers tailored catalogs for products and create portals for service requests using 
the ServiceNow®  Service Catalog  application. Combine this application with the Self-Service 
plugin to provide your users with quick access to the tools at their disposal.
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Manage People and Work

Supervise personnel, assignments, and tasks all on the ServiceNow AI Platform  using tools to 
centralize communications, connect agents and users across apps, assess and associate skills 
with people, and assign tasks based on available personnel.

Legacy  Capabilities

Explore the various ServiceNow  Legacy  options for past releases of the ServiceNow AI Platform, 
including automated work processes, communications process management, and voice and text 
messaging integrations.
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Applications and features

• Configuration Management Database (CMDB)

• Conversational interfaces

• Advanced Work Assignment

• Interaction management

• Live Feed core UI

• E-signature

• ServiceNow Voice

• Password Reset

• Skills Management

• Service Catalog

Configuration Management
The Configuration Management Database (CMDB)  application is a centralized source that 
gives you full visibility into your IT environment. By storing information about your organization's 
infrastructure and how it is configured, this system allows you to monitor your network 
and ensure stability and best performance. Other ServiceNow®  applications enhance the 
effectiveness of the CMDB application or closely overlap to enable needed business goals.

Overview
https://player.vimeo.com/video/973320817?
h=1eb2620107&badge=0&autopause=0&player_id=0&app_id=58479

Configuration 
Management 

CMDB (CMDB)

Build, adjust, and monitor 
representations of your 
business infrastructure 

to support ServiceNow®

products and services.

Common Service 
Data Model  (CSDM)

Get consistent modeling 
in the CMDB, with 
standardized data 

terminology that can be 
used across the entire 

ServiceNow AI Platform.

Application Services

Create application 
services CIs from devices 

and applications that 
business units and 

different products can use.
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Data integration

Use Service Graph and 
associated tools to 

populate the CMDB with 
data from third-parties. 
Convert imported data 
to comply with CMDB 

definitions and structures 
to ensure CMDB integrity.

Configuration Management Database (CMDB)

Create models of your infrastructure using Configuration Management. Store your infrastructure 
data, represented by configuration items (CI)—all the computers, servers, routers, database 
instances, and services in your network. Analyze trends, reduce problems, and handle incidents 
by monitoring relationships between CI.

Common Service Data Model  (CSDM)

Ensure your data is consistent across every database and ready for every ServiceNow  product. 
The CSDM  provides standard terms and definitions for your CI, and any IT services you use. Map 
your data to CMDB  tables clearly using this modeling to provide it to the apps that use it, across 
the entire ServiceNow AI Platform.

Application services

Use application services to represent and manage operations of various ServiceNow  business 
units and products. An application service is a set of interconnected applications and hosts 
which are configured to offer a service to the organization such as an organization's internal 
email system. The various CIs and the relationships between them comprise an application 
service and are stored in the CMDB.

Data integration

Populate the CMDB by importing and integrating third-party data into the CMDB, in bulk. Use 
Service Graph connectors to specify process parameters and any needed conversions to 
be applied to the imported data. Such integrations utilize robust CMDB processes, such as 
Identification and Reconciliation, to ensure the integrity of the CMDB after third-party data 
integrations.

Troubleshoot and get help

• Whitepaper: CMDB Design & Configuration

• Whitepaper: CMDB Design

• White Paper: ServiceNow CMDB - Unlocking the Power of Configuration Management

• Whitepaper: CMDB Design Guidance
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• CMDB 101 - What is a configuration management database and why do you need one?
(ServiceNow®  Community post)

• KB0546686: CMDB Resources Page

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support

Configuration Management Database (CMDB)
Use the ServiceNow®  Configuration Management Database (CMDB)  application to build logical 
representations of assets, services, and the relationships between them that comprise the 
infrastructure of your organization. Details about these components are stored in the CMDB 
as configuration items (CIs) which you can use to monitor the infrastructure, helping ensure 
integrity, stability, and continuous service operation.

Overview

Use core features such as CMDB Health, CMDB Identification and Reconciliation, and CMDB 
Data Manager to monitor and detect health issues, reconcile data integrity issues, and manage 
data life cycle.

Note: 
CMDB modules, features, and wizards are not supported on mobile devices. You 
cannot use a mobile device to access the CI Class Manager, Query Builder, or Duplicate 
CI Remediator or to access or configure CMDB features such as Identification and 
Reconciliation, CMDB Health, CI Life-cycle Management, baseline CMDB, and proposed 
changes.

Get started

Explore

Overview of CMDB

Configure

Populate the CMDB

CMDB Workspace

Manage CMDB health 
through dashboards.
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CI Class Manager

View, create, or edit basic 
class definitions and class 
settings for identification 

and Reconciliation, 
and CMDB Health.

CMDB 360 / 
Multisource CMDB

Track and manage how 
multiple sources populate 

the same CI attributes.

CMDB Data Manager

Perform bulk management 
of CI life cycle operations 

such as deletion, 
archival, and attestation.

Duplicate CIs remediation

Remediate single or bulk 
de-duplication tasks.

CIs attestation

Verify the existence of 
actual IT infrastructure 

and applications, 
systematically and in bulk.

Data Certification

Validate all your data 
in the CMDB on a 

regular schedule or 
on-demand, in CMDB 

and non-CMDB tables.

CMDB Query Builder

Build complex 
infrastructure and 
service queries.

Unified Map

View a hierarchical map of 
CIs and the relationships 

between them.

CMDB Health

Monitor and maintain 
CMDB health: duplicate 

CIs, required CI 
fields, and audits.

Reference

Reference topics provide 
detailed descriptions 
of tables, properties, 

forms, and roles.
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Troubleshoot and get help

• CMDB Design & Configuration

• CMDB Design

• Improving Configuration Item Data Quality

• CMDB Design Guidance

• CMDB 101: What is a configuration management database and why do you need one?
(ServiceNow®  Community post)

• KB0546686: CMDB Resources Page

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support

Overview of CMDB

The Configuration Management data base (CMDB) creates and maintains the logical 
configurations your network infrastructure needs to support a ServiceNow  service.

https://player.vimeo.com/video/973320817?
h=1eb2620107&badge=0&autopause=0&player_id=0&app_id=58479

In CMDB, logical service configurations are mapped to the physical layout data of the supporting 
network and application infrastructure in each of your respective domains. They track the 
physical and logical state of IT service elements and associate incidents to the state of service 
elements, which helps in analyzing trends and reducing problems and incidents.

The configurations are stored in a configuration management database (ServiceNow  CMDB) 
which consists of entities, called Configuration Items (CI), that are part of your environment. A CI 
may be:

• A physical entity, such as a computer or router

• A logical entity, such as an instance of a database

• Conceptual, such as a Requisition Service

In each case, there are attributes about the CI that you want to maintain, and there is control 
you want to have over the CI. There are changes that may need to be made and tracked against 
the CI. Also, a CI does not exist on its own. CIs have dependencies and relationship with other 
CIs. For example, the loss of disk drives may take a database instance down, which affects the 
requisition service that the HR department uses to order equipment for new employees.

It is this relationship data that makes the CMDB a powerful decision support tool. Understanding 
the dependencies and other relationships among your CIs can tell you, for example, exactly 
who and what is affected by the loss of that bank of disk drives. When you find out that a router 
has failed, you will be able to assess the effect of that outage. When you decide to upgrade the 
processor in a server, you can tell who or what will be affected during the outage.

Configuration items differ from environment to environment because each customer has 
unique needs. Details about the exact physical attributes of a computer may be needed by one 
customer, but may represent meaningless data to another. The ServiceNow AI Platform  provides 
a mechanism to easily define new classes of configuration items and new relationships that 
may exist between CIs. New classes can be defined that extend other classes. For example, a 
laptop class exists that extends the computer class. The computer class itself extends the base 
CI class. Customer class extensions are automatically part of the ServiceNow  environment and 
blend seamlessly into the integration points for other ITIL processes.
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You can for example, set the Used for  attribute in the cmdb_ci_server table to a value such 
as ‘development’, ‘test’, or ‘production’. These values indicate the environment that the CI is 
supporting, and serve as a way of tracking a CI through its lifecycle in a changing environment.

Extended CMDB

In base systems, CMDB provides core functionality for the configuration management database, 
including modules for hardware and configuration items. The separate Extended CMDB plugin 
includes a collection of modules for specialized configuration items, such as radio hardware, test 
equipment, and voice system hardware.

To extend the CMDB you can activate  the following plugins to access the modules for 
specialized configuration items.

• CMDB Mainframe (com.snc.cmdb.mainframe)

• CMDB Radio Category (com.snc.cmdb.radio.category)

• CMDB Telecom Category (com.snc.cmdb.telecom.category)

• CMDB Test Equipment (com.snc.cmdb.test.equipment)

CMDB hierarchy and CI Class Manager

Sets of CIs that share attributes are stored in their own class table. All CMDB tables are 
connected by relationships and inherit attributes from each other to form a web of tables referred 
to as the CMDB hierarchy.

Use the CI Class Manager  to manage CMDB classes within the CMDB hierarchy, CMDB Health, 
and other class-related definitions. For example, in the CI Class Manager you can view class 
attributes, class identification rules, and the list of CIs for a specific class. To view the list of CIs in 
the CMDB, you can also enter cmdb_ci_list.do  in the filter navigator.

Architecture

Related tables

There are tables that are not part of the CMDB hierarchy but which still qualify as CMDB data. 
Related tables, such as the Serial Number [cmdb_serial_number] table, don't inherent from the 
Configuration Item [cmdb_ci] table, but have at least one column that references a CMDB CI. 
Related tables are specified in the Related Entries [cmdb_related_entry] table.
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Some scenarios that involve related tables, can result in orphan or otherwise stale records in 
related tables. A CI in a related table can, for example, become orphan if the referenced CI in the 
CMDB is deleted. You can use the CMDB Data Manager  to create a policy of the 'Delete CMDB 
Related Entry' policy type, that will cascade-delete that un-needed related items data. For more 
information about creating that CMDB Data Manager policy, see Create a CMDB Data Manager 
policy in CMDB Workspace.

Localization

Using the Translated Text field type (instead of string) for attributes in CMDB tables, can reduce 
overall performance, including performance of features such as CMDB Health. This is because 
values in CMDB tables are dynamic and are likely to change often, and the data itself is likely 
to continuously grow. Using the Translated Text field also requires manual update of related 
text. The Translated Text field type is typically effective with static data that doesn't change and 
doesn't grow. For more information about field types, see Field types .

Roles required

Reading CMDB tables directly requires the cmdb_read role, however accessing the 
Configuration  module requires the asset, itil, or itil_admin roles. For viewing CMDB-related 
records in the user interface, the itil role is usually sufficient. For updating records and for other 
manipulation of records, roles with higher credentials are usually required, as noted in each 
procedure throughout the documentation set.

For details about CMDB and other roles, see Base system roles , or see a feature components 
topic such as Components installed with CMDB Workspace.

Related topics

CMDB schema model

Domain separation and Configuration Management Database (CMDB)

Domain separation is supported in the Configuration Management Database (CMDB). Domain 
separation enables you to separate data, processes, and administrative tasks into logical 
groupings called domains. You can control several aspects of this separation, including which 
users can see and access data.

Support level: Standard

• Includes all aspects of Basic  level support.

• Application properties are domain-aware as needed.

• Business logic: The service provider (SP) creates or modifies processes per customer. The use 
cases reflect proper use of the application by multiple SP customers in a single instance.

• The instance owner must configure the minimum viable product (MVP) business logic and data 
parameters per tenant as expected for the specific application.

Sample use case: An admin must be able to make comments required when a record closes for 
one tenant, but not for another.

For more information on support levels, see Application support for domain separation .

Overview

The following topics provide details about domain separation in Configuration Management 
(CMDB) modules:
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• Domain separation in CMDB Health

• Domain separation and CMDB Query Builder

• Domain separation and CMDB Identification and Reconciliation

• Domain separation and the relations formatter and the CI relationship editor

• CMDB APIs (CMDB SDK)

Related topics

Domain separation and Configuration Management Database (CMDB)

CMDB classifications and class dependency

CMDB classifications are groups of CIs that share attributes and are stored in their own class 
table. Classifications let administrators to define a class hierarchy for the CIs within the CMDB.

A CI class refers to the actual table name in the instance database. In that context, 'CI type' is a 
friendly name that a CI is known by, such as computer, router, or printer.

One of the characteristics of a CMDB class is its dependency on other classes. A class can be 
independent or dependent, which determines the dependency or independence of the class 
CIs.

Independent CIs

CIs from an independent class, such as Linux Server CIs, have their own identity, 
exist by themselves, and aren't dependent on any other CIs.

Dependent CIs

CIs from a depended class have relationships with CIs from other classes and exist 
meaningfully only if these relationships exist. Dependent CIs don't exist on their 
own in the absence of the dependent relationship. For example:

• Network Adapter CIs don't exist meaningfully without the Hardware CIs that 
contain them.

• Application CIs don't exist on their own without the Server CI they are hosted on.

Identification processes in the Identification and Reconciliation engine (IRE)  CMDB feature 
extensively use CIs dependency classification. To find out the dependency classification 
of a class, open the Identification Rule page for a class in CI Class Manager. To establish CI 
dependency, use the CI Class Manager to specify dependent relationship rules  for a CI class.

For more information, see Identification rules.

Dependent CIs management

A life cycle update for a CI affects its dependent CIs. For example, when the CI that a dependent 
CI depends on is deleted, the dependent CI becomes orphan with no further use. To maintain 
the integrity and health of the CMDB, the system applies cascade-cleanup processes to 
dependent CIs that are affected by a life cycle update.

For information about independent and dependent CIs, see CMDB classifications and class 
dependency.

To ensure that dependent CIs are properly managed after deleting or archiving CIs, you must:

1. Enable dependent CIs management as described on this page.

2. Manually approve the CMDB Data Manager  tasks that dependent CIs management generates, 
or configure those tasks to not require a review or an approval.
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Note: 
An Orphan dependent CI  in the context of Data Manager is different from an orphan CI  in 
the context of CMDB Health. An orphan dependent CI within the context of Data Manager 
belongs to a dependent class, and is missing the dependent relationship. The definition of 
an orphan CI in the context of CMDB Health is broader, and includes any CI that matches 
CMDB Health orphan rules. For more information about orphan CIs in CMDB Health, see 
CMDB Health KPIs and metrics.

Examples of dependent CIs needing cascade-cleanup:

• Tomcat application (T1) runs on a Linux Server (L1) and contains a WAR file (W1). When L1 is 
deleted, T1 and W1 become orphan dependent CIs.

• Network Adapters become orphan dependent CIs when the hardware itself is deleted.

• A Linux Server has retired and is set with end of life, the assumption is that if the server is no 
longer operational then applications which depend on it shouldn’t be operational either.

Enable dependent CIs management

To enable dependent CIs management:

• Configure your environment for CMDB Data Manager. For details about how to configure the 
environment for CMDB Data Manager and the CMDB Data Manager own prerequisites, see 
Working with CMDB Data Manager.

• Ensure that the cmdb.dependent.ci.cascade.op.enabled  system property is set to 
true  (true by default). This property enables cascade operations and doesn't exist in the base 
system. Therefore, to view or modify the property value, you must first add it to the System 
Properties [sys_properties]  table.

• To enable cascade-retirement processes, ensure that the system property 
cmdb.dependent.ci.cascade.retire.enabled, which is used to manage cascade-
retirement of CIs, is set to true (true by default). The business rule After BR: Track 
“Retired” CIs, that checks for downstream CI dependencies, runs only if this property is 
set to true. This property doesn't exist in the base system and to view or modify it, you must first 
add it to the System Properties [sys_properties]  table.

Cascade-cleanup operations apply only from when you enable the dependent CIs management 
feature. To apply cascade-cleanup to orphan dependent CIs that already existed in the CMDB 
before enabling the feature, see Cascade-cleanup existing orphan dependent CIs.

Use of CMDB Data Manager to perform cascade-cleanup operations

Dependent CIs management processes use the CMDB Data Manager  to process the life cycle 
updates for the dependent CIs in the CMDB Dependent CI Ledger [cmdb_dependent_ci_ledger] 
table in the following ways:

1. Requesting and getting approvals from users for the life cycle updates for the CIs.

2. Performing the actual delete, archive, or retire CI updates after these operations are approved.

The system generates tasks for the 'Dependent CI - Deletion', 'Dependent CI - Archive', and 
'Dependent CI - Retire' Data Manager policies, with the CIs that are ready to be deleted, 
archived, or retired as target CIs. These policies are set with the respective 'On Demand' policy 
types. Then, a Data Manager admin or user, according to the Managed By Group  setting, 
must review and approve these tasks before the Data Manager applies the respective subflow to 
the dependent CIs.
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To automatically approve those tasks, use the CMDB Data Manager to clear the Needs Review 
flag of the respective Data Manager policies. Those tasks will then run without requiring any user 
intervention.

Cascade-retire dependent CIs

When a CI is set to retire, dependent CIs management data processes attempt to cascade-
update all the CIs depending on that CI, also to retire.

1. CI is updated to retire as the CI’s Life Cycle Stage  attribute is set to End of Life 
according to CSDM standards.

2. Business rule After BR: Track “Retired” CIs  runs (only if the system property 
cmdb.dependent.ci.cascade.retire.enabled  is true) to check if the CI belongs 
to a class which has any downstream dependencies.

If yes: The CI is added to the CMDB CI End Of Life Ledger [cmdb_ci_end_of_life_ledger] table.

3. For each CI in the CMDB CI End Of Life Ledger [cmdb_ci_end_of_life_ledger] table, the 
scheduled job CMDB Cascade Retire Dependent CIs  checks the CI’s relationships 
in the CI Relationship [cmdb_rel_ci] table. If there is a dependent relationship with a 
dependent CI, then that dependent CI is added to the CMDB Dependent CI Ledger 
[cmdb_dependent_ci_ledger] table with the Retire  action.

For more information about dependent relationship rules, see CMDB dependent relationship 
rules.

4. Scheduled Job CMDB DependentCI Policy Processor  runs (if the system property 
cmdb.dependent.ci.cascade.retire.enabled  is true) to process the CIs in the 
CMDB Dependent CI Ledger [cmdb_dependent_ci_ledger] table. Those CIs are set as being 
ready to retire upon approval using the CMDB Data Manager. A task is created in the CMDB 
Data Manager against the Dependent CI Retire policy to actually retire the CIs.

Cascade-archive of dependent CIs

Archiving a CI can leave its dependent CIs as orphans in the CMDB. To prevent the accumulation 
of stale data, the system applies cleanup processes that cascade-archive those orphan 
dependent CIs.

Orphan dependent CIs are not immediately archived. When a CI is archived, all the CI 
relationship records for that CI in the [cmdb_rel_ci] table, are also archived. The system then 
checks for any dependent CIs that were orphaned as a result of this archiving. Any CIs in the 
dependency chain that are identified as orphan dependent CI, are checked for any of the 
following conditions. CIs that meet any of these conditions are not orphan dependent CIs and 
therefore will not be archived:

• The CI is an unhandled duplicate CI (the CI is associated with an unresolved de-duplication 
task).

• The CI has multiple parent CIs.

• The CI belongs to an excluded class. Excluded classes are stored in the CMDB Dependent CI 
Class Exclusion [cmdb_dependent_ci_class_exclusion] table. In the base system, that table is 
pre-populated with some classes such as cmdb_ci_vm, cmdb_ci_vmware_instance, 
and other VMware-related classes. You can manage the set of classes that are exempt from 
management of orphan dependent CIs, by adding or removing records to that table.
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Eventually, only those CIs that these conditions do not apply to are added to the CMDB 
Dependent CI Ledger [cmdb_dependent_ci_ledger] table. Those CIs are set as being ready for 
archival using the CMDB Data Manager, upon approval.

Cascade-delete of dependent CIs

Deleting a CI can leave its dependent CIs as orphans in the CMDB. To prevent the accumulation 
of stale data, the system applies cleanup processes that cascade-delete those orphan 
dependent CIs.

Orphan dependent CIs are not immediately deleted. When a CI is deleted, all the CI relationship 
records for that CI in the [cmdb_rel_ci] table, are cascade-deleted. Prior to deleting each of these 
relationship records, the system checks if the CI on the other end of the relationship belongs to 
a dependent class. Any CIs in the dependency chain that are identified as dependent on the 
deleted CI, are checked for any of the following conditions. CIs that meet any of these conditions 
are not orphan dependent CIs and therefore will not be deleted:

• The CI is an unhandled duplicate CI (the CI is associated with an unresolved de-duplication 
task).

• The CI has multiple parent CIs.

• The CI belongs to an excluded class. Excluded classes are stored in the CMDB Dependent CI 
Class Exclusion [cmdb_dependent_ci_class_exclusion] table. In the base system, that table is 
pre-populated with some classes such as cmdb_ci_vm, cmdb_ci_vmware_instance, 
and other VMware-related classes. You can manage the set of classes that are exempt from 
management of orphan dependent CIs, by adding or removing records to that table.

Eventually, only those CIs that these conditions do not apply to are added to the CMDB 
Dependent CI Ledger [cmdb_dependent_ci_ledger] table. Those CIs are set as being ready for 
deletion using the CMDB Data Manager, upon approval.

Extraneous relationships

For the delete and archive operations, the system also tracks CIs' extraneous relationships 
in the Dependent CI Relations Evaluation Config [cmdb_dependent_ci_extra_rels_config] 
table. Extraneous relationships are those relationships that are not in the CI’s 
chain of dependency and deleting or archiving them depends on the value of the 
cmdb.dependent.ci.extra.rel.check  system property. This property is set to true 
by default, in which case extraneous relationships are not deleted or archived. You can set the 
property to false  to delete and archive those relationships.

The cmdb.dependent.ci.extra.rel.check  property doesn't exist in the base 
system and to view or modify the property value, you must first add it to the System Properties 
[sys_properties]  table.

Cascade-cleanup existing orphan dependent CIs

When enabling the dependent CIs management feature, the cascade-cleanup operations 
apply only from when the feature is enabled. However, it might be necessary to apply a similar 
cascade-cleanup operation to orphan dependent CIs that already existed in the CMDB before 
the feature was enabled.

Activate  the Cleanup Orphan CIs scheduled job to perform a one-time cascade-cleanup 
of orphan dependent CIs across the CMDB. The Cleanup Orphan CIs scheduled job checks 
throughout the entire CMDB to identify any orphan dependent CIs. These CIs are then 
processed in the same manner that CIs that are cascade-deleted are processed. CIs that are 
ready to be deleted are added to the CMDB Dependent CI Ledger [cmdb_dependent_ci_ledger] 
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table. The CMDB Data Manager is then leveraged as described in the Use of CMDB Data 
Manager to perform cascade-cleanup operations  section.

The Cleanup Orphan CIs scheduled job is intended to run only once, after which the job 
deactivates itself. Depending on the size of the CMDB, it might take the Cleanup Orphan CIs 
scheduled job several days to complete.

Sample scenario: cascade-retire

1. Enable dependent CIs management.

2. In CMDB Data Manager, create and publish a Retire policy. For example, retire an independent 
Linux Server CI with relationships to the dependent CIs Network Adapter and File System.

3. Wait for the scheduled job CMDB Data Manager Retire Policy Processor  to run, 
or run it manually.

4. In the Data Manager overview page, select the Open task card and approve the retirement task 
(Approval=Approved). Change the state of the task to 'Work in progress' if it doesn't change 
automatically. This will retire the Linux Server CI and add it to the cmdb_ci_end_of_life_ledger 
table.

5. Run the scheduled job CMDB Cascade Retire Dependent CIs.

This scheduled job processes each CI in the cmdb_ci_end_of_life_ledger table, and queries 
the relationships in the cmdb_rel_ci table for this CI. If a relationship exists with other 
dependent CI, then those dependent CI are added to the cmdb_dependenct_ci_ledger table 
with the settings of state = 'Ready' and action = 'Retire'.

6. Wait for the scheduled job CMDB DependentCI Policy processor  to run, or run it 
manually. This scheduled job creates a task against the OOB Dependent CI Retire policy, 
targeting the CIs in the cmdb_dependenct_ci_ledger table.

7. In the Data Manager overview page, select the Open task card and approve the task described 
with “Dependent CI – Retire..”.

CMDB record types

The CMDB contains the following major record types.

CMDB record types

Record types Description

Configuration 
Item (CI)

Any computer, device, or service in the CMDB. A CI's record includes all of the 
relevant data, such as manufacturer, vendor, location, etc. Configuration items 
can be created or maintained either using tables, lists, and forms within the 
platform, or using the Discovery  application.

Relation Type A defined relationship between a CI and either another CI, a user, or a group. 
Relation types are defined twice, once from the perspective of the child CI and 
once from the parent CI's perspective.

For example, a parent CI that powers a child CI uses relation type Powers::Is 
Powered By. Example relation types include In Rack::Rack contains, Log 
Reviewed by::Reviews logs  for, or Backup done by::Does backups  for.
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CMDB record types  (continued)

Record types Description

CMDB relationships can be established using Discovery  or using the tables, 
lists, and forms within the platform. The CMDB form has a specific Related Items 
toolbar optimized for modifying relationships.

Related Lists of CI components

Related lists in CI records display additional components contained by that CI, such as disk 
drives on a server and the rules that control the behavior of a network router.

When Discovery  runs, the Related List is populated with the components that Discovery  finds 
running on the CI. The CI record might show different lists from scan to scan, depending on 
whether or not Discovery  found the component.

By default, the Related Lists only display those components that are associated with that CI 
in the CMDB that has been discovered by the last scan. Components that are recorded in the 
CMDB but are not discovered in a scan, are deemed absent and do not appear in the list.

There are two types of components that appear in the Related List: components that are CIs 
themselves (such as hard disks), and components that are not (serial numbers and rules). The 
default filter condition in the breadcrumbs for components that are CIs is [Status] [!=] [Absent]. 
The filter condition for components that are not CIs is [Absent] [=] [false].

For example, a router can have several Related Lists affected by these filter conditions, including 
routing rules, disk drives, interfaces, and network adapters. Only those components found 
during the last Discovery  appear in these Related Lists.

Icons in related lists

Any of the following icons may appear in lists of CI related items.

For currently active incidents against this 
configuration item

For currently active problems against the 
configuration item

For currently active changes against the 
configuration item that are not covered in the 
past, current, pending changes. For example, 
a request to update the operating system on a 
server that is currently in progress may display 
this icon.

For changes that were recently completed 
against the configuration item. changes with 
an "Actual_end_date" in the past.

For changes that are planned soon against the 
configuration item. changes with an "Actual 
start date" in the future.
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(continued)

For currently active changes against the 
configuration item that have an "Actual start 
date"

For outages that were recently completed 
against the configuration item. outages with an 
"end" date in the past.

For outages that are planned soon against the 
configuration item. outages with a "begin" date 
in the future.

For currently active outages against the 
configuration item that have a "begin" date in 
the past and no "end" date

This will only show up in the Tree view and 
indicates that a configuration item that is 
downstream has at least one of the above 
issues against it.

The system looks five calendar days into the past and seven calendar days into the future when 
looking at recent outages and changes.

Teams related list

The Teams related list associates a user group to a CI based on group type, providing flexibility 
in tracking the different types of groups assigned to a CI. The Teams related list appears on CI 
forms for CIs of the Service [cmdb_ci_service] class and its descendent classes such as the 
Application Service [cmdb_ci_service_auto] class.

Using the Teams related list can be useful if many data sources are used in the organization, and 
when using the IntegrationHub ETL.

In the base system, the Teams related list contains group types that match the fields:

• Approval Group

• Change Group

• Managed by Group

• Support Group

When you set a group assignment on a CI form of one of those classes, that group assignment 
is automatically synchronized with the Teams related list. If you set an assignment group for an 
application service, a relationship record is created to represent the new group assignment for 
the CI. The Teams related list on such CI forms, always shows the current settings for the various 
group assignments for the CI.

If there are multiple groups assigned to a CI, then on the Teams  related list on a CI form, you 
can designate one of those groups as primary. When an incident involving that CI is created, the 
incident is assigned to that primary group. Only one group type can be designated as primary for 
a CI at any given moment.

As an example, use the Teams related list for an application service with the following 
characteristics:
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• Requires access to a database

• Runs on Linux servers

• Has a group assigned to manage the software portion of the actual application

In that example, you can track all of these group assignments by adding the appropriate group 
types and setting CIs with the new custom group types.

By-directional synchronization

When you set or modify the value of one of the assignment group fields on a Service CI form, 
then the Teams related list is updated with that change, adding a Teams related record if a 
corresponding one doesn't exist. For example, when you set an empty Support group  field to 
Database San Diego  and save the form, then the system adds a Teams record in which Group 
type  is Support Group  and User group  is Database San Diego.

In the opposite direction, any change in a Teams related record, where Group type 
corresponds one of the group assignment fields in the CI, is synchronized to the corresponding 
field. For example, if you set User group  to CAB Approval  in the Support Group  group 
type, the Support group  field on the CI form is updated with the CAB Approval  value.

Deleting a Teams record doesn't affect the group assignment fields in the CI.

Add the Teams related list to a Service CI form

By default, the tab for the Teams related list doesn't appear in the Related Lists section on 
Service CI forms. You can add the Teams related list by selecting the form's Additional actions 
menu, selecting Configure  and then Related Lists. In the Available list that appears, move 
Teams  to the Selected list and then select Save.

Add a custom group type to the Teams related list

The Teams related list lets you add custom group types that are needed in your organization, 
extending the initial list of supported group types.

Before you begin
Role required: itil_admin, asset, or cmdb_admin

About this task
To add a group type, you must modify the dictionary definition of the group_type  column in 
the cmdb_rel_team  table.

Procedure

1. On a Service CI form, select the Teams  related list.

2. In the Columns  tab, select the Group type  column.

3. On the Dictionary Entry form, in the Choices  related list tab, insert a new row for a new Teams 
choice such as Datacenter Group.

4. Save your changes.

Create a CI class

Create a CI class (table) that is an extension of an existing CI class. Then create identification 
and reconciliation rules for the new class.
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Before you begin
The class that is being extended must have its Is_Extendable  field checked, indicating that 
the class is extendable.

Role required:

• Itil_admin and personalize_dictionary: Required for editing the dictionary table

• admin: Full access

About this task
The CI Class Manager is a centralized location for managing CMDB tables and for creating a 
class that is derived from another CMDB class. Creating a class requires basic details such as a 
label and a name. Identification and reconciliation rules are also required to ensure that the class 
can be successfully identified by the identification engine.

For more information about extending a class and how attributes are derived from a parent class 
in that process, see Table extension and classes .

Procedure

1. Navigate to All  > Configuration  > CI Class Manager.

2. Click Hierarchy  to expand the CI Classes list.

3. Select the class that the new class is extended from.

4. Click Add Child Class.
The Add Child Class  option appears only if the selected class is extendable.

5. On the Provide Basic Info  tab, fill out the information and then click Next.

Field Description

Display name A unique label for the class (such as Laptops 
or Thin Clients). The label appears on list 
and form views for the class. Updating the 
Label  field also updates the label record in 
the language file for the current language. 
See Field Labels in Data dictionary tables .

Maximum string length is 80 characters.

Table name
Automatically populated based on the table 
label and the prefix string 'u_cmdb_ci'.

You cannot modify the prefix; however, 
you can modify the rest of the table name. 
The name can contain only lowercase, 
alphanumeric ASCII characters and 
underscores (_).

Maximum string length is 80 characters.

Description Explanation of the use purpose of the class.

Icon The icon associated with the class.

Extensible Indicator of whether this class can be 
extended.
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Field Description

Principal Class Denotes whether this class is included in the 
Principal Class filter. If this class is included 
in the Principal Class filter, then CIs from 
this class appear in CI list views when the 
Principal Class filter is applied.

6. On the Add Attributes  tab, click the + sign and enter details for each new class column.

7. Click Next.
For description of the different columns in the list view, see Dictionary entry form . To 
designate an attribute as a CI identifier for class identification, double-click the attribute's 
Identification Rule column and set it to true.

8. On the Set Identification Rule  tab, examine the Derived  identification rule and its Identifier 
Entries.
You can click Replace  to replace the derived rule with a new identification rule and new 
identifier entries specific to the new class. See Identification rules  for details about 
identification rules and identifier entries.

9. On the Dependencies  tab, click Add dependency  to add dependent rules.
The Dependencies  tab appears only if there are dependent identification rules for the 
selected class.

10. On the Add Reconciliation Rules  tab, click Add  to create the following rules:

a. Reconciliation Rules

b. Data Refresh Rules

11. On the Add Suggested Relationships  tab, review the diagram of the class derived suggested 
relationships.

12. Use the filter to display only inbound, outbound, or specific relationship types.

13. To add a suggested relationship for the class:

a. Click New.

b. In the Add Suggested Relationship dialog box, select a Relationship  and a Target Class  for 
the relationship. This Class  and the Target Class  become parent or child in the suggested 
relationship, based on your selection of the Relationship.

c. Click Save.
When building relationships for the class in the Query Builder, the list of suggested 
relationships is updated.

14. Click Done.

Related topics

CMDB Identification and Reconciliation

Reclassify a CI

You can upgrade, downgrade, or switch the class of a CI by modifying its Class  attribute.

Before you begin
Role required: itil or asset (In general, the roles required to update a CI)

About this task
Each class is defined with a unique set of attributes. This set consists of attributes that were 
derived from the parent class, and additional attributes defined for the class.
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When you reclassify a CI, the following occurs.

1. The set of attributes is adjusted to match the set of attributes of the newly assigned class. 
Attributes are added or removed as needed.

2. If any attributes are unique to the current class and are not defined in the newly reclassified 
class, they are lost.

3. A new record with the CI's current sys_id is inserted to the table of the new class, with the 
appropriate set of attributes for the class (the sys_id of the CI is retained).

Depending on the reclassification, the following occurs.

Downgrade

The CI class is updated to a class that is higher in the class hierarchy, and the newly 
assigned class is a parent of the current class. For example, reclassifying a CI from 
the cmdb_ci_server  class to the cmdb_ci_computer  class.

For example, the cmdb_ci_server  class has attributes that the 
cmdb_ci_computer  class does not have. During the downgrade, these 
attributes and their respective values are not included in the new CI record that is 
inserted into the cmdb_ci_computer  class.

Upgrade

The CI class is updated to a class that is lower in the class hierarchy, and the 
newly assigned class is a derived child of the current class and has additional 
attributes. For example, reclassifying a CI from the cmdb_ci_computer  class to 
the cmdb_ci_server.

Switch

The newly assigned class is in a different branch in the class hierarchy and has a 
different set of attributes than the current class. For example, reclassifying a CI from 
the cmdb_ci_linux_server  class to the cmdb_ci_win_server  class.

A switch is a combination of a downgrade and an upgrade. For example if 
the CI is downgraded to the cmdb_ci_server, and then upgraded to the 
cmdb_ci_win_server  class. Therefore, attributes are lost in the same manner 
as in a downgrade operation.

Note: 
Avoid the CI class downgrade and CI class switch operations as those can lead to data 
loss. When automatic CI reclassification is enabled (which is by default), the identification 
process  can result in some automatic reclassifications which lead to data loss.

For information about CI reclassification by the Identification and Reconciliation Engine (IRE) 
and related system properties that control the behavior of automatic CI reclassification, see CI 
reclassification during IRE processing.

Procedure

1. Locate the CI that you want to reclassify and display it in a list view.
You can use the application navigator. Or for example, if the CI is a server, then in the 
navigation search box, type cmdb_ci_server.list  to display the CI in the Servers  view.

2. Ensure that the Class  field is displayed in the list.
If you do not see this attribute, personalize the list to add the Class  field.
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3. Double-click the Class  value for the CI, and select a new class.

4. Click the green check box to confirm your selection.

Delete CIs

You can use the CI Class Manager to delete CIs that are no longer needed.

Before you begin
Role required: itil_admin

About this task
For information about policy-based, large scale automated CI deletions, see Working with CMDB 
Data Manager.

Note: 
You can't delete base system tables. For information about deleting custom tables, see 
Delete a table .

Procedure

1. Navigate to All  > Configuration  > CI Class Manager.

2. Click Hierarchy  to expand the CI Classes list and then select the class from which you want to 
delete CI records.

3. In the class navigation bar on the left, click CI List.

4. On the CI List form view, select the CIs that you want to delete.
Select the check box in the header to select all the CIs that are visible.

5. Click Actions on selected rows  and then click Delete.

6. Click Delete  in the Confirmation  dialog box.

Result
After deleting CIs that a dependent CI depends on, the dependent relationship is also deleted. 
The dependent CI becomes an orphan and is not immediately deleted. In this situation, the 
system attempts to cascade delete such orphan dependent CIs to prevent the accumulation of 
stale data and maintain the health of the CMDB. For information about how the system manages 
orphan dependent CIs, see Management of orphan dependent CIs.

View and edit class definitions and metadata

Use the CI Class Manager as a central location to explore the CMDB class hierarchy, CI 
table definitions, and class CIs. View the details of each table such as its label and fields, 
relationships, and all related metadata definitions.

Before you begin
Role required: none

About this task
The CI Class Manager displays the entire CMDB class hierarchy in a tree-view format, 
consolidating class definitions into a central location. It lets you display metadata information for 
a class, such as reconciliation rules, mandatory and recommended fields, and audit templates. 
You can also select a specific class to view, to modify, or to extend its definition to create a 
derived class. For each class, you can directly access CMDB Health settings, identification and 
reconciliation rules, orphan scorecard, and certificate template, defined for the class.

For more information about extending a class and how attributes are derived from a parent class 
in that process, see Table extension and classes .
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Procedure

1. Navigate to All  > Configuration  > CI Class Manager.

2. Click Hierarchy  to expand the CI Classes list and then select a class to display details for.

3. On the class navigation bar, expand the following items to display further details for the class.

◦ Class Info:

▪ Basic Info:  Displays details for the selected class, such as the display and table name, 
description, and class icon. Lets you edit some of the class definitions, and prevents 
editing of some details such as the table name.

Role required: itil for reading, and itil_admin and personalize_dictionary for writing.

▪ Attributes:  Displays table attributes (columns). Lets you edit those attributes and add new 
ones.  For description of the different attributes in the list view, see Dictionary entry form .

Role required: personalize_dictionary for reading and writing

To add an attribute:

a. Click the Added  tab and scroll to the bottom of the list.

b. Double-click Insert new column, and enter details for each new class attribute. Set 
Identification  to true to designate an attribute as a CI identifier for class identification.

c. Click Save, and fix any errors that appear.

▪ Identification  and Reconciliation: Displays and lets you edit, create, and delete 
identification and inclusion rules, reconciliation and data refresh rules  for the class.

See CMDB Identification and Reconciliation  for more information.

Role required: itil for reading, and itil_admin (on top of itil) for writing.

▪ Dependent Relationships: Displays and lets you edit, create, and delete hosting and 
containment relationships for the class. See CMDB dependent relationship rules  for more 
information.

Role required: itil for reading and itil_admin (on top of itil) for writing.

▪ Suggested Relationships: Displays a diagram of all suggested relationships for the class, 
and lets you delete or add suggested relationships for the class. Use the navigation tools 
to increase or decrease the diagram, and to move the diagram on the page. Use the 
filter to display specific relationship types. See Suggested class relationships  for more 
information.

Role required: itil.

◦ All Relationship Rules: Displays a combined diagram of all suggested relationships and 
all dependent relationships for the class.  Use the navigation tools to zoom in or out, and 
to move or center the diagram on the page.  Use the filter to display specific relationship 
categories.

◦ Health: Lets you review and configure CMDB Health-related system properties, scorecards, 
and rules and settings for all CMDB health KPI and metrics, at the class level. See CMDB 
Health  for information about enabling and configuring CMDB Health, and displaying health 
reports.

Role required: Itil for reading and itll_admin (on top of itil) for writing.
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◦ CI List: Displays the CIs of the selected class. Lets you create CIs of the selected class and 
perform other operations such as delete.

Role required: Itil for reading. Writing requirements follow the selected table settings.

Related topics

Create or modify map icons

Update the list of classes in the Principal Class filter

Manage the list of classes that are included in the Principal Class filter to restrict the CIs that 
appear in CIs list views to only specific classes that you need. You can add or remove CMDB 
classes from the Principal Class filter.

Before you begin
Role required: itil_admin and personalize_dictionary

About this task
Apply the CMDB Principal Class filter in list views of CMDB CIs so that only CIs that belong to 
the classes in the filter, appear. In a base system, the Principal Class filter doesn't contain any 
classes. The principal class setting applies only to the current class and is not derived by child 
classes. For more information about list view filters, see Save and use filters in a list view .

You can also use the Principal Class filter in the Discovery sources card in the CMDB 360 
dashboard in CMDB Workspace. For more information about using the Principal Class filter, see 
CMDB 360 experience in CMDB Workspace.

Procedure

1. Navigate to All  > Configuration  > CI Class Manager.

2. Select Hierarchy  to expand the CI Classes list and then select a class to add or remove from 
the Principal Class filter.

3. On the class navigation bar, navigate to Class Info  > Basic Info.

4. On the Basic Info form, select or clear Principal Class.

5. Select Save.

Result
The Principal Class filter is updated with the addition or the removal of the class from the list of 
classes in the filter. When you apply the Principal Class filter to a Configuration Items list view, 
only CIs from classes included in the filter, appear.

What to do next
In both of the following scenarios, the list of CIs refreshes to show only CIs whose class is 
included in the Principal Class filter:

• 1. In the Filter navigator, type cmdb_ci.list  and then press the Enter key.

2. In the Configuration Items list view, select the List controls  menu icon, select Filters  and 
then select Principal Class.
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• 1. Open a Change Request form.

2. Scroll down and select the Affected CIs  tab. Select Add.

3. In the Add Affected CIs  form, select the List controls  menu icon, select Filters  and then 
select Principal Class.

For more information about adding affected CIs to change requests, see Associated CIs on a 
change request .

CI relationships in the CMDB

The CMDB, in contrast to a static asset list, helps you track not only the configuration items (CIs) 
within your system, but also the relationships between those items.

A relationship in the CMDB consists of two CIs and a relationship type:

• Parent CI

• Child CI

• Type of the relationship that links both CIs

For example, in the [Server1] [Managed by] [Server2] relationship:

• Server1 is the child CI

• Server2 is the parent CI

• [Managed by] is the relationship type

For example, a web application might read data from an instance of Oracle, which in turn might 
depend on a piece of underlying hardware. Most CIs in a CMDB have multiple relationships to 
other CIs, users, and groups.

The relationships between CIs can be automatically discovered. If you use Discovery, many 
relationships can be automatically loaded into the system through the discovery process. If you 
import your data from another system, you get some form of relationships.

You can add to automatically discovered relationships, create relationships, or edit relationships 
for a CI by launching the CI relationship editor  from the CI form.

Dependent and non-dependent relationships

Dependent relationships, such as tomcat RunsOn Hardware, are used by the Identification and 
Reconciliation Engine (IRE) to identify dependent CIs.

Non-dependent relationships are not used for CI identification, and therefore can be deleted 
if no longer needed. CMDB tracks discovery source and last scanned time for non-dependent 
relationship in the Relationship Sources [sys_rel_source] table. Dependent relationships are 
used for CI identification. Therefore they should not be directly deleted and they are not tracked.

Information in the Relationship Sources [sys_rel_source] table can be used to decide if it is safe 
to delete a non-dependent relationship. For example, a discovery source which is attempting to 
delete a non-dependent relationship can confirm that:

• There are no other data sources for that relationship.

• The relationship was not updated for some specified length of time and therefore is no longer 
needed.
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When a non-dependent relationship is deleted from the CI Relationship [cmdb_rel_ci] table, all 
cascading corresponding records in the Relationship Sources [sys_rel_source] table are deleted.

Key relationships

The following table contains descriptions for some key CMDB relationships.

Parent Child Description

Applicative Flow To Applicative Flow From
Connections between 
endpoint CIs.

Note: 
For internal use only 
(service model).

Connects to Connected by
Network Connections 
between elements that are 
talking to each other.

Examples: Workstation to 
switch, switch to switch, 
kubernetes workload to 
service.

Contains Contained by
Typically a containment 
relationship (CI to contained 
CI). The child CI typically has 
a single parent CI with this 
relationship type.

Examples: Tomcat to Tomcat 
WAR, VMware Datacenter 
contains Network.

Defines resources for Gets resources from
Parent CI defines/gets 
resources from a child CI.

Example: VMware - Resource 
pool gets resources from ESX 
Server.

Depends on Used by Parent CI depends on child CI. 
Meaning that problem/change 
in the child CI may impact the 
parent CI.

Hosted on Hosts
Hosting relationship between 
an element and its host.

Examples: Cloud resource 
to logical data center, k8s 
workload to k8s cluster.
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Parent Child Description

Implement End Point To Implement End Point From
Endpoint to CI that exposes 
this endpoint.

Note: 
For internal use only 
(service model).

Manages Managed by
Typically used where one CI 
manages one or more other 
CIs.

Example: vCenter manages 
vCenter Datacenter.

Members Member of
Typically used with clusters 
where a cluster node is a 
member of a cluster.

Example: ESXi Server is a 
member of vCenter Cluster.

Owns Owned by Usually a containment 
relationship (CI to owned 
CI). The child CI typically 
has a single parent with this 
relationship type.

Runs on Runs
Typically between a CI 
that represents a software 
application, to the hosting 
hardware/VM.

Example: Tomcat 'Runs on' 
Linux server.

Use End Point To Use End Point From
From the CI to an outgoing 
endpoint.

Note: 
For internal use only 
(service model).

Related topics

Create a CI relation rollup

Suggested class relationships

The system keeps a table (Suggested Relationship [cmdb_rel_type_suggest]) of relationship 
types that are appropriate for a CI type, based on its class. You can manage suggested 
relationships by navigating to Configuration  > Suggested Relationships, or in the CI Class 
Manager.
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Suggestion model

The relationship editor has a base CI. The base CI designates the CI that a user was on before 
launching the editor, as the base CI in the new relationship. If you launched the relationship 
editor from the lnux100 CI, then lnux100 becomes the base CI. Also, every CI in the system has a 
type (class). For example, bond lnux100 is of the Linux server type.

Many CI types are children of other types in the hierarchy. For example, the class hierarchy for a 
Linux server is:

cmdb_ci  -> cmdb_ci_hardware  ->cmdb_ci_computer  -> cmdb_ci_server  -> 
cmdb_ci_linux_server

The suggestion model works by analyzing the suggested relationship table for all relationships 
whose base class is the current base class of the user or any one of its parent classes. For 
example, looking at a Linux server, the suggestion model would retrieve any relationships whose 
base class was:

cmdb_ci_linux_server, cmdb_ci_server, cmdb_ci_computer, 
cmdb_ci_hardware, or cmdb_ci

ITOM Visibility, if available, uses enhanced discovery patterns to identify and add CI 
relationships to the Suggested Relationships table.

Suggested CI relationships in the relationship editor

The CI relationship editor uses the suggestion model to help users select reasonable 
relationships for configuration items.

For example, consider these relationship types in the system:

• Provides Power for :: Receives Power From

• Runs on :: Hosts

Typically, a user uses these relationships to define the following reasonable relationships 
between two items as follows:

• a database runs on a server

• a rack provides power for a server

Typically, neither of the following definitions would be appropriate:

• a rack runs on a server

• a server runs on a database

For descriptions of some key relationships, see CI relationships in the CMDB.

Related topics

CI Class Manager

Add a suggested relationship

Add a suggested relationship for a class. The list of suggested relationships for a class is 
available when you create a new relationship for a CI of that class.

Before you begin
Role required: To view — itil. To create, update, or delete suggested relationships — itil_admin.
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Procedure

1. Use the CI Class Manager (Role required: itil_admin):

a. Navigate to All  > Configuration  > CI Class Manager.

b. Click Hierarchy  to expand the CI Classes list, then select the class where you want to add a 
suggested relationship.

c. In the class navigation bar, click Suggested Relationships.

d. Click New.

e. In the Add Suggested Relationship dialog box, select a Relationship  and a Target Class  for 
the relationship.
This Class  and the Target Class  become parent or child in the suggested relationship, 
based on your selection of the Relationship.

f. Click Save.

2. Or, navigate to All  > Configuration  > Relationships  > Suggested Relationships  (Role required: 
admin):

a. Click New.

b. On the form, fill in the fields.

Suggested Relationship fields

Field Description

Base class The base class in the relationship, which 
depending on the relationship type, is either 
the parent or the child in the relationship.

Relationship Relationship type.

Dependent class The dependent class in the relationship, 
which depending on the relationship type, 
is either the parent or the child in the 
relationship.

Example: Suggested relationship you can add

Base Class Relationship Dependent/Target Class

Oracle Is Hosted On Linux Server

Oracle Is Hosted On Solaris Server

Note: 
The same parent class and relationship can appear more than once.
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What to do next
You may need to delete a suggested relationship, for example, to limit the choice of available 
relationships in the CI relationship editor. Removing a suggested relationship does not affect 
relationships that are created or updated by Discovery.

Relationship governance rules

Relationship governance rules is a set of relationship rules used to ensure consistency 
and validity in modeling relationships between configuration items (CIs) in the CMDB. Use 
relationship governance rules to prevent the selection of relationship types or directions that are 
not allowed between specific CI types.

Different applications such as Discovery and Service Mapping, create relationships between 
CIs. Each application might use inconsistent relationship type or direction to represent the same 
entity, resulting in multiple views of the same CIs. Relationship governance rules define what 
are valid relationship types and valid directions between pairs of CI types resulting in valid and 
consistent relationships in the CMDB.

Relationship governance rules consist of:

• CMDB dependent relationship rules: Rules (hosting and containment rules) that are used 
for CI identification. You can view and modify dependent relationship rules in the CI Class 
Manager, after selecting a class from the class hierarchy and clicking Dependent Relationship.

• Suggested relationships: Rules that are based on existing suggested relationships in the 
Suggested Relationship [cmdb_rel_type_suggest] table. Suggested relationships are used 
in the CI relationship editor. You can view and modify suggested relationships in the CI 
Class Manager, after selecting a class from the class hierarchy and clicking Suggested 
Relationships.

• Reference rules: Rules that are used mostly by Cloud Management to represent all the 
possible valid combinations of pairs of referencing and referenced CIs in the service definition.

• Built-in valid relationships: The following relationships are pre-defined in the base system as 
valid relationships:

◦ cmdb_ci_endpoint -> Applicative Flow To::Applicative Flow From -> cmdb_ci_endpoint

◦ cmdb_ci_endpoint -> Implement End Point To::Implement End Point From -> cmdb_ci

◦ cmdb_ci -> Use End Point To::Use End Point From -> cmdb_ci_endpoint

General behavior

• Relationship governance rules support inheritance.

For example, suppose that the suggested relationship cmdb_ci_appl Runs 
On::Runs cmdb_ci_hardware exists. Then a Runs On::Runs relationship between a 
cmdb_ci_appl_dot_net CI and a cmdb_ci_windows_server CI is valid. That is because .Net 
Application class inherits from the Application class and the Windows Server class inherits 
from the Hardware class.

• Duplicate relationship governance rules are not allowed.

• Relationship governance rules are not domain separated.

• It is allowed to have more than one relationship type between the same two CI types.

For example, the following relationships are valid:

◦ cmdb_ci_appl Depends On::Used by cmdb_ci_service

◦ cmdb_ci_appl Receives data from::Sends data to cmdb_ci_service
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Reports

A relationship between CIs is considered valid if it conforms to any of the relationship 
governance rules. Use the CMDB dashboard to view reports about overall relationships health 
including relationships compliance with relationship governance rules. The 'Relationships not 
compliant with all relationship rules' report shows CI relationships that are not compliant with any 
of the relationship governance rules.

CI relations formatter

The default CI form includes a CI relations formatter from which you can examine a CI and 
its relationships in various views. From the CI relations formatter, you can also launch the CI 
relationship editor for the CI.

If the domain separation plugin is activated, then only relationships in which the logged on user 
is authorized to view both CIs, are displayed.

The CI relations formatter contains a list of related CIs and a toolbar with controls for viewing 
the relationships between the current CI and related CIs. You can configure the controls in this 
formatter to modify varying aspects of the view. For more information about formatters, see 
Create a formatter and add it to the form .

Note: 

• If an endpoint is a child in one relationship and the same endpoint is a parent in another 
relationship, then that endpoint is hidden and does not appear in the relations formatter 
view. Similarly, relationship qualifier chains are also hidden and do not appear in the 
relationship formatter view.

◦ Example: CI1 > endpoint > CI2

In this example, CI1 is related to CI2 through relationships with endpoint. A single 
relationship appears in the relations formatter:

CI1 > CI2 (These relationships appear as a direct relationship without endpoint, 
because endpoint is a parent in one relationship and a child in another relationship).

◦ Example: CI1 > endpoint1 > CI2 > endpoint2

Two relationships appear in the relations formatter:

CI1 > CI2 (endpoint1 is hidden because it is a parent in one relationship and a child in 
another relationship).

CI1 > CI2 > endpoint2 (appears as level 2 relationship – endpoint1 is hidden and 
endpoint2 appears as it a child and not a parent in any other relationship).

• On instances that do not meet the internet browser requirements for the CI relations 
formatter, the default CI form includes the legacy CI relations formatter instead. For more 
information, see Legacy CI relations formatter.

• CIs not extended from the Configuration Item [cmdb_ci] table, are not displayed in 
Dependency Views maps and in CI relation formatters.

• The Applicative Flow To::Application Flow From  relationship is 
a special relationship type used only between Service Mapping endpoints. This 
relationship type is not intended for use in the CMDB as a relationship between CIs and 
therefore it is not displayed in the relations formatter.
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Controls for viewing related CIs

Control Definition

Add CI 
relationship

Starts the relationship editor to manually create CI relationships. For more 
information (including about roles required for the '+' control to appear), see 
Create or edit a CI relationship.

Show 
dependency 
views

Launches a Dependency Views map in another window or tab. The CI is the 
central node in the map, with a configurable number of levels above and below 
that node in the hierarchy. Map indicators next to the nodes indicate the number 
of tasks, incidents, problems, changes, or outages related to that node. Right-
click to expand collapsed nodes or display a list of related tasks or problems. For 
more information, see Dependency Views map.

Search for 
CI

Filters the CIs included in the display.

Click the Settings icon ( ) to configure additional view settings that filter the data displayed. 
Settings are preserved through logging out and logging back in.

Related items settings

Setting Description

Show 
Relations 
in Flat/Tree 
Layout

To view a flat list of related CIs that are grouped by relationship type in 
alphabetical order, click Flat  (default value).

To view groups of related CIs in a hierarchical tree, clickTree. If you select the 
tree view, you cannot configure any other settings for viewing related CIs. A 
single list of upstream and downstream relationships is displayed.

Show 
Relations in 
Split/Merge 
Layout

To view a single list that includes both upstream and downstream relationships, 
click Merge  (default value). Relationships are grouped by relationship type.

To view separate lists for upstream and downstream relationships, click Split.

Filter 
Relations by 
Max Level

Select the number of downstream and upstream levels in the hierarchy to 
include when displaying CIs in a flat view.

Default value is 3.

Filter 
Relations by 
Relationship 
Type

Select the types of relationships to view.

Default value is 'All Relationship Types'.

Filter 
Relations by 
CMDB View

Filter by tables specified in CMDB views, if any relationship filters exist.

The relations formatter uses the following icons to provide additional information about changes, 
problems, and outages related to CIs in the relationship:
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Icons related to CIs

Icon Description

Recently closed changes

Planned changes

Currently open changes

Recently closed outages

Problems

Incidents

Planned outages

Currently open outages

In large networks, a list of related CIs might be excessively long, which can slow performance 
when a CI form is rendered. You can configure these properties to control the amount of data that 
is displayed. To find a property, enter sys_properties.list  in the left navigation filter and 
search for the property.

Properties related to performance

Property Description

glide.ecmdb.find_relationship_issues Hides or displays an icon in the CI relations formatter 
that links to open issues for the CI. This property 
defaults to true (displays the icon).

glide.ui.max_relation_levels Specifies the maximum level for displaying CIs in flat 
view before reaching the maximum relations limit. The 
default value is 5.

glide.ui.max_relations
Specifies the maximum number of related CIs to display.

When exceeded:

• A notification appears indicating that the limit has 
been reached, and that not all relations are displayed. 
The default value is 1000.

• Flat layout reverts to the tree layout view.

Related topics

Create a formatter and add it to the form

Create or edit a relationship filter

Domain separation and the relations formatter and the CI relationship editor

Domain separation is supported in the relations formatter and the CI relationship editor. Domain 
separation enables you to separate data, processes, and administrative tasks into logical 
groupings called domains. You can control several aspects of this separation, including which 
users can see and access data.
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Overview

How domain separation works in the relations formatter and relationship editor

• Relations formatter

The relations formatter is domain-separation supported. The relations formatter is used to 
display CMDB relationships in the UI in different views. Since the CI Relationship (cmdb_rel_ci) 
table is not domain separated, relationships are visible in the relations formatter only if both 
parent and child CIs (cmdb) are visible in the domain.

The CI Relationship Type (cmdb_rel_type) table is not domain separated. Therefore, in the 
relations formatter, all the relationship types are available to be selected as a filter.

By default domain separation is supported in the relations formatter.

• Relationship editor

The relationship editor is domain-separation supported. You can use the relationship editor to 
add new relationships or delete existing relationships for the current CI.

◦ The CI relationship editor displays a list of CIs to add or remove from relationships. Since 
they are domain separated, the CI list view in the relationship editor displays the CIs that are 
visible to the current domain.

◦ The CI relationship editor displays a list of relationships to add or remove. Since the CI 
Relationship [cmdb_rel_ci] table is not domain separated, the relationships list view displays 
all the relationships of the current CI.

The Suggested Relationship (cmdb_rel_type_suggest) table is not domain separated, which 
means that all the suggested relationship types in the relationship editor are visible for all 
domains.

By default domain separation is supported in the relationship editor.

Related topics

Domain separation and Configuration Management Database (CMDB)

Create or edit a relationship filter

Create a custom relationship filter to display CI relationships from selected tables in the CI 
relations formatter.

Before you begin
Role required: ecmdb_admin

About this task
The CI relations formatter displays related CIs for the base CI, and the relationships between 
the CIs. You can use relationship filters on the CI relations formatter to customize CI relationship 
views.

Procedure

1. Navigate to All  > Configuration  > Relationships  > Relationship Filters.

2. Click New  or select a filter to edit.

3. Enter or edit the relationship filter name.

4. Right-click the form header and click Save.
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5. In the Configuration Types  section, click Edit.

6. On the Edit Members  form, select the tables of the CIs that you want to show with the filter and 
then move the tables to the Configuration Types list.

7. Click Save.

Result
On a CI form, in the relations formatter settings, you can select the newly defined relationship 
filter from the Filter Relations by CMDB View  list.

In the legacy CI relations formatter, you can click View  and select the newly defined relationship 
filter.

After you select a filter, the relations formatter displays only CIs from the tables specified in the 
filter or from descending tables.

Exclude relationships from the relations formatter view

Create a list of relationships that should not appear in the relations formatter view on CI forms.

Before you begin
Role required:

• To view the relationship type exclusion list — itil

• To create, update, or delete the relationship type exclusion list — itil_admin

Procedure

1. Navigate to All  > Configuration  > Relationships  > Relationship Type Exclusion List.

2. In the CI Relation Filters list view, click New.

3. Fill out the CI Relation Filter form to specify the relationship that you want to exclude from view.

4. Click Submit.
Excluded relationships do not appear in the relations formatter view on CI forms.

Legacy CI relations formatter

On instances that do not meet the internet browser requirements for the latest CI relations 
formatter, the default CI form includes the legacy CI relations formatter instead.

This element contains the list of related CIs and a toolbar with controls for viewing the 
relationships between the current CI and related CIs. For information about the latest CI relations 
formatter, see CI relations formatter.

Related items field

Note: 
The legacy BSM map provides a more complete view of CI relationships.

Configure the controls in this formatter with two properties that restrict varying aspects of the 
view.

Flat layout

Click the flat layout icon ( ) to group related CIs by relationship.
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Flat layout view

Tree layout

Click the tree layout icon ( ) to group related CIs in a hierarchical tree.

Tree Layout view

CI relationship editor

Use the relationship editor to view, create, modify, or delete CI relationships. Open the 
relationship editor from the CI Relations formatter.

When you use the relationship editor, the CI from which the editor was launched is designated as 
the base CI. You can then select one or more CIs as a second CI for the relationship. Depending 
on the selected relationship type, the base CI can become the parent CI or the child CI in the 
new relationship.

The relationship editor operates differently, depending on whether you select the Use suggested 
relationship  check box.

• With suggested relationships, the relationship editor lists all available relationship types for the 
base CI. To define a new relationship, select a relationship type, and then select a second CI 
for the relationship.

Suggested relationships are highlighted for you. These relationships are displayed in blue with 
a prefix of [Suggested].

• Without suggested relationships, you define a new relationship by first selecting a second CI 
for the relationship and then selecting a parent or a child relationship type.
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Note: 
The following relationship types are used only for Service Mapping endpoints, and you 
cannot use them as a relationship type between two CIs:

• Implement End Point To:Implement End Point From

• Use End Point To: Use End Point From

• Applicative Flow To:Applicative Flow From

Suggested relationships

If you select the Use suggested relationship  check box in the editor, the Suggested relationship 
list appears. It displays all available CI, user and group relationship types for the base CI. 
Relationship types have a suffix of (Parent)  or (Child)  to note the relationship descriptor, and 
suggested relationship types are displayed in blue and have a "*" prefix.

When you select a relationship, you are also designating the base CI as being the parent or the 
child CI in the new relationship. For example, if you select the 'Feeds' relationship type, the base 
CI becomes the designated parent CI, and the second CI that you select becomes the child CI in 
this relationship.

Downstream relationships

If you do not select the Use suggested relationship  check box in the editor, the Downstream 
relationships  list appears. It displays all relationships in which the base CI is the parent CI. The 
child CI of the relationship is displayed in the Child  column.

Upstream relationships

If you do not select the Use suggested relationship  check box in the editor, the Upstream 
relationships  list appears. It displays all relationships in which the base CI is the child CI. The 
parent CI in each relationship is displayed in the Parent  column.

Related topics

Add a suggested relationship

Create or edit a CI relationship

Legacy CI relationship builder

Create or edit a CI relationship

Use the relationship editor to view, create, or modify CI relationships. You can open the 
relationship editor from the CI Relations formatter.

Before you begin
Role required:

• To create relationships: ITIL or asset

• To view relationships, depending on the state of the Table API ACL:

◦ If inactive (default): ITIL or asset

◦ If active: ITIL or asset, and snc_platform_rest_api_access

For more information, see CI relationship security, REST API , and Table API .

About this task
The relationship editor operates differently, depending on whether you check the Use suggested 
relationship  option or not.
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Procedure

1. Launch the relationship editor:

a. Open a CI form.
For example:

i. Navigate to All  > Configuration  > CI Class Manager.

ii. On the CI Class Manager page, select Open Hierarchy.

iii. On the CI Class panel search and select the class of the CI for which you want to create or 
edit relationships.

iv. Select CI List  in the left-side panel and then in the list view, select the CI.

b. On the CI form, scroll down as needed to select the Add CI relationship icon (+ sign) in the 
Related Items section.

2. To use suggested relationships, first select a relationship type, and then select one or more CIs 
to be the child CIs in the relationship:

a. Select Use suggested relationship.

b. From the Suggested relationship type  list, select a relationship type.
You can filter the list of suggested relationships by using the filter check boxes.

Filter option Description

Hide CI 
relationship

Hides any relationships between the base CI and another CI 
(such as "Receives data from"). Default filter is stored in the 
ci_manage_relationships_filter_hint.cmdb_ci user preference.
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Filter option Description

Hide user 
relationship

Hides any relationships between the base CI and a user 
(such as "Logs reviewed by"). The default filter is stored in the 
ci_manage_relationships_filter_hint.sys_user preference.

Hide group 
relationship

Hides any relationships between the base CI and a group 
(such as "Backups done by"). Default filter is stored in the 
ci_manage_relationships_filter_hint.sys_user_group user preference.

The Configurations Items  list displays all the CIs that are appropriate for the base CI and 
the selected relationship type. The Relationships  list at the bottom of the editor, displays all 
existing relationships of the selected relationship type, in which the base CI is a parent CI or 
a child CI.

c. From the Configuration Items  list, select one or more CIs as a second CI for the relationship.
You can filter the list of Configurations Items  by adding conditions in the Filter  section and 
clicking Run filter.

If you selected a parent relationship type, these CIs becomes the child CI in the relationship, 
and if you selected a child relationship type, then the selected CIs become the parent CI in 
the relationship.

d. In the Relationships  section, click the plus icon (+) to add the new relationships.
Alternatively, you can drag the selected CIs to the Relationships  list. Each new relationship 
will consist of the base CI, the selected relationship type, and a selected second CI.

3. To not use suggested relationships, first select one or more CIs to be the child CIs in the 
relationship, and then select the relationship type:

a. Clear Use suggested relationship.

b. In the Configuration Items  list, select one or more CIs as a second CI for the relationship.
You can filter the list of Configurations Items  by adding conditions in the Filter  area and 
clicking Run filter. Depending on the relationship type that you will select, the selected CIs 
might become a parent or a child CI in the relationship.
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c. With at least one CI selected in the Configuration Items  list, click the '+' sign in the 
Downstream Relationships  section or the Upstream Relationships  section to create the 
relationship.

▪ Add the relationship to Downstream Relationships  to create a relationship in which the 
base CI is the parent CI and the selected CI is the child CI.

▪ Add the relationship to Upstream Relationships  to create a relationship in which the base 
CI is the child CI and the selected CI is the parent CI.

d. For each newly created relationship in either the Downstream Relationships  or the 
Upstream Relationships  lists, click Please select a relationship  and select a relationship 
type.

▪ The list of available relationship types in the Downstream Relationships  list contains 
parent relationships only, in which the base CI is the parent CI.

▪ The list of available relationship types in the Upstream Relationships  list contains child 
relationships only, in which the base CI is the child CI.

e. Click Save  or Save and Exit.
Only after you enter all the information that is necessary for creating the relationship, these 
buttons light up indicating that there are pending updates that require saving.

Related topics

Suggested class relationships

CI relationships in the CMDB

CI relationship security

Delete a CI relationship

Maintain the integrity of the CMDB by deleting any CI relationships that are no longer relevant or 
needed for a CI. Use the relationship editor to delete CI relationships.

Before you begin
Role required: ITIL or asset

Note: 
Deleting a relationship to a dependent CI can result in identification problems as the 
dependent CI will no longer have a relationship to the CI it depends on.

Procedure

1. Launch the relationship editor:

a. Open the CI form of the CI for which you want to delete a relationship.

b. Locate the Related Items  section near the center of the form.

c. Click the plus (+) icon on the Related items  section.

2. In the Relationship Editor, in the Relationships section, select the relationships that you want to 
delete for the CI.

3. Click the Delete selected relationships  icon.

4. Click Save  or Save and Exit.
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Legacy CI relationship builder

Used to define CI relationships manually, this page is a sophisticated version of the standard 

slushbucket. In the legacy CI relations formatter, click the CI relationship builder icon ( ) to 
display the legacy Define Relationships page.

For information about the latest CI relationship editor, see CI relationship editor.

Select a CI relationship type

The top half of the legacy relationship editor contains a large option box that allows you to select 
which type of relationship you want to manipulate. Click the particular type of relationship you 
are interested in working with.

Filter the list of CI relationships

In the legacy relationship editor, the check boxes along the right hand edge of the select box 
provide a quick way to filter down the list of available relationships.

By default, the system displays a list of all suggested relationships for the 
type of CI you selected. For example, if you selected a Database instance, 
a relationship of "Runs on" makes sense, but a relationship of "Provides 
HVAC for" does not. The default filter is stored in the user preferences 
ci_manage_relationships_filter_hint.cmdb_cici_manage_relationships_filter_hint.sys_user, and 
ci_manage_relationships_filter_hint.sys_user_group.

• Hide CI relationship  -- Hides any relationships between this CI and another CI (e.g. "Receives 
data from").

• Hide user relationships  -- Hides any relationships between this CI and a user (e.g. "Logs 
reviewed by").

• Hide group relationships  -- Hides any relationships between this CI and a group (e.g. 
"Backups done by").

• Show all relationships  -- If you have the appropriate role (out of the box this is itil_admin) you 
will have an additional check box labeled "Show all relationships." If you click that check box, 
the system will let you choose any relationship defined in the system, regardless of where it is 
on the "suggested" list for this type of CI.

Select CI relationship targets

In the legacy relationship editor, users can link or unlink CIs for a relationship type.

As soon as you pick a relationship type, the system will fill in the two select boxes at the bottom 
of the screen with CI's that are appropriate for the relationship you suggested. The left hand 
select box will contain a list of CI's that might reasonably be linked via this relationship, while the 
right hand box contains a list of those CI's which are already linked.

1. Link or unlink items.

Link new items Move that CI from the left hand box to the 
right hand box.

Unlink existing items Move them from the right hand box to the left.

When you make either type of change, a message appears indicating that you have pending 
changes.
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2. Apply or cancel your changes.

Click the Save button. This will save your set of changes, and go 
back to the previous screen (either a CI or the 
BSM map depending on how you got here).

Click the Cancel button. This causes you to exit without saving your 
changes.

Related topics

CI relationships in the CMDB

Relation qualifier

A relation qualifier, which is a CI of the Qualifier [cmdb_ci_qualifier] type, stores important 
information about the CI relationships.

In a relation qualifier, you can annotate arbitrary unique information about the relationship 
between two CIs. You can define multiple qualifiers for a single relationship, resulting in a 
qualifier chain. But, there can be only a single qualifier chain for a specific relationship type 
between two CIs.

For example, for a relationship between a parent CI and a child CI, you can add a 
relation qualifier to note that the relationship was discovered based on traffic (such as 
cmdb_ci_qualifier_trafficbased). This results in having two records in the CI 
Relationship [cmdb_rel_ci] table for the relationship.

• A record that links the parent CI and the new qualifier

• A record that links the new qualifier and the child CI

For this relationship, there is a parent CI and a child CI, and a relation qualifier of type 
cmdb_ci_qualifier_trafficbased.

For information about usage of relation qualifiers in the identification process, see Identification 
rules.

CI relationship security

When applying security to CI relationships, it is important to apply the access controls both to 
the CI Relationship (cmdb_rel_ci) table and to create an operation editCIRelations to the * table 
as well.

If the current instance has defined security for editCIRelations, it will be applied to 
edit_ci_relations automatically in the process of upgrading, and the out-of-date security will be 
removed.

Related topics

CI relationships in the CMDB

Create a CI relation rollup

Create a CI relation rollup

A CI relation rollup allows you to sum, count, max, min, or mean a relationship type. You can 
create CI relation rollups.

Before you begin
Role required: ecmdb_admin
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About this task
CI relation rollup can be useful for tracking and for receiving notifications. For example:

• In a sum roll up, add up fields from multiple CIs and display the result on another CI to which 
they are related. So, if you have four configuration items in a rack that are all consuming power, 
create a CI relation rollup to add all the power usage together and display the result in one field 
on the rack CI form.

• If a certain level of power consumption in a rack is exceeded, send a notification.

• With a rack that has 10 slots, send a notification when 9 slots are filled.

CI relation rollups use the cmdb synch event  business rule on the [cmdb_ci] table. Although 
this business rule is active by default, you must modify the rule slightly before it will run.

Procedure

1. Navigate to All  > Configuration  > Relationships  > CI Relation Rollups.

2. Click New.

3. Complete the form.

CI Relationship Rollup fields

Field Description

CI 
Relationship 
Type

Select a relationship type from the list to use with the rollup. For example, 
Members::Member  of contains the parent descriptor Members  and the child 
descriptor Member of.

Type Select the type of rollup from the drop-down list: COUNT, MAX, MEAN, MIN, or 
SUM.

Parent field The target field on which the operation will be done.

Child field The input to the equation type. The Parent field is affected by the selections in 
the child field.

Rollup class The classes that can use the relationship. For example, you can specify that 
the relationship only applies to racks.

4. To run the cmdb synch event  business rule, navigate to Business Rules.

5. Use the search box to find the [cmdb synch event] table.

6. Click the cmdb synch event  business rule to go to the Business Rule  page.

7. Select the Update, Delete, and Query  check boxes.
Additionally, if you wish CI relation rollups to recalculate when there is a change to a 
relationship, use a similar procedure to select the Active  check box on the cmdb_rel_ci 
synch event  business rule.

Related topics

CI relationships in the CMDB

CMDB schema model

The Configuration Management Database (CMDB) schema model is a series of connected tables 
that contain all the assets and business services controlled by a company and its configurations.

Related ServiceNow®  Store  apps and reference information:
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• CMDB tables descriptions: Descriptions of key CMDB tables in the base system.

• CMDB CI Class Models: A ServiceNow Store  app that adds class models that extend the base 
CMDB class hierarchy. This includes class descriptions, identification rules, identifier entries, 
and dependent relationships if applicable. You can then use the added classes as any other 
CMDB base class.

• Populating the CMDB: Information about the various options for populating the CMDB.

• Discovery patterns : A ServiceNow Store  app that provides a library of Discovery patterns for 
discovering specific devices and applications in the industry.

• Getting started with Service Graph Connectors: ServiceNow Store  apps that provide pre-
defined integrations for importing and integrating common third-party data into CMDB classes. 
Also includes the IntegrationHub ETL  wizard for creating new ETL transform maps.

CMDB tables contain information about computers and devices on the network, software 
contracts and licenses, business services, and so on. The IT desk can use the CMDB to better 
understand their network users' equipment, and the relationships between them. The CMDB can 
also be referenced by other processes within the system.

Applications such as Asset Management  and Contract Management, operate in conjunction 
with the CMDB. Asset Management  and Software Asset Management  link to CMDB all assets, 
hardware, software, assets in stock, as well as records for manufacturers and vendors. The 
Contract Management application contains information about contracts, including leases, 
service contracts, purchase orders, warranties, and software licenses. The Configuration 
Management Database (CMDB)  application has a focus on operation.

For more background information about the CMDB, see the ServiceNow Community  post) at 
CMDB 101- What is a configuration management database and why do you need one? .

Key CMDB tables

Key tables in the configuration management database (CMDB):

• The Base Configuration Item [cmdb] table, which is the core CMDB table for non IT CIs 
(descending classes are non IT CIs).

• The core Configuration Item [cmdb_ci] table, which stores the basic attributes of all the CIs. 
The admin, itil, or asset user role is required to access this table (descending classes are IT 
CIs).

• The CI Relationship [cmdb_rel_ci] table, which defines all relationships between CIs.

The Configuration Item table is extended to other tables, such as Database [cmdb_ci_database] 
and Computer [cmdb_ci_computer]. The Computer table is extended to the Server 
[cmdb_ci_server] table, which is extended to the UNIX  Server [cmdb_ci_unix_server] table, and 
so on.

Note: 
The Base Configuration Item [cmdb] table uses the table per partition extension model, 
which has different behaviors for replicating and deriving information than other extended 
tables. See Table extension and classes .

You can use the schema map to view more details of tables and their relationships:

1. Navigate to System Definition  > Tables & Columns.

2. Select a table and click Schema Map.
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Schema Map

Note: 
CIs not extended from the Configuration Item [cmdb_ci] table, are not displayed in 
Dependency Views maps and in CI relation formatters.

CI attributes

Attributes apply to all the CIs in a classification. To change attribute values for a CI, edit the 
appropriate CI. To add a unique attribute to a class, extend the class table and create a new 
classification for that CI.

The position of a CI in a classification hierarchy is determined by the attributes it shares with 
the CIs below it. Each time a CI has a single different attribute from its parent, the classification 
hierarchy branches.

For example, servers have different attributes from computers, which include workstations 
and laptops. Linux  servers and UNIX  servers have different attributes from the parent server 
classification and from each other, so they occupy separate branches in the hierarchy.

CMDB tables descriptions

List of tables in the CMDB in a base system  with table name, label, and a description of the type 
of information that is stored in the table.

You can extend tables in a base system by installing a CMDB CI Class Models store app 
which adds class models that support specific technologies. These extensions include class 
definitions, identification rules, identifier entries, and dependent relationships if applicable. The 
CMDB CI Class Models store app can also modify the label of a base table. For more information, 
see CMDB CI Class Models store app.
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Table name Display name (label) Table description

cmdb_ci Configuration Item Base configuration item table.

cmdb_ci_acc Accessory Accessories for phones, 
computers, and so on.

cmdb_ci_ad_controller Active Directory 
Domain Controller

Microsoft Active Directory 
domain controller.

cmdb_ci_ad_domain AD Domain Microsoft Active Directory 
domain.

cmdb_ci_aix_server AIX Server Server running the AIX 
operating system.

cmdb_ci_alias Alias Pseudonym for data locations, 
virtual email addresses, 
pointers, and so on.

cmdb_ci_apache_web_server Apache Web Server Server hosting Apache web 
server software.

cmdb_ci_appl Application Application, which is a 
collection of files and data that 
deliver a service and manage 
business processes.

cmdb_ci_appl_now_app ServiceNow 
Application CIs that Event Management 

generates for various 
components such as Impact 
calculator, which are used 
to bind alerts that are later 
shown in maps. Used 
internally by self-health when 
monitoring internal health 
checks for key components 
such as connector instance 
status and MID Server status.

Parent class for all 
ServiceNow  applications.

cmdb_ci_application_cluster Application Cluster Logical group of servers with 
clustering software installed 
on each of the servers in the 
group so that the group acts 
like a single system.

cmdb_ci_application_server_resource Application Server 
Resource

Parent class for application 
servers such as Coldfusion 
application server.

cmdb_ci_app_server Application Server A base table for logical CIs, 
which indicate the primary 
function of a physical or virtual 
server such as a Tomcat 
server or a WebSphere server.
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Table name Display name (label) Table description

cmdb_ci_app_server_composer Composer Server hosting IBM 
WebSphere Multichannel 
Bank Transformation Toolkit.

cmdb_ci_app_server_datapower Data Power Server hosting IBM DataPower 
Gateway Secure software.

cmdb_ci_app_server_domino Domino Server hosting IBM Domino 
software.

cmdb_ci_app_server_hp_ucmdb HP uCMDB Server hosting HP uCMDB 
software.

cmdb_ci_app_server_java JavaServer Server hosting Java 
application.

cmdb_ci_app_server_jb_module delivery Controler Server hosting inner 
module of JBoss application 
(deployed application).

cmdb_ci_app_server_jboss JBoss Server hosting JBoss 
Application Server (JBoss 
AS), which is a cross-platform 
Java application server, open-
source developed by JBoss 
software company.

cmdb_ci_app_server_jrun Jrun Server hosting JRun 
application.

cmdb_ci_app_server_jrun_war Jrun WAR Server hosting the inner 
module of JRun application 
(deployed application).

cmdb_ci_app_server_ora_ess Oracle Essbase 
Server

Server hosting Oracle 
Essbase software.

cmdb_ci_app_server_ora_ias Oracle iAS Server hosting Oracle Internet 
Application Server.

cmdb_ci_app_server_ora_ias_m Oracle iAS Web 
module

Server hosting the inner 
module of Oracle iAS 
application (deployed 
application).

cmdb_ci_app_server_remedy Remedy HSServer Server hosting Remedy 
HSSServer application.

cmdb_ci_app_server_tomcat Tomcat Server hosting Apache 
Tomcat software.

cmdb_ci_app_server_tomcat_war Tomcat WAR Server hosting inner module 
of Apache Tomcat application 
(deployed application).

cmdb_ci_app_server_vendavo Vendavo Application 
Server

Server hosting Vendavo 
Application Server software.

cmdb_ci_app_server_weblogic BEA Weblogic Server hosting Oracle 
WebLogic Server.
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Table name Display name (label) Table description

cmdb_ci_app_server_webseal Webseal Server hosting IBM Tivoli 
Access Manager solution.

cmdb_ci_app_server_websphere IBM Websphere Server hosting IBM 
WebSphere software.

cmdb_ci_app_server_wl_module WeblogicModule Server hosting inner module 
of WebLogic.

cmdb_ci_app_server_ws_ear Websphere EAR Server hosting inner module 
of IBM WebSphere software.

cmdb_ci_app_server_ws_odr Websphere ODR LB Server hosting WebSphere 
ODR LB application.

cmdb_ci_appl_active_directory Active Directory 
Service

Inner software module of AD 
Domain application.

cmdb_ci_appl_biztalk BizTalk Microsoft BizTalk Server 
software.

cmdb_ci_appl_biztalk_orch BizTalk 
Orchestration

Inner module of Microsoft 
Biztalk Server software.

cmdb_ci_appl_ca CA Enterprise 
Communicator

CA Enterprise Communicator 
software.

cmdb_ci_appl_ca_dir_server CA eTrust Directory 
Server

CA eTrust Directory Server 
software.

cmdb_ci_appl_ca_ent_man CA Introscope 
Enterprise Manager

CA introscope Enterprise 
Manager software.

cmdb_ci_appl_ca_id_man CA Identity Manager 
Provisioning Server

CA Identity Manager Server 
software.

cmdb_ci_appl_cisco_call_man Cisco CallManager Cisco CallManager (Cisco 
Unified Communications 
Manager) software.

cmdb_ci_appl_cisco_fibre Cisco Fibre 
InterConnect

Cisco Fibre InterConnect 
software.

cmdb_ci_appl_citrix_app Citrix Application 
Icon

Inner module of Citrix 
software.

cmdb_ci_appl_citrix_collector Citrix Collector Citrix Collector software.

cmdb_ci_appl_citrix_xenapp Citrix XenAPP or 
Presentation Server

Citrix XenApp software.

cmdb_ci_appl_connectit Connect-It Service Connect-It software.

cmdb_ci_appl_controlm Control-M Control-M software.

cmdb_ci_appl_delivery_controler Delivery Controler Application delivery controller 
software.

cmdb_ci_appl_doc_brava_proc Documentum Brava 
Job Processor

Brava (EMC Documentum) job 
processor software.

cmdb_ci_appl_doc_brava_server Documentum Brava 
License Server

Brava (EMC Documentum) 
License Server software.
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Table name Display name (label) Table description

cmdb_ci_appl_doc_docbase Documentum 
DocBase

Documentum Docbase 
software.

cmdb_ci_appl_doc_docbroker Documentum Broker Documentum Docbase broker 
software.

cmdb_ci_appl_dot_net .NET Application Microsoft .NET application 
software.

cmdb_ci_appl_fastsearch Fast Search Microsoft FAST Search 
software (for the SharePoint 
collaboration platform).

cmdb_ci_appl_generic Generic Application Generic application, which is 
identified by the system when 
there is an endpoint with an 
open port in listen mode and 
there is no pattern for it.

cmdb_ci_appl_glassfish GlassFish Oracle GlassFish Server 
software.

cmdb_ci_appl_glassfish_war GlassFish WAR Inner module of GlassFish 
application (deployed 
application).

cmdb_ci_appl_groundwork Groundwork Groundwork (open source) 
monitoring software.

cmdb_ci_appl_hp_index HP SM Index Server HP Service Manager Index 
Server software.

cmdb_ci_appl_hp_operations HP Operations 
Manager

HP Operations Manager 
software.

cmdb_ci_appl_hp_qc HP Quality Center HP Quality Center software.

cmdb_ci_appl_hp_service HP Service Manager HP Service Manager software.

cmdb_ci_appl_hp_sm_kb HP SM 
KnowledgeBase

HP Service Manager 
KnowledgeBase software.

cmdb_ci_appl_ibm_cics IBM CICS IBM CICS Transaction Server 
software.

cmdb_ci_appl_ibm_ctg IBM CTG IBM CICS Transaction 
Gateway software.

cmdb_ci_appl_ibm_wmb IBM WebSphere 
Message Broker

IBM WebSphere Message 
Broker software.

cmdb_ci_appl_ibm_wmb_listener IBM WMB Http 
Listener

IBM WebSphere HTTP 
Listener software.

cmdb_ci_appl_ibm_wmq IBM WebSphere MQ IBM Websphere MQ software.

cmdb_ci_appl_ibm_wmq_queue IBM WebSphere MQ 
Queue

Inner module of IBM 
WebSphere MQ software.

cmdb_ci_appl_itam ITAM Asset Center HP Asset Center software.

cmdb_ci_appl_mongo_config_serv Mongo Config 
Server

Mongo Configuration Server 
software.
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Table name Display name (label) Table description

cmdb_ci_appl_mongos Mongos Server MongoDB server software.

cmdb_ci_appl_ms_dynamic_crm Dynamic CRM 
Component

Microsoft Dynamic CRM 
software.

cmdb_ci_appl_msmq MSMQ Microsoft Message Queuing 
(MSMQ) software.

cmdb_ci_appl_ora_conc Oracle Concurrent 
Server

Oracle Concurrent Server 
software.

cmdb_ci_appl_ora_disc Oracle Discoverer 
Engine

Oracle Discoverer software.

cmdb_ci_appl_ora_disc_ui Oracle Discoverer UI Oracle Discoverer UI module 
software.

cmdb_ci_appl_ora_ebs Oracle ESB Oracle Enterprise Service Bus 
software.

cmdb_ci_appl_ora_forms Oracle Forms 
Engine

Oracle Forms software.

cmdb_ci_appl_ora_forms_ui Oracle Forms UI Oracle Forms UI software.

cmdb_ci_appl_ora_fs Oracle Fulfillment 
Server

Oracle Fulfillment Server 
software.

cmdb_ci_appl_ora_http Oracle HTTP Server Oracle HTTP Server software 
(web tier of Oracle Fusion 
middleware).

cmdb_ci_appl_ora_jms_queue Oracle Weblogic 
JMS Queue

Oracle WebLogic JMS 
software.

cmdb_ci_appl_ora_metric_client Oracle Metric Client Oracle Metric client software.

cmdb_ci_appl_ora_metric_svr Oracle Metric Server Oracle Metric server software.

cmdb_ci_appl_ora_notif_svr Oracle Notification 
Server

Oracle Notification Server 
(ONS) software.

cmdb_ci_appl_ora_oacore Oracle OACORE 
Server

Oracle OACORE server 
software.

cmdb_ci_appl_ora_oafm Oracle OAFM Server Oracle OAFM server software.

cmdb_ci_appl_ora_pm Oracle Process 
Manager

Oracle BPEL Process Manager 
server software.

cmdb_ci_appl_ora_queue Advanced Queue 
Queue

Oracle Advanced Queuing 
software.

cmdb_ci_appl_ora_report Oracle Report 
Server

The Oracle Report Server 
software.

cmdb_ci_appl_ora_tns Oracle App TNS 
Service

Oracle Application Express 
(TNS) listener software.

cmdb_ci_appl_ora_tnslsnr Oracle TNS Listener 
Engine

Oracle Application Express 
software.

cmdb_ci_appl_peoplesoft Peoplesoft 
Application Server

Peoplesoft Application Server 
software.
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Table name Display name (label) Table description

cmdb_ci_appl_rabbitmq RabbitMQ RabbitMQ (open source) 
software.

cmdb_ci_appl_rabbitmq_cluster RabbitMQ Cluster RabbitMQ Cluster (open 
source) software.

cmdb_ci_appl_sap_ascs SAP ASCS 
Application

SAP ASCS software.

cmdb_ci_appl_sap_bo SAP Business 
Objects CMS Server

SAP Business Objects CMS 
server software.

cmdb_ci_appl_sap_bo_scheduler SAP BO 
BOXIScheduleRouter

SAP BO BOXIScheduleRouter 
software.

cmdb_ci_appl_sap_bus_obj SAP Business 
Objects

SAP bushiness Object 
application.

cmdb_ci_appl_sap_ci SAP CI Application The SAP Central Instance 
software.

cmdb_ci_appl_sap_di SAP DI Application Oracle Development 
Infrastructure (DI) software.

cmdb_ci_appl_sap_ers SAP ERS Application Oracle Evaluated Receipt 
Settlement (ERS) software.

cmdb_ci_appl_sap_hana_db SAP Hana Db SAP HANA software.

cmdb_ci_appl_sap_jc SAP JC Application SAP JC (java application) 
software.

cmdb_ci_appl_sap_scs SAP SCS 
Application

SAP SCS (central services) 
software.

cmdb_ci_appl_sendmail Sendmail Sendmail (open source) 
software.

cmdb_ci_appl_sharepoint SharePoint Microsoft SharePoint software.

cmdb_ci_appl_sp_service SharePoint Service Microsoft Windows 
Sharepoint Services (WSS) 
software.

cmdb_ci_appl_tibco_hawk Tibco Hawk TIBCO Hawk software.

cmdb_ci_appl_tibco_matrix ActiveMatrix 
Business Works

TIBCO ActiveMatrix 
BusinessWorks software.

cmdb_ci_appl_tibco_matrix_proc ActiveMatrix 
Business Works 
Process

TIBCO ActiveMatrix 
BusinessWorks Process 
software.

cmdb_ci_appl_tibco_message Tibco Enterprise 
Message Service

TIBCO Enterprise Message 
Service software.

cmdb_ci_appl_tibco_queue EMS Queue Tibco EMS (Enterprise 
Message Service) Queues 
software.

cmdb_ci_appl_tuxedo Tuxedo Tuxedo software (middleware 
transactions for Unix, 
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Extended for Distributed 
Operations).

cmdb_ci_appl_tuxedo_portal Tuxedo Portal Tuxedo portal software.

cmdb_ci_appl_vign_content_svr Vignette Content 
Management Server

Vignette (Open Text Corp) 
Content Management Server 
software.

cmdb_ci_appl_vignette_search Vignette Search 
Starter

Vignette (Open Text Corp) 
Search Server software.

cmdb_ci_appl_vignette_server Vignette Server Vignette (Open Text Corp) 
Server software.

cmdb_ci_appl_weblogic_jms Weblogic JMS 
Server

WebLogic JMS software.

cmdb_ci_appl_weblogic_lb Weblogic LB WebLogic Server load 
balancer software.

cmdb_ci_appl_weblogicmodule Weblogic Module 
Server

WebLogic Server software.

cmdb_ci_appl_websphere_portal Websphere Portal WebSphere Portal software.

cmdb_ci_appl_wmb WMB Flow WebSphere Message Broker 
software.

cmdb_ci_application_cluster Application Cluster Logical cluster of application-
tier servers.

cmdb_ci_application_software Application Software
Computer program designed 
to perform a group of 
coordinated functions, tasks, 
or activities for the benefit of 
the user.

An extension of the Software 
table, providing installed 
software information (not a 
running process).

cmdb_ci_ats_power_eq Automatic Transfer 
Switch

Electrical power switch that 
switches a load between two 
sources.

cmdb_ci_availability_set Availability Set Logical grouping of virtual 
machines running on 
Microsoft Azure platform.

cmdb_ci_batch_job Batch Job A computer program or set of 
programs processed in batch 
mode.

cmdb_ci_aws_datacenter AWS datacenter Logical representation of 
an Amazon Web Services 
datacenter.

cmdb_ci_azure_datacenter Azure datacener Logical representation of a 
Microsoft Azure datacenter.
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cmdb_ci_base_rpa_process Base Bot Process Business reason, process 
type, and schedule.

cmdb_ci_base_rpa_robot Base Robot Machine where robot is 
running, state, and type.

cmdb_ci_business_app Business 
Application

All business applications.

cmdb_ci_business_process Business Process A process that is owned 
and carried out by the 
business and contributes 
to the delivery of a product 
or business service to a 
business customer.

cmdb_ci_chassis_server Server Chassis A metal structure that is 
used to house or physically 
assemble servers in various 
different form factors.

cmdb_ci_cim_profile CIM Profiles CIM Profiles (UML).

cmdb_ci_cim_server CIM Server Server hosting CIM profiles.

cmdb_ci_circuit Circuit Electrical circuits information.

cmdb_ci_cloud_database Cloud Database Database which runs on a 
cloud computing platform.

cmdb_ci_cloud_ip_address Cloud IP Address Web server which runs on a 
cloud computing platform.

cmdb_ci_cluster Cluster Logical group of computing 
resources bound together by 
software in order to function 
as one logical computing 
resource.

cmdb_ci_cluster_node Cluster Node Single computing resource 
which is logically/
operationally bound into a 
cluster.

cmdb_ci_cluster_resource Cluster Resource System object that is a 
set or grouping of cluster 
resources that are used to 
manage events that occur in a 
clustered environment.

cmdb_ci_cluster_vip Cluster Virtual IP Cluster VIP information.

cmdb_ci_cmp_price_product_base Cloud Product Price 
Base Used to calculate the 

approximate monthly cost of 
running a stack built on Virtual 
Servers in cloud environment:

• Cloud Price Base: Common 
price base to store pricing 
info of all the resources of 
all the supported clouds.
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• Cloud Price Product Base: 
Base table to store the 
common attributes of all the 
pricing resources.

• VM Instance Price: Specific 
table which extends the 
Cloud Price Product base 
to store the VM specific 
product info of all the 
supported clouds.

Parent class for cloud product 
prices such as VM instance 
price.

cmdb_ci_cmp_resource Cloud Resource Generic cloud resources.

cmdb_ci_comm Communication 
Device

Communication devices 
information. A choice list 
containing devices such as 
cellphone, phone, conference 
phone, and Wi-Fi.

cmdb_ci_computer Computer An extension of the Hardware 
table, capturing computer 
properties.

cmdb_ci_computer_room Computer Room Logical representation of a 
computer room.

cmdb_ci_config_automation_server Management Server
Dev Ops tools such as Chef 
and Puppet, that are used to 
manage server configurations.

Parent class for application 
management servers such as 
Puppet Master.

cmdb_ci_config_file Configuration file Configuration files which 
establish the parameters 
and initial settings for some 
computer programs.

cmdb_ci_crac Computer Room AC Air conditioning units used to 
cool data centers.

cmdb_ci_csu_dsu_network CSU/DSU Digital-interface device 
used to connect networking 
equipment to a digital circuit.

cmdb_ci_database Database Organized collection of data 
such as the set of files where 
data is stored, the reason for 
a database, and the metadata 
about the data.
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cmdb_ci_datacenter Data Center Facility used to house 
computer systems and 
associated components, 
such as telecommunications 
and storage systems. 
It generally includes 
redundant or backup power 
supplies, redundant data 
communications connections, 
environmental controls (such 
as air conditioning and fire 
suppression), and various 
security devices.

cmdb_ci_datapower_server Data Power Hosting 
Server

Server running IBM 
DataPower Gateway software.

cmdb_ci_datastore Datastore
Datastores are like file 
systems, abstracting the 
physical storage and 
providing a model for 
storing files. The child class 
represents the VMware 
specific Datastore.

Parent class for VMWare 
datastore object types such 
as vCenter Datastores.

cmdb_ci_db_catalog Database Catalog Metadata which defines 
database objects such as 
base tables, views (virtual 
tables), synonyms, value 
ranges, indexes, users, and 
user groups, for a specific 
database instance.

cmdb_ci_db_db2_catalog DB2 Catalog Database catalog for DB2 
database.

cmdb_ci_db_db2_instance DB2 Instance Instance of a DB2 database.

cmdb_ci_db_hbase_instance HBase Instance Instance of an HBase 
database.

cmdb_ci_db_instance Database Instance Software and memory used 
to manipulate data in a 
database.

cmdb_ci_db_mongodb_instance MongoDB Instance Instance of a MongoDB 
database.

cmdb_ci_db_mssql_analysis SQL Server Analysis 
Services

Microsoft SQL Server Analysis 
Services software.

cmdb_ci_db_mssql_catalog MSFT SQL Catalog Database catalog for a 
specific instance of a 
Microsoft SQL database.
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cmdb_ci_db_mssql_int_job SQL Server 
Integration Services 
Job

Scheduled job to run a SQL 
Server Integration Service 
package.

cmdb_ci_db_mssql_integration SQL Server 
Integration Services

MSQL Server Integration 
Services software.

cmdb_ci_db_mssql_reporting SQL Server 
Reporting Services

SQL Server software used 
for server-based reporting 
generation.

cmdb_ci_db_mysql_catalog MySQL Catalog Database catalog for a 
specific instance of a MySQL 
database.

cmdb_ci_db_mysql_clustermgnode MySQLClusterMGMNodeMySQL primary administrative 
interface to a running cluster.

cmdb_ci_db_mysql_clusternode MySQLClusterDataNodeSummary table used in the 
[ndbd] or [ndbd default] 
sections of a config.ini file for 
configuring MySQL Cluster 
data nodes.

cmdb_ci_db_mysql_instance MySQL Instance Instance of a MySQL 
database.

cmdb_ci_db_ora_catalog Oracle Catalog Database catalog for a 
specific instance of an Oracle 
database.

cmdb_ci_db_ora_instance Oracle Instance Instance of an Oracle 
database.

cmdb_ci_db_ora_listener Oracle Database 
Listener

Process that runs on an 
Oracle Database Server.

cmdb_ci_db_postgresql_instance PostgreSQL 
Instance

Instance of a PostgreSQL 
database.

cmdb_ci_db_syb_catalog Sybase Catalog Database catalog for a 
specific instance of a Sybase 
database.

cmdb_ci_db_syb_instance Sybase Instance Instance of a Sybase 
database.

cmdb_ci_desktop_software Desktop Software Software used on desktops 
and laptops.

cmdb_ci_dir_policy_server Policy Server Policy server, which provides 
a security component of 
a policy-based network 
that provides authorization 
services and facilitates 
tracking and control of files.

cmdb_ci_dir_site_minder_server Site Minder Server running SiteMinder 
software.

cmdb_ci_directory_ad_forest AD Forest Active Directory forest.
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cmdb_ci_directory_ha HA Proxy HAProxy software.

cmdb_ci_directory_iifp IIFP Identity Identification Feature 
Pack (Active Directory) 
software.

cmdb_ci_directory_ldap LDAP DB LDAP (Lightweight Directory 
Access Protocol) database 
software.

cmdb_ci_directory_server Directory Server Server running LDAP software.

cmdb_ci_disk Disk General category of data 
storage mechanisms.

cmdb_ci_disk_partition Disk Partition Sections of a disk separated 
so that information in each 
section can be managed 
separately.

cmdb_ci_display_hardware Display Hardware Hardware used to display 
information in visual form.

cmdb_ci_dns_alias DNS Alias Synonym for the host used to 
resolve DNS addresses.

cmdb_ci_dns_name DNS Name Primary DNS names.

cmdb_ci_docker Docker Container Docker containers (a runtime 
instance of a docker image).

cmdb_ci_docker_engine Docker Engine Docker software for running 
and managing Docker 
containers.

cmdb_ci_docker_image Docker Image Docker images. Ordered 
collection of root filesystem 
changes and the 
corresponding execution 
parameters for use within a 
container runtime.

cmdb_ci_docker_image_tag Docker Image Tag Docker tag, which is a label 
applied to a Docker image in a 
repository.

cmdb_ci_docker_local_image Docker Local Image Locally managed Docker 
image.

cmdb_ci_drs_vm_config DRS VM Config Distributed Resource 
Scheduler (DRS) behavior for 
the VMs in the vCenter that 
override the cluster behavior.

cmdb_ci_ec2_instance EC2 Virtual Machine 
Instance

Virtual machine running in 
the Amazon Elastic Compute 
Cloud (EC2) platform.

cmdb_ci_email_server Email Server Server running email software.
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cmdb_ci_email_server_jes JES Server running JES software 
(multi-featured hybrid MTA/
MDA server).

cmdb_ci_endpoint Endpoint Endpoint, which represents 
the entry point to a service, a 
process, or a queue or topic 
destination in service-oriented 
architecture.

cmdb_ci_environment Environment Logical grouping of hardware 
and software used to develop, 
test, and deliver computing 
services. For example: 
development, test, quality 
assurance, and production.

cmdb_ci_esx_resource_pool ESX Resource Pool VMware set of physical 
resources.

cmdb_ci_esx_server ESX Server Physical ESX server running 
the VMware ESXi operating 
system.

cmdb_ci_exchange_backend ExchangeBackEndServerServer running Exchange 
software.

cmdb_ci_exchange_cas Exchange Client 
Access Server

Server running Exchange 
software providing client 
access services.

cmdb_ci_exchange_edge_transport_serverExchange Edge 
Transport Server

Server running Exchange 
Edge Transport software.

cmdb_ci_exchange_frontend ExchangeFrontEndServerServer running Exchange 
software.

cmdb_ci_exchange_hub ExchangeHub Server running Exchange Hub 
software.

cmdb_ci_exchange_hub_transport_serverExchange Hub 
Transport Server

Server running Exchange Hub 
software providing transport 
services.

cmdb_ci_exchange_mailbox Exchange MailBox Exchange email account.

cmdb_ci_exchange_mailbox_server Exchange Mailbox 
Server

Server running Exchange 
software providing client 
access services.

cmdb_ci_exchange_service_component Exchange Service 
Component

Exchange Service Component 
software.

cmdb_ci_facility_hardware Facility Hardware Base class for hardware used 
to facilities services such as 
electric, water, sewer, air, and 
security.

cmdb_ci_fc_disk Fibre Channel Disk Base table for fibre channel 
disk.
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cmdb_ci_fc_export Fibre Channel 
Export

Storage volume exported 
by a storage server via Fibre 
Channel protocol.

cmdb_ci_fc_port Fibre Channel Port Fibre Channel port on a 
storage server, FC switch, or 
on a host's HBA.

cmdb_ci_fddi_network FDDI Cards Fiber Distributed Data 
Interface cards.

cmdb_ci_file_system File System File system information for a 
server, capturing details such 
as mount point, capacity, and 
type of file system.

cmdb_ci_file_system_nfs NFS File system Extension of File System, 
which provides NFS file 
system information.

cmdb_ci_file_system_smb SMB File system Extension of File System, 
which provides SMB file 
system information.

cmdb_ci_firewall_network Firewall Hardware Firewall hardware.

cmdb_ci_ftp_server FTP Server Server providing FTP services.

cmdb_ci_fuel_tank Fuel Tank Fuel tank.

cmdb_ci_generator_power_eq Power Generator Power generator.

cmdb_ci_group Group Logical group of CIs.

cmdb_ci_hardware Hardware Base class for hardware.

cmdb_ci_host_cluster Host Cluster
Cloud agnostic way of 
representing a group of hosts 
as a cluster. The child class 
represents VMware vCenter 
Cluster specific details.

Parent class for VMWare host 
cluster object types such as 
vCenter Clusters.

cmdb_ci_hpux_server HPUX Server Server running HPUX 
software.

cmdb_ci_hub_network Hub Hardware Physical network hub.

cmdb_ci_hvac HVAC Equipment Heating, ventilation, and air 
conditioning equipment.

cmdb_ci_hyper_v_cluster Hyper-V Cluster Cluster of the Hyper-V servers.

cmdb_ci_hyper_v_instance Hyper-V Virtual 
Machine Instance

Hyper-V virtual machine 
instance. This table 
extends the generic 
Virtual Machine Instance 
[cmdb_ci_vm_instance] table.
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cmdb_ci_hyper_v_network Hyper-V Virtual 
Network

Hyper-V virtual network.

cmdb_ci_hyper_v_object Hyper-V Object Base class for all Hyper-V 
objects.

cmdb_ci_hyper_v_resource_pool Hyper-V Resource 
Pool

Hyper-V resource pool.

cmdb_ci_hyper_v_rpool_comp Hyper-V Resource 
Pool Component

Resource pool component 
belonging to resource pool.

cmdb_ci_hyper_v_server Hyper-V Server Server running Hyper-V 
software.

cmdb_ci_ids_network Intrusion Detection 
System

Security intrusion detection 
systems.

cmdb_ci_iisdirectory IIS Virtual Directory Virtual Directory in IIS 
Manager.

cmdb_ci_imaging_hardware Imaging Hardware Hardware used to create 
electronic/physical images.

cmdb_ci_inetinfo Inetinfo service Inetinfo service of IIS 
application.

cmdb_ci_inf_software Infrastructure 
Software

Base class for enterprise 
software or programs 
specifically designed to 
help business organizations 
perform basic tasks such as 
workforce support, business 
transactions and internal 
services, and processes.

cmdb_ci_information_object Information Object
Types of information that a 
business application or any 
other entity handles.

For example: 'Employee Salary 
Data', Employee Personal 
Data', and 'Sales Data'.

cmdb_ci_installed_bundles Installed Bundles Extension of the 
Virtual Machine Object 
[cmdb_ci_vm_object] table, 
which represents bundles of 
installed software.

cmdb_ci_infra_service Infrastructure 
Service

IT services which support 
providing computing 
infrastructure.

cmdb_ci_infra_service_ldap LDAP Service Running LDAP service.

cmdb_ci_ip_address IP Address IP address.

cmdb_ci_ip_device IP Device Base class for devices with an 
IP address.
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cmdb_ci_ip_firewall IP Firewall Firewall hardware.

cmdb_ci_ip_network IP Network IP network information 
capturing details such 
as subnet, router, and 
router_interface_type.

cmdb_ci_ip_phone IP Phone IP-enabled (VOIP) phone.

cmdb_ci_ip_router IP Router Specialization of the Network 
Gear [cmdb_ci_netgear] table.

cmdb_ci_ip_server IP Server Server hardware.

cmdb_ci_ip_service IP Service Instance Base table for IP services 
running on a server such Unix 
daemon or Windows service.

cmdb_ci_ip_switch IP Switch Specialization of the Network 
Gear [cmdb_ci_netgear] table.

cmdb_ci_iplanet_web_server Iplanet Web Server Server running Oracle iPlanet 
Web Server (OiWS) software.

cmdb_ci_isam_server ISAM Server Server running ISAM software.

cmdb_ci_iscsi_disk iSCSI Disk Host mount of an iSCSI disk.

cmdb_ci_iscsi_export iSCSI Export Storage volume exported by a 
storage server via iSCSI.

cmdb_ci_kubernetes_component Kubernetes 
Component Kubernetes cluster, ingress, 

namespace, node, pod, 
service, volume, and 
workload. Also represents 
open shift build conf, 
deployment conf, docker 
images repository, group, 
images, images, stream, 
project, route, and user.

Parent class for Kubernetes 
components such as Pods 
and Clusters.

cmdb_ci_kvm KVM Hypervisor that manages 
kernel-based virtual machines 
(KVMs).

cmdb_ci_kvm_network Network KVM Virtual network.

cmdb_ci_kvm_object KVM Object Base object for all KVM 
objects.

cmdb_ci_kvm_storage_pool Storage Pool KVM storage pool.

cmdb_ci_kvm_storage_volume Storage Volume KVM storage volume.

cmdb_ci_kvm_vm_instance KVM Virtual Machine 
Instance

Virtual machine instance 
running on a KVM hypervisor.
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cmdb_ci_lb Load Balancer Server functioning as a load 
balancer.

cmdb_ci_lb_a10 A10 Load Balancer Server functioning as an A10 
load balancer.

cmdb_ci_lb_ace ACE Server functioning as an ACE 
load balancer.

cmdb_ci_lb_alteon Alteon Server functioning as an 
Alteon load balancer.

cmdb_ci_lb_appl Load Balancer 
Application

Application that provides load 
balancing functionality.

cmdb_ci_lb_backend_server LB Backend Server Server functioning as a 
backend load balancer.

cmdb_ci_lb_bigip F5 BIG-IP Server functioning as an F5 
BIG-IP load balancer.

cmdb_ci_lb_cisco_csm Cisco CSM Server functioning as a Cisco 
CSM load balancer.

cmdb_ci_lb_cisco_css Cisco CSS Server functioning as a Cisco 
CSS load balancer.

cmdb_ci_lb_f5_gtm F5 BigIP GTM Server functioning as an F5 
BigIP GTM load balancer.

cmdb_ci_lb_f5_ltm F5 BigIP LTM A server functioning as an F5 
BigIP LTM load balancer.

cmdb_ci_lb_haproxy HAProxy Load 
Balancer

Server functioning as an HA 
Proxy load balancer.

cmdb_ci_lb_isa ISA Server Server functioning as an ISA 
load balancer.

cmdb_ci_lb_modjk Modjk Load 
Balancer

Server functioning as a Cisco 
CSM load balancer.

cmdb_ci_lb_modproxy ModProxy Load 
Balancer

Server functioning as a 
ModProxy load balancer.

cmdb_ci_lb_netscaler Citrix Netscaler Server functioning as a Citrix 
Netscaler load balancer.

cmdb_ci_lb_network Network Load 
Balancer

Server performing network 
load balancing.

cmdb_ci_lb_nginx Nginx Load Balancer Server functioning as an Nginx 
load balancer.

cmdb_ci_lb_pool Load Balancer Pool Collection of host-to-port 
mappings to be balanced.

cmdb_ci_lb_pool_member Load Balancer Pool 
Member

Host-to-port mapping of a 
request to be balanced.

cmdb_ci_lb_radware Radware Load 
Balancer

Server functioning as a 
Radware load balancer.
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cmdb_ci_lb_service Load Balancer 
Service

Virtual service that the device 
balances by forwarding 
requests to members within a 
pool.

cmdb_ci_lb_template Load Balancer 
Template

Load balancer template which 
contains load balancer-related 
configuration settings for a 
specific type of network traffic.

cmdb_ci_lif LIF Logical interface.

cmdb_ci_lb_vlan Load Balancer VLAN Virtual LAN segment.

cmdb_ci_linux_server Linux Server Server running Linux software.

cmdb_ci_logical_datacenter Logical Datacenter VMware vCenter logical 
datacenter.

cmdb_ci_lpar Logical Partition Logical partition, commonly 
called an LPAR, is a subset 
of a computer's hardware 
resources, virtualized as a 
separate computer.

cmdb_ci_lvm_pool LVM Pool Linux Volume Manager 
storage pool.

cmdb_ci_lvm_pool_member LVM Pool Member Linux Volume Manager 
storage pool member.

cmdb_ci_mainframe IBM Mainframe IBM large-scale computer 
system.

cmdb_ci_mainframe_hardware Mainframe Hardware The hardware components 
of a large-scale computer 
system.

cmdb_ci_mainframe_lpar IBM Mainframe 
LPAR

Logical partition, which 
is commonly called an 
LPAR, and is a subset of 
a mainframes computer's 
hardware resources, 
virtualized as a separate 
computer.

cmdb_ci_memory_module Memory Module Circuit board that provides for 
memory storage.

cmdb_ci_mfp_printer Multi-function 
Printer

Physical device with scan, 
copy, and fax capabilities.

cmdb_ci_microsoft_iis_web_server Microsoft iis Web 
Server

Server running Internet 
Information Services (IIS) for 
Windows software.

cmdb_ci_modem_network Modem Hardware Physical modem hardware.

cmdb_ci_mpio_pool Multipath IO Pool Multipath IO pool, 
representing multiple 
redundant paths to storage.
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cmdb_ci_mpio_pool_group Multipath IO Pool 
Group

Group of multipath IO pools.

cmdb_ci_mpio_pool_path Multipath IO Pool 
Path

Single path in an MPIO pool.

cmdb_ci_msd Mass Storage 
Device

Physical storage device.

cmdb_ci_nas_file_system NAS File System Extension of the File System 
[cmdb_ci_file_system] 
table, representing network 
attached storage.

cmdb_ci_nat_gateway NAT Gateway Functionality for NAT gateway.

cmdb_ci_netapp_cdot NetApp CDOT Functionality of NetApp 
Clustered Data OnTap 
operating system

cmdb_ci_netapp_datacenter NetApp Datacenter NetApp logical datacenter.

cmdb_ci_netapp_svm NetApp SVM NetApp Storage Virtual 
Machine.

cmdb_ci_netapp_volume NetApp Volume NetApp FlexVol storage 
volume.

cmdb_ci_net_app_server Network Appliance 
Hardware

Server configured to perform 
as a networking appliance.

cmdb_ci_netgear Network Gear Extension of the Hardware 
table, that captures network 
equipment such as router, 
switch, hub, gateway, and 
bridge.

cmdb_ci_netware_server Netware Server Server running NetWare 
software.

cmdb_ci_network Cloud Network VMware vCenter cloud 
network.

cmdb_ci_network _acl Network ACL Network access control list 
(ACL).

cmdb_ci_network_acl_rule Network ACL Rule Rule used to control 
networking access rights.

cmdb_ci_network_adapter Network Adapter Network adapter hardware.

cmdb_ci_network_policy_group
Network Policy 
Group

Group policy consumed by 
Active Directory services.

cmdb_ci_network_template Network Template OpenStack file used to 
configure a network.

cmdb_ci_nic Cloud Mgmt 
Network Interface

Virtual network adapter.

cmdb_ci_nginx_web_server Nginx Web Server Server running Nginx software.
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cmdb_ci_openstack_datacenter OpenStack 
Datacenter

OpenStack logical datacenter.

cmdb_ci_optical_transport Fiber Optic 
Equipment Fiber optics which are used 

for long-distance and high-
performance data networking. 
Fiber optics are commonly 
used in telecommunication 
services such as internet, 
television and telephones.

Child class of Transport 
Hardware and parent class for 
telecom fiber optic equipment 
such as optical multiplexers 
and terminal equipment.

cmdb_ci_oslv_container Operating-system-
level Virtualization 
Container

Containers (a runtime 
instance of a docker image).

cmdb_ci_oslv_engine Operating-system-
level Virtualization 
Engine

Software for running and 
managing containers.

cmdb_ci_oslv_image Operating-system-
level Virtualization 
Image

Container images. 
Ordered collection of root 
filesystem changes and the 
corresponding execution 
parameters for use within a 
container runtime.

cmdb_ci_oslv_image_tag Operating-system-
level Virtualization 
Image Tag

Container tag, which is a label 
applied to a container image 
in a repository.

cmdb_ci_oslv_local_image Operating-system-
level Virtualization 
Local Image

Locally managed container 
image.

cmdb_ci_osx_server OS/X Server Server running OS/X 
operating system.

cmdb_ci_os_template Image Software files used to create 
a new instance of a compute 
resource such as server, 
desktop, virtual machine, and 
virtual router.

cmdb_ci_outofband_device Out-of-Band Device Hardware used to perform out-
of-band management.

cmdb_ci_patches Patch Patch software to fix or 
improve a computer program 
or its supporting data.

cmdb_ci_pc_hardware Personal Computer Multi-purpose electronic 
computer whose size, 
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capabilities, and price make it 
feasible for individual use.

cmdb_ci_pcf_component CloudFoundry 
Component Cloud Foundry provides 

a highly efficient, modern 
model for cloud native 
application delivery on top 
of Kubernetes. Component 
represents application, 
domain, organization, quota, 
routes, service, service plan, 
space, and space instances.

Parent class for price base of 
cloud products such as virtual 
machines.

cmdb_ci_pdu PDU Power distribution unit (PDU).

cmdb_ci_pdu_outlet Outlet Single outlet of a PDU.

cmdb_ci_peripheral Computer Peripheral Various computer peripherals 
such as monitor, docking 
station, KVM switch, projector, 
scanner, keyboard, mouse, 
and UPS.

cmdb_ci_personal_printer Personal Printer Printer whose size,capabilities 
and price make it feasible for 
individual use.

cmdb_ci_plotter Plotter Printer with capabilities to 
print large vector graphic 
images.

cmdb_ci_power_eq Power Equipment Hardware used to manage 
electrical power.

cmdb_ci_port Port Interface between a computer 
and other electronic devices.

cmdb_ci_port_group Port Group Group of ports on a virtual 
switch.

cmdb_ci_print_queue Print Queue Print queue, which is a list 
of printer output jobs held 
in a reserved memory area, 
including the most current 
status of all active and 
pending print jobs.

cmdb_ci_printer Printer Physical device which makes 
a persistent human-readable 
representation of graphics 
or text on paper or similar 
physical media.

cmdb_ci_printing_hardware Printing Hardware Physical device which makes 
a persistent human-readable 
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representation of graphics 
or text on paper or similar 
physical media.

cmdb_ci_puppet_master Puppet Primary Server running PuppetMaster 
application.

cmdb_ci_qtree Qtree Qtree file system.

cmdb_ci_qualifier Qualifier
Relation qualifier CIs which 
contain important information 
about CI relationships.

In a relation qualifier, you 
can annotate arbitrary 
unique information about 
the relationship between 
two CIs. You can define 
multiple qualifiers for a single 
relationship, resulting in a 
qualifier chain. However, 
there can be only a single 
qualifier chain for a specific 
relationship type between two 
CIs.

Parent class for the various 
relation qualifier types such 
as EntryPoint Markers and 
Boundary Connections.

cmdb_ci_rack Rack Datacenter racks containing 
details such as rack units, 
rack units in use, and power 
consumption.

cmdb_ci_raid RAID Storage pool using RAID 
mechanisms to ensure data 
integrity.

cmdb_ci_raid_member RAID Member Member of storage pool using 
RAID mechanisms.

cmdb_ci_resource_group Resource Group Resource pool is a logical 
abstraction for flexible 
management of resources.

cmdb_ci_sa_scaling_pol_base Scaling Policy Parent class for virtual 
machines scaling policy 
options such as simple and 
dynamic.

cmdb_ci_san Storage Area 
Network

Network which provides 
access to block level storage.

cmdb_ci_san_connection SAN Connection Connection in a SAN network.

cmdb_ci_san_disk SAN Disk Base table for the iSCSI 
Disk [cmdb_ci_iscsi_disk] 
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and the Fibre Channel Disk 
[cmdb_ci_fc_disk] tables.

cmdb_ci_san_endpoint SAN Endpoint One end of a SAN connection.

cmdb_ci_san_export SAN Export Base table for the iSCSI Export 
[cmdb_ci_iscsi_export] and 
the Fibre Channel Export 
[cmdb_ci_fc_export] tables.

cmdb_ci_san_fabric SAN Fabric Hardware that connects 
workstations and servers to 
storage devices in a SAN. 
Referred to as a "fabric."

cmdb_ci_san_zone SAN Zone Subset of SAN storage that 
certain users are restricted to.

cmdb_ci_san_zone_alias SAN Zone Alias Collection of SAN zone 
members.

cmdb_ci_san_zone_alias_member SAN Zone Alias 
Member

M2m relationship between 
SAN zone aliases and SAN 
zone members.

cmdb_ci_san_zone_member SAN Zone Member Ports and devices in a SAN 
zone.

cmdb_ci_san_zone_set SAN Zone Set Collection of SAN zones.

cmdb_ci_scanner Scanner Hardware used to create 
digital imagine of paper 
documents.

cmdb_ci_server Server Base class for all types of 
servers.

cmdb_ci_server_snapshot Server Snapshot Server snapshot, which is 
the state of a system at a 
particular point in time.

cmdb_ci_service Service IT Service that directly 
supports a Business Process 
(ITIL).

cmdb_ci_service_auto Application Service Services that can be 
monitored by the system, 
which in the base system, 
includes only application 
services. If Service Mapping 
is activated, there can also 
be records for dynamic CI 
groups. If Event Management 
is activated, there can be 
records for alert groups.

cmdb_ci_service_business Business Service Business services are 
published to business users 
and typically underpin one or 
more business capabilities. 
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Business services are often 
orderable by business users.

cmdb_ci_service_discovered Mapped Application 
Service

Application services, created 
by the Manual service 
population method. For 
each application service, 
there is a container CI record 
that models the application 
service.

cmdb_ci_service_technical Technical Service Technical services are 
published to service owners 
and typically underpin one 
or more business services. A 
technical service may have an 
operational view made up of 
one or more technical service 
offerings.

cmdb_ci_solaris_instance Solaris Virtual 
Machine Instance

Virtual machine instance 
running Solaris software.

cmdb_ci_solaris_server Solaris Server Physical server running 
Solaris software.

cmdb_ci_spkg Software Software package information 
containing details such as 
version, install count, license 
count, package name, and key 
(when SAM enabled).

cmdb_ci_storage_controller Storage Controller Logical device that controls 
a storage volume or Fibre 
Channel port.

cmdb_ci_storage_device Storage Device Base table for block storage 
devices such as DAS, SAN, 
and NAS.

cmdb_ci_storage_disk Storage Disk Disk installed in a storage 
server.

cmdb_ci_storage_export Storage Export Base table for the SAN Export 
[cmdb_ci_san_export] table.

cmdb_ci_storage_fileshare Storage File Share NAS file system on a storage 
server (an exported file 
system).

cmdb_ci_storage_hba Storage HBA Host bust adapter for Fibre 
Channel. The physical device 
that provides Fibre Channel 
ports.

cmdb_ci_storage_pool Storage Pool Logical collection of storage.

cmdb_ci_storage_pool_member Storage Pool 
Member

Logical volume in a storage 
pool.

cmdb_ci_storage_switch Storage Switch Fibre Channel switch.
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cmdb_ci_storage_volume Storage Volume Volume on a storage server.

cmdb_ci_storage_vol_snapshot Storage Volume 
Snapshot

Server snapshot is the state of 
a system at a particular point 
in time.

cmdb_ci_subnet Cloud Mgmt Subnet Part of a larger network.

cmdb_ci_sun_dir_proxy_server Sun Directory Proxy 
Server

Server running Sun ONE 
Directory Proxy Server 
software.

cmdb_ci_sun_ldap_dir_server Sun LDAP Server Server running Sun ONE 
Directory Server (LDAP) 
software.

cmdb_ci_surge_power_eq Surger Protection 
Equipment

Power equipment used to 
prevent power surges.

cmdb_ci_tape_server Server Tape Unit Hardware for using magnetic 
tape storage.

cmdb_ci_tomcat_connector Tomcat Connector Software which provides web 
server plugins to connect web 
servers with Tomcat and other 
backends.

cmdb_ci_tower_eq Tower Equipment Parent class for facility towers 
and tower equipment such as 
lights and beacons.

cmdb_ci_translation_rule NAT Rules to allow router to remap 
one network address to 
another.

cmdb_ci_transport_hardware Transport Hardware
Telecommunication 
hardware used for digital 
communication and 
related hardware such as 
telecommunication racks, 
servers to connect port to 
LAN, relays, channel banks, 
and network circuit switch.

Parent class for telecom 
transport hardware such as 
multiplexers and fiber optic 
equipment.

cmdb_ci_ucs_blade Cisco UCS Blade Physical Cisco UCS Blade 
server hardware.

cmdb_ci_ucs_chassis Cisco UCS Chassis Physical Cisco UCS chassis 
hardware used to hold Cisco 
UCS Blade server hardware.

cmdb_ci_ucs_equipment Cisco UCS 
Equipment

Cisco Unified Computing 
System (UCS) products.
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cmdb_ci_unix_cluster UNIX Cluster Set of computers clustered 
together to present a single 
Unix server resource.

cmdb_ci_unix_daemon UNIX Daemon Long running Unix background 
process used to answer 
requests for services.

cmdb_ci_unix_server UNIX Server Server running Unix software.

cmdb_ci_ups UPS Uninterrupted Power Supply 
devices, where devices are 
traditional UPS devices.

cmdb_ci_ups_alarm UPS Alarm Uninterrupted Power Supply 
alarm.

cmdb_ci_ups_bypass UPS Bypass Uninterrupted Power Supply 
bypass.

cmdb_ci_ups_input UPS Input Electrical input to an 
Uninterrupted Power Supply 
device.

cmdb_ci_ups_output UPS Output Electrical output from an 
Uninterrupted Power Supply 
device.

cmdb_ci_ups_power_eq Uninterruptible 
Power Supply

Uninterrupted Power Supply 
devices, where devices are 
any non-traditional UPS 
devices that manage electrical 
power.

cmdb_ci_vcenter VMware vCenter 
Instance

Installed instance of VMware 
VCenter software.

cmdb_ci_vcenter_cluster VMware vCenter 
Cluster

Set of servers that work 
together while running 
VMware VCenter software.

cmdb_ci_vcenter_cluster_drs_rule VMWare vCenter 
Cluster DRS Rule vCenter specific table which 

stores Distributed Resource 
Scheduler (DRS) basic rule 
information. Stores the affinity 
rule specifying that the 
members of a selected virtual 
machine DRS group can or 
must run on the members of a 
specific host DRS group.

Populated by the vCenter API 
ClusterRuleInfo(vim.cluster.RuleInfo) .

cmdb_ci_vcenter_datacenter VMware vCenter 
Datacenter

VMware VCenter data center 
objects.

cmdb_ci_vcenter_datastore VMware vCenter 
Datastore

VMware VCenter datastore 
objects containing details 
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such as capacity, freespace, 
filesystem, and type.

cmdb_ci_vcenter_datastore_disk Datastore Disk Individual VMware VCenter 
datastore disk.

cmdb_ci_vcenter_folder VMware vCenter 
Folder

VCenter folders, which can 
be used to group objects 
of the same type for easier 
management.

cmdb_ci_vcenter_network VMware vCenter 
Network

VMWare vCenter virtual 
network.

cmdb_ci_vcenter_object VMware vCenter 
Object

Base class for most VMware 
VCenter objects.

cmdb_ci_vcenter_server_obj VMware vCenter 
Server Object

VMware hypervisor.

cmdb_ci_veritas_disk Veritas Disk Physical disk that is controlled 
by Veritas Volume Manager.

cmdb_ci_veritas_disk_group Veritas Disk Group Collection of disks in Veritas 
Volume Manager.

cmdb_ci_veritas_plex Veritas Plex Logical partition in Veritas 
Volume Manager.

cmdb_ci_veritas_subdisk Veritas Subdisk Partition of a Veritas_disk.

cmdb_ci_veritas_volume Veritas Volume Aggregation of plexes.

cmdb_ci_virtualization_server Virtualization Server Base table used by the ESX 
Server [cmdb_ci_esx_server] 
table.

cmdb_ci_virtual_desktop Virtual Desktop User's desktop environment 
(such as icons, wallpaper, 
windows, folders, toolbars, 
and widgets) is stored 
remotely on a server.

cmdb_ci_virtual_pvt_gateway Virtual Private 
Gateway

Two VPN endpoints for 
automatic failover.

cmdb_ci_vm Virtual Machine 
HyperVisor

Hypevisor software.

cmdb_ci_vm_instance Virtual Machine 
Instance

Generic virtual machines 
information.

cmdb_ci_vm_object Virtual Machine 
Object

Base class for all VM objects. 
Parent for all objects such 
as Hyper-V object and KVM 
object.

cmdb_ci_vm_parallels Parallels Instance of Parallels software.

cmdb_ci_vm_template Virtual Machine 
Template

Template, which is a master 
copy of a virtual machine that 
can be used to create many 
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clones. Base table for all VM 
templates.

cmdb_ci_vm_user_credentials VM User Credentials Credentials, which are used 
to authenticate access rights 
and permissions.

cmdb_ci_vm_vmware VMware VMWare specialization of 
the Virtual Machine table. No 
longer used.

cmdb_ci_vm_zones Zones Partitioned virtual OS 
environment working in a 
Solaris operating system 
space.

cmdb_ci_voice_hardware Voice System 
Hardware Telecommunication systems 

that represent telephone 
systems, telephone 
exchanges, and voice mail.

Parent class for telecom voice 
system hardware such as 
voicemail and private branch 
exchanges.

cmdb_ci_volume_template Volume Template Set of rules that specify one or 
more capabilities of a storage 
volume (storage selection and 
layout rules).

cmdb_ci_vmware_instance VMware Virtual 
Machine Instance

VMware VM instance on 
VMware hypervisor.

cmdb_ci_vmware_template VMware Virtual 
Machine Template

Master copy of a VMware 
virtual machine that can be 
used to create many clones.

cmdb_ci_vpc Virtual Private Cloud On-demand configurable 
pool of shared computing 
resources allocated within a 
public cloud environment.

cmdb_ci_vpn Virtual Private 
Network

Private network configured to 
run across a public network.

cmdb_ci_vpn_connection VPN Connection Secure connection to another 
network over the Internet.

cmdb_ci_vserver_peer Vserver Peer Extends the Virtual Machine 
Object [cmdb_ci_vm_object] 
table. Peer relationship 
between the Vservers 
(NetApp).

cmdb_ci_wap_network Wireless Access 
Point

Networking hardware device 
that allows a Wi-Fi compliant 
device to connect to a wired 
network.
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cmdb_ci_web_application Web Application Client–server software 
application in which the client 
(or user interface) runs in a 
web browser.

cmdb_ci_web_domino Lotus Domino HTTP 
Server

Server running IBM Notes 
software (formerly Lotus 
Notes/IBM Domino).

cmdb_ci_web_server Web Server Computer system that 
processes requests via HTTP 
from the World Wide Web.

cmdb_ci_web_service Web Service Service offered by an 
electronic device to 
another electronic device, 
communicating with each 
other via the World Wide Web.

cmdb_ci_web_site Web Site A collection of related web 
pages.

cmdb_ci_websphere_cell Websphere Cell A logical grouping of IBM 
Websphere nodes (each 
of which runs one or more 
application servers) that are 
centrally managed.

cmdb_ci_win_cluster Windows Cluster A single (virtual) server 
composed of one ore more 
physical Windows Servers.

cmdb_ci_win_cluster_node Windows Cluster 
Node

A physical member of the 
Windows Cluster application.

cmdb_ci_win_cluster_resource Windows Cluster 
Resource

A logical or physical entity 
managed by the Windows 
Cluster application.

cmdb_ci_win_domain_controller Windows Domain 
Controller

A server that responds to 
security authentication 
requests within a Windows 
Server domain.

cmdb_ci_win_server Windows Server A server running Microsoft 
Windows Server operating 
system.

cmdb_ci_windows_service Windows Service A Windows computer 
program that operates in the 
background.

cmdb_ci_zone Data Center Zone A specified portion of a data 
center facility.

Service tables

In the CMDB, child tables of the Service [cmdb_ci_service] table store information about 
services, including application services.
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Key fields in the Service table

Field Description

Business 
criticality

The importance of this service to the business. This field can be used to 
determine disaster recovery strategies for this service. Default options are:

• 1 - most critical

• 2 - somewhat critical

• 3 - less critical

• 4 - not critical

SLA A reference to the Agreement [sla] table.

Service 
classification

Designates the type of the service.

• Application Service (For more information, see Application services)

• Technical Service (For more information, see Application services  and 
Populate an application service using the Dynamic CI Group method)

• Service Offering (For more information, see Service Portfolio Management 
service offerings )

• Shared Service (For more information, see IT shared services )

• Billable Service (To represents a service that is billed, or that is cost managed)

Used for Designates how this service is used. Default options are:

• Production

• Staging

• QA

• Test

• Development

• Demonstration

• Training

• Disaster Recovery

Users 
supported

The users that this service supports.

A reference to the Group [sys_users_group] table.

Version Use this field for your own versioning processes.

Service Configuration Item Association table

The Service Configuration Item Association table [svc_ci_assoc] binds an application service 
and a CI to track which CIs are part of each application service.

Field Description

Configuration Item Id A reference to the Configuration Item [cmdb_ci] table.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

80

https://www.webstg.servicenow.com/docs/access?context=SPM2-service-offerings&version=washingtondc&pubname=washingtondc-it-service-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=SPM2-service-offerings&version=washingtondc&pubname=washingtondc-it-service-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=SPM2-service-offerings&version=washingtondc&pubname=washingtondc-it-service-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=SPM2-service-offerings&version=washingtondc&pubname=washingtondc-it-service-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=SPM2-service-offerings&version=washingtondc&pubname=washingtondc-it-service-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=c_ITSharedService&version=washingtondc&pubname=washingtondc-it-business-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=c_ITSharedService&version=washingtondc&pubname=washingtondc-it-business-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=c_ITSharedService&version=washingtondc&pubname=washingtondc-it-business-management&ft:locale=en-US


Field Description

Service Id A reference to the Service [cmdb_ci_service] table.

Configuration Item [cmdb_ci] class

Attributes in the Configuration Item [cmdb_ci] class, which extends the Base Configuration Item 
[cmdb] class.

Warning: 
Do not modify any of these attributes in the dictionary. For example, do not modify the type 
of the location  attribute from reference to list. Such modifications may prevent features 
that use the CMDB, from functioning properly.

For descriptions of common CMDB tables in a base system, see CMDB tables descriptions.

Common core, user tables
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CMDB CI schema related to common core and non-core tables

Attributes

Attribute Description

Asset tag Asset tag/service tag for the specific asset

Assigned Date and time of assignment to user

Attributes Description of usage of attributes for the 
instance

Can Print Indicates whether the instance can print

Category Name of category applicable to the instance

Checked in Date and time of checking in

Checked out Date and time of checking out

Class System class name

Comments Comments related to the instance

Correlation ID ID of the instance from another data source

Cost Financial value in local currency (as defined in 
the Cost Currency field)

Cost currency Name of currency (such as dollars, pounds, 
Euros)

Created Date and time record was created

Created by Name of person/data source which initially 
created the record

Description Fit (how deployed) and function (purpose) of 
the instance
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Attribute Description

Discovery source Name of primary (most trusted) discovery 
source

DNS Domain Name of the DNS domain to which the 
instance belongs

Domain ID of the domain to which the instance 
belongs

Domain Path Path of the domain to which the instance 
belongs

Due Date and time instance was due

Due in Description of the manner of which the 
instance was due

Fault Count Number of faulty recorded against the 
instance to date

First Discovered Date and time instance was initially discovered

Fully Qualified Domain Name Full path name of domain to which the 
instance belongs

GL account General Ledger account name/number

Installed Date and time instance was most recently 
installed

Invoice number Invoice number used in acquisition process

IP Address Primary IP address used by the instance

Justification Description of the justification for the instance

Lease contract Number of current leasing contracts

MAC Address MAC address of the instance

Model Number Manufacturer original model number

Monitor Indicates whether the instance is monitored

Most Recent Discovery Date and time instance was last discovered

Name Name of the CI instance

Operational Status Configurable choice list with values for current 
operational states

Order received Date and time instance was initially received

Ordered Date and time instance was initially ordered

PO number Purchase order number used in acquisition 
process

Purchased Date instance was purchased

Requires verification Flag indicating whether verification is required 
for the instance

Serial number Serial number of the instance
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Attribute Description

Skip sync Flag indicating whether synchronization 
between Asset Management  and CMDB can 
be skipped

Start Date Date and time the instance was last started

Subcategory Name of Subcategory applicable to the 
instance

Sys ID ServiceNow  Sys ID (GUID)

Tags Related tags

Updated Date and time instance was last updated

Updated by Person/data source which last updated the 
record

Updates Configurable choice list with values for update 
states

Warranty expiration Date current warranty expires

Reference attribute Reference to

Approval Group Group table

Asset Asset table

Assigned to User table

Change Group Group table

Company Company table

Cost center Cost Center table

Department Department table

Location Location table

Maintenance Schedule Schedule table

Managed by User table

Manufacturer Company table

Model ID Product Model table

Owned by User table

Schedule Schedule table (for normal processing)

Support group Group table

Supported by User

Vendor Company table

Hardware [cmdb_ci_hardware] class

Attributes, identification rule, and other important schema structures for the CMDB Hardware 
[cmdb_ci_hardware] class.

For descriptions of common CMDB tables in a base system, see CMDB tables descriptions.
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Hardware, Computer, Server Schema

Note: 
cmdb_sw_instance noted in the diagram, is a reference to the cmdb_software_instance 
class, and Supported_Group is a reference to Support_Group.

Attributes

The Hardware class adds the following unique attributes:

Attribute Description

hardware_status​ Status of hardware such as In Maintenance  or 
Retired. Used to sync status to the Asset class.

hardware_substatus​ Secondary hardware status. Each setting in 
hardware_status  results in a different set 
of choices available for this field.

default_gateway​ Default gateway that the computer is 
connected through.

Key relationship structures

Use the following key relationships as important guidelines when creating Hardware, Computer, 
or Server CIs:

• Serial number: During CI identification, Identification and Reconciliation Engine (IRE) 
processes search for a serial number in two locations. One is the CI serial number attribute, 
and the second one is the Serial Number [cmdb_serial_number] table, with reference back to 
the Hardware [cmdb_ci_hardware] table.

◦ Store any serial number of any type other than System, only in the Serial Number table (and 
not in the server CI attribute).​

◦ If the system serial number is available, store it in both the Serial Number  attribute of the 
CI and in the Serial Number table.
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The Serial Number table is a many to one relationship linking back to the server CI. This table 
has a type field for specifying the type of the serial number (system, uuid, chassis, bios, or 
baseboard) and storing the actual value itself. Use the following Windows standards for serial 
number types in the Serial Number [cmdb_serial_number] table:

◦ system: Product identification such as a serial number for software, a die number on a 
hardware chip, or a project number (for noncommercial products).

◦ uuid: Universally unique identifier (UUID) for the product. A UUID is a 128-bit identifier that is 
guaranteed to be different from other generated UUIDs.

◦ chassis: Manufacturer-allocated number that is used to identify a physical element. 
Value is the Serial Number member of the System Enclosure or Chassis structure in the 
SMBIOS information. This type represents the properties associated with a physical system 
enclosure.

◦ bios: The assigned serial number of the BIOS. This type represents the attributes of the 
computer system basic input/output services (BIOS) that are installed on the computer.

◦ baseboard: Manufacturer-allocated number that is used to identify the physical element. 
This property is inherited from CIM_PhysicalElement, and is sometimes referred to as the 
'Motherboard Serial Number'.

• Network adapter:

◦ Use the Network Adapter [cmdb_ci_network_adapter] class to store network adapters.

◦ Set the Name  attribute in the Network Adapter class to be the name of the Network Adapter 
device (such as eth0, eth1).

◦ Set the MAC Address  attribute to be the MAC address value. Format the string with colon 
separators between octets and lower case hexadecimal characters with padded zeros.

For example: 'f8:f2:1e:00:d4:66'

◦ In the CI Relationship [cmdb_rel_ci] table, create an Owned By::Owns  relationship 
to the associated Hardware CI. Specify a reference from the Network Adapter 
[cmdb_ci_network_adapter] table using the CI with a reference to the associated Hardware 
CI.

• IP address:

◦ Use the IP Address [cmdb_ci_ip_address] class to store IP addresses.

◦ Store an IP address value in the IP Address  attribute, and in the Name  attribute (to avoid 
empty Name  attributes).

◦ Store an IPv4 IP address value using the format 'NNN.NNN.NNN.NNN', with decimal-based 
octets and period separators. Non-conforming values should be considered invalid and 
cleansed to null values.

◦ Store an IPv6 IP address value using lower case hexadecimal with colon separators. Non-
confirming values should be considered invalid and cleansed to null values.

◦ Set the Netmask  attribute to the IP address.

◦ In the CI Relationship [cmdb_rel_ci] table, create an Owned By::Owns  relationship to the 
associated Hardware CI.
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◦ Specify for the IP address a reference to the Network Adapter [cmdb_ci_network_adapter] 
table using the Configuration Item with a reference to the associated Hardware CI.

◦ To ensure that base system identification rules work properly, also store the IP address in the 
associated Network Adapter class.

• Network adapter and IP address:

◦ Store the MAC address of the network adapter installed on a server, in the Network Adapter 
[cmdb_ci_network_adapter] class.

◦ Store the IP address in the IP Address [cmdb_ci_ip_address] class.

◦ Do not store the MAC address or the IP address in the Server [cmdb_ci_server] class.​

Key reference structures

Use the following key references as important guidelines when creating Hardware, Computer, or 
Server CIs:

• Software and processes running on a server: The Software [cmdb_ci_spkg] class contains the 
generic software package that is related to the server CI. The cmdb_software_instance table 
instantiates each instance of the software package with:

◦ One to one reference back to the Server [cmdb_ci_server] class

◦ Many to one reference back to the Software class
These references are stored in the Installed on  and the Product Name  reference 
attributes respectively.

If either the Software Asset Management Foundation [com.snc.sams] or the Software 
Asset Management [com.snc.software_asset_management] plugin is installed, then store 
software details in the Software Installation [cmdb_sam_sw_install] table instead of the 
cmdb_software_instance table.

• The Manufacturer  and Model ID  are reference attributes to the Company 
[core_company] and Product Model [cmdb_model] tables respectively.

• The Owned By, Assigned To, Managed By, and Supported By  are reference 
attributes to the User [sys_user] table. The Change Group  and Support Group  are 
reference attributes to the Group [sys_user_group] table.

Identification rule

The base system contains pre-defined identification rules for the Hardware, Computer, and 
Server classes, which are identical. That identification rule has the following key identifier entries, 
listed in priority order:

1. Identifier entry which uses lookup-based identification specified with Serial Number 
[cmdb_serial_number] as the lookup table. The Serial Number table is a many to one reference 
from Serial Number back to the server CI.

2. Identifier entry specified with the Serial Number  attribute in the CI.

3. Identifier entry for the Name  attribute. If Serial Number  is not available, then the Name 
(which is the hostname) attribute is used. If both the Serial Number  and the Name 
attributes are provided, then Identification and Reconciliation Engine (IRE) looks first for the 
Serial Number. Then, if a Serial Number is not found, IRE falls back to using Name.
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4. Identifier entry specified for the MAC Address/IP Address  attributes in the Network 
Adapter table. However, do not rely only on the MAC Address/IP Address.

If both Serial Number  and Name  are not available, and only MAC Address/IP 
Address  are available, use MAC Address  as the name of the CI. Using the MAC Address 
as the name of the CI ensures that you don't create an empty CI.

For more information, see CMDB Identification and Reconciliation.

Computer [cmdb_ci_computer] class

Attributes, identification rule, and other important schema structures for the CMDB Computer 
[cmdb_ci_computer] class.

For descriptions of common CMDB tables in a base system, see CMDB tables descriptions.

Hardware, Computer, Server Schema

Note: 
cmdb_sw_instance noted in the diagram, is a reference to the cmdb_software_instance 
class, and Supported_Group is a reference to Support_Group.

Attributes

The Computer class adds the following unique attributes:

Attribute Description

CD_ROM​ Denotes whether a CD ROM exists.

CD Speed​ Speed of CD_ROM.

Chassis type​ Type of computer chassis.

CPU core count​ Number of cores per CPU.

CPU core thread​ Number of threads per core.

CPU count​ Number of CPUs.
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Attribute Description

CPU name​ Name of CPU.

CPU speed (MHz)​ Speed of CPU.

CPU type​ CPU type.

Disk space (GB)​ Amount of disk space (in GB).

Floppy​ Type of floppy drive.​

Form factor​ Form factor of the computer.

Object ID​ Object ID of the computer (such as the virtual 
machine ID associated with the computer).

Operating System​ Name of the operating system.

OS Address Width (bits)​ Operating system bit (such as 32, 64).

OS Domain​ NA​

OS Service Pack​ Service pack installed on the operating system​
.

OS Version​ Version of the operating system.

RAM (MB)​ Amount of RAM on the computer.

IsVirtual​ True/False denoting whether the device is 
running on a virtual machine instance.​

Reference attribute Reference to

CPU manufacturer​ Company [core_company] table​

Schema description

The CMDB schema model does not separate between servers and computers that are physical 
and servers and computer that are virtual. Instead, the Computer and the Server classes have 
a field named IsVirtual. If a computer or server is a virtual instance, set this IsVirtual 
attribute to true.

As described in the Virtual Machine schema section, to fully model a virtual machine, set the 
IsVirtual  attribute in the Computer or Server CI to true. Create a Virtual Machine Instance 
[cmdb_ci_vm_instance] record using the BIOS UUID  attribute as the key identifier. Then create 
a Hosted_On relationship between the Virtual Machine Instance record and the Computer or 
Server instance and set IsVirtual  to true.

Key relationship structures

Use the following key relationships as important guidelines when creating Hardware, Computer, 
or Server CIs:

• Serial number: During CI identification, Identification and Reconciliation Engine (IRE) 
processes search for a serial number in two locations. One is the CI serial number attribute, 
and the second one is the Serial Number [cmdb_serial_number] table, with reference back to 
the Hardware [cmdb_ci_hardware] table.
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◦ Store any serial number of any type other than System, only in the Serial Number table (and 
not in the server CI attribute).​

◦ If the system serial number is available, store it in both the Serial Number  attribute of the 
CI and in the Serial Number table.

The Serial Number table is a many to one relationship linking back to the server CI. This table 
has a type field for specifying the type of the serial number (system, uuid, chassis, bios, or 
baseboard) and storing the actual value itself. Use the following Windows standards for serial 
number types in the Serial Number [cmdb_serial_number] table:

◦ system: Product identification such as a serial number for software, a die number on a 
hardware chip, or a project number (for noncommercial products).

◦ uuid: Universally unique identifier (UUID) for the product. A UUID is a 128-bit identifier that is 
guaranteed to be different from other generated UUIDs.

◦ chassis: Manufacturer-allocated number that is used to identify a physical element. 
Value is the Serial Number member of the System Enclosure or Chassis structure in the 
SMBIOS information. This type represents the properties associated with a physical system 
enclosure.

◦ bios: The assigned serial number of the BIOS. This type represents the attributes of the 
computer system basic input/output services (BIOS) that are installed on the computer.

◦ baseboard: Manufacturer-allocated number that is used to identify the physical element. 
This property is inherited from CIM_PhysicalElement, and is sometimes referred to as the 
'Motherboard Serial Number'.

• Network adapter:

◦ Use the Network Adapter [cmdb_ci_network_adapter] class to store network adapters.

◦ Set the Name  attribute in the Network Adapter class to be the name of the Network Adapter 
device (such as eth0, eth1).

◦ Set the MAC Address  attribute to be the MAC address value. Format the string with colon 
separators between octets and lower case hexadecimal characters with padded zeros.

For example: 'f8:f2:1e:00:d4:66'

◦ In the CI Relationship [cmdb_rel_ci] table, create an Owned By::Owns  relationship 
to the associated Hardware CI. Specify a reference from the Network Adapter 
[cmdb_ci_network_adapter] table using the CI with a reference to the associated Hardware 
CI.

• IP address:

◦ Use the IP Address [cmdb_ci_ip_address] class to store IP addresses.

◦ Store an IP address value in the IP Address  attribute, and in the Name  attribute (to avoid 
empty Name  attributes).

◦ Store an IPv4 IP address value using the format 'NNN.NNN.NNN.NNN', with decimal-based 
octets and period separators. Non-conforming values should be considered invalid and 
cleansed to null values.

◦ Store an IPv6 IP address value using lower case hexadecimal with colon separators. Non-
confirming values should be considered invalid and cleansed to null values.
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◦ Set the Netmask  attribute to the IP address.

◦ In the CI Relationship [cmdb_rel_ci] table, create an Owned By::Owns  relationship to the 
associated Hardware CI.

◦ Specify for the IP address a reference to the Network Adapter [cmdb_ci_network_adapter] 
table using the Configuration Item with a reference to the associated Hardware CI.

◦ To ensure that base system identification rules work properly, also store the IP address in the 
associated Network Adapter class.

• Network adapter and IP address:

◦ Store the MAC address of the network adapter installed on a server, in the Network Adapter 
[cmdb_ci_network_adapter] class.

◦ Store the IP address in the IP Address [cmdb_ci_ip_address] class.

◦ Do not store the MAC address or the IP address in the Server [cmdb_ci_server] class.​

Key reference structures

Use the following key references as important guidelines when creating Hardware, Computer, or 
Server CIs:

• Software and processes running on a server: The Software [cmdb_ci_spkg] class contains the 
generic software package that is related to the server CI. The cmdb_software_instance table 
instantiates each instance of the software package with:

◦ One to one reference back to the Server [cmdb_ci_server] class

◦ Many to one reference back to the Software class
These references are stored in the Installed on  and the Product Name  reference 
attributes respectively.

If either the Software Asset Management Foundation [com.snc.sams] or the Software 
Asset Management [com.snc.software_asset_management] plugin is installed, then store 
software details in the Software Installation [cmdb_sam_sw_install] table instead of the 
cmdb_software_instance table.

• The Manufacturer  and Model ID  are reference attributes to the Company 
[core_company] and Product Model [cmdb_model] tables respectively.

• The Owned By, Assigned To, Managed By, and Supported By  are reference 
attributes to the User [sys_user] table. The Change Group  and Support Group  are 
reference attributes to the Group [sys_user_group] table.

Identification rule

The base system contains pre-defined identification rules for the Hardware, Computer, and 
Server classes, which are identical. That identification rule has the following key identifier entries, 
listed in priority order:

1. Identifier entry which uses lookup-based identification specified with Serial Number 
[cmdb_serial_number] as the lookup table. The Serial Number table is a many to one reference 
from Serial Number back to the server CI.

2. Identifier entry specified with the Serial Number  attribute in the CI.

3. Identifier entry for the Name  attribute. If Serial Number  is not available, then the Name 
(which is the hostname) attribute is used. If both the Serial Number  and the Name 
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attributes are provided, then Identification and Reconciliation Engine (IRE) looks first for the 
Serial Number. Then, if a Serial Number is not found, IRE falls back to using Name.

4. Identifier entry specified for the MAC Address/IP Address  attributes in the Network 
Adapter table. However, do not rely only on the MAC Address/IP Address.

If both Serial Number  and Name  are not available, and only MAC Address/IP 
Address  are available, use MAC Address  as the name of the CI. Using the MAC Address 
as the name of the CI ensures that you don't create an empty CI.

For more information, see CMDB Identification and Reconciliation.

Server [cmdb_ci_server] class

Attributes, identification rule, and other important schema structures for the CMDB Server 
[cmdb_ci_server] class.

For descriptions of common CMDB tables in a base system, see CMDB tables descriptions.

Hardware, Computer, Server Schema

Note: 
cmdb_sw_instance noted in the diagram, is a reference to the cmdb_software_instance 
class, and Supported_Group is a reference to Support_Group.

Attributes

The Server class adds the following unique attributes:

Attribute Description

Classification​ Type of server, such as production, 
development, disaster recovery, or user 
acceptance testing (UAT).

Firewall status Internet or intranet facing server.
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Attribute Description

Host name Use the Name attribute to store the host 
name of the server instead of the Host name 
attribute.

Used for Business service supported by the server, 
such as production, staging, or quality 
assurance (QA). This attribute uses the 
Used for  choice list field from the Service 
[cmdb_ci_service] table.

Reference attribute Reference to

Disaster backup Server [cmdb_ci_server] table. Reference to 
another server that is the backup server for 
this server.

Reference classes

The following reference classes extend the Server class. They do not add any new attributes.

Reference class​ Name​ Description​

cmdb_ci_solaris_server​ Solaris Server​ Server running Oracle Solaris 
operating system.

cmdb_ci_lb_cisco_csm​ Cisco CSM​ Cisco Security Manager (CSM) 
load balancer.

cmdb_ci_win_server​ Windows Server​ Server running Microsoft 
Windows Server operating 
system.

cmdb_ci_lb_ace​ ACE​ Cisco Application Control 
Engine load balancer.​

cmdb_ci_lb_netsclaer​ Citrix Netscaler​ Citrix Netscaler load balancer.

cmdb_ci_lb_alteon​ Alteon​ Alteon load balancer.​

cmdb_ci_lb​ Load Balancer​ Generic load balancer.

cmdb_ci_lb_a10​ A10 Load Balancer​ A10 load balancer.​

cmdb_ci_lb_cisco_css​ Cisco CSS​ Cisco Content Services Switch 
(CSS) load balancer.​

cmdb_ci_lb_cisco_gss​ Cisco GSS​ Cisco Global Site Selector 
(GSS) load balancer.​

cmdb_ci_osx_Server​ OS/X Server​ Server running OS/X 
operating system.

cmdb_ci_HPUX_Server​ HPUX Server​ Server running HP-UX 
operating system.

cmdb_ci_tape_server​ Server Tape Unit​ Server using a tape drive.

cmdb_ci_Server_Hardware​ Server Hardware​ Server hardware.​

cmdb_ci_datapower_server Data Power Hosting Server​ IBM DataPower hosting server.
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Reference class​ Name​ Description​

cmdb_ci_net_app_server​ Network Appliance Hardware​ NetApp hardware.

cmdb_ci_netware_server​ Netware Server​ Server running NetWare 
operating system.

cmdb_ci_ibm_zos_server​ IBM zOS Server​ Server running IBM z/OS 
operating system.

cmdb_ci_storage_node_element​Storage Node Element​ Storage node.​

cmdb_ci_chassis_server​ Server Chassis​ Server chassis.

cmdb_ci_lb_network​ Network Load Balancer​ Network load balancer 
hardware.

cmdb_ci_Unix_Server​ Unix Server​ Server running Unix operating 
system.​

cmdb_ci_linux_server Linux Server Server running Linux operating 
system.​

cmdb_ci_virtualization_server​ Virtualization Server​ Abstract base table 
used by Hyper-V Server 
[cmdb_ci_hyper_v_server] 
and ESX Server 
[cmdb_ci_esx_server].

cmdb_ci_mainframe​ IBM Mainframe​ Large-scale computer system 
with high-end capabilities.​

Schema description

The CMDB schema model does not separate between servers and computers that are physical 
and servers and computer that are virtual. Instead, the Computer and the Server classes have 
a field named IsVirtual. If a computer or server is a virtual instance, set this IsVirtual 
attribute to true.

As described in the Virtual Machine schema section, to fully model a virtual machine, set the 
IsVirtual  attribute in the Computer or Server CI to true. Create a Virtual Machine Instance 
[cmdb_ci_vm_instance] record using the BIOS UUID  attribute as the key identifier. Then create 
a Hosted_On relationship between the Virtual Machine Instance record and the Computer or 
Server instance and set IsVirtual  to true.

Key relationship structures

Use the following key relationships as important guidelines when creating Hardware, Computer, 
or Server CIs:

• Serial number: During CI identification, Identification and Reconciliation Engine (IRE) 
processes search for a serial number in two locations. One is the CI serial number attribute, 
and the second one is the Serial Number [cmdb_serial_number] table, with reference back to 
the Hardware [cmdb_ci_hardware] table.

◦ Store any serial number of any type other than System, only in the Serial Number table (and 
not in the server CI attribute).​

◦ If the system serial number is available, store it in both the Serial Number  attribute of the 
CI and in the Serial Number table.
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The Serial Number table is a many to one relationship linking back to the server CI. This table 
has a type field for specifying the type of the serial number (system, uuid, chassis, bios, or 
baseboard) and storing the actual value itself. Use the following Windows standards for serial 
number types in the Serial Number [cmdb_serial_number] table:

◦ system: Product identification such as a serial number for software, a die number on a 
hardware chip, or a project number (for noncommercial products).

◦ uuid: Universally unique identifier (UUID) for the product. A UUID is a 128-bit identifier that is 
guaranteed to be different from other generated UUIDs.

◦ chassis: Manufacturer-allocated number that is used to identify a physical element. 
Value is the Serial Number member of the System Enclosure or Chassis structure in the 
SMBIOS information. This type represents the properties associated with a physical system 
enclosure.

◦ bios: The assigned serial number of the BIOS. This type represents the attributes of the 
computer system basic input/output services (BIOS) that are installed on the computer.

◦ baseboard: Manufacturer-allocated number that is used to identify the physical element. 
This property is inherited from CIM_PhysicalElement, and is sometimes referred to as the 
'Motherboard Serial Number'.

• Network adapter:

◦ Use the Network Adapter [cmdb_ci_network_adapter] class to store network adapters.

◦ Set the Name  attribute in the Network Adapter class to be the name of the Network Adapter 
device (such as eth0, eth1).

◦ Set the MAC Address  attribute to be the MAC address value. Format the string with colon 
separators between octets and lower case hexadecimal characters with padded zeros.

For example: 'f8:f2:1e:00:d4:66'

◦ In the CI Relationship [cmdb_rel_ci] table, create an Owned By::Owns  relationship 
to the associated Hardware CI. Specify a reference from the Network Adapter 
[cmdb_ci_network_adapter] table using the CI with a reference to the associated Hardware 
CI.

• IP address:

◦ Use the IP Address [cmdb_ci_ip_address] class to store IP addresses.

◦ Store an IP address value in the IP Address  attribute, and in the Name  attribute (to avoid 
empty Name  attributes).

◦ Store an IPv4 IP address value using the format 'NNN.NNN.NNN.NNN', with decimal-based 
octets and period separators. Non-conforming values should be considered invalid and 
cleansed to null values.

◦ Store an IPv6 IP address value using lower case hexadecimal with colon separators. Non-
confirming values should be considered invalid and cleansed to null values.

◦ Set the Netmask  attribute to the IP address.

◦ In the CI Relationship [cmdb_rel_ci] table, create an Owned By::Owns  relationship to the 
associated Hardware CI.
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◦ Specify for the IP address a reference to the Network Adapter [cmdb_ci_network_adapter] 
table using the Configuration Item with a reference to the associated Hardware CI.

◦ To ensure that base system identification rules work properly, also store the IP address in the 
associated Network Adapter class.

• Network adapter and IP address:

◦ Store the MAC address of the network adapter installed on a server, in the Network Adapter 
[cmdb_ci_network_adapter] class.

◦ Store the IP address in the IP Address [cmdb_ci_ip_address] class.

◦ Do not store the MAC address or the IP address in the Server [cmdb_ci_server] class.​

Key reference structures

Use the following key references as important guidelines when creating Hardware, Computer, or 
Server CIs:

• Software and processes running on a server: The Software [cmdb_ci_spkg] class contains the 
generic software package that is related to the server CI. The cmdb_software_instance table 
instantiates each instance of the software package with:

◦ One to one reference back to the Server [cmdb_ci_server] class

◦ Many to one reference back to the Software class
These references are stored in the Installed on  and the Product Name  reference 
attributes respectively.

If either the Software Asset Management Foundation [com.snc.sams] or the Software 
Asset Management [com.snc.software_asset_management] plugin is installed, then store 
software details in the Software Installation [cmdb_sam_sw_install] table instead of the 
cmdb_software_instance table.

• The Manufacturer  and Model ID  are reference attributes to the Company 
[core_company] and Product Model [cmdb_model] tables respectively.

• The Owned By, Assigned To, Managed By, and Supported By  are reference 
attributes to the User [sys_user] table. The Change Group  and Support Group  are 
reference attributes to the Group [sys_user_group] table.

Identification rule

The base system contains pre-defined identification rules for the Hardware, Computer, and 
Server classes, which are identical. That identification rule has the following key identifier entries, 
listed in priority order:

1. Identifier entry which uses lookup-based identification specified with Serial Number 
[cmdb_serial_number] as the lookup table. The Serial Number table is a many to one reference 
from Serial Number back to the server CI.

2. Identifier entry specified with the Serial Number  attribute in the CI.

3. Identifier entry for the Name  attribute. If Serial Number  is not available, then the Name 
(which is the hostname) attribute is used. If both the Serial Number  and the Name 
attributes are provided, then Identification and Reconciliation Engine (IRE) looks first for the 
Serial Number. Then, if a Serial Number is not found, IRE falls back to using Name.
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4. Identifier entry specified for the MAC Address/IP Address  attributes in the Network 
Adapter table. However, do not rely only on the MAC Address/IP Address.

If both Serial Number  and Name  are not available, and only MAC Address/IP 
Address  are available, use MAC Address  as the name of the CI. Using the MAC Address 
as the name of the CI ensures that you don't create an empty CI.

For more information, see CMDB Identification and Reconciliation.

VMware vCenter Object [cmdb_ci_vcenter_object] class

Attributes, identification rule, and other important schema structures for Virtual Machine related 
classes.

For descriptions of common CMDB tables in a base system, see CMDB tables descriptions.

Schema description​

ServiceNow®  has an extensive modeling of virtual machines (VMs) environment, with classes 
such as:

• VMware vCenter Cluster [cmdb_ci_vcenter_cluster]

• VMware vCenter datacenter [cmdb_ci_vcenter_datacenter]

• VMware Virtual Machine Instance [cmdb_ci_vmware_instance]

Virtual machines are modeled just like any other server, but with the IsVirtual  attribute set to 
true.

VMWare vCenter Instance schema structure

In the diagram above, the 'Discovered' virtual server is referred to as the 'Guest' (VM object). 
Follow the preceding diagram for any further modeling of VMWare components.

Key reference structures

The Guest has the following important key reference structures:
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• An Instantiates::InstantiatedBy relationship with the cmdb_ci_vmware_instance (which is the 
VM instance reported by Center).

• A Virtualizes::Virtualized by relationship with ESXi Server (the hardware with the ESXi 
virtualization software installed).

• Guest (Discovered, VMObject) also has a HasRegistered::RegisteredOn relationship to ESXi 
Server.

Identification rules

• Guest operating system: Guest operating system is modeled as Server (with IsVirtual  set 
to true) and therefore identification rules follow the rules for the Server class. In most operating 
systems, BIOS UUID is reported as serial number. It is essential that you follow proper VMware 
guidelines to ensure that BIOS UUID is not being reused. Having a cloned BIOS UUID causes 
issues with identification rules.

• VM Instances: IRE uses instance MosRef ID as key identifier.

• ESX Server: Server is modeled as bare metal Server (with IsVirtual  set to false) and 
therefore applies the Server class identification rules.

Cloud class

Description, identification rule, and other important schema structures for the CMDB cloud 
classes.

For descriptions of common CMDB tables in a base system, see CMDB tables descriptions.

AWS/Azure/OpenStack class model​
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IBM Datacenter Cloud Schema model

Google Datacenter Schema Model

Cloud schema description

ServiceNow  has extensive models of cloud environments including Amazon Web Services 
(AWS), Microsoft Azure service, Google Cloud Platform (GCP), and IBM Cloud. Focusing on the 
compute side, the models for cloud environments and for Virtual Servers are similar. For example, 
instances of Amazon Elastic Compute Cloud (EC2) and Microsoft®  Azure Cloud Compute, are an 
extension of Virtual Machine instances, where CIs are typically created by connecting directly to 
cloud inventory. However, Virtual Machine instances do not represent actual usage of the cloud 
instance.

Cloud Service Account [cmdb_ci_cloud_service_account] is the main class for tracking cloud 
accounts such as AWS, GCP, and Azure (replacing for example, use of the cmdb_ci_aws_account 
table for AWS).
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For example, you can represent a Linux guest host running on Amazon EC2 by the Server 
[cmdb_ci_server] class, with the IsVirtual  attribute set to true  and with the relationship Runs 
on:Runs to the EC2 instance. Integrating the AWS Config Service or the Amazon CloudWatch 
application, provides information on the EC2 object ID. Running Discovery  or another discovery 
program on the guest Linux host, provides the hostname.

Ensure the following:

• Getting the correct UUID which gets stored in the Serial Number [cmdb_serial_number] table.

• Connecting/creating the cloud instance to Host OS, matching on the UUID/Object ID and 
creating the Runs On:Runs relationship.

Also, there is a complete model of Storage, Networking, Lamda/Functions in addition 
to modeling of different regions using the concept of the table Logical Datacenter 
[cmdb_ci_logical_datacenter] with Hosts:HostedOn relationship with Compute, Storage, and 
such.

Identification rule

The base system contains pre-defined identification rules for cloud schema classes. A cloud 
object requires the following identification items:​

• Object ID: Which is synonymous with the IDs that cloud vendors use for each type of cloud 
resource, such as Azure Compute, EC2, and Amazon Simple Storage Service (S3).

• Object ID is unique per region and therefore has dependent relationship requiring 
information from the Logical Datacenter [cmdb_ci_logical_data_center] table, about 
the region where the cloud resource is being hosted. For example, AWS Datacenter 
[cmdb_ci_aws_datacenter], Azure Datacenter [cmdb_ci_azure_datacenter], Google Datacenter 
[cmdb_ci_google_datacenter] that are extended from Logical Datacenter.

Logical Datacenter itself, has two identifier entries:​

◦ Object ID: Unique ID of the logical datacenter where applicable​

◦ Region: The region of the cloud resource

• Logical Datacenter has a dependency on cloud service accounts, which has two identifier 
entries:

◦ Object ID: Unique ID of the account where applicable.

◦ Account ID: The unique Account ID that encompasses the different cloud resources. 
Account ID is generally more applicable than Object ID.

For more information, see CMDB Identification and Reconciliation.

CMDB CI Class Models store app

The Configuration Management Database (CMDB)  contains out-of-the-box classes that store 
data about Configuration Items (CIs). The CMDB CI Class Models store app adds class models 
that extend the CMDB class hierarchy, including class descriptions, identification rules, identifier 
entries, and dependent relationships if applicable.

You can use the added classes as any other CMDB  class. Applications such as Discovery 
and Service Mapping  can use these class extensions to populate CIs and discover various 
technologies and software.

Related ServiceNow®  Store  apps and reference information:
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• CMDB schema model: A collection of class diagrams and class attributes for key CMDB 
classes.

• CMDB tables descriptions: Descriptions of key CMDB tables in the base system.

• Populating the CMDB: Information about the various options for populating the CMDB.

• Discovery patterns : A ServiceNow Store  app that provides a library of Discovery patterns for 
discovering specific devices and applications in the industry.

• Service Graph Connectors: ServiceNow Store  apps that provide pre-defined integrations 
for importing and integrating common third-party data into CMDB classes. Also includes the 
IntegrationHub ETL  wizard for creating new ETL transform maps.

Add class models

The app adds classes, columns, and the associated metadata as related records in the following 
tables:

• CMDB Class Information [cmdb_class_info]: Class descriptions

• Identifier [cmdb_identifier]: Identification rules

• Identifier Entry [cmdb_identifier_entry]: Identification entries

• CMDB Metadata Hosting Rules [cmdb_metadata_hosting]: Dependent relationships

Discover using extension classes

The table lists the software and technologies that applications can discover using the extension 
classes. It provides links to documentation for CMDB CI Class Models and the corresponding 
discovery patterns.

Software/Technology
CMDB CI Class Models Store 
app

ServiceNow Store  discovery 
patterns

Avi load balancer Avi load balancer extension 
classes

Avi Vantage load balancer 
discovery

BYOL Model of RDS for Oracle BYOL model of RDS for Oracle 
extension classes

Firewall Firewall extension classes

IBM Hardware Management 
Console (HMC)

IBM Hardware Management 
Console (HMC) extension 
classes

IBM  Virtualization and 
Hardware Management 
Console discovery

Internet of Things (IoT) Internet of Things (IoT) 
extension classes

N/A

Nutanix Nutanix extension classes Nutanix Acropolis discovery

OpenStack OpenStack extension classes OpenStack resource 
discovery

Red Hat Virtualization (RHV) Red Hat Virtualization (RHV) 
extension classes

Red Hat Virtualization 
discovery

Transport Layer Security (TLS) Transport Layer Security (TLS) 
extension classes

Discovery procedures 
provided by Certificate 
Inventory and Management 
ServiceNow Store  app
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Software/Technology
CMDB CI Class Models Store 
app

ServiceNow Store  discovery 
patterns

VMware NSX load balancer VMware NSX load balancer 
extension classes

VMware NSX Advanced load 
balancer discovery

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Verify successful installation

After installing the CMDB CI Class Models store app, make sure the classes were added 
successfully:

1. Navigate to All  > Configuration  > CI Class Manager.

2. Click Hierarchy  to display the CI Classes list.

This list contains the added classes, such as the Nutanix classes.

3. Select a class to see the corresponding class details, identification rules, identifier entries, and 
dependent relationships, if applicable.

Note: 
Uninstalling the CMDB CI Class Models application might compromise the integrity of the 
CMDB and result in unexpected behavior.

API extension classes

The CMDB CI Class Models  ServiceNow Store  app adds or updates classes for APIs (application 
programming interface).

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

APIs

APIs are a set of definitions and protocols that enable computer programs to communicate with 
each other, which enables you to build or integrate application software. APIs typically use web-
based technology to communicate with other APIs. APIs are generally used to programmatically 
perform jobs or tasks, or to view, import, export, delete, or modify data.

The classes added in this release extend the CMDB  data model and provide a foundation for the 
representation of API CI classes. You can use this foundation to do the following:

• Gain greater visibility into your APIs.

• Identify security issues and vulnerabilities associated with an API endpoint.

Classes

For additional detail, see the Community article titled "New Data Model in CMDB for APIs" .
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CMDB CI Class Models: The following classes for API are available. 

Class Extends Description

API

[cmdb_ci_api]

Configuration Item

[cmdb_ci]

APIs that enable two 
computer programs to 
communicate with each 
other, typically using 
web-based technologies. 
Example: ChatAPI (https://
[apiID].execute-api.use-
east-2.amazonaws.com).

API Component

[cmdb_ci_api_component]

Configuration Item

[cmdb_ci]

Reusable objects related 
to your API definition that 
facilitate functionality or 
exchange of data. API 
Headers related list. Example: 
GET https://[instance].service-
now.com/api/now/table/
{tablename}.

API Frontend

[cmdb_ci_api_frontend]

API Component

[cmdb_ci_api_component]

The part of an API from 
which a client or user 
interacts or makes requests. 
Example: GET https://
[apiID].execute-api.us-
east-2.amazonaws.com/{proxy
+}.

API Backend

[cmdb_ci_api_backend]

API Component

[cmdb_ci_api_component]

The part of an API that fulfills 
requests by interacting 
with backend services, 
such as servers. Example: 
Lambda:Chat-API-Proxy.

API Gateway

[cmdb_ci_api_gateway]

Application

[cmdb_ci_appl]

API infrastructure that 
centralizes client API requests 
and manages backend 
processes and services. 
Example: Kong Gateway.

Managed API

[cmdb_ci_managed_api]

Configuration Item

[cmdb_ci_api]

API discovered from a 
gateway or management 
service. You can enforce a 
dependency on a gateway for 
APIs in this class.

Class attributes

CMDB CI Class Models: Release 1.49.0 adds the following attributes to the respective classes.

API [cmdb_ci_api]

Attribute Data type Description

Base URL String (1024) Base address from which all 
API components extend.
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API [cmdb_ci_api]  (continued)

Attribute Data type Description

ID String (1024) Unique identifier from the 
source system.

Type Choice list Type of API. You can specify:

• REST

• SOAP

• HTTP

• gRPC

• GraphQL

• Websocket

Version Numeric Version of the API.

Spec Location URL URL to the location of the 
API specification. Example: 
OpenAPI spec definition.

Technical Specification 
Location

String Location of the technical 
specification repository for 
an API. Example: GitHub 
repository containing the 
deployed API code.

Design Specification Location String URL to the location of the API 
design or documentation. 
Example: SwaggerHub API 
Design Specification URL.

The API [cmdb_ci_api] class supports mapping of tags and labels to the Key Value 
[cmdb_key_value] table to enable key-value storage for API metadata.

API Component [cmdb_ci_api_component]

Attribute Data type Description

Method String REST API methods. Examples:

• GET

• POST

• DELETE

Protocol String Communication protocol. 
Example: HTTP, HTTPS.

Host String (100) System that hosts the API.

Path String (1024) Specific route the API follows.

Port String Communication port. 
Example: 80, 443, and so on.
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API Component [cmdb_ci_api_component]  (continued)

Attribute Data type Description

URL String (1024) URL of the resource being 
called.

ID String (1024) Unique identifier from the 
source system.

Internet Facing Boolean Boolean that denotes whether 
the component is reachable 
from the public internet. 
Specify 1 or "true" if the 
component is reachable.

Authorization String Type of authorization or 
authentication method. 
Example:

• Basic

• Key

• OAuth

• None

Request data types String (255) List of data types in the 
request. Examples:

• CC

• Email

• Address

Response data types String (255) List of data types in the 
response. Examples:

• CC

• Email

• Address

The API Component [cmdb_ci_api_component] class supports mapping of tags and labels to the 
Key Value [cmdb_key_value] table to enable key-value storage for API component metadata.

API Frontend [cmdb_ci_api_frontend]

Attribute Data type Description

Parent ID Reference to 
[cmdb_ci_api_frontend]

Reference to a parent API 
component.
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API Backend [cmdb_ci_api_backend]

Attribute Data type Description

Type String Backend protocol types of the 
API. Examples:

• Lambda

• HTTP

• Logic App

API Gateway [cmdb_ci_api_gateway]

Attribute Data type Description

ID String (255) Unique identifier from the 
source system.

The API Gateway [cmdb_ci_api_gateway] class supports mapping of tags and labels to the 
Key Value [cmdb_key_value] table. The mapping enables key-value storage for API gateway 
metadata.

The following marker classes are available for API gateways. These classes inherit all attributes 
from the API Gateway [cmdb_ci_api_gateway] parent class.

• Anypoint API Gateway [cmdb_ci_api_gateway_anypoint] (provided by MuleSoft)

• Tyk API Gateway [cmdb_ci_api_gateway_tyk]

• Boomi API Gateway [cmdb_ci_api_gateway_boomi]

The marker classes follow the existing class structure and do not require changes to 
Identification and Reconciliation engine (IRE)  rules.

Note: 
The Managed API [cmdb_ci_managed_api] class is specific to APIs discovered from 
gateways and other managed services, and does not introduce new attributes.

API Product Bundle [cmdb_ci_api_product_bundle]

Attribute Data type Description

ID String (255) Unique identifier of the API 
product bundle.

Discovered Approval Type String Type of request approval as 
discovered from the source 
system.

Discovered Access Type String Access configuration as 
discovered from the source 
system. For example, public or 
internal.

Creation Date Date/Time Date and time when the API 
product bundle was initially 
discovered or recorded.
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API Product Bundle [cmdb_ci_api_product_bundle]  (continued)

Attribute Data type Description

Last Modified Date Date/Time Date and time of the most 
recent update to the API 
product bundle.

Discovered State String Current state of the product 
bundle as reported by 
the source. For example, 
published or deprecated.

API Consumer Subscription [cmdb_ci_api_consumer_subscription]

Attribute Data type Description

Discovered Scope String Scope of access as 
discovered from the source 
system. For example, all APIs 
or specific APIs.

API Consumer Reference Reference to the 
API consumer 
record. For example, 
cmdb_ci_api_consumer.

ID String (255) Unique identifier of the API 
consumer subscription.

Discovered State String Subscription status as 
discovered from the source 
system. For example, active or 
inactive.

Creation Date Date/Time Date and time when the API 
consumer subscription was 
created in the source system.

Last Modified Date Date/Time Date and time of the most 
recent update to the API 
consumer subscription.

Key relationship structures

There are a number of key relationships that must be defined for API and Kong classes.

API relationships

Parent class Relationship Child class Relationship type

API

[cmdb_ci_api]

Uses::Used by API Component

[cmdb_ci_api_component]

Suggested

API Gateway

[cmdb_ci_api_gateway]

Provides::Provided By Managed API

[cmdb_ci_managed_api]

Dependent

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

107



API relationships  (continued)

Parent class Relationship Child class Relationship type

API Frontend

[cmdb_ci_api_frontend]

Use End Point To::Use 
End Point From

API Backend

[cmdb_ci_api_backend]

Suggested

API Backend

[cmdb_ci_api_backend]

Uses::Used By Kong Load Balancer

[cmdb_ci_kong_lb]

Suggested

API Gateway

[cmdb_ci_api_gateway]

Provides::Provided By API Product Bundle

[cmdb_ci_api_product_bundle]

Dependent

API Gateway

[cmdb_ci_api_gateway]

Provides::Provided By API Consumer 
Subscription

[cmdb_ci_api_consumer_subscription]

Dependent

API Product Bundle Contains::Contained 
by

API

[cmdb_ci_api]

Suggested

API Product Bundle Used by::Uses API Consumer 
Subscription

[cmdb_ci_api_consumer_subscription]

Suggested

Related non-CMDB tables

CMDB CI Class Models  v 1.49.0 introduces the following non-CMDB tables as related lists for the 
following API extension classes:

API related list

API Deployment [api_deployment]

Attribute Data type Description

Name String (100) Name of the API 
deployment.

API Reference Reference to the 
deployed API 
(cmdb_ci_api).

Unmatched API Endpoint Reference Reference to the 
unmatched API endpoint, 
if the API doesn't 
match an existing API 
(cmdb_ci_unmatched_api_endpoint).

Configuration Item Reference Reference to the 
Configuration Item. This 
is typically manually 
specified as a reference, if 
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API Deployment [api_deployment]  (continued)

Attribute Data type Description

you know what CI the API 
is deployed to.

Note: 
The API Deployment non-CMDB table relates to both the API [cmdb_ci_api] 
and Unmatched API Endpoint [cmdb_ci_unmatched_api_endpoint] classes.

API Component related list

API Header [api_header]

Attribute Data type Description

Name String (100) Name of the API header.

API Component Reference Reference to the 
component where the 
API header is defined 
(cmdb_ci_api_component).

Unmatched API Endpoint Reference Reference to the 
unmatched API when 
the endpoint can't be 
matched to an existing 
API or component 
(cmdb_ci_unmatched_endpoint).

API Gateway related lists

API Consumer [api_consumer]

Attribute Data type Description

Username String (100)
Name of the API 
consumer.

Note: 
The Consumer  field 
in the api_policy 
table is a reference 
field. To display the 
username in the 
Username  field on 
the API Policies list, 
you must set the 
display  attribute 
of Username  to 
true. If the attribute 
is not set to true, 
then the list displays 
the Sys ID instead.
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API Consumer [api_consumer]  (continued)

Attribute Data type Description

ID String (255) Unique identifier from the 
source system.

Custom ID String (100) Alternate display name of 
the user.

API Gateway Reference Reference to the 
gateway where the 
consumer is defined 
(cmdb_ci_api_gateway).

API Consumer Type Choice list API user type (user_type). 
You can specify:

• Internal

• External

• Unknown

Discovered State String Represents the current 
status of the API 
consumer's account.

Provider String Name of the identity 
management provider 
responsible for 
authenticating the API 
consumer.

Email String Email address of the API 
consumer.

Registration Date Date/Time Date the consumer 
registered with the 
providing platform.

API Consumer Access [api_consumer_access]

Attribute Data type Description

API Consumer Reference Reference to the 
API consumer 
record. For example, 
cmdb_ci_api_consumer.

API Reference Reference to the 
API [cmdb_ci_api] to 
which the consumer is 
requesting access.

Auth Method String Authentication method 
used by the API consumer 
to access the API. For 
example, API key or 
OAuth.
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API Consumer Access [api_consumer_access]  (continued)

Attribute Data type Description

State Choice Indicates whether the 
access is currently active 
or inactive.

Last used Date/Time Last date and time the API 
consumer accessed the 
API.

Valid to Date/Time Expiration date of the 
consumer’s access to the 
API.

API Policy [api_policy]

Attribute Data type Description

Name String (100) Name of the API policy.

ID String (255) Unique identifier from the 
source system.

Frontend Reference Reference to the 
API Frontend 
(cmdb_ci_api_frontend).

Managed API Reference Reference to the 
Managed API 
(cmdb_ci_managed_api).

Consumer Reference Reference to the 
API Consumer 
(api_consumer) non-
CMDB table.

Note: 
Consumer  is a 
reference field. 
To display the 
api_consumer 
(Username) in 
the API Policies 
list, you must set 
the display 
attribute to true  for 
Username  field on 
the api_consumer 
table. If the attribute 
is not set to true, 
then the list displays 
the Sys ID instead.

Protocols String Array of protocols that this 
API policy can apply to.
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API Policy [api_policy]  (continued)

Attribute Data type Description

Active Boolean Determines if this non-
CMDB table is considered 
active or inactive.

API Gateway Reference Reference to the 
gateway where the 
consumer is defined 
(cmdb_ci_api_gateway).

Unmatched API extension classes

The CMDB CI Class Models store app adds or updates classes for unmatched APIs (application 
programming interface).

The app adds class models that extend the CMDB class hierarchy, including class descriptions, 
identification rules, identifier entries, and dependent relationships (if applicable). You can 
use the added classes as any other CMDB class. Applications such as Discovery and Service 
Mapping Patterns  can use these class extensions to populate CIs and discover various 
technologies and software.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Unmatched APIs

API endpoints that are not structured well enough to populate the API [cmdb_ci_api] and API 
Component [cmdb_ci_api_component] classes instead populate the Unmatched API Endpoint 
[cmdb_ci_unmatched_api_endpoint] class. Unmatched APIs are typically used by integrations 
like security scanners or observability tools.

Classes

This section lists the classes that the CMDB CI Class Models store app adds or updates.

CMDB CI Class Models: Release 1.49.0 adds the following class for unmatched API endpoints. 
For the list of CMDB classes in a base system, including ones that this store app might be 
extending, see CMDB tables descriptions.

Class Extends Description

Unmatched API Endpoint

[cmdb_ci_unmatched_api_endpoint]

Configuration Item

[cmdb_ci]

APIs with unstructured 
endpoints that cannot 
populate cmdb_ci_api or 
cmdb_ci_api_component.

Class attributes

CMDB CI Class Models: Release 1.49.0 adds the following attributes to the Unmatched API 
Endpoint [cmdb_ci_unmatched_api_endpoint] class.
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Unmatched API Endpoint [cmdb_ci_unmatched_api_endpoint]

Attribute Data type Description

Method String Backend protocol types of the 
API. Examples:

• Lambda

• HTTP

• Logic App

Protocol String Communication protocol. 
Example: HTTP, HTTPS.

URL String (1024) URL of the resource being 
called.

ID String (1024) Unique identifier from the 
source system.

Internet Facing Boolean Boolean that denotes whether 
the component is reachable 
from the public internet. 
Specify 1 or "true" if the 
component is reachable.

Authorization String Type of authorization or 
authentication method. 
Example:

• Basic

• Key

• Oauth

• None

Request data types String (255) List of data types in the 
request. Examples:

• CC

• Email

• Address

Response data types String (255) List of data types in the 
response. Examples:

• CC

• Email

• Address

Key Relationship Structures

The Unmatched API Endpoint [cmdb_ci_unmatched_api_endpoint] CMDB class and API 
Endpoint Discovered [api_endpoint_discovered] non-CMDB table are intended for scenarios 
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where unstructured API data is ingested and needs to be processed beyond the capabilities of 
IntegrationHub-ETL.

API Endpoint Discovered [api_endpoint_discovered] can serve as a staging table for raw data 
for the API [cmdb_ci_api] and API Component [cmdb_ci_api_component] classes. API data 
that does not come from a well-structured data source or cannot have standard identification 
rules applied can first populate the API Endpoint Discovered [api_endpoint_discovered] 
table. You can then use a customer-defined integration to ensure that well-formed data that 
matches the quality and condition requirements for API [cmdb_ci_api] and API Component 
[cmdb_ci_api_component] populates the most appropriate table.

In cases where the data cannot be correctly parsed or is structured in an unexpected fashion, 
you can instead use a customer-defined integration to populate the Unmatched API Endpoint 
[cmdb_ci_unmatched_api_endpoint] table.

Data that populates the API Endpoint Discovered [api_endpoint_discovered] table is purged 
every 30 days.

API Endpoint Discovered [api_endpoint_discovered]

Attribute Data type Description

Name String (100) Name of the API endpoint.

Method String REST API methods. Examples:

• GET

• POST

• DELETE

URL String (1024) URL of the resource being 
called.

Type Choice list Type of API. You can specify:

• REST

• SOAP

• HTTP

• gRPC

• GraphQL

• Websocket

Authorization String Type of authorization or 
authentication method. 
Example:

• Basic

• Key

• OAuth

• None

Internet Facing Boolean Boolean that denotes whether 
the component is reachable 
from the public internet. 
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API Endpoint Discovered [api_endpoint_discovered]  (continued)

Attribute Data type Description

Specify 1 or "true" if the 
component is reachable.

Request Datatypes String (255) List of data types in the 
request. Examples:

• CC

• Email

• Address

Response Datatypes String (255) List of data types in the 
response. Examples:

• CC

• Email

• Address

Headers String (255) Comma-separated list of 
header names.

Configuration Item Reference Reference to a matching 
CMDB CI (API Component or 
Unmatched API Endpoint).

Related non-CMDB tables

The Unmatched API extension class uses the API Deployment [api_deployment] non-CMDB 
table as a related list:

API Deployment [api_deployment]

Attribute Data type Description

Name String (100) Name of the API deployment.

API Reference Reference to the deployed API 
(cmdb_ci_api).

Unmatched API Endpoint Reference Reference to the unmatched 
API endpoint, if the API 
doesn't match an existing API 
(cmdb_ci_unmatched_api_endpoint).

Configuration Item Reference Reference to the 
Configuration Item. This is 
typically manually specified as 
a reference, if you know what 
CI the API is deployed to.

Avi load balancer extension classes

The CMDB CI Class Models store app adds or updates classes for the Avi load balancer.
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The app adds class models that extend the CMDB  class hierarchy, including class descriptions, 
identification rules, identifier entries, and dependent relationships if applicable. You can use the 
added classes as any other CMDB  class. Applications such as Discovery  and Service Mapping 
patterns can use these class extensions to populate CIs and discover various technologies and 
software.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Avi load balancer

The Avi Vantage platform is built on software-defined principles, enabling a next generation 
architecture to deliver the flexibility and simplicity expected by IT and lines of business. The 
Avi Vantage platform architecture separates the data and control planes to deliver application 
services beyond load balancing, such as application analytics, predictive autoscaling, micro-
segmentation, and self-service, for app owners in on-premises or cloud environments. The 
platform provides a centrally managed, dynamic pool of load balancing resources on commodity 
x86 servers, virtual machines, or containers, to deliver granular services close to individual 
applications. Providing these services allows network services to scale near infinitely without the 
added complexity of managing hundreds of disparate appliances.

Discovery  uses the Avi Vantage load balancer discovery  pattern to find Avi load balancer 
resources.

Avi load balancer classes integrated with the CMDB class hierarchy

Classes

This section lists the classes that the CMDB  CI Class Models store app adds or updates. CMDB 
CI Class Models: Release 1.6.0 adds the following classes for the Avi load balancer. For the list 
of classes in a base system, including classes that this store app might be extending, see CMDB 
tables descriptions.
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Class Extends Description

Avi Controller

[cmdb_ci_avi_controller]

Virtual Machine Object

[cmdb_ci_vm_object]

Avi Controller is a single 
point of management and 
control that is the 'brain' of 
the entire Avi Vantage system, 
and typically deployed as a 
redundant three-node cluster.

Avi Controller Cluster

[cmdb_ci_avi_controller_cluster]

Virtual Machine Object

[cmdb_ci_vm_object]

Avi Controller cluster uses big 
data analytics to analyze the 
data and present actionable 
insights to administrators on 
intuitive dashboards on the 
Avi Admin Console.

Avi Service Engine

[cmdb_ci_avi_service_engine]

Virtual Machine Object

[cmdb_ci_vm_object]

Avi Service Engines (SEs) 
handle all data plane 
operations within Avi Vantage 
by receiving and executing 
instructions from the Avi 
Controller.

Class columns

CMDB CI Class Models: Release 1.6.0 adds the following column to the respective class.

Avi Service Engine [cmdb_ci_avi_service_engine]

Added column Description

version The version of the Avi Service Engine 
resource.

Related topics

CMDB schema model

BYOL model of RDS for Oracle  extension classes

The CMDB CI Class Models store app adds or updates classes for the BYOL Model of RDS for 
Oracle.

The app adds class models that extend the CMDB  class hierarchy, including class descriptions, 
identification rules, identifier entries, and dependent relationships if applicable. You can use the 
added classes as any other CMDB  class. Applications such as Discovery  and Service Mapping 
patterns can use these class extensions to populate CIs and discover various technologies and 
software.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .
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BYOL Model of RDS for Oracle

The Amazon  RDS for Oracle  is a fully managed commercial database that makes it easy to set up, 
operate, and scale Oracle  deployments in the cloud. You can run Amazon RDS for Oracle  under 
two different licensing models – “License Included” and “Bring-Your-Own-License (BYOL)“. In the 
“License Included” service model, you do not need separately purchased Oracle  licenses; the 
Oracle  Database software has been licensed by AWS.

We support discovery of the RDS Databases and their licenses.

Classes

This section lists the classes that the CMDB  CI Class Models store app adds or updates. CMDB 
CI Class Models: Release 1.23.0 adds the following classes for the BYOL Model of RDS for 
Oracle. For the list of classes in a base system, including classes that this store app might be 
extending, see CMDB tables descriptions.

Class Description

cmdb_ci_cloud_database The cloud databases.

cmdb_ci_serverless_hardware Hardware type information of the databases.

Class Columns

CMDB CI Class Models: Release 1.23.0 adds the following column to the respective class.

Serverless Hardware [cmdb_ci_serverless_hardware]

Added column Description

cloud_vendor The cloud vendor.

host_type The host type such as PaaS/IaaS.

cpu_core_count Amount of CPU cores.

cpu_core_thread Amount of CPU threads.

cpu_count Amount of CPUs.

object_id ID of the CI.

Cloud Database [cmdb_ci_cloud_database]

Added column Description

multi_az Determines if the database is deployed on 
multiple availability zones (true/false).

replication_enabled Determines if replication is enabled (true/
false).

replication_type Replication type.

replica_source Database name of the replication source.

Firewall extension classes

The CMDB CI Class Models store app adds or updates classes for firewall devices.
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The app adds class models that extend the CMDB  class hierarchy, including class descriptions, 
identification rules, identifier entries, and dependent relationships (if applicable). You can 
use the added classes as any other CMDB  class. Applications such as Discovery  and Service 
Mapping  patterns can use these class extensions to populate CIs and discover various 
technologies and software.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Firewalls

A firewall is a network security system that monitors and controls incoming and outgoing network 
traffic, based on security policies. Firewalls typically form a barrier between an internal network 
and an untrusted external network, such as the internet. It usually consists of security policies 
that help secure an organization from external threats and cyber attacks. Firewall vendors may 
provide a centralized firewall manager to manage many firewall devices and the security policies 
residing on them. For example, Panorama™  is the centralized management system for Palo Alto 
Networks firewalls.

Firewall extension classes integrated with the CMDB class hierarchy (CMDB CI 
Class Models: Release 1.11.0)
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Firewall extension classes integrated with the CMDB class hierarchy (CMDB CI 
Class Models: Release 1.10.0)

Classes

This section lists the classes that the CMDB  CI Class Models store app adds or updates.

CMDB CI Class Models: Release 1.10.0 adds or updates the following classes for the discovery of 
network firewall devices. For the list of CMDB classes in a base system, including ones that this 
store app might be extending, see CMDB tables descriptions.

Class Extends Description

IP Firewall 
[cmdb_ci_ip_firewall]

NETGEAR [cmdb_ci_netgear] Contains all network firewalls.

Firewall Device 
[cmdb_ci_firewall_device]

IP Firewall 
[cmdb_ci_ip_firewall]

Network security system 
that monitors and controls 
incoming and outgoing 
network traffic, based on 
security policies.
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Class Extends Description

Fortinet Firewall Device 
[cmdb_ci_firewall_device_fortinet]

Firewall Device 
[cmdb_ci_firewall_device]

Fortinet firewall device.

Juniper Firewall Device 
[cmdb_ci_firewall_device_juniper]

Firewall Device 
[cmdb_ci_firewall_device]

Juniper firewall device.

Firewall Device Group 
[cmdb_ci_firewall_device_group]

CMDB CI [cmdb_ci] Group of firewall devices.

Panorama Firewall 
Device Group 
[cmdb_ci_firewall_device_group_panorama]

Firewall Device Group 
[cmdb_ci_firewall_device_group]

Group of Panorama firewall 
devices.

Palo Alto Firewall Device 
[cmdb_ci_firewall_device_palo_alto]

Firewall Device 
[cmdb_ci_firewall_device]

Palo Alto firewall device.

Firewall Cluster 
[cmdb_ci_firewall_cluster]

[cmdb_ci_cluster] Group of firewall nodes that 
work as a single logical entity.

Fortinet Firewall Cluster 
[cmdb_ci_firewall_cluster_fortinet]

Firewall Cluster 
[cmdb_ci_firewall_cluster]

Fortinet firewall cluster.

Juniper Firewall Cluster 
[cmdb_ci_firewall_cluster_juniper]

Firewall Cluster 
[cmdb_ci_firewall_cluster]

Juniper firewall cluster.

Firewall Manager 
[cmdb_ci_firewall_manager]

CMDB CI [cmdb_ci] System that provides 
centralized management for 
many firewall devices and the 
security policies residing on 
them.

Panorama Firewall Manager 
[cmdb_ci_firewall_manager_panorama]

Firewall Manager 
[cmdb_ci_firewall_manager]

The centralized network 
security management tool for 
Palo Alto Networks firewalls.

Firewall Security Policy 
[cmdb_ci_firewall_sec_policy]

CMDB CI [cmdb_ci] The security policy that the 
firewall device enforces.

Panorama Firewall 
Security Policy 
[cmdb_ci_firewall_sec_policy_panorama]

Firewall Security Policy 
[cmdb_ci_firewall_sec_policy]

The security policy that the 
Panorama firewall device 
enforces.

CMDB CI Class Models: Release 1.12.0 adds the following class for the discovery of network 
firewall devices.

Class Extends Description

Cisco Firewall Device 
[cmdb_ci_firewall_device_cisco]

Firewall Device 
[cmdb_ci_firewall_device]

All Cisco Firewall devices.

Class columns

CMDB CI Class Models: Release 1.10.0 adds the following columns to the respective classes.

IP Firewall [cmdb_ci_ip_firewall] class

Added columns Description

Hardware Operating System OS running on the hardware.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

121



IP Firewall [cmdb_ci_ip_firewall] class  (continued)

Added columns Description

Hardware OS Version OS version running on the hardware.

Firewall Cluster [cmdb_ci_firewall_cluster] class

Added columns Description

Hardware Operating System OS running on the hardware.

Hardware OS Version OS version running on the hardware.

CMDB CI Class Models: Release 1.12.0 adds no columns to the existing classes.

Related topics

CMDB schema model

IBM Hardware Management Console (HMC) extension classes

The CMDB CI Class Models store app adds or updates classes for the IBM Hardware 
Management Console (HMC).

The app adds class models that extend the CMDB  class hierarchy, including class descriptions, 
identification rules, identifier entries, and dependent relationships if applicable. You can use the 
added classes as any other CMDB  class. Applications such as Discovery  and Service Mapping 
patterns can use these class extensions to populate CIs and discover various technologies and 
software.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

IBM Hardware Management Console (HMC)

The IBM HMC extension classes support discovery of IBM virtualization technology by providing:

• Discovery of LPARs/FRAMEs, which SAM use cases need

• Topology data of IBM HMC, which event correlation requires

• Topology data for ITSM use cases, such as in-frame migration
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IBM HMC extension classes integrated with the CMDB class hierarchy

Classes

This section lists the classes that the CMDB  CI Class Models store app adds or updates. See the 
class columns table for further details about the columns added for each class.

CMDB CI Class Models: Release 1.3.0 adds the following classes for the IBM HMC. For the list 
of CMDB classes in a base system, including ones that this store app might be extending, see 
CMDB tables descriptions.

Class Extends Description

IBM Frame

[cmdb_ci_ibm_frame]

Server

[cmdb_ci_server]

IBM physical machine with 
considerable resources which 
can be virtualized.

IBM HMC Processor pool

[cmdb_ci_processor_pool]

Virtual Machine Object

[cmdb_ci_vm_object]

IBM shared pool used to 
allocate processors to a group 
of LPARs.

CMDB CI Class Models: Release 1.2.0 adds the following classes for the IBM HMC.

Class Extends Description

IBM HMC Server 
[cmdb_ci_hmc_server]

Server [cmdb_ci_server] IBM console that manages 
frames and assigns logical 
partitions (LPARs) to pools.

IBM Frame 
[cmdb_ci_ibm_frame]

Server [cmdb_ci_server IBM physical machine with 
considerable resources which 
can be virtualized.
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Class Extends Description

IBM LPAR Instance 
[cmdb_ci_lpar_instance]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

IBM logical partition 
representing the virtual aspect 
of the operating system.

LPAR Resource 
[cmdb_ci_lpar_resource]

Configuration Item [cmdb_ci] Resource of an LPAR instance.

IBM HMC Processor pool 
[cmdb_ci_processor_pool]

Virtual Machine Object 
[cmdb_ci_vm_object]

IBM shared pool used to 
allocate processors to a group 
of LPARs.

Class columns

CMDB CI Class Models: Release 1.3.0 adds the following columns to the respective classes.

IBM Frame [cmdb_ci_ibm_frame] class

Added columns Description

Current available processor units Current available processor units.

Configurable processor units Configurable processor units.

Configurable memory units Configurable memory units.

Installed processor units Installed processor units.

Current available memory units Current available memory units.

Installed memory units Installed memory units.

IBM HMC Processor pool [cmdb_ci_processor_pool] class

Added columns Description

LPAR IDs LPAR IDs.

LPAR names LPAR names.

Frame name Frame name.

CMDB CI Class Models: Release 1.2.0 adds the following columns to the respective classes.

IBM HMC Server [cmdb_ci_hmc_server] class

Added columns Description

Frame count Count of frames.

Added columns Description

Is VIO Flags whether this VM is a (VIO) virtual input/
output server in the HMC topology.

High Watermark VCPU Peak in the utilization of virtual CPU assigned 
to during the reporting period.
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Added columns Description

Frame Serial Number Serial number of a frame (frame being a 
physical machine such as ESX).

VIO Servers List of VIO servers.

LPAR Resource [cmdb_ci_lpar_resource] class

Added columns Description

Node name Name of the node.

Partition Name Name of the partition.

Partition Number Number of the partition.

Type Type of LPAR Resource.

Mode Mode of LPAR Resource.

Entitled Capacity Allotted capacity granted.

Partition Group-ID ID of a group of partitions.

Shared Pool ID ID of a pool of shared processors.

Online Virtual CPUs A virtual CPU.

Maximum Memory Maximum amount of memory.

Minimum Memory Minimum amount of memory.

Variable Capacity Weight Logical partition processor capacity weight.

Minimum Capacity Minimum number of processes.

Capacity Increment Increments of process.

Maximum Physical CPUs in system Maximum CPUs allotted in system.

Active Physical CPUs in system Current CPUs in system.

Active CPUs in Pool Number of active CPUs within a pool.

Shared Physical CPUs in system Number of shared CPUs within a system.

Maximum Capacity of Pool Maximum capacity of processes within a pool.

Entitled Capacity of Pool Number of processes that are entitled.

Unallocated Capacity Number of free spaces.

Physical CPU Percentage Number of CPUs allocated to system.

Unallocated Weight At no extra charge resources on instance.

Desired Virtual CPUs Target number of virtual CPUs.

Desired Memory Target amount of memory.

Desired Variable Capacity Weight Targeted processor load.

Desired Capacity Target resources used within instance.

High Watermark VCPU Peak in the utilization of virtual CPU assigned 
to during the reporting period.
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IBM HMC Processor pool [cmdb_ci_processor_pool] class

Added columns Description

Pool ID ID of pool of processors.

CPU Core count Number of CPU cores.

Memory count Amount of memory used.

Unassigned cores Number of unused cores.

Unassigned memory Amount of unassigned memory.

The following class has no added columns: IBM Frame [cmdb_ci_ibm_frame].

Related topics

CMDB schema model

Internet of Things (IoT) extension classes

The CMDB CI Class Models store app adds or updates classes for the Internet of Things (IoT).

The app adds class models that extend the CMDB  class hierarchy, including class descriptions, 
identification rules, identifier entries, and dependent relationships if applicable. You can use the 
added classes as any other CMDB  class. Applications such as Discovery  and Service Mapping 
patterns can use these class extensions to populate CIs and discover various technologies and 
software.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Internet of Things (IoT)

IoT is a system of interrelated computing devices, mechanical and digital machines, objects, 
animals or people that are provided with unique identifiers and the ability to transfer data over 
a network without requiring human-to-human or human-to-computer interaction. The classes 
added in this release, extend the Data Model to provide a foundation for the representation of 
IoT CI classes. This foundation underpins workflows for Enterprise Asset Management (EAM), 
Governance Risk Compliance (GRC), Component Supply Management (CSM), and Field Service 
Management (FSM) surrounding the management of IoT devices and the transport vehicles that 
some reside in.
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IoT extension classes integrated with the CMDB class hierarchy

Classes

This section lists the classes that the CMDB  CI Class Models store app adds or updates.

CMDB CI Class Models: Release 1.6.0 adds the following classes for IoT. For the list of CMDB 
classes in a base system, including ones that this store app might be extending, see CMDB 
tables descriptions.

Class Extends Description

Transport Type

[cmdb_ci_transport]

cmdb_ci Types of transportation that 
contain interconnected 
technology.

Converged Infrastructure

[cmdb_ci_converged_infra]

cmdb_ci_hardware Devices that serve both 
computing and networking 
functions.

IoT Device

[cmdb_ci_IoT]

cmdb_ci_hardware Parent table that contains 
Internet of Things device 
types.

Aircraft

[cmdb_ci_aircraft]

Transport Type

[cmdb_ci_transport]

A transportation method that 
utilizes air or space as its 
primary pathway. For example, 
airplanes and helicopters.

Ship

[cmdb_ci_ship]

Transport Type

[cmdb_ci_transport]

A transportation method that 
utilizes water as its primary 
pathway. For example, ships.

Train

[cmdb_ci_train]

Transport Type

[cmdb_ci_transport]

A transportation method that 
utilizes rails as its primary 
pathway. For example, Amtrak.

Vehicle

[cmdb_ci_vehicle]

Transport Type

[cmdb_ci_transport]

A transportation method that 
utilizes wheels or tracks as 
its method of movement. 
For example, cars, trucks, 
bulldozers.

IoT Gateway Converged Infrastructure A device that provides the 
following services:
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Class Extends Description

[cmdb_ci_IoT_gateway] [cmdb_ci_converged_infra] • Forwards packets between 
LAN and WAN on the IP 
layer.

• Performs application layer 
functions between IoT 
nodes and other entities.

• Enables local, short-range 
communication between IoT 
devices.

Security Device

[cmdb_ci_security]

IoT Device

[cmdb_ci_IoT]

Connected device that serves 
a security function such as 
badge readers.

Single Board Computing

[cmdb_ci_sbc]

IoT Device

[cmdb_ci_IoT]

Single Board Computing 
device such as a Raspberry Pi.

Display Device

[cmdb_ci_display]

IoT Device

[cmdb_ci_IoT]

Connected device that 
displays images.

Imaging Device

[cmdb_ci_imaging]

IoT Device

[cmdb_ci_IoT]

Connected device that 
captures images.

Medical Device

[cmdb_ci_medical]

IoT Device

[cmdb_ci_IoT]

Connected device that serves 
a Medical Care function such 
as a nurse call unit.

Manufacturing Device

[cmdb_ci_manufacturing]

IoT Device

[cmdb_ci_IoT]

Connected device that helps 
a manufacturing process.

Multimedia Device

[cmdb_ci_multimedia]

IoT Device

[cmdb_ci_IoT]

A connected device that helps 
the generation or delivery of 
media content.

Payment Device

[cmdb_ci_payment]

IoT Device

[cmdb_ci_IoT]

Connected device that allows 
for purchasing goods or 
services.

Drone

[cmdb_ci_drone]

IoT Device

[cmdb_ci_IoT]

Unmanned connected device 
with mobility.

Wearable Technology

[cmdb_ci_wearable]

IoT Device

[cmdb_ci_IoT]

Connected device that is worn 
by an entity such as a smart 
watch.

Smart Television

[cmdb_ci_stv]

Display Device

[cmdb_ci_display]

A television that is network 
connected and can run 
applications.

IP Camera Imaging Device A camera that is network 
connected.
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Class Extends Description

[cmdb_ci_ip_camera] [cmdb_ci_imaging]

Patient Monitoring

[cmdb_ci_med_patient_monitoring]

Medical Device

[cmdb_ci_medical]

Monitors and tracks various 
physiological parameters of 
a patient. Monitors heart rate, 
blood pressure, oxygen levels, 
respiratory rate, and so on.

Surgical Instrument

[cmdb_ci_med_surgical_instrument]

Medical Device

[cmdb_ci_medical]

Devices used during surgical 
interventions. Life support 
tools and tools to assist 
surgeons in precise and 
controlled maneuvers.

Lab Equipment

[cmd_ci_med_lab_equipment]

Medical Device

[cmdb_ci_medical]

Specialized tools, apparatus, 
and instruments used 
in scientific research, 
experiments, and analyses.

Patient Implant

[cmdb_ci_med_patient_implant]

Medical Device

[cmdb_ci_medical]

Medical devices or tissues 
that are surgically placed 
inside a patient's body.

Clinical Device

[cmdb_ci_med_clinical_device]

Medical Device

[cmdb_ci_medical]

Devices used in a 
clinical setting for overall 
management, medical staff, 
and patient aid.

Diagnostic Imaging

[cmd_ci_med_diagnostic_imaging]

Medical Device

[cmdb_ci_medical]

Specialized equipment used 
in medicine to visualize the 
internal structures of the body.

Therapeutic Device

[cmdb_ci_med_therapeutic_device]

Medical Device

[cmdb_ci_medical]

Specialized tools designed 
to aid in the treatment, 
rehabilitation, or management 
of health conditions. Can 
range from orthopedic 
supports to cardiac implants 
and neurostimulation devices.

Process Logic Controller

[cmdb_ci_plc]

Manufacturing Device

[cmdb_ci_manufacturing]

A logic controller that is 
network connected which is 
used in manufacturing. For 
example, devices made by 
Siemens and Allen Bradley.

Human Machine Interface

[cmdb_ci_hmi]

Manufacturing Device

[cmdb_ci_manufacturing]

An HMI that is network 
connected which is used in 
manufacturing. For example, 
devices made by Siemens 
and Allen Bradley.

Game Console

[cmdb_ci_game_console]

Multimedia Device

[cmdb_ci_multimedia]

A device that is network 
connected which is used to 
play games or stream media. 
For example, an Xbox or 
Playstation.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

129



Class Extends Description

Media Player

[cmdb_ci_media_player]

Multimedia Device

[cmdb_ci_multimedia]

A device that is network 
connected which is used to 
play digital media content. For 
example, Amazon Fire TV.

Display Monitor Control

[cmdb_ci_monitor_control]

Multimedia Device

[cmdb_ci_multimedia]

A device that is network 
connected that controls the 
display of media on a monitor. 
For example, a Crestron Media 
Controller.

Point of Sale Device

[cmdb_ci_pos]

Payment Device

[cmdb_ci_payment]

A device that is network 
connected which is used in 
the purchase of goods or 
services. For example, a credit 
card reader.

Related topics

CMDB schema model

Kong extension classes

The CMDB CI Class Models store app adds or updates classes for Kong gateways.

The app adds class models that extend the CMDB class hierarchy, including class descriptions, 
identification rules, identifier entries, and dependent relationships (if applicable). You can 
use the added classes as any other CMDB class. Applications such as Discovery and Service 
Mapping Patterns  can use these class extensions to populate CIs and discover various 
technologies and software.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Kong

Kong is an API management platform that enables enterprise companies to better manage client 
and host traffic.

Classes

This section lists the classes that the CMDB CI Class Models store app adds or updates.

CMDB CI Class Models: Release 1.49.0 adds the following classes for Kong. For the list of CMDB 
classes in a base system, including ones that this store app might be extending, see CMDB 
tables descriptions.

Class Extends Description

Kong Gateway

[cmdb_ci_kong_gateway]

API Gateway

[cmdb_ci_api_gateway]

The Kong gateway application 
that hosts and manages 
individual APIs. Example: Kong 
Gateway instanceName.
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Class Extends Description

Kong Load Balancer

[cmdb_ci_kong_lb]

Load Balancer Application

[cmdb_ci_lb_appl]

The default load balancer on 
the Kong gateway application 
that points to backend service 
instances when fulfilling API 
requests. Example: httpbin-
upstream.

Kong Target

[cmdb_ci_kong_target]

API Component

[cmdb_ci_api_component]

The load-balanced backend 
of the gateway that fulfills API 
requests. Example: httpbin-
target1.

Class attributes

CMDB CI Class Models: Release 1.49.0 adds the following attributes to the respective classes.

Kong Gateway [cmdb_ci_kong_gateway]

Attribute Data type Description

Admin URL String (255) URL for making admin API 
requests.

Database String Type of database used by 
the Kong gateway. Example: 
Postgres or Cassandra.

Kong Load Balancer [cmdb_ci_lb_appl]

Attribute Data type Description

Algorithm String Type of algorithm used for 
load balancing. Example: 
round robin.

ID String (255) Unique identifier from the 
source system.

Kong Target [cmdb_ci_kong_target]

Attribute Data type Description

Target String (255) URL of target integration.

Key Relationship Structures

There are a number of key relationships that must be defined for API and Kong classes.

Kong relationships

Parent class Relationship Child class Relationship type

API Backend 
[cmdb_ci_api_backend]

Uses::Used By Kong Load Balancer Suggested
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Kong relationships  (continued)

Parent class Relationship Child class Relationship type

Kong Load Balancer 
[cmdb_ci_lb_appl]

Contains::Contained 
By

Kong Target Dependent

Kong Gateway 
[cmdb_ci_kong_gateway]

Provides::Provided By Kong Load Balancer Dependent

Related non-CMDB tables

The Kong Gateway class uses the Kong Workspace non-CMDB table as a related list:

Kong Workspace [kong_workspace]

Attribute Data type Description

Name String (100) Name of the Kong workspace.

ID String (255) Unique identifier from the 
source system.

API Gateway Reference Reference to the Kong API 
gateway.

Kong gateway example

Here is an example of a dependency view for the Kong gateway class that shows how a 
gateway would populate the dependent managed API-dependent class with related APIs 
and components. The Managed API class is considered a first-level relationship with respect 
to the gateway, while the frontend and backend components are considered second-level 
relationships. From here, you can then bind alerts to these CIs, configure dynamic CIs for service 
views and incidents, or establish any additional workflows that use CIs.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

132



Kubernetes extension classes

The CMDB CI Class Models store app adds or updates classes for the Kubernetes pattern.

The app adds class models that extend the CMDB  class hierarchy, including class descriptions, 
identification rules, identifier entries, and dependent relationships if applicable. You can use the 
added classes as any other CMDB  class. Applications such as Discovery  and Service Mapping 
patterns can use these class extensions to populate CIs and discover various technologies and 
software.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Kubernetes pattern

The Kubernetes pattern main flow helps with discovering Kubernetes core elements. The classes 
in this release, extend the support to discover kubernetes workload controller components like 
deployments, daemonsets, and statefulsets. The Workload Share library captures information 
about deployments, daemonsets, and statefulsets and stores them in the respective tables. 
Other extensions include a YAML and service mesh extension that generates a YAML file to 
track configuration files and creating service to service relations by discovering service mesh 
information.
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Kubernetes extension class integrated with the CMDB hierarchy

Kubernetes workload

Classes

This section lists the classes that the CMDB  CI Class Models store app adds or updates.

CMDB CI Class Models: Release 1.12.0 adds the following classes for Kubernetes pattern. For the 
list of CMDB classes in a base system, including ones that this store app might be extending, see 
CMDB tables descriptions.
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Class Extends Fields Relation

cmdb_ci_kubernetes_workloadcmdb_ci_kubernetes_components Provides from 
cmdb_ci_kubernetes_service

cmdb_ci_kubernetes_deploymentcmdb_ci_kubernetes_workload• Replicas Desired

• Replicas Updated

• Replicas Total

• Replicas Available

• Replicas 
Unavailable

Hosted on Cluster

cmdb_ci_kubernetes_daemonsetcmdb_ci_kubernetes_workload• Pods running

• Pods Waiting

• Pods Succeeded

• Pods Failed

• Pods Available

Hosted on Cluster

cmdb_ci_kubernetes_statefulsetcmdb_ci_kubernetes_workload• Pods running

• Pods Waiting

• Pods Succeeded

• Pods Failed

• Pods Available

Hosted on Cluster

Related topics

CMDB schema model

Network Intrusion Detection System (NIDS) CI extension class

The Network Intrusion Detection System (NIDS) [cmdb_ci_nids] class builds the relationships 
between passive network monitoring appliances, and the devices on the network that it 
discovers. A NIDS Manager manages the NIDS sensors that detect the devices and builds 
"Detects::detected by” relationships between the NIDS records (parent) and the CIs it discovers 
(child).​

This topic lists the relevant classes that the CMDB  CI Class Models store app adds or updates. 
See the class columns table for further details about the columns added for each class.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .
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Network Intrusion Detection System (NIDS) schema structure​

Classes

CMDB CI Class Models: Release 1.30 adds the following classes for the Network Intrusion 
Detection System (NIDS). For the list of CMDB classes in a base system, including ones that this 
store app might be extending, see CMDB tables descriptions.

Class Extends Description

Network Intrusion Detection 
System (NIDS) (cmdb_ci_nids)

cmdb_ci_ids_network NIDS is an intrusion detection 
system within the network that 
examines the traffic from all 
devices on the network. NIDS 
scanners build relationships 
between the OT network 
scanning appliances, and the 
OT devices on the network. An 
NIDS Manager manages the 
NIDS sensors.​

Class columns

CMDB CI Class Models: Release 1.30 adds the following columns to the Network Intrusion 
Detection System (NIDS) [cmdb_ci_nids] class.

Network Intrusion Detection System (NIDS) [cmdb_ci_nids] class

Column label Column name Description

NIDS source ID Correlation_id Identifier of the NIDS 
device. Uses the assigned 
Correlation ID for the NIDS as 
its nids_source_id.

NIDS source name nids_source_name Name of the NIDS device.

Network type assignment network_type_assignment Designates if the device is on 
an IT or OT network.
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Network Intrusion Detection System (NIDS) [cmdb_ci_nids] class  (continued)

Column label Column name Description

NIDS assignment site isa_entity_site ISA site assigned to the NIDS. 
This information is available 
when the logged in user has 
an assigned ISA Admin role.

Roles and Access Control Logic (ACLs)

The NIDS Admin (cmdb_nids_admin)  role is associated with the Network Intrusion Detection 
System (NIDS) [cmdb_ci_nids] class: Can create, read, update, and delete Network IDS (NDIS) OT 
records. To view the Network IDS Application selection on the application menu, you must have 
this role.

Key relationship structure

For each CMDB CI record with a “Detected by” relationship with an NIDS record, a ServiceNow 
Operational Technology  Certified Service Graph  Connector does the following:

1. Assigns the following NIDS-related metadata values to the CI:

a. Location

b. Company

c. Related users (Owned by, Managed by, Supported by, Assigned to)

d. Related user groups (Approval group, Managed by Group, Support group, Change group)

2. If the NIDS network type is set to OT, it assigns the following NIDS-related metadata values to 
the CI:

a. Creates an OT device (cmdb_ot_entity) record for the CI, using the cmdb_ot_entity reference 
on the CI.

b. Assigns the NIDS assignment zone to the OT device record.

c. If the Industrial Process Manager  is installed, assign the NIDS assignment site to the OT 
device record.

Network Inventory (NI) extension classes

The CMDB CI Class Models store app adds or updates classes for the Telecommunications 
Network Inventory  application. Telecommunications Network Inventory  uses the Network 
Inventory (NI) extension classes to extend the Configuration Management Database (CMDB) 
Configuration Item (CI) class hierarchy.

These extensions enable the CMDB  to store information about a service provider's network 
inventory. The store app adds class models that extend the CMDB  class hierarchy, including:

• Class descriptions

• Identification rules

• Identifier entries

• Dependent relationships, if applicable.

With the ServiceNow  Telecommunications Network Inventory  application, you can build a 
digital representation of your physical and logical networks. This application uses the NI class 
extensions to populate CIs that form the basis of your digital network inventory model. To learn 
more, see Telecommunications Network Inventory .
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Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Telecommunications Network Inventory  (NI) schema structure​

Classes

This section lists the relevant classes that the CMDB  CI Class Models store app adds or updates. 
See the class columns table for further details about the columns added for each class. For the 
list of CMDB classes in a base system, including ones that this store app might be extending, see 
CMDB tables descriptions.

NI extension classes

Class Extends Description

Network Site [cmdb_ci_ni_site] Site [cmdb_ci_site] Network Site.

Captures and maintains the 
location-specific attributes for 
each network site, including 
the network centers, 
buildings, floors, and rooms 
where equipment is located.

The network site records 
enable you to view all the 
equipment at a location. You 
can filter the locations by 
the assigned type, role, or 
function categories.

Telco Equipment Holder 
[cmdb_ci_ni_equipment_holder]

Equipment Holder 
[cmdb_ci_equipment_holder]

Telco Equipment Holder.
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NI extension classes  (continued)

Class Extends Description

Represents the physical 
units that contain the 
telecommunications 
equipment, including the 
cages, bays, cabinets, slots, 
relay racks, and line ups. The 
line ups contain the individual 
relay racks. Each relay rack 
contains the equipment 
shelves. The equipment 
holders can contain the other 
equipment holders.

The equipment holder 
records enable you to track 
and manage your network 
assets.

Telco Equipment 
[cmdb_ci_ni_telco_equipment]

Network gear 
[cmdb_ci_netgear]

Telco Equipment.

Represents a shelf or device 
that provides the technical 
functionality in a network. 
Examples include the routers, 
modems, mobile devices, 
optical cables, relays, and 
switches. The equipment can 
have slots, cards, or ports. 
The equipment can exist 
within an equipment holder 
or by itself because not all 
equipment is rack mounted.

The equipment records 
enable you to track and 
manage your network assets.

Network Interface 
[cmdb_ci_ni_interface]

Network Port 
[cmdb_ci_ni_network_port]

Network Interface.

Captures and maintain 
equipment-specific attributes 
for the network interfaces.

Interface Card 
[cmdb_ci_interface_card]

Hardware 
[cmdb_ci_hardware]

Interface Card.

Represents interface cards 
that are stored in a network. 
Cards can occupy more 
than one slot and can 
contain other cards. They 
can be the equipment 
ports that are physical or 
logical (virtual). Each port 
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NI extension classes  (continued)

Class Extends Description

is assigned a bandwidth 
value. The bandwidths are 
consumed when used in 
network designs.

Physical Connection 
[cmdb_ci_ni_physical_link]

Network Link 
[cmdb_ci_network_link]

Physical Connection.

Represents the physical port 
connections on the interface 
cards in your networks.

Logical Connection 
[cmdb_ci_ni_logical_path]

Network Circuit 
[cmdb_ci_network_circuit]

Logical Connection.

Represents the logical or 
virtual port connections on 
the network interface cards. 
A logical connection typically 
represents the multiple 
physical connections on an 
interface card.

Nutanix extension classes

The CMDB CI Class Models store app adds or updates classes for Nutanix.

The app adds class models that extend the CMDB  class hierarchy, including class descriptions, 
identification rules, identifier entries, and dependent relationships if applicable. You can use the 
added classes as any other CMDB  class. Applications such as Discovery  and Service Mapping 
patterns can use these class extensions to populate CIs and discover various technologies and 
software.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Nutanix Enterprise Cloud platform

The Nutanix Enterprise Cloud platform is a converged, scale-out compute and storage system 
that hosts and stores virtual machines. All nodes in a Nutanix cluster share the management of 
cluster resources. The foundational unit for the cluster is a Nutanix node which runs a standard 
hypervisor and contains processors, memory, and local storage (SSDs and hard disks). A Nutanix 
Controller virtual machine runs on each node, enabling the pooling of local storage from all 
nodes in the cluster.

Classes

This section lists the classes that the CMDB  CI Class Models store app adds or updates. See the 
class columns table for further details about the columns added for each class.

CMDB CI Class Models: Release 1.6.0 adds the following classes for Nutanix. For the list of 
CMDB classes in a base system, including ones that this store app might be extending, see 
CMDB tables descriptions.
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Class Extends Description

Nutanix Prism Central

[cmdb_ci_nutanix_prism_central]

Virtual Machine Object

[cmdb_ci_vm_object]

Multi-cluster manager 
responsible for managing 
multiple Acropolis Clusters to 
provide a single, centralized 
management interface.

CMDB CI Class Models: Release 1.2.0 adds the following classes for Nutanix.

Class Extends Description

Nutanix Cluster

[cmdb_ci_nutanix_cluster]

Virtual Machine Object

[cmdb_ci_vm_object]

Cluster comprising of the 
physical nodes running 
Nutanix software.

Nutanix Controller VM

[cmdb_ci_nutanix_controller_vm]

Application

[cmdb_ci_appl]

Nutanix controller virtual 
machine that is present in 
each node and that provides 
the storage clustering and 
management capabilities.

Nutanix Storage Container

[cmdb_ci_nutanix_storage_container]

Storage Volume

[cmdb_ci_storage_volume]

Subset of Nutanix storage 
pool used to apply policies 
such as reserved capacity, 
replication factor, and storage 
optimization options.

Nutanix Storage Pool

[cmdb_ci_nutanix_storage_pool]

Storage Pool

[cmdb_ci_storage_pool]

Grouping of physical disks 
within a Nutanix cluster which 
is typically used to create 
physical separation between 
virtual machines.

Nutanix Host

[cmdb_ci_nutanix_host]

Virtualization Server

[cmdb_ci_virtualization_server]

Physical host on which all the 
virtual machines run.

Nutanix Virtual Machine 
Instance

[cmdb_ci_nutanix_vm_instance]

Virtual Machine Instance

[cmdb_ci_vm_instance]

A virtual machine that runs on 
Nutanix infrastructure.

CMDB CI Class Models: Release 1.1.5 adds the following classes for Nutanix.

Class Extends Description

Nutanix Cluster

[cmdb_ci_nutanix_cluster]

Virtual Machine Object

[cmdb_ci_vm_object]

Cluster comprising of the 
physical nodes running 
Nutanix software.

Nutanix Controller VM

[cmdb_ci_nutanix_controller_vm]

Application

[cmdb_ci_appl]

Nutanix controller virtual 
machine that is present in 
each node and that provides 
the storage clustering and 
management capabilities.
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Class Extends Description

Nutanix Storage Container

[cmdb_ci_nutanix_storage_container]

Storage Volume

[cmdb_ci_storage_volume]

Subset of Nutanix storage 
pool used to apply policies 
such as reserved capacity, 
replication factor, and storage 
optimization options.

Nutanix Storage Pool

[cmdb_ci_nutanix_storage_pool]

Storage Pool

[cmdb_ci_storage_pool]

Grouping of physical disks 
within a Nutanix cluster which 
is typically used to create 
physical separation between 
virtual machines.

Nutanix Host

[cmdb_ci_nutanix_host]

Virtualization Server

[cmdb_ci_virtualization_server]

Physical host on which all the 
virtual machines run.

Nutanix Virtual Machine 
Instance

[cmdb_ci_nutanix_vm_instance]

Virtual Machine Instance

[cmdb_ci_vm_instance]

A virtual machine that runs on 
Nutanix infrastructure.

CMDB CI Class Models: Release 1.1.4 adds the following classes for Nutanix.

Nutanix Cluster

[cmdb_ci_nutanix_cluster]

Virtual Machine Object

[cmdb_ci_vm_object]

Cluster comprising of the 
physical nodes running 
Nutanix software.

Nutanix Controller VM

[cmdb_ci_nutanix_controller_vm]

Application

[cmdb_ci_appl]

Nutanix controller virtual 
machine that is present in 
each node and that provides 
the storage clustering and 
management capabilities.

Nutanix Storage Container

[cmdb_ci_nutanix_storage_container]

Storage Volume

[cmdb_ci_storage_volume]

Subset of Nutanix storage 
pool used to apply policies 
such as reserved capacity, 
replication factor, and storage 
optimization options.

Nutanix Storage Pool

[cmdb_ci_nutanix_storage_pool]

Storage Pool

[cmdb_ci_storage_pool]

Grouping of physical disks 
within a Nutanix cluster which 
is typically used to create 
physical separation between 
virtual machines.

Nutanix Host

[cmdb_ci_nutanix_host]

Virtualization Server

[cmdb_ci_virtualization_server]

Physical host on which all the 
virtual machines run.

Nutanix Virtual Machine 
Instance

[cmdb_ci_nutanix_vm_instance]

Virtual Machine Instance

[cmdb_ci_vm_instance]

A virtual machine that runs on 
Nutanix infrastructure.
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Class columns

CMDB CI Class Models: Release 1.6.0 adds no columns to the Nutanix Prism Central 
[cmdb_ci_nutanix_prism_central] class.

CMDB CI Class Models: Release 1.2.0 adds the following columns to the respective classes.

Nutanix Cluster [cmdb_ci_nutanix_cluster] class

Added columns Description

Block Serial Numbers Serial numbers of blocks that are connected to 
the cluster.

Cluster ID UUID (Universal Unique Identifier) of the 
cluster.

External Subnet Subnet of the external IP address of the 
cluster.

Full Version
Full version of the cluster.

For example: el7.3-release-euphrates-5.10.3.1-
stable-655d4def34bf18785782f2adb8cdd5f8457d1fe3

Hypervisor Types Types of hypervisors that are related to this 
cluster.

Internal Subnet Subnet of internal IP addresses.

NCC Version Nutanix cluster check version.

NTP Servers NTP servers that are related to this cluster.

Number of Nodes Number of nodes that are connected to the 
cluster.

Timezone Timezone of the cluster.

Version
Version of the cluster.

For example: 5.10.3.1

Nutanix Controller VM [cmdb_ci_nutanix_controller_vm] class

Added columns Description

Hypervisor Type Type of hypervisor.

Memory (MB) Amount of memory (in MB) available on the 
controller.

State On/off power state of controller.

VM ID UUID of the controller virtual machine.

Object ID ID of the controller virtual machine.
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Nutanix Storage Container [cmdb_ci_nutanix_storage_container] class

Added columns Description

Compression Indicates whether compression is enabled.

Container ID UUID of the container.

Deduplication
Indicates whether on disk deduplication is 
enabled, that is dedup compression applied to 
data on hard disks (HDD).

Performance tier deduplication is a 
prerequisite for on disk deduplication.

Erasure Code Indicates whether erasure coding is enabled.

Replication Factor Number of maintained data copies. The 
replication factor is specified (2 or 3) when the 
container is created.

The following classes have no added columns:

• Nutanix Storage Pool [cmdb_ci_nutanix_storage_pool]

• Nutanix Host [cmdb_ci_nutanix_host]

• Nutanix Virtual Machine Instance [cmdb_ci_nutanix_vm_instance]

CMDB CI Class Models: Release 1.1.5 adds the following columns to the respective classes.

Nutanix Cluster [cmdb_ci_nutanix_cluster] class

Added columns Description

Block Serial Numbers Serial numbers of blocks that are connected to 
the cluster.

Cluster ID UUID (Universal Unique Identifier) of the 
cluster.

External Subnet Subnet of the external IP address of the 
cluster.

Full Version
Full version of the cluster.

For example: el7.3-release-euphrates-5.10.3.1-
stable-655d4def34bf18785782f2adb8cdd5f8457d1fe3

Hypervisor Types Types of hypervisors that are related to this 
cluster.

Internal Subnet Subnet of internal IP addresses.

NCC Version Nutanix cluster check version.

NTP Servers NTP servers that are related to this cluster.

Number of Nodes Number of nodes that are connected to the 
cluster.
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Nutanix Cluster [cmdb_ci_nutanix_cluster] class  (continued)

Added columns Description

Timezone Timezone of the cluster.

Version
Version of the cluster.

For example: 5.10.3.1

Nutanix Controller VM [cmdb_ci_nutanix_controller_vm] class

Added columns Description

Hypervisor Type Type of hypervisor.

Memory Amount of memory (in MB) available to the 
virtual machine.

State On/off state of power.

VM ID UUID of the controller virtual machine.

Object ID ID of the controller virtual machine.

Nutanix Storage Container [cmdb_ci_nutanix_storage_container] class

Added columns Description

Compression Indicates whether compression is enabled.

Container ID UUID of the container.

Deduplication
Indicates whether on disk deduplication is 
enabled, that is dedup compression applied to 
data on hard disks (HDD).

Performance tier deduplication is a 
prerequisite for on disk deduplication.

Erasure Code Indicates whether erasure coding is enabled.

Replication Factor Number of maintained data copies. The 
replication factor is specified (2 or 3) when the 
container is created.

The following classes have no added columns:

• Nutanix Storage Pool [cmdb_ci_nutanix_storage_pool]

• Nutanix Host [cmdb_ci_nutanix_host]

• Nutanix Virtual Machine Instance [cmdb_ci_nutanix_vm_instance]

CMDB CI Class Models: Release 1.1.4 adds the following columns to the respective classes.
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Nutanix Cluster [cmdb_ci_nutanix_cluster] class

Added columns Description

Block Serial Numbers Serial numbers of blocks that are connected to 
the cluster.

Cluster ID UUID (Universal Unique Identifier) of the 
cluster.

External Subnet Subnet of the external IP address of the 
cluster.

Full Version
Full version of the cluster.

For example: el7.3-release-euphrates-5.10.3.1-
stable-655d4def34bf18785782f2adb8cdd5f8457d1fe3

Hypervisor Types Types of hypervisors that are related to this 
cluster.

Internal Subnet Subnet of internal IP addresses.

NCC Version Nutanix cluster check version.

NTP Servers NTP servers that are related to this cluster.

Number of Nodes Number of nodes that are connected to the 
cluster.

Timezone Timezone of the cluster.

Version
Version of the cluster.

For example: 5.10.3.1

Nutanix Controller VM [cmdb_ci_nutanix_controller_vm] class

Added columns Description

Hypervisor Type Type of hypervisor.

Memory Amount of memory (in MB) available to the 
virtual machine.

State On/off state of power.

VM ID UUID of the controller virtual machine.

Object ID ID of the controller virtual machine.

Nutanix Storage Container [cmdb_ci_nutanix_storage_container] class

Added columns Description

Compression Indicates whether compression is enabled.

Container ID UUID of the container.
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Nutanix Storage Container [cmdb_ci_nutanix_storage_container] class  (continued)

Added columns Description

Deduplication
Indicates whether on disk deduplication is 
enabled, that is dedup compression applied to 
data on hard disks (HDD).

Performance tier deduplication is a 
prerequisite for on disk deduplication.

Erasure Code Indicates whether erasure coding is enabled.

Replication Factor Number of maintained data copies. The 
replication factor is specified (2 or 3) when the 
container is created.

The following classes have no added columns:

• Nutanix Storage Pool [cmdb_ci_nutanix_storage_pool]

• Nutanix Host [cmdb_ci_nutanix_host]

• Nutanix Virtual Machine Instance [cmdb_ci_nutanix_vm_instance]

Related topics

CMDB schema model

OpenStack extension classes

The CMDB CI Class Models store app adds or updates classes for OpenStack.

The app adds class models that extend the CMDB  class hierarchy, including class descriptions, 
identification rules, identifier entries, and dependent relationships if applicable. You can use the 
added classes as any other CMDB  class. Applications such as Discovery  and Service Mapping 
patterns can use these class extensions to populate CIs and discover various technologies and 
software.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

OpenStack

OpenStack is a cloud operating system that controls large pools of compute, storage, and 
networking resources throughout a datacenter. All of these resources are managed and 
provisioned through APIs with common authentication mechanisms. Other components provide 
services such as orchestration, fault management, and service management to ensure high 
availability of user applications. OpenStack is broken up into services to enable you to plug and 
play components depending on your needs. These components are designed for horizontal 
scalability, so you can easily add new resources to grow your cloud over time.
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OpenStack classes integrated with the CMDB class hierarchy

Classes

This section lists the relevant classes that the CMDB  CI Class Models store app adds or updates. 
See the class columns table for further details about the columns added for each class.

CMDB CI Class Models: Release 1.8.0 adds the following classes for OpenStack. For the list 
of CMDB classes in a base system, including ones that this store app might be extending, see 
CMDB tables descriptions.

Class Extends Description

OpenStack Services 
[cmdb_ci_cloud_openstack_service]

Virtual Machine Object 
[cmdb_ci_vm_object]

An OpenStack web service 
that can be accessed via a 
URL.

OpenStack Endpoint 
[cmdb_ci_cloud_openstack_endpoint]

Virtual Machine Object 
[cmdb_ci_vm_object]

The access point of a Service.

OpenStack Domain 
[cmdb_ci_cloud_openstack_domain]

Virtual Machine Object 
[cmdb_ci_vm_object]

A collection of users, groups, 
and projects.

Class columns

CMDB CI Class Models: Release 1.8.0 adds the following columns to the respective classes.

OpenStack Services [cmdb_ci_cloud_openstack_service] class

Added columns Description

type The Service type, which describes the API 
implemented by the Service. Possible values: 
Compute, ec2, identity, image, network, or 
volume.

enabled Defines if the service and its endpoints appear 
in the Service catalog (true/false).
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OpenStack Endpoint [cmdb_ci_cloud_openstack_endpoint] class

Added columns Description

interface The interface type, which describes the 
visibility of the endpoint. Possible values:

• public - Visible by end users on a publicly 
available network interface.

• internal - Visible by end users on an 
unmetered internal network interface.

• admin - Visible by administrative users on a 
secure network interface.

enabled Defines if the Service and its endpoints 
appear in the Service catalog (true/false).

OpenStack Domain [cmdb_ci_cloud_openstack_domain] class

Added columns Description

enabled Defines if the domain is enabled (true/false).

Related topics

CMDB schema model

Operational Technology  (OT) extension classes

The CMDB CI Class Models store app adds or updates classes for Operational Technology  (OT).

Operational Technology (OT) data model

The Operational Technology  (OT) data model was created to enable management of “OT 
device” data. Operational Technology  that controls industrial equipment can be based on 
IT class hardware (computers, servers, network gear, and so on), or on specific hardware 
profiles not included in the ServiceNow  IT class model (PLCs, HMIs, Engineering Workstations, 
Historians, and so on). Therefore, a single OT device in the OT data model includes two primary 
components:

1. A CI class record. This can be an IT or an OT class CI.

2. An OT device details record. This describes the OT device type (function) and other OT-
specific attributes.

Each OT device in the CMDB  can be distinguished as having an “OT Device Details” reference 
[cmdb_ot_entity reference field] to a specific OT device details [cmdb_ot_entity table] record. 
This is a bi-directional reference; the ot_device reference on the cmdb_ot_entity table references 
the CI record. If the cmdb_ot_entity reference of a given CI record is not  empty, the CI is 
considered to be an OT device.

For example, an HMI (Human Machine Interface) OT device could be composed in at least two 
different ways.

1. A computer CI with an OT device detail record describing its “OT device type” as HMI.

2. An HMI CI with an OT device detail record describing its “OT device type” also as HMI.
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In this way, a list of HMIs can be derived and a list of all computers in an enterprise can also be 
derived.

For more details on the OT data model, see Implementing the CSDM framework for Operational 
Technology .

You can use the added classes as any other CMDB  class. Applications such as Discovery  for 
Operational Technology, and Service Graph  Connector for Operational Technology  (Excel) use 
these class extensions to populate CIs and discover various technologies and software. To learn 
more, see:

• Service Graph Connector for Operational Technology (Excel)

• Discovery for Operational Technology

Note: 
In Operational Technology, CIs used on an OT network to automate an industrial process 
are often referred to as  OT devices. This term shouldn’t be confused with an device record 
commonly used in the practice of Asset Management.
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Operational Technology  (OT) schema structure​

Classes

This section lists the relevant classes that the CMDB  CI Class Models store app adds or updates. 
See the class columns table for further details about the columns added for each class.

CMDB CI Class Models: Release 1.30 adds the following classes for Operational Technology 
(OT). For the list of CMDB  classes in a base system, including ones that this store app might be 
extending, see CMDB tables descriptions.

Class Extends Description

CNC [cmdb_ci_ot_cnc] cmdb_ci_ot_control Computer Numerical Control, 
used for automated control 
of machining tools such as 
drills, lathes, mills, and for 3D 
printers.

DCS [cmdb_ci_ot_dcs] cmdb_ci_ot_control Distributed Control System. 
Achieves control using 
intelligence distributed about 
the controlled process, rather 
than by a centrally located 
single unit.

DPU [cmdb_ci_ot_dpu] cmdb_ci_ot_control Distributed Processing Units. 
ICS on a dedicated network, 
with each DPU handling 
thousands of points of I/O.

EWS [cmdb_ci_ot_ews] cmdb_ci_ot_supervisory Engineering Workstation. 
A computing platform for 
configuration, maintenance, 
and diagnostics of ICS 
applications and other control 
system equipment.

Historian 
[cmdb_ci_ot_historian]

cmdb_ci_ot_supervisory Data Historian. A centralized 
database supporting data 
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Class Extends Description

analysis for industrial 
processes.

HMI [cmdb_ci_ot_hmi] cmdb_ci_ot_supervisory Human-Machine Interface. 
Hardware or software through 
which an operator interacts 
with a controller.

IED [cmdb_ci_ot_ied] cmdb_ci_ot_control Intelligent Electronic Device. 
Receives or sends data/
control from or to an external 
source for power grids.

Industrial Actuator 
[cmdb_ci_ot_industrial_actuator]

cmdb_ci_ot_field_device Component of a machine that 
is responsible for moving and 
controlling a mechanism, such 
as opening a valve.

Industrial Drive 
[cmdb_ci_ot_industrial_drive]

cmdb_ci_ot_field_device Equipment used to control 
the speed of machinery. 
It can be a mechanical 
electromechanical, hydraulic, 
or electronic device.

Industrial 3D Printer 
[cmdb_ci_ot_industrial_3d_printer]

cmdb_ci_ot_control Device used in additive 
manufacturing for the 
construction of a three-
dimensional object from a 
CAD model, or a digital 3D 
model.

Industrial Robot 
[cmdb_ci_ot_industrial_robot]

cmdb_ci_ot_field_device Robotic system used for 
manufacturing.

Industrial Sensor 
[cmdb_ci_ot_industrial_sensor]

cmdb_ci_ot_field_device Sensor device used to monitor 
the health of equipment

Network Gear 
[cmdb_ci_netgear]

cmdb_ci_hardware Network gear is an electronic 
device which is required 
for communication and 
interaction between devices 
on a computer network.

Operations Technology 
[cmdb_ci_ot]

cmdb_ci_hardware Base class for Operational 
Technology, used for 
industrial control. For 
instance, in manufacturing.

OPC Client 
[cmdb_ci_ot_opc_client]

cmdb_ci_ot_supervisory Software module that enables 
applications to acquire 
data from an OPC Server or 
conduct supervisory control 
using an OPC Server.

OPC Server 
[cmdb_ci_ot_opc_server]

cmdb_ci_ot_control Software module that enables 
applications to provide their 
data to the outside world 
using OPC.
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Class Extends Description

OT Control Module 
[cmdb_ci_ot_control_module]

cmdb_ci_ot_control Module such as a PLC or DCS 
connected to an OT Control 
System.

OT Control System 
[cmdb_ci_ot_control]

cmdb_ci_ot Base Class for industrial 
control systems (ICS), usually 
at Purdue Model Level 1 or 2.

OT Supervisory System 
[cmdb_ci_ot_supervisory]

cmdb_ci_ot Base class for supervisory 
systems, usually at Purdue 
Model Level 2 or 3.

OT System Service 
[cmdb_ci_ot_system_service]

cmdb_ci_ot_system Category of technology 
and systems that are used 
to manage, control, and 
monitor physical processes, 
machinery, and industrial 
operations.

PLC [cmdb_ci_ot_plc] cmdb_ci_ot_control Programmable Logic 
Controller. Used to control OT 
devices.

Protocol Converter 
[cmdb_ci_protocol_converter]

cmdb_ci_hardware_network_gearDevice used to convert 
standard or proprietary 
protocol of one device to the 
protocol suitable for the other 
device or tools to achieve the 
interoperability.

Quality Inspection Control 
System [cmdb_ci_ot_qics]

cmdb_ci_ot_control Control systems that assist 
specifically in quality and 
inspection functions.

RTU [cmdb_ci_ot_rtu] cmdb_ci_ot_control Remote Terminal Unit. Special 
purpose data acquisition 
and control unit designed 
to support DCS and SCADA 
remote stations

SCADA Client 
[cmdb_ci_ot_scada_client]

cmdb_ci_ot_supervisory Supervisory Control and 
Data Acquisition. Client 
that enables an operator to 
manage a SCADA server.

SCADA Server 
[cmdb_ci_ot_scada_server]

cmdb_ci_ot_control Supervisory Control and Data 
Acquisition. System capable 
of gathering and processing 
data and applying operational 
controls over long distance.

Class columns

CMDB CI Class Models: Release 1.30 adds the following columns to the respective classes.
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Operational Technology  (OT) [cmdb_ci_ot] class

Added columns Description

firmware_version Firmware version reported by discovery 
source.

hardware_version Hardware version reported by discovery 
source.

OT Control System [cmdb_ci_ot_control_system] class

Added columns Description

has_module true/false value describing if the system has 
modules, such as chassis / blade architecture.

backplane_name System-reported string name or number for 
the backplane.

backplane_id System-reported unique ID for the backplane

OT Control Module [cmdb_ci_ot_control_module] class

Added columns Description

slot_number Reported slot in the control system this 
module is using.

module_type Module type reported by the discovery source.

OT Field Device [cmdb_ci_ot_field_device] class

Added columns Description

device_type List that describes if the device provides input, 
output, or both to the parent control system.

OT System Service [cmdb_ci_ot_system_service] class

Added columns Description

display_name Name of the OT system.

isa_entity_site Site where the OT system is located.

Form view

All Operational Technology  (OT) extension classes have a "Default view" form view that includes 
the OT Device Details attribute at the top of the form. The following table lists the other classes 
that have the Operational Technology (OT)  view on their form context menu. This is the default 
form view for users with the cmdb_ot_viewer role for the following classes.

Class Description

base hardware [cmdb_ci_hardware] Base class for hardware.
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Class Description

base computer [cmdb_ci_computer] An extension of the Hardware table, capturing 
computer properties.

base server [cmdb_ci_server] Base class for all types of servers.

linux server [cmdb_ci_linux_server] Server running Linux software.

windows server [cmdb_ci_win_server] A server running Microsoft Windows Server 
operating system.

IoT Device base class [cmdb_ci_iot] Parent table that contains Internet of Things 
device types.

IP Firewall and extended classes 
[cmdb_ci_ip_firewall]

Contains all network firewalls.

IP Router [cmdb_ci_ip_router] Specialization of the Network Gear 
[cmdb_ci_netgear] table.

IP Switch [cmdb_ci_ip_switch] Specialization of the Network Gear 
[cmdb_ci_netgear] table.

Protocol Converter 
[cmdb_ci_protocol_converter]

Device used to convert standard or proprietary 
protocol of one device to the protocol suitable 
for the other device or tools to achieve the 
interoperability.

Classes not included in the table do not have the Operational Technology  (OT) view by default. 
For any additional classes required, you can add the Operational Technology  (OT) view to the 
form context menu. For more information about form context menu options, see Form context 
menu .

Roles and Access Control Logic (ACLs)

The following roles are associated with the Operational Technology  (OT) [cmdb_ci_ot] classes 
and associated tables that follow:

Admin (cmdb_ot_admin)

Can create, read, update, and delete OT records. An admin can also edit the OT 
Device Type on the OT Device form, and manage specific configurations on the OT 
entity tables.

Editor (cmdb_ot_editor)

Can create, read, update, and delete OT device records.

Viewer (cmdb_ot_viewer)

Can read OT device records.

Note: 
For the cmdb_ci_ot and cmdb_ot_entity tables:

• A user must have one of these three OT roles to view OT devices.

• IT users with an assigned itil role are restricted from viewing OT devices in the 
cmdb_ci_ot table, and records in the cmdb_ot_entity table. IT users are still able to see IT 
asset classes, such as Computer, Installed Software.

OT customers may want to restrict access to OT devices from users with an IT (itil) only role, for 
both a viewer and an admin role.
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Key relationship structures

Use the following key relationships as important guidelines when creating Operational 
Technology  (OT) CIs:

OT Entity

Since any CI class may be found on an OT network, the OT Entity table [cmdb_ot_entity] captures 
additional attributes required in an OT Environment:

Attribute Description

Business criticality Business criticality assigned in the discovery 
source.

OT device Reference to the CI that is on the OT network.

OT device type The function of the OT device, regardless of CI 
class.

• For a dedicated HMI appliance, the CI is 
in the cmdb_ci_ot_hmi class, and the OT 
device type should be HMI.

• For a computer performing the function of 
an HMI, the CI is in the cmdb_ci_computer 
class and the OT device type should be HMI

Purdue level Purdue level of the OT device.

Zone Zone assigned to the OT device, usually used 
in the context of a zone/conduit model.

The OT Entity is a related list added to the Operational Technology  (OT) [cmdb_ci_ot] table and 
extended tables. If you want to view OT entity metadata on an existing CI class, first add the 
related list to the form.

OT Entity Type

The [cmdb_ot_entity_type] table tracks the type of OT device that an OT or non-OT CI is 
performing the function of. It serves as a necessary part of the Purdue level data model, and 
extends the Application File [sys_metadata] table.

The ServiceNow AI Platform  includes records representing common OT device types of OT 
device CIs. The OT Entity Type table attributes include:

Attribute Description

Label Display name of a specific OT device type.

Name Value used to identify a specific OT device 
type.

OT table Value used for auto-populating the Type field 
for the OT entity record [cmdb_ot_entity] of an 
OT Class CI.

Parent Parent type of a specific type, which is a 
reference to a record in the same table 
[cmdb_ot_entity_type].
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Serial number

During CI identification, the Identification and Reconciliation Engine (IRE) processes search for 
a serial number in two locations. One is the CI serial number attribute, and the other is the Serial 
Number [cmdb_serial_number] table, with reference back to the Operational Technology  (OT) 
[cmdb_ci_ot] table.

• It stores any serial number of any type other than system serial number, and only in the Serial 
Number table (and not in the server CI attribute).

• If the system serial number is available, it stores it in both the Serial Number attribute of the CI 
and in the Serial Number table.

• The Serial Number table is a many-to-one relationship, linking back to the Operational 
Technology  (OT) CI. This table has a Type field for specifying the type of the serial number.

• For Operational Technology  (OT), use the string value system  for the serial number type to 
ensure proper reconciliation across various sources.

Network adapter

Use the Network Adapter [cmdb_ci_network_adapter] class to store network adapters.

1. Set the MAC Address attribute to be the MAC address value.

◦ Format the string with colon separators between octets and lower case hexadecimal 
characters with padded zeros.

◦ For example, 'f8:f2:1e:00:d4:66'.

2. Set the Name attribute in the Network Adapter class to be the same as the MAC Address.

3. In the CI Relationship [cmdb_rel_ci] table, create an Owned By:Owns relationship to the 
associated Hardware CI.

4. Using the CI with a reference to the associated Hardware CI, specify a reference from the 
Network Adapter [cmdb_ci_network_adapter] table.

IP Address

Use the IP Address [cmdb_ci_ip_address] class to store IP addresses.

1. Store an IP address value in the IP Address attribute, and in the Name attribute to avoid empty 
Name attributes.

◦ Store an IPv4 IP address value using the format 'NNN.NNN.NNN.NNN', with decimal-based 
octets and period separators. Non-conforming values should be considered invalid and 
cleansed to null values.

◦ Store an IPv6 IP address value using lower case hexadecimal with colon separators. Non-
confirming values should be considered invalid and cleansed to null values.

2. Set the Netmask attribute to the IP address.

3. Set the Name attribute in the Network Adapter class to be the same as the MAC Address.

4. In the CI Relationship [cmdb_rel_ci] table, create an Owned By::Owns relationship to the 
associated Hardware CI.

5. In the CI Relationship [cmdb_rel_ci] table, create an Owned By::Owns relationship to the 
associated Hardware CI.

6. For the IP address, specify a reference to the Network Adapter [cmdb_ci_network_adapter] 
table, using the Configuration Item with a reference to the associated Hardware CI.

7. To ensure that base system identification rules work properly, also store the IP address in the 
associated Network Adapter class.
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Network adapter and IP address

Use the IP Address [cmdb_ci_ip_address] class to store IP addresses.

1. Store the MAC address of the network adapter installed on a server, in the Network Adapter 
[cmdb_ci_network_adapter] class.

2. Store the IP address in the IP Address [cmdb_ci_ip_address] class.

Note: 
Do not store the MAC address or the IP address in the Operational Technology  (OT) 
[cmdb_ci_ot] table. The default Operational Technology  (OT) form is configured to display 
the IP address from the Network Adapter table.

Backup Storage Information

Use the Backup Storage Information [cmdb_backup_storage_information] class to create backup 
records that identify the device in internal or external backup services. The Backup Storage 
Information table includes the following attributes:

Attributes Description

Backup 
Configuration 
Status

Indicates whether the CI has been configured in the backup service or 
appliance with relevant policies.

Discovery 
Source

Discovery source of the backup record.

Backup 
Service

Reference to the Common Service Data Model  Technical Service hosting 
external and internal backup system, services, or appliances

Managed By Email ID of the user responsible for managing the backup.

Last 
Successful 
Backup

Date and time of the last successful backup made for a device.

Backup 
Source ID

Backup service record for a device, which identifies the device in external or 
internal backup services. Backup source id can include host_id, vcenter_id, 
instance_id, db_id.

Recovery 
Point 
Objective

Amount of time that can elapse between backups and the amount of data lost.

Execution 
Mode

Indicates whether the backup is configured to run automatically on a periodic 
basis, or if it is manually executed on an as-needed basis.

Last Backup 
Attempt

Date and time of the last backup attempt made for a device.

Backup 
Source

Details of the backed up CI. This table holds the backup status details for the 
referenced CI.

Managed By 
Group

Primary support group responsible for managing the backup.

Domain ID of the domain to which the instance belongs.
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Key reference structures

Use the following key references are important guidelines when creating Operational Technology 
(OT) records:

• When creating computer or server records for OT devices that are running on computers or 
servers, see the following topics:

◦ Computer [cmdb_ci_computer] class

◦ Server [cmdb_ci_server] class

• The Manufacturer and Model ID attributes are reference attributes to the Company 
[core_company] and Product Model [cmdb_model] tables respectively.

• The Owned By, Assigned To, Managed By, and Supported By attributes are reference attributes 
to the User [sys_user] table. The Change Group and Support Group attributes are reference 
attributes to the Group [sys_user_group] table.

Identification rules

The ServiceNow AI Platform  contains a pre-defined identification rule for the Operational 
Technology  (OT) classes. That identification rule has the following key identifier entries, listed in 
priority order:

1. Identifier entry that uses the identification specified in Serial Number [cmdb_serial_number] as 
the lookup table. The Serial Number table is a many-to-one reference from the serial number 
back to the server CI.

2. Identifier entry that is specified in the Serial Number attribute in the CI.

3. Identifier entry that is specified in the Mac Address attribute in the Network Adapter table.

4. Identifier entry for the Name attribute.

◦ If Serial Number and MAC Address are not available, then the Name (which is usually the 
system reported hostname) attribute is used.

◦ If both Serial Number and Name are not available, and only MAC Address is available, use 
MAC Address as the name of the CI. Using the MAC Address as the name of the CI ensures 
that you don't create an empty CI.

Note: 
To learn more, see CMDB Identification and Reconciliation.

Reclassifying IT devices on your OT network

For Xanadu  and later versions, you can create a Network Adapter identifier on the OT 
identification rule to reclassify IT devices on your OT network. Creating a Network Adapter 
identifier on the OT identification rule overwrites the Hardware identification rule's Network 
Adapter identifier entry. To do this, complete the following actions:

1. Navigate to All  > Configuration  > CI Class Manager.

2. Under Hardware  in the CI Classes  menu, select the Operational Technology (OT)  class.

3. Under the Class Info  menu, select Identification Rule.

4. Under Identifier Entries, select Add.

5. In the New Identifier Entry pop-up dialog box, choose Use attributes from another table 
(Lookup table)  and select Next.

6. In the Create Identifier Entry dialog box, complete the following steps:
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a. Select Hardware table  from Search On Table  dropdown list.

b. Enter 400  in the Priority  field.

c. Select Network Adapter  from the LookUP Table  from dropdown list.

d. Select Mac Address  from the Criterion Attributes  dropdown list.

e. Select Save.

Note: 
IT devices on an OT network are not reclassified automatically. If you want to automatically 
reclassify IT devices to OT, you must upgrade to Xanadu  or the latest ServiceNow AI 
Platform  version with the latest CMDB CI Class Models.

Related entries

Related entries for OT identification rules allow OT Service Graph Connectors  to create 
related records, such as OT device records and backup records. The Operational Technology 
[cmdb_ci_ot class] rule contains the following related entries:

• Backup Store [backup_source_configuration_item]

• External system metadata [configuration_item]

• OT device [ot_asset]

The OT Control Module [cmdb_ci_ot_control_module] rule contains the following related entries:

• Backup Store [backup_source_configuration_item]

• OT device [ot_asset]

Deprecated classes

CMDB CI Class Models: Release 1.30 soft deprecated (not removed, but marked as follows) with 
the release of the OT class model:

Class Description

Human Machine Interface [cmdb_ci_hmi] OT devices moved to cmdb_ci_ot to support 
broader use cases. Use cmdb_ci_ot_hmi 
instead.

Manufacturing Device 
[cmdb_ci_manufacturing]

OT devices moved to cmdb_ci_ot to support 
broader use cases. Use cmdb_ci_ot as the 
base class or other generic child classes as 
appropriate.

Programmable Logic Controller [cmdb_ci_plc] OT devices moved to cmdb_ci_ot to support 
broader use cases. Use cmdb_ci_ot_plc 
instead.

A script has been provided to migrate records from these classes to the new class tables. The 
admin role is required to perform the following tasks:

1. Navigate to System Definition  > Script Includes

2. Find the record named OTDevicesMigrationUtils.

3. Navigate to Definition  > Script Includes  > .
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4. In the background window, copy and paste the provided script.

5. Select the appropriate scope and run the script.

Troubleshooting

The following are some troubleshooting tips:

Problem Suggested resolution

Unable to see OT device menu items Ensure that the logged in user has been 
assigned the appropriate roles. To learn more, 
see the preceding Roles section.

Error creating or updating an OT device record Allow only one OT device record 
(cmdb_ot_entity) per CI.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

The CMDB CI Class Models store app  adds class models that extend the CMDB  class hierarchy, 
including:

• Class descriptions

• Identification rules

• Identifier entries

• Dependent relationships, if applicable.

Related topics

CMDB schema model

Red Hat Virtualization (RHV) extension classes

The CMDB CI Class Models store app adds or updates classes for Red Hat Virtualization (RHV).

The app adds class models that extend the CMDB  class hierarchy, including class descriptions, 
identification rules, identifier entries, and dependent relationships if applicable. You can use the 
added classes as any other CMDB  class. Applications such as Discovery  and Service Mapping 
patterns can use these class extensions to populate CIs and discover various technologies and 
software.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Red Hat Virtualization (RHV)

Red Hat Virtualization (RHV) is a virtualization product which is based on the Kernel-based 
Virtual Machine (KVM) hypervisor. RHV uses the SPICE protocol and Virtual Desktop Server 
Manager (VDSM) with a RHEL-based centralized management server. RHV solution is based 
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on two primary software components: Red Hat Virtualization Manager (RHV-M) and Red Hat 
Virtualization Hypervisors or hosts: Red Hat Enterprise Linux or RHV Host (RHV-H).

RHV classes integrated with the CMDB class hierarchy

Classes

This section lists the relevant classes that the CMDB  CI Class Models store app adds or updates. 
See the class columns table for further details about the columns added for each class.

CMDB CI Class Models: Release 1.8.0 adds the following classes for RHV. For the list of CMDB 
classes in a base system, including ones that this store app might be extending, see CMDB 
tables descriptions.

Class Extends Description

RHV LDC

[cmdb_ci_rhv_ldc]

Logical Datacenter

[cmdb_ci_logical_datacenter]

RHV logical datacenter.

RHV Datacenter

[cmdb_ci_rhv_datacenter]

This class is deleted.

N/A N/A

CMDB CI Class Models: Release 1.6.0 adds the following classes for RHV.

Class Extends Description

RHV Server

[cmdb_ci_rhv_server]

Virtualization Server

[cmdb_ci_virtualization_server]

The RHV virtualization host.

RHV Object

[cmdb_ci_rhv_object]

Virtual Machine Object

[cmdb_ci_vm_object]

A base class for other classes 
to derive from.
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Class Extends Description

RHV Manager

[cmdb_ci_rhv_manager]

Application

[cmdb_ci_appl]

RHV Manager instance.

RHV Cluster

[cmdb_ci_rhv_cluster]

RHV Object

[cmdb_ci_rhv_object]

RHV cluster.

RHV Datacenter

[cmdb_ci_rhv_datacenter]

Note: 
This class is being 
deleted in the CMDB 
CI Class Models 1.6.0 
release.

RHV Object

[cmdb_ci_rhv_object]

RHV datacenter.

RHV Virtual Machine Instance

[cmdb_ci_rhv_vm_instance]

Virtual Machine Instance

[cmdb_ci_vm_instance]

RHV virtual machine instance.

Class columns

CMDB CI Class Models: Release 1.6.0 adds the following columns to the respective classes.

RHV Server [cmdb_ci_rhv_server] class

Added columns Description

url URL used to access the object.

RHV Object [cmdb_ci_rhv_object] class

Added columns Description

href_id Href ID.

manager_id Manager ID.

url URL to access the object (used in child 
classes).

RHV Manager [cmdb_ci_rhv_manager] class

Added columns Description

url URL of the manager.

product_name Product name.
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RHV Cluster [cmdb_ci_rhv_cluster] class

Added columns Description

cpu_type CPU type.

cpu_architecture CPU architecture.

ksm Enabled state of kernel same-page merging 
(KSM) memory policy.

fencing_policy Fencing policy.

memory_overcommitment Amount of over-commitment memory allowed 
on the cluster.

transparent_huge_pages Transparent huge memory pages policy.

ballooning Memory ballooning for guests.

compatibility_version Compatibility version.

RHV Virtual Machine Instance [cmdb_ci_rhv_vm_instance] class

Added columns Description

mgmt_url Management URL.

cpu_architecture CPU architecture.

delete_protected Delete protected (true/false).

ha_priority HA priority.

high_availability High availability (true/false).

memory_policy_guaranteed Amount of memory guaranteed (MB).

memory_policy_max_mb Maximum memory in the dynamic memory 
allocation policy.

multi_queues Multi queues.

placement_policy Placement policy.

cpu_sockets Number of CPU sockets.

stateless Stateless (true/false).

storage_error_resume_behaviour Behavior of a virtual machine that is paused 
due to storage I/O error. For examples, 
AUTO_RESUME, LEAVE_PAUSED, and KILL.

start_time Start time.

stop_time Stop time.

threads Number of threads.

time_zone Time zone.

usb USB enabled state.

run_once Run once.

type RHV type.
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The following class was deleted in the CMDB CI Class Models 1.6.0 release.

RHV Datacenter [cmdb_ci_rhv_datacenter] class

Added columns Description

quota_mode Quota mode policy.

Related topics

CMDB schema model

Transport Layer Security (TLS) extension classes

The CMDB CI Class Models store app adds or updates a class for TLS certificates.

The app adds class models that extend the CMDB  class hierarchy. You can use the added 
classes as any other CMDB  class. Applications such as Discovery  and Service Mapping  patterns 
can use these class extensions to populate CIs and discover various technologies and software.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Transport Layer Security (TLS)

TLS is a cryptographic protocol designed to provide communications security over a computer 
network. The TLS protocol provides privacy and data integrity between communicating computer 
applications. Once the client and the server have agreed to use TLS, they negotiate a stateful 
connection by using a handshaking procedure. The server usually provides identification in 
the form of a digital certificate. The certificate contains the server name, the trusted certificate 
authority (CA) that vouches for the authenticity of the certificate, and the server's public 
encryption key. The client confirms the validity of the certificate before proceeding. When the 
handshake is completed, a secured connection is established.

TLS certificate classes integrated with the CMDB class hierarchy
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Scoped apps certification class

The scoped apps certification class supports TLS certificates. With this class you can proactively 
manage certificates by keeping stakeholders informed about any impending expiries. Use this 
extension class to ensure that certificates are monitored and renewed before they expire, to 
prevent severe outage of production systems.

Classes

This section lists the relevant classes that the CMDB  CI Class Models store app adds or updates. 
See the class columns table for further details about the columns added for each class.

The CMDB CI Class Models: Release 1.4.0 updates the following class:

Class Extends Description

Unique Certificate 
[cmdb_ci_certificate]

Configuration Item [cmdb_ci] A public key certificate in 
X.509 standard format.

The CMDB CI Class Models store app changes the Unique Certificate [cmdb_ci_certificate] class 
as follows:

• The assigned_to  attribute now depends on the assignment_group  attribute 
so that users in the assigned_to  attribute are filtered based on the specified 
assignment_group.

• The Certificate Inventory and Management  store app populates the Unique Certificate 
[cmdb_ci_certificate] table. The list view for that class does not have a New  button and you 
can no longer add new records to the table. This is because there are certain fields that are 
extracted from binary encoded parameters in the certificate which users may not be able to 
provide. Also, certificates have to be discovered rather uploaded.

• You can no longer add or delete attachments in the Certificate file  attribute.

The CMDB CI Class Models: Release 1.3.0 adds the following classes. For the list of CMDB 
classes in a base system, including ones that this store app might be extending, see CMDB 
tables descriptions.

Class Extends Description

Unique Certificate 
[cmdb_ci_certificate]

Configuration Item [cmdb_ci] N/A

Certificate Domain 
[certificate_domain]

N/A Fully qualified domain name.

Class columns

CMDB CI Class Models: Release 1.4.0 adds the following columns to the respective classes.

Unique Certificate [cmdb_ci_certificate] class

Added columns Description

Certificate file Certificate in an encoded form.

Fingerprint Hash value of the certificate.
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Unique Certificate [cmdb_ci_certificate] class  (continued)

Added columns Description

Fingerprint algorithm Algorithm used to hash the certificate.

Is certificate authority Indicates whether a certificate is a Certificate 
Authority (CA) or not.

Is selfsigned Indicates whether the certificate is self-signed 
or not.

Issuer Entity that has signed and issued the 
certificate.

Reference: Unique Certificate 
[cmdb_ci_certificate]

Issuer common name Common name of the issuer.

Issuer distinguished name Distinguished name of the issuer.

Key size Size of the key used by the signing algorithm.

Choices:

• Create priority 1 tasks

• Create priority 3 tasks

• Do not create renewal tasks

Renewal tracking Indicates whether to create any priority 1 or 
priority 3 tasks for the expiring certificates.

Root issuer Root entity that has signed and issued the 
intermediate certificate.

Choices:

• External

• Internal

Reference: Unique Certificate 
[cmdb_ci_certificate]

Service type Indicates whether the certificate is used for 
external or internal services.

Signature algorithm The cryptographic algorithm used to sign the 
certificate.

Choices:

• Issued

• Installed

• Revoked

• Retired

State Lifecycle states of the certificate.
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Unique Certificate [cmdb_ci_certificate] class  (continued)

Added columns Description

Subject alternative name
List of fully qualified domain names secured 
by the certificate.

Reference: Certificate Domain 
[certificate_domain]

Subject common name Identifies the hostname/domain associated 
with the certificate.

Subject country Subject's two letter country code.

Subject distinguished name Identifying information of the subject.

Subject email Subject's email.

Subject locality Subject's locality.

Subject organization Subject's organization.

Subject organizational unit Subject's organizational unit.

Subject state Subject's state.

Valid from Validity start period of the certificate.

Valid to Validity end period of the certificate.

Version X.509 version of the certificate.

Certificate Domain [certificate_domain] class

Added columns Description

Domain Fully qualified domain name.

CMDB CI Class Models: Release 1.3.0 adds no columns.

Related topics

CMDB schema model

VMware NSX load balancer extension classes

The CMDB CI Class Models store app adds or updates classes for VMware NSX load balancers.

The app adds class models that extend the CMDB  class hierarchy, including class descriptions, 
identification rules, identifier entries, and dependent relationships if applicable. You can use the 
added classes as any other CMDB  class. Applications such as Discovery  and Service Mapping 
patterns can use these class extensions to populate CIs and discover various technologies and 
software.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .
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VMware NSX load balancer

NSX is a network virtualization solution offered by VMware. Among the virtual resources included 
in the NSX solution are virtual LANs (VLANs), virtual load balancers, virtual routers, switches, and 
firewalls.

ServiceNow  Discovery  uses the VMware NSX Advanced load balancer discovery  pattern to find 
VMware NSX load balancers and their components: Listeners, pools, pool members, and health 
services.

VMware NSX load balancer classes integrated with the CMDB class hierarchy

Classes

This section lists the classes that the CMDB  CI Class Models store app adds or updates.

CMDB CI Class Models: Release 1.10.0 adds the following classes for the VMware NSX load 
balancer. For the list of CMDB classes in a base system, including ones that this store app is 
extending, see CMDB tables descriptions.

Class Extends Description

NSX Load Balancer 
[cmdb_ci_nsx_lb]

Load Balancer [cmdb_ci_lb] The table containing the NSX 
Load Balancer resources.

Class columns

The VMware NSX Advanced load balancer discovery  pattern introduces one new table with 
one identification rule and entry. The table uses only the columns inherited from its parent.

Related topics

CMDB schema model

Extend classes and rules

Extend and update CMDB CI Class Models store app classes and rules when using third-party 
integration tools.

When using a third-party tool to integrate with ServiceNow  apps, gaps can occur between the 
integration and different CIs. Some of the integrated tables and classes may be missing classes 
and rules not included with the CMDB CI Class Models store app.

The classes and rules in the following table enable you to add and extend the CMDB CI Class 
Models store app for integrations:
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Table Extends Rules and related entries

Containment rule:

cmdb_ci_db_postgresql_instance-
>Contains:Contained By-
>cmdb_ci_postgresql_schema

Identification Rule:

Dependent, Attributes: name

Postgresql Schema

cmdb_ci_postgresql_schema

cmdb_ci_db_catalog

Related Entries (cmdb_related_entry):

• Identifier: 
cmdb_ci_postgresql_schema

• Related table: cmdb_key_value

• Referenced field: configuration_item

Identification rule:

Independent, attributes: name
Information Object

cmdb_ci_information_object

cmdb_ci

Related Entries (cmdb_related_entry):

• Identifier: 
cmdb_ci_information_object

• Related table: cmdb_key_value

• Referenced field: configuration_item

Oracle Catalog

cmdb_ci_db_ora_catalog

cmdb_ci_db_catalog Related Entries (cmdb_related_entry):

• Identifier: cmdb_ci_db_ora_catalog

• Related table: cmdb_key_value

• Referenced field: configuration_item

Containment rule:

cmdb_ci_db_mysql_instance-
>Contains:Contained By-
>cmdb_ci_db_mysql_catalog

Identification rule:

Dependent, attributes: name

MySQL Catalog

cmdb_ci_db_mysql_catalog

cmdb_ci_db_catalog

Related Entries (cmdb_related_entry):
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Table Extends Rules and related entries

• Identifier: cmdb_ci_db_mysql_catalog

• Related table: cmdb_key_value

• Referenced field: configuration_item

MS SQL Database

cmdb_ci_db_mssql_database

cmdb_ci_db_instance Related Entries (cmdb_related_entry):

• Identifier: 
cmdb_ci_db_mssql_database

• Related table: cmdb_key_value

• Referenced field: configuration_item

Containment rule:

cmdb_ci_db_syb_instance-
>Contains:Contained By-
>cmdb_ci_db_syb_catalog

Identification rule:

Dependent, attributes: name

Sybase Catalog

cmdb_ci_db_syb_catalog

cmdb_ci_db_catalog

Related Entries (cmdb_related_entry):

• Identifier: cmdb_ci_db_syb_catalog

• Related table: cmdb_key_value

• Referenced field: configuration_item

Containment rule:

cmdb_ci_db_db2_instance-
>Contains:Contained By-
>cmdb_ci_db_db2_catalog

Identification rule:

Dependent, attributes: name

DB2 Catalog

cmdb_ci_db_db2_catalog

cmdb_ci_db_catalog

Related Entries (cmdb_related_entry):

• Identifier: cmdb_ci_db_db2_catalog

• Related table: cmdb_key_value

• Referenced field: configuration_item

For the list of CMDB classes in a base system, including ones that this store app is extending, 
see CMDB tables descriptions.
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Related topics

CMDB schema model

Baseline CMDB

CMDB baseline provides capabilities that help you understand and control the changes that 
have been made to your configuration items (CIs) in the CMDB.

• You can create a baseline, which is a snapshot of your configuration items in the CMDB. You 
can review the changes that have been made to that configuration item since a previous 
baseline. Multiple baselines may be created and the system tracks the changes that have 
been made per baseline.

Creating a baseline captures the attributes of the CI as well as all first-level relationships for the 
CI. Any changes to the base CI or to any related CIs are captured and displayed. Newly created 
CIs are not automatically added to a baseline.

• Associate a configuration item with a task, a change or change task, and to propose changes 
to the CI after the change is complete. You can record changes, and these changes are not 
applied to the CI immediately but are delayed until the change is complete.

When the change is complete, you can choose to apply the proposed changes which makes 
all changes previously proposed and associates the changes with the task.

For information about planning and implementing a baseline CMDB, see the CMDB Baseline 
life-cycle best practices and Diff Formatter troubleshooting [KB0829681]  knowledge base 
article.

Create a CMDB baseline

You can create a baseline for a CI to track updates to the CI over time.

Before you begin
Role required: ecmdb_admin and itil

Procedure

1. Navigate to All  > Configuration  > Baselines  > Baselines.

2. Click New.

3. Enter a Name  for the baseline.
By default, the cmdb_ci table is selected so that the record creates the baseline for all 
configuration items in the system.

4. Optional:  To limit the baseline to specific CIs, select a different Table  or choose Conditions 
that a CI must meet for it to have a baseline entry.

Example 
For example, you might create a baseline for the Database table with the condition [Location] 
[is] [<configured location>].

5. Click Submit.
The creation of a baseline is time consuming and occurs in the background. A message at the 
top of the record list notifies you that your baseline has been scheduled and you will receive 
an email when the process is complete.
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Display baseline differences

You can see the changes that have been made to a CI or any first level related CIs by configuring 
the CI form layout to display the CMDB Baseline diff field. This field is labeled Baseline 
differences on the form.

Before you begin
Role required: itil

About this task
Changes are displayed only for the cmdb_ci table and child tables. You can change the 
com.cmdb.baseline.max_changes  system property to limit the number of relationships 
and changes that appear in a baseline diff section on a CI form (set to 100 by default).

Procedure

1. Open a CI record.

2. Select the baseline you want to see for this CI from the choice list.
The field displays the details of any changes that were made to the current record for the 
selected baseline, or indicates that no changes were made.

Details of baseline differences

3. To add a relationship to the CI, click the green plus icon in the Related Items  toolbar.
The new relationship appears below the toolbar. For more information about the Related Items 
toolbar and how to control the display, see CI relations formatter.

4. Update a related CI and see the changes displayed as Basic attribute changes  in the current 
CI record.

Basic Attribute Changes

What to do next
To improve performance and prevent memory issues when showing large amounts of baseline 
differences data on CI forms, complete the following steps:

1. Set the system property com.cmdb.baseline.entry.attachment  to true.

2. Manually run once the CMDB Baseline convert XML to attachment  fix script. For 
information about running a fix script, see Run fix scripts .
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Properties for baseline CMDB

Use the baseline CMDB properties to configure how many changes and relationships for a CI 
can appear in the baseline diff for the CI.

These properties are available for baseline CMDB. To view and edit these properties, the admin 
role is required.

Properties for Baseline CMDB

Property Description

Maximum number of changes 
and relationships for a CI that can 
appear in the baseline diff for the CI.

com.cmdb.baseline.max_changes

• Type: integer

• Default value: 100

• Location: Configuration  > CMDB Properties  > 
Baseline Properties

com.cmdb.baseline.entry.attachment
Lets you manually run the CMDB Baseline 
convert XML to attachment  fix script. Setting 
this property to true and then running the CMDB 
Baseline convert XML to attachment  fix 
script, enables improved performance when showing 
large amounts of baseline differences data on CI forms.

When false, the CMDB Baseline Diff component uses 
legacy methods which might fail to load large amounts 
of baseline differences data.

• Type: true | false

• Default value: false

• Location: Add to System Properties [sys_properties]
table.

• Learn more: Baseline CMDB

CMDB Workspace  store app

The CMDB Workspace  is an efficient, central, and modernized way for you to work. Use CMDB 
Workspace  to search and explore the CMDB, examine health and recent activity, and access 
various CMDB dashboards and tools to support tasks in your organization.

Introduction

Watch the following video to get started with CMDB Workspace. Depending on the version 
of your CMDB Workspace, some UI elements and features might differ.  Introduction to CMDB 
Workspace

General interaction and additional information

• CMDB Workspace  leverages many Performance Analytics  capabilities and features, such as 
indicator sources. Throughout the CMDB Workspace  views, you can select the various cards to 
drill down to Performance Analytics KPI Details panes that show trends for the associated data. 
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On a KPI Details pane, you can modify different settings to change the scope of the data. You 
can also select Show Records  to list the records associated with the chart.

• Lists throughout the CMDB Workspace  have a filter icon ( ) that you can select to show 
the filter definition used for the list.

• You can open your Configurable Workspace experience in UI Builder  to access and edit your 
CMDB Workspace experience.

• See List of workspaces  for a list of all Workspaces that ServiceNow®  provides.

CMDB Workspace  doesn't support domain separation.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Note: 
Starting with the San Diego  release, the CMDB Workspace  store app is automatically 
installed when installing or upgrading the product.

Enable demo data

Enable demo data to install demo data-specific scheduled jobs that if the needed requirement is 
met, generates and populates demo data in CMDB Workspace  cards such as:

• Cloud vs Non-cloud resources chart in the CMDB Workspace  landing page and the Insights 
view: If Cloud Service Accounts [cmdb_ci_cloud_service_account] table exists

• Cards in the CMDB 360 view: If CMDB 360 is enabled

• Cards in the Insights view, CMDB Feature Adoption tile:

◦ CIs processed by IRE

◦ CIs processed by IRE based on source

◦ Data Manager

◦ Data attestation

◦ Query Builder

◦ Intelligent Search

• Cards in the What's new tile in the CMDB Workspace  landing page.

To populate CMDB Workspace  dashboards with demo data:

1. When installing the CMDB Workspace  store app, check Load demo data.

2. Access the [Demo] — CMDB Workspace demo data  scheduled job and select 
Execute Now.

Note: 
As a general practice, don't enable demo data in a production instance to prevent demo 
data mixing with real production data.
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Prerequisites

• Plugins:

◦ Recommended: CSDM Activation (com.snc.cmdb.csdm.activation)

Allows for legacy Lifecycle Status  field mappings and synchronization to legacy 
status fields. For details about use and customization of life-cycle rules when this plugin isn't 
activated, see Life-cycle rules and retirement definitions.

◦ Required (activated by default): CMDB CSDM Support (com.snc.cmdb.csdm)

◦ Required (activated by default): CMDB Page Templates (sn_cmdb_pg_templts)

◦ Required (activated by default): CMDB NLQ Search Connected (sn-cmdb-nlq-search)
For details about activating a plugin, see Activate a plugin .

• Roles: To access the CMDB Workspace, you must, at a minimum, have one of the following 
roles, which are essential for interacting with the CMDB Workspace. Depending on which of 
these roles is assigned to you, you might only have access to some of the features available in 
the CMDB Workspace:

◦ sn_cmdb_admin

◦ sn_cmdb_editor

◦ sn_cmdb_user

Note: 
As you drill down in the CMDB Workspace, there are some dashboards and list views that 
require specific roles in addition to the key CMDB Admin, CMDB Editor, or CMDB User 
roles.

• Features: CMDB Workspace  provides access to a wide range of applications and features. 
However, for CMDB Workspace to provide meaningful reports, overviews, and trends, you must 
set up and configure some of those features. Setup for such features is listed under Additional 
requirements.

Access the CMDB Workspace

Navigate to Workspaces  > CMDB Workspace  to access the CMDB Workspace  landing page.

In addition to the Home view described below, you can access features in the following views of 
the CMDB Workspace:

• My Work view: Manage CMDB Data Manager tasks such as attestation tasks, that are assigned 
to you.

• CMDB 360 view: View aggregations and analysis of CMDB 360 data on a dashboard, and 
create CMDB 360 queries.

• Management view: View recent key activities and health indicators for the CMDB, and access 
management tools and dashboards (accessible only to CMDB admins) that support your 
management tasks.

• Insights view: View level of adoption of key CMDB tools, features, and application services. 
Explore benefits and install those tools and features to maximize the efficiency of your CMDB 
functionality.

Intelligent Search

Accessible to: CMDB Admin, CMDB Editor, CMDB User.
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Lets you use Natural Language Query (NLQ) search capabilities provided by Intelligent Search for 
CMDB. Use the input field to construct a search string using everyday language. As you type, a 
dynamic list of relevant suggestions appears, with items matching single words or part phrases 
in the typed-in text, such as table names.

You can:

• Select Search tips  to see tips about constructing search strings. See details about the usage, 
examples for single and multi-table search, advanced filtering, and relationships in Intelligent 
Search.

• Select Search  to either run the query if the search string is already fully converted into a valid 
CMDB query, or to open the Refine your query dialog box.

◦ If the search string has no ambiguities with the table name or relationships, then the query 
runs and the results appear in a list view format.

Only the first 100 results of the query appear in the results pane.

▪ Select Load More Results  to view the next set of 100 results.

▪ Select Load All Results  to view the rest of the query results, up to the number specified by 
the glide.cmdb.query.max_results_limit  system property (10,000 by default).

If the constructed CMDB query contains more than a single table, then the View in Query 
Builder  button appears. Select the button to open the CMDB Query Builder  with your query 
fully constructed on the Query Builder canvas. You can use the Query Builder to continue 
editing the query.

◦ If there are any ambiguities with table names or relationship types in the search string, then 
the search string can't be converted into a valid CMDB query. In this case, the Refine your 
query dialog box appears letting you select from suggested CI classes and continue to 
parse your search string into a valid CMDB query. Those suggested CI classes are based on 
phrases in your search string. Use the drop-down lists to select the CI classes that match 
your intended search and then select View search results  to run the query.

◦ If Intelligent Search is unable to convert your search string into a valid CMDB query, then 
selecting Search  doesn't generate any query results. Instead, a feedback form appears. Fill 
out the form and select Submit Feedback  to record your feedback for your CMDB Admin to 
review.

• Use the Sample searches list to get you started in running a pre-defined search. This list 
consists of more common searches, or searches that are more difficult to construct such as 
searches that involve application services.

• Use the Your recent searches list to rerun a previous search.

• Select Results Feedback  to submit feedback on the search results for your CMDB Admin to 
review.

For more details about using NLQ with Intelligent Search, see Intelligent Search for CMDB.

Alternatively, you can select Use conditional search instead  to use a basic condition builder
functionality where you can specify conditions to search for CIs of a specific class.

You can:

• Select New condition set  to add a condition phrase.

• Select Related List Condition  to add a condition phrase for related lists .

• Select Search  to search through the CMDB.
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• Add and then adjust the sn_cmdb_ws.list.record_count_limit  system property to 
limit the record count summation and so to minimize the performance impact of that operation. 
The record count shows on the Conditional search page, for example, above the results list. 
For more information about adding and modifying that system property, see Components 
installed with CMDB Workspace.

In the results list, select a CI to see details including a timeline, health overview, and several 
types of attributes such as key and discovery attributes. For more information, see Cloud vs Non-
cloud resources.

UI activity Additional requirements

• Mapped Application Service

• Application Service

• Application Service Group

• Dynamic CI Group

• Tag Based Service

app_service_user role

• Business Service

• Technical Service

• Application Service Outage

service_viewer role

Important actions

Accessible to: CMDB Admin and CMDB Editor.

Important actions of various categories that require your attention or action. There are several 
task categories such as:

• Health tasks generated by CMDB Health: In health-related cards, such as Duplicate CIs, 
Orphan CIs, stale CIs, and De-Duplication tasks, select View CIs  or View Tasks  to drill down to 
the list of associated CIs or important tasks. In de-duplication-related cards generated by IRE, 
you can access the De-duplication dashboard and de-duplication libraries, to remediate de-
duplication tasks in bulk.

• Data attestation and life cycle approval tasks generated by the CMDB Data Manager: In data 
attestation-related cards, such as Reassignment Requests and Unassigned Overdue cards, 
selet View Tasks  to drill down to the associated important tasks.

Important actions are stored in the CMDB WS Imp Action Card Config 
[sn_cmdb_ws_imp_action_card_config] table that is accessible for editing only to users with 
the sn_cmdb_admin role. Authorized users can modify attributes of an important action such 
as Active  and Filter conditions, but can't modify the Type, Persona, and Table 
attributes.

• Important action cards show per the logged in user role, as specified in the CMDB WS Imp 
Action Card Config [sn_cmdb_ws_imp_action_card_config] table.

• A card appears only if there is at least one record that meets the card's filter condition.

• If you drill down a Health-related card and modify an associated CI, any resulting impact to 
health KPIs might appear only after the next cycle of the CMDB Health dashboard jobs.
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For information about managing the cards in the Important actions tile, see Modify important 
actions in CMDB Workspace.

What's new

Accessible to: CMDB Admin, CMDB Editor, CMDB User.

Counts of newly created CIs within a recent time interval. The New CIs total counts all CI types 
including applications, hardware, and application services, which also appear in separate cards 
in the tile. By default, historical data is aggregated for the Last 24 hours, which you can set to a 
different time interval such as Last 7 days.

Select a card to drill down to a Performance Analytics KPI Details pane that shows the trend for 
the respective item.

Counts in the What's new cards are based on the following tables:

Count Table

New CIs Configuration Item [cmdb_ci]

New application Application [cmdb_ci_appl]

New hardware Hardware [cmdb_ci_hardware]

New application services Application Service [cmdb_ci_service_auto]

CI overview
The following tabs provide summaries about CIs:

CI Summary

Accessible to: CMDB Admin, CMDB Editor, CMDB User (without tabs).

A chart of all CIs in the CMDB, grouped by up to 20 CMDB groups. The CMDB 
groups in the chart are specified as groups of closely-related classes.

Select a bar to drill down to the classes in the group and their CIs. Then, drill down 
a CI to show the Cloud vs Non-cloud resources  with a timeline, health overview, and 
several types of attributes such as key and discovery attributes.

You can add custom class groups by creating CMDB groups  with the following 
settings:

• Group type is set to 'CMDB Workspace'.

• Populated by encoded queries.

Such custom class groups will appear after the next time that the CMDB 
Workspace – Group  and Encoded Query Counts  scheduled jobs run and 
update the CMDB Workspace.
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Note: 

In systems with a very large number of CIs, for example a billion or more 
CIs, the set of queries that populate the CI Overview widget might run for an 
unreasonable length of time. In that case, you can choose to switch the default 
queries with a set of simpler queries that can handle such load and properly 
load the CI Overview widget. However, the results yielded from the simpler 
queries aren't as complete or accurate as the results of the original queries. A 
fundamental difference between the original and the simpler queries is that 
the simpler queries use only Common Service Data Model (CSDM)  attributes 
for CI status (such as life_cycle_stage), while the default queries 
also use the legacy operational_status  and status  attributes. In an 
environment that hasn't migrated to CSDM, the simple queries yield fewer 
results.

You can examine (read access only) the simple query in the Simple 
Condition  column in the cmdb_group_contains_encoded_query 
table.

To use the simpler set of queries, set the 
sn_cmdb_ws.ci_overview.enable_simple_condition  system 
property to true  (false  by default).

My CIs

Accessible to: CMDB Admin, CMDB Editor.

A chart of Cls with Managed By Group  being one of the groups you are a part of. 
CIs are grouped by up to 20 common class categories such as Applications, 
Devices, and Servers. If there are more than 20 classes to show, then all 
remaining classes are lumped into one additional bar on the chart.

Select a class bar to drill down into the CIs for the class. Then drill down to any 
Cloud vs Non-cloud resources  with a timeline, health overview, and several types of 
attributes such as key and discovery attributes.

Use the sn_cmdb_ws.ci_overview.managed_by_me.enabled​ property to show or 
hide this chart.

Cloud vs Non-cloud resources

Note: 
This procedure applies to Vancouver and later instances. If you are using an 
instance older than Vancouver, see the next item..

Charts showing counts and details for resources that are hosted on various cloud 
services versus those resources that aren't, with breakdown by key CI classes 
such as applications, databases, and datacenters. Resources can be deployed on 
cloud services such as the Microsoft Azure Cloud, or on the local instance or other 
non-cloud solutions. For some ongoing operations in the organization, it might be 
necessary to have those details that can be difficult to obtain.

The following conditions must be met for the Cloud vs Non-cloud resources charts 
to appear and to show meaningful data:

• The table Cloud Service Accounts [cmdb_ci_cloud_service_account] must exist.

• The Logical Datacenter [cmdb_ci_logical_datacenter] table must contain at least 
one record for a cloud datacenter.
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• The Datacenter Types [sn_cmdb_ws_datacenter_type] table must contain at least 
one record for a datacenter that is classified as cloud storage in the organization. 
In the base system, this table is pre-populated with several records for common 
cloud services such as the Azure Datacenter [cmdb_ci_azure_datacenter) class. 
The chart calculates and shows data only for cloud services for which there's a 
record in the Datacenter Types [sn_cmdb_ws_datacenter_type] table.

For details about adding datacenters in your organization, with the cloud or 
non-cloud classification, see Configure datacenters for the Cloud vs Non-cloud 
resources chart.

The following cloud vs Non-cloud charts are available:

• CI classes bar chart:

Each bar in the CI classes chart represents a pair of a CI class and a storage 
type (cloud, non-cloud), such as the bar for Applications/Cloud. For each bar, 
there's a scheduled job that runs every 24 hours to collect and calculate the 
data for the bar. The running time depends on the amount and complexity of the 
data that a job collects, which can be different for each scheduled job. Also, the 
schedules of the jobs are staggered so that they don't all run at the same time and 
exhaust resources. For details about the class-specific criteria used for the chart 
calculations, see Class-specific criteria for the Cloud vs Non-cloud resources 
chart.

If there’s a CI class/type pair that isn't important in the organization, you can 
exclude that pair from the CI classes chart. For more details, see Configure CI 
classes for the Cloud vs Non-cloud resources chart.

On the CI classes chart, you can:

◦ Select a bar to open the Cloud vs Non-cloud resources pane. Then, select 
either of the following tabs to drill down into further details for the bar:

Cloud vs Non-cloud CIs

Shows a bar chart for CIs stored on a cloud service and those 
CIs that aren't, per CI class. For each CI class, select the cloud 
or the non-cloud bar to show the CIs that are associated with the 
selected bar, in a list view. You can then select a CI from the list to 
further drill down to the CI details pane.

CI Classes by Cloud Providers

Pie charts per CI class with more granular details for those CIs that 
are hosted on cloud providers. Pie slices have randomly-selected 
colors, and they show a breakdown by cloud providers for various 
CI classes. For each pie, select a slice to show the CIs that are 
associated with the pie slice, in a list view. You can then select a CI 
from the list to further drill down to the CI details pane.

◦ Select Latest updates  to see updated status for the scheduled jobs that 
produce the data for the chart. Status is color-coded to indicate whether the job 
has completed successfully (green), or failed to complete (red).

• Application Services pie chart:
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The Application Services pie chart is available starting with CMDB Workspace 
v3.6.

The Application Services pie chart uses the Service Configuration Item 
Associations [svc_ci_assoc] table and checks the cloud/non-cloud status 
of application service CIs in the CI classes chart. Application services in the 
Application Services pie chart are classified as follows:

◦ Cloud: All of the CIs in the application service have been determined to be 
hosted on a cloud service.

◦ Non-cloud: All of the CIs in the application service have been determined not to 
be hosted on a cloud service.

◦ Hybrid: The application service contains a mixture of CIs where some are 
hosted and some aren't hosted on cloud services.

◦ Unknown: The cloud/non-cloud classification couldn't be determined because 
some of the application service CIs aren't classified as cloud or non-cloud CIs.

Note: 
Because classification of Application Services depends on the classification 
of CIs in the CI classes chart, there might be some discrepancy between the 
two charts. This can occur if an application service CI changed its cloud/
non-cloud status, and the Application Services chart hasn't refreshed yet to 
reflect that change.

Select the Application Services chart to access the list views of the associated 
application services, grouped by cloud/non-cloud classifications. From those list 
views, you can drill down to the Dependency Views  map for application services.

The scheduled jobs associated with the charts are set up with several hard-coded 
limits that if exceeded, result in failure conditions that are reflected in the job status. 
Timing out is set to two hours and the maximum number of records to collect is set 
to 500,000. If a job exceeds any of those limits, it's automatically stopped.

A scheduled job that can't complete for 3 (default) consecutive days is automatically 
disabled for future runs. You can manage the disabling of scheduled jobs, in the 
following ways:

• Modify the default number of consecutive days that are counted by adding the 
sn_cmdb_ws.insight.category.disable_after_failure  system 
property to the System Properties [sys_properties] table and then setting its 
value. For more details, see Add a system property .

• Resume a disabled scheduled job.

UI activity Additional requirements

• Mapped Application Service view

• Application Service

• Dynamic CI Group

• Tag Based Service

app_service_user role
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My work

Accessible to: CMDB Admin, CMDB Editor, CMDB User.

All open tasks from CMDB Data Manager  that are assigned to you, or to an assigned group in the 
Managed by Group  attribute which you are a member of. For CMDB Admins, also tasks that 
aren't assigned to anyone so that CMDB Admins can assign those unassigned tasks. Tasks can 
be, for example, attestation tasks and life cycle-related tasks.

Select Open tasks  and Overdue tasks  to review and process the tasks.

CMDB Health

Accessible to: CMDB Admin, CMDB Editor, CMDB User.

Health metrics for CIs and relationships. Select the percentage numbers to navigate to the 
CMDB Health and CMDB Relationship Health dashboards:

• The Overall percentage number represents the health of all CIs as an aggregation of all three 
health Key Performance Indicators (KPIs). Those KPIs are correctness, compliance, and 
completeness, each consisting of sub-metrics.

• The Relationship percentage number represents the overall health of relationships as an 
aggregation of the orphan, duplicate, and stale relationships KPIs.

• The color-coded status label follows the CMDB Health scorecard thresholds specified in the 
CI Class Manager. However, the labels 'Best', 'At Risk', and 'Critical' are replaced by 'Excellent', 
'Fair', and 'Poor' respectively. For more information see, Configure CMDB Health scorecard 
thresholds.

• Select Factors impacting your score  to see the breakdown of the score percentage by the 
three key KPIs (Completeness, Compliance, and Correctness).

For more information, see CMDB Health, CMDB Health KPIs and metrics, and View CI 
relationships health.

UI activity Additional requirements

CMDB Health asset or itil role

Set up and configure CMDB Health

Total CIs

Accessible to: CMDB Admin, CMDB Editor, CMDB User.

Count and trend of the total number of CIs in the CMDB for the past 7 days.

Use the sn_cmdb_ws.total_cis.enabled​ property to show or hide this chart.

Quick links

A list of links to key CMDB dashboards and tools.  You can add a link  to the list of quick links that 
are available to you.
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• Dependency View: Provides a graphic infrastructure view for a CI and any application or 
business services that it’s part of and that it supports.

• Query Builder: Easily build complex infrastructure and service queries, that span multiple 
CMDB classes, non-CMDB tables, and that can involve many CIs that are connected by 
different relationships.

• CMDB Data Manager: Centrally create, edit, review, publish, and track Data Manager policies 
and the tasks generated by the policies.

• CI Class List : List view of CMDB CIs grouped by common classes.

• Unified Map: Graphical map showing the hierarchy of CIs and the relationships between 
them, and application services. Directly from the map, you can access attributes of CIs and 
relationships, and related items such as changes, incidents, and problems for a CI.

UI activity Accessibility Additional requirements

Dependency View CMDB Admin, CMDB Editor, 
CMDB User

dependency_views role

Query Builder CMDB Admin, CMDB Editor, 
CMDB User

cmdb_query_builder_read 
role

Data Manager CMDB Admin

Add or edit a custom quick link CMDB Admin, CMDB Editor, 
CMDB User

Shared pages

For information about the shared pages, see the Dev site as follows:

• CI Service Relationships

• CI Infrastructure Relationships

CI details pane

When you drill down to a CI record, the following details for the CI appear:

• CI Timeline - Last 14 days: A timeline of CI activities such as change requests.

• CI Health: A summary of the health of the CI, showing related items such as critical incidents, 
incomplete attributes, and stale relationships for the CI.

Role requirement: itil (for accessing incidents).

• Details: CI attributes, grouped into categories such as Key attributes, Asset attributes, 
Discovery attributes, Operational attributes, and More attributes.

Note: 
Use the CMDB - Workspace  form view for a CI class to configure which attributes 
appear.
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• Activity: An activity stream to track what's changed in the CI record.

• Infrastructure Relationships: List of the infrastructure CIs related to the CI.

• Service Relationships: List of business applications, service offerings, and application services 
that the CI may be related to.

On the CI details pane, you can:

• Select Open Dependency View  to open the Dependency Views  map and display a graphic 
infrastructure view of the specific CI record.

• Select View CMDB 360 Data  to show CMDB 360 details at the CI attribute level for the 
specific CI record.

• Select Save  to save any changes made to attributes for the CI record.

• Select the More Actions icon (...) for additional functions:

◦ Select Create Change  to create a new change request  for the CI record.

◦ Select Create Incident  to create a new incident  for the CI record.

◦ Select Delete  to delete the CI record.

UI activity Additional requirements

CI Details

Accessible to: CMDB Admin, CMDB Editor, 
CMDB User

CI Health itil

Related Open Changes

Accessible to: CMDB Admin, CMDB Editor, 
CMDB User

sn_change_read role

Related Incidents

Accessible to: CMDB Admin, CMDB Editor, 
CMDB User

sn_incident_read role

Related Alerts

Accessible to: CMDB Admin, CMDB Editor, 
CMDB User

Event Management (com.glideapp.itom.snac) 
plugin

evt_mgmt_user role

Set up Event Management

Related Application Services

Accessible to: CMDB Admin, CMDB Editor, 
CMDB User

app_service_user role
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UI activity Additional requirements

View CMDB 360 Data

Accessible to: CMDB Admin, CMDB Editor, 
CMDB User

Enable and configure CMDB 360

Save

Accessible to: CMDB Admin

More Actions/Delete

Accessible to: CMDB Admin

My Work  view in CMDB Workspace

Use the My Work  view in CMDB Workspace  to manage your tasks. Tasks in this view are related 
to data compliance such as attestation, certification  and other life-cycle related tasks. The list of 
tasks for CMDB administrators can also contain unassigned tasks, for reassignment.

For CMDB administrators, lists of tasks can also contain unassigned tasks, for reassignment.  For 
managers, tasks of direct reports are included, and if you are a manager of a user group, then 
tasks of members in that group are also included.

Access

Role requirements: sn_cmdb_admin (CMDB Admin), sn_cmdb_editor (CMDB Editor), or 
sn_cmdb_user (CMDB User).

To access the My Work  view, navigate to Workspaces  > CMDB Workspace  and then select My 
Work  in the CMDB Workspace  menu bar.

Task status

The Task status section provides overall counts of tasks by their status. Counts in each status 
card are for attestation  and non-attestation, certification, and life-cycle  tasks as applicable.  Total 
tasks for example, is a count of all open tasks from CMDB Data Manager  that are assigned to you, 
or to an assigned group in the Managed by Group  attribute which you are a member of. For 
CMDB Admins, also tasks that aren't assigned to anyone.

Select a status card to show the associated tasks in the Attestation tasks  and All other tasks 
tabs in the My tasks section. For example, when you select the In progress status card in the 
Task status section, the Attestation tasks  list shows attestation tasks that are in progress and 
the All other tasks  list shows all non-attestation tasks that are in progress.

Certification tasks

The Certification tasks list view in the My tasks section lists any Data Certification tasks assigned 
to you or to an assignment group that you belong to in accordance with CMDB Data Manager 
policies.  For managers, tasks of direct reports are included, and for user group managers, tasks 
of members in the group are also included. Review and process these tasks by checking audit 
results for the associated CIs and attribute values. For more information about reviewing Data 
Certification tasks, see Review certification tasks in CMDB Workspace.
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Attestation tasks

The Attestation tasks  tab in the My tasks section  lists any attestation tasks assigned to you or 
to an assignment group that you belong to in accordance with CMDB Data Manager  Attestation 
policies.  For managers, tasks of direct reports are included, and for user group managers, tasks 
of members in the group are also included. Review and process these attestation tasks by 
checking the physical existence of IT infrastructure or applications associated with the CIs in the 
tasks. For information about reviewing and processing attestation tasks, see y.

The Overdue tasks  tab lists those tasks that are overdue so you can review those tasks at a 
higher priority.

Life-cycle tasks

The All other tasks  tab in the My tasks section lists any tasks, aside from attestation and 
certification tasks, assigned to you or to an assignment group that you belong to in accordance 
with CMDB Data Manager  policies.  For managers, tasks of direct reports are included, and for 
user group managers, tasks of members in the group are also included. Review and process 
these tasks.

CMDB 360  view in CMDB  Workspace

The CMDB 360  dashboard provides aggregations and analysis of CMDB 360  data. CMDB 
360  collects data about all the discovery sources reporting attribute values for CIs. Use the 
CMDB 360  view in Configuration Management Database (CMDB)  Workspace to track activities 
and identify potential issues of discovery sources. You can also create your own queries and 
associated schedules and reports to explore CMDB 360  data.

• For concepts and other background information about CMDB 360/Multisource CMDB, see 
CMDB 360/Multisource CMDB.

• For information about all CMDB 360  dashboard settings, see Configure the CMDB 360 
dashboard.

• For information about using the CMDB 360 view, see CMDB 360 experience in CMDB 
Workspace.

Note: 
Most cards on the CMDB 360 dashboard support non-CMDB tables in their aggregation, or 
can be configured to provide support. However, the CIs not reported by discovery sources 
card, for example, doesn't apply to non-CMDB tables. Creating queries for non-CMDB 
tables is also supported. For information about support for non-CMDB tables, see IRE 
support for non-CMDB tables.

Access

Requirements:

• Role requirement: sn_cmdb_user (CMDB user) or any role containing sn_cmdb_user

• Additional requirement: Enable and configure CMDB 360

To access the CMDB 360 view in the CMDB Workspace, navigate to Workspaces  > CMDB 
Workspace. In the CMDB Workspace  menu bar, select CMDB 360.

Management view in CMDB Workspace

The Management view provides CMDB Admins with quick access to key management tools and 
deep insights into CMDB health and activities. The view provides and details such as duplicate 
CIs and recent activities in the CMDB.
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Access

Role requirement: sn_cmdb_admin (CMDB Admin)

To access the Management view, navigate to Workspaces  > CMDB Workspace  and then select 
Management  in the CMDB Workspace  menu bar.

CMDB Data Manager

The following cards show details about CIs and policies associated with CMDB Data Manager:

Rejected CIs

CIs set as rejected during a review of attestation tasks.

Excluded CIs

CIs set as excluded  from CMDB Data Manager policies.

Draft policies

Draft Data Manager policies  that were created but not published.

CI Correctness

Cards in this section show health state for the sub metrics of the CMDB Health  correctness KPI. 
Counts are based on testing CIs against pre-defined data integrity rules such as:

• Identification rules  (to detect duplicate CIs)

• Orphan CI rules

• Staleness CI rules

You can set the time interval used in calculations for these counts.

For more information about the correctness KPI, and the duplicate, orphan, and stale sub 
metrics, see CMDB Health KPIs and metrics.

Recent activity trends

The following cards show recent activities in the CMDB:

Recent CI Activity

A 7-day chart showing metrics related to CIs such as the number of new CIs and 
updated CIs.

Recent Application Service Activity

A 7-day chart showing metrics related to Application Services  such as the total 
number of Application Services, new and updated Application Services, and the 
number of Application Services with outages.

Management tools

Provides links that you can use to access CMDB dashboards, tools, and list views. The links are 
grouped by categories as described below.

Note: 
Some links are conditionally available based on installation of applications, active plugins, 
and your assigned role. For a link that doesn't appear, make sure that all the requirements 
for the link are met.

Manage:
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• CI Class Manager: Centrally view, create, or edit class definitions and class settings for 
Identification and Reconciliation (IRE) and for CMDB Health.

Additional role requirement: itil or personalize_dictionary.

• Data Manager: Centrally create, edit, review, publish, and track Data Manager policies and the 
tasks generated by the policies.

• De-duplication Template Library: Create and manage de-duplication templates and libraries to 
remediate de-duplication tasks in bulk.

• De-duplication Dashboard: Show counts and insights for duplicate CIs in the CMDB, and run 
and track de-duplication templates to remediate de-duplication tasks in bulk.

• CMDB Groups: Show a list view of current CMDB groups where you can create new CMDB 
groups, and manage the existing CMDB groups. A CMDB group is a collection of CIs to which 
you can apply CI actions collectively to all the CIs in the group. For example, CMDB Health can 
monitor CIs in a Health-type CMDB group, and report the aggregated health for the group as a 
whole.

• Dynamic CI Groups: Show a list view of current dynamic CI groups where you can create new 
dynamic CI groups, and manage the existing ones. Dynamic CI Groups act as application 
services that are populated with members of the CMDB group that is associated with the 
dynamic CI group. For more information about dynamic CI groups, see Application services.

Optimize:

• CMDB Health: View the CMDB Health dashboards and configure the CMDB health KPIs and 
metrics that CIs are evaluated by in CMDB Health dashboards.

Additional requirements:

◦ Set up and configure CMDB Health

◦ Roles: asset or itil

• CMDB Data Foundations Dashboard: Displays the CMDB Data Foundations dashboard.

Additional requirements:

◦ Set up CSDM and CMDB Data Foundations Dashboards

◦ Roles: asset, Itil_admin, or admin

◦ Plugin: com.snc.cmdb.getwell

• De-Duplication Tasks: Remediate a de-duplication task by using the Duplicate CI Remediator 
wizard which guides you through the duplicate CI reconciliation process.

Additional role requirement: itil.

• CMDB Remediation Rules: Rules associated with a CMDB Health  task that was created for a 
failed CMDB Health test. A CMDB remediation rule runs a remediation workflow to remediate 
an issue reported by CMDB Health.

Visualize:

• Dependency Views: Provides a graphic infrastructure view for a CI and any applications or 
business services that it is part of and that it supports.

Additional role requirement: dependency_views.
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• Query Builder: Easily build complex infrastructure and service queries, that span multiple 
CMDB classes, non-CMDB tables, and that can involve many CIs that are connected by 
different relationships.

Additional role requirement: cmdb_query_builder_read.

Create: New Technical Service

Additional role requirement: service_admin.

Insights view in CMDB Workspace

Use the Insights view in CMDB Workspace  to see and increase the level of adoption of key 
CMDB features and application services to improve the overall health of the CMDB. Explore how 
tools and features can maximize the health and efficiency of your CMDB and use direct links to 
install and start using features immediately.

Insights view is available starting with CMDB Workspace  v3.4.6.

Access

Role requirement: sn_cmdb_user (CMDB User), or a user role containing sn_cmdb_user 
(sn_cmdb_admin, sn_cmdb_editor).

To access the Insights view, navigate to Workspaces  > CMDB Workspace  and then select 
Insights  in the CMDB Workspace  menu bar.

The Insights view includes the following tiles:

• CMDB feature adoption

• CMDB performance insights

• Application services

• Cloud vs Non-cloud resources

CMDB feature adoption

Shows dial charts for the overall adoption levels of all three categories of CMDB tools and 
features:

Data ingestion

Tools and features that support and ensure ingestion of high-quality data into the 
CMDB.

Data governance

Tools and features that let you manage the CMDB data after it has been ingested.

Search and analytics

Tools and features that provide meaningful and helpful insights into the CMDB data.

Select each dial chart in the tile to access its tab and associated cards with further details about 
the features in the category. Pay special attention to categories with low levels of adoption and 
those features that aren't yet implemented in the instance and which you should consider for 
adoption.

Each category tab shows cards for the features in the category and the following general cards:
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• Overall adoption level for the tab: The calculated overall level of adoption for the tab. 
Calculations are specific for each tab, and can be based, for example, on the level of adoption 
of some or all the features in the tab.

• Adoption progress: Installation, activation, or usage status per feature in the tab. Select a 
feature link to access a relevant resource such as the feature's landing page with an overview 
dashboard or an installation location.

Depending on adoption level, a card might contain any of the following resource links:

• Learn more: Link to documentation to learn and explore the benefits and usage of the feature.

• View demo: Link to a short demo about the feature.

• Get started: Link to a landing page where you can start immediately utilizing the feature.

• Install app: Link to the ServiceNow Store  where you can immediately install the app.

Cards use different methods to examine the instance and determine if the card's feature is 
installed, activated, and being used. For example, some cards check for the installation status of 
plugins and some cards rely on data in the specific feature tables. Many counts and aggregation 
data that appear on cards is based on Performance Analytics indicators  built on top of the Base 
Aggregate Data [sn_cmdb_ws_base_aggregate_data] table.

• If the result is that the card's feature is installed or being used, then the card shows charts and 
counts about the level of usage. In which case, the card's label might slightly adjust.

• If the result is that the card's feature isn't installed or isn't in use, then links are provided to 
resources where you can explore, install, and start using the feature.

Most of the cards scheduled jobs run every 24 hours, therefore, depending on the type of data, 
some card data is based on recent but not current data. The Last updated timestamp in the cards 
reflects the collection time for the data that was used for the card. Also, immediately after getting 
started with a feature, a card won't reflect on the latest status or usage of the feature, until up to 
24 hours when the card's scheduled job runs (for the CIs processed by IRE based on source 
card, the associated scheduled job, CMDB Workspace  - Populate aggregates Monthly, runs 
monthly).

The following sections provide details for each card, including the calculation script used for the 
card.

CMDB feature adoption: Data ingestion

The overall adoption level for data ingestion maps to the following findings in the instance:

• Low (red): Less than 80% of CIs are processed by Identification and Reconciliation Engine 
(IRE)

• Moderate (amber): 80—90% of CIs are processed by IRE

• High (green): Over 90% of CIs are processed by IRE

Data ingestion contains the following features and aggregations:

CIs processed by IRE

Determines the percentage of CIs that are processed by IRE, by checking the 
Source [sys_object_source] table. CIs that aren't processed by IRE introduce a data 
integrity risk.

The percentage of CIs that are being processed by IRE determines both, the level 
of adoption for this feature card and the overall adoption level for the entire data 
ingestion category.
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Service Graph Connectors

Determines the installation and usage status of Getting started with Service Graph 
Connectors, by checking:

• If the ITOM Licensing plugin (com.snc.itom.license) is active

• If there is at least one Service Graph Connector installed in the instance

If Service Graph Connectors are installed and are in use, then the card shows a 
count of those connectors.

Note: 
The count of Service Graph connectors that appears on the card might be 
slightly different than the number of connectors that show on the ServiceNow 
Store  site because the counting methods that are used are different.

IntegrationHub ETL

Determines whether the IntegrationHub ETL  store app is installed and used, 
based on records in the CMDB Integration Studio Application Data Sources 
[cmdb_inst_application_feed] table. If IntegrationHub ETL is in use, then the card 
shows a count of ETL transform maps in IntegrationHub ETL (demo ETL transform 
maps aren't counted).

Select View ETL transform maps  to open IntegrationHub ETL where you can 
examine existing ETL transform maps and create new ones.

CIs processed by IRE based on source

Chart showing CIs processed by IRE, grouped by Service Graph Connectors, 
ServiceNow  Discovery, a combination of both, and others, for the past six months.

The following discovery sources are counted as ServiceNow  Discovery:

• ServiceNow

• ServiceWatch​

• ACC-Visibility​

• AgentClientCollector

• CredentiallessDiscovery

Point to the chart to show monthly aggregation data.

This card is hidden if there are no CIs processed by IRE.

CMDB application for APIs and CLI

Determines whether the CMDB application for APIs and CLI  store app is installed.

This card appears only if the store app isn't installed, providing helpful resources for 
exploration and adoption.

CMDB feature adoption: Data governance

The overall adoption level for data governance maps to the following findings in the instance:

• Low (red): Less than 33% of features are used

• Moderate (amber): 33—66% of features are used

• High (green): Over 66% of features are used

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

192

https://www.webstg.servicenow.com/docs/access?context=cmdb-cli-commands&version=washingtondc&pubname=washingtondc-application-development&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=cmdb-cli-commands&version=washingtondc&pubname=washingtondc-application-development&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=cmdb-cli-commands&version=washingtondc&pubname=washingtondc-application-development&ft:locale=en-US


The overall level of adoption of data governance is based on whether CMDB Data Manager 
features are used.

Note: 
Historical data might not be available for all past 90 days because CMDB Workspace 
version 3.4, which relies on Performance Analytics indicators to collect and save 
historical usage data, was deployed less than 90 days ago. This situation might result in a 
discrepancy between actual usage and what the card shows.

CMDB Data Manager/CIs used in Data Manager policies

Determines usage by checking if either of the following conditions is true:

• There are any user-created Delete, Retire, or Archive policies 
(by searching table CMDB Data Manager Policy and Attributes 
[cmdb_data_manager_policy_and_attributes])

• There are any CIs processed by these user-created Delete, Retire, or Archive 
policies, in the last 90 days (by searching table CMDB Data Management Policy 
Executions [cmdb_data_management_policy_execution])

If CMDB Data Manager is in use, shows a chart with CIs that were processed by 
these policies in the past six months, by month, and by policy type.

Data attestation/CIs used in data attestation

Determines usage by checking if either of the following conditions is true:

• There are any user-created Attestation policies  (by searching table CMDB Data 
Manager Policy and Attributes [cmdb_data_manager_policy_and_attributes])

• There are any CIs processed by these user-created Attestation policies, in the 
last 90 days (by searching table CMDB Data Management Policy Executions 
[cmdb_data_management_policy_execution])

If data attestation is in use, shows a chart with CIs that were processed by 
attestation policy tasks in the past six months, by month.

Data synchronization

Checks if there is at least one class for which the managed_by_group  attribute is 
globally set so that all class CIs are synchronized on the same value.

For information about synchronizing group assignment attributes using the CI Class 
Manager, see Set the group for a CI or an entire class of CIs.

The Data synchronization card is available starting with CMDB Workspace  v3.6.

Principal classes

Checks if the Principal Class filter is configured with at least one principal class. The 
Principal Class filter limits the number of CIs that appear in list views, to show only 
CIs of principal classes. Reducing the amount of data in list views to only relevant 
data, improves performance and efficiency.

For more information about managing the Principal Class filter in CI Class Manager, 
see Update the list of classes in the Principal Class filter.

The Principal class card is available starting with CMDB Workspace  v3.6.
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CMDB feature adoption: Search & analytics

The overall adoption level for search & analytics maps to the following findings in the instance:

• Low (red): Less than 33% of features are used

• Moderate (amber): 33—66% of features are used

• High (green): Over 66% of features are used

Search & analytics contains the following features and aggregations:

CMDB Query Builder/Query Builder queries

Determines if the CMDB Query Builder  is in use, by checking if either of the 
following conditions is true:

• There are any records in the Saved Queries [qb_saved_query] table in which 
Source  is QB

• There are any queries executed or queries executed with reports, in the last 90 
days

Note: 
Historical data might not be available for all past 90 days because CMDB 
Workspace  version 3.4, which relies on Performance Analytics indicators to 
collect and save historical usage data, was deployed less than 90 days ago. 
This situation might result in a discrepancy between actual usage and what 
the card shows.

If CMDB Query Builder is in use, shows a chart with counts of query executions and 
query executions in reports, for the past six months, by month.

Point to the chart to see monthly aggregation data.

Intelligent search

Determines if Intelligent Search for CMDB  is in use by checking the NLQ Query Logs 
[nlq_query_log] table for any records where source  is CMDB_WS, from the past 
90 days. If Intelligent Search is in use, shows counts of Intelligent Search queries for 
the past six months, by month.

Note: 
Historical data might not be available for all past 90 days because CMDB 
Workspace  version 3.4, which relies on Performance Analytics indicators to 
collect and save historical usage data, was deployed less than 90 days ago. 
This situation might result in a discrepancy between actual usage and what 
the card shows.

CMDB 360 — Records in Multisource

Total number of raw CMDB 360  records in the CMDB 360 data store that contains 
records for each discovery source report, per each CI attribute. This card is identical 
to the Total CMDB 360 records  card in the Discovery Sources tile in the CMDB 360 
view.

This card appears only if CMDB 360 is enabled, which is determined by checking 
the ITOM Discovery License (com.snc.itom.discovery.license) plugin and the system 
property glide.identification_engine.multisource_enabled.

CMDB 360 queries
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Count of CMDB 360 queries that exist in the CMDB Multisource Queries 
[cmdb_multisource_query] table.

This card appears only if CMDB 360 is enabled, which is determined by checking 
the ITOM Discovery License (com.snc.itom.discovery.license) plugin and the system 
property glide.identification_engine.multisource_enabled.

CMDB Data Foundation dashboard

Determines if the CMDB and CSDM Data Foundations Dashboards  store app (which 
includes the CMDB Data Foundation dashboard) is installed.

This card appears only if the store app isn't installed, providing helpful resources 
for exploration and adoption. However, the feature is still included in calculating the 
search & analytics overall level of adoption.

CMDB Health Dashboard

Determines if CMDB Health  is in use by checking if at least one CMDB Health 
Dashboard job is enabled.

This card appears only if the feature isn't in use, providing helpful resources for 
exploration and adoption. However, the feature is still included in calculating the 
search & analytics overall level of adoption.

CMDB performance insights

CMDB performance insights is available starting with CMDB Workspace  v3.6 and only appears 
for users with the sn_cmdb_admin (CMDB Admin) role.

CMDB performance insights helps you understand the ways in which your configurations impact 
the performance of your CMDB. You can use the charts and tools within CMDB performance 
insights to troubleshoot, debug, or diagnose performance issues. CMDB performance insights 
also analyzes your CMDB and Service Graph Connectors  on your instance to generate 
recommendations on how you can improve the performance of your CMDB. The CMDB 
performance insights tile itself can show up to two of those recommendations.

Select View performance insights  to access the CMDB performance insights data.

The Payloads & CIs tab contains the following tiles:

Partial payloads

Partial payloads occur when the data source didn't provide enough information to 
uniquely identify the CI, preventing IRE from processing the CI.

• Total partial payload count:

Shows the total number of partial payloads that exist in your instance. 
Large numbers of partial payloads in your instance can cause performance 
deterioration of the CMDB.

For more information about partial payloads, see Identification and Reconciliation 
engine (IRE).

• Discovery source:

Breaks down the number of partial payloads by discovery sources. You can drill 
down on slices in this pie chart to see the list of partial payloads with errors, 
filtered by discovery source.
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You can drill down on specific partial payloads to better understand the error that 
you're experiencing. When you drill down on a partial payload, you can see the 
full payload item, which you can review to troubleshoot and address the specific 
errors.

For more information about error types, see Generate and simulate payload 
execution using identification simulation.

Related records

Data about related records that are missing references. A record is missing a 
reference when the Referenced  field for that record is empty.

• Related records missing reference:

Shows the total number of records that do not reference a CI in the Referenced 
field in the Related table. You can see a full list of the Related tables and the 
associated Referenced  fields in the Related Entries [cmdb_related_entry] 
table.

For more information about Related tables, see Overview of CMDB.

• Related records missing reference by table:

Breaks down the number of CMDB records missing references, by table. You can 
drill down on slices in this chart to see the list of specific records filtered by table.

Before you can drill down on a slice of this pie chart, you must have any user roles 
required to view the table.

You can also select New  from the list view to create a new related entry table 
record. For more information about creating or editing a related entry table record, 
see Edit a related table from CMDB performance insights.

Duplicate and stale CIs

A CI is flagged as duplicate during identification and reconciliation. A CI is flagged 
as stale if it has not been updated within the Effective Duration time period 
specified in the CMDB Health staleness rule  for the CI class.

• CIs:

Shows the number of CIs that are either duplicate or stale.

• Stale records by class:

Breaks down the number of stale CIs based on the CI class. You can drill down on 
slices in this pie chart to see the list of specific CI records filtered by class.

For more information about stale CIs, see CMDB Health KPIs and metrics.

• Duplicate records by class:

Breaks down the number of duplicate CIs based on the CI class. You can drill 
down on slices in this pie chart to see the list of specific CI records.

For more information about duplicate CIs, see Duplicate CIs remediation.

Relationship records missing parent or child
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Shows the trend line and number of relationship records in the CI Relationships 
[cmdb_rel_ci] table that are missing a parent or child CI. CIs that are missing a 
parent or child are considered invalid records and can have a performance impact 
on your instance.

Recommendations

Recommendations on this panel include a link to the related documentation and 
typically enable direct access to the associated tool, feature, or system property. 
Expand or minimize the panel by selecting the light bulb icon.

The first two recommendations appear on the CMDB performance insights tile of 
the Insights view.

You can only see a recommendation if you have the roles needed to access the 
feature, tool, or system property. Users with the sn_cmdb_admin role can hide 
recommendations or adjust the order in which recommendations appear. Users 
can use the Active  and Order  fields in the CMDB WS Imp Action Card Config 
[sn_cmdb_ws_imp_action_card_config] table to configure those elements.

The Service Graph connectors tab contains the following tiles:

Note: 

• The Service Graph connectors tab only appears if your instance has at least one Service 
Graph Connector  and you have the cmdb_inst_admin role.

• To edit data source or scheduled data import records from CMDB Workspace, you may 
need to set Application scope  to the Application  of the data source or data import.

Connectors data source

Configurations on your Service Graph Connector  data sources affect the ingestion 
and processing of incoming data. Changing your Service Graph Connector  data 
source configurations can streamline data handling, making your CMDB more 
efficient and reducing impacts on the performance of your instance.

• Sources with batch processing turned off:

Shows the percentage of Service Graph Connector  data sources in the Data 
Sources [sys_data_source] table with disabled Use Batch Import. It also lists the 
total number of data sources, and the number of data sources with enabled or 
disabled batch processing.

To enable batch processing, access the record of a specific data source from 
the list view and select Use Batch Import. For more information about batch 
processing, see Data source fields .

You can also select Edit  to update a data source from the list view. For more 
information about editing a data source, see Edit a data source from CMDB 
performance insights.

• Sources with concurrent import turned off:

Shows the percentage of scheduled data imports of Service Graph Connector 
data sources in the Scheduled Data Imports [scheduled_import_set] table with 
Concurrent Import  turned off. It also lists the total number of scheduled data 
imports, and the number of scheduled data imports with Concurrent Import 
turned on or off.
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To enable concurrent import, access the record of a specific scheduled data 
import from the list view and select Concurrent Import. For more information 
about concurrent import, see Concurrent imports .

You can also select Edit  to update a scheduled data import from the list view. For 
more information about editing a scheduled data import, see Edit a scheduled 
data import from CMDB performance insights.

• Sources with non-custom size partition method:

Shows the percentage of scheduled data imports of Service Graph Connector 
data sources in the Scheduled Data Imports [scheduled_import_set] table that 
use a non-custom size partition method. It also lists the total number of scheduled 
data imports, and the number of scheduled data imports that use a non-custom 
size partition method.

To use a custom size partition method, access the record of a specific scheduled 
data import from the list view. Ensure that Concurrent Import  is selected. From 
the Partition Method  drop-down menu that appears, select Custom size. For 
more information about partition methods, see Schedule a data import .

You can also select Edit  to update a new scheduled data import from the list view. 
For more information about editing a scheduled data import, see Edit a scheduled 
data import from CMDB performance insights.

Connectors execution trends

Aggregates Service Graph Connectors  with outlier connector executions, where the 
number of imported rows or the rate of processing is significantly higher or lower 
than the 30-day trend.

• Connectors with processing rate outliers:

Shows the number of Service Graph Connectors  that are considered outliers with 
connector execution processing rates outside the expected trend lines within the 
past 30 days.

• Connectors with import count outliers:

Shows the number of Service Graph Connectors  that are considered outliers with 
connector execution import counts outside the expected trend lines within the 
past 30 days.

You can drill down the cards in the Connectors execution trends tile to access the 
Service Graph connector execution trends window. In that windows, a Service 
Graph Connector  is available in the connectors drop-down menu only if it has an 
execution record.

Click the tabs on the Service Graph connector execution trends window to view 
the following charts and the Connector Execution list view of executed connector 
import sets:

• Processing rate:

Models the trend line of processing rates for connector executions. Shows the 
rate at which a connector processes rows of data over a period of time.

There are two zones, which are the Confidence Band and the Prediction Band. 
Service Graph Connectors  with connection executions that have processing rates 
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outside of the Prediction Band are considered outliers. These zones don't appear 
when you select more than one Service Graph Connector.

• Import count:

Models the trend line of rows processed for connector executions. Shows the 
number of rows a connector processes over a period of time.

There are two zones, which are the Confidence Band and the Prediction Band. 
Service Graph Connectors  with connector executions that have import row counts 
outside of the Prediction Band are considered outliers.

On both charts, you can select outlier and non-outlier Service Graph Connectors  to 
see the trend lines against each other.

For more information about processing data with Service Graph Connectors, see Getting started 
with Service Graph Connectors.

Application services (Application Services Dashboard)

Shows a chart with a count of application services  in your organization, based on records in the 
Application Services [cmdb_ci_service_auto] table. The chart shows the trend of total number of 
application services per day, for the past seven days. Use the Application Services Dashboard to 
monitor the adoption level and health of application services.​

Note: 
Some population methods for application services are available only with Service 
Mapping  and therefore won't appear in the tile if Service Mapping isn't installed.

Select the chart to access the tile tabs and their cards with further details. Pay special attention 
to application services that aren't fully configured and are missing data. Reduce the number 
of incomplete application services by editing application services  and populating any empty 
attributes.

Select any card to drill down to the list view of the respective application services.

The Overview tab shows the following aggregations:

• Total application services: Count of all application services.

• Population method defined: Count of application services for which a population method is 
specified.

• Population method not defined: Count of application services for which a population method 
isn't specified.

• Application services types: Chart of application services by population methods such as 
Dynamic CI Group and Manual, including application services without a population method 
(Empty). The chart includes business services that were converted to application services.

• Application services missing data: Chart of application services by key data, such as service 
offering and owner, that is missing.

The Application service coverage tab contains the following tiles and cards:
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• Application Servers

◦ Total servers: Total number of application servers.

◦ Servers not in application service: Count of application servers which aren't in any 
application service.

◦ Servers not in an application service: Chart of application servers which aren't in any 
application service, by class.

• Databases

◦ Total databases: Total number of databases

◦ Databases not in application service: Count of databases which aren't in any application 
service.

◦ Databases not in an application service: Chart of databases which aren't in any application 
service, by class.

• Hardware Servers

◦ Total hardware servers: Total number of hardware servers.

◦ Hardware servers not in application service: Count of hardware servers which aren't in any 
application service.

◦ Hardware servers not in an application service: Chart of hardware servers which aren't in any 
application service, by class.

Note: 
Application servers, hardware servers, and databases not included in application services, 
are counted only up to about 100,000, even if the actual number is over this limit. This 
number limit is set by the glide.cmdb.csdm.app_service.max_results  property.

Select Owned by, Support group, or Change group  to filter the list of application services that 
are included in the dashboard, by a key attribute. A filter doesn't impact counts of application 
services in which the respective filter attribute is missing. For example, filtering by Owner, doesn't 
change the count of the Missing Owner card.

Cloud vs Non-cloud resources

Charts  showing counts and details for resources  and application services  that are hosted on 
various cloud services versus those that aren't. Resources  and application services  can be 
deployed on cloud services such as the Microsoft Azure Cloud, or on the local instance or other 
non-cloud solutions. For some ongoing operations in the organization, it might be necessary to 
have those details which can be difficult to obtain.

For details about the charts, see 'Cloud vs Non-cloud resources' in the CMDB Workspace store 
app  topic.

The Application Services pie chart is available starting with CMDB Workspace  v3.6.

Modify important actions in CMDB Workspace

Modify the appearance order and other properties of the important action cards that appear on 
the landing page of the CMDB Workspace.

Before you begin
Role required: sn_cmdb_admin
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About this task
The task cards that appear in the Important tasks tile on the landing page of 
the CMDB Workspace, are stored in the CMDB WS Imp Action Card Config 
[sn_cmdb_ws_imp_action_card_config] table. You can edit some attributes of these cards, 
including the setting that controls whether a specific card appears at all. Cards in the Important 
actions tile are available only for the CMDB Admin [sn_cmdb_admin] and the CMDB Editor 
[sn_cmdb_editor] user roles and each is configured per one of those roles.

There is some overlap in the task cards that appear for a CMDB Admin and for a CMDB Editor, 
however, the filters in those task cards are different. Typically, for CMDB Admins, the card filter 
also includes unassigned tasks that a CMDB Admin needs to assign.

Only editing is possible, you can't add or delete action records in this table.

Procedure

1. Navigate to All.

2. In the navigation filter, enter sn_cmdb_ws_imp_action_card_config.list.

3. In the list view of the table, edit the table row that you want to modify or click the row to open 
the record form.

Field Description

Persona
The logged on user (such as CMDB Admin) 
for which this card appears.

You can't edit this field.

Type
Tasks group that this task belongs to, such as 
Duplicate CIs.

You can't edit this field.

Table The table used in the card filter.

You can't edit this field.

Active Determines whether the card for this action 
appears in CMDB Workspace.

Order Numeric value that determines the order of 
each card within the rest of the cards in the 
Important actions tile. Cards with lower order 
numbers appear before cards with higher 
order numbers.

Filter condition Filters for the tasks that are included for the 
card.

List columns Columns that appear in the list view when 
you click a card to show its associated tasks.

List groupby Attribute to group by the card's associated 
tasks in the card's list view. The card's list 
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Field Description

view appears when you click a card to show 
its associated tasks.

4. Click Update.

Add a quick link to the CMDB Workspace

For an immediate access to tools or data that you need, add your own quick link to the landing 
page of the CMDB Workspace.

Before you begin
Role required: sn_cmdb_admin, sn_cmdb_editor, or sn_cmdb_user

About this task
Quick links are stored in the Quick Links [sn_cmdb_ws_quick_links] table including those that are 
included in the base system. Only the user that added a quick link has access to that link, and 
can subsequently edit or delete that added link.

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the Quick links section, click the '+' icon.

3. Enter the URL  and Display text  for the link and then click Add.

A valid URL must start with "http:" or "https:". To link to a tool in the instance such as the CI 
Class Manager, enter the full URL to the tool's landing page.

4. Click Done.

Result
The new link is available only for the user that created the link, in the Quick links section in the 
landing page of the CMDB Workspace.

What to do next
Click on the Edit quick links icon to edit, delete, or reposition an added link. Then use the up and 
down arrows to move a link within the list, and click the Edit icon next to a link that you want to 
modify or delete from the list.

Configure datacenters for the Cloud vs Non-cloud resources chart

The Cloud vs Non-cloud resources chart in CMDB Workspace  determines which CIs  and 
application services  are stored on a cloud and which aren't in the organization. In addition to 
base system classifications, you can add cloud versus non-cloud classifications that reflect 
specific datacenter deployments in the organization.

Before you begin
Role required: sn_cmdb_admin

About this task
The Datacenter Types [sn_cmdb_ws_datacenter_type] table stores datacenter classes with a 
classification of being used as a cloud storage or not in the organization. The calculations for the 
Cloud vs Non-cloud resources chart in the CI overview tile in CMDB Workspace, reflects on the 
datacenters in that table and their classifications.

CIs are counted as non-cloud mainly if either of the following conditions is met:
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• The CI is not associated with any datacenter.

• The CI is associated with a datacenter that is classified as non-cloud in the Datacenter Types 
table.

In the base system, the Datacenter Types table contains several common datacenters. For 
example, the Azure Datacenter [cmdb_ci_azure_datacenter) class is classified as 'Cloud'. 
Therefore, the Cloud vs Non-cloud resources chart includes in its calculations and bars the Azure 
Datacenter [cmdb_ci_azure_datacenter) class.

Procedure

1. Select All.

2. In the Filter navigator, enter sn_cmdb_ws_datacenter_type.list  to access the 
Datacenter Types table.

3. Click New  and fill out the Datacenter Type form for a datacenter that is used in the 
organization.

Field Description

Datacenter class A child class of the Logical Datacenter 
[cmdb_ci_logical_datacenter] class which is 
used in the organization.

Type Classification that reflects whether the 
specified Datacenter class  is being used as 
cloud storage or not.

Cloud Provider Custom label for the cloud provider.

4. Click Submit.

Resume a disabled scheduled job for the Cloud vs Non-cloud resources chart

Reactivate a scheduled job to resume data collection for the Cloud vs Non-cloud resources chart 
in CMDB Workspace.

Before you begin
Role required: cmdb_query_builder (contained in the sn_cmdb_user, sn_cmdb_editor, 
sn_cmdb_admin user roles)

About this task
The Cloud vs Non-cloud resources  chart in CMDB Workspace  uses several scheduled jobs 
that gather and calculate the data for the charts. Each bar in the CI classes chart represents a 
pair of a CI class and a storage type (cloud, non-cloud) such as Applications/Cloud. Each bar 
is associated with its own scheduled job. When a scheduled job exceeds its limits of time and 
amount of collected data, it is automatically stopped. A job that can't complete for 3 (default) 
consecutive days is automatically disabled for future runs.

Use the following procedure to later resume that disabled scheduled job.
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Procedure

1. Click All.

2. In the Filter navigator, enter sysauto_query_builder.list  and open the Scheduled 
Email of Query Builders table.

3. In the Scheduled Email of Query Builders  list view, set Active  to true  for the scheduled job to 
resume.

Configure CI classes for the Cloud vs Non-cloud resources chart

Include or exclude pairs of CI Class/Type  in the Cloud vs Non-cloud resources chart in 
CMDB Workspace.

Before you begin
Role required: sn_cmdb_admin

About this task
The CMDB Insight Query Categories [sn_cmdb_ws_insight_query_category] table contains 
the pairs of CI Class/Type  for the Cloud vs Non-cloud resources chart in the CI overview 
tile in CMDB Workspace. The Active  setting in a record determines if the respective CI 
Class/Type  pair appears in the chart. By default, all pairs are configured to appear in the chart.

A CI Class/Type  pair appears or doesn't appear according to its Active  setting and 
regardless of the status of its associated scheduled job.

Procedure

1. Select All.

2. In the Filter navigator, enter sn_cmdb_ws_insight_query_category.list  to access 
the CMDB Insight Query Categories table.

3. Set Active  to true  or false  for a CI Class/Type pair.
For example, set Active  to false  for the Applications/Non-cloud  pair. This setting will 
exclude from the chart all CIs in the Applications class which are determined to be non-cloud.

Class-specific criteria for the Cloud vs Non-cloud resources chart

The Cloud vs Non-cloud resources chart provides counts for several key classes. The chart uses 
different classes and relationship criteria for each class to determine which resources count as 
cloud and which count as non-cloud.

The Cloud vs Non-cloud resources chart shows in the CI overview tile in the CMDB Workspace 
store app.

Virtual Machine Instance [cmdb_ci_vm_instance]:

• Cloud:

Virtual Machine Instance [cmdb_ci_vm_instance] -> (Hosted on::Hosts) -> Datacenter class 
(one of the configured cloud datacenters) -> (Hosted on::Hosts) -> Cloud Service Account 
[cmdb_ci_cloud_service-account]

• Non-Cloud:
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Virtual Machine Instance [cmdb_ci_vm_instance] -> (Hosted on::Hosts) -> Datacenter class 
(one of the configured non-cloud datacenters)

• Total: Equals the record count in the Virtual Machine Instance [cmdb_ci_vm_instance] table 
(unless there are Virtual Machine Instance records without any relationships)

Server [cmdb_ci_server]:

• Cloud:

Server [cmdb_ci_server] -> (Virtualized by::Virtualizes) -> Virtual Machine Instance 
[cmdb_ci_vm_instance] -> (Hosted on::Hosts) -> Datacenter (one of the configured cloud 
datacenters) -> (Hosted on::Hosts) -> Cloud Service Account [cmdb_ci_cloud_service-
account]

• Non-Cloud:

Server [cmdb_ci_server] -> Virtual Machine Instance [cmdb_ci_vm_instance] -> Datacenter 
class (one of the configured non-cloud datacenters)

OR

Server [cmdb_ci_server] has no relationships with Virtual Machine Instance 
[cmdb_ci_vm_instance]

• Total: Equals the record count in the Server [cmdb_ci_server] table (unless there are Server 
records without any relationships)

Application [cmdb_ci_appl]:

• Cloud:

Application [cmdb_ci_appl] -> (Runs on::Runs) -> Server [cmdb_ci_server]-> (Virtualized 
by::Virtualizes) -> Virtual Machine Instance [cmdb_ci_vm_instance] -> (Hosted on::Hosts) -> 
Datacenter (one of the configured cloud datacenters) -> (Hosted on::Hosts) -> Cloud Service 
Account [cmdb_ci_cloud_service-account]

OR

Application [cmdb_ci_appl] -> (Hosted on::Hosts) -> Datacenter class (one of the configured 
cloud datacenters)-> (Hosted on::Hosts) -> Cloud Service Account [cmdb_ci_cloud_service-
account]

• Non-Cloud:

Application [cmdb_ci_appl] -> Server [cmdb_ci_server] -> Virtual Machine Instance 
[cmdb_ci_vm_instance] -> Datacenter Datacenter class (one of the configured non-cloud 
datacenters)

OR

Application [cmdb_ci_appl] -> Server [cmdb_ci_server] -> no relationship with Virtual 
Machine Instance [cmdb_ci_vm_instance]

• Total: Equals the sum of Cloud + Non-Cloud (not the record count in the Application 
[cmdb_ci_appl] table)

Kubernetes Cluster [cmdb_ci_kubernetes_cluster]:
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• Cloud:

Kubernetes Cluster [cmdb_ci_kubernetes_cluster -> (Hosted on::Hosts) -> Datacenter (cloud 
logical data center) -> (Hosted on::Hosts) -> Cloud Service Account [cmdb_ci_cloud_service-
account]

• Non-Cloud:

Kubernetes Cluster [cmdb_ci_kubernetes_cluster -> Datacenter (non-cloud logical 
datacenter)

OR

Kubernetes Cluster [cmdb_ci_kubernetes_cluster -> no relationship with -> Datacenter

• Total: Equals the record count in the Kubernetes Cluster [cmdb_ci_kubernetes_cluster] table 
(unless there are Kubernetes Cluster records without any relationships)

Database Instance [cmdb_ci_db_instance]:

• Cloud:

Database Instance [cmdb_ci_db_instance] -> (Runs on::Runs) -> Server -> (Virtualized 
by::Virtualizes) -> Virtual Machine Instance [cmdb_ci_vm_instance] -> (Hosted on::Hosts) -> 
Logical Datacenter (one of the configured cloud datacenters)-> (Hosted on::Hosts) -> Cloud 
Service Account [cmdb_ci_cloud_service-account]

OR

Database Instance [cmdb_ci_db_instance] -> Logical Datacenter 
[cmdb_ci_logical_datacenter] (one of the configured cloud datacenters)-> (Hosted on::Hosts) 
-> Cloud Service Account [cmdb_ci_cloud_service-account]

• Non-Cloud:

Database Instance [cmdb_ci_db_instance] -> Server [cmdb_ci_server] -> Virtual Machine 
Instance [cmdb_ci_vm_instance] -> datacenter (non-cloud logical datacenter)

OR

Database Instance [cmdb_ci_db_instance] -> Server [cmdb_ci_server] with no relationship -> 
Virtual Machine Instance [cmdb_ci_vm_instance]

• Total: Sum of Cloud + Non-cloud (can be less than total number of records, subtracting the 
badly created records)

Storage Volume [cmdb_ci_storage_volume]:

• Cloud:

cmdb_ci_storage_volume -> (Hosted on::Hosts) -> Logical Datacenter 
[cmdb_ci_logical_datacenter] (one of the configured cloud datacenters)-> (Hosted on::Hosts) 
-> Cloud Service Account [cmdb_ci_cloud_service-account]

• Non-Cloud:

cmdb_ci_storage_volume -> Logical Datacenter [cmdb_ci_logical_datacenter] (one of the 
configured non-cloud datacenters)
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OR

cmdb_ci_storage_volume -> no relationships with Datacenter

Cloud Object Storage [cmdb_ci_cloud_object_storage]:

• Cloud:

Cloud Object Storage [cmdb_ci_cloud_object_storage] -> (Hosted on::Hosts) -> Logical 
Datacenter [cmdb_ci_logical_datacenter] -> (Hosted on::Hosts) -> Cloud Service Account 
[cmdb_ci_cloud_service-account] (requires CMDB CI Class Models store app)

• Non-Cloud:

N/A (This table can never have non cloud records)

Service Accounts [cmdb_ci_cloud_service_account]:

• Cloud:

datacenter_type attribute is populated with correct datacenter class

• Non-Cloud:

N/A (This table can never have non-cloud records)

Edit a related table from CMDB performance insights

Edit a related table on the Related Entries [cmdb_related_entry] table directly from the CMDB 
performance insights tool in the CMDB Workspace  Insights view. Update the related table to 
correctly reference another CI in the Referenced field when a reference is missing from the 
related table.

Before you begin
Role required: sn_cmdb_admin (CMDB Admin) and any role needed to access a related table.

About this task
A record is missing a reference when the Referenced  field for that record is empty. CMDB 
performance insights enables you to easily edit related tables that are missing a reference after 
you drill down on a slice of the Related records missing reference chart.

You can see the full list of related tables and associated referenced fields in the Related Entries 
[cmdb_related_entry] table.

Procedure

1. Navigate to Workspaces  > CMDB Workspace, and then in the CMDB Workspace  menu bar, 
select Insights.

2. On the CMDB performance insights tile, select View performance insights.

3. Navigate to the Related records tile of the Payloads & CIs  tab and then select a slice of the 
chart in the Related records missing reference by table card.

4. Select a check box next to a record and then select Edit.

5. Specify applicable CMDB CI references and then select Update.
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Related topics

Overview of CMDB

Insights view in CMDB Workspace

Edit a data source from CMDB performance insights

Edit a data source for your Service Graph Connectors  to specify the data that an import set 
should ingest. Consider configuring a batch process to make ingestion more efficient and 
improve performance.

Before you begin
Role required: sn_cmdb_admin (CMDB Admin) and import_admin.

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the CMDB Workspace  menu bar, select Insights.

3. On the CMDB performance insights tile, select View performance insights.

4. Select the Sources with batch processing turned off card in the Service Graph connectors tab.

5. On the Data sources list view, select a check box next to a record.

6. Select Edit.

7. Configure the data source.
For more information about data sources, see:

◦ Create a data source

◦ Data source fields

8. Select Update.

Edit a scheduled data import from CMDB performance insights

Edit a scheduled data import directly from CMDB performance insights for your Service Graph 
Connectors. Consider enabling Concurrent Import  with a custom size partition to split incoming 
data into multiple import sets and transform the import sets concurrently to reduce processing 
time.

Before you begin
Role required: sn_cmdb_admin (CMDB Admin) and one of these roles:

• import_scheduler

• import_admin

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the CMDB Workspace  menu bar, select Insights.

3. On the CMDB performance insights tile, select View performance insights.

4. In the Service Graph connectors tab, click the Sources with concurrent import turned off card 
or the Sources with non-custom size partition method card.

5. In the Scheduled Import sets list view, select a check box next to a record.

6. Select Edit.

7. Configure the scheduled data import.
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You may need to change your application scope to create or edit a scheduled data import from 
CMDB Workspace.

For more information about updating a scheduled data import, see Schedule a data import .

8. Select Update.

Related topics

Insights view in CMDB Workspace

Components installed with CMDB Workspace

Several types of components are installed with the activation of the CMDB Workspace 
(sn_cmdb_ws) plugin, including properties, tables, user roles, and scheduled jobs.ServiceNow

Note: 
The Application Files table lists the components that are installed with this application. 
For instructions on how to access this table, see Find components installed with an 
application .

In addition, the CMDB Workspace  plugin adds the CMDB Group type 'CMDB Workspace'.

Properties installed

The following properties are installed by the Configuration Management (CMDB) (com.snc.cmdb) 
plugin which is included in base systems.

Property Description

sn_cmdb_ws.ci_overview.managed_by_me.enabled​
Shows/hides the My CIs section 
of CI Overview on the CMDB 
Workspace  landing page, for 
users with sn_cmdb_editor role.

• Type: true | false

• Default: true

• Location: Add to System 
Properties [sys_properties]
table.

sn_cmdb_ws.total_cis.enabled​
Shows/hides the Total 
CIs section on the CMDB 
Workspace  landing page.

• Type: true | false

• Default: true

• Location: Add to System 
Properties [sys_properties]
table.

sn_cmdb_ws.ms.discovery_source_not_reporting_max_days
Number of days after which if 
one or more discovery sources 
stop reporting CIs, that CI is 
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Property Description

included in the CIs not reported 
by discovery sources chart in the 
CMDB 360 view.

• Type: integer

• Default: 7

• Location: Navigate to 
Workspaces  > CMDB 
Workspace  and then select 
CMDB 360. Select Settings 
and configure Number of 
days since CIs were last 
discovered by a discovery 
source  in the Potential issues 
section.

• Learn more: Configure the 
CMDB 360 dashboard.

sn_cmdb_ws.ms.report_max_limit
Maximum number of record 
that appears as list views when 
drilling down from the following 
charts:

• CIs not reported by discovery 
sources

• Data mismatch

• CIs by number of discovery 
sources

• CIs with a single source

Details:

• Type: integer

• Default: 100,000

• Location: Navigate to 
Workspaces  > CMDB 
Workspace  and then select 
CMDB 360. Select Settings 
and configure Maximum 
number of records to process 
in the Global section.

• Learn more: Configure the 
CMDB 360 dashboard.

sn_cmdb_ws.unifiedmap.map_search_filter.default_levels
Initial default number of levels 
from the home node, up and 
down the CMDB hierarchy, to 
show on a map. Up the hierarchy 
goes from all parents to their 
parents up to the specified level. 
Down the hierarchy goes from all 
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Property Description

children to their children up to 
the specified level.

• Type: integer

• Default: 3

• Location: Add to System 
Properties [sys_properties]
table.

Editing affects all users and 
requires the sn_cmdb_admin 
user role.

sn_cmdb_ws.unifiedmap.map_search_filter.max_levels​
Maximum number of levels 
from the home node, up and 
down the CMDB hierarchy, to 
show on a map. Up the hierarchy 
goes from all parents to their 
parents up to the specified level. 
Down the hierarchy goes from all 
children to their children up to 
the specified level.

• Type: integer

• Default: 25

• Location: System Properties 
[sys_properties] table

Editing affects all users and 
requires the sn_cmdb_admin 
user role.

sn_cmdb_ws.list.record_count_limit
The maximum number of results 
that the system counts for when 
using conditional search to 
search for CIs on the Home view 
in CMDB Workspace. This count 
shows for example, at the top of 
the search results list.

• Type: integer

• Default: 100,000

• Location: Add to System 
Properties [sys_properties]
table.

• More information: CMDB 
Workspace store app

For example, if a limit of 100,000 
is reached, the count shows 

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

211

https://www.webstg.servicenow.com/docs/access?context=r_AvailableSystemProperties&version=washingtondc&pubname=washingtondc-platform-administration&section=t_AddAPropertyUsingSysPropsList&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=r_AvailableSystemProperties&version=washingtondc&pubname=washingtondc-platform-administration&section=t_AddAPropertyUsingSysPropsList&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=r_AvailableSystemProperties&version=washingtondc&pubname=washingtondc-platform-administration&section=t_AddAPropertyUsingSysPropsList&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=r_AvailableSystemProperties&version=washingtondc&pubname=washingtondc-platform-administration&section=t_AddAPropertyUsingSysPropsList&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=r_AvailableSystemProperties&version=washingtondc&pubname=washingtondc-platform-administration&section=t_AddAPropertyUsingSysPropsList&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=r_AvailableSystemProperties&version=washingtondc&pubname=washingtondc-platform-administration&section=t_AddAPropertyUsingSysPropsList&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=r_AvailableSystemProperties&version=washingtondc&pubname=washingtondc-platform-administration&section=t_AddAPropertyUsingSysPropsList&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=r_AvailableSystemProperties&version=washingtondc&pubname=washingtondc-platform-administration&section=t_AddAPropertyUsingSysPropsList&ft:locale=en-US


Property Description

"100,000 +" to indicate that 
counting stopped at 100,000 
and that there are additional 
uncounted results.

Increasing the value of this 
property directly results in 
greater impact on performance. 
However, if a precise count 
is needed, set this limit to a 
number that isn't reached by the 
anticipated count.

Roles installed

The following roles are installed by the Configuration Management (CMDB) (com.snc.cmdb) 
plugin which is included in base systems. These roles are required for access and interaction 
with the CMDB Workspace, and are included for completeness.

Role title [name] Description Contains roles

CMDB Admin

[sn_cmdb_admin]
Provides full access to CMDB data, tools, and UIs 
within CMDB Workspace.

A CMDB Admin, for example, sets policies in 
the CI Class Manager and application service 
requirements. CMDB Admin provides the highest 
level of access to the CMDB.

CMDB Admin has read-only access to the 
Configuration Item [cmdb_ci] table.

• data_manager_admin

• canvas_admin

• sn_cmdb_editor

• cmdb_ms_admin

• cmdb_dedup_admin

CMDB Editor

[sn_cmdb_editor]

Provides access to CMDB records within 
CMDB Workspace and read-only  access to the 
Configuration Item [cmdb_ci] table. A CMDB 
Editor has writing privileges to CMDB Data 
Manager tasks and to CIs but can't change 
policies such as in the CMDB Data Manager or in 
the CI Class Manager.

• sn_cmdb_user

• cmdb_ms_editor

CMDB User

[sn_cmdb_user]

Provides read-only access to the CMDB data 
and to basic UIs such as CMDB reports and 
dashboards, within CMDB Workspace.

• canvas_user

• data_manager_user

• cmdb_ms_user

Multisource 
CMDB Admin

[cmdb_ms_admin]

Provides full access to data, dashboard 
configurations, and queries related to 
Multisource CMDB and CMDB 360.

cmdb_ms_editor

Multisource 
CMDB Editor

Provides access to CMDB 360 records and 
enables users to create and edit CMDB 360 
queries.

cmdb_ms_user
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Role title [name] Description Contains roles

[cmdb_ms_editor]

Multisource 
CMDB User

[cmdb_ms_user]

Provides read-only access to multisource data, 
CMDB 360 queries, and to related UIs such 
as CMDB 360 reports and dashboards, and 
Multisource Report Builder.

cmdb_read

Scheduled jobs installed

Scheduled 
job

Description

CMDB 
Workspace 
Collection

Updates the information in all the 7-Day Activity charts such as the CI Activity in 
Last 7 Days chart.

Multisource 
Dashboard 
Analytics 
Population

Runs daily to calculate the aggregate statistics of CMDB 360 data and populates 
the CMDB 360 dashboard landing page.

Multisource 
Dashboard 
Collection

Collects CMDB 360 data and then invokes the Multisource Dashboard 
Analytics Population  scheduled job.

Multisource 
Dashboard 
Data 
Generator 
( Demo 
data)

Demo job that populates CMDB 360 tables with simulated data, to showcase the 
CMDB 360 dashboard landing page. Runs on demand.

insight 
– cloud 
non-cloud 
aggregate

Runs every 30 minutes to collect data for the Cloud and non-cloud resources 
chart.

Insight 
- Cloud 
Applications

Collects cloud data for the cmdb_ci_appl table.

Insight - 
Non-cloud 
Applications

Collects non-cloud data for the cmdb_ci_appl table.

Insight 
- Cloud 
Object 
Storage

Collects cloud data for the cmdb_ci_cloud_object_storage table.

Insight 
- Cloud 
Service 
Account

Collects cloud data for the cmdb_ci_cloud_service_account table.
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Scheduled 
job

Description

Insight - 
Cloud DB 
Instances

Collects cloud data for the cmdb_ci_db_instance table.

Insight 
- Non-
cloud DB 
Instances

Collects non-cloud data for the cmdb_ci_db_instance table.

Insight 
- Cloud 
Kubernetes 
Cluster

Collects cloud data for the cmdb_ci_kubernetes_cluster table.

Insight - 
Non-cloud 
Kubernetes 
Cluster

Collects non-cloud data for the cmdb_ci_kubernetes_cluster table.

Insight 
- Cloud 
Servers​

Collects cloud data for the cmdb_ci_server table.

Insight - 
Non-cloud 
Servers​

Collects non-cloud data for the cmdb_ci_server table.

Insight 
- Cloud 
Storage 
Volume​

Collects cloud data for the cmdb_ci_storage_volume table.

Insight - 
Non-cloud 
Storage 
Volume​

Collects non-cloud data for the cmdb_ci_storage_volume table.​

Insight - 
Cloud VM 
Instances

Collects cloud data for the cmdb_ci_vm_instance table.

Insight 
- Non-
cloud VM 
Instances

Collects non-cloud data for the cmdb_ci_vm_instance table.

CMDB 
Workspace 
– Populate 
aggregates 
Daily

Runs daily to collect the latest data from the instance for cards such as the CI 
Summary chart in the CMDB Workspace  landing page, and the following cards in 
the Insights view:

• CIs processed by IRE​

• CIs used in Data Manager policies​

• CIs used in data attestation​

• Query Builder queries

• Intelligent search
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Scheduled 
job

Description

Populates the Base Aggregate Data [sn_cmdb_ws_base_aggregate_data] table 
with the collected data.

Once collection completes, invokes the CMDB Workspace Aggregates 
Daily Collection  scheduled job.

CMDB 
Workspace 
– Populate 
aggregates 
Monthly

Runs monthly to collect data from the instance for cards such as the following, in 
the Insights view:

• CIs processed by IRE based on source

• CIs processed by IRE​

Once collection completes, invokes the CMDB Workspace Aggregates 
Monthly Collection  scheduled job.

CMDB 
Workspace 
Aggregates 
Daily 
Collection

A Performance Analytics  job that stores the latest data generated by the CMDB 
Workspace – Populate aggregates Daily  scheduled job. The stored 
data is then shown in respective cards in the Insights view.

CMDB 
Workspace 
Aggregates 
Monthly 
Collection

A Performance Analytics  job that stores the latest data generated by the CMDB 
Workspace – Populate aggregates Monthly  scheduled job. The 
stored data is then shown in respective cards in the Insights view.

[Demo] 
— CMDB 
Workspace 
Collection

Supports demo data for CMDB Workspace  charts in various views such as the 
Home view.

Installed only if Load demo data  was checked when the CMDB Workspace store 
app was installed or upgraded.

[Demo] 
— CMDB 
Workspace 
demo data

Activates demo data for CMDB Workspace  charts in views such as the Insights 
view, and CMDB 360 view (if CMDB 360 is enabled). Populates the Base 
Aggregate Data [sn_cmdb_ws_base_aggregate_data] table with random numbers 
that illustrate trend lines in charts in the Home and Insights views. It then runs 
demo data collection scheduled jobs.

Installed only if Load demo data  was checked when the CMDB Workspace  store 
app was installed or upgraded.

[Demo] 
CMDB 
Workspace 
Aggregates 
Daily 
Collection

A Performance Analytics  job that supports demo data for CMDB Workspace 
charts in various views such as the Insights view and which is installed only 
if Load demo data  was checked when the CMDB Workspace  store app was 
installed or upgraded.

Stores the demo data generated by the CMDB Workspace – Populate 
aggregates Daily  scheduled job. The demo data is then shown in 
respective cards in the Insights view.
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Scheduled 
job

Description

[Demo] 
CMDB 
Workspace 
Aggregates 
Monthly 
Collection

A Performance Analytics  job that supports demo data for CMDB Workspace 
charts in various views such as the Insights view and which is installed only 
if Load demo data  was checked when the CMDB Workspace store app was 
installed or upgraded.

Stores the demo data generated by the CMDB Workspace – Populate 
aggregates Monthly  scheduled job. The demo data is then shown in 
respective cards in the Insights view.

CMDB 
Workspace 
Collection 
On Demand 
With 
Lookback

Collects historical data (past 30 days) for some indicators such as the Integration 
outliers.

Runs automatically during install or upgrade and isn't configured with any 
recurring schedule.

Tables installed

Table Description

CMDB Group Metadata

[sn_cmdb_ws_group_metadata]

CMDB group data with count of CIs in each group.

CMDB Group Query Metadata

[sn_cmdb_ws_group_query_metadata]

Encoded queries with count of CIs in each encoded query 
subgroup.

NLQ Sample Search

[sn_cmdb_ws_nlq_sample_search]

Sample searches that appear when selecting the search 
box of an Intelligent Search for CMDB widget.

NLQ Sample Search Table

[sn_cmdb_ws_nlq_sample_search_table]

References the actual tables associated with sample 
searches that appear when selecting the search box of an 
Intelligent Search for CMDB widget.

NLQ Excluded Table

[sn_cmdb_ws_nlq_excluded_table]

Tables with ambiguous names that should be excluded 
from Intelligent Search. These tables won’t appear in 
suggestions, and other tables with similar names are given 
higher priority in search results.

Important Actions Configuration

[sn_cmdb_ws_imp_action_card_config]

Configuration of appearance and behavior of Important 
action cards that appear on the landing page of the CMDB 
Workspace. Editing in this table is accessible only to users 
with the sn_cmdb_admin role. Authorized users can modify 
attributes of an important action such as Active and Filter 
conditions, but can't modify the Type, Persona, and Table 
attributes.

Quick Links
Quick links that appear on the CMDB Workspace  landing 
page.
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Table Description

[sn_cmdb_ws_quick_links]

CIs by Number of Sources

[sn_cmdb_ws_ms_cis_by_number_of_sources]

CIs grouped by the number of discovery sources they were 
discovered by. Records appear as a list view when clicking 
on the CIs by number of discovery sources bar chart in the 
CMDB 360 view.

CIs With a Single Source

[sn_cmdb_ws_ms_cis_with_single_source]

CIs reported by only one discovery source. Records appear 
as a list view when selecting the CIs with a single discovery 
source chart in the CMDB 360 view.

CMDB Workspace Multisource Class Metadata

[sn_cmdb_ws_ms_class_metadata]

Class configuration settings such as class selections and 
weights, that CMDB Admins can modify from the CMDB 360 
view. Used by CMDB 360 analytics population queries to 
store a sample set of coverage data for the CIs by number of 
sources and CIs with a single source drill-downs cards.

Multisource Data Mismatch Records

[sn_cmdb_ws_ms_data_mismatch]

Data mismatch records found from attribute discrepancies 
from various data sources. Records appear as a list view 
when selecting the Data mismatch chart in the CMDB 360 
view.

CMDB Workspace Multisource Data Mismatch 
Configurations

[sn_cmdb_ws_ms_data_mismatch_config]

Data mismatch settings, such as the selection of classes, 
attributes, conditions, and weights, that CMDB Admins can 
modify in the CMDB 360 view. Used by CMDB 360 analytics 
population queries to store a sample set of data mismatch 
records in the sn_cmdb_ws_ms_data_mismatch table.

Discovery sources not reporting CIs

[sn_cmdb_ws_ms_discovery_sources_not_reporting]

Data for when one or more discovery sources stop 
reporting CIs after the specific X number of days (X 
can be set in the CMDB 360 view and is stored in the 
sn_cmdb_ws.ms.discovery_source_not_reporting_max_days 
system property). Records appear as a list view when 
selecting the CIs not reported by discovery sources chart in 
the CMDB 360 view.

Multisource Workspace Settings Weight Type

[sn_cmdb_ws_ms_settings_weight_type]

Weight type (automatic or manual) for data mismatch and 
coverage settings in CMDB 360 view.

Datacenter Types

[sn_cmdb_ws_datacenter_type]

Classifications of datacenter classes which are considered 
cloud or non-cloud in the organization, which is used for the 
Cloud and non-cloud resources chart.

CMDB Insight Query Categories

[sn_cmdb_ws_insight_query_category]

Class categories and their status for inclusion in the Cloud 
and non-cloud resources chart.

CMDB Insight Data

[sn_cmdb_ws_insight_data]

Legacy table for storing data for the Cloud and non-cloud 
resources chart.

Starting with CMDB Workspace  version 3.4, the CMDB 
Product Insight Data [sn_cmdb_ws_product_insight_data] 
table is used instead.
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Table Description

Base Aggregate Data

[sn_cmdb_ws_base_aggregate_data]

Aggregation data for CMDB Workspace  cards and parent 
table to other aggregation tables. When processing for 
a count completes, State  of the existing record for that 
count is set to retired  and a new record for that count is 
created with the updated count value. Cards in CMDB 
Workspace  views show values only for counts where State 
= ready.

Read only.

Service Graph Connector

[sn_cmdb_ws_service_graph_connector]

Details about all Service Graph Connectors that are 
currently available in the ServiceNow Store  (excluding 
any Innovation Lab connectors). Data is used to provide a 
current count for the Service Graph Connectors card in the 
Insights view.

Read only.​

Rating Configuration

[sn_cmdb_ws_rating_config]

Start and end values for different ratings of a category. For 
example, start and end values for low, moderate, and high 
adoption level ratings for the data governance category in 
the Insights view.

Read only.​

Feature Category

[sn_cmdb_ws_feature_category]

Metadata of the feature card for most of the features at 
CMDB Workspace level.

Read only.​

CMDB Product Insight Data

[sn_cmdb_ws_product_insight_data]

Aggregated count for each class and datacenter class, used 
for cards in the Insights view.

Read only.​

Feature Category Runtime Attributes

[sn_cmdb_ws_feature_category_runtime_attribute]

Runtime attributes related to performance insights, that can 
be used when running various scheduled jobs.

Read only.​

Integration Aggregate Data

[sn_cmdb_ws_integration_aggregate_data]

Integration outlier information related to performance 
insights. Details for each Integration with execution records 
which contain processing rate or rows outliers.

Read only.​

Partial Payload Items

[sn_cmdb_ws_partial_payload_item]

Extracted partial payload information related to performance 
insights. Includes discovery source, error, and class, 
associated with each partial payload item.
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Table Description

Read only.​

Application Service Insights Data

[sn_cmdb_ws_app_svc_insight_data]

Application services details such as classification (cloud vs. 
non-cloud, hybrid, or unknown) and count of CIs associated 
with the application service.

Read only.​

Table Attributes

[sn_cmdb_ws_node_map_table_attributes]

Set of extended properties, per class, that appear in the 
Attributes pane in the contextual side panel for a selected CI 
in Unified Map.

For more information, see Configure extended properties for 
a class.

Node Map Related Items

[sn_cmdb_ws_node_map_related_item]

Categorization and order of related items, per class, that 
appear in the Related items pane in the contextual side 
panel, in CI badges, and in timelines. Applies in Unified Map.

For more information, see Configure related items.

Node Map References

[sn_cmdb_ws_node_map_reference]

Reference relationships that appear as a dotted line 
relationship in Unified Map.

For more information, see Configure map references.

Class Icons

[sn_cmdb_ws_class_icon]

Maps ServiceNow  platform UI Builder (UIB) icon values (for 
example 'serverbox-outline') to CMDB class display names 
that they are used for (for example 'Network Disk') in Unified 
Map.​

Node Map Profiles

[sn_cmdb_ws_node_map_profiles]

Class profiles that include default filters and some Unified 
Map settings, per class. A class profile is applied if no filter 
preset is in effect, to the initial map and when setting the 
filter preset to Default view.

Specifying a class profile can be especially useful for 
Service Mapping data with the Mapped Application Service 
class.

For more information, see Configure class profiles.

CMDB Data Management Certification Task To 
Document

[sn_cmdb_ws_dm_certification_task_to_document]

Mappings between certification tasks and records.

CMDB Certification Attribute Status

[sn_cmdb_ws_dm_certification_attribute_status]

Flattened failed attribute status JSON. Used for reporting 
certification exceptions.
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Table Description

CMDB Data Management Task Execution Context

[sn_cmdb_ws_dm_task_execution_context]

Mappings between tasks and a policy’s' execution context.

API Insights

The ServiceNow®  API Insights  workspace is an all-in-one application that enables you to track 
all your APIs. You can also use it to start workflows related to different stages in the application 
programming interface (API) life cycle.

Get started

Explore

Learn about the 
benefits of API Insights

and how it is used.

Configure

Plan and configure 
your implementation.

Analyze

Administer and 
monitor API data

Manage

Manage API data for 
informed decision-making.

Reference

Get details about 
installed components.

Troubleshoot and get help

• Ask questions and explore other resources for API Insights  in the ServiceNow Community

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support

Exploring API Insights

Learn about API Insights  with a sample workflow and review the benefits it can provide for 
different users in your organization.
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API Insights  overview

API Insights  is a centralized workspace for enterprise or software architects and Configuration 
Management Database (CMDB)  administrators to analyze and take action on their organization's 
application programming interface (API) inventory.

API Insights  users

Users

User Description

Enterprise architect Users with the sn_api_insights_ws.api_mgmt_architect role 
can access the API Insights  workspace to search APIs, monitor 
team APIs, view managed APIs, track API activity, review API 
access requests, and manage API life cycle aspects, including 
APIs without interfaces, business applications, ownership, or 
product models.

Enterprise architect 
administrator

Users with the sn_api_insights_ws.api_mgmt_architect_admin 
role can access the API Insights  workspace to search APIs, 
evaluate metrics on API usage, set parameters for creating 
an API, connect APIs to a business context, specify the group 
attribute for ownership, and associate a workflow for granting 
access to APIs.

CMDB  administrator Users with the sn_cmdb_admin role can configure and manage 
the API-related Service Graph Connectors. They can accept or 
reject clustering recommendations, search for and compare 
APIs, and adjust settings related to API data management 
within the CMDB.

Note: 
A CMDB  administrator  needs additional roles such as 
ml_report_user and cmdb_inst_admin to access some of 
the features and data.

Additionally, the CMDB  administrator  needs the following 
security roles to access specific widgets:

• sn_si.basic or evt_mgmt_user – Required for Events 
and Critical alerts

• sn_vul.vulnerability_read – Required for Active 
vulnerability items

• sn_msi.msi_incident_read – Required for Security 
incidents

• sn_si.read – Required for Incidents
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API Insights  example workflow

Example workflow for the API Insights  users

1. A CMDB  administrator  with the sn_cmdb_admin role logs in to API Insights  and configures 
the API Service Graph Connectors  to import API data from various sources. Also, reviews and 
resolves any connection errors to ensure a smooth data import process.

2. An enterprise architect administrator with the sn_api_insights_ws.api_mgmt_architect_admin 
role accesses the settings page and adjusts the ownership settings according to their 
preferences.

3. An enterprise architect with the sn_api_insights_ws.api_mgmt_architect role navigates to the 
APIs missing data section to enrich API records by adding relationships and references. This 
includes associating business context, assigning ownership groups, linking product models, 
and defining API designs.
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4. The enterprise architect explores the API page, which provides a centralized view of all APIs 
and views all APIs in one place. They drill down into specific APIs to analyze details such as 
ownership, deployment locations, consumer usage, security incidents, and alerts. Additionally, 
they assess how each API fits within the broader ecosystem, identifying key relationships and 
dependencies in the API relationship map.

API Insights  benefits

Benefit Feature Users

Implement a system of record for enterprise-
wide APIs.

Workspace to view 
and interact with API 
inventory

API Insights 
administrator

Achieve enterprise-wide visibility of APIs. Automated discovery 
and ingestion 
of API data from 
various sources 
into Configuration 
Management 
Database (CMDB)

API Insights 
administrator

Map APIs to application services and business 
context.

Workflow for mapping 
APIs to relevant 
application services 
and business context

API Insights 
administrator

Integrate API data from a broad ecosystem 
of sources into the CMDB  via Service Graph 
Connectors.

API data ingestion 
using API Service 
Graph Connectors 
into CMDB

CMDB  administrator

Search for relevant APIs. API search 
functionality with a 
user-friendly interface

API Insights 
administrator

Enable workflow configurations for API access 
requests.

Customization of 
API access request 
workflows

API Insights 
administrator

View the usage, security, and service mapping 
of each API and its components.

Detailed view of 
API inventory, 
requests according 
to minute, unique 
consumers, security 
data, IT Operations 
Management  (ITOM) 
and IT Service 
Management  (ITSM) 
data, and relationship 
mapping

API Insights  architect

API Insights 
administrator

CMDB  administrator

What to explore next

To learn more about configuring and using API Insights, see:

• Configuring API Insights

• Administering and monitoring API data with API Insights
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• Managing API data within API Insights

• Managing API access within API Insights

• Optimizing API organization with clustering recommendations in API Insights

• Managing API data connections added for Service Graph Connectors in API Insights

• API Insights reference

Configuring API Insights

Complete the configuration tasks to start using the API Insights  workspace.

Configuration overview

1. Configure API Insights  installation.

As an administrator with the admin role, set up API Insights  by installing the application and 
assigning roles to users for managing API operations.

2. Configure API Insights  data and imports.

As a CMDB  administrator with the sn_cmdb_admin role, set up data model recommendations 
for API clustering and configure settings for importing APIs into API Insights.

3. Configure settings to monitor and organize APIs in API Insights.

As an enterprise architect administrator with the 
sn_api_insights_ws.api_mgmt_architect_admin role, configure API management workflows, 
including automating API actions and defining settings to monitor and organize APIs in API 
Insights.

Configuring API Insights  as a system administrator

As a user with the admin role, set up the API Insights  workspace by installing the application and 
assigning roles to users for managing API operations.

System administrator tasks overview

1. Install API Insights.

Install the API Insights  application (sn_api_insights_ws).

2. Assign roles for API Insights users

Assign roles for using the API Insights  workspace.

Install API Insights

You can install the API Insights  application (sn_api_insights_ws) if you have the admin role.The 
application installs related ServiceNow®  Store  applications and plugins if they are not already 
installed.

Before you begin

• Ensure that the application and all of its associated ServiceNow Store  applications have valid 
ServiceNow  entitlements. For more information, see Get entitlement for a ServiceNow  product 
or application .

• Review the API Insights  application listing in the ServiceNow Store  for information on 
dependencies, licensing or subscription requirements, and release compatibility.
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Role required: admin

About this task
The following items are installed with API Insights:

• Plugins

• Store applications

• Roles

• Tables

For more information, see Components installed with API Insights.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the API Insights  application (sn_api_insights_ws) using the filter criteria and search bar.

You can search for the application by its name or ID. If you cannot find the application, you 
might have to request it from the ServiceNow Store.

In the list next to the Install  button, the versions that are available to you are displayed.

3. Select a version from the list and select Install.

In the Install dialog box that is displayed, any dependencies that are installed along with your 
application are listed.

4. If you're prompted, follow the links to the ServiceNow Store  to get any additional entitlements 
for dependencies.

5. Optional:  If demo data is available and you want to install it, select the Load demo data  check 
box.
Demo data comprises the sample records that describe application features for the common 
use cases. Load the demo data when you first install the application on a development or test 
instance.

Important: 
If you don't load the demo data during installation, it's unavailable to load later.

6. Select Install.

Assign roles for API Insights  users

Assign roles to control access to features, capabilities, and data in the API Insights  application.

Before you begin
Set the application scope to API Insights  using the application picker. For more information, see 
Application picker .

Role required: admin

About this task
Users with the sn_api_insights_ws.api_mgmt_architect_admin, 
sn_api_insights_ws.api_mgmt_architect, or sn_cmdb_admin roles can use the API Insights 
application. See Exploring API Insights.
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Procedure

Assign roles to users and groups using the ServiceNow AI Platform  user administration feature.

• To assign a role to a user, see Assign a role to a user .

• To assign a role to a group, see Assign a role to a group .

Configuring settings to manage API data and imports in API Insights

As a CMDB  administrator with the sn_cmdb_admin role, set up data model recommendations for 
API clustering and configure settings for importing APIs into the API Insights  workspace.

CMDB  administrator tasks overview

1. Configure data model recommendations for API clustering in API Insights

Set recommendations for clustering related API components to align the organization's data 
with the desired data model.

2. Configure instance API import settings in API Insights.

Set options to import custom and ServiceNow  APIs from your instance into the CMDB.

Configure data model recommendations for API clustering in API Insights

Set recommendations for clustering API components to align the organization's data with the 
desired data model.

Before you begin
Role required: sn_cmdb_admin

Procedure

1. Navigate to Workspaces  > API Insights.

2. Select the Settings  tab.

3. In the Data model recommendations section, configure system-generated recommendations 
for clustering related API components based on your organization’s data model.

Field Description

Proposed 
API 
clustering

Option to enable the system-generated API clustering recommendations. When 
selected, the system will propose clustering connections between related API 
components within the same API.

Cluster 
quality

Desired quality level for the API clustering recommendations. The cluster quality 
can range from 0  to 100, where a higher value represents a stronger connection 
between related components.

4. Select Save.

Configure instance API import settings in API Insights

Set options to import custom and ServiceNow  APIs from your instance into the CMDB.

Before you begin
Configure the Import ServiceNow API to API Insights  scheduled job to 
automatically import configured APIs from your ServiceNow  instance into the API Insights 
workspace at regular intervals. For more information, see Scheduled jobs .
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Role required: sn_cmdb_admin

About this task
Configure API import options to bring custom and ServiceNow  APIs from your ServiceNow 
instance into the CMDB. This feature enables you to analyze and manage ServiceNow  instance 
APIs together with other enterprise APIs within the API Insights  workspace.

Procedure

1. Navigate to Workspaces  > API Insights.

2. Select the Settings  tab.

3. In the Import instance APIs section, select Configure API import.

4. In the Set up import section, select the options for importing scripted and outbound REST 
APIs, and scripted and outbound SOAP APIs into the CMDB.

API import options

Option Description

All custom APIs Imports all custom-developed APIs within the instance.

ServiceNow APIs Imports predefined ServiceNow  APIs within the instance.

Active in last Imports only APIs based on recent activity, available for scripted APIs only.

a. If you select the ServiceNow APIs  check box, select Select APIs  and then manage the APIs 
to import.

Importing ServiceNow APIs

Action Description

Add 
ServiceNow 
APIs

On the Select ServiceNow APIs page, select Add to import list. Then, 
on the Add to import list page, select the check box for APIs from the All 
ServiceNow APIs list and select Add selected.

Remove any 
selected 
ServiceNow 
APIs

On the Select ServiceNow APIs page, select the check box for APIs from 
the Selected APIs list, and select Remove from import list.

b. If you select the Active in last  option, enter the number of days in the Days  field to import 
only APIs that have been active in the specified timeframe.

5. On the Select ServiceNow APIs page, select Done.

6. On the Configure API import page, select Save configuration.

Validating API specifications in API Insights

You can access API specification validation rules to verify that your API specifications are 
complete, consistent, and adhere to best practices.

Validation rules identify structural issues early during import or analysis, improving overall API 
quality. You can manage these rules to enforce standardization across API specifications and 
reduce errors by checking for missing or incorrect fields before APIs are published or used in 
production.
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Storing API specifications

The API Specification [sn_api_insights_ws_api_specification] table stores the specification 
documents that describe individual APIs. Each record includes the following details to identify 
the API to which the specification belongs and to manage multiple versions.

API specification details

Field Description

Name Name of the API.

Version Version of the API.

Type Format and version of the API specification standard being used. For example, 
openapi3.0.0  for an OpenAPI specification.

State Current status indicating whether the API specification has been validated 
against the applicable rules and the validation outcome. Valid values are:

• Unprocessed: Indicates that the API specification hasn’t been validated.

• Valid: Indicates that the API specification was validated and processed 
successfully or with warnings. If warnings are present, details are displayed in 
the Message  field.

• Invalid: Indicates that the API specification was validated but contains errors. 
Error details are displayed in the Message  field.

Specification Full content of the API specification file.

Note: 
For OpenAPI, includes the complete OpenAPI document describing 
endpoints, methods, and schema.

Message Messages are generated after processing all validation rules for the 
specification type. They include errors or warnings with explanations.

Validation rule structure

The Specification Validation Rule [sn_api_insights_ws_spec_validation_rule] table 
stores validation rules for the API specifications defined in the API Specification 
[sn_api_insights_ws_api_specification] table.

Note: 
The sn_cmdb_editor role is required to edit or delete validation rules, and the cmdb_read 
role to view them.

Each validation rule contains the following key components:

Validation rule components

Component Description

Specification API specification for which the rule is designed.

Version Version of the API specification the rule validates. If specified, the rule applies 
only to those versions. To restrict validation to specific versions, specify them 
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Validation rule components  (continued)

Component Description

in the Version  field. Separate multiple values with commas. For example, 
1.0,1.1,2.0.

Note: 
If the Version  field is left empty, the rule runs for all installed versions of the 
specified API specification type.

Type Type of validation to perform. The valid values are:

• Path: Verifies that the specific keys are present within arrays of objects, 
individual objects, or both, in the designated sections of the API specification 
document.

• Expected value: Validates whether the specified key matches the expected 
values specified in the Value  field. This validation applies only to a single key 
specified in the Key  field.

Key Part of the specification to verify. If no expected value is provided, you can enter 
multiple keys in the Key  field, separated by commas.

Value Expected values for the key specified in the Key  field. Separate multiple values 
with commas.

Severity Severity level of the validation rule outcome, either a warning or an error.

Note: 
When set to warning, the API specification remains valid if the rule isn’t 
met, indicating it is not a failure, and only a message is displayed.

Message Explanation of the issue when the rule is triggered.

Active Option to activate the rule. Only active rules are triggered by the API 
Specification Validation  scheduled job.

API specification validation process

The API Specification Validation  scheduled job automatically validates 
unprocessed API specifications against active rules based on their specification type to ensure 
compliance with required standards.

The validation process includes:

1. Retrieving all active validation rules from the Specification Validation Rule 
[sn_api_insights_ws_spec_validation_rule] table.

2. Selecting APIs marked as unprocessed in the API Specification 
[sn_api_insights_ws_api_specification] table.

3. Applying relevant validation rules to each selected API based on its specification type, such as 
OpenAPI.

4. Verifying the presence or correctness of specific fields or their values within the API 
specification.

5. Updating the processing status and capturing any errors or warnings.
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Predefined rules for OpenAPI specifications

By default, the application includes the following validation rules for OpenAPI specifications:

Validate tags

Verifies that each tag in the API specification includes a name  field. If the name  field 
is missing, the system returns a warning message but marks the specification as 
valid.

Validate required sections

Verifies that the API specification includes the required top-level sections: info, 
paths, and components. If any of these sections are missing, the system returns 
an error message and marks the specification as invalid.

Validate servers section

Verifies whether the API specification includes a servers  section that defines the 
server endpoints. If the servers  section is missing, the system returns an error 
message and marks the specification as invalid.

These predefined rules verify critical sections such as tagging, metadata, and server definitions 
in OpenAPI specifications.

Configuring settings to organize APIs in API Insights

As an enterprise architect administrator with the sn_api_insights_ws.api_mgmt_architect_admin 
role, configure workflows for organizing APIs, including automating API actions and defining 
settings to enable enterprise architects manage APIs in the API Insights  workspace.

Enterprise architect administrator tasks overview

1. Configure flow for automating API actions.

Configure workflows for automating API actions within API Insights.

2. Configure settings to manage APIs in API Insights.

Configure API management settings, including API creation tools, relationship models, 
ownership groups, and automated workflows, to streamline API governance and operational 
processes.

Configuring flows for API actions in API Insights

Configure flows in Workflow Studio  for automating API actions within API Insights, streamlining 
processes like API access requests.

Configure flows to automate various API actions, such as granting access to 
APIs or processing API requests. Enterprise architect administrators with the 
sn_api_insights_ws.api_mgmt_architect_admin role can then select workflows that align with 
specific API automation tasks when they configure settings for managing APIs. See Configure 
settings to manage APIs in API Insights.

Predefined flow to send reminders for API access

The API Request Reminder  subflow is available with the API Insights  application that sends 
reminders for approving any API access requests. This flow automatically sends reminder 
notifications to the ownership groups specified in the flow, prompting them to review and 
approve pending API access requests.
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Predefined flow to grant API access

The API Grant/Reject Access Template  subflow is available with the API Insights  application 
that grants access to any APIs. This flow automatically that identifies the API access requests 
and enables to grant or reject access to any APIs.

Configuring flow for API access request automation

To manage API access requests through custom flows, it's essential to configure the flow with 
specific input parameters. These parameters guide the flow's behavior.

To learn about creating flows, see Getting started with flows .

When creating a flow for API access request automation, you must use specific parameters that 
control how the flow works.

You must include the following input parameters in the flow:

Input params:
request (reference from sn_api_insights_ws_request_access_task 
 table) - Required
grant (string) - Required
description (string) - Optional

request

A required reference to a specific record in the API Requests Access Task 
[sn_api_insights_ws_request_access_task] table that identifies the API access 
request and facilitates interaction with the API Insights  application.

grant

A required string input that specifies the action to be taken, such as granting or 
denying access.

description

An optional string input to provide additional details or context about the API access 
request.

Configure settings to manage APIs in API Insights

Configure API Insights  settings, including API creation tools, relationship models, ownership 
groups, and automated workflows, to streamline API governance and operational processes.

Before you begin
Role required: sn_api_insights_ws.api_mgmt_architect_admin

Procedure

1. Navigate to Workspaces  > API Insights.

2. Select the Settings  tab.

3. In the API creation tool section, select an API creation tool from the available options.

Option Description

None Uses no external tool.

Digital Integration Management
Uses the Digital Integration Management ap­
plication (part of the Enterprise Architecture 
Workspace), if enabled, to initiate the API de­
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Option Description

sign process by creating a digital interface 
record.

External tool

Uses a third-party tool for API creation, requir­
ing the URL for the external tool (for example, 
http://www.postman.com ) to be en­
tered in the External API authoring tool URL 
field.

4. In the API-to-business application relationship model section, select a relationship model from 
the available options.

5. In the Ownership group section, set the ownership group responsible for managing the API.

6. In the Configure workflows section, select a workflow for automating an API action.

Note: 
Workflows are created by your administrator using the Flow Designer. See Configuring 
flows for API actions in API Insights.

7. Select Save.

Administering and monitoring API data with API Insights

The Overview tab in the API Insights  workspace provides a centralized overview of your 
organization's API landscape.

Depending on your role, the API Insights  page on the Overview tab serves as a centralized hub to 
manage data ingestion integrations, monitor your APIs, and assess data quality. Whether you're 
setting up new connections, tracking API performance, or evaluating the integrity of incoming 
data, this page provides the tools and visibility you need. By offering real-time metrics and quality 
checks, it empowers teams across the organization to gain actionable insights.

You can use the page to:

• As CMDB administrators, you can administer data ingestion and align data model for your 
organization. See Administering data ingestion and model alignment with API Insights.

• As enterprise architects, you can monitor APIs while assessing overall data quality and 
identifying key issues like missing data elements. See Monitoring APIs and assessing data 
quality with API Insights.

Administering data ingestion and model alignment with API Insights

The Overview tab in the API Insights  workspace provides a centralized view of data ingestion 
activities and integration health.
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Access the API Insights  Overview tab

To access the Overview tab, navigate to Workspaces  > API Insights. The Overview tab opens by 
default.

Required roles

CMDB  administrators can access the Overview tab within the API Insights  workspace to monitor 
incoming API data, evaluate alignment with the data model, and take action on misaligned or 
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incomplete data to verify consistent and accurate CMDB  records. They can view and resolve 
errors in connections when importing API data into CMDB  using Service Graph Connectors  and 
adjust data based on clustering recommendations.

Note: 
As a user with the sn_cmdb_admin role, you need additional roles such as ml_report_user 
and cmdb_inst_admin to access some of the features and data.

Features

Access the various cards on the Overview tab to gain insights on the API data available in your 
organization.

Note: 
Select a segment or count on a chart to open the KPI Details page and analyze how a 
specific metric trends over time. To learn more about the KPI Details feature, see KPI 
Details .

Overview tab features for CMDB  administrators

Feature Description Required roles

Search APIs API search within the organization to locate specific 
APIs for review or management.

sn_cmdb_admin

Connection 
status

Total count of active API connections and processing 
errors.

Provides insight into the status of API connections and 
highlights any processing issues to verify reliable data 
ingestion.

Active connections

Total number of installed connections with 
active import schedules. Select the count 
to view installed connections.

Errors

Total number of processing errors for 
installed connections.

sn_cmdb_admin 
and 
cmdb_inst_admin

API clustering 
recommendations

Number representing the current clustering 
recommendation, based on the data model 
recommendation settings.

See Configure data model recommendations for API 
clustering in API Insights.

sn_cmdb_admin 
and 
ml_report_user

APIs by discovery 
source

Total count of discovered APIs grouped by source.

Provides insight into the discovery methods of APIs 
across your organization.

sn_cmdb_admin

APIs by life cycle Total count of APIs grouped by life cycle stage as 
Operational, Deploy, or End of Life.

Provides visibility into API readiness and maintenance 
status across your organization.

sn_cmdb_admin
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Overview tab features for CMDB  administrators  (continued)

Feature Description Required roles

APIs by type Total count of APIs categorized by protocol or 
communication type.

Includes technologies such as REST, GraphQL, and 
SOAP, providing insight into the integration styles and 
interoperability across your organization.

sn_cmdb_admin

APIs by 
environment

Count of APIs deployed in each environment.

Highlights distribution across Development, Test, and 
Production stages, enabling monitoring of deployment 
progress and assessment of risk exposure.

sn_cmdb_admin

APIs by 
ownership group

Total count of APIs categorized by assigned ownership 
group.

Groups APIs by managing team or function, as defined 
by an enterprise architect administrator with the 
sn_api_insights_ws.api_mgmt_architect_admin role in 
settings. For more information on setting an ownership 
group, see Configure settings to manage APIs in API 
Insights.

sn_cmdb_admin

APIs missing data Count of APIs missing key attributes, including 
business context, ownership group, product model, or 
design.

Each bar represents a key attribute and indicates the 
number of APIs missing the attribute.

Color coding indicates the severity of missing data:

Red

More than 50% of APIs are missing the 
attribute.

Yellow

Between 10% and 50% of APIs are missing 
the attribute.

Green

Less than 10% of APIs are missing the 
attribute.

Use the visual indicator to prioritize remediation efforts 
based on data completeness. Select a bar in the bar 
chart to start the remediation process. See Identifying 
and remediating missing API data in API Insights.

sn_cmdb_admin

APIs by business 
application

Count of APIs linked to business applications.

Enables tracking of API connections to business 
applications to improve integration after connections 
are established.

sn_cmdb_admin
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Overview tab features for CMDB  administrators  (continued)

Feature Description Required roles

Connections 
overview

Summary of the status and activity of API data 
connections using Service Graph Connectors, 
including counts of successful, failed, or unknown 
connection tests, recent import success rate, and the 
number of connections currently processing data 
imports.

sn_cmdb_admin 
and 
cmdb_inst_admin

Monitoring APIs and assessing data quality with API Insights

The Overview tab in the API Insights  workspace provides a centralized view of data ingestion 
activities and integration health.

Access the API Insights  Overview tab

To access the Overview tab, navigate to Workspaces  > API Insights. The Overview tab opens by 
default.

Required roles

You need the sn_api_insights_ws.api_mgmt_architect or the 
sn_api_insights_ws.api_mgmt_architect_admin role.

Use cases

For examples of how different people in your organization would use this workspace, see these 
use cases.
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User Workspace use

Enterprise architect Search for APIs, compare APIs, request 
access to APIs, and address data issues.

Enterprise architect administrator Manage API Insights  settings, including API 
creation tools, business context  relationship 
models, and ownership groups.

Features

Access the various cards on the Overview tab to gain insights on the API data available in your 
organization.

Overview tab features

Feature Description Required roles

Search 
APIs

API search within the 
organization to locate 
specific APIs for review or 
management.

• sn_api_insights_ws.api_mgmt_architect

• sn_api_insights_ws.api_mgmt_architect_admin

Access 
requests 
received

Number of access requests 
received indicating the need 
for API access management.

• sn_api_insights_ws.api_mgmt_architect

• sn_api_insights_ws.api_mgmt_architect_admin

Your 
access 
requests

Number of access requests 
created by the logged-in user, 
indicating the activity for API 
access management.

• sn_api_insights_ws.api_mgmt_architect

• sn_api_insights_ws.api_mgmt_architect_admin

Helpful 
resources

Links to product 
documentation, knowledge 
base articles, and a 
community forum for 
additional support and 
information.

• sn_api_insights_ws.api_mgmt_architect

• sn_api_insights_ws.api_mgmt_architect_admin

APIs missing data

Missing 
business 
context

Count of APIs with no 
business context assigned.

• sn_api_insights_ws.api_mgmt_architect

• sn_api_insights_ws.api_mgmt_architect_admin

Missing 
ownership 
groups

Count of APIs with no 
ownership group assigned.

Ownership groups enable 
tracking remediation and 
managing access requests.

• sn_api_insights_ws.api_mgmt_architect

• sn_api_insights_ws.api_mgmt_architect_admin

Missing 
product 
models

Count of APIs with no product 
model assigned,

Product models enable 
accurate reporting and 

• sn_api_insights_ws.api_mgmt_architect

• sn_api_insights_ws.api_mgmt_architect_admin
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Overview tab features  (continued)

Feature Description Required roles

interactions with multiple 
versioned APIs.

Missing 
design

Count of runtime APIs, 
available as API configuration 
items (CIs), with no design 
representation.

Linking runtime APIs with 
design-time APIs, available 
as Digital Interface records, 
improves usability.

• sn_api_insights_ws.api_mgmt_architect

• sn_api_insights_ws.api_mgmt_architect_admin

Your team's APIs

All APIs Total number of APIs managed 
by a team.

• sn_api_insights_ws.api_mgmt_architect

• sn_api_insights_ws.api_mgmt_architect_admin

In design Number of APIs currently 
being designed.

• sn_api_insights_ws.api_mgmt_architect

• sn_api_insights_ws.api_mgmt_architect_admin

Operational Number of APIs in active use. • sn_api_insights_ws.api_mgmt_architect

• sn_api_insights_ws.api_mgmt_architect_admin

End of Life Number of APIs that are 
retired or decommissioned.

• sn_api_insights_ws.api_mgmt_architect

• sn_api_insights_ws.api_mgmt_architect_admin

APIs managed by your team

All APIs 
managed 
by your 
team

Overview of the APIs 
managed by a team, based 
on the group associated with 
the logged-in user and the 
APIs linked to that group. 
API details include name, 
consumer count, management 
platform, life cycle stage, 
version, and requests per 
minute.

Populates data corresponding 
to the selected card in the 
Your team's APIs  section.

• sn_api_insights_ws.api_mgmt_architect

• sn_api_insights_ws.api_mgmt_architect_admin

Managing API data within API Insights

You can use the API Insights  workspace to centralize and manage API data for informed 
decision-making.
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Within the API Insights  workspace, you can:

• View all APIs within your organization.

Manage and monitor all APIs within your organization by reviewing their life cycle stages, 
identifying missing critical attributes, and accessing helpful resources to ensure proper API 
maintenance and governance.

• Search for an API.

Search for an API or an API component available within your organization in the API Insights 
workspace.

• Compare APIs.

Compare APIs available within your organization in the API Insights  workspace.

• Connect to an API creation tool from API Insights.

Initiate API creation directly from the API Insights  workspace by connecting to an external API 
design tool of your choice.

• Request access.

Request access to an API available within your organization in the API Insights  workspace.

• Identify and remediate missing API data.

Identify and remediate missing API data in the API Insights  workspace by linking missing 
elements and verifying complete API records.

• Manage your team's API data.

Improve the operational efficiency of the API ecosystem within your organization by creating 
a relationship for APIs that lack key attributes such as business context, ownership groups, 
product models, or designs.

• View details of an API.

Gain insights into your organization's API performance, relationships, and governance from the 
API details page within the API Insights  workspace.

• Manage application service relationships.

Associate APIs with relevant configuration items (CIs) to ensure accurate mappings between 
APIs and the configuration items they support.

Viewing all APIs in API Insights

Manage and monitor all APIs within your organization by reviewing their life cycle stages, 
identifying missing critical attributes, and accessing helpful resources to ensure proper API 
maintenance and governance.

The All APIs page in the API Insights  workspace provides a comprehensive overview of all 
APIs within an organization ensuring that APIs are properly maintained and aligned with the 
organization's standards for interfaces, ownership, and product models.
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All APIs page

Accessing and using the All APIs page

To access the All APIs page, navigate to Workspaces  > API Insights, and then select the API  tab.

Viewing data

By default, the page displays the following data:

All APIs section

Displays the total number of APIs managed by the organization and categorizes 
them by their life cycle stage (All APIs, In design, Operational, End of Life). You can 
select the each card to view APIs by their life cycle stage in the API table.

API table

Lists all APIs with detailed columns for the API name, the number of consumers, 
management platform, life cycle stage, version, and the number of API requests 
processed per minute for each API listed in the table. This table provides an 
overview of the APIs and their status within the organization. You can select an API 
from the Name  column to view API details and request access to the API managed 
by your team. See Request access to an API in API Insights.
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On the API table, you can select Export  to export the APIs list as a PDF, CSV, JSON, 
or Microsoft Excel  file. To do so, select the desired file format from the File Type list. 
You can download the file to your local directory or email the file by selecting a value 
from the Delivery Type list. After making your selections, select Export  to complete 
the process.

Additionally, you can manually populate the API table on demand by selecting the 

refresh icon ( ).

You can further narrow down the API list based on platform type and instance 
using the Management Platform Type list to filter APIs by platform category and 
the Management Platform Instance list to refine results by a specific ServiceNow 
instance. Select Apply  to update the list based on the selected filters. If you select 
ALL  in either list, APIs from all available options are included in the table.

APIs missing data section

Highlights the APIs missing key attributes like business context, ownership groups, 
product models, and design  helping to identify issues in API governance. You can 
select the numeric value displayed in each card to identify and resolve issues with 
API data. See Identifying and remediating missing API data in API Insights.

Helpful resources

Contains quick links to product documentation, knowledge base articles, 
and community forums, providing easy access to additional resources for API 
management.

Search for an API or an API component in API Insights

Search for an API or an API component available within your organization in the API Insights 
workspace.

Before you begin
Role required: sn_api_insights_ws.api_mgmt_architect

Procedure

1. Navigate to Workspaces  > API Insights.

2. In the Search APIs  text box on the Overview tab, enter your search phrase and select Search.

Tip: 
Alternatively, after entering the search phrase, you can press the Enter key.

3. On the Search results page, select a tab to view more details.

Compare APIs in API Insights

Compare APIs available within your organization in the API Insights  workspace.

Before you begin
Role required: sn_api_insights_ws.api_mgmt_architect

Procedure

1. Navigate to Workspaces  > API Insights.

2. In the Search APIs  text box on the Overview tab, enter your search phrase and select Search.

3. On the Search results page, select the APIs  tab.
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4. Select the check boxes next to the Name column for APIs that you want to compare.

Note: 
You can select up to three APIs to compare.

5. Select Compare selected.

6. On the Compare APIs page, compare the selected APIs based on version, type, business 
context also called as business application, managed by group, life cycle stage, and sources.

Connect to an API creation tool from API Insights

Initiate API creation directly from the API Insights  workspace by connecting to an external API 
design tool of your choice.

Before you begin
The application administrator must configure an API creation tool. See Configure settings to 
manage APIs in API Insights.

Role required: sn_api_insights_ws.api_mgmt_architect

About this task
Search for an existing API in the API Insights  workspace, and if no matches are found, initiate API 
creation directly from the workspace.

Procedure

1. Navigate to Workspaces  > API Insights.

2. In the Search APIs  text box on the Overview tab, enter the name or keyword of the API to 
search for and select Search.

3. On the Search results page, select the APIs  tab to view matching APIs.

4. If no matching API is found, select Create API  to start designing a new API.

Result
Based on the settings configured by your application administrator, the API creation tool opens, 
enabling you to create an API.

Request access to an API in API Insights

Request access to an API available within your organization in the API Insights  workspace.

Before you begin
The application administrator must configure an ownership group and set up a workflow for 
managing access requests.

Role required: sn_api_insights_ws.api_mgmt_architect

About this task
Alternatively, you can request access to an API managed by your team. See Manage your team's 
API data in API Insights,

Procedure

1. Navigate to Workspaces  > API Insights.

2. In the Search APIs  text box on the Overview tab, enter your search phrase and select Search.

3. On the Search results page, select the APIs  tab.
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4. Select the check box next to the Name  column for the API for which you want to request 
access.

Note: 
You can request access for only one API at a time.

5. Select Request access.

6. In the Request access dialog box, fill in the details.

Field Description

Access type Method used for authenticating and authorizing users or applications 
when interacting with an API or service. The available options are:

API Key

Provides authentication using a unique token included in 
the request.

Application

Grants access at the application level, authenticating the 
application itself.

Basic Auth

Uses a base64-encoded string of credentials sent in the 
request header for authentication.

Developer

Offers access for individual developers or development 
environments.

OAuth 2.0

Employs tokens to authorize access securely, allowing 
applications to act on behalf of a user.

Other

Includes custom methods of authentication and 
authorization.

Access duration in 
days

Length of time, measured in days, for which access to an API is granted 
before reauthorization is needed.

Justification 
for your access 
request

Reason or explanation for why access to the API is needed.

7. Select Request.

Result
The access request is submitted for approval based on the workflow settings configured by your 
application administrator.

Identifying and remediating missing API data in API Insights

Identify and remediate missing API data in the API Insights  workspace by linking missing 
elements and verifying complete API records.
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Missing metadata can reduce the effectiveness of API discovery, life cycle tracking, and 
ownership accountability. Common missing elements include:

• Business context

• Ownership group

• Product model

• Design details

Resolving missing data ensures a more complete, accurate view of dependencies and 
ownership, improving impact assessments and service management.

The Overview tab of the API Insights  workspace enables improve the usability, governance, 
and integration of APIs by highlighting any incomplete or missing data within the Configuration 
Management Database (CMDB).

Remediating missing API data by roles

The following roles can identify and resolve missing metadata in API:

• An enterprise architect with the sn_api_insights_ws.api_mgmt_architect role can access 
the Overview tab in the API Insights  workspace to remediate missing API information using 
dedicated tiles for each type of missing data.

• A CMDB administrator with the sn_cmdb_admin role can access the Overview tab in the API 
Insights  workspace and select a bar within the APIs missing attributes bar chart to identify and 
update missing metadata.

Monitoring key metrics

You can monitor the following missing data associated with APIs within your organization:

Missing business context

APIs not associated with any business context  reduce the clarity and governance 
over which business areas are providing them.

Missing ownership groups

APIs without an assigned ownership group affect governance. Assigning ownership 
groups streamlines tracking remediations, managing access, and resolving issues 
quickly.

Missing product models

APIs without an assigned product model limit the ability to provide accurate 
reporting and interactions with versioned APIs.

Missing design

APIs with no design representation hinder their full integration into the system. 
Linking these APIs with their design-time counterparts (such as digital interface 
records) improves usability and operational efficiency.

Resolving missing API data

You can resolve missing API data by creating relationships for business context or references for 
ownership groups, product models, or designs, to establish connections between the API and 
other CIs within the CMDB.

You can establish the following relationships or references in API Insights  to resolve missing API 
data:
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API-to-business context  relationship

Links an API to a specific business context, defining the context in which the API is 
used and creating a relationship record in the CMDB.

API-to-ownership group reference

Links an API to a group responsible for its governance, access control, and 
maintenance, serving as a reference without creating a record in the CMDB.

API-to-product model reference

Links an API to a product model, providing information on the API's versioning, 
product line, and life cycle stage, serving as a reference without creating a record in 
the CMDB.

API-to-design reference

Links an API to its runtime or design-time interface, serving as a reference without 
creating a record in the CMDB.

Create a relationship or reference to remediate missing API data

Improve the operational efficiency of the API ecosystem within your organization by creating a 
relationship  or reference  for APIs that lack key attributes such as business context, ownership 
groups, product models, or designs.

Before you begin
Role required: sn_api_insights_ws.api_mgmt_architect, sn_cmdb_admin

About this task
Available missing data categories include:

• Missing business context

• Missing ownership groups

• Missing product models

• Missing designs

Note: 
Displayed only when the Digital Integration Management plugin (sn_apm_di) is activated.

Procedure

1. Navigate to Workspaces  > API Insights.

2. Select the Overview tab, if not already selected by default.

3. Select a missing data category to open the list of APIs missing that attribute.

◦ As a user with the sn_api_insights_ws.api_mgmt_architect role, in the APIs missing data 
section, select the number shown for a specific missing data category.

◦ As a user with the sn_cmdb_admin role, select a category bar in the APIs missing data bar 
chart.

4. On the APIs missing data page, select the check boxes next to the API names.

5. Resolve missing data.

◦ For resolving missing business context, select Create relationships.

◦ For resolving missing ownership groups, product model, or designs, select Create 
reference.

6. Select the check boxes next to the Name  column for the application services.
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7. Based on the type of connection needed, establish relationships or a reference.

◦ For business context, select Create relationships.

◦ For ownership groups, product model, or designs, select Create reference.

8. In the dialog box that appears, select Create.

Manage your team's API data in API Insights

Improve the operational efficiency of the API ecosystem within your organization by creating a 
relationship for APIs that lack key attributes such as business context also called as business 
application  ownership groups, product models, or designs.

Before you begin
Role required: sn_api_insights_ws.api_mgmt_architect

Procedure

1. Navigate to Workspaces  > API Insights  > Overview.

2. In the Your team's APIs section, select a category based on the API's life cycle stage.

◦ To view all the APIs managed by your team, select All APIs.

◦ To view the APIs managed by your team that are currently in the design phase, select In 
design.

◦ To view the APIs managed by your team that are active and in use, select Operational.

◦ To view the APIs managed by your team that have reached the end of their life cycle, select 
End of Life.

3. From the Name  column, select an API to view more details of the API.
See Viewing API details in API Insights.

4. Optional:  Select Request access  to gain access to the API.

Viewing API details in API Insights

As an enterprise architect, gain insights into your organization's API performance, relationships, 
and governance from the API details page within the API Insights  workspace.

The API details page in the API Insights  workspace provides a detailed view of an API's 
operational status, usage, security, and relationships within CMDB.
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API details page

.

Accessing and using the API details page

To access the API details page, navigate to Workspaces  > API Insights, select the APIs  tab, and 
then select an API from the Name  column from the API table.

Viewing data

By default, the page displays the following data:

• Header region

• Metadata region

• Related lists

• Overview panel

• Usage

• Security

• Events

• Relationship map

Header region

Displays the name of the API, version information, the API's current life cycle stage, 
such as Operational, or End of Life.

The View By  list enables you to toggle between different management platforms, if 
available, under which the API is managed.

The version selector enables the selection of different versions of the API to view 
and manage. Select Update  to update the details based on the selected version.
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Note: 
The View By  list and the version selector appear only if applicable for an API.

Metadata region

Displays the following fields.

Field Description

Description Brief summary or purpose of the API.

Last 
discovered

Last date the API was discovered or updated in the CMDB.

Discovery 
source

Source from where the API was discovered.

Type Type of the API whether scripted REST API, HTTP API, platform 
REST API, and so on.

Ownership 
group

Team or group responsible for managing the API.

Digital 
interface

Interaction method of the API within the system.

Related Lists

Displays the following fields.

Field Description

Access 
requests 
received

Displays the number of access requests made for the API. Select 
the number displayed on the card to view access request details.

Consumers Displays the number of consumers of the API.

Deployments Indicates any active or past deployments of the API across 
environments.

Overview panel

Lists all the available operations (endpoints) of the API. Select an endpoint to view 
its details.

Usage

Displays the following fields.

Field Description

Daily 
requests

Number of API component requests over time, represented as a 
line graph, with the x-axis showing the date range and the y-axis 
displaying the request count.

Requests by 
version (last 
10 days)

API request distribution across different versions over the past 10 
days.

Business 
applications

Number of business context also called as business application 
linked to the API design, as reflected in the digital interface record.
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Security

Displays the following fields.

Field Description

Active 
vulnerability 
items

Security vulnerabilities associated with the API enabling to track 
and resolve potential risks.

Security 
incidents

Security incidents, if enabled, providing insights into security 
breaches or issues that might have occurred with the API.

Events

Displays the following fields.

Field Description

Critical 
alerts

Critical alerts from IT operations related to the API enabling identifying 
major issues that could affect the API’s performance.

Incidents Recorded incidents, such as outages, change requests, or problems 
related to the API essential for tracking operational health and 
remediation efforts.

Relationship map

Provides a hierarchical overview of the API relationships with its components, 
management platforms, business applications, and designs, making it easier 
to understand the API's role within the broader system architecture.  In addition, 
provides the option to manage application service relationships. See Managing 
application service relationships for APIs.

A relationship map is a partial unified map similar to the one used in the CMDB 
Workspace. To open the unified map for APIs, select Open full map  in the 
Relationship map section of the API details page. To learn more, see Unified Map.

Unified map for APIs

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

249



Nodes on the map represent the API and its components in the CMDB  and 
lines represent connections and relationships between API components. The 
connections help you, for example, to assess the impact of a change to a selected 
node by showing components that are connected to it through relationships and 
references. Products such as Change Management , Incident Management , and 
Event Management  benefit from such information.

The map also shows the composition of application services useful with products 
such as Event Management  and Incident Management . You can review historical 
changes.

The following elements are available in the unified map for APIs:

1: Map

The map displays the specified API and its connections and 
relationships. In the example, the httpbin.org-v1.1  is the home 
node and the lines represent connections and relationships with other 
components. Select any node to view details like related application 
services, change history.

2: Content controls

• Search for and select the home node, specify the number of 
relationship levels for application services to display, and reload the 
map after making changes.

• Use filters to limit the types and relationship types that appear on the 
map.

• Show or hide the timeline of events (related items) for the selected 
API

3: Toolbox

Use the toolbox to control several visual aspects of the map, such as 
zoom level or layout mode.

4: Contextual side panel

• The Attributes  panel ( ) lists attributes like location and 
operational status for the selected API or relationship.

• The Application services  panel ( ) lists details of application 
services associated with the selected API.

• The Related items  panel ( ) shows related items such as active 
incidents or active problems for the selected API.

• The Changes  panel ( ) lists changes such as changes to 
operational status for the selected API.

5: Mini-map navigator

Set the zoom level or move the view to an area of interest. Select the 
icon to show or hide the navigator.

6: Timeline

The timeline indicates events (related items) like incidents, problems, 
and changes for the selected API over a specified period of time. You 
can use the timeline to visualize the history of changes to an API and 
how they affect the topology of the CMDB.
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Managing application service relationships for APIs

You can associate APIs with relevant configuration items (CIs) to ensure accurate mappings 
between APIs and the configuration items they support.

Application service relationships link APIs to business context and the CIs they depend on, 
providing clarity on dependencies and improving performance visibility. They enable you to 
monitor, track changes, and resolve issues more efficiently.

For APIs, application service relationships map how they interact with other CIs, enabling 
you to manage dependencies, ensure business continuity, and respond quickly to incidents. 
By understanding these relationships, you gain better control over API performance and the 
availability of connected CIs.

By using application service relationships, you can:

• Identify which APIs are tied to specific application services and their related CIs.

• Understand the dependencies between APIs and the CIs they support.

• Manage and monitor API performance and its impact on critical business services and CIs.

For more information, see Application services.

The available actions for handling application service relationships for APIs include:

• View application service relationships.

• Create application service relationships.

• Remove application service relationships.

View application service relationships

View existing relationships between an API and application services.

Before you begin
Role required: sn_cmdb_admin, sn_api_insights_ws.api_mgmt_architect_admin, or 
sn_api_insights_ws.api_mgmt_architect

Procedure

1. Navigate to Workspaces  > API Insights.

2. Select the APIs  tab.

3. Select an API from the Name  column on the API table.

4. In the Relationship map section, select Manage service relationships.

5. View existing relationships between application services and the selected API on the Related 
application services table.

Create application service relationships

Create relationships between an API and application services.

Before you begin
Role required: sn_cmdb_admin or sn_api_insights_ws.api_mgmt_architect_admin

Procedure

1. Navigate to Workspaces  > API Insights.

2. Select the APIs  tab.
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3. Select an API from the Name  column on the API table.

4. In the Relationship map section, select Manage service relationships.

5. Select Create relationships.

6. Select application services to create relationships with the selected API.

7. Select Create.

Remove application service relationships

Remove relationships between an API and application services.

Before you begin
Role required: sn_cmdb_admin or sn_api_insights_ws.api_mgmt_architect_admin

Procedure

1. Navigate to Workspaces  > API Insights.

2. Select the APIs  tab.

3. Select an API from the Name  column on the API table.

4. In the Relationship map section, select Manage service relationships.

5. On the Related application services table, select the check box for an existing relationship.

6. Select Remove relationships.

Managing API access within API Insights

Manage received and sent requests by granting or rejecting API access, sending reminders, or 
withdrawing requests in API Insights.

You can manage API access requests by performing the following actions:

• Manage requests received for API access in API Insights.

• Manage requests sent for API access in API Insights.

Manage requests received for API access in API Insights

Manage incoming received requests for API access in API Insights.

Before you begin
Role required: sn_api_insights_ws.api_mgmt_architect

Procedure

1. Navigate to Workspaces  > API Insights.

2. In the Access requests received section on the Overview tab, select the displayed numeric 
value.

3. In the Requests received  tab, review all incoming requests.
You can review the details such as API name, requested by, request type, duration, and the 
reason for the request.

Important: 
The View requests  link in the API request reminder email works 
only if you have the sn_api_insights_ws.api_mgmt_architect or 
sn_api_insights_ws.api_mgmt_architect_admin role and are part of the same group that 
received the email to view the requests.
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4. Select the check boxes next to the request names to select one or more access requests that 
you want to process.

5. Manage the received requests.

◦ Select Grant access  to approve access to the requested API.

◦ Select Reject request  to deny access to the requested API.

Result
A confirmation notification appears, indicating that the API request access flow process was 
initiated or completed successfully.

Manage requests sent for API access in API Insights

Manage your sent access requests by either sending a reminder or withdrawing the request in 
API Insights.

Before you begin
Role required: sn_api_insights_ws.api_mgmt_architect

Procedure

1. Navigate to Workspaces  > API Insights.

2. In the Your access requests section on the Overview tab, select the displayed numeric value.

3. In the Requests sent  tab, view a list of access requests you have sent.

4. Select the check boxes next to the request names to select one or more sent requests that you 
want to process.

5. Manage the sent requests.

Optimizing API organization with clustering recommendations in API Insights

Leverage clustering recommendations to organize and group related API components, improving 
the efficiency and accuracy of API management.

The API clustering recommendations feature analyzes unlinked API components and proposes 
clusters likely belonging to the same API. Each recommendation includes a cluster concept, size, 
and quality score. By accepting a recommendation, you can link the components to an existing 
API or create another API record, improving data organization and management.

You can:

• View API clustering recommendations.

• Accept clustering recommendations.

Viewing API clustering recommendations in API Insights

Use machine learning-based suggestions to group related API components, improving the 
organization and mapping of APIs within the system.

The Proposed API clustering tab of the Data recommendations page in the API Insights 
workspace provides machine learning-generated recommendations for API clustering.
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Proposed API clustering tab

Accessing the Proposed API clustering tab

To access the Proposed API clustering tab, navigate to Workspaces  > API Insights. On the 
Overview  tab, select the count metric in the API clustering recommendations section. The 
Proposed API clustering  tab is displayed on the Data recommendations page.

Viewing data

By default, the page displays the following data:

Cluster Concept

Displays the API components that the machine learning model has grouped 
together based on similarities. These concepts represent the core idea or 
functionality that defines each cluster.

Cluster size

Indicates the total number of components within the cluster. A larger size suggests 
that many components are related and grouped together under the same API 
concept.

Cluster Quality

Reflects the confidence or strength of the relationship between components in the 
cluster, measured on a scale from 0  to 100. A higher quality value implies stronger 
relationships among the API components within the cluster.

Updated

Displays the most recent timestamp when the cluster was updated, enabling 
tracking the recency of the machine learning recommendations and any changes to 
the clusters.

Accept clustering recommendation in API Insights

Associate API components with an API record by accepting clustering recommendation in the 
API Insights  workspace.

Before you begin
Role required: sn_api_insights_ws.api_mgmt_architect
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Procedure

1. Navigate to Workspaces  > API Insights.

2. On the Overview  tab, select the count metric displayed in the API clustering 
recommendations section.

3. On the Proposed API clustering  tab, review the list of recommendations.

4. From the Cluster Concept  column, select a cluster concept link.

5. On the Missing API page, review the list of API components that have not yet been associated 
with an API record.

6. Select the check boxes next to the API components to associate with an API record.

Note: 
You can select one or multiple components depending on your requirement.

7. Select Accept.

8. Select an API record.

9. Select Submit.

Result
The Missing API list is refreshed with the linked components removed from the list and 
associated with the specified API record.

Managing API data connections added for Service Graph Connectors  in API Insights

You can view the status of your API data connections, including success rates, processing status, 
and ongoing executions. and monitor the progress of connections added using Service Graph 
Connectors  in API Insights.

• View the status of API data connections in API Insights.

• Monitor configuration progress of connections in API Insights.

View the status of API data connections in API Insights

View the status of your API data connections using Service Graph Connectors, including 
success rates, processing status, and ongoing executions.

Before you begin
Role required: sn_cmdb_admin and cmdb_inst_admin

Procedure

1. Navigate to Workspaces  > API Insights.

2. In the Connections overview section of the Overview tab, access the various cards to gain 
insights on the performance of Service Graph Connectors.

Connections overview

Card Description

Connections 
status

Percentage of connections tested successfully based on connection status, 
with the count of success, error, and unknown statuses.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

255



Card Description

Processing 
status

Percentage of connections for which all data import runs in the last import 
execution were successful, with the count of success and error statuses.

Ongoing 
executions

Number of connections where data import execution is currently in progress.

3. From the Connection  column, select a connection.

4. On the connection record page, select a tab to view more information about the selected 
connection.

Connection record details

Tab Description

Details Connection information, such as the connection name and credentials 
associated with the connection.

Connection 
properties

Properties configured for the connection.

Data sources Data sources associated with the connection, specifying what data is being 
retrieved or synchronized.

Import 
schedules

Scheduled imports for the connection, including parent schedule, data 
source, timing and frequency of data retrieval.

Errors Error related to the connection.

Monitor configuration progress of connections in API Insights

Check progress status of API data connections in API Insights.

Before you begin
Role required: sn_cmdb_admin and cmdb_inst_admin

About this task
Service Graph Connectors  are integrations that facilitate API data ingestion into the 
Configuration Management Database (CMDB)  from various third-party sources. To learn more, 
see Getting started with Service Graph Connectors.

Procedure

1. Navigate to Workspaces  > API Insights.

2. On the Connection status section of the Overview tab, monitor the progress of connections 
configured for Service Graph Connectors  that import API data.

3. To view the number of installed connections, select the count metric from Active connections.

4. Review the list of installed and draft connections in their respective tabs.
See Viewing API data connections for a Service Graph Connector within API Insights.

5. Optional:  Select Create connection  to create a connection for importing API data.
See Create an API data connection for a Service Graph Connector within API Insights.

6. Optional:  Select Explore connectors  to explore available options for onboarding and 
maintaining Service Graph Connectors  that import API data within API Insights.
See Exploring Service Graph Connectors for API data within API Insights.
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Viewing API data connections for a Service Graph Connector  within API Insights

You can view installed and draft API data connections that were added using Service Graph 
Connectors  within API Insights.

The following connection types are available for viewing:

• Installed connection (see View an installed connection within API Insights.)

• Draft connection (see View a draft connection within API Insights.)

View an installed connection within API Insights

View the details of an installed connection that was added using a Service Graph Connector 
within SGC Central.

Before you begin
Role required: sn_cmdb_admin and cmdb_inst_admin

Procedure

1. Navigate to Workspaces  > API Insights.

2. Select the Connections  tab.

3. On the API connections page, select All connections.

4. Select the Installed  tab.

5. Review the list of installed API data connections.

6. Select a connection from the Connection  column to view the details, data sources, import 
schedules, and errors associated with the connection.

View a draft connection within API Insights

View the details and resume setting up draft connections.

Before you begin
Role required: sn_cmdb_admin and cmdb_inst_admin

Procedure

1. Navigate to Workspaces  > API Insights.

2. Select the Connections  tab.

3. On the API connections page, select All connections.

4. Select the Drafts  tab.

5. Review the list of draft connections.

6. Complete setting up the draft connections.

◦ Select Configure  to continue where a Service Graph Connector  was last configured within 
SGC Central.

◦ Select Resume setup  to set up a single instance connector for the first time.

Create an API data connection for a Service Graph Connector  within API Insights

Create an API data connection added for a Service Graph Connector  within API Insights.

Before you begin
Role required: sn_cmdb_admin and cmdb_inst_admin
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Procedure

1. Navigate to Workspaces  > API Insights.

2. Select the Connections  tab.

3. On the API connections page, select Create connection.

4. On the Create connection window, select a connector type for importing API data and then 
follow the playbook instructions to create a connection.

Exploring Service Graph Connectors  for API data within API Insights

You can explore available options for onboarding and maintaining API data using Service Graph 
Connectors  within API Insights.

Service Graph Connectors  are integrations that facilitate data ingestion into the Configuration 
Management Database (CMDB)  from various third-party sources. To learn more, see Getting 
started with Service Graph Connectors  and API Service Graph Connectors.

Options for maintaining Service Graph Connectors  for importing API data within API Insights 
include:

• Update an installed Service Graph Connector in API Insights.

• Install a Service Graph Connector with an available entitlement in API Insights.

• Install a Service Graph Connector from ServiceNow Store within API Insights.

Update an installed Service Graph Connector  in API Insights

Keep a Service Graph Connector  for importing API data up-to-date within API Insights.

Before you begin
Role required: sn_cmdb_admin and cmdb_inst_admin

Procedure

1. Navigate to Workspaces  > API Insights.

2. Select the Connections  tab.

3. On the API connections page, select Explore connectors.

4. In the Updates available section, review the updates that are available for a Service Graph 
Connector.

5. Update the connector.

◦ Select a connector to access the connector in Application Manager  and then install any 
updates.

◦ Select Install updates  to open Application Manager, and then view and install updates for a 
connector from the Updates  tab.

For more information, see .

Install a Service Graph Connector  with an available entitlement in API Insights

Install a Service Graph Connector  for importing API data that matches an entitlement available in 
Application Manager from within API Insights.

Before you begin
Role required: sn_cmdb_admin and cmdb_inst_admin
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Procedure

1. Navigate to Workspaces  > API Insights.

2. Select the Connections  tab.

3. On the API connections page, select Explore connectors.

4. In the Entitlements available section, select Explore in Application Manager.

5. In Application Manager, review the entitlements and install a connector for API data.
For more information, see .

Install a Service Graph Connector  from ServiceNow Store  within API Insights

Explore ServiceNow Store  to request and use a Service Graph Connector  with no available 
entitlements for importing API data from within API Insights.

Before you begin
Role required: sn_cmdb_admin and cmdb_inst_admin

Procedure

1. Navigate to Workspaces  > API Insights.

2. Select the Connections  tab.

3. On the API connections page, select Explore connectors.

4. In the Available from ServiceNow Store section, select Explore in ServiceNow Store.

5. On ServiceNow Store, review the list of Service Graph Connectors  for importing API data and 
install a connector.
For more information, see the ServiceNow Store  website.

API Insights  reference

Reference topics provide additional information about API Insights  components.

Components installed with API Insights

Several types of components are installed with activation of the API Insights  plugin, including 
tables, user roles, and scheduled jobs.

Roles installed

Role title [name] Description Contains roles

Enterprise architect administrator

[sn_api_insights_ws.api_mgmt_architect_admin]

Accesses the 
API Insights 
workspace to 
search APIs, 
review data model 
recommendations, 
monitors API 
connections, 
evaluate metrics 
on API usage, and 
set parameters 
for data model 
recommendations 

sn_api_insights_ws.api_mgmt_architect
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Role title [name] Description Contains roles

and de-
duplication tasks.

Enterprise architect

[sn_api_insights_ws.api_mgmt_architect]

Accesses the 
API Insights 
workspace to 
search APIs, 
monitor team 
APIs, view 
managed and 
subscribed 
APIs, track API 
activity, review API 
access requests, 
and manage 
API life cycle 
aspects, including 
APIs without 
business context, 
ownership, 
product models, 
or designs.

• task_editor

• sn_incident_read

• sn_vul.vulnerability_read

• sn_cmdb_editor

• sn_msi.msi_incident_read

Scheduled jobs installed

Scheduled job Description

Gather APIs without Business App 
relationship Identifies and collects APIs that do not have an 

associated business context also called as business 
application.

Import ServiceNow API to API Insights Retrieves ServiceNow  APIs from the ServiceNow 
registry and imports them into API Insights.

Import ServiceNow API usage to 
MetricBase

Collects ServiceNow  API usage data and pushes it to 
the MetricBase  application.

SyncOwnershipGroupsOfAPIVersions Synchronizes ownership groups for API versions in API 
Insights.

API Specification Validation Performs automated validation of API specifications in 
an instance.

Tables installed

Table Description

APIs missing relationships

[sn_api_insights_ws_apis_missing_relationships]

API records that lack a defined relationship.
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Table Description

API Specification

[sn_api_insights_ws_api_specification]

API specification details, such as OpenAPI 
definitions.

Importable ServiceNow APIs

[sn_api_insights_ws_importable_servicenow_api]

Details of APIs imported from ServiceNow.

Open API Specifications

[sn_api_insights_ws_openapi_specifications]

OpenAPI specification records for API 
Insights.

Push API Specification

[sn_api_insights_ws_push_api_spec]

Records for pushing API specifications.

API Requests Access Task

[sn_api_insights_ws_request_access_task]

Tasks related to API access requests.

Specification Validation Rule

[sn_api_insights_ws_spec_validation_rule]

Validation rules that validate API 
specifications based on the configured 
rules.

Plugins installed

Plugin Description

MetricBase (com.snc.clotho) Collects, retains, analyzes, graphs, and acts on time-series data.

ServiceNow Store  applications installed

Application Description

@devsnc/sn-list-
selector (sn_list-
selector)

Enables selecting a set of values from a simple or multi-dimensional 
data source.

CMDB CI 
Class Models 
(sn_cmdb_ci_class)

Provides the single source for all new base-system CMDB CI class 
models defined by ServiceNow.

CMDB Workspace 
(sn_cmdb_ws)

Enables a workspace for working with the CMDB  to search and 
explore the CMDB, understand its health, work on related tasks, 
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Application Description

view activity, performance and feature usage, and access various 
management tools to support tasks in an organization.

Node map Experience 
Component 
(sn_node_map)

Enables mapping and visualizing connections between concepts.

SGC Central 
(sn_sgc_central)

Enables discovering, installing, and monitoring Service Graph 
Connectors.

Timeline component 
(sn_ui_timeline)

Shows events and information across a timeline to contextualize 
history or important information for an object.

UX Commons 
(sn_app_ux_commons)

Enhances component experience with common UI Builder  utilities, 
controllers, and bundles.

API Insights  properties

API Insights  properties control the behavior of the application.

System properties

These system properties are available for API Insights.

Note: 
To open the System Properties [sys_properties] table, enter sys_properties.list  in 
the navigation filter.

System properties for API Insights

Property Description

sn_api_insights_ws.import_outbound_rest_api
Set the property to enable or disable the import of outbound REpresentational State Transfer (REST) APIs from your ServiceNow  instance to the API 
Insights  workspace.

• Type: string

• Default value: {"custom_api":false,"servicenow_api":false}

• Location: System Property [sys_properties] table

sn_api_insights_ws.import_outbound_soap_api
Set the property to enable or disable the import of outbound Simple Object Access Protocol Application Programming Interface (SOAP) APIs from your 
ServiceNow  instance to the API Insights  workspace.

• Type: string

• Default value: {"custom_api":false,"servicenow_api":false}

• Location: System Property [sys_properties] table

sn_api_insights_ws.import_scripted_rest_api
Set the property to enable or disable the import of scripted REST APIs from your ServiceNow  instance to the API Insights  workspace, and set the 
timeframe for recent activity.
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System properties for API Insights  (continued)

Property Description

• Type: string

• Default value: 
{"custom_api":false,"servicenow_api":true,"active_in_last":false,"active_in_last_number_of_days":90}

• Location: System Property [sys_properties] table

sn_api_insights_ws.import_scripted_soap_api
Set the property to enable or disable the import of scripted SOAP APIs from your ServiceNow  instance to the API Insights  workspace, and set the 
timeframe for recent activity.

• Type: string

• Default value: 
{"custom_api":false,"servicenow_api":false,"active_in_last":false,"active_in_last_number_of_days":90}

• Location: System Property [sys_properties] table

sn_api_insights_ws.ml_min_cluster_quality
Enter the minimum cluster quality to display in machine learning recommendations, ranging from 0  to 100.

• Type: integer

• Default value: 80

• Location: System Property [sys_properties] table

sn_api_insights_ws.search_api_limit
Enter the desired limit on results for API and API component searches.

• Type: integer

• Default value: 1000

• Location: System Property [sys_properties] table

sn_api_insights_ws.settings_api_to_business_app_service
Set the property to the relationship model between APIs and business context.

• Type: choice list

• Default value: CSDM

• Location: System Property [sys_properties] table

sn_api_insights_ws.settings_grant_access_workflow
Set the property to the sys ID of the workflow to be executed when an access request is submitted in API Insights.

• Type: string

• Default value: API Grant/Reject Access Template

• Location: System Property [sys_properties] table

sn_api_insights_ws.settings_preferred_tool
Set the preferred tool for the creation of new APIs in API Insights.

• Type: choice list

• Default value: Authoring tool

• Location: System Property [sys_properties] table
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System properties for API Insights  (continued)

Property Description

sn_api_insights_ws.settings_preferred_tool_url
Set the URL for the preferred API authoring tool inAPI Insights. This property value is used when the settings_preferred_tool  property is set 
to API Authoring Tool.

• Type: string

• Default value: http://www.postman.com

• Location: System Property [sys_properties] table

sn_api_insights_ws.settings_support_group_column
Set the column on the Configuration item [cmdb_ci] table that will represent the support group in the API Insights  dashboards.

• Type: choice list

• Default value: managed_by_group

• Location: System Property [sys_properties] table

sn_api_insights_ws.show_ml_clustering_recs
Set the property to false  to disable the clustering recommendations for orphan API components.

• Type: true | false

• Default value: true

• Location: System Property [sys_properties] table

sn_api_insights_ws.show_overview_metrics_widgets
Set the property to true  to enable showing the Metric Base widgets on the API and API Component Overview pages.

• Type: true | false

• Default value: false

• Location: System Property [sys_properties] table

Domain separation and API Insights

Domain separation is unsupported for API Insights. Domain separation enables you to separate 
data, processes, and administrative tasks into logical groupings called domains. You can control 
several aspects of this separation, including which users can see and access data.

Support level: No support

• The domain field may exist on data tables but there is no business logic to manage the data.

• This level is not considered domain-separated.

For more information on support levels, see Application support for domain separation .

Related topics

Domain separation for service providers

CMDB Identification and Reconciliation

The Identification and Reconciliation module provides a centralized framework for identifying 
and reconciling data from different data sources. It helps maintain the integrity of the CMDB and 
some non-CMDB tables when multiple data sources are used to create and update CI records.
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The use of multiple data sources increases the risk of introducing inconsistencies through 
duplicate records. To maintain the integrity of the database, it is important to correctly identify 
CIs and services so that new records are created only for CIs that are truly new.

The Identification and Reconciliation Engine (IRE) helps maintain the data integrity as follows:

• Prevent duplicate CIs by uniquely identifying CIs using sets of identification rules

• Reconcile CI attributes by allowing only authoritative data sources to write to the CMDB or to a 
supported non-CMDB table

• Reclassify CIs

• Provide a centralized framework to perform identification and reconciliation across different 
data sources

Data sources such as ServiceNow  Event Management, Horizontal Discovery, Import Sets, Cloud 
Insights, Pattern Discovery, and Manual Entry, use IRE APIs to perform CI identification and 
reconciliation. In addition, any 3rd party data source can leverage REST/Scriptable IRE APIs to 
also perform CI identification and reconciliation.

Support for non-CMDB tables

IRE processes support some non-CMDB tables. You can create identification rules, reconciliation 
rules, and other IRE-related rules to ensure the integrity of data inserted or updated in supported 
non-CMDB tables. For details, see IRE support for non-CMDB tables.

Related topics

Relation qualifier

Domain separation and CMDB Identification and Reconciliation

Domain separation is supported in the CMDB Identification and Reconciliation feature. Domain 
separation enables you to separate data, processes, and administrative tasks into logical 
groupings called domains. You can control several aspects of this separation, including which 
users can see and access data.

Overview

Domain separation is enforced during the CMDB Identification and Reconciliation  (IRE) process. 
IRE processes are domain aware and domain separation is applied to the Identification and 
Reconciliation rules.

For more information about domain separation, see domain separation .

How domain separation works in Identification and Reconciliation

Domain separation in the identification engine is enforced when users activate the domain 
separation plugin. Domain separation for IRE has two modes of operation in domain separated 
instances:

• Strict mode (enabled by default): In this mode, identification processes only those CIs in 
which the domain ID is identical to the domain of the currently logged in user. If duplicate CIs 
exist across domains (including parent and child domains), then those CIs aren't considered 
duplicate CIs because their domain IDs don't match.

• Platform domain separation mode (disabled by default): In this mode, IRE follows the platform 
domain separation behavior. So during identification, parent domains can access all CIs 
within their child domains or any of the domains it has visibility into. For more information, see 
Visibility domains and Contains domains .
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Platform domain separation mode is intended to be used by advanced users for very specific 
or advanced use cases.

Note: 

Platform domain separation mode introduces some risks that are greater on upgraded 
instances and much lesser on zBooted instances.

Depending on how IRE processes are configured on a domain separated instance, 
setting IRE to use platform domain separation mode might result in unexpected and 
undesirable behavior if not used carefully. One of the risks is if enabling platform domain 
separation mode is followed by running IRE processes from a different domain than 
the one on which IRE processes were previously run. In this situation, CIs that were 
previously identified as unique, might get identified as duplicate CIs and might cause 
some applications to start failing.

If any application is already using IRE effectively in domain separated environment, then 
there's no advantage in switching to platform domain separation mode that might create 
some risk.

Use the glide.identification_engine.platform_domain_separation_enabled  system property to 
switch between those two modes for IRE domain separation. By default, this property is set to 
false.

Platform domain separation mode

Set the system property glide.identification_engine.platform_domain_separation_enabled  to true 
to enable the platform domain separation mode for IRE processing. With the platform domain 
separation mode, parent domains can access all of their child domains during IRE processing. 
For example, IRE can detect a matching CI in a child domain and then update that CI instead of 
creating a new one.

In the platform domain separation mode for IRE:

• IRE run from a parent domain can access CIs contained within their domain, child domains 
that are lower in the domain hierarchy, and global domain.​

• IRE run from the global domain can access all CIs.

• Visibility domains and Contains domains  are supported.

Note: 
When platform domain separation mode is enabled, there might be a sudden increase in 
IRE detection of duplicate CIs.

Domain separation during the Identification Process

Domain separation during the Identification process is enforced as follows:

• Regardless of the setting of the 
glide.identification_engine.platform_domain_separation_enabled  system property:

◦ Domain IDs don't need to be explicitly sent in the input payload of the identification engine 
APIs. Internally, the identification engine causes the current domain ID of the user to call the 
identification engine APIs.

◦ During matching, if no records are found and a CI is inserted, the CI domain ID is the same 
as the domain ID of the logged-in user’s domain. When updating a CI, the CI domain ID 
doesn't change.
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◦ During matching, if duplicates are found, De-Duplication tasks created in the 
[reconcile_duplicate_task] table have the same domain ID as of the duplicate CIs.

◦ During matching, if reclassification of the CI isn't allowed, reclassification tasks are created in 
the [reclassification_task] table, with the same domain ID as the CI for which reclassification 
is needed.

• When the system property glide.identification_engine.platform_domain_separation_enabled  is 
set to false:

◦ Only CIs that have the same domain ID as the currently logged-in user's domain are used 
during matching.

◦ Duplicate CIs that exist across domains (including parent and child domains) aren't 
considered as duplicate CIs by IRE.

• When the system property glide.identification_engine.platform_domain_separation_enabled  is 
set to true:

◦ Duplicate CIs that exist across domains (such as parent and child domains) are considered 
as duplicate CIs by IRE.

◦ CIs from the logged in user domain and child domains are used during matching.

Domain separation and Identification Rules

The identification rules and identification inclusion rules used during the identification process 
are always defined at the global level. For example, the following tables don't have a sys_domain 
field:

• Identifier (cmdb_identifier)

• Identifier Entries (cmdb_identifier_entry)

• Related Entries (cmdb_related_entry)

• Identification Inclusion Rules (cmdb_ie_active_config)

Domain separation and Reconciliation Rules

The reconciliation definition rules that are used during the reconciliation process can be defined 
for different domains. For example, the following tables do have sys_domain, sys_overrides, 
sys_domain_path fields:

• Reconciliation Definition (cmdb_reconciliation_definition)

• Datasource Precedence (cmdb_datasource_precedence)

• Data Source Staleness Definitions (cmdb_datasource_staleness)

Components and process of Identification and Reconciliation

The CMDB Identification and Reconciliation functionality is supported by the Identification and 
Reconciliation engine (IRE), rules, and tasks. Identification rules, reconciliation rules, IRE data 
source rules, de-duplication tasks, and reclassification tasks determine how IRE identifies and 
reconciles CI.

Concepts and Components of Identification and Reconciliation

Identification

Process of uniquely identifying CIs, to determine if a CI already exists in the CMDB 
or if it is a newly discovered CI that must be added to the CMDB. Identification 
processes rely on identification rules, or on unique IDs for CIs that data sources can 
provide.
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Reconciliation

Process of reconciling CIs and CI attributes by allowing only designated 
authoritative data sources to write to the CMDB at the CI table and attribute level. 
The CMDB is updated in real time as records are being processed. There is no 
staging area to verify the reconciliation activities before they are committed. 
Reconciliation processes rely on reconciliation rules  and IRE data source rules.

Reconciliation is required only for update operations, when the identification 
process identifies a CI in the CMDB that matches an incoming CI in the payload. 
When IRE inserts a new CI, reconciliation is not applied.

De-duplication tasks

If the instance encounters duplicate CIs during the Identification and Reconciliation 
process, it groups each set of duplicate CIs into a de-duplication task. Review 
the information in these tasks to see how it was determined that these CIs are 
duplicates.

Reclassification tasks

During the CI identification process, a matched CI might need to be upgraded, 
downgraded, or switched to another CI class. If automatic reclassification 
is disabled, then the system generates a reclassification task. Review the 
information in these tasks, and decide whether a manual reclassification of the CI is 
appropriate.

APIs

The Identification and Reconciliation APIs are a centralized set of APIs that can be 
used with different sources of data such as Discovery, Monitoring, or Import Sets. 
You can use it to enforce Identification and Reconciliation before data is stored in 
the CMDB. Data sources do not directly write to the CMDB. Instead, they call APIs 
first to ensure that the data being written does not introduce inconsistencies.

Identification engine APIs are accessible in scoped apps. The Configuration 
Management For Scoped Apps (CMDB) plugin (com.snc.cmdb.scoped) allows a 
scoped app in scripts to use the prefix 'sn_cmdb.IdentificationEngine.<method>' 
to access identification engine APIs. The Configuration Management For Scoped 
Apps (CMDB) plugin is activated in base systems.

• createOrUpdateCI() : A scriptable API that creates or updates a CI based on 
identification and reconciliation rules.

• identifyCI() : Similar to the createOrUpdateCI  API, but does not commit 
the result to the database. Use this API with a given payload to find out if the 
identification engine will perform insert or update operations, without committing 
the operation.

• CreateOrUpdateCIEnhanced() : A scriptable API that provides the functionality 
of enhanced IRE features such as partial payload, partial commit, incomplete 
payload, and deduplication of payload items. You can select the enhanced 
features to use. However, if you enable partial payloads, then deduplication of 
payload items and partial commit are automatically enabled.

• identifyCIEnhanced : Similar to the createOrUpdateCIEnahnced  API, but 
does not commit the result to the database. Use this API with a given payload 
to find out if the identification engine will perform insert or update operations, 
without committing the operation.

• CMDBTransformUtil : An API to be used exclusively with Import Sets to apply 
Identification and Reconciliation processes to data imported by Import Sets.
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Predefined identification are included for many of the tables in the base system. You can 
customize these rules for your organization. When a new table is created in the CMDB, it 
derives identification and reconciliation rules from its parent table if these rules exist. To apply 
identification and reconciliation rules to a new table, create the rules either at the child level or at 
its parent level.

Process flow of Identification and Reconciliation

IRE

Identification and Reconciliation Engine (IRE)

Identification and Reconciliation engine (IRE)  is a rule-based engine, operating as an underlying 
key component in Identification and Reconciliation. IRE provides a centralized framework to 
perform identification and reconciliation processes across different data sources. IRE uses 
identification rules, reconciliation rules, and IRE data source rules when processing incoming 
data before inserting or updating data in the CMDB. IRE processes help maintain data integrity in 
the CMDB.

• IRE prevents duplicate CIs by uniquely identifying CIs.​

• IRE reconciles CI attributes by allowing only authoritative data sources to write to CMDB.

Identification and Reconciliation engine (IRE)

IRE is an underlying key component in Identification and Reconciliation, providing a centralized 
framework to perform identification and reconciliation processes across different data sources. 
IRE uses identification rules, reconciliation rules, and IRE data source rules when processing 
incoming data before inserting that data to the CMDB.

IRE processes help maintain data integrity in the CMDB.

• IRE prevents duplicate CIs by uniquely identifying CIs.​

• IRE reconciles CI attributes by allowing only authoritative data sources to write to CMDB.

ServiceNow®  applications such as Service Mapping, horizontal discovery, and pattern 
discovery, use APIs to apply identification and reconciliation processes. You can also apply 
IRE processes to data imported by import sets. When using other data sources including third-
party data sources, you can leverage REST or scriptable IRE APIs to perform identification and 
reconciliation.​

Additional information:
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• About properties that affect some functions of IRE: See Properties for Identification and 
Reconciliation.

• About using IRE APIs: See IdentificationEngine - Scoped .

• About enabling debugging and checking on issues with a payload: See How to log the payload 
sent to IRE and check the issues with the payload [KB0750382] .

• About the steps that IRE performs illustrating how IRE works, such as validating the payload, 
applying reconciliation, and committing the data to the CMDB: See [CMDB - IRE] How the 
CMDB Identification and Reconciliation Engine works when passing a CI (as payload) to the 
createOrUpdateCI() [KB0750386] .

• About how to run a payload through IRE: See [CMDB IRE] How to run the CI identification on 
demand using the payload [KB0750383] .

CI identification

The CMDB identification process relies on identification rules to uniquely identify CIs. When 
possible, CIs can also be uniquely identified using source_name  and source_native_key 
values provided in the sys_object_source_info  section of the payload, and the 
Source [sys_object_source] table. If identification is successful using that method, then it is 
not necessary to apply matching algorithms that rely on identification rules, which is a slower 
identification method.

A unique CI identifier can be provided in the optional sys_object_source_info  object in 
the IRE payload.

{
  "items": [
    {
      "className": "cmdb_ci_win_server",
      "values": {
        "name": "SAMLABVM52"
      },
      "sys_object_source_info": {
            "source_native_key": "16777219",
            "source_name": "SCCM",
            "source_feed": "SCCM Computer Identity",
            "source_recency_timestamp": "2019-08-26 13:00:00"
      }
     }
    ]
  }

Identification processes rely on CIs dependency classification  to uniquely identify CIs. For 
example, to identify a Tomcat CI which is a dependent CI. Assuming a Windows Server CI 
(independent class) which is running a Tomcat application (dependent class). elying on 'config 
file path' to uniquely identify the Tomcat CI, isn't sufficient because the Tomcat application can 
run on multiple machines with identical paths. The identification engine won't be able to choose 
a CI to update. Dependent relationships force the identification process to first identify the 
Windows Server host on which the Tomcat application is running, and only then, in the context of 
the host, to uniquely identify the Tomcat application itself.

Payload items identification

IRE generates identifier keys for all payload items in an incoming payload and then uses those 
keys when trying to match partial and incoming payloads. An identifier key is based either on:
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• Combination of the source_name  and source_native_key  values from the 
sys_object_source_info  object.

• Identification criterion attributes.

IRE stores the identifier keys associated with partial items in the CMDB IRE Partial Payloads 
Index [cmdb_ire_partial_payloads_index] table, and then uses those keys to try to match with 
identifier keys of incoming payloads.

Timestamps in key attributes

To help resolve conflicting attribute values, IRE uses timestamps in the following attributes to 
identify records that are older than the current record and therefore can be ignored:

• Most recent discovery (last_discovered) and Discovery source (discovery_source):

Most recent discovery (last_discovered) is the timestamp of when the CI was last 
discovered. IRE always updates CIs’ last_discovered  and discovery_source 
attributes during payload processing, even when no other CI attributes are updated. When 
last_discovered  is provided in the payload, IRE updates the CI with the provided value 
only if the last_discovered  time in the payload is newer than the one in the CMDB. If 
last_discovered  is not provided in the payload, IRE updates the last_discovered 
attribute with the current timestamp.

You can use the glide.identification_engine.skip_updating_source_last_discovered_if_older 
and the 
glide.identification_engine.ire_message_listener_skip_updating_source_last_discovered_to_now 
system properties to modify this default behaviour.

• First discovered (first_discovered) is the timestamp of when the CI was first created.

◦ When the CI is first created: If a value is provided in the payload, IRE inserts that value. 
Otherwise, IRE inserts the current timestamp.

◦ In subsequent updates: If a value is provided, IRE updates the CI with the provided value. 
Otherwise, the attribute is not updated.

You can also use the following system properties to modify how IRE uses the 
source_recency_timestamp  value in a payload to update the last_scan  attribute in the 
Source [sys_object_source] table:

• glide.identification_engine.skip_updating_last_scan_if_older

• glide.identification_engine.ire_message_listener_skip_updating_last_scan_to_now

Enhanced IRE features

The CreateOrUpdateCIEnhanced()  and identifyCIEnhanced  scriptable APIs provides the 
functionality for the following enhanced IRE features, which can be enabled or disabled as 
needed:

Partial payloads

IRE isolates items for which data sources did not provide enough information 
to uniquely identify the CI and therefore processing cannot continue. Some of 
these items are identified as partial items, which get stored for potential later 
processing. Other items are identified as incomplete items, which get stored for 
logging purposes only.
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For example: SCCM has multiple feeds such as a disk feed and a computer feed. 
The disk feed might have complete information about the disk but insufficient 
information about the computer CI that it depends on.

API option: partial_payloads  which is enabled by default. 
When partial_payloads  is enabled, partial_commits  and 
deduplicate_payloads  are automatically enabled regardless of their setting 
in options.

Partial commits

Errors in some items do not prevent committing the rest of the items in a payload. 
Therefore, when a payload contains items with errors, IRE still commits the 
remaining valid items in the payload. In this situation, some of the uncommitted 
items are saved as partial payloads and other uncommitted items are saved as 
incomplete payloads.

API option: partial_commits  which is enabled by default.

Deduplicate payload items

IRE deduplicates duplicate items within the payload, merging those duplicates into 
a single payload item for processing.

API option: deduplicate_payloads  which is enabled by default.

Generate summary

IRE generates summaries in the output payload with processing details such as the 
number of updates per class.

API option: generate_summary  which is disabled by default.

Partial items

A payload item is determined to be a partial item if it doesn't contain the necessary data for 
unique identification and if it has one of the following errors. Unique identification requires that 
the payload item has the sys_object_source_info  section with source_name  and 
source_native_key  values, or the full set of the identification criterion attributes specified 
for the CI class, or both.

IRE errors for a partial item:

• MISSING_MATCHING_ATTRIBUTES –— Item does not have identification criterion attributes to 
use at least one identifier entry for matching.​

• REQUIRED_ATTRIBUTE_EMPTY –— Unable to create a CI because a required attribute is 
missing.

• MISSING_DEPENDENCY –— Dependent CI is missing a dependency relation which is 
specified in the payload.

• INSERT_NOT_ALLOWED_FOR_SOURCE –— An IRE data source rule prevents the specified 
data sources from creating CIs of the specified class.

For more details about IRE error messages, see IRE error messages.

If processing fails because payload items are determined to be partial items, then 
the partial items are saved as partial payloads in the CMDB IRE Partial Payloads 
[cmdb_ire_partial_payloads] table in JSON format for later potential processing. IRE uses 
identifier keys to attempt to match incoming payloads with stored partial payloads.
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If later, a data source sends the data that was missing in the partial item, IRE matches the 
incoming payload with the stored partial payloads. IRE then merges any matching partial 
payloads with the incoming payload. To resolve any conflicting attributes, IRE uses either 
source_recency_timestamp  (when source_native_key  and source_name  are 
identical), or static reconciliation rules specified for the class. The result is a complete and valid 
payload which IRE then processes to create or update the respective CIs.

Partial payloads older than 90 days are deleted from the CMDB IRE Partial Payloads 
[cmdb_ire_partial_payloads] table.

Sample of a partial payload:

Disk feed:
{
  "items": [
    {
      "className": "cmdb_ci_computer",
      "sys_object_source_info": {
            "source_native_key": "Server001",
            "source_name": "SCCM",
            "source_feed": "DISK_FEED",
            "source_recency_timestamp": "2019-08-26 13:00:00"
      }
    },
    {
      "className": "cmdb_ci_disk",
      "values": {
        "name": "disk1"
      }
    }
  ],
  "relations": [{
              "parent": 0,
              "child": 1,
              "type": "Contains::Contained by"}
              ]
}

The computer item in the above payload does not have any attributes and therefore IRE can't 
process it. However, source_name  and source_native_key  are provided making it a 
partial item. Because the computer item is partial, the disk item that depends on the computer 
item, is a partial item too.

Sample of a subsequent payload that completes the previous partial payload by providing the 
missing details:

Server/Computer feed:
 {
  "items": [
    {
      "className": "cmdb_ci_linux_server",
      "values": { "name": 'linux001',
                "ip_address": "100.126.38.19",
                "mac_address": "DSWER4587" },
      "sys_object_source_info": {
            "source_native_key": "Server001",
            "source_name": "SCCM",
            "source_feed": "COMPUTER_IDENTITY",
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            "source_recency_timestamp": "2019-08-26 14:00:00"
      }
    }
  ]
}

The computer in the partial payload and the server in the new payload match because they have 
identical source_name  and source_native_key. Therefore, the partial payload and the 
new payload are merged, the operation is committed, and the partial payload is deleted from the 
Partial Payloads table.

There is a limit on the number of items per partial payload, which is set by the 
glide.identification_engine.partial_payload_items_max_size  property (1000 by default). Storing 
associated relationships, references, and dependent items, in one partial payload, can result in 
reaching that limit, in which case, the payload is split into multiple partial payloads.

For more information about partial payloads, see CreateOrUpdateCIEnhanced() .

Incomplete items

A payload item is determined to be an incomplete item if:

• It does not contain all the data necessary for unique identification

• It has an error that is not associated with a partial item

Unique identification is not possible if neither source_name  and source_native_key 
within the sys_object_source_info  object, nor the full set of identification criterion 
attributes specified for the CI class, is provided.

Incomplete items are saved as incomplete payloads in the CMDB IRE Incomplete Payloads 
[cmdb_ire_incomplete_payloads] table in JSON format. Incomplete items are stored for the 
purpose of logging payloads with irrecoverable errors, and are never processed again.

Adding relationships

Add relationships by using either indices, or the optional JSON internal_id element.

Use the relations  object in the payload to add or update relationships by referring to 
internal_ids  of items. Relationships can be created using main items and related items in 
the payload. For example:

• Relation (parent Index, child Index, Relation Type)

• Relation (parent Internal Id, child Internal Id, Relation Type)​

For more information and for code samples, see CreateOrUpdateCIEnhanced() .

Adding references between payload items

Add references between two payload items by using the optional JSON internal_id 
element, which uniquely identifies payload items.

Use the referenceItems  block to add or update references. You can add references 
between any two items, including main items, lookup items, and related items, in a single 
payload.

For more information and for code samples, see CreateOrUpdateCIEnhanced() .
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CI reclassification

Use the updateWithoutUpgrade, updateWithoutDowngrade, and 
updateWithoutSwitch  flags in the settings block in a payload, to prevent unintentional 
updates to CIs' class. These flags prevent upgrading, downgrading, or switching the class of a CI 
that multiple data sources unintentionally might attempt while updating the same CI. For more 
information and for code samples, see CreateOrUpdateCIEnhanced() .

Reclassification flags have precedence over any other system settings for CI reclassification 
during IRE processing.

Adding custom before and after scripts

Use the IntegrationHub ETL  to add custom Java scripts for a data source of a CMDB integration 
application. Those scripts provide access to the IRE input and output payloads, while processing 
CMDB integrations.

Before scripts provide access to a batch of input payloads that will be sent to IRE. Using a custom 
before script lets you:

• Skip a payload in the batch by setting the status  to SKIPPED. Optionally, provide a reason 
for skipping the payload which will appear as a comment on the respective import set row 
table.

• Modify the input payload.

• Write other custom logic inside the script that uses the IRE payload.

After scripts provide access to the IRE input and output payloads. Using a custom after script lets 
you:

• Easily compare the input and output payloads and identify the different operations that IRE 
performed on each CI.

• Access the sys_ids of the CIs that IRE created or updated.

• Write other custom logic inside the script that uses the IRE output payload.

Apply CI Identification and Reconciliation to Import Sets

You can apply CMDB Identification and Reconciliation processes when Import Sets are used to 
import CIs into the CMDB. CI identification can prevent duplicate CIs in the CMDB, which Import 
Sets might otherwise cause.

Populating CMDB tables using Import Sets can inadvertently result in duplicate CIs when 
multiple imported records are identical to an existing CI. To minimize this duplication, you can 
apply CMDB Identification and Reconciliation processes to Import Sets when importing new 
records into CMDB tables.

Transform map script

In the onBefore transform map script for an import set, add a call to the CMDBTransformUtil  API, 
similar to the following code sample:

(function runTransformScript(source, map, log, target) {
// Call CMDB API to do Identification and Reconciliation of 
 current row
var cmdbUtil = new CMDBTransformUtil();
cmdbUtil.setDataSource('ImportSet');
cmdbUtil.identifyAndReconcile(source, map, log);
ignore = true;
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if (cmdbUtil.hasError()) {
        var errorMessage = cmdbUtil.getError();
        log.error(errorMessage);
} else {
        log.info('IE Output Payload: ' + 
 cmdbUtil.getOutputPayload());
        log.info('Imported CI: ' + 
 cmdbUtil.getOutputRecordSysId());
}
 
})(source, map, log, target);

The ignore = true  code phrase prevents Import Sets from creating the same record again 
after it is processed by the identification engine.

Process

The identification engine performs identification of each source record before it is inserted into 
the CMDB. The identification engine determines if the record is a duplicate of an existing CI, and 
then:

• If not duplicate: Inserts the record to the target table.

• If duplicate: Updates the existing CI in the CMDB, with data from the source record.

The CMDBTransformUtil API pre-processes the source data, then passes the input values to the 
identification engine with import set being the data source by default. The CMDBTransformUtil 
API supports a target field that is a reference field in the same manner that Import Sets 
supports it. The CMDBTransformUtil API also supports a source script, evaluating source 
scripts to determine the target value which is then passed to the identification engine. For more 
information, see Creating a field map .

Specify multiple target tables for an import set

You can configure each record in an import set with its own target table. Then, instead of 
inserting all the transformed records into a single target table, the records are inserted into the 
different target tables that are specified per record. For example, you might need to insert some 
records from the import set to the Computer class and other records to the Server class.

When importing data using Import Sets , incorporate the following steps:

• In the data source file, add a target table column. Use a string such as "MyTable" to label the 
column header. In each record row, enter the target table for the record, as a valid CMDB class 
name such as "cmdb_ci_computer".

• After you Auto Map Matching Fields  on the Table Transform Map form, add a field map for the 
added target table column to establish a relationship between classes and the target tables in 
the CMDB.

1. In the Field Map  related list on the Table Transform Map form, click New.

2. Set Source field  to the header of the target table column that you added in the data source 
file, such as MyTable.

3. Set Target field  to Class.

4. Click Submit.

When you configure an import set with multiple target tables as described in the steps above, the 
Target table  that is specified on the Table Transform Map form is not used.
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Restrictions

The following restrictions apply:

• An import set should be associated with a single transform map. While adding a call to the 
CMDBTransformUtil API, ensure that still a single transform map exists for the import set.

• The CMDBTransformUtil API does not check if mandatory fields have values when used with 
Import Sets . Regardless of how enforce mandatory fields  is set in the transform 
map, data import fails if a mandatory field does not have a value.

• CI Identification and Reconciliation cannot be applied to Import Sets for dependent CIs (CIs 
with dependent identification rules).

Related topics

Create a transform map

Identification rules

The CMDB identification process relies on identification rules to uniquely identify CIs.

An identification rule applies to a CI class and consists of a single CI identifier  and one or more 
identifier entries  and related entries, each with a different priority. Each identifier entry defines 
a unique attribute set with a specific priority and each related entry defines rules for identifying 
related items. Create strong identification rules that are set with the highest priority for the 
strongest identifier entries and related entries.

The identification process and identification rules use the CIs attributes for identification:

Unique attributes

Designated sets of criterion attribute values of a CI, that can be used to uniquely 
identify the CI. Unique attributes can be from the same table or from derived tables.

Required attributes

Designated attributes of a CI that cannot be empty.

Derivation across the CMDB hierarchy

If no identification rule is explicitly defined for a child class, then the child class derives its 
identification rule, including any associated identification entries and related entries, from its 
parent class. Later, an own identification rule can be explicitly defined for the child class. In 
that case, the identification rule that was initially derived from the parent class, including any 
associated identification entries and related entries, is no longer in effect at the child class. 
Also, you must explicitly add identification entries and related entries in the newly created 
identification rule at the child class.

For example: The Hardware  class identification rule has a related entry for the Software 
Instance  table. This identification rule, including its associated related entry for the 
Software Instance  table, is derived by the Computer  class. If you then create a new 
identification rule for the Computer  class, it overwrites the identification rule that was derived 
from the Hardware  class. Therefore, the Hardware  class identification rule, including its 
associated related entry for the Software Instance  table, is no longer in effect for the 
Computer  class. If the same related entry is needed, you must explicitly add a related entry 
for the Software Instance  table in the newly created identification rule for the Computer 
class.

Identification rule types

CI dependency is specified in the CI Class Manager by the dependent relationship rules for the 
CI's class:
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Independent CIs

CIs, such as Server CIs, which exist on their own and are not dependent on any 
other CIs.

Dependent CIs

CIs which depend on a relationship to another CI and can't exist on their own in the 
absence of the dependent relationship. For example:

• Network Adapter  CIs can't exist meaningfully without the Hardware  CIs 
that contain them.

• Application  CIs can't exist on their own without the Server  CI they are 
hosted on.

The steps for identifying dependent CIs can be different from the steps for identifying 
independent CIs. This difference is reflected in the differences between dependent 
identification rules and independent identification rules:

Independent identification rule

A rule that identifies a CI based on the CI's own attributes, independently of other 
CIs or relationship.

Dependent identification rule

A rule in which identifying a CI requires identifying a dependent CI first. A CI 
can have dependency on one or more CIs, and a dependent CI can have only a 
single parent CI with dependency. The relationship types between the CI and its 
dependent CIs are also included in the identification process. To help with the 
identification process of dependent CIs, create dependent relationships  that define 
the dependency chain within CI types.

The payload used for identification of a dependent CI, can include a relationship 
with a qualifier chain. For such relationship, if there is a matching parent/child pair, 
the system compares the qualifier chain in the payload, with the qualifier chain of 
the CIs in the database. If there is a difference, the qualifier chain in the database is 
updated to match the qualifier chain in the payload for that relationship.

Identifier entries

You can configure an identifier entry to match a CI not only based on the CI's own attributes 
(field-based identification) but also based on the CI's related list (lookup-based identification) 
such as Serial Numbers  or Network Adapters. The lookup table that is used for identification, 
needs to have a reference field that points to cmdb_ci.

There are three types of identifier entries:

Regular identifier entry

Based on CI's attributes that uniquely identify the CI.

Lookup identifier entry

Uses a lookup table (related table) which can be any table that has a reference to 
the CI that is being identified. After you select a related lookup table, you select 
identifier attributes from the related table that reference either the cmdb_ci table 
itself, or one of its descendants.

If the lookup records do not already exist, then they are inserted in the lookup table 
referenced in the identifier entry.

Hybrid identifier entry

A combination of both, a regular identifier entry and a lookup identifier entry.
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Example: When discovering virtual machines in a cloud environment which might 
contain two virtual machines with an identical set of serial numbers. A lookup 
identifier entry for the Hardware table such as [Table: Serial Number, 
Criterion Attributes: Serial Number, Serial Number Type] 
cannot uniquely identify these two virtual machines. However, a hybrid identifier 
entry such as [Table: Serial Number, Criterion Attributes: 
Serial Number, Serial Number Type + (Name field from main 
Hardware table)]  can uniquely identify the two virtual machines.

Guidelines for lookup tables

Follow these guidelines when specifying a lookup table in an identifier entry.

1. Ensure that lookup tables reference the cmdb_ci table.

2. It is preferable to enforce exact count match (check box Enforce exact count match (Lookup)) 
for a stronger identification rule. During lookup identification, this option enforces matching 
only on exact lookup records count match. See Create or edit a CI identification rule  for more 
details.

3. Do not create conflicting identification rules especially for lookup-based rule.

Example: In a CI Identifier for the Hardware class, you specify a lookup-based rule for the 
Network Adapter class and you also define a CI Identifier for the Network Adapter class. 
Duplicates might potentially be created in the Network Adapter table, because there are 
contradicting rules to identify a unique CI in that table:

◦ One rule that looks only at criterion attributes (CI identifier rule)

◦ Another rule that looks at criterion attributes and referenced sys_id (lookup rule).

Example: CI with related items that needs to be inserted - sysId is available.

var payload = {
    items: [{
        className:'cmdb_ci_linux_server',
       related: [{
              className:'cmdb_ci_spkg',
              values: {
                name:'package1',
                version:'version1'
                }
        }],
        values: {
            sys_id:'194876usytrr65378098'
        }
}]
};

Related entries

You can define related entries which are rules that are based on related CIs. A related entry is 
based on a related table which can be any table (CMDB or non-CMDB) that has a reference to 
the CI that is being identified. Related entries let you create or update records on other tables in 
which the data is associated with the CI being identified by the identifier entries. Related entries 
are not used to directly identify CIs.

After you select a related table for the rule, the list in Referenced field  is populated with fields 
from the related table that reference either the cmdb_ci table itself, or one of its descendants.
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A related entry for a class is derived by child classes for which no related entries are specified.

Related topics

Relation qualifier

Create or edit a CI identification rule

Identification rules are used to uniquely identify CIs in the CMDB, as part of the identification and 
reconciliation process.  Each CMDB class can be associated with a single identification rule.

Before you begin
You can update a CI identification rule only at the class level that the rule is defined for. You can't 
update a derived rule.

Role required: itil has read access, itil_admin (on top of itil) has full access.

About this task
In a CI identification rule, specify a CI identifier, and identifier entries and related entries that 
uniquely identify the CI.

Review the following before creating identification rules:

• Identification rules

• General guidelines for using CMDB Identification

• Explore predefined identification rules:

1. Navigate to All  > CI Class Manager.

2. Select Hierarchy  and then search and select, for example, the Hardware class.

3. In the Hardware bar, expand Class Info  and select Identification Rule.

4. Examine all the sections and tiles with the settings of the Hardware class identification rule.

Procedure

1. Navigate to All  > Configuration  > CI Class Manager.

2. Select Hierarchy  to show the CI Classes list and then select the class for which to create an 
identification rule.

3. In the class navigation bar, expand Class Info  and then select Identification Rule.

4. Select Edit, Add, or Replace  (for a class that has derived the CI identification rule), in the 
Identification Rule section to create one.

5. Fill out the form, and then select Save.

Field Description

Independent/
Dependent

Designation of whether the CI identifier can identify the CI independently 
of other CIs, or not.

Note: 
To set the rule as Dependent, you must specify dependent 
relationship rules  for the selected class.

Name Name of CI identifier.

Description Description of the CI identifier.
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6. In the Identifier Entries section, select an existing identifier entry to edit, or select Add  to 
create one.

7. In the Identifier Entry dialog box, choose an option and then select Next.
Continue with one of the following three steps according to the option you selected:

Option Description

Use attributes from main table <table> Lets you select attributes from the currently 
selected table (regular identifier entry).

Use attributes from another table (Lookup 
table)

Lets you select attributes from any related 
table, other than the currently selected table 
(lookup identifier entry).

Use attributes from main and another table 
(Hybrid)

Lets you select attributes from both the 
currently selected table, and from another 
table (hybrid identifier entry).

8. Use attributes from main table <'table'>  option: Set the options on the form and then select 
Save.

Search On Table  is preset to the currently selected table in the CI Classes list.

Field Description

Active Check box that specifies the identifier entry is active. At least one identifier entry in an 
identification rule must be active for the rule to apply.

Priority Priority of the identifier entry. Identifier entries are applied based on priority. Rules with lower 
priority numbers are given higher priority. Identifier entries of identical priorities are applied 
randomly.

You can keep gaps between the priority numbers, so you can assign the unused priority 
numbers to new entries without modifying the existing priority order.

Criterion 
Attributes

Set of attributes that uniquely identify the CI. Attributes can belong to the current class, or to a 
parent class.

Note: 
It is possible to add reference fields as a criterion attribute. However, such fields might 
not always be effective:

◦ Reference fields store sys_ids that point to a record in another table, and thus is 
considered a weak criterion attribute (in terms of uniqueness) for the current table.

◦ The system detects and then replaces invalid values in a reference field with 
'Unknown'. For example, an invalid Model ID  value is replaced with the value 
'Unknown'. Also, if several CIs end up having that same reference field set to 
'Unknown', then these CIs become duplicate CIs.

Allow null 
attribute When selected, then if at least one criterion attribute is not null, attempt matching with an 

identifier entry even if there are criterion attributes that are null.

Otherwise, all criterion attributes must have values to attempt matching with an identifier 
entry.
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Field Description

Allow 
fallback 
to 
parent's 
rules

Allows the identification rules of the CI's parent to be used if a match is not found for this 
identification rule. Applies only for dependent identification rules.

Advanced 
Options

A filter to narrow the set of records that will be searched for a matching CI.

Available only if the 
glide.identification_engine.enable_identifier_optional_condition 
system property is set to true  (false  by default). In the base system, identifier entries 
of various classes are pre-configured with advanced options conditions. All these pre-
configured conditions in regular identifier entries will automatically apply when you set 
this property to true. Therefore, to prevent unexpected behavior, review those predefined 
conditions in regular identifier entries before setting this property to true.

For more details about this property, see Properties for Identification and Reconciliation.

Note: 
If criterion attributes have only two attributes and sys_class_name  is one of them 
(for example [name, sys_class_name], [ip_address, sys_class_name]), then the other 
attribute cannot be NULL, even if Allow null attribute  is enabled. This restriction is due to 
sys_class_name  being considered a special system matching attribute.

9. Use attributes from another table (Lookup table)  option:

a. Set Search On Table  to a table other than the currently selected table in the CI Classes list.
The Search On Table  must have a reference field to cmdb_ci, otherwise the identifier entry 
is considered invalid.

b. Set the rest of the fields as described in the previous step.

c. Optional:  Select Advanced options  and enter the information for a lookup identifier (scroll 
down if necessary).

Advanced Option Description

All of these 
conditions must 
be met

A filter to narrow the set of records that will be searched for a matching 
CI.

Enforce exact 
count match

For lookup identification, match a CI only on exact lookup records 
count match.

When enforced, all lookup items for a CI in the payload must have 
matching records in the lookup table, that reference the same CI:

i. Only matches CIs that have all the lookup items from the input 
payload referencing the CI in CMDB.

ii. If there are multiple matches, selects the oldest created CI as the 
final match.

When not enforced, one lookup item for a CI in the payload matching a 
record in the lookup table, is sufficient to consider a match:
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Advanced Option Description

i. Matches any CI that has at least one of the lookup items from the 
input payload referencing the CI in CMDB.

ii. If there are multiple matches, selects the CIs with the max number of 
lookup items from the input payload referencing the CI in CMDB.

iii. If there are still multiple matches, selects the oldest created CI as the 
final match.

d. Select Save.

10. Use attributes from main and another table (Hybrid)  option:

a. Set the options on the General Settings  tab as described in previous steps, and then select 
Next.

b. On the Main Table Settings  tab, select the attributes to use from the currently selected 
table, and then select Next.
Search On Table  is preset to the currently selected table in the CI Classes list.

c. On the Lookup Table Settings  tab, select a Search On Table  and then in Criterion 
Attributes  select attributes from the specified table. Search On Table  must have a reference 
field to cmdb_ci, otherwise the identifier entry is considered invalid.
You can select Advanced options  and enter the information for a lookup identifier as 
described in the previous step (scroll down if necessary).

d. Select Save.

Note: 
The Allow null attribute  option in the hybrid option, is set to false. Therefore, all of the 
selected criterion attributes from both the currently selected table and the lookup table, 
must have a value. Also, setting optional conditions is available only for the lookup table, 
and is not available for the main table.

11. Optional:  On the Related Entries section select an existing related entry to edit, or select Add 
to create one.

a. Update the Related Entry form and then select Save.

Related Entry form

Field Description

Active Check box that specifies that the related entry is active.

Related 
table

A related table that references the CI that is being matched.

Referenced 
field

A referenced field in Related table  that should store the referenced CI. This 
field always references the cmdb_ci table, or a descendent of the cmdb_ci 
table.

Priority Priority of the related entry for the specified Related table. Rules with lower 
priority numbers are given higher priority while matching a related item for 

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

283



Field Description

specific related table. Related entries for the specified related table with 
identical priorities are applied randomly.

You can keep gaps between the priority numbers, so you can assign the 
unused priority numbers to new entries without modifying the existing priority 
order.

Criterion 
attributes

The set of attributes to uniquely identify the related item. Attributes can 
belong to the current class, or to a parent class.

Note: 
It is possible to add reference fields as a criterion attribute. However, 
such fields might not always be effective:

▪ Reference fields store sys_ids that point to a record in another 
table, and thus is considered a weak criterion attribute (in terms of 
uniqueness) for the current table.

▪ The system detects and then replaces invalid values in a reference 
field with 'Unknown'. For example, an invalid Model ID  value is 
replaced with the value 'Unknown'. Also, if several CIs end up having 
that same reference field set to 'Unknown', then these CIs become 
duplicate CIs.

Click the lock icon to view, add, or remove attributes from the identification 
rule.

Allow null 
attribute

If at least one criterion attribute in the related table is not null, allow to attempt 
matching with an identifier entry even if there are criterion attributes which 
are null.

Filter 
conditions

Add conditions to construct a filter to narrow the set of records that will be 
searched for a matching related item.

Note: 
If criterion attributes have only two attributes and sys_class_name  is one of them 
(for example [name, sys_class_name], [ip_address, sys_class_name]), then the other 
attribute cannot be NULL, even if Allow null attribute  is enabled. This restriction is due 
to  sys_class_name  being considered a special system matching attribute.

Example:
For example, the pre-defined Hardware Rule  applies to the Hardware [cmdb_ci_hardware] table. 
It has an identifier entry with the criterion attribute Serial Number, Serial Number Type  and its 
Search on table  field is set to Serial Number.

The following payload snippet adds a CI to the cmdb_ci_linux_server  class, that is 
a child of the Hardware  class. It also shows how you can add related items in the payload 
for which you should create Related Entries  on the CI Identifier page for the Hardware 
[cmdb_ci_hardware] table:

 
{
    "items": [
        {
            "className": "cmdb_ci_linux_server",
            "lookup": [
                {
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                    "className": "cmdb_serial_number",
                    "values": {
                        "serial_number": "VMware-42 21 e3 da 44 
 14 5a a6-56 48 2b 0a 28 53 42 4c",
                        "serial_number_type": "system",
                        "valid": "true"
                    }
                },
                {
                    "className": "cmdb_serial_number",
                    "values": {
                        "serial_number": 
 "4221E3DA-4414-5AA6-5648-2B0A2853424C",
                        "serial_number_type": "uuid",
                        "valid": "true"
                    }
                },                }
            ],
 
    “related": [
                {
                    "className": "cmdb_ci_ucs_chassis",
                    "values": {
                        “name": “chassis1",
                        “category": “category1",
                        “short_description": “My Chassis 1"
                    }
                },
                {
                    "className": "cmdb_ci_ucs_chassis",
                    "values": {
                        “name": "chassis2",
                        "category": "category2",
                        "short_description": "My Chassis 2"
                    }
                },    }
     ],
 
            "values": {
                ......
                "name": "xpolog2.lab3",
                "os_name": "Linux",
                "output": "Linux xpolog2.lab3 
 2.6.32-431.el6.x86_64  1 SMP Fri Nov 22 03:15:09 UTC 2013 
 x86_64 x86_64 x86_64 GNU/Linux",
                "serial_number": "VMware-42 21 e3 da 44 14 5a 
 a6-56 48 2b 0a 28 53 42 4c",
                "sys_class_name": "cmdb_ci_linux_server"
            }
        }
    ]
}
                         

When the Hardware Rule  is applied, the Serial Number [cmdb_serial_number] table is searched 
for a match with the values specified within the lookup  key. Unless Enforce exact count match 
(Lookup)  is checked, it is not necessary for every lookup key to return a match, as long as there 
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is at least one match. If all matches reference the same CI, then that CI is considered to be the 
existing CI record. If no match is found, then the identification search continues to the next rule 
entry. If after all the rules are exhausted without finding a match, a new CI record is created in the 
database.

What to do next
You can optionally create an inclusion rule  to narrow the scope of CIs that are included in 
identification.

Create an identification inclusion rule

Narrow the scope of CIs that are included in the identification process by creating an 
identification inclusion rule.

Before you begin
Role required: itil has read access, itil_admin (on top of itil) has full access.

About this task
During duplication detection of independent CIs, the identification and reconciliation engine 
(IRE) processes only the CIs that satisfy the identification inclusion rules.  For example, you 
can set a filter to include only CIs whose state is operational. When no identification inclusion 
rules exist, all CIs are included in the identification process and in the CMDB Health duplicate 
metric calculations. In the base system, there are no predefined identification inclusion rules. 
Identification inclusion rules are defined at the class level.

Identification inclusion rules also indirectly impact what appears in CMDB health dashboards for 
duplicate CIs, in addition to any health inclusion rules.

Note: 
Identification inclusion rules impact any script that calls IRE, therefore create them carefully. 
Identification inclusion rules can prevent the identification of certain types of CIs, affecting 
some features of Discovery and Service Mapping.

Procedure

1. Navigate to All  > Configuration  > CI Class Manager.

2. Select Hierarchy  to display the CI Classes list.

3. Select the class for which to create an identification inclusion rule.

4. In the class navigation bar, expand Class Info  and then select Identification.

5. In the Inclusion Rule (Advanced) section, select Add  to create a rule or select Edit  to edit an 
existing rule.
In the Create Inclusion Rules dialog box, specify a criteria in the Active record condition  field. 
CIs must meet this criteria to be included in the identification process and in the duplicate 
CMDB Health metric.

6. Select Save.

What to do next
Navigate to All  > Configuration  > Identification/Reconciliation  > Identification Inclusion Rules 
>  to see the list of all identification inclusion rules.

Related topics

Create health inclusion rule

Reconciliation rules

Reconciliation rules determine which discovery sources can update CI attributes.
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Discovery sources, such as EventManagement, ImportSet, ManualEntry, and Tivoli, are used with 
the createOrUpdateCI()  API to simulate manual updates to CIs. Without reconciliation rules, 
discovery sources can overwrite each other's updates to attribute values.

There are two types of reconciliation rules:

Static reconciliation rules

Static reconciliation rules are the legacy reconciliation rules that set priorities for 
the various discovery sources for updating CI attributes. Static reconciliation rules 
specify which discovery sources can update class attributes, and the precedence 
order among these discovery sources.

When creating static reconciliation rules, ensure that there is a reconciliation rule 
for each discovery source that is authorized to update an attribute. Reconciliation 
rules can be defined at the parent and the child class level.

Static reconciliation rules are stored in the Reconciliation Definition 
[cmdb_reconciliation_definition] table.

Dynamic reconciliation rules

Dynamic reconciliation rules are based on attribute values processed by CMDB 
360/Multisource CMDB  rather than on discovery source priority. First, CMDB 360 
processes the current payload data into the CMDB 360 data store. Then, applying 
a dynamic reconciliation rule, IRE selects the largest or most reported value, for 
example, across all discovery sources. Because dynamic reconciliation rules 
leverage CMDB 360, you must enable that feature to use dynamic reconciliation 
rules.

Creating dynamic reconciliation rules can be useful, for example, if it becomes 
difficult to set priority order for multiple discovery sources. Only a single dynamic 
reconciliation rule can exist per class attribute.

Dynamic reconciliation rules are stored in the Dynamic Reconciliation Definitions 
[cmdb_dynamic_reconciliation_definition] table.

Examples of static reconciliation rules

The following sample static reconciliation rules are created for the cmdb_ci_computer  class 
and its cmdb_ci_linux_server  child class:

1. Discovery is exclusively authorized to update the name  attribute in the cmdb_ci_computer 
class.

Because reconciliation rules are derived by child classes from parent classes, this rule 
also authorizes Discovery to update the name  attribute in any child classes for the 
cmdb_ci_computer  class.

2. ServiceWatch is exclusively authorized to update the name  attribute in the 
cmdb_ci_linux_server  class.

3. ServiceWatch is exclusively authorized to update all attributes in the 
cmdb_ci_linux_server  class, as configured by leaving the Attributes  field empty in the 
rule.

See Create a CI reconciliation rule  for details about creating a static reconciliation rule that, for 
example, authorizes a discovery source to update a specific attribute such as name.
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Using reconciliation rules

As you create reconciliation rules, keep in mind the following principles which are designed for 
flexibility and the refinement of rules at the attributes level:

Precedence of dynamic reconciliation rules

When both, static and dynamic reconciliation rules exist for the same CI attribute, 
the dynamic reconciliation rule takes precedence over the static reconciliation rule.

Authorization for all attributes in a class

A static reconciliation rule lets you authorize a discovery source to update all 
attributes in a class. However, this authorization can be overridden for some of the 
attributes by rules for child classes in which specific attributes are listed.

For example, if only example rules  1 and  3 above are created, then Discovery is 
authorized to update the name  attribute in the cmdb_ci_linux_server  class. 
ServiceWatch is authorized to update all other attributes in the class except for the 
name  attribute.

To override the authorization of Discovery to update the name  attribute, example 
rule  2 above is added to specifically authorize ServiceWatch to update the 
attribute.

Authorization to only specific attributes in a class

To authorize a discovery source to update specific attributes in a class, create a 
static reconciliation rule for the discovery source, and list these attributes in the 
rule. A rule that grants access to specific attributes in a class overrides other static 
reconciliation rules with an empty attribute list that grants access to the entire class.

Example rule  1 above grants Discovery with exclusive authority to update the 
name  attribute of the cmdb_ci_computer  class. All other discovery sources are 
prevented from updating the name  attribute of any CI in the cmdb_ci_computer 
class.

Child class rules overrides parent class rules

Any reconciliation rules defined for a child class override the rules defined for its 
parent class. This rule applies also when the child's reconciliation rule is static and 
the parent's rule is dynamic (dynamic reconciliation rules have precedence over 
static reconciliation rules when they are for same level class).

For example, rule  1 above lets Discovery update the name  attribute in the 
cmdb_ci_computer  class and all of its child classes. However, rule  2 for the 
cmdb_ci_linux_server  child class, which overrides rule  1 for the parent 
class, explicitly authorizes ServiceWatch to update this attribute in the child class.

As a result:

• Discovery cannot update the name  attribute of the child 
cmdb_ci_linux_server  class. Only ServiceWatch is authorized to update 
this attribute.

• Discovery is authorized to update the name  attribute of CI records in all other 
child classes of the cmdb_ci_computer  class.

Overlapping static reconciliation rules

Static reconciliation rules that authorize different discovery sources for the same 
attributes of the same class can coexist and do not exclude each other.
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For example, assume the following rule is added. It is similar to example rule  1 
above but authorizes a different discovery source:

ServiceWatch is authorized to update the name  attribute in the 
cmdb_ci_computer  class.

Like example rule  1 above, this new rule applies to the name  attribute in the 
cmdb_ci_computer  class so both Discovery and ServiceWatch can update the 
attribute. Any reconciliation rules are enforced to prevent the discovery sources 
from overwriting each other's updates.

For more information about reconciliation rules, see the [CMDB - Data Precedence Rules] 
Understanding the CMDB data precedence rules and troubleshooting [KB0756709]  knowledge 
base article (Starting with the Paris release, reconciliation and data precedence rules are 
merged.

Domain separation

If Domain Separation is enabled, then you can scope reconciliation rules to specific domains. 
Rules of the parent domain, if not overridden, apply to CIs of child domain. All rules that are 
visible to a domain are applied, and a rule overriding the parent domain displays thele child 
domain version.

Understanding the CMDB reconciliation rules and troubleshooting [KB0756709]

Create a CI reconciliation rule

Create a static or a dynamic CI reconciliation rule.

If both, static and dynamic reconciliation rules exist for the same CI attribute, the dynamic rule 
has precedence.

Note: 
You can't create a reconciliation rule for system fields or for Identification and 
Reconciliation Engine (IRE) specific fields such as the Discovery source (discovery_source) 
field. Also, reconciliation rules can't be dot-walked using reference fields.

Create a static reconciliation rule

A static reconciliation rule specifies class attributes that discovery sources are authorized to 
update, and prevents unauthorized discovery sources from overwriting the attributes' values. 
A static reconciliation rule also specifies the prioritization among multiple discovery sources. 
Without static reconciliation rules, discovery sources can overwrite each other's updates to 
attribute values.

Before you begin
Role required: itil has read access, itil_admin (on top of itil) has full access.

About this task
Static reconciliation rules are used in conjunction with data refresh rules  to determine 
reconciliation steps for a CI. These rules determine if, when, and by which discovery source 
a CI can be updated. If multiple discovery sources are authorized to update the same class 
attributes, assign a priority to each of these discovery sources to prevent them from overwriting 
each other's updates.

After an authorized discovery source updates an attribute, subsequent updates are accepted 
only from the same discovery source or from a discovery source with a higher priority. Updates 
from a discovery source with a lower priority are rejected, unless these two conditions are met:
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• The lower priority source is the first source updating the CI.

• The CI became stale based on data refresh rules for the CI class.

Precedence order of static reconciliation rules:

• Rule configured for a specific attribute, has precedence over rule set with Apply to all 
attributes  (regardless of priority value).

• Between two rules for the same attribute or between two rules set with Apply to all attributes, 
the rule that is specific directly for the class has precedence over the derived rule.​

• Between two rules for the same attribute or between two rules set with Apply to all attributes 
at the same class level, precedence is determined by rule priorities.

Information about the last discovery source that updates each attribute is stored in the Data 
Source History [cmdb_datasource_last_update] table, but only after enabling the reconciliation 
rule. Therefore, there might be unexpected updates after you enable the rule until the highest 
priority data source has updated the CI.

Static reconciliation rules affect reconciliation of stale CI attributes. During reconciliation, the 
information in the Data Source History table is considered along with the data refresh rules for 
the CI's class, to determine if a CI attribute is stale. A CI attribute is determined to be stale if 
it was not updated by the latest discovery source to update the CI, within a time period. The 
time period is specified by the Effective Duration time in the data refresh rule for the class for 
the discovery source. In this case, if another authorized discovery source, with a lower priority 
attempts to update the stale CI attribute, the update is allowed.

If there is a dynamic reconciliation rule for the same CI attribute as in a static reconciliation rule, 
the dynamic rule takes precedence.

Procedure

1. Navigate to All  > Configuration  > CI Class Manager.

2. Select Hierarchy  to open the CI Classes hierarchy list.

3. Select a class for which to create a reconciliation rule.

4. In the class navigation bar, expand Class Info  and then select Reconciliation Rules.

5. In the Reconciliation Rules section, select Add  to create a rule or select an existing rule to edit.

6. Select the Static Reconciliation Rule  tile if it appears.
If CMDB 360/Multisource CMDB  is not enabled, you can't create a dynamic reconciliation rule 
and the tiles to choose the rule type do not appear.

7. Fill out the fields on the Add Data Sources & Prioritize  tab, and then select Next.

Field Description

Active Check box to activate this reconciliation rule.

Discovery Source Discovery source that you are configuring this 
rule for.

Priority Priority of Source  within other discovery 
sources for the specified attributes. Smaller 
numbers designate higher priority. Discovery 
sources without a reconciliation rule are 
assigned the lowest priority.
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You can add multiple pairs of Discovery Source  and Priority.

8. Fill out the fields on the Select Attributes  tab, and then select Next.

Field Description

Apply to all attributes Authorizes the specified discovery sources to 
update all attributes of the specified class.

Note: 
This rule will be overridden by any rule 
that applies to a specific attribute. In 
which case, instead of using this option, 
you can directly include all attributes for 
Attributes.

Attributes
Attributes, from the current or from a parent 
class, that the specified discovery sources 
are authorized to update.

Available only if Apply to all attributes  is not 
selected.

Update with Null
Attributes that the specified discovery 
sources can update with a null value. By 
default, authorized discovery sources cannot 
overwrite a non-null value with a null value.

Attributes in this list, which are not in the 
Attributes  list, are not included with the 
attributes that the discovery sources can 
update with a null value.

9. Fill out the fields on the Set Filter Condition  tab, and then select Save.

Field Description

Filter Condition
Conditions that CIs must meet for the rule to 
be applicable.

For example, to apply this rule only to CIs that 
are associated with the Finance department, 
select this condition: [Department] [is] 
[Finance].

Note: 
The glide.identification_engine.enable_reconciliation_filter_before_update  system 
property determines when filter conditions are applied. By default, those filter conditions 
are applied after attribute values have changed during payload processing. Set this 
property to true  so that Identification and Reconciliation Engine (IRE) applies the filter 
conditions before attribute values change.
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What to do next

• Select the filter icon ( ) and select:

◦ Attributes: To show only reconciliation rules for a specific attribute.

◦ Discovery sources: To show only reconciliation rules for a specific discovery source.

• Select Preview Rule  to see per attribute, the precedence order between any discovery 
sources that are authorized to update that attribute and any dynamic reconciliation rules.

• If CMDB 360/Multisource CMDB  is enabled, you can:

◦ Select Preview Data  to see all attributes for a specific CI. Also, for each attribute, the current 
CMDB value and discovery sources reported values for the attribute.

◦ Select Recompute  to recompute CI attribute values  after changing reconciliation rules.

• Navigate to All  > Configuration  > Identification/Reconciliation  > Reconciliation Definitions  to 
see a list view of all definitions of reconciliation rules.

Create a dynamic reconciliation rule

A dynamic reconciliation rule uses CMDB 360 data to choose a value such as the largest value 
that is reported, for updating a CI.

Before you begin
CMDB 360/Multisource CMDB  must be enabled.

Role required: itil has read access, itil_admin (on top of itil) has full access

About this task
If the same CI attribute has both, a static reconciliation rule and a dynamic reconciliation rule, the 
dynamic reconciliation rule has precedence.

A dynamic reconciliation rule supports several rule types, such as largest reported value and 
most reported value. When applying a dynamic reconciliation rule, IRE processes the current 
payload and then examines the CMDB 360 data store to select a value with which to update 
the CMDB. Depending on the dynamic reconciliation rule type, selecting the appropriate value 
might not be immediately conclusive. For example, there might not be a single value that is most 
reported, or for some values, the last discovered timestamp isn't reported. Therefore, when 
necessary, IRE falls back to examining additional details such as last reported, last discovered, 
and last updated values to select the most appropriate value.

Note: 
You can't add a dynamic reconciliation rule when creating a new child class in the CI Class 
Manager. You must first save the new child class and then add the dynamic reconciliation 
rule.

Procedure

1. Navigate to All  > Configuration  > CI Class Manager.

2. Select Hierarchy  to open the CI Classes hierarchy list.

3. Select a class for which to create a reconciliation rule.

4. In the class navigation bar, expand Class Info  and then click Reconciliation Rules.

5. In the Reconciliation Rules section, click Add  to create a rule or select an existing rule to edit.

6. Select the Dynamic Reconciliation Rule  tile.

7. On the Select Rule  tab, select a rule type in the Dynamic Rule Type  list field, and then click 
Next.
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8. On the Select Attributes  tab, select the attributes for which to apply the rule.

9. Select Next.
Attributes that the specified rule type can't be applied to and attributes for which a dynamic 
reconciliation rule already exists for, don’t appear.

10. Fill out the fields on the Set Filter Condition  tab, and then select Save.

Field Description

Filter Condition
Conditions that CIs must meet for the rule to 
be applicable.

For example, to apply a rule only to CIs that 
are associated with the Finance department, 
select this condition: [Department] [is] 
[Finance].

What to do next

• Select the filter icon ( ) and select:

◦ Attributes: To show only reconciliation rules for a specific attribute.

◦ Discovery sources: To show only reconciliation rules for a specific discovery source.

• Select Preview Rule  to see per attribute, the precedence order between any discovery 
sources that are authorized to update that attribute and any dynamic reconciliation rules.

• Select Preview Data  to see all attributes for a specific CI. Also, for each attribute, the current 
CMDB value and discovery sources reported values for the attribute.

• Recompute CI attribute values.

• Navigate to All  > Configuration  > Identification/Reconciliation  > Reconciliation Definitions  to 
see a list view of all definitions of reconciliation rules.

Create a data refresh rule

Specify data refresh rules to determine if a CI is stale for a specific discovery source. Such CIs 
can then be updated by a lower-priority authorized discovery source.

Before you begin
Role required: itil has read access, itil_admin (on top of itil) has full access.

About this task
Data refresh rules have no impact when dynamic reconciliation rules are in effect.

Data refresh rules are used in conjunction with static reconciliation rules to determine 
reconciliation steps for a CI. These rules determine if, when, and by which discovery source a CI 
can be updated.

Procedure

1. Navigate to All  > Configuration  > CI Class Manager.

2. Click Hierarchy  to display the CI Classes list.

3. Select the class for which to create a data refresh rule.

4. In the class navigation bar, expand Class Info  and then click Reconciliation Rules.
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5. In the Data Refresh Rules section, click Add  to create a rule or select an existing rule to edit.

6. Fill out the details in the Create Data Refresh Rules dialog box.

Field Description

Discovery source Discovery source for which staleness is 
evaluated.

Effective Duration
The time period that is used for the staleness 
test.

If the fields specified in the static 
reconciliation rule for the CI's class weren't 
updated by Discovery source  within the 
specified Effective Duration  — the CI is 
determined to be stale for Discovery source 
and a lower priority discovery source is 
authorized to update the CI.

When set to 0 (default), the CI is determined 
to be stale for Discovery source  immediately 
after an update and therefor, a lower priority 
discovery source will always be authorized to 
update the CI.

If you enter a value with a prefix that is valid 
and a suffix that is not, such as 15 x  — the 
valid portion of the value is used ('15'). If the 
entire value is invalid — the default value of 0 
is used.

Active Activates the rule.

7. Click Save.

Create an IRE data source rule

When using Identification and Reconciliation Engine (IRE), you can prevent a specific discovery 
(data) source from inserting new CIs for a specific class. Create IRE data source rules for 
discovery sources that you don't trust in creating CIs but continue to trust in updating those CIs 
that exist.

Before you begin
Role required: itil_admin

About this task
IRE data source rules have no impact when dynamic reconciliation rules are in effect.

For example, an IP scan tool that discovers network gear but does not discover servers and 
therefore creates server CIs without details. You can prevent such discovery source from 
creating specific CIs, while still permitting it to update those specific CIs if they exist. IRE data 
source rules are stored in the IRE Data Source Rule [cmdb_ire_data_source_rule] table.
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• Child classes derive IRE data source rules from parent classes like identification rules do.

• IRE data source rules that are specified for a child class, override any IRE data source rules 
derived from a parent class.

When IRE processes an insert operation that is prohibited by an IRE data source rule, the 
insert operation fails. This failure happens when the discovery source and CI class in the insert 
operation and in an IRE data source rule, match. When CreateOrUpdateCIEnhanced()  is used, 
IRE stores the failed payload in the CMDB IRE Partial Payloads [cmdb_ire_partial_payloads] table 
for future potential use.

Note: 
When an insert operation is not allowed by the IRE data source rule, then when using 
createOrUpdateCI() , the entire IRE payload fails since createOrUpdateCI()  doesn't allow 
partial commits.

If later, a permitted discovery source attempts to insert that same CI, then IRE inserts the CI 
after merging it with the matching CI from the partial payloads. IRE then deletes the partial 
payload from the CMDB IRE Partial Payloads [cmdb_ire_partial_payloads] table, and allows 
future updates by the discovery source specified in the rule.

IRE data source rules do not apply to lookup and related items, and only a single rule can be 
active for any class/discovery source pair.

Procedure

1. Navigate to All  > Configuration  > Identification/Reconciliation  > IRE Data Source Rule.

2. In the list view, click New  and fill out the IRE Data Source Rule form.

Field Description

Active Activates the IRE data source rule.

Applies to The class (and child classes) that the 
specified discovery (data) source is not 
allowed to create CIs of.

Data source Discovery (data) source that is not allowed to 
create CIs of the specified class.

Insert Not Allowed Disables the specified discovery (data) 
source from inserting new CIs from the 
specified class, to the CMDB.

3. Click Submit.

Result
If a payload item with an insert request, and in which the discovery source and the CI class 
match the discovery source and the CI class specified in the IRE data source rule:

1. The insert operation fails and IRE logs the following message:

INSERT_NOT_ALLOWED_FOR_SOURCE Insert into [xyz] is blocked for data source [xyz] by IRE 
data source rule.

2. If using CreateOrUpdateCIEnhanced() , then IRE stores the payload item as a partial payload 
in the CMDB IRE Partial Payloads [cmdb_ire_partial_payloads] table.
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If later, a permitted discovery source successfully inserts a CI that matches the CI from a partial 
payload item:

1. The current CI is merged with the matching CI from the partial payload, applying static 
reconciliation rules as needed.

2. The respective partial payload in the CMDB IRE Partial Payloads [cmdb_ire_partial_payloads] 
table is deleted.

3. Later payloads in which the non-permitted discovery source updates the respective CI, run 
successfully.

4. IRE allows the discovery source, that was previously prohibited from inserting the CI, to update 
that same CI which now exists in the CMDB.

Detecting duplicate CIs

When the identification process encounters duplicate CIs, it groups each set of duplicate CIs 
into a de-duplication task for review and remediation. A large number of duplicate CIs might 
be due to weak identification rules. You can configure the identification engine to reconcile 
duplicate CIs.

During CMDB Identification, processing of duplicate CIs is determined by the properties 
glide.identification_engine.skip_duplicates  (set to true by default) and 
glide.identification_engine.skip_duplicates.threshold  (set to 5 by 
default), and on the number of duplicate CIs that are detected. You can configure these 
properties so duplicate CIs are automatically reconciled, skipping duplication.

• If glide.identification_engine.skip_duplicates  is true, 
and the number of duplicate CIs is less than the threshold specified by 
glide.identification_engine.skip_duplicates.threshold, then the oldest 
of the duplicate CIs is picked as a match and gets updated. That oldest duplicate CI also 
becomes the main CI for that set of duplicate CIs. The rest of the duplicate CIs are tagged 
as duplicates by setting the cmdb_ci's duplicate_of  to the appropriate main CI. During 
matching, the identification engine filters out any CI that is tagged as duplicate of any CI.

• If glide.identification_engine.skip_duplicates  is false, then matching of 
duplicate CIs fails with an error, and none of the duplicate CIs are updated.

Also, the glide.duplicate_ci_remediator.max.cis  property determines de-
duplication processing for a large number of duplicate CIs. For more information, see the 'Large 
number of duplicate CIs' section in the Duplicate CIs remediation  topic.

In either case, de-duplication tasks are always created.

Note: 
For a duplicate CI, if any of the CI's attributes, other than duplicate_of, is updated by 
IRE processing, then the CI is no longer considered a duplicate CI. In that situation, the 
value of duplicate_of  is cleared in the CI.

For more information about these properties, see Properties for Identification and Reconciliation.

Review de-duplication tasks

For information about reviewing and remediating de-duplicate tasks, and how the main CI is 
used, see Duplicate CIs remediation.

Generate and simulate payload execution using identification simulation

Identification simulation is a central location for automatically constructing a payload that is 
guaranteed to be complete and valid. You can then simulate the processing of the payload by the 
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identification and reconciliation engine (IRE) and examine the results before actually submitting 
it for execution by IRE.

Use identification simulation to construct an input payload, and simulate processing of the 
payload by IRE. You can then examine the results, adjust identification rules if needed, and re-
run the simulation of the updated payload.

Use the identification simulation to:

• Automatically construct input payload that is based on existing identification rules, hosting and 
containment rules.

• Simulate execution of a payload (automatically constructed by identification simulation, or 
manually created).

• Browse payload output and execution log messages for a simulated run.

Note: 

• Identification simulation does not commit any updates to the CMDB.

• Identification simulation supports simulation of processing payloads that are provided 
and which contain non-CMDB tables, but doesn't support the generation of such 
payloads.

Automatically generate payload using identification simulation

Use identification simulation to automatically construct an input payload for a specified class. 
The constructed payload is complete with any required dependent CIs, correctly structured, and 
syntactically valid for processing by the identification and reconciliation engine (IRE).

Before you begin
Role required: admin

About this task
The payload that is constructed during identification simulation is for the specified class. For 
a dependent CI class, you will be prompted for information about all dependencies. After you 
provide the required details, identification simulation constructs the payload based on your 
input.

Note: 
Automatically generating payloads that contain non-CMDB tables, isn't supported.

Procedure

1. Navigate to All  > Configuration  > Identification/Reconciliation, and click Identification 
Simulation.

2. In the Start with CI Class  box click Start.

3. On the Payload Information  form, in the Data source  field, select the data source that is 
associated with this class update.
For the ServiceNow Discovery data source, select ServiceNow.

4. Select the Class  in the payload.

a. In the Criterion Attributes  area select the CI identifier attributes and then specify the values 
that uniquely identify a CI.

b. In the Additional Attributes  area specify attributes and values that matching CIs will be 
updated with.

5. For dependent CIs associated with dependent identification rules, fill out the Criterion 
Attributes  and Additional Attributes  sections in all Container level  sections that display.
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6. Click Generate Script.

7. If any errors indicate that there are missing fields, fill in the missing fields and then click 
Generate Script  again.

What to do next

• Click Run Simulation  to simulate processing of the payload by IRE.

• Examine the results of the simulation, fine-tune the payload as needed, and combine 
with other payloads for other classes as desired. After finalizing the payload, use the 
createOrUpdateCI()  API to execute the payload by IRE which will result in actual updates to 
the CMDB.

• Click Copy Script  to copy the JSON script into the clipboard. You can then paste that script 
into a third party software or to another screen of the identification simulation.

Simulate payload processing using identification simulation

Use identification simulation to simulate the identification and reconciliation engine (IRE) 
process of CI identification for an input payload. Provide a valid payload, which was constructed 
using identification simulation or that was created manually.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Configuration  > Identification/Reconciliation, and click Identification 
Simulation.

2. Optional:  To run a simulation of an existing payload:

a. Click Start  in the Start with Existing Payload  tile.

b. On the Insert JSON Payload page, select the Data source  that is associated with this class 
update.

c. Optional:  Select Use Enhanced Identification  to apply the identifyCIEnhanced  API for 
enhanced CI identification, instead of using the identifyCI API.

d. Paste the JSON payload into the empty canvas.

3. Optional:  To construct a new payload click Start  in the Start with CI Class  tile.
See Automatically generate payload using identification simulation  for more information.

4. Click Run Simulation  to simulate processing of the payload by IRE.

What to do next

1. Examine the results of the simulation in the results pane, and fine-tune the payload as needed:

a. Click Run #1  to display the Context ID  and the Run ID  of the simulated run.

b. Click the drop down arrow next to Run #1  to display additional details.

▪ Input: Displays the payload for the simulation.

▪ Logs: Displays all the logged messages that IRE generated while simulating processing of 
the payload, according to the specified logging level.

▪ Output: Displays the output payload returned by IRE.

2. After finalizing the payload, use the createOrUpdateCI()  API to execute the payload by IRE 
which will result in actual updates to the CMDB.
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Set logging level for identification simulation

Identification simulation logs each step of a simulated payload processing. You can then 
examine these run logs to determine if a payload was processed as expected, and if 
identification rules are effective. You can adjust the level of logging so it is helpful, and so that the 
amount of messages is not excessive or insufficient.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Configuration  > Identification/Reconciliation, and click Identification 
Simulation.

2. Click the Settings  icon.

3. Select logging level for the identification and reconciliation engine (IRE) under IE Log Level 
and for the service cache under Service Cache Log Level.
The logging levels are displayed in ascending order, from the minimum level to the maximum 
level of logging.

4. Click on the Settings  icon again to close the Settings  dialog box.

Examine run logs

Identification simulation provides run logs which are generated by Identification and 
Reconciliation Engine (IRE). You can access these run logs for payload runs, to examine results 
and for debugging purposes. IRE payload output logs appear in a user friendly format on a 
central page.

Before you begin
Role required: admin

About this task
Also, internal applications that use IRE (such as Discovery) can call an internal API to provide a 
URL to viewing IRE run logs.

Logging is in the context of a specific run of the identification engine, and you can 
filter the log list by a specific data source and time range. Up to 1000 run logs that are 
up to 2 months old are listed, grouped by Context IDs, and run times. You can use the 
glide.identification_logs.max_run_ids  property to modify the 1000 limit.

You can control the logging level by using the 
glide.discovery.identification.log_level  Discovery system property and 
setting the value to one of the following:

• Info

• Warn

• Error

• Debug

• DebugVerbose

• DebugObnoxious

Note: 
IRE performs an initial verification of a payload before processing identification rules. If 
IRE detects any duplicate CIs based on any class identifiers, the payload is rejected and 
processing stops.
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Procedure

1. Navigate to All  > Configuration  > Identification/Reconciliation  > Identification Logs.

2. Filter the runs list as follows:

a. Source: Select the data source for which to display run logs.

b. Time Range: Specify a time range for which to display run logs.
The Runs  list displays all runs for the specified data source, during the specified time range.

3. In the Runs  list, click a Run #  to display its Context ID  and Run ID.
A unique Context ID is associated with each specific payload that is run. Each run of that 
payload, is associated with a unique Run ID. A single Context ID for a payload that is run 
multiple times is associated with multiple Run IDs.

4. Click the drop down arrow for a Run #  to display additional details.

◦ Input: Displays the payload for the run.

◦ Logs: Displays all the logged messages that the identification engine generated while 
running the payload, according to the specified logging level.

◦ Output: Displays the output payload returned by the identification engine.

IRE error messages

The Identification and Reconciliation Engine (IRE) generates the following errors and messages. 
Depending on settings, these messages appear in the Identification Logging pane and in the 
system logs.

For information about lookup-based CI identification and qualifier chains, see Create or edit a CI 
identification rule.

Note: 
IRE performs an initial verification of a payload before processing identification rules. If 
IRE detects any duplicate CIs based on any class identifiers, the payload is rejected and 
processing stops.

For information about CMDB Identification Payload error: "FAILED TRYING TO EXECUTE ON 
CONNECTION", see CMDB Identification Payload error - "Insertion failed with error Error during 
insert of cmdb_ci...", where node logs show "FAILED TRYING TO EXECUTE ON CONNECTION" 
"Duplicate entry 'XXX' for key 'XXX'"  knowledge base article.

Error- IDENTIFICATION_RULE_MISSING

Message Description and Resolution

Identity Rule Missing for table [xyz] Description:

Identification rule is missing for a 
class.

Resolution:

Ensure that there is an 
identification rule for table [xyz], 
and that the rule is active.
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MISSING_MATCHING_ATTRIBUTES

Message Description and Resolution

In payload missing minimum set of input 
values for criterion (matching) attributes from 
identify rule for table [xyz]. Add these input 
values in payload item 'abc'

Description:

Missing minimum set of values 
for criterion attributes for an 
identification rule.

Resolution:

In the payload, add minimum set 
of values for criterion attributes 
for CI Identifier for table [xyz]. 
Open the CI Class Manager, click 
Hierarchy  and select the [xyz 
class. Check the identification 
rule and the identifier entries for 
table [xyz.

Error- NO_CLASS_NAME_FOR_INDEPENDENT_CI

Message Description and Resolution

Cannot have 'sys_class_name' as a key field in 
an Independent Identity Rule on 'xyz'

Description:

The class attribute was added 
to the CI identifier which is not 
supported.

Resolution:

Remove the class attribute from 
CI Identifier for table [xyz].

Error- IDENTIFICATION_RULE_FOR_LOOKUP_MISSING

Message Description and Resolution

Identity Rule for table [xyz] missing Lookup 
Rule for class [abc] Description:

The payload has a lookup class 
name, but the corresponding 
lookup rule is missing.

Resolution:

Add lookup identifier entry with 
[Search on table] as [abc] for CI 
Identifier for table [xyz].

For more information about this error 
message, see Identification error "Identity 
Rule for table [cmdb_ci_table_name] 
missing Lookup Rule for class 
[table_name]" [KB0786444] .
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Error- IDENTIFICATION_RULE_FOR_RELATED_ITEM_MISSING

Message Description and Resolution

Identity Rule for table [xyz] missing Related 
Rule for class [abc]

Description:

The payload has a related class 
name, but the corresponding 
related rule is missing.

Resolution:

Add related entry with [Related 
table] as [abc] within CI Identifier 
for table [xyz].

Error- NO_LOOKUP_RULES_FOR_DEPENDENT_CI

Message Description and Resolution

Cannot have Lookup Rule for a Dependent 
Identity Rule on 'xyz'

Description:

Cannot have Lookup Rule for a 
Dependent Identity Rule.

Resolution:

Remove lookup identifier entry 
from dependent CI Identifier for 
table [xyz].

Error- INVALID_INPUT_DATA

Message Description and Resolution

Found invalid sys_id in payload. No record 
with sys_id [xyz] exist in table [abc] or is a 
duplicate record with [duplicate_of] field set to 
a main CI

Description:

The payload has a reference to 
an invalid sys_id.

Resolution:

Remove the referenced sys_id, or 
provide a valid sys_id.

In payload no data source exist. You need 
to provide choice value from choice field 
[discovery_source] in table [cmdb_ci]

Description:

In payload no data source exists.

Resolution:

In the payload, provide a valid 
choice value from choice field 
[discovery_source] from table 
[cmdb_ci].

In payload invalid data source [xyz] exist. You 
need to provide a valid choice value from field 
[discovery_source] in table [cmdb_ci]

Description:

The payload contains an invalid 
data source.

Resolution:
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Message Description and Resolution

In the payload, provide a valid 
choice value from choice field 
[discovery_source] from table 
[cmdb_ci].

No such relationship with name [xyz] exist 
in table [cmdb_rel_type]. If out-of-box 
relationship for [xyz] has been removed or 
renamed, it should be restored

Description:

The payload is referencing a 
relationship that does not exist in 
the [cmdb_rel_type] table.

Resolution:

Verify that the reference to the 
relationship is accurate. Or, if it 
is a new relationship, add it to 
the [cmdb_rel_type] table. Or, If 
out-of-box relationship for [xyz] 
has been removed or renamed, 
restore it.

Payload relations 'xyz' has invalid parent 
record index: [0]

Description:

Payload references invalid parent 
indexes.

Resolution:

Check payload indexes and 
ensure that they are all valid.

Payload relations 'xyz' has invalid child record 
index: [0]

Description:

Payload references invalid child 
indexes.

Resolution:

Check payload indexes and 
ensure that they are all valid.

Error- DUPLICATE_RELATIONSHIP_TYPES

Message Description and Resolution

Duplicate relationship type records exists with 
name [xyz] in table [cmdb_rel_type] having 
sys_ids: [abc]

Description:

There are duplicate records in 
the [rel_ci_type] table for the 
relationship.

Resolution:

Remove the duplicate records.

Error- DUPLICATE_PAYLOAD_RECORDS

Message Description and Resolution

Found duplicate items in the payload (index 0 
and 1), using className [xyz] and fields [abc]. 
Remove duplicate items from payload

Description:
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Message Description and Resolution

The payload contains two items 
whose criterion attributes have 
identical values.

Resolution:

Remove one of the duplicate 
items.

Error- LOCK_TIMEOUT

Message Description and Resolution

Failed to acquire synchronization lock for xyz Description:

Failed to acquire the system 
mutex lock.

Resolution:

Increase the mutex 
expiration time by adding 
the system property 
glide.identification_engine.mutex_expiration_time 
and setting to an integer value 
that is greater than the default 
value (15 min).

Error- MULTIPLE_DUPLICATE_RECORDS

Message Description and Resolution

Found duplicate records in table [xyz] using 
fields [abc]

Description:

Found duplicate records in the 
specified table.

Resolution:

Fix the duplicate records found 
by the identification engine. 
Check de-duplication tasks for 
information about all duplicates.

Error- REQUIRED_ATTRIBUTE_EMPTY

Message Description and Resolution

Missing mandatory field [xyz] in table [abc]. 
Add input value for mandatory field in payload

Description:

A required attribute is missing in 
the payload.

Resolution:

In the payload, add input value 
for mandatory field [xyz] in table 
[abc].
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Error- MISSING_DEPENDENCY

Message Description and Resolution

In payload no relations defined for dependent 
class [xyz] that matches any containment/
hosting rules: [abc]. Add appropriate relations 
in payload for 'def'

Description:

No relations defined for the 
dependent class that matches 
any of its metadata rules.

Resolution:

In payload add appropriate 
relations for dependent 
class [xyz] that matches any 
containment/hosting rules: [abc].

Error- METADATA_RULE_MISSING

Message Description and Resolution

No containment or hosting rules defined for 
dependent class [xyz]. Add containment/
hosting rules for ‘abc'

Description:

There are no containment 
or hosting rules defined for 
dependent class.

Resolution:

Add containment or hosting rules 
for dependent class [xyz].

Error- MULTIPLE_DEPENDENCIES

Message Description and Resolution

Found multiple dependent relation items [xyz] 
and [abc] in payload

Description:

Multiple dependent relation items 
exist.

Resolution:

Remove one of the multiple 
dependent relation items [xyz] or 
[abc].

Multiple paths leading to the same 
destination: xyz  -> abc

Description:

Multiple paths leading to the 
same destination.

Resolution:

Remove duplicate relationship/
qualifier chains that might exists 
between xyz  -> abc.
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Error- ABANDONED

Message Description and Resolution

Abandoning processing payload item 'xyz', 
since its depends on payload item 'abc' has 
errors

Description:

Dependent payload item 
has errors, so abandoning 
processing.

Resolution:

Resolve the error on the 
dependent payload item ‘abc'.

Can't find matched record with sys_id [xyz] in 
table [abc]

Description:

Matched sys_id does not exist in 
the corresponding table.

Resolution:

Check in table [abc] whether 
matched record is a valid record 
based on input payload.

Identification engine API got called recursively, 
aborting...

Description:

The Identification engine API was 
called recursively.

Resolution:

Avoid calling the Identification 
engine API recursively.

Detected error while processing payload from 
xyz

Description:

Error occurred during processing 
payload.

Resolution:

Resolve all errors mentioned in 
the output payload from xyz.

While processing relations encountered errors 
in payload item: xyz

Description:

Payload item has errors.

Resolution:

Resolve errors in payload item 
‘xyz'.

Error occurred during parsing input json 
payload: xyz

Description:

Error occurred during parsing 
JSON payload.

Resolution:

Ensure that input JSON payload 
has correct JSON format.
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Error- MULTI_MATCH

Message Description and Resolution

Duplicate dependent records found having 
relationship [xyz] with same CI (className:
[abc], sysId:[def])

Description:

Found duplicate dependent CIs.

Resolution:

Check de-duplication tasks for 
information about all duplicates, 
and then delete duplicate 
records.

Found multiple relations between payload 
items: 'xyz' and 'abc'

Description:

Found multiple relations between 
payload items.

Resolution:

Check for duplicate relationship 
chains and qualifier chains that 
might exist.

Found duplicate records in lookup table [xyz] 
using fields [abc] and reference field [def]

Description:

Found duplicate records in 
lookup table.

Resolution:

Check de-duplication tasks for 
information about all duplicates, 
and then delete duplicate 
records.

Error- QUALIFICATION_LOOP

Message Description and Resolution

Qualification chain has loop that contains 
relation 'xyz'

Description:

Qualification chain has a loop.

Resolution:

Remove the loop from the 
qualification chain with relation 
‘xyz'.

Error- TYPE_CONFLICT_IN_QUALIFICATION

Message Description and Resolution

Invalid payload, qualification chain has 
multiple possible paths for payload items: 'xyz' 
and 'abc'

Description:

Multiple qualification paths 
found.

Resolution:
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Message Description and Resolution

Remove multiple possible 
qualification paths between items 
‘xyz’ and ‘abc'.

Error- RECLASSIFICATION_NOT_ALLOWED

Message Description and Resolution

CI Reclassification not allowed from class: 
[xyz] to [abc]

Description:

CI reclassification not allowed.

Resolution:

Check reclassification 
tasks for information about 
reclassification, and check if 
reclassification from class: [xyz] 
to [abc] is valid.

Error- DUPLICATE_RELATED_PAYLOAD

Message Description and Resolution

Found duplicate Related items (0 and 1) in the 
payload index 1 using fields xyz

Description:

Duplicate Related items present.

Resolution:

Remove one of the duplicate 
related items present in the 
payload.

Error- DUPLICATE_LOOKUP_PAYLOAD

Message Description and Resolution

Found duplicate Lookup items (0 and 1) in the 
payload index 1 using fields xyz

Description:

Duplicate lookup items present.

Resolution:

Remove one of the duplicate 
lookup items present in the 
payload.

INSERT_NOT_ALLOWED_FOR_SOURCE

Message Description and Resolution

Insert into [xyz] is blocked for data source 
[abc] by IRE data source rule

Description:

An IRE data source rule  is 
configured to prevent data source 
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Message Description and Resolution

[abc] from inserting CIs of the 
[xyz] class.

Resolution:

Delete or update the appropriate 
IRE data source rule to let data 
source [abc] insert CIs of the 
[xyz] class.

Or, wait for another permitted 
data source to create the same 
CI.

CI reclassification during IRE processing

During the Identification and Reconciliation Engine (IRE) CI identification process, a CI might 
need to be reclassified to a different sys_class_name  type. By default, CIs are reclassified 
automatically. If automatic reclassification is disabled, then the CI is not reclassified and the 
system generates a reclassification task for your review.

The class of a CI can be upgraded, downgraded, or switched to a different branch in the class 
hierarchy. For more details about reclassification operations, see Reclassify a CI. You can use 
system properties and payload flags to configure the IRE behavior of CI reclassification, globally 
or individually per CI.

Note: 
CI reclassification is possible only between two classes that have identical identification 
rules.

Configure automatic CI reclassification using system properties

You can use system properties to configure system-wide IRE behavior for CI reclassification. 
For information about CI reclassification-related properties, including access, see Properties for 
Identification and Reconciliation.

• The following properties enable or disable automatic reclassification updates that are 
specified in a payload. These properties are set to true  in the base system, enabling 
processing of CI updates, including CI reclassification updates.

To disable any automatic reclassification update, set the respective property to false. In 
that case, IRE rejects a payload (or a payload item in Enhanced IRE) with the respective 
reclassification updates, and creates a reclassification task.

◦ glide.class.upgrade.enabled

◦ glide.class.downgrade.enabled

◦ glide.class.switch.enabled

• The following properties enable IRE to process CI updates with reclassification operations. 
However, depending on the property setting, IRE processes or skips the reclassification 
update. These properties are set to false  in the base system, in which case IRE processes CI 
updates including any CI reclassifications.

Set a property to true  to configure IRE to process CI updates but not the CI respective 
reclassification update.
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◦ glide.identification_engine.update_without_switch_enabled

◦ glide.identification_engine.update_without_downgrade_enabled

◦ glide.identification_engine.update_without_upgrade_enabled

This set of properties takes precedence over the previous set of properties 
(glide.class.<reclassification>.enabled). For example, with the following conflicting property 
settings, the second property takes precedence over the first:

◦ glide.class.downgrade.enabled  = false

◦ glide.identification_engine.update_without_downgrade_enabled  = 
true

Example for IRE processing of a payload item with a switch of a CI from Linux Server to Window 
Server. With the following default property settings in the base system, IRE updates the attributes 
including the class switch:

• glide.class.switch.enabled  = true

• glide.identification_engine.update_without_switch_enabled  = false

However, with the following property settings, IRE updates the attributes but skips the class 
switch:

• glide.class.switch.enabled  = true

• glide.identification_engine.update_without_switch_enabled  = true

Configure automatic CI reclassification in input payloads

You can use flags which correspond to the system properties, in the input payload of the 
CreateOrUpdateCIEnhanced()  or the createOrUpdateCI()  APIs. In the payload, set these flags 
to true  or false  to temporarily override the respective system property settings, at the payload 
item level.

For the following payload flags that control reclassification behavior, if any is set, the setting has 
precedence regardless of the setting of the corresponding glide.class.xxx.enabled 
property:

• classUpgrade

• classDowngrade

• classSwitch

For the following payload flags that control reclassification behavior, the system checks if either 
the flag or its corresponding glide.identification_engine.update_xxx_enabled 
property is true to allow the update without the respective reclassification operation:

• updateWithoutUpgrade

• updateWithoutDowngrade

• updateWithoutSwitch

Also, you can pass payload level settings (which apply to all items within a payload), per data 
source, by specifying CI reclassification properties on the Robust Import Set Transformers form. 
For more information, see Robust import set transformer properties .

The following sample JSON payload enables automatic reclassification for the specified CI:
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{ items: [{className: 'cmdb_ci_server', classUpgrade: 
 true, classDowngrade: true, classSwitch: true, values: 
 {name: 'linux123', serial_number: '12srt567', ip_address: 
 '10.2.3.4'}, }]}

Reclassification restriction rules

Prevent IRE from downgrading or switching a CI class during payload processing to help prevent 
data loss. A reclassification restriction rule prevents a CI class change for specific source and 
target classes, while still processing any other property updates for the CI.

You can use a reclassification restriction rule, for example, to prevent a CI class downgrade from 
cmdb_ci_linux_server  (source class) to cmdb_ci_server  (target class). Or, to prevent 
a CI class switch from Linux Server to Windows Server. Reclassification restriction rules can be 
useful when using a Service Graph Connector which might lead to a class downgrade or switch, 
and a potential loss of important data.

To control the application of reclassification restriction rules:

• Use the 
glide.identification_engine.reclassification_restriction_rules_enabled 
system property to globally enable or disable the application of active reclassification 
restriction rules. This property is set to true  by default.

• Use the skipReclassificationRestrictionRules  payload flag in an IRE payload to 
prevent the application of active reclassification restriction rules.

For example, a payload with the skipReclassificationRestrictionRules  flag:

{
  "items": [
    {
      "className": "cmdb_ci_server",
      "values": {
        "short_description": "Linux server description",
        "name": "Linux Server 1"
      },
      "settings": {
        "skipReclassificationRestrictionRules": "true"
      }
    }
  ]
}

For information about how to create a reclassification restriction rule, see Create a 
reclassification restriction rule.

Create a reclassification restriction rule

Reduce data loss during IRE processing by preventing a CI class change for specific source and 
target classes. A reclassification restriction rule affects only the Class  attribute and does not 
prevent the update to the rest of the CI properties.

Before you begin
Role required: Itil_admin (Itil has read privilege only)
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About this task
If during IRE processing of a payload, a CI needs to be reclassified (downgrade or switch 
class), IRE checks reclassification restriction rules. If any reclassification restriction rule applies 
to the current CI reclassification, IRE processes the CI properties update, but skips the CI 
reclassification.

IRE output provides specific details about any processing related to reclassification restriction 
rules.

A reclassification restriction rule applies only to the direction between the specified source and 
the target classes. The rule doesn't prevent a reclassification in the opposite direction, from the 
specified target class to the source class. To restrict reclassification between two classes in both 
directions, specify two separate reclassification restriction rules, one for each direction.

Procedure

1. Enter cmdb_ire_reclassification_restriction.list  in the filter navigator.

2. Fill out the Reclassification Restriction form.

Field Description

Name Name of the reclassification restriction rule.

Source table Current CI class.

Source inheritance Whether to apply the reclassification 
restriction rule to child classes of Source 
table.

Target class Reclassification target class.

Target inheritance Whether to apply the reclassification 
restriction rule to child classes of Target 
table.

Type CI reclassification type: Downgrade  or 
Switch.

3. Click Submit.

What to do next
In the Reclassification Restrictions list view, you can activate or deactivate a reclassification 
restriction rule by setting its Active  value to true or false.

View a reclassification task

Reclassification tasks are created for CIs that could not be automatically reclassified during the 
identification process. Review these tasks to locate the CIs and decide if to reclassify them.

About this task
The properties you use to disable automatic CI reclassification determine whether 
reclassification tasks are created for those CIs that couldn't be automatically reclassified:

• Using any one of the 'glide.class.<reclassification operation>.enabled' properties (such as 
glide.class.upgrade.enabled): Reclassification tasks are created.

• Using any one of the 'glide.identification_engine.update_without_<reclassification 
operation>_enabled' properties (such as 
glide.identification_engine.update_without_switch_enabled): 
Reclassification tasks aren't created.
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Before you begin
Role required: admin or itil

Procedure

1. Navigate to All  > Configuration  > Identification/Reconciliation  > Reclassification Tasks.

2. Select a reclassification task.

3. Examine the details on the Reclassification Task form.

Reclassification Task form

Field Description

Configuration 
item

The CI that must be reclassified.

Short 
description

Short description noting that CI reclassification was not allowed.

Description Description noting the current class of the CI and the class that the CI must 
be changed to.

Internal 
payload

Payload used in the identification process.

What to do next
After examining the task details, you can locate the CI that is noted in the task Description  and 
manually reclassify it. For details, see Reclassify a CI.

CMDB dependent relationship rules

Service definitions consist of CI types and relationship types. Dependent relationship rules 
define the dependency structure of the CI types and the relationship types in these service 
definitions, helping in CI identification and in the construction of business service maps.

The dependencies that are defined by these rules are used when identifying dependent CIs 
to prioritize the order of CI identification, and to match CIs and respective dependent CIs in a 
payload.  Dependent relationship rules are also used by Service Mapping and can be defined for 
custom CI types. After defining a new CI type, you can define dependent relationship rules that 
specify how the new CI type is related to existing types in the CMDB.

Dependent relationship rules consist of hosting and containment rules (dependent relationship 
rules), each type modeling the data from a different perspective of the CI. Containment rules 
represent CIs' configuration hierarchy, describing which CI contains which other CIs. Hosting 
rules represent CIs' placement in a business definition, describing what CIs run on.

Both hosting and containment rules describe a relationship type between two CI types and the 
same relationship type can be used in a hosting rule and in a containment rule. It is the context in 
which the relationship is used that distinguishes between a containment and hosting rule.

Manage dependent relationship rules:

• To access rules at the class level, use the CI Class Manager. Navigate to All  > Configuration  > 
CI Class Manager.

• To access grouped rules, use the Metadata Editor. Navigate to All  > Configuration  > 
Identification/Reconciliation  > Metadata Editor.

The plugins that have been activated on an instance determine which hosting and containment 
rules exist in a base system.
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Hosting rules

Hosting rules represent all the possible valid combinations of pairs of hosting and hosted CIs 
in the service definition. Hosting rules are a flat set of rules that can be only one level deep, and 
which always involve resources, typically physical or virtual hardware. Each hosting rule is a 
stand-alone rule between two CI types, describing either a valid CI type that another CI type can 
host, or by which another CI type can be hosted. A hosting rule consists of a parent CI type, a 
relationship type (such as Hosted On::Hosts) and a child CI type. For example, you can have a 
hosting rule that specifies that the CI type ‘Application’ ‘Runs On::Runs’, the CI type ‘Hardware’.

A CI can be hosted on multiple resources (such as Windows and Linux). This CI is represented 
by a hosting rule for the CI with each resource that the CI can be hosted on. During CI 
identification, the pair of CIs that are being examined, should satisfy at least one hosting rule.

Hosting rules are stored in the CMDB Metadata Hosting Rules [cmdb_metadata_hosting] table.

Containment rules

Containment rules represent the containment hierarchy for a CI type, describing valid objects 
that a CI type can contain in the service definition, and valid objects that can be contained by 
the CI type. Containment rules are chained to each other in a containment rules group, with a CI 
type that is the top-level (root) parent of the group. The collection of containment rules construct 
a hierarchy-like map of containment relationships. Containment rules are logical concepts used 
to represent logical CIs, for example to describe software that runs on a server. A containment 
rule consists of a parent CI type, a relationship type (such as 'Contained By::Contains'), and 
a child CI type. For example, you might have a containment rule specifying that the CI type 
‘Tomcat’ ‘Contains::Contained By' CI type ‘WAR File’.

Endpoints are special containment rules that specify incoming or outgoing connections in the 
model, designating the CI types that data of some specified type flows in to or out from the 
service definition. After adding an endpoint to a containment rule, you cannot add any child rules 
to the endpoint rule.

Containment rules are stored in the CMDB Metadata Containment Rules 
[cmdb_metadata_containment] table.

Reference rules

Reference rules are used mostly by Cloud Management to represent all of the possible valid 
combinations of pairs of referencing and referenced CIs in the service definition.

• Reference rules are a flat set of rules that can be only one level deep.

• Reference rules always involve resources, typically virtual entities. Each reference rule is a 
stand-alone rule between two CI types, describing either a valid CI type that another CI type 
can reference, or by which another CI type can be referenced. Both the CI classes should be 
able to live independent of each other.

• A referencing rule consists of a parent CI type, a relationship type (such as Provisioned 
From::Provisioned) and a child CI type. For example, you can have a referencing rule 
that specifies that the CI type ‘Virtual Machine’ Provisioned From::Provisioned, the 
CI type ‘Image’.

• A CI can reference multiple resources (for example, a VM Instance can have a reference 
relation with both the Image and the Hardware templates). This CI is represented by a 
referencing rule for the CI with each resource that the CI can be referenced from.
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• The reference rule cannot be part of the CI identification.

• Reference rules are stored in the CMDB Metadata Reference Rules 
[cmdb_metadata_reference] table.

Rules requirements

The rules that you create are bound by the following requirements which narrow the 
relationships and ensure that only valid options are available in the drop-down lists in the 
Metadata Editor.

• Given a CI type that is as a child in a containment rule: Not this CI type or its children can be a 
top-level (root) parent of any other containment rule, and it cannot be in any hosting rule, either 
as a parent or as a child.

• Given a CI type that is a top-level (root) parent of a containment rule: It cannot be a child in a 
hosting rule (for example, you cannot be hosted on Tomcat, if Tomcat has any containment 
rules).

• Given a CI type that is a child in a hosting rule: It cannot be in any containment rule, either as a 
parent or a child.

• Given a CI type that is a parent in a hosting rule: It cannot be a child in any containment rule.

• Hosting rules cannot create loops such as Tomcat –runs_on- VMWare –runs_on- Tomcat.

Example: Hosting and containment rules model

Hosting rules that model the diagram:

Tomcat 'Runs on' Hardware.

Containment rules that model the diagram:

• Tomcat 'Contains' Configuration File

• Tomcat 'Contains' WAR

• WAR has two endpoints for JDBC with MySQL:

◦ Inbound

◦ Outbound

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

315



Example: Valid set of rules

 
Tomcat Hosted Linux
Linux Hosted Computer

The second metadata entry triggers the third requirement, which is satisfied (it is a hosting rule, 
not a containment rule).

Create dependent relationship rules

Create hosting and containment rules (dependent relationship rules) for CI classes to help with 
correctly identifying dependent CIs during the business discovery process and service mapping. 
Discovery  calls the identification API that applies dependent relationship rules.

You can create a basic hosting or containment rule in the CI Class Manager. Or, use 
the Metadata Editor to create groups of hosting and containment rules, and inbound or 
outbound endpoints in containment rules. The CI Class Manager and the Metadata Editor are 
synchronized, and you can use each of those tools to display and edit a dependent rule.

Create a dependent relationship rule for a CMDB class

Use the CI Class Manager to create a basic dependent relationship rule (hosting or containment 
relationship rule) for a CMDB class.

Before you begin
Role required: itil has read access, itil_admin (on top of itil) has full access.

About this task
The class for which you create dependent relationship rule, must have a dependent 
identification rule.

Procedure

1. Navigate to All  > Configuration  > CI Class Manager.

2. Click Hierarchy  to display the CI Classes list, and select the class for which you want to create 
a hosting or a containment rule.

3. In the class navigation bar, click Dependent Relationships.

4. In the Dependent Relationships view, click Add dependency.

5. Fill out the details in the Add Dependent Relationship Rule dialog box.

Field Description

Rule Type Designation of whether this rule is a hosting rule or a containment rule.

This Class The class that the rule applies to.

Relationship The relationship type for the rule.

Target Class The target class for the dependent relationship rule. The designation of this 
class as a child or parent class, is based on the specified Relationship.

6. Click Save.
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What to do next
You can click Reset to derived  and then confirm the operation to delete all dependent 
relationship rules that were added specifically for the selected class. Only dependent 
relationships that are derived from a parent class, remain.

For more information about child and parent classes, see Table extension and classes .

Create or edit a collection of containment rules

Create containment rule for CIs to help with correctly identifying dependent CIs during the 
business discovery process and service mapping. Discovery calls the identification API that 
applies dependent relationship rules.

Before you begin
Role required: admin

About this task
A containment rule is a dependent relationship rule which defines a relationship between two 
CIs, structured as: CIType1 RelationshipType CIType2. The first CI type that you add becomes the 
top level CI of a containment rules group which is a chain of containment rules. The entire set of 
containment rules is organized as groups according to top-level CIs.

To create a containment rules group for a new CI type, you need to first add the CI Type1 of the 
relationship. To add a child containment rule for a CI type that exists, you need to select that CI 
type, and define the second portion of the relationship rule which is the relationship type and CI 
Type2.

To each rule within a containment rules group you can add inbound or outbound endpoints, 
which are noted by blue up and down arrows. After adding an endpoint, you can not add a 
containment rule in that branch of the containment rules hierarchy.

Procedure

1. Navigate to All  > Configuration  > Metadata Editor.

2. In the Metadata Editor, click the Containment Rules  tab.

3. Click Add New Rule  to add a top-level rule or point to a rule for which you want to add a child 
rule and click the green '+' icon that appears on the right.

4. Complete the Add Containment Rule to <class>  form.

Field Description

Configuration 
Item Type

The CI class that the rule applies to.

Relationship 
Type

The relationship type for the rule.

Reverse 
Relationship 
Direction

Enable to use the reverse relationship in the rule.

Always 
include in 
Service Model

Enable to always include the CIs of the specified class in the Service Map 
if their parent CI (based on the containment relationship) is present in the 
Service Map.

5. Click Create.

6. Add an endpoint to a child rule:
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a. Point to a child rule for which you want to add an endpoint.

b. Click the blue "+" icon that appears on the right.

c. Complete the Add Endpoint To <class>  form.

Field Description

Endpoint Type The type of endpoint.

Inbound or Outbound The direction of the endpoint.

d. Click Create.

Create or edit a collection of hosting rules

Create hosting rule for CIs to assist in correctly identifying dependent CIs during the business 
discovery process and service mapping. Discovery  calls the identification API that applies 
dependent relationship rules.

Before you begin
A hosting rule is a dependent relationship rule which defines a relationship between two CIs, 
structured as: <CI Type1> <relationship type> <CI Type2>. To create a hosting rule, you need to 
add a CI type as <CI Type1> in the relationship rule, and then define the second portion of the 
relationship rule which is the relationship type and <CI Type2>. The entire set of hosting rules is 
organized as groups according to the top-level hosted CIs.

A hosting rule implicitly contains two rules, which are the reversal of each other. When you create 
the rule '<CI Type1> <relationship type> <CI Type2>', the rule '<CI Type2> <reversed relationship 
type> <CI Type1>' is automatically added.

Role required: admin

Procedure

1. Navigate to All  > Configuration  > Metadata Editor.

2. In the Metadata Editor, click the Hosting Rules  tab.

3. Click Add New Rule  to add a top-level rule or point to a rule for which you want to add a child 
rule and click the green '+' icon that appears on the right.

4. Complete the Add Hosted/Hosting Rule to <class>  form.

Field Description

Configuration Item Type The <CI Type2> in the rule.

Relationship Type The relationship type for the rule.

Reverse Relationship Direction Check to reverse relationship in the rule.

5. Click Create.
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IRE support for non-CMDB tables

Apply Identification and Reconciliation Engine (IRE) processes to supported non-CMDB tables to 
ensure data integrity and health of those tables.

Starting with the Washington DC  release, IRE supports some non-CMDB tables. You can use all 
IRE features with some non-CMDB tables after creating identification rules (CI identifiers and 
identifier entries) for those tables. Non-CMDB tables supported for IRE features include:

• In an application-specific scope: All non-CMDB tables

• In the global scope: Only non-CMDB tables that are preset in the base system. In 
the Washington DC  release for example, the Location [cmn_location], Department 
[cmn_department], Cost Center [cmn_cost_center], Building [cmn_building], User [sys_user], 
and Group [sys_user_group] non-CMDB tables are supported.

You can't use the CI Class Manager  to manage any IRE-related rules for non-CMDB tables. 
Instead, you must work directly with the respective tables in list views to create and manage 
those rules as described in the following procedures:

• Create an identification rule for a non-CMDB table

• Create a reconciliation rule for a non-CMDB table

• Create an IRE data source rule for non-CMDB tables

• Create a data refresh rule for a non-CMDB table

• Create an identification inclusion rule for a non-CMDB table

• Simulate payload execution using identification simulation

• Use partial payloads

• Review and remediate de-duplication tasks

You can use the following store apps with supported non-CMDB tables:

• CMDB 360 in CMDB Workspace

• IntegrationHub ETL

IRE processes are applied to supported non-CMDB tables with the following differences:

• IRE doesn't populate the discovery_source, last_discovered, and the 
first_discovered  attributes if those attributes don't exist in the non-CMDB table.

• IRE uses the non-CMDB table’s class name as sys_class_name  if the table doesn't include 
a sys_class_name  attribute.

• IRE payloads don't support relationships with non-CMDB tables.

Note: 
Although IRE-related user interface and accompanying documentation might reference 
CMDB and CMDB elements, most of those references also apply to any supported non-
CMDB tables.

Create an identification rule for a non-CMDB table

To use Identification and Reconciliation Engine (IRE) features with supported non-CMDB tables, 
you must first create identification rules that uniquely identify the table records. Each non-CMDB 
table can be associated with a single identification rule.

Before you begin
Role required: itil has read access, itil_admin (on top of itil) has full access
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About this task
Each identification rule consists of a single identifier for the table, one or more identifier entries, 
and one or more related entries.

Review the following topics before creating identification rules:

• Identification rules

• General guidelines for using CMDB Identification

When creating identifier entries, you can configure the Search on table  and Criterion attributes 
fields on the Identifier Entry form to implement one of the following options:

Regular identifier entry

Lets you select attributes from the associated identifier table.

Lookup identifier entry

Lets you select attributes from any related table (Lookup table), other than the 
currently selected table.

Hybrid identifier entry

Lets you select attributes from both the currently main selected table, and from 
another table (Lookup table).

For non-CMDB tables, only independent identification rules are supported.

Procedure

1. Navigate to All  > Identification/Reconciliation  > CI Identifiers.

2. In the Identifiers list view, click New.

3. Fill out the Identifier form.

Field Description

Name Name of CI identifier.

Applies to Supported non-CMDB table.

Independent Must be checked to indicate that the identifier can identify a record 
independently of other records.

4. Click Submit.

5. In the Identifiers list view, locate and open the identifier that you just created.

6. On the Identifier form, select the Identifier Entries  tab and then click New.

7. Fill out the Identifier Entry form.

Field Description

Identifier Preset with the name of the table of the associated identifier.

Search 
on table Preset with the label of the table of the associated identifier.

To create:
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Field Description

◦ A regular identifier entry: Set to the identifier table and select Criterion attributes  from that 
same table.

◦ A lookup identifier entry: Set to another table (lookup table) and select Criterion attributes 
from that lookup table.

◦ A Hybrid identifier entry: Set to another table (lookup table) and then do the following steps.

▪ Select Criterion attributes  from the lookup table.

▪ Add Hybrid Entry CI Criterion Attributes  from the current table using background 
scripts, after saving the rule. For more details, see the 'What to do next' section at the end 
of this task.

A lookup table should have a reference to the associated identifier table.

Criterion 
attributes

Set of attributes that uniquely identify the record. Attributes can belong to the current class, or 
to a parent class.

Note: 
It's possible to add reference fields as a criterion attribute. However, such fields might 
not always be effective:

◦ Reference fields store sys_ids that point to a record in another table, and thus is 
considered a weak criterion attribute (in terms of uniqueness) for the current table.

◦ The system detects and then replaces invalid values in a reference field with 
'Unknown'. For example, an invalid Model ID  value is replaced with the value 
'Unknown'. Also, if several CIs end up having that same reference field set to 
'Unknown', then these CIs become duplicate CIs.

Priority Priority of applying the identifier entry. Rules with lower priority numbers are given higher 
priority. Identifier entries of identical priorities are applied randomly.

You can keep gaps between the priority numbers, so you can assign the unused priority 
numbers to new entries without modifying the existing priority order.

Active Specifies whether the identifier entry is active. At least one identifier entry in an identification 
rule must be active for the rule to apply.

Enforce 
exact 
count 
match

For lookup identification, match a record only on exact lookup records count match.

When enforced, all lookup items for a record in the payload must have matching records in the 
lookup table that reference the same record:

a. Only matches records that have all the lookup items from the input payload referencing the 
record in the table.

b. If there are multiple matches, selects the oldest created record as the final match.

When not enforced, one lookup item for a record in the payload matching a record in the 
lookup table, is sufficient to consider a match:

a. Matches any record that has at least one of the lookup items from the input payload 
referencing the record in the table.

b. If there are multiple matches, selects the records with the max number of lookup items from 
the input payload referencing the record in the table.

c. If there are still multiple matches, selects the oldest created record as the final match.
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Field Description

Allow 
null 
attribute

When selected, then if at least one criterion attribute isn't null, attempt matching with an 
identifier entry even if there are criterion attributes that are null.

Otherwise, all criterion attributes must have values to attempt matching with an identifier 
entry.

Allow 
fallback 
to 
parent's 
rules

Allows the identification rules of the record's parent table to be used if a match isn't found for 
this identification rule. Applies only for dependent identification rules.

Optional 
condition

A filter to narrow the set of records that will be searched for a matching record.

Available only if the 
glide.identification_engine.enable_identifier_optional_condition 
system property is set to true  (false  by default). In the base system, identifier entries 
of various classes are pre-configured with advanced options conditions. All these pre-
configured conditions in regular identifier entries will automatically apply when you set 
this property to true. Therefore, to prevent unexpected behavior, review those predefined 
conditions in regular identifier entries before setting this property to true.

For more details about this property, see Properties for Identification and Reconciliation.

Note: 
If criterion attributes have only two attributes and sys_class_name  is one of them 
(for example [name, sys_class_name], [ip_address, sys_class_name]), then the other 
attribute can't be NULL, even if Allow null attribute  is enabled. This restriction is due to 
sys_class_name  being considered a special system matching attribute.

8. Click Submit.

9. On the Identifier form, select the Related Entries  tab and then click New.

10. Fill out the Related Entry form.

Related Entry form

Field Description

Identifier Preset with the identifier that this related entry is associated with.

Active Check box that specifies that the related entry is active.

Related 
table

A related table (lookup table) that references the record that is being matched.

Referenced 
field

A referenced field in Related table  with a reference to the associated identifier 
table.

Criterion 
attributes

The set of attributes to uniquely identify the related item. Attributes can belong 
to the current class, or to a parent class.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

322



Field Description

Note: 
It's possible to add reference fields as a criterion attribute. However, such 
fields might not always be effective:

◦ Reference fields store sys_ids that point to a record in another 
table, and thus is considered a weak criterion attribute (in terms of 
uniqueness) for the current table.

◦ The system detects and then replaces invalid values in a reference field 
with 'Unknown'. For example, an invalid Model ID  value is replaced 
with the value 'Unknown'. Also, if several CIs end up having that same 
reference field set to 'Unknown', then these CIs become duplicate CIs.

Click the lock icon to view, add, or remove attributes from the identification rule.

Allow null 
attribute

If at least one criterion attribute in the related table isn't null, allow to attempt 
matching with an identifier entry even if there are criterion attributes which are 
null.

Priority Priority of the related entry for the specified Related table. Rules with lower 
priority numbers are given higher priority while matching a related item for 
a specific related table. Related entries for the specified related table with 
identical priorities are applied randomly.

You can keep gaps between the priority numbers, so you can assign the 
unused priority numbers to new entries without modifying the existing priority 
order.

Optional 
condition

Filter conditions to narrow the set of records that will be searched for a 
matching related item.

11. Click Submit.

What to do next
To add criterion attributes to a Hybrid Entry CI Criterion Attributes  field in a hybrid identifier 
entry, instead of using the Identifier Entry form, you must use background scripts. After saving 
the identification rule, navigate to System Definitions  > Scripts - Background, and then enter a 
script that adds the attributes and click Run script.

Sample script:

var gr = new GlideRecord('cmdb_identifier_entry');
// get the identifier entry you want to update
gr.get('<identifier_entry_sys_id>');
// set the attributes you want in the hybrid rule in a comma 
 separated list
// for example: 'name,serial_number'
gr. 
 hybrid_entry_ci_criterion_attributes='<column_name_1>,<column_n
ame_2>,<etc.>';
gr.update();

This process requires the admin role.

Create a reconciliation rule for a non-CMDB table

Create a static or a dynamic CI reconciliation rule for a non-CMDB table.
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For information about static reconciliation rules, dynamic reconciliation rules, and other 
principals related to reconciliation rules, see Reconciliation rules.

If both, static and dynamic reconciliation rules exist for the same record attribute, the dynamic 
rule has precedence.

Note: 
You can't create a reconciliation rule for system fields or for Identification and 
Reconciliation Engine (IRE) specific fields such as the Discovery source (discovery_source) 
field. Also, reconciliation rules can't be dot-walked using reference fields.

Create a static reconciliation rule for a non-CMDB table

A static reconciliation rule specifies class attributes that data sources are authorized to update, 
and prevents unauthorized data sources from overwriting the attributes' values. A static 
reconciliation rule also specifies the prioritization among multiple data sources. Without static 
reconciliation rules, data sources can overwrite each other's updates to attribute values.

Before you begin
Role required: itil has read access, itil_admin (on top of itil) has full access.

About this task
Static reconciliation rules are used in conjunction with data refresh rules  to determine 
reconciliation steps for a record. These rules determine if, when, and by which data source a 
record can be updated. If multiple data sources are authorized to update the same attributes, 
assign a priority to each of these data sources to prevent them from overwriting each other's 
updates.

After an authorized data source updates an attribute, subsequent updates are accepted only 
from the same data source or from a data source with a higher priority. Updates from a data 
source with a lower priority are rejected, unless these two conditions are met:

• The lower priority source is the first source updating the record.

• The record became stale based on data refresh rules for the class.

Precedence order of static reconciliation rules:

• Rule configured for a specific attribute, has precedence over rule set with Apply to all 
attributes  (regardless of priority value).

• Between two rules for the same attribute or between two rules set with Apply to all attributes, 
the rule that is specific directly for the class has precedence over the derived rule.​

• Between two rules for the same attribute or between two rules set with Apply to all attributes 
at the same class level, precedence is determined by rule priorities.

Information about the last discovery source that updates each attribute is stored in the Data 
Source History [cmdb_datasource_last_update] table, but only after enabling the reconciliation 
rule. Therefore, there might be unexpected updates after you enable the rule until the highest 
priority data source has updated the CI.

Static reconciliation rules affect reconciliation of stale attributes. During reconciliation, the 
information in the Data Source History table is considered along with the data refresh rules for 
the CI's class, to determine if a CI attribute is stale. A CI attribute is determined to be stale if 
it was not updated by the latest discovery source to update the CI, within a time period. The 
time period is specified by the Effective Duration time in the data refresh rule for the class for 
the discovery source. In this case, if another authorized discovery source, with a lower priority 
attempts to update the stale CI attribute, the update is allowed.
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If there is a dynamic reconciliation rule for the same record attribute as in a static reconciliation 
rule, the dynamic rule takes precedence.

Procedure

1. Navigate to All  > Configuration  > Identification/Reconciliation  > Reconciliation Definitions.

2. In the Reconciliation Definitions list view, click New.

3. Fill out the Reconciliation Definition form.

Field Description

Data source The data source that you are configuring this 
rule for.

Priority Priority of Data source  within other data 
sources for the specified attributes. Smaller 
numbers designate higher priority. Data 
sources without a reconciliation rule are 
assigned the lowest priority.

Applies to Authorizes the specified data source to 
update all attributes of the specified non-
CMDB table.

Note: 
This setting will be overridden by 
any setting that applies to a specific 
attribute. In which case, instead of using 
this option, you can directly include all 
attributes for Attributes.

Filter condition
Conditions that records must meet for the 
rule to be applicable.

For example, to apply this rule only to 
records that are associated with the 
Finance department, select this condition: 
[Department] [is] [Finance].

Note: 
The 
glide.identification_engine.enable_reconciliation_filter_before_update 
system property determines when 
filter conditions are applied. By default, 
those filter conditions are applied 
after attribute values have changed 
during payload processing. Set this 
property to true  so that Identification 
and Reconciliation Engine (IRE) applies 
the filter conditions before attribute 
values change.
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Field Description

Attributes
Attributes from the current or from a parent 
class, that the specified data source is 
authorized to update.

Available only if Apply to all attributes  is not 
selected.

Update with null
Attributes that the specified data source 
can update with a null value. By default, 
authorized data sources cannot overwrite a 
non-null value with a null value.

Attributes in this list, which are not in the 
Attributes  list, are not included with the 
attributes that the data source can update 
with a null value.

4. Click Submit.

Create a dynamic reconciliation rule for a non-CMDB table

A dynamic reconciliation rule for non-CMDB table uses CMDB 360 data to choose a value such 
as the largest value that is reported, for updating a record.

Before you begin
CMDB 360/Multisource CMDB  must be enabled.

Role required: itil has read access, itil_admin (on top of itil) has full access

About this task
If the same CI attribute has both, a static reconciliation rule and a dynamic reconciliation rule, the 
dynamic reconciliation rule has precedence.

A dynamic reconciliation rule supports several rule types, such as largest reported value and 
most reported value. When applying a dynamic reconciliation rule, IRE processes the current 
payload and then examines the CMDB 360 data store to select a value with which to update 
the CMDB. Depending on the dynamic reconciliation rule type, selecting the appropriate value 
might not be immediately conclusive. For example, there might not be a single value that is most 
reported, or for some values, the last discovered timestamp isn't reported. Therefore, when 
necessary, IRE falls back to examining additional details such as last reported, last discovered, 
and last updated values to select the most appropriate value.

Note: 
You can't add a dynamic reconciliation rule when creating a new child class in the CI Class 
Manager. You must first save the new child class and then add the dynamic reconciliation 
rule.

Procedure

1. Click All.

2. In the Filter navigator, enter cmdb_dynamic_reconciliation_definition.list  to 
open the Dynamic Reconciliation Definitions table.

3. In the Dynamic Reconciliation Definitions list view, click New.
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4. Fill out the Dynamic Reconciliation Definition form.

Field Description

Name

Attributes Attributes for which to apply the rule. 
Attributes that the specified rule type can't be 
applied to and attributes for which a dynamic 
reconciliation rule already exists for, don’t 
appear.

Filter condition
Conditions that CIs must meet for the rule to 
be applicable.

For example, to apply a rule only to CIs that 
are associated with the Finance department, 
select this condition: [Department] [is] 
[Finance].

Applies to Non-CMDB table that this rule applies to.

Dynamic Rule Type Rule type which is based on CMDB 360 data.

5. Click Submit.

Create a data refresh rule for a non-CMDB table

To apply Identification and Reconciliation Engine (IRE) features to supported non-CMDB tables, 
create data refresh rules for those tables. Data refresh rules are used to determine if a record is 
stale for a specific data source. Such records can then be updated by a lower-priority authorized 
data source.

Before you begin
Role required: itil has read access, itil_admin (on top of itil) has full access

About this task
Data refresh rules have no impact when dynamic reconciliation rules are in effect.

Data refresh rules are used in conjunction with static reconciliation rules to determine 
reconciliation steps for a record. These rules determine if, when, and by which data source a 
record can be updated.

Procedure

1. Click All.

2. In the Filter navigator, enter cmdb_datasource_staleness.list  to open the Data 
Source Staleness Definitions table.

3. In the Data Source Staleness Definitions list view, click New.

4. Fill out the Data Source Staleness Definitions form.

Field Description

Applies to Non-CMDB class that this rule applies to.
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Field Description

Data source Data source for which record staleness is 
evaluated.

Effective Duration The time period that is used for the staleness 
evaluation.

If the fields specified in the static 
reconciliation rule for the record's class were 
not updated by the specified data source 
within the specified time period — the record 
is determined to be stale for that data source.

If you enter a value with a prefix that is valid 
and a suffix that is not, such as 15 x  — the 
valid portion of the value is used ('15'). If the 
entire value is invalid — the default value of 0 
is used.

Active Activates the rule.

5. Click Submit.

Create an identification inclusion rule for a non-CMDB table

Narrow the scope of records that are included in the identification process of non-CMDB records 
by creating an identification inclusion rule.

Before you begin
Role required: itil has read access, itil_admin (on top of itil) has full access.

About this task
During duplication detection of independent CIs, the Identification and Reconciliation Engine 
(IRE) processes only the records that satisfy the identification inclusion rules.  For example, 
you can set a filter to include only records whose state is operational. When no identification 
inclusion rules exist, all records are included in the identification process.

In the base system, there are no predefined identification inclusion rules. Identification inclusion 
rules are defined at the class level.

Note: 
Identification inclusion rules impact any script that calls IRE, therefore create them carefully. 
Identification inclusion rules can prevent the identification of certain types of records, 
affecting some features of Discovery and Service Mapping.

Procedure

1. Navigate to All  > Configuration  > Identification/Reconciliation  > Identification Inclusion 
Rules.

2. In the Identification Inclusion Rules list view, click New.

3. Fill out the Identification Inclusion Rules form.

Field Description

Applies to Non-CMDB table that this rule applies to.
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Field Description

Inclusion condition Criteria that non-CMDB records must meet to 
be included in the identification process.

4. Click Save.

Create an IRE data source rule for non-CMDB tables

When using Identification and Reconciliation Engine (IRE), you can prevent a specific data 
source from inserting new records for a specific non-CMDB table. Create IRE data source rules 
for data sources that you don't trust in creating records but continue to trust in updating those 
records that exist.

Before you begin
Role required: itil_admin

About this task
IRE data source rules have no impact when dynamic reconciliation rules are in effect.

• Child classes derive IRE data source rules from parent classes like identification rules do.

• IRE data source rules that are specified for a child class, override any IRE data source rules 
derived from a parent class.

When IRE processes an insert operation that is prohibited by an IRE data source rule, the 
insert operation fails. This failure happens when the data source and record class in the insert 
operation and in an IRE data source rule, match. When CreateOrUpdateCIEnhanced()  is used, 
IRE stores the failed payload in the CMDB IRE Partial Payloads [cmdb_ire_partial_payloads] table 
for future potential use.

Note: 
When an insert operation is not allowed by the IRE data source rule, then when using 
createOrUpdateCI() , the entire IRE payload fails since createOrUpdateCI()  doesn't allow 
partial commits.

If later, a permitted data source attempts to insert that same record, then IRE inserts the record 
after merging it with the matching record from the partial payloads. IRE then deletes the partial 
payload from the CMDB IRE Partial Payloads [cmdb_ire_partial_payloads] table, and allows 
future updates by the data source specified in the rule.

IRE data source rules do not apply to lookup and related items, and only a single rule can be 
active for any class/data source pair.

Procedure

1. Navigate to All  > Configuration  > Identification/Reconciliation  > IRE Data Source Rules.

2. In the IRE Data Source Rules list view, click New  and fill out the IRE Data Source Rule form.

Field Description

Data source Data source that is not allowed to create CIs 
of the specified class.

Active Activates the IRE data source rule.
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Field Description

Applies to The class (and child classes) that the 
specified data source is not allowed to create 
records for.

Insert Not Allowed Disables the specified data source from 
inserting new records of the specified class, 
to the non-CMDB table.

3. Click Submit.

Result
If a payload item with an insert request, and in which the data source and the record class match 
the data source and the record class specified in the IRE data source rule:

1. The insert operation fails and IRE logs the following message:

INSERT_NOT_ALLOWED_FOR_SOURCE Insert into [xyz] is blocked for data source [xyz] by IRE 
data source rule.

2. If using CreateOrUpdateCIEnhanced() , then IRE stores the payload item as a partial payload 
in the CMDB IRE Partial Payloads [cmdb_ire_partial_payloads] table.

If later, a permitted data source successfully inserts a record that matches the record from a 
partial payload item:

1. The current record is merged with the matching record from the partial payload, applying static 
reconciliation rules as needed.

2. The respective partial payload in the CMDB IRE Partial Payloads [cmdb_ire_partial_payloads] 
table is deleted.

3. Later payloads in which the non-permitted data source updates the respective record, run 
successfully.

4. IRE allows the data source, that was previously prohibited from inserting the record, to update 
that same record which now exists in the non-CMDB table.

General guidelines for using CMDB Identification

Review the following general guidelines for using CMDB Identification effectively.

Identification rules

An independent identification rule  identifies a CI based on the CI's attributes, independently of 
other CIs.

A dependent identification rule  identifies a CI by its dependent CIs and the relationships of the 
identified CI with those dependent CIs. Identification with a dependent identification rule is 
based on the dependent CIs and the relationships and qualifiers between the identified CI and 
its dependent CIs. Identification then requires more time than with an independent identification 
rule and is prone to some identification errors. Usage of dependent rules should therefore be 
minimized.

CI modeling determines which type of identification rules are required for proper CI 
identification.

Create identification rules using the following order of importance:
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1. Independent identification rules — It is always preferable to create independent identification 
rules rather than dependent identification rules. When you model a CI, define the CI with a 
complete set of attributes that lend themselves to independent identification, eliminating the 
need to use additional CIs for identification.

2. Dependent identification rules — If it is necessary to create dependent identification rules, 
then define a single level of dependency. Two is the maximum number of dependency levels 
that is supported.

3. Avoid creating lookup identifier entries. The use of lookup identifier entry is highly discouraged 
as it can reduce performance. If unavoidable, ensure to first review class definitions and 
consider updates that allow usage of independent identification rules.

4. Limit the number of identifier entries within an identification rule, ideally to 1. A second 
identifier entry can further reduce performance, as will each additional identifier entry.

5. Create strong identification rules in which the strongest identifier entries and related entries 
are set with the highest priority.

6. Ensure that the identification rule is at the class level that it needs to be.

Payload

Create the payload using the following order of importance:

1. Payload size — Limit the number of CIs per payload to 500.

2. Avoid duplicate entries in the payload.

Example: If an identification rule has a criterion attribute for the name  field, then the following 
payload has duplicate items resulting in failure:

var payload = {
    items: [{
        className:'cmdb_ci_linux_server',
        values: {
            name:'Win Server 200',
            ram:'2048'
        }},
{
        className:'cmdb_ci_linux_server',
        values: {
            name:'Win Server 200',
            ram:'4096'
        }}]
};

3. Do not pass system data such as the following in the payload.

var payload = {
    items: [{
        className:'cmdb_ci_linux_server',
        values: {
            name:'Win Server 200',
            sys_domain:'global',
            sys_domain_path:'xyz',
            sys_updated_on:'2017-06-15 16:25:11',
            sys_mod_count:23,
        }}]
};
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4. Provide the minimum necessary set of criterion attributes for each payload item, according to 
what is specified in the corresponding identification rules.

5. When matching CIs, use CIs’ sysIds if available. If provided, IRE can use the sysId to directly 
locate a CI without requiring any criterion attributes from the identification rule. In this case, IRE 
does not use the sysId in the matching process.

◦ Example: Independent CI that needs to be updated — sysId is available.

var payload = {
    items: [{
        className:'cmdb_ci_linux_server',
        values: {
            sys_id:'194876usytrr65378098',
            ram:'2048',
        }}]
};

◦ Example: Dependent CI that needs to be inserted. Tomcat War CI depends on Tomcat CI, 
and Tomcat CI depends on Linux Server CI. SysIds for the Tomcat and the Linux CIs are 
available.

var payload = {
        items: [{
            className:'cmdb_ci_app_server_tomcat_war’,
            values: {
                name:'war1',
                short_description:'my description'          
  }
        }, {
            className:'cmdb_ci_app_server_tomcat',
            values: {
                sys_id:'194876usytrr65378098'
            }
        }, {
            className:'cmdb_ci_linux_server',
            values: {
                sys_id:'09876tysueyt6345lakiu'
            }
        }],
        relations: [{
                    parent:1,
                    child:0,
                    type: 'Contains::Contained by’}, {
                        parent:1,
                        child:2,
                        type:'Runs on::Runs'}
                    ]
                };

◦ Example: Dependent CI that needs to be updated — sysId is available.

var payload = {
        items: [{
            className:'cmdb_ci_app_server_tomcat_war',
            values: {
                sys_id:'039387euey637465sytet',
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                short_description:'my description new'       
     }
        }]
                };

6. When inserting many CIs, all of which depend on the same CI, you should serialize your 
API calls. Otherwise, attempting to concurrently process many CIs can clog the system, 
significantly degrading overall system performance.

Properties for Identification and Reconciliation

Use the Identification and Reconciliation properties to configure the identification and 
reconciliation engine (IRE).

These properties are available for Identification and Reconciliation. To view and edit these 
properties, the admin role is required.

Note: 
To open the System Properties [sys_properties] table, enter sys_properties.list  in 
the navigation filter.

Properties for Identification and Reconciliation

Property Description

Enforce the requirement that required attributes cannot be null during identification and 
reconciliation.

glide.required.attribute.enabled

• Type: true | false

• Default value: true

• Location: Configuration  > CMDB Properties  > Identification/Reconciliation Properties

Allow class upgrade during IRE identification and reconciliation.

glide.class.upgrade.enabled

• Type: true | false

• Default value: true

• Location: Configuration  > CMDB Properties  > Identification/Reconciliation Properties

• Learn more: CI reclassification during IRE processing.

When false, IRE rejects a payload (or a payload item in Enhanced IRE) with the respective 
reclassification update, and creates a reclassification task.

Allow class downgrades during IRE identification and reconciliation.

glide.class.downgrade.enabled

• Type: true | false

• Default value: true

• Location: Configuration  > CMDB Properties  > Identification/Reconciliation Properties

• Learn more: CI reclassification during IRE processing.

When false, IRE rejects a payload (or a payload item in Enhanced IRE) with the respective 
reclassification update, and creates a reclassification task.

Allow class switching during IRE identification and reconciliation.

glide.class.switch.enabled

• Type: true | false

• Default value: true
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Properties for Identification and Reconciliation  (continued)

Property Description

• Location: Configuration  > CMDB Properties  > Identification/Reconciliation Properties

• Learn more: CI reclassification during IRE processing.

When false, IRE rejects a payload (or a payload item in Enhanced IRE) with the respective 
reclassification update, and creates a reclassification task.

glide.identification_engine.update_without_upgrade_enabled Enable IRE to process CI updates with upgrade reclassification updates. This property takes 
precedence over the glide.class.upgrade.enabled  property.

• Type: true | false

• Default value: false

• Location: Add to System Properties [sys_properties]  table.

• Learn more: CI reclassification during IRE processing.

Depending on the property setting, IRE processes or skips the upgrade update:

• true: IRE processes the CI updates but doesn't process the CI upgrade reclassification 
update.

• false: IRE processes the CI updates including the CI upgrade reclassification update.

glide.identification_engine.update_without_downgrade_enabled Enable IRE to process CI updates with downgrade reclassification updates. This property takes 
precedence over the glide.class.downgrade.enabled  property.

• Type: true | false

• Default value: false

• Location: Add to System Properties [sys_properties]  table.

• Learn more: CI reclassification during IRE processing.

Depending on the property setting, IRE processes or skips the downgrade update:

• true: IRE processes the CI updates, but doesn't process the CI downgrade reclassification 
update.

• false: IRE processes the CI updates including the CI downgrade reclassification update.

glide.identification_engine.update_without_switch_enabled Enable IRE to process CI updates with switch reclassification updates. This property takes 
precedence over the glide.class.switch.enabled  property.

• Type: true | false

• Default value: false

• Location: Add to System Properties [sys_properties]  table.

• Learn more: CI reclassification during IRE processing.

Depending on the property setting, IRE processes or skips the switch update:
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Properties for Identification and Reconciliation  (continued)

Property Description

• true: IRE processes the CI updates, but doesn't process the CI switch reclassification 
update.

• false: IRE processes the CI updates including the CI switch reclassification update.

glide.identification_engine.reclassification_restriction_rules_enabled Globally enable or disable the application of active reclassification restriction rules.

• Type: true | false

• Default value: true

• Location: Add to System Properties [sys_properties]  table.

• Learn more: CI reclassification during IRE processing.

Allow the update of an empty field by a lower priority data source.

glide.reconciliation.override.null

• Type: true | false

• Default value: true

• Location: Configuration  > CMDB Properties  > Identification/Reconciliation Properties

Controls how identification processes a small set of duplicate CIs.

glide.identification_engine.skip_duplicates

• Type: true | false

• Default value: true

• Other values:

true

If the number of duplicate CIs is less than the threshold specified by 
glide.identification_engine.skip_duplicates.threshold, 
then the oldest of the duplicate CIs is picked as a match and gets updated. That 
oldest CI is also designated as the main CI for that set of duplicate CIs.

For the rest of the duplicate CIs, the duplicate_of  field is set as a reference 
to the main CI.

false

Matching a CI fails, and an error is logged.

• Location: Configuration  > CMDB Properties  > Identification/Reconciliation Properties

Maximum number of CIs that can be in a set of duplicate CIs to allow 
identification to process the duplicate CIs according to the setting of 
glide.identification_engine.skip_duplicates.

glide.identification_engine.skip_duplicates.threshold

If the number of duplicate CIs exceeds the threshold, then identification processes the 
duplicate CIs as if glide.identification_engine.skip_duplicates  is set to 
false.

• Type: integer

• Default value: 5

• Location: Configuration  > CMDB Properties  > Identification/Reconciliation Properties
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Properties for Identification and Reconciliation  (continued)

Property Description

Maximum number of log runs that can be displayed when navigating to Configuration  > 
Identification Logs.

glide.identification_logs.max_run_ids

• Type: integer

• Default value: 1000

• Location: Configuration  > CMDB Properties  > Identification/Reconciliation Properties

glide.cache.size.service_cache
Maximum cache size (in MB) that is used by the identification engine for inbound and 
outbound relations. When the limit is reached, the least recently used cached data is 
discarded, releasing space for new data.

Note: 
You cannot disable the service cache.

• Type: integer

• Default value: 20

• Location: Add to System Properties [sys_properties]  table.

glide.identification_engine.granular_insert_locking Determines whether to use multiple granular insert locks or single global insert lock.

Set to false if there are performance issues associated with the usage of multiple granular 
insert locks.

• Type: true | false

• Default value: true

• Location: Add to System Properties [sys_properties]  table.

glide.identification_engine.batch_update_last_discovered Controls batch update of last_discovered  field in CIs that are being processed by the 
identification engine.

Set to false if there are business rules that apply to the last_discovered  field, and you 
want to trigger these rules when calling an Identification and Reconciliation API.

• Type: true | false

• Default value: true

• Location: Add to System Properties [sys_properties]  table.

glide.identification_engine.related_items_local_cache_count
For optimization, a custom number of locally cached query result entries of related/lookup 
items.

• Type: integer

• Default value: 15000

• Location: Add to System Properties [sys_properties]  table.
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Properties for Identification and Reconciliation  (continued)

Property Description

Note: 
If there is a memory issue due to optimization related to using local cache, set the 
glide.identification_engine.related_items_local_cache_count 
and the 
glide.identification_engine.dependent_items_local_cache_count 
properties to 0.

glide.identification_engine.dependent_items_local_cache_count
For optimization, a custom number of locally cached query result entries of dependent CIs.

• Type: integer

• Default value: 10000

• Location: Add to System Properties [sys_properties]  table.

Note: 
If there is a memory issue due to optimization related to using local cache, set the 
glide.identification_engine.related_items_local_cache_count 
and the 
glide.identification_engine.dependent_items_local_cache_count 
properties to 0.

glide.identification_engine.independent_items_local_cache_count
For optimization, a custom number of locally cached query result entries of independent CIs.

• Type: integer

• Default value: 100000

• Location: Add to System Properties [sys_properties]  table.

Setting the value to 0 avoids using local cache for independent CIs which might affect 
performance.

glide.cmdb.logger.source.identification_engine
Enable and configure what type of details the system logs when using IRE outside the scope of 
identification simulation. For example, when using an API, ECC queue or scheduled jobs.

• Type: string

• Values: info, warn, error, debug, or debugVerbose

• Location: Add to System Properties [sys_properties]  table.

Note: 
Depending on the setting, the system can generate large amounts of data that might 
affect overall system performance. Set the value with caution, and limit the level of details 
and use time to the minimum necessary for testing or debugging.

For more troubleshooting information, see the How to capture IRE [identification and 
reconciliation engine] debug logs [KB0750382]  knowledge base article.

glide.identification_engine.partial_payload_items_max_size
Maximum number of items allowed when creating a partial payload. When that limit is reached, 
the partial payload is split.
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Properties for Identification and Reconciliation  (continued)

Property Description

For example, when IRE creates a partial payload, items and associated relations and 
references, are all merged in one partial payload. This merge could result in a large partial 
payload.

Adjusting this property can help with performance issues related to IRE processing of partial 
items.

• Type: integer

• Default: 1000

• Learn more: Identification and Reconciliation engine (IRE)

• Location: Add to System Properties [sys_properties]  table

glide.identification_engine.partial_items_process_limit
Maximum number of partial items to be fetched in a single IRE call. After reaching this limit, IRE 
fetches only partial items corresponding to complete items in the input payload.

Adjusting the value can help with performance issues related to IRE processing of partial items.

• Type: integer

• Default: 2000

• Location: Add to System Properties [sys_properties]  table.

glide.identification_engine.partial_items_process_absolute_limit
Absolute limit of the number of partial items for IRE to fetch, after which, IRE stops fetching 
partial payloads from the CMDB IRE Partial Payloads [cmdb_ire_partial_payloads] table. 
Adjusting the value can help with performance issues related to IRE processing of partial items.

• Type: integer

• Default: 5000

• Location: Add to System Properties [sys_properties]  table.

glide.identification_engine.skip_updating_source_last_discovered_if_older
Determines how IRE updates the last_discovered  and the discovery_source 
attributes in the CMDB.

• true: If last_discovered  is provided in the payload and it is older than the 
last_discovered  of the CI in the CMDB, IRE does not use the payload values to update 
the last_discovered  and the discovery_source  attributes in the CMDB.

• false: Even if the last_discovered  provided in the payload is older than the 
last_discovered  of the CI in the CMDB, IRE uses the payload values to update the 
last_discovered  and the discovery_source  attributes in the CMDB.

Note: 
Only the attributes mentioned above are affected by this property in an update operation.

• Type: true | false

• Default: true

• Learn more: Identification and Reconciliation engine (IRE)

• Location: Add to System Properties [sys_properties]  table.
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Properties for Identification and Reconciliation  (continued)

Property Description

glide.identification_engine.ire_message_listener_skip_updating_source_last_discovered_to_now
If Robust Transform Engine (RTE) does not pass the 
ire.skip_updating_last_scan_to_now  custom property on the 
Robust Import Set Transformer form , IRE uses the value of this property for the 
skip_updating_source_last_discovered_to_now  IRE option.

• Type: true | false

• Default: false

• Location: Add to System Properties [sys_properties]  table.

glide.identification_engine.skip_updating_last_scan_if_older
Determines how IRE uses the source_recency_timestamp  value in a payload to 
determine whether to update the last_scan  attribute in the Source [sys_object_source] 
table.

• true: If source_recency_timestamp  is provided in the payload and it is older than the 
last_scan  of the CI in the CMDB, IRE does not update the last_scan  attribute in the 
Source [sys_object_source] table.

• false: Even if the source_recency_timestamp  provided in the payload is older 
than the last_scan  of the CI in the CMDB, IRE uses the payload value to update the 
last_scan  attribute in the Source [sys_object_source] table.

You can check the input payload for a CI and the last_scan  attribute value in the Source 
[sys_object_source] table to learn if IRE will update that last_scan  value or not.

Note: 
Only the attributes mentioned above are affected by this property in an update operation.

• Type: true | false

• Default: true

• Learn more: About mapping data columns to CMDB classes and attributes

• Location: Add to System Properties [sys_properties]  table.

glide.identification_engine.ire_message_listener_skip_updating_last_scan_to_now
If RTE does not pass the ire.skip_updating_last_scan_to_now  custom property 
on the Robust Import Set Transformer form , IRE uses the value of this property for the 
ire.skip_updating_last_scan_to_now  IRE option.

• Type: true | false

• Default: false

• Learn more: About mapping data columns to CMDB classes and attributes

• Location: Add to System Properties [sys_properties]  table.

glide.identification_engine.platform_domain_separation_enabled
Toggles domain separation support mode during IRE processing.

• false: IRE processes run only within the current domain. Basically disabling parent domains 
access to child domains during IRE processing.

• true: IRE domain separation follows the platform domain separation behavior. Basically, 
enabling parent domains to look access into all its child domains during IRE processing.
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Properties for Identification and Reconciliation  (continued)

Property Description

• Type: true | false

• Default: false

• Learn more: Domain separation and CMDB Identification and Reconciliation

• Location: Add to System Properties [sys_properties]  table.

glide.identification_engine.enable_identifier_optional_condition
Enables advanced options for regular identifier entries in identification rules. Those advanced 
options let you add conditions to narrow the set of records that will be searched for a matching 
CI.

Note: 

This property affects only regular identifier entries (it doesn't affect lookup or hybrid 
identifier entries).

In the base system, identifier entries of various classes are pre-configured with advanced 
options conditions. All these pre-configured conditions in regular identifier entries will 
automatically apply when you set this property to true.

To prevent unexpected behavior, review those predefined conditions in regular identifier 
entries before setting this property to true. In the Filter  box in the primary navigation, 
enter cmdb_identifier_entry.list. Then, in the Identifier Entry list view, review 
the 'Optional condition' column.

• Type: true | false

• Default: false

• Learn more: Create or edit a CI identification rule

• Location: Add to System Properties [sys_properties]  table.

glide.identification_engine.enable_reconciliation_filter_before_update
Determines whether filter conditions of a reconciliation rule are applied before a value change 
during payload processing, or after.

• Type: true | false

• Default: false

• Learn more: Create a static reconciliation rule, Create a dynamic reconciliation rule

• Location: Add to System Properties [sys_properties]  table.

Components installed with Identification and Reconciliation

Several types of components are installed with Identification and Reconciliation (included in the 
com.snc.cmdb plugin), including tables.

Tables installed

Table Description

Identifier Identification rule sets defined for different classes 
of CIs.
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Table Description

[cmdb_identifier]

Reconciliation Definition

[cmdb_reconciliation_definition]

Static reconciliation rules defined for different 
classes of CIs at the table and field level.

Dynamic Reconciliation Definitions

[cmdb_dynamic_reconciliation_definition]

Dynamic reconciliation rules defined for different 
attributes and classes.

Identifier Entry

[cmdb_identifier_entry]

Rule entries with different priorities assigned to 
each identifier.

Duplicate Audit Result

[duplicate_audit_result]

Duplicate audit results corresponding to a specific 
duplicate task. These results are generated 
automatically during the identification process and 
should not be added manually.

Remediate Duplicate Task

[reconcile_duplicate_task]

Task to address duplication that is detected during 
the identification process. Records are generated 
automatically, and users should not add records 
manually.

Reclassification Task

[reclassification_task]

Reclassification tasks that were generated during 
the identification process.

Data Source History

[cmdb_datasource_last_update]

Information about the last data source that updated 
each attribute. Used to determine if a data source 
can update a stale CI.

Data Source Staleness Definition

[cmdb_datasource_staleness]

Effective duration per data source. When effective 
duration is exceeded, then CMDB Health 
determines that the information provided by that 
data source is stale.

Identification Engine Context

[cmdb_ie_context]
Input payload, and data source (cmdb_ci’s 
discovery_source) that will be used as input 
for a specific identification engine API. Stores 
information about which specific identification 
engine API will be called (identifyCI 
or createOrUpdateCI  API). Also stores 
information about enhanced IRE options used in 
Identification Simulation.

Note: 
Internal table used by identification simulation.

Identification Engine Run

[cmdb_ie_run]
Specific cmdb_ie_context record that was used to 
run against the identification engine. Also details 
about the output payload returned by APIs, such as 
start and end time of the run and whether the run 
was successful.
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Table Description

Note: 
Internal table used by identification simulation.

Identification Engine Log

[cmdb_ie_log]
Identification engine logs for a specific 
cmdb_ie_run simulated in the identification 
simulation. Also details about logs level and order.

Note: 
Internal table used by identification simulation.

IRE Data Source Rule

[cmdb_ire_data_source_rule]

IRE data source rules.

CMDB IRE Partial Payloads

[cmdb_ire_partial_payloads]
Payload items that were determined to be partial, 
and which might be later matched with an incoming 
payload. If a partial payload is matched and 
processed, it is deleted from the CMDB IRE Partial 
Payloads table.

Partial payloads older than 90 days are deleted 
from the table.

For more information about usage of this table in 
IRE processes, see Identification and Reconciliation 
engine (IRE).

CMDB IRE Partial Payloads Index

[cmdb_ire_partial_payloads_index]
Identifier keys associated with partial items. IRE 
uses those keys to try to match with identifier keys 
of incoming payloads.

For more information about usage of this table in 
IRE processes, see Identification and Reconciliation 
engine (IRE).

CMDB IRE Incomplete Payloads

[cmdb_ire_incomplete_payloads]
Incomplete items, stored using JSON format 
as incomplete payloads. Incomplete items are 
stored for the purpose of logging payloads with 
irrecoverable errors, and are never processed 
again.

The table is configured for table rotation , with 
duration of one day and seven table rotations.

For more information about usage of this table in 
IRE processes, see Identification and Reconciliation 
engine (IRE).

IRE Output Aggregate Stats

[cmdb_ire_output_aggregate_stats]
This table is populated when RTE invokes IRE, for 
example, when processing integrations.
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Table Description

Details about data inserted by Import Sets or 
Robust Transform Engine (RTE) to the CMDB (via 
IRE). Numbers of items inserted, partial items, and 
updated items, are stored for each type of CI, per 
run.

IRE Output Target Items

[cmdb_ire_output_target_item]
This table is populated when RTE invokes IRE, for 
example, when processing integrations.

Details about data inserted by Import Sets or 
Robust Transform Engine (RTE) to the CMDB (via 
IRE). Target class and the sys_id are stored per 
ImportSet row id, within a run.

For this table to populate, RTE must pass the 
ire_output_detailed_stats  property.

Reclassification Restrictions

[cmdb_ire_reclassification_restriction]

Reclassification restriction rules. These rules 
prevent switch and downgrade reclassification 
updates for specific source and target classes. For 
more information, see CI reclassification during IRE 
processing.

User roles installed

Role Description

cmdb_payload_admin Automatically assigned to users with the cmdb_admin role for internal 
use only.

Related topics

Properties for Identification and Reconciliation

Populating the CMDB

You can populate the CMDB by using Discovery, by using the IntegrationHub ETL or Import Sets 
to import and integrate data from a third-party source, by integrating with an external CMDB, or 
by manually creating CIs.

When you populate the CMDB with information, you create a record for each configuration item 
in the cmdb_ci table or on one of the tables that extend that table.

Related ServiceNow®  Store  apps and reference information:

• CMDB schema model: A collection of class diagrams and class attributes for key CMDB 
classes.

• CMDB tables descriptions: Descriptions of key CMDB tables in the base system.

• CMDB CI Class Models: A ServiceNow Store  app that adds class models that extend the base 
CMDB class hierarchy. This includes class descriptions, identification rules, identifier entries, 
and dependent relationships if applicable. You can then use the added classes as any other 
CMDB base class.
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• Discovery patterns : A ServiceNow Store  app that provides a library of Discovery patterns for 
discovering specific devices and applications in the industry.

• Getting started with Service Graph Connectors: ServiceNow Store  apps that provide pre-
defined integrations for importing and integrating common third-party data into CMDB classes. 
Also includes the IntegrationHub ETL  wizard for creating new ETL transform maps.

ITIL configuration management auto-discovery

The key to any configuration management business practice is the initial and ongoing inventory 
or discovery of what you own. The ServiceNow  platform provides three options for auto-
discovery:

• The separate and highly robust Discovery  product.

• For organizations that want to leverage the discovery technologies they already have deployed 
(SMS, Tally NetCensus, LanDesk, and so on), the ServiceNow  platform supports integrations to 
those technologies via web services. Scanned data can be mapped directly into the CMDB.

For further information on designing, constructing, and maintaining the CMDB, see the CMDB 
Design & Configuration  white paper.

Discovery

The Discovery  product automatically populates the CMDB. Discovery  searches the network 
for all attached computers and devices, then populates the CMDB with information on each 
computer/device's configuration, provisioning, and current status. Discovery  uses probes, 
sensors, and patterns, to collect and process data about computers, servers, printers, a variety 
of IP-enabled devices, and the relationships between all the items found. Discovery  also reports 
on any software which is running, and the TCP connections between computer systems, thereby 
establishing their relationships. This information is sent back to the instance and is used to 
populate the CMDB.

For more information about Discovery  see:

• ITOM Visibility

• Discovery basics

Integrate third-party data using IntegrationHub ETL

Use the IntegrationHub ETL  to import and integrate data from a third party into the CMDB. Using 
IntegrationHub ETL, create ETL transform maps which are used for integrating data from specific 
data sources. IntegrationHub ETL guides you through importing source data, transforming 
any data if needed, and selecting target CMDB classes and attributes to map the data to. You 
then preview the integration results and adjust any configurations before scheduling recurring 
integrations.

Visit the ServiceNow Store  website to view and download common integrations.

Import data from another source using Import Sets

You can import data to the CMDB using Import Sets. Import sets  find files of information (in 
formats such as XML, Excel, or CSV), import them, and transform them onto the required table. 
This process can be scheduled or performed on demand.

To import relationships between CIs, use import sets to populate the table [cmdb_rel_ci] with 
information on the parent, the child, and the nature of the relationship. The [cmdb_rel_ci] table 
displays a list of all CI relationships and is useful when importing CI data.
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Import Sets overview

CMDB instance API

Use the CMDB instance API  to populate the CMDB by creating or updating CMDB tables.

Manually create a CI

Create a single CI for a specific class. The role required is based on the settings of the class 
table you select for the CI.

1. Use the CI Class Manager:

a. Navigate to All  > Configuration  > CI Class Manager.

b. Click Hierarchy  to display the list of CI Classes. Select the class to use for the CI.

c. In the class navigation bar, select CI List  and then on the CI list view, click New.

d. Fill out the CI form and then click Submit.

2. Or, directly use a table:

a. Navigate to All  > Configuration  and then elect the class to use for the CI, such as Business 
Services.

b. In the navigation filter of the application navigator, enter the table label (such as 'Linux'), or 
the table name in the format of <table name>.list (such as 'cmdb_ci_linux_server.list'). Then, 
press Enter.

c. In the list view of the table, click New  and fill out the form fields for the table.

d. Click Submit.

CMDB 360/Multisource CMDB

CMDB 360 retains complete history about discovery sources and proposed values, involved in 
updates of CI attributes. Use CMDB 360 data to track how the CMDB is populated by various 
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discovery sources at the CI attribute level. Also, to revert CI updates from a specific discovery 
source, or to recompute attribute values using updated reconciliation rules.

Starting with the Utah  release, the Multisource CMDB feature is part of the CMDB 360 feature. 
CMDB 360 provides all the functionality of Multisource CMDB and additional capabilities such 
as an analytics dashboard, and new query functionality. You can access all of the CMDB 360 
capabilities in the CMDB 360 view in CMDB Workspace.

How CMDB 360 works

When multiple discovery sources attempt to update the same CI attribute, the Identification and 
Reconciliation Engine (IRE)  uses reconciliation rules to select a single discovery source for the 
update. Without CMDB 360, details about the lower-priority discovery sources whose values 
were rejected, are discarded. Also, it is difficult to identify the source of an attribute value without 
CMDB 360.

With CMDB 360, the raw details for every discovery source and CI combination are retained for 
both, discovery sources that were selected for an update and all others that were not. CMDB 
360 data, consisting of records for each discovery source and CI combination, is stored in the 
CMDB MultiSource Data [cmdb_multisource_data] table. You can examine, query, and report on 
the CMDB 360 data store.

You can optionally exclude classes and their descendents from collecting and processing CMDB 
360 data. The CMDB MultiSource Data [cmdb_multisource_data] table doesn't contain data for 
those excluded classes. For more information, see Exclude classes from CMDB 360.

Note: 
CMDB 360 supports non-CMDB tables. The widely used term Configuration Item (CI), can 
also refer to a non-CMDB table record. For information about support for non-CMDB tables, 
see IRE support for non-CMDB tables.
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CMDB 360 insights into data source processes

After data is initially ingested from multiple data sources, several processes are applied to to 
standardize and reconcile the data before it is stored in the CMDB. CMDB 360 provides insights 
that can help you configure some of these processes.
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Using CMDB 360

Use CMDB 360 to:

• Create a dynamic reconciliation rule.

• Control CI updates at the discovery source and CI attribute level.

• Visualize discovery sources of attribute values, at the attribute level.

• Modify reconciliation rules and then recompute CMDB data, reflecting the updated 
reconciliation rules.

• Revert CMDB data integration from a specific discovery source, if, for example, you realize 
that the discovery source is not reliable. Recompute CI attribute values, while excluding the 
discovery source that you want to ignore.

• Validate a new discovery source by comparing its data to data from other discovery sources, 
which are known to be valid.

• Improve data management, data quality, and operational insights, by querying on CMDB 360 
data. Use the CMDB 360 query builder in CMDB Workspace  to create queries for CMDB 360 
records, discovery sources, and CI records.

Enable and configure CMDB 360

• Activate  the ITOM Discovery License (com.snc.itom.discovery.license) plugin.

• Navigate to All  > Configuration  > CMDB 360 Properties. Then, in the CMDB 360 Properties 
pane ensure that the glide.identification_engine.multisource_enabled  (Enables CMDB 360) 
property is set to true.

• Optionally, Exclude classes from CMDB 360.

By default, CMDB 360 tracks discovery source information for CIs from CMDB classes and 
doesn't collect data for non-CMDB tables. You can independently enable or disable tracking 
data for CMDB and for non-CMDB classes, using these system properties: 

• glide.identification_engine.multisource_cmdb_ci_enabled  (Enables capturing CMDB 360 data 
for CIs from CMDB classes)​

• glide.identification_engine.multisource_non_cmdb_ci_enabled  (Enables capturing CMDB 360 
data for CIs from non-CMDB classes

Report on CMDB 360 data

Use the CMDB 360 view in CMDB Workspace  to gain insights into the CMDB 360 data store. 
Build reports that, for example, do the followings:

• Find CIs not reported by any discovery source.

• Find discovery sources populating data in your CMDB.

• Compare attribute values across discovery sources.

• Compare attribute values between CMDB and other discovery source.

• Limit reports for CMDB 360 data, to a specific application service, technical service, or a 
CMDB group.

See Sample Multisource CMDB queries  for more details.
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Visualize CMDB 360 data

CMDB 360 is highly verbose in the user interface:

• On the Reconcliation Rules  page in CI Class Manager, click the Preview Data  tab to see per 
attribute, discovery sources that are authorized to update that attribute, in precedence order.

• On a CI form, click the CMDB 360 Data Preview  related link to see per CI attribute, current 
value in the CMDB and incoming values from other discovery sources.

Logging

Enable logging for CMDB 360 by adding and enabling the system property 
 glide.cmdb.logger.source.cmdb_multisource. In the Log [syslog] table, search for entries in which 
source=“cmdb_multisource”.

CMDB 360 experience in CMDB Workspace

The CMDB 360 view provides aggregations and analysis of CMDB 360 data which you can use 
to track activities and identify potential issues of discovery sources. You can also create different 
types of your own queries and associated schedules and reports to explore CMDB data.

Use the CMDB 360 view in CMDB Workspace  to access all of the CMDB 360 capabilities. For 
information about all CMDB 360 dashboard settings, see Configure the CMDB 360 dashboard.

Note: 
Most cards on the CMDB 360 dashboard support non-CMDB tables in their aggregation, or 
can be configured to provide support. However, the CIs not reported by discovery sources 
card, for example, doesn't apply to non-CMDB tables. Creating queries for non-CMDB 
tables is also supported. For information about support for non-CMDB tables, see IRE 
support for non-CMDB tables.

Access

Requirements:

• Role requirement: sn_cmdb_user (CMDB user) or any role containing sn_cmdb_user

• Additional requirement: Enable and configure CMDB 360

To access the CMDB 360 view in the CMDB Workspace, navigate to Workspaces  > CMDB 
Workspace. In the CMDB Workspace  menu bar, select CMDB 360.

Potential issues

Cards on the Potential issues tile show details about CIs with discovery sources that are 
incorrectly reporting on the CIs.

CIs not reported by discovery sources

Lists CIs that are discovered by multiple discovery sources, but one or more of the 
discovery sources has stopped reporting within a specified number of days. The 
Number of days since CIs were last discovered by a discovery source  dashboard 
setting is used in the card's aggregation.

Drill down on this card to see a list view of the CIs for the card and the specific 
discovery source per CI that is no longer reporting.

Example: You configure 7 days for the setting. A Linux server CI named backup-
linux.sea.com is reported by these discovery sources within the specified number of 
days:
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• ServiceNow  - today.

• ServiceWatch - 4 days ago.

• AgentClientCollector - 8 days ago.

In this scenario, the CI shows on the CIs not reported by discovery sources card, 
since AgentClientCollector reported over seven days ago.

Data mismatch

Lists CIs for which different discovery sources are reporting different values. 
Attributes are considered mismatched when different discovery sources report 
different values for the attribute. CIs that appear when you drill down on this card 
can reveal issues with the individual CI, or your reconciliation rules.

The specific records that appear in the drilled-down list view, depend on the Data 
mismatch  dashboard settings.

In the Data mismatch records list view, select an item in a Source column to access 
the Multisource Data Preview page with details about all discovery sources with 
values for the attribute. On the Multisource Data Preview page you can use the 
Search Attributes box to search for specific attributes and also choose one of the 
following options:

• All attributes: Shows all attributes of the selected class, regardless of whether 
they have a value in the CMDB.

• Attributes with CMDB values: Shows only attributes of the selected class, with a 
value in the CMDB.

• Attributes with multisource data: Shows all attributes of the selected class, and 
for each attribute shows current CMDB value and any other discovery sources 
with a value for the attribute.

Regardless of the option that you choose on the Multisource Data Preview page, a 
discovery source value that was used for the current CMDB value – is highlighted in 
green. These values are identical to the CMDB value of the attribute.

Saved queries

The Saved queries card shows up to 20 of your CMDB 360 queries. You can use the card to edit 
and run those queries, or create new queries. Saved queries are sorted on both the card and list 
view by the most recently created or updated queries.

If your instance has been upgraded from an instance that contained Multisource Report Builder 
queries, then those queries appear on the Saved queries card.

• Click a saved query to modify or view it before running.

• Click a query's action icon and then select Run.

• Click View All Queries  to see all the saved queries where you can examine or run a query.

• Click Create Query  to create a query of one of the following types:
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◦ Get Records: Creates a query that you can use to explore your CMDB 360 data. It queries 
your CMDB 360 for CIs matching your criteria that are reported by specified discovery 
sources.

◦ Find Gap: Creates a query that you can use to analyze gaps in discovery sources reporting 
your CMDB 360 data. It queries discovery sources that report CIs against discovery sources 
that don't  report those same CIs.

◦ Compare Attribute Values: Creates a query that you can use to identify CIs with attribute 
values that differ across multiple discovery sources or against the CMDB. It queries at least 
two discovery sources and/or the CMDB for CIs that match your criteria.

• Schedule a CMDB 360 query for a report  to run that query on a regular basis. Scheduling a 
query enables you to create a CMDB 360 report that integrates the query results with the 
platform Reporting feature .

Discovery sources

Cards in the Discovery sources tile show aggregated counts for your discovery sources.  This tile 
also includes coverage cards showing a breakdown of CIs per the number of discovery sources 
reporting those CIs.

Number of discovery sources

The total number of discovery sources that report CMDB 360 data.

Total CMDB 360 records

The total number of raw CMDB 360 records in the CMDB 360 data store that 
contains records for each discovery source report, per each CI attribute.

Reconciled CIs

The total number of unique CIs created in the CMDB after processing incoming data 
from all discovery sources, including after reconciling data from multiple discovery 
sources for the same CIs. For more information, see CMDB Identification and 
Reconciliation.

Discovery source overview

The distribution of CMDB 360 CIs across all reporting discovery sources.

Coverage: CIs with a single discovery source

Shows CIs that are only reported by a single discovery source, with a breakdown by 
the discovery source reporting those CIs.

Coverage: CIs by number of discovery sources

Shows CIs reported by multiple discovery sources, grouped by the number of 
discovery sources that are reporting those CIs.

You can use the following options to filter the calculated records in the CMDB 360 data store that 
apply to all cards in the Discovery sources tile:

• All (default): Includes records from both CMDB and non-CMDB tables.

• CMDB CI: Includes records only from CMDB classes.

• Principal Class: Includes records only from principal classes. For information about defining a 
class as principal and therefore including that class in the Principal Class filter, see Create a CI 
class.

Various settings apply only to the coverage charts. They determine the scope and type of data 
that is included in the coverage charts and can greatly affect the performance of the associated 
calculation job:
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• The 'Coverage cards' dashboard settings determine the data that the cards show in list views.

• The system properties sn_cmdb_ws.ms.calculate_cmdb_only  and 
glide.identification_engine.multisource_non_cmdb_ci_enabled 
determine if both CMDB and non-CMDB or CMDB only data, is included in the coverage 
charts. For more information about these system properties, see Components related to CMDB 
360.

Note: 
If the sn_cmdb_ws.ms.calculate_cmdb_only  is true or 
glide.identification_engine.multisource_non_cmdb_ci_enabled 
is false, then both 'All' and 'CMDB CI' filters show CMDB data only (non-CMDB data is 
ignored).

• The sn_cmdb_ws.ms.report_class_ci_count_max_threshold  system property 
and the CMDB 360 Analytics Skipped Class [sn_cmdb_ws_ms_skip_class] table, together, 
determine class inclusion in the coverage charts.

If the record count for a class (CMDB or non-CMDB) in the CMDB 360 
Data [cmdb_multisource_data] table exceeds the value set by the 
sn_cmdb_ws.ms.report_class_ci_count_max_threshold  system property, then 
a record is created in the CMDB 360 Analytics Skipped Class [sn_cmdb_ws_ms_skip_class] 
table and by default, the class is skipped in future calculations for the coverage 
charts. You can include a skipped class in the coverage charts by setting the 
Override class CI records population  column of a skipped class in the 
sn_cmdb_ws_ms_skip_class  table, to 'true'.

Some classes, when included or excluded from the coverage charts, can greatly impact the 
overall performance of the chart calculations. For more information, see Components related 
to CMDB 360.

Coverage

Cards on the Coverage tile show a breakdown of CIs per the number of discovery sources 
reporting those CIs:

CIs with a single source

Shows CIs that are only reported by a single discovery source, with a breakdown by 
the discovery source reporting those CIs.

CIs by number of sources

Shows CIs reported by multiple discovery sources, grouped by the number of 
discovery sources that are reporting those CIs.

The following settings determine the scope and type of data that is included in the Coverage tile 
charts, these settings can greatly affect the performance of the Coverage tile calculation job:

• The 'Coverage cards' dashboard settings determine the data that the cards show in list views.

• The system properties sn_cmdb_ws.ms.calculate_cmdb_only  and 
glide.identification_engine.multisource_non_cmdb_ci_enabled 
determine if both CMDB and non-CMDB or CMDB only data, is included in the Coverage chart. 
For more information about these system properties, see Components related to CMDB 360.

• Filter options filter the calculated records in the CMDB 360 data store, that apply to the 
Coverage charts:
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◦ All (default): Includes all those records for both CMDB and non-CMDB tables.

◦ CMDB CI: Includes only those records for CMDB classes.

◦ Principal Class: Includes only those records for principal classes. For information about 
defining a class as principal and therefore including that class in the Principal Class filter, 
see Create a CI class.

Note: 
If the sn_cmdb_ws.ms.calculate_cmdb_only  is true or 
glide.identification_engine.multisource_non_cmdb_ci_enabled 
is false, then both 'All' and 'CMDB CI' Coverage chart filters show CMDB data only (non-
CMDB data is ignored).

• The sn_cmdb_ws.ms.report_class_ci_count_max_threshold  system property 
and the CMDB 360 Analytics Skipped Class [sn_cmdb_ws_ms_skip_class] table, together, 
determine class inclusion in the Coverage chart.

If the record count for a class (CMDB or non-CMDB) in the CMDB 360 
Data [cmdb_multisource_data] table exceeds the value set by the 
sn_cmdb_ws.ms.report_class_ci_count_max_threshold  system 
property, then a record is created in the CMDB 360 Analytics Skipped Class 
[sn_cmdb_ws_ms_skip_class] table and by default, the class is skipped in future calculations 
for the Coverage chart. You can include a skipped class in the Coverage chart by setting 
the Override class CI records population  column of a skipped class in the 
sn_cmdb_ws_ms_skip_class  table, to 'true'.

Some classes, when included or excluded from the Coverage chart, can greatly impact the 
overall performance of the chart calculations. For more information, see Components related 
to CMDB 360.

In addition to the settings listed above, internal filters and excluded classes in the CMDB 360 
denied classes [cmdb_multisource_deny_class] table  also affect the final inclusion or not 
inclusion of classes.  You can review the list of CI classes in the 'Coverage cards' settings to see 
any notes about inclusion status.

Configure the CMDB 360 dashboard

Configure settings on the CMDB 360 dashboard of the Configuration Management Database 
(CMDB)  Workspace to determine how your CMDB 360  data is analyzed and aggregated. These 
settings affect the data that appears on the cards and the records shown when you drill down on 
those cards on your CMDB 360 dashboard.

About this task
For detailed information about CMDB 360-related components, such as system properties, 
scheduled jobs, and tables, that are installed with CMDB Workspace, see Components installed 
with CMDB Workspace.

Before you begin
Role required: cmdb_ms_admin

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the CMDB Workspace  menu bar, select CMDB 360.

3. Select Settings.
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4. Configure Global settings.
The Maximum number of records to process  setting determines the maximum number of 
records that can show when you drill down on the cards in the CMDB 360 dashboard. If the 
total number of returned records is greater than the specified setting value, the dashboard 
trims the list view output according to this setting and the settings of individual cards.

You can use this setting to limit the number of records that CMDB 360 must process. The 
setting applies to these cards:

◦ CIs not reported by discovery sources

◦ Data mismatch

◦ CIs with a single discovery source

◦ CIs by number of discovery sources

The CMDB 360 dashboard defaults this value to 100,000.

5. Configure Potential issues settings.
These settings affect the calculations for cards on the CMDB 360 view/Potential Issues tile 
and the list of CIs that appear when you drill down on those cards.

a. Configure CIs not reported by discovery sources.
The Number of days since CIs were last discovered by a discovery source  setting 
determines the number of days used in the calculation of the CIs not reported by discovery 
sources card. The card shows CIs that are discoverable by multiple sources, but at least one 
discovery source hasn't reported on that CI in the specified number of days.

b. Configure Data mismatch.
These settings affect the calculation of the ‘Data mismatch’ card and the list of CIs that 
appear when you drill down the card. These settings determine which classes to use for the 
card and the relative weight of each of those classes in the calculations.

Setting Description

Automatic data weights Evenly distributes weights between the selected CI classes.

Manual data weights Specify a custom weight for each CI class.

Select CI classes you 
want to include in the 
calculation

Specify the CI classes that you want to check for attribute 
mismatches. CI classes you specify also include any child 
classes.

Attributes are considered mismatched when different 
discovery sources report different values for the attribute.

Show CIs where EVERY 
attribute doesn't match

Select to include only CIs with a mismatch between discovery 
sources for every attribute that you specify.

Show CIs where ANY 
attribute doesn't match

Select to only include CIs with a mismatch between discovery 
sources for any attribute you specify.

Select an attribute Specify the attributes that you want to check for mismatches.

6. Configure Coverage settings.
These settings affect the calculations for the coverage cards in the Coverage tilein the 
Discovery Sources tile  on the CMDB 360 view and the list of CIs that appear when you drill 
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down on these cards. These settings determine which classes to use for the coverage charts 
and the relative weight of each of those classes.

Setting Description

Automatic data weights Evenly distributes weights for the selected CI classes.

Manual data weights Specify a custom weight for each CI class.

Select CI classes you want to 
include in the calculation

Specify the CI classes that you want to include in the CIs with 
a single source and CIs by number of sources cards.

CI classes that you specify also include any child classes.

7. Select Save.

Create a CMDB 360  Get Records query

Create a Get Records query from the CMDB 360  dashboard of your Configuration Management 
Database (CMDB)  Workspace to help you explore your existing CMDB 360  data.

Before you begin
Role required: sn_cmdb_user and either cmdb_ms_admin or cmdb_ms_editor

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the CMDB Workspace  menu bar, select CMDB 360.

3. On the Saved Queries tile, click Create Query.

4. Click I want to get CMDB 360 data.

5. Select the CI classes to include in the query.
You can click a selected class to open the condition builder. Use the condition builder 
to specify conditions that must be met for each class. Use And  or Or  to specify multiple 
conditions.

Select All Classes  if you want to include all CI classes without conditions.

6. Click Continue.

7. Select discovery sources to query on.
The query retrieves CMDB 360  data that originates from the discovery sources you specify.

You can leave the Select discovery sources prompt empty to retrieve data for all discovery 
sources.

8. Click Continue.

9. On the form, select the options:

Results Layout form

Field Description

Show 
unique 
CMDB 

Select if you want to see only unique CMDB 360  records. Records for the same 
CIs from different discovery sources are consolidated.
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Field Description

360 
records

Show CI 
records by 
discovery 
source

Select if you want to see records for each CI and discovery source pair.

Limit 
results to

Limits the query results to CIs that belong to a service or CMDB group. When you 
select Application Services, Technical Services, or CMDB Groups, a prompt 
appears. You can use the prompt to specify the service or group that you want 
the query to filter for.

10. Click Continue.

11. Enter a name and description for your query.

12. Click Save .

What to do next
Run the query at least once if you want to create a schedule or report.

On the CMDB 360  Query Results page:

• If the number of results exceeds the number of results appearing on the page:

◦ Click Load More Results​: To show the next page of results. The 
number of results that appear on each result page is specified by the 
glide.identification_engine.multisource.query.batch.limit  system property (100 items by 
default).

◦ Click Load All Results: To show all results, up to the limit specified by the 
glide.identification_engine.multisource.query.max.limit  system property (10000 by default).

◦ Click a CMDB 360  Source link to easily access preview data of a source and see more 
details.

• You can click Create Schedule  to set up a schedule  that runs your query on a regular basis. 
Scheduling your query enables you to use the query results in reports you create.

• After creating a schedule, you can click Create Report  to configure a report  that you can 
manage using Reporting capabilities .

• On the Query Results page, access a record to view further details. For example, click a link in 
the Primary Record column, and then in the CI Details page, click View CMDB 360 Data.

Create a CMDB 360 Find Gap query

Create a Find Gap query from the CMDB 360 dashboard of your Configuration Management 
Database (CMDB)  Workspace to help you find CIs that are not being reported by a discovery 
source.

Before you begin
Role required: sn_cmdb_user and either cmdb_ms_admin or cmdb_ms_editor

About this task
Gaps in discovery source reporting occur when at least one discovery source reports on the CI 
and another doesn't, enabling you to identify discovery sources that might have an issue.
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Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the CMDB Workspace  menu bar, select CMDB 360.

3. Click Create Query.

4. Click I want to find gaps in data between discovery sources.

5. Select the CI classes that you want to check for gaps.

6. Click Continue.

7. Select non-reporting discovery sources.
A non-reporting discovery source is a discovery source that doesn't report CIs as expected. 
Multiple non-reporting discovery sources have an OR condition with each other.

8. Select one or two reporting discovery sources.
These discovery sources report the CI as expected and act as a baseline for identifying the 
gap in reporting.

You can leave the Select reporting discovery sources for gap tracking  prompt empty to 
include all discovery sources in the query.

9. Click Continue.

10. On the form, select the options:

Results Layout form

Field Description

Show 
unique 
CMDB 
360 
records

Select if you want to see only unique CMDB 360 records. Records for the same 
CIs from different discovery sources are consolidated.

Show CI 
records by 
discovery 
source

Select if you want to see records for each CI and discovery source pair.

Limit 
results to

Limits the query results to CIs that belong to a service or CMDB group. When 
you select Application Services, Technical Services, or CMDB Groups, a 
prompt appears where you can specify the service or CMDB group that you want 
the query to filter for.

11. Click Continue.

12. Enter a name and description for your query.

13. Click Save .

What to do next
Run the query at least once if you want to create a schedule.

On the CMDB 360 Query Results page:
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• If the number of results exceeds the number of results appearing on the page:

◦ Click Load More Results​: To show the next page of results. The 
number of results that appear on each result page is specified by the 
glide.identification_engine.multisource.query.batch.limit  system property (100 items by 
default).

◦ Click Load All Results: To show all results, up to the limit specified by the 
glide.identification_engine.multisource.query.max.limit  system property (10000 by default).

◦ Click a CMDB 360 Source link to easily access preview data of a source and see more 
details.

• You can click Create Schedule  to set up a schedule  that runs your query on a regular basis. 
Scheduling your query enables you to use the query results in reports you create.

• After creating a schedule, you can click Create Report  to configure a report  that you can 
manage using Reporting capabilities .

• On the Query Results page, access a record to view further details.

Create a CMDB 360  Compare Attribute Values query

Create a Compare Attribute Values query from the CMDB 360  dashboard of your Configuration 
Management Database (CMDB)  Workspace to help you find CIs with mismatched attribute 
values between discovery sources.

Before you begin
Role required: sn_cmdb_user and either cmdb_ms_admin or cmdb_ms_editor.

About this task
The query enables you to determine if there’s an issue with how a discovery source reports a CI.

The Compare Attribute Values query compares CIs from different discovery sources for 
mismatched values. Mismatches occur when a discovery source reports attribute values for a CI 
that are different from values reported by other discovery sources or the CMDB. You can use the 
query to identify these CIs and reconcile the attribute values, or fix any issues with the discovery 
sources.

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the CMDB Workspace  menu bar, select CMDB 360.

3. Click Create Query.

4. Click I want to compare attribute values between discovery sources or against the CMDB.

5. Select a CI class that you want to compare attribute values for.
You can click a selected class to open the condition builder. Use the condition builder 
to specify conditions that must be met for each class. Use And  or Or  to specify multiple 
conditions.

6. Click Continue.

7. On the form, select the options:

Attributes to compare form

Field Description

Any attribute 
doesn't match

Select if you want to retrieve CIs where there's a mismatch with any 
specified attribute values between the discovery sources.
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Field Description

Every attribute 
doesn't match

Select if you want to retrieve CIs where there's a mismatch with every 
specified attribute value between the discovery sources.

Select attributes 
to compare

Specify the attributes that you want to compare for mismatched values.

8. Click Continue.

9. Select your discovery sources that you want to compare attribute values for.

Discovery sources form

Field Description

Compare 
to CMDB

Select if you want to compare the specified attribute values against your CI 
attributes recorded in the CMDB. When you compare against the CMDB, you only 
need one discovery source.

Select 
discovery 
sources

The discovery sources that you want to compare. Select at least two.

Limit 
results to

Limits the query results to CIs that belong to a service or CMDB  group. When you 
select Application Services, Technical Services, or CMDB Groups, a prompt 
appears. You can use the prompt to specify the service or group that you want the 
query to filter for.

10. Click Continue.

11. Enter a name and description for your query.

12. Click Save .

What to do next
Run the query at least once if you want to create a schedule.

On the CMDB 360  Query Results page:

• If the number of results exceeds the number of results appearing on the page:

◦ Click Load More Results​: To show the next page of results. The 
number of results that appear on each result page is specified by the 
glide.identification_engine.multisource.query.batch.limit  system property (100 items by 
default).

◦ Click Load All Results: To show all results, up to the limit specified by the 
glide.identification_engine.multisource.query.max.limit  system property (10000 by default).

◦ Click a CMDB 360  Source link to easily access preview data of a source and see more 
details.

• You can click Create Schedule  to set up a schedule  that runs your query on a regular basis. 
Scheduling your query enables you to use the query results in reports you create.

• After creating a schedule, you can click Create Report  to configure a report  that you can 
manage using Reporting capabilities .

• On the Query Results page, access a record to view further details.
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Schedule a CMDB 360  query for a report

Set up a schedule to regularly query for CMDB 360  data. Use scheduled queries to provide 
CMDB 360  data to reports you create, which can provide insight into how discovery sources 
populate the Configuration Management Database (CMDB)  and the reliability of those discovery 
sources.

Before you begin
Ensure that you run the CMDB 360  query at least once.

Role required: sn_cmdb_user and either cmdb_ms_admin or cmdb_ms_editor.

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the CMDB Workspace  menu bar, select CMDB 360.

3. On the Saved queries tile, create or access a CMDB 360  query.
If you created a new query, you must run the query at least once before you can click Create 
Schedule  on the query results page.

4. Select Schedule query  on the Results Layout page of the query.
To create a schedule for the Compare attributes values query, select Schedule query  on the 
Discovery Sources page.

5. Specify a Run  frequency and time you want to schedule the query to run.
When you select Weekly or Monthly, you must also select a day of the week or calendar day, 
respectively.

6. Click Save.

What to do next
Create a CMDB 360 report  to integrate CMDB 360  query results with platform Reporting 
capabilities . Each run of the query automatically updates the generated report.

Related topics

Create a CMDB 360 Get Records query

Create a CMDB 360 Find Gap query

Create a CMDB 360 Compare Attribute Values query

Exclude classes from CMDB 360

Prevent CMDB 360 from collecting, storing, and analyzing data for classes for which it isn't 
needed. CMDB 360 processes large amounts of data. Therefore, excluding classes can help 
improve the performance of the Multisource Dashboard Analytics Population scheduled job and 
of CMDB 360 queries.

Before you begin
Role required: cmdb_ms_admin (automatically included in the CMDB Admin role)

About this task
To exclude classes from CMDB 360, you must directly manage records in the CMDB 360 denied 
classes [cmdb_multisource_deny_class] table. For each class that you want to exclude, add an 
active record for that class. Excluding a class from CMDB 360 also automatically excludes any of 
its descending classes. In the base system, the CMDB 360 denied classes table is populated by 
default with some classes, such as dscy_net_base and discovery_net_base.
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Procedure

1. Select All  and then, in the Filter navigator, enter 
cmdb_multisource_deny_class.list  to open the CMDB 360 denied classes table.

2. Select New  and then fill out the form.

◦ Select the class to exclude (with its descendents) in the field labeled Deny this class and all 
extended classes from this class to store CMDB 360 data.

◦ Ensure that Active  is selected. If Active  isn't selected, then the specified class isn't excluded 
from CMDB 360.

◦ Select Submit.

Result
Existing data for the specified class and its descending classes will be gradually removed from 
the CMDB 360 Data [cmdb_multisource_data] table using record cleaners, without any impact to 
the system.

What to do next
You can deselect Active  or completely delete a record for a class that you want to include in 
CMDB 360 data collection.

Recompute CI attribute values

Modify reconciliation rules, or exclude a discovery source which is found to be invalid. Then, use 
the updated reconciliation rules in recomputing CI attribute values, for which those reconciliation 
rules or discovery source are applicable to.

Before you begin
Enable and configure CMDB 360.

If you want to recompute to apply updated reconciliation rules, then you must first update the 
reconciliation rules.

Role required: itil_admin or sn_cmdb_admin

About this task
CMDB 360 automatically generates a recompute task for each recompute that you 
submit. If you submit multiple recomputes, a recompute task is generated for each 
operation, but only one task runs at any given time. To list all recompute tasks, enter 
cmdb_multisource_recomp_task.list  in the left navigation search box.

There is a maximum number of records that can be included in a single 
recompute operation. This number is specified by the system property 
glide.identification_engine.multisource.recompute.max.ci.limit  (100,000 by default).

Note: 

• Recompute skips CIs which are reported by multiple discovery sources, but with different 
class names.

• Recomputing CI attribute values is not supported with non-CMDB tables.

Procedure

1. Navigate to All  > Configuration  > CI Class Manager.

2. Select a class from the CI Classes hierarchy list.

3. In the left-side pane, expand Class Info, and select Reconciliation Rules.
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4. On the Reconciliation Rules page, click Recompute.

5. Select the Recompute Type.

◦ Replace values from the specified discovery source with value from the discovery source 
next in priority, according to reconciliation rules: Recompute attribute values for the class 
CIs, applying priorities specified in reconciliation rules and while excluding the specified 
Discovery Source. Records for the discovery source you are excluding, are also removed 
from the CMDB 360 data store.

This operation applies to data that exists in the CMDB. If reconciliation rules remain in effect 
for the discovery source that you have excluded, then future data from that discovery source, 
can populate the CMDB.

◦ Apply updated reconciliation rules: Recompute attribute values for the class CIs, applying 
the updated reconciliation rules which are now in effect.

6. Select the Recompute Scope.
The scopes grow from one option to the next:

◦ Recompute only CIs of this class: Basic scope of CIs to recompute.

◦ Recompute CIs of this and derived classes: Expand the basic scope to include CIs from 
derived classes.

◦ Recompute CIs of this and derived classes, along with selected related items: Expand the 
previous scope to also include CIs from specified related items. Select the related items to 
include in the recompute.

7. Select the Delete action  for CIs for which the excluded discovery source, is the only discovery 
source.

◦ Delete record: Delete the CI record from CMDB.

◦ Set record attributes to custom value: Set a specified CI attribute to a custom value 
to remove the CI from regular operations without deleting the CI. For example, set the 
Operational status  attribute to Retired.

8. Select Next.

9. On the Review page, carefully review the counts for the affected CIs to ensure that all record 
counts are as you expect.

10. Select Back  to adjust any settings for the recompute.

11. Select Recompute.

What to do next
You can do any of the followings:

• In the status message that appears for the recompute operation, click the link to see the CMDB 
360 Recompute Task for more details. The Recompute Task shows the progress and status of 
the recompute operation.

You can abort the recompute by setting Status  to Closed Incomplete  and selecting Update. 
You can then set Status  back to Work in progress  to resume recompute from where it was 
aborted.

• Enter cmdb_multisource_recomp_task.list  in the left navigation search box, to see 
the status and progress of all recompute tasks.
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Multisource Report Builder (legacy)

Improve CMDB data management by querying and reporting on Multisource CMDB data. Use 
the Multisource Report Builder to gain insights about how discovery sources are populating 
the CMDB and their reliability. You can then adjust reconciliation rules to improve the quality of 
CMDB data, if needed.

CMDB 360 in CMDB Workspace

Starting with the Washington DC  release, the Multisource CMDB feature is part of the CMDB 
360 feature which is accessible in the CMDB Workspace. Create, view, modify, schedule, create 
reports, and run CMDB 360 queries using the CMDB 360 query builder  in the CMDB Workspace 
store app. Use the CMDB 360 query builder to create queries of the following types:

• Get Records: Queries your discovery sources for CIs that match your criteria.

• Find Gap: Queries for gaps in discovery sources reporting your CMDB 360 data. Queries 
discovery sources that report CIs against discovery sources that don't  report those same CIs.

• Compare Attribute Values: Queries for CIs with attribute values that differ across multiple 
discovery sources or against the CMDB. Queries at least two discovery sources and/or the 
CMDB for CIs that match your criteria.

Legacy Multisource Report Builder

Instead of using the CMDB 360 query builder in CMDB Workspace, you can still use the legacy 
Multisource Report Builder as described in this topic.

After you create a Multisource query in the Multisource Report Builder, you can run the 
query to see the results. You can then also create a Multisource report  that integrates the 
Multisource query results with the platform Reporting  capabilities. High level steps for creating 
a Multisource report:

1. Create a query, then save and run it.

2. Create a schedule for the query.

3. Create a Multisource report that is based on the Multisource query.

You can create queries that find:

• All the discovery sources populating data in your CMDB.

• CIs not reported by any discovery source.

• All CIs discovered by one discovery source, but not by another discovery source.

You can create other queries that show differences in CI attribute values between multiple data 
sources, while being compared to the CMDB:

• Show how an attribute value is different between a discovery source and the current CMDB 
record. For example, find Hardware CIs with different location than what SCCM reports.

• Show how an attribute is different between SourceA, SourceB, and SourceC. For example, 
show all Computer CIs where RAM is different between SCCM, ServiceWatch, and CMDB.

You can show query results by CI records, Multisource CMDB data records, or discovery sources. 
You can also limit the report results to CIs within a specific application service, technical service, 
or a CMDB group.
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Create a Multisource query in the legacy Multisource Report Builder

Query the Multisource CMDB data to gain insights about how discovery sources are populating 
the CMDB, and then use that query to create a Multisource data report.

Before you begin
Enable and configure CMDB 360.

Role required: cmdb_ms_editor

About this task
The Multisource Report Builder page updates dynamically as you set fields. Therefore, some of 
the fields that are described in the steps below might not appear.

Procedure

1. Navigate to All  > Configuration  > Multisource Report Builder​.

2. On the Multisource Report Builder page, select a query to edit or run, or click New.

3. Enter Name  and Description  for the query.

4. Select the Result type  for the query.

◦ CI records: Results show unique CIs from the Multisource CMDB data store.

◦ Multisource data records: Results show all entries of CI/discovery source combinations 
from Multisource CMDB data.

◦ Discovery sources​: Results are grouped by discovery sources that match the query criteria.

5. Select Only show difference  to show differences in CI attribute values and then select the 
Type of difference.

◦ Between CMDB record and discovery source: Show differences in attribute values between 
the CMDB data and the specified discovery sources.

◦ Between discovery sources: Show differences in attribute values between specified 
discovery sources based on Multisource data.

6. Select the Class  to apply the query to, or select All Classes  to apply the query to all classes.
Use the condition builder to specify conditions that must be met for the class. Use And  or Or  to 
specify multiple conditions.

7. Use the slushbucket to select one or more Discovery source  items to query on.

8. Set Field to compare  to the class attributes for which to show differences.
Use the OR and AND operators to compare based on multiple attributes.

The list of attributes is a pre-populated subset of the class attributes, to which you cannot add 
or remove items.

9. Set Limit results to  to limit the query results to CIs that belong to a specific application service, 
technical service, or a CMDB group.

10. Click Save  and then click Run.

What to do next

• On the CMDB Multisource Query Results page:

◦ If the number of results exceeds the number of results appearing on the page:

▪ Click Load More Results​: To show the next page of results. The 
number of results that appear on each result page is specified by the 
glide.identification_engine.multisource.query.batch.limit  system property (100 items by 
default).
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▪ Click Load All Results: To show all results, up to the limit specified by the 
glide.identification_engine.multisource.query.max.limit  system property (10000 by default).

▪ Click a Multisource CMDB value link or a CI value link to access the respective records 
and see more details.

◦ In the Configuration Item column, click a CI link to open the CI form. In the Related Links 
section on the CI form, click the Multisource Data  tab to show Multsource data, such as 
discovery sources, related to the CI.

• Create a schedule for the query and ensure that the schedule runs at least once. This step is 
required for creating a Multisource report.

Note: 
Initially, after creating a query, both the Create Schedule  and the Create Report  buttons 
are grayed out. Only after saving the query, you can create and run a schedule for the 
query, and only then you can create a report that is based on the query.

Schedule a Multisource query

After saving and running a Multisource query, create a schedule for the query to run 
automatically on a set schedule. Query results are stored in a results table and you can configure 
email addresses for the results to be sent to or include the results in CMDB dashboards.

Before you begin
The query for the schedule must be already saved and run at least one time.

Role required: cmdb_ms_user

Procedure

1. Navigate to All  > Configuration  > Multisource Report Builder​.

2. On the Multisource Report Builder page, select the query that you want to create a schedule 
for.

3. On the Multisource Report form, click Create Schedule.

4. On the Scheduled Email of Multisource Report Builders, click New.

5. Fill in the Scheduled Email of Multisource Report Builders form.

Field Description

Query Saved query that was created in Multisource 
Report Builder.

Users Users to email the query results to.

Groups User groups to email the query results to.

Run

Time

Frequency and time to run the query 
automatically.

When you set Run  to On Demand, the query 
runs only when you run it manually.

Email addresses More ad-hoc email addresses to email the 
query results to.
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Field Description

Subject Text that will appear as the subject of the 
email with the query results.

Introductory message Text that is included in the body of the email 
with the query results.

Type Type of the file with the query results, which 
will be attached to the email.

Zip output Enables zipping of the results file.

Conditional Enable a condition for running the query and 
specify the condition in the Condition  field. 
If the specified condition isn't met, the query 
doesn't run.

Condition
Condition that must be met for the query to 
run (Java script).

Appears only if Conditional  is selected.

Omit if no records Disable sending an email for a query run that 
returns no results.

Note: 
When using update sets  to port Multisource schedules from a non-production to a 
production environment, check the Users  and Groups  settings in the schedule. Any user 
or group that doesn't exist in the production environment, and which needs to receive the 
query results, must be re-added in either of the following ways:

◦ Manually created in the production environment. In this case, you must also remove 
the invalid user or group in the production environment (ported from non-production 
environment) from any schedules and add the new user or group instead.

◦ Explicitly ported from the non-production to production environment.

6. Click Submit.

What to do next

• If Run  is set to On Demand  in a schedule, or if you need to run a query randomly even if it has a 
recurring schedule, you can manually run that query as follows:

1. Navigate to All  > Configuration  > Multisource Report Schedules.

2. In the Scheduled Email of Multisource Report Builders list view, select the query that you 
want to run.

3. On the Scheduled Email of Multisource Report Builder form, click Execute Now.

• Create a Multisource report for the query, that integrates the Multisource query results with the 
platform Reporting  feature.

Create a report based on a Multisource (CMDB 360) query

After creating, saving, running, and scheduling a Multisource (CMDB 360) query, you can create 
a Multisource (CMDB 360) report that integrates the query results with the platform Reporting 
feature. You can for example, include such Multisource (CMDB 360) report in the platform CMDB 
dashboards.
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Before you begin
The Multisource (CMDB 360) query for the report must be already saved, have a schedule, and 
must have already run at least once.

Role required: cmdb_ms_user

About this task
Creating a report that is based on a Multisource (CMDB 360) query, creates a report source 
which you can then manage using Reporting  capabilities.

Note: 
If you are using the CMDB 360 view in CMDB Workspace  to generate the CMDB 360 query 
and the report, you can skip to step 4 in the procedure below.

Procedure

1. Navigate to All  > Configuration  > Multisource Report Builder​.

2. In the Multisource Report Builder list view, select the query that you want to create a schedule 
for.

3. On the Multisource Report form, click Create Report.

4. On the Create a report form, click Save  or Run.

Trouble? 
A report shows the results for the most recent query run. If meanwhile the query has changed, 
then the report shows results that are out of synchronization with the query. When you update 
the query, ensure to immediately run the updated query so that the report is synchronized with 
the query.

What to do next
To add a Multisource (CMDB 360) report to the CMDB Correctness Dashboard for example, see 
Add a report to a dashboard .

Sample Multisource CMDB queries

Use sample queries to create your own Multisource CMDB queries.

Discrepancy in multiple attributes between multiple discovery sources

Field Setting

Name Discrepancy in multiple attributes between 
multiple discovery sources (discovery source 
vs. discovery source)

Description Find Linux servers with name containing 
“backup” which have discrepancy in Disk 
Capacity  OR CPU Count  OR Serial 
Number  between discovery sources 
ServiceNow/ServiceWatch/SCCM/Tivoli.

Result type Multisource data records

Only show difference Selected

Type of difference Between discovery sources

Class Linux Server [cmdb_ci_linux_server]
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Discrepancy in multiple attributes between multiple discovery sources  (continued)

Field Setting

Conditions [Name] [contains] [backup]

Discovery Source ServiceNow/ServiceWatch/SCCM/Tivoli

Field to compare Disk Capacity  OR CPU Count  OR 
Serial Number

Limit results to All

Discrepancy in multiple attributes between CMDB record and discovery sources

Field Setting

Name Discrepancy in multiple attributes between 
multiple discovery sources (CMDB vs. 
discovery sources)

Description Find Linux Servers with name containing 
“backup” which have discrepancy in Disk 
Capacity  AND CPU Count  AND Fully 
Qualified Domain Name  for discovery 
sources ServiceNow/ServiceWatch/SCCM

Result type Multisource data records

Only show difference Selected

Type of difference Between CMDB record and discovery source

Class Linux Server [cmdb_ci_linux_server]

Conditions [Name] [contains] [backup]

Discovery Source ServiceNow/ServiceWatch/SCCM

Field to compare Disk Capacity  AND CPU Count  AND 
Fully Qualified Domain Name

Limit results to All

Servers discovered by ServiceNow  but not by Tivoli

Field Setting

Name Missing Discovery by Tivoli

Description Servers discovered by ServiceNow  but not by 
Tivoli

Result type CI records

Class Server [cmdb_ci_server]

Discovery Source
[is] [ServiceNow]

[is not] [Tivoli]

Limit results to All
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All discovery sources for backup servers

Field Setting

Name Discovery Sources Backup Servers

Description All discovery sources for backup servers

Result type Data sources

Class
Server [cmdb_ci_server]

and class condition:

[Host name][starts with][backup]

Limit results to All

All Multisource CMDB records where the reported value of Location is different between 
Altiris and Tivoli discovery sources

Field Setting

Name Compare Location-Altiris vs. Tivoli

Description List all Multisource CMDB records where the 
reported value of Location is different between 
Altiris and Tivoli discovery sources

Result type Multisource data records

Only show difference Selected

Type of difference Between discovery sources

Discovery Source • Altiris

• Tivoli

Field to compare Location

Limit results to All

All Multisource CMDB records for Linux Server, where the Location value is different than 
the reported value by Tivoli

Field Setting

Name Linux Server Location - Diff than Tivoli value

Description All Multisource CMDB records for Linux Server, 
where the Location value is different than the 
value reported by Tivoli.

Result type Multisource data records

Class Linux Server

Only show difference Selected

Type of difference Between CMDB record and discovery source
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All Multisource CMDB records for Linux Server, where the Location value is different than 
the reported value by Tivoli  (continued)

Field Setting

Discovery Source [is][Tivoli]

Field to compare Location

Limit results to All

Components related to CMDB 360

Several types of components are related to CMDB 360 (included in the com.snc.cmdb plugin), 
such as tables and properties.

Properties

Open the CMDB 360 Properties page by navigating to All  > Configuration  > CMDB 360 
Properties. You can hover over the '?' icon for a property, to show property names.

You must have the cmdb_ms_admin role to modify property values.

Property Description

glide.identification_engine.multisource_enabled
Enables CMDB 360.

• Type: true | false

• Default value: false

• Location: CMDB 360 Properties 
page

glide.identification_engine.multisource_cmdb_ci_enabled​
Enables capturing CMDB 360 
data for CIs from CMDB classes 
(derived from the cmdb_ci class).

• Type: true | false

• Default value: true

• Location: CMDB 360 Properties 
page

glide.identification_engine.multisource_non_cmdb_ci_enabled
Enables capturing CMDB 360 data 
for CIs from non-CMDB classes 
(not derived from the cmdb_ci 
class). For example, the Serial 
Number [cmdb_serial_number] 
class, or the Software instance 
[cmdb_software_instance] class.
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Property Description

• Type: true | false

• Default value: false

• Location: CMDB 360 Properties 
page

glide.identification_engine.multisource.query.batch.limit​
Max number of items to show per 
query results page, in the CMDB 
360 Report Builder. Changing 
the value of this property, might 
affect performance when running 
a query.

• Type: numeric

• Default value: 100

• Location: CMDB 360 Properties 
page

glide.identification_engine.multisource.query.max.limit​
Max number of query results to 
show when you click Load All 
Results  in the CMDB 360 Report 
Builder. Changing the value of this 
property, might affect performance 
when running a query.

• Type: numeric

• Default value: 10000

• Location: CMDB 360 Properties 
page

glide.identification_engine.multisource.recompute.max.ci.limit
Max number of CIs that can 
be included in a CMDB 360 
recompute operation.

• Type: numeric

• Default value: 100000

• Location: CMDB 360 Properties 
page

glide.cmdb.logger.source.cmdb_multisource​
Enable logging for CMDB 360. 
CMDB 360 logs are stored in the 
Log [syslog] table with source 
set to "cmdb_multisource".
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Property Description

• Type: string

• Values: info, warn, error, debug, 
or debugVerbose

• Location: Add to System 
Properties [sys_properties]
table.

sn_cmdb_ws.ms.calculate_cmdb_only
Limits the scope of data in the 
Coverage tile in the CMDB 360 
dashboard in CMDB Workspace, 
to CMDB classes only (derived 
from the cmdb_ci class).

• Type: true | false

• Default value: true

• Values:

◦ True: Include data only from 
CMDB classes.

◦ False: Include data from 
CMDB and non-CMDB tables.

• Location: Add to System 
Properties [sys_properties]

sn_cmdb_ws.ms.report_class_ci_count_max_threshold
Threshold number of multisource 
records that when exceeded for 
a class, CMDB 360 Coverage 
charts in CMDB Workspace stop 
populating data for that class 
(CMDB or non-CMDB tables).

When the specified threshold 
number is reached for a 
class, the system creates 
a record in the CMDB 360 
Analytics Skipped Class 
[sn_cmdb_ws_ms_skip_class] 
table causing that class to be 
skipped in future job runs.

Note: 
Managing class inclusion 
in the Coverage charts, 
by using this system 
property and the CMDB 360 
Analytics Skipped Class 
[sn_cmdb_ws_ms_skip_class] 
table, can greatly decrease 
or increase performance of 
the Coverage chart job.
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Property Description

• Type: numeric

• Default value: 10 million

• Location: Add to System 
Properties [sys_properties]

• Learn more: CMDB 360 
experience in CMDB Workspace

Tables

Table Description

CMDB 360 Data

[cmdb_multisource_data]

CMDB 360 data store. Contains the raw data sent by all discovery sources.

CMDB MultiSource Column Metadata

[cmdb_multisource_column_metadata]

Mapping of attributes for each class to floatable columns. Used to improves 
performance of queries that involve high volumes of data.

CMDB Multisource Queries

[cmdb_multisource_query]

CMDB 360 query definitions created by the user in CMDB Workspace  or in 
the legacy Multisource Report Builder.

Query Status

[cmdb_multisource_query_status]

State of execution, of queries created in CMDB Workspace  or in the legacy 
Multisource Report Builder.

CMDB Multisource Query Results

[cmdb_multisource_query_result] 

Results for queries created in CMDB Workspace  or in the legacy Multisource 
Report Builder, configured with result type of CI records.​

CMDB Multisource Query Result Multisource 
Records

[cmdb_multisource_query_result_ms_record]

Results for queries created in CMDB Workspace  or in the legacy Multisource 
Report Builder, configured with result type of CMDB 360 records.

CMDB Multisource Query Result Discovery 
Sources

[cmdb_multisource_query_result_disco_source]​

Results for queries created in CMDB Workspace  or in the legacy Multisource 
Report Builder, configured with result type of Discovery source records.

CMDB MultiSource Recompute Task CIs

[cmdb_multisource_recomp_task_ci]

All Cis that are involved in a recompute operation.​

CMDB Multisource Recompute Tasks

[cmdb_multisource_recomp_task]

Recomputation requests and progress status.

CMDB 360 denied classes

[cmdb_multisource_deny_class]

Classes that are excluded from CMDB 360 data collection and processing. 
For any class with an active record, there won't be any data in the CMDB 360 
Data [cmdb_multisource_data] table.
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Table Description

CMDB 360 Analytics Skipped Class

[sn_cmdb_ws_ms_skip_class]
Internally used to store records of classes for which the 
threshold number of multisource records, as set in the 
sn_cmdb_ws.ms.report_class_ci_count_max_threshold 
property, has exceeded. Classes in this table are excluded from the Coverage 
charts in CMDB Workspace.

You can set the Override class CI records population 
column for an excluded class to 'true', to include it in Coverage charts future 
computations.

Note: 
Managing class inclusion in the Coverage 
charts, by using this table and the 
sn_cmdb_ws.ms.report_class_ci_count_max_threshold 
system property, can greatly decrease or increase performance of the 
Coverage chart job.

Roles

Role Description

cmdb_ms_read Can access and run a CMDB 360 query but 
can't create a query. Contains cmdb_read role.

cmdb_ms_editor Can create and run a query, has full read 
and write access, but can't do Recompute. 
Contains cmdb_ms_read role.

cmdb_ms_admin Can create and run a query, and can 
modify CMDB 360 properties. Contains 
cmdb_ms_write role.

CMDB data management

The integrity and health of the CMDB is essential for the various features that depend on the 
data in the CMDB. As the CMDB grows and infrastructures change, the CMDB can accumulate 
stale, duplicate, or outdated CIs and therefore no longer accurately reflect the IT infrastructure 
and applications in the organization.

The CMDB Data Manager is an essential tool where you can create, publish, and manage 
policies that reflect organizational needs for data management. The CMDB Data Manager 
is a comprehensive and integrated solution, which scales to large CMDBs. It supports bulk 
management of CI life cycle operations such as deletion, archival, and attestation. Use the CMDB 
Data Manager to automate and govern CI life cycle operations to help maintain the CMDB in a 
healthy and efficient operational state.

Managing duplicate CIs is also an important data management task that helps maintain the 
health of the CMDB.

Working with CMDB Data Manager

CMDB Data Manager is a policy-driven framework for bulk management of CI life cycle 
operations such as deletion, archival, and attestation. The CMDB Data Manager is a 
comprehensive and integrated solution, which scales to large CMDBs and copes with rapid 
changes in a cloud-based world.
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Large CMDBs can over time accumulate large amounts of stale CIs that can impact overall 
performance. Custom mitigating solutions can be difficult to develop and to maintain, and are 
also prone to errors. The CMDB Data Manager is the tool where you can create, publish, and 
manage policies. Create policies to automate and govern CI life cycle operations to help maintain 
the CMDB in a healthy and efficient operational state.

Use the CMDB Data Manager to create policies that represent your organizational processes for 
managing the life cycle of CIs such as:

• Retire all computers without owners, which were created more than a year ago ('Retire' policy 
type).

• Archive all Linux servers in the Seattle datacenter which haven't been updated for six months 
('Archive' policy type).

• Delete all containers, which haven't been discovered in the past week ('Delete' policy type).

• Attest all the CIs in a specified location (Attestation policy type).

• Approve cascade-delete, archive, or retire life cycle tasks generated by dependent CI 
management.

• Delete orphan, stale, or irrelevant records in non-CMDB related tables. The non-CMDB Related 
tables in the Related Entry [cmdb_related_entry] table have references to CMDB tables. A CI 
in a related table can, for example, become orphan if the referenced CI in the CMDB is deleted 
('Delete CMDB Related Entry' policy type).

• Certify that attributes have a specific value required for the business.

You can apply CMDB Data Manager policies only to classes that extend the Configuration Item 
[cmdb_ci] table.

CMDB Data Manager experience in CMDB Workspace

You can use the CMDB Workspace  landing page and its views to fully administer CMDB Data 
Manager, access high-level analytic and counts for its policies and tasks, and review your tasks. 
For information about using the CMDB Data Manager in CMDB Workspace, see CMDB Data 
Manager experience in CMDB Workspace.

CMDB Data Manager on Core UI (UI 16)

Starting with the Washington DC  release, CMDB Data Manager on Core UI (UI 16) is being 
prepared for future deprecation. It will be hidden and no longer activated on new instances 
but will continue to be supported. CMDB Workspace provides the latest experience for this 
functionality.

CMDB Data Manager built on Core UI (UI 16) is available by navigating to All  > Configuration 
> CMDB Data Manager. For information about using the CMDB Data Manager legacy build on 
Core UI, see CMDB Data Manager on Core UI (UI 16).

Terms

Policy

A CMDB Data Manager policy captures the overall management plan for a life-
cycle event, such as CI retirement. A policy is associated with a subflow (the policy 
subflow) which creates the tasks (the policy tasks) for the target CIs of the policy. 
A policy is configured with a policy type and the policy tasks perform operations 
associated with that policy type, such as archiving or deleting a CI record. Also, you 
can configure a policy to require an approval.
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The policy type, policy subflow, and the policy tasks, are all aligned to a specific 
life cycle event of CIs. For example, a policy set with the delete policy type, is 
associated with the delete subflow, and its policy tasks handle the deletion of CIs.

A daily scheduled job processes all published CMDB Data Manager policies.

Policy subflow

The policy subflow  contains the underlying logic to process a life cycle event such 
as retire or delete. If the policy is configured to require approval, then the policy 
subflow runs only after a policy task is approved.

The base system provides several common subflows, such as delete, archive, and 
retire, which you can use with policies. You can also create custom subflows that are 
needed in the organization.

Policy task

A separate task is created and assigned to each unique Managed By Group 
value within the set of target CIs in a policy. A policy task triggers the policy subflow, 
tracks the set of target CIs for the task, and handles the approval of the task, if 
necessary.

If a policy requires an approval, the policy tasks don’t trigger the policy subflow until 
a member of the group assignment in the Managed by Group  attribute of the 
target CIs, approves the tasks. If a task is rejected or if the Managed by Group 
attribute is empty, the task is assigned to an administrator who must manually 
intervene to resolve the task.

If a policy isn't configured to require an approval, then the policy tasks are 
automatically approved.

CI exclusion list

A set of CIs to which policies of a specified type don't apply.

Policy types

You can create policies of the following types:

Delete

Use to remove a CI from its current table with no option to restore the CI into an 
active state.

Retire

Use to retire a CI while keeping the CI active in list views and in processes such as 
CMDB Health.

Attestation

Use to assign and process attestation tasks that verify the existence of actual IT 
infrastructure and applications that you own. As CIs are continuously ingested 
into the CMDB from various data sources, attesting CIs support the integrity of 
the CMDB. For more information about using the Attestation policy type, see CIs 
attestation.

Archive

Use to remove a CI from its current table and store the CI in a separate archive 
table for temporary retention. Archiving a CI excludes the CI from views and from 
features such as maps and the relations formatter. During the retention period, you 
can restore CIs into active state . At the end of the retention period, archived CIs 
are deleted from their archive table.
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Delete CMDB Related Entry

Use to clean up any irrelevant or stale data from related tables to help keep CMDB 
data healthy and relevant as the state of referenced CIs change.

Related tables, such as the Serial Number [cmdb_serial_number] table, aren't 
part of the CMDB hierarchy but still qualify as CMDB data. Related tables don't 
inherent from the Configuration Item [cmdb_ci] table, but have at least one column 
that references a CMDB CI. Related tables are specified in the Related Entries 
[cmdb_related_entry] table.

Certification

Use to certify that specific attributes are of a specific value.

You can implement your Retire, Delete, and Archive policies so that they follow Common Service 
Data Model (CSDM)  standards where for example, CIs are archived and deleted only when 
a CI is already in retired state. When you create these life cycle policies, the system applies 
processes to manage any dependent CIs that might be left behind. For more details about these 
processes and about verifying that the feature is enabled, see Dependent CIs management.

ServiceNow AI Platform®  data archiving

The functionality that the Archive policy type in CMDB Data Manager provides, relies and 
extends the ServiceNow AI Platform®  data archiving feature , applied specifically for CMDB 
CIs. While processing an Archive policy to archive CMDB CIs, CMDB Data Manager uses 
components and processes of ServiceNow AI Platform®  data archiving in the following ways:

• The Archive Rule [sys_archive] table contains the ServiceNow AI Platform®  archive rules 
including the Archive Configuration Items  CMDB archive rule which CMDB Data 
Manager Archive policies use.

• Data Manager relies on the Archive  scheduled job to run (every hour by default) and 
process CMDB Data Manager archive policies. The Archive  scheduled job is stored in the 
Schedule Item [sys_trigger] table.

• In the ServiceNow AI Platform®  table Archive Job Execution Chunks [sys_archive_run_chunk], 
the Keys  attribute contains the sys_ids of the CMDB CIs to be archived (where Rule ID is the 
CMDB archive rule ID).

• Archived records are stored in the ServiceNow AI Platform®  archive tables, which are prefixed 
by 'ar_'. In a similar way, the first time that a CMDB archive job runs, it creates an archive table 
for each CMDB class (prefixed by 'ar_cmdb'). Therefore, that initial CMDB archive task takes 
longer than subsequent CMDB archive tasks.

For each Data Manager archive policy, the system batches the policy CIs to be archived into 
batches of 1000 CIs. The sys_archive_run_chunk table contains a record per each of those 
batches.

CMDB archive tables, such as ar_cmdb_ci_computer, are listed under All  > System Archiving  > 
Archive Tables.

When using the CMDB Data Manager to archive CIs, you can also directly apply ServiceNow AI 
Platform®  data archiving features, such as restoring archived records  during a CIs retention 
period.

Life cycle state rules and retirement definitions

Life-cycle state rules define the retirement state for classes in your organization and support the 
transition of CIs through life cycle stages when using the CMDB Data Manager. After retiring CIs, 
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CMDB Data Manager configures the retired CIs according to the retirement definitions specified 
by life-cycle rules for the CIs class. Using a Retire, Archive, or Delete CMDB Data Manager 
policies requires that an active life-cycle rule exist for each targeted class in the policy. You can 
activate life-cycle rules in the base system to apply the default definitions, customize those rules, 
or add life-cycle rules for classes needed in your organization.

The life cycle state of a CI affects the CIs visibility and inclusion in ongoing CMDB processes:

• A retired CI isn't excluded from any views or processes such as CMDB Health.

• An archived CI no longer exists in its active table and instead it's stored in a separate archive 
table. Archived CIs are no longer visible or included in processes such as list views, maps, and 
relations formatters. Archived CIs can be retained for a specified retention period before being 
deleted from the archive table. During that retention period, archived CIs can be manually 
restored into an active state by using the ServiceNow AI Platform®  feature to restore archived 
records .

• A deleted CI no longer exists in the table that it belonged to and there's no way to restore it into 
an active state. Deleting a CI is an irreversible operation.

For more information about accessing and managing life-cycle rules, see Life-cycle rules and 
retirement definitions.

Configure the environment for CMDB Data Manager

Prepare your environment for using the CMDB Data Manager:

1. Some policy types such as the life cycle policies Retire, Archive, and Delete, require that an 
active life cycle rule  exists for each targeted class in the policy. This requirement doesn't apply 
to all policy types.  For example, this requirement doesn't apply to the Attestation policy type.  If 
you attempt to create a policy of a policy type for which this requirement applies but isn't met, 
an error message appears and the operation fails.

2. You can streamline approval of policies by populating the Manage by Group  attribute 
of CIs that you plan to target in policies. Use the CI Class Manager to populate that attribute 
for an entire class, in a single synchronization operation. For more information about this 
data synchronization, see Set the group for a CI or an entire class of CIs. If the Managed 
by Group  attribute isn't populated for a CI, then the approval process is directed to the 
administrator.

CMDB Data Manager experience in CMDB Workspace

Use the CMDB Data Manager in CMDB Workspace  to administer policies, CIs life-cycle and 
attestation tasks, view analytics about ongoing CMDB Data Manager processes, and to approve 
or reject assigned tasks.

CMDB Data Manager experience in CMDB Workspace

Use the CMDB Workspace  landing page and its views to administer CMDB Data Manager, to 
access overall analytic and counts for its policies and tasks, and review your tasks:

• Use the Management view in CMDB Workspace  to create and track policies, and to manage 
exclusion lists and retirement definitions.

• Use the Important actions tile on the CMDB Workspace  landing page to access data 
attestation and life cycle approval tasks such as reassignment requests and unassigned 
overdue tasks. Drill down these task cards to see further details about the tasks.

• Use the My work tile on the CMDB Workspace  landing page to access all open tasks, which are 
assigned to you, or to the group assigned in the Managed by Group  attribute and which 
you're a member of. For CMDB administrators, any unassigned tasks are also included for 
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reassignment. Review and process all tasks. Review and process attestation tasks by checking 
the physical existence of IT infrastructure or applications associated with the CIs in the tasks.

• Use the My Work view in CMDB Workspace  to access attestation and non-attestation tasks 
that are assigned to you or to an assignment group that you belong to in accordance with 
CMDB Data Manager policies. Overdue attestation tasks appear in a separated Overdue tasks 
list.

Manage policies in CMDB Data Manager in CMDB Workspace:

• Create a CMDB Data Manager policy in CMDB Workspace

• Review CMDB Data Manager tasks in CMDB Workspace

• Review CMDB Data Manager attestation tasks

• Manage retirement definitions for CMDB Data Manager

• Manage exclusion lists for CMDB Data Manager in CMDB Workspace

Administer Data Manager in CMDB Workspace

As a CMDB administrator, you can create policies, manage CI attestation, manage CI exclusion 
lists, access CMDB Data Manager insights, and access subflows and settings that are used in 
the CMDB Data Manager.

Get started with CMDB Data Manager in CMDB Workspace

The Data Manager overview page provides a dashboard view of Data Manager tasks, and lets 
you get started in using the CMDB Data Manager.

Before you begin
Role required: sn_cmdb_admin

Procedure

1. Navigate to Workspaces  > CMDB Workspace  and then select Management  in the CMDB 
Workspace menu bar.

2. Select the Data Manager  link in Management tools, in the Manage section.

3. Select Data Manager overview  in the left navigation bar.
The Data Manager overview page provides the following cards:

Open tasks

Count of the open tasks created for Data Manager policies.

Drill down the card to open a list view with details of the tasks associated with the 
card.

Unassigned tasks

Count of the open tasks created for Data Manager policies, which aren't assigned.

Drill down the card to open a list view with details of the tasks associated with the 
card.

Pending tasks

Tasks in Pending state, such as archive tasks where archive is still being 
processed.

Closed incomplete tasks

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

379



Tasks that encountered errors while processing, resulting with the task not 
completing successfully. Such tasks are in a Closed Incomplete state.

Overdue tasks

Count of tasks with a due date, such as attestation tasks, whose due date has 
passed.

Aging tasks

A bar chart showing counts of tasks without a due date and 
with no activity for over the number of days specified by the 
sn_cmdb_ws.glide.cmdb.data.manager.aging.policy.task.timeframe 
system property (30 by default).

Policies failing evaluation

Policies whose evaluation failed at some point and are in an error state. These 
policies require your attention, and after resolving any issues, you can publish 
them again.

Workload

◦ Groups: Tasks that are assigned to a group.

◦ Individuals: Tasks that are assigned to individual users.

What to do next

• Create a CMDB Data Manager policy in CMDB Workspace.

• Manage retirement definitions for CMDB Data Manager.

• Manage exclusion lists for CMDB Data Manager in CMDB Workspace.

• View CMDB Data Manager analytics in CMDB Workspace.

• View properties and other settings for CMDB Data Manager by selecting Settings  in the left 
navigation pane. For details about the system properties associated with those settings, see 
Components related to CMDB Data Manager.

Manage retirement definitions for CMDB Data Manager

Use CMDB Workspace to create,  delete,  edit, or activate a life-cycle rule to define the retirement 
state in your organization, for a class. Tables that are targeted in life-cycle CMDB Data Manager 
policies, must be associated with an active life-cycle rule. Target CIs in Retire policies, are set to 
match their associated class retirement definitions.

Before you begin
Role required: sn_cmdb_admin

For information about life-cycle rules used in CMDB Data Manager, see Life-cycle rules and 
retirement definitions.

About this task
Some life-cycle rules in the base system are inactive and you must activate any 
rule that you want to use with a CMDB Data Manager policy by setting its Active 
attribute to true. Life-cycle rules are stored in the CMDB Retirement Custom Definitions 
[cmdb_retirement_custom_definitions] table.

When CMDB Data manager retires a CI, ensure that any of its dependent CIs are also retired and 
don't remain as orphan CIs, by enabling management of dependent CIs. Orphan CIs can impact 
the consistency, accuracy, and integrity of the CMDB.
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• For information about enabling and managing dependent CIs, especially in the context of 
cascade-retire, cascade-archive, and cascade-delete, see Dependent CIs management.

• For details and definitions of independent and dependent CIs, see CMDB classifications and 
class dependency.

Note: 

• Always be aware of the automatic derivation of retirement definitions throughout the 
class hierarchy. For example, an active retirement definition for the Configuration Item 
[cmdb_ci] class can potentially be in effect throughout the entire CMDB hierarchy (aside 
from classes with their own retirement definition).

• You can't deactivate (or delete) the retirement definition of the Configuration Item 
[cmdb_ci] class.

• Each CMDB class can be associated with only a single retirement definition.

• Regardless of where you manage retirement definitions, the definitions are used in both 
the Data Manager (Core UI) and Data Manager in CMDB Workspace.

Procedure

1. Navigate to Workspaces  > CMDB Workspace  and then select Management in the CMDB 
Workspace menu bar.

2. Select the Data Manager  link in Management tools, in the Manage section.

3. In the Get started area on the Data Manager overview page, select Manage retirement 
definitions.

4. On the Data Manager settings page, review the Retirement definitions list view.

a. Optional:  Drill down to a definition and then on the Retirement definition form toggle the 
Active  switch to activate or deactivate a definition.

b. Optional:  Edit the conditions on the definition.

c. Select Save definition.

5. On the Data Manager settings page, select Add definition.

6. Fill out the Retirement definition form and then select Save definition.

Field Description

Active Toggles the retirement definition between 
being active and non-active.

Table Table that the retirement definition applies to.

Condition builder Condition that reflects on what retirement 
means in the organization.

Target CIs in Retire policies that belong to 
the specified table, are set as specified in the 
retirement definition. Therefore, you can only 
use AND  clauses in this definition while OR 
clauses aren't applicable.

Delete a CMDB Data Manager retirement definition

Delete a retirement definition that is no longer needed, in CMDB Workspace.
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Before you begin
The following restrictions are in effect:

• The retirement definition that you want to delete must be in an inactive mode (Active  = 
false).

• The retirement definition for the Configuration Item [cmdb_ci] class can't be deleted.

Role required: sn_cmdb_admin, data_manager_admin

About this task

Procedure

1. Navigate to Workspaces  > CMDB Workspace  and then select the Data Manager  quick link on 
the Home view.

2. In the Get started area on the Data Manager overview page, select Manage retirement 
definitions.

3. On the Data Manager settings page, in the Retirement definitions tile select the retirement 
definition that you want to delete.

4. On the Retirement definition page, select Delete definition.

5. In the Deleted retirement definition dialog box, select Delete.

Result
After the deletion, a retirement definition for the class is derived from a parent class.

Manage exclusion lists for CMDB Data Manager in CMDB Workspace

Create and manage exclusion lists for the various policy types in CMDB Data Manager. Policies 
of the specified type won't target CIs and other records in the exclusion list for that policy type.

Before you begin
Role required: sn_cmdb_admin

About this task

Note: 

• Regardless of where you manage exclusion lists, that same list is used in both the Data 
Manager (Core UI) and Data Manager in CMDB Workspace.

• The Certification policy type doesn't support exclusion lists.

Procedure

1. Navigate to Workspaces  > CMDB Workspace  and then select Management in the CMDB 
Workspace menu bar.

2. Select the Data Manager  link in Management tools, in the Manage section.

3. Select Excluded records  in the left-side bar.
The Excluded records list view shows lists of all records currently excluded, grouped by policy 
type. You can expand any group to show its CIs and other records and then drill down to any 
record.

4. Optional:  Remove excluded records from the exclusion list:

a. Expand a policy type group to show its list of excluded records.

b. In the list view, select the records that you want to remove from the exclusion list.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

382



c. Select Remove from list

d. In the Confirm removal from exclusion list dialog box, select Confirm.
The selected records are removed from the exclusion list and can be targeted for the policy 
type.

5. Optional:  Add records to an exclusion list:

a. Select Exclude Records  and fill out the Data Filter form.

Field Description

Tables Table from which to select CIs or records for 
the exclusion list.

Filter conditions Use the condition builder to specify the 
criteria that CIs or records from the specified 
Tables  must meet to be included in the 
exclusion list.

Related List Condition Add a condition that is based on related lists 
that are associated with the records that you 
want to exclude.

b. Select Apply filters  and then review the Search results list.

c. Select the records that you want to add to exclusion lists and then select Continue.

d. On the Select policy type page, select the policy types for which to exclude the selected 
records and then select Continue.

e. Review the details of the exclusion on the summary page and then select Save.

Create a CMDB Data Manager policy in CMDB Workspace

Create a CMDB Data Manager policy to automatically process CIs life cycle events such as 
deletion. Applying consistent and standard life cycle policies to CIs helps maintain the health of 
the CMDB.

Before you begin

• The life cycle policies Retire, Archive, and Delete, require that an active life-cycle rule  exists for 
each targeted class in the policy. If you attempt to create a policy of a policy type for which this 
requirement applies but isn't met, an error message appears and the operation fails.

• Verify that any custom subflow that you want to associate with a policy exists:

1. Navigate to Workspaces  > CMDB Workspace  and then select Management  in the CMDB 
Workspace menu bar.

2. Select the Data Manager  link in Management tools, in the Manage section.

3. Select Subflows  in the navigation bar on the left.

4. Review the subflows on the Data Manager subflows page, and drill down to a subflow to 
open it in Flow Designer.

5. Select Create new subflow  to create a new subflow in Flow Designer .
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• To require a review and an approval for a policy task: Ensure that the Managed By Group 
attribute is populated in target CIs and that the assigned users have the privilege to approve 
the policy tasks.

• When Asset Management  is activated, check if there's an asset record associated with that 
CI before retiring the CI. Check the associated asset record, if there's one, and verify that its 
asset state (install_status) is Retired.

Role required: sn_cmdb_admin

About this task
Specify for each policy a policy type, a subflow for life-cycle policies, a set of CIs to operate on 
as target CIs, and any other options specific to the selected policy type. Target CIs must typically 
be from classes extending the Configuration Item [cmdb_ci] table, and with the Delete CMDB 
Related Entry policy type, also tables in the Related Entries [cmdb_related_entry] table.  However, 
the Certification policy type for example, also supports non-CMDB tables.

Set condition filters to specify the initial set of CIs that the policy applies to. You can then further 
narrow down the initial set of CIs by using a CI exclusion list for the policy type. During the final 
preview of the policy, or from a policy task, you can select individual CIs to also exclude for 
the policy type. In addition, for operations that require that CIs are in a retired state, retirement 
definitions in life-cycle state rules  are enforced. The policy eventually applies to the resulting set 
of CIs, after applying all those filters.

Note: 
CMDB Data Manager limits the number of target CIs per task to 10,000. Therefore, when a 
task exceeds that number, Data Manager automatically creates as many additional tasks 
as needed to include all the CIs for the task. For example, if you target 30,000 CIs in an 
attestation task, Data Manager breaks down that task into three tasks, each targeting 
10,000 CIs.

For more information about life cycle state definitions and other concepts for working with the 
CMDB Data Manager, see Working with CMDB Data Manager.

Procedure

1. Navigate to Workspaces  > CMDB Workspace  and then select Management in the CMDB 
Workspace menu bar.

2. Select the Data Manager  link in Management tools, in the Manage section.

3. Select Policies  in the left-side bar.
For information about the Policies page, see View CMDB Data Manager policies in CMDB 
Workspace.

4. Select Create new policy.

5. Fill out the General information form and then select Continue.

Field Description

Name Unique name for the policy.

Description Description for the policy.

Policy Type
Life cycle event or data management action, 
such as Delete  or Attestation, that this policy 
manages, indicating the type of actions to 
perform on target CIs.
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Field Description

Your Policy Type  setting determines which 
fields appear in the forms that follow.

Work notes Notes that are internal and visible only to 
administrators.

6. Fill out the Data Filter form.

a. Fill out filter conditions for the target CIs and records for the policy.

Field Description

Table Table from which to select target CIs or 
records for the policy.

Filter conditions
Use the condition builder to specify the 
criteria that CIs from the specified Table 
must meet to be included as target CIs for 
the policy.

Related List Condition Add a condition that is based on related lists 
that are associated with the target records 
for the policy.

b. Select Apply filters  and then review the results of the impact analysis.

This analysis estimates the number of CIs that the policy applies to based on the policy 
filters, any CI exclusion lists, and the life cycle stage of CIs. For example:

▪ If the policy type is retired, CIs that meet the policy filters but are already in a retired state 
according to the class retirement definitions, aren't targeted for the policy.

▪ If the policy type is archive or delete, CIs that meet the policy filters but aren't retired 
according to the class retirement definitions, aren’t targeted for the policy. A filter on the 
Life Cycle Stage  or the Life Cycle Stage Status  attributes has no effect if 
the respective class retirement definition is based on those attributes.

Review the lists in the following tabs:

▪ Included records: You can select records to be excluded from the policy, and select 
Exclude records.

▪ Excluded records: Select records to be included in the policy, and select Include records.

Note: 
The Excluded records tab doesn't appear when the policy type is Certification.

c. Select Continue.

7. Fill out the Assignment form and then select Continue.

Set the Assignment type  and then the Task assignment  field that appears, to specify the type 
of assignment and the table columns to use for assigning the policy tasks. The drop-down 
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list in Task assignment  is dynamically populated with columns in the table that the policy is 
created for, that reference Assignment type  tables, as follows:

◦ User Field: Assigns policy tasks to a user in the user field specified in Task assignment. 
The drop-down list in Task assignment  contains fields in the table set by the data filter, that 
reference the User [sys_user] table (such as Attested by  and Assigned to).

◦ User Group Field: Assigns policy tasks to the user group in the user group field specified in 
Task assignment. The drop-down list in Task assignment  contains fields from the table set 
in the data filter, that reference the Groups [sys_user_group] table (such as Change Group 
and Support Group).

◦ Specific User: Assigns policy tasks to the user specified in Task assignment. The drop-
down list in Task assignment  contains users with the data_manager_user  role.

◦ Specific User Group: Assigns policy tasks to the user group specified in Task assignment. 
The drop-down list in Task assignment  contains user groups that are either directly 
associated with the data_manager_user  role, or contain at least one user with the 
data_manager_user  role.

In the User Group Field  and User Field  you can use dot-walking by selecting the search icon 

for the field: . In the selection dialog box, drill down lists by expanding or selecting list 
items that are links (usually appear in a unique text color).

8. Fill out the Options form and then select Continue.
The options that appear depends on whether they are relevant to the selected policy type. 
Therefore, some of the following options don't appear on your form. For example, not all policy 
types are associated with a subflow.

Field Description

Days to complete
Maximum number of days that policy tasks 
must be completed by.

If notifications are enabled for certification 
or attestation tasks, then this number is 
used to calculate the milestones for sending 
notifications. The full time (100%) interval 
starts when a task is created and ends when 
the number of days to complete the task 
arrives. Notifications are sent if a task isn't 
closed when 50%, 70%, and 90% of that 
interval passes. For more information about 
setting those notifications, see Components 
related to CMDB Data Manager.

Subflow
A subflow with the actions that will run on the 
target CIs for the policy.

The subflow typically matches the policy 
type. For example, if Policy type  is set 
to Delete CMDB Related Entry, then 
set Subflow  to Delete Related Entry 
Configuration Item.
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Field Description

Needs review
Option to require a review and an approval of 
the policy tasks, by the group assignment in 
CIs' Managed by Group  attribute or by an 
administrator.

Otherwise, all policy tasks are approved 
automatically.

Retention time
The length of time for retaining archived CIs 
in the archive table before they're deleted.

During the specified retention period, you 
can use the ServiceNow AI Platform®  data 
archiving feature to restore archived CIs .

Note: 
You can't use the CMDB Data Manager 
to re-archive a CI that was previously 
archived and restored.

Display fields
One or more fields that appear in list views in 
Data Certification tasks, that uniquely identify 
the records that require certification.

The selected fields can't overlap fields in 
Certification fields.

Certification fields
One or more fields whose value requires 
verification and certification.

The selected fields can't overlap fields in 
Display fields.

Allow field updates Option to allow certification task reviewers to 
update field values while reviewing CIs.

◦ When selected, certification task reviewers 
can update field values in order to certify a 
CI.

◦ When clear, certification task reviewer can't 
update field values, and therefore reject 
CIs that aren't compliant.

Allow empty field values
Option to allow or disallow users to certify CIs 
with empty attributes:

◦ When selected, certification task reviewers 
can certify or fail certification of a CI with an 
empty attribute.

◦ When clear, certification task reviewers 
can fail certification of a CI with an empty 
attribute but aren't able to certify that CI.
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Field Description

Instructions Any instructions to assigned users, to help 
them complete the tasks.

9. Fill out the Schedule form and then select Continue.

Field Description

Schedule
Recurring schedule for how often and when 
to run the task. The On demand  option 
doesn't set any recurring schedule for 
running the policy.

Your setting determines which other fields 
appear on the form.

Start time Time in the day to start running the policy.

Day of the week Day of the week to run the policy.

On Day of the month to run the policy.

Start day and time Date and time of first run of the policy.

Run after every Interval (by days) between subsequent runs 
after running the policy for the first time.

10. Review the policy details on the Review form, and then select Publish policy  to activate the 
policy or Save & Exit  to save the policy as a draft.
You can later continue to configure a draft policy, and then publish it when it's ready.

Result
After you publish a policy:

• A daily scheduled job processes the published policy and policy tasks are assigned as set in 
the policy. If the policy is associated with a subflow, then policy tasks trigger the policy subflow. 
Policy execution issues are recorded in an error log with notifications sent to the CMDB Data 
Manager administrator.

If the policy is configured to require an approval for its tasks, then email notifications are sent 
to members of the assignment group in the Managed by Group  attribute of the CI. If the 
policy is associated with a subflow, then a policy task triggers the policy subflow only after the 
task is approved.

• If the policy is associated with a subflow, then after a policy task is complete, the policy 
subflow closes the task. For an Attestation policy (which isn't associated with a subflow), a user 
must process all CIs in the task and submit the task to close it.

• For Attestation policies, attestation tasks are assigned to users as specified, and those tasks 
appear in the CMDB Workspace  when those users log in.

• For some policy types, such as Delete, the list of the target CIs is rolled up in a CSV file that is 
then attached to the task for tracking purposes.
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• Stale tasks are set to Closed Cancelled  by a daily scheduled job. A task 
becomes stale when it's still open and not approved after at least 90 days. The 
number of days after which a task is considered stale is determined by the 
cmdb.data.manager.stale.task.life.in.days  system property.

What to do next

• Publish a draft Data Manager policy in CMDB Workspace.

• On the Policies page, in the Published policies list view, select a policy to see policy details on 
a policy form. Select View Policy  to see the settings in all of the policy form pages.

• On the Policies page, in the Published policies list view, select a policy that you want to 
deactivate. On a policy form select Deactivate Policy  to temporarily prevent the policy from 
running.

• Click View Open Tasks  in the Open Policy Tasks tile to track the processing of policy tasks in 
the CMDB Data Management Task Control list view. The Success Percent column shows the 
percentage of CIs in the task for which the task is completed. A CI is counted as complete in 
an archival task only after the archival process has been fully completed for the CI (and isn't 
counted as complete while the CI is initially staged for archival for example).

• Users log in to the CMDB Workspace  to review and process attestation tasks  assigned to them.

• Users log in to the CMDB Workspace  to review and process non-attestation tasks  assigned to 
them.

Publish a draft Data Manager policy in CMDB Workspace

If you created a draft Data Manager policy in CMDB Workspace, or imported legacy certification 
schedules, you can activate that draft policy by publishing it.

Before you begin
Role required: sn_cmdb_admin

Procedure

1. Navigate to All  > Workspaces  > CMDB Workspace  and then select Management in the CMDB 
Workspace menu bar.

2. Select the Data Manager  link in Management tools, in the Manage section.

3. Select Policies in the left-side bar in the Data Manager overview page.

4. Select the Draft policies list view on the Data Manager policies page.

5. Select the policy that you want to publish and then, on the policy form, select Edit Policy.

6. Review any policy settings by selecting the pages to review in the left-side bar.

7. Select Review in the left-side bar and then, on the Review form select:

a. Publish Policy  to activate the policy.

b. Save & Exit  to save any changes and keep the policy in draft mode.

What to do next
Deactivate a policy to temporarily prevent the policy from running:

1. On the Policies page, select the Published policies list view.

2. Select a policy that you want to deactivate.

3. On a policy form select Deactivate Policy.
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View CMDB Data Manager policies in CMDB Workspace

View Data Manager policies on a dashboard view, with a timeline of upcoming scheduled 
policies, counts, and grouped by policy status.

Before you begin
Role required: sn_cmdb_admin

Procedure

1. Navigate to Workspaces  > CMDB Workspace  and then select Management in the CMDB 
Workspace menu bar.

2. Select the Data Manager  link in Management tools, in the Manage section.

3. Select Policies  in the left-side bar.

Select a tab on the Data Manager policies page:

◦ Published policies: Provides the following cards:

Upcoming scheduled policies

Timeline showing scheduled policies across time. On the timeline, you can:

▪ Point to indicators to show details about a scheduled policy.

▪ Zoom in or out to extend or shorten the time span of the timeline.

▪ Go forward or backward in time.

▪ Show or hid the timeline legend, where you can toggle the Attestation Policy 
switch to show or hide attestation policy indicators on the timeline.

Policies

Pie chart showing the breakdown of policies by policy type.

Published policies

List view of policies that are published. You can drill down a policy to show the 
policy form view with further details about the policy.

◦ Draft policies: Policies in draft state.

◦ De-activated policies: Policies that have been de-activated and therefore aren't active.

◦ Policies failing evaluation: Policies that are invalid and therefore require your attention.

What to do next

• Create a CMDB Data Manager policy in CMDB Workspace

• Manage retirement definitions for CMDB Data Manager

View CMDB Data Manager analytics in CMDB Workspace

The CMDB Data Manager in CMDB Workspace  provides charts and counts that show the overall 
state of Data Manager policies in the organization. Review these details to track progress and to 
identify any problems that require your attention.

Before you begin
Role required: Role required: data_manager_admin or sn_cmdb_admin
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Procedure

1. Navigate to Workspaces  > CMDB Workspace  and then select Management in the CMDB 
Workspace  menu bar.

2. Select the Data Manager  link in Management tools, in the Manage section.

3. Select Analytics  in the left navigation bar.
The Data Manager analytics page provides the following charts:

CIs processed by lifecycle policies

Counts of CIs processed by each type of lifecycle policy type such as Delete and 
Archive, over the past six months.

Average time to close tasks

Average number of days it took to close tasks, by general policy type such as 
lifecycle and attestation, over the past six months.

Closed complete vs closed incomplete tasks

Number of tasks per month, that were closed complete and incomplete, over the 
past year.

Policy execution time

Number of policies per day, broken by the length of execution time, over the past 
month.

Review CMDB Data Manager tasks in CMDB Workspace

Review Data Manager tasks (such as life-cycle tasks) that are assigned to you, to an assignment 
group that you belong to, to people you manage, or to members of a group that you are the 
manager of. All in accordance with CMDB Data Manager policies.  During the review, you can 
approve, cancel,  reject,  or reassign a task.

Before you begin
Role required: sn_cmdb_user, sn_cmdb_editor, or sn_cmdb_admin

About this task
To review attestation tasks, see Review CMDB Data Manager attestation tasks.

Procedure

1. Navigate to Workspaces  > CMDB Workspace  and then select My Work  in the CMDB 
Workspace menu bar.

2. In the My tasks section, select the All other tasks  tab.

3. Review the Approval tasks list view and then select the task that you want to process.

4. Review the task details on the task form.

5. Optional:  CMDB administrators can select Cancel task  if the task isn't needed.
The canceled task is deleted without any further processing.

6. Optional:  Select Reassign  if the task isn't appropriately assigned.
Then select Assign to me  or Request reassignment  as appropriate.

7. Optional:  Select Review records  to review the target CIs and records for the task.

a. Select any records that you want to exclude for the task and then select Exclude.
The records being excluded for the task are also being added to the exclusion list of the 
associated policy type. Therefore, these records will be excluded from any future tasks of the 
associated policy type.
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b. Select Reassign  if the task isn't appropriately assigned.

c. Select Reject task  to reject a task, fill in a Reason for rejection  and then select Save.

(Optional) You can only reject a task that is assigned to you.

After you reject a task, the State  of the task is set to Closed Canceled  and Approval  is 
set to Rejected. Also, appropriate notifications are sent to members of the group specified 
in the glide.cmdb.data_manager.rejected.task.notification_group 
system property. For more information about how this property is used for notifications, see 
Components related to CMDB Data Manager.

d. Select Assign to me  or Request reassignment  as appropriate.

e. Select Approve task  to trigger the subflow associated with the policy.

CMDB Data Manager on Core UI (UI 16)

The CMDB Data Manager built on Core UI (UI 16) lets you centrally create, edit, review, publish, 
and track Data Manager policies and the tasks generated by the policies.

The landing page of the CMDB Data Manager (Core UI) provides a dashboard view of policies, 
excluded CIs, and open policy tasks. Access the open policy tasks that need attention from the 
management group or from the CMDB Data Manager administrator. Preview those tasks, and 
then approve or reject to continue the process.

Note: 
Starting with the Washington DC  release, CMDB Data Manager on Core UI (UI 16) is being 
prepared for future deprecation. It will be hidden and no longer activated on new instances 
but will continue to be supported. CMDB Workspace provides the latest experience for this 
functionality.

Manage policies in the CMDB Data Manager (Core UI):

• Create a CMDB Data Manager policy

• Approve or reject a CMDB Data Manager task

• Review CMDB Data Manager attestation tasks

• Manage exclusion lists of CMDB Data Manager

To access the CMDB Data Manager (Core UI), navigate to All  > Configuration  > CMDB Data 
Manager.

Note: 
Dependent CI management processes generate dependent CI policies for which CMDB 
Data Manager shows policy preview details that aren't relevant.

1. Select View Policies  on the Policies tile on the CMDB Data Manager landing page.

2. Select All  in the breadcrumbs string.

3. Select one of the following policies: 'Dependent CI - Deletion', 'Dependent CI - Archive', or 
'Dependent CI - Retire'.

4. Select the Preview Policy tab on the policy form.

The data that appears on the Preview Policy page is irrelevant for any of those policies.
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Create a CMDB Data Manager policy

Create a policy in the CMDB Data Manager  legacy build on Core UI (UI 16)  to automatically 
process CIs life cycle event such as deletion. Applying consistent and standard life cycle 
policies to CIs helps maintain the health of the CMDB.

Before you begin

• The life cycle policies Retire, Archive, and Delete, require that an active life-cycle rule  exists for 
each targeted class in the policy. If you attempt to create a policy of a policy type for which this 
requirement applies but isn't met, an error message appears and the operation fails.

• Ensure that any custom subflow that you want to associate with a policy, exists.

• To require a review and an approval for a policy task: Ensure that the Managed By Group 
attribute is populated in target CIs and that the assigned users have the privilege to approve 
the policy tasks.

• When Asset Management  is activated, check if there is an asset record associated with that 
CI before retiring the CI. Check the associated asset record, if there is one, to ensure that the 
asset state (install_status) is Retired.

Role required:

• data_manager_admin: Full access to policies

• data_manager_user: Can read and preview policies

About this task
Specify for each policy a policy type, a life cycle subflow, and a set of CIs to operate on 
as target CIs. Target CIs must be from classes extending the Configuration Item [cmdb_ci] 
table, and with the Delete CMDB Related Entry policy type, also tables in the Related Entries 
[cmdb_related_entry] table.

Set condition filters to specify the initial set of CIs that the policy applies to. You can then further 
narrow down the initial set of CIs by using a CI exclusion list for the policy type. During the final 
preview of the policy, or from a policy task, you can select individual CIs to also exclude for 
the policy type. In addition, for operations that require that CIs are in a retired state, retirement 
definitions in life-cycle state rules  are enforced. In these cases:

• CIs that meet the policy filters but aren't retired according to the class retirement definitions, 
aren’t targeted for the policy.

• A filter on the Life Cycle Stage  or the Life Cycle Stage Status  attributes has 
no effect if the respective class retirement definition is based on those attributes.

The policy eventually applies to the resulting set of CIs, after applying all those filters.

Note: 
CMDB Data Manager limits the number of target CIs per task to 10,000. Therefore, when a 
task exceeds that number, Data Manager automatically creates as many additional tasks 
as needed to include all the CIs for the task. For example, if you target 30,000 CIs in an 
attestation task, Data Manager breaks down that task into three tasks, each targeting 
10,000 CIs.

More information:

• About life cycle state definitions, see Working with CMDB Data Manager.

• About creating a policy in the CMDB Data Manager in CMDB Workspace, see Create a CMDB 
Data Manager policy in CMDB Workspace.
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Procedure

1. Navigate to All  > Configuration  > CMDB Data Manager.

2. On the CMDB Data Manager landing page, in the Policies tile, click View Policies.

3. In the CMDB Data Manager Policy and Attributes list view, click New.

4. Fill out the fields in the different sections on the Define Policy  tab.

Note: 
Some fields are applicable only to specific policy types. Therefore some of the following 
fields, might not appear for the policy type that you choose.

Field (General) Description

Name Unique name for the policy.

Task Assignment Group Group to assign the task to.

Task Due In Days Due date for completing the policy tasks such 
as attestation tasks.

Needs Review
Check to require a review and an approval of 
the policy tasks, by the group assignment in 
CIs' Managed by Group  attribute or by an 
administrator.

Otherwise, all policy tasks are approved 
automatically.

Policy Type
Life cycle event or data management action, 
such as Delete  or Attestation, that this policy 
manages, indicating the type of actions to 
perform on target CIs.

User Group Group to use as the task assignment group 
for the Delete CMDB Related Entry policy 
type. The list is a subset of user groups from 
the Group [sys_user_group] table, where at 
least one member has a data_manager_user 
role.

Apply Retention Time
The length of time for retaining archived CIs 
in the archive table before they are deleted.

During the specified retention period, you 
can use the ServiceNow AI Platform®  data 
archiving feature to restore archived CIs .

Field (Condition Filter) Description

Related Entry Table The related table to apply a Delete CMDB 
Related Entry policy. The list contains 
related tables from the Related Entry 
[cmdb_related_entry] table.
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Field (Condition Filter) Description

Condition Filter
Criteria that CIs must meet to be included for 
the policy as target CIs.

Additional filtering such as a CI exclusion list, 
can further narrow down the set of target CIs.

Field (Action) Description

Subflow
A subflow with the actions that will run on the 
target CIs for the policy.

The subflow typically matches the policy 
type. For example, if Policy type  is set 
to Delete CMDB Related Entry, then 
set Subflow  to Delete Related Entry 
Configuration Item.

Note: 
The Attestation policy type is not 
associated with a subflow.

Field (Schedule) Description

Frequency How often to run the task.

Start Time Time to start running the task when it is due 
to run.

5. Optional:  Click Run filter  in the Condition Filter section, to see the resulting list of CIs that 
match the condition filters.

6. Click Save.

7. Click Preview  and wait for an impact analysis for the policy on the Preview Policy Impact 
page to complete.
This analysis estimates the number of CIs that the policy applies to based on the policy filters, 
any CI exclusion lists, and the life cycle stage of CIs. For example:

◦ If the policy type is retired, CIs that meet the policy filters but are already in a retired state, 
are not targeted for the policy.

◦ If the policy type is archive or delete, CIs that meet the policy filters but are not retired, are 
not targeted for the policy.

8. Optional:  Select CIs in the target CIs list that you want to also exclude for the policy type.
Click Exclude CI  and then click Recalculate Preview  to recalculate the data on the preview 
page.

9. Click Publish  to activate the policy.
Unpublished tasks are saved as draft policies.

Result
After you publish a policy:
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• A daily scheduled job processes the published policy and policy tasks are assigned as set in 
the policy. If the policy is associated with a subflow, then policy tasks trigger the policy subflow. 
Policy execution issues are recorded in an error log with notifications sent to the CMDB Data 
Manager Administrator.

If the policy is configured to require an approval for its tasks, then email notifications are sent 
to members of the assignment group in the Managed by Group  attribute of the CI. If the 
policy is associated with a subflow, then a policy task triggers the policy subflow only after the 
task is approved.

• If the policy is associated with a subflow, then after a policy task is complete, the policy 
subflow closes the task. For an Attestation policy (which is not associated with a subflow), a 
user must process all CIs in the task and submit the task to close it.

• For Attestation policies, attestation tasks are assigned to users as specified, and those tasks 
appear in the CMDB Workspace  when those users log in.

• For some policy types, such as Delete, the list of the target CIs is rolled up in a CSV file that is 
then attached to the task for tracking purposes.

• Stale tasks are set to Closed Cancelled  by a daily scheduled job. A task 
becomes stale when it is still open and not approved after at least 90 days. 
The number of days after which a task is considered stale is determined by the 
cmdb.data.manager.stale.task.life.in.days  system property.

What to do next

• Click View Open Tasks  in the Open Policy Tasks tile to track the processing of policy tasks in 
the CMDB Data Management Task Control list view. The Success Percent column shows the 
percentage of CIs in the task, for which the task is completed. A CI is counted as complete in 
an archival task only after the archival process has been fully completed for the CI (and isn't 
counted as complete while the CI is just staged for archival for example).

• Users log in to the CMDB Workspace  to review and process attestation tasks  assigned to them.

• You can open a policy in CMDB Data Manager and click Deactivate  to temporarily prevent the 
policy from running.

• Manage exclusion lists of CMDB Data Manager.

Related topics

Working with CMDB Data Manager

Approve or reject a CMDB Data Manager task

If you are an authorized approver, you might receive an email notification directing you to review 
a CMDB Data Manager policy task. Approve the task in the CMDB Data Manager legacy build on 
Core UI (UI 16), to continue its processing, or reject the task to send it to the CMDB Data Manager 
administrator for a more detailed review.

Before you begin
Role required:

• data_manager_admin: Full access to policy tasks and can set state to 'Work in progress' of an 
unassigned task.

• data_manager_user: Read access to policy tasks and can approve or reject an assigned policy 
task.
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About this task
Authorized approvers for a task are all users in the assignment group of the task, with the 
data_manager_user or data_manager_admin roles.

For information about using the more advanced CMDB Data Manager in CMDB Workspace, see 
CMDB Data Manager experience in CMDB Workspace.

Procedure

1. Navigate to All  > Configuration  > CMDB Data Manager.

2. On the CMDB Data Manager landing page, in the Open Policy Tasks tile, select View Open 
Tasks.

3. On the CMDB Data Management Task Control list view, select a task to review.

4. Select the Approvers  tab in the related lists section.

5. In a record where you are the Approver, select the Requested  value in the State  column.

6. On the Approval form, set State  to your approval choice such as Approved  or Rejected.

7. Select Update.

Result

1. The Approval  field of the task is set to Approved  or Rejected.

2. If the task is approved, then the policy subflow is triggered to continue processing the policy 
tasks for the target CIs.

Edit and activate a life-cycle rule  (Core UI)

Create, edit, or activate a life-cycle rule to define the retirement state in your organization, for a 
class. Tables that are targeted in life-cycle CMDB Data Manager policies, must be associated 
with an active life-cycle rule. Target CIs in Retire policies, are set to match their associated class 
retirement definitions.

Before you begin
Role required:

• data_manager_user has read access

• cmdb_admin and data_manager_admin have full access

About this task
Life-cycle rules in the base system are inactive and you must activate any rule that you want 
to use with a life-cycle CMDB Data Manager policy. To activate a life-cycle rule, set its Active 
attribute to true.

Each CMDB class can be associated with only a single rule. Life-cycle rules are stored in the 
CMDB Retirement Custom Definitions [cmdb_retirement_custom_definitions] table.

You can alternatively manage life-cycle rules in the Data Manager in CMDB Workspace. For 
more information, see Administer Data Manager in CMDB Workspace  and Manage retirement 
definitions for CMDB Data Manager. Regardless of where you manage life-cycle rules and 
retirement definitions, those same definitions are used in both the Data Manager legacy built on 
Core UI (UI 16) and Data Manager in CMDB Workspace.

Note: 
The retirement definition for the cmdb_ci class, can't be deactivated or deleted.
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Procedure

1. Navigate to Configuration  > CMDB Retirement Definitions.

2. In the list view, select the life-cycle rule/table that you want to edit and then edit or fill out the 
CMDB Retirement Custom Definition form.

Field Description

Active Activates the life-cycle rule.

Table The CMDB class that the life-cycle rule 
applies to, including any child classes of the 
specified class.

Retirement definition
One or more attribute conditions that 
together define the retirement state for the 
class.

Target CIs in Retire policies that belong to 
the specified table, are set as specified in the 
retirement definition. Therefore, you can only 
use AND  clauses in this definition while OR 
clauses aren't applicable.

3. Select Update.

Result
After the deletion, a retirement definition for the class is derived from a parent class.

What to do next
To delete a retirement definition (in Core UI), the retirement definition must be in an inactive 
mode (Active  = false):

1. Navigate to Configuration  > CMDB Retirement Definitions, and then select the retirement 
definition that you want to delete.

2. On the CMDB Retirement Custom Definition form, select Delete.

3. In the Delete retirement definition form, select Delete.

Manage exclusion lists of CMDB Data Manager

Create an exclusion list for the various policy types of the CMDB Data Manager, by using the 
CMDB Data Manager legacy build on Core UI (UI 16). Policies of a specific policy type will not 
target the CIs or other records in the exclusion list for that policy type.

Before you begin
Role required:

• data_manager_admin: Full access to CI exclusion lists

• data_manager_user: Read access and can add a CI to a CI exclusion list
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About this task

Note: 
Regardless of where you manage exclusion lists, that same list is used in both, the 
Data Manager (Core UI) and Data Manager in CMDB Workspace. For information about 
managing CI exclusion lists in the more advanced CMDB Data Manager in CMDB 
Workspace, see CMDB Data Manager experience in CMDB Workspace.

Procedure

1. Navigate to All  > Configuration  > CMDB Data Manager.

2. On the CMDB Data Manager landing page, in the Excluded CIs tile, click View Excluded CIs.

3. On the Excluded CIs list view, click Edit Exclusion List  and fill out the Specify Excluded CIs 
form.

Field Description

Policy Type Type of policy from which to exclude the 
specified CIs.

Condition Filter Conditions that CIs must meet to be excluded 
for the specified policy type.

4. Click Run filter.
All the CIs that meet the condition filters, appear in the Results section.

5. In the Results list, select any or all of the CIs that you want to exclude from the policies of the 
respective policy type.

6. In the Excluded CIs section, click the '+' icon to add the selected CIs to the Excluded CIs list.

7. Optional:  In the Excluded CIs list, select CIs that you want to remove from the exclusion list, 
then click the trash icon.

8. Click Save.

Life-cycle rules and retirement definitions

Use a life-cycle rule to specify the retirement definition for a class, reflecting processes and 
protocols in your organization. These rules support the transition of CIs through life-cycle stages 
as implemented by CMDB Data Manager policies. A life-cycle rule is required for each targeted 
class in a Retire, Archive, or Delete CMDB Data Manager policy.

Note: 
The same life-cycle rules and retirement definitions are used in both the Data Manager 
legacy built on Core UI (UI 16) and Data Manager in CMDB Workspace.

Usage

Life-cycle rules are used in life-cycle policies as follows:

• Setting target CIs in Retire policies, according to their associated class retirement definitions.

• Filtering out target CIs In Retire policies, that are determined to already be in a retired state 
according to their associated retirement definitions. Those CIs aren’t targeted even if they 
meet the policy filter.

• Identifying CIs as being ready to be processed by an Archive or Delete policies. Archive and 
Delete policies can only process CIs that are in a retired state that matches their associated 
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class retirement definitions. Therefore, target CIs in Archive and Delete policies, are checked 
against their associated class retirement definitions to verify that they are in a retired state 
before they can be archived or deleted.

Predefined life-cycle rules

The base system includes predefined life-cycle rules for key classes such as Hardware 
[cmdb_ci_hardware] and Application [cmdb_ci_appl], which are stored in the CMDB Retirement 
Custom Definitions [cmdb_retirement_custom_definitions] table. For example, the predefined 
rule for the Service [cmdb_ci_service] class defines that for a retired CI, the value of the 
attributes [operational status], [Phase], and [Status] is Retired.

Predefined retirement definitions are inactive by default  (other than the cmdb_ci retirement 
definition which is always active), and you must activate a retirement definition that corresponds 
to a targeted class in a Retire, Archive, or Delete CMDB Data Manager policy. By default, the 
cmdb_ci retirement definition is in effect throughout the entire CMDB hierarchy due to derivation.

You can use the default definition of a predefined life-cycle rule, or customize a rule to reflect 
practices in your organization. You can also add life-cycle rules for additional classes. However, 
each CMDB class can be associated with only a single life-cycle rule.

CMDB Data Manager requirement

The Retire, Archive, and the Delete CMDB Data Manager policies require that for each of the 
classes that the policy applies to, there's a corresponding active life-cycle rule. After retiring a CI, 
CI's attributes are configured according to the life-cycle rule for the CI's class.

Derivation across the CMDB hierarchy

Life-cycle rules are derived throughout the CMDB hierarchy in the same way that other rules, 
such as identification rules, are derived. Child classes extended from a parent class with a life-
cycle rule, derive that rule unless there’s a life-cycle rule defined at the child class level.

When there are retirement definitions for classes in different levels in the class hierarchy, then 
the retirement definitions that apply are those that are most specific for a class. For example, 
if there are retirement definitions for the Computer and the Configuration Item class, then the 
Computer class definitions also apply to its descendant classes. All other classes that aren't 
descendants of the Computer class, use the Configuration Item retirement definitions.

To create a life-cycle rule, see Manage retirement definitions in CMDB Workspace  or Edit and 
activate a life-cycle rule (Core UI).

Duplicate CIs remediation

When the instance encounters duplicate CIs during identification and reconciliation (IRE), it 
groups each set of duplicate CIs into a de-duplication task for review and remediation.

De-duplication tasks

De-duplication tasks provide details about the duplication, including a list of all the duplicate CIs. 
Review the details of each duplicate CI in the task and the data that was used to determine that 
the CI is a duplicate.

To remediate a de-duplication task, you need to reconcile its set of duplicate CIs into a single 
CI, eliminating the duplication. From a de-duplication task, you can run the Duplicate CI 
Remediator wizard to remediate a single de-duplication task.  Or, you can access the De-
duplication dashboard in CMDB Workspace  to create de-duplication templates that remediate 
de-duplication tasks in bulk.
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For more information about IRE processes that detect duplicate CIs and generate de-duplication 
tasks, see Detecting duplicate CIs.

Main CI

The main CI  plays an important role in the remediation of duplicate CIs. The main CI is one of the 
duplicate CIs that you want to retain as an active CI after reconciling the rest of the duplicate CIs 
into that main CI. You can then potentially retire or delete the rest of the duplicate CIs, or assign 
custom values to their attributes.  The first step during remediation is to select a main CI for the 
remediation process.  During remediation, you choose which attribute values, relationships, and 
related items from the duplicate CIs to reconcile into the main CI.  Alternatively, you can choose 
not to consolidate any data and retain the main CI as it is.

The duplicate_of  attribute in duplicate CIs, is used to store a reference to the main CI. For 
duplicate CIs which existed in an instance that was upgraded to the New York  release or later, the 
main CI is unknown. After upgrade, duplicate_of  for those duplicate CIs is set to 'Unknown', 
indicating that the CI is a duplicate but the main CI is unknown.

Before remediation, the CIs in a duplicate CIs set are all duplicates of each other. After 
remediation, a set of duplicate CIs consists of one main CI, and any number of CIs, each 
considered a duplicate of the main CI. The duplicate_of  attribute of the main CI is empty. 
The duplicate_of  attribute for all the rest of the duplicate CIs in the set, is a reference to the 
main CI of the set.

Default related items list

A list of related items that is used globally in the remediation of duplicate CIs, with all de-
duplication tasks. During remediation, all items from the default related items list are selected 
by default to be merged to the main CI. During remediation, adding or removing related items to 
be merged doesn't affect the default related items list. See Manage default related items list  for 
more information.

Note: 

• Merging of attributes and related items that are associated with assets is not supported. 
Asset related tables are not included in the default related items list and therefore they 
are not available for merge.

• If a scenario involves an inactive change request, the Configuration item  field on the 
Change Request form is cleared. If the current value is a duplicate CI, then it isn’t merged 
with the main CI.

De-duplication dashboard

CMDB Workspace  provides a de-duplication remediation solution letting you remediate de-
duplication tasks, in bulk. The De-duplication dashboard, and the de-duplication templates and 
libraries, let you remediate multiple de-duplication tasks, consistently, in a single operation. 
The De-duplication Template Library in CMDB Workspace  lets you create a preconfigured de-
duplication template with the remediation settings for a class. The De-duplication dashboard 
in CMDB Workspace  lets you then run the preconfigured template on multiple de-duplication 
tasks for the class that is set in the template. The remediation settings in the template, are then 
consistently applied to the duplicate CIs of the de-duplication tasks, to remediate CI duplication.

For more information about remediating duplicate CIs in CMDB Workspace, see CI de-
duplication experience in CMDB Workspace.
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Duplicate CI Remediator

A de-duplication remediation tool, that is wizard-like and that lets you reconcile a set of duplicate 
CIs associated with a single de-duplication task. You can choose one of the duplicate CIs 
to retain as an active CI, and then decide how to process the rest of the duplicate CIs. The 
Duplicate CI Remediator lets you set reconciliation options for attributes, relationships, and 
related items.

For information about using the Duplicate CI Remediator, see Remediate a de-duplication task 
(legacy).

Effects on related tasks (change, problem, incident)

Effect on change requests:

• When a CI is associated with a change request whose state isn’t New, then when duplicate CI 
remediation processes delete the CI, the CI is removed from the change request.

• When a CI is associated with a change request whose state is New, then when duplicate CI 
remediation processes delete the CI, the CI in the change request is updated to the main CI.

The business rule Ready only CI when not New  prevents change requests that aren't 
in the New state, from getting updated. This behavior ensures the validity and the continued 
processing of a change request when change request CIs are affected by duplicate remediation 
processing.

When a CI is associated with a problem or an incident task, those tasks remain valid after 
duplicate CI remediation processes run as the system merges the main CI in those tasks even if 
the remediation processes deleted the associated CI.

Properties that affect processing of duplicate CIs

During CMDB Identification, processing of sets of duplicate CIs is determined by:

• Property glide.identification_engine.skip_duplicates  (true by default).

• Property glide.identification_engine.skip_duplicates.threshold  (5 by 
default).

• Number of duplicate CIs in a set.

For information about how these properties affect the management of duplicate CIs, see 
Detecting duplicate CIs.

Special remediation scenarios

There are a few special remediation scenarios in which the remediation of duplicate CIs behaves 
differently:

Large number of duplicate CIs

Support for reconciliation of duplicate CIs is limited when the number of duplicate 
CIs exceeds a certain threshold. This threshold is based on the value of the 
glide.duplicate_ci_remediator.max.cis  property, which is 1,000 
by default. You can update this property to increase the threshold. However, this 
threshold never exceeds 5,000, even if you set the property to a value greater than 
5,000.

When the number of duplicate CIs for a de-duplication task exceeds the threshold, 
the options available in the wizard are limited:
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• On the Select Main CI  tab, only the Recommended  list of main CIs appears, and 
only the Use Main CI  option is available.

• Recommendations are based only on the oldest created, newest updated, and 
most recently discovered CIs.

• Reconciliation of attribute conflicts and CI relationships is not supported, and 
only default related items are reconciled.

Duplicate serial numbers

Duplicate CI remediation is usually applied to duplicate CMDB CIs. However, in 
some situations de-duplication tasks might be created for duplicate serial numbers. 
When remediation is applied to duplicate serial numbers, the merge of relationships 
from duplicate records, is not referenced and is not applied.

Large number of related items

A de-duplication task might be associated with a large number of 
related items which might block the remediation process as loading 
the task times out. To continue the remediation process in this 
case, you can try running remediation in a restricted mode. Add the 
glide.duplicate_ci_remediator.enable_restricted_mode 
system property, and set its value to true  to show the Use the Duplicate CI 
Remediator (Restricted Mode)  option in the Remediate dialog box. For more 
information about using this option to restrict the use of related items in de-
duplication remediation and allow remediation to proceed, see Using restricted 
mode within the Duplicate CI Remediator [KB1542272] .

Restrictions

IRE uses the duplicate_of  field internally by populating it as part of the skip duplicate 
mechanism, and you should restrict manual updates of that field. For more details, see Detecting 
duplicate CIs.

If you do attempt to modify the value of duplicate_of  directly on a CI form or by using a 
script, the following restrictions are enforced to ensure data integrity:

• A CI cannot be its own main CI (you cannot set a CI as a duplicate of itself).

• A CI and its main CI cannot be from different domains.

• The duplicate_of  attribute of the main CI cannot reference any CI as its main CI (you 
cannot set a CI as a duplicate of another duplicate CI to create a chain of duplicate CIs).

◦ If you attempt to set a CI as a duplicate of another duplicate CI, then the CI is set as a 
duplicate of the main CI of the duplicate CI you are trying to set. If the main CI of the 
duplicate CI you are trying to set is 'Unknown', the operation fails.

Example: Attempt to set a CI as duplicate of another duplicate CI

CIs Attempted setting Result (System enforced)

CI1: duplicate_of  = 
empty

CI2: duplicate_of  = CI3

CI3: Main CI

CI1: duplicate_of  = CI2 CI1: duplicate_of  = CI3

CI2: duplicate_of  = CI3

CI3: Main CI

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

403

https://support.servicenow.com/kb_view_customer.do?sysparm_article=KB1542272
https://support.servicenow.com/kb_view_customer.do?sysparm_article=KB1542272
https://support.servicenow.com/kb_view_customer.do?sysparm_article=KB1542272
https://support.servicenow.com/kb_view_customer.do?sysparm_article=KB1542272


If CI2 is a duplicate of 'Unknown', the operation fails.

◦ If a main CI becomes a duplicate of another CI, then it can no longer be a main CI. All CIs 
that were duplicates of that main CI are set as duplicates of the new main CI.

Example: Attempt to set a main CI as duplicate of another CI

CIs Attempted setting Result (System enforced)

CI1: duplicate_of  = CI4

CI2: duplicate_of  = CI4

CI3: duplicate_of  = CI4

CI4: Main CI

CI5: duplicate_of  = 
empty

CI4: duplicate_of  = CI5 CI1: duplicate_of  = CI5

CI2: duplicate_of  = CI5

CI3: duplicate_of  = CI5

CI4: duplicate_of  = CI5

CI5: Main CI

◦ If a main CI becomes a duplicate of a CI within the same duplicate CI set, then the selected 
duplicate becomes the main CI in the duplicate CI set. The rest of the duplicate CIs in the set 
are set as duplicates of the new main CI.

Example: Attempt to set a main CI as duplicate of a CI within the duplicate CIs set

CIs Attempted setting Result (System enforced)

CI1: duplicate_of  = CI4

CI2: duplicate_of  = CI4

CI3: duplicate_of  = CI4

CI4: Main CI

CI4: duplicate_of  = CI1 CI1: Main CI

CI2: duplicate_of  = CI1

CI3: duplicate_of  = CI1

CI4: duplicate_of  = CI1

• You can't delete a CI that is the main CI for a set of duplicate CIs. To delete a main CI, you must 
first disassociate that main CI with all of its duplicate CIs. Either delete all duplicate CIs that are 
associated with that main CI, or remove the reference to that main CI from all duplicate_of 
attributes in any duplicate CIs that have it.

CI de-duplication experience in CMDB Workspace

Create libraries of de-duplication templates in CMDB Workspace, to remediate de-duplication 
tasks in a consistent manner, and in bulk. De-duplication templates are pre-configured with all 
necessary settings for remediating de-duplication tasks, per class.

Use the De-duplication dashboard in CMDB Workspace  to see an overview and insights about 
duplicate CIs in your CMDB. The De-duplication dashboard lets you create de-duplication 
templates and organize these templates into libraries. You can also examine de-duplication 
tasks and then run a pre-configured template to remedy multiple de-duplication tasks in a single 
operation.

More information:
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• To learn about general duplicate CI remediation concepts, restrictions, and special cases such 
as remediations that involve a large number of duplicate CIs, see Duplicate CIs remediation.

• To remediate a single de-duplication task using the legacy Duplicate CI Remediator, see 
Remediate a de-duplication task (legacy).

• To learn about Identification and Reconciliation (IRE) processes that detect duplicate CIs and 
other concepts related to duplication CI, see Detecting duplicate CIs.

Access

Role requirement: cmdb_dedup_admin, or any role containing cmdb_dedup_admin (such as 
sn_cmdb_admin).

To access the de-duplication functionality in the CMDB Workspace, navigate to Workspaces  > 
CMDB Workspace  and select Management  in the CMDB Workspace  menu bar. Then select the 
following links in Management tools, in the Manage section:

• De-duplication Dashboard

• De-duplication Template Library

De-duplication templates and libraries

Use a de-duplication template to apply a consistent remediation to multiple, similar, de-
duplication tasks, in a single action. A de-duplication template contains the settings that 
are required to remediate de-duplication tasks for a class. For example, how to choose the 
main CI, which method to use to consolidate attributes, and what to do with the duplicate CIs 
(aside from the main CI) after remediation. A de-duplication template also contains conditions 
that de-duplication tasks are matched on. When you run a de-duplication template, the 
remediation settings in the template are applied to all de-duplication tasks that match the 
template conditions.

To be able to run a de-duplication template, the template must be in a published state (a 
template is initially in a draft state). You can unpublish a published template so it temporarily 
unavailable for use until you republish it.

Organize your de-duplication templates into libraries to group templates by categories that 
are meaningful in your organization and to help locate a template. For example, you can 
create several de-duplication templates, all of which for the same CMDB class such as 
cmdb_ci_win_server. Then, add all those templates to the 'De-duplication templates for 
cmdb_ci_win_server' library for easy access.

De-duplication dashboard

The De-duplication dashboard in CMDB Workspace  is a central location for remediating de-
duplication tasks. Use the dashboard to:

• See all de-duplication templates on a set of cards. Each card shows details about a template. 
On a template card, you can select Assign task  to assign de-duplication tasks to the template, 
and run the template to remediate its associated de-duplication tasks.

• Select Run all  to run all templates, each template remediating its assigned and matching de-
duplication tasks.

• Select View de-duplication tasks  to access a list view of de-duplication tasks with details such 
as the de-duplication template assignment. In the list view, you can select Only show tasks 
that do NOT match any template conditions  to show only those de-duplication tasks that are 
unassigned or unmatched to any template class.
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• Select  the context menu icon and then select  View template libraries  to create and manage 
de-duplication templates and libraries.

• Select the Running  tab to track templates that are currently running.

• Select the Completed  tab to check the status and details about the final state of a run, such as 
Completed, Cancelled, or Completed with errors.

De-duplication insights pane

The De-duplication insights pane on the right side of the De-duplication dashboard provides 
counts and insights related to the ongoing de-duplication processes in your organization. This 
pane provides the following cards and links to help you resolve issues:

• Total count of de-duplication tasks that were remediated in the past week.

• De-duplication tasks that have completed with various types of errors and therefore need your 
attention. Provides the View de-duplication tasks that need your attention  link to access a list 
view of the associated de-duplication tasks. You can examine error messages and drill down 
tasks for further troubleshooting details.

• De-duplication tasks that don't match the conditions in any template and therefore can't be 
assigned for remediation by a template. Provides the View de-duplication tasks that don't 
match  link to access a list view of the associated de-duplication tasks. You can drill down tasks 
for further details.

• Top 5 discovery sources that generate duplicate CIs.

Review the de-duplication templates and ensure that they're properly configured for remediating 
the ongoing duplicate CIs that are being generated in the CMDB by newly added data.

Create a de-duplication template

Create a de-duplication template that you can then run to apply pre-configured and consistent 
remediation to de-duplication tasks, in bulk. Organize your templates in libraries that make sense 
in your organization.

Before you begin
Role required: cmdb_dedup_admin (contained by default in sn_cmdb_admin)

About this task
By default, a newly created template is in draft mode. Therefor, after creating a template, you 
must publish the template to make it available for remediation.

Procedure

1. Navigate to Workspaces  > CMDB Workspace  and then select Management  in the CMDB 
Workspace  menu bar.

2. Select the De-duplication Template Library  link in Management tools, in the Manage section.

3. Optional:  Create a library for the new template.

a. On the De-duplication templates page, select Create a library.

b. In the Create new library dialog box, fill out the Name  and the Description  for the new library.

c. Select Create.

4. On the De-duplication templates page, select Create a template.
On the New template page, configure the different sections of the template by completing the 
rest of the steps.

5. General information: Fill out the form and then select Next.
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Field Description

Name Unique name for the template.

Class CMDB class that this template can be applied 
to.

Template library
Library that the de-duplication template 
belongs to. Select a newly created library or 
any other librarySelect a library, or select the 
'+' icon to create a new library.

Option Description

Automatically select all de-duplication tasks 
that match the selected class

Assign all de-duplication tasks that match 
the template class, to the template for 
remediation.

Add all child classes
Also assign all de-duplication tasks that 
match descending classes of the template 
class, to the template for remediation.

This option is available only if the 
Automatically select all de-duplication 
tasks that match the selected class  option is 
selected.

6. Create condition: Use a condition builder or a custom script to narrow down the list of de-
duplication tasks assigned to the template, and then select Next.
Use script  toggle options:

◦ Off: Specify conditions to filter on CIs from the template class. Only the de-duplication tasks 
containing CIs that match the filter will be assigned to the template.

◦ On: Enter a custom script that returns a valid array of de-duplication tasks sys_ids (from 
the Remediate Duplicate Task [reconcile_duplicate_task] table), that are applicable to the 
template class. Those de-duplication tasks will then be assigned to the template.

Note: 
Ensure that the script runtime doesn't exceed your intended runtime expectation and 
doesn't unexpectedly affect performance. Invalid values returned by the script are 
ignored.

7. Select main CI: Select the method for choosing the main CI from the drop-down list and then 
select Next.
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Note: 

◦ Applying the chosen method to a set of duplicate CIs must result in exactly one CI. If 
during remediation, the chosen method yields no CIs or multiple CIs, then the Newest 
updated  method is automatically applied regardless of your choice.

◦ After selecting the main CI out of the set of duplicate CIs, the main CI is separate from 
the rest of the duplicate CIs. From that point, 'duplicate CIs' refers to all of the initial 
duplicate CIs, aside from the selected main CI.

8. Merge attributes: Configure merging attributes from duplicate CIs into the main CI, and then 
select Next.

a. Select the method to use for merging the attributes of duplicate CIs into the corresponding 
attributes of the main CI.
For each method card on the left (such as Use latest updated CI), select attributes in the list 
on the right, that should be merged into the main CI using that method.

b. Select options as appropriate.

Option Description

Allow null value updates when merging 
attributes to main CIAllow null value updates 
from duplicate CIs to main CI

When merging duplicate CIs into the main 
CI, lets a null value from a duplicate CI to 
overwrite a non-null value in main CI.

Allow updates from duplicate CIs only when 
the main CI value is null

When merging duplicate CIs into the main 
CI:

▪ Prevents updates to main CI attributes 
that have non-null value.

▪ Allows updates to main CI attributes that 
have a null value, with a non-null value.

9. Merge relationships: Select an option for merging relationships from duplicate CIs into the 
main CI, and then select Next.

10. Merge related items: Select the method to use for merging related items associated with the 
duplicate CIs into the main CI, and then select Next.
For information about the default list of related items used in de-duplication processes, see 
Manage default related items list.

11. Duplicate CI actions: Select what to do with the duplicate CIs after they’re merged into the 
main CI, according to the template settings, then select Next.

12. Review and test: Access the following tabs to complete the template by reviewing and testing 
it.

a. Summary: Review all template settings and select Back  to modify any settings.

b. Test: Select a sample de-duplication task and then select Save and Preview Results  to save 
and run the template.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

408



c. Preview the results of the remediation test.

d. Select Save & Exit  to save the template and return to the De-duplication templates home 
page.

Result
The new template is added to the specified library in draft mode and can be edited. However, a 
template in draft mode isn't available for remediation of de-duplication tasks until you publish it.

What to do next

• Publish a de-duplication template

• Run a template to remediate de-duplication tasks

• Remediate a single de-duplication task

Run a template to remediate de-duplication tasks

Run a de-duplication template to remediate de-duplication tasks in bulk. A de-duplication 
template is pre-configured with remediation settings per class. Running a de-duplication 
template, remediates its assigned de-duplication tasks, consistently, according to the template 
settings.

Before you begin
Role required: cmdb_dedup_admin (contained by default in sn_cmdb_admin)

About this task
You can run a single template to remediate its associated de-duplication tasks, or run all 
published templates at once, each remediating its associated tasks. Before running any 
templates, ensure that those templates are properly configured with their remediation settings 
and are properly assigned with de-duplication tasks. De-duplication tasks can be automatically 
assigned to a template based on the template conditions. You can also manually assign 
additional de-duplication tasks to a template.

Procedure

1. Navigate to Workspaces  > CMDB Workspace  and then select Management  in the CMDB 
Workspace  menu bar.

2. Select the De-duplication Dashboard  link in Management tools, in the Manage section.

3. Select a template library in the Ready  tab, or select All libraries  in the libraries drop-down list 
(set to All libraries  by default).
The set of cards is filtered to show only the templates from the selected library, or to show all 
templates from all libraries if you select All libraries  from the drop-down list.

4. Optional:  On the De-duplication templates page, select Run all  to run all de-duplication 
templates on their assigned de-duplication tasks.
To assign de-duplication tasks to a template or to run a single template, continue with the 
following steps.

5. On the De-duplication templates page, locate the card with the template that you want to run 
and select Assign tasks  in that card.

6. Select the tasks in the Available de-duplication tasks list that you want to remediate using the 
selected de-duplication template. Then select Add Selected  to assign the selected tasks to 
the current template.

Available de-duplication tasks lists all open de-duplication tasks, some of which can be non-
compatible with the template. If you try to associate a non-compatible task, an error appears. 
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Some of the tasks in the list might be assigned to another template, and you can reassign 
those to the current template.

The Assigned de-duplication tasks pane on the right contains two tabs:

◦ All matching tasks: Shows de-duplication tasks that match the condition of the selected 
template.

◦ Your selected tasks: Shows the tasks that you’ve assigning to the template for remediation.
The selected tasks are added to the list in the Your selected tasks  tab in the Assigned de-
duplication tasks pane on the right. The template will run for all tasks in the Your selected 
tasks  list and any tasks in the All matching tasks  list that aren't assigned to another template.

7. Select Run template.
The selected template is added to the running queue.

What to do next

• Select the Running  tab to track the progress and details of templates that you added to the 
running queue and are currently running. General counts for the template run appear when 
those counts become available. The templates are sorted by their start time, with the template 
with the most recent start time at the top of the list.

◦ Select Details  (accessible only after all de-duplication tasks have been calculated) to show 
further details about this run and to drill down to de-duplication tasks.

◦ Select Cancel  to stop a template's run. The details for the cancelled template are added in 
the Completed  tab with the state of Cancel Requested. Upon completing the cancellation, 
the state changes to Cancelled.

After a template run completes, its details no longer appear under the Running  tab, but are 
available in the Completed  tab. Also, the completed template is available again for running in 
the Ready  tab.

• Select the Completed  tab to view general counts per template, such as erroneous and skipped 
tasks, and general run time. The templates are sorted by their completion time, with the 
template that completed most recently at the top of the list. Select Details  for a template to 
access a list view of the template's assigned de-duplication tasks. This list view shows details 
for each de-duplication task, such as its state  (color coded)  and error message if applicable. 
You can drill down a de-duplication task for further details.

• Select View de-duplication tasks that need your attention  in the De-duplication tasks 
completed with errors card in the De-duplication insights pane on the right. The De-duplication 
tasks with errors list view shows de-duplication tasks that didn't complete successfully along 
with an error message. You can drill down de-duplication tasks in the list for more details.

Remediate a single de-duplication task

Remediate a single de-duplilcation task using a de-duplication template in CMDB Workspace, or 
using the legacy Duplicate CI Remediator.

Before you begin
Role required: cmdb_dedup_admin (contained by default in sn_cmdb_admin)

Procedure

1. Navigate to Workspaces  > CMDB Workspace  and then select Management  in the CMDB 
Workspace  menu bar.

2. Select the De-duplication Dashboard  link in Management tools, in the Manage section.

3. In the De-duplication templates section, select View de-duplication tasks.
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4. In the De-duplication tasks list view, select the task that you want to remediate.

5. Select Remediate  on the task form.

6. In the Remediate dialog box, choose which method you want to use for remediation, and then 
select Remediate.

What to do next
On the task form:

• Track the progress and the details of remediation in the Activity stream until remediation is 
complete.

• Select the Duplicate Audit Results  tab to see the results of the duplicate audit.

Publish or unpublish a de-duplication template

After creating a de-duplication template, you must publish the draft template to make it available 
to run. You might also need to unpublish a published de-duplication template so it's temporarily 
unavailable for de-duplication remediation, until you republish it again.

Before you begin

• A template that you want to publish must not be in a published state.

• A template that you want to unpublish must be currently published.

• If the template that you want to unpublish is currently running or in the running queue, you 
must wait for the run to complete or cancel the run. In the De-duplication dashboard, select 
the Running  tab, locate the template that you want to unpublish, and then select Cancel  in the 
template's card.

Role required: cmdb_dedup_admin (contained by default in sn_cmdb_admin)

About this task

Procedure

1. Navigate to Workspaces  > CMDB Workspace  and then select Management  in the CMDB 
Workspace  menu bar.

2. Select the De-duplication Template Library  link in Management tools, in the Manage section.

3. In the libraries pane locate the template that you want to publish or unpublish and then either:

a. Publish: Ensure that all the sections of the template are complete and select Publish.

b. In the Publish template dialog box, select Publish.

c. Unpublish: Select Unpublish  and in the Unpublish template dialog box, select Unpublish.

Result
A published template:

• Becomes available on the De-duplication templates page and can be used for remediation.

• Can't be edited or retired.

An unpublished template is set back into draft mode:

• Is no longer available on the De-duplication templates page and can't be selected for 
remediation.

• Can be edited or retired.
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Retire a template

Retire a template that is no longer needed for remediating de-duplication tasks.

Before you begin
The template that you want to retire must be in an unpublished state.

Role required: cmdb_dedup_admin (contained by default in sn_cmdb_admin)

Procedure

1. Navigate to Workspaces  > CMDB Workspace  and then select Management  in the CMDB 
Workspace  menu bar.

2. Select the De-duplication Template Library  link in Management tools, in the Manage section.

3. In the library pane, select the template that you want to retire  and then select Retire.

4. Select the template's context menu and then select Retire template.

5. In the Retire template dialog box, select Retire.

Result
A retired template is no longer available in the De-duplication dashboard and can't be used for 
remediation.

Review de-duplication tasks  (legacy)

Review details of de-duplication tasks, and then potentially remediate a de-duplication task.

Before you begin
Role required: itil to view, and itil_admin or cmdb_dedup_admin to remediate a de-duplication 
task.

About this task
Alternatively, you can use de-duplication capabilities in the CMDB Workspace. Use the De-
duplication dashboard and the De-duplication Template Library to:

• Review de-duplication tasks

• Remediate de-duplication tasks in bulk by using de-duplication templates

• Gain insights into de-duplication counts and status in your organization

For more information, see CI de-duplication experience in CMDB Workspace.

If a duplicate CI is a dependent CI, then you can view the details of the dependent relationship, 
the Depend on CI, and any relation qualifier chain. If the dependent CI has a lookup table, then 
you can see the details of the respective lookup table.

Procedure

1. Navigate to All  > Configuration  > Identification/Reconciliation  > De-duplication Tasks.

2. Select a task.

Remediate Duplicate Task form

Field Description

Number Unique task number.

Assigned to Person who is responsible for resolving the task.
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Field Description

Short 
description

Description for the task.

Work notes
Details describing how the CI was identified as a duplicate.

Note: 
Not available in de-duplication tasks that were created prior to the 
London  release.

This field also contains user notes about the decisions and steps of 
resolving the task.

Priority Task priority.

State State of the de-duplication task as it progresses through resolution.

3. In the related lists section, click the Duplicate Audit Results  tab to see the list of duplicate CIs 
in this task.
You can click a CI to display more CI details.

Column Description

Duplicate CI Reference to the duplicate CI.

Note: 
This field is a document ID type, which means that it can reference any 
record on any table. If the referenced CI is deleted as part of resolving 
duplicate tasks, then this field is empty.

Relationship For a duplicate CI that is a dependent CI, this field shows the relationship 
between the duplicate CI and depend on CI.

Depend on 
CI

If the duplicate CI is a dependent CI, then this field displays the depend on CI.

Discovery 
source

Discovery method used for the CI.

What to do next
Analyze de-duplication tasks to determine which CIs should remain active and which of the 
duplicate CIs in the Duplicate Audit Results lists are stale or incorrect. Click Remediate  to 
remediate a single de-duplication task.

Related topics

Relation qualifier

Document ID field

Remediate a de-duplication task  (legacy)

Remediate a single de-duplication task by using the Duplicate CI Remediator wizard. Use 
the wizard to guide you through the duplicate CI reconciliation process or to apply a custom 
workflow.
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Before you begin
Review the following topics to familiarize yourself with important concepts of duplicate CI 
remediation:

• Duplicate CIs remediation  to learn about general duplicate CI remediation concepts, 
restrictions, and special cases such as remediations that involve a large number of duplicate 
CIs.

• Properties related to remediation of duplicate CIs  for information about important 
properties that affect processes of duplicate CI remediation. Including the 
glide.duplicate_ci_remediator.dry_run property that determines if the Duplicate CI Remediator 
actually updates the CMDB or not.

Role required: itil to read, itil_admin or cmdb_dedup_admin to write

About this task
Instead of using the legacy build of the Duplicate CI Remediator on Core UI, you can use the 
De-duplication dashboard, and de-duplication templates and libraries, available in CMDB 
Workspace. Using de-duplication capabilities in CMDB Workspace  is especially useful for bulk 
remediation of de-duplication tasks. These capabilities let you pre-configure a de-duplication 
template with remediation settings, which can then be applied in a consistent manner to 
multiple de-duplication tasks. For more information, see CI de-duplication experience in CMDB 
Workspace.

As you progress through the tabs of the Duplicate CI Remediator, CIs are not updated. All 
updates are applied only in the final step, after you click Remediate.

Note: 
Remediation behaves differently when remediation involves a large number of duplicate 
CIs or where the duplicates are serial numbers. For information about special cases in 
remediation, see Duplicate CIs remediation.

Procedure

1. Navigate to All  > Configuration  > Identification/Reconciliation  > De-duplication Tasks.

2. Open the de-duplication task that you want to remediate.

3. On the task form, select Remediate.

4. In the Remediate dialog box, select either of the following options:

◦ Use the Duplicate CI Remediator (Recommended): Use the wizard to consolidate duplicate 
CIs according to your configurations and settings. Follow the Duplicate CI Remediator tabs 
to configure the reconciliation.

Note: 
This option is not available with non-CMDB tables.

◦ Use a custom remediation workflow: Use an existing CMDB remediation rule or select Add 
New  to create a new one.

▪ On the CMDB Remediation Rule form, set Task type  to Remediate Duplicate Task 
and select Active.

▪ On the Workflow form, set Table  to Remediate Duplicate Task [reconcile_duplicate_task] 
and If condition matches  to None.

▪ Ensure that the associated workflow remediates duplicate CIs.
In the Remediate dialog box, select Next  to start the workflow and to exit the Duplicate CI 
Remediator. The Remediate Duplicate Task form appears, where you can update the State  of 
the task.
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◦ Use the Duplicate CI Remediator (Restricted Mode): Appears only if the 
glide.duplicate_ci_remediator.enable_restricted_mode  system 
property is set to true. You might need to use this option if remediation is blocked because 
loading the de-duplication task times out. This option might be relevant when there is a 
large number of related items associated with a de-duplication task, allowing remediation 
to continue with the limited features in a restricted mode. For more information about using 
this option to restrict the use of related items in de-duplication remediation and allow 
remediation to proceed, see Using restricted mode within the Duplicate CI Remediator 
[KB1542272] .

5. On the Select Main CI  tab in the Duplicate CI Remediator:

a. Select the main CI for this reconciliation using either of the following lists of duplicate CIs.
For any CI, you can click the Name  link to display the CI's attributes, or click the Related 
Items  link to display the number of related items.

▪ Recommended: A subset of the All  list, containing only system recommended main CIs. 
System recommendations are based on checking the duplicate CIs for the following 
criteria:

▪ CI with most related items.

▪ CI with most relationships.

▪ Newest discovered CI.

▪ Newest updated CI.

▪ Oldest created CI.

▪ Previous main CI, if one was previously selected.

▪ All: All duplicate CIs for the de-duplication task.

Either option lets you review a summary of the remediation settings before starting the 
remediation.

b. Select one of the following options to choose whether to consolidate any attribute values, 
relationships, or related items from any of the duplicate CIs into the main CI:

▪ Remediate Manually: Lets you specify which attribute values, relationships, and related 
items from duplicate CIs to consolidate into the main CI.

▪ Use Main CI: Retains main CI attribute values, merges relationships, and merges only the 
default related items.

Skip to step number 7 as this selection skips all configurations other than choosing the 
action for the duplicate CIs on the Determine Duplicate CI Actions  page.

6. On the Merge Attribute Values  tab review inconsistent values of each attribute.
For each attribute, choose to retain the main CI's value, or choose a value from a duplicate CI 
for the main CI to be set with.

7. Select Next.

Column Description

Attribute Attribute for which there are different values.

Main CI Value Attribute  value in the main CI.
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Column Description

Other Values The number of unique Attribute  values within 
the duplicate CIs.

To override the main CI attribute value with a duplicate CI value:

a. Click the Other Values  link.

b. In the attribute dialog box, click Unique Values  to display only unique attribute values, or All 
to display all attribute values including identical values.

c. Select a value for the main CI Attribute  to be set with.
You can click Reset to Original  to undo the selection of a different attribute value for the 
main CI.

d. Click Select.

Note: 
Attributes, such as system fields, discovery fields (discovery_source, 
last_discovered, first_discovered), and read-only fields (such as the asset 
field) do not appear in the list.

8. On the Merge Relationships and Related Items  tab:

a. In the Merge Relationships section, select whether to merge all relationships from all 
duplicate CIs into the main CI.
Click View all relationships  to display all the relationships in which a duplicate CI is a 
parent or a child. You can click a Parent  or a Child  link to display more details. Orphan and 
duplicate relationships of duplicate CIs are deleted if you choose to merge relationships. 
For more information about the CMDB Health relationship KPI, see CMDB Health KPIs and 
metrics.

b. In the Merge Related Items section use the slushbucket to select related items to be merged 
into the main CI. Click View all related items  to display all related tables (items) and the 
count of references in each table to one of the duplicate CIs. You can click the links in Main 
CI Related Items  and Duplicate CIs Related Items  to display details about the related items.

Related items in the slushbucket have the following 

format:
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▪ By default, all items in the default related items list are selected to be merged.

▪ Related items (tables) that have no references to a duplicate CI are not listed, unless that 
table is included in the default related items list.

▪ Since asset related tables are part of the exclusion list, they are not available for merge.

See Manage default related items list  for more information about configuring a default list of 
related items.

c. Click Next  .

9. On the Determine Duplicate CI Actions  tab, choose one of the following actions to perform 
after completing the reconciliation, then click Next.

◦ Set attributes to custom values  (recommended): Retain all duplicate CIs. Mark the duplicate 
CIs as invalid by setting a specific Attribute  to a specific Value  for all duplicate CIs. For 
example, set Operational Status  to Retired  to retire the duplicate CIs.

The duplicate_of  attribute of the duplicate CIs is automatically set to the appropriate 
main CI. Also, the duplicate CIs will not be added to any de-duplication task after this task 
is remediated. If the identification engine is not configured to skip duplication, ensure 
that identification inclusion rules are configured to exclude the duplicate CIs during 
identification. This configuration prevents new de-duplication tasks with the same duplicate 
CIs from being created after remediation.

Note: 
Discovery fields, system fields, read only fields, and date fields are excluded from the 
attributes list.

◦ Delete: Delete all duplicate CIs (only the main CI remains).

Note: 
Review Roll back and delete recovery  for information about reverting the deletion of 
CIs and related records.

10. On the Review and Confirm  tab:

a. Review the summary of the expected updates for this duplicate CIs reconciliation. Updates 
are based on your selections and therefore the summary includes only the details that are 
applicable. This summary can include details of the relationships and related items that 
will be merged to the main CI, the attribute values that the main CI will be set with, and 
the number of CIs that will be deleted.  Click Attributes, Relationships, Related Items, or 
Duplicate CI Actions  if applicable, to display further details such as changes to attribute 
values.

b. Click Remediate  to complete the reconciliation according to your reconciliation settings.
Once complete, the task State  is set to Closed Complete.

Result
The following relationships are deleted without being merged to the main CI:

• Relationships in which the type, child, or parent field is empty.

• Relationships for which merging to the main CI will result in cyclic relationships.

• Relationship for which merging to the main CI will result in duplicate relationships.
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What to do next
The reconciliation process runs in the background and may take a while to complete. Upon 
completion, the system sends a confirmation notice to the remediator of the task. Meanwhile, 
you can:

• Review Identification Rules: Review identification and inclusion rules and make any 
necessary updates to reduce CI duplication.

• Check Progress: View the task activities that are logged as the remediation progresses.

• View Main CI: View the main CI for this reconciliation process.

Manually create a de-duplication task

Manually create a de-duplication task when it is not automatically created. You can then use the 
Duplicate CI Remediator or the De-duplication dashboard in CMDB Workspace  to remediate the 
manually created task.

In some situations, duplicate CIs are not automatically detected and de-duplication tasks are not 
automatically generated. Such situation happens with a class for which identification rules are 
not defined and the identification engine cannot be applied. However, you still want to reconcile 
these duplicate CIs by utilizing the Duplicate CI Remediator  or the De-duplication dashboard  in 
CMDB Workspace.

Use the CMDBDuplicateTaskUtils  API to manually create a de-duplication task in which 
all duplicate CIs are specified. The de-duplication tasks that you create manually and the 
automatically created tasks, are stored in the same table ([reconcile_duplicate_task]) and are 
processed in the same manner.

Note: 
You can manually create a de-duplication task only for CMDB CIs and a CI can be specified 
as a duplicate CI only in a single de-duplication task.

Manage default related items list

You can add or remove items from the default list of related items which is used in duplicate CI 
remediation for all de-duplication tasks.

Before you begin
Role required: itil_admin

About this task
The default related items list is used by the Duplicate CI Remediator, appearing on the Merge 
Relationships and Related Items  tab. You can modify the list for only a specific task in the 
Duplicate CI Remediator without affecting the default global list.

The default related items list is also used by the De-duplication dashboard  in CMDB Workspace 
for remediation.

Globally modifying the list affects the remediation of all de-duplication tasks in the Duplicate CI 
Remediator  and in the De-duplication dashboard in CMDB Workspace.

Note: 
Only related items in which the reference field points to Configuration Item [cmdb_ci] in 
sys_dictionary  can be selected for the default related items list. Related items with 
references to any child of the Configuration Item class cannot be selected for the default 
related items list, but are still available for merging in the Duplicate CI Remediator for a 
specific task.
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Procedure

1. Navigate to All  > Configuration  > Identification/Reconciliation  > Duplicate CI Remediator 
Default Related Items.

2. On the Default Related Items List for Duplicate CI Remediator page, use the slushbucket to add 
or remove items from the Selected  list.

3. Click Save.

Properties related to remediation of duplicate CIs

Use de-duplication properties to configure how remediation of duplicate CIs works when using 
the Duplicate CI Remediator  or the De-duplication dashboard in CMDB Workspace.

To view and edit these properties, the admin role is required.

Although the properties below reference the Duplicate CI Remediator, these properties have an 
equivalent effect in duplicate CI remediation in CMDB Workspace.

Property Description

Attributes in which max_length  exceeds this 
property value (4000 by default) are excluded from 
the Select Main CI, Merge Attribute Values, and 
Determine Duplicate CI Actions  tabs in the Duplicate 
CI Remediator wizard.

glide.duplicate_ci_remediator.max.field_length

If the max_length  for an attribute is equal to the property value, and the size of the data exceeds the property value, then the 
data is truncated to the property value and the attribute appears in attribute lists.

• Type: integer

• Default value: 4000

• Location: Configuration  > CMDB Properties  > Duplicate CI Remediator Properties

Note: 
This property impacts the performance of de-duplication tasks, therefore be cautious about setting this value.

Comma separated list of related tables in the format 
'<table>.<reference column>', that are excluded from 
merging during duplicate CI remediation.

glide.duplicate_ci_remediator.related_items_blacklist

• Type: string

• Default value: 
cert_task.cmdb_ci,cert_audit_result.configuration_item,discovery_log.cmdb_ci,alm_hardware.ci,alm_asset.ci,fm_expense_line.ci

• Location: Configuration  > CMDB Properties  > Duplicate CI Remediator Properties

Threshold for the number of duplicate CIs, which if 
exceeded, support for reconciliation in the Duplicate 
CI Remediator is limited (1,000 by default).

glide.duplicate_ci_remediator.max.cis

• Type: integer

• Default value: 1000

• Location: Configuration  > CMDB Properties  > Duplicate CI Remediator Properties

• Learn more: See 'Large number of duplicate CIs' in Remediate a de-duplication task (legacy).

This threshold never exceeds 5,000, even if you set the property to a value greater than 5,000.

Determines whether the Duplicate CI Remediator 
actually remediates CI duplication by updating 
records in the CMDB, or not.

glide.duplicate_ci_remediator.dry_run

When set to false (default value), updates specified in the wizard are actually performed.

You can set this property to true and then test run through the Duplicate CI Remediator without any records actually being 
updated. In this case, the work notes for the task describe the changes that will happen in an actual remediation.

• Type: true | false

• Default value: false

• Location: Configuration  > CMDB Properties  > Duplicate CI Remediator Properties
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Property Description

glide.duplicate_ci_remediator.enable_restricted_mode
Enables restricted mode remediation in the Duplicate CI Remediator. This option restricts the use of related items in de-
duplication remediation and allows a blocked remediation to proceed using the Use the Duplicate CI Remediator (Restricted 
Mode)  option. For more information, see Using restricted mode within the Duplicate CI Remediator [KB1542272] .

• Type: true | false

• Default value: false

• Location: Add to System Properties [sys_properties]

• Learn more: Remediate a de-duplication task (legacy)

Set to true  to enable restricted mode remediation.

Components installed for duplicate CI remediation

Tables installed to support duplicate CI remediation (included in the com.snc.cmdb plugin).

Tables installed

Table Description

Remediate Duplicate Task

[reconcile_duplicate_task]

De-duplication tasks.

Duplicate Audit Result

[duplicate_audit_result]

CIs associated with each de-
duplication task.

Duplicate CI Remediation

[cmdb_duplicate_ci_remediation]

Input, selections on each tab, 
overall status of remediation, 
and results of each run of the 
Duplicate CI Remediator.

CMDB Workspace De-duplication template library

[sn_cmdb_ws_reconcile_duplicate_template_library]

Library names and their 
descriptions.

De-duplication template suggested task

[sn_cmdb_ws_reconcile_duplicate_template_suggested_task]

Mappings of de-duplication 
tasks to templates.

Scheduled jobs installed

Scheduled job Description

De-
duplication: 
Populate 
Duplicate Task 
Data

Runs daily to copy metadata, such as the identification attributes and 
identification rules used in generating a de-duplication task, into an easily 
accessible table. The metadata is stored in the Reconcile Duplicate Task 
Data [reconcile_duplicate_task_data] table and used for analytics for the De-
duplication dashboard.
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Scheduled job Description

De-
duplication: 
Populate 
Template Task 
Run Records

Runs every minute to evaluate the de-duplication tasks applicable for a 
template according to your settings. Based on settings, assigns matching 
tasks and manually added tasks to the template for remediation.

De-duplication tasks are remediated after you select Run template.

De-
Duplication: 
Template 
Scheduler

Runs every minute by the template scheduler to check the capacity of the 
execution engine. If there is available capacity, picks any new de-duplication 
tasks added to the queue, for remediation.

De-duplication tasks aren't remediated and remain in ready state unless this 
job runs periodically.

De-
duplication: 
Populate 
Template 
Suggested 
and Orphan 
Tasks

Runs hourly to count the number of tasks that match each published template 
and the number of tasks that don’t match any published template. These 
counts then appear on various cards in the De-duplication dashboard.

CIs attestation

Verify the existence of actual IT infrastructure and applications that you own, systematically 
and in bulk. As CIs are continuously ingested into the CMDB from various data sources, ensure 
the integrity of the CMDB. Remove any stale CIs that are associated with IT infrastructure or 
applications that no longer exists.

Use the CMDB Data Manager in CMDB Workspace  to create an Attestation policy, specifying 
CIs that need to be attested and the attestation frequency. Assign Attestation tasks to users 
that are familiar with or that manage the CIs, and who can attest or reject the IT infrastructure 
or applications that those CIs represent. Rejected CIs that are no longer needed can then be 
retired, archived, or deleted from the CMDB.

Users can go to the My Work view in CMDB Workspace  to see their assigned attestation tasks, 
and then review and process the tasks.

Smart detection and auto-attestation

Smart detection  streamlines and simplifies CI attestation. With smart detection you can auto-
attest  CIs that are automatically detected by discovery programs, based only on recent discovery 
results.

The following conditions must be met to enable smart detection:

• Discovery  is enabled in your organization or Getting started with Service Graph Connectors 
are implemented.

• The system property sn_cmdb_ws.attestation.smart_detection.disabled  is 
set to false  (default value).

In addition, smart detection uses the following system properties as filters when creating a list 
of CIs that are candidates for auto-attestation. To be included as candidates for auto-attestation, 
CIs must be discovered:
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• Within the discovery time window specified by the 
sn_cmdb_ws.attestation.smart_detection.discovery_window  system 
property (for example, within the last 30 days)

• By any discovery source that isn't excluded by the 
sn_cmdb_ws.attestation.smart_detection.discovery_source.exclusion 
system property

Then, when you review those candidate CIs, you can choose to auto-attest them.

Properties associated with Attestation

Property Description

sn_cmdb_ws.attestation.smart_detection.disabled Disables smart 
detection.

• Type: true | false

• Default value: false

• Values:

◦ true: Disable smart 
detection.

◦ false: Enable smart 
detection.

• Location: Add to 
System Properties 
[sys_properties]
table.

• Learn more: Review 
CMDB Data Manager 
attestation tasks

sn_cmdb_ws.attestation.smart_detection.discovery_source.exclusion
Comma-separated list of 
discovery sources that 
are excluded in smart 
detection processing. 
For example, a data 
source that is unreliable 
in detecting CIs.

CIs discovered by 
discovery sources in the 
list, can't be candidates 
for auto-attestation.

• Type: string

• Default value: Manual 
Entry
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Property Description

• Location: System 
property

• Learn more: Review 
CMDB Data Manager 
attestation tasks

sn_cmdb_ws.attestation.smart_detection.discovery_window
Number of days 
(discovery window) that 
smart detection uses 
to determine whether 
a CI is a candidate 
for auto-attestation. 
Only CIs that were 
discovered within this 
discovery window can 
be candidates for auto-
attestation.

• Type: integer

• Default value: 30

• Location: System 
property

• Learn more: Review 
CMDB Data Manager 
attestation tasks

Review CMDB Data Manager attestation tasks

Review attestation tasks that are assigned to you or to an assignment group that you belong to 
in accordance with CMDB Data Manager Attestation policies. Check the physical existence of IT 
infrastructure or applications associated with CIs in the attestation task and then process those 
CIs as appropriate.

About this task
For managers, tasks of direct reports are included, and for user group managers, tasks of 
members in the group are also included.

Before you begin
Role required:

• CMDB administrator: data_manager_admin, sn_cmdb_admin (already includes the 
data_manager_admin role)

• CI and service owner or manager: data_manager_user, sn_cmdb_user (already includes the 
data_manager_user role)

About this task
After you receive notifications about attestation tasks assigned to you, check the actual IT 
infrastructure or applications that you own, and then process the CIs in the task accordingly. 
Initially, all the CIs in the attestation task are listed in a Not Yet Reviewed list and therefore require 
attestation. Attested CIs are then moved to an Attested CIs list, while CIs you reject are moved to 
a separate Rejected CIs list. After processing all the CIs in the task, you can submit and complete 
the task. For general information about attestation and the flow of attestation, see CIs attestation.
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As you process the CIs in the task, details of your activities are captured in the activity stream of 
the task.

Attesting tasks is performed in the My Work  view in the CMDB Workspace store app.

Procedure

1. Navigate to Workspaces  > CMDB Workspace  and then select My Work  in the CMDB 
Workspace  menu.
Any attestation tasks that are assigned to you or to assignment groups you belong to, appear 
in the Attestation tasks  tab in the My tasks section. Attestation tasks are associated with 
details such as the due dates and short descriptions for those tasks. Assignment groups that 
you are a member of, are also listed.

2. Select a task to review  from the Attestation tasks list.  For a bulk review, select multiple tasks or 
check the box next to 'Configuration Item' to review all the tasks in the list.

3. Review details of a task:

a. Optional:  Administrators can select Cancel task  if attesting the CIs in the task isn't needed.
For example, if the task was created by error. The canceled task is deleted without any 
further processing.

b. Optional:  If the task isn't properly assigned, click Reassign  and then select one of the 
following options.
Depending on your selection, the task might no longer be assigned to you.

▪ To me: If the task isn't yet assigned to a specific user and you are the owner of the CIs who 
can process the task.

▪ (Optional) To other user: If you aren't the actual owner of the CIs and there is someone 
else that is more appropriate as the owner for the task. In the Reassign to other user dialog 
box, set Assign to  to that user and enter the reason for the reassignment. Then click 
Proceed.

For a CI owner, only users from the assignment group that the task is currently assigned to, 
appear. For Admins, all users with the data_manager_user role appear.

▪ Send for reassignment: If you aren't the appropriate user for this task and the 
administrator needs to assign the task to someone else. In the Send for reassignment 
dialog box, enter the reason for the operation and then click Submit  to send a notification 
to the administrator.

c. Click Review CIs to attest  to continue the CI attestation process.
If the task is not assigned to anyone, it is automatically assigned to the current user.

4. Optional:  If the Smart detection dialog box appears, click Review  to review the CIs or Auto-
attest  to attest the detected CIs without a review.
If you click Cancel, you can later click Run auto-attestation  in the Smart detection widget. 
When reviewing the CIs to attest, the list in the Smart detection pane is filtered to CIs that are 
candidates for auto-attestation, letting you auto-attest all those CIs in bulk.

a. Review the details of the CIs in the list.

b. Optional:  Click Auto-attest  to automatically attest all the CIs in the list and to move them to 
the Attested CIs list.

c. Optional:  Click Cancel auto-attestation  to leave all the CIs in the Not Yet Reviewed list and 
to later continue attesting those CIs regardless of smart detection.
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5. Review the CIs in the Not Yet Reviewed list.
You can click a CI to open a dashboard with more details such as CI health, key properties, 
and CMDB 360 data. The details that appear on the CI dashboard depend on settings and 
activation of different features.
Use the following cards on the right hand bar to get help and status:

◦ Click Attestation actions ( ) to get help on the possible actions you can take while 
reviewing CIs.

◦ Click Attestation status ( ) to see your progress in reviewing and attesting CIs.

◦ Click Smart detection status ( ) to see if any CIs are candidates for auto-attestation and 
to apply auto-attestation if applicable.

6. In the Details tab of the Attestation Review CIs pane, select the CIs that you are ready to 
process and select an action to apply to all selected CIs.

◦ Select the CIs that you can attest their existence and click Attest  to move them to the 
Attested list.

To undo attestation, select the Attested list, select the CIs that you want to move back to 
the Not Yet Reviewed list and click Unattest. Or, select the CIs that you want to move to the 
Rejected list and click Reject.

◦ Select the CIs that you can't attest their existence and click Reject  to move them to the 
Rejected list. In the Confirm rejecting CIs dialog box, enter an explanation and then click 
Proceed.

To undo rejection, select the Rejected list, select the CIs that you want to move back to the 
Not Yet Reviewed list and click Unattest. Or, select the CIs that you want to move to the 
Attested list and click Attest.

◦ Select the CIs that shouldn't be included in this task and in future Data Manager attestation 
policies, and click Exclude. In the Confirm excluding CIs dialog box, enter an explanation 
and then click Proceed.

Those excluded CIs are added to the exclusion list of CMDB Data Manager attestation 
policies. For more information, see Manage exclusion lists of CMDB Data Manager. Only an 
admin can undo this operation using the CMDB Data Manager.

◦ Select any CIs that you identify as duplicates of other CIs and click Remove duplicates from 
task. In the Confirm removing duplicate CIs dialog box, enter an explanation and then click 
Proceed.

Those duplicate CIs are removed from the attestation task and a de-duplication task is 
generated for them, which is similar to the de-duplication tasks created by the Identification 
and Reconciliation Engine (IRE). For more details about how to process and remediate de-
duplication tasks, see Duplicate CIs remediation.
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Note: 
Only an admin can undo this operation.

◦ After processing all the CIs in the task, when the Not Yet Reviewed list is empty, the Submit 
button is enabled. Click Submit, and then in the Submit attestation dialog box click Submit 
to close the task.

Data Certification

Data Certification manages scheduled and on-demand validations of data in CMDB and non-
CMDB tables.

Information is added to the CMDB by Discovery, by importing from third-party tools, or manually. 
For regulatory or procedural reasons, information in the CMDB requires checks for accuracy 
and certification. The person or team responsible for certification can define what information 
requires verification and a verification schedule. The schedule then generates a checklist for 
verifying the data. Individuals assigned to certification tasks answer a series of questions to 
verify the data.

Data certification can be performed against specific fields on specific tables. Based on the 
certification schedule, certification tasks are automatically created and assigned. For example, 
you can set up a certification to validate key information fields, such as Operating System  and 
CPU count, on all Windows  servers located in Chicago. You can then assign the tasks to the 
appropriate team member automatically.

Domain separated systems can use the Data Certification application.

Data Certification experience in CMDB Workspace

You can use the CMDB Workspace  landing page and its views to fully administer and use Data 
Certification, view various analytics, and handle Data Certification tasks such as:

• Create a Data Manager Certification policy.

• Convert legacy certification schedules into Data Manager Certification policies.

• Review certification tasks in CMDB Workspace.

• Review failed certification tasks in CMDB Workspace.

The Data Certification experience in CMDB Workspace  doesn’t provide functionality such as 
reset, merging of multiple Data Certification tasks, and escalation.

For more information about using Data Certification in CMDB Workspace, see Data Certification 
experience in CMDB Workspace.

Data Certification on Core UI (UI 16)

Data Certification experience in CMDB Workspace  provides the latest Data Certification 
functionality. However, the legacy build of Data Certification on Core UI (UI 16) is available by 
navigating to All  > Data Certification. For information about using the CMDB Data Manager 
legacy build on Core UI, see Data Certification on Core UI.
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Note: 

Data Certification in CMDB Workspace  and the legacy build of Data Certification on Core 
UI operate separately, and aren't synchronized. Therefore, any Data Certification elements, 
such as definitions and schedules, that you create in one of those implementations, doesn't 
appear and isn't included in the other implementation.

To convert data created in the legacy build of Data Certification on Core UI, into draft 
Certification policies in CMDB Workspace, see Convert legacy certification schedules into 
Data Manager Certification policies.

Data Certification experience in CMDB Workspace

Use Data Certification in CMDB Workspace  to administer Data Certification, create Certification 
policies, manage Data Certification tasks, and view analytics about ongoing processes.

Note: 
Data Certification in CMDB Workspace  and the legacy build of Data Certification on Core UI 
operate separately, and aren't synchronized. Therefore, any Data Certification definitions, 
such as filters and certification schedules, that you create in one of those implementations, 
doesn't appear and isn't available in the other implementation.

Data Certification experience in CMDB Workspace

Use the CMDB Workspace  landing page and its views to administer Data Certification:

• Use the Management view in CMDB Workspace  to navigate to CMDB Data Manager to create a 
new Certification policy.

• Use the My work tile on the CMDB Workspace  landing page to access your open and overdue 
Certification tasks that you need to review and process.

• Use the My Work view in CMDB Workspace  to access any Data Certification tasks assigned to 
you under the Certification tasks section.

Manage certification tasks in CMDB Workspace:

• Review Certification tasks in CMDB Workspace

• Review failed certification tasks in CMDB Workspace

Convert legacy certification schedules into Data Manager Certification policies

Convert certification schedules created in the legacy Data Certification application (running on 
Core UI), into draft Data Manager Certification policies available in CMDB Workspace.

Before you begin
Role required: data_manager_admin or sn_cmdb_admin

About this task
If you have been using the legacy Data Certification application on Core UI, then any associated 
certification schedules aren't available in the new implementation of Data Certification in CMDB 
Workspace  version 6.0. You can convert those definitions into draft Data Manager Certification 
policies. Then you can publish the converted policies in CMDB Workspace  just like publishing 
any draft Data Manager policy.

Important things to know:
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• Legacy certification schedules that were successfully converted are automatically deactivated.

• This conversion migrates most fields from the legacy certification schedule. However, the 
Assign to empty  and the Last run date  fields aren't migrated into CMDB Workspace 
Data Manager tables.

• Any dot-walking settings in the legacy certification schedules used for assignments of User 
Field  or User Group Field  are preserved in this conversion.

Procedure

1. Navigate to All  > Workspaces  > CMDB Workspace  and then select Management in the CMDB 
Workspace  menu bar.

2. Select the Data Manager  link in Management tools, in the Manage section.

3. On the Data Manager overview page, select Import  on the banner at the top of the page.
If there aren't any legacy certification schedules to import, the notification banner about 
importing existing policies doesn't appear.

4. In the Confirm import of certification schedule into draft policies, select Import into draft 
policies.

a. Track progression in the Import in progress dialog box.

b. Review the import results in the Import summary dialog box.

If there were earlier conversion operations, the results reflect only the current conversion 
operation. For example, the Completed count includes only those records that were 
successfully converted in the current run.

Select the links associated with the completed and skipped results to drill down to the 
associated records.

Also, to see additional details, select All  and in the Filter navigator, enter 
cert_schedule.list  to open the Certification Schedules table. The Migration 
Status  and the Migration exception  columns provide details that are especially 
important for failed and skipped records.

c. Select View draft policies  to view the converted policies in the Data Manager policies page, 
under the Draft policies tab.

5. Optional:  Publish a draft Data Manager policy in CMDB Workspace

Result

• If you log in while this conversion is in process, a progress message appears on the Data 
Manager overview page. You can select the View details  link to open the Import in progress 
dialog box with details about the progress of the operation.

• The legacy certification schedules are available as draft Certification policies in Data Manager 
in CMDB Workspace.

• The legacy certification schedules are deactivated.

• The legacy certification tasks are unchanged and you can review and resolve them as needed.

Review certification tasks in CMDB Workspace

Review the values of record fields and CI attributes in certification tasks assigned to you, and 
then certify, edit, or fail the review according to your findings.  For managers, tasks of direct 
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reports are included, and for user group managers, tasks of members in the group are also 
included.

Before you begin
Role required: sn_cmdb_user, sn_cmdb_editor, or sn_cmdb_admin

About this task
If a certification task isn't properly assigned, you can reassign it to another user if you know who 
the appropriate reviewer is, or request an administrator to reassign the task.

Note: 

• If the policy is configured to disallow empty attribute values, you will only be able to 
fail certification of the associated CIs, but you won't be able to certify them unless you 
populate the empty attributes first.

• If the policy is configured to disallow updates to field values, you won't be able to update 
non-compliant CIs, resulting in failing their certification.

Procedure

1. Navigate to Workspaces  > CMDB Workspace, then select My Work  in the CMDB Workspace 
menu bar.

2. Optional:  In the My tasks section, you can select multiple tasks to reassign tasks in bulk.

a. Select the Certification tasks tab, then the task or tasks that you want to reassign.

▪ Select Reassign: Reassign a task to another group or user if you aren't the appropriate 
user to review the field values and you know who the appropriate reviewer is.

▪ Assignment group: Select the assignment group the user belongs to.

▪ Assign to:  Search for the appropriate reviewer to reassign this task to.

▪ Submit a reason for this action: Enter a reason why you are reassigning the task.

▪ Select the Reassign  drop-down menu then select Assign to me: Assign the task that isn't 
assigned, to yourself, if you are the appropriate reviewer for this task.

▪ Select the Reassign  drop-down menu then select Request reassignment: Request to 
reassign the task, that is assigned to you incorrectly, to someone else. Enter a reason why 
the task needs to be reassigned, then select Submit.

b. Select Proceed.

3. In the Certification tasks tab, select the certification task that you want to review.

4. Review the details of the certification task, then select Review records to certify.

Note: 
You can reassign the tasks on this page, see Step 2 to review the reassignment options.

5. Select the records that you want to conclude the review for in the Review not completed tab, 
and then select Certify  or Fail.

You can select all the records showing on the page for bulk processing by selecting the check 
box in the first column header, and then selecting the Select all <n> item/s in this list  link that 
appears.
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◦ The review conclusion of certified or failed is applied in bulk only to those certification fields 
in the selected records, which are still pending a review. For example, a certification field that 
is already marked as certified, isn't affected by selecting Fail. Only the unreviewed fields are 
marked as failed. Records whose review is concluded are moved to the Review completed 
tab.

◦ If the policy is configured to disallow empty attribute values, then CIs with empty fields won't 
be certified when you select Certify. In this situation, to certify those CIs, you must first 
populate the empty attributes.

The review conclusion of certified or failed is applied in bulk only to those certification fields 
in the selected records, which are still pending a review. For example, a certification field that 
is already marked as certified, isn't affected by selecting Fail. Only the unreviewed fields are 
marked as failed. Records whose review is concluded are moved to the Review completed tab.

6. Select the records that you want to review in details and then select Review records.

A check mark next to a column header, denotes the fields whose values are included in this 
certification review (certification fields). All other columns show additional fields that are 
included only to help you identify records (display fields).

When you select records (or CIs) to review, the fields (or attributes) for the selected records 
appear on the right, in a separate field review section. When you select a single record to 
review, the field values of the selected record appear. When you select multiple records to 
review, the field values don't appear. In that section, select the fields to apply your review 
results, or select Select all fields  to apply the review results to all fields.

7. Select Submit  when all the records have been reviewed.
The Submit  button isn't available until all the records in the task are reviewed and the task is 
complete.

What to do next
You can review the certification results in the Review completed tab, and change certification 
results or edit field values.

Review failed certification tasks in CMDB Workspace

Review records (and CIs) that failed the certification review and are assigned to you. Those 
exceptions appear in a list that is dynamically updated as certification tasks are being reviewed.

Before you begin
Role required: sn_cmdb_admin

Procedure

1. Navigate to Workspaces  > CMDB Workspace, then select My Work  in the CMDB Workspace 
menu bar.

2. In the Certification exceptions pop-up banner, select Click here to view.

3. Select a drop-down to expand a task to show the records and fields that failed the certification 
review.

4. Select the Certification Document Id of the field that you want to update.
The Element column shows the fields that failed the review. The Certification Document Id 
column contains links to the respective records.

5. Review the details of fields that require updating.
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What to do next
See the Review certification tasks in CMDB Workspace  topic to locate and review the respective 
certification task and to update incorrect field values. You can also directly access record and CI 
forms to update incorrect values.

Data Certification on Core UI

The legacy build of Data Certification on Core UI lets you centrally track and handle Data 
Certification tasks, create certification filters, and define certification schedules.

Alternatively, you can use the full functionality of Data Certification in the CMDB Workspace store 
app. For more information, see CMDB Data Manager experience in CMDB Workspace.

Note: 

Data Certification in CMDB Workspace  and the legacy build of Data Certification on Core 
UI operate separately, and aren't synchronized. Therefore, any Data Certification elements, 
such as filters and schedules, that you create in one of those implementations, doesn't 
appear and isn't included in the other implementation.

To convert schedules created in the legacy build of Data Certification on Core UI, into draft 
Certification policies in CMDB Workspace, see Convert legacy certification schedules into 
Data Manager Certification policies.

Activate Data Certification

Activate the Data Certification plugin to access the application. Activating this plugin also 
activates the Version Management plugin, which manages certification filter versions.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the Data Certification plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.

Note: 
When domain separation and delegated admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .

Installed With Data Certification

Activating the Data Certification plugin installs the following components.

Demo data is available with Data Certification. The demo data provides information including 
filters, schedules, instances, and tasks.
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Tables

Data Certification adds the following tables:

Table Description

Certification Audit Definition 
[cert_audit_definition]

Stores collections of certification schedules that can be run 
as a single entity.

Certification Audit 
Definition Elements 
[m2m_cert_audit_def_cert_sched]

Lists the certification schedules in each certification audit 
definition.

Certification Audit Instance 
[cert_audit_instance]

Stores the certification instances associated with a specific 
audit definition.

Certification Element 
[cert_element]

Stores the data elements that are grouped into certification 
tasks.

Certification Filter [cert_filter] Stores the data that requires certification using a filtering 
condition for the certification.

Certification Instance 
[cert_instance]

Stores a collection of certification tasks representing a 
single instance of a scheduled certification. This table 
extends the Audit [cert_audit] table.

Certification Schedule 
[cert_schedule]

Stores certification for a specific set of information on a 
specific table, what user or group the tasks are assigned to, 
and how often this certification is done.

Certification Task [cert_task] Stores individual certification tasks. Certification Task 
extends the Task table.

Script Includes

Data Certification adds the following script includes:

Name Description

CertificationAjax Provides utilities that enable individual certification 
elements to be certified, rejected, or reverted.

CertificationTaskCreate Custom code that extends the standard code for 
certification tasks.

CertTaskEscalationTimerPercentage Updates time and percentage complete information for a 
certification.

CertificationUtilities Provides utility functions for certification.

Client Scripts

Data Certification adds the following client scripts:

Name Table Description

Alert If 
Boxes 
Checked

Certification Task 
[cert_task]

Provides a warning if the certifier attempts to leave a 
record without certifying the checked elements
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Name Table Description

Check Table 
Name

Certification 
Schedule 
[cert_schedule]

Updates the table name when a different filter is selected.

UI Policies

Data Certification adds the following UI policies:

Name Table Description

Hide next 
scheduled run

Certification 
Schedule 
[cert_schedule]

Hides the Next Scheduled Run  field when the schedule is 
set to run once or on demand only.

Hide Run When 
Not Active

Certification 
Schedule 
[cert_schedule]

Hide "run" associated fields when active is set to false.

Make table 
name read only

Certification 
Schedule 
[cert_schedule]

Makes the Table  field read-only.

Hide Table field Certification 
Element 
[cert_element]

Hides the Table  field on the certification task form.

Make percent 
complete field 
read only

Certification 
Instance 
[cert_instance]

Makes the Percent complete  field read only when the State 
is Work in Progress, Closed Complete, Closed Incomplete, 
or Cancelled.

Show Assign to 
fields

Certification 
Schedule 
[cert_schedule]

Shows the Assign To  field when the assignment type is User 
and hides the Assign To  field for all other assignment types.

Show Group 
field

Certification 
Schedule 
[cert_schedule]

Shows the Assignment Group  field when the assignment 
type is Group  and hides the Assignment Group  field for all 
other assignment types.

Show User field Certification 
Schedule 
[cert_schedule]

Shows the User  field when the assignment type is User.

Show 
Assignment 
Fields

Certification 
Schedule 
[cert_schedule]

Shows the Assign To Empty  option when the assignment 
type is User Field  or Group Field.

Business Rules

Data Certification adds the following business rules:

Name Table Description

Adjust dates 
for cert tasks

Certification 
Instance 
[cert_instance]

Adjusts dates for tasks belonging to the certification 
instance when the dates are changed for an active 
certification.
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Name Table Description

Cancel 
Instance

Certification 
Instance 
[cert_instance]

Cancels all open certification tasks when an active 
certification is canceled.

certification 
audit instance 
events

Certification 
Audit Instance 
[cert_audit_instance]

Sends an inserted event when an active certification 
audit instance is created. Sends a completed event 
when an active certification audit instance is marked as 
complete or incomplete.

certification 
element 
events

Certification Element 
[cert_element]

Sends a failed event when an element of a certification 
is marked as failed.

certification 
instance 
events

Certification 
Instance 
[cert_instance]

Sends an inserted event when an instance of a 
certification is created. Sends a completed event when 
an instance of a certification is completed.

Certification 
Instance 
Rollup

Certification Task 
[cert_task]

Updates the Percent complete  field on the certification 
instance record.

certification 
task events

Certification Task 
[cert_task]

Sends an inserted event when a task is inserted. Sends 
a completed event when a task is deactivated. Sends a 
canceled event when a task is canceled.

Certification 
Task Values

Certification Element 
[cert_element]

Updates the percent complete of the parent task when 
a certification element is updated.

Check 
Certification 
Audit Progress

Certification 
Instance 
[cert_instance]

Updates the completion status of the audit instance as 
a whole when a certification that is part of an audit is 
complete.

Clean 
Certification 
Views

Certification 
Instance 
[cert_instance]

Cleans all related records when a certification instance 
is deleted.

Copy 
certification 
schedule 
fields

Certification 
Instance 
[cert_instance]

Copies changes to the certification schedule to the 
certification instance.

Merge 
Certification 
Tasks

Certification Task 
[cert_task]

Merges two tasks together when a task is reassigned 
and there is another task for the same instance with the 
new user.

Prevent delete 
of Filter with 
Schedule

Certification Filter 
[cert_filter]

Prevents the deletion of a filter that is used in a 
schedule.

Reassign 
Notification

Certification Task 
[cert_task]

Sends out a notification to the new and previous 
assignees when a task is reassigned.

Rollup State Certification Task 
[cert_task]

Updates all necessary parent items when task state is 
changed.

Update audit 
reference

Certification Task 
[cert_task]

Makes Data Certification records compatible with 
Desired State records. This rule makes sure that the 
Audit  field is correctly completed when a record is 
inserted using Insert and Stay.
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Name Table Description

Update audit 
result

Certification Element 
[cert_element]

Makes Data Certification records compatible with 
Desired State records for reporting purposes. This rule 
puts certified values in the Desired value  column when 
an audit is Certified. It also puts actual values in the 
Discrepancy value  column when an audit is Failed.

Update 
follow_on_task 
& audit 
references

Certification Element 
[cert_element]

Makes Data Certification records compatible with 
Desired State records for reporting purposes. This rule 
makes certification tasks compatible with follow-on 
tasks and displays all tasks, regardless of origin.

Update next 
run time

Certification 
Schedule 
[cert_schedule]

Updates the Next scheduled run  field when a schedule 
runs Daily, Weekly, Monthly, or Periodically.

Verify Fields Certification 
Schedule 
[cert_schedule]

Verifies that no field is used in both Display  and 
Certification  fields when the fields of a certification 
schedule are changed.

Formatter

Data Certification adds the following formatter:

Formatter

Name Description

Certification 
Task 
Elements

Enables custom user interface formatting of elements on a certification task. For 
example, displays the green check mark and red exclamation point to use when 
certifying an element.

Properties

Properties

Name Table Description

glide.ui.cert_task_activity.fields System Properties 
[sys_properties]

Defines which journal field is the 
task activity field.

Default: work_notes

User Roles

Data Certification adds the following user roles:

User Roles

Role
Contains 
Roles

Description

certification_admin certification Can:

• Create and configure certifications

• Override provided answers
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User Roles  (continued)

Role
Contains 
Roles

Description

• Perform certification tasks for certification task 
owners

• Send certification task notifications to users and 
owners at any time

• Cancel or delete certifications in any state

certification_filter_admin certification Can create and manage all data certification filters.

certification none Can update active or incomplete tasks assigned to 
them or to groups of which they are a member. Can 
also update configuration items owned by them or by 
groups of which they are a member. Receives email 
notifications when assigned certification tasks.

Events

Data Certification adds the following events. The ServiceNow  system uses these events to send 
email notifications to task owners and managers about changes in certification records.

Name Description

cert_audit_instance.completed A certification audit instance has been completed.

cert_audit_instance.inserted A certification audit instance has been inserted.

cert_element.failed A certification element has failed certification.

cert_instance.complete A certification instance has been completed.

cert_instance.inserted A certification instance has been inserted.

cert_task.cancelled A certification task has been canceled.

cert_task.completed A certification task has been completed.

cert_task.escalate A certification task record has been escalated.

cert_task.inserted A new certification task has been created.

cert_task.notifications A certification task notification has been resent to a user.

cert_task.overdue A certification task is past its specified completion date.

cert_task.reassign A certification task has been reassigned.

cert_task.warning A new task escalation point has been reached.

Email Templates

Data Certification adds the following email templates:
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Name Message

certification.task.cancelled A certification task assigned to you/your group as part 
of the data certification and management process has 
been canceled.

certification.task.reminder.inserted A certification task that has been assigned to you/your 
group as part of the data certification and management 
process requires attention.

certification.task.reminder.outstanding A certification task that has been assigned to you/your 
group as part of the data certification and management 
process requires attention.

certification.task.reminder.overdue A certification task that has been assigned to you/your 
group as part of the data certification and management 
process is overdue.

Certification schedules

A certification schedule defines the information that requires certification and the frequency of 
execution.

At each time interval specified, or on-demand, the certification schedule generates a set of 
certification tasks based on set conditions. Use the Preview Certification Tasks related link to 
preview the certification tasks generated from a certification schedule.

Certification schedule
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Certification tasks

A certification task represents the work of verifying the data associated with a particular record.

Task owners are responsible for performing the certification tasks. Tasks have an associated 
workflow that sends reminders to the task owner and, if necessary, the manager of the owner at 
regular intervals.

Certification task

Note: 
If the message

Record cannot be certified until the instance is finished 
 creating all certification tasks and elements. Reload the 
 page to try again

appears, it signifies that:

• A large amount of data is present in the cmbd_ci and cmdb_ci_server tables.

• Data certification task processing is not complete (Data Certification jobs are still in 
process).

As directed, reload the page and wait for the processing to complete.

Clean up invalid elements

Use the Clean up invalid elements  UI action to query and delete certification elements that 
reference invalid records. Each certification task has a certification schedule, and each 
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certification schedule has Table and Filter fields. When you use this UI action, it performs the 
following processing:

1. Collects all available records from Table field in the certification schedule with filters that are 
available in certification schedule.

2. Collects all certification elements associated with the current certification task.

3. Deletes the certification elements that are no longer available for the data collected in the 
previous step.

4. After deleting invalid records, it recomputes the certification completion percentage using the 
following formula:

(1 - (number of certification elements pending / total no of certification elements associated)) * 
100;)

5. If there are no certification elements with a Pending status, it marks the associated certification 
task as Closed, and deactivates it.

6. If there are remaining certification elements with a Pending status, it activates the associated 
certification task and changes its status to Work in Progress.

Certification elements

Each element of each record being certified is tracked in its own certification element record.

Also tracked are the date and time when the element was certified, comments, and the original 
and certified values of the field. You can view elements on individual certification tasks. Or, you 
can directly access the Certification Elements [cert_element] table by navigating to All  and then 
in the Filter box, entering cert_element.list.

Certification elements

Certification instances

A certification instance is the collection of certification tasks for one execution of a certification 
schedule.
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Certification instances

Certification audit instances

A certification audit instance is a collection of the certification instances and tasks generated by 
a single execution of the certification audit definition.

Certification audit instance

Certification audit definition

A certification audit definition is a collection of certification schedules that can be run at once.
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Certification audit definition

Data Certification Overview module

The Data Certification Overview module displays various data certification-related reports on the 
Data Certification Console homepage.

The Overview module is a type of homepage.

The different levels of access are:

Access levels per role

Role Access

certification

• View (view overview page and refresh reports)

• Review, certify, and fail certifications

certification_admin

• View (view overview page and refresh reports)

• Customize (refresh, add, delete, and rearrange reports)

View, customize

admin

• View (view overview page and refresh reports)

• Customize (refresh, add, delete, and rearrange reports)

• Edit (can edit reports)
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Data Certification Overview Module

The Overview module includes the following reports:

Data Certification Overview Module Description

report Description Table

30/60/90 
Day Aging

Groups tasks by the number of days (30, 60, 90, and 90 and over) 
since the task was opened.

Certification 
Task

Certification 
Instances

Lists all certification instances. Certification 
Instance

Certification 
Progress 
Report

Groups tasks by task owner, indicating task progress as a 
percentage.

Certification 
Task

Certification 
Task 
Completed 
Report

Groups tasks by task owner, indicating tasks that are complete. Certification 
Task

Exceptions 
To Date

Lists all task elements that have comments added and a state of 
Failed  or In Progress.

Certification 
Element

Functional 
Roll Up

Lists the managers that have groups with assigned certification 
tasks. The report is a horizontal bar chart, grouped by status, with 
each bar representing a manager of an assignment group.

Certification 
Task

Hierarchical 
Roll Up

Shows the managers that have employees with assigned 
certification tasks (task owners). The report is a horizontal bar chart, 
grouped by status, with each bar representing a manager of a task 
owner (identified in the Assigned to  field).

Certification 
Task

Upcoming 
Schedules

Lists all schedules that are scheduled to run within the next 30 
days.

Certification 
Schedule

Related topics

Use the Data Certification Overview module

Use the Data Certification Overview module

View the status of data certification tasks.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Data Certification  > Overview.

2. Click elements within the reports to obtain more information.
For example, click any of the colored bars in the Functional Roll Up  bar chart and detailed 
information replaces the Data Certification Console screen.

3. Update some fields directly on the overview page.

Example:
For example, in the red box on the image shown, a certification schedule is being updated in the 
certification instances report.
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Data certification overview module

Related topics

Data Certification Overview module

Data Certification planning

Initial planning can make the certification process more successful.

By defining certification schedules and certification audit definitions, users with the 
certification_admin role establish when certifications are performed, who performs it, and what 
data must be certified.

Required Roles

Users with the certification_admin role can view filter versions. These users can create, update, 
and delete filters, if they have the proper access to necessary tables. In the base ServiceNow 
system, certification_admin users have limited system rights and do not have access to all the 
tables required for creating a filter. When assigning compliance resources, make sure to grant 
additional roles to the certification_admin user as needed. For example, this user requires roles 
that grant access to these tables:

• Company [core_company]

• Cost Center [cmn_cost_center]

• Schedule [cmn_schedule]

Planning Data Certification

Planning the data certification process requires defining:
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• The certification schedule defines certification for a particular set of information on a particular 
table. It also generates certification tasks to perform that certification. One certification task is 
generated per task owner and a certification instance record groups the tasks.

• The optional certification audit definition groups some certification schedules to be performed 
together and generates certification audit instances to perform them.

The following questions require answers for each certification schedule:

• What information requires certification?

• When is the due date for certification?

• Who must perform the certification?

Create a certification filter

A filter is a subset of configuration items from any ServiceNow  table that is created with a 
standard condition builder.

Before you begin
Role required: admin

About this task
An example is a filter that selects all UNIX  servers in the Australian data center.

With filters, you can:

• Create multiple versions of a filter and then select the version you want to use.

• Use one filter on multiple certification schedules.

• View the number of records that match your filter as you create the conditions.

Note: 
Be sure to create certification filters before creating certification schedules.

Procedure

1. Navigate to All  > Data Certification  > Certification Filters.

2. Click New.

3. Fill in the form (see table).

4. Click Submit.

This action saves the filter as version 1.
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Certification filter V1

5. To create another filter version, modify the filter conditions and click Update.

The system saves the new filter and increments the version number.

Certification filter V2

By default, the Certification Filters list shows only the current version of each filter. To see all 
filter versions, click All  in the breadcrumbs.
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Certification Filter List

6. To make an inactive filter the current version, open the inactive filter and click Revert.

Certification filter revert

This action creates a new, active version of the filter and makes all previous versions inactive.

7. To delete a single filter version, open that version record and click Delete.

8. To delete inactive versions of a filter, click Delete inactive versions  under Related Links  in that 
filter record.

You cannot delete a filter that is used in a schedule definition. The system displays a warning 
and the filter is not deleted.

Creating certification filters

Field Description

Name [Required] Filter name.
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Field Description

Description [Optional] Brief description of the filter.

Number [Read-only] Automatically assigned filter identification number.

Table Table containing the records to be filtered. Use of the Database View 
[sys_db_view]  table is limited by version.

Active Control to make the filter available for use from the Filter  field on the 
Certification Schedule form.

Version Current version of this filter. Any significant changes to the filter make the 
current version inactive. The system copies the updated filter, marks it as active, 
and increments the version number. The system saves all versions of the filter 
and makes them available to users. More than one version of a filter can be 
marked active.

Filter 
condition Field, operator, and value to create the condition. The available options depend 

on the table selected. You can view the number of records that match the filter 
by clicking the refresh icon.

Refresh Conditions

If the filter does not match any records, the system marks the certification 
instance as Closed Complete, with the Percent complete  value set to 100%.

Related topics

Data Certification planning

Define a certification schedule

A certification schedule specifies the fields to display, the fields that require certification, 
certification task assignments, completion requirements for task owners, frequency of schedule, 
and detailed instructions.

Before you begin
Role required: admin

About this task
Use the preview option to see what tasks are created before saving the schedule. If the tasks 
are not what you want, edit the schedule and preview the tasks again. The system creates 
certification tasks automatically when it executes a schedule.

To schedule a certification:

Procedure

1. Navigate to All  > Data Certification  > Schedule Definitions.

2. Click New

3. Fill in the fields (see table).

4. Click Submit.
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Defining A Certification Schedule

Field Description

Name A schedule name.

Filter A certification filter for this schedule.

Table [Read-only] The table holding the records to be certified. To change the table 
name, select a different Filter  or create a new Filter.

Display 
fields

The fields displayed in the Certification Task list to provide context. These 
do not require certification themselves. For example, although users are not 
required to certify the Name  field of a record, it displays so that users know 
what record they are certifying.

Certification 
fields

The fields to certify on this certification schedule.

Assignment 
type

A choice list to select how the certification schedule assigns the certification 
tasks.

◦ User Field: Select a user reference field on the table being certified. As an 
example, select the user named in the Managed by  field to identify the user 
who performs the task. This selection displays the Assign to  and Assign to 
empty  fields. If the reference field on the record is empty, the value in the 
Assign to empty  field is used.

◦ Specific User: Select a specific user to perform the tasks. This selection 
displays the User  field.

◦ Group Field: Select a group reference field on the table being certified. As 
an example, select the Support group  field to identify the user who performs 
the task. This selection displays the Assign to group  and Assign to empty 
fields. All members of the group from the reference field on the record are 
assigned to the tasks. If the reference field on the record is empty, the value 
in the Assign to empty  field is used.

◦ Specific Group: Select a specific group to perform the tasks. This selection 
displays the Group  field. All members of the named group are assigned to 
the tasks.

User This field appears when:

◦ Assignment type  is Specific User. This system assigns this user to all 
certification tasks for this schedule.

◦ The Assign to empty  field is set to Create Assigned Task, and you have 
selected User Field  as the assignment type. The system assigns this user to 
certification tasks containing unassigned records.

You can only select users with the certification role.

Assign to 
group

The group field that defines the group assigned to the certification tasks. This 
field is available only when the Assignment type  is Group Field.

Group The specific group to which certification tasks are assigned for this schedule. 
This field is available only when the Assignment type  is Specific Group

Assign to The user field that defines which user is assigned to the certification task. This 
field is available only when the Assignment type  is User Field.

Assign to 
empty

The behavior to use if the field selected in Assign to  or Assign to group  is 
blank on the record being certified. For example, if a task must be assigned to 
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Field Description

a manager, but no manager is identified, the value in this field determines what 
happens. This field appears only when the Assignment type  is User Field  or 
Group Field. The possible selections are:

◦ Do Not Create Task: No task is created when the Assign to  or Assign to 
group  field is empty.

◦ Create Unassigned Task: Create a task, but do not assign it to any user or 
group. The task can be manually assigned later.

◦ Create Assigned Task: Create a task and assign it to the user or group 
specified. If you selected an assignment type of User Field, the User  field is 
available. If you selected the Group Field  type, the Group  field is available.

The schedule automatically creates certification tasks for all records that do 
have "Assign to" populated, regardless of which selection you make for "Assign 
to empty."

Days to 
complete

[Required] The number of days that task owners have to complete the 
certification tasks. When the certification schedule is part of a certification 
audit definition, the Days to Complete  audit definition value overrides the value 
set for the certification schedule.

Active Check box to activate this certification schedule, generating certification tasks 
at the scheduled date and time. Clear this check box to hide scheduling fields 
on the form (except Last run date) and not generate certification tasks.

Run How often to run the schedule that generates certification tasks:

◦ Daily

◦ Weekly

◦ Monthly

◦ Periodically

◦ Once

◦ On Demand

Day When Run  is Weekly, the day of the week when the schedule runs and 
generates certification tasks.

When Run  is Monthly, the day of the month the schedule runs and generates 
certification tasks. If the day is 29, 30  or 31, the certification runs on the last 
day of the month for shorter months.

Repeat 
Interval

When Run  is Periodically, the frequency that the schedule runs to generate 
certification tasks, entered in time, days, or both. For example, set Days  to 10 
and Hours  to 14:00:00  to run the schedule and generate certification tasks 
every 10 days at 14:00.

Starting When Run  is Periodically  or Once, the date and time the schedule runs and 
generates certification tasks.

Time When Run  is Daily, Weekly, Monthly, or Once, the time of day, on a 24-hour 
clock, the schedule runs and generates certification tasks.

Last run 
date

[Read-only] The date and time that the schedule ran last, either on its regular 
schedule or manually, and generated certification tasks.
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Field Description

Next 
scheduled 
run

[Read-only] The next date and time the schedule runs and generates 
certification tasks.

Task 
Description

A description to add to the Short Description  field of the certification task.

Instructions An HTML field for providing instructions to the user or group performing the 
certification.

Related topics

Data Certification planning

Preview a certification task

Previewing certification tasks saves any changes to the Certification Schedule form and displays 
the tasks that are created when you execute the certification schedule.

Before you begin
Role required: admin

About this task
Previewing tasks is especially useful if you want to test different combinations of options in the 
Assignment type, Assign to, and Assign to empty  fields.

Procedure

1. Navigate to All  > Data Certification  > Schedules  > Schedule Definitions.

2. Click a certification schedule Name.

3. In Related Links, click Preview Certification Tasks.

The tasks to be created appear at the top of the screen.

Certification info message

Related topics

Data Certification planning

Define a certification schedule

Use a certification schedule notification

After you define a certification schedule, the system automatically sends notifications to specific 
users based on the information in the schedule.

Before you begin
Role required: admin
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About this task
The following notifications are sent automatically:

Certification Schedule Notifications

Time 
elapsed to 
end date

Email template name Notification message is sent to

0% (when 
task is 
created)

certification.task.reminder.inserted Task owner or assignment group, if 
specified

50% certification.task.reminder.outstanding Task owner or assignment group, if 
specified

75% certification.task.reminder.outstanding Task owner, assignment group, if 
specified, and manager of the task owner, 
if specified

95% certification.task.reminder.outstanding Task owner, assignment group, if 
specified, and manager of the task owner, 
if specified

100% certification.task.reminder.overdue Task owner, assignment group, if 
specified, and manager of the task owner, 
if specified

The email templates used in the notifications can be edited, for example, to change the email 
message text.

Executing a Certification Schedule

Executing a certification schedule generates certification tasks based on the schedule.

Procedure

1. Navigate to All  > Data Certification  > Schedules  > Schedule Definitions.

2. Click a certification schedule Name.

3. Click Execute Now.
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The related lists Certification Instances  and Certification Tasks  display the instances or 
tasks generated by the schedule. The amount of time it takes to generate all certification tasks 
depends on the size of the table selected and how many fields require certification.

Execute certification schedule

Define and create a certification audit

A certification audit is a collection of certification schedules that can be run as a single entity.

Before you begin
Role required: admin

About this task
Certification audits can be useful when there are multiple certification schedules. After creating 
a certification audit definition, you can generate a certification audit instance. The certification 
audit instance is a collection of the certification instances and tasks generated by a single 
execution of the certification audit definition.

Procedure

1. Navigate to All  > Data Certification  > Audits  > Audit Definitions.

2. Click New.

3. Fill in the fields (see table).

4. Right-click the header bar and select Save.

5. In the Certification Schedules  related list, click Edit.

6. In the Collection  list on the left, select one or more schedules and click Add.

7. Click Save.

8. In Related Links, click Create Certification Audit Instance.

The system generates an audit instance based on the certification schedules selected. All 
audit instances based on this audit definition are listed in the Certification Audit Instances 
related list.

Defining and Creating a Certification Audit

Field Description

Name The name of the audit definition.
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Field Description

Days to 
Complete

The number of days that task owners have to complete the certification tasks 
created by this audit definition. Overrides the identical field on the certification 
schedule.

Description A short description of the intended audit.

Related topics

Data Certification planning

Track a certification audit instance

You can view a list of all certification audit instances at any time.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Data Certification  > Audits  > Audit Instances.

2. View the Certification Instances  related list.

The list contains each of the associated instances generated as part of the audit.

Related topics

Data Certification planning

Data certification performance

After the certification process has been planned, certification tasks can be performed according 
to defined schedules.

Users with the certification role can perform certification tasks. The certification tasks can be 
tracked as part of certification instances.

Related topics

Data Certification planning

Define a certification schedule

Installed With Data Certification

View and resolve certification tasks

After you execute a certification schedule manually or at a scheduled time, the ServiceNow 
system performs certain actions.

• Creates certification tasks for any records that meet the filter requirements in the specified 
table, like tasks from the Configuration Item [cmdb_ci]  table.

• Assigns the new tasks to the user or group identified in one of these certification schedule 
fields:

◦ Assign to

◦ User

◦ Assign to group

◦ Group
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• Places the new tasks in the Work in Progress  state.

• Adds the certification schedule Short description  and Assigned to  values to the corresponding 
fields on the certification task record.

• Adds the certification schedule Days to complete  and Complete by  date fields to the 
certification task record, based on when the task is created.

Note: 
If the certification filter does not match any CIs, the system sets the State  to Closed 
Complete  and the Percent complete  to 100.

To view tasks assigned to you, navigate to Data Certification  > Tasks  > My Tasks. To resolve 
tasks assigned to you, see Certify an element. For more information about purpose and usage of 
certification tasks, see certification tasks.

The following information is tracked on the certification task record:

Certification task record

Field Description

Number An identification number for the certification task.

Assigned to The user responsible for certifying the data.

Assignment 
group

The group responsible for certifying the data.

Complete 
by

[Read-only] A date field containing a deadline for the task. This field is 
automatically filled in based on the Days to Complete field on the certification 
schedule.

State [Read-only] The current state of the certification task. The selections are: Work in 
Progress, Closed Incomplete, Closed Complete, and Cancelled.

Percent 
complete

The task progress as a percentage. This field is read-only when a task is in a 
Closed Incomplete, Closed Complete, or Cancelled state.

Escalation [Read-only] The escalation level of the task. When 0–49% of the time to Complete 
By has elapsed, this field is set to Normal. At 50%, this field changes to Moderate 
and an email reminder  is sent to the task owner. At 75%, this field changes to High 
and an email reminder are sent to the task owner and the manager of the task 
owner. At 95%, this field remains set to High, but a second email reminder is sent 
to the task owner and manager.

Short 
Description

A short description of the task. This field is automatically filled in with the text from 
the certification schedule of the Task description field.

Work notes Information about work performed on the certification.

Certify an element

The Certification Task form contains a list of all elements to be certified.

Before you begin
Role required: admin

About this task

Note: 
After you certify all the elements in a task, no elements can be reverted.
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Procedure

1. Navigate to All  > Data Certification  > Tasks  > My Tasks.

2. Open a certification task with a State  of Work in Progress.

3. In the upper right corner of the list, select records that require certification for this task or all 
records that are part of this certification task.

Certification list 3

4. Select the check box beside a certification element.

5. In Optional comment for checked elements, above the list, enter information that would be 
useful to others.

Certification list

6. Do:

◦ Click the green check mark to certify the element.

◦ Click the red exclamation point to fail the element.

7. To see the certified or failed element, set the view to Show All Records.

A green check mark or red exclamation mark appears beside the element.
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8. Point to an icon to see any certification comments.

9. Ensure that all elements have the correct certification, either accepted or rejected.

After you certify all elements, no elements can be reverted. When all elements of a certification 
task are certified or rejected, the task State  changes to Closed Complete.

View an audit result

View audit results after you certify the elements.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Data Certification  > Schedules  > Audit Results.

The list of data certification audit results appears, grouped by certification instances. Certified 
configuration items show the Original value  only. Failed CIs contain the Certified value  and the 
Original value.

2. Click the links in the list to open any of the related records.

Data cert audit results

Export the certification list

Users with the certification_admin role can export the certifications list and save the list in Excel, 
CSV, XML, or PDF format. This list is useful when you have a long list of certification elements or if 
many different users are assigned to certify elements on a single certification schedule.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Data Certification  > Tasks  > All Tasks

2. Open a task.

3. Open any column context menu in the certification data list and complete the export.
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Reset certifications

You cannot reset any element after all elements are certified.

• To reset individual certifications, right-click the element in the certification list and select 
Revert Certification.

• To reset the entire task to its starting point, click the Reset all Certifications to Pending  related 
link.

Track a task with a certification instance

The Certification Tasks related list on the certification instance record provides information about 
associated tasks.

Before you begin
Role required: admin

About this task
The State  field on the certification instance record is read-only and is based on the cumulative 
states of the certification tasks associated with the instance. The Percent complete  column 
allows users with the certification_admin role to track task progress quickly. For more information, 
see Track Certification Tasks.

To track a certification instance:

Procedure

1. Navigate to All  > Data Certification  > Schedules  > Instances.

2. Click a certification instance Number.

3. View and edit the following fields as necessary.

Certification instance

Field Description

Number [Read-only] Automatically generated identification number for the instance.

Certification 
Schedule

The certification schedule  used to create the certification instance.

State [Read-only] Current state of the certification instance: Work in Progress, 
Complete, Closed Incomplete, or Cancelled. For more information, see Track 
Certification Tasks.

Created [Read-only] Date and time the certification instance was created. Date is 
filled in automatically when the Execute Now button clicks the associated 
certification schedule.

Complete 
by

[Required] Date and time when the certification instance must be completed. 
The system updates this field when it executes the schedule, using the 
deadline specified on the instance. All certification tasks associated with 
the certification instance must be marked Complete, Closed Incomplete, or 
Cancelled before the instance is complete.

Percent 
complete

Percentage of the instance that has reached the Closed Complete state. This 
field is automatically filled in based on the Percent Complete fields on the 
associated certification tasks.
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Field Description

Task 
Description

Information about the certification instance. This field automatically displays 
the text from the Task description field of the associated certification schedule.

Instructions Field for providing instructions to the user or group performing the certification. 
This field is automatically filled in with information from the Instructions field on 
the associated certification schedule.

Cancel a certification instance

Users with the certification_admin role can cancel a certification instance.

Before you begin
Role required: admin

About this task
The instance must have a State  of Work in Progress. Canceling a certification instance:

• Changes the certification instance State  to Cancelled.

• Changes all associated Work in Progress  certification tasks to Cancelled.

To cancel a certification instance:

Procedure

1. Navigate to All  > Data Certification  > Schedules  > Instances.

2. Click a certification instance Number.

3. Click Cancel.

Track a certification task

Use the certification task state to track the progress of a task.

Before you begin
Role required: admin

About this task
The available task states are Work in Progress, Closed Complete, Closed Incomplete, and 
Cancelled.

When the state of a certification task changes, the certification instance state also changes in 
the following cases:

• If any certification task is in Work in Progress  state, the certification instance is placed in Work 
in Progress  state.

• If all certification tasks are in Cancelled  state, the certification instance is placed in Cancelled 
state.

• If all certification tasks are in Cancelled  or Closed Complete  state, the instance is placed in a 
Closed Complete  state. For example, if three certification tasks are Cancelled, and one task is 
Closed Complete, the instance state is changed to Closed Complete.

• When one certification task is Closed Incomplete  and the remainder of the tasks are 
Cancelled  or Closed Complete, the instance is placed in Closed Incomplete.

To view the state of certification tasks:
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Procedure

1. Navigate to All  > Data Certification  > Tasks  and select My Tasks  or All Tasks.

2. View the State  column for each task.

Escalate a certification task

Users with the certification_admin role can escalate a task in the Work in Progress state. To 
escalate a task, the task owner identified in the Assigned to field on the task record must have an 
associated manager.

Before you begin
Role required: admin

About this task
Personalize the User form to see the Manager  field.

Escalating a task:

• Sends an email message to the task owner and the manager of the task owner stating that the 
task has been escalated.

• Sets the manager as the new task owner.

The event that triggers the escalation is named cert_task.escalate and the email notification 
is named Escalation Notification. To edit the text of the email message that is sent, edit the 
Escalation Notification  email notification directly.

For more information, see Email notifications .

To escalate a certification task from the Certification Task form:

Procedure

1. Navigate to All  > Data Certification  > Tasks  > All Tasks.

2. Select a certification task Number.

3. Select Escalate.
If the Escalate  button is not available, the user in the Assigned to  field does not have an 
associated Manager.

Escalate a certification task from the certification task list

Escalate a certification task to notify the manager of the current task owner.

Before you begin
Role required: admin

To escalate a task, the task owner identified in the Assigned to field on the task record must have 
an associated manager.

Procedure

1. Navigate to All  > Data Certification  > Tasks  > All Tasks.

2. Select the check box to the left of a certification task Number, you can select multiple check 
boxes.
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3. From the Actions on Selected Rows  menu below the list, select Escalate.
If the Escalate  button is not available, the user in the Assigned to  field does not have an 
associated Manager. Select multiple tasks from the list. The menu option shows how many 
tasks are not eligible for escalation, such as Escalate (4 of 6).

Reassign a certification task

If you have the certification_admin role, you can reassign any certification task in the Work in 
Progress  state. Tasks in Closed Complete, Closed Incomplete, or Cancelled  state cannot be 
reassigned. When a task is reassigned, the current task owner and the new task owner are sent a 
message.

Before you begin
Role required: certification_admin

About this task
The event associated with the reassignment is named cert_task.reassign and the email 
notification is named Certification Task Reassignment. To edit the text of the email message that 
is sent, edit the Certification Task Reassignment  email notification directly.

For more information, see Email notifications .

To reassign a certification task:

Procedure

1. Navigate to All  > Data Certification  > Tasks  > All Tasks.

2. Click a certification task Number.

3. Enter a new name in the Assigned to  field.

Send certification task reminders

The Certification Task Escalations workflow sends automatic email reminders.

The Certification Task Escalations workflow sends automatic email reminders to the:

• Certification task owner.

• Assignment group, if the assignment group was specified on the Certification Task  form.

• Manager of the certification task owner, if necessary and if a manager was specified on the 
User form.

The reminders are based on the Complete by  field on the certification task record. If the 
Complete by  date is changed, the reminder schedule automatically adjusts to reflect the new 
date.

Certification task reminders

Time elapsed to 
end date

Email reminder is sent to
Escalate field on task 
record reads

50% task owner and assignment group (if specified) Moderate

75% task owner, assignment group, and manager of 
the task owner

High

95% task owner, assignment group, and manager of 
the task owner

High
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Certification task reminders  (continued)

Time elapsed to 
end date

Email reminder is sent to
Escalate field on task 
record reads

100% task owner, assignment group, and manager of 
the task owner

High

To set reminders for different or more intervals, edit the workflow Certification Task Escalations. 
In addition to the email reminders sent automatically, users with the certification_admin role can 
send email reminders manually at any time.

Send an email reminder from the certification task form

How to manually send email reminders from the Certification Task form.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Data Certification  > Tasks  > All Tasks.

2. Click a certification task Number.

3. Right-click the header bar and select Resend email notifications.

Send an email reminder from the certification task list

How to manually send email reminders from the Certification Task list.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Data Certification  > Tasks  > All Tasks.

2. Select the check box to the left of a certification task Number, you can select multiple check 
boxes.

3. From the Actions on Selected Rows  menu below the list, select Resend email notifications.

4. Select multiple tasks from the list.
The menu option shows how many notifications are outstanding and how many were sent, 
such as Resend email notifications (15 of 18).

Mark a certification task as closed incomplete

Mark a task as closed incomplete if, for example, only some of the elements can be certified.

Before you begin
Role required: admin

About this task
The following users can mark a task as closed incomplete:

• Users with the certification_admin role.

• User identified in the Assigned to  field on the certification task record.

To mark a task as closed incomplete:
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Procedure

1. Navigate to All  > Data Certification  > Tasks  and select All Tasks, or My Tasks.

2. Click a certification task Number.

3. In Work Notes, enter information about why the task could not be completed.

4. Click Close Incomplete.

If at least one task on a certification instance is marked Closed Incomplete, the Completed 
date and Percent complete  fields on the certification instance record are not updated. A user 
with the certification_admin role can:

◦ Complete the incomplete task or tasks.

◦ Cancel the incomplete task or tasks.

When all tasks on the certification instance are Closed Complete  or Cancelled:

◦ The system sets the Completed  date field on the certification instance record to the current 
date and time.

◦ The Percent complete  field on the certification instance record is set to 100 percent.

Certification tasks cancellation

Users with the certification_admin role can cancel a certification task in the Work in Progress or 
Closed Incomplete state.

When a certification task is cancelled, a notification email is sent to the task owner or assignment 
group assigned to the task. The task owner or assignment group manager is not notified.

Cancel an individual task

Cancel a particular data certification tasks in the Work in Progress state.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Data Certification  > Tasks  > All Tasks.

2. Find a task with a State  of Work in Progress.

3. Click the task Number.

4. Click Cancel.

Cancel all tasks in an instance

Cancel data certification tasks in the Work in Progress state.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Data Certification  > Schedules  > Instances.

2. Find an instance with a State  of Work in Progress.

3. Click the instance Number.

4. Click Cancel.
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All tasks in the instance with a state of Work in Progress  are cancelled. The task owner or 
assignment group is notified.

The email template used for the notification is named certification.task.cancelled. The email 
templates can be edited to change the email message text, for example.

Domain separation and Data Certification

Domain separation is supported in Data Certification processing. Domain separation enables you 
to separate data, processes, and administrative tasks into logical groupings called domains. You 
can control several aspects of this separation, including which users can see and access data.

Support level: Basic

• Business logic: Ensure data goes into the proper domain for the application’s service provider 
use cases.

• In the application, the user interface, cache keys, reporting, rollups, aggregations, and so on, 
all consider domain at production run time.

• The owner of the instance needs to be able to set up the application to function normally 
across multiple tenants.

Use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, 
the client must be able to see my response.

How domain separation works in Data Certification

• Data Certification has only basic domain separation. As long as the Certification Instances 
(CIs) or records that must be certified are correctly domain-separated and the users who must 
certify the CIs or records are in a domain that can view the data, Data Certification works as 
expected.

• Recommendation: The instance owner must be responsible for assigning Certification Tasks 
and Certification Instances to the correct domain. Changing the domain for these records does 
not change functionality, but limits the view of the records.

How to set up domain separation for Data Certification

After enabling the Domain Separation plugin, there are no additional steps required to set up 
domain separation for Data Certification.

• instance owners determine which CIs or records that need to be certified can be domain-
separated.

• Customers can configure a domain-separated environment by assigning tasks to a domain, but 
if the data is already domain-separated, then only users with the right domain permissions can 
view the data in a certification task.

How tenant domains manage their own application data

It's not necessary to set the domain on the certification tables but it can be done if the instance 
owner should want that. As long as the CI’s or records that must be certified are domain-
separated, users with the correct domain permissions can view them.
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Domain-separated tables

• cert_instance – Changing the domain on this table does not change any functionality, nor 
does it change the domains of the tasks created from the table.

• cert_task – Changing the domain on this table changes the domain viewing permissions of the 
task.

• cert_element – It is not recommended to change the domain on these records. As long as the 
CIs or records to be certified are already domain-separated, cert_element records will reflect 
that.

• cert_filter – Changing the domain on this table changes the domain viewing and filtering of CIs 
or records.

Use cases

Instance owners who have multiple clients that certify the infrastructure they own can assign 
domains to those CIs and the Certification Tasks to restrict the view from one client to another.

Related topics

Domain separation for service providers

Components related to CMDB Data Manager

The following scheduled jobs, tables, roles, and properties, are related to CMDB Data Manager. 
Some of those, are installed with CMDB Workspace.

System properties

As a Data Manager Administrator (data_manager_admin) you can view CMDB Data Manager 
properties in CMDB Workspace.

1. Navigate to Workspaces  > CMDB Workspace  and then select Management  in the CMDB 
Workspace  menu bar.

2. Select the Data Manager  link in Management tools, in the Manage section.

3. Select Settings  in the left navigation bar.

Property Description

glide.cmdb.data.manager.delete.batch.size Size of each batch of CIs that is deleted or 
archived (affects performance optimization).

• Type: Integer

• Default value: 1000

glide.cmdb.data.manager.subflow.timeout Threshold (in milliseconds) for subflow 
running time. A subflow that passes this 
threshold while running, is cancelled.

• Type: Integer

• Default value: 600,000 (10 minutes)

glide.cmdb.data_manager.default_archive_time Number of days that it is still possible to 
restore archived CIs from archive tables. After 
the specified number of days pass, archived 
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Property Description

CIs are permanently deleted from the archive 
tables.

• Type: Integer

• Default value: 120

cmdb.data.manager.stale.task.life.in.days
Number of days after which a task is 
considered stale and is set to Closed 
Cancelled  by the CMDB Data Manager - 
Stale Task Cleaner  daily scheduled 
job.

Details:

• Type: Integer

• Default value: 90

sn_cmdb_ws.glide.cmdb.data.manager.aging.policy.task.timeframeNumber of days before a Data Manager task is 
marked as aged.

• Type: Integer

• Default value: 30

sn_cmdb_ws.cmdb.dm.policy_types.due_date_notification

Notifications

Notifications about certification and attestation 
incomplete tasks. When either is checked, 
the system notifies task owners as the due 
date for incomplete tasks is approaching. 
Notifications are sent when 50%, 70%, and 
90% of the time to due date has passed. On 
the task due date, a past due notification is 
sent to the task owner and to the task owner's 
manager.

Upon closing a task, sending notifications 
stops.

For information about how the Days to 
complete  setting is used to calculate when 
notifications are sent, see Create a CMDB 
Data Manager policy in CMDB Workspace.

sn_cmdb_ws.glide.cmdb.data_manager.rejected.task.notifications.group

Group to receive notifications for a rejected 
task

System identifier of a user group to notify 
about tasks that are being rejected.

By default, this property has no value, in which 
case, all data manager administrators are 
notified about rejected tasks.

For information about how this property is 
used when reviewing and rejecting life-cycle 
tasks, see Review CMDB Data Manager tasks 
in CMDB Workspace.
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Scheduled jobs

Scheduled job Description

CMDB Data Manager Archive/Delete Policy 
Processor Processes all published polices of type 

Archive and Delete:

• Applies policies only to CIs that are already 
retired.

• Processes all Archive policies first, and if no 
errors encountered, continues to process 
any Delete policies.

CMDB Data Manager Retire Policy Processor Processes all published polices of type Retire: 
Applies policies only to CIs that are not retired.

CMDB Data Manager - Stale Task Cleaner
Cleans up stale CMDB Data Manager tasks by 
setting the task to Closed Cancelled.

The 
cmdb.data.manager.stale.task.life.in.days 
system property determines the number of 
days after which a task is considered stale (90 
by default).

A task becomes stale if:

• The task was created at least 90 days (by 
default) ago and it is still open.

• The approval requests are older than 90 
days (by default) and the task is not yet 
approved.

CMDB Data Manager Delete Related Entry 
Policy Processor

Processes the Delete CMDB Related Entry 
policy by deleting the specified related tables 
from the Related Entry [cmdb_related_entry] 
table.

Tables

Table Description

CMDB Data Management Policy

[cmdb_data_management_policy]

Details about CMDB Data Manager policies.

CMDB Data Management Policy Executions

[cmdb_data_management_policy_execution]

Execution records corresponding to each 
policy evaluation.

CMDB Data Management Policy Runtime 
Attributes

[cmdb_data_management_policy_runtime_attributes]

Current policy metadata including status and 
summary.
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Table Description

CMDB Data Management Task Control

[cmdb_data_management_task]

Open policy tasks generated by published 
policies.

CMDB Data Management Tasks to CIs

[cmdb_data_management_task_to_ci]

Associations of tasks to CIs.

CMDB Data Manager Task to Documents

[cmdb_data_management_task_to_document]

Associations of task and to related items.

CMDB Data Management Attestation Tasks to 
CIs

[sn_cmdb_ws_attestation_task_to_ci]

Associations of task and attestation CIs.

CMDB Data Management Tasks to CIs

[cmdb_ci_state_management_task_to_ci]

Associations of task and CIs for 'Dependent CI 
Deletion' policy type.

Excluded CIs

[cmdb_policy_ci_exclusion_list]

Tracks the CIs that are set to be excluded 
during policy evaluation.

CMDB Policy Type

[cmdb_policy_type]

Policy types supported by the CMDB Data 
Manager.

CMDB Policy Type Categories

[cmdb_policy_type_categories]

Associations of policy types to Flow Designer 
Categories.

CMDB Retirement Custom Definitions

[cmdb_retirement_custom_definitions]

Life-cycle rules for life cycle policies (Retire/
Archive/Delete). For example, custom 
retirement definitions.

CMDB Policy Scheduled Jobs

[cmdb_policy_scheduled_job]

Policy scheduled Job details.

Dependent CI Relations Evaluation Config

[cmdb_dependent_ci_extra_rels_config]
Information about CIs' extraneous 
relationships which is used for the delete and 
archive operations. Extraneous relationships 
are those relationships that are not in the CI’s 
chain of dependency.

For more information, see Dependent CIs 
management.

CMDB Dependent CI Class Exclusions

[cmdb_dependent_ci_class_exclusion]
Excluded classes for dependent CI, which is 
used with the Archive/Retire/Delete policy 
types to determine which CIs are orphan 
dependent CIs.
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Table Description

For more information, see Dependent CIs 
management.

CMDB Dependent CI Ledger

[cmdb_dependent_ci_ledger]

Staging table for orphaned dependent CI 
related to the deletion or archival of the 
main CI that they depend on. Also used in a 
cascade-retire dependent CIs operation.

For more information, see Dependent CIs 
management.

CMDB CI End Of Life Ledger

[cmdb_ci_end_of_life_ledger]
CIs that are being set as retired that 
belong to a class that has any downstream 
dependencies.

Used in the Dependent CI Retire policy.

Roles

Role title [name] Description Contains roles

CMDB Data Manager 
administrator

[data_manager_admin]

Can access all features in the CMDB 
Data Manager, including:

• Full access to assigned tasks.

• Full access to policies.

• Ability to associate subflow categories 
to policy type.

Can create, edit, and delete policies, 
calculate previews, approve tasks, and 
manage exclusion lists.

• task_editor

• data_manager_user

• cmdb_query_builder_read

CMDB Data Manager 
user

[data_manager_user]

Can view CMDB Data Manager policies 
in read-only mode and calculate 
previews.

Can perform the following tasks:

• View assigned tasks.

• Update, approve, or reject an 
assigned task.

• Add a CI to an exclusion list from their 
task.

cmdb_read

CMDB groups

A CMDB group is a collection of CIs that lets you apply CI actions collectively to all the CIs that 
are members in the group.
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For example, a CMDB CI Lifecycle Management API can use a CMDB group scriptable API to 
retrieve the group's list of CIs, and then apply a CI Lifecycle Management action collectively to all 
the CIs. You can also use a CMDB group with the Dynamic CI Group  service population method, 
to populate an application service.

Group type

A CMDB group is configured with a group type.

• If a CMDB group type is set to Health, then the CIs in the group can be monitored by CMDB 
Health, and the aggregated health is reported for the group as a whole in the CMDB group view 
dashboard. For example, you can monitor health only for CIs in a specific location.

• If a CMDB group is set to CMDB Workspace, then that group appears in the  Management view 
in the CMDB Workspace.

Create and populate a CMDB group

Depending on the group type, you can populate a CMDB group by manually adding individual 
CIs, selecting saved CMDB queries, or building encoded queries in the CMDB group itself. The 
resulting CIs from each query are added as members to the group.

Before you begin
Roles required:

• To view CMDB groups - itil

• To use a CMDB queries - cmdb_query_builder on top of itil

• To manually add CIs - itil or asset

Also, to populate a CMDB group using a CMDB query, a saved CMDB query must exist.

About this task
The system property glide.cmdb.group.max_ci_limit  determines the maximum 
number of CIs that a CMDB group can contain (by default 10,000). Once the specified limit is 
reached, CIs can't be added to the group unless you increase the value of that property.

Procedure

1. Navigate to All  > Configuration  > CMDB Groups.

2. In the CMDB Groups pane, select New.

3. Fill out the form, right-select the title bar and select Save.

CMDB Group form

Field Description

Group Name A unique name for the group.

Group type ◦ Default: Basic group type which can be 
populated by manually adding CIs, saved 
queries, and encoded queries.

◦ Health: Sets CMDB Health to monitor the 
health of the group CIs and aggregate 
health results for the group as a whole.

Can be populated only by encoded 
queries.
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Field Description

Note: 
Dynamic filters are not supported 
when populating this type of CMDB 
groups.

◦ CMDB Workspace: Custom class group 
which appears in the CI Overview panel in 
CMDB Workspace store app.

Can be populated only by encoded 
queries.

4. To use saved CMDB queries:

a. Select CMDB Group Contains Saved Queries  and then select Add Query.

b. Select a query from the Query Builder Saved Query  list.

c. Select Submit.
The returned results consists of the CIs from all the classes that are referenced in the saved 
query. Those CIs become members of the CMDB group.

5. To manually add CIs:

a. Select CMDB Group Contains Configuration Items  and then select Edit Manual CI.

b. Optional:  Add filters.

c. Select CIs in the Configuration Item  list and select the '+'  icon at the bottom.

d. In the Group members  list, select the CIs to add to the group.

e. Select Save  or Save and Exit.

f. In the Save Confirmation  dialog box, select OK.

g. Select Submit.

6. To use encoded queries:

a. Select CMDB Group Contains Encoded Queries  and then select New.

b. Fill out the CMDB Group Contains Encoded Query form with the query conditions that filter 
the CIs to be included in the group.

Note: 
Dynamic filters aren't supported for CMDB health-type groups, even though it's 
possible to add them in a condition clause.

Field Description

Class Class for which the encoded query applies 
to.

CI Overview Condition Filter that is used in the calculation for the CI 
Overview chart in CMDB Workspace.

Applies only if the 
sn_cmdb_ws.ci_overview.enable_simple_condition 
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Field Description

system property is set to true  (false  by 
default). Improves performance by yielding 
less results when there is a large amount of 
data in an environment that hasn't migrated 
to CSDM.

This condition isn't used when selecting 
Show All CI.

Condition Filters the CIs that are included in the 
group. Used if CI Overview Condition  isn't 
applicable.

c. Select Submit.

What to do next
Select Show All CI  to show all CIs from all the result columns of the query. However, only CIs 
from CMDB tables are shown.

Show CI Lifecycle Management details for CMDB group CIs

Display CI Lifecycle Management operational state and CI actions that apply to the CIs that are 
members of a CMDB group.

Before you begin
Role required: none

About this task
If the CMDB group is based on a CMDB query, then the query runs in real-time and displays the 
resulting CIs. If the query does not complete successfully due to timing out or for other reasons, 
then appropriate error messages are displayed.

Procedure

1. Navigate to All  > Configuration  > CMDB Groups.

2. On the CMDB Groups  page, click a CMDB group.

3. Click Show All CI.

Field Description

Configuration Item CI group member.

Class Class of CI group member.

Operational Status CI Lifecycle Management operational 
state of the CI such as 'Repair in Progress' 
or 'Operational'. Possible operational 
states are defined in the choice list of the 
Operational status  field in the 
cmdb_ci table.

Actions CI Lifecycle Management actions that apply 
to the CI such as 'Cloning' and 'Provision'. 
Possible actions are defined in the CMDB CI 
Actions [statemgmt_cmdb_actions] table.
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CMDB  Compliance

CMDB  Compliance is a tool set that enables administrators to certify CMDB  data for correctness 
and fix any discrepancies found in the data.

Note: 
For compliance in the context of internal business goals and objectives, and external 
legislation and regulations, see Exploring Policy and Compliance Management .

Certification options

CMDB  Compliance offers these certification options to suit the size and requirements of your 
organization:

Option Description

Desired 
State

Automatically compares the actual attributes and relationships of specific 
ServiceNow  records against the desired states for those records. For example, 
an audit can detect a Linux database server with insufficient RAM or whose 
Depends on relationships with another CI is incorrect. The system then publishes 
any discrepancies found and automatically assigns follow-on tasks to qualified 
users to bring that server into compliance.

Architecture 
Compliance

Automatically compares the actual attributes of specific CIs, such as CPU count, 
RAM, or disk size against the expected attributes for those CIs. The system 
publishes any discrepancies found and automatically assigns remediation tasks 
to qualified users.

Compliance Templates and Audits

The Templates and Audits modules on the top level of the Compliance menu enable a 
certification_admin user to create, edit, and delete all template and audit types.

You can use Compliance Templates and Audits to evaluate records for any table in the 
ServiceNow  system, not just those tables extending the Configuration Item [cmdb_ci]  table. 
Compliance audits certify record attributes only. Compliance templates can be used in Control 
Test Definitions in Governance Risk and Compliance.

Compliance Activation

Compliance functionality is provided by the Certification Core (com.snc.certification_core) plugin 
which contains shared functionality required for certification audits.

The Certification Core (com.snc.certification_core) plugin consists of the following plugins, and is 
activated by default.

• Activated by default: Desired State Certification  (com.snc.certification_desired_state)

• Activate : Architecture Compliance  (com.snc.architecture_compliance), which automatically 
activates the Version Management (com.snc.version) plugin that manages certification filter 
and template versions.

• Activate : Data Certification  (com.snc.certification_v2), which automatically activates the 
Version Management (com.snc.version) plugin that manages certification filter versions.

Installed with Compliance

These components are installed with the Certification Core plugin.
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Demo data is included with the Desired State and Architecture Compliance plugins.

The Certification Core plugin adds or modifies these tables.

Compliance Certification Core tables

Name Description

Audit [cert_audit] Contains all the data required to run an audit, including the users 
assigned to follow-on tasks and the run schedule.

Audit Result 
[cert_audit_result]

Contains the results of specific, certification audits.

Follow On Task 
[cert_follow_on_task]

Contains the tasks that were generated from an audit discrepancy.

Certification Template 
[cert_template] Contains the definition of the desired state of the record. The 

template includes a filter that identifies the records to evaluate and 
the expected attributes and relationship values.

Contains the records to certify, the expected attributes, and the 
expected relationship values.

Certification Condition 
[cert_cond]

Base table that defines the desired attribute or relationship 
conditions used in templates.

Certification 
Attribute Condition 
[cert_attr_cond]

Contains the conditions that define the desired CI attribute values. 
This table extends the Certification Condition [cert_cond] base 
table.

Certification CI 
Relationship Condition 
[cert_ci_rel_cond]

Contains the CI to CI relationship conditions. This table extends the 
Certification Condition [cert_cond] base table.

Certification User 
Relationship Condition 
[cert_user_rel_cond]

Contains the CI to user relationship conditions. This table extends 
the Certification Condition [cert_cond] base table.

Certification Group 
Relationship Condition 
[cert_group_rel_cond]

Contains the CI to group relationship conditions. This table extends 
the Certification Condition [cert_cond] base table.

Certification Related 
List Condition 
[cert_related_list_cond]

Contains the related list conditions. This table extends the 
Certification Condition [cert_cond] base table.

Certification Filter 
[cert_filter]

Contains a certification filter, including the table that contains the 
records to audit and the filter conditions.

User roles

The certification role is automatically assigned to all users with the itil role when the Certification 
Core plugin  is activated or when compliance applications are upgraded. Certification core 
installs two business rules, both called Add Certification Role To Manager, that perform similar 
tasks on different tables. One rule checks for a manager specified on the User [sys_user] table, 
and the other checks for the certification role on the User Role [sys_user_has_role] table. When 
both a manager and the certification role are specified for a user, the system automatically grants 
the certification role to the manager. This functionality ensures that a certification task can be 
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escalated successfully to the next level. The system grants this automatic role to the user's 
immediate manager only and not to others up the management chain.

Note: 
When a manager has only the certification role and no other role, the manager is 
considered a Requester and is not counted as a subscribed user (Fulfiller).

Compliance Certification Core user roles

Name Contains roles Description

certification none Can read and update certification tasks to 
resolve discrepancies.

certification_filter_admin none Can create, read, and update certification 
filters.

certification_admin certification, 
certification_filter_admin

Can manage the entire certification 
process. These users can create, edit, and 
delete all certification records.

UI policies

Compliance Certification Core UI policies

Name Table Description

Make table read 
only

Audit 
[cert_audit]

Sets the table field derived from the selected filter to read-
only.

Hide Audit Type Audit 
[cert_audit]

Hides the Audit type field.

Hide next 
scheduled run

Audit 
[cert_audit]

Hides the Next scheduled run date when an audit is inactive 
or on-demand.

Show task fields 
when create tasks 
is set to true

Audit 
[cert_audit]

Displays all fields related to creating tasks when the user 
selects the Create tasks check box.

Make name 
mandatory

Audit 
[cert_audit]

Makes Name a mandatory field.

Prevent editing of 
Last run date

Audit 
[cert_audit]

Makes Last run date field read-only.

Show User field Audit 
[cert_audit]

Shows or hides fields based on the Assignment type 
selected. The system shows the User field when you select 
the following assignment types:

• User Field if the Assign to empty option is Create 
Assigned Task.

• Specific User

Show Assign to 
fields

Audit 
[cert_audit]

Shows or hides fields based on the Assignment type 
selected. The system shows the Assign to field when the 
assignment type is User Field.
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Compliance Certification Core UI policies  (continued)

Name Table Description

Show Assignment 
Fields

Audit 
[cert_audit]

Shows or hides fields based on the Assignment type 
selected. The system shows the Assign to empty field when 
you select either of the following assignment types:

• User Field

• Group Field

Show Group field Audit 
[cert_audit]

Shows or hides fields based on the Assignment type 
selected. The system shows the Group field when you select 
either of the following assignment types:

• Specific Group

• Group Field if the Assign to empty option is Create 
Assigned Task.

Hide "run" 
associated fields 
when active is set 
to false

Audit 
[cert_audit]

Hides these scheduling fields when the audit is inactive:

• Run

• Day

• Time

• Last scheduled run

Show script 
window on 
Scripted Audit

Audit 
[cert_audit]

Displays the Run this script field when the audit type is 
Scripted.

Make table read 
only

Certification 
Condition 
[cert_cond]

Sets the table field derived from the selected filter to read-
only.

Script includes

Compliance Certification Core script includes

Name Description

DesiredStateUtil Utility functions for desired state, used to clone a 
template for Insert functionality.

CMDBRElationshipAjax Tool to get all relationships for a given table.

RelationshipQueryParseAjax Parses condition filters. This script include is the internal 
code used in generating the compliance conditions.

CertificationUtils Utility functions for certification that find Next run time 
value, and so on.

CertTaskEscalationTimerPercentage Utility method for setting escalation timer durations.

ConditionUtilsAjax AJAX utilities for parsing queries into a human-readable 
format.
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Compliance Certification Core script includes  (continued)

Name Description

DeleteInactiveVersionsAjax AJAX server-side script to delete all inactive versions of a 
record.

Client scripts

Compliance Certification Core client scripts

Name Table Description

Make audit type 
read only if not 
new

Certification 
Template 
[cert_template]

Sets the correct audit type for new records, and if the 
record is not new, sets the Audit type field to read only.

Update table 
name (filter)

Audit 
[cert_audit]

Updates the table Name field when the filter is updated.

Update table 
name

Audit 
[cert_audit]

Updates the table Name field when the template is 
updated.

Set table name 
on new

Audit 
[cert_audit]

Returns the table name from the template or filter.

Update table 
name

Certification 
Template 
[cert_template]

Updates the table Name field when a new filter is chosen 
and checks all existing conditions to see if they work for 
the new table.

Show 
conditions 
when table is 
set

Certification 
Template 
[cert_template]

Shows and hides conditions appropriately when the table 
is set.

Reset filter 
when audit type 
changes

Certification 
Template 
[cert_template]

Clears the filter and updates the lists shown when the 
audit type is changed.

Business rules

Compliance Certification Core business rules

Name Table Description

Clone 
condition

Certification 
Condition 
[cert_cond]

Part of certification versioning. This business rule retains 
the original ID when a condition is changed.

Copy audit 
type from audit

Audit Result 
[cert_audit_result]

Ensures that all audit results have the same audit type as 
the audit that generated them.

Copy values 
from template

Audit [cert_audit] When a user selects a template, and updates the table, 
filter, and audit type from the template.

Delete 
condition

Certification 
Condition 
[cert_cond]

Part of certification versioning that deletes a condition.
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Compliance Certification Core business rules  (continued)

Name Table Description

Prevent 
deletion of 
audit with 
results

Audit [cert_audit] Prevents deletion of an audit containing results.

Prevent delete 
of Filter with 
Template

Certification Filter 
[cert_filter]

Prevents deletion of a filter still linked to a template or 
audit.

Prevent 
deletion of 
result with task

Audit Result 
[cert_audit_result]

Prevents deletion of an audit result with an attached task.

Prevent delete 
of Template 
with Audit

Certification 
Template 
[cert_template]

Prevents deletion of a template still being used by an 
audit.

Update 
conditions' 
tables

Certification 
Template 
[cert_template]

When storing template conditions, properly run all 
workflows and update the condition fields to contain the 
display version of the conditions.

Update filter 
version

Certification Filter 
[cert_filter]

Creates a version when the filter changes in any 
meaningful way.

Update next 
run time

Audit [cert_audit] Updates the time in the Next scheduled run field when an 
audit is modified.

Update next 
run time during 
execution

Audit [cert_audit] When the audit runs, update the Next scheduled run field 
to the next time the audit is scheduled to run.

Update table Certification 
Template 
[cert_template]

Update the stored table to the table of the filter.

Update 
template 
version

Certification 
Template 
[cert_template]

Creates a version when the template changes in any 
meaningful way.

Compliance Overview module

The Compliance Overview module is a type of a homepage.

About this task
The Compliance Overview module summarizes:

• Current audit states

• Outstanding certification tasks

• Compliance discrepancies

• Upcoming audits

• General state of compliance audits for Data Certification, Desired State, Architectural 
Compliance, and Scripted audits

Only users with certain roles can access the Overview module. The different levels of access are:
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Access levels per role

Role Access

certification
View (view overview page and refresh reports)

certification_admin

• View (view overview page and refresh reports)

• Customize (refresh, add, delete, and rearrange reports)

View, customize

admin

• View (view overview page and refresh reports)

• Customize (refresh, add, delete, and rearrange reports)

• Edit (can edit gauges)

Procedure

1. Navigate to All  > Compliance  > Overview.

2. Select elements within the reports to obtain more information.
For example, select a bar in the Compliance Discrepancies chart to open a list of audit results 
filtered by the respective attributes.

Architecture Compliance

Architecture Compliance manages scheduled or on-demand audits of CMDB  data to determine 
which configuration items (CI) match expected attributes. The compliance audits check servers 
to ensure that their physical resources, such as CPU speed or memory, comply with certain 
standards.

The compliance process checks servers to ensure that their resources, such as CPU speed or 
memory, comply with standards set by your organization. Audit reports show any discrepancies 
in the attributes of the target CIs, and ServiceNow  automatically assigns follow-on tasks to 
qualified users who can remediate those discrepancies.

The administrator responsible for compliance checking creates template definitions of expected 
attributes and then schedules an audit to check CIs for compliance. The audit results identify 
CIs that pass certification and itemize the discrepancies in those CIs that fail. ServiceNow 
automatically generates and assigns follow-on tasks to track the process of getting the CIs back 
into compliance. Users with the admin role activate Architecture Compliance.

Architecture Compliance roles

To access or configure certification elements, a user must have the certification_admin role. 
These users can create, update, and delete filters if they have the proper access to necessary 
tables.

In the base system, certification_admin users have limited system rights and do not have access 
to all the necessary tables. When assigning compliance resources, make sure to grant additional 
roles to the certification_admin user as needed. For example, the certification administrator 
needs roles that grant access to these tables:
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• Company [core_company]

• Cost Center [cmn_cost_center]

• Schedule [cmn_schedule]

Architecture Compliance Process

Perform these tasks in this order to certify configuration items with Architecture Compliance.

1. Create a filter.

Create a filter that defines a subset of configuration items to certify. You can create multiple 
versions of a filter, and then activate the version you want to use for compliance checking. 
Architecture compliance only supports filters on the Configuration Item [cmdb_ci] table and all 
tables that extend it.

2. Create a template.

Create template conditions using values from reference fields in a related list or conditions 
that define the expected physical attributes of each CI in an audit. The template uses a filter to 
determine which configuration items the system examines based on these conditions.

3. Create and run an audit.

Create and schedule an audit or run an audit on demand. The audit generates a set of results 
based on the conditions in the template you specify.

4. View audit results.

View the audit results which display any discrepancies between the expected state, as 
expressed by the template conditions, and the actual state of the target configuration items.

5. Correct discrepancies.

Correct the discrepancies the audit found by completing the follow-on tasks created by the 
system.

Architecture Compliance Overview module

The Architecture Compliance Overview module displays various architecture compliance 
reports. The Overview module is a type of homepage.

Only compliance users with certain roles can access the Overview module. The different levels 
of access are:

Access levels per role

Role Access

certification
View (view overview page and refresh reports)

certification_admin

• View (view overview page and refresh reports)

• Customize (refresh, add, delete, and rearrange reports)

View, customize
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Access levels per role  (continued)

Role Access

admin

• View (view overview page and refresh reports)

• Customize (refresh, add, delete, and rearrange reports)

• Edit (can edit reports)

Using the Architecture Compliance Overview module

To use the Architecture Compliance Overview module, navigate to Compliance  > Architecture 
Compliance  > Overview  and click elements within the gauges to obtain more information.

The available reports are:

Architecture Compliance Overview module gauges

Report Description Table

30/60/90 Day Task Aging All outstanding follow-on tasks grouped by age 
in 30-day increments

Certification 
Task

Architecture Compliance 
Discrepancies

All audited attribute discrepancies Audit 
Results

Hierarchical Task Roll Up All follow-on tasks grouped by Assigned to  user Follow On 
Task

Outstanding Architecture 
Compliance Tasks

All follow-on tasks in the Pending, Open, or 
Work in Progress  state

Follow On 
Task

Upcoming Architecture 
Compliance Audits

All scheduled audits Audit
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Architecture Compliance module

Desired State

Desired State performs scheduled or on-demand audits of CMDB  data to determine which 
records match the expected attributes, CI relationships, and relationships to other records in the 
system.

For example, desired state can determine if a computer has a license for a particular software 
program. The compliance process checks configuration items (CI) to ensure that their attributes 
and relationships comply with standards set by your organization. Audit results show any 
discrepancies in the desired state of a record, and ServiceNow  automatically assigns follow-on 
tasks to qualified users who can remediate those discrepancies.

Desired State roles

To access or configure certification elements, a user must have the certification_admin role. 
These users can create, update, and delete filters if they have the proper access to necessary 
tables.

In the base system, certification_admin users have limited system rights and do not have access 
to all the necessary tables. When assigning compliance resources, make sure to grant additional 
roles to the certification_admin user as needed. For example, the certification administrator 
requires roles that grant access to these tables:

• Company [core_company]

• Cost Center [cmn_cost_center]

• Schedule [cmn_schedule]
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Desired State process

The desired state certification process can mean checking servers to ensure that their physical 
resources, such as CPU speed or memory, comply with certain standards. This process also 
ensures that all critical business services have a manager, support group, and approval group 
assigned.

The administrator responsible for certification creates definitions of desired states and then 
schedules an audit to check CIs for compliance. The audit results identify CIs that pass 
certification and itemize the discrepancies in those CIs that fail. The ServiceNow  system 
automatically generates follow-on tasks to track the process of adjusting the CIs to the desired 
state.

Desired state differs substantially from data certification. Data certification is a manual process 
to ensure that your data matches reality. Desired state examines the same data and determines 
when the configuration of each item is in the desired and approved state.

1. Create a certification filter: Create a filter that defines a subset of configuration items to certify. 
You can create multiple versions of a filter, and then activate the version you want to use for 
certification. You can create filters on the Configuration Item [cmdb_ci] table and all tables 
that extend it.

2. Create a template: Create a template with conditions that define the desired state of the 
physical attributes, related records, and relationships for a CI. The certification filter you select 
for the template determines which configuration items the system examines.

3. Create and run an audit: Create an audit using the template. Set the audit to run on a schedule 
or on demand. The audit generates a set of results based on the conditions from the template 
you specify. Determine usage of follow-on tasks:

◦ Determine if the audit creates follow-on tasks and assignment.

◦ Determine if the same follow-on task is used for the same audit failure across multiple runs. 
The system attribute glide.allow.new.cert_follow_on_task  is set to true by 
default, allowing for new follow on tasks to be created for the same failure, at each audit run.

4. View audit results: View the audit results which display any discrepancies between the desired 
state, as specified by the template, and the actual state of the target configuration items.

5. Correct discrepancies: Correct the discrepancies the audit found by completing the follow-on 
tasks created by the system.

Desired State Overview module

The Desired State Overview module displays various desired state reports. The Overview 
module is a type of homepage.

Desired State Overview module roles

Only compliance users with certain roles can access the Overview module. The different levels 
of access are:

Access levels per role

Role Access

certification
View (view overview page and refresh reports)
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Access levels per role  (continued)

Role Access

certification_admin

• View (view overview page and refresh reports)

• Customize (refresh, add, delete, and rearrange reports)

View, customize

admin

• View (view overview page and refresh reports)

• Customize (refresh, add, delete, and rearrange reports)

• Edit (can edit reports)

The different levels of access are:

• View: can view the overview page and refresh reports.

• Customize: can refresh, add, delete, and rearrange reports.

• Edit: can edit reports.

Use the Desired State Overview module

The Desired State Overview module displays various desired state reports.

Before you begin
Role required: none

Procedure

1. Navigate to All  > Compliance  > Desired State  > Overview.

2. Move or add reports where needed.

3. Click elements within the reports to obtain more information.

The Desired State Overview Module in the base system contains these reports:

◦ Upcoming Desired State Audits: All scheduled audits.

◦ Outstanding Desired State Tasks: All follow-on tasks in the Pending, Open, or Work in 
Progress  state.

◦ Hierarchical Task Roll Up: All follow-on tasks grouped by Assigned to  user.
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◦ Desired State Discrepancies: All audit discrepancies for attributes and relationships.

◦ 30/60/90 Day Task Aging: All outstanding follow-on tasks grouped by age in 30-day 
increments.

Desired State reporting

The Desired State application includes reports to assess your audit results.

These reports are available to all users whose role gives them access to the Reporting
application. Users with the admin role can share these reports with specific users of groups or 
change the display options.

Navigate to Reports  > View / Run. In the Reports  search field, enter all or part of the report name 
such as Desired State. You can also scroll to the designated category and select one of the 
reports.

In addition to these reports, you can generate your own reports.
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Desired state report table

Report Description Category

Desired State 
Discrepancies

This report displays all desired state audit results that have a 
follow-on task that is not yet in the Closed Complete state. This 
report displays by column name.

• Type: bar chart

• Table: Audit Result [cert_audit_result]

Audit 
Result

Desired State 
Result with 
Stability Unstable

This report displays all audit results where the Stability field has 
the value Unstable. This report displays by CI and stacked by 
audit.

• Type: bar chart

• Table: Audit Result [cert_audit_result]

Audit 
Result

Desired State 
Result with 
Threshold 
Exceeded

This report displays all audit results where the Threshold field 
has the value Exceeded. This report displays by CI and stacks by 
each audit.

• Type: bar chart

• Table: Audit Result [cert_audit_result]

Audit 
Result

Upcoming Desired 
State Audits

This report displays the desired state audits that are scheduled 
to run in the next two quarters.

• Type: List (tabular) report

• Table: Audit [cert_audit]

Audit

30/60/90 Day 
Desired State 
Task Aging

This report displays the number of follow-on tasks that are not 
Closed Complete for desired state audit types. The report is 
grouped by aging level.

• Type: Horizontal bar chart

• Table: Follow On Task [cert_follow_on_task]

Follow 
On Task

Desired State 
Hierarchical Task 
Roll Up

This report displays similar data to the Task Aging report, but 
groups the results by manager.

• Type: Horizontal bar chart

• Table: Follow On Task [cert_follow_on_task]

Follow 
On Task

Outstanding 
Desired State 
Tasks

This report displays similar data to Task Aging report, but groups 
the results by short description.

• Type: List (tabular) report

• Table: Follow On Task [cert_follow_on_task]

Follow 
On Task
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Certification audits

A certification audit compares the actual attributes of certain ServiceNow  records. This audit 
selects a filter, against the expected attributes, relationships, and related record values defined 
by template conditions or a script.

You can configure the audit to create and assign follow-on tasks to remediate any discrepancies 
the audit finds. Audit records use a standard ServiceNow  scheduler to determine when to run. 
After an audit runs, the results and follow-on tasks appear in related lists in the audit record.

Users with the certification_admin role can create, update, delete, and run audits. Users with the 
certification role can view audits, audit results, and follow-on tasks.

Create a compliance audit

Create a compliance audit. Compliance offers two types of audits: one uses templates to define 
conditions and the other uses a script.

Before you begin
Role required: certification_admin

Procedure

1. Ensure that an appropriate template record was created for this audit.

Note: 
Conditions in the template define the values to audit.

2. Use the CI Class Manager:

a. Navigate to All  > Configuration  > CI Class Manager.

b. Select a class from the Class Hierarchy.

c. In the sidebar on the right, check Advanced  and then click Audit  in the Compliance  group.

3. Or, navigate to one of these modules:

◦ All  > Compliance  > Audits

◦ All  > Compliance  > Architecture Compliance  > Audits

◦ All  > Compliance  > Desired State  > Audits

◦ All  > Compliance  > Scripted Audits  > Audits

4. Click New.
The system opens a new record for the audit type associated with the navigation path you 
selected. The Audit type  field is read-only.

5. Complete the form using the fields described in the table below.

6. Right-click the header bar and select Save.

The Audit Results  and Follow On Tasks  related lists appear on the form.

7. To run the audit immediately, click Run Audit.

When template audits run, ServiceNow  updates the date and time in the Last run date  field 
and populates the related lists. For scripted audits, the Last run date  field is not populated.

8. View the records that passed and the discrepancies found by the audit in the Audit Results 
related list.
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You can open template records and any follow-on tasks directly from this related list. Notice 
that the value in the Task description  field appears as the Short description  in the follow-on 
tasks.

Note: 
You cannot delete audit records that have audit results or audit results that have follow-on 
tasks. ServiceNow  disables the Delete  option in records and lists where these dependent 
records exist.

Creating Audits

Field Description

Name Name for this audit.

Filter Filter to use when the audit type is Scripted. This field is required for scripted 
audits, but is hidden for all other audit types.

Template [Required] Template to use when this audit runs. Audit type filters the list of 
available templates, and only the active versions of templates are available 
for selection. For example, when you create an audit from Desired State, only 
templates of the Desired State audit type are available for selection. For the 
Desired State and Architecture Compliance audit types, only templates for 
tables that extend the Configuration Item [cmdb_ci] table are available. This 
field is hidden when the audit type is Scripted.

Table [Read-only] Table for the template.

Create 
tasks

Option to create follow-on tasks for correcting discrepancies (selected). In a 
scripted audit, you can create the logic for either task state by using true  to 
create tasks or false  to not create tasks. By default, this check box is cleared 
(false) in a new audit record.

Assignment 
type

Method for assigning follow-on tasks. This field is visible only when the Create 
task  check box is selected. Choices are:

◦ User Field: Select a user reference field on the table being audited. For 
example, you choose the user identified in the Managed by  field on the failed 
record to perform the tasks. This selection displays the Assigned to  and 
Assign to empty  fields. If the reference field on the record is empty, the value 
in the Assign to empty  field is used.

◦ Specific User: Select a specific user to perform the tasks. This selection 
displays the User  field.

◦ Group Field: Select a group reference field on the table being audited. For 
example, you choose the group identified in the Support group  field on the 
failed record to perform the tasks. Tasks are assigned to all members of the 
group. This selection displays the Assign to group  and Assign to empty 
fields. If the reference field on the record is empty, the value in the Assign to 
empty  field is used.

◦ Specific Group: Select a specific group to perform the tasks. This selection 
displays the Group  field. All members of the selected group are assigned to 
the tasks.

User The specific user this audit assigns to follow-on tasks. This user must have the 
certification role. This field is available under these conditions:
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Field Description

◦ Assignment type is set to Specific User.

◦ Assign to empty is set to Create Assigned Task, and Assignment type  is set 
to User Field.

Assign to 
group

The group field that defines which group this audit assigns to the follow-on task. 
This field is available only when the Assignment type  is Group Field.

Group The specific group this audit assigns to follow-on tasks. This field is available 
only when the Assignment type  is Specific Group.

Assign to The user field that defines which user this audit assigns to the follow-on task. 
This field is available only when the Assignment type  is User Field.

Assign to 
empty

The behavior to use if the field selected in Assign to  or Assign to group  is blank 
on the record being audited. For example, if a follow-on task must be assigned 
to a manager, but no manager is identified, the Assign to empty  setting 
determines what happens. This field appears only when the Assignment type 
is User Field  or Group Field. Choices are:

◦ Do Not Create Task: No follow-on task is created when the Assign to  or 
Assign to group  field is empty.

◦ Create Unassigned Task: Create a follow-on task, but do not assign it to any 
user or group. The task can be manually assigned later.

◦ Create Assigned Task: Create a follow-on task and assign it to the user or 
group specified. If the assignment type is User Field, the User  field becomes 
available. If the assignment type is Group Field, the Group  field becomes 
available.

The audit automatically creates follow-on tasks for all records that have Assign 
to  populated, regardless of the Assign to empty  setting.

Short 
description

Brief description of the purpose of the audit.

Task 
description

General description of the work required for the follow-on tasks for the audit. All 
follow-on tasks created by this audit inherit this description.

Active Activation control for this audit record. Clear this check box to prevent this audit 
from running and creating follow-on tasks.

Run How often to run the schedule that generates the audit.

◦ Daily

◦ Weekly

◦ Monthly

◦ Periodically

◦ Once

◦ On Demand

Day ◦ If Run  is Weekly, the day of the week when the audit runs.

◦ If Run  is Monthly, the day of the month when the audit runs. If the day is 29, 
30 or 31, for shorter months the audit runs on the last day of the month.

Repeat 
Interval

If Run  is Periodically, the frequency that the audit runs, based on a 24-hr. 
clock. Enter the number of days between audits and the time of day that you 
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Field Description

want the audit to run. For example, set Days  to 10  and Hours  to 14:00:00  to run 
the audit every 10 days at 2:00pm.

Starting If Run  is Periodically  or Once, the date and time when the audit runs.

Time If Run  is Daily, Weekly, Monthly, or Once, the time of day, on a 24-hour clock, 
when the audit runs.

Last run 
date

[Read-only] The last date and time the audit ran, either on its regular schedule 
or manually. Audit previews do not update this field.

Next 
scheduled 
run

[Read-only] The next date and time when the audit runs. The system 
recalculates this field when you change the schedule.

Audit type [Read-only] The type assigned to this audit. The system selects the audit type 
based on the application from which the audit is created. The type can be:

◦ Desired State

◦ Architecture Compliance

◦ Compliance

◦ Scripted

Health 
window

Duration of the evaluation period for threshold and stability. The health window 
value defines the number of Health window units in an evaluation period for an 
audit. This value is expressed as a positive integer. The default value for this 
field is 7.

Health 
window 
unit

Unit of measurement that defines the duration of a health window. The default 
value for this field is Days. Choices are:

◦ Minutes

◦ Hours

◦ Days

◦ Months

Threshold 
count

Sets the acceptable number of audit failures for the desired state field that can 
occur within the specified health window for a CI. The audit results indicate 
when a desired state field is within or has exceeded this threshold limit. The 
default value for the threshold is 5.

Stability 
count

Sets the acceptable number of times that audit results for a CI can switch 
between Certified  and Failed  within the specified health window. The audit 
results for a CI indicate whether it is stable or unstable. The default value for 
stability is 1.

Run this 
script

Audit script to run which contains the conditions that a CI need to comply with 
to pass the audit. This field is available only when the audit type is Scripted. 
The Audit form includes a sample script with instructions for performing the 
audit and generating the follow-on tasks.

Copy an audit

New audits can be created from an existing audit.

Before you begin
Role required: none
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Procedure

1. Open the audit record you want to copy.

2. Change the name or short description to distinguish this audit from the original.

3. Make any other changes you need.

4. Right-click in the header bar and select either Insert or Insert and Stay from the context menu.
The system clears the Last run date  field and inserts the record into the database.

Schedule and run an audit

The system performs audits automatically from the schedule you configure.

Users with the certification_admin or admin role can generate on-demand audits directly from 
the Audit form by clicking Run Audit. When an audit runs, ServiceNow  populates the Audit 
Results  related list in the form and shows follow-on tasks, if any, in the Follow On Tasks  related 
list. Click Preview Audit Results  to generate an audit preview that tests your template conditions 
without generating any audit results.

Certification audit results

Audit results show the records that have passed or failed an audit and itemize any discrepancies 
detected.

A discrepancy is considered any departure from the expected conditions defined in the template 
or script used for the audit. Audit results provide links to the source records and to the follow-on 
tasks for bringing failed records into compliance. Records that pass an audit have a single entry 
in the results table with a state of Certified. Records that fail an audit show all discrepancies, 
each with a state of Failed.

ServiceNow  displays results from a certification audit in these locations:

• Audit Results list

• A related list in the Audit record

• A related list in the compliance view of a CI record

View an audit result

To generate certification results, you must first create and run an audit.

Before you begin
Role required: none

Procedure

1. Navigate to one of the following locations:

◦ Compliance  > Desired State  > Audit Results

◦ Compliance  > Architecture Compliance  > Audit Results

◦ Compliance  > Scripted Audits  > Audit Results

◦ Data Certification  > Schedules  > Audit results

2. From any audit results list, you can edit the filter to show the results for any audit type.
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Audit Type filter

The results filter by audit type and grouped by audit number. Within the groups, results list by 
date, from oldest to newest.

3. You can open the audit record, the CI record, or the follow-on tasks from this list.

Note: 
The Audit type  field was set automatically when the audit result was created and cannot 
be changed. For scripted audits, the audit type is set when you create the audit record.

Audit results show this information:

Audit Results

Field Description

Created Date and time the audit ran.

Document Record that was certified, such as a configuration item (CI).

State
Results of certification for each condition evaluated. The three possible states 
are:

◦ Certified  A certified record is one that passed all conditions. The instance 
generates only one audit result for a certified record.

◦ Failed  Records that are not certified have an audit result for each failed 
condition. The Column name, Desired value, Discrepancy value, and 
Follow on taskare only populated for failed results.

◦ Pending  A pending state indicates that the audit is incomplete. Data 
certification audits use this state when a result is awaiting user input.

Column 
name

Audited field, relationship, or related list column that did not match the 
expected state.

Desired 
value

Attribute or relationship required for this record that was not found, from the 
condition in the expected state template. For data certification, this column is 
blank if the record has a state of Failed  or Pending.

Discrepancy 
value

Actual value of the attribute that did not match the expected state. The follow-
on task, if provided, tracks resolution of this discrepancy. In a list of results for 
the Data Certification  audit type, this column is blank if the record has a state 
of Certified  or Pending.

Follow on 
task

Link to the follow-on task generated for remediating a discrepancy.

Audit Link to the audit record that produced the results.

Threshold
State of an audited, desired state field with a defined failure threshold. This 
threshold is the acceptable number of failures for a desired state field within 

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

491



Field Description

a specified health window and is configured in the Audit form. Possible 
threshold states for the results are:

◦ In Limit

◦ Exceeded

Stability
Stability state of a CI. Stability state is based on the number of times the 
audit result for a desired state field changes from Certified to Failed within a 
specified health window. Possible stability states are:

◦ Stable

◦ Unstable

Delete an audit result

While audit results can be deleted, you cannot delete an audit result that has a follow-on task 
associated with it.

Before you begin
Role required: none

Procedure

1. Navigate to one of these modules:

◦ Compliance  > Desired State  > Audit Results

◦ Compliance  > Architecture Compliance  > Audit Results

◦ Compliance  > Scripted Audits  > Audit Results
The list groups by audit name.

2. Select the check box for a result in the list, and then select Delete  from the Actions on 
selected rows  menu at the bottom of the list.

Note: 
If the result record has a follow-on task, the Delete  option is not available. If you select 
multiple records, some with and some without tasks, the system only deletes those 
records that do not have tasks.

3. Click a date/time link to see the results for a specific CI.

Note: 
The Delete  button only appears on the form if the audit result does not have a follow-on 
task.

4. Click Delete.

View an audit result in the Compliance view

After an audit has run, you can view the results and follow-on tasks from the Compliance view in 
the records of every CI audited.

Before you begin
Role required: none
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About this task
This view is available only for systems that use the default CI classes provided with the base 
ServiceNow  system, such as Hardware, Software, and Computer. For information about creating 
views, see View Management.

Procedure

1. Navigate to All  > Configuration  and open the record of a CI that was included in a compliance 
audit.

2. Select the view to configure by performing the appropriate action for your list version.
The Audit Results Compliance View appears.

Audit Results Compliance View List Descriptions

Lists Description

Passed 
Audit 
Results

Lists audits for this CI that passed without discrepancies. The information includes 
the versions of the template and filter used. Records are grouped first by audit, and 
then by creation date and time.

Failed 
Audit 
Results

Lists all failed audits for this CI. The information includes the discrepancy data, 
the follow-on task, and the versions of the template and filter used. Records are 
grouped first by audit, and then by creation date and time.

Follow 
On 
Tasks

Lists all follow-on tasks generated from audit discrepancies for this CI.

3. Right-click the header bar and select View  > Compliance  from the context menu.

Results preview

You can preview an audit to view potential results without saving audit results or generating 
follow-on tasks. For example, use this feature to test template conditions for correctness without 
creating thousands of result records.

In an audit record, click Preview Audit Results  under Related Links  to show a summary of the 
potential audit results appears at the top of the audit record.

Previewing does not change the Last run date  field.

Health windows

A health window is a trailing time frame in which the ServiceNow  system evaluates audit results 
from CIs that have desired state fields defined.

The Health window  and Health unit  fields define each window, and ends when an audit runs. 
For example, an audit runs on the fifteenth of the month with a seven-day window. It evaluates 
the threshold values of a desired state field from the eighth to the fifteenth. When the same audit 
runs the next day, the system evaluates the threshold from the ninth to the 16th, and so on. The 
audit counts backward seven days from the current day. ServiceNow  evaluates a CI threshold 
value for each health window, without considering the results from the previous window. As a 
result, the health of a CI can fail for one audit and then pass in a subsequent audit that runs in a 
new window.

ServiceNow  evaluates stability by recording the number of times a desired state threshold value 
for a CI switch between Failed  and Certified  within the health window. In the example shown 
here, a 5-minute health window was set for the desired state field on a UPS unit that measures 
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the remaining battery time. The threshold was set at 2, which allows the field to fail two audits in 
the same health window.

In the initial audit, the system evaluated the threshold value for the Seconds on battery  field 
within a 5-minute window. This window ran from 13:52:51 to the time of the audit at 13:57:51. The 
desired state field showed In Limit for that audit and the second audit conducted less than a 
minute later. The next two audits were conducted within five minutes of the first audit and both 
showed that the threshold (set at 2) was Exceeded. A subsequent audit was conducted five 
minutes after the audit in which the desired state field threshold was first exceeded. Since the 
health window had moved forward enough units, the Seconds on battery  field was within limits 
again with only one failure in the 5-minute window being evaluated.

Certification filters

A certification filter creates a subset of ServiceNow  records to audit, typically from configuration 
items (CI) of a certain type, such as all UNIX  servers in a specific datacenter.

However, you can define a filter for any ServiceNow  table by using any set of system-supported 
conditions. Audited records identified by a filter for expected attributes or relationships, 
depending on the audit type.

You can create multiple versions of a filter, reactivate inactive versions, and select the version 
you want to use in a template or a certification schedule. Only the active versions of a filter are 
available for selection in template records. You can use a single filter for multiple certification 
templates or schedules.

Certification filters

Filter Description

Data Certification Validates CMDB  data.

Architecture 
Compliance

Manages reviews of CMDB  data in architecture compliance audits to 
determine which configuration items (CIs) match expected attributes.

Desired State Manages reviews of CMDB  data to determine which CIs match a desired 
state for both attributes and relationships.

Compliance Manages reviews of records from any ServiceNow  table to determine which 
records match an expected set of attributes and related record conditions.

IT Governance 
Risk and 
Compliance

Generates audits and tests to ensure that controls are being followed and 
creates tasks to track corrective actions.

Roles

In the base ServiceNow  system, users with the certification_admin role have limited system 
rights and do not have access to the tables required for creating a filter.

When assigning compliance resources, make sure certification_admin users have any 
additional roles they need. For example, a user requires roles that grant access to the Company 
[core_company]  table.

Compliance filter

The compliance filter for license bases uses the following fields to define entitled users or CIs.

These field values can be used independently or together to calculate compliance.
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Compliance Filter

Value Description

Entitled 
company

All users or configuration items (CI) at all locations of this company, in all 
departments are entitled to use this software package. Compliance at this level 
calculates how many licenses are purchased for the company at large and how 
many entitled users or CIs consume them.

Entitled 
location

CIs and users who are assigned to this company location in any department are 
entitled to use this software package. Compliance at this level calculates how 
many licenses are purchased for this company location and how many users and 
CIs consume them.

Entitled 
department

Only the users or CIs in this department at this company location are entitled to 
use this software package. Compliance is calculated for a single department only.

The license form can display information about all CIs or named users who are using this 
software package. The form indicates when license reconciliation is necessary and displays all 
compliant users or CIs.

Possible compliance levels are:

Compliance

Level Description

Non 
applicable

Compliance levels for all infrastructure licenses that are related to cluster 
licenses are set to Non applicable  automatically. Compliance levels are 
calculated in the cluster license only, and not in the related infrastructure 
licenses.

Out of 
compliance

More licenses are being consumed than were purchased. There are more 
users or CIs using this license than the license allows, and some users or CIs 
are not be entitled to use this software package.

Unused The licenses for this software package are currently unused.

Reconciliation 
required

CIs or users who are not entitled to use this software are consuming licenses. 
Licenses that require reconciliation are considered out of compliance. 
Reconciliation requires action to ensure that unentitled users are not using the 
software. Reconciliation involves uninstalling software or increasing license 
counts to match actual user counts.

Nearly out of 
compliance

For a software package to be at this compliance level, more than 95% of the 
licenses are in use by entitled users or CIs. License bases at this level are 
considered to be In compliance.

In compliance This software package has unused licenses. All users or CIs using a license are 
entitled to use this software package.

Create a filter

You can create as many versions of a filter as necessary. You can then designate which versions 
are active and available for selection in Compliance template records, Governance Risk and 
Compliance control test definitions, or Data Certification schedule definitions.

Before you begin
Role required: none
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Procedure

1. Navigate to All  > Configuration  > CI Class Manager, and:

a. Click Hierarchy  to display the CI Classes list.
Select the class to create a filter for.

b. In the class navigation bar, expand Health, select Compliance, and then click Certification 
Filter.

2. Or, navigate to one of these modules:

◦ Compliance  > Filters

◦ Data Certification  > Schedules  > Certification Filters

3. Select an existing filter to edit, or click New.

4. Fill in the fields (see table below).

5. Click Submit.
This action saves the filter as version 1.

6. To create another version of this filter, open the record and modify the name, table, or 
conditions.

Note: 
You can change a filter Description without incrementing a version.

7. Click Update.

The system saves a new version of the current filter and makes it the Active version. The 
previous version is marked inactive. The system displays only active filter versions for selection 
when you create templates or schedules.

Creating Filters

Field Description

Number [Read-only] Displays the automatically assigned filter identification number. All 
versions of a filter have the same number.

Name [Required] Filter name.

Description [Optional] Describes this filter. You can change the description of a filter without 
incrementing a version.

Table Specifies the table containing the records to select. The template or schedule 
that uses this filter works on this table. For example, select the ESXi Server 
[cmdb_ci_esx_server]  table to select VMware ESX servers.

Active Makes this filter available for use from the Filter  field on the Certification 
Template or Schedule Definition form. Multiple versions of a filter can be active. 
You can activate or deactivate a filter without incrementing the version.

Version [Read-only] Indicates the version of this filter. Any changes to this filter, except 
to the description or the Active  check box, makes it inactive. The system 
increments the version of the updated filter and marks it as active. The system 
saves all versions of the filter and makes them available for reactivation.
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Field Description

Filter 
condition

Specifies the fields, operators, and values that create the filter. The available 
fields are based on the selected table. The condition builder shows the number 
of records that match the conditions. Click the refresh icon

Refresh Conditions

to recalculate the number of matching records when you edit the conditions.

Copy a filter

New filters can be created from an existing filter.

Before you begin
Role required: none

Procedure

1. Navigate to All  > Configuration  > CI Class Manager, and:

a. Click Hierarchy  to display the CI Classes list.
Select the class to create a filter for.

b. In the class navigation bar, expand Health  and select Compliance.
Then click Certification Filter.

2. Or, navigate to one of these modules:

◦ Compliance  > Filters

◦ Data Certification  > Schedules  > Certification Filters

3. Open the filter record that you want to copy.

4. Make sure to change the filter name or description to distinguish the new filter from the 
original.

5. Make any other necessary changes.

6. Right-click in the header bar and select either Insert  or Insert and Stay  from the context menu.
The system increments the record number and sets the version to 1 for the new record. Both 
the original filter and the copy are Active and appear in the record list. Showing all copies of a 
filter allows you to see the entire history of the filter.

Delete a certification filter

Delete certification filters that are no longer needed and no longer in use.

Before you begin
Role required: certification_admin or admin

About this task
You can't delete a certification filter that is being used in a template or a scripted audit.
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Procedure

1. Navigate to All  > Configuration  > CI Class Manager, and:

a. Select Hierarchy  to show the CI Classes list.

b. Select the class to delete a filter for.

c. In the class navigation bar, expand Health.

d. Select Compliance  and then Certification Filter.

2. Or, navigate to one of these modules:

◦ Compliance  > Filters

◦ Data Certification  > Schedules  > Certification Filters

3. Open the filter record you want to delete.

a. To delete a single filter version, open that version record and click Delete.

The system hides the Delete  button for filters that are in use. If you delete the latest version 
of a filter that is active, the previous version of that filter is reset to Active.

b. To delete all unused and inactive versions of a filter, open any version of that filter and click 
Delete inactive versions  under Related Links.

4. When prompted, select OK  to proceed.
The system deletes unused filter versions. A message in the header bar identifies filter 
versions that cannot be deleted because they are used in a template or scripted audit.

Manage a filter version in a form

You can view and manage all versions of a filter from the Certification Filter form.

Before you begin
Role required: none

About this task
Versions can be displayed in a list. The default list of filters displays only the active version of 
each filter. To see all filter versions in the list view, select All  in the breadcrumbs.

Procedure

1. Open any version of a filter.
The Other Versions related list displays all other versions of this filter, both active and inactive. 
The system prevents you from editing either the filter version or the record number in the list 
view.

2. Click any version in the related list to display the record for that version.

3. To make an inactive filter the current version, open the filter, edit it if desired, and then click 
Revert.

This action:

◦ Deactivates the previous active version of the filter.

◦ Copies the inactive filter.

◦ Makes this new copy current and active.
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Certification follow-on tasks

The ServiceNow  system can automatically generate and assign follow-on tasks to correct 
discrepancies detected during compliance audits.

The system attribute glide.allow.new.cert_follow_on_task  is set to true by default, 
allowing for new follow on tasks to be created for the same failure, at each audit run. You can set 
this property to false, to configure audit to use the same follow-on task for the same audit failure 
across multiple runs.

You configure and assign follow-on tasks to qualified users or groups in the audit record. A user 
with the certification_admin role can reassign any follow-on task. The Audit Results related list in 
the Follow On Task form contains links to the records that failed.

Access follow-on tasks

Users with the certification role can only access follow-on tasks assigned to them but can 
reassign these tasks to other users.

Procedure

1. Navigate to All  > Compliance  > My Follow On Tasks.
The list contains all active follow-on tasks assigned to the logged in user.

2. Open a task.

The record shows the specifics of the task, the task activity, and the failed audit results.

3. Open records from the Audit Results  related list to see each discrepancy.

4. Go to the CI named in the record and perform the work to bring it into compliance.

5. Update the State  field in the follow-on task record and add work notes as you correct each 
discrepancy.

When you change the state, the system updates the task activity appropriately.

When the task is Closed Complete  it no longer appears on the My Work  list.

Manage follow-on tasks

Users with the certification_admin or admin role can see all follow-on tasks.

Before you begin
Role required: none

About this task
Tasks are pre-assigned to a user or group as specified in the audit record, but users with the 
certification_admin role can reassign the task.

Procedure

1. Navigate to the appropriate application:

◦ Compliance  > Architecture Compliance  > Follow On Tasks

◦ Compliance  > Desired State  > Follow On Tasks

◦ Compliance  > Scripted Audits  > Follow On Tasks

The list of follow-on tasks appears, filtered by audit type.

2. Open a task.
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The Audit  and Configuration item  fields are read-only for all users.

3. Edit the Change group  or the Assigned to  field if necessary.

4. Edit the Short description  field if necessary.

The short description is inherited from the Task description  field in the Audit form.

5. Use the links in the Audit Results  related list to open the individual records that failed the 
audit.

6. If you update the follow-on task record, be sure to add work notes.

Certification templates

Certification templates can define attributes, relationships, and reference field values that 
indicate what a record is expected to contain.

These values are used to perform audits on ServiceNow  records. The certification filter selected 
in the template identifies the table and records to audit, and the template conditions set the 
expected state for those records. The type of audit you create determines which tables and 
template conditions are available.

Users with the certification_admin role can create, update, and delete templates. Users with the 
certification role can view template versions.

Certification template audit types

When you create a template, ServiceNow  assigns an Audit type that determines which tables 
and conditions are available in the certification template. This value is based on the application 
from which the template is created. Each application lists only the templates with the associated 
type.

Available Condition Builders

The available condition builders for each audit type:

• Compliance: Runs audits on any set of ServiceNow  records, not only configuration items (CI). 
This audit type provides the following types of conditions for any ServiceNow  table:

◦ Attribute: Sets conditions for the attributes of the records.

◦ Related List: Runs audits on records in tables that reference the table defined in the 
template.

• Architecture Compliance:  Defines the following types of conditions for tables that extend the 
Configuration Item [cmdb_ci] table.

◦ Attribute:  Sets conditions for physical attributes of CIs, such as memory or disk size.

◦ Related List:  Runs audits on records in tables that reference the table defined in the 
template.

• Desired State: Defines the following types of conditions for tables that extend the 
Configuration Item [cmdb_ci] table.

◦ Attribute: Sets conditions for physical attributes of CIs, such as memory or disk size.

◦ CI relationship: Defines the relationships these CIs have with other CIs. An example of a 
relationship is a business service, such as Outlook Web Access, that depends on a server.

◦ User relationship: Defines the user who reviewed the log records. The only operator 
available with this condition builder.
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◦ Group relationship: Defines user groups who backed up this CI. The only operator available 
with this condition builder.

◦ Related List: Runs audits on records in tables that point toward the table defined in the 
template.

Certification Template Record List

The default Templates list displays only the active version of each template, but you can update 
the breadcrumbs to display all template versions.

• Default Templates List: The default Templates list displays only the active version of each 
template, filtered by Audit type.

• All Template Versions: To view all template versions for an audit type, click the 
arrow before Active=true  to remove that condition from the breadcrumbs. 

Create or edit a certification template

To create a certification template, follow these instructions.

Before you begin
Activate the Certification Core plugin to enable the Compliance functionality. See Compliance 
Activation  for details.

Procedure

1. Ensure that you have an appropriate filter that defines the records the template evaluates.

The template applies its conditions to these records.

2. Use the CI Class Manager to navigate to the Certification Template form:

a. Navigate to All  > Configuration  > CI Class Manager.

b. Click Hierarchy  to display the CI Classes list.
Select the class for which to create a certification template.

c. In the class navigation bar, expand Health  and then click Compliance.

3. Click Certification Template.

4. Or, navigate using one of these paths:

◦ All  > Compliance  > Architecture Compliance  > Templates

◦ All  > Compliance  > Desired State  > Templates

◦ All  > Compliance  > Templates

◦ All  > Audit Definitions  > Templates

5. Click New  or select a certification template to edit.

The following fields are completed automatically:

◦ Number: Each new template has a unique number. All versions of the same template use the 
same number.

◦ Active: All new templates are set to Active.
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◦ Version: The version of a new template is set to 1.

◦ Audit type: The system sets the default type to Architecture Compliance, Desired State, 
or Compliance, depending on the application in which the template was created. You can 
select a different type when you create the template, but the field becomes read-only when 
you submit the record. The system uses audit types to filter record lists for appropriate data 
and determine which conditions are visible on the template form.

6. Complete the following mandatory fields.

◦ Name: Enter a descriptive name for this template. The name helps identify the purpose.

◦ Filter: Select the filter that identifies the records to be certified. You can select either active 
or inactive filter versions. By default, the system presents only active versions for selection. 
If you start typing the name of a filter, the auto-complete feature displays all versions for 
selection. For architecture compliance and desired state templates, only filters that use a 
table extended from Configuration Item [cmdb_ci] appear on the choice list. All filters appear 
on the choice list for a compliance template. After you select a filter, the template condition 
builder appears. The template operates on the table specified in the filter.

7. Enter a Description  for this template.

8. Define certification conditions using the condition builders.

All conditions are AND conditions. The audit type of the template determines which conditions 
are available.

◦ Certification Attribute Conditions: [All audit types] Select configuration item attributes or 
specifications to certify, such as CPU count, memory, or disk space. Available fields in the 
attribute condition builder depend on the table from the filter. Typical ServiceNow  conditions 
for attributes are available, including the between  operator for setting numerical conditions 
with high and low boundary values. This operator was added specifically for desired state 
conditions.

The Show Related Fields  item supports dot-walking, allowing you to include referenced 
fields in a certification attribute condition. Click Show Related Fields  or Remove Related 
Fields  to add or remove referenced fields (in the form of <field> => <field>). Select a 
referenced field to drill down to the next level of referenced fields.

See Dot walking .

◦ Certification CI Relationship Conditions: [Desired State audit types] Define the CI 
relationships to certify, such as Runs on  or Depends on.

◦ Certification User Relationship Conditions: [Desired State audit types] Select the desired 
user relationship for this configuration item. The relationship provided in the base system is 
Log reviewed by.

◦ Certification Group Relationship Conditions: [Desired State audit types] Select the desired 
group relationship for this configuration item. The relationship provided in the base system is 
Backed up by.

◦ Certification Related List Conditions: [All audit types] Select field values from tables that 
reference the template table, or user-defined related lists which are created via custom 
relationships in the sys_relationship table. To create a condition that evaluates all servers in 
the Server [cmdb_ci_server] table for the presence of Microsoft Word 2007, as referenced in 
the Software Installation [cmdb_sam_sw_install] table. The resulting condition is [Software 
Installation->Installed on] [Display name] [is] [Microsoft Word 2007].
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Check All  to include all records in the condition requirements of the related list. If there are 
no records in the related list, then:

▪ If All  is checked, the condition requirement is met.

▪ If All  is unchecked, the requirement is not met.

Note: 
By default, the condition builders for relationships display only suggested relationships. 
To see all possible relationships, select the Show all relationships  check box on the right 
side of the form.

a. Click Insert a new row  to insert a condition.
You cannot insert an empty condition.

b. Click the green check mark icon to save a condition.
Make sure to save the condition before performing any other operation. Updating the form 
does not save the condition.

c. To delete a condition, click the red X  beside the condition.
The system marks the condition as inactive.

d. To reactivate a condition, click the gray X.
If another condition for the same field exists, the system prevents reactivation and warns you 
of the conflict.

9. Click Submit.
ServiceNow  saves the template as version 1.

10. To create another version of the template, change the name, edit the conditions, or select a 
different filter.
Updating the template description does not create a new version.

Note: 
If you select a filter whose table is incompatible with the existing template 
conditions, the system displays a warning that the conditions cannot be applied. 

11. Click Update.
The system saves a new version of the current template and makes it the Active  version. The 
previous version is marked inactive.

Clone a Certification template

New templates can be cloned from an existing template.

Procedure

1. Open the template record to be copied.

2. Make any necessary changes.

3. Change the template name or description to distinguish it from the original.

4. Click Clone.
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ServiceNow  increments the record number above the highest template number and sets the 
version of the new record to 1. A message appears under the header bar naming the source 
record for the clone.Both templates are Active  and appear in the record list. The record list 
allows you to see the entire history of the template.

Manage Certification template versions

You can view and manage all versions of a template from the Template form.

Procedure

1. Open any version of a template.
The Other Versions  related list displays all other versions of this template, both active and 
inactive.

2. Click any version in the related list to display the record for that version.

3. Update the template to create a new version.
The system increments a version of the template when you edit any field except Description 
and Active. You can manage the template versions without returning to the list view.

4. To make an inactive template the current version, open that version, edit it if desired, and then 
click Revert.
This action does:

◦ Deactivates the previously active version of the template.

◦ Copies the inactive template.

◦ Makes the new copy the current, active version.

5. Select the Audits  related list to view all audits configured to use this template.

6. Click New  to create a new audit record with the template selection and table pre-populated.

Delete a Certification template

Certification templates can be deleted.

About this task
Only users with the certification_admin or admin role can delete template versions. You cannot 
delete a template version that is being used for an audit.

Procedure

1. To delete a single template version, open that version record and click Delete.

The system hides the Delete  button for templates that are in use. If you delete the latest, active 
version of a template, the previous version of that template is reset to Active.

2. To delete all unused and inactive versions of a template, open any version of that template and 
click Delete inactive versions  under Related Links.
This control appears on all versions, whether they are used in an audit.

3. When prompted, click OK  to proceed.
The system deletes only template versions that are not used in an audit. All protected versions 
are named in a message that appears in the header bar.

Scripted audits

A scripted audit enables users with the certification_admin role to conduct an audit from a script 
rather than using restrictive template conditions.
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A scripted audit uses a certification filter  to select the records to audit, and then creates 
standard follow-on tasks for remediation of any discrepancies. Use this type of audit to query 
for any values or states that a script can define. A scripted audit is a specific audit type that is 
activated together with the Desired State  plugin. ServiceNow  provides a sample audit script with 
configuration instructions.

Create a scripted audit

A scripted audit is an audit whose conditions are defined by a script.

Procedure

1. Navigate to All  > Compliance  > Scripted Audits  > Audits.

An audit type of Scripted  filters the list.

2. Click New.

3. Complete the form (see table).

4. Create the audit script.

The Run this script  field includes a sample script with instructions for performing the audit 
and generating the follow-on tasks. This field appears only when you access audits from the 
Scripted Audits module.

5. Click Submit.

Sample script:

/*
/////////////////////////////////////////////////////
/// This script works with Data Center Zones filter //
/////////////////////////////////////////////////////
 
var desiredFloorSpaceUsage = 30;  // Value to audit against
var assignToUser = '46d44a23a9fe19810012d100cca80666';  // Beth 
 Anglin
var assignToGroup = '8a5055c9c61122780043563ef53438e3'; // 
 Hardware group
var taskMsg = 'See the audit results below for the 
 discrepancies that must be addressed';
 
// API call to retrieve records based on the filter
var gr = new 
 SNC.CertificationProcessing().getFilterRecords(current.filte
r);
 
// Loop over all records defined by the filter
while(gr.next()) {
 var sysId = gr.getValue('sys_id'); // Sys ID of audited record
 var floorSpaceInUse = gr.getValue('floor_space_in_use'); // 
 Value to audit
 
 // Determine if certification condition passes or fails
 if (floorSpaceInUse < desiredFloorSpaceUsage) {
  var columnNameSpace = gr.floor_space_in_use.getLabel(); // 
 String value of column audited against
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  // Call create Follow on Task API and save the returned 
 sys_id for use in logging audit result fail
  // Params:
  // auditId - Sys id of the audit record executed
  // ciId Sys - id of the configuration item.  Empty string if 
 not a cmdb ci
  // assignedTo - Sys id of user to assign task to.  Can be 
 empty
  // assignmentGroup - Sys id of group to assign task to.  Can 
 be empty
  // shortDescr - Short description for the Follow On Task. 
 Can be empty
  // Return value: Sys id of the created follow on task
  var followOnTask = new 
 SNC.CertificationProcessing().createFollowOnTask(current.sys_
id, sysId, assignToUser, '', taskMsg);
 
  // Call log failed result API
  // Params:
  // auditId - Sys id of audit record executed
  // auditedRecordId - Sys id of the record audited
  // followOnTask - Sys id of the follow on task associated 
 with the audited record(@see auditedRecordId). Can be empty
  // columnDisplayName - Label of the column audited(ex. Disk 
 space (GB)).  Can be empty
  // operatorLabel - Label of the operator used to audit the 
 column(ex. is not empty, greater than). Can be empty
  // desiredValue - Desired value of the column.  Can be empty
  // discrepancyValue - Discrepancy value.  Can be empty
  // isCI - True, if audited record is a CI. False, otherwise.
  // domainToUse - Sys domain of the "cert_audit" record.  Can 
 be empty
  new 
 SNC.CertificationProcessing().logAuditResultFail(current.sys_
id, sysId, followOnTask, columnNameSpace, 'greater than', 
 desiredFloorSpaceUsage, floorSpaceInUse, true);
 } else { // If certification condition pass, write a Audit 
 Result Pass via API
  // Params:
  // auditId - Sys id of audit record executed
  // auditedRecordId - Sys id of the record audited
  // isCI - True, if audited record is a CI. False, otherwise. 
 Can be empty.
  // domainToUse - Sys domain of the "cert_audit" record.  Can 
 be empty.
  new 
 SNC.CertificationProcessing().logAuditResultPass(current.sys_
id, sysId, true);
 }
}
*/

New scripted audit table.

Field Description

Name Name for this audit.
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Field Description

Filter Filter to use when the audit type is Scripted. This field is required for scripted 
audits, but is hidden for all other audit types.

Template [Required] Template to use when this audit runs. Audit type filters the list of 
available templates and only the active versions of a template are available for 
selection. This field is hidden when the audit type is Scripted.

Table [Read-only] Displays the table for the template.

Create 
tasks

Creates follow-on tasks for correcting discrepancies when selected. In a 
scripted audit, you can create the logic for either task state by using true to 
create a task or false if no task is created. By default, this check box is cleared 
(false) in a new audit record.

Assignment 
type A choice list to select how the audit assigns the follow-on tasks. This field is 

visible only when the Create task check box is selected. Choices are:

◦ User Field: elect a user reference field on the table being audited. As an 
example, select the user named in the Managed by field on the failed record 
to perform the tasks. This selection displays the Assigned to and Assign to 
empty fields. If the reference field on the record is empty, the value in the 
Assign to empty field is used.

◦ Specific User: Select a specific user to perform the tasks. This selection 
displays the User field.

◦ Group Field: Select a group reference field on the table being audited. As 
an example, select the Support group from the failed record to perform the 
tasks. This selection displays the Assign to group and Assign to empty fields. 
All members of the group from the reference field on the failed record are 
assigned to the tasks. If the reference field on the record is empty, the value 
in the Assign to empty field is used.

◦ Specific Group: Select a specific group to perform the tasks. This selection 
displays the Group field. All members of the selected group are assigned to 
the tasks.

User
The specific user this audit assigns to follow-on tasks. This field is available 
under these conditions:

◦ Assignment type is set to Specific User.

◦ Assign to empty is set to Create Assigned Task, and Assignment type is set to 
User Field.

Note: 
Ensure that the specified user has the certification role.

Assign to 
group

The group field that defines which group this audit assigns to the follow-on task. 
This field is available only when the Assignment type is Group Field.

Group The specific group this audit assign to follow-on tasks. This field is available 
only when the Assignment type is Specific Group and you have selected Group 
Field as the assignment type.

Assign to The user field that defines which user this audit assigns to the follow-on task. 
This field is available only when the Assignment type is User Field.

Assign to 
empty The behavior to use if the field selected in Assign to or Assign to group is blank 

on the record being audited. For example, if a follow-on task must be assigned 
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Field Description

to a manager, but no manager is identified, the value in this field determines 
what happens. This field appears only when the Assignment type is User Field 
or Group Field. The possible selections are:

◦ Do Not Create Task: No follow-on task is created when the Assign to or Assign 
to group field is empty.

◦ Create Unassigned Task: Create a follow-on task, but do not assign it to any 
user or group. The task can be manually assigned later.

◦ Create Assigned Task: Create a follow-on task and assign it to the user or 
group specified. If you selected an assignment type of User Field, the User 
field becomes available. If you selected the Group Field type, the Group field 
becomes available.

The audit automatically creates follow-on tasks for all records that have Assign 
to populated, regardless of which selection you make for Assign to empty.

Short 
description

Brief description of the purpose of the audit.

Task 
description

General description of the work required for the follow-on tasks created by this 
audit. All follow-on tasks created by this audit inherit this description.

Active Activates this audit schedule and generates follow-on tasks at the scheduled 
date and time. Clear this check box to hide scheduling fields on the form 
(except Last run date) and not generate follow-on tasks.

Run How often to run the schedule that generates the audit.

◦ Daily

◦ Weekly

◦ Monthly

◦ Periodically

◦ Once

◦ On demand

Day

◦ If Run is Weekly, the day of the week when the audit runs.

◦ If Run is Monthly, the day of the month when the audit runs. If the day is 29, 
30 or 31, for shorter months the audit runs on the last day of the month.

Repeat 
Interval

If Run is Periodically, the frequency that the audit runs entered in time, days, or 
both. For example, set Days to 10 and Hours to 14:00:00 to run the audit every 
10 days at 2:00pm.

Starting If Run is Periodically or Once, the date and time when the audit runs.

Time If Run is Daily, Weekly, Monthly, or Once, the time of day, on a 24-hour clock, 
when the audit runs.

Last run 
date

[Read-only] The last date and time the audit ran, either on its regular schedule 
or manually. Audit previews do not update this field.

Next 
scheduled 
run

[Read-only] The next date and time on which the audit runs. The system 
recalculates this field when you change the schedule.
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Field Description

Audit type [Read-only] The type assigned to this audit. The system selects the audit type 
based on the application from which the audit was created and can be:

◦ Desired State

◦ Architecture Compliance

◦ Compliance

◦ Scripted

Run this 
script

Audit script to run. This field is available only when the audit type is Scripted. 
The Audit form includes a sample script with instructions for performing the 
audit and generating the follow-on tasks. See Script Methods  for a list of the 
methods provided and the accepted parameters.

Script methods

ServiceNow  provides four methods for creating the audit script.

Script methods

Name Description Parameters

getFilterRecords public GlideRecord getFilterRecords(String 
filterId)

filterID: The sys_id of the 
filter to use.

logAuditResultPass public void logAuditResultPass(String auditId, 
String auditedRecordId, boolean isCI, String 
domainToUse)

auditId: Sys_id of audit 
record executed

auditedRecordId: Sys_id 
of the record audited.

isCI: True, if the audited 
record is a CI, false if 
otherwise.

domainToUse: 
Sys_domain of the 
cert_audit record.

logAuditResultFail public void logAuditResultFail(String 
auditId, String auditedRecordId, String 
followOnTask, String columnDisplayName, 
String operatorLabel, String desiredValue, 
String discrepancyValue, boolean isCI, String 
domainToUse)

auditId: Sys_id of audit 
record executed.

auditedRecordId: Sys_id 
of the record audited.

followOnTask: Sys_id 
of the follow-on task 
associated with the 
audited record and can 
be an empty string.

columnDisplayName: 
Label of the column 
audited. For example, 
Disk space (GB).
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Script methods  (continued)

Name Description Parameters

operatorLabel: Label 
of the operator used to 
audit the column. For 
example, is not empty or 
greater than can be the 
label.

desiredValue: Desired 
value of the column.

discrepancyValue: 
Discrepancy value.

isCI: True, if the audited 
record is a CI, false if 
otherwise.

domainToUse: 
Sys_domain of the 
cert_audit record.

createFollowOnTask() public String createFollowOnTask(String 
auditId, String ciId, String assignedTo, String 
assignmentGroup, String shortDescr)

auditId: Sys_id of the 
audit record executed.

ciId: Sys_id of the 
configuration item. This 
string is empty when the 
table is not extended 
from the cmdb_ci table.

assignedTo: Sys_id of 
the assigned user of the 
task. This string can be 
empty.

assignmentGroup: 
Sys_id of the group the 
task is assigned to. This 
string can be empty.

shortDescr: The text 
to use for the short 
description of the 
follow-on task.

Managing proposed changes

The proposed changes feature allows you to pre-configure changes to configuration items and 
their associated relationships. These pre-configured changes are prepared to be implemented, 
but do not actually happen until they are applied at a later time.

When you view a CI, the proposed changes can be displayed so that you can see what is 
planned.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

510



This feature is useful when you want to make modifications while a change process is in the 
approval stage, and only implement the changes after the approvals are complete. If the change 
is never approved, no changes to records have to be reversed. If the change is approved, a quick 
command applies all the proposed changes.

You can make the following proposed changes to a CI:

• Modify any field on the CI form.

• Add or delete a relationship to that CI.

To modify a relationship, you must delete the current relationship and add a new relationship. 
You cannot delete a proposed change.

View CI history

You can view the history of changes to a CI in a list, calendar, or timeline format.

View the proposed changes of a CI

You can view the proposed changes so that you can see what is planned for the CI.

Before you begin
Role required: personalize_form

About this task
To view any proposed changes, configure the CI form layout to display the CMDB Scheduled 
Changes  field. Proposed changes are not displayed in a CI form by default.

Procedure

1. Navigate to All  > Change  > Open  and open a change request.

2. In the Affected CIs  related list, open the Configuration Item.
You may also navigate directly to the CI form.

3. Right-click the form header bar.

4. Select Configure  > Form Layout.

5. Move the CMDB Scheduled Changes  field to the Selected  pane.

6. Click Save.
The CI form shows the details of any proposed changes in the Scheduled changes  area.

Add a proposed change to a CI

Proposed changes to a CI can be made while viewing a change request or any task-related 
record.

Before you begin
Role required: itil

Procedure

1. In the Change Request form, go to the Affected CIs  related list.
If there are no CIs in the Affected CIs list, click Edit  to add CIs that are affected by this change 
request.

2. Right-click the CI that you want to configure for a proposed change, and select Proposed 
Change.

3. Complete the form to make the proposed changes, and click Save Proposed Change.
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Click Update  to apply the changes immediately. Click Delete  to delete the CI.

4. To propose an addition or a removal of a CI relationship:

a. Click the plus icon in the Related Items  section.

b. In the Relationships section, add or delete a relationship.
For information about using the relationship editor, see Create or edit a CI relationship.

c. Click Save Propose Change.

d. Confirm saving the proposed change.

Click Update  or Delete  to commit the changes immediately.

Note: 
Use only with CI relationships. Proposing additions or removal of relationships is not valid 
for user relationships and group relationships.

What to do next
After the proposed changes are saved, the Apply Proposed Changes  button appears on the 
Change Request form. This button lets the user commit the proposed changes to the CI. Your 
business processes determine the appropriate time to commit the changes. The CI retains the 
existing data until the proposed changes are committed. However, users can see that changes 
have been proposed.

Apply a proposed change to a CI

When you apply the proposed changes, all the proposed changes for that change request are 
applied to the configuration item. You can apply proposed changes without verification, or if 
verification tests of the proposed changes have failed.

Before you begin
Role required: itil

About this task
After you apply the proposed changes, the Scheduled changes  part of the form displays No 
scheduled changes found. You can configure proposed change verification rules which you can 
use to verify proposed changes before applying the changes.

Procedure

1. Navigate to the Change Request  form.

2. Click the Apply Proposed Changes  button.
You may have to right-click the form header and select the Reload Form  option to see the 
changes.

Create or edit a proposed change verification rule

Ensure that proposed changes meet business requirements and do not introduce invalid data to 
the CMDB, create a rule that includes a script to verify the proposed changes.

Before you begin
Role required: asset or itil

About this task
When you configure proposed change verification rules for a CI, you have an option to verify that 
the proposed changes pass the verification test script in the rule. The verification test results 
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are logged as passed or failed, and you can view the results. Running the verification test is not 
mandatory, and a failed verification test does not prevent you from applying proposed changes.

Procedure

1. Navigate to All  > Configuration  > Change Verification  > Proposed Change Verification Rules.

2. Click New  or select an existing rule to edit.

3. Fill in the fields, as appropriate.

Proposed Change Verification Rules form

Field Description

Rule 
name

The name of this rule.

Table 
name

The table to which the rule applies.

Filter 
condition

Conditions to apply this rule to specific CIs.

Active Check box to activate this rule.

Rule 
script A verification Java script that needs to return true or false. For example:

validateRule()
 {
 var os = current.getValue("os");
 var cpu = current.getValue("cpu_count");
 
    //Use current.getValue(fieldName) to 
 get the proposed change value, eg. var os = 
 current.getValue("os");
    //Your verification code
 
 if (os != "SunOS" || cpu < 2)
 return false;
     //Return true to pass the verification and false 
 if the verification failed
 return true;
 }

4. Click Submit  or Update.

Result
On the Change Request  form, you can click Verify Proposed Changes  to verify proposed 
changes for the affected CIs.

Verify proposed changes

Before applying proposed changes to affected CIs, use proposed change verification rules to 
verify that the changes meet business requirements and do not add invalid data to the CMDB.

Before you begin
Create or edit the rules used to verify proposed changes. For details, see Create or edit a 
proposed change verification rule.
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Role required: none

About this task
You can apply proposed changes even if they are unverified or fail a verification test.

Procedure

1. Open the Change Request  form that affects the CI.

2. Click Verify Proposed Changes.
The proposed changes are verified against any proposed change verification rules in which 
the CI meets the Filter condition  criteria.

3. Review the message that appears at the top of the form after the verification process is 
finished.
The message states whether the verification tests passed or failed.

What to do next
To view the details of any verification tests that were performed for the change request in the 
past two days, click the Proposed Change Verification Log  related link.

Create or edit a planned change validation script

Create a custom script that checks if a change to a class was valid according to business 
requirements, and whether the change was planned or not. A planned change validation script is 
used whenever a CI change is viewed in the CI timeline or change history.

Before you begin
Role required: admin or itil

About this task
The system attempts to validate each CI change as follows:

• If a custom script exists for the CI or one of the CI parents, then the script is executed and 
the results are used to flag the change as valid or invalid. Parent CIs are examined in the 
hierarchical order.

• If a custom script does not exist for the CI or any of its parents, then a predefined validation 
script is used. The change is determined as a planned change if the change occurred between 
the Work start  and Work end  dates of the change request associated with the changed CI.

However, this check is not always reliable because a user might have manually modified the CI 
within the work dates, which flags the change as valid even if it is invalid.

The script needs to return a boolean, true or false, which depends on meeting the test criteria 
in the script. You can define a separate script for each CI class, and you can define multiple 
planned change validation scripts for a single class. For example, to maintain different versions 
of the script. Only one script can be active for a CI class at any given time.

These are the parameters that uniquely characterize a change:

• The fields that were changed

• The data source that performed the change

• The time stamp of the change

To correctly determine the validity of a change, examine the parameters and apply business 
logic to evaluate if the validation tests are met. A planned change validation script can test any of 
these characteristics and determine when a change meets pre-established criteria. For example, 
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the custom script can check if the mode of the CI is operational or maintenance, or who initiated 
the change.

Procedure

1. Navigate to All  > Configuration  > Change Verification  > Planned Change Validation Script.

2. Click New  or select a validation script to edit.

3. Complete the form.

Planned change validation script form

Control Description

Active Check box to activate this script for validating changes.

Applies 
to

Class that this script applies to.

Script Script to run to validate a change. If the script does not return a boolean value, then 
it is configured to false.

The script has a template which displays the input variables of the script.

Template script input variables

Variable Type Description

current GlideRecord Current record that is being processed.

updatedOn GlideDateTime Time stamp of the change.

updatedBy String Entity responsible for the change.

fieldsChanged String Comma-separated list of the names of all fields that were 
changed.

Example 

This sample script checks who initiated the record update. It returns true if admin initiated the 
record update. Otherwise, the script returns false.

isValidChange();
 
function isValidChange(/*GlideRecord current, GlideDateTime 
 updatedOn, String updatedBy, String changedFields*/)
{
   //Return true if the user that updated the record has an 
 admin role
   return isUserAdmin(updatedBy);
}
 
function isUserAdmin(userName)
{
   var grUser = new GlideRecord("sys_user");
   grUser.addQuery('name', userName);
   grUser.query();
   if(grUser.next())
   {
       var roles = new GlideRecord ("sys_user_has_role");
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       roles.addActiveQuery();
       roles.addQuery('user', grUser.sys_id);
       roles.query();
       while(roles.next())
       {
          if(roles.role.name == 'admin')
             return true;
       }
   }
   return false;
}

4. Click Submit.

Intelligent Search for CMDB

Use everyday natural language query (NLQ) in a search string to query for a set of CIs in the 
CMDB. Intelligent Search for CMDB, parses, resolves ambiguities, and converts your search 
string into a valid CMDB query. Complex search strings open fully constructed on a canvas of 
CMDB Query Builder where you can continue and refine, or run.

Intelligent Search for CMDB is supported only on English language instances and isn't supported 
when the instance preferred language is set to a language other than English.

Integration with CMDB Workspace

Intelligent Search for CMDB is integrated into Home view in the CMDB Workspace store app. 
For information about how to use Intelligent Search, sample search strings, and helpful tips, see 
CMDB Workspace store app  (Intelligent Search section).

Integration with CMDB Query Builder

Intelligent Search for CMDB is integrated with the CMDB Query Builder  in the 
ServiceNow AI Platform. This integration is controlled by the system property 
glide.cmdb.query.nlq.activated, which is set to true  by default. Intelligent Search for 
CMDB lets you use natural language processing in the CMDB Query Builder to find CIs and their 
relationships using Intelligent Search for CMDB functions.

Using Intelligent Search for CMDB

Intelligent Search is tailored to the CMDB, searching only through the CMDB class hierarchy for 
tables, and for CIs and their relationships.

Use the Intelligent Search search field to construct a search string using everyday natural 
language. Your queries can span multiple CMDB classes and involve many CIs that are 
connected by different relationships. After resolving any ambiguities with table names or 
relationship types, Intelligent Search converts your search string into a query that the CMDB 
can run. The CMDB query is constructed dynamically as you type into the search box and spell 
checker is applied if needed. A dynamic list of relevant suggestions appears as you type, with 
items such as table names, matching single words or part phrases in the typed-in text.

Use Intelligent Search:
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• Search tips: Shows details and tips about the usage, and examples for single and multi-table 
search, advanced filtering, and relationships in Intelligent Search. The Relationships tab 
contains a link to the CMDB Implicit Relationships  table.

• Search: Depending on whether the search string is already fully converted into a valid CMDB 
query and whether the search is for a single or multiple tables.

◦ If the search string has no ambiguities with the table name or relationships, then the query 
runs and the results appear in a list view format.

If the constructed CMDB query contains more than a single table, then the View in Query 
Builder  button appears. Click the button to open the CMDB Query Builder  with your query 
fully constructed on the Query Builder canvas. You can use the Query Builder to continue 
editing the query.

◦ If there are any ambiguities with table names or relationship types in the search string, then 
the search string can't be converted into a valid CMDB query. In this case, the Refine your 
query dialog box appears to continue and parse your search string into a valid CMDB query. 
The dialog box contains suggested synonyms and labels for phrases in your search string. 
Use the drop-down lists to select the synonyms that match your intended search and then 
click Go  to run the query.

◦ If Intelligent Search is unable to convert your search string into a valid CMDB query, then 
clicking Search  does not generate any query results. Instead, a feedback form appears. Fill 
out the form and click Submit Feedback  to send your feedback to ServiceNow  analysis.

• Results Feedback: Submit feedback to ServiceNow  analysts, to express your assessment of 
the results. Choose descriptions that capture any gap between the results and your expected 
results, and add any helpful details.

Sample searches

When you click the search box, the drop-down list of pre-defined sample searches appears. The 
list consists of more common searches, or searches that are more difficult to construct such as 
searches that involve application services. Run any of those searches to get started.

• Sample searches are stored in the NLQ Sample Search [sn_cmdb_ws_nlq_sample_search] 
table

• Referenced tables are stored in the NLQ Sample Search Table 
[sn_cmdb_ws_nlq_sample_search_table] table

CMDB Admins (sn_cmdb_admin user role) can modify a sample search by directly editing 
its record in the NLQ Sample Search table. Click All  and then in the Filter navigator, enter 
sn_cmdb_ws_nlq_sample_search.list. In the NLQ Sample Searches list view edit the 
record for a search that you want to modify.

Any modification to sample searches is reflected in both, the CMDB Workspace  and the CMDB 
Query Builder.

Synonyms

The NLQ Synonym [nlq_synonym] table is pre-populated with synonyms for natural language 
strings for CMDB table and column names, and relationships. This table is used to match natural 
language search words to the CMDB query language. For example, the phrase ‘linux server’ has 
synonyms such as ‘Linux Server’, ‘Server’, and ‘Virtual Machine Instance’.
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For details about viewing and adding synonyms customized to your business needs, see NLQ 
synonyms .

CMDB Implicit Relationships

You can help Intelligent Search find more results by defining some of the relationships between 
classes as implicit relationships. Implicit relationships can be useful in queries that involve 
service offering and application services.

NLQ admins can create new implicit relationships by navigating to All  > NLQ  > CMDB Implicit 
Relationships.

An implicit relationship defines the relationship between two tables and includes any filters you 
want to apply. When creating an implicit relationship, you set the following items:

• From table (from_table): The class that acts as the parent

• Filters: Conditions that are applied to the columns of the from_table

• To table: The class that acts as the child

• Relationship: How the from_table interacts with the to_table. For example, Contains: Contained 
by  means the from_table contains the to_table

• Skipped table: The class that is implied and not captured by the CMDB Query Builder

For example, in CMDB Query Builder, you want to see your service offerings that have had 
a P1 incident in the last 10 days. However, if you were to type show me all business 
service offerings with p1 incidents in the last 10 days, NLQ wouldn't 
understand the relationship.

Implicit relationships are stored in the NLQ CMDB Implicit Relationship 
[nlq_cmdb_implicit_relationship] table and are used in the CMDB Workspace  and if integrated, 
also in CMDB Query Builder.

For more information about NLQ in the ServiceNow AI Platform, see Natural Language Query 
(NLQ) .

Unified Map

The Unified Map  feature graphically shows a hierarchical map of CIs and the relationships 
between them, while centered on a CI that you choose (the home node). The Unified Map  feature 
combines some of the capabilities of Dependency Views and of Service Mapping, into a single 
map experience.

Unified Map  is included in CMDB Workspace.

Because Unified Map  shows how CIs are connected to each other, it is useful with products 
such as Change Management , Incident Management , and Event Management . Nodes on 
the map represent CIs in the CMDB hierarchy and different types of lines between the nodes 
represent the connections between CIs.

For example, Unified Map  helps you understand the impact of a change by visually showing 
how CIs are connected to other CIs by relationships and references. Unified Map also shows 
the composition of application services which lets it be useful with products such as Event 
Management and Incident Management. For example, you can see all CIs that are members of 
the 'Revenue App' application service. You can review historical changes, and then easily filter 
the CIs so that only Application CIs appear.

Unified Map provides the following panels:
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• Map pane that shows the map for a CI, and which lets you access the following utilities:

◦ CI search field letting you search for the home node CI  for the map

◦ Filter panel letting you filter CIs  and relationships that appear on the map, and create filter 
presets  to reapply a set of filters on any map

◦ Toolbox letting you modify various visual aspects, such as the layout mode, of the map

◦ Mini-map navigator letting you easily move the entire map to an area of interest and set the 
zoom level for the map

• Timeline  showing related item events for the CIs on the map, up to six months in the past and 
six months into the future, as of the time of viewing the timeline.

• Contextual side panel on the right where you can choose the Attributes, Application services, 
Related items, or Changes  module. The panel shows different types of details per module and 
according to the selections on the map

Panels and elements in Unified Map

The map content and the details that appear in the various modules in the contextual side panel, 
is synchronized. The selected module in the contextual side panel determines the type of details 
that appear and your selection on the map determines the scope. If you select a CI on the map, 
then the contextual side panel shows details for that CI. For some modules, if nothing is selected 
on the map, the contextual side panel shows details for all the CIs on the map.

For example, if the Application services module is selected and a CI is selected on the map, then 
the contextual side panel shows all application services related to the selected CI. If you then 
select an empty space on the map so that no CI is selected — The contextual side panel shows 
all application services that are associated with any CI in the map.

Access

You can access the Unified Map feature from CMDB Workspace, in either of the following ways:

• Navigate to Workspaces  > CMDB Workspace. Then, in the Quick Links section on the CMDB 
Workspace  Home view, select Unified Map.

• Select Open Map  on a CI form, to open a map for the respective CI as the home node of the 
map.  By default, CIs must be in an operational state to use this capability. For more information, 
see Configure operational states of CIs.

Role requirements:
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• To access maps: sn_cmdb_user, sn_cmdb_editor or sn_cmdb_admin roles

• To access maps with operational application services: app_service_user, and sm_user or 
sm_admin

• To access maps with operational and non-operational application services: 
app_service_admin, and sm_user or sm_admin

• To access and view related items: itil

Map content

The map pane shows a graphical layout of CIs and their relationships including group CIs such 
as application services, and a timeline. You can set and change the content on the map as 
follows:

Home node

Use the Search box to select the CI, such as an application service CI, that you want 
the map to center on. That CI is the home node of the map. The home node  is easily 
visible by its thicker border line and by a pulsating effect. The home node is the 
focal point of a map and all other CIs and relationship lines are drawn in the context 
of the home node.

Level

Select the levels drop-down list to set the map level. The map level limits the 
number of hierarchy levels for which to show CIs, therefore, limiting the overall 
size of a map. Starting with the home node, the map shows all CIs up and down 
the hierarchy, up to the specified level. By default, only the first three levels of CIs, 
directly descending from the home node, appear on the map.

Filter

Select Open filter panel ( ) to filter the data appearing on the current map, and 
create filter presets. Each filtering category includes only items that are relevant to 
the current map. The list in the CI types category, for example, includes all the CI 
types on the map, and you can filter in or out any of those items. A blue dot appears 
on the filter icon when filters are being applied.

Filtered items don't appear on the map unless you select the Show filtered items 

icon ( )  to expose them as grayed-out CIs and relationships.

For more information about configuring map filters, see Configure map filters.

Service Mapping

When Service Mapping  is installed then application services populated by Service 
Mapping population methods, are included in maps. Otherwise, only application 
services populated by CMDB-related population methods, appear.

Without Service Mapping, any other data that Service Mapping provides for 
application services, such as relationships, grouping, and mapped application 
services data (and subclasses of that class), isn't available. Also, the Application 
services module in the contextual side panel, doesn't show details for CIs in the 
map.

If Service Mapping is installed and the 
sn_sm_scoped_app.sa.unified_map.enabled  system property is 
enabled, you can access Unified Map from the Service Mapping Workspace. For 

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

520

https://www.webstg.servicenow.com/docs/access?context=c_ServiceMappingOverview&version=washingtondc&pubname=washingtondc-it-operations-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=c_ServiceMappingOverview&version=washingtondc&pubname=washingtondc-it-operations-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=c_ServiceMappingOverview&version=washingtondc&pubname=washingtondc-it-operations-management&ft:locale=en-US


more information, see Access the Unified Map feature from the Service Mapping 
Workspace .

Filtering by operational state of CIs

By default, non-operational CIs are filtered out of the map and only Cis in which 
Life Cycle Stage  is Operational  or empty, appear on maps. When searching 
for CIs in a map, those CIs that are filtered out based on operational state, aren't 
included in the results. Also, viewing details for a CI that is filtered out based on 
operational state, such as a non-operational CI, the Open Map  button on the CI 
form isn't available.

An administrator can change this default behavior to show non-operational CIs, or 
CIs of any combination of Life Cycle Stage  values. For more information, see 
Configure operational states of CIs.

Number of elements

The number of elements that a map retrieves and shows, is up to the number 
of elements within the specified level, without exceeding the value of the 
node.map.max.edge.count  system property (250 by default, and CIs within a 
collapsed group CI are counted):

• If node.map.max.edge.count  is greater than the number of elements within 
the specified level: Then all elements up to the specified level, show on the map.

• If node.map.max.edge.count  is less than the number of elements within 
the specified level: Then any additional elements, beyond the specified level, are 
truncated and don't show on the map.

An administrator can modify the node.map.max.edge.count  property, which 
affects the amount of data on a map and impacts performance.

Map appearance and interaction

The map initially appears using default settings. Colors used in Unified Map to highlight some 
field values, follow the Next Experience color themes, and dashed lines represent references 
between end point CIs.

You can interact with the map and change the appearance of its current content, as follows:

• Use the toolbox on the map to change map appearance:

◦ Zoom in or out: Add or reduce the level of details on the map.

◦ Align to home node: Move the home node to the center of the map.

◦ Fit to screen: Center the map on the canvas and set the zoom level to its maximum level that 
enables the entire map to fit on the canvas.

◦ Export map: Export the map to a PDF document on your local drive.

◦ Collapse all: Collapse all group CIs that are expanded, center the map on the canvas, and 
set the zoom level to its maximum level that enables the entire map to fit on the canvas.

◦ Switch map layout to either of the following options:

▪ Unified vertical layout: Shows elements in a vertical tree pattern according to their 
upstream and downstream relationships. This option is the default layout for showing 
mapped application services.

▪ Unified force layout: Shows elements in a clustered arrangement around a parent CI, 
regardless of upstream or downstream relationships.
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• Toggle visibility of the timeline: Show or hide the timeline underneath the map by selecting the 

Toggle visibility of the timeline icon ( ). For more information about the timeline, see Show 
CI related items events on a timeline.

• Point to a CI to animate the relationships between the CI and its connected CIs.

• Use the mini-map navigator on the bottom right to easily move the entire map on the canvas 
and set the zoom level to a specific percentage number. You can hide or show the mini-map 
navigator.

• Select the number badge on a group CI to expand the group and show its member CIs. The 
group parent and any CI members are temporarily highlighted by a light purple color (point to a 
group if needed). Select the badge again to collapse the group back into its group CI mode.

• Drag CI nodes on the map canvas to reposition CIs as needed.

Contextual side panel

Select one of the following modules in the contextual side panel on the right to show different 
types of details for CIs on the map:

• Attributes ( ): Shows the Attributes pane with details that are based on selections in 
the map. For more information about using this module, see Show attributes for a CI or a 
relationship in a map.

• Application services ( ): Cards in the Application services pane show key details, such as 
Owner  and Discovery source, for application services. If a CI is selected on the map, 
then application services related to the selected CI, appear. If nothing is selected on the map, 
then any application service that is related to any CI on the map, appears.

For more information about using this module, see Show application services for a CI in a map.

• Related items ( ): Shows related items grouped by related items categories, such as active 
incidents and alerts, in the Related items pane. If a CI is selected on the map, then only related 
items that are associated with the selected CI, appear. If nothing is selected, then all related 
items that are associated with any CI on the map, appear.

◦ For information about using this module, see Show related items for a CI in a map.

◦ For information about how administrators can configure the related items details appearing 
in badges, on timelines, and in cards in the Related items panel, see Configure options for 
the Related items module.

• Changes ( ): Shows CI changes in the Changes pane. If a CI is selected on the map, then 
only changes for the selected CI, appear. If no CI is selected, then the Changes pane doesn't 
show any change details.

For more information about using this module, see Show changes for a CI in a map.
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Service maps

Mapped services, appear on the map as group CIs that you can expand and collapse to 
show or hide its members. Mapped services are descendents of the Application Services 
[cmdb_ci_service_auto] class, such as application services and dynamic CI groups. A badge on a 
group CI shows the number of members in the group.

Select the badge to expand the group to show all members, and then collapse the group back to 
hide members and to show only the group CI. In its expanded mode, point to any CI in the group 
to temporarily highlight all CI members by a light purple color.

Administer Unified Map

As an administrator, you can modify several settings in Unified Map  to reflect how maps are used 
in the organization.

The Unified Map  configurations in the following tasks affect all users. Users can customize some 
aspects of their own experience with Unified Map, but can't configure settings in these tasks.

Configure operational states of CIs

Specify the operational states that CIs can be in to be included in maps.

Before you begin
Role required: sn_cmdb_admin

About this task
Note: 
This setting affects all users. Individual users cannot configure this setting. See Configure 
map filters  and Configure options for the Related items module  for settings that individual 
users can use to customize their personal experience with Unified Map.

By default, non-operational CIs are filtered out of maps and only CIs in which Life Cycle 
Stage  is Operational  or empty, appear.

Search results don't include those CIs that are filtered out based on operational state. Also, 
viewing details for a CI that is filtered out based on operational state, such as a non-operational 
CI, the Open Map  button on the CI form isn't available.

Procedure

1. Navigate to All  and then, in the Filter box in the main navigation bar, enter 
sn_cmdb_ws_operational_lifecycle_for_unified_map.list  to open the 
Operational life cycle modes  table.

2. Edit the default record whose Name  is CMDB Workspace Unified Map View.

a. Unlock the Life cycle list  field.

b. On the right side, select the Add/Remove multiple  icon.

c. In the Edit Members dialog box, select Life Cycle Stages values that CIs can have to be 
included in maps.

d. Select Save.

e. On the record form, select Update.

Configure related items

Add related items categories, configure what appears on individual cards in the Related items 
module, and configure how related items appear on timelines and in badges.
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Before you begin
Role required: sn_cmdb_admin

About this task
Note: 
This setting affects all users. Individual users cannot configure this setting. See Configure 
map filters  and Configure options for the Related items module  for settings that individual 
users can use to customize their personal experience with Unified Map.

Related items are grouped by categories in the Related items pane in the contextual 
side panel, and also appear in CI badges and in timelines. The Node Map Related Item 
[sn_cmdb_ws_node_map_related_item] table contains the settings that determine which related 
items and associated details, appear. By default for example, common categories of related 
items, such as active incidents, are pre-configured to appear. You can add or modify records in 
the Node Map Related Item [sn_cmdb_ws_node_map_related_item] table to globally manage 
related items in maps.

Procedure

1. Navigate to All  and then, in the Filter box in the main navigation bar, enter 
sn_cmdb_ws_node_map_related_item.list  to open the Node Map Related Item 
table.

2. Select an existing record or select New  and then fill out the form.

Field Description

Name The category label that appears in the 
contextual side panel when the Related items 
module is selected for a CI.

Table Tables from which records for the category 
are retrieved.

Order Order that the category appears within all 
related items categories. The list of related 
items categories is sorted in an ascending 
order. The category with the smallest order 
number is at the top of the list.

Active Enables the appearance of the related item 
category.

Reference field Reference attribute in the specified 
Table  that references the CIs for the 
category. Typically set to Configuration Item 
[cmdb_ci].

Configure related items in the Related items contextual side panel.

Related fields and conditions tab

Number field Numeric attribute from the specified Table 
that uniquely identifies each record in the 
category. This attribute is used in the record 
links that appears in each individual card 
when drilling down the related item category.
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Title field Attribute from the specified Table  that 
appears as the title of each individual card 
when drilling down the category in the 
contextual side panel.

Fields Set of attributes from the specified Table  that 
appear in individual cards when drilling down 
the related item category. For example, when 
drilling down alerts, the set of attributes that 
appear on each individual alert card.

Sort fields Order of appearance of the specified set of 
Fields.

Footer field Attribute from the specified Table  that 
appears at the bottom of individual cards 
when drilling down the related item category, 
regardless of the sort order specified in Sort 
fields.

Conditions Conditions to apply to the specified Table 
that retrieve the set of records for the 
category.

Configure related items in badges and timelines.

Badge and timeline configuration tab

Badge and timeline icon Icon that appears in CI badges and on 
timelines, for the specified related item.

Badge and timeline highlight field Highlight configuration for applying colors to 
the icons in timelines and on the map.

Date field
The date field to position the event on the 
timeline.

End date field Optional end date field to use for a range on 
the timeline.

3. Select Submit  or Update.

Configure extended properties for a class

Each class has a unique set of extended properties that appear in the Unified Map Attributes 
panel for a CI. Many common classes are preconfigured with such properties. You can modify 
the default settings and globally configure extended properties for additional classes.

Before you begin
Role required: sn_cmdb_admin

About this task
Note: 
This setting affects all users. Individual users cannot configure this setting. See Configure 
map filters  and Configure options for the Related items module  for settings that individual 
users can use to customize their personal experience with Unified Map.
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Procedure

1. Navigate to All  and then, in the Filter box in the main navigation bar, enter 
sn_cmdb_ws_node_map_table_attributes.list  to access the Table Attributes 
table.

2. Select an existing record or select New  and then fill out the form.

Field Description

CMDB Class Name The class to which this configuration applies.

Display attributes
List of attributes that appear as extended 
attributes in the contextual side panel when 
a user selects the Properties module for a CI. 
The list contains attributes of the specified 
CMDB Class Name  from which you can 
select.

To unlock the field, select the Unlock Display 
attributes icon.

3. Select Submit  or Update.

Configure map references

Map references enable connections on the map between CIs from two classes that aren't 
connected by a relationship.

Before you begin
Role required: sn_cmdb_admin

About this task
Note: 
This setting affects all users. Individual users cannot configure this setting. See Configure 
map filters  and Configure options for the Related items module  for settings that individual 
users can use to customize their personal experience with Unified Map.

References connect CIs from two classes that don't have a relationship connection between 
them. On the map, any two CIs from the referenced class and from the referencing class, appear 
connected by a dotted line as if there's a relationship connection between them. For such 
reference connections, the relationship type is Reference. There are several pre-configured map 
references which you can modify, and you can also add additional map references.

For example, a Windows Server CI record has a map reference to records in the File System table 
that you want to include in a map. In that case, Server ABC (referencing CI) shows connections to 
C:\ and D:\ file systems (referenced CIs).

Procedure

1. Navigate to All  and then, in the Filter box in the main navigation bar, enter 
sn_cmdb_ws_node_map_reference.list  to open the Node Map References table.

2. Select an existing record or select New  and then fill out the form.
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Field Description

CI class The referencing class that this configuration 
applies to.

Referenced CI class Class that the specified Reference field 
references.

Reference field Attribute in the specified CI class  that 
contains the reference.

Show Reverse Creates a map reference for the reverse 
reference between the specified CI class  and 
Referenced CI class.

Active Enables the configuration so that the map 
reference shows referenced CIs.

3. Select Submit  or Update.

Configure class profiles

Configure profiles that set default map filters and default map orientation for a class. For 
example, to show Service Mapping data for the Mapped Application Service class.

Before you begin
Role required: sn_cmdb_admin

About this task
Note: 
This setting affects all users. Individual users cannot configure this setting. See Configure 
map filters  and Configure options for the Related items module  for settings that individual 
users can use to customize their personal experience with Unified Map.

Class profiles are applied when no filter preset  is used with the current map. This typically 
happens when you initially load a map without a filter preset or when you set the filter preset to 
Default view. Class profiles let you configure only the Layer category in the filter panel. Several 
common classes such as the Mapped Application Service [cmdb_ci_service_discovered] class 
are pre-configured with class profiles.

Procedure

1. Navigate to All  and then, in the Filter box in the main navigation bar, enter 
sn_cmdb_ws_node_map_profiles.list  to open the Node Map Profiles table.

2. Select an existing record or select New  and then fill out the form.

Field Description

Orientation Orientation of the map.

CMDB CI class Class of the home node of the map for which 
to apply this profile.

Layers Filters in the Layers category, to filter 
elements in or out of the map.
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Field Description

Active Active profiles affect what the map displays.

3. Select Submit  or Update.

Show a CI in a map

Select a CI as the home node  that a map centers on. The home node in Unified Map is the focal 
point of a map. All other CIs and relationships on the map are drawn in the context of the home 
node.

Before you begin
Role required: See general role requirements for Unified Map

About this task
When you select a group CI as the home node, such as an application service  or a dynamic 
CI group, the Attributes module shows the attributes of the group CI itself and cards for the CI 
members of the group. Each card showing details for a CI that is a group member. When you 
open a map for an application service CI, a badge on group CIs in the map shows the number 
of CI members in that group. In that case, group functionality is available letting you expand or 
collapse the group CIs.

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the Quick links section in the Home view, select Unified Map.

3. In the search field, search for a CI that you want to see a map for.
The CI that you find and select, is automatically set as the home node for the map.

What to do next
You can change the map content or appearance as described in Unified Map, and you can do 
any of the following interactions:

• Show CI key details on the map: Point to a CI to show the CI's full name and class (or zoom 
into the map until those details appear), its related items details, and the direction of the 
CI relationships. If there are multiple related items associated with a CI, then the CI badge 
contains the string 'Multiple' and a badge showing the number of related items appears on the 
timeline. You can point to that badge on the timeline to show all related items.

• Show complete CI details: Select a CI (CI border thickens) to show its respective details in the 
Attributes, Application services, Related items, or Changes module panes. For group CIs, such 
as an application service  or a dynamic CI group, the Attributes pane also shows detail cards 
for the CIs that are members of the group.

• Show relationship details: Select a line, which represents relationships between the CIs, to 
show the relationship attributes in the Contextual side panel on the right (select the Attributes 
module if needed). If there are multiple relationships between CIs, then a badge shows the 
total number of relationships, and details for all the relationships appear in the Attributes 
panel.

• Move a CI: Drag a CI to a different place on the map. Map elements that are connected to that 
CI, are automatically moved and redrawn according to the new placement of the CI.

• Change the level setting: Select the level drop-down and set the number of relationship levels 
from the home node, for which to show CIs on the map.

• Select a different home node: Right-click a CI. Then, in the pop-up menu, select Set as Home 
node  to redraw the map with the selected CI as its home node.
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• Expand and collapse a group CI: Select the number badge (indicating the number of CI 
members) on a group CI to expand the group and show its CI members. Select the badge 
again to collapse the group and to show the group CI and its number badge. In its expanded 
mode, the group parent and any CI members are temporarily highlighted by a light purple color 
(point to a group if needed).

• Show filtered items: Select the Show filtered items icon ( )  to expose the filtered items on 
the map, in a grayed-out shade. For more details about configuring map filters, see Configure 
map filters.

Show CI related items events on a timeline

Show related items events, such as incidents and changes, associated with the CIs on the map, 
across a time range.

Before you begin
Role required: See general role requirements at Unified Map

About this task
Select a CI on the map to show its related items on the timeline, or select an empty space on the 
map to show related items for all of the CIs on the map. Multiple related items from the same date 
are grouped into a badge which shows the number of related items in the group.

The time range of timelines stretches from six months in the past through six months into the 
future, relative to the current time. An event that occurred outside of this time range, doesn't 
appear on the timeline. However, such events might still appear in the corresponding Related 
items pane and a CI badge might show data for those related items.

A timeline uses a marker  to filter out CIs that were created after the marker date, and doesn't 
affect related items on the timeline. Set the marker to visualize topology changes in the CMDB 
until a specific point in time. Maps are synchronized with their associated timelines, showing the 
CIs and relationships as they existed at the marker's date and time. For example, CIs that were 
created after the marker's date and time, don't appear on the map.

As an administrator, you can configure some properties of the timeline, such as which related 
items details appear on timelines. For more information about configuring timelines, see 
Configure related items.

Show related items events in a timeline, as follows:

Procedure

• Move to the marker to show its date setting.

• Move to a related items badge to show details about the related items for that point of time.

• Drag the marker to another date to be set as a marker.

• Zoom in or out to extend or to shrink the range of dates that show on the timeline.

• Select the More options button and then select Replace marker, Clear marker, or Add marker 
to manage the marker.

• Select Now  to set the marker to current time.

What to do next

Select the Toggle visibility of the timeline icon ( )  to show or hide the timeline.
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Configure map filters

Specify the type of CIs that you want to see on the current map by filtering out data using 
different filtering categories.

Before you begin
Role required: See general role requirements at Unified Map

About this task
Note: 
This setting affects all users. Individual users cannot configure this setting. See Configure 
map filters  and Configure options for the Related items module  for settings that individual 
users can use to customize their personal experience with Unified Map.

Some maps might extend to be too large to be useful. After selecting the home node, you can 
reduce the size of a map by filtering out CIs of specific type or with specific attribute values. For 
example, you can filter out CIs associated with a specific discovery source or which are owned 
by a specific user, and which you aren’t interested in.

The Map filter panel lets you filter by layer types, CI classes, and relationship types. Filter 
options reflect the elements that are currently on the map and represent attribute values from all 
elements in the map. Select or clear items to filter CIs and relationships in the map.

Note: 

• Filter conditions that might filter out the home node CI might be available in the map filter 
panel because of other CIs on the map. However, you can't filter out the home node CI 
even it matches those filter conditions.

• Maps retrieve and show only up to 250 CMDB elements and any remaining elements are 
truncated and don't appear on the map.

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the Quick links section in the Home view, select Unified Map.

3. In the search bar, search for the CI you want as the home node for the map.

4. Select Open filter panel ( ).

5. In the Map filter panel, select or clear filters that you want to apply to the current map.

6. Close the Map filter panel.

What to do next

• Select the Show filtered items icon ( )  to expose all filtered items as grayed-out elements, 
or to hide them.

• Create a filter presets  to reuse a custom set of filters.

Manage filter presets

Create and save a custom set of Unified Map map filters, which you can then apply to any map to 
show only what you are interested in.

Before you begin
Role required: See general role requirements for Unified Map

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

530



About this task
After you configure a custom set of map filters, you can capture those settings as a filter preset. 
You can then select that filter preset to apply automatically all of its filter settings to the current 
map.

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the Quick links section in the Home view, select Unified Map.

3. In the search bar, search for the CI you want as the home node for the map.

4. Select Open filter panel ( ).

5. In the Map filter panel, select the filters that you want to include in the filter preset.
The filter settings are also applied to the current map.

6. Select the star-shaped icon, enter a Preset name, and then select Save.

7. Close the Map filter panel.

What to do next

• Apply a filter preset: Select the View preset list icon In the Map filter dialog box, then select a 
preset filter and close the Map filter panel.

• Update a filter preset: Select a filter preset in the Map filter dialog box and update the filter 
settings. Then select the star-shaped icon, and in the Save Preset dialog box do either of the 
following:

◦ Select Update preset

◦ Select Save as new preset  and enter a filter preset name
Select Save.

• Remove a filter preset: Select the filter preset in the Map filter dialog box. Without changing the 
preset, select the star-shaped icon, and in the Remove preset dialog box select Remove.

Show attributes for a CI or a relationship in a map

Open the Attributes module in Unified Map to view attributes for a CI and for relationships that 
are on a map.

Before you begin
Role required: See general role requirements for Unified Map

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the Quick links section in the Home view, select Unified Map.

3. In the Search bar, search for a CI to be set as the home node for the map and then select the 
CI or a relationship on the map.

4. Select Attributes ( ) in the contextual side panel to access the Attributes module.
The Attributes pane shows the following details:

◦ For a non-group CI: The top section contains common key attributes, such as Class  and 
Discovery source  that appear for CIs of any class (other than Application Service CIs). 
The bottom section contains attributes that uniquely extend the CI's class in the CMDB 
hierarchy.
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◦ For a group CI: The top card shows attributes of the group CI and underneath, the 
Configuration items section contains cards showing attributes for each of the group member 
CIs.

◦ For a single relationship: A card with the attributes for the selected relationship.

◦ For a multi-relationship badge: A card for each of the relationships in the relationship set, 
showing the attributes for the relationship. The number of cards is equal to the number on 
the relationship badge, which is a count of the different types of relationships between the 
two CIs, in the same direction. Relationship connections are based on records in the CI 
Relationship [cmdb_rel_ci] table.

What to do next
In a CI card in the Applications pane, select the Actions menu and then select any of the 
following options:

• View CI details  to open the CI form for the CI.

• Open in new map  to open an additional map with the current CI set as the home node.

• Set CI as home  to set the selected CI as the new home node for the map.

Select a mapped application service CI on the map to show its entry points in the Attributes 
pane.

Show application services for a CI in a map

Open the Application services module in Unified Map to view details of application services 
associated with a CI.

Before you begin
Service Mapping  must be installed to show application services for a selected CI.

Role required: See general role requirements for Unified Map

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the Quick links section in the Home view, select Unified Map.

3. In the Search bar, search for a CI to be set as the home node for the map and then select the 
CI on the map.

4. Select Application Services ( ) in the contextual side panel to access the Application 
Services module.

What to do next

• Select another CI on the map to show its related application services. Or, select an empty 
space on the map so that no CI is selected, to show all application services for any of the CIs 
on the map.

• In the Application services pane:

◦ Use the Search box to search for a specific application service.

◦ Select ( ) to open the filter panel, and then select a category and a sort order by which to 
sort the application service cards. Close the filter panel to apply your settings.

• In an individual application service card, select Application Service actions ( ) and then 
select:
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◦ View CI details  to open the CI form for the application service CI.

◦ Open in new map  to open a new map in which the application service is set as the home 
node.

◦ Set CI as home  to set the application service as the home node on the map and redraws the 
map accordingly.

Some fields, such as Business criticality, are color-coded to denote specific values. 
For example, a status of Most Critical is highlighted by default with a red background.

Show changes for a CI in a map

Open the Changes module in Unified Map to view historical changes for a CI that's on the map.

Before you begin
Role required: See general role requirements for Unified Map

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the Quick links section in the Home view, select Unified Map.

3. In the Search bar, search for a CI to be set as the home node for the map and then select the 
CI on the map.

4. Select Changes ( ) in the side panel to access the Changes module.

What to do next

• Select another CI on the map to show changes for.

• In the Changes pane:

◦ Select Open filters ( ) and then select and configure any of the following filter types:

▪ Post types

▪ Field changes

▪ Flagged

▪ Filter sets

◦ Select the Search icon ( ) and enter text in the Search Activity Stream field to find specific 
changes by entering terms.

◦ Select the  or the  sorting icons to toggle between sorting the change cards in an 
ascending or descending order.

• Select Show less  or Show more  to show the minimum or the maximum level of details in a 
change card.

• In an individual card: Select the Flag as important icon to flag the change as important.

Show related items for a CI in a map

Open the Related Items module in Unified Map to show all related items such as active incidents 
or active problems, for a CI that's on the map.

Before you begin
Role required: See general role requirements for Unified Map
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Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the Quick links section in the Home view, select Unified Map.

3. In the Search bar, search for a CI to be set as the home node for the map and then select the 
CI on the map.

4. Select Related items ( ) in the contextual side panel to access the Related items module.
Related items are grouped by category. The categories that appear are based on the Related 
Items options  and badges show the number of related items of the respective category, for a 
selected CI (or for all CIs if no CI is selected).

What to do next

• Select another CI on the map to show related items for, or select an empty space on the map 
so that no CI is selected, to show all related items for any of the CIs on the map.

• Select Related items user preferences ( ) in the Related items pane, to set the related item 
categories  that you want to see in the Related items pane.

• Select a related item category (the category must contain least one item) to drill down to the 
individual related item cards and see key details for each related item.

• In a related item card:

◦ Select the related item link to drill down to the actual related item record.

◦ Open the filter panel to set a sorting category and order for the cards.

Some details, such as Priority  and Risk, are color-coded to highlight certain values. 
Color-codes use the default ServiceNow  platform color code settings.

Configure options for the Related items module

Use the Related items module in Unified Map to set your preference for which categories of 
related items, such as active incidents and active problems, appear for CIs.

Before you begin
Role required: See general role requirements for Unified Map

About this task
Related items are grouped by categories in the contextual side panel when selecting the Related 
items module. Administrators configure which related item categories are globally available, and 
you can further customize these settings to reflect your own preferences.

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the Quick links section in the Home view, select Unified Map.

3. Select the Related items icon  to open the Related items module.

4. In the Related items panel, select the Related items user preferences icon .

5. In the Related items Settings dialog box, select and deselect items in the Available items list to 
reflect which related item categories you want to show for CIs.
Selected items are moved into the Selected item lists and when you select a CI on the map for 
which to show related items, those categories appear.

6. Select Apply.
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Dependency Views

ServiceNow®  Dependency Views  graphically displays an infrastructure view for a configuration 
item (CI) and the application or business services that it is part of and that it supports. 
Dependency Views  indicates the status of its configuration items, and allows access to CIs 
related alerts, incidents, problems, changes, and services.

If Service Mapping is activated, Dependency Views  maps are enhanced to display 
dependencies that reflect connections in service maps.

Explore

• Washington DC

• Domain separation and 
Dependency Views

Administer

• Create or modify map 
indicators

• Create or modify map icons

• Create a predefined filter

• Create or modify Map 
Related Items

• Create or modify 
Dependency Views menu 
actions

• Create or edit a dependency 
type

Use

• Dependency Views map

• Dependency Views map 
menus and controls

• View a Dependency Views 
map

• Change the layout of 
Dependency Views map

• Filter the view of a 
Dependency Views map

• Perform actions on nodes 
in a Dependency Views 
map

• Supported browsers for 
Dependency Views

Develop

• Developer training

• Developer documentation

• Properties for Dependency 
Views

• Components installed with 
Dependency Views

Integration

View metrics for CIs in a 
Dependency Views map

Troubleshoot and get help

• Ask or answer questions in 
the Now Community

• Search the Known Error 
Portal for known error 
articles

• Contact Customer Service 
and Support

Supported browsers for Dependency Views

The latest version or service pack of internet browsers are required to view and manipulate 
Dependency Views maps.

The Dependency Views module supports the latest version or service pack of the following 
browsers:

• Firefox with the latest ESR

• Chrome latest version
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• Safari version 8 or later (latest is recommended)

• Microsoft Internet Explorer (IE) version 11 and Microsoft Edge.

The Dependency Views module is not supported on tablets and on mobile devices.

Domain separation and Dependency Views

Domain separation is unsupported in Dependency Views. Domain separation enables you to 
separate data, processes, and administrative tasks into logical groupings called domains. You 
can control several aspects of this separation, including which users can see and access data.

Support level: Basic

• Business logic: Ensure that data goes into the proper domain for the application’s service 
provider use cases.

• The application supports domain separation at run time. The domain separation includes 
separation from the user interface, cache keys, reporting, rollups, and aggregations.

• The owner of the instance must set up the application to function across multiple tenants.

Sample use case: When a service provider (SP) uses chat to respond to a tenant-customer’s 
message, the customer must be able to see the SP's response.

For more information on support levels, see Application support for domain separation .

How domain separation works in Dependency Views

Dependency views are generated using both Configuration Item [cmdb_ci] and CI Relationship 
[cmdb_rel_ci] tables. The [cmdb_ci] table is domain separated, but the [cmdb_rel_ci] table is not. 
You can create relationships only by selecting two CIs. They should be in the same domain for 
you to be able to see them.

To be successful with domain separation in Dependency Views, make sure that relevant CIs 
are visible for the current domain. If the instance is domain separated, ServiceNow  domain 
separation rules apply (see Related information link below).

Tenant domains will be able to see only their domain and global CIs.

Related topics

Domain separation for service providers

Dependency Views map

ServiceNow®  Dependency Views maps graphically display CIs that support application or 
business services and the relationships between the CIs.

The CMDB Workspace  store app provides the Unified Map  feature as an alternative to using 
Dependency Views. Unified Map  combines the capabilities of Dependency Views and Service 
Mapping  into a single map experience.

A ServiceNow  service (application service or business service) is work or goods that are 
supported by an IT infrastructure. For example, delivering email service to an employee can 
require services such as email servers, web servers, and the work to configure the user's 
account.
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A Dependency Views map has one starting point, called the root CI or root node of the map. 
The root CI is surrounded by a darker frame that repaints itself with a pulsing effect drawing the 
attention to the root CI. The maps can show both upstream and downstream dependencies 
for the root CI. By default the Dependency Views map displays 3 levels, both upstream and 
downstream relationships. Administrators can configure the number of levels displayed. The map 
collapses and expands clusters to make them easier to view. By default, clusters are collapsed.

In a Dependency Views map, map indicators indicate if a CI has any active, pending issues. You 
can investigate the tasks that are connected to a CI to get more details. When you return to the 
map from another form, the system restores the last map viewed, using the default filter and 

layout settings. When you click the icon ( ) on a CI record or on a task record that identifies a 
CI, the map opens.

Many of the relationships in map are created through the discovery process. You can also 
create, define, and delete CI relationships in the map. You can display the map from different 
perspectives and open specific records that relate to configuration items. The system refreshes 
the map automatically to reflect changes to the CMDB.

Note: 
CIs not extended from the Configuration Item [cmdb_ci] table, are not displayed in 
Dependency Views maps and in CI relation formatters.

The Dependency Views module is active in all instances, and includes demo data.

Dependency Views sample map

When you click the map icon [ ] on a CI record or on a task record that identify a CI, a map 
opens.

Roles

Users with the itil and ecmdb_admin roles can view maps and perform all actions in the map. 
Actions include access to the map views and saved filters, both from the lists in the map and 
from the Saved Filters  module.

Dependency Views map menus and controls

Dependency Views maps contain the following menus and controls.
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Dependency Views map

Map options

The following options are available across the top of the map.

Menu to save, load and export views of the map.

<Root CI> Next to the menu icon is the name of the current root node 
(CI) of the map.

Enter the name of a CI, application service, or business 
service to load into the map. Alternatively, you can start typing 
to have the auto-complete feature present a list of CIs and 
services that match your partial value.

Vertical Display the map in vertical view.

Horizontal Display the map in horizontal view.

Radial Display the map in radial view.

Force Centers the elements around the parent CI, regardless of 
upstream or downstream relationships.

Group Groups the elements according to their CI type.

Details Displays related lists such as Problems, Changes and Related 
Services that are associated with the selected CI.

• Click a service to highlight the CIs that are associated with 
that service.

• Click Related Services, then double-click a service to 
display the map in the Event Management dashboard.

If the Event Management plugin is active, then events and 
alerts are also displayed.

Settings Set filters for the map.
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Use the navigation tools to increase or decrease the view of 
the map, rearrange the icons on the map, and move the map 
on the page.

• Use the plus sign (+) to increase magnification of the map.

• Use the minus sign (-) to decrease magnification of the map.

• Click the center dot to center the map on the page.

• Use the direction arrows to move the page in that direction.

• Use the selection tool under the navigation tool to toggle 
between moving the entire map or moving one CI on the 
map.

Map menu

The following options are available if you right-click the map background.

Run Layout Redraws the map with the current layout option.

Fit To Screen Resizes the map to fit all the nodes in the map window.

Reset Filters Performs the same action as the Filters  > Reset  option.

Node menu

The following options are available if you right-click a node.

View Form Displays the CMDB  record of the selected CI in a new tab of the browser.

View Map Reloads the map using the selected CI as the new root node, with the currently 
defined layout setting. This option does not display on the root node.

View 
Related 
Tasks

Displays all tasks or outages associated with the selected CI, including incidents, 
problems, change requests, and follow-on tasks. This option is always available, 
even if there are no tasks associated with the CI. This option does not appear on 
collapsed nodes.

View 
Affected CIs

Shows a list of all tasks that have the CI listed as an Affected CI. This option 
is only visible when you access the map from the map icon in a task record's 
Configuration item field.

View 
Related 
Outages

Displays all outages involving the selected CI. This option only appears when 
there is an outage associated with the CI. This option does not appear on 
collapsed nodes.

Add 
Relationship

This option displays a dotted green line that you can drag to another CI to create 
a relationship link. A popup dialog allows you to define the relationship type.

Expand Displays all CIs and components within a clustered node, or virtual groups 
(virtual nodes that appear when glide.bsm.too_many_children  is 
reached). This option appears only if the node is a cluster node or a virtual group 
node.

If Load More  was previously used, then Expand  reverts the results of the Load 
More  operation.
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The number of additional icons to display is bound by the value of the 
glide.bsm.max_nodes  property.

Collapse Collapses all CIs and components within a cluster node back to a single node. 
Also, collapses a virtual group that has been expanded. This option only appears 
if the node has been expanded using the Expand  menu item.

If Load More  was previously used, then Expand  reverts the results of the Load 
More  operation.

Run Layout 
From Here

This option re-runs the chosen layout using the current node. Use this option to 
get a new or clearer view on the same map.

Load More Starting at the selected icon, loads the next level of the map, past the setting of 
Max Levels.

Virtual grouping is not applied at the newly loaded level even if the criteria for 
virtual grouping is met.

The number of additional icons to display is bound by the value of the 
glide.bsm.max_nodes  property.

Relationship menu

The following options are available if you right-click a relationship link.

View 
Relationship 
Form

Opens the CI Relationship  form. You can modify the Parent, Type, and Child 
of the relationship from this form.

Modify 
Relationship

Searches for and selects a new relationship for this link.

Delete 
Relationship

Deletes a relationship. The relationship is deleted after prompting for 
confirmation.

Cluster nodes in a Dependency Views map

Dependency Views maps can display cluster group nodes alongside individual CI nodes, and 
the child nodes of these cluster groups.

Clusters  are CIs in the Cluster [cmdb_ci_cluster] table. A cluster CI is an organized set of 
computer CIs that work together as a single system. Each node in a cluster group represents a 
CI, typically a server, that can have referenced hardware, such as disks and network adapters.

Cluster nodes on a Dependency Views map can display in two modes:

• Collapsed mode: Displays only the cluster CI node without its child CI nodes. This mode 
avoids unnecessary clutter in large maps.

• Expanded mode: Displays the cluster CI node and all its child CI nodes.

Menu options available for a clustered node include Collapse  and Expand, which allow you to 
control the density on the map.

By default, Dependency Views collapses all cluster groups and displays clusters in collapsed 
mode on the map.
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Annotation

Icons for cluster nodes and cluster group CI nodes are noted by the string "Cluster" and by a 
unique cluster icon. The system searches through all the component nodes in a cluster CI or 
collapsed node looking for tasks, outages, and trouble, such as incidents, problems, or change 
requests. This search evaluates only the number of levels that are displayed in the diagram.

An expanded cluster node displaying its child nodes

Virtual grouping of nodes in a Dependency Views map

To reduce the density on a map, Dependency Views automatically groups CIs of a similar CI type 
from the same level.

A large number of nodes can cause a Dependency Views map to become too dense to be 
helpful. Therefore, if the number of nodes with a similar CI type from same level, exceeds the 
value of the Maximum number of nodes (of a similar CI type and at the 
same level) to display before applying virtual grouping  property, then 
those nodes are automatically grouped into a virtual group. A single node, the virtual group node 
is displayed to represent the virtual group, while all actual nodes in the virtual group (that are of a 
similar CI type), are hidden. Virtual group nodes represent CIs of a similar CI type but are not CIs 
by themselves and cannot have tasks assigned to them. The number of actual collapsed nodes 
in the virtual group is noted on the virtual group node.

By default, child nodes of a virtual group are not displayed. You can enable the Show 
children of virtual groups  property to display child nodes underneath virtual groups.
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Virtual grouping is not applied at the level underneath a virtual group even if the criteria for 
virtual grouping is met (the number of nodes with a similar CI type from that level exceeds the 
preconfigured property value). However, virtual grouping can happen at the following level if that 
criteria is met. This behavior does not depend on any property settings, and you cannot change 
it.

Menu options for a virtual group include Expand  and Collapse, which allow you to apply virtual 
grouping and display only the virtual group node, or to undo the virtual grouping and display all 
actual nodes.

Virtual links

A virtual node is connected to other nodes with a virtual link. A virtual link denotes that there 
such link between at least one CI in the virtual group, to another CI node on the map.

Note: 
Predefined filters do not apply to virtual groups. Therefore a virtual group displays even if it 
contains CIs that a predefined filter would have excluded. Upon the expansion of a virtual 
group, predefined filters are applied, and any or all of the CIs that were previously virtually 
grouped, might no longer display on the map.

Also, when using the node menu option Load More, virtual grouping is not applied at the 
newly loaded level even the criteria for virtual grouping is met.

An expanded virtual group

Related topics

Properties for Dependency Views

Use Dependency Views

Use the layout controls on a Dependency Views map to display elements in different 
configurations for easier management. Use the filter panel on the map to display fewer levels 
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or to filter out elements you don't want to see, then save the filter for use later. Draw new 
relationships between elements or edit existing relationships.

View a Dependency Views map

When you display a Dependency Views map, the map is centered on the root CI and displays 
the layout and number of levels defined in the map properties. If Operational Intelligence is 
activated, then a Dependency Views map provides a mode that lets you directly access metrics 
information for the CIs on the map.

Before you begin
Role required: dependency_views (see general requirements)

General role requirements:

• To access a Dependency Views map from either the navigation menu, a script API, or directly 
from a URL, the minimum role required is the dependency_views. Some operations that are 
related to icons, indicators, and menu actions require the ecmdb_admin role. Some operations 
that are related to properties and dependency types require the admin role.

• Dependency Views enforces ACL permissions on CIs, and visually hides them and their 
relationship from the map if the permission requirement is not met.

About this task
The maps generated by Dependency Views are based on D3 and Angular technology, providing 
a modern interactive graphical interface to visualize configuration items and their relationships.

If Service Mapping is activated, Dependency Views maps are enhanced to display 
dependencies that reflect connections in service maps. In addition, the list of related services 
in the Details  section, includes application services, and technical and manual services if Event 
Management is activated. All CIs that are included in a service, are displayed underneath the 
service node on the map.

Maps provided by Service Mapping are for application services, including comprehensive maps 
from the perspective of application services. For more information, see Service Mapping .

Administrators can configure the setting for the default layout of the map and number of levels 
displayed. When you access the map from a saved view, the map opens using the properties in 
the saved view, and not the default map properties.

Procedure

Navigate to All  > Dependency Views  and open one of these modules:

• View Map in New Tab: Opens the map in a new, full screen tab without the application 
navigator.

• View Map: Opens the map in the content pane of the current tab.

• Saved Views: Opens a view of a map that you previously saved.

Click a number in the Version  column, and then click the Display Dependency Views map icon 

( ).

Save or load a Dependency Views map

In the View Map  module, use the menu icon to save and load Dependency Views maps.
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Procedure

1. Navigate to All  > Dependency Views  > View Map.

2. Click the View menu icon ( ).

3. Select Save View, Load View, or Last View.

Delete a saved Dependency Views map view

Use the Saved Views  module to delete a previously saved view.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Dependency Views  > Saved Views.

2. Select the check box for map view that you want to delete.

3. Select Delete  from the Actions on selected rows  drop-down menu.

Change the layout of Dependency Views map

You can select from different layout options for your Dependency Views map.

Before you begin
Role required: none

Procedure

1. Navigate to All  > Dependency Views  > View Map.

2. Select one of the following layout options from the menu across the top of the view.

◦ Vertical: Displays the elements in a vertical tree pattern according to their upstream and 
downstream relationships. This is the default value for the initial display of the map.

◦ Horizontal: Displays the elements in a horizontal tree pattern according to their upstream 
and downstream relationships.

◦ Radial: Displays the elements in a radial pattern according to their upstream and 
downstream relationships.

◦ Force: Centers the elements around the parent CI, regardless of upstream or downstream 
relationships.

◦ Group: Groups the elements according to their CI type.

◦ Details: Displays related alerts, incidents, problems, and related services.

Related Services  displays application services related to the CIs currently displaying in 
the map. If Event Management is activated then technical services and manual services 
are included. You can double-click a service to display the map in the Event Management 
dashboard.

Filter the view of a Dependency Views map

Filter a Dependency Views map to display specific types or categories of configuration items.

Before you begin
Role required: admin
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About this task
Use the filter panel to control which elements of the map are displayed and to save versions of a 
filter for later use.

Procedure

1. Navigate to All  > Dependency Views  > View Map.

2. Click the Map settings icon  to open map settings.

Map settings

Filter panel strips 
and options

Description

Save Custom 
Settings

Configure desired custom settings, then enter a name and click Save.

Custom settings can be loaded by using the Load Saved Custom Settings 
option.

Navigate to Dependency Views  > Saved Settings  >  to display all saved 
custom settings.

Load Custom 
Settings

Apply previously saved custom settings to the current map.

Predefined 
Filters

Apply previously defined filters  consisting of configuration type, CI type, 
and relationship filters. You can Set a predefined filter as default.

This filter is applied first, before any other filters (such as Filter CIs by 
Depth) are applied.

Dependency 
Type

Apply a filter that runs in real time and generates a custom view of a service 
map for a specific CI.

Max Levels Designate how many levels from the root CI display on the map.

Filter CIs by 
Depth

Designate which levels of CI display on the map.

Filter CIs by CI 
Type

Designate what CI types display in the map.

Filter CIs By CI 
Location

Designate what CI locations display in the map.

Filter CIs By CI 
Manufacturer

Designate what CI manufacturers display in the map.

Filter CIs By 
Audit Failure

Hides CIs that failed the CMDB  health staleness test. This option is 
available only if there are any such CIs.

Filter 
Relationship 
Types

Designate what relationship types display in the map.

Map Indicators Designate what types of tasks display and get counted in the map.

Remove 
Filtered Items

Off:  Gray out filtered items on the map.

On:  Do not display filtered items on the map.
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Filter panel strips 
and options

Description

Run Layout 
Automatically

On:  The configured layout to the map is reapplied whenever the filter is 
changed.

Off:  The map layout remains static when the filter is changed.

Fit to Screen 
Automatically

On:  The map magnification will increase or decrease automatically to 
display all CIs on the map.

Off:  The map magnification remains unchanged when the map is reloaded.

3. Click a filter strip to expand or collapse it, and to set filter items.

View metrics for CIs in a Dependency Views map

Operational Intelligence processes metrics data for CIs, calculates statistics and aggregations, 
and detects metrics anomalies. A Dependency Views map lets you switch to metrics mode to 
directly access the Insights Explorer that displays metrics data for CIs on the map.

Before you begin
The Operational Intelligence (com.snc.sa.metric) plugin must be activated to enable this 
functionality, and metrics data needs to be processed for the CIs on the Dependency Views map.

Role required: admin

About this task
Open a Dependency Views map in metric mode which integrates a Dependency Views map 
with the Insights Explorer functionality that is tailored to the map. In this mode, you can access 
Insights Explorer functions directly from the map, to explore metrics data for the CIs on the map. 
All map CIs are accessible in the right hand side pane, from where you can drill into metrics data.

Procedure

1. Navigate to All  > Dependency Views  > View Map  to open a map.

2. Right-click on a CI on the map and select View Metrics  to open the Dependency View map in 
metrics mode.
In the panel on the right side, the CI that you selected on the Dependency View map is 
selected by default, and the list of all the metrics available for that CI are displayed.

3. Click the '<' sign on the left of the CI to display all the CIs that you can explore metrics for.
The Insights Explorer is scoped for exploring only the CIs that currently display on the 
Dependency Views map, and you cannot add or remove CIs from the list. If you use map 
settings or filters to filter out CIs from the map, the same filtering will apply to the list of CIs that 
you can explore metrics for.

4. Click on a CI in the CIs list or right-click on a CI on the Dependency Views map, to drill down to 
the CI's metrics.

5. Click the Dependencies Map  tab or the Metrics  tab to switch modes:
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a. In Metrics  mode: The full functionality of the Insights Explorer is available, you can create 
metric charts by dragging metrics into the canvas.
You can modify chart settings, select different time ranges for the charts, and perform other 
actions as described in View metric values in the Insights Explorer .

b. In Dependencies Map  mode: Select a CI on the map to drill down to its metrics data, drop-
down the Layout  list to choose a different layout, or modify map settings.

Perform actions on nodes in a Dependency Views map

You can view various related items for the nodes in a Dependency Views map.

About this task
If the node is a collapsed node or represents a cluster, the incidents, problems and change 
requests are for all the collapsed nodes.

Procedure

1. Navigate to All  > Dependency Views  > View Map.

2. Click the Node menu icon  next to a node or right-click a node on the map to access the 
following menu items:

Node Menu

View Form Displays the CMDB  record of the selected CI in a new tab of the browser.

View Map Reloads the view using the selected CI as the new root node, with the currently 
defined layout setting. This option does not display on the root node.

View 
Related 
Tasks

Displays all tasks or outages associated with the selected CI, including 
incidents, problems, change requests, and follow-on tasks. This option is 
always available, even if there are no tasks associated with the CI. This option 
does not appear on collapsed nodes.

View 
Affected CIs

Shows a list of all tasks that have the CI listed as an Affected CI. This option 
is only visible when you access the view from the view icon in a task record's 
Configuration item field.

View 
Related 
Outages

Displays all outages involving the selected CI. This option only appears when 
there is an outage associated with the CI. This option does not appear on 
collapsed nodes.

Add 
Relationship

This option displays a dotted green line that you can drag to another CI to 
create a relationship link. A popup dialog allows you to define the relationship 
type.

Expand Displays all CIs and components within a cluster node or a collapsed node. 
This option only appears if the node is a collapsed or cluster node.

The number of additional icons to display is bound by the value of the 
glide.bsm.max_nodes  property.

Collapse Collapses all CIs and components within a cluster node or a collapsed 
node back to a single node. This option only appears if the node has been 
expanded using the Expand menu item.

Run Layout 
From Here

This option re-runs the chosen layout using the current node. Use this option 
to get a new or clearer view on the same map.
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Load More Starting at the selected icon, loads the next level of the map, past the setting of 
Max Levels.

The number of additional icons to display is bound by the value of the 
glide.bsm.max_nodes  property.

Export a Dependency Views map

Export a Dependency Views map to an image in PNG format.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Dependency Views  > View Map.

2. Configure the map view as you want the image to appear.
The exported image displays the current view of the map.

3. Click the view menu icon ( ).

4. Click Export Image.

5. Right-click the image and select Save Image As, Print, or any other menu option.

Note: 
You can't export images from a Dependency Views map using Internet Explorer as your 
browser.

6. Click the "X" button to close the Export Image  window.

View collapsed nodes in a Dependency Views map

Cluster and virtually grouped nodes can be displayed in a collapsed mode to avoid unnecessary 
clutter in large maps.

Procedure

1. To expand a collapsed node, right-click the CI and select Expand  from the context menu.

2. To collapse an expanded cluster node with children, right-click the CI and select Collapsefrom 
the context menu.

Administer Dependency Views

Users with the admin role can control the appearance and behavior of Dependency Views by 
configuring map indicators, map related items, map icons, and menu actions.

Create or modify map indicators

Dependency Views maps and application service maps, use icons to display additional 
information for a CI by displaying its related records such as alerts, outages, incidents and 
problems. These icons are called map indicator.

Before you begin
Role required: admin

About this task
The default configuration includes map indicators for the following record types:
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• Open incident.

• Open alert.

• Unplanned current outage.

• Planned current outage, or an open problem.

• Current, planned, or recent change request.

You can filter out the display of affected CIs, alerts, current change requests, incidents and 
problems from the map settings menu.

The Affected CI’s map indicator appears for CIs in two related but not identical situations. It 
appears for CIs for which tasks such as change request, incident, or problem were directly 
created for, and for any CIs that were added in those tasks (parent tasks) as Affected CIs (The 
CI for which a task is directly created for, is automatically added as an affected CI in that task). 
The state of affected CI’s depends on the status of the respective parent task. For as long as the 
parent task is active, the associated affected CIs continue to be impacted by the task issue. In 
a map, the Affected CI’s indicator displays for all affected CIs for as long as the parent task is 
active. On a map, the Affected CI tooltip displays the details of the task records in which the CI 
was added as an affected CI. However, the Details  pane does not contain an Affected CI’s tab, 
and no further details about affected CIs, or the associated tasks are displayed. After the parent 
task is closed, the Affected CI’s indicator no longer displays for any of the tasks’ affected CIs. For 
information about affected CIs in Change Management, see Associate CIs to a change request .

Note: 
Details about affected CIs are derived from the task  and the cmdb_ci  tables and their 
extensions. Therefore, if you use custom tables to store CIs for incidents, problems and 
changes, it affects the details that are displayed for affected CIs.

For more information on how map indicators are used to show tasks and outages in clusters and 
collapsed nodes, see Cluster nodes in a Dependency Views map.

Procedure

1. Navigate to All  > Dependency Views  > Map Indicators.

2. Click New  to create a new map indicator, or click the name of an indicator from the Table 
column to modify an existing map indicator.

3. Fill in the fields on the form, as appropriate.

Map Indicator form

Field Description

Table Name of the table represented by this map indicator.

Note:  The list shows only tables and database views that are in the same 
scope as the map indicator. Views are not supported, although included in 
the list.

Name Name of the indicator.

Order Priority order of the task. The highest priority task is the indicator with the 
lowest order number.

Icon File name and path of the icon image file, which can be a system image.
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Field Description

◦ To create a new icon, see Create or modify map icons

◦ To create or use a system image see Storing images in the database .

CMDB  CI field Name of the field on the selected table that contains the configuration item.

Start field Record property that determines the time-point on the metric chart timeline 
for placing records in the Insights Explorer.

Possible values depend on the selected Table. For example, the incident 
indicator has values such as Actual end, Actual Start, and Approval Set.

Description 
field

Name of the field on the selected table that contains the description of the 
configuration item.

Description Text to display when hovering over the indicator. Alphanumeric characters 
and spaces are valid for this field.

Conditions Condition builder that specifies for which CIs to apply this indicator. For 
example, a CI that has a current past outage is highlighted for 5 days. You 
can configure a condition to designate a different timeframe for what is 
considered to be current.

Active in 
Service Map

Toggle that you can enable to make the specified table available in the 
Settings dialog box for application service maps. You can then toggle 
between displaying or not displaying the respective records on the map.

Active 
Dependencies

Toggle that you can enable to make the specified table available in the 
Settings dialog box for Dependency Views maps. You can then toggle 
between displaying or not displaying the respective records on the map.

Active in 
Metrics

Enable to make the toggle for the specified table available in the Settings 
dialog box for the Insights Explorer. You can then toggle between displaying 
or not displaying the respective records on the Insights Explorer.

Label Text to display for the indicator on the map.

Tooltip Label Prefix portion of the tooltip (Tooltip Label : Tooltip info).

Tooltip Info Suffix portion of the tooltip (Tooltip Label : Tooltip info).

4. Click Submit  to enter a new map indicator or click Update  to modify an existing map indicator.

Result
For an indicator to appear in a Dependency Views map, a CI must meet all filter conditions, and 
Active Dependencies  must be selected.

Create or modify map icons

Upload new icons or modify existing icons to customize the icon displayed for a CI in maps in 
Dependency Views, Service Mapping, and Event Management.

Before you begin
Role required: admin

About this task
The icons used in Dependency Views maps are listed in the Map Icons module. Records in the 
Map Icons  list are arranged by CI classes, such as cmdb_ci_linux_server. The path to the default 
image files is https://<instance name>.service-now.com/images/app.ngbsm/<image name.svg>. 
For information about uploading images to the database, see Storing images in the database .
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Role required: admin or cmdb_admin roles are required to access the records in this table 
[ngbsm_icon] to upload new icons.

Procedure

• Navigate to All  > Configuration  > CI Class Manager, and do the following actions:

1. Click Hierarchy  to display the CI Classes list.

2. Select a class to modify the icon for.

3. In the class navigator bar, expand Class Info  and then select Basic Info.

4. On the Basic Info form, click Icon.

5. In the Icons dialog box, select an icon and then click Update.

6. On the Basic Info  form, click Update.

• Navigate to All  > Dependency Views  > Map Icons, and do the following actions:

1. Click New  to create a new map icon or click the name of an existing icon in the Label  column 
to modify an existing icon.

2. On the form, fill in the fields.

Map Icons form

Field Description

CI 
Type

Label or the informal name of the CI table that this icon represents in the view.

Icon Name of the icon.

URL Path to the icon image using the following format: /image name.svg  Click the 
lock icon to enter a new path.

3. Fill in the fields on the form, as appropriate.

4. Click Submit  to enter a new icon or click Update  to modify an existing icon.

What to do next
You can modify a Dependency Views map indicator to use the new icon.

Create a predefined filter

Create filters to narrow down the CIs that are displayed on a Dependency Views map. You can 
create filters that are based on CIs' class, CIs' attributes, or CIs' relationships.

Before you begin
Role required: ecmdb_admin

About this task
Create a predefined filter that you can then select to determine the scope of the CIs that are 
displayed in a Dependency Views map. Configuration type  filters filter by CI class, CI filters  filter 
by CI attributes, and relationship filters  filter by relationships. Only CIs that match at least one of 
the configuration type filters (if any exists), and at least one of the CI filters (if any exists), and at 
least one of the relationship type filters (if any exists) - are displayed on the map. If no filters are 
defined, then no filtering is applied.
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Note: 
Predefined filters do not apply to virtual groups. Therefore a virtual group displays even if 
it contains CIs that a predefined filter would have not included. Upon the expansion of a 
virtual group, predefined filters are applied, and any or all of the CIs that were previously 
virtually grouped, might no longer display on the map.

Procedure

1. Navigate to All  > Dependency Views  > Predefined Filters.

2. On the Predefined Filters  page, click New.

3. Type in a Name  for the filter.

4. Click Roles, and in the Roles  dialog box, select the roles that this filter will be available for.

5. Right-click on the page header, and click Save.

6. Create a configuration type filter:

a. Click Configuration Types, and then click Edit.

b. In the Collection  slushbucket, select the classes that CIs must belong to in order to be 
displayed on the map, and move them to the Configuration Types List.

c. Click Save.

7. Create a CI filter:

a. Click CI Filters, and then click New.

b. In the CI Filters  page enter conditions to filter CIs by specific attribute values.

c. Click Submit.

8. Create a relationship type filter:

a. Click Relationship Type, and then click New.

b. In the Collection  slushbucket, select the relationships that CIs must have in order to be 
displayed on the map, and move them to the Relationship Types List.

c. Click Save.

What to do next
After creating a predefined filter, you can apply it to a map:

1. Click the Map settings icon  to open Map Settings.

2. Select a filter from the Predefined Filters  list.

3. Click Apply.

Related topics

Filter the view of a Dependency Views map

Set a predefined filter as default

You can set a custom predefined filter as the default predefined filter for viewing maps.

Before you begin
Role required: admin
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Procedure

1. Create the custom predefined filter to be used as the default predefined filter.

2. On the predefined filter form, click the context menu and select Copy sys_id.

3. Navigate to User Administration  > User Preferences.

4. Click New  and create a new user preference record using these values:

◦ Name: ecmdb.ciview

◦ Type: String

◦ Value: Paste the sys_id of the custom predefined filter

◦ User: Leave blank to create a system-wide setting

◦ Description: Description of the predefined filter

◦ System: Selected

5. Click Submit.

What to do next
In Map Settings, when you select the Default  option for Predefined Filters, the custom 
predefined filter that was set, will be applied.

Related topics

Filter the view of a Dependency Views map

Create or modify Map Related Items

The Map Related Items module relates referenced CIs to one another, which allows them to be 
displayed in a Dependency Views map.

Before you begin
Role required: admin

About this task
The base system configuration includes the following tables and relates them to items in the 
Computer [cmdb_ci_computer] and Server [cmdb_ci_server] tables.

• Disk [cmdb_ci_disk]

• Network Adapter [cmdb_ci_network_adapter]

• Database [cmdb_ci_database]

Some additional referenced CIs that can be related in this manner are file systems and running 
processes.

In the following example, computer nodes in the map are related to network adapter nodes if the 
Configuration Item  field of the adapter records reference the specific CI node. Access or create 
a network adapter record from the Network Adapter related list in the cmdb_ci_computer record.
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Dependency Views Configuration Item field

The Dependency Views map for the *JEMPLOYEE-IBM computer shows the network adapter 
attached to the computer.

Dependency Views map Related Items example

You can configure Dependency Views to display CIs that have no relationship record, but are 
related to other CIs by reference fields.

Procedure

1. Navigate to All  > Dependency Views  > Map Related Items.

2. Click New  to create a new related item, or click in the row of an existing CI to modify an existing 
map related item.

3. On the form, fill in the fields.
See the Related Items form table.

4. Click Submit  to enter a new map related item or click Update  to modify an existing map related 
item.

Related Items form

Control Description

Configuration 
item

CI that represents the base node or a CI in a table that extends the base 
node table. In the base system, the configuration item that represents the 
base node is Computer [cmdb_ci_computer], which includes all types of 
workstations and servers.

Related item Table name of the related item. Only the cmdb_ci table and tables that extend 
it are displayed in the choice list.
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Control Description

Related field Field that links this related item to the configuration item. In many cases, the 
appropriate value is automatically populated in the field after the first two 
fields are selected. Select the drop-down menu for additional options.

Active Check box to enable or disable this record.

Create or modify Dependency Views menu actions

To modify an existing menu option, first you create a copy of the original menu action record, and 
then you modify the copy.

Before you begin
Role required: admin

About this task
This ensures that your instance can update the record normally during the upgrade process and 
allows you to quickly restore the original menu option, if necessary.

Procedure

1. To create a new menu option, navigate to Dependency Views  > Map Menu Actions  and click 
New.
Fill in the fields on the form, as appropriate. See the Menu Action form table.

2. To modify an existing menu option, navigate to Dependency Views  > Map Menu Actions.

3. Open the menu action you want to edit.

4. Right-click in the header and click Insert and Stay.
This step creates a duplicate copy of the menu action and leaves it open for editing.

5. Change the name of the copied record to avoid confusion.

6. Modify the form fields as necessary and save the record.

7. Open the original record and disable it by clearing the Active  check box.

Menu Action form

Control Description

Name Descriptive name that appears as the menu option.

Active Check box that allows you to enable or disable this record.

Condition Condition that triggers the display of this menu option. If the condition evaluates 
to false  the menu option does not display. Script is evaluated in JavaScript in the 
user's browser and does not have access to all the APIs that Business Rules do. 
For details on available parameters, see Condition Parameters. .

Item Map element for which the menu option displays. Valid values are:

◦ Canvas  for the menu on the map background.

◦ Node  for the menu on a CI.

◦ Relationship  for the menu on a relationship link.

Order Physical location of the option in the menu. The option with the lowest order 
number appears first in the menu. All editable and custom options appear below 
the permanent menu options.
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Control Description

Script Script that is executed in the browser when the menu option is selected. Script is 
evaluated in JavaScript in the user's browser and does not have access to all the 
APIs that Business Rules do.

Type Menu action type being created, either a menu option or a menu separator. The 
menu separator is a single line. When the type is a separator, the Script  field is 
ignored.

Condition and script parameters for menu actions

You can use the following condition and script parameters for menu actions.

Condition parameters

Note: 
The usual regular expression conventions are valid in the condition field, such as ! for NOT, 
&& for AND, and || for OR.

The Condition  field contains a boolean expression that evaluates to true or false. If the condition 
is true or if there is no condition, the specified option appears in the menu when you right-click 
a CI or a relationship link. When you select the option from the menu, ServiceNow  executes the 
associated script.

Common Elements for Building a Condition

Text Description

item Node or reference link's data on which you performed the right-click 
action.

item.label Label of the node.

item.ci_type CI's type (table), such as cmdb_ci_service.

item.name Name of CIs. CI's type name or the table label.

item.location Location of the CI, such as New York.

item.manufacturer_name Name of the CI’s manufacturer, such as Dell Inc.

item.id The sys_id of the CI.

item.is_selected The item that is selected in the map.

item.level The current default level.

item.locationId The sys_id of the CI node's location.

item.locationName The full address of the location.

item.manufaturerId The sys_id of the CI's manufacturer.

Valid Conditions for Condition Parameters

Condition Description

item.is_collapsed The node is a collapsed node.

item.is_cluster The node is a cluster node.
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Script parameters

Menu action scripts are executed on the client when a user clicks the menu option. You can 
use the same building blocks in scripts as in conditions. Menu action scripts do not function on 
separators. These are some additional, useful expressions for scripts:

Condition Description

item.id The sys_id of the CI node or relationship link.

item.source The sys_id of the relationship's parent or child.

item.target The sys_id of the relationship's parent or child.

item.label The name of the CI node, such as IronMail-SD-02.

item.location The sys_id of the CI node's location.

item.location_name The full address of the location, such as 4616 Clairemont Drive, North 
Clairemont, San Diego CA.

item.manufacturer_id The sys_id of the CI's manufacturer.

Create or edit a dependency type

Use one of the dependency types provided, or create a custom dependency type with a script 
that will execute in real time to generate a custom view of a Dependency Views map for a specific 
CI.

Before you begin
Role required: none

About this task
Create a JavaScript to customize the map. The script must comply with JavaScript syntax 
guidelines and the directions in the default script template, and it can call platform APIs. Use a 
dependency type, for example:

• To narrow down and simplify a map, leaving out CIs that are not important for a specific task.

• To include only specific CIs that are hidden by default, such as qualifiers, end-points, and 
entry points.

• To display virtual relationships that are calculated, and that otherwise do not exist in the 
CMDB.

• As a tool to plan a new topology deployment that is based on existing resources.

The following dependency types are available in the base system:

Default

The default setting in the base system. With this setting, there is no processing 
of the dependency map through any dependency type scripts that might filter or 
modify the map.

Show All Relationships

Returns all qualifiers, end points, and entry points. This dependency type is 
available in the base system and is disabled by default. Typically, you would enable 
this dependency type for debugging and tracking purposes.

The following dependency types are available with Service Mapping :

Application to Network Devices
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Returns the network devices in the network paths leading to/from the given CI.

Network Device to Applications

Returns the applicative CIs which are target or source of network paths containing 
the given network device. In addition, returns the hosts of those applicative CIs, and 
for an applicative CI that is an inclusion, its parent CI is returned too.

Physical Network Connections

Returns hosts/network devices that are physically connected to the given host or 
network device.

Flow Dependencies

Returns all the server to server connections that were discovered using the Netflow 
collector. The script builds a graph based on data in the [sa_flow_server_comm] 
table. This table contains pairs of services represented by an IP and a listening port 
that are communicating with each other. For more information, see Data collection 
and discovery using Netflow  and Data collection and discovery using VPC Flow 
Logs .

Procedure

1. Navigate to All  > Dependency Views  > Dependency Types.

2. In the Load Filter Scripts  list view, select an existing depenency type, or click New.

3. Enter or modify a script, adhering to the guidelines and requirements in the script template 
that is provided.

4. Click Submit.

Result
In a Dependency Views map, you can click Dependency Type  to apply a custom script defined in 
a dependency type.

Related topics

Data collection and discovery using Netflow

Properties for Dependency Views

Use Dependency Views properties to configure how data appears in Dependency Views maps.

These properties are available for Dependency Views. To view and edit these properties, the 
admin role is required.

Properties for Dependency Views

Property Description

Maximum number of CIs to display on a map at 
once.

glide.bsm.max_nodes

The maximum number of nodes to retrieve 
from the database. If more nodes exist in 
the database, they are not displayed in 
the map.

• Type: Integer

• Default value: 1000

• Location: Dependency Views  > Map 
Properties
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Properties for Dependency Views  (continued)

Property Description

Maximum level depth from the root CI that can be 
initially displayed in Dependency Views.

glide.bsm.max_levels

Level depth is the graph distance between 
the root CI and a node.

• Type: Integer

• Default value:: 3

• Other possible values: 1-49

• Location: Dependency Views  > Map 
Properties

Display the continuation of the map underneath 
virtual group. Virtual links are used to connect 
virtual groups to their child nodes.

glide.bsm.show_virtual_node_children

• Type: Yes | No

• Default value: No

• Location: Dependency Views  > Map 
Properties

Maximum number of child nodes to display (the 
rest will be collapsed).

glide.bsm.too_many_children

Maximum number of nodes (of a similar 
CI type and at the same level) to display 
before applying virtual grouping.

Nodes are collapsed for the map to meet 
this limit.

• Type: Integer, valid values 1 or greater

• Default value: 10

• Location: Dependency Views  > Map 
Properties

A value of true indicates that filtered out items 
will be removed from the graph along with any 
disconnected children while a value of false 
indicates that the items will be dimmed in color.

glide.ngbsm.filters_remove_filtered_items

• Type: Yes | No

• Default value: Yes

• Location: Dependency Views  > Map 
Properties

Maximum number of relations per node.

glide.bsm.max_num_rels

The maximum number of relations to 
retrieve from the database. If more 
relations exist in the database, they are 
not displayed in the map.

• Type: Integer

• Default value: 100

• Other values: 1 or greater

• Location: Dependency Views  > Map 
Properties

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

559



Properties for Dependency Views  (continued)

Property Description

A value of true indicates that when filters are 
changed the graph will recalculate it layout using 
the currently selected layout algorithm.

glide.ngbsm.filters_run_layout_automatically

• Type: Yes | No

• Default value: Yes

• Location: Dependency Views  > Map 
Properties

A value of true indicates that when filters are 
changed the graph will be fit to the screen 
automatically.

glide.ngbsm.filters_fit_to_screen_automatically

• Type: Yes | No

• Default value: No

• Location: Dependency Views  > Map 
Properties

A value of true allows relationship lines to be 
drawn using smooth curves instead of straight line 
segments. These curves can be more taxing on 
the browser, setting to false may improve fluidity of 
animation and interaction for Dependency Views.

glide.ngbsm.performance_allow_curves

• Type: Yes | No

• Default value: Yes

• Location: Dependency Views  > Map 
Properties

Amount of time in milliseconds a notification stays 
on the screen.

glide.ngbsm.notification_display_time

• Type: Integer

• Default value: 5000

• Location: Dependency Views  > Map 
Properties

The maximum amount of results displayed when 
searching for CIs.

glide.ngbsm.search_ci_limit

• Type: Integer

• Default value: 10

• Location: Dependency Views  > Map 
Properties

The maximum amount of results displayed when 
searching for Relationship Types.

glide.ngbsm.search_rel_type_limit

• Type: Integer

• Default value: 5

• Location: Dependency Views  > Map 
Properties

When available, the map should display the class 
labels for each CI.

glide.ngbsm.show_class_labels

• Type: Yes | No

• Default value: Yes

• Location: Dependency Views  > Map 
Properties
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Properties for Dependency Views  (continued)

Property Description

Truncate node labels to a single line and to fit 
available space (default). Disable to display entire 
labels on multiple lines and wrapped as needed.

glide.ngbsm.truncate_long_labels

If 
glide.ngbsm.show_class_labels 
is enabled, then the class label always 
displays on top of the CI label, and 
wrapping applies to both the class and the 
CI labels.

• Type: Yes | No

• Default value: No

• Location: Dependency Views  > Map 
Properties

Minimum horizontal distance between nodes in 
horizontal layout.

glide.bsm.layout_horizontal_spacing_x

The distance is measured in pixels 
between one node's center to another 
node's center.

• Type: Integer

• Default value: 200

• Location: Dependency Views  > Map 
Properties

Minimum vertical distance between nodes in 
horizontal layout.

glide.bsm.layout_horizontal_spacing_y

The distance is measured in pixels 
between one node's center to another 
node's center.

• Type: Integer

• Default value: 100

• Location: Dependency Views  > Map 
Properties

Minimum horizontal distance between nodes in 
vertical layout.

glide.bsm.layout_vertical_spacing_x

The distance is measured in pixels 
between one node's center to another 
node's center.

• Type: Integer

• Default value: 125

• Location: Dependency Views  > Map 
Properties

Minimum vertical distance between nodes in 
vertical layout.

glide.bsm.layout_vertical_spacing_y

The distance is measured in pixels 
between one node's center to another 
node's center.
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Properties for Dependency Views  (continued)

Property Description

• Type: Integer

• Default value: 125

• Location: Dependency Views  > Map 
Properties

Components installed with Dependency Views

Several types of components are installed with the activation of the Next_Gen BSM 
(com.snc.ng_bsm) plugin, such as tables.

Note: 
The Application Files table lists the components that are installed with this application. 
For instructions on how to access this table, see Find components installed with an 
application .

Tables installed

Table Description

Available CI icons

[ngbsm_ci_icons]

Stores all available CI class icons.

Icons for CI types

[ngbsm_ci_type_icon]

Maps icons to CI class names.

Map Script

[ngbsm_script]

Custom scripts that run in real time and generate a custom view of a 
map for a specific CI.

Map View

[ngbsm_view]

Serialized map views saved by users.

Map Filter

[ngbsm_filter]

Filters saved by users.

Menu Action

[ngbsm_context_menu]

Default and custom context menu actions that appear when users 
right click a map.

Related Item

[ngbsm_related_item]

Stores which reference fields should be treated as relationships when 
building the map. This allows users to include CI's that are related via 
a reference field instead of a relationship.

Edge Colors

[bsm_edge_color]

Color definitions to use when drawing the relationships between 
nodes based on relationship type.

Map Indicator Stores all map indicators.
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Table Description

[bsm_indicator]

BSM Saved Map

[bsm_graph]

Details of maps.

BSM Map Actions

[bsm_action]

Actions on the map.

BSM Map View

[map_view]

Parents' predefined filters.

Map View 
Configuration Types

[map_view_ci_type]

Configuration type filters, limiting the CI class types to be displayed, 
per predefined filter.

Map View Relationship 
Types

[map_view_rel_type]

Relationship type filters, limiting the links to be displayed between 
CIs, per each predefined filter.

[map_viewroles]
Roles that a specific predefined filter should be applied to.

CI Filters

[map_filters]

CI attribute filters, limiting the CIs to be displayed, per predefined 
filter.

Querying the CMDB

The CMDB Query Builder allows you to easily build complex infrastructure and service queries, 
that span multiple CMDB classes, non-CMDB tables, and that involve many CIs that are 
connected by different relationships.

The CMDB Query Builder provides a canvas into which you drag the CI classes that you want to 
include in a query. Then you add relationships, AND/OR operators between the CI classes, and 
define the relationship properties to query for. You can use saved queries to populate a CMDB 
group with CIs, and then use scriptable APIs to retrieve the CI list and apply actions collectively 
to all the CIs in the group.

There are two query types: CMDB Query and a Service Mapping  query, which you can use 
separately or in combination to create queries such as:

• All hardware in my service offering that has Windows installed.

• All CIs of a certain type in an application service. For example, all Apaches/Web Servers/Linux 
servers per service.

• All virtual servers and the physical servers that host them.

• All servers that are not mapped to any application service.

• All application services and their associated servers and the cost of each server. This query 
helps evaluate the cost of technology for each application service.
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Starting node: The starting point of the query which is labeled as STARTING NODE  on the 
Query Builder canvas. The first class that you drag to the canvas becomes automatically the 
starting node of the query and you cannot select a different starting node. In a complex query, 
the starting node must always be the only node connected to an AND/OR operator. If you try to 
connect a second node to an operator that the starting node is connected to, the query fails to 
run and a prompt to select a different starting node appears.

Additional information

• For a webinar, see CMDB Query Builder Queries and Reporting - Platform Analytics Academy
blog post in the ServiceNow Community.

• For some tips and basic troubleshooting for the CMDB Query Builder, see the CMDB Query 
Builder [KB0681251] .

Intelligent Search for CMDB integration

By default, Intelligent Search for CMDB  functionality is integrated into the CMDB Query Builder. 
When opening the Query Builder, you can use the Intelligent Search search box which appears 
above the Query Builder canvas. Intelligent Search lets you use everyday natural language query 
(NLQ) to build a query. Intelligent Search parses, resolves any ambiguities in table names and 
relationship types, and then converts your search string into a valid query. The query appears 
fully constructed on the Query Builder canvas where you can run or continue and develop the 
query.

The integration of Intelligent Search for CMDB with the CMDB Query Builder is controlled by the 
system property glide.cmdb.query.nlq.activated, which is set to true  by default. If 
you set the property to false, Intelligent Search for CMDB will not be available within the Query 
Builder.

AI Search  and CMDB

NLQ  Genius Results for AI Search  use natural language queries to find CMDB tables that 
match your search without leaving a portal or workspace. For more information, see NLQ Genius 
Results .

Note: 
AI Search  is a complementary search experience that allows you to surface CMDB records 
in your normal flow of work, without having to access the CMDB Query Builder. It doesn't 
replace intelligent Search for CMDB, which is purpose-built and integrated into CMDB 
Query Builder.

CMDB Query

A query type that queries the infrastructure for CI classes and the relationships and references 
that connect them. You can optionally add the context of non-CMDB tables to a CMDB query.

You can include Application services  in a CMDB query, to find, for example:

• All critical application services in your database.

• All infrastructure in a particular application service.

• All incidents for a particular CI in an application service, or all incidents for all the CIs of an 
application service.

• All application services with a pattern of a service connected to a database, and where the 
database has incidents.
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The list of available non-CMDB tables includes a subset of tables within the system, which 
have a reference to the Configuration Item [cmdb_ci] class or its children. The list of non-CMDB 
tables, includes tables such as Asset, Task, and Problem. You can use the system property 
glide.cmdb.query.non_cmdb.black_listed_tables  to narrow down the list of non-CMDB tables to 
choose from.

Service Mapping  Query

A query type that queries application services. The query is framed within an application service 
map. You define a pattern, and query for application service maps that have that pattern in their 
definition. The relationships in Service Mapping  queries are matched by single-level direct 
relationships which is similar to the CMDB queries, and in addition, they are also matched by 
multi-level indirect relationships if they exist. A query for a relationship between two CI classes 
is satisfied even if the two CI classes are connected by intermediate CI classes that are not 
specified in the query.

Combination Query

You can combine the two query types by incorporating a saved Service Mapping  query into 
a CMDB query. For example, create a CMDB query for Windows Servers that are connected 
to Tomcat WAR. Then connect the Tomcat WAR CI class to a Service Mapping  query. The 
query changes to find Windows Servers that are connected to Tomcat WAR which is included 
in the services that returned by the Service Mapping  query. You can inverse that query by 
choosing Does Not Belong To Service. This changes the query to find Windows Servers that 
are connected to Tomcat WAR that is not included in services returned by the Service Mapping 
query.

Relationship properties

When you connect CI classes on the canvas, the CMDB Query Builder displays the Connection 
Properties in the right-side bar, where you can configure the properties of the relationship, such 
as the relationship direction. For Service Mapping  queries, you can configure whether to query 
for related or unrelated CIs.

Connection properties include:

• Relationship type: Query for CIs and descending classes with specific relationship types.

• Relationship direction: Which CI class is the parent and which CI class is the child in the 
relationship.

• Relationship level: Query only on first-level relationship or also on second-level relationships.

• No relationships: Query for CIs which have no relationship to the set class.

• References fields: A field that the parent and ancestor parent CI classes use to reference the 
child CI class.

Newly added relationships between CI classes may take up to 30 minutes to appear in the 
relationship list.

Related topics

CMDB groups

Domain separation and CMDB Query Builder

Domain separation is supported in the CMDB Query Builder. Domain separation enables you to 
separate data, processes, and administrative tasks into logical groupings called domains. You 
can control several aspects of this separation, including which users can see and access data.
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Overview

How domain separation works in the CMDB Query Builder

With the CMDB Query Builder you can easily build complex infrastructure and service queries 
that span multiple CMDB classes, and that involve many CIs that are connected by different 
relationships. Domain separation is set to be on by default.

• Saved Query

The user creates a query by dragging a class node from the class hierarchy and dropping it to 
the canvas and connecting the nodes with the relationships type.

The user can save the created query as an XML file to the database [qb_saved_query] table in 
the CMDB for future use. The saved query is domain separated.

• Query results

With a saved query, the user clicks Run  and the query result is saved and displays in the 
platform list view.

In the query results, the domain separation behaves in the same way as the platform list 
view for the CI relationship [cmdb_rel_ci] table and CMDB CI [cmdb] table. Consequently, 
since the CI relationship is not domain separated, all relationships of the query result display, 
regardless of the domains. Conversely, if the query result is CI only, since the CMDB CI is 
domain separated, the results display only if visible in the current domain.

Related topics

Domain separation and Configuration Management Database (CMDB)

Build a CMDB query using the CMDB Query Builder

A CMDB query type that queries the infrastructure for CI classes and optionally non-CMDB 
tables, and the relationships and references that connect them.

Before you begin
The Core UI plugin  (com.glide.ui.ui16) must be activated.

Role required: cmdb_query_builder_read to only view and run saved queries, and 
cmdb_query_builder (contained for itil, itil_admin, and asset) to create and save queries, modify 
saved queries, and run queries. For reporting on queries, report related ACLs are required.

Authorized users can update and delete  a query created by another user.

About this task
Build the query by dragging the CI classes and non-CMDB tables that you want to include in 
the query. Then dropping them as nodes on the canvas, and defining relationship properties 
between them. You can filter on the attributes of any node to narrow down the results to a 
specific set of CIs of that class or to a single specific CI. You can also select which property 
columns appear in the query results.

As you step through building a query, list options and other user interface elements of the CMDB 
Query Builder, are dynamically filtered as appropriate to your selections.

To learn more about using Query Builder, see the CMDB Query Builder Queries and Reporting 
- Platform Analytics Academy  ServiceNow Community  video. For a step-by-step walk through 
of building CMDB queries in the Query Builder, including queries with application services, see 
Sample queries.
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Procedure

1. Navigate to All  > Configuration  and click CMDB Query Builder.

2. On the CMDB Query Builder  page do either of the following steps:

◦ Click Create new. Type in a Name, choose CMDB Query  as the Query type, and then click 
Create.

◦ Click a widget of a saved query to continue building an existing query. Search saved queries 
first if needed.

◦ Point to the upper right corner of a saved query widget, and click the Duplicate Query  icon 
to edit a copy of a saved query. The default name of the new query contains the string 'copy'.

3. On the canvas, you can do any of the following operations:

◦ Add CI classes to the query: On the CMDB Classes  tab, select classes from the hierarchy 
list and drag them to the canvas.

◦ Add an Application Service CI to the query: On the CMDB Classes  tab, select the 
Application Service  class from the hierarchy list and drag it to the canvas.

In Application Service Properties on the right-side bar, you can select Convert attached 
nodes to pattern  to query on patterns between the application service and other CMDB 
class nodes. When querying on a pattern, the nodes on both ends of the pattern connection, 
can be any number of levels apart. If Convert attached nodes to pattern  is not selected, 
then the connection between the application service node and other CMDB class nodes, 
represent direct relationships.

◦ Add non-CMDB tables to the query: Select a table from the Non-CMDB Tables  list and drag 
it to the canvas.

Note: 
A non-CMDB table cannot be the starting node in the query.

◦ Add connections (relationships or patterns for application services) between two nodes on 
the canvas:

a. On the first node in the connection, click the small square at the center of the right side.

b. On the second node in the connection, click the small square at the center of the left side 
to create the connection.

Connection UI Notations

Notation Description

Full line A relationship in a CMDB query.

Red asterisk at the center of the connection 
line

Information such as relationship type is 
missing, invalidating the query.

Levels:<n> Types:<n>  or a <Reference 
type>  notation on the connection line As applicable: The number of relationship 

levels and the number of relationship types 
included for the connection. Or, a reference 
type for a relationship that is a reference.

Dashed line A pattern connection between an 
application service node and another node.
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◦ In Connection Properties on the right-side bar, configure relationship settings (click the 
connection line if necessary):

a. In the Relationship Direction section, select the Parent  node (the Child  node 
automatically adjusts).

b. In the Relationship Levels section, set Level  to First level relationships  if the CIs are 
directly connected. Or, Up to 2nd level relationships  if the CIs are connected either 
directly or indirectly through another CI.

c. In the Relationship Types and Related Items section, select either option:

Option Description

No Relationships To query for CIs with no connecting 
relationships, such as All Tomcat WAR 
CIs which are not connected 
to a Windows Server.

Add Relationship Types To select specific or any relationship type.

Add a Related Item To query for related CIs between the 
nodes.

◦ Configure CI reference column for a connection to a non-CMDB table: In the Connection 
Properties right-side bar, in the CI Reference Column section, select the column with a 
reference to a CI from the Use CI reference column  list. If only one option is available, it is 
automatically selected.

◦ Configure the pattern between an application service node set with the Convert attached 
nodes to pattern  option, and a non-CMDB table node: Select Apply <table> reference filter 
to all nodes in the pattern  to apply the query to the application service CI itself and to the 
CIs within the application service.

◦ Add filters to a class node: Apply filters to narrow down a class query to a specific set of CIs 
or to a single specific CI.

a. Point to the node to add a filter to, and then click the Apply filters  icon that pops up above 
the node.

b. In the Filters section, add attribute and related list conditions .

c. Close the Filters  section.
For example: Add a filter for database location to query for databases located in Seattle.

Click Applied Filters  in the right-side bar to view all filters for each node on the canvas.

◦ Add And/Or operators to the query:

a. Connect one node to two other nodes.

b. Click the And  box that appears on the connection line, to toggle between the And/Or 
operators.

For example: C1 is Tomcat WAR, C2 is Linux Server, and C3 is Windows Server. Query for 
All Tomcat WAR CIs which are connected either to Linux Server 
Or to a Windows Server.

◦ Add property columns for a node, to appear in the query results:
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Note: 
For a relationship, the query results include the parent, child, and type  columns. 
You cannot add any other columns from the [cmdb_rel_ci] table.

a. Click Properties  in the right-side pane.

b. Click a node once or twice, so that the Report Columns section appears in the right-side 
bar, and then click Add Columns.

c. Select properties and then click outside the properties list to close it.

◦ Create a combination query by integrating a Service Mapping  query into a CMDB query:

a. When building a CMDB query, click Saved Service Queries  in the left-side bar.

b. Select and then drag a Service Mapping  query to the canvas.
This query returns all CIs that satisfy the CMDB query, and that are included in the services 
returned by the embedded Service Mapping  query.

◦ Add a search tag that can then be used as a search criteria for saved queries:

a. Click the Add Tags  icon at the top of the canvas.

b. Click Add Tag  and in the Query Tags  dialog box enter one or more tag strings.

c. Click the Add Tags  icon again to close the Query Tags  dialog box.

4. Click Save.

On the Saved Queries  tab, point to a saved query widget and click Query Information. Query 
details such as the query type, last update date, CMDB groups associated with the query, and 
the query schedules appear.

What to do next

• Click Run.

Only the first 100 results of the query appear in the results pane.

◦ Click Load More Results  to view the next set of 100 results.

◦ Click Load All Results  to view the rest of the query results, up to the number specified by the 
glide.cmdb.query.max_results_limit  system property (10,000 by default).

Click a CI to open its CI form, and on the CI form click Dashboard  to view CI health in the CI 
dashboard.

Note: 

◦ Ensure that the glide.security.use_csrf_token  property is set to true, allowing all results 
to appear.

◦ When Level  is set to Up to 2nd level relationships, the relationship type does not 
appear in the query results.

◦ When a query is running, wait for it to complete or to time out before opening or running 
another query.

• Modify Query Builder settings: Click the  (Settings) icon to open the Query Builder 
Settings  dialog box.
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• Copy and share the URL of a saved query with users that have access to the CMDB Query 
Builder. Pasting the shared URL in a new internet browser window, directly opens the saved 
query in the CMDB Query Builder.

• Create reports in CMDB Query Builder.

• Create a schedule  to run the query at a future time, and to email the results to interested 
parties.

• Export query results:

Click the Query Results context menu and select Export. Even if the Load More Results  button 
is visible, indicating that there are additional query results, only the results that are visible are 
exported.

• Export and import a CMDB query  to port a query definition between instances.

• Populate a CMDB group  using a saved query.

• Delete a CMDB query.

Related topics

Sample queries

Build a Service Mapping query using the CMDB Query Builder

The Service Mapping query type is a pattern consisting of classes and relationships between 
those classes. After you build the pattern and run the query, the query returns all the Service 
Mapping services that contain that pattern.

Before you begin
The Core UI plugin  (com.glide.ui.ui16) must be activated.

Role required: cmdb_query_builder_read to only view and run saved queries, and 
cmdb_query_builder (contained for itil, itil_admin, and asset) to create and save queries, modify 
saved queries, and run queries.

Authorized users can update and delete  a query created by another user.

About this task
Build the query by dragging the CI classes that you want to include in the query, dropping them 
as nodes on the canvas, and then defining relationship properties between them. For every class 
node in the query, you can filter on its attributes to narrow down the results to a specific set of CIs 
of that class or to a single specific CI. You can also select which property columns appear in the 
query results.

As you step through building a query, list options and other user interface elements of the CMDB 
Query Builder, are dynamically filtered as appropriate to your selections.

See Sample queries  for a step-by-step walk through of building a Service Mapping query in the 
CMDB Query Builder.

Procedure

1. Navigate to All  > Configuration  > CMDB Query Builder.

2. On the CMDB Query Builder  page do either of the following:

a. Click Create new.

b. Enter a Name.
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c. Select Service Mapping Query  as the Query type.

d. Select Create.

e. Select a widget of a saved query to continue building an existing query. Search saved 
queries  first if needed.

f. Point to the upper right corner of a saved query widget.

g. Select the Duplicate Query  icon to edit a copy of a saved query.
The new query's default name contains the string 'copy'.

3. On the canvas, you can do any of the following:

◦ Add CI classes to the query: Select classes from the CMDB Classes  hierarchy list and drag 
them to the canvas.

◦ Add connections (relationships) between two nodes on the canvas:

a. On the first node in the relationship, click the small square at the center of the right side.

b. On the second node in the relationship, click the small square at the center of the left side 
to create the connection.

c. In Connection Properties  on the right-side bar, configure the following (click the 
connection line if necessary):

▪ In the Relationship Direction section, select the Parent  node (the Child  node 
automatically adjusts).

▪ In the Service Query Properties section, select Find Related CIs  or Find Unrelated CIs 
to query for a pattern in which the two classes have or do not have relationships with 
each other, respectively.

For example, All Tomcat WAR CIs which are not connected to a 
Windows Server.

Relationship UI Notations

Notation Description

Dashed line A relationship in a Service Mapping query.

◦ Add filters to a class node: Apply filters to narrow down a class to a specific set of CIs or to a 
single specific CI.

a. Point to the node to add a filter to, and then click the Apply filters  icon that pops up above 
the node.

b. In the Filters section, add attribute and related list conditions .

c. Close the Filters  section.
For example: Add a filter for business criticality to query for businesses that are 'most critical'.

Click Applied Filters  in the right-side bar to view all filters for each node on the canvas.

◦ Add And/Or operators to the query:
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a. Connect one node to two other nodes.

b. Click the And  box that appears on the connection line, to toggle between the And  and the 
Or  operators.

For example C1 is Tomcat WAR, C2 is Linux Server, and C3 is Windows Server. Query for all 
Tomcat WAR CIs which are connected either to Linux Server Or to a Windows Server.

◦ Add property columns for a node, to display in the query results:

Note: 
For a relationship, the query results display the parent, child, and type  columns. 
You cannot add any other columns from the [cmdb_rel_ci] table.

a. Click Properties  in the right-side pane.

b. Click a node once or twice, so that the node's Report Columns section appears in the 
right-side bar, and then click Add Columns.

c. Select properties and then click outside the properties list to close it.

◦ Select columns and add filters that will be applied to the resulting set of services:

a. Select Properties  in the right-side bar, and then click an empty space on the canvas to 
ensure that nothing is selected.

b. Click Add Columns  at the bottom of the right-side bar and select columns to add. Click 
outside the columns list to close it.

c. Click the Apply Service Mapping Query Filters  icon at the top of the canvas and add 
filters.

◦ Inverse the entire query and search for all Service Mapping services that do not include the 
query pattern: Click a node once or twice so that Query Properties appear in the right-side 
bar. In the Metadata section, toggle Services Including This Pattern  to enable or disable the 
option.

◦ Add a search tag that can then be used as a search criteria for saved queries:

a. Click the Add Tags  icon at the top of the canvas.

b. Click Add Tag  and in the Query Tags  dialog box enter one or more tag strings.

c. Click the Add Tags  icon again to close the Query Tags  dialog box.

4. Click Save.

On the Saved Queries  tab, point to a saved query widget and click Query Information  to view 
query details such as the query type, last update date, and the query schedules.

What to do next

• Click Run.

The query results pane displays only the first 100 results of the query.

◦ Click Load More Results  to display the next set of 100 results.

◦ Click Load All Results  to display the rest of the query results, up to the number specified by 
the glide.cmdb.query.max_results_limit  system property (10,000 by default).

Click a CI to open its CI form, and on the CI form click Dashboard  to view CI health in the CI 
dashboard.
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Note: 
When a query is running, wait for it to complete or to time out before opening or running 
another query.

• Modify Query Builder settings: Click the Settings icon ( ) icon to open the Query Builder 
Settings  dialog box.

• Copy and share the URL of a saved query with users that have access to the CMDB Query 
Builder. Pasting the shared URL in a new internet browser window, directly opens the saved 
query in the CMDB Query Builder.

• Create reports in CMDB Query Builder.

• Create a schedule  to run the query at a future time, and to email the results to interested 
parties.

• Export query results:

Export query results that are visible: Click the Query Results context menu and select Export. 
Even if the Load More Results  button is visible, indicating that there are additional query 
results, only the results that are visible are exported.

• Export and import a CMDB query  to port a query definition between instances.

• Populate a CMDB group  using the saved query.

• Delete a CMDB query.

Related topics

Sample queries

Sample queries

Use the following sample queries to build your own CMDB queries and Service Mapping queries.

Using the CMDB Query Builder requires that the Core UI plugin  (com.glide.ui.ui16) is activated.

CMDB query sample

Use this example to build a CMDB query to find all servers with a connection to a database.

Before you begin
Role required: none

Example:

1. Navigate to All  > Configuration  > CMDB Query Builder.

2. Click Create new. Enter a Name  - All servers with a connection to a DB. 
Choose CMDB Query, and click Create.

3. In the CMDB Classes  list, locate the Server  class, and drag it to the canvas.

4. Locate the Database  class, and place it to the right of the Server  class node on the canvas.

5. Click at the center of the right side of Server, and then at the center of the left side of 
Database  to create a connection line between the two class nodes.

6. Click once or twice on the connection line until the Connection Properties panel appears 
in the sidebar. In the Relationship Types and Related Items section, click Add Relationship 
Types  and add all the relationships from the list.
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Settings in the Relationship Direction section reflect the parent-child direction in the 
relationship. If the Database class is the parent in the relationship, then the Parent  and Child 
settings are switched.

7. Click Save, and then click Saved Queries  on the left to see the widget for the saved query.

8. Click the query widget to return to the canvas in edit mode.

9. Click Run  to execute the query.

Review the query results. Each row displays the name of a server CI, the name of a database 
CI, and the relationship type between them.

10. Add columns to the query results:

a. Click the Server 1  node on the canvas once or twice so that the Server 1 Report Columns 
section appears in the right-side pane. Click Add Columns.

b. Select Manufacturer  and then click outside the columns list to close it.

c. Click Run.
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Review the query results which now include the Manufacturer  column.

d. Click Save  again to save all your customization for this query.

CMDB query sample - Application service 1

Use this example to build a CMDB query to find all critical application services, and their owner.

Before you begin
Role required: none

Example:

1. Navigate to All  > Configuration  > CMDB Query Builder.

2. Click Create new.

3. Enter All critical application services  as the query Name. Choose CMDB 
Query  and then click Create.

4. In the CMDB Classes  list, locate the Application Service  class, and then drag it to the canvas.

5. Add a filter to the application service node:

a. Point to the application service node, and then click the Apply filters  icon that appear.

b. In the Filters section, add the condition [business criticality] [is] [1 - most critical].

c. Close the Filters section.

6. Add columns to the query results:

a. In the Properties right-side bar, click Add Columns.

b. Select business criticality  and owned by, and then click outside the columns list to close it.

7. Click Save.

8. Click Run  and then review the results. You can for example, locate any of the critical 
application services without an owner.

CMDB query sample - Application service 2

Use this example to build a CMDB query to find all application services, for which there is an 
incident or a change request, for either, the application service itself, or any CI within the service.

Before you begin
Role required: none

Example:

1. Navigate to All  > Configuration  > CMDB Query Builder.

2. Click Create new.

3. Enter Application services with incidents or change requests  as the 
query Name. Choose CMDB Query  and then click Create.

4. In the CMDB Classes  list, locate the Application Service  class and then drag it to the canvas.

5. Click Non-CMDB Tables.

6. Locate the Incidents  class in the class hierarchy, and then drag it to the canvas.

7. Locate the Change Requests  class in the class hierarchy, and then drag it to the canvas.

8. Connect the Application Service and the Incidents nodes, and then, in the Properties right-
side bar:
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a. Select Apply Incidents reference filter to all nodes in the pattern.

b. Set Use CI reference column  to Configuration item.

9. Connect the Application Service and the Change Request node, and then, in the Properties 
right-side bar:

a. Select Apply Change Request reference filter to all nodes in the pattern.

b. Set Use CI reference column  to Configuration item.

10. Click the And  operator between the Incidents and the Change Request nodes, and switch it to 
Or.

11. Click Save.

12. Click Run  and then review the results.

CMDB query sample - Application service 3

Use this example to build a CMDB query to find all hardware in my service offering that has 
Windows installed.

Before you begin
Role required: none

Example:

1. Navigate to All  > Configuration  > CMDB Query Builder.

2. Click Create new.

3. Enter All hardware in my service offering that has Windows 
installed  as the query Name. Choose CMDB Query  and then click Create.

4. In the CMDB Classes  list, locate the following classes, and then drag them to the canvas.

◦ Service

◦ Service Offering

◦ Application Service

◦ Searching for infrastructure, Hardware

5. Connect the Service node to the Service Offering node.

In the Properties right-side bar, click Add Relationship Type  and select the Connect 
to::Connected by  relationship.

6. Connect the Serviced Offering node to the Application Service node.

In the Properties right-side bar, click Add Relationship Type  and select the Connect 
to::Connected by  relationship.

7. Click the Application Service node.

In the Properties right-side bar, select Convert attached nodes to pattern  to include all CIs 
within the application service, in the query.

8. Connect the Application Service node to the Hardware node.

9. All infrastructure under Service,

10. Click Save.

11. Click Run  and then review the results.
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You can click Column options  of the Service column header, and select to Group by Service. 
Then expand a service to see all the hardware infrastructure under that service.

12. Return to the CMDB Query Builder window, to expand the query to include only infrastructure 
CIs on which Windows is installed.

13. Click Non-CMDB Tables, locate the Software Instance  class, and drag it to the canvas.

14. Connect the Hardware node to the Software Instance node.

In the Properties right-side bar, set Use CI reference column  to Installed on.

15. Point to the Software Instance node, and click on the Apply filters  icon that appears. In the 
Filters section, add the condition [Product Name.Name] [is] [windows]. Close the Filters 
section.

16. Click Save.

17. Click Run  and review the new results.

Service Mapping query sample

Use this example to build a Service Mapping query to find all Linux servers in services.

Before you begin
Role required: none

Example:

1. Navigate to All  > Configuration  and click CMDB Query Builder

2. Click Create new. Enter a Name  - Linux server in services. Choose Service 
Mapping Query, and click Create.

3. In the CMDB Classes  hierarchy list, locate Linux Server  and drag it to the canvas.

4. Click Run.

Review the query results. Each row displays the name of a Service Mapping Service and the 
name of a Linux Server that is a member of that service.

5. On the right-side pane, click Disable Service Including This Pattern  and then click Run  again.

Review the query results. Now, each row displays the name of a Service Mapping Service that 
does not include the specified Linux Server.

Run a partial CMDB query

You can run a partial query in the CMDB Query Builder by defining a section of a query, and then 
running it.

Before you begin
The Core UI plugin  (com.glide.ui.ui16) must be activated.

Role required: cmdb_query_builder (contained for itil, itil_admin, and asset)

About this task
While building a query or reviewing a saved query, you can run only a section of the query. On 
the canvas in the CMDB Query Builder, highlight a section of the query which contains the nodes 
and relationships of the partial query that you want to run. You can then examine the results of 
the partial query, and update the query if needed.
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Procedure

1. Navigate to All  > Configuration  > CMDB Query Builder.

2. On the CMDB Query Builder page, click a tile to open an existing query.

3. Click the selection tool under the navigation tool  to switch to a section selection mode.

4. Border a section of the query:

a. Click the mouse device on the upper left corner of the section that you want to create.

b. Drag the mouse device to the bottom right corner of the section that you want to create.
As you drag the mouse device, the selected section is highlight in light blue.

c. Release the mouse device.
The query nodes that are included in the partial query, appear with a blue border.

5. Click Run.

6. In the Pick Starting Node dialog box, select the starting node for the partial query, and click 
Confirm.

Result
The results of the partial query appear in the Results pane.

Delete a CMDB query

Delete a CMDB query that is no longer used or needed.

Before you begin
The query that you want to delete must be already saved.

Role required: cmdb_query_builder (contained for itil, itil_admin, and asset). Authorized users 
can delete a query created by another user.

Procedure

1. Navigate to All  > Configuration  and click CMDB Query Builder.

2. On the CMDB Query Builder  page, select the Saved Queries tab and set the viewing mode to 

Card view ( ).

3. Hover over the card with the query that you want to delete.

4. Click the Delete Query (X) icon that appears in the upper right corner of the card.

Batch size for CMDB Query Builder queries

In a base system, a global batch size of 100 is allocated for every Query Builder query run. If 
needed, you can use a system property to override the default global batch size, or optimize the 
batch size value per saved query.

Queries can differ widely as they can be configured to query a wide variety of classes. Therefore, 
the batch size in the base system might not be optimal for every query, and some queries might 
time out or take a long time to complete. The optimal batch size for running queries depends 
on system load such as amount of data and number of relationships in your system. Contact 
Support for assistance in calculating the batch size for your query.
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Batch size is applicable and behaves the same in all query run scenarios, regardless of how the 
run was initiated:

• Query Builder user interface (ad hoc or saved query)

• Query Builder Scriptable API

• Scheduled jobs

• CMDB groups

The batch size for query runs is allocated in the following priority order:

1. The value in the Execution Batch Size  field in the Saved Queries table, for a specific 
saved query. If set, this value applies only to the saved query, and has priority over the global 
value of 100 and the value of the glide.cmdb.query.batch_size  system property.

2. The value of the system property glide.cmdb.query.batch_size, if exists, determines globally 
the batch size that is allocated to all query runs. If you add and set this property, the value 
applies to all queries, other than saved queries with Execution Batch Size  value set.

3. A global value of 100, if the previous two options are not configured.

Modifying batch size for queries

If you are experiencing performance problems when running queries, you can modify the batch 
size value:

• Globally for all queries: By adding (if necessary) and setting the value of the system property 
glide.cmdb.query.batch_size.

• Per saved query: Set batch size for a specific saved query

Set batch size for a specific saved query

Configure a custom batch size for a CMDB Query Builder saved query that takes a long time 
to complete or that times out. A custom batch size overrides the global batch size in the base 
system and the value of the glide.cmdb.query.batch.size  system property.

Before you begin
Role required: admin

About this task
Contact Support for assistance in calculating the batch size for your query.

Procedure

1. In the Filter navigator, enter qb_saved_query.list  and press Enter to navigate to the 
Saved Queries table.

2. In the Saved Queries list view, locate the saved query for which you want to change batch size.

3. Set or modify the value in the Execution Batch Size  field.
Set the value to be greater than the global value in the glide.cmdb.query.batch.size  property, or 
increase any existing value.

Navigation in CMDB Query Builder

Use the navigation tools to enlarge or shrink the query, to move the query, or to border a section 
of the query to run.

Using the Query Builder requires that the Core UI plugin  (com.glide.ui.ui16) is activated.
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Use the buttons in the navigation tool  as follows:

• Use the plus sign (+) to increase magnification of the query.

• Use the minus sign (-) to decrease magnification of the query.

• Click the center dot to center the query on the canvas.

• Use the direction arrows to move the query in that direction.

• Use the selection tool under the navigation tool to toggle between two states:

◦ Moving the entire query on the canvas.

◦ Bordering a section of the query, which you can then run as a partial query.

Create reports in CMDB Query Builder

Use CMDB Query Builder reports to show the results of a CMDB query or a Service Mapping 
query. Create a basic report, or a dynamic report that automatically updates when the results of 
the associated saved query change.

Create a dynamic report

After running a saved query in the CMDB Query Builder, create a dynamic report that 
continuously updates to show the latest query results. You can use a dynamic report as any other 
report created using Reporting and you can add it to Performance Analytics dashboards.

Before you begin
Ensure that the query that you want to create a dynamic report for is a saved query, and that 
there is a specified schedule for the query. Also, run the saved query and ensure that all query 
results are visible.

Role required:

• To create: cmdb_query_builder and report_user

• To view: Reporting role requirements might apply, see Administering reports  for Reporting 
role requirements.

In a base system, the cmdb_query_builder role is contained in the itil and asset roles.

About this task
The Create Report  button in CMDB Query Builder which is used to create a dynamic report, is 
activated only if:

• The query is saved

• The query has a schedule

• The entire set of query results is present after a query run

The initial dynamic report that you create, is based on the results from the initial run of the saved 
query. Then, on every subsequent run of the saved query, the associated report automatically 
updates with the latest query results.

However, if you change the query definition itself, the query and the report are no longer in sync 
and you must create a new report.
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Procedure

1. Navigate to All  > Configuration  > CMDB Query Builder.

2. In the Saved Queries  tab, select the saved query for which you want to create a report.
Ensure that the query has a specified schedule.

3. Click Run  and ensure that all query results appear.

4. Click Load All Results  if available, to load all results.
The Create Report  button is enabled only if all query results are showing.

5. Click Create Report.
If the CMDB Query Builder displays the query results in a new tab, then after the new tab 
opens with the query results, return to the CMDB Query Builder window.

6. In the Report Designer, click Next  or Back  to view and configure the new report in the Data, 
Type, Configure, and Style  tabs.
The report is pre-populated with the CMDB query results and a few other report details.

◦ Report name  is set to the name of the saved query.

◦ Source type  is set to Data source.

◦ Data source  is set to the table in which the query results are stored.

◦ Query Sys ID  is the ID of the latest run of the query.

For more details about Reporting and about configuring a report in the Report Designer, see 
Reporting , Creating reports .

7. Click Save  or Run.

Result
CMDB Query Builder creates a report source which you can attach to a report and use with 
dashboards. For more details about report sources, see Report sources .

What to do next
Use either of the following steps to view the new report source. The name of the new report 
source is set to the name of the CMDB query it was created from, and cannot be changed.

• In Query Builder, click Saved Queries. In the Saved Queries window, click the Query 
Information  icon in the tile of the saved query. Scroll to the bottom of the information list and 
then click the link under Report source.

• Navigate to All  > Reports  > Administration  > Report Sources  and locate the new report 
source.

Create a basic report

After running a query in the CMDB Query Builder, you can create a basic report that is scoped to 
the query execution.

Before you begin
The Core UI plugin  (com.glide.ui.ui16) must be activated.

Role required:

• View report: cmdb_query_builder or cmdb_query_builder_read

• Create report: cmdb_query_builder or cmdb_query_builder_read, and report_user

In a base system, the cmdb_query_builder role is contained in the itil and asset roles.
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Procedure

1. Navigate to All  > Configuration  and click CMDB Query Builder.

2. Build a query.

3. In the query results pane, click Load More Results  or Load All Results  to load all the results 
that you want to include in the basic report.

4. In the query results pane, click the column context menu and select Bar Chart  or Pie Chart.

Result
The Reports application creates a basic report, which is scoped to the query results that are 
currently loaded and is static.

Related topics

Reporting

Build a CMDB query using the CMDB Query Builder

Build a Service Mapping query using the CMDB Query Builder

Run a partial CMDB query

Search saved queries

The CMDB Query Builder allows you to search for a specific saved query using any combination 
of search criteria such as the query's name, type, custom tags, and who created or updated the 
query.

Before you begin
To locate a saved query using a Query Tags  search criteria, the query must have a query tag 
associated with it. For more information see Build a CMDB query using the CMDB Query Builder, 
or Build a Service Mapping query using the CMDB Query Builder.

The Core UI plugin  (com.glide.ui.ui16) must be activated.

Role required: cmdb_query_builder (contained for itil, itil_admin, and asset)

Procedure

1. Navigate to All  > Configuration  > CMDB Query Builder.
The Saved Queries tab shows all saved queries in tiles, and also a tile for creating a new query.

2. On the Saved Queries tab, specify a Sort by  criteria to filter the saved queries that are 
showing.

3. In the Search Saved Queries  field, enter a search string that corresponds to the Sort by 
selection and then select an item from the list that gets populated as you type.
The drop-down list includes search strings that can be applied to the sorting criteria such as 
'Query name'.

4. Refine the search by entering additional Search Saved Queries  search strings as needed.

Create a schedule for a CMDB query

Schedule a saved CMDB query to run once at a scheduled time or on a recurring schedule, and 
to email the query results to specified users.

Before you begin
The Core UI plugin  (com.glide.ui.ui16) must be activated and a saved CMDB query that was built 
in the CMDB Query Builder must exist.
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Role required: cmdb_query_builder (contained for itil and asset)

About this task
The query results are attached to the email as a file in the specified format. By default, the 
maximum result rows that can be attached is 10,000. This is controlled by a system property.

Procedure

1. If need to, navigate to All  > Configuration  > CMDB Query Builder  and then click a saved 
query.

2. Click Create Schedule  and fill out the form.

Scheduled Email of Query Builder form

Field Description

Query The query to run.

Users
Users who should receive query results email.

To receive emails, users must have an Email 
address defined and have Notifications set to 
Enable in their user records.

Groups Groups to email the query results to.

Zip output Indicates whether the report should be sent 
as a zip file.

Active Indicates whether to run the query according 
to the specified schedule.

Run Frequency for running the query.

Time Time of day to run the query.

Conditional Indicates whether to display the Condition 
field, which allows you to specify conditions 
under which the query runs.

Omit if not records Indicate whether to distribute email if the 
query returns zero results.

Email addresses Email addresses of users who should receive 
the email but who are not in the system.

Subject Text that appears in the subject line of the 
distribution email.

Introductory message Additional message that is delivered with the 
query results.

Condition
User-created script that checks for certain 
conditions to be true before running the 
query.

This field is visible only when Conditional  is 
checked.
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Field Description

Type File format to use for the query results.

Note: 
Configure the form layout  to add this 
field to the form.

Export and import a CMDB query

Export a saved CMDB or Service Mapping query definition to an XML file which you can later 
import and run in the CMDB Query Builder. This process lets you port a saved query between 
instances, such as from a development environment to a production environment.

Before you begin

• You must save a query before you can export it.

• Domain in an exported query must be visible in both, source and destination instances.

Role required: cmdb_query_builder (contained in itil, itil_admin, and asset).

About this task
When exporting a combination query, the integrated Service Mapping  query definition is 
included in the exported query.

For backward compatibility, you can alternatively Export and import a query as an update set.

Procedure

1. Navigate to All  > Configuration  > CMDB Query Builder.

2. Export a saved query:

a. In the Saved Queries  tab, in either list view or card view, select a saved query.

b. Click the Export query  icon at the top of the Query Builder canvas.

c. Wait for the Query Export Complete  message to appear and then click Download.
You can now access the query XML file.

3. Import a saved query:

a. In the Saved Queries  tab, click the Import query  icon at the top of the CMDB Query Builder 
window.

b. In Finder, select the saved query XML file and click Open.
The imported query is available in the Saved Queries  tab of the CMDB Query Builder on the 
instance.

Export and import a query as an update set

Export a saved query definition to an XML file as an update set, which you can later import.

Before you begin
Role required: To export — cmdb_query_builder (contained in itil and asset). To import — user 
with permission to import an update set.
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Domain in the exported query must be visible in both, source and destination instances.

About this task
Export a query definition as an update set which you can later import and commit. This process 
lets you port a query between instances, such as from a development environment to a 
production environment. For more information about exporting and then committing update sets 
using XML files, see Save an update set as a local XML file .

When exporting a combination query, the integrated Service Mapping  query definition is 
included in the exported update set.

Procedure

1. Export a saved query:

a. In the Filter navigator, enter qb_saved_query.list.

b. Select Enter  to navigate to the Saved Queries table.

c. In the Saved Queries list view, select the query that you want to export.

d. Select Actions on selected rows  and then Export query.

e. Wait for the Query Exporter  to complete the export.

2. Import the exported saved query:

a. Navigate to System Update Sets  > Retrieved Update Sets.

b. On the Retrieved Update Sets form, select Import Update Sets from XML.

c. On the Import XML page, select Choose file.

d. Select the exported XML file.

e. Select Upload.

f. Open the new record that was added to the Retrieved Update Sets list view.

g. On the Retrieved Update Set form, select Preview Update Set Batch.

h. Close the Batch Update Set Preview dialog box.

i. Select Commit Update Set Batch.

j. Close the Commit Update Set Batch dialog box.

Result
The imported query is added to the Query Builder saved queries on the instance.

Settings for CMDB Query Builder

Use settings to control some aspects of the CMDB Query Builder behavior.

Using the Query Builder requires that the Core UI plugin  (com.glide.ui.ui16) is activated.

Open the Query Builder Settings  dialog box:

1. Navigate to All  > Configuration  > CMDB Query Builder.

2. On the CMDB Query Builder  page, click the Settings icon ( ).

3. Click the Settings icon again to close the dialog box.
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Setting Description

Display Relationships in Results Display the relationship between CIs in the 
query results.

Display Suggested Connections Filter the CMDB classes and the non-CMDB 
tables lists in the left pane to display only 
classes and tables that the selected node on 
the canvas has a relationship with. You can 
then drag any item from the filtered list to the 
canvas, and connect it to the selected node 
on the canvas.

This setting applies only to CMDB queries.

Display Results in New Tab Display query results in a separate browser tab 
titled Query Results.

Properties for CMDB Query Builder

Use the CMDB Query Builder properties to configure query processing.

These properties are available for CMDB Query Builder. To view and edit these properties, the 
admin role is required.

Note: 
To open the System Properties [sys_properties] table, enter sys_properties.list  in 
the navigation filter.

Properties for CMDB Query Builder

Property Description

Limits the number of results for a scheduled 
query and in the results section in the Query 
Builder when you click Load All Results.

glide.cmdb.query.max_results_limit

• Type: integer

• Default value: 10000

• Location: Configuration  > CMDB Properties 
> Query Builder Properties

Time limit (in seconds) for running one batch 
to get one batch of query results (100 results).

glide.cmdb.query.batch_time_limit_in_sec

• Type: integer

• Default value: 300

• Location: Configuration  > CMDB Properties 
> Query Builder Properties

Time limit (in seconds) for running an entire 
query to get all results.

glide.cmdb.query.query_time_limit_in_sec

• Type: integer

• Default value: 1800

• Location: Configuration  > CMDB Properties 
> Query Builder Properties

Exclude list of non-CMDB tables that shouldn’t 
appear in the CMDB Query Builder when 
creating a CMDB query.

• Type: string

• Default value: empty
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Properties for CMDB Query Builder  (continued)

Property Description

glide.cmdb.query.non_cmdb.black_listed_tables • Other values: Comma separated list of table 
names (not labels). Can include '*abc' to 
exclude all tables containing 'abc' in their 
table name.

• Location: Configuration  > CMDB Properties 
> Query Builder Properties

glide.cmdb.query.batch_size
Batch size allocated globally when saved 
queries run.

• Type: integer

• Default value: 100

• Location: Add to System Properties 
[sys_properties]  table.

Monitor system foundations in the CSDM  and the CMDB  Data Foundations 
Dashboards

The ServiceNow®  CSDM  and CMDB  Data Foundations Dashboards store app contains 
dashboards which provide insights into the key foundational metrics of your CMDB  and Common 
Service Data Model  (CSDM). This app provides recommendations to ensure that the CMDB  and 
CSDM  are properly configured for optimal usage and to mitigate any potential risks.

Note: 
CSDM and the CMDB Data Foundations Dashboards don't support domain separation.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

The CSDM  and CMDB  Data Foundations Dashboards store app provides dashboards that 
complement each other. See the respective sections for each of the following dashboards:

CMDB Data Foundations dashboard

Evaluates various configurations and customizations in the CMDB. This dashboard 
checks that important data is valid and properly configured, and identifies and 
provides visibility into potential risks in the implementation. Use the CMDB  Data 
Foundations dashboard to prevent issues and support continuous effective 
functioning of the CMDB.

CSDM Data Foundations dashboard

The CSDM Data Foundations dashboard displays key CSDM  metrics on a single 
page to assist you in getting the full benefit from your ServiceNow AI Platform® 

products.

The CSDM and the CMDB Data Foundations dashboards capability is provided by the 
com.snc.cmdb.getwell plugin, which is activated by default in base systems.
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For an introduction, watch the ServiceNow  Data Foundations Dashboards for CSDM and CMDB
video.

Access the dashboards

To access these dashboards, navigate to All  > Configuration, and then select CMDB Data 
Foundations Dashboard  or CSDM Data Foundations Dashboard. You can toggle between 

the two dashboards by clicking the change dashboard icon ( ) on the title bar of either 
dashboard.

Manage performance

It might be useful to manage the performance impact of some metrics that are greatly affected 
by, for example, a large CMDB or a high number of non-compliant CIs. You can use any of the 
following methods to manage performance of those metrics to improve the overall performance 
of the dashboards:

Deactivate a metric

Starting with CSDM and the CMDB Data Foundations Dashboards v2.2 you can 
deactivate CSDM or CMDB metrics.

To improve performance, deactivate metrics that aren't needed or that require 
extensive resources and affect performance. The active/non-active settings for 
metrics are preserved across family release upgrades.

To deactivate a metric, you must access the CMDB/CSDM Get Well Metrics 
[sn_getwell_metric] table where all CMDB and CSDM metrics are stored. Navigate 
to the list view of the table [sn_getwell_metric]. Then, locate the metric that you want 
to deactivate and set its Active  column to false. Tiles on the dashboards that are 
associated with inactive metrics stop collecting data and aren't refreshed.

Limit a metric

For the following metrics, you can use metric-specific settings to limit their 
performance impact:

• CMDB metrics:

◦ CIs Processed via IRE

◦ CIs with Relationships to Parent and Child

◦ Hardware CIs with Serial Numbers

• CSDM metrics:

◦ Application Services with 'Consumes::Consumed By' 
Relationship to Business Application

◦ Application Services with Business Application 
Relationships

◦ Business Application with Application Service 
Relationship

The following columns in the CMDB/CSDM Get Well Metrics [sn_getwell_metric] 
table are set with default values per metric, that limit performance impact and which 
you can fine tune. Review those settings for example, when there is a large number 
of non-compliant CIs for a metric. Another example is having a large CMDB where a 
small number of compliant CIs for a metric is already a sufficient indication of health 
and there is no need to process the rest of the CIs for that metric.
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• Aggregate limit: The maximum number or percentage of non-compliant CIs 
that are reported for the metric. Once that threshold is reached, counting for the 
metric stops for the run and the score for the metric is set to 0.

• Fail count threshold: The threshold of the number of consecutive metric 
runs that failed due to exceeding the metric's Runtime threshold. When that 
threshold is reached, the respective metric is automatically deactivated.

• Runtime threshold: The time threshold in seconds that is considered too 
long for a metric run. When exceeded, the current metric run is considered failed.

For most metrics, when the number of consecutive runs that fail because the 
runtime exceeds Runtime threshold, is greater than the Fail count 
threshold, the system automatically deactivates the metric. You can manually 
reactivate a deactivated metric by setting its Active  column to true. An exception to 
the those column definitions and usage is the CMDB CIs Processed via IRE 
metric. For details, see CMDB Data Foundations dashboard.

CMDB Data Foundations dashboard

Use the CMDB Data Foundations dashboard to monitor foundational key health-related metrics 
in CMDB.

Requirements

• To access the CMDB Data Foundations dashboard, users must be configured with the admin, 
itil_admin, or asset roles. Some metrics that let you drill-down to Performance Analytics (PA) 
data, might require additional roles for accessing specific tables. Those roles are specified as 
appropriate per metric.

• The CMDB Data Foundations dashboard adds the following scheduled jobs, which must be 
running:

◦ CMDB Get Well Metric Collection: Calculates and stores details for compliant 
CIs associated with metrics, populating the list view of the metrics. Data appears on the 
dashboard only after the first run of this scheduled job. Metrics' scores are stored in the 
CMDB Data Foundations Metric Scores [sn_getwell_cmdb_score] table. This non-PA job runs 
daily by default.

◦ CMDB Data Foundations PA Metric Collection: Calculates the total non-
compliant CIs associated with metrics and populates the PA widgets on the dashboard. Also, 
provides trending data over time for the non-compliant CIs associated with metrics. This PA 
job runs daily by default.

◦ CMDB Get Well CIs Processed Via IRE Metric Batch Collection: 
Invoked once a day (by default) by the CMDB Get Well Metric Collection  job and 
repeatedly runs in 10 minute intervals, to process as many 1,000-CIs (default) batch files as 
possible. After each 10-minute run, the job stops for a minute.
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Overview

The CMDB Data Foundations dashboard provides four tabs, each grouping a distinctive set of 
CMDB metrics:

• Best Practices: Checks if usage of tables and properties is as intended for supporting the 
health of the CMDB. This set of metrics checks adherence of CSDM-related standards, for 
example, for populating services and relationships.

• Customizations: Checks how customizations to the CMDB are used. This set of metrics 
checks that customizations are not used excessively, and that they are used only when 
needed and are correctly applied.

• Data Management Practices: Checks if importing third-party data into the CMDB is properly 
done without compromising the integrity of the CMDB. This set of metrics checks if the 
imported data is properly configured and formatted to provide the foundation for CMDB 
functions.

• ITSM Processes: Check if ITSM processes leverage CMDB data.

Columns in the list view of metrics

The following columns appear in the list view of metrics:

Name

Name of metric.

Priority

Priority of an metric. The priority for an metric is a calculation of the weight of the 
metric and the severity of the percentage score. Priority ranges from 1- Critical  as 
the highest priority, to the lowest priority which is 5 - Low. Metrics are listed in their 
priority order, starting with the highest priority metric (lowest priority number).

Result

Percentage number of CIs (or the measured item) which are in compliance with 
the metric. A bar shows the percentage of CIs (or the measured item) which 
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are in compliance versus the percentage of items which are not in compliance. 
The portion on the bar that represents CIs (or the measured item) which are in 
compliance, uses the following color scheme to note the level of compliance:

• Red: 0–50% of the total CIs (or the measured item), are in compliance for the 
metric.

• Yellow: 50–90% of the total CIs (or the measured item), are in compliance for the 
metric.

• Green: Above 90% of the total CIs (or the measured item), are in compliance for 
the metric.

The portion on the bar that represents the percentage of items which are not 
in compliance for the metric, always appears in darker shade. Also, all metric 
percentage scores are aligned so that a higher percentage score and a smaller 
darker-shade portion on an metric bar, always indicate the more optimal state.

Note: 
Some metrics use a lower threshold value which impacts the result that 
appears in the dashboard. For these metrics, if the percentage of compliant 
CIs is less than the lower threshold value, then the result appears as 0 for the 
metric.

Remediation playbook URL

Links to remediation playbook articles in Now Support. These knowledge articles 
provide context for the respective issue, guidelines to help remediate the issue, and 
other necessary details to bring CIs into compliance. Click the link and use your 
Now Support  credentials to access the knowledge article.

Performance Analytics widgets

Most metrics are associated with Performance Analytics (PA) widgets  (tiles) that provide further 
details about CIs that are not in compliance with the metric, correlating to the dark-shade portion 
of the metric bar. Drill down the tiles to access PA widgets, which are provided by the CMDB 
Data Foundations PA Metric Collection  scheduled job.

On the Analytics Hub page:

• Click the Breakdowns  context menu to see any available breakdowns.

• Ensure that the Real-time  ( ) option is selected and then click Show Records  to see a 
list view of the respective CIs.

Best Practices metrics

The Best Practices  tab contains the following metrics:

Create Asset Business Rule is Enabled

Checks for the existence of the Create Asset on insert  business rule. If 
the business rule exists, the percentage score for the metric is 100. Otherwise, the 
percentage score is set to 0.

Custom CMDB Attributes at the Right Level

Percentage of custom attributes that should be added at a higher level in the CMDB 
hierarchy. For example, the custom attribute Warranty duration  was added 
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three times in the Computer class, instead of adding the attribute once at a higher 
level in the hierarchy, which is more efficient.

• If (total number of attributes that can be moved up > 10): Percentage is set to 0.

• Otherwise: Percentage is set to (10 – total number of attributes that can be moved 
up)*10.

Hardware CIs with Serial Numbers

Percentage of Computer or Network Gear CIs with a serial number versus those CIs 
without. The metric is based on the following conditions:

• Class is an instance of Computer or Gear

• Status = installed

• Operational status = operational

• Serial number is empty

The complete set of CIs for this metric consists of the CIs that satisfy the first 
three conditions. The CIs that satisfy all conditions are counted as non-compliant 
Computer or Network Gear CIs, which are without a serial number.

Note: 
If the percentage of compliant CIs is less than 70%, then the percentage score 
for this metric is set to 0.

The Hardware CIs Missing Serial Numbers tile shows the total number of CIs which 
are not in compliance with the metric, correlating the darker-shaded portion of the 
metric bar. Click the tile to drill down the PA widget for further details, such as the list 
all those CIs.

The Hardware CIs Missing Serial Number by Key Classes chart shows those CIs 
that are missing a Serial Number, grouped by key classes. Point to a class bar on the 
chart to show more details, and click a class bar to access a list view of those CIs for 
class.

To manage a potential performance impact, other than deactivating the metric, 
you can limit the performance impact by adjusting the following performance 
management columns for the metric in the CMDB/CSDM Get Well Metrics 
[sn_getwell_metric] table. For this metric, those columns are set with the following 
default values:

• Aggregate limit: 30 (% of CIs in the metric)

• Fail count threshold: 3

• Runtime threshold: 3,600

For more information about these columns, see Performance management in 
Monitor system foundations in the CSDM and the CMDB Data Foundations 
Dashboards.

Services with Owners

Percentage of operational services in which the owned_by  field is populated 
versus those operational services in which this field isn't populated.

The complete set of CIs for this metric consists of all the operational services in the 
Service [cmdb_ci_service] table (where operational_status  = Operational). 
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The percentage score for this metric is calculated as (Compliant CIs/Complete set 
of CIs) *100.

The Services Missing Owners tile shows the total number of CIs which are not in 
compliance with the metric, correlating the darker-shaded portion of the metric bar. 
Click the tile to drill down the PA widget for further details, such as the list all those 
CIs.

Customizations metrics

The Customizations  tab contains the following metrics:

Base System Business Application Table Usage

Checks for the existence of a custom business application table, which is any table 
that extends [cmdb_ci], whose name starts with “u_” or “x_” and which contains the 
strings “bus” and “app”.

If such custom table exists, then is 0, and if not, the percentage is 100.

The Custom Business Application Tables tile shows any custom business 
application tables. Click the tile to drill down the PA widget for further details, such 
as the list all those tables.

Base System CMDB Relationship Types Usage

Percentage of base system relationship types versus custom relationship types that 
were created by users. Creating custom relationship types can interfere with the 
integrity of the CMDB therefore this metric can help you prevent such problems.

This metric counts records in the Relationship Type [cmdb_rel_type] table where 
sys_package  is “global” and name  is not “Manages::Managed by”. The 
percentage score for this metric is calculated as follows:

• If count is <= 0, then percentage is 100

• If count is > 10, then percentage is 0

• Otherwise percentage = (10 – count)*10

The Custom CMDB Relationship Types tile shows the relationships which are not 
in compliance with the metric, correlating the darker-shaded portion of the metric 
bar. Those are the relationships that were not included in the base system and were 
custom created. Click the tile to drill down the PA widget for further details, such as 
the list all those relationships.

Base System Relationship Types Not Deleted or Recreated

Percentage of relationship types that exist in the base system and which were not 
deleted or recreated, versus those that were deleted and maybe recreated. Deleting 
and recreating base system relationships can interfere with the integrity of the 
CMDB, therefore this metric can help you prevent potential problems.

This metric counts the number of base system relationships that were deleted and 
possibly recreated. The percentage score for the metric is calculated as follows:

• If count is <= 0 then the percentage is set to 100

• If count is > 10 then the percentage is set to 0

• Otherwise, the percentage = (10 – count)*10

.
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The Base System CMDB Relationship Types Deleted and/or Recreated tile shows 
the relationships which are not in compliance with the metric, correlating the darker-
shaded portion of the metric bar. Click the tile to drill down the PA widget for further 
details, such as the list all those relationships.

Custom CMDB Tables Using Standard Naming

Percentage of custom CMDB tables whose name doesn't start with the standard 
string “u_cmdb_ci”. The metric counts tables in the Tables [sys_db_object] table that 
extend from the CMDB table and whose name starts with the string “u_” (indicating 
that it is a custom table) but not with “u_cmdb_ci”.

The percentage score for this metric is calculated as follows:

• If count <= 0 then percent is 100

• If count > 6 then percent is 0

• If count is between 0 and 6, then percent is (1-(count/6))*100

The Custom CMDB Tables Not Using Standard Naming tile shows the tables which 
are not in compliance with the metric, correlating the darker-shaded portion of the 
metric bar. Click the tile to drill down the PA widget for further details, such as the list 
all those tables.

Use of Custom Attributes

Percent of custom attributes that were added to CMDB tables in the base system. 
Custom attributes are identified by a table name that starts with "cmdb_ci" and a 
column name that starts with “u_.”

The percentage score for the metric is calculated as follows:

• If (total custom attribute count > 50): Percentage is set to 0.

• If (total custom attribute count < 10): Percentage is set to 100.

• If (total custom attribute count is 10–50): Percentage is set to (total custom 
attribute count – 10)/(50-10)*100.

Data Management Practices metrics

The Data Management Practices  tab contains the following metrics:

Active CIs Updated in Last 90 days

Percentage of Hardware [cmdb_ci_hardware] or Virtual Machine Instance 
[cmdb_ci_vm_instance] active CIs that were updated in the past 90 days versus 
those CIs that were not (stale CIs). The metric is based on the following conditions:

• Class is an instance of Hardware or VMware Virtual Machine Instance

• Status = installed

• Operational status = operational

• Updated >= 90 days

The complete set of CIs for this metric consists of CIs that satisfy the first 
three conditions. The CIs that satisfy all conditions, are counted as stale 
CIs of the Hardware [cmdb_ci_hardware] and Virtual Machine Instance 
[cmdb_ci_vm_instance] classes.
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Note: 
If the percentage of compliant CIs is less than 65%, then the result displayed 
for this metric is set to 0.

The Active CIs Not Updated in 90 Days tile shows the total number of CIs which 
are not in compliance with the metric, correlating the darker-shaded portion of the 
metric bar. Click the tile to drill down the PA widget for further details, such as the list 
all those CIs.

CIs Processed via IRE

Percentage of Hardware [cmdb_ci_hardware] or Virtual Machine Instance 
[cmdb_ci_vm_instance] CIs processed via IRE versus those CIs not processed 
via IRE. CIs are counted as processed via IRE if they satisfy all of the following 
conditions:

• Instance of Hardware [cmdb_ci_hardware] or Virtual Machine Instance 
[cmdb_ci_vm_instance]

• Status = installed

• Operational status = operational

• Sys_id is IN (target_sys_id FROM sys_object_source table)

The CIs that satisfy only the first three conditions but fail the forth condition, are 
counted as CIs not processed via IRE.

Note: 
Viewing the data provided by PA for this metric, requires the additional role 
of admin or discovery_admin.  However, the Show Records  button on the 
Analytics Hub page isn't supported.

To manage a potential performance impact, other than deactivating the metric, 
you can limit the performance impact by adjusting the following performance 
management columns for the metric in the CMDB/CSDM Get Well Metrics 
[sn_getwell_metric] table. For this metric, those columns are set with the following 
default values:

• Aggregate limit: 1,000 (Number of records in each batch file processed 
by the CMDB Get Well CIs Processed Via IRE Metric Batch 
Collection  job during its 10-minute run intervals.)

• Fail count threshold: 3

• Runtime threshold: 72,000 (Daily limit of total runtime of all CMDB Get 
Well CIs Processed Via IRE Metric Batch Collection  job 
runs)

For this metric, there is no trigger for automatically setting the metric score to 0. For 
more information about these columns, see 'Performance management' in Monitor 
system foundations in the CSDM and the CMDB Data Foundations Dashboards.

CIs with Names

Percentage of Hardware, VMware Virtual Machine Instance, or Application CIs with 
a name up to 200. The metric is based on the following conditions:

• Class is an instance of Hardware [cmdb_ci_hardware], Virtual Machine Instance 
[cmdb_ci_vm_instance], or Application [cmdb_ci_appl]

• Status = installed
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• Operational status = operational

• Name is empty

Non-compliant CIs are counted as the CIs that are missing a name, which are those 
CIs that satisfy all conditions.

The percentage score for the metric is calculated as follows:

• If count of CIs without names is > 200, percent is 0

• If count of CIs without names is < 200, percent is (200-(count of CIs without 
names)/200 * 100)

The CIs Missing Names tile shows the total number of CIs which are not in 
compliance with the metric, correlating the darker-shaded portion of the metric bar. 
Click the tile to drill down the PA widget for further details, such as the list all those 
CIs.

CIs with Relationships to Parent and Child

Percentage of non-orphan CIs versus orphan CIs.

The complete set of CIs for this metric consists of CIs in records from the CI 
Relationship [cmdb_rel_ci] table. CIs in which [parent.sys_class_name=(empty)] OR 
[child.sys_class_name=(empty)], are counted as orphan CIs.

The Orphan CIs tile shows the total number of orphan CIs, correlating the darker 
portion of the metric bar. Select the tile to drill down to the list all those CIs.

To manage a potential performance impact, other than deactivating the metric, 
you can limit the performance impact by adjusting the following performance 
management columns for the metric in the CMDB/CSDM Get Well Metrics 
[sn_getwell_metric] table. For this metric, those columns are set with the following 
default values:

• Aggregate limit: 1,000

• Fail count threshold: 3

• Runtime threshold: 3,600

For more information about these columns, see Performance management in 
Monitor system foundations in the CSDM and the CMDB Data Foundations 
Dashboards.

Handled Duplicate CIs

Percentage of duplicate CIs of the Hardware or VMware Virtual Machine Instance 
classes, that were remediated, up to 200. If the number of unhandled duplicate CIs 
is greater than the upper threshold of 200, then is set to 0. The metric is based on 
the following conditions:

• Class is an instance of the Hardware [cmdb_ci_hardware] or the Virtual Machine 
Instance [cmdb_ci_vm_instance] class.

• Status = installed

• Operational status = operational

• Duplicate_of in not empty

Non-compliant CIs are counted as those CIs that satisfy all conditions. Non-
compliant CIs are those Hardware [cmdb_ci_hardware] or Virtual Machine 
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Instance [cmdb_ci_vm_instance] duplicate CIs that were not remediated. For more 
information, see Duplicate CIs remediation.

The percentage score for this metric is calculated as follows:

• If count of non-compliant CIs is > 200 then percent is 0

• If count of non-compliant CIs is < 200 then percent is (200-count of non-
compliant CIs)/200*100

The Unhandled Duplicate CIs tile shows the total number of CIs which are not in 
compliance with the metric, correlating the darker-shaded portion of the metric bar. 
Click the tile to drill down the PA widget for further details, such as the list all those 
CIs.

Installed Server CI Naming Reflecting Hostname

Percent of Server CIs where name reflects the host name, up to the first period in 
the name. The complete set of CIs for the metric are all the servers in the Server 
[cmdb_ci_server] table in which install_status=1 and host_name  is not 
empty.

Examples of compliant CIs:

• Server Name is “abc”, and host name is “abc.1.2.3”

• Server Name and host name are the same

The percentage score for the metric is calculated as (Compliant CIs/Total CIs)*100.

The Installed Server CI Naming Not Reflecting Hostname tile shows the number of 
Server CIs which are not in compliance with the metric. Click the tile to drill down 
the PA widget for further details, such as the list all those CIs.

Note: 
If you need to manually refresh the Installed Server CI Naming Not Reflecting 
Hostname widget, then you must first run the CMDB Get Well Metric Collection 
job, and then run the CMDB Data Foundations PA Metric Collection job.

Managed CIs with Model Entries

Percentage of Hardware [cmdb_ci_hardware] CIs with a model ID versus those CIs 
without.

The complete set of CIs for this metric consists of all the CIs in the Hardware 
[cmdb_ci_hardware] table. Compliant CIs are those in which model_id  is 
populated.

The Managed CIs Missing Model Entries tile shows the total number of CIs which 
are not in compliance with the metric, correlating the darker-shaded portion of the 
metric bar. Click the tile to drill down the PA widget for further details, such as the list 
all those CIs.

Servers with Location

Percentage of Server CIs in which Location  is populated versus Server CIs 
in which Location  isn't populated. The complete set of CIs for this metric are 
the Server CIs in the Server [cmdb_ci_server] table in which install_status =1 and 
operational_status=1. Compliant CIs are those CIs in which also location is not null.

The percentage score for the metric is calculated as (Compliant CIs/Total CIs)*100.
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The Servers Missing Location tile shows the number of Server CIs which are not in 
compliance with the metric. Those are the Server CIs in which Location  is empty. 
Click the tile to drill down the PA widget for further details, such as the list all those 
CIs.

Unique Locations

Percentage of unique locations versus non-unique (duplicate) locations.

The complete set of locations for this metric consists of all the locations in the 
Location [cmn_location] table records, in which name  is not null. A duplicate 
location is counted as a record in which name  is not null, and the same name is 
used more than once.

The percentage score for the metric is calculated as (Compliant CIs/Total CIs)*100.

The Duplicate Locations tile shows the total number of CIs which are not in 
compliance with the metric, correlating the darker-shaded portion of the metric bar. 
Click the tile to drill down the PA widget for further details, such as the list all those 
CIs.

Note: 
If you need to manually refresh the Installed Server CI Naming Not Reflecting 
Hostname widget, then you must first run the CMDB Get Well Metric Collection 
job, and then run the CMDB Data Foundations PA Metric Collection job.

ITSM Processes metrics

The ITSM Processes  tab contains the following metrics:

Changes Referencing a CI

Percentage of change requests with a reference to CIs versus those change 
requests without. The complete set includes all change requests created in the last 
90 days. Compliant records are those change requests in which the cmdb_ci  field 
is not empty.

The percentage score for the metric is calculated as (Compliant change requests/
Total change requests) * 100.

The Changes Not Referencing a CI tile shows the total number of records which 
are not in compliance with the metric, correlating the darker-shaded portion of the 
metric bar. Click the tile to drill down the PA widget for further details, such as the list 
all those change requests.

Note: 
Viewing all the data provided by Performance Analytics for this metric (when 
drilling down), requires the additional role of itil or sn_change_read.

Changes Relating to both a Service and a CI

Percentage of changes relating services to CIs versus those changes that don't. 
The complete set of CIs for this metric consists of all change request records. 
Compliant records are those change requests in which both, the cmdb_ci  and the 
business_service  fields, are not empty.

The Incidents Relating to Neither a Service nor a CI tile shows the total number of 
records which are not in compliance with the metric, correlating the darker-shaded 
portion of the metric bar. Click the tile to drill down the PA widget for further details, 
such as the list all those CIs.
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Note: 
Viewing all the data provided by Performance Analytics for this metric (when 
drilling down), requires the additional role of itil or sn_change_read. Click the 
tile to drill down the PA widget for further details, such as the list all those CIs.

Incidents Referencing a CI

Percentage of incidents referencing a CI versus those incidents that don't. The 
complete set of records includes all incidents created in the last 60 days. Compliant 
incidents are all those in which the cmdb_ci  field is not empty.

The percentage score for the metric is calculated as (Compliant Incidents/Total 
Incidents)*100.

The Incidents Not Referencing a CI shows the total number of incidents which are 
not in compliance with the metric, correlating the darker-shaded portion of the 
metric bar. Click the tile to drill down the PA widget for further details, such as the list 
all those incident records.

Note: 
Viewing all the data provided by Performance Analytics for this metric (when 
drilling down), requires the additional role of itil or sn_incident_read.

Incidents Relating to both a Service and a CI

Percentage of incidents relating to both a service and a CI versus those incidents 
that don't. The complete set for this metric is all incident created in the last 60 
days. Compliant records are those incidents in which both, the cmdb_ci  and the 
business_service  fields, are not empty.

The percentage score for the metric is calculated as (Compliant Incidents/Total 
Incidents) * 100.

The Incidents Relating to Neither a Service nor a CI shows the total number of 
records which are not in compliance with the metric, correlating the darker-shaded 
portion of the metric bar. Click the tile to drill down the PA widget for further details, 
such as the list all those incident records.

Note: 
Viewing all the data provided by Performance Analytics for this metric (when 
drilling down), requires the additional role of itil or sn_incident_read. Click the 
tile to drill down the PA widget for further details, such as the list all those CIs.

CSDM  Data Foundations dashboard

The CSDM Data Foundations dashboard displays key CSDM  indicators on a single page to help 
you get the full benefit from your ServiceNow AI Platform  products.

Access the dashboard

Use either of the following methods to open the dashboard:

Navigate to All  > Configuration, and then select CSDM Data Foundations Dashboard.

1. In CMDB Workspace, navigate to Workspaces  > CMDB Workspace.

2. Select Management  in the CMDB Workspace  menu bar.

3. Select CSDM Data Foundations Dashboard  in the Optimize section of the Management tools.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

599



Select the change dashboard icon ( ) to toggle between the CSDM  and CMDB  dashboards.

Example

The reports on each tab display the data metrics that are appropriate for the maturity of your 
organization's CSDM  implementation stage (foundation, crawl, walk, run, and fly).  A label on each 
report identifies the metric being displayed.

In this example, a report on the Run  tab indicates that several business service offerings don't 
have the required relationships to application services. With this knowledge, Service owners can 
add the relationships to ensure that customer service agents get complete information on the 
upstream impacts of applications that are down.

Tabs on the dashboard

• The Foundation domain involves tables that contain base data that is referenced from or 
to objects in the other CSDM  domains. Foundation data is required before you can use 
ServiceNow  products or add data to the CMDB.  See 'Foundation' stage reports on the CSDM 
Data Foundations dashboard.

• In the Crawl stage, you work on base-system  CMDB  tables that are associated with IT Service 
Management  (ITSM).  See 'Crawl' stage reports on the CSDM Data Foundations dashboard.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

600



• In the Walk stage, you identify and populate the network infrastructure CIs and applications 
that your organization's technical teams support.  See 'Walk' stage reports on the CSDM Data 
Foundations dashboard.

• In the Run stage, you set up the relationship between a technology and the business that sells 
and/or consumes the technology.  See 'Run' stage reports on the CSDM Data Foundations 
dashboard.

• When you reach the Fly stage, you've accomplished all or most of the process of implementing 
the CSDM  framework. The fly stage completes the process.  See 'Fly' stage reports on the 
CSDM Data Foundations dashboard.

Managing performance of data collection

The system runs scheduled jobs that collect data for three CSDM  metrics:

• App services that are missing a business app relationship

• Business apps that are missing an app service relationship

• App services where the relationship to business apps is not Consumed by

To ensure optimum performance, the system stops collecting data for some metrics when 
a specified number of non-compliant CIs is discovered. For information on managing data 
collection for a metric that isn't needed or that affects performance of the dashboard, see 
Manage performance.

Related topics

Configure the CSDM Data Foundations dashboard

Monitor system foundations in the CSDM and the CMDB Data Foundations Dashboards

CMDB Health

Monitoring and maintaining the health of the CMDB is essential to an effective and continuous 
use of the product. Health indicators such as duplicate CIs, required CI fields, and audits 
contribute to the calculation of health scorecards at the CI, class, and CMDB level.

Note: 
CMDB Health doesn't support non-CMDB tables.

The health of the CMDB data is monitored and reported for the following KPIs, each further 
consisting of sub metrics:

• Completeness: CIs are tested for required and recommended fields that are not populated.

• Correctness: CIs are tested against pre-defined data integrity rules such as identification rules 
(to detect duplicate CIs), orphan CI rules, and stale CI rules.

• Compliance: The CMDB data is audited for adherence to pre-defined certificates.

• Relationships: The health of CI relationships is tested for indicators such as orphan and 
duplicate relationships. And for compliance with suggested relationships, hosting and 
containment rules.

After CIs are tested for various health indicators, the results are aggregated at the class level, 
and eventually at the overall CMDB level. You can configure how health is calculated and the 
weight of each KPI and each metric at every level of the aggregation. For most health tests, you 
can configure the health tests themselves.
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CMDB Health experience in CMDB Workspace

You can use the CMDB Workspace  landing page and its views to access CMDB health details 
that are based on CMDB Health activities and aggregations. For example:

• Use the Important actions tile on the landing page to access cards with CMDB Health-related 
tasks such as de-duplication tasks.

• Use the CMDB Health tile to see overall health metrics for CIs and relationships, to navigate to 
the CMDB Health and CMDB Relationship Health dashboards, and to drill down to more health 
details for specific CIs.

• Use tiles throughout the CMDB Workspace  to drill down to health overviews of specific CIs.

CI remediation

CMDB Health provides a framework for configuring CI remediation. Remediation lets you 
proactively apply corrective actions to unhealthy CIs in a managed and standardized fashion.

Domain separation

CMDB Health is domain aware. If the domain separation plugin has been activated, then the 
CMDB dashboard displays health based on data, rules, and settings from the logged-on user 
domain. If rules and settings are not defined for a child domain, then the parent's settings are 
applied, recursively.

Metric tests from the global domain propagate to subdomains. However, subdomains can have 
their own local metric tests which override the global domain tests. Up until the San Diego 
release, subdomain local metric tests were applied to the subdomain CIs and also to the global 
domain CIs (which are visible on subdomains). Global domain CIs that failed metric tests of local 
subdomains, could have generated large amounts of data due to duplicated data.

Starting with the Tokyo  release, CIs in the global domain are evaluated only against metric tests 
specified in the global domain. In subdomains, local metric tests are applied only to the CIs in 
that subdomain and are not applied to the global domain CIs (even though the global domain CIs 
are visible in the subdomain). Health results for CIs in the global domain appear on subdomains 
and health results on subdomains reflect this new behavior.

See Domain separation in CMDB Health  for more information.

Setup

To start gathering and aggregating health data, you need to enable the CMDB Health-related 
jobs (CMDB Health Dashboard jobs) which are initially disabled. You also need to configure 
CMDB Health related system properties and health KPI and metric test rules, to customize how 
aggregated data is calculated and other CMDB Health behavior.

For all the details about setting up and configuring CMDB Health, see Set up and configure 
CMDB Health.

Domain separation in CMDB Health

This is an overview of domain separation as it pertains to CMDB Health. Domain separation 
enables you to separate data, processes, and administrative tasks into logical groupings called 
domains. You can control several aspects of this separation, including which users can see and 
access data.

Overview

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

602



CMDB dashboards should be set up with their own set of rules to best accommodate how the 
user needs them. CMDB dashboard jobs adhere to those rules to produce reports. These are 
covered in separate sections below.

How domain separation works in CMDB Health

For dashboards to be the most effective, users should configure the dashboard accordingly. This 
is done by setting up the orphan, staleness, and inclusion rules to meet their needs, which then 
affect the reports displayed on the dashboard.

The settings and metrics define different aspects of each application because each domain 
can be configured differently. These rules are set up in addition to those that are included in the 
base system. There are different types of owners for different CIs; each domain has its own set of 
rules.

Metric tests from the global domain propagate to subdomains. However, subdomains can have 
their own local metric tests which override the global domain tests. Up until the San Diego 
release, subdomain local metric tests were applied to the subdomain CIs and also to the global 
domain CIs (which are visible on subdomains). Global domain CIs that failed metric tests of local 
subdomains, could have generated large amounts of data due to duplicated data.

Starting with the Tokyo  release, CIs in the global domain are evaluated only against metric tests 
specified in the global domain. In subdomains, local metric tests are applied only to the CIs in 
that subdomain and are not applied to the global domain CIs (even though the global domain CIs 
are visible in the subdomain). Health results for CIs in the global domain appear on subdomains 
and health results on subdomains reflect this new behavior.

Note: 
Domain separation is on by default, but each domain can be configured as needed.

Health Preferences

Configure these preferences during setup:

1. Global system properties that control CMDB Health – System properties are not domain 
separated. To learn more see CMDB Health system properties.

2. CMDB Health Dashboard Jobs  – There is a dashboard job for each major KPI, such as 
Completeness. That job finds the health of the CIs across all the enabled domains. There is 
only one job run for all domains and jobs themselves are not domain separated.

Users can define the frequency with which they want to run jobs; the report runs for all the 
domains. The more domains included in the job, the longer the job runs.

3. Health Metrics – These selections are domain-separated and adhere to the established 
“system overrides” logic of domain separation. Changes are made according to the domain 
for which the user is logged in. Base system values are defined at the global domain. The 
overriding domain logic means these values apply for all domains. If users want different 
values for a domain, they must be logged in to a specific domain and change the property from 
there. The new property setting applies only to that domain and any domain that inherits this 
domain. To learn more, see Health Metrics.

Note: 
Regarding the Completeness, Compliance, and Correctness KPIs: Users can disable this 
KPI if they don’t want to see that as part of the dashboard score. All these settings are 
domain-separated and the user can define specific properties for the domain.
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a. Weighted averages – These settings can affect all or part of the metrics in Completeness, 
Compliance, Correctness, and Relationship. They can be set differently for different 
domains.

b. Active – This setting is the most important because it affects how long the jobs run. The more 
domains with flags set to Active, the longer the jobs take. It’s best to select only those 
domains you wish to be Active  and render the rest as Active  = false. You can set this in 
Health Preferences. The default settings for global domain are Active  = true, but you can 
modify or disable specific domains the user wants to see in the dashboard. Users should 
consider the domain hierarchy when changing these values. If there is a large number of 
domains (>100) the job can take a very long time. To mitigate this, set Active  to false  for all 
the root domains, thereby disabling all the other domains in the hierarchy. If there is a rule at 
the top, all child domains inherit that rule.

c. Failure Threshold, Create Task, Task Assignee Group  – All these settings 
can be set differently for different domains depending on what is needed in each domain.

d. Exceptions – For Relationship metrics (relationship, duplicate relations, orphan relations, 
stale relations) the failure threshold setting is not domain separated. The Failure Threshold 
for the global domain is applied to all domains. For example, even if users were to override 
the Failure Threshold for a domain, the global domain setting for Threshold is still applied.

e. Troubleshooting / Implementation detail – These settings are stored in the 
cmdb_health_metric_pref  table, which is domain separated.

CMDB Health-related rules

See CMDB Health-related rules settings at:

• Required

• Recommended

• Orphan

• Staleness

Most of the CMDB Health-related rules are domain separated and provided by the users. Users 
can define different rules for different domains by logging in to each domain and adding/
overriding rules in the CI Class Manager.

1. Completeness

a. Required fields – These are based on the class schema defined in the platform’s System 
dictionary  and is fixed for all domains. These cannot be changed.

b. Recommended fields – These are domain separated. The table used is 
cmdb_recommended_fields, which is domain separated. The user can set these up for 
different domains.

2. Correctness

a. Duplicates – Duplicates are based on Identification rules, which are not domain separated, 
so the same rules apply to all domains.

b. Orphan – Orphan rules are domain separated; there are different orphan rules for different 
domains. The table used is cmdb_health_orphan_rule  and is domain separated.

c. Staleness – Staleness rules are domain separated. The table used is 
cmdb_health_staleness_rule. The base system rule (60 days) is set for global domain so is 
inherited by all domains as the default rule.

3. Compliance
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Audit – Audit scores are based on the desired state or scripted audits defined in the 
compliance module by the user.Audits themselves are domain separated. When audit score 
evaluation is enabled for a domain, scores become based only on the audits visible in that 
domain.

Health inclusion rules:

• Health inclusion rules are domain separated. The rules are stored in the 
cmdb_health_config  table which is domain separated.

• Each domain can have its specific health inclusion rules and domain-specific rules for each 
sub-metric.

• When a health inclusion rule is defined globally, all sub-domains inherit the rule according to 
the domain structure and the rule can be overridden at any domain.

• When a health inclusion rule is defined at the Configuration Item [cmdb_ci] class level, all 
descending classes inherit the rule and the rule can be overridden at any class level.

Health Dashboards (CMDB View/ Service View / Group View)

In general, CMDB Health dashboards are domain aware and show data according to the logged-
on domain user. If a user is logged into a domain and views a health dashboard:

1. Only scores for enabled metrics in that domain display (based on the Health Preferences 
Active  flag as discussed above).

2. All scores are based on CIs that are visible from the specific domain. (These are regular 
domain visibility rules: From that domain you can see CIs in global domain, the specific 
domain, any child domain of that domain or any domain that gets directly or indirectly 
contained by that domain.)

3. The dashboard view is based on domain rules defined in domain mapping, as opposed to 
those provided by the logged-in user. This view overrides any additional domain visibility 
rules that a logged-in user might have. The admin sets the basic rules, but does not set each 
individual domain. The admin can give specific users or user groups additional visibility to 
other domains and the dashboard still does not change. The dashboard strictly follows the 
domain rules mentioned above, based on the domain hierarchy for the domain in which the 
user is logged in.

4. As explained in the Health Preferences section, users can define different preference values 
for any domain which impact the scores reported in the dashboard. Preferences that can 
impact scores include Weighted Averages, Failure Threshold, and Active.

5. As explained in the CMDB Health Rules section, the scores reported for the metrics are based 
on the health rules defined for them (staleness, orphan, recommended, audit, and inclusion 
rules) which can be defined differently for a specific domain (in the CI Class Manager). Only 
the required metric and duplicate metric are based on rules that apply in all domains.

6. Service View/ Group View – These reports also largely follow the above points. Typically, these 
views differ from various views/filters for the Health Report. One is based off business rules, 
the other is based off CMDB Health groups.

Related topics

Domain separation and Configuration Management Database (CMDB)

Set up and configure CMDB Health

The data collection system is highly configurable, however, the base system is minimally 
configured for aggregating CMDB health data. Most importantly, the CMDB Health Dashboard 

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

605



jobs are disabled by default and data is not collected. To display valuable and meaningful data, 
you should review and adjust settings.

1. Review CMDB Health KPIs and metrics  to learn what CMDB Health can monitor, and what 
needs to be configured to enable and support each metric.

2. For each KPI and associated metric that you want monitored, define the necessary rules and 
fulfill other needed requirements. For example, create orphan rules for detecting orphan 
records, if you are interested in this metric.

3. Review and adjust the threshold ranges for best, at risk, and critical states for the CMDB health 
metrics scorecards - see Configure CMDB Health scorecard thresholds.

4. Set metric aggregation preferences, deactivate KPI and metrics that you are not interested in 
reporting, set failure thresholds, and adjust weighted averages of aggregation  - see Configure 
KPI and metrics aggregation preferences.

5. Narrow the scope of CIs that are included in health calculations - see Create health inclusion 
rule.

6. Enable the Health Dashboard jobs for the KPIs that you want reported - see Enable and 
configure a CMDB Health Dashboard job.

7. Customize the CI dashboard  (optional).

CMDB Health system properties

Configure the following system properties to customize how CMDB Health is monitored and 
evaluated.

Role required: itil_admin

Note: 
To open the System Property [sys_properties] table, enter 
sys_properties.list  in the navigation filter.

Property Description

Max time in minutes for which individual metric 
processor will run in each scheduled cycle

[glide.cmdb.health.metricProcessor.maxRunningTime]

If processing of a metric exceeds 
the specified time, CMDB Health 
processing halts until the next CMDB 
Health job is scheduled to run.

• Type: integer

• Default value: 120

• Location: Navigate to All  > 
Configuration  > Health Preference. 
In the right hand-side navigator, click 
System Properties.

For performance reasons, it is 
recommended not to set this property 
to a value greater than 120.
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Property Description

Note: 
If you enter an invalid value, the 
default value is used.

glide.cmdb.logger.use_syslog.CMDBHealth A comma-separated list that controls 
the level of logging of CMDB Health 
jobs. Logging creates entries in the 
system logs to capture messages 
generated by the health auditing 
process each time they run. This 
logging helps debugging if there is a 
failure.

For example, to log error and info 
messages, set the value to 'error,info'.

• Type: String

• Default value: error

• Other possible values: Comma-
separated list with any of the 
following values:

◦ info

◦ error

◦ warn

Or '*' which is equivalent to including 
all possible values.

• Location: System Property 
[sys_properties] table.

glide.cmdb.health.src.cmdb_health_audit_only
When set to true, disables health 
results from sources other than CMDB 
Health audit (such as Cloud Discovery). 
Only results generated by CMDB 
Health audit appear for KPIs in the 
CMDB Health dashboard.

For example, by default, if a CI is 
determined to be stale by Discovery, 
then that CI is counted as stale for the 
correctness KPI even though CMDB 
Health audit didn't determine that CI to 
be stale. However, in this case, drilling-
down the stale CIs metric, still shows 
those CIs in which source is Cloud 
Discovery.

• Type: true | false

• Default value: false
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Property Description

• Location: System Property 
[sys_properties] table.

• Learn more:

◦ CMDB Health KPIs and metrics

◦ Discovery for VMware vCenter

glide.cmdb.health.staleness_exclude_dependent_cis
Exclude dependent CIs for the 
staleness CMDB Health metric.

When enabled, dependent CIs are not 
checked for staleness, regardless of 
any staleness or inclusion rules that are 
defined for the respective CI types.

• Type: true | false

• Default value: false

• Location: System Property 
[sys_properties] table.

Related topics

CMDB Health Dashboard for Helsinki | Overview

Enable and configure a CMDB Health Dashboard job

Enable and configure the jobs that process CMDB health tests, to start calculating CMDB health 
scores for the completeness, compliance, correctness, and relationship  KPI. 
These health scores are then aggregated into the overall CMDB health report.

Before you begin
Role required: admin

About this task
In the base system, CMDB Health Dashboard jobs are disabled by default. Enable and configure 
the respective job for the CMDB health KPI that you want data collected and aggregated for. You 
can schedule a job to run on a recurring schedule, or execute it once at any time.

For more information about how CMDB Health Dashboard jobs work, see the Understanding the 
CMDB HealthDashboard Numbers  blog post in the ServiceNow  Community.

Procedure

1. Navigate to All  > Configuration  > CMDB Dashboard  > CMDB View, and then click CMDB 
Health Dashboard Jobs .

2. Select a job that you want to enable or configure.

CMDB Health Dashboard job Description

CMDB Health Dashboard 
- Completeness Score 
Calculation

Script for calculating the completeness KPI of CMDB health.
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CMDB Health Dashboard job Description

CMDB Health Dashboard - 
Compliance Score Calculation

Script for calculating the compliance KPI of CMDB health.

CMDB Health Dashboard - 
Correctness Score Calculation

Script for calculating the correctness KPI of CMDB health.

CMDB Health Dashboard - 
Relationship Score Calculation

Script for calculating the CI relationships KPI of CMDB 
health.

CMDB Health Dashboard 
- Relationship Compliance 
Processor

Script for calculating compliance of relationships with 
suggested relationships, and with hosting and containment 
rules.

3. Review the default configuration, and update as necessary.

Field Description

Name Job name. Leave this field with the pre-
populated name.

Active Select to activate the job.

Conditional If selected, the scripted condition must 
evaluate to true before the job can run.

Run
Configure the schedule for job execution, or 
select On Demand  to run the job manually 
when needed.

If Active  is selected, then additional fields 
appear according to your choice. For 
example, Repeat Interval  (when Run  is set to 
Periodically), and Time  for various settings 
of Run. Fill in the details to set precise 
running times.

Time zone Local time zone.

Run this script The job's script.

Note: 
Changes to the script might result in 
unexpected behavior.

4. Click Execute Now  to run the job once immediately.

Result
After you enable a CMDB Health Dashboard job, the results for the KPI are aggregated and 
displayed in the CMDB dashboard and CI dashboard, at the CMDB, class, and CI levels.

Related topics

CMDB Health Dashboard for Helsinki | Overview
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Configure CMDB Health scorecard thresholds

Configure the thresholds for best, at risk, and critical state definitions for the KPIs and metrics 
scorecards. You can configure these settings globally for the entire CMDB, or individually per 
class.

Before you begin
Role required: itil has read access, itil_admin (on top of itil) has full access.

About this task
Scorecard thresholds are used to determine overall metric state, and are defined by upper and 
lower thresholds. For example, scorecards thresholds for completeness:

• 0 - lower threshold: Best state

• Lower threshold - upper threshold: At risk state

• Upper threshold - 100: Critical state

In the base system, upper thresholds are set to 67 and lower thresholds are set to 33 for all KPIs 
and metrics. You can adjust scorecard thresholds to reflect the range of failures that should be 
used for each health state. Applying the change to a scorecard is based on the selected class in 
the CI Classes list:

• If the top level Configuration Item class is selected in the CI Classes list, changes to metric 
scorecards apply to the entire hierarchy.

• If any other class is selected in the CI Classes list, changes to metric scorecards apply to the 
selected class.

For CMDB groups, you can specify a separate set of scorecard thresholds, per CMDB group/KPI 
or metric. See Configure CMDB groups scorecard thresholds  for more details.

Procedure

1. Navigate to All  > Configuration  > CI Class Manager.

2. Click Hierarchy  to display the CI Classes list, and then select a class to set scorecards for.

3. In the class navigation bar, expand Health.

4. To configure the overall scorecard, select Other Scorecards  and then select Overall 
Scorecard.

5. To configure a scorecard for any of the KPIs (such as Compliance), or for relationship-related 
metrics (such as duplicate relations):

a. Select configuration item  at the top of the Hierarchy  list.

b. Click a KPI item, Completeness, Compliance, or Correctness.

c. Click the tab CMDB Completeness Scorecard, CMDB Compliance Scorecard, or CMDB 
Correctness Scorecard.

When you select the top-level Configuration Item class, changes to threshold settings in any 
metric scorecard apply to the entire class hierarchy.

6. To configure a scorecard for any metric:

a. In the CI Classes list, select the class to which the updated scorecard should apply to.
Select the top level Configuration Item to apply the change to the entire hierarchy.

b. Click the KPI that contains the metric for which you want to configure scorecard.
For example, click Completeness  to configure the Required Fields scorecard.
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c. Select the scorecard tab of the metric to configure, such as Required Fields Scorecard.
You might need to click New  to edit the scorecards.

7. Slide the threshold sliders, or enter specific numbers to increase or to decrease the threshold 
bars to fit your definitions for best, at risk, and critical levels for the scorecard.

8. Click Save.

Related topics

CMDB Health KPIs and metrics

CMDB Health Dashboard for Helsinki | Overview

Configure CMDB groups scorecard thresholds

Each CMDB group can have its unique set of scorecard thresholds for best, at risk, and critical 
state definitions for specific KPIs or metrics.

Before you begin
Role required: itil_admin (on top of itil)

About this task
Scorecard thresholds are used to determine overall metric state, and are defined by upper and 
lower thresholds:

• 0 - lower threshold: Best state

• Lower threshold - upper threshold: At risk state

• Upper threshold - 100: Critical state

In the base system, for all KPIs and metrics, upper thresholds are set to 67 and lower thresholds 
are set to 33. You can adjust scorecard thresholds for a specific CMDB group per KPI or metric, to 
reflect the range of failures that should be used in health reporting.

CMDB groups scorecard thresholds are stored in the [cmdb_health_scorecard_group_threshold] 
table.

Procedure

1. In the search box in the navigation bar, enter 
cmdb_health_scorecard_group_threshold.list  and press the Enter key.

2. In the CMDB Health Group Scorecard Thresholds  list, click New.

3. Fill out the form.

Field Description

Upper threshold Upper range of percentage of CIs failing 
the specified metric tests, that is used to 
calculate best and at risk states.

CMDB Group The CMDB group to which this scorecard 
threshold setting applies to.

Lower threshold Lower range of percentage of CIs failing 
the specified metric tests, that is used to 
calculate at risk and critical states.
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Field Description

Metric The metric to which the scorecard threshold 
setting applies to.

4. Click Submit.

Related topics

Configure CMDB Health scorecard thresholds

Configure KPI and metrics aggregation preferences

Metrics health scorecards are aggregated into their respective KPI, which in return are 
aggregated into the overall CMDB Health report. Set aggregation preferences for KPIs, and 
for each of their respective metrics, deactivate KPIs and metrics that you are not interested in 
reporting, and adjust weighted averages of aggregation.

Before you begin
To start collecting and reporting CMDB health KPIs and metrics, you must first enable and 
configure the CMDB health dashboard jobs.

Role required: itil_admin (on top of itil)

About this task
The completeness KPI for example, consists of the metrics required fields  and 
recommended fields, each contributing a different weight to the sum. You can configure the 
proportional weight of required fields and recommended fields within completeness to be 25 and 
75 respectively. You can also configure the proportional weight of completeness, compliance and 
correctness within the aggregated sum of the overall CMDB health.

Note: 
Non-active KPI or metrics are displayed on the CMDB dashboard in faded coloring, 
displaying the most recent aggregations that were calculated when the KPI or metric was 
active.

If Domain Support - Domain Extensions is activated, then you can configure aggregation 
preferences per domain.

In the ServiceNow  base system, the weights of KPIs have default settings, and metrics are 
globally set.

Procedure

1. Navigate to All  > Configuration  > Health Preferences.

2. Select Health Metrics  on the right-hand side navigator.

3. From the Select Metric  list select one of the KPIs such as Completeness, or a metric.

For Completeness, Compliance  and Correctness:

Field Description

Active Activate the KPI so it is included in the 
aggregated CMDB health report.

Weighted Averages Specify the weight of each metric in the 
aggregated KPI health report. The sum of 
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Field Description

weighted averages of all metrics should be 
100.

For a metric:

Field Description

Active Activate the metric so it is included in the 
aggregated health report for the respective 
KPI.

Create Task If a record fails the metric test, create a task 
with details about the failure. You can then 
view the task on the CI dashboard, and 
configure remediation for the task.

Failure Threshold When the threshold number of CIs that fail 
the health metric test is reached, health 
processing stops for the metric for this cycle.

Task Assignee Group An assignment group for the task.

4. Click Save.

Related topics

CMDB Health Dashboard for Helsinki | Overview

Set a CI attribute to be mandatory

Configure a CI attribute as mandatory so it is included in the CMDB Health tests for the 
required  metric if enabled.  Required  is a metric of the CMDB Health completeness  KPI.

Before you begin
Role required:

• Itil_admin and personalize_dictionary: For editing the dictionary table

• itil has read access

About this task
When a field is configured as mandatory, then if the required  metric is enabled, the CMDB 
health tests check whether that field is populated or not. The CMDB dashboard displays the 
aggregated report of the percentage of CIs for which one or more required fields is empty.

Procedure

1. Navigate to All  > Configuration  > CI Class Manager.

2. Click Hierarchy  to display the CI Classes list.
Then select the class with the field that needs to be set as mandatory.

3. In the class navigation bar, expand Class Info  and then select Attributes.
In the Attributes view, click Added.

4. Locate the attribute that you want to set as mandatory, and then double-click its Mandatory 
value and set it to true.
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The next time the form is opened, a field status indicator appears next to the field label, 
indicating that a value is mandatory.

Note: 
Mandatory fields are global. The field is marked as mandatory everywhere it appears on 
a form. Also, mandatory fields do not appear correctly when using Service Mapping tag-
based discovery. For more information, see Tag-based discovery in Service Mapping .

Related topics

CMDB Health Dashboard for Helsinki | Overview

Make a field mandatory

Set a CI field to be recommended

Define a list of CI fields as recommended, noting that it is desirable that they are populated by a 
data source such as Discovery. You can then configure the CMDB completeness KPI to include 
recommended fields in its aggregated health reports.

Before you begin
Role required:

• Itil_admin and personalize_dictionary: For editing the dictionary table

• itil has read access

About this task
Use this procedure for fields which should not be mandatory, but that might have useful 
information that the CI should have. For example, a field with information that might at some 
point help with diagnosis. Initially, a derived class is set with the recommended fields that are 
defined at the parent level. You can add or remove recommended fields for a derived class, 
setting it with its own recommended fields, without affecting the recommended fields at the 
parent or sibling levels. If all recommended fields for a derived class are removed, then the 
derived class automatically derives the recommended fields from its parent class.

The CI Class Manager doesn't support dot-walking for selecting fields from referenced tables, 
as recommended. See the steps at the bottom for directly updating tables with recommended 
fields, where one level dot-walking is supported.

For more information about child and parent classes, see Table extension and classes .

Procedure

1. Navigate to All  > Configuration  > CI Class Manager.

2. Select Hierarchy  to show the CI Classes list, and then select the class that contains the fields 
that need to be set as recommended.

3. In the class navigation bar, expand Health, select Completeness, and then select the 
Recommended Fields tab.

4. In the Recommended Fields tab, use the slushbucket to move the fields that you want to 
designate as recommended, from the Available  list to the Selected  list.

5. Click Save.

What to do next
You can see the list of recommended fields, per class, in the CMDB Recommended Fields 
[cmdb_recommended_fields] table.
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You can directly update the CMDB Recommended Fields table outside the CI Class Manager, 
where you can use dot-walking to designate a field from a referenced table, as recommended:

1. Select All.

2. In the Filter navigator, enter cmdb_recommended_fields.list  to access the CMDB 
Recommended Fields table.

3. On the CMDB Recommended Field form, set Table  to the table that you want to set with 
recommended fields.

4. Select Recommended fields  and use the slushbucket to select recommended fields for the 
table. You can expand a reference field up to one level, and use dot-walking to select a field 
from a referenced table.

5. Select Submit.

Related topics

CMDB Health Dashboard for Helsinki | Overview

Create or edit a CMDB Health orphan rule

Create an orphan rule to determine the percentage of orphan CIs in the CMDB.  This sum is then 
aggregated into the correctness CMDB Health KPI, and weighed into the overall CMDB health 
report. Orphan rules are defined per class, and only a single orphan rule can be defined per 
class.

Before you begin
Role required: itil has read access, itil_admin (on top of itil) has full access.

About this task
Specify the conditions that CIs must meet to be considered an orphan CI. Specify attributes that 
a CI must have, relationships that a CI should not have, or both.  In the relationship conditions, 
you can either specify that the CI has no relationships, or a set of specific relationships that the 
CI doesn't have.

Note: 
If there is a health inclusion rule  for the orphan metric, then the conditions in the health 
inclusion rule and the conditions in the health orphan rule, shouldn't be identical.

A health orphan rule can for example, identify a CI of the cmdb_ci_computer class as an orphan 
CI if the CI is not set with an owner or an asset.

Procedure

1. Navigate to All  > Configuration  > CI Class Manager.

2. Select Hierarchy  to show the CI Classes list and then select the class for which to create an 
orphan rule.

3. In the class navigation bar, expand Health, select Correctness, and then select the Orphan 
Rule tab.

4. Select a rule to edit, if one exists, or select New, and then fill out the form.

Field Description

Class The class for which the orphan rule applies.

Attributes Attribute conditions that a CI must satisfy to 
be considered an orphan CI. For example, 
the filter conditions in which both the 
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Field Description

Assigned to  and the Owned by  fields 
are empty, will identify the matching CIs as 
orphans.

Condition And/Or operation between the Attributes 
conditions and the Relationship  conditions.

Relationship
The relationship conditions that a CI must 
fail,based on records in the CI Relationship 
[cmdb_rel_ci] table, in order to be considered 
an orphan CI.

To specify that a CI must have no 
relationships, choose Any Relation  and Any 
Class  respectively.

5. Select Submit  or Update  to save the rule.

Related topics

CMDB Health Dashboard for Helsinki | Overview

Create or edit a CMDB Health staleness rule

If the staleness metric is in effect, then staleness rules are used to determine the percentage of 
stale CIs in the CMDB.  This sum is then aggregated into the correctness KPI, and weighs into the 
overall CMDB health calculation.

Before you begin
Role required: itil has read access, itil_admin (on top of itil) has full access.

About this task
The Discovery setting of certain types of CIs as stale takes precedence over a CMDB Health 
staleness rule defined for the CI. For more information about Discovery marking CIs as stale, see 
Discovery for VMware vCenter .

Staleness rules are defined per class.  If a rule isn't defined for a class, then the parent's rule is 
automatically derived by the child class and applies for the child class. If later a staleness rule is 
defined at the child class level, it overwrites the staleness rule that was derived from the parent 
class.

Procedure

1. Navigate to All  > Configuration  > CI Class Manager.

2. Select Hierarchy  to show the CI Classes list and then select the class for which to create a 
staleness rule.

3. In the class navigation bar, expand Health, select Correctness, and then select the Staleness 
Rule tab.

4. Select a staleness rule to edit or select New, and then fill out the Staleness Rule form.

Field Description

Applies to The class for which the rule applies.
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Field Description

Effective Duration The time period that is used for the staleness 
test.

If the CI was not updated (based on Updated 
sys_updated_on) within the specified 
time period — the CI is determined to be 
stale.

If you enter a value with a prefix that is valid 
and a suffix that is not, such as 15 x  — the 
valid portion of the value is used ('15'). If the 
entire value is invalid — the value is ignored 
and the previous valid value is used.

5. Select Submit  or Update  to save the rule.

Related topics

CMDB Health Dashboard for Helsinki | Overview

Create health inclusion rule

Filter the CIs that are included in health calculations and that appear in CMDB health 
dashboards by defining health inclusion rules. Health inclusion rules can be specified per 
domain.

Before you begin
Role required: itil has read access, itil_admin (on top of itil) has full access.

About this task
Evaluation for the required, orphan, recommended, duplicate and staleness health metrics, 
will apply only to CIs that satisfy health inclusion rules. For example, if you want scores of the 
duplicate metric to appear only for server and network CIs.

Note: 

• Creating health inclusion rules at the level of the base cmdb_ci table can potentially filter 
out health results of all classes in CMDB health dashboards.

• Applying a health inclusion rule to the duplicate metric, is supported only in the global 
domain.

• Due to performance issues, dot-walking in health inclusion rules for the duplicate metric 
is not supported.

In addition to any health inclusion rules, identification inclusion rules  also indirectly impact 
what appears in CMDB health dashboards for duplicate CIs. The dashboard itself uses the 
identification engine (IRE) to identify duplicate CIs and therefore identification inclusion rules are 
applied.

Inheritance of health inclusion rules:

• If there are no health inclusion rules specified for a child class, then rules specified on a parent 
class are applied to the child class.

• If health inclusion rules are specified for a child class, then those rules take precedence over 
rules specified on a parent class.
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In the base system, there are no predefined health inclusion rules, in which case all CIs are 
included in the CMDB Health calculations.

Procedure

1. Navigate to All  > Configuration  > CI Class Manager.

2. Click Hierarchy  to display the CI Classes list.

3. Select the class for which to create a health inclusion rule.

4. In the class navigation bar, expand Health  and then click Health Inclusion Rules.

5. Click an existing rule to edit or click New  and then fill out the Health Inclusion Rules form.

Field Description

Applies to Class this rules applies to.

Active record condition Criteria that CIs must meet to be included 
in the evaluation for the specified health 
metrics.

Applies to metric Metrics that the rule applies to.

6. Click Save  or Update.

What to do next
You can delete a health inclusion rules that is no longer needed by selecting that rule, and then 
on the CMDB Health Configuration form, selecting Delete.

CMDB Health KPIs and metrics

The overall CMDB health score consists of three Key Performance Indicators (KPIs) which are 
correctness, compliance, and completeness, each further consisting of sub-metrics. Each KPI 
and metric is associated with a scorecard that determines its contribution to the aggregated 
health at the overall CMDB level, class, and CI level.

You can configure which KPIs and metrics are included in the aggregated calculation, and set 
their weight in the aggregation. In the base system, all KPIs and all metrics are included in the 
aggregated health report.

Overall
An aggregation of all three KPIs (correctness, completeness and compliance), according to their 
overall scorecard weight settings.

Correctness

A KPI which is an aggregation of the following metrics, according to the correctness scorecard 
weight settings.

Orphan

Measures the percentage of orphan CIs in the CMDB. A CI can become orphan 
if it was unintentionally left in the CMDB when it is no longer needed. A CI is 
determined to be orphan if:

• The CI satisfies the criteria in an orphan rule. This criteria checks for specific 
attributes that a CI must have, and for CIs that have no relationships or that don't 
have specific relationships.

• Data is missing for the CI in its respective table, or in one of its parents' table.
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Staleness

Measures the percentage of stale CIs in the CMDB. A CI is stale if it was not 
updated within the Effective Duration  time period that is specified in the staleness 
rule  that applies to the class.

The base system includes a default staleness rule for the Configuration Item 
[cmdb_ci] class, which sets the Effective Duration  time to 60 days. This rule applies 
to all extended CMDB classes, and can be overridden by class specific staleness 
rules defined by the user. To determine CI staleness, a staleness rule for the CI's 
class is used if it exists, otherwise, the default staleness rule is used.

In addition, a relationship in which a stale CI is a parent or a child, is determined to 
be a stale relationship.

Note: 

Discovery marks VMware vCenter CIs that no longer physically exist, as stale. 
By default, this setting takes precedence over a CMDB Health staleness rule 
defined for the CI. When drilling-down in the CMDB dashboard to Health 
Results, the Source  for CIs determined to be stale by Discovery, is Cloud 
Discovery.

For the aggregated score of the correctness KPI to include 
only health results generated by CMDB Health, set the 
glide.cmdb.health.src.cmdb_health_audit_only  system 
property to true. In which case, drilling-down to the details of stale CIs still 
shows those CIs in which source is Cloud Discovery. For more information, see 
CMDB Health system properties  and Discovery for VMware vCenter .

Duplicate

Measures the percentage of duplicate CIs in the CMDB using identification rules. 
Only independent CIs are evaluated for duplication. In a set of duplicate CIs, the 
count of duplicate CIs is the total number of CIs in the set, minus one. The detailed 
graphs for a duplicate set of CIs display all the CIs in the set.

For more details, examples, and troubleshooting information about duplicate metric, 
see the CMDB Health - Duplicate Metric - algorithm [KB0726425]  knowledge base 
article.

Completeness

A KPI which is an aggregation of the following metrics, according to the completeness scorecard 
weight settings.

Required

Measures the percentage of CIs in which fields that are defined as mandatory, are 
not populated.   Missing fields are tagged as incomplete noting that for this CI some 
information is missing. Required fields are equivalent to the fields that are specified 
as mandatory  in the system dictionary.

Recommended

Measures the percentage of CIs in which fields that are set as recommended, are 
not populated. Out-of-box, no recommended fields are specified.

You can use the Add Identifier Fields In Recommended Rules  scheduled job to set 
criterion attributes from active identification rules, as recommended fields. You can 
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use the Remove Identifier Fields In Recommended Rules  scheduled job to unset 
criterion attributes from active identification rules, as recommended fields.

Compliance

Based on the results of actual CMDB audit runs.

Note: 
Audit must be activated for the compliance KPI to show results. For more information, see 
Compliance Activation.

Audit

Audit  compares actual values of specified fields, against expected values defined 
in template and scripted audits. Based on the Last run date  of audits, CMDB 
Health identifies the set of the most recent complete audit run, and uses those 
audit results. To pass the CMDB Health audit test, a CI must be in compliance 
with all audits for that CI. Create a compliance-type audit, for which the results are 
calculated into the CMDB Health compliance KPI.

When running scripted audits, the Last run date  is not populated. Therefore, 
for the compliance KPI to include the results of a scripted audit, update the script in 
the audit to record the audit run time.

Relationships

Measures the health of CI relationships, consisting of the following metrics which are not-
configurable:

Duplicate relationships

Relationships that have identical parent and child CIs, identical relationship type, 
and an identical port.  Duplicate relationships are displayed per relationship type. In 
a set of duplicate relationships, the duplicate relationship count is the total number 
of duplicate relationships in the set, minus one. The detailed graphs for a duplicate 
set of relationships display all the relationships in the set.

Orphan relationships

A relationship that is missing either a parent CI, a child CI, or both.

Stale relationships

A relationship in which the parent CI or the child CI is a stale CI.

A single relationship can fail more than one health test. For example, a duplicate relationship can 
also be stale.

Also reports the following relationship-related summaries:

• Relations not compliant with suggested relations

• Relations not compliant with containment rules

• Relations not compliant with hosting rules

Related topics

CMDB Health system properties

Configure KPI and metrics aggregation preferences

Configure CMDB Health scorecard thresholds

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

620



CMDB Health dashboards

CMDB dashboards display CMDB health reports and let you configure the CMDB health KPIs 
and metrics that CIs are evaluated for.

Dashboard Use

CMDB Dashboard

Configuration  > CMDB Dashboard  > CMDB 
View

Main CMDB health dashboard:

• Overall CMDB and class level aggregated 
CI health. Aggregation is displayed from the 
metric level up to the overall CMDB level.

• Aggregated health for CI relationships, and 
its metrics.

• Displays the tasks that were generated for 
CIs that failed a health test.

• Drill down for each KPI to a detailed report of 
associated metrics, broken by class.

• Manage the CMDB Health Dashboard jobs.

Video: CMDB Health dashboard

CI Dashboard

<CI form>  > Dashboard

Health reports at the CI level:

• Pass/fail results for each metric, per CI.

• Displays incidents, changes, and other 
tasks affecting the CI, and business services 
affected by the CI.

CI Class Manager

Configuration  > CI Class Manager

Central location to manage CI classes and to 
configure CMDB health settings:

• Configure scorecard thresholds of all KPIs 
and associated metrics.

• Configure weight of KPIs and associated 
metrics in health aggregation.

• Manage rules and definitions that are used 
for health tests, such as orphan rules, audit 
certificates, and recommended fields rule.

• Explore the class hierarchy.

• Update and extend a CI class.

• Delete all records for a class.

CMDB Health Preferences

Configuration  > Health Preferences

Central location for configuring CMDB Health 
settings:

• Configure CMDB Health preferences.

• Manage the CMDB Health Dashboard jobs.

• Activate and configure weighted averages 
for KPIs and metrics.
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Dashboard Use

• Set the maximum failure threshold for the 
KPIs.

• Configure creation of tasks for failed CIs.

CMDB Service Dashboard

Configuration  > CMDB Dashboard  > Service 
View

Main CMDB service health dashboard:

• Overall service aggregated health and 
detailed health for CIs per service. 
Aggregation is displayed from the metric 
level up to the overall services level.

• Displays the tasks that were generated for 
CIs in a service that failed a health test.

• Drill down for each KPI to a detailed report of 
associated metrics, broken by class.

• Manage the CMDB Health Dashboard jobs.

CMDB Group View Dashboard

Configuration  > CMDB Dashboard  > Group 
View

Main CMDB groups (whose type is Health) 
dashboard:

• Overall CMDB health groups aggregated 
health and detailed health for CIs in the 
group. Aggregation is displayed from the CI 
level up to the overall group level.

• Drill down for each KPI to a detailed report of 
associated metrics, broken by class.

• Manage the CMDB Health Dashboard jobs.

View CMDB health reports

The CMDB dashboard serves as a central location to view aggregated health reports for your 
CMDB at a glance which helps you understand the CMDB health status. Also, it provides 
functions to address health issues, and improve CMDB health.

The CMDB dashboard requires some configuration before it can display meaningful data. Once 
CMDB Health is configured and the CMDB Health Dashboard Jobs are enabled, the dashboard 
displays data that is automatically collected and calculated on a recurring schedule. The CMDB 
dashboard uses the Performance Analytics framework for dashboards and employs some of the 
capabilities it provides. The CMDB dashboard is domain aware.

Using the CMDB dashboard requires the asset or itil role.

For information, see:

• Sharing responsive dashboards (Sharing), see Share a responsive dashboard .

Note: 
Only users with the itil role can view a CMDB dashboard which has been shared.

• How score cards in CMDB Health dashboards are calculated, see CMDB Health Dashboard 
Score Card Explained [KB0829828] .
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Access and configuration

Access the CMDB dashboard by navigating to Configuration  > CMDB Dashboard  > CMDB 
View. On the CMDB dashboard:

• Click CMDB Health Dashboard Jobs  to enable and manage the jobs that monitor and collect 
health data for CIs and CI relationships.

• Click the default CMDB Dashboard - CMDB View  dashboard to list additional CMDB drill-in 
dashboards.

The CMDB dashboard has two viewing modes. Click CI Health  or Relationship Health  to toggle 
between them.

CMDB Health view

The CMDB Health view is the default view for the CMDB dashboard which contains:

• Scorecards detailing the overall health of CIs in your CMDB, per health KPI and metric

• Useful reports showing a breakdown of any duplicate, orphan, or stale CIs by class

• Widgets that list the top 10 incident, alert, and change generating CIs in the CMDB

All the default widgets in the CI Class view can be filtered using the CMDB class hierarchy tree. 
Initially, the class hierarchy filter is set to the root class, Configuration Item (All). Click All  to select 
a different class, filtering all widgets on the dashboard to display data only for the selected class 
and its child classes.

In each scorecard widget, the horizontal bar in the center and the % number are correlated, 
displaying the aggregated health summary for the KPI. Health results of associated metrics are 
displayed underneath, each contributing according to the configuration of the metric scorecard, 
and its threshold.

Except for the Overall health scorecard, you can drill into any widget in the CI Class view:

• In a scorecard widget: Click the large aggregated percent number or the health bar to drill into 
a more detailed dashboard for that KPI.

• In a charts widget: Click a bar to display a list of all the records that the bar represents.

• In lists: Click the ‘i’ icon to view a list of all the tasks or alerts related to the CI.

For more details about the CMDB Health dashboard, see the CMDB Health Dashboard Score 
Card Explained  knowledge base article.

Relationship Health view

The Relationship Health view displays various scorecards for health indicators of CI relationships 
in your CMDB. It contains charts detailing any duplicate, orphan or stale relationships, broken 
down by relationship type. You can drill down these charts for further details.

Changing the CI Class selection while in the Relationship view has no effect on the data 
displayed in this view.

Color codes

Both, the CI class view and the relationship view, use color codes when displaying aggregated 
health status. The status definitions are based on each scorecard’s threshold limits that are 
defined in the CI Class Manager.
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Color code Definition Default threshold setting

Green Best Less than or equal to 33

Orange At risk More than 33 and less than or 
equal to 67

Red Critical More than 67

Gray Incomplete N/A

Note: 

The  icon indicates that the maximum failure threshold for the scorecard has been 
reached. The tests for the metric are halted for this cycle, and all associated aggregated 
summaries are 0%. Review the scorecard rules which might be ineffective, or the CMDB 
might be in an unstable state.

Dashboard layout configuration

The CMDB dashboard uses some of the capabilities that Performance Analytics provides for 
responsive dashboards. You can, for example, add or remove widgets from the layout.

For information about adding a widget (Add Widgets) and changing other layout settings 
such as adding a tab (Create Tab) to the dashboard, see Edit a dashboard . The drop-down 
that appears when adding a widget, includes CMDB-related widgets that are used in CMDB 
dashboards and other system widgets which are typically not relevant in CMDB reports.

Domain separation

If the Domain Support — Domain Extensions Installer plugin is activated, then the CMDB 
dashboard is domain aware:

• The CMDB dashboard aggregates and reports health failures and scores based on user’s 
domain visibility of CIs. If domain visibility lets a user see a CI, then the audit rule in that user’s 
domain applies to that CI, whether the CI is in the user's domain or in a contained domain. If a 
CI fails health tests from different user domains, then separate failure records are created.

• Users can configure KPI and metric settings specific to the needs in their domain. So different 
domains can have different settings such as active/inactive, and thresholds.

• A child domain derives its immediate parent's domain health configurations if the child domain 
does not configure its own. A child domain can override parent's configurations by modifying 
them.

Related topics

CMDB Health Dashboard for Helsinki | Overview

Working with responsive dashboards

View services health reports

The CMDB service dashboard serves as a central location to view aggregated health reports 
for services at a glance. Also, it lets you drill into a service to perform remediation actions that 
address health issues, and that improve CMDB health. The CMDB service dashboard uses the 
Performance Analytics framework for dashboards and employs the capabilities it provides.
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Requirements

• The Event Management and Service Mapping Core plugin must be activated.

• Role required: asset or itil.

Configuration

The CMDB service dashboard requires some configuration before it can display meaningful 
data, using the same settings as the CMDB dashboard. The CMDB service dashboard uses the 
settings for the Business Service, Manual Service, and Technical Service 
classes. For each CI that is included in a service, the rule settings of its respective class are 
applied. You can customize these settings in the CI Class Manager, and on the CMDB Health 
Preferences page. Once CMDB Health is configured and the CMDB Health Dashboard Jobs 
are enabled, the CMDB service dashboard displays data that is automatically collected and 
calculated on a recurring schedule.

Note: 
The CMDB service dashboard doesn’t include all services from the Service 
[cmdb_ci_service] table. Only services from the cmdb_ci_service_auto table 
and its descendants (cmdb_ci_service_discovered, cmdb_ci_service_manual, 
cmdb_ci_query_based_service), are included.

The glide.cmdb.services_hierarchy_limit  system property limits the number of service CIs that 
appear in the CMDB service dashboard. This limit applies to any child class of the Application 
Services [cmdb_ci_service_auto] class and is set to 10,000 by default.

Domain separation

CMDB Health is domain aware. If domain separation has been activated, then the CMDB service 
dashboard displays health based on data, rules, and settings from the logged-on user domain. 
If rules and settings are not defined for a child domain, then the parent’s settings are applied, 
recursively.

Access

Access the CMDB service dashboard by navigating to Configuration  > CMDB Dashboard  > 
Service View.

Report details

The CMDB service dashboard displays aggregated health for services, and also details for 
individual services. For a specific service, the CMDB service dashboard displays aggregated 
health for all the CIs in that service, including the service CI itself. Also it provides useful reports 
about service classes such as the Business Service  class. You can drill down those reports 
to display further details of duplicate, orphan, or stale CIs per service and lists of the top 10 
incident, alert, and change generating CIs in the service.

All default widgets can be filtered using the CMDB service hierarchy tree. Initially, the service 
hierarchy filter is set to Business Service. Click Business Service  to expand it and to select a 
different class, filtering all widgets on the dashboard to display data only for the selected class, 
its child classes, or services of that class.

In each scorecard widget, the horizontal bar in the center and the % number are correlated, 
displaying the aggregated health summary for the KPI. Health results of associated metrics are 
displayed underneath, each contributing according to the weight configuration of the metric 
scorecard, and its threshold.
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With the exception of the Overall health scorecard, you can drill into any widget in the service 
dashboard:

• In a scorecard widget: Click the large aggregated percent number or the health bar to drill into 
a more detailed dashboard for that KPI.

• In a charts widget: Click a bar to display a list of all the records that the bar represents.

• In lists: Click the ‘i’ icon to view a list of all the tasks or alerts related to the CI.

Color codes

The CMDB service dashboard uses color codes when displaying aggregated health status. The 
status definitions are based on the threshold limits for each scorecard, defined in the CI Class 
Manager.

Color code Definition Default threshold setting

Green Best Less than or equal to 33

Orange At risk More than 33 and less than or 
equal to 67

Red Critical More than 67

Gray Incomplete N/A

The  icon indicates that the maximum failure threshold for the scorecard has been reached. 
The tests for the metric are halted for this cycle, and all associated aggregated summaries 
display 0%.

Related topics

View CMDB health reports

View CMDB groups health reports

View CMDB groups health reports

The CMDB group view dashboard serves as a central location to view aggregated health reports 
for CMDB groups at a glance. Also, it lets you drill into a CMDB group to perform remediation 
actions that address health issues, and that improve CMDB health. The CMDB group view 
dashboard uses the Performance Analytics framework for dashboards and employs the 
capabilities it provides.

Configuration

The CMDB group view dashboard requires some configuration before it can display meaningful 
data, using the same settings as the CMDB dashboard. For each CI that is included in a CMDB 
group, the rule settings of its respective class are applied. You can customize these settings 
in the CI Class Manager, and on the CMDB Health Preferences page. Once CMDB Health 
is configured and the CMDB Health Dashboard Jobs are enabled, the CMDB group view 
dashboard displays data that is automatically collected and calculated on a recurring schedule.

CMDB Health is domain aware. If domain separation has been activated, then the CMDB group 
view dashboard displays health based on data, rules, and settings from the logged-on user 
domain. If rules and settings are not defined for a child domain, then the parent’s settings are 
applied, recursively.

Role required: asset or itil.
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Access

Access the CMDB group view dashboard by navigating to Configuration  > CMDB Dashboard  > 
Group View. Then, select a CMDB group from the CMDB Health Group List  drop-down list.

Report details

For each CMDB group, the CMDB group view dashboard displays aggregated health for all the 
CIs in that group. You can drill down those reports to display further details of duplicate, orphan, 
or stale CIs per CMDB group. In each scorecard widget, the horizontal bar in the center and the 
% number are correlated, displaying the aggregated health summary for the KPI. Health results 
of associated metrics are displayed underneath, each contributing according to the weight 
configuration of the metric scorecard, and its threshold.

With the exception of the Overall health scorecard, you can drill into any widget in the CMDB 
group view dashboard:

• In a scorecard widget: Click the large aggregated percent number or the health bar to drill into 
a more detailed dashboard for that KPI.

• In a chart widget: Click a bar to display a list of all the records that the bar represents.

• In lists: Click the ‘i’ icon to view a list of all the tasks or alerts related to the CI.

Color codes

The CMDB group view dashboard uses color codes when displaying aggregated health status. 
The status definitions are based on the threshold limits for each scorecard, defined in the CI 
Class Manager.

Color code Definition Default threshold setting

Green Best Less than or equal to 33

Orange At risk More than 33 and less than or 
equal to 67

Red Critical More than 67

Gray Incomplete N/A

The  icon indicates that the maximum failure threshold for the scorecard has been reached. 
The tests for the metric are halted for this cycle, and all associated aggregated summaries 
display 0%.

Related topics

Configure CMDB groups scorecard thresholds

View CMDB health reports

View services health reports

View CI health

The CI dashboard is a central location displaying health report for an individual CI, history of 
changes to the CI in a timeline view, and the relation formatter. The CI dashboard also displays 
incidents, changes, and other tasks affecting the CI, and business services affected by the CI. 
You can access the CI dashboard from a CI form, or from the CMDB dashboard.
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Before you begin
Role required: asset or itil

About this task
The health scores are based on settings of CMDB Health KPIs and metrics. The report is 
calculated in real-time from data stored in health-related tables which the CMDB Dashboard jobs 
update on a recurring schedule. The completeness and correctness KPIs are always up to date, 
but for other KPIs, it is possible that updates to the CMDB are not reflected because one of the 
dashboard jobs hasn’t run yet, as follows:

• Compliance: Depends on audit cycles and on the 'CMDB Health Dashboard - Compliance 
Score Calculation' job.

• Relationships: Depends on the 'CMDB Health Dashboard - Correctness Score Calculation' job.

To ensure that the latest updates to these KPIs are reflected on the CI dashboard, navigate to the 
respective dashboard job, and click Execute Now.

Procedure

1. Go to a dashboard in one of the following ways:

◦ On a CI form click Dashboard.

◦ Use the class hierarchy:

a. Navigate to CMDB Dashboard  > CMDB Health.

b. Click CMDB Dashboard - All  to display the class hierarchy. Enter a search string.

c. Select a CI from the Configuration Items  group.

The search results are grouped by Classes  and Configuration Items  that match the search 
string.

2.

Result
Various widgets in the report display CI's health with the following color codes:

• Green: The CI passed the health test (for example, it is not a duplicate).

• Red: The CI failed the health test (for example, it is a duplicate)

• Grey: The CI was not tested for this metric, because the threshold was not set for the CI (class) 
in the CI module.

The report displays the change history for the CI in a timeline format, that you can zoom in or out 
to select a time period for which to display details for. Use the related lists tabs Change, Incident, 
Task, Business Services, and Alerts  to further drill into additional details.
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Note: 

Missing rules or other class definitions can prevent some health scores from being 
evaluated for a CI. The results in the CI dashboard in these situations, are described below:

Duplicate

• If no identification rules ([cmdb_identifier]) are defined for the CI’s class or 
its ancestors: A notification to that effect appears.

• If only dependent identification rules are defined: Not applicable 
notification appears.

Orphan

• If the CI is excluded by health inclusion rules: Not applicable 
notification appears.

• If no orphan rules ([cmdb_health_orphan_rule]) are defined for the CI’s class 
or its ancestors: A notification about missing a rule appears.

Staleness

• If the CI is excluded by health inclusion rules: Not applicable 
notification appears.

• If no staleness rules ([cmdb_health_staleness_rule]) are defined for the CI’s 
class or its ancestors: A notification about missing a rule appears.

Audit

• If no audits ([cert_audit]) are defined for the CI (CI dashboard checks 
only desired states and scripted audits): Not applicable  notification 
appears.

• If there are audits defined for the CI but the audits did not run: Not 
applicable  notification appears.

Related topics

Enable and configure a CMDB Health Dashboard job

Timeline of CI changes

CI relations formatter

Customize the CI dashboard

You can add, remove or re-arrange content on the CI dashboard to display the CI health statistics 
that are important to you.

Role required: itil_admin

On a CI form click Dashboard  and customize the CI dashboard as follows:

• Drag a tile near its upper edge and drag it to a different location on the dashboard to rearrange 
the current layout.

• Click the X in the upper right side of a widget to hide the widget.

• Click the + sign in the upper left corner of the dashboard to add content. In the Add content 
dialog box, select the content to add and the location to place it.
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• Click the gear icon in a widget tile to edit widget settings such as title and height.

• Click Reset to Default  to revert to the base system settings.

View CI relationships health

View aggregated orphan, stale, and duplicate CI relationships in the CMDB dashboard. You can 
configure the relationship scorecards, but you cannot configure the underlying relationship KPI 
health tests.

Before you begin
The CMDB Health Dashboard - Relationship Compliance Processor dashboard job must run to 
generate data for these reports.
Role required: itil or asset

About this task
CMDB Health measures CI relationship health using a separate KPI and metrics.

Orphan relationship

A relationship that is missing parent, child, or relationship type.

Duplicate relationship

Relationships that have identical parent, child, and relationship type.

Stale relationship

A relationship in which one of the CIs is stale. For a stale CI — its associated 
relationships are also stale.

In addition, the following relationship compliance reports are available:

Relationships not compliant with all relationship rules

Relationships that do not comply with any relationship governance  rule, including 
suggested relationships and dependent relationship rules.

Relationships not compliant with suggested relationships

Suggested CI relationships  are used as rules to test if relationships comply with 
specified suggested relationships.

Relationships not compliant with containment rules

Containment rules are used to test if relationships comply with specified 
containment relationships.

Relationships not compliant with hosting rules

Hosting rules are used to test if relationships comply with specified hosting 
relationships.

For each of the compliance reports, testing a relationship requires a rule (suggested relationship, 
hosting rule, or containment rule) in which the parent and child CI classes match the parent and 
child CI classes in the tested relationship. If the relationship types in the rule and in the tested 
relationship do not match, then the relationship is not in compliance. If an applicable rule is 
not found, then the relationship is considered to be in compliance. Rules apply to the classes 
specified in the rule, and also to descendant classes. Therefore, when testing a relationship, 
rules that apply to ascendant parents of the CIs in the tested relationship are used. If there are 
multiple rules that match the parent and the child CI classes of the tested relationship, then the 
tested relationship needs to satisfy only one of these rules to be in compliance.
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Procedure

1. Navigate to All  > Configuration  > CMDB Dashboard  > CMDB View.

2. Select the Relationship Health  tab.

3. Scroll to the bottom of the page to examine the relationship compliance reports.
Report results are grouped by relationship type, and you can drill down for further details:

◦ Point to a relationship type to display its label and the % of relationships that are not in 
compliance.

◦ Click on a relationship type to drill down to a detailed list of all the relations of that type that 
are not compliant. Click on a specific relationship to display more details such as the failure 
description. The Failure Description  field lists only a single rule that the relationship did not 
comply with, even if there are additional rules that the relationship fails to comply with.

What to do next
For troubleshooting information, see the How to identify and delete duplicate CMDB CI 
Relationship records, or ones that have orphan or missing parent/child relationships 
[KB0780988]  knowledge base article.

Related topics

Enable and configure a CMDB Health Dashboard job

Create CMDB remediation rule

A CMDB remediation rule is associated with a task that was created for a failed CMDB health 
test. A CMDB remediation rule is applied automatically or manually to execute a remediation 
workflow that can, for example, delete stale CIs.

Before you begin
You must first create and publish a remediation workflow that addresses the CI issue, stored in 
the Workflow [wf_workflow] table. The workflow can be a regular workflow or an Orchestration 
workflow, and must adhere to the following requirements:

• The table in the workflow must match the task type in the remediation rule.

• The workflow isn't configured with any filter conditions by setting If condition matches  to 
None, so that the filters of the CMDB remediation rule will apply.

For more information about Flow Designer (previously Workflow), see Flow Designer .

Role required: itil_admin (on top of itil)

Procedure

1. Navigate to All  > Configuration  > CMDB Remediations.

2. Select New  and then fill out the CMDB Remediation Rule form.

Field Description

Name Remediation name.

Task type Type of CMDB health-related tasks to apply 
the remediation to.

Task filter Filters tasks to apply remediation to. Also 
applies dot-walking  on CI fields so that 
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Field Description

remediation is applied to tasks associated 
with matching CIs.

Execution ◦ Manual: Remediation is applied manually.

◦ Automatic: The workflow is applied once, 
upon the creation of a task that matches 
the Task type  and Task filter.

Active Allowing the workflow to run.

Workflow The CMDB remediation workflow (regular or 
Orchestration) that will execute automatically 
or manually, depending on the Execution 
setting. You can click the Lookup using list 
icon, and then click New  to create a new 
workflow.

3. Select Submit.

Result
If Execution  is set to Automatic, then the business rule Run remediations for 
CMDBHealth task  applies the remediation workflow to CIs that match the Task filter. If 
Execution  is set to Manual, then you can manually apply the remediation workflow defined in the 
rule.

Related topics

Dot-Walking

Apply CMDB remediation

Manually initiate a workflow to remediate a CI that failed a CMDB health test. For example, you 
can remediate CIs that are orphan or stale.

Before you begin
Role required: itil_admin

To manually apply a CMDB remediation, a CMDB remediation rule must exist, in which Execution 
is set to Manual.

About this task
Except for the duplicate and audit health metrics, you can choose to create tasks for health test 
failures for a metric.
To remediate failures of the duplicate metric, use de-duplication tasks.

For all metrics except for audit, each CI that failed a metric test is associated with a single task. 
Because a CI can fail multiple audits, a single CI can be associated with multiple audit tasks. The 
first of those tasks is in the Task  field, and any additional tasks are in the Additional Tasks  field. 
To remediate failures of the audit metric, refer to the audit tasks for the audits that the CI failed.

Procedure

1. Navigate to All  > Configuration  > CMDB Dashboard, and then click CMDB View, Service 
View, or Group View.

2. Click on one of the bars in a bar chart on the page.
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Or, click on a metric tile that is associated with the remediation that you want to apply, and then 
in a detailed report click on a bar in a bar chart. For example, to remediate an orphan CI, click 
the Completeness  tile.

3. In the Task  column in the CMDB Health Results  list, select the task that is associated with the 

CI that you want to remediate. Point to the information icon ( ) for a result record to display 
the CMDB Health Results dialog box with more details about the health test.
The CMDB Health Results list contains records only for the CIs that failed a metric test.

Field Column

CI The CI associated with the test results.

Class Name The CI’s class.

Description Details about the reasons for the CI failing the 
metric test.

Last Evaluated On Time that the CI was evaluated for the metric, 
and which resulted in failure.

Metric The CMDB Health metric associated with this 
test result.

Source Source of the health test failure:

◦ CMDB Health Audit: Corresponds to the 
dashboard

◦ Cloud discovery

Task The task associated with the health test 
failure. For the audit metric, if there are 
multiple failures, then only the first task is 
listed.

Additional Tasks If there are multiple tasks related to the audit 
metric, contains all tasks other than the first 
which is in the Task  field.

Active Used internally in combination with the To 
Delete  field to determine the correct results 
set that this failure belongs to.

To Delete Used internally in combination with the 
Active  field to determine the correct results 
set that this failure belongs to.

4. On the task form, click Remediate.

5. In the Run Remediations  dialog box, select the remediation rule that you want to apply.
The list of remediation rules is based on the type of health metric (such as orphan, stale), and 
on the filter defined in the rule.

6. Click Execute.

Related topics

Create CMDB remediation rule
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Components installed with CMDB Health

Several types of components are installed with CMDB Health (included in the com.snc.cmdb 
plugin), such as tables, properties, and scheduled jobs.

Note: 
The Application Files table lists the components that are installed with this application. 
For instructions on how to access this table, see Find components installed with an 
application .

Properties installed

Property Description

glide.cmdb.services_hierarchy_limit Maximum number of service CIs that can appear in the 
CMDB service dashboard. This limit applies to any child 
class of the Application Services [cmdb_ci_service_auto] 
class.

• Type: integer

• Default: 10,000

• Range: 0-100,000

• Location: Add to System Properties [sys_properties]
table.

• Learn more: View services health reports

Scheduled jobs installed

Scheduled job Description

CMDB Health 
Dashboard - 
Completeness 
Score 
Calculation

Script for calculating the completeness KPI of CMDB health.

CMDB Health 
Dashboard - 
Compliance 
Score 
Calculation

Script for calculating the compliance KPI of CMDB health.

CMDB Health 
Dashboard - 
Correctness 
Score 
Calculation

Script for calculating the correctness KPI of CMDB health.

CMDB Health 
Dashboard - 
Relationship 
Score 
Calculation

Script for calculating the CI relationships KPI of CMDB health.
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Scheduled job Description

CMDB Health 
Dashboard - 
Relationship 
Compliance 
Processor

Script for calculating compliance of relationships with suggested 
relationships, and with hosting and containment rules.

Add Identifier 
Fields In 
Recommended 
Rules

Sets all criterion attributes from all active identifier entries from all active 
identification rules, as recommended fields. These added recommended 
fields are then checked by the CMDB Health Dashboard - Completeness 
Score Calculation scheduled job when evaluating the recommended health 
metric.

Remove 
Identifier 
Fields In 
Recommended 
Rules

Identifies any recommended field that is a criterion attribute in any 
active identifier entry in any active identification rule. Then removes the 
recommended setting for that field.

Tables installed

Table Description

CMDB Health Metric

[cmdb_health_metric]

Details such as if a KPI or metric is enabled, maximum failure 
threshold, and other settings for all CMDB Health KPIs and 
metrics.

CMDB Health Result

[cmdb_health_result]

Results from the most recent CMDB Health processing 
cycle.

CMDB Health Scorecard

[cmdb_health_scorecard]

Current and historic health scores. Status of historic score 
records is 'Historic', and of latest score records is 'Complete’.

CMDB Health Orphan Rule

[cmdb_health_orphan_rule]

Rules for calculating orphan records per class.

CMDB Recommended Fields

[cmdb_recommended_fields]

Recommended fields per class.

CMDB Health Metric Status

[cmdb_health_metric_status]

Internal table that tracks the status of each KPI and metric 
that is being processed. Includes status, processing time, 
and processing start date.

State for a KPI or metric changes from 'In Progress' to either 
of:

• Complete

• MaxFailures

• Daily Processing Time Out

Processing of a timed out KPI or metric continues on the 
following day.
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Table Description

CMDB Health Processor Status

[cmdb_health_processor_status]

Internal table that tracks the processing progress of each 
KPI and metric. Contains a list of tables that are processed 
for each KPI and metric, and processing status. Classes are 
processed sequentially, changing status from Draft -> In 
Progress -> Complete.

CMDB Relationship All Rules 
Health Results

[cmdb_health_result_rel_all]

Stores results about relationship health, to be used by the 
All Relationships report.

CMDB Health process tracking

Use the following information to track and resolve issues with the CMDB Health processes.

Logging

By default, only error messages are logged to the syslog table, with the source name 
CmdbHealth. To enable logging of 'info' and 'warning' messages (which are typically 
logged at the start and end of each processing cycle), update the system property 
glide.cmdb.logger.use_syslog.CMDBHealth. For information about using this property, see CMDB 
Health system properties.

Processing status

If scheduled jobs are enabled, but data is not displaying on the CMDB dashboard, you can 
check the processing status in the CMDB Health Metric Status [cmdb_health_metric_status] 
table. Depending on the status of the inactive  metric, decide how to proceed.

Initially, the state of all metrics is 'In Progress'.

Possible final states of a metric:

Complete

All classes are processed and the number of failures is under the maximum failures 
threshold.

Max Failures

The number of failures for this metric reached the maximum failures threshold. 
Processing has been aborted and will start over in the next run.

Daily Time Out Pause

The processor reached the processing time limit. Processing is paused and will 
resume in the next run.

At the end of a processing cycle, the final state of a KPI depends on the final state of its 
associated metrics. Possible final state of a KPI:

Complete

All associated metrics are in Complete state and score calculation is complete.

Incomplete

Score is not calculated because one of the associated metrics reached its 
maximum failure thresholds.

Daily Time Out Pause
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Timed out because one of the associated metrics has reached its processing time 
limit.

Processing time

If processing of a metric times out, you can find out which class takes too long to process. Use 
this information to find out if any validation rules are weak.

The progress of each metric is tracked in the CMDB Health Processor Status table 
[cmdb_health_processor_status]. Status for classes that have been processed for a metric is 
Complete, and for classes that are yet to be processed is Draft. By looking at the update time for 
each class, you can calculate the length of processing time for each class.

Orphan records due to broken hierarchy

Orphan rules might detect an orphan CI, which you are not able to access and delete. Or, there 
might be a mismatch between the list view that displays the orphan records, and the total 
number of records. These findings are due to records being deleted in the database from only 
one table in the CMDB hierarchy.

These CI records are not accessible via GlideRecord and must be deleted directly from the 
database. Therefore, in this case, to delete an orphan CI from the database you must contact 
Support to get help.

Orphan test results provide the details of where exactly the hierarchy is broken. For example, 
the message "This cmdb_ci_linux_server CI [91054fc24f22520053d6e1d18110c713] is missing 
record in cmdb_ci_computer table" means that a record of that sys_id must be deleted from the 
CMDB, cmdb_ci, cmdb_ci_hardware, cmdb_ci_server, and the cmdb_ci_linux_server tables (the 
Computer class is between the Hardware and the Server classes in the hierarchy.)

Scripted audits Skipped

An error message is logged if the results from a scripted audit are not included in the compliance 
KPI. The reason can be that the script in the audit was not updated to populate its Last ran date 
field. Without a Last ran date  value, CMDB Health is unable to identify these run results as part of 
a recent complete audit run, and skips those results.

CMDB Health process status: failure threshold reached

The CMDB dashboard displays the string ‘failure threshold reached' when the number of CIs that 
are failing the metric tests, reaches the failure threshold set for the metric.

CMDB Health stops processing for this metric in the current cycle, and therefore there is no 
aggregated health score for the metric. Processing will be attempted again in the next cycle. 
Also, status in the CMDB Health Metric Status [cmdb_health_metric_status] table is set to Max 
Failures  for this metric.

When the health score of a metric cannot be evaluated, then the processing status of the 
respective KPI (for example, correctness) is set to Incomplete. The CMDB dashboard displays 
the string Incomplete score  for the respective KPI and for the CMDB Health overall score. 
Also, aggregated health scores for the metric are not available for any class in the CMDB 
hierarchy.

Review and adjust the following definitions as needed:
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• Review and refine the rules defined for the metric which has reached max failures. If a rule 
associated with the metric is too generic, resulting in large number of failures, attempt to refine 
it as follows:

◦ Completeness:

Review the mandatory fields for the associated classes and remove those that aren't critical 
for the health score. Also, review the recommended fields that are causing failures and 
remove those that aren't critical for the health score.

For more information see Set a CI attribute to be mandatory  and Set a CI field to be 
recommended.

◦ Compliance:

Review the audit failures from the audit jobs and adjust the audits to reduce the number of 
failures. For more information, see CMDB Health KPIs and metrics.

◦ Correctness:

▪ Orphan: Review the orphan rules and adjust them to remove excessive orphan failures. 
For more information, see Create or edit a CMDB Health orphan rule.

▪ Staleness: Review the effective duration for the classes that are causing failures and 
adjust the duration to reduce the number of failures. For more information, see Create or 
edit a CMDB Health staleness rule.

▪ Duplicate: Review the de-duplication tasks and remediate the tasks to remove duplicate 
CIs and to avoid creating failure records. For more information, see Remediate a de-
duplication task (legacy).

• Increase the failure threshold  for the metric that is failing and check if processing for this 
metric completes successfully in the next cycle. Increasing the failure threshold beyond 500K 
might reduce overall performance.

CMDB Health process status: incomplete score

The CMDB dashboard displays the string 'incomplete score' for a metric when it fails to calculate 
the score for the metric.

'Incomplete score' is displayed when:

• The number of CIs that are failing the tests of one of its sub-metric, reaches the failure 
threshold set for the metric. In this situation, the processing status for the respective parent 
metric (for example, correctness) is set to 'incomplete' in the CMDB Health Metric Status 
[cmdb_health_metric_status] table. Processing for the failing metric in the current cycle stops, 
and therefore there are no aggregated health scores for the sub-metric, the parent parent 
metric, or the overall CMDB Health.

To remediate, you need to resolve the underlying cause of CIs failing the sub-metric tests. See 
CMDB Health process status: failure threshold reached  for more information about resolving 
the failures of the sub-metric.

• An error is encountered while processing the sub-metric.

To remediate, examine the system logs to determine the cause of the error. After fixing the 
cause of the problem, restart processing by manually executing the respective parent metric 
dashboard job.
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CI Class Manager

Use the CI Class Manager to centrally view, create, or edit basic class definitions, and class 
settings for identification, reconciliation, and CMDB Health. To access the CI Class Manager, 
navigate to All  > Configuration  > CI Class Manager.

Note: 
CI Class Manager doesn't support working with non-CMDB tables. For more details, see IRE 
support for non-CMDB tables.

Class Basics

• Create a class

• View class basic information

• Class columns

• Add a suggested 
relationship

• Display all CIs for a class

• Dependency Views map 
icons for a class

• Delete CIs

• Update the list of classes in 
the Principal Class filter

CMDB Health

• Create a compliance audit

• Create a certification filter

• Create a certification 
template

• CMDB Health orphan rule

• CMDB Health staleness 
rules

• Set a CI field to be 
recommended

• Set a CI attribute to be 
mandatory

• CMDB health scorecard 
thresholds

• Health inclusion rules

IRE

• Identification:

◦ CI identification rules

◦ Identification inclusion 
rules

• Reconciliation:

◦ CI reconciliation rules

◦ Data refresh rules

• Dependencies:

Dependent relationship 
rules  (hosting and 
containment)

Service Mapping

• Entry point types for Service 
Mapping

• CI types for Service 
Mapping and Discovery

CMDB CI Lifecycle Management (legacy)

From the time of its creation to the time that it is no longer needed, a CMDB CI would typically 
transition through several operational states while undergoing various operations. CI LIfecycle 
Management provides the mechanism to define states and actions for a CI and lets you apply 
appropriate actions based on a CI's state to tailor the management of CI lifecycle to business 
needs.

The CMDB Data Manager is now a more comprehensive and integrated solution for managing CI 
life cycle operations such as deletion and archival, in bulk. For information about the CMDB Data 
Manager, see Working with CMDB Data Manager.

Terms associated with CI Lifecycle Management:
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Operational states

A set of states that a CI can be at such as 'Operational' or 'Repair in Progress'. A 
CI can be associated with only a single operational state at any given time. The 
choices for operational states are based on the operational_status  field in 
the [cmdb_ci] table. There are several operational states that are defined in the base 
system such as 'Retired' and 'Repair in Progress'. You can modify this list to reflect 
operational states that are relevant in your business.

Note: 
By default, Service Mapping is configured to ignore all host CIs for which 
the value of Operational status [operational_status]  is not 1 
(Operational) or the value of status [install_status]  is 100  (absent). 
For additional information about this behavior, see Preparing customized 
ServiceNow deployments to work with Service Mapping  [KB0647574] in the 
HI Knowledge Base.

CI Lifecycle Management allows multiple operators and automations to 
simultaneously set different operational states of a CI. Since a CI cannot be 
associated with multiple operational states, it is important to configure each 
operational state with a priority. These priorities are then used in such situation to 
determine which of the operational states is the cumulative operational state.

CI actions

A set of actions that can be applied to a CI during its lifetime. You can define CI 
actions that are relevant in your business.

Compatible CI Actions

CI Lifecycle Management allows a CI to have multiple active CI actions 
simultaneously, however they must be specifically defined as compatible. By 
default, there are no two actions for a CI that are compatible with each other. You 
can change this behavior by specifying pairs of actions that are compatible and 
thus allowed to be applied simultaneously to a CI. For example, you can specify that 
the ‘Patching’ and the ‘Provisioning’ CI actions are compatible making it possible to 
apply both simultaneously to a CI.

Not Allowed CI Actions

By default, any CI action can be applied to any CI. You can restrict this behavior 
by defining a rule that an action is not allowed for a CI when it is in a specific 
operational state. For example, you can define a Not Allowed CI Action in which it 
is not allowed to apply the 'Provisioning' action to a Linux Server that is in a 'Non-
Operational' state.

Not Allowed Operational Transitions

By default, transitions are allowed from any operational state to another. You can 
restrict this behavior by defining a rule that for a specified CI, a transition from a 
certain operational state to another operational state is not allowed. For example, 
you can define that for a Linux Server it is not allowed to transition from 'Repair in 
progress' to 'Non-Operational'.

Requestor

A requestor can be a workflow or a non-workflow operator that is trying to set 
operational states and apply CI actions. Each requestor has an associated 
requestor ID that is a GUID and that can be an active workflow context or a non-
workflow registered operator ID.

Lease time

A time period that each requestor (especially non-workflow operators) can provide, 
during which a specified CI action is allowed to be active for a specified CI.
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CMDB CI Lifecycle Management provides a set of APIs to manage CI operational states and CI 
actions. And the UI where you define a set of rules to restrict certain operational state transitions 
and to restrict actions based on operational states. It also provides a mechanism to audit CI 
operational state and CI actions during the entire CI lifecycle.

Providers such as automation, workflows, or Change Management can use CI Lifecycle 
Management as a mechanism to manage CI operational states and apply CI actions. By 
default, the behavior of CI Lifecycle Management has no restrictions on some operations, 
and full restrictions on other operations. The CI Lifecycle Management UI lets you modify this 
default behavior by specifying Not Allowed CI Actions, Compatible CI Actions, and Not Allowed 
Operational Transitions that restricts some operations and enables for others.

With CI Lifecycle Management you can:

• Manage CI operational states and CI actions throughout the entire CI lifecycle.

• Manage CI operational state transitions.

• Restrict certain operational state transitions.

• Associate certain actions for certain CI types that are in specific operational state.

• Restrict IT Service Management applications based on CI operational state.

• Audit CI operational states and CI actions during the entire CI lifecycle.

Lifecycle management APIs

CI Lifecycle Management provides a set of APIs to manage CI operational state and CI actions 
during the entire CI lifecycle. All restrictions and allowances specified by rules in the UI are 
enforced when state management APIs run, and if an API attempts to perform a restricted 
operation, the operation is blocked and an error is logged.

Registering requestors

When using the lifecycle management APIs to apply CI actions, requestors are required to 
be registered and to obtain a requestor ID which is unique within the lifecycle management 
tables. To register and to obtain a requestor ID, non-workflow users should call the 
registerOperator  API. Workflow users can use the active Workflow context as the 
requestor ID, and they do not need to explicitly call registerOperator.

After completing the CI lifecycle operations, the requestor should call the 
unregisterOperator  API to unregister. All the state management records associated 
with that specific requestor ID are then marked as inactive or they are removed by the CI 
Lifecycle Management — Restore Internal State Management Tables 
scheduled job.

Integration with Incident Management  and Problem Management

A base instance includes the pre-defined CI action CreateTask  used for creating a task for 
a CI. New instances have a pre-defined Not Allowed CI Action, specifying that the 'CreateTask' 
action is not allowed for any CI with a Retired  operational state. This restriction is integrated 
with Incident Management  and with Problem Management  to prevent the creation of incident 
or problem tasks for retired CIs. The 'CreateTask' CI action is used as a reference qualifier 
to the Configuration Item  field of the Incident/Problem tables. In a new incident 
or problem, CIs in which Operational Status  is 'Retired' — are filtered out from the 
Configuration Item  list on the form. For more information about reference qualifiers, see 
Reference qualifiers  .
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Integration with Asset Management

In a base system, a CI's Operational Status  field and the Status/Hardware Status 
(if its hardware) fields are kept synchronized if one of the two fields' values is Retired. When 
Operational Status  of a CI is set to Retired, then the Status/Hardware Status 
field is automatically set to Retired. In the opposite direction, when the Status/Hardware 
Status  field of a CI is set to Retired, Operational Status  is automatically set to Retired 
too.

• When an Operational Status  field changes from Retired  to another status, the CI’s 
Status/Hardware Status  field is set to Installed.

• When a CI’s Status/Hardware Status  field changes from Retired  to another status, the 
Operational Status  field is automatically set to Non-Operational.

The change of state from 'Retired' to another state is seldom, and by default, the state is 
changed to 'Non-Operational'. However, this might not be the intended state for the record. 
Therefore, it important that administrators review and manage the state appropriately in this 
case.

Whenever CI’s Status/Hardware Status  changes, it is synchronized to the CI’s 
corresponding Asset State  field, and vice versa — keeping the CI’s Operational 
Status  and the CI’s corresponding Asset State  synchronized.

For more information about mapping Asset State  and Substate  fields to a CI's 
Status/Hardware Status  (if its hardware) field, see Map asset state and CI hardware 
status . And for more information about retiring assets, see Retire assets .

Get started with CI Lifecycle Management

Follow these high level steps to get started and to track activities of the CI Lifecycle Management 
module of the CMDB application.

Before you begin
Role required: none

Procedure

1. Activate the base system CI Lifecycle Management - Restore Internal State Management 
Tables  scheduled job that continuously checks and maintains data integrity of all internal CI 
Lifecycle Management tables.

2. Define CI actions.

3. Define compatible CI actions  rules.
Navigate to All  > Configuration  > CI Lifecycle Management  > CMDB CI Actions  to display 
currently active/inactive CI actions in the CMDB.

4. Define not-allowed CI actions  rules.

5. Define not-allowed operational state transitions  rules.

6. Define new operational states by modifying the operational_status  field in the 
[cmdb_ci] table in the system dictionary.
Navigate to All  > Configuration  > CI Lifecycle Management  > View Internal Operational 
States  to display available operational states set by each requestor.

7. Set priority for operational states.

8. Call APIs to apply CI actions.
Navigate to All  > Configuration  > CI Lifecycle Management  > CMDB CI Actions  to display 
which actions were submitted and thier active/inactive state in the CMDB.
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9. Navigate to All  > Configuration  > CI Lifecycle Management  > View CI State Registered Users 
to display currently registered operators that were registered via the registerOperator 
API.

10. Review Renew Lease tasks and extend leases as needed.
Navigate to All  > Configuration  > CI Lifecycle Management  > Renew Lease Tasks.

These tasks are created automatically by the CI Lifecycle Management - Restore 
Internal State Management Tables  scheduled job for CI action records in 
which the lease for a valid requester has expired. The Requestor should use the lifecycle 
management API ExtendCIActionLease  to extend the lease. Otherwise, if the lease 
remains expired for a specified grace period, the CI Lifecycle Management - 
Restore Internal State Management Tables  scheduled job marks the 
respective CI action record as ‘inactive'.

The grace period for expired lease time is configurable by the system property 
glide.cmdb.statemgmt.max_lease_expired_days.

11. Navigate to All  > Configuration  > CI Lifecycle Management  > State Management Logs  to 
display logs of CI Lifecycle Management operations.

Lifecycle management APIs

CI Lifecycle Management provides a set of state management APIs for manipulating CI 
operational states, and applying CI actions.

State management APIs adhere to restrictions and allowances specified by Not Allowed CI 
Actions, Compatible CI Actions, and Not Allowed Operational Transitions. If an API attempts 
to perform a restricted operation, the operation is blocked, an error is logged, and a task is 
automatically created if appropriate.

Lifecycle management APIs can set operational states and CI actions to CMDB groups by 
utilizing lifecycle management bulk APIs.

Registration APIs

• registerOperator() - Method to register operator with state management for non-workflow user.

• unregisterOperator(String requestorId) - Method to unregister operator for non-workflow users.

• isValidRequestor(String requestorId) - Method to determine if the specified requestor is a valid 
active workflow user or a registered user.

• isLeaseExpired(String requestorId, String ciSysId, String ciActionName) - Method to check if 
registered user lease expired.

• extendCIActionLease(String requestorId, String ciSysId, String ciActionName, String 
leaseTime) - Method to extend CI Action Lease time, for registered users. If previous lease 
already expired, extend lease from now.

Operational State APIs

• setBulkCIOperationalState(String requestorId, String sysIdList, String opsLabel, String 
opsStateListOld) - Method to set Operational State for an array of CIs.

• getOperationalState(String ciSysId) - Method to get CI Operational State.
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CI Actions APIs

• addBulkCIAction(String requestorId, String sysIdList, String ciActionName, String 
ciActionListOld, String leaseTime) - Method to add CI Action for an array of CIs.

• removeBulkCIAction(String requestorId, String sysIdList, String ciActionName) - Method to 
remove a CI Action for a list of CIs.

• getCIActions(String ciSysId) - Method to get CI Actions.

Not Allowed Action Based on Operational State API

isNotAllowedAction (String ciType, String opsLabel, String actionName) - Method to check if a 
specific CI action is not allowed for specific Operational State on a CI Type.

Not Allowed Operational State Transition API

isNotAllowedOpsTransition(String ciType, String opsLabel, String transitionOpsLabel) - Method 
to check if specific operational state transition is not allowed on a CI Type.

Compatible Action API

isCompatibleCIAction(String actionName, String otherActionName)- Method to check if two 
specific actions are compatible with each other.

Example: Using state management APIs

// 1. Register Operator with State Mgmt
var output = 
 SNC.StateManagementScriptableApi.registerOperator();
var jsonUntil = new JSON();
var result = jsonUntil.decode(output);
var requestorId = result.requestorId;
 
// Get list of sys_ids to update
var sys_ids;
 
// 2. Set list of sys_ids's Operational State to 'Repair in 
 Progress'
output = 
 SNC.StateManagementScriptableApi.setBulkCIOperationalState(requ
estorId, sys_ids,'Repair in Progress');
gs.print(output);
 
// 3. Set list of sys_ids's CI Action State to 'Patching'
output = 
 SNC.StateManagementScriptableApi.addBulkCIAction(requestorId, 
 sys_ids, 'Patching');
gs.print(output);

Components installed by CI Lifecycle Management

Several types of components are installed by CI Lifecycle Management (included in the 
com.snc.cmdb plugin), including tables, scheduled jobs, and properties.
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Note: 
The Application Files table lists the components that are installed with this application. 
For instructions on how to access this table, see Find components installed with an 
application .

Scheduled jobs installed

Scheduled job Description

CI Lifecycle Management - Restore 
Internal State Management Tables

Continuously checks and maintains the data integrity of 
all internal CI Lifecycle Management tables.

Update life cycle from legacy Updates CIs Life cycle stage  and Life cycle 
status  fields when legacy status fields change.

Update legacy from CSDM” Updates CIs legacy status fields when life cycle 
changes.

Tables installed

Table Description

CI State Registered Users

[statemgmt_register_users]

All currently active registered users that were created via the 
registerOperator  API. You cannot manually add new 
records to this table.

CI Actions

[statemgmt_ci_actions]

A set of CI actions that can be applied to a CI during its 
lifetime.

CMDB CI Actions

[statemgmt_cmdb_actions]

Active/inactive CI actions set by a specific requestor for a 
specific CI. You cannot manually add new records to this table.

Compatible CI Actions

[statemgmt_compat_actions]

Set of rules that define pairs of CI actions that are compatible 
for a CI and can be applied simultaneously.

Not Allowed CI Actions

[statemgmt_not_allow_actions]

Set of rules that define specific actions that are not allowed for 
a CI when its in a specific operational state.

Internal Operational States

[statemgmt_ops_state]

Internal operational states set by a specific active requestor 
for a specific CI. You cannot manually add new records to this 
table.

Renew Lease Task

[statemgmt_renew_lease_task]

Set of tasks that were automatically created to renew the lease 
of CI actions whose lease has expired. You cannot manually 
add new records to this table.

Operational State Priorities

[statemgmt_ops_state_pri]

Priorities of operational states which determine precedence 
when multiple operational states are set for same CIs by 
different requestors.

Not Allowed Operational 
Transitions

Set of rules that define specific operational state transitions 
that are not allowed.
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Table Description

[statemgmt_not_allow_ops]

Properties installed

Property Description

glide.cmdb.statemgmt.max_lease_expired_days Maximum number of days that lease 
expiration can be set with for CI Actions.

• Type: integer

• Default value: 15

• Location: System Property [sys_properties] 
table.

glide.cmdb.statemgmt.max_bulk_count Maximum number of CIs that CI Lifecycle 
Management can process in a bulk update 
operation.

• Type: integer

• Default value: 1000

• Location: System Property [sys_properties] 
table.

Activate the CI Lifecycle Management scheduled job

When starting to use the CI Lifecycle Management module, ensure to activate the CI 
Lifecycle Management - Restore Internal State Management Tables 
scheduled job which is disabled by default. This scheduled job continuously checks and 
maintains the data integrity of all internal CI Lifecycle Management tables.

Before you begin
Role required: none

About this task
When CI Lifecycle Management operations do not complete properly, for example due to a 
failure of the requestor or a requestor whose lease has expired, the integrity of tables related 
to CI Lifecycle Management might be compromised. The CI Lifecycle Management - 
Restore Internal State Management Tables  scheduled job scans tables related to 
CI Lifecycle Management, and does the following:

• De-activates or removes all internal lifecycle management records with invalid requestors, and 
closes any corresponding Renew Lease Tasks if present.

• Detects records associated with a valid requestor whose lease has expired, and automatically 
creates a Renew Lease Task to notify the user and to provide details for extending the lease. 
If the requestor takes no action and the lease remains expired for a specified grace period 
(default 15 days), automatically de-activates the corresponding CI action record, and closes 
any corresponding Renew Lease Task if present.
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Procedure

1. Navigate to System Definition, and click Scheduled Jobs.

2. Search for the CI Lifecycle Management - Restore Internal State 
Management Tables  job.

3. In the respective Active  column, double-click the value false, and select true.

4. Click the Save  icon.

Define a CI action

Define a CI Lifecycle Management CI action that can be later applied to CIs.

Before you begin
Role required: none

About this task
You can view a list of all the actions that are currently applied to CIs by navigating to 
Configuration  and clicking CMDB CI Actions.

Procedure

1. Navigate to All  > Configuration  > CI Lifecycle Management  > CI Actions.

2. On the CI Actions page, select New.

3. Enter Name  and Description.

4. Select Submit.

Define compatible CI actions

Allow a CMDB CI Lifecycle Management operation in which two specified CI actions can be 
applied simultaneously to a CI.

Before you begin
Role required: none

About this task
By default, it is not allowed to apply more than a single action to a CI. You can change that 
behavior by defining pairs of CI actions as compatible and therefore these actions can be 
applied simultaneously to a CI. For example you can specify that Provisioning and Patching are 
compatible CI actions, which lets you apply both to a CI at the same time.

Procedure

1. Navigate to All  > Configuration  > Compatible CI Actions.

2. On the Compatible CI Actions  page click New  and fill out the form.

Compatible CI Actions

Field Description

Action First action in the compatibility actions pair.

Compatible Action Second action in the compatibility actions 
pair.

Result
An API can successfully apply the two specified actions simultaneously to a CI.
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Define a not-allowed CI action

Define a restriction for CI Lifecycle Management in which a specified action is not allowed for a 
CI that is in a specified operational state.

Before you begin
Role required: none

About this task
By default, there are no restrictions in the CMDB CI Lifecycle Management on applying CI 
actions. You can restrict this behavior by not allowing a specified action to be applied to a CI 
when it is in a specified operational state. For example, you can define a restriction in which the 
provisioning action cannot be applied to a Linux Server that is in a non-operational state.

Procedure

1. Navigate to All  > Configuration  > CI Lifecycle Management  > Not Allowed CI Actions.

2. Click New  on the Not Allowed CI Actions  page, and fill out the form.

Field Description

Not Allowed Action The action that is being restricted.

CI Type The CI type for which the restriction 
applies to. To apply a rule to all CIs, select 
Configuration Item.

Operational State The operational state that the CI must be at in 
order to apply the restriction.

3. Click Submit.

Result
If an API attempts to apply the specified action to the specified CIs, while it is in the specified 
operational state, the operation fails and an error is logged.

Set priority for an operational state

CI Lifecycle Management allows multiple operators or automations to simultaneously set 
different operational states for a CI. A CI can have only a single operational state, so in this 
case, the cumulative operational state of the CI is set to the one with the highest priority. It is 
recommended that you specify a priority for each operational state that you define so that a 
cumulative state can be correctly calculated.

Before you begin
Role required: none

About this task

Procedure

1. Navigate to All  > Configuration  > CI Lifecycle Management  > Operational State Priority.

2. On the Operational State Priority  page, click the operational state for which you want to set or 
update priority.

3. Enter a Priority  and click Update.
Smaller numbers represent higher priority.
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Define a non-allowed operational transition

Define a restriction for CI Lifecycle Management in which a specified CI cannot transition from 
one operational state to another.

Before you begin
Role required: none

About this task
By default, CI Lifecycle Management has no restrictions for transitioning CIs from one 
operational state to another. You can restrict this behavior by defining transitions that are not 
allowed for a specified CI. For example, you can define a restriction on transitioning a Linux 
server from non-operational state to repair in progress state.

Procedure

1. Navigate to All  > Configuration  > CI Lifecycle Management  > Not Allowed Operational 
Transitions.

2. On the Not Allowed Operational Transitions  page, click New  and fill out the form.

Field Description

CI Type The CI type for which the restriction applies.

Not Allowed Transition The CI state into which transitioning is 
restricted.

Operational State The operational state that the CI must be in 
for the restriction to apply.

Result
If an API attempts to transition a CI that is in the specified operational state to a state that is not 
allowed, the operation fails and an error is logged.

View CMDB benchmarks

CMDB calculates several CMDB Health benchmarks which then display in the Benchmarks 
dashboard. These benchmarks are based on various CMDB Health metrics, displaying monthly 
averages, trends, comparisons to industry averages of your ServiceNow  peers, and global 
benchmarks.

Before you begin
Role required: none

The CMDB Health Dashboard jobs must be enabled and health data must be collected. 
Also, navigate to Benchmarks  > Setup  and ensure that the CMDB KPIs are enabled under IT 
Operations Management.

About this task
CMDB provides the following benchmarks:

• % of non-compliant CIs

• % of duplicate CIs

• % of stale CIs

For an instance, each of these benchmarks is the calculated monthly average for the 
corresponding CMDB Health metric. Calculating a monthly average requires that there is a 
metric result value for each day of the month. Therefore, each day on which the respective 
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Health Dashboard job did not run, is assumed with the aggregated result from the run that is 
most recent to that day. The monthly average is then calculated based on the sum of all the daily 
aggregated results for the metric in that month, divided by the number of days of the month. For 
a CMDB Health Dashboard job that ran multiple times in a single day, only the results of the last 
run in that day are used for the monthly average calculation.

Note: 
The frequency of CMDB Health Dashboard job executions depend on whether the job is 
enabled, its schedule and on manual runs.

Global averages are based on the sum of monthly averages of all peer instances, divided by the 
number of instances (aside from instances for which the monthly average is 0).

Procedure

1. Navigate to Benchmarks  > Dashboard.

2. Click the  icon and select IT Operations Management.

3. Click ALL  or CMDB.

4. Click on a CMDB benchmark to drill down to trend data, and other benchmark details.

Related topics

CMDB Health

Benchmarks

Benchmarks dashboard

CMDB APIs (CMDB SDK)

Use CMDB APIs to create, update, and read operations on the CMDB. Domain separation is 
supported in CMDB APIs.

CMDB APIs (CMDB SDK)

Use the following CMDB APIs to create, update, and read operations on the CMDB:

• CMDBGroupAPI - Scoped

• CMDBTransformUtil - Global

• CMDBUtil - Global

• IdentificationEngineScriptableApi

• IdentificationEngine - Scoped

Domain separation in CMDB APIs

Domain separation enables you to separate data, processes, and administrative tasks into 
logical groupings called domains. You can control several aspects of this separation, including 
which users can see and access data.

CMDB APIs are used for accessing the CMDB from a script. CMDB stores the CI and relation 
information; CMDB is domain separated.

CMDB APIs support the following operations:
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• Create a new CI:

This operation goes through the Identification and Reconciliation Engine which supports 
domain separation when creating a CI. The domain of the caller is used for this operation.

• Update an existing CI:

This operation goes through the Identification and Reconciliation Engine which supports 
domain separation when creating a CI. The domain of the caller is used for this operation.

• Create/Delete relations:

The cmdb_rel_ci table is not domain separated.

• Query CMDB CI/Query CMDB table:

Results are filtered by the domain(s) visible to the caller.

• Query CMDB metadata table:

Metadata information is not domain separated.

Setting up domain separation for CMDB APIs

If domain separation is enabled for CMDB, then it is also available for CMDB APIs.

Data separation

Data is stored and domain separated in CMDB. There is no additional work needed from the 
CMDB API perspective.

Configuring a domain-separated environment

The configuration is done at the CMDB level.

If a domain column is present for base system application tables

See the Domain separation in CMDB Health  topic.

Tenant domains and application data

There is no application-specific data to manage with CMDB.

Related topics

Domain separation and Configuration Management Database (CMDB)

Quick start tests for Configuration Management Database (CMDB)  (CMDB)

Validate that Configuration Management Database (CMDB)  still works after you make any 
configuration change such as apply an upgrade or develop an application. Copy and customize 
these quick start tests to pass when using your instance-specific data.

Configuration Management Database (CMDB)  quick start tests require activating the 
Configuration Management (CMDB) plugin (com.snc.cmdb) and the CMDB  - ATF Tests plugin 
(com.snc.cmdb.atf).
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CMDB BSM: Dependency Views test suite
Test suite to check functionality of Dependency Views APIs.

Test Description Release version

CMDB BSM: Dependency 
Views

Test functionality of 
Dependency Views APIs. 
These APIs retrieve 
Dependency Views map and 
associated map items such 
as context menu items, for a 
given CI sys_id and using itil 
user role.

New York

CMDB HEALTH: CI Health Dashboard test suite
Test suite to check whether CMDB CI Health Dashboard is functional at a basic 
level.

Test Description Release version

CMDB HEALTH: Health Job 
Status

Checks whether any CMDB 
Health dashboard jobs, which 
were started 30 or more days 
ago, are still in progress.

New York

CMDB HEALTH: CMDB 
Health Completeness/ 
Recommended

Checks whether the CI 
dashboard is functional for 
the recommended metric 
(included in the CMDB Health 
completeness KPI).

This test validates:

• Creation of a health 
inclusion rule for the 
recommend metric.

• Creation of a recommended 
field that satisfies the health 
inclusion rule.

• Validate that the health 
inclusion rule is correctly 
applied to a test record 
with missing data in the 
recommended field.

New York

CMDB IRE: Identification Reconciliation Engine test suite
Test suite to check Identification and Reconciliation Engine (IRE) functionality.

Test Description Release version

CMDB IRE: IRE Validation Validate CI identifiers and 
reconciliation definitions 

Madrid
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CMDB IRE: Identification Reconciliation Engine test suite
Test suite to check Identification and Reconciliation Engine (IRE) functionality.

(continued)

Test Description Release version

and check indexes for CI 
identifiers.

CMDB IRE: Reconciliation 
Rule Check operations on a 

reconciliation rule, in CI 
Class Manager, using itil and 
itil_admin roles. Operations 
include create, edit, and 
delete a reconciliation rule.

Also, check for active and not 
active setting, and derived 
rules.

Paris

CMDB IRE: Identification Rule
Check operations on an 
identification rule, in CI 
Class Manager, using itil and 
itil_admin roles. Operations 
include create, edit, and 
delete an identification rule.

Also, check for active and not 
active setting, and derived 
rules.

Paris

CMDB QB: Query Builder test suite
Test suite to verify CMDB Query Builder functions such as create query, read 
query, and execute query using two related user roles - cmdb_query_builder 
and cmdb_query_builder_read.

Test Description Release version

CMDB QB: Query Builder - 
cmdb_query_builder Role

Verify that 
cmdb_query_builder user role 
can save queries, and access 
and run all saved queries, in 
CMDB Query Builder.

New York

CMDB QB: Query Builder - 
cmdb_query_builder_read 
Role

Verify that 
cmdb_query_builder_read 
user role can access and run 
all saved queries, and cannot 
save any query, in CMDB 
Query Builder.

New York
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CMDB REL: Relationship Editor and Formatter test suite
Test suite to verify functionality of Relationship Editor and Relationship 
Formatter.

Test Description Release version

CMDB REL 
EDITOR:Relationship Editor

Check addition of relations to 
a CI and deletion of relations 
from a CI using itil user role.

New York

CMDB REL 
FORMATTER:Relationship 
Formatter

Check accuracy of CI 
information, relationship 
types, relationships, 
associated records such 
as change tickets, and 
settings such as CMDB views 
(relationship filters), displayed 
for a specific CI in relationship 
formatter using itil user role.

New York

CMDB SDK: SDK REST API test suite
Test suite to verify functionality of CMDB SDK Rest APIs.

Test Description Release version

CMDB SDK: Query CMDB 
Metadata

Test querying CMDB 
metadata.

New York

CMDB SDK: Create a relation 
for a CI using REST APIs

Test creation of a relationship 
for a CI in the CMDB using the 
CMDB REST APIs.

New York

CMDB SDK: Delete a relation 
for a CI using REST APIs

Test deletion of a relationship 
for a CI using CMDB REST 
APIs.

New York

CMDB SDK: Create a CI using 
REST API

Test creation of a CI using 
CMDB REST APIs.

New York

CMDB SDK: Query CMDB 
using REST APIs

Test querying the CMDB using 
CMDB REST APIs.

New York

CMDB SDK: Update a CI using 
REST APIs

Test updating of a CI using 
CMDB REST APIs.

New York

CMDB SDK: Query for a CI 
using REST APIs

Test querying a CI using 
CMDB REST APIs.

New York

Related topics

Quick start tests

Useful related lists in CI forms

By default, the forms that display manageable configuration items (CI) - computers, printers, 
network gear, uninterruptible power supplies (UPS), and power distribution units (PDU) - provide 
a number of related lists for the form.
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The following related lists are common to all forms for manageable CIs.

• Network Adapters - Displays all the NICs installed on a CI.

• CI IPs - Displays all the IP addresses on this CI:

◦ Computers (workstations, laptops using various macOS  and Windows  operating systems)

◦ Windows  servers

◦ Linux  servers

◦ AIX servers

◦ Solaris servers

◦ Devices discovered through SNMP.

• DNS Names for CIs - Displays all the DNS names on a CI.

The IP version information appears in all IP address related lists and forms.

Note: 
Since all paths here click into the IP Address to DNS Names  list that associates an IP 
address with a DNS name, this part of the common flow was not added to the tree structure.

Discovery source

A table called Source [sys_object_source] stores information identifying the source of a 
discovery (by ServiceNow  Discovery  or another product), the ID of that source, and the date/time 
of the last scan. To view this information, configure a CI form  and add the Sources  related list.

This table is populated automatically when the Discovery plugin  is enabled.

Table form views

When you view a table definition form, you can open the context menu, and select a form view 
in which to display the table. The default view for a table is the Default view. For any class that is 
an extension of the CMDB table, you can select the CI Definition view which provides additional 
access to related tables and information.

The CI Definition form view is a centralized location from which you can configure and view a 
table. In addition to the information that the default view displays, the CI Definition form view 
provides the following controls.

Control Description

Icon  tab View and create new NG-BSM icons for CI types

CI Identifier  tab View and create new CI identifiers

Reconciliation Definitions  tab View and create new data source definitions

Inclusion  related link Links to the Metadata Editor

To access these additional controls on the CI Definition form view, you need to first create a new 
table that is derived from the CMDB table, and then view it using the CI Definition form.

Related topics

Create a CI class
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Platform Analytics Solution  for Configuration Management (CMDB)

Platform Analytics Solutions  contain preconfigured dashboards. These dashboards contain 
actionable data visualizations that help you improve your business processes and practices.

Platform Analytics  data visualizations use Performance Analytics  indicator data to show you data 
over time, helping you analyze your business processes and identify areas of improvement. With 
Platform Analytics Solutions, you can get value from Performance Analytics  for your application 
with minimal setup. You can always create your own objects as well.

Important: 
Set up and test Platform Analytics Solutions  on a non-production instance before enabling 
them in production.

To enable the solutions for Configuration Management (CMDB), an admin can navigate to 
Performance Analytics  > Guided Setup. Click Get Started  then scroll to the section for 
Configuration Management (CMDB). The guided setup takes you through the entire setup and 
configuration process.

Related topics

Platform Analytics Solutions  

Activate your Performance Analytics subscription

Common Service Data Model
The CSDM  is the data framework that admins should follow when they set up ServiceNow 
products and applications. The standards for defining configuration items (CIs) and relationships 
between CIs in the CMDB  ensure that your data resides in the appropriate CMDB  tables. The 
result is maximum value from ServiceNow AI Platform  applications.

About the CSDM

The CSDM  is the data model standard for all products that use the Configuration Management 
Database (CMDB).

• The CSDM  guidelines ensure unified data access for ServiceNow AI Platform  products.

• The CSDM  gives you clear direct prescriptive guidelines for service modeling within the 
CMDB.

• CSDM  terms and definitions ensure consistent and accurate service reporting.

• The CSDM  data model supports multiple configuration strategies and includes guidelines for 
using base-system  tables and relationships.

• You can use the CMDB  query builder to create reports showing CMDB  configuration items 
(CIs) and their relationships.

You will find additional information about the CSDM  on the Community Forum . Also, see CSDM 
in a nutshell .

Playlist of all videos

Expert guidance to assess and improve your CSDM  implementation — the CSDM 
Assessment

The CSDM  Assessment provides Impact Customers with leading practices and prescriptive 
guidance on the CSDM  and how it supports processes on the ServiceNow AI Platform. To 
help your organization plan for and implement CSDM, the assessment includes interactions 

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

656

https://www.webstg.servicenow.com/docs/access?context=content-packs-in-form-analytics&version=washingtondc&pubname=washingtondc-now-intelligence&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=content-packs-in-form-analytics&version=washingtondc&pubname=washingtondc-now-intelligence&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=content-packs-in-form-analytics&version=washingtondc&pubname=washingtondc-now-intelligence&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=c_PremiumPerformanceAnalytics&version=washingtondc&pubname=washingtondc-now-intelligence&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=c_PremiumPerformanceAnalytics&version=washingtondc&pubname=washingtondc-now-intelligence&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=c_PremiumPerformanceAnalytics&version=washingtondc&pubname=washingtondc-now-intelligence&ft:locale=en-US
https://community.servicenow.com/community
https://community.servicenow.com/community
https://community.servicenow.com/community
https://www.youtube.com/watch?v=EnlhMhP2FsM&list=PLkGSnjw5y2U7QNr9jL6TAgwQvYBI_LEtK&index=34
https://www.youtube.com/watch?v=EnlhMhP2FsM&list=PLkGSnjw5y2U7QNr9jL6TAgwQvYBI_LEtK&index=34
https://www.youtube.com/watch?v=EnlhMhP2FsM&list=PLkGSnjw5y2U7QNr9jL6TAgwQvYBI_LEtK&index=34
https://www.youtube.com/watch?v=EnlhMhP2FsM&list=PLkGSnjw5y2U7QNr9jL6TAgwQvYBI_LEtK&index=34
https://www.youtube.com/playlist?list=PLkGSnjw5y2U7QNr9jL6TAgwQvYBI_LEtK
https://www.youtube.com/playlist?list=PLkGSnjw5y2U7QNr9jL6TAgwQvYBI_LEtK
https://www.youtube.com/playlist?list=PLkGSnjw5y2U7QNr9jL6TAgwQvYBI_LEtK


with ServiceNow  CSDM  experts and personalized content. See Common Service Data Model 
Assessment Accelerators .

CSDM  documentation

Explore

See how the CSDM framework ensures 
that your data resides in the appropriate 

CMDB tables for maximum value from 
your ServiceNow AI Platform applications.

Implement the framework

Following the CSDM framework ensures 
that you meet your primary goal of 
consistent accuracy in reporting 

and analytics so you can effectively 
manage your digital environment.

Manage the framework

The CSDM is the data framework that 
admins should follow when they set up 
ServiceNow products and applications. 
The standards for defining configuration 

items (CIs) and relationships between 
CIs in the CMDB ensure that your 

data resides in the appropriate CMDB
tables. The result is maximum value from 

ServiceNow AI Platform applications.

Reference

Reference topics provide detailed 
descriptions of tables, properties, forms, and 
roles that are used in the CSDM framework.

Key principles that guided the design and development of the CSDM  framework

The framework is intended to help you avoid errors in implementation and to ensure that your 
ServiceNow AI Platform  products generate accurate, complete, and consistent reports. The 
following principles guided the development of the CSDM  framework.

Use simplified concepts

Represent concepts in a simple, distinct manner to eliminate duplicates and 
confusion over data sources.

Design for reporting and analytics

A prime objective of CSDM  is to support consistent analysis.

Prescribe the data relationships
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Tell users in a clear direct way which relationships and references to use to link 
CSDM  tables.

Share the data model across products

The CSDM  identifies a data model that is shared across products to simplify 
concepts and collaboration. Collaborating with other product teams achieves the 
best shared design.

Use clear definitions

Use agreed-upon CSDM  definitions wherever a table, reference, or attribute is used.

Share base-system  tables

zBoot must provide shared base-system  CSDM  tables by default.

Consistent data integrations

To ensure data integrity, use prescribed technologies when integrating external data 
sources

Speed adoption

For each new release, provide automation and guidance for CSDM  that accelerates 
upgrading and minimizes issues.

Enable data governance and process

The presence of data within the model provides little value without governance and 
effective process to manage the truth and validity of the data.

Provide practical user documentation

Each product team that references CSDM  objects should provide documented 
guidance on use and/or value of the objects. Links to product-specific guidance 
appear in Applying the CSDM guidelines to your product.

Exploring the CSDM  framework

See how the CSDM  framework ensures that your data resides in the appropriate CMDB  tables for 
maximum value from your ServiceNow AI Platform  applications.

CSDM  overview
The CSDM  is the data framework that admins should follow when they set up ServiceNow 
products and applications. The standards for defining configuration items (CIs) and relationships 
between CIs in the CMDB  ensure that your data resides in the appropriate CMDB  tables. The 
result is maximum value from ServiceNow AI Platform  applications.

Join the ServiceNow CSDM Community to learn more.

Definitions of CSDM  terms

See CSDM terms.

CSDM  conceptual model

This illustration identifies each CSDM  domain and the several roles and user types that work 
together to manage your ServiceNow  applications and services. Each domain is associated with 
one or more products, services, or service types.

See Common Service Data Model — conceptual model  for a full description.
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CSDM  benefits

Benefit Value and associated features

Rationalization — Determine how 
well an enterprise application is 
performing

Identify insights from operational activities related to 
services (visualize aggregated information across all 
your services and supporting operations).

Application Portfolio Management  (APM) and IT 
Business Management  (ITBM)

Outage reduction — Identify affected 
business services quickly

Prioritize critical events based on service-related 
information.

IT Service Management  (ITSM) and Event Management

Reporting — Consistent and reliable 
information about your services and 
digital products

Understand Services, their makeup and accountabilities.

IT Service Management  (ITSM)

Alignment — Align business 
processes to reduce risk and assure 
compliance

Understand Service Health (availability, CSAT, 
Performance, Vulnerabilities, IPC stats)

Governance, Risk, and Compliance  (GRC)

CSDM videos in the ServiceNow Community

Playlist of all videos

Common Service Data Model  — conceptual model

The CSDM  is the data framework that admins should follow when they set up ServiceNow 
products and applications. The standards for defining configuration items (CIs) and relationships 
between CIs in the CMDB  ensure that your data resides in the appropriate CMDB  tables. The 
result is maximum value from ServiceNow AI Platform  applications.
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CSDM  domains: Details

Each domain is associated with one or more products, services, or service types, each of which 
you can extend as needed. Every box in the diagram (except Request Catalog Item) represents 
CIs in the CMDB. Roles and user types appear next to their area of responsibility.

Foundation domain

The Foundation domain involves tables that contain base data that is referenced 
from or to objects in the other CSDM  domains. Foundation data is required before 
you can use ServiceNow  products or add data to the CMDB.  See Foundation 
domain of the CSDM framework

Design domain

The Design domain supports the design and planning of digital products. CIs 
in the Design domain aren’t operational, so you can’t select them for Incident 
Management, Problem Management, or Change Management. Enterprise architects 
and application owners are the typical users of tables in this domain.  See Design 
domain of the CSDM framework.
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Build domain

The Build domain involves the tables that are used in the build effort (systems 
development life cycle — SDLC or Agile Development) of digital products like 
DevOps. The tables represent the logical development details of the enterprise 
applications (digital products) to be deployed and used by the business. These are 
not operational CIs.  See Build domain of the CSDM framework.

Manage Technical Services domain

The Manage Technical Services domain involves the tables used by IT Operations 
Management  (ITOM) products such as Service Mapping  and Discovery. These 
are deployed instances of digital products and their related and discoverable 
components and documentation of the services that provide and support the 
deployed instances.  See Manage Technical Services domain of the CSDM 
framework.

Sell / Consume domain

The Sell/Consume domain involves the tables used by Service Portfolio 
Management  (Service Portfolio Management) and Customer Service Management 
(CSM). This is the portfolio and request catalog of business service offerings that 
depend on the deployed digital products.  See Sell/Consume domain of the CSDM 
framework.

Manage Portfolio domain

The Manage Portfolio domain is a layer on top of the CSDM  conceptual model that 
interacts with the other CSDM  domains. The typical user, a service owner, might be 
responsible for services in more than one domain.  See Manage Portfolio domain of 
the CSDM framework.

Services and service types

A service enables you to achieve the outcomes that you want with minimal risks and without 
ownership of specific costs and risks. This definition is consistent with the base definition of 
“service” in ITIL v3 and IT4IT. Services typically have three components: the interaction, the 
offering, and the service system.

The ServiceNow AI Platform  includes the following base-system  service types that you can 
extend to align with the service types in your organization.

Application services (Application Service table [cmdb_ci_service_auto])

Application services are logical representations of a deployed application stack. 
Because application services are logical in nature, they should use the Logical life-
cycle value pairs. Application services follow the same life cycle guidance as any 
other logical CI.

• An application service is an operational CI and a unique instance of an 
application.

• Used in Incident, Problem, and Change.

• Can be created for each region and each environment (Development, QA, and 
Production).

• Can be created via manual mapping, service mapping with entry point, and 
dynamic query.

For more information about leaf nodes and structured hierarchies, see Design 
domain of the CSDM framework.

Business services (cmdb_ci_service_business)
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A business service is a service type that is published to business users. A business 
service typically implements one or more business capabilities.

Usually, business users order business services. Business users can select the 
desired offering and service commitment levels via the Service Catalog. For 
example, procurement, shipping, and finance.

• A business service is an operational CI.

• A business service must be a one-level service and not a hierarchy of business 
services.

• A business service can be used for impact in Incident, Problem, and Change and 
for approvals for Change.

• A business service must be focused on the consumer or seller.

See Sell/Consume domain of the CSDM framework.

Technical services (cmdb_ci_service_technical)

Technical services are the systems associated with the admins of CIs in the Manage 
Technical Services domain: Application service owners, Technical service owners, 
and Technology service owners). Technical services are typically lower-level leaf 
nodes of one or more business services or application services in a structured 
hierarchy.

• Technical services are operational CIs.

• A technical service must be a one-level service and not a hierarchy of technical 
services.

• Technical services are used for impact in Incident, Problem, and Change. Also 
used for approvals for Change.

• Technical services must be provider-focused and include the technology 
provided for the business to consume or sell.

See Manage Technical Services domain of the CSDM framework.

CSDM videos in the ServiceNow Community

Playlist of all videos

Foundation domain of the CSDM  framework

The Foundation domain involves tables that contain base data that is referenced from or to 
objects in the other CSDM  domains. Foundation data is required before you can use ServiceNow 
products or add data to the CMDB.

The tables in the Foundation domain aren't used in Configuration Management Database 
(CMDB)  relationships. Instead, the tables contain critical referential data. Typical users of the 
domain are process owners, data stewards, product owners, and contract managers.
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Business process

A business process has a well-defined start and finish. Examples of business processes in the 
banking industry are the customer onboarding process and the credit check process. Each 
business process can have levels of criticality and impact. Business processes are stored in the 
cmdb_ci_business_process table.

In a parent-child relationship, business processes can be identified by using the parent attribute 
as a reference to a parent business process.

The business process is a manually-maintained CI that can identify declared and determined 
criticality as well as impact to confidentiality, integrity, and availability. Business processes can 
be reviewed monthly, quarterly, semi-annually, or annually. In addition, the next review date 
can be recorded. For further information, see Business process management  and Create a 
business process .

Contracts

A contract is a binding agreement between two parties. In the ServiceNow AI Platform, contracts 
contain detailed information such as the contract number, start and end dates, active status, 
terms and conditions statements, documents, renewal information, and financial terms.

• A contract is not a CI. Contracts use contract model types from the Product Models  module. 
Contracts are stored in the [ast_contract] table.

• Use the Contract Management  application to manage and track contracts. See Contract 
Management application .

• In the Service Level Management  application, contracts group together SLAs that relate to a 
single vendor or customer, as well as the CIs, locations, groups, users, and child contracts that 
are related to the contract. For more information, see Define a service contract .

• Service contracts used by Vendor Management Workspace  can support hardware CIs as part 
of an SLA.

• In the Customer Service Management  product, service contracts define the type of support 
that customers receive. A contract can include an account and contact or a consumer and the 
specific assets that are covered. A contract can also include multiple service entitlements and 
SLAs. See Define a service contract in Customer Service Management .

Products and product models

A product model is a specific version or configuration of a product used to manage and track 
applications on the ServiceNow AI Platform. Product models identify the product owner, team, 
product status, compatibility with other products, reference to product catalog, and reference 
objects in the various stages of a product's life cycle. For more information, see Product 
catalog .

Additionally, you can identify the products reaching end-of-life as defined by third party 
providers or internal product owners. You can also bundle other products as components to 
represent the set of products that your organization develops, sells, or uses.

Product models are extended into seven base types: application model (version agnostic), 
software model (version specific),contract model, facility model, hardware model, consumable 
model, service model. Products might be bundled to create a collection or group of products, for 
example a FlashBlade server (hardware model), or a 24/7 support service (service model).
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Product models are stored in the [cmdb_model] table or the extended tables aligned to the 
seven base types. The product model tables are not CIs. Configuration items can use the Model 
ID  attribute to reference product models. For example, a service offering CI might reference a 
particular service model that other service offerings of the same type also reference.

Application, service, and software class instance CIs aren't created through Discovery, so their 
Model ID [model_id]  values might not refer to product model  records. To help you to migrate to a 
product-centric management paradigm, each instance of a logical CI should be associated with 
a product model.  See Auto-generate product models for logical CIs.

CMDB  group

A CMDB  group is a collection of CIs (but is not, itself, a CI). A group is based on the results of 
saved Query Builder queries, encoded queries, or manual entries. You can apply an action to all 
members of a group at one time.

You can work with a CMDB  group across the ServiceNow AI Platform.
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• For the CSDM, the Dynamic CI Group references a CMDB  group to provide a list of CIs based 
on a common criteria.

• CMDB  groups are stored in the table [cmdb_group].

• The CMDB  group can potentially replace the spreadsheets that you might be using to group 
your CIs.

For additional information, see CMDB groups.

Life-cycle states

Life-cycle states track the life cycles for products, assets, contracts, CIs, locations, and other 
objects. Using the standard CSDM  life-cycle values consistently helps you to effectively track 
objects through their transitions over time. Reporting can therefore accurately reflect the actual 
states of CIs: usage, availability, end of support, and so on.

See the ServiceNow Community  video: CSDM V4 product and life cycle discussion

The standard CSDM  life-cycle value pair covers all phases of a product instance life cycle.

• A Life cycle stage  is one of the broad phases that a CI moves through, from inception 
or procurement to retirement and end of life.

• Life cycle stage status  is the specific status of a CI within its current life cycle stage.

For example, a hardware CI in the Operational  stage might change status over time from In Use 
to In Maintenance  to End of Support. A different hardware CI might go from In Use  to End of 
Support  without ever having been in In Maintenance  status.
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When you enable the CSDM  framework, you can start using the Life Cycle Stage  and 
Life Cycle Stage Status  fields to track an asset's life cycle. To use the fields, follow the 
procedure described in Second activation step — Activate the CSDM plugin. The following life-
cycle processes can use life-cycle fields:

• Product life cycle

• Hardware life cycle

• Logical life cycle

• Document life cycle

• Location life cycle

Legacy life-cycle statuses are auto-updated

The following legacy statuses are automatically mapped to the Life Cycle Stage  and 
Life Cycle Stage Status  fields when you follow the procedure described in Second 
activation step — Activate the CSDM plugin.

Important: 
Legacy fields are not deleted after you implement the Life Cycle Stage  and Life 
Cycle Stage Status  fields.

• Product Model Status

• Asset State

• Asset Substate

• Contract Status

• CI Install Status

• CI Operational Status

• CI Hardware Status

• CI Hardware Substatus

Map your existing life-cycle values to CSDM life-cycle states

Use the Life Cycle Mapping module (CSDM  > Life Cycle Mapping) to specify how your existing 
life-cycle values should be converted to CSDM  life-cycle value pairs. The mapping ensures 
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ServiceNow AI Platform  products "see" legacy CIs in your environment. In this example, the 
existing Pending Install  value of the Install Status  attribute for hardware CIs will always map to 
the Deploy/Test  life-cycle value pairs in the CMDB. See Specify how to map legacy life-cycle 
states to CMDB states  and Activate life cycle migration.

Common data

Common data elements are not configuration items. Common data is shared and used 
throughout the ServiceNow AI Platform. Common data includes organizational structure 
(Company, Business Unit, Department), locations, groups, and users. Many ServiceNow AI 
Platform  products depend on common data to provide business value.

Planning your common data is essential to the effective implementation of ServiceNow AI 
Platform  products and features. Consider the following issues:

• Do you have a trusted source for the data?

• Do you have multiple data sources?

• How often does the data change?

• Do you have the depth of data that the CIs require?

• Who maintains the data?

Common data is stored in the following tables:

• Company: [core_company]

• Business unit: [business_unit]

• Department: [cmn_department]

• Location: [cmn_location]

• Groups: [sys_user_group]

• Users: [sys_user]
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Location management

Data that comes from multiple sources and federated integrations is difficult to maintain. 
The following attributes have been added to the location (cmn_location) table to simplify 
management:

• Source: The origin of the location record.

• Location type: The position of the location record in the hierarchy of locations. You can use 
the following options to create a hierarchy of location data to suit your requirements: Region, 
County, State/Province, City, Site, Building/Structure, Floor, and Room.

• Managed by group: The group that governs or manages this location record.

• Validation  (duplicate and primary): Flag duplicate records and manually filter locations that are 
not be displayed.

• Life cycle stage  and Life cycle stage status: See Life-cycle states.

CSDM videos in the ServiceNow Community

Playlist of all videos

Design domain of the CSDM  framework

The Design domain supports the design and planning of digital products. CIs in the Design 
domain aren’t operational, so you can’t select them for Incident Management, Problem 
Management, or Change Management. Enterprise architects and application owners are the 
typical users of tables in this domain.

Tables used in the Design domain

The Design domain includes the tables used by Application Portfolio Management  (APM). You 
use APM  to rationalize and manage your business applications, but you're not required to use 
APM  to benefit from the data in these tables.

• Business capability table [cmdb_ci_business_capability]

• Business application table [cmdb_ci_business_app]

• Information object table [cmdb_ci_information_object]
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Relationships between CIs that support decision making

An accurate service model that includes the following relationships can serve as the foundation 
for strategically aligned architectural decisions. The relationships enable you to determine the 
risks involved in using particular business capabilities. In addition, they enable you to assess 
services based on their relationships to business capabilities and business applications.

Relationship between a business capability and its supporting business applications

This relationship supports visualization and reporting.

• A business capability  is a high-level capability that supports a business model or 
fulfills a mission for your organization.

A business capability typically describes a specific task that achieves one or 
more business outcomes. Business capabilities are often listed as verbs (for 
example, manage financials or provide IT support services). You can use business 
capabilities to rationalize and prioritize the cost of business applications and 
business services.

• A business application  represents the software and infrastructure that provides 
a business function (for example, the titles catalog). Business applications are 
not strictly required, but they are strongly recommended because they increase 
productivity and perform other business functions such as accounts payables, 
accounts receivables, and general ledger. You can use APM  to add any business 
application for which you must track costs, usage, business value, functionality, 
and risks.

Relationship between a business application and the application services

The relationship connects the record of the business application that is used in 
planning and design with where and how it’s realized operationally, represented 
by application services. The relationship accounts for each use of a business 
application in the development, test, and production environments (dev, test, 
and prod application service instances). Often there are multiple production 
deployments. For example, a large retailer uses a business application that runs 
a cash register in each of its 1,000 stores. There are therefore 1,000 production 
instances of the application service — one per store — for that one business 
application. See the "CSDM in a nutshell" video  for additional discussion of the 
relationship.

Business capabilities represented in a hierarchy

You can represent business capabilities in a hierarchy of a parent business capability and one or 
more lower-level (child) capabilities. Child capabilities (leaf nodes) are represented by numeric 
values: 1.0 for the parent and 2.0 through 6.0 for the leaf nodes. If you add, update, or delete a 
capability at a leaf node, be sure to update the levels of all the capabilities for the leaf nodes 
in that hierarchy, as applicable. If a business capability hierarchy requires more than six levels, 
divide the structure into multiple business capabilities.

Use the Business Capability form to create, modify, and extend business capabilities.
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To update capabilities, select the Update Capability Level and HierarchyID  related link. Follow 
these guidelines when you update capabilities to ensure that the capability map reflects the 
change:

• If the parent capability is updated in the hierarchy, the levels of all its leaf node capabilities are 
recalculated.

• The total number of leaf node levels in a hierarchy can’t exceed six.

• When adding a capability, the hierarchy level is automatically assigned based on the parent 
capability level.

• You can delete only leaf node-level capabilities or capabilities without leaf node levels.

• Don’t create circular relationships. For instance, when creating a parent capability, a leaf node 
capability can’t be its parent.

Adding a Business application

A business application is a manually managed CI class. You must therefore manually create 
required relationships to CIs (for example, with instances of the application services in use). 
Creating relationships also enables you to relate business applications to infrastructure CIs such 
as databases and web servers. If needed, you can integrate or connect two or more business 
applications to establish their relationship.

A business application can span the following entities:

• Environments (for example, Development, Test, or Production).

• Geographies (for example, the Americas, the Asia Pacific Japan (APJ)

• Regions (for example, Europe, the Middle East, and Africa [EMEA]).
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Use either of the following methods to add a business application:

• Import the list of applications from a spreadsheet or third-party tool. To import data, define a 
data source and a transform map and then run or schedule an import.

• Use the Business Application form.

Information object

• An information object is a CI that displays and describes the information (or type of data) that 
the application receives from the database. Information objects are part of the information 
portfolio and are referenced by the business application.

• Information objects are mapped to the information object table [cmdb_ci_information_object].

• You can use the information object table to identify the types of data that a business 
application uses, including highly sensitive data such as:

◦ Personally Identifiable Information (PII)

◦ Payment Card Industry Data Security Standard (PCI DSS) data

◦ Health Insurance Portability and Accountability Act (HIPAA) data

CSDM videos in the ServiceNow Community

Playlist of all videos

Build domain of the CSDM  framework

The Build domain involves the tables that are used in the build effort (systems development life 
cycle — SDLC or Agile Development) of digital products like DevOps. The tables represent the 
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logical development details of the enterprise applications (digital products) to be deployed and 
used by the business. These are not operational CIs.

SDLC component CI records in the SDLC Component table [cmdb_ci_sdlc_component] enable 
the DevOps  product to provide enhanced capabilities for visualizing and managing your 
application development pipeline.

Records in the table are not operational and are not direct targets of the ITSM  Incident 
Management, Problem Management, or Change Management  processes. You therefore are not 
required to configure SDLC component records.

The tables in the build domain reference the logical development details of the enterprise 
applications to be deployed and used by the business. A common persona in this domain is 
Teams. The SDLC Component table is available through the CMDB  schema version 1.33.

SDLC component

An SDLC component is a CI that represents a unique development effort of code. It represents 
parts of a larger business application or digital product broken down into its individually 
developed components. In other words, the SDLC component is a software element of a larger 
application or technology.

Types of SDLC components:

• Application: An application service is a deployed instance of the SDLC application component. 
Examples include micro services and APIs. The build team typically builds application services 
on behalf of the Service Owner (as described in Manage Portfolio domain of the CSDM 
framework.

• Infrastructure: Any infrastructure CI that represents a snapshot of its configuration details is 
a deployed instance of the SDLC infrastructure component. Examples include database and 
security configurations.

CSDM videos in the ServiceNow Community

Playlist of all videos

Manage Technical Services domain of the CSDM  framework

The Manage Technical Services domain involves the tables used by IT Operations Management 
(ITOM) products such as Service Mapping  and Discovery. These are deployed instances of 
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digital products and their related and discoverable components and documentation of the 
services that provide and support the deployed instances.

The CIs in this domain are discovered items such as installed applications, servers, and network 
components. The Manage Technical Services domain also represents the portfolio of technical 
services in use. These services are operational, which means that you can select them for ITSM 
Incident Management, Problem Management, or Change Management.

Typical users are application service owners (for the application and platform) and technology 
service owners (for the infrastructure and delivery). Technology consumers can request technical 
service offerings through the request catalog. Catalogs are described in detail in Service 
Catalog.

The tables in the Manage Technical Services domain represent the technology that your 
business sells or consumes in the provider view. While you aren’t required to use Service 
Mapping  and Discovery  to populate the tables, those products accelerate the process and 
minimize errors. They also enable you to manage CIs and their relationships. The domain 
includes the following tables:

• Technical service table [cmdb_ci_service_technical]

• Technical services in Event Management  use the Dynamic CI group table 
[cmdb_ci_query_based_service].

• Request catalog

• Technical service offering table [service_offering]

• Dynamic CI group table [cmdb_ci_query_based_service]

• Mapped Application Service table [cmdb_ci_service_discovered] (included in the base 
system)

Technical services

Technical services are associated with service owners and are typically layered under one or 
more business or application services. A technical service may have one or more technical 
service offerings.
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Technical service users can view and manage the technologies that you provide to the business. 
Event Management  enables you to monitor service performance. You can also use Event 
Management  to identify health issues for related infrastructure CIs and application services.

Technical services can be managed as part of the Service Portfolio in the Sell/Consume domain 
(that is, a Service Portfolio hierarchy can be referenced from a Technical Service). This allows for 
a more complete hierarchy and management of both Technical Services and Business Services 
within the Service Portfolio Management  workspace and related workspaces. You can make 
better decisions when you know how spend on technical services can improve performance and 
reliability of your business services.

Note: 
Business services and technical services connect to the spm_service_portfolio through the 
spm_taxonomy_node. See Service Portfolio Management taxonomy .

Technical service offerings

Technology consumers can request technical service offerings (SO) through the request catalog. 
Catalogs are described in detail in Service Catalog. The consumer can typically select the 
following features and options:

• Level of performance

• Location or geography

• Environment

• Pricing

• Availability

• Capability

• Support group (for incident)

• Technical approval group (for change)

• Packaging options (commitments)

Technical service offerings typically have the following components:

One or more service commitments

A service commitment defines the service delivery obligations agreed to between 
the consumer and the provider. Service commitments uniquely define the level 
of service in terms of availability, criticality, scope, pricing, and other factors. For 
example, an organization may offer two levels of support for an application service:

• Support for a production-level offering: Provides a high level of availability and 
criticality for production instances. Includes a 24/7, 5-minute response time 
guarantee (24 hours per day seven days per week).

• Support for a non-production-level offering: Limited availability and criticality 
for non-production instances. Includes a 60-minute response time guarantee 
between 8:00 a.m. and 5:00 p.m., Monday through Friday.

A service offering subscription that records which users have access to an offering

Technical service offerings that are mapped to the [service_offering] table are 
classified as “technical service" and are derived from the service. The technical 
service offering is based on how the parent serves a specific technical need. Every 
operational technical service should have at least one technical service offering.
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Each CI associated through a Dynamic CI Group can be related to only one 
Technical Service or Technical Service Offering. Conflicts can result when one 
service includes multiple offerings with different SLAs, OLAs, Support Groups, and 
commitments.

Dynamic CI groups

A dynamic CI group is comprised of CIs that result from a CMDB  Groups query. For example, 
you can create a dynamic CI group based on location: "all web servers in Detroit" or "all Oracle 
databases in Mumbai".

Note: 
Dynamic CI groups contain only CIs and can't contain other CI groups.

Dynamic CI group are mapped to the [cmdb_ci_query_based_service] table and are classified as 
either application service or technical service, as applicable. You might want to use dynamic CI 
groups in the following situations:

Query-based application service

You don’t have Service Mapping  enabled yet, but you have 12 servers and three 
database instances in MyAppServiceProd. You can replace your spreadsheets with 
a dynamic CI group as an application service.

See Populate an application service using the Dynamic CI Group method.

Managed group of Infrastructure CIs

The web servers in Detroit are managed by the DetroitRockCity Technical Service 
Offering. Instead of manually creating relationships from Technical Service 
Offerings to Infrastructure CIs, use a Dynamic CI group. A single relationship from 
your Technical Service Offering CI (DetroitRockCity) to your dynamic CI Group (web 
servers in Detroit) gives you the visibility you need.

A way to manage patches for your CIs

In Change Management, you can select the dynamic CI group for the CIs you need 
to update and use a business rule to auto-populate the Affected CI  field.

Application services

An application service is a logical representation of a deployed system or an application stack. 
Using application services, you can view maps and change history for services. For example, the 
Event Management  application can monitor service performance and identify health issues for 
application services.

Application services can be internal, like an organization's email system or customer-facing, 
like an organization's website. For example, creating financial reports through a web-based 
application requires a computer, web server, application server, databases, middleware, and 
network infrastructure. The applications and hosts are configured to offer the service of financial 
reporting. An application service represents an instance of such a business application or 
system in the development, test, or production environment.

Application services are the entry points for the Service Mapping  feature. Application services 
underpin a business or technical service and are mapped to the CMDB  Application Service table 
[cmdb_ci_service_auto] for common reporting.

Application services are key relationship entities for IT Service Management  (ITSM), IT 
Operations Management  (ITOM), Strategic Portfolio Management  (SPM), and Customer Service 
Management (CSM).
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Application services include relationships between business applications, business services, 
technical services, applications, and infrastructure CIs. You can expose an application service by 
using the related business or technical service offering.

The table that an application service maps to depends on the method used to create it:

Methods mapped to tables

Method used to create the application service Mapped to table

Top Down Discovery (Service Mapping) cmdb_ci_service_discovered

Dynamic CI Group (Query-based) cmdb_ci_query_based_service

Tags cmdb_ci_service_tags

Manual (using the Create an Application 
Service form)

cmdb_ci_service_discovered

• For more information about application services and the methods you can use to create them, 
see Application services  and Create an application service.

• You can specify required attributes for application services. See Specifying attributes and 
relationships for Application Services  and Modify the attributes and relationships required for 
application services.

• You can set a relationship between an application service and the components of other CSDM 
domains. See Service Mapping .

Applications

An application is any program or module that defines behavior and performs a specific function. 
Applications are typically discoverable instances and provide a specific set of functions for one 
or more services.

• The application table and extended tables contain uniquely discovered instances of code in 
use on the host.

• Applications are considered infrastructure CIs.

• The instance is limited to the applications on a single host. This limitation ensures that 
applications are uniquely identified during discovery.

• There's a one-to-many (and not a one-to-one) relationship between the application and the 
application service. A single installed application, such as a database instance, may support 
multiple application services depending on the configuration and the use of the applications.

Note: 
The application table [cmdb_ci_appl] isn't an inventory or portfolio of your applications. 
Don't make the mistake of storing managed application details in the application table. 
Those details (inventory or application portfolio objects) belong in the business application 
table (as documented in Design domain of the CSDM framework).

Infrastructure CIs

Infrastructure CIs are managed physical and logical components. A CI can be a single module, 
such as a server, database, or a router or a complete system such as a web server, database, or 
infrastructure.
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The underlying infrastructure components or CIs can be complicated. The complexity increases 
as data structures are layered on top of physical CIs. For that reason, you should work with a 
business relationship manager or enterprise architect to define your business capabilities and 
business applications.

CSDM videos in the ServiceNow Community

Playlist of all videos

Sell/Consume domain of the CSDM  framework

The Sell/Consume domain represents the portfolio of business services that may sell or 
consume elements of the Manage Technical Services domain. The Sell/Consume domain 
involves the tables used by Service Portfolio Management  (Service Portfolio Management) and 
Customer Service Management  (CSM). This is the portfolio and request catalog of business 
service offerings that depend on the deployed digital products.

Typical users are the business relationship manager and the customer service manager. 
Business consumers can request business services through the request catalog. Catalogs are 
described in detail in Service Catalog. You're not required to use Service Portfolio Management 
or CSM  to use the referenced tables, however those products enable you to manage workflows 
and report service-related data.

The Sell/Consume domain includes the following tables:

• Business service offering table [service_offering].

• The Business Service table [cmdb_ci_service_business] extends the core Service table 
[cmdb_ci_service].

Note: 
Before the Business Service table was added, all Business Services existed in 
the Service table. In the future, all Business Services might migrate from core 
cmdb_ci_service to cmdb_ci_service_business. Until then, both tables operate identically.

• Service portfolio table [spm_service_portfolio]. The Service portfolio table is not a CMDB  table.
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You can select the tables in the Sell/Consume domain to use with Incident Management  and 
Change Management.

Business service offerings

Business service offerings are the starting point for configuring Service Portfolio Management. 
Business service offerings inherit from Business Services. Business service offerings consist of 
one or more service commitments that define the level of service in terms of availability, scope, 
pricing, and other factors. For example, an organization might offer two levels of desktop support:

• A silver offering of upgrades and virus protection.

• A gold offering with the silver commitments plus a response time guarantee of 30 minutes 
between the hours of 8:00 a.m. and 5:00 p.m., Monday through Friday.

Note: 
Business services and technical services connect to the spm_service_portfolio through the 
spm_taxonomy_node. See Service Portfolio Management taxonomy .

Business service offerings have the following characteristics:

• Business service offerings tailor the service by capability, availability, pricing, and packaging 
options. You can use the service offering to set different levels of performance and features for 
a particular service.

• Business service offering commitments define the agreed-upon service delivery obligations.

• Business service offering subscriptions record which users have access to an offering.

• Business service offerings are the CMDB  records that identify the specific business area 
and the entity where the service is delivered. Some business services and service offerings 
depend on the application service.

• Business service offerings are derived from the service and are refined depending on how the 
parent serves a particular business need.

Note: 
You should configure at least one service offering for each operational business service or 
technical service.

You can view your business service offerings in the Digital Portfolio Management (DPM).
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Business service offerings typically have different service-level agreements (SLAs) depending 
on their commitments. Without a business service offering, SLAs remain at a process level only. 
For example, the SLA stays at a P1 incident or a minor change, and doesn't refer to the affected 
service offering.

You can represent business services and business service offerings as catalog items in the 
service catalog to make them available for consumers.

Business services

A business service is associated with business users and is typically layered beneath one 
or more business capabilities. A business service can contain one or more business service 
offerings.

Business consumers can use the request catalog to order business services, business service 
offerings, and service commitment levels. Catalogs are described in detail in Service Catalog. 
Business services are mapped to the [cmdb_ci_service_business] table and are classified as 
“business services.”

Service portfolios

A service portfolio is a hierarchical collection of business services, products, projects, or 
applications. A portfolio can represent a strategic business objective and enables you to manage 
all included items as a group (for example, life cycles). Items are organized into the following 
categories:

• Objective (business intent)

• Capability

• Organization (for example, enterprise resource planning [ERP] or financial management)

• Geography (location)

Request catalogs

A request catalog enables consumers to order and manage business and technical products, 
services, service commitment options, and offerings (for example, the Human Resources [HR] 
service catalog). Catalogs contain catalog items and are the starting point for consumers to 
access available services.

Catalog Item

A catalog item is an item or a service that a consumer can request from the catalog. A service 
can contain multiple catalog items (for example, the employee onboarding catalog). Catalog 
items are listed on the service portal and are available to the users that need them (either 
through subscription or job responsibility). Each catalog item is linked to one service offering.

CSDM videos in the ServiceNow Community

Playlist of all videos

Manage Portfolio domain of the CSDM  framework

The Manage Portfolio domain is a layer on top of the CSDM  conceptual model that interacts with 
the other CSDM  domains. The typical user, a service owner, might be responsible for services in 
more than one domain.
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For example, in the Sell/Consume domain, the service owner for Human Resources (HR) might 
be financially responsible for the business application that provides HR services. The service 
owner might also need to manage the HR application instances (known as application services 
or systems) and might also be accountable for the impact the application has on the business.

Because of these additional responsibilities, CSDM enables service owners to oversee business 
applications and their deployed instances. This visibility enables service owners to perform their 
duties and meet their responsibilities.

CSDM videos in the ServiceNow Community

Playlist of all videos

Implementing the CSDM  framework in stages

Following the CSDM  framework ensures that you meet your primary goal of consistent accuracy 
in reporting and analytics so you can effectively manage your digital environment.

Improve your CSDM  implementation

The CSDM  Assessment provides Impact Customers with leading practices and prescriptive 
guidance on the CSDM  and how it supports processes on the ServiceNow AI Platform. To 
help your organization plan for and implement CSDM, the assessment includes interactions 
with ServiceNow  CSDM  experts and personalized content. See Common Service Data Model 
Assessment Accelerators .

Activating CSDM

First activation step — Map existing life cycle data to CSDM standards

You can align life-cycle values for each product instance on the asset, CI, and IBI 
tables. A one-time process moves legacy data for asset and CI across the platform 
to standard CSDM  life-cycle values. Business rules then ensure identical IBI, asset, 
and CI life cycle data for each product instance.

Second activation step — Activate the CSDM plugin

Activate the CSDM  plugin so you can begin implementing the framework.

Third activation step — Migrate existing data to the CSDM framework

You complete several tasks to ensure that your existing application data migrates 
successfully to the required tables in the CMDB.

Implementing the CSDM  framework

It's best to use a staged approach when you implement the CSDM  framework. Each 
implementation stage involves particular information types and provides specific benefits. 
Because each stage builds on the preceding stage, we use an analogy to the way a person 
develops: foundation, crawl, walk, run, and, eventually, fly.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

680

https://www.youtube.com/playlist?list=PLkGSnjw5y2U7QNr9jL6TAgwQvYBI_LEtK
https://www.youtube.com/playlist?list=PLkGSnjw5y2U7QNr9jL6TAgwQvYBI_LEtK
https://www.youtube.com/playlist?list=PLkGSnjw5y2U7QNr9jL6TAgwQvYBI_LEtK
https://www.webstg.servicenow.com/docs/access?context=CSDM-assessment&version=washingtondc&pubname=washingtondc-impact&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=CSDM-assessment&version=washingtondc&pubname=washingtondc-impact&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=CSDM-assessment&version=washingtondc&pubname=washingtondc-impact&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=CSDM-assessment&version=washingtondc&pubname=washingtondc-impact&ft:locale=en-US


Note: 
Business applications reference information objects in the information portfolio. You might 
need to implement the Information Object table [cmdb_ci_information_object] earlier than 
the Fly stage. Your business requirements determine the right stage for implementing the 
table.

CSDM implementation stages — Foundation

In the Foundation stage of implementing the CSDM  framework, you prepare the 
referential data that enables accurate reporting to support good business decisions. 
Use the base-system  tables when you begin implementing the CSDM  to derive the 
highest value from your ServiceNow  products and the ServiceNow AI Platform.

CSDM implementation stages — Crawl

In the Crawl stage, you work on base-system  CMDB  tables that are associated with 
IT Service Management  (ITSM).

CSDM implementation stages — Walk

In the Walk stage, you identify and populate the network infrastructure CIs and 
applications that your organization's technical teams support.

CSDM implementation stages — Run

In the Run stage, you set up the relationship between a technology and the 
business that sells and/or consumes the technology.

CSDM implementation stages — Fly

When you reach the Fly stage, you've accomplished all or most of the process of 
implementing the CSDM  framework. The fly stage completes the process.

Key guidelines for you to follow

• When linking CSDM  tables, use only the relationships that are designed in the model.

• Collaborate on the shared data model with other product teams. Also, when you extend CSDM 
and related functionality, be sure to follow the provided guidance. Following the guidance and 
collaborating with other product teams helps you achieve the best design.

• Use agreed-upon CSDM  definitions whenever you use a table, reference, or attribute.

• Use the provided CSDM  base tables.

• Use the recommended technologies when you integrate external data sources. The specified 
process ensures data integrity and integration consistency.

• Follow the provided guidance for setting up and using ServiceNow AI Platform  products.
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Configure the CSDM  Data Foundations dashboard

Use the CSDM  Data Foundations dashboard to monitor and evaluate key foundational metrics of 
the CSDM  framework.

Before you begin
For an introduction to the dashboard, see CSDM Data Foundations dashboard.

• Before you use the dashboard for the first time, populate the CSDM  metrics: Navigate 
to All  > System Scheduler  > Scheduled Jobs  and run the CSDM Get Well Metric 
Collection  job.

• The CSDM  Data Foundations dashboard adds the following scheduled jobs that must be 
running:

◦ CSDM Get Well Metric Collection: Calculates and stores details for compliant 
CIs associated with metrics. Data appears on the dashboard only after the first run of this 
scheduled job. metrics' scores are stored in the CSDM Data Foundations Metric Scores 
[sn_getwell_csdm_score] table. The job runs daily by default.

◦ CSDM Data Foundations PA Metric Collection: Calculates the total count of 
non-compliant CIs that are associated with each metric. It also provides trending data over 
time for the non-compliant CIs associated with metrics.

• Role required: app_service_admin, app_service_user, asset, cmdb_read, itil_admin, 
portfolio_admin, service_viewer, or technology_service_owner

Procedure

1. Navigate to All  > CSDM  > Configuration  > CSDM Data Foundations Dashboard.

2. Select a tab.

The reports on each tab display the data metrics that are appropriate for the maturity of your 
organization's CSDM  implementation stage (foundation, crawl, walk, run, and fly).

3. Review the reports.

Note the percentages and color-coding in the Result  column for each metric.

◦ If the percentage is 100%, the CSDM  framework has the information it needs. You don't need 
to do anything else.

◦ Otherwise, required information is missing and additional actions are required. Continue 
with step 5.

Note the metrics on the Foundation  tab:

Named Product Models with Product Owners

Shows cmdb_model records that meet the following conditions:

◦ Status  = in production

◦ Name  and Owner  is not empty

Configuration Item Status Values

Shows the percentage of CIs with default status values.

◦ 80%: At least 1 to 5 CIs have custom status values.

◦ 60%: 6 to 10 CIs have custom status values.

◦ 40%: 11 to 15 CIs have custom status values.

◦ 20%: 16 or more CIs have custom status values.
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To view the default base-system  status values, enter 
sn_getwell_oob_status_table_field.list  in the navigator Filter 
text box. The Configuration Item Status Values form displays the list of elements 
and associated tables. Select a table name to see the list of default labels and 
values.

Business Units with Companies

Shows business unit records where the Company  field is not empty.

Locations with Parents.

Shows cmdb_ci records that meet the following conditions:

◦ Status  = installed

◦ Operational status  = operational

◦ Location  and Location.parent  is not empty

4. Select the tiles associated with the foundational metrics to access Performance Analytics 
widgets.

Performance Analytics widgets  are provided by the CSDM PA Metric Collection 
scheduled job. These widgets provide trending data over time for the non-compliant CIs 
associated with the metric.
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◦ Ensure that the real-time option is selected (  and then select Show Records  to view 
the list of CIs.

◦ Select the Breakdowns  context menu to view available breakdowns.

5. Scroll to the list of CIs in the Custom Status Values  related list.

The charts show the number of custom values that have been defined for each element. Select 
a chart to view custom values that have been defined for the element. This example shows 
custom label-value combinations for the install_status element.

6. Select a CI to drill down to the form view.

The form view provides the required information. If you don't see the form, you may not have 
sufficient access privileges. Contact your ServiceNow  administrator.

7. When you're finished using the form, select Update  or Delete  to return to the list view.

8. Navigate to return to the CSDM  Data Foundations dashboard.

Result
The key foundational metric results are available for you to review and analyze.

First activation step — Map existing life cycle data to CSDM  standards

You can align life-cycle values for each product instance on the asset, CI, and IBI tables. A one-
time process moves legacy data for asset and CI across the platform to standard CSDM  life-cycle 
values. Business rules then ensure identical IBI, asset, and CI life cycle data for each product 
instance.

After you migrate existing data, you will continue to use only standard life-cycle states when 
creating or updating CIs to gain the following benefits:

• To handle alerts appropriately, Event Management and Operational Intelligence need to know 
whether a CI is in maintenance life-cycle status.

• To report cost data effectively, Cloud Insights needs to know the state of a CI.

• To generate consistent tasks and workflows, Audit and Compliance need to use standard life 
cycle values.
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You must activate life cycle migration  to migrate legacy life cycle values to the CSDM standard 
fields and values.

Life Cycle Mapping table

The base system  contains the Life Cycle Mapping [life_cycle_mapping] table, which is pre-
populated with widely used legacy life cycle mappings. Each mapping record specifies how to 
map a legacy life-cycle field’s value, based on its table, to the standard CSDM  values.

• Life cycle stage  (life_cycle_stage): The broad life cycle phases that a CI moves through, 
from inception or procurement to retirement and end of life.

• Life cycle status  (life_cycle_stage_status): The specific status of a CI within its current 
life cycle stage.

The table typically contains multiple record entries per class, each entry for a specific legacy 
life cycle and life-cycle value pair. When there are multiple record entries for a class, the entries 
are prioritized by importance and likelihood for containing meaningful values for the mapping 
process.

The standard CSDM  life-cycle value pair covers all phases of a product instance life cycle.

• A Life cycle stage  is one of the broad phases that a CI moves through, from inception 
or procurement to retirement and end of life.

• Life cycle stage status  is the specific status of a CI within its current life cycle stage.

For example, a hardware CI in the Operational  stage might change status over time from In Use 
to In Maintenance  to End of Support. A different hardware CI might go from In Use  to End of 
Support  without ever having been in In Maintenance  status.

Custom life cycle values

In an upgrade scenario, life cycle migration checks for custom legacy life-cycle values that were 
added in the system. For each custom value, the system adds a record to the Life Cycle Mapping 
[life_cycle_mapping] table. Those mapping records, however, are incomplete and inactive.

Before you activate life cycle migration, you must edit and activate those records to supply the 
desired life cycle control to use for mapping.
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Specify how to map legacy life-cycle states to CMDB  states

Use the Life Cycle Mapping module to specify how existing legacy status values should be 
converted to CSDM  life-cycle value pairs. You map both asset and CI legacy status values to life-
cycle values.

Before you begin
Role required: itil_admin or asset_admin

About this task
In this example, your existing data uses a life-cycle attribute named Install Status  for hardware 
CIs. You use the Life cycle mapping form to map the existing Pending Install  value of the Install 
Status  attribute to the Deploy/Test  life-cycle state in the CMDB.

Procedure

1. Navigate to All  > CSDM  > Life Cycle Mapping.

2. On the Life cycle mappings list view, select New  and then fill in the Life cycle mapping form.

The fields on the form are described in Life cycle mapping form.

Important: 
If you map more than one legacy status value set to any single life-cycle value pair, then 
select the Reverse sync  option in the next step.

3. Skip this step if you map only one legacy status value set to a life-cycle value pair.

The Priority  value on the life cycle mapping table is used when a record update triggers the 
“legacy-to-life-cycle” sync, and multiple legacy value states on the record match with mapping 
rules. Of the multiple values, the highest priority (lowest numerical value) entry is used to set 
the life-cycle value pairs. If the highest priority entry can't be used, the system uses the next 
record in priority. The Reverse sync  field does not appear on the form by default, but you can 
add it if needed.
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Priority is not used if reverse sync is active because there should be a maximum of one 
reverse-sync choice for each life-cycle value per class.

Note: 
Use of reverse sync results in some loss of fidelity over time. As time goes on, the lower 
priority values will become less common (unless you have a process that sets that value 
directly).

4. Select Submit.

5. Repeat the process and, when you have mapped all existing life-cycle states, migrate them to 
the CMDB.
For instructions, see Activate life cycle migration.

Activate life cycle migration

Activate life cycle migration to migrate your mapped legacy custom life-cycle settings to the 
CSDM  standard life-cycle values. The migration script migrates both existing and to incoming 
data.

Before you begin
Before you activate life cycle migration, navigate to CSDM  > Life Cycle Mapping. Review the pre-
populated mappings in the Life Cycle Mappings  list view:

• Adjust and add any mappings as needed for your environment.

• Review mappings for any custom legacy life cycle values. Those mappings are incomplete and 
you must provide the desired standard life cycle control to map to.

• Ensure that all mappings are configured with a life cycle control.

• Ensure that all mappings are activated.

Role required: itil_admin or asset_admin

Procedure

1. Navigate to CSDM  > Life Cycle Mapping.

2. On the Life Cycle Mappings  list view, click Activate.
Activation can complete only if all mapping records are set to active and are configured with a 
life cycle control, and all mapping records for custom legacy values are fully configured.

Result
The script performs the following activities:

• One-time bulk mapping of legacy values to the Life cycle stage  and Life cycle 
status  fields. The mappings are based on the mapping records in the Life Cycle Mapping 
table, which contain values, source, and target fields.

• Change the default false setting for the csdm.lifecycle.migration.activated 
system property to true. The change activates the Update life cycle from legacy 
business rule. Future insert or update CI operations will trigger the rule to populate the 
standard Life cycle stage  and Life cycle status  fields to ensure that life cycle 
standards are used continually and consistently.

For example, when creating a hardware CI, and setting the legacy Status  and 
Operational status  fields. After saving, the new life cycle standard fields are 
automatically populated with the matching life cycle standard values based on the 
corresponding record entry in the Life Cycle Mapping table. If you modify legacy values, the 
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standard fields are automatically updated based on another matching record in the Life Cycle 
Mapping table.

• Because life cycle migration is a one-time process, the Activate  button is disabled.

What to do next
After the data has migrated successfully, you can start managing data following the CSDM 
model:

1. Activate the CSDM Activation (com.snc.cmdb.csdm.activation) plugin .

2. Use the CMDB Data Manager  to centrally govern the life cycle of CIs, in bulk, and in a standard 
and consistent way.

Second activation step — Activate the CSDM  plugin

Activate the CSDM  plugin so you can begin implementing the framework.

Before you begin

Important: 
Before you activate the CSDM  plugin, you must map your existing life cycle data to standard 
CSDM  attributes. The mapping enables you to track assets effectively through their life 
cycle transitions with the CMDB Data Manager. For instructions, see Migrate to CSDM life 
cycle standards.

• Role required: itil and itil_admin

Procedure

Activate the CSDM  Activation plugin: com.snc.cmdb.csdm.activation.
For more information, see Activate a plugin .

Third activation step — Migrate existing data to the CSDM  framework

You complete several tasks to ensure that your existing application data migrates successfully to 
the required tables in the CMDB.

Before you begin
Role required: admin

About this task
Keep the following points in mind:

• Some CSDM  tables have been introduced recently so you might not be familiar with them. See 
the documentation for your ServiceNow  product to learn about unfamiliar tables.

• You can continue to use customized or non-conforming CMDB  tables. If you do so, however, 
you may not get the full benefit of your ServiceNow  products.

• Be sure to use the migration tools that are described in CSDM migration tools.

Manage the attributes that you are using.  Rationalize your custom attributes. Use the following 
guidelines to decide whether you really need to keep all customizations:

• Best Practice: The custom attribute doesn't have a related base-system  attribute but you need 
to use it.

• Keep: The custom attribute doesn't have a related base-system  attribute but it's required for a 
unique use case.
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• Refactor: The custom attribute does have a base-system  attribute or a capability that can be 
migrated.

• Do Not Need: The customization is no longer needed. Delete the attributes that you don’t use 
or use only rarely. Consider deleting attributes if there’s a better way to address a use case.

Consider related dependencies.  Moving configuration items (CIs) to a new table doesn't 
automatically move related dependencies. To identify related dependencies, use the scripts 
described in Migrating into CSDM identifying table dependencies  (available on the ServiceNow 
Community ).

Important: 
The script doesn't move your data or their dependencies. It only identifies the 
dependencies. You refactor data and dependencies as part of the migration.

After running the scripts and evaluating the data, you will have a better idea of the effort required 
to migrate your data. Decide whether you need all referenced reports, rules, and scripts. Then 
decide what you want to migrate and make a migration plan.

Migration workflow

Procedure

1. Back up your data.
Export your data (with all attributes) to Excel and keep the file in a secure location. Have a 
contingency plan in case issues arise.

2. Map the attributes.
Identify the table where the data should go. Make sure that destination table has the required 
base-system  attributes. Rationalize your custom attributes. Decide which customizations you 
will keep.

3. Move CIs from existing classes to CMDB  classes.

Note: 
Don’t forget about non-conforming tables and their dependencies. You could have 
hundreds of reports, business rules, scripts, table references, and more that need the 
data in your non-conforming tables.

Moving CIs to a new table does not automatically move reports, business rules, and so on. 
As described in the following steps, the fix script identifies dependencies that you need to 
refactor. You can download the fix script  from the ServiceNow Community.

4. Refactor the attributes.
Solidify the data model and get the data ready for migration.

Make sure you have completed the attribute mapping-related tasks described in earlier steps. 
Follow the guidelines and refactor your data as needed.

5. Migrate the data.
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Note: 
Make sure that you have a valid and recent backup. Make another backup if necessary. 
During migration, you lose all customized or base-system  attributes that are not in the 
same table hierarchy.

Keep these points in mind as you proceed:

◦ Migrate your CIs to the new class to move the CI and all its related objects, incidents, and 
changes to the new table.

◦ Start with a few CIs and increase the number when you feel comfortable.

6. Remediate your table dependencies:

a. Modify reports to use the new table.

b. Migrate business rules and scripts as needed.

c. Update table references as needed.

7. Reload data into the new attributes using the backup that you made earlier.

8. Validate all data and dependencies.

Result
You've successfully migrated your application to the CSDM  framework, and your data is in the 
required CMDB  locations.

CSDM  migration tools

Migration tools simplify the process of migrating your data to the CSDM  framework.

Data migration script

Use the fix script from the ServiceNow Community  to identify table dependencies. See Migrating 
into CSDM identifying table dependencies .

CMDB  Data Foundations dashboard

Navigate to All  > Configuration  and then select CMDB Data Foundations Dashboard.

• CMDB  dashboard: Each tab provides key metrics that evaluate configuration and 
customizations in the CMDB.

• The metrics provide visible results of evaluation. Color codes and weighted priority help with 
planning.

• Each metric includes a link to a remediation playbook with background and plays for 
remediation.

See Monitor system foundations in the CSDM and the CMDB Data Foundations Dashboards.

CSDM  Data Foundations dashboard

Navigate to All  > Configuration  and then select CSDM Data Foundations Dashboard.

The CSDM  dashboard focuses on key data elements to support you in implementing the CSDM 
framework. The reports on each tab display the data metrics that are appropriate for the maturity 
of your organization's CSDM  implementation stage (foundation, crawl, walk, run, and fly).  See 
CSDM Data Foundations dashboard.
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CSDM  implementation stages — Foundation

In the Foundation stage of implementing the CSDM  framework, you prepare the referential data 
that enables accurate reporting to support good business decisions. Use the base-system  tables 
when you begin implementing the CSDM  to derive the highest value from your ServiceNow 
products and the ServiceNow AI Platform.

Benefits of preparing the data in the Foundation stage

The basis of any good data model is the foundational data that is referenced throughout the 
model.

• The base-system  tables act as the foundation for many ServiceNow  products.

• The tables help your company align with reporting requirements early to expedite the value 
you get from the CSDM. You can reduce or eliminate costly rework tasks needed to align with 
reporting requirements.

Tables that you work on during the Foundation stage

Business Process table [cmdb_ci_business_process]

A business process has a well-defined start and finish. Examples of business 
processes in the banking industry are the customer onboarding process and the 
credit check process. Each business process can have levels of criticality and 
impact. Business processes are stored in the cmdb_ci_business_process table.

Contract table [ast_contract]

The Contract table identifies binding agreements between two parties. When 
you populate services provided by vendors into the CMDB, consider the role that 
contracts play when evaluating service level agreements (SLAs).

Product model table [model_id]

The Product model table [model_id] identifies the unique types of products your 
organization develops or consumes. When you group assets and CIs by product 
model, you unify and relate CIs that are part of the same digital product and 
portfolios of products. Grouping assets and CIs by product model can help you plan 
projects, monitor costs, and rationalize your data. Discovery can populate hardware 
product models after they’re operational, but other types of product models require 
planning from product owners.

Use the CSDM Product Model Assignment  job to auto-generate a product 
model  record (application model, service model, or software model) for each logical 
CI that is not yet associated with a product model. Product models are ideal for 
associating CIs that are parts of a single digital product.  See Auto-generate product 
models for logical CIs.

CMDB  Group table [cmdb_ci_query_based_service]

The CMDB  Group table identifies a collection of CIs based on the results of saved 
Query Builder queries, encoded queries, or manual entries. CMDB  groups are 
critical elements of Dynamic CI groups and the strategic management of CIs. 
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Decide early how you want to report CI information and how you want to monitor 
CIs. These decisions affect how you create CMDB  groups.

Location table [cmn_location]

The Location table uniquely identifies geographic locations. You can create a 
hierarchy of location data using the Parent  attribute. The hierarchy might include 
entries that match your reporting requirements. For example, you could populate 
the location table as follows

Your organization's location attributes

To include more detail in reports, you could extend the Location table to include 
floors, rooms, and even datacenters. With hierarchy capabilities, trusted source 
data, and your requirements in hand, you can create locations that support your 
future reporting needs.

Group table [sys_user_group]

The Group table identifies sets of users that share a common purpose. Groups may 
perform tasks such as approving change requests, resolving incidents, receiving 
email notifications, or performing work order tasks. Groups also use the referential 
data in the CMDB  to identify how CIs are managed (for example, the Managed 
by group) and supported (for example, the Support group). Any business rules, 
assignment rules, system roles, or attributes that refer to a group automatically 
apply to all group members.

User table [sys_user]

The User table identifies the persons and applications that have access to your 
ServiceNow  instance. You can organize users into groups that are associated with 
the Company, Business Unit, and Department tables.

Organizational structure

Organization structure tables identify internal business structures and external 
customers, manufacturers, and vendors.

Company table [core_company]

The Company table is populated with the legal entities of companies. 
Entities can be either internal (your organization) or external. You can 
use the Parent attribute to build a hierarchy. Consider the legal entities 
that you need for reporting when the CMDB  is populated.

• Internal entries should focus on a hierarchy of legal entities rather 
than a hierarchy of business units within a legal entity.

• External entries are identified by a True or False flag. The Customer 
flag identifies your external customers.

The Manufacturer flag identifies companies that create products that 
you consume. An internal organization might be a manufacturer.

• The Vendor flag identifies organizations that provide products that 
you purchase. An internal organization might be a vendor.

Business Unit table [business_unit]

The hierarchy of your business is populated in the Business Unit table 
with a reference to the parent company. A business unit is a part of 
your organization that is responsible for specific operations, such as 
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finance, human resources (HR), or IT. A hierarchy within a business 
unit is common. For large multinational organizations, you may have 
business units that identify independent regional operations and the 
specific operations within the region.

Department table [cmn_department]

The Department table includes a finer level of detail about a business 
unit. The Department table gives you another way to categorize users, 
groups, assets, and CIs.

Life-cycle tables

Life-cycle states track the life cycles for products, assets, contracts, CIs, locations, 
and other objects. Using the standard life-cycle values consistently helps you to 
track objects through their transitions over time. Reporting can therefore accurately 
reflect the actual states of CIs: usage, availability, end of support, and so on.

Note: 
Based on the type of item, the [life_cycle_control] table specifies which life 
cycle stage values are available for each life cycle stage.

The standard CSDM  life-cycle value pair covers all phases of a product instance life 
cycle.

• A Life cycle stage  is one of the broad phases that a CI moves through, 
from inception or procurement to retirement and end of life.

• Life cycle stage status  is the specific status of a CI within its current 
life cycle stage.

For example, a hardware CI in the Operational  stage might change status over time 
from In Use  to In Maintenance  to End of Support. A different hardware CI might go 
from In Use  to End of Support  without ever having been in In Maintenance  status.

When you enable the CSDM  framework, you can start using the Life Cycle 
Stage  and Life Cycle Stage Status  fields to track an asset's life cycle. To 
use the fields, follow the procedure described in Second activation step — Activate 
the CSDM plugin. The following assets can use life-cycle states:

• Product life cycle

• Hardware life cycle
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• Logical life cycle

• Document life cycle

• Location life cycle

Watch the ServiceNow Community  video: CSDM V4 product and life cycle 
discussion

CSDM  implementation stages — Crawl

In the Crawl stage, you work on base-system  CMDB  tables that are associated with IT Service 
Management  (ITSM).

Benefits of the operations that you perform in the Crawl stage

• The operations provide the minimum CMDB  support requirements for Incident Management 
and Change Management.

• Setting up APM  is faster because your business application data is in the right place in the 
CMDB.

• The operations build the foundation for using DevOps  because your SDLC component data is 
populated and ready to relate to your applications.

• Service Mapping  is ready to use for mapping entry points because your application service 
data is populated.

• The operations build the foundation for using TPM  risk details, a capability of APM.

The operations prepare you to manage and monitor the life cycles and versions of the 
underlying technologies of the business applications in your enterprise.

The data enables you to identify outdated or at-risk software using APM, Service Mapping  and 
Software Asset Management  (SAM) Professional.

Tables that you work on during the Crawl stage

Important: 
Future products and product enhancements depend on the data that you prepare in each 
of the tables.

During this stage, you work on the following base-system  CMDB  tables:

• Business Application table [cmdb_ci_business_app]

• Mapped Application Service table [cmdb_ci_service_discovered]

• Application table [cmdb_ci_appl] (discoverable)

• Server/host (discoverable)

Note: 
Some of the classes that you implement in this stage are logical CIs. Logical CIs aren’t 
created through Discovery, so their Model ID  values might not refer to product model 
(application model, service model, or software model) records. To help you to migrate to a 
product-centric management paradigm, each instance of a logical CI should be associated 
with a product model. See Auto-generate product models for logical CIs.
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Start by focusing on applications and the application-related data in these areas and tables:

Business Application table [cmdb_ci_business_app]

A business application is a base-system  CMDB  table that stores your inventory, 
application portfolio, and their metadata.

Because this table is not an operational configuration item (CI), it is not used by 
ITSM  Incident Management, Problem Management, or Change Management 
processes.

SDLC Component table [cmdb_ci_sdlc_component]

SDLC component CI records in the SDLC Component table 
[cmdb_ci_sdlc_component] enable the DevOps  product to provide enhanced 
capabilities for visualizing and managing your application development pipeline.

This table represents the software part or element of a larger whole for applications 
and infrastructure. Related material may serve as representative of developmental 
details. It can be used if you need to identify the stratification of a business 
application or digital product.

Note: 
This is not an operational CI and cannot be used in incident, problem, and 
change.

Application Service table [cmdb_ci_service_auto]

The application service is typically the system that the caller identifies when they 
report an issue with an application.

A mapped application service is a base-system  CMDB  table that identifies the 
related business application in use. The application service ties all the elements of 
the CSDM  together where applications are present.

You may have several application services representing each deployment based on 
the environment (development, QA, production) and location or geography (North 
America, Asia Pacific).

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

695



Because application services are logical in nature, they should use the Logical life-
cycle value pairs. Application services follow the same life cycle guidance as any 
other logical CI.

Application table [cmdb_ci_appl]

An application is a base-system  CMDB  table that represents the discoverable 
instance of an application: code related to a process in use on a host. This table 
isn't an inventory of your applications. Because of the high level of complexity 
involved, don't try to manually populate the application table. Discovery  creates and 
maintains this table.

Important: 
The application table [cmdb_ci_appl] isn't an inventory or portfolio of your 
applications. Don't make the mistake of storing managed application details in 
the application table. Those details (inventory or application portfolio objects) 
belong in the business application table (as documented in Design domain of 
the CSDM framework).

The application may be identified as the root cause of an incident. However, if you're 
not using Event Management, the application may not be the initial cause.

If you're using Discovery, applications are automatically related to their host, which 
provides an impact hierarchy from server-to-host applications.

CSDM  implementation stages — Walk

In the Walk stage, you identify and populate the network infrastructure CIs and applications that 
your organization's technical teams support.

Benefits of the operations that you perform in the Walk stage

Managing discovered infrastructure CIs

The operations facilitate managing the discovered infrastructure CIs. You might 
manually managing the metadata on these CIs, such as support group and 
technical approval group. By identifying the technical service offering that manages 
these CIs, you can:

• Configure ServiceNow  to populate and synchronize this metadata onto the 
related child objects.

• Eliminate the manual effort of maintaining the metadata on thousands of CIs.

View supported CIs

The operations establish a view of the CIs that your organization's technical teams 
support.

You can see the specific support assignments, which you can change as needed 
based on your support structure, operational-level agreements (OLAs), and 
commitments.

Also, this view enables you to formalize for your process for supporting applications 
and technology owners.

Prepare for Service Portfolio Management

The operations build the foundation for using Service Portfolio Management 
(Service Portfolio Management).

You can start using Service Portfolio Management  more quickly because your 
service data are in the right place.
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Use the request catalog

The operations enable you to order technology service offerings through the 
request catalog. You can also automate ordering some offerings to enhance the 
request workflow and update or create related CIs. Catalogs are described in detail 
in Service Catalog.

Note: 
The request catalog is not a CMDB  table.

Prepare for ITOM) products

The operations build the foundation for Information Technology Operations 
Management  (ITOM) products, such as Service Mapping  and Discovery.

Enable Automation

The operations enable more automated methods of grouping CIs for identification 
and management by Technical Service Offerings.

Tables that you work on during the Walk stage

The walk stage includes base-system  CMDB  tables that identify the technology provider.

Note: 
Some of the classes that you implement in this stage are logical CIs. Logical CIs aren’t 
created through Discovery, so their Model ID  values might not refer to product model 
(application model, service model, or software model) records. To help you to migrate to a 
product-centric management paradigm, each instance of a logical CI should be associated 
with a product model. See Auto-generate product models for logical CIs.

Technical service table [cmdb_ci_service_technical], or [cmdb_query_based_services] for 
Event Management

The Technical service table has a service classification of "technical service". 
This base-system  CMDB  table identifies the provider of the technology that your 
business consumes.

Technology service offering table [service_offering]
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A Technical service offering is a service offering with a service classification of 
"technical service". Technical service offerings may be further divided as follows:

• Location and geography

• Environment (production or non-production)

• Pricing

• Availability

• Support group (for Incident Management)

• Technical approval group (for Change Management)

• Packaging options (commitments)

The technical service offering comes from the service, based on how the parent 
serves a specific technical need. Every operational technical service must be 
associated with at least one technical service offering.

Note: 
Not all technical service offerings have to be related to applications or 
infrastructure CIs. Managed Service Providers may provide technical service 
offerings.

Dynamic CI group table [cmdb_ci_query_based_service]

A Dynamic CI group is a collection of CIs based on the results of saved Query 
Builder queries, encoded queries, or manual entries. Query Builder is described in 
Querying the CMDB. For more information about Dynamic CI groups and how you 
can use them, see Manage Technical Services domain of the CSDM framework.

CSDM  implementation stages — Run

In the Run stage, you set up the relationship between a technology and the business that sells 
and/or consumes the technology.

ITSM  considerations during the Run stage

When you use ITSM, you must understand the impact that a technology can have on your 
business. For example, your business may:

• Consume the technology.

• Sell the technology (as is the case with Customer Service Management).

• Both sell the technology and consume it.

Benefits of the operations that you perform in the Run stage

• Run-stage operations ensure impact assessment for Incident Management  and Change 
Management. Within an incident or change, you can identify the impacted business, assuming 
relationships exist between the selected CI and the impacted businesses.

• Run-stage operations provide a foundation for using Service Portfolio Management  in the 
Digital Portfolio Management (DPM). Service owners can monitor service portfolios and 
understand service-related information including service trends, improvement initiatives, 
service performance, and outage monitoring.

• Run-stage operations provide a foundation for ITSM  capabilities. This foundation populates 
the related “Subscribe by” table on a service offering to identify the business and subscribers 
affected. Business service offerings can identify subscribers by user, company, location, 
department, and group.
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Tables that you work on during the Run stage

Note: 
Some of the classes that you implement in this stage are logical CIs. Logical CIs aren’t 
created through Discovery, so their Model ID  values might not refer to product model 
(application model, service model, or software model) records. To help you to migrate to a 
product-centric management paradigm, each instance of a logical CI should be associated 
with a product model. See Auto-generate product models for logical CIs.

Business service portfolio table [service_portfolio]

Note: 
The Business service portfolio is not a CMDB  table.

A business service portfolio is not a CMDB  table. A business service portfolio is a 
hierarchical collection of business services (products and services) that define a 
business objective.

Business service table [cmdb_ci_service_business]

The business service table is a base-system  CMDB  table. This table identifies a 
business objective that uses (and depends on) the infrastructure that technology 
uses.

This dependency means that the business service must sell or consume that 
infrastructure.

Business service offering table [service_offering] (service offering classified as a 
"business service")

Business service offerings are the starting point for configuring Service Portfolio 
Management. Business service offerings consist of one or more service 
commitments. These service commitments uniquely define the level of service in 
terms of availability, scope, pricing, and other factors.

The business service offering comes from the service. The business service offering 
is fine-tuned based on how the parent serves a specific technical need.

Every business service should have at least one business service offering.
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Request catalog

A catalog (sometimes called a request catalog or service request catalog) is a set 
of business and technical products, services, service commitment options, and 
offerings that users can order on a self-service basis. You can manage a catalog to 
present your available products and services to users as catalog items. Catalogs are 
described in detail in Service Catalog.

CSDM  implementation stages — Fly

When you reach the Fly stage, you've accomplished all or most of the process of implementing 
the CSDM  framework. The fly stage completes the process.

Benefits of the operations that you perform in the Fly stage

The Fly stage is a foundation for using APM  capabilities

You can use APM  capabilities to rationalize your business applications. Ask 
questions such as the following:

• Are you spending too much on your business capabilities?

• Are you spending too little on your business capabilities?

• Should you increase the amount you spend on emerging business capabilities?

The Fly stage is a foundation for using APM  with Service Portfolio Management 
capabilities

You can use APM  with Service Portfolio Management  capabilities to rationalize your 
business services and related offerings. Ask questions such as the following:

• Are you spending too much or too little on services?

• Are you spending too little or too little on services?

• Are they the right services compared to emerging capabilities?

The Fly stage is a foundation for using ITSM  capabilities

Starting with the New York  release, you can use the request catalog to relate a 
service offering to a catalog item. You can also enhance the request workflow to 
automatically populate the “Subscribe by” table. Catalogs are described in detail in 
Service Catalog.

Note: 
The request catalog is not a CMDB  table.

The Fly stage can hep you to manage business services

If your environment has a combination of CIs from each of the CSDM  domains, this 
stage provides away to manage business services.

The Fly stage is a way to identify the types of data that may be contained in or used by 
your business applications

The information object table helps you see what's in your information portfolio.

Tables that you work on during the Fly stage

You reach the fly stage after you have accomplished all or most of the earlier stages.
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Note: 
Some of the classes that you implement in this stage are logical CIs. Logical CIs aren’t 
created through Discovery, so their Model ID  values might not refer to product model 
(application model, service model, or software model) records. To help you to migrate to a 
product-centric management paradigm, each instance of a logical CI should be associated 
with a product model. See Auto-generate product models for logical CIs.

The fly stage completes the remaining aspects of CSDM  framework:

Business capability table [cmdb_ci_business_capability]

A business capability  is a high-level capability that supports a business model or 
fulfills a mission for your organization.

Information object table [cmdb_ci_information_object]

You capture asset information as information objects. You can connect the 
information objects to your business applications to create an application portfolio 
that you can use at any time.

You can use the Information Object table to identify the types of data that a 
business application uses, including highly sensitive data such as:

• Personally Identifiable Information (PII)

• Payment Card Industry Data Security Standard (PCI DSS) data

• Health Insurance Portability and Accountability Act (HIPAA) data

Information objects are part of the information portfolio. The information portfolio 
links to the following data:

• Data Domains: Total number of records in the Data Domain table 
[sn_apm_data_domain].

• Information Objects: Total number of records in the Information Object table 
[cmdb_ci_information_object].

• Database Instances: Total number of records in the Database Instance table 
[cmdb_ci_db_instance].

• Database Catalogs: Total number of records in the Database Catalog table 
[cmdb_ci_db_catalog].

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

701



Important: 
You might need to implement the Information object table 
[cmdb_ci_information_object] as part of an earlier stage. Your business 
requirements determine the right stage for implementing the table.

Request catalog

Users request services through the request catalog. The request catalog is not a 
CMDB  table. Catalogs are described in detail in Service Catalog.

The fly stage includes these components:

• Business service portfolio table [service_portfolio]

• Business service table [cmdb_ci_service_business]; (service classified as a 
"business service")

• Business service offering table [service_offering]; (service offering classified as a 
"business service")

Auto-generate product models for logical CIs

Use the CSDM Product Model Assignment  job to auto-generate a product model 
record (application model, service model, or software model) for each logical CI that is not yet 
associated with a product model. Product models are ideal for associating CIs that are parts of a 
single digital product.

Before you begin
Users with read access to modified CI records can view the new product models.

Role required: admin

About this task
Application, service, and software class instance CIs are not created through Discovery, so 
their Model ID [model_id]  values might not refer to product model  records. To assist you in 
migrating to a product-centric management paradigm, each instance of a logical CI should be 
associated with a product model. The CSDM Product Model Assignment  job operates on 
the following classes and uses the name of the class instance as the name of the new product 
model.

• Service Offering

• Technical Service

• Application Service: The script adds the version (as it relates to the Business Application) to 
the associated software model name. For example, the software model for the MyAppService 
application service CI might be MyAppService - version: 2.1.

• Business Service

• Business Application

The CSDM Product Model Assignment  job calls the CSDMModelUtil  script. The script 
performs these actions for each instance of the supported CSDM  classes that does not refer to a 
product model:

1. Create a new application model, service model, or software model record with the same name 
as the CI. If the requisite info for generating the name value does not appear in the CI, the 
script uses the default value that you specified.

2. For the CI, add a reference to the new product model  in the Model ID [model_id]  field.
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Operation of the script:

• The script observes the access rules of the CMDB  admin that runs the script.

• If an auto-generated product model  record for a class instance CI would be identical to an 
existing record, then the existing record is used for that CI.

• If your data includes CIs with identical names (this is actually an error), then the resulting 
model_id values might conflict. Validate the resulting model_ids after running the script.

Procedure

1. Specify the default name to use if the name / version values of a CI are insufficient to auto-
generate the name for the new product model.

a. Navigate to Configuration  > CI Class Manager  and then select Open Hierarchy.

b. Navigate to each of the supported classes in turn (Application Service, Business Service, 
and so on).

c. On the Basic Info  page for the class, enter the appropriate name in the Default Product 
Model  field.

2. Run the CSDM Product Model Assignment  job.

a. Navigate to System Scheduler  > Scheduled Jobs  > Scheduled Jobs.

b. Search for and open the CSDM Product Model Assignment  job.

c. Select Execute Now.
The script runs and generates the product models.

3. Review the created product models  to ensure that the new Model ID [model_id]  values are 
correct.

Use:
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◦ All  > Product Catalog  > Product Models  > Application Models

◦ All  > Product Catalog  > Product Models  > Service Models

◦ All  > Product Catalog  > Product Models  > Software Models

4. Run the job whenever you want to create product model  settings for new class instances.

Managing the CSDM  framework

The CSDM  is the data framework that admins should follow when they set up ServiceNow 
products and applications. The standards for defining configuration items (CIs) and relationships 
between CIs in the CMDB  ensure that your data resides in the appropriate CMDB  tables. The 
result is maximum value from ServiceNow AI Platform  applications.

CSDM  modules

Navigate to the modules that assist you in implementing and managing the CSDM  domains and 
their components.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

704



CSDM Data Foundations Dashboard

The CSDM Data Foundations dashboard displays key CSDM  indicators on a single 
page to help you get the full benefit from your ServiceNow AI Platform  products.  See 
CSDM Data Foundations dashboard.

Getting Started

Select Getting Started  to open the library of CSDM  user documentation — the 
documentation you are viewing now.

Application Service Settings

Use the Application Service Settings module to specify the attributes and 
relationships that are required when a user creates an application service.  See 
Specifying attributes and relationships for Application Services.

Application Service Dashboard
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The Application services dashboard enables you to monitor and manage 
application services to ensure that application services are fully configured and are 
populated in the CMDB.  See Monitoring and managing application services.

Life Cycle Mapping

Use the Life Cycle Mapping module to specify how existing legacy status values 
should be converted to CSDM  life-cycle value pairs. You map both asset and CI 
legacy status values to life-cycle values.  See First activation step — Map existing life 
cycle data to CSDM standards.

Design

Work in the tables that are referenced in the Design domain of the CSDM. See 
Design domain of the CSDM framework.

Manage Technical Services

Work in the tables that are referenced in the Manage Technical Services domain of 
the CSDM. See Manage Technical Services domain of the CSDM framework.

Sell and Consume

Work in the tables that are referenced in the Sell/Consume domain of the CSDM. 
See Sell/Consume domain of the CSDM framework.

Synchronize data for 'Managed by' and 'Change' groups

Synchronizing group assignment attributes

Set the group for a CI or an entire class of CIs

Synchronize data using a technical service offering

CSDM  Data Foundations dashboard

The CSDM Data Foundations dashboard displays key CSDM  indicators on a single page to help 
you get the full benefit from your ServiceNow AI Platform  products.

Access the dashboard

Use either of the following methods to open the dashboard:

Navigate to All  > Configuration, and then select CSDM Data Foundations Dashboard.

1. In CMDB Workspace, navigate to Workspaces  > CMDB Workspace.

2. Select Management  in the CMDB Workspace  menu bar.

3. Select CSDM Data Foundations Dashboard  in the Optimize section of the Management tools.

Select the change dashboard icon ( ) to toggle between the CSDM  and CMDB  dashboards.

Example

The reports on each tab display the data metrics that are appropriate for the maturity of your 
organization's CSDM  implementation stage (foundation, crawl, walk, run, and fly).  A label on each 
report identifies the metric being displayed.

In this example, a report on the Run  tab indicates that several business service offerings don't 
have the required relationships to application services. With this knowledge, Service owners can 
add the relationships to ensure that customer service agents get complete information on the 
upstream impacts of applications that are down.
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Tabs on the dashboard

• The Foundation domain involves tables that contain base data that is referenced from or 
to objects in the other CSDM  domains. Foundation data is required before you can use 
ServiceNow  products or add data to the CMDB.  See 'Foundation' stage reports on the CSDM 
Data Foundations dashboard.

• In the Crawl stage, you work on base-system  CMDB  tables that are associated with IT Service 
Management  (ITSM).  See 'Crawl' stage reports on the CSDM Data Foundations dashboard.

• In the Walk stage, you identify and populate the network infrastructure CIs and applications 
that your organization's technical teams support.  See 'Walk' stage reports on the CSDM Data 
Foundations dashboard.

• In the Run stage, you set up the relationship between a technology and the business that sells 
and/or consumes the technology.  See 'Run' stage reports on the CSDM Data Foundations 
dashboard.

• When you reach the Fly stage, you've accomplished all or most of the process of implementing 
the CSDM  framework. The fly stage completes the process.  See 'Fly' stage reports on the 
CSDM Data Foundations dashboard.

Managing performance of data collection

The system runs scheduled jobs that collect data for three CSDM  metrics:
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• App services that are missing a business app relationship

• Business apps that are missing an app service relationship

• App services where the relationship to business apps is not Consumed by

To ensure optimum performance, the system stops collecting data for some metrics when 
a specified number of non-compliant CIs is discovered. For information on managing data 
collection for a metric that isn't needed or that affects performance of the dashboard, see 
Manage performance.

Related topics

Configure the CSDM Data Foundations dashboard

Monitor system foundations in the CSDM and the CMDB Data Foundations Dashboards

Specifying attributes and relationships for Application Services

Use the Application Service Settings module to specify the attributes and relationships that are 
required when a user creates an application service.

Configuring the Application Service Settings

Navigate to CSDM  > Application Service Settings  to access the form. For instructions, see 
Modify the attributes and relationships required for application services.

Monitoring and managing application services

The Application services dashboard enables you to monitor and manage application services to 
ensure that application services are fully configured and are populated in the CMDB.
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Viewing application service reports

A report on the dashboard, for example, can direct you to an application service that is not 
configured with a service population method so you can repair it. For more information, see 
Monitor the health of application services in the Application Service Dashboard.

You have two options:

View the Application Service dashboard on CMDB  Insights

To view the dashboard in the Insights view, select CMDB Workspace, select the Insights icon 

( ), and then select the Application services  tile. See Insights view in CMDB Workspace.

View the Application Service dashboard

To view the dashboard, navigate to All  > CSDM  > Application Service Dashboard.
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Synchronizing group assignment attributes

To empower a particular user group to manage a collection of CIs or CI classes, set group 
assignment attributes through the technical service offering or the CI Class Manager. The 
operation synchronizes the group attribute data across all CIs that belong to the specified CI 
class or groups of CIs.

Methods for synchronizing group assignment attributes

• Synchronize data using a technical service offering: Directly set the Support group, Change 
group, or Managed by group  attributes in a technical service offering. The settings are applied 
to CIs that are associated with the technical service offering.

• Set the group for a CI or an entire class of CIs: Set the Managed by group  attribute for a 
specific class in the CI Class Manager. All CIs within the class will have their Managed by 
group  field populated based on the value specified in the CI Class Manager. With this method, 
the Managed by group  setting is applied only to the CIs that aren’t associated with a technical 
service offering. For CIs that are managed by a technical service offering, the Managed by 
group  field is first synchronized with its dynamic CI group. This field is then synchronized with 
the CIs that are part of that dynamic CI group, overwriting the entry from the CI Class Manager.

• Use Support Group and Change Group: By using dynamic CI groups, data synchronization 
enables you to manage data that cannot be discovered. The values in the Support Group 
and Change Group  (previously labeled Assignment Group) fields in the cmdb_ci table are 
synchronized with their related dynamic CI groups and with all the CIs that are contained as 
part of that dynamic CI group object.
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Team data synchronization

Related topics

CI Class Manager

Set the group for a CI or an entire class of CIs

Synchronize group assignment attributes on entire CI classes and individual CIs using the CI 
Class Manager.

Before you begin
Role required: itil and itil_admin

About this task
Set the Managed by group  attribute for a specific class in the CI Class Manager. All CIs within 
the class will have their Managed by group  field populated based on the value specified in the 
CI Class Manager. With this method, the Managed by group  setting is applied only to the CIs 
that aren’t associated with a technical service offering. For CIs that are managed by a technical 
service offering, the Managed by group  field is first synchronized with its dynamic CI group. This 
field is then synchronized with the CIs that are part of that dynamic CI group, overwriting the 
entry from the CI Class Manager.

Procedure

1. Navigate to All  > Configuration  > CI Class Manager.

2. Select Hierarchy  to expand the CI Classes list, select a class to display details for, and then 
select Basic Info.

3. Specify the value in the Managed by Group  attribute and select Save.

4. To verify the change, select CI List.
The change should be applied to the Managed by Group  attribute of all CIs of this class unless 
they are associated with a technical service offering. The change is applied only to the CIs in 
the class and not to the sub classes under a CI.

Example:
As an itil_admin, you can define a user group that can manage all CIs belonging to a specific 
class by following these steps:

1. Navigate to the CI Class Manager and select the Linux Server  class in the list.

2. Select Basic Info  and, in the Managed By Group attribute, select sys_user_group  and then 
select Save.

3. To verify that the attribute was updated, select CI List  and navigate to the Linux Server class. 
You will see that the Managed By Group  attribute has been updated to sys_user_group.
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Synchronize data using a technical service offering

Synchronize group assignment attributes on entire CI classes and individual CIs that use a 
technical service offering.

Before you begin
Role required: itil and itil_admin

About this task
Directly set the Support group, Change group, or Managed by group  attributes in a technical 
service offering. The settings are applied to CIs that are associated with the technical service 
offering.

Procedure

1. Navigate to All  > Configuration  > CMDB Groups  and create a new CMDB  group.
See CMDB groups  for details.

2. Navigate to All  > Configuration  > Dynamic CI Groups.

3. Create a new Dynamic CI group and associate it with the CMDB  group that you created.

See Manage Technical Services domain of the CSDM framework  for more information on 
Dynamic CI groups.

4. Navigate to All  > CSDM  > Technical Service Offering  and create a new technical service 
offering.
See Manage Technical Services domain of the CSDM framework  for more information on 
technical service offerings.

5. Navigate to the CI Relationships  table and select New  and enter the following values:

◦ Parent: Select the technical service offering you created.

◦ Child: Select the Dynamic CI group you created.
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6. Select Submit.
You have created a relationship between the technical service offering and the Dynamic CI 
group.

7. Navigate to All  > CSDM  > Technical Service Offering  and open the technical service offering 
that you created.

8. Enter values in the following fields:

◦ Support group

◦ Change group

◦ Managed by group

9. Right-click the header and select Save.
A message confirms that data synchronization has been enabled for the fields.
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10. The values that you specified are applied to the related Dynamic CI group and all associated 
CIs.

Note: 

◦ If a new CI is added to the class, the data will be synchronized only after the scheduled 
CSDM Data Sync job is completed. If you need to synchronize the data immediately, 
navigate to Scheduled Jobs  > CSDM Data Sync  and select Execute.

◦ The Managed by Group  field might be populated in both the CI Class Manager and the 
technical service offering. In this case, the value specified in the Managed by Group 
field in the technical service offering takes precedence.

Applying the CSDM  guidelines to your product

The "Product view" topics describe how several ServiceNow  products benefit from your use of 
the Common Service Data Model  (CSDM) framework.

Products and features that benefit when following the CSDM  guidelines

The following topics identify the specific CMDB  tables that the products update and obtain data 
from. The topics provide practical instructions for implementing the CSDM  guidelines.

Change Management

Applying CSDM guidelines to Change Management

Customer Service Management

Customer Service Management product view

Digital Portfolio Management

Apply the CSDM guidelines to Digital Portfolio Management

Enterprise Architecture  (EA) (formerly Application Portfolio Management)

Applying the CSDM  guidelines to Enterprise Architecture

Incident Management

Applying CSDM guidelines to Incident Management

Install Base Management

Common Service Data Model framework for Install Base Management

ITOM AIOps

ITOM AIOps and CSDM reference

ITOM Visibility

Applying the CSDM  guidelines to ITOM Visibility

Operational Technology

Implementing the CSDM framework for Operational Technology

Problem Management

Applying the CSDM  guidelines to Problem Management

RPA Hub

Applying the CSDM guidelines to RPA Hub

Service Catalog

Applying the CSDM  guidelines to Service Catalog

Service Portfolio Management
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Applying the CSDM guidelines to Service Portfolio Management

The topics include the following information:

• Brief overview of the function and benefits of the product.

• Use case and examples.

• CSDM  tables managed by the product.

• CSDM  tables used by the product.

• Mention of other ServiceNow  products that add value to the product.

• Mention of other ServiceNow  products that benefit from the product.

Note: 
A CSDM  use case might have one or more data types. Other ServiceNow  products 
may also manage these data types. The use cases don't describe all possible product 
dependencies.

The product view topics do not address the following information:

• Implementing the ServiceNow  product.

• Configuring systems that are not included in the base system. Such systems might be referred 
to in this product view, but they are out-of-scope.

• Using other ServiceNow  products, such as IT Service Management  (ITSM), Strategic Portfolio 
Management (SPM), and IT Operations Management  (ITOM).

CSDM videos in the ServiceNow Community

Playlist of all CSDM videos

Problem Management  product view

Problem Management  helps identify the cause of an error in the IT infrastructure, reported as 
occurrences of related incidents. The goal of this product view is to help you to understand how 
Problem Management  key entities work with the core CSDM  framework.

With Problem Management  you can perform the following actions:

• Document the root cause of an error and resolve it permanently.

• Create known error articles from a problem to provide guidance and help deflect incidents.

• Collaborate on problem tasks with other teams to identify the root cause using a drag-and-
drop functionality on visual task boards.

The Problem Management  form references the following CSDM  elements (attributes and related 
views).

1. Service — References the [cmdb_ci_service_business] table.

Note: 
Earlier releases labeled this attribute Business Service.

2. Service Offering — References the [service_offering] table to see the service offerings affected 
by the problem in the Service Offerings related list [task_service_offering].

3. Configuration Items — References the [cmdb_ci] table

4. Affected/Causal CIs — Related list [task_ci] table

5. Impacted Services — Related list [task_cmdb_ci_service] table
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Change Request form

Problem Management  and CSDM  tables

Problem Management  manages and uses CSDM  tables. Several ServiceNow  products benefit 
from and add value to Problem Management.

CSDM  tables used by Problem Management

1. Application Service table [cmdb_ci_discovered_service]: Application Service or any 
infrastructure CI

2. Configuration Item tables [cmdb_ci*]

3. Business Service [cmdb_ci_service_business] table and Technical service 
[cmdb_ci_service_technical] table: Use the service classification attribute to identify business 
services and technical services.

4. Service Offering table [service_offering]: Utilized as a choice list attribute to filter types of 
service offerings like Business Service, Technical Service, and Application Service.
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Products that add value to Problem Management

When you use Problem Management  with one of the following ServiceNow  products, you 
increase the value you get from Problem Management.

• Discovery  provides details about the hardware and software CIs you are using.

• Service Portfolio Management  provides life-cycle information for a service.

• Asset Management provides the related product model. Software Asset Management  (SAM 
Foundation ) and Hardware Asset Management (HAM) provide life-cycle data for Technology 
Portfolio Management.

• Security Management provides initial information to containment, eradication, and recovery of 
security related problems.

• Risk Management  provides IT risk and financial risk information.

Products that benefit from APM

• IT Service Management  (ITSM): Services have the context of the business and applications, 
along with the information and technologies layered beneath them.

• Information Technology Operations Management  (ITOM): Understands the business context 
for the application services along with the hardware and software being managed.

• Governance, Risk, and Compliance  (GRC): Auditors can leverage the business applications 
and related Information Objects. This helps auditors understand the design-time data 
sensitivity for scoping audits, measuring risks, and managing audit activities.

• Asset Management: Manages the software and hardware life cycles for business applications 
and business services.

Problem Management  use case

The Problem Management  use case is described in this section.

Problem Management  is used to prevent problems and the occurrence of resulting incidents. It 
also aims at eliminating recurring incidents and minimizing the impact of incidents that cannot 
be prevented. With Problem Management, you can capture information on affected configuration 
items (CIs), with type as asset, in a problem to keep a record of the updated, repaired, swapped, 
or retired configuration items. By keeping track of the assets, you can identify the location of the 
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assets, their usage and when the assets were changed. Using Problem Management, you to 
monitor and manage the assets in your company using a systematic approach.

If a configuration item (CI) has resulted in a problem, use the dependency view to identify other 
configuration items (CIs) affected by the CI that caused the problem. You can then associate 
affected configuration items (CIs) with a problem record to find out how the problem affects other 
CIs with dependent relationships.

Key features of the Problem Management  use case

The CMDB, when used by the CSDM  framework, provides value to Problem Management  in the 
following ways:

• Understand the impact of the problem on services and service offerings.​

• Dynamically route problems.

• Identify one or more impacted services to address the problem.​

The CSDM  data elements used in Problem Management  are:

1. Subscription: Related lists on service offerings that identify who has access to the offering and 
thus may be impacted in an outage. A problem can identify impact using the subscribed by 
tables. The related lists are as follows:

◦ Service Subscriptions by Company [service_subscribe_company]

◦ Service Subscriptions by Department [service_subscribe_department]

◦ Service Subscriptions by Group [service_subscribe_sys_user_grp]

◦ Service Subscriptions by Location [service_subscribe_location]

◦ Service Subscriptions by User [service_subscribe_sys_user]

2. Business service offering may be used by problems to provide the business approver based 
on approval_group and business_criticality. A business service may have multiple offerings, 
each with a different criticality.

3. Technical service offering may be used by problems to provide the technical approver 
approval_group and technical assignment group on the attribute assignment_group.
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4. Application service may be used to provide prod and non-prod (DEV, QA, UAT, etc.) 
environments. Non-prod environments may be filtered out if desired. The legacy used_for 
attribute maps to the environment  attribute. You should use the environment  attribute.

Note: 
Some service offerings may identify the environment of the offering as well.

Results of the Problem Management  use case

The CSDM  framework provides Problem Management  context for problems on what CIs may be 
involved.

To determine the impact and root cause, compete the following steps:

1. Populate the Configuration Item attribute on the Problem form, configuration_item, with the CI 
item or service affected.

2. (Optional) Use the Service and Service Offering attributes on the Problem form to help narrow 
down the list of configuration items to choose from. This feature is not available with the base 
system  and needs additional configuration.

3. (Optional) Use the Affected CI related list to identify the CIs that may have caused the problem.

Problem Management  considerations

Consider these points while implementing the CSDM  framework.

• Application Service: An application service is a service type that is a logical representation of a 
deployed application stack.

• Using application service for a problem: Some of the scenarios where the application service 
can be used for a problem include:

◦ The problem is for an application issue: In this scenario the application service may be 
populated in the configuration_item attribute on the Problem form representing the unique 
deployment of an application stack. For example, the application service of MyApp 3.0 Prod 
has been reported as being unavailable.

◦ The problem on an infrastructure CI is impacting devices. In this scenario the 
application service may be populated on the problem’s Impacted Services related list, 
task_cmdb_ci_service, to identify the Application Service as one of the impacted services. 
For example, the Server Acme42 may be impacting my Application Service of MyApp 3.0 
Prod and other related services.

Service Catalog  product view

The Service Catalog  lets you create other catalogs (such as the Request Catalog and the Product 
Catalog) that provide self-service opportunities in the channel you want to use, such as the 
self-service portal, the mobile app, or the Virtual Agent  (conventional interface). The goal of this 
product view is to help you to understand how Service Catalog  key entities work with the core 
CSDM  framework.

You can create catalog items that can be used submit requests such as service and product 
offerings. You can also standardize request fulfillment to ensure the accuracy and availability of 
the items in the catalogs.

In addition to offerings that are fulfilled using Request Management application for IT, you can 
use Service Catalog  Record Producers to submit requests or tickets in non-IT applications such 
as HR, Legal, Facilities and any record in any custom application.

For implementation details, see Service Catalog.
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Service Catalog  and CSDM  tables

Service Catalog  manages and uses CSDM  tables. Several ServiceNow  products benefit from and 
add value to Service Catalog.

CSDM  tables managed by the Service Catalog

The Service Catalog  primarily manages business services in the Sell/Consume domain. 
Technical Services are also viewed from the Operate domain of Event Management.

The Service Catalog  manages the Catalog Item table [sc_cat_item]. The Catalog Item table 
creates requests in Request Management. The requests usually have an automated, semi-
automated, or business workflow for fulfilling the request, which can consist of approvals and 
tasks. When part of Service Portfolio Management, the CIs are associated with service offerings. 
When you link a catalog item, you can track request activity for all catalog items associated with a 
service offering. An offering can have multiple catalog items.

The CIs can include:

• PC Hardware Item (pc_hardware_cat_item): Submits hardware asset requests included in 
Asset Management  workflows.

• PC Software Item (pc_software_cat_item): Submits software asset requests included in Asset 
Management  workflows.

• Record Producer (sc_cat_item_producer): Submits requests or generates records other than 
Request Management tables for services that aren't serviced by Request Management (for 
example, HR Cases, Facilities Requests, or Legal Requests).

CSDM  tables managed by the Service Catalog

CSDM  tables used by the Service Catalog

1. Configuration Item tables [cmdb_ci*]

2. Service Offering table [sc_cat_item_subscribe]

3. Application Service table [cmdb_ci_discovered_service]

4. Product Model tables [cmdb_model]
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Note: 
The following legacy CMDB  relationships that once provided access to catalog items are 
no longer supported. To provide access, use the new relationships listed in the table.

Relationship tables

CMDB  table Catalog item relationship table New relationship to use instead

User (sys_user) sc_cat_item_user_mtom, 
sc_cat_item_user_no_mtom

User criteria

Group (sys_user_group) sc_cat_item_group_mtom, 
sc_cat_item_group_no_mtom

User criteria

Department 
(cmn_department)

sc_cat_item_dept_mtom, 
sc_cat_item_dept_no_mtom

User criteria

Location (smn_location) sc_cat_item_location_mtom, 
sc_cat_item_location_no_mtom

User criteria

Company (core_company) sc_cat_item_company_mtom, 
sc_cat_item_company_no_mtom

User criteria

CSDM  tables used by the Service Catalog

Products that benefit from the Service Catalog

Service Portfolio Management  (Service Portfolio Management)

Ties catalog items to service offerings. Lets service owners create and maintain 
catalog items more easily, and gives more visibility into the service offerings.

Hardware Asset Management  and Software Asset Management

Self-service catalog lets you order an asset and track service delivery.

Human Resources (HR)
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Exposes the creator (Record Producer) of HR cases and displays the Record 
Producer in the relevant self-service catalogs (for example, Portal, Mobile, and 
Virtual Agent).

Customer Service Management  (CSM)

Exposes the creator (Record Producer) of customer service cases and displays 
the Record Producer in the relevant self-service catalogs (for example, Self-service 
Portal, Mobile, and Virtual Agent).

Service Catalog  use case

You can create customized catalogs where you can request items such as a specific service or 
product. With this use case, CSDM  provides Service Catalog  connection to the service offerings 
and services.

Service Catalog  use case

Catalogs contain catalog items and are the starting points for accessing available services. 
Request Catalogs and Product Catalogs are two of the customized catalogs you can create from 
the Service Catalog. For details, see Service Catalog.

• A Request Catalog is a list of business and technical products, services, service commitment 
options, and offerings that you can order.

• A Product Catalog  is a set of information about individual models. A model is a specific 
version or configuration of an asset. Asset managers use the Product Catalog  as a centralized 
repository for model information.

Key features of the Service Catalog  use case

Digital Portfolio Management (DPM)  uses the CSDM  framework to navigate the Service Portfolio. 
You can then use the Service Portfolio to locate the services and their related service offerings, 
catalog items, dependents, dependencies, metric roll-ups, costs and initiatives. The associated 
metrics are aggregated using the CSDM  framework with the related tables.

Catalog items

A catalog item is an item or a service that you can request from the catalog. A service can contain 
multiple catalog items. Catalog items are listed on the catalog portal and are available to the 
users who need them (either through subscription or job responsibility). Each catalog item is 
linked to one service offering.

The Catalog Item form includes the following tabs.

• Item Details: Description of the catalog item.

• Process Engine: The defined process used to fulfill the catalog Item request.

• Picture: Picture used to represent the catalog item when it appears in the catalog.

• Pricing: Pricing details for the catalog item.

• Portal Settings: Provides specific settings on how you interact with the catalog item in the 
catalog portal.
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Catalog Item form

Product Catalog  use case

Use the Product Catalog  to specify information about a product model. Product models are 
specific versions or configurations of an asset. Asset managers use the Product Catalog  as a 
centralized repository for model information.

A detailed and well-maintained Product Catalog  can coordinate with the Service Catalog, asset, 
procurement, request, contract, and vendor information. Models published to the Product 
Catalog  are automatically published to the Service Catalog. The Service Catalog  includes 
information about goods (models) and services. If the model is available from multiple vendors, a 
model can be listed more than once. Models are included with Asset Management.

Key features of the Product Catalog  use case

This use case lets you include hardware and software product information as items in the 
Product Catalog.
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Product Catalog  items

Results of Product Catalog  use case

The CSDM  framework ensures that product models are available in the catalog and that there are 
processes defined to consume the models.

Service Catalog  considerations

Consider these points while implementing the CSDM  framework.

• The Product Catalog  builds on the Service Catalog. Product catalogs specify the product 
models that are available for use. Product-specific attributes are captured in each catalog item. 
You can create product catalogs for each type of products in your portfolio.

• You can create catalog types that reflect the types of offered products and services.

CSDM  reference

Reference topics provide detailed descriptions of tables, properties, forms, and roles that are 
used in the CSDM  framework.

Basics

CSDM terms

CI relationships in the CSDM

How CSDM concepts map to CMDB tables

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

724



Life cycles

Document life cycle

Hardware life cycle

Location life cycle

Logical life cycle

Product life cycle

CSDM  terms

Most ServiceNow  products and ServiceNow AI Platform  applications align closely with the 
Common Service Data Model. This table defines terms as they are used across the ServiceNow 
AI Platform  and products.

Common CSDM  terms

Term Definition Notes

Application Any deployed program, 
module, or group of 
programs that is designed 
to provide specific 
functionality on a computer 
infrastructure.

Defines behavior and has specific functionality 
associated with it. Applications are typically 
discoverable functionality, like Apache  Web 
Server.

Application 
service

A service type that is a 
logical representation of a 
deployed application stack.

Examples of application services are hosting, data 
backup, and recovery.

Note: 
Applications and application services do 
not have a one-to-one relationship. An 
application service can include multiple 
applications. An application can be included 
in multiple application services.

Asset An item whose financial 
value is tracked.

Many assets are CIs and vice versa, but that is 
not always the case. Assets have a life cycle with 
financial considerations, for example, Microsoft 
365.

Business 
Application

Represents all software and 
infrastructure environments 
(dev, test, prod) that are 
configured to provide 
functionality.

Used to increase productivity and perform other 
business functions accurately. For example, Dell 
Online.

Business 
capability

High-level capability that 
an organization requires to 
execute its business model 
or fulfill its mission.

Typically described in the context of performing 
one or more specific tasks to achieve business 
outcomes. For example, demand management or 
financial planning.

Business 
service

A business service is 
a service type that is 
published to business 
users. A business service 

Usually, business users order business services. 
Business users can select the desired offering 
and service commitment levels via the Service 
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Common CSDM  terms  (continued)

Term Definition Notes

typically implements one or 
more business capabilities.

Catalog. For example, procurement, shipping, and 
finance.

• A business service is an operational CI.

• A business service must be a one-level service 
and not a hierarchy of business services.

• A business service can be used for impact 
in Incident, Problem, and Change and for 
approvals for Change.

• A business service must be focused on the 
consumer or seller.

Configuration 
item (CI)

Physical and logical 
components of an 
infrastructure that are 
currently or soon will 
be under configuration 
management.

Might be a single module such as a server, 
database, or router or a more complex item, such 
as a complete system. For example, a web server, 
database, or infrastructure.

Operating 
model

An abstract and ideally 
visual representation 
(model) of how an 
organization delivers 
value to its customers or 
beneficiaries.

Typically represents the various elements of how 
an organization operates. It usually incorporates 
strategy positions such as the innovation model, 
degree of intelligent automation, industry 
alignment, provider delivery models, and the 
business expectations of IT.

Portfolio Collection of services, 
products, projects, or 
applications.

Used to manage like items together for a 
business. Portfolios may be grouped by objective, 
capabilities, organization, like projects, or 
services.

Service Means of delivering value 
to customers by facilitating 
outcomes that users want 
to achieve without the 
ownership of specific costs 
and risks.

Typically has three aspects:

• Interaction

• Offering

• Service system

ServiceNow  provides three base service types:

• Business

• Technical

• Application

You can extend the base types to align with the 
service types in your organization.

Service 
catalog

Provides consumable 
view of available products, 
services, service 
commitment options, and 
offerings.

Helps manage which services a user may have 
access to. Also, catalogs are the starting point 
for access to available services. For example, IT 
services catalog.
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Common CSDM  terms  (continued)

Term Definition Notes

Service 
commitment

Defines the service delivery 
obligations agreed to 
between the consumer and 
the provider.

Often manifested in the form of contracts such 
as service level agreements, operational level 
agreements, and underpinning contracts. Service 
commitments include specific performance 
characteristics that differentiate one offering from 
another.

Service 
offering

A stratification of a service 
into capability, availability, 
pricing, and packaging 
options.

Different levels of performance and features for a 
given service can be made available. For example, 
ITSM  Standard and ITSM  Pro.

Technical 
service

A service type that is 
published to service 
owners and typically 
underpins a business or 
application service.

Typically orderable by service owners. Service 
owners are able to select the desired offering 
and service commitment levels via the Service 
Catalog. For example, computers, storage, and 
networks).

CI relationships in the CSDM

For configuration management to be most effective, establish relationships between the objects 
and configuration items (CIs) in the conceptual CSDM.

Required CSDM  relationships

• Most features and products, such as the Technology Portfolio Management risk assessment 
and Application Portfolio Management  (APM), depend on the relationships.

• The relationships commonly created as part of Service Mapping  and Discovery  are the 
standard for infrastructure CIs. If you map the elements manually, be sure to consider how 
Discovery  would have treated them.

• Not all objects in the CSDM  conceptual model are CMDB  tables, and not all the objects have 
relationships. You may need to create some of the following required relationships.
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Note: 
Business services and technical services connect to the spm_service_portfolio through the 
spm_taxonomy_node. See Service Portfolio Management taxonomy .

Creating relationships between CIs

See CI relationships in the CMDB  for information on creating relationships between CIs.

Resources in the ServiceNow Community

For an extended explanation of the business application reference attribute's role in managing 
platforms from a CSDM  perspective, see this article  in the ServiceNow  community.

Playlist of all videos

How CSDM  concepts map to CMDB  tables

The objects in the conceptual CSDM  framework must map to the physical model objects (CIs 
and CI class tables) in the CMDB.
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Note: 
Business services and technical services connect to the spm_service_portfolio through the 
spm_taxonomy_node. See Service Portfolio Management taxonomy .

CSDM videos in the ServiceNow Community

Playlist of all videos

'Foundation' stage reports on the CSDM  Data Foundations dashboard

Foundation domain reports on the CSDM  Data Foundations dashboard

Reports on the Foundation tab

In this example, a report on the Foundation  tab indicates that most named product models don't 
have associate product owners. Without this data, you might not be able, for example, to identify 
products that are reaching end-of-life. For details, see Products and product models.
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CSDM Foundation Indicators report

• The Priority  value is the product of the weight of the metric and the severity of the 
actual score. Priority ranges from 1 — Critical (the highest priority), to 5 — Low (the 
lowest priority).

• The Result  column displays a color-coded bar showing the percentage of CIs or 
the measured item that are in compliance for the key foundational metric.

◦ Red: 0–50% are in compliance.

◦ Yellow: 50–90% are in compliance.

◦ Green: More than 90% are in compliance.

To ensure optimum performance, the system stops collecting data for some 
metrics when they reach a specified number of non-compliant CIs. For 
information on managing data collection for a metric that isn't needed or that 
affects performance of the dashboard, see Manage performance.

• The Remediation playbook URL  column displays links to knowledge articles in 
Now Support  with instructions for bringing the CIs into compliance. Use your Now 
Support  credentials to access the knowledge article.

To view detailed information on the impact of a metric and for details on working on issues, 
select the appropriate Remediation playbook URL.

Named product models without product

For details, see Products and product models.

Locations without parents
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You can create a hierarchy of location data using the Parent  attribute to match 
your reporting requirements. Missing parent locations break the structure. See 
Location table [cmn_location].

Business units without companies

The hierarchy of your business is populated in the Business Unit table with a 
reference to the parent company. A business unit is a part of your organization that 
is responsible for specific operations, such as finance, human resources (HR), or IT. 
A hierarchy within a business unit is common. For large multinational organizations, 
you may have business units that identify independent regional operations and the 
specific operations within the region.

Related topics

CSDM Data Foundations dashboard

'Crawl' stage reports on the CSDM  Data Foundations dashboard

Crawl stage reports on the CSDM  Data Foundations dashboard

Reports on the Crawl tab

In this example, a report on the Crawl  tab indicates that there are application services that are 
not associated with a business application.

CSDM Foundation Indicators report

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

731



• The Priority  value is the product of the weight of the metric and the severity of the 
actual score. Priority ranges from 1 — Critical (the highest priority), to 5 — Low (the 
lowest priority).

• The Result  column displays a color-coded bar showing the percentage of CIs or 
the measured item that are in compliance for the key foundational metric.

◦ Red: 0–50% are in compliance.

◦ Yellow: 50–90% are in compliance.

◦ Green: More than 90% are in compliance.

To ensure optimum performance, the system stops collecting data for some 
metrics when they reach a specified number of non-compliant CIs. For 
information on managing data collection for a metric that isn't needed or that 
affects performance of the dashboard, see Manage performance.

• The Remediation playbook URL  column displays links to knowledge articles in 
Now Support  with instructions for bringing the CIs into compliance. Use your Now 
Support  credentials to access the knowledge article.

To view detailed information on the impact of a metric and for details on working on issues, 
select the appropriate Remediation playbook URL.

App service to business app not Consumed by

The report identifies incorrect relationships.

App services missing business app relationship

Percent of CIs missing an important relationship. The application service is a base-
system  CMDB  table that should map to the related business application in use. 
Because the application service is typically the system that a caller identifies when 
they report an issue with an application, the relationship is requires if you are to 
identify the affected business application. For more information, see Monitor the 
health of application services on the Application Service Dashboard.

Business apps missing app service relationship

Percent of CIs missing an important relationship.

Managing performance of data collection

The system runs scheduled jobs that collect data for three CSDM  metrics:

• App services that are missing a business app relationship

• Business apps that are missing an app service relationship

• App services where the relationship to business apps is not Consumed by

To ensure optimum performance, the system stops collecting data for some metrics when 
a specified number of non-compliant CIs is discovered. For information on managing data 
collection for a metric that isn't needed or that affects performance of the dashboard, see 
Manage performance.

Related topics

CSDM Data Foundations dashboard

'Walk' stage reports on the CSDM  Data Foundations dashboard

Walk stage reports on the CSDM  Data Foundations dashboard
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Reports on the Walk tab

In this example, a report on the Walk  tab indicates that there are technical service offerings that 
are not associated with a support group. This indicates a risk that downtimes will take longer to 
remedy.

To view detailed information on the impact of a metric and for details on working on issues, 
select the appropriate Remediation playbook URL.

CSDM Foundation Indicators report

• The Priority  value is the product of the weight of the metric and the severity of the 
actual score. Priority ranges from 1 — Critical (the highest priority), to 5 — Low (the 
lowest priority).

• The Result  column displays a color-coded bar showing the percentage of CIs or 
the measured item that are in compliance for the key foundational metric.

◦ Red: 0–50% are in compliance.

◦ Yellow: 50–90% are in compliance.

◦ Green: More than 90% are in compliance.

To ensure optimum performance, the system stops collecting data for some 
metrics when they reach a specified number of non-compliant CIs. For 
information on managing data collection for a metric that isn't needed or that 
affects performance of the dashboard, see Manage performance.

• The Remediation playbook URL  column displays links to knowledge articles in 
Now Support  with instructions for bringing the CIs into compliance. Use your Now 
Support  credentials to access the knowledge article.
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Related topics

CSDM Data Foundations dashboard

'Run' stage reports on the CSDM  Data Foundations dashboard

Run stage reports on the CSDM  Data Foundations dashboard

Reports on the Run tab

In this example, a report on the Run  tab indicates that several business service offerings don't 
have the required relationships to application services. With this knowledge, Service owners can 
add the relationships to ensure that customer service agents get complete information on the 
upstream impacts of applications that are down.

To view detailed information on the impact of a metric and for details on working on issues, 
select the appropriate Remediation playbook URL.

CSDM Foundation Indicators report

• The Priority  value is the product of the weight of the metric and the severity of the 
actual score. Priority ranges from 1 — Critical (the highest priority), to 5 — Low (the 
lowest priority).

• The Result  column displays a color-coded bar showing the percentage of CIs or 
the measured item that are in compliance for the key foundational metric.
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◦ Red: 0–50% are in compliance.

◦ Yellow: 50–90% are in compliance.

◦ Green: More than 90% are in compliance.

To ensure optimum performance, the system stops collecting data for some 
metrics when they reach a specified number of non-compliant CIs. For 
information on managing data collection for a metric that isn't needed or that 
affects performance of the dashboard, see Manage performance.

• The Remediation playbook URL  column displays links to knowledge articles in 
Now Support  with instructions for bringing the CIs into compliance. Use your Now 
Support  credentials to access the knowledge article.

Managing performance of data collection

The system runs scheduled jobs that collect data for three CSDM  metrics:

• App services that are missing a business app relationship

• Business apps that are missing an app service relationship

• App services where the relationship to business apps is not Consumed by

To ensure optimum performance, the system stops collecting data for some metrics when 
a specified number of non-compliant CIs is discovered. For information on managing data 
collection for a metric that isn't needed or that affects performance of the dashboard, see 
Manage performance.

Related topics

CSDM Data Foundations dashboard

'Fly' stage reports on the CSDM  Data Foundations dashboard

Fly stage reports on the CSDM  Data Foundations dashboard

Reports on the Fly tab

In this example, a report on the Fly  tab indicates that there are information objects that are not 
associated with a business application.

To view detailed information on the impact of a metric and for details on working on issues, 
select the appropriate Remediation playbook URL.
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CSDM Foundation Indicators report

• The Priority  value is the product of the weight of the metric and the severity of the 
actual score. Priority ranges from 1 — Critical (the highest priority), to 5 — Low (the 
lowest priority).

• The Result  column displays a color-coded bar showing the percentage of CIs or 
the measured item that are in compliance for the key foundational metric.

◦ Red: 0–50% are in compliance.

◦ Yellow: 50–90% are in compliance.

◦ Green: More than 90% are in compliance.

To ensure optimum performance, the system stops collecting data for some 
metrics when they reach a specified number of non-compliant CIs. For 
information on managing data collection for a metric that isn't needed or that 
affects performance of the dashboard, see Manage performance.

• The Remediation playbook URL  column displays links to knowledge articles in 
Now Support  with instructions for bringing the CIs into compliance. Use your Now 
Support  credentials to access the knowledge article.

Note: 
Starting with the CSDM  Data Foundations dashboard v2.2, the following metrics no longer 
appear on the Fly  tab:

• Information objects missing an app service relationship

• Catalog request items related to service offerings

Related topics

CSDM Data Foundations dashboard
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Document life cycle

The CSDM  framework provides standard fields and values that you can use to track the life cycle 
of an asset or a CI.  The document life-cycle states represent the overall life cycle of document 
assets (contracts) and CIs (business process) as related to their products.

Document life-cycle states

A life-cycle state  is the combination life-cycle stage  and life-cycle status  of an asset or CI 
over the life cycle. For example, a document CI in the Operational  stage might change status 
over time from In Use  to Published  to Pending Retirement. A different document CI in the 
Operational  stage might go from the In Use  status directly to Pending Retirement  status without 
ever having been in the Published  status.

The stage and status values for documents are visible only in tables related to documents in 
Contract Management  and the CMDB.

Note: 
Based on the type of item, the [life_cycle_control] table specifies which life cycle stage 
values are available for each life cycle stage.

For additional information on how you can benefit from implementing life-cycle value pairs for 
CMDB  entities, see the 'life-cycle value pair' section in the 'Foundation domain' topic.

CSDM videos in the ServiceNow Community

Playlist of all videos

Hardware life cycle

The CSDM  framework provides standard fields and values that you can use to track the life cycle 
of an asset or a CI.  The hardware life-cycle states represent the overall life cycle of hardware 
assets and CIs as related to their products.

Hardware life-cycle states

Hardware assets are physical items that are stocked, for example servers, monitors, and 
keyboards. A life-cycle state  is the combination life-cycle stage  and life-cycle status  of an asset 
or CI over the life cycle. The stages and statuses for the hardware life-cycle process are visible 
only in hardware-related tables in Asset Management  and CMDB.
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The standard CSDM  life-cycle value pair covers all phases of a product instance life cycle.

• A Life cycle stage  is one of the broad phases that a CI moves through, from inception 
or procurement to retirement and end of life.

• Life cycle stage status  is the specific status of a CI within its current life cycle stage.

For example, a hardware CI in the Operational  stage might change status over time from In Use 
to In Maintenance  to End of Support. A different hardware CI might go from In Use  to End of 
Support  without ever having been in In Maintenance  status.

Note: 
Based on the type of item, the [life_cycle_control] table specifies which life cycle stage 
values are available for each life cycle stage.
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For additional information on how you can benefit from implementing life-cycle value pairs for 
CMDB  entities, see the 'life-cycle value pair' section in the 'Foundation domain' topic.

Holistic life cycle: CMDB  hardware tables (from cmdb_ci)​

CMDB  hardware tables​ CMDB  hardware table name​

Accessory​ cmdb_ci_acc​

Communication Device​ cmdb_ci_comm​

Computer Peripheral​ cmdb_ci_peripheral​

Computer Room AC​ cmdb_ci_crac​

Display Hardware​ cmdb_ci_display_hardware​

Facility Hardware​ cmdb_ci_facility_hardware​

Hardware​ cmdb_ci_hardware​

Imaging Hardware​ cmdb_ci_imaging_hardware​

IP Device​ cmdb_ci_ip_device​

Monitoring Equipment​ cmdb_ci_monitoring_hardware​

Network Adaptor​ cmdb_ci_network_adaptor​

Printing Hardware​ cmdb_ci_printing_hardware​

Rack​ cmdb_ci_rack​

Storage Device​ cmdb_ci_storage_device​

Example hardware classes

View attributes, identification rule, and other important schema structures for the CMDB 
Computer [cmdb_ci_computer] class. See Hardware [cmdb_ci_hardware] class.

How retiring an application service might affect a hardware CI

An application service is the logical representation of the underlying hardware and software 
CIs that work together to implement a business application or system. The application service 
represents an instance of the business application or system.

Hardware and software CIs are managed using the physical  life cycle states. Because an 
application service is a logical representation, it is managed as using the logical  life-cycle states. 
The physical hardware CIs that are part of the service map under an application service have 
their own life cycle, but they are related through the application services as a specific set of 
dependencies or decomposition.

Example 1: A hardware CI is not retired when the application service is retired

When an application service is retired, the associated hardware might not be 
retired. For example, the hardware might remain idle, unrelated to any application 
service, until it is reallocated for use by a new application service.

Example 2: A hardware CI is shared by multiple application services

In the common scenario of a shared database, multiple application services (each 
with a unique database schema) share a single database service. The database 
service runs on a single physical host.
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When one of the application services is retired, the database service and host 
cannot be retired. All of the other application services still depend on the database 
service that is running on the host.

CSDM videos in the ServiceNow Community

Playlist of all videos

Location life cycle

The CSDM  framework provides standard fields and values that you can use to track the life cycle 
of an asset or a CI.  The location life-cycle states represent the overall life cycle of a location 
within common data.

Location life-cycle states

A life-cycle state  is the combination life-cycle stage  and life-cycle status  of an asset or CI over 
the life cycle. For example, a location CI in the Operational  stage might change status over time 
from In Use  to Pending Retirement. A different location CI in the Operational  stage might go 
from the Available  status directly to Pending Retirement  status without ever having been in the 
In Use  status.

The stage and status values for locations are visible only in the common data locations table.

Note: 
Based on the type of item, the [life_cycle_control] table specifies which life cycle stage 
values are available for each life cycle stage.

For additional information on how you can benefit from implementing life-cycle value pairs for 
CMDB  entities, see the 'life-cycle value pair' section in the 'Foundation domain' topic.

CSDM videos in the ServiceNow Community

Playlist of all videos

Logical life cycle

The CSDM  framework provides standard fields and values that you can use to track the life cycle 
of an asset or a CI.  The logical life-cycle states represent the overall life cycle of logical assets 
and CIs as related to their products.
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Logical life-cycle states

A logical or software asset includes items like applications, services, and licenses.

A life-cycle state  is the combination life-cycle stage  and life-cycle status  of an asset or CI over 
the life cycle. For example, a logical CI in the Operational  stage might change status over time 
from In Use  to Pending Retirement  to End of Support. A different logical CI in the Operational 
stage might go from In Use  status directly to End of Support  status without ever having been in 
the Pending Retirement  status.

Note: 
A CI may be in the Operational  stage, but might no longer be supported by the vendor or 
publisher or third-party. That doesn’t mean, however, that it can be or should be retired.

The stage and status values logical items are visible only in tables related to logical items in 
Asset Management  and the CMDB.

Note: 
Based on the type of item, the [life_cycle_control] table specifies which life cycle stage 
values are available for each life cycle stage.

For additional information on how you can benefit from implementing life-cycle value pairs for 
CMDB  entities, see the 'life-cycle value pair' section in the 'Foundation domain' topic.

Application service life cycles

Because application services are logical in nature, they should use the Logical life-cycle value 
pairs. Application services follow the same life cycle guidance as any other logical CI.

Holistic Life cycle: CMDB  Logical Tables (from cmdb_ci)​

Logical life cycle tables

CMDB Logical table Table name

Application Cluster cmdb_ci_application_cluster

Batch Job cmdb_ci_batch_job
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Logical life cycle tables  (continued)

CMDB Logical table Table name

Business Application cmdb_ci_business_app

Business Capability cmdb_ci_business_capability

Business Process cmdb_ci_business_process

CIM Profiles cmdb_CIM_profile

Cloud Key Pair cmdb_ci_cloud_keu_pair

Cloud Mgmt Subnet cmdb_ci_subnet

Cloud Resouce Base cmdb ci resource base

Cluster cmdb_ci_cluster

Cluster Node cmdb_cil_cluster_node

Cluster Resource cmdb ci cluster resource

Cluster Virtual IP cmdb_ci_cluster_vip

Configuration File cmdb_ci_config_file

Database cmdb_ci_database

Database Catalog cmdb_ci_db_catalog

Datastore Disk cmdb_ci_vcenter_datastore_disk

Disk Partition cmdb_ci_disk_partition

DNS Name cmdb_ci_dns_name

DRS VM Config cmdb_ci_drs_vm_config

Endpoint cmdb_ci_endpoint

Environment cmdb_ci_environment

Fiber Channel Port cmdb_ci_fc_port

Information Object cmdb_ci_information_object

IP Address cmdb_ci_ip_address

IP Network cmdb_ci_ip_network

IP Phone cmdb_ci_ip_phone

IP Service Instance cmdb_ci_ip_ service

Load Balancer Interface cmdb_ci_Ib_interface

Load Balancer Pool cmdb_ci_Ib_pool

Load Balancer Pool Member cmdb_ci_Ib_pool_member

Load Balancer Service cmdb_ci_Ib_ service

Load Balancer VLAN cmdb_ci_Ib _vlan

Logical Partition cmdb_ci_lpar

Memory Module cmdb_ci_memory_module

Network Appliance Hostname cmdb_ci_net_app_host
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Logical life cycle tables  (continued)

CMDB Logical table Table name

Network Hostname cmdb_ci_network_host

Network Traffic cmdb_ci_net_traffic

Operating System Level Virtualization Container cmdb_ci_oslv_container

Operating System Level Virtualization Image cmdb_ci_osiv_image

Operating System Level Virtualization Image TAg cmdb_ci_oslv_image_tag

Operating System Level Virtualization Local Image cmdb_ci _oslv _local_image

Package cmdb_ci_os_packages

Patch cmdb_ci_patches

Port cmdb_ci_port

Print Queue cmdb_ci_print_queue

Qualifier cmdb_ci_qualifier

SAN Connection cmdb_ci_san_connection

SAN Endpoint cmdb_ci_san_endpoint

SAN Fabric cmdb ci san fabric

SAN Zone cmdb_ci_san_zone

SAN Zone Alias cmdb_ci_san_zone_alias

SAN Zone Alias Member cmdb_ci_san_zone_alias_member

SAN Zone Member cmdb_ci_san_zone_member

SAN Zone Set cmdb_ci_san_zone_set

Service cmdb_ci_service

Storage Area Network cmdb_ci_san

Storage Controller cmdb_ci_storage_controller

Storage Export cmdb_ci_storage_export

Storage File Share cmdb_ci_storage_fileshare

Storage HBA cmdb_ci_storage_hba

Storage Pool cmdb_ci_storage_pool

Storage Pool Member cmdb_ci_storage_pool_member

Storage Volume cmdb_ci _storage_volume

Tomcat Connector cmdb_ci_tomcat_connector

UPS Bypass cmdb_ci_ups_bypass

UPS Alarm cmdb_ci_ups_alarm

UPS Input cmdb_ci_ups_input

UPS Output cmdb_ci_ups_output

Veritas Disk Group cmdb_ci_veritas_disk_group
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Logical life cycle tables  (continued)

CMDB Logical table Table name

Virtual Machine Object cmdb_ci_vm_object

Virtual Private Cloud cmdb_ci_vpc

Virtual Private Network cmdb_ci_vpn

Websphere Cell cmdb_ci_websphere_cell

CSDM videos in the ServiceNow Community

Playlist of all videos

Product life cycle

The CSDM  framework provides standard fields and values that you can use to track the life cycle 
of an asset or a CI.  The product life-cycle states represent the overall life cycle of a product 
model, a specific version, or a product configuration.

Product life-cycle states

A life-cycle state  is the combination life cycle stage  and life cycle stage status  of an asset or 
CI over the life cycle. For example, a product CI in the Operational  stage might change status 
over time from Available  to Pending Retirement  to End of Support. A different product CI in 
the Operational  stage might go from the Available  status directly to the End of Support  status 
without ever having been in the Pending Retirement  status.

Note: 
Based on the type of item, the [life_cycle_control] table specifies which life cycle stage 
values are available for each life cycle stage.

For additional details on products, see Products and product models.

For additional information on how you can benefit from implementing life-cycle value pairs for 
CMDB  entities, see the 'life-cycle value pair' section in the 'Foundation domain' topic.

CSDM videos in the ServiceNow Community

Playlist of all videos
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Life cycle mapping form

Use the Life Cycle Mapping module to specify how existing legacy status values should be 
converted to CSDM  life-cycle value pairs. You map both asset and CI legacy status values to life-
cycle values.

Fields on the Life cycle mapping form

Field Description

Mapping for table Legacy CMDB  table and descending tables 
that this mapping applies to.

Applies to a descending table unless there 
is a mapping configured specifically to the 
descending table.

Priority
Priority of applying this mapping definition for 
the table.

Priority is used when the life_cycle_mapping 
table contains multiple entries for a class. 
The highest priority entry is used first when 
searching for meaningful legacy values. If the 
first entry can't be used, the next record in 
priority is used.

Lower numerical values indicate higher 
priority.

Active
Denotes whether to apply this mapping 
definition.

Deactivation results in lower-priority mappings 
being used or setting standard life cycle fields 
to TBD.

Legacy field name Legacy field in the specified Mapping for 
table  that is currently being used to store a 
life cycle stage. The value should be used as 
the source for the life cycle mapping.

Legacy field value Legacy value in the specified Mapping for 
table  that is currently being used store life 
cycle status. The value should be used as the 
source for the life cycle mapping.

Legacy subfield name Legacy field in the specified Mapping 
for table  that is also used for life cycle 
management.

Legacy subfield value Additional legacy value in the specified 
Mapping for table  that is also used for 
life cycle management.
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Field Description

Life cycle control Class and life cycle stage and status, that 
are used as the authoritative source of valid 
combinations for life cycle mapping.

Table Standard life cycle table to map the specified 
Mapping for table  to. Setting is based on the 
selection in Life cycle control.

Lifecycle stage
Standard life cycle stage to map the specified 
Legacy field name  to. Setting is based on the 
selection in Life cycle control.

If there is no match in the life_cycle_mapping 
table, value is set to TBD.

Lifecycle stage status
Standard life cycle stage value to map the 
specified Legacy field value  to. Setting is 
based on the selection in Life cycle control.

If there is no match in the life_cycle_mapping 
table, value is set to TBD.

Application services
Understand application services, learn about different application service types and how 
multiple ServiceNow®  business units and products use them.

What application services are

Warning: 
To ensure optimal performance and functionality of your instance, it is best practice to 
limit the number of application services to 100,000. Exceeding this number might lead to 
performance issues. If you need to exceed this limit, contact your account representative 
for assistance.

An application service is a set of interconnected applications and hosts which are configured to 
offer a service to the organization. Application services can be internal, like an organization email 
system or customer-facing, like an organization website.  For example, creating financial reports 
through a web-based application requires a computer, web server, application server, databases, 
middleware, and network infrastructure. These applications and hosts are all configured to 
offer the service of financial reporting.  In development environments, an application service 
represents an instance of a business application or system.

ServiceNow  applications refer to devices and applications that comprise an application service 
as configuration items (CIs). The various CIs and the relationships between them, that comprise 
an application service, are stored in the Configuration Management Database (CMDB).

Each application service contains an entry point as the top-level CI. An entry point is a point 
where clients access an application service.  Typically, it is a URL, or a combination of the 
IP address and port for application services in enterprise deployments. For cloud-based 
deployments, an entry point can be a URL to a cloud resource like an AWS  gateway.
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Application service

The Common Service Data Model  (CSDM) helps you streamline service types and service 
offerings. You can add relationships between application services and other service-related 
objects in the CSDM: Business Application, Technical Service Offerings, or Business Service 
Offerings.

There are the following types of application services:

Discovered

Service Mapping  discovers application services using patterns and by following 
traffic connections.

Pattern-based discovery creates precise and complete application services that 
represent the service-centric view of the IT infrastructure. It creates a high-fidelity 
map that is well suited to managing mission-critical application services.

In addition, it provides visibility of cloud-native services such as compute, load 
balancers, and API gateways. You can use service entry points such as AWS  S3 
buckets, AWS  and Microsoft Azure  API gateways, AWS  Lambda functions, and 
Microsoft Azure  functions to map services. It can also detect Lambda to Lambda 
calls and Lambda to RDS connections to build dynamic service maps.

Top-down method maps VMs on-premises and in public clouds. However, it requires 
these VMs to be fully discovered for the top-down discovery to determine which 
applications are running in the VM. If a VM isn't fully discovered, use the tag-based 
method to bridge the gap (see later in this document). Tag-based mapping also 
maps containers, that you cannot map using the top-down discovery.
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Discovered application services have the service classification of 
application service. They are stored in the Mapped Application Service 
[cmdb_ci_service_discovered] table.

Dynamic CI Group

Dynamic CI groups which act as application services. The members of the CMDB 
groups  that is associated with the dynamic CI group, populates the application 
service. A dynamic CI group is a dynamic grouping of CIs, based on some common 
criteria such as the location of all web servers in Detroit or all Oracle databases in 
Boston. After creating a dynamic CI group, it can be used as a group offering in IT 
Service Management.

If created from the Application Service wizard, the service classification is 
application service, and if created from the legacy Event Management  UI 
or Service Mapping  UI, the classification is technical service. Application 
services of the Dynamic CI Group type are stored in the Dynamic CI Group 
[cmdb_ci_query_based_service] table.

Tag-based

A tag is a label that consists of a key-value pair. Your organization may use tags 
to categorize its assets, to enhance query and reporting capabilities. Discovery 
and Cloud Provisioning and Governance  can discover tags used by all major 
cloud providers and container ecosystems. Once the tags are discovered, Service 
Mapping  can create application services based on these tags.  For example, you can 
use tags to map all application services your organization uses in the production 
environment in the EMEA region.

Tag-based application services have the service classification of 
application service. They are stored in the Tag-based Application Service 
[cmdb_ci_service_by_tags] table.

Created Manually

With manual mapping, application owners manually document the applications, 
IT infrastructure, and relationships that support each application service. This 
methodology is the best fit for configuration items that are not fully discoverable 
due to security access issues. For example, IPS devices which support an intrusion 
prevention service for the security business unit.

Try to avoid manual mapping wherever possible. It’s incredibly time consuming 
to map services manually, and often the information needed for mapping is not 
available due to evolving technology and a lack of processes that track and 
document the infrastructure dependencies needed for application context. And, 
whenever subsequent changes are made to the application service topology, the 
service map must be manually updated.

Manually created application services have the service classification of application 
service. Application services of the created manually type are stored in the Mapped 
Application Service [cmdb_ci_service_discovered] table.

Dynamic

A dynamic application service includes only CIs that are part of CI relationships 
stored in the CMDB  CI Relationship [cmdb_rel_ci] table.

You can't edit a dynamic application service by directly adding or removing CIs from 
it. Dynamic application services are updated automatically to reflect any change to 
CI relationships in the CMDB CI Relationship [cmdb_rel_ci] table. When you add 
a relationship to a CI that is contained in a dynamic application service, then that 
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service automatically updates to reflect the addition of the relationship and the 
associated new CI. In a similar manner, a dynamic application service automatically 
updates upon the removal of a relationship and its associated CI from a CI within 
the service.

One way to create dynamic application services, is by converting legacy business 
services or legacy manual services (created with Event Management, for example) 
into application services of the dynamic type.

Dynamic application services have the service classification of application service. 
Dynamic application services are stored in Calculated Application Services 
[cmdb_ci_service_calculated] table.

Who uses application services

Application services provide foundation for operation of the following business units and 
products of the ServiceNow AI Platform:

• ITOM Health  gathers alerts from infrastructure events captured by third-party monitoring 
tools. It then uses IT-related information gathered by Discovery  to map alerts to configuration 
items. Based on the collected information, then provides dashboards showing a consolidated 
view of all service-impact events.

• ITOM Optimization  gives you tools to provision private and public cloud infrastructure 
and services and to achieve consistent management and cost visibility. The Cloud Cost 
Management  application, available in the ServiceNow Store , helps you to analyze the 
full range of costs associated with cloud assets so you can identify and take action on 
opportunities to save money and optimize operations.

• IT Service Management  users rely on the application services reflecting the IT infrastructure 
to manage and deliver services to their customers.

• Customer Service Management users efficiently diagnose and resolve issues related to the IT 
infrastructure in the context of application services.

• Software Asset Management  users understand the software running in your IT environment 
and track configurations that impact software license consumption across your IT 
environments and datacenters.

• Strategic Portfolio Management  users utilize data collected for application services to gain a 
comprehensive understanding of the applications used in your organization.

• Security Operations  users view security incidents to find out which application services are 
at risk. They also use this information to prioritize and resolve threats based on the impact they 
pose to their organization.

How to create application services

Depending on the needs of your organization, you can deploy different methods of creating and 
populating application services.

Important: 
You can use the top-down and manual methods for the same application service. You 
cannot combine any other methods for creating or populating the same application service.

Analyze the IT infrastructure and service deployment in your organization to pick the optimal 
method of creating and populating application services.
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Choosing the right method for your deployment

Method When to use Additional considerations

Top-down discovery

Service Mapping  performs 
top-down discovery of 
application services. Service 
Mapping  uses patterns to 
discover and map CIs. A 
pattern is a sequence of 
steps whose purpose is to 
detect attributes of a CI and its 
outbound connections. This 
method creates precise and 
complete application services 
that reliably represent the 
service-aware view of your 
organization's IT infrastructure

Tag-based discovery in 
Service Mapping  is a 
complimentary method that 
enriches the results of top-
down discovery.

Use this method to discover 
industry-recognized or 
customized second-tier and 
third-tier applications. Such 
applications may include 
load-balancing solutions, 
application or web servers 
with database connections.

Pattern-based mapping 
requires configuring 
credentials, users, and user 
permissions to let Service 
Mapping  access applications 
inside your organization 
private network. This process 
may take time and effort.

Tag-based

If your organization uses 
tags for asset management, 
you can use these tags to 
map application services. 
Discovery  and Cloud 
Provisioning and Governance 
discover tags assigned to CIs, 
and populate the CMDB  with 
this data. Service Mapping 
uses the tag-related data from 
the CMDB  to map services.

Tag-based service mapping 
complements top-down 
service mapping. It provides 
visibility of containers and 
also maps VMs that aren’t fully 
discovered, which top-down 
service mapping is unable to 
do. However, while tag-based 
mapping associates tagged 
components with specific 
application services, it doesn’t 
map the connections between 
these components—This 
is another reason why tag-
based mapping complements 

Map resources on cloud 
workloads like IaaS/Paas/
FaaS/CaaS as well as on 
container workloads using 
Kubernetes, OpenShift, or 
AWS  ECS.

Also, map resources in the 
Site Reliability Engineering 
(SRE) or Customer 
Reliability Engineering (CRE) 
deployments.

Using tag-based method, you 
can map container resources 
in your deployments.

Typically, you use this method 
to discover applications on 
cloud virtualizations or PaaS 
deployments.

Unlike other mapping 
methods, tag-based mapping 
doesn't require configuring 
credentials or providing users 
with elevated rights.

Tag-based application 
services may not include 
relevant CIs, if these CIs don't 
have correct tags assigned to 
them.
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Choosing the right method for your deployment  (continued)

Method When to use Additional considerations

rather than replaces top-down 
service mapping.

Ingesting Application 
Performance Management 
(APM) maps from integrated 
Dynatrace or AppDynamics 
deployments

Create application services 
using the integration with 
AppDynamics application 
model  and Dynatrace 
monitoring  platform 
available on ServiceNow 
Store.

Use this integration to create 
application services based on 
APM maps from Dynatrace or 
AppDynamics. You are able 
to use application services 
created by this method for 
monitoring Health.

Analyze discovered resources 
in the CMDB  before ingesting 
from 3rd party to avoid 
creating duplicate CIs.

Populate an application 
service using the Dynamic CI 
Group method

Based on CMDB  groups, 
whose members populate the 
application service.

Use this method as a simple 
and fast way to create 
dynamic CI groups for 
deployments including 
Microsoft Active Directory, 
Microsoft Exchange  or 
other DNS-related services. 
Dynamic CI Groups are 
especially useful if only a 
list of resource is available, 
without configuration details 
or credentials.

Using a CMDB  group lets you 
use CMDB  Health to monitor 
health, and use a CMDB 
Query Builder saved query to 
filter for the CIs included in 
the application service.

There is no map view for 
application services created 
using this method. You can 
only view CIs belonging to 
such an application service as 
a list.

Need to ensure that the CMDB 
group accurately filters for the 
CIs that should be included in 
the application service.

Application service API

Create an automation for 
creating application services 
in bulk. Use this method, 
if your organization has 
performed cross-organization 
mapping and analysis and 
collected some information 
about services.

Application services created 
using APIs belong to the 
manual type are stored in the 
Mapped Application Service 
[cmdb_ci_service_discovered] 
table.

Use this method for 
environments that require 
tracing of DevOps Continuous 
Integration/Continuous 
Deployment (CI/CD) process.

You can import third-
party service maps into 
manual application services 
individually or in bulk. For 
example, see the Digital 
Guidebook: Importing 
3rd-party service maps 
into ServiceNow Service 
Mapping .

Be familiar with the exact 
service structure: sys_id 
of each CI comprising the 
service and the hierarchy that 
the CIs form. This method 
requires knowledge of the 
scripting infrastructure that 
your organization uses.
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Choosing the right method for your deployment  (continued)

Method When to use Additional considerations

Populate an application 
service using the Manual 
method

Create a manual application 
service with one CI only: the 
entry point. To populate a 
manually created application 
service, add other CIs 
manually as described in 
Manually add CIs to an 
application service.

Alternatively, create and 
populate manual application 
services by converting 
business services  created 
in the CMDB  and stored in 
[cmdb_ci_service].

Use the manual method if 
you can't use other methods 
of creating or populating 
application services.

Create application services 
manually for intrusion 
prevention.

This method doesn't require 
any preexisting setup or 
object configuration.

You can include CIs of any 
class in manually created 
application services.

Manually created application 
services reflect some changes 
to CIs, like CI attributes. 
However, they do not 
automatically reflect changes 
to CI relationships.

Populate an application 
service using the Dynamic 
Service method

Application services that 
automatically update to reflect 
any change to CI relationships 
in the CMDB CI Relationship 
[cmdb_rel_ci] table.

To conform with Common 
Service Data Model, you can 
also convert legacy services 
to dynamic application 
services. Those legacy 
services are stored in 
the [cmdb_ci_service] or 
[cmdb_ci_service_manual] 
CMDB tables:

• Convert business services 
to application services

• Convert legacy manual 
services into dynamic 
application services

Use this method to transform 
legacy business services into 
application services that other 
ServiceNow  products can 
utilize. For example, dynamic 
application services can be 
used for service monitoring 
and change management.

You can't edit a dynamic 
application service by adding 
or removing CIs from it. The 
system automatically modifies 
an application service of 
the dynamic type when you 
modify relevant relationships 
for CIs that are part of that 
application service.

From CSV file

Service Mapping  extracts 
information from this file and 
creates potential application 
services referred to as service 
candidates. Use this method, 
if your organization has 

If necessary, you can import 
service candidates from 
multiple CSV files.

Organize all the collected 
information in a specific 
order in a CSV file, precisely 
as described in the 
documentation.
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Choosing the right method for your deployment  (continued)

Method When to use Additional considerations

performed cross-organization 
mapping and analysis and 
collected some information 
about services.

To comply with CSDM, convert manual services created using IT Operations Management  Event 
Management  and stored in [cmdb_ci_service_manual] as covered in Convert manual services to 
application services  or Convert manual services to application services using API . Converted 
services become application services of the manual type stored in the Mapped Application 
Service [cmdb_ci_service_discovered] table.

Domain separation

Domain separation, if deployed, impacts an application service  as follows:

• When creating an application service, the application service  is assigned to the user's domain.

• When manually adding a CI to an application service, you can choose only CIs that belong to 
the service domain.

• When using the createOrUpdateService - POST  REST API for creating or updating an 
application service, the process stops if one of the CIs referenced in the API belongs to a 
different domain than the application service itself.

• When converting business services into application services, the newly created application 
service belongs to the same domain as the original business service. The application service 
comprises only CIs belonging to the same domain as the application service itself.

Create an application service

Create an application service  to adhere to CSDM standards and to standardize the organization, 
maintenance, and monitoring of services in your organization.

Before you begin
Role required: Depending on the population method used:

• Dynamic CI Group: app_service_admin

• Manual: app_service_admin

• Dynamic Service: app_service_admin

• Top Down Discovery: sm_admin

• Tags: sm_admin

About this task

Warning: 
To ensure optimal performance and functionality of your instance, it is best practice to 
limit the number of application services to 100,000. Exceeding this number might lead to 
performance issues. If you need to exceed this limit, contact your account representative 
for assistance.

An application service is a set of interconnected applications and hosts which are configured to 
offer a service to the organization. Application services can be internal, like an organization email 
system or customer-facing, like an organization website.
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An application service  has an entry point, which lets users access the application service. If you 
are at the planning stage and do not know what the entry points are for an application service, 
you can create the application service without entry points. Such an application service is 
referred to as an empty application service, to which you can add entry points at any later time.

All application services created in the Application Service wizard, are set with the 
application service  service classification.

Service Mapping, if activated, can automatically discover and map application services as 
described in Application service mapping . A discovered application service  contains the CIs 
and the connections between them that Service Mapping  discovered and mapped.

You can also create an application service by using the createOrUpdateService - POST  REST 
API.

Procedure

1. Navigate to All  > CSDM  > Manage Technical Services  > Application Service.

2. In the Application Services list view, click New  to open the Application Service wizard.

3. In the Provide Basic Details  tab:

a. Fill out the fields for Basic Details.

Field Description

Number Pre-populated unique ID for the application 
service.

Name Unique application service name which is 
not in use by any other type of application 
service. Use self-explanatory names such 
as mailing service  or printing 
service.

Environment
The environment of the offering such 
as production, development, or test, as 
identified by some service offerings.

Used by Incident Management and Change 
Management.

Version The application service configuration 
version.
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Field Description

Model ID A product model such as a software model 
where end of life data is stored.

Operational Status Operational status of the application 
service, such as Ready  or Retired.

Support Group Used by Incident Management as the group 
managing the contract covering the asset.

Change Group Used by ITSM for routing of change and 
change-related tasks.

Managed By Group Group responsible for managing the data.

Owned By
User who is familiar with the infrastructure 
and applications making up the service. 
This user is the application service 
Subject Matter Expert (SME) who provides 
information necessary for a successful 
creation of an application service.

If the owner name is not listed, create a user 
with the sm_app_owner role, as the owner. 
Alternatively, you can choose a user with the 
sm_admin role.

Note: 
See Teams related list  for details about the automatic synchronization between the 
assignment group fields and the Teams  related list.

b. In the Set Relationships section, add relationships between the application service and 
other components in the CSDM domain.

c. Click the Business Application, Technical Service Offering, Business Service Offering, or 
the Parent Application Service  tab, and add items to the respective Selected  list.

▪ The technical service offering list includes records in the Service Offering 
[service_offering] table, in which the Service classification  attribute is Technical 
Service.

▪ The business service offering list includes records in the Service Offering 
[service_offering] table, in which the Service classification  attribute is Business 
Service.

▪ The parent application service list includes application service records from the 
Application Service [cmdb_ci_service_auto] table. Adding a parent application service 
relationship creates hierarchies and dependencies of application services in deployments 
such as:

▪ Platform host and platform application deployments

▪ Micro service deployments in which one or more micro services identified as an 
application service, is part of a larger application service deployment

▪ Shared technical service dependencies

d. Click Next.
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For information about CSDM relationships, see CI relationships in the CSDM.

Also, some fields and relationships are noted as required on the page. To change which fields 
and which relationships are required, see Modify the attributes and relationships required for 
application services.

4. On the Populate the Application Service  tab:

a. Click Choose a Method  or click Next  to skip selecting a service population method.

b. On the Choose a Method page, select a Service Population Method, and then follow the 
respective link to complete the specific population method:

▪ Top Down Discovery: Populate application services using top-down discovery

▪ Dynamic CI Group: Populate an application service using the Dynamic CI Group method.

▪ Tags: Populate application services using tags

▪ Manual: Populate an application service using the Manual method

▪ Dynamic Service: Populate an application service using the Dynamic Service method

Note: 
The Top Down Discovery  and the Tags  options are available only if Service Mapping is 
installed.

c. To add another method to populate the application service, click Add Method  on the Service 
Population Methods page.
Or, click Next.

▪ You can add any combination of the Top Down Discovery  and the Manual  methods. 
However, if you select the Dynamic CI Group, Tags, or the Dynamic Service  method, the 
Add Method  button is grayed out and you cannot add additional methods.

▪ You can click a card for a Converted Business Service method to see details about the 
service conversion, such as the conversion type. For more information, see Convert 
business services to application services.

5. On the Preview the Service  tab, review and verify the summaries for creating and populating 
the application service.

a. Review Relationships.

b. You can click Edit Relationships  to modify the relationships to other CSDM objects.

c. Review Population Methods Summary.

d. You can click Edit Methods  to modify the selection methods.

e. Click Done.
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Result
The application service is created, and you can access the new application service by navigating 
to application services list views:

• CSDM  > Manage Technical Services  > Application Service: Contains application service 
CIs from any class extending the Application Service [cmdb_ci_service_auto] class, except 
alert groups. The list view includes the tag-based, discovered, manual, dynamic CI groups, 
converted, dynamic, and empty application service types.

• Configuration  > Application Services  > Application Services: Contains application service 
CIs from any class extending the Application Service [cmdb_ci_service_auto] class, except 
alert groups. The list view includes the tag-based, discovered, manual, dynamic CI groups, 
converted, dynamic, and empty application service types.

• Service Mapping  > Services  > Application Services: Contains application service CIs from 
the Mapped Application Service [cmdb_ci_service_discovered] class. The list view includes 
the top-down (discovered) and empty application service types.

What to do next

• If the service population method is Dynamic CI Group:

◦ Click View CMDB Group CI's  to list all the CIs in the CMDB group that is associated with the 
application service.

◦ Click View Service CI's  to list all the CIs in the application service.
Both lists of CIs are identical, unless the CMDB group contains more than 10,000 CIs. In this 
case, View CMDB Group CI's  shows all the CIs in the CMDB group, and View Service CI's 
shows only the 10,000 CIs that are members of the application service.

• If the service population method is Tags, Top Down Discovery, or Manual, and click View 
Map  to view the application service map  where you can:

◦ Link application services

◦ View CI attributes in an application service map

◦ View the change history of application services

◦ Compare two versions of an application service

• Click Advanced, and then on the Advanced Details page, click Additional Info, Questionnaire, 
Reject Messages, or Worknotes, to add details.

Populate application services using top-down discovery

Use top-down discovery to populate an application service. This discovery method deploys 
discovery patterns to find configuration items (CIs) belonging to the service and connections 
between these CIs. Pattern-based discovery creates precise and complete application services 
that reliably represent the service-aware view of your organization's IT infrastructure.

Before you begin

• Top-Down Discovery is one of several methods for populating an application service with 
CIs. Choosing a method for populating an application service, is only one step of the generic 
procedure for creating an application service. Ensure that you have completed the initial steps 
as described in Create an application service. The procedure described here is incomplete by 
itself as it complements that generic procedure.

• Verify that Service Mapping is set up properly .

• Ensure you know which entry point to use for this application service and which attributes you 
must be able to define for this entry point. Learn about Entry point attributes  available with 
Service Mapping.
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For information about the different types of application services and the different methods you 
can use to populate application services, including using top-down discovery, see Application 
services.

Role required: sm_admin

About this task
A pattern is a sequence of commands whose purpose it is to detect attributes of a CI and its 
outbound connections.   Service Mapping  and Discovery  share a set of preconfigured patterns 
that cover most of the commonly used devices and applications.

Service Mapping  starts pattern-based top-down discovery process from the entry point you 
define.

An entry point is a point where clients access an application service.   Usually, it is either a URL 
or a combination of the IP address and port.    Service Mapping  starts the mapping process from 
this point.  For example, to map your electronic mailing application service, define an IP address 
or host name of the email server as an entry point.

Entry points vary depending on the nature of the application service.  Service Mapping 
comes with a wide range of preconfigured entry point types that cover many commonly used 
applications.

Procedure

1. From the Service Population Method  list in the Choose a Method window, select Top-Down 
Discovery.

2. From the Application Type  list, select the CI class of the application that serves as the entry 
point for this application service.
Entry point parameters depend on the type you select.

3. Define attributes for the selected entry point as described in Entry point attributes .

4. Optional:  Add free-text comment that may provide useful information for handling this 
application service later.

5. Click Save.

What to do next
Complete the generic procedure Create an application service.

Related topics

Discovery patterns used by ITOM Visibility  

Populate an application service using the Dynamic CI Group method

The Dynamic CI Group method for populating an application service, automatically generates 
a dynamic CI group. The members of the CMDB group that the dynamic CI group is based on, 
populates the application service. The application service continuously synchronizes with the 
CMDB group to reflect any changes in membership in the CMDB group.

Before you begin
The Dynamic CI Group is one of several methods for populating an application service with 
CIs. Choosing a method for populating an application service, is only one step of the generic 
procedure for creating an application service. Ensure that you have completed the initial steps as 
described in Create an application service. The procedure described here is incomplete by itself 
as it complements that generic procedure.
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Note: 

• The number of CIs in an application service that is populated by the Dynamic CI Group 
method, is limited to 10,000, even if the associated CMDB group has more than 10,000 
CIs.

• A CMDB group can be used to populate only a single application service. For more 
information about populating and using CMDB groups, see CMDB groups.

• A dynamic CI group contains CIs but can't contain other groups.

For information about the different types of application services and the different methods you 
can use to populate application services, including Dynamic CI Group, see Application services.

Role required: app_service_admin

Procedure

1. In the Choose a Method page, select Dynamic CI Group  as the Service Population Method.

2. Fill out the fields that appear, which are specific to the Dynamic CI Group service population 
method.

Field Description

Service Population Method The method used for populating the application 
service with CIs. Set to Dynamic CI Group.

CMDB Table Notes the Dynamic CI Group 
[cmdb_ci_query_based_service] table, in which 
application services created by the Dynamic CI 
Group method, are stored.

Group Name The CMDB group whose members become 
members the application service.

Note: 
CIs from a class that extends the 
cmdb_ci_service  class (Services), are 
automatically filtered out and are not added 
to the application service.

3. Click Save.

Result
The alert impact on dynamic CI groups is calculated on the following CIs:

• All CIs that are part of the dynamic CI's CMDB group.

• Children of current CIs with a relationship of: Runs on::Runs

• CIs related to either the current CIs or their children, with a relationship of: Virtualized 
by::Virtualizes

For more information, see alert impact calculation .

What to do next
Complete the generic procedure Create an application service.
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Populate application services using tags

Use tags that help categorize and organize configuration items (CIs) in your organization to 
populate application services. Tag-based mapping doesn't require configuring credentials or 
providing users with elevated rights.  Tag-based population method requires the Service Mapping 
feature of ITOM Visibility.

Before you begin

1. Analyze the tag usage in your organization and make a list of all tags and their purposes. Use 
the Key Value [cmdb_key_value] table to see the tags in the CMDB.

2. If necessary, assign tags to CIs that you want to include in application services.

3. Tags is one of several methods for populating an application service with CIs. Choosing a 
method for populating an application service, is only one step of the generic procedure for 
creating an application service. Ensure that you have completed the initial steps as described 
in Create an application service. The procedure described here is incomplete by itself as it 
complements that generic procedure.

4. Analyze the tag usage in your organization and make a list of all tags and their purposes. Use 
the Key Value [cmdb_key_value] table to see the tags in the CMDB.

5. If necessary, assign tags to CIs that you want to include in an application service.

Role required: sm_admin

About this task
A tag is a label that consists of a key-value pair. Your organization may use tags to categorize 
its assets, to enhance query and reporting capabilities. Discovery  and Cloud Provisioning and 
Governance  can discover tags used by all major cloud providers and container ecosystems. 
Once the tags are discovered, Service Mapping  can create application services based on these 
tags.  For example, you can use tags to map all application services your organization uses in the 
production environment in the Europe, the Middle East and Africa (EMEA) region.

If you have configured tag-based service families and tag categories , you can use these tag 
definitions for populating an application service. Part of defining a tag-based service family is 
defining a tag category, which contains tag keys. If necessary, you can also define tag values to 
narrow the criteria used for populating application services. Based on the tag definitions for the 
tag-based service family, Service Mapping  creates service candidates - suggested application 
services. When you use the tag-based service families to populate an application service, you 
must select the relevant service candidate.

Alternatively, you can define tag keys and their values while choosing the tag-based population 
method for a new application service. Define up to three tag keys and tag values for the 
population criteria. CIs that have discovered tag keys and tag values, become part of an 
application service.

For information about the different types of application services and the different methods you 
can use to populate application services, including using tags, see Application services.

Note: 
Service Mapping  includes CIs that are part of CI relationships even if these CIs do not 
have tags assigned to them. For more information, see Tag-based discovery in Service 
Mapping .
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Procedure

1. From the Service Population Method  list in the Choose a Method window, select Tags.

2. To define new tag criteria, perform the following steps:

a. Select Use a list of tags.

b. Enter the tag key and its respective tag value.
Matching tag keys that exist in the system, appear in the auto-fill options.

Important: 
Tag-based mapping is not case-sensitive; same key names and key values spelled with 
upper and lower case are identified as the same.

c. Optional:  Click the plus icon and add another tag key and tag value.

d. Click Preview Result  to see the list of CIs that match the defined criteria, and if necessary, 
refine the tag definitions.

Note: 
You can add no more than three tag key-value pairs for one application service.

3. To use tag definitions from a preconfigured tag-based service family, perform the following 
steps:

a. Select Use a candidate from a tag-based service family.

b. Optional:  To see the tag definitions for this tag-based service family, click the Preview 

button 

c. From the Tag-Based Service Family  list, select the relevant family.
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d. Review the tag categories and values assigned to the service family.

e. From the Service Candidate  list, select the relevant candidate.

f. Optional:  To review the service candidate form, click the Preview  button .

4. Optional:  Add free-text comment that may provide useful information for handling this 
application service later.

5. Click Save.

What to do next
Complete the generic procedure Create an application service.

Populate an application service using the Manual method

The Manual method for populating an application service, is based on selecting an entry point 
CI, which lets users access the application service. To populate the application service, you then 
manually add CIs to the new application service.

Before you begin
Role required: app_service_admin

About this task
Manual is one of several methods for populating an application service with CIs. Choosing a 
method for populating an application service, is only one step of the generic procedure for 
creating an application service. Ensure that you have completed the initial steps as described 
in Create an application service. The procedure described here is incomplete by itself as it 
complements that generic procedure.

For information about the different types of application services and the different methods you 
can use to populate application services, including Manual, see Application services.
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Procedure

1. In the Choose a Method page, select Manual  as the Service Population Method.

2. Fill out the fields that appear, which are specific to the Manual service population method.

Field Description

Service Population Method Manual

CMDB Table Notes the Mapped Application Service 
[cmdb_ci_service_discovered] table, in which 
application services, created by the Manual 
service population method, are stored.

Class The class from which to choose the entry 
point CI  for the application service.

CI The CI from the specified Class, to be the 
entry point for the application service.

Note: 
To eliminate the possibility of delayed 
results when searching for a specific 
CI, make your search as specific as 
possible. A search with *<name> might 
take a long time and return a large data 
set.

3. Click Save.

What to do next

1. Complete the generic procedure Create an application service.

2. Manually add CIs  to populate the application service.

Populate an application service using the Dynamic Service method

The Dynamic Service method for populating an application service generates a dynamic 
application service. A dynamic application service automatically updates to reflect any changes 
to CI relationships in the CMDB CI Relationship [cmdb_rel_ci] table.

Before you begin
The Dynamic Service is one of several methods for populating an application service with 
CIs. Choosing a method for populating an application service, is only one step of the generic 
procedure for creating an application service. Ensure that you have completed the initial steps as 
described in Create an application service. The procedure described here is incomplete by itself 
as it complements that generic procedure.

New dynamic application services initially don't contain any CIs (unless they were converted 
from legacy business services or legacy manual services). Dynamic application services get 
automatically populated when they’re connected to other CIs with CMDB relationships. Entry 
points are automatically created when a relationship between a dynamic application service CI 
and other CIs is created.

For information about the different types of application services and the different methods you 
can use to populate application services, including Dynamic Service, see Application services.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

763

https://www.webstg.servicenow.com/docs/access?context=manually-add-ci-to-business-service&version=washingtondc&pubname=washingtondc-it-operations-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=manually-add-ci-to-business-service&version=washingtondc&pubname=washingtondc-it-operations-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=manually-add-ci-to-business-service&version=washingtondc&pubname=washingtondc-it-operations-management&ft:locale=en-US


Role required: app_service_admin

Procedure

1. In the Choose a Method page, select Dynamic Service  as the Service Population Method.

2. Fill out the fields that appear, which are specific to the Dynamic Service service population 
method.

Field Description

Service Population Method The method used for populating the application 
service with CIs. Set to Dynamic Service.

CMDB Table Notes the Calculated Application Services 
[cmdb_ci_service_calculated] table, in which 
application services created by the Dynamic 
Service method, are stored.

Levels The number of levels of related CIs to include in 
the application service.

3. Click Save.

What to do next
Complete the generic procedure Create an application service.

Monitor the health of application services on the Application Service 
Dashboard

Monitor the health state of application services in the Application Service Dashboard. With that 
information, you can reduce the number of incomplete application services by populating them 
and adding missing data. To use application services effectively, ensure that application services 
are fully configured and are populated.

Before you begin
Role required: itil_admin or app_service_admin

About this task
Edit the application services  that are reported as missing important details. For example, if an 
application service is not configured with a service population method, configure a service 
population method for the application service.

The data that appears in the Application Service Dashboard is calculated on a 24-hour cycle 
during night hours.

Instead of using the legacy Application Service Dashboard that CSDM provides, you can use the 
latest Application Service Dashboard in the Insights view in CMDB Workspace. The Application 
services tile in the Insights view provides similar insights as the legacy dashboard, but with a 
better user experience.

Procedure

1. Navigate to All  > CSDM  > Application Service Dashboard.

2. View counts on the Application Service Overview  tab, which indicate basic configurations of 
application services that are incomplete.
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◦ Count of all application services, complete and incomplete (Total Application Services).

◦ Count of application services configured with a service population method (Population 
method defined).

◦ Count of application services missing a service population method (No population method 
defined). Data for the tags and top down discovery methods appear only if Service Mapping 
is installed.

◦ Breakdown of application services by their missing essential data such as an Owner, a 
Change Group, or a Business Service.

◦ Application services without relationships to technical service offerings or to business 
service offerings.

◦ Breakdown of application services by service population methods, including business 
services that were converted to application services.

3. View counts on the Related Focus Areas  tab, which indicate other potentially incomplete 
configurations of application services.

◦ Total number of application servers, and from those, the number of application servers 
which are not in any application service. Also, the breakdown of these application servers by 
class.

◦ Total number of databases, and from those, the number of databases which are not in any 
application service. Also, the breakdown of these databases by class.

◦ Total number of hardware servers, and from those, the number of hardware servers which 
are not in any application service. Also, the breakdown of these servers by class.

Note: 
Application servers, hardware servers, and databases, not included in application 
services, are counted only up to about 100,000, even if the actual count is 
greater than this limit. This number limit is determined by the value of the 
glide.cmdb.csdm.app_service.max_results  property.

4. Optional:  Filter the count results in either the Application Service Overview  or the Related 
Focus Areas  tab by specific application service properties.
You can filter by the Owner, Change Group, or the Support Group properties. A filter does not 
impact counts of application services in which the respective filter property is missing. For 
example, filtering by Owner, doesn't change the count of Missing Owner.

5. Optional:  Select a widget in either the Application Service Overview  or the Related Focus 
Areas  tab to drill down to the respective CI list view.
For example, click the No population method defined widget to see the CI list view of 
application services in which no population method is defined.

6. Optional:  Edit the coloring rules that determine the threshold for displaying counts in red.
This applies only to the widgets for application services that are not fully configured, such as 
the No population method defined widget.

a. Click the Add Widgets  ('+') icon.

b. Point to the banner of a widget and click the Edit Content  icon.

c. In the Edit Report window, click the Style  tab and then click Edit coloring rules.

d. See Create coloring rules for multilevel pivot table reports  to complete this edit, and for 
more details.

Role required for this step is report_admin or admin.
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What to do next
After identifying any application services that are missing important details, edit the application 
services to add the missing details.

1. Navigate to CSDM  > Manage Technical Services  > Application Services.

2. In the Application Services list view, select an application service to edit.

3. Add the missing details.

For details about configuring an application service, see Create application service.

Modify the attributes and relationships required for application services

Modify the lists of attributes and relationships that are required when creating application 
services.

Before you begin
Role required: itil_admin

About this task
In application service settings, the lists of required attributes and required relationships 
determine which of those items are required when creating application services. By default, the 
list of required attributes contains the required Name  and Number  attributes. Also by default, no 
relationships are required.

You can choose from predefined lists of allowed required attributes and relationships. To change 
the requirement status of an attribute, remove it from or add it to the list of required attributes. 
You can also add Business Application, Technical Service Offering, or 
Business Service Offering  to the list of required relationships.

Procedure

1. Navigate to All  > CSDM  > Application Service Settings.

2. Review the list of Available  items in the Required attributes and Required relationships lists 
and then add items to the Selected  list.

3. Click Save.

Result
Next time that you create an application service, the required attributes and relationships are 
visibly noted in the Basic Details section on the Create an Application Service page.

Convert business services to application services

Unify the way you manage services in the organization by converting manually created records 
in the Service [cmdb_ci_service] table into application services. Conversion lets you streamline 
the different types of services in your organization, leverage ITOM Visibility  capabilities, and 
align with the Common Service Data Model  (CSDM). The conversion is irreversible: You can't 
transform application services back into business services.

Using application services has benefits such as:

• Viewing service maps and change history of services.

• Easily seeing the service context by providing a flat list of all CIs in the application service.

• Monitoring service health. If Event Management is deployed, you can monitor service 
performance and identify health issues for application services.
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• In Change Management, the list of impacted services on a change request form is more 
accurate because the list includes only application services.

• Applying Customer Service Management tools to open and manage cases at the service level.

Discovery doesn't run on converted application services, because converted services are 
manual. However, if after the conversion you add Discoverable by Service Mapping  entry points 
to the application service, then Service Mapping  starts discovering such this application service.

Choosing between application services of the manually created and dynamic 
type

You can convert business services into application services of the manually created type or of 
the dynamic type. You can edit manually created application services by adding or removing 
CIs at any time. The system does not update manually created services automatically. If there 
are changes to CIs making up a manually created application service, the service does not 
automatically reflect it.

Dynamic services are updated automatically to reflect any change to CI relationships stored 
in the CMDB  CI Relationship [cmdb_rel_ci] table. When you add a relationship to a CI that is 
contained in a dynamic service, then that service automatically updates to reflect the addition of 
the relationship and the associated new CI. In a similar manner, a dynamic service automatically 
updates upon the removal of a relationship and its associated CI from a CI within the service.

To learn more about different types of application services, see application services.

Conversion process

During conversion, the following changes and processes occur:

• The service record is moved from the Service [cmdb_ci_service] table into the Mapped 
Application Service [cmdb_ci_service_discovered] table by changing the record class.

• The application service  is set with all the original business service attributes such as name, 
owner, and operational status.

• The system adds related items from the business service to the converted application service, 
up to the specified level.

• The system queries the CMDB  for the latest CI changes.

• Event Management, if activated, applies CI impact rules to CIs that are associated with alerts 
and that are part of the application service. Event Management  deploys CI impact rules for 
alert monitoring.

• You can edit a converted application service of the manually created type by navigating 
to CSDM  > Manage Technical Services  > Application Service. Then select a converted 
application service. The service population method for a converted application service, is set 
to Converted Business Service. For more information about editing application services, see 
Create an application service.

Note: 
You can't edit a dynamic application service by adding or removing CIs from it. The 
system automatically modifies an application service of the dynamic type when you 
modify relevant relationships for CIs that are part of that application service.

Non-compliant CIs

A conversion might involve adding CIs of the following CI types, which cannot be added to an 
application service:
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• cmdb_ci_file_system

• cmdb_ci_network_adapter

• cmdb_ci_storage_device

• cmdb_ci_disk_partition

• cmdb_ci_memory_module

• cmdb_ci_ip_address

• cmdb_ci_storage_pool_member

• dscy_net_base

• cmdb_ci_storage_export

• cmdb_ci_endpoint

• cmdb_ci_translation_rule

• cmdb_ci_qualifier

• cmdb_ci_application_cluster

• cmdb_ci_config_file

If the original business service contains related items belonging to these CI types, then the 
system does not add such CIs or connections coming from them.  If necessary, you can prevent 
CIs of other CI types from being added to application services by modifying the Manual CI 
Inclusions / Exclusions [svc_manual_ci_exclusions_inclusions.list]  table.

Domain separation

In environments with domain separation, only CIs belonging to the same domain as the 
application service  are added to the application service. If there is a domain hierarchy, CIs must 
belong to the same child domain as the application service.

Convert business services to application services in bulk

Convert a subset of business services to application services, in bulk and automatically rather 
than one at a time. Individually select the business services for the conversion, and then convert 
them into application services.

Before you begin
Role required: app_service_admin, ecmdb_admin, or itil_admin

About this task
Use bulk conversion to convert legacy business services to application services. For the bulk 
conversion, individually select the business services from the Services list view, typically up to 
100 business services in a single conversion. You can create multiple bulk conversion records, 
each with a different set of business services. However, do not include a business service in 
more than one bulk conversion.

Note: 
You can't undo this conversion operation.

Procedure

1. Navigate to All  > Configuration  > Services.

2. In the Services list view, select the services that you want to include in the conversion.

3. In the Actions on selected rows drop down list, select Bulk Convert Application Services.
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4. Fill out the Bulk Convert Services form.

Field Description

Name Pre-populated with "Application Service 
Conversion: <time stamp>".

Select configuration items
List of services included in the conversion.

You can unlock the list and select services to 
remove from the list. Or, use the Select target 
record search box to search and add services 
to the list, by service names.

Levels The number of levels of related CIs to include 
in the converted application service.

Update service when CMDB updates Select this check box to convert the business 
service into an application service of the 
dynamic type.

5. Select Start Conversion.

What to do next

• Check the status of a conversion: On the Bulk Convert Services form, scroll to the Bulk Convert 
Services Entries section to see the status (such as Ready or Completed) of a conversion.

• Track the progress of a conversion as it runs: In the navigation filter, enter 
cmdb_convert_bulk_services.list  and press the Enter key to see the list of 
conversions, and their progress.

• (Optional) On a change request form, view affected dynamic services. For example, after you 
add an affected CI that is associated with a dynamic service:

1. Navigate to Change  > Open.

2. Select a new change request to add affected CIs to.

3. On the Change Request form, scroll to the Related Links section.

4. Click the Affected CIs  tab and then click Add  to add an affected CI to the change request.

5. Open the form context menu and select Refresh Impacted Services.

6. Click the Impacted Services/CIs  tab to see any dynamic services that are associated with 
the affected CI and that are impacted by the change request.

For more information about affected CIs on a change request, see Associated CIs on a change 
request .

Convert an individual business service to an application service

Manually convert a specific business service to an application service.

Before you begin
Review the original business service to evaluate it.
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• Make sure that all CIs and CI relations are relevant for the future application service. If 
necessary, change the CI relations in the CMDB.

• Make sure that the original business service doesn't contain more than 5000 CI relations. 
Application services that contain more than 5000 CI relations cause mapping and monitoring 
performance issues.

• Decide how many levels of CI relations you are going to use during conversion.

Warning: 
The conversion is irreversible: You can't transform application services back into business 
services.

Role required: app_service_admin

Procedure

1. Navigate to All  > Configuration  > Business Services.

2. Select the business service that you want to convert to an application service.

3. Click Convert to Application Service.
The Converting to Application Service dialog box opens.

4. Select a number from the Up to  list, as the number of levels of related CIs to include in the 
conversion.
The maximum number of levels is eight.

5. Select Update service when CMDB updates  to convert the business service into an 
application service of the dynamic type.

6. Click OK.

Result
The system adds the CIs from the business service to the converted application service.

What to do next
Open the map for the newly converted application services.

Make sure that the application services aren't too large:

• Service Mapping  doesn't offer to view CI list instead of a map for an application service.

• There is no discovery message indicating that the application service is too large: The map 
does not display the entire service, because it is too large. 
The number of CI connections exceeded the allowed maximum.

If the service is too large, perform the following actions:

• Review the converted application service to identify CI relations irrelevant or redundant for this 
service. Remove such CI relations in the CMDB.

• Decide how many levels of related CIs you must include into this application service. If 
necessary, change the number of levels used in conversion  to reduce the service size.

Related topics

Application services

Convert legacy manual services into dynamic application services

Unify the way that you manage services in your organization by converting legacy manual 
services into dynamic application services. Conversion lets you streamline the different types 
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of services in your organization, leverage ITOM capabilities, and align with the Common Service 
Data Model  (CSDM).

Before you begin
Role required: app_service_admin

About this task

Note: 
Converting a legacy manual service to a dynamic application service is irreversible. Once 
converted, you can’t revert it back to a legacy manual service. However, you can convert a 
dynamic application service to a manual application service.

You can't edit a dynamic application service directly. If you remove a CI from the map, it 
reappears once the service is recalculated. To ensure permanent changes, update the CI 
relationships in the CMDB CI Relationship [cmdb_rel_ci] table.

During conversion, the following changes and processes occur:

• A change to the record class moves the service record from the Service [cmdb_ci_service] or 
the Manual Service [cmdb_ci_service_manual] table to the [cmdb_ci_service_calculated] table.

• The dynamic application service is configured with all the original attributes of the legacy 
manual service such as name, owner, and operational status.

• Related items from the legacy manual service are added to the converted dynamic application 
service, up to three levels by default.

• All connections created between CIs in the dynamic application service are endpoint CIs with 
the relationship uses, implement, or application flow.

• Event Management, if activated, applies CI impact rules to CIs that are associated with alerts 
and that are part of the application service. Event Management deploys CI impact rules for 
alert monitoring.

A conversion might involve adding non-compliant CIs, which can’t be added to an application 
service:

• cmdb_ci_file_system

• cmdb_ci_network_adapter

• cmdb_ci_storage_device

• cmdb_ci_disk_partition

• cmdb_ci_memory_module

• cmdb_ci_ip_address

• cmdb_ci_storage_pool_member

• dscy_net_base

• cmdb_ci_storage_export

• cmdb_ci_endpoint

• cmdb_ci_translation_rule

• cmdb_ci_qualifier

• cmdb_ci_application_cluster

• cmdb_ci_config_file
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If the original manual service contains related items belonging to these CI types, then these CIs 
or connections coming from them aren’t added to the dynamic service. If necessary, you can 
prevent other CI types from being added to application services by modifying the Manual CI 
Inclusions/Exclusions [svc_manual_ci_exclusions_inclusions.list] table.

Procedure

1. Navigate to All  > Configuration  > Application Services  > Application Services.

2. Confirm that the view is set to the default view.

a. Select the List controls icon for the list view.

b. Select View  and then select Default view.

3. Open the legacy manual service that you want to convert to a dynamic application service.

4. In the Related Links section on the service form, select Convert to Dynamic Service.

Manually add CIs to an application service

Add configuration items (CIs) to manually created application services or to services discovered 
by Service Mapping. You can edit discovered and manually created application services.

Before you begin

• Verify that the CI type for the CI that you are planning to add, exists. If necessary, create the CI 
type as described in Create CI types for Service Mapping and Discovery .

• Add CIs to the CMDB for the device or application that you want to add, if necessary. See 
Populate the CMDB  for more information.

Role required: app_service_admin or sm_admin

About this task
Adding a CI to an application service requires creating a relationship between the new CI and 
a CI in the application service. You can add CIs to an application service that was created 
manually, by either:

• Adding a method to populate the application service.

Navigate to CSDM  > Manage Technical Services  > Application Service. Select an application 
service and then use the Populate the Application Service  tab to choose a method to 
populate the application service. For more details, see Create an application service.

• Using the application service service map as described in the steps below.

The default relationship type of the added connection in this case is Depends on::Used 
by. You can modify this default relationship type by changing the value of the Components 
installed with application services  property.

Important: 
You cannot fine-tune or edit tag-based and dynamic services from the map.

Information about the CI in application service, to which you are connecting a new CI, is updated 
in the CMDB. This information includes the type of the relationship between the CIs. If other 
application services use the same applicative flow, the CMDB  recognizes it and adds the CI you 
added manually to these application services by analogy. For example, you manually added an 
IBM WebSphere Message Broker to an IBM WebSphere HTTP Listener in the Bank Customer 
Portal service. The system also adds this IBM WebSphere Message Broker to the same HTTP 
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Listener in the Bank Internal Portal service, because it uses this HTTP Listener. The same logic 
applies when you remove a CI you added manually: The system removes it from all application 
services where you either manually added it or the system added it by analogy.

You can manually connect a CI only to actual CIs existing in the CMDB, not to a visualization of 
other items on the map such as clusters or boundaries. Also, you cannot add CIs of these CI 
types to an application service:

• cmdb_ci_file_system

• cmdb_ci_network_adapter

• cmdb_ci_storage_device

• cmdb_ci_disk_partition

• cmdb_ci_memory_module

• cmdb_ci_ip_address

• cmdb_ci_storage_pool_member

• dscy_net_base

• cmdb_ci_storage_export

• cmdb_ci_endpoint

• cmdb_ci_translation_rule

• cmdb_ci_qualifier

• cmdb_ci_application_cluster

• cmdb_ci_config_file

If necessary, you can prevent CIs of other CI types from being added to application services 
by modifying the Manual CI Inclusions / Exclusions [svc_manual_ci_exclusions_inclusions.list] 
table.

In environments with domain separation, only CIs belonging to the same domain as the 
application service  are added to the application service. If there is a domain hierarchy, CIs must 
belong to the same child domain as the application service.

If working with an application service  discovered by Service Mapping, manually add a CI:

• To indicate that an application service  contains a device or application, which Service 
Mapping  cannot discover. For example, add an A/C unit to the Production Floor service.

• To add a temporary placeholder for a CI, which Service Mapping  did not discover. In this 
case you are planning to perform necessary troubleshooting to ensure that Service Mapping 
discovers this CI in the future. For example, add an IBM WebSphere Message Broker to the 
Bank Customer Portal service.

• To create an application service  that combines entry points and CIs automatically discovered 
by Service Mapping  with entry points and CIs from the CMDB. After you manually add an 
entry point, you can update the application service  with CIs from the CMDB  based on the 
relationships defined there.

For additional information related to Service Mapping, see Pattern customization  and Enable 
traffic-based discovery for CI types or specific CIs .
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Procedure

1. Open the application service map.

a. Navigate to All  > CSDM  > Manage Technical Services  > Application Service.

b. Select the needed application service.

c. On the application service page, select View Map.

2. If needed, click Edit  to ensure that the map is in Edit mode.

If Service Mapping  is deployed, then in Edit mode, the Discovery Messages section appears 
below the map.

3. To connect a CI to another CI on the map, right-click the CI to which you want to connect the 
new CI, and then select Add a CI.

4. In the Add A CI dialog box, specify the CI to add:

Field Description

CI Type Select the CI type (CI class) for the CI you are 
adding. Every CI belongs to a CI type which 
contains a set of attributes configured for this 
kind of CI, for example, cmdb_ci_appl  for 
applications.

CI Name Select the CI from the list of CIs of the 
selected CI type.

Note: 
To eliminate the possibility of delayed 
results when searching for a specific 
CI, make your search as specific as 
possible. A search with *<name> might 
take a long time and return a large data 
set.

The CI type list includes only allowed CI types. For example, you cannot add an application 
cluster.

5. Click Submit.
The manually added CI appears on the map.

Note: 
When you manually add a CI, which is an application, as a child to a service that already 
includes its parent application CI, the newly added child application CI is hidden inside 
the inclusion. Click the plus (+) symbol next to the parent application CI to see the child 
application CI.

6. Optional:  If Service Mapping  is activated, add a discoverable outgoing connection for the 
manually added CI:

a. Right-click the manually added CI.

b. Select Manually add a connection.
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Note: 
If you do not see the Manually add a connection  option in the right-click menu, check 
that you are logged in with the user that belongs to the same domain as the application 
service.

c. Configure attributes for the entry point as described in Entry points attributes .

d. Click Submit.
Discovery  and Service Mapping  attempt to discover this CI. If successful, the CI appears on 

the map. Otherwise, a warning icon ( ) appears.

7. Optional:  If Service Mapping  is activated and you want Service Mapping  to automatically 
discover a CI, which you previously added manually:

a. Customize the relevant pattern or fine-tune traffic-based discovery to enable Service 
Mapping  to discover the CI.

b. Navigate to the relevant application service  map.

c. Click Run discovery.

d. After the discovery process finishes, verify that Service Mapping  discovered the CI by 
checking the connector leading to the CI.
If Service Mapping  discovered the CI, then two connectors, a manual and automatically 
discovered, appear for the CI.

e. Right-click the CI you added manually.
In the example, it is IBM WebSphere Message Broker.
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f. Select Remove manually added CI.
The map shows the CI with only one connector leading to it. If this CI had any manually 
added connections, they are removed together with the manually added CI.

Related topics

Link application services

addCI()

Manually update an application service with changes from the CMDB

Ensure that an application service  is up-to-date and reflects all the latest changes to its 
configuration items (CIs). Regularly update application services to reflect any changes to CIs and 
their relationships in the CMDB.

Before you begin
Role required: app_service_admin

About this task
There is no mechanism or an API that automatically updates application services that were 
created manually. Also, you may need to manually update application services discovered by 
Service Mapping, if they contain manually added CIs. You can only update application services 
which contain manually created entry points and which are not discovered by Service Mapping.

An example of a change is deleting CIs from the CMDB  or connecting two CIs one of which is 
part of an application service. In the first case, your application service may show a CI that no 
longer exists. In the second case, on the contrary, the application service omits a CI.

An update might involve adding CIs of the following CI types, which cannot be added to an 
application service:

• cmdb_ci_file_system

• cmdb_ci_network_adapter

• cmdb_ci_storage_device

• cmdb_ci_disk_partition

• cmdb_ci_memory_module

• cmdb_ci_ip_address

• cmdb_ci_storage_pool_member

• dscy_net_base

• cmdb_ci_storage_export

• cmdb_ci_endpoint

• cmdb_ci_translation_rule

• cmdb_ci_qualifier

• cmdb_ci_application_cluster

• cmdb_ci_config_file

If necessary, you can prevent CIs of other CI types from being added to application services 
by modifying the Manual CI Inclusions / Exclusions [svc_manual_ci_exclusions_inclusions.list] 
table.
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Also, the system can connect a CI from the application service  only to actual CIs that exist in the 
CMDB, not a visualization of other items on the map like clusters or boundaries.

The maximum number of CI connections added to application services during this operation 
is controlled by the sa.service.max_ci_service_population  property. By default, the value 
is 1,000 (one thousand connections). Increasing the number of CI connections may cause 
performance issues. To adjust the maximum number of added CI connections, add the 
sa.service.max_ci_service_population property, as described in Add a system property .

In environments with domain separation, only CIs belonging to the same domain as the 
application service  are added into the application service. If there is a domain hierarchy, CIs 
must belong to the same child domain.

You can also update application services by using APIs.

Procedure

1. Navigate to All  > CSDM  > Manage Technical Services  > Application Service.

2. On the Application Services list view, select the application service  that you want to update.

3. Click Advanced  and then click Advanced Configurations.

4. On the Additional Info page, click the Update with changes from CMDB  related link.

5. Select a number in the Up to  list to limit the number of levels of related items to be updated.
If the specified number is higher than the number of levels of related items that already exist in 
the application service, then the system adds the missing CIs and their connections.

Warning: 
Specifying a lower number than the number of levels that already exist in the application 
service, does not result in the removal of CIs from the application service.

6. Click OK.

Result

• The system updates the application service  with the changes from the CMDB and shows them 
on the map.

• After the update process is complete, the application service  form opens.

Link application services

You can manually link two application services by adding a reference to one application 
service into another application service. The service that contains the reference, becomes a 
dependent service. The service that you include as a reference is a contained service. You can 
link application services to create dependencies for impact monitoring in Event Management.

Before you begin
You can edit discovered and manually created application services.

Important: 
You cannot fine-tune or edit tag-based and dynamic services from the map.

Ensure that you know the name and the service type of the application service, to which you 
want to add a reference.

Role required: app_service_admin or sm_admin
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About this task
To create a link, add a reference to the relevant application service as an outgoing connection 
of the relevant CI inside another application service. For example, you can add the UK Portal 
application service as a link to the Online Store application service. In this case, the Online Store 
service becomes dependent on the UK Portal service that it contains. The Online Store service 
reflects discovery errors for its contained service in the Edit map mode, as well as alerts in Event 
Management.

Example of linked application services

When you link an application service to another application service, the information about 
the CI, to which you linked the service, is updated in the CMDB. The CMDB  recognizes other 
application services that use the same applicative flow, and adds the contained application 
service to these application services by analogy. The same logic applies when you remove a 
contained application service: The system removes it from all application services where you 
either manually linked this service or the system linked this service by analogy.

When using Service Mapping, you may want to link application services to create:
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• A dependency between two application services.

• A placeholder for a map branch that Service Mapping  failed to discover. If you create or 
customize a pattern to discover the configuration item (CI) serving as an entry point for the 
contained application service, Service Mapping  can discover this contained service.

• An indication that an application service  contains a branch, which Service Mapping  cannot 
discover.

You can add an application service  as a contained service to as many application service  as 
necessary.

Procedure

1. Navigate to Service Mapping  > Application Services.

2. Click View map  next to the relevant application service.

3. If needed, click Edit  to ensure that the map is in Edit mode.

4. Right-click the CI to which you want to link an application service as a reference.

5. Select Add A CI.

6. In the Add a CI dialog box, select the application service you want to add as a contained 
service:

Field Description

CI Type Select the relevant service type from this list:

◦ Tag-Based Application Service

◦ Mapped Application Service  for 
discovered or manually created application 
services

◦ Calculated Application 
Service  for dynamic services

◦ Dynamic CI Group

CI Name Select the name of the application service 
that you want to link as a contained service.

7. Click Submit.
The icon for the contained service appears on the map.

Related topics

Application services

View dependent application services in classic  Service Mapping  

View contained application services in classic  Service Mapping  

Group application services

Organize application services by groups to perform actions simultaneously on multiple services, 
and to control user access to services. You can use Event Management  to track service health by 
service groups.

Before you begin
Role required: sm_admin or app_service_admin

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

779

https://www.webstg.servicenow.com/docs/access?context=view-linked-services&version=washingtondc&pubname=washingtondc-it-operations-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=view-linked-services&version=washingtondc&pubname=washingtondc-it-operations-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=view-linked-services&version=washingtondc&pubname=washingtondc-it-operations-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=view-linked-services&version=washingtondc&pubname=washingtondc-it-operations-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=view-linked-services&version=washingtondc&pubname=washingtondc-it-operations-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=view-contained-services&version=washingtondc&pubname=washingtondc-it-operations-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=view-contained-services&version=washingtondc&pubname=washingtondc-it-operations-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=view-contained-services&version=washingtondc&pubname=washingtondc-it-operations-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=view-contained-services&version=washingtondc&pubname=washingtondc-it-operations-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=view-contained-services&version=washingtondc&pubname=washingtondc-it-operations-management&ft:locale=en-US


About this task
Typically, enterprises have hundreds of services which makes it impractical to manage them 
individually. Service groups can make service lists much shorter and easier to manage, 
especially in large organizations or service providers.

How you group application services depends on the user and on service provisioning policies 
in your enterprise. The relation between application services in groups is purely logical and the 
same application service can belong to multiple groups.  For example, the Mobile service can be 
part of the following service groups: Sales, Beijing, and Telephony.

Example of an application service belonging to different groups

You can embed a service group within another service group to create a hierarchy of service 
groups. If users have access to a parent service group, they automatically have access to all its 
child groups.  By default, all new services are assigned to the All  service group that lets all users 
view and manage application services. When you assign a role to a service group, the users with 
this role can access application services in this service group and in the All  service group. To 
enable users with this role to access other services, assign this role to the respective service 
group. Do not assign user roles directly to the All  service group.

If Service Mapping  is activated, service groups can contain a mixture of manually created 
application services and application services discovered by Service Mapping.

You can use ServiceNow AI Platform  Notifications  to alert users if the service group severity 
changes to critical. The overall severity of the group is determined by the highest alert severity 
within the group.

Procedure

1. Navigate to All  > Configuration  > Application Services  > Service Groups.

2. Click New.

3. Enter the name of the new application service  group in the Name  field.

4. To embed this group in another group, enter the name of the other group in the Parent Group 
field.

5. Right-click the form header and click Save.
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6. Add an application service to the newly created service group.

a. In the Service Group Members section, click New.

b. In the Name  field, enter the name of the application service.
If you are using Event Management, you can also enter an alert group name.

c. Click Submit.

7. Alternatively, add an application service to a group from the application service form.

a. Navigate to All  > Configuration  > Application Services  > Application Services.

b. Select the application service you want to add to a service group.

c. In the Service Group Members  section, double-click Insert a new row.

d. Enter the name of the service group to which you want to add the selected application 
service.

e. Click the OK  icon ( ).

f. Click Update.

Control user access to application services

Assign user roles to service groups to grant users access to application services in your 
organization. Your organization may restrict access to some services for security or secrecy 
reasons.

Before you begin
Make sure that you have performed the user provisioning tasks for the users you want to grant 
access:

1. Add users to user groups .

2. Create new roles .

3. Assign roles to users or user groups .

Also, make sure that you have created service groups as described in Group application 
services.

Role required: app_service_admin or sm_admin

About this task
In the base system, the following roles provide access to application services:

app_service_admin

Creates and modifies application services, creates service groups, views, and edits 
application service maps.

app_service_user

Views maps for operational application services and retrieves service content 
using the getContent - GET REST API. The itil role that serves as the basic helpdesk 
technician role contains the app_service_user role.

Service Mapping  provides these preconfigured roles:

sm_admin
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Sets up the Service Mapping  application. Maps, fixes, and maintains application 
services. Also performs advanced configuration and customization of the product. 
Assign this role to application administrators.

sm_user

Views maps for operational application services to plan change or migration, as well 
as analyze the continuity and availability of services. Assign this role to application 
users.

sm_app_owner

Provides information necessary for successful mapping of an application service. 
Once a service is mapped, this user reviews the results and either approves it or 
suggests changes. Assign the sm_app_owner role to users who own application 
services and are familiar with the infrastructure and applications that make up the 
services.

Note: 
Users with the itil role only can view all application services.

Event Management  provides these preconfigured roles:

evt_mgmt_admin

Has read and write access to all Event Management  features to configure Event 
Management.

evt_mgmt_operator

In addition to the evt_mgmt_user permissions, can also activate operations on 
alerts such as acknowledge, close, open incident, and run remediations.

evt_mgmt_user

Has read access to all Event Management  features. Has write access to alerts to 
manage the alert life. Has the itil role to be able to manage incidents that are created 
from alerts.

evt_mgmt_integration

Has create access to the Event [em_event] and Registered Nodes 
[em_registered_nodes] tables to integrate with external event sources.

Typically, enterprises have hundreds of services which makes it impractical to manage them 
individually. Service groups can make service lists much shorter and easier to manage, 
especially in large organizations or service providers.  In a hierarchy of service groups, access to 
a parent service group automatically grants access to all the child service groups.

Users inherit permissions from roles that are assigned to them. You can assign some roles 
directly to service groups to allow all users with this role to access all application services 
belonging to this group. However, most enterprises choose to organize their roles as a hierarchy. 
It helps to manage roles across multiple ServiceNow  applications. For example, the Service 
Mapping  administrator [sm_admin] can be part of a broader administrator role like administrator 
[admin]. You can add users to user groups and then assign roles to the user groups to give 
permissions of this role simultaneously to all the group users.
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Assigning a role to an application service group

By default, all new services are assigned to the All  service group that lets all users view and 
manage application services. When you assign a role to a service group, the users with this role 
can access application services in this service group and in the All  service group. To enable 
users with this role to access other services, assign this role to the respective service group. Do 
not assign user roles directly to the All  service group.

Procedure

1. Navigate to either of the following:

◦ Configuration  > Application Services  > Service Group Responsibilities.

◦ If Service Mapping  is activated: Service Mapping  > Services  > Service Group 
Responsibilities.

◦ If Event Management  is activated: Event Management  > Services  > Service Group 
Responsibilities.

2. Click New  and fill out the Application Service Group Responsibilities form.

Field Description

Application Service Group Service group to which you want to assign a 
role.

Role
Role you want to assign to the selected 
service group.

For example, financial_services_admin.

3. Click Submit.

Example:
To manage access to services that contain sensitive financial information in your organization:

1. Organize the services into the Financial Services group.

2. Create a new user role, financial services administrator [financial_services_admin] role, that 
contains the [app_service_admin] role.

3. Assign the Financial Services administrator role to the Financial Services group.
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As a result, only users with the Financial Services administrator role can access application 
services belonging to the Financial Services group.

View an application service map in base system

An application service map provides a visualization of data for the CIs comprising an application 
service, and the relationships and connections between these CIs.

Before you begin
Role required: app_service_user to view the map in View mode, and app_service_admin to 
modify services in Edit mode.

About this task
When you create an application service, the system generates an associated application service 
map. The system then updates the map to reflect any changes to the application service. This 
map consists of icons representing CIs and arrows that represent the connections between 
them.

If Service Mapping  is deployed, see Application service maps  and View CI connection 
attributes in an application service map  for more details.

To open an application service map, navigate to CSDM  > Manage Technical Services  > 
Application Service, select an application service, and then click View map.

Perform any of the following operations in the application service map.

Procedure

• Select  on the windows bar to navigate to a different application service.

• Use the navigation tools to increase or decrease the view of the map and to move the map on 
the page.
You can also click anywhere on the map area and drag a segment of the map into the visible 

area.

• View changes: You can view changes and change records associated with the application 
service as a whole or with any of its CIs, within a time range.

For more information, see View the change history of application services .

Records under the Change  tab underneath the map, which are associated with a selected CI 
or connection, are highlighted. If you select a change record under the Change  tab, then the 
associated CI icon appears yellow on the map.

• View attributes: When you select a device, application, or connector on the map, it appears in 
blue and its attributes appear in the Properties pane on the right of the map.

When nothing is selected on the map, the details of the application service itself appear on the 
Properties pane.
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Open the CI's form for further details by clicking Detailed Properties  at the bottom of the 
Properties pane.

• Select Edit  to add or remove CIs from the map or View  to switch the map mode.

• Select  for Additional actions:

◦ Set Group CIs on map: Simplify maps by grouping 10 or more CIs belonging to the same 
type and hosted on servers sharing prefix and domain name.

◦ Set Spanning tree view: Simplify the map by organizing CIs into a tree structure and hiding 
some connection lines. This option is especially useful for very large maps.

◦ Map Indicators: Show additional information for a CI or for the application service itself 
by displaying related records such as alerts, outages, incidents, and problems. For each 
indicator that is enabled, the corresponding indicator icon appears next to CIs with 
associated records, and the corresponding tab appears underneath the map. If a record is 
associated with the application service itself, the indicator appears next to the application 
service name.

For information about managing map indicators, see Create or modify map indicators. For 
more general information, see Event Management Map Indicators (Video) .

◦ Export to PDF: Export the map to a .PDF file which you can then share as needed. After the 

PDF file is ready, click  to download the PDF file to your local drive.

• View the details of a connection.

By default, connection lines for the same CI on an application service map, are merged. This 
merge reduces clutter on the map and helps to make the map more readable. For a merged 
connection line, you can view details for all the underlying connection lines.

Merged connection lines

◦ To view the source and target CIs of a connection, right-click a connection line.

If spanning tree view is enabled:

1. Select the CI whose connections you want to view to show all the concealed connections 
for the CI.

2. Right-click one of the connection lines.

◦ To view properties of a connection, click a connection line. For manually added connections, 
Endpoint Type is Manual Endpoint.
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◦ To view properties of a connection within a merged connection:

1. Right-click the merged connection line.

2. Select one of the connections.

3. Select Select edge.

What to do next
You can change the details that appear in the Properties pane by updating the form view 'Form 
view and section', as described in Configuring the form layout .

Related topics

Spanning tree view property

View CI attributes in an application service map in classic  Service Mapping

An application service map displays attributes for each configuration item (CI) that is part of the 
application service, as well as for the application service itself. The attributes come from the 
CMDB.

Before you begin
Role required: sm_admin or sm_user

About this task
You can view the following information for each CI:

Name label

The CI name. This attribute is either preconfigured on the CI or configured during CI 
installation.

Basic attributes

A summary of the most important CI attributes.

Detailed attributes

A complete list of all attributes collected for the CI.

Each CI type (CI class) has different attributes. For example, the Linux Server type has different 
attributes than the SQL Instance type.

If Service Mapping  is deployed, the way CIs appear on the map depends on the view you select 
for the map . Attributes available for viewing also depend on the Service Mapping  setup. For 
more information, see description of components installed with Service Mapping .

Procedure

1. Open the application service map.

a. Navigate to All  > CSDM  > Manage Technical Services  > Application Service.

b. Select the needed application service.

c. On the application service page, select View Map.

2. If needed, click Edit  to ensure that the map is in Edit mode.

If Service Mapping  is deployed, then in Edit mode, the Discovery Messages section appears 
below the map.

3. To see the full name of a CI whose name has been shortened on the map, point to the CI.

A tooltip displays the full CI name.
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4. Click a CI to see its details in the Properties  pane.

The attributes of applications and the servers that host them appear separately.

5. To view more detailed attributes for the CI, click Detailed properties  at the bottom of the 
Properties pane.

6. Optional:  To view configuration files associated with a CI in environments where Service 
Mapping  or Discovery  are enabled and tracking changes to CI configuration files is enabled):

◦ Review the list of files under Tracked Files  in the Properties  pane. Click the file name to 
open the actual file.

◦ Click the Affected CIs  tab and view the list of configuration files. Click the file name to open 
the actual file.

View the change history of application services in classic  Service Mapping

You can view the changes made to an application service as a whole and to the individual 
configuration items (CIs) comprising the service. Change history is useful for maintenance, 
planning, or troubleshooting procedures.

Before you begin
Role required: admin, sm_admin, sm_user, app_service_admin, or app_service_user

About this task
Details about changes to an application service and to its CIs are stored in the CMDB. Typically, 
these changes reflect adding or removing CIs from an application service, upgrading or updating 
CIs, or modifying CI configuration files. The system gathers this data by querying CMDB tables 
and then creating the change history view. In deployments where Service Mapping  is activated, 
the type of change information Service Mapping  queries depends on discovery patterns that 
Service Mapping  uses to discover CIs.
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Changes to configuration files are associated with CIs to which these files belong. Maps show 
configuration file changes as changes to related CIs.

While you can see change records for a specific CI in the context of application services, you 
can also see detailed history of a specific CI separate from its application service  as described in 
History Timeline .

If the ServiceNow AI Platform  is configured to validate changes, all changes are evaluated and 
rendered as valid or not. If a change is valid, its change record on the application service map is 
marked as approved. For more information about configuring the platform for change validation, 
see Managing proposed changes.

Changes to the application service  appear on the history timeline.

The type of change mark depends on the nature of changes that it represents:

Light gray balloon ( )

Unapproved change that does not influence the application service behavior. For 
example, a change in a network path or adding a node to a cluster.

Dark gray balloon ( )

Unapproved change that changes the application service behavior.

Green balloon ( )

An approved change in deployments where the ServiceNow AI Platform  is 
configured to validate changes.

Double balloon ( )

Multiple separate changes that happened a short time from each other.

You can mark times on the history scale by creating baselines to quickly return to the marked 
view.

Procedure

1. Open the application service map.

a. Navigate to All  > CSDM  > Manage Technical Services  > Application Service.

b. Select the needed application service.

c. On the application service page, select View Map.

2. Review change records created for this application service  on the Changes  tab at the bottom 
of the page.

If Service Mapping  is deployed, then in Edit mode, the Discovery Messages section appears 
below the map.

3. On the history timeline, set the time range of changes that you want to view.
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The map shows the history view of the application service for the time you selected.

Note: 
The Change  tab shows all change records, even the ones which are filtered out of the 
history view.

4. To mark a time on the time scale, set a baseline:

a. Click the Compare  icon.

b. Navigate to the time you want to mark as a baseline on the history scale.

c. Click Set baseline.

d. Enter the name of the baseline and click OK.
The new baseline appears as a button above the history scale and as a blue flag on the 
history scale.

5. View the change history.

6. To exit the history view and see the current status of the application service, click the current 
icon.

Related topics

View an application service map in base system

Compare two versions of an application service in classic Service Mapping

Modify tracking changes in configuration files

Fine-tune tracking changes for the change history
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Compare two versions of an application service in classic  Service Mapping

You can see a summary of application service changes at a glance by comparing two versions 
of an application service. This feature is useful for checking the application service status before 
and after a certain change or problem.

Before you begin
Role required: admin, app_service_admin, app_service_user, sm_admin, or sm_user

About this task
Specify two points in time for which to compare the two versions of an application service. 
You can use the change indicators on the timeline to specify one point in time that is before 
and another that is after a change for which to see the details. For example, if you know that 
the application service started to fail at a certain time, you can compare two versions of the 
application service, one before and one after the problem started. This comparison lets you see 
the summary of changes that possibly led to the problems.

Service Mapping, if deployed, tracks and shows all changes to a CI including configuration files 
associated with a CI. When you compare two versions of an application service, you can see 
changes made to configuration files as changes to CIs. You can also compare two versions of a 
configuration file to see the actual changes in the files, during the time range specified for the 
comparison.

Procedure

1. Open the application service map.

a. Navigate to All  > CSDM  > Manage Technical Services  > Application Service.

b. Select the needed application service.

c. On the application service page, select View Map.

2. If needed, click Edit  to ensure that the map is in Edit mode.

If Service Mapping  is deployed, then in Edit mode, the Discovery Messages section appears 
below the map.

3. On the history timeline, set the time range of changes that you want to view.
The map shows the history view of the application service for the time you selected.

Note: 
The Change  tab shows all change records, even the ones which are filtered out of the 
history view.

4. Click the Compare  icon.

5. Set Compare point 1  and Compare point 2  as the two points in time for the comparison.

You can drag the pointers on the history scale to set corresponding time points.
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If the history scale does not include the time set for comparison, then its corresponding 
pointer appears next to the compare point in yellow:

Note: 
If there are no changes to the service during the time interval specified by Compare 
point 1  and Compare point 2, then no change details are displayed.

6. Click Compare.
The comparison view opens in a separate tab.

7. Select a marked CI to see the relevant change record on the Changes  tab.

8. Optional:  If Service Mapping  is deployed, you can compare two versions of a configuration file 
that appears on the map as Updated:

a. Select the CI that is associated with the updated configuration file.

b. In the Properties  pane, click the link to the updated file.
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The Tracked Configuration Files Version Compare  tab opens showing two versions of the 
configuration file side by side.

c. Review actual changes.

(Optional) Highlight colors indicate the type of change:

▪ Purple — Updated line

▪ Pink — New line

▪ Gray — Deleted line

d. Navigate between the changes using the arrows in the upper right corner.

e. Close the Tracked Configuration Files Version Compare  tab when finished.

9. Close the comparison view when finished.

Related topics

View the change history of application services in classic Service Mapping

Compare versions of CI configuration files

Use application services APIs

Application services provide APIs that let you perform operations such as creating and updating 
an application service, populating it with CIs from the CMDB, and retrieving details from an 
existing application service.
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Role required: app_service_admin

An application service is a set of interconnected applications and hosts which are configured to 
offer a service to the organization. Application services can be internal, like an organization email 
system or customer-facing, like an organization website.

Create an application service

Using the createOrUpdateService - POST  REST API to create an application service  suits your 
organization if the ServiceNow  CMDB  already contains the CIs making up the service. Typically, 
it is the case when you have manually added CIs directly into the CMDB, or used the Discovery 
application to discover CIs and store information about them in the CMDB. You can also use 
this API to create an application service  containing CIs discovered using non-ServiceNow 
applications.

By default, when an application service  is created, all CI connections are of the Depends 
on::Used by  relationship type. You can modify this default type by changing the value of the 
sa.it_service.manual_ci_rel_type  property.

Before creating an application service, ensure that:

• The CMDB contains all the CIs comprising the application service.

• You have the sys_id of each CI comprised in the application service you want to create.

• You understand the hierarchy that the CIs form.

The Mapped Application Service [cmdb_ci_service_discovered] table contains every application 
service  including services you create using APIs.

You can also manually create an application service  using the user interface as described in 
Create an application service.

Retrieve content from an application service

Use the getContent - GET  REST API to retrieve a list of CIs and the relationships between them, 
for an application service that was created manually.

Additional APIs

The following JavaScript APIs are also available:

• addCI() : Add a CI to a manually created an application service.

For restrictions on the CIs being added and other details about adding a CI to an application 
service, see Manually add CIs to an application service.

• addManualConnection() : Add a manually created connection to an application service.

• migrateManualToApplicationService() : Convert a manual service to an application service.

• populateApplicationService() : Populate an application service with CIs and relationships 
from the designated entry point.
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• removeCI() : Remove a manually created CI from an application service.

• removeManualConnection() : Remove a manually created connection and the connected CI 
from an application service.

Related topics

Application Service API

Components installed with application services

Several types of components are installed with activation of the Application Service 
[com.snc.cmdb.it_service] plugin, including tables, user roles, and scheduled jobs.

Note: 
The Application Files table lists the components that are installed with this application. 
For instructions on how to access this table, see Find components installed with an 
application .

Roles installed

Role title [name] Description
Contains 
roles

[app_service_user]
Views maps for operational application services and retrieves 
service content using the getContent - GET REST API. The itil 
role that serves as the basic helpdesk technician role contains 
the app_service_user role.

None

[app_service_admin]
Creates and modifies application services, creates service 
groups, views, and edits application service maps.

itil

Tables installed

Table Description

BaseLines

[sa_baselines]

Storing points in the time defined as baselines for 
application services.

Business Service User preferences

[sa_business_service_user_prefs]

User preferences associated with a specific 
application service.

Menu Action

[sa_context_menu]

Data on configurable menu options for CIs in the 
application service map.

Hash

[sa_hash]

Internal table which contains counters and hashes 
on various types of updates related to application 
services.

Entry Point Maps entry points to application services.
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Table Description

[sa_m2m_service_entry_point]

Discovered Service Notification

[sa_notification]

Internal table which contains data on notifications 
between different parts of the software. Mostly 
used after activating Service Mapping.

Service Group Members

[sa_service_group_member]

Maps service groups to application service 
members.

Business Service Group Responsibilities

[sa_service_group_responsibilities]

Data on users having access to application service 
groups.

Checkpoint Attribute Description

[checkpoint_attribute_description]

Links between history timeline changes and 
service model internal entities (checkpoints). Used 
in lists of history of changes in application service 
maps.

Application Service

[cmdb_ci_service_auto]

Services that can be monitored by the system, 
which in the base system, includes only 
application services. If Service Mapping is 
activated, there can also be records for dynamic 
CI groups. If Event Management is activated, there 
can be records for alert groups.

Mapped Application Service

[cmdb_ci_service_discovered]

Application service CIs. For each application 
service, there is a container CI record that models 
the application service.

Bulk Convert Services

[cmdb_convert_bulk_services]

All bulk conversions of business services to 
application services (current and past), along with 
the conversion progress which is refreshed every 
10 seconds.

Application Services Action Results

[csdm_dashboard_action_report_result]

Results for the 'Application Services Missing Data' 
report in the Application Service Dashboard.

Application Services Types Results

[csdm_dashboard_type_report_result]

Results for the 'Application Services by Type' 
report in the Application Service Dashboard.

Application Services Dashboard Results

[csdm_dashboard_reports_result]

Results for the '<Application Servers | Databases | 
Hardware Servers> Not in an Application Service' 
reports in the Application Service Dashboard.

Manual CI Inclusions / Exclusions 
[svc_manual_ci_exclusions_inclusions.list]

Contains CI classes included or excluded 
from application services during population of 
manual or dynamic application services. Service 
population happens when

• Manually adding CIs to an application service

• Converting a business service to an application 
service
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Table Description

• Creating or updating an application service 
using APIs

• Manually updating an application service with 
changes from the CMDB

In the base system, the following CI classes are 
excluded:

• cmdb_ci_file_system

• cmdb_ci_network_adapter

• cmdb_ci_storage_device

• cmdb_ci_disk_partition

• cmdb_ci_memory_module

• cmdb_ci_ip_address

• cmdb_ci_storage_pool_member

• dscy_net_base

• cmdb_ci_storage_export

• cmdb_ci_endpoint

• cmdb_ci_translation_rule

• cmdb_ci_qualifier

• cmdb_ci_application_cluster

• cmdb_ci_config_file

CIs of any CI class that is not configured for 
exclusion in this table can be added to application 
services.

This table supports the functionality that was 
earlier supported using the following deprecated 
property: sa.mapping.user.manual.citype.blacklist.

Properties installed

To access application services properties, navigate to All  > Configuration  > Application 
Services  > Properties. The role required for modifying property values, is app_service_admin.

If Service Mapping  is deployed, see Properties installed with Service Mapping  for additional 
application service properties.

Note: 
To open the System Properties [sys_properties] table, enter sys_properties.list  in 
the navigation filter.
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Property Usage

The sys_id of the default relation type to be added 
between source and target when adding CI manually to 
application service

sa.it_service.manual_ci_rel_type

• Type: string

• Default value: 
5599a965c0a8010e00da3b58b113d70e 
(Depends on::Used by)

• Learn more: Manually add CIs to an 
application service

Coefficient of aggregation interval. 0 value means 
no aggregation is performed on history timeline. The 
purpose of this property is to decrease number of 
changes in history timeline by increasing the interval 
allowed between changes

sa.history.aggr_interval_coef

• Type: integer

• Default value: 1

A list of comma delimited CI types that are 
excluded when using the 'Convert to Application 
Service' and 'Populating Application Service 
from CIs in the CMDB' operations. Example: 
cmdb_ci_service,cmdb_ci_endpoint,cmdb_ci_hardware

sa.mapping.user.manual.citype.blacklist

This property is deprecated in Tokyo.

This exclusion list applies when:

• Manually adding CIs to an application 
service

• Converting a business service to an 
application service

• Creating or updating an application 
service using APIs

• Manually updating an application 
service with changes from the CMDB

• Type: string

• Default value: None

Sync Service Mapping operations with Service 
Modeling

sa.service_modeling.use

• Type: true|false

• Default value: true

Enable limitation of application service maps drawing 
by number of nodes and edges.

sa.map.LIMIT_MAX_GRAPH_SIZE

Limit the number of nodes and edges on 
application service maps.

• Type: true|false

• Default value: true

Setting this property to false may reduce 
performance in maps of large services.
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Property Usage

Maximal number of displayable nodes on application 
service map. Maps with larger values will not be 
displayed.

sa.map.MAX_NODES_FOR_LAYOUT

The max number of nodes displayed on 
an application service map. If the number 
of nodes exceeds the specified number, 
the map does not appear and an error 
message appears.

• Type: integer

• Default value: 5000

Global flag to allow or disable spanning tree view for 
maps. true (default) - allows but not forces spanning 
tree view on maps.

sa.map.ALLOW_SPANNING_TREE_VIEW

Enable spanning tree view for application 
service maps.

• Type: true|false

• Default value: true

Maximal number of displayable edges on application 
service map before spanning tree view applied.

sa.map.MAX_EDGES_FOR_FULL_LAYOUT

The max number of edges displayed on an 
application service map, before applying 
spanning tree view.

• Type: integer

• Default value: 1000

Maximal number of displayable edges on application 
service map. Maps with larger values will not be 
displayed.

sa.map.MAX_EDGES_FOR_LAYOUT

Max number of edges displayed on an 
application service map. If the number 
of edges exceeds the specified number, 
the map does not appear and an error 
message appears.

• Type: integer

• Default value: 100000

Increasing the default value may reduce 
performance in maps for large services.

Maximal degree of node on application service map 
for large map mode. Maps with smaller degrees will be 
displayed in regular mode. Maps with larger degrees will 
apply more edges merging for more compact view.

sa.map.LIMIT_GRAPH_DEGREE

• Type: integer

• Default value: 1000

Increasing the default value may reduce 
performance in maps for large services.

Limit of amount of services that displayed on Services 
Tree on maps. Then this limit reached, Services Tree will 
be blocked.

sa.service_tree.MAX_ITEMS_TO_DISPLAY

• Type: integer

• Default value: 7000
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Property Usage

Maximal amount of connection properties to be shown 
at once when connection line selected on service map. 
If selected line contains more connections than defined 
here, then properties panel will have notification about 
cut-off connections.

sa.map.max_connections_in_properties_panel

• Type: integer

• Default value: 50

Enable grouping of CIs on map.

sa.map.enable_auto_grouping

• Type: true|false

• Default value: true

Minimal number of CIs on a map to apply CI grouping. 
Relevant only if CI grouping is enabled on the map. 
The following CIs are not counted: discovered clusters, 
internal CIs inside inclusion boxes, entry points, error 
nodes, host CIs or CIs that are not hosted on other CIs.

sa.map.min_nodes_for_auto_grouping

• Type: integer

• Default value: 10

Render full labels on CIs on map. Applicable to all 
CI labels (CI name, host name, cluster label, etc.) 
Enabling this will disable labels truncation, and labels 
will most probably overlap with other map elements. Not 
applicable to network/storage path maps.

sncCommonMap.RENDER_FULL_LABELS

The default value of disabled, means 
none.

• Type: choice list

• Default value: Disabled

• Other possible values:

◦ Exported PDF only: pdf

◦ Map and PDF views: all

Maximal width of CI node labels in pixels. Relevant for 
any kind of labels (CI name, host name, cluster label 
etc.) This size also modifies horizontal space between 
CI elements. Applied to map view and exported PDF 
view. Not applicable to network/storage path maps.

sncCommonMap.NODE_LABEL_WIDTH

• Type: integer

• Default value: 95

• Other possible values:

◦ Min value: 20

◦ Max value: 1000

glide.cmdb.csdm.app_service.max_results Max number of items that are calculated 
in the '<Application Servers | Databases | 
Hardware Servers> Not in an Application 
Service' report in the Application Service 
Dashboard.

• Type: integer

• Default value: 100000

• Location: Add to System Properties 
[sys_properties]  table.
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Property Usage

sa.service.max_ci_service_population The maximum number of CI connections 
added to application services during the 
following operations: Converting manual 
services created in Event Management 
into application services and updating 
application services with changes from the 
CMDB.

• Type: integer

• Default value: 1,000

• Location: Add to System Properties 
[sys_properties]  table.

Increasing the default value may cause 
performance issues.

sa.service.population.stop_expansion_under_ci_classes List of application service CI classes. If 
an application service belongs to a CI 
class that extends one of the CI classes 
in the list, the system does not insert CIs 
under this application service CI during 
Manually updating an application service 
with changes from the CMDB.

• Type: string

• Default value: 
cmdb_ci_service_discovered

• Location: System Property 
[sys_properties] table.

Integrating third-party data into CMDB
Import and integrate third-party data into Configuration Management Database (CMDB)  classes.

Available methods

Use the combination of the following data integration methods to integrate third-party data into 
CMDB.

Integration Commons for CMDB

Framework that provides a set 
of common operations and 

functionalities for integrations.

IntegrationHub 
ETL

ETL transform 
maps for 

integrations.

Service Graph 
Connectors

Connectors for bringing 
in third-party data 

correctly and quickly.
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API Service Graph Connectors

Connectors for bringing in 
API data correctly and quickly.

Enhanced integration solutions

Simplify integration and resolve issues with the following enhanced integration solutions.

Service Graph Connector Central

A CMDB Workspace view for managing the full life cycle of creating, 
editing, monitoring, and debugging Service Graph Connector connections.

Related applications and features

CMDB schema model

A collection of class diagrams and class attributes for key CMDB  classes.

CMDB tables descriptions

Descriptions of key CMDB  tables in the base system.

CMDB  CI Class Models

A ServiceNow Store  app that adds class models that extend the base CMDB  class 
hierarchy. The hierarchy includes class descriptions, identification rules, identifier 
entries, and dependent relationships, if applicable. You can then use the added 
classes as any other CMDB  base class.

Populating the CMDB

Options for populating the CMDB.

Discovery patterns

A ServiceNow Store  app that provides a library of discovery patterns for discovering 
specific devices and applications in the industry.

CMDB Identification and Reconciliation

A centralized framework for identifying and reconciling data from different data 
sources that helps maintain the integrity of the CMDB  when multiple data sources 
are used to create and update configuration item (CI) records.

Integration Commons for CMDB

The Integration Commons for CMDB  (sn_cmdb_int_util) store app contains the CMDB 
Integrations Dashboard  and a set of Robust Transform Engine (RTE) transforms and script 
includes.
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Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Dependencies

CMDB and CSDM Data Foundations Dashboards v2.3.5 or later versions (see Monitor system 
foundations in the CSDM and the CMDB Data Foundations Dashboards)

Using the CMDB  Integrations Dashboard

The Integration Commons for CMDB  store app provides a dashboard with a central view of the 
status, processing results, and processing errors of all installed Service Graph Connectors  and 
any custom integrations created in IntegrationHub ETL.

See CMDB Integrations Dashboard  for more information.

Using RTE transforms

The Integration Commons for CMDB  (com.snc.cmdb.integration_util) plugin provides the 
Integration Commons functionality. You can use the transforms and script includes to 
standardize the values stored in the CMDB by different data integrations or by changes. The 
attributes that are included in the Integration Commons for CMDB  store app are attributes that 
the Identification and Reconciliation Engine (IRE) requires for identification or attributes that 
could be used to derive classes.

The transforms are common operation types and template scripts available as templated 
operations. A templated operation is a transform that controls the logic for the transform. The 
result is that there can be only a single output. When a transform returns multiple values, then 
those values are concatenated by a triple pipe (|||). You then must use the split transform to 
retrieve the values that you’re interested in. The inputs are either a single field or a list of fields. 
For all but one transform, the inputs are assumed to be a fixed list of fields as described for each 
of the following individual transform.

Note: 
The RTE transforms are included in the Integration Commons for CMDB  store app and are 
available in the IntegrationHub ETL  store app. For more information on RTE transforms, 
see  RTE operation types included within the Integration Commons for CMDB app  and  RTE 
transforms template scripts included within the Integration Commons for CMDB app.

ServiceNow  Service Graph Connectors  that are available at the ServiceNow Store, have 
dependencies on the transforms and script includes in the Integration Commons for CMDB  store 
app. Therefore, when you install such CMDB integration, the Integration Commons for CMDB 
store app is automatically installed too.

You can also configure the Application Dependency Mapping (ADM) adapter to populate running 
processes, TCP connections, and applications into CMDB. For more information, see Configuring 
the ADM adapter for Service Graph Connectors.

Important: 
After upgrades and deployments of new applications or integrations, run quick start tests 
to verify that Integration Commons for CMDB  works as expected. See Quick start tests for 
Integration Commons for CMDB  for more information.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

802

https://store.servicenow.com/sn_appstore_store.do#!/store/home
https://store.servicenow.com/sn_appstore_store.do#!/store/home
https://store.servicenow.com/sn_appstore_store.do#!/store/home
https://docs.servicenow.com/bundle/store-release-notes/page/release-notes/store/sn-store-release-notes.html
https://docs.servicenow.com/bundle/store-release-notes/page/release-notes/store/sn-store-release-notes.html
https://docs.servicenow.com/bundle/store-release-notes/page/release-notes/store/sn-store-release-notes.html
https://docs.servicenow.com/bundle/store-release-notes/page/release-notes/store/sn-store-release-notes.html


Related topics

Configuring the ADM adapter for Service Graph Connectors

Accessing the connection details of Service Graph Connectors

Managing CMDB data deletion

Partition size computation for parallel loading in Integration Commons for CMDB

Quick start tests for Integration Commons for CMDB

CMDB  Integrations Dashboard

You can use the CMDB  Integrations Dashboard  that provides a central view of status, processing 
results, and processing errors of all installed Service Graph Connectors  and any custom 
integrations created in IntegrationHub ETL  run.

The CMDB  Integrations Dashboard  is available with the Integration Commons for CMDB 
(sn_cmdb_int_util) store app. On the dashboard, you can see metrics for all Service Graph 
Connector  runs, or filter the view to a specific connector, a specific time duration, or a specific 
connector run.

Learn more about the CMDB  Integrations Dashboard  from the following video.

CMDB Integrations Dashboard overview

Access CMDB  Integrations Dashboard

Access the CMDB  Integrations Dashboard  provided with the Integration Commons for CMDB 
store app for maintaining data consistency and accuracy across multiple data sources.

Before you begin
Role required: None

Procedure

1. Navigate to Self-Service  > Dashboards.

2. On the Dashboards view, select CMDB Integrations Dashboard  and do any of the following 
actions:

◦ Select the CMDB Execution Status  tab to see metrics such as the total number of 
integrations and processed rows, integration runs actively running, daily statistics, and 
details about the classes that were updated.

◦ Select the CMDB Integration Errors  tab to see metrics such as number of import and 
integration errors, and number of erroneous imported records.

◦ Point to the score on the various tiles to drill down to the list views for the associated 
records. Point to the charts to show more details for the chart.

◦ Narrow down the scope of the integration runs included in the metrics on the dashboard 
by configuring filters on the right-hand side of the dashboard. Set any of the following filters 
and then select Apply. The filter settings apply to any metric with a filter icon in its upper left 
corner.

Filters

Filter Description

Import Date Select All  or a time period, such as Last 7 
days, from which to include integration runs 
in metrics.
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Filter Description

CMDB Applications Select All, or a CMDB application, such as 
SCCM, or a custom integration, from which 
to include integration runs in metrics.

CMDB Import Select All, or a specific integration run to 
include in metrics.

RTE operation types included within the Integration Commons for CMDB  app

The Robust Transform Engine (RTE) operation types are common operation methods for use in 
ETL without having to write your own complex data transformations.

The following operation types are available in the Integration Commons for CMDB  app.

Concatenation

Combines the values from input fields into a single string, joining them on the optional 
joining_string  field.

Details

Table RTE Entity Concatenation Operation [sys_rte_eb_concat_operation]

Input field source_sys_rte_eb_fields

Input is a set of fields and constants.

Output field target_sys_rte_eb_field

Output is the combined value of the provided fields as a single string.

Additional fields joining_string  (optional)

Example

Input joining_string Result

"input_1", "input_2", "input_3" ", " "input_1, input_2, input_3"

Convert to Boolean

Converts the incoming value to a Boolean.

Details

Table RTE Entity Convert to Boolean Operation 
[sys_rte_eb_to_boolean_operation]

Input field source_sys_rte_eb_field

Input is a string value.

Output field target_sys_rte_eb_field
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Details

Output is true  when input is true  or 1, otherwise output is false. (case 
insensitive)

Example

Input Result

input_1 false

true true

1 true

0 false

11 false

Convert to Date

Attempts to convert the incoming value to a GlideDateTime value by applying the date_format to 
the incoming value.

Details

Table RTE Entity Convert to Date Operation [sys_rte_eb_to_date_operation]

Input field source_sys_rte_eb_field

Input is a data timestamp value with date format.

Output field target_sys_rte_eb_field

Output is the date timestamp in the specified date format. Attempts to 
directly convert using GlideDateTime if the date_format is incorrect. Returns 
an empty value if unable to parse at all.

Example

Input Result

"2018/09/20 11:21:00 AM EST" with 
date_format "yyyy/MM/dd hh:mm:ss a z"

"2018-09-20 16:21:00"

"2018/09/20 01:21:00 PM EST" with 
date_format "yyyy/MM/dd hh:mm:ss a z"

"2018-09-20 18:21:00"

"09/20/18" with date_format "yyyy/MM/dd 
hh:mm:ss a z"

""0018-09-20 00:00:0"

Convert to Numeric

Converts the incoming value to a number.
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Details

Table RTE Entity Convert to Numeric Operation 
[sys_rte_eb_to_numeric_operation]

Input field source_sys_rte_eb_field

Input is a value.

Output field target_sys_rte_eb_field

Output is a numeric value. If the input value is non-numeric the output is 
empty.

Example

Input Result

input_1 null

1.23 1.23

1.00 1

two null

Copy

Copies the value of the source field to all the target fields.

Details

Table RTE Entity Copy Operation [sys_rte_eb_copy_operation]

Input field source_sys_rte_eb_field

Input is a value.

Output field target_sys_rte_eb_fields

Output is the copied source field value.

Additional field overwrite_existing_value  (optional, Boolean): If true, then the 
values of the target fields are replaced. Otherwise, any non-empty value 
isn’t overwritten.

Extract First Numeric

Sets the target field as the first numeric value found in the source field.

Details

Table RTE Extract Numeric Operation [sys_rte_eb_extract_numeric_operation]

Input field source_sys_rte_eb_field

Input is a value.
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Details

Output field target_sys_rte_eb_field

Output is the numeric value found in the input.

Additional fields • decimal_places  (optional, number) : Forces the output to have a 
specified number of decimal places.

• remainder_target_field  (optional, reference to field): Set to the 
trimmed remainder of the source field, after removing the first numeric 
value.

Example

Input Result

100 mb 100

100.123 mb 100.123

100.123 mb with decimal_places=2 100.12

100 mb with decimal_places=2 100.00

100 mb with remainder_target_field mb

Glide Lookup Operation

Performs a lookup in the database on the target table specified in the target_table  field.

Details

Table RTE Glide Lookup Operation [sys_rte_eb_glide_lookup_operation]

Input field source_sys_rte_eb_fields

The database table for lookup.

Output field target_sys_rte_eb_fields

The resulting data based on the lookup operation.

Additional fields • target_table

• glide_matching_fields  (string): Comma-separated 
list of column names in the target table. For each input field in 
source_sys_rte_eb_fields, there must be an equal number of values in 
glide_matching_fields.

• glide_target_fields  (string): Comma-separated list of column 
names in the target table. For each target field in target_sys_rte_eb_fields, 
there must be an equal number of values in glide_target_fields.
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Example

Input Result

• Input Field 1: 100 South Charles Street, 
Baltimore

• Input Field 2: MD

• Target Table: Location (cmn_location)

• Glide Matching Fields: street,state

• Glide Target Fields: sys_id

Output Field 1: 
25ab9c4d0a0a0bb300f7dabdc0ca7c1c

Multiple Input Script

Runs a script with multiple inputs setting the target_sys_rte_eb_field  field as the 
output for that script.

Details

Table RTE Entity Multiple Input Script Operation 
[sys_rte_eb_multi_in_script_operation]

Input field source_sys_rte_eb_fields

Input is a script.

Output field target_sys_rte_eb_field

Output is the result of the input script.

Additional Fields • script  (script)

• use_unique_input_sets(Boolean): When true, only unique input 
values are included in the data batch for IRE processing. Otherwise, all 
input object’s field values are included.

Example for using use_unique_input_sets, with a script function that takes 
record_type  and operating_system  as input and returns record_with_os:

Examples

Record record_type operating_system

1 computer Windows XP

2 computer Linux

3 computer Windows XP

If use_unique_inputs_sets is set to true, then the script processes only two values (computer 
+ Windows XP  and computer  + Linux). If use_unique_inputs_sets  is set to 
false, then each of the three values is individually processed (computer  + Windows XP, 
computer  + Linux, and computer  + Windows XP).
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Sample script:

(function(batch, output) {
                for (var i = 0; i < batch.length; i++) {
                        // batch[i] is the unique set of 
 inputs/individual record
                        // batch[i].<field> gives access to the 
 field value
                        var in0 = gs.nil(batch[i].record_type) ? 
 '' : batch[i].record_type;
                        var in1 = 
 gs.nil(batch[i].operating_system) ? '' : 
 batch[i].operating_system;
                        // output[i] is the output for the 
 specific combination of inputs/individual record
                        output[i] = in0 + "_" + in1;
                    }
                }
            })(batch, output);

Multiple Input/Output Script

Runs a script with multiple inputs setting the target fields specified in the 
target_sys_rte_eb_fields  field as the multiple outputs for that script.

Details

Table RTE Entity Multiple Input/Output Script Operation 
[sys_rte_eb_multiple_input_output_script_operation]

Input field source_sys_rte_eb_fields

Input is a script.

Output field target_sys_rte_eb_fields

Output is the result of the input script.

Additional Fields script  (script)

Sample script:

(function(batch, output) {
                for (var i = 0; i < batch.length; i++) {
                        var userId = (batch[i].user_id);
                        var userIdParts = userId.split(".");
                        output[i].first_name = userIdParts[0];
                        output[i].last_name = userIdParts[1];
                    }
                }
            })(batch, output);

Regex Replace

Replaces each substring of the input string that matches the regular expression pattern 
specified in the match_regex  field with the string specified in the replacement_regex 
field.
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Details

Table RTE Entity Regular Expression Replace Operation 
[sys_rte_eb_regex_replace_operation]

Input field source_sys_rte_eb_field

Input is a string value.

Output field target_sys_rte_eb_field

Output is the replaced string.

Additional fields • match_regex  (string, regular expression)

• replacement_regex  (string)

Example

Input Result

"String&With(Special)$Characters" 
with match_regex="[^0-9a-zA-Z]+" and 
replacement_regex=" "

"String With Special Characters"

Replace

Replaces each substring of the input string that matches the string specified in the 
match_string  field with the string specified in the replacement_string  field.

Details

Table RTE Entity Replace Operation [sys_rte_eb_replace_operation]

Input field source_sys_rte_eb_field

Input is a string value.

Output field target_sys_rte_eb_field

Output is the replaced string.

Additional fields • match_string  (string)

• replacement_string  (string)

Example

Input Result

"Original String" with match_string = "Original" 
and replacement_string= "Replacement"

"Replacement String"
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Round Numeric

Rounds off the input numeric value to the nearest whole number.  Non-numbers are truncated.

Details

Table RTE Entity Round Numeric Operation 
[sys_rte_eb_round_numeric_operation]

Input field source_sys_rte_eb_field

Input is a numeric value.

Output field target_sys_rte_eb_field

Output is a whole number.

Additional fields • match_string  (string)

• replacement_string  (string)

Example

Input Result

"1.5" "2"

"1.4" "1"

"i’m a string" ""

Script Operation

Runs a script with an input and sets the target_sys_rte_eb_field  field as the output for 
that script.

Note: 
The Script operation type has been largely superseded by the Multi Input Script Operation 
and is included for backwards compatibility with the existing configurations.

Details

Table RTE Entity Script Operation [sys_rte_eb_script_operation]

Input field source_sys_rte_eb_field

Input is a script.

Output field target_sys_rte_eb_field

Output is the result of the input script.
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Details

Additional fields • script(script)

• use_unique_input_sets  (Boolean): When true, only unique input 
values are included in the data batch for IRE processing. Otherwise, all 
input object’s field values are included. For an example and for more 
details, see the Multiple Input Script transform.

The source field is included in the ‘batch’ variable as the JavaScript field ‘input’.

(function(batch, output) {
                for (var i = 0; i < batch.length; i++) {
                        // batch[i] is the unique set of 
 inputs/individual record
                        // batch[i].input gives access to the 
 field value
                        var in0 = gs.nil(batch[i].input) ? '' : 
 batch[i].input;
                        // output[i] is the output for the 
 specific combination of inputs/individual record
                        output[i] = in0 + " modified by script";
                    }
                }
            })(batch, output); 

Example:

/* Example Script
 (function(batch, output) {
     for (var i = 0; i < batch.length; i++) {
         //step1: access the input variables
         var a = batch[i].input; //Value of the source field.
 
         //step2: Your script/code goes here.
         var b = a + 1;
         //step3: set the output for each elements
         output[i] = b;
     }
 })(batch, output);
*/ 

Set

Sets the target_sys_rte_eb_field  field value to the string provided in the set_value 
field.

Details

Table RTE Entity Set Operation [sys_rte_eb_set_operation]

Output field target_sys_rte_eb_field

Output is the value associated with the set_value  field.
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Details

Additional fields • set_value  (string)

• overwrite_existing_value  (optional, Boolean) : When true, the 
current value of the target field is overwritten. Otherwise, a non-empty 
value isn't replaced.

Set Min/Max

Sets the target field to either the maximum or minimum of the values from all input fields.

Details

Table RTE Entity Min/Max Operation [sys_rte_eb_min_max_operation]

Input field source_sys_rte_eb_fields

Input is a set of values.

Output field target_sys_rte_eb_field

Output is the maximum or minimum value based on the min_max  value.

Additional fields • data_type  (choice list with values as STRING, NUMERIC, and DATE)

• min_max  (choice list with values as MIN and MAX)

Examples

Input Output

"2", "-1", "0" 2

"a", "b" c

"2", "-1", "0" -1

"a", "b" a

Split

Splits the string included in the source_sys_rte_eb_field  input value at the separator 
specified in the splitting_string  field and assigns the resulting array of strings to the 
target_sys_rte_eb_field  field, in order.

Details

Table RTE Entity Split Operation [sys_rte_eb_split_operation]

Input field source_sys_rte_eb_field

Input is a string value.

Output field target_sys_rte_eb_fields
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Details

Output is list of substrings.

Additional fields splitting_string  (string)

Example

Input Result

"value1||value2||value3", splitting_string:"||" 
with target_sys_rte_eb_fields 
{target1,target2,target3}

target1 : value1, target2 : value2, target3 : 
value3

"value1||value2||value3", splitting_string:"||" 
with target_sys_rte_eb_fields {target1}

target1 : value1

"value1", splitting_string:"||" 
with target_sys_rte_eb_fields 
{target1,target2,target3}

target1 : value1, target2 : <null>, target3 : <null>

Trim

Removes any whitespaces at the beginning and at the end of the string included 
in the source_sys_rte_eb_field  input value and assigns the result to the 
target_sys_rte_eb_field  field.  This transform is equivalent to the Java String trim() 
Method.

Details

Table RTE Entity Trim Operation [sys_rte_eb_trim_operation]

Input field source_sys_rte_eb_field

Input is a string value.

Output field target_sys_rte_eb_field

Output is the input string value but without any leading and trailing spaces.

Example

Input Result

" value 1 " "value 1"

Uppercase

Changes all characters of the source_sys_rte_eb_field  input value to upper case and 
assigns the result to the target_sys_rte_eb_field  field.

Details

Table RTE Entity Upper Case Operation [sys_rte_eb_upper_case_operation]

Input field source_sys_rte_eb_field
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Details

Input is a string value.

Output field target_sys_rte_eb_field

Output is the upper case string value.

Example

Input Result

"value1" "VALUE1"

Uppercase Trim

Combines both the Uppercase and the Trim transforms.

Details

Table RTE Entity Upper Case Trim Operation 
[sys_rte_eb_upper_case_trim_operation]

Input field source_sys_rte_eb_field

Input is a string value.

Output field target_sys_rte_eb_field

Output is the upper case string value without any whitespaces at the 
beginning and end.

Example

Input Result

"      value1    " "VALUE1"

RTE transforms template scripts included within the Integration Commons for CMDB  app

The Robust Transform Engine (RTE) transforms are templated operations included within the 
Integration Commons for CMDB  (sn_cmdb_int_util) store app.

The following script-based RTE transforms are available in the Integration Commons for CMDB 
app.

CI Lookup Operation

Use to get the value of a field on an existing configuration item (CI) in the CMDB by the source 
native key.

Details

Table Robust Transform Engine CI Lookup Operation 
[sn_cmdb_int_util_ci_lookup_operation]

Input field source_sys_rte_eb_field
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Details

Input in order is:

1. Discovery Source

2. Source Native Key

3. CI Field

The operation queries the Source [sys_object_source] table for the 
discovery source and the associated source native key, and then returns 
the CI Field value of the matching record in the target table and the 
associated target sys ID.

Output field target_sys_rte_eb_field

Output is the value of the field name on the CI matched by the source 
native key lookup or an empty string if there is no match.

The Source [sys_object_source] table is queried using the discovery source and source native 
key ordering by the last scan. The table iterates through the results of the query and queries the 
target table by the target sys ID until a valid CI is found. After a valid CI is found, the operation 
returns the value of the CI Field on the matching CI.

Example

Discovery Source Source Native Key CI Field Result

ServiceNow ServiceNow|||
COMPUTER-NAME|||
Computer-01

name Computer-01

Cleanse Company

Use to cleanse hardware manufacturer name and add the record to the Company 
[core_company] table to populate a reference, when the manufacturer is not linked to a model or 
software (cpu_manufacturer).

Details

Table Robust Transform Engine Entity Cleanse Company Operation 
[sn_cmdb_int_util_cleanse_company_operation]

Input field source_sys_rte_eb_field

Input is a company/manufacturer name.

Output field target_sys_rte_eb_field

Output is the resulting sys_id and name of the company in core_company, 
concatenated by triple pipe (|||).

Script include 
function

sn_cmdb_int_util.CmdbIntegrationHardwareModelUtil().cleanseCompany(input)

If a matching record does not exist, then a new record is created in core_company so the return 
always includes a sys_id and name (unless the input is empty or invalid). The name is cleansed 
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and a fuzzy lookup is done via the CmdbIntegrationCompanyModelUtil script include before the 
MakeAndModelJS platform API is called.

Example

Input Result

SERVICENOW 93d4ecfac0a8000b6294d71b733977fb|||
ServiceNow

Cleanse Hardware Model

Use to create, cleanse, or lookup a hardware model to create a reference (model_id).

Details

Table Robust Transform Engine Entity Cleanse Hardware Model Operation 
[sn_cmdb_int_util_cleanse_hardware_model_operation]

Input fields source_sys_rte_eb_fields

Input in order is:

1. The manufacturer name

2. The model name

If either value is provided by itself, then the operation only processes what 
is found.

Output field target_sys_rte_eb_field

Output is the resulting sys_id and name of the company in core_company, 
and sys_id and name of the model in cmdb_model - all concatenated by 
triple pipe (|||).

Script include 
function

sn_cmdb_int_util.CmdbIntegrationHardwareModelUtil().cleanseModelAndCompany(manufacturer_in, 
model_in)

For either the manufacturer or model, if a matching record does not exist then a new record is 
created so the return always includes sys_ids and names for both records (unless the input is 
empty or invalid).

The manufacturer name is processed like the Cleanse Company transform and then the 
manufacturer name and model name  are sent to the MakeAndModelJS platform API.

Example

Manufacturer Name Model Name Result

ServiceNow Incorporated SERVICENOW 93d4ecfac0a8000b6294d71b733977fb|||
ServiceNow|||
ba29cb303710200044e0bfc8bcbe5d6d 
|||ServiceNow

Cleanse Hardware Model with Model Number

Use to create, cleanse, or lookup a hardware model to create a reference (model_id).
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Details

Table Robust Transform Engine Entity Cleanse 
Hardware Model With Model Number Operatio 
[sn_cmdb_int_util_cleanse_hardware_model_number_operation]

Input fields source_sys_rte_eb_fields

Input in order is:

1. The manufacturer name

2. The model name

3. The model number

4. CI Class

Note: 
The CI Class  field is an optional input field, and when included, 
the MakeAndModelJS  platform API gets the model record 
by querying the product model class from the Model Category 
[cmdb_model_category] table. Else, the API gets the model record 
from the Hardware Models [cmdb_hardware_product_model] table 
only.

If either value is provided by itself, then the operation only processes what 
is found.

Output field target_sys_rte_eb_field

Output is the resulting sys_id and name of the company in core_company, 
and sys_id and name of the model in cmdb_model - all concatenated by 
triple pipe (|||).

Script include 
function

sn_cmdb_int_util.CmdbIntegrationHardwareModelUtil().cleanseModelAndCompany(manufacturer_in, 
model_in)

For either the manufacturer or model, if a matching record does not exist then a new record is 
created so the return always includes sys_ids and names for both records (unless the input is 
empty or invalid).

The manufacturer name is processed like the Cleanse Company transform and then the 
manufacturer name, model name, and model number are sent to the MakeAndModelJS 
platform API.

Example

Manufacturer Name Model Name Model Number Result

ServiceNow 
Incorporated

SERVICENOW BC0AA8000C56 93d4ecfac0a8000b6294d71b733977fb|||
ServiceNow|||
ba29cb303710200044e0bfc8bcbe5d6d 
|||ServiceNow

Cleanse IP Address

Use when a field provides an IP address.
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Details

Table Robust Transform Engine Entity Cleanse IP Operation 
[sn_cmdb_int_util_cleanse_ip_operation]

Input fields source_sys_rte_eb_field

Input is the IP address to cleanse.

Output field target_sys_rte_eb_field

Output is the resulting IP address, which can be empty.

Script include 
function

sn_cmdb_int_util.CmdbIntegrationNetworkUtil().cleanseIpAddress(input)

The IP address is tested for both IPv4 and IPv6 structures along with some known derivations (an 
IPv4 with spaces instead of periods). If a result is found, then it is formatted and returned.

Examples

Ip Ip Results

192.160.89.1 192.160.89.1

192.160.89.1,54.21.12.311 192.160.89.1

192 160 89 1 54 21 12 311 192.160.89.1

192-160-89-1 192.160.89.1

2001:0db8:0000:0000:0000:ff00:0042:8329 2001:0db8:0000:0000:0000:ff00:0042:8329

junk

175912537 10.124.54.89

-1

0

Cleanse IP Version

Use when the source of data does not provide an IP version or when the IP version might be 
unreliable.

Details

Table Robust Transform Engine Entity Cleanse IP Version Operation 
[sn_cmdb_int_util_cleanse_ip_version_operation]

Input fields source_sys_rte_eb_field

Input is the IP address to cleanse.

Output field target_sys_rte_eb_field

Output is the resulting cmdb_ci_ip_address.ip_version lookup key (either 4, 
6, or empty).
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Details

Script include 
function

sn_cmdb_int_util.CmdbIntegrationNetworkUtil().deriveIpVersion(input)

The input IP address value is checked for either proper IPv4 or IPv6 structure, otherwise the 
return is empty. This function provides no IP cleansing.

Example

Input Result

192.160.89.1 4

Cleanse MAC Address

Use when a field provides a MAC address.

Details

Table Robust Transform Engine Entity Cleanse MAC Operation 
[sn_cmdb_int_util_cleanse_mac_operation]

Input fields source_sys_rte_eb_field

Input is the MAC address to cleanse.

Output field target_sys_rte_eb_field

Output is the resulting MAC address which can be empty.

Script include 
function

sn_cmdb_int_util.CmdbIntegrationNetworkUtil().cleanseMacAddress(input)

The MAC address is tested for proper structure along with some known derivations (for example, 
a MAC address with spaces instead of colons). If a result is found, then it is formatted and 
returned.

Example

Input Result

00 0A 95 9D 68 16 00:0a:95:9d:68:16

Cleanse Operating System

Use to extract, cleanse, and format an operating system name, when the source provides an 
operating system value.

Details

Table Robust Transform Engine Entity Cleanse OS Operation 
[sn_cmdb_int_util_cleanse_os_operation]

Input fields source_sys_rte_eb_field
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Details

Input is the operating system name to cleanse.

Output field target_sys_rte_eb_field

Output is the resulting operating system name. The resulting operating 
system name is also written to the cmdb_ci_computer.os list field.

Script include 
function

sn_cmdb_int_util.CmdbIntegrationOsUtil().cleanseAndInsertOs(input)

Most of the current cleansing is centered on Microsoft operating system values aside from 
common cleansing such as fixing casing.

Examples

Operating System Operating System Results

Windows Server 2003 R2 64 bit Edition 
Service Pack 2

Windows Server 2003 R2

Windows 2003 Windows 2003

Windows Vista 64 bit Edition Windows Vista

Windows 2000 Professional Service Pack 4 Windows 2000 Professional

Windows XP Service Pack 2-3 Windows XP

Microsoft Windows Server 2003 R2 64 bit 
Edition Service Pack 2

Windows Server 2003 R2

Microsoft Windows 2003 Windows 2003

Microsoft Windows Vista 64 bit Edition Windows Vista

Microsoft Windows 2000 Professional Service 
Pack 4

Windows 2000 Professional

Microsoft Windows XP Service Pack 2-3 Windows XP

linux ubuntu Linux Ubuntu

Linux Ubuntu Server Linux Ubuntu Server

Cleanse Serial Number

Use to cleanse and remove invalid serial numbers.

Details

Table Robust Transform Engine Entity Cleanse Serial Number Operation 
[sn_cmdb_int_util_cleanse_serial_number_operation]

Input fields source_sys_rte_eb_fields

Input is the serial number to cleanse.

Output field target_sys_rte_eb_field

Output is the resulting serial number.
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Examples

Serial Number Serial Number Results

ec2aa2da-5312-aa3e-804c-c35feabeda5f ec2aa2da-5312-aa3e-804c-c35feabeda5f

1045–1209–6738–4668–7696–2783 1045–1209–6738–4668–7696–2783

Cleanse Serial Number With Alternate Value Return if Invalid

Use to cleanse Serial Number and verify the length of the cleansed serial number. Returns the 
alternate value if the length of serial number is invalid.

Details

Table Robust Transform Engine Entity Cleanse Serial Number With Alternate Value 
Return

[sn_cmdb_int_util_cle
$anse_serial_number_with_alternate_value_return_if_invalid]

Input fields source_sys_rte_eb_fields

Inputs: serial number, Alternate value

Output field target_sys_rte_eb_field

Output: Cleansed serial number if the length is valid, Alternate value 
otherwise.

Script include 
function

global.SerialNumberManager().isValid(input)

The operation cleanses the serial number and checks If the cleansed 
serial number length is greater than or equal to the value specified in the 
sn_cmdb_int_util.minimum_valid_serial_number_length  system property. The 
default value of the property is set to 7.

Cleanse IMEI Number With Alternate Value Return if Invalid

Use to cleanse the IMEI number and verify the length of the cleansed IMEI number. Returns the 
alternate value if the length of IMEI number is invalid.

Details

Table Robust Transform Engine Entity Cleanse IMEI With Alternate Value Return if 
Inval

[sn_cmdb_int_util_cleanse_imei_with_alternate_value_return_if_invalid]

Input fields source_sys_rte_eb_fields

Inputs: IMEI number, Alternate value

Output field target_sys_rte_eb_field
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Details

Output: IMEI number if the length is valid, Alternate value otherwise.

Script include 
function

None

The operation cleanses the IMEI number and checks If the cleansed IMEI number length is equal 
to the value specified in the sn_cmdb_int_util.valid_imei_number_length  system 
property. The default value of the property is set to 15.

Cleanse Software Model

Use to cleanse and create a software model. Also, to create manufacturer and software model if 
they do not exist and follow with a split operation.

Details

Table Robust Transform Engine Entity Cleanse Software Model Operation 
[sn_cmdb_int_util_cleanse_software_model_operation]

Input fields source_sys_rte_eb_fields

Input in order is:

1. The manufacturer name

2. The software name

3. The software version (not required)

If only manufacturer or name is provided, then only those values are 
processed and returned.

Output field target_sys_rte_eb_field

Output is the resulting sys_id and name of the company in core_company, 
the cleansed software name, and the cleansed software version all 
concatenated by a triple pipe (|||).

Script include 
function

sn_cmdb_int_util.CmdbIntegrationSoftwareModelUtil().cleanseSoftwareModel(company, 
model, version)

If a matching manufacturer record does not exist, then a new record is created so the return 
always includes the sys_id and name for the manufacturer (if the manufacturer is not empty or 
invalid).

The manufacturer name is processed the same as in the Cleanse Company transform and then 
the manufacturer name is sent to the MakeAndModelJS platform API.

The software name and version are cleansed and formatted and returned. The version is 
removed from the software name if present.

Examples

Manufacturer Software Name Software Version Results

Dell Inc.

NoManufacturer
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Examples  (continued)

Manufacturer Software Name Software Version Results

1.0.0.0

Dell Inc. DataEngine 1.0.17.2 b7e7d7d8c0a8016900a5d7f291acce5c|||
Dell Inc.|||DataEngine|||1.0.17.2

GenuineIntel TestSoftware 1.0.0.1 7aad6d00c611228400f00e0f80b67d2d|||
Intel|||TestSoftware|||1.0.0.1

Dell Inc. TestSoftware 232 b7e7d7d8c0a8016900a5d7f291acce5c|||
Dell Inc.|||TestSoftware|||232

Dell Inc. TestSoftware 123.0.0.0 b7e7d7d8c0a8016900a5d7f291acce5c|||
Dell Inc.|||TestSoftware|||123.0

America Online TestSoftware 1.0.0.0 0c43d035c61122750000251553f6f8e8|||
America Online|||TestSoftware|||1.0

America Online TestSoftware 1.0.0.0 0c43d035c61122750000251553f6f8e8|||
America Online|||TestSoftware|||1.0

dell LowerCase 1.0.0.0 b7e7d7d8c0a8016900a5d7f291acce5c|||
Dell Inc.|||LowerCase|||1.0

Dell Corporation.

Incorporated, 
Corp.

TestSoftware 1.0.0.0 b7e7d7d8c0a8016900a5d7f291acce5c|||
Dell Inc.|||TestSoftware|||1.0

Microsoft
Microsoft SQL

Server 2016 
Enterprise

2.0.0 0e8b8e650a0a0b3b004f285ffbb1a4fc|||
Microsoft|||Microsoft SQL Server 
2016 Enterprise|||2.0

Dell Computer DataEngine 1.0.17.2 b7e7d7d8c0a8016900a5d7f291acce5c|||
Dell Inc.|||DataEngine|||1.0.17.2

Adobe TestSoftware 1 b7e8b5c4c0a80169008b49e468920048|||
Adobe Systems|||TestSoftware|||1.0

Create Software Instance Name

Use when a hardware name, software name, and software version is provided, to create a new 
software instance name.

Details

Table Robust Transform Engine Entity Create Software Instance Name Operation 
[sn_cmdb_int_util_create_software_instance_name_operation]

Input fields source_sys_rte_eb_fields

Input in order is:
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Details

1. The hardware name

2. The software name

3. The software version (not required)

Output field target_sys_rte_eb_field

Output is the software instance name.

Script include 
function

sn_cmdb_int_util.CmdbIntegrationSoftwareModelUtil().createSoftwareInstanceName(hw_name_in, 
sw_name_in, sw_version_in)

Examples

Hardware Name Software Name Software Version Results

computer1 microsoft 2.0.1 microsoft 2.0.1-
computer1

computer2 adobe adobe-computer2

computer3 adobe 2.1 adobe 2.1-computer3

hw2 sw3 301 sw3 301-hw2

Derive CI Class from Model

Use when processing a computer record and a model is provided but the class of the computer 
is ambiguous otherwise. Can be used along with other Derive CI Class transforms.

Details

Table Robust Transform Engine Entity Derive Class From Model Operation 
[sn_cmdb_int_util_derive_class_from_model_operation]

Input fields source_sys_rte_eb_fields

Input in order is:

1. The model name

2. The current class name

Output field target_sys_rte_eb_field

Output is the resulting class name.

Script include 
function

sn_cmdb_int_util.CmdbIntegrationClassUtil().deriveClassNameFromModelInput(model_in, 
class_in)

Does not return a value of a class which is higher in the class hierarchy (a parent class) than 
the provided input class. For example, does not return cmdb_ci_computer if the input is 
cmdb_ci_server. Looks only at the cmdb_ci_computer hierarchy, going through cmdb_ci_server 
(cmdb_ci_computer, cmdb_ci_server, children of cmdb_ci_server).

Currently looks for Server, Windows Server, and Linux Server indicators in the model.
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Examples

Model Class Class Results

window server cmdb_ci_computer cmdb_ci_win_server

Microsoft server cmdb_ci_computer cmdb_ci_win_server

linux server cmdb_ci_computer cmdb_ci_linux_server

Microsoft server cmdb_ci_server cmdb_ci_win_server

linux server cmdb_ci_server cmdb_ci_linux_server

Red hat server cmdb_ci_server cmdb_ci_linux_server

Arch server cmdb_ci_server cmdb_ci_linux_server

Centos server cmdb_ci_server cmdb_ci_linux_server

Debian server cmdb_ci_server cmdb_ci_linux_server

Fedora server cmdb_ci_server cmdb_ci_linux_server

Suse server cmdb_ci_server cmdb_ci_linux_server

Oracle server cmdb_ci_server cmdb_ci_linux_server

Rhel server cmdb_ci_server cmdb_ci_linux_server

Ubuntu server cmdb_ci_server cmdb_ci_linux_server

Junk

cmdb_ci_server cmdb_ci_server

Junk server cmdb_ci_computer cmdb_ci_server

Junk cmdb_ci_computer cmdb_ci_computer

Derive CI Class from Native Class Identifier

Use when processing a computer record and a native class indicator is provided but the class of 
the computer is ambiguous otherwise. Can be used along with other Derive CI Class transforms.

Details

Table Robust Transform Engine Entity Derive Class From Native Value Operation 
[sn_cmdb_int_util_derive_class_from_native_value_operation]

Input fields source_sys_rte_eb_fields

Input in order is:

1. The native class identifier

2. The current class name

Output field target_sys_rte_eb_field

Output is the resulting class name.

Script include 
function

sn_cmdb_int_util.CmdbIntegrationClassUtil().deriveClassNameFromNativeValue(native_id_in, 
class_in)
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Does not return a value of a class which is higher in the class hierarchy (a parent class) than 
the provided input class. For example, does not return cmdb_ci_computer if the input is 
cmdb_ci_server. Looks only at the cmdb_ci_computer hierarchy, going through cmdb_ci_server 
(cmdb_ci_computer, cmdb_ci_server, children of cmdb_ci_server).

Currently looks for Server, Windows Server, and Linux Server indicators in the native identifier.

Examples

Native Class Class Class Results

window server cmdb_ci_computer cmdb_ci_win_server

Microsoft server cmdb_ci_computer cmdb_ci_win_server

linux server cmdb_ci_computer cmdb_ci_linux_server

Microsoft server cmdb_ci_server cmdb_ci_win_server

linux server cmdb_ci_server cmdb_ci_linux_server

Red hat server cmdb_ci_server cmdb_ci_linux_server

Arch server cmdb_ci_server cmdb_ci_linux_server

Centos server cmdb_ci_server cmdb_ci_linux_server

Debian server cmdb_ci_server cmdb_ci_linux_server

Fedora server cmdb_ci_server cmdb_ci_linux_server

Suse server cmdb_ci_server cmdb_ci_linux_server

Oracle server cmdb_ci_server cmdb_ci_linux_server

Rhel server cmdb_ci_server cmdb_ci_linux_server

Ubuntu server cmdb_ci_server cmdb_ci_linux_server

Junk

cmdb_ci_server cmdb_ci_server

Junk server cmdb_ci_computer cmdb_ci_server

Junk cmdb_ci_computer cmdb_ci_computer

Derive CI Class from Operating System

Use when processing a computer record and an operating system is provided but the class of 
the computer is ambiguous otherwise. Can be used along with other Derive CI Class transforms.

Details

Table Robust Transform Engine Entity Derive Class From OS Operation 
[sn_cmdb_int_util_derive_class_from_os_operation]

Input fields source_sys_rte_eb_fields

Input in order is:

1. The operating system name

2. The current class name

Output field target_sys_rte_eb_field
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Details

Output is the resulting class name.

Script include 
function

sn_cmdb_int_util.CmdbIntegrationClassUtil().deriveClassNameFromOsName(os_in, 
class_in)

Does not return a value of a class which is higher in the class hierarchy (a parent class) than 
the provided input class. For example, does not return cmdb_ci_computer if the input is 
cmdb_ci_server. Looks only at the cmdb_ci_computer hierarchy, going through cmdb_ci_server 
(cmdb_ci_computer, cmdb_ci_server, children of cmdb_ci_server).

Currently looks for Server, Windows Server, and Linux Server indicators in the operating system 
name.

Examples

Operating System Class Class Results

window server cmdb_ci_computer cmdb_ci_win_server

Microsoft server cmdb_ci_computer cmdb_ci_win_server

linux server cmdb_ci_computer cmdb_ci_linux_server

Microsoft server cmdb_ci_server cmdb_ci_win_server

linux server cmdb_ci_server cmdb_ci_linux_server

Red hat server cmdb_ci_server cmdb_ci_linux_server

Arch server cmdb_ci_server cmdb_ci_linux_server

Centos server cmdb_ci_server cmdb_ci_linux_server

Debian server cmdb_ci_server cmdb_ci_linux_server

Fedora server cmdb_ci_server cmdb_ci_linux_server

Suse server cmdb_ci_server cmdb_ci_linux_server

Oracle server cmdb_ci_server cmdb_ci_linux_server

Rhel server cmdb_ci_server cmdb_ci_linux_server

Ubuntu server cmdb_ci_server cmdb_ci_linux_server

Junk

cmdb_ci_server cmdb_ci_server

Junk server cmdb_ci_computer cmdb_ci_server

Junk cmdb_ci_computer cmdb_ci_computer

Derive Virtual From Hardware Model

Use when processing a computer record that may be virtual, a hardware model is provided, and 
the virtual status is ambiguous. Can be used along with other Derive Virtual From transforms.

Details

Table Robust Transform Engine Entity Derive Virtual From Model Operation 
[sn_cmdb_int_util_derive_virtual_from_model_operation]
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Details

Input fields source_sys_rte_eb_fields

Input in order is:

1. The hardware model name

2. The current virtual flag value

Output field target_sys_rte_eb_field

Output is the resulting virtual flag (true/false). If the current virtual flag is 
‘true’, the result is true. Otherwise the result is ‘true’ or ‘false’.

Script include 
function

sn_cmdb_int_util.CmdbIntegrationVirtualDetectionUtil().detectVirtualFromModelName(model_in, 
is_virtual_in)

Looks for indicators in the model name for a virtual device (VMware).

Examples

Hardware Model Virtual Flag Virtual Flag Results

thinkpad true true

thinkpad false false

thinkpad false

vmware inc true true

true true

false false

false

Derive Virtual From Native Indicator

Use when processing a computer record that may be virtual, a virtual indicator is provided by the 
source, and the virtual status is ambiguous. Can be used along with other Derive Virtual From 
transforms.

Details

Table sn_cmdb_int_util_derive_virtual_from_native_value_operation

Input fields source_sys_rte_eb_fields

Input in order is:

1. The native indicator

2. The current virtual flag value

Output field target_sys_rte_eb_field

Output is the resulting virtual flag (true/false). If the current virtual flag is 
‘true’, the result is true. Otherwise the result is ‘true’ or ‘false’.

Script include 
function

sn_cmdb_int_util.CmdbIntegrationVirtualDetectionUtil().detectVirtualFromNativeIdentifier(native_in, 
is_virtual_in)
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Tests native indicator against a list of common values and looks for a ‘true’ boolean indicator.

Examples

Native Virtual Value Virtual Flag Virtual Flag Results

virtual false true

virtual true

virtual true true

y false true

y true

y true true

yes false true

yes true

yes true true

true false true

true true

true true true

t false true

t true

t true true

other false false

other false

other true true

not virtual false false

not virtual false

not virtual true true

false false

false

true true

Derive Virtual From Serial Number

Use when processing a computer record that may be virtual, a serial number is provided by the 
source, and the virtual status is ambiguous. Can be used along with other Derive Virtual From 
transforms.

Details

Table sn_cmdb_int_util_derive_virtual_from_serial_number_operation

Input fields source_sys_rte_eb_fields

Input in order is:
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Details

1. The serial number

2. The current virtual flag value

Output field target_sys_rte_eb_field

Output is the resulting virtual flag (true/false). If the current virtual flag is 
‘true’, the result is true. Otherwise the result is ‘true’ or ‘false’.

Script include 
function

sn_cmdb_int_util.CmdbIntegrationVirtualDetectionUtil().detectVirtualFromSerialNumber 
(serial_in, is_virtual_in)

Looks for indicators in the serial number for a virtual device (VMware).

Examples

Serial Number Virtual Flag Virtual Flag Results

123 true true

123 false false

123 false

vmware-123 true true

true true

false false

false

Extract and Scale by Units

Use when the source has numerical values that need to be scaled and numerical value with an 
input such as 2048Mb. The source does not always provide the units so it may be required to 
calculate or guess the units being provided. The target units depend on the target field in the 
CMDB. If not specified, the decimal place field is set at 2 by default.

Note: 
This field is case sensitive.

Details

Table sn_cmdb_int_util_extract_and_scale_by_units_operation

Input fields source_sys_rte_eb_fields

Output field target_sys_rte_eb_field

Script include 
function

sn_cmdb_int_util.CmdbIntegrationExtractScaleUnitUtil().extractAndScaleUnits(input,defaultUnit,outputUnit,decimalPlaces)

Examples

Input Value Default Unit Output Unit Result

2048Mb Mb GB 2GB
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Examples  (continued)

Input Value Default Unit Output Unit Result

17179869184 B GB 16GB

First Non Null Value

Use when you have a list of fields providing similar information that must map to a single field and 
you want to rank the order in which they can provide those values.

For Example Internally in SolarWinds, there is a hierarchy of tables that are join. In one example, 
a computer’s name could come from the child most table or any of that tables parents but 
each of those is a separate field in the pull. Starting with the most specific table, the values are 
searched for the first instance of a name value.

Details

Table sn_cmdb_int_util_first_non_null_operation

Input fields source_sys_rte_eb_fields

Input is a list of fields of any length.

Output field target_sys_rte_eb_field

Output is the value from the first field in the list that doesn’t have a null (or 
empty) value.

Script include 
function

sn_cmdb_int_util.CmdbIntegrationFirstNonNullValueUtil().firstNonNullValue(batch[i])

Example

Field 1 Field 2 Field 3 Result

foo foo2 foo

Process Name, Domain, FQDN, DNS set

Use when the source provides name, domain, FQDN, or DNS information. Can be used 
for only a subset of these (if for example, the source only provides name and domain). 
In the case that a source only provides fields that are lower in the input list (FQDN) the 
CmdbIntegrationHardwareNameUtil script include can be called from a script operation to 
minimize having to create empty dummy fields.

Details

Table sn_cmdb_int_util_process_name_set_operation

Input fields source_sys_rte_eb_fields

Takes up to four Input fieldss (any additional fields are ignored), in the 
following order:

1. Name

2. Domain
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Details

3. FQDN

4. DNS

You don't have to provide all four input values, but you must provide those 
values in the specified order. If for example, you only want to cleanse 
domain, you must provide a name attribute, even it if empty.

Output field target_sys_rte_eb_field

Output is a concatenated set of values in the same order, using a triple pipe 
(|||): {name}|||{domain}|||{fqdn}|||{dns}

Script include 
function

sn_cmdb_int_util.CmdbIntegrationHardwareNameUtil().processNameDomainFqdnDnsSet(name, 
domain, fqdn, dns)

FQDN and DNS are first processed to see if their formats are correct. FQDN has an additional 
discovery regex it must pass (via properties): glide.discovery.fqdn.regex – 
default : ^([^.]+)\\.((?:[^.]+\\.)+[^.]+)$

Possible name and domain values are extracted if possible. When name and domain are 
processed, if there is no FQDN, a value is generated if possible. A resulting name value is also 
modified using the following discovery flags:

1. glide.discovery.hostname.case – default: No change. Can be set to ‘Lower case’, ‘Upper case’, 
‘No change’

2. glide.discovery.hostname.include_domain – default: false. If ‘true’ the domain is added to the 
final name value

Examples

Name Domain FQDN DNS Results

myName other.net otherName.other.netmycomp.servicenow.commyName|||
other.net|||
otherName.other.net|||
mycomp.servicenow.com

na other.net otherName.other.netmycomp.servicenow.comotherName|||
other.net|||
otherName.other.net|||
mycomp.servicenow.com

servicenow.com |||
servicenow.com||||||

name.servicenow.comname|||
servicenow.com|||
name.servicenow.com|||
name.servicenow.com

name.servicenow.com name|||
servicenow.com|||
name.servicenow.com|||
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Examples  (continued)

Name Domain FQDN DNS Results

name.servicenow.com name|||
servicenow.com|||
name.servicenow.com|||

name servicenow.com name|||
servicenow.com|||
name.servicenow.com|||

Process FQDN

Use when the source provides a suspected FQDN value but no other naming fields such as 
name, domain, or DNS.

Details

Table sn_cmdb_int_util_process_fqdn_operation

Input fields source_sys_rte_eb_field

Input is a single field containing an FQDN.

Output field target_sys_rte_eb_field

Output is a concatenated set of values in the same order using a triple pipe 
(|||): {name}|||{domain}|||{fqdn}|||{dns}

Script include 
function

sn_cmdb_int_util.CmdbIntegrationHardwareNameUtil().processNameDomainFqdnDnsSet('’, 
'’, fqdn, '’)

The processing follows the same logic as the ‘Process Name, Domain, FQDN, DNS set’ transform 
except that only FQDN is used as an input.

Example

Input Result

mycomputer.servicenow.com mycomputer|||servicenow.com|||
mycomputer.servicenow.com|||

Scale Unit

Use when the source has numerical inputs that must be scaled. The source does not always 
provide the current units so it may be required to calculate or guess the units being provided. 
The target units depend on the field being targeted in the CMDB.

Details

Table sn_cmdb_int_util_scale_unit_operation

Input fields source_sys_rte_eb_fields

Inputs in order are:
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Details

1. The input value

2. The current units

3. The target units

Output field target_sys_rte_eb_field

Output is the input value scaled from the current units to the target units. If 
no units are found for the current units, then the input value is returned. If 
no current or target units are found the input is returned as the output.

Script include 
function

sn_cmdb_int_util.CmdbIntegrationScaleUnitUtil().scaleUnits(input_value, 
input_unit, output_unit)

Example

Input Result

• Input Field 1: 1

• Input Field 2: GB

• Input Field 3: MB

1024

Software Bundle ID Lookup

Use when a source, such as Jamf, does not provide the software publisher but does provide a 
Mac software bundle ID. Software Bundle ID Lookup looks up records in the Bundleid Lookup 
[sn-cmdb_int_util_bundleid_lookup] table by bundle_id. If a record with the specified bundle_id 
exists, it extracts the respective software publisher. Otherwise, it creates a new record which will 
be queried the next time the Lookup Mac Software Bundle IDs data source runs.

Details

Table sn_cmdb_int_util_software_bundle_id_lookup_operation

Input fields • source_sys_rte_eb_field

• Bundle ID

Output field target_sys_rte_eb_field

Output is the resulting artist name, track name, and seller name, all 
concatenated by a triple pipe (|||), or an empty string if no match is found.

Script include 
function

sn_cmdb_int_util.CmdbIntegrationSoftwareBundleIdLookup. 
lookupSoftware(bundleId)

Example

Input Result

Input Field 1: com.microsoft.Word Microsoft Corporation|||Microsoft Word||| 
Microsoft Corporation
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User Lookup

Use to look up a user in the User [sys_user] table by user name or email, attempting to match in 
the following order:

1. The User Name matching the user_name  attribute.

2. The Email matching the email attribute.

3. If nothing is matching, it returns empty.

Details

Table sn_cmdb_int_util_user_lookup_operation

Input fields source_sys_rte_eb_fields

Inputs in order are:

1. User Name

2. Email (Optional)

Output field target_sys_rte_eb_field

sysId of the sys_user.

Script include 
function

sn_cmdb_int_util.CmdbIntegrationUserLookup. 
lookupUser(username, email)

Examples

Input Result

Input Field 1: abel.tuter 62826bf03710200044e0bfc8bcbe5df1

• Input Field 1: atuter

• Input Field 2: abel.tuter@example.com

62826bf03710200044e0bfc8bcbe5df1

Configuring the ADM adapter for Service Graph Connectors

You can configure the Application Dependency Mapping (ADM) adapter to populate running 
processes, TCP connections, and applications into CMDB.

As a user with the admin role, you can use the ADMHelper  script include to configure 
the ADM adapter that populates running processes, TCP connections, and applications 
into CMDB. The ADMHelper  script include is available within the Integration Commons 
for CMDB  (sn_cmdb_int_util) store app. The ADMHelper  script include invokes the 
ApplicationDependencyMapping  script include that is available within the Discovery and 
Service Mapping Patterns application (sn_itom_pattern).

The ADM adapter requires the inputs as discussed in the following table:

Inputs for the ADM adapter

Input Input type

Running Process Details Required
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Inputs for the ADM adapter  (continued)

Input Input type

Computer Sys Id Required

TCP connection details Optional

ADM Properties Optional

For interpreting and populating the CIs, the ADM processor requires the input data in a specific 
format. Ensure that the keys are formed as shown in the following example:

Example keys for ADM processor

TCP connections data Running process

[
{
"pid": "1068",
"local_ip": 
 "127.0.0.1",
"local_port": 
 "199",
"ip": "0.0.0.0",
"port": "199",
"state": 
 "LISTEN",
"type": "on"
}
]

[
   {
"pid": "1",
"ppid": "0",
"command": "/usr/lib/systemd/systemd", 
 "name": "systemd",
"parameters": "--switched-root --system 
 --deserialize 21"
}
 
]

The ApplicationDependencyMapping  script include processes TCP connections and 
running process data and populates the following tables:

• TCP Connections [cmdb_tcp]

• Running Process [cmdb_running_process]

• Application [cmdb_ci_appl]

Note: 
After the data is populated into the TCP Connections [cmdb_tcp] and Running Process 
[cmdb_running_process] tables, the ApplicationDependencyMapping  script 
include reconciles the TCP connections and running process data for populating 
the Application [cmdb_ci_appl] table based on the data in the Network Adapter 
[cmdb_ci_network_adapter] and IP Address [cmdb_ci_ip_address] tables. Classified 
processes are added to the corresponding child class in the Application [cmdb_ci_appl] 
table. The addition of unclassified processes to the Application [cmdb_ci_appl] table 
depends on the system property value.

Accessing the connection details of Service Graph Connectors

The common connection framework included within the Integration Commons for CMDB 
(sn_cmdb_int_util) store app enables accessing connection details of Service Graph Connectors 
in a single view.
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With the common connection framework, you can access all the connections used by Service 
Graph Connectors  or the connections that are specific to a Service Graph Connector. The 
connection details include the connection alias, connection properties, data sources, and 
scheduled data imports associated with a connection for a Service Graph Connector.

Viewing connections

To view the connection details for all Service Graph Connectors  that use the common 
connection framework, navigate to All  > Service Graph Connectors  > Connections  from the 
application navigator.

If a Service Graph Connector  uses the common connection framework, you can also view the 
connections specific to the connector. To view the connection details, open the Service Graph 
Connector  from the application navigator, access its Connections module to view the Service 
Graph Connections list, and then select the connection name.

The Service Graph Connections page displaying the connection details also includes the 
Test Connection  related link that you can select to test the connection. If the connection is 
successful, a success message is displayed. Else, an error message with the reason of failure is 
displayed.

Common connection framework tables

The common connection framework uses the following tables:

Service Graph Connections [sn_cmdb_int_util_service_graph_connection]

Stores the connection records for all the Service Graph Connectors  that 
use the common connection framework. The Service Graph Connections 
[sn_cmdb_int_util_service_graph_connection] table also includes other common 
connection framework tables as related lists.

Properties [sn_cmdb_int_util_service_graph_connection_property]

Stores the connection properties associated with a specific connection.

Service Graph Connection Data Sources 
[sn_cmdb_int_util_service_graph_connection_data_source]

Stores the many-to-many (m2m) connection details between the Service Graph 
Connections [sn_cmdb_int_util_service_graph_connection] table and the data 
sources for a Service Graph Connector.

Service Graph Connection Scheduled Data Imports 
[sn_cmdb_int_util_service_graph_connection_scheduled_data_import]

Stores the m2m connection details between the Service Graph Connections 
[sn_cmdb_int_util_service_graph_connection] table and the scheduled data 
imports for a Service Graph Connector.

Service Graph Connection Test Script 
[sn_cmdb_int_util_service_graph_connection_test_script]

Stores records that include scripts for triggering the test connection process for 
Service Graph Connectors.

Managing CMDB  data deletion

The Integration Commons for CMDB  (sn_cmdb_int_util) store app uses post-script and transform 
map methods to remove imported Configuration Management Database (CMDB)  records that 
were deleted later from the source third-party application.
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Post-script method

The post-script method checks the Source [sys_object_source] table for configuration items (CIs) 
not updated in the last run for a specific source feed. It then removes any non-updated CIs from 
the associated target CMDB  tables synchronously, handling the removal of target records one at 
a time.

Most Service Graph Connectors  use the post-script method to manage the removal of any CMDB 
records.

The post-script method uses the RecordRemoval  script to handle various record deletion 
strategies. Hard deletion involves permanently and completely removing records from the 
CMDB, making them unrecoverable and suitable for data that is no longer needed. Soft 
deletion marks records as deleted without actually removing them from the CMDB, allowing 
for potential recovery and preserving historical data. Optimized soft deletion, managed by 
the Identification and Reconciliation Engine (IRE), enhances this soft deletion approach by 
using a specialized table, such as the extension attributes table, and applying reconciliation 
rules to manage deleted records more efficiently. By default, the table can hold up to 100 
records at a time, but as a user with the admin role, you can adjust this limit by setting the 
sn_cmdb_int_util.ire_payload_items_size  system property. This property is 
not available by default and you must create this property of type integer within the Integration 
Commons for CMDB  (sn_cmdb_int_util) store app. For more information, see Add a system 
property .

Transform map-based method

The transform map-based method checks the Source [sys_object_source] table for configuration 
items (CIs) not updated in the last run for a specific source feed. It then utilizes the multi-
threaded deletion approach to remove any non-updated CIs from the associated target CMDB 
tables concurrently, handling the removal of all target records within an import set at once. 
Multiple import sets are created to store target record data within the Integration Commons 
Remove Record [sn_cmdb_int_util_remove_record] staging table enabling multi-threaded 
deletion of records. Therefore, reducing the data processing time.

The Integration Commons Remove Record [sn_cmdb_int_util_remove_record] staging table 
tracks non-updated CIs by storing target record details including the discovery source, source 
feed, target table sys_id, and target table name of these CIs. The on-start script defined within 
the Remove Record Transform Map  then deletes the records from the associated target 
tables.

The transform map-based method is used by a Service Graph Connector  to improve the data 
processing time. For example, the SG-Tanium Remove Software  data source within the Service 
Graph Connector for Tanium  removes software data using the transform map-based method. See 
Service Graph Connector for Tanium.

Partition size computation for parallel loading in Integration Commons for CMDB

Integration Commons for CMDB  supports computed partition size for the parallel loading 
framework, if supported in a Service Graph Connector.

The parallel loading feature of ServiceNow AI Platform, executes data load using multiple 
threads. The partition size for a data source is computed by the Integration Commons for CMDB 
application used by the parallel loading feature. This partition size confirms that the workload is 
evenly distributed among the available threads. By balancing the data load, a data source within 
a Service Graph Connector  can manage data loading uniformly across the available nodes, 
reducing processing time and improving overall efficiency. This approach promotes efficient data 
loading, minimizes latency, and optimizes the performance of data sources.
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The partition size computation for the parallel loading feature within the Integration Commons for 
CMDB  application is based on the following calculations:

• Partition size calculation

• Parallel jobs calculation

Partition size calculation

The partition size for parallel loading in a data source is determined by both the number of active 
primary nodes on your ServiceNow  instance and the total volume of data to be loaded by the 
data source using the following formula:

Partition size = Total data volume / (10% * Active primary 
 nodes)

For example, if there are 4  active primary nodes and the data volume to be loaded is 1000  units, 
the partition size is calculated as:

Partition size = 1000 / (10% * 4) = 1000 / 0.4 = 25

Parallel jobs calculation

Parallel jobs enable distributing the workload evenly across multiple jobs, reducing the data 
loading time and improving the efficiency of data retrieval. The calculation of the number of 
parallel jobs created for a partition is based on the following formula:

Number of parallel jobs = Total data volume/Partition size

In the earlier example, where the total data volume is 1000  units and the partition size is 25, the 
number of parallel jobs created is calculated as:

Number of parallel jobs = 1000/25 = 40

Quick start tests for Integration Commons for CMDB

Validate that integrations for CMDB  pass validation  and still work after you make any 
configuration changes such as applying an upgrade or developing an application.

Danger: 
By default, the system property that is used to run automated tests is disabled to prevent 
you from accidentally running these tests on a production system. To avoid data corruption 
or an outage, run tests only on development, test, and other non-production instances. See 
Enable or disable executing Automated Test Framework tests .

Integration Commons for CMDB

CMDB INT: CMDB Integrations Validation test suite
Test suite to verify the integrity of an integration using multiple tests.

Test Description Release version

CMDB INT: Set Test Session 
Application

Modify the run server-side 
script to set an application 
name so that you can test only 
one integration. Otherwise, all 
integrations installed will be 
tested.

Paris
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CMDB INT: CMDB Integrations Validation test suite
Test suite to verify the integrity of an integration using multiple tests.

(continued)

Test Description Release version

CMDB INT: Test Against 
Source Analysis

Test an integration against 
the values in the CMDB 
Integration Source Analysis 
[sn_cmdb_int_util_cmdb_integration_source_analysis] 
table.

Paris

CMDB INT: Validate 
Application Feed

Validate all application feeds 
in an integration.

Paris

CMDB INT: Validate Discovery 
Source

Validate that the discovery 
source exists.

Paris

CMDB INT: Validate Entity 
Mappings

Validate all entity mappings of 
an integration.

Paris

CMDB INT: Validate Fields Validate fields for CMDB 
Integrations.

Paris

CMDB INT: Validate Lookups Validate CMDB integration 
lookups.

Paris

CMDB INT: Validate 
Mandatory Operations

Validate that all integrations 
for mandatory operations exist 
for mapped fields.

Paris

CMDB INT: Validate 
Operations

Validate all operations for an 
integration.

Paris

CMDB INT: Validate 
References

Validate CMDB integration 
references.

Paris

CMDB INT: Validate Related 
Entries

Validate all related classes 
against the data dictionary for 
related entries.

Paris

CMDB INT: Validate 
Relationships

Validate CMDB integration 
relationships.

Paris

To learn more about Integration Commons for CMDB, see Integration Commons for CMDB.

Related topics

Quick start tests

IntegrationHub ETL

Use the IntegrationHub ETL store app to create and manage ETL transform maps, which integrate 
third-party data into the CMDB or into non-CMDB tables without compromising the integrity 
of data. IntegrationHub ETL provides a simplified user interface that guides you through the 
integration process end-to-end, including a test integration run of sample data.

The IntegrationHub ETL (sn_int_studio) plugin provides the IntegrationHub ETL functionality.
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• Use the CMDB Integrations Dashboard to track progress, results, and errors associated with 
using custom integrations created in IntegrationHub ETL. The CMDB Integrations Dashboard is 
included in the Integration Commons for CMDB  store app.

• Watch the IntegrationHub ETL | Importing resources into the CMDB  video for an introduction 
and walk through of the IntegrationHub ETL tool.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Roles required

Users with the cmdb_inst_admin role can use IntegrationHub ETL to create integrations, or 
customize a pre-existing integration provided by ServiceNow  or a vendor at the ServiceNow 
Store. A vendor can create a new integration and provide it as an application for anyone to use.

Support for non-CMDB tables

Starting with the Washington DC  release, IntegrationHub ETL supports the integration of third-
party data into some non-CMDB tables. IntegrationHub ETL supports those non-CMDB tables 
that are supported by Identification and Reconciliation (IRE). For details about which non-CMDB 
tables are supported and any needed configuration, see IRE support for non-CMDB tables.

Supported non-CMDB tables are available in IntegrationHub ETL when specifying classes, 
conditional classes, class associations, and reference sources in mapping definitions. 
However, there are some differences between using CMDB classes and non-CMDB tables in 
IntegrationHub ETL:

• Specifying class associations isn't mandatory for non-CMDB tables.

• Adding relationships doesn't apply to non-CMDB tables.

• Class associations for a non-CMDB table is based on a reference field instead of a CMDB 
relationship.

Note: 
Although the IntegrationHub ETL user interface and accompanying documentation 
references CMDB and CMDB elements, most of those references also apply to supported 
non-CMDB tables.

Process

The two key components that IntegrationHub ETL uses for processing are:

• Robust Transform Engine (RTE) : Used to transform raw source data that is stored in staging 
tables, into the data that is mapped and integrated into the CMDB. RTE uses ETL transform 
maps that were created for the integration during data transformation.

• Identification and Reconciliation engine (IRE): Used as a centralized framework for 
identification and reconciliation processes across different data sources. IRE processes help 
maintain data integrity in the CMDB and in supported non-CMDB tables.

IntegrationHub ETL uses RTE and IRE which work together to process and integrate data. Data 
is first imported from a data source, and is then stored in temporary staging tables in Import 
Sets systems. Using the data in the staging tables and the ETL transform map created by 
IntegrationHub ETL, RTE creates IRE payloads which are then processed by IRE. IRE applies 
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reconciliation processes to avoid potential problems such as duplicate CIs, ensuring that the 
CMDB or non-CMDB tables remain healthy, and then integrates the resulting data.

When you create an integration, you import source data, transform data if needed, and select 
target CMDB classes (or non-CMDB tables) and attributes to map the data to. Eventually, 
you run an integration test of the sample data, using your settings in the IntegrationHub ETL. 
You can then preview the integration test results and adjust any settings before scheduling 
recurring integration runs for large data sets. If you develop and test the ETL transform map on a 
development instance, then you can test and adjust the configuration before implementation on 
a production instance.

For example, you can integrate data from SCCM (Microsoft System Center Configuration 
Manager).

Refer to the community page IntegrationHub-Extract Tranform Load (IH-ETL) is GA in ServiceNow 
store  for an overview of IntegrationHub ETL, including its components and workflow.

Guided Setup

A guided setup organizes all the tasks in the correct order, tracks the completion of tasks, and 
enforces any task dependencies. Tasks that depend on the completion of other tasks, are 
enabled or disabled as you step through the tool and complete tasks.

Read-only mode

When opening a Service Graph Connector in which IntegrationHub ETL isn't detecting any 
incoming data from the data source, the integration is available in read-only mode. In read-only 
mode you can access all the guided setup tasks on the ETL Transform Map Assistant page. You 
can examine all the settings and definitions in the integration even though it isn't populated with 
actual data. However, you can't make any updates to a read-only connection.

Read-only mode is useful for studying an existing connection for the purpose of creating a new 
connection that is similar to the read-only connection. The read-only mode can also assist in 
troubleshooting issues with the connection.

IntegrationHub ETL and Import Sets

Using IntegrationHub ETL and ETL transform maps has the following advantages over using 
Import Sets and transform maps:

• Identification and Reconciliation Engine (IRE) processes are incorporated into the 
IntegrationHub ETL so all data is automatically processed by IRE as part of the integration. 
Using Import Sets and transform maps does not provide a simple way to apply IRE processes.

• IntegrationHub ETL uses guided setup which provides guidance and a simple user interface 
for the entire process of integrating third-party data.

• IntegrationHub ETL includes an integration test for a small data set using the new ETL 
transform map. This test lets you review the results and adjust configuration settings before 
scheduling recurring integrations.

Terms

The following terms are associated with the IntegrationHub ETL:

CMDB application

Name of the third-party vendor such as SCCM 2019. A CMDB application has two 
associated attributes: Name  and Discovery Source. When creating a new 
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integration, ensure to configure a discovery source for the CMDB application that 
you plan to use, before using the IntegrationHub ETL.

Data source

The source feed, such as SCCM 7.0 Computer Identity, where the raw source data 
is imported from. If you use various REST endpoints for different types of data, then 
each REST endpoint is associated with its own data source and an ETL transform 
map.

ETL transform map

The output generated by IntegrationHub ETL. You can integrate third-party data into 
the CMDB or into non-CMDB tables using an ETL transform map which is configured 
for the respective integration.

Source data

Original, raw data that have been imported into IntegrationHub ETL. Source data 
can be used in its original form, or you can transform the data before mapping and 
integration.

Transform

An operation, that you can apply to a specific data column to transform the data 
values. For example, to transform the format of the data values. Use transforms to 
standardize data formats and meet other system requirements.

Transformed data

Some of the source data might not be compliant with the requirements of its target 
CMDB attributes and classes or non-CMDB tables. In those cases, you can apply 
various types of transforms to the source data, before mapping the data to the 
target CMDB classes and attributes or non-CMDB tables. Transforms, can for 
example convert data format, replace values, and concatenate values from multiple 
data columns.

Each CMDB application can have multiple connections for retrieving raw data. Each connection 
that is used to retrieve a certain type of data, has its own pair of data source and an ETL 
transform map. Therefore, one CMDB application can have multiple ETL transform maps, and 
each of those ETL transform maps is associated with a single Data Source.

For example:

CMDB Application ETL Transform Map Data Source

SCCM Computer Identify /sccm/2019/comp

SCCM Disk /sccm/2019/disk

SCCM

SCCM Application /sccm/2019/appl

Nested data payloads

To process nested data payloads, you must first ensure that the data source that is used for the 
integration, is set with the Data in single column  option. With that setting, you can correctly 
represent nested data in a JSON payload which IntegrationHub ETL then processes as nested 
data, rather than as flat data.

Sample of nested data:

{
            "u_computer_fqdn": "computer2-fqdn",
            "u_computer_id": 2,
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            "u_computer_ip": "computer2-ip",
            "u_computer_location": "PDX",
            "u_computer_mac": "computer2-mac",
            "u_computer_name": "nested-payload-computer2",
            "u_computer_os": "computer2-os",
            "interfaces": [
                {
                    "u_interface_ip": "computer2-eth1-ip",
                    "u_interface_mac": "computer2-eth1-mac",
                    "u_interface_name": "computer2-eth1",
                    "ip": ""
                },
                {
                    "u_interface_ip": "computer2-eth2-ip",
                    "u_interface_mac": "computer2-eth2-mac",
                    "u_interface_name": "computer2-eth2",
                    "ip": {
                        "u_ip_address": "computer2-eth2-ip",
                        "u_mac_address": "computer2-eth2-mac"
                    }
                }
            ],
            "software": [
                {
                    "u_software_name": "computer2-software2",
                    "u_software_version": 
 "computer2-software2-1.0",
                    "instance": {
                        "u_software_instance_name": 
 "computer2-software1-instance"
                    }
                },
                {
                    "u_software_name": "computer2-software2",
                    "u_software_version": 
 "computer2-software2-2.0",
                    "instance": {
                        "u_software_instance_name": 
 "computer2-software2-instance"
                    }
                }
            ]
        },

You can view the layers of nested data in a separate panel in IntegrationHub ETL, apply 
transforms, map, and integrate that data into the CMDB.

When creating a nested data JSON payload, the following restrictions apply:

• Field names must start with a letter (between A-Z or a-z) or with ‘_’, and must only contain 
letters (between A-Z or a-z), digits (0-9), or the ‘_’ character.

For example, a field name can't contain special characters such as *, [,],  , $, spaces, and dot.
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• Field names can't be “temp” or “object”, which are reserved for internal use.

• Consistently throughout the payload, you must use an array or an object to represent data in 
a specific level, regardless of the number of items in the level. If you use an array for multiple 
items in one object, you must also use an array to represent a single item in other objects.

For a demo about working with nested payload data, watch the Integration Hub - ETL nested 
payload feature demo  video on the ServiceNow YouTube channel.

Related topics

Teams related list

Create an ETL transform map

IntegrationHub ETL provides a guided setup which walks you through the completion of all 
necessary tasks for creating an ETL transform map for a specific integration.

Guided setup

Guided setup organizes all the tasks in the correct order, tracks the completion of tasks, and 
enforces any task dependencies. Tasks that depend on the completion of other tasks, are 
enabled or disabled as you step through the tool and complete tasks.

Use guided setup on the ETL Transform Map Assistant page to complete the following tasks.

Import source data and specify basic details

Provide basic details for the integration, such as the source of the data that you want to integrate 
into CMDB, and import the source data.

Before you begin
The data source that you plan to select for the ETL Transform Map must exist in the same 
application scope as the one being used in the current session.

When you open an ETL transform map, by default the map is not validated. You can enable this 
validation step by adding the system property  sn_int_studio.validation.enabled 
to the System Properties [sys_properties] table and then setting it to true. After validation is 
complete, you choose how to handle validation errors.

Role required: cmdb_inst_admin

Procedure

1. Navigate to All  > Configuration  > IntegrationHub ETL.
The landing page of the IntegrationHub ETL lists all integrations that exist in the system, 
including integrations that were downloaded from the ServiceNow Store. Starting with 
IntegrationHub ETL v3.2, integrations are grouped by the CMDB Application  value, in 
which case expand the respective group to locate an integration.

2. Click the Name  of an integration to view or modify, or click Create new.
If the system property sn_int_studio.validation.enabled  is set to true, then 
IntegrationHub ETL validates the ETL transform map that you are loading. If there are any 
validation errors, the Invalid Mapping Data Detected dialog box appears, listing all the specific 
errors that were detected. You can choose to delete the invalid mappings and continue 
with only the valid mappings, or you can choose to keep the invalid mappings. However, 
notifications about invalid mappings will continue to appear as you continue to work with the 
integration.

The system detects errors such as:
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◦ Missing source or target fields in corresponding Robust Transform Engine (RTE) field 
mappings records

◦ Missing table columns in an import set

Note: 
In this situation, any corresponding metadata records in RTE are no longer valid and 
are automatically deleted. Records such as field mappings and transform operations 
that are associated with the missing table columns in the import set, are deleted.

◦ Missing an Identification and Reconciliation Engine (IRE) lookup rule for a lookup class

3. On the ETL Transform Map Assistant page, in the Specify Basic Details section of the guided 
setup, select the Import Source Data and Provide Basic Details  task.

4. Fill out the form.

Field Description

CMDB Application
The CMDB application associated with the 
ETL transform map.

You can select Add new, which adds the 
CMDB Application  and the Discovery 
Source  fields for the new CMDB application.

Name Name of the ETL transform map.

Description Description of the integration.

Data Source List of all data sources in the system.

Note: 
Be cautious in subsequently modifying 
the data source as it can result in 
substantial changes to the data 
integration. Aligning to the import set 
table of the new data source might 
require the removal of columns and 
associated transforms, or the addition 
of new columns. IntegrationHub ETL 
validation processes will detect any 
required updates and let you agree or 
reject these updates.

Sample Import Set
An Import Set that is associated with the 
specified Data Source.

A subset of that Import Set data is used to 
preview source data.

Select the Auto-pull a new import set  option 
to pull a new Import Set of the associated 
data source.

Starting with IntegrationHub ETL v3.2, if 
no Import Set is specified, then the map is 
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Field Description

loaded and is automatically set to be in read-
only mode. You can review configurations 
in the map but can’t edit mappings or 
transforms.

Preview Size Override
Number of data records that are loaded 
and used as sample for the preview for 
this transform map. If set, this custom 
setting overrides the value of the 
sn_int_studio.preview.size 
system property, and applies only to the 
current transform map.

If Load Complete Schema  is disabled, 
then the nested data structure for the map 
is generated based only on the specified 
number of records that are loaded.

Field available starting with IntegrationHub 
ETL v3.2.

Load Complete Schema
Enable or disable loading the entire data 
schema for generating the data structure for 
the map.

When disabled, the nested data structure 
for the map is generated based only 
on the number or records loaded as 
sample records for preview. The number 
of records loaded is determined by 
either the Preview Size Override 
setting, or by the global system property 
sn_int_studio.preview.size.

Field available starting with IntegrationHub 
ETL v3.2.

CMDB Application Name of a new CMDB Application. Appears 
if you set CMDB Application  to Add new.

Discovery Source
Discovery source associated with a new 
CMDB Application. Appears if you set 
CMDB Application  to Add new.

5. Click  Save  to save the current changes or  Mark as Complete.

A time stamp appears in the header when you click Save, which remains for the duration of 
the IntegrationHub ETL session for the ETL transform map. When you re-enter the session or 
switch between ETL maps, the time stamp disappears.

Related topics

Create an Import Set data source
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Preview and prepare data

Review sample records of raw source data, which will be integrated into the CMDB. Transform 
and prepare data to align with the target classes and attributes, if needed.

Before you begin
The number of records in the sample data is globally determined by the system property 
sn_int_studio.preview.size, which is set to 100 by default. The maximum number of 
records in the sample data that IntegrationHub ETL can process is 10,000. If you set that property 
above the 10,000 limit, then IntegrationHub ETL will only process up to 10,000 records and a 
message will appear to that effect.

Starting with IntegrationHub ETL v3.2, you can override the value of the 
sn_int_studio.preview.size  property by setting the Preview Size Override  field on the 
Import Source Data and Provide Basic Details form, per map.

To process nested data from a nested payload, the respective data source must be set with the 
Data in single column  option.

Role required: cmdb_inst_admin

About this task
Review the values in the data columns of the sample data and identify columns that do not align 
with the requirements of the intended target classes and attributes. You can transform data, for 
example, by converting the data format, replacing values, and concatenating data columns. You 
can apply transformations one on top of another, creating a chain of data transformations. You 
can also set a data column to be ignored in the mapping and integration process.

Note: 
To set a CMDB attribute to be empty, use the string '<EMPTY _STRING>'.

Columns for nested data appear alongside the rest of the data, with a Nested Objects  notation 
in the data column header. The count of nested data items per object appear with a link which 
lets you drill to deeper levels of the nested data. To show the data structure of nested data in a 
separate panel, enable the Show data structure  option.

The Data Structure panel has two options for displaying nested data:

• Tree: Nested data grouped by objects, where each object node corresponds to a record entry 
in the source data. Expand object nodes to show all nested data for the record.

• Collection: Nested data grouped by the top-level object (by default) and then by nested data 
items such as software. Expand a node such as software, to show which software is installed 
on each computer.

You can navigate through the levels of nested data in the Data Structure panel, the breadcrumbs 
path, or through number links that appear in the source data itself. Your selections and the 
data that appears are kept synchronized between all views of the nested data, regardless of 
navigation.

For a demo about working with nested payload data, watch the Integration Hub - ETL nested 
payload feature demo  video on the ServiceNow YouTube channel.

Procedure

1. Navigate to All  > Configuration  > IntegrationHub ETL, and click the Name  of an integration.
The landing page of the IntegrationHub ETL lists all integrations that exist in the system, 
including integrations that were downloaded from the ServiceNow Store.
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2. In the ETL Transform Map Assistant page, in the Prepare Source Data for Mapping section of 
the guided setup, select Preview and Prepare Data.

3. Optional:  Select Show data structure  to open the Data Structure panel which shows the 
structure of nested data.
In the Data Structure panel, you can drill down through the levels of nested data.

4. Optional:  Select the action menu for a column and then select a Sort operation.

5. Select the action menu for a column, and then either select Group by  to group the data by the 
respective column, or select Ungroup  to undo the grouping operation.

6. Optional:  Click New Transform  and then select Use Source Column , or select the action 
menu for a column and select New Transform  to transform the selected column.

(Optional) You can't create new transforms for nested objects at this top-level view of the data. 
A nested object column contains number links which indicate the number of nested items for 
the record. To create a new transform for nested objects, click that number link to drill down to 
the actual nested data. Alternatively, navigate in the Data Structure panel to the nested object 
for which you want to create a transform.

A transform of nested data can reference parent objects of the nested data being transformed. 
Using the sample payload for nested data  as an example, a transform for an interface object 
can reference the parent computer object but can't reference a software object.

a. In the New Transform sidebar on the right, select a Transform Type  and modify the 
Transform Description  if appropriate.
For more details about transform types, see Transform types in IntegrationHub ETL.

b. Optional:  Select Hide initial column used for this transform  to hide from the current view all 
the columns that were used for this transform.
This setting is temporary for the current session, and if you refresh the page, the hidden 
column reappears. To show a hidden column, you can also click the gear icon on the banner 
frame. Then, move the hidden column from the Available to the Selected list and click OK.

c. Select or verify the Input Column  whose values are being transformed.

d. Optional:  Modify the Output Column Name  for any of the columns that will be added with 
the transformed values.

e. Click Apply.
A new column with the transformed values appears, placed in alphabetical order based 
on the output column name. If you used the suggested output column name, then the new 
column appears to the right of the input column.

f. Review the transformed data and adjust any transforms, if needed.

7. Optional:  To apply the 'Set Fixed Value Column' transform:

a. Click New Transform  and then select Set Fixed Value Column.

b. In the Set Fixed Value Column sidebar, enter a Column Name  and a Column Description  for 
the new column.

c. Set Assign Column Value  to the value that is fixed for the new column.

d. Click Apply.

8. Optional:  Select the action menu for a column, and then select Ignore in Mapping  to exclude 
the column from mapping and integration in the current session.
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(Optional) In a subsequent session, the Ignore in Mapping  setting does not apply, and the 
column will be included in mapping.

You can click Include in Mapping  to undo the Ignore in Mapping  setting for the column.

9. Optional:  Select the action menu for a column, and then select Delete This and Downstream 
Columns  to delete the column along with any columns that were added using this column as 
an input column.

10. Optional:  Click New Transform  and then select Table Lookup, which lets you specify a table 
to look up and extract additional values from, then fill out the fields in the Table Lookup sidebar 
on the right.
Values from the specified lookup table are matched with the mapped data. For the records that 
match, the specified values from the lookup table, are added as a column, to the data that is 
being prepared for mapping.

Table Lookup

Field Description

Lookup Table Table to use for matching with the data that 
is being mapped. When records from the 
lookup table and the mapped data satisfy the 
Look Up Condition, then specified values 
from the Lookup Table  are extracted from the 
respective record and added to the mapped 
data.

Lookup Condition
(Optional) A set of pairs of column conditions. 
Each pair specifies a column in the lookup 
table and a column in the mapped data, 
which are attempted to be matched.

◦ If values of target table column: The 
column in the target table to match to a 
column in the mapped data.

◦ Match values of source data table: The 
column in the mapped data to match to a 
column in the lookup table.

You can add multiple pairs of columns to 
match on.

Lookup Condition
(Optional) Values to extract from the Lookup 
Table  when there is a match with the mapped 
data.

Then output values from the following 
columns: The lookup table columns to extract 
values from, when values from the lookup 
table and the mapped data, satisfy the 
Lookup Condition.

You can specify multiple lookup table 
columns to extract values from. For every 
column that you specify, a corresponding 
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Field Description

Output Column Name  field automatically 
appears. Specify a label for the column that 
will be added with the extracted values.

Output Column Name
(Optional) A label for the column that will be 
added to the mapped data, with the values 
extracted from the lookup table.

An Output Column Name  field is 
automatically added for every column that 
you specify in Then output values from the 
following columns.

11. Review the data and ensure that the intended set of data to be integrated is transformed, 
correctly formatted and prepared for import.

12. Click Mark as Complete.

Result
Data is prepared when the set of source data columns and transformed columns that you want 
to integrate, meet any formatting and other value requirements of the target CMDB classes and 
attributes. These columns are then ready to be mapped and integrated to CMDB classes and 
attributes.

About mapping data columns to CMDB classes and attributes

There are several requirements and guidelines for mapping source data to target CMDB classes 
and attributes. Also, there is an option of deactivating class mappings while preserving the 
settings for an easy reactivation. Review these concepts to ensure proper processing by the 
Identification and Reconciliation Engine (IRE).

Required mappings

You must map data to all required attributes of the target class in addition to mapping to 
attributes that are not configured as required. Also, the following two fields appear by default and 
you cannot delete them:

Source Native Key

IRE uses to uniquely identify a record and for building relationships and references. 
Also, improves performance of insert and update operations. When processing a 
payload, IRE generates an error if this field is empty.

Source Recency Timestamp

IRE uses to identify records that are older than the current record and therefore can 
be ignored, to help resolve conflicting attribute values. If a value is provided, it is 
used only if it is later than the value that is currently stored in the CMDB. If a value is 
not provided, IRE updates the attribute with the current timestamp.

The following system properties let you modify how IRE uses the 
source_recency_timestamp  value in a payload to update the last_scan 
attribute in the Source [sys_object_source] table:

• glide.identification_engine.skip_updating_last_scan_if_older

• glide.identification_engine.ire_message_listener_skip_updating_last_scan_to_now
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For more information about how IRE uses source_native_key  and 
source_recency_timestamp  for CI identification, see Identification and Reconciliation 
engine (IRE).

Conditional class

A conditional class lets you map different sets of data records to different target classes 
according to specific column values, or the status of a specific plugin.

For example, if a display name contains 'Windows', then 'Windows Server' is selected as the 
target class. But if the display name contains 'Linux', then 'Linux Server' is selected as the target 
class. For records that do not meet any of these conditions (display name does not contain 
'Windows' nor 'Linux'), 'Server' is selected as the target class.

Associated class

An associated class lets you select the CMDB class to be associated with a target non-CMDB 
table. Setting an associated class is required for IRE processing if the non-CMDB table is not 
configured for IRE processing. For a non-CMDB table that is supported and configured for IRE 
processing, setting an associated class is optional. See IRE support for non-CMDB tables  for 
more information.

The software Instance is a non-CMDB class but it does not have IRE rules associated with it. 
So, things we said about it here pre-Utah are still valid. But for non-CMDB classes with IRE rules 
it's not mandatory to have an association. For example “If the target class for mapping is a non-
CMDB class with a reference to a CMDB class, you must select the CMDB class to associate the 
non-CMDB target class with” non-CMDB class with IRE rules Instead of “you must” it should be. 
“You can”. Same with the Example it's not valid for non-CMDB with IRE rules.

If the target class for mapping is a non-CMDB class with a reference to a CMDB class, you must 
select the CMDB class to associate the non-CMDB target class with. A non-CMDB class refers 
to a class, such Serial Number [cmdb_serial_number], that does not extend the Configuration 
Item [cmdb_ci] class. The Related Entry [cmdb_related_entry] class might contain multiple CMDB 
class associations for the same non-CMDB class. Therefore, select the appropriate association 
to allow IRE processes to update the target non-CMDB class.

For example, the Related Entry [cmdb_related_entry] class has a record which associates the 
non-CMDB Software Instance [cmdb_software_instance] class with the CMDB Software Package 
[cmdb_ci_spkg] class. If you select Software Instance as a target class, you must associate the 
Software Instance class with the Software Package [cmdb_ci_spkg] class.

Deactivating class mappings

When you edit an ETL transform map, provided by a Service Graph Connector for example, you 
can delete a class mapping to prevent the class from being populated when the integration runs. 
However, if you later decide to populate that class, you must readd that class and reconfigure 
all the class mappings. Instead, you can deactivate a class mapping to temporarily ignore the 
class during the integration run, while preserving all of its mapping configuration. A class that you 
choose to deactivate is grayed out in the user interface but you can continue and edit the class 
mappings. Later, you can reactivate a class mapping to enable populating the class, without 
needing to reconfigure the class mappings.

Some classes that you choose to deactivate, trigger an automatic deactivation of additional 
classes that you did not directly choose to deactivate. Which classes are automatically 
deactivated, depends on the class that you chose to deactivate. For example, whether the class 
has dependent relationships or associated classes. Those automatically deactivated classes:
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• Appear in light gray in the user interface and you can't reactivate them.

• Are automatically reactivated when you reactivate:

◦ The class that you initially deactivated which triggered the automatic deactivation

◦ Any class that the deactivated class depends on

All classes that you directly deactivate mappings for and the resulting class mappings that are 
automatically deactivated, are not populated when the integration runs. Also, any relationships 
and lookup tables associated with those classes, are not populated when the integration runs.

Class mapping and other deactivation scenarios:

• Deactivate a class which no class depends on and which has no associated classes:

Triggers an automatic deactivation of any lookup rules and relationships associated with the 
deactivated class.

• Deactivate a lookup rule, such as serial number, within a class mapping:

Does not trigger any automatic deactivations.

• Deactivate a CMDB class which is associated with a non-CMDB class:

◦ Triggers an automatic deactivation of the associated non-CMDB class.

◦ Deactivating the non-CMDB class, does not impact the associated CMDB class.

• Deactivate a class with dependent relationships (Applies only if the dependent relationship 
exists in IntegrationHub ETL):

◦ Triggers an automatic deactivation of any class that has a single dependent relationship with 
the deactivated class.

◦ If a class has multiple dependent relationships, then it is automatically deactivated only 
when you deactivate all of the dependent on classes.

For example, a scenario in which the File System class has dependent relationships with 
both, the Computer and a Server class. If you deactivate the Computer class, the File System 
class is not automatically deactivated. Only if you also deactivate the Server class, the File 
System class is automatically deactivated.

• Deactivate a conditional class or a class mapping within a conditional class:

◦ Deactivating or activating a conditional class, triggers an automatic deactivation or activation 
of all conditional class mappings within the conditional class.

◦ Deactivating a class mapping within a conditional class: Prevents the deactivated class 
from getting populated during integration runs. However, the associated 'If', 'Else if', or 'Else' 
conditions themselves remain in effect within the condition of the conditional class. For 
example, if you deactivate the following class mapping:

[If] [operating_system] [contains] [Linux] Then [Class] [is] [Linux Server].

Then, the Linux Server class is not populated, but the [If] [operating_system] [contains] 
[Linux]  condition is in effect.
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Map data columns to CMDB classes and attributes

Choose target classes and attributes in the CMDB to map source data columns to. You can map 
a data column to a specific target class, or add conditions so that the choice of target class 
depends on specific data values.

Before you begin
Role required: cmdb_inst_admin

About this task
Data columns that you map can be either source data columns which were not transformed, 
or transformed data columns. For example, to integrate a data column into the Computer and 
Software Package classes, select those classes as target classes and then map data columns 
into specific attributes in those classes.

When you configure mapping for a class, relationship, or a lookup rule, those items are always 
initially set as activated. For details about the results of deactivating mappings, see Deactivating 
class mappings.

Note: 
Changing a class impacts any mappings that were already configured for the class, 
sometimes deleting those mappings. Details about the affected mappings and the impact, 
appear in the Affected mappings dialog box before you proceed with the class change. 
However, these details appear only when the change is from a CMDB class to another 
CMDB class or from a non-CMDB class to another non-CMDB class.

Procedure

1. Navigate to All  > Configuration  > IntegrationHub ETL, and click the Name  of an integration.
The landing page of the IntegrationHub ETL lists all integrations that exist in the system, 
including integrations that were downloaded from the ServiceNow Store.

2. In the ETL Transform Map Assistant page, in the Map Data to CMDB and Add Relationships 
section of the guided setup, select Select CMDB Classes to Map Source Data.
Attributes that are configured as required in the platform, are noted, and you must map a data 
column to each of those attributes.

3. Click Add Class  to add a target class to map to, or click Edit Class  to edit a class.

a. In the Add Class dialog box, select a CMDB Class.

b. Click Save.

c. Optional:  Set the Activate/Deactivate Mapping  toggle switch for a class, to on or off.
If the Affected class mappings dialog box appears, review the list of affected classes, and 
then click Proceed.
When you add a non-CMDB class, it is initially deactivated and the Activate/Deactivate 
Mapping  toggle switch is disabled, until you add an associated class that is active.

4. Click Add Conditional Class  and then in the Add Conditional Class  dialog box, specify the 
conditions that must be met for data to be mapped to different target classes.

a. Collection  is automatically set to the data branch in the hierarchy which is associated with 
the lowest-level attribute.
You can modify the value to the data branch from which you want to map data from, which 
must be at a higher level in the same data branch of the hierarchy.
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b. In the If  drop-down list, select attribute conditions that data values must meet, or enter 
plugins  in the search box and specify a plugin condition.
You can then specify that the rest of the records, which did not match any conditions, 
are mapped to yet a different target class. Data records will be mapped to different target 
classes according to the conditions met.

When processing nested data, a prefix denotes the first level in the nested hierarchy for 
attribute items.

Note: 
When you select a non-CMDB class, it is initially deactivated and the Activate/
Deactivate Mapping  toggle switch is disabled, until you add an associated class that is 
active.

c. Click Save.

d. Optional:  Set the Activate/Deactivate Mapping  toggle switch for a conditional class, to on 
or off.
If the Affected class mappings dialog box appears, review the list of affected classes, and 
then click Proceed.

e. Optional:  Click Edit Class  to edit the settings of a conditional class.
In the Edit Conditional Class dialog box, set the Activate/Deactivate Mapping  toggle switch 
for a class mapping, to on or off. Click Save, and if the Affected class mappings dialog box 
appears, review the list of affected classes and then click Proceed.

▪ A deactivated class is not populated during integration runs, however, this doesn't affect 
the associated condition. The 'If', 'Else if', and 'Else' conditions themselves remain in effect 
within the condition of the conditional class and matching CIs are filtered accordingly.

▪ The toggle switch of the conditional class reflects the summary of the states of all the 
conditional class mappings within the conditional class. If at least one of the conditional 
class mappings is activated, then the toggle switch of the conditional class appears as 
activated. Otherwise, the toggle switch of the conditional class appears as deactivated.

5. For a non-CMDB class, click Add Associated Class  to associate the non-CMDB class with a 
CMDB class  and to enable the Activate/Deactivate Mapping  toggle switch..
Or, click Edit Associated Class  to edit an already associated class.

a. In the Add Associated Class dialog box, select a CMDB class.
The list includes all entries in the Related Entry [cmdb_related_entry] class for the specified 
non-CMDB table  (deactivated classes are not included).

b. Click Add.

c. Optional:  Set the Activate/Deactivate Mapping  toggle switch for an associated class, to on 
or off.

Note: 
If an associated class was not added or is deactivated, then the Activate/Deactivate 
Mapping  toggle switch is disabled.

6. Click Set Up Mapping  to configure mapping for a newly added class, or click Edit Mapping  to 
edit a mapping.
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a. To map, drag data columns from the Data sidebar on the right, to CMDB target attribute on 
the left side of the mapping page.

Or, click the  icon to search and select data columns for the mapping.
When mapping nested data:

▪ Data columns in the Data sidebar appear in a tree format that represents the structure of 
the nested data. Each attribute is associated with sample data for the attribute.

▪ Transformed columns are noted by a cyan-shaded dot.

▪ All mappings to a specific CMDB class must be from the same source branch in the 
nested data. Only the branch from which you selected the first column to map, is valid for 
selecting columns in subsequent mappings.

This restriction applies differently when mapping to attributes in lookup tables. All 
mappings to attributes in a lookup table also must be from the same source branch. 
However, that source branch can be different than the source branch you used with non-
lookup tables.

Note: 
You can work around this restriction by using the Copy  transform in the data 
preparation step, to copy attributes from a parent level to a child level. Prepare the 
data so that all the attributes that you want to map, are at the same level.

▪ When you drag a column to map from the Data sidebar, the fields of CMDB target 
attributes that are valid for the mapping, are highlighted by a green frame. If you attempt 
to drop a column in an invalid target attribute, the respective field is highlighted by a red 
frame and an error appears.

b. Click Add Attribute.

c. In the Add Attribute dialog box, from the Attribute  list, select one or more items as target 
attributes to map data to.
You can also scroll down to the IRE Settings  section of the list and select one of the robust 
import set transformer properties  . Click Save.
For information about precedence order between robust import set transformer properties 
defined at the individual item level and at the IRE payload level, see robust import set 
transformer properties  .

d. Map any lookup rules such as the 'Serial Number Lookup 1' rule.

Lookup rules are in a deactivated state until you map them.  Click the filter icon for the lookup 
rule to edit or add any lookup filters. In the lookup filter dialog box, specify attribute or plugin 
conditions that must be met for data to be mapped to various target classes. Then click 
Save.

After mapping a field of a lookup rule, you can set the Activate/Deactivate Lookup rule toggle 
switch for a rule, to on or off.

e. Optional:  Click View Class Details  to view the current class in CI Class Manager.
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f. Optional:  Click the Transform Data  tab to navigate to the data preparation page where you 
can review and further transform data that you want to map.

g. Return to the Select CMDB Classes to Map Source Data page.

7. Click Mark as Complete.

Add Relationships

Add relationships that exist among the target CMDB classes, for an integration.

Before you begin

• A class that you want to add in the relationship, must be in an activated state.

• A base relationship or a relationship within a conditional relationship, that you want to edit, 
must be in an activated state.

• In a conditional relationship that you want to edit, at least one relationship condition must be in 
an activated state. Otherwise, the Edit Relationship  button is grayed out.

Role required: cmdb_inst_admin

About this task
When creating relationships with nested data, you can't create a relationship between sibling 
objects from the nested data. Using the sample payload for nested data  as an example, you can't 
create a relationship between interfaces and software.

ITOM Visibility, if available, uses enhanced discovery patterns to identify and add CI 
relationships to the Suggested Relationships table in the base system. When applicable, use 
the Suggested Relationships table to select relationships that are in compliance with Common 
Service Data Model  (CSDM) standards.

Procedure

1. Navigate to All  > Configuration  > IntegrationHub ETL, and click the Name  of an integration.
The landing page of the IntegrationHub ETL lists all integrations that exist in the system, 
including integrations that were downloaded from the ServiceNow Store.

2. In the ETL Transform Map Assistant page, in the Map Data to CMDB and Add Relationships 
section of the guided setup, select Add Relationships.

3. Add relationships.

a. Add relationships by selecting Add Relationship  or Add Conditional Relationship  if you 
want to specify attribute conditions that must be met before adding a relationship.

b. Complete the following actions as needed.
The Relationship Type  list menu changes based on the selected parent and child class:

◦ If there is a dependent relationship, the list is disabled and the relationship type is 
automatically populated.

◦ If there is more than one dependent relationship, the list displays both containment 
and hosting relationship options and the containment relationship type is automatically 
populated.
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◦ If there is no dependent relationship, the list displays Suggested relationships  with the first 
suggested relationship automatically selected, followed by the base system relationship 
types.

◦ If there is no suggested relationship, the list displays No suggested relationships  followed 
by the base system relationship types.

4. Click Save  to save the current changes or Mark as Complete.

A time stamp appears in the header when you click Save, which remains for the duration of 
the Integration Hub ETL session for the ETL transform map. When you re-enter the session or 
switch between ETL maps, the time stamp disappears.

Preview mapping results

Preview the results of the sample data integration.

Before you begin
Role required: cmdb_inst_admin

About this task
Run an integration test and view a summary of the results, for the sample data (by default, up to 
100 records). The summary includes total numbers for relationships that were created, mapped 
classes, partial and incomplete payloads that IRE couldn’t process. You can also view detailed 
messages from Robust Transform Engine (RTE) and from Identification Reconciliation Engine 
(IRE).

Note: 
Most IntegrationHub ETL log messages (from RTE and IRE) are informational. 
However, even if the com.glide.import_set.importlog_level  and the 
glide.importlog.log_to_table  system properties are set to not add INFO log 
messages, IntegrationHub ETL does render INFO log messages. For more details about 
these properties, see Import sets properties .

After you view the details in the summary page, you can return to any step to make adjustments 
and then rerun the integration.

Procedure

1. Navigate to All  > Configuration  > IntegrationHub ETL, and click the Name  of an integration.
The landing page of the IntegrationHub ETL lists all integrations that exist in the system, 
including integrations that were downloaded from the ServiceNow Store.

2. In the ETL Transform Map Assistant page, in the Preview Sample Integration Results and 
Schedule Import section of the guided setup, select Test and Rollback Integration Results.

3. On the Test and Rollback Integration Results page, click Run Integration.

4. View the summary page and click the various tabs to see the integration run results for the 

affected CMDB classes. You can click  to open CI forms and view information.

Note: 
The order of the attribute columns follows the default columns list for the class in the 
platform. First, the default columns for the class appear from left to right, followed by 
the rest of the attribute columns organized in alphabetical order. For example, to see 
the default columns list for the Computers class, navigate to All  > Configuration  > 
Computers.
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5. Optional:  Select any class tab and click Edit Mapping  to return to the Select CMDB Classes to 
Map Source Data page where you can review and change mapping settings.

Note: 
Clicking Edit Mapping  rolls back all the changes that were made to the CMDB as a result 
of this integration run.

6. Optional:  Click the Relationships  tab and review any relationships that were created.
Click Edit Relationships  to return to the Add Relationships page where you can review and 
change any relationship configurations.

Note: 
Clicking Edit Relationships  rolls back all the changes that were made to the CMDB as a 
result of this integration run.

7. Click the Error Log, Activity Log, or the Warning Log  tabs to see the respective details logged 
by IRE and RTE during the integration.

IRE log records are grouped by categories and further organized by the respective class. For 
IRE log messages, the Message column contains only the messages themselves which were 
extracted from the raw log message. The Log Message column contains the complete log 
message, which includes class and category in addition to the message itself. RTE logs appear 
under the Other category.

Use the Verbose  toggle switch to change the viewing mode for the Message and the Log 
Message columns:

◦ Verbose on: Shows fully expanded text of log messages.

◦ Verbose off: Shows a condensed version of the log messages. The fully expanded text of the 
log messages appears when you point to a message.

8. Click the Incomplete Payloads  and Partial Payloads  tabs for details about IRE payloads for 
the integration run.

9. Select Mark as Complete.
The Rollback options dialog box appears and you can choose either of the following options.

◦ Retain Data: All the changes to the CMDB resulting from this integration, are retained.

◦ Perform Rollback: All the changes to the CMDB resulting from this integration, are rolled 
back and the CMDB is restored to its state before running the integration.

Provide integration schedule

Configure a schedule for importing data to CMDB using this ETL Transform Map.

Before you begin
Role required: cmdb_inst_admin

Procedure

1. Navigate to All  > Configuration  > IntegrationHub ETL, and click the Name  of an integration.
The landing page of the IntegrationHub ETL lists all integrations that exist in the system, 
including integrations that were downloaded from the ServiceNow Store.

2. In the ETL Transform Map Assistant page, in the Preview Sample Integration Results and 
Schedule Import section of the guided setup, select Set Import Schedule.

3. On the Provide Schedule page, click Set Schedules.

4. In the Scheduled Data Imports list view (which opens in a new tab), click New.
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5. Fill out the Scheduled Data Import form and then click Submit.
See Schedule a data import  for details about the form fields.

6. Click Mark as Complete.

Transform types in IntegrationHub ETL

Use various transforms in IntegrationHub ETL to convert and prepare source data for mapping to 
the CMDB.

Transforms from the Integration Commons for CMDB  store app, are also available in 
IntegrationHub ETL.

Concatenation

Combines the values from input fields into a single string, joining them on the optional 
joining_string  field.

Details

Table sys_rte_eb_concat_operation

Input fields source_sys_rte_eb_fields

Output field target_sys_rte_eb_field

Additional Fields joining_string  (optional)

Example

Input “input_1”, “input_2”, “input_3”

Additional 
Fields

joining_string  = ”, ”

Result “input_1, input_2, input_3”

Convert to Boolean

Converts the incoming value to a boolean. ‘true’ and ‘1’ values convert to 'true' (case 
insensitive), and any other values convert to 'false'.

Details

Table sys_rte_eb_to_boolean_operation

Input fields source_sys_rte_eb_field

Output field target_sys_rte_eb_field

Examples:

• All of the following inputs return 'true':

◦ true

◦ 1

• All of the following inputs return 'false':
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◦ “input_1”

◦ “”

◦ 0

◦ 11

Convert to Date

Attempts to convert the incoming value to a GlideDateTime  value by applying the 
date_format  to the incoming value. Attempts to directly convert using GlideDateTime  if 
the date_format  is incorrect.

Details

Table sys_rte_eb_to_date_operation

Input fields source_sys_rte_eb_field

Output field target_sys_rte_eb_field

Returns an empty value if unable to parse at all.

Additional Fields date_format  (Java simple date format)

Example

Input "2018/09/20 11:21:00 a.m. EST”

Additional 
Fields

date_format  = “yyyy/MM/dd hh:mm:ss a z”

Result “2018-09-20 16:21:00”

Example

Input "2018/09/20 01:21:00 PM EST”

Additional 
Fields

date_format  = “yyyy/MM/dd hh:mm:ss a z”

Result “2018-09-20 18:21:00”

Example

Input "09/20/18”

Additional 
Fields

date_format  = “yyyy/MM/dd hh:mm:ss a z”

Result “0018-09-20 00:00:00”

Convert to Numeric

Converts the incoming value to a number.
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Details

Table sys_rte_eb_to_numeric_operation

Input fields source_sys_rte_eb_field

Output field target_sys_rte_eb_field

If the incoming value is non-numeric, then the output is empty.

Example

Input 1.23

Result 1.23

Example

Input 1.00

Result 1

Example

Input input_1

Result null

Example

Input two

Result null

Copy

Copies the source field’s value to all of the target fields.

Details

Table sys_rte_eb_copy_operation

Input fields source_sys_rte_eb_field

Output field target_sys_rte_eb_fields

Additional Fields overwrite_existing_value  (optional, boolean): If true, then the 
values of target fields are replaced. Otherwise, any non-empty value is not 
overwritten.

Extract Leading Numeric

Sets the target field to be the first numeric value found in the source field.
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Details

Table sys_rte_eb_extract_numeric_operation

Input fields source_sys_rte_eb_field

Output field target_sys_rte_eb_field

Additional Fields • decimal_places  (optional, number): Forces the output to have a 
specified number of decimal places.

• remainder_target_field  (optional, reference to a field): Set to the 
trimmed remainder of the source field, after removing the first numeric 
value.

Example

Input “100 mb”

Result "100”

Example

Input “100.123 mb”

Result “100.123"

Example

Input “100.123 mb”

Additional 
Fields

decimal_places  = 2

Result “100.12”

Example

Input “100 mb”

Additional 
Fields

decimal_places  = 2

Result “100.00”

Example

Input “100 mb”

Additional 
Fields

remainder_target_field  = <field>

Result “100” and <field> = “mb”
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Glide Lookup

Performs a lookup in the database on the target_table.

Details

Table sys_rte_eb_glide_lookup_operation

Input fields source_sys_rte_eb_fields

Output field target_sys_rte_eb_fields

Additional Fields • target_table

• glide_matching_fields  (string): Comma-separated 
list of column names in the target table. For each input field in 
source_sys_rte_eb_fields, there must be an equal number of 
values in glide_matching_fields

• glide_target_fields  (string): Comma-separated list 
of column names in the target table. For each target field in 
target_sys_rte_eb_fields, there must be an equal number of 
values in glide_target_fields.

Example

Input • Input Field 1: 100 South Charles Street, Baltimore

• Input Field 2: MD

Additional 
Fields

• Target Table: Location (cmn_location)

• Glide Matching Fields: street,state

• Glide Target Fields: sys_id

Result Output Field 1: 25ab9c4d0a0a0bb300f7dabdc0ca7c1c

Min/Max

Sets the target field to either the maximum or minimum of the values from all input fields.

Details

Table sys_rte_eb_min_max_operation

Input fields source_sys_rte_eb_fields

Output field target_sys_rte_eb_field

Additional Fields • data_type  (choice list <STRING,NUMERIC,DATE>)

• min_max  (choice list <MIN,MAX>)
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Example

Input “2”, “-1”, “0”

Additional 
Fields

• data_type  = NUMERIC

• min_max  = MAX

Result “2”

Example

Input “a”, “b”

Additional 
Fields

• data_type  = STRING

• min_max  = MAX

Result “b”

Example

Input “2”, “-1”, “0”

Additional 
Fields

• data_type  = NUMERIC

• min_max  = MIN

Result “-1”

Example

Input “a”, “b”

Additional 
Fields

• data_type  = STRING

• min_max  = MIN

Result “a”

Multiple Input Script

Runs a script with multiple inputs, setting the target_field  == output for that script.

Each source field is available inside of the ‘batch’ variable as JavScript fields. The name of the 
JavaScript field is the field attribute of the entity field (looking at sys_rte_eb_field.field, 
not sys_rte_eb_field.name).

Details

Table sys_rte_eb_multi_in_script_operation

Input fields source_sys_rte_eb_fields
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Details

Output field target_sys_rte_eb_field

Additional Fields • script  (script)

• use_unique_input_sets  (boolean): When true, only unique input 
values are included in the data batch for IRE processing. Otherwise, all 
input object’s field values are included.

Example for using use_unique_input_sets, with a script function that takes 
record_type  and operating_system  as input and returns record_with_os:

Input data

Record record_type operating_system record_with_os

1 computer Windows XP

2 computer Linux

3 computer Windows XP

If use_unique_inputs_sets  is set to true, then the script processes only two values 
(computer + Windows XP and computer + Linux). If use_unique_inputs_sets  is set to 
false, then each of the three values is individually processed (computer + Windows XP, computer 
+ Linux, and computer + Windows XP).

Sample script:

            (function(batch, output) {
                for (var i = 0; i < batch.length; i++) {
                        // batch[i] is the unique set of 
 inputs/individual record
                        // batch[i].<field> gives access to the 
 field value
                        var in0 = gs.nil(batch[i].record_type) ? 
 '' : batch[i].record_type;
                        var in1 = 
 gs.nil(batch[i].operating_system) ? '' : 
 batch[i].operating_system;
                        // output[i] is the output for the 
 specific combination of inputs/individual record
                        output[i] = in0 + "_" + in1;
                    }
                }
            })(batch, output);

Sample script:

            /* Example Script
             // In this example the script input fields are 
 'input_field_1', 'input_field_2' - replace these with the 
 fields used as script inputs // There is a static field 
 'input' that has all the input field values concatenated with a 
 '|' (function(batch, output) {
                 for (var i = 0; i < batch.length; i++) {
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                     //step1: access the input variables
                     var a = batch[i].input_field_1; //Value of 
 the first source field.
                     var b = batch[i].input_field_2; //Value of 
 the second source field.
 
                     //step2: Your script/code goes here.
                     var c = a + b;
 
                     //step3: set the output for each elements
                     output[i] = b;
                 }
 
             })(batch, output);
            */

Rexeg Replace

Replaces each substring of the incoming string that matches the specified match_regex, with 
the specified replacement_regex  string value.

Details

Table sys_rte_eb_regex_replace_operation

Input fields source_sys_rte_eb_field

Output field target_sys_rte_eb_field

Additional Fields • match_regex  (string, regular expression)

• replacement_regex  (string)

Example

Input “String&With(Special)$Characters”

Additional 
Fields

• match_regex  = “[^0-9a-zA-Z]+”

• replacement_regex  = “ ”

Result “String With Special Characters”

Replace

Replaces each substring in the incoming string that matches the specified match_string, 
with the replacement_string  string value.

Details

Table sys_rte_eb_replace_operation

Input fields source_sys_rte_eb_field

Output field target_sys_rte_eb_field
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Details

Additional Fields • match_string  (string)

• replacement_string  (string)

Example

Input “Original String”

Additional 
Fields

• match_string  = “Original”

• replacement_string  = “Replacement”

Result “Replacement String”

Round Numeric

Rounds the number value to the nearest whole number. Non-numbers are truncated.

Details

Table sys_rte_eb_round_numeric_operation

Input fields source_sys_rte_eb_field

Output field target_sys_rte_eb_field

Example

Input “1.5”

Result "2"

Example

Input “1.4”

Result "1"

Example

Input “i’m a string”

Result ""

Script

Runs a script with input, setting the target_field == output for that script.

This transform has been superseded by the Multi Input Script transform and is included for 
backwards compatibility with existing configurations.
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Details

Table sys_rte_eb_script_operation

Input fields source_sys_rte_eb_field

Output field target_sys_rte_eb_field

Additional Fields • script  (script)

• use_unique_input_sets  (boolean): When true, only unique input 
values are included in the data batch for IRE processing. Otherwise, all 
input object’s field values are included. For an example and for more 
details, see the Multiple Input Script transform.

The source field is included in the ‘batch’ variable as the JavaScript field ‘input’.

          (function(batch, output) {
                for (var i = 0; i < batch.length; i++) {
                        // batch[i] is the unique set of 
 inputs/individual record
                        // batch[i].input gives access to the 
 field value
                        var in0 = gs.nil(batch[i].input) ? '' : 
 batch[i].input;
                        // output[i] is the output for the 
 specific combination of inputs/individual record
                        output[i] = in0 + " modified by script”;
                    }
                }
            })(batch, output); 

Example:

/* Example Script
 (function(batch, output) {
     for (var i = 0; i < batch.length; i++) {
         //step1: access the input variables
         var a = batch[i].input; //Value of the source field.
 
         //step2: Your script/code goes here.
         var b = a + 1;
         //step3: set the output for each elements
         output[i] = b;
     }
 })(batch, output);
*/ 

Set

Sets the target field’s value to the string specified in set_value.

Details

Table sys_rte_eb_set_operation

Input fields source_sys_rte_eb_field
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Details

Output field target_sys_rte_eb_field

Additional Fields • set_value  (string)

• overwrite_existing_value  (optional, boolean): When true, the 
current value of the target field is overwritten. Otherwise, a non-empty 
value isn't replaced.

Split

Splits the source field’s value on the splitting_string  and assigns each resulting item 
from the split to the target_sys_rte_eb_fields, in order.

Details

Table sys_rte_eb_split_operation

Input fields source_sys_rte_eb_field

Output field target_sys_rte_eb_fields

Additional Fields splitting_string  (string)

Example

Input “value1||value2||value3”, with target_sys_rte_eb_fields 
{target1,target2,target3}

Additional 
Fields

splitting_string  = ”||”

Result target1 : value1, target2 : value2, target3 : value3

Example

Input “value1||value2||value3”, with target_sys_rte_eb_fields  {target1}

Additional 
Fields

splitting_string  = ”||”

Result target1 : value1

Example

Input “value1”, with target_sys_rte_eb_fields  {target1,target2,target3}

Additional 
Fields

splitting_string  = ”||”

Result target1 : value1, target2 : <null>, target3 : <null>
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Trim

Trims leading and trailing whitespace from the source_sys_rte_eb_field  value and 
assigns the result to the  target_sys_rte_eb_field. This transform is equivalent to a 
Java String.trim().

Details

Table sys_rte_eb_trim_operation

Input fields source_sys_rte_eb_field

Output field target_sys_rte_eb_field

Example

Input “ value 1 ”

Result “value 1”

Uppercase

Uppercases the source_sys_rte_eb_field  value and assigns the result to 
target_sys_rte_eb_field.

Details

Table sys_rte_eb_upper_case_operation

Input fields source_sys_rte_eb_field

Output field target_sys_rte_eb_field

Example

Input “value1”

Result “VALUE1”

Uppercase Trim

Combines both the Uppercase and the Trim transforms.

Details

Table sys_rte_eb_upper_case_trim_operation

Input fields source_sys_rte_eb_field

Output field target_sys_rte_eb_field

Example

Input “ value1 ”

Result “VALUE1”
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Add before and after scripts to an integration data source

Add custom before and after scripts for a data source of a CMDB integration application. Those 
scripts provide access to the input and output payloads of IRE. When a CMDB integration 
invokes Identification and Reconciliation Engine (IRE), those scripts run before and after IRE 
processes the integration payload.

Before you begin
Role required: cmdb_inst_admin

Procedure

1. Navigate to All  > Configuration  > IntegrationHub ETL.

The landing page of the IntegrationHub ETL lists all integrations that exist in the system, 
including integrations that were downloaded from the ServiceNow Store.

2. Click the CMDB Application  link for the integration that you want to add scripts for.

3. On the CMDB Integration Studio Application form, in the CMDB Integration Studio Application 
Data Sources related list, open the data source record for the CMDB integration.

4. On the CMDB Integration Studio Application Data Source form, check Execute Before Script 
or Execute After Script.

5. Review the Before Script  and After Script  comments and enter your custom scripts at the 
bottom of the script field.
The comments in the script fields provide details for the before and after scripts. Use those 
guidelines, explanations such as what operations are supported, and examples when creating 
your custom script.

6. Click Update.

Related topics

Identification and Reconciliation engine (IRE)

Duplicate an ETL transform map

Use an existing ETL transform map if you need to create a map that is mostly similar to that 
existing map. Select an existing map, specify a new data source for the new duplicate map, and 
then change or retain other settings such as data transforms.

Before you begin
The data source for the new duplicated ETL transform map must satisfy these requirements:

• The schema of the data source must be identical to the schema of the original ETL transform 
map. For example, both data sources must have an identical number of columns and identical 
column labels.

• The data source must preexist.

• The data source must not be used in any other ETL transform map.

Role required: cmdb_inst_admin

Procedure

1. Navigate to All  > Configuration  > IntegrationHub ETL.
The landing page of the IntegrationHub ETL lists all integrations that exist in the system, 
including integrations that were downloaded from the ServiceNow  Store.

2. Click Duplicate  and then fill out the Duplicate ETL Transform Map form.
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Field Description

Duplicate from The ETL transform map to duplicate from.

CMDB application
The CMDB application associated with the 
ETL transform map.

You can select Add new, which adds the 
CMDB Application  and the Discovery 
Source  fields for the new CMDB application.

Discovery Source Discovery source associated with a new 
CMDB Application. Appears if you set CMDB 
Application  to Add new.

CMDB Application Name Name of a new CMDB Application. Appears if 
you set CMDB Application  to Add new.

Name Name of the ETL transform map.

Data Source The source feed, unique for this ETL 
transform map, where the raw source data is 
imported from.

3. Click Create Duplicate.

Result
Data for the new duplicated ETL transform map is imported, and the Import Source Data and 
Provide Basic Details  task, is set as complete.

What to do next
Continue with the next steps on the guided setup steps to review the imported data and 
complete the integration using the duplicated ETL transform map.

Getting started with Service Graph Connectors

Service Graph Connectors, including API Service Graph Connectors, are predefined integrations 
that ingest third-party data and API data into the Configuration Management Database (CMDB) 
from various domains, such as security, servers, software or monitoring, Internet of Things (IoT), 
and cloud.

Important: 
See Service Graph Connectors  and API Service Graph Connectors  for a list of connectors 
provided by ServiceNow.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Service Graph Connectors  overview

The following video provides an overview of Service Graph Connectors.

Service Graph Connectors
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As a purpose-built app, you can use a Service Graph Connector, including an API Service Graph 
Connector, to maintain the quality and consistency of third-party data in your CMDB.

You can use the following connector types:

Service Graph Connectors

A Service Graph Connector  imports and integrates third-party data into CMDB 
and non-CMDB  tables. For a list of Service Graph Connectors, see Service Graph 
Connectors.

API Service Graph Connectors

An API Service Graph Connector  imports and integrates third-party API data into 
CMDB  and non-CMDB  tables. For a list of API Service Graph Connectors, see API 
Service Graph Connectors.

Partner-built connectors

Service Graph Connectors  can be built by partners and vendors. For a list of 
partner-built connectors, see the ServiceNow Store  website.

The connectors also make sure that third-party data is mapped to the right locations in 
your CMDB  as specified by the Common Service Data Model  (CSDM). The CSDM  enables 
ServiceNow  products to use the data and increases reporting accuracy. For more information on 
CSDM, see Common Service Data Model.

The Service Graph Connectors, including API Service Graph Connectors, manage the 
configuration data pipeline in the following steps:

1. Ingest the data by identifying class, attribute, and data sources by using the identification 
rules.

2. Standardize the data to comply with your CMDB.

3. Reconcile the data into a single coherent picture by using the reconciliation rules.

4. Ingest the data into your CMDB.

You can track the status and processing results of all installed integrations using the SGC Central 
view within the CMDB Workspace  or integrations dashboard provided with the Integration 
Commons for CMDB  store app. For more information, see SGC Central, Integration Commons for 
CMDB, and CMDB Integrations Dashboard.

Using SGC Central  for connectors

The Service Graph Connector Central  application also called as SGC Central  is available as a 
view in the CMDB Workspace. The application enables you to discover and install Service Graph 
Connectors, including API Service Graph Connectors, and then effectively manage the full life 
cycle of creating, editing, monitoring, and debugging connections. The SGC Central  application 
also ensures that connectors remain supported and up-to-date with certified partners.

The SGC Central  application minimizes customization and accelerates time to value with intuitive 
setup options and playbook-guided connector deployment. If the playbook experience isn’t 
available for a connector, you can follow the guided setup provided with the connector.

To learn more, see SGC Central.

Required role

As a user with the admin role, you can install Service Graph Connectors, including API Service 
Graph Connectors.
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Using connectors

By using Service Graph Connectors  and API Service Graph Connectors, you can mandate data 
governance and design practices. Examples of mandated practices using connectors include:

• Consistently associating data with specific CI types. For instance, IP addresses are assigned 
to network interfaces rather than a mix of interfaces and servers. Ensuring that ServiceNow 
products know where to find third-party data. For more information, see CMDB classifications 
and class dependency.

• Using the Identification and Reconciliation (IRE) engine to identify and classify data correctly 
before it’s loaded into the CMDB. Helping prevent duplicate CIs and ensuring that attribute 
values are consistent across multiple data sources.

For information on the IRE-related rules used in Service Graph Connectors, see the following 
topics:

◦ CMDB Identification and Reconciliation

◦ Identification rules

◦ Reconciliation rules

◦ Create an IRE data source rule

◦ Detecting duplicate CIs

◦ Create a data refresh rule

◦ Create an identification inclusion rule

• Using the IntegrationHub ETL functionality so that data is transformed and loaded in the fastest 
and most efficient manner. For more information, see IntegrationHub ETL.

Resolving connector issues

You can use the Service Graph Connector Support Tools  scoped application to resolve any 
issues or perform a general analysis on a Service Graph Connector  installed on your instance. 
See Service Graph Connector Support Tools.

Service Graph Connectors

You can use a Service Graph Connector  to import and integrate third-party data into CMDB  and 
non-CMDB  tables.

Important: 
Visit the ServiceNow Store  website to view the latest list of all Service Graph Connectors.

To learn more, see Getting started with Service Graph Connectors.

Select an application to learn about the Service Graph Connector  available for ingesting data 
from the application into your CMDB.

Public cloud providers

AWS GCP Microsoft Azure
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Software, server, or network applications

Infoblox Trellix

Operational Technology (OT) applications

Claroty CTD Microsoft Defender 
for IoT  (On-premises 

Management Console)

Microsoft Defender 
for IoT  (Azure)

Operational Technology 
(Excel import)

Partner-built connectors

Service Graph Connectors  can be built by partners and vendors. For a list of partner-built 
connectors, see the ServiceNow Store  website.

Service Graph Connector for Active Directory

The Service Graph Connector for Active Directory  retrieves computer and software information 
from the Microsoft Active Directory  (AD) product and imports it into the Configuration 
Management Database (CMDB) in your instance using Lightweight Directory Access Protocol 
(LDAP).

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Supported versions

• Microsoft Active Directory  version: Last tested on

• Supported ServiceNow®  versions:

◦ Utah

◦ Vancouver

◦ Washington
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Use cases

Import computer and software details about your assets from the Microsoft Active Directory 
product into your CMDB.

Guided setup

The guided setup for the Service Graph Connector for Active Directory  provides an organized 
sequence of tasks to configure the integration on your instance. To access the guided setup, 
Configure Service Graph Connector for Active Directory.

CMDB  integrations dashboard

The Integration Commons for CMDB  store app provides a dashboard with a central view of 
the status, processing results, and processing errors of all installed integrations. You can see 
metrics for all integration runs. You can filter the view to a specific CMDB  integration, a specific 
time duration, or a specific integration run. For more details about monitoring Microsoft Active 
Directory  integrations in the CMDB  Integrations Dashboard, see Using the CMDB Integrations 
Dashboard.

Data mapping

Data from the Service Graph Connector for Active Directory  data sources is mapped and 
transformed into the ServiceNow  CMDB  Configuration Item (CI) class definitions using 
the Robust Transform Engine (RTE). Data is inserted into the ServiceNow  CMDB  using the 
Identification and Reconciliation Engine (IRE).

After you complete the guided setup, you configure the integration to periodically pull data from 
the Active Directory. The data is loaded into the following tables.

You can use the Integration Hub ETL application to view the data maps.

Data sources and staging tables for Active Directory

Data source Staging table

SGC Active Directory Import SGC Active Directory Import 
[sn_sec_sgc_ad_active_directory_import]

Computer Computer [cmdb_ci_computer]

Software Software [cmdb_ci_spkg], 
[cmdb_software_instance], 
[cmdb_sam_sw_install]

SGC Active Directory Computer SGC Active Directory Computer 
[sn_sec_sgc_ad_active_directory_computer]

Configure Service Graph Connector for Active Directory

Configure your Lightweight Directory Access Protocol (LDAP) connections and verify them, set up 
scheduled imports, and optionally add multiple instances with the Guided Setup.

Before you begin
To use this Service Graph Connector, you need a subscription to a Subscription Unit that is 
based in the IT Operations Management  (ITOM) Visibility application or in the ITOM  Discovery 
application. As defined in the section titled "Managed IT Resource Types" in ServiceNow 
Subscription Unit Overview  for your subscription, for managed IT resources that are created 
or modified in the CMDB  by this Service Graph Connector, but that aren’t yet managed by ITOM 

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

879

https://www.servicenow.com/products/entitlements-packages.html
https://www.servicenow.com/products/entitlements-packages.html
https://www.servicenow.com/products/entitlements-packages.html
https://www.servicenow.com/products/entitlements-packages.html
https://www.webstg.servicenow.com/docs/access?context=itom-license-module&version=washingtondc&pubname=washingtondc-it-operations-management&ft:locale=en-US


Visibility or ITOM Discovery , these resources will increase Subscription Unit consumption from 
that application. Review your current Subscription Unit consumption within ITOM Visibility or 
ITOM Discovery to ensure available capacity.

• The Integration Commons for CMDB  store app, which is automatically installed.

• The CMDB  CI class models store app, which is automatically installed. See CMDB CI Class 
Models store app.

• The ITOM  Discovery License plugin (com.snc.itom.discovery.license). You must activate this 
plugin.

• ITOM  Licensing plugin (com.snc.itom.license). For more information, see Request Discovery .

• The Datastream Action plugin (com.glide.hub.action_type.datastream), which is automatically 
installed.

• Observability Commons for CMDB  (sn_observability), which is only required for event 
ingestion. This app must be installed prior to installing the connector for Event Management to 
work. For more information, see Observability Commons for CMDB  on the ServiceNow Store.

After you have followed the instructions provided to you to download and activate the Service 
Graph Connector for Active Directory  application, refer to Download an application from the 
ServiceNow Store for the first time  and Install a Security Operations integration . There are a 
few steps you need to complete before you configure this integration.

Role required: admin

Procedure

1. Navigate to All  > Service Graph Connectors  > Active Directory  > Setup.

2. On the Welcome to Guided Setup Home page, select Continue.

3. On the Experience page, select Best Experience  followed by Continue.
The Service Graph Connector for Active Directory (AD) page is displayed with the following 
tasks:

◦ Configure LDAP Server

◦ Add Multiple Instances

◦ Set up scheduled import jobs

4. Select Configure LDAP Server  to expand it.
The following steps are displayed in the left navigation panel:

◦ Configure Inactive threshold

◦ Update LDAP OU definition

◦ Configure LDAP Server Details

◦ Test LDAP Server Connection

A single LDAP server is supplied along with the application. This server includes a computer 
organizational (OU) unit that retrieves a computer's object information from the computers OU.

5. Optional:  Select Configure Inactive threshold  to open the record.
The System Property sn_sec_sgc_ad.inactive_threshold form is displayed.

6. Select the here  link in the message at the top of the form to edit the record.

7. Optional:  Alternatively, you can select the Globe  icon in the upper right of the screen and 
select Service Graph Connector for Active Directory  from the list to change the application 
scope so you can edit the form.
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As you progress through the Guided Setup, follow any instructions you see at the top of the 
pages in for modifying the application scope so you can open, edit, and save the record.

8. Enter a threshold in the Value  field.
The default value is 90 days. Before you modify this value, refer to the information about the 
threshold setting at the top of the page. With this setting, assets that match the day threshold 
value are excluded from import.

9. Right-click in the gray header titled System Property sn_sec_sgc_ad.inactive_threshold of the 
record and select Save.

10. Select Mark as complete  followed by Continue.
The LDAP OU Definition Access record is displayed.

11. Update LDAP OU Definition Access.

a. Follow the steps listed at the top of the page and on the LDAP OU Definition record to verify 
or switch the application scope to 'Global' with the application picker.

b. Select the LDAP OU Definition  record on the table to open it.

c. On the record, if not selected, select the Application Access  tab.

d. If displayed, select the link to edit the record followed by the check boxes for the permission 
settings you want.

e. Right-click in the gray header of the Table LDAP OU Definition record and select Save.

f. Select Mark as complete  followed by Continue.
The Configure LDAP Server Details page is displayed.

12. Provide the details for LDAP server connection.

a. Verify values or fill in the fields.

Field Value

Name Read-only: Unique name for the LDAP server 
for example SGC-AD-computer.

Application Read-only: Service Graph Connector for 
Active Directory (AD).

Active Check box selected.

Login distinguished name Login name for the AD server.

Login password Password for the AD server.

Starting search directory Directory you want to search for example 
DC=Ops.

(Optional) MID Server Dedicated MID Server for the connection, if 
available.
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Field Value

Note: 
A MID Server is required for on-
premise connections if the instance is 
not publicly accessible.

LDAP Server URLs Add the URL for the server for example 
ladp://host-name:389/.

b. Right-click in the gray header titled LDAP Server and select Save.

c. Select Mark as complete  followed by Continue.
The Test LDAP Server Connection page is displayed.

13. Test the LDAP Server Connection.

a. Scroll to the Related links section on the form and select the Test Connection  link
If the connection is successful, a Connected Successfully message is displayed. If your 
connection test fails, a message is displayed with information about why the connection 
failed. Review the Message field for how to proceed.

b. If you edit the record to fix the connection, right-click in the gray header titled LDAP Server 
and select Save.

c. Select Mark as complete  followed by Continue.
Add Multiple Instances is displayed in the top header the tasks.

Adding Multiple instances is optional. If you don’t want to add multiple instances, you can 
proceed to step 14 and the Set scheduled import jobs task.

14. Optional:  Add multiple instances.
To add multiple instances, you must update data source access. You must edit the permissions 
on the Datasource [sys_data_source] table to create a data source for the new connection in 
the Service Graph Connector for Active Directory.

15. Select Add Multiple Instances  from the top header drop down list.
The following tasks are displayed:

◦ Update Data Source Access

◦ Update Scheduled Data Import Access

◦ Add Another LDAP Server

◦ List of configured LDAP servers

16. Select Update Data Source Access.

a. Follow the steps listed at the top of the page to switch the application scope with the 
application picker to open, edit, and save the record.

b. Select the Data Import record from the list to open it.

c. With the Application Access  tab selected, follow the instructions to edit the record and 
modify the check boxes.
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d. Right-click in the gray header titled Table Data Source and select Save.

e. Select Mark as complete  followed by Continue.
The Update scheduled data import access page is displayed.

17. Update scheduled data import access.

a. Select the Scheduled Data Import  record from the list to open it.

b. Optional:  With the Application Access  tab selected, follow the instructions to edit the 
record and modify the check boxes.

c. Right-click in the gray header titled Table Scheduled Data Import and select Save.

d. Select Mark as complete  followed by Continue.
The Add Another LDAP Server page is displayed. There are two steps for this task:

◦ LDAP server configuration

◦ Basic LDAP server information

18. Provide LDAP server configuration information.

a. Fill out the fields.

Field Value

Type of LDAP server Active Directory

Server name Unique name of the LDAP server.

Server URL URL for example ldap://host-
name:389/.

Start search directory Directory you want to search for example 
DC=SecOps.

b. Select Submit.
After you submit these edits, complete the second configuration step.

c. Fill in the fields for the basic LDAP server information.

Field Value

Application Read-only Service Graph Connector for 
Active Directory.

Active Check box selected.

Login distinguished name Login name for the AD server.

Login password Password for the AD server.

Starting search directory Directory you want to search for example 
DC=SecOps.

MID Server Dedicated MID Server for the connection.
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Field Value

Note: 
A MID Server is not required for the 
LDAP server.

d. Right-click in the gray header titled LDAP Server and select Save.

e. Select Mark as complete  followed by Continue.
The List of configured LADP server page is displayed.

f. Select your new record from the list to open it and test the connection.

g. Optional:  Edit information on the form.

h. When you are satisfied with the information, scroll to the Related links and select the Test 
Connection  link.
If the connection is successful, a message is displayed. If your connection test fails, review 
the Message and Suggestion fields for how to proceed.

i. After a successful connection, right-click in the gray header titled LDAP Server and select 
Save.

j. Select Mark as complete  followed by Continue.

19. To set up scheduled jobs, select Set up scheduled import jobs  from the drop down list in the 
top header.
You must activate a scheduled job from the configuration page.

a. On the Configure the scheduled jobs page, select a record from the Scheduled Data Imports 
list to open it.

b. Select the Active  check box and fill in the fields.

Field Value

Name Unique name for the LDAP server, SGC-AD-
computer.

Application Read-only Service Graph Connector for 
Active Directory (AD).

Run How often you want the job to run. If you 
want to run a test import prior to scheduling 
it, you might prefer to set this to Once.

Run as Run the scheduled job with the credentials 
of another specified user.

Time When you want the job to run.

Active Select the check box.
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Field Value

Conditional Specific conditions under which this job is 
run.

Use connection Leave this deactivated for the first run. 
Specifies another connection and 
credentials for this job.

Concurrent import Leave activated. Splits data into multiple 
imports sets. See the message for more 
information.

Partition Method Leave as Custom size.

Partition size 15,000. Import set size for early scheduling.

Execute pre-import script Leave activated. Specifies a script to run 
before the import is performed.

Execute post-import script Leave activated. Specifies a script to run 
after the import is performed.

c. Optional:  Select Execute now  to run the job.
If you do not choose to run the job on-demand, the next job runs according to the schedule 
you set.

d. Right-click in the gray Scheduled Data Imports header and select Save.

e. Select Mark as complete  followed by Continue.

20. On the Home page for Guided Setup, select Complete  to finish the configuration.

CMDB classes targeted in Service Graph Connector for Active Directory

When you complete the guided setup, you can configure the integration to periodically pull data. 
The data is saved in tables that extend from the Configuration item [cmdb_ci] table.

Computer [cmdb_ci_computer]

The following attributes in the Computer [cmdb_ci_computer] table are populated by collected 
data.

Attribute label Attribute name

Name name

Category category

Object ID object_id

Fully qualified domain name fqdn

Checked out check_out

Check in check_in

First discovered first_discovered

Operating System os
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Attribute label Attribute name

OS Version os_version

Software [cmdb_ci_spkg]

The following attributes in the Software [cmdb_ci_spkg] table are populated by collected data.

Attribute label Attribute name

Name name

Key key

Version version

Software Instance [cmdb_software_instance]

The following attributes in the Software Instance [cmdb_software_instance] table are populated 
by collected data.

Attribute label Attribute name

Name name

Install On installed_on

Product Name software

Software Installation [cmdb_sam_sw_install]

The following attributes in the Software Installation [cmdb_sam_sw_install] table are populated 
by collected data.

Attribute label Attribute name

Display Name display_name

Version version

Discovery source discovery_source

SGC Active Directory Computer [sn_sec_sgc_ad_active_directory_computer]

The following attributes in the SGC Active Directory Computer 
[sn_sec_sgc_ad_active_directory_computer] table are populated by collected data.

Attribute label Attribute name

Account expires account_expires

Bad password count bad_pwd_count

Bad password time bad_password_time

Code page code_page

Common name cn
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Attribute label Attribute name

Country code country_code

Description description

Display name display_name

Distinguished name distinguished_name

DN dn

Dscorepropagation data dscore_propagation_data

Instance type instance_type

Iscritical system object iscritical_system_object

Keywords keywords

Last logon last_logon

Local policy flags local_policy_flags

Logon count logon_count

Member of member_of

Ms-DS-Host service account msds_host_service_account

Ms-DS-Supported encryption types msds_support_ncryptiontypes

Name name

Object class object_class

Object GUID object_guid

Other well known objects other_well_known_objects

Password last set pwd_last_set

Primary group id primary_groupid

SamAccount name sam_account_name

SamAccount type sam_account_type

Service binding information service_binding_information

Service class name service_class_name

Service DNS name service_dns_name

Service DNS name type service_dns_name_type

Service principal name service_principal_name

Show in advanced view only show_in_advanced_view_only

Source source

User account control user_account_control

USN changed usn_changed

USN created usn_created

When changed when_changed
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Service Graph Connector for AWS

Use the Service Graph Connector for AWS  to securely bring in Amazon Web Services  (AWS) data 
into your ServiceNow  instance.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

The integration uses AWS  native technologies and AWS  security best practices to enable cloud 
teams to connect the data within their ServiceNow  workflow. For more information about the 
Service Graph Connector for AWS, see the Service Graph Connector for AWS - Introduction
article on the ServiceNow Community  site.

Supported ServiceNow  versions

• Washington DC

• Xanadu

• Yokohama

• Zurich

Use cases

The following are examples on how you can use the Service Graph Connector  for different 
ServiceNow  applications:

• Visibility into cloud resources, relationships, and state in real time.

• Deep discovery of applications for ITAM or SAM outcomes.

• Governance and compliance outcome.

Important information for upgrading Service Graph Connector for AWS

Before you begin the upgrade process, complete the following tasks:

• If there are any customizations, delete the records associated with the Service Graph 
Connector for AWS  from the Customer Updates [sys_update_xml] table. See Customer 
Updates table .

• Upgrade any dependencies.

After you've installed the latest version of the Service Graph Connector for AWS:

• Perform a full import of data from your AWS  instance. Verify that the Use last run datetime  field 
value is cleared for all the AWS  data sources in the Data Source [sys_data_source] table.

• Download and rerun the AWS  scripts. See Configure the AWS environment.

Configuring a connection for the connector

You can configure a connection for the connector by using the SGC Central  view in the CMDB 
Workspace. The view enables you to discover and install connectors, and then effectively 
manage the full life cycle of creating, editing, monitoring, and debugging connections. To 
configure the connector using SGC Central, see Configure Service Graph Connector for AWS 
using SGC Central.
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Important: 
Unless there are configuration issues, use the SGC Central  view in the CMDB Workspace 
to configure the connection for the connector, as the guided setup method is being 
deprecated.

CMDB integrations dashboard

The Integration Commons for CMDB  store app provides a dashboard with a central view of the 
status, processing results, and processing errors of all installed integrations. You can see metrics 
for all integration runs. You can filter the view to a specific CMDB  integration, a specific time 
duration, or a specific integration run. For more details about monitoring AWS  integrations in the 
CMDB  Integrations Dashboard, see Using the CMDB Integrations Dashboard.

Data mapping

Data from the AWS  data sources is mapped and transformed into the ServiceNow  CMDB 
Configuration Item (CI) class definitions using the Robust Transform Engine (RTE). Data is 
inserted into the ServiceNow  CMDB  using the Identification and Reconciliation Engine (IRE).

Note: 
If the Use last run datetime  field for an AWS  data source in the Data Source 
[sys_data_source] table is empty, the connector imports all available initial data. If the Use 
last run datetime  field includes a date stamp, the connector imports incremental data that 
has been newly added since the previous run.

The following table lists the import schedule order, the data sources and import schedules of 
the same name, the staging tables, the target tables as CMDB  CI classes, the import schedule 
requirement type, and the import schedule dependencies for AWS.

Data mapping for AWS

Order

Name

(data source or 
import schedule)

Staging table CMDB  CI classes

Import 
schedule 
requirement 
type

Import 
schedule 
dependencies

1 SG-AWS-
Organization

SG-AWS-Organization 
[sn_aws_integ_sg_aws_organization] Cloud Organizations Required None

2 SG-AWS-Org-
Units

SG-AWS-Org-Units 
[sn_aws_integ_sg_aws_org_units] AWS Organizational Unit Optional SG-AWS-

Organization

3 SG-AWS-
Service-
Account

SG-AWS-Service-Account 
[sn_aws_integ_sg_aws_service_account] Cloud Service Account

Cloud Organizations

Key Value

Required SG-AWS-
Organization

4 SG-AWS-
Service-
Account-Tags

SG-AWS-Service-Account-Tags 
[sn_aws_integ_sg_aws_service_account_tags] Cloud Service Account

Key Value

Optional SG-AWS-
Organization

SG-AWS-
Service-
Account
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Data mapping for AWS  (continued)

Order

Name

(data source or 
import schedule)

Staging table CMDB  CI classes

Import 
schedule 
requirement 
type

Import 
schedule 
dependencies

5 SG-AWS-Org-
Unit-Accounts

SG-AWS-Org-Unit-Accounts 
[sn_aws_integ_sg_aws_org_unit_accounts] Cloud Service Account Optional SG-AWS-

Organization

SG-AWS-
Service-
Account

6 SG-AWS-
Datacenters

SG-AWS-Datacenters 
[sn_aws_integ_sg_aws_datacenters] Cloud Service Account

AWS Datacenter

Required SG-AWS-
Organization

SG-AWS-
Service-
Account

7 SG-AWS-VPC SG-AWS-VPC [sn_aws_integ_sg_aws_vpc]
Cloud Service Account

Cloud Network

AWS Datacenter

Key Value

SG-AWS Extension 
Attributes

Required SG-AWS-
Organization

SG-AWS-
Service-
Account

SG-AWS-
Datacenters

8 SG-AWS-
Subnets

SG-AWS-Subnets 
[sn_aws_integ_sg_aws_subnets] Availability Zone

Cloud Network

Cloud Subnet

AWS Datacenter

Key Value

SG-AWS Extension 
Attributes

Required SG-AWS-
Organization

SG-AWS-
Service-
Account

SG-AWS-
Datacenters

SG-AWS-VPC

9 SG-AWS-
Network-
Interface

SG-AWS-Network-Interface 
[sn_aws_integ_sg_aws_network_interface] Cloud Network

Cloud Subnet

Cloud Mgmt Network 
Interface

AWS Datacenter

Key Value

Required 
for a virtual 
machine 
(VM) 
instance

SG-AWS-
Organization

SG-AWS-
Service-
Account

SG-AWS-
Datacenters
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Data mapping for AWS  (continued)

Order

Name

(data source or 
import schedule)

Staging table CMDB  CI classes

Import 
schedule 
requirement 
type

Import 
schedule 
dependencies

SG-AWS Extension 
Attributes

SG-AWS-VPC

10 SG-AWS-
Security-Group

SG-AWS-Security-Group 
[sn_aws_integ_sg_aws_security_group] Cloud Network

Compute Security Group

AWS Datacenter

Key Value

SG-AWS Extension 
Attributes

Required 
for a VM 
instance

SG-AWS-
Organization

SG-AWS-
Service-
Account

SG-AWS-
Datacenters

SG-AWS-VPC

11 SG-AWS-
Storage-
Volume

SG-AWS-Storage-Volume 
[sn_aws_integ_sg_aws_storage_volume]

Storage Volume

Storage Volume 
Snapshot

AWS Datacenter

Key Value

SG-AWS Extension 
Attributes

Required 
for a VM 
instance

SG-AWS-
Organization

SG-AWS-
Service-
Account

SG-AWS-
Datacenters

SG-AWS-VPC

12 SG-AWS-
Image-Private

SG-AWS-Image [sn_aws_integ_sg_aws_image]
Image Required 

for a VM 
instance

SG-AWS-
Organization

SG-AWS-
Service-
Account

SG-AWS-
Datacenters

SG-AWS-VPC

13 SG-AWS-
Image-Id

SG-AWS-Image-Id 
[sn_aws_integ_sg_aws_image_id] Image Required 

for a VM 
instance

SG-AWS-
Organization

SG-AWS-
Service-
Account

SG-AWS-
Datacenters
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Data mapping for AWS  (continued)

Order

Name

(data source or 
import schedule)

Staging table CMDB  CI classes

Import 
schedule 
requirement 
type

Import 
schedule 
dependencies

SG-AWS-VPC

14 SG-AWS-
Hardware-Type

SG-AWS-Hardware-Type 
[sn_aws_integ_sg_aws_hardware_type] Hardware Type

AWS Datacenter

Required 
for a VM 
instance

SG-AWS-
Organization

SG-AWS-
Service-
Account

SG-AWS-
Datacenters

SG-AWS-VPC

15 SG-AWS-EC2 SG-AWS-EC2 [sn_aws_integ_sg_aws_ec2]
Virtual Machine Instance

The following CIs 
are populated when 
populating the Virtual 
Machine Instance CI:

Server

VNIC Endpoint

Storage Mapping

Block Endpoint

IP Address

Network Adapter

Key Value

Optional SG-AWS-
Organization

SG-AWS-
Service-
Account

SG-AWS-
Datacenters

SG-AWS-VPC

SG-AWS-
Subnets

SG-AWS-
Network-
Interface

SG-AWS-
Hardware-
Type

SG-AWS-
Security-
Group

SG-AWS-
Storage-
Volume

SG-AWS-
Image-Private

SG-AWS-
Image-Id
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Data mapping for AWS  (continued)

Order

Name

(data source or 
import schedule)

Staging table CMDB  CI classes

Import 
schedule 
requirement 
type

Import 
schedule 
dependencies

16 SG-AWS-ELB-
V1

SG-AWS-ELB-V1 [sn_aws_integ_sg_aws_elb_v1]
Cloud Load Balancer

Compute Security Group

Availability Zone

AWS Datacenter

Key Value

SG-AWS Extension 
Attributes

Optional SG-AWS-
Organization

SG-AWS-
Service-
Account

SG-AWS-
Datacenters

17 SG-AWS-ELB-
V2

SG-AWS-ELB-V2 
[sn_aws_integ_sg_aws_elb_v2] Cloud Load Balancer

Compute Security Group

Availability Zone

AWS Datacenter

Key Value

SG-AWS Extension 
Attributes

Optional SG-AWS-
Organization

SG-AWS-
Service-
Account

SG-AWS-
Datacenters

18 SG-AWS-RDS SG-AWS-RDS [sn_aws_integ_sg_aws_rds]
Cloud DataBase

AWS Datacenter

Key Value

SG-AWS Extension 
Attributes

Optional SG-AWS-
Organization

SG-AWS-
Service-
Account

SG-AWS-
Datacenters

19 SG-AWS-API-
Gateway

SG-AWS-API-Gateway 
[sn_aws_integ_sg_aws_api_gateway] Cloud Gateway 

[cmdb_ci_cloud_gateway]

AWS Datacenter

Key Value

SG-AWS Extension 
Attributes

Optional SG-AWS-
Organization

SG-AWS-
Service-
Account

SG-AWS-
Datacenters

20 SG-AWS-
Lambda

SG-AWS-Lambda 
[sn_aws_integ_sg_aws_lambda] Cloud Function Optional SG-AWS-

Organization
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Data mapping for AWS  (continued)

Order

Name

(data source or 
import schedule)

Staging table CMDB  CI classes

Import 
schedule 
requirement 
type

Import 
schedule 
dependencies

SG-AWS-
Service-
Account

SG-AWS-
Datacenters

21 SG-AWS-S3 SG-AWS-S3 [sn_aws_integ_sg_aws_s3]
Cloud Object Storage Optional SG-AWS-

Organization

SG-AWS-
Service-
Account

SG-AWS-
Datacenters

22 SG-AWS-
DynamoDb

SG-AWS-DynamoDb 
[sn_aws_integ_sg_aws_dynamodb] DynamoDB Table

AWS Datacenter

Key Value

SG-AWS Extension 
Attributes

Optional SG-AWS-
Organization

SG-AWS-
Service-
Account

SG-AWS-
Datacenters

23 SG-AWS-
Software-
Inventory

SG-AWS-Software-Inventory 
[sn_aws_integ_sg_aws_software_inventory]

SG-AWS-Software-Staging 
[sn_aws_integ_sg_aws_temp_software_staging]

When the Software Asset 
Management (SAM) 
application isn't installed:

Software Packages

Software Instance

Server

When the SAM 
application is installed:

Software Installation

Server

Optional SG-AWS-
Organization

SG-AWS-
Service-
Account

SG-AWS-
Datacenters

SG-AWS-VPC

SG-AWS-
Subnets

SG-AWS-
Network-
Interface

SG-AWS-
Hardware-
Type
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Data mapping for AWS  (continued)

Order

Name

(data source or 
import schedule)

Staging table CMDB  CI classes

Import 
schedule 
requirement 
type

Import 
schedule 
dependencies

SG-AWS-
Security-
Group

SG-AWS-
Storage-
Volume

SG-AWS-
Image-Private

SG-AWS-
Image-Id

SG-AWS-EC2

24 SG-AWS-
Software-
Remove

SG-AWS-Software-Remove 
[sn_aws_integ_sg_aws_software_remove] None Optional SG-AWS-

Organization

SG-AWS-
Service-
Account

SG-AWS-
Datacenters

SG-AWS-VPC

SG-AWS-
Subnets

SG-AWS-
Network-
Interface

SG-AWS-
Hardware-
Type

SG-AWS-
Security-
Group

SG-AWS-
Storage-
Volume

SG-AWS-
Image-Private

SG-AWS-
Image-Id
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Data mapping for AWS  (continued)

Order

Name

(data source or 
import schedule)

Staging table CMDB  CI classes

Import 
schedule 
requirement 
type

Import 
schedule 
dependencies

SG-AWS-EC2

SG-AWS-
Software-
Inventory

25 SG-AWS-SSM-
SendCommand

SG-AWS-SSM-SendCommand 
[sn_aws_integ_sg_aws_ssm_sendcommand] Application

Running Process

TCP Connections

Optional SG-AWS-
Organization

SG-AWS-
Service-
Account

SG-AWS-
Datacenters

SG-AWS-VPC

SG-AWS-
Subnets

SG-AWS-
Network-
Interface

SG-AWS-
Security-
Group

SG-AWS-
Storage-
Volume

SG-AWS-
Image-Private

SG-AWS-
Image-Id

SG-AWS-EC2

26 SG-AWS-Tags SG-AWS-Tags [sn_aws_integ_sg_aws_tags]
DynamoDB Table

Cloud Load Balancer

Cloud Function

Key Value

Optional SG-AWS-
Organization

SG-AWS-
Service-
Account

SG-AWS-
Datacenters
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Data mapping for AWS  (continued)

Order

Name

(data source or 
import schedule)

Staging table CMDB  CI classes

Import 
schedule 
requirement 
type

Import 
schedule 
dependencies

SG-AWS-
ELB-V1

SG-AWS-
ELB-V2

SG-AWS-
DynamoDb

SG-AWS-
Lambda

27 SG-AWS-
VM-Hw-
Consolidation

SG-AWS-VM-Hw-Consolidation 
[sn_aws_integ_sg_aws_vm_hw_consolidation] Virtual Machine Instance

Server

Optional SG-AWS-
Organization

SG-AWS-
Service-
Account

SG-AWS-
Datacenters

SG-AWS-VPC

SG-AWS-
Subnets

SG-AWS-
Network-
Interface

SG-AWS-
Security-
Group

SG-AWS-
Storage-
Volume

SG-AWS-
Image-Private

SG-AWS-
Image-Id

SG-AWS-EC2

SG-AWS-
Hardware-
Type
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Data mapping for AWS  (continued)

Order

Name

(data source or 
import schedule)

Staging table CMDB  CI classes

Import 
schedule 
requirement 
type

Import 
schedule 
dependencies

28 SG-AWS-EKS-
Cluster

SG-AWS-EKS-Cluster 
[sn_aws_integ_sg_aws_eks_cluster] Kubernetes Cluster

AWS Datacenter

Key Value

SG-AWS Extension 
Attributes

Optional SG-AWS-
Organization

SG-AWS-
Service-
Account

SG-AWS-
Datacenters

SG-AWS-VPC

SG-AWS-
Subnets

SG-AWS-
Network-
Interface

SG-AWS-
Security-
Group

SG-AWS-
Storage-
Volume

SG-AWS-
Image-Private

SG-AWS-
Image-Id

SG-AWS-EC2

SG-AWS-
Hardware-
Type

SG-AWS-
VM-Hw-
Consolidation

29 SG-AWS-EKS-
Cluster-2

SG-AWS-EKS-Cluster-2 
[sn_aws_integ_sg_aws_eks_cluster_2] Kubernetes Cluster

AWS Datacenter

Key Value

Optional SG-AWS-
Organization

SG-AWS-
Service-
Account
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Data mapping for AWS  (continued)

Order

Name

(data source or 
import schedule)

Staging table CMDB  CI classes

Import 
schedule 
requirement 
type

Import 
schedule 
dependencies

SG-AWS Extension 
Attributes

SG-AWS-
Datacenters

SG-AWS-VPC

SG-AWS-
Subnets

SG-AWS-
Network-
Interface

SG-AWS-
Security-
Group

SG-AWS-
Storage-
Volume

SG-AWS-
Image-Private

SG-AWS-
Image-Id

SG-AWS-EC2

SG-AWS-
Hardware-
Type

SG-AWS-
VM-Hw-
Consolidation

SG-AWS-
EKS-Cluster

30 SG-AWS-EKS-
FULL

SG-AWS-EKS-FULL 
[sn_aws_integ_sg_aws_eks_full] Kubernetes Cluster

Server

Kubernetes Namespace

Kubernetes Node

Kubernetes Service

Kubernetes Pod

Docker Container

Optional SG-AWS-
Organization

SG-AWS-
Service-
Account

SG-AWS-
Datacenters

SG-AWS-VPC
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Data mapping for AWS  (continued)

Order

Name

(data source or 
import schedule)

Staging table CMDB  CI classes

Import 
schedule 
requirement 
type

Import 
schedule 
dependencies

Docker Image

Kubernetes Volume

Kubernetes Deployment

Kubernetes DaemonSet

Kubernetes ReplicaSet

SG-AWS-
Subnets

SG-AWS-
Network-
Interface

SG-AWS-
Security-
Group

SG-AWS-
Storage-
Volume

SG-AWS-
Image-Private

SG-AWS-
Image-Id

SG-AWS-EC2

SG-AWS-
Hardware-
Type

SG-AWS-
VM-Hw-
Consolidation

SG-AWS-
EKS-Cluster

SG-AWS-
EKS-Cluster-2

31 SG-AWS-
Generic-
Resources

SG-AWS-Generic-Resources 
[sn_aws_integ_sg_aws_generic_resources] Cloud Resource

SG-AWS Extension 
Attributes

Optional SG-AWS-
Organization

32 SG-AWS-
Redshift-
Cluster

SG-AWS-Redshift-Cluster 
[sn_aws_integ_sg_aws_redshift_cluster] Amazon Redshift Optional SG-AWS-

Organization

SG-AWS-
Service-
Account
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Data mapping for AWS  (continued)

Order

Name

(data source or 
import schedule)

Staging table CMDB  CI classes

Import 
schedule 
requirement 
type

Import 
schedule 
dependencies

SG-AWS-
Datacenters

33 SG-AWS-Get-
Inventory

SG-AWS-Get-Inventory 
[sn_aws_integ_sg_aws_get_inventory] Server Required SG-AWS-

Organization

SG-AWS-
Service-
Account

SG-AWS-
Datacenters

34 SG-AWS-
GenericTags

SG-AWS-GenericTags 
[sn_aws_integ_sg_aws_generictags] Cloud Resource

Key Value

Optional
SG-AWS-
Organization

SG-AWS-
Generic-
Resources
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Note: 

• The SG-AWS-Generic-Resources data source imports data for generic resources that 
aren't tracked by other data sources. The connector utilizes the Service Graph Resource 
Inclusion Whitelist [sn_cmdb_int_util_service_graph_resource_inclusion_whitelist] table 
to differentiate between generic and other supported resource types.

The connector first populates all supported resources in the Service Graph Resource 
Inclusion Whitelist [sn_cmdb_int_util_service_graph_resource_inclusion_whitelist] 
table. These resources, categorized under their respective supported resource types, 
have specific data sources designated for ingestion within the connector. When the 
SG-AWS-Generic-Resources data source is executed and retrieves unsupported 
resource types, they are added to the Service Graph Resource Inclusion Whitelist 
[sn_cmdb_int_util_service_graph_resource_inclusion_whitelist] table and categorized as 
generic.

• To import global generic resources such as IAM user and IAM group, 
specify a standard AWS region that has Config  enabled with 
includeGlobalResourceTypes  set to true  by updating the value of the 
sn_aws_integ.global_generic_resource_region  system property for the 
SG-AWS-Generic-Resources data source.

If an aggregator is configured, and the 
sn_aws_integ.global_generic_resource_region  value is not specified, the 
aggregator region is assigned as the value of this system property for importing global 
generic resources.

• If the AWS  Systems Manager (SSM) service isn't enabled, the connector populates 
the server records in the Server [cmdb_ci_server] class. If the AWS  SSM service is 
enabled, then based on the platform type obtained through the SSM service, the server 
records are populated in either the Linux Server [cmdb_ci_linux_server] class or the 
Windows Server [cmdb_ci_win_server] class. The Server [cmdb_ci_server] class is 
the parent class of the Linux Server [cmdb_ci_linux_server] and the Windows Server 
[cmdb_ci_win_server] classes.

• All labels associated with an AWS  resource are added to the Key Value [cmdb_key_value] 
table.

Note: 
You can use the CMDB  Data Manager  to delete tag data from retired CIs in the Key 
Value [cmdb_key_value] table based on conditions like retention time and discovery 
source. A scheduled job runs the policy, which can be configured to execute during 
off-peak hours.

• The basic information about a GCP  resource is stored in the SG-AWS Extension 
Attributes [sn_aws_extension_attributes] table.

• Starting with the Service Graph Connector for AWS  2.10.0 version, the SG-AWS-Get-
Inventory data source runs before the SG-AWS-EC2 data source and creates a Server 
[cmdb_ci_server] CI with the host name mapped to the Name attribute, instead of being 
mapped to the VM name.

• The SG-AWS-GenericTags data source imports tag data only for generic 
resources that have an ARN key. You can use the SG-AWS Extension Attributes 
[sn_aws_extension_attributes] table to verify which generic resources have an ARN key.

For more information on where data is saved when pulling data from AWS, see CMDB classes 
targeted in Service Graph Connector for AWS  and Supported AWS resource types.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

902



When you run the diagnostic test, the data is loaded in the following tables:

• SG AWS Diagnostic Details [sn_aws_integ_sg_aws_diagnostic_details]

• SG-AWS Diagnostic Summary [sn_aws_integ_sg_aws_diagnostic_summary]

• SG AWS Diagnostic Summary Notes [sn_aws_integ_sg_aws_diagnostic_summary_notes]

You can use the IntegrationHub ETL app to view the data maps. See IntegrationHub ETL  for more 
information.

The AWS  configuration data for each connection is stored in the SG AWS Application properties 
[sn_aws_integ_sg_aws_application_properties] table.

For more information about how CI information is pulled from AWS, see the Service Graph 
Connector for AWS - Functional Spec and CI  article on the ServiceNow Community  site.

BYOL support

Bringing your own licenses (BYOL) is the process of bringing previously purchased on-premises 
licenses to Amazon AWS Cloud. The connector supports the BYOL of the Image CIs for Oracle 
Database servers on Amazon AWS Cloud  by populating the Key Value [cmdb_key_value] 
table with the licensing information. When the licensing information is found, the key is set to 
Windows_OS_License_Type_automatic  and the key value is set to BYOL  in the Key 
Value [cmdb_key_value] table.

To support BYOL, the sn_aws_integ.load_all_images  system property is enabled 
during the initial pull to import the metadata of all Image CIs included in the SG-AWS-Image-Id 
data source. After the initial pull, the property is deactivated automatically. The SG-AWS-Image-Id 
data source then imports the metadata of the Image CIs without names only.

Managing retired CIs in EKS components

If the Amazon Elastic Kubernetes Services (EKS) CIs are deleted in EKS components such as 
pods, services, and volumes, the corresponding CI entries are automatically set to Retired  in the 
following CMDB  CI classes:

Kubernetes Cluster, Kubernetes Node, Kubernetes Pod, Kubernetes Service, Kubernetes 
DaemonSet Kubernetes Namespace, Kubernetes Deployment, Docker Container, Kubernetes 
Volume

Shared VPC and subnets support

Import CI relationships established between virtual private clouds (VPCs), subnets, and network 
interfaces hosted in different AWS  accounts. For example, a VPC in one AWS  account can be 
connected to a subnet in the same account, which can then link to a network interface and a 
virtual machine in another AWS  account.

Additional resources

See the following articles on the ServiceNow Community  site for any additional information on 
the AWS  set up:

• Service Graph Connector for AWS - Introduction

• How do I configure the AWS Service Graph Connector?

• Service Graph Connector for AWS - Diagnostic Tool & Troubleshooting Issues
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• Service Graph Connector for AWS - Functional Spec and CI

• Cloud Discovery and SG-AWS

Related content

Service Graph Connectors

Enable optimized deletion of retired CIs in AWS

Enable optimized SG-AWS-SendCommand data source performance

Handling import failures for large AWS resources

Handling memory utilization errors for Service Graph Connector for AWS

Life cycle management of records in Service Graph Connector for AWS

Record removal process in Service Graph Connector for AWS

Configure the AWS  environment for the Service Graph Connector for AWS

Configure your Amazon Web Services  (AWS) environment to import data using the Service 
Graph Connector for AWS.

Before you begin
Install the Service Graph Connector for AWS  application (sn_aws_integ). For more information, 
see Install a ServiceNow Store application .

Role required: application administrator

Procedure

1. Learn about the AWS  resources used by the connector.
Get familiar with the AWS  concepts to learn how the Service Graph Connector for AWS  is 
integrated with AWS.

2. Download the AWS scripts.
Download the AWS  scripts included within the guided setup of the Service Graph Connector 
for AWS.

3. Review the requirements before executing the AWS  scripts.
Complete the prerequisites before you execute the AWS  scripts.

4. Execute the AWS scripts.
Execute scripts provided with the Service Graph Connector for AWS  to set up the AWS 
environment for importing data.

AWS  resources used by the Service Graph Connector for AWS

Get familiar with the AWS  concepts to learn how the Service Graph Connector for AWS  is 
integrated with Amazon Web Services  (AWS).

AWS  Config  service and configuration recorder

Important: 
The AWS  Config  service and AWS  configuration recorder  are required for setting up the 
connector.

The AWS  Config  service monitors and records changes to your AWS  resource configurations.
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The AWS  configuration recorder  detects changes in resource configurations and captures 
these changes as configuration items (CIs). The is required for setting up the connector. The 
configuration recorder  enables recording all hardware data in AWS  Config. See What Is AWS 
Config?  on the AWS  Documentation site.

The Service Graph Connector for AWS  includes the EnableAWSConfig.yml  script to enable 
the AWS  Config  service that instead enables the configuration recorder. See Executing scripts 
required for setting up AWS.

Note: 
Ensure that the AWS  Config  service is enabled for all applicable AWS  accounts and 
regions.

AWS  Config  aggregator

Important: 
The AWS  Config  aggregator is optional for setting up the connector.

The AWS  Config  aggregator collects the AWS  Config  configuration and compliance data from the 
following sources:

• Multiple accounts and multiple regions

• Single account and multiple regions

• An organization in AWS  organizations and all the accounts within the organization that have 
AWS  Config  enabled.

The advantages of using an AWS  Config  aggregator with the Service Graph Connector for AWS 
are:

• Gets all the data from a single location.

• Gets the bootstrap updates (baseline configurations) and the incremental updates (new 
configurations added after the last update).

• Doesn't require looping into each account and region.

• Accelerates pulling data.

Due to these advantages, consider leveraging the AWS  Config  aggregator for pulling data from 
multiple accounts or multiple regions.

Note: 
For detecting any deleted resources, the connector uses the 
config:ListDiscoveredResources  API to loop through each AWS  account and 
region and update the CMDB  CI accordingly. As a date range for selecting resources 
can't be specified in the ListDiscoveredResources  API, the connector might make 
multiple API calls to gather all the data that might impact the performance of the connector.

For more information on setting up an AWS  Config  aggregator, see Multi-Account Multi-
Region Data Aggregation  and Setting Up an Aggregator Using the Console  on the AWS 
Documentation site.

AWS  Systems Manager  and AWS  Systems Manager Inventory

Important: 
AWS  Systems Managerand AWS  Systems Manager Inventory  are required for setting up the 
deep discovery feature.
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The AWS  Systems Manager  enables fetching server data, also called as deep discovery data, 
from EC2 instances across AWS accounts and regions through SSM documents. The deep 
discovery data includes host name, serial number, CPU data, TCP data, and process information.

The AWS  Systems Manager Inventory  imports the software data installed on the EC2 instances. 
The Inventory resource group in AWS  Systems Manager  collects information about the EC2 
instances and the software applications installed on them.

Ensure that the following items are configured in all AWS  accounts:

• The AWS  Systems Manager Agent (SSM Agent)  is installed on all managed EC2 instances.

• The AmazonSSMForInstancesRole IAM instance profile role is attached as the instance profile 
on EC2 instances.

• The AWS  Systems Manager Inventory  is configured in each AWS  region.

• The AWS  Systems Manager  has access to the managed EC2 instances.

Note: 
By default, AWS  Systems Manager  doesn’t have permission to perform actions on EC2 
instances. You can grant access by attaching the AmazonSSMForInstancesRole IAM 
instance profile role to the EC2 instance. See Setting up AWS Systems Manager  on the 
AWS  Documentation site.

The advantages of using AWS  Systems Manager  and AWS  Systems Manager Inventory  are:

• The AWS  Systems Manager  enables getting the detailed server data such as host name, serial 
number, CPU data, TCP data, and process information.

• The AWS  Systems Manager Inventory  enables the server classification and getting the 
software data.

Download the AWS  scripts

Download the AWS  scripts included within the guided setup of the Service Graph Connector for 
AWS.

Before you begin

• Ensure that you have installed the Service Graph Connector for AWS  application 
(sn_aws_integ). For more information, see Install a ServiceNow Store application .

• Ensure that you’ve selected the Service Graph Connector for AWS  application scope by using 
the application picker. See Application picker .

Role required: admin

Procedure

1. Navigate to All  > Service Graph Connector for AWS  > Setup.

2. On the Getting started page, select Get Started.

3. In the Configure the AWS environment  section of the Service Graph Connector for AWS  page, 
select Get Started.

4. For the Download the scripts task, select Configure.

5. When you download all the scripts onto your local machine, select Close  to close the 
Download the scripts dialog box and return to the guided setup.

6. Set the Download the scripts task to complete by selecting Mark as Complete.
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Prerequisites for executing scripts

Complete the prerequisites before you execute the AWS  scripts.

Important: 
Ensure that you have downloaded the scripts available within the Service Graph Connector 
for AWS. See Download the AWS scripts.

Decide the following details to be used later during the execution of the AWS  scripts:

• ServiceNow  IAM role

• ServiceNow  IAM username

• S3 bucket for the ServiceNow  IAM role

Note: 
Define an S3 bucket only when you are using deep discovery scripts.

Determine the ServiceNow  IAM role

Determine the identity and access management (IAM) role that performs read-only operations in 
member accounts to fetch the configuration items (CIs) from the AWS  environment.

By default, the 
CreateSnowOrganizationAccountAccessRoleInMemberAccount.yml  script 
creates the SnowOrganizationAccountAccessRole IAM role. You can use the default name 
created by the script or create a new IAM role. However, when required as an input parameter, 
you must enter the same IAM role across scripts. See Executing scripts required for setting up 
AWS.

Determine the ServiceNow  IAM username

Determine the name of the IAM user that assumes the ServiceNow  IAM role in the member 
accounts.

By default, the CreateServiceNowUser.yml  script creates the NOWSGCUser IAM user. 
You can use the default name created by the script or create a new IAM user. However, when 
required as an input parameter, you must enter the same IAM username across scripts. See 
Executing scripts required for setting up AWS.

Define the S3 bucket for deep discovery

Set up an S3 bucket with read and delete privileges for the ServiceNow  IAM role to store and 
delete the SendCommand  API responses when importing AWS  data.

Before you begin
Role required: Application administrator

About this task
Create an S3 bucket for the Service Graph Connector for AWS  application and enable the 
ServiceNow  IAM role  to have access to this bucket in the organization.

Note: 
Use an S3 bucket only when you want to perform deep discovery on EC2 instances.

Procedure

1. Create an S3 bucket in an AWS  account region.
See Creating a bucket  on the AWS  documentation site.
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Note: 
The S3 bucket must have the following permission settings.

S3 bucket permissions and their settings

Permission Setting

Access Bucket and objects not public

S3 Block Public Access Block public access to S3 buckets and objects

For more information, see S3 Block Public Access  on the AWS  documentation site.

2. Add a bucket policy.

See Bucket policies  on the AWS  documentation site.

To access the S3 bucket you created in step 1, its bucket policy must allow the IAM instance 
profile role attached to the managed EC2 instances. You can either create a bucket policy 
or grant access to your AWS  member account  in the bucket access control list (ACL). The 
member account must include the EC2 instances.

Note: 
Adding an AWS  member account  to the bucket ACL allows all users and roles in the 
member account to access the S3 bucket.

Refer to the following sample code when adding a bucket policy.

{
    "Version": "2012-10-17",
    "Id": "S3PolicyforServiceNowIAMrole",
    "Statement": [
        {
            "Sid": "EC2S3Access",
            "Effect": "Allow",
            "Principal": {
                "AWS": 
 "arn:aws:iam::AWS-ACCOUNT:role/INSTANCE-PROFILE-ROLE-NAME"
            },
            "Action": [
                "s3:GetObject",
                "s3:PutObject",
                "s3:PutObjectAcl"
            ],
            "Resource": "arn:aws:s3:::DOC-EXAMPLE-BUCKET/*"
        }
    ]
}

Where

◦ SOURCE-AWS-ACCOUNT  is the AWS  account  ID of the member account that includes the 
EC2 instances.

◦ INSTANCE-PROFILE-ROLE-NAME  is the IAM instance profile that is attached to the EC2 
instances.

By default, the AmazonSSMForInstancesRoleSetup.yml  script creates the 
AmazonSSMForInstancesRole IAM instance profile role and attaches the role to the 
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AmazonSSMManagedInstanceCore bucket policy. See Executing scripts required for setting 
up AWS.

◦ DOC-EXAMPLE-BUCKET  is the S3 bucket name.

The following example bucket policy shows the effect, principal, action, and resource 
elements. The policy allows AmazonSSMRoleForInstances, an IAM instance profile 
role in an account with ID 123456789000, s3:GetObject, s3:PutObject, and 
s3:PutObjectAcl  S3 permissions on the myS3Bucket  bucket.

{
    "Version": "2012-10-17",
    "Id": "S3PolicyforServiceNowIAMrole",
    "Statement": [
        {
            "Sid": "EC2S3Access",
            "Effect": "Allow",
            "Principal": {
                "AWS": [
                   
 "arn:aws:iam::123456789000:role/AmazonSSMRoleForInstances",
                   
 "arn:aws:iam::123456789001:role/AmazonSSMRoleForInstances",
                   
 "arn:aws:iam::123456789002:role/AmazonSSMRoleForInstances",
                   
 "arn:aws:iam::123456789003:role/AmazonSSMRoleForInstances",
                   
 "arn:aws:iam::123456789004:role/AmazonSSMRoleForInstances"
                ]
            },
            "Action": [
                "s3:GetObject",
                "s3:PutObject",
                "s3:PutObjectAcl"
            ],
            "Resource": "arn:aws:s3:::myS3Bucket/*"
        }
    ]
}

3. Attach IAM permissions to the instance profile role for EC2 instances to publish the 
SendCommand  API responses to the S3 bucket you created in step 1.
See Using instance profiles  and Attach an IAM role to an instance  on the AWS 
documentation site.

The IAM instance profile role attached to the managed EC2 instances must have the 
s3:GetObject, s3:PutObject, and s3:PutObjectAcl  S3 permissions to allow 
access to the S3 bucket as shown in the following sample policy.

{
    "Version": "2012-10-17",
    "Statement": [
        {
        "Sid": "PublishTerminalOutputToS3",
            "Effect": "Allow",
            "Action": [
                "s3:PutObject",
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                "s3:GetObject",
                "s3:PutObjectAcl"
            ],
            "Resource": "arn:aws:s3:::DOC-EXAMPLE-BUCKET/*"
        }
    ]
}

Where, DOC-EXAMPLE-BUCKET  is the S3 bucket name.

Note: 
Make sure you add the suffix /*  at the end of the bucket name to enable creating files 
under the bucket name.

Executing scripts required for setting up AWS

You must execute scripts provided with the Service Graph Connector for AWS  to set up the AWS 
environment for importing data.

Important: 
Before executing an AWS  script, ensure that you have completed the prerequisites. See 
Prerequisites for executing scripts.

The AWS  scripts provided with the connector configure AWS  resources to import the 
configuration items (CIs) data into the CMDB. To learn more, see AWS resources used by the 
Service Graph Connector for AWS.

Based on the AWS  environment requirements, the scripts provided with the Service Graph 
Connector for AWS  are categorized as described in the following table.

Basic scripts

Scripts for configuring 
the AWS environment 

to import data by 
using the connector.

Deep discovery scripts

Scripts for setting up deep 
discovery on Amazon

Elastic Compute Cloud 
(Amazon EC2) instances.

Amazon  EKS scripts

Scripts for setting up 
Amazon Elastic Kubernetes 

Service (EKS) clusters.

Basic scripts

Use the basic scripts to configure the AWS  environment for importing data using the Service 
Graph Connector for AWS.

The following table describes the basic AWS  scripts available with the connector, the input 
parameters entered when executing a script, the conditions to execute the scripts, and the script 
execution results.
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Basic script details

Script Input parameters Execution condition Result

EnableAWSConfig.yml None Execute the script in all the AWS  accounts and AWS  regions by creating a 
CloudFormation StackSet  in the management account.

See Create a stack set  on the AWS  documentation site.

Enables the 
AWS  Config 
recorder.

CreateServiceNowUser.yml SNUserName

Name of the ServiceNow  IAM user that was 
created as part of the setup. See Prerequisites 
for executing scripts.

Default value: NOWSGCUser

MbrActRoleName

Name of the ServiceNow  IAM role that was 
created as part of the setup. See Prerequisites 
for executing scripts.

Default value: 
SnowOrganizationAccountAccessRole

Execute the script by creating a stack either in the management account or in a 
designated member account.

See Creating a stack on the AWS  CloudFormation console  on the AWS 
documentation site.

Creates the 
ServiceNow 
IAM user.

CreateSnowOrganizationAccountAccessRoleInMemberAccount.yml ACNNBR

Management account ID when the ServiceNow 
IAM user  is in a management account

Or

Designated member account ID when the 
ServiceNow  IAM user is in a designated 
member account.

S3Bucket

Amazon  S3 bucket name to get the 
SendCommand  output.

ServiceNowUserName

Name of the ServiceNow  IAM user that was 
created as part of the setup. See Prerequisites 
for executing scripts.

Default value: NOWSGCUser

Execute the script in all the AWS  accounts by creating a CloudFormation StackSet  in 
the management account.

See Create a stack set  on the AWS  documentation site.

Enables 
read-only 
IAM policies, 
roles, and 
groups 
for the 
ServiceNow 
IAM user.

SnowDesignatedAccountAccessRoleInManagementAccount.yml MEMBERACTNBR

Member account ID where the ServiceNow  IAM 
user  was created.

Execute the script by creating a stack in the management account.

See Creating a stack on the AWS  CloudFormation console  on the AWS 
documentation site.

Note: 
Use the 
SnowDesignatedAccountAccessRoleInManagementAccount.yml 
script only when the ServiceNow  IAM user was created in a member account.

Creates the 
ServiceNow 
IAM role 
in the 
management 
account.
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Basic script details  (continued)

Script Input parameters Execution condition Result

AWS-SystemsManager-AutomationExecutionRole.yml None Execute the script in all the AWS  accounts by creating a CloudFormation StackSet  in 
the management account.

See Create a stack set  on the AWS  documentation site.

Provisions 
the 
execution 
role 
necessary 
to run 
automations 
in member 
accounts. A 
prerequisite 
for 
configuring 
Systems 
Manager 
Automation.

AWS-SystemsManager-AutomationAdministrationRole.yml None Execute the script by creating a stack in the management account.

See Creating a stack on the AWS  CloudFormation console  on the AWS 
documentation site.

Provisions 
the 
administrator 
role in the 
management 
account 
necessary 
to run cross-
account 
automation 
across 
multiple 
accounts. A 
prerequisite 
for 
configuring 
Systems 
Manager 
Automation.

Deep discovery scripts

Use the deep discovery scripts to set up deep discovery on Amazon  EC2 instances.

Note: 
Execute the deep discovery  scripts only when you want to perform deep discovery on EC2 
instances.

The following table describes the deep discovery  scripts, the input parameters entered when 
executing a script, the conditions to execute the scripts, and the script execution results.
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Deep discovery script details

Script Input parameters
Execution 
condition

Result

AmazonSSMForInstancesRoleSetup.yml S3Bucket

S3 bucket 
name that 
collects 
the details 
from EC2 
instances. 
See 
Prerequisites 
for executing 
scripts.

Execute the 
script in all the 
AWS  accounts 
by creating a 
CloudFormation 
StackSet  in the 
management 
account.

See Create 
a stack set
on the AWS 
documentation 
site.

Creates the 
AmazonSSMForInstancesRole 
IAM instance profile role 
to be attached to the EC2 
instances.

SG-AWS-RunShellScript-Setup.yml None Execute the 
script in all the 
AWS  accounts 
and the AWS 
regions by 
creating a 
CloudFormation 
StackSet  in the 
management 
account.

AWS 
administrators 
must 
update SSM 
documents 
and verify that 
EC2 instances 
can execute 
relevant 
commands 
for proper 
integration.

See Create 
a stack set
on the AWS 
documentation 
site.

Creates AWS  Systems 
Manager  (SSM) documents 
to fetch deep discovery data 
from a Linux  EC2 instance. 
Retrieves version details for 
middleware applications, 
including Apache HTTP 
server, Nginx server, Apache 
Tomcat server, and MySQL 
instance.

SG-AWS-RunPowerShellScript-
Setup.yml

None Execute the 
script in all the 
AWS  accounts 
and the AWS 
regions by 

Creates AWS  SSM documents 
to fetch deep discovery data 
from a Windows  EC2 instance.
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Deep discovery script details  (continued)

Script Input parameters
Execution 
condition

Result

creating a 
CloudFormation 
StackSet  in the 
management 
account.

See Create 
a stack set
on the AWS 
documentation 
site.

Amazon  EKS  scripts

Use the Amazon  EKS  scripts to set up Amazon Elastic Kubernetes Service (EKS)  clusters.

Note: 
Execute the Amazon  EKS  scripts only when the Amazon  EKS service for Kubernetes  clusters 
is required.

The following table describes the Amazon  EKS  scripts, the conditions to execute the scripts, and 
the script execution results.

Amazon  EKS  script details

Script Execution condition Result

SG-AWS-
RunKubeCtlEKSNamesShellScript.yml

Execute the script in all 
the AWS  accounts and the 
AWS  regions where the EC2 
Bastion hosts are located by 
creating a CloudFormation 
StackSet  in the management 
account.

See Create a stack set  on 
the AWS  documentation site.

Creates an AWS  SSM 
document to discover 
EKS clusters associated 
with EC2 Bastion hosts.

Note: 
An AWS  Cloud 
administrator can 
update the SSM 
document in their 
AWS  setup.

SG-AWS-RunKubeCtlShellScript.yml Execute the script in all 
the AWS  accounts and the 
AWS  regions where the EC2 
Bastion hosts are located by 
creating a CloudFormation 
StackSet  in the management 
account.

Creates an AWS  SSM 
document to fetch CIs 
related to Kubernetes 
components, such as 
pods, services, and 
deployments, from EKS 
clusters.
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Amazon  EKS  script details  (continued)

Script Execution condition Result

See Create a stack set  on 
the AWS  documentation site.

Note: 
An AWS  Cloud 
administrator can 
update the SSM 
document in their 
AWS  setup.

Configure Service Graph Connector for AWS  using SGC Central

Use the playbook available with the SGC Central  application to set up the Service Graph 
Connector for AWS  for pulling in AWS  data into the CMDB

Before you begin

• Install Service Graph Connector for AWS  version 2.7.0 or later from the ServiceNow Store. For 
ServiceNow Store  installation steps, see Install a ServiceNow Store application .

• Verify that you’ve completed the prerequisites for setting up AWS. See Configure the AWS 
environment.

Role required: cmdb_inst_admin or admin

About this task
The playbook experience for onboarding connectors is activated with SGC Central  in the CMDB 
Workspace. To configure the SGC Central  application, see Configuring SGC Central  and for more 
information on how to interact with a playbook, see Interact with Playbook .

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the CMDB Workspace, select SGC Central.

3. On the Dashboard page, select Create connection.

Tip: 
Alternatively, you can select Create connection  on the All connections page.

4. On the Create connection window, select the AWS  connector type and then select Create 
connection.

5. Complete the initial prerequisites when setting up a connection for the first time using a 
connector.

Note: 
This step is required only during the first-time setup. See Perform initial setup tasks when 
creating a connection in SGC Central.

6. Complete the prerequisites for setting up the AWS  environment.

a. Configure the basic setup in the AWS  environment required for importing data using the 
connector.

i. In the Prerequisites  stage of the playbook, select the Download basic scripts  activity.

ii. Execute the scripts to configure the AWS  environment.
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For more information on executing scripts, see Basic scripts.

iii. Select the I have read the instructions and executed the script accordingly  check box to 
confirm that you have executed the scripts.

iv. Select Continue.

b. Set up deep discovery on Amazon Elastic Compute Cloud (Amazon EC2) instances.

Note: 
Complete this step only to perform deep discovery on EC2 instances. Else, select Skip.

i. In the Prerequisites  stage of the playbook, select the Download deep discovery scripts 
activity.

ii. Execute the scripts to configure Amazon  EC2 instances  for deep discovery.

For more information on executing scripts, see Deep discovery scripts.

iii. Select Continue.

c. Set up Amazon Elastic Kubernetes Service (EKS) clusters.

Note: 
Complete this step only when the Amazon EKS service for Kubernetes clusters is 
required. Else, select Skip.

i. In the Prerequisites  stage of the playbook, select the Download Amazon EKS scripts 
activity.

ii. Execute the scripts to set up Amazon EKS clusters.

For more information on executing scripts, see Amazon EKS scripts.

iii. Select Continue.

7. Complete the setup for configuring the connector for importing data.

a. Create and test connection.

i. In the Setup  stage of the playbook, select the Create and test connection  activity.

ii. On the form, fill in the fields.

Create and test connection form

Field

Connection 
name

Name to identify the AWS  connection record.

For example, SG_AWS_CredentialAlias_Org.

Access Key 
ID

Access key ID of the IAM user that has permissions to interact with the 
AWS resources.

Secret 
Access Key

Secret access key that corresponds to the Access key ID required for 
authenticating the connection securely.
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Field

Use MID 
Server

Option to use a MID Server.

Note: 
Use of a MID Server is optional.

Mid 
Selection

Name of the MID Server used by the connector.

This field appears only when the Use MID Server  check box is selected.

iii. Select Create and test connection.

iv. Once the connection test is complete, select Continue.

b. Set configuration properties for the connection to access the AWS  resources.

i. In the Setup  stage of the playbook, select the Set configuration properties  activity.

ii. In the Organization details section, fill in the organization details including the account 
identifier, name and description of the AWS  organization.

iii. In the S3 account details section, fill in the details.

S3 account details

Field Description

S3 
account ID

Numeric identifier of the AWS  account that hosts the Amazon  Simple 
Storage Service (Amazon  S3) bucket.

S3 bucket 
name

Name of the Amazon  S3 bucket that collects the details from Amazon  EC2 
instances.

S3 region Region where the Amazon  S3 bucket resides.

iv. In the AWS regions  field of the AWS regions and STS assume role name section, enter the 
AWS  regions to collect the CI data.

By default, the Service Graph Connector for AWS  runs through all the AWS  regions to 
collect the CI data.

You can enter AWS  specific regions to speed up the CI data import process. For example, 
us-east1, us-east-2.

If this field is left empty, the Service Graph Connector for AWS  pulls the resources from all 
the AWS  regions.

However, for the AWS GovCloud regions, don’t leave the Regions  field empty. The 
supported AWS GovCloud regions are us-gov-east-1  and us-gov-west-1.

If you update the Regions  field value later, clear the value of the Last run datetime  field in 
all the data sources related to the Service Graph Connector for AWS  to import a new set of 
data.

v. In the STS assume role name  field of the AWS regions and STS assume role name 
section, enter the AWS Identity and Access Management (IAM) role name.
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The AWS IAM role name is obtained by the ServiceNow  user by calling the AssumeRole 
API offered by the AWS  Security Token Service (STS). The AssumeRole  API returns a set 
of temporary security credentials for the ServiceNow  user to access the AWS  resources.

Note: 
Enter the IAM role name but don’t prefix arn  in the name. If you 
leave this field is empty, the value of this field is automatically set to 
SnowOrganizationAccountAccessRole, which is the default IAM role name for the 
ServiceNow  user.

vi. In the SSM SendCommand document details section, enter the name of the document 
that defines the actions run by the AWS  Systems Manager (SSM) on a Linux-based 
Amazon  EC2 instance or a Windows-based Amazon  EC2 instance in their respective 
fields.

vii. In the Management account ID  field of the Management account ID and standalone 
account ID section, enter the management account ID in the AWS  organization.

Enter a value for this field when the ServiceNow  user was created in an AWS  member 
account.

The account calls the ListAccounts  API associated with the AWS  organization to 
collect CI information from all the accounts. For more information, see ListAccounts  on 
the AWS  documentation site.

viii. In the Standalone account ID  field of the Management account ID and standalone 
account ID section, enter the ID of a member account in the AWS  organization.

Note: 
When specifying a standalone account, the AWS  organization-related data such 
as the organization name, organization units, organization ID, and service accounts 
are not imported. To import the full data later, clear any value mentioned in the 
Standalone account ID  field. See the Service Graph Connector for AWS - Standalone 
Setup [KB1642159]  article in the Now Support  Knowledge Base.

ix. In the AWS config aggregator details section, enter the AWS  account details for the 
aggregator resource type.

AWS config aggregator details

Field Description

Config 
aggregator 
account

AWS  account where the aggregator resource type in the AWS  Config 
service has been configured.

Enter a value in this field when you’re using an AWS  Config aggregator.

Config 
aggregator 
name

Name of the aggregator resource type. This field is available only when 
you enter a value in the Config aggregator account  field.

Config 
aggregator 
region

Region where the aggregator resource type resides. This field is available 
only when you enter a value in the Config aggregator account  field.

x. In the AWS key rotation setup section, enter the key rotation process details.
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AWS key rotation setup

Field Description

AWS rotate 
keys

Option to enable the key rotation process.

AWS key 
rotation 
date

Key rotation date. Set the value to the required key rotation date for the first 
run. For subsequent runs, this field is automatically set to the rotation date. 
This field is available only when you select the AWS Rotate Keys  check 
box.

AWS key 
rotation 
period (in 
days)

Key rotation period in days. This field is available only when you select the 
AWS rotate keys  check box.

AWS key 
rotation 
status

Status message of a key rotation displaying whether the rotation was 
a success or a failure. This field is automatically set to display the key 
rotation status message. This field is available only when you select the 
AWS rotate keys  check box. If the rotation status is a failure, an email 
notification is triggered, if configured.

Email 
accounts 
for 
receiving 
error 
notifications

Comma-separated list of the email addresses of recipients who receive 
notifications about the AWS  key rotation errors.

Email 
account 
groups for 
receiving 
error 
notifications

Comma-separated list of the ServiceNow  groups who receive notifications 
about the AWS  key rotation errors.

xi. Select the Is gov cloud  check box in the Gov cloud setup section to indicate that the 
connection setup is for the AWS  GovCloud.

xii. In the SSM EKS SendCommand document details section, enter the AWS  SSM document 
details.

SSM EKS SendCommand document details

Field Description

EKS cluster 
names 
document

Name of the AWS  SSM document to discover EKS clusters associated 
with EC2 Bastion hosts.

EKS shell 
script 
document

Name of the AWS  SSM document to fetch CIs related to Kubernetes 
components, such as pods, services, and deployments, from EKS 
clusters.

xiii. Select Save properties.

xiv. Select Continue.
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c. Configure the required EC2 resources for Amazon Elastic Kubernetes Service (EKS)  to import 
EKS cluster data.

Note: 
Complete this step only when EC2 resources are needed. Else, select Skip  for the 
Configure EKS EC2 resources  activity.

An EKS EC2 resource  is a bastion host that has network access to EKS clusters. The EKS 
clusters aren't directly accessible to the connector. Therefore, you must provide the EKS 
EC2 resource  details. For importing EKS cluster data, the connector uses the SSM Send 
Command on EKS EC2 resources  to run kubectl commands remotely.

Note: 
Ensure that you’ve configured your AWS  environment for the EKS integration. For 
more information, see the Service Graph Connector for AWS - Amazon EKS Integration 
[KB1437138]  article in the Now Support  Knowledge Base.

i. In the Setup  stage of the playbook, select the Configure EKS EC2 resources  activity.

ii. On the Configure EKS EC2 resources page, select New.

iii. On the Configure EKS EC2 resources window that appears, fill in the fields.

Configure EKS EC2 resources fields

Field Description

EKS EC2 
Resource Id

Identifier of the EKS EC2 resource.

EC2 Region AWS region where the EKS EC2 resource  is located.

EC2 Account User name assigned to the EKS EC2 resource  account.

Connection 
Alias

Connection alias associated with the AWS  environment setup and 
configured in step 7.a.ii.

Connection Connection name associated with the AWS  environment setup and 
configured in step 7.a.ii.

Active Option to activate the EKS EC2 resource.

iv. Select Save.

v. Repeat steps from 7.c.ii  to 7.c.iv  to add more EKS EC2 resources.

vi. Select Continue.

d. Run the AWS  diagnostic tool before running a scheduled import job to identify any issues in 
the AWS  environment setup.

i. In the Setup  stage of the playbook, select the Run diagnostic tests  activity.

ii. On the Run diagnostic test page, select an option to exclude the corresponding test 
results from the diagnostic summary.

Skip SSM setup tests

Excludes the software inventory data from the summary results by not calling 
the GetInventory  API. Select this option when you’ve opted out or not set 
up the configuration for SSM.
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Skip SSM Deep Discovery tests

Excludes the deep discovery data from the summary results. Select this 
option when you’ve opted out or not set up the configuration for SSM deep 
discovery.

Skip EKS setup tests

Excludes the EKS data from the summary results by not running the kubectl 
commands.

Note: 
This check box appears only when you’ve configured EC2 resources in 
the Configure EKS EC2 resources  activity.

iii. Select Run diagnostic test  and wait for the test to complete.

iv. Review the diagnostic summary, the API access results, and the IAM permission validation 
logs.

v. When the test results are successful, select Continue.

e. Configure the import schedule to import data at regular intervals.

i. In the Setup  stage of the playbook, select the Configure import schedule  activity.

ii. Expand the Parent scheduled data import within the Import schedules list to select the 
SG-AWS-Organization  import schedule.

iii. In the Configure import schedule  dialog box, select the Active  check box, and then fill in 
the run schedule and time details.

For more information, see Schedule a data import .

iv. Select Save.

Alternatively, select Execute Now  to execute the import schedule immediately.

v. Select Continue.

f. In the Setup  stage of the playbook, select the Confirm connection setup  activity to verify 
whether the connection was created.

What to do next
Select View all connections  to review the connection details. The configured connection 
appears in the Installed connections list.

Related topics

Service Graph Connector for AWS

CMDB classes targeted in Service Graph Connector for AWS

Supported AWS resource types

Accessing the connection details of Service Graph Connector for AWS

Additional features within the Service Graph Connector for AWS

Configure Service Graph Connector for AWS  using the guided setup

Set up the AWS  environment and scheduled jobs to pull in AWS  data into the CMDB.
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Before you begin
Important: 
Unless there are configuration issues, use the SGC Central  view in the CMDB Workspace 
to configure the connection for the connector, as the guided setup method is being 
deprecated.

To use this Service Graph Connector, you need a subscription to a Subscription Unit that is 
based in the IT Operations Management  (ITOM) Visibility application or in the ITOM  Discovery 
application. As defined in the section titled "Managed IT Resource Types" in ServiceNow 
Subscription Unit Overview  for your subscription, for managed IT resources that are created 
or modified in the CMDB  by this Service Graph Connector, but that aren’t yet managed by ITOM 
Visibility or ITOM Discovery , these resources will increase Subscription Unit consumption from 
that application. Review your current Subscription Unit consumption within ITOM Visibility or 
ITOM Discovery to ensure available capacity.

Dependencies and requirements:

• The Integration Commons for CMDB  store app, which is automatically installed.

• The CMDB CI class models store app, which is automatically installed. See CMDB CI Class 
Models store app.

• Discovery Core plugin (com.snc.discovery.core), which is automatically installed by Discovery.

• The ITOM Discovery License plugin (com.snc.itom.discovery.license). You must activate this 
plugin.

• ITOM Licensing plugin (com.snc.itom.license). For more information, see Request Discovery .

Ensure that you’ve completed the prerequisites for setting up AWS. See Configure the AWS 
environment.

Note: 
When upgrading from an earlier version, ensure that you’ve updated the SSM documents 
and IAM permissions in your AWS  instance.

• For updating SSM documents, run the SG-AWS-RunShellScript-
Setup.yml, SG-AWS-RunPowerShellScript-Setup.yml, and SG-AWS-
RunKubeCtlShellScript.yml  scripts.

• For updating the IAM permissions assigned to the 
SnowOrganizationAccountAccessRole role, run the 
CreateSnowOrganizationAccountAccessRoleInMemberAccount.yml 
script.

Role required: admin

About this task
For more information on the Service Graph Connector for AWS  setup instructions, see the 
following articles:

• Service Graph Connector for AWS - Setup Instructions [KB1220597]  article on the Now 
Support  Knowledge Base.

• Service Graph Connector for AWS - Introduction  on the ServiceNow  Community site.

• SGC-AWS - Release 2.0 Features  on the ServiceNow  Community site.

If you upgrade the connector, complete the following tasks before the upgrade process:
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• If there are any customizations, delete the records associated with the Service Graph 
Connector for AWS  from the Customer Updates [sys_update_xml] table. See Customer 
Updates table .

• Upgrade any dependencies.

After you've installed the latest version of the Service Graph Connector for AWS:

• Perform a full import of data from your AWS  instance. Verify that the Use last run datetime  field 
value is cleared for all the AWS  data sources in the Data Source [sys_data_source] table.

• Download and rerun the AWS  scripts. See Configure the AWS environment.

Procedure

1. Ensure that you’ve selected the Service Graph Connector for AWS  application scope by using 
the application picker.
For more information, see Application picker .

2. Navigate to All  > Service Graph Connectors  > AWS  > Setup.

3. Configure the AWS environment.

Note: 
For the Download the scripts task, select Configure  to download the scripts.

After you’ve downloaded the scripts and configured the AWS  environment, set the Download 
the scripts and AWS Setup Instructions tasks to complete.

4. Configure the authentication credentials to authenticate requests sent to the AWS  APIs.

a. Configure your AWS  credentials.

i. For the Configure the connection  section of the Service Graph Connector for AWS  page, 
select Get Started.

ii. For the Configure the credentials  task, select Configure.

iii. In the Name  field, enter a name for the authentication.

SG-AWS-Credentials-Org  is the default credential alias name. You can add multiple 
AWS  instances. However, don’t modify the default connection alias.

iv. Enter the access key ID and the secret access key in the Access Key ID  and Secret 
Access Key  fields respectively.

The AWS  access keys are long-term credentials for the IAM user and include two parts: 
an access key ID and a secret access key. You must use both the access key ID and the 
secret access key together to authenticate requests.

v. Return to the Configure the connection task page by selecting the back icon (<).

vi. Set the Configure the credentials task to complete by selecting Mark as Complete.

b. Test the AWS  API connection to import data from the AWS  application.

i. For the Test the connection  task in the Configure the connection  section, select 
Configure.

ii. Select the Test Connection  related link.
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iii. When the Status  field is set to Success, select the back icon (<) to return to the guided 
setup.

iv. Set the Test the connection  task to complete by selecting Mark as Complete.

c. Update the required configuration properties for an AWS  instance.

i. For the Update configuration properties for instance  task, select Configure.

ii. On the SG-AWS Configuration Properties form that opens in a new tab, review, and modify 
the fields.

SG-AWS Configuration Properties form

Field Description

Connection Details

Connection 
Alias

Name to identify the AWS  connection record. For example, 
SG_AWS_CredentialAlias_Org.

You can add multiple AWS  instances. However, don’t modify the name for 
the default connection alias SG_AWS_CredentialAlias_Org.

Organization Details

Organization 
Account

Numeric account identifier of the AWS  organization.

Organization 
Name

Name of the AWS  organization.

Organization 
Description

Description of the AWS  organization.

AWS Regions

Regions AWS  regions to collect the CI data.

By default, the Service Graph Connector for AWS  runs through all the 
AWS  regions to collect the CI data.

You can enter AWS  specific regions to speed up the CI data import 
process. For example, us-east1, us-east-2.

If this field is left empty, the Service Graph Connector for AWS  pulls the 
resources from all the AWS  regions.

However, for the AWS GovCloud regions, don’t leave the Regions  field 
empty. The supported AWS GovCloud regions are us-gov-east-1  and 
us-gov-west-1.

If you update the Regions  field value later, clear the value of the Last 
run datetime  field in all the data sources related to the Service Graph 
Connector for AWS  to import a new set of data.

STS Assume Role Name

STS Role AWS Identity and Access Management (IAM) role name that is obtained 
by the ServiceNow  user by calling the AssumeRole  API offered by the 
AWS  Security Token Service (STS). The AssumeRole  API returns a set 
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Field Description

of temporary security credentials for the ServiceNow  user to access the 
AWS  resources.

Note: 
Enter the IAM role name but don’t prefix arn  in the name. If you 
leave this field is empty, the value of this field is automatically set to 
SnowOrganizationAccountAccessRole, which is the default IAM 
role name for the ServiceNow  user.

S3 Account Details

S3 Account 
Id

Numeric identifier of the AWS  account that hosts the Amazon  Simple 
Storage Service (Amazon  S3) bucket.

S3 Bucket 
Name

Name of the Amazon  S3 bucket that collects the details from Amazon  EC2 
instances.

S3 Region Region where the Amazon  S3 bucket resides.

SSM SendCommand Document Details

SSM Send 
Command 
Linux Name

Name of the document that defines the actions run by the AWS  Systems 
Manager (SSM) on a Linux-based Amazon  EC2 instance.

SSM Send 
Command 
Windows 
Name

Name of the document that defines the actions run by the AWS  SSM on a 
Windows-based Amazon  EC2 instance.

Management Account ID

Management 
Account ID

Management account in the AWS  organization. The account calls 
the ListAccounts  API associated with the AWS  organization to 
collect CI information from all the accounts. For more information, see 
ListAccounts  on the AWS  documentation site.

Enter a value for this field when the ServiceNow  user was created in an 
AWS  member account.

Standalone Account ID Details

Standalone 
Account ID

ID of a member account in the AWS  organization.

Note: 
When specifying a standalone account, AWS organization-related 
data such as the organization name, organization units, organization 
ID, and service accounts are not imported. If you want to import the 
full data later, clear any value mentioned in the Standalone Account 
ID  field. See the Service Graph Connector for AWS - Standalone 
Setup [KB1642159]  article in the Now Support  Knowledge Base.

AWS Config Aggregator Details

Config 
Aggregator 
Account

AWS  account where the aggregator resource type in the AWS  Config 
service has been configured.

Enter a value in this field when you’re using an AWS  Config aggregator.
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Field Description

Config 
Aggregator 
Name

Name of the aggregator resource type. This field is available only when 
you enter a value in the Config Aggregator Account  field.

Config 
Aggregator 
Region

Region where the aggregator resource type resides. This field is available 
only when you enter a value in the Config Aggregator Account  field.

AWS Key Rotation Setup

AWS Rotate 
Keys

Option to enable the key rotation process.

AWS Key 
Rotation 
Date

Key rotation date. Set the value to the required key rotation date for the 
first run. For subsequent runs, this field is automatically set to the rotation 
date.  This field is available only when you select the AWS Rotate Keys 
check box.

AWS Key 
Rotation 
Period (in 
Days)

Key rotation period in days. This field is available only when you select the 
AWS Rotate Keys  check box.

AWS Key 
Rotation 
Status

Status message of a key rotation displaying whether the rotation was 
a success or a failure. This field is automatically set to display the key 
rotation status message. This field is available only when you select the 
AWS Rotate Keys  check box. If the rotation status is a failure, an email 
notification is triggered, if configured.

Email 
accounts 
for receiving 
error 
notifications

Comma-separated list of the email addresses of recipients who receive 
notifications about the AWS  key rotation errors.

Email 
account 
groups for 
receiving 
error 
notifications

Comma-separated list of the ServiceNow  groups who receive 
notifications about the AWS  key rotation errors.

Gov Cloud Setup

Is Gov Cloud Option to indicate that the connection setup is for the AWS GovCloud.

SSM EKS SendCommand Document Details

EKS Cluster 
Names 
Document

Name of the AWS  SSM document to discover EKS clusters associated 
with EC2 Bastion hosts.

EKS Shell 
Script 
Document

Name of the AWS  SSM document to fetch CIs related to Kubernetes 
components, such as pods, services, and deployments, from EKS 
clusters.

iii. Select Save  and then Close  to close the tab and return to the guided setup tab.

iv. Set the Update configuration properties for instance  task to complete by selecting Mark 
as Complete.
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5. Configure the required EC2 resources for Amazon Elastic Kubernetes Service (EKS)  to import 
EKS cluster data.
An EKS EC2 resource  is a bastion host that has network access to EKS clusters. The EKS 
clusters aren't directly accessible to the connector. Therefore, you must provide the EKS EC2 
resource  details. For importing EKS cluster data, the connector uses the SSM Send Command 
on EKS EC2 resources  to run kubectl commands remotely.

Note: 
Ensure that you’ve configured your AWS  environment for the EKS integration. For 
more information, see the Service Graph Connector for AWS - Amazon EKS Integration 
[KB1437138]  article in the Now Support  Knowledge Base.

a. For the Configure the EKS Resource Details  section of the Service Graph Connector for AWS 
page, select Get Started.

b. For the Enter the EKS EC2 Resource Details  task, select Configure.

c. On the form that opens in a new tab, fill in the fields.

SG-AWS-EKS-EC2-Resource form

Field Description

EKS EC2 
Resource Id

Identifier of the EKS EC2 resource.

EC2 Account User name assigned to the EKS EC2 resource  account.

EC2 Region AWS region where the EKS EC2 resource  is located.

Active Option to activate the EKS EC2 resource.

Note: 
Set to false, if you are not using the EKS EC2 resource  resource.

Connection Connection alias associated with the AWS  environment setup and 
configured in step 4.a.

d. Select Submit  to return to the guided setup.

e. Repeat steps from 5.b  to 5.d  to add multiple EKS EC2 resources.
All the EKS EC2 resources  are added to the SG-AWS-EKS-Master 
[sn_aws_integ_sg_aws_eks_master] table.

f. Set the Enter the EKS EC2 Resource Details  task to complete by selecting Mark as 
Complete.

6. Run the AWS  diagnostic tool before running a scheduled import job to identify any issues in 
the AWS  environment setup.

a. For the Service Graph AWS Diagnostic Tool  section of the Service Graph Connector for AWS 
page, select Get Started.

b. For the AWS Setup Diagnostic Tool  task, select Configure.
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c. Select the organization ID from the text field.

d. Select Run Diagnostic Test.

Tip: 
Select one of the following options to exclude the corresponding test results from the 
diagnostic summary:

Skip SSM setup tests

Excludes the software inventory data from the summary results by not 
calling the GetInventory  API. Select this option when you’ve opted out 
or not set up the configuration for SSM.

Skip SSM Deep Discovery tests

Excludes the deep discovery data from the summary results. Select this 
option when you’ve opted out or not set up the configuration for SSM 
deep discovery.

Skip EKS setup tests

Excludes the EKS data from the summary results by not running the 
kubectl commands. Select this option when you’ve opted out or not set up 
the EKS integration.

e. Optional:  View only EKS cluster test results by selecting View EKS Test Details.

f. Optional:  Preview any previous diagnostic tool results by selecting Load DT Results, 
selecting a diagnostic ID, and then selecting Load Results.

g. When you finish reviewing the diagnostic summary results, select the back button of your 
browser to return to the guided setup.

h. Set the AWS Setup Diagnostic Tool  task to complete by selecting Mark as Complete.

7. Configure the scheduled jobs to import data from the AWS  application.

a. In the Configure the scheduled import jobs  section of the Service Graph Connector for AWS 
page, select Get started.

b. For the Configure the scheduled job  task, select Configure.

c. Select the scheduled job that you want to activate.

d. On the Scheduled Data Import form, verify the field values for the scheduled job.
For more information, see Schedule a data import .

e. Select Update.

f. Repeat the steps 7.c  to 7.e  for each scheduled job for data import.
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g. Select the back icon (<) to return to the guided setup page.

h. Set the Configure the scheduled job  task to complete by selecting Mark as Complete  in the 
guided setup.

8. Optional:  Add multiple AWS  instances.

a. In the Add Multiple Instances  section of the Service Graph Connector for AWS  page, select 
Get Started.

b. Ensure that you have edit permissions for the Datasource [sys_data_source] table to create 
data sources for the new instance.

i. Select the Global  application scope by using the application picker.

ii. For the Update Data Source Access  task, select Configure.

iii. In the Application Access related list, select the Can create, Can update, and Can delete 
check boxes, if not already selected.

iv. Select Update  to close the tab and return to the guided setup.

v. Modify the application scope again to Service Graph Connector for AWS  by using the 
application picker.

vi. Set the Update Data Source Access  task to complete by selecting Mark as Complete.

c. Update access for scheduled import jobs.

i. Select the Global  application scope by using the application picker.

ii. For the Update Scheduled Data Import Access  task, select Configure.

iii. In the Application Access related list, select the Can create, Can update, and Can delete 
check boxes, if not already selected.

iv. Select Update  to close the tab and return to the guided setup tab.

v. Set the Update Scheduled Data Import Access  task to complete by selecting Mark as 
Complete.

vi. Modify the application scope again to Service Graph Connector for AWS  by using the 
application picker.

d. Clear the cache of the Data Source [sys_data_source] and Scheduled Data Imports 
[scheduled_import_set] tables to enable creating a data source for the new connection in 
the Service Graph Connector for AWS.

i. For the Clear Cache for Data Source and Scheduled Data Imports tables  task, select 
Configure.

ii. In the Run script  text box of the background script page, enter the following script:

GlideTableManager.invalidateTable("sys_data_source");
      GlideCacheManager.flushTable("sys_data_source");
 
     
 GlideTableManager.invalidateTable("scheduled_import_set");
      GlideCacheManager.flushTable("scheduled_import_set");
 
      GlideTableManager.invalidateTable("sys_db_object");
      GlideCacheManager.flushTable("sys_db_object");
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iii. Select Run Script  to run the background script in the global  scope.

The script may take several minutes to execute.

iv. After the script is executed, select Close.

v. Set the Clear Cache for Data Source and Scheduled Data Imports tables  task to complete 
by selecting Mark as Complete.

vi. Modify the application scope again to Service Graph Connector for AWS  by using the 
application picker.

e. Create a credential alias for the new AWS  connection in the Service Graph Connector for 
AWS.

i. For the Create new Connection & Credentials Alias Record  task, select Configure.

ii. On the Connection & Credential Aliases form that opens in a new tab, fill in the connection 
details.

iii. Select Submit  and close the tab and return to the guided setup tab.

iv. Set the Create new Connection & Credentials Alias Record  task to complete by selecting 
Mark as Complete.

f. Create credentials for the new AWS  credential alias.

i. For the Create new Connection & Credentials Alias Record  task, select Configure.

ii. On the Connections page of the Flow Designer, select Add Connection.

iii. In the Create Connection window, fill in the connection name, access key, and secret key 
details.

iv. Select Create Connection.

v. Close the Flow Designer  and return to the guided setup tab.

vi. Set the Create new Connection & Credentials Alias Record  task to complete by selecting 
Mark as Complete.

g. Update properties for the new instance for the Service Graph Connector for AWS  by 
selecting Configure  for the Configure AWS environment for the new Instance  task.
For more information, follow the step 4.c  discussed earlier for configuring the properties of 
the AWS  connection available by default.

When you're done updating the properties, set the Configure AWS environment for the new 
Instance  task to complete by selecting Mark as Complete.

h. Enter the EKS EC2 Resource details by selecting Configure  for the Update EKS Resource 
Details  task.
For more information, follow the step 5  discussed earlier for configuring the EKS EC2 
Resource details for the AWS  connection available by default.

When you're done updating the properties, set the Update EKS Resource Details  task to 
complete by selecting Mark as Complete.

i. Configure the scheduled imports for the new AWS instance.

i. For the Configure the Scheduled Imports  task, select Configure.

ii. In the Scheduled Data Imports list that opens in a new tab, select the organization of the 
AWS  instance that you want to configure.
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iii. Select the scheduled data import that you want to activate.

iv. On the Scheduled Data Import form, modify the field values for the scheduled job.

v. Select Update.

vi. Repeat the steps 8.i.iii  to 8.i.v  for each scheduled job for data import.

vii. Close the tab for the Scheduled Data Imports list and return to the guided setup tab.

viii. Set the Configure the Scheduled Imports  task to complete by selecting Mark as Complete 
in the guided setup.

Related topics

Handling import failures for large AWS resources

Handling memory utilization errors for Service Graph Connector for AWS

CMDB  classes targeted in Service Graph Connector for AWS

When you complete setting up the connection, you can configure the integration to periodically 
pull data from AWS. The data is saved in tables that extend from the Configuration item [cmdb_ci] 
table.

Amazon Redshift [cmdb_ci_aws_redshift]

The following attributes in the Amazon Redshift [cmdb_ci_aws_redshift] table are populated by 
collected data:

Attribute label Attribute name

Name name

Object ID object_id

TCP port(s) tcp_port

Cluster Availability Status cluster_availability_status

Install Status install_status

Availability Zone availability_zone

Fully qualified domain name fqdn

Node Count node_count

Node Type node_type

Operational status operational_status

Start date start_date

VPC ID vpc_id

Relationships created for Application

Parent class Relationship type Child class

Amazon Redshift 
[cmdb_ci_aws_redshift]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Amazon Redshift 
[cmdb_ci_aws_redshift]

Reference Availability Zone 
[cmdb_ci_availability_zone]
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Application [cmdb_ci_appl]

The following attributes in the Application [cmdb_ci_appl] table are populated by collected data:

Attribute label Attribute name

Class sys_class_name

Version version

TCP port(s) tcp_port

Running Process running_process

Running process key parameters running_process_key_parameters

Name name

Running process command running_process_command

Relationship created for Application

Parent class Relationship type Child class

Application [cmdb_ci_appl] Runs on::Runs Server [cmdb_ci_server]

Availability Zone [cmdb_ci_availability_zone]

The following attributes in the Availability Zone [cmdb_ci_availability_zone] table are populated 
by collected data:

Attribute label Attribute name

Name name

Object ID object_id

Install Status install_status

Operational status operational_status

State state

Relationships created for Availability Zone

Parent class Relationship type Child class

Availability Zone 
[cmdb_ci_availability_zone]

Contains::Contained by Cloud Subnet 
[cmdb_ci_cloud_subnet]

Availability Zone 
[cmdb_ci_availability_zone]

Contains::Contained by Cloud Load Balancer 
[cmdb_ci_cloud_load_balancer]

AWS Datacenter [cmdb_ci_aws_datacenter]

The following attributes in the AWS Datacenter [cmdb_ci_aws_datacenter]  table are populated by 
collected data:
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Attribute label Attribute name

Name name

Object ID object_id

Region region

Install Status install_status

Operational status operational_status

Relationships created for AWS Datacenter

Parent class Relationship type Child class

AWS Datacenter 
[cmdb_ci_aws_datacenter]

Contains::Contained by Availability Zone 
[cmdb_ci_availablity_zone]

AWS Datacenter 
[cmdb_ci_aws_datacenter]

Hosted on::Hosts Cloud Service Account 
[cmdb_ci_cloud_service_account]

AWS Organizational Unit [cmdb_ci_aws_org_unit]

The following attributes in the AWS Organizational Unit [cmdb_ci_aws_org_unit] table are 
populated by collected data:

Attribute label Attribute name

Object ID object_id

Install Status install_status

Name name

Operational status operational_status

Org Unit Parent ID org_unit_parent_id

Organizational ID aws_org_id

Root ID root_id

Relationship created for AWS Organizational Unit

Parent class Relationship type Child class

AWS Organizational Unit 
[cmdb_ci_aws_org_unit]

Contains::Contained by Cloud Service Account 
[cmdb_ci_cloud_service_account]

Block Endpoint [cmdb_ci_endpoint_block]

The following attributes in the Block Endpoint [cmdb_ci_endpoint_block] table are populated by 
collected data:

Attribute label Attribute name

Host host
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Attribute label Attribute name

Name name

Object ID object_id

Install Status install_status

Operational status operational_status

Cloud DataBase [cmdb_ci_cloud_database]

The following attributes in the Cloud DataBase [cmdb_ci_cloud_database] table are populated by 
collected data:

Attribute label Attribute name

Name name

Object ID object_id

TCP port(s) tcp_port

Automated Backups automated_backup

Category category

Fully qualified domain name fqdn

Install Status install_status

Operational status operational_status

State state

Type type

Version version

Relationships created for Cloud DataBase

Parent class Relationship type Child class

Cloud DataBase 
[cmdb_ci_cloud_database]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Cloud DataBase 
[cmdb_ci_cloud_database]

Reference Key Value [cmdb_key_value]

Cloud Function [cmdb_ci_cloud_function]

The following attributes in the Cloud Function [cmdb_ci_cloud_function] table are populated by 
collected data:

Attribute label Attribute name

Name name

Object ID object_id

Code Size code_size
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Attribute label Attribute name

CodeSha256 codesha256

Function Last Modified function_last_modified

Install Status install_status

Language language

Operational status operational_status

Version version

Relationships created for Cloud Function

Parent class Relationship type Child class

Cloud Function 
[cmdb_ci_cloud_function]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Cloud Function 
[cmdb_ci_cloud_function]

Reference Key Value [cmdb_key_value]

Cloud Gateway [cmdb_ci_cloud_gateway]

The following attributes in the Cloud Gateway [cmdb_ci_cloud_gateway] table are populated by 
collected data:

Attribute label Attribute name

Name name

Object ID object_id

Fully qualified domain name fqdn

Install Status install_status

Operational status operational_status

Relationships created for Cloud Gateway

Parent class Relationship type Child class

Cloud Gateway 
[cmdb_ci_cloud_gateway]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Cloud Gateway 
[cmdb_ci_cloud_gateway]

Reference Key Value [cmdb_key_value]

Cloud Hardware Type [cmdb_ci_cloud_hardware_type]

The following attributes in the Cloud Hardware Type [cmdb_ci_cloud_hardware_type] table are 
populated by collected data:

Attribute label Attribute name

Name name
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Attribute label Attribute name

Object ID object_id

Provider provider

Cores cores

Install Status install_status

IP Address ip_address

Local Storage GB local_storage_gb

Memory MB memory_mb

Operational status operational_status

vCPUs vcpus

Zone zone

Relationships created for Cloud Hardware Type

Parent class Relationship type Child class

Cloud Hardware Type 
[cmdb_ci_cloud_hardware_type]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Cloud Image [cmdb_ci_cloud_os_image]

The following attributes in the Cloud Image [cmdb_ci_cloud_os_image] table are populated by 
collected data:

Attribute label Attribute name

Name name

Object ID object_id

Description short_description

Environment environment

Guest OS guest_os

Image Source image_source

Image Type image_type

Provider provider

Root Device Type root_device_type

Relationships created for Cloud Image

Parent class Relationship type Child class

Cloud Image 
[cmdb_ci_cloud_os_image]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Cloud Image 
[cmdb_ci_cloud_os_image]

Reference Key Value
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Cloud Load Balancer [cmdb_ci_cloud_load_balancer]

The following attributes in the Cloud Load Balancer [cmdb_ci_cloud_load_balancer] table are 
populated by collected data:

Attribute label Attribute name

Name name

Object ID object_id

Canonical Hosted Zone ID canonical_hosted_zone_id

Canonical Hosted Zone Name canonical_hosted_zone_name

DNS Name dns_name

Fully qualified domain name fqdn

Install Status install_status

Operational status operational_status

State state

Relationships created for Cloud Load Balancer

Parent class Relationship type Child class

Cloud Load Balancer 
[cmdb_ci_cloud_load_balancer]

Contains::Contained by Compute Security Group 
[cmdb_ci_compute_security_group]

Cloud Load Balancer 
[cmdb_ci_cloud_load_balancer]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Cloud Load Balancer 
[cmdb_ci_cloud_load_balancer]

Reference Key Value [cmdb_key_value]

Cloud Mgmt Network Interface [cmdb_ci_nic]

The following attributes in the Cloud Mgmt Network Interface [cmdb_ci_nic] table are populated 
by collected data:

Attribute label Attribute name

IP Address ip_address

Name name

Object ID object_id

Public IP public_ip

Install Status install_status

Operational status operational_status

Private DNS private_dns

Private IP private_ip

Public DNS public_dns
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Attribute label Attribute name

State state

Configuration Item cmdb_ci

Relationships created for Cloud Mgmt Network Interface

Parent class Relationship type Child class

Cloud Mgmt Network Interface 
[cmdb_ci_nic]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Cloud Mgmt Network Interface 
[cmdb_ci_nic]

Use End Point To::Use End 
Point From

VNIC Endpoint 
[cmdb_ci_endpoint_vnic]

Cloud Mgmt Network Interface 
[cmdb_ci_nic]

Reference Key Value [cmdb_key_value]

Cloud Mgmt Network Interface 
[cmdb_ci_nic]

Reference Virtual Machine Instance 
[cmdb_ci_vm_instance]

Cloud Network [cmdb_ci_network]

The following attributes in the Cloud Network [cmdb_ci_network] table are populated by 
collected data:

Attribute label Attribute name

Name name

Object ID object_id

Cidr cidr

Install Status install_status

Operational status operational_status

State state

Relationships created for Cloud Network

Parent class Relationship type Child class

Cloud Network 
[cmdb_ci_network]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Cloud Network 
[cmdb_ci_network]

Contains::Contained by Cloud Subnet 
[cmdb_ci_cloud_subnet]

Cloud Network 
[cmdb_ci_network]

Contains::Contained by Compute Security Group 
[cmdb_ci_compute_security_group]

Cloud Network 
[cmdb_ci_network]

Reference Key Value [cmdb_key_value]

Cloud Object Storage [cmdb_ci_cloud_object_storage]

The following attributes in the Cloud Object Storage [cmdb_ci_cloud_object_storage] table are 
populated by collected data:
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Attribute label Attribute name

Name name

Object ID object_id

ACL Access Type acl_access_type

Cloud Provider cloud_provider

Creation Date creation_date

Encryption Type encryption_type

Install Status install_status

Operational status operational_status

Policy Access Type policy_access_type

Service Name service_name

Relationships created for Cloud Object Storage

Parent class Relationship type Child class

Cloud Object Storage 
[cmdb_ci_cloud_object_storage]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Cloud Object Storage 
[cmdb_ci_cloud_object_storage]

Reference Key Value [cmdb_key_value]

Cloud Organizations [cmdb_ci_cloud_org]

The following attributes in the Cloud Organizations [cmdb_ci_cloud_org] table are populated by 
collected data:

Attribute label Attribute name

Object ID object_id

Install Status install_status

Master Email master_email

Name name

Operational status operational_status

Root ID root_id

Relationships created for Cloud Organizations

Parent class Relationship type Child class

Cloud Organizations 
[cmdb_ci_cloud_org]

Contains::Contained by Cloud Service Account 
[cmdb_ci_cloud_service_account]

Cloud Organizations 
[cmdb_ci_cloud_org]

Contains::Contained by AWS Organizational Unit 
[cmdb_ci_aws_org_unit]
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Cloud Resource [cmdb_ci_cmp_resource]

The following attributes in the Cloud Resource [cmdb_ci_cmp_resource] table are populated by 
collected data:

Attribute label Attribute name

Name name

Object ID object_id

Description short_description

Install Status install_status

Operational status operational_status

Resource type resource_type

State state

Relationship created for Cloud Resource

Parent class Relationship type Child class

Cloud Resource 
[cmdb_ci_cmp_resource]

Reference Key Value [cmdb_key_value]

Cloud Service Account [cmdb_ci_cloud_service_account]

The following attributes in the Cloud Service Account [cmdb_ci_cloud_service_account] table are 
populated by collected data:

Attribute label Attribute name

Name name

Account Email account_email

Install Status install_status

Is management account is_master_account

Operational status operational_status

Parent account parent_account

Datacenter Type datacenter_type

Discovery credentials discovery_credentials

Account Id account_id

Object ID object_id

Organization Id organization_id
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Relationships created for Cloud Service Account

Parent class Relationship type Child class

Cloud Service Account 
[cmdb_ci_cloud_service_account]

Reference Cloud Service Account 
[cmdb_ci_cloud_service_account]

Cloud Service Account 
[cmdb_ci_cloud_service_account]

Reference Key Value [cmdb_key_value]

Cloud Subnet [cmdb_ci_cloud_subnet]

The following attributes in the Cloud Subnet [cmdb_ci_cloud_subnet] table are populated by 
collected data:

Attribute label Attribute name

Name name

Object ID object_id

Available IP Count available_ip_count

CIDR cidr

Install Status install_status

Operational status operational_status

State state

Relationships created for Cloud Subnet

Parent class Relationship type Child class

Cloud Subnet 
[cmdb_ci_cloud_subnet]

Contains::Contained by Cloud Load Balancer 
[cmdb_ci_cloud_load_balancer]

Cloud Subnet 
[cmdb_ci_cloud_subnet]

Contains::Contained by Cloud Mgmt Network Interface 
[cmdb_ci_nic]

Cloud Subnet 
[cmdb_ci_cloud_subnet]

Reference Key Value [cmdb_key_value]

Compute Security Group [cmdb_ci_compute_security_group]

The following attributes in the Compute Security Group [cmdb_ci_compute_security_group] table 
are populated by collected data:

Attribute label Attribute name

Name name

Object ID object_id

Install Status install_status
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Relationships created for Compute Security Group Table

Parent class Relationship type Child class

Compute Security Group 
[cmdb_ci_compute_security_group]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Compute Security Group 
[cmdb_ci_compute_security_group]

Reference Key Value [cmdb_key_value]

Docker Container [cmdb_ci_docker_container]

The following attributes in the Docker Container [cmdb_ci_docker_container] table are populated 
by collected data:

Attribute label Attribute name

Container id container_id

Image id image_id

Install Status install_status

Name name

Operational status operational_status

Status status

Docker Image [cmdb_ci_docker_image]

The following attributes in the Docker Image [cmdb_ci_docker_image] table are populated by 
collected data:

Attribute label Attribute name

Image id image_id

Install Status install_status

Name name

Operational status operational_status

Relationship created for Docker Image

Parent class Relationship type Child class

Docker Image 
[cmdb_ci_docker_image]

Instantiates::Instantiated by Docker Container 
[cmdb_ci_docker_container]

DynamoDB Table [cmdb_ci_dynamodb_table]

The following attributes in the DynamoDB Table [cmdb_ci_dynamodb_table] table are populated 
by collected data:
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Attribute label Attribute name

Name name

Object ID object_id

Cloud Provider cloud_provider

Creation Date creation_date

Encryption encryption

Install Status install_status

Operational status operational_status

Read Units read_units

Service Name service_name

Write Units write_units

Relationships created for DynamoDB Table

Parent class Relationship type Child class

DynamoDB Table 
[cmdb_ci_dynamodb_table]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

DynamoDB Table 
[cmdb_ci_dynamodb_table]

Reference Key Value [cmdb_key_value]

Hardware Type [cmdb_ci_compute_template]

The following attributes in the Hardware Type [cmdb_ci_compute_template] table are populated 
by collected data:

Attribute label Attribute name

Name name

Object ID object_id

Cores cores

Install Status install_status

Local Storage GB local_storage_gb

Memory MB memory_mb

Operational status operational_status

vCPUs vcpus
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Note: 
If the sn_itom_pattern.use a single hardware type for cloud data 
center  property is set to true, hardware type data is populated in the Cloud Hardware 
Type [cmdb_ci_cloud_hardware_type] table. If this property is set to false, hardware 
type data is populated in the Hardware Type [cmdb_ci_compute_template] table. Before 
you configure the sn_itom_pattern.use a single hardware type for 
cloud data center  property, the existing hardware type data must be cleaned. For 
instructions, see the Service Graph Connector For AWS - Migrating to a new hardware type 
model [KB1705233]  article in the Now Support  Knowledge Base.

Relationship created for Hardware Type

Parent class Relationship type Child class

Hardware Type 
[cmdb_ci_compute_template]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Image [cmdb_ci_os_template]

The following attributes in the Image [cmdb_ci_os_template] table are populated by collected 
data:

Attribute label Attribute name

Name name

Object ID object_id

Class sys_class_name

Description short_description

Environment environment

Guest OS guest_os

Image Source image_source

Image Type image_type

Install Status install_status

Operational status operational_status

Root Device Type root_device_type

Relationships created for Image

Parent class Relationship type Child class

Image [cmdb_ci_os_template] Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Image [cmdb_ci_os_template] Reference Key Value

IP Address [cmdb_ci_ip_address]

The following attributes in the IP Address [cmdb_ci_ip_address] table are populated by collected 
data:
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Attribute label Attribute name

Install Status install_status

Nic nic

IP Address ip_address

Name name

Operational status operational_status

Relationship created for IP Address

Parent class Relationship type Child class

IP Address 
[cmdb_ci_ip_address]

Reference Network Adapter 
[cmdb_ci_network_adapter]

Key Value [cmdb_key_value]

The following attributes in the Key Value [cmdb_key_value] table are populated by collected data:

Attribute label Attribute name

Key key

Value Value

Kubernetes Cluster [cmdb_ci_kubernetes_cluster]

The following attributes in the Kubernetes Cluster [cmdb_ci_kubernetes_cluster] table are 
populated by collected data:

Attribute label Attribute name

Cluster Resource ID cluster_resource_id

IP Address ip_address

Name name

Port port

Fully qualified domain name fqdn

Install status install_status

Namespace namespace

Operational status operational_status

Relationships created for Kubernetes Cluster

Parent class Relationship type Child class

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Contains::Contained by Kubernetes Namespace 
[cmdb_ci_kubernetes_namespace]
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Relationships created for Kubernetes Cluster  (continued)

Parent class Relationship type Child class

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Contains::Contained by Kubernetes Pod 
[cmdb_ci_kubernetes_pod]

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Contains::Contained by Kubernetes Service 
[cmdb_ci_kubernetes_service]

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Cluster of::Cluster Kubernetes Node 
[cmdb_ci_kubernetes_node]

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Managed by::Manages Server [cmdb_ci_server]

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Reference Key Value [cmdb_key_value]

Kubernetes DaemonSet [cmdb_ci_kubernetes_daemonset]

The following attributes in the Kubernetes DaemonSet [cmdb_ci_kubernetes_daemonset] table 
are populated by collected data:

Attribute label Attribute name

Kubernetes UID k8s_uid

Name name

Namespace namespace

Install Status install_status

Operational status operational_status

SelfLink self_link

Relationship created for Kubernetes DaemonSet

Parent class Relationship type Child class

Kubernetes DaemonSet 
[cmdb_ci_kubernetes_daemonset]

Hosted on::Hosts Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Kubernetes Deployment [cmdb_ci_kubernetes_deployment]

The following attributes in the Kubernetes Deployment [cmdb_ci_kubernetes_deployment] table 
are populated by collected data:

Attribute label Attribute name

Kubernetes UID k8s_uid

Name name

Namespace namespace
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Attribute label Attribute name

Available Replicas available_replicas

Install Status install_status

Operational status operational_status

SelfLink self_link

Relationship created for Kubernetes Deployment

Parent class Relationship type Child class

Kubernetes Deployment 
[cmdb_ci_kubernetes_deployment]

Hosted on::Hosts Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Kubernetes Namespace [cmdb_ci_kubernetes_namespace]

The following attributes in the Kubernetes Namespace [cmdb_ci_kubernetes_namespace] table 
are populated by collected data:

Attribute label Attribute name

Kubernetes UID k8s_uid

Name name

Install Status install_status

Namespace namespace

Operational status operational_status

Kubernetes Node [cmdb_ci_kubernetes_node]

The following attributes in the Kubernetes Node [cmdb_ci_kubernetes_node] table are populated 
by collected data:

Attribute label Attribute name

Kubernetes UID k8s_uid

Name name

Install Status install_status

Operational status operational_status

Kubernetes Pod [cmdb_ci_kubernetes_pod]

The following attributes in the Kubernetes Pod [cmdb_ci_kubernetes_pod] table are populated 
by collected data:

Attribute label Attribute name

Kubernetes UID k8s_uid

Name name
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Attribute label Attribute name

Namespace namespace

Install Status install_status

IP Address ip_address

Operational status operational_status

Resource version resource_version

Relationships created for Kubernetes Pod

Parent class Relationship type Child class

Kubernetes Pod 
[cmdb_ci_kubernetes_pod]

Contains::Contained by Docker Container 
[cmdb_ci_docker_container]

Kubernetes Pod 
[cmdb_ci_kubernetes_pod]

Contains::Contained by Kubernetes Volume 
[cmdb_ci_kubernetes_volume]

Kubernetes Pod 
[cmdb_ci_kubernetes_pod]

Contains::Contained by Docker Image 
[cmdb_ci_docker_image]

Kubernetes ReplicaSet [cmdb_ci_kubernetes_replicaset]

The following attributes in the Kubernetes ReplicaSet [cmdb_ci_kubernetes_replicaset] table are 
populated by collected data:

Attribute label Attribute name

Kubernetes UID k8s_uid

Name name

Namespace namespace

Install Status install_status

Operational status operational_status

SelfLink self_link

Relationships created for Kubernetes ReplicaSet

Parent class Relationship type Child class

Kubernetes ReplicaSet 
[cmdb_ci_kubernetes_replicaset]

Hosted on::Hosts Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Kubernetes Service [cmdb_ci_kubernetes_service]

The following attributes in the Kubernetes Service [cmdb_ci_kubernetes_service] table are 
populated by collected data:

Attribute label Attribute name

Kubernetes UID k8s_uid
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Attribute label Attribute name

Name name

Namespace namespace

Install Status install_status

IP Address ip_address

Operational status operational_status

Selector selector

Kubernetes Volume [cmdb_ci_kubernetes_volume]

The following attributes in the Kubernetes Volume [cmdb_ci_kubernetes_volume] table are 
populated by collected data:

Attribute label Attribute name

Kubernetes UID k8s_uid

Mount Path mount_path

Name name

Volume ID volume_id

Install Status install_status

Namespace namespace

Operational status operational_status

Network Adapter [cmdb_ci_network_adapter]

The following attributes in the Network Adapter [cmdb_ci_network_adapter] table are populated 
by collected data:

Attribute label Attribute name

IP Address ip_address

MAC Address mac_address

Configuration Item cmdb_ci

Name name

Install Status install_status

Operational status operational_status

Relationship created for Network Adapter

Parent class Relationship type Child class

Network Adapter 
[cmdb_ci_network_adapter]

Reference Server [cmdb_ci_server], Linux 
Server [cmdb_ci_linux_server], 
or Windows Server 
[cmdb_ci_win_server]
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Server [cmdb_ci_server]

The following attributes in the Server [cmdb_ci_server] table are populated by collected data:

Attribute label Attribute name

Name name

Class sys_class_name

CPU core count cpu_core_count

CPU core thread cpu_core_thread

CPU count cpu_count

CPU name cpu_name

CPU manufacturer cpu_manufacturer

CPU speed (MHz) cpu_speed

Disk Space (GB) disk_space

DNS Domain dns_domain

Fully qualified domain name fqdn

Install Status install_status

Is Virtual virtual

Object ID object_id

Operating System os

Operational status operational_status

OS Version os_version

RAM (MB) ram

Note: 
If the AWS  Systems Manager (SSM) service isn't enabled, the connector populates the 
server records in the Server [cmdb_ci_server] class. If the AWS  SSM service is enabled, 
then based on the platform type obtained through the SSM service, the server records 
are populated in either the Linux Server [cmdb_ci_linux_server] class or the Windows 
Server [cmdb_ci_win_server] class. The Server [cmdb_ci_server] class is the parent class 
of the Linux Server [cmdb_ci_linux_server] and the Windows Server [cmdb_ci_win_server] 
classes.

Relationships created for Server

Parent class Relationship type Child class

Server [cmdb_ci_server] Virtualized by::Virtualizes Virtual Machine Instance 
[cmdb_ci_vm_instance]

Server [cmdb_ci_server] Owns::Owned by IP Address 
[cmdb_ci_ip_address]

Server [cmdb_ci_server] Owns::Owned by Network Adapter 
[cmdb_ci_network_adapter]
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Relationships created for Server  (continued)

Parent class Relationship type Child class

Server [cmdb_ci_server] Reference Software Installation 
[cmdb_sam_sw_install]

Server [cmdb_ci_server] Reference Key Value [cmdb_key_value]

Software [cmdb_ci_spkg]

The following attributes in the Software [cmdb_ci_spkg] table are populated by collected data 
when the Software Asset Management  (SAM) application isn't installed:

Attribute label Attribute name

Key key

Discovery source discovery_source

Name name

Version version

Manufacturer manufacturer

Relationship created for Software

Parent class Relationship type Child class

Software [cmdb_ci_spkg] Reference Software Instance 
[cmdb_software_instance]

Software Installation [cmdb_sam_sw_install]

The following attributes in the Software Installation [cmdb_sam_sw_install] table are populated 
by collected data when the SAM application is installed:

Attribute label Attribute name

Display name display_name

Publisher publisher

Version version

Discovery source discovery_source

Software Instance [cmdb_software_instance]

The following attributes in the Software Instance [cmdb_software_instance] table are populated 
by collected data when the SAM application isn't installed:

Attribute label Attribute name

Name name

Installed on installed_on
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Attribute label Attribute name

Install date install_date

Relationship created for Software Instance

Parent class Relationship type Child class

Software Instance 
[cmdb_software_instance]

Reference Server [cmdb_ci_server]

Storage Mapping [cmdb_ci_storage_mapping]

The following attributes in the Storage Mapping [cmdb_ci_storage_mapping] table are populated 
by collected data:

Attribute label Attribute name

Name name

Object ID object_id

Host host

Install Status install_status

Mapping Type mapping_type

Mount Point mount_point

Operational status operational_status

Relationship created for Storage Mapping

Parent class Relationship type Child class

Storage Mapping 
[cmdb_ci_storage_mapping]

Use End Point To::Use End 
Point From

Block Endpoint 
[cmdb_ci_endpoint_block]

Storage Volume [cmdb_ci_storage_volume]

The following attributes in the Storage Volume [cmdb_ci_storage_volume] table are populated by 
collected data:

Attribute label Attribute name

Object ID object_id

Volume ID volume_id

Install Status install_status

Name name

Operational status operational_status

Size size

Size bytes size_bytes
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Attribute label Attribute name

State state

Storage Type storage_type

Relationships created for Storage Volume

Parent class Relationship type Child class

Storage Volume 
[cmdb_ci_storage_volume]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Storage Volume 
[cmdb_ci_storage_volume]

Reference Key Value [cmdb_key_value]

Storage Volume Snapshot [cmdb_ci_storage_vol_snapshot]

The following attributes in the Storage Volume Snapshot [cmdb_ci_storage_vol_snapshot] table 
are populated by collected data:

Attribute label Attribute name

Name name

Object ID object_id

Install Status install_status

Operational status operational_status

Relationship created for Storage Volume Snapshot

Parent class Relationship type Child class

Storage Volume Snapshot 
[cmdb_ci_storage_vol_snapshot]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Virtual Machine Instance [cmdb_ci_vm_instance]

The following attributes in the Virtual Machine Instance [cmdb_ci_vm_instance] table are 
populated by collected data:

Attribute label Attribute name

Name name

Object ID object_id

CPUs cpus

Disks disks

Disks size (GB) disks_size

Fully qualified domain name fqdn

Install Status install_status

IP Address ip_address
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Attribute label Attribute name

Memory (MB) memory

Monitor monitor

Network adapters nics

Operational status operational_status

Placement Group ID placement_group_id

State state

VM Instance ID vm_inst_id

Relationships created for Virtual Machine Instance

Parent class Relationship type Child class

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Located in::Houses Availability Zone 
[cmdb_ci_availability_zone]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Contains::Contained by Storage Mapping 
[cmdb_ci_storage_mapping]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Provisioned From::Provisioned Image [cmdb_ci_os_template]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Provisioned From::Provisioned Cloud Hardware Type 
[cmdb_ci_cloud_hardware_type]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Provisioned From::Provisioned Hardware Type 
[cmdb_ci_compute_template]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Reference Key Value [cmdb_key_value]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Use End Point To::Use End 
Point From

Storage Volume 
[cmdb_ci_storage_volume]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Use End Point To::Use End 
Point From

Cloud Mgmt Network Interface 
[cmdb_ci_nic]

VNIC Endpoint [cmdb_ci_endpoint_vnic]

The following attributes in the VNIC Endpoint [cmdb_ci_endpoint_vnic] table are populated by 
collected data:

Attribute label Attribute name

Host host

Name name

Object ID object_id

Install Status install_status

Operational status operational_status
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Quick start tests for Service Graph Connector for AWS

Validate that Service Graph Connector for AWS still works after you make any configuration 
change such as applying an upgrade or developing an application. Copy and customize these 
quick start tests to pass when using your instance-specific data.

Danger: 
By default, the system property that is used to run automated tests is disabled to prevent 
you from accidentally running these tests on a production system. To avoid data corruption 
or an outage, run tests only on development, test, and other non-production instances. See 
Enable or disable executing Automated Test Framework tests .

SG-AWS: Service Graph Connector for AWS Validation test suite
Test suite to verify the integrity of an integration using multiple tests.

Test Description Release version

SG-AWS API Gateway Validate the ingestion of 
multiple CI records in the 
Cloud Gateway.

Utah

SG-AWS DynamoDb Validate the ingestion of 
multiple CI records in the 
DynamoDB table.

Utah

SG-AWS EC2 Loads data in the CMDB such 
as all dependent CIs such 
as Organizations, Service-
Accounts, Networks, Subnets, 
and Network-Interfaces, after 
which mock data for SG-AWS-
EC2 is prepared.

Utah

SG-AWS EKS Cluster Validates the ingestion of 
multiple CI records in the 
Kubernetes Cluster table.

Utah

SG-AWS ELB V1 Validates the ingestion of 
multiple CI records in the 
Cloud Load Balancer.

Utah

SG-AWS ELB V2 Validates the ingestion of 
multiple CI records in the 
Cloud Load Balancer.

Utah

SG-AWS Generic Resource Validates the ingestion of 
multiple CI records in the 
Cloud Resource table.

Utah

SG-AWS Hardware Type Validates the ingestion of 
multiple CI records in the 
Hardware Type table.

Utah

SG-AWS Image Id Validates the ingestion of 
multiple CI records in the 
Image table.

Utah

SG-AWS Image Private Validates the ingestion of 
multiple CI records in the 
Image table.

Utah
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SG-AWS: Service Graph Connector for AWS Validation test suite
Test suite to verify the integrity of an integration using multiple tests.

(continued)

Test Description Release version

SG-AWS Lambda Validates the ingestion of 
multiple CI records in the 
Cloud function table.

Utah

SG-AWS Network Interface Validates the ingestion of 
multiple CI records in the 
Cloud Mgmt Network Interface 
table.

Utah

SG-AWS Organization Tests RTE mappings for the 
ingestion of CIs in the Cloud 
Organization table.

Utah

SG-AWS RDS Validates the ingestion of 
mutliple CI records in the 
Cloud Database table.

Utah

SG-AWS S3 Validates the ingestion of 
multiple CI records in the 
Cloud Object Storage table.

Utah

SG-AWS Security Group Validates the ingestion of 
multiple CI records in the 
Compute Security Group 
table.

Utah

SG-AWS Service Account Tests RTE mappings for the 
ingestion of CIs in the Cloud 
Service Account table.

Utah

SG-AWS Software Inventory Validates the ingestion 
of Software Data and 
classification of CI records 
in the Server table. It 
tests whether the server 
is classified as Linux or 
Windows.

Utah

SG-AWS Software Remove Validates the removal of 
Software Data from the 
cmdb_software_instance or 
the cmdb_sam_sw_install 
table.

Utah

SG-AWS Storage Volume Loads mock import data 
for Storage Volume into 
the relevant staging table. 
Validates if fields are 
populated as expected in the 
cmdb_ci_storage_volume, 
cmdb_ci_storage_vol_snapshot, 
and 
sn_aws_extension_attributes 
tables and if the appropriate 

Utah
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SG-AWS: Service Graph Connector for AWS Validation test suite
Test suite to verify the integrity of an integration using multiple tests.

(continued)

Test Description Release version

relationships have been 
created between the inserted 
CIs.

SG-AWS SSM SendCommand Validates the ingestion of 
multiple CI records in the 
TCP Connection and Running 
Process tables. Updates 
records in the Server table.

Utah

SG-AWS Subnets Validates the ingestion of 
multiple CIs in the Cloud 
Subnet table.

Utah

SG-AWS VM Hw 
Consolidation

Validates the update of 
multiple CI records in the 
Virtual Machine Instance and 
Server table.

Utah

SG-AWS VPC Tests RTE mappings 
associated with SG-
AWS VPC Data source. 
It loads import set data 
for VPCs, Datacenters, 
Service-Acccount, and 
Organizations. Validates if 
the CIs have been added to 
the cmdb_ci_network table, 
the fields are populated with 
the expected value, and 
appropriate relationships 
verified through the 
cmdb_rel_ci table.

Utah

Related topics

Quick start tests

Accessing the connection details of Service Graph Connector for AWS

You can access the connection details of the Service Graph Connector for AWS  in a single view 
using the common connection framework (CCF) included within the Integration Commons for 
CMDB  (sn_cmdb_int_util) store app.

With the CCF, you can access all the connections used by the Service Graph Connector for AWS. 
The connection details include the connection alias, connection properties, data sources, and 
scheduled data imports associated with a connection. You can also test the connection. For 
more information, see Accessing the connection details of Service Graph Connectors.

Access the details of an AWS  connection

Access the details of an AWS  connection configured for the Service Graph Connector for AWS.
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Before you begin
Role required: admin

Procedure

1. Navigate to All  > Service Graph Connectors  > AWS  > Connections.

2. From the Name  column of the Service Graph Connections list, select a connection.

3. On the Service Graph Connections page, view the connection details such as the connection 
name, alias, and data sources.

4. Select a related list to view further details of the connection.

5. Optional:  Select the Test Connection  related link to test the connection.

Additional features within the Service Graph Connector for AWS

Use the additional features available within the Service Graph Connector for AWS  to maximize its 
use for importing data.

The following features are available within the Service Graph Connector for AWS:

Enabling optimized deletion of retired CIs in AWS

Enable the sn_aws_integ.enableOptimizedDeletion  system property 
for the optimized deletion of retired configuration items (CIs) in AWS  during delta 
import of data.

Enabling optimized SG-AWS-SendCommand  data source performance

When using the SG-AWS-Software-Inventory data source, enable the 
sn_aws_integ.is_software_inventory_enabled  system property for 
optimizing the performance of the SG-AWS-SendCommand and SG-AWS-SSM-
GetS3Object data sources.

Handling import failures for large AWS  resources

Manage the data source failure when importing resources from AWS.

Handling memory utilization errors for Service Graph Connector for AWS

Avoid the memory utilization errors when using the Service Graph Connector for 
AWS  to import a large number of CIs from an AWS  instance.

Setting up partition size with parallel loading enabled

Optimize the performance of the SG-AWS-Image-Private, SG-AWS-Tags, SG-AWS-
SendCommand, and AWS-SSM-GetS3Object  data sources by configuring the 
partition size setting in the aws_account_partition_size  connection 
property.

Disable parallel loading for Service Graph Connector for AWS data sources

Disable parallel loading for specific data sources in the Service Graph Connector for 
AWS.

Handling parallel deletion of CIs in Service Graph Connector for AWS

Optimize performance when using the Service Graph Connector for AWS  by 
enabling the parallel deletion of CIs.

Enable mapping for Cloud Os Image in AWS

Enable mapping of AWS  Cloud Os Image data to the Cloud Image 
[cmdb_ci_cloud_os_image] table.
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Enable optimized deletion of retired CIs in AWS

Enable the sn_aws_integ.enableOptimizedDeletion  system property for the 
optimized deletion of retired configuration items (CIs) in AWS  during delta import of data.

Before you begin
Set the application scope to Service Graph Connector for AWS  using the application picker. For 
more information, see Application picker .

Role required: admin

About this task
By default, the ListDiscoveredResources  API is utilized in batches of 20 to ascertain 
deleted resource data as there's no other API in AWS  that provides deleted resource deltas. 
This action adversely impacts performance, particularly with a large number of resources, as the 
majority of time is dedicated to API calls.

When your AWS  instance has a large number of CIs to import, you can enable the 
sn_aws_integ.enableOptimizedDeletion  property to accelerate the import time. 
The property enables deleting any retired CI classes with an improved logic. In this optimized 
deletion approach, a complete pull is conducted. Without depending on AWS  API calls, the 
deleted CI is determined by comparing imported resources from the last run with the resources 
imported in the current run. By default, the value of the property is set to false.

Note: 
You can use the sn_aws_integ.enableOptimizedDeletion  property only when 
you have the AWS  Config aggregator setup.

Procedure

1. Enter sys_properties.list  in the navigation filter, and then open the 
sn_aws_integ.enableOptimizedDeletion  property.

2. In the Value  field, enter true.

3. Select Update.

Enable optimized SG-AWS-SendCommand  data source performance

When the SG-AWS-Software-Inventory data source is being utilized, enable the 
sn_aws_integ.is_software_inventory_enabled  system property for optimizing the 
performance of the SG-AWS-SendCommand and SG-AWS-SSM-GetS3Object data sources.

Before you begin
Set the application scope to Service Graph Connector for AWS  using the application picker. For 
more information, see Application picker .

Role required: admin

About this task
The SG-AWS-SendCommand and SG-AWS-SSM-GetS3Object data sources utilize  SSM 
GetInventory  API calls for importing software data, impacting performance. To enhance 
the performance of the SG-AWS-SendCommand and SG-AWS-SSM-GetS3Object data 
sources, consider leveraging the SG-AWS-Software-Inventory  data source by enabling the 
sn_aws_integ.is_software_inventory_enabled  system property. This optimization 
skips a substantial number of SSM GetInventory  API calls, enhancing the performance of 
the SG-AWS-SendCommand and SG-AWS-SSM-GetS3Object data sources. However, the SG-
AWS-SendCommand and SG-AWS-SSM-GetS3Object data sources import  data from the same 
servers that are configured for the SG-AWS-Software-Inventory  data source.
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By default, the sn_aws_integ.is_software_inventory_enabled  property is set 
to false. To enhance the performance of the SG-AWS-SendCommand and SG-AWS-SSM-
GetS3Object data sources, set the sn_aws_integ.is_software_inventory_enabled 
property to true.

Procedure

1. Enter sys_properties.list  in the navigation filter, and then open the 
sn_aws_integ.is_software_inventory_enabled  property.

2. In the Value  field, enter true.

3. Select Update.

Handling import failures for large AWS  resources

Manage the data source failure when importing resources from AWS.

When importing large AWS  resources, the data sources in the Service Graph Connector for AWS 
might fail because of a Direct REST response exceeding the 1024-MB limit. For more information, 
see REST step .

You can save the response as an attachment to handle the REST response size limitation error in 
the Service Graph Connector for AWS.

Save the response as an attachment

With the save response as an attachment feature, the response of each data source is 
temporarily stored as an attachment and after the response is read, the attachment is deleted 
automatically. The save response as an attachment feature is activated by default and is 
triggered by the sn_aws_integ.save_payload_as_attachment  system property.

As a user with the admin role, you can deactivate the save response as an attachment feature by 
setting the sn_aws_integ.save_payload_as_attachment  property to false. When 
the feature is deactivated and the response size is within the limit, the data sources run normally.

Handling memory utilization errors for Service Graph Connector for AWS

You can use the SgAwsApplicationProperties  script include to avoid memory utilization 
errors when importing a large number of configuration items (CIs) from an AWS  instance via the 
Service Graph Connector for AWS.

By making multiple database calls to ingest AWS  data in smaller batches, the 
SgAwsApplicationProperties  script include avoids overloading of the Robust Transform 
Engine (RTE) and results in reduced memory usage. However, for the script include to function 
properly, verify that the AWS  Config aggregator  is enabled on your AWS  instance.

To access the script include, navigate to All  > System Definitions  > Script Includes, and then 
search for and select SgAwsApplicationProperties. For more information, see Script 
includes .

In the SgAwsApplicationProperties  script include, you can modify the functions as 
described in the following table to resolve memory utilization errors.
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SgAwsApplicationProperties script include functions

Functionality Implementation

Enable multiple database 
calls to import the AWS 
Config data.

Set the value of the isConfigDbLoadEnabled  function to 
true. For the function to work correctly, verify that the AWS 
Config aggregator is  enabled.

Note: 
Enabling isConfigDbLoadEnabled  might impact the 
import set load time as multiple database calls are being 
made instead of a single database call.

Enabling the isConfigDbLoadEnabled  function resolves 
the memory utilization error for the following data sources:

• SG-AWS-API-Gateway

• SG-AWS-DynamoDb

• SG-AWS-EC2

• SG-AWS-EKS-Cluster

• SG-AWS-ELB-V1

• SG-AWS-ELB-V2

• SG-AWS-Generic-Resources

• SG-AWS-Lambda

• SG-AWS-Network-Interface

• SG-AWS-RDS

• SG-AWS-S3

• SG-AWS-Security-Group

• SG-AWS-Storage-Volume

• SG-AWS-Subnets

• SG-AWS-VPC

Enable multiple database 
calls to import the tag-
related data from your AWS 
service account.

Set the value of the isConfigTagsDbLoadEnabled 
function to true. For the function to work correctly, 
verify that both the AWS  Config aggregator  and the 
isConfigDbLoadEnabled  function are enabled.

Enabling the isConfigTagsDbLoadEnabled  function 
facilitates the AWS  Config aggregator  to reduce the load time for 
tag-related data in the following data sources:

• SG-AWS-Lambda

• SG-AWS-DynamoDb

• SG-AWS-ELB-V1

• SG-AWS-ELB-V2

Set partition size for AWS  accounts with parallel loading enabled

When using the SG-AWS-Image-Private, SG-AWS-Tags, SG-AWS-SendCommand, and AWS-
SSM-GetS3Object  data sources, you can optimize their performance by setting the partition size 
in the aws_account_partition_size  connection property.
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Before you begin
Set the application scope to Service Graph Connector for AWS  using the application picker. For 
more information, see Application picker .

Role required: admin

About this task
The parallel loading feature is available for the SG-AWS-Image-Private, SG-AWS-Tags, SG-
AWS-SendCommand, and AWS-SSM-GetS3Object  data sources from the Washington DC 
Patch 5 release. This feature determines the number of AWS  accounts that can be executed 
as parallel jobs to retrieve configuration item (CI) data. Partition size determines how many 
AWS  accounts a single parallel-thread evaluates for data retrieval. For example, if you set the 
aws_account_partition_size  property to 5  and there are 25  AWS  accounts, the 
application generates 5  parallel jobs during data loading.

Note: 
If the aws_account_partition_size  property isn't configured, the partition size 
computation feature of the Integration Commons for CMDB  application automatically 
determines the partition size for parallel loading at runtime. See Partition size computation 
for parallel loading in Integration Commons for CMDB.

Procedure

1. Navigate to All  > Service Graph Connectors  > AWS  > Connections.

2. From the Name  column of the Service Graph Connections list, select a connection.

3. From the Property  column of the Service Graph Connection Properties related list, select 
aws_account_partition_size.

4. In the Value  field, enter a numeric value greater than 0  for the partition size.

5. Select Update.

Disable parallel loading for Service Graph Connector for AWS  data sources

You can disable parallel loading for specific data sources in the Service Graph Connector for 
AWS.

Before you begin
Set the application scope to Service Graph Connector for AWS  using the application picker. For 
more information, see Application picker .

Role required: admin

Procedure

1. Navigate to All  > Service Graph Connectors  > AWS  > Data sources.

2. From the list of data sources, open the data source for which you want to disable parallel 
loading.

3. Clear the Enable parallel loading  check box.

4. Select Update.

Handling parallel deletion of CIs in Service Graph Connector for AWS

Parallel deletion of configuration items (CIs) in the Service Graph Connector for AWS  optimizes 
performance.

The parallel deletion feature is available for the following data sources from Washington DC 
patch 5 after the parallel job plugin is activated:
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• SG-AWS-API-Gateway

• SG-AWS-DynamoDb

• SG-AWS-EC2

• SG-AWS-ELB-V1

• SG-AWS-ELB-V2

• SG-AWS-Generic-Resources

• SG-AWS-Lambda

• SG-AWS-Network-Interface

• SG-AWS-RDS

• SG-AWS-S3

• SG-AWS-Security-Group

• SG-AWS-Storage-Volume

• SG-AWS-Subnets

• SG-AWS-VPC

Note: 
If you upgraded to Service Graph Connector for AWS  version 2.9.1 before the parallel job 
plugin was activated, you must run the SGC - Parallel Loading Fix  script to 
enable parallel deletion.

Multiple jobs are created for deleting CIs based on the number of accounts in your configuration. 
You can modify the number of jobs that are created by setting the partition size in the 
aws_account_partition_size  connection property. See Set partition size for AWS 
accounts with parallel loading enabled.

Note: 
Only one job is created to import new and updated CIs.

Enable mapping for Cloud Os Image in AWS

Enable the sn_cmdb_ci_class.use_single_cloud_os_image  system property to add 
Cloud Os Image data to the Cloud Image [cmdb_ci_cloud_os_image] table instead of adding the 
data to the Image [cmdb_ci_os_template] table.

Before you begin
Set the application scope to Service Graph Connector for AWS  using the application picker. For 
more information, see Application picker .

Role required: admin

About this task
In Service Graph Connector for AWS  version 2.9.1 and earlier, the Cloud Os Image data was 
added to the Image [cmdb_ci_os_template] table. Multiple records were created for the same 
image because the Image [cmdb_ci_os_template] table is a dependent class. Starting with 
the Service Graph Connector for AWS  2.10.0 version, Cloud Os Image data is added to the 
Cloud Image [cmdb_ci_cloud_os_image] table, which is an independent class, when the 
sn_cmdb_ci_class.use_single_cloud_os_image  system property is enabled.
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Procedure

1. Enter sys_properties.list  in the navigation filter, and then open the 
sn_cmdb_ci_class.use_single_cloud_os_image  property.

2. In the Value  field, enter true.

3. Select Update.

Service Graph Connector for AWS  reference

Reference topics provide additional information about Service Graph Connector for AWS 
components.

Supported AWS  resource types

Several AWS  resource types are imported as CMDB  data by the Service Graph Connector for 
AWS.

AWS  Config resources

When the AWS  Config aggregator is enabled, the following APIs are invoked:

• ListDiscoveredResources

• BatchGetAggregateResourceConfig

• SelectAggregateResourceConfig

When the AWS  Config aggregator is disabled, the following APIs are invoked:

• ListDiscoveredResources

• SelectResourceConfig

• BatchGetResourceConfigAction

Note: 
For a list of AWS  resource types supported by AWS  Config, see Supported Resource 
Types  on the AWS  documentation site.

CMDB  CI classes and AWS  Config resources

CMDB  CI classes
AWS  resource 
type

AWS  Config resource identifier

Cloud Network [cmdb_ci_network]
Amazon VPC AWS::EC2::VPC

Cloud Subnet 
[cmdb_ci_cloud_subnet]

Amazon 
subnet

AWS::EC2::Subnet

Cloud Mgmt Network Interface 
[cmdb_ci_nic]

Amazon 
Elastic 
network 
interface

AWS::EC2::NetworkInterface
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CMDB  CI classes and AWS  Config resources  (continued)

CMDB  CI classes
AWS  resource 
type

AWS  Config resource identifier

Compute Security Group 
[cmdb_ci_compute_security_group] Amazon 

EC2 security 
group

AWS::EC2::SecurityGroup

Storage Volume 
[cmdb_ci_storage_volume] Amazon EBS 

volume
AWS::EC2::Volume

Cloud Load Balancer 
[cmdb_ci_cloud_load_balancer]

Classic load 
balancer

AWS::ElasticLoadBalancing::LoadBalancer

Cloud Load Balancer 
[cmdb_ci_cloud_load_balancer]

Application 
load 
balancer, 
network load 
balancer, or 
gateway load 
balancer

AWS::ElasticLoadBalancingV2::LoadBalancer

Cloud Gateway 
[cmdb_ci_cloud_gateway]

API gateway 
with 
WebSocket 
APIs or HTTP 
APIs

AWS::ApiGatewayV2::Api

Virtual Machine Instance 
[cmdb_ci_vm_instance] Amazon EC2 

instance
AWS::EC2::Instance

Server [cmdb_ci_server] Amazon EC2 
instance

AWS::EC2::Instance

Cloud DataBase 
[cmdb_ci_cloud_database] Amazon RDS 

DB instance
AWS::RDS::DBInstance

Cloud Function 
[cmdb_ci_cloud_function]

Lambda 
function

AWS::Lambda::Function

Cloud Object Storage 
[cmdb_ci_cloud_object_storage]

Amazon S3 
bucket

AWS::S3::Bucket

DynamoDB Table 
[cmdb_ci_dynamodb_table]

DynamoDB 
table

AWS::DynamoDB::Table
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CMDB  CI classes and AWS  Config resources  (continued)

CMDB  CI classes
AWS  resource 
type

AWS  Config resource identifier

Software [cmdb_ci_spkg] Software 
configuration 
for managed 
instances

AWS::SSM::ManagedInstanceInventory

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Amazon EKS 
cluster

AWS::EKS::Cluster

Amazon Redshift 
[cmdb_ci_aws_redshift]

Amazon 
Redshift

AWS::Redshift::Cluster

Amazon EC2 resources

CMDB  CI classes and Amazon EC2 resources

CMDB  CI classes AWS  resource type AWS  API action

Availability Zone [cmdb_ci_availability_zone] AWS availability zone None

Hardware Type 
[cmdb_ci_compute_template] Amazon EC2 instance 

types

DescribeInstanceTypes

Image [cmdb_ci_os_template] Amazon Machine Image 
(AMI)

DescribeImages

Cloud Image [cmdb_ci_cloud_os_image] Amazon Machine Image 
(AMI)

DescribeImages

Cloud Hardware Type 
[cmdb_ci_cloud_hardware_type]

Amazon EC2 instance 
types

DescribeInstanceTypes

AWS Systems Manager resources

All AWS Systems Manager  resources invoke the SendCommand  API action.

CMDB  CI classes and AWS Systems Manager resources

CMDB  CI classes AWS  resource type AWS  API action

Running Process [cmdb_running_process] Running process in EC2 
instances

SendCommand

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

966

https://docs.aws.amazon.com/AWSEC2/latest/APIReference/API_DescribeInstanceTypes.html
https://docs.aws.amazon.com/AWSEC2/latest/APIReference/API_DescribeInstanceTypes.html
https://docs.aws.amazon.com/AWSEC2/latest/APIReference/API_DescribeInstanceTypes.html
https://docs.aws.amazon.com/AWSEC2/latest/APIReference/API_DescribeImages.html
https://docs.aws.amazon.com/AWSEC2/latest/APIReference/API_DescribeImages.html
https://docs.aws.amazon.com/AWSEC2/latest/APIReference/API_DescribeImages.html
https://docs.aws.amazon.com/AWSEC2/latest/APIReference/API_DescribeImages.html
https://docs.aws.amazon.com/AWSEC2/latest/APIReference/API_DescribeImages.html
https://docs.aws.amazon.com/AWSEC2/latest/APIReference/API_DescribeImages.html
https://docs.aws.amazon.com/AWSEC2/latest/APIReference/API_DescribeInstanceTypes.html
https://docs.aws.amazon.com/AWSEC2/latest/APIReference/API_DescribeInstanceTypes.html
https://docs.aws.amazon.com/AWSEC2/latest/APIReference/API_DescribeInstanceTypes.html
https://docs.aws.amazon.com/systems-manager/latest/APIReference/API_SendCommand.html
https://docs.aws.amazon.com/systems-manager/latest/APIReference/API_SendCommand.html
https://docs.aws.amazon.com/systems-manager/latest/APIReference/API_SendCommand.html
https://docs.aws.amazon.com/systems-manager/latest/APIReference/API_SendCommand.html
https://docs.aws.amazon.com/systems-manager/latest/APIReference/API_SendCommand.html
https://docs.aws.amazon.com/systems-manager/latest/APIReference/API_SendCommand.html


CMDB  CI classes and AWS Systems Manager resources  (continued)

CMDB  CI classes AWS  resource type AWS  API action

TCP Connections [cmdb_tcp] TCP connections in EC2 
instances

Kubernetes Node [cmdb_ci_kubernetes_node] Amazon EKS node

Kubernetes Pod [cmdb_ci_kubernetes_pod] Amazon EKS pod

Kubernetes Service 
[cmdb_ci_kubernetes_service]

Amazon EKS service

Kubernetes DaemonSet 
[cmdb_ci_kubernetes_daemonset]

Kubernetes DaemonSet

Kubernetes Namespace 
[cmdb_ci_kubernetes_namespace]

Kubernetes namespace

Kubernetes Deployment 
[cmdb_ci_kubernetes_deployment]

Kubernetes deployment

Docker Container [cmdb_ci_docker_container] Docker container

Kubernetes Volume 
[cmdb_ci_kubernetes_volume]

Kubernetes Volume

Organizations resources

CMDB  CI classes and organizations

CMDB  CI classes
AWS  resource 
type

AWS  API action

Cloud Organizations [cmdb_ci_cloud_org] AWS 
Organizations

DescribeOrganization

Cloud Service Account 
[cmdb_ci_cloud_service_account]

AWS  accounts ListAccounts

AWS Datacenter [cmdb_ci_aws_datacenter]
AWS  regions DescribeRegions

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

967

https://docs.aws.amazon.com/organizations/latest/APIReference/API_DescribeOrganization.html
https://docs.aws.amazon.com/organizations/latest/APIReference/API_DescribeOrganization.html
https://docs.aws.amazon.com/organizations/latest/APIReference/API_DescribeOrganization.html
https://docs.aws.amazon.com/organizations/latest/APIReference/API_ListAccounts.html
https://docs.aws.amazon.com/organizations/latest/APIReference/API_ListAccounts.html
https://docs.aws.amazon.com/organizations/latest/APIReference/API_ListAccounts.html
https://docs.aws.amazon.com/AWSEC2/latest/APIReference/API_DescribeRegions.html
https://docs.aws.amazon.com/AWSEC2/latest/APIReference/API_DescribeRegions.html
https://docs.aws.amazon.com/AWSEC2/latest/APIReference/API_DescribeRegions.html


Resource Group Tagging resources

CMDB  CI class and resource group tagging

CMDB  classes AWS  resource type
AWS  API 
action

Key Value 
[cmdb_key_value]

Tags for AWS Lambda, Amazon DynamoDB, ELBv1, 
and ELBv2

GetResources

Generic resources

Generic resources are stored in the Cloud Resource [cmdb_ci_cmp_resource] CMDB  CI class.

CMDB  CI classes and generic resources

CMDB  CI class AWS  resource type AWS API action

State Manager 
association compliance

AWS::SSM::AssociationCompliance

Database subnet group AWS::RDS::DBSubnetGroup

AWS WAF rate based 
rule

AWS::WAF::RateBasedRule

AWS WAF regional rule 
group

AWS::WAFRegional::RuleGroup

AWS WAF regional rate 
based rule

AWS::WAFRegional::RateBasedRule

Managed policies and 
inline policies

AWS::IAM::Policy

AWS WAF Web ACL rule AWS::WAF::WebACL

AWS WAF Regional 
Web ACL rule

AWS::WAFRegional::WebACL

AWS Certificate 
Manager (ACM) 
certificate

AWS::ACM::Certificate

Cloud Resource 
[cmdb_ci_cmp_resource]

Amazon EC2 Auto 
Scaling group

AWS::AutoScaling::AutoScalingGroup
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CMDB  CI classes and generic resources  (continued)

CMDB  CI class AWS  resource type AWS API action

IAM user for AWS 
account

AWS::IAM::User

Amazon Redshift event 
subscription

AWS::Redshift::EventSubscription

Amazon RDS DB 
snapshot

AWS::RDS::DBSnapshot

Amazon Redshift cluster 
parameter group

AWS::Redshift::ClusterParameterGroup

Amazon EC2 Auto 
Scaling group launch 
configuration

AWS::AutoScaling::LaunchConfiguration

Amazon Redshift cluster 
snapshot

AWS::Redshift::ClusterSnapshot

AWS CloudFormation 
stack

AWS::CloudFormation::Stack

AWS CodeBuild project AWS::CodeBuild::Project

AWS Elastic Beanstalk 
application version

AWS::ElasticBeanstalk::ApplicationVersion

AWS CodePipeline 
pipeline

AWS::CodePipeline::Pipeline

Amazon Redshift 
security group

AWS::Redshift::ClusterSecurityGroup

Amazon CloudFront 
distribution

AWS::CloudFront::Distribution

AWS CloudTrail trail AWS::CloudTrail::Trail

Amazon CloudFront 
streaming distribution

AWS::CloudFront::StreamingDistribution
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CMDB  CI classes and generic resources  (continued)

CMDB  CI class AWS  resource type AWS API action

AWS WAF rule group AWS::WAF::RuleGroup

Amazon RDS DB 
security group

AWS::RDS::DBSecurityGroup

Amazon RDS event 
subscription

AWS::RDS::EventSubscription

AWS WAF regional rule AWS::WAFRegional::Rule

AWS WAF rule AWS::WAF::Rule

IAM role for AWS 
account

AWS::IAM::Role

Amazon EC2 Auto 
Scaling scheduled 
action

AWS::AutoScaling::ScheduledAction

AWS Elastic Beanstalk 
environment

AWS::ElasticBeanstalk::Environment

AWS Redshift cluster AWS::Redshift::Cluster

Amazon EC2 Auto 
Scaling group scaling 
policy

AWS::AutoScaling::ScalingPolicy

AWS Shield protected 
AWS resource

AWS::Shield::Protection

Amazon CloudWatch 
alarm

AWS::CloudWatch::Alarm

EncryptionConfig - AWS 
X-Ray

AWS::XRay::EncryptionConfig

AWS Shield protected 
AWS region

AWS::ShieldRegional::Protection
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CMDB  CI classes and generic resources  (continued)

CMDB  CI class AWS  resource type AWS API action

Amazon Redshift 
subnet group

AWS::Redshift::ClusterSubnetGroup

AWS Elastic Beanstalk 
application

AWS::ElasticBeanstalk::Application

IAM group for AWS 
account

AWS::IAM::Group

Life cycle management of records in Service Graph Connector for AWS

Life cycle management in the Service Graph Connector for AWS  monitors and updates the 
statuses of AWS  resources throughout their entire life cycle, from creation to deletion.

The life cycle management process helps maintain the accuracy and integrity of data in the 
Configuration Management Database (CMDB).

In life cycle management, the record removal process involves systematically deleting obsolete 
or unnecessary resources. This step ensures that outdated entries are cleared, keeping the 
CMDB  accurate and up-to-date. See Record removal process in Service Graph Connector for 
AWS.

Life cycle management for CIs in Service Graph Connector for AWS

The following table lists the configuration items (CIs) in CMDB  and other non-CMDB  tables for 
which life cycle management is available in Service Graph Connector for AWS.

Supported tables for life cycle management

Data source CMDB  CI classes
Life cycle management 
available

SG-AWS-Organization Cloud Organizations [cmdb_ci_cloud_org] Yes

SG-AWS-Org-Units AWS Organizational Unit 
[cmdb_ci_aws_org_unit]

Yes

SG-AWS-Service-
Account

Cloud Service Account 
[cmdb_ci_cloud_service_account]

Yes

SG-AWS-Service-
Account-Tags

Key Value [cmdb_key_value] No

SG-AWS-Org-Unit-
Accounts

None No

SG-AWS-Datacenters AWS Datacenter [cmdb_ci_aws_datacenter] No

SG-AWS-VPC Network Adapter [cmdb_ci_network_adapter] Yes

Availability Zone [cmdb_ci_availability_zone] NoSG-AWS-Subnets

Cloud Subnet [cmdb_ci_cloud_subnet] Yes
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Supported tables for life cycle management  (continued)

Data source CMDB  CI classes
Life cycle management 
available

SG-AWS-Network-
Interface

Cloud Mgmt Network Interface [cmdb_ci_nic] Yes

SG-AWS-Security-
Group

Compute Security Group 
[cmdb_ci_compute_security_group]

Yes

Storage Volume [cmdb_ci_storage_volume] YesSG-AWS-Storage-
Volume

Storage Volume Snapshot 
[cmdb_ci_storage_vol_snapshot]

Yes

SG-AWS-Image-Private Image [cmdb_ci_os_template] Yes

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Yes

Server [cmdb_ci_server] Yes

Block Endpoint [cmdb_ci_endpoint_block] Yes

VNIC Endpoint [cmdb_ci_endpoint_vnic] Yes

Storage Mapping 
[cmdb_ci_storage_mapping]

Yes

Image [cmdb_ci_os_template] Yes

SG-AWS-EC2

IP Address [cmdb_ci_ip_address] Yes

SG-AWS-Image-Id Image [cmdb_ci_os_template] Yes

SG-AWS-Hardware-
Type

Hardware Type [cmdb_ci_compute_template] Yes

SG-AWS-VM-Hw-
Consolidation

None No

SG-AWS-ELB-V1 Cloud Load Balancer 
[cmdb_ci_cloud_load_balancer]

Yes

SG-AWS-ELB-V2 Cloud Load Balancer 
[cmdb_ci_cloud_load_balancer]

Yes

SG-AWS-RDS Cloud DataBase [cmdb_ci_cloud_database] Yes

SG-AWS-S3 Cloud Object Storage 
[cmdb_ci_cloud_object_storage]

Yes

SG-AWS-DynamoDb DynamoDB Table [cmdb_ci_dynamodb_table] Yes

SG-AWS-API-Gateway Cloud Gateway [cmdb_ci_cloud_gateway] Yes

SG-AWS-Lambda Cloud Function [cmdb_ci_cloud_function] Yes

Software Installation [cmdb_sam_sw_install] No

Software [cmdb_ci_spkg] No

SG-AWS-Software-
Inventory

Software Instance [cmdb_software_instance] No

SG-AWS-Software-
Remove

None No
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Supported tables for life cycle management  (continued)

Data source CMDB  CI classes
Life cycle management 
available

TCP Connections [cmdb_tcp] No

Running [cmdb_running_process] No

SG-AWS-SSM-
SendCommand

Application [cmdb_ci_appl] No

SG-AWS-Tags Key Value [cmdb_key_value] No

SG-AWS-EKS-Cluster Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Yes

SG-AWS-EKS-Cluster-2 None No

Kubernetes Namespace 
[cmdb_ci_kubernetes_namespace]

Yes

Kubernetes Node 
[cmdb_ci_kubernetes_node]

Yes

Kubernetes Service 
[cmdb_ci_kubernetes_service]

Yes

Kubernetes Pod [cmdb_ci_kubernetes_pod] Yes

Docker Container 
[cmdb_ci_docker_container]

Yes

Kubernetes Volume 
[cmdb_ci_kubernetes_volume]

Yes

Kubernetes Deployment 
[cmdb_ci_kubernetes_deployment]

Yes

Kubernetes DaemonSet 
[cmdb_ci_kubernetes_daemonset]

Yes

SG-AWS-EKS-FULL

Kubernetes ReplicaSet 
[cmdb_ci_kubernetes_replicaset]

Yes

SG-AWS-Generic-
Resources

Cloud Resource [cmdb_ci_cmp_resource] Yes

SG-AWS-Redshift-
Cluster

Amazon Redshift [cmdb_ci_aws_redshift] Yes

SG-AWS-Generic-Tags Key Value [cmdb_key_value] No

SG-AWS-Get-Inventory Server [cmdb_ci_server] Yes

Record removal process in Service Graph Connector for AWS

The Service Graph Connector for AWS  uses the optimized deletion approach to manage removal 
of records.

Record removal is the process of handling data that is no longer needed. For any discovered 
resources deleted later after pulling data, the Service Graph Connector for AWS  automatically 
updates the Install Status  field of the associated CMDB  CI classes to indicate any retired or 
deleted records.
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Deletion of records in Service Graph Connector for AWS  involves marking the install status of a 
record as retired  rather than permanently deleting it from the system. The record remains in the 
database, making it possible to reference or restore it later. Deletion for Service Graph Connector 
for AWS  relies on the Source [sys_object_source table], which can become inefficient with large 
datasets.

To enhance the deletion process, you can enable the optimized deletion method that leverages 
the SG-AWS Extension Attributes [sn_aws_extension_attributes] table. This table is regularly 
purged of obsolete records, improving performance and efficiency. The process still marks 
the install status of a record as retired  but the streamlined data structure reduces overhead, 
ensuring quicker processing and better system performance. See Enable optimized deletion of 
retired CIs in AWS.

Optimized deletion is enabled for all tables in the Service Graph Connector for AWS, except for 
the following tables:

Hardware Type [cmdb_ci_compute_template], Availability Zone [cmdb_ci_availability_zone], 
AWS Datacenter [cmdb_ci_aws_datacenter], Running Process [cmdb_running_proces], TCP 
Connections [cmdb_tcp], and Application [cmdb_ci_appl]

Service Graph Connector for ExtraHop

Use the Service Graph Connector for ExtraHop to pull data from the ExtraHop application into 
your ServiceNow  instance.

Important: 
Starting with the Vancouver  release, the ServiceNow  hosted Service Graph Connector for 
Extrahop  is being prepared for future deprecation. It will be hidden and no longer activated 
on new instances but will continue to be supported. The Extrahop hosted Service Graph 
Connector for Extrahop  provides the latest experience for this functionality. For details, see 
the Deprecation Process [KB0867184]  article in the Now Support  Knowledge Base.

The Service Graph Connector for ExtraHop provides real-time network visibility across your 
enterprise by implementing stream processing, so that you can transform your network data into 
structured wire data.

The Service Graph Connector for ExtraHop pulls network visibility data into the ServiceNow® 

Configuration Management Database (CMDB)  application. The connector enriches discovered 
device data and establishes relationships between devices based on network traffic flow.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

System requirements and supported versions

Dependencies and requirements:

• MID Server that is installed on Linux or Windows, unless the ExtraHop appliance is publicly 
accessible.

• ExtraHop Discover appliance with firmware version 7.2 or later with a user account that has 
unlimited privileges.

• Supported versions: ExtraHop v7.9.

• Supported ServiceNow  versions:

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

974

https://support.servicenow.com/kb_view.do?sysparm_article=KB0867184
https://support.servicenow.com/kb_view.do?sysparm_article=KB0867184
https://support.servicenow.com/kb_view.do?sysparm_article=KB0867184
https://store.servicenow.com/sn_appstore_store.do#!/store/home
https://store.servicenow.com/sn_appstore_store.do#!/store/home
https://store.servicenow.com/sn_appstore_store.do#!/store/home
https://docs.servicenow.com/bundle/store-release-notes/page/release-notes/store/sn-store-release-notes.html
https://docs.servicenow.com/bundle/store-release-notes/page/release-notes/store/sn-store-release-notes.html
https://docs.servicenow.com/bundle/store-release-notes/page/release-notes/store/sn-store-release-notes.html
https://docs.servicenow.com/bundle/store-release-notes/page/release-notes/store/sn-store-release-notes.html


◦ Tokyo

◦ Utah

◦ Vancouver

◦ Washington DC

Use cases

The following are examples on how you can use the Service Graph Connector:

• Identification of network interactions between CIs.

• Discovery of network traffic flow data between computers or other types of hardware.

• Creation of relationships between devices. The relationships are based on network traffic flow.

Guided setup

The guided setup for the Service Graph Connector for ExtraHop provides an organized sequence 
of tasks to configure the integration on your instance. To access the guided setup, see Configure 
Service Graph Connector for ExtraHop.

CMDB Integrations Dashboard

The Integration Commons for CMDB  store app provides a dashboard with a central view of the 
status, processing results, and processing errors of all installed Service Graph Connectors. 
You can see metrics for all integration runs. You can also filter the view to a specific CMDB 
integration, a specific time duration, or a specific integration run. For more details about 
monitoring ExtraHop integrations in the CMDB  Integrations Dashboard, see Using the CMDB 
Integrations Dashboard.

Data mapping

Data from data sources in the ExtraHop application is mapped and transformed into the 
ServiceNow  CMDB  Configuration Item (CI) class definitions using the Robust Transform Engine 
(RTE). Data is inserted into the ServiceNow  CMDB  using the Identification and Reconciliation 
Engine (IRE).

When you complete setting up the connection, you can configure the integration to periodically 
pull data from the ExtraHop application. The data is loaded into the following staging tables:

• ExtraHop Computer [sn_extrahop_integr_computer]

• ExtraHop Network Activity [sn_extrahop_integr_activity]

The data is then inserted into the following target tables:

• CI Relationship [cmdb_rel_ci]

• Hardware [cmdb_ci_hardware]

• IP Address [cmdb_ci_ip_address]

• Network Adapter [cmdb_ci_network_adapter]

Related topics

Service Graph Connectors

Configure Service Graph Connector for ExtraHop

Set up a REST message and scheduled jobs to import ExtraHop data into your CMDB.
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Before you begin

Important: 
Starting with the Vancouver  release, the ServiceNow  hosted Service Graph Connector for 
Extrahop  is being prepared for future deprecation. It will be hidden and no longer activated 
on new instances but will continue to be supported. The Extrahop hosted Service Graph 
Connector for Extrahop  provides the latest experience for this functionality. For details, see 
the Deprecation Process [KB0867184]  article in the Now Support  Knowledge Base.

To use this Service Graph Connector, you need a subscription to a Subscription Unit that is 
based in the IT Operations Management  (ITOM) Visibility application or in the ITOM  Discovery 
application. As defined in the section titled "Managed IT Resource Types" in ServiceNow 
Subscription Unit Overview  for your subscription, for managed IT resources that are created 
or modified in the CMDB  by this Service Graph Connector, but that aren’t yet managed by ITOM 
Visibility or ITOM Discovery , these resources will increase Subscription Unit consumption from 
that application. Review your current Subscription Unit consumption within ITOM Visibility or 
ITOM Discovery to ensure available capacity.

Dependencies and requirements:

• The Integration Commons for CMDB  store app, which is automatically installed.

• The CMDB CI class models store app, which is automatically installed. See CMDB CI Class 
Models store app.

• ITOM Licensing plugin (com.snc.itom.license). For more information, see Request Discovery .

• ITOM Discovery License plugin (com.snc.itom.discovery.license). You must activate this plugin.

• MID Server that is installed on Linux or Windows, unless the ExtraHop appliance is publicly 
accessible.

• ExtraHop Discover appliance with firmware version 7.2 or later, with a user account that has 
unlimited privileges.

• To connect to the ExtraHop application, configure an API key. For more information, see 
ExtraHop REST API Guide , specifically, see the "ExtraHop API requirements" section.

Roles required: admin

Procedure

1. Navigate to All  > Service Graph Connector ExtraHop  > Setup.

2. On the Getting started page, click Get Started.

3. On the Service Graph Connector for the ExtraHop page, in the Configure REST message 
section, select the task Configure ExtraHop REST message.

4. Configure a REST message to use when sending requests to the ExtraHop API.

a. On the next page, in the Configure ExtraHop REST message task section, click Configure.

b. On the form, fill in the fields.

REST Message form

Field Description

Name Descriptive name for this REST Message. 
This field is automatically set.
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Field Description

Endpoint URL to the web service API endpoint. 
Set the field to a base URL. For example, 
https://myextrahop.com.

Note: 
Updating the Endpoint base URL also 
updates the base URLs for all HTTP 
methods that are associated with the 
ExtraHop REST message. In the HTTP 
Request  tab, update the Authorization 
header to use your API key in the Value 
field.

Description Description for this REST Message. This field 
is automatically set.

Application Application that contains this message. The 
field is automatically set.

Authentication type Type of authentication to apply to HTTP 
requests. The field is automatically set.

Use mutual authentication Option to use multiple authentication by 
authenticating HTTP requests. Mutual 
authentication cannot be used with a MID 
Server.

c. Click Update  if necessary.

d. In the Configure ExtraHop REST message task section, click Mark as Complete.

5. Test the connection to the ExtraHop Computer API.

a. In the Test Computer connection task section, click Configure.

b. On the form, fill in the fields.

HTTP Method form

Field Description

Name Unique identifier for this HTTP method. This 
field is automatically set.

Endpoint URL to the web service API endpoint

Use MID Server MID Server that sends this HTTP request. 
Using a MID Server is not compatible with 
mutual authentication.

REST Message REST message record that this method is 
based on. This field is automatically set.

HTTP method HTTP method that is implemented by this 
method. This field is automatically set.
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Field Description

Application Application that contains this method. This 
field is automatically set.

Authentication type Type of authentication to apply to HTTP 
requests.

Use mutual authentication Option to use multiple authentication by 
authenticating HTTP requests. Mutual 
authentication cannot be used with a MID 
Server.

c. Select the HTTP Request  tab and fill out the Use MID Server  field.

d. Click the Authentication  tab and then click the Test  related link.
Testing the connection takes a few moments. When the test is complete, the page is 
refreshed and shows the test results.

e. Select Mark as Complete.

Note: 
The connection is successful if the HTTP Status  field is set to 200. If there are 
any errors in the Error Message  field, then the connection failed and further 
troubleshooting is required.

f. Click Update  if necessary.

g. In the Test Computer connection task section, click Mark as Complete.

6. Test the connection to the ExtraHop Network Activity Create API.

a. In the Test Network Activity Create connection task section, click Configure.

b. On the form, fill in the fields.

HTTP Method form

Field Description

Name Unique identifier for this HTTP method.

Endpoint URL to the web service API endpoint

Use MID Server MID Server that sends this HTTP request. 
Using a MID Server is not compatible with 
mutual authentication.

REST Message REST message that this method is based on. 
This field is automatically set.

HTTP method HTTP method that is implemented by this 
method. This field is automatically set.

Application Application that contains this record. This 
field is automatically set.
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Field Description

Authentication type Type of authentication to apply to HTTP 
requests. This field is automatically set.

Use mutual authentication Option to use multiple authentication by 
authenticating HTTP requests. Mutual 
authentication cannot be used with a MID 
Server.

c. Click the Authentication  tab and then click the Test  related link.
Testing the connection takes a few moments. When the test is complete, the page is 
refreshed and shows the test results.

d. Select Mark as Complete.

Note: 
The connection is successful if the HTTP Status  field is set to 200. If there are 
any errors in the Error Message  field, then the connection failed and further 
troubleshooting is required.

e. Click Update  if necessary.

f. In the Test Network Activity Create connection task section, click Mark as Complete.

7. Set up the scheduled import jobs.

a. On the Service Graph Connector for ExtraHop page, in the Set up scheduled import jobs 
section, select the task Configure Computer scheduled job.

b. In the Configure Computer scheduled job task section, click Configure.

c. On the form, fill in the fields.

Scheduled Data Import form

Field Description

Name Name of the scheduled job.

Data source Data source record that defines the data to 
import.

Run as Option to run the scheduled job with the 
credentials of the specified user.

Active Option to activate the scheduled job. Select 
this option.

Concurrent Import Function that loads the data from multiple 
import sets. The function then processes 
and transforms the data concurrently.

Partition Method Partition method for the concurrent import 
set.

Partition Size Import set size for early scheduling.
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Field Description

Execute pre-import script Option to specify a script to run before the 
import is performed.

Execute post-import script Option to specify a script to run after the 
import is performed.

Application Application that contains this scheduled job.

Run Frequency of running the import.

Conditional Conditions under which this job is executed.

d. Click Update  if necessary.

e. In the Configure Computer scheduled job task section, click Mark as Complete.

8. Configure the Network Activity scheduled job.

a. On the Service Graph Connector for ExtraHop page, in the Set up scheduled import jobs 
section, select the task Configure Network Activity scheduled job.

b. In the Configure Network Activity scheduled job task section, click Configure.

c. On the form, fill in the fields.

Scheduled Data Import form

Field Description

Name Name of the scheduled job.

Data source Data source record that defines the data to 
import.

Run as Option to run the scheduled job with the 
credentials of the specified user.

Active Option to activate the scheduled job. Select 
this option.

Concurrent Import Function that loads the data from multiple 
import sets. The function then processes 
and transforms the data concurrently.

Partition Method Partition method for the concurrent import 
set.

Partition Size Import set size for early scheduling.

Execute pre-import script Option to specify a script to run before the 
import is performed.

Execute post-import script Option to specify a script to run after the 
import is performed.

Application Application that contains this scheduled job.

Run Frequency of running the import.
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Field Description

Conditional Conditions under which this job is executed.

d. Click Update  if necessary then Mark as Complete.

CMDB  classes targeted in Service Graph Connector for ExtraHop

When you complete setting up the connection, you can configure the integration to periodically 
pull data from ExtraHop. The data is saved in tables that extend from the Configuration item 
[cmdb_ci] table.

Important: 
Starting with the Vancouver  release, the ServiceNow  hosted Service Graph Connector for 
Extrahop  is being prepared for future deprecation. It will be hidden and no longer activated 
on new instances but will continue to be supported. The Extrahop hosted Service Graph 
Connector for Extrahop  provides the latest experience for this functionality. For details, see 
the Deprecation Process [KB0867184]  article in the Now Support  Knowledge Base.

The following attributes in the Hardware [cmdb_ci_hardware] table are populated by collected 
data:

Attribute label Attribute name

Name name

Manufacturer manufacturer

Relationships created for Hardware

Parent class Relationship type Child class

Hardware [cmdb_ci_hardware] Owns::Owned by IP Address 
[cmdb_ci_ip_address]

Hardware [cmdb_ci_hardware] Owns::Owned by Network Adapter 
[cmdb_ci_network_adapter]

Hardware [cmdb_ci_hardware] Receives data from::Sends 
data to

Hardware [cmdb_ci_hardware]

The following attributes in the IP Address [cmdb_ci_ip_address] table are populated by collected 
data:

Attribute label Attribute name

IP Address ip_address

IP version ip_version

Name name

Nic nic
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Relationship created for IP Address

Parent class Relationship type Child class

IP Address 
[cmdb_ci_ip_address]

Reference Network Adapter 
[cmdb_ci_network_adapter]

The following attributes in the Network Adapter [cmdb_ci_network_adapter] table are populated 
by collected data:

Attribute label Attribute name

Name name

Configuration Item cmdb_ci

MAC Address mac_address

Relationship created for Network Adapter

Parent class Relationship type Child class

Network Adapter 
[cmdb_ci_network_adapter]

Reference Hardware [cmdb_ci_hardware]

Service Graph Connector for GCP

Use the Service Graph Connector for GCP  to ingest CMDB  data from a Google Cloud Platform 
(GCP)  project using the REST APIs.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Key features

• Get started quickly with a streamlined onboarding process.

• Use only the credentials you need.

• No MID Server required.

• Get end-to-end data coverage.

• No agents or individual scanning needed.

• Performant at scale.

Supported versions

Versions

GCP ServiceNow

Last tested on July 16, 2025 • Washington DC

• Xanadu
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Versions  (continued)

GCP ServiceNow

• Yokohama

• Zurich

Use cases

You can use the Service Graph Connector for GCP  to get visibility into cloud resource identities, 
relationships, and state in real-time.

Important information for upgrading Service Graph Connector for GCP

After you've installed the latest version of the Service Graph Connector for GCP, you must 
synchronize the newly added data sources. Use the Advanced Setup  section in the guided setup 
to synchronize data sources. For more information, see Configure Service Graph Connector for 
GCP.

Configuring a connection for the connector

You can configure a connection for the connector by using the SGC Central  view in the CMDB 
Workspace. The view enables you to discover and install connectors, and then effectively 
manage the full life cycle of creating, editing, monitoring, and debugging connections. To 
configure the connector using SGC Central, see Configure Service Graph Connector for GCP 
using SGC Central.

Important: 
Unless there are configuration issues, use the SGC Central  view in the CMDB Workspace 
to configure the connection for the connector, as the guided setup method is being 
deprecated.

CMDB integrations dashboard

The Integration Commons for CMDB  store app provides a dashboard with a central view of the 
status, processing results, and processing errors of all installed integrations. You can see metrics 
for all integration runs. You can filter the view to a specific CMDB  integration, a specific time 
duration, or a specific integration run. For more details about monitoring GCP  integrations in the 
CMDB  Integrations Dashboard, see Using the CMDB Integrations Dashboard.

Data mapping

Data from the GCP  data sources is mapped and transformed into the ServiceNow  CMDB 
Configuration Item (CI) class definitions using the Robust Transform Engine (RTE). Data is 
inserted into the ServiceNow  CMDB  using the Identification and Reconciliation Engine (IRE).

When you complete setting up the connection, you can configure the integration to periodically 
pull data from the GCP  application.

The following table lists the data sources, the staging tables, the target tables as the CMDB  CI 
classes, and the resource types imported for a GCP  project.
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Data mapping for GCP

Data source Staging table
CMDB  CI 
classes

Resource types

SG-GCP 
Organization

SG-GCP Organization [sn_gcp_integ_sg_gcp_organization] Cloud 
Organizations

Organization

SG-GCP 
Folder

SG-GCP Folder [sn_gcp_integ_sg_gcp_folder] Google 
Organization 
Folder

SG-GCP 
Extension 
Attributes

Folder

SG-GCP 
Project

SG-GCP Project [sn_gcp_integ_sg_gcp_project] Google 
Organization 
Project

Cloud 
Service 
Account

Key Value

SG-GCP 
Extension 
Attributes

Project

SG-GCP 
Network

SG-GCP Network [sn_gcp_integ_sg_gcp_network] Cloud 
Network

SG-GCP 
Extension 
Attributes

Network

SG-GCP 
Machine 
Image

SG-GCP Machine Image 
[sn_gcp_integ_sg_gcp_machine_image]

Image

Key Value

SG-GCP 
Extension 
Attributes

MachineImage

SG-GCP 
Subnet

SG-GCP Subnet [sn_gcp_integ_sg_gcp_subnet] Cloud Subnet

Google 
Datacenter

Key Value

SG-GCP 
Extension 
Attributes

Subnetwork

SG-GCP 
Storage 
Volume

SG-GCP Storage Volume 
[sn_gcp_integ_sg_gcp_storage_volume]

Storage 
Volume

Disk
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Data mapping for GCP  (continued)

Data source Staging table
CMDB  CI 
classes

Resource types

Google 
Datacenter

Cloud Disk 
Type

Key Value

SG-GCP 
Extension 
Attributes

SG-GCP 
Storage 
Volume 
Snapshot

SG-GCP Storage Volume Snapshot 
[sn_gcp_integ_sg_gcp_storage_vol_snapshot]

Storage 
Volume 
Snapshot

Key Value

SG-GCP 
Extension 
Attributes

Snapshot

SG-GCP 
Security 
Group

SG-GCP Security Group 
[sn_gcp_integ_sg_gcp_security_group]

Compute 
Security 
Group

Network ACL

Network ACL 
Rule

Key Value

SG-GCP 
Extension 
Attributes

Firewall

SG-GCP 
Software 
Inventory

SG-GCP Software Inventory 
[sn_gcp_integ_sg_gcp_software_inventory] When the 

Software 
Asset 
Management 
(SAM) 
application 
isn't installed:

Software

Software 
Instance

When 
the SAM 
application 

Instance
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Data mapping for GCP  (continued)

Data source Staging table
CMDB  CI 
classes

Resource types

is installed: 
Software 
Installation

SG-GCP VM 
Instance

SG-GCP VM Instance [sn_gcp_integ_sg_gcp_vm_instance] Virtual 
Machine 
Instance

Google 
Datacenter

Hardware 
Type

Availability 
Zone

Cloud Mgmt 
Network 
Interface

Server

Storage 
Mapping

VNIC 
Endpoint

Block 
Endpoint

IP Address

Key Value

SG-GCP 
Extension 
Attributes

Instance

SG-GCP 
Execute 
Patch Job

SG-GCP Execute Patch Job 
[sn_gcp_integ_sg_gcp_execute_patch_job]

Not 
applicable

Not applicable

SG-GCP 
Hardware 
Type

SG-GCP Hardware Type 
[sn_gcp_integ_sg_gcp_hardware_type]

Hardware 
Type

Google 
Datacenter

Availability 
Zone

MachineType
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Data mapping for GCP  (continued)

Data source Staging table
CMDB  CI 
classes

Resource types

SG-GCP 
VM Hw 
Consolidation

SG-GCP VM Hw Consolidation 
[sn_gcp_integ_sg_gcp_vm_hw_consolidation]

Virtual 
Machine 
Instance

Server

None

SG-GCP Load 
Balancer Pool

SG-GCP Load Balancer Pool 
[sn_gcp_integ_sg_gcp_load_balancer_pool]

Load 
Balancer Pool

Google 
Datacenter

Cloud 
Service 
Account

SG-GCP 
Extension 
Attributes

Key Value

TargetPool

SG-GCP Load 
Balancer Pool 
Member

SG-GCP Load Balancer Pool Member 
[sn_gcp_integ_sg_gcp_load_balancer_pool_member]

Load 
Balancer Pool 
Member

SG-GCP 
Extension 
Attributes

TargetPool

SG-GCP Load 
Balancer 
Health 
Service

SG-GCP Load Balancer Health 
Service[sn_gcp_integ_sg_gcp_load_balancer_health_service]

Cloud Load 
Balancer 
Health 
Service

SG-GCP 
Extension 
Attributes

HealthCheck

SG-GCP Load 
Balancer

SG-GCP Load Balancer 
[sn_gcp_integ_sg_gcp_load_balancer]

Cloud Load 
Balancer

Google 
Datacenter

Cloud 
Service 
Account

SG-GCP 
Extension 
Attributes

BackendService
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Data mapping for GCP  (continued)

Data source Staging table
CMDB  CI 
classes

Resource types

Key Value

SG-GCP Load 
Balancer 
Service

SG-GCP Load Balancer Service 
[sn_gcp_integ_sg_gcp_load_balancer_service]

Load 
Balancer 
Service

SG-GCP 
Extension 
Attributes

ForwardingRule

SG-GCP 
Cloud 
Database

SG-GCP Cloud Database 
[sn_gcp_integ_sg_gcp_cloud_database]

Cloud 
DataBase

Google 
Datacenter

SG-GCP 
Extension 
Attributes

Key Value

Instance

SG-GCP 
Cloud 
Function

SG-GCP Cloud Function 
[sn_gcp_integ_sg_gcp_cloud_function]

Cloud 
Function

Google 
Datacenter

SG-GCP 
Extension 
Attributes

Key Value

Function

SG-GCP 
Cloud Object 
Storage

SG-GCP Cloud Object Storage 
[sn_gcp_integ_sg_gcp_cloud_object_storage]

Cloud Object 
Storage

Google 
Datacenter

Key Value

SG-GCP 
Extension 
Attributes

Buckets

SG-GCP 
Kubernetes 
Cluster

SG-GCP Kubernetes Cluster 
[sn_gcp_integ_sg_gcp_kubernetes_cluster]

Kubernetes 
Cluster

Key Value

SG-GCP 
Extension 
Attributes

Cluster
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Data mapping for GCP  (continued)

Data source Staging table
CMDB  CI 
classes

Resource types

SG-GCP 
Kubernetes 
Node

SG-GCP Kubernetes Node 
[sn_gcp_integ_sg_gcp_kubernetes_node]

Kubernetes 
Node

SG-GCP 
Extension 
Attributes

Node

SG-GCP 
Kubernetes 
Pod

SG-GCP Kubernetes Pod 
[sn_gcp_integ_sg_gcp_kubernetes_pod]

Kubernetes 
Pod

Kubernetes 
Volume

Docker Image

Docker 
Container

Key Value

SG-GCP 
Extension 
Attributes

Pod

SG-GCP 
Kubernetes 
Service

SG-GCP Kubernetes Service 
[sn_gcp_integ_sg_gcp_kubernetes_service]

Kubernetes 
Service

Key Value

SG-GCP 
Extension 
Attributes

Service

SG-GCP 
Kubernetes 
Namespace

SG-GCP Kubernetes Namespace 
[sn_gcp_integ_sg_gcp_kubernetes_namespace]

Kubernetes 
Namespace

Cloud 
Service 
Account

Key Value

SG-GCP 
Extension 
Attributes

Namespace

SG-GCP 
Kubernetes 
Deployment

SG-GCP Kubernetes Deployment 
[sn_gcp_integ_sg_gcp_kubernetes_deployment]

Kubernetes 
Deployment

Key Value

SG-GCP 
Extension 
Attributes

Deployment
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Data mapping for GCP  (continued)

Data source Staging table
CMDB  CI 
classes

Resource types

SG-GCP 
Kubernetes 
Replicaset

SG-GCP Kubernetes Replicaset 
[sn_gcp_integ_sg_gcp_kubernetes_replicaset]

Kubernetes 
ReplicaSet

Key Value

SG-GCP 
Extension 
Attributes

ReplicaSet

SG-GCP 
Kubernetes 
Cluster Roles

SG-GCP Kubernetes Cluster Roles 
[sn_gcp_integ_sg_gcp_kubernetes_cluster_role]

Kubernetes 
Cluster Role

Key Value

SG-GCP 
Extension 
Attributes

ClusterRole

SG-GCP 
Kubernetes 
Cluster Role 
Binding

SG-GCP Kubernetes Cluster Role Binding 
[sn_gcp_integ_sg_gcp_kubernetes_cluster_role_binding]

Kubernetes 
Cluster Role 
Binding

Key Value

SG-GCP 
Extension 
Attributes

ClusterRoleBinding

SG-GCP 
Kubernetes 
Node Pool

SG-GCP Kubernetes Node Pool 
[sn_gcp_integ_sg_gcp_kubernetes_node_pool]

Kubernetes 
Node Pool

Key Value

SG-GCP 
Extension 
Attributes

NodePool

SG-GCP 
Generic 
Resource

SG-GCP Generic Resource 
[sn_gcp_integ_sg_gcp_generic_resource]

Note: 
The SG-GCP Generic Resource data source only works 
with a service account that has organization-level 
access.

Cloud 
Resource

Resource

SG-GCP 
Annotation

SG-GCP Annotation [sn_gcp_integ_sg_gcp_annotation] Key Value Annotation

SG-GCP Get 
Patch Job

SG-GCP Get Patch Job 
[sn_gcp_integ_sg_gcp_get_patch_job]

Not 
applicable

Not applicable

SG-GCP 
Generic 

SG-GCP Generic Resource Annotation 
[sn_gcp_integ_sg_gcp_generic_resource_annotation]

Key Value Annotation
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Data mapping for GCP  (continued)

Data source Staging table
CMDB  CI 
classes

Resource types

Resource 
Annotation
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Note: 

• The SG-GCP Annotation data source populates all labels and tags  associated with GCP 
supported resources to the Key Value  table.

• Starting with the Service Graph Connector for GCP  1.10 version, the SG-GCP Generic 
Resource Annotation data source populates the tags and labels for Generic resources to 
the Key Value  table.

• The basic information about a GCP  resource is stored in the SG-GCP Extension Attributes 
[sn_gcp_integ_extension_attributes] table.

• After all the data sources are executed, the Server [cmdb_ci_server] class is updated with 
the class entry, and then based on the Windows or Linux class, the records are created 
in the Windows Server [cmdb_ci_win_server] and Linux Server [cmdb_ci_linux_server] 
classes, respectively.

• The SG-GCP Generic Resource data source imports data for generic resources not 
tracked by other data sources. The connector utilizes the Service Graph Resource 
Inclusion Whitelist [sn_cmdb_int_util_service_graph_resource_inclusion_whitelist] table 
to differentiate between generic and other supported resource types.

The connector first populates all supported resources in the Service Graph Resource 
Inclusion Whitelist [sn_cmdb_int_util_service_graph_resource_inclusion_whitelist] 
table. These resources, categorized under their respective supported resource types, 
have specific data sources designated for ingestion within the connector. When 
the SG-GCP Generic Resource data source is executed and retrieves unsupported 
resource types, they are added to the Service Graph Resource Inclusion Whitelist 
[sn_cmdb_int_util_service_graph_resource_inclusion_whitelist] table and categorized as 
generic.

• For any discovered resources deleted later after pulling data, the Service Graph 
Connector for GCP  automatically updates the Install Status  field of the associated CMDB 
CI classes to indicate any retired or deleted records. For more information, see Life 
cycle management of records in Service Graph Connector for GCP  and Record removal 
process in Service Graph Connector for GCP.

• Starting with the Service Graph Connector for GCP  1.9.0 version, when the 
sn_itom_pattern.use a single hardware type for cloud data 
centers  system property is set to true, hardware type data is added to the Cloud 
Hardware Type [cmdb_ci_cloud_hardware_type] table, instead of being added to the 
Hardware Type [cmdb_ci_compute_template] table. For more information, see the Service 
Graph Connector For GCP - Migrating to a new hardware type model [KB1899584]
article in the Now Support  Knowledge Base.

• Starting with the Service Graph Connector for GCP  1.9.0 version, when the 
sn_cmdb_ci_class.use_single_cloud_os_image  system property is set to 
true, image type data is added to the Cloud Image [cmdb_ci_cloud_os_image] table, 
instead of being added to the Image [cmdb_ci_os_template] table. For more information, 
see the Service Graph Connector For GCP - Migrating to a new Cloud OS Image model 
[KB1983751]  article in the Now Support  Knowledge Base.

• Starting with the Service Graph Connector for GCP  1.9.0 version, list API calls return only 
the information that is required to make batch calls and not the entire resource response.

• Starting with the Service Graph Connector for GCP  1.10 version, parallel data loading is 
enabled for the SG-GCP Annotation and SG-GCP Generic Resource Annotation data 
sources.

• Starting with the Service Graph Connector for GCP  1.10 version, you can configure 
the AppScript Folder IDs  connection property to exclude AppScript folder 
information from imports. Automations are run on AppScript folders, which contain 
multiple projects that include meta information. AppScript folders don't contain any 
resources such as networks, subnets, and VMs.

Specify the AppScript folder IDs as a comma-separated list in the Value  field of the 
AppScript Folder IDs  connection property to exclude the AppScript folders and 
projects information from being added to the CMDB  during import.

• Starting with the Service Graph Connector for GCP  1.10 version, the SG-GCP Software 
Inventory scheduled import runs before the SG-GCP VM Instance scheduled import. The 
SG-GCP Software Inventory scheduled job populates the operating system information 
for the Server records, which determines the script that needs to be run for deep 
discovery (Shell script for Linux VMs or PowerShell script for Windows VMs).

• Starting with the Service Graph Connector for GCP  1.10 version, the SG-GCP Get Patch 
Job scheduled import supports deep discovery by running commands on VMs. For 
information about deep discovery for the Service Graph Connector for GCP, see the 
Enabling deep discovery for Service Graph Connector for GCP  article in the Now Support 
Knowledge Base.
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For more information on where data is saved when pulling data from a GCP  project, see CMDB 
classes targeted in Service Graph Connector for GCP.

You can use the IntegrationHub ETL app to view the data maps. See IntegrationHub ETL  for more 
information.

BYOL and BYOS support

Bringing your own licenses (BYOL) or bringing your own subscriptions (BYOS) is the process 
of bringing previously purchased on-premises licenses or subscriptions to Google Cloud. The 
connector supports the BYOL and BYOS of the Image CIs for the Red Hat Enterprise Linux 
(RHEL) and SUSE Linux Enterprise Server (SLES) services on Google Cloud. The connector 
populates the Key Value [cmdb_key_value] table with the licensing information. Depending on 
the platform usage, the key is set to either Windows_OS_License_Type_automatic  or 
Linux_OS_License_Type_automatic, and the key value is set to either BYOL  or BYOS.

Related topics

Service Graph Connectors

Handling import failures for large GCP resources

Deep discovery for Service Graph Connector for GCP

Configure Service Graph Connector for GCP  using SGC Central

Use the playbook available with the SGC Central  application to set up the Service Graph 
Connector for GCP  for pulling in GCP  project data into the CMDB.

Before you begin
Install Service Graph Connector for GCP  version 1.8.0 or later from the ServiceNow Store. For 
ServiceNow Store  installation steps, see Install a ServiceNow Store application . 

Role required: cmdb_inst_admin or admin

About this task
The playbook experience for onboarding connectors is activated with SGC Central  in the CMDB 
Workspace. To configure the SGC Central  application, see Configuring SGC Central  and for more 
information on how to interact with a playbook, see Interact with Playbook .

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the CMDB Workspace, select SGC Central.

3. On the Overview page, select Create connection.

Tip: 
Alternatively, you can select Create connection  on the All connections page.

4. On the Create connection window, select the GCP  connector type and then select Create 
connection.

5. Complete the initial prerequisites when setting up a connection for the first time using a 
connector.

Note: 
This step is required only during the first-time setup. See Perform initial setup tasks when 
creating a connection in SGC Central.
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6. Complete the prerequisites for setting up the GCP  environment.

a. Set up the GCP  environment and create a Java KeyStore (JKS) certificate to encrypt the 
security certificates obtained from a GCP  application.

i. In the Prerequisites  stage of the playbook, select the Review setup instructions  activity.

ii. Select Service Graph connector for GCP - Setup Instructions  link to view the setup 
instructions included in the Service Graph connector for GCP - Setup Instructions 
[KB1220598]  article in the Now Support  Knowledge Base.

iii. Make a note of the destination keystore password. You need to specify this password 
while importing the JKS certificate into the Service Graph Connector for GCP  application.

iv. Select the I have read the setup instructions  check box to confirm that you have set up 
the GCP  environment according to the instructions.

v. Select Continue.

vi. After completing the Review setup instructions  activity, select Continue.

b. Create an X.509 certificate to associate the JKS certificate for the GCP  application with the 
Service Graph Connector for GCP.

Note: 
You can skip this step if you're reusing an existing certificate by selecting Skip.

i. In the Prerequisites  stage of the playbook, select the Create X.509 certificate  activity.

ii. Select New.

iii. On the form, fill in the fields.

Create new X.509 Certificate form

Field Description

Name Name of the X.509 certificate. For example, SG-
GCP-509Certificate-Org1.

Key store 
password

Password to access the JKS certificate as noted down in the step 
6.a.iii.

Short 
description

Description of the X.509 certificate.

iv. In the Attachments section, select Add File  to browse and upload the keystore.p12 file for 
the JKS certificate you created in step 6.a.

v. Select the I have read the setup instructions  check box after you have completed the 
setup.

vi. After completing the Create X.509 certificate  activity, select Continue.

7. Optional:  Download the scripts that are required to enable deep discovery for the Service 
Graph Connector for GCP.

a. In the Prerequisites  stage of the playbook, select the Download GCP deep discovery 
scripts  activity.

b. Download the deep discovery scripts for Linux  and Windows  VMs.
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For more information about deep discovery for the Service Graph Connector for GCP, see 
the Service Graph Connector for GCP - Deep Discovery Setup Instructions [KB2213095]
article in the Now Support  Knowledge Base.

c. After completing the Download GCP deep discovery scripts  activity, select Continue.

8. Enter connection details and test the API connection for importing GCP  data.

a. In the Setup  stage of the playbook, select the Create and test connection  activity.

b. On the form, fill in the fields.

Create and test connection form

Field Description

Connection Name Name to identify the GCP  connection 
record.

Service Account Email ServiceNow  service account associated with 
the GCP  application.

Keystore Name of the X.509 certificate that you 
created in step 6.b.

Keystore Password Password to access the JKS certificate as 
noted down in the step 6.a.iii.

Organization Id ID of the organization associated with the 
GCP  application.

Discovery Scope Discovery scope of the GCP  application. The 
available options are:

Organization

Select Organization  when the 
ServiceNow  service account 
has access to data within the 
GCP  organization.

Projects

Select Projects  when the 
ServiceNow  service account 
has access to data within GCP 
projects only.

c. Select Update and test connection.

d. Once the connection test is complete, select Continue.

9. Optional:  Configure the deep discovery connection properties.

a. In the Setup  stage of the playbook, select the Configure connection properties  activity.
If deep discovery is already configured on the connection, the values are pre-populated 
on the Deep Discovery properties  form. For more information about the deep discovery 
connection properties for GCP, see Deep discovery connection properties.
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b. Review the pre-populated fields on the Deep Discovery properties  form.

c. After completing the Configure connection properties  activity, select Continue.

10. Configure the import schedule to import data at regular intervals.

a. In the Setup  stage of the playbook, select the Configure import schedule  activity.

b. Select Configure import schedule.

c. Expand the Parent scheduled data import within the Import schedules list to select the SG-
GCP Organization  import schedule.

d. In the Configure import schedule  dialog box, select the Active  check box, and then fill in the 
run schedule and time details.

For more information, see Schedule a data import .

e. Select Save.
Alternatively, select Execute Now  to execute the import schedule immediately.

f. Select Continue.

11. In the Setup  stage of the playbook, select the Confirm connection creation  activity to verify 
whether the connection was configured.

What to do next
Select View all connections  to review the connection details. The configured connection 
appears in the Installed connections list.

Related topics

Service Graph Connector for GCP

Deep discovery for Service Graph Connector for GCP

Configure Service Graph Connector for GCP  using the guided setup

Set up scheduled import jobs to pull in data from a GCP  project into your CMDB.

Before you begin
Important: 
Unless there are configuration issues, use the SGC Central  view in the CMDB Workspace 
to configure the connection for the connector, as the guided setup method is being 
deprecated.

To use this Service Graph Connector, you need a subscription to a Subscription Unit that is 
based in the IT Operations Management  (ITOM) Visibility application or in the ITOM  Discovery 
application. As defined in the section titled "Managed IT Resource Types" in ServiceNow 
Subscription Unit Overview  for your subscription, for managed IT resources that are created 
or modified in the CMDB  by this Service Graph Connector, but that aren’t yet managed by ITOM 
Visibility or ITOM Discovery , these resources will increase Subscription Unit consumption from 
that application. Review your current Subscription Unit consumption within ITOM Visibility or 
ITOM Discovery to ensure available capacity.
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Dependencies and requirements:

• The Integration Commons for CMDB  store app, which is automatically installed.

• The CMDB CI class models store app, which is automatically installed. See CMDB CI Class 
Models store app.

• The ITOM Discovery License plugin (com.snc.itom.discovery.license). You must activate this 
plugin.

• ITOM Licensing plugin (com.snc.itom.license). For more information, see Request Discovery .

• The Datastream Action plugin (com.glide.hub.action_type.datastream), which is automatically 
installed.

• Observability Commons for CMDB  (sn_observability), which is only required for event 
ingestion. This app must be installed prior to installing the connector for Event Management to 
work. For more information, see Observability Commons for CMDB  on the ServiceNow Store.

Note: 
If you have an earlier version of the Service Graph Connector for GCP, then don’t migrate 
data from the old connector. You must uninstall the previous version and run the new 
integration.

Role required: admin

Note: 
If you create non-admin RunAs users to run scheduled imports, grant the cmdb_inst_admin 
role to those users.

Procedure

1. Ensure that the application scope is set to the Service Graph Connector for GCP  application 
by using the application picker.
For more information, see Application picker .

2. Navigate to All  > Service Graph Connectors  > GCP  > Setup.

3. On the Getting started page, select Get Started.

4. Configure the connection to send requests to the GCP  application.

a. In the Configure the Connection and Credentials  section of the Service Graph Connector for 
GCP  page, select Get Started.

b. Set up the GCP  environment and create a Java KeyStore (JKS) certificate to encrypt the 
security certificates obtained from a GCP  application.

Make a note of the destination keystore password. You need to specify this password while 
importing the JKS certificate into the Service Graph Connector for GCP  application.

For instructions, see the Service Graph Connector for GCP - Setup Instructions 
[KB1220598]  article in the Now Support  Knowledge Base.

Note: 
After you have set up the GCP environment, return to the guided setup and set the 
GCP Setup Instructions  task in the Configure the Connection and Credentials  section 
to complete by selecting Mark as Complete.

c. Create an X.509 certificate to associate the JKS certificate for the GCP  application with the 
Service Graph Connector for GCP.
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i. For the Create X.509 certificate  task, select Configure.

ii. On the form that opens in a new tab, fill in the fields.

X.509 Certificate form

Field Description

Name Name of the X.509 certificate. For example, SG-
GCP-509Certificate-Org1.

Notify on 
expiration

Users to be notified when the certificate expires. If no users are selected, 
the logged-in user is added by default, along with the last two logged-in 
users with the administrator role.

Warn in 
days to 
expire

Number of days to send a notification before the certificate expires.

Active Option to activate the certificate.

Type Certificate container that is automatically set to Java Key Store. Leave the 
field value set to Java Key Store.

Expires in 
days

Number of days until the certificate expires.

Key store 
password

Password to access the JKS certificate as noted down in the previous step.

Short 
description

Description of the X.509 certificate.

iii. Select the manage attachments icon ( ).

iv. Select Choose file  to browse and upload the keystore.p12 file for the JKS certificate you 
created in step 4.b.

v. Close the dialog box.

vi. Select the Validate Stores/Certificates  related link.

vii. On successful validation, select Update  to return to the guided setup page.

viii. Set the Create X.509 certificate  task to complete by selecting Mark as Complete.

d. Edit the default connection.

i. For the Edit Default Connection  task, select Configure.

ii. In the Flow Designer, select SG-GCP Default Connection, and then select Edit.

iii. On the form that opens in the Edit Connection dialog box, fill in the fields.

Edit Connection form

Field Description

Service 
Account 
Email

Service account created in and associated with the GCP  application.

Keystore Name of the keystore that you created in step 4.b.
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Field Description

Key 
Password

Destination keystore password associated with the keystore.

Organization 
Id

ID of the organization associated with the GCP  application.

Discovery 
Scope

Discovery scope of the GCP  application. The available options are:

organizations

Select organizations  when the ServiceNow  service account 
has access to data within the GCP  organization.

projects

Select projects  when the ServiceNow  service account has 
access to data within GCP  projects only.

iv. Select Edit and Get OAuth Token.

v. After the OAuth token flow is completed successfully, close the dialog box and the 
browser tab, and return to the guided setup page.

vi. Set the Edit Default Connection  task to complete by selecting Mark as Complete.

e. Test the GCP  API connection to import data from the GCP  application.

i. For the Test the Connection  task, select Configure  to open the SG-GCP Default 
Connection page in a new browser tab.

ii. Test the connection by selecting the Test Connection  related link.

Testing the connection may take a few moments. The page is refreshed to show the test 
results.

iii. When the Status  field is set to Success, close the browser tab and return to the guided 
setup page.

If any of the tests have an error code or message or error sign, the connection failed and 
further troubleshooting is required.

iv. Set the Test the Connection  task to complete by selecting Mark as Complete.

f. Configure the scheduled jobs to import data from the GCP  application.

i. For the Configure the Scheduled Imports  task, select Configure  to open the Scheduled 
Data Imports list in a new browser tab.

ii. Select the SG-GCP Organization scheduled job.

iii. On the Scheduled Data Import form, verify the field values for the scheduled job.

For more information, see Schedule a data import .

iv. Select Active  check box to activate the SG-GCP Organization scheduled job.

v. In the Run  field, select Periodically  to specify how often the job will run.

vi. Select Update.

vii. Return to the guided setup page.

viii. Set the Configure the Scheduled Imports  task to complete by selecting Mark as 
Complete.
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5. Optional:  Add multiple GCP  instances.

a. In the Add Multiple Instances  section of the Service Graph Connector for GCP  page, select 
Get Started.

b. Create data sources for the new GCP  connection.

i. Ensure that you have edit permissions for the Datasource [sys_data_source] table.

ii. For the Update Data Source Access  task, select Configure.

iii. To edit the record, select the Global  application scope from the application picker.

iv. In the Application Access related list of the Data Source form that opens in a new tab, 
select the Can create, Can update, and Can delete  check boxes.

v. Select Update.

vi. Return to the guided setup page.

vii. From the application picker, select the Service Graph Connector for GCP  application 
scope.

viii. Set the Update Data Source Access  task to complete by selecting Mark as Complete.

c. Create a scheduled import job for the new GCP  connection.

i. Ensure that you have edit permissions for the Scheduled data import 
[scheduled_import_set] table.

ii. For the Update Scheduled Data Import Access  task, select Configure.

iii. To edit the record, select the Global  application scope from the application picker.

iv. In the Application Access related list of the Scheduled Data Import form that opens in a 
new tab, select the Can create, Can update, and Can delete  check boxes.

v. Select Update.

vi. Return to the guided setup page.

vii. From the application picker, select the Service Graph Connector for GCP  application 
scope.

viii. Set the Update Scheduled Data Import Access  task to complete by selecting Mark as 
Complete.

d. Clear the cache on the Data Source [sys_data_source] and Scheduled Data Imports 
[scheduled_import_set] tables.

i. For the Clear Cache for Data Source and Scheduled Data Imports tables  task, select 
Configure.

ii. In the Run script  text box of the background script page, enter the following script:

GlideTableManager.invalidateTable("sys_data_source");
GlideCacheManager.flushTable("sys_data_source");
GlideTableManager.invalidateTable("scheduled_import_set");
GlideCacheManager.flushTable("scheduled_import_set");
GlideTableManager.invalidateTable("sys_db_object");
GlideCacheManager.flushTable("sys_db_object");

iii. Select Run Script  to run the background script in the global  scope.

The script may take several minutes to execute.
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iv. After the script is executed, select Close.

v. Return to the guided setup page.

vi. From the application picker, select the Service Graph Connector for GCP  application 
scope.

vii. Set the Clear Cache for Data Source and Scheduled Data Imports tables  task to complete 
by selecting Mark as Complete.

e. To create an X.509 certificate for the new GCP  instance, repeat the step 4.c, and then set the 
Create X.509 certificate  task to complete by selecting Mark as Complete.

f. Add a new connection.

i. For the Add New Connection  task, select Configure.

ii. In the Flow Designer, select Add Connection.

iii. On the form that opens in the Create Connection dialog box, fill in the fields.

Edit Connection form

Field Description

Connection 
Name

Unique name for the new connection.

Service 
Account 
Email

ServiceNow  service account associated with the GCP  application.

Keystore Name of the keystore that you created in step 5.e.

Key 
Password

Destination keystore password associated with the keystore.

Organization 
Id

ID of the organization associated with the GCP  application.

Discovery 
Scope

Discovery scope of the GCP  application. The available options are:

organizations

Select organizations  when the ServiceNow  service account 
has access to data within the GCP  organization.

projects

Select projects  when the ServiceNow  service account has 
access to data within GCP  projects only.

g. Test the new connection.

i. For the Test New Connection  task, select Configure.

ii. In Service Graph Connections page that opens in a new browser tab, select the new 
connection that you want to test from the list of available connections.

iii. Test the connection by selecting the Test Connection  related link.

Testing the connection may take a few moments. The page is refreshed to show the test 
results.
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iv. When the Status  field is set to Success, close the browser tab and return to the guided 
setup page.

If any of the tests have an error code or message or error sign, the connection failed and 
further troubleshooting is required.

v. Set the Test New Connection  task to complete by selecting Mark as Complete.

h. To configure the scheduled jobs to import data from the new GCP  instance, repeat step 4.f, 
and then set the Configure the Scheduled Imports  task to complete by selecting Mark as 
Complete.

6. Synchronize new data sources to import data from GCP  instances.

a. In the Advanced Setup  section of the Service Graph Connector for GCP  page, select Get 
Started.

b. Synchronize new data sources for creating all the required credentials to make the new data 
sources work correctly.

i. For the Sync New Data source  task, select Configure.

ii. Select Synchronize Datasources.

iii. Return to the guided setup page by closing the Sync New Data source window.

iv. Set the Sync New Data source  task to complete by selecting Mark as Complete.

7. Set up OS Config Patch Jobs to enable deep discovery.

a. In the Setup OS Config Patch Jobs for extended discovery  section of the Service Graph 
Connector for GCP  page, select Get Started.

b. For the Download script files  task, select Configure.

c. Save the Shell script and PowerShell script files.

The Shell script contains commands that run on Linux  VMs. The PowerShell script contains 
commands that run on Windows  VMs.

d. In the Shell script and PowerShell script files, specify the name of and the path in the Cloud 
Storage Bucket where the output of the commands are to be uploaded.

e. Upload the deep discovery scripts to the Cloud Storage Bucket.

f. Navigate back to the guided setup page, and set the Download script files  task to complete 
by selecting Mark as Complete.

g. For the Configure GCP Cloud Storage Bucket for running Patch Jobs  task, select Configure.

h. To configure the GCP  Cloud Storage Bucket to run patch jobs, follow the deep discovery 
setup instructions in the Service Graph Connector for GCP - Deep Discovery Setup 
Instructions [KB2213095]  article in the Now Support  Knowledge Base.
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i. Navigate back to the guided setup page, and set the Configure GCP Cloud Storage Bucket 
for running Patch Jobs  task to complete by selecting Mark as Complete.

j. For the Configure connection properties  task, select Configure.

k. On the SG-GCP Configuration Properties form, select the connection for which you want to 
run deep discovery from the Connection  list.

In the Properties section of the SG-GCP Configuration Properties form, the following fields 
are populated with the values for the connection that you selected. If required, update the 
field values.

Field Description

Name of the Cloud Storage Bucket where the .sh 
and .ps1 files are uploaded in Google Cloud Platform

Name of the Cloud Storage Bucket 
where the deep discovery scripts 
are saved.

Path to the .sh file uploaded to Cloud Storage Bucket Path of the deep discovery Shell 
script file.

Generation number of the .sh file uploaded to Cloud 
Storage Bucket

Number used to identify the 
versioning of the cloud storage 
object.

Path to the.ps1 file uploaded to Cloud Storage Bucket Path of the deep discovery 
PowerShell script file.

Generation number of the .ps1 file uploaded to Cloud 
Storage Bucket

Number used to identify the 
versioning of the cloud storage 
object.

Name of the Cloud Storage Bucket provided in .sh 
and .ps1 files where the outputs of the commands 
have to be stored

Name of the output Cloud Storage 
Bucket.

Folder path provided in .sh and .ps1 files where the 
outputs are uploaded in the Storage Bucket

Path of the output storage folder in 
the Cloud Storage Bucket.

l. Select Save.

m. Navigate back to the guided setup, and set the Configure connection properties  task to 
complete by selecting Mark as Complete.

Related topics

Service Graph Connector for GCP

Configure Service Graph Connector for GCP using SGC Central

Deep discovery for Service Graph Connector for GCP

CMDB  classes targeted in Service Graph Connector for GCP

When you complete setting up the connection, you can configure the integration to periodically 
pull data from a GCP  project. The data is saved in tables that extend from the Configuration item 
[cmdb_ci] table.
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Availability Zone [cmdb_ci_availability_zone]

The following attributes in the Availability Zone [cmdb_ci_availability_zone] table are populated 
by collected data:

Attribute label Attribute name

Name name

Object ID object_id

Block Endpoint [cmdb_ci_endpoint_block]

The following attributes in the Block Endpoint [cmdb_ci_endpoint_block] table are populated by 
collected data:

Attribute label Attribute name

Host host

Name name

Install Status install_status

Operational status operational_status

Cloud DataBase [cmdb_ci_cloud_database]

The following attributes in the Cloud DataBase [cmdb_ci_cloud_database] table are populated by 
collected data:

Attribute label Attribute name

Name name

Object ID object_id

TCP port(s) tcp_port

CPU Count cpu_count

Fully qualified domain name fqdn

Install Status install_status

IP Address ip_address

Memory Size (GB) memory_size

Node Count node_count

Operational status operational_status

State state

Type type

Version version
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Relationships created for Cloud DataBase

Parent class Relationship type Child class

Cloud DataBase 
[cmdb_ci_cloud_database]

Hosted on::Hosts Google Datacenter 
[cmdb_ci_google_datacenter]

Cloud DataBase 
[cmdb_ci_cloud_database]

Reference Key Value [cmdb_key_value]

Cloud DataBase 
[cmdb_ci_cloud_database]

Reference SG-GCP Extension Attributes 
[sn_gcp_integ_extension_attributes]

Cloud Disk Type [cmdb_ci_disk_type]

The following attributes in the Cloud Disk Type [cmdb_ci_disk_type] table are populated by 
collected data:

Attribute label Attribute name

Name name

Object ID object_id

Relationships created for Cloud Disk Type

Parent class Relationship type Child class

Cloud Disk Type 
[cmdb_ci_disk_type]

Hosted on::Hosts Google Datacenter 
[cmdb_ci_google_datacenter]

Cloud Disk Type 
[cmdb_ci_disk_type]

Reference Key Value [cmdb_key_value]

Cloud Function [cmdb_ci_cloud_function]

The following attributes in the Cloud Function [cmdb_ci_cloud_function] table are populated by 
collected data:

Attribute label Attribute name

Name name

Object ID object_id

CodeSha256 codesha256

Function Last Modified function_last_modified

Install Status install_status

Language language

Operational status operational_status

Version version
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Relationships created for Cloud Function

Parent class Relationship type Child class

Cloud Function 
[cmdb_ci_cloud_function]

Hosted on::Hosts Google Datacenter 
[cmdb_ci_google_datacenter]

Cloud Function 
[cmdb_ci_cloud_function]

Reference Key Value [cmdb_key_value]

Cloud Function 
[cmdb_ci_cloud_function]

Reference SG-GCP Extension Attributes 
[sn_gcp_integ_extension_attributes]

Cloud Load Balancer [cmdb_ci_cloud_load_balancer]

The following attributes in the Cloud Load Balancer [cmdb_ci_cloud_load_balancer] table are 
populated by collected data:

Attribute label Attribute name

Name name

Object ID object_id

Install Status install_status

Operational status operational_status

State state

Relationships created for Cloud Load Balancer

Parent class Relationship type Child class

Cloud Load Balancer 
[cmdb_ci_cloud_load_balancer]

Hosted on::Hosts Google Datacenter 
[cmdb_ci_google_datacenter]

Cloud Load Balancer 
[cmdb_ci_cloud_load_balancer]

Reference Key Value [cmdb_key_value]

Cloud Load Balancer 
[cmdb_ci_cloud_load_balancer]

Reference SG-GCP Extension Attributes 
[sn_gcp_integ_extension_attributes]

Cloud Load Balancer Health Service [cmdb_ci_lb_health_service]

The following attributes in the Cloud Load Balancer Health Service [cmdb_ci_lb_health_service] 
table are populated by collected data:

Attribute label Attribute name

Name name

Object ID object_id

Healthy threshold healthy_threshold

Install Status install_status

Interval in seconds check_interval_sec
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Attribute label Attribute name

Monitor type protocol monitor_type

Operational status operational_status

Port port

Request path request_path

Timeout in seconds timeout_sec

Unhealthy threshold unhealthy_threshold

Relationships created for Cloud Load Balancer Health Service

Parent class Relationship type Child class

Cloud Load Balancer 
Health Service 
[cmdb_ci_lb_health_service]

Hosted on::Hosts Cloud Service Account 
[cmdb_ci_cloud_service_account]

Cloud Load Balancer 
Health Service 
[cmdb_ci_lb_health_service]

Contains::Contained by Cloud Load Balancer 
[cmdb_ci_cloud_load_balancer]

Cloud Load Balancer 
Health Service 
[cmdb_ci_lb_health_service]

Reference SG-GCP Extension Attributes 
[sn_gcp_integ_extension_attributes]

Cloud Mgmt Network Interface [cmdb_ci_nic]

The following attributes in the Cloud Mgmt Network Interface [cmdb_ci_nic] table are populated 
by collected data:

Attribute label Attribute name

IP Address ip_address

Name name

Object ID object_id

Public IP public_ip

Install Status install_status

Operational status operational_status

Private IP private_ip

Configuration Item cmdb_ci

Relationships created for Cloud Mgmt Network Interface

Parent class Relationship type Child class

Cloud Mgmt Network Interface 
[cmdb_ci_nic]

Owns::Owned by IP Address 
[cmdb_ci_ip_address]

Cloud Mgmt Network Interface 
[cmdb_ci_nic]

Reference Virtual Machine Instance 
[cmdb_ci_vm_instance]
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Cloud Network [cmdb_ci_network]

The following attributes in the Cloud Network [cmdb_ci_network] table are populated by 
collected data:

Attribute label Attribute name

Name name

Object ID object_id

Description short_description

Install Status install_status

Operational status operational_status

State state

Relationships created for Cloud Network

Parent class Relationship type Child class

Cloud Network 
[cmdb_ci_network]

Hosted on::Hosts Cloud Service Account 
[cmdb_ci_cloud_service_account]

Cloud Network 
[cmdb_ci_network]

Contains::Contained by Cloud Subnet 
[cmdb_ci_cloud_subnet]

Cloud Network 
[cmdb_ci_network]

Contains::Contained by Network ACL 
[cmdb_ci_network_acl]

Cloud Network 
[cmdb_ci_network]

Reference SG-GCP Extension Attributes 
[sn_gcp_integ_extension_attributes]

Cloud Object Storage [cmdb_ci_cloud_object_storage]

The following attributes in the Cloud Object Storage [cmdb_ci_cloud_object_storage] table are 
populated by collected data:

Attribute label Attribute name

Name name

Object ID object_id

Cloud Provider cloud_provider

Install Status install_status

Operational status operational_status

Service Name service_name

Relationships created for Cloud Object Storage

Parent class Relationship type Child class

Cloud Object Storage 
[cmdb_ci_cloud_object_storage]

Hosted on::Hosts Google Datacenter 
[cmdb_ci_google_datacenter]
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Relationships created for Cloud Object Storage  (continued)

Parent class Relationship type Child class

Cloud Object Storage 
[cmdb_ci_cloud_object_storage]

Reference Key Value [cmdb_key_value]

Cloud Object Storage 
[cmdb_ci_cloud_object_storage]

Reference SG-GCP Extension Attributes 
[sn_gcp_integ_extension_attributes]

Cloud Organizations [cmdb_ci_cloud_org]

The following attributes in the Cloud Organizations [cmdb_ci_cloud_org] table are populated by 
collected data:

Attribute label Attribute name

Object ID object_id

Install Status install_status

Name name

Operational status operational_status

Time time

Relationships created for Cloud Organizations

Parent class Relationship type Child class

Cloud Organizations 
[cmdb_ci_cloud_org]

Contains::Contained by Google Organization Folder 
[cmdb_ci_gcp_folder]

Cloud Organizations 
[cmdb_ci_cloud_org]

Reference SG-GCP Extension Attributes 
[sn_gcp_integ_extension_attributes]

Cloud Resource [cmdb_ci_cmp_resource]

The following attributes in the Cloud Resource [cmdb_ci_cmp_resource] table are populated by 
collected data:

Attribute label Attribute name

Name name

Object ID object_id

Description short_description

Install status install_status

Operational status operational_status

Resource type resource_type
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Relationships created for Cloud Resource

Parent class Relationship type Child class

Cloud Resource 
[cmdb_ci_cmp_resource]

Reference SG-GCP Extension Attributes 
[sn_gcp_integ_extension_attributes]

Cloud Resource 
[cmdb_ci_cmp_resource]

Reference Key Value [cmdb_key_value]

Cloud Service Account [cmdb_ci_cloud_service_account]

The following attributes in the Cloud Service Account [cmdb_ci_cloud_service_account] table are 
populated by collected data:

Attribute label Attribute name

Account Id account_id

Discovery credentials discovery_credentials

Name name

Object ID object_id

Datacenter Type datacenter_type

Install status install_status

Operational status operational_status

Organization Id organization_id

Relationships created for Cloud Service Account

Parent class Relationship type Child class

Cloud Service Account 
[cmdb_ci_cloud_service_account]

Reference Key Value [cmdb_key_value]

Cloud Service Account 
[cmdb_ci_cloud_service_account]

Reference SG-GCP Extension Attributes 
[sn_gcp_integ_extension_attributes]

Cloud Subnet [cmdb_ci_cloud_subnet]

The following attributes in the Cloud Subnet [cmdb_ci_cloud_subnet] table are populated by 
collected data:

Attribute label Attribute name

Name name

Object ID object_id

Available IP Count available_ip_count

Broadcast Address broadcast_address

CIDR cidr

Gateway gateway
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Attribute label Attribute name

Install Status install_status

Operational status operational_status

State state

Subnet Mask subnet_mask

Relationships created for Cloud Subnet

Parent class Relationship type Child class

Cloud Subnet 
[cmdb_ci_cloud_subnet]

Contains::Contained by Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Cloud Subnet 
[cmdb_ci_cloud_subnet]

Reference Key Value [cmdb_key_value]

Cloud Subnet 
[cmdb_ci_cloud_subnet]

Reference SG-GCP Extension Attributes 
[sn_gcp_integ_extension_attributes]

Compute Security Group [cmdb_ci_compute_security_group]

The following attributes in the Compute Security Group [cmdb_ci_compute_security_group] table 
are populated by collected data:

Attribute label Attribute name

Name name

Object ID object_id

Install Status install_status

Operational status operational_status

State state

Relationships created for Compute Security Group

Parent class Relationship type Child class

Compute Security Group 
[cmdb_ci_compute_security_group]

Hosted on::Hosts Cloud Service Account 
[cmdb_ci_cloud_service_account]

Compute Security Group 
[cmdb_ci_compute_security_group]

Reference Key Value [cmdb_key_value]

Compute Security Group 
[cmdb_ci_compute_security_group]

Reference SG-GCP Extension Attributes 
[sn_gcp_integ_extension_attributes]

Docker Container [cmdb_ci_docker_container]

The following attributes in the Docker Container [cmdb_ci_docker_container] table are populated 
by collected data:
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Attribute label Attribute name

Container id container_id

Command command

Container created container_created_at

Image id image_id

Install Status install_status

Name name

Operational status operational_status

Status status

Docker Image [cmdb_ci_docker_image]

The following attributes in the Docker Image [cmdb_ci_docker_image] table are populated by 
collected data:

Attribute label Attribute name

Image id image_id

Name name

Google Datacenter [cmdb_ci_google_datacenter]

The following attributes in the Google Datacenter [cmdb_ci_google_datacenter] table are 
populated by collected data:

Attribute label Attribute name

Name name

Object ID object_id

Region region

Install Status install_status

Relationships created for Google Datacenter

Parent class Relationship type Child class

Google Datacenter 
[cmdb_ci_google_datacenter]

Contains::Contained by Availability Zone 
[cmdb_ci_availability_zone]

Google Datacenter 
[cmdb_ci_google_datacenter]

Hosted on::Hosts Cloud Service Account 
[cmdb_ci_cloud_service_account]

Google Organization Folder [cmdb_ci_gcp_folder]

The following attributes in the Google Organization Folder [cmdb_ci_gcp_folder] table are 
populated by collected data:
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Attribute label Attribute name

Object ID object_id

Install Status install_status

Name name

Operational status operational_status

Parent parent_ci

Parent Id parent_id

Parent Type parent_type

Time time

Relationship created for Google Organization Folder

Parent class Relationship type Child class

Google Organization Folder 
[cmdb_ci_gcp_folder]

Reference SG-GCP Extension Attributes 
[sn_gcp_integ_extension_attributes]

Google Organization Folder 
[cmdb_ci_gcp_folder]

Reference Cloud Organizations 
[cmdb_ci_cloud_org]

Google Organization Folder 
[cmdb_ci_gcp_folder]

Reference Google Organization Folder 
[cmdb_ci_gcp_folder]

Google Organization Project [cmdb_ci_gcp_project]

The following attributes in the Google Organization Project [cmdb_ci_gcp_project] table are 
populated by collected data:

Attribute label Attribute name

Operational status operational_status

Discovery credentials discovery_credentials

Name name

Object ID object_id

Install Status install_status

Parent parent_ci

Parent Id parent_id

Parent Type parent_type

Project Id project_id

Status status

Time time

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1013



Relationships created for Google Organization Project

Parent class Relationship type Child class

Google Organization Project 
[cmdb_ci_gcp_project]

Reference Google Organization Folder 
[cmdb_ci_gcp_folder]

Google Organization Project 
[cmdb_ci_gcp_project]

Reference Cloud Organizations 
[cmdb_ci_cloud_org]

Hardware Type [cmdb_ci_compute_template]

The following attributes in the Hardware Type [cmdb_ci_compute_template] table are populated 
by collected data:

Attribute label Attribute name

Name name

Object ID object_id

Class className

Description short_description

Local Storage GB local_storage_gb

Memory MB memory_mb

vCPUs vcpus

Zone zone

Note: 
If the sn_itom_pattern.use a single hardware type for cloud data 
centers  system property is set to true, the className  is set to Cloud Hardware Type 
[cmdb_ci_cloud_hardware_type]. If the property is set to false, the className  is set to 
Hardware Type [cmdb_ci_compute_template].

Relationship created for Hardware Type

Parent class Relationship type Child class

Hardware Type 
[cmdb_ci_compute_template]

Hosted on::Hosts Google Datacenter 
[cmdb_ci_google_datacenter]

Image [cmdb_ci_os_template]

The following attributes in the Image [cmdb_ci_os_template] table are populated by collected 
data:

Attribute label Attribute name

Name name

Object ID object_id

Class className
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Attribute label Attribute name

Fully qualified domain name fqdn

Install Status install_status

Operational status operational_status

Note: 
If the sn_cmdb_ci_class.use_single_cloud_os_image  system property is set 
to true, the className  is set to Cloud Image [cmdb_ci_cloud_os_image]. If the property 
is set to false, the className  is set to Image [cmdb_ci_os_template].

Relationships created for Image

Parent class Relationship type Child class

Image [cmdb_ci_os_template] Hosted on::Hosts Cloud Service Account 
[cmdb_ci_cloud_service_account]

Image [cmdb_ci_os_template] Reference Key Value [cmdb_key_value]

Image [cmdb_ci_os_template] Reference SG-GCP Extension Attributes 
[sn_gcp_integ_extension_attributes]

IP Address [cmdb_ci_ip_address]

The following attributes in the IP Address [cmdb_ci_ip_address] table are populated by collected 
data:

Attribute label Attribute name

IP Address ip_address

Install Status install_status

IP version ip_version

Name name

Operational status operational_status

Relationship created for IP Address

Parent class Relationship type Child class

IP Address 
[cmdb_ci_ip_address]

Reference Key Value [cmdb_key_value]

Key Value [cmdb_key_value]

The following attributes in the Key Value [cmdb_key_value] table are populated by collected data:

Attribute label Attribute name

Key key

Value value

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1015



The tags and labels associated with the following CI classes are populated in the Key Value 
[cmdb_key_value] table.

CMDB  CI classes Label populated Tag populated

Cloud DataBase 
[cmdb_ci_cloud_database]

Yes Yes

Cloud Function 
[cmdb_ci_cloud_function]

Yes Yes

Cloud Load Balancer 
[cmdb_ci_cloud_load_balancer]

No Yes

Cloud Load Balancer 
Health Service 
[cmdb_ci_lb_health_service]

No Yes

Cloud Network 
[cmdb_ci_network]

No Yes

Cloud Object Storage 
[cmdb_ci_cloud_object_storage]

Yes Yes

Cloud Organizations 
[cmdb_ci_cloud_org]

No Yes

Cloud Resource 
[cmdb_ci_cmp_resource]

Yes Yes

Cloud Service Account 
[cmdb_ci_cloud_service_account]

Yes Yes

Cloud Subnet 
[cmdb_ci_cloud_subnet]

No Yes

Compute Security Group 
[cmdb_ci_compute_security_group]

No Yes

Google Organization Folder 
[cmdb_ci_gcp_folder]

No Yes

Google Organization Project 
[cmdb_ci_gcp_project]

Yes Yes

Image [cmdb_ci_os_template] No Yes

IP Address 
[cmdb_ci_ip_address]

Yes Yes

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Yes Yes

Kubernetes Cluster Role 
[cmdb_ci_kubernetes_cluster_role]

Yes Yes

Kubernetes Cluster 
Role Binding 
[cmdb_ci_kubernetes_cluster_role_binding]

Yes Yes

Kubernetes Deployment 
[cmdb_ci_kubernetes_deployment]

Yes Yes
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CMDB  CI classes Label populated Tag populated

Kubernetes Namespace 
[cmdb_ci_kubernetes_namespace]

Yes Yes

Kubernetes Node 
[cmdb_ci_kubernetes_node]

Yes Yes

Kubernetes Node Pool 
[cmdb_ci_kubernetes_node_pool]

Yes Yes

Kubernetes Pod 
[cmdb_ci_kubernetes_pod]

Yes Yes

Kubernetes ReplicaSet 
[cmdb_ci_kubernetes_replicaset]

Yes Yes

Kubernetes Service 
[cmdb_ci_kubernetes_service]

Yes Yes

Load Balancer Pool 
[cmdb_ci_lb_pool]

No Yes

Load Balancer Service 
[cmdb_ci_lb_service]

Yes Yes

Storage Volume 
[cmdb_ci_storage_volume]

Yes Yes

Storage Volume Snapshot 
[cmdb_ci_storage_vol_snapshot]

Yes Yes

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Yes Yes

Note: 
Labels are not supported by Google Cloud  for the following CI classes:

• Cloud Load Balancer [cmdb_ci_cloud_load_balancer]

• Cloud Load Balancer Health Service [cmdb_ci_lb_health_service]

• Cloud Network [cmdb_ci_network]

• Cloud Organizations [cmdb_ci_cloud_org]

• Cloud Subnet [cmdb_ci_cloud_subnet]

• Compute Security Group [cmdb_ci_compute_security_group]

• Google Organization Folder [cmdb_ci_gcp_folder]

• Image [cmdb_ci_os_template]

• Load Balancer Pool [cmdb_ci_lb_pool]

Kubernetes Cluster [cmdb_ci_kubernetes_cluster]

The following attributes in the Kubernetes Cluster [cmdb_ci_kubernetes_cluster] table are 
populated by collected data:

Attribute label Attribute name

Cluster Resource ID cluster_resource_id
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Attribute label Attribute name

IP Address ip_address

Kubernetes UID k8s_uid

Name name

Port port

Cluster Version cluster_version

Description short_description

Install Status install_status

Operational status operational_status

SelfLink self_link

Subnet Mask subnet_mask

Relationships created for Kubernetes Cluster

Parent class Relationship type Child class

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Hosted on::Hosts Google Datacenter 
[cmdb_ci_google_datacenter]

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Cluster of::Cluster Kubernetes Node 
[cmdb_ci_kubernetes_node]

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Contains::Contained by Kubernetes Pod 
[cmdb_ci_kubernetes_pod]

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Contains::Contained by Kubernetes Cluster Role 
[cmdb_ci_kubernetes_cluster_role]

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Contains::Contained by Kubernetes Cluster 
Role Binding 
[cmdb_ci_kubernetes_cluster_role_binding]

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Contains::Contained by Kubernetes Namespace 
[cmdb_ci_kubernetes_namespace]

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Contains::Contained by Kubernetes Service 
[cmdb_ci_kubernetes_service]

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Reference Key Value [cmdb_key_value]

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Reference SG-GCP Extension Attributes 
[sn_gcp_integ_extension_attributes]

Kubernetes Cluster Role [cmdb_ci_kubernetes_cluster_role]

The following attributes in the Kubernetes Cluster Role [cmdb_ci_kubernetes_cluster_role] table 
are populated by collected data:

Attribute label Attribute name

Kubernetes UID k8s_uid

Comments comments
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Attribute label Attribute name

Description short_description

Install Status install_status

Operational status operational_status

Kubernetes Cluster cluster

Name name

Relationships created for Kubernetes Cluster Role

Parent class Relationship type Child class

Kubernetes Cluster Role 
[cmdb_ci_kubernetes_cluster_role]

Hosted on::Hosts Google Datacenter 
[cmdb_ci_google_datacenter]

Kubernetes Cluster Role 
[cmdb_ci_kubernetes_cluster_role]

Hosted on::Hosts Cloud Service Account 
[cmdb_ci_cloud_service_account]

Kubernetes Cluster Role 
[cmdb_ci_kubernetes_cluster_role]

Reference Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Kubernetes Cluster Role 
[cmdb_ci_kubernetes_cluster_role]

Reference SG-GCP Extension Attributes 
[sn_gcp_integ_extension_attributes]

Kubernetes Cluster Role 
[cmdb_ci_kubernetes_cluster_role]

Reference Key Value [cmdb_key_value]

Kubernetes Cluster Role Binding [cmdb_ci_kubernetes_cluster_role_binding]

The following attributes in the Kubernetes Cluster Role Binding 
[cmdb_ci_kubernetes_cluster_role_binding] table are populated by collected data:

Attribute label Attribute name

Kubernetes UID k8s_uid

Comments comments

Description short_description

Install Status install_status

Name name

Kubernetes Cluster cluster

Operational status operational_status

Relationships created for Kubernetes Cluster Role Binding

Parent class Relationship type Child class

Kubernetes Cluster 
Role Binding 
[cmdb_ci_kubernetes_cluster_role_binding]

Hosted on::Hosts Google Datacenter 
[cmdb_ci_google_datacenter]
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Relationships created for Kubernetes Cluster Role Binding  (continued)

Parent class Relationship type Child class

Kubernetes Cluster 
Role Binding 
[cmdb_ci_kubernetes_cluster_role_binding]

Hosted on::Hosts Cloud Service Account 
[cmdb_ci_cloud_service_account]

Kubernetes Cluster 
Role Binding 
[cmdb_ci_kubernetes_cluster_role_binding]

Reference Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Kubernetes Cluster 
Role Binding 
[cmdb_ci_kubernetes_cluster_role_binding]

Reference SG-GCP Extension Attributes 
[sn_gcp_integ_extension_attributes]

Kubernetes Cluster 
Role Binding 
[cmdb_ci_kubernetes_cluster_role_binding]

Reference Key Value [cmdb_key_value]

Kubernetes Deployment [cmdb_ci_kubernetes_deployment]

The following attributes in the Kubernetes Deployment [cmdb_ci_kubernetes_deployment] table 
are populated by collected data:

Attribute label Attribute name

Kubernetes UID k8s_uid

Name name

Namespace namespace

Available Replicas available_replicas

Description short_description

Desired Replicas desired_replicas

Install Status install_status

Kubernetes Cluster cluster

Operational status operational_status

Total Replicas total_replicas

Unavailable Replicas unavailable_replicas

Updated Replicas updated_replicas

Relationships created for Kubernetes Deployment

Parent class Relationship type Child class

Kubernetes Deployment 
[cmdb_ci_kubernetes_deployment]

Hosted on::Hosts Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Kubernetes Deployment 
[cmdb_ci_kubernetes_deployment]

Hosted on::Hosts Cloud Service Account 
[cmdb_ci_cloud_service_account]
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Relationships created for Kubernetes Deployment  (continued)

Parent class Relationship type Child class

Kubernetes Deployment 
[cmdb_ci_kubernetes_deployment]

Reference Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Kubernetes Deployment 
[cmdb_ci_kubernetes_deployment]

Reference Key Value [cmdb_key_value]

Kubernetes Deployment 
[cmdb_ci_kubernetes_deployment]

Reference SG-GCP Extension Attributes 
[sn_gcp_integ_extension_attributes]

Kubernetes Namespace [cmdb_ci_kubernetes_namespace]

The following attributes in the Kubernetes Namespace [cmdb_ci_kubernetes_namespace] table 
are populated by collected data:

Attribute label Attribute name

Kubernetes UID k8s_uid

Name name

Description short_description

Install Status install_status

Namespace namespace

Operational status operational_status

Relationships created for Kubernetes Namespace

Parent class Relationship type Child class

Kubernetes Namespace 
[cmdb_ci_kubernetes_namespace]

Contains::Contained by Kubernetes Service 
[cmdb_ci_kubernetes_service]

Kubernetes Namespace 
[cmdb_ci_kubernetes_namespace]

Contains::Contained by Kubernetes Deployment 
[cmdb_ci_kubernetes_deployment]

Kubernetes Namespace 
[cmdb_ci_kubernetes_namespace]

Contains::Contained by Kubernetes ReplicaSet 
[cmdb_ci_kubernetes_replicaset]

Kubernetes Namespace 
[cmdb_ci_kubernetes_namespace]

Contains::Contained by Kubernetes Pod 
[cmdb_ci_kubernetes_pod]

Kubernetes Namespace 
[cmdb_ci_kubernetes_namespace]

Hosted on::Hosts Cloud Service Account 
[cmdb_ci_cloud_service_account]

Kubernetes Namespace 
[cmdb_ci_kubernetes_namespace]

Reference Key Value [cmdb_key_value]

Kubernetes Namespace 
[cmdb_ci_kubernetes_namespace]

Reference SG-GCP Extension Attributes 
[sn_gcp_integ_extension_attributes]

Kubernetes Node [cmdb_ci_kubernetes_node]

The following attributes in the Kubernetes Node [cmdb_ci_kubernetes_node] table are populated 
by collected data:
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Attribute label Attribute name

IP Address ip_address

Kubernetes UID k8s_uid

Name name

Description short_description

Install Status install_status

Namespace namespace

Operational status operational_status

Kubernetes Cluster cluster

Relationships created for Kubernetes Node

Parent class Relationship type Child class

Kubernetes Node 
[cmdb_ci_kubernetes_node]

Hosted on::Hosts Google Datacenter 
[cmdb_ci_google_datacenter]

Kubernetes Node 
[cmdb_ci_kubernetes_node]

Hosted on::Hosts Cloud Service Account 
[cmdb_ci_cloud_service_account]

Kubernetes Node 
[cmdb_ci_kubernetes_node]

Reference Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Kubernetes Node 
[cmdb_ci_kubernetes_node]

Reference SG-GCP Extension Attributes 
[sn_gcp_integ_extension_attributes]

Kubernetes Node 
[cmdb_ci_kubernetes_node]

Reference Key Value [cmdb_key_value]

Kubernetes Node Pool [cmdb_ci_kubernetes_node_pool]

The following attributes in the Kubernetes Node Pool [cmdb_ci_kubernetes_node_pool] table are 
populated by collected data:

Attribute label Attribute name

Name name

Object ID object_id

Disk Type disk_type

Image Type image_type

Install Status install_status

Machine Type machine_type

Operational status operational_status

Pod CIDR Range podIpv4CidrSize

Resource version resource_version

Kubernetes Cluster cluster
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Relationships created for Kubernetes Node Pool

Parent class Relationship type Child class

Kubernetes Node Pool 
[cmdb_ci_kubernetes_node_pool]

Hosted on::Hosts Google Datacenter 
[cmdb_ci_google_datacenter]

Kubernetes Node Pool 
[cmdb_ci_kubernetes_node_pool]

Uses::Used by Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Kubernetes Node Pool 
[cmdb_ci_kubernetes_node_pool]

Reference Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Kubernetes Node Pool 
[cmdb_ci_kubernetes_node_pool]

Reference Key Value [cmdb_key_value]

Kubernetes Node Pool 
[cmdb_ci_kubernetes_node_pool]

Reference SG-GCP Extension Attributes 
[sn_gcp_integ_extension_attributes]

Kubernetes Pod [cmdb_ci_kubernetes_pod]

The following attributes in the Kubernetes Pod [cmdb_ci_kubernetes_pod] table are populated 
by collected data:

Attribute label Attribute name

Kubernetes UID k8s_uid

Name name

Namespace namespace

Description short_description

Host IP host_ip

Install Status install_status

IP Address ip_address

Operational status operational_status

Resource version resource_version

Relationships created for Kubernetes Pod

Parent class Relationship type Child class

Kubernetes Pod 
[cmdb_ci_kubernetes_pod]

Contains::Contained by Docker Image 
[cmdb_ci_docker_image]

Kubernetes Pod 
[cmdb_ci_kubernetes_pod]

Hosted on::Hosts Cloud Service Account 
[cmdb_ci_cloud_service_account]

Kubernetes Pod 
[cmdb_ci_kubernetes_pod]

Contains::Contained by Kubernetes Volume 
[cmdb_ci_kubernetes_volume]

Kubernetes Pod 
[cmdb_ci_kubernetes_pod]

Contains::Contained by Docker Container 
[cmdb_ci_docker_container]

Kubernetes Pod 
[cmdb_ci_kubernetes_pod]

Reference Key Value [cmdb_key_value]
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Relationships created for Kubernetes Pod  (continued)

Parent class Relationship type Child class

Kubernetes Pod 
[cmdb_ci_kubernetes_pod]

Reference SG-GCP Extension Attributes 
[sn_gcp_integ_extension_attributes]

Kubernetes ReplicaSet [cmdb_ci_kubernetes_replicaset]

The following attributes in the Kubernetes ReplicaSet [cmdb_ci_kubernetes_replicaset] table are 
populated by collected data:

Attribute label Attribute name

Kubernetes UID k8s_uid

Name name

Namespace namespace

Description short_description

Desired Replicas desired_replicas

Install Status install_status

Operational status operational_status

SelfLink self_link

Total Replicas total_replicas

Kubernetes Cluster cluster

Relationships created for Kubernetes ReplicaSet

Parent class Relationship type Child class

Kubernetes ReplicaSet 
[cmdb_ci_kubernetes_replicaset]

Hosted on::Hosts Cloud Service Account 
[cmdb_ci_cloud_service_account]

Kubernetes ReplicaSet 
[cmdb_ci_kubernetes_replicaset]

Hosted on::Hosts Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Kubernetes ReplicaSet 
[cmdb_ci_kubernetes_replicaset]

Reference Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Kubernetes ReplicaSet 
[cmdb_ci_kubernetes_replicaset]

Reference Key Value [cmdb_key_value]

Kubernetes ReplicaSet 
[cmdb_ci_kubernetes_replicaset]

Reference SG-GCP Extension Attributes 
[sn_gcp_integ_extension_attributes]

Kubernetes Service [cmdb_ci_kubernetes_service]

The following attributes in the Kubernetes Service [cmdb_ci_kubernetes_service] table are 
populated by collected data:
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Attribute label Attribute name

Kubernetes UID k8s_uid

Name name

Namespace namespace

Description short_description

Install Status install_status

IP Address ip_address

Operational status operational_status

Relationships created for Kubernetes Service

Parent class Relationship type Child class

Kubernetes Service 
[cmdb_ci_kubernetes_service]

Hosted on::Hosts Cloud Service Account 
[cmdb_ci_cloud_service_account]

Kubernetes Service 
[cmdb_ci_kubernetes_service]

Reference Key Value [cmdb_key_value]

Kubernetes Service 
[cmdb_ci_kubernetes_service]

Reference SG-GCP Extension Attributes 
[sn_gcp_integ_extension_attributes]

Kubernetes Volume [cmdb_ci_kubernetes_volume]

The following attributes in the Kubernetes Volume [cmdb_ci_kubernetes_volume] table are 
populated by collected data:

Attribute label Attribute name

Kubernetes UID k8s_uid

Mount Path mount_path

Name name

Volume ID volume_id

Namespace namespace

Load Balancer Pool [cmdb_ci_lb_pool]

The following attributes in the Load Balancer Pool [cmdb_ci_lb_pool] table are populated by 
collected data:

Attribute label Attribute name

Name name

Object ID object_id

Install Status install_status

Operational status operational_status
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Relationships created for Load Balancer Pool

Parent class Relationship type Child class

Load Balancer Pool 
[cmdb_ci_lb_pool]

Hosted on::Hosts Google Datacenter 
[cmdb_ci_google_datacenter]

Load Balancer Pool 
[cmdb_ci_lb_pool]

Owns::Owned by Load Balancer Pool Member 
[cmdb_ci_lb_pool_member]

Load Balancer Pool 
[cmdb_ci_lb_pool]

Reference Key Value [cmdb_key_value]

Load Balancer Pool 
[cmdb_ci_lb_pool]

Reference SG-GCP Extension Attributes 
[sn_gcp_integ_extension_attributes]

Load Balancer Pool Member [cmdb_ci_lb_pool_member]

The following attributes in the Load Balancer Pool Member [cmdb_ci_lb_pool_member] table are 
populated by collected data:

Attribute label Attribute name

Name name

Object ID object_id

Install status install_status

Operational status operational_status

Relationship created for Load Balancer Pool Member

Parent class Relationship type Child class

Load Balancer Pool Member 
[cmdb_ci_lb_pool_member]

Reference SG-GCP Extension Attributes 
[sn_gcp_integ_extension_attributes]

Load Balancer Service [cmdb_ci_lb_service]

The following attributes in the Load Balancer Service [cmdb_ci_lb_service] table are populated 
by collected data:

Attribute label Attribute name

IP Address ip_address

Name name

Object ID object_id

Port port

Install Status install_status

Listener Protocol listener_protocol

Operational status operational_status

Service Type service_type
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Relationships created for Load Balancer Service

Parent class Relationship type Child class

Load Balancer Service 
[cmdb_ci_lb_service]

Contains::Contained by Load Balancer Pool 
[cmdb_ci_lb_pool]

Load Balancer Service 
[cmdb_ci_lb_service]

Hosted on::Hosts Cloud Load Balancer 
[cmdb_ci_cloud_load_balancer]

Load Balancer Service 
[cmdb_ci_lb_service]

Reference SG-GCP Extension Attributes 
[sn_gcp_integ_extension_attributes]

Load Balancer Service 
[cmdb_ci_lb_service]

Reference Key Value [cmdb_key_value]

Network ACL [cmdb_ci_network_acl]

The following attributes in the Network ACL [cmdb_ci_network_acl] table are populated by 
collected data:

Attribute label Attribute name

Name name

Object ID object_id

Description short_description

Install Status install_status

Operational status operational_status

Relationships created for Network ACL

Parent class Relationship type Child class

Network ACL 
[cmdb_ci_network_acl]

Contains::Contained by Network ACL Rule 
[cmdb_ci_network_acl_rule]

Network ACL 
[cmdb_ci_network_acl]

Reference Key Value [cmdb_key_value]

Network ACL Rule [cmdb_ci_network_acl_rule]

The following attributes in the Network ACL Rule [cmdb_ci_network_acl_rule] table are populated 
by collected data:

Attribute label Attribute name

Name name

Allow Deny allow_deny

Allowed\Denied Traffic allowed_denied_traffic

Destination Ranges destination_ranges

Install Status install_status
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Attribute label Attribute name

Operational status operational_status

Outbound is_outbound

Source Ranges source_ranges

Target Tags target_tags

Relationship created for Network ACL Rule

Parent class Relationship type Child class

Network ACL Rule 
[cmdb_ci_network_acl_rule]

Reference Key Value [cmdb_key_value]

Server [cmdb_ci_server]

The following attributes in the Server [cmdb_ci_server] table are populated by collected data:

Attribute label Attribute name

Name name

Object ID object_id

Class sys_class_name

CPU count cpu_count

Disk space (GB) disk_space

Host name host_name

Install Status install_status

IP Address ip_address

Is Virtual virtual

Operating System os

Operational status operational_status

OS Version os_version

RAM (MB) ram

Relationships created for Server

Parent class Relationship type Child class

Server [cmdb_ci_server] Virtualized by::Virtualizes Virtual Machine Instance 
[cmdb_ci_vm_instance]

Server [cmdb_ci_server] Owns::Owned by IP Address 
[cmdb_ci_ip_address]

Server [cmdb_ci_server] Reference Software Installation 
[cmdb_sam_sw_install]

Server [cmdb_ci_server] Reference Key Value [cmdb_key_value]
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Relationships created for Server  (continued)

Parent class Relationship type Child class

Server [cmdb_ci_server] Reference SG-GCP Extension Attributes 
[sn_gcp_integ_extension_attributes]

SG-GCP Extension Attributes [sn_gcp_integ_extension_attributes]

The following attributes in the SG-GCP Extension Attributes [sn_gcp_integ_extension_attributes] 
table are populated by collected data:

Attribute label Attribute name

Resource ID resource_id

Folder ID folder_id

Organization ID organization_id

Parent parent

Project project

Project ID project_id

Self Link self_link

Service Graph Connection Record sg_connection_record

Region region

Resource Type resource_type

Organization-Credential Record org_credential_record

Software [cmdb_ci_spkg]

The following attributes in the Software [cmdb_ci_spkg] table are populated by collected data 
when the Software Asset Management  (SAM) application isn't installed:

Attribute label Attribute name

Key key

Discovery source discovery_source

Name name

Version version

Manufacturer manufacturer

Relationship created for Software

Parent class Relationship type Child class

Software [cmdb_ci_spkg] Reference Software Instance 
[cmdb_software_instance]

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1029



Software Installation [cmdb_sam_sw_install]

The following attributes in the Software Installation [cmdb_sam_sw_install] table are populated 
by collected data when the SAM application is installed:

Attribute label Attribute name

Display name display_name

Publisher publisher

Version version

Discovery source discovery_source

Last scanned last_scanned

Installed on installed_on

Relationship created for Software Installation

Parent class Relationship type Child class

Software Installation 
[cmdb_sam_sw_install]

Reference Server [cmdb_ci_server]

Software Instance [cmdb_software_instance]

The following attributes in the Software Instance [cmdb_software_instance] table are populated 
by collected data when the SAM application isn't installed:

Attribute label Attribute name

Name name

Installed on installed_on

Install date install_date

Relationship created for Software Instance

Parent class Relationship type Child class

Software Instance 
[cmdb_software_instance]

Reference Server [cmdb_ci_server]

Storage Mapping [cmdb_ci_storage_mapping]

The following attributes in the Storage Mapping [cmdb_ci_storage_mapping] table are populated 
by collected data:

Attribute label Attribute name

Name name

Object ID object_id

Install Status install_status
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Attribute label Attribute name

Mapping Type mapping_type

Operational status operational_status

Storage Volume [cmdb_ci_storage_volume]

The following attributes in the Storage Volume [cmdb_ci_storage_volume] table are populated by 
collected data:

Attribute label Attribute name

Object ID object_id

Volume ID volume_id

Install Status install_status

Name name

Operational status operational_status

Size bytes size_bytes

State state

Storage type storage_type

Relationships created for Storage Volume

Parent class Relationship type Child class

Storage Volume 
[cmdb_ci_storage_volume]

Hosted on::Hosts Google Datacenter 
[cmdb_ci_google_datacenter]

Storage Volume 
[cmdb_ci_storage_volume]

Reference Key Value [cmdb_key_value]

Storage Volume 
[cmdb_ci_storage_volume]

Reference SG-GCP Extension Attributes 
[sn_gcp_integ_extension_attributes]

Storage Volume Snapshot [cmdb_ci_storage_vol_snapshot]

The following attributes in the Storage Volume Snapshot [cmdb_ci_storage_vol_snapshot] table 
are populated by collected data:

Attribute label Attribute name

Name name

Object ID object_id

Capacity capacity

Install Status install_status

Operational status operational_status

Parent ID parent_id

Size (GB) size
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Attribute label Attribute name

State state

Volume Name volume_name

Relationships created for Storage Volume Snapshot

Parent class Relationship type Child class

Storage Volume Snapshot 
[cmdb_ci_storage_vol_snapshot]

Hosted on::Hosts Google Datacenter 
[cmdb_ci_google_datacenter]

Storage Volume Snapshot 
[cmdb_ci_storage_vol_snapshot]

Provisioned From::Provisioned Storage Volume 
[cmdb_ci_storage_volume]

Storage Volume Snapshot 
[cmdb_ci_storage_vol_snapshot]

Reference Key Value [cmdb_key_value]

Storage Volume Snapshot 
[cmdb_ci_storage_vol_snapshot]

Reference SG-GCP Extension Attributes 
[sn_gcp_integ_extension_attributes]

Virtual Machine Instance [cmdb_ci_vm_instance]

The following attributes in the Virtual Machine Instance [cmdb_ci_vm_instance] table are 
populated by collected data:

Attribute label Attribute name

Name name

Object ID object_id

CPUs cpus

Disks disks

Disks size (GB) disks_size

Install Status install_status

IP Address ip_address

Memory (MB) memory

Network adapters nics

Operational status operational_status

State state

Termination Protection termination_protection

VM Instance ID vm_inst_id

Relationships created for Virtual Machine Instance

Parent class Relationship type Child class

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Provisioned From::Provisioned Hardware Type 
[cmdb_ci_compute_template]
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Relationships created for Virtual Machine Instance  (continued)

Parent class Relationship type Child class

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Contains::Contained by Cloud Subnet 
[cmdb_ci_cloud_subnet]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Hosted on::Hosts Google Datacenter 
[cmdb_ci_google_datacenter]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Contains::Contained by Cloud Mgmt Network Interface 
[cmdb_ci_nic]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Contains::Contained by Storage Mapping 
[cmdb_ci_storage_mapping]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Provisioned From::Provisioned Image [cmdb_ci_os_template]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Use End Point To::Use End 
Point From

Block Endpoint 
[cmdb_ci_endpoint_block]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Hosted on::Hosts Google Organization Project 
[cmdb_ci_gcp_project]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Reference Key Value [cmdb_key_value]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Reference SG-GCP Extension Attributes 
[sn_gcp_integ_extension_attributes]

VNIC Endpoint [cmdb_ci_endpoint_vnic]

The following attributes in the VNIC Endpoint [cmdb_ci_endpoint_vnic] table are populated by 
collected data:

Attribute label Attribute name

Host host

Name name

Object ID object_id

Install Status install_status

IP Address ip_address

Operational status operational_status

Relationship created for VNIC Endpoint

Parent class Relationship type Child class

VNIC Endpoint 
[cmdb_ci_endpoint_vnic]

Implement End Point 
To::Implement End Point From

Cloud Mgmt Network Interface 
[cmdb_ci_nic]

Accessing the connection details of Service Graph Connector for GCP

You can access the connection details of the Service Graph Connector for GCP  in a single view 
using the common connection framework (CCF) included within the Integration Commons for 
CMDB  (sn_cmdb_int_util) store app.
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With the CCF, you can access all the connections used by the Service Graph Connector for GCP. 
The connection details include the connection alias, connection properties, data sources, and 
scheduled data imports associated with a connection. You can also test the connection. For 
more information, see Accessing the connection details of Service Graph Connectors.

Access the details of a GCP  connection

Access the details of a GCP  connection configured for the Service Graph Connector for GCP.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Service Graph Connectors  > GCP  > Connections.

2. From the Name  column of the Service Graph Connections list, select a connection.

3. On the Service Graph Connections page, view the connection details such as the connection 
name, alias, and data sources.

4. Select a related list to view further details of the connection.

5. Optional:  Select the Test Connection  related link to test the connection.

Handling import failures for large GCP  resources

Manage the data source failure when importing resources from GCP.

When importing large GCP  resources, the data sources in the Service Graph Connector for GCP 
might fail because of a Direct REST response exceeding the 1024-MB limit. For more information, 
see REST step .

You can use one or more of the following options to handle the REST response size limitation 
error in the Service Graph Connector for GCP:

• Save the response as an attachment

• Modify the batch size

Save the response as an attachment

With the save response as an attachment feature, the response of each data source is 
temporarily stored as an attachment and after the response is read, the attachment is deleted 
automatically. The save response as an attachment feature is activated by default and is 
triggered by the sn_gcp_integ.save_rest_response_as_attachment  system 
property.

As a user with the admin role, you can deactivate the save response as an attachment feature 
by setting the sn_gcp_integ.save_rest_response_as_attachment  property to 
false. When the feature is deactivated and the response size is within the limit, the data 
sources run normally.

Modify the batch size

By default, the maximum batch size of the environment variable for a data source is set to 100 
records. You can reduce or increase the batch size based on the data volume. To manage the 
batch size of a data source, you must add a system property of integer type for the data source 
as described in the following table.
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System properties for handling the batch size of Service Graph Connector for GCP  data 
sources

Data source System property

SG-GCP Cloud Database sg_gcp_cloud_db_batch_size

SG-GCP Cloud Function sg_gcp_cloud_function_batch_size

SG-GCP Cloud Object 
Storage

sg_gcp_object_storage_batch_size

SG-GCP Kubernetes 
Cluster

sg_gcp_kubernetes_cluster_batch_size

SG-GCP Kubernetes 
Cluster Role

sn_gcp_integ.sg_gcp_kubernetes_cluster_role_batch_size

SG-GCP Kubernetes 
Cluster Role Binding

sn_gcp_integ.sg_gcp_kubernetes_cluster_role_binding_batch_size

SG-GCP Kubernetes 
Deployment

sg_gcp_kubernetes_deployment_batch_size

SG-GCP Kubernetes 
Namespace

sg_gcp_kubernetes_namespace_batch_size

SG-GCP Kubernetes 
Node

sg_gcp_kubernetes_node_batch_size

SG-GCP Kubernetes Pod sg_gcp_kubernetes_pod_batch_size

SG-GCP Kubernetes 
Replicaset

sg_gcp_kubernetes_replicaset_batch_size

SG-GCP Kubernetes 
Service

sg_gcp_kubernetes_service_batch_size

SG-GCP Load Balancer sg_gcp_load_balancer_batch_size

SG-GCP Load Balancer 
Health Service

sg_gcp_lb_health_service_batch_size

SG-GCP Load Balancer 
Pool

sg_gcp_lb_pool_batch_size

SG-GCP Load Balancer 
Pool Member

sg_gcp_lb_pool_member_batch_size

SG-GCP Load Balancer 
Service

sn_gcp_integ.sg_gcp_lb_service_batch_size

SG-GCP Network sg_gcp_network_batch_size

SG-GCP Kubernetes 
Node Pool

sn_gcp_integ.sg_gcp_kubernetes_node_pool_batch_size

SG-GCP Security Group sg_gcp_security_group_batch_size

SG-GCP Software 
Inventory

sg_gcp_software_inventory_batch_size

SG-GCP Storage Volume sg_gcp_storage_volume_batch_size

SG-GCP Storage Volume 
Snapshot

sg_gcp_storage_vol_snapshot_batch_size
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System properties for handling the batch size of Service Graph Connector for GCP  data 
sources  (continued)

Data source System property

SG-GCP Subnet sg_gcp_subnet_batch_size

SG-GCP VM Instance sg_gcp_vm_instance_batch_size

Note: 
You must add these system properties as they aren't available by default. You must have 
the admin role to add or modify a system property. For more information, see Add a system 
property .

Deep discovery for Service Graph Connector for GCP

The SG-GCP Execute Patch Job and SG-GCP Get Patch Job scheduled import jobs enable deep 
discovery by running patch jobs at the GCP  project level.

Deep discovery involves fetching server data. The deep discovery data populates host name, 
serial number, CPU data, TCP connections, and running processes data into the CMDB.

The Service Graph Connector for GCP  uses OS Config Patch jobs on GCP  projects to execute 
the deep discovery commands on the VMs. These patch jobs run independently on Linux  and 
Windows  VMs.

The following scheduled imports execute the OS Config Patch jobs, and then read and delete 
the output:

• SG-GCP Execute Patch Job

• SG-GCP Get Patch Job

Deep discovery connection properties

Deep discovery connection properties

Connection property name Connection property value

Scripts Bucket Name Name of the Cloud Storage Bucket where the 
deep discovery scripts are saved.

Outputs Bucket Name Name of the output Cloud Storage Bucket.

Outputs Storage Path Path of the output Cloud Storage Bucket.

Shell Script Object Path Path of the deep discovery Shell script file.

Shell Script Generation Number Number that is used to identify the versioning 
of the cloud storage object.

PowerShell Script Object Path Path of the deep discovery PowerShell script 
file.

PowerShell Script Generation Number Number that is used to identify the versioning 
of the cloud storage object.

SG-GCP Execute Patch Job

The SG-GCP Execute Patch Job scheduled import reads the path of the Shell and PowerShell 
scripts uploaded to the Cloud Storage Bucket and the generation numbers from the deep 
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discovery connection properties. The scheduled import then runs the commands on Linux  and 
Windows  VMs separately.

In the Import Set table for the SG-GCP Execute Patch Job import schedule, each project will 
have two rows, one for Linux  VMs and the other for Windows  VMs. The Import Set  rows remain 
in Pending  state because no transformations are required for these rows. The Import Set  rows 
include the patch job ID and the list of instances on which the deep discovery script is run. The 
output is stored in the Cloud Storage Bucket with the Object ID of the VMs on which the deep 
discovery commands are run.

SG-GCP Get Patch Job

The SG-GCP Get Patch Job scheduled import reads the output of the commands that are run 
on the Linux  and Windows  VMs. The scheduled import reads the output from the output bucket 
and folder path that are specified in the deep discovery connection properties. The SG-GCP Get 
Patch Job scheduled import then deletes the output from the Cloud Storage Bucket. The Import 
Set  rows are processed using Application Dependency Mapping (ADM) to populate the Server 
records with the data of the VMs on which deep discovery was run. The Import Set  rows include 
VM data such as running processes, TCP connections, and CPU information.

Application Dependency Mapping

Using the deep discovery information, Application Dependency Mapping (ADM) creates and 
classifies the following applications from the imported middleware information:

• Apache Web Server

• MongoDB Instance

• MSFT SQL Instance

• MySQL Instance

• Nginx Web Server

• Oracle Database Listener

• Oracle Instance

• PostgreSQL Instance

• Tomcat

Additional resource

Service Graph Connector for GCP - Deep Discovery Setup Instructions [KB2213095]  article in 
the Now Support  Knowledge Base

Life cycle management of records in Service Graph Connector for GCP

Life cycle management in the in the Service Graph Connector for GCP  monitors and updates the 
statuses of GCP  resources throughout their entire life cycle, from creation to deletion.

The life cycle management process helps maintain the accuracy and integrity of data in the 
Configuration Management Database (CMDB).

In life cycle management, the record removal process involves systematically deleting obsolete 
or unnecessary resources. This step ensures that outdated entries are cleared, keeping the 
CMDB  accurate and up-to-date. See Record removal process in Service Graph Connector for 
GCP.
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Life cycle management for CIs in Service Graph Connector for GCP

The following table lists the configuration items (CIs) for which life cycle management is available 
in Service Graph Connector for GCP.

Supported CIs for life cycle management

Data source CMDB  CI classes
Life cycle 
management 
available

SG-GCP Organization Cloud Organizations [cmdb_ci_cloud_org] Yes

SG-GCP Folder Google Organization Folder 
[cmdb_ci_gcp_folder]

Yes

Google Organization Project 
[cmdb_ci_gcp_project]

YesSG-GCP Project

Cloud Service Account 
[cmdb_ci_cloud_service_account]

Yes

SG-GCP Network Cloud Network [cmdb_ci_network] Yes

SG-GCP Machine Image Image [cmdb_ci_os_template] Not applicable

Cloud Subnet [cmdb_ci_cloud_subnet] YesSG-GCP Subnet

Google Datacenter 
[cmdb_ci_google_datacenter]

Not applicable

SG-GCP Storage Volume Storage Volume [cmdb_ci_storage_volume] Yes

SG-GCP Storage Volume 
Snapshot

Storage Volume Snapshot 
[cmdb_ci_storage_vol_snapshot]

Yes

Compute Security Group 
[cmdb_ci_compute_security_group]

Yes

Network ACL [cmdb_ci_network_acl] Yes

SG-GCP Security Group

Network ACL Rule [cmdb_ci_network_acl_rule] Yes

SG-GCP Software 
Inventory

Software [cmdb_ci_spkg]

Software Instance [cmdb_software_instance]

Software Installation [cmdb_sam_sw_install]

Yes

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Yes

Server [cmdb_ci_server] Yes

Storage Mapping [cmdb_ci_storage_mapping] Yes

VNIC Endpoint [cmdb_ci_endpoint_vnic] Yes

Block Endpoint [cmdb_ci_endpoint_block] Yes

IP Address [cmdb_ci_ip_address] Yes

Cloud Mgmt Network Interface [cmdb_ci_nic] Yes

SG-GCP VM Instance

Hardware Type [cmdb_ci_compute_template] Not applicable
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Supported CIs for life cycle management  (continued)

Data source CMDB  CI classes
Life cycle 
management 
available

Image [cmdb_ci_os_template] Yes

Availability Zone [cmdb_ci_availability_zone] Not applicable

SG-GCP Execute Patch 
Job

Not applicable Not applicable

Hardware Type [cmdb_ci_compute_template] Not applicable

Google Datacenter 
[cmdb_ci_google_datacenter]

Not applicable

SG-GCP Hardware Type

Availability Zone [cmdb_ci_availability_zone] Not applicable

SG-GCP VM Hw 
Consolidation

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Not applicable

SG-GCP Load Balancer 
Pool

Load Balancer Pool [cmdb_ci_lb_pool] Yes

SG-GCP load Balancer 
Pool Member

Load Balancer Pool Member 
[cmdb_ci_lb_pool_member]

Yes

SG-GCP Load Balancer 
Health Service

Cloud Load Balancer Health Service 
[cmdb_ci_lb_health_service]

Yes

SG-GCP Load Balancer Cloud Load Balancer 
[cmdb_ci_cloud_load_balancer]

Yes

SG-GCP Load Balancer 
Service

Load Balancer Service [cmdb_ci_lb_service] Yes

SG-GCP Cloud Database Cloud DataBase [cmdb_ci_cloud_database] Yes

SG-GCP Cloud Function Cloud Function [cmdb_ci_cloud_function] Yes

SG-GCP Cloud Object 
Storage

Cloud Object Storage 
[cmdb_ci_cloud_object_storage]

Yes

SG-GCP Kubernetes 
Cluster

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Yes

SG-GCP Kubernetes 
Node

Kubernetes Node [cmdb_ci_kubernetes_node] Yes

Kubernetes Pod [cmdb_ci_kubernetes_pod] Yes

Kubernetes Volume 
[cmdb_ci_kubernetes_volume]

No

Docker Image [cmdb_ci_docker_image] No

SG-GCP Kubernetes Pod

Docker Container [cmdb_ci_docker_container] Yes

SG-GCP Kubernetes 
Service

Kubernetes Service 
[cmdb_ci_kubernetes_service]

Yes

SG-GCP Kubernetes 
Namespace

Kubernetes Namespace 
[cmdb_ci_kubernetes_namespace]

Yes
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Supported CIs for life cycle management  (continued)

Data source CMDB  CI classes
Life cycle 
management 
available

SG-GCP Kubernetes 
Deployment

Kubernetes Deployment 
[cmdb_ci_kubernetes_deployment]

Yes

SG-GCP Kubernetes 
Replicaset

Kubernetes ReplicaSet 
[cmdb_ci_kubernetes_replicaset]

Yes

SG-GCP Kubernetes 
Cluster Roles

Kubernetes Cluster Role 
[cmdb_ci_kubernetes_cluster_role]

Yes

SG-GCP Kubernetes 
Cluster Role Binding

Kubernetes Cluster Role Binding 
[cmdb_ci_kubernetes_cluster_role_binding]

Yes

SG-GCP Kubernetes 
Node Pool

Kubernetes Node Pool 
[cmdb_ci_kubernetes_node_pool]

Yes

SG-GCP Generic 
Resource

Cloud Resource [cmdb_ci_cmp_resource] Yes

SG-GCP Annotation Key Value [cmdb_key_value] Not applicable

SG-GCP Get Patch Job Not applicable Not applicable

SG-GCP Generic 
Resource Annotation

Key Value [cmdb_key_value] Not applicable

Record removal process in Service Graph Connector for GCP

The Service Graph Connector for GCP  uses soft deletion and hard deletion to manage the 
removal of records.

Record removal is the process of handling data that is no longer needed. For any discovered 
resources that are deleted later after pulling data, the Service Graph Connector for GCP 
automatically updates the Install Status  field of the associated CMDB  CI classes to indicate any 
retired or deleted records.

• Soft deletion

• Hard deletion

Soft deletion

Soft deletion involves marking the install status of a record as retired  rather than permanently 
deleting it from the system. The record remains in the database, making it possible to reference 
or restore it later. Soft deletion for Service Graph Connector for GCP  relies on the SG-GCP 
Extension Attributes [sn_gcp_integ_extension_attributes] table. This table is regularly purged of 
obsolete records, improving performance and efficiency. The process marks the install status 
of a record as retired, but the streamlined data structure reduces overhead, enabling quicker 
processing and better system performance.

Soft deletion is enabled for the following data sources in Service Graph Connector for GCP:

• SG-GCP Folder

• SG-GCP Project

• SG-GCP Network

• SG-GCP Subnet
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• SG-GCP Storage Volume

• SG-GCP Storage Volume Snapshot

• SG-GCP Security Group

• SG-GCP VM Instance

• SG-GCP Load Balancer Pool

• SG-GCP Load Balancer Pool Member

• SG-GCP Load Balancer Health Service

• SG-GCP Load Balancer

• SG-GCP Load Balancer Service

• SG-GCP Cloud Database

• SG-GCP Cloud Function

• SG-GCP Cloud Object Storage

• SG-GCP Kubernetes Cluster

• SG-GCP Kubernetes Node

• SG-GCP Kubernetes Pod

• SG-GCP Kubernetes Service

• SG-GCP Kubernetes Namespace

• SG-GCP Kubernetes Deployment

• SG-GCP Kubernetes Replicaset

• SG-GCP Kubernetes Cluster Roles

• SG-GCP Kubernetes Cluster Role Binding

• SG-GCP Kubernetes Node Pool

Starting with the Service Graph Connector for GCP  1.10 version, the SG-GCP Generic 
Resource data source uses the post-script method for soft deletion, which relies on the Source 
[sys_object_source] table. For more information about the post-script method, see Post-script 
method.

Hard deletion

Hard deletion involves permanently deleting a record from the system. The record is removed 
from the CMDB  and can't be referenced or restored later. The SG-GCP Software Inventory data 
source uses the hard deletion method for the deletion of records.

Service Graph Connector for Google Console

Use the Service Graph Connector for Google Console  to import device details from 
Chromebooks  into the Configuration Management Database (CMDB).

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .
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Key features

• Get visibility across Chromebook  devices.

• Get started quickly with a streamlined onboarding process.

• Use only the credentials you need.

Supported versions

Versions

Google Console ServiceNow

Last tested on July 05, 2024 • Xanadu

• Washington DC

• Vancouver

• Utah

Use cases

You can use the Service Graph Connector for Google Console  to get visibility into Google 
ChromeOS  devices, enabling administrators to centrally manage enrollment, configuration, and 
monitoring these devices.

Guided setup

The guided setup for the Service Graph Connector for Google Console  provides an organized 
sequence of tasks to configure the integration on your instance. To access the guided setup, see 
Configure Service Graph Connector for Google Console.

CMDB integrations dashboard

The Integration Commons for CMDB  store app provides a dashboard with a central view of 
the status, processing results, and processing errors of all installed integrations. You can see 
metrics for all integration runs. You can filter the view to a specific CMDB  integration, a specific 
time duration, or a specific integration run. For more details about monitoring Google Console 
integrations in the CMDB  Integrations Dashboard, see Using the CMDB Integrations Dashboard.

Data mapping

Data from the Google Console  data source is mapped and transformed into the ServiceNow 
CMDB  Configuration Item (CI) class definitions using the Robust Transform Engine (RTE). Data is 
inserted into the ServiceNow  CMDB  using the Identification and Reconciliation Engine (IRE).

When you complete setting up the connection, you can configure the integration to periodically 
pull data from the Google Console  application.

Note: 
For any discovered resources that were deleted later, the Service Graph Connector for 
Google Console  automatically marks the corresponding records as no longer active or valid 
in CMDB.
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The following table lists the data sources, the staging tables, and the target tables as CMDB CI 
classes as where data is stored for a Chromebook  device within Google Console.

Data mapping for Google Console

Data source Staging table
CMDB  CI 
classes

Resource 
type

SG-
GoogleConsole-
ChromeDevices

SG-GoogleConsole-ChromeDevices 
[sn_googleconsole_i_sg_googleconsole_chromedevices]

Computer

IP Address

Network 
Adapter

When the 
Software 
Asset 
Management 
(SAM) 
and SAM 
Foundation 
applications 
are not 
installed:

Software

Software 
Instance

When 
the SAM 
application, 
the SAM 
Foundation 
application, 
or both are 
installed:

Software 
Installation

Chrome 
OS 
devices

For more information on where data is saved when pulling data from a Chromebook  device, see 
CMDB classes targeted in Service Graph Connector for Google Console.

You can use the IntegrationHub ETL app to view the data maps. See IntegrationHub ETL  for more 
information.

Related topics

Service Graph Connectors

Configure Service Graph Connector for Google Console

Set up scheduled import jobs to pull in Chromebook  device data from the Google Console  into 
your CMDB.
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Before you begin
To use this Service Graph Connector, you need a subscription to a Subscription Unit that is 
based in the IT Operations Management  (ITOM) Visibility application or in the ITOM  Discovery 
application. As defined in the section titled "Managed IT Resource Types" in ServiceNow 
Subscription Unit Overview  for your subscription, for managed IT resources that are created 
or modified in the CMDB  by this Service Graph Connector, but that aren’t yet managed by ITOM 
Visibility or ITOM Discovery , these resources will increase Subscription Unit consumption from 
that application. Review your current Subscription Unit consumption within ITOM Visibility or 
ITOM Discovery to ensure available capacity.

Dependencies and requirements:

• The Integration Commons for CMDB store app, which is automatically installed. See 
Integration Commons for CMDB.

• The CMDB CI class models store app, which is automatically installed. See CMDB CI Class 
Models store app.

• ITOM Licensing plugin (com.snc.itom.license). See Request Discovery .

Role required: admin

Procedure

1. Verify that the application scope is set to the Service Graph Connector for Google Console 
application by using the application picker.
For more information, see Application picker .

2. Navigate to All  > Service Graph Connectors  > Google Console  > Setup.

3. On the Service Graph Connector for Google Console  page, verify that the Quick Start  option is 
selected and then select Continue.

4. Configure the authentication credentials to send requests to the Google Console  API.

a. In the Configure the Connection and Credentials  section of the Service Graph Connector for 
Google Console  page, select Start.

b. Set up the Google Console  environment.

i. Select the Google Console Setup Instructions  task.

ii. Select the link to the Service Graph connector for Google Console - Setup Instructions 
[KB1516892]  article in the Now Support  Knowledge Base and follow the instructions to 
set up the Google Console  environment.

Note: 
Make a note of the destination keystore password. You need to specify this password 
while importing the Java Keystore (JKS) certificate into the Service Graph Connector 
for Google Console  application.

iii. Set the Google Console Setup Instructions  task to complete by selecting the Mark as 
complete  check box and then select Continue.

c. Create an X.509 certificate to associate the JKS certificate for the Google Console 
application with the Service Graph Connector for Google Console.

i. Select the Create X.509 certificate  task.

ii. In the X.509 Certificates  list, select New.

iii. On the form, fill in the fields.
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X.509 Certificate form

Field Description

Name Name of the X.509 certificate. For example, SG-
GoogleConsole-509Certificate.

Type Certificate container. Select Java Key Store.

Key store 
password

Password to access the JKS certificate as noted down in the previous 
step.

Note: 
You can leave the value of other fields as-is.

iv. Select the manage attachments icon ( ).

v. Select Choose file  to browse and upload the keystore.p12 file for the JKS certificate you 
created in the previous step.

vi. Close the dialog box.

vii. Select the Validate Stores/Certificates  related link.

viii. On successful validation, select Update  to return to the guided setup page.

ix. Set the Create X.509 certificate  task to complete by selecting the Mark as complete 
check box and then select Continue.

d. Configure the connection.

i. Verify that the application scope is set to the Service Graph Connector for Google Console 
application by using the application picker.

ii. Select the Configure the Connection  task and then select Click Here.

iii. On the Connections page that opens in another browser tab, select Edit  for the SG-
GoogleConsole  connection that is available by default.

iv. On the form, fill in the fields.

Edit Connection form

Field Description

Connection Name Name to identify the connection record. For example, SG-
GoogleConsole.

Don’t modify the name for the default connection alias SG-
GoogleConsole.

Service Account 
Email

Email address of the service account in Google Console.

Keystore Password The password that you used when you created the JKS file in the 
previous step.

Keystore Select the name of the JKS file you created in the previous step.

v. Select Edit and Get OAuth Token.
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vi. After the OAuth token is generated, return to the guided setup.

vii. Set the Configure the Connection  task to complete by selecting the Mark as complete 
check box and then select Continue.

e. Set up the configuration properties.

i. Select the Add configuration properties  task.

ii. In the Service Graph Connections  section, review and modify the property details 
by selecting a property from the Property  column in the Service Graph Connection 
Properties related list.

You can configure the Customer ID  property to pull Chromebook  devices for the 
specified customer ID.

iii. Select Update  in the Service Graph Connection Properties section.

iv. Set the Add connection properties  task to complete by selecting the Mark as complete 
check box and then select Continue.

f. Test the Google Console  API connection to import data from the Google Console 
application.

i. Select the Test Connection  task.

ii. Test the connection by selecting the Test Connection  related link.

Testing the connection might take a few moments. The page is refreshed to show the test 
results.

iii. When the Status  field is set to Success, select Update.

If any of the tests have errors, follow the suggestions for remediation.

iv. Set the Test Connection  task to complete by selecting the Mark as complete  check box 
and then select Continue.

5. Optional:  Integrate with multiple Google Console  instances.

a. Follow the instructions in the Service Graph connector for Google Console - Setup 
Instructions [KB1516892]  article in the Now Support  Knowledge Base to set up the Google 
Console  environment.

Note: 
Make a note of the destination keystore password.

b. In the Add Multiple Instances  section of the Service Graph Connector for Google Console 
page, select Start.

c. Create data sources for the new Google Console  connection.

i. Ensure that you have edit permissions for the Datasource [sys_data_source] table.

ii. Select the Update Data Source Access  task.

iii. To edit the record, select the Global  application scope from the application picker.

iv. In the Application Access related list of the Data Source form that opens in a new tab, 
select the Can create, Can update, and Can delete  check boxes.

v. Select Update.
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vi. From the application picker, select the Service Graph Connector for Google Console 
application scope.

vii. Set the Update Data Source Access  task to complete by selecting the Mark as complete 
check box and then select Continue.

d. Create a scheduled import job for the new Google Console  connection.

i. Ensure that you have edit permissions for the Scheduled data import 
[scheduled_import_set] table.

ii. Select the Update Scheduled Data Import  task.

iii. To edit the record, select the Global  application scope from the application picker.

iv. In the Application Access related list of the Scheduled Data Import form, select the Can 
create, Can update, and Can delete  check boxes.

v. Select Update.

vi. From the application picker, select the Service Graph Connector for Google Console 
application scope.

vii. Set the Update Scheduled Data Import  task to complete by selecting the Mark as 
complete  check box and then select Continue.

e. Create an X.509 certificate for the new Google Console  instance by repeating the step 
4.c, and then mark the Create X.509 certificate  task to complete by selecting the Mark as 
complete  check box and then select Continue.

f. Add another connection for the new Google Console  instance.

i. Verify that the application scope is set to the Service Graph Connector for Google Console 
application by using the application picker.

ii. Select the Add Another Connection  task and then select Click Here.

iii. On the Connections page that opens in another browser tab, select Add Connection.

iv. On the form, fill in the fields.

Create Connection form

Field Description

Connection Name Name to identify the connection record.

Service Account 
Email

Email address of the service account in Google Console.

Keystore Password The password that you used when you created the JKS file in the 
previous step.

Keystore Select the name of the JKS file you created in the previous step.

v. Select Create and Get OAuth Token.

vi. After the OAuth token is generated, return to the guided setup.

vii. Set the Add Another Connection  task to complete by selecting the Mark as complete 
check box and then select Continue.

g. Add the configuration properties for the new Google Console  instance.
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i. Select the Add configuration properties  task.

ii. Select the connection record you created in the previous step.

iii. In the Service Graph Connections  section, review and modify the property details 
by selecting a property from the Property  column in the Service Graph Connection 
Properties related list.

You can configure the Customer ID  property to pull Chromebook  devices for the 
specified customer ID.

iv. Select Update  in the Service Graph Connection Properties section.

v. Set the Add connection properties  task to complete by selecting the Mark as complete 
check box and then select Continue.

h. Test the Google Console  API connection to import data from new Google Console  instance.

i. Select the Test New Connections  task.

ii. Select the connection record you created in the previous step.

iii. Test the connection by selecting the Test Connection  related link.

Testing the connection might take a few moments. The page is refreshed to show the test 
results.

iv. When the Status  field is set to Success, select Update.

If any of the tests have errors, follow the suggestions for remediation.

v. Set the Test New Connections  task to complete by selecting the Mark as complete  check 
box and then select Continue.

6. Configure the scheduled job for the import of Google Console  data.

a. In the Configure the scheduled jobs  section of the Service Graph Connector for Google 
Console  page, select Start.

b. Select the SG-GoogleConsole-ChromeDevices  scheduled job.
For a multiple instance setup, select the scheduled job created with the scheduled import in 
step 5.d  for the new connection.

c. On the Scheduled Data Import form, verify the field values.

For more information, see Schedule a data import .

d. Select the Active  check box to activate the scheduled job.

e. In the Run  field, select Periodically  to specify how often the job will run.

f. Select Update.

g. Set the Configure the scheduled jobs  task to complete by selecting the Mark as complete 
check box and then select Continue.

7. On the Service Graph Connector for Google Console  page, select Complete  to save your 
changes.
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8. In the Complete setup dialog box, select Complete  to complete the setup.

9. In the message box that appears, select Done.

CMDB  classes targeted in Service Graph Connector for Google Console

When you complete setting up the connection, you can configure the integration to periodically 
pull Google Console  data from Chromebook  devices. The data is saved in tables that extend 
from the Configuration item [cmdb_ci] table.

Computer [cmdb_ci_computer]

The following attributes in the Computer [cmdb_ci_computer] table are populated by collected 
data:

Attribute label Attribute name Google Console  attribute

Install Status install_status status

Model number model_number model

Model ID model_id model

Manufacturer manufacturer model

Name name serialNumber

Serial number serial_number serialNumber

Assigned assigned lastEnrollmentTime

Operating System os os

Operational status operational_status status

OS Version os_version osVersion

Assigned to assigned_to annotatedUser

Relationships created for Computer

Parent class Relationship type Child class

Computer 
[cmdb_ci_computer]

Owns::Owned by Network Adapter 
[cmdb_ci_network_adapter]

Computer 
[cmdb_ci_computer]

Owns::Owned by IP Address 
[cmdb_ci_ip_address]

Computer 
[cmdb_ci_computer]

Reference
When the Software Asset 
Management (SAM) and SAM 
Foundation  applications aren't 
installed:

Software [cmdb_ci_spkg]

Software Instance 
[cmdb_software_instance]

When the SAM or SAM 
Foundation  application is 
installed:
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Relationships created for Computer  (continued)

Parent class Relationship type Child class

Software Installation 
[cmdb_sam_sw_install]

IP Address [cmdb_ci_ip_address]

The following attributes in the IP Address [cmdb_ci_ip_address] table are populated by collected 
data:

Attribute label Attribute name Google Console  attribute

IP Address ip_address lastKnownNetwork.ipAddress

Name name lastKnownNetwork.ipAddress

Nic nic macAddress

Relationship created for IP Address

Parent class Relationship type Child class

IP Address 
[cmdb_ci_ip_address]

Reference Network Adapter 
[cmdb_ci_network_adapter]

Network Adapter [cmdb_ci_network_adapter]

The following attributes in the Network Adapter [cmdb_ci_network_adapter] table are populated 
by collected data:

Attribute label Attribute name Google Console  attribute

Configuration Item cmdb_ci serialNumber

MAC Address mac_address macAddress

Name name macAddress

Relationship created for Network Adapter

Parent class Relationship type Child class

Network Adapter 
[cmdb_ci_network_adapter]

Reference Computer 
[cmdb_ci_computer]

Software [cmdb_ci_spkg]

The following attributes in the Software [cmdb_ci_spkg] table are populated by collected 
data when the Software Asset Management  (SAM) and SAM Foundation  applications are not 
installed:
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Attribute label Attribute name Google Console  attribute

Key key name-version

Name name name

Version version version

Relationship created for Software

Parent class Relationship type Child class

Software [cmdb_ci_spkg] Reference Software Instance 
[cmdb_software_instance]

Software Installation [cmdb_sam_sw_install]

The following attributes in the Software Installation [cmdb_sam_sw_install] table are populated 
by collected data when the SAM application, the SAM Foundation  application, or both are 
installed:

Attribute label Attribute name Google Console  attribute

Discovery source discovery_source None

Display name display_name Name

Installed on installed_on serialNumber

Version version Version

Relationship created for Software Installation

Parent class Relationship type Child class

Software Installation 
[cmdb_sam_sw_install]

Reference Computer 
[cmdb_ci_computer]

Software Instance [cmdb_software_instance]

The following attributes in the Software Instance [cmdb_software_instance] table are populated 
by collected data when the SAM and SAM Foundation  applications are not installed:

Attribute label Attribute name Google Console  attribute

Installed on installed_on serialNumber

Name name name, version, serialNumber

Relationship created for Software Instance

Parent class Relationship type Child class

Software Instance 
[cmdb_software_instance]

Reference Computer 
[cmdb_ci_computer]
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Service Graph Connector for Infoblox

Use the Service Graph Connector for Infoblox  to pull data from an Infoblox  instance into your 
ServiceNow  instance.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Supported versions

• Supported versions: Infoblox  API v2.11.2

• Supported ServiceNow  versions:

◦ Washington DC

◦ Xanadu

◦ Yokohama

◦ Zurich

Use cases

The following example use cases describe how you can use the Service Graph Connector for 
Infoblox  for different ServiceNow®  applications:

• Configure the Infoblox  connection for connecting to an Infoblox  instance.

• Create IP address management (IPAM) tasks when subnets are added or deleted.

• Schedule periodic synchronization of IPAM CIs by configuring scheduled data imports jobs.

• View imported IPAM CIs and IPAM tasks.

Configuring a connection for the connector

You can configure a connection for the connector by using the SGC Central  view in the CMDB 
Workspace. The view enables you to discover and install connectors, and then effectively 
manage the full life cycle of creating, editing, monitoring, and debugging connections. To 
configure the connector using SGC Central, see Configure Service Graph Connector for Infoblox 
using SGC Central.

Important: 
Unless there are configuration issues, use the SGC Central  view in the CMDB Workspace 
to configure the connection for the connector, as the guided setup method is being 
deprecated.

CMDB integrations dashboard

The Integration Commons for CMDB  store app provides a dashboard with a central view of the 
status, processing results, and processing errors of all installed integrations. You can see metrics 
for all integration runs. You can filter the view to a specific CMDB  integration, a specific time 
duration, or a specific integration run. For more details about monitoring Infoblox  integrations in 
the CMDB  Integrations Dashboard, see Using the CMDB Integrations Dashboard.
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Data mapping

Data from the Infoblox  data source is mapped and transformed into the ServiceNow  CMDB 
configuration item (CI) class definitions using the Robust Transform Engine (RTE). Data is 
inserted into the ServiceNow  CMDB  using the Identification and Reconciliation Engine (IRE).

When you complete setting up the connection, you can configure the integration to pull data 
periodically from Infoblox.

The following data sources are included for the Infoblox  app:

SG-Infoblox IP Pool

Imports all the network containers from the Infoblox  instance, loads the imported 
data in the SG-Infoblox IP Pool [sn_infoblox_integ_sg_infoblox_ip_pool] table, and 
then populates the IP Pool [cmdb_ci_ip_pool] target table. The SG-Infoblox Network 
data source runs after the SG-Infoblox IP Pool data source does.

SG-Infoblox Network

Runs after the SG-Infoblox IP Pool data source, imports the IPv4 
and IPv6 networks and subnets data from the Infoblox  instance, 
loads the imported data in the SG-Infoblox Detailed Subnetwork 
[sn_infoblox_integ_sg_infoblox_detailed_subnetwork] table, and then populates 
the IP Network Subnet [cmdb_ci_ip_network_subnet] and Managed Network 
[cmdb_ci_managed_network] target tables. The SG-Infoblox IP Address data source 
runs after the SG-Infoblox Network data source does.

The Detailed Subnetwork [sn_infoblox_integ_sg_infoblox_detailed_subnetwork] 
table determines which IP addresses are imported based on the value of 
the Get Ip Address  field. To import an IP address, set the Get Ip 
Address  field value to true. Alternatively, you can specify the list of IP 
addresses to be imported in pipe-delimited string format in the Value  field of the 
sn_infoblox_integ.included_network_regex  system property.

Note: 
IP addresses will not be imported during the first run of the 
Service Graph Connector for Infoblox  unless you update the 
sn_infoblox_integ.included_network_regex  system property 
because the Get Ip Address  field value is set to false  by default.

SG-Infoblox IP Address

Runs after the SG-Infoblox Network data source, imports the IPv4  and IPv6 
IP addresses from the Infoblox  instance, loads the imported data in the SG-
Infoblox IP Address [sn_infoblox_integ_sg_infoblox_ip_address] table, and 
then populates the Allocated IP Address [cmdb_ci_allocated_ip_address], 
IP Network Subnet [cmdb_ci_ip_network_subnet], and Managed Network 
[cmdb_ci_managed_network] target tables.

SG-Infoblox DNS Alias

Imports all the canonical name (CNAME) records from the Infoblox 
instance, loads the imported data in the SG-Infoblox DNS Alias 
[sn_infoblox_integ_sg_infoblox_dns_alias] table, and then populates the DNS Alias 
[cmdb_ci_dns_alias] target table.

For more information on where data is saved when pulling data from Infoblox, see CMDB classes 
targeted in Service Graph Connector for Infoblox.

You can use the IntegrationHub ETL app to view the data maps. See IntegrationHub ETL  for more 
information.
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Parallel data loading

Starting with the Service Graph Connector for Infoblox  1.3.0 version, parallel data loading can 
be enabled for the SG-Infoblox Network and SG-Infoblox IP Address data sources by setting 
the partition size in the sn_infoblox_integ.parallel_loading_partition_size 
system property. This system property determines the maximum number of networks that each 
partition processes. The maximum value that you can set for the partition size is 150.

• For the SG-Infoblox Network data source, the partition size is based on network views.

• For the SG-Infoblox IP Address data source, the partition size is based on the number of 
networks.

Related topics

Service Graph Connectors

Configure Service Graph Connector for Infoblox  using SGC Central

Use the playbook available with the SGC Central  application to set up the Service Graph 
Connector for Infoblox  for pulling in Infoblox  data into the CMDB.

Before you begin
Install Service Graph Connector for Infoblox  version 1.2.0 or later from the ServiceNow Store. For 
ServiceNow Store  installation steps, see Install a ServiceNow Store application . 

Role required: cmdb_inst_admin or admin

About this task
The playbook experience for onboarding connectors is activated with SGC Central  in the CMDB 
Workspace. To configure the SGC Central  application, see Configuring SGC Central  and for more 
information on how to interact with a playbook, see Interact with Playbook .

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the CMDB Workspace, select SGC Central.

3. On the Overview page, select Create connection.

Tip: 
Alternatively, you can select Create connection  on the All connections page.

4. On the Create connection window, select the Infoblox  connector type and then select 
Configure connection.
A default connection, SG_Infoblox_Connection, for Infoblox  is available within the application. 
As the Service Graph Connector for Infoblox  supports only a single instance, you can 
configure the default connection for the first time or resume editing it thereafter.

5. Complete the initial prerequisites when setting up a connection for the first time using a 
connector.

Note: 
This step is required only during the first-time setup. See Perform initial setup tasks when 
creating a connection in SGC Central.

6. Enter connection details and test the API connection for importing Infoblox  data.
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a. In the Setup  stage of the playbook, select the Configure and test connection  activity.

b. On the form, fill in the fields.

Configure and test connection form

Field Description

Connection name Name to identify the Infoblox  connection 
record.

Connection URL Infoblox  base URL in the following format: 
<base-URL>.

User name User name for authenticating the HTTP 
request.

Password Password for the username used for 
authenticating the HTTP request.

Use MID Server Option to use the MID Server for connecting 
to the Infoblox  instance.

Note: 
A MID Server is required only if a direct 
connection between the ServiceNow 
and Infoblox  instances isn’t possible.

Mid Selection MID Server for the connection.

This field appears only when you select the 
Use MID Server  check box.

c. Select Update and test connection.

d. Once the connection test is complete, select Continue.

7. Optional:  Specify network views and the API version for connecting to the Infoblox  instance 
by setting the configuration properties.

Note: 
To skip this step, select Continue  for the Set configuration properties  activity. If you skip 
this step, the default values of the Network view  and API version  properties are 
considered.

a. In the Setup  stage of the playbook, select the Set configuration properties  activity.

b. In the Network view  field, enter the network views for which data is to be imported.
For multiple views, separate them with commas. For example: view1,view2.

If you leave this field empty or set it to Default, the data sources within the connector 
import data from all the network views.

c. In the API version  field, enter the version of WAPI  you’re using.
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(Optional) For more information about the Infoblox  API, see the Infoblox Developer 
documentation .

d. Select Save properties.

e. Select Continue.

8. Optional:  Opt for task creation on network insertion or deletion.

Note: 
To skip this step, select Continue  for the Configure task preferences  activity.

a. In the Setup  stage of the playbook, select the Configure task preferences  activity.

b. Select the Create task on network insertion  check box to enable creating a task when a 
network is inserted.

c. Select the Create task on network deletion  to enable creating a task when a network is 
deleted.

d. In the Task user group list, select the user group assigned to tasks created on network 
insertion or deletion.

e. Select Save preferences.

f. Select Continue.

9. Configure the import schedule to import data at regular intervals.

a. In the Setup  stage of the playbook, select the Configure import schedule  activity.

b. Select Configure import schedule.

c. Expand the Parent scheduled data import within the Import schedules list to select the SG-
Infoblox IP Pool  import schedule.

d. In the Configure import schedule  dialog box, select the Active  check box, and then fill in the 
run schedule and time details.

For more information, see Schedule a data import .

e. Select Save.
Alternatively, select Execute Now  to execute the import schedule immediately.

f. Select Continue.

10. In the Setup  stage of the playbook, select the Confirm connection setup  activity to verify 
whether the connection was configured.

What to do next
Select View all connections  to review the connection details. The configured connection 
appears in the Installed connections list.
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Related topics

Service Graph Connector for Infoblox

CMDB classes targeted in Service Graph Connector for Infoblox

Accessing the connection details of Service Graph Connector for Infoblox

Configure Service Graph Connector for Infoblox  using the guided setup

Pull in data from Infoblox  into your CMDB.

Before you begin
Important: 
Unless there are configuration issues, use the SGC Central  view in the CMDB Workspace 
to configure the connection for the connector, as the guided setup method is being 
deprecated.

To use this Service Graph Connector, you need a subscription to a Subscription Unit that is 
based in the IT Operations Management  (ITOM) Visibility application or in the ITOM  Discovery 
application. As defined in the section titled "Managed IT Resource Types" in ServiceNow 
Subscription Unit Overview  for your subscription, for managed IT resources that are created 
or modified in the CMDB  by this Service Graph Connector, but that aren’t yet managed by ITOM 
Visibility or ITOM Discovery , these resources will increase Subscription Unit consumption from 
that application. Review your current Subscription Unit consumption within ITOM Visibility or 
ITOM Discovery to ensure available capacity.

Dependencies and requirements:

• The Integration Commons for CMDB  store app, which is automatically installed.

• The CMDB CI class models store app, which is automatically installed. See CMDB CI Class 
Models store app.

• The ITOM Discovery License plugin (com.snc.itom.discovery.license). You must activate this 
plugin.

• ITOM Licensing plugin (com.snc.itom.license). For more information, see Request Discovery .

• The Datastream Action plugin (com.glide.hub.action_type.datastream), which is automatically 
installed.

• Observability Commons for CMDB  (sn_observability), which is only required for event 
ingestion. This must be installed prior to installing the connector for Event Management to 
work. For more information, see Observability Commons for CMDB  on the ServiceNow Store.

Note: 
If you have an earlier version of the Service Graph Connector for Infoblox, then don’t 
migrate data from the old connector. You must uninstall the previous version and run the 
new integration.

Role required: admin

Procedure

1. Ensure that the application scope is set to the  Service Graph Connector for Infoblox 
application by using the application picker.
For more information, see Application picker .

2. Navigate to All  > Service Graph Connectors  > Infoblox  > Setup.

3. On the Getting started page, select Get Started.
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4. Configure the authentication credentials and HTTP connection details for sending requests to 
the Infoblox  API.

a. Configure your Infoblox  authentication credentials.

i. In the Configure the connection  section of the Service Graph Connector for Infoblox  page, 
select Get Started.

ii. For the Configure Infoblox authentication credentials  task, select Configure  to open the 
Basic Auth Credentials page opens in a new browser tab.

iii. In the Name  field, enter a name for the authentication.

For example, Infoblox Credential.

iv. In the User name  field, enter the user name that is used to authenticate the HTTP request 
when this authentication profile is enabled.

v. In the Password  field, enter the password for the user name that is used to authenticate 
the HTTP request.

vi. Select Update  to return to the guided setup page.

vii. Set the Configure Infoblox authentication credentials  task to complete by selecting Mark 
as Complete.

b. Configure the Infoblox  connection settings.

i. For the Configure Infoblox HTTP connection  task, select Configure  to open the HTTP(s) 
Connection page in a new browser tab.

ii. Review the fields and in the Name  field and enter the Infoblox  instance name.

iii. Use the URL builder to build the connection string or in the Connection URL  field, enter 
the Infoblox  base URL in the following format: https://<base-URL>.

iv. In the api_version  field of the Attributes section, enter the version of WAPI  you’re using.

v. In the network_view  field of the Attributes section, enter the network views for which data 
is to be imported.

For multiple views, separate the views with commas. For example: view1,view2. If you 
leave this field empty, the data sources import data from all the network views.

vi. Select Update  to return to the guided setup page.

vii. Set the Configure Infoblox HTTP connection  task to complete by selecting Mark as 
Complete.

For more information about the Infoblox  API, see the Infoblox Developer documentation .

c. Configure the connection properties.

i. For the Configure connection properties  task, select Configure  to open the Service Graph 
Connections  page in a new browser tab.

ii. To review and modify the property details, select a property from the Property  column in 
the Service Graph Connection Properties related list.

iii. Select Update  on the Service Graph Connection Properties page.

iv. Select Update  on the Service Graph Connections page to return to the guided setup page.

v. Set the Configure connection properties  task to complete by selecting Mark as Complete.
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d. Test the Infoblox  API connection to import data from the Infoblox  application.

i. In the Configure the connection  section of the Service Graph Connector for Infoblox  page, 
select Continue.

ii. For the Test the connection  task, select Configure  to open the Service Graph Connections 
page in a new browser tab.

iii. Select Test Connection.

iv. When the Status  field is set to Success, select Update  to close the Test the connection 
dialog box and return to the guided setup page.

If any of the tests have errors, follow the suggestions for remediation.

v. Set the Test the connection  task to complete by selecting Mark as Complete.

5. Optional:  Add multiple instances.

Note: 
If you don't need to add multiple instances, you can skip this step.

a. In the Add Multiple Instances  section of the Service Graph Connector for Infoblox  page, 
select Get Started.

b. For the Update Data Source Access  task, select Configure.

c. Select the Data Source [sys_data_source] table.

d. Select the Global  application scope by using the application picker.

e. In the Application Access related list, select the Can create, Can update, and Can delete 
check boxes, if not already selected.

f. Select Update  to close the tab and return to the guided setup.

g. Modify the application scope again to Service Graph Connector for Infoblox  by using the 
application picker.

h. Set the Update Data Source Access  task to complete by selecting Mark as Complete.

i. For the Update Scheduled Data Import Access  task, select Configure.

j. Select the Scheduled data import [scheduled_import_set] table.

k. Repeat steps 5.d  to 5.g.

l. Set the Update Scheduled Data Import Access  task to complete by selecting Mark as 
Complete.

m. Clear the cache for the new connection.
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i. For the Clear Cache for Data Source and Scheduled Data Imports tables  task, select 
Configure.

ii. Select the Global  application scope by using the application picker.

iii. In the Run script  text box of the background script page, enter the following script:

GlideTableManager.invalidateTable("sys_data_source");
GlideCacheManager.flushTable("sys_data_source");
 
GlideTableManager.invalidateTable("scheduled_import_set");
GlideCacheManager.flushTable("scheduled_import_set");
 
GlideTableManager.invalidateTable("sys_db_object");
GlideCacheManager.flushTable("sys_db_object");

iv. Select Run Script  to run the background script.

The script may take several minutes to execute.

v. After the script is executed, select Close.

vi. Modify the application scope again to Service Graph Connector for Infoblox  by using the 
application picker.

vii. Set the Clear Cache for Data Source and Scheduled Data Imports tables  task to complete 
by selecting Mark as complete.

n. Add a basic authentication connection to the new Infoblox  instance.

i. For the Add Another Basic Auth Connection  task, select Configure.

ii. To create a new connection, select Add Connection.

iii. In the Connection Information section of the Create Connection window, fill in the fields.

Connection Information

Field Description

Connection name Name to identify the Infoblox  connection 
record.

Connection URL Infoblox  base URL in the following format: 
<base-URL>.

Use MID Server Option to use a MID Server.

Note: 
Use of a MID Server is optional.

MID Selection Name of the MID Server used by the 
connector.

(Optional) This field appears only when the 
Use MID server  check box is selected.

MID Application Name of the MID application used by the 
connector.
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Field Description

(Optional) This field appears only when the 
Use MID server  check box is selected.

iv. In the Credential Information section of the Create Connection window, fill in the fields.

Credential Information

Field Description

Username Infoblox  account user name that is used to 
authenticate the connection request.

Password Password that is used to authenticate the 
connection request.

v. Select Create Connection.

vi. Navigate back to the guided setup, and set the Add Another Basic Auth Connection  task to 
complete by selecting Mark as Complete.

o. Test the newly added connections.

i. For the Test connections  task, select Configure.

ii. From the Name  column, select the new connection.

iii. Select the Test Connection  related link to start the testing process.

iv. When the Status  field is set to Success, return to the guided setup page.

Note: 
If any of the tests have errors, follow the suggestions for remediation.

v. Set the Test connections  task to complete by selecting Mark as Complete.

6. Configure the IP address management tasks and user groups.

a. Enable properties to create an IP address management task when deleting or inserting a 
network.

i. In the Configure IP address management tasks  section of the Service Graph Connector for 
Infoblox  page, select Get Started.

ii. For Enable creating a task, select Configure  to open the Enable create Task page in a new 
browser tab.

iii. Select the Create a task when a network is deleted  and Create a task when a network 
is inserted  check boxes to enable properties for creating IP address management tasks 
when deleting and inserting a network, respectively.

iv. Select Save.

v. Close the Enable create Task page tab and return to the guided setup page.

vi. Set Enable creating a task  to complete by selecting Mark as Complete.

b. Configure the user group for IP address management tasks.
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i. For the Configure the user group for IP address management tasks  task, select Configure 
to open the SG Infoblox Connection  page in a new browser tab.

ii. In the Connection alias  field, review and change the connection alias.

iii. In the Task user group  field, change the assignment group for the connection alias.

Note: 
By default, the user group for the IP address management tasks is assigned to the IP 
Address Management user group. To change the default assignment group, change 
the task user group for the connection alias.

iv. Select Update  to return to the guided setup page.

v. Set the Configure the user group for IP address management tasks  task to complete by 
selecting Mark as Complete.

7. Configure the scheduled jobs to import data from the Infoblox  application.

a. In the Set up scheduled import jobs  section of the Service Graph Connector for Infoblox 
page, select Get started.

b. For the Configure the scheduled jobs  task, select Configure  to open the Scheduled Data 
Imports  page in a new browser tab.

c. From the Name  column, select the scheduled job that you want to activate.

d. On the Scheduled Data Import form, verify the field values for the scheduled job.
For more information, see Schedule a data import .

e. Select Update.

f. Repeat the steps 7.c  to 7.e  for each scheduled job for data import.

g. Close the Scheduled Data Imports  page tab and return to the guided setup page.

h. Set the Configure the scheduled jobs  task to complete by selecting Mark as Complete  in 
the guided setup.

CMDB  classes targeted in Service Graph Connector for Infoblox

When you complete setting up the connection, you can configure the integration to pull data 
periodically from Infoblox. The data is saved in tables that extend from the Configuration item 
[cmdb_ci] table.

Allocated IP Address [cmdb_ci_allocated_ip_address]

The following attributes in the Allocated IP Address [cmdb_ci_allocated_ip_address] table are 
populated by collected data:

Attribute label Attribute name

IP Address ip_address

Managed Network managed_network
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Attribute label Attribute name

Is Broadcast is_broadcast

Is Conflict is_conflict

Is DHCP is_dhcp

Is DNS is_dns

Is Managed is_managed

Is Reserved is_reserved

Name name

Relationship created for Allocated IP Address

Parent class Relationship type Child class

Allocated IP Address 
[cmdb_ci_allocated_ip_address]

Reference Managed Network 
[cmdb_ci_managed_network]

DNS Alias [cmdb_ci_dns_alias]

The following attribute in the DNS Alias [cmdb_ci_dns_alias] table is populated by collected data:

Attribute label Attribute name

Name name

IP Network Subnet [cmdb_ci_ip_network_subnet]

The following attributes in the IP Network Subnet [cmdb_ci_ip_network_subnet] table are 
populated by collected data:

Attribute label Attribute name

Name name

Parent Pool parent_pool

CIDR cidr

Relationships created for IP Network Subnet

Parent class Relationship type Child class

IP Network Subnet 
[cmdb_ci_ip_network_subnet]

Members::Member of Allocated IP Address 
[cmdb_ci_allocated_ip_address]

IP Network Subnet 
[cmdb_ci_ip_network_subnet]

Reference SG-Infoblox Detailed 
Subnetwork 
[sn_infoblox_integ_sg_infoblox_detailed_subnetwork]

IP Pool [cmdb_ci_ip_pool]

The following attributes in the IP Pool [cmdb_ci_ip_pool] table are populated by collected data:
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Attribute label Attribute name

Name name

Parent Pool parent_pool

CIDR cidr

Managed Network [cmdb_ci_managed_network]

The following attribute in the Managed Network [cmdb_ci_managed_network] table is populated 
by collected data:

Attribute label Attribute name

Name name

SG-Infoblox Detailed Subnetwork 
[sn_infoblox_integ_sg_infoblox_detailed_subnetwork]

The following attributes in the SG-Infoblox Detailed Subnetwork 
[sn_infoblox_integ_sg_infoblox_detailed_subnetwork] table are populated by collected data:

Attribute label Attribute name

Connection ID connection_id

Get Ip Address list_ip_address

Network network

Network Type network_type

Network View network_view

Accessing the connection details of Service Graph Connector for Infoblox

You can access the connection details of the Service Graph Connector for Infoblox  in a single 
view using the common connection framework (CCF) included within the Integration Commons 
for CMDB  (sn_cmdb_int_util) store app.

With the CCF, you can access all the connections used by the Service Graph Connector for 
Infoblox. The connection details include the connection alias, connection properties, data 
sources, and scheduled data imports associated with a connection. You can also test the 
connection. For more information, see Accessing the connection details of Service Graph 
Connectors.

Access the details of an Infoblox  connection

Access the details of an Infoblox  connection configured for the Service Graph Connector for 
Infoblox.

Before you begin
Role required: admin
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Procedure

1. Navigate to All  > Service Graph Connectors  > Infoblox  > Connections.

2. From the Name  column of the Service Graph Connections list, select a connection.

3. On the Service Graph Connections page, view the connection details such as the connection 
name, alias, and data sources.

4. Select a related list to view further details of the connection.

5. Optional:  Select the Test Connection  related link to test the connection.

Service Graph Connector for Jamf

Use the Service Graph Connector for Jamf  to pull data from Jamf  into your ServiceNow  instance.

The Service Graph Connector for Jamf  pulls data from computers, disks, networks, and software 
applications into the ServiceNow®  Configuration Management Database (CMDB)  application.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Supported versions

• Supported versions:

◦ Jamf  API v2.1.0

◦ Jamf  Pro API 10.28.0

◦ Jamf  Pro 10.35.0

• Supported ServiceNow  versions:

◦ Washington DC

◦ Xanadu

◦ Yokohama

Use cases

The following are examples on how you can use the Service Graph Connector  for different 
ServiceNow®  applications:

• IT Operations Management (ITOM) Visibility

◦ Detailed hardware and software inventory tracking for macOS  hardware and apps. The 
tracking can be done with or without Software Asset Management  (SAM).

◦ Detailed hardware and software inventory tracking for hardware and apps for both iPhones 
and iPads. The tracking can be done with or without Software Asset Management  (SAM).

◦ Compliance tracking for mobile devices and end-user computers.

◦ Duplicate data detection on imports to improve performance of nightly imports.

• Software Asset Management (SAM)  and IT Asset Management (ITAM)

◦ Software package and installation tracking.

◦ License reclamation by detecting removed software.

◦ Software Usage tracking.
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• IT Service Management (ITSM)

◦ Incidents, problems, and changes on discovered configuration items (CI).

◦ Automatic ownership assignment based on top users.

Configuring a connection for the connector

You can configure a connection for the connector by using the SGC Central  view in the CMDB 
Workspace. The view enables you to discover and install connectors, and then effectively 
manage the full life cycle of creating, editing, monitoring, and debugging connections. To 
configure the connector using SGC Central, see Configure Service Graph Connector for Jamf 
using SGC Central.

Important: 
Unless there are configuration issues, use the SGC Central  view in the CMDB Workspace 
to configure the connection for the connector, as the guided setup method is being 
deprecated.

CMDB integrations dashboard

The Integration Commons for CMDB  store app provides a dashboard with a central view of the 
status, processing results, and processing errors of all installed integrations. You can see metrics 
for all integration runs. You can filter the view to a specific CMDB  integration, a specific time 
duration, or a specific integration run. For more details about monitoring Jamf  integrations in the 
CMDB  Integrations Dashboard, see Using the CMDB Integrations Dashboard.

Data mapping

Data from the Jamf  data source is mapped and transformed into the ServiceNow  CMDB 
Configuration Item (CI) class definitions using the Robust Transform Engine (RTE). Data is 
inserted into the ServiceNow  CMDB  using the Identification and Reconciliation Engine (IRE).

When you complete setting up the connection, you can configure the integration to periodically 
pull data from Jamf.

The delta data synchronization feature is available in Jamf  version 2.14 and 
higher. You can configure the is_delta_enabled_for_computers  and 
is_delta_enabled_for_mobiles  connection properties for synchronizing only delta 
data from a Jamf  instance. See Configuring data synchronization in Service Graph Connector for 
Jamf.

The following data sources are included for the Jamf  application:

SG-Jamf Computers

Imports data from computers and loads the imported data in the SG-Jamf 
Computers [sn_jamf_integrate_sg_jamf_computers] staging table.

SG-Jamf Lookup Mac Software Bundle Ids

Imports data from software applications installed on macOS  devices and 
loads the imported data in the SG-Jamf Lookup Mac Software Bundle Ids 
[sn_cmdb_int_util_mac_software_bundleid_lookup] staging table.

Note: 
To view the publisher information for applications installed on macOS  devices, 
run the SG-Jamf Lookup Mac Software Bundle Ids data source before running 
the SG-Jamf Computers or SG-Jamf Mobile Devices data sources.
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SG-Jamf Mobile Devices

Imports data from mobile devices and loads the imported data in the SG-Jamf 
Mobile Devices [sn_jamf_integrate_sg_jamf_mobile_devices] staging table.

SG-Jamf Remove Computers Software

Removes the imported computer software data that were later deleted from the 
source and updates the information in the SG-Jamf Remove Computers Software 
[sn_jamf_integrate_jamf_remove_software] staging table.

SG-Jamf Remove Mobile Software

Removes the imported mobile software data that were later deleted from the 
source and updates the information in the SG-Jamf Remove Mobile Software 
[sn_jamf_integrate_remove_mobile_software] staging table.

SG-Jamf Software Usage

Imports the software usage details from the Jamf  environment to track which 
software data is being used infrequently, hasn't been used recently enough, or 
isn't being used at all and loads the imported data in the SG-Jamf Software Usage 
[sn_jamf_integrate_jamf_software_usage] staging table. Based on the software 
usage information, you can add a reclamation rule to aggregate usage records and 
to identify unused software devices. See Software reclamation rules .

Note: 
The SG-Jamf Software Usage data source is available only when the Software 
Asset Management Professional plugin (com.snc.samp) is activated on your 
ServiceNow  instance. See Request Software Asset Management .

The imported data is then inserted into the following target tables:

• CI Relationship [cmdb_rel_ci]

• Computer [cmdb_ci_computer]

• Disk [cmdb_ci_disk]

• Handheld Computing device [cmdb_ci_handheld_computing]

• IP Address [cmdb_ci_ip_address]

• Network Adapter [cmdb_ci_network_adapter]

• Printer [cmdb_ci_printer]

• Serial Number [cmdb_serial_number]

• Software Installation [cmdb_sam_sw_install] (If the SAM application is installed.)

• Software Instance [cmdb_software_instance] (If the SAM application is not installed.)

• Software [cmdb_ci_spkg] (If the SAM application is not installed.)

• Software Usage [samp_sw_usage]

Note: 
For the Computer [cmdb_ci_computer] and Handheld Computing device 
[cmdb_ci_handheld_computing] data sources, if you created multiple Jamf  instances 
and want to know where the CIs originated from, you can identify the origins from 
the Key  and Value  columns. Additionally, you can view the Jamf Extension Attributes 
[sn_jamf_integrate_extension_attribute] and Most recent discovery [last_discovered] 
fields in both data sources. If you want to configure multiple instances, follow the steps in 
Configure Service Graph Connector for Jamf using the guided setup  in step 4.
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For more information on where data is saved when pulling data from a Jamf  application, see 
CMDB classes targeted in Service Graph Connector for Jamf.

You can use the IntegrationHub ETL app to view the data maps. See IntegrationHub ETL  for more 
information.

Related topics

Service Graph Connectors

Configure Service Graph Connector for Jamf  using SGC Central

Use the playbook available with the SGC Central  application to set up the Service Graph 
Connector for Jamf  for pulling in Jamf  data into the CMDB.

Before you begin
Install Service Graph Connector for Jamf  version 2.13.0 or later from the ServiceNow Store. For 
ServiceNow Store  installation steps, see Install a ServiceNow Store application . 

When using client credentials for authentication, obtain the OAuth credentials from your Jamf 
administrator. Make a note of the following details:

• Application (client) ID

• Client Secret

If using Client Credentials authentication in Jamf  Pro, you need to utilize the API Roles and 
Clients functionality. For more details, refer to the API Roles and Clients  section in the Jamf 
documentation. When creating a new API client in the Jamf  environment, the Access token 
lifetime  field on the form for creating a client enables setting how long the token remains valid. 
The default is 60  seconds, but due to ServiceNow AI Platform  limitations, the value must be set 
to more than 60  seconds. Setting the token lifetime to 3600  seconds (1 hour) helps prevent 
potential issues.

Role required: cmdb_inst_admin or admin

About this task
The playbook experience for onboarding connectors is activated with SGC Central  in the CMDB 
Workspace. To configure the SGC Central  application, see Configuring SGC Central  and for more 
information on how to interact with a playbook, see Interact with Playbook .

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the CMDB Workspace, select SGC Central.

3. On the Overview page, select Create connection.

Tip: 
Alternatively, you can select Create connection  on the All connections page.

4. On the Create connection window, select the Jamf  connector type and then select Create 
connection.

5. Complete the initial prerequisites when setting up a connection for the first time using a 
connector.

Note: 
This step is required only during the first-time setup. See Perform initial setup tasks when 
creating a connection in SGC Central.
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6. Determine the type of authentication for the Jamf  connection.

a. In the Setup  stage of the playbook, select the Select alias template  activity.
If needed, expand the Setup  stage to select an activity.

b. Select an alias template for the connection.

▪ SG-Jamf OAuth Connection: Select when using OAuth or client credentials for 
authentication.

▪ SG-Jamf Basic Connection: Select when using Basic authentication or Bearer token.

c. Select Continue.

7. Enter connection details and test the API connection for importing data.

a. In the Setup  stage of the playbook, select the Configure and test connection  activity.

b. On the form, fill in the fields.

▪ When the SG-Jamf OAuth Connection  template is selected, fill in the details as shown in 
the following table.

OAuth connection information

Field Description

Connection Name Name to identify the Jamf  connection 
record.

Connection URL Base URL to connect to the Jamf  API.

Note: 
This field is automatically set to the 
URL to connect to the application. 
Leave the field value as is.

OAuth Client ID Application (client) ID of your Jamf  client 
application as noted in the Before you 
begin  section.

Note: 
Verify that the Jamf  client has read 
privileges for the Computers  and 
Mobile Devices  categories in Jamf.

OAuth Client Secret Client Secret of your Jamf  client application 
as noted in the Before you begin  section.

Use MID Server Option to use a MID Server.

Note: 
Use of a MID Server is optional.

Mid Selection Name of the MID Server used by the 
connector.
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Field Description

This field appears only when the Use MID 
Server  check box is selected.

▪ When the SG-Jamf Basic Connection  template is selected, fill in the details as shown in 
the following table.

Basic connection information

Field Description

Connection Name Name to identify the Jamf  connection 
record.

Connection Host Target host value used by the connection.

Note: 
Update the Host  field with your 
Jamf  base URL or IP address. For 
example, demojamfhost.com  or 
127.0.0.1.

User Name User name that is used to authenticate the 
HTTP or HTTPS request when this Basic 
authentication profile is enabled.

Note: 
Verify that the Jamf  user has read 
privileges for the Computers  and 
Mobile Devices  categories in Jamf.

Password Password that is used to authenticate the 
HTTP or HTTPS request when this Basic 
authentication profile is enabled.

Use MID Server Option to use a MID Server.

Note: 
Use of a MID Server is optional.

Mid Selection Name of the MID Server used by the 
connector.

This field appears only when the Use MID 
Server  check box is selected.

c. Select Create and test connection.

d. Once the connection test is complete, select Continue.

8. Optional:  Set configuration properties for the connection to access Jamf  resources.
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Note: 
To skip this step, select Continue  for the Set configuration properties  activity. If you skip 
this step, the default values of the properties are considered.

a. In the Setup  stage of the playbook, select the Set configuration properties  activity.

b. Set the fields for configuration properties as described in the following table.

Configuration properties

Field Description

Import 
managed 
application 
records only

Option to limit the import to managed application records only.

Note: 
If the Import managed application records only  check box is 
cleared, the default behavior is to import all application records.

Use JAMF Pro 
API

Option to enable the use of the Jamf  Pro API for querying computer 
records.

Note: 
When the Use JAMF Pro API  check box is selected, the connector 
uses the Jamf  Pro API, which offers pagination of response data and 
improved performance over the Jamf  Classic API.

c. Select Continue.

9. Configure the import schedule to import data at regular intervals.

a. In the Setup  stage of the playbook, select the Configure import schedule  activity.

b. Select Configure import schedule.

c. Select the Active  check box, and then fill in the run schedule and time details.

For more information, see Schedule a data import .

d. Select Save.

e. Repeat steps from 9.b  to 9.d  for each job displayed on the page.

f. Select Continue.

10. In the Setup  stage of the playbook, select the Confirm connection creation  activity to verify 
whether the connection was created.

What to do next
Select View all connections  to review the connection details. The configured connection 
appears in the Installed connections list.
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Related topics

Service Graph Connector for Jamf

CMDB classes targeted in Service Graph Connector for Jamf

Accessing the connection details of Service Graph Connector for Jamf

Configure Service Graph Connector for Jamf  using the guided setup

Set up authentication credentials and scheduled jobs to import Jamf  data into your Configuration 
Management Database (CMDB).

Before you begin
Important: 
Unless there are configuration issues, use the SGC Central  view in the CMDB Workspace 
to configure the connection for the connector, as the guided setup method is being 
deprecated.

To use this Service Graph Connector, you need a subscription to a Subscription Unit that is 
based in the IT Operations Management  (ITOM) Visibility application or in the ITOM  Discovery 
application. As defined in the section titled "Managed IT Resource Types" in ServiceNow 
Subscription Unit Overview  for your subscription, for managed IT resources that are created 
or modified in the CMDB  by this Service Graph Connector, but that aren’t yet managed by ITOM 
Visibility or ITOM Discovery , these resources will increase Subscription Unit consumption from 
that application. Review your current Subscription Unit consumption within ITOM Visibility or 
ITOM Discovery to ensure available capacity.

Dependencies and requirements:

• The Integration Commons for CMDB  store app, which is automatically installed.

• The CMDB CI class models store app, which is automatically installed. See CMDB CI Class 
Models store app.

• ITOM Licensing plugin (com.snc.itom.license). An unlicensed plugin that contains computation 
logic for SU consumption as necessary. For more information, see Request Discovery .

• Jamf  Classic API version 10.x.

When using client credentials for authentication, obtain the OAuth credentials from your Jamf 
administrator. Make a note of the following details:

• Application (client) ID

• Client Secret

If using Client Credentials authentication in Jamf  Pro, you need to utilize the API Roles and 
Clients functionality. For more details, refer to the API Roles and Clients  section in the Jamf 
documentation. When creating a new API client in the Jamf  environment, the Access token 
lifetime  field on the form for creating a client enables setting how long the token remains valid. 
The default is 60  seconds, but due to ServiceNow AI Platform  limitations, the value must be set 
to more than 60  seconds. Setting the token lifetime to 3600  seconds (1 hour) helps prevent 
potential issues.

Roles required: admin

Procedure

1. Navigate to All  > Service Graph Connectors  > Jamf  > Setup.

2. On the Getting Started page, select Get started.

3. Set configuration properties.
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a. On the Service Graph Connector for Jamf page, in the Set configuration properties section, 
select Configure JSON data size limit.

b. For the Configure JSON data size limit  task, select Configure.

c. Select the Global  application scope from the application picker.

d. Set the com.glide.transform.json.max-partial-length  system property 
value.

▪ To create a system property, select New  and enter 
com.glide.transform.json.max-partial-length  as the name and 65536 
as the value of the property.

▪ If the com.glide.transform.json.max-partial-length  property already 
exists, verify that its value is set to 65536.

e. Set the Configure JSON data size limit  task to complete by selecting Mark as Complete.

4. Configure the authentication credentials and HTTP connection for sending requests to the 
Jamf  API.

a. Enter Basic or Bearer token authentication details.

Important: 
Skip this step if using Client credentials for authentication, and instead go to step 4.c.

i. For the Configure Jamf authentication: Basic or Bearer token authentication  task, select 
Configure.

ii. On the form, fill in the fields.

Basic Auth Credentials form

Field Description

Name Descriptive name of this authentication 
configuration.

User name User name that is used to authenticate the 
HTTP or HTTPS request when this Basic 
authentication profile is enabled.

Note: 
Verify that the Jamf  user has read 
privileges for the Computers  and 
Mobile Devices  categories in Jamf.

Password Password that is used to authenticate the 
HTTP or HTTPS request when this Basic 
authentication profile is enabled.

iii. Select Update.

iv. Set the Configure Jamf authentication: Basic or Bearer token authentication  task to 
complete by selecting Mark as Complete.
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b. Configure the Jamf  HTTP connection.

Important: 
Skip this step if using Client credentials for authentication, and instead go to step 4.c.

i. For the Configure Jamf HTTP connection  task, select Configure.

ii. On the form, fill in the fields.

HTTP(s) Connection form

Field Description

Name Name of the connection.

Credential Credential value used by this connection.

Connection alias Connection value that is used to refer to 
the connection.

Active Option to activate the HTTP connection.

Domain Domain that contains the connection.

URL builder Option to enable the system to build the 
connection URL.

Connection URL Connection URL for the connection. You 
can either manually enter a URL or use the 
URL builder to build the connection string.

Note: 
You can't modify the Connection URL 
field if you select the URL builder 
check box.

Mutual authentication Option to set the connection with mutual 
authentication. This field appears only 
when the URL builder  check box is 
selected.

Protocol Underlying protocol used by the 
connection. This field appears only when 
the URL builder  check box is selected.

Note: 
Update the Protocol  field if you are 
using anything other than https.

Use MID server Option to select a MID Server that sends 
this HTTP connection. Using a MID 
Server is not compatible with mutual 
authentication.

Connection timeout Number of milliseconds the system waits 
for a successful host connection. If a 
successful connection doesn't occur 
during this time, the connection request 
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Field Description

times out. Leave this field empty to use the 
system default connection timeout value.

Host Target host value used by the connection. 
This field appears only when the URL 
builder  check box is selected.

Note: 
Update the Host  field with your 
Jamf  base URL or IP address. For 
example, demojamfhost.com  or 
127.0.0.1.

Override default port Target value port that is used by the 
connection. This field appears only when 
the URL builder  check box is selected.

Base path Base path for HTTPS connection. This field 
appears only when the URL builder  check 
box is selected.

Note: 
To use the Jamf  Pro API, the Base 
path  field must be empty. Therefore, 
clear any value in the Base path  field.

iii. Select Update.

iv. Set the Configure Jamf HTTP connection  task to complete by selecting Mark as Complete.

c. Configure the client authentication credentials.

Important: 
Skip this step if using basic token for authentication, and instead go to step 4.a.

i. For the Configure Jamf authentication: Client credentials  task, select Configure.

ii. Select Edit  for the SG-Jamf OAuth Connection, the default connection.

iii. In the Connection Information section of the Edit Connection window, fill in the fields.

Connection Information

Field Description

Connection Name Name to identify the Jamf  connection 
record.

SG-Jamf OAuth Connection  is the 
default credential alias name and is read-
only.

Connection URL Base URL to connect to the Jamf  API.
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Field Description

Note: 
This field is automatically set to the 
URL to connect to the application. 
Leave the field value as is.

iv. (Optional) If a MID Server is required for the Jamf  server connection, select the Use MID 
Server  check box. Then, select the MID Server-related fields accordingly.

v. In the Credential Information section of the Edit Connection window, fill in the fields.

Credential Information

Field Description

OAuth Client ID Application (client) ID of your Jamf  client 
application as noted in the Before you 
begin  section.

Note: 
Verify that the Jamf  client has read 
privileges for the Computers  and 
Mobile Devices  categories in Jamf.

OAuth Client Secret Client Secret of your Jamf  client application 
as noted in the Before you begin  section.

d. Test the connection.

i. For the Test connection  task, select Configure.

ii. Review the properties in the Service Graph Connection Properties related list.

Note: 
The properties in the Service Graph Connection Properties related list of the 
connection record are modifiable. Be sure to complete the guided setup, review 
the property descriptions, and follow the instructions carefully before making any 
changes to them.

▪ For Basic authentication, set the auth_type  property value to basic 
(applicable only for Jamf  versions lower than 10.35. Note that Jamf  no longer 
supports Basic authentication, and it will be disabled for all instances starting with 
Jamf  version 11.5).

▪ For Bearer token authentication, set the auth_type  property value to bearer 
(available in Jamf  version 10.35 or higher).

▪ For Client credentials (OAuth 2.0) authentication, set the auth_type  property 
value to oauth  (available in Jamf  version 10.49 or higher).

▪ If no authentication type is selected, the connector defaults to Bearer token 
authentication.

iii. Test the connection by selecting the Test Load 20 Records  related link.

Testing the connection might take a few moments. The page is refreshed to show the test 
results.
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Note: 
The connection is successful if the HTTP Status  is 200. If there is anything displayed 
in the Error Code  and Error Message  fields, then the connection failed and further 
troubleshooting is required. Do not select Load All Records  during this setup.

iv. Set the Test the connection  task to complete by selecting Mark as Complete.

5. Optional:  Add multiple instances.

Note: 
If you don't need to add multiple instances, you can skip this step.

a. In the Add Multiple Instances  section of the Service Graph Connector for Jamf  page, select 
Get Started.

b. Enable creating data sources for the new Jamf  connection.

i. Ensure that you have edit permissions for the Datasource [sys_data_source] table.

ii. For the Update data source Access  task, select Configure.

iii. To edit the record, select the Global  application scope from the application picker.

iv. In the Application Access related list of the Data Source form that opens in a new tab, 
select the Can create, Can update, and Can delete  check boxes.

v. Select Update.

vi. Select the back icon (<) to return to the guided setup page.

vii. From the application picker, select the Service Graph Connector for Jamf  application 
scope.

viii. Set the Update data source Access  task to complete by selecting Mark as Complete

c. Enable creating a scheduled data import job for the new Jamf  connection.

i. Ensure that you have edit permissions for the Scheduled data import 
[scheduled_import_set] table.

ii. For the Update scheduled data import access  task, select Configure.

iii. To edit the record, select the Global  application scope from the application picker.

iv. In the Application Access related list of the Scheduled Data Import form that opens in a 
new tab, select the Can create, Can update, and Can delete  check boxes.

v. Select Update.

vi. Select the back icon (<) to return to the guided setup page.

vii. From the application picker, select the Service Graph Connector for Jamf  application 
scope.

viii. Set the Update scheduled data import access  task to complete by selecting Mark as 
Complete.

d. Select authentication type for new connection.

Note: 
From the application picker, select the Service Graph Connector for Jamf  application 
scope.
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i. For the Select authentication type for new connection  task, select Configure.

ii. Select sn_jamf_integrate.auth_type  from the Name  column.

iii. Set the sn_jamf_integrate.auth_type  property to one of the following values:

▪ basic: Basic authentication that uses a username and password.

▪ bearer: Bearer token authentication that uses a username and password to retrieve a 
bearer token.

▪ oauth: Client credentials authentication that uses a client ID and client secret to 
authenticate via OAuth 2.0.

iv. Navigate back to the guided setup.

v. Set the Select authentication type for new connection  task to complete by selecting Mark 
as Complete.

e. Add another connection.

Note: 
Verify that the Service Graph Connector for Jamf  application scope is selected in the 
application picker.

i. For the Add another connection  task, select Configure.

ii. In the Flow Designer, select Add Connection.

iii. On the form, based on the authentication type fill in the fields.

Note: 

▪ For Basic or Bearer token authentication-based connection, don't include 
https://  in the Connection Host  field. Example connection host value: 
test.jamfcloud.com.

▪ For Client credentials authentication-based connection, include https:// 
in the Connection URL  field. Example connection URL value: https://
test.jamfcloud.com.

iv. Depending on the authentication type, select the button to create the connection.

v. Navigate back to the guided setup.

vi. Set the Add another connection  task to complete by selecting Mark as Complete.

f. When using the Jamf  Pro API, the Jamf  Pro 10.35 or higher version, or both, specify the Jamf 
Pro version and API.

i. For the Select JAMF Pro version and API  task, select Configure.

ii. In the Use JAMF Pro API  column, for the connection you created, modify the value from 
false  to true  to use the Jamf  Pro API  instead of the Classic API.

iii. Update the Jamf Pro 10.35 or higher  column value to true  when using the Jamf  Pro 10.35 
or higher version.
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Note: 
With the Jamf Pro 10.35 or higher  column value set to true, the Bearer Token 
authentication is used to authenticate the Jamf  API. Else, the basic authentication is 
used.

iv. Set the Select JAMF Pro version and API  task to complete by selecting Mark as Complete.

g. Test the new connections.

i. For the Test new connections  task, select Configure.

ii. Select the name of the connection you want to test.

iii. To validate the data source configuration, select Test Load 20 Records.

Note: 
If any of the tests have an error code or message or error sign, the connection failed 
and further troubleshooting is required.

iv. Set the Test new connections  task to complete by selecting Mark as Complete.

6. Set up the scheduled import jobs.

a. For the Configure scheduled jobs  task in the Set up scheduled import jobs  section, select 
Configure.

b. Select the scheduled job that you want to activate.

Note: 
By default, the SG-Jamf Mobile Devices scheduled job is automatically set as Active 
and runs the SG-Jamf Computer scheduled job as a parent.

c. On the Scheduled Data Import form, verify the field values for the scheduled job and select 
the Active  check box to activate the scheduled job.

For more information, see Schedule a data import .

d. Select Update.

e. Repeat the steps 6.b  to 6.d  for each scheduled job for data import.

f. Set the Configure scheduled jobs  task to complete by selecting Mark as Complete  in the 
guided setup.

CMDB  classes targeted in Service Graph Connector for Jamf

When you complete setting up the connection, you can configure the integration to periodically 
pull data from Jamf. The data is saved in tables that extend from the Configuration item [cmdb_ci] 
table.

Computer [cmdb_ci_computer]

The following attributes in the Computer [cmdb_ci_computer] table are populated by collected 
data:
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Attribute label Attribute name

MAC Address mac_address

Name name

Serial number serial_number

CPU core count cpu_core_count

CPU count cpu_count

CPU name cpu_name

CPU speed (MHz) cpu_speed

CPU type cpu_type

DNS Domain dns_domain

Fully qualified domain name fqdn

Most recent discovery last_discovered

OS Service Pack os_service_pack

OS Version os_version

RAM (MB) ram

Model ID model_id

Assigned to assigned_to

Manufacturer manufacturer

Operating System os

Relationships created for Computer

Parent class Relationship type Child class

Computer 
[cmdb_ci_computer]

Owns::Owned by Network Adapter 
[cmdb_ci_network_adapter]

Computer 
[cmdb_ci_computer]

Owns::Owned by IP Address 
[cmdb_ci_ip_address]

Computer 
[cmdb_ci_computer]

Contains::Contained by Disk [cmdb_ci_disk]

Computer 
[cmdb_ci_computer]

Reference Key Value [cmdb_key_value]

Computer 
[cmdb_ci_computer]

Reference SG-Jamf Extension Attributes 
[sn_jamf_integrate_extension_attributes]

Disk [cmdb_ci_disk]

The following attributes in the Disk [cmdb_ci_disk] table are populated by collected data:

Attribute label Attribute name

Manufacturer manufacturer
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Attribute label Attribute name

Computer computer

Model ID model_id

Name name

Serial number serial_number

Most recent discovery last_discovered

Size bytes size_bytes

Relationship created for Disk

Parent class Relationship type Child class

Disk [cmdb_ci_disk] Reference Computer 
[cmdb_ci_computer]

Handheld Computing Device [cmdb_ci_handheld_computing]

The following attributes in the Handheld Computing Device [cmdb_ci_handheld_computing] 
table are populated by collected data:

Attribute label Attribute name

Description short_description

Carrier carrier

Name name

Serial number serial_number

Disk spae (GB) disk_space

ICCID iccid

IMEI imei

MEID meid

Operating System os

OS Version os_version

Phone Number phone_number

Root Access root_access

Manufacturer manufacturer

Assigned to assigned_to

Model ID model_id

Relationships created for Handheld Computing Device

Parent class Relationship type Child class

Handheld Computing Device 
[cmdb_ci_handheld_computing]

Owns::Owned by Network Adapter 
[cmdb_ci_network_adapter]
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Relationships created for Handheld Computing Device  (continued)

Parent class Relationship type Child class

Handheld Computing Device 
[cmdb_ci_handheld_computing]

Owns::Owned by IP Address 
[cmdb_ci_ip_address]

Handheld Computing Device 
[cmdb_ci_handheld_computing]

Reference Key Value [cmdb_key_value]

Handheld Computing Device 
[cmdb_ci_handheld_computing]

Reference SG-Jamf Extension Attributes 
[sn_jamf_integrate_extension_attributes]

IP Address [cmdb_ci_ip_address]

The following attributes in the IP Address [cmdb_ci_ip_address] table are populated by collected 
data:

Attribute label Attribute name

IP Address ip_address

IP version ip_version

Most recent discovery last_discovered

Name name

Nic nic

Relationship created for IP Address

Parent class Relationship type Child class

IP Address 
[cmdb_ci_ip_address]

Reference Network Adapter 
[cmdb_ci_network_adapter]

Key Value [cmdb_key_value]

The following attributes in the Key Value [cmdb_key_value] table are populated by collected data:

Attribute label Attribute name

Key key

Value value

Network Adapter [cmdb_ci_network_adapter]

The following attributes in the Network Adapter [cmdb_ci_network_adapter] table are populated 
by collected data:

Attribute label Attribute name

MAC Address mac_address

Name name
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Attribute label Attribute name

Discovery Source discovery_source

Most recent discovery last_discovered

Relationships created for Network Adapter

Parent class Relationship type Child class

Network Adapter 
[cmdb_ci_network_adapter]

Reference Computer 
[cmdb_ci_computer]

Network Adapter 
[cmdb_ci_network_adapter]

Reference Handheld Computing Device 
[cmdb_ci_handheld_computing]

Printer [cmdb_ci_printer]

The following attributes in the Printer [cmdb_ci_printer] table are populated by collected data:

Attribute label Attribute name

Name name

IP Address ip_address

Most recent discovery last_discovered

Serial Number [cmdb_serial_number]

The following attributes in the Serial Number [cmdb_serial_number] table are populated by 
collected data:

Attribute label Attribute name

Serial Number serial_number

Serial Number Type serial_number_type

Valid valid

Relationships created for Serial Number

Parent class Relationship type Child class

Serial Number 
[cmdb_serial_number]

Reference Computer 
[cmdb_ci_computer]

Serial Number 
[cmdb_serial_number]

Reference Handheld Computing Device 
[cmdb_ci_handheld_computing]

SG-Jamf Extension Attributes [sn_jamf_integrate_extension_attributes]

The following attributes in the SG-Jamf Extension Attributes 
[sn_jamf_integrate_extension_attributes] table are populated by collected data:
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Attribute label Attribute name

Id id

Extension Attributes extension_attributes

Software [cmdb_ci_spkg]

The following attributes in the Software [cmdb_ci_spkg] table are populated by collected data 
Software Asset Management  (SAM) application isn't installed:

Attribute label Attribute name

Version version

Manufacturer manufacturer

Key key

Name name

Relationship created for Software

Parent class Relationship type Child class

Software [cmdb_ci_spkg] Reference Software Instance 
[cmdb_software_instance]

Software Installation [cmdb_sam_sw_install]

The following attributes in the Software Installation [cmdb_sam_sw_install] table are populated 
by collected data when the SAM application is installed:

Attribute label Attribute name

Discovery source discovery_source

Display name display_name

Installed on installed_on

Last scanned last_scanned

Publisher publisher

Version version

Relationship created for Software Installation

Parent class Relationship type Child class

Software Installation 
[cmdb_sam_sw_install]

Reference Server [cmdb_ci_server]

Software Instance [cmdb_software_instance]

The following attributes in the Software Instance [cmdb_software_instance] table are populated 
by collected data when the SAM application isn't installed:
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Attribute label Attribute name

Name name

Installed on installed_on

Relationships created for Software Instance

Parent class Relationship type Child class

Software Instance 
[cmdb_software_instance]

Reference Handheld Computing Device 
[cmdb_ci_handheld_computing]

Software Instance 
[cmdb_software_instance]

Reference Computer 
[cmdb_ci_computer]

Accessing the connection details of Service Graph Connector for Jamf

You can access the connection details of the Service Graph Connector for Jamf  in a single view 
using the common connection framework (CCF) included within the Integration Commons for 
CMDB  (sn_cmdb_int_util) store app.

With the CCF, you can access all the connections used by the Service Graph Connector for Jamf. 
The connection details include the connection alias, connection properties, data sources, and 
scheduled data imports associated with a connection. You can also test the connection. For 
more information, see Accessing the connection details of Service Graph Connectors.

Access the details of a Jamf  connection

Access the details of a Jamf  connection configured for the Service Graph Connector for Jamf.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Service Graph Connectors  > Jamf  > Connections.

2. From the Name  column of the Service Graph Connections list, select a connection.

3. On the Service Graph Connections page, view the connection details such as the connection 
name, alias, and data sources.

4. Select a related list to view further details of the connection.

5. Optional:  Select the Test Connection  related link to test the connection.

Configuring data synchronization in Service Graph Connector for Jamf

You can configure the connection properties for synchronizing only delta data from a Jamf 
instance.

The delta data synchronization feature is available in Jamf  version 2.14 and higher. The 
connector provides the ability to import only delta data from a Jamf  instance. With delta 
synchronization enabled, the importing process of Jamf  data is quicker because the connector 
imports only the changes in Jamf  data. The Last success import time  field of a data source 
displays the timestamp of the most recent successful pull run. The delta pull period is calculated 
by subtracting the last successful run date and time from the current date and time that is Delta 
period = Current date timestamp - Last success import date timestamp.
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The application includes the is_delta_enabled_for_computers  and 
is_delta_enabled_for_mobiles  connection properties to enable delta 
synchronization for computers and mobile devices, respectively. By default, the 
is_delta_enabled_for_computers  and is_delta_enabled_for_mobiles 
properties are set to false. To enable delta data synchronization, set these properties to true.

Note: 

• The is_delta_enabled_for_computers  connection property is available only if 
the use_jamf_pro_api  property is set to true.

• The is_delta_enabled_for_mobiles  connection property is available only if the 
use_jamf_mobile_pro_api  property is set to true.

See Service Graph Connector for Jamf properties.

When you want to import full data from your Jamf  instance, you must disable the 
is_delta_enabled_for_computers  and is_delta_enabled_for_mobiles 
properties by setting these properties to false. See Disable delta synchronization.

Note: 
When the full import of data is completed, set the 
is_delta_enabled_for_computers  and is_delta_enabled_for_mobiles 
properties back to true  to pull delta data later. If you leave the properties set to false, 
full data is imported with every pull, which takes considerable time.

Disable delta synchronization

Disable delta synchronization to import all the Jamf  data.

Before you begin
Role required: admin

About this task
The delta data synchronization feature is available in Jamf  version 2.14 and higher.

Procedure

1. Navigate to All  > Service Graph Connectors  > Jamf  > Connections.

2. From the list of connections, open the connection for which you want to disable delta 
synchronization.

The connection properties are displayed in the Service Graph Connection Properties related 
list.

◦ To disable delta synchronization for computers, open the 
is_delta_enabled_for_computers  property.

◦ To disable delta synchronization for mobile devices, open the 
is_delta_enabled_for_mobiles  property.

3. In the Value  field, enter false.

4. Select Update.

Service Graph Connector for Jamf  properties

Service Graph Connector for Jamf  properties control the behavior of the connector.
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Connection properties

These connection properties are available for the Service Graph Connector for Jamf.

Note: 
To open the Service Graph Connection Properties 
[sn_cmdb_int_util_service_graph_connection_property] table for the connector, navigate 
to All  > Service Graph Connectors  > Jamf  > Connections, and select the connection 
name. The connection properties are displayed in the Service Graph Connection Properties 
related list.

Connection properties for Service Graph Connector for Jamf

Property Description

auth_type
Set the property to basic  to use Basic authentication for 
the connection. This authentication type uses a username 
and password.

Set the property to oauth  to use Client credentials (OAuth 
2.0) authentication for the connection. This authentication 
type uses a client ID and client secret.

The default Bearer token authentication type uses a 
username and password to retrieve a token for subsequent 
connection requests.

• Type: basic | bearer | oauth

• Default value: bearer

Note: 

• For an OOB default connection, any of the three 
authentication types can be used.

• For additional connections (multi-instance), only 
the Basic and Bearer authentication types can be 
used. To use the Client credentials (OAuth 2.0) 
authentication type, follow the guided setup to 
configure client authentication credentials for the 
connection. See Configure Service Graph Connector 
for Jamf using the guided setup.

import_managed_apps_only
Set the property to true  to import only managed 
application records.

When the property is set to false, all application records 
are imported.

• Type: true | false

• Default value: false

is_delta_enabled_for_computers
Set the property to true  to enable the SG-Jamf Computers 
data source to pull only the changes (delta) between 
consecutive imports.
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Connection properties for Service Graph Connector for Jamf  (continued)

Property Description

When the property is set to false, a full import is 
performed with every pull.

Note: 
This property is available only if the 
use_jamf_pro_api  property is set to true.

• Type: true | false

• Default value: false

See Configuring data synchronization in Service Graph 
Connector for Jamf.

is_delta_enabled_for_mobiles
Set the property to true  to enable the SG-Jamf Mobile 
Devices data source to pull only the changes (delta) 
between consecutive imports.

When the property is set to false, a full import is 
performed with every pull.

Note: 
This property is available only if the 
use_jamf_mobile_pro_api  property is set to 
true.

• Type: true | false

• Default value: false

See Configuring data synchronization in Service Graph 
Connector for Jamf.

use_jamf_mobile_pro_api
Set the property to true  to use the Jamf  Pro API for 
querying Jamf  mobile device records. Set the property to 
false  to use the Jamf  Classic API.

Note: 
The Jamf  Pro API is supported by Jamf  version 11.4 
and higher. The Jamf  Pro API supports pagination of 
response data and provides performance improvement 
compared to the Jamf  Classic API.

• Type: true | false

• Default value: null

use_jamf_pro_api
Set the property to false  to use the Jamf  Classic API 
instead of the Jamf  Pro API for querying Jamf  mobile device 
records.

When the property is set to true, the Jamf  Pro API is used 
for querying Jamf  mobile device records.
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Connection properties for Service Graph Connector for Jamf  (continued)

Property Description

Note: 
The Jamf  Pro API is supported by Jamf  version 11.4 
and higher. The Jamf  Pro API supports pagination of 
response data and provides performance improvement 
compared to the Jamf  Classic API.

• Type: true | false

• Default value: true

Service Graph Connector for Microsoft Azure

Use the Service Graph Connector for Microsoft Azure  to pull data from Microsoft Azure  into your 
CMDB.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Supported versions
Supported ServiceNow  versions:

• Washington DC

• Xanadu

• Yokohama

• Zurich

Use cases

The following are examples on how you can use the Service Graph Connector:

• Visibility into cloud resources, relationships, and state in near real-time.

• Service ITAM/SAM outcomes through deep discovery of applications.

Configuring a connection for the connector

You can configure a connection for the connector by using the SGC Central  view in the CMDB 
Workspace. The view enables you to discover and install connectors, and then effectively 
manage the full life cycle of creating, editing, monitoring, and debugging connections. To 
configure the connector using SGC Central, see Configure Service Graph Connector for 
Microsoft Azure using SGC Central.

Important: 
Unless there are configuration issues, use the SGC Central  view in the CMDB Workspace 
to configure the connection for the connector, as the guided setup method is being 
deprecated.
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CMDB integrations dashboard

The Integration Commons for CMDB  store app provides a dashboard with a central view of 
the status, processing results, and processing errors of all installed integrations. You can see 
metrics for all integration runs. You can filter the view to a specific CMDB  integration, a specific 
time duration, or a specific integration run. For more details about monitoring Microsoft Azure 
integrations in the CMDB  Integrations Dashboard, see Using the CMDB Integrations Dashboard.

Data mapping

Data from the Azure  data sources is mapped and transformed into the ServiceNow  CMDB 
Configuration Item (CI) class definitions using the Robust Transform Engine (RTE). Data is 
inserted into the ServiceNow®  CMDB  using the Identification and Reconciliation Engine (IRE).

When you complete setting up the connection, you can configure the integration to periodically 
pull data from Azure. The data is loaded into staging tables and then inserted into the target 
tables.

The following table lists the data sources, the staging tables, and the target tables as CMDB  CI 
and non-CMDB  classes for Azure.

Data mapping for Azure

Data source Staging table Target tables

SG-Azure 
Subscriptions

SG Azure Subscriptions [sn_sg_azure_integ_subscriptions]
Cloud 
Service 
Account

Key Value

SG-Azure 
Datacenter 
Updation

SG-Azure Datacenter Updation 
[sn_sg_azure_integ_datacenter_updation] Azure 

Datacenter

SG-Azure 
Resource 
Group

SG-Azure Resource Group 
[sn_sg_azure_integ_resource_groups] Resource 

Group

Key Value

SG-Azure 
Availability 
Zone

SG-Azure Availability Sets [sn_sg_azure_integ_availability_sets]
Availability 
Zone

Key Value

SG-Azure 
Storage 
Volume

SG-Azure Storage Volume [sn_sg_azure_integ_storage_volume]
Storage 
Volume

Key Value

SG-Azure 
Load 
Balancers

SG-Azure Load Balancers [sn_sg_azure_integ_load_balancers]
Cloud Load 
Balancer

Cloud LB 
IPAddress

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1090



Data mapping for Azure  (continued)

Data source Staging table Target tables

Key Value

SG-Azure 
Network

SG-Azure Network [sn_sg_azure_integ_network]
Cloud 
Network

Cloud 
Service 
Account

Cloud 
Subnet

Key Value

SG-Azure 
Public IP 
Address

SG-Azure Public IP Address 
[sn_sg_azure_integ_public_ip_address] Cloud Public 

IP Address

Cloud Mgmt 
Network 
Interface

Cloud Load 
Balancer

Cloud LB 
IPAddress

Key Value

SG-Azure 
Security 
Group

SG-Azure Security Group [sn_sg_azure_integ_security_group]
Compute 
Security 
Group

Key Value

SG-Azure 
Storage 
Accounts

SG-Azure Storage Accounts 
[sn_sg_azure_integ_storage_accounts] Cloud 

Storage 
Account

Key Value

SG-Azure 
Virtual 
Machines

SG-Azure Virtual Machine [sn_sg_azure_integ_virtual_machine]
Virtual 
Machine 
Instance

Image

Linux Server

Server
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Data mapping for Azure  (continued)

Data source Staging table Target tables

Windows 
Server

Key Value

SG-Azure 
Network 
Interface

SG-Azure Network Interface 
[sn_sg_azure_integ_network_interface] Cloud Mgmt 

Network 
Interface

IP Address

Hardware

Virtual 
Machine 
Instance

Key Value

SG-Azure 
SQL

SG-Azure SQL [sn_sg_azure_integ_sql]
Cloud 
DataBase

Key Value

SG-Azure 
Functions

SG-Azure Functions [sn_sg_azure_integ_functions]
Cloud 
Function

SG-Azure 
Generic 
Resources

SG-Azure Generic Resources 
[sn_sg_azure_integ_generic_resources]

Note: 
The SG-Azure Generic Resources data source imports 
data for generic resources that aren't tracked by other data 
sources.

Cloud 
Resource

Key Value

SG-Azure 
Scale Sets

SG-Azure Scale Sets [sn_sg_azure_integ_scale_sets]
Instance 
Scale Set

SG-Azure 
Scale Sets 
VMs

SG-Azure Scale Sets VMs [sn_sg_azure_integ_scale_sets_vms]
Virtual 
Machine 
Instance

Storage 
Volume

Image

Cloud Mgmt 
Network 
Interface
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Data mapping for Azure  (continued)

Data source Staging table Target tables

Hardware 
Type

Azure 
Datacenter

Linux Server

Server

Windows 
Server

Key Value

SG-Azure 
Software

SG-Azure Software [sn_sg_azure_integ_software]

Note: 
The SG-Azure Software data source imports the software 
data from the ConfigurationData  table in the Log Analytics 
workspace of Azure.

The SG-Azure Software import is set to inactive by default.

When the 
Software 
Asset 
Management 
(SAM) 
application 
isn't 
installed:

Software

Software 
Instance

When 
the SAM 
application is 
installed:

Software 
Installation

SG-Azure 
Software 
Remove

SG-Azure Software Remove 
[sn_sg_azure_integ_software_remove]

The SG-Azure Software Remove import is set to inactive by 
default.

When 
the SAM 
application 
isn't 
installed:

Software

Software 
Instance

When 
the SAM 
application is 
installed:
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Data mapping for Azure  (continued)

Data source Staging table Target tables

Software 
Installation

SG-Azure 
TCP

SG-Azure TCP [sn_sg_azure_integ_tcp]

Note: 
The SG-Azure TCP data source imports the TCP and 
processes data from the VMConnection  and VMProcess 
tables in the Log Analytics  workspace of Azure. To populate 
the tables, you must first enable the VM insights  feature in 
the Azure  portal. For more information, see Enabling VM 
insights for collecting Azure data.

TCP 
Connection

Running 
Process

SG-Azure 
Hardware 
Template 
Updation​

Hardware templates [sn_sg_azure_integ_hardware_templates]
Hardware 
Type

SG-Azure HW 
Consolidation

SG-Azure HW Consolidation 
[sn_sg_azure_integ_hw_consolidation] Virtual 

Machine 
Instance

Computer

SG-Azure 
Run 
Command

SG-Azure Run Command [sn_sg_azure_integ_run_command]
No data 
created

SG-Azure 
Get Run 
Command

SG-Azure Get Run Command 
[sn_sg_azure_integ_get_run_command] Application

TCP 
Connection

Running 
Process

SG-Azure 
Kubernetes 
Cluster

SG-Azure Kubernetes Cluster 
[sn_sg_azure_integ_kubernetes_cluster] Kubernetes 

Cluster
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Note: 

• The connector utilizes the Service Graph Resource Inclusion Whitelist 
[sn_cmdb_int_util_service_graph_resource_inclusion_whitelist] table to differentiate 
between generic and other supported resource types.

The connector first populates all supported resources in the Service Graph Resource 
Inclusion Whitelist [sn_cmdb_int_util_service_graph_resource_inclusion_whitelist] 
table. These resources, categorized under their respective supported resource types, 
have specific data sources designated for ingestion within the connector. When the 
SG-Azure Generic Resources data source is executed and retrieves unsupported 
resource types, they are added to the Service Graph Resource Inclusion Whitelist 
[sn_cmdb_int_util_service_graph_resource_inclusion_whitelist] table and categorized as 
generic.

• Starting with the Service Graph Connector for Microsoft Azure  1.12.0 version, the SG-
Azure Hardware Template Updation and SG-Azure HW Consolidation import schedules 
replace the SG-Azure Hardware Template import schedule. The SG-Azure Hardware 
Template Updation and SG-Azure HW Consolidation data sources fetch only the data of 
the hardware templates that are used for VMs in Azure, instead of fetching all hardware 
templates.

For more information on where data is saved when pulling data from Azure, see CMDB classes 
targeted in Service Graph Connector for Microsoft Azure  and Supported Microsoft Azure 
resource types.

You can use the IntegrationHub ETL app to view the data maps. See IntegrationHub ETL  for more 
information.

Additional resource

How do I configure the Azure Service Graph Connector?

Related topics

Service Graph Connectors

Configure Service Graph Connector for Microsoft Azure using the guided setup

CMDB classes targeted in Service Graph Connector for Microsoft Azure

Configuring data synchronization in Service Graph Connector for Microsoft Azure

Enabling VM insights for collecting Azure data

Setting up multiple connections in Service Graph Connector for Microsoft Azure

Configure Service Graph Connector for Microsoft Azure  using SGC Central

Use the playbook available with the SGC Central  application to set up the Service Graph 
Connector for Microsoft Azure  for pulling in Microsoft Azure  data into the CMDB.

Before you begin
Install Service Graph Connector for Microsoft Azure  version 1.9.0 or later from the ServiceNow 
Store. For ServiceNow Store  installation steps, see Install a ServiceNow Store application . 

Important: 
After the initial import of Azure  data, the application performs a delta import of data. 
However, you can perform a full pull of data anytime later by disabling the delta 
synchronization and setting the sn_sg_azure_integ.is_delta_sync_enabled 
property to false. For more information, see Configuring data synchronization in Service 
Graph Connector for Microsoft Azure.
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Role required: cmdb_inst_admin or admin

About this task
The playbook experience for onboarding connectors is activated with SGC Central  in the CMDB 
Workspace. To configure the SGC Central  application, see Configuring SGC Central  and for more 
information on how to interact with a playbook, see Interact with Playbook .

The connector uses the Azure Management APIs  for the complete pull of data from Azure. 
However, to pull delta changes from Azure, the Azure Resource Graph APIs  are used. The domain 
name system (DNS) is Microsoft Azure Management, but the path is a resource graph.

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the CMDB Workspace, select SGC Central.

3. On the Overview page, select Create connection.

Tip: 
Alternatively, you can select Create connection  on the All connections page.

4. On the Create connection window, select the Microsoft Azure  connector type and then select 
Create connection.

5. Complete the initial prerequisites when setting up a connection for the first time using a 
connector.

Note: 
This step is required only during the first-time setup. See Perform initial setup tasks when 
creating a connection in SGC Central.

6. Complete the prerequisites for setting up the Azure  environment.

a. Complete the instructions required for setting up the Azure  environment.

i. In the Prerequisites  stage of the playbook, select the Review setup instructions  activity.

ii. Obtain the OAuth credentials including client ID, client secret, and token URL from your 
Microsoft Azure  administrator.

iii. For importing hardware data, grant the User.Read  permission on the Microsoft 
Graph  API in the Azure  environment. Also, ensure that the IAM policy for the Azure 
subscription has the Reader role. See Assign a user as an administrator of an Azure 
subscription with conditions  on the Microsoft Azure  documentation site.

iv. For importing software data, grant the Data.Read  permission on the Log Analytics 
API in the Azure  environment. In addition, set up a Log Analytics workspace in the Azure 
environment.

v. After completing the Review setup instructions  activity, select Continue.

7. Determine whether to import only hardware data or both hardware and software data.

a. In the Setup  stage of the playbook, select the Select services  activity.
If needed, expand the Setup  stage to select an activity.

b. Optional:  To import both hardware and software data, select the Hardware and software 
check box.
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Note: 
Importing software data requires a hardware connection.

(Optional) If you need to import only hardware data, the Hardware only  check box is 
already selected by default.

c. Select Continue.

8. Enter the connection details and test the API connection for importing hardware data.

a. In the Setup  stage of the playbook, select the Create and test hardware connection  activity.

b. On the form, fill in the fields.

Create and test hardware connection form

Field Description

Connection name Name to identify the hardware connection 
record.

For example, SG-Azure hardware 
connection.

Connection URL Base URL to connect to your Azure  client 
application.

Note: 
This field is automatically set to the 
URL to connect to the application. 
Leave the field value as is.

OAuth client ID Application (client) ID of your Azure  client 
application as noted in step 6.a.

OAuth client secret Client secret of your Azure  client application 
as noted in step 6.a.

OAuth token URL Callback URL for the Azure  client 
application.

Based on the region of your Azure  client 
application, enter the token URL in one of 
the following formats:

▪ Global

https://login.microsoftonli
ne.com/<tenantid>/oauth2/v2
.0/token

▪ US Government

https://login.microsoftonli
ne.us/<tenantid>/oauth2/v2
.0/token

▪ China

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1097



Field Description

https://login.partner.micro
softonline.cn/<tenantid>/oa
uth2/v2.0/token

▪ Germany

https://login.microsoftonli
ne.de/<tenantid>/oauth2/v2
.0/token

Where <tenantid>  is the tenant ID of 
your Azure  client application as noted in 
step 6.a.

c. Select Create and test connection.

d. Once the connection test is complete, select Continue.

9. Configure the import schedule to import hardware data at regular intervals.

a. In the Setup  stage of the playbook, select the Configure hardware import schedule  activity.

b. Select Configure import schedule.

c. Expand the Parent scheduled data import within the Import schedules list to select the 
Connection name-SG-Azure Subscriptions  import schedule.

d. In the Configure import schedule  dialog box, select the Active  check box, and then fill in the 
run schedule and time details.

For more information, see Schedule a data import .

e. Select Save.
Alternatively, select Execute Now  to execute the import schedule immediately.

f. Select Continue.

10. Enter the connection details and test the API connection for importing software data.

The Create and test software connection  activity for importing software data appears only 
when the Hardware and software  check box is selected in step 7.b.

a. In the Setup  stage of the playbook, select the Create and test software connection  activity.

b. On the form, fill in the fields.

Create and test software connection form

Field Description

Software connection name Name to identify the software connection 
record.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1098

https://www.webstg.servicenow.com/docs/access?context=t_ScheduleADataImport&version=washingtondc&pubname=washingtondc-integrate-applications&ft:locale=en-US#table_r53_5hm_xp
https://www.webstg.servicenow.com/docs/access?context=t_ScheduleADataImport&version=washingtondc&pubname=washingtondc-integrate-applications&ft:locale=en-US#table_r53_5hm_xp
https://www.webstg.servicenow.com/docs/access?context=t_ScheduleADataImport&version=washingtondc&pubname=washingtondc-integrate-applications&ft:locale=en-US#table_r53_5hm_xp


Field Description

For example, SG-Azure software 
connection.

Hardware connection name Name of the hardware connection record.

Note: 
This field is automatically set to the 
hardware connection name specified 
in step 8.b.

Connection URL Base URL to connect to the Log Analytics 
workspace in the following format:

https://api.loganalytics.io/v
1/workspaces/<workspace_id>

Where <workspace_id>  is the ID of the 
Log Analytics workspace as noted in step 
6.a.

Note: 
This field is automatically set to 
the URL to connect to the Log 
Analytics workspace. Replace the 
<workspace_id>  variable in 
the auto-generated URL with the 
workspace ID of your Log Analytics 
workspace.

OAuth client ID Application (client) ID of your Azure  client 
application as noted in step 6.a.

OAuth client secret Client secret of your Azure  client application 
as noted in step 6.a.

OAuth token URL Token URL of your Azure  client application.

Based on the region of your Azure  client 
application, enter the token URL in one of 
the following formats:

▪ Global

https://login.microsoftonli
ne.com/<tenantid>/oauth2/v2
.0/token

▪ US Government

https://login.microsoftonli
ne.us/<tenantid>/oauth2/v2
.0/token

▪ China
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Field Description

https://login.partner.micro
softonline.cn/<tenantid>/oa
uth2/v2.0/token

▪ Germany

https://login.microsoftonli
ne.de/<tenantid>/oauth2/v2
.0/token

Where <tenantid>  is the tenant ID of 
your Azure  client application as noted in 
step 6.a.

c. Select Create and test connection.

d. Once the connection test is complete, select Continue.

11. Configure the import schedule to import software data at regular intervals.

The Configure software import schedule  activity for importing software data appears only 
when the Hardware and software  check box is selected in step 7.b.

a. In the Setup  stage of the playbook, select the Configure software import schedule  activity.

b. Expand the Parent scheduled data import within the Import schedules list to select the 
Connection name-SG-Azure TCP  import schedule.

c. In the Configure import schedule  dialog box, select the Active  check box, and then fill in the 
run schedule and time details.

For more information, see Schedule a data import .

d. Select Save.
Alternatively, select Execute Now  to execute the import schedule immediately.

e. Repeat steps 11.b  to 11.d  for any other parent import schedule if not already set to active.

f. Select Continue.

12. In the Setup  stage of the playbook, select the Connection setup complete  activity to verify 
whether the connection was created.

What to do next
Select View all connections  to review the connection details. The created connection appears in 
the Installed connections list.

Related topics

Service Graph Connector for Microsoft Azure

CMDB classes targeted in Service Graph Connector for Microsoft Azure

Supported Microsoft Azure resource types
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Service Graph Connector for Microsoft Azure properties

Accessing the connection details of Service Graph Connector for Microsoft Azure

Additional features within the Service Graph Connector for Microsoft Azure

Configure Service Graph Connector for Microsoft Azure  using the guided setup

Set up data sources and scheduled import jobs to pull in data from Azure  into your CMDB.

Before you begin
Important: 
Unless there are configuration issues, use the SGC Central  view in the CMDB Workspace 
to configure the connection for the connector, as the guided setup method is being 
deprecated.

To use this Service Graph Connector, you need a subscription to a Subscription Unit that is 
based in the IT Operations Management  (ITOM) Visibility application or in the ITOM  Discovery 
application. As defined in the section titled "Managed IT Resource Types" in ServiceNow 
Subscription Unit Overview  for your subscription, for managed IT resources that are created 
or modified in the CMDB  by this Service Graph Connector, but that aren’t yet managed by ITOM 
Visibility or ITOM Discovery , these resources will increase Subscription Unit consumption from 
that application. Review your current Subscription Unit consumption within ITOM Visibility or 
ITOM Discovery to ensure available capacity.

Dependencies and requirements:

• The Integration Commons for CMDB  store app, which is automatically installed.

• The CMDB CI class models store app, which is automatically installed. See CMDB CI Class 
Models store app.

• Discovery Core plugin (com.snc.discovery.core), which is automatically installed by Discovery.

• The Datastream Action plugin (com.glide.hub.action_type.datastream), which is automatically 
installed.

• The ITOM Discovery License plugin (com.snc.itom.discovery.license). You must activate this 
plugin.

• ITOM Licensing plugin (com.snc.itom.license). For more information, see Request Discovery .

Important: 
After the initial import of Azure  data, the application performs a delta import of data. 
However, you can perform a full pull of data anytime later by disabling the delta 
synchronization and setting the sn_sg_azure_integ.is_delta_sync_enabled 
property to false. For more information, see Configuring data synchronization in Service 
Graph Connector for Microsoft Azure.

Role required: admin

About this task
The connector uses the Azure Management APIs  for the complete pull of data from Azure. 
However, to pull delta changes from Azure, the Azure Resource Graph APIs  are used. The domain 
name system (DNS) is Microsoft Azure Management, but the path is a resource graph.

For more information on the Azure  setup instructions, see the Service Graph Connector for Azure 
- Overview  article on the ServiceNow Community  site.
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Procedure

1. Navigate to All  > Service Graph Connectors  > Azure  > Setup.

2. On the Getting started page, select Get Started.

3. Create data sources and scheduled imports for the new connection.

a. On the Service Graph Connector for Microsoft Azure  page, in the Update Data Sources and 
Scheduled Imports Access, select the task Update Scheduled Data Import Access.

b. In the Update Scheduled Data Import Access section, select Configure  and do the following:

i. For the Update Scheduled Data Import access task, select Configure.

ii. Select the Global  application scope by using the application picker.

iii. In the Application Access related list, select the Can create, Can update, and Can delete 
check boxes, if not already selected.

iv. Select Update  to close the tab and return to the guided setup.

v. Modify the application scope again to Service Graph Connector for Microsoft Azure  by 
using the application picker.

vi. Set the Update Scheduled Data Import access  task to complete by selecting Mark as 
Complete.

vii. Repeat the steps 3.b.ii  to 3.b.v  for the Update Data Source Access task with the Data 
Source [sys_data_source] table and set the task to complete by selecting Mark as 
Complete.

c. Clear the cache for the new connection.

i. In the Clear Cache for Datasource and Import set section, select Configure.

ii. In the Run script  text box of the background script page, enter the following script:

GlideTableManager.invalidateTable("sys_data_source");
      GlideCacheManager.flushTable("sys_data_source");
 
     
 GlideTableManager.invalidateTable("scheduled_import_set");
      GlideCacheManager.flushTable("scheduled_import_set");
 
      GlideTableManager.invalidateTable("sys_db_object");
      GlideCacheManager.flushTable("sys_db_object");

iii. Select Run Script  to run the background script in the global  scope.

The script may take several minutes to execute.

iv. After the script is executed, select Close.

v. From the application picker, select the Service Graph Connector for Microsoft Azure 
application.

vi. Select Mark as Complete.

4. Create a connection to import hardware configuration items (CIs) from the Azure  client 
application.
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Note: 
Ensure that you have the User.Read  permission on the Microsoft Graph  API 
for the hardware import.  Also, ensure that the IAM policy for the Azure  subscription has 
the Reader role. See Assign a user as an administrator of an Azure subscription with 
conditions  on the Microsoft Azure  documentation site.

a. Obtain the OAuth credentials from your Azure  administrator.
Make a note of the following details:

▪ Application (client) ID

▪ Client Secret

▪ Directory (tenant) ID

▪ Connection URL

Note: 
After getting the OAuth credentials, in the guided setup for Service Graph Connector 
for Microsoft Azure, go to the Create connection for the hardware import  section of 
the  Service Graph Connector for Microsoft Azure  page and set the Get the OAuth 
credentials  task to complete by selecting Mark as Complete.

b. Configure your Azure hardware connection and credentials.

i. In the Create connection for the hardware import  section of the Service Graph Connector 
for Microsoft Azure page, select Continue.

ii. For the Create or Edit connection task, select Configure.

iii. On the Connections page of the Flow Designer, select Configure  for the SG-Azure 
Hardware Connection  connection that is available by default for the hardware import.

You can create multiple connections by selecting Add Connection.

iv. On the form, review and modify the fields.

Configure Connection form

Field Description

Connection Information

Connection Name Name to uniquely identify the hardware 
connection record. For example, SG-
Azure Hardware Connection.

Connection URL Base URL to connect to your Azure  client 
application.

Note: 
This field is automatically set to the 
URL to connect to the application. 
Leave the field value as is.

Credential Information

OAuth Client ID Application (client) ID of your Azure  client 
application as described in step 4.a.
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Field Description

OAuth Client Secret Client Secret of your Azure  client 
application as described in step 4.a.

OAuth Token URL Token URL of your Azure  client application.

Based on the region of your Azure  client 
application, enter the token URL in one of 
the following formats:

▪ Global

https://login.microsoftonl
ine.com/<tenantid>/oaut
h2/v2.0/token

▪ US Government

https://login.microsoftonl
ine.us/<tenantid>/oauth2/v
2.0/token

▪ China

https://login.partner.micr
osoftonline.cn/<tenantid>/
oauth2/v2.0/token

▪ Germany

https://login.microsoftonl
ine.de/<tenantid>/oauth2/v
2.0/token

Where <tenantid>  is the tenant ID of 
your Azure  client application as described 
in step 4.a.

v. Select Configure and Get OAuth Token.

vi. When the OAuth token flow is successfully completed, return to the Create connection for 
the hardware import task page using the back button for your browser.

vii. Set the Create or Edit connection task to complete by selecting Mark as Complete.

c. Test the Microsoft Graph  API connection to import hardware data from the Azure  client 
application.

i. For the Test Connection task, select Configure.

ii. Select the data source associated with the newly created connection in the Name  column 
of the Data Sources list.

iii. Select the Test Load 20 Records  related link.

iv. When the state changes to Complete, return to the setup by selecting Back to Guided 
Setup  in the Help panel.

v. Set the Test Connection task to complete by selecting Mark as Complete.

d. Review the scheduled data imports configuration.
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i. For the Set up scheduled import jobs task, select Configure.

ii. Select the SG-Azure Subscriptions  scheduled job.

iii. On the Scheduled Data Import form, verify the field values for the scheduled job and 
select the Active  check box.

For more information, see Schedule a data import .

iv. Select Update.

v. Set the Set up scheduled import jobs task to complete by selecting Mark as Complete  in 
the Help panel.

5. Create a connection to import software information from the Azure  client application.

Note: 
Ensure that you have the Data.Read  permission on the Log Analytics  API for the 
software import.

a. Obtain the OAuth credentials and set up the Log Analytics workspace in the Azure.

i. Ensure that you have the OAuth credentials from step 4.a.

ii. Configure the Log Analytics workspace in the Azure  client application.

▪ Use an existing workspace, if available.

▪ Create another workspace.

For more information, see Create Log Analytics workspace  in the Azure 
documentation.

Note: 
Make a note of the Workspace ID.

iii. Deploy Azure Monitoring Agent (AMA), and then enable change tracking and inventory 
using AMA.

For more information, see Enable Change Tracking and Inventory using Azure Monitoring 
Agent  in the Azure  documentation.

iv. Deploy Dependency Agent as part of VM insights to collect discovered data about VM 
processes and their connections.

For more information, see Enable VM Insights overview  in the Azure  documentation.

Note: 
After obtaining the OAuth credentials, in the guided setup for Service Graph Connector 
for Microsoft Azure, go to the Create connection for the software import section of 
the Service Graph Connector for Microsoft Azure page and set the Get the OAuth 
credentials task to complete by selecting Mark as Complete.

b. Configure your Azure software connection and credentials.

i. In the Create connection for the software import  section of the Service Graph Connector 
for Microsoft Azure page, select Continue.

ii. For the Create or Edit connection task, select Configure.
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iii. On the Connections page of the Flow Designer, select Configure  for the SG-Azure log 
analytics connection  connection that is available by default for the software import.

You can create multiple connections by selecting Add Connection.

iv. On the form, review and modify the fields.

Configure Connection form

Field Description

Connection Information

Software Connection Name Name to uniquely identify the software 
connection record. For example, 
SG-Azure log analytics 
connection.

Hardware Connection Name Name of the hardware connection 
associated with the software as described 
in step 4.b.iv.

You add a hardware connection name to 
associate the software connection with the 
respective hardware.

Connection URL Base URL to connect to the Log Analytics 
workspace in the following format:

https://api.loganalytics.
io/v1/workspaces/<workspace_
id>

Where <workspace_id>  is the ID of the 
Log Analytics workspace as described in 
step 5.a.ii.

Note: 
This field is automatically set to 
the URL to connect to the Log 
Analytics workspace. Replace the 
<workspace_id>  variable in 
the auto-generated URL with the 
workspace ID of your Log Analytics 
workspace.

Credential Information

OAuth Client ID Application (client) ID of your Azure  client 
application as described in step 4.a.

OAuth Client Secret Client Secret of your Azure  client 
application as described in step 4.a.

OAuth Token URL Token URL of your Azure  client application.

Based on the region of your Azure  client 
application, enter the token URL in one of 
the following formats:
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Field Description

▪ Global

https://login.microsoftonl
ine.com/<tenantid>/oaut
h2/v2.0/token

▪ US Government

https://login.microsoftonl
ine.us/<tenantid>/oauth2/v
2.0/token

▪ China

https://login.partner.micr
osoftonline.cn/<tenantid>/
oauth2/v2.0/token

▪ Germany

https://login.microsoftonl
ine.de/<tenantid>/oauth2/v
2.0/token

Where <tenantid>  is the tenant ID of 
your Azure  client application as described 
in step 4.a.

v. Select Configure and Get OAuth Token.

vi. When the OAuth token flow is successfully completed, return to the Create connection for 
the software import task page using the back button for your browser.

vii. Set the Create or Edit connection task to complete by selecting Mark as Complete.

c. Test the Log Analytics  API connection to import software data from the Azure  client 
application.

i. For the Test Connection task, select Configure.

ii. Select the data source associated with the newly created connection in the Name  column 
of the Data Sources list.

iii. Select the Test Load 20 Records  related link.

iv. When the state changes to Complete, return to the setup by selecting Back to Guided 
Setup  in the Help panel.

v. Set the Test Connection task to complete by selecting Mark as Complete.

d. Review the scheduled data imports configuration.

i. For the Set up scheduled import jobs task, select Configure.

ii. Select the SG-Azure Software  scheduled data import.

iii. On the Scheduled Data Import form, verify the field values for the scheduled job and 
select the Active  check box.

For more information, see Schedule a data import .
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iv. Select Update.

v. Set the Set up scheduled import jobs task to complete by selecting Mark as Complete  in 
the Help panel.

6. Optional:  Enable extended discovery using the run  command.

(Optional) The run  command is used to run a set of commands on the VMs to fetch server 
information such as CPU count, cores, model, and manufacturer. For information about 
extended discovery using the run  command, see the Extended discovery with Run Command 
on Service Graph connector for Microsoft Azure [KB2210811]  article in the Now Support 
Knowledge Base.

a. Download the scripts that are required to enable extended discovery.

i. For the Download the scripts task, select Configure.

ii. After the scripts are downloaded, select Mark as Complete  to set the Download the 
scripts task to complete.

b. Configure an Azure storage account for extended discovery.

i. For the Configure Azure Storage account for Run Command task, select Configure.

For information about configuring an Azure storage account for extended discovery, 
see the Instructions for setting up Run Command in Service Graph Connector for Azure 
[KB2001668]  article in the Now Support  Knowledge Base.

ii. Set up a new Azure storage account.

iii. Set up a container to upload the script files.

iv. Set up another container to store the results.

v. Provide run  command access to the service principal.

vi. Select Mark as Complete  to set the Configure Azure Storage account for Run Command 
task to complete.

c. Configure the connection properties for the new instance that you created for Service Graph 
Connector for Microsoft Azure.

i. For the Configure connection properties task, select Configure.

ii. In the Connection*  field of the SG-Azure Configuration Properties section, select the new 
instance that you created.

The fields in the Properties section are populated with the details of the instance.

iii. In the Properties section, provide the following details for the instance that you created:

▪ Name of the storage account where the containers are created

▪ Subscription ID where the storage account is created

▪ Resource group of the storage account

▪ Name of the container where the sh  and ps1  files are uploaded in Azure

▪ Name of the container where the results of the commands are to be stored

▪ URI of the sh  file that has to be run on Linux  machines

▪ URI of the ps1  file that has to be run on Windows  machines
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iv. Select Save.

v. Select Mark as Complete  to set the Configure connection properties task to complete.

Result
The data from Azure  is pulled into your CMDB.

CMDB  classes targeted in Service Graph Connector for Microsoft Azure

When you complete setting up the connection, you can configure the integration to periodically 
pull data from Microsoft Azure. The data is saved in tables that extend from the Configuration 
item [cmdb_ci] table.

Application [cmdb_ci_appl]

The following attributes in the Application [cmdb_ci_appl] table are populated by collected data:

Attribute label Attribute name

Class sys_class_name

Version version

TCP port(s) tcp_port

Running Process running_process

Running process key parameters running_process_key_parameters

Name name

Running process command running_process_command

Relationship created for Application

Parent class Relationship type Child class

Application [cmdb_ci_appl] Runs on::Runs Computer 
[cmdb_ci_computer]

Availability Zone [cmdb_ci_availability_zone]

The following attributes in the Availability Zone [cmdb_ci_availability_zone] table are populated 
by collected data.

Attribute label Attribute name

Install Status install_status

Name name

Object ID object_id

Operational status operational_status

State state

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1109



Relationship created for Availability Zone

Parent class Relationship type Child class

Availability Zone 
[cmdb_ci_availability_zone]

Reference Key Value [cmdb_key_value]

Azure Datacenter [cmdb_ci_azure_datacenter]

The following attributes in the Azure Datacenter [cmdb_ci_azure_datacenter]  table are populated 
by collected data.

Attribute label Attribute name

Comments comments

Name name

Object ID object_id

Region region

Status install_status

Relationships created for Azure Datacenter

Parent class Relationship type Child class

Azure Datacenter 
[cmdb_ci_azure_datacenter]

Hosted on::Hosts Cloud Service Account 
[cmdb_ci_cloud_service_account]

Azure Datacenter 
[cmdb_ci_azure_datacenter]

Contains::Contained by Resource Group 
[cmdb_ci_resource_group]

Azure Datacenter 
[cmdb_ci_azure_datacenter]

Contains::Contained by Availability Zone 
[cmdb_ci_availability_zone]

Cloud DataBase [cmdb_ci_cloud_database]

The following attributes in the Cloud DataBase [cmdb_ci_cloud_database] table are populated by 
collected data.

Attribute label Attribute name

Fully qualified domain name fqdn

Install Status install_status

Name name

Object ID object_id

Operational status operational_status

State state

Type type

Version version
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Relationships created for Cloud DataBase

Parent class Relationship type Child class

Cloud DataBase 
[cmdb_ci_cloud_database]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]

Cloud DataBase 
[cmdb_ci_cloud_database]

Reference Key Value [cmdb_key_value]

Cloud Function [cmdb_ci_cloud_function]

The following attributes in the Cloud Function [cmdb_ci_cloud_function] table are populated by 
collected data.

Attribute label Attribute name

App Function state app_function_state

Code Location URL code_location_url

Fully qualified domain name fqdn

Function Last Modified function_last_modified

Install Status install_status

IP Address ip_address

Name name

Object ID object_id

Operational status operational_status

Relationship created for Cloud Function

Parent class Relationship type Child class

Cloud Function 
[cmdb_ci_cloud_function]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]

Cloud LB IPAddress [cmdb_ci_cloud_lb_ipaddress]

The following attributes in the Cloud LB IPAddress [cmdb_ci_cloud_lb_ipaddress] table are 
populated by collected data.

Attribute label Attribute name

Fully qualified domain name fqdn

Install Status install_status

IP Address ip_address

IPAddress Type ipaddress_type

Name name

Object ID object_id
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Attribute label Attribute name

Operational status operational_status

Cloud Load Balancer [cmdb_ci_cloud_load_balancer]

The following attributes in the Cloud Load Balancer [cmdb_ci_cloud_load_balancer] table are 
populated by collected data.

Attribute label Attribute name

Canonical Hosted Zone Name canonical_hosted_zone_name

DNS Name dns_name

Fully qualified domain name fqdn

Install Status install_status

IP Address ip_address

Name name

Object ID object_id

Operational status operational_status

State state

Relationships created for Cloud Load Balancer

Parent class Relationship type Child class

Cloud Load Balancer 
[cmdb_ci_cloud_load_balancer]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]

Cloud Load Balancer 
[cmdb_ci_cloud_load_balancer]

Owns::Owned by Cloud LB IPAddress 
[cmdb_ci_cloud_lb_ipaddress]

Cloud Load Balancer 
[cmdb_ci_cloud_load_balancer]

Reference Key Value [cmdb_key_value]

Cloud Mgmt Network Interface [cmdb_ci_nic]

The following attributes in the Cloud Mgmt Network Interface [cmdb_ci_nic] table are populated 
by collected data.

Attribute label Attribute name

Configuration Item cmdb_ci

Install Status install_status

IP Address ip_address

MAC Address mac_address

Name name

Object ID object_id

Operational status operational_status
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Attribute label Attribute name

Primary primary

Private IP private_ip

Public DNS public_dns

Public IP public_ip

State state

Static is_static

Relationships created for Cloud Mgmt Network Interface

Parent class Relationship type Child class

Cloud Mgmt Network Interface 
[cmdb_ci_nic]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]

Cloud Mgmt Network Interface 
[cmdb_ci_nic]

Contains::Contained by Cloud Public IP Address 
[cmdb_ci_cloud_public_ipaddress]

Cloud Mgmt Network Interface 
[cmdb_ci_nic]

Reference Key Value [cmdb_key_value]

Cloud Mgmt Network Interface 
[cmdb_ci_nic]

Reference Virtual Machine Instance 
[cmdb_ci_vm_instance]

Cloud Mgmt Network Interface 
[cmdb_ci_nic]

Reference Computer 
[cmdb_ci_computer]

Cloud Network [cmdb_ci_network]

The following attributes in the Cloud Network [cmdb_ci_network] table are populated by 
collected data.

Attribute label Attribute name

Cidr cidr

Install Status install_status

Name name

Object ID object_id

Operational status operational_status

State state

Relationships created for Cloud Network

Parent class Relationship type Child class

Cloud Network 
[cmdb_ci_network]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]

Cloud Network 
[cmdb_ci_network]

Contains::Contained by Compute Security Group 
[cmdb_ci_compute_security_group]
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Relationships created for Cloud Network  (continued)

Parent class Relationship type Child class

Cloud Network 
[cmdb_ci_network]

Contains::Contained by Cloud Subnet 
[cmdb_ci_cloud_subnet]

Cloud Network 
[cmdb_ci_network]

Reference Key Value [cmdb_key_value]

Cloud Public IP Address [cmdb_ci_cloud_public_ipaddress]

The following attributes in the Cloud Public IP Address [cmdb_ci_cloud_public_ipaddress] table 
are populated by collected data.

Attribute label Attribute name

Install Status install_status

Name name

Object ID object_id

Operational status operational_status

Public DNS public_dns

Public IP Address public_ip_address

State state

Relationships created for Cloud Public IP Address

Parent class Relationship type Child class

Cloud Public IP Address 
[cmdb_ci_cloud_public_ipaddress]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]

Cloud Public IP Address 
[cmdb_ci_cloud_public_ipaddress]

Reference Key Value [cmdb_key_value]

Cloud Resource [cmdb_ci_cmp_resource]

The following attributes in the Cloud Resource [cmdb_ci_cmp_resource] table are populated by 
collected data.

Attribute label Attribute name

Description short_description

Install Status install_status

Name name

Object ID object_id

Operational status operational_status

Resource type resource_type

State state
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Relationships created for Cloud Resource

Parent class Relationship type Child class

Cloud Resource 
[cmdb_ci_cmp_resource]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]

Cloud Resource 
[cmdb_ci_cmp_resource]

Reference Key Value [cmdb_key_value]

Cloud Service Account [cmdb_ci_cloud_service_account]

The following attributes in the Cloud Service Account [cmdb_ci_cloud_service_account] table are 
populated by collected data.

Attribute label Attribute name

Account Id account_id

Name name

Object ID object_id

Datacenter Type datacenter_type

Relationship created for Cloud Service Account

Parent class Relationship type Child class

Cloud Service Account 
[cmdb_ci_cloud_service_account]

Reference Key Value [cmdb_key_value]

Cloud Storage Account [cmdb_ci_cloud_storage_account]

The following attributes in the Cloud Storage Account [cmdb_ci_cloud_storage_account] table 
are populated by collected data.

Attribute label Attribute name

Blob Service blob_service

File Service file_service

Install Status install_status

Name name

Object ID object_id

Queue Service queue_service

Sku Name sku_name

State state

Table Service table_service
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Relationships created for Cloud Storage Account

Parent class Relationship type Child class

Cloud Storage Account 
[cmdb_ci_cloud_storage_account]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]

Cloud Storage Account 
[cmdb_ci_cloud_storage_account]

Reference Key Value [cmdb_key_value]

Cloud Subnet [cmdb_ci_cloud_subnet]

The following attributes in the Cloud Subnet [cmdb_ci_cloud_subnet] table are populated by 
collected data.

Attribute label Attribute name

CIDR cidr

Install Status install_status

Name name

Object ID object_id

Operational status operational_status

State state

Relationship created for Cloud Subnet

Parent class Relationship type Child class

Cloud Subnet 
[cmdb_ci_cloud_subnet]

Reference Key Value [cmdb_key_value]

Compute Security Group [cmdb_ci_compute_security_group]

The following attributes in the Compute Security Group [cmdb_ci_compute_security_group] table 
are populated by collected data.

Attribute label Attribute name

Install Status install_status

Name name

Object ID object_id

Operational status operational_status

State state

Relationships created for Compute Security Group

Parent class Relationship type Child class

Compute Security Group 
[cmdb_ci_compute_security_group]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]
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Relationships created for Compute Security Group  (continued)

Parent class Relationship type Child class

Compute Security Group 
[cmdb_ci_compute_security_group]

Reference Key Value [cmdb_key_value]

Computer [cmdb_ci_computer]

The following attributes in the Computer [cmdb_ci_computer] table are populated by collected 
data.

Attribute label Attribute name

Name name

CPU core count cpu_core_count

CPU count cpu_count

Disk space (GB) disk_space

IP Address ip_address

Is Virtual virtual

Object ID object_id

Operating System os

Operational status operational_status

OS Version os_version

RAM (MB) ram

Serial number serial_number

Relationships created for Computer

Parent class Relationship type Child class

Computer 
[cmdb_ci_computer]

Owns::Owned by IP Address 
[cmdb_ci_ip_address]

Computer 
[cmdb_ci_computer]

Virtualized by::Virtualizes Virtual Machine Instance 
[cmdb_ci_vm_instance]

For information about the classification of VDIs into the Computer [cmdb_ci_computer] CI class, 
see the Classification of VDIs into computer class using Service graph connector for Azure 
[KB2184443]  article in the Now Support  Knowledge Base.

Hardware Type [cmdb_ci_compute_template]

The following attributes in the Hardware Type [cmdb_ci_compute_template] table are populated 
by collected data.

Attribute label Attribute name

Name name
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Attribute label Attribute name

Object ID object_id

Class sys_class_name

Cores cores

Logical Storage GB local_storage_gb

Memory MB memory_mb

vCPUs vcpus

Relationship created for Hardware Type

Parent class Relationship type Child class

Hardware Type 
[cmdb_ci_compute_template]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]

Note: 
When the Cloud Hardware Type class extension is enabled, the Class  attribute is set to 
Cloud Hardware Type. Else, the attribute is set to Hardware Type.

As a user with the admin role, you can enable the Cloud Hardware Type class 
extension by setting the use a single hardware type for cloud data centers  property 
(sn_itom_pattern.use a single hardware type for cloud data 
centers) to true. For more information, see the Service Graph Connector For Microsoft 
Azure - Migrating to a new hardware type model [KB1288455]  article in the Now Support 
Knowledge Base.

Relationship created for Hardware Type

Parent class Relationship type Child class

Hardware Type 
[cmdb_ci_compute_template]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]

Image [cmdb_ci_os_template]

The following attributes in the Image [cmdb_ci_os_template] table are populated by collected 
data.

Attribute label Attribute name

Guest OS guest_os

Image Source image_source

Install Status install_status

Name name

Object ID object_id

Offer offer

Operational status operational_status

Version version
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Attribute label Attribute name

Vendor vendor

Relationship created for Image

Parent class Relationship type Child class

Image [cmdb_ci_os_template] Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]

Instance Scale Set [cmdb_ci_instance_scale_set]

The following attributes in the Instance Scale Set [cmdb_ci_instance_scale_set] table are 
populated by collected data.

Attribute label Attribute name

Install Status install_status

Name name

Object ID object_id

Operational status operational_status

State state

Relationship created for Instance Scale Set

Parent class Relationship type Child class

Instance Scale Set 
[cmdb_ci_instance_scale_set]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]

IP Address [cmdb_ci_ip_address]

The following attributes in the IP Address [cmdb_ci_ip_address] table are populated by collected 
data.

Attribute label Attribute name

Owned By Configuration Item owned_by_cmdb_ci

IP Address ip_address

Name name

Nic nic

Relationships created for IP Address

Parent class Relationship type Child class

IP Address 
[cmdb_ci_ip_address]

Reference Cloud Mgmt Network Interface 
[cmdb_ci_nic]
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Relationships created for IP Address  (continued)

Parent class Relationship type Child class

IP Address 
[cmdb_ci_ip_address]

Reference Computer 
[cmdb_ci_computer]

Key Value [cmdb_key_value]

The following attributes in the Key Value [cmdb_key_value] table are populated by collected data.

Attribute label Attribute name

Key key

Value value

Kubernetes Cluster [cmdb_ci_kubernetes_cluster]

The following attributes in the Kubernetes Cluster [cmdb_ci_kubernetes_cluster] table are 
populated by collected data.

Attribute label Attribute name

Cluster Resource ID cluster_resource_id

Cluster Version cluster_version

Fully qualified domain name fqdn

Install Status install_status

Kubernetes UID k8s_uid

Name name

Relationship created for Kubernetes Cluster

Parent class Relationship type Child class

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]

Linux Server [cmdb_ci_linux_server]

The following attributes in the Linux Server [cmdb_ci_linux_server] table are populated by 
collected data.

Attribute label Attribute name

CPU core count cpu_core_count

Disk space (GB) disk_space

Install Status install_status

Is Virtual virtual
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Attribute label Attribute name

Name name

Object ID object_id

Operating System os

Operational status operational_status

OS Version os_version

RAM (MB) ram

Serial number serial_number

Relationship created for Linux Server

Parent class Relationship type Child class

Linux Server 
[cmdb_ci_linux_server]

Virtualized by::Virtualizes Virtual Machine Instance 
[cmdb_ci_vm_instance]

Resource Group [cmdb_ci_resource_group]

The following attributes in the Resource Group [cmdb_ci_resource_group] table are populated by 
collected data.

Attribute label Attribute name

Name name

Object ID object_id

Operational status operational_status

Install Status install_status

State state

Relationships created for Resource Group

Parent class Relationship type Child class

Resource Group 
[cmdb_ci_resource_group]

Contains::Contained by Virtual Machine Instance 
[cmdb_ci_vm_instance]

Resource Group 
[cmdb_ci_resource_group]

Contains::Contained by Cloud Load Balancer 
[cmdb_ci_cloud_load_balancer]

Resource Group 
[cmdb_ci_resource_group]

Contains::Contained by Instance Scale Set 
[cmdb_ci_instance_scale_set]

Resource Group 
[cmdb_ci_resource_group]

Contains::Contained by Image [cmdb_ci_os_template]

Resource Group 
[cmdb_ci_resource_group]

Contains::Contained by Storage Volume 
[cmdb_ci_storage_volume]

Resource Group 
[cmdb_ci_resource_group]

Reference Key Value [cmdb_key_value]
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Serial Number [cmdb_serial_number]

The following attributes in the Serial Number [cmdb_serial_number] table are populated by 
collected data.

Attribute label Attribute name

Serial Number serial_number

Serial Number Type serial_number_type

Valid valid

Relationships created for Serial Number

Parent class Relationship type Child class

Serial Number 
[cmdb_serial_number]

Reference Server [cmdb_ci_server]

Serial Number 
[cmdb_serial_number]

Reference Windows Server 
[cmdb_ci_win_server]

Serial Number 
[cmdb_serial_number]

Reference Linux Server 
[cmdb_ci_linux_server]

Server [cmdb_ci_server]

The following attributes in the Server [cmdb_ci_server] table are populated by collected data.

Attribute label Attribute name

CPU core count cpu_core_count

CPU count cpu_count

Disk space (GB) disk_space

Install Status install_status

Is Virtual virtual

Name name

Object ID object_id

Operating System os

Operational status operational_status

OS Version os_version

RAM (MB) ram

Serial number serial_number

Comments comments
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Relationships created for Server

Parent class Relationship type Child class

Server [cmdb_ci_server] Owns::Owned by Cloud Mgmt Network Interface 
[cmdb_ci_nic]

Server [cmdb_ci_server] Virtualized by::Virtualizes Virtual Machine Instance 
[cmdb_ci_vm_instance]

Software [cmdb_ci_spkg]

The following attributes in the Software [cmdb_ci_spkg] table are populated by collected data.

Attribute label Attribute name

Key key

Name name

Version version

Relationship created for Software

Parent class Relationship type Child class

Software [cmdb_ci_spkg] Reference Software Instance 
[cmdb_software_instance]

Software Installation [cmdb_sam_sw_install]

The following attributes in the Software Installation [cmdb_sam_sw_install] table are populated 
by collected data.

Attribute label Attribute name

Display name display_name

Publisher publisher

Version version

Discovery source discovery_source

Software Instance [cmdb_software_instance]

The following attributes in the Software Instance [cmdb_software_instance] table are populated 
by collected data.

Attribute label Attribute name

Installed on installed_on

Name name
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Relationships created for Software Instance

Parent class Relationship type Child class

Software Instance 
[cmdb_software_instance]

Reference Computer 
[cmdb_ci_computer]

Storage Volume [cmdb_ci_storage_volume]

The following attributes in the Storage Volume [cmdb_ci_storage_volume] table are populated by 
collected data.

Attribute label Attribute name

Install Status install_status

Name name

Object ID object_id

Operational status operational_status

Size size

Size bytes size_bytes

State state

Volume ID volume_id

Relationships created for Storage Volume

Parent class Relationship type Child class

Storage Volume 
[cmdb_ci_storage_volume]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]

Storage Volume 
[cmdb_ci_storage_volume]

Reference Key Value [cmdb_key_value]

Virtual Machine Instance [cmdb_ci_vm_instance]

The following attributes in the Virtual Machine Instance [cmdb_ci_vm_instance] table are 
populated by collected data.

Attribute label Attribute name

CPUs cpus

Disks size (GB) disks_size

Install Status install_status

IP Address ip_address

Memory (MB) memory

Name name

Object ID object_id
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Attribute label Attribute name

Operational status operational_status

State state

VM Instance ID vm_inst_id

Relationships created for Virtual Machine Instance

Parent class Relationship type Child class

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Managed by::Manages Instance Scale Set 
[cmdb_ci_instance_scale_set]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Provisioned From::Provisioned Image [cmdb_ci_os_template]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Provisioned From::Provisioned Hardware Type 
[cmdb_ci_compute_template]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Contains::Contained by Cloud Mgmt Network Interface 
[cmdb_ci_nic]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Uses:Used by Storage Volume 
[cmdb_ci_storage_volume]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Reference Key Value [cmdb_key_value]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Reference Computer 
[cmdb_ci_computer]

Windows Server [cmdb_ci_win_server]

The following attributes in the Windows Server [cmdb_ci_win_server] table are populated by 
collected data.

Attribute label Attribute name

CPU core count cpu_core_count

Disk space (GB) disk_space

Install Status install_status

Is Virtual virtual

Name name

Object ID object_id

Operating System os

Operational status operational_status

OS Version os_version

RAM (MB) ram

Serial number serial_number
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Relationship created for Windows Server

Parent class Relationship type Child class

Windows Server 
[cmdb_ci_win_server]

Virtualized by::Virtualizes Virtual Machine Instance 
[cmdb_ci_vm_instance]

Quick start tests for Service Graph Connector for Microsoft Azure

Validate that Service Graph Connector for Microsoft Azure still works after you make any 
configuration change such as applying an upgrade or developing an application. Copy and 
customize these quick start tests to pass when using your instance-specific data.

Danger: 
By default, the system property that is used to run automated tests is disabled to prevent 
you from accidentally running these tests on a production system. To avoid data corruption 
or an outage, run tests only on development, test, and other non-production instances. See 
Enable or disable executing Automated Test Framework tests .

Service Graph Connector for Microsoft Azure

SG-Azure: Service Graph Connector for Microsoft Azure Validation test suite
Test suite to verify the integrity of an integration using multiple tests.

Test Description Release version

SG-Azure Availability Zone Validate the successful 
ingestion of the record in the 
Availability Zone table with the 
prerequisite parent ingestion.

Utah

SG-Azure Data Center Validate the successful 
ingestion of multiple records 
in the Azure Data Center table 
with the prerequisite parent 
ingestion.

Utah

SG-Azure Functions Validate the successful 
ingestion of multiple records 
in the Cloud Service Account, 
Data Center, Cloud Database, 
and Cloud Function.

Utah

SG-Azure Generic Resources Validate the successful 
ingestion of multiple records 
in the Cloud Resource and 
Relations table.

Utah

SG-Azure Hardware Template Validate the successful 
ingesion of multiple records 
in the Hardware Template and 
Compute Template tables.

Utah

SG-Azure Load Balancers Validate the successful 
ingestion of multiple records 
in the Load Balancer, 
Computer Security Group 

Utah
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SG-Azure: Service Graph Connector for Microsoft Azure Validation test suite
Test suite to verify the integrity of an integration using multiple tests.

(continued)

Test Description Release version

and Relations table with the 
prerequisite parent ingestion.

SG-Azure Network Validate the successful 
ingestion of multiple records 
in the Network table with the 
prerequisite parent ingestion.

Utah

SG-Azure Network Interface Validate the successful 
ingestion of multiple records 
in the Networks, Public IP 
Address and Relations table.

Utah

SG-Azure Public IP Address Validate the successful 
ingestion of multiple records 
in the Public IP Address, 
Networks, and Load Balancer 
tables.

Utah

SG-Azure Resource Group Validate the successful 
ingestion of records in the 
Resource Group table.

Utah

SG-Azure Scale Sets Validate the successful 
ingestion of records in the 
Scale Sets and Relations 
tables.

Utah

SG-Azure Scale Sets VMs Validate the successful 
ingestion of multiple records 
in the Servers, Virtual Machine 
Instance, Scale Sets, and 
Relations tables with the 
prerequisite parent ingestion.

Utah

SG-Azure Security Groups Validate the successful 
ingestion of multiple records 
in the Cloud Service Account, 
Computer Security Group, 
and Relations tables with the 
prerequisite parent ingestion.

Utah

SG-Azure Server Config Data Validate the successful 
ingestion of multiple records 
in the Virtual Machine 
Instance, Linux Server, and 
Relations tables with the 
prerequisite parent ingestion.

Utah

SG-Azure Software Validate the successful 
ingestion of multiple records 
in the Virtual Machine 
Instance, Software Records, 

Utah
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SG-Azure: Service Graph Connector for Microsoft Azure Validation test suite
Test suite to verify the integrity of an integration using multiple tests.

(continued)

Test Description Release version

and Relations tables with the 
prerequisite parent ingestion.

SG-Azure SQL Validate the successful 
ingestion of multiple records 
in the Data Center, Cloud 
Database, and Relations 
tables with the prerequisite 
parent ingestion.

Utah

SG-Azure Storage Account Validate the successful 
ingestion of multiple records 
in the Storage Account, 
Computer Security Group 
and Relations tables with the 
prerequisite parent ingestion.

Utah

SG-Azure Storage Volume Validate the successful 
ingestion of multiple records 
in the Storage Volume, 
Computer Security Group 
and Relations tables with the 
prerequisite parent ingestion.

Utah

SG-Azure Subscription Validate the successful 
ingestion of records in the 
Cloud Service Account table.

Utah

SG-Azure VMs Validate the successful 
ingestion of multiple records 
in the Virtual Machines, 
Virtual Machine Instance 
and Relations tables with 
prerequisite parent ingestion.

Utah

To learn more about Service Graph Connector for Microsoft Azure, see Service Graph Connector 
for Microsoft Azure.

Related topics

Quick start tests

Accessing the connection details of Service Graph Connector for Microsoft Azure

You can access the connection details of the Service Graph Connector for Microsoft Azure  in 
a single view using the common connection framework (CCF) included within the Integration 
Commons for CMDB  (sn_cmdb_int_util) store app.

With the CCF, you can access all the connections used by the Service Graph Connector for 
Microsoft Azure. The connection details include the connection alias, connection properties, 
data sources, and scheduled data imports associated with a connection. You can also test 
the connection. For more information, see Accessing the connection details of Service Graph 
Connectors.
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Access the details of an Azure  connection

Access the details of an Azure  connection configured for the Service Graph Connector for 
Microsoft Azure.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Service Graph Connectors  > Azure  > Connections.

2. From the Name  column of the Service Graph Connections list, select a connection.

3. On the Service Graph Connections page, view the connection details such as the connection 
name, alias, and data sources.

4. Select a related list to view further details of the connection.

5. Optional:  Select the Test Connection  related link to test the connection.

Additional features within the Service Graph Connector for Microsoft Azure

Use the additional features available within the Service Graph Connector for Microsoft Azure  to 
maximize its use for importing data.

The following features are available within the Service Graph Connector for Microsoft Azure:

Configure multiple Azure  connections

Follow the guided setup to establish a hardware or software connection, or 
configure a workspace when adding a software connection.

Set partition size for Azure accounts with parallel loading enabled

Optimize the performance of data sources by enabling parallel data loading.

Disable delta synchronization

Import full data from your Azure  instance when needed.

Enabling VM insights for collecting Azure data

Enable the VM insights  feature for all the VMs in your Log Analytics workspace to 
populate the VMConnection and VMProcess tables in Azure.

Setting up multiple connections in Service Graph Connector for Microsoft Azure

The Service Graph Connector for Microsoft Azure  supports multiple Azure  connections.

Important: 
Add multiple connections by selecting Add connection  on the Connections page of the 
Flow Designer  in the guided setup. For more information, see Configure Service Graph 
Connector for Microsoft Azure.

Setting up multiple connections

You can set up a hardware or software connection by using the guided setup. The Service 
Graph Connector for Microsoft Azure  supports only one-to-one mapping between hardware and 
software connections. Therefore, when configuring multiple software connections, you must 
also configure an equivalent number of hardware connections. You can differentiate multiple 
connections using their respective connection aliases.

For example, if you add 10 software connections for 10 different workspaces, you must also add 
10 hardware connections for each corresponding software connection.
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Setting up multiple workspaces

You can set up a workspace when adding a software connection using the guided setup. To set 
up multiple workspaces, you must configure that many different software connections in the 
Service Graph Connector for Microsoft Azure  as there are workspaces and an equivalent number 
of hardware connections.

For example, if you have 10 workspaces, you must add 10 software connections for each 
workspace and 10 hardware connections for each corresponding software connection.

Set partition size for Azure  accounts with parallel loading enabled

Optimize the performance of data sources  by setting the partition size in the 
azure_full_pull_partition_size  system property.

Before you begin
Set the application scope to Service Graph Connector for Microsoft Azure  using the application 
picker. For more information, see Application picker .

Role required: admin

About this task
The parallel loading feature is available for the following data sources:

• Starting with the Service Graph Connector for Microsoft Azure  1.13.0 version:

◦ SG-Azure Functions

◦ SG-Azure Generic Resources

◦ SG-Azure Get Run Command

◦ SG-Azure Hardware Template Updation​

◦ SG-Azure HW Consolidation​

◦ SG-Azure Kubernetes Cluster

◦ SG-Azure Load Balancers

◦ SG-Azure Network Interface

◦ SG-Azure Public IP Address

◦ SG-Azure Run Command

◦ SG-Azure Scale Sets VMs

• Starting with the Service Graph Connector for Microsoft Azure  1.11.0 version:

◦ SG-Azure Network

◦ SG-Azure Virtual Machines

◦ SG-Azure Storage Volume

For a full data pull, the azure_full_pull_partition_size  property determines the 
number of Azure  subscriptions that can be executed as parallel jobs to retrieve configuration 
item (CI) data. Partition size determines how many Azure  subscriptions a single parallel-thread 
evaluates for data retrieval. If you set the azure_full_pull_partition_size  property to 
100, the partition size is 100 subscriptions.

Note: 
If the azure_full_pull_partition_size  property isn't configured, the partition 
size computation feature of the Integration Commons for CMDB  application automatically 
determines the partition size for parallel loading at runtime. See Partition size computation 
for parallel loading in Integration Commons for CMDB.
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Procedure

1. Navigate to All  > Service Graph Connectors  > Azure  > Connections.

2. From the Name  column of the Service Graph Connections list, select a connection.

3. From the Property  column of the Service Graph Connection Properties related list, select 
azure_full_pull_partition_size.
The azure_full_pull_partition_size  system property determines the number of 
subscriptions that each partition processes for a full pull. For more information, see Service 
Graph Connector for Microsoft Azure properties.

4. In the Value  field, enter a numeric value greater than 0  for the partition size.

5. Select Update.

Note: 
After you enable parallel data loading for a data source, the Test Load 20 Records  and 
Load All Records  options don't work for executing the data source. You must select 
Execute Now  from Scheduled Data Import  to execute the data source for which parallel 
loading is enabled.

Configuring data synchronization in Service Graph Connector for Microsoft Azure

You can configure the system property for synchronizing only delta data from an Azure  instance.

The connector provides the ability to import only delta data from an Azure  instance. With delta 
synchronization enabled, the importing process of Azure  data is quicker because the connector 
imports the changes in Azure  data only.  The Last Run Time  field of a data source displays the 
timestamp of the most recent delta pull run. The Last Run Time  field is updated only when the 
last delta pull run was a success. An empty Last Run Time  field indicates no previous delta pull 
run for the data source, but either a full pull run or no run at all. The delta pull period is calculated 
by subtracting the last run date and time from the current date and time that is Delta period = 
Current date timestamp - Last run date timestamp.

The application includes the sn_sg_azure_integ.is_delta_sync_enabled 
system property to enable delta synchronization. By default, the property is set to true. 
However, when you want to import full data from your Azure  instance, you must disable 
the sn_sg_azure_integ.is_delta_sync_enabled  property. See Disable delta 
synchronization.

Note: 
When the full import of data is completed, set the 
sn_sg_azure_integ.is_delta_sync_enabled  property back to true  to pull 
delta data later. If you leave the property set to false, full data is imported with every 
pull, which takes considerable time. In addition, always importing full data contributes 
to discrepancies in the pulled-in data, as the full import doesn’t include any updated or 
deleted configuration items (CIs).

For a delta pull, you can also configure the grace time, page size, preceding time period, and API 
call duration using system properties. For more information, see Service Graph Connector for 
Microsoft Azure properties.

Disable delta synchronization

Disable delta synchronization to import all the Microsoft Azure  data.

Before you begin
Set the application scope to Service Graph Connector for Microsoft Azure  using the application 
picker. For more information, see Application picker .
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Role required: admin

Procedure

1. Enter sys_properties.list  in the navigation filter, and then open the 
sn_sg_azure_integ.is_delta_sync_enabled  property.

2. In the Value  field, enter false.

3. Select Update.

Enabling VM insights  for collecting Azure  data

You must enable the VM insights  feature in the Azure  portal for collecting TCP and processes 
data using the Service Graph Connector for Microsoft Azure.

Requirements for enabling the VM insights feature

• Ensure that you’ve created the Log Analytics  workspace to push the logs from virtual machines 
(VMs) via insights in Azure  Monitor. See Insights in Azure Monitor  on the Microsoft Azure 
documentation site.

• Note down the subscription name associated with your Log Analytics workspace.

Collecting the TCP and processes data

The SG-Azure TCP and SG-Azure VM Config Data data sources in the Service Graph Connector 
for Microsoft Azure  import data from the VMConnection and VMProcess tables in Azure, 
respectively. To fetch data correctly from the VMConnection and VMProcess tables in Azure, you 
must enable the VM insights  feature for all the VMs in your Log Analytics workspace. To learn 
how to populate these tables via insights, see Enable VM insights in the Azure portal  on the 
Microsoft Azure  documentation site.

There are several methods available for enabling VM insights. For more information, see Enable 
VM insights overview  on the Microsoft Azure  documentation site.

Note: 
In the data collection rule,  ensure that you’ve selected the Enable guest performance  and 
Enable processes and dependencies (Maps)  check boxes on the rule form.

Service Graph Connector for Microsoft Azure  reference

Reference topics provide additional information about Service Graph Connector for Microsoft 
Azure  components.

Supported Microsoft Azure  resource types

Several Microsoft Azure  resource types are imported as CMDB  data.

Microsoft Azure  resource types refer to the names included in delta queries used for filtering 
data using the Azure Resource Graph  API for a specific data source.

Note: 
Delta pulls include data from a specific time period that is defined by the condition within a 
delta query.

The following table lists the Service Graph Connector for Microsoft Azure  data sources, Microsoft 
Azure  resource types they import, and indicates whether they support both full pull and delta pull 
of data during import. ✓  indicates supported and   indicates not supported.
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Resource types supported in Service Graph Connector for Microsoft Azure

Data source CMDB  CI classes Microsoft Azure  resource type
Full 
pull

Delta 
pull

Cloud Service Account 
[cmdb_ci_cloud_service_account]

Microsoft.Resources/
subscriptions

   SG-Azure 
Subscriptions

Key Value [cmdb_key_value] Tags    

SG-Azure 
Datacenter 
Updation

Azure Datacenter 
[cmdb_ci_azure_datacenter]

None    

Resource Group 
[cmdb_ci_resource_group]

Microsoft.Resources/
subscriptions/
resourcegroups

   SG-Azure 
Resource Group

Key Value [cmdb_key_value] Tags    

Availability Zone 
[cmdb_ci_availability_zone]

Microsoft.Compute/
availabilitySets

   SG-Azure 
Availability Zone

Key Value [cmdb_key_value] Tags    

Storage Volume 
[cmdb_ci_storage_volume]

Microsoft.Compute/disks    SG-Azure Storage 
Volume

Key Value [cmdb_key_value] Tags    

Cloud Load Balancer 
[cmdb_ci_cloud_load_balancer]

Microsoft.Network/
loadBalancers

   

Cloud LB IPAddress 
[cmdb_ci_cloud_lb_ipaddress]

Microsoft.Network/
loadBalancers

   

SG-Azure Load 
Balancers

Key Value [cmdb_key_value] Tags    

Cloud Network [cmdb_ci_network] Microsoft.Network/
virtualnetworks

   

Cloud Service Account 
[cmdb_ci_cloud_service_account]

Microsoft.Network/
virtualnetworks

   

Cloud Subnet [cmdb_ci_cloud_subnet] Microsoft.Network/
virtualnetworks

   

SG-Azure Network

Key Value [cmdb_key_value] Tags    

Cloud Mgmt Network Interface 
[cmdb_ci_nic]

Microsoft.Network/
networkInterfaces

   

IP Address [cmdb_ci_ip_address] Microsoft.Network/
networkInterfaces

   

Hardware [cmdb_ci_hardware] Microsoft.Network/
networkInterfaces

   

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Microsoft.Network/
networkInterfaces

   

SG-Azure Network 
Interface

Key Value [cmdb_key_value] Tags    

SG-Azure Public 
IP Address

Cloud Public IP Address 
[cmdb_ci_cloud_public_ipaddress]

Microsoft.Network/
publicIPAddresses
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Resource types supported in Service Graph Connector for Microsoft Azure  (continued)

Data source CMDB  CI classes Microsoft Azure  resource type
Full 
pull

Delta 
pull

Cloud Mgmt Network Interface 
[cmdb_ci_nic]

Microsoft.Network/
publicIPAddresses

   

Cloud Load Balancer 
[cmdb_ci_cloud_load_balancer]

Microsoft.Network/
publicIPAddresses

   

Cloud LB IPAddress 
[cmdb_ci_cloud_lb_ipaddress]

Microsoft.Network/
publicIPAddresses

   

Key Value [cmdb_key_value] Tags    

Compute Security Group 
[cmdb_ci_compute_security_group]

Microsoft.Network/
networkSecurityGroups

   SG-Azure Security 
Group

Key Value [cmdb_key_value] Tags    

Cloud Storage Account 
[cmdb_ci_cloud_storage_account]

Microsoft.Storage/
storageAccounts

   SG-Azure Storage 
Accounts

Key Value [cmdb_key_value] Tags    

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Microsoft.Compute/
virtualMachines

   

Image [cmdb_ci_os_template] Microsoft.Compute/
virtualMachines

   

Linux Server [cmdb_ci_linux_server] Microsoft.Compute/
virtualMachines

   

Server [cmdb_ci_server] Microsoft.Compute/
virtualMachines

   

Windows Server [cmdb_ci_win_server] Microsoft.Compute/
virtualMachines

   

SG-Azure Virtual 
Machines

Key Value [cmdb_key_value] Tags    

When the Software Asset Management 
(SAM) application isn't installed:

Software [cmdb_ci_spkg]

Software Installation 
[cmdb_sam_sw_install]

None    SG-Azure 
Software

When the SAM application is installed:

Software Instance 
[cmdb_software_instance]

None    

Cloud DataBase 
[cmdb_ci_cloud_database]

Microsoft.Sql/servers

Microsoft.DBforPostgreSQL/
servers

   SG-Azure SQL

Key Value [cmdb_key_value] Tags    
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Resource types supported in Service Graph Connector for Microsoft Azure  (continued)

Data source CMDB  CI classes Microsoft Azure  resource type
Full 
pull

Delta 
pull

TCP Connection [cmdb_tcp] None    SG-Azure TCP

Running Process 
[cmdb_running_process]

None    

SG-Azure 
Functions

Cloud Function 
[cmdb_ci_cloud_function]

Microsoft.Web/sites    

Cloud Resource 
[cmdb_ci_cmp_resource]

Microsoft.ResourceGraph/
resources - Generic

   SG-Azure Generic 
Resources

Key Value [cmdb_key_value] Tags    

SG-Azure Scale 
Sets

Instance Scale Set 
[cmdb_ci_instance_scale_set]

Microsoft.Compute/
virtualmachinescalesets

   

Virtual Machine Instance 
[cmdb_ci_vm_instance]

None    

Storage Volume 
[cmdb_ci_storage_volume]

None    

Image [cmdb_ci_os_template] None    

Cloud Mgmt Network Interface 
[cmdb_ci_nic]

None    

Hardware Type 
[cmdb_ci_compute_template]

None    

Azure Datacenter 
[cmdb_ci_azure_datacenter]

None    

Linux Server [cmdb_ci_linux_server] None    

Server [cmdb_ci_server] None    

Windows Server [cmdb_ci_win_server] None    

SG-Azure Scale 
Sets VMs

Note: 
Imports 
uniform 
orchestration 
scale sets 
VMs.

Key Value [cmdb_key_value] Tags    

When the SAM application isn't 
installed:

Software [cmdb_ci_spkg]

Software Installation 
[cmdb_sam_sw_install]

None    SG-Azure 
Software Remove

When the SAM application is installed:

Software Instance 
[cmdb_software_instance]

None    

SG-Azure 
Hardware 

Hardware Type 
[cmdb_ci_compute_template]

None    
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Resource types supported in Service Graph Connector for Microsoft Azure  (continued)

Data source CMDB  CI classes Microsoft Azure  resource type
Full 
pull

Delta 
pull

Template 
Updation​

Virtual Machine Instance 
[cmdb_ci_vm_instance]

None    SG-Azure HW 
Consolidation​

Computer [cmdb_ci_computer] None    

SG-Azure Run 
Command

None None    

Application [cmdb_ci_appl] None    

TCP Connection [cmdb_tcp] None    

SG-Azure Get Run 
Command

Running Process 
[cmdb_running_process]

None    

SG-Azure 
Kubernetes 
Cluster

SG-Azure Kubernetes Cluster 
[sn_sg_azure_integ_kubernetes_cluster]

microsoft.containerservice/
managedclusters

   

Life cycle management of records in Service Graph Connector for Microsoft Azure

Life cycle management in the Service Graph Connector for Microsoft Azure  monitors and 
updates the statuses of Azure  resources throughout their entire life cycle, from creation to 
deletion.

The life cycle management process helps maintain the accuracy and integrity of data in the 
Configuration Management Database (CMDB).

Life cycle management for CIs in Service Graph Connector for Microsoft Azure

The following table lists the configuration items (CIs) in CMDB  and other non-CMDB  tables for 
which life cycle management is available in Service Graph Connector for Microsoft Azure.

Supported tables for life cycle management

Data source CMDB  CI classes
Life cycle 
management 
available

Availability Zone [cmdb_ci_availability_zone] YesSG-Azure Availability 
Zone

Key Value [cmdb_key_value] No

SG-Azure Datacenter 
Updation

Azure Datacenter [cmdb_ci_azure_datacenter] Not applicable

SG-Azure Functions Cloud Function [cmdb_ci_cloud_function] Yes

Cloud Resource [cmdb_ci_cmp_resource] YesSG-Azure Generic 
Resources

Key Value [cmdb_key_value] No

Application [cmdb_ci_appl] Not applicableSG-Azure Get Run 
Command

TCP Connection [cmdb_tcp] Not applicable
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Supported tables for life cycle management  (continued)

Data source CMDB  CI classes
Life cycle 
management 
available

Running Process [cmdb_running_process] Not applicable

SG-Azure Hardware 
Template Updation​

Hardware Type [cmdb_ci_compute_template] Not applicable

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Not applicableSG-Azure HW 
Consolidation​

Computer [cmdb_ci_computer] Not applicable

SG-Azure Kubernetes 
Cluster

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Yes

Cloud Load Balancer 
[cmdb_ci_cloud_load_balancer]

Yes

Cloud LB IPAddress 
[cmdb_ci_cloud_lb_ipaddress]

Yes

SG-Azure Load 
Balancers

Key Value [cmdb_key_value] No

Cloud Network [cmdb_ci_network] Yes

Cloud Subnet [cmdb_ci_cloud_subnet] Yes

Cloud Service Account 
[cmdb_ci_cloud_service_account]

No

SG-Azure Network

Key Value [cmdb_key_value] No

Cloud Mgmt Network Interface [cmdb_ci_nic] Yes

IP Address [cmdb_ci_ip_address] No

Hardware [cmdb_ci_hardware] Not applicable

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Not applicable

SG-Azure Network 
Interface

Key Value [cmdb_key_value] No

Cloud Public IP Address 
[cmdb_ci_cloud_public_ipaddress]

Yes

Cloud Mgmt Network Interface [cmdb_ci_nic] Yes

Cloud Load Balancer 
[cmdb_ci_cloud_load_balancer]

Yes

Cloud LB IPAddress 
[cmdb_ci_cloud_lb_ipaddress]

Yes

SG-Azure Public IP 
Address

Key Value [cmdb_key_value] No

Resource Group [cmdb_ci_resource_group] YesSG-Azure Resource 
Group

Key Value [cmdb_key_value] No

SG-Azure Scale Sets Instance Scale Set 
[cmdb_ci_instance_scale_set]

Yes
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Supported tables for life cycle management  (continued)

Data source CMDB  CI classes
Life cycle 
management 
available

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Yes

Storage Volume [cmdb_ci_storage_volume] Yes

Image [cmdb_ci_os_template] Not applicable

Cloud Mgmt Network Interface [cmdb_ci_nic] Yes

Hardware Type [cmdb_ci_compute_template] Not applicable

Linux Server [cmdb_ci_linux_server] Yes

Server [cmdb_ci_server] Yes

Windows Server [cmdb_ci_win_server] Yes

SG-Azure Scale Sets 
VMs

Key Value [cmdb_key_value] No

Compute Security Group 
[cmdb_ci_compute_security_group]

YesSG-Azure Security Group

Key Value [cmdb_key_value] No

SG-Azure Software
When the Software Asset Management (SAM) 
application isn't installed:

Software [cmdb_ci_spkg]

Software Instance [cmdb_software_instance]

When the SAM application is installed:

Software Installation [cmdb_sam_sw_install]

Yes

SG-Azure Software 
Remove When the SAM application isn't installed:

Software [cmdb_ci_spkg]

Software Instance [cmdb_software_instance]

When the SAM application is installed:

Software Installation [cmdb_sam_sw_install]

Yes

Cloud DataBase [cmdb_ci_cloud_database] YesSG-Azure SQL

Key Value [cmdb_key_value] No

Cloud Storage Account 
[cmdb_ci_cloud_storage_account]

YesSG-Azure Storage 
Accounts

Key Value [cmdb_key_value] No

Storage Volume [cmdb_ci_storage_volume] YesSG-Azure Storage 
Volume

Key Value [cmdb_key_value] No
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Supported tables for life cycle management  (continued)

Data source CMDB  CI classes
Life cycle 
management 
available

Cloud Service Account 
[cmdb_ci_cloud_service_account]

NoSG-Azure Subscriptions

Key Value [cmdb_key_value] No

TCP Connection [cmdb_tcp] NoSG-Azure TCP

Running Process [cmdb_running_process] No

Linux Server [cmdb_ci_linux_server] Yes

Server [cmdb_ci_server] Yes

Windows Server [cmdb_ci_win_server] Yes

Image [cmdb_ci_os_template] Yes

Key Value [cmdb_key_value] No

SG-Azure Virtual 
Machines

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Yes

Service Graph Connector for Microsoft Azure  properties

Service Graph Connector for Microsoft Azure  properties control the behavior of the connector.

System properties

These system properties are available for Service Graph Connector for Microsoft Azure.

Note: 
To open the System Properties [sys_properties] table, enter sys_properties.list  in 
the navigation filter.

System properties for Service Graph Connector for Microsoft Azure

Property Description

api_retry_max
Enter the maximum retry limit for a Microsoft Azure 
API call made from the data sources within the 
connector.

• Type: integer

• Default value: 3

• Location: System Property [sys_properties] table

api_retry_max_without_backoff
Enter the maximum retry limit for a Microsoft Azure 
API call made from the data sources within the 
connector, without using exponential backoff to 
increase the waiting time between consecutive 
retries.
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System properties for Service Graph Connector for Microsoft Azure  (continued)

Property Description

• Type: integer

• Default value: 3

• Location: System Property [sys_properties] table

azure_full_pull_partition_size
Set the partition size for Azure  full data pull. This 
property determines the number of subscriptions 
that each partition processes. The value must be 
set to a numeric value greater than 0.

• Type: integer

• Default value: null

• Location: System Property [sys_properties] table

Note: 
If no value is specified, the property value is 
determined based on the number of active 
threads in the instance.

See Set partition size for Azure accounts with 
parallel loading enabled.

delta_grace_time
Enter the additional time period in hours added 
to the current delta pull period when fetching 
incremental changes.

• Type: integer

• Default value: 0

• Location: System Property [sys_properties] table

delta_page_size
Enter the page size that is the maximum number of 
records fetched per page in a delta pull for the data 
sources within the connector.

• Type: integer

• Default value: 500

• Location: System Property [sys_properties] table

is_delta_sync_enabled
Set the property to false  to deactivate  delta 
synchronization.

• Type: true | false

• Default value: false

• Location: System Property [sys_properties] table

See Configuring data synchronization in Service 
Graph Connector for Microsoft Azure.
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System properties for Service Graph Connector for Microsoft Azure  (continued)

Property Description

LDC_status
Set the property to true  to enable populating 
the passive status of an Azure datacenter 
(also known as a logical datacenter) in the 
Comments attribute of the Azure Datacenter 
[cmdb_ci_azure_datacenter] CI class when the 
regionType  attribute is Logical  or the service 
account for the datacenter is deactivated .

• Type: true | false

• Default value: false

• Location: System Property [sys_properties] table

load_balancer_page_limit
Enter the maximum number of records per page 
to be fetched in a delta pull for the SG-Azure Load 
Balancers data source.

• Type: integer

• Default value: 500

• Location: System Property [sys_properties] table

maximum_delta_total_period
Enter the maximum time period in days preceding 
the current run time during delta pull.

• Type: integer

• Default value: 7

• Location: System Property [sys_properties] table

maximum_delta_window_period
Enter the maximum time duration in hours for 
each API call to repeat within the total delta period 
during delta pull.

• Type: integer

• Default value: 24

• Location: System Property [sys_properties] table

network_interface_page_limit
Enter the maximum number of records per page to 
be fetched in a delta pull for the SG-Azure Network 
Interface data source.

• Type: integer

• Default value: 500

• Location: System Property [sys_properties] table

pull_disabled_subscriptions
Set the property to false  to deactivate  the import 
of resources associated with deactivated  Azure 
subscriptions.
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System properties for Service Graph Connector for Microsoft Azure  (continued)

Property Description

• Type: true | false

• Default value: true

• Location: System Property [sys_properties] table

security_group_page_limit
Enter the maximum number of records per page to 
be fetched in a delta pull for the SG-Azure Security 
Group data source.

• Type: integer

• Default value: 500

• Location: System Property [sys_properties] table

sn_sg_azure_integ.insert_short_lived_vms
Set the property to false  to deactivate  the 
creation of a virtual machine (VM) in the CMDB 
if the VM was created and terminated during the 
delta load period.

• Type: true | false

• Default value: true

• Location: System Property [sys_properties] table

software_page_limit
Enter the maximum number of records fetched per 
page when importing software data through the 
SG-Azure Software data source.

• Type: integer

• Default value: 5000

• Location: System Property [sys_properties] table

tcp_and_process_page_limit
Enter the maximum number of records fetched per 
page when importing TCP and running process 
data through the SG-Azure TCP data source.

• Type: integer

• Default value: 1000

• Location: System Property [sys_properties] table

tcp_time_period
Enter the time period in hours during which TCP 
and running process data is imported through the 
SG-Azure TCP data source.

• Type: integer

• Default value: 1

• Location: System Property [sys_properties] table
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System properties for Service Graph Connector for Microsoft Azure  (continued)

Property Description

vm_power_state_page_limit
Enter the maximum number of records fetched 
per page when importing the power state of VMs 
through the SG-Azure VM Config Data data source.

• Type: integer

• Default value: 1000

• Location: System Property [sys_properties] table

network_page_limit
Custom property for the SG-Azure Network data 
source. Create this system property if you need to 
decrease the number of records that are fetched in 
a delta pull.

For more information, see Add a system property .

Specify the maximum number of records per 
page to be fetched in a delta pull for the SG-Azure 
Network data source.

• Type: integer

• Default value: 500

• Location: System Property [sys_properties] table

Service Graph Connector for Microsoft Defender Endpoint

Use the Service Graph Connector for Microsoft Defender Endpoint  to pull data from machines 
protected by the Microsoft Defender for Endpoint  security solution into your ServiceNow 
instance.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Supported versions

• Supported Microsoft Defender for Endpoint  versions:

◦ Microsoft Defender for Endpoint  Plan 1

◦ Microsoft Defender for Endpoint  Plan 2

• Supported ServiceNow  versions:

◦ Washington DC

◦ Xanadu

◦ Yokohama
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Use cases

The ServiceNow  Security Operations  applications have features that interact with the Service 
Graph Connector  to gain insights into machines utilizing the Microsoft Defender for Endpoint 
security solution.

Important Information for upgrading Service Graph Connector for Microsoft 
Defender Endpoint

After you upgrade to Service Graph Connector for Microsoft Defender Endpoint  1.2.0, migrate 
data from the Server [cmdb_ci_server] CI class to the Computer [cmdb_ci_computer] CI class. 
For more information, see the Service Graph Connector for Microsoft Defender Endpoint - Data 
migration after upgrade to version 1.2.0 [KB2096769]  article in the Now Support  Knowledge 
Base.

Configuring a connection for the connector

You can configure a connection for the connector by using the SGC Central  view in the CMDB 
Workspace. The view enables you to discover and install connectors, and then effectively 
manage the full life cycle of creating, editing, monitoring, and debugging connections. To 
configure the connector using SGC Central, see Configure Service Graph Connector for 
Microsoft Defender Endpoint using SGC Central.

Important: 
Unless there are configuration issues, use the SGC Central  view in the CMDB Workspace 
to configure the connection for the connector, as the guided setup method is being 
deprecated.

CMDB integrations dashboard

The Integration Commons for CMDB  store app provides a dashboard with a central view of the 
status, processing results, and processing errors of all installed integrations. You can see metrics 
for all integration runs. You can filter the view to a specific CMDB  integration, a specific time 
duration, or a specific integration run. For more details about monitoring Microsoft Defender for 
Endpoint  integrations in the CMDB  Integrations Dashboard, see Using the CMDB Integrations 
Dashboard.

Data mapping

Data from the Microsoft Defender for Endpoint  data source is mapped and transformed into the 
ServiceNow  CMDB  configuration item (CI) class definitions using the Robust Transform Engine 
(RTE). Data is inserted into the ServiceNow  CMDB  using the Identification and Reconciliation 
Engine (IRE).

When you complete setting up the connection, you can configure the integration to pull data 
periodically from the machines utilizing the Microsoft Defender for Endpoint  security solution.

The following data source is included for the Microsoft Defender for Endpoint  security solution:

SG-Defender Machines

Imports all the machine-related data from the machines utilizing the Microsoft 
Defender for Endpoint  security solution, loads the imported data in the SG-
Defender Machines [sn_defender_integ_sg_defender_machines] staging table, and 
then populates the following target tables:
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• IP Address [cmdb_ci_ip_address]

• Software Installation [cmdb_sam_sw_install] (If the Software Asset Management 
(SAM) application is installed.)

• Software Instance [cmdb_software_instance] (If the SAM application is not 
installed.)

• Software [cmdb_ci_spkg] (If the SAM application is not installed.)

• SG-Defender Machines Related 
[sn_defender_integ_sg_defender_machines_related]

• Network Adapter [cmdb_ci_network_adapter]

• Computer [cmdb_ci_computer]

• Windows Server [cmdb_ci_win_server]

Note: 
Only operating system details are populated in the Software Installation 
[cmdb_sam_sw_install], Software Instance [cmdb_software_instance], and Software 
[cmdb_ci_spkg] tables.

For more information on where data is saved when pulling data from the Microsoft Defender for 
Endpoint  security solution, see CMDB classes targeted in Service Graph Connector for Microsoft 
Defender Endpoint.

You can use the IntegrationHub ETL app to view the data maps. See IntegrationHub ETL  for more 
information.

Related topics

Service Graph Connectors

Configure Service Graph Connector for Microsoft Defender Endpoint  using SGC Central

Set up scheduled import jobs to pull in Microsoft Defender for Endpoint  data into your 
Configuration Management Database (CMDB).

Before you begin
Complete the following tasks:

• Install Service Graph Connector for Microsoft Defender Endpoint  version 1.1.0 or later from 
the ServiceNow Store. For ServiceNow Store  installation steps, see Install a ServiceNow Store 
application .

• Verify that you have an active subscription to Microsoft Defender for Endpoint.

• Verify that you have created an Azure  application to get programmatic access to Microsoft 
Defender for Endpoint. See Create an app to access Microsoft Defender for Endpoint without a 
user  in the Microsoft 365  documentation.

• Obtain the tenant ID, client ID, and client secret details for the Microsoft Defender for Endpoint 
administrator account.

• Enable the Machine.Read.All and Machine.ReadWrite.All permissions in Microsoft Defender 
for Endpoint. See Permissions  for the List machines  API in the Microsoft 365 
documentation.

Role required: cmdb_inst_admin or admin
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About this task
The playbook experience for onboarding connectors is activated with SGC Central  in the CMDB 
Workspace. To configure the SGC Central  application, see Configuring SGC Central  and for more 
information on how to interact with a playbook, see Interact with Playbook .

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the CMDB Workspace, select SGC Central.

3. On the Overview page, select Create connection.

Tip: 
Alternatively, you can select Create connection  on the All connections page.

4. On the Create connection window, select the Microsoft Defender  connector type, and then 
select Configure connection.
A default connection, SG Defender OAuth2.0 connection, for Microsoft Defender for Endpoint 
is available within the application. As the Service Graph Connector for Microsoft Defender 
Endpoint  supports only a single instance, you can configure the default connection for the first 
time or resume editing it thereafter.

5. Complete the initial prerequisites when setting up a connection for the first time using a 
connector.

Note: 
This step is required only during the first-time setup. See Perform initial setup tasks when 
creating a connection in SGC Central.

6. Enter connection details and test the API connection for importing Microsoft Defender for 
Endpoint  data.

a. In the Setup  stage of the playbook, select the Configure and test connection  activity.

b. On the form, fill in the fields.

Configure and test connection form

Field Description

Connection Name Name to identify the Microsoft Defender for 
Endpoint  connection record.

Note: 
This field is automatically set to 
SG Defender OAuth2.0 
connection. Leave the field value as 
is.

OAuth Client ID Application (client) ID of your Microsoft 
Defender for Endpoint  as described in the 
Before you begin  section.

OAuth Client Secret Client Secret of your Microsoft Defender 
for Endpoint  as described in the Before you 
begin  section.
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Field Description

OAuth token URL Token URL of your Microsoft Defender for 
Endpoint.

Enter the token URL in the following format:

https://login.microsoftonline
.com/<tenantid>/oauth2/v2.0/t
oken

Where <tenantid>  is the tenant ID of 
your Microsoft Defender for Endpoint  as 
described in the Before you begin  section.

Use MID Server Option to use a MID Server.

Note: 
Use of a MID Server is optional.

Mid Selection Name of the MID Server used by the 
connector.

This field appears only when the Use MID 
Server  check box is selected.

c. Select Update and test connection.

d. Once the connection test is complete, select Continue.

7. Configure the import schedule to import data at regular intervals.

a. In the Setup  stage of the playbook, select the Configure import schedule  activity.

b. Select Configure import schedule.

c. Expand the Parent scheduled data import within the Import schedules list to select the SG-
Defender Machines  import schedule.

d. In the Configure import schedule  dialog box, select the Active  check box, and then fill in the 
run schedule and time details.

For more information, see Schedule a data import .

e. Select Save.
Alternatively, select Execute Now  to execute the import schedule immediately.

f. Select Continue.

8. In the Setup  stage of the playbook, select the Confirm connection setup  activity to verify 
whether the connection was configured.

What to do next
Select View all connections  to review the connection details. The configured connection 
appears in the Installed connections list.
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Related topics

Service Graph Connector for Microsoft Defender Endpoint

CMDB classes targeted in Service Graph Connector for Microsoft Defender Endpoint

Accessing the connection details of Service Graph Connector for Microsoft Defender Endpoint

Configure Service Graph Connector for Microsoft Defender Endpoint  using the guided setup

Pull in data from machines utilizing the Microsoft Defender for Endpoint  security solution into 
your Configuration Management Database (CMDB).

Before you begin
Important: 
Unless there are configuration issues, use the SGC Central  view in the CMDB Workspace 
to configure the connection for the connector, as the guided setup method is being 
deprecated.

To use this Service Graph Connector, you need a subscription to a Subscription Unit that is 
based in the IT Operations Management  (ITOM) Visibility application or in the ITOM  Discovery 
application. As defined in the section titled "Managed IT Resource Types" in ServiceNow 
Subscription Unit Overview  for your subscription, for managed IT resources that are created 
or modified in the CMDB  by this Service Graph Connector, but that aren’t yet managed by ITOM 
Visibility or ITOM Discovery , these resources will increase Subscription Unit consumption from 
that application. Review your current Subscription Unit consumption within ITOM Visibility or 
ITOM Discovery to ensure available capacity.

Dependencies and requirements:

• The Integration Commons for CMDB  store app, which is automatically installed.

• The CMDB CI class models store app, which is automatically installed. See CMDB CI Class 
Models store app.

• The ITOM Discovery License plugin (com.snc.itom.discovery.license). You must activate this 
plugin.

• ITOM Licensing plugin (com.snc.itom.license). For more information, see Request Discovery .

• The Datastream Action plugin (com.glide.hub.action_type.datastream), which is automatically 
installed.

• Observability Commons for CMDB  (sn_observability), which is only required for event 
ingestion. For Event Management to work, the Observability Commons for CMDB 
(sn_observability) app must be installed prior to installing the connector. For more information, 
see Observability Commons for CMDB  on the ServiceNow Store.

Complete the following tasks:

• Install the Service Graph Connector for Microsoft Defender Endpoint  application 
(sn_defender_integ). For more information, see Install a ServiceNow Store application .

• Ensure that you have an active subscription to Microsoft Defender for Endpoint.

• Ensure that you have created an Azure  application to get programmatic access to Microsoft 
Defender for Endpoint. See Create an app to access Microsoft Defender for Endpoint without a 
user  in the Microsoft 365  documentation.

• Obtain the tenant ID, client ID, and client secret details for the Microsoft Defender for Endpoint 
administrator account.

• Enable the Machine.Read.All and Machine.ReadWrite.All permissions in Microsoft Defender 
for Endpoint. See Permissions  for the List machines  API in the Microsoft 365 
documentation.
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Role required: admin

Procedure

1. Ensure that the application scope is set to the Service Graph Connector for Microsoft 
Defender Endpoint  application by using the application picker.
For more information, see Application picker .

2. Navigate to All  > Service Graph Connectors  > Microsoft Defender  > Setup.

3. On the Getting started page, select Get Started.

4. Configure the authentication credentials details for sending requests to the List machines 
API in Microsoft Defender for Endpoint.

a. Configure your Microsoft Defender for Endpoint  authentication credentials.

i. In the Configure the connection  section of the Service Graph Connector for Microsoft 
Defender  page, select Get Started.

ii. For the Configure the credentials  task, select Configure.

iii. On the form, review and modify the fields.

Application Registries form

Field Description

Connection Name Name to identify the connection record.

Note: 
This field is automatically set to the 
SG Defender OAuth  connection 
record. Leave the field value as is.

Client ID Application (client) ID of your Microsoft 
Defender for Endpoint  as described in the 
Before you begin  section.

Client Secret Client Secret of your Microsoft Defender 
for Endpoint  as described in the Before you 
begin  section.

OAuth Token URL Token URL of your Microsoft Defender for 
Endpoint.

Enter the token URL in the following format:

https://login.microsoftonlin
e.com/<tenantid>/oauth2/v2
.0/token

Where <tenantid>  is the tenant ID of 
your Microsoft Defender for Endpoint  as 
described in the Before you begin  section.

iv. Select Update  to return to the guided setup page.

v. Set the Configure the credentials  task to complete by selecting Mark as Complete.

b. Test the List machines  API connection to import machine-related data from Microsoft 
Defender for Endpoint.
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i. For the Test the connection  task, select Configure.

ii. On the Service Graph Connections page, select Test Connection.

iii. When the Status  field is set to Success, select Update  to close the Test the connection 
dialog box and return to the guided setup page.

If any of the tests have errors, follow the suggestions for remediation.

iv. Set the Test the connection  task to complete by selecting Mark as Complete.

5. Configure the scheduled jobs to import machine-related data from Microsoft Defender for 
Endpoint.

a. In the Set up scheduled import jobs  section of the Service Graph Connector for Microsoft 
Defender  page, select Get Started.

b. For the Configure scheduled jobs  task, select Configure.

c. From the Name  column, select the scheduled job that you want to activate.
By default, the SG-Defender Machines scheduled job is available to run the SG-Defender 
Machines data source.

d. On the Scheduled Data Import form, verify the field values for the scheduled job.
For more information, see Schedule a data import .

e. Select Update.

f. Select the back button of your browser to return to the guided setup page.

g. Set the Configure the scheduled jobs  task to complete by selecting Mark as Complete  in 
the guided setup.

Related topics

Accessing the connection details of Service Graph Connector for Microsoft Defender Endpoint

CMDB  classes targeted in Service Graph Connector for Microsoft Defender Endpoint

When you complete setting up the connection, you can configure the integration to pull data 
periodically from machines utilizing the Microsoft Defender for Endpoint  security solution. The 
data is saved in tables that extend from the Configuration item [cmdb_ci] table.

Computer [cmdb_ci_computer]

The following attributes in the Computer [cmdb_ci_computer] table are populated by collected 
data:

Attribute label Attribute name

Class sys_class_name

Discovery source discovery_source

Install Status install_status

Name name
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Attribute label Attribute name

Operating System os

OS Version os_version

Relationships created for Computer

Parent class Relationship type Child class

Computer 
[cmdb_ci_computer]

Owns::Owned by IP Address 
[cmdb_ci_ip_address]

Computer 
[cmdb_ci_computer]

Owns::Owned by Network Adapter 
[cmdb_ci_network_adapter]

Computer 
[cmdb_ci_computer]

Reference SG-Defender 
Machines Related 
[sn_defender_integ_sg_defender_machines_related]

Computer 
[cmdb_ci_computer]

Reference Software Installation 
[cmdb_sam_sw_install]

IP Address [cmdb_ci_ip_address]

The following attributes in the IP Address [cmdb_ci_ip_address] table are populated by collected 
data:

Attribute label Attribute name

Install Status install_status

IP Address ip_address

IP version ip_version

Name name

Nic nic

Relationship created for IP Address

Parent class Relationship type Child class

IP Address 
[cmdb_ci_ip_address]

Reference Network Adapter 
[cmdb_ci_network_adapter]

SG-Defender Machines Related 
[sn_defender_integ_sg_defender_machines_related]

The following attributes in the SG-Defender Machines Related 
[sn_defender_integ_sg_defender_machines_related] table are populated by collected data:

Attribute label Attribute name

Agent Version agent_version

Device Id device_id
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Attribute label Attribute name

Exposure Level exposure_level

First Seen first_seen_date

Health Status health_status

IsAadJoined isaadjoined

Last Reported last_reported

Managed by managed_by

Onboarding Status onboarding_status

Network Adapter [cmdb_ci_network_adapter]

The following attributes in the Network Adapter [cmdb_ci_network_adapter] table are populated 
by collected data:

Attribute label Attribute name

Discovery source discovery_source

Install Status install_status

MAC Address mac_address

Name name

Relationships created for Network Adapter

Parent class Relationship type Child class

Network Adapter 
[cmdb_ci_network_adapter]

Reference Server [cmdb_ci_server]

Network Adapter 
[cmdb_ci_network_adapter]

Reference Computer 
[cmdb_ci_computer]

Software [cmdb_ci_spkg]

The following attributes in the Software [cmdb_ci_spkg] table are populated by collected data 
when the Software Asset Management  (SAM) application isn't installed:

Attribute label Attribute name

Key key

Name name

Version version

Relationship created for Software

Parent class Relationship type Child class

Software [cmdb_ci_spkg] Reference Software Instance 
[cmdb_software_instance]
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Software Installation [cmdb_sam_sw_install]

The following attributes in the Software Installation [cmdb_sam_sw_install] table are populated 
by collected data when the SAM application is installed:

Attribute label Attribute name

Discovery source discovery_source

Display name display_name

Version version

Software Instance [cmdb_software_instance]

The following attributes in the Software Instance [cmdb_software_instance] table are populated 
by collected data when the SAM application isn't installed:

Attribute label Attribute name

Installed on installed_on

Name name

Relationship created for Software Instance

Parent class Relationship type Child class

Software Instance 
[cmdb_software_instance]

Reference Server [cmdb_ci_server]

Windows Server [cmdb_ci_win_server]

The following attributes in the Windows Server [cmdb_ci_win_server] table are populated by 
collected data when the SAM application isn't installed:

Attribute label Attribute name

Class sys_class_name

Discovery source discovery_source

Install Status install_status

Name name

Operating System os

OS Version os_version

Relationships created for Windows Server

Parent class Relationship type Child class

Windows Server 
[cmdb_ci_win_server]

Owns::Owned by Network Adapter 
[cmdb_ci_network_adapter]
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Relationships created for Windows Server  (continued)

Parent class Relationship type Child class

Windows Server 
[cmdb_ci_win_server]

Owns::Owned by IP Address 
[cmdb_ci_ip_address]

Windows Server 
[cmdb_ci_win_server]

Reference SG-Defender 
Machines Related 
[sn_defender_integ_sg_defender_machines_related]

Windows Server 
[cmdb_ci_win_server]

Reference Software Installation 
[cmdb_sam_sw_install]

Service Graph Connector for Microsoft Defender Endpoint  properties

Service Graph Connector for Microsoft Defender Endpoint  properties control the behavior of the 
connector.

System properties

These system properties are available for Service Graph Connector for Microsoft Defender 
Endpoint.

Note: 
To open the System Properties [sys_properties] table, enter sys_properties.list  in 
the navigation filter.

System properties for Service Graph Connector for Microsoft Defender Endpoint

Property Description

sn_defender_integ.pagination_record_count
Enter the maximum number of rows fetched in 
the List machines  API response from the 
machine resource type.

• Type: integer

• Default value: 500

• Location: System Property [sys_properties] 
table

Accessing the connection details of Service Graph Connector for Microsoft Defender 
Endpoint

You can access the connection details of the Service Graph Connector for Microsoft Defender 
Endpoint  in a single view using the common connection framework (CCF) included within the 
Integration Commons for CMDB  (sn_cmdb_int_util) store app.

With the CCF, you can access all the connections used by the Service Graph Connector for 
Microsoft Defender Endpoint. The connection details include the connection alias, data sources, 
and scheduled data imports associated with a connection. You can also test the connection.

Access the details of a Microsoft Defender for Endpoint  connection

Access the details of a Microsoft Defender for Endpoint  connection configured for the Service 
Graph Connector for Microsoft Defender Endpoint.
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Before you begin
Role required: admin

Procedure

1. Navigate to All  > Service Graph Connectors  > Microsoft Defender  > Connections.

2. From the Name  column of the Service Graph Connections list, select a connection.

3. On the Service Graph Connections page, view the connection details such as the connection 
name, alias, and data sources.

4. Select a related list to view further details of the connection.

5. Optional:  Select the Test Connection  related link to test the connection.

Related topics

Accessing the connection details of Service Graph Connectors

Life cycle management of records in Service Graph Connector for Microsoft Defender 
Endpoint

Life cycle management in the Service Graph Connector for Microsoft Defender Endpoint 
monitors and updates the statuses of Microsoft Defender for Endpoint  resources throughout 
their entire life cycle, from creation to deletion.

The life cycle management process helps maintain the accuracy and integrity of data in the 
Configuration Management Database (CMDB).

Life cycle management for CIs in Service Graph Connector for Microsoft 
Defender Endpoint

The following table lists the configuration items (CIs) in CMDB  and other non-CMDB  tables for 
which life cycle management is available in the Service Graph Connector for Microsoft Defender 
Endpoint. The Install Status [install_status] attribute of the CIs is updated to installed or retired 
according to the state of the CI.

Supported tables for life cycle management

Data source CIs
Life cycle management 
available

SG-Defender 
Machines

Windows Server [cmdb_ci_win_server] Yes

SG-Defender 
Machines

IP Address [cmdb_ci_ip_address] Yes

SG-Defender 
Machines

Network Adapter 
[cmdb_ci_network_adapter]

Yes

SG-Defender 
Machines

Computer [cmdb_ci_computer] Yes

Service Graph Connector for Microsoft Intune

Use the Service Graph Connector for Microsoft Intune  to pull data from the Microsoft Intune 
application into your ServiceNow  instance.

The Service Graph Connector for Microsoft Intune  pulls data from mobile devices, computers 
and software applications into the ServiceNow®  Configuration Management Database (CMDB) 
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application. The integration provides greater visibility into mobile devices, computers and related 
software applications that run on them.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Supported versions

Versions

Microsoft Intune ServiceNow

• Microsoft Intune  Graph API v1.0

• Microsoft Intune  Graph API Beta

• Washington DC

• Xanadu

• Yokohama

Use cases

The following are examples on how you can use the Service Graph Connector  for different 
ServiceNow®  applications:

• IT Operations Management (ITOM) Visibility

◦ Detailed hardware and application inventory for Android, Apple, and Windows  mobile 
devices. The inventory can be used with or without Software Asset Management  (SAM).

◦ Compliance tracking for mobile devices. You can build your own device (BYOD) or use 
corporate-owned devices.

• IT Service Management (ITSM)

◦ Incidents, problems, and changes on discovered configuration items (CI).

◦ Ownership tracking and assignment for mobile devices.

You can also do the following types of administrative actions:

• Device Management: You can report on various aspects of the device.

• Integration with Azure Monitor: Delta notification.

Configuring a connection for the connector

You can configure a connection for the connector by using the SGC Central  view in the CMDB 
Workspace. The view enables you to discover and install connectors, and then effectively 
manage the full life cycle of creating, editing, monitoring, and debugging connections. To 
configure the connector using SGC Central, see Configure Service Graph Connector for 
Microsoft Intune using SGC Central.

Important: 
Unless there are configuration issues, use the SGC Central  view in the CMDB Workspace 
to configure the connection for the connector, as the guided setup method is being 
deprecated.
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CMDB integration dashboards

The Integration Commons for CMDB  store app provides a dashboard with a central view of 
the status, processing results, and processing errors of all installed integrations. You can see 
metrics for all integration runs. You can filter the view to a specific CMDB  integration, a specific 
time duration, or a specific integration run. For more details about monitoring Microsoft Intune 
integrations in the CMDB  Integrations Dashboard, see Using the CMDB Integrations Dashboard.

Data mapping

Data from data sources in the Microsoft Intune  application is mapped and transformed into the 
ServiceNow  CMDB  Configuration Item (CI) class definitions using the Robust Transform Engine 
(RTE). Data is inserted into the ServiceNow  CMDB  using the Identification and Reconciliation 
Engine (IRE).

The following table describes the data sources, the staging tables, and the target tables as 
CMDB  CI classes, and the resource types imported for a Microsoft Intune  application.

Data mapping for Microsoft Intune

Data 
source

Staging table CMDB  CI classes
Resource 
types

SG-Intune 
Computer

SG-Intune Computer 
[sn_intune_integrat_computer] Computer

SG-Intune Computer Related

IP Address

Serial Number

When the Software Asset 
Management (SAM) 
application isn't installed:

Software

Software Instance

When the SAM application 
is installed: Software 
Installation

Computers

SG-Intune 
Devices

SG-Intune Devices 
[sn_intune_integrat_devices] Handheld Computing Device

Serial Number

Network Adapter

SG-Intune Device Related

IP Address

When the Software Asset 
Management (SAM) 
application isn't installed:

Software

Mobile 
devices
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Data mapping for Microsoft Intune  (continued)

Data 
source

Staging table CMDB  CI classes
Resource 
types

Software Instance

When the SAM application 
is installed: Software 
Installation

SG-Intune 
Software

SG-Intune Software 
[sn_intune_integrat_software] Software

Discovered 
apps

SG-Intune 
Device 
Reports

SG-Intune Device Reports 
[sn_intune_integrat_device_reports] Computer  or Handheld 

Computing Device

Serial Number

Network adapter

SG-Intune Computer Related

SG-Intune Device Related

IP Address

Note: 
Imports Wireless (Wi-
Fi) IPv4 Address of a 
device only.

When the Software Asset 
Management (SAM) 
application isn't installed:

Software

Software Instance

When the SAM application 
is installed: Software 
Installation

Computers 
and mobile 
devices

SG-Intune 
Software 
Reports

SG-Intune Software Reports 
[sn_intune_integrat_software_reports] When the Software Asset 

Management (SAM) 
application isn't installed:

Software

Software Instance

When the SAM application 
is installed: Software 
Installation

Discovered 
apps

When you complete setting up the connection, you can configure the integration to periodically 
pull data from the Microsoft Intune  application.
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Note: 

• Configure the SG-Intune Device Reports data source only when resolving server errors 
and improving slow performance with the SG-Intune Computer and SG-Intune Devices 
data sources.

• Configure the SG-Intune Software Reports data source only when resolving server errors 
and improving slow performance with the SG-Intune Software data source.

• For any discovered software applications that were deleted later in the Microsoft Intune 
application, the Service Graph Connector  automatically deletes the corresponding 
records in CMDB.

• To view more details about a handheld computing device or computer in the Computer 
[cmdb_ci_computer] class, enable the related lists SG-Intune Device Related and SG-
Intune Computer Related.

You can add these related lists by configuring the Related Lists view on the form that 
opens when you select a handheld computing device or computer configuration 
item (CI) in the Computer [cmdb_ci_computer] class. Computer CIs are displayed 
in the Computers list, accessed by navigating to All  > Configuration  > Base Items  > 
Computers. For more information about adding related lists to a form, see Configuring 
the form layout .

For more information on where data is saved when pulling data from a Microsoft Intune 
application, see CMDB classes targeted in Service Graph Connector for Microsoft Intune.

You can use the IntegrationHub ETL app to view the data maps. See IntegrationHub ETL  for more 
information.

Additional resources

Service Graph Connector for Microsoft Intune - Troubleshooting connection issues  on 
ServiceNow Community

Related topics

Service Graph Connectors

Configure Service Graph Connector for Microsoft Intune  using SGC Central

Use the playbook available with the SGC Central  application to set up the Service Graph 
Connector for Microsoft Intune  for pulling in Microsoft Intune  data into the CMDB.

Before you begin
Install Service Graph Connector for Microsoft Intune  version 2.5.0 or later from the ServiceNow 
Store. For ServiceNow Store  installation steps, see Install a ServiceNow Store application . 

Obtain the following information from your Microsoft Intune  administrator:

• Client ID

• Client Secret

• Token URL

For the connector to access the data in Microsoft Intune, the credential information is required to 
use the Microsoft Graph API. Therefore, you must grant the following Graph API permissions from 
the App registrations page in the Microsoft  portal:
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• DeviceManagementManagedDevices.Read.All (Type: Application)

• DeviceManagementApps.Read.All (Type: Application)

• User.Read.All (Type: Application)

Role required: cmdb_inst_admin or admin

About this task
The playbook experience for onboarding connectors is activated with SGC Central  in the CMDB 
Workspace. To configure the SGC Central  application, see Configuring SGC Central  and for more 
information on how to interact with a playbook, see Interact with Playbook .

For more details on permissions, see Service Graph Connector for Microsoft Intune - 
Troubleshooting connection issues  on ServiceNow Community  and Microsoft Graph 
permissions reference  on the Microsoft  documentation site.

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the CMDB Workspace, select SGC Central.

3. On the Overview page, select Create connection.

Tip: 
Alternatively, you can select Create connection  on the All connections page.

4. On the Create connection window, select the Microsoft Intune  connector type and then select 
Create connection.

5. Complete the initial prerequisites when setting up a connection for the first time using a 
connector.

Note: 
This step is required only during the first-time setup. See Perform initial setup tasks when 
creating a connection in SGC Central.

6. Enter connection details and test the API connection for importing Microsoft Intune  data.

a. In the Setup  stage of the playbook, select the Create and test connection  activity.

b. On the form, fill in the fields.

Create and test connection form

Field Description

Connection Name Name to identify the Microsoft Intune 
connection record.

For example, SG-Intune connection.

Connection URL Base URL to connect to your Microsoft 
Intune  application.

Based on the region of your Microsoft 
Intune  application, enter the connection 
URL in one of the following formats:

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1160

https://www.webstg.servicenow.com/docs/access?context=playbook-ui&version=washingtondc&pubname=washingtondc-build-workflows&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=playbook-ui&version=washingtondc&pubname=washingtondc-build-workflows&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=playbook-ui&version=washingtondc&pubname=washingtondc-build-workflows&ft:locale=en-US
https://community.servicenow.com/community?id=community_blog&sys_id=a405ef9bdbbd7018bb4a474d13961903
https://community.servicenow.com/community?id=community_blog&sys_id=a405ef9bdbbd7018bb4a474d13961903
https://community.servicenow.com/community?id=community_blog&sys_id=a405ef9bdbbd7018bb4a474d13961903
https://community.servicenow.com/community?id=community_blog&sys_id=a405ef9bdbbd7018bb4a474d13961903
https://learn.microsoft.com/en-us/graph/permissions-reference
https://learn.microsoft.com/en-us/graph/permissions-reference
https://learn.microsoft.com/en-us/graph/permissions-reference
https://learn.microsoft.com/en-us/graph/permissions-reference


Field Description

▪ Global

https://graph.microsoft.com

▪ US Government

https://graph.microsoft.us

▪ China

https://microsoftgraph.chin
acloudapi.cn

▪ Germany

https://graph.cloudapi.de/

OAuth Client ID Client ID of the Microsoft Intune  application 
as noted in the Before you begin  section.

OAuth Client Secret Client secret of the Microsoft Intune 
application as noted in the Before you begin 
section.

OAuth Token URL Callback URL for the Microsoft Intune 
application.

Based on the region of your Microsoft 
Intune  application, enter the token URL in 
one of the following formats:

▪ Global

https://login.microsoftonli
ne.com/<tenantid>/oauth2/v2
.0/token

▪ US Government

https://login.microsoftonli
ne.us/<tenantid>/oauth2/v2
.0/token

▪ China

https://login.partner.micro
softonline.cn/<tenantid>/oa
uth2/v2.0/token

▪ Germany

https://login.microsoftonli
ne.de/<tenantid>/oauth2/v2
.0/token

Where <tenantid>  is the tenant ID of 
your Microsoft Intune  application.

Use MID server Option to use the MID Server for connecting 
to the Microsoft Intune  instance.
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Field Description

Note: 
A MID Server is required only if 
a direct connection between the 
ServiceNow  and Microsoft Intune 
instances isn’t possible.

Mid Selection MID Server for the connection.

This field appears only when you select the 
Use MID Server  check box.

c. Select Create and test connection.

d. Once the connection test is complete, select Continue.

7. Configure the import schedule to import data at regular intervals.

a. In the Setup  stage of the playbook, select the Configure import schedule  activity.

b. Expand the Parent scheduled data import within the Import schedules list to select the 
Connection Name-SG-Intune Devices  import schedule.

c. Select the Active  check box, and then fill in the run schedule and time details.

For more information, see Schedule a data import .

d. Select Save.
Alternatively, select Execute Now  to execute the import schedule immediately.

e. Select Continue.

8. In the Setup  stage of the playbook, select the Confirm connection setup  activity to verify 
whether the connection was configured.

What to do next
Select View all connections  to review the connection details. The configured connection 
appears in the Installed connections list.

Related topics

Service Graph Connector for Microsoft Intune

CMDB classes targeted in Service Graph Connector for Microsoft Intune

Accessing the connection details of Service Graph Connector for Microsoft Intune

Configure Service Graph Connector for Microsoft Intune  using the guided setup

Set up authentication credentials and a scheduled job to import Microsoft Intune  data into your 
CMDB.
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Before you begin
Important: 
Unless there are configuration issues, use the SGC Central  view in the CMDB Workspace 
to configure the connection for the connector, as the guided setup method is being 
deprecated.

To use this Service Graph Connector, you need a subscription to a Subscription Unit that is 
based in the IT Operations Management  (ITOM) Visibility application or in the ITOM  Discovery 
application. As defined in the section titled "Managed IT Resource Types" in ServiceNow 
Subscription Unit Overview  for your subscription, for managed IT resources that are created 
or modified in the CMDB  by this Service Graph Connector, but that aren’t yet managed by ITOM 
Visibility or ITOM Discovery , these resources will increase Subscription Unit consumption from 
that application. Review your current Subscription Unit consumption within ITOM Visibility or 
ITOM Discovery to ensure available capacity.

Obtain the following information from your Microsoft Intune  administrator:

• Client ID

• Client Secret

• Token URL

For the connector to access the data in Microsoft Intune, the credential information is required to 
use the Microsoft Graph API. Therefore, you must grant the following Graph API permissions from 
the App registrations page in the Microsoft  portal:

• DeviceManagementManagedDevices.Read.All (Type: Application)

• DeviceManagementApps.Read.All (Type: Application)

• User.Read.All (Type: Application)

For more details on permissions, see Service Graph Connector for Microsoft Intune - 
Troubleshooting connection issues  on ServiceNow Community  and Microsoft Graph 
permissions reference  on the Microsoft  documentation site.

Dependencies and requirements:

• The Integration Commons for CMDB  store app, which is automatically installed.

• The CMDB CI class models store app, which is automatically installed. See CMDB CI Class 
Models store app.

• ServiceNow IntegrationHub Professional Pack Installer 
(com.glide.hub.integrations.professional). You must activate this plugin before you use the SG-
Intune Device Reports and SG-Intune Software Reports data sources.

• Datastream Action plugin (com.glide.hub.action_type.datastream), which is automatically 
installed.

• ITOM Licensing plugin (com.snc.itom.license). For more information, see Request Discovery .

Starting with Service Graph Connector for Microsoft Intune  2.1.1 release, the multi-instance 
support is available to import data from multiple Microsoft Intune  instances. This feature involves 
dynamically creating data sources and scheduled imports; thus, requires the granting of 
additional permissions. The guided setup includes additional steps for this feature.

Role required: admin

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1163

https://www.servicenow.com/products/entitlements-packages.html
https://www.servicenow.com/products/entitlements-packages.html
https://www.servicenow.com/products/entitlements-packages.html
https://www.servicenow.com/products/entitlements-packages.html
https://www.webstg.servicenow.com/docs/access?context=itom-license-module&version=washingtondc&pubname=washingtondc-it-operations-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=itom-license-module&version=washingtondc&pubname=washingtondc-it-operations-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=itom-license-module&version=washingtondc&pubname=washingtondc-it-operations-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=itom-license-module&version=washingtondc&pubname=washingtondc-it-operations-management&ft:locale=en-US
https://community.servicenow.com/community?id=community_blog&sys_id=a405ef9bdbbd7018bb4a474d13961903
https://community.servicenow.com/community?id=community_blog&sys_id=a405ef9bdbbd7018bb4a474d13961903
https://community.servicenow.com/community?id=community_blog&sys_id=a405ef9bdbbd7018bb4a474d13961903
https://community.servicenow.com/community?id=community_blog&sys_id=a405ef9bdbbd7018bb4a474d13961903
https://learn.microsoft.com/en-us/graph/permissions-reference
https://learn.microsoft.com/en-us/graph/permissions-reference
https://learn.microsoft.com/en-us/graph/permissions-reference
https://learn.microsoft.com/en-us/graph/permissions-reference
https://www.webstg.servicenow.com/docs/access?context=t_ActivateTheDiscoveryPlugin&version=washingtondc&pubname=washingtondc-it-operations-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=t_ActivateTheDiscoveryPlugin&version=washingtondc&pubname=washingtondc-it-operations-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=t_ActivateTheDiscoveryPlugin&version=washingtondc&pubname=washingtondc-it-operations-management&ft:locale=en-US


Procedure

1. Navigate to All  > Service Graph Connectors  > Intune  > Setup.

2. On the Getting Started page, select Get started.

3. Configure the credentials.

a. On the Service Graph Connector for Microsoft Intune page, in the Configure the connection 
section, select the task Configure credentials.

b. On the next page, in the Configure credentials task section, select Configure.

c. On the form, fill in the fields.

Edit Connection form

Field Description

Connection Name Name of the Microsoft Intune  application. 
This field is automatically set.

Connection URL Connection URL for the connection.

Based on the region of your Microsoft 
Intune  application, enter the connection 
URL in one of the following formats:

▪ Global

https://graph.microsoft.com

▪ US Government

https://graph.microsoft.us

▪ China

https://microsoftgraph.chin
acloudapi.cn

▪ Germany

https://graph.cloudapi.de/

OAuth Client ID The client ID of the Microsoft Intune 
application.

OAuth Client Secret The client secret of the Microsoft Intune 
application.

OAuth Token URL Callback URL for the Microsoft Intune 
application.

Based on the region of your Microsoft 
Intune  application, enter the token URL in 
one of the following formats:
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Field Description

▪ Global

https://login.microsoftonli
ne.com/<tenantid>/oauth2/v2
.0/token

▪ US Government

https://login.microsoftonli
ne.us/<tenantid>/oauth2/v2
.0/token

▪ China

https://login.partner.micro
softonline.cn/<tenantid>/oa
uth2/v2.0/token

▪ Germany

https://login.microsoftonli
ne.de/<tenantid>/oauth2/v2
.0/token

Where <tenantid>  is the tenant ID of 
your Microsoft Intune  application.

d. Select Edit and Get OAuth Token.

e. Go back to the guided setup page and for the Configure credentials task, select Mark as 
Complete.

4. Optional:  If needed, configure the MID Server.

a. In the Configure MID Server section, select Configure.

b. Select the Use MID server  check box.

c. Select Update  to save the record.

Note: 
You do not need to update the other fields.

5. Test the connection to the Microsoft Intune  API.

a. In the Test the connection section, select Configure.

b. On the form, review the fields.

Data Source form

Field Description

Name Unique name for this data source.

Import set table label Label of the table that will be created for this 
data source.
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Field Description

Import set table name Name of the table that will be created for this 
data source.

Data in single column Option to set to data in single column.

Type Data storage type of the data to be imported.

Application Application containing this record.

c. Optional:  Modify the properties in the Service Graph Connection Properties  related list of 
the connection record.

Note: 
Try to retain the default value of the software_path  property to ensure the proper 
retrieval of software details.

d. Select the Test Connection  related link to start the testing process.

e. When the Status  field is set to Success, return to the guided setup page.
If any of the tests have errors, follow the suggestions for remediation.

f. In the Test the connection task section, select Mark as Complete.

6. Add multiple instances.

a. On the left sidebar, select the Add Multiple Instances icon ( ).

b. On the Service Graph Connector for Microsoft Intune page, in the Add Multiple Instances 
section, select the Update Data Source Access task.

c. Select the Global  application scope by using the application picker.

d. In the Application Access related list, select the Can create, Can update, and Can delete 
check boxes, if not already selected.

e. Select Update  to close the tab and return to the guided setup.

f. Modify the application scope again to Service Graph Connector for Microsoft Intune  by 
using the application picker.

g. Set the Update Data Source Access task to complete by selecting Mark as Complete.

h. Repeat the steps 6.c  to 6.f  for the Update Scheduled data import access task with the 
Scheduled data import [scheduled_data_set] table and set the task to complete by selecting 
Mark as Complete.

7. Clear the cache for the new connection.

a. In the Clear Cache for Datasource and Import set section, select Configure.

b. In the Run script  text box of the background script page, enter the following script:

 
      GlideTableManager.invalidateTable("sys_data_source");
      GlideCacheManager.flushTable("sys_data_source");
 
     
 GlideTableManager.invalidateTable("scheduled_import_set");
      GlideCacheManager.flushTable("scheduled_import_set");
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      GlideTableManager.invalidateTable("sys_db_object");
      GlideCacheManager.flushTable("sys_db_object");

c. Select Run Script  to run the background script in the global  scope.
The script may take several minutes to execute.

d. After the script is executed, select Close.

e. From the application picker, select the Service Graph Connector for Microsoft Intune 
application.

f. Select Mark as Complete.

8. To either add or save the connection, select Configure  for the Create or Edit connection task.

◦ To add a connection, select Add Connection.

◦ To save the edits for the existing connection, select Edit.

Note: 
Obtain the following information from your Microsoft Intune  administrator:

◦ Client ID

◦ Client Secret

◦ Token URL

When a Microsoft Intune  administrator registers an application, the Client ID, Client 
Secret, and Token URL will be available. To get more information about how to register an 
application, see the Microsoft Intune documentation site .

a. On the form, fill in the fields or edit as needed.

Create Connection form

Field Description

Connection Name Display name for the connection.

Connection URL Connection URL for the new connection.

Based on the region of your Microsoft Intune 
application, enter the connection URL in one 
of the following formats:

▪ Global

https://graph.microsoft.com

▪ US Government

https://graph.microsoft.us

▪ China

https://microsoftgraph.chin
acloudapi.cn
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Field Description

▪ Germany

https://graph.cloudapi.de/

OAuth Client ID Client ID for the Microsoft Intune 
application.

OAuth Client Secret Client Secret for the Microsoft Intune 
application.

OAuth Token URL Callback URL for the Microsoft Intune 
application.

Based on the region of your Microsoft Intune 
application, enter the token URL in one of 
the following formats:

▪ Global

https://login.microsoftonli
ne.com/<tenantid>/oauth2/v2
.0/token

▪ US Government

https://login.microsoftonli
ne.us/<tenantid>/oauth2/v2
.0/token

▪ China

https://login.partner.micro
softonline.cn/<tenantid>/oa
uth2/v2.0/token

▪ Germany

https://login.microsoftonli
ne.de/<tenantid>/oauth2/v2
.0/token

Where <tenantid>  is the tenant ID of 
your Microsoft Intune  application.

b. Either add or save the connection.

▪ To create the new connection, select Create and Get OAuth Tokens.

▪ To save the edits for the existing connection, select Edit and Get OAuth Token.

c. Navigate back to the guided setup and select Mark as Complete.

d. Optional:  Set up the MID Server for the connection you created.

i. In the Configure Mid Servers section, select Configure.

ii. Select the name of the connection you created.

iii. Select the Use MID server  check box.
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iv. Select Update.

v. When you're finished with the task, select Mark as Complete

9. Test the API connection to import data from the Microsoft Intune  application.

a. Test the connection, in the Test New Connections section, by selecting Configure.

i. Select the name of the data source associated with the newly created connection.

ii. Select the Test Connection  related link to start the process.

iii. Optionally modify the properties in the Service Graph Connection Properties  related list.

Microsoft Intune  connection properties

Property Description

api_version The version of the Microsoft Intune  Graph API.

software_path The path of the software code for finding apps and 
associated devices or vice versa. Leave the property 
value as is.

include_primary_user_details Enable retrieving the details of the primary user during 
import and populating the assigned_to  attribute in the 
records of the cmdb_ci table by setting the property value 
to true. For retrieving the enrolled user details, set the 
property value to false.

Retrieving primary user details increases the time for 
importing data because of additional API calls.

Note: 
When a user is assigned to a device initially, the 
enrolled and primary users are the same. If the 
device is reassigned to another user, the primary 
user name is reassigned to the new user, but the 
enrolled user is still the original enrolled user name.

include_ip_address_details Enable retrieving the IP addresses of devices 
during import and populate the records in the 
cmdb_ci_ip_address table by setting the property value to 
true. To skip retrieving IP addresses, set the property to 
false.

Retrieving IP addresses increases the time for importing 
data because of additional API calls.

Note: 
The properties in the Service Graph Connection Properties  related list of the 
connection record are modifiable. However, try to retain the default value of the 
software_path  property to ensure the proper retrieval of software details.

iv. When the Status  field is set to Success, return to the guided setup page.
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Note: 
If any of the tests have errors, follow the suggestions for remediation.

v. Return to the guided setup and select Mark as Complete  for the Test New Connections 
task.

10. Set up the scheduled import jobs.

a. For the Configure scheduled jobs task in the Set up scheduled import jobs section, select 
Configure.

b. Select the name of the scheduled import you want to run.

c. On the Scheduled Data Import form, verify the field values for the scheduled job and select 
the Active  check box.

For more information, see Schedule a data import .

d. Select Update.

e. Set the Configure scheduled jobs  task to complete by selecting Mark as Complete.

11. Use advanced options to resolve server errors and improve performance with the SG-Intune 
Computer, SG-Intune Devices, and SG-Intune Software data sources while importing a large 
number of devices into the Microsoft Intune  portal.

Note: 

◦ The SG-Intune Device Reports data source serves as an alternative to the SG-Intune 
Computer and SG-Intune Devices data sources, importing the same information while 
optimizing the data retrieval process by minimizing API calls and reducing import time.

◦ The SG-Intune Software Reports data source serves as an alternative to the SG-Intune 
Software data source.

◦ Both the SG-Intune Device Reports and SG-Intune Software Reports data 
sources require the paid ServiceNow IntegrationHub Professional Pack Installer 
(com.glide.hub.integrations.professional) plugin.

◦ To enable the creation of attachments, the glide.attachment.extensions 
system property must be set to either null or bin, zip, json.

For more information, see the Service Graph Connector For Microsoft Intune – 
Advanced [KB1641546]  article in the Now Support  Knowledge Base.

a. Configure the scheduled jobs to import data using the SG-Intune Device Reports and SG-
Intune Software Reports data sources.

i. In the Advanced [Beta] section, for the Configure scheduled jobs for advanced data 
sources  task, select Configure.

ii. In the Scheduled jobs list, select SG-Intune Trigger Device Reports  job.

iii. On the Scheduled Script Execution form, verify the field values for the scheduled job and 
select the Active  check box.

For more information, see Schedule script execution form .
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iv. Select Update.

v. To activate the scheduled job for the SG-Intune Software Reports data source, repeat 
steps 11.a.ii  to 11.a.iv  by selecting the SG-Intune Trigger Software Reports  scheduled job.

vi. Return to the guided setup page and set the Configure scheduled jobs for advanced data 
sources  task to complete by selecting Mark as Complete.

Important: 

▪ Deactivate the SG-Intune Computer and SG-Intune Devices scheduled imports after 
setting up the SG-Intune Trigger Device Reports scheduled job for the SG-Intune 
Device Reports data source.

▪ Deactivate the SG-Intune Software scheduled import after setting up the SG-Intune 
Trigger Software Reports scheduled job.

▪ Activate the ServiceNow IntegrationHub Professional Pack Installer 
(com.glide.hub.integrations.professional) plugin on your instance.

For more information, see the Service Graph Connector For Microsoft Intune – 
Advanced [KB1641546]  article in the Now Support  Knowledge Base.

b. Configure the scheduled import for the SG-Intune Device Reports and SG-Intune Software 
Reports data sources.

i. In the Advanced [Beta] section, for the Configure the scheduled import for advanced data 
sources  task, select Configure.

ii. In the Scheduled Data Imports list, select the SG-Intune Device Reports  scheduled 
import.

iii. On the Scheduled Data Import form, verify the field values for the scheduled data import 
and select the Active  check box.

For more information, see Schedule a data import .

iv. Select Update.

v. Return to the guided setup page and set the Configure the scheduled import for advanced 
data sources  task to complete by selecting Mark as Complete.

Important: 
Verify that the SG-Intune Device Reports scheduled import is configured to run 3 hours 
after the SG-Intune Trigger Device Reports and SG-Intune Trigger Software Reports 
scheduled jobs.

Example: If the SG-Intune Trigger Device Reports job is set for 9 a.m. and SG-Intune 
Trigger Software Reports for 10 a.m. daily, schedule the SG-Intune Device Reports 
scheduled import for 1 p.m. daily.

c. When using multiple instances, update the permissions on the Scheduled Script Execution 
[sys_autoscript] table so that you can add scheduled jobs for the new connections.

i. For the Update scheduled job access  task, select Configure.

ii. Select the Global  application scope from the application picker.

iii. In the Application Access related list, select the Can create, Can update, and Can delete 
check boxes.

iv. Select  Update.
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v. Switch back to the Service Graph Connector for Microsoft Intune application scope using 
the application picker.

vi. Return to the guided setup page and set the Update scheduled job access  task to 
complete by selecting Mark as Complete.

d. When using multiple instances, clear the Scheduled Script Execution (sysauto_script) table 
cache to configure scheduled jobs for the new connections.

i. For the Clear cache for scheduled job  task, select Configure.

ii. Select the Global  application scope from the application picker.

iii. In the Run script  field, enter the following code:

GlideTableManager.invalidateTable("sysauto_script");
GlideCacheManager.flushTable("sysauto_script");
GlideTableManager.invalidateTable("sys_db_object");
GlideCacheManager.flushTable("sys_db_object");

iv. Select  Run Script.

v. Switch back to the Service Graph Connector for Microsoft Intune application scope using 
the application picker.

vi. Return to the guided setup page and set the Clear cache for scheduled job  task to 
complete by selecting Mark as Complete.

e. When using multiple instances, create advanced data sources, scheduled jobs, and 
scheduled imports for the new connections.

Tip: 
You can create additional connections for multiple instances by following the 
instructions in the Add Multiple Instances  section of the guided setup.

i. For the Set up advanced data sources for multiple instances  task, select Configure.

ii. On the form, fill in the fields to configure your scheduled job details for the new 
connection.

Field Description

Instance Prefix to Data source and 
Scheduled data import sets

Identifier that is used in all of the data 
source and scheduled import names for 
this distinct SG-Intune connection. In a 
multiple instance deployment, keep prefix 
short, meaningful identifier that enables 
you to identify a set of related data sources.

Note: 
Try to keep the prefix the same as 
your connection name.

Connection and Credentials Alias Connection alias that was created in the 
previous step.

Run Scheduled Import as User User to populate the field on the scheduled 
data import.
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iii. Select Submit  to create scheduled imports for your new connection.

iv. To activate any newly created scheduled jobs, repeat steps 11.a.ii  to 11.a.iv.

v. To activate any newly created parent scheduled import, repeat steps 11.b.ii  to 11.b.iv.

vi. Return to the guided setup page and set the Set up advanced data sources for multiple 
instances  task to complete by selecting Mark as Complete.

CMDB  classes targeted in Service Graph Connector for Microsoft Intune

When you complete setting up the connection, you can configure the integration to periodically 
pull data from Microsoft Intune. The data is saved in tables that extend from the Configuration 
item [cmdb_ci] table.

Computer [cmdb_ci_computer]

The following attributes in the Computer [cmdb_ci_computer] table are populated by collected 
data:

Attribute label Attribute name

Name name

Serial number serial_number

Description short_description

Disk space (GB) disk_space

Manufacturer manufacturer

Operating System os

OS Version os_version

Model ID model_id

Assigned to assigned_to

Chassis type chassis_type

Relationships created for Computer

Parent class Relationship type Child class

Computer 
[cmdb_ci_computer]

Owns::Owned by Network Adapter 
[cmdb_ci_network_adapter]

Computer 
[cmdb_ci_computer]

Owns::Owned by IP Address 
[cmdb_ci_ip_address]

Computer 
[cmdb_ci_computer]

Reference SG-Intune Computer Related 
[sn_intune_integrat_computer_related]

Computer 
[cmdb_ci_computer]

Reference Software Installation 
[cmdb_sam_sw_install]

Handheld Computing Device [cmdb_ci_handheld_computing]

The following attributes in the Handheld Computing Device [cmdb_ci_handheld_computing] 
table are populated by collected data:
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Attribute label Attribute name

Name name

Serial number serial_number

Description short_description

Disk space (GB) disk_space

IMEI imei

MEID meid

Operating System os

OS Version os_version

Phone Number phone_number

Root Access root_access

Model ID model_id

Carrier carrier

Assigned to assigned_to

Manufacturer manufacturer

Relationships created for Handheld Computing Device

Parent class Relationship type Child class

Handheld Computing Device 
[cmdb_ci_handheld_computing]

Owns::Owned by Network Adapter 
[cmdb_ci_network_adapter]

Handheld Computing Device 
[cmdb_ci_handheld_computing]

Owns::Owned by IP Address 
[cmdb_ci_ip_address]

Handheld Computing Device 
[cmdb_ci_handheld_computing]

Reference SG-Intune Device Related 
[sn_intune_integrat_device_related]

Handheld Computing Device 
[cmdb_ci_handheld_computing]

Reference Software Installation 
[cmdb_sam_sw_install]

Software Installation [cmdb_sam_sw_install]

The following attributes in the Software Installation [cmdb_sam_sw_install] table are populated 
by collected data:

Attribute label Attribute name

Display name display_name

Version version

Discovery source discovery_source

Publisher publisher

Installed on installed_on
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Note: 
The Publisher attribute is populated by the SG-Intune Software Reports data source only.

Relationships created for Software Installation

Parent class Relationship type Child class

Software Installation 
[cmdb_sam_sw_install]

Reference Handheld Computing Device 
[cmdb_ci_handheld_computing]

Computer 
[cmdb_ci_computer]

Network Adapter [cmdb_ci_network_adapter]

The following attributes in the Network Adapter [cmdb_ci_network_adapter] table are populated 
by collected data:

Attribute label Attribute name

MAC Address mac_address

Name name

Configuration Item cmdb_ci

Relationships created for Network Adapter

Parent class Relationship type Child class

Network Adapter 
[cmdb_ci_network_adapter]

Reference Handheld Computing Device 
[cmdb_ci_handheld_computing]

Network Adapter 
[cmdb_ci_network_adapter]

Reference Computer 
[cmdb_ci_computer]

IP Address [cmdb_ci_ip_address]

The following attributes in the IP Address [cmdb_ci_ip_address] table are populated by collected 
data:

Attribute label Attribute name

IP version ip_version

Owned By Configuration Item owned_by_cmdb_ci

IP Address ip_address

Name name

Relationships created for IP Address

Parent class Relationship type Child class

IP Address 
[cmdb_ci_ip_address]

Reference Handheld Computing Device 
[cmdb_ci_handheld_computing]
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Relationships created for IP Address  (continued)

Parent class Relationship type Child class

IP Address 
[cmdb_ci_ip_address]

Reference Computer 
[cmdb_ci_computer]

Serial Number [cmdb_serial_number]

The following attributes in the Serial Number [cmdb_serial_number] table are populated by 
collected data:

Attribute label Attribute name

Serial Number serial_number

Serial Number Type serial_number_type

Valid valid

Relationships created for Serial Number

Parent class Relationship type Child class

Serial Number 
[cmdb_serial_number]

Reference Handheld Computing Device 
[cmdb_ci_handheld_computing]

Serial number 
[cmdb_serial_number]

Reference Computer 
[cmdb_ci_computer]

SG-Intune Computer Related [sn_intune_integrat_computer_related]

The following attributes in the SG-Intune Computer Related 
[sn_intune_integrat_computer_related] table are populated by collected data:

Attribute label Attribute name

Device ID device_id

Azure AD Registered azure_ad_registered

Compliance State compliance_state

Device Enrollment Type device_enrollment_type

Email Address email_address

Encrypted is_encrypted

Managed Device Owner Type managed_device_owner_type

Management Agent management_agent

Supervised is_supervised

SG-Intune Device Related [sn_intune_integrat_device_related]

The following attributes in the SG-Intune Device Related [sn_intune_integrat_device_related] 
table are populated by collected data:
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Attribute label Attribute name

Device ID device_id

Azure AD Registered azure_ad_registered

Compliance State compliance_state

Device Category device_category

Device Enrollment Type device_enrollment_type

Device State device_state

Email Address email_address

Encrypted is_encrypted

Managed Device Owner Type managed_device_owner_type

Management Agent management_agent

Security Patch Level security_patch_level

Supervised is_supervised

System Management Bios Version system_management_bios_version

Wifi Subnet ID wifi_subnet_id

Note: 
The attributes Device Category, Device State, Security Patch Level, System Management 
Bios Version, and Wifi Subnet ID are populated by the SG-Intune Device Reports data 
source only.

The attributes Azure AD Registered, Device Enrollment Type, and Management Agent aren't 
populated by the SG-Intune Device Reports data source.

Software [cmdb_ci_spkg]

The following attributes in the Software [cmdb_ci_spkg] table are populated by collected data:

Attribute label Attribute name

Key key

Name name

Version version

Relationship created for Software

Parent class Relationship type Child class

Software [cmdb_ci_spkg] Reference Software Instance 
[cmdb_software_instance]

Software Instance [cmdb_software_instance]

The following attributes in the Software Instance [cmdb_software_instance] table are populated 
by collected data:
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Attribute label Attribute name

Name name

Installed on installed_on

Relationships created for Software Instance

Parent class Relationship type Child class

Software Instance 
[cmdb_software_instance]

Reference Handheld Computing Device 
[cmdb_ci_handheld_computing]

Software Instance 
[cmdb_software_instance]

Reference Computer 
[cmdb_ci_computer]

Accessing the connection details of Service Graph Connector for Microsoft Intune

You can access the connection details of the Service Graph Connector for Microsoft Intune  in 
a single view using the common connection framework (CCF) included within the Integration 
Commons for CMDB  (sn_cmdb_int_util) store app.

With the CCF, you can access all the connections used by the Service Graph Connector for 
Microsoft Intune. The connection details include the connection alias, connection properties, 
data sources, and scheduled data imports associated with a connection. You can also test 
the connection. For more information, see Accessing the connection details of Service Graph 
Connectors.

Access the details of a Microsoft Intune  connection

Access the details of a Microsoft Intune  connection configured for the Service Graph Connector 
for Microsoft Intune.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Service Graph Connectors  > Intune  > Connections.

2. From the Name  column of the Service Graph Connections list, select a connection.

3. On the Service Graph Connections page, view the connection details such as the connection 
name, alias, and data sources.

4. Select a related list to view further details of the connection.

5. Optional:  Select the Test Connection  related link to test the connection.

Service Graph Connector for Microsoft Intune  properties

Service Graph Connector for Microsoft Intune  properties control the behavior of the connector.

Connection properties

These connection properties are available for Service Graph Connector for Microsoft Intune.
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Note: 
To open the Service Graph Connection Properties 
[sn_cmdb_int_util_service_graph_connection_property] table for the connector, navigate 
to All  > Service Graph Connectors  > Intune  > Connections  and select the connection 
name. The connection properties are displayed in the Service Graph Connection Properties 
related list.

Connection properties for Service Graph Connector for Microsoft Intune

Property Description

api_version
Enter the version of the Microsoft Intune  Graph API.

• Type: string

• Default value: v1.0

device_report_chunks_count
Set the number of device report chunks. The value must 
be a power of 16 (for instance, 1, 16, 256, and so on).

• Type: integer

• Default value: 1

export_apis_max_calls_before_wait
Set the maximum number of API calls that can be made 
consecutively before a waiting period is enforced.

• Type: integer

• Default value: 8

export_apis_wait_time_in_ms
Set the duration (in milliseconds) for the waiting period 
after the specified number of consecutive API calls is 
reached.

• Type: integer

• Default value: 120000

include_ip_address_details
Set the property to true  to retrieve IP address details 
during import and add the records to the IP Address 
[cmdb_ci_ip_address] table.

Set the property to false  to skip retrieving IP addresses.

Retrieving IP addresses increases the time for importing 
data because of additional API calls.

• Type: true | false

• Default value: true

include_primary_user_details
Set the property to true  to retrieve primary user details 
during import and add the assigned_to attribute to the 
Configuration item [cmdb_ci] table.

Set the property to false  to retrieve the enrolled user 
details.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1179



Connection properties for Service Graph Connector for Microsoft Intune  (continued)

Property Description

Retrieving primary user details increases the time for 
importing data because of additional API calls.

Note: 
When a user is assigned to a device initially, the 
enrolled and primary users are the same. If the 
device is reassigned to another user, the primary 
user name is reassigned to the new user, but the 
enrolled user is still the original enrolled user name.

• Type: true | false

• Default value: true

software_path
Set the path of the software code for finding apps and 
associated devices.

Note: 
Set the property to null value to enable the logic to 
determine the path of the software code.

• Type: device | app

• Default value: device

software_report_chunks_count
Set the number of software report chunks. The value must 
be a power of 16 (for instance, 1, 16, 256, and so on).

• Type: integer

• Default value: 16

Service Graph Connector for Microsoft SCCM

Use the Service Graph Connector for Microsoft SCCM  to pull data from Microsoft  System Center 
Configuration Manager (SCCM) into your ServiceNow  instance.

The Service Graph Connector for Microsoft SCCM  (SG-SCCM) imports SCCM data into the 
ServiceNow®  Configuration Management Database (CMDB)  application. The integration does 
not write to the SCCM database and supports the Microsoft  Endpoint Configuration Manager 
(MECM). The integration pulls data from computers, processors, operating systems, disks, 
networks, and software.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .
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Supported versions

• Supported Microsoft  SCCM/MECM versions:

◦ 2409

◦ 2403

• Supported ServiceNow  versions:

◦ Washington DC

◦ Xanadu

◦ Yokohama

Use cases

The following ServiceNow  applications have features that interact with the Service Graph 
Connector:

• IT Operations Management (ITOM) Visibility

◦ Ability to get visibility into your infrastructure.

◦ Detailed hardware and software inventory tracking. The tracking can be done with or without 
Software Asset Management  (SAM).

◦ Ability to detect delta changes for efficient incremental imports from SCCM to the 
ServiceNow AI Platform.

• IT Service Management (ITSM)

◦ Incidents, problems, and changes on discovered configuration items (CI).

◦ Automatic device ownership assignment.

• Software Asset Management (SAM)  and IT Asset Management (ITAM)

◦ Tight integration with Software Asset Management Professional  and client software 
distribution workflows.

◦ Inventory Software package and installation tracking.

◦ Software Usage tracking.

◦ License reclamation by detecting removed software.

◦ Support for software editions, normalizing publisher information, and normalizing product 
Information.

◦ Support for SCCM Asset Intelligence.

Important information for upgrading Service Graph Connector for Microsoft 
SCCM

After you've installed the latest version of the Service Graph Connector for Microsoft SCCM, 
ensure that you have removed the last_run_datetime  field value from the Data Source 
[sys_data_source] table for the SCCM  data sources.

Configuring a connection for the connector

You can configure a connection for the connector by using the SGC Central  view in the CMDB 
Workspace. The view enables you to discover and install connectors, and then effectively 
manage the full life cycle of creating, editing, monitoring, and debugging connections. To 
configure the connector using SGC Central, see Configure Service Graph Connector for 
Microsoft SCCM using SGC Central.
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Important: 
Unless there are configuration issues, use the SGC Central  view in the CMDB Workspace 
to configure the connection for the connector, as the guided setup method is being 
deprecated.

CMDB integrations dashboard

The Integration Commons for CMDB  store app provides a dashboard with a central view of 
the status, processing results, and processing errors of all installed integrations. You can see 
metrics for all integration runs. You can filter the view to a specific CMDB  integration, a specific 
time duration, or a specific integration run. For more details about monitoring Microsoft  SCCM 
integrations in the CMDB  Integrations Dashboard, see Using the CMDB Integrations Dashboard.

Data mapping

Data from the SCCM data sources is mapped and transformed into the ServiceNow  CMDB 
Configuration Item (CI) class definitions using the Robust Transform Engine (RTE). Data is 
inserted into the ServiceNow®  CMDB  using the Identification and Reconciliation Engine (IRE).

The SCCM data sources include the following:

• SG-SCCM Computer Identity

You can see the following data if it is available in SCCM:

◦ Asset Tag. If the Asset Tag data is available, the mapping can be optionally enabled via the 
guided setup.

◦ Assigned

◦ DNS Domain

• SG-SCCM Computer OU. This data source imports data about the Organizational 
Unit (OU) name. The data is stored in the SG-SCCM Computer Related 
[sn_sccm_integrate_sccm_2019_computer_related] table. To add the view, open the computer 
record, click the top header, and select View  > SG-SCCM Computer Related.

• SG-SCCM Disk

• SG-SCCM Last Discovered Update. This data source will run at the end of the import schedules 
to update the last_discovered date on the Computer CI. The source will conduct a full pull of all 
the computers and bring in only the ResourceID and the LastHWScan columns to update the 
CMDB  Computer table.

• SG-SCCM Network

• SG-SCCM Operating System

• SG-SCCM Processor

• SG-SCCM Removed Software. Ensure the Use last run datetime  option is cleared for every run.

• SG-SCCM Removed Software AI. Ensure the Use last run datetime  option is cleared for every 
run.

• SG-SCCM Software

• SG-SCCM Software AI

Note: 
If you have Asset Intelligence on your Microsoft SCCM instance, you have to run SG-SCCM 
Removed Software AI and SG-SCCM Software AI. If you do not have Asset Intelligence on 
your instance, you have to run SG-SCCM Removed Software and SG-SCCM Software.
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When you complete setting up the connection, you can configure the integration to periodically 
pull data from SCCM. The data is loaded into staging tables and then inserted into the following 
target tables:

• CI Relationship [cmdb_rel_ci]

• Computer [cmdb_ci_computer] (required)

• Disk [cmdb_ci_disk]

• IP address [cmdb_ci_ip_address]

• Network Adapter [cmdb_ci_network_adapter]

• Serial Number [cmdb_serial_number]

• Software Installation [cmdb_sam_sw_install] (If the SAM application is installed.)

• Software Instance [cmdb_software_instance] (If the SAM application is not installed.)

• Software [cmdb_ci_spkg] (If the SAM application is not installed.)

• Software Usage [samp_sw_usage]

For more information on where data is saved when pulling data from a Microsoft SCCM 
application, see CMDB classes targeted in Service Graph Connector for Microsoft SCCM.

You can use the IntegrationHub ETL app to view the data maps. See IntegrationHub ETL  for more 
information.

Resolving the missing IP address or MAC address issue

By default, network adapters that are missing an IP address or MAC address are not imported. To 
include these network adapters in the import, do the following:

1. Navigate to Service Graph Connector for Microsoft SCCM  > Data Sources.

2. Select SG-SCCM Network.

3. Remove the where clause from the SQL statement  field.

Additional resources

• How do I configure the SG-SCCM Service Graph Connector?  article on the ServiceNow 
Community  site

• Service Graph Connector for Microsoft SCCM - FAQ and Troubleshooting  blog post on the 
ServiceNow Community  site

• Service Graph Connector for Microsoft SCCM 3.0 Setup Guidelines [KB1001248]  article in 
the Now Support  Knowledge Base

• Support for Removed Software functionality in Service Graph Connector for SCCM 
integration  blog post on the ServiceNow Community  site

Related topics

Service Graph Connectors

Configure Service Graph Connector for Microsoft SCCM  using SGC Central

Use the playbook available with the SGC Central  application to set up the Service Graph 
Connector for Microsoft SCCM  for pulling in Microsoft  SCCM  data into the CMDB.

Before you begin
Install Service Graph Connector for Microsoft SCCM  version 3.5.0 or later from the ServiceNow 
Store. For ServiceNow Store  installation steps, see Install a ServiceNow Store application . 

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1183

https://www.servicenow.com/community/cmdb-articles/sg-sccm-service-graph-connector/ta-p/2854458
https://www.servicenow.com/community/cmdb-articles/sg-sccm-service-graph-connector/ta-p/2854458
https://www.servicenow.com/community/cmdb-articles/sg-sccm-service-graph-connector/ta-p/2854458
https://community.servicenow.com/community?id=community_blog&sys_id=a753807adb7eb0d0fd8d2b69139619a8
https://community.servicenow.com/community?id=community_blog&sys_id=a753807adb7eb0d0fd8d2b69139619a8
https://community.servicenow.com/community?id=community_blog&sys_id=a753807adb7eb0d0fd8d2b69139619a8
https://hi.service-now.com/kb_view.do?sysparm_article=KB1001248
https://hi.service-now.com/kb_view.do?sysparm_article=KB1001248
https://hi.service-now.com/kb_view.do?sysparm_article=KB1001248
https://www.servicenow.com/community/cmdb-blog/support-for-removed-software-functionality-in-service-graph/ba-p/2274937
https://www.servicenow.com/community/cmdb-blog/support-for-removed-software-functionality-in-service-graph/ba-p/2274937
https://www.servicenow.com/community/cmdb-blog/support-for-removed-software-functionality-in-service-graph/ba-p/2274937
https://www.servicenow.com/community/cmdb-blog/support-for-removed-software-functionality-in-service-graph/ba-p/2274937
https://www.webstg.servicenow.com/docs/access?context=t_InstallApplications&version=washingtondc&pubname=washingtondc-application-development&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=t_InstallApplications&version=washingtondc&pubname=washingtondc-application-development&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=t_InstallApplications&version=washingtondc&pubname=washingtondc-application-development&ft:locale=en-US


Role required: cmdb_inst_admin or admin

About this task
The playbook experience for onboarding connectors is activated with SGC Central  in the CMDB 
Workspace. To configure the SGC Central  application, see Configuring SGC Central  and for more 
information on how to interact with a playbook, see Interact with Playbook .

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the CMDB Workspace, select SGC Central.

3. On the Overview page, select Create connection.

Tip: 
Alternatively, you can select Create connection  on the All connections page.

4. On the Create connection window, select the Microsoft  SCCM  connector type, and then select 
Create connection.

5. Complete the initial prerequisites when setting up a connection for the first time using a 
connector.

Note: 
This step is required only during the first-time setup. See Perform initial setup tasks when 
creating a connection in SGC Central.

6. Select a template that matches the credentials for establishing a Java Database Connectivity 
(JDBC) connection to the SCCM database.

a. In the Setup  stage of the playbook, select the Select alias template  activity.

b. Select a template.

▪ SCCM JDBC Connection Credentials: Select to use a username and password to 
establish a JDBC connection to the SCCM database.

▪ SCCM JDBC Conn Cred (Integrated Auth): Select to use Windows JDBC-integrated 
authentication, which uses domain credentials, for authenticating a JDBC connection to 
the SCCM database.

c. Select Continue.

7. Enter connection details and test the API connection for importing Microsoft  SCCM  data.

a. In the Setup  stage of the playbook, select the Create and test connection  activity.

b. On the form, fill in the fields.

Create and test connection form

Field Description

Connection name Name to identify the Microsoft  SCCM 
connection record.

For example, SG-SCCM connection.
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Field Description

Query timeout Number of seconds the JDBC driver waits 
for a query to complete.

0  indicates no timeout. If the timeout is 
exceeded, the integration considers the 
JDBC result inaccessible and marks the 
result as an error.

Connection timeout Number of seconds before the MID 
Server connection cache pool closes the 
connection and removes the connection.

0  indicates no timeout.

Host Network address of the server where the 
Microsoft  SQL Server database is located.

Database name Name of the Microsoft  SQL Server database 
that SCCM uses.

Override default port Custom port of the Microsoft  SQL Server 
instance.

The default port for Microsoft  SQL Server is 
1433

Instance name Microsoft  SQL Server instance.

MID Server MID Server for the connection.

Note: 
It’s required to select a MID Server 
for an Integrated Authentication 
connection.

For the SCCM JDBC Connection 
Credentials  option, this field appears 
only when you select the Use MID 
Server  check box.

Note: 
The following fields appear only when you select the SCCM JDBC Connection 
Credentials  template in step 6.

Format JDBC driver used for connecting to the 
SCCM database.

SCCM uses Microsoft  SQL 
Server as its database backend. 
This field is automatically set to 
com.microsoft.sqlserver.jdbc.SQLServerDriver. 
Leave the field value as is.

Username User name for connecting to the JDBC 
server.
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Field Description

Password Password for the JDBC server.

Use MID Server Option to use the MID Server for accessing 
the JDBC server.

c. Select Create and test connection.

d. Once the connection test is complete, select Continue.

8. Optional:  Configure the connection and connector properties to map attributes and manage 
data imports.

Note: 
To skip this step, select Continue  for the Configure properties  activity.

a. In the Setup  stage of the playbook, select the Configure properties  activity.

b. To map the asset tags from Microsoft  SCCM  to the asset tag attribute in the Computer 
[cmdb_ci_computer] class, in the Connection properties section of the Configure properties 
page, select the Map asset tags  check box.

c. To avoid creating duplicate records in the CMDB Disks [cmdb_ci_disk] table when the 
Discovery application is running, in the Connector properties section of the Configure 
properties page, select the Avoid creating duplicate records  check box.

d. To set the import disk name to the format starting with Disk  [disknumber], in the 
Connector properties section of the Configure properties page, select the Transform disk 
name to disk number  check box.
Where the disknumber  is the number extracted from the disk name

e. Select Continue.

9. Optional:  Modify the SQL statement for a data source.

Note: 
To skip this step, select Skip  for the Customize data source SQL statement  activity.

a. In the Setup  stage of the playbook, select the Customize data source SQL statement 
activity.

b. Double-click (or use the keyboard shortcut) the Custom SQL statement  column value for a 
data source and enter the custom SQL statement.

c. Repeat the step 9.b  for each data source where you want to modify the SQL statement.

d. Select Mark Complete.

10. Configure the import schedules to import data at regular intervals.

a. In the Setup  stage of the playbook, select the Configure import schedule  activity.

b. Expand the Parent scheduled data import within the Import schedules list to select the 
Connection Name-SCCM Computer Identity  import schedule.
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c. Select the Active  check box, and then fill in the run schedule and time details.

For more information, see Schedule a data import .

d. Select Save.
Alternatively, select Execute Now  to execute the import schedule immediately.

e. Select Continue.

11. In the Setup  stage of the playbook, select the Confirm connection creation  activity to verify 
whether the connection was created.

What to do next
Select View all connections  to review the connection details. The created connection appears in 
the Installed connections list.

Related topics

Service Graph Connector for Microsoft SCCM

CMDB classes targeted in Service Graph Connector for Microsoft SCCM

Enable Software Editions in Service Graph Connector for Microsoft SCCM

Accessing the connection details of Service Graph Connector for Microsoft SCCM

Configure Service Graph Connector for Microsoft SCCM  using the guided setup

Set up and validate data source connection credentials to import Microsoft  SCCM  data into your 
CMDB.

Before you begin
Important: 
Unless there are configuration issues, use the SGC Central  view in the CMDB Workspace 
to configure the connection for the connector, as the guided setup method is being 
deprecated.

Confirm that you are in the Service Graph Connector for Microsoft SCCM  application scope by 
using the application picker.

Note: 
If you’re currently using a version of the Microsoft  SCCM  plugin, see Upgrade from the 
legacy SCCM plugin to the Service Graph Connector for Microsoft SCCM.

Dependencies and requirements:

• The Integration Commons for CMDB  store app, which is automatically installed.

• The CMDB CI class models store app, which is automatically installed. See CMDB CI Class 
Models store app.

• Integration - JDBC (com.snc.integration.jdbc)

• Windows  MID Server  required for access to the SCCM environment.

To access Microsoft  SCCM  data, you must have appropriate access to the Microsoft  SCCM 
database. You must have sufficient credentials to query the SQL Server that contains the 
Microsoft  SCCM  database. You must do the following:
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1. Create a SQL Server account to connect to the Microsoft  SCCM  database on the MID Server to 
use the data sources.

2. Connect to your Microsoft  SCCM  SQL Server and configure the following:

a. Add a new login username and password for SQL authentication.

b. Choose the Microsoft  SCCM  database that ServiceNow  data sources will connect to.

c. Assign the db_datareader  role membership to the Microsoft  SCCM  user.

Note: 
If you have the Service Graph Connector for Microsoft SCCM  version 2.1.6 or earlier 
versions installed in your production environment, contact Customer Service and Support 
for additional steps to remove the SCCM Discovery Source from being included when 
calculating the subscription unit consumption.

Starting with Service Graph Connector for Microsoft SCCM  version 3.0.4, support for multi-
instance is introduced, enabling Service Graph Connector for Microsoft SCCM  to connect to and 
import data from multiple Microsoft  SCCM  instances. This feature involves dynamically creating 
data sources and scheduled imports, requiring the granting of additional permissions. For more 
information about how to complete these steps, see Service Graph Connector for Microsoft 3.0 
Setup Guidelines [KB1001248]  in Now Support .

Role required: admin

Procedure

1. Navigate to All  > Service Graph Connectors  > SCCM  > Setup.

2. On the Getting Started page, select Get Started.

3. On the Service Graph Connector for Microsoft SCCM  page, in the Configure Data source and 
Scheduled data import access section, select the task Configure Data source access.

4. Update the data source access to enable creating data sources and scheduled data imports 
for a new connection in the Service Graph Connector for Microsoft SCCM.

a. For the Configure Data source access task, select Configure.

b. Select the Global  application scope by using the application picker.

c. In the Application Access related list, select the Can create, Can update, and Can delete 
check boxes, if not already selected.

d. Select Update  to close the tab and return to the guided setup.

e. Modify the application scope again to Service Graph Connector for Microsoft SCCM  by 
using the application picker.

f. Set the Update Data Source Access  task to complete by selecting Mark as Complete.

g. Repeat the steps 4.b  to 4.e  for the Update Scheduled data import access task with the 
Scheduled data import [scheduled_data_set] table and set the task to complete by selecting 
Mark as Complete.

5. Configure the authentication credentials and configuration used for connecting to the 
Microsoft  SCCM database.

a. Use a username and password to establish a JDBC connection to the SCCM database.

Note: 
Perform this step only when you want to use a username and password to establish a 
JDBC connection. Otherwise, select Skip  to skip the step.
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i. For the Configure connection  task in the Configure the connection  section, select 
Configure.

ii. Configure the connection.

▪ To configure the connection available by default, select Configure  for the SCCM JDBC 
Connection Credentials  connection.

▪ To create another connection, select Add Connection.

Note: 
You can create multiple connections by selecting Add Connection. If not 
redirected to the connection setup, on the Workflow Studio  Integrations page 
search for SCCM JDBC Connection Credentials  to modify the default connection 
or add another connection.

iii. On the form, fill in the fields.

Configure Connection or Create Connection form

Field Description

Connection Information

Connection name Name to identify the Microsoft  SCCM 
connection record.

For example, SG-SCCM connection.

Query timeout Number of seconds the JDBC driver waits 
for a query to complete.

0  indicates no timeout. If the timeout is 
exceeded, the integration considers the 
JDBC result inaccessible and marks the 
result as an error.

Connection timeout Number of seconds before the MID 
Server connection cache pool closes the 
connection and removes the connection.

0  indicates no timeout.

Format JDBC driver used for connecting to the 
Microsoft  SCCM  database.

Microsoft  SCCM  uses Microsoft  SQL 
Server as its database backend. 
This field is automatically set to 
com.microsoft.sqlserver.jdbc.SQLServerDriver. 
Leave the field value as is.

Host Network address of the server where the 
Microsoft  SQL Server database is located.

Database name Name of the Microsoft  SQL Server 
database that Microsoft  SCCM  uses.
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Field Description

Override default port Custom port of the Microsoft  SQL Server 
instance.

The default port for Microsoft  SQL Server is 
1433

Instance name Microsoft  SQL Server instance.

Use MID Server Option to use the MID Server for accessing 
the JDBC server.

MID Server MID Server for the connection.

Note: 
It’s required to select a MID Server 
for an Integrated Authentication 
connection.

For the SCCM JDBC Connection 
Credentials  option.

Credential Information

Username User name for connecting to the JDBC 
server.

Password Password for the JDBC server.

iv. Save your changes.

▪ For the default connection, select Configure Connection.

▪ For a new connection, select Create Connection.

v. Navigate back to the guided setup and set the Configure connection  task to complete by 
selecting Mark as Complete.

b. Use Windows JDBC-integrated authentication, which uses domain credentials, for 
authenticating a JDBC connection to the SCCM database.

Note: 
Perform this step if you need the JDBC connection with integrated authentication. 
Otherwise, select Skip  to skip the step.

i. For the Configure connection (Integrated authentication)  task in the Configure the 
connection  section, select Configure.

ii. Configure the connection.

▪ To configure the connection available by default, select Configure  for the SCCM JDBC 
Conn Cred (Integrated Auth)  connection.

▪ To create another connection, select Add Connection.

Note: 
You can create multiple connections by selecting Add Connection. If not 
redirected to the connection setup, on the Workflow Studio  Integrations page 
section search for SCCM JDBC Conn Cred (Integrated Auth)  to modify the default 
connection or add another connection.
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iii. On the form, fill in the fields.

Configure Connection or Create Connection form

Field Description

Connection name Name to identify the Microsoft  SCCM 
connection record.

Query timeout Number of seconds the JDBC driver waits 
for a query to complete.

0  indicates no timeout. If the timeout is 
exceeded, the integration considers the 
JDBC result inaccessible and marks the 
result as an error.

Connection timeout Number of seconds before the MID 
Server connection cache pool closes the 
connection and removes the connection.

0  indicates no timeout.

Host Network address of the server where the 
Microsoft  SQL Server database is located.

Database name Name of the Microsoft  SQL Server 
database that Microsoft  SCCM  uses.

Override default port Custom port of the Microsoft  SQL Server 
instance.

The default port for Microsoft  SQL Server is 
1433

Instance name Microsoft  SQL Server instance.

MID Server MID Server for the connection.

Note: 
It’s required to select a MID Server 
for an Integrated Authentication 
connection.

For the SCCM JDBC Connection 
Credentials  option.

iv. Save your changes.

▪ For the default connection, select Configure Connection.

▪ For a new connection, select Create Connection.

v. Navigate back to the guided setup and set the Configure connection (Integrated 
authentication)  task to complete by selecting Mark as Complete.

6. Configure the connection and connector properties to map attributes and manage data 
imports.
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a. Optional:  Enable mapping asset tags from Microsoft  SCCM  to the asset tag attribute in the 
Computer [cmdb_ci_computer] class.

i. For the Configure Connection Properties  task in the Configure Data Source and Scheduled 
Data Import  section, select Configure.

ii. In the Name column, select the connection.

iii. In the Service Graph Connection Properties  related list, select asset_tag  in the Property 
column.

iv. In the Value  field, enter true  to enable mapping asset tags.

v. Select Update.

vi. Navigate back to guided setup and set the Configure Connection Properties  task to 
complete by selecting Mark as Complete.

b. Test the Computer Identity data source to verify that all data sources are properly connected.

i. For the Validate Data Sources  task in the Configure Data Source and Scheduled Data 
Import  section, select Configure.

ii. In the Name column, select the Computer Identity data source associated with the 
connection.

iii. Select Test Load 20 Records.

iv. When the State  field is set to Complete  and the Completion code  field is set to Success, 
select the Return to data source  link.

v. Navigate back to guided setup and set the Validate Data Sources  task to complete by 
selecting Mark as Complete.

c. Ensure that all data from the Computer Identity source is imported without the date time 
filtering during the next test load.

i. For the Reset 'Last run datetime' in test load data source  task in the Configure Data 
Source and Scheduled Data Import  section, select Configure.

ii. In the Name column, select the Computer Identity data source associated with the 
connection.

iii. Clear the Use last run datetime  check box.

iv. Select Update.

v. Navigate back to guided setup and set the Reset 'Last run datetime' in test load data 
source  task to complete by selecting Mark as Complete.

7. Optional:  Configure the process for importing disk data when the Discovery  application is 
running.

a. Avoid creating duplicate records in the CMDB Disks [cmdb_ci_disk] table.

Note: 
You can avoid creating duplicate records in the CMDB Disks [cmdb_ci_disk] 
table when the Discovery  application is running by configuring the 
sn_sccm_integrate.sccm_disks_managed  property and setting its value to 
true. By default, the property value is set to false.
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i. For the Configure Disk Data Imports  task in the Configure Disk Data Imports  section, select 
Configure.

ii. On the System Property page, set the value of the 
sn_sccm_integrate.sccm_disks_managed  property to true.

iii. Select Update.

iv. Set the Configure Disk Data Imports  task to complete by selecting Mark as Complete.

Note: 
Any existing disk records are updated only after the next hardware scan is executed in 
the Microsoft SCCM instance.

b. Optional:  Transform imported disk name to disk number format.

Note: 
You can set the imported disk name to the format Disk  <disknumber>. Where 
<disknumber>  is the number extracted from the imported disk name.

i. Select the Integration Commons for CMDB  application scope from the application picker.

ii. For the Configure Disk Name Transformation  task in the Configure Disk Data Imports 
section, select Configure.

iii. On the System Property page, set the value of the 
sn_cmdb_int_util.transform_disk_name_to_discovery_format 
property to true.

iv. Select Update.

v. From the application picker, select the Service Graph Connector for Microsoft SCCM 
application scope.

vi. Set the Configure Disk Name Transformation  task to complete by selecting Mark as 
Complete.

8. Configure the scheduled data imports.

Note: 
If the Use Integrated Authentication  check box is selected for the data source, the run 
as user for the scheduled data import job must have the import_admin role. For more 
information, see the "Use Integrated Authentication" is being unchecked when you run 
the scheduled import related to SG-SCCM or SG-SCCM Computer Identity Data Source 
[KB1312810]  article in the Now Support  Knowledge Base.

a. For the Configure scheduled jobs  task in the Configure scheduled jobs task section, select 
Configure.

b. On the Scheduled Data Import form, verify the field values for the scheduled job.
For more information, see Schedule a data import .

All other Service Graph Connector for Microsoft SCCM  scheduled jobs that are active will 
run in their specified order after the Computer Identity scheduled job is finished running. 
Select the Active  check box for a scheduled job to activate the job.
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Important: 
If you are upgrading to the Service Graph Connector for Microsoft SCCM, deactivate 
the existing 'SG-SCCM Computer Identity scheduled data import'. Additionally, you 
cannot use the baseline scheduled data import or data sources that have a name 
starting with 'SG-SCCM' because they are used as templates for creating an instance 
of data sources and scheduled data imports.

c. Select Update.

d. Set the Configure Scheduled data imports  task to complete by selecting Mark as Complete.

e. Optional:  When upgrading the Service Graph Connector for Microsoft SCCM, deactivate 
the existing SG-SCCM Computer Identity scheduled data import.
For the Deactivate Legacy Scheduled Data Imports  task, select Configure.

f. In the Name column, select the SG-SCCM Computer Identity scheduled data import and 
clear the Active  check box.

g. Set the Deactivate Legacy Scheduled Data Imports  task to complete by selecting Mark as 
Complete.

9. Optional:  Customize the Instance Data source SQL statement.

a. For the Customizing Data source SQL statement  task in the Customize Instance Data source 
SQL statement section, select Configure.

b. Select the name of the instance in which you want to customize the SQL statement.

c. Select Update.

d. Set the Customizing Data source SQL statement  task to complete by selecting Mark as 
Complete.

Trouble? 

To resolve issues when configuring the connector, you can view the following additional 
resources:

• How to identify and delete duplicate CMDB CI Relationship records or ones that have orphan 
or missing parent/child relationships [KB0780988]  in the Now Support  Knowledge Base

• How to delete sys_object_source records [KB0746309 ]  in the Now Support  Knowledge Base

• Duplicate software installs with different Discovery Source [KB0958768]  in the Now Support 
Knowledge Base

• Assigned To Field Doesn't Get Updated For Computer CIs in Service Graph Connector for 
SCCM [KB1277555]  in the Now Support  Knowledge Base

• Service Graph connector for Microsoft SCCM software usages data import  blog post on the 
ServiceNow Community  site

CMDB  classes targeted in Service Graph Connector for Microsoft SCCM

When you complete setting up the connection, you can configure the integration to periodically 
pull data from Microsoft SCCM. The data is saved in tables that extend from the Configuration 
item [cmdb_ci] table.
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Computer [cmdb_ci_computer]

The following attributes in the Computer [cmdb_ci_computer] table are populated by collected 
data:

Attribute label Attribute name

Serial number serial_number

CPU core count cpu_core_count

CPU speed (MHz) cpu_speed

CPU type cpu_type

CPU manufacturer cpu_manufacturer

Name name

Asset tag asset_tag

Assigned assigned

Chassis type chassis_type

Class sys_class_name

CPU core thread cpu_core_thread

CPU count cpu_count

CPU name cpu_name

Default Gateway default_gateway

DNS Domain dns_domain

Most recent discovery last_discovered

Operating System os

OS Address Width (bits) os_address_width

OS Domain os_domain

OS Service Pack os_service_pack

OS Version os_version

RAM (MB) ram

Model ID model_id

Manufacturer manufacturer

Assigned to assigned_to

Relationships created for Computer

Parent class Relationship type Child class

Computer 
[cmdb_ci_computer]

Owns::Owned by Network Adapter 
[cmdb_ci_network_adapter]

Computer 
[cmdb_ci_computer]

Owns::Owned by IP Address 
[cmdb_ci_ip_address]
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Relationships created for Computer  (continued)

Parent class Relationship type Child class

Computer 
[cmdb_ci_computer]

Contains::Contained by Disk [cmdb_ci_disk]

Computer 
[cmdb_ci_computer]

Reference Key Value [cmdb_key_value]

Computer 
[cmdb_ci_computer]

Reference Software Installation 
[cmdb_sam_sw_install]

Computer 
[cmdb_ci_computer]

Reference SG-SCCM Computer Related 
[sn_sccm_integrate_sccm_2019_computer_related]

Disk [cmdb_ci_disk]

The following attributes in the Disk [cmdb_ci_disk] table are populated by collected data:

Attribute label Attribute name

Disk space (GB) disk_space

Size bytes size_bytes

Computer computer

Device ID device_id

Name name

Description short_description

Drive type drive_type

Manufacturer manufacturer

Model ID model_id

Relationship created for Disk

Parent class Relationship type Child class

Disk [cmdb_ci_disk] Reference Computer 
[cmdb_ci_computer]

IP Address [cmdb_ci_ip_address]

The following attributes in the IP Address [cmdb_ci_ip_address] table are populated by collected 
data:

Attribute label Attribute name

IP Address ip_address

IP version ip_version

Name name

Nic nic
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Relationship created for IP Address

Parent class Relationship type Child class

IP Address 
[cmdb_ci_ip_address]

Reference Network Adapter 
[cmdb_ci_network_adapter]

Key Value [cmdb_key_value]

The following attributes in the Key Value [cmdb_key_value] table are populated by collected data:

Attribute label Attribute name

Key key

Value value

Network Adapter [cmdb_ci_network_adapter]

The following attributes in the Network Adapter [cmdb_ci_network_adapter] table are populated 
by collected data:

Attribute label Attribute name

MAC Address mac_address

Name name

DHCP Enabled dhcp_enabled

Netmask netmask

Configuration Item cmdb_ci

Relationship created for Network Adapter

Parent class Relationship type Child class

Network Adapter 
[cmdb_ci_network_adapter]

Reference Computer 
[cmdb_ci_computer]

Serial Number [cmdb_serial_number]

The following attributes in the Serial Number [cmdb_serial_number] table are populated by 
collected data:

Attribute label Attribute name

Serial Number serial_number

Serial Number Type serial_number_type

Valid valid
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Relationship created for Serial Number

Parent class Relationship type Child class

Serial Number 
[cmdb_serial_number]

Reference Computer 
[cmdb_ci_computer]

SG-SCCM Computer Related 
[sn_sccm_integrate_sccm_2019_computer_related]

The following attributes in the SG-SCCM Computer Related 
[sn_sccm_integrate_sccm_2019_computer_related] table are populated by collected data:

Attribute label Attribute name

Resource ID resource_id

OU Name ou_name

Software [cmdb_ci_spkg]

The following attributes in the Software [cmdb_ci_spkg] table are populated by collected data:

Attribute label Attribute name

Key key

Name name

Version version

Vendor vendor

Manufacturer manufacturer

Relationship created for Software

Parent class Relationship type Child class

Software [cmdb_ci_spkg] Reference Software Instance 
[cmdb_software_instance]

Software Installation [cmdb_sam_sw_install]

The following attributes in the Software Installation [cmdb_sam_sw_install] table are populated 
by collected data when the SAM application is installed:

Attribute label Attribute name

Publisher publisher

Last scanned last_scanned

Installed on installed_on

Display name display_name

Discovery source discovery_source
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Attribute label Attribute name

Install date install_date

Prod id prod_id

Version version

Revision revision

Sccm group ID sccm_group_id

SCCM TimeStamp sccm_timestamp

Assigned to assigned_to

Relationship created for Software Installation

Parent class Relationship type Child class

Software Installation 
[cmdb_sam_sw_install]

Reference Computer 
[cmdb_ci_computer]

Software Instance [cmdb_software_instance]

The following attributes in the Software Instance [cmdb_software_instance] table are populated 
by collected data:

Attribute label Attribute name

Name name

Installed on installed_on

Install date install_date

Sccm group ID sccm_group_id

SCCM TimeStamp sccm_timestamp

Relationship created for Software Instance

Parent class Relationship type Child class

Software Instance 
[cmdb_software_instance]

Reference Computer 
[cmdb_ci_computer]

Upgrade from the legacy SCCM  plugin to the Service Graph Connector for Microsoft SCCM

Deactivate the scheduled imports and pull records so that you can upgrade from the Microsoft 
SCCM 2016 plugin or an earlier version of the plugin to the Service Graph Connector for 
Microsoft SCCM.

Before you begin
Role required: none

If you are upgrading to the Service Graph Connector for Microsoft SCCM, the following steps are 
mandatory. The steps must be executed in any instance with an existing install of the Microsoft 
SCCM 2016 plugin or with an earlier version of the plugin.
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Note: 
The Service Graph Connector for Microsoft SCCM  is an independent implementation that 
does not reuse any components from the Microsoft  SCCM 2016 plugin.

About this task
The Service Graph Connector for Microsoft SCCM  is a successor to the Microsoft  SCCM 2016 
plugin. If you already have the Microsoft  SCCM 2016 plugin or an earlier version installed in your 
instance, you must follow these steps to enable the successful transition from using the SCCM 
plugin to using the Service Graph Connector. Additionally, you can run a SG-SCCM cleanup 
to delete the Network Adapters and Disks created from the older SCCM plugin to make the 
migration faster.

When the Service Graph Connector for Microsoft SCCM  is installed in an instance, you must no 
longer run any components from the Microsoft  SCCM 2016 plugin, including Data Sources and 
Scheduled Data Imports. The SCCM 2016 plugin Scheduled Data Imports must be tuned off. The 
Service Graph Connector for Microsoft SCCM  installs a new set of SG-SCCM Data Sources and 
Scheduled Data Imports.

Warning: 
This upgrade process should be performed and validated in a non-production or test 
instance that is based on a recent clone of the customer production instance. Failure to 
first validate upgrade in a non-production instance may result in unexpected outcomes and 
possible data loss or corruption.

Any customizations to the SCCM 2016 plugin will not automatically migrate. The customizations 
would have to be reimplemented in the Service Graph Connector for Microsoft SCCM, such as 
by using IntegrationHub-ETL.

Procedure

1. Optional:  If you are migrating from the SCCM 2016 plugin, then run the Migration Readiness 
Tool for Service Graph Connector for SCCM.

(Optional) The plugin can be downloaded from the ServiceNow Store .

The tool does not migrate any changes, but runs a series of ATF tests to identify any 
customizations that were done to the legacy SCCM 2016 plugin compared to the OOB SCCM 
2016 plugin. It will not migrate the changes between the two plugins, but serves to alert any 
customizations.

2. After the tool has finished running, review the tests that were failed.
A failed test means that a customization was made in the plugin. The customization could 
be a transform map. For example, if a transform map was modified, then it needs to be 
reimplemented in the connector.

3. Deactivate the scheduled imports from the older SCCM plugin.
For more information on how to deactivate scheduled imports, see Upgrade the SCCM 
integration version .

4. Optional:  Delete duplicate OS software records in the older SCCM plugin.

Note: 
There is no cleanup required for Computer OS Software records if SAM is enabled.

a. Navigate to the Software Package or Software Instance table in the older SCCM plugin.

b. Search for the duplicate OS records that you want to delete.
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You can tell which records are the SG-SCCM software OS records if the version number is 
included in the Name or Product Name.

c. To delete the duplicate software OS records from the Software Package table, do the 
following:

i. On the Software Package table, select the duplicate OS record that does not have SG-
SCCM  in the Discovery Source  column.

ii. Delete the duplicate OS record and repeat with other records as needed.

d. To delete the duplicate software OS records from the Software Instance table, do the 
following:

i. On the Software Instance table, select the duplicate OS record that has the SCCM group 
ID  column empty.

ii. Delete the duplicate OS record and repeat with other records as needed.

Note: 
This step is optional because there is a difference in the way software OS records are 
written to the CMDB, between the legacy SCCM plugin and Service Graph Connector. 
The SCCM plugin did not record values to sys_object_source, a discovery_source, or a 
sccm_group_id.

5. After you are finished deactivating the scheduled imports and deleting the duplicate OS 
records  from the older SCCM plugin, configure the connector.
For instructions, see Configure the Service Graph Connector for Microsoft SCCM.

6. Optional:  Clean up the Disk and Network Adapter records created by the SCCM plugin.

a. Confirm that you are in the Service Graph Connector for Microsoft SCCM  application scope.

b. Navigate to Scheduled Job  > SG-SCCM CleanupUtil.

c. Select the SG-SCCM CleanupUtil  scheduled job, and then switch to the global 
application scope.

d. To make a copy of the scheduled job, right-click the header of the scheduled job and select 
Insert and Stay.

e. Change the name to SG-SCCM CleanupUtil Global.

f. Click Update.

g. When you need to run the scheduled job, click Execute Now.

h. Optional:  To check the progress of the run, do the following:

i. Navigate to System Log  > All.

ii. To filter the records for the script run, enter SG-SCCM CleanupUtil  under the 
Message  search box.
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The script will have a log message for each batch so that you know the status of the 
current run and its progress.

Note: 
The duration of the run depends on the amount of Network Adapter and Disk data in 
the CMDB  from the previous SCCM integration. The data must meet the condition for 
the cleanup.

What to do next
When you execute the Service Graph Connector  components, your existing CMDB  data created 
by the SCCM plugin becomes managed and maintained by Service Graph Connector for 
Microsoft SCCM.

Upgrade from an earlier version of Service Graph Connector for Microsoft SCCM  to the later 
version

Upgrade your Service Graph Connector for Microsoft SCCM. When you upgrade versions, you 
can select the files that you want to transfer from the earlier version to the later version of the 
Service Graph Connector for Microsoft SCCM.

Before you begin
To avoid any serious upgrade issues, perform the upgrade in a test or development instance 
prior to upgrading in a production environment.
Role required: admin

About this task
When you upgrade from an earlier version to the latest version of the Service Graph Connector 
for Microsoft SCCM, there are Skipped Updates. The original SCCM data source files that were 
installed have the last run date updated as part of the data source runs. The files will be treated 
as custom files by the platform. When the newer version is installed, the newer data sources will 
not be automatically upgraded.

After you have upgraded to the newer version, you can check the upgrade status.

Procedure

1. Review all the updates from the upgrade center and select the data source files from the newer 
version.
You can access the upgrade history and review the updates from the Skipped Changes to 
Review related list. See Review skipped records using related lists .

2. If you have customized the earlier version, select the changes that you need from the older file 
and migrate them to the new file.

Note: 
Repeat this migration process for all the other skipped update files.

What to do next
After the upgrade, if there are changes to the SQL in the data source files or mapping, then do 
the following:

1. Clear the Use last run datetime  check box in all the data sources.

2. Perform a full pull of data from all the data sources.
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Note: 
Upgrading from Service Graph Connector for Microsoft SCCM  v2.3 to v2.3.1 requires a 
minimum pull of Computer and Software, because the Source Native Key for the software 
within the SQL was changed in the SG-SCCM Removed Software data source. Without the 
correct Source Native Keys, it will not be able find the software in the CMDB.

For more information on resolving any conflicts, see the following topics:

• Revert a customization

• Resolve a skipped update and set a resolution status

• Skipped Changes to Review related list

Enable Software Editions in Service Graph Connector for Microsoft SCCM

Enable software editions so that you can gather edition information for products such as Adobe 
Acrobat, Microsoft  SQL Server, and Windows Exchange Server into the Service Graph Connector 
for Microsoft SCCM.

Before you begin
Note: 
There are two types of setup that are required, one on the SCCM Manager and the other 
on the ServiceNow  Instance. For more information on how to set up the SCCM Manager, 
see the SCCM Manager Setup section of the Custom solution to gather editions in SCCM 
[KB0721360]  article on the HI Knowledge Base. When you're finished setting up the SCCM 
Manager, refer back to this task and complete the steps.

Role required: admin

About this task
You can set up the ServiceNow  Instance on the Service Graph Connector for Microsoft SCCM.

Procedure

1. Navigate to All  > Service Graph Connector Microsoft SCCM  > Import Schedules.

2. Select the Software Edition scheduled import you created to edit this import record.

3. Select the Active  check box.

4. Click Update.

5. Navigate to Service Graph Connector Microsoft SCCM  > Data Sources.

6. Select the Software Edition data source you created.

7. Under the Transforms list, select Update software install with edition.

8. Edit the data source and select the Active  check box.

9. Click Update.

What to do next
You can verify that the edition information has been gathered by doing the following:

1. Navigate to Service Graph Connector Microsoft SCCM  > Data Sources  and the Software 
Edition data source you want to verify.

2. Select Load All Records.
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Note: 
If the displayed completion code is Success, then the software edition data source was 
executed successfully. If the displayed completion code is Error, then there is an error 
that must be fixed.

Accessing the connection details of Service Graph Connector for Microsoft SCCM

You can access the connection details of the Service Graph Connector for Microsoft SCCM  in 
a single view using the common connection framework (CCF) included within the Integration 
Commons for CMDB  (sn_cmdb_int_util) store app.

With the CCF, you can access all the connections used by the Service Graph Connector for 
Microsoft SCCM. The connection details include the connection alias, connection properties, 
data sources, and scheduled data imports associated with a connection. You can also test 
the connection. For more information, see Accessing the connection details of Service Graph 
Connectors.

Access the details of a Microsoft  SCCM connection

Access the details of a Microsoft  SCCM connection configured for the Service Graph Connector 
for Microsoft SCCM.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Service Graph Connectors  > SCCM  > Connections.

2. From the Name  column of the Service Graph Connections list, select a connection.

3. On the Service Graph Connections page, view the connection details such as the connection 
name, alias, and data sources.

4. Select a related list to view further details of the connection.

5. Optional:  Select the Test Connection  related link to test the connection.

Service Graph Connector for Netskope

The Service Graph Connector for Netskope pulls in asset inventory data (hardware and software) 
from the Netskope database into the Configuration Management Database (CMDB)  application 
in your ServiceNow AI Platform®  instance.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Supported versions

• Netskope  API version: Get Client Data v1.

• Netskope  client version: 112.

• Washington, Xanadu, Yokohama ServiceNow®  family releases.
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Use cases

• Import Netskope  Client information and store it in appropriate configuration item (CI) classes in 
your CMDB.

• Configure multiple instances of Netskope  in the Service Graph Connector.

Guided setup

Use the guided setup feature to help you configure your integration in an organized sequence of 
tasks.

CMDB  integrations dashboard

The Integration Commons for CMDB  store app provides a dashboard with a central view of 
the status, processing results, and processing errors of all installed integrations. You can see 
metrics for all integration runs. You can filter the view to a specific CMDB  integration, a specific 
time duration, or a specific integration run. For more details about monitoring SentinelOne 
integrations in the CMDB  Integrations Dashboard, see Using the CMDB Integrations Dashboard.

Configure the Service Graph Connector for Netskope

The guided setup for the Service Graph Connector for Netskope  provides an organized 
sequence of tasks to configure the integration on your ServiceNow AI Platform  instance.

Before you begin
To use this Service Graph Connector, you need a subscription to a Subscription Unit that is 
based in the IT Operations Management  (ITOM) Visibility application or in the ITOM  Discovery 
application. As defined in the section titled "Managed IT Resource Types" in ServiceNow 
Subscription Unit Overview  for your subscription, for managed IT resources that are created 
or modified in the CMDB  by this Service Graph Connector, but that aren’t yet managed by ITOM 
Visibility or ITOM Discovery , these resources will increase Subscription Unit consumption from 
that application. Review your current Subscription Unit consumption within ITOM Visibility or 
ITOM Discovery to ensure available capacity.

Dependencies and requirements:

• The Integration Commons for CMDB store app, which is automatically installed.

• The CMDB CI Class Models store app store app, which is automatically installed.

• Discovery Core plugin (com.snc.discovery.core), which is automatically installed by Discovery.

• The ITOM Discovery License plugin (com.snc.itom.discovery.license). You must activate this 
plugin.

• ITOM Licensing plugin (com.snc.itom.license). For more information, see Request Discovery.

• Guided Setup (com.sn.ads.setup).

• Data Stream (com.glide.hub.action_type.datastream).

• ITOM Patterns.

Roles required:

• Netskope  Role - Viewer

• ServiceNow AI Platform®  Role - admin
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Procedure

1. Navigate to Service Graph Connectors  > Netskope  > Setup.

2. On the Home page, select Continue.

3. On the Experience page, select the Best Experience  from it.

4. On the Service Graph Connector for Netskope  page in the Configure the connection page, 
select the Configure Netskope Authentication Credentials  task and follow these steps:

a. In the API Key field, enter your Netskope  API Key and update the credential record.

b. Select the Mark as Complete  checkbox and select Continue.

5. In the Configure Netskope  HTTP Connection  task follow these steps:

a. Add the Netskope  base URL (Uniform Resource Locator).

b. Select the Mark as Complete  checkbox and select Continue.

6. In the Test Connection  task follow these steps:

a. Select the Test Connection  link.

The Status code field displays 200  if the connection is successful.

b. Select the Mark as Complete  checkbox and select Continue.

7. Optional:  To create another connection, select the Update Data Source Access  section and 
follow these steps:

a. Give permission to create and update the data source.

b. Select the Mark as Complete  checkbox and select Continue.

c. Give permission to create and update the Scheduled Import Sets.

d. Select the Mark as Complete  checkbox and select Continue.

e. Clear the cache with the code snippet mentioned previously using Scripts-Background.

f. Select the Mark as Complete  checkbox and select Continue.

g. Add a new connection by clicking the link.

h. After you add a new connection, select the Mark as Complete  checkbox and select 
Continue.

i. Select the new connection record and select the Test Connection link.

The Status code field displays 200  if the connection is successful.

j. Select the Mark as Complete  checkbox and select Continue.

8. Fill out the fields on the Scheduled Data Import form:

Field Description

Name Name of the scheduled job.

Data source Data source record that defines the data to 
import, for example, SG-Netskope-Client.

Run as Option to run the scheduled job with the 
credentials of the specified user.

Active Option to activate the scheduled job. Select 
this option.
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Field Description

Concurrent Import Function that loads the data from multiple 
import sets. The function then processes and 
transforms the data concurrently.

Partition Method Partition method for the concurrent import 
set. Select Custom Size.

Partition Size Import set size for early scheduling. Set 1000 
as a value.

Execute pre-import script Option to specify a script to run before the 
import is performed. Leave this field with its 
default setting.

Execute post-import script Option to specify a script to run after the 
import is performed. Leave this field with its 
default setting.

Application Application that contains this scheduled job.

Run Frequency of running the import.

Conditional Conditions under which this job is executed.

9. Click Execute Now.

10. In the Help task bar, select Mark as Complete  and select Continue.

Service Graph Connector for Observability - AppDynamics

Use the Service Graph Connector for Observability - AppDynamics  to ingest CMDB  data from 
an AppDynamics  installation using REST APIs. Push events from AppDynamics  into ServiceNow 
with Event Management.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Supported versions

• Supported versions: AppDynamics  version 20.3

• Supported ServiceNow  versions:

◦ Washington DC

◦ Xanadu

◦ Yokohama

◦ Zurich

Configuring a connection for the connector

You can configure a connection for the connector by using the SGC Central  view in the CMDB 
Workspace  enables you to discover and install connectors, and then effectively manage the 
full life cycle of creating, editing, monitoring, and debugging connections. To configure the 
connector using SGC Central, see Configure Service Graph Connector for Observability - 
AppDynamics using SGC Central.
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Important: 
Unless there are configuration issues, use the SGC Central  view in the CMDB Workspace 
to configure the connection for the connector, as the guided setup method is being 
deprecated.

CMDB integrations dashboard

The Integration Commons for CMDB  store app provides a dashboard with a central view of 
the status, processing results, and processing errors of all installed integrations. You can see 
metrics for all integration runs. You can filter the view to a specific CMDB  integration, a specific 
time duration, or a specific integration run. For more details about monitoring AppDynamics 
integrations in the CMDB  Integrations Dashboard, see Using the CMDB Integrations Dashboard.

Data mapping

Data from the AppDynamics  data sources is mapped and transformed into the ServiceNow 
CMDB  Configuration Item (CI) class definitions using the Robust Transform Engine (RTE). Data is 
inserted into the ServiceNow  CMDB  using the Identification and Reconciliation Engine (IRE).

The AppDynamics  data sources include the following:

• SG-AppDynamics Application Services

• SG-AppDynamics Servers and Applications

• SG-AppDynamics Server Tags

• SG-AppDynamics Tier to Tier Relationship

For more information on where data is saved when pulling data from AppDynamics, see CMDB 
classes targeted in Service Graph Connector for Observability - AppDynamics.

You can use the IntegrationHub ETL app to view the data maps. See IntegrationHub ETL  for more 
information.

Additional resources

• Service Graph Connector for Observability AppDynamics  article on the ServiceNow 
Community  site

• How do I configure the AppDynamics Service Graph Connector?  article on the ServiceNow 
Community  site

Related topics

Service Graph Connectors

Configure Service Graph Connector for Observability - AppDynamics  using SGC Central

Set up scheduled import jobs to pull in AppDynamics  data into your Configuration Management 
Database (CMDB).

Before you begin

• Install Service Graph Connector for Observability - AppDynamics  version 1.4.0 or later from 
the ServiceNow Store. For ServiceNow Store  installation steps, see Install a ServiceNow Store 
application .

• Install Observability Commons for CMDB  (sn_observability), which is only required for 
event ingestion. This application must be installed prior to installing the connector for Event 
Management to work. For more information, see Observability Commons for CMDB  on the 
ServiceNow Store.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1208

https://www.servicenow.com/community/cmdb-blog/service-graph-connector-for-observability-appdynamics/ba-p/2275530
https://www.servicenow.com/community/cmdb-blog/service-graph-connector-for-observability-appdynamics/ba-p/2275530
https://www.servicenow.com/community/cmdb-blog/service-graph-connector-for-observability-appdynamics/ba-p/2275530
https://www.servicenow.com/community/architect-articles/appdynamics-service-graph-connector/ta-p/2623395
https://www.servicenow.com/community/architect-articles/appdynamics-service-graph-connector/ta-p/2623395
https://www.servicenow.com/community/architect-articles/appdynamics-service-graph-connector/ta-p/2623395
https://www.webstg.servicenow.com/docs/access?context=t_InstallApplications&version=washingtondc&pubname=washingtondc-application-development&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=t_InstallApplications&version=washingtondc&pubname=washingtondc-application-development&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=t_InstallApplications&version=washingtondc&pubname=washingtondc-application-development&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=t_InstallApplications&version=washingtondc&pubname=washingtondc-application-development&ft:locale=en-US
https://store.servicenow.com/sn_appstore_store.do#!/store/application/97e04562072020107add6a77c4a9351a
https://store.servicenow.com/sn_appstore_store.do#!/store/application/97e04562072020107add6a77c4a9351a
https://store.servicenow.com/sn_appstore_store.do#!/store/application/97e04562072020107add6a77c4a9351a


Role required: cmdb_inst_admin or admin

About this task
The playbook experience for onboarding connectors is activated with SGC Central  in the CMDB 
Workspace. To configure the SGC Central  application, see Configuring SGC Central  and for more 
information on how to interact with a playbook, see Interact with Playbook .

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the CMDB Workspace, select SGC Central.

3. On the Overview page, select Create connection.

Tip: 
Alternatively, you can select Create connection  on the All connections page.

4. On the Create connection window, select the AppDynamics  connector type, and then select 
Configure connection.
A default connection for AppDynamics  is available within the application. As the Service Graph 
Connector for Observability - AppDynamics  supports only a single instance, you can configure 
the default connection for the first time or resume editing it thereafter.

5. Complete the initial prerequisites when setting up a connection for the first time using a 
connector.

Note: 
This step is required only during the first-time setup. See Perform initial setup tasks when 
creating a connection in SGC Central.

6. Enter connection details and test the API connection for importing AppDynamics  data.

a. In the Setup  stage of the playbook, select the Configure and test connection  activity.

b. On the form, fill in the fields.

Configure and test connection form

Field Description

Connection name Name to identify the AppDynamics 
connection record.

Connection URL Base URL of your AppDynamics  controller.

OAuth Client ID Application (client) ID of your AppDynamics 
client application.

Note: 
Verify that Server Visibility is active 
for the AppDynamics  account and 
the AppDynamics  user has the 
Applications and Dashboards Viewer 
(Default) and Server Monitoring User 
(Default) roles.
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Field Description

OAuth Client Secret Client secret of your AppDynamics  client 
application.

Use MID server Option to use a MID Server.

Note: 
Use of a MID Server is optional.

MID selection Name of the MID Server used by the 
connector.

This field appears only when the Use MID 
server  check box is selected.

c. Select Update and test connection.

d. Once the connection test is complete, select Continue.

7. Optional:  Enable real-time event integration by creating an HTTP request template to receive 
real-time health-check alerts and events from AppDynamics  to your ServiceNow  instance.

Note: 
To skip this step, select Skip  for the Enable real-time event integration  activity.

a. In the Setup  stage of the playbook, select the Enable real-time event integration  activity.

b. Select Continue  to create an HTTP request template automatically.

(Optional) After you enable real-time event integration, multiple API calls are executed to 
start the event ingestion service in AppDynamics. For more information, see the Service 
Graph Connector for Observability AppDynamics  article on the ServiceNow Community 
site.

8. Configure duplicate detection rules.

AppDynamics  uses duplicate detection rules to insert only new or updated rows into the 
CMDB. To insert all rows, deactivate the rule and run the Clean AppDynamics Duplicate Row 
Hashes  scheduled job for a full data import.

a. In the Setup  stage of the playbook, select the Configure duplicate detection rules  activity.

b. In the Duplicate detection rules list, select the rule from the Name  column.

c. On the Edit duplicate detection rule  window, select the Active  check box to activate the rule.

Note: 
To remove fields from being evaluated, add the field names in the Ignore Fields  field for 
a rule. To ignore multiple fields, separate the fields with commas.

d. Select Save.
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e. Repeat steps from 8.b  to 8.d  for each rule you want to activate.

f. Select Continue.

9. Configure the import schedule to import data at regular intervals.

a. In the Setup  stage of the playbook, select the Configure import schedule  activity.

b. Expand the Parent scheduled data import within the Import schedules list to select the SG-
AppDynamics Servers and Applications  import schedule.

c. Select the Active  check box, and then fill in the run schedule and time details.

For more information, see Schedule a data import .

d. Select Save.
Alternatively, select Execute Now  to execute the import schedule immediately.

e. Select Continue.

10. In the Setup  stage of the playbook, select the Confirm connection setup  activity to verify 
whether the connection was configured.

What to do next
Select View all connections  to review the connection details. The configured connection 
appears in the Installed connections list.

Related topics

Service Graph Connector for Observability - AppDynamics

CMDB classes targeted in Service Graph Connector for Observability - AppDynamics

Accessing the connection details of Service Graph Connector for Observability - 
AppDynamics

Configure Service Graph Connector for Observability - AppDynamics  using the guided setup

Set up scheduled import jobs to pull in data from AppDynamics  into your Configuration 
Management Database (CMDB).

Before you begin
Important: 
Unless there are configuration issues, use the SGC Central  view in the CMDB Workspace 
to configure the connection for the connector, as the guided setup method is being 
deprecated.

To use this Service Graph Connector, you need a subscription to a Subscription Unit that is 
based in the IT Operations Management  (ITOM) Visibility application or in the ITOM  Discovery 
application. As defined in the section titled "Managed IT Resource Types" in ServiceNow 
Subscription Unit Overview  for your subscription, for managed IT resources that are created 
or modified in the CMDB  by this Service Graph Connector, but that aren’t yet managed by ITOM 
Visibility or ITOM Discovery , these resources will increase Subscription Unit consumption from 
that application. Review your current Subscription Unit consumption within ITOM Visibility or 
ITOM Discovery to ensure available capacity.
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Dependencies and requirements:

• The Integration Commons for CMDB  store app, which is automatically installed.

• The CMDB CI class models store app, which is automatically installed. See CMDB CI Class 
Models store app.

• The ITOM Discovery License plugin (com.snc.itom.discovery.license). You must activate this 
plugin.

• ITOM Licensing plugin (com.snc.itom.license). For more information, see Request Discovery .

• The Datastream Action plugin (com.glide.hub.action_type.datastream), which is automatically 
installed.

• Observability Commons for CMDB  (sn_observability), which is only required for event 
ingestion. This must be installed prior to installing the connector for Event Management to 
work. For more information, see Observability Commons for CMDB  on the ServiceNow Store.

When using client credentials for authentication, obtain the OAuth credentials from your 
AppDynamics  administrator. Make a note of the following details:

• Application (client) ID

• Client Secret

Note: 
If you have an earlier version of the Service Graph Connector for Observability - 
AppDynamics, then do not migrate data from the old connector. You must uninstall the 
previous version and run the new integration.

Role required: admin

Procedure

1. Ensure that the application scope is set to the Service Graph Connector for Observability - 
AppDynamics  application by using the application picker.
For more information, see Application picker .

2. Navigate to All  > Service Graph Connectors  > AppDynamics  > Setup.

3. On the Getting started page, select Get Started.

4. Configure the authentication credentials and establish an HTTP connection to send requests 
to the AppDynamics  API.

a. In the Configure API authentication  section of the Service Graph Connector for Observability 
- AppDynamics  page, select Get Started.

b. Configure the connection for AppDynamics  by editing the default connection.

You can configure either a Basic Auth connection or an OAuth connection.

Note: 
As the connector supports only single instance, edit the 
AppDynamicsConnectionAlias  connection, available by default.

▪ Configure a Basic Auth connection.

i. For the Configure Basic Auth Connection  task, select Configure.

ii. Select Edit  for AppDynamicsConnectionAlias.
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Note: 
If not redirected to the connection setup, search for 
AppDynamicsConnectionAlias  on the Integrations page, and then select View 
Details  to edit the default connection.

iii. In the Connection Information section of the Edit Connection window, fill in the fields.

Connection Information

Field Description

Connection name Name to identify the AppDynamics 
connection record.

AppDynamicsConnectionAlias  is 
the default credential alias name and is 
read-only.

Host name Host name of your AppDynamics 
controller.

iv. (Optional) If a MID Server is required for the AppDynamics  server connection, select the 
Use MID server  check box. Then, select the MID Server-related fields accordingly.

v. In the Credential Information section of the Edit Connection window, fill in the fields.

Credential Information

Field Description

Username AppDynamics  account user name that 
is used to authenticate the connection 
request.

Note: 
Verify that Server Visibility is active 
for the AppDynamics  account and 
the AppDynamics  user has the 
Applications and Dashboards Viewer 
(Default) and Server Monitoring User 
(Default) roles.

Password Password that is used to authenticate the 
connection request.

vi. Select Edit Connection.

vii. Return to the guided setup page.

viii. Set the Configure Basic Auth Connection  task to complete by selecting Mark as 
Complete.

▪ Configure an OAuth connection.

i. For the Configure OAuth Authentication: Client Credentials  task, select Configure.

ii. Select Edit  for AppDynamicsConnectionAlias.
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Note: 
If not redirected to the connection setup, search for 
AppDynamicsConnectionAlias  on the Integrations page, and then select View 
Details  to edit the default connection.

iii. In the Connection Information section of the Edit Connection window, fill in the fields.

Connection Information

Field Description

Connection name Name to identify the AppDynamics 
connection record.

AppDynamicsConnectionAlias  is 
the default credential alias name and is 
read-only.

Connection URL Base URL of your AppDynamics  controller.

iv. (Optional) If a MID Server is required for the AppDynamics  server connection, select the 
Use MID server  check box. Then, select the MID Server-related fields accordingly.

v. In the Credential Information section of the Edit Connection window, fill in the fields.

Credential Information

Field Description

OAuth Client ID Application (client) ID of your 
AppDynamics  client application as noted 
in the Before you begin  section.

Note: 
Verify that the API client has a role 
with the required privileges and 
sufficient Token Expiration Time.

OAuth Client Secret Client secret of your AppDynamics  client 
application as noted in the Before you 
begin  section.

vi. Select Edit Connection.

vii. Return to the guided setup page.

viii. Set the Configure OAuth Authentication: Client Credentials  task to complete by 
selecting Mark as Complete.

c. Test the connection.

i. For the Test connection  task, select Configure.

ii. Select the Test Connection  related link to start the testing process.

iii. When the Status  field is set to Success, return to the guided setup page.
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Note: 
If any of the tests have errors, follow the suggestions for remediation.

iv. Set the Test the connection  task to complete by selecting Mark as Complete.

d. Enable AppDynamics  event integration with your ServiceNow  instance by pushing a default 
HTTP Request Template to AppDynamics.

Note: 
To push HTTP requests, verify that the Observability Commons for CMDB application 
(sn_observability) is installed for events ingestion on your ServiceNow  instance. Also, 
on your AppDynamics  instance, as the ServiceNow  user, you must have the account-
level Configure HTTP Request Templates permission to create or modify HTTP Request 
Templates.

i. For the Push HTTP Request Template  task, select Configure.

ii. Select the Push HTTP Request Template  related link.

iii. Return to the guided setup page.

iv. Set the Push HTTP Request Template  task to complete by selecting Mark as Complete.

After you push the HTTP request template, multiple API calls are executed to start the event 
ingestion service in AppDynamics. For more information, see the Service Graph Connector 
for Observability AppDynamics  article on the ServiceNow Community  site.

5. Configure duplicate detection rules.

a. For the Configure duplicate detection rules  task in the Duplicate detection rules  section, 
select Configure.

b. In the CMDB Duplicate Row Rules list, set the Active  column value for a rule to true  to 
activate the rule.

Note: 
To remove fields from being evaluated, add the field names in the Ignore Fields  column 
for a rule. To ignore multiple fields, separate the fields with commas.

c. Return to the guided setup page.

d. Set the Configure duplicate detection rules  task to complete by selecting Mark as 
Complete.

6. Configure advanced settings.

a. For the Advanced Settings  task in the Advanced  section, select Configure.

b. Review and modify the advanced properties.
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Advanced properties

Property Description

Toggle to populate relationships between 
tiers

Option to enable the import of relationships 
between AppDynamics  tiers in the CI 
Relationship [cmdb_rel_ci] table.

The number of minutes of metrics to fetch in 
order to generate tier to tier relationships

Number of minutes of metrics to fetch 
for generating tier-to-tier relationships. 
For example, 60  retrieves the last hour's 
relationships.

Toggle to import business transactions from 
AppDynamics

Option to enable the import of business 
transactions into the Calculated Application 
Service [cmdb_ci_service_calculated] table.

Toggle to populate tags for imported servers Option to enable the import of server tags 
into the Key Value [cmdb_key_value] table.

Toggle to import node data from 
AppDynamics  and map to the cmdb_ci_appl 
hierarchy

Option to enable the import of nodes 
into the Application [cmdb_ci_appl] table 
hierarchy.

c. Select Save.

d. Set the Advanced Settings  task to complete by selecting Mark as Complete.

7. Set up the SG-AppDynamics Servers and Applications scheduled job available by default.

a. For the Configure scheduled job  task in the Set up scheduled import jobs  section, select 
Configure.

b. On the Scheduled Data Import form, verify the field values for the SG-AppDynamics Servers 
and Applications scheduled job and select the Active  check box.

For more information, see Schedule a data import .

c. Select Update.

d. Set the Configure scheduled job  task to complete by selecting Mark as Complete.

CMDB  classes targeted in Service Graph Connector for Observability - AppDynamics

When you complete setting up the connection, you can configure the integration to periodically 
pull data from AppDynamics. The data is saved in tables that extend from the Configuration item 
[cmdb_ci] table.

AppDynamics Extension [sn_sg_appd_extension]

The following attributes in the AppDynamics Extension [sn_sg_appd_extension] table are 
populated by collected data:

Attribute label Attribute name

AppDynamics ID appdynamics_id
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Attribute label Attribute name

Controller Name controller_name

Agent Type agent_type

Type type

Application [cmdb_ci_appl]

The following attributes in the Application [cmdb_ci_appl] table are populated by collected data:

Attribute label Attribute name

Class sys_class_name

Name name

Running process command running_process_command

Relationships created for Application

Parent class Relationship type Child class

Application [cmdb_ci_appl] Runs on::Runs Server [cmdb_ci_server]

Application [cmdb_ci_appl] Reference AppDynamics Extension 
[sn_sg_appd_extension]

Calculated Application Service [cmdb_ci_service_calculated]

The following attributes in the Calculated Application Service [cmdb_ci_service_calculated] table 
are populated by collected data:

Attribute label Attribute name

Name name

Hide from dashboard hide_from_dashboard

Metadata metadata

Operational status operational_status

Service Populator Status populator_status

Service Populator service_populator

Service Type type

Short Description short_description

Relationships created for Calculated Application Service

Parent class Relationship type Child class

Calculated 
Application Service 
[cmdb_ci_service_calculated]

Depends on::Used by Application [cmdb_ci_appl]
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Relationships created for Calculated Application Service  (continued)

Parent class Relationship type Child class

Calculated 
Application Service 
[cmdb_ci_service_calculated]

Depends on::Used by Server [cmdb_ci_server]

Calculated 
Application Service 
[cmdb_ci_service_calculated]

Depends on::Used by Calculated 
Application Service 
[cmdb_ci_service_calculated]

IP Address [cmdb_ci_ip_address]

The following attributes in the IP Address [cmdb_ci_ip_address] table are populated by collected 
data:

Attribute label Attribute name

IP Address ip_address

Nic nic

IP version ip_version

Name name

Relationship created for IP Address

Parent class Relationship type Child class

IP Address 
[cmdb_ci_ip_address]

Reference Network Adapter 
[cmdb_ci_network_adapter]

Key Value [cmdb_key_value]

The following attributes in the Key Value [cmdb_key_value] table are populated by collected data:

Attribute label Attribute name

Key key

Value value

Network Adapter [cmdb_ci_network_adapter]

The following attributes in the Network Adapter [cmdb_ci_network_adapter] table are populated 
by collected data:

Attribute label Attribute name

MAC Address mac_address

Name name

Discovery source discovery_source
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Relationship created for Network Adapter

Parent class Relationship type Child class

Network Adapter 
[cmdb_ci_network_adapter]

Reference Server [cmdb_ci_server]

Server [cmdb_ci_server]

The following attributes in the Server [cmdb_ci_server] table are populated by collected data:

Attribute label Attribute name

Name name

Relationships created for Server

Parent class Relationship type Child class

Server [cmdb_ci_server] Owns::Owned by IP Address 
[cmdb_ci_ip_address]

Server [cmdb_ci_server] Owns::Owned by Network Adapter 
[cmdb_ci_network_adapter]

Server [cmdb_ci_server] Reference Key Value [cmdb_key_value]

Accessing the connection details of Service Graph Connector for Observability - 
AppDynamics

You can access the connection details of the Service Graph Connector for Observability - 
AppDynamics  in a single view using the common connection framework (CCF) included within 
the Integration Commons for CMDB  (sn_cmdb_int_util) store app.

With the CCF, you can access all the connections used by the Service Graph Connector for 
Observability - AppDynamics. The connection details include the connection alias, connection 
properties, data sources, and scheduled data imports associated with a connection. You can 
also test the connection. For more information, see Accessing the connection details of Service 
Graph Connectors.

Access the details of an AppDynamics  connection

Access the details of an AppDynamics  connection configured for the Service Graph Connector 
for Observability - AppDynamics.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Service Graph Connectors  > AppDynamics  > Connections.

2. From the Name  column of the Service Graph Connections list, select a connection.

3. On the Service Graph Connections page, view the connection details such as the connection 
name, alias, and data sources.

4. Select a related list to view further details of the connection.

5. Optional:  Select the Test Connection  related link to test the connection.
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Service Graph Connector for Observability - Datadog

Use the Service Graph Connector for Observability - Datadog  to ingest CMDB  data from a 
Datadog  installation using REST APIs. Push events from Datadog  into ServiceNow  with Event 
Management.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Supported versions

Supported ServiceNow  versions:

• Washington DC

• Xanadu

• Yokohama

Guided setup

The guided setup for the Service Graph Connector for Observability - Datadog  provides an 
organized sequence of tasks to configure the integration on your instance. To access the guided 
setup, see Configure Service Graph Connector for Observability - Datadog using guided setup.

[store-future: BEGIN review]

Configuring a connection for the connector

You can configure a connection for the connector by using the SGC Central  view in the CMDB 
Workspace  enables you to discover and install connectors, and then effectively manage the 
full life cycle of creating, editing, monitoring, and debugging connections. To configure the 
connector using SGC Central, see Configure Service Graph Connector for Observability - 
Datadog using SGC Central.

Important: 
Unless there are configuration issues, use the SGC Central  view in the CMDB Workspace 
to configure the connection for the connector, as the guided setup method is being 
deprecated.

[End]

CMDB integrations dashboard

The Integration Commons for CMDB  store app provides a dashboard with a central view of the 
status, processing results, and processing errors of all installed integrations. You can see metrics 
for all integration runs. You can filter the view to a specific CMDB  integration, a specific time 
duration, or a specific integration run. For more details about monitoring Observability Datadog 
integrations in the CMDB  Integrations Dashboard, see Using the CMDB Integrations Dashboard.

Data mapping

Data from the Datadog  data sources is mapped and transformed into the ServiceNow  CMDB 
Configuration Item (CI) class definitions using the Robust Transform Engine (RTE). Data is 
inserted into the ServiceNow  CMDB  using the Identification and Reconciliation Engine (IRE).
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The Datadog  data source includes SGO-Datadog Hosts  [sn_datadog_integra_datadog_hosts].

For more information on where data is saved when pulling data from Datadog, see CMDB classes 
targeted in Service Graph Connector for Observability - Datadog.

When you complete setting up the connection, the data from Datadog  is automatically loaded 
into staging tables and then inserted into the following target tables:

• Cloud DataBase [cmdb_ci_cloud_database]

• Cloud Load Balancer [cmdb_ci_cloud_load_balancer]

• Cloud Service Account [cmdb_ci_cloud_service_account]

• IP Address [cmdb_ci_ip_address]

• Key Value [cmdb_key_value]

• Logical Datacenter [cmdb_ci_logical_datacenter]

• Network Adapter [cmdb_ci_network_adapter]

• Server [cmdb_ci_server]

You can use the IntegrationHub ETL app to view the data maps. See IntegrationHub ETL  for more 
information.

Related topics

Service Graph Connectors

Configure Service Graph Connector for Observability - Datadog using SGC Central

Configure Service Graph Connector for Observability - Datadog using guided setup

CMDB classes targeted in Service Graph Connector for Observability - Datadog

Accessing the connection details of Service Graph Connector for Observability - Datadog
[store-future: BEGIN review]

Configure Service Graph Connector for Observability - Datadog  using SGC Central

Set up scheduled import jobs to pull in Datadog  data into your Configuration Management 
Database (CMDB).

Before you begin

• Install Service Graph Connector for Observability - Datadog  version 1.3.0 or later from the 
ServiceNow Store. For ServiceNow Store  installation steps, see Install a ServiceNow Store 
application .

• Install the Observability Commons for CMDB  application (sn_observability), which is only 
required for event ingestion. This application must be installed prior to installing the connector 
for Event Management to work. For more information, see Observability Commons for CMDB
on the ServiceNow Store.

Role required: cmdb_inst_admin or admin

About this task
The playbook experience for onboarding connectors is activated with SGC Central  in the CMDB 
Workspace. To configure the SGC Central  application, see Configuring SGC Central  and for more 
information on how to interact with a playbook, see Interact with Playbook .
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Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the CMDB Workspace, select SGC Central.

3. On the Overview page, select Create connection.

Tip: 
Alternatively, you can select Create connection  on the All connections page.

4. On the Create connection window, select the Datadog  connector type, and then select 
Configure connection.
A default connection, SGO-Datadog Connection, for Datadog  is available within the 
application. As the Service Graph Connector for Observability - Datadog  supports only a 
single instance, you can configure the default connection for the first time or resume editing it 
thereafter.

5. Install the Observability Commons for CMDB  application (sn_observability) for event ingestion.

Note: 
The Install Observability Commons for CMDB  activity appears only when the 
Observability Commons for CMDB  application (sn_observability) isn't already installed. If 
event ingestion isn't needed, you can skip this step by selecting Continue  for the Install 
Observability Commons for CMDB  activity.

a. In the Prerequisites  stage of the playbook, select the Install Observability Commons for 
CMDB  activity.

b. Install the Observability Commons for CMDB  application (sn_observability) from the 
ServiceNow Store.

c. After you have installed the application, select Continue.

6. Enter connection details and test the API connection for importing Datadog  data.

a. In the Setup  stage of the playbook, select the Create and test connection  activity.

b. On the form, fill in the fields.

Configure and test connection form

Field Description

Connection name Name to identify the Datadog  connection 
record.

Connection URL Base URL for the Datadog  API endpoint.

API key Datadog  API token.

Application key Datadog  application key that works together 
with the API key to provide user-level 
authentication.

c. Select Update and test connection.

d. Once the connection test is complete, select Continue.

7. Optional:  Configure the connector properties to access resources.
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Note: 
To skip this step, select Continue  for the Set configuration properties  activity.

a. In the Setup  stage of the playbook, select the Set configuration properties  activity.

b. In the Hosts filter  field, enter host tags in the key:value  format to import data only from 
hosts that match the specified tags in Datadog.

Note: 
For multiple entries, separate the tags with commas. Example: 
datadog:monitored,env:production.

In the example, the filter includes monitored hosts in the key:value  format as 
datadog:monitored  and env:production. Therefore, the data from only these 
hosts with matching tags are imported.

c. Select Continue.

8. Optional:  Fetch monitors from Datadog  to use the webhook for sending updates to your 
ServiceNow  instance.

Note: 
This step appears only when the Observability Commons for CMDB  application 
(sn_observability) is installed on your instance. To skip this step, select Skip  for the 
Configure observability  activity.

a. In the Setup  stage of the playbook, select the Configure observability  activity.

b. To fetch all the monitors from the Datadog  environment, select Fetch monitors.

c. After fetching the Datadog  monitors, select the check boxes next to the monitor names in the 
Datadog  monitors section and then mark them as active by selecting Mark as active.
In the table of fetched monitors, the active monitors are set to true, and inactive monitors are 
set to false  in the Webhook Active  cell for that monitor.

Note: 

▪ At least one Datadog  monitor must be active for observability to work.

▪ To exclude a monitor, double-click the value in the Webhook Active  cell for that 
monitor in the table of fetched monitors, select false  (if it is currently set to true), and 
then select OK.

▪ Any update in the Webhook Active  value is synced between ServiceNow  and 
Datadog.

d. When at least one monitor is set to true, select Continue  for the Configure observability 
activity.

9. Configure the import schedule to import data at regular intervals.

a. In the Setup  stage of the playbook, select the Configure import schedule  activity.

b. Expand the Parent scheduled data import within the Import schedules list and select the 
SGO Datadog - Hosts  import schedule.
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c. Select the Active  check box, and then fill in the run schedule and time details.

For more information, see Schedule a data import .

d. Select Save.
Alternatively, select Execute Now  to execute the import schedule immediately.

e. Select Continue.

10. In the Setup  stage of the playbook, select the Confirm connection creation  activity to verify 
whether the connection was configured.

What to do next
Select View all connections  to review the connection details. The created connection appears in 
the Installed connections list.

Related topics

Service Graph Connector for Observability - Datadog

CMDB classes targeted in Service Graph Connector for Observability - Datadog

Accessing the connection details of Service Graph Connector for Observability - Datadog
[End]

Configure Service Graph Connector for Observability - Datadog[store-future: BEGIN review] 
using guided setup[End]

Pull in data from Datadog  into your Configuration Management Database (CMDB).

Before you begin
To use this Service Graph Connector, you need a subscription to a Subscription Unit that is 
based in the IT Operations Management  (ITOM) Visibility application or in the ITOM  Discovery 
application. As defined in the section titled "Managed IT Resource Types" in ServiceNow 
Subscription Unit Overview  for your subscription, for managed IT resources that are created 
or modified in the CMDB  by this Service Graph Connector, but that aren’t yet managed by ITOM 
Visibility or ITOM Discovery , these resources will increase Subscription Unit consumption from 
that application. Review your current Subscription Unit consumption within ITOM Visibility or 
ITOM Discovery to ensure available capacity.

Dependencies and requirements:

• The Integration Commons for CMDB  store app, which is automatically installed.

• The CMDB CI class models store app, which is automatically installed. See CMDB CI Class 
Models store app.

• The ITOM Discovery License plugin (com.snc.itom.discovery.license). You must activate this 
plugin.

• ITOM Licensing plugin (com.snc.itom.license). For more information, see Request Discovery .

• The Datastream Action plugin (com.glide.hub.action_type.datastream), which is automatically 
installed.

• Observability Commons for CMDB  (sn_observability), which is only required for event 
ingestion. This must be installed prior to installing the connector for Event Management to 
work. For more information, see Observability Commons for CMDB  on the ServiceNow Store.
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Note: 
If you have an earlier version of the Service Graph Connector for Observability - Datadog, 
then don’t migrate data from the old connector. You must uninstall the previous version and 
run the new integration.

Role required: admin

Procedure

1. Navigate to All  > Service Graph Connectors  > Observability Datadog  > Setup.

2. On the Getting started page, select Get Started.

3. Configure the authentication credentials and the host name to send requests to the Datadog 
API.

a. Configure your Datadog  credentials.

i. In the Configure the Connection  section of the Datadog Integration with CMDB  page, 
select Get Started.

ii. For the Configure the Credentials  task, select Configure.

iii. In the Connection name  field, enter a name for the connection.

Note: 
Do not modify the name of the default connection.

iv. In the Connection URL  field, enter the base URL or IP address for Datadog.

v. In the API key  field, enter the Datadog  API token.

vi. In the Application key  field, enter the application key  used for connecting to the Datadog 
API.

vii. Select Update.

viii. Set the Configure the Credentials  task to complete by selecting Mark as Complete.

b. Test the connection.

i. For the Test Connection  task, select Configure.

ii. Test the connection by selecting the Test Connection  related link.

Testing the connection might take a few moments. The page is refreshed to show the test 
results.

iii. When the Status  field is set to Success, select Update.

If any of the tests have errors, follow the suggestions for remediation.

iv. Set the Test Connection  task to complete by selecting Mark as complete.

c. Optional:  Add a filter for the SGO-Datadog Hosts  [sn_datadog_integra_datadog_hosts] data 
source.

i. For the Create Hosts Filter  task, select Configure.

ii. Enter a comma-separated list of host tags in key:value  format in the Value  field to 
define a filter for pulling host data from Datadog.

For example, datadog:monitored,env:production.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1225



iii. Select Update.

iv. Set the Create Hosts Filter  task to complete by selecting Mark as complete.

4. Configure the webhook and monitors for Observability Datadog.

a. In the Configure Observability  section of the Datadog Integration with CMDB  page, select 
Get started.

b. For the Configure the Webhooks and Monitors  task, select Configure.

c. In the Datadog Webhooks list, select New  to add a Datadog  webhook.

d. Fill in the fields.

New record form

Field Description

Name Name of the Datadog  webhook.

Connection 
Alias

Search for and select the connection and credential alias that you created 
in step 3.

e. Select Submit.

f. Populate the Datadog Webhooks list by selecting the Synchronize Monitors  related link on 
the Datadog Webhook page.

Note: 
In the Datadog Webhooks list, don't select New  to add a monitor as this option is not 
used in this scenario.

g. In the Name  column of the Datadog Webhooks list, select a monitor.

h. On the Datadog Monitors page, select the Webhook Active  check box, and then select 
Update.

i. Repeat steps 4.g  and 4.h  for all the monitors in the Datadog Webhooks list.

j. On the Datadog Webhook page, select Update  to save your changes.

k. Set the Configure the Webhooks and Monitors  task to complete by selecting Mark as 
Complete.

Related topics

Service Graph Connector for Observability - Datadog

CMDB classes targeted in Service Graph Connector for Observability - Datadog

Accessing the connection details of Service Graph Connector for Observability - Datadog
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CMDB  classes targeted in Service Graph Connector for Observability - Datadog

When you complete setting up the connection, the data is automatically pulled from Datadog. 
The data is saved in target tables.

Cloud DataBase [cmdb_ci_cloud_database]

The following attributes in the Cloud DataBase [cmdb_ci_cloud_database] table are populated by 
collected data:

Attribute label Attribute name

Object ID object_id

Fully qualified domain name fqdn

Name name

Type type

Version version

Relationships created for Cloud DataBase

Parent class Relationship type Child class

Cloud DataBase 
[cmdb_ci_cloud_database]

Hosted on::Hosts Logical Datacenter 
[cmdb_ci_logical_datacenter]

Cloud DataBase 
[cmdb_ci_cloud_database]

Reference Key Value [cmdb_key_value]

Cloud Load Balancer [cmdb_ci_cloud_load_balancer]

The following attributes in the Cloud Load Balancer [cmdb_ci_cloud_load_balancer] table are 
populated by collected data:

Attribute label Attribute name

Name name

Object ID object_id

Relationships created for Cloud Load Balancer

Parent class Relationship type Child class

Cloud Load Balancer 
[cmdb_ci_cloud_load_balancer]

Hosted on::Hosts Logical Datacenter 
[cmdb_ci_logical_datacenter]

Cloud Load Balancer 
[cmdb_ci_cloud_load_balancer]

Reference Key Value [cmdb_key_value]

Cloud Service Account [cmdb_ci_cloud_service_account]

The following attributes in the Cloud Service Account [cmdb_ci_cloud_service_account] table are 
populated by collected data:
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Attribute label Attribute name

Account Id account_id

Name name

Object ID object_id

Datacenter Type datacenter_type

IP Address [cmdb_ci_ip_address]

The following attributes in the IP Address [cmdb_ci_ip_address] table are populated by collected 
data:

Attribute label Attribute name

IP Address ip_address

Nic nic

Name name

Relationship created for IP Address

Parent class Relationship type Child class

IP Address 
[cmdb_ci_ip_address]

Reference Network Adapter 
[cmdb_ci_network_adapter]

Key Value [cmdb_key_value]

The following attributes in the Key Value [cmdb_key_value] table are populated by collected data:

Attribute label Attribute name

Key key

Value value

Logical Datacenter [cmdb_ci_logical_datacenter]

The following attributes in the Logical Datacenter [cmdb_ci_logical_datacenter] table are 
populated by collected data:

Attribute label Attribute name

Name name

Object ID object_id

Region region
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Relationship created for Logical Datacenter

Parent class Relationship type Child class

Logical Datacenter 
[cmdb_ci_logical_datacenter]

Hosted on::Hosts Cloud Service Account 
[cmdb_ci_cloud_service_account]

Network Adapter [cmdb_ci_network_adapter]

The following attributes in the Network Adapter [cmdb_ci_network_adapter] table are populated 
by collected data:

Attribute label Attribute name

Configuration Item cmdb_ci

MAC Address mac_address

Name name

Relationship created for Network Adapter

Parent class Relationship type Child class

Network Adapter 
[cmdb_ci_network_adapter]

Reference Server [cmdb_ci_server]

Server [cmdb_ci_server]

The following attributes in the Server [cmdb_ci_server] table are populated by collected data:

Attribute label Attribute name

Class sys_class_name

CPU core thread cpu_core_thread

CPU count cpu_count

CPU speed (MHz) cpu_speed

CPU type cpu_type

Disk space (GB) disk_space

DNS Domain dns_domain

Fully qualified domain name fqdn

Name name

Operating System os

RAM (MB) ram
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Relationships created for Server

Parent class Relationship type Child class

Server [cmdb_ci_server] Owns::Owned by Network Adapter 
[cmdb_ci_network_adapter]

Server [cmdb_ci_server] Owns::Owned by IP Address 
[cmdb_ci_ip_address]

Server [cmdb_ci_server] Reference Key Value [cmdb_key_value]

Related topics

Service Graph Connector for Observability - Datadog

Accessing the connection details of Service Graph Connector for Observability - Datadog

You can access the connection details of the Service Graph Connector for Observability - 
Datadog  in a single view using the common connection framework (CCF) included within the 
Integration Commons for CMDB  (sn_cmdb_int_util) store app.

With the CCF, you can access all the connections used by the Service Graph Connector for 
Observability - Datadog. The connection details include the connection alias, connection 
properties, data sources, and scheduled data imports associated with a connection. You can 
also test the connection. For more information, see Accessing the connection details of Service 
Graph Connectors.

Access the details of a Datadog  connection

Access the details of a Datadog  connection configured for the Service Graph Connector for 
Observability - Datadog.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Service Graph Connectors  > Datadog  > Connections.

2. From the Name  column of the Service Graph Connections list, select a connection.

3. On the Service Graph Connections page, view the connection details such as the connection 
name, alias, and data sources.

4. Select a related list to view further details of the connection.

5. Optional:  Select the Test Connection  related link to test the connection.

Related topics

Service Graph Connector for Observability - Datadog

Service Graph Connector for Observability - Dynatrace

Use the Service Graph Connector for Observability - Dynatrace  to ingest CI data, events, metrics, 
and logs from Dynatrace  into your ServiceNow  instance.

Note: 
The Service Graph Connector for Observability - Dynatrace  provided by ServiceNow  is 
different from the Service Graph Connector for Dynatrace  provided by Dynatrace.
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Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Supported versions

• Supported versions:

◦ Minimum version supported: Dynatrace  SaaS; Version 1.284

• Supported ServiceNow  versions:

◦ Washington DC

◦ Xanadu

◦ Yokohama

◦ Zurich

Important information for upgrading Service Graph Connector for Observability 
- Dynatrace

Before upgrading the Service Graph Connector for Observability - Dynatrace  to version 1.10.0 
or later, disable the reconciliation rules for tables extending the Application [cmdb_ci_appl] 
table. See the Reconciliation rules(ServiceNow, ServiceWatch) on multiple table like Apache web 
server stopping other discovery source to update fields on those tables [KB1649455]  article in 
the Now Support  Knowledge Base.

Configuring a connection for the connector

You can configure a connection for the connector by using the SGC Central  view in the CMDB 
Workspace  enables you to discover and install connectors, and then effectively manage the 
full life cycle of creating, editing, monitoring, and debugging connections. To configure the 
connector using SGC Central, see Configure Service Graph Connector for Observability - 
Dynatrace using SGC Central.

Important: 
Unless there are configuration issues, use the SGC Central  view in the CMDB Workspace 
to configure the connection for the connector, as the guided setup method is being 
deprecated.

CMDB integrations dashboard

The Integration Commons for CMDB  store app provides a dashboard with a central view of the 
status, processing results, and processing errors of all installed integrations. You can see metrics 
for all integration runs. You can filter the view to a specific CMDB  integration, a specific time 
duration, or a specific integration run. For more details about monitoring Dynatrace  integrations 
in the CMDB  Integrations Dashboard, see Using the CMDB Integrations Dashboard.

Data mapping

Data from the Dynatrace  data sources is mapped and transformed into the ServiceNow  CMDB 
Configuration Item (CI) class definitions using the Robust Transform Engine (RTE). Data is 
inserted into the ServiceNow  CMDB  using the Identification and Reconciliation Engine (IRE).

The following table describes the data sources, the staging tables, the target tables as CMDB  CI 
classes, and the Dynatrace  entities imported by each data source.
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Data mapping for Dynatrace  entities

Data source Description Staging table CMDB  CI classes Entities

SGO-Dynatrace 
Hosts

Ingests host data 
from Dynatrace.

Contains 
computer data.

SGO-Dynatrace 
Hosts 
[sn_dynatrace_integ_sg_dynatrace_hosts]

Computer

IP Address 
[cmdb_ci_ip_address]

Key value

When the 
Software Asset 
Management 
(SAM) 
application isn't 
installed:

Software

Software 
Instance

When the SAM 
application 
is installed: 
Software 
Installation

Note: 
Only the 
operating 
system data 
is stored 
in the 
Software 
Packages, 
Software 
Instance, 
and 
Software 
Installation 
CI classes.

Host

SGO-Dynatrace 
Processes

Ingests process 
data from 
Dynatrace.

Contains running 
process data.

SGO-Dynatrace 
Processes 
[sn_dynatrace_integ_sg_dynatrace_processes]

The target table 
is populated 
using Application 
Dependency 
Mapping (ADM). 
The ADM adapter 
analyzes the 
imported data 
and command-
line arguments, 
identifies the 
appropriate 
table based on 

Process
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Data mapping for Dynatrace  entities  (continued)

Data source Description Staging table CMDB  CI classes Entities

the conditions 
included in 
Discovery 
Process 
Classifications 
list, and inserts 
the data into 
the table, which 
extends the 
Application 
[cmdb_ci_appl] 
table. To learn 
about process 
classification, 
see Discovery 
classifiers .

Note: 
The 
addition of 
unclassified 
processes 
to the 
Application 
[cmdb_ci_appl] 
table 
depends 
on the 
value of the 
sn_dynatrace_integ.createUnmatchedApplicationCIs 
system 
property. 
For more 
information, 
see Service 
Graph 
Connector 
for 
Observability 
- Dynatrace 
properties.

SGO-Dynatrace 
Process Groups

Ingests process 
group data from 
Dynatrace.

Contains a group 
of similar running 
processes.

SGO-Dynatrace 
Process Groups 
[sn_dynatrace_integ_sg_dynatrace_process_groups]

Group Process Group

SGO-Dynatrace 
Services

Ingests service 
data from 
Dynatrace.

SGO-Dynatrace 
Services 
[sn_dynatrace_integ_sg_dynatrace_services]

Calculated 
Application 
Service

Service

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1233

https://www.webstg.servicenow.com/docs/access?context=discovery-classifiers&version=washingtondc&pubname=washingtondc-it-operations-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=discovery-classifiers&version=washingtondc&pubname=washingtondc-it-operations-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=discovery-classifiers&version=washingtondc&pubname=washingtondc-it-operations-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=discovery-classifiers&version=washingtondc&pubname=washingtondc-it-operations-management&ft:locale=en-US


Data mapping for Dynatrace  entities  (continued)

Data source Description Staging table CMDB  CI classes Entities

Contains 
information 
related to 
services that are 
detected via the 
Dynatrace  agent.

Can be filtered 
using advanced 
settings 
properties.

Key value

SGO-Dynatrace 
Applications

Ingests 
application data 
from Dynatrace.

Contains 
information 
related to the 
applications 
defined manually.

Applications 
are parents 
to services 
representing 
a higher level, 
logical group of 
services.

SGO-Dynatrace 
Applications 
[sn_dynatrace_integ_sg_dynatrace_applications]

Calculated 
Application 
Service

Key value

Application

SGO-Dynatrace 
Application Rels

Ingests 
application 
relationships 
from Dynatrace.

Returns the 
same data as the 
SGO-Dynatrace 
Services data 
source.

Maps 
relationships 
between 
applications and 
processes that 
could have been 
skipped due to 
filtered services.

SGO-Dynatrace 
Application 
Relationships 
[sn_dynatrace_integ_sg_dynatrace_application_relationships]

Calculated 
Application 
Service

Service

SGO-Dynatrace 
AWS Application 
Network LB

Ingests cloud 
load balancer 
data from 
Dynatrace.

SGO-Dynatrace 
AWS Application 
Network LB 
[sn_dynatrace_integ_sgo_dynatrace_aws_application_network_lb]

Cloud Load 
Balancer

Key Value

AWS  Network 
Load Balancer
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Data mapping for Dynatrace  entities  (continued)

Data source Description Staging table CMDB  CI classes Entities

Contains 
information 
related to AWS 
application and 
network load 
balancer.

AWS  Application 
Load Balancer

SGO-Dynatrace 
AWS Datacenters

Ingests AWS 
datacenter 
and availability 
zone data from 
Dynatrace.

Contains 
information 
related to AWS 
datacenters and 
availability zones.

SGO-
Dynatrace AWS 
Availability Zone 
[sn_dynatrace_integ_sgo_dynatrace_aws_availability_zone]

AWS Datacenter

Availability Zone

AWS  Availability 
Zone

SGO-Dynatrace 
AWS EC2 
Instance

Ingests AWS 
virtual machine 
instance data 
from Dynatrace.

Contains 
information 
related to 
virtual machine 
instances, server 
details, cloud 
hardware type, 
cloud image, and 
tags.

SGO-Dynatrace 
AWS EC2 
Instance 
[sn_dynatrace_integ_sg_dynatrace_aws_ec2_instance]

Virtual Machine 
Instance

Server

Cloud Hardware 
Type

Hardware Type

Image

Key Value

EC2 Instance

SGO-Dynatrace 
AWS Elastic 
Loadbalancer

Ingests cloud 
load balancer 
data from 
Dynatrace.

Contains load 
balancer details 
and tags.

SGO-Dynatrace 
AWS Elastic 
Loadbalancer 
[sn_dynatrace_integ_sgo_dynatrace_aws_elastic_loadbalancer]

Cloud Load 
Balancer

Key Value

Elastic Load 
Balancer

SGO-Dynatrace 
AWS Service 
Account

Ingests cloud 
service account 
data from 
Dynatrace.

Contains 
information 
related to AWS 
account IDs.

SGO-Dynatrace 
AWS Service 
Account 
[sn_dynatrace_integ_sgo_dynatrace_aws_service_account]

Cloud Service 
Account

AWS  Credentials
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Data mapping for Dynatrace  entities  (continued)

Data source Description Staging table CMDB  CI classes Entities

SGO-Dynatrace 
Azure Load 
Balancer

Ingests Azure 
load balancer 
data from 
Dynatrace.

Contains Azure 
load balancer 
and cloud load 
balancer IP 
address and tag 
details.

SGO-Dynatrace 
Azure Load 
Balancer 
[sn_dynatrace_integ_sgo_dynatrace_azure_load_balancer]

Cloud Load 
Balancer

Cloud LB 
IPAddress

Key Value

Azure  Load 
Balancer

SGO-Dynatrace 
Azure Region

Ingests Azure 
datacenter data 
from Dynatrace.

Contains Azure 
datacenter 
information.

SGO-Dynatrace 
Azure Region 
[sn_dynatrace_integ_sgo_dynatrace_azure_region]

Azure Datacenter Azure  Region

SGO-Dynatrace 
Azure Storage 
Accounts

Ingests Azure 
cloud storage 
account data 
from Dynatrace.

Contains 
information 
related to cloud 
storage accounts.

SGO-Dynatrace 
Azure Storage 
Accounts 
[sn_dynatrace_integ_sgo_dynatrace_azure_storage_accounts]

Cloud Storage 
Account

Azure  Storage 
Account

SGO-Dynatrace 
Azure Strg Acnts 
v2

Ingests Azure 
cloud storage 
account data 
from Dynatrace 
using v2 API.

Contains 
information 
related to cloud 
storage accounts.

SGO-Dynatrace 
Azure Storage 
Accounts v2 
[sn_dynatrace_integ_sgo_dynatrace_azure_storage_accounts_v2]

Cloud Storage 
Account

cloud:azure:storage:storageaccounts

SGO-Dynatrace 
Azure 
Subscriptions

Ingests Azure 
subscription data 
from Dynatrace.

Contains Azure 
subscription 
details.

SGO-Dynatrace 
Azure 
Subscriptions 
[sn_dynatrace_integ_sg_dynatrace_azure_subscriptions]

Cloud Service 
Account

Azure 
Subscription

SGO-Dynatrace 
Azure VM

Ingests Azure 
virtual machine 
instance data 
from Dynatrace.

SGO-Dynatrace 
Azure VM 
[sn_dynatrace_integ_sgo_dynatrace_azure_vm]

Virtual Machine 
Instance

Azure  VM
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Data mapping for Dynatrace  entities  (continued)

Data source Description Staging table CMDB  CI classes Entities

Contains 
information 
related to Azure 
virtual machine 
instances.

SGO-Dynatrace 
Docker Container

Ingests Docker 
container data 
from Dynatrace.

Contains 
information 
related to the 
Docker  container 
image.

SGO-Dynatrace 
Docker Container 
[sn_dynatrace_integ_sgo_dynatrace_docker_container]

Docker Container

Application

Docker Image

Computer 
[cmdb_ci_computer]

Container Group 
Instance

SGO-Dynatrace 
Kubernetes 
Cluster

Ingests 
Kubernetes 
cluster data from 
Dynatrace.

Contains 
information 
related to 
Kubernetes 
clusters.

SGO-Dynatrace 
Kubernetes 
Cluster 
[sn_dynatrace_integ_sgo_dynatrace_kubernetes_cluster]

Kubernetes 
Cluster

Kubernetes 
Cluster

SGO-Dynatrace 
Kubernetes 
Namespace

Ingests 
Kubernetes 
namespace data 
from Dynatrace.

Contains 
information 
related to 
Kubernetes 
namespaces.

SGO-Dynatrace 
Kubernetes 
Namespace 
[sn_dynatrace_integ_sgo_dynatrace_kubernetes_namespace]

Kubernetes 
Namespace

Cloud 
Application 
Namespace

SGO-Dynatrace 
Kubernetes Node

Ingests 
Kubernetes 
node data from 
Dynatrace.

Contains 
information 
related to 
Kubernetes 
nodes.

SGO-Dynatrace 
Kubernetes Node 
[sn_dynatrace_integ_sgo_dynatrace_kubernetes_node]

Kubernetes Node Kubernetes  Node

SGO-Dynatrace 
Kubernetes Pod

Ingests 
Kubernetes 
pod data from 
Dynatrace.

SGO-Dynatrace 
Kubernetes Pod 
[sn_dynatrace_integ_sgo_dynatrace_kubernetes_pod]

Kubernetes Pod Cloud 
Application 
Instance

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1237



Data mapping for Dynatrace  entities  (continued)

Data source Description Staging table CMDB  CI classes Entities

Contains 
information 
related to 
Kubernetes  pods.

SGO-Dynatrace 
Kubernetes 
Service

Ingests 
Kubernetes 
service data from 
Dynatrace.

Contains 
information 
related to 
Kubernetes 
services.

SGO-Dynatrace 
Kubernetes 
Service 
[sn_dynatrace_integ_sgo_dynatrace_kubernetes_service]

Kubernetes 
Service

Kubernetes 
Service

SGO-Dynatrace 
Azure Cosmos 
DB v1

Ingests Azure 
Cosmos DB data 
from Dynatrace.

Contains 
information 
related to Azure 
Cosmos DB.

SGO-Dynatrace 
Azure 
Cosmos DB v1 
[sn_dynatrace_integ_sgo_dynatrace_azure_cosmos_db_v1]

Cloud DataBase

Azure Datacenter

Cloud Service 
Account

Key value

AZURE_COSMOS_DB

SGO-Dynatrace 
Azure Cosmos 
DB V2

Ingests Azure 
Cosmos DB data 
from Dynatrace.

Contains 
information 
related to Azure 
Cosmos DB.

SGO-Dynatrace 
Azure Cosmos 
DB V2 
[sn_dynatrace_integ_sgo_dynatrace_azure_cosmos_db_v2]

Cloud DataBase

Azure Datacenter

Cloud Service 
Account

Key value

cloud:azure:documentdb:databaseaccounts:global

cloud:azure:documentdb:databaseaccounts:mongo

SGO-Dynatrace 
Azure SQL Server 
V2

Ingests Azure 
SQL Server data 
from Dynatrace.

Contains 
information 
related to Azure 
SQL Server.

SGO-Dynatrace 
Azure SQL 
Server V2 
[sn_dynatrace_integ_sgo_dynatrace_azure_sql_server_v2]

Cloud DataBase

Azure Datacenter

Key value

cloud:azure:sql:servers:databases:dtu

cloud:azure:sql:servers:databases:vcore

cloud:azure:sql:servers:databases:hyperscale

SGO-Dynatrace 
Azure Function 
App

Ingests Azure 
Functions 
app data from 
Dynatrace.

Contains 
information 
related to Azure 
Functions  app.

SGO-Dynatrace 
Azure 
Function App 
[sn_dynatrace_integ_sgo_dynatrace_azure_function_app]

Cloud Function

Azure Datacenter

Cloud Service 
Account

Key value

AZURE_FUNCTION_APP
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Data mapping for Dynatrace  entities  (continued)

Data source Description Staging table CMDB  CI classes Entities

SGO-Dynatrace 
Azure Scale Sets 
VM

Ingests Azure 
Virtual Machine 
Scale Sets 
(VMSS)  data from 
Dynatrace.

Contains 
information 
related to Azure 
VMSS.

SGO-Dynatrace 
Azure Scale 
Sets VM 
[sn_dynatrace_integ_sgo_dynatrace_azure_scale_sets_vm]

Instance Scale 
Set

Azure Datacenter

Cloud Service 
Account

Key value

AZURE_VM_SCALE_SET

SGO-Dynatrace 
AWS RDS V1

Ingests Amazon 
Relational 
Database Service 
(RDS) data from 
Dynatrace.

Contains 
information 
related to 
Amazon  RDS.

SGO-Dynatrace 
AWS RDS V1 
[sn_dynatrace_integ_sgo_dynatrace_aws_rds_v1]

Cloud DataBase

AWS Datacenter

Key value

RELATIONAL_DATABASE_SERVICE

SGO-Dynatrace 
AWS RDS V2

Ingests Amazon 
Relational 
Database Service 
(RDS) data from 
Dynatrace.

Contains 
information 
related to 
Amazon  RDS.

SGO-Dynatrace 
AWS RDS V2 
[sn_dynatrace_integ_sgo_dynatrace_aws_rds_v2]

Cloud DataBase

AWS Datacenter

Key value

cloud:aws:rds

SGO-Dynatrace 
AWS Dynamo DB 
v1

Ingests Amazon 
Dynamo DB data 
from Dynatrace.

Contains 
information 
related to 
Amazon  Dynamo 
DB.

SGO-
Dynatrace AWS 
Dynamo DB v1 
[sn_dynatrace_integ_sgo_dynatrace_aws_dynamo_db_v1]

DynamoDB Table

AWS Datacenter

Key value

DYNAMO_DB_TABLE

SGO-Dynatrace 
AWS Dynamo DB 
v2

Ingests Amazon 
Dynamo DB data 
from Dynatrace.

Contains 
information 
related to 
Amazon  Dynamo 
DB.

SGO-Dynatrace 
AWS Dynamo 
DB v2 
[sn_dynatrace_integ_sgo_dynatrace_aws_dynamo_db_v2]

DynamoDB Table

AWS Datacenter

Key value

cloud:aws:dynamodb
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Data mapping for Dynatrace  entities  (continued)

Data source Description Staging table CMDB  CI classes Entities

SGO-Dynatrace 
AWS Lambda 
Func V1

Ingests AWS 
Lambda Function 
data from 
Dynatrace.

Contains 
information 
related to 
AWS  Lambda 
Function.

SGO-Dynatrace 
AWS Lambda 
Func V1 
[sn_dynatrace_integ_sgo_dynatrace_aws_lambda_func_v1]

Cloud Function

Azure Datacenter

Key value

AWS_LAMBDA_FUNCTION

SGO-Dynatrace 
AWS Lambda 
Func V2

Ingests AWS 
Lambda Function 
data from 
Dynatrace.

Contains 
information 
related to 
AWS  Lambda 
Function.

SGO-Dynatrace 
AWS Lambda 
Func V2 
[sn_dynatrace_integ_sgo_dynatrace_aws_lambda_func_v2]

Cloud Function

Azure Datacenter

Key value

cloud:aws:lambda

SGO-Dynatrace 
AWS S3 Bucket 
V2

Ingests Amazon 
S3  bucket data 
from Dynatrace.

Contains 
information 
related to 
Amazon S3 
bucket.

SGO-Dynatrace 
AWS S3 
Bucket V2 
[sn_dynatrace_integ_sgo_dynatrace_aws_s3_bucket_v2]

Cloud Object 
Storage

AWS Datacenter

Key value

cloud:aws:s3

SGO-Dynatrace 
Custom 
Applications

Ingests custom 
application data 
from Dynatrace.

Contains 
information 
related to custom 
applications.

SGO-Dynatrace 
Custom 
Applications 
[sn_dynatrace_integ_sgo_dynatrace_custom_applications]

Calculated 
Application 
Service

Configuration 
Item [cmdb_ci]

Key value

CUSTOM_APPLICATION

SGO-Dynatrace 
AWS Auto 
Scaling Group V1

Ingests AWS 
autoscaling 
group data from 
Dynatrace  using 
V1 API.

Contains 
information 
related to AWS 
autoscaling 
group.

SGO-Dynatrace 
AWS Auto 
Scaling Group V1 
[sn_dynatrace_integ_sgo_dynatrace_aws_auto_scaling_group_v1]

Cloud Resource

AWS Datacenter

Key value

AUTO_SCALING_GROUP
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When you complete setting up the connection, you can configure the integration to pull data 
from Dynatrace  periodically. The data is loaded into the staging tables, and then inserted into the 
target tables.

For more information on where data is saved when pulling data from Dynatrace, see CMDB 
classes targeted in Service Graph Connector for Observability - Dynatrace.

You can use the IntegrationHub ETL app to view the data maps. See IntegrationHub ETL  for more 
information.

Additional resources

• Introduction to Service Graph Connector for Observability Dynatrace  article on the 
ServiceNow Community  site

• How do I configure the Dynatrace Service Graph Connector?  article on the ServiceNow 
Community  site

Related topics

Service Graph Connectors

Service Graph Connector for Observability - Dynatrace properties

Configure Service Graph Connector for Observability - Dynatrace  using SGC Central

Set up scheduled import jobs to pull in Dynatrace  data into your Configuration Management 
Database (CMDB).

Before you begin
Install Service Graph Connector for Observability - Dynatrace  version 1.11.0 or later from the 
ServiceNow Store. For ServiceNow Store  installation steps, see Install a ServiceNow Store 
application .

Role required: cmdb_inst_admin or admin

About this task
The playbook experience for onboarding connectors is activated with SGC Central  in the CMDB 
Workspace. To configure the SGC Central  application, see Configuring SGC Central  and for more 
information on how to interact with a playbook, see Interact with Playbook .

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the CMDB Workspace, select SGC Central.

3. On the Overview page, select Create connection.

Tip: 
Alternatively, you can select Create connection  on the All connections page.

4. On the Create connection window, select the Dynatrace  connector type, and then select 
Configure connection.

5. Complete the initial prerequisites when setting up a connection for the first time using a 
connector.
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a. Optional:  Install the Observability Commons for CMDB  application (sn_observability) for 
event ingestion.

Note: 
The Install Observability Commons for CMDB  activity appears only when the 
Observability Commons for CMDB  application (sn_observability) isn't already installed. 
If event ingestion isn't needed, you can skip this step by selecting Continue  for the 
Install Observability Commons for CMDB  activity.

i. In the Prerequisites  stage of the playbook, select the Install Observability Commons for 
CMDB  activity.

ii. Install the Observability Commons for CMDB  application (sn_observability) from the 
ServiceNow Store.

iii. After you have installed the application, select Continue.

b. Create data sources for the connection.

Note: 
This step is required when configuring the connector for the first time only.

i. Verify that you have edit permissions for the Datasource [sys_data_source] table.

ii. In the Prerequisites  stage of the playbook, select the Update data source access  activity.

iii. Select Update access.

iv. To edit the record, select the Global  application scope from the application picker.

v. In the Application Access related list of the Data Source form, select the Can create, Can 
update, and Can delete  check boxes.

vi. Select Update.

vii. From the application picker, select the application scope of the connector.

viii. After completing the Update data source access  activity, select Continue.

c. Enable creating scheduled jobs for the connection by updating the scheduled data import 
access.

Note: 
This step is required when configuring the connector for the first time only.

i. Verify that you have edit permissions for the Scheduled Data Import 
[scheduled_import_set] table.

ii. In the Prerequisites  stage of the playbook, select the Update scheduled data import 
access  activity.

iii. Select Update access.

iv. To edit the record, select the Global  application scope from the application picker.

v. In the Application Access related list of the Data Source form, select the Can create, Can 
update, and Can delete  check boxes.

vi. Select Update.

vii. From the application picker, select the application scope of the connector.

viii. After completing the Update scheduled data import access  activity, select Continue.
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d. Enable creating values for the connection by updating the variable value access.

Note: 
This step is required when configuring the connector for the first time only.

i. Verify that you have edit permissions for the Value [sys_variable_value] table.

ii. In the Prerequisites  stage of the playbook, select the Update variable value access 
activity.

iii. Select Update access.

iv. To edit the record, select the Global  application scope from the application picker.

v. In the Application Access related list of the Data Source form, select the Can create, Can 
update, and Can delete  check boxes.

vi. Select Update.

vii. From the application picker, select the application scope of the connector.

viii. After completing the Update variable value access  activity, select Continue.

e. Clear the cache on the Data Source [sys_data_source] table.

Note: 
This step is required when configuring the connector for the first time only.

i. In the Prerequisites  stage of the playbook, select the Clear cache  activity.

ii. Select Run clear cache.

iii. In the Run script  text box of the background script page, enter the following script:

GlideTableManager.invalidateTable("sys_data_source");
      GlideCacheManager.flushTable("sys_data_source");
 
     
 GlideTableManager.invalidateTable("scheduled_import_set");
      GlideCacheManager.flushTable("scheduled_import_set");
 
     
 GlideTableManager.invalidateTable("sys_variable_value");
      GlideCacheManager.flushTable("sys_variable_value");
 
      GlideTableManager.invalidateTable("sys_db_object");
      GlideCacheManager.flushTable("sys_db_object");

iv. Select Run Script  to run the background script in the global  scope.

The script may take several minutes to execute.

v. After the script is executed, select Close.

vi. From the application picker, select the application scope of the connector.

vii. After completing the Clear cache  activity, select Continue.

f. Verify that the Event Management  application works properly with the Dynatrace 
environment by copying the EvtMgmtImpactManagerMediator  script to the Global 
application scope.
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Note: 
This step is displayed only when the Observability Commons for CMDB  plugin 
(sn_observability) is already installed and is required when configuring the connector 
for the first time only.

i. In the Prerequisites  stage of the playbook, select the Enable script access for event 
management  activity.

ii. Select Enable script access.

iii. Select the Global  application scope from the application picker.

iv. From the context menu, select Insert and Stay.

v. Verify that the EvtMgmtlmpactManagerMediator  script was copied to the Global 
application scope and the Accessible from  field was set to All application 
scopes.

vi. Select Update.

vii. From the application picker, select the application scope of the connector.

viii. After completing the Enable script access for event management  activity, select 
Continue.

6. Enter connection details and test the API connection for importing Dynatrace  data.

a. In the Setup  stage of the playbook, select the Create and test connection  activity.

b. On the form, fill in the fields.

Create and test connection form

Field Description

Connection name Name to identify the Dynatrace  connection 
record.

Hostname Hostname of your Dynatrace  environment.

API Key Dynatrace  API Key.

Note: 
The API Key must be prefixed with 
api-token.

c. Select Create and test connection.

d. Once the connection test is complete, select Continue.

7. Optional:  Configure the connection and connector properties to map attributes and manage 
data imports.

Note: 
To skip this step, select Continue  for the Set configuration properties  activity.
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a. In the Setup  stage of the playbook, select the Set configuration properties  activity.

b. Fill in the form.

Configuration properties

Field Description

Management 
zone Ids

List of the management zone IDs to fetch from your Dynatrace  environment. 
For multiple entries, separate the zone IDs with commas.

Management 
zone names

List of the management zones to fetch from your Dynatrace  environment. 
For multiple entries, separate the zone names with commas.

Service 
types

List of the Dynatrace  service types from where to ingest the data into the 
CMDB. For multiple entries, separate the service types with commas.

Note: 
All service types except for DATABASE_SERVICE are mapped to 
the Calculated Application Service [cmdb_ci_service_calculated] 
CMDB  table. The DATABASE_SERVICE service type is mapped to the 
Database Instance [cmdb_ci_db_instance] CMDB  table.

Valid values are:

▪ BACKGROUND_ACTIVITY

▪ CICS_SERVICE

▪ CUSTOM_SERVICE

▪ DATABASE_SERVICE

▪ ENTERPRISE_SERVICE_BUS_SERVICE

▪ EXTERNAL

▪ IBM_INTEGRATION_BUS_SERVICE

▪ IMS_SERVICE

▪ MESSAGING_SERVICE

▪ QUEUE_LISTENER_SERVICE

▪ RMI_SERVICE

▪ RPC_SERVICE

▪ WEB_REQUEST_SERVICE

▪ WEB_SERVICE

Tags List of the tag names to fetch from your Dynatrace  environment. For multiple 
entries, separate the tags with commas.

c. To manage data source failures during import, select the Save REST response as 
attachment  check box to save each response as an attachment temporarily.

d. Select Continue.
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8. Optional:  To enable Dynatrace  notifications as events in your ServiceNow  instance, trigger the 
workflow to create a problem notification and alerting profile in your Dynatrace  environment.

Note: 
This step is displayed only when the Observability Commons for CMDB  plugin 
(sn_observability) is already installed. To skip this step, select Skip  for the Configure 
observability  activity.

a. In the Setup  stage of the playbook, select the Configure observability  activity.

b. Select Create problem notification.

Note: 
The created records appear in the Dynatrace  application under the display name 
ServiceNow default Problem notification  and can be customized.

c. Dismiss any success alerts and select Continue.

9. Configure the import schedule to import data at regular intervals.

a. In the Setup  stage of the playbook, select the Configure import schedule  activity.

b. Expand the Parent scheduled data import within the Import schedules list to select the SGO-
Dynatrace Hosts - Connection Name  import schedule.

c. Select the Active  check box, and then fill in the run schedule and time details.

For more information, see Schedule a data import .

d. Select Save.
Alternatively, select Execute Now  to execute the import schedule immediately.

10. In the Setup  stage of the playbook, select the Confirm connection creation  activity to verify 
whether the connection was created.

What to do next
Select View all connections  to review the connection details. The created connection appears in 
the Installed connections list.

Related topics

Service Graph Connector for Observability - Dynatrace

CMDB classes targeted in Service Graph Connector for Observability - Dynatrace

Service Graph Connector for Observability - Dynatrace properties

Configure Service Graph Connector for Observability - Dynatrace

Use the Service Graph Connector for Observability - Dynatrace  to ingest Configuration 
Management Database (CMDB)  data from Dynatrace  using REST APIs. This connector is the 
second generation of the Service Graph Connector for Observability - Dynatrace  application 
developed by ServiceNow.

Before you begin
To use this Service Graph Connector, you need a subscription to a Subscription Unit that is 
based in the IT Operations Management  (ITOM) Visibility application or in the ITOM  Discovery 
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application. As defined in the section titled "Managed IT Resource Types" in ServiceNow 
Subscription Unit Overview  for your subscription, for managed IT resources that are created 
or modified in the CMDB  by this Service Graph Connector, but that aren’t yet managed by ITOM 
Visibility or ITOM Discovery , these resources will increase Subscription Unit consumption from 
that application. Review your current Subscription Unit consumption within ITOM Visibility or 
ITOM Discovery to ensure available capacity.

Dependencies and requirements:

• The Integration Commons for CMDB  store app, which is automatically installed.

• The CMDB CI class models store app, which is automatically installed. See CMDB CI Class 
Models store app.

• The ITOM Discovery License plugin (com.snc.itom.discovery.license). You must activate this 
plugin.

• ITOM Licensing plugin (com.snc.itom.license). For more information, see Request Discovery .

• The Datastream Action plugin (com.glide.hub.action_type.datastream), which is automatically 
installed.

• Observability Commons for CMDB  (sn_observability), which  is only required for event 
ingestion and will need to be installed prior to installing the connector for Event Management 
to work. For more information, see Observability Commons for CMDB  on the ServiceNow 
Store.

Note: 
To access the Dynatrace  API, you need an access token with Read entities (entities.read) 
scope.

Role required: admin

Procedure

1. Navigate to All  > Service Graph Connectors  > Dynatrace Observability  > Setup.

2. On the Getting started page, select Get Started.

3. Set impact values for clusters and have the connector get access to the 
SNC.ImpactManager  API.

Note: 
This step appears when Observability Commons is installed.

a. On the Setup page, in the Enable Access To SNC.Impact Manager section, select the Copy 
Script to Global Scope  task.

b. In the Copy Script to Global Scope section, copy the script.

i. Select Configure.

ii. Switch to the global scope.

iii. Select the Additional actions icon ( ).

iv. Select Insert and Stay.

v. Select Mark as Complete.

c. In the Verify script is copied properly section, verify the script.
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i. Select Configure.

ii. Select the EvtMgmtImpactManagerMediator  script and verify it was copied to the 
global scope.

iii. In the Accessible from  field, ensure it is set to All application scopes.

iv. Select Mark as Complete.

4. Configure the basic setup.

a. On the Setup page, in the Basic section, select the Configure Auth Token for Dynatrace 
task.

b. On the next page, in the Configure Auth Token for Dynatrace section, configure the 
authentication token.

i. Select Configure.

ii. In the API Key  field, enter api-token <your api token>.

For example, api-token mytokenid.

iii. Select Mark as Complete.

c. In the Configure HTTP Connection for Dynatrace section, configure the HTTP connection.

i. Select Configure.

ii. Update the Host  field with a fully qualified hostname for your Dynatrace instance.

For example, abc123.live.dynatrace.com.

The hostname is automatically filled in the Connection URL  field.

iii. Enable the use of a MID Server, select the Use MID Server  check box.

Note: 
The HTTP connection will be pre-configured to use the API key that was configured 
during the previous setup task.

iv. Select Mark as Complete.

d. Test the HTTP connection.

i. In the Test Connection section, select Configure.

ii. To test the connection configuration, select Test Connection.

Note: 
If any of the tests have errors, follow the suggestions for remediation.

iii. Set the Test Connection  task to complete by selecting Mark as Complete.

e. In the Create Default Notification Payload Template section, select Configure.
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Note: 
You need an access token with the following scopes:

▪ Read configuration (ReadConfig)

▪ Write configuration (WriteConfig)

▪ Read log content (LogExport)

▪ Read metrics (metrics.read)

▪ Read settings (settings.read)

▪ Write settings (settings.write)

▪ Read logs (logs.read)

i. Update the name of the payload template, if needed.

ii. Select Problem Notification Setup.

iii. Set the Create Default Notification Payload Template  task to complete by selecting Mark 
as Complete.

f. Optional:  If you want to support multiple instances, in the Upgrade Source Native Keys 
section, select Configure.

i. In the Run script  text box of the background script page, enter the following script:

var gr = new GlideRecord("sys_object_source");
gr.addQuery("name", "SGO-Dynatrace");
var grOR = gr.addQuery("id", "STARTSWITH", "HOST-");
grOR.addOrCondition("id", "STARTSWITH", 
 "PROCESS_GROUP_INSTANCE-");
grOR.addOrCondition("id", "STARTSWITH", "PROCESS_GROUP-");
grOR.addOrCondition("id", "STARTSWITH", "SERVICE-");
grOR.addOrCondition("id", "STARTSWITH", "APPLICATION-");
gr.query();
while (gr.next()) {
    gr.setValue("id", "f379137e075820107add6a77c4a93538|||" 
 + gr.getValue("id"));
    gr.update();
}

ii. Select Run Script  to run the background script in the global  scope.

The script may take several minutes to execute.

iii. After the script is executed, select Close.

iv. From the application picker, select the Service Graph Connector for Observability 
Dynatrace  application.

v. Select Mark as Complete.

5. For a Grail-enabled tenant, configure the OAuth 2.0 client credentials and test the connection.
For more information on Dynatrace  OAuth credentials, see Authentication for the Account 
Management API  on the Dynatrace  documentation site.
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a. Set the Dynatrace Grail status to indicate whether using the Grail-enabled tenant.

Note: 

You can check Grail enablement by contacting your Dynatrace  administrator.

i. In the Configure Dynatrace Grail OAuth section of the Service Graph Connector for 
Observability Dynatrace Setup page, select Get Started.

ii. For the Set Dynatrace Grail status  task, select Configure  and review or modify the property 
settings for a Grail-enabled tenant.

iii. If you've Grail-enabled tenant, set the Value  field of the grailEnabled  property to 
true.

Else, leave the value set to false.

iv. Set the Configure Dynatrace Grail OAuth  task to complete by selecting Mark as Complete.

b. Add a new OAuth connection.

Note: 
You need an OAuth token with the following scope permissions in Grail:

▪ storage:logs:read

▪ storage:buckets:read

i. In the Configure OAuth credentials section, select Configure.

ii. On the Flow Designer  page that opens in a new browser tab, select Add Connection.

iii. Enter a name, the connection URL, OAuth client ID, and OAuth client secret details.

iv. Select Create and Get OAuth Token.

v. Return to the guided setup page.

vi. Set the Configure OAuth credentials  task to complete by selecting Mark as Complete.

c. Test the new OAuth connection.

i. In the Test Connection section, select Configure.

ii. To test the connection configuration, select Test Connection.

iii. When the Status  field is set to Success, select Update  to close the Test the connection 
dialog box and return to the guided setup page.

If any of the tests have errors, follow the suggestions for remediation.

iv. Set the Test Connection  task to complete by selecting Mark as Complete.

6. Set up the additional configurations.

a. On the Guided setup page, in the Advanced section, select the Advanced settings  task.

b. In the Advanced Settings section, select Configure  and review or modify the existing 
settings for a custom configuration.
You can configure the following settings:
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▪ Review the page size used in REST API requests to fetch Dynatrace entities.

▪ Define number of days a configuration item (CI) can be inactive before it is ignored.

▪ Enter the percentage of an application cluster's nodes that need to be in a state to raise 
that state to its parent in the service map.

For example, you can define the percentage of nodes that need to go critical for the parent 
of a cluster to be in a critical state. If there are 10 nodes in a cluster, setting the property 
value to 70  would require at least 7 out of the 10 nodes in the cluster to go into a critical 
state to reflect up to the parent service of the cluster.

▪ Enable ingesting events that do not have a matching CI in the CMDB.

▪ Enable populating the Application (cmdb_ci_appl) CIs from Dynatrace (Dynatrace 
processes) during scheduled imports.

c. Select Save.

d. Select Mark as Complete  for the Advanced Settings task.

e. Configure connection properties for the Dynatrace  connection.

i. In the Configure Instance Settings  section, select Configure.

ii. In the Service Graph Connection Properties related list, configure the properties of the 
connection record.

Dynatrace  connection properties

Property Description

managementZoneNames Enter the name of the management zone to fetch from your 
Dynatrace  environment. For multiple entries, separate the 
zone names with commas.

tags Enter the name of the tags to fetch from your Dynatrace 
environment. For multiple entries, separate the tags with 
commas.

serviceTypes Enter the list of Dynatrace  service types from where to ingest 
the data into CMDB. For multiple entries, separate the service 
types with commas.
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Property Description

Note: 
All service types except for DATABASE_SERVICE 
are mapped to the Calculated Application Service 
[cmdb_ci_service_calculated] CMDB  table. The 
DATABASE_SERVICE service type is mapped to the 
Database Instance [cmdb_ci_db_instance] CMDB  table.

Valid values are:

▪ BACKGROUND_ACTIVITY

▪ CICS_SERVICE

▪ CUSTOM_SERVICE

▪ DATABASE_SERVICE

▪ ENTERPRISE_SERVICE_BUS_SERVICE

▪ EXTERNAL

▪ IBM_INTEGRATION_BUS_SERVICE

▪ IMS_SERVICE

▪ MESSAGING_SERVICE

▪ QUEUE_LISTENER_SERVICE

▪ RMI_SERVICE

▪ RPC_SERVICE

▪ WEB_REQUEST_SERVICE

▪ WEB_SERVICE

managementZoneIds Enter the name of the management zone ID to fetch from your 
Dynatrace  environment. For multiple entries, separate the 
zone IDs with commas.

iii. Select Update.

iv. Complete the Configure Instance Settings  task by selecting Mark as Complete.

f. Execute the Fix Older Ids  fix script to migrate the IDs of the imported data from the 
previous format to the latest format of the object IDs.

Note: 
Beginning with the 1.9.0 version of the Service Graph Connector for Observability - 
Dynatrace, the latest format of the object IDs, which is Base64 Encoding, is used for 
data import. The Fix Older Ids  fix script migrates any existing data with previous 
object IDs to the latest format.

g. Configure the notification settings.

The setup enables pulling ITOM events from Dynatrace  into the ServiceNow  instance.

i. In the Configure Problem Notification section, select Configure.

ii. To push the configuration to Dynatrace, select Problem Notification Setup.
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iii. To receive the configuration from Dynatrace, select Fetch Notification Setup.

iv. Complete the Configure Problem Notification task by selecting Mark as Complete.

7. Clean up records from the previous instance.

Note: 
If you are not migrating from the previous Dynatrace  version, you can skip this step.

a. On the Setup page, in the Clean Up Records From Previous Integration section, select the 
Execute the New Integration  task.

b. On the next page, in the Execute the New Integration section, select Configure  and select 
Update.

c. Select Mark as Complete.

d. In the Verify Integration Execution Has Completed section, verify the integration execution.

i. Select Configure.

ii. In the State  field, wait for the field to change to Complete  or Complete with errors.

It is normal to have errors during the migration from an older version.

iii. To refresh the list, select and hold (or right-click) the header and select Refresh List.

iv. Select Mark as Complete.

e. In the Delete Application Services Left Over From Previous Version section, select Configure 
to delete any application services that you no longer need from the previous integration.

f. Select Mark as Complete.

g. In the Cleanup Identification Remnants - Copy Script section, copy the script.

i. Select Configure.

ii. Change the current scope to Global.

iii. Select the menu icon ( ).

iv. Select Insert and Stay.

v. Select Mark as Complete.

h. In the Cleanup Identification Remnants - Execute Script section, execute the script.

i. Select Configure.

ii. Select the record of the script you copied.

iii. Select Update.

8. Optional:  Add multiple instances.

Note: 
If you do not need to add multiple instances, you can skip this step.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1253



a. In the Add Multiple Instances  section of the Service Graph Connector for Microsoft 
Defender  page, select Get Started.

b. Update the data source access to create a data source for the new connection.

i. Ensure that you have edit permissions for the Datasource [sys_data_source] table.

ii. For the Update Data Source Access  task, select Configure.

iii. To edit the record, select the Global  application scope from the application picker.

iv. In the Application Access related list of the Data Source form that opens in a new tab, 
select the Can create, Can update, and Can delete  check boxes.

v. Select Update  to return to the guided setup page.

vi. Select the Service Graph Connector for Observability Dynatrace  application scope from 
the application picker.

vii. Set the Update Data Source Access task to complete by selecting Mark as Complete.

c. Update the scheduled data import access to create a scheduled import for the new 
connection.

i. Ensure that you have edit permissions for the Scheduled data import 
[scheduled_import_set] table.

ii. For the Update Scheduled Data Import Access  task, select Configure.

iii. To edit the record, select the Global  application scope from the application picker.

iv. In the Application Access related list of the Data Source form that opens in a new tab, 
select the Can create, Can update, and Can delete  check boxes.

v. Select Update  to return to the guided setup page.

vi. Select the Service Graph Connector for Observability Dynatrace  application scope from 
the application picker.

vii. Set the Update Scheduled Data Import Access  task to complete by selecting Mark as 
Complete.

d. Update the value access to create the data source for the new connection.

i. Ensure that you have edit permissions for the Value [sys_variable_value] table.

ii. For the Update Value Access  task, select Configure.

iii. To edit the record, select the Global  application scope from the application picker.

iv. In the Application Access related list of the Data Source form that opens in a new tab, 
select the Can create, Can update, and Can delete  check boxes.

v. Select Update  to return to the guided setup page.

vi. Select the Service Graph Connector for Observability Dynatrace  application scope from 
the application picker.

vii. Set the Update Value Access task to complete by selecting Mark as Complete.

e. Clear the data source and import set cache for the new connection.

i. For the Clear Cache for Datasource and Import set  task, select Configure.

ii. In the Run script  text box of the background script page, enter the following script:
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      GlideTableManager.invalidateTable("sys_data_source");
      GlideCacheManager.flushTable("sys_data_source");
 
     
 GlideTableManager.invalidateTable("scheduled_import_set");
      GlideCacheManager.flushTable("scheduled_import_set");
 
     
 GlideTableManager.invalidateTable("sys_variable_value");
      GlideCacheManager.flushTable("sys_variable_value");
 
      GlideTableManager.invalidateTable("sys_db_object");
      GlideCacheManager.flushTable("sys_db_object");

iii. Select Run Script  to run the background script in the global  scope.

The script may take several minutes to execute.

iv. After the script is executed, select Close.

v. Select the Service Graph Connector for Observability Dynatrace  application scope from 
the application picker.

vi. Set the Clear Cache for Datasource and Import set  task to complete by selecting Mark as 
Complete.

f. Add another connection.

i. Ensure that the application scope is set to Service Graph Connector for Observability  in 
the application picker.

ii. For the Add Another Connection  task, select Configure.

iii. On the Flow Designer  page that opens in a new browser tab, select Add Connection.

iv. On the form, fill in the fields.

Connection form

Field Description

Connection Name Display name for the connection.

Connection Hostname Host name of the Dynatrace  instance.

API Key Dynatrace  API Key.

Note: 
The API Key must be prefixed with 
api-token.

v. Select Create Connection.

vi. Return to the guided setup page.

vii. Set the Add Another Connection  task to complete by selecting Mark as Complete.

g. If using a Grail-enabled tenant, configure additional OAuth 2.0 connections.

i. For the Add another OAuth connection  task, select Configure.

ii. On the Flow Designer  page that opens in a new browser tab, select Add Connection.
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iii. Enter a name, the connection URL, OAuth client ID, and OAuth client secret details.

iv. Select Create and Get OAuth Token.

v. Return to the guided setup page.

vi. Set the Add another OAuth connection  task to complete by selecting Mark as Complete.

h. If using a Grail-enabled tenant, select the OAuth 2.0 client credentials alias created earlier in 
the Add another OAuth connection  task.

i. For the Link connection record with OAuth client credentials  task, select Configure.

ii. In the OAuth 2.0 Connection and Credentials Alias  field, search for and select the OAuth 
connection alias you created in the step 8.g.

iii. In the Service Graph connection record, search for and select the connection record you 
created in step 8.f.

iv. Select Submit.

v. Return to the guided setup page.

vi. Set the Link connection record with OAuth client credentials  task to complete by selecting 
Mark as Complete.

i. Optional:  Set up the MID Server for the connection you created.

i. For the Configure Mid Servers  task, select Configure.

ii. Select the name of the connection you created.

iii. Select the Use MID server  check box.

iv. Select Update.

v. Set the Configure Mid Servers  task to complete by selecting Mark as Complete.

j. Configure the instance settings.

i. In the Configure Instances section, select Configure.

ii. Select the name of the connection you want to configure and then select Update.

iii. Set the Configure Instances  task to complete by selecting Mark as Complete.

k. Test the new connections.

i. For the Test Connections task, select Configure.

ii. Select the name of the connection you want to test.

iii. To validate the data source configuration, select Test Load 20 Records.

iv. When the Status  field is set to Success, select Update  to close the Test the connection 
dialog box and return to the guided setup page.

If any of the tests have errors, follow the suggestions for remediation.

v. Set the Test Connections  task to complete by selecting Mark as Complete.

l. Create default notification payload templates.

i. Ensure that you have the access token with the following scopes:

▪ Read configuration (ReadConfig)

▪ Write configuration (WriteConfig)
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▪ Read log content (LogExport)

▪ Read metrics (metrics.read)

ii. For the Create Default Notification Payload Templates task, select Configure.

iii. Select the connection you want to create a default notification payload template for.

iv. Update the name of the payload template, if needed.

v. Select Problem Notification Setup.

The notification is created with the payload parameters as described in the following table.

Notification payload paramters

Parameter Description

name Name of the notification. The name is automatically prefixed with 
ServiceNow Default Problem Notification  and the 
instance name is added to it.

alertingProfile ID of the alerting profile in Dynatrace.

type Type of payload that is automatically set to webhook.

url Webhook URL in the format https://https://<instance 
name>.service-now.com/ /api/sn_em_connector/
em/inbound_event?source=SGO-Dynatrace.

payload Custom payload created for notification in the following format:

{
 
  "ImpactedEntities": {ImpactedEntities},
 
  "ImpactedEntity": "{ImpactedEntity}",
 
  "PID": "{PID}",
 
  "ProblemDetailsHTML": "{ProblemDetailsHTML}",
 
  "ProblemDetailsJSON": {ProblemDetailsJSON},
 
  "ProblemDetailsMarkdown": 
 "{ProblemDetailsMarkdown}",
 
  "ProblemDetailsText": "{ProblemDetailsText}",
 
  "ProblemID": "{ProblemID}",
 
  "ProblemImpact": "{ProblemImpact}",
 
  "ProblemSeverity": "{ProblemSeverity}",
 
  "ProblemTitle": "{ProblemTitle}",
 
  "ProblemURL": "{ProblemURL}",
 
  "State": "{State}",
 
  "Tags": "{Tags}"
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Parameter Description

 
} 

vi. Repeat the steps for each connection.

vii. Set the Create Default Notification Payload Templates  task to complete by selecting Mark 
as Complete.

9. Set up scheduled import jobs.

a. In the Set up scheduled import jobs  section of the Service Graph Connector for Microsoft 
Defender  page, select Get Started.

b. For the Configure the scheduled import jobs task, select Configure.

c. Select the name of the scheduled import you want to run.

d. On the Scheduled Data Import form, verify the field values for the scheduled job and select 
the Active  check box.

For more information, see Schedule a data import .

e. Select Update.

f. Set the Set up scheduled import jobs  task to complete by selecting Mark as Complete.

CMDB  classes targeted in Service Graph Connector for Observability - Dynatrace

When you complete setting up the connection, you can configure the integration to periodically 
pull data from Dynatrace. The data is saved in tables that extend from the Configuration item 
[cmdb_ci] table.

Application [cmdb_ci_appl]

The following attributes in the Application [cmdb_ci_appl] table are populated by collected data.

Attribute label Attribute name

Class sys_class_name

Configuration file config_file

Installation directory install_directory

Name name

Operational status operational_status

Running process command running_process_command

Running process key parameters running_process key parameters

Version version
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Relationships created for Application

Parent class Relationship type Child class

Application [cmdb_ci_appl] Runs on::Runs Computer 
[cmdb_ci_computer]

Application [cmdb_ci_appl] Runs on::Runs Docker Container 
[cmdb_ci_docker_container]

Application [cmdb_ci_appl] Reference Key value [cmdb_key_value]

Note: 
Based on the Discovery  Process Classifications list, the tables that extend the 
Application [cmdb_ci_appl] table are populated by the SGO-Dynatrace Processes 
[sn_dynatrace_integ_sg_dynatrace_processes] data source.

Availability Zone [cmdb_ci_availability_zone]

The following attributes in the Availability Zone [cmdb_ci_availability_zone] table are populated 
by collected data.

Attribute label Attribute name

Name name

Object ID object_id

AWS Datacenter [cmdb_ci_aws_datacenter]

The following attributes in the AWS Datacenter [cmdb_ci_aws_datacenter] table are populated by 
collected data.

Attribute label Attribute name

Name name

Object ID object_id

Region region

Relationships created for AWS Datacenter

Parent class Relationship type Child class

AWS Datacenter 
[cmdb_ci_aws_datacenter]

Hosted on::Hosts Cloud Service Account 
[cmdb_ci_cloud_service_account]

AWS Datacenter 
[cmdb_ci_aws_datacenter]

Contains::Contained by Availability Zone 
[cmdb_ci_availability_zone]

Azure Datacenter [cmdb_ci_azure_datacenter]

The following attributes in the Azure Datacenter [cmdb_ci_azure_datacenter] table are populated 
by collected data.
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Attribute label Attribute name

Install Status install_status

Name name

Object ID object_id

Region region

Relationship created for Azure Datacenter

Parent class Relationship type Child class

Azure Datacenter 
[cmdb_ci_azure_datacenter]

Hosted on::Hosts Cloud Service Account 
[cmdb_ci_cloud_service_account]

Calculated Application Service [cmdb_ci_service_calculated]

The following attributes in the Calculated Application Service [cmdb_ci_service_calculated] table 
are populated by collected data.

Attribute label Attribute name

Comments comments

Correlation ID correlation_id

Hide from dashboard hide_from_dashboard

Metadata metadata

Name name

Operational status operational_status

Service Populator service_populator

Service Populator Status populator_status

Service Type type

Note: 
The Comments  attribute includes the following information:

• Service Type

• Edition

• TCP Port

Relationships created for Calculated Application Service

Parent class Relationship type Child class

Calculated 
Application Service 
[cmdb_ci_service_calculated]

Depends on::Used by Configuration Item [cmdb_ci]
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Relationships created for Calculated Application Service  (continued)

Parent class Relationship type Child class

Calculated 
Application Service 
[cmdb_ci_service_calculated]

Runs on::Runs Computer 
[cmdb_ci_computer]

Calculated 
Application Service 
[cmdb_ci_service_calculated]

Contains::Contained by Cloud Load Balancer 
[cmdb_ci_cloud_load_balancer]

Calculated 
Application Service 
[cmdb_ci_service_calculated]

Contains::Contained by Group [cmdb_ci_group]

Calculated 
Application Service 
[cmdb_ci_service_calculated]

Reference Key value [cmdb_key_value]

Cloud DataBase [cmdb_ci_cloud_database]

The following attributes in the Cloud DataBase [cmdb_ci_cloud_database] table are populated by 
collected data.

Attribute label Attribute name

Fully qualified domain name fqdn

Install Status install_status

Name name

Object ID object_id

State state

TCP port(s) tcp_port

Type type

Version version

Relationships created for Cloud DataBase

Parent class Relationship type Child class

Cloud DataBase 
[cmdb_ci_cloud_database]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Cloud DataBase 
[cmdb_ci_cloud_database]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]

Cloud DataBase 
[cmdb_ci_cloud_database]

Reference Key Value [cmdb_key_value]

Cloud Function [cmdb_ci_cloud_function]

The following attributes in the Cloud Function [cmdb_ci_cloud_function] table are populated by 
collected data.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1261



Attribute label Attribute name

Code Size code_size

Fully qualified domain name fqdn

Install Status install_status

Language language

Name name

Object ID object_id

Version version

Relationships created for Cloud Function

Parent class Relationship type Child class

Cloud Function 
[cmdb_ci_cloud_function]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]

Cloud Function 
[cmdb_ci_cloud_function]

Reference Key Value [cmdb_key_value]

Cloud Hardware Type [cmdb_ci_cloud_hardware_type]

The following attributes in the Cloud Hardware Type [cmdb_ci_cloud_hardware_type] table are 
populated by collected data.

Attribute label Attribute name

Name name

Object ID object_id

Provider provider

Relationship created for Cloud Hardware Type

Parent class Relationship type Child class

Cloud Hardware Type 
[cmdb_ci_cloud_hardware_type]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Cloud LB IPAddress [cmdb_ci_cloud_lb_ipaddress]

The following attributes in the Cloud LB IPAddress [cmdb_ci_cloud_lb_ipaddress] table are 
populated by collected data.

Attribute label Attribute name

Install Status install_status

Name name

Object ID object_id
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Cloud Load Balancer [cmdb_ci_cloud_load_balancer]

The following attributes in the Cloud Load Balancer [cmdb_ci_cloud_load_balancer] table are 
populated by collected data.

Attribute label Attribute name

Install Status install_status

Name name

Object ID object_id

Operational status operational_status

Relationships created for Cloud Load Balancer

Parent class Relationship type Child class

Cloud Load Balancer 
[cmdb_ci_cloud_load_balancer]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Cloud Load Balancer 
[cmdb_ci_cloud_load_balancer]

Owns::Owned by Cloud LB IPAddress 
[cmdb_ci_cloud_lb_ipaddress]

Cloud Load Balancer 
[cmdb_ci_cloud_load_balancer]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]

Cloud Load Balancer 
[cmdb_ci_cloud_load_balancer]

Reference Key Value [cmdb_key_value]

Cloud Object Storage [cmdb_ci_cloud_object_storage]

The following attributes in the Cloud Object Storage [cmdb_ci_cloud_object_storage] table are 
populated by collected data.

Attribute label Attribute name

Cloud Provider cloud_provider

Install Status install_status

Name name

Object ID object_id

Service Name service_name

Relationships created for Cloud Object Storage

Parent class Relationship type Child class

Cloud Object Storage 
[cmdb_ci_cloud_object_storage]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Cloud Object Storage 
[cmdb_ci_cloud_object_storage]

Reference Key Value [cmdb_key_value]
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Cloud Resource [cmdb_ci_cmp_resource]

The following attributes in the Cloud Resource [cmdb_ci_cmp_resource] table are populated by 
collected data.

Attribute label Attribute name

Install Status install_status

Name name

Object ID object_id

Relationships created for Cloud Resource

Parent class Relationship type Child class

Cloud Resource 
[cmdb_ci_cmp_resource]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Cloud Resource 
[cmdb_ci_cmp_resource]

Reference Key Value [cmdb_key_value]

Cloud Service Account [cmdb_ci_cloud_service_account]

The following attributes in the Cloud Service Account [cmdb_ci_cloud_service_account] table are 
populated by collected data.

Attribute label Attribute name

Account Id account_id

Datacenter Type datacenter_type

Install Status install_status

Name name

Object ID object_id

Operational status operational_status

Cloud Storage Account [cmdb_ci_cloud_storage_account]

The following attributes in the Cloud Storage Account [cmdb_ci_cloud_storage_account] table 
are populated by collected data.

Attribute label Attribute name

Name name

Install Status install_status

Object ID object_id

Sku Name sku_name
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Relationships created for Cloud Storage Account

Parent class Relationship type Child class

Cloud Storage Account 
[cmdb_ci_cloud_storage_account]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]

Cloud Storage Account 
[cmdb_ci_cloud_storage_account]

Reference Key Value [cmdb_key_value]

Computer [cmdb_ci_computer]

The following attributes in the Computer [cmdb_ci_computer] table are populated by collected 
data.

Attribute label Attribute name

Class sys_class_name

CPU core count cpu_core_count

DNS Domain dns_domain

Fully qualified domain name fqdn

Is Virtual virtual

Name name

Operating System os

OS Version os_version

RAM (MB) ram

Relationships created for Computer

Parent class Relationship type Child class

Computer 
[cmdb_ci_computer]

Owns::Owned by IP Address 
[cmdb_ci_ip_address]

Computer 
[cmdb_ci_computer]

Reference Key Value [cmdb_key_value]

Computer 
[cmdb_ci_computer]

Reference Software Installation 
[cmdb_sam_sw_install]

Docker Container [cmdb_ci_docker_container]

The following attributes in the Docker Container [cmdb_ci_docker_container] table are populated 
by collected data.

Attribute label Attribute name

Container id container_id

Install Status install_status

Name name
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Note: 
The Install Status  value is based on the value of the 
properties.containerStatus.state  field in the incoming payload.

• If the properties.containerStatus.state  value is running, the Install 
Status  value is set to 1 (Installed).

• If the properties.containerStatus.state  value is terminated  or is empty, 
or if there are any errors, the Install Status  value is set to 7 (Retired).​

• For all other properties.containerStatus.state  values, the Install 
Status  value isn't updated.​

Docker Image [cmdb_ci_docker_image]

The following attributes in the Docker Image [cmdb_ci_docker_image] table are populated by 
collected data.

Attribute label Attribute name

Image id image_id

Image digest image_digest

Name name

Relationship created for Docker Image

Parent class Relationship type Child class

Docker Image 
[cmdb_ci_docker_image]

Instantiates::Instantiated by Docker Container 
[cmdb_ci_docker_container]

DynamoDB Table [cmdb_ci_dynamodb_table]

The following attributes in the DynamoDB Table [cmdb_ci_dynamodb_table] table are populated 
by collected data.

Attribute label Attribute name

Name name

Install Status install_status

Object ID object_id

Relationships created for DynamoDB Table

Parent class Relationship type Child class

DynamoDB Table 
[cmdb_ci_dynamodb_table]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

DynamoDB Table 
[cmdb_ci_dynamodb_table]

Reference Key Value [cmdb_key_value]
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Group [cmdb_ci_group]

The following attribute in the Group [cmdb_ci_group] table is populated by collected data.

Attribute label Attribute name

Name name

Relationship created for Group

Parent class Relationship type Child class

Group [cmdb_ci_group] Contains::Contained by Application [cmdb_ci_appl]

Hardware Type [cmdb_ci_compute_template]

The following attributes in the Hardware Type [cmdb_ci_compute_template] table are populated 
by collected data.

Attribute label Attribute name

Name name

Object ID object_id

Relationship created for Hardware Type

Parent class Relationship type Child class

Hardware Type 
[cmdb_ci_compute_template]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Image [cmdb_ci_os_template]

The following attributes in the Image [cmdb_ci_os_template] table are populated by collected 
data.

Attribute label Attribute name

Name name

Object ID object_id

Relationship created for Image

Parent class Relationship type Child class

Image [cmdb_ci_os_template] Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Instance Scale Set [cmdb_ci_instance_scale_set]

The following attributes in the Instance Scale Set [cmdb_ci_instance_scale_set] table are 
populated by collected data.
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Attribute label Attribute name

Name name

Install Status install_status

Object ID object_id

Relationships created for Instance Scale Set

Parent class Relationship type Child class

Instance Scale Set 
[cmdb_ci_instance_scale_set]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]

Instance Scale Set 
[cmdb_ci_instance_scale_set]

Reference Key Value [cmdb_key_value]

IP Address [cmdb_ci_ip_address]

The following attributes in the IP Address [cmdb_ci_ip_address] table are populated by collected 
data.

Attribute label Attribute name

IP Address ip_address

IP version ip_version

Name name

Key value [cmdb_key_value]

The following attributes in the Key value [cmdb_key_value] table are populated by collected data.

Attribute label Attribute name

Key key

Value value

Kubernetes Cluster [cmdb_ci_kubernetes_cluster]

The following attributes in the Kubernetes Cluster [cmdb_ci_kubernetes_cluster] table are 
populated by collected data.

Attribute label Attribute name

Cluster Resource ID cluster_resource_id

Install Status install_status

Name name
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Relationships created for Kubernetes Cluster

Parent class Relationship type Child class

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Contains::Contained by Kubernetes Namespace 
[cmdb_ci_kubernetes_namespace]

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Cluster of::Cluster Kubernetes Node 
[cmdb_ci_kubernetes_node]

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Contains::Contained by Kubernetes Service 
[cmdb_ci_kubernetes_service]

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Contains::Contained by Kubernetes Pod 
[cmdb_ci_kubernetes_pod]

Kubernetes Namespace [cmdb_ci_kubernetes_namespace]

The following attributes in the Kubernetes Namespace [cmdb_ci_kubernetes_namespace] table 
are populated by collected data.

Attribute label Attribute name

Install Status install_status

Kubernetes UID k8s_uid

Name name

Kubernetes Node [cmdb_ci_kubernetes_node]

The following attributes in the Kubernetes Node [cmdb_ci_kubernetes_node] table are populated 
by collected data.

Attribute label Attribute name

Install Status install_status

Kubernetes UID k8s_uid

Name name

Kubernetes Pod [cmdb_ci_kubernetes_pod]

The following attributes in the Kubernetes Pod [cmdb_ci_kubernetes_pod] table are populated 
by collected data.

Attribute label Attribute name

Install Status install_status

Kubernetes UID k8s_uid

Name name

Namespace namespace
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Relationships created for Kubernetes Pod

Parent class Relationship type Child class

Kubernetes Pod 
[cmdb_ci_kubernetes_pod]

Runs on::Runs Kubernetes Node 
[cmdb_ci_kubernetes_node]

Kubernetes Pod 
[cmdb_ci_kubernetes_pod]

Contains::Contained by Docker Container 
[cmdb_ci_docker_container]

Kubernetes Service [cmdb_ci_kubernetes_service]

The following attributes in the Kubernetes Service [cmdb_ci_kubernetes_service] table are 
populated by collected data.

Attribute label Attribute name

Install Status install_status

Kubernetes UID k8s_uid

Name name

Namespace namespace

Server [cmdb_ci_server]

The following attributes in the Server [cmdb_ci_server] table are populated by collected data.

Attribute label Attribute name

DNS Domain dns_domain

Fully qualified domain name fqdn

Is Virtual virtual

Name name

Object ID object_id

Relationships created for Server

Parent class Relationship type Child class

Server [cmdb_ci_server] Virtualized by::Virtualizes Virtual Machine Instance 
[cmdb_ci_vm_instance]

Server [cmdb_ci_server] Reference Key Value [cmdb_key_value]

Software [cmdb_ci_spkg]

The following attributes in the Software [cmdb_ci_spkg] table are populated by collected data.

Attribute label Attribute name

Key key
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Attribute label Attribute name

Name name

Version version

Relationship created for Software

Parent class Relationship type Child class

Software [cmdb_ci_spkg] Reference Software Instance 
[cmdb_software_instance]

Software Installation [cmdb_sam_sw_install]

The following attributes in the Software Installation [cmdb_sam_sw_install] table are populated 
by collected data.

Attribute label Attribute name

Discovery source discovery_source

Display name display_name

Version version

Software Instance [cmdb_software_instance]

The following attributes in the Software Instance [cmdb_software_instance] table are populated 
by collected data.

Attribute label Attribute name

Installed on installed_on

Name name

Relationship created for Software Instance

Parent class Relationship type Child class

Software Instance 
[cmdb_software_instance]

Reference Computer 
[cmdb_ci_computer]

Virtual Machine Instance [cmdb_ci_vm_instance]

The following attributes in the Virtual Machine Instance [cmdb_ci_vm_instance] table are 
populated by collected data.

Attribute label Attribute name

Install Status install_status

IP Address ip_address

Name name
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Attribute label Attribute name

Object ID object_id

Operational status operational_status

VM Instance ID vm_inst_id

Relationships created for Virtual Machine Instance

Parent class Relationship type Child class

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Provisioned From::Provisioned Hardware Type 
[cmdb_ci_compute_template]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Provisioned From::Provisioned Cloud Hardware Type 
[cmdb_ci_cloud_hardware_type]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Provisioned From::Provisioned Image [cmdb_ci_os_template]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Reference Key Value [cmdb_key_value]

Set up push notifications from Dynatrace

Set up push notifications of events from Dynatrace  into a ServiceNow  instance that has the 
Service Graph Connector for Observability - Dynatrace  installed.

Before you begin
If you don't have an alerting profile in Dynatrace, then complete the following steps to create one:

1. Navigate to Settings  > Alerting  > Alerting Profiles.

2. Set up an alerting profile according to your business needs.

Note: 
For more information about how to set up an alerting profile, see Alerting profiles  on the 
Dynatrace documentation site.

You must have Observability Commons for CMDB installed.

Role required: admin

Procedure

1. In the Dynatrace  instance, navigate to Settings  > Integration  > Problem notifications.

2. Click Add Notification.

3. On the form, fill in the fields.

Field Value

Notification Type Custom Integration
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Field Value

Display Name Name of the notification

Webhook URL Use the following URL: https://<name_of_your_servicenow_instance_name> /api/
sn_em_connector/em/inbound_event?source=SGO-Dynatrace

Additional HTTP Headers > Create basic authorization a. In the ServiceNow  instance, set a password for the pre-created Dynatrace  API user by doing the following:

i. Navigate to System Security  > Users.

ii. Select the Dynatrace API user.

iii. Set the Password  field with a new password.

iv. Clear the Password needs reset  check box.

v. Update or save the user.

b. Set the Username  field to DynatraceAPI.

c. Set the Password  field to the password that you had created.

d. Click Add.

Custom Payload Use the following payload:

{
  "connectionId": <connections_alias_sys_id>,
  "ImpactedEntities": {ImpactedEntities},
  "ImpactedEntity": "{ImpactedEntity}",
  "PID": "{PID}",
  "ProblemDetailsHTML": "{ProblemDetailsHTML}",
  "ProblemDetailsJSONv2": {ProblemDetailsJSONv2},
  "ProblemDetailsMarkdown": "{ProblemDetailsMarkdown}",
  "ProblemDetailsText": "{ProblemDetailsText}",
  "ProblemID": "{ProblemID}",
  "ProblemImpact": "{ProblemImpact}",
  "ProblemSeverity": "{ProblemSeverity}",
  "ProblemTitle": "{ProblemTitle}",
  "ProblemURL": "{ProblemURL}",
  "State": "{State}",
  "Tags": "{Tags}"
}

Note: 
For the <connections_alias_sys_id>:

a. Navigate to All  > IntegrationHub  > Connection & Credentials  > Connection & Credential Aliases.

b. Select to open the connector for which you want to get the <connections_alias_sys_id>.

c. Right-click the context menu ( ) and then select Copy sys_id.

Alerting Profile Select the alerting profile created in the Before you begin section or another alerting profile.

Sending Test Notifications Click to send a test notification, and verify that the response status is 200.
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Service Graph Connector for Observability - Dynatrace  properties

Service Graph Connector for Observability - Dynatrace  properties control the behavior of the 
connector.

Connection properties

These connection properties are available for Service Graph Connector for Observability - 
Dynatrace.

Note: 
To open the Service Graph Connection Properties 
[sn_cmdb_int_util_service_graph_connection_property] table for the connector, navigate 
to All  > Service Graph Connectors  > Dynatrace Observability  > Connections  and select 
the connection name. The connection properties are displayed in the Service Graph 
Connection Properties related list.

Connection properties for Service Graph Connector for Observability - Dynatrace

Property Description

managementZoneIds
Enter a list of management zone IDs to fetch from 
Dynatrace. For multiple entries, separate the IDs with 
commas.

managementZoneNames
Enter a list of management zones to fetch from Dynatrace. 
For multiple entries, separate the names with commas.

tags
Enter a list of tags to fetch from Dynatrace. For multiple 
entries, separate the tags with commas.

grailEnabled
Set the property to true  for a Grail-enabled tenant.

OAuth Connection
View the Sys ID of the OAuth connection and credential 
alias linked to the Service Graph connection record.

serviceTypes
Enter a list of Dynatrace  service types from where to ingest 
the data into CMDB. For multiple entries, separate the 
service types with commas.
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Connection properties for Service Graph Connector for Observability - Dynatrace 
(continued)

Property Description

Note: 
All service types except for DATABASE_SERVICE 
are mapped to the Calculated Application Service 
[cmdb_ci_service_calculated] CMDB  table. The 
DATABASE_SERVICE service type is mapped to the 
Database Instance [cmdb_ci_db_instance] CMDB 
table.

Valid values are:

• BACKGROUND_ACTIVITY

• CICS_SERVICE

• CUSTOM_SERVICE

• DATABASE_SERVICE

• ENTERPRISE_SERVICE_BUS_SERVICE

• EXTERNAL

• IBM_INTEGRATION_BUS_SERVICE

• IMS_SERVICE

• MESSAGING_SERVICE

• QUEUE_LISTENER_SERVICE

• RMI_SERVICE

• RPC_SERVICE

• WEB_REQUEST_SERVICE

• WEB_SERVICE

saveRESTResponseAsAttachment​
Set the property to true  to use the SGO-Dynatrace 
Fetch Entities For Larger Payload action flow and save the 
response from Dynatrace  as an attachment with a .json 
extension. 

Set the property to false  to use the dedicated action 
flow and consume the response from Dynatrace  as a data 
stream for processing.​

• Type: true | false

• Default value: false

System properties

These system properties are available for Service Graph Connector for Observability - 
Dynatrace.
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Note: 
To open the System Properties [sys_properties] table, enter sys_properties.list  in 
the navigation filter.

System properties for Service Graph Connector for Observability - Dynatrace

Property Description

sn_dynatrace_integ.critical_cluster_threshold
Enter the percentage of an application 
cluster's nodes that need to be in a 
state to raise that state to its parent in 
the service map.

• Type: integer

• Default value: 75

• Location: System Property 
[sys_properties] table

sn_dynatrace_integ.default_from_value_days
Enter the number of days a 
configuration item (CI) can be inactive 
before it is ignored.

• Type: integer

• Default value: 300

• Location: System Property 
[sys_properties] table

sn_dynatrace_integ.events_for_unmatched_ci.enabled
Set the property to true  to ingest 
events that don't have a matching CI in 
CMDB.

• Type: true | false

• Default value: false

• Location: System Property 
[sys_properties] table

sn_dynatrace_integ.page_size
Enter the page size used in REST 
requests to fetch Dynatrace  entities.

• Type: integer

• Default value: 50

• Location: System Property 
[sys_properties] table

sn_dynatrace_integ.populate_applications
Set the property to true  to populate 
the Application [cmdb_ci_appl] CIs 
from Dynatrace  processes. Set the 
property to false  to ignore the 
Application [cmdb_ci_appl] CIs.
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System properties for Service Graph Connector for Observability - Dynatrace  (continued)

Property Description

• Type: true | false

• Default value: false

• Location: System Property 
[sys_properties] table

Note: 
This property is read via 
scheduled imports. The manual 
execution of the SGO-Dynatrace 
Processes and SGO-Dynatrace 
Process Groups data sources will 
not consider this property.

sn_dynatrace_integ.createUnmatchedApplicationCIs
Set the property to true  to add 
unclassified processes to the 
Application [cmdb_ci_appl] table. 
Set the property to false  to ignore 
unclassified processes.

• Type: true | false

• Default value: true

• Location: System Property 
[sys_properties] table

Note: 
Classified processes are added 
to the corresponding child 
application classes in the 
Application [cmdb_ci_appl] table 
regardless of the value of this 
property.

Accessing the connection details of Service Graph Connector for Observability - Dynatrace

You can access the connection details of the Service Graph Connector for Observability - 
Dynatrace  in a single view using the common connection framework (CCF) included within the 
Integration Commons for CMDB  (sn_cmdb_int_util) store app.

With the CCF, you can access all the connections used by the Service Graph Connector for 
Observability - Dynatrace. The connection details include the connection alias, connection 
properties, data sources, and scheduled data imports associated with a connection. You can 
also test the connection.

Access the details of a Dynatrace  connection

Access the details of a Dynatrace  connection configured for the Service Graph Connector for 
Observability - Dynatrace.

Before you begin
Role required: admin
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Procedure

1. Navigate to All  > Service Graph Connectors  > Dynatrace Observability  > Connections.

2. From the Name  column of the Service Graph Connections list, select a connection.

3. On the Service Graph Connections page, view the connection details such as the connection 
name, alias, and data sources.

4. Select a related list to view further details of the connection.

5. Optional:  Select the Test Connection  related link to test the connection.

Related topics

Service Graph Connector for Observability - Dynatrace properties

Accessing the connection details of Service Graph Connectors

Service Graph Connector for Observability - New Relic

Use the Service Graph Connector for Observability - New Relic  to ingest CMDB  data from a 
New Relic  installation using REST APIs. Push events from New Relic  into ServiceNow  with Event 
Management.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Supported versions

• New Relic  version: Last tested on July 01, 2025

• Supported ServiceNow  versions:

◦ Washington DC

◦ Xanadu

◦ Yokohama

◦ Zurich

Configuring a connection for the connector

You can configure a connection for the connector by using the SGC Central  view in the CMDB 
Workspace. The view enables you to discover and install connectors, and then effectively 
manage the full life cycle of creating, editing, monitoring, and debugging connections. To 
configure the connector using SGC Central, see Configure Service Graph Connector for 
Observability - New Relic using SGC Central.

Important: 
Unless there are configuration issues, use the SGC Central  view in the CMDB Workspace 
to configure the connection for the connector, as the guided setup method is being 
deprecated.

CMDB integrations dashboard

The Integration Commons for CMDB  store app provides a dashboard with a central view of the 
status, processing results, and processing errors of all installed integrations. You can see metrics 
for all integration runs. You can filter the view to a specific CMDB  integration, a specific time 
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duration, or a specific integration run. For more details about monitoring Observability New Relic 
integrations in the CMDB  Integrations Dashboard, see Using the CMDB Integrations Dashboard.

Data mapping

Data from the New Relic  data sources is mapped and transformed into the ServiceNow  CMDB 
Configuration Item (CI) class definitions using the Robust Transform Engine (RTE). Data is 
inserted into the ServiceNow  CMDB  using the Identification and Reconciliation Engine (IRE).

The following data sources are included for New Relic:

• SG-New Relic Application Services

• SG-New Relic Applications

• SG-New Relic Disks

• SG-New Relic Hosts

• SG_New Relic Networks

When you complete setting up the connection, you can configure the integration to periodically 
pull data from the New Relic  application. The data is loaded into the following staging tables:

• SG-New Relic Applications [sn_newrelic_integ_sg_new_relic_applications]

• SG-New Relic Application Services [sn_newrelic_integ_application_services]

• SG-New Relic Disks [sn_newrelic_integ_disks]

• SG-New Relic Hosts [sn_newrelic_integ_hosts]

• SG_New Relic Networks [sn_newrelic_integ_networks]

The data is then inserted into the following target tables:

• Application [cmdb_ci_appl]

• Application service [cmdb_ci_service_calculated]

• Disk [cmdb_ci_disk]

• IP Address[cmdb_ci_ip_address]

• Network Adapter [cmdb_ci_network_adapter]

• Running Process [cmdb_running_process]

• Server [cmdb_ci_server]

• Software Installation [cmdb_sam_sw_install] (If the Software Asset Management (SAM) 
application is installed.)

• Software Instance [cmdb_software_instance] (If the SAM application is not installed.)

• Software [cmdb_ci_spkg] (If the SAM application is not installed.)

For more information on where data is saved when pulling data from New Relic, see CMDB 
classes targeted in Service Graph Connector for Observability - New Relic.

You can use the IntegrationHub ETL app to view the data maps. See IntegrationHub ETL  for more 
information.
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System property

The sn_newrelic_integ.alerts_for_unmatched_ci.enabled  system property 
determines whether to ingest events that don't have a matching CMDB  CI class. Set the value of 
this system property to true  to ingest unmatched events. The default value is false.

Related topics

Service Graph Connectors

Configure Service Graph Connector for Observability - New Relic  using SGC Central

Use the playbook available with the SGC Central  application to set up the Service Graph 
Connector for Observability - New Relic  for pulling in New Relic  project data into the CMDB.

Before you begin
Dependencies and requirements:

• Install Service Graph Connector for Observability - New Relic  version 1.3.0 or later from the 
ServiceNow Store. For ServiceNow Store  installation steps, see Install a ServiceNow Store 
application .

• Install Observability Commons for CMDB  (sn_observability), which is only required for event 
ingestion. This must be installed prior to installing the connector for Event Management to 
work. For more information, see Observability Commons for CMDB  on the ServiceNow Store.

Role required: cmdb_inst_admin

About this task
The playbook experience for onboarding connectors is activated with SGC Central  in the CMDB 
Workspace. To configure the SGC Central  application, see Configuring SGC Central  and for more 
information on how to interact with a playbook, see Interact with Playbook .

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the CMDB Workspace, select SGC Central.

3. On the Overview page, select Create connection.

Tip: 
Alternatively, you can select Create connection  on the All connections page.

4. On the Create connection window, select the New Relic  connector type, and then select 
Create connection.

5. Complete the initial prerequisites when setting up a connection for the first time using a 
connector.

Note: 
This step is required only during the first-time setup. See Perform initial setup tasks when 
creating a connection in SGC Central.

6. Enter connection details and test the API connection for importing New Relic  data.

a. In the Setup  stage of the playbook, select the Create and test connection  activity.

b. On the form, fill in the fields.
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Configure and test connection form

Field Description

Connection Name Name to identify the New Relic  connection 
record.

Connection URL New Relic  base URL in the following format: 
<base-URL>.

API Key New Relic  API key or tenant code.

Account ID New Relic  account ID.

c. Select Update and test connection.

d. After the connection test is complete, select Continue.

7. For the Configure Observability  activity, select Continue.
New Relic  creates the destination, channel, and workflow required to enable alerts for all 
configuration items (CIs).

8. Configure the import schedule to import data at regular intervals.

a. In the Setup  stage of the playbook, select the Configure import schedule  activity.

b. Select Configure import schedule.

c. Expand the Parent scheduled data import within the Import schedules list to select the SG-
New Relic Hosts  import schedule.

d. In the Configure import schedule  dialog box, select the Active  check box, and then fill in the 
run schedule and time details.

For more information, see Schedule a data import .

e. Select Save.
Alternatively, select Execute Now  to execute the import schedule immediately.

f. Select Continue.

9. In the Setup  stage of the playbook, select the Confirm connection creation  activity to verify 
whether the connection was configured.

10. Enable alerts for configuration items (CIs) that aren’t available in the CMDB.

a. Navigate to Workspaces  > CMDB Workspace  > SGC Central.

b. Select Settings.

c. Select New Relic system properties.

d. On the System Properties form, select the 
sn_newrelic_integ.alerts_for_unmatched_ci.enabled  system property.

e. Set the Value  of the system property to true.

f. Select Submit.
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What to do next
Select View all connections  to review the connection details. The configured connection 
appears in the Installed connections list.

Related topics

Service Graph Connector for Observability - New Relic

Configure Service Graph Connector for Observability - New Relic  using the guided setup

Set up scheduled import jobs to pull in data from New Relic  into your CMDB.

Before you begin
To use this Service Graph Connector, you need a subscription to a Subscription Unit that is 
based in the IT Operations Management  (ITOM) Visibility application or in the ITOM  Discovery 
application. As defined in the section titled "Managed IT Resource Types" in ServiceNow 
Subscription Unit Overview  for your subscription, for managed IT resources that are created 
or modified in the CMDB  by this Service Graph Connector, but that aren’t yet managed by ITOM 
Visibility or ITOM Discovery , these resources will increase Subscription Unit consumption from 
that application. Review your current Subscription Unit consumption within ITOM Visibility or 
ITOM Discovery to ensure available capacity.

Dependencies and requirements:

• The Integration Commons for CMDB  store app, which is automatically installed.

• The CMDB CI class models store app, which is automatically installed. See CMDB CI Class 
Models store app.

• The ITOM Discovery License plugin (com.snc.itom.discovery.license). You must activate this 
plugin.

• ITOM Licensing plugin (com.snc.itom.license). For more information, see Request Discovery .

• The Datastream Action plugin (com.glide.hub.action_type.datastream), which is automatically 
installed.

• Observability Commons for CMDB  (sn_observability), which is only required for event 
ingestion. This must be installed prior to installing the connector for Event Management to 
work. For more information, see Observability Commons for CMDB  on the ServiceNow Store.

Note: 
If you have an earlier version of the Service Graph Connector for Observability - New Relic, 
then don’t migrate data from the old connector. You must uninstall the previous version and 
run the new integration.

Role required: admin

Procedure

1. Ensure that the application scope is set to the Service Graph Connector for Observability - 
New Relic  application by using the application picker.
For more information, see Application picker .

2. Navigate to All  > Service Graph Connectors  > New Relic  > Setup.

3. On the Getting started page, select Get Started.

4. Configure the authentication credentials to send requests to the New Relic  application.
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a. Configure your New Relic  connection and credentials.

i. In the Configure the Connection  section of the New Relic Integration with CMDB  page, 
select Get Started.

ii. For the Configure connection and credentials task, select Configure.

iii. On the Connections page of the Flow Designer, select Configure  for the 
NewRelicConnectionAlias  connection that is available by default.

iv. On the form, review and modify the fields.

Configure Connection form

Field Description

Connection Information

Connection Name Name to uniquely identify the 
connection record. For example, 
NewRelicConnectionAlias.

Connection URL Base URL to connect to the New Relic 
application in the following format:

https://api.newrelic.com/gra
phql

Note: 
This field is automatically set to the 
URL to connect to the NerdGraph 
API in the New Relic  application. 
Leave the field value as is.

Credential Information

API Key NerdGraph  API token used for 
authentication on the New Relic 
application.

Account ID Account ID associated with the New Relic 
credential.

v. Select Configure Connection.

Note: 
The Service Graph Connector for Observability - New Relic  supports connection to a 
single New Relic  instance only. So, you can use the single default connection only.

vi. Return to the Configure the connection task page using the back button for your browser.

vii. Set the Configure connection and credentials task to complete by selecting Mark as 
Complete.

b. Test the NerdGraph  API connection to import data from the New Relic  application.

i. In the Configure the Connection  section of the New Relic Integration with CMDB  page, 
select Continue.

ii. For the Test Connection  task, select Configure.
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iii. Test the connection by selecting the Test Connection  related link.

Testing the connection might take a few moments. The page is refreshed to show the test 
results.

iv. When the Status  field is set to Success, select Update.

If any of the tests have errors, follow the suggestions for remediation.

v. Set the Test Connection  task to complete by selecting Mark as Complete.

5. Configure the destination, channel, and workflow  for Observability New Relic  and turn on alerts 
for unmatched configuration items (CIs).

a. Configure the destination, channel, and workflow  for Observability New Relic.

i. In the Configure Observability  section of the New Relic Integration with CMDB  page, select 
Get started.

ii. For the Configure destination, channel and workflow  task, select Configure.

iii. In the SG-New Relic Webhooks list, select New.

iv. On the form, fill in the fields.

New record form

Field Description

Name Name of the New Relic  configuration.

The destination, channel, and workflow  strings are 
appended to the configuration name when the configuration is 
created.

Connection and 
Credential Alias

Select the connection alias that you created in step 4.

v. Select Submit.

vi. Set the Configure destination, channel and workflow  task to complete by selecting Mark 
as Complete.

b. Enable alerts for configuration items (CIs) that aren’t available in the CMDB.

i. In the Configure Observability  section of the New Relic Integration with CMDB  page, select 
Continue.

ii. For the Turn on alerts for unmatched CI  task, select Configure.

iii. On the System Properties form, select the 
sn_newrelic_integ.alerts_for_unmatched_ci.enabled  system property.

iv. Set the Value  of the system property to true.

v. Select Submit.

vi. Set the Turn on alerts for unmatched CI  task to complete by selecting Mark as Complete.

6. Configure the scheduled jobs to import data from the New Relic  application.
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a. In the Set up scheduled data imports  section of the New Relic Integration with CMDB  page, 
select Get started.

b. For the Configure Scheduled Data Imports  task, select Configure.

c. Select the scheduled job that you want to activate.

d. On the Scheduled Data Import form, verify the field values for the scheduled job.
For more information, see Schedule a data import .

e. Select the Active  check box to activate the scheduled job.

f. Select Update.

g. Repeat steps 6.c  to 6.f  for each scheduled job for data import.

h. Navigate back to the guided setup page.

i. Set the Configure Scheduled Data Imports  task to complete by selecting Mark as Complete.

CMDB  classes targeted in Service Graph Connector for Observability - New Relic

When you complete setting up the connection, you can configure the integration to periodically 
pull data from New Relic. The data is saved in tables that extend from the Configuration item 
[cmdb_ci] table.

Server [cmdb_ci_server]

The following attributes in the Server [cmdb_ci_server] table are populated by collected data:

Attribute label Attribute name

CPU core count cpu_core_count

Disk space (GB) disk_space

DNS Domain dns_domain

Fully qualified domain name fqdn

Host name host_name

Operating System os

Relationships created for Server

Parent class Relationship type Child class

Server [cmdb_ci_server] Contains::Contained by Disk [cmdb_ci_disk]

Server [cmdb_ci_server] Owns::Owned by IP Address 
[cmdb_ci_ip_address]

Server [cmdb_ci_server] Owns::Owned by Network Adapter 
[cmdb_ci_network_adapter]
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Calculated Application Service [cmdb_ci_service_calculated]

The following attributes in the Calculated Application Service [cmdb_ci_service_calculated] table 
are populated by collected data:

Attribute label Attribute name

Name name

Metadata metadata

Service Populator Status populator_status

Service Type type

IP Address [cmdb_ci_ip_address]

The following attributes in the IP Address [cmdb_ci_ip_address] table are populated by collected 
data:

Attribute label Attribute name

IP Address ip_address

IP version ip_version

Name name

Nic nic

Relationship created for IP Address

Parent class Relationship type Child class

IP Address 
[cmdb_ci_ip_address]

Reference Network Adapter 
[cmdb_ci_network_adapter]

Software Instance [cmdb_software_instance]

The following attributes in the Software Instance [cmdb_software_instance] table are populated 
by collected data:

Attribute label Attribute name

Installed on installed_on

Name name

Relationship created for Software Instance

Parent class Relationship type Child class

Software Instance 
[cmdb_software_instance]

Reference Server [cmdb_ci_server]
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Software [cmdb_ci_spkg]

The following attributes in the Software [cmdb_ci_spkg] table are populated by collected data:

Attribute label Attribute name

Key key

Nic nic

Name name

Relationship created for Software

Parent class Relationship type Child class

Software [cmdb_ci_spkg] Reference Software Instance 
[cmdb_software_instance]

Disk [cmdb_ci_disk]

The following attributes in the Disk [cmdb_ci_disk] table are populated by collected data:

Attribute label Attribute name

Device ID device_id

Free disk space (GB) free_space

Computer computer

Name name

Disk space (GB) disk_space

File system file_system

Relationship created for Disk

Parent class Relationship type Child class

Disk [cmdb_ci_disk] Hosted on::Hosts Server [cmdb_ci_server]

Network Adapter [cmdb_ci_network_adapter]

The following attributes in the Network Adapter [cmdb_ci_network_adapter] table are populated 
by collected data:

Attribute label Attribute name

Configuration Item cmdb_ci

MAC Address mac_address

Name name
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Relationship created for Network Adapter

Parent class Relationship type Child class

Network Adapter 
[cmdb_ci_network_adapter]

Reference Server [cmdb_ci_server]

Application [cmdb_ci_appl]

The following attributes in the Application [cmdb_ci_appl] table are populated by collected data:

Attribute label Attribute name

Class sys_class_name

Name name

Running process command running_process_command

Relationship created for Application

Parent class Relationship type Child class

Application [cmdb_ci_appl] Runs on::Runs Server [cmdb_ci_server]

Accessing the connection details of Service Graph Connector for Observability - New Relic

You can access the connection details of the Service Graph Connector for Observability - 
New Relic  in a single view using the common connection framework (CCF) included within the 
Integration Commons for CMDB  (sn_cmdb_int_util) store app.

With the CCF, you can access all the connections used by the Service Graph Connector for 
Observability - New Relic. The connection details include the connection alias, connection 
properties, data sources, and scheduled data imports associated with a connection. You can 
also test the connection. For more information, see Accessing the connection details of Service 
Graph Connectors.

Access the details of a Service Graph Connector for Observability - New Relic  connection

Access the details of a New Relic  connection configured for the Service Graph Connector for 
Observability - New Relic.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Service Graph Connectors  > New Relic  > Connections.

2. From the Name  column of the Service Graph Connections list, select a connection.

3. On the Service Graph Connections page, view the connection details such as the connection 
name, alias, and data sources.

4. Select a related list to view further details of the connection.

5. Optional:  Select the Test Connection  related link to test the connection.
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Service Graph Connector for OpenTelemetry

Use the Service Graph Connector for OpenTelemetry  to ingest Configuration Management 
Database (CMDB)  data from the ServiceNow  Cloud Observability  (formerly Lightstep) application 
using REST APIs. Push events from the Cloud Observability  application into ServiceNow  with 
Event Management.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Supported ServiceNow  versions

• Utah

• Vancouver

• Washington DC

Use cases

The following examples describe how you can use the Service Graph Connector for 
OpenTelemetry:

• Import project topologies from Cloud Observability  so that the site reliability engineering (SRE) 
teams can have a single view for triage with other ServiceNow  data points (such as a change 
request, an incident) from a single view.

• Import events created by Cloud Observability  against monitored projects to pinpoint SRE 
triage activities.

Guided setup

The guided setup for the Service Graph  Connector for OpenTelemetry  provides an organized 
sequence of tasks to configure the integration on your instance. To access the guided setup, see 
Configure Service Graph Connector for OpenTelemetry.

CMDB integrations dashboard

The Integration Commons for CMDB  store app provides a dashboard with a central view of the 
status, processing results, and processing errors of all installed integrations. You can see metrics 
for all integration runs. You can filter the view to a specific CMDB  integration, a specific time 
duration, or a specific integration run. For more details about monitoring Cloud Observability 
integrations in the CMDB  Integrations Dashboard, see Using the CMDB Integrations Dashboard.

Data mapping

Data from the Cloud Observability  data sources is mapped and transformed into the ServiceNow 
CMDB  configuration item (CI) class definitions using the Robust Transform Engine (RTE). Data is 
inserted into the ServiceNow  CMDB  using the Identification and Reconciliation Engine (IRE).

When you complete setting up the connection, you can configure the integration to pull data 
from the application periodically.

The following table describes the data sources, the scheduled jobs, the staging tables, and the 
target tables as CMDB  CI classes for the Cloud Observability  application.
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Data mapping for Cloud Observability

Data source Description Scheduled job Staging table
CMDB  CI 
classes

OpenTelemetry 
Resources

Imports all the Kubernetes 
clusters, workloads, and 
application services from the 
OpenTelemetry  traces.

OpenTelemetry 
Resources

OpenTelemetry 
Delta 
Resources

OpenTelemetry Resources 
[sn_sg_lightstep_resources] Calculated 

Application 
Service

Kubernetes 
Cluster

Kubernetes 
Deployment

Kubernetes 
Node

Kubernetes 
Pod

Kubernetes 
StatefulSet

Kubernetes 
ReplicaSet

Kubernetes 
DaemonSet

Kubernetes 
Job

Kubernetes 
Cronjob

Kubernetes 
Namespace

Server

Key Value

OpenTelemetry 
Pods

Imports all the Kubernetes  pods 
from the containers.

OpenTelemetry 
Pods

OpenTelemetry 
Delta Pods

OpenTelemetry K8s Pods 
[sn_sg_lightstep_pods] Kubernetes 

Cluster

Kubernetes 
Pod

OpenTelemetry 
Containers

Imports all the containers from the 
OpenTelemetry  traces.

OpenTelemetry 
Containers

OpenTelemetry 
Delta 
Containers

OpenTelemetry docker containers 
[sn_sg_lightstep_containers] Docker 

Container

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1290



Data mapping for Cloud Observability  (continued)

Data source Description Scheduled job Staging table
CMDB  CI 
classes

OpenTelemetry 
Container 
Images

Imports all the container images 
from the OpenTelemetry  traces.

OpenTelemetry 
Container 
Images

OpenTelemetry 
Delta 
Container 
Images

Opentelemetry container images 
[sn_sg_lightstep_container_images] Docker 

Image

OpenTelemetry 
Services

Imports all the Kubernetes 
services from the OpenTelemetry 
traces.

OpenTelemetry 
Delta Services

OpenTelemetry 
Services

OpenTelemetry K8s Services 
[sn_sg_lightstep_kubernetes_services] Kubernetes 

Service

OpenTelemetry 
Dependency 
Map

Imports the dependency maps 
to get an aggregate view of the 
traced data.

The data source also imports 
and loads any inferred services 
and their related services 
data in the Inferred service 
[sn_sg_lightstep_inferred_service] 
staging table.

Note: 
You need to link the 
imported inferred services 
with a CI manually. See 
Inferred service linking.

OpenTelemetry 
Dependency 
Map

OpenTelemetry Dependency Map 
[sn_sg_lightstep_dependency_map] Calculated 

Application 
Service

For more information on where data is saved when pulling data from Cloud Observability, see 
CMDB classes targeted in Service Graph Connector for OpenTelemetry.

You can use the IntegrationHub ETL app to view the data maps. See IntegrationHub ETL  for more 
information.

Inferred service linking

The ServiceNow  Cloud Observability  application can infer the presence of an inferred service 
when the span calling the remote service has the necessary information. Service Graph 
Connector for OpenTelemetry  provides the linking of inferred services and their related services 
with CIs in the CMDB. For more information, see Linking inferred services with CIs.

Related topics

Service Graph Connectors

Configure Service Graph Connector for OpenTelemetry

Set up scheduled import jobs to pull in data from ServiceNow  Cloud Observability  (formerly 
Lightstep) into your Configuration Management Database (CMDB).
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Before you begin
To use this Service Graph Connector, you need a subscription to a Subscription Unit that is 
based in the IT Operations Management  (ITOM) Visibility application or in the ITOM  Discovery 
application. As defined in the section titled "Managed IT Resource Types" in ServiceNow 
Subscription Unit Overview  for your subscription, for managed IT resources that are created 
or modified in the CMDB  by this Service Graph Connector, but that aren’t yet managed by ITOM 
Visibility or ITOM Discovery , these resources will increase Subscription Unit consumption from 
that application. Review your current Subscription Unit consumption within ITOM Visibility or 
ITOM Discovery to ensure available capacity.

Dependencies and requirements:

• The Integration Commons for CMDB  store app, which is automatically installed.

• The CMDB CI class models store app, which is automatically installed. See CMDB CI Class 
Models store app.

• The ITOM Discovery License plugin (com.snc.itom.discovery.license). You must activate this 
plugin.

• ITOM Licensing plugin (com.snc.itom.license). For more information, see Request Discovery .

• The Datastream Action plugin (com.glide.hub.action_type.datastream), which is automatically 
installed.

• Observability Commons for CMDB  (sn_observability), which is only required for event 
ingestion. For Event Management to work, the Observability Commons for CMDB  app must be 
installed prior to installing the connector. For more information, see Observability Commons 
for CMDB  on the ServiceNow Store.

Note: 
If you have an earlier version of the Service Graph Connector for OpenTelemetry, then don’t 
migrate data from the old connector. You must uninstall the previous version and run the 
new integration.

Role required: admin

Procedure

1. Ensure that the application scope is set to Service Graph Connector for OpenTelemetry  by 
using the application picker.
For more information, see Application picker .

2. Navigate to All  > Service Graph Connectors  > OpenTelemetry  > Setup.

3. On the Getting started page, select Get Started.

4. Configure the application properties to set up your organization and authentication credentials 
for sending requests to the ServiceNow  Cloud Observability  APIs.

a. In the Configure the connection  section of the Service Graph Connector for OpenTelemetry 
page, select Get started.

b. For the Use OpenTelemetry  task, ensure that the Cloud Observability  application meets the 
conditions as discussed in the ServiceNow Cloud Observability setup [KB1527588]  article 
in the Now Support  Knowledge Base.

Important: 
Note down your projects, organization, and API key details of the Cloud Observability 
application to be used later during the installation of the connector.
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After you have set up the OpenTelemetry  environment in the Cloud Observability 
application, return to the guided setup and mark the Use OpenTelemetry  task to complete by 
selecting Mark as Complete.

c. Enter your Cloud Observability  organization details from where you want to retrieve the 
projects, resources, and dependency-mapping information.

i. For the Set up your organization  task, select Configure.

ii. In the Value  field of the Service Graph Connection Properties form, enter the name of your 
Cloud Observability  organization.

iii. Select Update.

iv. Mark the Set up your organization  task to complete by selecting Mark as Complete.

d. Enter the API key details associated with the Cloud Observability  application.

i. For the Set up the API key  task, select Configure.

ii. In the API Key  field of the API Key Credentials form, enter the API key associated with the 
Cloud Observability  application that you noted down in step 4.b.

iii. Select Update.

iv. Set the Set up the API key  task to complete by selecting Mark as Complete.

e. Test the Cloud Observability  API connection to import data from the Cloud Observability 
application.

i. For the Test the connection  task, select Configure.

ii. Select the Test Connection  related link.

iii. When the Status  field is set to Success, select X  to close the Test the connection  dialog 
box and return to the guided setup page.

If any of the tests have errors, follow the suggestions for remediation.

iv. Set the Test the connection  task to complete by selecting Mark as Complete.

f. Retrieve all the projects included in your Cloud Observability  organization.

i. For the Get projects  task, select Configure.

ii. Select Get Projects.

iii. When the Project properties  related list is populated with all the projects included in the 
organization you specified in step 4.c.ii, select X  to close the Get projects  dialog box and 
return to the guided setup page.

iv. Set the Get projects  task to complete by selecting Mark as Complete.

5. Optional:  Configure additional configurations to set up lookback time, add excluded projects, 
run project diagnostics, and configure integration settings for service maps and stale 
configuration items (CIs).

a. In the Advanced settings  section of the Service Graph Connector for OpenTelemetry  page, 
select Continue.

b. Set up the lookback time from when you want to retrieve resources from the projects.
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(Optional) Lookback time is used to calculate the start and end time for retrieving resources 
from a project of an organization and should match the scheduled job frequency setting. For 
example, if the lookback time is set to 12 hours, resources are retrieved from the start time 
calculated as the current time minus 12 hours and until the end time that is the current time.

i. For the Set up lookback time  task, select Configure.

ii. In the Value  field of the Service Graph Connection Properties form, enter the lookback 
time in hours.

iii. Select Update.

iv. Set the Set up lookback time  task to complete by selecting Mark as Complete.

c. Select the projects from which you don't want to retrieve resources.

i. For the Add excluded projects  task, select Configure.

ii. Select a project from the Project  column.

iii. Select the Exclude project  check box.

iv. Select Update.

v. Repeat steps from 5.c.ii  to 5.c.iv  for each project that you want to exclude.

vi. Select X  to close the Add excluded projects  dialog box and return to the guided setup 
page.

vii. Set the Add excluded projects  task to complete by selecting Mark as Complete.

d. Run project diagnostics to test the Resource API response and ensure that the API contains 
the Kubernetes  cluster name, Kubernetes  namespace, and Kubernetes  nodes.

i. For the Run project diagnostics  task, select Configure.

ii. Select a project from the Project  column.

iii. Select Run diagnostics.

iv. When the Diagnostics status  field set to Success, select X  to close the Run project 
diagnostics  dialog box and return to the guided setup page.

If any of the Diagnostic tests have errors, follow the instructions in the Diagnostics 
message  field to resolve the errors.

v. Repeat the steps 5.d.ii  to 5.d.iv  for each project that you want to run diagnostics.

vi. Set the Run project diagnostics  task to complete by selecting Mark as Complete.

e. Configure the system properties for service maps and stale CIs.

i. For the Configure system properties for the connector  task, select Configure.

ii. Verify the default values for the properties or fill in the values for a custom configuration.

iii. Select Save.

iv. Set the Configure system properties for the connector  task to complete by selecting Mark 
as Complete.

6. Configure the scheduled jobs to import complete or incremental data from the Cloud 
Observability  application.
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a. In the Configure the scheduled import jobs  section of the Service Graph Connector for 
OpenTelemetry  page, select Continue.

b. Activate the scheduled job for full data import.

By default, the OpenTelemetry Resources  scheduled job is available for full data 
import. However, you must activate the job.

i. For the Configure the scheduled job for full import  task, select Configure.

ii. On the Scheduled Data Import form for the OpenTelemetry Resources  scheduled 
job, verify the field values for the scheduled job and select the Active  check box.

For more information, see Schedule a data import .

iii. Select Update.

iv. Set the Configure the scheduled job for full import  task to complete by selecting Mark as 
Complete  in the guided setup.

c. Optional:  Activate the scheduled job for delta data import.

(Optional) By default, the OpenTelemetry Delta Resources  scheduled job is 
available for delta data import. However, you must activate the job.

Note: 
The delta data pull doesn't occur in the following scenarios:

▪ The full data import is scheduled at the same time.

▪ The Last Run Datetime  field of a data source is empty.

▪ The last delta data pull period is more than 3 days.

i. For the Configure the scheduled job for delta import  task, select Configure.

ii. On the Scheduled Data Import form for the OpenTelemetry Delta Resources 
scheduled job, verify the field values for the scheduled job and select the Active  check 
box.

For more information, see Schedule a data import .

iii. Select Update.

iv. Set the Configure the scheduled job for delta import  task to complete by selecting Mark 
as Complete  in the guided setup.

Note: 
When adding a new project to retrieve resources, be sure to perform a full import before 
running a delta import to avoid partial data and populate the CMDB  accurately.

7. Manage alerts and events by sending events from the Cloud Observability  application to the 
ServiceNow  Event Management  application.
You can manage alerts and events only when the Observability Commons for CMDB 
application is installed.
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Note: 
Enabling this feature requires a paid Cloud Observability  license, but the feature is also 
available to free accounts for the purpose of evaluating the product in non-production 
environments. You can reach out to your ServiceNow  account representative for more 
information.

a. In the Manage alerts and events  section of the Service Graph Connector for OpenTelemetry 
page, select Continue.

b. Create a webhook destination for a project.

i. For the Create a webhook  task, select Configure.

ii. Select a project that is not excluded from the Project  column.

iii. Select Create Webhook  to create a webhook destination in the Cloud Observability 
application.

iv. After a success message appears, select X  to close the Create a webhook  dialog box and 
return to the guided setup page.

When the webhook is created successfully:

▪ The system automatically creates a user record for each webhook destination in your 
ServiceNow  instance.

▪ The user name of the user record starts with ls_api_<project_name>  and the 
user is assigned the evt_mgmt_integration role.

v. Repeat the steps 7.b.ii  to 7.b.iv  for each project for which you want to create a webhook.

vi. Set the Create a webhook  task to complete by selecting Mark as Complete  in the guided 
setup.

c. Configure the system property for ingesting events that don’t have matching CIs in the 
CMDB.

i. For the Configure the property for unmatched CIs  task, select Configure.

ii. In the Value  field, enter true.

iii. Select Update.

iv. Set the Configure the property for unmatched CIs  task to complete by selecting Mark as 
Complete  in the guided setup.

Related topics

Service Graph Connector for OpenTelemetry properties

Accessing the connection details of Service Graph Connector for OpenTelemetry

Linking inferred services with CIs

CMDB  classes targeted in Service Graph Connector for OpenTelemetry

When you complete setting up the connection, you can configure the integration to periodically 
pull data from ServiceNow  Cloud Observability  (formerly Lightstep). The data is saved in tables 
that extend from the Configuration item [cmdb_ci] table.
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Calculated Application Service [cmdb_ci_service_calculated]

The following attributes in the Calculated Application Service [cmdb_ci_service_calculated] table 
are populated by collected data:

Attribute label Attribute name

Service Populator service_populator

Name name

Hide from dashboard hide_from_dashboard

Operational status operational_status

Service Populator Status populator_status

Service Type type

Relationships created for Calculated Application Service

Parent class Relationship type Child class

Calculated 
Application Service 
[cmdb_ci_service_calculated]

Connects to::Connected by Kubernetes Deployment 
[cmdb_ci_kubernetes_deployment]

Calculated 
Application Service 
[cmdb_ci_service_calculated]

Connects to::Connected by Calculated 
Application Service 
[cmdb_ci_service_calculated]

Calculated 
Application Service 
[cmdb_ci_service_calculated]

Reference Key Value [cmdb_key_value]

Docker Container [cmdb_ci_docker_container]

The following attributes in the Docker Container [cmdb_ci_docker_container] table are populated 
by collected data:

Attribute label Attribute name

Container id container_id

Install Status install_status

Name name

Docker Image [cmdb_ci_docker_image]

The following attributes in the Docker Image [cmdb_ci_docker_image] table are populated by 
collected data:

Attribute label Attribute name

Image id image_id

Install Status install_status
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Attribute label Attribute name

Name name

Key Value [cmdb_key_value]

The following attributes in the Key Value [cmdb_key_value] table are populated by collected data:

Attribute label Attribute name

Key key

Value value

Kubernetes Cluster [cmdb_ci_kubernetes_cluster]

The following attributes in the Kubernetes Cluster [cmdb_ci_kubernetes_cluster] table are 
populated by collected data:

Attribute label Attribute name

Name name

Namespace namespace

Install Status install_status

Kubernetes UID k8s_uid

Relationships created for Kubernetes Cluster

Parent class Relationship type Child class

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Cluster of::Cluster Kubernetes Node 
[cmdb_ci_kubernetes_node]

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Contains::Contained by Kubernetes Pod 
[cmdb_ci_kubernetes_pod]

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Contains::Contained by Kubernetes Namespace 
[cmdb_ci_kubernetes_namespace]

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Contains::Contained by Kubernetes Service 
[cmdb_ci_kubernetes_service]

Kubernetes Cronjob [cmdb_ci_kubernetes_cronjob]

The following attributes in the Kubernetes Cronjob [cmdb_ci_kubernetes_cronjob] table are 
populated by collected data:

Attribute label Attribute name

Kubernetes Cluster cluster

Name name

Namespace namespace

Install Status install_status
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Relationships created for Kubernetes Cronjob

Parent class Relationship type Child class

Kubernetes Cronjob 
[cmdb_ci_kubernetes_cronjob]

Hosted on::Hosts Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Kubernetes Cronjob 
[cmdb_ci_kubernetes_cronjob]

Reference Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Kubernetes DaemonSet [cmdb_ci_kubernetes_daemonset]

The following attributes in the Kubernetes DaemonSet [cmdb_ci_kubernetes_daemonset] table 
are populated by collected data:

Attribute label Attribute name

Kubernetes Cluster cluster

Name name

Namespace namespace

Install Status install_status

Relationships created for Kubernetes DaemonSet

Parent class Relationship type Child class

Kubernetes DaemonSet 
[cmdb_ci_kubernetes_daemonset]

Hosted on::Hosts Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Kubernetes DaemonSet 
[cmdb_ci_kubernetes_daemonset]

Reference Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Kubernetes Deployment [cmdb_ci_kubernetes_deployment]

The following attributes in the Kubernetes Deployment [cmdb_ci_kubernetes_deployment] table 
are populated by collected data:

Attribute label Attribute name

Kubernetes Cluster cluster

Name name

Namespace namespace

Install Status install_status

Relationships created for Kubernetes Deployment

Parent class Relationship type Child class

Kubernetes Deployment 
[cmdb_ci_kubernetes_deployment]

Hosted on::Hosts Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]
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Relationships created for Kubernetes Deployment  (continued)

Parent class Relationship type Child class

Kubernetes Deployment 
[cmdb_ci_kubernetes_deployment]

Connects to::Connected by Kubernetes Node 
[cmdb_ci_kubernetes_node]

Kubernetes Deployment 
[cmdb_ci_kubernetes_deployment]

Connects to::Connected by Kubernetes ReplicaSet 
[cmdb_ci_kubernetes_replicaset]

Kubernetes Deployment 
[cmdb_ci_kubernetes_deployment]

Reference Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Kubernetes Job [cmdb_ci_kubernetes_job]

The following attributes in the Kubernetes Job [cmdb_ci_kubernetes_job] table are populated by 
collected data:

Attribute label Attribute name

Kubernetes Cluster cluster

Kubernetes UID k8s_uid

Name name

Namespace namespace

Install Status install_status

Relationships created for Kubernetes Job

Parent class Relationship type Child class

Kubernetes Job 
[cmdb_ci_kubernetes_job]

Hosted on::Hosts Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Kubernetes Job 
[cmdb_ci_kubernetes_job]

Reference Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Kubernetes Namespace [cmdb_ci_kubernetes_namespace]

The following attributes in the Kubernetes Namespace [cmdb_ci_kubernetes_namespace] table 
are populated by collected data:

Attribute label Attribute name

Kubernetes Cluster cluster

Name name

Install Status install_status

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1300



Relationship created for Kubernetes Namespace

Parent class Relationship type Child class

Kubernetes Namespace 
[cmdb_ci_kubernetes_namespace]

Reference Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Kubernetes Node [cmdb_ci_kubernetes_node]

The following attributes in the Kubernetes Node [cmdb_ci_kubernetes_node] table are populated 
by collected data:

Attribute label Attribute name

Kubernetes UID k8s_uid

Name name

Install Status install_status

Namespace namespace

Kubernetes Cluster cluster

Relationships created for Kubernetes Node

Parent class Relationship type Child class

Kubernetes Node 
[cmdb_ci_kubernetes_node]

Hosted on::Hosts Server [cmdb_ci_server]

Kubernetes Node 
[cmdb_ci_kubernetes_node]

Reference Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Kubernetes Pod [cmdb_ci_kubernetes_pod]

The following attributes in the Kubernetes Pod [cmdb_ci_kubernetes_pod] table are populated 
by collected data:

Attribute label Attribute name

Name name

Install Status install_status

Kubernetes Cluster cluster

Kubernetes UID k8s_uid

Namespace namespace

IP Address ip_address

Start date start_date
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Relationships created for Kubernetes Pod

Parent class Relationship type Child class

Kubernetes Pod 
[cmdb_ci_kubernetes_pod]

Contains::Contained by Docker Image 
[cmdb_ci_docker_image]

Kubernetes Pod 
[cmdb_ci_kubernetes_pod]

Contains::Contained by Docker Container 
[cmdb_ci_docker_container]

Kubernetes Pod 
[cmdb_ci_kubernetes_pod]

Reference Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Kubernetes ReplicaSet [cmdb_ci_kubernetes_replicaset]

The following attributes in the Kubernetes ReplicaSet [cmdb_ci_kubernetes_replicaset] table are 
populated by collected data:

Attribute label Attribute name

Kubernetes UID k8s_uid

Name name

Namespace namespace

Install Status install_status

Kubernetes Cluster cluster

Relationships created for Kubernetes ReplicaSet

Parent class Relationship type Child class

Kubernetes ReplicaSet 
[cmdb_ci_kubernetes_replicaset]

Hosted on::Hosts Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Kubernetes ReplicaSet 
[cmdb_ci_kubernetes_replicaset]

Connects to::Connected by Kubernetes Node 
[cmdb_ci_kubernetes_node]

Kubernetes ReplicaSet 
[cmdb_ci_kubernetes_replicaset]

Reference Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Kubernetes Service [cmdb_ci_kubernetes_service]

The following attributes in the Kubernetes Service [cmdb_ci_kubernetes_service] table are 
populated by collected data:

Attribute label Attribute name

Name name

Namespace namespace

Install Status install_status
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Kubernetes StatefulSet [cmdb_ci_kubernetes_statefulset]

The following attributes in the Kubernetes StatefulSet [cmdb_ci_kubernetes_statefulset] table are 
populated by collected data:

Attribute label Attribute name

Name name

Kubernetes Cluster cluster

Namespace namespace

Install Status install_status

Relationship created for Kubernetes StatefulSet

Parent class Relationship type Child class

Kubernetes StatefulSet 
[cmdb_ci_kubernetes_statefulset]

Hosted on::Hosts Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Kubernetes StatefulSet 
[cmdb_ci_kubernetes_statefulset]

Reference Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Server [cmdb_ci_server]

The following attribute in the Server [cmdb_ci_server] table is populated by collected data:

Attribute label Attribute name

Name name

Related topics

Kubernetes extension classes

CI relationships in the CMDB

Service Graph Connector for OpenTelemetry  properties

Service Graph Connector for OpenTelemetry  properties control the behavior of the connector.

Connection properties

These connection properties are available for Service Graph Connector for OpenTelemetry.

Note: 
To open the Service Graph Connection Properties 
[sn_cmdb_int_util_service_graph_connection_property] table for the connector, navigate 
to All  > Service Graph Connectors  > OpenTelemetry  > Connections  and select the 
connection name. The connection properties are displayed in the Service Graph 
Connection Properties related list.
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Connection properties for Service Graph Connector for OpenTelemetry

Property Description

Organization
Enter the name of an OpenTelemetry  organization.

• Type: string

• Default value: None

• Location: Service Graph Connection Properties 
[sn_cmdb_int_util_service_graph_connection_property] table

Lookback 
Time

Enter time in hours to retrieve OpenTelemetry  resources.

• Type: integer

• Default value: 12

• Location: Service Graph Connection Properties 
[sn_cmdb_int_util_service_graph_connection_property] table

System properties

These system properties are available for Service Graph Connector for OpenTelemetry.

Note: 
To open the System Properties [sys_properties] table, enter sys_properties.list  in 
the navigation filter.

System properties for Service Graph Connector for OpenTelemetry

Property Description

sn_sg_lightstep.classes_to_inactivate_stale_records
Enter a list of configuration item 
(CI) classes to be inactivated 
as stale records. For multiple 
entries, separate the CI classes 
with commas.

• Type: string

• Default value: None

• Location: System Property 
[sys_properties] table

sn_sg_lightstep.events_for_unmatched_ci.enabled
Set the property to true  to 
ingest events that don't have a 
matching CI in CMDB.

• Type: true | false

• Default value: false

• Location: System Property 
[sys_properties] table

sn_sg_lightstep.resource_api_num_rows
Enter the maximum number 
of rows fetched in the 
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System properties for Service Graph Connector for OpenTelemetry  (continued)

Property Description

Resource API response from 
OpenTelemetry  resources.

• Type: integer

• Default value: 2500

• Location: System Property 
[sys_properties] table

sn_sg_lightstep.service_map_classes_to_exclude
Enter a list of CI classes to be 
excluded from the service map. 
For multiple entries, separate the 
CI classes with commas.

• Type: string

• Default value: None

• Location: System Property 
[sys_properties] table

sn_sg_lightstep.service_map_max_levels
Enter the maximum hierarchy 
level of CIs to be included in the 
service map.

• Type: integer

• Default value: 5

• Location: System Property 
[sys_properties] table

sn_sg_lightstep.service_map_relationship_types_to_exclude
Enter a list of Cl relationship 
types to be excluded from the 
service map. For multiple entries, 
separate the CI relationship 
types with commas.

• Type: string

• Default value: None

• Location: System Property 
[sys_properties] table

Linking inferred services with CIs

Create inferred services relationships in your ServiceNow  instance with other Cloud 
Observability  application services as originally configured in the application by linking an 
inferred service configuration item (CI) in CMDB  with an inferred service from the Cloud 
Observability  application.

Inferred services

The inferred services in the Cloud Observability  application are referred to as external 
services, libraries, or dependencies such as a database or a third-party API that haven’t been 
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instrumented with OpenTelemetry. These types of technologies are manually defined in the 
Cloud Observability  application, and you can import them into your ServiceNow  instance through 
the Service Graph Connector for OpenTelemetry.

For information about adding inferred services in the Cloud Observability  application, see Add 
inferred services  in the Cloud Observability  documentation.

Storing inferred services data

The OpenTelemetry Dependency Map [sn_sg_lightstep_dependency_map] data source 
available with the Service Graph Connector for OpenTelemetry  iterates through all the included 
projects in a Cloud Observability  organization and pulls in the inferred services details. Inferred 
services details include mapping of related services. The data source saves these details in the 
Inferred service [sn_sg_lightstep_inferred_service] table.

The following attributes in the Inferred service [sn_sg_lightstep_inferred_service] table are 
populated by the OpenTelemetry Dependency Map [sn_sg_lightstep_dependency_map] data 
source.

Attribute label Attribute name

Project project

Organization organization

ID id

Inferred service inferred_service

Inferred service CI inferred_service_ci

Active active

Last scan last_scan

Cloud Observability CI cloud_observability_ci

Due to insufficient information for defining identification rules, the pulled in inferred services 
don’t automatically bind to a CI in CMDB. However, as a user with the cmdb_inst_admin role, you 
can manually link a CI to an inferred service. The linking creates appropriate relationships with 
the related services and generates the inferred service mapping in the respective application 
service maps of your ServiceNow  instance.

Link an inferred service

Link a Cloud Observability  inferred service with a CI to create relationships between the inferred 
service and other Cloud Observability  services in your ServiceNow  instance.

Before you begin
Role required: cmdb_inst_admin

Procedure

1. Navigate to All  > Service Graph Connectors  > OpenTelemetry  > Inferred services.

2. Review the inferred services available from the Cloud Observability  app in the Inferred service 
column.

3. For an inferred service, double-click the Inferred service CI  column cell.

4. Select the lookup using list icon ( ) to search for and select an inferred service CI available 
within the Configuration item [cmdb_ci] table.
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5. Select the save icon ( ).

6. Repeat the steps 3  to 5  for each inferred service that you want to link with a CI.

Result
The Update CI relationship  business rule is triggered that creates appropriate 
relationships for the inferred service with the related services and generates the inferred service 
mapping in the respective application service maps.

Note: 

• If you remove any mapping later, the Delete CI relationship  business rule is 
triggered to delete any relationships between the inferred service CIs and the Cloud 
Observability  inferred services.

• For any inferred services that were not last scanned in the Cloud Observability  app, the 
Service Graph Connector automatically deactivates the corresponding records in CMDB 
and deletes the relationship for the inactive records.

Accessing the connection details of Service Graph Connector for OpenTelemetry

You can access the connection details of the Service Graph Connector for OpenTelemetry  in 
a single view using the common connection framework (CCF) included within the Integration 
Commons for CMDB  (sn_cmdb_int_util) store app.

With the CCF, you can access all the connections used by the Service Graph Connector for 
OpenTelemetry. The connection details include the connection alias, connection properties, 
data sources, and scheduled data imports associated with a connection. You can also test the 
connection.

Access the details of a Service Graph Connector for OpenTelemetry  connection

Access the details of an OpenTelemetry  connection configured for the Service Graph Connector 
for OpenTelemetry.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Service Graph Connectors  > OpenTelemetry  > Connections.

2. From the Name  column of the Service Graph Connections list, select a connection.

3. On the Service Graph Connections page, view the connection details such as the connection 
name, alias, and data sources.

4. Select a related list to view further details of the connection.

5. Optional:  Select the Test Connection  related link to test the connection.

Related topics

Service Graph Connector for OpenTelemetry properties

Accessing the connection details of Service Graph Connectors

Service Graph Connector for Qualys

The Service Graph Connector for Qualys pulls in asset inventory data (hardware and software) 
from the Qualys database into the Configuration Management Database (CMDB)  application in 
your ServiceNow AI Platform®  instance.
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Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Supported versions

Use this data to manage your Qualys  resources directly from your ServiceNow AI Platform® 

instance.

Supported Qualys  APIs:

• Qualys  Global Asset API v2. You might prefer to use this API if you are importing data for the 
Security Posture Control Security Posture Control  application.

• Qualys  Asset Management API v2. This API is deactivated by default. You should only activate 
this API if you don't have access to the Qualys  Cybersecurity Asset Management (CSAM) 
product. ServiceNow  uses a different API (Asset management and tagging) for this API but the 
data returned is not comprehensive.

Supported ServiceNow®  versions:

• Utah

• Vancouver

• Washington

Use cases

The following are examples on how you can use the Service Graph Connector for Qualys  for 
different ServiceNow  applications:

• Complements the Qualys  Asset Discovery.

• Import data with the Global Asset API or the Asset Management API.

• Multi-instance support.

Guided Setup

The guided setup for the Service Graph Connector for Qualys  provides you with an organized 
sequence of tasks to configure the integration on your instance.

CMDB  integrations dashboard

The Integration Commons for CMDB  store app provides a dashboard with a central view of the 
status, processing results, and processing errors of all installed integrations. You can see metrics 
for all integration runs. You can filter the view to a specific CMDB  integration, a specific time 
duration, or a specific integration run. For more details about monitoring Qualys  integrations in 
the CMDB  Integrations Dashboard, see Using the CMDB Integrations Dashboard.

Hardware CI Rules

The hardware Configuration item (CI) mapping rule table is equipped with hardware category1, 
hardware category2 and corresponding target CI class. Following a Qualys  API call, the system 
checks the hardware category1 and hardware category2 to determine their satisfaction, if 
hardware category1 and hardware category2 is match with the table record then the associated 
target CI class is added to the import set table data. During the mapping process, this 
designated target CI class is then utilized.
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Computer CI Rules

The Computer CI Mapping Rule table is equipped with predefined rules, including criteria 
such as OS name, OS category, OS category 2, OS Publisher, OS Product name, and the 
corresponding target CI class. Following a Qualys  API call, the system checks these rules to 
determine their satisfaction. If a rule is met, the associated target CI class is added to the import 
set table data. During the mapping process, this designated target CI class is then utilized.

If you want to update CI attributes, you must create new reconciliation rules to determine which 
discovery sources can update CI attributes. See 'Reconciliation rules' in the online product 
documentation and the Identification and Reconciliation Fundamentals article in the ServiceNow 
Support Knowledge base for more information.

Asset Management CI Rules

The Asset Management CI Mapping Rule table is equipped with predefined rules, including 
criteria such as Operating System, Is Volume Info Present, Is processor Present, Cloud Provider 
and the corresponding target CI class. Following a Qualys  API call, the system checks these 
rules to determine their satisfaction. If a rule is met, the associated target CI class is added to 
the import set table data. During the mapping process, this designated target CI class is then 
utilized.

Configure the Service Graph Connector for Qualys

Set up the Qualys  environment and scheduled jobs to import in Qualys  data into your 
Configuration Management Database (CMDB).

Before you begin
To use this Service Graph Connector, you need a subscription to a Subscription Unit that is 
based in the IT Operations Management  (ITOM) Visibility application or in the ITOM  Discovery 
application. As defined in the section titled "Managed IT Resource Types" in ServiceNow 
Subscription Unit Overview  for your subscription, for managed IT resources that are created 
or modified in the CMDB  by this Service Graph Connector, but that aren’t yet managed by ITOM 
Visibility or ITOM Discovery , these resources will increase Subscription Unit consumption from 
that application. Review your current Subscription Unit consumption within ITOM Visibility or 
ITOM Discovery to ensure available capacity.

Dependencies and requirements:

• The Integration Commons for CMDB  store app, which is automatically installed.

• The CMDB  CI class models store app, which is automatically installed. See CMDB CI Class 
Models store app.

• The ITOM Discovery License plugin (com.snc.itom.discovery.license). You must activate this 
plugin.

• ITOM Licensing plugin (com.snc.itom.license). For more information, see Request Discovery .

• The Datastream Action plugin (com.glide.hub.action_type.datastream), which is automatically 
installed.

• Observability Commons for CMDB  (sn_observability), which is only required for event 
ingestion. This app must be installed prior to installing the connector for Event Management to 
work. For more information, see Observability Commons for CMDB  on the ServiceNow Store.

There are two supported Qualys  APIs:
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• Qualys  Global Asset API v2. You might prefer to use this API if you are importing data for the 
Security Posture Control  application.

• Qualys  Asset Management API v2. This API is deactivated by default. You should only activate 
this API if you don't have access to the Qualys  Cybersecurity Asset Management (CSAM) 
product. ServiceNow®  uses a different API (Asset management and tagging) for this API but 
the data returned is not comprehensive.

For more information, see Service Graph Connector for Qualys APIs.

Role required: admin

Procedure

1. Navigate to All  > Service Graph Connectors  > Qualys  > Setup.

2. Select Continue  on the Home page.

3. Select Best Experience  and Continue  on the Experience page.
On the Service Graph Connector for Qualys  page in the Configure the connection page, three 
tasks are displayed:

◦ Configure the connection

◦ Add multiple instances

◦ Set up scheduled import jobs

4. Select Start  for the Configure the Connection  task to expand it.
The following steps are displayed:

◦ Configure Qualys  authentication credentials

◦ Configure Qualys  HTTP Connection

◦ Test Connection

5. Select Configure Qualys authentication credentials.

a. In the Username and Password field, enter your Qualys  username and password.

b. Select the Active  check box to activate the record.

c. Right-click in the gray header titled Basic Auth Credentials and select Save.

d. Select Mark as complete  followed by Continue.
The Configure Qualys  HTTP Connection page is displayed.

6. Fill in the fields.

a. Add the Qualys  base URL or Host details.

Domain part of the URL without the 'https'. An example might be 
qualysapi.qualys.com.

b. Optional:  If the API is accessible through a MID Server, activate the Use MID Server  check 
box.

c. In the advanced MID Server configuration section select the appropriate MID Server from 
the MID Selection list.
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d. Right-click in the gray header titled HTTP(s) Connection and select Save.

e. Select Mark as complete  followed by Continue.
The Test Connection page is displayed.

7. Test the connection.

a. Update the use_asset_management_and_tagging_api  property in the 'Service Graph 
Connection Properties' section.

Option Description

true Set the property 
use_asset_management_and_tagging_api 
flag to true  if you are using the asset 
management and tagging API in the 
configuration.

false Set the property 
use_asset_management_and_tagging_api 
to false  if you are not using the asset 
management and tagging API in the 
configuration.

b. In the Related links section select the Test Connection  link.
If the connection is successful, the status code field displays 200  or 201  and a message is 
displayed. If your connection test fails, review the Message and Suggestion fields for how to 
proceed.

c. Right-click in the gray header titled Service Graph Connections and select Save.

d. Select Mark as complete  followed by Continue.
The Update Data Source Access page is displayed.

8. Update the data source.

a. Follow the steps listed at the top of the page to switch the application scope with the 
application picker to open, edit, and save the record.

b. Select a record from the list to open it.

c. Select the Application Access  tab.

d. Select the check boxes to set the permissions you want.

e. Right-click in the gray header titled Tables and select Save.

f. Select Mark as complete  followed by Continue.
The Update Scheduled Data Import page is displayed.

9. Update the Scheduled Data Import record.
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a. Follow the steps listed at the top of the page to switch the application scope with the 
application picker as required to open, edit, and save the record.

b. Select the Application Access  tab.

c. Select the check boxes to set the permissions you want.

d. Right-click in the gray header titled Table and select Save.

e. Select Mark as complete  followed by Continue.
The Add Another Connection task is displayed.

10. Follow the instructions at the top of the page to add a connection.

a. Follow the steps listed at the top of the page to switch the application scope with the 
application picker to open, edit, and save the record.

b. Select the link.
The SG-Qualys Connections page is displayed.

c. Select Add Connection  and fill out the fields.

Field Description

Connection name Unique name for your connection

Connection URL Connection URL

User name Qualys  account user name

Password Qualys  account password

d. Select Create Connection.

e. Navigate back to the Add Another Connection page in the Setup Assistant.

f. Select Mark as complete  followed by Continue.
The Configure MID Server for new HTTP connection page is displayed.

11. Configure the MID Server

a. Select a record to open it.

b. Select the Use MID server check box.

c. Select the search icon in the MID Server field and choose one from the list.

d. Right-click in the gray header titled HTTP(s) Connection and select Save.

e. Select Mark as complete  followed by Continue.
The Test New Connections page is displayed.
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12. Test the connection.

a. Select the record for the connection you want to test.

b. Scroll to the Related links section and select the Test Connection  link.
If the connection is successful, the status code field displays 200  or 201  and a message is 
displayed. If your connection test fails, review the Message and Suggestion fields for how to 
proceed.

c. Right-click in the gray header titled, Service Graph Connections and select Save.

d. Select Mark as complete  followed by Continue.
The Configure the scheduled jobs page is displayed.

13. Configure the scheduled jobs.

a. Select a record to open it.

b. Fill out the scheduled data import from.

Field Description

Name Name of the scheduled job.

Application Read-only application name.

Data source Data source record that defines the data to import.

Run How often you want the job to run. If you want to run a test import prior to 
scheduling it, you might prefer to select Once.

Run as Option to run the scheduled job with the credentials of the specified user.

Conditional Specific conditions under which this job is run.

Active Option to activate the scheduled job. Select this option.

Use connection Leave this deactivated for the first run. Specifies another connection and 
credentials for this job.

Concurrent 
Import

Leave check box activated. Splits data into multiple imports sets. See the 
field message for more information.

Partition 
Method

Leave set as Custom size.

Partition Size Leave set as 1,000. Import set size for early scheduling.

Execute pre-
import script

Leave check box selected. Specifies a script to run before the import is 
performed.

Execute post-
import script

Leave check box selected. Specifies a script to run after the import is 
performed.

c. Right-click in the gray header titled Scheduled Data Import and select Save.

d. Optional:  Select Execute Now.
If you do not choose to run the job on-demand, the next job runs according to the schedule 
you set.
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e. Select Mark as complete  followed by Continue.
The Home page of the Setup Assistant is displayed.

14. Optional:  Add Multiple Instances

a. Select Add Multiple Instances to expand it.
The following steps are displayed:

▪ Update Data Source Access

▪ Update Scheduled Data Import

▪ Add Another Connection

▪ Configure MID Server for New HTTP connection

▪ Test New Connections

b. To update the Data Source, follow the steps listed in step 8.

c. To update the Scheduled Data Import, follow the steps in step 9.

d. To add another connection, follow the steps listed in step 10.

e. To configure a MID Server, follow the steps listed in step 11.

f. To test connections, follow the steps listed in step 12.

15. On the Service Graph Connector for Qualys  page for Guided Setup, select Complete  to finish 
the configuration.

Service Graph Connector for Qualys  APIs

Data from the Qualys  data source fields is imported with the Global Asset API and the Asset 
Management and Tagging API.

Global Asset API

• A Qualys  Cybersecurity Asset Management (CSAM) license is required.

• Asset information includes details such as Hardware Category and OS Category.

Asset Management and Tagging API

• A CSAM license is not required

• Asset information does not include details about Hardware Category and OS Category.

Mapped attributes

The following table compares what data is imported by the two APIs. The sections after the table 
list data imported by the Global asset API that is not supported by the Asset Management and 
Tagging API.

Global Asset API Asset Management and Tagging API

Mapped attributes Mapped attributes
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Global Asset API Asset Management and Tagging API

assetId

assetUUID

hostId

lastModifiedDate

agentId

createdDate

sensorLastUpdatedDate

assetType

address

dnsName

assetName

netbiosName

timeZone

biosDescription

lastBoot

totalMemory

cpuCount

lastLoggedOnUser

domainRole

hwUUID

biosSerialNumber

biosAssetTag

isContainerHost

created

name

dnsHostName

fqdn

os

manufacturer

tracking method

netbios

timezone

network guid

IsDockerHost

modified

lastVulnScan

model

cloudProvider

type

qwebHostId

criticalSocre

lastSystemBoot

domain

lastLogOnUser

lastComplianceScan

AWS Cloud details

accountId

availabilityZone

hasAgent

hostname

imageId

instanceId

AWS Cloud details

instanceId

privateDnsName

privateIpAddress

instanceState

monitoringEnabled

region
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Global Asset API Asset Management and Tagging API

instanceState

privateDNS

privateIpAddress

instanceType

qualysScanner

kernelId

launchdate

region.code

region.name

spotInstance

subnetId

vpcId

tags.key

tags.value

accountId

availabilityZone

instance_type

AWS Cloud tag details

• key

• value

MS Azure Cloud details

vmId

state

name

imagePublisher

imageVersion

offer

location

platform

resourceGroupName

size

subnet

subscriptionId

virtualNetwork

MS Azure Cloud details

resourceGroupName

vmId

state

subscriptionId

location

image_id

publisher

version

offer

vm_size

subnet_id

vpc_id

MS Azure Cloud tag details

• key

• value

Network interface details Network interface details
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Global Asset API Asset Management and Tagging API

hostname

addressIpV4

addressIpV6

macAddress

interfaceName

dnsAddress

gatewayAddress

manufacturer

macVendorIntroDate

netmask

addresses

address

host_name

interface_name

macAddress

gatewayAddress

interface_id

type

Software details

token1

token2

uniqueKey

publisher

installDate

id

installPath

lastUseDate

authorization

authorizationDetectionScore

Software details

version

name

Volume details

name

free

size

Volume details

name

free

size

Open port details

port

description

protocol

Open port details

port

protocol

serviceName
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Global Asset API Asset Management and Tagging API

detectedService

firstFound

lastUpdated

service_id

Processor details

description

speed

numCPUs

noOfSocket

threadsPerCore

coresPerSocket

multithreadingStatus

Processor details

name

speed

Tag details

tagId

tagName

foregroundColor

backgroundColor

businessImpact

criticalityScore

Asset tag details

id

name

Agent details

version

configurationProfile

activations

connectedFrom

lastActivity

lastCheckedIn

lastInventory

udcManifestAssigned

errorStatus

Agent details

agentVersion

agentLastCheckIn

status

platform

connectedFrom

agentId

AgentConfigurationName

ChirpStatus
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Additional Global asset API details

The following sections list data imported by the Global asset API that is not supported by the 
Asset Management and Tagging API.

Global asset API OS details

• fullName

• version

• publisher

• osName

• category

• category1

• category2

• productName

• edition

• marketVersion

• update

• architecture

• productUrl

• productFamily

• installDate

• release

Global asset API OS lifecycle

OS lifecycle details

• gaDate

• eolDate

• eosDate

• stage

• lifeCycleConfidence

• eolSupportStage

• eosSupportStage

Global asset API OS taxonomy

OS Taxonomy details

• id

• name

• category1

• category2
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Global asset API hardware

Hardware details

• fullName

• category

• category1

• category2

• manufacturer

• productName

• model

• productUrl

• productFamily

Global asset API hardware lifecycle

Hardware lifecycle details

• introDate

• gaDate

• eosDate

• obsoleteDate

• stage

• lifeCycleConfidence

Global asset API taxonomy

Hardware taxonomy details

• id

• name

• category1

• category2

Global asset API sensor

Sensor details

• activatedForModules

• pendingActivationForModules

• lastVMScan

• lastComplianceScan

• lastFullScan

• lastVmScanDateScanner

• lastVmScanDateAgent

• lastPcScanDateScanner

• lastPcScanDateAgent
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• firstEasmScanDate

• lastEasmScanDate

Global asset API service

Service details

• name

• status

• description

Global asset API last location

Last location details

• city

• state

• country

• name

• continent

• postal

Global asset API criticality

Criticality details

• score

• isDefault

• lastUpdated

Global asset API processor

Processor details

• description

• speed

• numCPUs

• noOfSocket

• threadsPerCore

• coresPerSocket

• multithreadingStatus

Global asset API business information

Business information details

• businessAppListData

• riskScore

• passiveSensor

• domain
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• subdomain

• missingSoftware

• whois

• organizationName

• isp

• asn

• easmTags

• hostingCategory1

• customAttributes

CMDB classes targeted in the Service Graph Connector for Qualys

When you complete the guided setup, you can configure the integration to periodically pull data. 
The data is saved in tables that extend from the Configuration item [cmdb_ci] table. The Service 
Graph Connector for Qualys  identifies and classifies information about various configuration 
Items (CIs).

SGC Qualys  Asset Cloud Tag

The following attributes in the SGC Qualys Asset Cloud Tag 
[sn_sec_sgc_qualys_asset_cloud_tag] table are populated by collected data.

Attribute label Attribute name

Key key

Qualys Asset qualys_asset

Value value

Configuration item configuration_item

SGC Qualys Asset Software Details 
[sn_sec_sgc_qualys_asset_software_details]

The following attributes in the SGC Qualys Asset Software Details 
[sn_sec_sgc_qualys_asset_software_details] table are populated by collected data.

Attribute label Attribute name

Name token1

Qualys Asset qualys_asset

Configuration item configuration_item

Unique key unique_key

Id id

Install Path install_path

Last Use Date last_use_date

Version token2
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Hardware Type [cmdb_ci_compute_template]

The following attributes in the Hardware Type [cmdb_ci_compute_template] table are populated 
by collected data.

Attribute label Attribute name

Name name

Object ID object_id

Image [cmdb_ci_os_template]

The following attributes in the Image [cmdb_ci_os_template] table are populated by collected 
data.

Attribute label Attribute name

Name name

Object ID object_id

Offer offer

Version version

Software [cmdb_ci_spkg]

The following attributes in the Software [cmdb_ci_spkg] table are populated by collected data.

Attribute label Attribute name

Key key

Discovery source discovery_source

Name name

Version version

Manufacturer manufacturer

SGC Qualys Asset Network Interface Details 
[sn_sec_sgc_qualys_asset_nic_details]

The following attributes in the SGC Qualys Asset Network Interface Details 
[sn_sec_sgc_qualys_asset_nic_details] table are populated by collected data.

Attribute label Attribute name

Configuration item configuration_item

IPv4 ip_v4

Addresses addresses

Interface Id interface_id

IPv6 ip_v6

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1323



Attribute label Attribute name

MAC Vendor Intro Date mac_vendor_intro_date

Qualys Asset qualys_asset

Type type

Server [cmdb_ci_server]

The following attributes in the Server [cmdb_ci_server] table are populated by collected data.

Attribute label Attribute name

Manufacturer manufacturer

Name name

Asset tag asset_tag

Class sys_class_name

CPU count cpu_count

DNS Domain dns_domain

First discovered first_discovered

Fully qualified domain name fqdn

Install Status install_status

Operating System os

Operational status operational_status

OS Address Width (bits) os_address_width

OS Service Pack os_service_pack

OS Version os_version

RAM (MB) ram

SGC Qualys Asset Open Port Details 
[sn_sec_sgc_qualys_asset_open_port_details]

The following attributes in the SGC Qualys Asset Open Port Details 
[sn_sec_sgc_qualys_asset_open_port_details] table are populated by collected data.

Attribute label Attribute name

Port port

Protocol protocol

Description description

Detected Service detected_service

First Found first_found

Last Updated last_updated

Qualys Asset qualys_asset
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Attribute label Attribute name

Service Id service_id

SGC Qualys Asset Details [sn_sec_sgc_qualys_asset_details]

The following attributes in the SGC Qualys Asset Details [sn_sec_sgc_qualys_asset_details] table 
are populated by collected data.

Attribute label Attribute name

Asset Name asset_name

Activated Modules activated_modules

Address address

Agent Configuration Profile agent_configuration_profile

Agent Connected From agent_connected_from

Agent Eror Status agent_error_status

Agent ID agent_id

Agent Last Activity agent_last_activity

Agent Last Checked In agent_last_checked_in

Agent Last Inventory agent_last_inventory

Agent Platform platform

Agent Status status

Agent UDC Manifest Assigned agent_udc_manifest_assigned

Agent Version agent_version

ASN asn

Asset ID asset_id

Asset Type asset_type

Asset UUID asset_uuid

Assigned Location assigned_location

AWS Host Name aws_host_name

AWS Kernel ID aws_kernel_id

AWS Launch Date aws_launch_date

AWS Region Name aws_region_name

Azure Image Publisher azure_image_publisher

Azure Platform azure_platform

Azure Subnet azure_subnet

Azure Virtual Network azure_virtual_network

Bios Description bios_description

Bios Serial Number bios_serial_number
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Attribute label Attribute name

Business AppListData business_applist_data

Business Information business_information

Chirp Status chirp_status

City lastlocation_city

Continent lastlocation_continent

Country lastlocation_country

Custom Attribrutes custom_attributes

Domain domain

Domain Role domain_role

ESAM Tags easm_tags

First EASM Scan Date first_easm_scan_date

Hardware Category hardware_category

Hardware Category1 hardware_category1

Hardware Category2 hardware_category2

Hardware FullName hardware_fullname

Hardware Lifecycle Confidence hardware_lifecycle_lifecycleconfidence

Hardware Lifecycle EOSDate hardware_lifecycle_eosdate

Hardware Lifecycle GaDate hardware_lifecycle_gadate

Hardware Lifecycle IntroDate hardware_lifecycle_introdate

Hardware Lifecycle ObsoleteDate hardware_lifecycle_obsoletedate

Hardware Lifecycle Stage hardware_lifecycle_stage

Hardware Model hardware_model

Hardware Product Family hardware_product_family

Hardware Product Name hardware_product_name

Hardware Product URL hardware_product_url

Hardware Texonomy Category1 hardware_taxonomy_category1

Hardware Texonomy Category2 hardware_taxonomy_category2

Hardware Texonomy ID hardware_taxonomy_id

Hardware Texonomy Name hardware_taxonomy_name

Has Agent aws_has_agent

Host ID host_id

Hosting Category1 hosting_category1

Hw UUID hw_uuid

Is Container Host is_container_host

IsDefault criticality_isdefault
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Attribute label Attribute name

ISP isp

Last Boot last_boot

Last Compliance Scan last_compliance_scan

Last EASM Scan Date last_easm_scan_date

Last Full Scan last_full_scan

Last Location Name lastlocation_name

Last Logged On User last_logged_on_user

Last Modified Date last_modified_date

Last PC Scan Date Agent last_pc_scan_date_agent

Last PC Scan Date Scanner last_pc_scan_date_scanner

Last Updated criticality_lastupdated

Last VM Scan last_vm_scan

Last VM Scan Date Agent last_vm_scan_date_agent

Last VM Scan Date Scanner last_vm_scan_date_scanner

Missing Software missing_software

NetBios Name netbios_name

Network Guid network_guid

Organization Name organization_name

OS Category os_category

OS Category1 os_category1

OS Category2 os_category2

OS Edition os_edition

OS Lifecycle Confidence os_lifecycle_confidence

OS Lifecycle EOL Date os_lifecycle_eol_date

OS Lifecycle EOLSupport Stage os_lifecycle_eol_supportstage

OS Lifecycle EOS Date os_lifecycle_eos_date

OS Lifecycle EOSSupport Stage os_lifecycle_eos_supportstage

OS Lifecycle Ga Date os_lifecycle_ga_date

OS Lifecycle Stage os_lifecycle_stage

OS Market Version os_market_version

OS Name os_name

OS Product Family os_product_family

OS Product Name os_product_name

OS Product URL os_product_url

OS Release os_release
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Attribute label Attribute name

OS Taxonomy Category1 os_taxonomy_category1

OS Taxonomy Category2 os_taxonomy_category2

OS Taxonomy ID os_taxonomy_id

OS Taxonomy Name os_taxonomy_name

Passive Sensor passive_sensor

Postal lastlocation_postal

Provider provider

Qualys Scanner qualys_scanner

Risk Score risk_score

Score criticality_score

Sensor Last Updated Date sensor_last_updated_date

Spot Instance spot_instance

State lastlocation_state

SubDomain subdomain

Time Zone time_zone

Tracking Method tracking_method

WhoIs whois

Virtual Machine Instance [cmdb_ci_vm_instance]

The following attributes in the Virtual Machine Instance [cmdb_ci_vm_instance] table are 
populated by collected data.

Attribute label Attribute name

Name name

Object ID object_id

IP Address ip_address

Monitor monitor

State state

VM Instance ID vm_inst_id

Cloud Service Account [cmdb_ci_cloud_service_account]

The following attributes in the Cloud Service Account [cmdb_ci_cloud_service_account] table are 
populated by collected data.

Attribute label Attribute name

Account Id account_id

Name name
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Attribute label Attribute name

Object ID object_id

Datacenter Type datacenter_type

Cloud Mgmt Network Interface [cmdb_ci_nic]

The following attributes in the Cloud Mgmt Network Interface [cmdb_ci_nic] table are populated 
by collected data.

Attribute label Attribute name

MAC Address mac_address

Name name

Object ID object_id

Public IP public_ip

DNS Domain dns_domain

Host Name host_name

IP default gateway ip_default_gateway

Netmask netmask

Manufacturer manufacturer

Availability Zone [cmdb_ci_availability_zone]

The following attributes in the Availability Zone [cmdb_ci_availability_zone] table are populated 
by collected data.

Attribute label Attribute name

Object ID object_id

SGC Qualys Asset Tag [sn_sec_sgc_qualys_asset_tag]

The following attributes in the SGC Qualys Asset Tag [sn_sec_sgc_qualys_asset_tag] table are 
populated by collected data.

Attribute label Attribute name

Tag Id tag_id

Tag Name tag_name

Background Color background_color

Business Impact business_impact

Criticality Score criticality_score

Foreground Color foreground_color

Qualys Asset qualys_asset
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SGC Qualys Asset Processor Details 
[sn_sec_sgc_qualys_asset_processor_details]

The following attributes in the SGC Qualys Asset Processor Details 
[sn_sec_sgc_qualys_asset_processor_details] table are populated by collected data.

Attribute label Attribute name

Description processor_description

Cores Per Socket processor_corespersocket

Multi Threading Status processor_multithreadingstatus

No Of Socket processor_noofsocket

Number of CPUs processor_numcpus

Qualys Asset qualys_asset

Speed processor_speed

File System [cmdb_ci_file_system]

The following attributes in the File System [cmdb_ci_file_system] table are populated by 
collected data.

Attribute label Attribute name

Name name

Free space bytes free_space_bytes

Size bytes size_bytes

Software Instance [cmdb_software_instance]

The following attributes in the File System [cmdb_ci_file_system] table are populated by 
collected data.

Attribute label Attribute name

Installed on installed_on

Name name

Install date install_date

Azure Datacenter [cmdb_ci_azure_datacenter]

The following attributes in the Azure Datacenter [cmdb_ci_azure_datacenter] table are populated 
by collected data.

Attribute label Attribute name

Name name

Object ID object_id
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Attribute label Attribute name

Region region

AWS Datacenter [cmdb_ci_aws_datacenter]

The following attributes in the AWS Datacenter [cmdb_ci_aws_datacenter] table are populated by 
collected data.

Attribute label Attribute name

Name name

Object ID object_id

Region region

Cloud Subnet [cmdb_ci_cloud_subnet]

The following attributes in the Cloud Subnet [cmdb_ci_cloud_subnet] table are populated by 
collected data.

Attribute label Attribute name

Object ID object_id

Software Installation [cmdb_sam_sw_install]

The following attributes in the Software Installation [cmdb_sam_sw_install] table are populated 
by collected data.

Attribute label Attribute name

Display name display_name

Publisher publisher

Version version

Discovery source discovery_source

Install date install_date

Cloud Network [cmdb_ci_network]

The following attributes in the Cloud Network [cmdb_ci_network] table are populated by 
collected data.

Attribute label Attribute name

Object ID object_id

SGC Qualys Asset Service Details [sn_sec_sgc_qualys_asset_service_details]

SGC Qualys Asset Service Details [sn_sec_sgc_qualys_asset_service_details].
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Name name

Description description

Qualys Asset qualys_asset

Status status

Relationships created by Cloud Network [cmdb_ci_network]

Parent class Relationship type Child class

Cloud Network 
[cmdb_ci_network]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Cloud Network 
[cmdb_ci_network]

Contains::Contained by Cloud Subnet 
[cmdb_ci_cloud_subnet]

Relationships created by Virtual Machine Instance [cmdb_ci_vm_instance]

Parent class Relationship type Child class

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Provisioned From::Provisioned Image [cmdb_ci_os_template]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Virtualized by::Virtualizes Server [cmdb_ci_server]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Provisioned From::Provisioned Hardware Type 
[cmdb_ci_compute_template]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Relationships created by Server [cmdb_ci_server]

Parent class Relationship type Child class

Server [cmdb_ci_server] Reference SGC Qualys Asset 
Network Interface Details 
[sn_sec_sgc_qualys_asset_nic_details]

Server [cmdb_ci_server] Reference Software Installation 
[cmdb_sam_sw_install]

Server [cmdb_ci_server] Reference SGC Qualys Asset 
Service Details 
[sn_sec_sgc_qualys_asset_service_details]

Server [cmdb_ci_server] Reference SGC Qualys Asset 
Software Details 
[sn_sec_sgc_qualys_asset_software_details]
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Parent class Relationship type Child class

Server [cmdb_ci_server] Reference SGC Qualys Asset 
Open Port Details 
[sn_sec_sgc_qualys_asset_open_port_details]

Server [cmdb_ci_server] Reference SGC Qualys Asset 
Processor Details 
[sn_sec_sgc_qualys_asset_processor_details]

Server [cmdb_ci_server] Reference SGC Qualys Asset Tag 
[sn_sec_sgc_qualys_asset_tag]

Server [cmdb_ci_server] Reference SGC Qualys Asset Cloud Tag 
[sn_sec_sgc_qualys_asset_cloud_tag]

Server [cmdb_ci_server] Reference SGC Qualys Asset Details 
[sn_sec_sgc_qualys_asset_details]

Server [cmdb_ci_server] Contains::Contained by File System 
[cmdb_ci_file_system]

Relationships created by Azure Datacenter [cmdb_ci_azure_datacenter]

Parent class Relationship type Child class

Azure Datacenter 
[cmdb_ci_azure_datacenter]

Hosted on::Hosts Cloud Service Account 
[cmdb_ci_cloud_service_account]

AWS Datacenter 
[cmdb_ci_aws_datacenter]

Contains::Contained by Availability Zone 
[cmdb_ci_availability_zone]

Azure Datacenter 
[cmdb_ci_azure_datacenter]

Contains::Contained by Availability Zone 
[cmdb_ci_availability_zone]

AWS Datacenter 
[cmdb_ci_aws_datacenter]

Hosted on::Hosts Cloud Service Account 
[cmdb_ci_cloud_service_account]

Relationships created by Hardware Type [cmdb_ci_compute_template]

Parent class Relationship type Child class

Hardware Type 
[cmdb_ci_compute_template]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]

Hardware Type 
[cmdb_ci_compute_template]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Relationships created by Image [cmdb_ci_os_template]

Parent class Relationship type Child class

Image [cmdb_ci_os_template] Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Image [cmdb_ci_os_template] Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]
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Relationships created by Cloud Mgmt Network Interface [cmdb_ci_nic]

Parent class Relationship type Child class

Cloud Mgmt Network Interface 
[cmdb_ci_nic]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Cloud Mgmt Network Interface 
[cmdb_ci_nic]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]

Reference-type relationships

Parent class Relationship type Child class

SGC Qualys Asset 
Software Details 
[sn_sec_sgc_qualys_asset_software_details]

Reference Server [cmdb_ci_server]

SGC Qualys Asset 
Network Interface Details 
[sn_sec_sgc_qualys_asset_nic_details]

Reference Cloud Mgmt Network Interface 
[cmdb_ci_nic]

SGC Qualys Asset Cloud Tag 
[sn_sec_sgc_qualys_asset_cloud_tag]

Reference Server [cmdb_ci_server]

Software Instance 
[cmdb_software_instance]

Reference Server [cmdb_ci_server]

Software [cmdb_ci_spkg] Reference Software Instance 
[cmdb_software_instance]

Service Graph Connector for Rapid7

The Service Graph Connector for Rapid7 pulls in asset inventory data (hardware and software) 
from the Rapid7 database into the Configuration Management Database (CMDB)  application in 
your ServiceNow AI Platform®  instance.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Supported versions

• Version 4.0 of the Rapid7 InsightVM  application.

• Utah, Vancouver, and Washington ServiceNow®  family releases.

Use cases

• Complement the data from the Rapid7 InsightVM  discovery product.

• Import hardware data and details about your assets from the Rapid7 InsightVM  integration and 
store them in appropriate configuration item (CI) classes in your CMDB.
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CMDB  integrations dashboard

The Integration Commons for CMDB  store app provides a dashboard with a central view of the 
status, processing results, and processing errors of all installed integrations. You can see metrics 
for all integration runs. You can filter the view to a specific CMDB  integration, a specific time 
duration, or a specific integration run. For more details about monitoring Rapid7  integrations in 
the CMDB  Integrations Dashboard, see Using the CMDB Integrations Dashboard.

Guided setup

Use the guided setup feature for the Service Graph Connector for Rapid7  to help you configure 
your integration in an organized sequence of tasks.

Note: 
The API token requires the InsightIDR viewer role.

Configure the Service Graph Connector for Rapid7

After you have followed the instructions provided to you to download and activate the Service 
Graph Connector for Rapid7  application, refer to Download an application from the ServiceNow 
Store for the first time  and Install a Security Operations integration . There are a few steps you 
need to complete before you configure this integration.

Configure the Service Graph Connector for Rapid7

Configure your connections, set up scheduled imports, verify successful connections and 
optionally add multiple instances in the Guided Setup.

Before you begin
To use this Service Graph Connector, you need a subscription to a Subscription Unit that is 
based in the IT Operations Management  (ITOM) Visibility application or in the ITOM  Discovery 
application. As defined in the section titled "Managed IT Resource Types" in ServiceNow 
Subscription Unit Overview  for your subscription, for managed IT resources that are created 
or modified in the CMDB  by this Service Graph Connector, but that aren’t yet managed by ITOM 
Visibility or ITOM Discovery , these resources will increase Subscription Unit consumption from 
that application. Review your current Subscription Unit consumption within ITOM Visibility or 
ITOM Discovery to ensure available capacity.

• The Integration Commons for CMDB  store app, which is automatically installed.

• The CMDB  CI class models store app, which is automatically installed. See CMDB CI Class 
Models store app.

• The ITOM Discovery License plugin (com.snc.itom.discovery.license). You must activate this 
plugin.

• ITOM Licensing plugin (com.snc.itom.license). For more information, see Request Discovery .

• The Datastream Action plugin (com.glide.hub.action_type.datastream), which is automatically 
installed.

• Observability Commons for CMDB  (sn_observability), which is only required for event 
ingestion. This app must be installed prior to installing the connector for Event Management to 
work. For more information, see Observability Commons for CMDB  on the ServiceNow Store.

Roles required:

• admin for tasks in the Guided Setup

• insightIDR viewer role for the API token
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Procedure

1. Navigate to All  > Service Graph Connectors  > Rapid7  > Setup  in the navigation panel in your 
instance.

2. On the Welcome to Guided Setup Home page, select Continue.

3. On the Experience page that is displayed, select Best Experience  followed by Continue.
On the Service Graph Connector for Rapid7  page, there are three tasks displayed:

◦ Configure the connection

◦ Add multiple instances

◦ Set up scheduled imports

4. Select Configure the connection  to expand it.
There are three steps:

◦ Configure Rapid7  authentication credentials

◦ Configure Rapid7  HTTP Connection

◦ Test Connection

5. Select Configure Rapid7 authentication credentials  and fill in the fields.

a. Enter a name for the credentials, for example SGRapid7.Credential.

b. Verify the Active  check box is selected.

c. In the API Key field, enter your Rapid7 InsightVM  API key.

d. Leave the other field values in their current settings.

e. Right-click in the gray header titled API Key Credentials and select Save.

f. Select Mark as complete  followed by Continue.
The Configure Rapid7  HTTP Connection page is displayed.

6. Configure Rapid7  HTTP Connection.

a. Fill in the fields,

Field Value

Name Connection name, SGRapid7, for example.

Active Selected.

Credential Credentials to use for the connection. Select 
one from the list.

Connection alias Select one from the list. 
sn_sec_sgc_rapid7.SGRapid7, for example

URL builder Select the check box. Fill in the new fields.

Connection URL URL that includes 'https', for example, 
https://us.api.insight.rapid7.com
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Field Value

Host Rapid7  domain part of the URL without 
the 'https'. An example might be 
us.api.insight.rapid7.com.

Protocol https

b. Right-click in the gray header titled HTTP(s) Connection and select Save.

c. Select Mark as complete  followed by Continue.
The Test Connection page is displayed.

7. Test the connection.

a. Select the Test Connection  link under Related Links.
If the connection is successful, 200  is displayed in the Status Code field and a message is 
displayed. If your connection test fails, review the Message and Suggestion fields for how to 
proceed.

b. Right-click in the gray header titled Service Graph Connections and select Save.

c. Select Mark as complete  followed by Continue.
The steps for Add Multiple Instances is displayed. This step is optional and you might prefer 
to wait after you confirm you can import data before setting up multiple instances.

8. To configure the scheduled job, navigate back to the Guided Setup page and select Set up 
scheduled import jobs.

a. Follow the steps listed at the top of the page to switch the application scope with the 
application picker to open, edit, and save the record.
You must select the Active check box to activate the scheduled job.

b. Select a record.

c. Fill in the fields.

Field Value

Name Unique Name for scheduled job.

Application Read-only: Service Graph Connector for 
Rapid7.

Data source Data source used.

Run How often you want the job to run. If you 
want to run a test import prior to scheduling 
it, you might prefer to select Once.

Run as Run the scheduled job with the credentials 
of another specified user.

Time When you want the job to run.

Active Select the check box to activate the job.
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Field Value

Conditional Specific conditions under which this job is 
run.

Use connection Leave this check box deactivated for the 
first run. Specifies another connection and 
credentials for this job.

Concurrent import Leave check box activated. Splits data into 
multiple imports sets. See the field message 
for more information.

Partition Method Leave as Custom size.

Partition size 15,000. Leave this value for the import set 
size for early scheduling.

Execute pre-import script Leave check box activated. Specifies a script 
to run before the import is performed.

Execute post-import script Leave check box activated. Specifies a script 
to run after the import is performed.

d. Optional:  Select Execute now  to run the job.
If you do not choose to run the job on-demand, the next job runs according to the schedule 
you set.

e. Right-click in the gray header titled Scheduled Data Imports and select Save.

f. Select Mark as complete  followed by Continue.

9. Optional:  Return to Guided setup and add multiple instances.
When indicated, follow the steps listed at the top of the page to switch the application scope 
with the application picker to open, edit, and save the record.

10. Select Update Data Sources.

a. On the Update Data Source Access page, select Data Source.

b. On the page that is displayed, select the Application Access  tab.

c. Review the access settings and update as needed.

d. Right-click in the gray header titled Table and select Save.

e. Select Mark as complete  followed by Continue.

f. Select Schedule Update Schedule Data Import.

g. Select the Application Access  tab to view the permission settings.

h. When you are satisfied with the settings, right-click in the gray header titled Tables and 
select Save.

i. Select Mark as complete  followed by Continue.
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j. Follow the steps listed at the top of the page to switch the application scope with the 
application picker to open, edit, and save the record.

k. On the Add Another Connection page, select the Click here  link.
The Flow Designer  connection page is displayed and you can create a new connection.

l. From this page, select Add Connection.

m. Fill in the fields with your connection information.

Field Description

Rapid7  Connection name Unique name for your connection.

Rapid7  Connection URL Connection URL.

API Key Rapid7  API key.

n. Select Create Connection.
Your connections are displayed on the Rapid7  page.

o. Select Mark as complete  followed by Continue.
The Test New Connections page is displayed. Locate your new connection and note the 
status is 'Pending'.

p. Scroll and select the Test Connection  link.
If the connection is successful, 200 is displayed in the Status Code field and a message is 
displayed. If your connection test fails, review the Message and Suggestion fields for how to 
proceed.

q. Right-click in the gray header titled Service Graph Connections and select Save.

r. Select Mark as complete  followed by Continue.
The Configure the scheduled jobs page is displayed.

s. Repeat the steps listed previously in step 8.

t. On the Service Graph Connector for Rapid7  page for Guided Setup, select Complete  to 
finish the configuration.

CMDB classes targeted in the Service Graph Connector for Rapid7

When you complete the guided setup, you can configure the integration to periodically pull data. 
The data is saved in tables that extend from the Configuration item [cmdb_ci] table.

Hardware [cmdb_ci_hardware]

The following attributes in the Hardware [cmdb_ci_hardware] table are populated by collected 
data.

Attribute label Attribute name

Name name
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Attribute label Attribute name

Correlation ID correlation_id

MAC Address mac_address

Install Status install_status

Operational Status operational_status

IP Address [cmdb_ci_ip_address]

The following attributes in the IP Address [cmdb_ci_ip_address] table are populated by collected 
data.

Attribute label Attribute name

Name name

IP Address ip_address

Owned By Configuration Item owned_by_cmdb_ci

SGC Rapid7 Asset [sn_sec_sgc_rapid7_sgc_rapid7_asset]

The following attributes in the SGC Rapid7 Asset [sn_sec_sgc_rapid7_sgc_rapid7_asset] table are 
populated by collected data.

Attribute label Attribute name

Assessed for policies assessed_for_policies

Assessed for vulnerabilities assessed_for_vulnerabilities

Configuration item configuration_item

Credential assessments credential_assessments

Critical vulnerabilities critical_vulnerabilities

Exploits exploits

Last assessed for vulnerabilities last_assessed_for_vulnerabilities

Last scan end last_scan_end

Last scan start last_scan_start

Malware kits malware_kits

Moderate vulnerabilities moderate_vulnerabilities

New new

OS architecture os_architecture

OS description os_description

OS family os_family

OS name os_name

OS system name os_system_name

OS type os_type
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Attribute label Attribute name

OS vendor os_vendor

OS version os_version

Remediated remediated

Risk score risk_score

Same same

Severe vulnerabilities severe_vulnerabilities

Tags tags

Total vulnerabilities total_vulnerabilities

Type type

Unique identifiers unique_identifiers

Configuration item configuration_item

Relationships created for Hardware

Parent class Relationship type Child class

Hardware [cmdb_ci_hardware] Owns::Owned by IP Address 
[cmdb_ci_ip_address]

Hardware [cmdb_ci_hardware] Reference SGC Rapid7 Asset 
[sn_sec_sgc_rapid7_sgc_rapid7_asset]

Relationships created for IP Address

Parent class Relationship type Child class

IP Address 
[cmdb_ci_ip_address]

Reference Hardware [cmdb_ci_hardware]

Relationships created by SGC Rapid7 Asset

Parent class Relationship type Child class

SGC Rapid7 Asset 
[sn_sec_sgc_rapid7_sgc_rapid7_asset]

Reference Hardware [cmdb_ci_hardware]

Service Graph Connector for SentinelOne

The Service Graph Connector for SentinelOne pulls in asset inventory data (hardware and 
software) from the SentinelOne database into the Configuration Management Database (CMDB) 
application in your ServiceNow AI Platform®  instance.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .
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Supported Versions

• Supported SentinelOne API versions: Get Agents- V2.1

• Supported ServiceNow AI Platform®  versions:

◦ Xanadu

◦ Washington

◦ Vancouver

Use cases

• Import SentinelOne agent information and store it in appropriate configuration item (CI) 
classes in your CMDB.

• Configure multiple instances of SentinelOne in the Service Graph Connector.

Guided setup

Use the guided setup feature to help you configure your integration in an organized sequence of 
tasks.

CMDB  integrations dashboard

The Integration Commons for CMDB  store app provides a dashboard with a central view of 
the status, processing results, and processing errors of all installed integrations. You can see 
metrics for all integration runs. You can filter the view to a specific CMDB  integration, a specific 
time duration, or a specific integration run. For more details about monitoring SentinelOne 
integrations in the CMDB  Integrations Dashboard, see Using the CMDB Integrations Dashboard.

Configure the Service Graph Connector for SentinelOne

The guided setup for the Service Graph Connector for SentinelOne  provides an organized 
sequence of tasks to configure the integration on your ServiceNow AI Platform  instance.

Before you begin
To use this Service Graph Connector, you need a subscription to a Subscription Unit that is 
based in the IT Operations Management  (ITOM) Visibility application or in the ITOM  Discovery 
application. As defined in the section titled "Managed IT Resource Types" in ServiceNow 
Subscription Unit Overview  for your subscription, for managed IT resources that are created 
or modified in the CMDB  by this Service Graph Connector, but that aren’t yet managed by ITOM 
Visibility or ITOM Discovery , these resources will increase Subscription Unit consumption from 
that application. Review your current Subscription Unit consumption within ITOM Visibility or 
ITOM Discovery to ensure available capacity.

Dependencies and requirements:

• The Integration Commons for CMDB store app, which is automatically installed.

• The CMDB CI Class Models store app store app, which is automatically installed.

• Discovery Core plugin (com.snc.discovery.core), which is automatically installed by Discovery.

• The ITOM Discovery License plugin (com.snc.itom.discovery.license). You must activate this 
plugin.

• ITOM Licensing plugin (com.snc.itom.license). For more information, see Request Discovery.

• Guided Setup (com.sn.ads.setup).
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• Data Stream (com.glide.hub.action_type.datastream).

• ITOM Patterns.

Roles required:

• SentinelOne Role - viewer

• ServiceNow AI Platform®  Role - admin

Guided Setup

The guided setup for the Service Graph Connector for SentinelOne  provides an organized 
sequence of tasks to configure the integration on your instance.

Procedure

1. Navigate to Service Graph Connectors  > SentinelOne  > Setup.

2. On the Home page, select Continue.

3. On the Experience page, select the Best Experience  from it.

4. On the Service Graph Connector for SentinelOne  page in the Configure the connection page, 
select the Configure SentinelOne Authentication Credentials  task and follow these steps:

a. In the API Key field, enter your SentinelOne API Key and update the credential record.

b. Select the Mark as Complete  checkbox and select Continue.

5. In the Configure SentinelOne HTTP Connection  task follow these steps:

a. Add the SentinelOne base URL (Uniform Resource Locator).

b. Select the Mark as Complete  checkbox and select Continue.

6. In the Test Connection  task follow these steps:

a. Select the Test Connection  link.

The Status code field displays 200  if the connection is successful.

b. Select the Mark as Complete  checkbox and select Continue.

7. Optional:  To create another connection, select the Update Data Source Access  section and 
follow these steps:

a. Give permission to create and update the data source.

b. Select the Mark as Complete  checkbox and select Continue.

c. Give permission to create and update the Scheduled Import Sets.

d. Select the Mark as Complete  checkbox and select Continue.

e. Clear the cache with the code snippet mentioned previously using Scripts-Background.

f. Select the Mark as Complete  checkbox and select Continue.

g. Add a new connection by clicking the link.

h. After you add a new connection, select the Mark as Complete  checkbox and select 
Continue.

i. Select the new connection record and select the Test Connection link.

The Status code field displays 200  if the connection is successful.

j. Select the Mark as Complete  checkbox and select Continue.
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8. Fill out the fields on the Scheduled Data Import form:

Field Description

Name Name of the scheduled job.

Data source Data source record that defines the data to 
import.

Run as Option to run the scheduled job with the 
credentials of the specified user.

Active Option to activate the scheduled job. Select 
this option.

Concurrent Import Function that loads the data from multiple 
import sets. The function then processes and 
transforms the data concurrently.

Partition Method Partition method for the concurrent import 
set.

Partition Size Import set size for early scheduling.

Execute pre-import script Option to specify a script to run before the 
import is performed.

Execute post-import script Option to specify a script to run after the 
import is performed.

Application Application that contains this scheduled job.

Run Frequency of running the import.

Conditional Conditions under which this job is executed.

9. Click Execute Now.

10. In the Help task bar, select Mark as Complete.

CMDB  classes targeted in the Service Graph Connector for SentinelOne

When you complete the guided setup, you can configure the integration to periodically pull data. 
The data is saved in tables that extend from the Configuration item [cmdb_ci] table.

AWS Datacenter [cmdb_ci_aws_datacenter]
The following attributes in the AWS Datacenter [cmdb_ci_aws_datacenter] table are populated by 
collected data.

Attribute label Attribute name

Object Id object_id

Region region

Name name
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Relationships for AWS Datacenter

Parent Class Relationship Type Child Class

AWS Datacenter 
[cmdb_ci_aws_datacenter]

Hosted On: Hosts Cloud Service Account 
[cmdb_ci_cloud_service_account]

Azure Datacenter [cmdb_ci_azure_datacenter]

The following attributes in the Azure Datacenter [cmdb_ci_azure_datacenter] table are populated 
by collected data.

Attribute label Attribute name

Object Id region

Name name

Region region

Relationships for Azure Data Center

Parent Class Relationship Type Child Class

Azure Datacenter 
[cmdb_ci_azure_datacenter]

Hosted On: Hosts Cloud Service Account 
[cmdb_ci_cloud_service_account]

Availability Zone [cmdb_ci_availability_zone]

The following attributes in the Availability Zone [cmdb_ci_availability_zone] table are populated 
by collected data.

Relationships for Availability Zone

Parent Class Relationship Type Child Class

Azure Datacenter 
[cmdb_ci_azure_datacenter]

Contains:Contained by Availability Zone 
[cmdb_ci_availability_zone]

Attribute label Attribute name

Name name

Object Id object_id

Region region

GCP Datacenter [cmdb_ci_google_datacenter]

The following attributes in the GCP Datacenter [cmdb_ci_google_datacenter] table are populated 
by collected data.

Attribute label Attribute name

Name name
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Attribute label Attribute name

Object Id object_id

Account Id account_id

Datacenter Type datacenter_type

Relationships for GCP Datacenter

Parent Class Relationship Type Child Class

GCP Datacenter 
[cmdb_ci_google_datacenter]

Hosted On: Hosts Cloud Service Account 
[cmdb_ci_cloud_service_account]

Cloud Service Account [cmdb_ci_cloud_service_account]

The following attributes in the Cloud Service Account [cmdb_ci_cloud_service_account] table are 
populated by collected data.

Attribute label Attribute name

Name name

Object Id object_Id

Account Id account_Id

Datacenter Type datacenter_type

Relationships for Cloud Service Account

Parent Class Relationship Type Child Class

Network [cmdb_ci_network] Hosted On: Hosts Cloud Service Account 
[cmdb_ci_cloud_service_account]

Cloud Subnets [cmdb_ci_cloud_subnet]

The following attributes in the Cloud Subnets [cmdb_ci_cloud_subnet] table are populated by 
collected data.

Attribute label Attribute name

Object Id object_id

Name name

Relationships for Cloud Subnets

Parent Class Relationship Type Child Class

Network [cmdb_ci_network] Contains:Contained by Cloud Subnets 
[cmdb_ci_cloud_subnet]
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Hardware Type [cmdb_ci_compute_template]

The following attributes in the Hardware Type [cmdb_ci_compute_template] table are populated 
by collected data.

Attribute label Attribute name

Name name

Object Id object_id

Relationships for Hardware Type

Parent Class Relationship Type Child Class

Compute Template 
[cmdb_ci_compute_template]

Hosted On: Hosts Cloud Service Account 
[cmdb_ci_cloud_service_account]

VM Instance 
[cmdb_ci_vm_instance]

Provisioned From::Provisioned Compute Template 
[cmdb_ci_compute_template]

Cloud Network [cmdb_ci_network]

The following attributes in the Cloud Network [cmdb_ci_network] table are populated by 
collected data.

Attribute label Atribute name

Object Id object_id

Name name

Relationships for Cloud network

Parent Class Relationship Type Child Class

Network [cmdb_ci_network] Hosted on::Hosts Cloud Service Account 
[cmdb_ci_cloud_service_account]

Virtual Machine Instance [cmdb_ci_vm_instance]

The following attributes in the Virtual Machine Instance [cmdb_ci_vm_instance] table are 
populated by collected data.

Attribute label Attribute name

Object Id object_id

Name name

VM Instance ID vm_inst_id
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Relationships for VM Instance

Parent Class Relationship Type Child Class

VM Instance 
[cmdb_ci_vm_instance]

Hosted On: Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

VM Instance 
[cmdb_ci_vm_instance]

Virtualized by::Virtualizes Server [cmdb_ci_server]

VM Instance 
[cmdb_ci_vm_instance]

Hosted On: Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Key Value [cmdb_key_value]

The following attributes in the Key Value [cmdb_key_value] table are populated by collected data.

Attribute label Attribute name

Key key

Value value

Tag tag

Image [cmdb_ci_os_template]

The following attributes in the Image [cmdb_ci_os_template] table are populated by collected 
data.

Attribute label Attribute name

Object Id object_id

Name name

Relationships for Image

Parent Class Relationship Type Child Class

Image [cmdb_ci_os_template] Hosted on::Hosts Cloud Service Account 
[cmdb_ci_cloud_service_account]

Server [cmdb_ci_server]

The following attributes in the Server [cmdb_ci_server] table are populated by collected data.

Attribute label Attribute name

Attribute label Attribute name

Name name

Serial number serial_number

CPU speed (MHz) cpu_speed

CPU count cpu_count
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Attribute label Attribute name

RAM (MB) ram

OS Address Width (bits) os_address_width

Operating System os

CPU core count cpu_core_count

Fully qualified domain name fqdn

CPU name cpu_name

First Discovered first_discovered

Model Id model_id

Model Number model_number

Name name

Computer [cmdb_ci_computer]

The following attributes in the Computer [cmdb_ci_computer] table are populated by collected 
data.

Attribute label Attribute name

Name name

Serial number serial_number

CPU speed (MHz) cpu_speed

CPU count cpu_count

RAM (MB) ram

OS Address Width (bits) os_address_width

Operating System os

CPU core count cpu_core_count

Fully qualified domain name fqdn

CPU name cpu_name

First Discovered first_discovered

Model Id model_id

Model Number model_number

Name name

SentinelOne Asset Tags [sn_sec_sgc_sntlone_asset_tags]

The following attributes in the SentinelOne Asset Tags [sn_sec_sgc_sntlone_asset_tags] table 
are populated by collected data.

Attribute label Attribute name

ID tags_id
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Attribute label Attribute name

Key tags_key

Value tags_value

Assigned At tags_assignedat

Assigned By tags_assignedby

Assigned By ID assigned_by_id

IP Address [cmdb_ci_ip_address]

The following attributes in the IP Address [cmdb_ci_ip_address] table are populated by collected 
data.

Attribute label Attribute name

IP Address ip_address

Name name

Nic nic

IP version ip_version

Relationships for IP Address

Parent Class Relationship Type Child Class

Server [cmdb_ci_server] Owns:Owned by IP Address 
[cmdb_ci_ip_address]

Network Adapter [cmdb_ci_network_adapter]

The following attributes in the Network Adapter [cmdb_ci_network_adapter] table are populated 
by collected data.

Attribute label Attribute name

Mac Address mac_address

Name name

Ip Default Gateway ip_default_gateway

Discovery Source discovery_source

Relationships for Network Adapter

Parent Class Relationship Type Child Class

Server [cmdb_ci_server] Owns:Owned by Network Adapter 
[cmdb_ci_network_adapter]
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SentinelOne Additional Attributes [sn_sec_sgc_sntlone_additonal_attributes]

The following attributes in the SentinelOne Additional Attributes 
[sn_sec_sgc_sntlone_additonal_attributes] table are populated by collected data.

Attribute label Attribute name

NetworkInterfaces Name networkinterfaces_name

NetworkInterfaces GatewayMacAddress networkinterfaces_gatewaymacaddress

UUID uuid

Configuration item configuration_item

Network Quarantine Enabled network_quarantine_enabled

Last Successful Scan Date last_successful_scan_date

License_Key license_key

First Discovered first_discovered

Location Enabled location_enabled

Ad ComputerDistinguishedName ad_computerdistinguishedname

Agent Version agent_version

Scan Status scan_status

Scan Started At scan_started_at

ID id

IP Address Subnet ip_address_subnet

Mitigation Mode Suspicious mitigation_mode_suspicious

Last Scan Finished At last_scan_finished_at

Firewall Enabled firewall_enabled

Console Migration Status console_migration_status

Group ID group_id

Operational State Expiration operational_state_expiration

Last IP To Mgmt last_ip_to_mgmt

Threat Reboot Required threat_reboot_required

Machine Type machine_type

Is Pending Uninstall

Ranger Status

Is_pending_uninstall

ranger_status

Ad LastUserDistinguishedName ad_lastuserdistinguishedname

Agent Up To Date agent_up_to_date

Ranger Version ranger_version

Last Boot Time last_boot_time

Disk Encryption Status disk_encryption_status
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Attribute label Attribute name

Mitigation Mode mitigation_mode

Last Full Scan last_full_scan

Agent Uninstalled agent_uninstalled

Extenal Id extenal_id

Updated At updated_at

Last Scan Aborted At last_scan_aborted_at

Network Status network_status

Show Alert Icon show_alert_icon

Subscribed On subscribed_on

Account ID account_id

Recently Active recently_active

Active Threats active_threats

Allow Remote Shell allow_remote_shell

Site Name site_name

First Full Mode Time first_full_mode_time

Infected infected

App Vulnerability Status app_vulnerability_status

Site ID site_id

Agent Installer Type agent_installer_type

Account Name acount_name

NetworkInterfaces Name networkinterfaces_name

NetworkInterfaces GatewayMacAddress networkinterfaces_gatewaymacaddress

NetworkInterfaces ID networkinterfaces_id

user_actions_needed user_actions_needed

aws_security_group aws_security_group

proxyState_console proxyState_console

proxyState_deepVisibility proxyState_deepVisibility

Ad UserPrincipalName ad_userPrincipalName

Ad ComputerMemberOf ad_computerMemberOf

Ad ComputerDistinguishedName ad_computerDistinguishedName

Ad LastUserMemberOf ad_lastUserMemberOf

Ad LastUserDistinguishedName ad_lastUserDistinguishedName

Ad Mail ad_mail

Agent Decommissioned agent_decommissioned

Agent Operational State agent_operational_state
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Attribute label Attribute name

Last Active Date last_active_date

Group Updated At group_updated_at

Missing Permissions missing_permissions

Service Graph Connector for SentinelOne  Properties

Property Description

sn_sec_sgc_sntlone.api_page_size Enter the number of records per page to 
retrieve.

• Type: string

• Default value: 1000

• Location: System Property [sys_properties] 
table

Note: 
To open the System Properties [sys_properties] table, enter sys_properties.LIST in the 
navigation filter.

Service Graph Connector for Splunk

The Service Graph Connector for Splunk pulls in asset inventory data (hardware and software) 
from the Splunk database into the Configuration Management Database (CMDB)  application in 
your ServiceNow AI Platform®  instance.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Supported versions

Supported versions:

• Xanadu

• Washingtondc

• Vancouver

Use cases

By default, the Service Graph Connector for Splunk  pulls the following basic forwarding details:

• Forwarder's version

• Forwarder's type

• Forwarder's last check-in time

• OS

• Host

• Host IP address
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With the Service Graph Connector for Splunk add-on, you have the option to import extended 
data for your Windows  and Linux  assets with the Service Graph Connector for Splunk  that 
includes the following details:

• MAC address

• Operating system details

• Asset name

• Software details

• File system

• Last logon date

• Open ports

This data is stored in the Configuration Management Database (CMDB) and Splunk  Asset 
Details extension attributes custom tables. To import these extended asset details, the add-on is 
required. See Install the add-on for the Service Graph Connector for Splunk.

Guided setup

The guided setup for the Service Graph Connector for Splunk  provides an organized sequence 
of tasks to configure the integration on your instance. To access the guided setup, see the 
section titled Configure the Service Graph Connector for Splunk.

CMDB  integrations dashboard

The Integration Commons for CMDB  store app provides a dashboard with a central view of 
the status, processing results, and processing errors of all installed integrations. You can see 
metrics for all integration runs. You can filter the view to a specific CMDB  integration, a specific 
time duration, or a specific integration run. For more details about monitoring integrations in the 
CMDB  Integrations Dashboard, see Using the CMDB Integrations Dashboard.

Configure the Service Graph Connector for Splunk

Configure your connections, set up scheduled imports, verify successful connections and 
optionally add multiple instances in the Guided Setup.

Before you begin
To use this Service Graph Connector, you need a subscription to a Subscription Unit that is 
based in the IT Operations Management  (ITOM) Visibility application or in the ITOM  Discovery 
application. As defined in the section titled "Managed IT Resource Types" in ServiceNow 
Subscription Unit Overview  for your subscription, for managed IT resources that are created 
or modified in the CMDB  by this Service Graph Connector, but that aren’t yet managed by ITOM 
Visibility or ITOM Discovery , these resources will increase Subscription Unit consumption from 
that application. Review your current Subscription Unit consumption within ITOM Visibility or 
ITOM Discovery to ensure available capacity.

• The Integration Commons for CMDB  store app, which is automatically installed.

• The CMDB  CI class models store app, which is automatically installed. See CMDB CI Class 
Models store app.

• The ITOM Discovery License plugin (com.snc.itom.discovery.license). You must activate this 
plugin.

• ITOM Licensing plugin (com.snc.itom.license). For more information, see Request Discovery .

• The Datastream Action plugin (com.glide.hub.action_type.datastream), which is automatically 
installed.
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• Optional: Only required for event ingestion. Observability Commons for CMDB 
(sn_observability). If used, this app must be installed prior to installing the connector for Event 
Management to work. For more information, see Observability Commons for CMDB  on the 
ServiceNow Store.

Role required: admin

Procedure

1. Navigate to All  > Service Graph Connectors  > Splunk  > Setup  in the navigation panel in your 
instance.

2. On the Welcome to Guided Setup Home page, select Continue.

3. On the Experience page that is displayed, select Best Experience  followed by Continue.
On the Service Graph Connector for Splunk  page, there are three tasks displayed:

◦ Configure the connection

◦ Add multiple instances

◦ Set up scheduled import jobs

4. Select Configure the connection  to expand it.
There are three tasks:

◦ Configure Splunk  authentication credentials

◦ Configure Splunk  HTTP Connection

◦ Test Connection

5. Select Configure Splunk authentication credentials  and fill in the fields.

a. Enter a name for the credentials, for example SG-Splunk Credentials.

b. Verify the Active  check box is selected.

c. Enter your User name and Password for your Splunk  instance.

d. Leave the other field values in their current settings.

e. Right-click in the gray header titled Basic Auth Credentials and select Save.

f. Select Mark as complete  followed by Continue.
The Configure Splunk  HTTP Connection page is displayed.

6. Configure the Splunk  HTTP connection.

a. Fill in the fields.

Field Value

Name Connection name, SG-Splunk 
Connection, for example.

Active Selected.

Credential Credentials to use for the connection. Select 
one from the list.
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Field Value

Domain global.

Connection alias Select one from the list. 
sn_sec_sgc_splunk.SGSplunk, for example

URL builder Select the check box. Fill in the new fields.

Host Splunk domain part of the URL without the 
'https'. An example might be splunk3.com 
or an IP address.

Override default port The Splunk instance port,8089, for example.

Protocol https.

(Optional) Use MID server Select the check box for a dedicated MID 
Server for the connection, if available.

i. Select Specific MID Server  from the MID 
Selection drop down list.

ii. Select a MID Server from the list.

Note: 
A MID Server is required for on-
premise connections if the connection 
is not publicly accessible.

b. Right-click in the gray header titled HTTP(s) Connection and select Save.

c. Select Mark as complete  followed by Continue.
The Test Connection page is displayed.

d. Optional:  Set the flag for the is the servicenow addon installed 
(is_snow_addon_installed).
By default, the property on the Service Graph Connection Properties tab is set to false.

Option Description

false The default query is set to extract only 
essential information about the forwarder 
that includes the host name and the 
operating system.​

true The query offers more information about the 
forwarder along with extensive asset details 
via the ServiceNow add-on.

(Optional) This data is imported only if the 
add-on is installed on the Splunk  instance.

7. Test the connection.
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a. Select the Test Connection  link under Related Links.
If the connection is successful, 201  is displayed in the Status Code field and a message 
is displayed after a few moments. If your connection test fails, review the Message and 
Suggestion fields for how to proceed.

b. After a successful test, right-click in the gray header titled Service Graph Connections and 
select Save.

c. Select Mark as complete  followed by Continue.
The steps for Add Multiple Instances is displayed. To add multiple instances, proceed to 
step 9. This step is optional and you might prefer to wait after you confirm you can import 
data before setting up multiple instances. To set the import schedule, follow the steps below.

8. To configure the scheduled job, select Set up scheduled import jobs  from the drop down list 
under Add Multiple Instances in the header.

a. On the Configure the scheduled jobs page, select a record under Scheduled Data Imports.

b. Select the frequency from the list for the Run field.
If you want to run a test import prior to scheduling it, you might prefer to select Once.

c. Select the Active  box to activate the scheduled job.

d. Optional:  Edit the fields as required.

(Optional) You might prefer to leave these fields in their default settings for the first few runs 
to confirm data imports.

Field Value

Name Unique Name for scheduled job.

Application Read-only: Service Graph Connector for 
Splunk

Data source Data source used.

Run as Run the scheduled job with the credentials 
of another specified user.

Time When you want the job to run.

Conditional Specific conditions under which this job is 
run.

Use connection Leave this check box deactivated for the 
first run. Specifies another connection and 
credentials for this job.

Concurrent import Leave check box activated. Splits data into 
multiple imports sets. See the field message 
for more information.

Partition Method Leave as Custom size.

Partition size 15,000. Leave this value for the import set 
size for early scheduling.
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Field Value

Execute pre-import script Leave check box activated. Specifies a script 
to run before the import is performed.

Execute post-import script Leave check box activated. Specifies a script 
to run after the import is performed.

e. Optional:  Select Execute now  to run the job.
If you do not choose to run the job on-demand, the next job runs according to the schedule 
you set.

f. Right-click in the gray header titled Scheduled Data Import and select Save.

g. Select Mark as complete  followed by Continue.
The main task page is displayed.

9. Optional:  To add multiple instances, select Update Data Sources.

(Optional) When indicated, follow the steps listed at the top of the page to switch the 
application scope with the application picker to open, edit, and save the record.

a. On the Update Data Source Access page, select Data Source.

b. On the page that is displayed, select the Application Access  tab.

c. Review the access settings and update as needed.

d. Right-click in the gray header titled Table and select Save.

e. Select Mark as complete  followed by Continue.

f. On the Update Schedule Data Import  record, select Schedule Data Import  to open it.

g. Select the Application Access  tab to view the permission settings.

h. When you are satisfied with the settings, right-click in the gray header titled Tables and 
select Save.

i. Select Mark as complete  followed by Continue.

j. Follow the steps listed at the top of the page to switch the application scope with the 
application picker to open, edit, and save the record.

k. On the Add Another Connection page, select the Click here  link.
The Flow Designer connection page is displayed and you can create a new connection.

l. From this page, select Add Connection.

m. Fill in the fields with your connection information.
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Field Description

Splunk  Connection name Unique name for your connection.

Splunk  Connection URL Connection URL in https format.

User name Splunk  user name.

Password Splunk  password.

n. Select Create Connection.
Your connections are displayed on the page.

o. On the Add Multiple Instance page, select Mark as complete  followed by Continue.
The Configure MID Server for New HTTP Connection page is displayed.

p. Locate your new connection and select it to open the record.
The connection URL is displayed in the Connection URL field.

q. Optional:  Select the Use MID server check box to add a MID Server.

i. Select Specific MID Server  from the MID Selection drop down list.

ii. Select a MID Server from the list.

r. Right-click in the gray header titled HTTP(s) Connection and select Save.

s. Select Mark as complete  followed by Continue.
The Test New Connections page is displayed.

10. Test the new connection.

a. Scroll and select the connection you want to test.

b. Select the Test Connection  link under Related Links.
If the connection is successful, 201  is displayed in the Status Code field and a message 
is displayed after a few moments. If your connection test fails, review the Message and 
Suggestion fields for how to proceed.

c. After a successful test, right-click in the gray header titled Service Graph Connections and 
select Save.

d. Select Mark as complete  followed by Continue.
The Configure the scheduled jobs page is displayed

e. On the Service Graph Connector for Splunk  page for Guided Setup, select Complete  to 
finish the configuration.

Service Graph Connector for Splunk  add-on

Import more detailed asset data with the Service Graph Connector for Splunk  with an add-
on developed by ServiceNow  engineering. The add-on permits you to import data about your 
Windows  and Linux  assets.
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Service Graph Connector for Splunk

The Service Graph Connector for Splunk  retrieves computer and software information from the 
Splunk  product and imports it into the Configuration Management Database (CMDB) in your 
instance. By default, the following basic data is imported:

• Forwarder's version (agent)

• Forwarder's type (agent)

• Forwarder's last check-in time (agent)

• OS

• Host

• Host IP address

The service graph connector for Splunk  is available on the ServiceNow®  Store.

The ServiceNow  Add-on for Windows  and Linux  assets

With the Windows  and Linux  Assets add-on, you have the option to import more detailed asset 
data with the Service Graph Connector for Splunk  that includes the following data:

• MAC address

• Operating system details

• Asset name

• Installed software details

• File system

• Last logon date

• Open ports

• Running processes

• Running services

This add-on is available for download into your Splunk  console from splunkbase .

Downloading and installing the add-on

Prior to installing this add-on, you must verify you have installed and activated the following 
applications and add-ons:

• Service Graph Connector Splunk

• Splunk_TA_nix version 9.0.0 (Linux) or later

• Splunk_TA_windows version 8.9.0 or later add-ons available from splunkbase.

These add-ons permit you to identify and import more specific data related to your Linux  and 
Windows  assets with your imports with the Splunk  Service Graph Connector API.

For example, searches from these add-ons might provide you with data you want about Windows 
drivers, Windows  Network Adaptors, Linux  Hardware, and other OS Details.
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Target workloads

In the app.manifest, individual agents on a specific machine send information to a central hub 
(server) where data is collected, stored, and managed. This central machine is where the apps 
are installed.

To adjust workloads to specify resources for a search, indexing, or other workloads, in Splunk 
Web, select Settings  > Workload Management  > Workload Rules.

In the Status column, select the toggle to activate or deactivate individual workload rules.

Supported deployments

This add-on supports the following types of deployments:

• standalone

• distributed

• search head clustering

See Splunk  documentation for more information about their supported workloads.

Install the add-on for the Service Graph Connector for Splunk

Install the Splunk  add-on developed by ServiceNow®  engineering from splunkbase to search for 
Windows  and Linux  Assets.

Before you begin
Role required: admin or security_admin

Procedure

1. Navigate to splunkbase  ( splunkbase ) and log in.

2. In your Splunk  console, select Apps  > FInd More Apps.

3. Locate the ServiceNow Add-on for Windows and Linux Assets  app and select Install.

Note: 
You can upgrade from within the app.

4. Follow the prompts.

5. Optional:  Navigate to Settings  > Searches, reports and alerts  to view when searches are 
scheduled.

Note: 

(Optional) You can change the schedules, but since the schedules run in a specific order 
and require successful completion before the next search in the list is initiated, you might 
prefer to leave the settings in their defaults.

After all the searches are completed, the data is grouped from each search into a few 
coalesced key-value parings (kvstores) for import into your instance: asset details, asset 
process details, asset service details, and asset software details.

6. Select App: Search and Reporting (search)  > ServiceNow Add-on for Windows and Linux 
Assets.

By default, search data is stored in the following key definitions:
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◦ Asset_index_macro: Index=”internal”

◦ Asset_linex_Index_macro: index=”main”

◦ Asset_windows_index=”main”

If you are storing the search data for Linux  and Windows  in custom indexes, you must update 
your search macros.

7. To update your search macros, navigate to Settings  > Advanced search  > Search macros 
> Search & Reporting (Search)  > ServiceNow Add-on for Windows and Linux Assets 
ServiceNow_TA_windows_linux_assets

8. On the Search macros page, update the index as required in the Definition column.

9. Optional:  Adjust workloads to specify resources for search, indexing, and other workloads.

a. In Splunk  Web, select Settings  > Workload Management  > Workload Rules.

b. In the Status column, select the toggle to activate or deactivate individual workload rules.
See Service Graph Connector for Splunk add-on  for more information about target workloads 
and supported deployments.

CMDB classes targeted in the Service Graph Connector for Splunk

When you complete the guided setup, you can configure the integration to periodically pull data. 
The data is saved in tables that extend from the Configuration item [cmdb_ci] table.

Computer [cmdb_ci_computer]

The following attributes in the Hardware [cmdb_ci_computer] table are populated by collected 
data.

Attribute label Attribute name

Name name

Serial Number serial_number

Operating System os

OS Version os_version

CPU name cpu_name

CPU manufacturer cpu_manufacturer

CPU type cpu_type

CPU speed (MHz) cpu_speed

CPU core count cpu_core_count

CPU count cpu_count

Manufacturer manufacturer

IP Address [cmdb_ci_ip_address]

The following attributes in the IP Address [cmdb_ci_ip_address] table are populated by collected 
data.
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Attribute label Attribute name

Name name

IP Address ip_address

Network Adapter [cmdb_ci_network_adapter]

The following attributes in the Network Adapter [cmdb_ci_network_adapter] table are populated 
by collected data.

Attribute label Attribute name

Name name

MAC Address mac_address

Manufacturer manufacturer

Software [cmdb_ci_spkg]

The following attributes in the Software [cmdb_ci_spkg] table are populated by collected data.

Attribute label Attribute name

Name name

Version version

Software Instance [cmdb_software_instance]

The following attributes in the Software Instance [cmdb_software_instance] table are populated 
by collected data.

Attribute label Attribute name

Name name

Product name software

Installed On installed_on

Software Installation [cmdb_sam_sw_install]

The following attributes in the Software Installation [cmdb_sam_sw_install] table are populated 
by collected data. This table is populated only when the Software Asset Management 
applications are installed.

Attribute label Attribute name

Display Name display_name

Version version

Discovery Source discovery_source
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Splunk Asset Details [sn_sec_sgc_splunk_asset_details]

The following attributes in the Splunk Asset Details [sn_sec_sgc_splunk_asset_details] table are 
populated by collected data.

Attribute label Attribute name

Configuration Item configuration_item

Forwarder GUID forwarder_guid

Forwarder Type forwarder_type

Forwarder Version forwarder_version

Host Name host_name

Host Status host_status

Host type host_type

Last logon date last_check_in

Model Name model_name

OS Architecture os_architecture

OS Build Number os_build_number

OS Family os_family

Relationships created for Computer

Parent class Relationship type Child class

Computer [cmdb_rel_ci Owns::Owned by IP Address 
[cmdb_ci_ip_address]

Computer [cmdb_rel_ci Owns::Owned by Network Adapter 
[cmdb_ci_network_adapter]

Computer [cmdb_rel_ci Contains::Contained by File system 
[cmdb_ci_file_system]

Service Graph Connector for SolarWinds

Use the Service Graph Connector for SolarWinds  to pull in data from the SolarWinds  software 
into your ServiceNow  instance.

The Service Graph Connector for SolarWinds  pulls in asset inventory data (hardware and 
software) from the SolarWinds  database into the ServiceNow®  Configuration Management 
Database (CMDB)  application.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .
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Supported versions

• Supported SolarWinds  Orion minimum versions:

◦ 2019.4 HF6

◦ 2020.2.1. HF2

• Supported ServiceNow  versions:

◦ Washington DC

◦ Xanadu

◦ Yokohama

Use cases

The following are examples on how you can use the Service Graph Connector:

• Automatic normalization of asset information for hardware, virtualization and cloud resources, 
and software.

• Ability to configure and save synchronization schedules.

Guided setup

The guided setup for the Service Graph Connector for SolarWinds  provides an organized 
sequence of tasks to configure the integration on your instance. To access the guided setup, see 
Configure Service Graph Connector for SolarWinds.

CMDB integrations dashboard

The Integration Commons for CMDB  store app provides a dashboard with a central view of the 
status, processing results, and processing errors of all installed Service Graph Connectors. 
You can see metrics for all integration runs. You can filter the view to a specific integration, a 
specific time duration, or a specific integration run. For more details about monitoring SolarWinds 
integrations in the CMDB  Integrations Dashboard, see Using the CMDB Integrations Dashboard.

Data mapping

Data from data sources in the SolarWinds  software is mapped and transformed into ServiceNow 
CMDB  tables using the Robust Transform Engine (RTE). Data is inserted into ServiceNow  CMDB 
using the Identification and Reconciliation Engine (IRE).

When you complete setting up the connection, you can configure the integration to periodically 
pull data from the SolarWinds  software.

The data is loaded into staging tables and then inserted into the following CMDB  target tables:

• AIX Server [cmdb_ci_aix_server]

• Availability Zone [cmdb_ci_availability_zone]

• CI Relationship [cmdb_rel_ci]

• Cloud Network [cmdb_ci_network]

• Cloud Service Account [cmdb_ci_cloud_service_account]

• Cloud Subnet [cmdb_ci_cloud_subnet]

• Computer [cmdb_ci_computer]

• Disk [cmdb_ci_disk]
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• Hardware [cmdb_ci_hardware]

• Hardware Type [cmdb_ci_compute_template]

• Hyper-V Server [cmdb_ci_hyper_v_server]

• IIS Virtual Directory [cmdb_ci_iisdirectory]

• Image [cmdb_ci_os_template]

• IP Address [cmdb_ci_ip_address]

• Linux Server [cmdb_ci_linux_server]

• Logical Datacenter [cmdb_ci_logical_datacenter]

• Microsoft iis Web Server [cmdb_ci_microsoft_iis_web_server]

• MS SQL Server [cmdb_ci_db_mssql_server]

• MS SQL DataBase [cmdb_ci_db_mssql_database]

• Network Adapter [cmdb_ci_network_adapter]

• Network Gear [cmdb_ci_netgear]

• Serial Number [cmdb_serial_number]

• Server [cmdb_ci_server]

• Software Installation [cmdb_sam_sw_install] (If the Software Asset Management (SAM) 
application is installed.)

• Software Instance [cmdb_software_instance] (If the SAM application is not installed.)

• Software [cmdb_ci_spkg] (If the SAM application is not installed.)

• Solaris Server [cmdb_ci_solaris_server]

• Storage Volume [cmdb_ci_storage_volume]

• UNIX Server [cmdb_ci_unix_server]

• VM Instance [cmdb_ci_vm_instance]

• Windows Server [cmdb_ci_win_server]

For more information on where data is saved when pulling data from SolarWinds, see CMDB 
classes targeted in Service Graph Connector for SolarWinds.

You can use the IntegrationHub ETL app to view the data maps. See IntegrationHub ETL  for more 
information.

Related topics

Service Graph Connectors

Configure Service Graph Connector for SolarWinds  using SGC Central

Use the playbook available with the SGC Central  application to set up the Service Graph 
Connector for SolarWinds  for pulling in SolarWinds  data into the CMDB.

Before you begin
Install Service Graph Connector for SolarWinds  version 2.6.0 or later from the ServiceNow Store. 
For ServiceNow Store  installation steps, see Install a ServiceNow Store application .

Air gap connections are available from version 2.5.0 of the Service Graph Connector for 
SolarWinds. You can set up either standard data sources or air gap data sources. Before you 
set up air gap data sources, you must configure the air gap solution for the Service Graph 
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Connector for SolarWinds  in your high-secure server and low-secure server. See Configuring air 
gap connections for Service Graph Connector for SolarWinds.

Role required: admin or cmdb_inst_admin

About this task
The playbook experience for onboarding connectors is activated with SGC Central  in the CMDB 
Workspace. To configure the SGC Central  application, see Configuring SGC Central  and for more 
information on how to interact with a playbook, see Interact with Playbook .

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the CMDB Workspace, select SGC Central.

3. On the Dashboard page, select Create connection.

Tip: 
Alternatively, you can select Create connection  on the All connections page.

4. On the Create connection window, select the SolarWinds  connector type, and then select 
Create connection.

5. Complete the initial prerequisites when setting up a connection for the first time using a 
connector.

Note: 
This step is required only during the first-time setup. See Perform initial setup tasks when 
creating a connection in SGC Central.

6. Complete the setup for configuring the connector for importing data.

a. Select the data source type.

i. In the Setup  stage of the playbook, select the Select data source type  activity.

▪ Select Standard data sources  if you're working with environments that have direct 
internet access.

Proceed to step 6.c.

▪ Select Air gap data sources  if you're working with restricted environments that don't 
have direct internet access.

ii. Select Continue.

b. Download and run the PowerShell scripts to set up an air gap connection.

Note: 
Before you add an air gap data source, you must configure the air gap solution for the 
Service Graph Connector for SolarWinds  in your high-secure and low-secure servers. 
See Configuring air gap connections for Service Graph Connector for SolarWinds.

i. In the Setup  stage of the playbook, select the Download PowerShell scripts  activity.

The Download PowerShell scripts  activity appears only when you select Air gap data 
sources  as the data source type in step 6.a.

ii. Select Download PowerShell scripts.
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iii. Run the PowerShell scripts.

For more information on configuring an air gap connection, see Configuring air gap 
connections for Service Graph Connector for SolarWinds.

iv. After configuring the air gap connection, select Continue.

c. Create and test a connection.

i. In the Setup  stage of the playbook, select the Create and test connection  activity.

ii. On the form, fill in the fields.

▪ For standard data sources:

Create and test connection form

Field Description

Connection Name Display name for the connection.

Connection URL Connection host name for SolarWinds.

User name User name for SolarWinds  authentication.

Password Password for SolarWinds  authentication.

Use MID server Option to use a MID Server. Select this 
check box.

MID selection Select a MID Server from the list.

This field appears only when the Use MID 
Server  check box is selected.

MID application Select a MID Server application from the 
list.

This field appears only when the Use MID 
Server  check box is selected.

▪ For air gap data sources:

Create and test connection form

Field Description

Connection name Display name for the connection.

Parent directory Path of the SolarWinds  directory where 
the data is stored in your low-secure 
server.

Archive data after retrieval Option to archive data after retrieval.

Archive path [Optional] Folder where the data is to be archived if 
the Archive data after retrieval  check box 
is selected.
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Field Description

MID server Name of the MID Server that you deployed 
in your low-secure server.

See Configure air gap solution for Service 
Graph Connector for SolarWinds in a low-
secure server.

iii. Select Create and test connection.

iv. Once the connection test is complete, select Continue.

d. Configure the properties of the connector to access resources.

i. In the Setup  stage of the playbook, select the Set configuration properties  activity.

▪ Select SAM installed  if a Service & Application Monitor (SAM) module is installed on the 
SolarWinds  instance.

▪ Select NPM installed  if a Network Performance Monitor (NPM) module is installed on 
the SolarWinds  instance.

ii. Select Continue.

e. Configure the import schedule to import data at regular intervals.

i. In the Setup  stage of the playbook, select the Configure import schedule  activity.

ii. Expand the Parent scheduled data import within the Import schedules list, and select the 
SG-Solarwinds Hardware import schedule.

iii. In the Configure import schedule  dialog box, select the Active  check box, and then fill in 
the run schedule and time details.

For more information, see Schedule a data import .

iv. Select Save.

Alternatively, select Execute Now  to execute the import schedule immediately.

v. Select Continue.

f. In the Setup  stage of the playbook, select the Confirm connection creation  activity to verify 
whether the connection was created.

What to do next
Select View all connections  to review the connection details. The configured connection 
appears in the Installed connections list.

Related topics

Service Graph Connector for SolarWinds

CMDB classes targeted in Service Graph Connector for SolarWinds

Accessing the connection details of Service Graph Connector for SolarWinds

Configuring air gap connections for Service Graph Connector for SolarWinds
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Configure Service Graph Connector for SolarWinds

Set up authentication credentials and scheduled jobs to import SolarWinds  data into your 
CMDB.

Before you begin
Important: 
Unless there are configuration issues, use the SGC Central  view in the CMDB Workspace 
to configure the connection for the connector, as the guided setup method is being 
deprecated.

To use this Service Graph Connector, you need a subscription to a Subscription Unit that is 
based in the IT Operations Management  (ITOM) Visibility application or in the ITOM  Discovery 
application. As defined in the section titled "Managed IT Resource Types" in ServiceNow 
Subscription Unit Overview  for your subscription, for managed IT resources that are created 
or modified in the CMDB  by this Service Graph Connector, but that aren’t yet managed by ITOM 
Visibility or ITOM Discovery , these resources will increase Subscription Unit consumption from 
that application. Review your current Subscription Unit consumption within ITOM Visibility or 
ITOM Discovery to ensure available capacity.

Before you start the configuration, navigate to System Definition  > Business Rules, and 
deactivate the ValidateServiceAccountID  business rule.

Air gap connections are available from version 2.5.0 of the Service Graph Connector for 
SolarWinds. You can set up either regular data sources or air gap data sources. Before you set 
up air gap data sources, you must configure the air gap solution for the Service Graph Connector 
for SolarWinds  in your high-secure server and low-secure server. See Configuring air gap 
connections for Service Graph Connector for SolarWinds.

Dependencies and requirements:

• The Integration Commons for CMDB  store app, which is automatically installed.

• The CMDB CI class models store app, which is automatically installed. See CMDB CI Class 
Models store app.

• Discovery Core plugin (com.snc.discovery.core), which is automatically installed by Discovery.

• ITOM Discovery License plugin (com.snc.itom.discovery.license). You must activate this plugin.

• ITOM Licensing plugin (com.snc.itom.license). For more information, see Request Discovery .

• SolarWinds  Orion Platform.

• SolarWinds  Server & Application Monitor and/or Network Performance Monitor.

Roles required:

• To configure the ServiceNow  platform: admin

• To access SolarWinds  data: User with SWIS (SolarWinds  Information Service) access (the 
same as through the Orion website, not database users).

About this task

Note: 
SolarWinds  Integration can work with or without Service & Application Monitor (SAM) and 
Network Performance Monitor (NPM) being installed.
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Procedure

1. Navigate to All  > Service Graph Connectors  > SolarWinds  > Setup.

2. On the Getting started page, select Get Started.

3. Configure your authentication credentials used to connect to the SolarWinds  SWIS API.

a. On the Service Graph Connector for SolarWinds page, in the Configure the connection 
section, select the Configure the authentication credentials used to connect to 
SolarWinds SWIS API  task.

b. For the Configure the authentication credentials used to connect to SolarWinds SWIS API 
task, select Configure.

c. Fill in the fields on the Basic Auth Credentials form.

Basic Auth Credentials form

Field Description

Name Human-readable name for this credential. 
This field is automatically set. You can 
optionally change this setting.

User name SolarWinds  user name.

Note: 
The SolarWinds  user must have 
a role with read privileges to the 
SolarWinds  Information Service API for 
all SolarWinds  data sources that the 
integration can pull data.

Password SolarWinds  password that is stored in the 
database in encrypted form.

Active Option to check whether this credential is 
active.

Credential alias Advanced selection criteria for this 
credential.

Order Order in which credentials are tried. Smaller 
numbers are tried first.

d. Select Update  if required.

e. Set the Configure the authentication credentials used to connect to the SolarWinds SWIS 
API task to complete by selecting Mark as Complete.

4. Configure the SolarWinds  HTTP connection.

a. For the Configure SolarWinds HTTP connection task, select Configure.

b. Review the HTTP(s) Connection form, and fill in the fields as required.
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HTTP(s) Connection form

Field Description

Name Name of the connection. This field is 
automatically set. You can optionally change 
the name.

Use MID server Option to enable the connection to use a 
MID server.

Host Target host value used by the connection. 
This field is automatically set by the 
connection URL.

Credential Credential value used by the connection.

Connection alias Connection alias value with which the 
connection can be referred.

URL builder URL builder that is used to build the 
connection URL.

Mutual authentication Option to enable mutual authentication.

Protocol Underlying protocol used by the connection.

Active Option to activate the HTTP connection.

Domain Domain to which the connection belongs.

Override default port Target port value used by the connection.

Base path Base path for HTTP(S) connection that is 
required but should not be modified.

c. Select Update, if required.

d. Set the Configure SolarWinds HTTP connection task to complete by selecting Mark as 
Complete.

5. Configure the SolarWinds  modules.

a. For the Configure SolarWinds Modules task, select Configure.

b. Update the Value  for the sn_solarwinds_inte.npm_installed  and the 
sn_solarwinds_inte.sam_installed  properties in one of the following ways:

▪ If the respective module is installed on the SolarWinds  instance, then set the fields to true.

▪ If the respective module is not installed on the SolarWinds  instance, then set the fields to 
false.

Note: 
This update changes the API class and the data that is returned from them.

c. Set the Configure SolarWinds Modules task to complete by selecting Mark as Complete.

6. Test the connection.
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a. For the Test the connection task, select Configure.

b. Review the fields on the Data Source form, which are automatically set.

Data Source form

Field Description

Name Unique name for this data source.

Import set table label Label of the table that will be created for this 
data source.

Import set table name Name of the table that will be created for this 
data source.

Type Data storage type of the data to be imported.

Data in single column Data in single column.

Application Application containing this record.

Data stream action The Data Source request action that will be 
invoked to get data.

c. Test the connection by selecting the Test Load 20 Records  related link.

Testing the connection takes a few moments, after which the page refreshes to show the test 
results.

This step tests the SG-Solarwinds Hardware data source, and verifies that data is loaded 
into the staging table. A successful connection for the SG-Solarwinds Hardware data 
source means that all SolarWinds data sources connect successfully, so you do not need to 
individually test all data sources.

The connection is successful if the HTTP Status  is 200. If there is an Error Code  and Error 
Message, the connection failed and further troubleshooting is required.

d. Navigate back to the guided setup, and set the Test the connection task to complete by 
selecting Mark as Complete.

7. Add multiple instances.

Note: 
If you do not need to add multiple instances, you can skip this step.

a. On the Service Graph Connector for SolarWinds page, in the Add Multiple Instances section, 
select the Update Data Source Access  task.

b. For the Update Data Source Access task, select Configure.

c. Select the Data Source [sys_data_source] table.

d. Select the Global  application scope by using the application picker.

e. In the Application Access related list, select the Can create, Can update, and Can delete 
check boxes, if not already selected.

f. Select Update  to close the tab and return to the guided setup.
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g. Modify the application scope again to Service Graph Connector for SolarWinds  by using 
the application picker.

h. Set the Update Data Source Access  task to complete by selecting Mark as Complete.

i. Repeat the steps 7.d  to 7.g  for the Update Scheduled Data Import Access task with the 
Scheduled data import [scheduled_data_set] table and for the Update Value Access task 
with the Value [sys_variable_table] table, and set the tasks to complete by selecting Mark as 
Complete.

8. Clear the cache for the new connection.

a. Select the Clear Cache for Datasource and Import set  task, and then select Configure.

b. Clear the cache by selecting Global  from the Scope menu.

c. Enter the following script.

 
      GlideTableManager.invalidateTable("sys_data_source");
      GlideCacheManager.flushTable("sys_data_source");
 
     
 GlideTableManager.invalidateTable("scheduled_import_set");
      GlideCacheManager.flushTable("scheduled_import_set");
 
     
 GlideTableManager.invalidateTable("sys_variable_value");
      GlideCacheManager.flushTable("sys_variable_value");
 
      GlideTableManager.invalidateTable("sys_db_object");
      GlideCacheManager.flushTable("sys_db_object");

d. Select Run Script.

e. From the Scope menu, select Service Graph Connector for SolarWinds.

f. Set the Clear Cache for Datasource and Import set task to complete by selecting Mark as 
Complete.

9. Add a connection to another SolarWinds  instance.

Note: 
Confirm that the current scope is Service Graph Connector for SolarWinds.

a. Select the Add Another Connection  task, and then select Configure.

b. In the Select Data Source Type section, select either regular data sources or air gap data 
sources.
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▪ To add or edit regular data sources, select Regular Data Sources.

▪ To add or edit air gap data sources, select Airgap Data Sources.

Note: 
Before you add an air gap data source, you must configure the air gap solution for the 
Service Graph Connector for SolarWinds  in your high-secure and low-secure servers. 
See Configuring air gap connections for Service Graph Connector for SolarWinds.

c. Either create or edit a connection.

▪ To create a new connection, select Add Connection.

▪ To edit an existing connection, select Edit.

d. Fill in or edit the fields on the form, as required.

▪ For regular data sources:

Create Connection form

Field Description

Connection Name Display name for the connection.

Connection URL Connection host name for SolarWinds.

User name User name for SolarWinds  authentication.

Password Password for SolarWinds  authentication.

▪ For air gap data sources:

Create Connection form

Field Description

Connection Name Display name for the connection.

MID Server Name of the MID server that you deployed 
in your low-secure server.

See Configure air gap solution for Service 
Graph Connector for SolarWinds in a low-
secure server.

Parent Directory Path of the SolarWinds  directory where the 
data is stored in your low-secure server.

Archive Data After Retrieval Option to archive data after retrieval.

Archive Path [Optional] Folder where the data is to be archived if 
the Archive Data After Retrieval  check box 
is selected.

e. Either add or save the connection.

▪ To add a new connection, select Create Connection.

▪ To save the edits for the existing connection, select Edit Connection.
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f. Navigate back to the guided setup, and select Mark as Complete  to set the Add Another 
Connection task to complete.

g. If required, set up the MID Server for the connection you created.

i. For the Configure Mid Servers task, select Configure.

ii. Select the name of the connection you created.

iii. Select the Use MID server  check box.

iv. Select Update.

v. Set the Configure Mid Servers task to complete by selecting Mark as Complete.

h. If required, configure the connections in the Configure SolarWinds Modules section by 
selecting Configure.

i. When you're finished, close the window, and navigate back to the guided setup.

j. Set the Configure SolarWinds Modules task to complete by selecting Mark as Complete.

k. For the Test New Connections task, select Configure.

i. Select the name of the data source associated with the newly created connection.

ii. Select the Test Load 20 Records  related link.

Note: 
If the displayed completion code is Success, then the sources are validated. But if 
the displayed completion code is Error, then there is an error that you must fix.

iii. Navigate back to the guided setup, and set the Test New Connections task to complete by 
selecting Mark as Complete.

10. Set up scheduled import jobs.

a. On the Service Graph Connector for SolarWinds page, in the Set up scheduled import jobs 
section, select the Configure the scheduled import jobs  task.

b. For the Configure the scheduled import jobs task, select Configure.

c. Review the fields on the Scheduled Data Import form, which are automatically set.

Scheduled Data Import form

Field Description

Name Name of the scheduled job.

Data source Data source record that defines the data to 
import.

Run as Option to run the scheduled job with the 
credentials of the specified user.

Active Option to activate the scheduled job. Select 
this option.
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Field Description

Concurrent Import Function that loads the data from multiple 
import sets. The function then processes 
and transforms the data concurrently.

Partition Method Partition method for the concurrent import 
set.

Partition Size Import set size for early scheduling.

Execute pre-import script Option to run a pre-import script before the 
import is performed.

Execute post-import script Option to run a post-import script after the 
import is performed.

Application Application containing this record.

Run Frequency of running the import.

Conditional Conditions under which this job is executed.

Note: 
All active SolarWinds  scheduled jobs will run in their specified order after the SG-
Solarwinds Hardware scheduled job runs. You can modify the Active  setting for each 
SolarWinds  scheduled job as appropriate for your integration.

d. Select Update  if required, and then select Mark as Complete  to set the Set up scheduled 
import jobs task to complete.

Related topics

Service Graph Connector for SolarWinds

CMDB classes targeted in Service Graph Connector for SolarWinds

Configure Service Graph Connector for SolarWinds using SGC Central

Accessing the connection details of Service Graph Connector for SolarWinds

Configuring air gap connections for Service Graph Connector for SolarWinds

CMDB  classes targeted in Service Graph Connector for SolarWinds

When you complete setting up the connection, you can configure the integration to periodically 
pull data from Solarwinds. The data is saved in tables that extend from the Configuration item 
[cmdb_ci] table.

The following attributes in the Availability Zone [cmdb_ci_availability_zone] table are populated 
by collected data:

Attribute label Attribute name

Name name

Object ID object_id
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Relationships created for Availability Zone

Parent class Relationship type Child class

Availability Zone 
[cmdb_ci_availability_zone]

Contains::Contained by Cloud Subnet 
[cmdb_ci_cloud_subnet]

Availability Zone 
[cmdb_ci_availability_zone]

Contains::Contained by Cloud Network 
[cmdb_ci_network]

The following attributes in the Cloud Key Pair [cmdb_ci_cloud_key_pair] table are populated by 
collected data:

Attribute label Attribute name

Object ID object_id

Name name

Relationship created for Cloud Key Pair

Parent class Relationship type Child class

Cloud Key Pair 
[cmdb_ci_cloud_key_pair]

Hosted on::Hosts Logical Datacenter 
[cmdb_ci_logical_datacenter]

The following attributes in the Cloud Network [cmdb_ci_network] table are populated by 
collected data:

Attribute label Attribute name

Name name

Object ID object_id

Relationships created for Cloud Network

Parent class Relationship type Child class

Cloud Network 
[cmdb_ci_network]

Contains::Contained by Cloud Subnet 
[cmdb_ci_cloud_subnet]

Cloud Network 
[cmdb_ci_network]

Hosted on::Hosts Logical Datacenter 
[cmdb_ci_logical_datacenter]

The following attributes in the Cloud Service Account [cmdb_ci_cloud_service_account] table are 
populated by collected data:

Attribute label Attribute name

Account Id account_id

Name name

Object ID object_id

Datacenter Type datacenter_type
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The following attributes in the Cloud Subnet [cmdb_ci_cloud_subnet] table are populated by 
collected data:

Attribute label Attribute name

Name name

Object ID object_id

The following attributes in the Computer [cmdb_ci_computer] table are populated by collected 
data:

Attribute label Attribute name

CPU core count cpu_core_count

CPU core thread cpu_core_thread

CPU name cpu_name

CPU speed (MHz) cpu_speed

CPU manufacturer cpu_manufacturer

Is Virtual virtual

Relationships created for Computer

Parent class Relationship type Child class

Computer 
[cmdb_ci_computer]

Virtualized by::Virtualizes Virtual Machine Instance 
[cmdb_ci_vm_instance]

Computer 
[cmdb_ci_computer]

Contains::Contained by Disk [cmdb_ci_disk]

The following attributes in the Disk [cmdb_ci_disk] table are populated by collected data:

Attribute label Attribute name

Model ID model_id

Device ID device_id

Name name

Disk space (GB) disk_space

Free disk space (GB) free_space

Size size

Size bytes size_bytes

Computer computer

Manufacturer manufacturer

Volume serial number volume_serial_number
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Relationship created for Disk

Parent class Relationship type Child class

Disk [cmdb_ci_disk] Reference Computer 
[cmdb_ci_computer]

The following attributes in the Hardware [cmdb_ci_hardware] table are populated by collected 
data:

Attribute label Attribute name

Model ID model_id

Name name

DNS Domain dns_domain

Manufacturer manufacturer

Serial number serial_number

Class sys_class_name

Default Gateway default_gateway

Fully qualified domain name fqdn

Relationships created for Hardware

Parent class Relationship type Child class

Hardware [cmdb_ci_hardware] Owns::Owned by IP Address 
[cmdb_ci_ip_address]

Hardware [cmdb_ci_hardware] Owns::Owned by Network Adapter 
[cmdb_ci_network_adapter]

The following attributes in the Hardware Type [cmdb_ci_compute_template] table are populated 
by collected data:

Attribute label Attribute name

Name name

Object ID object_id

Relationship created for Hardware Type

Parent class Relationship type Child class

Hardware Type 
[cmdb_ci_compute_template]

Hosed on::Hosts Logical Datacenter 
[cmdb_ci_logical_datacenter]

The following attributes in the IIS Virtual Directory [cmdb_ci_iisdirectory] table are populated by 
collected data:
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Attribute label Attribute name

Alias alias

Installation directory install_directory

Name name

Relationship created for IIS Virtual Directory

Parent class Relationship type Child class

IIS Virtual Directory 
[cmdb_ci_iisdirectory]

Runs on::Runs Hardware [cmdb_ci_hardware]

The following attributes in the Image [cmdb_ci_os_template] table are populated by collected 
data:

Attribute label Attribute name

Name name

Object ID object_id

Relationship created for Image

Parent class Relationship type Child class

Image [cmdb_ci_os_template] Hosted on::Hosts Logical Datacenter 
[cmdb_ci_logical_datacenter]

The following attributes in the IP Address [cmdb_ci_ip_address] table are populated by collected 
data:

Attribute label Attribute name

IP Address ip_address

Netmask netmask

IP version ip_version

Nic nic

Relationship created for IP Address

Parent class Relationship type Child class

IP Address 
[cmdb_ci_ip_address]

Reference Network Adapter 
[cmdb_ci_network_adapter]

The following attributes in the Logical Datacenter [cmdb_ci_logical_datacenter] table are 
populated by collected data:
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Attribute label Attribute name

Name name

Region region

Class sys_class_name

Relationships created for Logical Datacenter

Parent class Relationship type Child class

Logical Datacenter 
[cmdb_ci_logical_datacenter]

Contains::Contained by Availability Zone 
[cmdb_ci_availability_zone]

Logical Datacenter 
[cmdb_ci_logical_datacenter]

Hosted on::Hosts Cloud Service Account 
[cmdb_ci_cloud_service_account]

The following attributes in the Microsoft iis Web Server [cmdb_ci_microsoft_iis_web_server] table 
are populated by collected data:

Attribute label Attribute name

Name name

Running process command running_process_command

Version version

Operational status operational_status

PID pid

Install Status install_status

Type type

Relationships created for Microsoft iis Web Server

Parent class Relationship type Child class

Microsoft iis Web Server 
[cmdb_ci_microsoft_iis_web_server]

Contains::Contained by IIS Virtual Directory 
[cmdb_ci_iisdirectory]

Microsoft iis Web Server 
[cmdb_ci_microsoft_iis_web_server]

Runs on::Runs Hardware [cmdb_ci_hardware]

The following attributes in the MS SQL DataBase [cmdb_ci_db_mssql_database] table are 
populated by collected data:

Attribute label Attribute name

Data Base database

Name name
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Relationship created for MS SQL DataBase

Parent class Relationship type Child class

MS SQL DataBase 
[cmdb_ci_db_mssql_database]

Runs on::Runs Hardware [cmdb_ci_hardware]

The following attributes in the MSFT SQL Instance [cmdb_ci_db_mssql_instance] table are 
populated by collected data:

Attribute label Attribute name

Edition edition

Instance Name instance_name

Name name

Operational status operational_status

Service pack service_pack

Install Status install_status

Relationships created for MSFT SQL Instance

Parent class Relationship type Child class

MSFT SQL Instance 
[cmdb_ci_db_mssql_instance]

Runs on::Runs Hardware [cmdb_ci_hardware]

MSFT SQL Instance 
[cmdb_ci_db_mssql_instance]

Contains::Contained by MS SQL DataBase 
[cmdb_ci_db_mssql_database]

The following attributes in the Network Adapter [cmdb_ci_network_adapter] table are populated 
by collected data:

Attribute label Attribute name

DHCP Enabled dhcp_enabled

Netmask netmask

Configuration Item cmdb_ci

Mac manufacturer mac_manufacturer

MAC Address mac_address

Name name

Relationship created for Network Adapter

Parent class Relationship type Child class

Network Adapter 
[cmdb_ci_network_adapter]

Reference Hardware [cmdb_ci_hardware]

The following attributes in the Serial Number [cmdb_serial_number] table are populated by 
collected data:
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Attribute label Attribute name

Serial Number serial_number

Serial Number Type serial_number_type

Valid valid

Relationship created for Serial Number

Parent class Relationship type Child class

Serial Number 
[cmdb_serial_number]

Reference Hardware [cmdb_ci_hardware]

The following attributes in the Software [cmdb_ci_spkg] table are populated by collected data:

Attribute label Attribute name

Key key

Name name

Version version

Manufacturer manufacturer

Relationship created for Software

Parent class Relationship type Child class

Software [cmdb_ci_spkg] Reference Software Instance 
[cmdb_software_instance]

The following attributes in the Software Instance [cmdb_software_instance] table are populated 
by collected data:

Attribute label Attribute name

Install date install_date

Installed on installed_on

Name name

Relationships created for Software Instance

Parent class Relationship type Child class

Software Instance 
[cmdb_software_instance]

Reference Computer 
[cmdb_ci_computer]

Software Instance 
[cmdb_software_instance]

Reference Hardware [cmdb_ci_hardware]

The following attributes in the Storage Volume [cmdb_ci_storage_volume] table are populated by 
collected data:
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Attribute label Attribute name

Object ID object_id

Volume ID volume_id

Name name

Size bytes size_bytes

Relationship created for Storage Volume

Parent class Relationship type Child class

Storage Volume 
[cmdb_ci_storage_volume]

Hosted on::Hosts Logical Datacenter 
[cmdb_ci_logical_datacenter]

The following attributes in the Virtual Machine Instance [cmdb_ci_vm_instance] table are 
populated by collected data:

Attribute label Attribute name

Name name

Object ID object_id

IP Address ip_address

State state

Relationships created for Virtual Machine Instance

Parent class Relationship type Child class

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Hosted on::Hosts Logical Datacenter 
[cmdb_ci_logical_datacenter]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Provisioned From::Provisioned Image [cmdb_ci_os_template]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Provisioned From::Provisioned Hardware Type 
[cmdb_ci_compute_template]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Use End Point To::Use End 
Point From

Storage Volume 
[cmdb_ci_storage_volume]

Related topics

Service Graph Connector for SolarWinds

Accessing the connection details of Service Graph Connector for SolarWinds

You can access the connection details of the Service Graph Connector for SolarWinds  in a single 
view using the common connection framework (CCF) included within the Integration Commons 
for CMDB  (sn_cmdb_int_util) store app.

With the CCF, you can access all the connections used by the Service Graph Connector for 
SolarWinds. The connection details include the connection alias, connection properties, data 
sources, and scheduled data imports associated with a connection. You can also test the 
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connection. For more information, see Accessing the connection details of Service Graph 
Connectors.

Access the details of a SolarWinds  connection

Access the details of a SolarWinds  connection configured for the Service Graph Connector for 
SolarWinds.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Service Graph Connectors  > SolarWinds  > Connections.

2. From the Name  column of the Service Graph Connections list, select a connection.

3. On the Service Graph Connections page, view the connection details such as the connection 
name, alias, and data sources.

4. Select a related list to view further details of the connection.

5. Optional:  Select the Test Connection  related link to test the connection.

Configuring air gap connections for Service Graph Connector for SolarWinds

Air gap connections for the Service Graph Connector for SolarWinds  enable safe and controlled 
data transfer without compromising security.​

An air gap is a security measure that involves isolating a computer or network and preventing 
it from establishing an external connection. Air-gapped networks keep critical systems secure 
by isolating them from external connections to protect the systems from cyber threats. Air gap 
connections for the Service Graph Connector for SolarWinds  facilitate controlled data exchange 
between the air-gapped networks and external systems while maintaining the integrity of the air-
gapped environment.

Air gap connections are available from version 2.5.0 of the Service Graph Connector for 
SolarWinds. You can add either regular data sources or air gap data sources during the guided 
setup. To access the guided setup, see Configure Service Graph Connector for SolarWinds.

Perform the following sequence of tasks to configure the air gap solution before you add air gap 
data sources during the guided setup:

1. Configure air gap solution for Service Graph Connector for SolarWinds in a high-secure server

2. Configure air gap solution for Service Graph Connector for SolarWinds in a low-secure server

3. Configure air gap solution for Service Graph Connector for SolarWinds in a ServiceNow 
instance

4. Perform a test data load for the air gap solution for Service Graph Connector for SolarWinds

5. Perform a full data load for the air gap solution for Service Graph Connector for SolarWinds

Configure air gap solution for Service Graph Connector for SolarWinds  in a high-secure server

Configure the air gap solution for the Service Graph Connector for SolarWinds  in your high-
secure server.

Before you begin
Role required: admin
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Procedure

1. Navigate to All  > Service Graph Connectors  > SolarWinds  > Setup  > Add Multiple Instances  > 
Add Another Connection.

2. Download the SgSolarWindsHighSecureSetup.ps1  and 
GetSolarWindsData.ps1  PowerShell scripts from the link provided in the Add Another 
Connection section.

3. Log on to your high-secure server.

4. Create a SolarWinds  directory.

All the configurations required for the air gap solution are created in the SolarWinds  directory.

5. Copy the GetSolarWindsData.ps1  and SgSolarWindsHighSecureSetup.ps1 
PowerShell scripts that you downloaded in step 2  to the SolarWinds  directory.

6. Start a PowerShell session, and run the SgSolarWindsHighSecureSetup.ps1  script to 
generate the JSON configuration file that is used by the GetSolarWindsData.ps1  script.

a. At the prompt, enter the path for the SolarWinds  directory that you created in step 4.

b. Enter a name for the configuration file, or press the Return key to accept the default value.

c. Enter the values for the global properties, or press the Return key to accept the default 
values.

▪ npmInstalled: Set the value to true  if the module is installed on the SolarWinds 
instance. Set the value to false  if the module isn't installed on the SolarWinds  instance.

▪ samInstalled: Set the value to true  if the module is installed on the SolarWinds 
instance. Set the value to false  if the module isn't installed on the SolarWinds  instance.

▪ pageSize: Enter the number of records to be fetched in a SolarWinds  API call.

▪ endpoint: Update the Host  field with the host name for your SolarWinds  instance.

▪ port: Specify the port on which the SolarWinds  instance allows API calls.

▪ credentialsPath: Specify the location to store the SolarWinds  credentials XML file.

▪ logDirectory: Specify the location to store the log file from the 
GetSolarWindsData.ps1  script.

d. Specify names for the data source data directories, or press the Return key to accept the 
default values.

The directories are created if they don’t already exist.

e. Enter the SolarWinds  credentials.

Note: 
You can either use Windows credential manager to store the user name and 
password, or implement your own mechanism for storing the credentials. The 
GetSolarWindsData.ps1  script must have access to the credentials to trigger 
REST calls.

f. Exit the PowerShell session.
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7. Provide write and delete permissions for the SolarWinds  directory and the child directories.

You must provide delete permissions for old records to be cleaned up.

Related topics

Configure air gap solution for Service Graph Connector for SolarWinds in a low-secure server

Configure air gap solution for Service Graph Connector for SolarWinds  in a low-secure server

Configure the air gap solution for the Service Graph Connector for SolarWinds  in your low-secure 
server after you finish the configuration in your high-secure server.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Service Graph Connectors  > SolarWinds  > Setup  > Add Multiple Instances  > 
Add Another Connection.

2. Download the SgSolarWindsLowSecureSetup.ps1  PowerShell script from the link 
provided in the Add Another Connection section.

3. Log on to your low-secure server.

4. Create a SolarWinds  directory.

All the configurations required for the air gap solution are created in the SolarWinds  directory.

5. Copy the SgSolarWindsLowSecureSetup.ps1  PowerShell script that you downloaded 
in step 2  to the SolarWinds  directory.

6. Start a PowerShell session, and run the SgSolarWindsLowSecureSetup.ps1  script.

a. At the prompt, enter the path for the SolarWinds  directory that you created in step 4.

b. Specify names for the data source data directories, or press the Return key to accept the 
default values.

The directories are created if they don’t already exist.

c. Exit the PowerShell session.

7. Provide read and delete permissions for the SolarWinds  directory.

Related topics

Configure air gap solution for Service Graph Connector for SolarWinds in a ServiceNow 
instance

Configure air gap solution for Service Graph Connector for SolarWinds  in a ServiceNow 
instance

Configure the air gap solution for the Service Graph Connector for SolarWinds  in your 
ServiceNow  instance after you finish the configuration in your high-secure and low-secure 
servers.

Before you begin
Role required: admin
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Procedure

1. Navigate to All  > System Definition  > Plugins, and download the ServiceNow 
IntegrationHub Action Step – PowerShell  plugin.

2. Navigate to All  > Service Graph Connectors  > SolarWinds  > Setup  > Add Multiple Instances  > 
Add Another Connection.

3. Select the Add Another Connection  task, and then select Configure.

4. In the Select Data Source Type section, select Airgap Data Sources, and then select Add 
Connection.

5. Fill in the fields on the Create Connection form.

Create Connection form

Field Description

Connection Name Display name for the connection.

MID Server Name of the MID Server that you deployed in 
your low-secure server.

You can obtain the sys_id  of the MID 
Server from the ecc_agent table.

Parent Directory Path of the SolarWinds  directory where the 
data is stored in your low-secure server.

See Configure air gap solution for Service 
Graph Connector for SolarWinds in a low-
secure server.

Archive Data After Retrieval Option to archive data after retrieval.

Archive Path [Optional] Folder where the data is to be archived if the 
Archive Data After Retrieval  check box is 
selected.

6. Select Create Connection.

Related topics

Perform a test data load for the air gap solution for Service Graph Connector for SolarWinds

Perform a test data load for the air gap solution for Service Graph Connector for SolarWinds

After you configure the air gap solution for the Service Graph Connector for SolarWinds, test 
whether the SolarWinds  endpoint is accessible from the high-secure server.

Before you begin
Role required: admin

Procedure

1. Navigate to the SolarWinds  directory in your high-secure server.

2. Run the .\GetSolarWindsData.ps1 -configFilePath CONFIG_PATH  script, 
where CONFIG_PATH  is the location of the JSON configuration file that is generated by the 
setup script.
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The script accesses the SolarWinds  Hardware API, and creates a sample file in the Hardware 
directory and a log file in the Logs directory.

◦ If the test data load is successful, the log file contains the Test Load status 
SUCCESS!  message.

◦ If the test data load fails, the log file contains the Error occurred while 
processing hardware StatusCode 403  message.

If the test data load fails, verify the SolarWinds  user credentials and ensure that the user 
has the required permissions to pull the data from SolarWinds. If the credentials need to be 
updated, you must run the SgSolarWindsHighSecureSetup.ps1  PowerShell script 
again. See Configure air gap solution for Service Graph Connector for SolarWinds in a high-
secure server.

Related topics

Perform a full data load for the air gap solution for Service Graph Connector for SolarWinds

Perform a full data load for the air gap solution for Service Graph Connector for SolarWinds

After you verify that the test data load for the air gap solution for the Service Graph Connector for 
SolarWinds  is successful, you can perform a full data load.

Before you begin
Role required: admin

Procedure

1. Navigate to the SolarWinds  directory in your high-secure server.

2. Run the .\GetSolarWindsdata.ps1 -completeLoad $true 
-configFilePath CONFIG_PATH  script, where CONFIG_PATH  is the location of the 
JSON configuration file that is generated by the setup script.

By default, the existing files in the data source data directories are deleted each time the 
.\GetSolarWindsdata.ps1 -completeLoad $true -configFilePath 
CONFIG_PATH  script is run. You can add the -clean $false  parameter to the script if you 
want to retain the existing files.

The script fetches data from all the SolarWinds  APIs, and stores the data in the respective 
directories.

3. After the data is loaded in your high-secure server, transfer the data to your low-secure server 
using a method of your choice, such as SFTP.

4. Verify that the data is loaded in your low-secure server.

5. Set the full data load job (using the .\GetSolarWindsdata.ps1 -completeLoad 
$true -configFilePath CONFIG_PATH  script) to run on a schedule based on that of 
the Scheduled Import Job on your Service Graph Connector for SolarWinds  instance.

6. Set the data transfer job (from your high-secure server to your low-secure server) on a 
schedule based on that of the Scheduled Import Job on your Service Graph Connector for 
SolarWinds  instance.

7. Test the air gap connection in your ServiceNow  instance.

a. Navigate to All  > Service Graph Connectors  > SolarWinds  > Connections.

b. Select the air gap connection that you created.
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c. Select the Test Connection  related link.
When the connection is successful, the Status  field is set to Success. If the connection 
fails, follow the suggestions for remediation.

Service Graph Connector for Tanium

Use the Service Graph Connector for Tanium  to bring in hardware, software, and software usage 
data from a Tanium  environment into your ServiceNow  instance.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Supported versions

Versions

Tanium ServiceNow

• Tanium  1.9 or later versions for hardware and software

• Tanium  1.17 or later versions for software usage

• Washington DC

• Xanadu

• Yokohama

Important information for upgrading Service Graph Connector for Tanium

Tanium  Platform 7.6.2 or later versions support token-based authorization only. After you have 
installed the latest version of the Service Graph Connector for Tanium, verify the following 
configurations to use Tanium  Platform 7.6.2 or later versions in your on-premise setups:

• For a single instance, reconfigure the authentication type of an existing connection to use 
token-based authorization.

• For multiple instances, deactivate the existing scheduled jobs for previously configured 
instances that used basic authorization, and then create and configure new instances to use 
token-based authorization.

Configuring a connection for the connector

You can configure a connection for the connector by using the SGC Central  view in the CMDB 
Workspace. The view enables you to discover and install connectors, and then effectively 
manage the full life cycle of creating, editing, monitoring, and debugging connections. To 
configure the connector using SGC Central, see Configure Service Graph Connector for Tanium 
using SGC Central.

Important: 
Unless there are configuration issues, use the SGC Central  view in the CMDB Workspace 
to configure the connection for the connector, as the guided setup method is being 
deprecated.
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CMDB integrations dashboard

The Integration Commons for CMDB  store app provides a dashboard with a central view of the 
status, processing results, and processing errors of all installed integrations. You can see metrics 
for all integration runs. You can filter the view to a specific CMDB  integration, a specific time 
duration, or a specific integration run. For more details about monitoring Tanium  integrations in 
the CMDB  Integrations Dashboard, see Using the CMDB Integrations Dashboard.

Data mapping

Data from the Tanium  data sources is mapped and transformed into the ServiceNow  CMDB 
Configuration Item (CI) class definitions using the Robust Transform Engine (RTE). Data is 
inserted into the ServiceNow  CMDB  using the Identification and Reconciliation Engine (IRE).

The following table describes the data sources, the staging tables, and the target tables 
including CMDB  CI and non-CMDB  CI classes for the Tanium  application.

Data mapping for Tanium

Data source Staging table Target tables
Resource 
types

SG-Tanium 
Applications

SG-Tanium Applications 
[sn_tanium_integ_sg_tanium_applications] Application

Running Process

TCP

Applications

SG-Tanium 
Hardware 
and 
Software

SG Tanium Import 
[sn_tanium_integ_sg_tanium_import] Computer

File System

Disk

IP Address

When the Software 
Asset Management 
(SAM) application 
isn't installed:

Software

Software Instance

When the SAM 
application is 
installed:

Software Installation

Server and 
software

SG-Tanium 
Usage

SG Tanium Usage Import 
[sn_tanium_integ_sg_tanium_usage_import] Software Usage 

[samp_sw_usage]

None
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Data mapping for Tanium  (continued)

Data source Staging table Target tables
Resource 
types

SG-Tanium 
Remove 
Software

Integration Commons Remove Record 
[sn_cmdb_int_util_remove_record] None

None

Note: 

• The SG-Tanium Usage data source is available only when the Software Asset 
Management Professional plugin (com.snc.samp) plugin is activated on your ServiceNow 
instance. See Request Software Asset Management .

• The SG-Tanium Remove Software data source creates import sets and uses the transform 
map-based method for removing any target records for software data that weren't 
updated in the last delta query check. See Managing CMDB data deletion.

• Starting with the Service Graph Connector for Tanium  1.8.0 release, a buffer time is added 
for software removal when the buffer_days_from_last_scan_for_hardware 
system property is enabled. When this system property is enabled, the software 
removal candidate is removed only if the last scan time of the hardware on 
which the software removal candidate is installed is earlier than the last 
success import time + buffer time. To enable this property, set the value of the 
buffer_days_from_last_scan_for_hardware  system property to a non-zero 
numeral value according to the number of days of buffer that you require. To disable this 
property, set the value to 0.

You can use the IntegrationHub ETL app to view the data maps. See IntegrationHub ETL  for more 
information.

Additional resource

How do I configure the Tanium Service Graph Connector?  article on the ServiceNow 
Community  site

Related topics

Service Graph Connectors

Configure Service Graph Connector for Tanium  using SGC Central

Set up scheduled import jobs to pull in Tanium  data into your Configuration Management 
Database (CMDB).

Before you begin
Install Service Graph Connector for Tanium  version 1.7.0 or later from the ServiceNow Store. For 
ServiceNow Store  installation steps, see Install a ServiceNow Store application .

Role required: cmdb_inst_admin or admin

About this task
The playbook experience for onboarding connectors is activated with SGC Central  in the CMDB 
Workspace. To configure the SGC Central  application, see Configuring SGC Central  and for more 
information on how to interact with a playbook, see Interact with Playbook .
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Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the CMDB Workspace, select SGC Central.

3. On the Overview page, select Create connection.

Tip: 
Alternatively, you can select Create connection  on the All connections page.

4. On the Create connection window, select the Tanium  connector type, and then select Create 
connection.

5. Complete the initial prerequisites when setting up a connection for the first time using a 
connector.

Note: 
This step is required only during the first-time setup. See Perform initial setup tasks when 
creating a connection in SGC Central.

6. Complete the prerequisites for setting up the Tanium  environment.

a. Create a custom view on your Tanium  instance.

i. In the Prerequisites  stage of the playbook, select the Create custom view  activity.

ii. Create a custom view on your Tanium  instance to be used in the Select view  activity later 
by referring to the Tanium Asset User Guide for Cloud .

Note: 
Copy the unmodifiable ServiceNow (reserved)  view from the Tanium  instance to 
create the custom view.

iii. After creating a view, select the I have created a custom view for this connection 
according to the instructions  check box.

iv. After completing the Select view  activity, select Continue.

7. Determine the type of authentication for the Tanium  connection.

a. In the Setup  stage of the playbook, select the Select alias template  activity.
If needed, expand the Setup  stage to select an activity.

b. Select an alias template for the connection.

▪ Basic authentication: Select when using Basic authentication that grants access to the 
Tanium  data.

▪ Token-based authentication: Select when using an authentication token for the Tanium 
API to grants access to the Tanium  data.

c. Select Continue.

8. Enter connection details and test the API connection for importing Tanium  data.
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a. In the Setup  stage of the playbook, select the Configure and test connection  activity.

b. On the form, fill in the fields.

Create and test connection form

Field Description

Connection name Name to identify the Tanium  connection 
record.

Host name Base URL or IP address of the Tanium  server.

Username Tanium  account username that is used to 
authenticate the connection request.

This field appears only when the Basic 
authentication  alias template was selected 
in the Select alias template  activity.

Password Password associated with the user name 
required for authenticating requests.

This field appears only when the Basic 
authentication  alias template was selected 
in the Select alias template  activity.

Token Authentication token for the Tanium  API that 
grants access to the Tanium  data.

This field appears only when the Token-
based authentication  alias template was 
selected in the Select alias template 
activity.

Use MID Server Option to use a MID Server.

Note: 
Use of a MID Server is optional.

MID selection Name of the MID Server used by the 
connector.

This field appears only when the Use MID 
Server  check box is selected.

c. Select Update and test connection.

d. Once the connection test is complete, select Continue.

9. Select the view created on your Tanium  instance.
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a. In the Setup  stage of the playbook, select the Select view  activity.

b. In the View  field, select the custom view you created on the Tanium  instance in the 
Prerequisites activity.

c. Select Continue.

10. Configure the import schedule to import data at regular intervals.

a. In the Setup  stage of the playbook, select the Configure import schedule  activity.

b. Expand the Parent scheduled data import within the Import schedules list to select the 
Connection name  - SG-Tanium Usage  import schedule.

c. In the Configure import schedule  dialog box, select the Active  check box, and then fill in the 
run schedule and time details.

For more information, see Schedule a data import .

d. Select Save.
Alternatively, select Execute Now  to execute the import schedule immediately.

e. Repeat steps 10.b  to 10.d  for the Connection name  - SG-Tanium Hardware and 
Software  parent import schedule.

f. Select Continue.

11. In the Setup  stage of the playbook, select the Confirm connection creation  activity to verify 
whether the connection was created.

What to do next
Select View all connections  to review the connection details. The configured connection 
appears in the Installed connections list.

Related topics

Service Graph Connector for Tanium

CMDB classes targeted in Service Graph Connector for Tanium

Accessing the connection details of Service Graph Connector for Tanium

Configure Service Graph Connector for Tanium  using the guided setup

Set up scheduled import jobs to pull in data from Tanium  into your Configuration Management 
Database (CMDB).

Before you begin
Important: 
Unless there are configuration issues, use the SGC Central  view in the CMDB Workspace 
to configure the connection for the connector, as the guided setup method is being 
deprecated.

To use this Service Graph Connector, you need a subscription to a Subscription Unit that is 
based in the IT Operations Management  (ITOM) Visibility application or in the ITOM  Discovery 
application. As defined in the section titled "Managed IT Resource Types" in ServiceNow 
Subscription Unit Overview  for your subscription, for managed IT resources that are created 
or modified in the CMDB  by this Service Graph Connector, but that aren’t yet managed by ITOM 
Visibility or ITOM Discovery , these resources will increase Subscription Unit consumption from 
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that application. Review your current Subscription Unit consumption within ITOM Visibility or 
ITOM Discovery to ensure available capacity.

Dependencies and requirements:

• The Integration Commons for CMDB  store app, which is automatically installed.

• The CMDB CI class models store app, which is automatically installed. See CMDB CI Class 
Models store app.

• The Datastream Action plugin (com.glide.hub.action_type.datastream), which is automatically 
installed.

Note: 
If you have an earlier version of the Service Graph Connector for Tanium, then do not 
migrate data from the old connector. You must uninstall the previous version and run the 
new integration.

Role required: admin

About this task
For more information on the Service Graph Connector for Tanium  setup, see How do I configure 
the Tanium Service Graph Connector?  article on the ServiceNow Community  site.

Procedure

1. Ensure that the application scope is set to the Service Graph Connector for Tanium  application 
by using the application picker.
For more information, see Application picker .

2. Navigate to All  > Service Graph Connectors  > Tanium  > Setup.

3. On the Getting started page, select Get Started.

4. Configure the authentication credentials and HTTP connection.

a. On the Service Graph Connector for Tanium  page, in the Configure the Connection and 
Credentials section, select Set authentication type.

b. For the Set authentication type  task, select Configure.

c. Specify the system property details for the authentication type.

i. In the Value  field, enable either token-based authentication or basic authentication.

▪ To enable the basic authorization, enter basic.

▪ To enable the token-based authorization, enter token.

Note: 
Tanium  Platform 7.6.2 supports only token-based authorization for an on-premise 
setup. To use Tanium  Platform 7.6.2 or later versions, enable the token-based 
authorization type and enter the details for the token-based authorization in the next 
step.

ii. Select Update.

iii. Set the Set authentication type  task to complete by selecting Mark as Complete.

d. Configure the connection based on the authentication type.
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i. For the basic authorization type:

1. For the Configure the Basic auth Credentials task, select Configure.

Note: 
The Configure the Basic auth Credentials task appears only when you have 
specified basic  as the value in the step 4.c.i.

2. Select Edit  for Basic authentication  within the sn_tanium_integ scope.

3. In the Connection Information section of the Edit Connection window, fill in the fields.

Connection Information

Field Description

Connection name Name to identify the Tanium  connection 
record.

Token-based authentication  is 
the default credential alias name and is 
read-only.

Host name Base URL or IP address of the Tanium 
server.

Note: 
This field is automatically set to the 
URL to connect to the application. 
Leave the field value as is.

4. (Optional) If a MID Server is required for the Tanium  server connection, select the Use 
MID Server  check box. Then, select the MID Server-related fields accordingly.

5. In the Credential Information section, enter the Tanium  account username in the 
Username  field and the password in the Password  field.

6. Select Edit connection.

7. Return to the guided setup page.

8. Set the Configure the Basic auth Credentials task to complete by selecting Mark as 
Complete.

ii. For the token-based authorization type:

1. For the Configure the Token auth Credentials task, select Configure.

Note: 
The Configure the Token auth Credentials  task appears only when you have 
specified token  as the value in the step 4.c.i.

2. Select Edit  for Token-based authentication  within the sn_tanium_integ scope.

3. In the Connection Information section of the Edit Connection window, fill in the fields.
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Connection Information

Field Description

Connection name Name to identify the Tanium  connection 
record.

Token-based authentication  is 
the default credential alias name and is 
read-only.

Host name Tanium  base URL or IP address.

Note: 
This field is automatically set to the 
URL to connect to the application. 
Leave the field value as is.

4. (Optional) If a MID Server is required for the Tanium  server connection, select the Use 
MID Server  check box. Then, select the MID Server-related fields accordingly.

5. In the Credential Information section of the Edit Connection window, enter the 
authentication token for the Tanium  API in the Token  field to grants access to Tanium 
data.

6. Select Edit connection.

7. Return to the guided setup page.

8. Set the Configure the Token auth Credentials  task to complete by selecting Mark as 
Complete.

e. Test the connection.

i. For the Test connection  task, select Configure.

ii. Select the Test Connection  related link to start the testing process.

iii. When the Status  field is set to Success, return to the guided setup page.

Note: 
If any of the tests have errors, follow the suggestions for remediation.

iv. Set the Test the connection  task to complete by selecting Mark as Complete.

f. Create a custom view.

Note: 
The integration depends on a custom view from Tanium.

i. Configure the view on your Tanium  instance.

1. On your Tanium  instance, navigate to Modules  > Asset.

2. Select Views.

3. If you have not done so already, create the ServiceNow (reserved) view by selecting 
Create View  > Create ServiceNow view.
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Note: 
By default, the ServiceNow (reserved) view is non-editable.

4. Create a copy of the view to edit it.

5. Edit the copy.

a. Add all fields from the SIU Product Usage  bucket.

b. Add Asset  to the Last Seen  field.

c. Add Network Adapter  to the Model  field.

6. Save the view.

ii. Select the view on your ServiceNow  instance.

1. In the guided setup, for the Configure the View  task, select Configure.

2. In the ServiceNow  instance, select the view you created in step 4.f.i.

3. Select Set View.

4. Set the Configure the View  task to complete by selecting Mark as Complete.

g. In the ADM setup instruction section, ignore the instructions as application dependency 
mapping is not supported currently.

5. Configure the Tanium  scheduled jobs.

a. For the Configure the Scheduled Import  task, select Configure.

b. Select the scheduled job that you want to activate.

c. On the Scheduled Data Import form, verify the field values for a scheduled job and select the 
Active  check box to activate the scheduled job.

Note: 
When using a token-based authentication, the user you specify in the Run as  field for a 
scheduled job must have the connection_admin role.

For more information, see Schedule a data import .

d. Select Update.

e. Repeat the steps 5.b  to 5.d  for each scheduled job for data import.

f. Set the Configure the Scheduled Import  task to complete by selecting Mark as Complete.

6. Optional:  Add multiple instances.

Note: 
If you don't need to add multiple instances, you can skip this step.

a. On the Service Graph Connector for Tanium page, in the Add Multiple Icons section, select 
the Update Data Source Access  task.

b. On the next page, in the Update Data Source Access section, select Configure.
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c. Select the Data Source [sys_data_source] table.

d. Select the Global  application scope by using the application picker.

e. In the Application Access related list, select the Can create, Can update, and Can delete 
check boxes, if not already selected.

f. Select Update  to close the tab and return to the guided setup.

g. Modify the application scope again to Service Graph Connector for Tanium  by using the 
application picker.

h. Set the Update Data Source Access task to complete by selecting Mark as Complete.

i. Repeat the steps 6.d  to 6.g  for the Update Scheduled data import access task with the 
Scheduled data import [scheduled_data_set] table and set the task to complete by selecting 
Mark as Complete.

a. Clear the cache for the new connection.

i. For the Clear Cache for Datasource and Import set  task, select Configure.

ii. In the Run script  text box of the background script page, enter the following script:

GlideTableManager.invalidateTable("sys_data_source");
      GlideCacheManager.flushTable("sys_data_source");
 
     
 GlideTableManager.invalidateTable("scheduled_import_set");
      GlideCacheManager.flushTable("scheduled_import_set");
 
      GlideTableManager.invalidateTable("sys_db_object");
      GlideCacheManager.flushTable("sys_db_object");

iii. Select Run Script  to run the background script in the global  scope.

The script may take several minutes to execute.

iv. After the script is executed, select Close.

v. From the application picker, select the Service Graph Connector for Tanium  application.

vi. Set the Clear Cache for Datasource and Import set  task to complete by selecting Mark as 
complete.

b. Add a basic authorization connection to another Tanium instance.

Note: 
Tanium  Platform 7.6.2 supports only token-based authorization for an on-premise setup. 
To use Tanium  Platform 7.6.2 or later versions, use the token-based authorization.

i. For the Add Another Basic Auth Connection  task, select Configure.

ii. To create a new connection, select Add Connection.

iii. Enter the connection details on the Create Connection form.

iv. Select Create Connection.

v. Navigate back to the guided setup and set the Add Another Basic Auth Connection  task to 
complete by selecting Mark as Complete.

c. Add a token-based authorization connection to another Tanium instance.
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i. For the Add Another Token Auth Connection  task, select Configure.

ii. To create a new connection, select Add Connection.

iii. Enter the connection details on the Create Connection form.

iv. Select Create Connection.

v. Navigate back to the guided setup and set the Add Another Token Auth Connection  task to 
complete by selecting Mark as Complete.

d. Set configuration properties for newly added connections.

i. For the Set configuration properties  task, select Configure.

ii. From the Name  column, select the new connection.

iii. In the Service Graph Connection Properties related list, review and modify the following 
properties.

Field Value

max_retry_count Determines the number of retry attempts 
triggered for a Tanium  Asset REST action in 
case of failure.

pagination_record_count Specifies the page size for each API call 
made during a Tanium  Application Data 
REST action.

rest_action_limit Specifies the page size for each API call 
made during a Tanium  Asset REST action.

view_id Specifies the identifier used to fetch 
hardware and software data from a specific 
Tanium  view. To modify the view identifier, 
access the SG Tanium Connection 
[sn_tanium_integ_connection] table.

iv. Return to the guided setup page.

v. Set the Set configuration properties  task to complete by selecting Mark as Complete.

e. Test the newly added connections.

i. For the Test connections  task, select Configure.

ii. From the Name  column, select the new connection.

iii. Select the Test Connection  related link to start the testing process.

iv. When the Status  field is set to Success, return to the guided setup page.

Note: 
If any of the tests have errors, follow the suggestions for remediation.

v. Set the Test connections  task to complete by selecting Mark as Complete.

f. Set the Tanium  view for the connection.
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i. For the Set view  task, select Configure.

ii. In the Connection and Credentials Alias  field, search for and select the alias created 
earlier in the Add Another Basic Auth Connection or Add Another Token Auth Connection 
task.

iii. In the View  field, search for and select the corresponding Tanium  view associated with the 
connection.

iv. Select Set View.

v. Set the Set view  task to complete by selecting Mark as Complete.

g. Skip the ADM setup for multi instance  task as ADM is not supported currently.

h. Configure the Tanium  scheduled job.

i. For the Configure the Scheduled Imports  task, select Configure.

ii. Select the scheduled data import that you want to activate.

iii. On the Scheduled Data Import form, verify the field values for the scheduled job and 
select the Active  check box.

Note: 
When using a token-based authentication, the user you specify in the Run as  field for 
a scheduled job must have the connection_admin role.

For more information, see Schedule a data import .

iv. Select Update.

v. Repeat steps 6.h.ii  to 6.h.iv  for each scheduled job for data import.

vi. Set the Configure the Scheduled Imports  task to complete by selecting Mark as 
Complete.

7. Optional:  Use the advanced settings to manage excluding the serial number population on 
the IBM  AIX  and Oracle  Solaris  operating system (OS) platforms.

a. In the Advanced section of the guided setup, for the Advanced Settings task, select 
Configure.

b. To exclude the serial number population, enter false  in the Exclude the serial number 
population  field.

c. Select Save.

d. Close the window and set the Advanced Settings task to complete by selecting Mark as 
Complete.

CMDB  classes targeted in Service Graph Connector for Tanium

When you complete setting up the connection, you can configure the integration to periodically 
pull data from Tanium. The data is saved in tables that extend from the Configuration item 
[cmdb_ci] table.

Application [cmdb_ci_appl]

The following attributes in the Application [cmdb_ci_appl] table are populated by collected data:
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Attribute label Attribute name

Class sys_class_name

Name name

Running process command running_process_command

Relationship created for Application

Parent class Relationship type Child class

Application [cmdb_ci_appl] Runs on::Runs Computer[cmdb_ci_computer]

Computer [cmdb_ci_computer]

The following attributes in the Computer [cmdb_ci_computer] table are populated by collected 
data:

Attribute label Attribute name

Name name

Serial number serial_number

Class sys_class_name

CPU core count cpu_core_count

CPU count cpu_count

CPU speed (MHz) cpu_speed

CPU type cpu_type

DNS Domain dns_domain

IP Address ip_address

CPU manufacturer cpu_manufacturer

CPU name cpu_name

Is Virtual virtual

Most recent discovery last_discovered

Operating System os

OS Domain os_domain

OS Service Pack os_service_pack

OS Version os_version

RAM (MB) ram

Model ID model_id

Manufacturer manufacturer
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Relationships created for Computer

Parent class Relationship type Child class

Computer 
[cmdb_ci_computer]

Owns::Owned by Network Adapter 
[cmdb_ci_network_adapter]

Computer 
[cmdb_ci_computer]

Owns::Owned by IP Address 
[cmdb_ci_ip_address]

Computer 
[cmdb_ci_computer]

Contains::Contained by Disk [cmdb_ci_disk]

Computer 
[cmdb_ci_computer]

Contains::Contained by File System 
[cmdb_ci_file_system]

Computer 
[cmdb_ci_computer]

Reference Software Installation 
[cmdb_sam_sw_install]

Computer 
[cmdb_ci_computer]

Virtualized by::Virtualizes Virtual Machine Instance 
[cmdb_ci_vm_instance]

Disk [cmdb_ci_disk]

The following attributes in the Disk [cmdb_ci_disk] table are populated by collected data:

Attribute label Attribute name

Manufacturer manufacturer

Name name

Computer computer

Serial number serial_number

Device interface device_interface

Storage type storage_type

Model ID model_id

Device ID device_id

Size bytes size_bytes

Relationship created for Disk

Parent class Relationship type Child class

Disk [cmdb_ci_disk] Reference Computer 
[cmdb_ci_computer]

File System [cmdb_ci_file_system]

The following attributes in the File System [cmdb_ci_file_system] table are populated by 
collected data:
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Attribute label Attribute name

Name name

File system file_system

Free space bytes free_space_bytes

Label label

Media type media_type

Mount point mount_point

Size bytes size_bytes

Computer computer

Relationship created for File System

Parent class Relationship type Child class

File System 
[cmdb_ci_file_system]

Reference Computer 
[cmdb_ci_computer]

IP Address [cmdb_ci_ip_address]

The following attributes in the IP Address [cmdb_ci_ip_address] table are populated by collected 
data:

Attribute label Attribute name

Nic nic

IP Address ip_address

IP version ip_version

Name name

Relationship created for IP Address

Parent class Relationship type Child class

IP Address 
[cmdb_ci_ip_address]

Reference Network Adapter 
[cmdb_ci_network_adapter]

Network Adapter [cmdb_ci_network_adapter]

The following attributes in the Network Adapter [cmdb_ci_network_adapter] table are populated 
by collected data:

Attribute label Attribute name

Discovery source discovery_source

Netmask netmask

Mac manufacturer mac_manufacturer
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Attribute label Attribute name

MAC Address mac_address

Name name

Model ID model_id

DHCP Enabled dhcp_enabled

Relationship created for Network Adapter

Parent class Relationship type Child class

Network Adapter 
[cmdb_ci_network_adapter]

Reference Computer 
[cmdb_ci_computer]

Serial Number [cmdb_serial_number]

The following attributes in the Serial Number [cmdb_serial_number] table are populated by 
collected data:

Attribute label Attribute name

Serial Number serial_number

Serial Number Type serial_number_type

Valid valid

Relationship created for Serial Number

Parent class Relationship type Child class

Serial Number 
[cmdb_serial_number]

Reference Computer 
[cmdb_ci_computer]

Software [cmdb_ci_spkg]

The following attributes in the Software [cmdb_ci_spkg] table are populated by collected data 
when the Software Asset Management  (SAM) application isn't installed:

Attribute label Attribute name

Version version

Manufacturer manufacturer

Key key

Name name

Relationship created for Software

Parent class Relationship type Child class

Software [cmdb_ci_spkg] Reference Software Instance 
[cmdb_software_instance]
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Software Installation [cmdb_sam_sw_install]

The following attributes in the Software Installation [cmdb_sam_sw_install] table are populated 
by collected data when the SAM application is installed:

Attribute label Attribute name

Display name display_name

Publisher publisher

Version version

Discovery source discovery_source

Last scanned last_scanned

Software Instance [cmdb_software_instance]

The following attributes in the Software Instance [cmdb_software_instance] table are populated 
by collected data when the SAM application isn't installed:

Attribute label Attribute name

Name name

Installed on installed_on

Relationship created for Software Instance

Parent class Relationship type Child class

Software Instance 
[cmdb_software_instance]

Reference Computer 
[cmdb_ci_computer]

Virtual Machine Instance [cmdb_ci_vm_instance]

The following attribute in the Virtual Machine Instance [cmdb_ci_vm_instance] table is populated 
by collected data:

Attribute label Attribute name

Sys ID sys_id

Note: 
Service Graph Connector for Tanium  doesn't create a Virtual Machine Instance CI. During 
look-up in the Virtual Machine Instance [cmdb_ci_vm_instance] table, if a VM instance 
is found that has an object ID that matches the cloud instance ID of a server instance, a 
relationship is created between that VM instance and the server instance.

Accessing the connection details of Service Graph Connector for Tanium

You can access the connection details of the Service Graph Connector for Tanium  in a single 
view using the common connection framework (CCF) included within the Integration Commons 
for CMDB  (sn_cmdb_int_util) store app.
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With the CCF, you can access all the connections used by the Service Graph Connector for 
Tanium. The connection details include the connection alias, connection properties, data 
sources, and scheduled data imports associated with a connection. You can also test the 
connection. For more information, see Accessing the connection details of Service Graph 
Connectors.

Access the details of a Tanium  connection

Access the details of a Tanium  connection configured for the Service Graph Connector for 
Tanium.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Service Graph Connectors  > Tanium  > Connections.

2. From the Name  column of the Service Graph Connections list, select a connection.

3. On the Service Graph Connections page, view the connection details such as the connection 
name, alias, and data sources.

4. Select a related list to view further details of the connection.

5. Optional:  Select the Test Connection  related link to test the connection.

Service Graph Connector for Trellix

Use the Service Graph Connector for Trellix  to bring in device, server, and network data from 
a Trellix  environment into your ServiceNow  instance to streamline your incident response and 
asset management use cases.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Supported versions
Supported ServiceNow  versions:

• Washington DC

• Xanadu

• Yokohama

Use cases

The following examples describe how you can use the Service Graph Connector for Trellix for 
security operations management:

• Identify cybersecurity risks in the environment.

• Assess dependencies between configuration items (CI).

• Enable effective security incident response and endpoint management systems.

• Identify data quality issues, reconcile inconsistencies, and manage incidents and changes on 
discovered CIs.
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Configuring a connection for the connector

You can configure a connection for the connector by using the SGC Central  view in the CMDB 
Workspace. The view enables you to discover and install connectors, and then effectively 
manage the full life cycle of creating, editing, monitoring, and debugging connections. To 
configure the connector using SGC Central, see Configure Service Graph Connector for Trellix 
using SGC Central.

Important: 
Unless there are configuration issues, use the SGC Central  view in the CMDB Workspace 
to configure the connection for the connector, as the guided setup method is being 
deprecated.

CMDB integrations dashboard

The Integration Commons for CMDB  store app provides a dashboard with a central view of the 
status, processing results, and processing errors of all installed integrations. You can see metrics 
for all integration runs. You can filter the view to a specific CMDB  integration, a specific time 
duration, or a specific integration run. For more details about monitoring Tanium  integrations in 
the CMDB  Integrations Dashboard, see Using the CMDB Integrations Dashboard.

Data mapping

Data from the Trellix  data sources is mapped and transformed into the ServiceNow  CMDB 
Configuration Item (CI) class definitions using the Robust Transform Engine (RTE). Data is 
inserted into the ServiceNow  CMDB  using the Identification and Reconciliation Engine (IRE).

The following data source is included for the Trellix  application:

SG-Trellix-Devices

Imports data from devices and loads the imported data in the SGC Trellix Device 
Import [sn_trellix_integ_sgc_trellix_device_import] staging table.

The imported data is then inserted into the following target tables:

• File System  [cmdb_ci_file_system]

• IP Address  [cmdb_ci_ip_address]

• Network Adapter  [cmdb_ci_network_adapter]

• Server  [cmdb_ci_server]

• Software Installation  [cmdb_sam_sw_install] (if the Software Asset Management (SAM) 
application is installed)

• Software  [cmdb_ci_spkg] (if the SAM application isn't installed)

• Software Instance  [cmdb_software_instance] (if the SAM application isn't installed)

• Storage Disk  [cmdb_ci_storage_disk]

You can use the IntegrationHub ETL app to view the data maps. See IntegrationHub ETL  for more 
information.

System property

The following system property is available for Service Graph Connector for Trellix: 
sn_trellix_integ.getdevices_count. This property sets the pagination size for the 
records that are fetched from the Trellix  API.
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• Type: integer

• Default value: 100

Note: 
To open the System Properties [sys_properties] table, enter sys_properties.list  in 
the navigation filter.

Related topics

Service Graph Connectors

Configure Service Graph Connector for Trellix using SGC Central

Configure Service Graph Connector for Trellix using guided setup

CMDB classes targeted in Service Graph Connector for Trellix

Configure Service Graph Connector for Trellix  using SGC Central

Use the playbook available with the SGC Central  application to set up the Service Graph 
Connector for Trellix  for pulling in Trellix  data into the CMDB.

Before you begin
Install Service Graph Connector for Trellix  version 1.0.0 [store-future: BEGIN review]or later 
[End]from the ServiceNow Store. For ServiceNow Store  installation steps, see Install a 
ServiceNow Store application .

Role required: cmdb_inst_admin or admin

About this task
The playbook experience for onboarding connectors is activated with SGC Central  in the CMDB 
Workspace. To configure the SGC Central  application, see Configuring SGC Central  and for more 
information on how to interact with a playbook, see Interact with Playbook .

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the CMDB Workspace, select SGC Central.

3. On the Dashboard page, select Create connection.

Tip: 
Alternatively, you can select Create connection  on the All connections page.

4. On the Create connection window, select the Trellix  connector type, and then select Create 
connection.

5. Complete the initial prerequisites when setting up a connection for the first time using a 
connector.

Note: 
This step is required only during the first-time setup. See Perform initial setup tasks when 
creating a connection in SGC Central.

6. Complete the setup for configuring the connector for importing data.
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a. Create and test a connection.

i. In the Setup  stage of the playbook, select the Create and test connection  activity.

ii. On the form, fill in the fields.

Create and test connection form

Field

Connection 
name

Name to identify the Trellix  connection record.

For example, SGTrellix.

Connection 
url

URL of the connection.

User name User name of your Trellix  account.

Password Password of your Trellix  account.

Use MID 
server

Option to use a MID Server. Select this check box if you’re using an on-
premises instance of Trellix.

Note: 
A MID Server must be configured on your ServiceNow  instance 
before you select this option.

Mid 
Selection

Name of the MID Server used by the connector.

This field appears only when the Use MID Server  check box is selected.

iii. Select Create and test connection.

iv. Once the connection test is complete, select Continue.

b. Configure the import schedule to import data at regular intervals.

i. In the Setup  stage of the playbook, select the Configure import schedule  activity.

ii. Expand the Parent scheduled data import within the Import schedules list, and select the 
SG-Trellix-Devices import schedule.

iii. In the Configure import schedule  dialog box, select the Active  check box, and then fill in 
the run schedule and time details.

For more information, see Schedule a data import .

iv. Select Save.

Alternatively, select Execute Now  to execute the import schedule immediately.

v. Select Continue.

c. In the Setup  stage of the playbook, select the Confirm connection setup  activity to verify 
whether the connection was created.

What to do next
Select View all connections  to review the connection details. The configured connection 
appears in the Installed connections list.
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Related topics

Service Graph Connector for Trellix

CMDB classes targeted in Service Graph Connector for Trellix

Accessing the connection details of Service Graph Connector for Trellix

Configure Service Graph Connector for Trellix  using guided setup

Set up scheduled import jobs to pull in data from a Trellix  project into your CMDB.

Before you begin
Important: 
Unless there are configuration issues, use the SGC Central  view in the CMDB Workspace 
to configure the connection for the connector, as the guided setup method is being 
deprecated.

To use this Service Graph Connector, you need a subscription to a Subscription Unit that is 
based in the IT Operations Management  (ITOM) Visibility application or in the ITOM  Discovery 
application. As defined in the section titled "Managed IT Resource Types" in ServiceNow 
Subscription Unit Overview  for your subscription, for managed IT resources that are created 
or modified in the CMDB  by this Service Graph Connector, but that aren’t yet managed by ITOM 
Visibility or ITOM Discovery , these resources will increase Subscription Unit consumption from 
that application. Review your current Subscription Unit consumption within ITOM Visibility or 
ITOM Discovery to ensure available capacity.

Dependencies and requirements:

• The Integration Commons for CMDB store app, which is automatically installed. See 
Integration Commons for CMDB.

• The CMDB CI class models store app, which is automatically installed. See CMDB CI Class 
Models store app.

• The ITOM Licensing plugin (com.snc.itom.license). See Request Discovery .

Role required: admin

Procedure

1. Verify that the application scope is set to the Service Graph Connector for Trellix  application by 
using the application picker.
For more information, see Application picker .

2. Navigate to All  > Service Graph Connectors  > Trellix  > Setup.

3. On the Service Graph Connector for Trellix page, verify that the Quick Start  option is selected, 
and then select Continue.

4. Configure the connection to send requests to the Trellix  application.

a. On the Service Graph Connector for Trellix page, in the Configure the Connection and 
Credentials  section, select Start.

b. Configure the authentication credentials.
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i. For the Configure Trellix authentication credentials  task, fill in the fields on the Basic Auth 
Credentials form.

Basic Auth Credentials form

Field Description

Name Credentials to use for the connection. For example, 
SGTrellix.Credentials.

Order The sequence in which the records are processed. The default value is 100.

User 
name

User name of your Trellix  account.

Password Password of your Trellix  account.

Active Verify that the check box is selected.

ii. Select Update  to save the authentication credentials.

iii. Set the Configure Trellix authentication credentials  task to complete by selecting Mark as 
complete, and then select Continue.

c. Configure the HTTP connection.

i. For the Configure Trellix HTTP Connection  task, fill in the fields on the HTTP(s) Connection 
form.

HTTP(s) Connection form

Field Description

Name Name to identify the Trellix  connection record. For example, SGTrellix.

Don’t modify the name for the default connection SGTrellix.

Active Verify that the check box is selected.

Credential Credentials to use for the connection.

Domain Domain that contains the connection.

Connection 
alias

Connection alias that resolves your connection and credentials at runtime.

Note: 
Only one connection is active per connection alias at a time.

Connection 
URL

Base URL of the connection. The base URL is the hostname of your Trellix 
instance. For example, https://subdomain.domain.com:port.

Use MID 
server

Option to use a MID Server. Select this check box if you're using an 
on-premises instance of Trellix. Complete the Advanced MID Server 
Configuration.

Note: 
A MID Server must be configured on your ServiceNow  instance before 
you select this option.
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Field Description

MID 
selection

Select a MID Server from the list.

This field appears only when the Use MID Server  check box is selected.

MID 
application

Select a MID Server application from the list.

This field appears only when the Use MID Server  check box is selected.

Connection 
timeout

The maximum time (in seconds) the system waits while attempting to 
establish a connection.

ii. Select Update  to save the HTTP connection details.

iii. Set the Configure Trellix HTTP Connection  task to complete by selecting Mark as 
complete, and then select Continue.

d. Test the Trellix  API connection to import data from the Trellix  application.

i. Test the connection by selecting the Test Connection  related link in the Test Connection 
task.

Testing the connection might take a few moments. The page is refreshed to show the test 
results.

ii. When the Status  field is set to Success, set the Test Connection  task to complete by 
selecting Mark as complete, and then select Continue.

If any of the tests have errors, follow the suggestions for remediation.

5. Optional:  Add multiple instances.

Note: 
If you don't need to add multiple instances, you can skip this step.

a. On the Service Graph Connector for Trellix page, in the Add Multiple Instances section, 
select Start.

b. In the Update Data Source Access section, select the Data Source [sys_data_source] table.

c. Select the Global  application scope by using the application picker.

d. In the Application Access related list, select the Can create, Can update, and Can delete 
check boxes, if not already selected.

e. Modify the application scope again to Service Graph Connector for Trellix  by using the 
application picker.

f. Select Update  to save the data source access details.

g. Set the Update Data Source Access task to complete by selecting Mark as Complete, and 
then select Continue.

h. Repeat steps 5.c  to 5.e  for the Update Scheduled Data Import Access task with the 
Scheduled data import [scheduled_data_set] table.
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i. Select Update  to save the scheduled data import access details.

j. Set the Update Scheduled Data Import Access task to complete by selecting Mark as 
Complete, and then select Continue.

k. In the Add Another Connection section, modify the application scope to Service Graph 
Connector for Trellix  by using the application picker.

l. Select Click Here.

m. On the Workflow Studio page, select Add Connection  in the SGTrellix section.

n. Fill in the fields on the Create Connection form, and then select Create Connection.

Create Connection form

Field Description

Connection 
name

Name to identify the Trellix  connection record.

Connection 
url

URL of the connection.

Use MID 
server

Option to use a MID Server. Select this check box if you're using an 
on-premises instance of Trellix. Complete the Advanced MID Server 
Configuration.

Note: 
A MID Server must be configured on your ServiceNow  instance before 
you select this option.

MID 
selection

Select a MID Server from the list.

(Optional) This field appears only when the Use MID Server  check box is 
selected.

MID 
application

Select a MID Server application from the list.

(Optional) This field appears only when the Use MID Server  check box is 
selected.

User name User name of your Trellix  account.

Password Password of your Trellix  account.

o. Close the Workflow Studio page, and navigate back to the guided setup.

p. Set the Add Another Connection task to complete by selecting Mark as Complete, and then 
select Continue.

q. In the Test New Connections section, select the newly created connection record, and then 
select the Test Connection  related link.
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(Optional) Testing the connection might take a few moments. The page is refreshed to show 
the test results.

r. When the Status  field is set to Success, set the Test New Connections task to complete by 
selecting Mark as complete, and then select Continue.

(Optional) If any of the tests have errors, follow the suggestions for remediation.

6. Configure the scheduled jobs to import data from the Trellix  application.

a. On the Service Graph Connector for Trellix page, in the Set up scheduled import jobs 
section, select Start.

b. For the Configure the scheduled jobs  task, select the connection.

Note: 
The SG-Trellix-Devices scheduled import job is set to inactive by default.

c. On the Scheduled Data Import form, verify the field values for the scheduled job.

For more information, see Schedule a data import .

d. Select the Active  check box to activate the SG-Trellix-Devices scheduled import job.

e. In the Run  field, select Periodically  to specify how often the job runs.

f. Select Execute Now  to execute the import schedule.

g. Set the Configure the scheduled jobs  task to complete by selecting Mark as complete, and 
then select Continue.

7. On the Service Graph Connector for Trellix page, select Exit  to exit the guided setup.

8. [store-future: BEGIN review] On the Service Graph Connector for Trellix page, select Complete 
to save your changes.  [End]

9. [store-future: BEGIN review] In Complete setup dialog box, select Complete  to complete the 
setup.  [End]

10. [store-future: BEGIN review] In the message box that appears, select Done.  [End]

Related topics

Service Graph Connector for Trellix

CMDB classes targeted in Service Graph Connector for Trellix

Accessing the connection details of Service Graph Connector for Trellix

CMDB  classes targeted in Service Graph Connector for Trellix

When you complete setting up the connection, you can configure the integration to periodically 
pull data from Trellix. The data is saved in tables that extend from the Configuration item 
[cmdb_ci] table.
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File System [cmdb_ci_file_system]

The following attributes in the File System [cmdb_ci_file_system] table are populated by 
collected data:

Attribute label Attribute name

Computer computer

Disk Space (GB) disk_space

Free space bytes free_space_bytes

Name name

Relationship created for File System

Parent class Relationship type Child class

File System 
[cmdb_ci_file_system]

Reference Server [cmdb_ci_server]

IP Address [cmdb_ci_ip_address]

The following attributes in the IP Address [cmdb_ci_ip_address] table are populated by collected 
data:

Attribute label Attribute name

IP Address ip_address

Netmask netmask

Nic nic

Relationship created for IP Address

Parent class Relationship type Child class

IP Address 
[cmdb_ci_ip_address]

Reference Network Adapter 
[cmdb_ci_network_adapter]

Network Adapter [cmdb_ci_network_adapter]

The following attributes in the Network Adapter [cmdb_ci_network_adapter] table are populated 
by collected data:

Attribute label Attribute name

Configuration Item cmdb_ci

IP Address ip_address

MAC Address mac_address

Name name

Netmask netmask
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Relationship created for Network Adapter

Parent class Relationship type Child class

Network Adapter 
[cmdb_ci_network_adapter]

Reference Server [cmdb_ci_server]

Server [cmdb_ci_server]

The following attributes in the Server [cmdb_ci_server] table are populated by collected data:

Attribute label Attribute name

Class sys_class_name

CPU count cpu_count

CPU speed (MHz) cpu_speed

CPU type cpu_type

DNS Domain dns_domain

Host name host_name

Install Status install_status

IP Address ip_address

Is Virtual virtual

MAC Address mac_address

Manufacturer manufacturer

Model ID model_id

Name name

Operating System os

OS Service Pack os_service_pack

OS Version os_version

RAM (MB) ram

Serial number serial_number

Relationships created for Server

Parent class Relationship type Child class

Server [cmdb_ci_server] Contains::Contained by Storage Disk 
[cmdb_ci_storage_disk]

Server [cmdb_ci_server] Contains::Contained by File System 
[cmdb_ci_file_system]

Server [cmdb_ci_server] Owns::Owned by IP Address 
[cmdb_ci_ip_address]

Server [cmdb_ci_server] Owns::Owned by Network Adapter 
[cmdb_ci_network_adapter]
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Software [cmdb_ci_spkg]

The following attributes in the Software [cmdb_ci_spkg] table are populated by collected data:

Attribute label Attribute name

Key key

Name name

Version version

Relationship created for Software

Parent class Relationship type Child class

Software [cmdb_ci_spkg] Reference Software Instance 
[cmdb_software_instance]

Software Installation [cmdb_sam_sw_install]

The following attributes in the Software Installation [cmdb_sam_sw_install] table are populated 
by collected data:

Attribute label Attribute name

Discovery Source discovery_source

Installed on installed_on

Name name

Version version

Relationship created for Software Installation

Parent class Relationship type Child class

Software Installation 
[cmdb_sam_sw_install]

Reference Server [cmdb_ci_server]

Software Instance [cmdb_software_instance]

The following attributes in the Software Instance [cmdb_software_instance] table are populated 
by collected data:

Attribute label Attribute name

Installed on installed_on

Name name
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Relationship created for Software Instance

Parent class Relationship type Child class

Software Instance 
[cmdb_software_instance]

Reference Server [cmdb_ci_server]

Storage Disk [cmdb_ci_storage_disk]

The following attributes in the Storage Disk [cmdb_ci_storage_disk] table are populated by 
collected data:

Attribute label Attribute name

Computer computer

Disk space (GB) disk_space

Free disk space (GB) free_space

Name name

Relationship created for Storage Disk

Parent class Relationship type Child class

Storage Disk 
[cmdb_ci_storage_disk]

Reference Server [cmdb_ci_server]

Related topics

Service Graph Connector for Trellix

Accessing the connection details of Service Graph Connector for Trellix

You can access the connection details of the Service Graph Connector for Trellix  in a single view 
using the common connection framework (CCF) included within the Integration Commons for 
CMDB  (sn_cmdb_int_util) store app.

With the CCF, you can access all the connections used by the Service Graph Connector for 
Trellix. The connection details include the connection alias, connection properties, data sources, 
and scheduled data imports associated with a connection. You can also test the connection. For 
more information, see Accessing the connection details of Service Graph Connectors.

Access the details of a Trellix  connection

Access the details of a Trellix  connection configured for the Service Graph Connector for Trellix.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Service Graph Connectors  > Trellix  > Connections.

2. From the Name  column of the Service Graph Connections list, select a connection.

3. On the Service Graph Connections page, view the connection details such as the connection 
name, alias, and data sources.
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4. Select a related list to view further details of the connection.

5. Optional:  Select the Test Connection  related link to test the connection.

Related topics

Service Graph Connector for Trellix

Service Graph Connector for VMware Workspace ONE UEM

Use the Service Graph Connector for VMware Workspace ONE UEM  to pull data from VMware 
Workspace ONE Unified Endpoint Management (UEM)  into your ServiceNow  Instance.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

The integration imports different hardware assets into the ServiceNow®  Configuration 
Management Database (CMDB)  application.

Supported versions

• Supported versions:

◦ VMware  Workspace ONE UEM  version 2008

◦ Application Discovery Manager (ADM) API version 2

• Supported ServiceNow  versions:

◦ Washington DC

◦ Xanadu

◦ Yokohama

◦ Zurich

Use cases

The following are examples on how you can use the Service Graph Connector  for different 
ServiceNow  applications:

• IT Operations Management (ITOM) Visibility

◦ Detailed hardware and application inventory for Android, Apple, and Windows  mobile 
devices. The inventory can be used with or without Software Asset Management  (SAM).

◦ Compliance tracking for mobile devices. You can build your own device (BYOD) or use 
corporate-owned devices.

• IT Service Management (ITSM)

◦ Incident, problem, change on discovered configuration items (CI).

◦ Ownership tracking and assignment for mobile devices.

Guided setup

The guided setup for the Service Graph Connector for VMware Workspace ONE UEM  provides 
an organized sequence of tasks to configure the integration on your instance. To access the 
guided setup, see Configure Service Graph Connector for VMware Workspace ONE UEM.
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CMDB integrations dashboard

The Integration Commons for CMDB  store app provides a dashboard with a central view of 
the status, processing results, and processing errors of all installed integrations. You can see 
metrics for all integration runs. You can filter the view to a specific CMDB  integration, a specific 
time duration, or a specific integration run. For more details about monitoring Workspace ONE 
integrations in the CMDB  Integrations Dashboard, see Using the CMDB Integrations Dashboard.

Data mapping

Data from the VMware  Workspace ONE UEM  Devices and Apps data sources is mapped 
and transformed into the ServiceNow  CMDB  Configuration Item (CI) class definitions using 
the Robust Transform Engine (RTE). Data is inserted into the ServiceNow  CMDB  using the 
Identification and Reconciliation Engine (IRE).

When you complete setting up the connection, you configure the integration to periodically pull 
data from VMware  Workspace ONE UEM.

The data is loaded into the SG-Workspace ONE UEM Devices and Apps staging 
[sn_vmwoneuem_integ_devices_and_apps] table.

The data is then inserted into the following target tables:

• Computer [cmdb_ci_computer]

• Handheld Computing Device [cmdb_ci_handheld_computing]

• Media Player [cmdb_ci_media_player]

• Network Adapter [cmdb_ci_network_adapter]

• Printer [cmdb_ci_printer]

• SAM Software Installation [cmdb_sam_sw_install], if com.snc.sams plugin is installed.

• Serial Number [cmdb_serial_number]

• Software Instance [cmdb_software_instance], if com.snc.sams plugin is not installed.

• Software Package [cmdb_ci_spkg], if com.snc.sams plugin is not installed.

Note: 
To view any additional information such as the device owner, type of ownership, or 
compliance status, you need to switch to the SG-Workspace ONE UEM view. This view 
displays a SG-Workspace ONE UEM Device Related  tab in the related list tabs with the 
additional information.

For more information on where data is saved when pulling data from VMware  Workspace 
ONE Unified Endpoint Management (UEM), see CMDB classes targeted in Service Graph 
Connector for VMware Workspace ONE UEM.

You can use the IntegrationHub ETL app to view the data maps. See IntegrationHub ETL  for more 
information.

Related topics

Service Graph Connectors

Configure Service Graph Connector for VMware Workspace ONE UEM

Use the Service Graph Connector for VMware Workspace ONE UEM  to pull mobile and 
computing devices data from VMware  Workspace ONE Unified Endpoint Management (UEM)  into 
your ServiceNow  instance.
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Before you begin
To use this Service Graph Connector, you need a subscription to a Subscription Unit that is 
based in the IT Operations Management  (ITOM) Visibility application or in the ITOM  Discovery 
application. As defined in the section titled "Managed IT Resource Types" in ServiceNow 
Subscription Unit Overview  for your subscription, for managed IT resources that are created 
or modified in the CMDB  by this Service Graph Connector, but that aren’t yet managed by ITOM 
Visibility or ITOM Discovery , these resources will increase Subscription Unit consumption from 
that application. Review your current Subscription Unit consumption within ITOM Visibility or 
ITOM Discovery to ensure available capacity.

Dependencies and requirements:

• The Integration Commons for CMDB  store app, which is automatically installed.

• The CMDB CI class models store app, which is automatically installed. See CMDB CI Class 
Models store app.

• The ITOM Discovery License plugin (com.snc.itom.discovery.license). You must activate this 
plugin.

• ITOM Licensing plugin (com.snc.itom.license). For more information, see Request Discovery .

• The Datastream Action plugin (com.glide.hub.action_type.datastream), which is automatically 
installed.

Roles required: admin

When using client credentials for authentication, obtain the OAuth credentials from your VMware 
Workspace ONE UEM  administrator. Make a note of the following details:

• Application (client) ID

• Client Secret

• Token URL

For information about how to get OAuth credentials, see the VMware documentation site .

About this task
To configure the Service Graph Connector for VMware Workspace ONE UEM, you must configure 
either OAuth authentication credentials or basic authentication credentials.

Procedure

1. Navigate to All  > Service Graph Connectors  > Workspace ONE UEM  > Setup.

2. On the Getting started page, select Get Started.

3. In the Configure the Connection and Credentials  section of the Service Graph Connector for 
VMware Workspace ONE UEM  page, select Get Started.

4. Configure authentication credentials for the connection.
You can configure either a basic authentication connection or an OAuth connection.

a. For the Set authentication type  task, select Configure.

▪ To enable basic authentication, set the value of the auth_type  connection property to 
basic.

▪ To enable OAuth authentication, set the value of the auth_type  connection property to 
oauth.
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b. Select Update, and navigate back to the guided setup page.

c. Set the Set authentication type  task to complete by selecting Mark as Complete.

5. Configure the credentials for authentication.

◦ Configure a basic authentication connection.

a. For the Configure the Basic Auth Credentials  task, select Configure.

b. On the form, fill in the fields.

Field Description

Name Name of the authentication.

For example, WorkspaceOneUEM 
Basic Auth Credentials.

User name Your VMware  Workspace ONE UEM  user 
name.

Password Your VMware  Workspace ONE UEM 
password.

c. Select Update, and navigate back to the guided setup page.

d. Set the Configure the Basic Auth Credentials  task to complete by selecting Mark as 
Complete.

e. For the Configure API key  task, select Configure  to configure an API key for the basic 
authentication connection.

f. In the API Key  field, enter your VMware  Workspace ONE UEM  API key or tenant code.

g. Select Update, and navigate back to the guided setup page.

h. Set the Configure API key  task to complete by selecting Mark as Complete.

◦ Configure an OAuth connection.

a. For the Configure the OAuth Credentials  task, select Configure.

b. On the form, fill in the fields.

Field Description

Name Name of the authentication.

For example, WorkspaceOneUEM 
OAuth Provider.

Client ID Application (client) ID of your VMware 
Workspace ONE UEM  client application as 
noted in the Before you begin  section.

Client Secret Client secret of your VMware  Workspace 
ONE UEM  client application as noted in the 
Before you begin  section.
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c. Select Update, and navigate back to the guided setup page.

d. Set the Configure the OAuth Credentials  task to complete by selecting Mark as Complete.

6. Establish an HTTP connection to send requests to the VMware  Workspace ONE UEM  API.

a. For the Configure HTTP connection  task, select Configure.

b. On the HTTP(s) Connection  form, specify the host name of your VMware  Workspace ONE 
UEM  instance in the Host  field.

Note: 
The HTTP connection is pre-configured to use the authentication credentials that were 
configured in steps 4  and 5.

c. Select Update.

d. Set the Configure HTTP Connection  task to complete by selecting Mark as Complete.

7. Test the connection.

a. For the Test the Connection  task, select Configure.

b. Select the Test Connection  related link to start the testing process.

c. When the Status  field is set to Success, navigate back to the guided setup page.
If any of the tests have errors, follow the suggestions for remediation.

d. Set the Test the Connection  task to complete by selecting Mark as Complete.

8. Set up the scheduled import job.

a. For the Configure the scheduled job  task, select Configure.
The SG-Workspace ONE UEM Devices and Apps  scheduled job is set to inactive by default.

b. Select the SG-Workspace ONE UEM Devices and Apps  scheduled job.

c. On the Scheduled Data Import form, verify the field values for the scheduled job.
For more information, see Schedule a data import .

d. Select the Active  check box to activate the SG-Workspace ONE UEM Devices and Apps 
scheduled job.

e. In the Run  field, select Periodically  to specify how often the job should run.

f. Select Update.
Alternatively, select Execute Now  to execute the import schedule immediately.

g. Set the Configure the scheduled job  task to complete by selecting Mark as Complete.

9. Optional:  Add multiple instances.
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Note: 
If you don't need to add multiple instances, you can skip this step.

a. In the Add multiple instances  section of the Service Graph Connector for VMware 
Workspace ONE UEM  page, select Get Started.

b. For the Update scheduled data import access  task, select Configure.

c. Select the Scheduled data import [scheduled_import_set] table.

d. Select the Global  application scope by using the application picker.

e. In the Application Access related list, select the Can create, Can update, and Can delete 
check boxes, if not already selected.

f. Select Update, and then navigate back to the guided setup.

g. Modify the application scope again to Service Graph Connector for VMware Workspace 
ONE UEM  by using the application picker.

h. Set the Update scheduled data import access  task to complete by selecting Mark as 
Complete.

i. For the Update Data Source Access  task, select Configure.

j. Select the Data Source [sys_data_source] table.

k. Repeat steps 9.d  to 9.g.

l. Set the Update Data Source Access  task to complete by selecting Mark as Complete.

m. Clear the cache for the new connection.

i. For the Clear cache for Data Source and Import Set tables  task, select Configure.

ii. Select the Global  application scope by using the application picker.

iii. In the Run script  text box of the background script page, enter the following script:

GlideTableManager.invalidateTable("sys_data_source");
      GlideCacheManager.flushTable("sys_data_source");
     
 GlideTableManager.invalidateTable("scheduled_import_set");
      GlideCacheManager.flushTable("scheduled_import_set");
      GlideTableManager.invalidateTable("sys_db_object");
      GlideCacheManager.flushTable("sys_db_object");

iv. Select Run Script  to run the background script.

The script may take several minutes to execute.

v. After the script is executed, select Close.
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vi. Modify the application scope again to Service Graph Connector for VMware Workspace 
ONE UEM  by using the application picker.

vii. Set the Clear cache for Data Source and Import Set tables  task to complete by selecting 
Mark as complete.

n. Configure the connection for the VMware  Workspace ONE UEM  instance.

(Optional) You can configure either a basic authentication connection or an OAuth 
connection.

▪ Configure a basic authentication connection.

i. For the Add basic authentication connection  task, select Configure.

ii. To create a new connection, select Add Connection.

iii. In the Connection Information section of the Create Connection window, fill in the fields.

Connection Information

Field Description

Connection name Name to identify the VMware  Workspace 
ONE UEM  connection record.

Connection URL Connection URL of your VMware 
Workspace ONE UEM  connection.

Use the format https://host-
name/API  for the connection URL.

iv. In the Credential Information section of the Create Connection window, fill in the fields.

Credential Information

Field Description

Username VMware  Workspace ONE UEM  account 
user name that is used to authenticate the 
connection request.

Password Password that is used to authenticate the 
connection request.

v. Select Create Connection.

vi. Navigate back to the guided setup, and set the Add basic authentication connection 
task to complete by selecting Mark as Complete.

vii. For the Configure API key  task, select Configure  to configure an API key for the basic 
authentication connection.

viii. Select the API Key  record that corresponds to the connection alias for the new basic 
authentication connection.

ix. Set the API key, and then select Update.

x. Navigate back to the guided setup, and set the Configure API key  task to complete by 
selecting Mark as Complete.

▪ Configure an OAuth connection.
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i. For the Add an OAuth connection  task, select Configure.

ii. To create a new connection, select Add Connection.

iii. In the Connection Information section of the Create Connection window, fill in the fields.

Connection Information

Field Description

Connection Name Name to identify the VMware  Workspace 
ONE UEM  connection record.

Connection URL Connection URL of your VMware 
Workspace ONE UEM  controller.

Use the format https://host-
name/API  for the connection URL.

iv. In the Credential Information section of the Create Connection window, fill in the fields.

Credential Information

Field Description

OAuth Client ID Application (client) ID of your VMware 
Workspace ONE UEM  client application as 
noted in the Before you begin  section.

OAuth Client Secret Client secret of your VMware  Workspace 
ONE UEM  client application as noted in 
the Before you begin  section.

For information about how to get OAuth credentials, see the VMware documentation 
site .

v. Select Create and Get OAuth Token.

vi. Navigate back to the guided setup, and set the Add an OAuth connection  task to 
complete by selecting Mark as Complete.

o. Test the newly added connections.

i. For the Test connections  task, select Configure.

ii. From the Name  column, select the new connection.

iii. Select the Test Connection  related link to start the testing process.

iv. When the Status  field is set to Success, return to the guided setup page.

Note: 
If any of the tests have errors, follow the suggestions for remediation.

v. Set the Test connections  task to complete by selecting Mark as Complete.

p. Configure the scheduled job to import data from the VMware  Workspace ONE UEM 
application.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1429

https://docs.vmware.com/en/VMware-Workspace-ONE-UEM/services/UEM_ConsoleBasics/GUID-BF20C949-5065-4DCF-889D-1E0151016B5A.html
https://docs.vmware.com/en/VMware-Workspace-ONE-UEM/services/UEM_ConsoleBasics/GUID-BF20C949-5065-4DCF-889D-1E0151016B5A.html
https://docs.vmware.com/en/VMware-Workspace-ONE-UEM/services/UEM_ConsoleBasics/GUID-BF20C949-5065-4DCF-889D-1E0151016B5A.html
https://docs.vmware.com/en/VMware-Workspace-ONE-UEM/services/UEM_ConsoleBasics/GUID-BF20C949-5065-4DCF-889D-1E0151016B5A.html


(Optional) The SG-Workspace ONE UEM Devices and Apps  scheduled job is set to inactive 
by default.

i. For the Configure import schedule  task, select Configure.

ii. Select the SG-Workspace ONE UEM Devices and Apps  scheduled job.

iii. On the Scheduled Data Import form, verify the field values for the scheduled job.

(Optional) For more information, see Schedule a data import .

iv. Select the Active  check box to activate the SG-Workspace ONE UEM Devices and Apps 
scheduled job.

v. In the Run  field, select Periodically  to specify how often the job should run.

vi. Select Update.

Alternatively, select Execute Now  to execute the import schedule immediately.

10. Optional:  Configure additional settings.

a. In the Configure additional settings (optional)  section of the Service Graph Connector for 
VMware Workspace ONE UEM  page, select Get Started.

b. For the Configure duplicate detection rules  task, select Configure.

c. On the CMDB Duplicate Row Rule form, select Active.

d. Update the Value  field to true  to activate the duplicate detection rule during data import.

e. Select OK, and navigate back to the guided setup.

f. To remove fields from being evaluated, add the field names as a comma-separated list in the 
Ignore Fields column on the CMDB Duplicate Row Rules form.
Use this option for fields that change with every import.

g. Set the Configure duplicate detection rules  task to complete by selecting Mark as 
Complete.

h. For the Enable software import  task, select Configure.

i. Select the connection record for which you want to enable the import of software data.
The turn_off_software_import  connection property is set to true  by default.

j. Set the turn_off_software_import  connection property value to false  to import 
software data.

k. Set the Enable software import  task to complete by selecting Mark as Complete.

l. For the Import non-managed software  task, select Configure.

m. Select the connection record for which you want to import non-managed software data.
By default, software records that have the IsManaged  field set to false  aren't imported.
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n. Set the managed_apps_only  connection property value to false  to import non-
managed software data.

o. Set the Import non-managed software  task to complete by selecting Mark as Complete.

p. For the Import apps based on software status value  task, select Configure.
By default, the connector imports applications that have the status value 2, 3, or 5.

Status values of applications

Status Value

Pending Install 1

Installed 2

Pending Removal 3

Removed 4

Unknown 5

q. Select the connection record for which you want to update the set of imported applications.

r. Set the import_apps_with_status  connection property value to the required 
software status values (as a comma-separated list).

s. Set the Import apps based on software status value  task to complete by selecting Mark as 
Complete.

CMDB  classes targeted in Service Graph Connector for VMware Workspace ONE UEM

When you complete setting up the connection, you can configure the integration to periodically 
pull data from VMware  Workspace ONE Unified Endpoint Management (UEM). The data is saved 
in tables that extend from the Configuration item [cmdb_ci] table.

Computer [cmdb_ci_computer]

The following attributes in the Computer [cmdb_ci_computer] table are populated by collected 
data:

Attribute label Attribute name

Name name

Serial number serial_number

Is Virtual virtual

Most recent discovery last_discovered

Operating System os

OS Version os_version

RAM (MB) ram

Assigned to assigned_to
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Attribute label Attribute name

Model ID model_id

Manufacturer manufacturer

Handheld Computing Device [cmdb_ci_handheld_computing]

The following attributes in the Handheld Computing Device [cmdb_ci_handheld_computing] 
table are populated by collected data:

Attribute label Attribute name

MAC Address mac_address

Name name

Serial number serial_number

IMEI imei

Most recent discovery last_discovered

Operating System os

OS Version os_version

Phone Number phone_number

RAM (MB) ram

Root Access root_access

Manufacturer manufacturer

Model ID model_id

Carrier carrier

Assigned to assigned_to

Hardware [cmdb_ci_hardware]

The following attribute in the Hardware [cmdb_ci_hardware] table is populated by collected data:

Attribute label Attribute name

Most recent discovery last_discovered

Relationships created for Hardware

Parent class Relationship type Child class

Hardware [cmdb_ci_hardware] Owns::Owned by Network Adapter 
[cmdb_ci_network_adapter]

Hardware [cmdb_ci_hardware] Owns::Owned by IP Address 
[cmdb_ci_ip_address]

Hardware [cmdb_ci_hardware] Reference SG-Workspace ONE 
UEM Device Related 
[sn_vmwoneuem_integ_device_related]
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Relationships created for Hardware  (continued)

Parent class Relationship type Child class

Hardware [cmdb_ci_hardware] Reference Key Value [cmdb_key_value]

IP Address [cmdb_ci_ip_address]

The following attributes in the IP Address [cmdb_ci_ip_address] table are populated by collected 
data:

Attribute label Attribute name

Name name

Nic nic

IP Address ip_address

IP version ip_version

Relationship created for IP Address

Parent class Relationship type Child class

IP Address 
[cmdb_ci_ip_address]

Reference Network Adapter 
[cmdb_ci_network_adapter]

Key Value [cmdb_key_value]

The following attributes in the Key Value [cmdb_key_value] table are populated by collected data:

Attribute label Attribute name

Key key

Value value

Media Player [cmdb_ci_media_player]

The following attributes in the Media Player [cmdb_ci_media_player] table are populated by 
collected data:

Attribute label Attribute name

Name name

Serial number serial_number

Manufacturer manufacturer

Model ID model_id

MAC Address mac_address

Assigned to assigned_to

Most recent discovery last_discovered
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Network Adapter [cmdb_ci_network_adapter]

The following attributes in the Network Adapter [cmdb_ci_network_adapter] table are populated 
by collected data:

Attribute label Attribute name

Name name

Configuration Item cmdb_ci

MAC Address mac_address

Most recent discovery last_discovered

Relationship created for Network Adapter

Parent class Relationship type Child class

Network Adapter 
[cmdb_ci_network_adapter]

Reference Hardware [cmdb_ci_hardware]

Printer [cmdb_ci_printer]

The following attributes in the Printer [cmdb_ci_printer] table are populated by collected data:

Attribute label Attribute name

Assigned to assigned_to

MAC Address mac_address

Name name

Most recent discovery last_discovered

Manufacturer manufacturer

Model ID model_id

Serial number serial number

Serial Number [cmdb_serial_number]

The following attributes in the Serial Number [cmdb_serial_number] table are populated by 
collected data:

Attribute label Attribute name

Serial Number serial_number

Serial Number Type serial_number_type

Valid valid
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Relationships created for Serial Number

Parent class Relationship type Child class

Serial Number 
[cmdb_serial_number]

Reference Computer 
[cmdb_ci_computer]

Serial Number 
[cmdb_serial_number]

Reference Handheld Computing Device 
[cmdb_ci_handheld_computing]

Serial Number 
[cmdb_serial_number]

Reference Printer [cmdb_ci_printer]

Serial Number 
[cmdb_serial_number]

Reference Media Player 
[cmdb_ci_media_player]

SG-Workspace ONE UEM Device Related 
[sn_vmwoneuem_integ_device_related]

The following attributes in the SG-Workspace ONE UEM Device Related 
[sn_vmwoneuem_integ_device_related] table are populated by collected data:

Attribute label Attribute name

Device ID device_id

Device Compliance State compliance_state

Device Ownership device_ownership

User Email user_email

User Name user_name

Software [cmdb_ci_spkg]

The following attributes in the Software [cmdb_ci_spkg] table are populated by collected data:

Attribute label Attribute name

Key key

Name name

Version version

Relationship created for Software

Parent class Relationship type Child class

Software [cmdb_ci_spkg] Reference Software Instance 
[cmdb_software_instance]

Software Instance [cmdb_software_instance]

The following attributes in the Software Instance [cmdb_software_instance] table are populated 
by collected data:
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Attribute label Attribute name

Name name

Installed on installed_on

Relationship created for Software Instance

Parent class Relationship type Child class

Software Instance 
[cmdb_software_instance]

Reference Hardware [cmdb_ci_hardware]

Accessing the connection details of Service Graph Connector for VMware Workspace ONE 
UEM

You can access the connection details of the Service Graph Connector for VMware Workspace 
ONE UEM  in a single view using the common connection framework (CCF) included within the 
Integration Commons for CMDB  (sn_cmdb_int_util) store app.

With the CCF, you can access all the connections used by the Service Graph Connector for 
VMware Workspace ONE UEM. The connection details include the connection alias, connection 
properties, data sources, and scheduled data imports associated with a connection. You can 
also test the connection. For more information, see Accessing the connection details of Service 
Graph Connectors.

Access the details of a VMware  Workspace ONE UEM  connection

Access the details of a VMware  Workspace ONE UEM  connection configured for the Service 
Graph Connector for VMware Workspace ONE UEM.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Service Graph Connectors  > Workspace ONE UEM  > Connections.

2. From the Name  column of the Service Graph Connections list, select a connection.

3. On the Service Graph Connections page, view the connection details such as the connection 
name, alias, and data sources.

4. Select a related list to view further details of the connection.

5. Optional:  Select the Test Connection  related link to test the connection.

Related topics

Service Graph Connector for VMware Workspace ONE UEM

Service Graph Connector for Wiz

Use the Service Graph Connector for Wiz  to ingest CMDB  data from projects within the Wiz 
platform  using the REST APIs.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .
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Key features

• Get started quickly with a streamlined onboarding process.

• Use only the credentials you need.

• Be instantly aware of any modifications with near real-time discovery of changes.

• Get visibility across multiple cloud environments.

• Identify risks in the environment through Wiz.

• Assess application dependencies.

• Get the most out of your security incident response and endpoint management with the 
ServiceNow AI Platform.

Supported versions

Versions

Wiz ServiceNow

Last tested on April 07, 2025 • Washington DC

• Xanadu

• Yokohama

Use cases

You can use the Service Graph Connector for Wiz  to get visibility into cloud resource identities, 
relationships, and state in real-time.

Configuring a connection for the connector

You can configure a connection for the connector by using the SGC Central  view in the CMDB 
Workspace  enables you to discover and install connectors, and then effectively manage the 
full life cycle of creating, editing, monitoring, and debugging connections. To configure the 
connector using SGC Central, see Configure Service Graph Connector for Wiz using SGC 
Central.

Important: 
Unless there are configuration issues, use the SGC Central  view in the CMDB Workspace 
to configure the connection for the connector, as the guided setup method is being 
deprecated.

CMDB integrations dashboard

The Integration Commons for CMDB  store app provides a dashboard with a central view of the 
status, processing results, and processing errors of all installed integrations. You can see metrics 
for all integration runs. You can filter the view to a specific CMDB  integration, a specific time 
duration, or a specific integration run. For more details about monitoring Wiz  integrations in the 
CMDB  Integrations Dashboard, see Using the CMDB Integrations Dashboard.
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Data mapping

Data from the Wiz  data sources is mapped and transformed into the ServiceNow  CMDB 
Configuration Item (CI) class definitions using the Robust Transform Engine (RTE). Data is 
inserted into the ServiceNow  CMDB  using the Identification and Reconciliation Engine (IRE).

When you complete setting up the connection, you can configure the integration to periodically 
pull data from the Wiz  application.

Note: 
For any discovered resources that were deleted later, the Service Graph Connector for Wiz 
automatically marks the corresponding records as retired or absent in CMDB.

The following table lists the data sources, the staging tables, and the target tables CMDB  CI 
classes and non-CMDB  classes where data is stored for a Wiz  project.

Data sources mapping for Wiz

Data source Staging table Target tables

SG-Wiz-
Organization

SG-Wiz-Organization 
[sn_wiz_integ_sg_wiz_organization]

Cloud Organizations

SG-Wiz Extension Attributes

Google Organization Folder

SG-Wiz-
Subscription

SG-Wiz-Subscription 
[sn_wiz_integ_sg_wiz_subscription]

Cloud Service Account

Google Organization Project

SG-Wiz Extension Attributes

Key Value

SG-Wiz-
Datacenter

SG-Wiz-Datacenter 
[sn_wiz_integ_sg_wiz_datacenter]

AWS Datacenter

Azure Datacenter

Google Datacenter

SG-Wiz Extension Attributes

SG-Wiz-
Resource-
Group

SG-Wiz-Resource-Group 
[sn_wiz_integ_sg_wiz_resource_group]

Resource Group

SG-Wiz Extension Attributes

Key Value

SG-Wiz-
Network-
Interface

SG-Wiz-Network-Interface 
[sn_wiz_integ_sg_wiz_network_interface]

Cloud Mgmt Network Interface

SG-Wiz Extension Attributes

Key Value

SG-Wiz-
Virtual-
Network

SG-Wiz-Virtual-Network 
[sn_wiz_integ_sg_wiz_virtual_network]

Cloud Network

SG-Wiz Extension Attributes

Key Value
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Data sources mapping for Wiz  (continued)

Data source Staging table Target tables

SG-Wiz-
Firewall

SG-Wiz-Firewall [sn_wiz_integ_sg_wiz_firewall] Compute Security GroupKey 
Value

SG-Wiz-
Volume

SG-Wiz-Volume [sn_wiz_integ_sg_wiz_volume] Storage Volume

Cloud Disk Type

SG-Wiz Extension Attributes

Key Value

SG-Wiz-
Virtual-
Machine

SG-Wiz-Virtual-Machine 
[sn_wiz_integ_sg_wiz_virtual_machine] Virtual Machine Instance

Hardware Type

Linux Server

Windows Server

Server

Key Value

SG-Wiz Extension Attributes

SG-Wiz-
Virtual-
Machine-
Image

SG-Wiz-Virtual-Machine-Image 
[sn_wiz_integ_sg_wiz_virtual_machine_image] Image

Note: 
Data with no 
subscription IDs 
for images aren't 
imported. Also, if the 
subscription ID for 
an image is available, 
but the subscription-
specific details are not 
available in Wiz, the data 
isn't imported by the 
connector.

Key Value

SG-Wiz Extension Attributes

SG-Wiz-
Load 
Balancer

SG-Wiz-Load Balancer 
[sn_wiz_integ_sg_wiz_load_balancer]

Cloud Load Balancer

Key Value

SG-Wiz Extension Attributes

SG-Wiz-
Database

SG-Wiz-Database 
[sn_wiz_integ_sg_wiz_database]

Cloud DataBase

Cloud DataBase Cluster

DynamoDB Table
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Data sources mapping for Wiz  (continued)

Data source Staging table Target tables

Key Value

SG-Wiz Extension Attributes

SG-Wiz-
Bucket

SG-Wiz-Bucket [sn_wiz_integ_sg_wiz_bucket] Cloud Object Storage

Key Value

SG-Wiz Extension Attributes

SG-Wiz-
Serverless

SG-Wiz-Serverless 
[sn_wiz_integ_sg_wiz_serverless]

Cloud Function

Key Value

SG-Wiz Extension Attributes

SG-Wiz-
Network-
Address

SG-Wiz-Network-Address 
[sn_wiz_integ_sg_wiz_network_address]

Cloud Public IP Address

Key Value

SG-Wiz Extension Attributes

SG-Wiz-
Storage-
Account

SG-Wiz-Storage-Account 
[sn_wiz_integ_sg_wiz_storage_account]

Cloud Storage Account

Key Value

SG-Wiz Extension Attributes

SG-Wiz-API-
Gateway

SG-Wiz-API-Gateway 
[sn_wiz_integ_sg_wiz_api_gateway]

Cloud Gateway

Key Value

SG-Wiz Extension Attributes

SG-Wiz-
Snapshot

SG-Wiz-Snapshot 
[sn_wiz_integ_sg_wiz_snapshot]

Storage Volume Snapshot

Key Value

SG-Wiz Extension Attributes

SG-Wiz 
Kubernetes 
Cluster

SG-Wiz Kubernetes Cluster 
[sn_wiz_integ_sg_wiz_k8s_cluster]

Kubernetes Cluster

Key Value

SG-Wiz Extension Attributes

SG-Wiz 
Kubernetes 
Namespace

SG-Wiz-K8s Namespace 
[sn_wiz_integ_sg_wiz_k8s_namespace]

Kubernetes Namespace

Key Value

SG-Wiz Extension Attributes

SG-Wiz-
Kubernetes 
Node

SG-Wiz-Kubernetes Node 
[sn_wiz_integ_sg_wiz_kubernetes_node]

Kubernetes Node

Key Value
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Data sources mapping for Wiz  (continued)

Data source Staging table Target tables

SG-Wiz Extension Attributes

SG-Wiz-
Kubernetes 
Deployment

SG-Wiz-Kubernetes Deployment 
[sn_wiz_integ_sg_wiz_kubernetes_deployment]

Kubernetes Deployment

Key Value

SG-Wiz Extension Attributes

SG-Wiz-
Kubernetes 
Service

SG-Wiz-Kubernetes Service 
[sn_wiz_integ_sg_wiz_kubernetes_service]

Kubernetes Service

Key Value

SG-Wiz Extension Attributes

SG-Wiz-
Kubernetes 
Pod

SG-Wiz-Kubernetes Pod 
[sn_wiz_integ_sg_wiz_kubernetes_pod]

Kubernetes Pod

Key Value

SG-Wiz Extension Attributes

SG-Wiz-
Kubernetes 
Replica Set

SG-Wiz-Kubernetes Replica Set 
[sn_wiz_integ_sg_wiz_kubernetes_replica_set]

Kubernetes ReplicaSet

Key Value

SG-Wiz Extension Attributes

SG-Wiz 
Kubernetes 
Container

SG-Wiz Kubernetes Container 
[sn_wiz_integ_sg_wiz_kubernetes_container]

Docker Container

SG-Wiz Extension Attributes

SG-Wiz-
Compute 
Instance 
Group

SG-Wiz-Compute Instance Group 
[sn_wiz_integ_sg_wiz_compute_instance_group]

Instance Scale Set

SG-Wiz Extension Attributes

Key Value

Note: 
All the labels or tags associated with a Wiz  resource are added to the Key Value 
[cmdb_key_value] table and the project information about a Wiz  resource is stored in the 
SG-Wiz Extension Attributes [sn_wiz_integ_extension_attributes] table.

For more information on where data is saved when pulling data from a Wiz  project, see Target 
tables for storing Service Graph Connector for Wiz data  and Supported Wiz types.

You can use the IntegrationHub ETL app to view the data maps. See IntegrationHub ETL  for more 
information.

Related topics

Service Graph Connectors

Set up the Wiz  environment

You must obtain the credentials associated with the Wiz  service account to configure Wiz  for use 
with the Service Graph Connector for Wiz.
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Before you begin
Role required: Wiz  user with a role that has Write (W) permission on service accounts

About this task
To create a service account, you must be logged in as a Wiz  user with Write (W) permission on 
service accounts. Project-scoped roles can create service accounts only on their own projects.

For more information on obtaining Wiz  details, see Add a Service Account  on the Wiz 
documentation site (requires Wiz  login).

Procedure

1. Log in to your Wiz  dashboard.

2. Obtain the Wiz URL.

a. Navigate to your user profile and copy the API Endpoint URL.

Note: 
The Service Graph Connector for Wiz  uses the following token URL:

https://auth.app.wiz.io/oauth/token

3. Obtain the client ID and client secret.

a. Navigate to Settings  > Service Accounts.

b. Select Add Service Account.

c. Name the new service account.

d. Optional:  In the Projects list, select projects to limit access of the service account.

e. In the API Scopes  field, select the permissions read:resources  and read:projects.

f. Select Add Service Account.

g. From the Copy your secret credentials dialog box that appears, copy the client secret and 
client ID from their respective fields.

h. Select Finish  to return to the Wiz  dashboard.

Configure Service Graph Connector for Wiz  using SGC Central

Set up scheduled import jobs to pull in data from a Wiz  project into your Configuration 
Management Database (CMDB).

Before you begin

• Install Service Graph Connector for Wiz  version 1.3.0 or later from the ServiceNow Store. For 
ServiceNow Store  installation steps, see Install a ServiceNow Store application .

• You must obtain the OAuth credentials associated with the Wiz  service account and make a 
note of the following details:

◦ Client ID

◦ Client secret

◦ OAuth token URL

◦ Connection URL
For more information, see Set up the Wiz environment.

• You must have the following permissions for the Wiz  service account:
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◦ read:resources

◦ read:projects

Role required: cmdb_inst_admin or admin

About this task
The playbook experience for onboarding connectors is activated with SGC Central  in the CMDB 
Workspace. To configure the SGC Central  application, see Configuring SGC Central  and for more 
information on how to interact with a playbook, see Interact with Playbook .

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the CMDB Workspace, select SGC Central.

3. On the Overview page, select Create connection.

Tip: 
Alternatively, you can select Create connection  on the All connections page.

4. On the Create connection window, select the Wiz  connector type, and then select Configure 
connection.
A default connection, SG-Wiz, for Wiz  is available within the application. As the Service Graph 
Connector for Wiz  supports only a single instance, you can configure the default connection 
for the first time or resume editing it thereafter.

5. Complete the initial prerequisites when setting up a connection for the first time using a 
connector.

Note: 
This step is required when configuring the connector for the first time only. See Perform 
initial setup tasks when creating a connection in SGC Central.

6. Enter connection details and test the API connection for importing Wiz  data.

a. In the Setup  stage of the playbook, select the Create and test connection  activity.

b. On the form, fill in the fields.

Create and test connection form

Field Description

Connection name Name to identify the Wiz  connection record.

Connection URL Base URL to connect to your Wiz  application.
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Field Description

Note: 
Based on the region of your Wiz 
application, enter the connection URL 
in the following format:

https://api.<region>.app.
wiz.io

Where <region>  is the region where 
the Wiz tenant  is located. For example, 
us1, us2, eu1, or eu2.

Client ID Client ID of your Wiz  application as 
described in Before you begin.

Client secret Client secret of your Wiz  application as 
described in Before you begin.

OAuth token URL Token generation URL. This field is 
automatically set to the following URL:

https://auth.app.wiz.io/oau
th/token

c. Select Update and test connection.

d. Once the connection test is complete, select Continue.

7. Optional:  Configure properties of the connector to access resources.

Note: 
To skip this step, select Continue  for the Set configuration properties  activity.

a. In the Setup  stage of the playbook, select the Set configuration properties  activity.

b. On the form, fill in the fields.

Configuration properties

Field Description

Projects List of project IDs for which the resources are to be imported.

(Optional) Separate multiple entries with a comma.

Exclude 
projects

List of project IDs for which the resources are excluded only when the Projects 
property isn’t set. In this case, all the resources except for the specified projects 
are imported.

Separate multiple entries with a comma.

c. Select Continue.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1444



8. Configure the import schedule to import data at regular intervals.

a. In the Setup  stage of the playbook, select the Configure import schedule  activity.

b. Expand the Parent scheduled data import within the Import schedules list to select the SG-
Wiz-Organization  import schedule.

c. Select the Active  check box, and then fill in the run schedule and time details.

For more information, see Schedule a data import .

d. Select Save.
Alternatively, select Execute Now  to execute the import schedule immediately.

9. Optional:  Enable the Reset Last Run Datetime for SG-Wiz  script to retrieve full 
data periodically.

Note: 
To skip this step, select Skip  for the Enable full data retrieval  activity.

a. In the Setup  stage of the playbook, select the Enable full data retrieval  activity.

b. Select the Active  check box, and then fill in the run schedule and time details.

Note: 
When active, the script clears the Last Run Date Time  field value in a data source, 
ensuring that the SG-Wiz Organization scheduled job retrieves all Wiz-related data 
sources periodically.

c. Select Continue.

10. In the Setup  stage of the playbook, select the Confirm connection creation  activity to verify 
whether the connection was created.

What to do next
Select View all connections  to review the connection details. The created connection appears in 
the Installed connections list.

Related topics

Service Graph Connector for Wiz

Target tables for storing Service Graph Connector for Wiz data

Service Graph Connector for Wiz properties

Supported Wiz types

Accessing the connection details of Service Graph Connector for Wiz

Configure Service Graph Connector for Wiz  using guided setup

Set up scheduled import jobs to pull in data from a Wiz  project into your CMDB.
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Before you begin
Important: 
Unless there are configuration issues, use the SGC Central  view in the CMDB Workspace 
to configure the connection for the connector, as the guided setup method is being 
deprecated.

To use this Service Graph Connector, you need a subscription to a Subscription Unit that is 
based in the IT Operations Management  (ITOM) Visibility application or in the ITOM  Discovery 
application. As defined in the section titled "Managed IT Resource Types" in ServiceNow 
Subscription Unit Overview  for your subscription, for managed IT resources that are created 
or modified in the CMDB  by this Service Graph Connector, but that aren’t yet managed by ITOM 
Visibility or ITOM Discovery , these resources will increase Subscription Unit consumption from 
that application. Review your current Subscription Unit consumption within ITOM Visibility or 
ITOM Discovery to ensure available capacity.

Dependencies and requirements:

• Wiz  advanced or standard license

• The Integration Commons for CMDB store app, which is automatically installed. See 
Integration Commons for CMDB.

• The CMDB CI class models store app, which is automatically installed. See CMDB CI Class 
Models store app.

• ITOM Licensing plugin (com.snc.itom.license). See Request Discovery .

• Discovery and Service Mapping Patterns (sn_itom_pattern). See Install Discovery and Service 
Mapping Patterns .

• Discovery Core (com.snc.discovery.core)

You must obtain the OAuth credentials associated with the Wiz  service account and make a note 
of the following details:

• Client ID

• Client Secret

• OAuth Token URL

• Connection URL

See Set up the Wiz environment.

You must have the following permissions for the Wiz  service account:

• read:resources

• read:projects

Role required: admin

Procedure

1. Verify that the application scope is set to the Service Graph Connector for Wiz  application by 
using the application picker.
For more information, see Application picker .

2. Navigate to All  > Service Graph Connectors  > Wiz  > Setup.

3. On the Service Graph Connector for Wiz  page, verify that the Quick Start  option is selected 
and then select Continue.

4. Configure the connection to send requests to the Wiz  application.
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a. In the Configure the Connection and Credentials  section of the Service Graph Connector for 
Wiz  page, select Start.

b. Configure the connection.

i. Select the Configure the Connection  task and then select Click Here.

ii. On the Connections page that opens in another browser tab, select Edit  for the SG-Wiz 
connection that is available by default.

iii. On the form, fill in the fields.

Edit Connection form

Field Description

Connection 
Name

Name to identify the connection record. For example, SG-Wiz.

Don’t modify the name for the default connection alias SG-Wiz.

Connection 
URL

Base URL to connect to your Wiz  application.

Note: 
Based on the region of your Wiz  application, enter the connection 
URL in the following format:

https://api.<region>.app.wiz.io

Where <region>  is the region where the Wiz tenant  is located. For 
example, us1, us2, eu1, or eu2.

Client ID Client ID of your Wiz  application as described in Before you begin.

Client 
Secret

Client secret of your Wiz  application as described in Before you begin.

OAuth 
Token URL

Token generation URL. This field is automatically set to the following URL:

https://auth.app.wiz.io/oauth/token

iv. Select Edit and Get OAuth Token.

v. Return to the guided setup.

vi. Set the Configure the Connection  task to complete by selecting the Mark as complete 
check box and then select Continue.

c. Configure the connection properties.

i. Select the Add configuration properties  task.

ii. In the Service Graph Connections  section, review and modify the property details 
by selecting a property from the Property  column in the Service Graph Connection 
Properties related list.

You can configure the following properties:

Projects

A list of comma-separated project IDs for which the resources are to be 
pulled.
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Exclude Projects

A list of comma-separated project IDs for which the resources are excluded 
only when the Projects  property isn’t set. In this case, all the resources 
except for the specified projects are imported.

Note: 
If no property is configured, data from all the Wiz  projects are fetched.

iii. Select Update  in the Service Graph Connection Properties section.

iv. Set the Add connection properties  task to complete by selecting the Mark as complete 
check box and then select Continue.

d. Test the Wiz  API connection to import data from the Wiz  application.

i. Select the Test Connection  task.

ii. Test the connection by selecting the Test Connection  related link.

Testing the connection might take a few moments. The page is refreshed to show the test 
results.

iii. When the Status  field is set to Success, select Update.

If any of the tests have errors, follow the suggestions for remediation.

iv. Set the Test Connection  task to complete by selecting the Mark as complete  check box 
and then select Continue.

5. Configure the scheduled jobs to import data from the Wiz  application.

a. Configure the scheduled job for the complete (full) import of data during the initial execution, 
and then incremental (delta) import of data on subsequent executions.

i. Select the Configure the scheduled jobs  task.

ii. Select the SG-Wiz-Organization  scheduled job.

iii. On the Scheduled Data Import form, verify the field values for the scheduled job.

For more information, see Schedule a data import .

iv. Select the Active  check box to activate the SG-Wiz-Organization scheduled job.

v. In the Run  field, select Periodically  to specify how often the job will run.

vi. Select Update.

vii. Set the Configure the scheduled jobs  task to complete by selecting the Mark as complete 
check box and then select Continue.

b. Configure the Reset Last Run Datetime for SG-Wiz scheduled script to enable full pull for 
subsequent execution of the scheduled job.

Note: 
To fetch the complete data using a data source on subsequent executions, you must 
remove the Last Run Date Time  field value from a data source. The Reset Last Run 
Datetime for SG-Wiz scheduled script provided with the connector resets the Last Run 
Date Time  field value automatically. Therefore, confirming that the SG-Wiz Organization 
scheduled job executes all data sources for a full pull.
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i. Select the Configure the scheduled script for full data retrieval  task.

ii. Select the Active  check box to activate the SG-Wiz scheduled script.

iii. In the Run  field, select Periodically  to specify how often the script will run.

For more information, see Automatically run a script of your choosing .

iv. Select Update.

v. Set the Configure the scheduled script for full data retrieval  task to complete by selecting 
the Mark as complete  check box and then select Continue.

6. On the Service Graph Connector for Wiz  page, select Complete  to save your changes.

7. In Complete setup dialog box, select Complete  to complete the setup.

8. In the message box that appears, select Done.

Target tables for storing Service Graph Connector for Wiz  data

When you complete setting up the connection, you can configure the integration to periodically 
pull data from a Wiz  project. The data is saved in tables that extend from the CMDB  CI classes 
and other non-CMDB classes.

AWS Datacenter [cmdb_ci_aws_datacenter]

The following attributes in the AWS Datacenter [cmdb_ci_aws_datacenter] table are populated by 
collected data:

Attribute label Attribute name Wiz  attribute

Name name name

Object ID object_id externalId

Region region name

Relationships created for AWS Datacenter

Parent class Relationship type Child class

AWS Datacenter 
[cmdb_ci_aws_datacenter]

Hosted on::Hosts Cloud Service Account 
[cmdb_ci_cloud_service_account]

AWS Datacenter 
[cmdb_ci_aws_datacenter]

Reference SG-Wiz Extension Attributes 
[sn_wiz_integ_extension_attributes]

Azure Datacenter [cmdb_ci_azure_datacenter]

The following attributes in the Azure Datacenter [cmdb_ci_azure_datacenter]  table are populated 
by collected data.

Attribute label Attribute name Wiz  attribute

Name name name

Object ID object_id externalId
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Attribute label Attribute name Wiz  attribute

Region region name

Relationships created for Azure Datacenter

Parent class Relationship type Child class

Azure Datacenter 
[cmdb_ci_azure_datacenter]

Hosted on::Hosts Cloud Service Account 
[cmdb_ci_cloud_service_account]

Azure Datacenter 
[cmdb_ci_azure_datacenter]

Contains::Contained by Resource Group 
[cmdb_ci_resource_group]

Azure Datacenter 
[cmdb_ci_azure_datacenter]

Reference SG-Wiz Extension Attributes 
[sn_wiz_integ_extension_attributes]

Cloud DataBase [cmdb_ci_cloud_database]

The following attributes in the Cloud DataBase [cmdb_ci_cloud_database] table are populated by 
collected data:

Attribute label Attribute name Wiz  attribute

Name name name

Object ID object_id externalId

Install Status install_status None

Type type nativeType

Relationships created for Cloud DataBase

Parent class Relationship type Child class

Cloud DataBase 
[cmdb_ci_cloud_database]

Hosted on::Hosts Cloud Service Account 
[cmdb_ci_cloud_service_account]

Cloud DataBase 
[cmdb_ci_cloud_database]

Reference SG-Wiz Extension Attributes 
[sn_wiz_integ_extension_attributes]

Cloud DataBase 
[cmdb_ci_cloud_database]

Reference Key Value [cmdb_key_value]

Cloud DataBase Cluster [cmdb_ci_cloud_db_cluster]

The following attributes in the Cloud DataBase Cluster [cmdb_ci_cloud_db_cluster] table are 
populated by collected data:

Attribute label Attribute name Wiz  attribute

Cluster ID cluster_id externalId

Name name name

Cluster Type cluster_type kind

Install Status install_status None
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Attribute label Attribute name Wiz  attribute

Vendor vendor None

Relationships created for Cloud DataBase Cluster

Parent class Relationship type Child class

Cloud DataBase Cluster 
[cmdb_ci_cloud_db_cluster]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Cloud DataBase Cluster 
[cmdb_ci_cloud_db_cluster]

Reference Key Value [cmdb_key_value]

Cloud DataBase Cluster 
[cmdb_ci_cloud_db_cluster]

Reference SG-Wiz Extension Attributes 
[sn_wiz_integ_extension_attributes]

Cloud Disk Type [cmdb_ci_disk_type]

The following attributes in the Cloud Disk Type [cmdb_ci_disk_type] table are populated by 
collected data:

Attribute label Attribute name Wiz  attribute

Name name properties.volumeType, zone

Object ID object_id properties.volumeType, zone

Relationship created for Cloud Disk Type

Parent class Relationship type Child class

Cloud Disk Type 
[cmdb_ci_disk_type]

Hosted on::Hosts Google Datacenter 
[cmdb_ci_google_datacenter]

Cloud Function [cmdb_ci_cloud_function]

The following attributes in the Cloud Function [cmdb_ci_cloud_function] table are populated by 
collected data:

Attribute label Attribute name Wiz  attribute

Name name name

Object ID object_id externalId

CodeSha256 codesha256 awsLambda_codeSha256

Install Status install_status None

Language language runtime

Relationships created for Cloud Function

Parent class Relationship type Child class

Cloud Function 
[cmdb_ci_cloud_function]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]
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Relationships created for Cloud Function  (continued)

Parent class Relationship type Child class

Cloud Function 
[cmdb_ci_cloud_function]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Cloud Function 
[cmdb_ci_cloud_function]

Hosted on::Hosts Google Datacenter 
[cmdb_ci_google_datacenter]

Cloud Function 
[cmdb_ci_cloud_function]

Reference SG-Wiz Extension Attributes 
[sn_wiz_integ_extension_attributes]

Cloud Function 
[cmdb_ci_cloud_function]

Reference Key Value [cmdb_key_value]

Cloud Gateway [cmdb_ci_cloud_gateway]

The following attributes in the Cloud Gateway [cmdb_ci_cloud_gateway] table are populated by 
collected data:

Attribute label Attribute name Wiz  attribute

Name name name

Object ID object_id externalId (for Azure)

providerUniqueId (for AWS)

Install Status install_status None

Relationships created for Cloud Gateway

Parent class Relationship type Child class

Cloud Gateway 
[cmdb_ci_cloud_gateway]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]

Cloud Gateway 
[cmdb_ci_cloud_gateway]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Cloud Gateway 
[cmdb_ci_cloud_gateway]

Reference SG-Wiz Extension Attributes 
[sn_wiz_integ_extension_attributes]

Cloud Gateway 
[cmdb_ci_cloud_gateway]

Reference Key Value [cmdb_key_value]

Cloud Load Balancer [cmdb_ci_cloud_load_balancer]

The following attributes in the Cloud Load Balancer [cmdb_ci_cloud_load_balancer] table are 
populated by collected data:

Attribute label Attribute name Wiz  attribute

Name name name

Object ID object_id name (for AWS Load Balancer 
v1)
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Attribute label Attribute name Wiz  attribute

externalId (for Azure and AWS 
Load Balancer v2)

Install Status install_status None

Relationships created for Cloud Load Balancer

Parent class Relationship type Child class

Cloud Load Balancer 
[cmdb_ci_cloud_load_balancer]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]

Cloud Load Balancer 
[cmdb_ci_cloud_load_balancer]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Cloud Load Balancer 
[cmdb_ci_cloud_load_balancer]

Hosted on::Hosts Google Datacenter 
[cmdb_ci_google_datacenter]

Cloud Load Balancer 
[cmdb_ci_cloud_load_balancer]

Reference Key Value [cmdb_key_value]

Cloud Load Balancer 
[cmdb_ci_cloud_load_balancer]

Reference SG-Wiz Extension Attributes 
[sn_wiz_integ_extension_attributes]

Cloud Mgmt Network Interface [cmdb_ci_nic]

The following attributes in the Cloud Mgmt Network Interface [cmdb_ci_nic] table are populated 
by collected data:

Attribute label Attribute name Wiz  attribute

MAC Address mac_address macAddress

Name name name

Object ID object_id externalId

Install Status install_status None

Relationships created for Cloud Mgmt Network Interface

Parent class Relationship type Child class

Cloud Mgmt Network Interface 
[cmdb_ci_nic]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]

Cloud Mgmt Network Interface 
[cmdb_ci_nic]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Cloud Mgmt Network Interface 
[cmdb_ci_nic]

Hosted on::Hosts Google Datacenter 
[cmdb_ci_google_datacenter]

Cloud Mgmt Network Interface 
[cmdb_ci_nic]

Reference Key Value [cmdb_key_value]

Cloud Mgmt Network Interface 
[cmdb_ci_nic]

Reference SG-Wiz Extension Attributes 
[sn_wiz_integ_extension_attributes]
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Cloud Network [cmdb_ci_network]

The following attributes in the Cloud Network [cmdb_ci_network] table are populated by 
collected data:

Attribute label Attribute name Wiz  attribute

Name name name

Object ID object_id externalId

Cidr cidr addressRanges

Install Status install_status None

Relationships created for Cloud Network

Parent class Relationship type Child class

Cloud Network 
[cmdb_ci_network]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]

Cloud Network 
[cmdb_ci_network]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Cloud Network 
[cmdb_ci_network]

Reference Key Value [cmdb_key_value]

Cloud Network 
[cmdb_ci_network]

Reference SG-Wiz Extension Attributes 
[sn_wiz_integ_extension_attributes]

Cloud Object Storage [cmdb_ci_cloud_object_storage]

The following attributes in the Cloud Object Storage [cmdb_ci_cloud_object_storage] table are 
populated by collected data:

Attribute label Attribute name Wiz  attribute

Name name name

Object ID object_id externalId (for Azure and GCP)

providerUniqueId (for AWS)

Cloud Provider cloud_provider cloudPlatform

Install Status install_status None

Relationships created for Cloud Object Storage

Parent class Relationship type Child class

Cloud Object Storage 
[cmdb_ci_cloud_object_storage]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]

Cloud Object Storage 
[cmdb_ci_cloud_object_storage]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]
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Relationships created for Cloud Object Storage  (continued)

Parent class Relationship type Child class

Cloud Object Storage 
[cmdb_ci_cloud_object_storage]

Hosted on::Hosts Google Datacenter 
[cmdb_ci_google_datacenter]

Cloud Object Storage 
[cmdb_ci_cloud_object_storage]

Reference SG-Wiz Extension Attributes 
[sn_wiz_integ_extension_attributes]

Cloud Object Storage 
[cmdb_ci_cloud_object_storage]

Reference Key Value [cmdb_key_value]

Cloud Organizations [cmdb_ci_cloud_org]

The following attributes in the Cloud Organizations [cmdb_ci_cloud_org] table are populated by 
collected data:

Attribute label Attribute name Wiz  attribute

Object ID object_id ProviderUniqueId(AWS  and 
Azure), externalid (for GCP)

Name name name

Relationships created for Cloud Organizations

Parent class Relationship type Child class

Cloud Organizations 
[cmdb_ci_cloud_org]

Contains::Contained by Cloud Service Account 
[cmdb_ci_cloud_service_account]

Cloud Organizations 
[cmdb_ci_cloud_org]

Reference SG-Wiz Extension Attributes 
[sn_wiz_integ_extension_attributes]

Cloud Public IP Address [cmdb_ci_cloud_public_ipaddress]

The following attributes in the Cloud Public IP Address [cmdb_ci_cloud_public_ipaddress] table 
are populated by collected data:

Attribute label Attribute name Wiz  attribute

Name name name

Object ID object_id externalId

Install Status install_status None

Public IP Address public_ip_address address

Relationships created for Cloud Public IP Address

Parent class Relationship type Child class

Cloud Public IP Address 
[cmdb_ci_cloud_public_ipaddress]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]
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Relationships created for Cloud Public IP Address  (continued)

Parent class Relationship type Child class

Cloud Public IP Address 
[cmdb_ci_cloud_public_ipaddress]

Hosted on::Hosts Google Datacenter 
[cmdb_ci_google_datacenter]

Cloud Public IP Address 
[cmdb_ci_cloud_public_ipaddress]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Cloud Public IP Address 
[cmdb_ci_cloud_public_ipaddress]

Reference SG-Wiz Extension Attributes 
[sn_wiz_integ_extension_attributes]

Cloud Public IP Address 
[cmdb_ci_cloud_public_ipaddress]

Reference Key Value [cmdb_key_value]

Cloud Service Account [cmdb_ci_cloud_service_account]

The following attributes in the Cloud Service Account [cmdb_ci_cloud_service_account] table are 
populated by collected data:

Attribute label Attribute name Wiz  attribute

Account Id account_id externalId

Name name name

Object ID object_id externalId

Datacenter Type datacenter_type cloudPlatform

Is master account is_master_account ProviderUniqueID (AWS  only)

Organization Id organization_id ProviderUniqueID (AWS  only)

Parent account parent_account ProviderUniqueID (AWS  only)

Relationships created for Cloud Service Account

Parent class Relationship type Child class

Cloud Service Account 
[cmdb_ci_cloud_service_account]

Reference Cloud Service Account 
[cmdb_ci_cloud_service_account]

Cloud Service Account 
[cmdb_ci_cloud_service_account]

Reference Key Value [cmdb_key_value]

Cloud Service Account 
[cmdb_ci_cloud_service_account]

Reference SG-Wiz Extension Attributes 
[sn_wiz_integ_extension_attributes]

Cloud Storage Account [cmdb_ci_cloud_storage_account]

The following attributes in the Cloud Storage Account [cmdb_ci_cloud_storage_account] table 
are populated by collected data:

Attribute label Attribute name Wiz  attribute

Name name name

Object ID object_id externalId
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Attribute label Attribute name Wiz  attribute

Install Status install_status None

Relationships created for Cloud Storage Account

Parent class Relationship type Child class

Cloud Storage Account 
[cmdb_ci_cloud_storage_account]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]

Cloud Storage Account 
[cmdb_ci_cloud_storage_account]

Reference Key Value [cmdb_key_value]

Cloud Storage Account 
[cmdb_ci_cloud_storage_account]

Reference SG-Wiz Extension Attributes 
[sn_wiz_integ_extension_attributes]

Compute Security Group [cmdb_ci_compute_security_group]

The following attributes in the Compute Security Group [cmdb_ci_compute_security_group] table 
are populated by collected data:

Attribute label Attribute name Wiz  attribute

Name name name

Object ID object_id externalId

Install Status install_status None

Region region region

Relationships created for Compute Security Group

Parent class Relationship type Child class

Compute Security Group 
[cmdb_ci_compute_security_group]

Hosted on::Hosts Cloud Service Account 
[cmdb_ci_cloud_service_account]

Compute Security Group 
[cmdb_ci_compute_security_group]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]

Compute Security Group 
[cmdb_ci_compute_security_group]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Compute Security Group 
[cmdb_ci_compute_security_group]

Reference SG-Wiz Extension Attributes 
[sn_wiz_integ_extension_attributes]

Compute Security Group 
[cmdb_ci_compute_security_group]

Reference Key Value [cmdb_key_value]

Docker Container [cmdb_ci_docker_container]

The following attributes in the Docker Container [cmdb_ci_docker_container] table are populated 
by collected data:
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Attribute label Attribute name Wiz  attribute

Container id container_id externalId (for Kubernetes, 
ACA, and ACI)

providerUniqueId (for ECS)

Image id image_id image

Install Status install_status None

Name name name

Relationships created for Docker Container

Parent class Relationship type Child class

Docker Container 
[cmdb_ci_docker_container]

Hosts:: Hosted on AWS Datacenter 
[cmdb_ci_aws_datacenter] (for 
ECS)

Docker Container 
[cmdb_ci_docker_container]

Hosts:: Hosted on Azure Datacenter 
[cmdb_ci_azure_datacenter] 
(for ACA, ACI)

Docker Container 
[cmdb_ci_docker_container]

Reference SG-Wiz Extension Attributes 
[sn_wiz_integ_extension_attributes]

DynamoDB Table [cmdb_ci_dynamodb_table]

The following attributes in the DynamoDB Table [cmdb_ci_dynamodb_table] table are populated 
by collected data:

Attribute label Attribute name Wiz  attribute

Name name name

Object ID object_id name

Install Status install_status None

Relationships created for DynamoDB Table

Parent class Relationship type Child class

DynamoDB Table 
[cmdb_ci_dynamodb_table]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

DynamoDB Table 
[cmdb_ci_dynamodb_table]

Reference SG-Wiz Extension Attributes 
[sn_wiz_integ_extension_attributes]

DynamoDB Table 
[cmdb_ci_dynamodb_table]

Reference Key Value [cmdb_key_value]

Google Datacenter [cmdb_ci_google_datacenter]

The following attributes in the Google Datacenter [cmdb_ci_google_datacenter] table are 
populated by collected data:
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Attribute label Attribute name Wiz  attribute

Name name name

Object ID object_id properties.externalId

Region region region

Relationships created for Google Datacenter

Parent class Relationship type Child class

Google Datacenter 
[cmdb_ci_google_datacenter]

Hosted on::Hosts Cloud Service Account 
[cmdb_ci_cloud_service_account]

Google Datacenter 
[cmdb_ci_google_datacenter]

Reference SG-Wiz Extension Attributes 
[sn_wiz_integ_extension_attributes]

Google Organization Folder [cmdb_ci_gcp_folder]

The following attributes in the Google Organization Folder [cmdb_ci_gcp_folder] table are 
populated by collected data:

Attribute label Attribute name Wiz  attribute

Object ID object_id externalId

Name name name

Relationship created for Google Organization Folder

Parent class Relationship type Child class

Google Organization Folder 
[cmdb_ci_gcp_folder]

Reference SG-Wiz Extension Attributes 
[sn_wiz_integ_extension_attributes]

Google Organization Project [cmdb_ci_gcp_project]

The following attributes in the Google Organization Project [cmdb_ci_gcp_project] table are 
populated by collected data:

Attribute label Attribute name Wiz  attribute

Name name name

Object ID object_id externalId

Project Id project_id providerUniqueId

Relationship created for Google Organization Project

Parent class Relationship type Child class

Google Organization Project 
[cmdb_ci_gcp_project]

Reference SG-Wiz Extension Attributes 
[sn_wiz_integ_extension_attributes]
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Hardware Type [cmdb_ci_compute_template]

The following attributes in the Hardware Type [cmdb_ci_compute_template] table are populated 
by collected data:

Attribute label Attribute name Wiz  attribute

Name name instanceType

Object ID object_id instanceType

Relationships created for Hardware Type

Parent class Relationship type Child class

Hardware Type 
[cmdb_ci_compute_template]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Hardware Type 
[cmdb_ci_compute_template]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]

Hardware Type 
[cmdb_ci_compute_template]

Hosted on::Hosts Google Datacenter 
[cmdb_ci_google_datacenter]

Image [cmdb_ci_os_template]

The following attributes in the Image [cmdb_ci_os_template] table are populated by collected 
data:

Attribute label Attribute name Wiz  attribute

Name name name

Object ID object_id externalId

Install Status install_status None

Relationships created for Image

Parent class Relationship type Child class

Image [cmdb_ci_os_template] Hosted on::Hosts Cloud Service Account 
[cmdb_ci_cloud_service_account]

Image [cmdb_ci_os_template] Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Image [cmdb_ci_os_template] Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]

Image [cmdb_ci_os_template] Reference SG-Wiz Extension Attributes 
[sn_wiz_integ_extension_attributes]

Image [cmdb_ci_os_template] Reference Key Value [cmdb_key_value]

Note: 
Data with no subscription IDs for images aren't imported. Also, if the subscription ID for an 
image is available, but the subscription-specific details are not available in Wiz, the data 
isn't imported by the connector.
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Instance Scale Set [cmdb_ci_instance_scale_set]

The following attributes in the Instance Scale Set [cmdb_ci_instance_scale_set] table are 
populated by collected data:

Attribute label Attribute name Wiz  attribute

Name name name

Install Status install_status None

Object ID object_id externalId

Relationships created for Instance Scale Set

Parent class Relationship type Child class

Instance Scale Set 
[cmdb_ci_instance_scale_set]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]

Instance Scale Set 
[cmdb_ci_instance_scale_set]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Instance Scale Set 
[cmdb_ci_instance_scale_set]

Reference SG-Wiz Extension Attributes 
[sn_wiz_integ_extension_attributes]

Instance Scale Set 
[cmdb_ci_instance_scale_set]

Reference Key Value [cmdb_key_value]

Key Value [cmdb_key_value]

The following attributes in the Key Value [cmdb_key_value] table are populated by collected data:

Attribute label Attribute name Wiz  attribute

Key key tags

Value value tags

Kubernetes Cluster [cmdb_ci_kubernetes_cluster]

The following attributes in the Kubernetes Cluster [cmdb_ci_kubernetes_cluster] table are 
populated by collected data:

Attribute label Attribute name Wiz  attribute

Cluster Resource ID cluster_resource_id providerUniqueId

Name name name

Install Status install_status None

Kubernetes UID k8s_uid externalId

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1461



Relationships created for Kubernetes Cluster

Parent class Relationship type Child class

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Contains::Contained by Kubernetes Service 
[cmdb_ci_kubernetes_service]

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Contains::Contained by Kubernetes Namespace 
[cmdb_ci_kubernetes_namespace]

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Hosted on::Hosts Google Datacenter 
[cmdb_ci_google_datacenter]

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Cluster of::Cluster Kubernetes Node 
[cmdb_ci_kubernetes_node]

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Contains::Contained by Kubernetes Pod 
[cmdb_ci_kubernetes_pod]

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Reference Key Value [cmdb_key_value]

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Reference SG-Wiz Extension Attributes 
[sn_wiz_integ_extension_attributes]

Kubernetes Deployment [cmdb_ci_kubernetes_deployment]

The following attributes in the Kubernetes Deployment [cmdb_ci_kubernetes_deployment] table 
are populated by collected data:

Attribute label Attribute name Wiz  attribute

Kubernetes UID k8s_uid uid

Name name name

Namespace namespace namespace

Available Replicas available_replicas status_availableReplicas

Desired Replicas desired_replicas spec_replicas

Install Status install_status None

Total Replicas total_replicas status_replicas

Updated Replicas updated_replicas status_updatedReplicas

Kubernetes Cluster cluster Kubernetes_clusterExternalID

SelfLink self_link api_version

namespace

name

Unavailable Replicas unavailable_replicas status_unavailableReplicas
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Relationships created for Kubernetes Deployment

Parent class Relationship type Child class

Kubernetes Deployment 
[cmdb_ci_kubernetes_deployment]

Hosted on::Hosts Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Kubernetes Deployment 
[cmdb_ci_kubernetes_deployment]

Reference Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Kubernetes Deployment 
[cmdb_ci_kubernetes_deployment]

Reference Key Value [cmdb_key_value]

Kubernetes Deployment 
[cmdb_ci_kubernetes_deployment]

Reference SG-Wiz Extension Attributes 
[sn_wiz_integ_extension_attributes]

Kubernetes Namespace [cmdb_ci_kubernetes_namespace]

The following attributes in the Kubernetes Namespace [cmdb_ci_kubernetes_namespace] table 
are populated by collected data:

Attribute label Attribute name Wiz  attribute

Install Status install_status None

Namespace namespace name

Kubernetes Cluster cluster Kubernetes_clusterExternalID

Name name name

Relationships created for Kubernetes Namespace

Parent class Relationship type Child class

Kubernetes Namespace 
[cmdb_ci_kubernetes_namespace]

Reference Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Kubernetes Namespace 
[cmdb_ci_kubernetes_namespace]

Reference Key Value [cmdb_key_value]

Kubernetes Namespace 
[cmdb_ci_kubernetes_namespace]

Reference SG-Wiz Extension Attributes 
[sn_wiz_integ_extension_attributes]

Kubernetes Node [cmdb_ci_kubernetes_node]

The following attributes in the Kubernetes Node [cmdb_ci_kubernetes_node] table are populated 
by collected data:

Attribute label Attribute name Wiz  attribute

IP Address ip_address status_address

Kubernetes UID k8s_uid uid

Name name name

Install Status install_status None

Kubernetes Cluster cluster Kubernetes_clusterExternalID
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Relationships created for Kubernetes Node

Parent class Relationship type Child class

Kubernetes Node 
[cmdb_ci_kubernetes_node]

Reference Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Kubernetes Node 
[cmdb_ci_kubernetes_node]

Reference Key Value [cmdb_key_value]

Kubernetes Node 
[cmdb_ci_kubernetes_node]

Reference SG-Wiz Extension Attributes 
[sn_wiz_integ_extension_attributes]

Kubernetes Pod [cmdb_ci_kubernetes_pod]

The following attributes in the Kubernetes Pod [cmdb_ci_kubernetes_pod] table are populated 
by collected data:

Attribute label Attribute name Wiz  attribute

Kubernetes UID k8s_uid uid

Namespace namespace namespace

Host IP host_ip status_hostIP

Install Status install_status None

IP Address ip_address status_podIPs

Kubernetes Cluster cluster Kubernetes_clusterExternalID

Name name name

Resource version resource_version resourceVersion

Relationships created for Kubernetes Pod

Parent class Relationship type Child class

Kubernetes Pod 
[cmdb_ci_kubernetes_pod]

Contains::Contained by Docker Container 
[cmdb_ci_docker_container]

Kubernetes Pod 
[cmdb_ci_kubernetes_pod]

Reference Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Kubernetes Pod 
[cmdb_ci_kubernetes_pod]

Reference Key Value [cmdb_key_value]

Kubernetes Pod 
[cmdb_ci_kubernetes_pod]

Reference SG-Wiz Extension Attributes 
[sn_wiz_integ_extension_attributes]

Kubernetes ReplicaSet [cmdb_ci_kubernetes_replicaset]

The following attributes in the Kubernetes ReplicaSet [cmdb_ci_kubernetes_replicaset] table are 
populated by collected data:

Attribute label Attribute name Wiz  attribute

Kubernetes UID k8s_uid uid
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Attribute label Attribute name Wiz  attribute

Name name name

Namespace namespace namespace

Available Replicas available_replicas status_availableReplicas

Desired Replicas desired_replicas spec_replicas

Install Status install_status None

SelfLink self_link api_version

namespace

name

Total Replicas total_replicas status_replicas

Kubernetes Cluster cluster Kubernetes_clusterExternalID

Relationships created for Kubernetes ReplicaSet

Parent class Relationship type Child class

Kubernetes ReplicaSet 
[cmdb_ci_kubernetes_replicaset]

Hosted on::Hosts Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Kubernetes ReplicaSet 
[cmdb_ci_kubernetes_replicaset]

Reference Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Kubernetes ReplicaSet 
[cmdb_ci_kubernetes_replicaset]

Reference Key Value [cmdb_key_value]

Kubernetes ReplicaSet 
[cmdb_ci_kubernetes_replicaset]

Reference SG-Wiz Extension Attributes 
[sn_wiz_integ_extension_attributes]

Kubernetes Service [cmdb_ci_kubernetes_service]

The following attributes in the Kubernetes Service [cmdb_ci_kubernetes_service] table are 
populated by collected data:

Attribute label Attribute name Wiz  attribute

Kubernetes UID k8s_uid uid

Name name name

Install Status install_status None

Kubernetes Cluster cluster Kubernetes_clusterExternalID

Namespace namespace namespace

IP Address ip_address spec_clusterIP

Selector selector spec_selector

Service Type service_type spec_type
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Relationships created for Kubernetes Service

Parent class Relationship type Child class

Kubernetes Service 
[cmdb_ci_kubernetes_service]

Reference Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Kubernetes Service 
[cmdb_ci_kubernetes_service]

Reference Key Value [cmdb_key_value]

Kubernetes Service 
[cmdb_ci_kubernetes_service]

Reference SG-Wiz Extension Attributes 
[sn_wiz_integ_extension_attributes]

Linux Server [cmdb_ci_linux_server]

The following attributes in the Linux Server [cmdb_ci_linux_server] table are populated by 
collected data.

Attribute label Attribute name Wiz  attribute

Name name name

Object ID object_id externalId

Serial number serial_number providerUniqueId

CPU count cpu_count vCPUs

Install Status install_status None

Is Virtual None None

Operating System os operatingSystem

Resource Group [cmdb_ci_resource_group]

The following attributes in the Resource Group [cmdb_ci_resource_group] table are populated by 
collected data:

Attribute label Attribute name Wiz  attribute

Name name name

Object ID object_id externalId

Install Status install_status None

Relationships created for Resource Group

Parent class Relationship type Child class

Resource Group 
[cmdb_ci_resource_group]

Contains::Contained by Cloud Load Balancer 
[cmdb_ci_cloud_load_balancer]

Resource Group 
[cmdb_ci_resource_group]

Contains::Contained by Storage Volume 
[cmdb_ci_storage_volume]

Resource Group 
[cmdb_ci_resource_group]

Reference SG-Wiz Extension Attributes 
[sn_wiz_integ_extension_attributes]
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Relationships created for Resource Group  (continued)

Parent class Relationship type Child class

Resource Group 
[cmdb_ci_resource_group]

Reference Key Value [cmdb_key_value]

Serial Number [cmdb_serial_number]

The following attributes in the Serial Number [cmdb_serial_number] table are populated by 
collected data:

Attribute label Attribute name Wiz

Serial Number providerUniqueID providerUniqueId

Serial Number Type serial_number_type None

Valid serial_number_valid providerUniqueId

Note: 
The Serial Number [cmdb_serial_number] table is populated for Azure only.

Relationships created for Serial Number

Parent class Relationship type Child class

Serial Number 
[cmdb_serial_number]

Reference Server [cmdb_ci_server]

Serial Number 
[cmdb_serial_number]

Reference Windows Server 
[cmdb_ci_win_server]

Serial Number 
[cmdb_serial_number]

Reference Linux Server 
[cmdb_ci_linux_server]

Server [cmdb_ci_server]

The following attributes in the Server [cmdb_ci_server] table are populated by collected data:

Attribute label Attribute name Wiz  attribute

Name name name

Object ID object_id externalId

Serial number serial_number providerUniqueId

CPU count cpu_count vCPUs

Install Status install_status None

Is Virtual virtual None

Operating System os operatingSystem
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SG-Wiz Extension Attributes [sn_wiz_integ_extension_attributes]

The following attribute in the SG-Wiz Extension Attributes [sn_wiz_integ_extension_attributes] 
table is populated by collected data:

Attribute label Attribute name Wiz  attribute

Project ID project_id productIDs

CMDB Class u_cmdb_class None

Storage Volume [cmdb_ci_storage_volume]

The following attributes in the Storage Volume [cmdb_ci_storage_volume] table are populated by 
collected data:

Attribute label Attribute name Wiz  attribute

Object ID object_id externalId

Volume ID volume_id externalId

Install Status install_status None

Name name name

Size size sizeGb

Size bytes size_bytes sizeGb

Storage type storage_type volumeType

Relationships created for Storage Volume

Parent class Relationship type Child class

Storage Volume 
[cmdb_ci_storage_volume]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]

Storage Volume 
[cmdb_ci_storage_volume]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Storage Volume 
[cmdb_ci_storage_volume]

Hosted on::Hosts Google Datacenter 
[cmdb_ci_google_datacenter]

Storage Volume 
[cmdb_ci_storage_volume]

Reference SG-Wiz Extension Attributes 
[sn_wiz_integ_extension_attributes]

Storage Volume 
[cmdb_ci_storage_volume]

Reference Key Value [cmdb_key_value]

Storage Volume Snapshot [cmdb_ci_storage_vol_snapshot]

The following attributes in the Storage Volume Snapshot [cmdb_ci_storage_vol_snapshot] table 
is populated by collected data:

Attribute label Attribute name Wiz  attribute

Object ID object_id externalId
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Attribute label Attribute name Wiz  attribute

Name name name

Install Status install_status None

Relationships created for Storage Volume Snapshot

Parent class Relationship type Child class

Storage Volume Snapshot 
[cmdb_ci_storage_vol_snapshot]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]

Storage Volume Snapshot 
[cmdb_ci_storage_vol_snapshot]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Storage Volume Snapshot 
[cmdb_ci_storage_vol_snapshot]

Hosted on::Hosts Cloud Service Account 
[cmdb_ci_cloud_service_account]

Storage Volume Snapshot 
[cmdb_ci_storage_vol_snapshot]

Reference Key Value [cmdb_key_value]

Storage Volume Snapshot 
[cmdb_ci_storage_vol_snapshot]

Reference SG-Wiz Extension Attributes 
[sn_wiz_integ_extension_attributes]

Virtual Machine Instance [cmdb_ci_vm_instance]

The following attributes in the Virtual Machine Instance [cmdb_ci_vm_instance] table are 
populated by collected data:

Attribute label Attribute name Wiz  attribute

Name name name

Object ID object_id externalId

CPUs cpus vCPUs

Disks disks totalDisks

Install Status install_status None

Memory (MB) memory memoryGB

VM Instance ID vm_inst_id externalId

Relationships created for Virtual Machine Instance

Parent class Relationship type Child class

Linux Server 
[cmdb_ci_linux_server]

Virtualized by::Virtualizes Virtual Machine Instance 
[cmdb_ci_vm_instance]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Hosted on::Hosts AWS Datacenter 
[cmdb_ci_aws_datacenter]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Hosted on::Hosts Azure Datacenter 
[cmdb_ci_azure_datacenter]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Hosted on::Hosts Google Datacenter 
[cmdb_ci_google_datacenter]
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Relationships created for Virtual Machine Instance  (continued)

Parent class Relationship type Child class

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Managed by::Manages Instance Scale Set 
[cmdb_ci_instance_scale_set]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Provisioned From::Provisioned Hardware Type 
[cmdb_ci_compute_template]

Windows Server 
[cmdb_ci_win_server]

Virtualized by::Virtualizes Virtual Machine Instance 
[cmdb_ci_vm_instance]

Server [cmdb_ci_server] Virtualized by::Virtualizes Virtual Machine Instance 
[cmdb_ci_vm_instance]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Reference SG-Wiz Extension Attributes 
[sn_wiz_integ_extension_attributes]

Virtual Machine Instance 
[cmdb_ci_vm_instance]

Reference Key Value [cmdb_key_value]

Windows Server [cmdb_ci_win_server]

The following attributes in the Windows Server [cmdb_ci_win_server] table are populated by 
collected data.

Attribute label Attribute name Wiz  attribute

Name name name

Object ID object_id externalId

Serial number providerUniqueID providerUniqueId

CPU count cpu_count vCPUs

Install Status install_status None

Is Virtual None None

Operating System os operatingSystem

Service Graph Connector for Wiz  properties

Service Graph Connector for Wiz  properties control the behavior of the connector.

Connection properties

These connection properties are available for Service Graph Connector for Wiz.

Note: 
To open the Service Graph Connection Properties 
[sn_cmdb_int_util_service_graph_connection_property] table for the connector, navigate 
to All  > Service Graph Connectors  > Wiz  > Connections  and select the connection name. 
The connection properties are displayed in the Service Graph Connection Properties 
related list.
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Connection properties for Service Graph Connector for Wiz

Property Description

Projects
Enter a list of comma-separated Project IDs for which the resources are to be pulled. 
For multiple entries, separate the IDs with commas.

Exclude 
Projects

Enter a list of comma-separated Project IDs for which the resources are excluded 
only when the Projects property isn't set. In this case, all the resources except for 
the specified projects are imported. For multiple entries, separate the names with 
commas.

System properties

These system properties are available for Service Graph Connector for Wiz.

Note: 
To open the System Properties [sys_properties] table, enter sys_properties.list  in 
the navigation filter.

System properties for Service Graph Connector for Wiz

Property Description

sn_wiz_integ.list_resources_action.page_size
Enter the page size used in REST requests to 
fetch Wiz  entities.

• Type: string

• Default value: 100

• Location: System Property [sys_properties] 
table

Supported Wiz  types

The Wiz  types and corresponding native types are imported as CMDB  data and saved in tables 
that extend from the Configuration item [cmdb_ci] table.

For information on Wiz  types and Wiz  native types, see Security Graph Object Normalization  on 
the Wiz  documentation site (requires Wiz  login).

Wiz  types Wiz  native types CMDB  CI classes

AWS Organization

GCP Organization

Cloud OrganizationsCloud 
Organization

GCP Folder Google Organization Folder

AWS Account

Azure Subscription

Cloud Service AccountSubscription

GCP Project Cloud Service Account
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Wiz  types Wiz  native types CMDB  CI classes

Google Organization Project

AWS Region AWS Datacenter

Azure Location Azure Datacenter

Region

GCP Region Google Datacenter

Resource Group Azure Resource Group Resource Group

AWS Network Interface

Azure Network Interface

Network Interface

GCP Compute Network Interface

Cloud Mgmt Network Interface

AWS VPCVirtual Network

Azure Virtual Network

Cloud Network

AWS EC2 Security Group

Azure Network Security Group

Firewall

GCP Firewall

Compute Security Group

AWS EC2 Volume (EBS)

AWS Lightsail Disk

Azure Disk

Storage VolumeVolume

GCP Compute Disk
Storage Volume, Cloud Disk Type

AWS EC2 Instance

AWS Lightsail Instance

Azure Scale Set Virtual Machine

Azure Compute Virtual Machine

Virtual Machine

GCP Compute Instance

Virtual Machine Instance, Server, 
Hardware Type

AWS Machine Image (AMI)

Azure Compute Virtual Machine 
Image

Virtual Machine 
Image

GCP Compute Image

Image

AWS ELB v1

AWS ELB V2 Application Load 
Balancer

AWS ELB V2 Gateway Load Balancer

Load Balancer

AWS ELB V2 Network Load Balancer

Cloud Load Balancer
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Wiz  types Wiz  native types CMDB  CI classes

AWS ELB V2

Azure Application Gateway

Azure Load Balancer

Azure Traffic Manager

GCP Compute Backend Service

GCP Compute Region Backend 
Service

AWS DynamoDB Table DynamoDB Table

AWS ElastiCache for Memcached 
Cluster

AWS ElastiCache Redis Cluster

AWS RDS Aurora MySQL Cluster

AWS DocumentDB Cluster

AWS RDS MSSQL Server Cluster

AWS RDS MariaDB Cluster

AWS RDS MySQL Cluster

AWS Neptune Cluster

AWS RDS Oracle Cluster

AWS RDS PostgreSQL Cluster

Cloud DataBase Cluster

Azure Cosmos DB Cassandra 
Keyspace

Azure Cosmos DB SQL Database

Azure MariaDB Database

Azure Cosmos DB MongoDB 
Collection

Azure Database for MySQL 
(Database)

Azure Database for MySQL Flexible 
(Database)

Azure Database for PostgreSQL 
(Database)

Azure Database for PostgreSQL 
Flexible (Database)

Azure Redis Database

Azure SQL Database

Database

Azure SQL Managed Instance 
Database

Cloud DataBase
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Wiz  types Wiz  native types CMDB  CI classes

Azure Data Explorer (Kusto) Database 
Instance

AWS S3 Bucket

Azure Blob Storage Container

Bucket

GCP Bucket

Cloud Object Storage

AWS Lambda Function

Azure Function

Serverless

GCP Cloud Function

Cloud Function

AWS Elastic IP Address

Azure CDN Endpoint

Azure Public IP Addresses

GCP Compute Address

Network Address

GCP Endpoint

Cloud Public IP Address

Storage Account Azure Storage Account Cloud Storage Account

AWS API Gateway

AWS API Gateway V2

API Gateway

Azure API Management

Cloud Gateway

AWS Elastic Kubernetes Service 
(EKS) Cluster

Azure Kubernetes Service (AKS) 
Cluster

GCP Kubernetes Engine (GKE) 
Cluster

Kubernetes 
Cluster

Kubernetes Cluster

Kubernetes Cluster 
[cmdb_ci_kubernetes_cluster]

Namespace Kubernetes Namespace Kubernetes Namespace

Kubernetes Node Kubernetes Node Kubernetes Node

Deployment Kubernetes Deployment Kubernetes Deployment

Kubernetes 
Service

Kubernetes Service Kubernetes Service

Pod Kubernetes Pod Kubernetes Pod

Replica Set Kubernetes Replica Set Kubernetes ReplicaSet
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Wiz  types Wiz  native types CMDB  CI classes

AWS Auto Scaling GroupCompute 
Instance Group

Azure Availability Set

Instance Scale Set

Kubernetes Container

AWS ECS Container

Azure ACA Container

Container

Azure ACI Container

Docker Container

Accessing the connection details of Service Graph Connector for Wiz

You can access the connection details of the Service Graph Connector for Wiz  in a single view 
using the common connection framework (CCF) included within the Integration Commons for 
CMDB  (sn_cmdb_int_util) store app.

With the CCF, you can access all the connections used by the Service Graph Connector for Wiz. 
The connection details include the connection alias, connection properties, data sources, and 
scheduled data imports associated with a connection. You can also test the connection. For 
more information, see Accessing the connection details of Service Graph Connectors.

Access the details of a Wiz  connection

Access the details of a Wiz  connection configured for the Service Graph Connector for Wiz.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Service Graph Connectors  > Wiz  > Connections.

2. From the Name  column of the Service Graph Connections list, select a connection.

3. On the Service Graph Connections page, view the connection details such as the connection 
name and alias.

4. Select a related list to view further details of the connection.

5. Optional:  Select the Test Connection  related link to test the connection.

Domain separation and Service Graph Connectors

Domain separation is supported for Service Graph Connectors. Domain separation enables you 
to separate data, processes, and administrative tasks into logical groupings called domains. You 
can control several aspects of this separation, including which users can see and access data.

Support level: Standard*

The support level is Standard but has some exceptions or special conditions.
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• Includes all aspects of Basic  level support.

• Business logic: The service provider (SP) creates or modifies processes per customer. The use 
cases reflect proper use of the application by multiple SP customers in a single instance.

• The instance owner must be able to configure minimum viable product (MVP) business logic 
and data parameters. This configuration is done per tenant, as expected for the specific 
application.

Sample use case: An admin must be able to make comments required when a record closes for 
one tenant, but not for another.

For more information on support levels, see Application support for domain separation .

How domain separation works in Service Graph Connectors

Domain separation is supported only for multi-instance Service Graph Connectors.

Note: 
The Identification and Reconciliation Engine (IRE) uses strict domain separation in releases 
prior to San Diego. That is, hierarchical domains are not supported.

You must install the Domain Support - Domain Extensions Installer 
(com.glide.domain.msp_extensions.installer) plugin before working with the 
Service Graph Connectors  tables. See Request domain separation .

Tables that do not have a Domain (sys_domain) column are not domain-separated. You can add a 
Domain (sys_domain) column to an existing table. See Add a domain field to a table .

Note: 

• The import set tables are not domain-separated.

• Transform histories are not domain-separated.

• The Key Value [cmdb_key_value] and Software Instance [cmdb_software_instance] 
tables, which are related to the Configuration Management Database (CMDB), are not 
domain-separated.

For more information about domain separation for Service Graph Connectors, see the Service 
Graph Connector Domain Separation  article in the Now Support  Knowledge Base.

Related topics

Domain separation for service providers
[store-future: BEGIN review]

Configure domain separation for Service Graph Connectors

Configure domain separation for Service Graph Connectors  to separate data into logically 
defined domains.

Before you begin
Role required: admin

Procedure

1. Install the Domain Support – Domain Extensions Installer system plugin to enable the domain 
separation feature for Service Graph Connectors.

2. Set up domains in Domain Admin  > Domains.
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3. Create users for each domain.

4. Update the Run As  user from a user on the Scheduled Data Import to a user within the domain 
in which you want the data to be imported.

[End]

Service Graph Connector Support Tools

You can use the ServiceNow®  Service Graph Connector Support Tools  application to resolve any 
issues or perform a general analysis on a Service Graph Connector  installed on your instance.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Key features

The Service Graph Connector Support Tools  application includes prebuilt conversations as a 
response to an issue type and enables resolving Service Graph Connector  issues and to perform 
a general analysis.

The application provides capability to debug and resolve the following types of issues:

Connection issues

Depending on the data source selected, asks to update or set required properties, 
enables to run the Flow Designer  action corresponding to the connector manually, 
and provides a link to HTTP logs for verifying the response from the data source.

Data issues

Checks for customizations in Identification and Reconciliation engine (IRE) 
rules, reconciliation rules, business rules, and mappings. Reviews the field and 
import causing the issue, reprocesses the import row, and provides the complete 
transformation information. Also, provides additional troubleshooting steps.

Performance issues

Depending on the data source and import set selected, makes a basic performance 
check and reviews the history of the Configuration Management Database (CMDB) 
integration executions.

Mapping issues

Reviews mappings for input and output fields using the IntegrationHub ETL  store 
app.

The chatbot conversation also directs to the knowledge articles landing page in the Now Support 
knowledge base, if available for a connector.

Install Service Graph Connector Support Tools

You can install Service Graph Connector Support Tools  if you have the admin role. The 
application installs related ServiceNow®  Store  applications and plugins if they are not already 
installed.

Before you begin

• Ensure that the application and all of its associated ServiceNow Store  applications have valid 
ServiceNow  entitlements. For more information, see Get entitlement for a ServiceNow  product 
or application .
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Role required: admin

About this task
The following applications or plugins are installed with Service Graph Connector Support Tools:

Integration Commons for CMDB (sn_cmdb_int_util)

Contains the CMDB  Integrations Dashboard  and a set of Robust Transform Engine 
(RTE) transforms and script includes.

Glide Virtual Agent Lite (com.glide.cs.chatbot.lite)

Provides IT service assistance using several prebuilt IT Service Management  (ITSM) 
conversations.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the Service Graph Connector Support Tools  application (sn_sgc_support) using the filter 
criteria and search bar.

You can search for the application by its name or ID. If you cannot find the application, you 
might have to request it from the ServiceNow Store.

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released 
apps, see the ServiceNow Store  version history release notes .

3. If you're prompted, follow the links to the ServiceNow Store  to get any additional entitlements 
for dependencies.

4. Select Install.

Resolving Service Graph Connector  issues

You can use the Service Graph Connector Support Tools  application to initiate a chatbot 
conversation with a virtual agent and resolve an issue or perform a general analysis on a Service 
Graph Connector  installed on your instance.

If a user with the admin role has installed the Service Graph Connector Support Tools 
application, you can initiate a chat conversation with a virtual agent to resolve Service Graph 
Connector  issues. The application includes prebuilt conversations as a response to an issue 
type.

You can use the prebuilt conversations to debug and resolve the following types of issues:

Connection issues

Depending on the data source selected, the virtual agent suggests you to update 
or set required properties, run the Flow Designer  action corresponding to the 
connector manually, and verify the response from the data source using HTTP logs.

Data issues

The virtual agent suggests you to check for customizations in Identification 
and Reconciliation engine (IRE) rules, reconciliation rules, business rules, and 
mappings. Review the field and import causing the issue, reprocess the import 
row, and view the complete transformation information. Also, suggests to perform 
additional troubleshooting steps.

Performance issues
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Depending on the data source and import set selected, the virtual agent suggests 
you to make a basic performance check and review the history of the Configuration 
Management Database (CMDB)  integration executions.

Mapping issues

The virtual agent suggests you to review mappings for input and output fields using 
the IntegrationHub ETL  store app.

Resolve a Service Graph Connector  issue

Resolve the Service Graph Connector  issues or perform a general analysis using the 
Troubleshooting module available for Service Graph Connectors.

Before you begin
Install Service Graph Connector Support Tools

Role required: admin

Procedure

1. Navigate to All  > Service Graph Connectors  > Troubleshooting.

2. In the Now Support window, select Click here to start a new conversation.

3. Select Show me everything.

4. Select Service Graph Connector Help.

5. Select a help option.

6. Based on the selected help option, follow the help instructions to resolve an issue or perform a 
general analysis.

7. Optional:  Close the conversation by selecting End the chat.

API Service Graph Connectors

You can use an API Service Graph Connector  to import and integrate third-party API data into 
CMDB  tables.

Important: 
Visit the ServiceNow Store  website to view the latest list of all API Service Graph 
Connectors.

Select a technology to learn about the API Service Graph Connector  available for ingesting data 
from an application using the technology into your CMDB.

Apigee X AWS API Gateway
Azure API Management

Kong Gateway
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API Service Graph Connector for Apigee X

Use the ServiceNow®  API Service Graph Connector for Apigee X  to import API proxy  details from 
an Apigee X  application into the Configuration Management Database (CMDB).

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Key features

Import data into a normalized data model for consistency across other technologies.

Supported ServiceNow  versions

• Washington DC

• Xanadu

• Yokohama

Use cases

You can use the API Service Graph Connector for Apigee X  to:

• Maintain an end-to-end inventory of exposed and backend APIs, identifying what APIs are 
published, used, and by whom.

• Track APIs from customer-facing endpoints to the underlying services, identifying impacted 
endpoints when services change or fail and creating incidents for reported issues.

• Address vulnerabilities and security incidents related to API endpoints, and create compliance 
requirements to measure against.

Configuring a connection for the connector

You can configure a connection for the connector by using the SGC Central  view in the CMDB 
Workspace. The view enables you to discover and install connectors, and then effectively 
manage the full life cycle of creating, editing, monitoring, and debugging connections. To 
configure the connector using SGC Central, see Configure API Service Graph Connector for 
Apigee X using SGC Central.

Important: 
Unless there are configuration issues, use the SGC Central  view in the CMDB Workspace 
to configure the connection for the connector, as the guided setup method is being 
deprecated.

Data mapping

Data from the Apigee X  data sources is mapped and transformed into the CMDB  Configuration 
Item (CI) class definitions using the Robust Transform Engine (RTE). Data is inserted into the 
CMDB  using the Identification and Reconciliation Engine (IRE).

When you complete setting up the connection, you can configure the integration to periodically 
pull data from an Apigee X  application.

The following table lists the data sources in the order that they run, the staging tables, and the 
target tables as CMDB  CI and non-CMDB  classes for an Apigee X  application.
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Data mapping for Apigee X

Data source Staging table Target tables

Organization SGA Apigee X Organization 
[sn_apigee_x_sga_apigee_x_organization] Cloud 

Organizations

Folder SGA Apigee X Folder [sn_apigee_x_sga_apigee_x_folder] Google 
Organization 
Folder

Project SGA Apigee X Project [sn_apigee_x_sga_apigee_x_project] Google 
Organization 
Project

Managed API SGA Apigee X Managed API 
[sn_apigee_x_sga_apigee_x_managed_api]

Managed API

API Deployment

Apigee API 
Gateway

API Consumer SGA Apigee X API Consumer 
[sn_apigee_x_sga_apigee_x_api_consumer]

API Consumer

API Frontend 
Backend

SGA Apigee X Frontend Backend 
[sn_apigee_x_sga_apigee_x_frontend_backend]

API Frontend

API Backend

API Product SGA Apigee X API Product 
[sn_apigee_x_sga_apigee_x_api_product]

API Product 
Bundle

Key Value

API Consumer 
Subscription

SGA Apigee X API Consumer Subscription 
[sn_apigee_x_sga_apigee_x_api_consumer_subscription]

API Consumer 
Subscription

Key Value

API Consumer 
Access

SGA Apigee X API Consumer Access 
[sn_apigee_x_sga_apigee_x_api_consumer_access]

API Consumer 
Access

For more information on where data is saved when pulling data from an Apigee X  application, 
see Target tables for storing API Service Graph Connector for Apigee X data.

You can use the IntegrationHub ETL app to view the data maps. See IntegrationHub ETL  for more 
information.

Configure API Service Graph Connector for Apigee X  using SGC Central

Set up scheduled import jobs to pull in Apigee X  data into your CMDB.

Before you begin
Install API Service Graph Connector for Apigee X  version 1.0.0 or later from the ServiceNow 
Store. For ServiceNow Store  installation steps, see Install a ServiceNow Store application .

Role required: cmdb_inst_admin or admin

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1481

https://www.webstg.servicenow.com/docs/access?context=t_InstallApplications&version=washingtondc&pubname=washingtondc-application-development&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=t_InstallApplications&version=washingtondc&pubname=washingtondc-application-development&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=t_InstallApplications&version=washingtondc&pubname=washingtondc-application-development&ft:locale=en-US


About this task
The playbook experience for onboarding connectors is activated with SGC Central  in the CMDB 
Workspace. To configure the SGC Central  application, see Configuring SGC Central  and for more 
information on how to interact with a playbook, see Interact with Playbook .

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the CMDB Workspace, select SGC Central.

3. On the Overview page, select Create connection.

Tip: 
Alternatively, you can select Create connection  on the All connections page.

4. On the Create connection window, select the Apigee X  connector type, and then select Create 
connection.

5. Complete the initial prerequisites when setting up a connection for the first time using a 
connector.

Note: 
This step is required only during the first-time setup. See Perform initial setup tasks when 
creating a connection in SGC Central.

6. Complete the prerequisites for setting up the Apigee X  environment.

a. Set up the Apigee X  environment and create a Java KeyStore (JKS) certificate to encrypt the 
security certificates obtained from an Apigee X  application.

i. In the Prerequisites  stage of the playbook, select the Review setup instructions  activity.

ii. Review and complete the setup instructions on the API Service Graph connector for 
Apigee X - Setup Instructions [KBB0010364]  article in the Now Support  Knowledge Base.

You must create a service account, assign roles, bind roles to the service account, enable 
APIs, create a P12 file, and register it in your ServiceNow  instance.

Make a note of the destination keystore password. You need to specify this password 
while importing the JKS certificate into the API Service Graph Connector for Apigee X 
application.

iii. Select the I have read the setup instructions  check box to confirm that you have set up 
the Apigee X  environment according to the instructions.

iv. Select Continue.

b. Create an X.509 certificate to associate the Java KeyStore (JKS) certificate for the Apigee X 
application with the connector.

Note: 
You can skip this step if you're reusing a previously created certificate.

i. In the Prerequisites  stage of the playbook, select the Create X.509 certificate  activity.

ii. On the form, fill in the fields.
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X.509 Certificate form

Field Description

Name Name of the X.509 certificate. For example, SGA-
ApigeeX-509Certificate.

Key store 
password

Password to access the JKS certificate as noted down in the previous 
step.

Short 
description

Description of the X.509 certificate.

iii. In the Attachments section, select Add File.

iv. Browse and select the P12 file for the JKS certificate you created in the previous step.

v. On the Upload a file dialog box, select Upload.

vi. Select Continue.

7. Enter connection details and test the API connection for importing Apigee X  data.

a. In the Setup  stage of the playbook, select the Create and test connection  activity.

b. On the form, fill in the fields.

Configure and test connection form

Field Description

Connection name Name to identify the Apigee X  connection 
record.

Service account Email Email address associated with the 
ServiceNow  service account used for 
authentication with Apigee X  as noted in the 
previous step.

X.509 certificate Name of the X.509 certificate as noted in the 
previous step.

Keystore Password Password associated with the keystore as 
noted in the previous step.

c. Select Create and test connection.

d. Once the connection test is complete, select Continue.

8. Set the configuration properties for the connection.

a. In the Setup  stage of the playbook, select the Set configuration properties  activity.

b. Enter the properties.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1483



Service Graph Connection Properties

Property Description

Apigee identification

Organization 
Id

Organization within the Apigee X  system to which the projects belong.

Project Id Project identifier within the Apigee X  environment that the connection will 
be linked to.

For multiple project IDs, separate them with commas.

Data retrieval configuration

Discovery 
Scope

Discovery scope of the Apigee X  application. The available options are:

Organization

Select Organization  when the ServiceNow  service account 
has access to data within the Apigee X  organization.

Projects

Select Projects  when the ServiceNow  service account has 
access to data within Apigee X  projects only.

Exclude 
Environments

Apigee X  environments that should be excluded from the connection.

For multiple environments, separate them with commas. All gateways 
except those listed in the Exclude Environments  property are 
fetched.

If you leave this field empty, the data sources within the connector import 
data from all the environments.

Collection 
period in 
days

Duration in days for collecting API usage data.

Collect usage 
data

Option to enable usage data collection to retrieve API usage data over a 
specified duration.

Performance configuration

Page size Number of records per page. Default is 100, minimum is 2.

Partition size Partition size for Apigee X  managed APIs if parallel loading is enabled.

Accepts a numeric value greater than zero. If left empty, the value is 
automatically calculated.

c. Select Continue.

9. Configure the import schedule to import data at regular intervals.

a. In the Setup  stage of the playbook, select the Configure import schedule  activity.

b. Select Configure import schedule.
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c. In the Configure import schedule  dialog box, in the Name  field, enter the Organization 
import schedule.

d. Select the Active  check box, and then fill in the run schedule and time details.

For more information, see Schedule a data import .

e. Select Save.

f. For the Configure import schedule  activity, select Continue.

10. In the Setup  stage of the playbook, select the Confirm connection creation  activity to verify 
whether the connection was created.

What to do next
Select View all connections  to review the connection details. The configured connection 
appears in the Installed connections list.

Related topics

API Service Graph Connector for Apigee X

Target tables for storing API Service Graph Connector for Apigee X data

Configure API Service Graph Connector for Apigee X  using the guided setup

Set up scheduled import jobs to pull in Apigee X  data into your CMDB.

Before you begin
Important: 
Unless there are configuration issues, use the SGC Central  view in the CMDB Workspace 
to configure the connection for the connector, as the guided setup method is being 
deprecated.

Dependencies and requirements:

• The Integration Commons for CMDB store app, which is automatically installed. See 
Integration Commons for CMDB.

• The CMDB CI class models store app, which is automatically installed. See CMDB CI Class 
Models store app.

• The ITOM Discovery License plugin (com.snc.itom.discovery.license). You must activate this 
plugin.

• ITOM Licensing plugin (com.snc.itom.license). See Request Discovery .

Role required: admin

Procedure

1. Verify that the application scope is set to the API Service Graph Connector for Apigee X 
application by using the application picker.
For more information, see Application picker .

2. Navigate to All  > Service Graph Connectors  > Apigee X  > Setup.

3. On the API Service Graph Connector for Apigee X  page, select Continue.

4. Configure the authentication credentials to send requests to the Apigee X  application.
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a. In the Configure the Connection and Credentials  section of the API Service Graph 
Connector for Apigee X  page, select Start.

b. Grant the attachment update permission so that the API Frontend Backend data source can 
retrieve files from Apigee X  and attach them to records.

i. Select the Update Attachment Access  task.

ii. Select the Global  application scope from the application picker.

iii. On the Application Access related list of the Attachment subpage, select the  Can update 
check box, and then select  Update.

iv. Select the API Service Graph Connector for Apigee X  application scope from the 
application picker.

v. Set the Update Attachment Access  task to complete by selecting the Mark as complete 
check box and then select Continue.

c. Set up the Apigee X  environment and create a Java KeyStore (JKS) certificate to encrypt the 
security certificates obtained from an Apigee X  application.

i. Select the Apigee X Setup Instructions  task.

ii. Review and complete the setup instructions on the API Service Graph connector for 
Apigee X - Setup Instructions [KBB0010364]  article in the Now Support  Knowledge Base.

Make a note of the destination keystore password. You need to specify this password 
while importing the JKS certificate into the API Service Graph Connector for Apigee X 
application.

iii. Set the Apigee X Setup Instructions  task to complete by selecting the Mark as complete 
check box and then select Continue.

d. Create an X.509 certificate to associate the Java KeyStore (JKS) certificate for the Apigee X 
application with the connector.

i. Select the Create X.509 certificate  task.

ii. Select New.

iii. On the form, fill in the fields.

X.509 Certificate form

Field Description

Name Name of the X.509 certificate. For example, SGA-
ApigeeX-509Certificate.

Notify on 
expiration

Users to be notified when the certificate expires. If no users are selected, 
the logged-in user is added by default, along with the last two logged-in 
users with the administrator role.

Warn in 
days to 
expire

Number of days to send a notification before the certificate expires.

Active Option to activate the certificate.

Type Certificate container that is automatically set to Java Key Store. Leave the 
field value set to Java Key Store.
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Field Description

Expires in 
days

Number of days until the certificate expires.

Key store 
password

Password to access the JKS certificate as noted down in the previous step.

Short 
description

Description of the X.509 certificate.

iv. Select the manage attachments icon ( ).

v. Select Choose file  to browse and upload the keystore.p12 file for the JKS certificate you 
created in step 4.c.

vi. Close the dialog box.

vii. Select the Validate Stores/Certificates  related link.

viii. On successful validation, select Update  to return to the guided setup page.

ix. Set the Create X.509 certificate  task to complete by selecting the Mark as complete 
check box and then select Continue.

e. Configure the connection.

i. Verify that the application scope is set to the API Service Graph Connector for Apigee X 
application by using the application picker.

ii. Select the Configure the Connection  task.

iii. Select Click Here  to open the Connections page in a separate browser tab.

iv. Search for and select Edit  for SGA Apigee X Connection.

v. In the Connection Information section of the Edit Connection window, fill in the fields.

Connection Information

Field Description

Connection name Name to identify the Apigee X  connection 
record.

SGA Apigee X Connection  is the 
default credential alias name. You can add 
multiple Apigee X  instances. However, try 
not to modify the default connection name.

vi. In the Credential Information section of the Edit Connection window, fill in the fields.

Credential Information

Field Description

Service account email Email address associated with the 
ServiceNow  service account used for 
authentication with Apigee X  as noted in 
the Before you begin  section.

X.509 certificate X.509 certificate created in step 4.d.
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Field Description

Keystore Password Password associated with the keystore as 
noted in the Before you begin  section.

vii. Select Edit and Get OAuth Token.

viii. Select Update.

ix. When the OAuth token flow is successfully completed, return to the guided setup page 
and set the Configure the Connection  task to complete by selecting the Mark as complete 
check box and then select Continue.

f. Configure properties of the connector to access resources.

i. Select the Add configuration properties  task.

ii. In the Service Graph Connection Properties related list, enter the values for the properties.

Service Graph Connection Properties

Property Description

CollectionPeriod(days) Duration in days for collecting API usage data.

CollectUsageData Enable usage data collection to retrieve API usage data over a 
specified duration.

Discovery Scope Discovery scope of the Apigee X  application. The available 
options are:

Organization

Select Organization  when the ServiceNow  service 
account has access to data within the Apigee X 
organization.

Projects

Select Projects  when the ServiceNow  service 
account has access to data within Apigee X 
projects only.

Exclude Environments Apigee X  environments that should be excluded from the 
connection.

For multiple environments, separate them with commas. 
All gateways except those listed in the Exclude 
Environments  property are fetched.

Organization Id Organization within the Apigee X  system to which the project 
belongs.

Page Size Number of records per page. Default is 100, minimum is 2.

PartitionSize Partition size for Apigee X  managed APIs if parallel loading is 
enabled.

Accepts a numeric value greater than zero. If left empty, the 
value is automatically calculated.

Project Id Project identifier within the Apigee X  environment that the 
connection will be linked to.
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Property Description

For multiple project IDs, separate them with commas.

Tip: 
To enter a property value, double-click (or use the keyboard shortcut) to enter a value 
in the Value  cell for the property.

iii. Set the Add configuration properties  task to complete by selecting the Mark as complete 
check box and then select Continue.

g. Test the connection.

i. Select the Test Connection  task.

ii. Test the connection by selecting the Test Connection  related link.

Testing the connection might take a few moments. The page is refreshed to show the test 
results.

iii. When the Status  field is set to Success, select Update.

If any of the tests have errors, follow the suggestions for remediation.

iv. Set the Test Connection  task to complete by selecting the Mark as complete  check box 
and then select Continue.

5. Optional:  Integrate with multiple Apigee X  instances.

a. In the Add Multiple Instances  section of the API Service Graph Connector for Apigee X  page, 
select Start.

b. Enable creating data sources for the new Apigee X  connection.

i. Verify that you have edit permissions for the Datasource [sys_data_source] table.

ii. Select the Update Data Source Access  task.

iii. To edit the record, select the Global  application scope from the application picker.

iv. In the Application Access related list of the Data Source form that opens in another tab, 
select the Can create, Can update, and Can delete  check boxes.

v. Select Update.

vi. From the application picker, select the API Service Graph Connector for Apigee X 
application scope.

vii. Set the Update Data Source Access  task to complete by selecting the Mark as complete 
check box and then select Continue.

c. Enable creating a scheduled import job for the new Apigee X  connection.

i. Ensure that you have edit permissions for the Scheduled data import 
[scheduled_import_set] table.

ii. Select the Update Scheduled Data Import Access  task.

iii. To edit the record, select the Global  application scope from the application picker.

iv. In the Application Access related list of the Scheduled Data Import form, select the Can 
create, Can update, and Can delete  check boxes.
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v. Select Update.

vi. From the application picker, select the API Service Graph Connector for Apigee X 
application scope.

vii. Set the Update Scheduled Data Import Access  task to complete by selecting the Mark as 
complete  check box and then select Continue.

d. Clear the cache on the Data Source [sys_data_source] and Scheduled Data Imports 
[scheduled_import_set] tables.

i. Select the Clear Cache for Data Source and Scheduled Data Imports tables  task.

ii. In the Run script  text box of the background script page, enter the following script:

GlideTableManager.invalidateTable("sys_data_source");
GlideCacheManager.flushTable("sys_data_source");
GlideTableManager.invalidateTable("scheduled_import_set");
GlideCacheManager.flushTable("scheduled_import_set");
GlideTableManager.invalidateTable("sys_db_object");
GlideCacheManager.flushTable("sys_db_object");
GlideTableManager.invalidateTable("sys_attachment");
GlideCacheManager.flushTable("sys_attachment");

iii. Select Run Script  to run the background script in the global  scope.

The script may take several minutes to execute.

iv. After the script is executed, select Close.

v. From the application picker, select the API Service Graph Connector for Apigee X 
application scope.

vi. Set the Clear Cache for Data Source and Scheduled Data Imports tables  task to complete 
by selecting Mark as complete.

e. To create an X.509 certificate for the new Apigee X  instance, repeat step 4.d, and then mark 
the Create X.509 certificate  task to complete by selecting Mark as complete.

f. Add another connection for the new Apigee X  instance.

i. Verify that the application scope is set to the API Service Graph Connector for Apigee X 
application by using the application picker.

ii. Select the Add Another Connection  task and then select Click Here.

iii. On the Connections page that opens in another browser tab, select Add Connection.

iv. In the Create Connection window, fill in the connection, service account, and keystore 
details including keystore password.

(Optional) You created the keystore in step 5.e.

v. Select Create and Get OAuth Token.

vi. Close the Connections page and return to the guided setup page tab.

vii. Set the Add Another Connection  task to complete by selecting the Mark as complete 
check box and then select Continue.

g. Add properties for the new connection.
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i. Verify that the application scope is set to the API Service Graph Connector for Apigee X 
application by using the application picker.

ii. Select the Add configuration properties  task.

iii. From the Name  column, select the connection name you created in step 5.f.

iv. In the Service Graph Connection Properties related list, enter the values for the properties.

(Optional) For more information on properties, see 4.f.ii.

Tip: 
To enter a property value, double-click (or use the keyboard shortcut) to enter a value 
in the Value  cell for the property.

v. Set the Add configuration properties  task to complete by selecting the Mark as complete 
check box and then select Continue.

h. Test the new connection.

i. Select the Test New Connections  task.

ii. From the Name  column, select the connection name you created in step 5.f.

iii. Test the connection by selecting the Test Connection  related link.

Testing the connection might take a few moments. The page is refreshed to show the test 
results.

iv. When the Status  field is set to Success, select Update.

If any of the tests have errors, follow the suggestions for remediation.

v. Set the Test New Connections  task to complete by selecting the Mark as complete  check 
box and then select Continue.

6. Configure the scheduled job for the import of Apigee X  data.

a. In the Set up Scheduled Import Jobs  section of the API Service Graph Connector for Apigee 
X  page, select Start.

b. Select the Organization  scheduled job.
For a multiple instance setup, select the scheduled import created with the connection in 
step 5.f.

c. On the Scheduled Data Import form, verify the field values.

For more information, see Schedule a data import .

d. Select the Active  check box to activate the scheduled job.

e. In the Run  field, select Periodically  to specify how often the job will run.

f. Select Update.

g. Set the Set up Scheduled Import Jobs  task to complete by selecting the Mark as complete 
check box and then select Continue.
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7. On the API Service Graph Connector for Apigee X  page, select Complete  to save your 
changes.

8. In the Complete setup dialog box, select Complete  to complete the setup.

9. In the message box that appears, select Done.

Target tables for storing API Service Graph Connector for Apigee X  data

When you complete setting up the connection, you can configure the integration to periodically 
pull data from an Apigee X  application. The data is saved in tables that extend from the 
Configuration item [cmdb_ci] classes and other non-CMDB classes.

Cloud Organizations [cmdb_ci_cloud_org]

The following attributes in the Cloud Organizations [cmdb_ci_cloud_org] table are populated by 
collected data:

Attribute label Attribute name

Object ID object_id

Install Status install_status

Name name

Operational status operational_status

Time time

Relationship created for Cloud Organizations

Parent class Relationship type Child class

Cloud Organizations 
[cmdb_ci_cloud_org]

Contains::Contained by Google Organization Folder 
[cmdb_ci_gcp_folder]

Google Organization Folder [cmdb_ci_gcp_folder]

The following attributes in the Google Organization Folder [cmdb_ci_gcp_folder] table are 
populated by collected data:

Attribute label Attribute name

Parent parent_ci

Object ID object_id

Install Status install_status

Name name

Operational status operational_status

Parent Id parent_id

Parent Type parent_type

Time time

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1492



Relationships created for Google Organization Folder

Parent class Relationship type Child class

Google Organization Folder 
[cmdb_ci_gcp_folder]

Reference Google Organization Folder 
[cmdb_ci_gcp_folder]

Google Organization Folder 
[cmdb_ci_gcp_folder]

Reference Cloud Organizations 
[cmdb_ci_cloud_org]

Google Organization Project [cmdb_ci_gcp_project]

The following attributes in the Google Organization Project [cmdb_ci_gcp_project] table are 
populated by collected data:

Attribute label Attribute name

Parent parent_ci

Name name

Object ID object_id

Install Status install_status

Operational status operational_status

Parent Id parent_id

Parent Type parent_type

Project Id project_id

Time time

Relationships created for Google Organization Project

Parent class Relationship type Child class

Google Organization Project 
[cmdb_ci_gcp_project]

Reference Cloud Organizations 
[cmdb_ci_cloud_org]

Google Organization Project 
[cmdb_ci_gcp_project]

Reference Google Organization Folder 
[cmdb_ci_gcp_folder]

Apigee API Gateway [cmdb_ci_apigee_api_gateway]

The following attributes in the Apigee API Gateway [cmdb_ci_apigee_api_gateway] table are 
populated by collected data:

Attribute label Attribute name

ID id

Name name

Install Status install_status

Operational status operational_status
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Relationships created for Apigee API Gateway

Parent class Relationship type Child class

APIgee API Gateway 
[cmdb_ci_apigee_api_gateway]

Provides::Provided by Managed API 
[cmdb_ci_managed_api]

APIgee API Gateway 
[cmdb_ci_apigee_api_gateway]

Reference API Consumer [api_consumer]

Apigee API Gateway 
[cmdb_ci_apigee_api_gateway]

Provides::Provided by API Consumer Subscription 
[cmdb_ci_api_consumer_subscription]

Apigee API Gateway 
[cmdb_ci_apigee_api_gateway]

Provides::Provided by API Product Bundle 
[cmdb_ci_api_product_bundle]

Managed API [cmdb_ci_managed_api]

The following attributes in the Managed API [cmdb_ci_managed_api] table are populated by 
collected data:

Attribute label Attribute name

Life Cycle Stage life_cycle_stage

ID id

Name name

Version version

Base URL base_url

Install Status install_status

Operational status operational_status

Model ID model_id

Correlation ID correlation_id

Life Cycle Stage Status life_cycle_stage_status

Relationships created for Managed API

Parent class Relationship type Child class

Managed API 
[cmdb_ci_managed_api]

Uses::Used by API Frontend 
[cmdb_ci_api_frontend]

Managed API 
[cmdb_ci_managed_api]

Uses::Used by API Backend 
[cmdb_ci_api_backend]

Managed API 
[cmdb_ci_managed_api]

Reference API Deployment 
[api_deployment]

API Frontend [cmdb_ci_api_frontend]

The following attributes in the API Frontend [cmdb_ci_api_frontend] table are populated by 
collected data:
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Attribute label Attribute name

API Version api_version

Host host

Method method

Path path

URL url

Description short_description

Name name

Operational status operational_status

Protocol protocol

Relationship created for API Frontend

Parent class Relationship type Child class

API Frontend 
[cmdb_ci_api_frontend]

Use End Point To::Use End 
Point From

API Backend 
[cmdb_ci_api_backend]

API Backend [cmdb_ci_api_backend]

The following attributes in the API Backend [cmdb_ci_api_backend] table are populated by 
collected data:

Attribute label Attribute name

URL url

Name name

Operational status operational_status

Type type

API Product Bundle [cmdb_ci_api_product_bundle]

The following attributes in the API Product Bundle [cmdb_ci_api_product_bundle] table are 
populated by collected data:

Attribute label Attribute name

ID id

Creation Date creation_date

Description short_description

Discovered Access Type discovered_access_type

Discovered Approval Type discovered_approval_type

Last Modified Date last_modified_date
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Attribute label Attribute name

Name name

Relationships created for API Product Bundle

Parent class Relationship type Child class

API Product Bundle 
[cmdb_ci_api_product_bundle]

Used by::Uses API Consumer Subscription 
[cmdb_ci_api_consumer_subscription]

API Product Bundle 
[cmdb_ci_api_product_bundle]

Reference Key Value [cmdb_key_value]

API Consumer Subscription [cmdb_ci_api_consumer_subscription]

The following attributes in the API Consumer Subscription [cmdb_ci_api_consumer_subscription] 
table are populated by collected data:

Attribute label Attribute name

ID id

Creation Date creation_date

API Consumer api_consumer

Discovered State discovered_state

Last Modified Date last_modified_date

Name name

Relationship created for API Consumer Subscription

Parent class Relationship type Child class

API Consumer Subscription 
[cmdb_ci_api_consumer_subscription]

Reference Key Value [cmdb_key_value]

Key Value [cmdb_key_value]

The following attributes in the Key Value [cmdb_key_value] table are populated by collected data:

Attribute label Attribute name

Key key

Value value

API Deployment [api_deployment]

The following attributes in the API Deployment [api_deployment] table are populated by 
collected data:
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Attribute label Attribute name

API api

Name name

API Consumer [api_consumer]

The following attributes in the API Consumer [api_consumer] table are populated by collected 
data:

Attribute label Attribute name

ID id

API Gateway api_gateway

Custom ID custom_id

Email email

Registration Date registration_date

Username username

API Consumer Access [api_consumer_access]

The following attributes in the API Consumer Access [api_consumer_access] table are populated 
by collected data:

Attribute label Attribute name

API Product Bundle api_product_bundle

API Consumer Subscription api_consumer_subscription

API api

API Consumer api_consumer

Accessing the connection details of API Service Graph Connector for Apigee X

You can access the connection details of the API Service Graph Connector for Apigee X  in a 
single view using the common connection framework included within the Integration Commons 
for CMDB  (sn_cmdb_int_util) store app.

With the CCF, you can access all the connections used by the API Service Graph Connector 
for Apigee X. The connection details include the connection alias, connection properties, 
data sources, and scheduled data imports associated with a connection. You can also test 
the connection. For more information, see Accessing the connection details of Service Graph 
Connectors.

Access the details of an Apigee X  connection

Access the details of an Apigee X  connection configured for the API Service Graph Connector 
for Apigee X.

Before you begin
Role required: admin
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Procedure

1. Navigate to All  > Service Graph Connectors  > Apigee X  > Connections.

2. From the Name  column of the Service Graph Connections list, select a connection.

3. On the Service Graph Connections page, view the connection details such as the connection 
name and alias.

4. Select a related list to view further details of the connection.

5. Optional:  Select the Test Connection  related link to test the connection.

API Service Graph Connector for AWS API Gateway

Use the ServiceNow®  API Service Graph Connector for AWS API Gateway  to import API details 
from an AWS API Gateway  service into the Configuration Management Database (CMDB).

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Key features

Import data into a normalized data model for consistency across other technologies.

Supported ServiceNow  versions

• Washington DC

• Xanadu

• Yokohama

Use cases

You can use the API Service Graph Connector for AWS API Gateway  to:

• Maintain an end-to-end inventory of defined APIs, identifying what APIs are published, used, 
and by whom.

• Track APIs from customer-facing endpoints to the underlying services, identifying impacted 
endpoints when services change or fail and creating incidents for reported issues.

• Address vulnerabilities and security incidents related to API endpoints, and create compliance 
requirements to measure against.

Configuring a connection for the connector

You can configure a connection for the connector by using the SGC Central  view in the CMDB 
Workspace. The view enables you to discover and install connectors, and then effectively 
manage the full life cycle of creating, editing, monitoring, and debugging connections. To 
configure the connector using SGC Central, see Configure API Service Graph Connector for AWS 
API Gateway using SGC Central.

Important: 
Unless there are configuration issues, use the SGC Central  view in the CMDB Workspace 
to configure the connection for the connector, as the guided setup method is being 
deprecated.
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Data mapping

Data from the AWS API Gateway  data sources is mapped and transformed into the CMDB 
Configuration Item (CI) class definitions using the Robust Transform Engine (RTE). Data is 
inserted into the CMDB  using the Identification and Reconciliation Engine (IRE).

When you complete setting up the connection, you can configure the integration to periodically 
pull data from an AWS API Gateway  service.

The following table lists the data sources in the order they run, the staging tables, and the target 
tables as CMDB  CI and non-CMDB  classes for an AWS API Gateway  service.

Data mapping for AWS API Gateway

Data source Staging table Target tables

Managed API 
Rest

SGA-AWS Managed API Rest 
[sn_aws_api_gw_int_api_gateway_managed_api_import_set]

AWS API 
Gateway

Managed 
API

Key Value

Managed API 
V2

SGA-AWS Managed API V2 
[sn_aws_api_gw_int_sga_aws_managed_api_v2]

Managed 
API

AWS API 
Gateway

Key Value

Frontend 
Backend 
REST

SGA-AWS Frontend-Backend REST 
[sn_aws_api_gw_int_sga_aws_frontend_backend_rest]

API Backend

API Frontend

Backend V2 SGA-AWS Backend V2 
[sn_aws_api_gw_int_sga_aws_backend_v2]

API Backend

Frontend V2 SGA-AWS Frontend V2 
[sn_aws_api_gw_int_sga_aws_frontend_v2]

API Frontend

Deployment 
Rest

SGA-AWS API Gateway Deployment Rest 
[sn_aws_api_gw_int_sga_aws_api_gateway_deployment_rest]

API 
Deployment

Deployment 
V2

SGA-AWS API Gateway Deployment V2 
[sn_aws_api_gw_int_sga_aws_api_gateway_deployment_v2]

API 
Deployment

Consumer SGA-AWS Consumers 
[sn_aws_api_gw_int_sga_aws_consumers]

API 
Consumer

Policies SGA-AWS API Gateway Policies 
[sn_aws_api_gw_int_sga_aws_api_gateway_policies]

API Policy

API Consumer 
Access

SGA-AWS-API-Consumer-Access 
[sn_aws_api_gw_int_sga_aws_api_consumer_access]

API 
Consumer 
Access

For more information on where data is saved when pulling data from an AWS API Gateway 
service, see Target tables for storing API Service Graph Connector for AWS API Gateway data.
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You can use the IntegrationHub ETL app to view the data maps. See IntegrationHub ETL  for more 
information.

Configure API Service Graph Connector for AWS API Gateway  using SGC Central

Set up scheduled import jobs to pull in AWS API Gateway  data into your CMDB.

Before you begin
Install API Service Graph Connector for AWS API Gateway  version 1.0.0 or later from the 
ServiceNow Store. For ServiceNow Store  installation steps, see Install a ServiceNow Store 
application .

The authentication mechanism used by the connector is AWS Signature Type (HMAC 
Authentication Technique) with AWS  Security Token Service (STS) token. For information about 
permissions, see the API Service Graph Connector for AWS API Gateway - Setup Instructions 
[KB1962734]  article in the Now Support  Knowledge Base.

Role required: cmdb_inst_admin or admin

About this task
The playbook experience for onboarding connectors is activated with SGC Central  in the CMDB 
Workspace. To configure the SGC Central  application, see Configuring SGC Central  and for more 
information on how to interact with a playbook, see Interact with Playbook .

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the CMDB Workspace, select SGC Central.

3. On the Overview page, select Create connection.

Tip: 
Alternatively, you can select Create connection  on the All connections page.

4. Complete the initial prerequisites when setting up a connection for the first time using a 
connector.

Note: 
This step is required only during the first-time setup. See Perform initial setup tasks when 
creating a connection in SGC Central.

5. Enter connection details and test the API connection for importing AWS API Gateway  data.

a. In the Setup  stage of the playbook, select the Create and test connection  activity.

b. On the form, fill in the fields.

Create and test connection form

Field Description

AWS API Gateway Connection Name Name to identify the AWS API Gateway 
connection record.

For example, SG-AWS-API-Gateway 
connection.
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Field Description

Access Key Access key ID of the IAM user that has 
permissions to interact with the AWS 
resources.

Secret Key Secret access key that corresponds to the 
Access key ID required for authenticating 
the connection securely.

c. Select Create and test connection.

d. Once the connection test is complete, select Continue.

6. Optional:  Copy configuration properties from an existing AWS  connection.

Note: 
The Copy configuration properties  activity is displayed only when an AWS  connection is 
already set up on your instance.

a. In the Setup  stage of the playbook, select the Copy configuration properties  activity.

b. In the AWS Connection  field, select the connection.
The values of the following properties are copied from the selected AWS  connection:

▪ Standalone account ID

▪ Management account ID

▪ Gov cloud

▪ STS assume role

▪ AWS regions

▪ Config aggregator name

▪ Config aggregator account

▪ Config aggregator region

c. Select Continue.

d. Once the connection test is complete, select Continue.

7. Set the configuration properties for the connection.

a. In the Setup  stage of the playbook, select the Set configuration properties  activity.

b. Fill in the property details.

Note: 
If you select to copy the configuration properties from an existing AWS  connection, the 
properties listed in the step 6.b  are copied from the existing connection automatically.
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AWS API Gateway  configuration properties

Property Description

Management account ID or standalone account ID

Management 
account ID

Management account ID associated with the AWS API Gateway 
account.

Standalone 
account ID

ID of a member account associated with the AWS API Gateway 
account.

STS assume role name and AWS regions

STS assume role 
name

STS Assume Role name of the AWS  account  that is used for querying 
the STS Assume Role  API to obtain the API credentials.

AWS regions List of comma-separated regions where the AWS API Gateway  resides.

Config aggregator setup

Config aggregator 
account ID

AWS account ID where the aggregator resource type in the AWS Config 
service has been configured.

Config aggregator 
name

Name of the aggregator resource type in the AWS Config service.

Config aggregator 
region

Region where the aggregator resource type resides.

API usage data

CollectUsageData Option to enable usage data collection to retrieve API usage data over 
a specified duration.

Collection period 
in days

Duration in days for collecting API usage data.

Gov cloud setup

Is gov cloud Option to indicate that the connection setup is for the AWS GovCloud.

c. Select Continue.

8. Configure the import schedule to import data at regular intervals.

a. In the Setup  stage of the playbook, select the Configure import schedule  activity.

b. Expand the Parent scheduled data import within the Import schedules list to select the 
Managed API Rest  import schedule associated with your connection.

Note: 
The connection name is prefixed to the schedule name.

c. In the Configure import schedule  dialog box, select the Active  check box, and then fill in the 
run schedule and time details.

For more information, see Schedule a data import .

d. Select Save.
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Alternatively, select Execute Now  to execute the import schedule immediately.

e. Select Continue.

9. In the Setup  stage of the playbook, select the Confirm connection creation  activity to verify 
whether the connection was configured.

What to do next
Select View all connections  to review the connection details. The configured connection 
appears in the Installed connections list.

Related topics

API Service Graph Connector for AWS API Gateway

Target tables for storing API Service Graph Connector for AWS API Gateway data

Configure API Service Graph Connector for AWS API Gateway  using the guided setup

Set up scheduled import jobs to pull in AWS API Gateway  data into your CMDB.

Before you begin
Important: 
Unless there are configuration issues, use the SGC Central  view in the CMDB Workspace 
to configure the connection for the connector, as the guided setup method is being 
deprecated.

The authentication mechanism used by the connector is AWS Signature Type (HMAC 
Authentication Technique) with AWS  Security Token Service (STS) token. For information about 
permissions, see the API Service Graph Connector for AWS API Gateway - Setup Instructions 
[KB1962734]  article in the Now Support  Knowledge Base.

Dependencies and requirements:

• The Integration Commons for CMDB store app, which is automatically installed. See 
Integration Commons for CMDB.

• The CMDB CI class models store app, which is automatically installed. See CMDB CI Class 
Models store app.

• The ITOM Discovery License plugin (com.snc.itom.discovery.license). You must activate this 
plugin.

• ITOM Licensing plugin (com.snc.itom.license). See Request Discovery .

Role required: admin

Procedure

1. Verify that the application scope is set to the API Service Graph Connector for AWS API 
Gateway  application by using the application picker.
For more information, see Application picker .

2. Navigate to All  > Service Graph Connectors  > AWS API Gateway  > Setup.

3. On the Guided Setup page, select Continue.

4. Configure the authentication credentials to send requests to the AWS API Gateway.
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a. In the Configure the Connection and Credentials  section of the API Service Graph 
Connector for AWS API Gateway  page, select Start.

b. Configure the connection.

i. Select the Configure AWS authentication credentials  task.

ii. In the Name  field, enter a name for the authentication.

SGAwsApiCredentials  is the default credential alias name. You can add multiple 
AWS API Gateway  instances. However, try not to modify the default connection alias.

iii. Enter the access key ID and the secret access key in the Access Key ID  and Secret 
Access Key  fields respectively.

The AWS access keys are long-term credentials for the IAM user and include two parts: 
an access key ID and a secret access key. You must use both the access key ID and the 
secret access key together to authenticate requests.

iv. Select Update.

v. Set the Configure AWS authentication credentials  task to complete by selecting the Mark 
as complete  check box and then select Continue.

c. Update the required configuration properties for an AWS API Gateway  instance and test the 
connection.

i. Select the Configure and Test AWS Account Details  task.

ii. In the Service Graph Connections  section, review and modify the property details 
by selecting a property from the Property  column in the Service Graph Connection 
Properties related list.

You can configure the following properties:

AccountId

A numeric identifier of the AWS  account ID.

CollectionPeriod(days)

Duration in days for collecting API usage data.

CollectUsageData

Enable usage data collection to retrieve API usage data over a specified 
duration.

IsGovCloud

Enable to indicate that the connection setup is for the AWS GovCloud.

ConfigAggregatorAccountId

AWS account ID where the aggregator resource type in the AWS Config 
service has been configured.

Region(s)

A list of comma-separated regions where the AWS API Gateway  resides.

PartitionSize

Partition size for AWS managed APIs if the parallel loading is enabled.

Accepts a numeric value greater than zero. If left empty, the value is 
automatically calculated.
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StandaloneAccountId

The ID of a member account associated with the AWS API Gateway  account.

ConfigAggregatorName

The name of the aggregator resource type in the AWS Config service.

ManagementAccountId

The management account ID associated with the AWS API Gateway  account.

ConfigAggregatorRegion

The region where the aggregator resource type resides.

StsRoleName

The STS Assume Role name of the AWS  account  that is used for querying the 
STS Assume Role  API to obtain the API credentials.

iii. Select Update  in the Service Graph Connection Properties section.

iv. Test the connection by selecting the Test Connection  related link.

Testing the connection might take a few moments. The page is refreshed to show the test 
results.

v. When the Status  field is set to Success, select Update.

If any of the tests have errors, follow the suggestions for remediation.

vi. Set the Configure and Test AWS Account Details  task to complete by selecting the Mark 
as complete  check box and then select Continue.

5. Optional:  Integrate with multiple AWS API Gateway  instances.

a. In the Add Multiple Instances  section of the API Service Graph Connector for AWS API 
Gateway  page, select Start.

b. Enable creating data sources for the new AWS API Gateway  connection.

i. Ensure that you have edit permissions for the Datasource [sys_data_source] table.

ii. Select the Update Data Source Access  task.

iii. To edit the record, select the Global  application scope from the application picker.

iv. In the Application Access related list of the Data Source form that opens in a new tab, 
select the Can create, Can update, and Can delete  check boxes.

v. Select Update.

vi. From the application picker, select the API Service Graph Connector for AWS API Gateway 
application scope.

vii. Set the Update Data Source Access  task to complete by selecting the Mark as complete 
check box and then select Continue.

c. Enable creating a scheduled import job for the new AWS API Gateway  connection.

i. Ensure that you have edit permissions for the Scheduled data import 
[scheduled_import_set] table.

ii. Select the Update Data Scheduled Import Access  task.

iii. To edit the record, select the Global  application scope from the application picker.
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iv. In the Application Access related list of the Scheduled Data Import form, select the Can 
create, Can update, and Can delete  check boxes.

v. Select Update.

vi. From the application picker, select the API Service Graph Connector for AWS API Gateway 
application scope.

vii. Set the Update Data Scheduled Import Access  task to complete by selecting the Mark as 
complete  check box and then select Continue.

d. Clear the cache on the Data Source [sys_data_source] and Scheduled Data Imports 
[scheduled_import_set] tables.

i. Select the Clear Cache for Data Source and Scheduled Data Imports tables  task.

ii. In the Run script  text box of the background script page, enter the following script:

GlideTableManager.invalidateTable("sys_data_source");
GlideCacheManager.flushTable("sys_data_source");
GlideTableManager.invalidateTable("scheduled_import_set");
GlideCacheManager.flushTable("scheduled_import_set");
GlideTableManager.invalidateTable("sys_db_object");
GlideCacheManager.flushTable("sys_db_object");

iii. Select Run Script  to run the background script in the global  scope.

The script may take several minutes to execute.

iv. After the script is executed, select Close.

v. From the application picker, select the API Service Graph Connector for AWS API Gateway 
application scope.

vi. Set the Clear Cache for Data Source and Scheduled Data Imports tables  task to complete 
by selecting Mark as Complete.

e. Add another connection for the new AWS API Gateway  instance.

i. Verify that the application scope is set to the API Service Graph Connector for AWS API 
Gateway  application by using the application picker.

ii. Select the Add Another Connections  task and then select Click Here.

iii. On the Connections page that opens in another browser tab, select Add Connection.

iv. In the Create Connection window, fill in the connection name, access key, and secret key 
details.

v. Select Create Connection.

vi. Close the Flow Designer  and return to the guided setup tab.

vii. Set the Add Another Connections  task to complete by selecting the Mark as complete 
check box and then select Continue.

f. Update the required configuration properties for the new AWS API Gateway  connection and 
test the connection.

i. Select the Test New Connections  task.

ii. Select the connection record you created in step 5.e.

iii. Test the connection by selecting the Test Connection  related link.
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Testing the connection might take a few moments. The page is refreshed to show the test 
results.

iv. When the Status  field is set to Success, select Update.

If any of the tests have errors, follow the suggestions for remediation.

v. Set the Test New Connections  task to complete by selecting the Mark as complete  check 
box and then select Continue.

6. Configure the scheduled job for the import of AWS API Gateway  data.

a. In the Set up Scheduled Import Jobs  section of the API Service Graph Connector for AWS 
API Gateway  page, select Start.

b. Select the Managed API Rest  scheduled job.
For multiple instances, select the scheduled job for the Managed API Rest  data source.

c. On the Scheduled Data Import form, verify the field values for the scheduled job.

For more information, see Schedule a data import .

d. Select Active  check box to activate the scheduled job for the Managed API Rest  data 
source.

e. Select Update.

f. Set the Set up Scheduled Import Jobs  task to complete by selecting the Mark as complete 
check box and then select Continue.

7. On the API Service Graph Connector for AWS API Gateway  page, select Complete  to save your 
changes.

8. In Complete setup dialog box, select Complete  to complete the setup.

9. In the message box that appears, select Done.

Target tables for storing API Service Graph Connector for AWS API Gateway  data

When you complete setting up the connection, you can configure the integration to periodically 
pull data from an AWS API Gateway  service. The data is saved in tables that extend from the 
Configuration item [cmdb_ci] classes and other non-CMDB classes.

AWS API Gateway [cmdb_ci_aws_api_gateway]

The following attributes in the AWS API Gateway [cmdb_ci_aws_api_gateway] table are 
populated by collected data:

Attribute label Attribute name

ID id

Name name

Operational status operational_status
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Relationships created for AWS API Gateway

Parent class Relationship type Child class

AWS API Gateway 
[cmdb_ci_aws_api_gateway]

Provides::Provided by Managed API 
[cmdb_ci_managed_api]

AWS API Gateway 
[cmdb_ci_aws_api_gateway]

Reference API Policy [api_policy]

AWS API Gateway 
[cmdb_ci_aws_api_gateway]

Reference API Consumer [api_consumer]

Managed API [cmdb_ci_managed_api]

The following attributes in the Managed API [cmdb_ci_managed_api] table are populated by 
collected data:

Attribute label Attribute name

Life Cycle Stage Status life_cycle_stage_status

ID id

Name name

Version version

Base URL base_url

Operational status operational_status

Life Cycle Stage life_cycle_stage

Model ID model_id

Type type

Relationships created for Managed API

Parent class Relationship type Child class

Managed API 
[cmdb_ci_managed_api]

Uses::Used by API Frontend 
[cmdb_ci_api_frontend]

Managed API 
[cmdb_ci_managed_api]

Uses::Used by API Backend 
[cmdb_ci_api_backend]

Managed API 
[cmdb_ci_managed_api]

Reference API Deployment 
[api_deployment]

API Frontend [cmdb_ci_api_frontend]

The following attributes in the API Frontend [cmdb_ci_api_frontend] table are populated by 
collected data:

Attribute label Attribute name

Host host

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1508



Attribute label Attribute name

Method method

Path path

URL url

Authorization authorization

Name name

Operational status operational_status

Protocol protocol

Relationship created for API Frontend

Parent class Relationship type Child class

API Frontend 
[cmdb_ci_api_frontend]

Use End Point To::Use End 
Point From

API Backend 
[cmdb_ci_api_backend]

API Backend [cmdb_ci_api_backend]

The following attributes in the API Backend [cmdb_ci_api_backend] table are populated by 
collected data:

Attribute label Attribute name

ID id

URL url

Name name

Operational status operational_status

Type type

API Consumer [api_consumer]

The following attributes in the API Consumer [api_consumer] table are populated by collected 
data:

Attribute label Attribute name

ID id

Username username

API Gateway api_gateway

API Consumer Access [api_consumer_access]

The following attributes in the API Consumer Access [api_consumer_access] table are populated 
by collected data:
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Attribute label Attribute name

API api

API Consumer api_consumer

API Deployment [api_deployment]

The following attributes in the API Deployment [api_deployment] table are populated by 
collected data:

Attribute label Attribute name

Name name

API api

API Policy [api_policy]

The following attributes in the API Policy [api_policy] table are populated by collected data:

Attribute label Attribute name

Name name

Consumer consumer

ID id

Managed API managed_api

Relationship created for API Policy

Parent class Relationship type Child class

API Policy [api_policy] Reference Managed API 
[cmdb_ci_managed_api]

Key Value [cmdb_key_value]

The following attributes in the Key Value [cmdb_key_value] table are populated by collected data:

Attribute label Attribute name

Key key

Value value

Accessing the connection details of API Service Graph Connector for AWS API Gateway

You can access the connection details of the API Service Graph Connector for AWS API Gateway 
in a single view using the common connection framework included within the Integration 
Commons for CMDB  (sn_cmdb_int_util) store app.

With the CCF, you can access all the connections used by the API Service Graph Connector for 
AWS API Gateway. The connection details include the connection alias, connection properties, 
data sources, and scheduled data imports associated with a connection. You can also test 
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the connection. For more information, see Accessing the connection details of Service Graph 
Connectors.

Access the details of an AWS API Gateway  connection

Access the details of an AWS API Gateway  connection configured for the API Service Graph 
Connector for AWS API Gateway.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Service Graph Connectors  > AWS API Gateway  > Connections.

2. From the Name  column of the Service Graph Connections list, select a connection.

3. On the Service Graph Connections page, view the connection details such as the connection 
name and alias.

4. Select a related list to view further details of the connection.

5. Optional:  Select the Test Connection  related link to test the connection.

API Service Graph Connector for Azure API Management

Use the ServiceNow®  API Service Graph Connector for Azure API Management  to import 
API details from an Azure API Management  application into the Configuration Management 
Database (CMDB).

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Key features

Import data into a normalized data model for consistency across other technologies.

Supported ServiceNow  versions

• Washington DC

• Xanadu

• Yokohama

Use cases

You can use the API Service Graph Connector for Azure API Management  to:

• Maintain an end-to-end inventory of exposed and backend APIs, identifying what APIs are 
published, used, and by whom.

• Track APIs from customer-facing endpoints to the underlying services, identifying impacted 
endpoints when services change or fail and creating incidents for reported issues.

• Address vulnerabilities and security incidents related to API endpoints, and create compliance 
requirements to measure against.
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Configuring a connection for the connector

You can configure a connection for the connector by using the SGC Central  view in the CMDB 
Workspace. The view enables you to discover and install connectors, and then effectively 
manage the full life cycle of creating, editing, monitoring, and debugging connections. To 
configure the connector using SGC Central, see Configure API Service Graph Connector for 
Azure API Management using SGC Central.

Important: 
Unless there are configuration issues, use the SGC Central  view in the CMDB Workspace 
to configure the connection for the connector, as the guided setup method is being 
deprecated.

Data mapping

Data from the Azure API Management  data sources is mapped and transformed into the CMDB 
Configuration Item (CI) class definitions using the Robust Transform Engine (RTE). Data is 
inserted into the CMDB  using the Identification and Reconciliation Engine (IRE).

When you complete setting up the connection, you can configure the integration to periodically 
pull data from an Azure API Management  application.

The following table lists the data sources in the order they run, the staging tables, and the target 
tables as CMDB  CI and non-CMDB  classes for an Azure API Management  application.

Data mapping for Azure API Management

Data source Staging table Target tables

API 
Management 
Services

SGA Azure API Management 
[sn_azure_api_gw_sga_azure_api_management]

Azure API 
Management

Azure 
Subscription

Cloud 
Service 
Account

Resource 
Group

DNS Alias

Managed API SGA Azure Managed API 
[sn_azure_api_gw_sga_azure_managed_api]

Managed API

API Frontend 
Backend

SGA Azure API Frontend Backend 
[sn_azure_api_gw_sga_azure_api_frontend_backend_import]

API Frontend

API Backend

API GraphQL 
Frontend 
Backend

SGA Azure API GraphQL Frontend Backend 
[sn_azure_api_gw_sga_azure_api_graphql_frontend_backend]

API Frontend

API Backend

API Consumer SGA Azure API Consumer 
[sn_azure_api_gw_sga_azure_api_consumer]

API 
Consumer
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Data mapping for Azure API Management  (continued)

Data source Staging table Target tables

API Product SGA Azure API Product 
[sn_azure_api_gw_sga_azure_api_product]

API Product 
Bundle

API Consumer 
Subscription

SGA Azure API Consumer Subscription 
[sn_azure_api_gw_sga_azure_api_subscription]

API 
Consumer 
Subscription

API Tag API Tag [sn_azure_api_gw_api_tag] Key Value

API Consumer 
Access

SGA Azure API Consumer Access 
[sn_azure_api_gw_sga_azure_managed_api]

API 
Consumer 
Access

For more information on where data is saved when pulling data from an Azure API Management 
application, see Target tables for storing API Service Graph Connector for Azure API 
Management data.

You can use the IntegrationHub ETL app to view the data maps. See IntegrationHub ETL  for more 
information.

Configure API Service Graph Connector for Azure API Management  using SGC Central

Set up scheduled import jobs to pull in Azure API Management  data into your CMDB.

Before you begin
Install API Service Graph Connector for Azure API Management  version 1.0.0 or later from the 
ServiceNow Store. For ServiceNow Store  installation steps, see Install a ServiceNow Store 
application . 

Obtain the OAuth credentials from your Azure  administrator. Make a note of the following details:

• Application (client) ID

• Client Secret

• Directory (tenant) ID

• Connection URL

Role required: cmdb_inst_admin or admin

About this task
The playbook experience for onboarding connectors is activated with SGC Central  in the CMDB 
Workspace. To configure the SGC Central  application, see Configuring SGC Central  and for more 
information on how to interact with a playbook, see Interact with Playbook .

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the CMDB Workspace, select SGC Central.

3. On the Overview page, select Create connection.

Tip: 
Alternatively, you can select Create connection  on the All connections page.
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4. On the Create connection window, select the Azure API Management  connector type, and 
then select Create connection.

5. Complete the initial prerequisites when setting up a connection for the first time using a 
connector.

Note: 
This step is required only during the first-time setup. See Perform initial setup tasks when 
creating a connection in SGC Central.

6. Enter connection details and test the API connection for importing Azure API Management 
data.

a. In the Setup  stage of the playbook, select the Create and test connection  activity.

b. On the form, fill in the fields.

Create and test connection form

Field Description

Azure API Management Connection Name Name to identify the Azure API Management 
connection record.

For example, Azure API Management 
Connection.

Connection URL Base URL to connect to the Azure API 
Management  service.

Note: 
This field is automatically set to the 
URL to connect to the application. 
Leave the field value as is.

OAuth Client ID Application (client) ID of your Azure  client 
application as noted in the Before you begin 
section.

OAuth Client Secret Client Secret of your Azure  client application 
as noted in the Before you begin  section.

OAuth Token URL Token URL of your Azure  client application.

Based on the region of your Azure  client 
application, enter the token URL in one of 
the following formats:

▪ Global

https://login.microsoftonli
ne.com/<tenantid>/oauth2/v2
.0/token

▪ US Government

https://login.microsoftonli
ne.us/<tenantid>/oauth2/v2
.0/token
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Field Description

▪ China

https://login.partner.micro
softonline.cn/<tenantid>/oa
uth2/v2.0/token

▪ Germany

https://login.microsoftonli
ne.de/<tenantid>/oauth2/v2
.0/token

Where <tenantid>  is the tenant ID of 
your Azure  client application as noted in the 
Before you begin  section.

c. Select Create and test connection.

d. Once the connection test is complete, select Continue.

7. Optional:  Set the configuration properties for the connection.

Note: 
To skip this step, select Continue  for the Set configuration properties  activity.

a. In the Setup  stage of the playbook, select the Set configuration properties  activity.

b. Fill in the property details.

Azure API Management configuration properties

Property Description

Azure API Management connection

Discovery Scope Discovery scope of the Azure  client application. The available options 
are:

Management Group

Select Management Group  when the ServiceNow  service 
account has access to data within the Azure  management 
group.

Subscription

Select Subscription  when the ServiceNow  service 
account has access to data within the Azure  subscription 
only.

Subscription

Subscription Id(s) Subscription IDs of Azure API Management  services.

For multiple subscription IDs, separate them with commas. If the 
discovery scope is set to Subscription  and this field is left blank, all 
subscriptions for the specified tenant in the credentials are discovered.
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Property Description

Azure API Management connection

Management Group

Management 
Group Id(s)

Management group IDs of Azure API Management  services.

For multiple management groups, separate them with commas.

Get Nested 
Group 
Subscriptions

Option to enable retrieving data from all nested child subscriptions 
when Management Group  is set as the discovery scope.

Disable the property to exclude nested child subscriptions.

Optional Exclusive Configuration

ExcludeServices Azure API Management  services  that should be excluded from the 
connection.

For multiple services, separate them with commas. All gateways except 
those listed in the ExcludeServices  property are fetched.

ResourceGroups Resource group name of Azure API Management  services.

For multiple resource groups, separate their names with commas. If 
you leave this field empty, the data sources within the connector import 
data from all the available resource groups.

Usage Data Configuration

CollectUsageData option to enable usage data collection to retrieve API usage data over a 
specified duration.

c. Select Continue.

8. Configure the import schedule to import data at regular intervals.

a. In the Setup  stage of the playbook, select the Configure import schedule  activity.

b. Expand the Parent scheduled data import within the Import schedules list to select the API 
Management Services  import schedule associated with your connection.

Note: 
The connection name is prefixed to the schedule name.

c. In the Configure import schedule  dialog box, select the Active  check box, and then fill in the 
run schedule and time details.

For more information, see Schedule a data import .

d. Select Save.
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Alternatively, select Execute Now  to execute the import schedule immediately.

e. Select Continue.

9. In the Setup  stage of the playbook, select the Confirm connection creation  activity to verify 
whether the connection was created.

What to do next
Select View all connections  to review the connection details. The created connection appears in 
the Installed connections list.

Related topics

API Service Graph Connector for Azure API Management

Target tables for storing API Service Graph Connector for Azure API Management data

Configure API Service Graph Connector for Azure API Management  using the guided setup

Set up scheduled import jobs to pull in Azure API Management  data into your CMDB.

Before you begin
Important: 
Unless there are configuration issues, use the SGC Central  view in the CMDB Workspace 
to configure the connection for the connector, as the guided setup method is being 
deprecated.

Dependencies and requirements:

• The Integration Commons for CMDB store app, which is automatically installed. See 
Integration Commons for CMDB.

• The CMDB CI class models store app, which is automatically installed. See CMDB CI Class 
Models store app.

• The ITOM Discovery License plugin (com.snc.itom.discovery.license). You must activate this 
plugin.

• ITOM Licensing plugin (com.snc.itom.license). See Request Discovery .

Obtain the OAuth credentials from your Azure  administrator. Make a note of the following details:

• Application (client) ID

• Client Secret

• Directory (tenant) ID

• Connection URL

Role required: admin

Procedure

1. Verify that the application scope is set to the API Service Graph Connector for Azure API 
Management  application by using the application picker.
For more information, see Application picker .

2. Navigate to All  > Service Graph Connectors  > Azure API Management  > Setup.

3. On the API Service Graph Connector for Azure API Management  page, verify that the Quick 
Start  option is selected and then select Continue.
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4. Configure the authentication credentials to send requests to the Azure API Management 
application.

a. In the Configure the Connection and Credentials  section of the API Service Graph 
Connector for Azure API Management  page, select Start.

b. Configure the connection.

i. Select the Configure Azure authentication credentials  task.

ii. Select Click Here  to open the Connections page in a separate browser tab.

iii. Search for and select Edit  for Azure API Management Connection.

iv. In the Connection Information section of the Edit Connection window, fill in the fields.

Connection Information

Field Description

Azure API Management Connection Name Name to identify the Azure API 
Management  connection record.

Azure API Management 
Connection  is the default credential 
alias name. You can add multiple Azure API 
Management  instances. However, try not to 
modify the default connection name.

Connection URL Base URL to connect to the Azure API 
Management  service.

Based on the region of your Azure  client 
application, enter the URL in one of the 
following formats:

▪ Global

https://management.azure.
com

▪ US Government

htttps://management.usgovc
loudapi.net

▪ China

https://management.chinacl
oudapi.cn

▪ Germany

https://management.microso
ftazure.de/

v. In the Credential Information section of the Edit Connection window, fill in the fields.
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Credential Information

Field Description

OAuth Client ID Application (client) ID of your Azure client 
application as noted in the Before you 
begin  section.

OAuth Client Secret Client Secret of your Azure  client 
application as noted in the Before you 
begin  section.

OAuth Token URL Token URL of your Azure  client application.

Based on the region of your Azure  client 
application, enter the token URL in one of 
the following formats:

▪ Global

https://login.microsoftonl
ine.com/<tenantid>/oaut
h2/v2.0/token

▪ US Government

https://login.microsoftonl
ine.us/<tenantid>/oauth2/v
2.0/token

▪ China

https://login.partner.micr
osoftonline.cn/<tenantid>/
oauth2/v2.0/token

▪ Germany

https://login.microsoftonl
ine.de/<tenantid>/oauth2/v
2.0/token

Where <tenantid>  is the tenant ID of 
your Azure  client application as noted in 
the Before you begin  section.

vi. Select Edit and Get OAuth Token.

vii. Select Update.

viii. When the OAuth token flow is successfully completed, return to the guided setup page 
and set the Configure Azure authentication credentials  task to complete by selecting the 
Mark as complete  check box and then select Continue.

c. Configure a connection to manage Azure  resources via Azure API Management.

i. Select the Configure Properties  task.

ii. In the Service Graph Connection Properties related list, enter the values for the properties.
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Service Graph Connection Properties

Property Description

CollectionPeriod(days) Duration in days for collecting API usage data.

CollectUsageData Enable usage data collection to retrieve API usage data 
over a specified duration.

Discovery Scope Discovery scope of the Azure  client application. The 
available options are:

Management Group

Select Management Group  when the 
ServiceNow  service account has access to 
data within the Azure  management group.

Subscription

Select Subscription  when the ServiceNow 
service account has access to data within 
the Azure  subscription only.

ExcludeServices Azure API Management  services  that should be 
excluded from the connection.

For multiple services, separate them with 
commas. All gateways except those listed in the 
ExcludeServices  property are fetched.

GetNestedGroupSubscriptions Enable retrieving data from all nested child 
subscriptions when Management Group  is set as the 
discovery scope.

Set the property to false  to exclude nested child 
subscriptions.

ManagementGroupId Management group IDs of Azure API Management 
services.

For multiple management groups, separate them with 
commas.

PartitionSize Partition size for Azure  managed APIs if parallel loading 
is enabled.

Accepts a numeric value greater than zero. If left empty, 
the value is automatically calculated.

ResourceGroups Resource group name of Azure API Management 
services.

For multiple resource groups, separate their names with 
commas. If you leave this field empty, the data sources 
within the connector import data from all the available 
resource groups.

SubscriptionId Subscription IDs of Azure API Management  services.
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Property Description

For multiple subscription IDs, separate them with 
commas. If the discovery scope is set to Subscription 
and this field is left blank, all subscriptions for the 
specified tenant in the credentials are discovered.

Tip: 
To enter a property value, double-click (or use the keyboard shortcut) to enter a value 
in the Value  cell for the property.

iii. Set the Configure Properties  task to complete by selecting the Mark as complete  check 
box and then select Continue.

d. Test the connection.

i. Select the Test Connection  task.

ii. Test the connection by selecting the Test Connection  related link.

Testing the connection might take a few moments. The page is refreshed to show the test 
results.

iii. When the Status  field is set to Success, select Update.

If any of the tests have errors, follow the suggestions for remediation.

iv. Set the Test Connection  task to complete by selecting the Mark as complete  check box 
and then select Continue.

5. Optional:  Integrate with multiple Azure API Management  instances.

a. In the Add Multiple Instances  section of the API Service Graph Connector for Azure API 
Management  page, select Start.

b. Enable creating data sources for the new Azure API Management  connection.

i. Verify that you have edit permissions for the Datasource [sys_data_source] table.

ii. Select the Update Data Source Access  task.

iii. To edit the record, select the Global  application scope from the application picker.

iv. In the Application Access related list of the Data Source form that opens in another tab, 
select the Can create, Can update, and Can delete  check boxes.

v. Select Update.

vi. From the application picker, select the API Service Graph Connector for Azure API 
Management  application scope.

vii. Set the Update Data Source Access  task to complete by selecting the Mark as complete 
check box and then select Continue.

c. Enable creating a scheduled import job for the new Azure API Management  connection.

i. Ensure that you have edit permissions for the Scheduled data import 
[scheduled_import_set] table.

ii. Select the Update Scheduled Data Import Access  task.
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iii. To edit the record, select the Global  application scope from the application picker.

iv. In the Application Access related list of the Scheduled Data Import form, select the Can 
create, Can update, and Can delete  check boxes.

v. Select Update.

vi. From the application picker, select the API Service Graph Connector for Azure API 
Management  application scope.

vii. Set the Update Scheduled Data Import Access  task to complete by selecting the Mark as 
complete  check box and then select Continue.

d. Clear the cache on the Data Source [sys_data_source] and Scheduled Data Imports 
[scheduled_import_set] tables.

i. Select the Clear Cache for Data Source and Scheduled Data Imports tables  task.

ii. In the Run script  text box of the background script page, enter the following script:

GlideTableManager.invalidateTable("sys_data_source");
GlideCacheManager.flushTable("sys_data_source");
GlideTableManager.invalidateTable("scheduled_import_set");
GlideCacheManager.flushTable("scheduled_import_set");
GlideTableManager.invalidateTable("sys_db_object");
GlideCacheManager.flushTable("sys_db_object");

iii. Select Run Script  to run the background script in the global  scope.

The script may take several minutes to execute.

iv. After the script is executed, select Close.

v. From the application picker, select the API Service Graph Connector for Azure API 
Management  application scope.

vi. Set the Clear Cache for Data Source and Scheduled Data Imports tables  task to complete 
by selecting Mark as Complete.

e. Add another connection for the new Azure API Management  instance.

i. Verify that the application scope is set to the API Service Graph Connector for Azure API 
Management  application by using the application picker.

ii. Select the Add Another Connection  task and then select Click Here.

iii. On the Connections page that opens in another browser tab, select Add Connection.

iv. In the Create Connection window, fill in the connection, credentials, and subscription ID 
details.

v. Select Create and Get OAuth Token.

vi. Close the Connections page and return to the guided setup page tab.

vii. Set the Add Another Connection  task to complete by selecting the Mark as complete 
check box and then select Continue.

f. Add properties for the new connection.

i. Verify that the application scope is set to the API Service Graph Connector for Azure API 
Management  application by using the application picker.

ii. Select the Add Properties to New Connections  task.

iii. From the Name  column, select the connection name you created in step 5.e.
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iv. In the Service Graph Connection Properties related list, enter the values for the properties.

(Optional) For more information on properties, see 4.c.ii.

Tip: 
To enter a property value, double-click (or use the keyboard shortcut) to enter a value 
in the Value  cell for the property.

v. Set the Add Properties to New Connections  task to complete by selecting the Mark as 
complete  check box and then select Continue.

g. Test the new connection.

i. Select the Test New Connections  task.

ii. From the Name  column, select the connection name you created in step 5.e.

iii. Test the connection by selecting the Test Connection  related link.

Testing the connection might take a few moments. The page is refreshed to show the test 
results.

iv. When the Status  field is set to Success, select Update.

If any of the tests have errors, follow the suggestions for remediation.

v. Set the Test New Connections  task to complete by selecting the Mark as complete  check 
box and then select Continue.

6. Configure the scheduled job for the import of Azure API Management  data.

a. In the Set up Scheduled Import Jobs  section of the API Service Graph Connector for Azure 
API Management  page, select Start.

b. Select the API Management Services  scheduled job.
For a multiple instance setup, select the scheduled import created with the connection in 
step 5.e.

c. On the Scheduled Data Import form, verify the field values.

For more information, see Schedule a data import .

d. Select the Active  check box to activate the scheduled job.

e. In the Run  field, select Periodically  to specify how often the job will run.

f. Select Update.

g. Set the Set up Scheduled Import Jobs  task to complete by selecting the Mark as complete 
check box and then select Continue.

7. On the API Service Graph Connector for Azure API Management  page, select Complete  to 
save your changes.

8. In the Complete setup dialog box, select Complete  to complete the setup.

9. In the message box that appears, select Done.
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Target tables for storing API Service Graph Connector for Azure API Management  data

When you complete setting up the connection, you can configure the integration to periodically 
pull data from an Azure API Management  application. The data is saved in tables that extend 
from the Configuration item [cmdb_ci] classes and other non-CMDB classes.

Cloud Service Account [cmdb_ci_cloud_service_account]

The following attributes in the Cloud Service Account [cmdb_ci_cloud_service_account] table are 
populated by collected data:

Attribute label Attribute name

Account Id account_id

Name name

Object ID object_id

Datacenter Type datacenter_type

Operational status operational_status

Relationship created for Cloud Service Account

Parent class Relationship type Child class

Cloud Service Account 
[cmdb_ci_cloud_service_account]

Contains::Contained by Resource Group 
[cmdb_ci_resource_group]

Azure Subscription [cmdb_ci_azure_subscription]

The following attributes in the Azure Subscription [cmdb_ci_azure_subscription] table are 
populated by collected data:

Attribute label Attribute name

Name name

Object ID object_id

Operational status operational_status

Azure API Management [cmdb_ci_azure_api_mgmt]

The following attributes in the Azure API Management [cmdb_ci_azure_api_mgmt] table are 
populated by collected data:

Attribute label Attribute name

ID id

Name name

Fully qualified domain name fqdn

Gateway URL gateway_url

Operational status operational_status
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Attribute label Attribute name

Version version

Relationships created for Azure API Management

Parent class Relationship type Child class

Azure API Management 
[cmdb_ci_azure_api_mgmt]

Provides::Provided by API Product Bundle 
[cmdb_ci_api_product_bundle]

Azure API Management 
[cmdb_ci_azure_api_mgmt]

Provides::Provided by API Consumer Subscription 
[cmdb_ci_api_consumer_subscription]

Azure API Management 
[cmdb_ci_azure_api_mgmt]

Uses::Used by DNS Alias [cmdb_ci_dns_alias]

Azure API Management 
[cmdb_ci_azure_api_mgmt]

Provides::Provided by Managed API 
[cmdb_ci_managed_api]

Azure API Management 
[cmdb_ci_azure_api_mgmt]

Reference API Consumer [api_consumer]

Resource Group [cmdb_ci_resource_group]

The following attributes in the Resource Group [cmdb_ci_resource_group] table are populated by 
collected data:

Attribute label Attribute name

Name name

Object ID object_id

Operational status operational_status

DNS Alias [cmdb_ci_dns_alias]

The following attributes in the DNS Alias [cmdb_ci_dns_alias] table are populated by collected 
data:

Attribute label Attribute name

Name name

Managed API [cmdb_ci_managed_api]

The following attributes in the Managed API [cmdb_ci_managed_api] table are populated by 
collected data:

Attribute label Attribute name

ID id

Minor Version minor_version

Name name
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Attribute label Attribute name

Version version

Base URL base_url

Correlation ID correlation_id

Description short_description

Fully qualified domain name fqdn

Operational status operational_status

Type type

Life Cycle Stage Status life_cycle_stage_status

Life Cycle Stage life_cycle_stage

Model ID model_id

Relationships created for Managed API

Parent class Relationship type Child class

Managed API 
[cmdb_ci_managed_api]

Uses::Used by API Frontend 
[cmdb_ci_api_frontend]

Managed API 
[cmdb_ci_managed_api]

Uses::Used by API Backend 
[cmdb_ci_api_backend]

Managed API 
[cmdb_ci_managed_api]

Uses::Used by API Consumer Subscription 
[cmdb_ci_api_consumer_subscription]

Note: 
Applies only when 
the Discovered Scope 
[discovered_scope] 
attribute value is set to 
api.

API Frontend [cmdb_ci_api_frontend]

The following attributes in the API Frontend [cmdb_ci_api_frontend] table are populated by 
collected data:

Attribute label Attribute name

API Minor Version api_minor_version

API Version api_version

Host host

Method method

Path path

URL url

Description short_description
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Attribute label Attribute name

Name name

Operational status operational_status

Relationship created for API Frontend

Parent class Relationship type Child class

API Frontend 
[cmdb_ci_api_frontend]

Use End Point To::Use End 
Point From

API Backend 
[cmdb_ci_api_backend]

API Backend [cmdb_ci_api_backend]

The following attributes in the API Backend [cmdb_ci_api_backend] table are populated by 
collected data:

Attribute label Attribute name

Host host

ID id

Note: 
Applicable to GraphQL APIs only.

Method method

Note: 
Applicable to GraphQL APIs only.

Path path

URL url

Name name

Operational status operational_status

API Consumer [api_consumer]

The following attributes in the API Consumer [api_consumer] table are populated by collected 
data:

Attribute label Attribute name

ID id

Discovered State discovered_state

Email email

Provider provider

Registration Date registration_date

Username username
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API Product Bundle [cmdb_ci_api_product_bundle]

The following attributes in the API Product Bundle [cmdb_ci_api_product_bundle] table are 
populated by collected data:

Attribute label Attribute name

ID id

Discovered Access Type discovered_access_type

Discovered Approval Type discovered_approval_type

Discovered State discovered_state

Name name

Operational status operational_status

Relationships created for API Product Bundle

Parent class Relationship type Child class

API Product Bundle 
[cmdb_ci_api_product_bundle]

Contains::Contained by Managed API 
[cmdb_ci_managed_api]

API Product Bundle 
[cmdb_ci_api_product_bundle]

Used by::Uses API Consumer Subscription 
[cmdb_ci_api_consumer_subscription]

API Consumer Subscription [cmdb_ci_api_consumer_subscription]

The following attributes in the API Consumer Subscription [cmdb_ci_api_consumer_subscription] 
table are populated by collected data:

Attribute label Attribute name

ID id

Creation Date creation_date

Discovered Scope discovered_scope

Name name

Sys ID sys_id

API Consumer api_consumer

Operational status operational_status

Relationship created for API Consumer Subscription

Parent class Relationship type Child class

API Consumer Subscription 
[cmdb_ci_api_consumer_subscription]

Reference API Consumer Access 
[api_consumer_access]

Key Value [cmdb_key_value]

The following attributes in the Key Value [cmdb_key_value] table are populated by collected data:
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Attribute label Attribute name

Key key

Value value

API Consumer Access [api_consumer_access]

The following attributes in the API Consumer Access [api_consumer_access] table are populated 
by collected data:

Attribute label Attribute name

API Consumer api_consumer

Access type access_type

API Product Bundle api_product_bundle

State state

API Consumer Subscription api_consumer_subscription

API api

Valid to valid_to

Accessing the connection details of API Service Graph Connector for Azure API Management

You can access the connection details of the API Service Graph Connector for Azure API 
Management  in a single view using the common connection framework included within the 
Integration Commons for CMDB  (sn_cmdb_int_util) store app.

With the CCF, you can access all the connections used by the API Service Graph Connector 
for Azure API Management. The connection details include the connection alias, connection 
properties, data sources, and scheduled data imports associated with a connection. You can 
also test the connection. For more information, see Accessing the connection details of Service 
Graph Connectors.

Access the details of an Azure API Management  connection

Access the details of an Azure API Management  connection configured for the API Service 
Graph Connector for Azure API Management.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Service Graph Connectors  > Azure API Management  > Connections.

2. From the Name  column of the Service Graph Connections list, select a connection.

3. On the Service Graph Connections page, view the connection details such as the connection 
name and alias.

4. Select a related list to view further details of the connection.

5. Optional:  Select the Test Connection  related link to test the connection.
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API Service Graph Connector for Kong Gateway

Use the ServiceNow®  API Service Graph Connector for Kong Gateway  to import API details from 
a Kong Gateway  application into the Configuration Management Database (CMDB).

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Key features

Import data into a normalized data model for consistency across other technologies.

Supported ServiceNow  versions

• Washington DC

• Xanadu

• Yokohama

Use cases

You can use the API Service Graph Connector for Kong Gateway  to:

• Maintain an end-to-end inventory of exposed and backend APIs, identifying what APIs are 
published, used, and by whom.

• Track APIs from customer-facing endpoints to the underlying services, identifying impacted 
endpoints when services change or fail and creating incidents for reported issues.

• Address vulnerabilities and security incidents related to API endpoints, and create compliance 
requirements.

Configuring a connection for the connector

You can configure a connection for the connector by using the SGC Central  view in the CMDB 
Workspace. The SGC Central  view enables you to discover and install connectors, and then 
effectively manage the full life cycle of creating, editing, monitoring, and debugging connections. 
To configure the connector using SGC Central, see Configure API Service Graph Connector for 
Kong Gateway using SGC Central.

Important: 
Unless there are configuration issues, use the SGC Central  view in the CMDB Workspace 
to configure the connection for the connector, as the guided setup method is being 
deprecated.

Data mapping

Data from the Kong Gateway  data sources is mapped and transformed into the CMDB 
Configuration Item (CI) class definitions using the Robust Transform Engine (RTE). Data is 
inserted into the CMDB  using the Identification and Reconciliation Engine (IRE).

When you complete setting up the connection, you can configure the integration to periodically 
pull data from a Kong Gateway  application.

The following table lists the data sources in the order they run, the staging tables, and the target 
tables as CMDB  CI and non-CMDB  classes for a Kong Gateway  application.
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Data mapping for Kong Gateway

Data source Staging table Target tables

SG-Kong Gateway SG-Kong Gateway 
[sn_kong_integ_sg_kong_gateway] Kong Gateway

SG-Kong 
Workspaces

SG-Kong Workspaces 
[sn_kong_integ_sg_kong_workspaces]

Kong Workspace

SG-Kong Load 
Balancers

SG-Kong Load Balancers 
[sn_kong_integ_sg_kong_lbs]

Kong Load 
Balancer

SG-Kong Targets SG-Kong Targets [sn_kong_integ_sg_kong_targets] Kong Target

Key Value

SG-Kong Services SG-Kong Services 
[sn_kong_integ_sg_kong_services]

Managed API

API Backend

Key Value

SG-Kong Routes SG-Kong Routes [sn_kong_integ_sg_kong_routes] API Frontend

SG-Kong Consumers SG-Kong Consumers 
[sn_kong_integ_sg_kong_consumers]

API Consumer

SG-Kong Plugins SG-Kong Plugins [sn_kong_integ_sg_kong_plugins] API Policy

For more information on where data is saved when pulling data from a Kong Gateway  application, 
see Target tables for storing API Service Graph Connector for Kong Gateway data.

You can use the IntegrationHub ETL app to view the data maps. See IntegrationHub ETL  for more 
information.

Configure API Service Graph Connector for Kong Gateway  using SGC Central

Set up scheduled import jobs to pull in Kong Gateway  data into your Configuration Management 
Database (CMDB).

Before you begin
Install API Service Graph Connector for Kong Gateway  version 2.0.0 or later from the ServiceNow 
Store. For ServiceNow Store  installation steps, see Install a ServiceNow Store application .

Role required: admin

About this task
The playbook experience for onboarding connectors is activated with SGC Central  in the CMDB 
Workspace. To configure the SGC Central  application, see Configuring SGC Central  and for more 
information on how to interact with a playbook, see Interact with Playbook .

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the CMDB Workspace, select SGC Central.

3. On the Overview page, select Create connection.

Tip: 
Alternatively, you can select Create connection  on the All connections page.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1531

https://www.webstg.servicenow.com/docs/access?context=t_InstallApplications&version=washingtondc&pubname=washingtondc-application-development&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=t_InstallApplications&version=washingtondc&pubname=washingtondc-application-development&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=t_InstallApplications&version=washingtondc&pubname=washingtondc-application-development&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=playbook-ui&version=washingtondc&pubname=washingtondc-build-workflows&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=playbook-ui&version=washingtondc&pubname=washingtondc-build-workflows&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=playbook-ui&version=washingtondc&pubname=washingtondc-build-workflows&ft:locale=en-US


4. On the Create connection window, select the Kong  connector type, and then select Create 
connection.

5. Complete the initial prerequisites when setting up a connection for the first time using a 
connector.

Note: 
This step is required only during the first-time setup. See Perform initial setup tasks when 
creating a connection in SGC Central.

6. Select a template for the authentication type to create a connection.

a. In the Setup  stage of the playbook, select the Select alias template  activity.

b. Select a template type.

▪ Kong RBAC Authentication: Select when using token-based authentication.

▪ Kong Basic Authentication: Select when using basic authentication.

7. Enter connection details and test the API connection for importing Kong Gateway  data.

a. In the Setup  stage of the playbook, select the Configure and test connection  activity.

b. On the form, fill in the fields.

Configure and test connection form

Field Description

Connection Name Name to identify the Kong Gateway 
connection record.

Host Name Admin URL address of the Kong Admin 
API server.

Protocol Protocol used for the connection ensuring 
secured communication between the client 
and the Kong  server.

Override default port Port used by the Kong Admin  API.

API Key Authentication secret to connect to the 
Kong Gateway  service. This field appears 
only when Kong RBAC Authentication 
is selected in the Select alias template 
activity.

User Name User name required for authenticating 
requests to the Kong Gateway Admin 
API. This field appears only when Kong 
Basic Authentication  is selected in the 
Select alias template  activity.

Password Password associated with the user name 
required for authenticating requests. 
This field appears only when Kong Basic 
Authentication  is selected in the Select 
alias template  activity.
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c. Select Create and test connection.

d. Once the connection test is complete, select Continue.

8. Optional:  Set the configuration properties for the connection.

a. In the Setup  stage of the playbook, select the Set configuration properties  activity.

b. In the Exclude workspaces  field, enter the workspace that must be excluded from 
import.

(Optional) For multiple workspaces, separate them with commas. For example: 
workspace1,workspace2. If you leave this field empty, the data sources within the 
connector import data from all the workspaces.

c. Select the Import tags  check box, to ingest tags from the Kong Gateway  service..
When selected, specify the key-value pair separator for tags in the Tags value separator 
field. If not selected, tags won't be fetched.

d. In the Tags value separator  field, enter the separator for key and value in tags.
For example, if the tag value separator is set to =, the tag env=prod  is saved with env  as 
the key and prod  as the value.

If left empty, no tags will be ingested.

e. Select Continue.

9. Configure the import schedule to import data at regular intervals.

a. In the Setup  stage of the playbook, select the Configure import schedule  activity.

b. Select Configure import schedule.

c. Expand the Parent scheduled data import within the Import schedules list to select the SG-
Kong Gateway  import schedule.

d. In the Configure import schedule  dialog box, select the Active  check box, and then fill in the 
run schedule and time details.

For more information, see Schedule a data import .

e. Select Save.
Alternatively, select Execute Now  to execute the import schedule immediately.

f. Select Continue.

10. In the Setup  stage of the playbook, select the Confirm connection setup  activity to check 
whether the connection was configured.

What to do next
Select View all connections  to review the connection details. The configured connection 
appears in the Installed connections list.
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Related topics

API Service Graph Connector for Kong Gateway

Target tables for storing API Service Graph Connector for Kong Gateway data

Configure API Service Graph Connector for Kong Gateway  using the guided setup

Set up scheduled import jobs to pull in Kong Gateway  data into your Configuration Management 
Database (CMDB).

Before you begin
Important: 
Unless there are configuration issues, use the SGC Central  view in the CMDB Workspace 
to configure the connection for the connector, as the guided setup method is being 
deprecated.

Dependencies and requirements:

• The Integration Commons for CMDB store app, which is automatically installed. See 
Integration Commons for CMDB.

• The CMDB CI class models store app, which is automatically installed. See CMDB CI Class 
Models store app.

• The ITOM Discovery License plugin (com.snc.itom.discovery.license). You must activate this 
plugin.

• ITOM Licensing plugin (com.snc.itom.license). See Request Discovery .

For basic authentication, obtain the username and password required for authenticating 
requests to the Kong Gateway Admin  API.

For token-based authentication, obtain the API key for connecting to the Kong Gateway  service.

Role required: admin

Procedure

1. Verify that the application scope is set to the API Service Graph Connector for Kong Gateway 
application by using the application picker.
For more information, see Application picker .

2. Navigate to All  > Service Graph Connectors  > Kong Gateway  > Setup.

3. Configure the authentication type, credentials, and HTTP connection details.

a. In the Configure connection and credentials  section of the Kong Gateway Integration with 
CMDB  page, select Get Started.

b. Configure the authentication type.

i. For the Set authentication type  task, select Configure.

ii. Set the Auth Type  property to one of the following values:

▪ Basic: Basic authentication that uses a username and password.

▪ Token: Token-based authentication that uses a username and password to retrieve a 
token.

iii. Select Update.

iv. Set the Set authentication type  task to complete by selecting Mark as Complete.
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c. Configure the authentication credentials used for sending requests to the Kong Gateway 
Admin  API.

i. For the Configure the connection  task, select Configure.

ii. Based on the authentication type, select the connection type.

▪ For basic authentication, on the Connections page, search for and select Kong Basic 
Authentication  and then select View Details.

▪ For token-based authentication, on the Connections page, search for and select Kong 
RBAC Authentication  and then select View Details.

iii. Edit the basic authentication details available by default.

Note: 
Skip this step if using token-based authentication.

1. In the Connection Information section of the Edit Connection window, fill in the fields.

Connection Information

Field Description

Connection Name Name to identify the Kong Gateway 
connection record.

Kong Basic Authentication  is 
the default connection name. You can 
add multiple Kong Gateway  instances. 
However, try not to modify the default 
connection name.

Host Name Target domain name or IP address used to 
access the Kong Gateway  instance.

Protocol Protocol used for the connection ensuring 
secured communication between the 
client and the Kong  server. This field is 
automatically set to https. Valid values 
are:

▪ http

▪ https

Override default port Port used by the Kong Admin  API.

2. In the Credential Information section of the Edit Connection window, fill in the fields.

Credential Information

Field Description

User name Username required for authenticating 
requests to the Kong Gateway Admin 
API as noted in the Before you begin 
section.
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Field Description

Password Password associated with the username 
required for authenticating requests as 
noted in the Before you begin  section.

3. Select Edit Connection.

iv. Edit the token-based authentication details available by default.

Note: 
Skip this step if using basic authentication.

1. In the Connection Information section of the Edit Connection window, fill in the fields.

Connection Information

Field Description

Connection Name Name to identify the Kong Gateway 
connection record.

Kong RBAC Authentication  is 
the default connection name. You can 
add multiple Kong Gateway  instances. 
However, try not to modify the default 
connection name.

Host Name Target domain name or IP address used to 
access the Kong Gateway  instance.

Protocol Protocol used for the connection ensuring 
secured communication between the 
client and the Kong  server. This field is 
automatically set to https. Valid values 
are:

▪ http

▪ https

Override default port Port used by the Kong Admin  API.

2. In the Credential Information section of the Edit Connection window, in the API Key  field, 
enter the authentication secret to connect to the Kong Gateway  service as noted in the 
Before you begin  section.

3. Select Edit Connection.

v. Set the Configure the connection  task to complete by selecting Mark as Complete.

d. Configure the properties to control the scope of data retrieval.

i. For the Set configuration properties  task, select Configure.

ii. In the Service Graph Connection Properties related list, configure the properties.
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Properties

Property Description

Exclude Workspaces Name of the workspace to exclude. Entities 
in this workspace won't be populated in the 
Kong Gateway  service.

For multiple workspaces, separate 
them with commas. For example: 
workspace1,workspace2.

If you leave this field empty, the data 
sources within the connector import data 
from all the workspaces.

Import Tags Tags to ingest from the Kong Gateway 
service.

For multiple tags, separate them with 
commas.

When specified, enter the key-value pair 
separator for tags in the Tags Value 
Separator  property. If not specified, tags 
won't be fetched.

Tags Value Separator Separator for key and value in tags.

For example, if the tag value separator is 
set to =, the tag env=prod  is saved with 
env  as the key and prod  as the value.

If left empty, no tags are ingested.

Note: 
The Auth Type, Workspaces, and Load Balancers  properties are populated 
automatically.

iii. Set the Set configuration properties  task to complete by selecting Mark as Complete.

e. Test the connection.

i. For the Test connection  task, select Configure.

ii. Test the connection by selecting the Test Connection  related link.

Testing the connection might take a few moments. The page is refreshed to show the test 
results.

iii. When the Status  field is set to Success, select Update.

If any of the tests have errors, follow the suggestions for remediation.

iv. Set the Test connection  task to complete by selecting Mark as Complete.

4. Optional:  Add multiple instances.
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Note: 
If you don't need to add multiple instances, you can skip this step.

a. In the Add multiple Instances  section of the Kong Gateway Integration with CMDB  page, 
select Get Started.

b. Enable creating data sources for the new Kong Gateway  connection.

i. Ensure that you have edit permissions for the Datasource [sys_data_source] table.

ii. For the Update data source access  task, select Configure.

iii. To edit the record, select the Global  application scope from the application picker.

iv. In the Application Access related list of the Update Data Source Access form, select the 
Can create, Can update, and Can delete  check boxes.

v. Select Update.

vi. Select the API Service Graph Connector for Kong Gateway  application by using the 
application picker.

vii. Set the Update data source access  task to complete by selecting Mark as Complete.

c. To enable creating data sources for the new connection, clear the cache of the tables Data 
Source [sys_data_source] and Tables [sys_db_object].
To clear the cache:

i. For the Clear cache  task, select Configure.

ii. In the Run script  text box of the background script page, enter the following script:

GlideTableManager.invalidateTable("sys_data_source");
      GlideCacheManager.flushTable("sys_data_source");
      GlideTableManager.invalidateTable("sys_db_object");
      GlideCacheManager.flushTable("sys_db_object"); 

iii. Select Run Script  to run the background script in the global  scope.

The script may take several minutes to execute.

iv. After the script is executed, select Close.

v. Select the API Service Graph Connector for Kong Gateway  application by using the 
application picker.

vi. Set the Clear cache  task to complete by selecting Mark as Complete.

d. Add a new connection.

i. For the Add another connection  task, select Configure.

ii. Based on the authentication type, select the connection type.

▪ For basic authentication, on the Connections page, search for and select Kong Basic 
Authentication  and then select Add Connection.

▪ For token-based authentication, on the Connections page, search for and select Kong 
RBAC Authentication  and then select Add Connection.

iii. Fill in the basic authentication details.

Note: 
Skip this step if using token-based authentication.
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1. In the Connection Information section of the Create Connection window, fill in the fields.

Connection Information

Field Description

Connection Name Name to identify the Kong Gateway 
connection record.

Host Name Target domain name or IP address used to 
access the Kong Gateway  instance.

Protocol Protocol used for the connection ensuring 
secured communication between the 
client and the Kong  server. This field is 
automatically set to https. Valid values 
are:

▪ http

▪ https

Override default port Port used by the Kong Admin  API.

2. In the Credential Information section of the Create Connection window, fill in the fields.

Credential Information

Field Description

User name Username required for authenticating 
requests to the Kong Gateway Admin 
API as noted in the Before you begin 
section.

Password Password associated with the username 
required for authenticating requests as 
noted in the Before you begin  section.

3. Select Create Connection.

iv. Fill in the token-based authentication details.

Note: 
Skip this step if using basic authentication.

1. In the Connection Information section of the Create Connection window, fill in the fields.

Connection Information

Field Description

Connection Name Name to identify the Kong Gateway 
connection record.

Host Name Target domain name or IP address used to 
access the Kong Gateway  instance.

Protocol Protocol used for the connection ensuring 
secured communication between the 
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Field Description

client and the Kong  server. This field is 
automatically set to https. Valid values 
are:

▪ http

▪ https

Override default port Port used by the Kong Admin  API.

2. In the Credential Information section of the Create Connection window, in the API Key 
field, enter the authentication secret to connect to the Kong Gateway  service as noted in 
the Before you begin  section.

3. Select Create Connection.

v. Set the Add another connection  task to complete by selecting Mark as Complete.

e. Configure the properties for the new connection.

i. For the Set configuration properties for new connection  task, select Configure.

ii. From the Name column, select the connection record of the new connection.

iii. In the Service Graph Connection Properties related list, configure the properties.

Properties

Property Description

Exclude Workspaces Name of the workspace to exclude. Entities 
in this workspace won't be populated in the 
Kong Gateway  service.

For multiple workspaces, separate 
them with commas. For example: 
workspace1,workspace2. If you leave 
this field empty, the data sources within 
the connector import data from all the 
workspaces.

Import Tags Tags to ingest from the Kong Gateway 
service.

For multiple tags, separate them with 
commas.

When specified, enter the key-value pair 
separator for tags in the Tags Value 
Separator  property. If not specified, tags 
won't be fetched.

Tags Value Separator Separator for key and value in tags.

(Optional) For example, if the tag value 
separator is set to =, the tag env=prod 
is saved with env  as the key and prod  as 
the value.
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Property Description

If left empty, no tags are ingested.

Note: 
The Auth Type, Workspaces, and Load Balancers  properties are populated 
automatically.

iv. Select Update.

v. Set the Set configuration properties for new connection  task to complete by selecting 
Mark as Complete.

f. Test the new connection.

i. For the Test new connections  task, select Configure.

ii. From the Name column, select the connection record of the new connection.

iii. Test the connection by selecting the Test Connection  related link.

Testing the connection might take a few moments. The page is refreshed to show the test 
results.

iv. When the Status  field is set to Success, select Update.

If any of the tests have errors, follow the suggestions for remediation.

v. Set the Test new connections  task to complete by selecting Mark as Complete.

g. Repeat steps from 4.a  until 4.f  to add another instance.

5. Set up the scheduled import jobs.

a. In the Set up scheduled import jobs  section of the Kong Gateway Integration with CMDB 
page, select Get Started.

b. For the Configure the scheduled import  task, select Configure.

c. From the Name column, select the parent scheduled job SG-Kong Gateway.

d. On the Scheduled Data Import form, verify the field values for the scheduled job.

For more information, see Schedule a data import .

e. Select the Active  check box to activate the SG-Kong Gateway scheduled import.

f. In the Run  field, select Periodically  to specify how often the job will run.

g. Select Update.

h. Set the Configure the scheduled import  task to complete by selecting Mark as Complete.
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Target tables for storing API Service Graph Connector for Kong Gateway  data

When you complete setting up the connection, you can configure the integration to periodically 
pull data from a Kong Gateway  application. The data is saved in tables that extend from the 
Configuration item [cmdb_ci] classes and other non-CMDB classes.

Kong Gateway [cmdb_ci_kong_gateway]

The following attributes in the Kong Gateway [cmdb_ci_kong_gateway] table are populated by 
collected data:

Attribute label Attribute name

ID id

Name name

Admin URL admin_url

Database database

Description short_description

Version version

Relationships created for Kong Gateway

Parent class Relationship type Child class

Kong Gateway 
[cmdb_ci_kong_gateway]

Provides::Provided by Kong Load Balancer 
[cmdb_ci_kong_lb]

Kong Gateway 
[cmdb_ci_kong_gateway]

Provides::Provided by Managed API 
[cmdb_ci_managed_api]

Kong Gateway 
[cmdb_ci_kong_gateway]

Reference Kong Workspace 
[kong_workspace]

Kong Gateway 
[cmdb_ci_kong_gateway]

Reference API Policy [api_policy]

Kong Gateway 
[cmdb_ci_kong_gateway]

Reference API Consumer [api_consumer]

Kong Workspace [kong_workspace]

The following attributes in the Kong Workspace [kong_workspace] table are populated by 
collected data:

Attribute label Attribute name

ID id

Name name

API Gateway api_gateway
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Relationship created for Kong Workspace

Parent class Relationship type Child class

Kong Workspace 
[kong_workspace]

Reference Kong Gateway 
[cmdb_ci_kong_gateway]

API Policy [api_policy]

The following attributes in the API Policy [api_policy] table are populated by collected data:

Attribute label Attribute name

Frontend frontend

ID id

Active active

Name name

Protocols protocols

Managed API managed_api

Consumer consumer

API Gateway api_gateway

Relationship created for API Policy

Parent class Relationship type Child class

API Policy [api_policy] Reference Kong Gateway 
[cmdb_ci_kong_gateway]

API Consumer [api_consumer]

The following attributes in the API Consumer [api_consumer] table are populated by collected 
data:

Attribute label Attribute name

ID id

API Gateway api_gateway

Custom ID custom_id

Username username

Relationship created for API Consumer

Parent class Relationship type Child class

API Consumer [api_consumer] Reference Kong Gateway 
[cmdb_ci_kong_gateway]
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Kong Load Balancer [cmdb_ci_kong_lb]

The following attributes in the Kong Load Balancer [cmdb_ci_kong_lb] table are populated by 
collected data:

Attribute label Attribute name

ID id

Name name

Algorithm algorithm

Relationships created for Kong Load Balancer

Parent class Relationship type Child class

Kong Load Balancer 
[cmdb_ci_kong_lb]

Contains::Contained by Kong Target 
[cmdb_ci_kong_target]

Kong Load Balancer 
[cmdb_ci_kong_lb]

Reference Key Value [cmdb_key_value]

Kong Target [cmdb_ci_kong_target]

The following attributes in the Kong Target [cmdb_ci_kong_target] table are populated by 
collected data:

Attribute label Attribute name

ID id

Name name

Target target

Relationship created for Kong Target

Parent class Relationship type Child class

Kong Target 
[cmdb_ci_kong_target]

Reference Key Value [cmdb_key_value]

Managed API [cmdb_ci_managed_api]

The following attributes in the Managed API [cmdb_ci_managed_api] table are populated by 
collected data:

Attribute label Attribute name

Life Cycle Stage life_cycle_stage

Life Cycle Stage Status life_cycle_stage_status

ID id

Name name
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Attribute label Attribute name

Base URL base_url

Type type

Model ID model_id

Relationships created for Managed API

Parent class Relationship type Child class

Managed API 
[cmdb_ci_managed_api]

Uses::Used by API Frontend 
[cmdb_ci_api_frontend]

Managed API 
[cmdb_ci_managed_api]

Uses::Used by API Backend 
[cmdb_ci_api_backend]

API Frontend [cmdb_ci_api_frontend]

The following attributes in the API Frontend [cmdb_ci_api_frontend] table are populated by 
collected data:

Attribute label Attribute name

Host host

ID id

Method method

Path path

URL url

Name name

Protocol protocol

Relationship created for API Frontend

Parent class Relationship type Child class

API Frontend 
[cmdb_ci_api_frontend]

Use End Point To::Use End 
Point From

API Backend 
[cmdb_ci_api_backend]

API Backend [cmdb_ci_api_backend]

The following attributes in the API Backend [cmdb_ci_api_backend] table are populated by 
collected data:

Attribute label Attribute name

Host host

ID id

Path path

URL url
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Attribute label Attribute name

Name name

Port port

Protocol protocol

Relationship created for API Backend

Parent class Relationship type Child class

API Backend 
[cmdb_ci_api_backend]

Uses::Used by Kong Load Balancer 
[cmdb_ci_kong_lb]

Key Value [cmdb_key_value]

The following attributes in the Key Value [cmdb_key_value] table are populated by collected data:

Attribute label Attribute name

Configuration item configuration_item

Key key

Value value

Accessing the connection details of API Service Graph Connector for Kong Gateway

You can access the connection details of the API Service Graph Connector for Kong Gateway  in 
a single view using the common connection framework included within the Integration Commons 
for CMDB  (sn_cmdb_int_util) store app.

With the CCF, you can access all the connections used by the API Service Graph Connector 
for Kong Gateway. The connection details include the connection alias, connection properties, 
data sources, and scheduled data imports associated with a connection. You can also test 
the connection. For more information, see Accessing the connection details of Service Graph 
Connectors.

Access the details of a Kong Gateway  connection

Access the details of a Kong Gateway  connection configured for the API Service Graph 
Connector for Kong Gateway.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Service Graph Connectors  > Kong Gateway  > Connections.

2. From the Name  column of the Service Graph Connections list, select a connection.

3. On the Service Graph Connections page, view the connection details such as the connection 
name and alias.

4. Select a related list to view further details of the connection.

5. Optional:  Select the Test Connection  related link to test the connection.
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SGC Central

The ServiceNow®  Service Graph Connector Central  view also called as the SGC Central  view 
in the CMDB Workspace  enables you to discover and install connectors, and then effectively 
manage the full life cycle of creating, editing, monitoring, and debugging connections.

Get started

Explore

Learn about the benefits of 
SGC Central and how it is used.

Configure

Plan and configure your implementation.

Onboard

Onboard Service Graph Connectors
to import third-part data into CMDB.

Reference

Get details about installed components.

Troubleshoot and get help

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support

Exploring SGC Central

Learn about the SGC Central  application with a sample workflow and review the benefits it can 
provide for different users in your organization.

SGC Central  overview

With the SGC Central  application you can discover and install integration-ready Service Graph 
Connectors, monitor their connection performance and insights, ensure complete visibility into 
discovered sources and processed data, and access tools and resources for diagnosing and 
resolving connection issues. You access the application from the SGC Central  view in the CMDB 
Workspace.
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SGC Central  users

Users

User Description

Administrator Users with the admin role can install and upgrade Service 
Graph Connectors, create a connection and configure 
connection properties, monitor connections and data imports, 
and manage connections.

CMDB  installation 
administrator

Users with the cmdb_inst_admin role can access the SGC 
Central  view in CMDB Workspace  to view a list of Service 
Graph Connectors  installed on a ServiceNow  instance.They 
can also create a connection and configure connection 
properties, monitor connections and data imports, and 
manage connections..
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SGC Central  workflow

Example workflow for the SGC Central  users

A user with the admin or cmdb_inst_admin role uses SGC Central  to perform the following tasks:

1. Based on the connection type, searches for a Service Graph Connector  within the SGC 
Central  view in CMDB Workspace.

2. Selects a connector type and creates the connection using the playbook available for the 
connector.
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a. Configures the properties for the connection.

b. Sets up import schedules for targeted data sources.

3. Tracks the third-party data imported by the system using the connection into CMDB.

4. Monitors the SGC Central  dashboard for any errors in the connection or the data processing 
pipeline.

5. Makes edits to the configuration or import schedules if needed.

SGC Central  benefits

SGC Central  benefits

Benefit Feature Users

Visualize connection status Integrated dashboard 
to gain instant 
insights into the 
connection status of 
your connectors and 
performance, keeping 
your connections 
running smoothly. 
In addition, quickly 
debug for seamless 
integration.

Administrator, 
CMDB  installation 
administrator

Discover integration-ready connectors Explore and install 
connectors based 
on the connection 
type requirements. 
See which connectors 
have new versions 
available and are 
eligible for upgrade.

Administrator

Manage connections intuitively Create or modify 
connections to your 
needs.

Administrator, 
CMDB  installation 
administrator

What to explore next

To learn more about configuring and using SGC Central, see:

• Configuring SGC Central

• Managing connections added for Service Graph Connectors in SGC Central

• SGC Central reference

Configuring SGC Central

Set up the SGC Central  application for onboarding and maintaining Service Graph Connectors 
and monitoring the errors related to connections added using Service Graph Connectors.
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Configuration checklist

1. Install SGC Central.

Note: 
If you don't see the SGC Central  view in the CMDB Workspace, clear the browser cache 
and try accessing the view again.

2. Configure scheduled jobs for data collection.

Note: 
If you don't see data on the SGC Central  dashboard, run scheduled jobs to display data 
on the SGC Central  dashboard.

3. Onboard Service Graph Connectors  within SGC Central.

4. Configure the Service Graph Connector  settings within SGC Central.

Install SGC Central

You can install the SGC Central  application (sn_sgc_central) if you have the admin role. The 
application installs related ServiceNow®  Store  applications and plugins if they are not already 
installed.

Before you begin

• Ensure that the application and all of its associated ServiceNow Store  applications have valid 
ServiceNow  entitlements. For more information, see Get entitlement for a ServiceNow  product 
or application .

• Review the SGC Central  application listing in the ServiceNow Store  for information on 
dependencies, licensing or subscription requirements, and release compatibility.

• Review the supported CMDB Workspace  versions for the corresponding ServiceNow  versions 
as listed in the following table.

ServiceNow  versions and supported CMDB Workspace  versions

ServiceNow  versions Supported CMDB Workspace  versions

Xanadu 7.0.9 or later

Washington DC 6.2.0 or later

Vancouver 5.5.0 or later

Role required: admin

About this task
The following items are installed with SGC Central:

• Plugins

• Store applications

• Scheduled jobs

• Tables

For more information, see Components installed with SGC Central.
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Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the SGC Central  application ((sn_sgc_central)) using the filter criteria and search bar.

You can search for the application by its name or ID. If you cannot find the application, you 
might have to request it from the ServiceNow Store.

In the list next to the Install  button, the versions that are available to you are displayed.

3. Select a version from the list and select Install.

In the Install dialog box that is displayed, any dependencies that are installed along with your 
application are listed.

4. If you're prompted, follow the links to the ServiceNow Store  to get any additional entitlements 
for dependencies.

5. Optional:  If demo data is available and you want to install it, select the Load demo data  check 
box.
Demo data comprises the sample records that describe application features for the common 
use cases. Load the demo data when you first install the application on a development or test 
instance.

Important: 
If you don't load the demo data during installation, it's unavailable to load later.

6. Select Install.

Configuring scheduled jobs for SGC Central

You can configure scheduled jobs to automate data collection for tracking integration 
performance, errors, and processing status of Service Graph Connectors  within the SGC Central 
application.

Scheduled jobs ensure that integration performance data is consistently gathered and available 
for reporting and analysis within SGC Central. For more information on configuring a scheduled 
job, see Scheduled jobs .

Types of scheduled jobs in SGC Central

SGC Central  provides different scheduled jobs to meet various data collection needs:

SGC central collection

Collects score and metric data displayed on the SGC Central  dashboard for the 
latest integration activity. This job runs daily automatically or as configured.

Note: 
As a user with the admin role, you must run this scheduled job immediately 
after installing SGC Central  and update its schedule based on your 
preferences to reflect the latest integration activity.

SGC central collection onDemand with lookback

Enables on-demand collection of historical integration data for analysis. The job 
collects scores for a lookback period of 30 days, meaning it gathers data from 30 
days ago to today (0 days ago), enabling historical data collection for performance 
analysis.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1552

https://www.webstg.servicenow.com/docs/access?context=c_ScheduledJobs&version=washingtondc&pubname=washingtondc-platform-administration&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=c_ScheduledJobs&version=washingtondc&pubname=washingtondc-platform-administration&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=c_ScheduledJobs&version=washingtondc&pubname=washingtondc-platform-administration&ft:locale=en-US


Note: 
As a user with the admin role, you can run this scheduled job on demand, 
rather than on a daily schedule.

Exploring Service Graph Connectors  in SGC Central

You can explore available options for onboarding and maintaining Service Graph Connectors 
within the SGC Central  view of the CMDB Workspace.

Service Graph Connectors  are integrations that facilitate data ingestion into the Configuration 
Management Database (CMDB)  from various third-party sources. To learn more, see Getting 
started with Service Graph Connectors.

Options for maintaining Service Graph Connectors  in SGC Central  include:

• Updating an installed Service Graph Connector.

• Installing a Service Graph Connector  using an available entitlement.

• Installing a Service Graph Connector  from the ServiceNow Store.

Update an installed Service Graph Connector  in SGC Central

Keep a Service Graph Connector  up-to-date within SGC Central.

Before you begin
Role required: admin

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the CMDB Workspace, select SGC Central.

3. Select Explore connectors.

4. In the Updates available section, review the updates that are available for a Service Graph 
Connector.

5. Update the connector.

◦ Select a connector to access the connector in Application Manager  and then install any 
updates.

◦ Select Install updates  to open Application Manager, and then view and install updates for a 
connector from the Updates  tab.

For more information, see Application Manager .

Install a Service Graph Connector  with an available entitlement in SGC Central

Install a Service Graph Connector  that matches an entitlement available in Application Manager 
from within the SGC Central  view of the CMDB Workspace.

Before you begin
Role required: admin

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the CMDB Workspace, select SGC Central.

3. Select Explore connectors.

4. In the Entitlements available section, select Explore in Application Manager.
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5. In Application Manager, review the entitlements and install a connector.
For more information, see Application Manager .

Install a Service Graph Connector  from ServiceNow Store  in SGC Central

Explore ServiceNow Store  to request and use a Service Graph Connector  with no available 
entitlements from within the SGC Central  view of the CMDB Workspace.

Before you begin
Role required: admin

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the CMDB Workspace, select SGC Central.

3. Select Explore connectors.

4. In the Available from ServiceNow Store section, select Explore in ServiceNow Store.

5. On ServiceNow Store, review the list of Service Graph Connectors  and install a connector.
For more information, see the ServiceNow Store  website.

Configuring Service Graph Connectors  settings in SGC Central

You can view and configure settings for your Service Graph Connectors  within the SGC Central 
view of the CMDB Workspace.

In SGC Central, you can configure Service Graph Connectors  settings related to system 
properties. See Configure system properties for a Service Graph Connector in SGC Central.

Configure system properties for a Service Graph Connector  in SGC Central

Configure system properties for a Service Graph Connector  within the SGC Central  view of the 
CMDB Workspace.

Before you begin
Role required: admin

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the CMDB Workspace, select SGC Central.

3. Select Settings.

4. In the Browse system properties by connector section, select an available Service Graph 
Connector.

Note: 
When you select a connector type, the application scope changes to the selected type.

5. On the system properties page of the Service Graph Connector, select a property from the 
Name  column.

6. Review and modify the system property.

7. Select Save.

8. Repeat steps from 5  to 7  for any other property.
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Managing connections added for Service Graph Connectors  in SGC Central

You can create and update connections added for Service Graph Connectors  within the SGC 
Central  view of the CMDB Workspace  to ingest data into Configuration Management Database 
(CMDB) from third-party sources.

You can create and manage the connections for the following connectors:

• API Service Graph Connector for Apigee X

• API Service Graph Connector for AWS API Gateway

• API Service Graph Connector for Azure API Management

• Service Graph Connector for GCP

• API Service Graph Connector for Kong Gateway

• Service Graph Connector for AWS

• Service Graph Connector for Infoblox

• Service Graph Connector for Jamf

• Service Graph Connector for Microsoft Azure

• Service Graph Connector for Microsoft Defender Endpoint

• Service Graph Connector for Microsoft Intune

• Service Graph Connector for Microsoft SCCM

• Service Graph Connector for Observability - AppDynamics

• [store-future: BEGIN review]Service Graph Connector for Observability - Datadog[End]

• Service Graph Connector for Observability - Dynatrace

• Service Graph Connector for Observability - New Relic

• Service Graph Connector for SolarWinds

• Service Graph Connector for Tanium

• Service Graph Connector for Trellix

• Service Graph Connector for Wiz

What to do next

• Create a connection.

Create a connection added for a Service Graph Connector  within SGC Central.

• Update a connection.

Update a connection using a Service Graph Connector  within SGC Central.

• View a connection.

View installed and draft connections that were added using Service Graph Connectors  within 
SGC Central.

• Monitor and analyze connections.

Monitor the installation, performance, and error handling of Service Graph Connectors  from 
the Overview page in the Service Graph Connector Central  view of the CMDB Workspace.
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• Access IntegrationHub ETL to create and manage ETL transform maps.

Access the IntegrationHub ETL dashboard within SGC Central  to manage ETL transform maps.

Perform initial setup tasks when creating a connection in SGC Central

Complete the prerequisites for setting up a connection for the first time using a Service Graph 
Connector  within the SGC Central  view of the CMDB Workspace.

Before you begin
Role required: admin

About this task
During the initial connection setup with a Service Graph Connector, a few tasks appear in the 
Prerequisites stage. Complete these tasks before proceeding to the next steps.

Procedure

1. Create data sources for the connection.

a. Ensure that you have edit permissions for the Datasource [sys_data_source] table.

b. In the Prerequisites  stage of the playbook, select the Update data source access  activity.

c. Select Update access.

d. To edit the record, select the Global  application scope from the application picker.

e. In the Application Access related list of the Data Source form, select the Can create, Can 
update, and Can delete  check boxes.

f. Select Update.

g. From the application picker, select the application scope of the connector.

h. After completing the Update data source access  activity, select Continue.

2. Clear the cache on the Data Source [sys_data_source] table.

a. In the Prerequisites  stage of the playbook, select the Clear cache  activity.

b. Select Run clear cache.

c. In the Run script  text box of the background script page, enter the following script:

GlideTableManager.invalidateTable("sys_data_source");
GlideCacheManager.flushTable("sys_data_source");
GlideTableManager.invalidateTable("sys_db_object");
GlideCacheManager.flushTable("sys_db_object");

d. Select Run Script  to run the background script in the global  scope.

The script may take several minutes to execute.

e. After the script is executed, select Close.

f. From the application picker, select the application scope of the connector.

g. After completing the Clear cache  activity, select Continue.

Create a connection for a Service Graph Connector  in SGC Central

Create a connection added for a Service Graph Connector  within the SGC Central  view of the 
CMDB Workspace.
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Before you begin
Role required: cmdb_inst_admin or admin

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the CMDB Workspace, select SGC Central.

3. On the Dashboard page, select Create connection.

Tip: 
Alternatively, you can select Create connection  on the All connections page.

4. On the Create connection window, select a connector type and then follow the playbook 
instructions to create a connection.

If the playbook experience isn't supported for a connector, follow the guided setup 
instructions.

Note: 

◦ When you select a connector type, the application scope changes to the selected type.

◦ When setting up a connection using a Service Graph Connector  for the first time, you 
might need to complete the initial setup tasks. See Perform initial setup tasks when 
creating a connection in SGC Central.

Update a connection for a Service Graph Connector  in SGC Central

Update a connection configured for a Service Graph Connector  within the SGC Central  view of 
the CMDB Workspace.

Before you begin
Role required: cmdb_inst_admin or admin

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the CMDB Workspace, select SGC Central.

3. Select All connections.

4. Select the Installed  tab.

5. Select a connection from the Connection  column.

Note: 
When you select a connection, the application scope changes to the selected connector 
type.

6. On the Details  tab, review and modify the details for a connection.

7. Select Update and test connection.

8. Optional:  Select a tab to view further details of the connection, such as data sources, import 
schedules, and any errors.
Additional tabs might appear depending on the connector type.
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Viewing connections for a Service Graph Connector  in SGC Central

You can view installed and draft connections that were added using Service Graph Connectors 
within the SGC Central  view of the CMDB Workspace.

The following connection types are available for viewing:

• Installed connection (see View an installed connection in SGC Central.)

• Draft connection (see View a draft connection in SGC Central.)

View an installed connection in SGC Central

View the details of an installed connection that was added using a Service Graph Connector 
within the SGC Central  view of the CMDB Workspace.

Before you begin
Role required: cmdb_inst_admin or admin

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the CMDB Workspace, select SGC Central.

3. Select All connections.

4. Select the Installed  tab.

5. Review the list of installed connections.

6. Select a connection from the Connection  column to view the details, data sources, import 
schedules, and errors associated with the connection.

Note: 
When you select a connection, the application scope changes to the selected connector 
type.

View a draft connection in SGC Central

View the details and resume setting up draft connections.

Before you begin
Role required: cmdb_inst_admin or admin

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the CMDB Workspace, select SGC Central.

3. Select All connections.

4. Select the Drafts  tab.

5. Review the list of draft connections.

6. Complete setting up the draft connections.

◦ Select Configure  to continue where a Service Graph Connector  was last configured within 
SGC Central.

◦ Select Resume setup  to set up a single instance connector for the first time.

Note: 
When you select a connection, the application scope changes to the selected connector 
type.
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Monitoring and analyzing connections added for Service Graph Connectors  in SGC Central

The Overview page in the Service Graph Connector Central  (SGC Central) view of the CMDB 
Workspace  provides a centralized dashboard view for administrators to monitor the installation, 
performance, and error handling of Service Graph Connectors.
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Access the SGC Central  Overview page

To open the dashboard, navigate to CMDB Workspace  > SGC Central.

Required roles

• admin

• cmdb_inst_admin

Use cases

For examples of how different people in your organization would use this dashboard, see these 
use cases.

User Dashboard use

Administrators or CMDB installation 
administrator

Proactively monitor, analyze, and optimize 
data imports to identify issues and track 
performance.

Overview page features

Use the Overview page to monitor and troubleshoot your Service Graph Connectors  connections 
through dedicated sections, filters, indicators, and visual reports and gain insights on the 
performance of Service Graph Connectors.

Feature description

Feature Description

Connections overview Displays the current state of your configured 
Service Graph Connector  connections, 
including status, execution results, and error 
summaries.

Ingested and processed data Displays key metrics related to the data 
imported and processed from third-party 
applications.

Data processing performance Displays how many configuration items (CIs) 
were added or updated over time, in addition 
to the number of processing errors.

Filters Enables narrowing the data shown in graphs 
and metrics based on connector type, 
connection, data source, or date range.

Indicators Enables viewing of high-level metrics that 
reflect the volume and quality of imported data 
and help identify issues such as incomplete or 
failed import set processing.

Reports Enables real-time visualizations that provide 
insights into data ingestion, processing trends, 
and error categorization across your Service 
Graph Connector  connections.
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Connections overview

Displays the current state of your configured Service Graph Connector  connections, including 
status, execution results, and error summaries.

Connections overview section

Card Description Card summary table

Connection 
status

Percentage of connections 
tested successfully based on 
connection status, with the count 
of success, error, and unknown 
statuses.

The connection status summary table 
displays the following details:

Connection

Displays the name of the 
configured Service Graph 
Connector. Each entry links 
to more details about the 
connection.

Connector type

Displays the Service Graph 
Connector  type as the 
integration source or platform for 
the connection.

Connection status

Displays the current state of 
each connection. Valid values 
include:

Success

All connections 
were configured 
and tested without 
errors.

Error

Connection 
configuration issues 
encountered during 
setup.

Error summary

Provides a short description 
of the most recent connection 
error, if any.

Updated on

Displays the timestamp of the 
last connection status update 
for each connection in the 
following format: YYYY-MM-DD 
HH:MM:SS.

Processing 
status

Percentage of connections for 
which all data import runs in 
the last import execution were 
successful, with the count of 
success and error statuses.

The processing status summary table 
displays the following details:

Connection
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Connections overview section  (continued)

Card Description Card summary table

Note: 

Only import sets that 
encountered errors during 
their last execution are 
counted as processing 
errors and shown on the 
card.

Displays the name of the 
configured Service Graph 
Connector. Each entry links 
to more details about the 
connection.

Last processing status

Indicates the result of the most 
recent processing run. Valid 
values include:

Success

All scheduled jobs 
completed without 
errors.

Error

One or more jobs 
encountered issues 
during processing.

Activated schedules

Indicates the number of 
scheduled jobs that are 
activated for importing the data 
using the connection.

Processed

Indicates the total number 
of import set runs that were 
executed for the connection.

Success

Indicates how many of the 
processed import set runs 
completed successfully.

Error

Displays the number of import 
set runs that ended in an error, 
including those import sets that 
were canceled.

Error summary

Provides a short description of 
the most recent error, if any. The 
summary includes error type and 
cause.

Last processed on

Displays the timestamp of 
the last processing activity 
for the import set of the 
connection, including both 
successful and failed runs in the 
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Connections overview section  (continued)

Card Description Card summary table

following format: YYYY-MM-DD 
HH:MM:SS.

Ongoing 
executions

Number of connections where 
data import execution is in 
progress.

The ongoing execution status summary table 
displays the following details:

Connection

Displays the name of the 
configured Service Graph 
Connector. Each entry links 
to more details about the 
connection.

Activated schedules

Indicates the number of 
scheduled jobs that are 
activated for importing the data 
using the connection.

In progress

Displays how many scheduled 
jobs are currently running for the 
connection.

Processed

Displays the number of 
completed executions, where 
data has been collected and 
processed according to the 
configured scheduled job.

Processing time

Indicates the total duration taken 
by the most recent completed 
import set execution in the 
following format YYYY-MM-DD 
HH:MM:SS.

Ingested and processed data

Displays key metrics related to the data imported and processed from third-party applications.

Ingested and processed data section

Card Description Indicators

Import 
sets

Number of import sets processed by 
data sources based on the selected 
filters, with the count of success, 
partial, and error statuses.

Select the View all import sets  link 
to view a complete list of processed 
import sets.

SGC.Integrations.ImportSet

SGC.Fully.successful.ImportSet

SGC.Part.success.ImportSet

SGC.Fully.error.ImportSet
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Ingested and processed data section  (continued)

Card Description Indicators

Imported 
rows

Count of rows imported across all 
import sets based on the selected 
filters.

Select the View all latest import set 
rows ingested  link to view a complete 
list of import set rows ingested.

SGC.Integrations.Importset.rows.ingested

CIs Total CIs processed based on the 
selected filters, with the count of 
added and updated CIs.

Select the View all inserted and 
updated records  link to view a 
complete list of inserted and updated 
CIs.

None

Partial or 
incomplete 
CIs

Total CIs that are partial payloads 
based on the selected filters, with 
the count of partial and incomplete 
categories.

Select the View all partial and 
incomplete records  link to view a 
complete list of partial and incomplete 
CIs.

None

Data processing performance

Displays how many configuration items (CIs) were added or updated over time, in addition to the 
number of processing errors.

Data processing performance section

Card Description Indicators

CIs and 
errors 
trends

Daily trends for CIs that were added, updated, and any data processing 
errors occurred during data import process based on the selected 
filters.

Records 
added

Records 
updated

Errors

Processing 
time

Top 10 connections by the latest import set processing time.

Select the View all latest import sets  link to view a complete list of 
import sets.

None

Processing 
errors

Top 10 connections with the highest number of data processing errors, 
with a breakup by data source, connection, and credential issues.

None
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Data processing performance section  (continued)

Card Description Indicators

Select the View all latest errors  link to view a complete list of 
processing errors.

Filters

Enables narrowing the data shown in graphs and metrics based on connector type, connection, 
data source, or date range.

Name Type Description

Connector type List Filters a list of installed 
Service Graph Connectors.

Connection List Filters a list of connection 
records for the Service Graph 
Connectors.

Data source List Filters a list of data sources 
for the Service Graph 
Connectors.

Date range Date Filters the SGC Central 
dashboard data based on the 
date range selected.

Indicators

Enables viewing of high-level metrics that reflect the volume and quality of imported data and 
help identify issues such as incomplete or failed import set processing.

Records added

Total number of records that were inserted into the system on the previous day, as 
recorded in the sn_cmdb_int_util_cmdb_integration_execution_audit table. The 
score is calculated by counting the number of records updated on the specified 
day, based on operations that were marked as inserted in the audit log.

Records updated

Total number of records that were updated in the system on the previous day, as 
recorded in the sn_cmdb_int_util_cmdb_integration_execution_audit table. The 
score is calculated by counting the number of records updated on the specified 
day, based on operations that were marked as Updated in the audit log.

Records added or updated

Total number of records that were added or updated in the system on the previous 
day, as recorded in the sn_cmdb_int_util_cmdb_integration_execution_audit table. 
The score is calculated by counting the number of records inserted or updated on 
the specified day, based on operations that were marked as Inserted or Updated in 
the audit log.

Errors

Total number of errors categorized under credentials, data source, or connection 
issues that occurred during integration executions on the previous day, as recorded 
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in the sn_cmdb_int_util_cmdb_integration_execution_error table. The score is 
calculated by counting the number of errors on the specified day.

SGC.processing.errors

Number of processing errors categorized under data source issues that 
occurred during integration executions on the previous day, as recorded in the 
sn_cmdb_int_util_cmdb_integration_execution_error table. The score is calculated 
by counting the number of errors on the specified day.

SGC.connection.errors

Total number of errors categorized under credentials or connection issues that 
occurred during integration executions on the previous day, as recorded in the 
sn_cmdb_int_util_cmdb_integration_execution_error table. The score is calculated 
by counting the number of errors on the specified day.

SGC.Integrations.ImportSet

Total number of import sets that were either completed successfully or encountered 
errors during their transformation process on the previous day, as recorded in 
the sn_cmdb_int_util_cmdb_integration_execution_import_set table. The score is 
calculated by counting the total number of import sets on the specified day.

SGC.Fully.successful.ImportSet

Total number of import sets that were completed successfully during 
their transformation process on the previous day, as recorded in the 
sn_cmdb_int_util_cmdb_integration_execution_import_set table. The score is 
calculated according to this formula: Count of import sets with Errors 
= 0.

SGC.Fully.error.ImportSet

Total number of import sets that completed with errors during their 
transformation process on the previous day, as recorded in the 
sn_cmdb_int_util_cmdb_integration_execution_import_set table. The score is 
calculated according to this formula: Count of import sets with Errors 
≠ 0 and Rows = Errors.

SGC.Part.success.ImportSet

Total number of import sets that completed with some errors where the number of 
rows processed differs from the number of errors reported on the previous day, as 
recorded in the sn_cmdb_int_util_cmdb_integration_execution_import_set table. 
The score is calculated according to this formula: Count of import sets 
with Errors ≠ 0 and Rows ≠ Errors.

SGC.Integrations.Importset.rows.ingested

Total number of rows ingested for the import sets on the previous day, as recorded 
in the sn_cmdb_int_util_cmdb_integration_execution table. The score is calculated 
according to this formula: Sum of rows ingested.

SGC.Integrations.Processing Rate

Average processing rate of import sets based on the total number of rows 
processed and the total processing time (in hours) for the import sets that either 
completed successfully or encountered errors on the previous day, as recorded in 
the sn_cmdb_int_util_cmdb_integration_execution table. The score is calculated 
according to this formula: Sum of rows processed/Total time (in 
hours).
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Reports

Enables real-time visualizations that provide insights into data ingestion, processing trends, and 
error categorization across your Service Graph Connector  connections.

Title Type Source table Description

Affected CIs and 
errors

Relative compare 
( )

CMDB Integration 
Execution Error 
[sn_cmdb_int_util_cmdb_integration_execution_error]

Displays configuration 
items (CIs) added, 
CIs updated, and 
cumulative errors 
occurred during data 
import over time.

Error breakdown Column ( ) CMDB Integration 
Execution Error 
[sn_cmdb_int_util_cmdb_integration_execution_error]

Displays the count of 
errors grouped over 
time.

Import set rows 
ingested

Single score ( ) CMDB Integration 
Execution Import Set 
[sn_cmdb_int_util_cmdb_integration_execution_import_set]

Displays the number 
of import set rows 
ingested in a day.

Import set processing 
rate

Single score ( ) CMDB Integration 
Execution 
[sn_cmdb_int_util_cmdb_integration_execution]

Displays the average 
rate at which an 
import set processes 
data within an hour.

Records added or 
updated

Single score ( ) CMDB Integration 
Execution Audit 
[sn_cmdb_int_util_cmdb_integration_execution_audit]

Displays the number 
of records that were 
updated or added for 
CI classes.

Total import sets Single score ( ) CMDB Integration 
Execution Import Set 
[sn_cmdb_int_util_cmdb_integration_execution_import_set]

Displays the number 
of import sets 
initialized by data 
sources in the given 
time frame and the 
count of import sets 
categorized by their 
status.

Updated classes Column ( ) CMDB Integration 
Execution Audit 
[sn_cmdb_int_util_cmdb_integration_execution_audit]

Displays the 
breakdown of updated 
and inserted CIs for a 
class.

Accessing the IntegrationHub ETL dashboard in SGC Central

You can access the IntegrationHub ETL dashboard within the SGC Central  view of the CMDB 
Workspace  to manage ETL transform maps.

IntegrationHub ETL is a tool for creating and managing ETL transform maps to integrate third-
party data into the CMDB  or non-CMDB  tables. Select Go to IntegrationHub ETL Home  to view 
the IntegrationHub ETL home page.

To learn about the IntegrationHub ETL store app, see IntegrationHub ETL.
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Access IntegrationHub ETL in SGC Central

The IntegrationHub ETL dashboard provides a centralized platform for monitoring ETL processes 
within the SGC Central  view of the CMDB Workspace.

Before you begin
Role required: admin

Procedure

1. Navigate to Workspaces  > CMDB Workspace.

2. In the CMDB Workspace, select SGC Central.

3. Select IntegrationHub ETL.

4. In the ETL definitions section of the IntegrationHub ETL page, select a category to view more 
details about the selected ETL definition.

ETL definitions

Category Description

Total Total number of ETL definitions configured within the system.

Active Number of ETL processes that are currently active and running.

Scheduled Number of ETL processes that are scheduled for future execution.

5. To open the home page of the IntegrationHub ETL store app, select Go to IntegrationHub ETL 
Home.

SGC Central  reference

Reference topics provide additional information about SGC Central  components.

Components installed with SGC Central

Several types of components are installed with activation of the SGC Central  (sn_sgc_central) 
plugin, including tables, user roles, and scheduled jobs.

Scheduled jobs installed

Scheduled job Description

SGC central collection Reads from the imports brought in by the connectors and updates the 
dashboard data.

SGC central collection 
onDemand with 
lookback

Collects historical data for the lookback period from when the data 
is retrieved for connectors. The default lookback period is set to 30 
days.
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Tables installed

Table Description

Connection Record Tabs

[sn_sgc_central_connection_record_tabs]

Includes the tabs displayed on the page 
to edit connection, including default tabs 
like Details, Data Sources, Scheduled 
Imports, and Errors, and additional 
tabs specific to individual connectors, 
arranged by order.

Connection property config

[sn_sgc_central_conn_prop_config]

Stores the connection property fields 
for the Connection Properties tab 
displayed on the page to create or edit 
a connection, including group ordering, 
descriptions, mandatory fields, and 
default values for auto-population.

Service Graph Connection Trigger

[sn_sgc_central_service_graph_connection_trigger]

Stores the trigger record to initialize 
playbook context in the create 
connection flow when a new record 
is inserted. The playbook is selected 
based on the referred metadata record's 
application scope field that is the Service 
Graph Connector  scope.

Service Graph Connector

[sn_sgc_central_service_graph_connector]

Stores Service Graph Connector  details 
such as scope, app ID, and associated 
provider.

SGC Installed Connection

[sn_sgc_central_st_installed_connection]

Stores all installed or draft connections, 
including details such as connection, 
processing status, last run, and import 
frequency information.

SGC IntegrationHub ETL

[sn_sgc_central_st_integrationhub_etl]

Stores the Extract Transform Load (ETL) 
list for display under the IntegrationHub 
ETL list view in SGC Central.

ServiceNow Store  applications installed

Application Description

Integration Commons for CMDB 
(sn_cmdb_int_util)

Contains the CMDB  Integrations Dashboard 
and a set of Robust Transform Engine (RTE) 
transforms and script includes.

CMDB Workspace (sn_cmdb_ws) Provides a single place to access CMDB-
focused features including SGC Central.
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Domain separation and SGC Central

Domain separation is unsupported for SGC Central. Domain separation enables you to separate 
data, processes, and administrative tasks into logical groupings called domains. You can control 
several aspects of this separation, including which users can see and access data.

Support level: No support

• The domain field may exist on data tables but there is no business logic to manage the data.

• This level is not considered domain-separated.

For more information on support levels, see Application support for domain separation .

Related topics

Domain separation for service providers

Conversational Interfaces
Enable users to engage with live agents, virtual agents, or both using ServiceNow® 

Conversational Interfaces. These interfaces provide tools for creating and managing optimal 
conversational experiences for users in the chat channels that they prefer.

Get started with Conversational Interfaces

Select a tile to get started with Conversational Interfaces  products and tools.

Conversational 
Interfaces Console

Use the Conversational 
Interfaces Console to 
install and configure 
conversational tools.

Virtual Agent

Augment customer 
service with a virtual agent 

that handles common 
support issues using pre-
built conversations and 
automated workflows.

Now Assist  in 
Virtual Agent

Use generative AI 
skills to enhance the 
requester experience 

in Virtual Agent.

Agent Chat

Provide your agents with a 
workspace that has built-

in productivity features for 
engaging with customers.

Sidebar

Provide your agents with 
a way to collaborate with 

others when working on a 
Workspace task-based or 
interaction-based record.

Conversational Interfaces 
Diagnostic Tool

Diagnose issues with low-
performing conversations.
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Additional Resources for 
Conversational Interfaces

Manage and enhance 
your Conversational 

Interfaces experience

Conversational Interfaces Console
Explore, implement, and maintain your Conversational Interfaces  using a home-page or console 
experience. All the settings and configurations you need to set up and launch your interfaces, 
such as Virtual Agent  and Agent Chat, are consolidated in the ServiceNow®  Conversational 
Interfaces  console.

For an introduction to the Conversational Interfaces  console, and to get familiar with the product, 
watch this video.  Getting Started with the Conversational Interfaces console.

Get started

Explore

Learn about the Conversational Interfaces 
Console concepts and features.

Install

Install Virtual Agent and 
pre-built conversations.

Configure

Select conversation settings for Virtual 
Agent, Agent Chat, and Sidebar

Reference

Get technical information about records 
in the Interactions table and data 

management in Conversational Interfaces.

Exploring Conversational Interfaces Console

The Conversational Interfaces  applications enable your users to engage with live agents, virtual 
agents, or both. These interfaces provide tools for creating and managing optimal conversational 
experiences for your users, in the chat channels that they prefer.
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If you are new to Conversational Interfaces  and haven't implemented or used Virtual Agent 
yet, you can access the Conversational Interfaces Console  application to explore all available 
features.

For existing users, you can access the Conversational Interfaces  console application to discover 
added enhancements or advanced-level features.

Conversational Interfaces  console advantages

Implement Conversational Interfaces  to support your users with virtual and live agents through 
the chat channels they prefer. Increase the productivity of your IT organization by deflecting 
the more common, easier to resolve user issues, to a 24/7-available Virtual Agent  bot. The 
Conversational Interfaces  console makes it easy for you to quickly get started and work towards 
achieving positive outcomes with your implementation.

Navigate through an intelligent experience that is uniquely tailored to where you are as a 
Conversational Interfaces  user. The Conversational Interfaces  console is ideal for first-time users 
who have never installed or configured Conversational Interfaces, to the most experienced user 
looking to expand full capabilities and maintain existing implementations.

Conversational Interfaces  console provides the following features:

• Guided experience modules that walk you through essential tasks, such as adding your bot to 
a portal, branding and customizing your bot, setting up bot greetings, collecting metrics, and 
more.

• Access to helpful resources and videos to help you plan your virtual or human agent 
conversational experience.

• General settings for both Virtual Agent  and Agent Chat, as well as settings specific to each 
application.

• Bot performance metrics for recent conversations.

• Progress panel that shows you what has been configured on your instance.

Navigate to All  > Conversational Interfaces  > Home  to start exploring its features.

Note: 
The Conversational Interfaces  console is also available in the Omni-Experience Standard 
Feature Set app from the ServiceNow Store. Existing customers don't need to install it from 
the store. However, subsequent updates will be available there. Visit the ServiceNow Store
website for more information. For cumulative release notes information for all released 
apps, see the ServiceNow Store version history release notes .

Monitoring and managing Conversational Interfaces  applications

Use the Conversational Interfaces Home  page to monitor the performance of recent 
conversations or test your bot. Plugin update notices will alert you when a feature update is 
ready.

Your bot's performance

Review the performance of recent live conversations from the Conversational 
Interfaces  console. For more details, select View details in VA Analytics  to open 
the Conversational Analytics Dashboard.
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Test your bot

Select Try your bot  to open a conversation in a new window and test the active 
topics. Enter a request and send it to start a conversation with the bot. The number 
of active topics is indicated for your information.

Update plugins

Notifications on the Conversational Interfaces  console let you know when to update 
an installed plugin. Select Update plugin  to update it from the ServiceNow Store.
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Channels in Conversational Interfaces

The various ways in which your end users engage with virtual and live agents are called 
channels. In Conversational Interfaces, users and agents converse through channels that have 
specific communication modes: chat mode for real-time conversations and messaging mode for 
long-running conversations.

Conversation channels provide your end users and agents with different options for interacting. 
These options are based on when your users and agents are available to connect, and the chat 
applications used in your business environment. There are two types of channels: chat channels 
and messaging channels.

Chat channels

Chat channels support two-way conversations in real time. These conversations may involve a 
user and a live agent or a user and a virtual agent. This mode of conversation is synchronous, 
and the user is guaranteed a response. Supported chat channels let your end users and agents 
interact based on the chat applications (clients) that they’re using and when they’re available to 
connect.

The following channels are supported for synchronous chat:

• Service Portal (mweb) web client

• Mobile web (mweb) client

• Conversational Integration with Microsoft Teams

• Conversational Integration with Slack

• Conversational Integration with Workplace from Facebook

• Conversational Integration with Alexa

• Conversational Integration with WhatsApp (powered by Twilio)

• Conversational Integration with LINE

• Conversational Integration with Facebook Messenger

Messaging channels

Messaging channels let end users and agents communicate over longer periods of time, 
especially when one party isn’t online. This mode of chat is asynchronous and happens at the 
parties' convenience.
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When your end users and agents must communicate over longer periods without being online 
concurrently, pre-built messaging channels let them chat asynchronously, at their convenience.

The following channels are available for asynchronous chat:

• Mobile web (mweb) client: Configure this channel for iOS, Android, and desktop devices for 
asynchronous chat

• Now Assist panel : Used by Now Assist panel .

• SMS channel: Used by Conversational SMS Integration with Twilio

Messaging Channels table

Messaging channels are defined in the Messaging Channels table [sys_cs_channel]. If you’re 
using the custom chat integration framework  to create custom chat integrations, you can specify 
the channel mode for those integrations—either chat or messaging. For channels such as the 
mweb channel, you can choose either chat or messaging as well.

Configured channels for an instance

Live agent support by channel

Not all channels may be suitable for live agent support. For example, you may want to disable 
support for the Bot-to-Bot and voice channels. Live agent support is enabled by default, but 
admins can change this setting in the Messaging Channels [sys_cs_channel] table. For details, 
see Disable live agent support for a channel.

Chat and messaging features

The Conversational Interfaces  channels offer basic features that make it easy for your agents 
and end users to stay connected:

• Message indicators that inform your users of new and unread messages received when they’re 
away from chat or when they’ve been offline.

• Typing indicators that show a chat participant is responding.
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• System messages, displayed to users and agents that provide information about the 
conversation state.

• Secure handling of sensitive data, such as passwords or account numbers. This data is 
masked when users enter the information, and it cannot be viewed by others.

• Automatic closing of idle chat or messaging conversations.

New and unread message indicators

End users receive new message indicators on chat and messaging channels when they're 
offline. Users can be anonymous (guests) or known (authenticated). The unread message count 
is displayed on the chat widget.

In asynchronous chat, the unread message count reflects the number of any offline messages 
sent by a live agent and any simple notifications received.

Unread message count and new message indicators (Service Portal web client)

Message indicators are displayed as follows:

• There is no limit on the number of unread messages. Up to 50 unread messages can be 
viewed at a given time. Messages can span multiple conversations, either open (current) or 
closed (past) conversations.

• When users open the chat client, they’re shown the last message received. They can scroll up 
or down to read the unread messages, as directed by the New messages above  button or New 
messages below  button.

• A new messages separator line is displayed between the read and unread messages.

• When a user closes and reopens the chat window, the messages displayed are considered as 
"read" even though the user might not have reviewed them.
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System messages

During active conversations with live or virtual agents, certain system messages inform users 
and agents about the conversation state. For example, if a user is engaged in live chat, but 
doesn’t respond within a certain amount of time, a conversation timeout message is displayed: 
The conversation is timing out, are you still there?

You can change base system messages by editing their related system properties in Chat 
Settings in the Conversational Interfaces  console.

Disable live agent support for a channel

Add the disable_live_agent  property to the Channel Properties related list to exclude it 
from live agent support.

Before you begin
Role required: admin

About this task
The disable_live_agent  property is replacing the 
com.glide.cs.exclude.liveagent.support  system property to indicate that the 
channel doesn't support a live agent. If the disable_live_agent  parameter is not set for the 
channel, the older system property will still be honored for the time being.

Procedure

1. Navigate to All, and then enter sys_cs_channel.list  in the filter.

2. Select a channel name in the table.
For example, select Alexa.

3. In the Channel Properties  related list, select New.

4. On the Custom Adapter Property New record form, fill in the fields.

Field Description

Name Enter disable_live_agent.

Value Enter true.

5. Select Submit.

Result
The disable_live_agent  parameter displays in the Channel Properties related list.
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Using Asynchronous Chat in messaging channels

Enable your organization or brand to maintain constant engagement with end users. With 
Asynchronous Chat, your agents and end users can participate in long-running conversations 
without being online concurrently. Agents can also proactively contact users whenever there is 
useful information to share, such as important alerts or updates.

With Asynchronous Chat, end users and agents can engage in conversations that might span 
several hours or even days. These conversations run on messaging channels that allow your 
users and agents to communicate at different times and to resume conversations where they left 
off. Users can respond at their convenience and are no longer limited to working with agents only 
during customer support hours.

Long-running conversations are supported on channels that are designated as messaging 
channels in the Messaging Channel [sys_cs_channel] table. Messaging channels provided with 
your base system include the SMS channel, which is used by the ServiceNow  Conversational 
SMS Integration with Twilio  app and the ServiceNow  Conversational SMS service channel app.

Starting with the Rome  release, you can also configure the web (mweb) channel, which includes 
the iOS, Android, and desktop devices, as a messaging channel instead of a chat channel. For 
configuration details, see Configure asynchronous chat for the web channel.

Note: 
The web chat and mweb channels are the only channels that support both chat and 
messaging mode, depending on your need. Web chat can only be set up in one mode on 
any given instance. The Asynchronous Chat feature specifically refers to the mweb channel 
in messaging mode.
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Requirements

Asynchronous chat requires certain plugins and ServiceNow  applications from the ServiceNow 
Store.

Plugins and ServiceNow apps required for asynchronous chat

Plugin or ServiceNow app Description

Glide Conversation Server

[com.glide.cs]

Enables Virtual Agent  functionality handled by the Conversation 
Server, including conversation settings and the Virtual Agent  web 
client plugin (com.glide.cs.sn-va-web-client-app).

The Conversation Server is included with Virtual Agent Lite, 
which is provided with your base system. For full Virtual Agent 
functionality, see Activate Glide Virtual Agent, which is available by 
subscription.

Conversational Messaging

[com.glide.messaging.awa]
Enables features for conversational messaging, such as 
messaging actions in Workspace.

For details, see Activate Conversational Messaging.

Now Mobile app

(Version 12.2)
Enables users to submit incidents and requests, manage tasks, 
and request help from Agent Chat (and Virtual Agent  if using 
Virtual Agent).

End users install the Now Mobile  app for iOS  or Android  systems 
from the Apple App Store or the Google Play store, respectively.

Agent-initiated Messaging 
Interface

(Version 3.0)

Supports agent-initiated conversations in messaging 
channels. This ServiceNow  app, available from the ServiceNow 
Store , also installs the Conversational Messaging plugin 
(com.glide.messaging.awa).

How Asynchronous Chat works

Asynchronous Chat provides various features to help you improve the conversational experience 
for your users and agents, such as:

• Message indicators that inform users of new and unread messages received when they're 
away from the chat window or when they've been offline.

• System messages, displayed to users and agents, that are tailored to either messaging or chat 
channels.

• Idle conversation timeout period that admins can adjust for messaging channels, as needed.

• Proactive messaging capability that enables agents to initiate communication with users

The following sections explain how these features work for Asynchronous Chat.

New and unread message indicators

End users can receive messages on a messaging channel, even when they're offline. Users can 
be anonymous (guests) or known (authenticated). The unread message count is displayed on 
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the chat widget. The unread message count reflects the number of any offline messages that 
were sent by a live agent and any simple notifications received.

Unread message count and new message indicators

• There is no limit on the number of unread messages. Up to 50 unread messages can be 
viewed at a given time. Messages can span multiple conversations, either open (current) or 
closed (past) conversations.

• When users open the chat client, they land on the very last message received. They can scroll 
up or down to read the unread messages, as directed by a New messages above  button or 
New messages below  button.

• A new messages separator line displays between the read and unread messages.

• When users close and re-open the chat window, the messages displayed are considered as 
"read" even though users might not have reviewed them.

System messages

Certain system messages that are displayed to users and agents in chat mode are not applicable 
in messaging mode, and are suppressed as needed. The following table identifies system 
messages that are displayed or suppressed, depending on the mode.

System messages displayed in messaging and chat modes

System message
Messaging mode (web and 
mobile)

Chat mode

X has closed the support session.

[Displayed when either the agent or user 
closes the chat session]

Displayed Displayed

The support session was closed.

[Displayed when the chat session was not 
closed by the agent or user]

Suppressed Displayed

X has entered the chat. Suppressed Displayed

Thank you for contacting support. I am 
looking into your question and will be with 
you shortly.

Displayed Displayed

The conversation is timing out, are you still 
there?

[ Controlling idle live chat 
sessions  controlled by the 
com.glide.cs.idle_chat_reminder_message 
system property]

Suppressed Displayed

Idle conversations and messaging actions in messaging channels

In chat channels, the default idle conversation timeout period for Virtual Agent and Live 
Agent conversations is two hours (7200 seconds). However, for Live Agent conversations in 
messaging channels, certain messaging actions are automatically applied, which affects how 
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idle conversations are handled. In messaging channels, when a requester hasn't responded to 
an agent message within two days, the conversation state changes to Closed Abandoned and 
the message is closed. For more information on messaging actions, see Configure messaging 
actions.

As admins, you can override the conversation idle timeout period per channel by setting the 
value in the Conversation Idle Timeout  field in the Messaging Channels [sys_cs_channel] table. 
For details, see Override the conversation timeout period by channel.

Proactive messaging
Using the Agent-initiated messaging interface, agents can proactively communicate with end 
users to share relevant or helpful information. When agents initiate messaging from the mweb 
channel in Asynchronous Chat, your users have the option to respond immediately and engage 
in a two-way conversational experience. Proactive messaging with the mweb channel has the 
following capabilities:

• Compose Message  feature that agents use to create and send messages to selected users. 
Messages can contain links and file attachments.

• When a user replies to a message, the ongoing interaction context is retained, providing the 
agent with the information needed to maintain the conversation.

Agent-initiated message on mweb channel

For more information on agent-intiated messages, see Install agent-initiated messaging interface.

End user experience in live agent conversations

When a user starts the web client after having received offline messages from a specific agent, 
for example Agent A, the conversation is in live agent mode:
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• If Agent A is available, the user can resume the conversation with Agent A.

• If Agent A is not available, but Agent B is, depending on the agent reassignment settings, the 
chat window displays Agent B's name and avatar and the conversation resumes.

• If no agents are available, the conversation is routed to an agent based on the Queue Max Wait 
Time. If there isn't a wait time, the conversation waits until an agent becomes available.

Configure asynchronous chat for the web channel

Set the web client as a messaging channel for asynchronous chat.

Before you begin
Role required: virtual_agent_admin or admin

About this task
The base system web channel, mweb, is automatically configured as a chat channel for web and 
mobile clients. To use the web channel as a messaging channel, change the channel Type  in the 
Messaging Channel [sys_cs_channel] table.

Procedure

1. Navigate to All  and in the Navigation filter, enter sys_cs_channel.list.

2. In the Messaging Channel form, select the mweb record and double click the Type  field.

3. Change the Type to Messaging.

4. Save the value.

Result
The mweb channel is set to messaging mode. To help manage long-running conversations, the 
system automatically performs certain messaging actions in messaging mode:

• Requester message without agent response (agent experience): If an agent hasn't responded 
to a requester within 30 minutes, the agent receives a reminder that a message from an end 
user needs a response.

• Agent message without requester response: If a requester hasn't responded to an agent 
message after two days, the conversation state in the Interaction record is automatically set to 
closed abandoned.

For more information on messaging actions, see Configure messaging actions. For details on 
Virtual Agent  and Live Agent  idle conversation timeouts and conversation states, see Closing 
Virtual Agent and Agent Chat conversations  and Virtual Agent interaction records.

Installing Conversational Interfaces  components

Use the Conversational Interfaces Home  page to install Virtual Agent  and related plugins. Once 
installed, select a card to customize your bot or set up Agent Chat.

If you've never installed Virtual Agent, the Conversational Interfaces  console prompts you to do 
so first. The layout of the Home  page may vary, depending on which features you have installed 
and configured.

Install Virtual Agent

To begin, you must install the Virtual Agent  plugin. Select Get Virtual Agent plugin 
to install it.
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Get pre-built bot topics

Activate plugins that provide the pre-built topic conversations you want to use 
to handle common user requests. For example, IT-related support issues, such 
as resetting a password or HR-related issues such as requesting a leave of 
absence. For more information, see Prebuilt Virtual Agent topics, topic blocks, and 
ServiceNow NLU models.

Here's what you can do next
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Explore popular Virtual Agent  settings from the Conversational Interfaces Home 
page. Next steps typically include branding your bot, adding it to a portal that your 
users can access, and creating conversations in Virtual Agent Designer.

Before implementing your Conversational Interfaces, take some time to ask and 
answer a few important questions meant to help you envision the Conversational 
Interfaces  experience you need and want for your business. Browse the Get the 
essentials for your Virtual Agent  section for more options.

Set up Agent Chat

Activate and set up live agent support. Set up agent names and avatars, set agent 
status messages, and determine whether agents can view user chat history.

Install Sidebar

Provide live agents with a way to collaborate with others while they work on a 
Workspace task-based or interaction-based record.
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Bot Accelerator progress panel

The progress panel quickly shows you what has been configured and what tools 
remain unconfigured or inactive.

Configuring Conversational Interfaces

You can use the Conversational Interfaces  console and the Chat Settings  option in the Home 
page to explore and configure general chat functionality and set up Virtual Agent  and Agent Chat 
features.

Configuring Conversational Interfaces

Use the cards on the Conversational Interfaces  console to set up features for Virtual Agent  and 
Agent Chat. The cards automatically sort each time you visit and unaddressed features appear 
first.
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For more information, select the question mark at the top right. This opens a contextual help 
panel.

Now Assist in Virtual Agent cards

Card Description

Create a Virtual Agent  with Now Assist, using 
an LLM model and generative AI skills.

To create a virtual agent using Now Assist, 
select Get started  to display the Assistants 
screen. For more information, see Manage 
LLM virtual agents on the Assistants screen.

Create a Virtual Agent  with NLU, which 
contains default settings and setup topics.

To create a virtual agent using an NLU model:

1. Select Get started  to open a new window 
with the plugin screen where you can install 
the com.glide.cs.chatbot plugin. For more 
information, see Activate Virtual Agent.

2. After the plugin is installed, return to the 
previous window and refresh it using your 
browser's refresh button.

3. Select Settings  to display the CI Admin 
Experience settings page.

4. In the left-hand panel, select Virtual Agent 
to configure your settings and NLU models. 
For more information, see Configuring 
Virtual Agent.

Monitor your Now Assist  in Virtual Agent
To view Virtual Agent  analytics for existing LLM 
virtual agents, select View performance. For 
more information, see Analyzing Now Assist in 
Virtual Agent.

To manage existing LLM virtual agents, select 
Manage assistants  to display the Assistants 
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Now Assist in Virtual Agent cards  (continued)

Card Description

screen. For more information, see Manage 
LLM virtual agents on the Assistants screen.

Chat configuration cards

Card Feature Description

Get pre-built 
topics

Teach your bot to handle 
additional requests using 
pre-built conversation 
topics.

Request AI Search Give your users the power 
to search for answers 
to their questions or 
solutions to their requests 
by adding AI Search  to 
your Virtual Agent  bot.

Brand your bot Customize your bot by 
selecting the colors and 
icons, and add a logo that 
reflects your company’s 
portal.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1588



Chat configuration cards  (continued)

Card Feature Description

Create your bot's 
greeting

Customize your bot by 
choosing how it greets 
and interacts with your 
users.

Add your bot to a 
portal

Choose where you want 
your Virtual Agent  bot to 
live by adding it to a portal.

Set up Topic 
Recommendations

Get recommended topics 
based on analyses of 
existing support requests.
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Chat configuration cards  (continued)

Card Feature Description

Capture 
conversational 
metrics

Use the Conversational 
Analytics Dashboard to 
collect interaction metrics 
to evaluate your bot's 
performance.

Set up Natural 
Language 
Understanding 
(NLU)

Help your bot better 
understand a user's 
intent. For details, see 
Advantages of natural 
language models over 
keywords.

Virtual Agent 
integration with 
messaging apps

Add your bot to other 
channels, such as a 
Conversational Integration 
with Slack  or Microsoft 
Teams.
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Chat configuration cards  (continued)

Card Feature Description

Set up Agent Chat Connect users to live chat 
support in the chat client 
they are using.

Setting up Sidebar Provide live agents with 
a way to collaborate with 
others while they work on 
a Workspace task-based 
or interaction-based 
record.

Install and 
configure the 
Profanity Filter 
plugin for Agent 
Chat

Prevent live agents from 
sending messages with 
inappropriate or profane 
language to requesters.
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Chat configuration cards  (continued)

Card Feature Description

Install 
Conversational 
IVR with Amazon 
Connect

Enable user conversations 
with a bot using the phone 
channel.

Using language 
detection and 
dynamic machine 
translation in 
Virtual Agent

Enable a combination of 
language detection and 
machine translation for 
Virtual Agent  to improve 
the chat experience for 
diverse users.

Set up Issue Auto 
Resolution

Provide users with 
immediate self-service by 
using machine learning to 
intelligently deliver Virtual 
Agent  topics, Knowledge 
articles, and catalog items.
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Chat configuration cards  (continued)

Card Feature Description

Install 
Omnichannel 
Callback

Enable other 
ServiceNow®  apps to 
display or announce 
callback options to users.

Assistants

The Assistants screen appears when you select the Assistants  tab on the Conversational 
Interfaces home screen.

Chat settings

The Chat Settings  tab opens with the General  tab selected. This tab contains general settings 
that apply to all Conversational Interfaces  applications. The currently installed plugins and 
available plugins that you can activate are listed as links. Select a link for more information or to 
start an activation process.

The Virtual Agent, Agent Chat, and Sidebar  tabs in the left navigation pane open configuration 
settings pages for each application.

For more information about these settings, see the following topics:

• General settings

• Virtual Agent settings
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• Agent Chat settings

• Sidebar settings

Finding configuration settings from earlier releases in Conversational Interfaces  console

If you upgraded from a previous release, you will find that configuration settings and forms for 
Virtual Agent  and Agent Chat  can be accessed from the Conversational Interfaces  console page.

Use the following table to find where Virtual Agent  and Agent Chat  configuration forms and 
settings used in previous releases are located in the Conversational Interfaces  console and Chat 
Settings.

For example, the former Chat Setup form is now Agent Chat Settings, which you can access 
from the Set up Agent Chat  card in Conversational Interfaces  console (navigate to All  > 
Conversational Interfaces  > Home) or through the Chat Settings  tab on the Home page.

Configuration forms and settings for Virtual Agent  and Agent Chat

Configuration form or setting in previous release
Conversational 
Interfaces  console 
action card

Chat Settings

Chat client

Branding and Chat menu

[Conversational Interfaces  > Branding and 
Chat Menu]

Edit your bot's 
look and feel Branding in General 

Settings

[All  > Conversational 
Interfaces  > Settings]

Messaging Apps Integration for Microsoft 
Teams, Slack, and Workplace from Facebook

[Conversational Interfaces  > Messaging 
Apps Integration] - Still available in application 
navigator under Conversational Interfaces

Add your bot to 
other channels Channels in General 

Settings

[All  > Conversational 
Interfaces  > Settings]

Chat Setup

[Conversational Interfaces  > Chat Setup]

Set up Agent Chat

• Agent Chat settings

[All  > Conversational 
Interfaces  > Settings  > 
Agent Chat]

• Enable notifications 
moved to Virtual Agent 
settings

[All  >  > 
Conversational 
Interfaces  > Settings  > 
Virtual Agent]
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Configuration forms and settings for Virtual Agent  and Agent Chat  (continued)

Configuration form or setting in previous release
Conversational 
Interfaces  console 
action card

Chat Settings

Context related list in Chat Setup

[Conversational Interfaces  > Chat Setup]

No card
Context variables in 
General Settings

[All  > Conversational 
Interfaces  > Settings]

System Messages related list in Chat Setup

[Conversational Interfaces  > Chat Setup]

No card
System messages in 
General Settings

[All  > Conversational 
Interfaces  > Settings]

URL Navigation related list in Chat Setup

[Conversational Interfaces  > Chat Setup]

No card
URL navigation in 
General Settings

[All  > Conversational 
Interfaces  > Settings]

Conversation routing

Pre-chat Survey

[Conversational Interfaces  > Pre-Chat Survey]]

No card
Pre-chat surveys in 
General Settings

[All  > Conversational 
Interfaces  > Settings]

Context Topic intent

[Conversational Interfaces  > Context Topic 
Intent]

No card
Topic context intent in 
General Settings

[All  > Conversational 
Interfaces  > Settings]

Virtual Agent

Topic Recommendations

[Conversational Interfaces  > Virtual Agent 
> Topic Recommendations]  - Option still 
available in application navigator under 
Conversational Interfaces

Get 
recommended 
topics

Topic Recommendations 
in Virtual Agent settings

[All  > Conversational 
Interfaces  > Settings  > 
Virtual Agent]

Recommendation Settings

[Conversational Interfaces  > Virtual Agent 
> Recommendation Settings]]- Option still 
available in application navigator under 
Conversational Interfaces

No card
Topic Recommendations 
in Virtual Agent settings

[All  > Conversational 
Interfaces  > Settings  > 
Virtual Agent]
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Configuration forms and settings for Virtual Agent  and Agent Chat  (continued)

Configuration form or setting in previous release
Conversational 
Interfaces  console 
action card

Chat Settings

NLU settings tab in General Settings

[Conversational Interfaces  > Virtual Agent  > 
General Settings]

Set up NLU
Natural Language 
Understanding in Virtual 
Agent settings

[All  > Conversational 
Interfaces  > Settings  > 
Virtual Agent]

Incident Auto-Resolution

[Conversational Interfaces  > Incident Auto-
Resolution  >

• Setup

• Configuration

• Simulation]

Options are still available in application 
navigator under Conversational Interfaces

Set up Auto 
Resolution Issue Auto Resolution 

(IAR) in Virtual Agent 
settings

[All  > Conversational 
Interfaces  > Settings  > 
Virtual Agent]

Deflection Settings tab in General Settings

[Conversational Interfaces  > Virtual Agent  > 
General Settings]

No card
Deflection Metrics in 
Virtual Agent settings

[All  > Conversational 
Interfaces  > Settings  > 
Virtual Agent]

Custom Greetings and Setup

[Conversational Interfaces  > Virtual Agent  > 
Custom Greetings and Setup]

Choose how your 
bot greets users Custom greetings and 

setup in Virtual Agent 
settings

[All  > Conversational 
Interfaces  > Settings  > 
Virtual Agent]

Metrics

Conversational Analytics

[Conversational Interfaces  > Conversational 
Analytics  >

• Virtual Agent Dashboard

• Event Configuration

• Formula Override]

Collect interaction 
metrics

No setting
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Configuration forms and settings for Virtual Agent  and Agent Chat  (continued)

Configuration form or setting in previous release
Conversational 
Interfaces  console 
action card

Chat Settings

Options are still available in application 
navigator under Conversational Interfaces

General chat settings

Use the Conversational Interfaces Console  to set up the basic chat features shared by Virtual 
Agent  and Agent Chat.

General chat settings

I want to... See these topics

Chat Client Display Options

Brand my bot Branding your chat client

Preview new or unread messages in a 
minimized chat window

Enable message preview on the web client

Conversation Routing

Configure my bot to run in third-party 
messaging apps

Virtual Agent integration with messaging apps.

Create pre-chat surveys Define pre-chat survey configurations

Create and use context variables to 
store chat-related information

Configure context variables for storing chat-related 
information

Display or announce callback options 
to users through other ServiceNow 
apps

Omnichannel Callback

Configure topic context intents Define topic context intent configurations

System Actions

Modify system chat messages Change Virtual Agent and Agent Chat system 
messages

Specify how links open from the chat 
window

URL navigation in Conversational Interfaces

Configure my bot to detect sensitive 
data

Configuring Sensitive Data Handler

Send email summaries of unread 
messages to users when they are 
inactive

Sending missed chat activity emails

Manage LLM virtual agents on the Assistants screen

Create, edit, and turn on/off LLM virtual agents from the Assistants screen.

Before you begin
Role required: virtual_agent_admin
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Procedure

1. Navigate to All  > Conversational Interfaces  > Assistants.

2. The Assistants screen displays existing LLM virtual agents with these fields:

Field Description

Name
Virtual agent's name.

Description
Description of the virtual agent.

Status Is the virtual agent active.

Last updated Date and time the virtual agent was most recently updated.

3. To create a new virtual agent, select Create new  to display the Now Assist  for Virtual Agent 
Overview screen.
Follow the screens to create a new virtual agent. For more information, see Configuring Now 
Assist in Virtual Agent.

4. To edit an existing virtual agent, select the virtual agent's name or select the three vertical dots 

( ) at the end of any field and select Edit.
If Virtual Agent  is completely configured, the Now Assist  for Virtual Agent  Review screen 
displays. For more information, see Configuring Now Assist in Virtual Agent. If Virtual Agent  is 
not completely configured, the last unfinished step in the Virtual Agent  guided setup displays. 
For more information, see Installing Conversational Interfaces components.

5. To turn an existing virtual agent on or off, select the three 

vertical dots ( ) at the end of any field and select Turn on or 

off.

Add your bot to a portal

Give your users a place to interact with your bot and human agents. Choose a Service Portal 
chat configuration provided with your base system, such as the Service Portal  Agent Chat 
configuration used for Agent Chat  and Virtual Agent. Your end users can initiate and maintain a 
bot or Agent Chat  conversation in any page of the portal.
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Before you begin
Activate the Glide Virtual Agent (com.glide.cs.chatbot) or the Agent Chat 
(com.glide.interaction.awa) plugin. You can activate the Glide Virtual Agent plugin only if you have 
a subscription.

Role required: admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Home.

2. Under Add your bot to a portal, select Add to portal  to configure the base system portal.
For example, to configure the portal used for Agent Chat and Virtual Agent, select Service 
Portal Agent Chat Config.

3. On the form, update the portal configuration.

Field Description

Active
Option to make the configuration active. The base system Service Portal 
configurations are automatically active.

Name
Unique name for the configuration record.

Portals
The portals in which you would like to use this chat configuration. If no portal is 
selected, the configuration applies to all portals in the system.

Application
Read-only application scope for the record.

Public
Option to make the portal available to users before they log in.

Roles
Roles that a user must have to use the portal. If you don't select a role, Agent 
Chat  and Virtual Agent is available to all users regardless of their role.

Order Number that indicates the order in which the configurations should run. Only 
one configuration applies per portal. If there are multiple configurations on a 
portal, the system runs the first configuration found from lowest to highest.

Server 
script A script that passes page and widget data to an Agent Chat  conversation 

when a user initiates the conversation. For example, pass a field to the chat 
conversation to enable Agent Chat  to access the value. Data passed in this 
script is available to every page in the portal associated with this record. This 
script has access to the GlideSPScriptable  API.

Note: 
The portal suffix, page ID, and language are automatically available to 
Agent Chat  and do not require a custom script. Sys ID and table are 
automatically available to Agent Chat  when they are present in the URL.

The following example returns an object containing the list of catalogs 
associated with the portal to the current conversation.
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Field Description

(function ($sp) {
   return {
      catalogs: $sp.getValue(‘catalogs’)
   };
})($sp);

When Agent Chat  opens in an iframe  HTML element, the list of catalogs is 
included in the iframe  URL. Parameters from this field override any conflicting 
page data passed to Agent Chat.

4. Select Update.

Result
Your end users can initiate and maintain an Agent Chat  or Virtual Agent  conversation from any 
page in the selected portal.

What to do next

See your portal in action

Return to Conversational Interfaces Home  and under Add your bot to a portal, 
select the second navigation dot at the bottom of the card. When the card changes 
to Interact with your bot, use the Open portal  menu to select the portal to view. 
When the specified portal page opens, select the chat icon in the lower right corner 
to start a bot conversation.

Configure other Service Portal Agent Chat  features

In Service Portal, you can customize the Agent Chat  button and pass page data to 
Agent Chat. For more information, see Configure Agent Chat in Service Portal .

Branding your chat client

Customize your chat interface with your own brand, including company logo and bot avatar, UI 
color schemes, fonts, and the chat support menu displayed to your users.

Note: 
For new customers onboarding from Vancouver onward, the web client is only accessible 
to authenticated users by default. To allow unauthenticated users to access the web 
client, enable Public access  in Conversational Interfaces  > Settings  > General. For more 
information, see Enable public access to the web client.

Multiple branding configurations

You can create any number of branding configurations for an instance. These branding 
configurations apply to the web chat and mobile clients and don't apply to the Conversational 
Integrations for Slack, Microsoft Teams, Workplace by Facebook, and Facebook Messenger.

Note: 
Branding for bots in the Conversational Integration with Microsoft Teams  is available 
through the Microsoft Teams  app customization feature. For details, see MS Teams 
branding for the conversational integration  in Now Community. For information about 
branding bots in Slack, see Configure branding for your Virtual Agent bot in Slack.

The default branding configuration includes the Virtual Agent  bot, which has a ServiceNow 
avatar. If you want additional branded bots, create a user profile for each bot in the User 
[sys_user] table. Give your bot a unique user ID, name (for example, Acme), upload the photo 
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(image) for your bot avatar, and make your bot active. For details on adding users to your 
instance, see Create a user .

Once created, you then select the bot to be used in a configuration. A branded bot can be used 
in a single configuration or in multiple branding configurations.

Supported branding items

Conversational Interfaces  provides a default branding configuration that you can customize. 
To change the default configuration, create other branding configurations, or modify the chat 
(support) menu, gather and prepare the following files and information:

Organization images

Images of company logos to be used in your chat windows. If you're using Virtual 
Agent, the images of avatars to be used for branded bots.

Images must be in .jpg, .png, .bmp, .gif, .jpeg, .ico, or .svg file format. The images can 
be high resolution, but the image display is scaled based on the aspect ratio. Keep 
in mind that if chat is run in its own browser window, a thumbnail of the branding 
logo displays automatically in the browser tab.

Colors and fonts

Colors and fonts used for the various user interface items, such as chat bubbles, 
buttons, and notifications displayed.

If you want to change the color of interface items, determine the Hex number or 
RGBA color for those items. When you specify the Hex or RBGA colors during 
configuration, you can immediately see your changes in the example chat window. 
To learn more about Hex numbers and RGB color specifications, see HTML Color 
Names (W3CSchools) .
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UI items in the chat window

Chat menu items

Contact information for your support organization, such as support call hours, call 
center support phone number, and support email address. You can customize 
information in the support menu by adding or changing menu items, including the 
text and icons displayed. You can also control the visibility of the menu items (show 
or hide menu options).

You can also change the default menu icons or add icons for new menu items. The 
icons must be in .svg file format. For better resolution, use a single-color icon.
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Chat menu

Create a new user for a branded bot

The default branding configuration includes the Virtual Agent  bot, which has a ServiceNow 
avatar. To create a new bot with your own branding, create an active user profile for the bot and 
link it to a Live Profile.

Before you begin
Role required: admin

About this task
If you want to create a new branded bot, create an active user profile for each bot in the 
User [sys_user] table. Then create a bot profile record by adding this user to the Live Profile 
[live_profile] table.

Procedure

1. Create a user  for the bot.
Include an image (avatar) for your bot when you create the user. Also ensure that the user is 
active.

2. Navigate to All, and then enter live_profile.list  in the filter.

3. Select New.

4. On the form, fill in the fields.

Field Description

Name Unique name for the bot profile.

Type Type of live profile. Select User.

Document Table associated with the profile.

a. Select the Search icon ( ).

b. In the Select the document dialog box, specify the following information:
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Field Description

▪ Table name: Select User [sys_user].

▪ Document: Select the name of the user you created for the bot.

c. Select OK.

Photo Image (avatar) for the bot profile.

Description Text that describes the live profile.

5. Select Submit.

Result
You can associate the bot profile with a new branding configuration. For details, see Set up your 
Virtual Agent bot's branding.

Set up your Virtual Agent  bot's branding

Create different Virtual Agent  branding configurations for the various organizations that use your 
instance. These configurations apply to the web-based chat and mobile clients only.

Before you begin
If you're using ServiceNow®  mobile, make sure you set up Virtual Agent  for mobile chat. For 
details, see Configure Virtual Agent for a ServiceNow mobile application.

Check for updates and improvements to the Omni-Experience Standard Feature Set application 
on the ServiceNow Store.

Note: 
Branding for bots in the Conversational Integration with Microsoft Teams  is available 
through the Microsoft Teams  app customization feature. For details, see MS Teams 
branding for the conversational integration  in Now Community. Branding for bots in Slack 
is available as well. For details, see Configure branding for your Virtual Agent bot in Slack.

Role required: virtual_agent_admin or admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. Under the Display Options  section, select View All  next to Branding.

3. Select New  to create a branding configuration or select the branding configuration record to 
be updated.

4. On the form, fill in the fields.

Label Description

Branding 
name

Name of the branding configuration.

Create a new branding configuration or select one of the available choices. For 
the Washington DC  release, the choices include:

◦ Polaris-Dark

◦ Polaris-Light

Chat 
Header

Text string that identifies your company or organization in the chat window. For 
example: Acme Support.
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Label Description

Minimum 
delay 
between 
bot 
messages 
(ms)

Minimum delay, in milliseconds (ms), that occurs between bot responses. The 
default delay is 500 ms.

Minimum 
delay 
before 
displaying 
typing 
animation 
(ms)

Minimum delay, in milliseconds (ms), that occurs before showing the animation 
ellipsis indicating the bot is processing user input.

Menu Title Name of the support menu. The default title is Contact Support.

Branding 
key

Read-only sys_id of the configuration, which reflects the Branding name  you 
entered. The key is in lower case letters with spaces replaced by underscore 
characters.

Bot Profile List that opens the Live Profile form to select or create a new bot user profile, 
which includes the bot picture (avatar).

◦ To review and edit the Virtual Agent  bot profile, click the information icon.

▪ To change the Virtual Agent  bot photo or description, click Edit record  in 
the message at the top of the page.

▪ In the Live Profile form, modify the fields and click Update.

◦ To choose or change the bot for the configuration, select the search icon 
and click the Bot Profile  field. Choose the bot profile that you created in a 
previous step.

Chat 
Header 
Logo

Logo image that displays in the chat header. If live chat is run in a browser 
window, the logo also displays in the browser tab. The chat header logo is set 
to 42x42 pixels, and the chat message logo is set to 24x24 pixels. An uploaded 
image that is smaller than these dimensions will appear stretched. A larger 
image will be scaled down.

◦ To add a logo, select Attach Image  and use the file finder to choose the 
image.

◦ To change the logo, select View image. From the file finder, select the new 
logo file and click OK. The updated logo displays below this field.

◦ To remove the logo, select the trash icon. The file is immediately deleted.

5. Select Save.
From here, you can adjust the color, icons, and font type and size of the chat client to match 
your brand. For example, you can:

◦ Change the color of items

◦ Customize the icons

◦ Customize the fonts used in the chat

6. To change the color of items in the chat window, select the Colors  tab.
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Select an item and specify the Hex or red blue green alpha (RGBA) colors you want to use for 
that item. When you do so, the example chat window shows a preview of your changes.

Customize color for each item

Label Description

Chat window

Chat Header 
Background

Background color of the chat header.

Chat 
Background

Background color of the chat window.

Menu Icon Color of the menu icon, which provides user options to end a conversation 
or contact customer support.

Chat Header 
Font

Font color of text in the chat header.

Input 
Background

Background color of the user input bar.

Chat messages

User Bubble 
Background

Background color of the user chat bubble.

Agent Bubble 
Background

Background color of the live agent chat bubble.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1606



Label Description

Bot Bubble 
Background

Background color of the bot chat bubble.

Link Color of links presented in the conversation.

Button 
Background

Background color of buttons used in the conversation.

Notification 
Background

Background color of Virtual Agent  notifications delivered in the web chat 
client.

User Bubble 
Font

Font color of text in the user chat bubble.

Agent Bubble 
Font

Font color of text in the live agent chat bubble.

Bot Bubble 
Font

Font color of text in the bot chat bubble.

Link turned off Color of links turned off in the conversation.

Notification Text Font color of Virtual Agent  notifications delivered in the web chat client.

Others

System 
message

Color of general system messages displayed in the conversation.

Category 
background

Background color of the heading above a list of topics.

Separator Color of the dashed line that separates each conversation in the Preview 
window.

Time Stamp Color of the timestamp displayed when significant activity occurs during a 
conversation, such as a record being created.

Category font Font color of text in the category heading.

Loading 
Animation

Color of the animated dots that indicate the system is processing 
information.

7. To customize the chat icons in the chat window, select the Icons  tab.
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You can customize the icons on four different chat screens: the main chat screen, the all topics 
screen, the support menu, and the end conversation screen. Use this tab to do the following:

◦ Add a custom icon: Select Add  for the icon, and then select Attach image. After choosing 
the image file, select Apply.

◦ Replace a custom icon: Select Replace  for the icon. Select the trash can icon to delete the 
current image, and then upload a new one.

◦ Revert to the system default icon: Select Remove  for the icon.

Note: 
You can't remove system default icons.

When you specify the icons during configuration, the example chat window shows a preview of 
your changes.

Note: 
Unlike other settings on the branding page, icon changes take effect on the web client as 
soon as you select Apply. Other changes don't take effect until you select Save  at the top 
of the page.

Valid file formats are .jpg, .png, .bmp, .gif, .jpeg, .ico, and .svg.

8. Optional:  Customize the font type and font size.

(Optional) The available branding configurations (for example, Polaris-Light or Polaris-Dark) are 
located here.
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Note: 
This feature is only available after you've installed and updated the Omni-Experience 
Standard Feature Set to the latest version through the ServiceNow®  Store.

To customize the fonts shown in the chat, select the Fonts  tab.

To change the font type, choose one of the following methods:

a. Select the fonts you want to use.
From the chat header text  drop-down list, select the font you want to use for the header.

Do the same for the chat body text.

You will see an example of the new font.

b. Download the fonts from a URL.
From the Add custom font  drop-down list, select From URL, specify the URL, and apply the 
changes.

c. Upload the fonts you want to add from an attached file.
From the Add custom font  drop-down list, select Upload font, specify the path to the file you 
want to attach, and apply the changes.

(Optional) To change the font size for the chat header and the chat body, do the following:

a. From the Font body size  dropdown, choose the Regular, Large, or Extra Large font size.

b. From the Font header size  dropdown, choose the Regular, Large, or Extra Large font size.

Note: 
These changes do not apply to custom controls you have added to the chat widget. 
Custom controls must be updated separately.

c. Preview the changes in your chat window on your portal or website.

9. To update the Contact support menu, scroll down to the Menu Items  section.

You can change the icons, labels, visibility, and display order of the Email, Chat, and Phone 
menu items. You can also add custom options to the menu.

a. In the Menu Items  section, do any of the following:

▪ To edit a menu item, select the record icon.

▪ To add a new menu item, select New.

▪ To delete a menu item, select the record icon. In the record, select the More Actions icon 

, and then select Delete.
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For each menu entry, fill in the fields.

Field Description

Label Text string that describes the menu type.

The labels for the default menu types in the Global application scope are:

▪ Email - Option that opens the default email. Default label: Send Email to 
Customer Support

▪ Chat – Option for chatting with a live agent. Default label: Contact Live 
Agent  for Chat type

▪ Phone - Option that indicates when phone support is available. Default 
label: Call Support—(Daily 5AM - 11PM)

The label text can be up to 75 characters in length.

Type Type of menu item. For example, if you're adding a menu item that is a link to 
specific information such as a help page, select the Link  Type.

The menu item types are:

▪ Email: Option for contacting support through email.

▪ Link: Option for a link to a web page

▪ Chat: Option for contacting a live agent through chat.

▪ Text: Option for setting a text string

▪ Phone: Option for contacting support by phone

Value The menu type value. For example, the Value  for Email is the email address of 
the support group.

The values for the default menu types are:

▪ Email: Email address of the support group. For example: 
support@example.com.

▪ Phone: Phone number of your call support organization.

▪ Email: Email address of your support organization.

Note: 
The chat menu type doesn't have a value.

Visible
Option that makes the item visible in the Contact support menu.

Clear this option to hide the menu item.

Display 
default 
icon

Option that indicates the default icon for the item is visible in the menu.

Clear this option to add, change, or delete a menu icon.
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Field Description

▪ To add an icon for a new menu item, select View image. From the file finder, 
choose your icon file and select OK. The uploaded icon displays below the 
Icon  field.

▪ To change an icon, in the Icon  field select Update. From the file finder, 
select the new logo file and click OK. The updated Icon displays below this 
field.

▪ To remove the icon, select trash  icon. The file is immediately deleted.

Order Number that identifies the sequence in which the item appears in the Contact 
support menu. The number 1 indicates that the item is the first option listed in 
the menu.

Application Global.

b. When you complete the Menu Item  section for a menu type, select Save..

10. Do one of the following to apply the branding configuration:

◦ Apply the branding configuration to a destination page. Enter the system parameter 
sysparm_branding_key  with the branding key in the web client URL. For example:

https://<your-instance-name>service-now.com/$sn-va-web-client-
app.do?sysparm_branding_key=acme

In this example, acme  is the key of the branding configuration to be used.

◦ Apply the branding configuration to an embedded web client. Enter the system parameter 
sysparm_branding_key  with the branding key in the URL for the embedded web client. 
For example:

https://<your-instance-name>service-now.com/$sn-va-web-client-
app_embed.do?sysparm_branding_key=acme

In this example, acme  is the key of the branding configuration to be used.

◦ Apply the branding configuration to a Service Portal  Agent Chat  Configuration. In the server 
script that passes page and widget data to an Agent Chat  (Virtual Agent  or Live Agent) 
conversation, specify the branding key to be used. Items passed in this script are available 
to all pages in the portal. For details on setting up Service Portal  Agent Chat, see .  Add your 
bot to a portal.

For example, the following Service Portal  Agent Chat  Configuration for the Knowledge Portal 
uses the chat branding key, custom_1.
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Note: 
There are other Service Portal Agent Chat features that you can configure, such 
as customizing the Agent Chat button  in your portal. For more information on 
customizing the Agent Chat widget in Service Portal, see Configure Agent Chat in 
Service Portal .

11. Optional:  If you're using Conversation Autopilot  with your branded bot, specify the branded 
bot name displayed in the chat window during Autopilot sessions by changing system 
properties as follows.

a. Navigate to All  > Conversational Interfaces  > Settings.

b. Under the System actions  section, select View All  next to System messages.

c. Change the Value  field of the 
com.glide.cs.autopilot.client_initiated_header  system property to 
specify the branded bot name instead of the Virtual Agent  bot name displayed in the header 
of the chat window.

Autopilot header in chat window
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d. Update the com.glide.cs.autopilot.client_initiated_message 
system property to specify the branded bot name displayed to the requester during the 
conversation.

Autopilot message during the conversation

Enable message preview on the web client

Admins can allow their end users to see a preview of any new or unread messages waiting for 
them when the chat window is minimized.

Before you begin
This feature is only available after you've installed and updated the Omni-Experience Standard 
Feature Set to the latest version through the ServiceNow Store .

Set the com.glide.cs.advanced-chat-popover system property to True. This system property 
enables the smart chat component on the Service Portal. By default, the property is set to False.

Role required: admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings  > General.

2. Under Display options, enable Message preview.
A message displays confirming that the setting has been saved.

Result
When message preview is enabled, and the chat window is minimized, the end user sees a 

message preview badge icon  in the minimized chat window. The message preview badge 
icon lets the user know that there are new or unread messages, and how many. In this example, 
the end user has one new or unread message.

A message preview pane shows the first new or unread message next to the badge icon. The 
message is based the conversation. For example, if the user needed help with using the laptop, 
the message preview pane could be similar to the following image.
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The end user can either:

• Click the message preview pane to continue the conversation in the chat, or

• Close the message preview pane.

The badge icon appears only when there are new or unread messages. The badge icon is 
updated every 10 seconds, and displays the first new or unread message.

Enable public access to the web client

Enable public access to the Virtual Agent  web client for portals.

Before you begin
Role required: admin

About this task
Public access to the Virtual Agent  web client defaults to off. Use the following steps to allow 
public access to the web client for only portals.

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings  > General.

2. Under Display options, enable Public access.

Example of public access

A message displays confirming that the setting has been saved.

Configure context variables for storing chat-related information

Specify chat context variables, also called Live Agent  chat variables, for storing chat-related 
information, such as pre-chat survey responses. These variables contain contextual information 
that can be used to determine topic intent or control how chats are routed to live agents. You can 
also define variables to capture contextual information passed in Virtual Agent  topic scripts to 
share with live agents.
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Before you begin
Virtual Agent  provides pre-built context variables. Before you add a variable, review the list of 
available Live Agent context variables.

Role required: virtual_agent_admin or admin

About this task
You can use context variables in scripts or with the condition builder. For example, you can 
reference context variables in the Live agent  area in the topic Properties  tab when creating a 
topic. When a condition is applied to a topic, it must return as true to display to the user.

For details about using context variables in topic scripts, see Virtual Agent scripts. For 
information about learning to use context variables, see Tutorial: Route interactions by context. 
For descriptions of Live Agent context variables, see Live agent chat context variables.

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. Under Context variables, select View All.

3. On the Context Variables page, select New  to add a variable.

4. On the form, fill in the fields.

Field Description

Name Name of the context variable to be created.

Script Variable Name
Live Agent  variable name, which is 
automatically created from the Name. The 
variable name begins with LiveAgent.

Table
Name of the ServiceNow  table associated 
with the context variable. Select a table from 
the list.

Record Option to associate the context variable to a 
record in the specified table. If you selected a 
table, this option is automatically selected.

Value Script that determines the information stored 
in the context variable.

5. Select Save.
The context variable is now available for use.

Live agent chat context variables

Use chat context variables to pass certain information from the topic to share with a live agent or 
to control how bot conversations are routed to live agents. Virtual Agent  includes some default 
variables, and you can define new ones.

Note: 
The Interaction table is part of the interaction management framework, which is 
activated through the Interactions Management plugin (com.glide.interaction). This 
plugin is included with the Agent Chat  (com.glide.interaction.awa) and Connect Support 
(com.glide.connect.support) plugins.
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Live Agent variables included with Virtual Agent

Variable Description

application Application scope of the chat. For example, Global, 
HR, CSM, or ITSM.

auto_resolution_context_id
If Auto Resolution is enabled, the ID of the record 
created when a requester is redirected to Virtual 
Agent.

case
Case ID (from the [sn_customerservice_case] table) 
that is used with the Customer Service Management 
application when a case is related to the chat.

csp_category
Category defined in the Consumer Service portal in 
the CSM  application (requires the com.glide.service-
portal.consumer-portal plugin).

For more information, see Using the Consumer 
Service Portal .

csp_email Requester’s email address, as entered in a pre-chat 
survey on the Consumer Service Portal.

csp_first_name Requester’s first name, as entered in a pre-chat 
survey on the Consumer Service Portal.

csp_last_name Requester’s last name, as entered in a pre-chat 
survey on the Consumer Service Portal.

devicetype Type of device being used for the chat. For example, 
mweb  (web client), android, or ios.

esc_pre_chat_ask_a_question
Requester response to a pre-chat survey selection 
from within the HR Service Delivery  application ESC 
view of the HR Case record.

experience_name Name assigned to the Live Agent experience.

hr_topic_id
ID of the current topic. Used in Advanced Work 
Assignment  to determine which HR queue to transfer 
the user for live agent chat.

interaction_account
Used with CSM  chats that are initiated by B2B 
users who are tracked as contacts for a particular 
account. Corresponds with the Account  field on the 
Interaction [interaction] table, which references the 
Accounts [customer_account] table.

interaction_consumer
Used with CSM  chats that are initiated by B2C 
users who are tracked as consumers. Matches 
the interaction.consumer field referencing the 
csm_consumer table. Corresponds with the 
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Live Agent variables included with Virtual Agent  (continued)

Variable Description

Consumer  field on the Interaction [interaction] table, 
which references the Consumers [csm_consumer] 
table.

interaction_contact
Used with CSM  chats that are initiated by B2B 
users who are tracked as contacts for a particular 
account. Corresponds with the Contact  field on the 
Interaction [interaction] table, which references the 
Contacts [customer_contact] table.

interaction_id Sys_id of the interaction record associated with the 
chat session.

For more information, see Virtual Agent interaction 
records.

language Two-letter language code for the requester's chat.

Note: 
Language values use ISO standard two-
character language codes. For more 
information, see ISO 639.1 language codes .

mandatory_skills Required skills and skill level for an agent.

For example, German language proficiency with 
an associated high skill level may be required 
for German-speaking requesters. You can define 
mandatory skills and activate skill levels in Advanced 
Work Assignment. For more information, see 
Configure agent assignment rules.

optional_skills Skills and skill levels that would be useful for a given 
chat scenario.

You can define optional skills in Advanced Work 
Assignment. For more information, see Configure 
agent assignment rules.

page The specific page (within a portal) that the chat was 
accessed from.

portal Name of the portal that the chat was accessed from.

post_assessment_instance Reference to the post-chat survey (Assessment 
Instances [asmt_assessment_instance] table), if there 
is one.

post_chat_survey_name Name of a post-chat survey that is used to gather 
feedback from the requester.

For information about creating surveys, see Create 
chat surveys.
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Live Agent variables included with Virtual Agent  (continued)

Variable Description

For information about creating surveys in Connect 
Chat, see Configure a survey in Connect Chat 
support.

pre_assessment_instance Reference to the pre-chat survey (Assessment 
Instances [asmt_assessment_instance] table), if there 
is one.

pre_chat_survey_name Name of a pre-chat survey that is used to gather 
information from the requester.

For information about creating surveys, see Create 
chat surveys. To learn more about how chat context 
variables from pre-chat surveys are used in Advanced 
Work Assignment  to route work to live agents, see 
Work item queues.

For information about creating surveys in Connect 
Chat, see Configure a survey in Connect Chat 
support.

queue Sys_id of the pre-built Connect Support chat queue 
(deprecated).

search_text
Search terms entered by the requester. Used to 
search Virtual Agent  topics.

short_description Used to set the short description in the interaction 
record associated with the chat.

sys_id Sys_id of a record that relates to the interaction. 
Typically, this is the record being viewed in the portal 
when the chat is requested.

table Table containing the record that relates to the 
interaction. Typically, this is the record being viewed 
in the portal when the chat is requested.

url URL from which the request originates.

Additional resources

• How to transfer a chat to a specific queue using context variables

• Virtual Agent and Natural Language Understanding (NLU) community forum

• Conversational Interfaces Academy

Change Virtual Agent  and Agent Chat  system messages

Customize the default system messages displayed during Virtual Agent  conversations and Agent 
Chat.

Before you begin
Role required: virtual_agent_admin or admin
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About this task
Use System messages  in Chat Settings to change the properties that control standard chat 
messages displayed in your instance. If you're using Virtual Agent  and Agent Chat, the System 
Messages  list displays properties for both Virtual Agent  and Agent Chat  messages. If you're 
using Agent Chat  only, the System Messages  list displays only the properties relevant to Agent 
Chat.

Note: 
While the web client uses the Messages table [sys_ui_message] to configure the greeting 
and closing messages, third-party Conversational Integrations (such as Microsoft Teams) 
use system messages. To change them, modify these messages in System Messages as 
follows:

• For greetings that call vaSystem.getTopicSelectionMessage(), modify the 
value of com.glide.cs.topic_picker_msg.

• For closings that call vaSystem.endConversation(), modify the value of 
com.glide.cs.conversation_ended_msg.

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. Under System messages, select View All.

3. In the System Messages list, select the property record for the message you want to change.

4. In the Value  field, enter the new message text and select Save.
Any changes are immediately applied to the system messages displayed in your instance.

URL navigation in Conversational Interfaces

Use URL navigation settings to specify where and how chat links open. You can configure certain 
links to open in a specific portal. You can also specify the link target, such as a popup window.

Your base system instance provides default portals in which chat links to records from certain 
ServiceNow  tables are opened automatically. For example, Service Portal  is the default portal 
used to display knowledge records from the Knowledge [kbknowledge] table and also catalog 
items from the Catalog Item [sc_cat_item] table.

Use URL navigation  in Chat Settings to change these default mappings, as well as define custom 
mappings that map a portal URL to a specified ServiceNow  table. The portal configurations apply 
to the web client, chat channels, and messaging channels.

How URL navigation works

To determine the portals to be used for chat links, the system evaluates the following information 
in the order listed:

1. sysparm  portal parameter - If you specified a sysparm_portal parameter in the instance URL 
for the web client, that portal is used.

2. Topic script variable - If you specified a portal in a topic script variable, that portal is used.

3. Default portal for Provider Channel Identity - If you specified a default portal in the Provider 
Channel Identity [sys_cs_provider_application] table for pre-built chat integrations or custom 
chat integrations, that portal is used. The default portal applies to the chat and messaging 
channels for the provider. For details on configuring the Provider Channel Identity, see Create 
a channel identifier for your custom chat integration  in Custom chat integration framework.

4. Default portal for a table - Uses the portal value in the default portal mapping listed in URL 
navigation  Chat Setting.
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5. Global default portal - If you defined a global default portal using the 
com.glide.cs.url_redirect.default.portal  system property, that global portal 
is used.

6. Service Portal  - If you didn't define a global portal using the 
com.glide.cs.url_redirect.default.portal  property, Service Portal  is used.

Legacy URL mappings defined in previous releases (fallback method)

If you previously added the 
com.glide.cs.portal_url_mapping.default.<portal_value>.<table_name> 
property to create URL mappings that were used instead of the default URL mappings, those 
properties are retained after you upgrade to the Washington DC  release. However, you 
can now view the mappings using URL navigation  in Chat Settings or the URL Navigation 
[sys_cs_portal_url_mapping] table. There are two types of URL mappings.

Default mappings

All system properties with the format 
com.glide.cs.portal_url_mapping.portal.<table_name>  that 
define the default portal used for certain ServiceNow  tables.

Default URL mapping properties

Property Description

com.glide.cs.portal_url_mapping.portal.kb_knowledge
Default portal context (URL mapping) to use 
for Knowledge Base articles.

• Type: string

• Default value: sp (Service Portal)

com.glide.cs.portal_url_mapping.portal.sc_cat_item
Default portal context (URL mapping) to use 
for Service Catalog items.

• Type: string

• Default value: sp (Service Portal)

com.glide.cs.portal_url_mapping.portal.sys_user
Default portal context (URL mapping) for 
sys_ user records.

• Type: string

• Default value: esc (Employee Service 
Center)

Custom mappings

All system properties that define a portal and table combination using the format 
com.glide.cs.portal_url_mapping.<portal_name>.<table_name>. 
These mappings are retained as custom mappings. When the portal or table is 
specified with  _default, it indicates that any portal or table is used.

The system determines the URL for custom mappings by evaluating the following 
values:

• Portal and table/parent table

• Portal and any table
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• Any portal and table/parent table

• Any portal and any table

Custom URL mapping properties

Property Description

com.glide.cs.portal_url_mapping._default.kb_knowledgeDefault for Knowledge URL mapping.

• Type: string

• Value:/{{portal}}?
id=kb_article&sys_id={{data.sys_id}}

com.glide.cs.portal_url_mapping._default.sc_cat_itemDefault for Catalog Item URL mapping.

• Type: string

• Value: /{{portal}}?
sys_id={{data.sys_id}}&id={{data.table_name}}&table={{data.table_name}}

com.glide.cs.portal_url_mapping._default.sys_userDefault for User URL mapping.

• Type: string

• Value: /{{portal}}?
id=user_profile&sys_id={{data.sys_id}}

com.glide.cs.portal_url_mapping._default._defaultDefault URL mapping for records other 
than knowledge articles, Service Catalog 
items, People (sys_user) records, publication 
records, and task records.

• Type: string

• Value: /{{portal}}?
sys_id={{data.sys_id}}&id=form&table={{data.table_name}}

Smart links

As an admin, you can specify the target for URL links based on patterns that you specify. For 
example, if you want all KB articles to open in a new window, you can configure the mapping in 
general chat settings. For more information, see Create a smart link preference.

Configure URL navigation for chat links

Configure the portals in which links to ServiceNow  records in Live Agent  and Virtual Agent 
conversations are opened, including links in output cards and cards for Virtual Agent 
notifications and AI Search  results.

Before you begin
Role required: admin
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Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. Under URL navigation,  select View All.

3. On the URL Navigation page, do one of the following:

◦ To create a new custom mapping, select New.

◦ To change a default or custom mapping, select the record to be updated.

◦ If you have multiple mapping records to be updated, click the box to the left of the mapping 
record to be updated and select Edit. The preview pane opens and shows the URL 
Navigation fields that you can change in the selected records.

4. Complete or update the URL Navigation fields.

Field Description

Description Name of the portal for a particular table record.

Type Type of portal mapping:

◦ Default Mapping: Default portal mapped to the following 
ServiceNow  tables:

▪ Service Portal - Catalog Item [sc_cat_item] table

▪ Service Portal - Knowledge [kb_knowledge] table

▪ Employee Center Portal - User [sys_user] table

◦ Custom Mapping: Portal URL definition that identifies 
a portal and ServiceNow  table combination, which is 
entered in the Value  field.

Table
ServiceNow  table that maps to the portal. Select a table 
from the list of tables.

Application Name of the application to which this URL mapping 
belongs.

Portal Portal to be used in the mapping. Select a portal from the 
list of portals.

Value
For new custom mappings, specify the 
combination of portal and table values to form 
the link. For example, the following value maps 
knowledge articles to the CSP portal:/csp?
id=kbarticle&sys_id={{data.sys_id}}

If you're changing a custom mapping that 
was defined in a previous release using the 
com.glide.cs.portal_url_mapping._default.<table> 
system property, you do not need to specify a Value.

5. Select Save  to enter a new mapping or update an existing mapping.
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Create a smart link preference

Create smart links to specify where a URL should open. For example, the URL could open in a 
new browser window, in a new browser tab, in the chat window, or in a pop-up window.

Before you begin
Role required: virtual_agent_admin or admin

About this task
If you (as an admin) have enabled URL navigation  on the page, you can specify patterns for 
where and how the links open in the chat windows. End users see the URL links based on the 
patterns you've specified.

For example, you can set these URL "smart links" to open in a new browser window, in a new 
browser tab, in the chat window, or in a pop-up window. If you specify a pop-up window, you can 
set the size of the window your end users see.

Smart links can be used in chats with live agents.

Error messages display for channels that don't support smart links.

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. Under the System actions  section, select View All  next to URL navigation.

3. Select the Target Location  tab.

4. Select New.

5. On the form, fill in the fields.

Field Description

Description The purpose of the smart link.

Where to open Where to open the link. Choose one of the following options:

◦ New Browser Tab: Opens the link in a new browser tab.

◦ Load in Place:: Opens the link in the current location.

◦ Parent: Opens the link at the highest or parent level.

◦ Popup: Opens the link in a pop-up window and lets you specify the pop-
up window size.

◦ Raise Event: In the web client only, prevents the default select behavior, 
avoiding a page navigation (the chat is kept open).

Order Number that indicates the order in which smart link preferences run. If there 
are multiple preferences, the system runs the first smart link preference 
found, from lowest to highest order.

URL Pattern URL pattern that uses regular expression quantifiers.

If the regular expression is invalid, an error message is shown.

Condition 
mode

Expression logic to specify a condition for applying the smart link 
preference.
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Field Description

Select either:

◦ Simple, or

◦ Advanced

Set conditions

Note: 
Applies 
only if you 
select the 
Simple 
condition 
mode.

If you select the Simple  condition mode, use the condition builder to add or 
edit the condition.

The condition builder specifies that the smart link is only applicable to links 
in the Service Portal  when they're accessed on the web client.

◦ devicetype: Refers to the channel. In the Washington DC  release, only 
the web client (mweb) is supported. The mobile web client isn't supported 
currently.

◦ portal: Represents a specific portal. Specify the portal URL suffix in the 
condition. Navigate to All  > Service Portal  > Portals  to view portals and 
their suffixes

◦ Select Set.

Script

Note: 
Applies 
only if you 
select the 
Advanced 
condition 
mode.

If you select the Advanced  condition mode, use the script editor to create 
or edit a JavaScript condition statement. When the end user selects the 
link, the component triggers a Window: message event . As a developer, if 
you see the Window: message event , you can decide how to handle the 
navigation. For example:

window.addEventListener('message', e => {
    if (e.data.type === 'SMART_LINK_CLICKED') {
    console.log(e.data);
    /**
       {
            type: 'SMART_LINK_CLICKED',
          src: 'https://domain.com/link/src'
       }
    */
  }
});

6. Select Save.

What to do next
If you would like to enable smart link preference for Microsoft Teams, you must first Configure 
link authentication and opening experience in Microsoft Teams  and then Configure smart links in 
Microsoft Teams
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Create chat surveys

Use Survey Designer to build conversational questionnaires for gathering pre-chat information 
and post-chat feedback from end users. These questionnaires run in the chat client for Virtual 
Agent  and Agent Chat.

Before you begin
Identify the information that you want from your requesters, such as their name or email address. 
If you're collecting pre-chat information, determine whether certain survey responses should 
be stored as chat context variables so that you can use that information for topic discovery or 
routing chats to certain work item queues. Before you build your survey, configure the context 
variables  for storing responses to certain survey questions. You will map these chat context 
variables to the appropriate questions in your survey.

Role required: survey_admin or admin

About this task
You define, configure, and publish conversational questionnaires (surveys) using Survey 
Designer. You can use various survey controls to define the content of your questionnaires. For 
details on the survey controls available, see Survey designer elements  to see how the controls 
are rendered in the survey. For example, the Choice control provides a multiple choice selection 
to your users.

The survey controls map to corresponding Virtual Agent Designer  input controls that render the 
survey as a conversation in the chat client. For examples on how Virtual Agent Designer  input 
controls are rendered in run-time conversations, see Virtual Agent Designer user input controls. 
The following table identifies the survey controls supported in Virtual Agent Designer.

Survey controls that map to Virtual Agent Designer  input controls

Survey Designer controls Comparable Virtual Agent Designer  user input controls

Attachment Image

Boolean Boolean

Choice Static Choice

Date Date Time

Date/Time Date Time

Number Text input

Percentage Text input

Scale Static Choice

Numeric scale Static Choice

String Text

Image scale Carousel

Reference Not supported

Multiple selection Not supported

Ranking Not supported

Template Not supported
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Procedure

1. Navigate to All  > Survey  > Survey Designer.

2. Select the Configuration  tab and configure the survey.
As you configure your survey, remember the following:

◦ If you want an introduction note and end note to begin and end your survey, enter your 
content in the Introduction  and End note  fields.

◦ Select the Chat Survey  option to enable conversational questionnaires. This option also 
enables the display of the Context  option in the Properties form for each survey control.

◦ Click Save.

For details, see Configure a survey in the survey designer.

3. Click the Design  tab and give your survey a Name.
As you design your survey questions, remember the following:

◦ To create a question, drag a data type icon from the Controls palette and drop it into 
the category container. Give each question a Name  and click the gear icon to open the 
Properties form for the control.

◦ In the Properties form, complete the fields as needed to define the control.

▪ If you enable the Mandatory  option, users are required to answer the survey question. If 
you leave this field blank, users can skip the question in the survey.

▪ If you want to store the user response to this question, enter the chat context variable in 
the Context  field.

◦ Click Save.

For details, see Create a question in the survey.

4. When you are finished defining the questions in your survey, select Preview  to review your 
survey.

5. When you are satisfied with the survey, select Save and Publish.
Your survey is listed in the Assessment Metric Types [asmt_metric_type] table.

What to do next
Define the pre-chat and post-chat survey configurations that control the surveys to be presented 
to your requesters.

Define pre-chat survey configurations

Use pre-chat surveys to capture preliminary information from a customer. You can define a 
configuration that determines the pre-chat survey to be presented to your customers. From 
the responses received, Advanced Work Assignment  routes chat conversations to appropriate 
queues and groups.

Before you begin
Create the chat survey  to be used in this pre-chat survey configuration.

Role required: admin

About this task
Apply the conditions that determine the pre-chat questionnaire to be presented to your 
requesters.
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Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. Under Pre-chat surveys  on the General  tab, select View all.

3. On the Chat Surveys page, select New  to create a new chat survey configuration or select the 
configuration you want to update.

4. Under Details, enter or change the settings.

Field Description

Name Unique name for this pre-chat survey configuration.

Active Option that activates this pre-chat survey configuration.

Show 
Summary

Option that asks requesters if they want to see a summary of the survey 
responses they entered.

Order Number that indicates the order in which survey configurations run. If there 
are multiple pre-chat survey configurations, the system runs the first survey 
configuration found, from lowest to highest order.

Condition 
mode

Type of condition to be used to control the conversational survey presented to 
requesters.

◦ Advanced: Specify a JavaScript scripted condition.

◦ Simple: Specify a condition using the condition builder.

Condition Condition that controls when the survey configuration is used. Select Set 
Condition  to specify the conditions.

Survey List of the pre-chat surveys available. Choose the survey to be presented to the 
requester.

5. Select Save.

Result
When a requester completes the pre-chat survey, the user is transferred either to a live agent if 
Agent Chat  is set as the fulfiller interface or a virtual agent if Virtual Agent  is set as the fulfiller. 
The user's pre-chat responses are stored as context in the chat interaction record. Before 
entering into a chat conversation, the assigned agent can review the context of the issue.

Define post-chat survey configurations

Control the post-chat questionnaire displayed to your requesters to gather feedback on their 
experience with live agents. You configure the post-chat surveys to be used for chat queues 
defined in Advanced Work Assignment.

Before you begin

• Activate the Agent Chat  plugin (com.glide.interaction.awa) if Advanced Work Assignment  is not 
already installed.

• In AWA, configure the chat service channel  and the work item queues.

• Determine the post-chat survey to be displayed to your requesters.
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◦ Review the existing chat surveys available in the Assessment Metric Types 
[asmt_metric_type] table by navigating to All  > Survey View  > View Surveys. You can use a 
pre-built feedback survey, such as the survey for Virtual Agent  feedback (a pre-built Virtual 
Agent setup topic).

◦ If you need different post-chat surveys, create them using Survey Designer. For details, see 
Create chat surveys.

Role required: admin

Procedure

1. Navigate to All  > Advanced Work Assignment  > Settings  > Queues.

2. Select the queue (that uses the Chat service channel) to which the post-chat survey 
configuration applies.

3. Go to the Post Chat Survey  related list, and then select New.
If the Post Chat Survey list doesn't display, you may need to add it to the form.

4. On the form, fill in the fields.

Field Description

Name Unique name for this post-chat survey configuration.

Active Option that enables this post-chat survey configuration.

Show 
Summary

Survey option that asks requesters if they want to see a summary of the survey 
responses they entered.

Order Number that indicates the order in which survey configurations run. If there are 
multiple chat survey configurations, the system runs the first survey found, from 
lowest to highest order.

Requester 
ended

Option that specifies if the post chat survey should always run regardless of who 
ends the chat.

◦ True: Survey should run when either the requester or the agent ends the chat.

◦ False: Survey should run only when the agent ends the chat.

Condition 
mode

Type of condition that determines the conversational survey presented to 
requesters.

◦ Simple: Specify a condition using the condition builder.

◦ Advanced: Specify a JavaScript scripted condition.

Condition Condition that determines the conversational survey displayed to requesters.

Use the condition builder to select the conditions to be applied. The fields 
available for selection are based on the Chat service channel.

Script JavaScript condition statement that specifies the condition for using this chat 
survey. The condition must evaluate to true.

Survey List of the chat surveys available. Choose the post-chat survey to be presented 
to your requesters.

5. Select Submit.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1628



Result
When a live agent ends the chat session, the post-chat survey (configured for the chat queue) is 
presented to the requester. When the requester submits the post-chat survey, the chat session 
ends for the requester. The Interaction Related Records list stores the post-survey chat results 
and creates a related record that links the assessment to the live agent (fulfiller).

Using pre-chat surveys with context variables for topic discovery

Capture user input from pre-chat surveys to use as utterances or keywords for topic discovery.

If you're using a pre-chat survey, you can use information supplied by the user to direct them to 
the appropriate Virtual Agent  topic without asking them to choose from a list of available topics.

A good example of this is the CSP Anonymous Pre-Chat Survey, which is included with the 
Customer Service Management (CSM)  application. This survey applies to guest users on the 
CSP portal. In addition to asking for the user's name and email address, the last question asks 
the user to briefly describe the issue. The answer is mapped to the short_description field in the 
question settings. This is the context for the user's answer.

Question settings for the CSP Anonymous Pre-Chat Survey in Survey Designer

The user response can be passed to Virtual Agent for use in topic discovery. In order to do this, 
you must create a record for it in General Chat Settings.
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Topic context intent card in General Chat Settings

The Pre-chat short description as NLU intent record allows the CSP Anonymous Pre-Chat 
Survey input to function a bit like an NLU intent. When the survey runs, the interaction's 
short_description is used as the search text for the conversation. Virtual Agent  uses this input for 
topic discovery so that users don't have to select a topic from the Greetings screen.

The Context topic intent record that corresponds with the pre-chat survey

Define topic context intent configurations

Use pre-chat survey information to determine the appropriate Virtual Agent  conversation topic 
automatically displayed to end users (requesters), rather than prompting them to choose from a 
list of conversation topics.

Before you begin

• Configure the chat context variables  for storing user answers to specific questions in your chat 
surveys.

• As you create your chat survey, map a survey question to a new or existing chat context 
variable. The variable stores the user response that Virtual Agent  uses to determine topic 
context intent and the conversation topic displayed.

• Role required: virtual_agent_ admin or admin
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About this task
Create a context topic intent to specify conditions that determine which Virtual Agent 
conversation topic is displayed after a user answers a pre-chat survey. The context topic intent 
uses data collected by the survey to find an appropriate topic for the user.

For example, a pre-chat survey asks the user “What problem are you having with your 
computer?” and maps their answer to a context variable called “problem” in the survey. The 
variable passes from the survey to the topic context intent. Instead of the chat going directly to 
topic discovery, the variable stored in the intent is used as an utterance to feed into the Virtual 
Agent  for topic discovery.

You can define conditions in a topic context intent to limit topic discovery, such as restricting the 
“problem” variable in the preceding example to only feed to ITSM VA conversations. The Context 
Topic [sys_cs_context_topic] table is used to map your variables for intent discovery, after the 
pre-chat survey has been executed.

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. Under Topic context intent, select View All.

3. In the Context Topic page, select New  or the configuration to be modified.

4. On the form, fill in the fields.

Field Description

Name Name of the configuration for topic context intent 
(topic discovery).

Active Option that activates this topic intent 
configuration.

Order Order in which Virtual Agent  evaluates topic intent 
configurations to find a matching condition for 
displaying the topic. Virtual Agent  reviews the 
configuration that has the lowest order value first.

Condition mode
Type of condition that determines how the topic 
intent configuration is to be applied.

◦ Simple: Specify a condition using the condition 
builder.

◦ Advanced: Specify a JavaScript scripted 
condition.

Condition Condition for applying the specified context 
variable that displays the corresponding 
conversation topic. Select Set conditions  to enter 
the condition filter.

If no condition is specified, the specified context 
variable applies to all conversations.

Script JavaScript condition statement for applying 
the specified context variable that displays the 
corresponding conversation topic. The condition 
must evaluate to true.
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Field Description

[Displayed when Condition mode  is set 
to Advanced]

Context Chat context variable that stores the user 
response to a specific survey question and used 
to determine the topic intent.

5. Select Save.

Result
The context topic intent configuration is added to the Context Topic [sys_cs_context_topic] table. 
Virtual Agent  displays the appropriate conversation topic to users based on the context intent 
configuration.

Conversational Interfaces Guided Setup

Use the Conversational Interfaces Guided Setup to create a personalized setup process for just 
the conversational interface features you need. The Conversational Interfaces Guided Setup 
starts with a survey and creates a personalized task list based on your survey responses.

Before you begin
The system admin role is required to activate the plugins and store applications. However, 
AWA admins and Virtual Agent  admins can complete additional setup tasks for their respective 
solutions.

Role required: admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Conversational Interfaces Guided Setup.
The Conversational Interfaces Guided Setup page appears.

2. Review the sections Getting started and Things to consider for setup, which provide 
information on the setup process and highlight various items to think about before 
implementing Virtual Agent, Agent Chat, or both.
Also consider whether you want to run Quick setup to get your agents running in as little as 30 
minutes, in a minimal number of steps. Manual setup involves a comprehensive series of steps 
to set up your agents and may take a couple of hours or several days to complete, based on 
your configuration.

3. Select Get Started.

4. In Customize your setup, select Get Started  and then Configure  to start your personalized 
setup.

5. Select the type of agents that you're using and the type of setup (Quick or Manual).
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6. Select Continue  and complete the subsequent setup tasks.

What to do next
After you've completed the setup tasks, you and your topic authors can explore the functionality 
provided with Virtual Agent, such as reviewing pre-built conversations and creating or updating 
conversation topics for your end users.

Related topics

Guided Setup

Conversational Interfaces  reference

Conversational Interfaces  reference topics provide shared technical descriptions of features that 
apply to Virtual Agent  and Agent Chat, such as the Interactions table.

Data management in Conversational Interfaces

Use data management tools, such as table cleaners, to maintain Conversational Interfaces 
tables.

Virtual Agent  table cleaning

Virtual Agent  has a data retention policy that automatically deletes records from certain 
base system tables when they reach a specific age, to prevent tables from growing to an 
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unmanageable size. Some Virtual Agent  and related Conversational Interfaces  tables are not 
automatically cleaned. You can activate table cleaning for the following tables.

Conversational Interfaces  tables that need cleaning

Table label Table name Description
Default record age 
(seconds)

Chat Server 
Analytics

sys_cs_analytics Server records that include 
sys IDs for messages, 
threads, conversations, 
users, and events.

7,776,000

Conversations sys_cs_conversation Conversation details, 
including topic definition, 
device used, and consumer 
(user).

Note: 
Table cleaner also 
automatically deletes 
the related records for 
the following:

• Conversation 
Messages

• Conversation Tasks

• Conversation 
Members

• Session bindings

• Profane message 
logs if using the 
Profanity Filter

5,184,000

Message Last 
Reads

sys_cs_message_last_readMessage IDs of the last 
messages read by users 
in chat and messaging 
channels.

15,552,000

CI Analytics sys_ci_analytics Conversation details used 
in Conversational Analytics. 
If the conversation ID is 
available, table cleaner 
removes closed, complete, 
and faulted conversations 
from the Conversations 
[sys_cs_conversation] table.

604,800

The Auto Flushes [sys_auto_flush] table lists the base system tables and their corresponding 
record ages. When table cleaning is activated, the Table Cleaner scheduled job triggers the table 
cleaner to remove the records that meet the default record age. If needed, you can change the 
record age for a table and specify any conditions to filter the records to be removed. For details, 
see Activate table cleaning for Virtual Agent tables.

If a table has related child tables, the table cleaner automatically performs a cascade delete 
to remove the related child tables. For example, when table cleaning is activated for the 
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Conversation [sys_cs_conversation] table, the table cleaner runs automatically when the table is 
60 days (5,184,000 seconds) old. The table cleaner also performs a cascade delete to remove 
the related child tables. To learn more about table cleaning in the ServiceNow AI Platform, see 
Table cleaner .

Activate table cleaning for Virtual Agent  tables

Activate table cleaning for certain tables used in Virtual Agent  and Conversational Interfaces.

Before you begin
Role required: admin

About this task
You can activate table cleaning for these Virtual Agent  and Conversational Interfaces  tables:

• Chat Server [sys_cs_analytics]

• Conversations [sys_cs_conversation]

• Message Last Reads [sys_cs_message_last_read]

• Ci Analytics [sys_ci_analytics]

Procedure

1. Open the Auto Flush [sys_auto_flush] table by typing sys_auto_flush.list  in the filter 
navigator.

2. Select the table to be activated for cleaning.

3. Change the fields in the form as needed.

Auto Flush form

Field Description

Age in seconds
The time, in seconds, that specifies when 
records in the table are to be deleted.

To change the age, enter the new value in 
seconds.

Active Option to activate or deactivate table 
cleaning for this table. Select this option to 
activate table cleaning.

Cascade delete Option to activate or deactivate table 
cleaning for related tables. Some tables may 
have child tables that are also automatically 
cleaned.

Conditions Condition builder for specifying filter 
conditions that define the records to be 
removed.

4. Select Update.

The Table Cleaner scheduled job automatically runs the cleaner when the table records meet 
the specified record age and any conditions that you set for them.
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Interaction Insights table

User sentiment analysis prepares agents for the tone of incoming conversations. Business 
rules can be created based on this value and agents can take appropriate actions on the chat, 
whether it comes from Virtual Agent, another live agent, or from a queue.

Both synchronous and asynchronous channels support sentiment analysis. Use Task 
Intelligence  to set up sentiment analysis.

When configured, sentiment analysis is performed at the end of a Virtual Agent  or live agent 
conversation. The user sentiment is stored in the Interaction Insights [sys_cs_interaction_insight] 
table.

Interaction Insights table

Field Description

Interaction The sys ID for the conversation in the Interactions [interaction] table.

Sentiment Shows the sentiment level of the interaction, if sentiment analysis is enabled 
on the instance. This value can be shown to agents in the Agent Chat  interface. 
Business rules can be created based on this value at handoff (Virtual Agent  to live 
agent, live agent to live agent, or live agent to queue). Valid values are as follows:

• Positive

• Neutral

• Negative

• null (no value assessed)

Sentiment 
Normalized

Sentiment score between -0.5 (negative sentiment) and 0.5 (positive sentiment).

You can modify these values by adjusting the 
com.glide.cs.neutral_sentiment_max_value  and 
com.glide.cs.neutral_sentiment_min_value  system parameters.

Type Type of analysis performed. For example, Sentiment.

User Name of the agent or Virtual Agent.

User Type Type of user. For example, Agent.

Virtual Agent
Unlock your enterprise productivity with ServiceNow®  Virtual Agent. Provide your employees 
and customers with a friendly messaging interface, featuring pre-built conversations powered by 
artificial intelligence.

https://player.vimeo.com/video/988245428?
badge=0&autopause=0&player_id=0&app_id=58479

Get started with ServiceNow AI Platform  Virtual Agent

Select a tile to get started with ServiceNow AI Platform  Virtual Agent.
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Explore

Learn how employees, 
customers, and agents 

use Virtual Agent.

Plan and configure

Plan and configure 
your Virtual Agent 
implementation.

Build and deploy

Design and build 
automated conversations 

and reusable topic 
components.

Integrate and maintain

Extend Virtual Agent 
capabilities by integrating 

with other applications.

Analyze

Improve and refine 
Virtual Agent interactions 
using deep insights into 

conversational data.

Reference

Get Virtual Agent 
Designer interface 

descriptions and Virtual 
Agent technical details.

Get started with Virtual Agent  for specific businesses

To explore Virtual Agent  for IT Service Management, Customer Service Management, or HR 
Service Delivery, select a business tile to learn more.

Virtual Agent
for IT Service 
Management

Predefined 
Virtual Agent
topics to help 

your employees 
complete common 

IT-related tasks.

Virtual Agent for 
Customer Service 

Management

Predefined 
Virtual Agent
topics to help 

your customers 
complete common 
self-service tasks.

Virtual Agent
for HR Service 

Delivery

Predefined 
Virtual Agent
topics to help 

your employees 
complete common 
HR-related tasks.

Virtual Agent
for Workplace 

Service Delivery

Predefined 
Virtual Agent
topics to help 

your employees 
complete common 

workplace-
related tasks.
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Virtual Agent
for Field Service 

Management

Predefined 
Virtual Agent
topics to help 

your customers 
complete common 

field service 
management 

tasks.

Virtual Agent for 
Project Portfolio 

Management

Predefined 
Virtual Agent
topics to help 

your customers 
complete common 

Project Portfolio 
Management

tasks.

Virtual Agent
for Legal 

Service Delivery

Predefined 
Virtual Agent
topics to help 

your customers 
complete common 
legal-service tasks.

Additional resources

• Virtual Agent and Natural Language Understanding (NLU) community forum

• Conversational Interfaces Academy

Note: 
We improve performance and the user experience by tracking aggregate in-app activity, 
including interaction with our app. This tracking is focused on aggregated technical 
information rather than personal information.

Exploring Virtual Agent

The  ServiceNow  Virtual Agent  platform provides user assistance through conversations within 
an intelligent messaging interface.  Design and build automated conversations with an out-of-
the-box system that help your users quickly obtain information, make decisions, and perform 
common work tasks with Virtual Agent.

Overview

Virtual Agent  helps solve ordinary issues and delivers results for common requests, leaving your 
agents and technicians free to focus on more complex user issues. You can change the look 
and feel of the chat experience to suit each audience for your business, including running your 
chatbot in a variety of common or custom messaging channels. Monitor your bot's success with 
the Conversational Analytics dashboard.

When you add Now Assist  in Virtual Agent  skills, your developers have access to large language 
model (LLM) topic discovery. The Now Assist  topics skill includes LLM-enabled controls that 
make topic authoring easier so that you can deliver self-service solutions more quickly.
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Pre-built Virtual Agent  topics

Pre-built Virtual Agent  topics are available from the ServiceNow Store. These topics are designed 
to handle common issues that can occur and are customized for ServiceNow  workflows. 
Available plugins include the following:

• ITSM Virtual Agent conversations

• Customer Service Virtual Agent conversations

• HR Service Delivery Virtual Agent conversations

Virtual Agent  and Virtual Agent Lite

The Virtual Agent  platform is available as a professional subscription or in a limited version 
(Virtual Agent Lite) that is automatically included with the ServiceNow AI Platform®.
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Virtual Agent  Professional provides all the core functionality for creating and deploying Virtual 
Agent  conversations. Virtual Agent  includes the following features, which are automatically 
installed with the Glide Virtual Agent plugin (com.glide.cs.chatbot):

• Virtual Agent Designer  (supports Natural Language Understanding (NLU) in Virtual Agent 
conversations)

• Virtual Agent  web client

• Virtual Agent  notifications

• Conversational custom chat integration framework

• Conversational Interfaces  console for admin configuration

• Topic Recommendations  (ServiceNow Store  app)

• Conversational Analytics (ServiceNow Store  app)

Virtual Agent Lite  provides a limited (trial) version of Virtual Agent  for ITSM standard customers. 
For more information, see Virtual Agent Lite.

Virtual Agent  benefits

Benefit Feature Role

Use a conversation designer to build and test 
conversations without scripting or advanced skills. 
Drag and drop elements on the graphical canvas to see 
the entire flow. Go further with branching, looping, and 
scripting.

Virtual Agent 
Designer

virtual_agent_admin 
or admin

Use LLM topic discovery instead of Natural Language 
Understanding  (NLU) or keywords to create more 
conversational experiences. Now Assist  in Virtual Agent 
uses LLMs and generative AI skills to improve deflection 
rates and reduce the amount of time-consuming work that 
NLU topic discovery requires.

Now Assist 
in Virtual 
Agent

LLM topic 
discovery in 
Virtual Agent

virtual_agent_admin 
or admin

Create custom chat experiences for users from where they 
run Virtual Agent. Configuring 

Now Assist 
in Virtual 
Agent

Branding 
your chat 
client

Setting 
up chat 
experiences 
for Virtual 
Agent users

virtual_agent_admin 
or admin

Seamlessly transfer the entire conversation history and 
context to the right human agent so they can quickly 
address any escalations and resolve user issues.

Using Virtual 
Agent with a 
live agent

virtual_agent_admin 
or admin
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Benefit Feature Role

Connect to where your employees and customers already 
are—in web portals, Now®  Mobile  apps, and collaboration 
tools like Slack, Microsoft Teams, Facebook Messenger 
consumer app, Workplace from Facebook enterprise 
messaging app, and any other popular chat or messaging 
app.

Integrating 
Virtual Agent 
with other 
channels

virtual_agent_admin 
or admin

Analyze the performance of Virtual Agent  through 
preconfigured dashboards.

Analyzing 
Virtual Agent 
performance

virtual_agent_admin 
or admin

Deliver real-time alerts and status updates to employees, 
including actionable notifications and SMS notifications. 
Deliver notifications via all supported channels, including 
web, Slack, Workplace, and SMS. You can quickly collect 
feedback for critical decisions and resolve requests faster.

Configuring 
Virtual Agent 
notifications

virtual_agent_admin 
or admin

Serve your international Virtual Agent  users, regardless of 
their language and locale.

Localization 
options for 
Virtual Agent

virtual_agent_admin 
or admin

Integrate with other ServiceNow AI Platform  applications, 
such as AI Search. Use Flow Designer  to add automated 
workflows to conversation topics, and access many third-
party services using Integration Hub  spokes.

Improving 
the user 
experience 
with AI 
Search

Integrating 
Virtual Agent 
with Flow 
Designer 
workflows

Integration 
Hub

virtual_agent_admin 
or admin

The Virtual Agent  API enables developers, advanced 
users, and admins to use Virtual Agent  as a standalone 
or secondary bot in your chat environment. Use Virtual 
Agent  Bot Interconnect  as the primary bot in a diverse 
chat environment.

Using Virtual 
Agent API

Using Virtual 
Agent Bot 
Interconnect 
in your 
configuration

virtual_agent_admin 
or admin

Note: 
For developer training, go to the Developer's Portal  (login required). Navigate to Learn  > 
Courses  > Virtual Agent.

Virtual Agent  web client interface

The Virtual Agent  web client interface captures an automated messaging session between 
Virtual Agent  and the user. Users can see a list of all the topics that the bot can help with, enter a 
request, request a transfer to a live agent, send and receive attachments, and receive visual and/
or audio notifications.
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The web client interface uses the Service Portal web widget, which you can configure for custom 
service portals. This widget is available in the CSM, HR Service Delivery, and ITSM Service 
Portals.

Simple conversation example — web client

A simple conversation typically includes the following elements:

• Default welcome message from the virtual agent, followed by the first prompt for the 
conversation. The initial prompt asks the user to type a question or to choose from a list of 
available topics.

• User response to the first prompt. In this example, the user chooses the topic for checking an 
IT ticket.

• Series of prompts, acknowledgments, and responses exchanged between the virtual agent 
and the user until the users reach their goals or complete their tasks. You can use different rich 
controls in bot prompts, for example, choice lists with buttons or a carousel of images to select 
an item.

• Closing message to end the conversation.

When your users start a conversation with the bot, they can enter a request or see a list of 
everything that the bot can help with. If they choose to see everything, the chat window displays 
all topics available to the user. Your users can use the search box to filter the list of topics.
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See all topics

The conversational interface offers your users several options to manage the conversation. Users 
can stop the current conversation and start a new one, contact support to access a live agent for 
immediate assistance, and control audible alerts for chats.

Support options menu

When users transfer to a live agent, the chat window header changes to indicate that they 
are now interacting with a live agent. The attachment and send icons are available in the chat 
window for uploading an image, text, or PDF file and sending it to the agent.
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Live agent transfer

During live chat, users can attach a file of any type (for example an image, text, or PDF file) and 
send it to the agent. The system automatically performs a virus scan on the file attachment. If the 
scan is successful, the file is sent to the agent.

• If the scan fails, a message informs the user that the scan did not pass so that the user can 
correct the file and then upload the file again.

• If the upload and virus scan process times out (the upload takes too long), a message tells the 
user that the file couldn't be processed and to try the file upload again.

Note: 
Most chat clients support file attachment uploads. However, the mobile chat client only 
supports file attachment uploads in bot conversations. Users cannot upload files in mobile 
chat with a live agent.

Your users automatically receive audio and visual alerts when they receive a message from a live 
agent or virtual agent.

• The visual indicator displays the number of messages received, next to the chat icon in the 
Service Portal  window. When the user opens the chat, the indicator number closes.

New message alerts

• Your authenticated end users can enable or disable audible alerts of chats through the toggle 
switch on the chat menu (Contact Support).

• Authenticated end users can also enable or disable the delivery of notifications through the 
toggle switch on the chat menu (Contact Support).

• The default sound notification uses the sn_va_web_client_alert.mp3 audio file.
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◦ You can change the sound that requesters hear by uploading your own audio file. For details, 
see Manage audio files .

◦ To turn off the audio notification for your instance, use the system parameter 
sysparm_disable_audio_notifications=true. For example: 
https://<your-instance name>.service-now.com/nav_to.do?
sysparm_disable_audio_notifications=true

Quick start for Virtual Agent

Using the Conversational Interfaces  console, you can quickly add Virtual Agent  to a portal, 
configure branding, personalize the greeting, and begin to use pre-built ITSM Virtual Agent 
conversations.

If you have a license for a Now Assist  product, you can also quickly deploy Now Assist  skills in 
Virtual Agent  in a matter of minutes. For details, see Configuring Now Assist in Virtual Agent.

Before you begin

If you have a license for Virtual Agent, the following sections will help you get started and create 
conversations for your organization quickly.

If you do not have a license for Virtual Agent, you can try Virtual Agent Lite, which comes 
preinstalled. For information about getting started with Virtual Agent Lite, see Quick start for 
Virtual Agent Lite.

Use the Conversational Interfaces  console application to activate and configure Virtual Agent 
quickly. For more information about the Conversational Interfaces  console, see Conversational 
Interfaces Console.

Step 1: Activate Virtual Agent  and recommended store plugins

If Virtual Agent  has not been activated on your instance, you will need to install it.

Conversational Interfaces  console page when Virtual Agent  is not installed

1. Navigate to All  > Conversational Interfaces  > Home.

2. If Virtual Agent  is not installed, select Get Virtual Agent plugin  on the home page.

3. When prompted, select Start install.

The Applications page opens with Virtual Agent  (com.glide.cs.chatbot) selected.
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Install the Virtual Agent  plugin

a. If you have a Virtual Agent  license, select Install/Update All.

b. In the dialog box, select Install  to begin.

4. Under Choose what type of requests you want your bot to support, select Get ITSM plugin.

Install the ITSM Virtual Agent  Conversations plugin

5. Follow the directions in the ServiceNow Store  and select Opt-in  when prompted.

6. Repeat steps 3 and 4 to install additional plugins. Otherwise, continue to the next section.

Step 2: Make Virtual Agent  available to users

Add a chat entry to the menu of your web portal. You can add Virtual Agent  to additional portals 
later.

1. Navigate to All  > Conversational Interfaces  > Home.

2. Under Add your bot to a portal, select Add to portal.

Add your bot to a portal tile on the Conversational Interfaces  console page

3. Fill in the form for Service Portal Agent Chat Configuration.

Type a name and unlock the Portal(s)  field to specify one or more portals for your virtual agent. 
Type a number in the Order  field to specify where to include Virtual Agent  on the menu.
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a. In the Name  field, type a name for the configuration.

b. Select the Portal  lock icon to open it.

c. Select the search icon, and then select a portal.

d. In the Order  field, type a number to indicate the order that the configurations should run.

Only one configuration applies per portal. If there are multiple configurations on a portal, the 
system runs the first configuration found from lowest to highest.

4. Select Submit.

For more detailed information, see Add your bot to a portal.

Step 3: Customize the look and feel of Virtual Agent

You can change the way Virtual Agent  looks to the end user. You can change the colors, add your 
company logo, and change the icon that represents your bot.

1. Navigate to All  > Conversational Interfaces  > Home.

2. Under Edit your bot's look and feel, select Set up branding.

Edit your bot's look and feel tile on the Conversational Interfaces  console page

The Branding settings page opens.

3. Select New  or the name of an existing branding record.

4. On the form, fill in the fields.

5. Select Save.

6. Apply the branding configuration as described in Set up your Virtual Agent bot's branding.

Step 4: Get recommended topics

The Topic Recommendations  app lets you evaluate the common use cases that Virtual Agent  can 
help resolve or deflect. You can use Topic Recommendations  with Virtual Agent  topics that use 
either keyword or NLU topic discovery.

1. Navigate to All  > Conversational Interfaces  > Home.

2. Under Set up Topic Recommendations, select Get Recommendations.
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Set up topic recommendations

The Topic Recommendations  page opens.

3. Use the Quick start for Topic Recommendations  to configure and get topic recommendations 
based on your company's data.

Explore further

As you work with Virtual Agent, you can expand its capabilities by implementing other features. 
For example, you can do the following:

• Setting up chat experiences for Virtual Agent users

• Create new Virtual Agent  topics

• Change Virtual Agent and Agent Chat system messages

• Enable AI Search

• Implement Natural Language Understanding  (NLU)

• Use Virtual Agent  with a live agent

• Localize Virtual Agent  topics

Example Asset Refresh Virtual Agent  conversation with notifications

Virtual Agent  can automate many workflows, and a number of common solutions are available 
when you install Virtual Agent  and related plugins, such as ITSM Virtual Agent  Conversations.

Overview

For an overview of the Asset Refresh workflow from the user perspective, watch this video.

Automate workflows with Virtual Agent. In this example, a user is notified that it's time to get a 
new tablet. The Virtual Agent workflow helps him order a replacement.
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Pre-built components in Virtual Agent

Virtual Agent  comes with a basic configuration that includes common greetings, NLU intents, 
reusable logic, and pre-built conversations. Using these building blocks, you can quickly put 
together workflows to handle some of the most common organizational needs, including the 
following:

• Resetting a password

• IT Self-Service

• IT troubleshooting

• HR queries and employee profile updates

• Customer Service queries and requests

To help you understand the possibilities, the Asset Refresh example uses pre-built topic blocks 
that are included in the ITSM Virtual Agent Conversations  plugin. These topic blocks do most of 
the "heavy lifting" in the topic.

Asset Refresh workflow

The purpose of the Asset Refresh topic is to automate hardware upgrades for your employees. If 
your organization's policy is to replace computers or tablets every two years, then you can create 
a business rule that says when a user has had an asset for two years, the asset should move 
to the In maintenance  state. You can create a notification that is triggered by this change 
of state in the Hardware table. In our example, the asset owner receives the notification and is 
instructed to upgrade their asset.

The Asset Refresh Virtual Agent  topic provides the action for the notification. When the user 
selects the link in the notification, they proceed to the workflow in Virtual Agent. This example 
topic contains the primary flow (helping the user upgrade their hardware) and two secondary 
flows that ensure that the user's needs are met.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1649

https://www.webstg.servicenow.com/docs/access?context=itsm-password-management&version=washingtondc&pubname=washingtondc-it-service-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=itsm-password-management&version=washingtondc&pubname=washingtondc-it-service-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=itsm-password-management&version=washingtondc&pubname=washingtondc-it-service-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=itsm-va-self-service-topics&version=washingtondc&pubname=washingtondc-it-service-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=itsm-va-self-service-topics&version=washingtondc&pubname=washingtondc-it-service-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=itsm-va-self-service-topics&version=washingtondc&pubname=washingtondc-it-service-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=itsm-va-it-issues-generic&version=washingtondc&pubname=washingtondc-it-service-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=itsm-va-it-issues-generic&version=washingtondc&pubname=washingtondc-it-service-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=itsm-va-it-issues-generic&version=washingtondc&pubname=washingtondc-it-service-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=hr-virtual-agent-conversations&version=washingtondc&pubname=washingtondc-employee-service-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=hr-virtual-agent-conversations&version=washingtondc&pubname=washingtondc-employee-service-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=hr-virtual-agent-conversations&version=washingtondc&pubname=washingtondc-employee-service-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=csm-virtual-agent-chatbot&version=washingtondc&pubname=washingtondc-customer-service-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=csm-virtual-agent-chatbot&version=washingtondc&pubname=washingtondc-customer-service-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=csm-virtual-agent-chatbot&version=washingtondc&pubname=washingtondc-customer-service-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=itsm-virtual-agent&version=washingtondc&pubname=washingtondc-it-service-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=itsm-virtual-agent&version=washingtondc&pubname=washingtondc-it-service-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=itsm-virtual-agent&version=washingtondc&pubname=washingtondc-it-service-management&ft:locale=en-US


After a greeting message, Virtual Agent  asks the user if they want to upgrade now or get more 
information. If they choose to upgrade now, they are directed through the primary flow. Virtual 
Agent  uses the Lookup utility to find the expiring asset that is assigned to the user. Then Virtual 
Agent  makes sure the user still has the asset. If they do not, Virtual Agent  uses the Create 
Incident topic block to open an Incident to resolve the problem. If the user still has the asset, 
Virtual Agent  uses the Search Catalog Item topic block to find a replacement. The Request 
Catalog Item topic block is used to request it. The request is sent to the user, and the workflow 
ends.

If the user chooses to get more information, the AI Search topic block returns one or more 
specific KB articles that explain the organization's policy. Once the user has viewed these, they 
are given the option to upgrade now or later. If they choose to upgrade now, they are redirected 
through the primary workflow; otherwise, the conversation ends.

Creating the Asset Refresh example workflow

The following topics describe how to use Virtual Agent Designer  and actionable notifications to 
create the Asset Refresh workflow. Follow these steps in order.

1. Create the Asset Refresh topic in Virtual Agent Designer.

2. Create the Open Incident workflow in the Asset Refresh topic.

3. Create the More Information workflow in the Asset Refresh topic.

4. Create the notification for the Asset Refresh topic.

5. Associate content with the Asset Refresh notification.
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Create the Asset Refresh topic in Virtual Agent Designer

Create the topic in Virtual Agent Designer  using topic blocks that come with the ITSM Virtual 
Agent  Conversations plugin. When the user receives a notification that it's time to upgrade, they 
will be directed to this topic.

Before you begin
Install the following applications:

• Glide Virtual Agent  plugin (com.glide.cs.chatbot)

You must have a subscription for Virtual Agent  before you can activate the Glide Virtual Agent 
plugin.

• Enable Natural Language Understanding  (NLU), if not already enabled (recommended).

• ITSM Virtual Agent Conversations  (available in the ServiceNow®  Store)

If this application is already installed, check the ServiceNow Store  for an updated version 
before you begin.

Determine the application scope for your Virtual Agent  topic and actionable notification. They 
don't have to reside in the same application scope, but it can be easier to maintain if they do.

Publish the following ITSM Virtual Agent  components. If you're using an application scope other 
than ITSM Virtual Agent Conversations, you should duplicate and publish these topic blocks in 
the scope you intend to use. To do this, change your application scope, and then duplicate the 
topic blocks in Virtual Agent Designer.

• Create Incident topic block

• Request Catalog Item topic block

• AI Search topic block

• Search Catalog Item topic block

Role required: virtual_agent_admin or admin

About this task
For more information about building topics and the Virtual Agent Designer  interface, see the 
following topics:

• Getting started with Virtual Agent Designer

• Create a Virtual Agent topic

• Virtual Agent Designer controls

• Virtual Agent Designer interface reference

Tip: 
Look through existing conversations to ensure you are not duplicating effort, and familiarize 
yourself with Virtual Agent  and the flow of topics. Additionally, it may be helpful to outline 
the flow of a conversation before building it in Virtual Agent Designer.

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer.

2. On the Topics page, select Create.
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3. On the Create a topic form, set up your topic.

a. Enter a name, such as Asset Refresh.

b. If NLU is enabled, select an existing model, or create a new one.

c. Select or create an intent for the NLU model.

For descriptions of all field values, see Create a topic form.

d. Select Create.

The Flow  tab appears with Start and End nodes. For an overview of this screen and its 
components, see Topic Flow tab.

4. Create your initial message to greet the user.

a. From the Components area, drag a Text bot response node onto the canvas.

b. Select the node to view the properties palette.
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c. Enter a name for the node and the response you want to display to the user.

5. Ask the user if they want to proceed with the asset refresh.

a. From the Components area, drag a Static choice input node onto the canvas.

b. In the properties palette, enter the following information:

▪ A unique name, such as Continue or Defer.

▪ A text prompt, such as What would you like to do next? Learn more, or 
continue with the upgrade?

▪ In the Choices area, provide a text prompt for each choice and a value for that choice, so 
you can refer to it later on.

For example, your choices might be Learn more  and Continue with upgrade. 
The values should make sense as variable names. For example, info  and upgrade.
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6. Add a Decision utility to handle the user's choice.

a. From the Components area, drag a Decision utility onto the canvas.

b. Select the plus icon to add a second branch.

c. Name each branch to correspond with the decisions (info and upgrade).
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d. For each branch, select it and then use the Branch Condition area to indicate which option 
the branch will follow.

7. For the upgrade branch, add a Lookup utility node to confirm that the user still has the asset.
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a. From the Components area, drag a Lookup utility onto the canvas.

b. In the properties palette, specify the following information:

▪ A unique name, such as Asset Lookup.

▪ The table name: Asset [alm_asset]

▪ In the Condition builder, select Assigned to, and then dot-walk to Input Variables > User. 
Select and  to include State > is > In maintenance.

The asset state will tie into the notification you send the user for this asset refresh.

8. Ask the user if they still have the asset.

a. From the Components area, drag a Boolean input node onto the canvas.
The Boolean node automatically asks if you want to add a Decision utility with two paths. 
Select Yes. A Decision node appears in the flow with values of true  and false. Both are 
already mapped to the Boolean node.

b. Add a user prompt.
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Use dot-walking to refer to the asset found by the Asset Lookup node.

9. If the user still has the asset (the Boolean response is true), we want to search for it in the 
catalog.

a. From the Components area, drag the Topic Block utility onto the Asset Check true  branch on 
the canvas.

b. In the properties palette, select Search Catalog Item  for the Topic block.

c. Under Input mapping, use dot-walking to specify the query_term  parameter from the Asset 
Lookup node (Input Variables > Asset Lookup > Display name).

The catalog search will provide these output variables by default, shown under Output 
mapping.

10. Request the upgraded item.

a. From the Components area, drag the Topic Block utility onto the canvas beneath the Search 
Catalog Item topic block.

b. In the properties palette, select Request Catalog Item  for the Topic block.
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c. In the Input mapping area, use dot-walking to specify the catalog_item_id  that the 
previous topic block returned.

This topic block returns output variables as well. The user will be able to select variables for 
their new device, as well. You can configure these variables in Service Catalog.

11. Ask the user to confirm their choice of device.

a. From the Components area, drag the Card bot response node onto the canvas beneath the 
Request Catalog Item topic block.

b. In the properties palette, specify the following information:

▪ A unique name, such as Device Request Record.

▪ Card type: Record

▪ Populate this card by referencing: Table

▪ Table name: Requested Item [sc_req_item]

▪ In the Condition builder, add Sys ID is Input Variables>Record_id.

▪ In the fields  area, select the record columns to display in the card to the user.

For example, specify Number, Short description, and Estimated delivery.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1658



12. Drag this flow's arrow to the End node to complete this part of the workflow.

13. Select Save.

What to do next
Create the Open Incident workflow in the Asset Refresh topic

Related topics

Maximizing code reuse with topic blocks

Create the Open Incident workflow in the Asset Refresh topic

Each Decision branch introduces additional workflows. After creating our main Asset Refresh 
workflow, we need to ensure that the user can get help if something goes wrong. In this example, 
we will help the user create an incident.

Before you begin
Create the Asset Refresh topic in Virtual Agent Designer

Role required: virtual_agent_admin or admin

Procedure

1. Open the Asset Refresh topic in Virtual Agent Designer.

2. Return to the false  decision branch after the Asset Check Boolean question that you asked the 
user.
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a. From the Components area, drag a Text bot response node onto the false  branch on the 
canvas.

b. Select the node to view the properties palette.

c. Enter a name for the node and the response you want to display to the user.

For example, name the node Open Incident. For the Response message, type Since 
you no longer have the device, we need to open an incident.

3. Add a Topic Block utility to node to create the incident.

a. From the Components area, drag a Topic Block utility node onto the canvas.

b. In the properties palette, select Create Incident  for the Topic block.

c. Under Input mapping, use dot-walking to specify the caller  and short_description 
parameters.

▪ For the caller, specify Input Variables > User.

▪ For the short description, specify Input Variables > Asset Lookup > Asset tag.
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d. Under Output mapping, make sure to enable the created_incident_sys_id variable.

4. Drag this flow's arrow to the End node to complete this part of the workflow.

5. Select Save.

What to do next
Create the More Information workflow in the Asset Refresh topic

Create the More Information workflow in the Asset Refresh topic

In our example, we must provide the workflow for the "more information" Decision branch. If the 
user wants to learn more before upgrading, we can point them to a specific KB article explaining 
how your organization's policy works.

Before you begin

• Create the Asset Refresh topic in Virtual Agent Designer

• Create the Open Incident workflow in the Asset Refresh topic

Role required: virtual_agent_admin or admin

Procedure

1. Open the Asset Refresh topic in Virtual Agent Designer.

2. Return to the info  decision branch after the Continue or Defer static choice node where you 
first prompted the user to continue or get more information.

a. From the Components area, drag a Topic Block utility node onto the canvas.

b. In the properties palette, select AI Search  for the Topic block.

c. Under Input mapping, specify the search term.
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For example, enter hardware upgrade policy.

3. Show the results of the search to the user.

a. From the Components area, drag a Card bot response node onto the canvas.

b. In the properties palette, specify the following information:

▪ A unique name, such as Upgrade KB Articles.

▪ Card type: Record

▪ Populate this card by referencing: Table

▪ Table name: Knowledge Article [sn_km_mr_st_kb_knowledge]

▪ In the Condition builder, restrict the results to specific internal KB numbers that describe 
the policy, such as Number is KB000000456.

▪ In the fields  area, select Content  for a single KB article, or Short description  if multiple 
records are returned.

4. Once the user has read the KB article, give them the option to continue with the upgrade.

a. From the Components area, drag a Static choice input node onto the canvas.

b. In the properties palette, enter the following information:

▪ A unique name, such as Upgrade Next Steps.

▪ A text prompt, such as Would you like to upgrade now?
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▪ In the Choices area, provide a text prompt for each choice and a value for that choice, so 
you can refer to it later on.

For example, your choices might be Yes, upgrade now  and No, maybe later. 
The values should make sense as variable names. For example, yes  and no.

5. Add a Decision utility to handle the user's choice.

a. From the Components area, drag a Decision utility onto the canvas.

b. Select the plus icon to add a second branch.

c. Name each branch to correspond with the static choice node decisions (yes and no).

d. For each branch, select it and then use the Branch Condition area to indicate which option 
the branch will follow.

e. Drag the no  flow's arrow to the End node to complete this part of the workflow.
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f. Drag the yes  flow's arrow to the Asset Lookup node to bring the user to the upgrade 
workflow.

6. Select Save.

Result
Your topic is ready to test. Test the topic, making sure you go through each possible workflow in 
the conversation and make any needed adjustments.

For more information about testing topics, see Testing NLU/Keyword topics. If you're using NLU 
discovery, add utterances  to the intent and train and test your NLU model.

When you're finished, publish the topic.

What to do next
Create the notification for the Asset Refresh topic

Related topics

Improving the user experience with AI Search
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Create the notification for the Asset Refresh topic

Create an actionable notification to trigger the Asset Refresh Virtual Agent  example topic you just 
created. The user will automatically receive the notification when it's time for them to order a new 
hardware asset.

Before you begin
Publish the Asset Refresh topic. Change the application scope  in your instance to the same 
application you used to create your Asset Refresh topic. Ideally, the notification should be in the 
same application scope as your Virtual Agent  topic.

Role required: virtual_agent_admin or admin

About this task
The ServiceNow AI Platform  and ITSM Virtual Agent  Conversations come with pre-built 
actionable notifications, and you can also create your own. For more information, see 
Notifications .

Tip: 
On the Notifications page, you can view only the actionable notifications that come with 
ITSM Virtual Agent  Conversations by filtering the list on Application is ITSM Virtual Agent 
Conversations.

Procedure

1. Navigate to All  > System Notification  > Provider  > Notifications.

2. Select New.

3. In the Name  field, provide a unique name, such as Asset Refresh Notification.

4. On the When to send  tab, specify the trigger that will send the notification.

a. For the Trigger, specify Record Change.

b. For the Table, specify the Hardware [alm_hardware].

c. For the Conditions, specify State > is > In maintenance.
When assets in the hardware table are available for refresh, they're moved to the In 
maintenance  state on this example instance. You can specify filter conditions based on 
the business rules for your instance.

5. Select the Who will receive  tab to configure the recipient of the notification.
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a. Select the lock icon next to Recipients listed in fields.

b. In the Available  list, select Assigned to, and then select the right arrow icon to move it to the 
Selected  column.

6. Select Submit.

What to do next
Associate content with the Asset Refresh notification

Related topics

ITSM Virtual Agent pre-built actionable notifications

Associate content with the Asset Refresh notification

After creating the actionable notification for the Asset Refresh topic, go back into the notification 
and add content. This links the notification with the Virtual Agent  topic that you created.

Before you begin
Role required: virtual_agent_admin or admin

Procedure

1. Navigate to All  > System Notification  > Provider  > Notifications.

2. Select the Asset Refresh Notification to open the record.
New fields for content are available in the record.
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3. Select the Contents  tab and create the content for the notification.

a. Select New Provider Content.

b. When prompted for the type of notification content, select Virtual Agent Content - Chat.

c. On the form, fill in the fields.

Notification Content - Virtual Agent form

Field Description

Name Unique name for the content. For example, enter Asset Refresh 
Notification Content.

Notification By default, Asset Refresh Notification.

Format tab

Type Select Simple.

Table Specify Hardware [alm_hardware].

Message tab

Advanced Leave this option unselected.

Message 
heading

A suitable heading for the notification, such as Upgrade your device.

Message The contents of your message letting the user know that it's time for them to 
upgrade. You can customize the message using variables in the record for a 
more personal touch.

Channels tab

Delivery 
channels

Select mweb, which is the default channel for Virtual Agent.

You can configure other channels to run Virtual Agent  as well. For more 
information, see Integrating Virtual Agent with other channels.

d. Select Submit.
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4. On the Asset Refresh Notification record, select the Actions  tab and create the action.

a. Select New Provider Action.

b. When prompted for the type of notification action, select Virtual Agent.

c. On the form, fill in the fields.

Notification Action - Virtual Agent form

Field Description

Name Unique name for this action. For example, enter Asset Refresh 
Notification Action.

Notification By default, Asset Refresh Notification.

Active Ensure this option is selected.

Topic The name of the published Asset Refresh Virtual Agent  topic you created in 
previous steps.

d. Select Submit.

5. On the Asset Refresh Notification record, select the Link Actions to Content  tab to map the 
actions to the content.

a. Select New.

b. On the form, fill in the fields.

Actionable Content form

Field Description

Name Unique name for the actionable content. For example, enter Asset 
Refresh Actionable Content.

Notification By default, Asset Refresh Notification.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1668



Field Description

Actions Select the lock icon ( ), and then type in the search field or select the 

search icon ( ) to locate the action you created on the Actions  tab in the 
previous step.

Content The name of the Asset Refresh provider content record you created on the 
Contents  tab in a previous step.

Disable 
skip

Leave this option unselected.

Active Leave this option selected.

c. Select Submit.

LLM topic discovery in Virtual Agent

Large language models (LLMs) enable Virtual Agent  to process user statements in plain 
language. Conversations that use LLMs can outperform those conversations that use Natural 
Language Understanding  (NLU), with easier setup.

How LLMs work in Virtual Agent

When you create a topic in Virtual Agent Designer, you can select LLM as the model type for your 
topic whenever Now Assist  in Virtual Agent  is turned on. Virtual Agent  then uses LLM generative 
AI to discover topics that match the user's intent.

Unlike NLU  topics, LLMs don't require models, intents, or keywords to be linked to the topic. 
LLMs can discover topics and perform language-related tasks, such as text generation for case 
summaries and resolution notes, without months of training on NLU  models. Overall, you can 
create, configure, and deploy LLM topics faster than working with NLU.

With LLMs, Virtual Agent  can do the following:

• Perform topic discovery without needing a singular declared intent in a given topic.

• Find intents without backup keywords as in NLU  modeling.

• Extract entity values without prior mapping as in NLU  modeling.

• Handle multiple conversation topic switches in a single conversation session.

Topic discovery

With LLM topic discovery, topic authors no longer need to create and maintain complex NLU 
models and intents with backup keywords. The LLM does all of the heavy lifting for you. The only 
requirement is a robust, plain language topic description on the Properties  tab in Virtual Agent 
Designer. The LLM uses this description to find the best topic match for the user utterance. If 
there are multiple potential matches, the user will see a list of topics to choose from.
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For example, if a user asks Virtual Agent  to calculate a ride share fee, the LLM matches the user 
utterance with an existing topic that can calculate the ride share with a tip.

Entity extraction

With LLM topics, the LLM has all the information needed to determine if an utterance has the 
information to fulfill a request. Unlike NLU  models, you don't need to associate entities with a user 
input node or add nodeless NLU entities as input variables to a topic. The LLM simply finds the 
entity that most closely fits the user intent.

Topic switching

Topic switching is faster and easier with LLMs compared to NLU  topics. The LLM processes your 
requests to change intent made in natural language, and activates the appropriate topic.

For example, if you start a conversation by asking for a mobile phone, you don't have to cancel 
the order first or restart the conversation. Instead, you can ask Virtual Agent  to order a laptop 
instead. Virtual Agent  immediately switches from the mobile phone topic to the laptop topic. 
Topic switching can be done during a query, but not within a catalog ordering flow.

Additional resources

• Now Assist in Virtual Agent

• LLM assistants

Natural Language Understanding (NLU) topic discovery in Virtual Agent

Apply Natural Language Understanding (NLU) models that enable Virtual Agent  to process user 
statements in automated conversations. An NLU model provides information that your virtual 
agent uses to determine what users want to do and to extract relevant values from their input. 
With NLU, Virtual Agent  can offer a more natural and engaging conversational experience.

NLU components

ServiceNow  NLU can learn the syntax, semantics, and vocabulary of your company using the 
data in your ServiceNow  instance. Use NLU Workbench, the NLU model builder, and the NLU 
inference service to enable the system to learn and respond to user intent.

The following elements work together to identify what the user wants to do so that a solution can 
be found:

Model groups

A model group supports a given application, user roles, and languages. For 
example, you may have a model that supports the Search feature and another 
model that supports Virtual Agent. Typically, a model group contains multiple 
intents.

For more information, see Model management .

Intents

Intents represent actions. They describe what the user wants to do or what your 
application can handle. Intents can pertain to any of the following:

• Functions, such as resetting a password or ordering an item.

• Domains, such as healthcare, financial, or government.

• Customers, such as the US Army, Wells Fargo, or Boeing.
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In Virtual Agent, a single intent is mapped to one conversation topic.

For more information, see NLU intents .

Utterances

Instead of keywords, you enter natural language examples, called utterances. 
Utterances help NLU to evaluate word meanings and contexts so it can infer user or 
system actions. Example utterances might include the following:

• Reset my password.

• Change password.

• I don't remember my password.

• Forgot my password.

• My password needs to be reset.

Entities

Entities represent the object of (or context for) the action. You can define them for 
individual intents. NLU can match defined entities with user input to slot-fill the 
values. Slot-filling can eliminate the need to ask some questions within a topic flow. 
There are three basic types of entities that you can define:

• Common or system entities, such as date, time, currency, location, quantity, 
people, or organization.

• Entities based on ServiceNow  records, such as a case number.

• Company- or domain-specific entities, such as meeting rooms, company policies, 
and so forth.

For more information, see NLU entities .

Example intent definition in an NLU model group
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How NLU models work in Virtual Agent

When you create or update topics in Virtual Agent Designer, you specify the NLU model and 
intent that Virtual Agent  uses to find the appropriate conversation topic for fulfilling the intent.

Virtual Agent  supports models from different services. You can use the following providers:

• ServiceNow  NLU models that you create using NLU Workbench.

ServiceNow  provides pre-built (read-only) NLU models and topics for various ServiceNow 
business applications, such as Customer Service Management, HR Service Delivery, and 
ITSM. You can use the intents defined in these pre-built models and reuse them when you 
create your own models.

• If you're using IBM Watson Assistant as your NLU service provider, NLU intents and entities are 
created in IBM Watson Assistant.

• If you're using Microsoft LUIS as your NLU service provider, NLU intents and entities are 
defined in the Microsoft Language Understanding Intelligent Service (LUIS).

• If you're using Google Dialogflow  ES as your NLU service provider, NLU intents and entities are 
defined in the Google Cloud  platform.

Note: 
Virtual Agent  supports only one NLU service provider per instance.

With NLU models, your virtual agent can do the following:

• Perform topic discovery.

• Designate backup keywords in case an intent is not matched.

• Extract entity values.

• Handle conversation switching in a conversation session.

These capabilities are explained in the following sections.

Topic discovery

When users provide an utterance, the utterance is a statement that is associated with a specific 
intent. Virtual Agent  processes these utterances to launch the appropriate conversation topic. 
Each topic has a single intent that you specify in Virtual Agent Designer.

During the topic discovery process, intents are matched to topics. Virtual Agent  returns the most 
relevant topics for a user's request. The topic discovery process returns the following results to a 
user:
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• Single match: When a user utterance directly matches an intent (topic), the topic runs 
automatically.

A user request matches an utterance in an intent

• Multiple matches: When a user utterance matches more than one intent, Virtual Agent  returns 
a choice list of the relevant matches so that the user can choose the appropriate topic.

A user request matches utterances in multiple intents

Note: 
If there are multiple matches, Virtual Agent  returns three intents by 
default. You can change the number of topics returned by using the 
com.glide.cs.max_number_display_topics  system property.
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• No matches: When Virtual Agent  can't find a matching intent, it uses AI Search  to generate 
search results that display relevant links to Q&A knowledge articles, Service Catalog items, or 
person (user) records.

This feature is controlled by the AI Search  Fallback setup topic and the Virtual Agent  search 
configurations, which are enabled by default in chat experiences. To learn more about the AI 
Search  results generated, see Virtual Agent integration with AI Search.

If you disable the AI Search  Fallback setup topic, Virtual Agent  automatically displays a fallback 
error message that enables the user to select a topic or enter a different request.

Example fallback message

For details about how the AI Search  Fallback setup topic and the fallback response (the 
fallback setup topic) work, see Setting up chat experiences for Virtual Agent users.

For detailed information about NLU topic discovery, see Natural Language Understanding topic 
discovery logic in Virtual Agent.

Topic discovery with backup keywords

When you create or update topics, you can also optionally specify keywords that Virtual Agent 
uses to determine the topic if NLU doesn't return a matching intent and topic. Virtual Agent  uses 
keywords in the following situations:

• No topics (intents) are discovered.

• The appropriate topic (intent) can't be determined because too many topics (intents) are 
discovered.

• The language of the topic and intent is not currently supported in NLU.

Note: 
If Virtual Agent  can't determine the topic based on NLU or the keyword, it falls back on the 
AI Search  capability to deliver relevant results. The AI Search  capability must be enabled.

Entity extraction

With NLU models, Virtual Agent  can determine when user statements in a conversation contain 
important information to fulfill a task or goal. Entities identify the information that Virtual 
Agent  can extract from the conversation, such as an object or a person's name. To extract the 
appropriate values, Virtual Agent  uses the entity information that is associated with an intent that 
is defined in the NLU model.

When designing your topic, you can use entities as follows:
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• Associate an entity with a user input node  on the Flow  tab. You can specify whether Virtual 
Agent  asks the user to confirm the slot-filled entity value or to skip the node.

• Add nodeless NLU entities as input variables to a topic. These variables can be slot-filled from 
NLU service provider predictions or provided outside of the scope of the topic.

Conversation switching

Users engaged in a Virtual Agent  conversation can switch topics anytime during the 
conversation. For example, a user might be updating an item in the user's employee profile. But 
before completing the update, that user might ask to order an item instead. Virtual Agent  can find 
and run the appropriate topic based on the user's request. You can enable users who switched 
topics to resume the original conversation.

Another example is when a user might ask a casual question or engage in small talk. The 
question might be unrelated to the original request. By reviewing the intents defined in the NLU 
model, Virtual Agent  can match and launch the appropriate conversation for the switched topic.

ServiceNow  NLU  multi-language support and integration with Virtual Agent 
Designer

If you're using ServiceNow  NLU, you can map an NLU model group and an associated intent 
to a topic. You can also update, train, and test the associated NLU model from within Virtual 
Agent Designer. As you work on a topic, you can also improve or modify the utterances and the 
associated entities for an intent without leaving the interface.

ServiceNow  NLU  model groups contain a primary language and secondary languages. Use 
the primary language to author your topic, which can then be translated into the secondary 
languages within the group. For more information, see Multilingual model management .

As you work on your topics, Virtual Agent Designer  provides language-mapping views for 
previewing and testing topics with their associated language-specific models. For more 
information, see Localizing Virtual Agent conversations.

Advantages of natural language models over keywords

Natural language models help Virtual Agent  to process human language based on context and 
your company's data. In this way, what the user needs can be more accurately matched with a 
corresponding topic. Virtual Agent  supports large language models (LLMs) and Natural Language 
Understanding  (NLU).

Language is difficult

Keyword matching has its limitations. For example, sometimes an apple is a piece of fruit, and 
sometimes it's an electronic device. Context matters, and so does intent. Natural language 
models are designed to deal with the following problems:

• There are multiple ways to describe the same thing.

Examples: Office password reset  or Reset my password for Office

• Expressions can be ambiguous.

Example: Server reporting mail missing after migration. What is missing, 
the server or the mail?

• Contextual information is essential.

Example: activate London instance in staging
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• Words can acquire new meanings over time.

For example, a cell  can pertain to biology or a cell phone.

• Slang, acronyms, and industry idioms can be difficult to interpret.

Example: set up SSO on the dev instance

• Error messages are often hard to understand.

Virtual Agent  provides two kinds of natural language topic discovery. You can use both in your 
instance, but only one at a time in any given chat.

LLM topic discovery in Virtual Agent

Use LLMs to discover topics and access generative AI capabilities without building 
complex models, intents, or entities.

Natural Language Understanding (NLU) topic discovery in Virtual Agent

Use ServiceNow  NLU or a supported provider to discover topics.

Dialog Acts for Virtual Agent

As part of the Vancouver  release, the Dialog Acts feature expands natural language 
communication with Virtual Agent, leading to more fluid conversations between user and agent.

How Dialog Acts works

Dialog Acts interprets and applies user inputs during a Virtual Agent  conversation. With this 
feature active, you engage with Virtual Agent  in your own natural language, instead of selecting 
replies based on prompts in the topic.

For example, if you request a laptop in a Virtual Agent  conversation, you use the topic prompts 
to select a manufacturer, screen size, and amount of RAM. Without Dialog Acts, you change 
specifications only by following the prompts in the topic, potentially taking more time to loop 
through a Virtual Agent  conversation as you reset your options. With Dialog Acts, if you change 
your mind about any of the laptop's specifications before finishing the request, you can input an 
utterance such as, "Actually, I need 8 GB of RAM." If your input matches the Natural Language 
Understanding  (NLU) model closely enough, the specifications are changed immediately, even if 
you're on a different point in the topic. If the input doesn't match, it's added to a list of ignorable 
utterances.

User utterances are stored in the Open NLU Predict State Tracking 
[open_nlu_predict_state_tracking] table, while feedback is tracked by the Open NLU Predict 
Dialog Act Feedback [open_nlu_predict_dialog_act_feedback] table. Languages are tracked 
in the Open NLU Driver Languages [open_nlu_driver_language] table. In the current release, 
English is the sole language support for Dialog Acts.

Activating Dialog Acts

Activate Dialog Acts by toggling the Enable Dialog Acts  switch in the Create a topic form  or 
the Topic Properties tab. When activated, a second Confirm modified values  toggle appears. 
Use this switch to provide a prompt confirming that a variable is to be changed based on your 
utterances.

Considerations for implementing Dialog Acts

The Dialog Acts feature is available as long as NLU  is active for the instance and the topic. 
However, at least one of the preconfigured responses must be Active for the Dialog Acts toggles 
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in the Topic Properties tab  to be available. Dialog Acts can work without a model intent, but it 
can't select an entity if the topic is not associated with that model or intent.

Decision nodes can be modified by a condition or script to skip reprompting by Dialog Acts. 
However, the Modify Dialog Acts  toggle doesn't work if there are multiple date-time nodes on a 
topic.

Available Dialog Acts responses

The current release includes the following types of responses, stored in the Open NLU Dialog 
Acts [open_nlu_dialog_act] table:

Dialog Acts response types

Type Description

Modify Alter a variable recorded previously.

Affirm Confirm a variable.

Negate Decline confirming a variable.

Implement NLU in Virtual Agent

Create and maintain NLU  model groups and intents that map to your conversation topics in 
Virtual Agent. You can create and edit model groups in NLU Workbench  or from topics in Virtual 
Agent Designer.

Before you begin
Activate the plugins for Glide Virtual Agent  and any pre-built topics  that you want to use.

Role required: virtual_agent_admin or admin

About this task
When authoring conversations for an NLU instance, be aware of the following guidelines:

• Verify that you are in the appropriate application scope before you create or update a 
topic. For example, if you are creating ITSM topics, verify that you are in the ITSM Virtual 
Agent Conversations  scope, and not the scope for the ITSM NLU Model for Virtual Agent 
Conversations.

• Specify the NLU Model  and Associated Intent  for the topic in the Topic Properties tab. If you 
want to allow topic switching in the conversation session, enable Resume topic flow.

Note: 
A topic can map to only one intent in an NLU model. Once you select an intent for a topic, 
the intent is no longer available for use in other topics.

• Set the NLU entity properties in the property sheet for each input control  that you add to the 
conversation flow. The entity properties identify the entity associated with the node, a switch 
for allowing text input for the control (prompt), and another switch for confirming the slot-filled 
entity value that Virtual Agent  extracts.

Procedure

1. View the Virtual Agent General Settings, and change your NLU service provider, if needed.

If you're using a different NLU service provider supported by Virtual Agent, configure it as 
described in one of the following topics:
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◦ IBM Watson Assistant Intent and Entity integration

◦ Microsoft LUIS Intent and Entity integration

◦ Google DialogFlow Essentials (ES) Intent and Entity integration

2. Optional:  If you're supporting conversations in other languages, enable NLU languages in 
Virtual Agent settings.

3. Associate a model group and intent with each Virtual Agent  topic in your instance.
You can do this in the following ways:

◦ Add NLU to an existing Virtual Agent keyword topic.

◦ Create or map model groups and intents when you create a new topic.

◦ Preview  and test the pre-built ServiceNow  topics in Virtual Agent Designer.

Determine whether you want to use any of the topics, then duplicate  them as needed.

◦ Run Topic Recommendations reports for your instance  to identify pre-built Virtual Agent 
topics and intents that you can quickly implement in your organization.

4. Test the topic.

5. When you're ready to deploy a topic, publish the topic.

Result
The topic state changes to Active.

Virtual Agent Lite

Virtual Agent Lite  is a limited version of Virtual Agent  that is available to ITSM  standard 
customers.

About Virtual Agent Lite

Use Virtual Agent Lite, to implement a virtual agent that provides IT service assistance using 
several pre-built ITSM  conversations. As with Virtual Agent, you can set up and configure the 
chat clients for your end users. Use Virtual Agent Designer  to review, duplicate, and publish the 
pre-built conversation topics for your end users.

Virtual Agent Lite  is preinstalled in your instance. To use it, you must install ITSM Virtual Agent 
Conversation Topics Lite, which provides several pre-built conversations for common IT support 
requests. These keyword-based conversations run in the web chat client and also in Virtual 
Agent  messaging integrations for the following channels:

• Slack

• Microsoft Teams

• Workplace by Facebook

• Facebook Messenger

Virtual Agent Lite  features

For Washington DC, the Virtual Agent Designer  features available in Virtual Agent Lite  include the 
following:

• Localization Framework  integration.

The Localization Framework  is used in multi-language topic authoring and translations. The 
Localization Framework  is installed automatically with Virtual Agent. Activate the ServiceNow® 

plugin for each language you want to support. For more information, see Activate a language .
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In Virtual Agent Lite, information in the Languages  tab is read-only.

• Control topic discovery and visibility.

The Active  option of the header includes two options (toggle switches). Admins and topic 
authors can use these options to do one or both of the following:

◦ Enable Virtual Agent  to discover topics for use in chats.

◦ Include a topic in the All Topics  menu. This menu lists all of the topics that are available for 
use.

For more information about using these options, see Control topic discovery and visibility.

After using Virtual Agent Lite, you can upgrade to Virtual Agent  to access all of the features. 
Contact your ServiceNow  account representative for upgrade information.

Virtual Agent Lite  limitations

Virtual Agent Lite  has the following limitations:

• Virtual Agent Designer  limitations: Virtual Agent Lite  only supports conversation topics in the 
ITSM  self-service category (including related topic blocks) and the platform setup topics. This 
means you can't do the following:

◦ Create new topics, topic blocks, or custom controls.

◦ Specify the conditions that control how or when the topics are used.

◦ Specify the Live Agent (chat) variables that provide context for conversations.

◦ Enable the Available for Agent Autopilot  toggle switch.

Note: 
A lock icon displays next to the Virtual Agent Designer  fields that are not available in 
Virtual Agent Lite.

• Keyword-based conversations: Virtual Agent Lite  only supports keyword-based conversations. 
Natural Language Understanding  (NLU) models and NLU-enabled topics aren't supported. This 
means that related NLU  features, such as topic switching and multi-language NLU  models, are 
also not supported. Language support is available for conversations through ServiceNow AI 
Platform  language internationalization .

• Virtual Agent  tables: Virtual Agent  tables are read only for admins and Virtual Agent  admins.

• Localized content: Translated content is read-only. You can't add new translations or localize 
content. The Languages  tab displays a banner asking users to contact their Account Executive 
for more information about upgrading to the latest release.

• Custom channels: You can't run Virtual Agent Lite  topics in any custom chat channels (created 
through custom chat integrations), except for the supported Virtual Agent  integrations for 
Slack, Microsoft Teams, Workplace by Facebook, and Facebook Messenger  applications.

• Virtual Agent  notifications: You can receive only simple and non-actionable notifications. 
Actionable notifications are not supported with Virtual Agent Lite.

• Virtual Agent  Analytics Dashboard: This feature is not available in Virtual Agent Lite.

What to do

Set up and configure Virtual Agent Lite. For details, see Quick start for Virtual Agent Lite.
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Quick start for Virtual Agent Lite

Virtual Agent Lite  comes pre-installed, so all you have to do to try it is activate the ITSM Virtual 
Agent  Conversation Topics Lite plugin and set it up.

Before you begin
If you plan to integrate Virtual Agent Lite  with Slack, Microsoft Teams, Workplace, or Facebook 
Messenger  apps, you must be an administrator for those messaging apps.

Role required: virtual_agent_admin or admin

Procedure

1. Activate the ITSM Virtual Agent  Conversation Topics Lite plugin:

a. Navigate to All  > Plugins.

b. In the Search field, type ITSM Virtual Agent.

c. Find the entry for ITSM Virtual Agent  Conversation Topics Lite (com.snc.itsm.virtualagent.lite), 
and then click Activate.

2. Optional:  Configure Virtual Agent Lite  for additional portals.
Virtual Agent Lite  appears in the Service portal by default. For more information about 
configuring the Service portal, see Service Portal events .

3. Preview and test ITSM Virtual Agent  Lite topics in Virtual Agent Designer.
Two topics are available for use with Virtual Agent Lite.

4. Duplicate and publish ITSM Virtual Agent  Lite topics.
Users can now access Virtual Agent Lite  topics.

Preview and test ITSM  Virtual Agent Lite  topics

Run a pre-built IT Service Management  (ITSM) Virtual Agent Lite  topic to decide whether you 
want to deploy it to your end users. ITSM

Before you begin
Activate the plugin for ITSM Virtual Agent Conversation Topics Lite
(com.snc.itsm.virtualagent.lite).

Role required: virtual_agent_admin or admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer.

2. In the Category  filter, select ITSM Self Service Lite  to show only the ITSM  Virtual Agent Lite 
conversations.
Two pre-built topics are available: Check IT Ticket Status and Report IT Issue.

3. Select the topic that you want to preview.
In the Flow  tab, the Virtual Agent Designer  canvas opens with a read-only view of the topic 
flow. You can resize the canvas to see the nodes in the flow, but you can't add or change 
controls and their related property sheets.
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4. Select Test  to run the conversation in a test chat window.
For example, if you're testing the Check Ticket Status topic, the test chat window runs the 
conversation and lets you respond to the prompts displayed. You can also view the test logs to 
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see the messages logged and conversation tasks performed during the conversation, as well 
as the variables used in the conversation.

What to do next
If you'd like to deploy a topic, duplicate and publish the topic  so that it's available to your users.

Duplicate and publish Virtual Agent Lite  topics

Copy and publish a pre-built ITSM Virtual Agent  Lite topic to deploy it to your users.

Before you begin
Preview (test) the pre-built ITSM Virtual Agent Lite topics.

Role required: virtual_agent_admin or admin

Procedure

1. In the topic that you've tested, select Duplicate  in the triple-dot icon on the Virtual Agent 
Designer  header bar.

a. In the pop-up window, enter the name of your duplicated topic.

b. Select Save.
The Topic Properties  page (Properties  tab) for your duplicated topic opens.
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Note: 
You can duplicate a pre-built topic but you can't duplicate a copy of a pre-built topic.

2. Change these property fields as needed:

Property Description

Description A brief explanation of the topic.

Keywords A word or phrase that is associated with and activates 
the topic. You can add, change, or delete keywords.

Roles Roles that an end user must have to view and run the 
topic. If a topic is public (available to users, including 
guest users, who are not authenticated in ServiceNow), 
select only the Public role.

3. Select Save, and then select the triple-dot icon followed by Publish, to make the topic active 
and available in your chat clients.

Result
When your users run Virtual Agent, the chat client displays the published topics in the topic 
selection menu. If there are three or fewer topics available to the user, the menu items (topics) 
are displayed as buttons.

For example, in the Microsoft Teams  integration, the topic selection menu displays these three 
topics as buttons.

Topic choices in the Microsoft Teams  channel

Configuring Virtual Agent

Configure the Virtual Agent  features, components, and integrations that you need to provide 
support to your employees, IT teams, and customers.

Use the Conversational Interfaces Console  to activate and configure Virtual Agent. Some of the 
general settings in the console are shared with other applications, such as Agent Chat.

General chat settings

I want to... See these topics

Chat Client Display Options

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1683



General chat settings  (continued)

I want to... See these topics

Brand my bot Branding your chat client

Preview new or unread messages in a 
minimized chat window

Enable message preview on the web client

Conversation Routing

Configure my bot to run in third-party 
messaging apps

Virtual Agent integration with messaging apps.

Create pre-chat surveys Define pre-chat survey configurations

Create and use context variables to 
store chat-related information

Configure context variables for storing chat-related 
information

Display or announce callback options 
to users through other ServiceNow 
apps

Omnichannel Callback

Configure topic context intents Define topic context intent configurations

System Actions

Modify system chat messages Change Virtual Agent and Agent Chat system 
messages

Specify how links open from the chat 
window

URL navigation in Conversational Interfaces

Configure my bot to detect sensitive 
data

Configuring Sensitive Data Handler

Send email summaries of unread 
messages to users when they are 
inactive

Sending missed chat activity emails

Virtual Agent  settings

I want to... See these topics

Get recommendations for Virtual Agent 
topics based on my data

Quick start for Topic Recommendations

Configure performance tracking for 
Virtual Agent  topics

Create deflection configurations and patterns

Use Natural Language Understanding 
(NLU) for topic discovery Configure Natural Language Understanding in 

Virtual Agent

Creating models  (using NLU Workbench)

Create custom greetings and setup 
topics

Configure a Virtual Agent chat experience

Determine which issues are routed to 
Virtual Agent  first

Configure and run an Issue Auto Resolution 
simulation

Send notifications to users in Virtual 
Agent Configuring Virtual Agent notifications
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Virtual Agent  settings  (continued)

I want to... See these topics

Enable Virtual Agent notifications

Use AI Search to return fallback results 
for Virtual Agent

Improving the user experience with AI Search

Detect and dynamically translate Virtual 
Agent  topics into a different language

Using language detection and dynamic machine 
translation in Virtual Agent

Virtual Agent  security

Platform hardening for your instance is leveraged by Virtual Agent, so you should follow the 
overall platform hardening recommendations. For details, see Secure your instance .

For security details about Virtual Agent, refer to the following topics:

• Virtual agent embedded client content security policy (instance security hardening)

• Virtual agent embedded client X-Frame-Options (instance security hardening)

Activate Virtual Agent

You can activate the Glide Virtual Agent plugin (com.glide.cs.chatbot) if you have the admin role. 
This plugin automatically activates other necessary plugins if they are not already active.

Before you begin
Role required: admin

About this task
You must have a subscription for Virtual Agent  before you can activate the Glide Virtual Agent 
plugin.

Plugins automatically installed with Glide Virtual Agent

Plugin Description

Conversational Analytics

[com.sn.conversational.analytics]

Enables the ServiceNow  Conversational 
Analytics app.

Note: 
Subsequent updates for the 
Conversational Analytics app must 
be installed from the ServiceNow 
Store.

Integration - Multiple Provider Single Sign-On 
Installer

[com.snc.integration.sso.multi.installer]

Enables authentication for multiple 
identity providers (IDPs) using SAML or 
OpenID connect(OIDC).

Localization Framework  Installer

[com.glide.localization_framework.installer]

Provides the framework for localization of 
Virtual Agent  conversations.

NLU Model for Virtual Agent  Setup Topics Installs the NLU model for Virtual Agent 
Setup topics.
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Plugins automatically installed with Glide Virtual Agent  (continued)

Plugin Description

[com.glide.cs.nlu.topics]

Proxy Agent to the ServiceNow  Natural Language 
Understanding Server

[com.glide.nlu.intent.discovery]

Activates the connection to the 
ServiceNow  NLU server for NLU intent 
discovery. Used by Virtual Agent  and 
other clients. Activates:

• NLU Workbench - Core [com.glide.nlu]

• Predictive Intelligence 
[com.glide.platform_ml]

• Proxy agent for connecting to NLU 
providers [com.glide.nlu.proxy] - Proxy 
agent for connecting to NLU providers

Proxy Agent to the IBM Watson Natural Language 
Understanding server

[com.glide.nlu.ibmwatson.intent.discovery]

Activates the IBM Watson Assistant  Intent 
and Entity integration, which enables 
Virtual Agent  to use intents, entities, 
and utterances defined in IBM Watson 
Assistant.

Proxy Agent to the Microsoft LUIS Natural 
Language Understanding server

[com.glide.nlu.msluis.intent.discovery]

Activates the Microsoft LUIS integration, 
which enables Virtual Agent  to use 
intents, entities, and utterances defined 
in the Microsoft Language Understanding 
Intelligent Service (LUIS).

Proxy Agent to the Google Dialogflow  ES Natural 
Language Understanding server

[com.glide.nlu.googledialogflow.es.intent.discovery]

Activates the Google Dialogflow  ES 
integration, which enables Virtual Agent 
to use intents, entities, and utterances 
defined in Google Dialogflow  ES.

Topic Recommendations

[com.snc.va_topic_recommender]

Enables the ServiceNow  Topic 
Recommendations  app.

Note: 
Subsequent updates for the Topic 
Recommendations  app must be 
installed from the ServiceNow Store.

Virtual Agent integration with actionable 
notifications

com.glide.cs.actionable.notification

Enables ServiceNow  actionable 
notifications on Virtual Agent  channels.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the Glide Virtual Agent plugin (com.glide.cs.chatbot) using the filter criteria and search 
bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel. For more information, see Request a plugin .
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3. Select Install, and then in the Activate Plugin dialog box, select Activate.

Note: 
When domain separation and delegated admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

What to do next
Activate additional Virtual Agent plugins  for related features, such as the plugins for predefined 
Virtual Agent  topics.

Installed with Virtual Agent

Various types of components are installed with activation of the Glide Virtual Agent 
[com.glide.cs.chatbot] plugin, including tables and user roles.

Note: 
The Application Files table lists the components that are installed with this application. 
For instructions on how to access this table, see Find components installed with an 
application .

Roles installed
With the Virtual Agent Administrator [virtual_agent_admin] role, users can create and manage 
topics (bot conversations), using Virtual Agent Designer.

• If using Natural Language Understanding, the NLU  admin role is included.

• If the Virtual Agent admin is granted access to AI Search-related tables, the search application 
administrator role [search_application_admin] is included.

• If the Virtual Agent admin is granted access to Entity View Action Mapper tables, the EVAM 
admin role [evam_admin] is included.

• For multilanguage support, the localization_requestor role is included by default. For more 
information, see Localization Framework roles  .

• For more information on the roles contained in virtual_agent_admin, see Virtual Agent roles.

Users installed

The Glide Conversation Server plugin (com.glide.cs) automatically installs a virtual agent user 
(virtual.agent) in the User [sys_user] table. Ongoing Virtual Agent  interactions  are assigned to this 
virtual agent user. If you're using Advanced Work Assignment  (AWA), interactions assigned to the 
virtual agent user are not routed by AWA. The virtual agent user is also used in the default web 
chat branding settings to associate a virtual agent user profile with a bot avatar.

Tables installed

Table Description

Adapter Configurations

[sys_cs_adapter_configuration]

Stores records for default keywords, labels, 
and message values for third-party messaging 
integrations.

Adapter Configuration Page

[sys_cs_adapter_configuration_page]

Stores the configuration for third-party 
messaging integrations. This table is the root 
table for:
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Table Description

• Configurations - Slack Integration 
[sys_cs_adapter_configuration_page_slack]

• Configurations - Teams Integration 
[sys_cs_adapter_configuration_page_teams]

• Configurations - Workplace Integration 
[sys_cs_adapter_configuration_page_workplace]

• Configurations - Facebook 
Messenger Integration 
[sys_cs_adapter_configuration_page_messenger]

Adapter Message

[sys_cs_adapter_message]

Stores adapter messages.

Brandings

[sys_cs_branding_setup]

Stores different branding configurations for the 
web-based chat client used in an instance.

Client Adapter

[sys_cs_client_adapter]

Stores each adapter state.

Consumer Channel

[sys_cs_consumer_channel]

Stores consumer channel information.

Consumer Device Context

[sys_cs_consumer_device_context]

Stores consumer device context information.

Context Topics

[sys_cs_context_topic]

Stores different configurations for determining 
the appropriate conversation topic displayed 
to end users based on their pre-chat survey 
answers.

Conversation

[sys_cs_conversation]

Stores a record for each conversation on 
the instance. Each record includes the 
Conversation Task [sys_cs_conversation_task] 
and Conversation Message [sys_cs_message] 
related lists, which show all the topics run 
and associated messages presented in the 
conversation.

Conversation Consumer

[sys_cs_consumer]

Stores a record representing the user in a 
conversation, and references the associated 
sys_user record for that user.

Conversation Server Field Script Validators

[sys_cs_field_script_validator]

Stores text format validation rules and default 
error messages. Read-only.

Custom Controls

[sys_cs_custom_control]

Identifies custom controls.
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Table Description

Custom Control Definitions

[sys_cs_custom_control_definition]

Binds a client type (for example, web or 
mobile) to a custom control.

Conversation Media

[sys_cs_media]

Media attached to conversations are stored in 
sys_attachment, and associated to this table.

Conversation Message

[sys_cs_message]

Stores a record for each message in a 
conversation. Shows the messages displayed 
for each topic in the conversation flow.

Conversation Server Connect Hand-off

[sys_cs_connect_handoff]

Stores mapping of Virtual Agent  conversations 
and Connect/Workspace conversations.

Conversation Session

[sys_cs_session]

Stores a record for each conversation.

Conversation Task

[sys_cs_conversation_task]

Stores a record for each conversation task. 
Each record shows the conversation flow, 
which can include multiple topics that are run 
during the conversation.

Conversation Task FDIH Invocations

[sys_cs_fdih_invocation]

Tracks the state of a call to a Flow Designer 
action or subflow in a conversation.

Conversation Vendor

[sys_cs_vendor]

Stores vendor information.

CS Consumer Account

[sys_cs_consumer_account]

Stores third-party user information.

Custom Greetings and Setup

[sys_cs_context_profile]

Stores a profile record for context-driven chat 
experiences. Contains customizations in the 
following child tables:

• Setup topics [sys_cs_context_profile_topic] - 
Stores the setup topics used for each setup 
topic type.

• Promoted topics 
[sys_cs_context_profile_promotion] - Stores 
the topics that are highlighted in the Virtual 
Agent client.

• Search Profiles 
[sys_cs_context_profile_search] - Stores 
the AI search profile for the associated chat 
experience.

Custom Controls

[sys_cs_custom_control]

Stores the custom input and response 
controls.
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Table Description

Custom Control Definitions

[sys_cs_custom_control_definition]

Binds a client type (for example web chat 
client) to a custom control. Stores the channel, 
domain, and user interface component 
defined for a custom control.

General Settings

[sys_cs_general_settings]

Stores the records for the NLU configuration.

Live Agent Setup

[sys_cs_live_agent_setup]

Stores the Live Agent  setup with queue 
information.

Live Agent Support Queue Cache

[sys_cs_support_queue_cache]

The database cache used for support queue 
wait times.

Open NLU Drivers

[open_nlu_driver]

Stores the records of the NLU service 
providers used in the instance. Identifies the 
base system NLU provider and other services 
installed, such as IBM Watson NLU.

Open NLU Driver Http Connections

[open_nlu_driver_http_connection]

Stores all the HTTP connection references for 
the NLU service provider.

Open NLU Driver Languages

[open_nlu_driver_language]

Lists the language codes for the NLU service 
providers (ServiceNow NLU, IBM Watson 
Assistant, and MS LUIS). Identifies the driver 
codes and associated languages.

Open NLU Predict Entity Feedbacks

[open_nlu_predict_entity_feedback]

Stores the disposition taken by an application 
in response to an NLU entity prediction result. 
For example, in Virtual Agent  the goal is to map 
a predicted NLU entity to an input variable in a 
Virtual Agent  topic.

Open NLU Predict Intent Feedbacks

[open_nlu_predict_intent_feedback]

Stores the disposition taken by an application 
in response to an NLU intent prediction result. 
For example, in Virtual Agent  the goal is to map 
a predicted NLU intent to a Virtual Agent  topic.

Published Topic

[sys_cb_design_topic]

Stores design topic definitions and references 
the runtime topic.

Session Binding

[sys_cs_session_binding]

Stores session binding and AMB channel 
information.

Configurations - Slack Integration

[sys_cs_adapter_configuration_page_slack]

Extends the 
sys_cs_adapter_configuration_page table. 
Stores the configuration for the Slack 
messaging application.

Configurations - Facebook Messenger 
Integration

Extends the sys_cs_adapter_configuration 
page table. Stores the configuration for the 
Facebook Messenger  messaging application.
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Table Description

[sys_cs_adapter_configuration_page_messenger]

Teams Adapter Configuration Page

[sys_cs_adapter_configuration_page_teams]

Extends the 
sys_cs_adapter_configuration_page table. 
Stores the adapter configuration for the 
Microsoft Teams  messaging application.

Workplace Adapter Configuration Page

[sys_cs_adapter_configuration_page_workplace]

Extends the 
sys_cs_adapter_configuration_page table. 
Stores the adapter configuration for the 
Workplace  messaging application.

Vendor Client Adapter Configuration

[sys_cs_vendor_client_adapter_configuration]

Stores the adapter configuration for third-party 
messaging applications.

Topic

[sys_cb_topic]

Stores a record for each topic (design-time 
definition).

Topic

[sys_cs_topic]

Stores an instance of a topic from 
sys_cb_topic at run time. Records on this table 
are cleaned every 12 hours.

Topic Category

[sys_cb_topic_category]

Stores all the categories that identify the 
different types of topics, such as setup topics 
and small talk topics. Also includes custom 
categories defined by admins.

Topic Library Usages

[sys_cs_topic_library_usage]

Stores references to published topic blocks.

Vendor Context Configuration

[sys_cs_vendor_context_configuration]

Stores vendor-specific device context 
information.

Virtual Agent Context

[sys_cs_virtual_agent_context]

Stores Virtual Agent  context variables.

Properties installed

Property Description

com.glide.cs.branding.msg_delay Minimum delay between bot messages

com.glide.cs.branding.type_presence_delay Minimum delay before displaying typing 
animation

com.glide.cs.conversation_faulted_reason Message that displays the following default 
message when a conversation has faulted: 
It seems that you have left the 
conversation.

com.glide.cs.general.error_message Generic error message
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Property Description

com.glide.cs.general.live_agent_handoff_error_messageError message when no live agent has been 
set up

com.glide.cs.general.live_agent_handoff_messageMessage to display when handing over to a 
live agent

com.glide.cs.general.support_email General support email

com.glide.cs.general.support_hours General support hours

com.glide.cs.general.support_phone General support phone

com.glide.cs.global_configuration The sys_id of the default configuration page 
(sys_cs_configuration_page)

com.glide.cs.javascript.reserved_words Reserved words in JavaScript that should not 
be used as vaInputs names or vaVars names

com.glide.cs.live_agent_queue The chat queue that users transfer to when a 
conversation transitions from a virtual agent to 
a live agent. This default queue is used unless 
the topic specifies a specific queue to use.

com.glide.cs.suggest.minimum_characters The minimum number of characters the user 
must enter in a keyword search before partial 
matching, phonetic matching, and spellcheck 
begin to function.

com.glide.cs.suggest.enable_partial_search Enables partial matching searches on topic 
searches when set to true.

com.glide.cs.suggest.enable_phonetic_search Enables phonetic searching on topic searches 
when set to true.

com.glide.cs.suggest.enable_spell_check Enables alternate search spellings on topic 
searches when set to true.

Virtual Agent  roles

Virtual Agent  adds several roles for users operating as Virtual Agent  administrators.

To learn more about managing subscriptions, see Managing per-user subscriptions in 
Subscription Management  and contact your account representative.

Role description

Roles that are installed with Virtual Agent  are listed below with the following information:

Role title [name]

Name of the role. Text within brackets matches the Name  field in the Roles 
[sys_user_role] table.

Description

Description of the role and its intended use.

Contains Roles

List of roles contained within the role.

Groups

List of groups this role is assigned to by default.

Considerations
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Warnings or other considerations for administrators.

Installed roles

Note: 

Simplify user administration by creating groups that contain all the roles necessary for 
specific personas rather than to individual users. You can then assign individual users 
to those groups. When users transition to new roles, you can then re-assign their group 
memberships, and avoid scenarios where users retain unexpected roles.

For details on the administration of users, groups, and roles, see User Administration .

Issue auto resolution administrator [iar_admin]

Configures the delivery of automated task resolution messages in Virtual Agent, email, or SMS.

Contains Roles

List of roles contained within the role.

• evam_admin

• search_application_admin

Groups

List of groups this role is assigned to by default.

None.

Special considerations

Note: 
Avoid granting an admin role when more specialized roles are available.

Chat survey administrator [chat_survey_admin]

Controls and configures post-chat surveys for gathering feedback on user experience, or for chat 
queues defined in Advanced Work Assignment.

Contains Roles

List of roles contained within the role: survey_admin.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

Note: 
Avoid granting an admin role when more specialized roles are available.

Action Designer  [action_designer]

Launches the Action Designer  app, to automate tasks with sequences of related steps.
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Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

EVAM  administrator [evam_admin]

Accesses Entity View Action Mapping, to standardize display of different data sources in cards or 
lists.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

Note: 
Avoid granting an admin role when more specialized roles are available.

Virtual Agent branding [va_branding]

Fetches branding settings via scripted rest API.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.
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Activity subscriptions administrator [actsub_admin]

Creates subscribable objects and subscribes to activities on those objects.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

Note: 
Avoid granting an admin role when more specialized roles are available.

Action Designer  [action_designer]

Launches the Action Designer  app, to automate tasks with sequences of related steps.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

EVAM  administrator [evam_admin]

Accesses Entity View Action Mapping, to standardize display of different data sources in cards or 
lists.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.
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Special considerations

Note: 
Avoid granting an admin role when more specialized roles are available.

Virtual Agent branding [va_branding]

Fetches branding settings via scripted rest API.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

Activity subscriptions administrator [actsub_admin]

Creates subscribable objects and subscribes to activities on those objects.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

Note: 
Avoid granting an admin role when more specialized roles are available.

Flow designer [flow_designer]

Launches the Flow Designer  app, to create multi-step workflows.

Contains Roles

List of roles contained within the role.

• decision_table_reader

• flow_operator

• rest_api_builder
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Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

Automated testing framework designer [atf_test_designer]

Creates and runs automated tests to confirm proper instance function after making changes to 
the instance.

Contains Roles

List of roles contained within the role: impersonator.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

NLU  Administrator [nlu_admin]

Creates NLU  models and associated intents in the NLU Workbench.

Contains Roles

List of roles contained within the role.

• sn_nlu_workbench.nlu_feedback_admin

• nlu_editor

• nlu_user

Groups

List of groups this role is assigned to by default.

None.

Special considerations

Note: 
Avoid granting an admin role when more specialized roles are available.

External application installation administrator [external_app_install_admin]

Installs external apps such as Slack, Microsoft Teams, and Workplace.
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Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

Note: 
Avoid granting an admin role when more specialized roles are available.

Any user assigned this role can alter or delete topics created in the Virtual Agent Designer 
system, including topics that other topics refer to or have as dependencies.

Automated Customer Experiences (ACE) user [sn_ace.ace_user]

Accesses and reads ACE records.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

Conversational Interfaces guided setup administrator 
[sn_ci_gs_content.ci_guided_setup_admin]

Creates a guided setup to assist users with planning the roll-out of Conversational Interfaces 
materials, and performs the basic configurations to go live.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.
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Special considerations

Note: 
Avoid granting an admin role when more specialized roles are available.

Localization requestor [localization_requestor]

Creates translation requests, and views completed translations in the Localization Framework.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

Self-service manager [sn_ssa_core.self_service_manager]

Performs CRUD operations on Pattern and Activity configuration and the Deflection data tables.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

Image administrator [image_admin]

Manages image files on the Images [db_image] table.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.
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Special considerations

Note: 
Avoid granting an admin role when more specialized roles are available.

Search application administrator [search_application_admin]

Inserts data into, updates, and deletes search-UX related configuration 
tables including: [sys_search_context_config], [sys_search_source], 
[m2m_search_context_config_search_source], [sys_search_facet], and [sys_search_filter]. The AI 
Search  administrator [ais_admin] role is included in this role to perform AI Search  configuration.

Contains Roles

List of roles contained within the role.

• ais_admin

• personalize_dictionary

Groups

List of groups this role is assigned to by default.

None.

Special considerations

Note: 
Avoid granting an admin role when more specialized roles are available.

Chat analytics administrator [chat_analytics_admin]

Sets up the Conversational Analytics dashboard, reconfigures its contents, and creates funnels 
to review performance of conversation flows.

Contains Roles

List of roles contained within the role: chat_analytics_viewer.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

Note: 
Avoid granting an admin role when more specialized roles are available.

Additional plugins for Virtual Agent

After activating Virtual Agent, you can activate additional plugins to enable other features for 
conversation design.

You must have the admin role to activate these additional plugins. For details, see Activate a 
plugin .

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1700

https://www.webstg.servicenow.com/docs/access?context=t_ActivateAPlugin&version=washingtondc&pubname=washingtondc-platform-administration&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=t_ActivateAPlugin&version=washingtondc&pubname=washingtondc-platform-administration&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=t_ActivateAPlugin&version=washingtondc&pubname=washingtondc-platform-administration&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=t_ActivateAPlugin&version=washingtondc&pubname=washingtondc-platform-administration&ft:locale=en-US


Plugin Description

• Human Resources Service Delivery: 
HR Service Delivery Virtual Agent 
Conversations [sn_hr_va] available through 
the ServiceNow  Store

• ITSM Virtual Agent conversations 
[sn_itsm_va] available through the 
ServiceNow  Store

• CSM Virtual Agent  conversations 
[com.sn_csm.virtualagent]

Enables predefined Virtual Agent 
conversations, reusable topic blocks, and 
prebuilt ServiceNow  NLU models  for the 
Customer Service Management, HR Service 
Delivery, and IT Service Management 
applications.

• Requires the Glide Virtual Agent 
(com.glide.cs.chatbot) plugin to be activated.

• Automatically activates the NLU Workbench 
(com.snc.nlu_studio) plugin.

• Automatically activates the Service 
Management Virtual Agent Topic Blocks 
(com.glideapp.cs.sm_topic_blocks) plugin. 
Includes common topic blocks such as 
contextual search.

NLU Workbench  [com.snc.nlu_studio] Enables the creation of custom ServiceNow 
Natural Language Understanding (NLU) 
models used by Virtual Agent.

NLU Workbench  - Advanced Features 
[com.snc.nlu.workbench.advanced]

Expands the functionality of NLU Workbench 
by providing conflict review, batch testing, and 
model performance features. Available from 
the ServiceNow®  Store.

Conversational Analytics Dashboard

[com.sn.conversational.analytics]
Provides insights into user interactions so you 
can see how well Virtual Agent  understood 
and resolved user issues.

Prebuilt Virtual Agent  topics, topic blocks, and ServiceNow  NLU models

Prebuilt Virtual Agent  conversations (topics), reusable topic blocks, and ServiceNow  NLU models 
are available for the Virtual Agent  platform and various business applications, such as Customer 
Service Management, HR Service Delivery, IT Service Management, and more.

These pre-defined conversations help users with common self-service tasks in each business 
area, such as creating or updating cases or providing answers to frequently asked questions. 
Prebuilt topic blocks are reusable components (similar to subflows) that perform a specific 
function or task and can be added to a conversation topic. Prebuilt NLU models define the 
business-specific language understanding needed for Virtual Agent  to understand and process 
user requests. Each NLU intent in a model maps to a single Virtual Agent  conversation topic.

Summaries of prebuilt topics and topic blocks

For more information on the Virtual Agent  prebuilt topics and topic blocks provided by various 
ServiceNow  applications, refer to the documentation for those applications. For example, the 
CSM, HRSD, and ITSM applications provide information on their prebuilt topics in the following 
sections:
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Predefined topics and topic blocks Activated by

Customer Service Virtual Agent 
conversations

com.sn_csm.virtualagent

Human Resources Virtual Agent 
conversations Request the HR Service Delivery Virtual Agent 

Conversations from the ServiceNow Store.

Visit the ServiceNow Store  website to view 
all the available apps and for information 
about submitting requests to the store. For 
cumulative release notes information for all 
released apps, see the ServiceNow Store 
version history release notes .

ITSM Virtual Agent Conversations
Request ITSM Virtual Agent and the ITSM NLU 
Model for Virtual Agent Conversations from 
the ServiceNow Store.

Visit the ServiceNow Store  website to view 
all the available apps and for information 
about submitting requests to the store. For 
cumulative release notes information for all 
released apps, see the ServiceNow Store 
version history release notes .

Virtual Agent  Platform topics and topic blocks

• Virtual Agent Designer setup topics

• Virtual Agent platform topic blocks  (such 
as Agent Availability, AI Search, and FAQ 
Conversation Builder)

com.glide.cs.chatbot

Note: 
The plugins for the CSM, HR Service Delivery, and ITSM predefined conversations also 
install their prebuilt ServiceNow  NLU models and topic blocks. The Glide Virtual Agent 
plugin installs the prebuilt NLU model for setup topics, as well as platform topic blocks.

After installing the plugins or apps, you can preview (test) the topics and topic blocks using 
Virtual Agent Designer. You can review the intents, utterances, and entities in the prebuilt NLU 
models using ServiceNow  NLU Workbench  or within Virtual Agent Designer if your NLU-enabled 
topics are associated with intents in ServiceNow  NLU models.

Working with prebuilt topics and topic blocks in Virtual Agent Designer

• Previewing topics and topic blocks – After you install the plugins for prebuilt topics, admins or 
Virtual Agent  admins can access the prebuilt topics and topic blocks in the Topics page. Select 
the topic and in the Flow  tab, select Test. Review the conversation as it runs in the test window 
to determine the topics and topic blocks that you want to use.

• Using prebuilt topics and topic blocks – Although prebuilt topics and topic blocks are read 
only and can't be changed, you can reuse them by duplicating  and modifying them as needed. 

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1702

https://www.webstg.servicenow.com/docs/access?context=csm-virtual-agent-chatbot&version=washingtondc&pubname=washingtondc-customer-service-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=csm-virtual-agent-chatbot&version=washingtondc&pubname=washingtondc-customer-service-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=csm-virtual-agent-chatbot&version=washingtondc&pubname=washingtondc-customer-service-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=csm-virtual-agent-chatbot&version=washingtondc&pubname=washingtondc-customer-service-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=hr-virtual-agent-conversations&version=washingtondc&pubname=washingtondc-employee-service-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=hr-virtual-agent-conversations&version=washingtondc&pubname=washingtondc-employee-service-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=hr-virtual-agent-conversations&version=washingtondc&pubname=washingtondc-employee-service-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=hr-virtual-agent-conversations&version=washingtondc&pubname=washingtondc-employee-service-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=hr-virtual-agent-conversations&version=washingtondc&pubname=washingtondc-employee-service-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=hr-virtual-agent-conversations&version=washingtondc&pubname=washingtondc-employee-service-management&ft:locale=en-US
https://store.servicenow.com/sn_appstore_store.do#!/store/home
https://store.servicenow.com/sn_appstore_store.do#!/store/home
https://store.servicenow.com/sn_appstore_store.do#!/store/home
https://docs.servicenow.com/bundle/store-release-notes/page/release-notes/store/sn-store-release-notes.html
https://docs.servicenow.com/bundle/store-release-notes/page/release-notes/store/sn-store-release-notes.html
https://docs.servicenow.com/bundle/store-release-notes/page/release-notes/store/sn-store-release-notes.html
https://docs.servicenow.com/bundle/store-release-notes/page/release-notes/store/sn-store-release-notes.html
https://docs.servicenow.com/bundle/store-release-notes/page/release-notes/store/sn-store-release-notes.html
https://www.webstg.servicenow.com/docs/access?context=itsm-virtual-agent&version=washingtondc&pubname=washingtondc-it-service-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=itsm-virtual-agent&version=washingtondc&pubname=washingtondc-it-service-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=itsm-virtual-agent&version=washingtondc&pubname=washingtondc-it-service-management&ft:locale=en-US
https://store.servicenow.com/sn_appstore_store.do#!/store/home
https://store.servicenow.com/sn_appstore_store.do#!/store/home
https://store.servicenow.com/sn_appstore_store.do#!/store/home
https://docs.servicenow.com/bundle/store-release-notes/page/release-notes/store/sn-store-release-notes.html
https://docs.servicenow.com/bundle/store-release-notes/page/release-notes/store/sn-store-release-notes.html
https://docs.servicenow.com/bundle/store-release-notes/page/release-notes/store/sn-store-release-notes.html
https://docs.servicenow.com/bundle/store-release-notes/page/release-notes/store/sn-store-release-notes.html
https://docs.servicenow.com/bundle/store-release-notes/page/release-notes/store/sn-store-release-notes.html


After you test a duplicated topic and are ready to deploy it to your Virtual Agent  clients, publish 
the topic. Similarly, after testing a duplicated topic block, publish it to make it available for use 
in conversation (calling) topics.

For details on creating, testing (previewing), duplicating, and publishing a topic, see Getting 
started with Virtual Agent Designer. For details on working with topic blocks, see Maximizing 
code reuse with topic blocks.

Working with prebuilt ServiceNow  NLU models in ServiceNow  NLU Workbench

• Reviewing a prebuilt NLU model – After you install the plugins for predefined topics, you 
can view the prebuilt models in NLU Workbench. The prebuilt NLU models for ServiceNow 
applications define the intents, entities, and utterances used for the predefined topics. These 
models are also trained and published. You can also review the utterances for a prebuilt model 
in Virtual Agent Designer. However to copy a prebuilt model, you use NLU Workbench.

• Duplicating prebuilt NLU models – Although prebuilt NLU models are read only and can't be 
edited, you can Duplicate an NLU model  prebuilt NLU models to create your own NLU models 
and Import an NLU  intent  from prebuilt models or other NLU models that you create in NLU 
Workbench.

For details on creating, training, and publishing ServiceNow  NLU models, see Natural Language 
Understanding .

Setting up chat experiences for Virtual Agent  users

Create different chat experiences for your end users based on the context in which they initiate a 
conversation with Virtual Agent.

How chat experiences work

A chat experience defines the structure of a bot conversation (setup topics), an initial set of 
topics displayed to users (promoted topics), and the AI Search  configurations for displaying 
search results in conversations. Virtual Agent  provides a preconfigured, default chat experience 
that you (admins and topic authors) can use to control the user experience with Virtual Agent.

You can configure the default chat experience and also create custom chat experiences, tailored 
to the context in which different users run Virtual Agent, such as the service portal or channel 
that they're using. Custom chat experiences inherit the default chat experience settings, but you 
can override the defaults as needed for a given context.

Note: 
If you're using Virtual Agent Lite, you can configure certain setup topics in the default chat 
experience but you can't create custom chat experiences.

A chat experience consists of the following:

Setup topics

Virtual Agent  provides common conversational elements, such as a welcome 
greeting to begin a conversation and a conversation closing, and automatically 
includes them in virtual agent conversations. These pre-built elements, called 
setup topics, are part of a basic conversation structure that is applied to all your 
conversations. They are installed with Virtual Agent  and Virtual Agent Lite.

These setup topics run automatically at appropriate points in a conversation, based 
on the context, utterances (if NLU is enabled), or keywords that users enter during 
the conversation.
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Example setup topics in a conversation

Virtual Agent  provides the following types of pre-built setup topics:

Setup topic Description

Greeting Presents a welcome greeting to users, and asks users to enter a 
request or see what items it can assist with.

Provide 
Virtual Agent 
Feedback

Displays a survey to get user feedback on the conversational 
experience, before the conversation ends.

Live Agent 
Support

Enables users to request a live agent transfer and view items that 
the live agent can assist with.

Virtual Agent 
Capabilities

Presents a list of what the virtual agent can help with.

Error 
Handling 
Topic

Displays a standard error message when an unrecoverable system 
error occurs and transfers the user to a live agent.

Closing 
Conversation

Displays a closing message that ends the conversation.

AI Search 
Fallback

Generates AI Search results for a user when Virtual Agent can't find 
a matching intent and topic or keyword.

Fallback 
Topic

Presents standard messages that ask the user to enter another 
request or select a different topic when the virtual agent does not 
understand a user entry or selection.

Anything 
Else Topic

After completing a task or request, virtual agent asks if the user 
needs further assistance with another request or task.

The setup topics have corresponding intents (set in the pre-built NLU model 
for setup topics) and also keywords. Virtual Agent  recognizes the utterances or 
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keywords that users can enter to run certain setup topics, such as the Virtual Agent 
Capabilities (help) topic or the Live Agent support topic.

You can preview (test) the pre-built setup topics to see how they work. In the Topics 
page of Virtual Agent Designer, use the Type  filter to list the Setup Topics and 
select the setup topics to test. Pre-built topics are read-only, but you can duplicate, 
customize (modify) if needed, and publish them.

Promoted topics

You can display a collection of up to six topics that are relevant to your users, 
displayed before the Show me everything  button in the chat window. You can use 
these promoted topics in a chat experience to give your users quick and convenient 
access to the topics used for a given context.

Note: 
Promoted topics may not be supported on all clients.

Example promoted topics

Search profile

A search profile defines how Virtual Agent  search results are generated through 
the AI Search application and how the results are displayed to users. Virtual Agent 
uses a default search application that controls the data source for searches and a 
UI configuration (set in the Entity View Action Mapping application) that controls the 
search results displayed in Genius cards and multi-link output. These configurations 
also apply to search results generated as a fallback when Virtual Agent  can't 
determine the appropriate topic. For more information, see Improving the user 
experience with AI Search.
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Example AI Search result

Get started with chat experiences

Navigate to All  > Conversational Interfaces  > Settings, and then select Virtual Agent. Use the 
Custom Greetings and Setup  tile to manage the default and custom chat experiences. You can 
do the following:

• Configure the default chat experience, including the setup topics, promoted topics, and search 
criteria used. For example, you can activate the Virtual Agent  Feedback setup topic so that it is 
applied to all your bot conversations.

• Create different custom chat experiences based on the context in which your end users run 
Virtual Agent. The settings that you define in a custom chat experience override the default 
chat experience.

Working with setup topics

Setup topics are part of a standard conversation structure applied to all your conversations, 
such as the welcome greeting or fallback responses. Setup topics run at the appropriate spot 
in a conversation based on the context, keywords, or utterances entered by the user, and any 
conditions that are specified for the setup topic.

You define setup topics in a Virtual Agent Designer  chat experience using the Custom Greetings 
and Setup option. A chat experience sets the context in which users run Virtual Agent. This 
context includes:

• Setup topics applied to bot conversations.

• A small list of topics, called promoted topics, initially displayed in the chat window.

• AI Search  configuration used to display AI Search  results for your users.

For more information on chat experiences, see Setting up chat experiences for Virtual Agent 
users. For details on configuring a chat experience, see Configure a Virtual Agent chat 
experience.
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Note: 
Setup topics in conversations are discoverable (via topic discovery) only when they're 
configured in a Virtual Agent chat experience  using the Custom Greetings and Setup 
option. If any setup topics are not included in a chat experience, those setup topics are 
not listed in the chat window's All Topics menu (topic picker) and cannot be discovered by 
Virtual Agent.

Setup topics run during a conversation as follows.

1. Conversation beginning: Virtual Agent  presents the Greeting topic and the list of available 
topics (Virtual Agent  capabilities) that the user can select.

Note: 
If you want the chat window to immediately take users to a live agent, do not select the 
Live Agent Support topic as a greeting. Instead, use the system method to transfer to a 
live agent.

2. Conversation body: These setup topics are presented at different points in the conversation 
depending on the context:

◦ User requests help: Virtual Agent  presents the Explore help topic (Virtual Agent  capabilities).

◦ User enters a request or keyword that Virtual Agent  doesn't understand: Virtual Agent 
presents the Fallback topic, unless the AI Search fallback topic is enabled.

◦ If the AI Search Fallback topic is enabled and the user enters a request or keyword but 
Virtual Agent  can't find a matching topic or keyword, or finds too many topics to determine 
the matching topic: Virtual Agent  runs AI Search  to generate relevant search results for the 
user. If the AI Search  results do not help the user, or if the AI Search Fallback setup topic is 
not activated, Virtual Agent  runs the Fallback topic.

◦ An unrecoverable system error occurs during conversation: Virtual Agent  runs the Error 
Handling topic, and then transfers the user to a live agent.

◦ User requests a transfer to live agent: Virtual Agent  runs the Live Agent topic, which transfers 
the user to a live agent.

◦ After a task or user request is completed: Virtual Agent  runs the Anything else topic to ask if 
the user wants to continue with another request or task.

3. Conversation ending:

◦ If the user doesn't want further assistance after a task or the request is completed, Virtual 
Agent  presents the Survey topic for feedback on the conversational experience.

◦ After the survey, Virtual Agent  confirms that the feedback has been received, and runs the 
Closing topic to end the conversation.

The default setup topics are read-only and have topic names with a period at the end of the 
setup topic name, such as Greeting. You can create your own custom setup topics by duplicating 
a setup topic and changing it as needed. You can also change prompts or add other controls to 
the topic, just as you might when creating other topics.

If you want a closing message to be different from the default Closing topic, create a custom 
setup topic that contains the revised closing text. You also need to create an intent for that 
custom setup topic in the NLU model for setup topics, or define topic keywords in the Topic 
Properties page. You can then select the custom setup topic to be used in a custom chat 
experience instead of using a default setup topic.

The following table provides examples of the pre-built setup topics in the default chat 
experience.
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Setup topic type Setup topic name and description

Anything else
Anything Else Topic. Virtual Agent  asks users if they need 
further assistance.

If users select Yes, Virtual Agent  returns a list of related items 
that it can help with.

Live agent
Live Agent Support. Tells users that a live agent transfer is in 
process:

Error
Error Handling Topic. Displays a generic error message to the 
user when the Virtual Agent  encounters a problem that it can't 
resolve (unrecoverable system error) and transfers the user to a 
live agent.

Greeting
Greetings. Starts a conversation by greeting users and giving 
them the option to enter a request or see the items that the 
Virtual Agent  can assist with.
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Setup topic type Setup topic name and description

Note: 
The pre-built setup topics include a personalized greeting 
called the Dynamic Greeting Topic, which welcomes the 
user by name. To change the default greetings topic, 
double click Setup topic name  and then choose the 
personalized greeting from the list of available setup 
topics.

Survey
Virtual Agent  Feedback topic.

Gathers user feedback on the conversational experience with 
the Virtual Agent. The survey setup topic displays randomly in 
33% of your Virtual Agent  conversations.

The survey topic includes an introductory sentence that admins 
can customize as needed. The survey then presents a choice 
list with options users can select to describe their experience.

Example survey feedback choices

After the users provide their feedback, a message confirms that 
their feedback has been received:

Note: 
To change the probability (percentage) that the survey 
setup topic occurs in your conversations, change the 
value in the com.glide.cs.survey.probability 
system property. To display the survey setup topic 
randomly in 50% of your Virtual Agent  conversations, set 
the Value  to 0.50.

Closing
Closing Conversation. Displays a closing message to the user 
that ends the conversation:

AI Search  fallback
AI Search  Fallback. When enabled, this setup topic uses AI 
Search  search to generate fallback AI Search results when 
Virtual Agent  can't find a matching intent or it finds too many 
intents and can't determine the appropriate topic to display to a 
user.

Fallback
Fallback Topic. Displays a standard message to the user when:
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Setup topic type Setup topic name and description

• When virtual agent doesn't understand a user utterance 
or keyword and the AI Search  fallback setup topic is not 
enabled in the chat experience. AI Search  fallback topic was 
deactivated in the chat experience, and the virtual agent 
doesn't understand a user statement or keyword.

• Users indicate that the AI Search  results aren't helpful.

Explore help
Virtual Agent  Capabilities. Enables users to ask for assistance 
during a conversation and view a list of items that the Virtual 
Agent  can assist with (Virtual Agent  capabilities).

Change text in the Show me everything button

Configure the text in the Show me everything  button displayed in the chat window to control 
the display of the initial greetings and the Show me everything  button in Virtual Agent 
conversations. Edit the message in the System Properties [sys_properties] table, or in a copy of 
the Greetings setup topic.

Before you begin
If you’re updating the Greetings setup topic in Virtual Agent Designer, first Create a copy  of the 
Greetings setup topic, since the prebuilt Greetings setup topic is read-only.

Role required: virtual_agent_admin or admin

About this task
You can change the Virtual Agent  greeting message by either updating the default greeting 
through the System Properties [sys_properties] table, or changing the message in the Greetings 
setup topic in Virtual Agent Designer.

If you change the message in the System Properties table, the default greetings setup topic (and 
any custom greetings topics that don't override the default Show me everything) all show the 
updated message. If you change the greeting message through Virtual Agent Designer, you can 
make more targeted changes, such as a message for an HR-based greeting topic.

The Greetings setup topic contains the Send Topic Picker script action, which controls the text 
in the Show me everything  button. To change the text, edit the Send Topic Picker script action in 
the copy of the Greetings setup topic.
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Procedure

Navigate to All  and use one of the following methods.

Result
If you follow the System Properties method, your change to the greeting message is shown in 
all Virtual Agent  conversations. If you follow the Virtual Agent Designer  method, your change is 
shown in conversations related to the Greetings setup topic.

What to do next
If you customized your Greetings topic, add it to the default chat experience or to a new custom 
chat experience that you created. For details, see Configure a Virtual Agent chat experience.

Hide or reveal the Show me everything button

Set properties to hide or reveal the Show me everything  button in Virtual Agent  conversations 
that use LLM (large language model) and NLU/Keyword (Natural Language Understanding) topic 
discovery.

Before you begin
Role required: vitual_agent_admin or admin

About this task
By default, the greeting portion of a Virtual Agent  conversation includes a Show me everything 
button, which brings up the entire list of available Virtual Agent  topics and a search filter. Use 
the following steps to toggle the Show me everything  button for LLM and NLU/Keyword topic 
discovery, respectively.

Procedure

Use either of the following methods, depending on whether you are working with LLM or NLU 
topics.

Result
The Show me everything  button is removed from the greeting messages in your Virtual Agent 
conversations.

Change the Virtual Agent  greeting messages in the Greeting setup topic

The Virtual Agent  greeting setup topic provides default greeting messages for your 
conversations. Customize these greetings by adding system properties that change the default 
welcome message and the top selection message prompting users to enter an issue or request.

Before you begin
Role required: virtual_agent_admin or admin

About this task
Starting with the Orlando  release, the com.glide.cs.general.welcome_message 
and com.glide.cs.general.top_selection_message  properties are no longer 
automatically installed with Virtual Agent. These properties define the greeting messages used in 
the Greeting setup topic.

In the Orlando  release, the default Greeting setup topic was updated. If you upgraded 
from the New York  release, these properties are retained so that you can continue 
using the original Greeting setup topic. If you want to use the updated Greeting 
setup topic, delete the com.glide.cs.general.welcome_message  and 
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com.glide.cs.general.top_selection_message  system properties that contain the 
original Greeting messages.

Note: 
These properties aren't present in the base system, but creating them enables you to 
override these messages. The custom messages that that you create only appear with 
NLU/Keyword topics.

For new customers, the updated Greeting setup topic (see the following example) is the default. 
If you want to change the default message text in the Greeting setup topic, add these system 
properties to the System Property [sys_properties] table:

• com.glide.cs.general.welcome_message: Change the default welcome message

• com.glide.cs.general.top_selection_message: Change the top selection 
message that displays after the welcome message

Default messages in Greeting setup topic (starting with the Orlando  release)

Procedure

1. Navigate to All, and then enter sys_properties.list  in the filter.

2. Select New  to add the com.glide.cs.general.welcome_message  property.

a. On the form, complete the following fields.

Field Value

Name Enter the system property name: 
com.glide.cs.general.welcome_message

Description Enter an explanation for this property: Welcome message

Type Select string.

Value
Enter the greeting text. For example: How can I help you?

b. Select Submit.

3. In the System Properties table, select New  to add the 
com.glide.cs.general.top_selection_message  property.
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a. On the form, complete the following fields.

Field Value

Name Enter the system property name: 
com.glide.cs.general.top_selection_message

Description Enter an explanation for this property: Top selection message

Type Select string.

Value
Enter the text that specifies the next selection action that the user can make 
after the welcome message is presented to the user. For example: You can 
enter your request below, or use the button to see 
everything that I can help with.

b. Select Submit.

Configure a Virtual Agent  chat experience

Change the preconfigured Virtual Agent  default chat experience or create a custom chat 
experience for your users. You can configure setup topics, specify promoted topics, and if 
needed, change the search profile.

Before you begin
If you want to specify custom setup topics or promoted topics that are displayed to your users in 
the chat window, make those topics active (published) so that they're available for configuration 
in the chat experience.

Role required: virtual_agent_admin or admin

About this task
The default chat experience provides the default settings for the setup topics and the Virtual 
Agent  search configurations in your instance. A custom chat experience uses the default 
settings from the default chat experience, but you can override them as needed. Defining a chat 
experience includes the following steps:

1. Configure setup topics.

◦ Activate setup topics that are not initially enabled, such as the Anything else, Survey topic, 
and AI Search Fallback topic types.

Note: 
If you upgraded from the Quebec  release, the AI Search Fallback topic is deactivated 
by default. Enable it to return AI Search results as a fallback when Virtual Agent  can't 
determine intents, topics, or keywords.

◦ If you want setup topics to be included in topic discovery and listed in the All topics menu, 
be sure to include those setup topics in the default or a custom chat experience.

◦ Deactivate setup topics if you don't want them to run in your conversations.

2. Promote up to six topics that are initially displayed to your users, above the Show me 
everything  button in the chat window. Promoted topics are supported only on the web and 
mobile clients.

3. Change the Search Application configuration in the Search Profile, if needed.
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Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. Select Virtual Agent  and under Custom Greetings and Setup, select View All.

3. Define the chat experience.
Do one of the following:

◦ To change the setup topics, promoted topics, or AI Search setting in the default chat 
experience, proceed to Step 5 or 6, depending on what you want to change.

Note: 
The settings for the default chat experience are preconfigured (read-only).

◦ To define a new experience, select New  and complete the fields in Custom Greetings and 
Setup. Then proceed to Step 4.

◦ To edit a custom experience, select the custom experience record and select Edit  to update 
Custom Greetings and Setup.

Custom Greetings and Setup

Field Description

Name Name of the chat experience.

Description Brief description (purpose) of the chat experience, for example ESC portal.

Active Option that activates or deactivates the chat experience. The chat experience is 
active (enabled) by default. To deactivate the chat experience, clear this option.

Order Order value that Virtual Agent  uses to determine which chat experience to 
apply. The default chat experience has an Order value of 1000. Virtual Agent 
checks all the chat experiences, and if there is more than one match, the 
experience with the lowest order value (<1000) is applied.

Provide the context

Condition 
Mode

Options for specifying the chat experience context:

◦ Simple: A no-code condition builder to specify the context. This is the mode 
for the default chat experience.

◦ Advanced: A JavaScript scripted condition that specifies the context. The 
condition must evaluate to true.

Condition Condition builder for specifying the experience context. See the list of the 
available context variables  that can be specified.
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Field Description

For example, a Simple, no-code condition might specify the devicetype (ios or 
android) and the portal to which it applies. In this case, the condition applies to 

the Service Portal (sp). 

Script Script editor for specifying the condition in a script, if you selected Advanced as 
the Condition Mode.

4. Select Create custom experience  if this is a new custom chat experience.

◦ The settings for the setup and promoted topics are empty. The setup topics and promoted 
topics specified for the default chat experience are used automatically, unless you override 
them by adding new topics or changing them in your custom experience.

◦ To change the setup topics, promoted topics, or AI search settings in the default experience, 
proceed to the next steps.

5. Select the Setup Topics  tab.
The default experience for new instances automatically includes most of the pre-built setup 
topics in your conversations, except for the Anything else and Survey topics. If you upgraded 
from the Quebec  or Rome  release, the AI Search fallback topic type is also not active.

Note: 
the Live Agent  and Virtual Agent  Feedback topics are not listed in the Virtual Agent  topic 
picker (All Topics) menu by default. You must associate a setup topic type to a setup topic 
as part of the default or custom chat experience.

Select Update  to apply your changes.

6. Select the Promoted Topics  tab to configure promoted topics.
Specify up to six Virtual Agent  topics to be initially displayed in the chat window.

Note: 
Promoted topics are supported only on the web and mobile clients.

a. For each topic to be promoted, select Add topic.

b. On the form, fill in the fields.
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Field Description

Topic The topic to be promoted.

Order A number that indicates the order in which the topic is listed in the chat window.

c. Select Submit.

d. If needed, select Test  to see how the promoted topics are displayed in the chat window.

7. Select the Search Mapping  tab to change the search application for the chat experience.
The default mapping consists of the Search Application Configuration and the Search UI 
(EVAM) Configuration for Virtual Agent.

Note: 
The Virtual Agent  Default Search Application Configuration is tied to a search profile that 
does not provide Person card results.

a. Select the value in the Active  column to open the Search Profile record.

b. To change the Search Application Configuration, select a configuration from the list of 
available Search Application Configurations.
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c. Select Update.

Note: 
Although you can change the Search UI (EVAM) Configuration, the Virtual Agent Search 
(EVAM) configuration provides the appropriate card views and lists of Virtual Agent 
search results. If you want to create your own EVAM configuration for use, see Create an 
EVAM definition.

Test chat experiences

After you create or modify a Virtual Agent  chat experience, you can test (simulate) it to verify that 
it works as expected.

Before you begin
Role required: virtual_agent_admin or admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings, and select the Virtual Agent  tab.

2. Under Custom greetings and setup, select View All.

3. Select the chat experience and view the profile.

4. In the header bar, select Test, which automatically opens the chat test window and the 
associated tabs that display processing details.
The items that you defined for the chat experience, such as custom setup topics or promoted 
topics, run in the test window. The following example shows the custom greeting setup topic 
and promoted topics defined for the ESC portal.
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5. To specify a different context, do the following:

a. In the Test this topic  window, select Include topic discovery.
The Context  tab appears.

b. In the Context  tab, choose a context from the list of variables (these context variables are 
defined in Chat Settings).
For example, you could select portal from the list of variables and enter the portal name, IT 
Express.

c. Select Apply context and reload.
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The items that you defined for the chat experience, such as custom setup topics or promoted 
topics, run in the test window.

Configuring the Portable Virtual Agent  Web Client

The Portable Web Client is a chat widget that can run on third-party web pages, in the service 
portal, or in UI Builder  portals.

The Portable Web Client is a new Seismic component that makes it easy to add Virtual Agent 
chat to your page. It simplifies configuration and provides the following features:

• Easily configurable

• Simpler single sign-on (SSO) authentication flow

• Connect to Service Portal Agent Chat

• System parameters and context variables work the same as before

Prerequisites for using the Portable Virtual Agent  web client

The Portable Web Client uses an inline frame element (iframe). The third-party website 
must be under the same parent domain as your ServiceNow®  instance. For example, 
site1.company.com  and site2.company.com  share the same parent domain. If you're 
embedding the web client on any subdomain that is not shared with your ServiceNow  instance, 
the URL must be a custom instance URL. Due to increased browser security, the web client may 
fail to load if you don't use a custom URL.

Before you begin, do the following:
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1. Activate the custom URL plugin (com.snc.customurl) in your instance.

2. Add the custom URL (that you previously purchased and registered) to your instance.

Note: 
To learn more about using custom URLs, see Associating custom URLs to your instance .

Using SSO authentication with the Portable Virtual Agent  web client

After you embed the Virtual Agent client, you can optionally trigger SSO authentication from the 
web client, but only when your instance is set up to use an external SSO provider. Your hosting 
site must also use the same SSO provider as your instance. For details on setting SSO providers, 
see External single sign-on (SSO) .

To trigger SSO authentication, create a JavaScript script that defines conditions for 
running authentication and redirects users to a web client page that you specify. You 
also specify the allowed URLs that can be passed in this script, by identifying them in the 
com.glide.cs.web_client_login_redirect_urls  system property. Specify the full 
redirect URLs or the host part of the URL, such as https://example.com.

This procedure requires that you set values for the following two system properties:

• com.glide.cs.embed.csp_frame_ancestors

• com.glide.cs.embed.xframe_options  (IE 11 only)

These properties determine the security policy for the embedded web client, namely how 
browsers render and secure HTML content for Virtual Agent  and Live Agent  chat, in an iframe, 
before you embed the web chat client. The HTTP header directives that you specify tell the 
browser whether a page can be embedded on certain domains to mitigate clickjacking attempts. 
Setting both properties ensures that there are security directives for major browsers and also 
older browsers, such as Internet Explorer.

Note: 
If you're using the Content Management System (CMS) application to create custom 
interfaces for the ServiceNow AI Platform  and ServiceNow®  applications, be aware that it 
does not support Virtual Agent.

Related topics

Configure the Portable Virtual Agent web client

Add the Portable Virtual Agent web client to a third-party website

Configure the Portable Virtual Agent  web client

Configure the Portable Web Client chat widget to run Virtual Agent  on third-party web pages.

Before you begin
Note: 
For new customers onboarding from Vancouver onward, the web client is only accessible 
to authenticated users by default. To allow unauthenticated users to access the web client, 
you must enable the sn_va_web_client_app_embed page for public access. For more 
information, see Make UI pages public or private .

Role required: admin
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About this task
ServiceNow  only supports the Portable Virtual Agent  when the top-level domain and domain 
name match the site that is loading the web client. SSO is only supported through the service-
now.com URL. Anything beyond that will require custom solution and implementation.

Procedure

1. Navigate to All, and then enter sys_properties.list  in the filter.

2. In the System Properties [sys_properties] table, search for the 
com.glide.cs.embed.csp_frame_ancestors  property by name.

3. Click the property name to open the form and specify the directive values.

Field Description

Type string

This is the default value.

Value Source value of the HTTP header directive: Content-Security-
Policy:frame-ancestors<source>This property applies to most major 
browsers, except for Internet Explorer.

Specify one or more sources, including the following:

◦ 'self': Indicates that the origin is the same as the page being served. For example, if 
the value is 'self' http://mywebsite.com, then the iframe is embedded 
within the parent domain as well as mywebsite.com. This is the default value.

◦ host-source: The domains in which the external web page can be embedded. 
Specify the Internet host site by name, IP address, or optional URL and/or port 
number. Site address can start with a wildcard (asterisk) character. Example value: 
http://*.example.com

◦ scheme-source: A schema. For example: http:  or https:

◦ none: No matching URLs.

For more information about source values that you can specify, see CSP:frame-ancestors
and Virtual agent embedded client content security policy (instance security hardening)  in 
Instance Security Hardening Settings .

4. Return to the System Properties [sys_properties] table to search for the 
com.glide.cs.embed.xframe_options  property by name.

5. Click the property name to open the form and specify the directive values.

Field Description

Type string

This is the default value.

Value Value of the of the X-Frame-Options header directive, to indicate whether the browser 
can render an external web page in a frame.

Specify one of the following values:
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Field Description

◦ sameorigin: Displays the page in a frame that has the same origin as the page itself. 
This is the default value. This property applies to older browsers, such as Internet 
Explorer 11. Example value: allow from https://example.com

◦ deny: Does not display the page in a frame.

◦ allow-from uri: Displays the page only in a frame on the specified origin.

Note: 
This value no longer works in modern browsers.

For more information about source values that you can specify, see X-Frame-Options  and 
Virtual agent embedded client X-Frame-Options (instance security hardening)  in Instance 
Security Hardening Settings .

6. Configure CORS Rules for the REST API to give access across domains.
This rule gives the web domain you specify the rights to call the API that gives it access to the 
chat widget on the web page without a security restraint. All domains must share a common 
parent domain. Also, you must create a new CORS Rule for each subdomain that you want to 
support.

a. Navigate to All  > System Web Services  > REST  > CORS Rules.

b. Click New.

c. On the form, fill in the fields.

Field Description

Name Unique name for the rule.

Application Scope of the application. Global  is the default value.

REST API Name of the REST API. Select Conversation Consumer Account [now/cs].

Domain The domain for your website. For example: https://mycompany.com

If you have multiple subdomains for your website, you must create 
a CORS Rule for each. For example, support.mycompany.com  and 
products.mycompany.com  would require two separate CORS Rules.

Note: 
Wildcards are not allowed.

Max age The number of seconds to cache the client session. After an initial CORS 
request, further requests from the same client within the specified time do not 
require a preflight message.

If you do not specify a value, the default value of 0  indicates that all requests 
require a preflight message.

d. On the HTTP Methods  tab, select GET.
The Portable Web Client will only receive requests.
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e. Click Submit.

f. Optional:  Repeat these steps if you want to add the Portable Web Client to another 
subdomain on your website.

7. Optional:  Create a JavaScript script that uses the  window.postMessage()  method 
(Web API) to define event conditions that trigger SSO authentication in a user interface page 
and returns users to a web client page that you specify.
To redirect users to a web client page, use the following string: "https://<your-
instance>.service-now.com/sn_va_web_client_login.do?
sysparm_redirect_uri=’ + encodeURIComponent(<your-page>)

Note: 
Before you run the script, use the 
com.glide.cs.web_client_login_redirect_urls  system property to 
specify the URLs that can be passed in the script. The redirection works only when you 
specify one or more allowed URLs in the property value. Specify the full redirect URLs or 
the host part of the URL. For example: https://example.com .

Example script

<script>
    window.addEventListener("message", function(e) {
       // redirect to SSO login if the web client logs in but 
 is logged in as a guest user(unauthenticated)
      if(e.data.type==="SESSION_CREATED" && 
 e.data.authenticated === false)
        window.location.href = 
 "https://<your-instance>.service-now.com/sn_va_web_client_logi
n.do?sysparm_redirect_uri=<’ + encodeURIComponent(<your-page>);
 
      // redirect to SSO login if the ServiceNow platform logs 
 out from underneath the web client
      if(e.data.type==="SESSION_LOGGED_OUT")
        window.location.href = 
 "https://<your-instance>service-now.com/"https://<your-instanc
e>service-now.com/sn_va_web_client_login.do?sysparm_redirect_ur
i=’ + encodeURIComponent(<your-page>);
    });
  </script>

In this example, authentication is triggered in the specified instance when 
the SESSION_CREATED or SESSION_LOGGED_OUT events occur. After 
authentication (when the SSO credentials for users are accepted), users 
are redirected to the embedded web client page that you specified in 
sn_va-web_client_login.do?sysparm_redirect_uri=’ + 
encodeURIComponent(<your-page>), as long as you also specified the page URL in 
the com.glide.cs.web_client_login_redirect_urls  property.

What to do next
Add the Portable Virtual Agent web client to a third-party website.

Add the Portable Virtual Agent  web client to a third-party website

To use the Portable Web Client chat widget for Virtual Agent  on third-party web pages, add the 
necessary code to your web page.
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Before you begin
Configure the Portable Virtual Agent web client  prior to completing this topic's steps.

For additional information, review the How to embed Virtual Agent in an external site  article on 
the ServiceNow Community  site.

Role required: virtual_agent_admin or admin

Procedure

Import and instantiate this script reference to the page header to create a ServiceNow  chat 
instance on your external page header:

Note: 
In the script reference example, site1.example.com refers to the URL for your ServiceNow 
instance.

<script type="module" >
      import ServiceNowChat from 
 "https://site1.example.com/uxasset/externals/now-requestor-chat
-popover-app/index.jsdbx?sysparm_substitute=false";
      var chat = new ServiceNowChat({ instance: 
 "https://site1.example.com/", });
    </script>

Tip: 
If your organization uses a custom domain name, input the custom domain name as the 
instance property, rather than the ServiceNow  domain name, to ensure that browser results 
are consistent among multiple browsers.

Example with configuration

const chat = new ServiceNowChat({
 instance: 'https://site1.example.com',
 context: {
  skip_load_history: 1
 },
 branding: {
  bgColor: ' 333',
  primaryColor: ' 000',
  hoverColor: ' EFEFEF',
  activeColor: ' AAA',
  openIcon: 'custom-open.svg',
  closeIcon: 'custom-close.svg',
  sizeMultiplier: 1.6
 },
 offsetX: 50,
 offsetY: 50,
 position: 'left',
 translations: {
  'Open dialog': 'Open chat',
  'Open Chat. {0} unread message(s)': 'Click to open',
  'Close chat.': 'Click to close',
 },
});

JSON configuration schema
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{
    instance: <string> - url to your instance, must be 
 of the same domain (sub-domain)
    context: <object> - sys_parm variables to pass into 
 the iframe
    branding: <object> - branding settings
          bgColor: <rgb|hex> - can take an rgb tuple, 
 ie: '56,56,56' or a 3 or 6 hex color code, ie:  333 or 
  efefef.  background color of button
    primaryColor: <rgb|hex> - font color
    hoverColor: <rgb|hex> - hover background color of 
 button
    activeColor: <rgb|hex> - click / active background 
 color of button
    openIcon: <string> - name of the uploaded custom 
 icon in settings
    closeIcon: <string> - name of the uploaded custom 
 icon in settings
   offsetX: <integer> - distance in pixels the button 
 moves along the x-axis
   offsetY: <integer> - distance in pixels the button 
 moves along the y-axis
   position: <enum: left|right> - position left or 
 right side of screen
   translations: <object> - contains label mappings for 
 translations or label changes
    'Open dialog': <string> - replacement text for 
 accessibility
    'Open Chat. {0} unread messages(s)': <string> - 
 replacement text for tooltip
    'Close chat.': <string> - replacement text for 
 tooltip
}

Embed the Virtual Agent  web client in an external web page (legacy method)

Load the Virtual Agent  web client interface in an external web page by using an inline frame 
element (iframe). You can also optionally enable the single sign-on (SSO) authentication process 
to run automatically for guest users who are using the web client and are not logged in.

Before you begin

Important: 
Consider adding the Portable Virtual Agent  Web Client to your web page instead. It reduces 
code complexity and is easier to implement. It also includes standard chat features, such 
as click actions for launching or closing the chat. For details, see Add the Portable Virtual 
Agent web client to a third-party website.

• In the iframe, you specify the URL of the instance to be embedded. If you're embedding the 
web client on any page that is not on your ServiceNow  instance, the URL must be a custom 
instance URL. Due to increased browser security, the web client may fail to load if you don't use 
a custom URL. To learn more about using custom URLs, see Associating custom URLs to your 
instance .

To use a custom URL, do the following:
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◦ Activate the custom url plugin (com.snc.customurl) in your instance.

◦ Add the custom URL (that you previously purchased and registered) to your instance.

Note: 
The Virtual Agent  web client does not work from an iframe in Safari by default. Apple 
blocks cross-origin iframes (when the domain of the URL used in the iframe does not 
match the domain of the website itself).

• After you embed the Virtual Agent client, you can optionally trigger SSO authentication from 
the web client, but only when your instance is set up to use an external SSO provider. Your 
hosting site must also use the same SSO provider as your instance. For details on setting SSO 
providers, see External single sign-on (SSO) .

To trigger SSO authentication, you create a JavaScript script that defines conditions for 
running authentication and redirects users to a web client page that you specify (see Step 2 
below). You also specify the allowed URLs that can be passed in this script, by identifying them 
in the com.glide.cs.web_client_login_redirect_urls  system property. Specify 
the full redirect URLs or the host part of the URL, such as https://example.com .

Role required: admin

About this task
This procedure requires that you set values for the following two system properties:

• com.glide.cs.embed.csp_frame_ancestors

• com.glide.cs.embed.xframe_options

These properties determine the security policy for the embedded web client, namely how 
browsers render and secure HTML content for Virtual Agent  and Live Agent  chat, in an iframe, 
before you embed the web chat client.

To generate SSO authentication for your guest users, you can create a script that uses the 
window.postMessage()  method (Web API) to trigger authentication and specify the URL 
where users are redirected after authentication. For more information on this method and 
Window objects, see Window.postMessage() .

Note: 
If you're using the Content Management System (CMS) application to create custom 
interfaces for the ServiceNow AI Platform  and ServiceNow®  applications, be aware that it 
does not support Virtual Agent.

Procedure

1. Set both the com.glide.cs.embed.csp_frame_ancestors  and 
com.glide.cs.embed.xframe_options  system properties to specify the HTTP header 
directives for securing the iframe contents.
The HTTP header directives tell the browser whether a page can be embedded on certain 
domains to mitigate clickjacking attempts. Setting both properties ensures that there are 
security directives for major browsers and also older browsers, such as Internet Explorer.

a. In the navigation filter, enter sys_properties.list.

b. In the System Property [sys_properties] table, search for the 
com.glide.cs.embed.csp_frame_ancestors  property by name.
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Note: 
This property sets the source value of the HTTP header directive: Content-
Security-Policy:frame-ancestors<source>. Use the host-source 
value to specify the domains in which the external web page can be embedded. This 
property applies to most major browsers, except for Internet Explorer.

c. Click the property name to open the form and specify the directive values.

System Property: com.glide.cs.embed.csp_frame_ancestors

Field Description

Type string

This is the default value.

Value Specify one or more sources, including:

▪ 'self': Indicates that the origin is the same 
as the page being served. For example, 
if the value is 'self' http://
mywebsite.com, then the iframe is 
embedded within the parent domain as 
well as mywebsite.com. This is the default 
value.

▪ host-source: The domains in which the 
external web page can be embedded. 
Specify the Internet host site by name, 
IP address, or optional URL and/or port 
number. Site address can start with a 
wildcard (asterisk) character. Example 
value: http://*.example.com

▪ scheme-source: A schema. For example: 
http:  or https:

▪ none: No matching URLs.

For more information about source values that you can specify, see CSP:frame-ancestors
and Virtual agent embedded client content security policy (instance security hardening)  in 
Instance Security Hardening Settings .

d. Return to the System Property [sys_properties] table to search for the 
com.glide.cs.embed.xframe_options  property by name.

Note: 
This property sets the value of the of the X-Frame-Options header directive, to indicate 
whether the browser can render an external web page in a frame. Use the default 
sameorigin  value to specify the domains in which the external web page can be 
embedded. This property applies to older browsers, such as Internet Explorer 11.

e. Click the property name to open the form and specify the directive values.
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System Property: com.glide.cs.embed.xframe_options

Field Description

Type string. Default value.

Value Specify a value, including:

▪ sameorigin. Default value. Displays the 
page in a frame that has the same origin 
as the page itself. Example value: allow 
from https://example.com.

▪ deny. Does not display the page in a 
frame.

▪ allow-from uri. Displays the page 
only in a frame on the specified origin.

Note: 
This value no longer works in 
modern browsers.

For more information about source values that you can specify, see X-Frame-Options  and 
Virtual agent embedded client X-Frame-Options (instance security hardening)  in Instance 
Security Hardening Settings .

2. After associating your ServiceNow instance to a custom URL, create the iframe 
element and specify the custom URL in the inline element (iframe) used to embed the 
Virtual Agent  client in an external web page: "https://<your-domain>.com/
sn_va_web_client_app_embed.do"

Note: 
Your instance may have multiple custom URLs, but only one instance URL. You must use 
your custom instance URL only.

For example:

<iframe id="sn_va_web_client"
    title="ServiceNow Virtual Agent Client"
    width="600"
    height="900"
   
 src="https://<your-domain>.com/sn_va_web_client_app_embed.do">
"https://<your-domain>.com/"https://<your-domain>.com/</iframe>

Note: 
Use the ?sysparm_skip_load_history=true  parameter at the end of the URL to 
load the interface without the conversation history.

3. Optional:  Create a JavaScript script that uses the window.postMessage()  method (Web 
API) to define event conditions that trigger SSO authentication in a user interface page and 
returns users to a web client page that you specify.
To redirect users to a web client page, use this string: "https://<your-
instance>.service-now.com/sn_va_web_client_login.do?
sysparm_redirect_uri=’ + encodeURIComponent(<your-page>)
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Note: 
Before you run the script, use the 
com.glide.cs.web_client_login_redirect_urls  system property to 
specify the URLs that can be passed in the script. The redirection works only when you 
specify one or more allowed URLs in the property value. Specify the full redirect URLs or 
the host part of the URL, such as https://example.com .

Example script:

<script>
    window.addEventListener("message", function(e) {
       // redirect to SSO login if the web client logs in but 
 is logged in as a guest user(unauthenticated)
      if(e.data.type==="SESSION_CREATED" && 
 e.data.authenticated === false)
        window.location.href = 
 "https://<your-instance>.service-now.com/sn_va_web_client_logi
n.do?sysparm_redirect_uri="+ encodeURIComponent(location.href);
 
      // redirect to SSO login if the ServiceNow platform logs 
 out from underneath the web client
      if(e.data.type==="SESSION_LOGGED_OUT")
        window.location.href = 
 "https://<your-instance>service-now.com/sn_va_web_client_login
.do?sysparm_redirect_uri=" + encodeURIComponent(location.href);
    });
  </script>

In this example, authentication is triggered in the specified instance when 
the SESSION_CREATED or SESSION_LOGGED_OUT events occur. After 
authentication (when the SSO credentials for users are accepted), users 
are redirected to the embedded web client page that you specified in 
sn_va-web_client_login.do?sysparm_redirect_uri=’ + 
encodeURIComponent(<your-page>), as long as you also specified the page URL in 
the com.glide.cs.web_client_login_redirect_urls  property.

Configure Virtual Agent  for a ServiceNow  mobile application

Virtual Agent  provides optimized templates for the mobile experience. Configure a service portal 
to run Virtual Agent  on a ServiceNow  mobile application.

Before you begin
Install the required plugins:

• Virtual Agent  (com.glide.cs.chatbot)

• Conversational Messaging (com.glide.messaging.awa)

• Core ServiceNow®  mobile  plugins

For more information, see Mobile plugins .

Role required: admin
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Procedure

1. Install the corresponding mobile plugins for each application that you want to use in Virtual 
Agent.
For example, if you're using Virtual Agent  ITSM conversations, install the ITSM Mobile Agent 
(sn_itsm_mobile_agt) plugin as well. For more information, see Mobile plugins for ServiceNow 
Agent .

2. Navigate to All  > Now Mobile App  > Applet Launchers.

3. Click the Homepage  record.

If prompted, click the link at the top of the page to edit the record.

4. Click the Body  tab.

Launcher screen Homepage record

5. Click Chat  under Quick Action Button  to open the record.
If you don't see a Chat entry, add it as follows:
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a. In the Unified Navigation  bar, click the scope icon and change the application scope so that 
it matches the application that contains the record.

b. Click the back button to return to the previous page.

c. Click the Homepage  record.

d. Click the Body  tab.

e. Under Quick Action Button, double-click Insert a new row.

f. Type Chat, and then press Enter or click the save icon.

g. Click Update.

6. Fill in the Chat form as follows.

Note: 
If prompted, click the link at the top of the page to edit the record.

a. In the Function  field, select Agent Chat.

b. Click the info icon  on the Function  field and verify that Chat Launcher  is set in the Type 
field (this is the default setting).
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c. Select the Active  check box.

d. Click Update.

Chat form configuration

Result
Depending on the device and the patch version of the server instance, end users can access the 
Virtual Agent  chat icon in the bottom-right or top-right corner of the app. Tap the plus icon or the 
chat icon to start a conversation.

The topics you create in Virtual Agent Designer  can be used in both the web and mobile clients, 
as well as any other channels you may configure. Virtual Agent  output components are already 
optimized for Android  and iOS, including image and video cards, link unfurling, AI Search results, 
and Virtual Agent notifications.

What to do next
To enable Now Assist  in native Virtual Agent, see Configuring Now Assist in Virtual Agent.

Now Mobile  notification of unread chat and Virtual Agent  messages

When Now®  Mobile  app users navigate away from the app after starting an active conversation, 
they can automatically receive Virtual Agent  mobile push notifications informing them of new, 
unread chat messages and  Virtual Agent  notifications that have arrived.

Now Mobile  users might need to leave an active conversation for various reasons. They could 
be waiting for an available agent and decide to handle other tasks instead. Or, they could 
be engaged in a long-running (asynchronous) conversation and do not need to be online 
concurrently with an agent. Now Mobile  users can check Virtual Agent  push notifications to 
get timely information about their current conversations when they’re away from the app. 
These push notifications enable them to stay engaged with live and virtual agents and avoid 
unnecessary conversation closures (timeouts).
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Enabling Virtual Agent  message push notifications

To receive Virtual Agent  mobile push notifications, your users must enable push notifications for 
the Now Mobile  app on their iOS  or Android  devices.

In base system instances, the Virtual Agent  Message Push notification is automatically enabled 
for all Now Mobile  users. Users can modify their notification preferences  by navigating to All  > 
Self-Service  > My Notification Preferences.

How Virtual Agent  mobile push notifications work

Virtual Agent  push notifications display information about incoming, unread chat messages 
from agents and any Virtual Agent  messages. The push notifications are listed in the notification 
center (lock screen) of mobile devices. Users tap a push notification in the list to open the Now 
Mobile  app and continue the corresponding conversation.
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Example Virtual Agent  push notifications in the Now Mobile  app

Note: 
Virtual Agent  push notifications are not displayed under the notifications  tab in the Now 
Mobile  app. These push notifications also do not generate associated badge numbers 
on the Now Mobile  app icon. However, badge numbers are displayed on the Virtual Agent 
quick launch icon within the app.

To process unread chat or Virtual Agent  messages and deliver them to Now Mobile  users, the 
system does the following:

• Checks which user accounts are registered to receive push notifications.

• Determines the mobile clients (devices) that are not in use.

• Runs the Generate Virtual Agent Push Notification  scheduled job every 60 
seconds to:

◦ Identify and batch new unread messages.

◦ Add unread messages records to the Push Notifications [sys_cs_message_notification] 
table, which generates the Virtual Agent  push notifications.

◦ Delivers Virtual Agent  push notifications to Now Mobile  users away from the app.

Depending on when the Generate Virtual Agent Push Notification 
scheduled job processes new unread messages, push notifications might not arrive in the 
order that they were generated, and it might take slightly longer than one minute for push 
notifications to arrive.

Virtual Agent  push notification message content

The content of Virtual Agent  push notification messages sent to Now Mobile  users reflects the 
actual text from the live or virtual agent. If a text representation of the message, such as a rich 
control, cannot be generated, the text New Message  is displayed instead.
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Note: 
System action messages that are displayed to users during live chat or virtual agent 
conversations are not included in Virtual Agent  push notifications or in the count of 
unread messages. The exception is the system message for the live agent timeout: The 
conversation is timing out, are you still there?  This message is 
sent as a push notification since it is time-sensitive and informs users that the conversation 
might be closed if they do not respond.

View and modify Virtual Agent  style templates

Virtual Agent  provides optimized templates for the mobile experience. You can view and modify 
the style sheets in the Adapter Cards [sys_cs_adapter_card] table.

Before you begin
Role required: virtual_agent_admin or admin

Procedure

1. Click All, and then enter sys_cs_adapter_card.list  in the navigation filter.
The Adapter Cards page opens.

2. Click an entry in the Card Name  column.

3. Click the name of the channel you want to view in the embedded list.
For example, click iOS  or Android Device  to view the corresponding style sheet.

4. Make any changes in the Template Definition  field.

5. Click Update.

Multiple active conversations for Virtual Agent

As of the Washington DC  release, Virtual Agent  (VA) features the ability to have multiple 
conversations at the same time, separated and directed by chosen context.

Overview

Virtual Agent  messages commonly follow one conversation with a shared history that persists 
on all VA clients, and thus all portals. For example, if you’re conversing with Virtual Agent  in 
a Service Portal (SP) portal context, the same conversation is shown in an Employee Service 
Center (ESC) portal. The multiple active conversations feature expands the reach of Virtual Agent 
by eliminating the one-conversation limit. By configuring their Virtual Agent  conversations based 
on context, customers can choose to share or restrict any or all content between concurrent 
conversations on differing portals.

Each Virtual Agent conversation is fully independent, with no overlap between chats. For 
example, a conversation in SP will be entirely different from ESC. Each conversation also has 
its own transcript. You must set up context values for Natural Language Understanding (NLU) 
chats, while Large Language Model (LLM) chats are automatically configured for multiple active 
conversations based on each portal. An administrator can activate an LLM assistant for each 
portal by using guided setup configurations. (For more information on configuring Virtual Agent 
conversations, see Conversational Interfaces Guided Setup.)

Benefits of multiple active conversations

Previously, if a user was engaged in a conversation with a virtual agent, the chat would take 
place in a single context. Switching contexts involved a risk of exposing sensitive information 
by carrying over the entire chat history to the other portal. For example, if you have an HR 
conversation in the HR portal, then brought up an IT request, the chat continues in the IT 
portal. However, this request also brings the HR conversation history into the IT portal with it. 
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Alternatively, admins can activate the skip_load_history  system parameter to avoid 
exposure risk, but the initial conversation closes when the chat continues on the IT portal.

To exclude conversation history between portals, use the following procedure:

1. Navigate to All  > Service Portal  > Agent Chat.

2. Select the Agent Chat Configuration for which you want to set the context value.

3. In the Server Script window, add the line skip_load_history: true  to load 
conversations without the conversation history.

Note: 
The script syntax may differ depending on the configuration.

The multiple active conversations feature bypasses the skip_load_history method, and enables 
continuous engagement with Virtual Agent  chat, by routing selected notifications and topics to 
their configured contexts only. Users don’t need scripting or extensive customization, and they 
can conduct conversations without interruption or information exposure in the wrong context. 
With portals and notification contexts aligned, users receive information appropriate to their 
context, including incident updates and other relevant data.

Considerations for using multiple active conversations

Implementing multiple active conversations should happen in the following order: Admins 
should define portal consumer context values, set or update a default context, activate the 
multiple active conversations system, and finally, configure notifications sent to portals. However, 
if the delivered Service Portal context is sufficient, admins can skip configuring and setting 
values.

Topics can be created within a portal context. If the portal context maps to consumer account 
context, then topics map to consumer account contexts.

Set NLU  portal consumer context values for multiple active conversations

Use context values to determine which portals receive certain messages and notifications for 
users in that portal.

Before you begin
Activate Virtual Agent. For more information, see Activate Virtual Agent.

Configure your Agent Chat system for your portal or portals. See Configure Agent Chat in a 
portal  for more information.

Role required: virtual_agent_admin or admin

About this task
With consumer context added to a portal configuration, that portal acts as context for multiple 
active conversations with Virtual Agent.

Note: 
These instructions are for configuring Natural Language Understanding (NLU) 
conversations. Large Language Model (LLM) conversations are configured for multiple 
active conversations based on portals, with no configuration necessary.

Procedure

1. Navigate to All  > Service Portal  > Agent Chat.

2. Select the Agent Chat Configuration for which you want to set the context value.
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3. In the Server Script window, add the line consumer_account_context: 'VALUE', 
replacing VALUE  with your desired consumer account context.

Server script example

Note: 

The syntax of the account context line depends on how the configuration is set up. For 
example, some configurations use an equal sign versus a colon. In the case of the esc 
context, there are also two relevant chat configurations.

Values that are defined or created in a script aren’t displayed to an admin as a selection 
for use elsewhere in the system.

4. Select Update.

What to do next
Set a default context for your conversations. See Set a default NLU context value for multiple 
active conversations  for more information.

Set a default NLU  context value for multiple active conversations

Use consumer account context values to define where Virtual Agent  messages are directed by 
default when using the multiple active conversations feature.

Before you begin
Define values for portal consumer contexts. For more information, see Set NLU portal consumer 
context values for multiple active conversations.

Configure context values that align Virtual Agent  and your portals. See Configure Agent Chat in a 
portal  for more information.

Role required: virtual_agent_admin or admin.

About this task
You can create as many context values as you need. One consumer account context must always 
be set to Yes  to provide a default content area. The default acts as a fallback for the web client 
when the portal setup doesn’t include context. The default is also used as the context for mobile 
conversations, which only support one conversation at a time. Context values are stored in the 
Conversation Consumer Account Context [sys_cs_consumer_account_context] table. (The CS 
Consumer Account [sys_cs_consumer_account] table Installed with Virtual Agent  shows whether 
third-party users in your instance have a context assigned to them.)
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Note: 
These instructions are for configuring Natural Language Understanding (NLU) 
conversations. Large Language Model (LLM) conversations are configured for multiple 
active conversations based on portals, with no configuration necessary.

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings  > Virtual Agent.

2. Under multiple active conversations, select View settings.

Note: 
The delivered default value for consumer account contexts is sp.

3. Select New.

4. On the form, fill in the fields.

Consumer Account Contexts form

Field Description

Name Name of the context value (also used as 
reference in the backend).

Short Description Description for the context (displayed on 
the Conversational Interfaces  card when the 
default value is shown).

Is Default Consumer Account Context Option to make this context value the default 
for your Virtual Agent  conversations.

Note: 
Only one consumer account context 
can be set as the default. Setting a new 
one as a default automatically resets the 
last context to False.

5. Select Save.

What to do next
Activate the multiple active conversations system. For more information, see Activate multiple 
active conversations in Virtual Agent.

Activate multiple active conversations in Virtual Agent

Use the multiple active conversations system, in combination with defined context values and a 
default portal, to handle concurrent conversations with Virtual Agent.

Before you begin
A default context is necessary to start out with the multiple active conversations system. See Set 
a default NLU context value for multiple active conversations  for more information.

Role required: virtual_agent_admin or admin

About this task
Virtual Agent  includes settings that let multiple conversations be carried out with the same user 
across multiple portals. Users can also receive updates and notifications sent to any number of 
portals (determined by an administrator) anywhere in their instance on ServiceNow AI Platform.
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The multiple active conversations feature is inactive by default in Virtual Agent  until toggled on. 
As of the Vancouver release, multiple active conversations are available through the web client; 
other channels may be incorporated in future.

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings  > Virtual Agent.

2. Under multiple active conversations, select Manage settings.

3. Select Activate.

4. Select Save.

What to do next
With multiple active conversations activated, you can also send notifications from Virtual Agent 
to portals using the feature. See Route Virtual Agent NLU notifications through multiple portals  for 
more information.

Route Virtual Agent  NLU  notifications through multiple portals

Send notifications and other Virtual Agent  messages through as many portals as desired.

Before you begin
The multiple active conversations feature includes the ability to send notifications on incidents. 
You can configure your notifications to go to only one conversation on a specific portal, or to any 
number of concurrent conversations.

Activate multiple active conversations in Virtual Agent

Configure a delivery channel for Virtual Agent notification

Role required: virtual_agent_admin or admin

Note: 
These instructions are for configuring Natural Language Understanding (NLU) 
conversations. Large Language Model (LLM) conversations are configured for multiple 
active conversations based on portals, with no configuration necessary.

Procedure

1. Navigate to All  > sys_notification_va_content.list.
A list of Virtual Agent  Notification Contents appears.

2. Select the Notification Content that you want to send through multiple portals.
For example, to receive comments on Incidents, select the Incident commented  Notification 
Content.

3. Under the Channels  tab, confirm that the Consumer account contexts pane is available after 
activating multiple active conversations for the web client.
The Default Consumer Account Context will be visible in the pane.

Note: 
This string should also match the portal where the conversation will be directed. For 
example, the SP portal will also be the name of the Consumer account context.

4. To add a context, on the Select target record  line, input the string matching the desired 
Consumer account context.
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Note: 
This string should also match the portal where the conversation will be directed. For 
example, the SP portal will also be the name of the Consumer account context.

5. To remove a context, select it in the Consumer account contexts pane, then select the X.

6. Select Update.

Result
Messages with multiple contexts will now be sent through Virtual Agent  to users at their matching 
portals.

Configuring Virtual Agent  notifications

Send ServiceNow  notifications directly to users via the Virtual Agent  chatbot on supported 
messaging channels. Notifications can be simple informational messages for review, or 
actionable messages with buttons that users can select to perform certain actions.

Notifications are sent to recipients via the Virtual Agent  bot in the web client, pre-built messaging 
integrations (for example, SMS Twilio, Slack, Microsoft Teams, Workplace from Facebook 
services, and Facebook Messenger  messaging platform), and custom chat integrations.

Notification functionality is included with the Glide Virtual Agent  (com.glide.cs.chatbot) plugin 
and also with Virtual Agent Lite, which is included with the ServiceNow AI Platform. However, 
Virtual Agent Lite  users can receive only simple notifications, while Virtual Agent  users can 
receive both actionable notifications and simple notifications. Users with no associated 
ServiceNow  profiles in the [sys_user] table can receive non-actionable Virtual Agent  notifications.

How Virtual Agent  notifications work

As an admin, you can define different types of notifications that have specific layouts and 
content. You can also customize certain aspects of notification content, such as the message 
heading and message content.

Simple notifications

The content can be a standard informational message, record card, or an image 
card. Simple notifications are delivered to users immediately, even when they're 
engaged in a conversation with a virtual or live agent.

Actionable notifications

These notifications have buttons that enable the recipient to perform certain 
actions, such as adding a comment or requesting a live agent. When you create 
an actionable notification, you associate an action with a published Virtual Agent 
topic, a scriptable action, or a flow action that handles the action to be performed. 
To encourage users to act on a notification, admin users can choose to remove 
the Skip  option. If the user still doesn’t act, the conversation will be completed as 
inactive.

Note: 
The notifications are actionable only when there is an associated link action to 
its content.

Actionable notifications are delivered to users when they're not in an active 
conversation with a virtual or live agent. A queue stores actionable notifications that 
are waiting to be delivered, for up to eight hours by default.
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Actionable notifications are best suited for conversational purposes, for use cases 
such as:

• Password reset

• Incident update

• Approval request

• Course survey

• Service follow-ups and surveys

• Employee onboarding follow-ups

When a topic conversation completes, Virtual Agent  automatically prompts the user 
to view pending notifications (if any). Admins can suppress this prompt by setting 
the  com.glide.cs.show_pending_notifications_prompt  property 
on the System Properties table to false.

Notifications with dynamic content

You can personalize Virtual Agent  notifications by adding dynamic content to 
message headers and messages. For record- and event-based notifications, you 
use parameter substitution to specify the variables that identify the record values 
(from the notification table) to be included in the content.

Advanced notifications with dynamic content

You can create Virtual Agent  notifications that use a script to add dynamic content 
in message headers and messages. The content can come from multiple data 
sources and include third-party services, such as URL shortening.

Variables in notifications

You can pass information to a completed survey when the notification is triggered. 
Context is defined by the script found in the notification topic. This script cannot be 
modified.

vaVars.global_notification_context =
  JSON.stringify({
    'tableName': table_name,
        'tableSysId': sys_id,
        'actionId': actionId,
        'eventParm1': eventParm1,
        'eventParm2': eventParm2});

Notifications are triggered by records updates or by creating a platform event in the 
event queue. actionId  is the ID number for the action. The platform event takes 
in the eventParm1  and eventParm2  parameters. If a notification is triggered, 
the parameters are passed to the topic. To capture the notification incident number 
in your topic, use the following script.

var notificationContext = 
 JSON.parse(vaVars.global_notification_context);
vaVars.sysId = notificationContext.tableSysId;
varVars.tableName = notificationContext.tableName;

Notification processing

Virtual Agent  notifications have certain processing controls and limitations, such as the 
maximum number of recipients allowed per notification and the number of notifications that 
can be sent per day. The following table identifies these processing controls and the system 
properties that can be used to change their default values.
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Virtual Agent  notification processing controls and limitations

Notification processing control 
or limitation

Default value Associated system property

Maximum number of 
recipients per notification per 
channel

100,000 recipients com.glide.cs.per_notification_user_limit

Max limit: None

Note: 

• If there are more 
recipients than the 
configured number, 
warning messages are 
displayed to reduce 
the recipient list while 
you’re configuring 
the notification and 
when the notification 
is delivered. The 
warnings are displayed 
only when there is 
Virtual Agent content 
associated with the 
notification.

• Recipient limits 
may apply to third-
party delivery 
channels based on 
the level of service or 
subscription.

Maximum number of 
notifications per day, per 
channel

100,000 notifications com.glide.cs.daily_notification_limit 

Max limit: None

Note: 
Rate limits may apply 
to third-party delivery 
channels based on 
the level of service or 
subscription.

Lifespan of actionable 
notifications (a queue stores 
actionable notifications that 
are waiting to be delivered)

8 hours com.glide.cs.idle_actionable_notification_timer

Note: 
You can specify a 
maximum value of 72 
hours.

Allow access to notification 
card content and parameter 

False (not enabled) com.glide.cs.notification_record_access_check
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Virtual Agent  notification processing controls and limitations  (continued)

Notification processing control 
or limitation

Default value Associated system property

substitutions in notification 
headings and messages

Note: 
This property does 
not apply to advanced 
notifications.

Notification experience for end users

The notification experience for end users depends on the type of notification that they're 
receiving. End users can also manage how their notifications are delivered by subscribing to or 
unsubscribing from notifications.

• Simple message notifications - These notifications are delivered immediately to the end user, 
even when the user is chatting with a bot or live agent. The user sees the incoming message 
but can continue with the current conversation.

• Actionable notifications - These notifications are delivered only when the user is not in an 
active conversation with a virtual or live agent. When users complete their conversation with 
a bot or live agent, they can use the Show notification  command to view a list of pending 
notifications, which displays the heading of each notification. Users can select a pending 
notification to review, then perform the appropriate action for the notification, or skip the 
action.

User subscriptions for notifications

End users can subscribe or unsubscribe to notifications on the channel that they're using. For 
example, the chat menu provides a toggle switch that users can use to subscribe or unsubscribe 
to notifications on the web channel.

In the conversational integrations for Slack, Microsoft Teams, Workplace from Facebook 
services, end users manage their notification subscriptions by using the Subscribe  and 
Unsubscribe  commands.

What to do next

Create Virtual Agent  notifications

Create a notification that is sent directly to users via the Virtual Agent  chatbot. The notification 
specifies when users receive the notification (triggers for the notification) and who receives it 
(recipients with and without accounts in the User [sys_user] table).

Before you begin
Role required: virtual_agent_admin or admin

Procedure

1. Navigate to All  > System Notification  > Provider  > Notifications  and select New.

2. On the form, fill in the fields.
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Notifications form

Field Description

Name Name of the notification.

Table Table to receive notifications about.

Application Application scope of the notification.

Type Type of the notification.

Category Category of the notification. For Virtual Agent, it's chat.

Active Option to activate the notification. The notification is active by 
default.

Trigger

Triggered By System action that triggers the notification. You can choose to 
send the notification after a record is changed or after an event is 
triggered.

Inserted
Option to send the notification after a record is inserted.

This field appears when you select Record Change  in the Triggered 
By  field.

Updated
Option to send the notification after a record is updated.

This field appears when you select Record Change  in the Triggered 
By  field.

Event
Event that triggers the notification. For example, to send a notification 
after an incident is closed or resolved, you would select the 
incident.inactive  event. By default, this event is logged in the 
system each time a user resolves or closes an incident.

This field appears when you select Event  in the Triggered By  field.

Conditions Filter to specify the table records that users receive notifications 
about. For example, to send notifications about top-priority incidents, 
you would select Incident [incident]  in the Table  field and set the 
conditions to [Priority] [is] [1 - Critical].

Recipients

Users Users who receive the notification.

Add users from the static User ([sys_user] table or its extension 
tables) to define recipients for the notification.

Note: 
You can define the recipients for notifications only for chat 
channels using this field.

Recipients in fields Record fields that include recipients who receive the notification. 
For example, to send the notification to the record assignee, select 
Assigned to.
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Field Description

Add recipients from the User [sys_user] table or its extension tables 
to trigger the notification.

Note: 
You can define the recipients for notifications for both chat 
channels and messaging channels using this field.

Is originating user 
included?

Option to include the user who changed the record or triggered the 
event.

3. Select Submit.

Note: 
Use the Submit  button for Virtual Agent  notifications. The Submit and Add Common 
Content  button is for other use cases.

What to do next

• Create additional recipients for Virtual Agent notifications.

• Define the notification contents.

Create additional recipients for Virtual Agent  notifications

Create and define additional recipients for a Virtual Agent  notification to be delivered on chat 
channels or messaging channels.

Before you begin
Role required: admin

About this task

• The admin can define recipients under the Additional Recipients related list for messaging 
channels.

Note: 
Selecting the channel (chat channel or messaging channel) is a prerequisite to defining 
the content for the notification.

• The admin can define recipients under the Additional Recipients related list for chat and 
messaging channels using a dynamic condition.

Procedure

1. Navigate to All  > System Notification  > Provider  > Notifications  and select the notification 
that you want to create additional recipients for.

2. In the Additional Recipients related list, click New.

3. On the form, fill in the fields.

Additional Notification Recipients form

Field Description

Notification Identifier of the notification.
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Field Description

The notification name is auto-populated.

Recipient Table The scope of the recipient record for the 
notification.

The Recipient Table  field is auto-populated 
with the user [sys_user] as the default value.

Application The scope of the recipient record.

Active Option to activate the notification for the 
defined additional recipients.

Static Recipients Names of the recipients from the scope of the 
selected recipient table.

Dynamic Recipients

Dynamic Conditions Dynamic filter conditions for the defined 
recipients.

The dynamic condition is applicable for both 
messaging and chat channels.

This dynamic condition enables you to define 
the recipients list for a group of users to send 
a notification.

Click the refresh icon ( ) next to the records 
match condition  link to update the exact 
number of records matching the latest filter 
condition. By default, it shows the total 
number of records in the current table.

Note: 
Only one active record can be added 
for a particular recipient table. If you 
want to add another record for the 
recipient table, you must deactivate the 
current record.

4. Click Submit.

Define Virtual Agent  notification contents

Create the content for a Virtual Agent  notification delivered in a chat or messaging channel.

Before you begin

• Images for image cards must be 400 pixels wide or larger and must be 
in .jpg, .png, .bmp, .gif, .ico, or .svg format.

• If you're upgrading from an earlier release and want ACLs observed for data 
displayed in record cards and parameter substitutions in chat notifications, set the 
com.glide.cs.notification_record_access_check  system property to true. The 
default value for this system property is false, which means that data is delivered regardless of 
the user's access level.
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Note: 
This property does not apply to advanced notifications.

• Role required: virtual_agent_admin or admin

About this task
You can personalize Virtual Agent  notifications by using parameter substitution to add 
dynamic content to the message header and message. When adding dynamic content to your 
notifications, you specify the variables that identify the record values to be included in the 
content. You can add dynamic content to the following types of notifications:

• Record-based notifications - Use the ${<variable_name>}  format in your content to 
specify a variable that represents a record value from the table used for the notification. For 
example, if you want to customize the message heading for a notification that uses the Incident 
table and you want to include the incident Priority  in the message, use the Select variable 
column to select the variable for incident priority.

• Event-based notifications - Use the ${event.parm1}  and ${event.parm2}  format to 
specify event-specific parameters that pass record information in the notification content. To 
learn more about event parameters and how they work, see Events .

• Advanced notifications - Modify a script provided for advanced notification use cases to 
specify dynamic content from different data sources and identify third-party services, such as 
URL shortening for streamlining links in the content.

Procedure

1. Navigate to All  > System Notification  > Provider  > Notifications  and select the notification for 
which you're defining or updating content.

2. Do one of the following:

◦ If you're defining new content, navigate to the Notification Contents  related list, select New 
Provider Content, and go to step 3.

◦ If you're updating content, navigate to the Notification Contents  related list, select the 
content to be updated, and go to step 4.

3. Select the Virtual Agent  content type:

◦ Virtual Agent Content - Chat: The notification is for chat channels.

◦ Virtual Agent Content - Messaging: The notification is for a messaging channel, such as 
SMS.

Notification content

4. Provide or update the notification content:

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1747

https://www.webstg.servicenow.com/docs/access?context=events&version=washingtondc&pubname=washingtondc-build-workflows&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=events&version=washingtondc&pubname=washingtondc-build-workflows&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=events&version=washingtondc&pubname=washingtondc-build-workflows&ft:locale=en-US


a. On the form, fill in the fields for the chat or messaging notification:

Notification Content - Virtual Agent  Chat or Virtual Agent  Messaging

Field Description

Name Name of the notification content.

Notification Notification that is associated with the content. This field is 
populated automatically with the notification that you created.

Type Notification layout:

▪ Simple: A message-only notification, that contains information for 
review.

▪ Record card: A notification that contains information about a 
particular record in a table.

▪ Image card: A notification that contains images.

Table (For Record Cards) Table to receive notifications about. This field is 
populated automatically with the table defined in the notification.

Fields (For Record Cards) Fields to be displayed in the notification. For 
example, if you select Comments and Work notes, the notification 
includes the comments and work notes that users have added to 
the record.

Application Application scope of the notification content.

Active Option to activate the notification content.

Enable link (For Record Cards) Option to add a link to the record.

Advanced Option that opens the script editor for entering a script that returns 
dynamic content for notification heading and message content 
pulled from multiple data sources.

Script
(For advanced notification content) Script that you can edit to 
specify dynamic content from various data sources, including third-
party services (such as URL shortening), to be used in the message 
heading and message content.

Message heading Text that appears at the top of the message. The default message 
heading is: A notification has arrived. You can 
continue the conversation after viewing the 
notification.

If you want to create a custom heading with dynamic content, enter 
the heading text and specify the variables used in the text:

▪ For record-based notifications: Expand the Select variables 
column and choose the variables for the record values to be 
included in the heading. The variables map to records in the 
table used for the notification. For example: An incident 
has been assigned to you with Priority:
${priority}
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Field Description

▪ For event-based notifications: Specify the ${event.parm1} 
and ${event.parm2}  variables to identify event-specific 
parameters that pass record information in the notification 
content.

Message Content of the message with rich text format.

If you want to create a custom message with dynamic content, enter 
the message text and specify the variables used in the text:

▪ For record-based notifications: Expand the Select variables 
column and choose the variables for the record values to be 
included in the message. The variables map to records in 
the table used for the notification. For example: Here's a 
brief description of your assigned incident:
${short_description}

▪ For event-based notifications: Specify the ${event.parm1} 
and ${event.parm2}  variables to identify event-specific 
parameters that pass record information in the notification 
content.

A notification message defined with rich text format 
is displayed in bold, italics, link (url), and unordered 

list.

When users click the URL in the message, they are redirected to the 
destination as per the portal configuration.

Image Source (For Image Cards) Option for selecting the image to be displayed in 
the notification:

▪ Upload image: Add the image by uploading.

▪ URL: Specify the URL for the image.

Image (For Image Cards) Image displayed in the card.

▪ To add the image, select Click to add. From the file finder, choose 
your image file and select OK.

▪ To change the image, select Update. From the file finder, select 
the new image file and select OK.

▪ To remove the image, select Delete. The file is immediately 
deleted.
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Field Description

Image alt text (For Image Cards) Alternative text for the image to be displayed in 
the card.

Note: 
To create or update the messaging notification details, navigate to the Delivery 
Channel  related list and complete the form. For more information, see Configure a 
delivery channel for Virtual Agent notification.

b. Select Submit  or Update.

What to do next

• To configure a delivery channel, see Configure a delivery channel for Virtual Agent notification.

• If you're creating an actionable notification, see Define the actions.

Configure a delivery channel for Virtual Agent  notification

Configure a delivery channel for Virtual Agent  notifications by specifying the messaging channel 
information to send notifications to users.

Before you begin
Ensure that a messaging channel is configured in your instance. Virtual Agent  admins can only 
select one or more chat channels for the notification from the list of chat channels associated 
with the instance.

Role required: virtual_agent_admin

About this task
Use the delivery channel to support multiple channels for the same notification content. 
The procedure to configure delivery channels depends on the channel type. There are two 
notification channel types: Messaging channels and chat channels. For more information about 
channels, see Channels in Conversational Interfaces.

Delivery channels are also part of multiple active conversations in Virtual Agent. See Route 
Virtual Agent NLU notifications through multiple portals  for more information.

Procedure

1. Navigate to All  > System Notification  > Provider  > Notifications.

2. Select the notification for which you want to define or update content.

3. In the notification Contents related list, open the notification content.

4. Follow the procedure according to the channel type for the notification that you're configuring.

◦ To update delivery channels for messaging content, select New  in the Delivery Channels 
related list.

◦ To update delivery channels for chat content, select the Add/Remove multiple  option in the 
Delivery Channels related list.
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Use the arrows to add or remove specific delivery channels from your Selected Delivery 
Channels list. When you've defined all applicable delivery channels, select Save.

Note: 
If no specific chat channel is defined, notifications are triggered to all available chat 
channels by default. Virtual Agent  admins can modify the chat channels associated 
with a notification at any time.

5. On the form, fill in the fields.

Delivery channel form

Field Description

Notification Content Reference of the notification content pre-
populates for the delivery channel.

Active Option to activate the delivery channel.

Connection Connection record for the messaging 
channel configured in the instance.

Send From Provider application for the selected 
messaging channel.

Send To (Table) Name of the table that you want to send the 
notifications to.

Send To (Field) Name of the field that you want to send the 
notifications to. This field is optional.

6. Select Submit  (new notification records) or Update  (existing notification records).

Define Virtual Agent  notification actions

Create the actions for a Virtual Agent  chat or messaging channel to send actionable notifications.
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Before you begin

• An action requires an associated, published (active) Virtual Agent  topic, a Scriptable action, or 
a Flow action which can perform the action represented by a button in the notification, such 
as talk to an agent (live agent support) or bot feedback (Virtual Agent  feedback). Consider 
working with your topic authors to determine the appropriate topics and corresponding 
actions. For more information about designing the Virtual Agent  topics, see Getting started 
with Virtual Agent Designer.

Note: 
Scriptable actions and Flow actions are asynchronous and are executed when you select 
the action without a Virtual Agent  topic. You can select either an existing flow that is 
defined or coordinate with the flow authors to send actionable notifications.

• Role required: virtual_agent_admin or admin

Procedure

1. Navigate to All  > System Notification  > Provider  > Notifications  and select the notification for 
which you are defining actions.

2. Navigate to the Notification Actions  related list and select New Provider Action.

3. Select a notification action.

Select notification action

4. On the form, fill in the fields to define the notification actions.

Notification Content - Actions

Field Description

Name Name of the notification action. For example, Talk to an agent.

Notification Notification that is associated with the action. This field is populated 
automatically with the notification that you created.

Async Option to enable the action execution without blocking the current 
request.

Both Script and Flow actions in Virtual Agent  are asynchronous.

Model Type Type of actions that are configured. For example, NLU/Keyword topic 
or LLM topic.

If a user selects LLM, that action will be sent to an LLM enabled 
Virtual Agent. If NLU is selected, that action will only be for an NLU 
enabled Virtual Agent.

Topic Virtual Agent  topic that handles this notification action.
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Field Description

Note: 
Virtual Agent  Pro is required to send a topic with actionable 
notification.

Script Script to execute the notification action.

The script filed is available only when you select Scriptable 
notification action.

Note: 
The Scriptable Action is available only for Virtual Agent  Pro 
users.

Application Application scope of the notification content.

Active Option to activate the notification content.

Choose Flow or Action

Flow Flow to trigger the sequence of the notification action.

Note: 

◦ You cannot choose the flow if you provided the action.

◦ The Flow field appears only when you select Flow notification 
action.

◦ The Flow Action is available only for Virtual Agent  Pro users.

Action Action to use the correct table and field configuration for the 
notification action.

Note: 

◦ You cannot choose the action if you provided the Flow.

◦ The Action field appears only when you select the Flow 
notification action.

◦ The Flow Action is available only for Virtual Agent  Pro users.

Inputs

Script Script to pass inputs to a flow action.

This Script field appears when you select the Flow notification action.

5. Select Submit.

6. To define another action for the notification, repeat steps 3 through 5.

What to do next
Define link actions to notification content.
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Define the Virtual Agent  link actions to notification content

Create the link actions for Virtual Agent  notification content to be delivered in a chat or 
messaging channel as actionable notifications.

Before you begin

• Ensure that you have activated the Glide Virtual Agent  plugin (com.glide.cs.chatbot).

Note: 
Only Virtual Agent  Pro customers can associate actions with notification contents and 
receive actionable notifications.

• Role required: virtual_agent_admin or admin.

About this task
Notification content, with no associated link actions, is delivered as a non-actionable notification.

Procedure

1. Navigate to All  > System Notification  > Provider  > Notifications  and select the notification for 
which you're defining the link actions.

2. In the Link Actions related list, select New.

3. On the form, fill in the fields.

Actionable Content form

Field Description

Name Name of the link action.

Actions Notification action that the link action is 
created to.

You can select one or more notification 
actions for a notification and also put them in 
the order that you want them to be shown on 
the notification.

Actions listed in event parm1 Actions listed in an event parameter.

Users and actions cannot both be passed 
into the parameter. For example, if you input 
a sys_id of a user in event param1, the user is 
considered in the output.

Application Application scope of the notification content.

Notification Notification that is associated with the 
content. This field is populated automatically 
with the notification that you created.

Content Notification content for the link action 
created.

Active Option to activate the notification content.

Actions listed in event parm2 Actions listed in an event parameter.
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Field Description

Users and actions cannot both be passed 
into the parameter. For example, if you input 
a sys_id of a user in event param2, the user is 
considered in the output.

4. Select Submit.

5. To define another link action for the notification content, repeat steps 3 and 4.

Note: 
Only a single notification with active content is supported for a provider. However, if the 
content for the notification is not active, you can define the secondary content for the 
notification and make that content active.

6. Optional:  To remove the Skip  action from an actionable notification, do the following steps:

a. Select the notification and open the Link Actions to Content related list.

b. Select the Actionable Content and select the Disable skip  option.

Note: 
This option only displays when the Content Type is Virtual Agent.

What to do next
Enable Virtual Agent  notifications. For more information, seeEnable Virtual Agent  notifications.

Enable Virtual Agent  notifications

Enable Virtual Agent  notifications so that your end users can receive notifications in supported 
Virtual Agent  channels.

Before you begin
Role required: virtual_agent_admin or admin

Procedure

Enable notifications for your users in the appropriate channel:

Channel Description

Web client

a. Navigate to All  > Conversational Interfaces  > 
Settings.

b. Select Virtual Agent.
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Channel Description

c. Under Notifications, slide the Use notifications 
toggle switch to enable notifications.

Note: 
You can also change the notification text color 
and background in chat branding configurations. 
For details, see Set up your Virtual Agent bot's 
branding.

Slack, Microsoft Teams, or Workplace 
messaging integrations a. Navigate to All  > Conversational Interfaces  > 

Channels and Integrations.

b. For the appropriate messaging integration, select 
Enable notifications for all users.

Custom chat integration a. Navigate to All  and in the filter navigator, enter 
sys_cs_channel.list.

b. In Messaging Channels, select the custom 
integration record to update.

c. Select Enable Notifications  to activate notifications.

d. Select Update.

For more information on configuring custom chat 
integrations, seeConversational custom chat 
integrations.

Notifications are sent to recipients via the Virtual Agent  bot in the channels that you enabled.

Create cross-scope access privileges for topic blocks and custom controls

Enable topic authors and developers to access Virtual Agent  topic blocks and custom controls 
from other scoped applications.
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Before you begin
Role required: admin

About this task
Developers and topic authors may need to access topic blocks  and custom controls  created 
in other application scopes. To give them access, define cross-scope privilege records for the 
appropriate applications. For more information on cross-scope privileges, see Cross-scope 
privilege record .

Procedure

1. Activate the Virtual Agent  conversation plugins for the applications that are the source 
and target scopes, for example the CSM (com.sn_csm.virtualagent) or ITSM Virtual Agent 
(com.snc.itsm.virtualagent) plugins.

2. Set your application scope (the Source scope requesting access) using the application 
picker .

3. Navigate to All  > System Applications  > Application Cross-Scope Access  and select New.

4. On the Cross scope privilege form, complete the following fields.

Field Value

Source scope Application requesting access to another application's 
resources.

Target Scope Application whose resources are being requested (the 
scope with the topic blocks or custom controls).

Target Name Name of the object being requested: sys_cs_topic

Target Type Table

Operation Read

Status Authorization for this record: Allowed

5. Select Submit.

Result
The cross-scope privilege is listed in the Cross scope privileges [sys_scope_privilege] table. 
Topic authors or developers can access the topic blocks or custom controls from the target 
scope.

Configure Natural Language Understanding  in Virtual Agent

Configure Natural Language Understanding  (NLU) in Virtual Agent  to identify the NLU  service 
provider for your instance. You can also specify the languages of NLU  models used during 
conversation design, based on the languages supported by your NLU  provider and the 
ServiceNow AI Platform®.

Before you begin
You can select only one NLU  service provider for your instance. Virtual Agent  supports the 
following NLU  services:

• ServiceNow NLU  (default): Create your models, intents, and entities in Virtual Agent Designer 
and NLU Workbench.

• IBM Watson Assistant: Configure the IBM Watson Assistant intent and entity integration  so 
that Virtual Agent  can access IBM Watson Assistant  NLU  model information.
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• Microsoft LUIS: Configure the Microsoft LUIS Intent and Entity integration  so that Virtual Agent 
can access Microsoft LUIS  NLU  model information.

• Google DialogFlow Essentials (ES): Configure the Google DialogFlow ES intent and entity 
integration  so that Virtual Agent  can access Google Dialogflow  ES NLU  model information.

The Activate  toggle switch for NLU  is toggled on for all new Virtual Agent  activations and the 
NLU Service Provider  defaults to ServiceNow NLU. The Activate  toggle switch is toggled off 
for Virtual Agent Lite. If you upgraded from the previous release, Virtual Agent  retains the NLU 
settings and integration information for your NLU  service provider.

Role required: virtual_agent_admin or admin

About this task
The NLU-enabled topics that you preview, create, or update in Virtual Agent Designer  must 
use NLU  models created in the NLU  service that you select here. For example, if you specify 
ServiceNow  as the service provider, you can view and access topics that use ServiceNow  NLU 
model groups.

Similarly, to work on NLU  topics in multiple languages, the languages must be enabled in your 
NLU  service and added to your model groups. For more information, see Multilingual model 
management .

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. Click Virtual Agent.

3. Under Natural Language Understanding  (NLU), click View Settings.

4. On the form, fill in the fields.

Natural Language Understanding (NLU) form

Field Description

NLU Service 
Provider

Available NLU  service providers for intent and entity extraction.

The Supported NLU  Languages list is displayed. It shows all of the language 
plugins that have been installed. For ServiceNow NLU, English is enabled to 
true  by default.

This field is automatically set to ServiceNow NLU.

Ask user 
if topic VA 
chose is 
correct

Option to prompt the user to confirm that the matched intent is correct. This 
option enables user confirmation only on initial intent discovery.

When enabled, Virtual Agent  asks the user for confirmation before continuing 
to the automatically selected topic content. Enabling this field triggers the 
Intent confirmation message  field.

User confirmation example
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Field Description

If the user selects No  for an initial intent, then Virtual Agent  runs the global 
fallback topic. If the user selects No  for an automatically selected intent in mid-
topic, then Virtual Agent  returns to the topic that the user was in.

Ask user if 
switched 
topic is 
correct

Option to prompt the user to confirm that the switched intent is correct. This 
option is enabled by default and prompts user confirmation only when the user 
triggers an intent switch in mid-topic.

When enabled, Virtual Agent  asks the user for confirmation before continuing 
to the switched topic content. Enabling this field triggers the Intent 
confirmation message  field.

5. Edit the Intent confirmation message  field, if needed.

Text entered in this field is shown to the user to confirm that the matched intent is correct.

6. If you plan to use language-specific NLU  models, enable the languages in the Supported NLU 
Languages list.
A language is enabled if the Enabled column displays true. For more information, see Enable 
NLU languages in Virtual Agent settings.

7. Click Save.

Result
When you create or update a topic in Virtual Agent Designer, you can choose NLU  models 
available for your specified NLU  provider and the specified languages, if applicable. You can also 
set the NLU  entity properties for the input controls that you add to your topic flow.

Configure IBM Watson Assistant as the NLU provider for Virtual Agent

Use the intents, entities, and utterances defined in IBM Watson Assistant  and apply them as an 
NLU model for your Virtual Agent  conversations.

Before you begin
In IBM Watson Assistant, do the following:
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• In your IBM  account, create a Resource Link  in the AI (Artificial Intelligence) category. Once 
you have created the Resource Link, you should see the API key and URL:

• In your workspace, define the intents, entities, and utterances for your NLU model.

• Locate your workspace credentials and copy the workspace Password, which you must 
provide when setting your credentials during configuration.

In your ServiceNow  instance, make sure that the Glide Virtual Agent  plugin (com.glide.cs.chatbot) 
is activated. This plugin installs the proxy agent for the IBM  Watson Natural Language 
Understanding server plugin (com.glide.nlu.ibmwatson.intent.discovery), which is needed for this 
integration.

Role required: admin

About this task
Configuring the IBM Watson Assistant  integration involves providing IBM Watson Assistant 
credentials for authentication. You can set only one NLU service provider for your instance.

Note: 
If you upgraded from a previous release, the upgrade process automatically retains the IBM 
Watson Assistant  workspace Password  that you provided.

As of the Quebec  release, Virtual Agent  supports legacy version 1 URLs only:

• Models: https://<IBM HOST>/assistant/api/{{api_version}}/
workspaces?version={{published_version}}

• Intents: https://<IBM HOST>/assistant/api/
{{api_version}}/workspaces/{{model_id}}/intents?
version={{published_version}}&page_limit=1000
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• Entities: https://<IBM HOST>/assistant/api/{{api_version}}/
workspaces/{{model_id}}/entities?version={{published_version}}

• Prediction: https://<IBM HOST>/assistant/api/{{api_version}}/
workspaces/{{model_id}}/message?version={{published_version}}

Procedure

1. Set the IBM  Watson endpoint in your ServiceNow  instance for each of the following HTTP(s) 
Connections records:

◦ IBM  Watson NLU Models

◦ IBM  Watson NLU Intents

◦ IBM  Watson NLU Entities

◦ IBM  Watson NLU Prediction

a. Navigate to All, and then enter http_connection.list  in the filter.

b. In the HTTP(s) Connections page, select an IBM  Watson entry in the Name column to open 
the record.

c. Edit the URL in the Host  and Base path  fields to reflect the endpoint in your IBM  Watson NLU 
account.
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d. Select Update.

e. Repeat these steps for the remaining IBM  Watson records.

2. Add the IBM  Watson NLU API key in your ServiceNow  instance for each of the following Basic 
Auth Credentials records:

◦ IBM  Watson NLU Models

◦ IBM  Watson NLU Intents

◦ IBM  Watson NLU Entities

◦ IBM  Watson NLU Prediction

a. Navigate to All, and then enter basic_auth_credentials.list  in the filter.

b. In the Basic Auth Credentials page, select an IBM  Watson entry in the Name column to open 
the record.

c. In the Password  field, enter the IBM  Watson NLU API key.

d. Select Update.

e. Repeat these steps for the remaining IBM  Watson records.

3. Make the IBM Watson NLU service active.

a. Navigate to All, and then enter open_nlu_driver.list  in the filter.

b. In the Open NLU Drivers table, locate the IBM Watson Script record and in the Active  field, 
set the value to true.
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Activating this setting adds IBM Watson - Script active  to the list of available NLU services in 
Virtual Agent  settings.

4. To enable NLU in your instance, navigate to Conversational Interfaces  > Settings, and then do 
the following:

a. Click Virtual Agent.

b. Under Natural Language Understanding (NLU), click View Settings.

c. Slide the Activate  toggle switch to enable Natural Language Understanding.

d. In the NLU service provider  list, select IBM Watson - Script.

e. If you plan to use language-specific NLU models, enable the languages in the Supported 
NLU Languages list.
A language is enabled if the Enabled column displays true. For more information, see Enable 
NLU languages in Virtual Agent settings.

f. Click Save.

IBM Watson Assistant is the NLU service provider for your instance.

Configure Microsoft LUIS  as the NLU provider for Virtual Agent

Use the intents, entities, and utterances defined in a Microsoft Language Understanding 
Intelligent Service (LUIS) application and apply them as an NLU model for your Virtual Agent 
conversations.

Before you begin
In Microsoft LUIS, do the following:

• Sign in to the LUIS portal and create an application to be used as an NLU model  (requires a 
Microsoft Azure  account.)

• Locate and copy these Microsoft LUIS  keys:

◦ Authoring key that was automatically generated when you created your Microsoft LUIS 
account. The authoring key provides the authentication needed for your LUIS  applications 
and for creating, training, and publishing them. You can find the authoring key by signing into 
LUIS, selecting your user account, and opening Account Settings.
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◦ Prediction endpoint runtime key that you assigned to the resource for your Microsoft LUIS 
application. Virtual Agent  accesses the LUIS  runtime query prediction endpoint through this 
key.

Note: 
If you are using more than one LUIS  application (NLU model), you must provide the 
prediction endpoint runtime key for each application that you create.

In your ServiceNow  instance, do the following:

• Make sure that the Glide Virtual Agent  plugin is activated, as it installs the Proxy 
Agent to the Microsoft LUIS  Natural Language Understanding server plugin 
(com.glide.nlu.msluis.intent.discovery) needed for this integration. If you upgraded from a 
previous release, the upgrade process automatically retains the LUIS  keys that you provided.

• Role required: admin

About this task
You can set only one NLU service provider for your instance.

Procedure

1. To set the credential passwords for the LUIS  NLU model, entities, intents, and prediction 
information, do the following:

a. Navigate to All, and then enter http_connection.list  in the filter.

b. In the HTTP(s) Connections page, select MSLuisNLUModels  in the Connection alias column 
to open the record.

c. In the Connection & Credential Aliases for MSLuisNLUModels page, go to the Connection 
Attributes related list.

d. Find the Credential Password attribute, and then double-select in the Default value  column 
to edit the value.
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e. Enter the MS LUIS authoring key  in the Default value  field, and then select the save icon.

f. Return to the HTTP(s) Connections page and repeat these steps to add the MS LUIS 
authoring key  as the default value in the following Connection aliases:

▪ MSLuisNLUCustomEntities

▪ MSLuisNLUPrebuiltEntities

▪ MSLuisNLUIntents

▪ MSLuisNLUPrediction
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Note: 
Repeat these steps for each Microsoft LUIS  application that you use as an NLU model. 
Each application has its own prediction endpoint runtime key that you must provide.

2. Make the LUIS  NLU service active.

a. Navigate to All, and then enter open_nlu_driver.list  in the filter.

b. In the Open NLU Drivers table, set the Active  field value for the MS Luis Script  record to 
true.

Note: 
Activating this setting adds MS Luis - Script  to the list of available NLU services in 
Virtual Agent  settings.
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3. To enable NLU in your instance, navigate to Conversational Interfaces  > Settings, and then do 
the following:

a. Select Virtual Agent.

b. Under Natural Language Understanding (NLU), select View Settings.

c. Slide the Activate  toggle switch to enable Natural Language Understanding.

d. In the NLU Service Provider  list, select MS Luis - Script.

e. If you plan to use language-specific NLU models, enable the languages in the Supported 
NLU Languages list.
A language is enabled if the Enabled column displays true. For more information, see Enable 
NLU languages in Virtual Agent settings.

f. Select Save.

Microsoft LUIS  is now the NLU service provider for your instance.

Configure Google Dialogflow  ES as the NLU provider for Virtual Agent

Use the intents, entities, and utterances defined in Google Dialogflow  ES. Apply them as an NLU 
model for your Virtual Agent  conversations.

Configuring the Google Dialogflow  ES integration involves providing Google Dialogflow 
credentials for authentication. You can set only one NLU service provider for your instance.

Requirements

This NLU configuration requires the following:

• A Washington DC  ServiceNow  instance

• A Google Dialogflow  ES agent with defined intents, entities, and utterances

For more information, see the Google Dialogflow ES documentation .

Note: 
A Google Dialogflow  agent is similar to a ServiceNow  model. Currently, Virtual Agent  only 
supports one Google Dialogflow  ES agent per instance.

• Access to the Google Cloud  platform

• The Glide Virtual Agent  [com.glide.cs.chatbot] plugin must be installed on your ServiceNow 
instance.

The following plugins are installed with Glide Virtual Agent  by default:

◦ com.snc.integration.sso.multi.installer: Integration - Multiple Provider Single Sign-On Installer

◦ com.glide.nlu.googledialogflow.es.intent.discovery: Proxy agent to the Google Dialogflow  ES 
Natural Language Understanding server

Create a service account and private key in Google Dialogflow  ES

To use Google Dialogflow  as your NLU provider for Virtual Agent, create a service account and 
private key for your agent in Google Dialogflow.
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Before you begin
Create an agent in Google Dialogflow.

Role required: admin

Procedure

1. Log in to your Google Dialogflow  account.

2. Click the agent settings icon, and then click the project ID on the General  tab.

3. On the Google Cloud  dashboard, click Go to project settings.
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4. On the IAM & Admin page, click Service Accounts.

5. Click + Create Service Account.

6. Provide a name, and then click Create and Continue.

7. Under the Grant this service account access to project section, select Owner  as the role.
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8. Click Continue.

9. Click Done.

10. In the Email  column, click the link for the record.

The Service account details page opens.

11. Copy the Email and the Unique ID and save them for a later step.
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12. On the Service account details page, click the Keys  tab.

13. Click Add Key  > Create new key.

14. When prompted for the key type, select P12, and then click Create.
The P12 file is downloaded to your computer.

15. Make note of the private key password (notasecret).
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You will need this password in a later step.

Private key password example

Generate a Java Keystore (JKS) file and configure security on your ServiceNow  instance

To use Google Dialogflow  as your NLU provider for Virtual Agent, use the private key you 
downloaded to generate a JKS file and set up authentication in your ServiceNow  instance.

Before you begin
Make sure the Java Development Kit (JDK) is installed on the system.

Role required: admin

About this task

Note: 
Google Dialogflow  uses OAuth2.0 for authentication.

Procedure

1. Open a command shell window.

2. To create a JKS file from the P12 file, do the following:

a. Run the following command:

keytool -importkeystore 
 -srckeystore /local_dir/myprivatekey.p12 -srcstoretype 
 pkcs12 -destkeystore /local_dir/myprivatekey.jks 
 -deststoretype JKS

In this example, /local_dir/myprivatekey.p12  points to the private key that you 
downloaded in the previous step.

b. When prompted, enter notasecret  for the destination keystore password and the source 
keystore password.
notasecret  is the private key password you noted from the previous step. You will enter 
this password three times.

A JKS file is created in the same directory.

3. In your ServiceNow  instance, add the JKS file to the Google Dialogflow  X.509 certificate record:
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a. Navigate to All, and then enter sys_certificate.list  in the filter.

b. Select Google Dialogflow  X.509 Certificate to open the record.

c. On the form, fill in the fields as follows.

Field Value

Type Select Java Key Store.

Key store 
password

Enter the private key password that you specified when creating the JKS 
file (notasecret).

Active Select this option to activate the certificate.

d. Select the attachment icon and upload the JKS file to the record.

e. Under Related Links, select Validate Stores/Certificates.
You should see a Valid key_store  message.

f. Select Update.

4. In your ServiceNow  instance, update the Google Dialogflow  JWT (JSON Web Token) Keystore 
alias record.

a. Navigate to All, and then enter jwt_keystore_aliases.list  in the filter.

b. Select Google Dialogflow  JWT Keystore to open the record.

c. On the form, fill in the fields as follows.

Field Value

Signing 
Keystore

Select Google DialogFlow X.509 Certificate.

Signing 
Algorithm

Select RSA 256.

Signing Key Enter the private key password that you specified when creating the JKS 
file (notasecret).

Key Id Leave this field empty.

d. Select Update.

5. In your ServiceNow  instance, update the Google Dialogflow  JWT provider record.

a. Navigate to All, and then enter jwt_provider.list  in the filter.

b. Select Google Dialogflow  JWT Provider to open the record.
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c. In the Signing Configuration  field, select Google DialogFlow JWT Keystore.

d. In the Standard Claims related list, enter the email address for your Google Dialogflow  agent 
service account as the Claim Value  for the iss  entry.

For more information, refer to Create a service account and private key in Google Dialogflow 
ES.

e. Select Update.

6. In your ServiceNow  instance, update the Google Dialogflow  NLU OAuth Provider record:

a. Navigate to All, and then enter oauth_entity.list  in the filter.

b. Select Google Dialogflow  NLU to open the record.

c. On the form, fill in the fields as follows.

Field Value

Client ID Enter the unique ID for your Google Dialogflow  agent service account that 
you saved from a previous step.

Client Secret Enter the private key password that you specified when creating the JKS file 
(notasecret).

Default 
Grant Type

Select JWT Bearer.

d. Select Update.

7. In your ServiceNow  instance, update the GoogleDialogFlowESNLUPrediction  system alias.

a. Navigate to All, and then enter sys_alias.list  in the filter.

b. Select GoogleDialogFlowESNLUPrediction  to open the record.
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c. Select the Connection Attributes  tab and find the EnvID  record.

d. In the Default value  column, update the value with the name of the Google Dialogflow 
environment where the agent was published.
The default value is prod.

e. Select Update.

8. Specify Google Dialogflow  ES as your NLU provider in Virtual Agent.
For more information, see Configure Natural Language Understanding in Virtual Agent.

Activate the Google Dialogflow  ES service and enable it in your instance

When you activate the Google Dialogflow  ES service in the Open NLU Drivers [open_nlu_driver] 
table, the service becomes available as an option in Virtual Agent  NLU settings.

Before you begin
Role required: admin

Procedure

1. Navigate to All, and then enter open_nlu_driver.list  in the filter.

2. In the Open NLU Drivers table, locate the Google Dialogflow  ES Script record.

3. In the Active column, set the value to true.

4. To enable NLU in your instance, navigate to Conversational Interfaces  > Settings, and then do 
the following:

a. Click Virtual Agent.

b. Under Natural Language Understanding (NLU), click View Settings.
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c. Slide the Activate  toggle switch to enable Natural Language Understanding.

d. In the NLU service provider list, select Google Dialogflow ES - Script.

e. If you plan to use language-specific NLU models, enable the languages in the Supported 
NLU Languages list.
A language is enabled if the Enabled column displays true. For more information, see Enable 
NLU languages in Virtual Agent settings.

f. Click Save.

Result
Google Dialogflow  ES is the NLU service provider for your instance.

Test Virtual Agent  with Google Dialogflow  ES NLU in Virtual Agent Designer

Test topic discovery with Google Dialogflow  and Virtual Agent  in the Virtual Agent Designer 
interface.

Before you begin
Check the following:

• Ensure that your Google Dialogflow  agent (model) is published as a version with the most 
recent changes.

For more information, see Versions and environments  in the Google Dialogflow 
documentation.

• Ensure that at least one topic is mapped to an existing Google Dialogflow  agent (model) and 
intent.

Role required: virtual_agent_admin or admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer.

2. In the Topics page, click Test Active Topics.

3. Type an utterance that should trigger the Google Dialogflow  intent that is mapped to the topic.

4. To test entity slot-filling, do the following:

a. On the Flow  tab, add a Text user input node.

b. Select an entity for the NLU entity  field.
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Ensure that the entity you select is configured in your Google Dialogflow  ES agent. When a 
matching utterance is entered in the Test this topic window, the topic should be triggered, and 
the entity should slot-fill automatically.

Enhanced natural language handling of user inputs in NLU topic discovery

Give Virtual Agent  the capability of recognizing natural variations on yes  and no  from the user, 
such as sure  or nope. By defining a range of boolean responses as affirmative or negative, 
Virtual Agent  doesn't have to prompt the user to restate their preference.

When Virtual Agent  doesn't understand unexpected user input, it prompts the user again for 
information that it can understand. Starting with the Tokyo  release, Virtual Agent  can understand 
natural variations in boolean "yes/no" responses, such as yep  or nah.

Natural language handling in ServiceNow  NLU

The VA NLU Dispatches [sys_cs_nlu_dispatch] table stores the names of the model and intents 
that handle utterance variations.

For ServiceNow®  NLU, the Setup Topics Model is already configured to handle boolean user 
inputs in English. There are two records in the table, BOOLEAN_NO  and BOOLEAN_YES, which 
are mapped to the Negative  and Affirmative  intents in the Setup Topics Model.
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The Setup Topics Model and intents are read only, so if you need to modify the intents or add 
additional intents in other languages, create a new model with new intents. You can update the 
existing entries and add new ones to the table.

Setting up natural language handling for third-party NLU providers

If you are using IBM  Watson, Microsoft LUIS, or Google Dialogflow  for NLU topic discovery, add 
entries for the corresponding model and intents in the VA NLU Dispatches table, as described in 
Configure enhanced natural language user input handling.

Changing the confidence threshold

The confidence threshold for boolean inputs is defined in the 
com.glide.cs.dialog.boolean_threshold  system property. The default value is 0.9. 
For more information, see Add a system property .

Configure enhanced natural language user input handling

Add enhanced natural language handling for boolean user responses to your Virtual Agent 
environment. If you're using additional languages or third-party NLU providers, specify the model 
and intents that define variations in yes/no utterances for your bot.

Before you begin
In your NLU provider, create a model with two intents, or add two intents to an existing model. 
One intent should contain affirmative or "yes" utterances. The other intent should contain 
negative or "no" utterances.

If your environment supports multiple languages, create models and intents for each language.

Role required: virtual_agent_admin or admin

About this task
The default entries in this table apply to ServiceNow  NLU for English only. If you want to 
implement natural language handling in other languages, add new entries to the table for each 
language.

Procedure

1. Navigate to All, and then enter sys_cs_nlu_dispatch.list  in the filter.

2. Select New  or an existing entry that you want to modify.
Alternatively, select New  to add an entry for another language or third-party NLU provider.

3. On the form, fill in the fields.

Field Description

NLU Model ID Name of the model that contains the defining 
intents for the boolean responses.

Name Value name that represents the type of user 
input being configured. The following values 
are valid:
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Field Description

◦ BOOLEAN_NO: Maps to utterances 
that express a "no" response to a yes/no 
question.

◦ BOOLEAN_YES: Maps to utterances that 
express a "yes" response to a yes/no 
question.

Active Option that enables enhanced natural 
language user responses on your instance.

NLU Intent ID Name of the corresponding intent for the 
boolean option.

By default, the intent for BOOLEAN_NO is 
Negative. The intent for BOOLEAN_YES is 
Affirmative. If you need to make changes, 
create a new model with these intents, and 
then specify the new intent in this field.

Language Language of the intent. English for 
ServiceNow  NLU is configured by default.

If you need to support other languages,you 
can add a row in the table for each supported 
language.

4. Select Submit  or Update.

Result
Depending on your environment, your configuration may contain entries for other languages 
(such as French or German in the example below) or for other NLU providers, such as IBM 
Watson.

Create or modify custom categories

Create or change custom categories for organizing and grouping related Virtual Agent  objects, 
such as topics. You can also make category labels visible in the Topic picker menu displayed to 
end users.

Before you begin
Role required: virtual_agent_admin or admin
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About this task
Use topic categories to group related conversation topics. When your create or update a topic, 
you can assign one or more categories to which the topic belongs. You can also view your topics 
by category in Virtual Agent Designer.

For your end users, you can make the custom category label visible in the Topic picker menu so 
that associated topics are displayed by category.

Before you create a new category, review the existing categories (All  > Conversational 
Interfaces  > Virtual Agent  > Categories) to determine if you need a new category.

Note: 
Pre-built topics have associated, default categories that can't be changed or deleted. 
Also, you can delete a custom category only when the category does not have any topics 
assigned to it.

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Categories.

2. Select New  to create a custom category or select a category record to change it.

Field Description

Name Label for the category.

Description Brief description of the category purpose.

Application Application scope of the category.

Visible to end user Option to display the category label in the Topic picker 
menu for end users.

Note: 

◦ If you upgraded from a previous release, 
existing category labels are set to not visible.

◦ This option does not control the topics 
displayed within the category. At the topic level, 
use the Condition  field in the Topic Properties 
page to set conditions that control when a topic 
is displayed to end users.

3. Select Submit  or Update.
The topic category appears in the following items:

◦ Category  list collector (slushbucket) on the Topic Properties page in Virtual Agent Designer 
so that you can assign one or more categories to a topic.

◦ Category  filter on the Topics page, so that you can view topics by category.

◦ Topic cards on the Topics page, for topics that have assigned categories.
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◦ Topic picker menu displayed to end users, if you made the category visible. Topics with 
multiple categories are displayed in the appropriate categories. Topics without categories 
are listed in the Others category.

Topic picker menu

4. To delete a topic category, open the category record and click Delete.
If there are no topics associated with the category, the category is deleted. It is no longer listed 
in the Category  field on the Topics Properties page and in the Category  filter on the Topics 
page in Virtual Agent Designer.

Building and deploying Virtual Agent

Convert the time your agents and technicians spend handling low-impact user requests into an 
intelligently managed interaction. Enable Virtual Agent  with NLU  to understand the intent of what 
people are looking for and provide them with more relevant answers.

You can quickly deploy AI‑powered  chatbot conversations using customizable templates for the 
most common enterprise IT, HR, and customer service scenarios. You can design, build, and test 
conversations with Virtual Agent Designer.

Using Virtual Agent  Topic Recommendations

Use the Topic Recommendations  app to identify pre-built Virtual Agent  topics that can be quickly 
implemented in your organization. Topic Recommendations  uses Intent Discovery  to analyze 
data from your organization and to find relevant pre-built topics that your organization can benefit 
from, and new topics that would be useful to create.

The Topic Recommendations  app lets you evaluate the common use cases that Virtual Agent  can 
help resolve or deflect. You can use Topic Recommendations  with Virtual Agent  topics that use 
either keyword or NLU topic discovery. Use it to do the following:
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1. Choose the ServiceNow  data to analyze (configure analysis).

2. Analyze your existing data (run the analysis you configured).

3. Review the analysis results and use pre-built solutions:

◦ Duplicate a pre-built topic suggestion, such as a topic from ITSM Virtual Agent 
Conversations (available from the ServiceNow Store).

◦ [NLU only] Add an intent to your model and a new empty topic. You must provide the flow for 
the new topic in Virtual Agent Designer.

The Topic Recommendations  app requires NLU Workbench  and ITSM Virtual Agent 
Conversations from the ServiceNow Store. The Washington DC  release of Topic 
Recommendations  supports only ITSM Virtual Agent recommendations. Although Topic 
Recommendations  uses NLU Workbench for machine learning purposes, it does not require that 
NLU be enabled in Virtual Agent.

For information about the apps that are automatically installed with Topic Recommendations, see 
Update Topic Recommendations.

Required plugins

• Ensure that the application and all of its associated ServiceNow Store  applications have valid 
ServiceNow  entitlements. For more information, see Get entitlement for a ServiceNow  product 
or application .

• Topic Recommendations  requires the following plugins and ServiceNow Store  applications. 
Ensure that they are activated before you install Topic Recommendations.

Required ServiceNow  plugins

Glide Virtual Agent (com.glide.cs.chatbot)

Activates all the plugins needed to run Virtual Agent  Pro. For details, 
see Activate Virtual Agent.

Note: 
Starting with the San Diego  release, the Topic 
Recommendations  app is automatically installed when 
you initially activate the Glide Virtual Agent  plugin 
(com.glide.cs.chatbot). Subsequent updates for this app must 
be installed from the ServiceNow Store.

NLU Workbench (NLU topic discovery only)

Activates the plugins needed to run Natural Language 
Understanding  in your instance. For more information, see Activate 
the NLU Workbench .

Required ServiceNow Store  applications

Intent Discovery  (NLU  discovery only)

Identifies user intents from analyzing incident/case data. To learn 
more, see Intent Discovery .

ITSM Virtual Agent Conversations

Provides pre-built IT service management conversations to help your 
organization quickly deploy automated self-service conversations. 
For more information, see ITSM Virtual Agent .
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Items installed with Topic Recommendations

The following items are installed with Topic Recommendations:

• Scheduled jobs: Run Topic Recommendation Reports  for running Topic 
Recommendation reports at scheduled times.

• The following tables are installed:

Table Description

Default settings for Topic Recommendations

[sn_topic_recommend_default_setting]
The source data (table and text field), 
taxonomy, and filters used when running a 
Topic Recommendations  analysis

Installed recommended topics

[sn_topic_recommend_topic_staging]
Topics generated for recommended topics

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

What to do

• Get started with Topic Recommendations

• Define default recommendation settings

• Run a Topic Recommendation analysis

• Add recommended topics and intents to Virtual Agent

• Link a topic recommendation to an existing Virtual Agent topic

• Unlink a topic recommendation from an existing Virtual Agent topic

• Troubleshoot issues with Topic Recommendations

Update Topic Recommendations

You can install updates to the Topic Recommendations  application 
(com.snc.va_topic_recommender) if you have the admin role.

Before you begin
Starting with the Tokyo  release, the Topic Recommendations  store app is automatically installed 
with Virtual Agent. When using Topic Recommendations, the app checks the ServiceNow Store 
and notifies you when an update is available.

Role required: admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Topic Recommendations.
If an update is available, a notification displays on the Topic Recommendations  page.
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2. Select View update.

Note: 
Visit the ServiceNow Store  website to view all the available apps and for information 
about submitting requests to the store. For cumulative release notes information for all 
released apps, see the ServiceNow Store  version history release notes .

3. Follow the instructions on the ServiceNow Store  website to request an update for Topic 
Recommendations  on your instance.

Quick start for Topic Recommendations

To get recommended topics based on your data, configure analysis reports, run the reports, and 
then review the results. You can either add new topics to Virtual Agent  or link a recommendation 
to an existing topic.

The Topic Recommendations  page appears in your instance at All  > Conversational Interfaces  > 
Virtual Agent  > Topic Recommendations.

Step 1: Configure analysis reports based on ServiceNow  data

Until you define analysis reports, the Topic Recommendations  page is empty.

Topic Recommendations  page with no reports defined

Each analysis report is based on the following:

• Data source: The ServiceNow  data that you want to analyze. The options are: Incident 
[incident] table, Request [sc_request] table, Live Agent  chat transcripts, and Virtual Agent 
fallback utterances.

• The field to analyze: A selected field (with a string data type) in the data source table to 
analyze. For example, the Short description  field.

• Taxonomy: The business application that includes the data sets. When you install ITSM Virtual 
Agent  Conversations, the Incident and Request data sets are installed by default. As additional 
data sets for applications become available, the data sets are displayed as a taxonomy on the 
page after they’re installed on an instance.
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You can also add conditions to your analysis reports and configure them to run on a schedule. 
When new recommendations are available, a notification appears in the Virtual Agent Designer 
Topics page.

Configure analysis reports for Topic Recommendations  in Virtual Agent  settings. For details, see 
Configure analysis reports for Topic Recommendations.

Step 2: Run an analysis report

Run all configured analysis reports together or selectively run one at a time from the Topic 
Recommendations  page.

During analysis, the Topic Recommendations  app does the following:

• Uses Intent Discovery  to review your data source, comparing your data source against the 
related taxonomy for your business application. Intent Discovery  matches the data field 
specified in your data set to intents in the taxonomy.

• Maps the matched intents to pre-built topics in Virtual Agent. If intents don’t have associated 
pre-built topics, the app recommends them as new topics that you can build because they 
were requested frequently enough by your users.

• Displays the analysis results as topic cards in the Topic Recommendations  page.

For more information, see Run a Topic Recommendation analysis.

Step 3: Review report results and add or link topics and intents

Results are sorted into the following groups:

• Topics that Virtual Agent  can handle: Recommendations in this group can be addressed with a 
pre-built topic.

When you add this type of recommendation to Virtual Agent, the matched pre-built topic is 
duplicated in your instance. You can then modify, test, and publish the added topic using 
Virtual Agent Designer.

• User intents that need topic flows: Recommendations in this group match a ServiceNow  NLU 
intent.

When you add this type of recommendation to Virtual Agent, an empty topic is created and 
mapped to the matched intent in the model that you specify. You can then open the topic in 
Virtual Agent Designer  and create a flow for the new topic.

The results are displayed in descending order of matches to your data source. The top 20 intent 
matches are displayed. If there are more than 20 intents, you can view them in NLU Workbench.

For more information about adding a recommendation to Virtual Agent, see Add recommended 
topics and intents to Virtual Agent. You can also link a recommendation to an existing topic.
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Mapping recommendations to Virtual Agent  topics

Configure analysis reports for Topic Recommendations

To generate Topic Recommendations, specify a default data source (ServiceNow  table and field) 
and the conditions for filtering the data records.

Before you begin
Role required: virtual_agent_admin or admin

About this task
When configuring analysis reports, consider the following:

• You can define only one setting per data table and taxonomy pair.

• Two data sets for the ITSM taxonomy (Incident and Requests) are provided by default, but you 
can define your own data sources.

• In the Washington DC  release, Topic Recommendations  requires a minimum of 10,000 records 
in your analysis scope (data source). This minimum provides a reasonably sized data set to 
achieve a certain level of quality in the analyses.

• Keep your analysis scope (data source) under 300,000 records. In the Washington DC  release, 
this is the maximum number allowed. This limit maximizes the performance of the analysis 
report.

• You can schedule analysis reports to run automatically at specified intervals.

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. Select Virtual Agent.

3. Under Topic Recommendations, click View all.

4. Select New.

5. On the form, fill in the fields.
For details, see Topic Recommendations settings.

6. Select Save.

Result
The data source that you defined for a given table and taxonomy displays as a section on the 
Topic Recommendations  page. You can now run a topic recommendation analysis.
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Run a Topic Recommendation analysis

Generate a report that analyzes a given data source and identifies the appropriate Virtual Agent 
pre-built topics that you can implement. For intents that do not have matching pre-built topics, 
the report identifies the user intents (topics) that you can create.

Before you begin
Verify that the appropriate Virtual Agent  conversation plugins are activated so that the Topic 
Recommendations  app can identify the appropriate pre-built topics.

You can use the Check for updates  link on the Topic Recommendations  page to check which 
plugins are installed.

Make sure you configure analysis reports  first.

Role required: virtual_agent_admin or admin

About this task
The analysis process takes about 15 minutes or less to return recommendation results. In the 
Washington DC  release, Topic Recommendations  requires a minimum of 10,000 records in the 
data source and will only process a maximum of 300,000 records. Use filters in the settings page 
to reduce the number of records in the data source, if needed.

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Topic Recommendations.

2. In the Topic Recommendations  page, go to the data source to be analyzed and trigger the 
analysis.

◦ If the view is set to All, do the following:

a. Select Get new recommendations.

b. In the dialog box, select the sources you want to get reports for.

If a check box is unavailable, a report may already be running, or the amount of data to 
analyze might be outside of the minimum or maximum allowed.

c. Select Get new recommendations.

◦ If the view is set to By Source, do the following:

a. Select Run analysis  or Refresh  in the source status bar.

b. Modify any settings in the dialog box, and then select Get recommendations.
A message indicates that the topic-finding process has started and the approximate time for 
recommendation results. The page or status bar displays Analysis in progress. You 
can review other items while the analysis runs.

Note: 
Changing the settings here affects only this analysis. The default settings for the 
recommendation are preserved. To change the default settings, see Configure analysis 
reports for Topic Recommendations.

3. When the report completes, review the analysis results for the data set.
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The results display as cards in two sections: Topics that VA can handle  for pre-built topics and 
User intents that need topic flows  for intents and corresponding topics that can be created.

Tip: 
To view details about a pre-built topic or user intent, select the card, and then click the 
Info icon ( ) to open an overlay card. For more information, see Topic Recommendations 
cards.

What to do next
You can add a Topic Recommendation as a new topic  or link it to an existing topic. You can also 
hide a recommendation  from the list in aggregate view.

Add recommended topics and intents to Virtual Agent

After you run and review a Topic Recommendations  report, select the pre-built topics and 
suggested intents to add to Virtual Agent.

Before you begin
Role required: virtual_agent_admin or admin

About this task
When you add a recommended topic to Virtual Agent, the Topic Recommendations  app 
automatically does the following:

• Duplicates the pre-built topics that you selected.

• Creates empty topics for the intents you selected.

• If you're using ServiceNow  NLU:

◦ Creates a new NLU model if it doesn't exist.

◦ Updates and trains the NLU model with the added intents.

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Topic Recommendations.

2. Go to the analysis results for your data source.

3. Select one or more topic and intent cards to be added to Virtual Agent, and then click Add to 
VA.
Selected cards are highlighted in blue and display as Selected, as shown in the following 
example.

4. If you're using ServiceNow  NLU, select one of the following options in the Model  list:

◦ Create new model

Select this option to create a new model group. If other languages are enabled for your 
instance, select the languages to add as secondary models in the group. Click make 
primary  for the primary language in the group.
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Adding selected recommendations to a new model group

For more information about model groups, see Multilingual model management .

◦ An existing model name

If other languages are enabled for your instance, select the languages to add as secondary 
models in the group.

Adding selected recommendations to an existing model group

5. Select Add to VA.
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Result
For recommended pre-built topics, Virtual Agent  duplicates the topic (but removes the 
Template  portion of the file name). For recommended intents, Virtual Agent  creates a new topic 
mapped to the intent. These topics are added to the Recommended  category in the Virtual Agent 
Designer  Topics page.

In the Topic recommendations page, the topic card shows the date it was added and its status 
(Active  or Inactive). To open the new topic from the Topic Recommendations  page, click the 

info icon to open the overlay card. Click the open link icon  to open the topic in Virtual Agent 
Designer.

Recommended topic cards for an added topic

Link a topic recommendation to an existing Virtual Agent  topic

Instead of creating a new topic from a topic recommendation, you can link it to an existing topic. 
This lets Virtual Agent  know that you have a topic that addresses the recommendation.

Before you begin
Role required: virtual_agent_admin or admin

About this task
If you continue to get recommendations for an active topic after linking it, the topic probably 
needs improvement.

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Topic Recommendations.

2. Select the info icon  to open the overlay card for a topic that has a New  status.

3. At the bottom of the overlay card, select Here's how to link to an existing topic.
Select the link as shown in the following example.
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4. In the dialog box, select a topic in the Find topic to link  list.

5. Select Link topic.

Result
The overlay card shows that the recommendation is linked, as well as the date this occurred.

Overlay card for a linked topic

If a topic recommendation continues to appear in your analysis results after you linked it to a 
topic, you may want to revisit the topic to improve its effectiveness.

You can also unlink a topic recommendation from a Virtual Agent  topic.

Unlink a topic recommendation from a Virtual Agent  topic

You can unlink a topic recommendation from a topic. This lets you link it to a new or alternate 
topic.
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Before you begin
Role required: virtual_agent_admin or admin

About this task
You can either add a recommendation as a new topic or link it to an existing topic. If you link it 
to an existing topic, you can always unlink it later if you need to. Added topic recommendations 
create an empty topic that you provide with a workflow, so you can't unlink them using this 
method.
The following example shows the difference between a linked recommendation and an added 
recommendation.

Example of linked and added cards in the Topic Recommendations  page

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Topic Recommendations.

2. Select the info icon ( ) to open the overlay card for a linked topic.

3. Select Unlink.

Result
Unlinked recommendations are set to New  status. You can link it to another topic, or add it to 
Virtual Agent  as a new topic.
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Note: 
If you added a topic to Virtual Agent  for a recommendation, it is not shown as linked, so you 
can't unlink it. To reset an added recommendation as New, delete the topic that was added 
in Virtual Agent Designer.

Hide a topic recommendation

You can choose to ignore a topic recommendation by hiding it. Doing so hides it for everyone on 
the instance. You can still view hidden recommendations and show it again later.

Before you begin
Role required: virtual_agent_admin or admin

About this task
Topic recommendations are hidden only when View  is set to All  (aggregate view). Hidden 
recommendation cards will still display when View  is set to By Source. The status on the card is 
Hidden.

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Topic Recommendations.

2. Select the info icon ( ) to open the overlay card for a topic that has a New status.

3. Select Hide.

Result
The recommendation is hidden from the list. To view hidden recommendations, slide the Show 
hidden  toggle switch to enable it.

To return a recommendation's status to New, select the info icon ( ) to open the overlay card for 
the topic, and then select Don't hide.

Troubleshoot issues with Topic Recommendations

Investigate and resolve unexpected behavior with Topic Recommendations, or find answers to 
common questions.
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For information about using Topic Recommendations, see Quick start for Topic 
Recommendations.

Note: 
Topic Recommendations  tries to train the model when you add new topics to Virtual Agent. 
If an error occurs during training, the topic is still added, but the model remains in a draft 
state.

Issue Solution

Topic 
Recommendations 
page is blank

No analysis reports have been configured.

Configure an analysis report. You can also install or activate ITSM Virtual 
Agent  Conversations, which will add default configurations to Topic 
Recommendations. For more information, see Set up ITSM Virtual 
Agent .

Error when adding 
topics to Virtual 
Agent

Check the error log for details:

1. Navigate to All  > System Logs  > System Log  > Errors.

2. Find the entry that has a value of sn_topic_recommend  in the Source 
column.

The Message field displays the error.

Note: 
If model training fails while adding topics, Topic 
Recommendations  will ignore those errors and continue to add 
your recommendations. In this case, you will be notified that the 
models are in draft state.

Reports have intent 
matches, but no pre-
built topic matches

Make sure ITSM Virtual Agent  Conversations is installed and activated 
for the instance. If the app is installed, then none of the pre-built topics 
address the issues found in your reports. For more information, see Set 
up ITSM Virtual Agent .

Analysis reports 
are not available 
in production 
instances

This is the expected behavior. Analysis reports and Intent Discovery  are 
designed to live in one instance only. Added topics and NLU models are 
made available in a "new" instance, but the Topic Recommendations 
reports do not move between instances.

Analysis report 
is stuck and 
says "Analysis in 
progress"

Check the status in the Discovery Report Definitions table:

1. Navigate to All  > sn_nlu_discovery_report_definition.list.

2. Sort the table on the Created column, and then find the name of the 
affected analysis definition.

3. If the Status column is empty, the analysis failed. Try running it again.

You can also navigate to NLU Workbench  > Intent Discovery  to see 
if something went wrong in the intent discovery process. For more 
information, see Intent Discovery .
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Issue Solution

Adding new topics 
takes longer than 
expected

Try the following:

• Navigate to All  > sn_topic_recommend_topic_staging.list  and view 
the Status column to see what stage topic generation is in. Training 
models can take some time.

• Navigate to All  > System Logs  > Events  to see which event ran last or 
if the event is queued.

• If the reason for failure is not clear, navigate to All  > 
sn_topic_recommend_topic_staging.list  and change the value of the 
Status field to Error. You can then try to add the recommendation 
again.

Can't generate a 
report with less than 
10,000 or more than 
300,000 records

Topic Recommendations  currently supports a minimum of 10,000 
records and a maximum of 300,000 records. This is done for 
performance and to ensure a statistically significant data set.

Model is not 
preselected in the 
app

If you are upgrading from Quebec  and this is your use of the Topic 
Recommendations  app, you must select a model. Once you select a 
model, Topic Recommendations  preserves the selection.

Unmigrated model 
support While you are encouraged to migrate your models to groups, Topic 

Recommendations  does not require models to be grouped.

Unlinked topics You don't have to link all recommendations. Topic linking is a way to 
"acknowledge" a recommendation if you have an existing topic.

The Topics/
Requests VA Can 
Handle  tab is not 
displayed

System property glide.ui.escape_all_script  is not set to True.

Navigate to ALL > sys_properties.list  (or ALL sys_properties_list.do). 
Search for and select glide.ui.escape_all_script, then set its 
Value to True.

Topic Recommendations  interface reference

The Topic Recommendations  app provides two main pages: a configuration page and the Topic 
Recommendations  page, where you find any recommended topics.

For more information about the Topic Recommendations  user interface, see the following topics:

• Topic Recommendations settings

• Topic Recommendations page

• Topic Recommendations cards

Topic Recommendations  settings

Use the Topic Recommendations  settings page to configure analysis reports based on your 
ServiceNow®  data.

You can find the Topic Recommendations  settings in the Conversational Interfaces Chat Settings 
(All  > Conversational Interfaces  > Settings) under Virtual Agent. When you first install Topic 
Recommendations, nothing is configured, so the settings page appears empty.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1795



Empty Topic Recommendations  settings page

Once configured, you can view or edit analysis reports on this page.

Configured Topic Recommendations  settings

Topic Recommendations  analysis settings

When you create or edit a Topic Recommendations  analysis record, specify the information in 
the following form.

Default settings for Topic Recommendations

Field Description

Data 
source ServiceNow  table that contains the data to be analyzed.
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Default settings for Topic Recommendations  (continued)

Field Description

Field 
analyzed

Field (string column) in the table to be analyzed. For example, the Short 
description  in the Incident table.

Taxonomy Comprehensive list of intents for a specific business application, such as ITSM.

Filter by Condition builder for filtering the records to be analyzed. Click Set conditions  to 
open the condition builder.

The default filter is [Created] [after] [Last 90 days].

Frequency The schedule for running the analysis, which is triggered through the Run Topic 
Recommendation Reports scheduled job:

• None

• Every Month

• Every 3 Months

• Every 6 Months

• Every 12 Months

Note: 
If you're using a non-production instance for testing, set the analysis 
schedule in your production instance so that it and your analysis history are 
retained. The intent discovery process works best in a single instance, where 
data is not promoted between instances.

Related topics

Configure analysis reports for Topic Recommendations

Topic Recommendations  page

Use the Topic Recommendations  page to run analysis reports, view recommendations, add 
topics to Virtual Agent, or link a recommendation to an existing topic.

View all recommendations (aggregate view)

Topic Recommendations  shows all results in this view by default. This view allows you to run or 
refresh analysis reports for all configured sources at one time. The configured sources for the 
recommendations are listed as hyperlinks. Click the link to open the settings for the report. If a 
recommendation has a New status, you can select it, and then click Add to VA.
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Default (aggregate) view

View recommendations by source

You can view topic recommendations by their data source. This lets you run a new analysis or 
refresh an existing analysis for a single data source, rather than running all of them at once. Click 
Settings  to view the report's settings. If a recommendation has a New status, you can select it, 
and then click Add to VA.
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Topic Recommendations  page in source view

Topic Recommendations  cards

Recommended topic and intent cards display the status of the recommendation, allowing you to 
track them more easily over time.

Card status

Topic and intent recommendations appear as cards. The status lets you know what action has 
been taken, if any, for each recommendation.

Example intent recommendation cards

Topic and intent card statuses

Status Description

New Topic or intent has never been added to Virtual Agent.

Cards with New  status have a dark gray border.

Active Topic or intent was added to Virtual Agent  or linked to an existing topic  and published.

Cards with Active  status have a green border.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1799



Topic and intent card statuses  (continued)

Status Description

If you keep getting recommendations for an Active topic, it probably needs 
improvement.

Inactive Topic or intent was added to Virtual Agent  but never published, or it was linked to an 
existing, unpublished topic.

Cards with Inactive  status have a light gray border.

If you keep getting recommendations for an Inactive topic, take steps to publish it and 
make it active.

Hidden Topic or intent was not added to Virtual Agent, but it was marked as hidden from the 
aggregate view and has a status of Hidden.

Overlay cards

To get more details about a pre-built topic or user intent, select the recommendation card, and 
then click the info icon to open an overlay card.

The overlay card includes a description of the pre-built topic or user intent and the following 
information, which can provide insight into why the topic or intent was recommended.

Label Description

Per contact, VA 
could save

How long it takes for Virtual Agent  to resolve an intent (displayed in 
minutes).

How they 
contacted you

The way in which users engaged with support. For example, phone  or 
email.

Who handled the 
ticket

The assignment group.

Language The languages of users interacting with support for this issue.

Topic completion Graph that shows a snapshot of topic completion over a window of time. 
This information displays for active topics only.

Status area

This section displays one of the following statuses.

How to apply this 
recommendation

Suggestions for an unused recommendation.

You can do one of the following:

• Select the card, and then click Add to VA  to create a new topic.

• Link the recommendation  to an existing topic.

Added topic 
recommendation

Displays the name of the topic that was added for the recommendation, as 
well as the date when it was added.

Click the open link icon  to view the topic in Virtual Agent Designer.

Linked topic Displays the name of the topic that was linked, as well as the date when 
the recommendation was linked.
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Label Description

Click the open link icon  to view the associated topic in Virtual Agent 
Designer. You can also unlink the topic  from the recommendation.

Example overlay card

Using Issue Auto Resolution

You can proactively deflect issues and expedite the resolution process for your agent and 
user with the Issue Auto Resolution  (IAR) application. Through machine learning and Natural 
Language Understanding  (NLU), users get immediate self-service and can access Virtual Agent 
topics, Knowledge  articles, and catalog items.

How Issue Auto Resolution  works

When a user creates an issue, the Issue Auto Resolution  application uses machine learning and 
NLU to identify the criticality of the issue, the intent, and an appropriate Virtual Agent  topic for an 
automatic resolution. If a Virtual Agent  topic isn’t found, Issue Auto Resolution  does an AI Search 
to return the most appropriate Knowledge  articles, FAQs, or catalog content. The deflection 
content is then delivered to the user through the configured response channel, such as email, 
short messaging service (SMS), or Virtual Agent.

Issue Auto Resolution  Admin Console

As an administrator, you use the IAR Admin Console to set up the Issue Auto Resolution 
application, review how configurations may perform based on historical data (simulations), and 
track performance. You can also see the total cases processed, the solutions identified by the 
Issue Auto Resolution  application, and the cases closed by the user.

To view the IAR Admin Console, navigate to All> Issue Auto Resolution> Overview. The 
Overview page contains an FAQ section that provides tips for how certain features work. You can 
also find a section where you can upgrade your IAR.
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Issue Auto Resolution  use cases

To learn more about the use cases for Issue Auto Resolution  for ITSM  and HR Service Delivery, 
see Issue Auto Resolution for ITSM Virtual Agent  and Issue Auto Resolution for HR Service 
Delivery .

Configure and run an Issue Auto Resolution  simulation

Use the incident data from your organization to run simulations from the matching intents that the 
Issue Auto Resolution  application based its predictions on from the case descriptions.

Before you begin
Role required: virtual_agent_admin or admin

About this task
You can run multiple simulations for a Issue Auto Resolution  (IAR) configuration. You can also do 
the following tasks:

• Cancel a simulation: Stop a simulation in progress.

• Refresh simulation status: Check the status of a simulation in progress.

• Delete a simulation: Delete a simulation configuration, but not while a simulation is running.

Procedure

1. Configure and configure an IAR simulation.

a. Navigate to All  > Issue Auto Resolution  > Simulations  > ..

b. Select New  or Create new simulation  if you don't have an existing simulation.

c. On the form, fill in the fields.

Create new simulation

Field Description

Name Name of the simulation configuration.

Auto Resolution configuration Table that contains the records to be 
simulated. The default configuration is for 
incidents.

State Simulation status:

▪ Ready: Simulation is ready to run.

▪ Running: Simulation is in progress.

▪ Canceled: Simulation stopped.

▪ Complete: Simulation finished.

▪ Error: Simulation encountered a 
processing error, but continues the 
simulation for the next set of records.

Record set Condition that identifies the records 
evaluated in the simulation. For example: 
[Active] [is] [true]. This condition is 
automatically filled in with the conditions 
that you specify in your incident 
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Field Description

configuration, but you can modify the 
conditions as needed.

Note: 
Record sets that return a large number 
of records can take longer to simulate. 
To reduce the simulation time, consider 
changing the record set to return a 
smaller number of records. 50,000 
is the maximum record limit for each 
simulation run.

d. Select Save.

2. After the new simulation is created, select Run.
The simulation may take a bit more time depending on the number of records that you have. 
After a run is completed, you see the Latest resolution potential  and other simulation results.

3. To specify a time and schedule to run the simulation instead of manually running one, select 
Enable scheduled job.
You can run the simulation on a daily, weekly, or monthly basis at a specific time, in hours, 
minutes, and seconds. After you set up the schedule, select Save. To cancel your scheduled 
job, disable Automatically run this simulation. For each simulation run, the following 
information is displayed:

Simulation results

Field Description

Start time Date and time that the simulation started.

Completed time Date and time that the simulation ended.

Progress Percentage of the simulation performed.

Latest trained version Version number of the machine learning 
model used for the simulation.

State Status of the simulation:

◦ Complete: Simulation completed its run.

◦ Ready: Simulation is ready to run.

◦ Running: Simulation is in progress.

◦ Canceled: Simulation stopped.

◦ Complete: Simulation finished.

◦ Error: Simulation encountered an error.

Total records Total number of records evaluated in the 
simulation.

Resolution rate (%) Percentage of cases that the simulation 
has predicted that match active intents with 
active topics.
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4. View the simulation details of the individual run by selecting the link within Runs  > Start time.

Run details

Field Description

Resolution potential Percentage of incidents that have active 
intents and are mapped to active topics.

Inactive topics Virtual Agent  topics currently mapped to 
intents that aren’t active and not visible 
to users. Select an active topic by using 
the intent to topic map table in the IAR 
configuration, or go to Virtual Agent  Designer 
to activate the topic.

Mapped intents: Active Intent that was successfully predicted from 
the case description and is active in your 
intent to topic map table.

Mapped intents: Inactive Predicted intents that are available but not 
active in your intent to topic map table.

No intents found Description in the records didn’t match any of 
the intents available.

Unmapped intents Intent that was successfully predicted from 
the case description, but the intent itself 
hasn’t been added to the intent to topic map 
table in the configuration. To increase the 
coverage for those incidents, add those 
additional intents to the table.

Issue Auto Resolution  configuration settings

Learn about the different configuration settings that you can use for the Issue Auto Resolution 
(IAR) application. For example, you can see the status of your Issue Auto Resolution 
configurations and decide to turn off or edit each configuration setting to fit your organization's 
needs.

The following tables show the configuration settings that are available for Issue Auto Resolution

Note: 

To modify your settings, navigate to All  > Issue Auto Resolution> Settings.

Task configuration
Specify the tables, defaults, and task templates while processing the task.

Setting Definition

Table Name of the table for the Issue Auto 
Resolution  application to process.

Invocation type Trigger for theIssue Auto Resolution 
application either through a business rule 
when the case is created or an API on 
demand.
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Task configuration
Specify the tables, defaults, and task templates while processing the task.

(continued)

Setting Definition

Assign to Assignee for the case that is being processed 
by the Issue Auto Resolution  application.

Requester User requesting assistance on the issue.

Task assignment template Template that sets the fields and values when 
it’s being assigned to the user.

Task resolution template Template that sets the fields and values when 
the user indicates that the issue is resolved.

Task completion template Template that sets the fields and values during 
the interim state while the matched topic 
conversation flow runs.

Unresolved task template Template that sets the fields and values when 
the end user requests agent assistance.

Entry & exit criteria
Set the entry & exit criteria for issues processed through an IAR.

Setting Definition

Entry conditions Records that are processed for the Issue Auto 
Resolution  application. Only the issues that 
match the entry condition are processed by 
the Issue Auto Resolution  application.

Exit conditions Condition where the Issue Auto Resolution 
application stops processing when the 
machine learning process is complete.

Machine learning model settings
Select the machine learning models to be used by IAR. Choose a training 
language that you want to use and train the model for intent identification 
when required. The machine learning model contains English, Spanish, French, 
German, Japanese, Dutch, Italian, and Portuguese. To configure new languages 
for a user, add the language(s) in Training detailsTraining language, then 
select Train. For more accurate intent prediction, tune and publish your model 
before turning on IAR. See Issue Auto Resolution Tuning in NLU

Setting Definition

Training language Language in which the training must be 
performed for the machine learning model.

Configuration languages Overview of the machine learning models 
associated with the Issue Auto Resolution 
configuration.
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Machine learning model settings
Select the machine learning models to be used by IAR. Choose a training 
language that you want to use and train the model for intent identification 
when required. The machine learning model contains English, Spanish, French, 
German, Japanese, Dutch, Italian, and Portuguese. To configure new languages 
for a user, add the language(s) in Training detailsTraining language, then 
select Train. For more accurate intent prediction, tune and publish your model 
before turning on IAR. See Issue Auto Resolution Tuning in NLU

(continued)

Setting Definition

Retrain frequency Interval in which the machine model must be 
retrained with the training data.

Advanced Advanced settings that you can enable.

Prediction fields List of fields used as input for processing the 
issue.

Pre-processing extension Server script to perform data cleanup 
or manipulation on the issue before it's 
processed by machine learning APIs. The pre-
processing script is available only when your 
enable the Advanced setting.

Post-processing extension Server script to perform additional actions on 
the results from machine learning APIs. The 
post-processing script is available only when 
you enable the Advanced setting.

AI Search settings

Setting Definition

Apply AI Search AI search results that are delivered if relevant 
Virtual Agent  topics aren't found.

Search application Detailed AI search settings, including the 
search source, number of search results to 
retrieve, and more.

Search results portal Portal to be used in links while delivering 
recommendations to the users on any 
response channel.

AI Search display topic Virtual Agent  topic that performs AI search and 
presents the results.

EVAM definition Definition of how search results from different 
data sources are displayed for the end users 
in cards and lists.
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Intent to topic map settings
Enter your intent and topic map to configure your resolutions using "true" or 
"false". Hover over and select "true" or "false" to edit.

Setting Definition

Intent to topic map List of intents and their associated Virtual 
Agent  topics. When an issue is identified, the 
corresponding topic is delivered to the user for 
automatic resolution.

AI Search settings

Setting Definition

Apply AI Search AI search results that are delivered if relevant 
Virtual Agent  topics aren't found.

Search application Detailed AI search settings, including the 
search source, number of search results to 
retrieve, and more.

Search results portal Portal to be used in links when delivering 
recommendations to the users on any 
response channel.

AI Search display topic Virtual Agent  topic that performs AI search and 
presents the results.

EVAM definition Definition of how search results from different 
data sources are displayed for the end users 
in cards and lists.
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Response channels settings
Admin users and users with the iar_admin role can configure where to deliver 
the resolutions, using Virtual Agent, Email, or SMS.

When at least one intent to topic map is active, the VA response channel is 
mandatory. When AI Search is enabled, one of the three response channels 
needs to be mandatory: email, SMS, or VA.

When VA is selected as a response channel, the user will also receive an 
additional comment on the portal prompting them to open VA to respond to 
the notification. Email templates have also been updated to show a preview 
of AI Search topics to give end users a better idea of the content itself in the 
email.

These are the pre-requisites for response channels.

• To add Virtual Agent as a response channel, install Glide Virtual Agent and 
enable Virtual Agent on Service Portal. Notifications must be enabled on at 
least one active channel. Depending on your organization's needs, admin 
users can also install Conversational Integration with Microsoft Teams on 
Slack.

• To add email as a response channel, ensure email sending is enabled 
in Notifications. To learn more about setting up email notifications, see 
Outbound mail configuration .

• To add SMS as a response channel, install the Twilio Notify app and set up 
the Conversational SMS Integration with Twilio.

Setting Definition

Follow up sequence
Options on how to deliver the deflection 
content to your users:

• All: Delivers the deflection content to the 
user on all available response channels.

• First match: Delivers the deflection content 
on an active channel where the user is 
available, in the order defined by the 
response channels list.

Response channels
List of available response channels to send 
the user deflection content.

When you set the Follow up sequence  to 
First match, the response channel order 
determines the channel that is used to contact 
the user. You can adjust the order number to 
change the priority sequence.

You must set up the email properties to set 
Email  as an active channel.
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Response channels settings
Admin users and users with the iar_admin role can configure where to deliver 
the resolutions, using Virtual Agent, Email, or SMS.

When at least one intent to topic map is active, the VA response channel is 
mandatory. When AI Search is enabled, one of the three response channels 
needs to be mandatory: email, SMS, or VA.

When VA is selected as a response channel, the user will also receive an 
additional comment on the portal prompting them to open VA to respond to 
the notification. Email templates have also been updated to show a preview 
of AI Search topics to give end users a better idea of the content itself in the 
email.

These are the pre-requisites for response channels.

• To add Virtual Agent as a response channel, install Glide Virtual Agent and 
enable Virtual Agent on Service Portal. Notifications must be enabled on at 
least one active channel. Depending on your organization's needs, admin 
users can also install Conversational Integration with Microsoft Teams on 
Slack.

• To add email as a response channel, ensure email sending is enabled 
in Notifications. To learn more about setting up email notifications, see 
Outbound mail configuration .

• To add SMS as a response channel, install the Twilio Notify app and set up 
the Conversational SMS Integration with Twilio.

(continued)

Setting Definition

The Glide Virtual Agent plugin is required, and 
Virtual Agent notifications must be enabled to 
set Chatbot as an active response channel.

You must configure Twilio Notify  to set SMS as 
an active response channel.

Initial recommendation email Email template used to deliver the deflection 
content to users when the AI search 
recommendations are found.

Catalog submitted email Email template used to notify users 
when a catalog item is submitted from 
recommendations made by the Issue Auto 
Resolution  application.

Notify SMS phone Twilio Notify  phone number to be used to 
deliver SMS to users.

Initial recommendation SMS SMS template used to deliver the 
deflection content to users when AI search 
recommendations are found.

Catalog submitted SMS SMS template used to notify users 
when a catalog item is submitted from 
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Response channels settings
Admin users and users with the iar_admin role can configure where to deliver 
the resolutions, using Virtual Agent, Email, or SMS.

When at least one intent to topic map is active, the VA response channel is 
mandatory. When AI Search is enabled, one of the three response channels 
needs to be mandatory: email, SMS, or VA.

When VA is selected as a response channel, the user will also receive an 
additional comment on the portal prompting them to open VA to respond to 
the notification. Email templates have also been updated to show a preview 
of AI Search topics to give end users a better idea of the content itself in the 
email.

These are the pre-requisites for response channels.

• To add Virtual Agent as a response channel, install Glide Virtual Agent and 
enable Virtual Agent on Service Portal. Notifications must be enabled on at 
least one active channel. Depending on your organization's needs, admin 
users can also install Conversational Integration with Microsoft Teams on 
Slack.

• To add email as a response channel, ensure email sending is enabled 
in Notifications. To learn more about setting up email notifications, see 
Outbound mail configuration .

• To add SMS as a response channel, install the Twilio Notify app and set up 
the Conversational SMS Integration with Twilio.

(continued)

Setting Definition

recommendations made by the Issue Auto 
Resolution  application.

SLA & reminders
You can select if you wish to use the SLA engine versus the Task SLA.

Setting Definition

Use SLA engine Task-based SLA engine that provides 
additional flexibility and functionality.

Auto resolution reminders
List of reminders and the Email and SMS 
templates used to deliver reminders.

SLA percentage at which to send the reminder 
using the Email and SMS templates.

To send automatic resolution reminders, you 
must set Use SLA engine  to true.

Note: 
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SLA & reminders
You can select if you wish to use the SLA engine versus the Task SLA.

(continued)

Setting Definition

The SMS Notification template is only available 
when the Notify app is installed.

Task SLA Duration that an issue is assigned to the 
Issue Auto Resolution  application before it’s 
automatically reassigned to a live agent, if not 
yet resolved.

Review

Setting Definition

Review Opportunity to review your configuration 
before you select Enable IAR.

Issue Auto Resolution  diagnostic chat

Admin users can initiate a chat conversation to troubleshoot the settings and functionality of 
Issue Auto Resolution  if an issue arises that wasn't addressed as expected.

Enabling diagnostic chat

To enable the Issue Auto Resolution  diagnostic tool, an admin user must set certain Restricted 
Caller access records to Allowed  on the Restricted Caller Access Privileges table.

To identify the records to allow, follow these steps:

1. Navigate to All  > System Applications  > Application Restricted Caller Access.

2. Filter the records by Source=76fec17dc0e1d5d0f877e9d0ea777a12  (Script Include: 
IARIssueNotAssignedDiagnostic).

3. Navigate to each record and change the status to Allowed.

Diagnostic conversation flows

The admin user enters IAR  in the chat window to initiate a conversation about Issue Auto 
Resolution, and then selects one of two issues:

• An Incident or case isn’t getting assigned to the Bot user.

• An Incident or case isn’t going through Issue Auto Resolution.
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Conversation flow: Incident or HR case is not getting assigned to bot user

1. Confirm your selection, return to search, or search KB articles.

2. Select the type of case or Incident with which you need help, or choose to search all Issue 
Auto Resolution  configurations.
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3. The diagnostic tool performs an analysis on Issue Auto Resolution  configuration and settings 
and displays the results. The diagnostic confirms the following conditions:

◦ The prediction server is up.

◦ There are existing Issue Auto Resolution  configurations.

◦ The configurations are active.

A health check for the selected configuration type also runs to determine if the Incident or 
case is properly configured for Issue Auto Resolution. The diagnostic for an Incident checks 
the following conditions:

◦ Issue Auto Resolution  configuration is active.

◦ Language configuration is active.

◦ There is an active response channel.

◦ There is an active intent topic map for the Incident configuration.
The diagnostic for a case additionally checks that AI Search  has been enabled and doesn’t 
check for an intent topic map. If all the settings are correct and the issue persists, the user can 
choose to continue the conversation.
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4. Enter the Incident or case number and confirm it’s correct.

The bot asks you to confirm the number you entered.

5. The diagnostic tool analyzes the issue to determine if the following conditions are met:
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◦ The trigger condition on the configuration matches the Incident or case values.

◦ The business rule order is the highest.

◦ There’s only one trigger business rule for Issue Auto Resolution  on the Incident or case table 
and it’s active.

If the suggestions don’t resolve the issue, you can choose to run further analysis.

Conversation flow: An Incident or case is not going through Issue Auto 
Resolution

1. Confirm your choice to proceed diagnosing a functionality issue with Issue Auto Resolution.

2. The diagnostic tool checks the following conditions:

◦ The intent prediction was successful (Incidents only).

◦ The criticality is correct and AI Search  is active (cases only).

◦ A notification was sent.

◦ The end user responded to the notification.
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If any of these checks reveal an issue, the diagnostic tool displays a possible solution. Indicate 
whether these solutions resolved the issue, or choose to perform further analysis.

Related topics

Conversational Interfaces Diagnostic Tool

Getting started with Virtual Agent Designer

The Virtual Agent Designer  is a diagram tool for creating and managing topics, which are 
blueprints for conversations between a virtual agent and user. You can design topics that help 
your users resolve common work issues or guide them through self-service tasks.

Virtual Agent  conversations are defined in a topic. When building a topic, there are various 
components (controls) that you can use to build the logic of a conversation, as well as the 
responses that the user sees.

Virtual Agent  can use either generative AI, Natural Language Understanding (NLU), or keywords 
to match the user's request with the appropriate conversation or topic. You can use generative AI 
through Now Assist  in Virtual Agent  to match the user's request with the desired conversation or 
topic. Now Assist  in Virtual Agent  uses large language models (LLMs) and generative AI skills to 
improve deflection rates and reduce the amount of time-consuming work that Natural Language 
Understanding  (NLU) topic discovery requires. With Now Assist  in Virtual Agent, you can test and 
publish your models from within Virtual Agent Designer.

With keyword topic discovery, the topic author associates keywords with the topic. With NLU 
topic discovery, the topic author associates the topic with an intent  within an NLU model. An 
intent describes what the user wants to achieve. User utterances are matched with intents to 
determine the most appropriate topic for the user. Associating a topic with a model and intent is 
called mapping.

If you're using ServiceNow  NLU, then Virtual Agent Designer  integrates with NLU Workbench  so 
that you can map topics to new or existing models and intents without leaving the interface. In 

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1816



addition, you can also modify utterances, test, train, and publish your models from within Virtual 
Agent Designer.

Virtual Agent Designer  Topics page

When you open Virtual Agent Designer, the Topics landing page lists the objects in your 
instance. These objects include topics, topic blocks, custom controls, setup topics, and small 
talk topics. The Topics page lets you access, create, and edit these objects in Virtual Agent 
Designer.

You can also test and preview active topics to verify that they work as intended. You can also sort 
and search for topics. When you have many topics, use the sort filters to quickly organize and 
find your topics. For more information, see Virtual Agent Designer Topics page.

Each topic card identifies the object and provides the following basic information:

• Name: Object name. If the object is a topic block or custom control, the icon for the object type 
is also displayed.

• Published status: Time (minutes, hours, days, or months) that the item was last published and 
state. The status also indicates if the object is read-only.

Source template: Pre-built topics include the word template  in the name. You can duplicate 
these predefined conversation templates and use them.

• Draft state: If you update a published item but have not yet republished it, the Published status 
is marked as Draft. This lets you quickly identify the items that are still in progress.

• Modified: Time (minutes, hours, days, or months) that the item was last updated.

• Category: Type of group to which the topic or object belongs.

Example topic card with publish status and category

Topic properties

Use the topic Properties  tab to identify a Virtual Agent  object and how it is used. The properties 
you can specify depend on the method of topic discovery used in your instance: LLM, NLU, 
or keywords. For example, if you enable NLU in the General Settings  page, the Properties  tab 
includes fields for identifying the NLU model and intent for the topic. Or if you've enabled Now 
Assist  and are working with an LLM topic, the Properties  tab includes fields for what you want 
the topic to do and which assistant(s) to use.

Use the Properties tab to do the following:

• Specify the name and type of object, such as topic, topic block, custom control, and so forth).

• Specify the model type, purpose of the topic, and which assistant(s) can run this topic for Now 
Assist  customers.

• Control who uses the topic and what channels it can run in.

• Associate live agent variables  with a topic.

• Add keywords to the topic or map the topic to a ServiceNow  NLU  model and intent.
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For more information, see Topic Properties tab.

Topic flow

When you create or update a topic, topic block, or custom control, you build the conversation 
flow in the Flow  tab. In the default view, the flow looks like a diagram. Use the controls for user 
inputs, bot responses, and utilities to define the flow. The status of the topic and NLU model (if 
used) appears in the upper-right corner of the window.

The Table View  option in Virtual Agent Designer  displays the nodes in your conversation flow as 
a table, rather than as a diagram. Each node is identified in a corresponding row in the table. You 
can add, change, or delete nodes using these table rows.

For example, instead of dragging and dropping controls onto the canvas, you can select Add 
new node  to insert a node into the appropriate row in the table. When you focus on a particular 
row (node), the corresponding property sheet for the node displays.

As you create or update your design, you might find it helpful to switch between the diagram 
view and the Table View using the Table View  option. If your conversation contains many nodes, 
Table View lets you review all the nodes in your conversation quickly. You can use the Search 
table  option to quickly find a particular node or control.

Use this tab to do the following:

• Design the flow of your topic.

• Define script variables for a topic.

• Use system-derived entities in your topic.

• Add nodeless NLU entities to your topic flow.

For more information, see Topic Flow tab.

NLU model and intent mappings

If you enabled NLU on your instance, the NLU Intent  tab is available for your topics in Virtual 
Agent Designer. Once you've bound the topic to a model and intent on the Properties  tab, you 
can use the NLU Intent  tab to do the following:

• Review and edit utterances and associated entities.

• Train, test, and publish your NLU model.

Test the topic model with user utterances to see if it triggers the appropriate intent and topic. 
You can also test entity recognition.

Note: 
The virtual_agent_admin role includes the nlu_admin role, which enables topic authors to 
work on ServiceNow  models.

For more information about this tab, see Topic NLU Intent tab.

Topic languages

The Languages  tab displays the topic's translation status for languages that have been activated 
on the instance. If you're using NLU, you can also review the language mappings for that topic.

Use the Languages  tab to do the following:
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• View translation status for activated language plugins.

• View and test the topic in a specific language.

• Edit the topic translations.

• Request topic translations in additional languages.

• View or modify NLU language mappings and entity mapping.

For more information, see NLU model mapping in Virtual Agent Designer.

For more information about this tab, see Topic Languages tab.

Designing a Virtual Agent  topic

Walk through the design of an example Virtual Agent  topic that enables users to view incidents 
they submitted. The example highlights various design controls that can be used to build the 
conversation flow.

Using Virtual Agent  tools and features, you can develop conversations that address many 
issues that can be resolved without human intervention. Once you become familiar with the 
product and its capabilities, your creativity is one of the most important tools for developing 
conversations.

To get started more quickly, the following resources are available for Virtual Agent:

Pre-built Virtual Agent topics, topic blocks, and ServiceNow NLU models

These pre-defined conversations help users with common self-service tasks in 
each business area, such as creating or updating cases or providing answers to 
frequently asked questions. Duplicate the pre-built topics  you want to use, and then 
customize them for your organization.

Virtual Agent Topic Recommendations

Use the Topic Recommendations  app to identify pre-built Virtual Agent  topics that 
can be quickly implemented in your organization. Topic Recommendations  uses 
Intent Discovery  to analyze data from your organization and to find relevant pre-built 
topics that your organization can benefit from, and new topics that would be useful 
to create.

Getting started with conversation design

Use Virtual Agent Designer  controls and reusable conversational elements to create the dialogue 
for your conversations between Virtual Agent  and the end user. Before you begin, make sure you 
do the following:

Identify the use case for a conversation.

Determine who will use a conversation topic and the goal, such as solving a user 
problem or assisting with a self-service task. Besides gathering key requirements for 
your topic, identify the information that you need from the user to complete the goal.

For example, you can review your support requests over time and other available 
metrics to determine common issues, use cases, and customer requests or goals. 
From there, you can predict recurring requests or issues that a virtual agent could 
help with.

Determine the structure of a conversation.

As you think about your conversation flow, identify the direct path to resolution. 
Then consider alternate paths where the conversation might branch, depending 
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on the information supplied by the user. Consider how to handle each branch and 
whether users might loop back to an earlier point in the conversation.

Conversations have a beginning (the greeting), a middle, and an end, which may 
include a survey or an incident number to follow up on. In the middle, consider how 
the user might need to switch topics, depending on the issue.

If you're using Natural Language Understanding  (NLU), consider scenarios where 
a user might want to switch topics during a conversation session. For example, a 
user might want to change topics entirely. Or a user might get sidetracked and ask a 
question that seems out of context, maybe to engage in "small talk" with the virtual 
agent. Determine whether you want to let the user resume the original conversation 
after switching topics during the conversation.

You can also review the pre-built setup topics, conversation topics, and topic blocks 
(reusable subflows that perform certain design steps and logic). Determine whether 
you can use these pre-built items and consider customizing them as needed.

Understand the design process in Virtual Agent Designer

When you create a topic in Virtual Agent Designer, the design process involves 
these basic steps:

Topic design process

The topic properties determine the different ways in which a topic is designed and 
used. For example, you can control who uses the topic and any conditions that 
affect how or when the topic is used. If you're using ServiceNow  Natural Language 
Understanding  (NLU), you can associate an NLU model and intent with your topic. 
For details on the properties that you define for various objects, see Create a Virtual 
Agent topic, Create a reusable topic block, and Create a custom control.

Have knowledge in the following areas (what to know before you begin).

• General knowledge of the ServiceNow  platform and application table structures.

• If you're using NLU, an understanding of how intents, entities, and utterances are 
used in your NLU models.

• If you're using scripts in conversation design, an understanding of HTML, 
JavaScript, and REST integrations.

Plan the structure of a conversation

The first step in implementing a Virtual Agent  topic is to decide what the topic covers. Consider 
the intended audience and what you want the audience to accomplish when using the 
conversation. For this example, the goal of this example topic is to create a flow that enables end 
users to see the status of incidents they submitted. The topic includes an option for the user to 
add a comment to the incident.

With this goal in mind, the topic needs the following elements:
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• A prompt for the user to select an incident

• An output showing the status of the incident

• A prompt to ask if the user wants to leave a comment

• A utility control to branch the conversation on that answer

• A prompt for the user to enter a comment

• A utility control to add the user input as a comment in the incident

Build the conversation flow with Virtual Agent  controls

The conversation will look similar to the following dialogue flow.

Important: 
This flow is intended to give you a general idea of how a completed flow looks. Keep in mind 
that you will be building your topic incrementally and testing your topic frequently, so it's not 
necessary to build the entire layout first. Make sure to consider both functionality and user 
experience in your testing.
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A completed conversation flow

Configure controls within the conversation

This example begins with defining the conversation flow in Virtual Agent Designer, after the topic 
properties have been set. The conversation begins with a Start node and finishes with an End 
node.
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1. In Virtual Agent Designer, add a Dynamic Choice  control to the conversation flow. This control 
is used to select the incident.

a. Enter Choose an incident  for the Node name  property. The variable name 
choose_an_incident  is automatically generated for the control.

b. In the Prompt  property, enter the text the user sees before selecting an incident.

c. In the Populate choices by  property, select Record.

d. In the Table  property, select Incident [incident].

e. In the Filter choices  property, select the Condition  option, and create a condition:

▪ Active is true AND Assignment group is Hardware AND Category is Database

AND

▪ State is New OR State is In Progress

An example condition builder

2. Add a Card  control to the flow. This control shows information from the record selected by the 
Dynamic Choice  in the previous step.

a. Enter Status Card  for the Node name  property.

b. In the Card type  property, select Record.

c. In the Record  property, select Choose an Incident. This choice refers to the Dynamic Choice 
control created in the previous step, so the data displayed comes from the record chosen 
there.

d. In the fields  control, select a field. The choices available are the available fields on the 
chosen record. In this case, you can see the fields on the incident table.

e. After a field has been selected, click the Add Field  option to add additional fields to the card. 
To delete fields from the card, click the delete icon to the right of the field.

3. Add a Boolean  control to the flow. This control is used to prompt the customer with a yes/no 
question. In this case, the control checks whether the user wants to leave a comment on the 
selected incident record.
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a. Enter Leave Comment?  for the Node name  property. The variable name 
leave_comment_  is automatically generated for the control.

b. In the Prompt  property, enter the text the user sees before the prompt. In this case, ask 
users whether they want to leave a comment on the incident.

4. Add a Decision  control to the flow. This control branches the conversation into two possible 
paths. The path the conversation follows depends on the choice the user made in the previous 
step.

a. There are no properties on the decision control; however, there are properties on the 
branches below the decision. By default, there is a single branch labeled Always. Click the 
blue plus icon at the bottom of the decision control. A second branch appears that is also 
labeled Always.

b. Click one of the branches to access the properties for this branch.

c. Change the name to Leave Comment.

d. In the condition property, select the Condition  option and click the Add Condition  button. 
Use the condition builder to create a condition as shown in the following screen shot.

If the value of the Leave Comment?  is true, this condition is met. This variable is the variable 
from the Boolean control in the previous step. If the user chose Yes  at that prompt, the 
conversation follows this branch.

e. Click the other branch of the decision to access the properties for this branch.

f. Change the name to No Comment.

g. In the condition property, select the Condition  option and click the Add Condition  button. 
Use the condition builder to create a condition as shown in the following screen shot.
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If the value of the Leave Comment?  is false, this condition is met. This variable is the 
variable from the Boolean control in the previous step. If the user chose No  at that prompt, 
the conversation follows this branch.

h. One of the two branches you have created points to the End  node of the conversation. The 
second branch should also lead to this node. Click the arrow at the bottom of that branch 
and drag it to the End  node.

5. Add a Text Input  control to the Leave Comment  branch of the conversation. This control is 
used to request text input from the user.

a. Enter Get Comment  for the Node name  property. The variable name get_comment  is 
automatically generated for the control.

b. In the Prompt  property, enter the text the user sees before the prompt. In this case, ask the 
user for the text of the comment.

c. Optionally, you can enter a value in the Advanced  > Confirmation messages  > Input 
completion confirmation  property. This value appears after the user enters a comment.

6. Add a Record Action  control to the conversation below the Get Comment  control. This 
control is used to add the text entered into the previous control as a comment on the selected 
incident.

a. Enter Update Incident  for the Node name  property.

b. In the Action Type  property, select Update a Record.

c. In the Record  property, select Choose an Incident. This choice refers to the Dynamic Choice 
control created in the previous step, so the record chosen there is the one that this Record 
Action control updates.

d. In the Field  property, click Add Field. You can select and give values to fields from this record 
in the pop-up window that appears.

e. Select the Additional Comments  field from the list.

f. Click the data pill picker icon ( ), and then select the Get Comment  input variable from 
the list. This option refers to the value entered by the user in the Text Input  control in the 
previous step.

g. Click Save.

Test the conversation

Use the Test  button to test the flow of the conversation. Preview topics often throughout 
the design process to find errors or unexpected behavior quickly. For further information on 
identifying and resolving issues with topics, see Debug a Virtual Agent topic.
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Create a Virtual Agent  topic

Use Virtual Agent Designer  to create and modify Virtual Agent  topics (conversations). Build your 
topic to meet a specific objective or goal, such as fulfilling a user's request or helping a user 
complete a task.

Before you begin
Do the following:

• Review Getting started with Virtual Agent Designer.

• Configure Virtual Agent  settings. For example, if you're creating Natural Language 
Understanding  (NLU) topics, configure NLU settings. For more information, see Configure 
Natural Language Understanding in Virtual Agent. If you're creating large language model 
(LLM) topics, turn on Now Assist  in Virtual Agent. For more information, see Configuring Now 
Assist in Virtual Agent.

• Plan your conversation before you begin. For more information, see Designing a Virtual Agent 
topic.

• Verify that you're in the appropriate application scope before you create or update a 
topic. For example, if you're creating ITSM  topics, verify that you're in the ITSM Virtual 
Agent Conversations  scope (and not the scope for the ITSM  NLU  Model for Virtual Agent 
Conversations). For details, see Change the application scope in Virtual Agent Designer.

Role required: virtual_agent_admin or admin

About this task
The topic is in the Inactive state until you publish it. Publishing a topic changes the topic state to 
Active and automatically deploys the topic to your Virtual Agent  clients.

The Large Language Model (LLM) topic type is faster and easier to set up compared to using 
Natural Language Understanding. You don't have to select NLU  intents or train NLU  models for 
your virtual agent. For more information, see LLM topic discovery in Virtual Agent.

When NLU  is enabled, the Set up Natural Language Understanding (NLU) section is displayed 
in the Topic Properties page. You can use this section to specify the associated NLU  model 
and intent for the topic. You can also optionally specify keywords that Virtual Agent  can use as 
a fallback if NLU  doesn't return a matching intent and topic. For more information, see Natural 
Language Understanding (NLU) topic discovery in Virtual Agent.

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer.

2. In the Topics page, select Create.

3. On the form, fill in the fields.
For a description of the field values, see the Create a topic form.

4. Select Create.

5. On the Flow  tab, build the conversation flow.

Flow 
steps

Description

Add 
controls To create the topic flow:
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Flow 
steps

Description

a. Select the controls for user inputs, bot responses, or utilities from the palette and 
drop them onto the canvas.

When you add a control to the canvas, it becomes a node in the conversation 
flow.

b. For each node, complete the corresponding property sheet. In the topic header 
bar, select Save. The topic header bar displays a Saving in progress... 
message. The toast message Successfully saved your topic  appears 
in the lower-right corner afterward for 4 seconds, and can be closed by selecting 
the X  in the message.

For details about each control and the corresponding properties that you define, 
see User inputs, Bot responses, and Utilities.

As you add controls, watch for a yellow warning badge or a red error badge in the 
corner of the control. The number on the badge indicates the number of issues 
in that control, such as missing mandatory information in the property sheet. 
(Highlighting a badge or the "Incomplete" banner at the top of the property sheet 
details the items in need of correction.)

Move a 
node

Select the node, drag it to the new location in the flow, and Select Save.

Delete 
a node Select the X  in the upper right corner of the node. In the topic header bar, select 

Save. The topic header bar displays a Saving in progress...  message. 
The toast message Successfully saved your topic  appears in the 
lower-right corner afterward for 4 seconds, and can be closed by selecting the X  in 
the message.

Note: 
You can't delete a node that has a script variable used by subsequent 
JavaScript expressions in the flow. Also, you can delete a decision node only 
when it has a single branch.

6. Select Test  in the header bar to test your topic in a chat window.
You can review test results in the adjoining tabs. For detailed information, see LLM topic testing 
and Testing NLU/Keyword topics.

If the Now Assist  panel or Microsoft Teams  is configured for your environment, preview options 
for those channels display in the Test button list. Select Preview in Now Assist panel  or 
Preview in Microsoft Teams  in the list to test your topic in those environments.  For more 
information, see Integrating Virtual Agent with enterprise messaging apps.

7. When you're finished with the topic, select the More actions on Topics icon ( ) in the topic 
header bar, then select Save.
The topic is in the Inactive state until you publish it.
The topic header bar displays a Saving in progress...  message. The toast message 
Successfully saved your topic  appears in the lower-right corner afterward for 4 
seconds, and can be closed by selecting the X  in the message.
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What to do next
Publish  the topic to deploy the topic to your Virtual Agent  clients. The topic state changes to 
Active.

If you created a topic that might be frequently used in certain contexts (environments), consider 
promoting the topic as part of the default or custom chat experience.

NLU  model mapping in Virtual Agent Designer

ServiceNow®  model groups help you to manage the localization of both topics and Natural 
Language Understanding  (NLU) models more easily. You can map Virtual Agent  topics to a new or 
existing model group directly from Virtual Agent Designer.

A topic is a Virtual Agent  conversation. Users find the appropriate conversation using either 
keyword or NLU  topic discovery. If you're using NLU for topic discovery, this means that your topic 
is associated with an NLU  intent, which contains potential user utterances and other information. 
When a topic is associated with an intent, it’s mapped  to that intent. An NLU  model is a group of 
related intents.

When you create or edit a topic and have ServiceNow  NLU  turned on, then you can do the 
following in Virtual Agent Designer:

• Map the topic to an existing model and intent.

• Map the topic to an existing model and create an intent.

Mappings are created for all languages that have been activated in NLU  Settings as well. For 
more information, see Configure Natural Language Understanding in Virtual Agent.

• Create and map the topic to a new model and intent.

If more than one language has been activated in NLU  Settings, mappings are automatically 
created for secondary languages in the new model group. For more information, see Topic 
mapping to a multilingual NLU model group.

For example, when creating a topic, you can select the NLU  model and its associated intent. In 
the following Company email issues topic, the selected model from the NLU Model drop-down 
list is the ITSM NLU for Virtual Agent (11 languages)  model. After selecting the NLU  model, the 
intent list refreshes and you can select your preferred intent. This action maps the NLU  intent 
to this topic. You can change the NLU  model and intent selections later on through the topic's 
Properties  tab, if needed.
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Topic mapping to a multilingual NLU  model group

When you map a topic to a multilingual model group in Virtual Agent Designer, the topic 
mappings for enabled languages are set up automatically.

Model groups contain a primary language model, such as English, and secondary language 
models. Secondary models are translated copies of the primary model, where each secondary 
model uses a different language. Any supported language can be the primary language for a 
primary model or the secondary language for a secondary model. The language is reflected 
in the model name. For example, FR  for French, DE  for German, JA  for Japanese, and ES  for 
Spanish.
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Multilingual model groups contain one primary language model and multiple 
secondary language models

You can view or change the model and intent mappings on the topic Properties  tab. You can 
review secondary language mapping on the topic Languages  tab.

Because secondary model content is only a translated copy of its primary model content, the 
secondary language mappings must always point to the same model group as the primary 
language. For this reason, if you map a language in a topic to a model that is part of a multilingual 
model group, then all of the topic mappings are updated to use the language models in that 
group. Virtual Agent Designer  informs you of the change.

Updated NLU mappings message

Note: 
You can map single-language models to a topic as long as there is no conflict with the 
corresponding language models in the group.

If you create a model group in NLU Workbench, you can specify the primary language. If you 
create a model from within Virtual Agent Designer, the primary language is determined by the 
user session language. For example, if you create a new model in a German user session, the 
primary language of the model group will be German.

Model groups make it easier to maintain your topics. For more information about NLU model 
groups, see Multilingual model management .

Note: 
If a model contains only a single language, that language is considered to be the primary 
language. The topic is mapped to the model and specified intent only. If more than one 
language has been activated in NLU  Settings, those languages are not mapped to the 
model. To use the topic in other languages, map them to other models manually on the 
Languages  tab. For more information, see Map a topic to a secondary NLU model.
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Handling disabled intents within a model

If an intent for the primary language within the model group is disabled, the primary intent 
displays as disabled in Virtual Agent Designer. When the primary language is disabled, the intent 
is still mapped to the topic, but all secondary intents are also shown as disabled. This is because 
the secondary languages are always dependent on the primary language within a model. If an 
intent for one or more secondary languages is disabled, the other languages remain active. 
Virtual Agent Designer  displays messaging to indicate that some intents are currently disabled.

Topic with a disabled French intent on the Languages tab

To allow topic discovery for the language, enable the intent in NLU Workbench. For more 
information, see Enable or disable a secondary model intent .

Avoiding model conflicts

In order to avoid conflicts, Virtual Agent Designer  may not display all of the existing models when 
you create or modify topics. Virtual Agent Designer  does the following:

• Only displays model groups that contain language models that reflect the user's current 
session.

• Shows a warning if the selected model group has language mappings that will change existing 
language mappings, whether in another model group or in a single-language model.

• Automatically maps intents in each language model in the group to the topic.

• Ensures that duplicate model names or intent names are not used.

• If a topic is mapped to a multilingual model group, hides single-language model groups on the 
NLU Language Mapping  tab.

If languages in a topic are mapped to intents in more than one model group, conflicts may occur. 
An intent can only be mapped to one topic. If this situation occurs when you attempt to publish a 
topic, Virtual Agent Designer  displays an error message.

Modify NLU utterances and entities for a Virtual Agent  topic

View, test, and modify NLU utterances for a Virtual Agent  topic on the NLU Intent  tab in Virtual 
Agent Designer.

Before you begin
If the topic is not currently mapped to a model and intent, the NLU Tab is not available. Specify a 
model and intent on the Properties  tab in Virtual Agent Designer.
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Role required: virtual_agent_admin or admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer.

2. Open a topic and view the NLU Intent  tab.

3. On the Utterances  tab, you can do the following:

◦ Type a new utterance in the box, and then click Add.

◦ Click the pencil icon to edit an utterance.

When you are done making changes, click Save.

4. Optional:  Associate entities with words in utterances.
Entities represent the context for the action. For example, common industry terms can 
be defined as entities to clarify the context. Universal system entities may include known 
elements like date and time or currency. NLU can match defined entities with user input to slot-
fill the values. There are five types of entities you can define. For detailed information, see NLU 
entities .

5. Click Save  in the header bar.

What to do next
After making changes, you can train, test, and publish the model  from this tab.

Add NLU  to an existing keyword topic

Create and map an NLU  model group and intent for the topic from Virtual Agent Designer.

Before you begin
Configure NLU on the instance in Virtual Agent General Settings.

Role required: virtual_agent_admin or admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer.

2. Open an existing topic.

3. Select the Properties  tab.

4. In the NLU Model  field, do one of the following:

Note: 
If the NLU model  field does not appear and you have Now Assist  enabled, ensure that 
you haven't selected an LLM topic. Navigate back to the Topics page and select a topic 
that has the Model Type  set to NLU/Keywords.

◦ Choose an existing model.

◦ Select Create Model  to create a new model group.

a. In the Model Name  field, enter a name for the new model group.

b. In the Intent name  field, accept the default value or enter a name for the new intent.

Note: 
New models are created in Draft  state.

5. In the Associated Intent  field, do one of the following:
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◦ Choose an existing intent.

◦ Select Create intent  to create a new intent.

In the Intent Name  field, accept the default value or enter a name for the new intent.

6. Optional:  In the Keywords  field, enter key phrases or terms that users enter to initiate the 
conversation with the Virtual Agent.
Press Enter  after each phrase. Keywords are also used for languages that are currently not 
available in NLU.

7. Select the NLU Intent  tab, and then add utterances and associate entities with them.
For more information about adding utterances, see Create an NLU intent . For more 
information about defining entities, see Entities .

8. Make any other changes on the Flow  tab, such as associating entities with a node or adding 
entities as input variables for the topic.

9. When you're finished with the topic, select Save  in the topic header bar.

Result
The modified topic is in the inactive state until you publish it.

Add nodeless NLU entities as input variables to a topic

You can add nodeless NLU entities as input variables to a topic if NLU is enabled for Virtual 
Agent. These variables can be slot-filled from NLU service provider predictions or provided 
outside of the scope of the topic.

Before you begin
Role required: virtual_agent_admin or admin

About this task
If a custom control prompts a user for a date and the user mentioned a date in their initial 
utterance, you can capture that without prompting the user again. To prompt the user when not 
slot-filled, use input controls.

For more information about NLU  entities, see Entities . For more information about system 
entities, see NLU system entities.

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer.

2. Open a topic and view the Flow  tab.

3. In the Variables sidebar, click the Input  plus icon.

4. On the form, fill in the fields.

Add Input Variable dialog box

Field Description

Input 
Types

Data type of the input. The fields on the dialog box change according to your 
choice.

◦ String: Alphanumeric text. Shows the Input format  field. Choose plain text or a 
conforming rule, depending on the type of data.

◦ True/False: Boolean value, either yes or no.

◦ Date Time: Date, time, or both. Shows the Input format  field.
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Field Description

◦ Static Choice: Defined user choices. Shows Display name  and Value to store 
field pairs.

◦ Dynamic Choice: Choice of table records. Shows Populate choices by, Table, 
and Filter choices  fields. The value can be either conditional or scripted.

For details, see Input data types in Virtual Agent topics.

Name Name of the variable for the entity.

Variable names must be unique within the scope of a topic. The name appears 
as a variable when used in dot walking.

NLU Entity The NLU entity associated with the node.

This could be a pre-built Virtual Agent  entity that you import into the model, a 
system entity (such as DURATION, TIME, or MONEY), or a custom entity that you 
created.

String data type properties

Input 
format Text format that is validated when a user enters certain text items. If the user 

doesn't enter the expected format, an error message indicates that the format is 
not valid and asks the user to reenter the text.

Choose the format of the text item to be validated:

◦ Text: Any text string (no validation)

◦ Email: Format that consists of an email prefix (user name), @ symbol, and 
domain.

◦ IP address (IPV4, IPV6): Data communication delivery format for Internet 
Protocol version 4 or version 6.

◦ Phone number (E.164): Internationally recognized standard phone number 
format.

◦ URL: Web address format

◦ Custom: Script that provides a text validation rule for a custom text format 
and the related error messages displayed when the expected format is not 
entered.

Note: 
For phone and IP address format examples, see E.164 phone formats  and 
IP address field types .

Date Time data type properties

Input 
format

Type of Date Time control to be displayed. Select one of the following formats:

◦ Date: Shows only the monthly calendar for the user to select the date.

◦ DateTime: Shows both a monthly calendar and time picker.

◦ Time: Shows only the time picker for the user to select the time (hours and 
minutes).

Static Choice data type properties

Choices Enter two or more choices as follows:
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Field Description

[For Static 
Choice 
data type]

◦ Display name: Short phrase or text that appears to the user for that choice.

◦ Value to store: The string that is stored in the variable when the corresponding 
choice is selected.

Dynamic Choice data type properties

Populate 
choices 
by

Type of dynamic variable to be used. Select one of the following options:

◦ Record: Returns records from the table selected. The values for these options 
are GlideRecord objects.

◦ Script: Expression that returns an array of options.

Table

[Record 
values 
only]

If you selected Record  as the method to populate choices, select the table to be 
searched.

Filter 
choices

[Record 
values 
only]

Select one of the following:

◦ Condition Builder: Creates a filter used to select a subset of records from the 
table.

◦ Script: Defines the enumeration list for the options (choice list) to be 
displayed. The name value pair is stored as a string object.

5. Click Save.

NLU entities appear alongside topic input variables in the Variables sidebar.

Note: 

You can remove a slot-filled value to prompt the user again (unbind it from the initial input 
value). For more information, read about the vaInputs.myvar.unbindEntity(); 
method in Virtual Agent scripts.

Branch a Virtual Agent  conversation with a Decision utility

Your conversations may need to branch depending on end user input or choices. Use the 
Decision utility to branch the conversation when certain conditions are met.

Before you begin
For more information about the Decision utility, see Decision utility.

Role required: virtual_agent_admin or admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer.

2. Open a topic and view the Flow  tab.

3. Drag the Decision  utility onto the canvas.

The Decision  utility node added to the canvas has a single branch named Always  by default.
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Note: 
If you insert a Boolean  user input control, you're prompted to add a Decision  utility 
directly after the Boolean node on the canvas. Selecting Yes  on the Boolean node's 
Decision utility prompt automatically generates two branches named True  and False. 
The two branches conditions are automatically set through the condition builder.

4. Click the plus sign (+) under the node.
A second branch named Always  is added below the Decision utility node.

5. Click the plus sign (+) under the node to add additional branches.

6. Click a branch label, and then specify the branch properties in the form.

Field Description

Name Unique name for the branch.

Condition Expression logic to specify a condition for following this branch in the 
conversation. The condition must evaluate to true.

◦ Condition: Use the Condition builder  to add or edit conditions.

◦ Script: Use the script editor to create or edit a script that contains a condition 
statement.

7. Define the properties for each branch in the Decision utility.

8. When you're finished with the topic, click Save  in the topic header bar.

Insert a header card in a Static Choice or Dynamic Choice control

When you create a Virtual Agent  topic, you can include images and YouTube videos on Static 
Choice and Dynamic Choice user input controls.

Before you begin
Role required: virtual_agent_admin or admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer  and open a topic or 
create a new one.

2. On the Flow tab, drag a Static Choice or a Dynamic Choice user input control onto the canvas.

3. On the Properties sheet, go to Advanced (optional), and then expand the Header card 
section.

4. Slide the Insert  toggle switch to enable it.
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Insert a header card

5. Under Would you like help?, select either Yes  or No, I will use a script.

◦ If you selected Yes, select Add card  and complete the following form fields.

Add card dialog box

Field Description

Card type Type of header card:

▪ Large image with text

▪ Small image with text

▪ Youtube Video Card

The fields in the dialog box change according to your choice.

Title Image or video title. You can enter it directly in the text field or use a data pill 
or script to provide the value.

Title Link The URL to use for the video title hyperlink. You can enter it directly in the text 
field or use a data pill or script to provide the value. If this field is empty, the 
title displays as plain text.

This field is only available for the YouTube video card option.

Description Brief description of the image or video.

Image URL 
Link

URL link for the image. You can enter it directly in the text field or use a data 
pill or script to provide the value. You can also select Upload Image  to upload 
the image.

This field is only available for the large and small image card options.

Image alt 
text

Alternative, screen-readable text that describes the image. It’s used for 
accessibility programs.

This field is only available for the large and small image card options.

Youtube 
Video ID

The alphanumeric string at the end of the YouTube URL. For example, in the 
URL https://www.youtube.com/watch?v=AacDp2mUQ1I  the 
YouTube video ID is AacDp2mUQ1I.
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Field Description

This field is only available for the YouTube video card option.

◦ If you selected No, I will use Script, select Add script  to input a script to display your desired 
media, following the example in the script dialog box.

Header Card script example

function() {
    /*
        var cardName = "Large image with text";
        var cardData = {
            title: 'Choose color',
            description: 'choose the right color of 
 the flowers in the image',
            image: 
 'https://homepages.cae.wisc.edu/~ece533/images/tuli
ps.png',
            imageAlt: 'Choose color'
        }
        var template = "";
        if 
 (vaSystem.isAMBClient(vaContext.deviceType))
            template = 
 vaSystem.fillTemplateFromData(cardName, 
 JSON.stringify(cardData));
      return {
          cardTemplate: template,
          cardName: cardName,
          cardData: JSON.stringify(cardData),
          renderStyle: "card"
      };
    */
    }

6. Select Save.

Change the application scope in Virtual Agent Designer

Set the application scope before you create or update a topic. For example, if you're creating 
ITSM  topics, verify that you're in the ITSM Virtual Agent Conversations  scope (and not the 
scope for the ITSM  NLU Model for Virtual Agent  Conversations).

Before you begin
Role required: virtual_agent_admin or admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer.

2. On the Topics page, select the Globe icon  in the navigation bar.

3. Select Application Scope, and then choose the appropriate scope for your conversations.
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For example, select HR Service Delivery Virtual Agent Conversations.

Note: 
If you're using domain separation, you can change the domain you're working in. Select 
Domain scope: global  to change the domain. Any topics created within a domain are 
restricted to users of that domain. For more information, see Domain separation and 
Virtual Agent.

Result

When the scope is not Global, the Globe icon displays with a red ring: . Select it again to 
change the scope.

Define script variables for a topic

Use the Variables sidebar to define script variables for a topic. Script variables can store 
information that is not found in ServiceNow  tables. This information can then be shared 
elsewhere in a topic.

Before you begin
Role required: virtual_agent_admin or admin

About this task
For more information about writing scripts for Virtual Agent, see Virtual Agent scripts.

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer.

2. In the Topics page, open an existing topic or create a new one.
The Flow  tab displays the conversation flow.

3. In the Variables sidebar, click the Script  plus icon.

4. On the form, fill in the fields.

Add Script Variable dialog box

Field Description

Variable 
name

Name of the variable. The name is case-sensitive. Spaces in the name are 
replaced with an underscore character.

Default 
value

Default value for the variable. You can use either a static value or a script that 
specifies a dynamic value for this variable.

5. Click Save.

Create a small talk topic

Build small talk topics that let Virtual Agent  engage in casual conversation with users. A small talk 
topic provides a response to a casual question that users might ask during a conversation, such 
as the time or date. A small talk topic can occur anytime within a conversation session and can 
be unrelated to the original conversation intent.

Before you begin
Define the corresponding intent for a small talk topic in the appropriate NLU model.

Role required: virtual_agent_admin or admin
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About this task
Small talk topics are NLU-based conversations that diverge from the original bot conversation, 
usually to provide answers or information to casual questions that end users might ask. For 
example, you can create small talk topics that provide the current weather or time of day. When 
users engage with the bot through a small talk topic, they can return to the original conversation 
topic.

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer.

2. In the Topics page, click + Create.

3. For the Type, select Small Talk.

4. Follow the steps for creating a topic, including the NLU-related properties.
Note the following:

◦ When you set the topic properties in the Properties page, set the following NLU properties 
for the small talk topic:

Field Description

NLU Model Model that defines the intent for this small talk topic.

Associated intent Intent defined in the NLU model for this small talk topic.

◦ When you complete your small talk topic, remember to publish it when you are ready to 
deploy it to your Virtual Agent  clients.

Control topic discovery and visibility

Admins and topic authors can enable Virtual Agent  to discover topics for use in chats, include a 
topic in the list users see, or both. The topics can be setup topics and small talk topics.

Before you begin
Role required: virtual_agent_admin or admin

About this task
Virtual Agent Designer  includes two options in the Active  option of the header bar.

Active option menu
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Admins or topic authors can use these options to manage the active topics as follows:

• Include the topic in topic discovery.

By selecting Included in topic discovery, admins or topic authors can enable Virtual Agent  to 
discover the topic by using keyword or Natural Language Understanding  (NLU) discovery.

Note: 
If these methods don't generate search results, or Virtual Agent  can't determine the 
appropriate conversation to display, use AI Search  as a fall-back method.

• Include the topic in the list of topics available for use.

By selecting Included in list of topics, admins or topic authors can include the topic in the All 
Topics  menu. The All Topics  menu lists all of the topics available for use.

To see the All Topics  menu, first select Show me everything  in the chat window.

You should then see the All Topics  menu.
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The options you select automatically update the corresponding property in the Topics 
[sys_cs_topic] table. For example, if you've enabled Included in topic discovery, the Is Topic 
Discoverable  property in the Topics [sys_cs_topic] table is set to true.

Is Topic Discoverable option in the Topics table

Note: 
If the fields are not visible, you can configure the form layout  to show them.

Procedure

1. Create a Virtual Agent topic.

2. Select the Active  option in the header bar.

Note: 
Selecting this option also publishes the topic.

3. Select the options you want to use, or accept the default settings.
Some options are enabled or disabled by default, based on the type of topic.

Default settings by topic

Options

Included in Topic Discovery Included in the list of topics

Topics Enabled Enabled

Setup topics Disabled Enabled
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Options

Included in Topic Discovery Included in the list of topics

Small talk topics Disabled Enabled

4. Select Save.

5. Optional:  Select Test  to test the topic.

Result
Depending on the options enabled, Virtual Agent  can discover the topic, the topic is included in 
the All Topics  menu in the chat window, or both.

Use system-derived entities in a topic

Associate system-derived entities such as such as date, time, duration, or location with a node in 
a topic.

Before you begin
Create the Booking Reservations  NLU model and system entities (FromLocation  and 
ToLocation) as described in Create a system-derived entity . In this example procedure, you 
will create a topic that can slot fill locations that are used in an utterance.

Role required: virtual_agent_admin or admin

Procedure

1. Create a new topic  called Booking Reservations.
When completing the Properties  tab, make sure that you choose the Booking Reservations 
NLU model that you created in an earlier exercise.

2. Drag a Text bot response component onto the canvas, and then select it.
In the properties sheet, fill in the fields.

Response Properties sheet

Field Description

Node name Type Intro.

Response Message Type Let's get you booked on a flight.

Intro Text response properties
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3. Drag a Text user input component onto the canvas.
In the properties sheet, fill in the fields.

User Input Properties sheet

Field Description

Node name Type Fromwhere.

Prompt Type Where are you departing from?

Input format Select Text. This doesn't restrict the input format.

NLU entity Select FromLocation.

This list only shows existing entities, such as system entities or 
entities that you created for the model.

Do not ask users to confirm 
recognized entity Select this option to avoid having Virtual Agent  ask the user to 

confirm the location.

Advanced (optional)

Topic switching

Enable NLU to switch topics Slide this toggle switch to enable topic switching.
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Fromwhere Text user input response properties

4. Drag another Text user input component onto the canvas.
In the properties sheet, fill in the fields.

Field Description

Node name Type Towhere.

Prompt Type Where are you heading?

Input format Select Text. This doesn't restrict the input format.

NLU Entity Select ToLocation.
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Field Description

This list only shows existing entities, such as system entities or 
entities that you created for the model.

Do not ask users to confirm 
recognized entity

Select this option to avoid having Virtual Agent  ask the user to 
confirm the location.

Advanced (optional)

Topic switching

Enable NLU to switch topics Slide this toggle switch to enable topic switching.

Towhere Text user input response properties
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5. Drag another Text bot response component onto the canvas, and then select it.
In the properties sheet, fill in the fields.

Field Description

Node 
name

Type Confirmation.

Response 
Message

Type Great! I have you booked on a flight from 
[Fromwhere] to [Towhere]. Bon voyage!  Use dot-walking to replace 
[Fromwhere]  and [Towhere]  with the input variables you created in the 
previous nodes.

Confirmation text response properties

6. Click Save.

What to do next
Use additional system-derived entities for your Booking a Reservation topic. For example, you 
can use system-derived entities to capture the dates that the user wants to travel.
For more information about default system entities, see NLU system entities.

LLM topic migration

The topic migration workflow enables you to convert your existing Natural Language 
Understanding  (NLU) and keyword topics into new large language model (LLM) topics.

Now Assist  capabilities bring generative AI to Virtual Agent  using LLM topics. With topic 
migration, there’s no need to manually recreate all your NLU  and keyword topics to be LLM 
topics. You can select the topics that you want to migrate into LLM topics from your existing 
NLU  and keyword topics. Migrating NLU  and keyword topics doesn’t change the original NLU  or 
keyword topics. A copy of the existing topic is created during topic migration, but the new topic's 
Model Type  field is set to LLM and includes LLM-compatible nodes and descriptions.

All types of topics can be migrated from the NLU/Keyword model type to the LLM model type 
during topic migration, including the following object types:
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• Topic

• Topic block

• Setup topic

• Small talk

• Custom input control

• Custom response control

If no migration issues occur, the preceding object types can all optionally be published except 
the topic block. Although dynamic topic blocks can be optionally published, the topic block type 
is automatically published after it's been migrated.

Roles and accessibility

Users with the virtual_agent_admin role or sn_vad_genai.topic_migration_admin role can work 
with topic migration. Topic migration is accessible through Virtual Agent Designer  in the Migrate 
Topics to LLM  option.

Topic descriptions

When migrating NLU  topics to LLM topics, you can choose whether you want to have generative 
AI create your LLM topic descriptions. When on the Settings page of the topic migration 
workflow, you can choose to Keep current topic descriptions?. The Keep current topic 
descriptions?  option is off by default. When this setting is off, generative AI pulls either NLU 
intent utterances or keywords from topics to create LLM topic descriptions during the migration 
process. If the topic is associated with an intent, a maximum of 10 utterances are pulled into 
the LLM topic's Detail description  field under an Additional instructions  value. 
When this setting is on, generative AI doesn’t create LLM topic descriptions and your existing 
NLU  and keyword topic descriptions migrate into your new LLM topics. Migrating existing topic 
descriptions can result in issues if the existing topic doesn’t have a description.

The Detail description  field is required for LLM topics but not for NLU/keyword topics. If a 
new LLM topic is migrated over with an empty description, you must add a description prior to 
that topic being published. Regardless of how topic descriptions migrate, you can edit topic 
descriptions during the Publish (optional) page of the topic migration workflow by double-
clicking (or use the keyboard shortcut) the text in the Description column. For more information 
on editing topic descriptions, see Migrate NLU topics to LLM topics. For examples of strong topic 
descriptions, see LLM topic and node description examples.

Node descriptions

Although NLU  topics' node names migrate exactly as-is during migration, the node descriptions 
can vary. NLU  input nodes use the Prompt  field. LLM input nodes use the Detail description 
field. During topic migration, the value in the Prompt  field migrates into the Detail description 
field's value. How the value migrates can vary depending on if that value included text-only, 
scripts, or data pills. Refer to the following table to view how the values migrate differently and 
compare examples.
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How the Prompt field's value migrates to the Detail description field's value

NLU  Prompt field value LLM Detail description field value

Contains text Migrates text as-is.

For example, if the NLU  Prompt  field's value 
is Enter the incident number, then 
the LLM Detail description  field's value is also 
Enter the incident number.

Contains script or data pill Migrates using the following template: 
Collect + Node name.

For example, if you have an NLU  node named 
Get incident number  and the Prompt 
field's value contains a script or data pill, then 
the migrated LLM node's Detail description 
field's value is Collect Get incident 
number.

If the topics that you plan to migrate include scripts or data pills in their existing Prompt  field, 
review and update the LLM Detail description  field after migration for each affected topic. A 
warning message of Add relevant detail description  appears for LLM topics on 
the Virtual Agent Designer  canvas for each node that migrated with the template of Collect + 
Node name. Updating the description to something more accurate and descriptive improves 
your users' experience of interacting with the Virtual Agent. For an example of a strong node 
description, see LLM topic and node description examples.

The following entities can be migrated from NLU  nodes to LLM nodes:

• simple

• mapped

• pattern

• system-derived

If an NLU  node is mapped to an entity, those utterances' entities are added to the LLM node's 
Detail description  field under an Additional instructions:  make-shift header value. 
The Additional instructions:  content differs slightly depending on the type of entity 
that is migrated. The layout of the Detail description  field value resembles something like the 
following:

• [Prior NLU Prompt field value]  if the value was text-only and not a script or data 
pill.

• [Additional instructions: For this input, the data should be 
extracted from the user input if it has a value from this list 
of words: [simple entity word list].
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Example of an NLU node with associated entities migrating to an LLM node

Migration issues

You can access migration issue data either by searching for 
topic_migration_execution_item.list  in the Navigation pane or downloading 
the .CSV file version of the table. After you've migrated topics, the downloadable .CSV file is 
accessible through the Review migration log  option in the topic migration's Migrate topics page. 
For more information about migration issues, see NLU to LLM migration log.

Migrate NLU topics to LLM topics

Migrate one or more of your existing Natural Language Understanding (NLU) or keyword topics 
into new large language model (LLM) topics while maintaining your original NLU/keyword topics. 
After migration is complete, choose whether to publish your new LLM topics.

Before you begin
Role required: virtual_agent_admin or sn_vad_genai.topic_migration_admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer.

2. Select Migrate Topics to LLM.

The Topic Migration workflow page opens in a new browser tab.

3. Review and determine which NLU  and keyword topics you want to migrate into LLM topics on 
the Select topics page.
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Tip: 
Select the link in the Name column to review the topic in the Virtual Agent Designer 
canvas in a new browser tab. Migrate fewer than 50 topics at one time to allow yourself 
enough time to review the topics.

4. Select which NLU  and keyword topics you want to migrate, and then select Next  on the Select 
topics page.

Important: 
If you leave the topic migration workflow, you are unable to return to where you left off and 
you must restart the process.

5. Review the affected topic blocks, and then select Next  on the Review topic blocks page.

Only topic blocks and topic blocks associated with the selected topics are displayed in this list. 
Topic blocks used in dynamic topic blocks must be manually selected for migration. You can 
select the link in the Topic Block column to view the topic block in the Virtual Agent Designer 
canvas in a new browser tab.

Note: 
If no topic blocks were selected or associated with the selected topics, select Next  to 
continue.

6. Choose which settings to apply to all topics migrating to LLM, and then select Next  on the 
Settings page.
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Settings field description

Field Description

Select assistant(s) for migrated topics Migrated LLM topics are associated with 
these assistants.

Choose how migrated topics are named Newly migrated topics include the value 
entered in the Add to internal topic name 
field as either a prefix or suffix (default). 
This option only affects the migrated topics' 
Internal name  value and not the topics' 
Display name  value. The original NLU 
topic name is used as the Display name  to 
customers interacting with LLM topics in 
Virtual Agent.

Keep current topic descriptions? Current topic descriptions are used as the 
LLM topic descriptions rather than using 
generative AI to create topic descriptions 
for migrated LLM topics. This field is turned 
off by default. If this field is turned on, and 
there was no topic description in the original 
NLU topic, a topic description must be 
manually added to the new LLM topic before 
publication.

7. Review the topics for migration on the Migrate topics page, and then select Next  to begin 
migration.

Note: 
Leave the browser window open until the migration process is complete.
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Example of an in-progress topic migration

Example of a completed topic migration

The migration complete progression bar appears and displays a dynamic percentage 
of completeness. During migration, the Migration status column updates dynamically 
with the values changing from Not started  to either Failed  or Complete. After 
migration is complete, you can choose to select Review migration log  or Next. Selecting 
Review migration log  downloads a .CSV file of the Topic Migration Execution Items 
[topic_migration_execution_item.list] table data. For more information on this table data, see 
NLU to LLM migration log. Selecting Next  directs you to the Publish (optional) page.

8. Optional:  Continue to the Publish (optional) page by selecting Next.

9. Optional:  Review and edit topic descriptions on the Publish (optional) page by double-clicking 
(or use the keyboard shortcut) the text in the Description column and pressing Enter  to save 
the updated description.
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Tip: 
If you select the LLM topic link, you are redirected to that topic in Virtual Agent Designer 
through a new browser tab or window. Any edits that you make in Virtual Agent Designer 
are reflected in the topic migration's Publish (optional) page. If you edit and save the 
updated description, but don’t publish the topic, the updated description remains visible 
in Virtual Agent Designer. For additional information about strong LLM topic descriptions, 
see LLM topic and node description examples.

10. Optional:  Select each LLM Topic check box that you want to publish, and then select Publish 
topics.

You receive a Selected topics were successfully published  output 
message. The topics that you migrated, but didn't select to publish, continue to appear on this 
page until you navigate away from the topic migration workflow.

11. Optional:  Exit the topic migration workflow by selecting Close.
You’re redirected to the Virtual Agent Designer  Topics page.

What to do next
After you navigate away from the topic migration workflow, the topics that you migrated, but 
didn’t publish, can be managed and published from the Virtual Agent Designer  canvas. If you 
choose to migrate other topics in the future, the topic migration workflow restarts from the 
beginning.

NLU  to LLM migration log

The Topic Migration Execution Items [topic_migration_execution_item.list] table includes 
data when migrating Natural Language Understanding  (NLU) topics to large language model 
(LLM) topics such as the migration status, migration issues, and migrated or published topic 
information.

You can access this topic migration data either by searching for 
topic_migration_execution_item.list  in the Navigation pane or downloading 
the .CSV file version of the table. After you've migrated topics, the downloadable .CSV file is 
accessible through the Review migration log  option in the topic migration workflow's Migrate 
topics page.
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Example of the Review migration log option

The Topic Migration Execution Items [topic_migration_execution_item.list] table defaults to 
include the following columns:

• Description

• Issues

• LLM Topic

• Migration Execution

Note: 
The Migration Execution  column includes the unique ID that is generated for each 
migration batch. For example, when 10 topics are migrated at the same time, the table 
contains 10 topic rows with each row containing the same migration execution value.

• Migration status

• NLU  Topic

• Status

• Type

Example of the Topic Migration Execution Items table data
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Generic issues may occur during the topic migration process. The following table includes 
specific, common issues that you may encounter in the Issues column and whether the issue 
blocks the topic from being published.

Issues column details

Types of issues Issues column value Can the topic be published?

Node-level issues: These 
issues are validation error 
messages that can include 
missing fields such as name, 
description, and so on.

Some topic 
properties couldn’t 
be generated. To 
publish, manually 
review and edit the 
following nodes: 
[list of node names]

No.

The issue must be corrected 
before the topic can be 
published.

Script-level issues: These 
issues occur whenever an 
NLU  input node has a script or 
data pill in the Prompt  field.

Some topic 
properties couldn’t 
be generated because 
the topic used a 
script. To publish, 
manually review and 
edit the following 
nodes: [list of node 
names]

Yes.

Topics with this issue can be 
published because Collect 
[Node Name]  populates in 
the Detailed description  field, 
but the value of the Detailed 
description  field value should 
be revised and improved.

Topic-level issues: These 
issues are validation errors 
at the topic level such as 
a missing description, 
keywords, or any other 
required field.

Some topic 
properties couldn't 
be generated. 
Edit them before 
publishing the 
topic.

No.

The issue must be corrected 
before the topic can be 
published.

LLM-generated description 
issues: These issues occur 
whenever LLM is unable 
to generate a valid topic 
description.

The topic 
description couldn’t 
be generated. Edit 
the description 
field on the Publish 
page or from the 
topic properties 
page in Virtual 
Agent Designer 
before publishing.

Yes.

Topics with this issue can 
be published because the 
[Topic name]  populates 
the Topic description  field, 
but the Topic description  field 
value should be revised and 
improved.

LLM-generated description 
issues related to NLU  intent 
complications: These issues 
occur whenever an NLU 
model and intent is mapped 
to a topic but is missing 
from the sys_nlu_model or 
sys_nlu_intent table or if these 
values are incorrectly mapped 
to the topic.

The topic 
description couldn’t 
be generated because 
the mapped intent 
wasn’t found. Edit 
the description 
field on the Publish 
page or from the 
topic properties 
page in Virtual 
Agent Designer 
before publishing.

Yes.

Topics with this issue can 
be published because the 
[Topic name]  populates 
the Topic description  field, 
but the Topic description  field 
value should be revised and 
improved.

LLM-generated description 
issues related to NLU  intent 

The topic 
description couldn’t 

Yes.
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Issues column details  (continued)

Types of issues Issues column value Can the topic be published?

complications: These issues 
occur whenever an NLU 
model's intent and keywords 
aren’t mapped to the topic.

be generated because 
both the intent 
and keywords are 
missing. Edit the 
description field 
on the Publish page 
or from the topic 
properties page 
in Virtual Agent 
Designer before 
publishing.

Topics with this issue can 
be published because the 
[Topic name]  populates 
the Topic description  field, 
but the Topic description  field 
value should be revised and 
improved.

Dynamic topic block issues: 
These issues occur whenever 
there’s a node that has a 
dynamic topic block that 
wasn’t migrated.

The migration tool 
couldn’t convert 
one or more dynamic 
topic block nodes 
from this topic. The 
topic blocks used 
inside the dynamic 
topic blocks must be 
manually migrated. 
The following nodes 
use these dynamic 
topic blocks: [list 
of node names]

Yes.

Topics with this issue can 
be published because the 
topic block names use a script 
for dynamic topic blocks 
and continue to operate as 
expected, using the NLU 
topic block. If you encounter 
this issue, select these topic 
blocks for migration from the 
Select topics page and update 
the topic block names in the 
script.

Switch topic script issues: 
These issues occur whenever 
a node has a switch topic 
function that wasn’t migrated.

The migration tool 
couldn’t convert 
one or more switch 
topic scripts from 
this topic. The 
topics used inside 
the switch topic 
script need to be 
manually migrated. 
The following nodes 
use these switch 
topic scripts: [list 
of node names]

Yes.

Topics with this issue can 
be published because 
the topic script continues 
to use the NLU  topic until 
migration. If you encounter 
this issue, select these topics 
for migration from the Select 
topics page.

Process failure issues: These 
issues occur whenever there's 
an error during a particular 
migration process.

This topic couldn't 
be migrated. Contact 
ServiceNow  support 
for assistance.

No.

The issue must be corrected 
by a ServiceNow  employee 
before the topic can be 
published.

Process failure issues: These 
issues occur whenever 
there's an error during the 
transformation of NLU  nodes 
to LLM nodes.

This topic couldn't 
be migrated because 
the transformation 
of NLU  nodes to 
LLM nodes failed. 
Contact ServiceNow 

No.

The issue must be corrected 
by a ServiceNow  employee 
before the topic can be 
published.
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Issues column details  (continued)

Types of issues Issues column value Can the topic be published?

support for 
assistance.

Process failure issues: These 
issues occur whenever there's 
an error during a particular 
migration process.

This topic couldn't 
be migrated because 
the publish payload 
failed to generate. 
Contact ServiceNow 
support for 
assistance.

No.

The issue must be corrected 
by a ServiceNow  employee 
before the topic can be 
published.

Process failure issues: These 
issues occur whenever there's 
an error during a particular 
migration process.

This topic can’t be 
published until a 
topic description is 
added.

No.

The issue must be corrected 
before the topic can be 
published. Edit the description 
field on the Publish page 
or from the topic properties 
page in Virtual Agent Designer 
before publishing.

LLM topic and node description examples

Strong topic and node descriptions for large language model (LLM) topics result in a better 
Virtual Agent  user experience.

Topic description examples

Admins write LLM topic descriptions during topic creation and can manage the descriptions 
on the topic's Properties  tab. Topic authors with the virtual_agent_admin role or 
sn_vad_genai.topic_migration_admin role can also change the LLM-generated topic description 
on the Publish (optional) page of the topic migration workflow if they want to provide more details 
than what was automatically generated. In the Topic description  field, describe in detail what 
you want the topic to do. The more information that you provide in your topic descriptions, the 
more successful your user's experience is with the Virtual Agent. The following table provides 
examples of both weak and strong topic descriptions.

Weak and strong topic description examples

Topic name Weak topic description Strong topic description

Company Holiday Calendar This topic is about a holiday 
calendar for employees in a 
company.

This topic is about a holiday 
calendar for employees in a 
company. Users can ask for 
the holiday list or company 
holiday for a specific year, 
specific date, inquire about 
a specific holiday, or ask 
if they have a day off for a 
particular holiday. The topic 
also covers the availability of a 
holiday calendar and specific 
holidays like Freedom Day and 
wellbeing days.
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Weak and strong topic description examples  (continued)

Topic name Weak topic description Strong topic description

Active Directory Password 
Change

This topic is related to 
the management and 
administration of Active 
Directory, a directory service 
provided by Microsoft.

This topic is related to 
the management and 
administration of Active 
Directory, a directory service 
provided by Microsoft. 
This topic involves making 
changes to the Active 
Directory, such as creating, 
modifying, or deleting 
directories and processes. 
This topic also includes tasks 
performed by administrators, 
such as managing user 
accounts, groups, and 
permissions within the Active 
Directory environment.

Node name and Detail description example

Make input node names unique and descriptive so that they explain what operation the user 
is trying to perform. Descriptive node names enable the LLM to work properly with entities 
and slot filling. For example, if admins create two similar input node names, such as AD 
Operation Type  and AD Operation, the LLM may identify the wrong node and map 
it to random input node variables. Renaming the nodes to differentiate the two is best. For 
example, AD Operation for Password Reset  and AD Operation for Locked 
Credentials and Change Password  are stronger, more unique node names.

The Detail description  field for all LLM-enabled user input nodes requires you to describe one 
specific detail that you need from the user. Using detailed descriptions helps the LLM generate 
user prompts and capture the most important part of their reply.

There are currently seven LLM-enabled user input nodes:

• Input Collector

• Text

• Static Choice

• Dynamic Choice

• Boolean

• Date Time

• Carousel

When working with one of the preceding input nodes, include clear instructions within the Detail 
description  field about what possible values the LLM should request from the user. For example, 
in an Active Directory Operation topic, admins must be specific in the Detail description  field 
about what operations are allowed. Providing detailed descriptions enables the LLM to use value 
mapping to identify the entity and fill the slots. The following table provides examples of a weak 
and strong node Detail description  field.
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Detail description for an Active Directory Operation Type topic's input node example

Weak detail description Strong detail description

Collect AD Operation Type
Collect Active Directory (AD) Operation Type

Additional instructions:

For this input these values are mapped 
values: {"reset":["reset","locked","unable to 
sign in","expiry", "expired", "expire"],"change":
["change"]}. The keys must be extracted if the 
user input contains the values associated with 
the keys.

Strong detail description example of LLM-enabled input node

Duplicate a Virtual Agent  topic

Create a new topic or topic block by copying an existing Virtual Agent  topic or topic block and 
customize it.

Before you begin
Role required: virtual_agent_admin or admin
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About this task
Consider duplicating topics in the following scenarios:

• When you want to use an existing topic, such as a prebuilt topic or topic block, as the basis for 
a new topic or topic block.

• When you want to modify an active topic while preserving the original topic for reference 
purposes or as a backup.

• When you want to convert a Natural Language Understanding  (NLU) topic to a large language 
model (LLM) topic.

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer, and in the Topics 
page, select the item to be copied.

2. In the topic header bar, select the more actions on topics icon ( ), then select Duplicate.

a. In the Duplicate window, enter the new name for the item.

b. Select Save.

3. Update the properties on the Properties  tab and on the Flow  tab, change the conversation 
flow design as needed.

Note: 
Keep in mind the goal or purpose of your new topic as you set the properties and 
update the flow. For example, if you're using keyword-based topics, you might need to 
change certain keywords based on the purpose of your new topic. For Natural Language 
Understanding  (NLU)-enabled topics, you might need to change the NLU  model and 
intent associated with the topic.

Topic and topic block duplication

If you're 
duplicating

See this section

Topics
See Create a Virtual Agent topic  for a description of the topic properties that you 
can change and how to add or change the nodes in the flow.

Topic 
blocks

See Create a reusable topic block  for a description of the topic block properties 
that you set and the input and output parameters that you define for the block.

4. As you update your design, use the Test  option to run your design in a chat test window, then 
fine-tune your design flow accordingly.
For details on test features regarding NLU topics, see Testing NLU/Keyword topics.

[store-future: BEGIN review]For details on test features of LLM topics, see LLM topic testing.
[End]

What to do next
If you’ve completed the topic or topic block, publish  it to deploy it to your Virtual Agent  clients.

LLM topic testing

Preview, test, and debug topics that use large language models (LLMs) in the Virtual Agent 
Designer  chat window.
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You can test your topic's functions by running your conversation in a chat test window as you 
work. The web (Service Portal) chat client is the default test window.

Large language model (LLM) topics are faster and easier to test compared to Natural Language 
Understanding  (NLU) topics. For example, you don't need to retest your topic after updating 
utterances and retraining models as with NLU  topics.

If you're using the Virtual Agent integrations with third-party messaging apps, elements in 
your conversation might appear differently in third-party messaging applications. Test your 
conversations in any third-party applications where you want to deploy Virtual Agent.

Note: 
If the Now Assist  panel or Microsoft Teams  is configured for your environment, preview 
options for those channels display in the Test button list. Select Preview in Now Assist 
panel  or Preview in Microsoft Teams  in the list to test your topic in those environments.

Testing your LLM topic in the chat test window

LLM test options

Test LLM topics on the Virtual Agent Designer  canvas by working with the Test  options on the 
topic header bar. When testing from a single topic, the Include topic discovery  option must be 
selected to work with the assistants. If the topic is associated with multiple LLM assistants, use 
the Assistant drop-down list to select which assistant you want to test. For more information 
about LLM assistants, see LLM assistants.

Note: 
If your topic is missing any necessary materials, an incomplete badge appears in the corner 
of the flow diagram pane. A yellow or red warning badge also appears next to each node. 
The incomplete badge lists the total number of issues, while the local warning badges 
show how many issues are found in each node. If you select Test  when there are issues, 
an Issues window opens with the number of issues present along with the details of each 
issue. These details include a full description and a hyperlink to each incomplete item.

Alternatively, you can test active (published) LLM topics on the Topics page. Use the LLM 
Assistant  filter to restrict your topics to only topics associated with that assistant, and then 
select Test active topics. If you don't use the LLM Assistant  filter, select Test LLM assistant 
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topics  from the Test active topics drop-down list. When using the Test active topics  option or 
sub-options from the Topics page, topic discovery is enabled, so it's not listed as an option. 
When testing from the Topics page, the Assistant drop-down list appears in the chat test window. 
You must have previously established at least the default Now Assist  in Virtual Agent  assistant 
to see the Assistant drop-down list. When a topic is associated with just one LLM assistant, the 
Assistant drop-down list defaults to that assistant name. If you have multiple assistants, select 
which assistant you want to work with using the Assistant drop-down list. For more information 
about creating multiple LLM assistants, see Manage LLM virtual agents on the Assistants screen.

The chat test window opens in the Now Assist  in Virtual Agent  web client. The Assistant drop-
down list and Include topic discovery  option might display depending on where you originated 
the test from and if you have established any LLM assistants.

You can provide feedback to each utterance made by the LLM by selecting from the like thumbs-

up icon ( ) or dislike thumbs-down icon ( ) options that appear when you hover over an 
utterance. All LLM-enabled user inputs aside from the Input Collector have these feedback 
options.

LLM utterance feedback options

The chat test window also displays adjoining tabs that provide details about your topic as you 
test it. The following tabs are available when testing LLM topics:

• Analyze test phrases  - Results for topic discovery based on your input.

• Prompt discovery  - List of all the prompts in the topic that are sent to the LLM.

• Variables  - List of all the variables used in the conversation, such as input and Live Agent 
variables.

• Edit variables  - Options for editing the variables used in this topic.

• Context  - Options for specifying the context (using context variables) in which a topic is run.

• Logs  - List of the processing performed.
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Example LLM testing chat test window and test tabs

The following tabs appear when you test their related topic types on the Virtual Agent Designer 
canvas:

• The Analyze test phrases, Prompt discovery, Variables, and Logs  tabs appear for all LLM 
topic types.

• The Edit variables  tab appears for topic blocks and custom controls.

• The Context  tab appears for topics, setup topics, or small talk topics when you select Include 
topic discovery.

If you run tests from the Topics page, the test window shows only the Analyze test phrases, 
Variables, Context  (available by default, with no Include topic discovery  option), and Logs  tabs.

Analyze test phrases tab

When you test LLM-enabled topics, results for topic discovery appear based on your input. 
When you input a test phrase, you can see a variety of search results when Genius Results 
are enabled including skill (topic) discovery, Knowledge Base  (KB) articles, and catalog items. 
Under the skills search results, variables and values may also be listed (such as the variable 
@laptop_make  and the value macbook), depending on the topic. These Genius Results 
only appear if you’re testing a published topic and have selected the Include topic discovery 
option. If the Include topic discovery  option appears inactive, publish the topic to work with 
topic discovery. A Search indexing in progress  message might appear, but you can 
still test while the search indexing runs although topic discovery might not be updated. For more 
information about how Genius Results work, see Now Assist in AI Search .
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Additionally, when testing active LLM assistant topics from the Topics page, you see skills results 
for Semantic search. Semantic search analyzes the meanings and context of your search terms 
and uses that information to find results with similar meanings. It improves search recall by 
interpreting natural language to more accurately reflect your search's intent. If semantic search 
is deactivated for topic discovery testing, those results are not displayed. For more information 
about semantic search, see Semantic vector search in AI Search .

Example Analyze test phrases tab for LLM topics

Prompt discovery tab

If your topic contains any prompts that are sent to the LLM, they’re shown in the Nodes category. 
The Nodes category lists LLM-enabled user input nodes on the canvas, their field names and 
types, and their contents.

You can modify the content of any of the prompts to develop optimal prompts for the 
conversation. Each prompt's status starts at Original prompt. If you alter a prompt's 

content, its status changes to Modified prompt  and a revert icon ( ) appears next to it. 
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The total number of prompts modified is listed at the bottom of the tab next to a Save to topic 
button. To test the modified prompts, select Apply and restart. To undo changes to a prompt, 
select the revert icon next to the prompt. Alternatively, undo all changes by selecting Revert  that 
activates when you modify any prompts.

Note: 
If you select Save to topic, all changes are saved and all Modified prompt  messages 
reset to Original prompt.

Example Prompt discovery tab
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Example Prompt discovery tab with a modification

Variables tab

The Variables  tab displays a list of all the variables used in the conversation and the associated 
values captured as the conversation progresses, so that you can follow along. A conversation 
can have these variable types:

• Input variables

• Script variables

• Live Agent  variables

• Variables passed between a calling topic and topic block

The list is separated into sections by variable types. The following example shows the Input 
variables section. Notice that for the static list control, both the display label and value are 
captured for the selected choice.
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Example list of input variables

The following example shows the Input variables section for the grouped list control. This 
variable information appears similar to the static list control, but the variables are separated by 
each group of the grouped choice.
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Example list of grouped choice variables

Edit Variables tab

When testing topics, topic blocks, and small talk topics, you can edit the variables found in the 
topic's nodes.

Context tab

The Context  tab appears when you’re testing topics, setup topics, or small talk topics, to specify 
a different context for the chat. Choose a context variable from the list. The variables contain 
contextual information that can be used to determine topic intent or control how chats are routed 

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1869



to live agents. For example, you could select portal  from the list of variables and enter the portal 
name IT Express. The Context  tab is unavailable when creating test cases.

For more information about defining context variables, see Configure context variables for storing 
chat-related information. For more information about live agent variables that are included with 
Virtual Agent, see Live agent chat context variables.

Example Context tab

Next steps

When you're done testing your topic, close the test chat window. If necessary, use the test 
information to adjust your topic to perform more accurately. For example, the results on the 
Analyze test phrases  tab may return low scores or Unsure  or Unknown  confidence ratings. 
Improve scores by updating the topic description or instructions in the LLM-enabled user input 
nodes.

Testing NLU/Keyword topics

Use the chat test window to preview, test, and debug Natural Language Understanding 
(NLU)/Keyword topics.

As you work on a topic in Virtual Agent Designer, you can run your conversation in a chat test 
window. The default test window is the web (Service Portal) chat client. If it's configured for your 
instance, you can also run the test window in the Microsoft Teams  application.

If you're using the Virtual Agent integrations with third-party messaging apps, elements in 
your conversation might appear differently in third-party messaging applications. Test your 
conversations in any third-party applications where you want to deploy Virtual Agent.
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Note: 
If the Now Assist  panel or Microsoft Teams  is configured for your environment, preview 
options for those channels display in the Test button list. Select Preview in Now Assist 
panel  or Preview in Microsoft Teams  in the list to test your topic in those environments.

Testing your NLU/Keyword topic in the chat test window

Example NLU/Keyword test options

To run your topic in the chat test window, select the Test  option in the topic header bar. 
Alternatively, you can test active (published) topics by selecting Test NLU/keyword topics  from 
the Test active topics  button on the Topics page.

Note: 
If your topic is missing any necessary materials, an incomplete badge appears in the corner 
of the flow diagram pane. A yellow or red warning badge also appears next to each node. 
The incomplete badge lists the total number of issues, while the local warning badges show 
how many are found in each node. Selecting Test  when there are issues present opens an 
Issues window at the bottom, which counts up and details all the issues needing correction. 
These details include a full description and a hyperlink to each incomplete item.

The chat test window opens in the web client and displays adjoining tabs that provide details 
about your topic as you test it. You can use these tabs:

• Analyze Test Phrases  - The results for intent matching and entity recognition appear based on 
what you entered in the conversation.

• Variables  - List of all the variables used in the conversation, such as input and Live Agent 
variables.

• Context  - Options for specifying the context (using context variables) in which a topic is run.

• Logs  - A list of the processing performed.
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Example Natural Language Understanding (NLU) chat test window and test tabs

By default, the Include Topic Discovery  option is enabled. This option automatically performs 
topic discovery and generates prediction results for NLU  topics using test phrases that you enter 
in the test window. The conversation begins with the Virtual Agent  greeting and the button for the 
menu of available topics.

If you're using the Test Active Topics  option or sub-options from the Topics page, topic discovery 
is enabled, so it's not listed as an option. Testing active topics behaves the same as testing from 
a topic except that test cases can't be created.

Analyze test phrases tab

For NLU  enabled topics, the Analyze test phrases  tab provides an analysis of the possible 
intents that match the test phrase (utterance) that you entered in the chat test window. The tab 
lists the prediction results, which include matched intents and their prediction scores, along with 
any entity recognition and slot-filling results. The top match is listed first. The predicted intents 
depend on the prediction confidence threshold set in the NLU  service.
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Example Analyze test phrases tab for NLU/Keyword topics

If an utterance doesn't match a current intent, you can add or change utterances in Virtual Agent 
Designer. For more information, see Modify NLU utterances and entities for a Virtual Agent topic.

Make changes, train the model again, and then retest until you're satisfied with the results. When 
the topic is ready, you can publish both the topic and the model from Virtual Agent Designer.

Variables tab

The Variables  tab displays a list of all the variables used in the conversation and the associated 
values captured as the conversation progresses, so that you can follow along. A conversation 
can have these variable types:

• Input variables

• Script variables

• Live Agent  variables

• Variables passed between a calling topic and topic block

• "Nodeless" NLU  entities declared as a slot-filled variable for the topic

The list is separated into sections by type of variable. The following example shows the Input 
variables section. Notice that for the static list control, both the display label and value are 
captured for the selected choice.
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Example list of input variables

The following example shows the Input variables section for the grouped list control. This 
variable information appears similar to the static list control, but the variables are separated by 
each group of the grouped choice.

Example list of grouped choice variables

Context tab

Use the Context  tab to specify a different context for the chat. Choose a context variable from the 
list. These variables contain contextual information that can be used to determine topic intent or 
control how chats are routed to live agents. For example, you could select portal  from the list of 
variables and enter the portal name IT Express. The Context  tab is unavailable when creating 
test cases.
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For more information about defining context variables, see Configure context variables for storing 
chat-related information. For more information about live agent variables that are included with 
Virtual Agent, see Live agent chat context variables.

Example Context tab

Logs tab

The Logs  tab displays the processing and error messages that are recorded while running your 
conversation. If you're using scripts in Virtual Agent Designer, use gs.log, gs.print, and 
gs.warn  statements in your scripts to output information in this log.
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Example Logs tab

Next steps

When you're done testing your topic, close the test chat window. If needed, you can use the 
test information to fine-tune your conversation. For example, if the results on the Analyze 
test phrases  tab return multiple possible matches for your utterance, you could update the 
utterances for your intent and NLU  model on the NLU Intent  tab for your topic.

Train and test your NLU  model in Virtual Agent Designer

Use the NLU Intent  tab to train and try a Natural Language Understanding  (NLU) model that is 
mapped to a topic without leaving Virtual Agent Designer.

Before you begin
Role required: virtual_agent_admin or admin

About this task
As you make changes to a topic's intent, train the model so that your updates are incorporated. 
Then try and test the model to review prediction results based on the latest changes. Continue to 
test and refine your model until you're satisfied with your changes.

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer.

2. Open a topic and view the NLU Intent  tab.

3. Select Train model.
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A message indicates that the model was successfully trained.

4. Select Try model.
In the Try model panel, manually enter an utterance to test. The prediction results display in the 
panel.

Example of testing an utterance in the NLU Try model panel

If prediction confidence score results meet or surpass the confidence threshold you 
established for the model, the results appear under Top prediction(s). In this example, the 
threshold value is 65%.

The default value of the com.glide.cs.intent_confidence_threshold  property is 
0.7.

The default value of the com.glide.cs.entity_confidence_threshold  property is 
0.5.

Note: 
You can compare the draft NLU  model to its most recent published version. For more 
information, see Compare draft and published versions of your NLU model .

5. When you're satisfied with the prediction results, publish the model from NLU Workbench  or 
click Publish  in the topic Header bar and select NLU Model.

What to do next
You can publish the model at the same time as the Virtual Agent  topic if the model meets 
publication criteria. Make sure your model has passed through all phases of development and is 
ready to publish. For more information, see Model management .

For more information on providing feedback using thumbs icons in the results, see Test panel 
feedback .

Automated testing for Virtual Agent  topics that use NLU  topic discovery

Automated testing for your Virtual Agent  topic flows uses the ServiceNow  Automated Test 
Framework  product through Virtual Agent Designer. You can create and run automated tests 
through the Automated Test Framework  to confirm that your topic flow works after making a 
change.

Create topic test cases through a topic's Test  > Create test case  preview and view the topic's 
test cases through the Topics List page's Manage NLU/keyword test cases  button. Only 
run automated tests on a development, test, or other non-production instance to avoid data 
corruption and outage. For more information, see the Automated Test Framework .
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Working with test cases is only available if you have:

• Installed the com.glide.cs.atf plugin (installed as a part of the Virtual Agent chatbot plugin).

• Received one of the following roles: atf_test_designer, atf_ws_designer, atf_test_admin, 
virtual_agent_admin, or admin.

• Published topics with one of the following topic types: Topic, Setup Topic, or Small talk.

Create an automated test in Virtual Agent Designer

Create automated tests in Virtual Agent Designer  and run tests regularly against ideal 
conversation topic flows. You can create multiple automated tests for a topic to capture different 
conversation flows for various situations such as ideal conversation paths or errors.

Before you begin
Plugin required: com.glide.cs.atf.

Role required: atf_test_designer, atf_ws_designer, atf_test_admin, virtual_agent_admin, or admin

About this task
As you work on a published topic, setup topic, or small talk topic, use the Test  option in the topic 
header bar to run your conversation in a chat test window. The default test window is the web 
(Service Portal) chat client. Use the Create test case  button to create a test case and save the 
test case in the Automated Test Framework.

Note: 
You can find a list of NLU/Keyword test cases by selecting the Manage NLU/Keyword test 
cases  button on the Virtual Agent Designer  main page. Automated tests are also listed on 
the Automated Test Framework  (ATF) Tests [sys_atf_test] table. For more information on 
managing NLU/Keyword test cases, see Manage and run automated test cases in Virtual 
Agent Designer

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer.

2. Select a published topic.

3. In the topic's header bar, select Test.

4. Select Create test case.

Note: 
The Create test case  button is only available for published topics that are non-read only 
with one of the following topic types: Topic, Setup Topic, or Small talk.

The topic's test client restarts and the test case begins to capture your ideal conversation. 
While capturing your test case, the Include Topic Discovery  and the Context  tabs are 
unavailable.

5. Enter the conversational flow that you want to capture and test.

Tip: 
Select Restart  at any time to restart the topic conversation and test case capture.

6. Select Stop.
The Test case name  field displays the topic's name along with the date and timestamp. For 
example: [Topic name] 3/28/2022, 3:32:19 PM.

7. Perform one of the following actions.
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Manage and run automated test cases in Virtual Agent Designer

Run reusable test cases of your published topics using the Automated Test Framework 
through Virtual Agent Designer  to identify performance issues and prevent regressions before 
production.

Before you begin
Plugin required: com.glide.cs.atf.

Role required: atf_test_designer, atf_ws_designer, atf_test_admin, virtual_agent_admin, or admin

About this task
The Manage NLU/keyword test cases  button opens the Run test cases  tab. Before you can run 
a test case, you previously must have created a test case. The Create test cases  tab displays 
published topics that don't have associated automated tests. These topics appear in order from 
their last published date. After you select a topic name, a new window opens and you're directed 
to that topic in Virtual Agent Designer. From the topic, you can select Test  to create a test case. 
For more information, see Create an automated test in Virtual Agent Designer.

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer.

2. Select Manage NLU/keyword test cases.
You either see the Run test cases  tab or the Get started  button. The Run test cases  tab 
displays topics that have had test cases previously created. The Get started  button redirects 
you to the Create test cases  tab to begin creating your topics' automated testing.

3. In the list view, review the columns.

Run test cases columns

Column Description

Test case Displays the linked test case name. Selecting 
the linked name opens a new window and 
directs you to that test within the Automated 
Test Framework. From the Automated 
Test Framework  you can view test details, 
including test steps.

Topic Displays the linked topic name. Selecting the 
linked name opens a new window and directs 
you to that topic in Virtual Agent Designer. 
Topics with multiple test cases are grouped.

Run status Displays the run status of the test. Three 
statuses are possible:

◦ Ready: The test case is ready to be run.

◦ In-progress: A temporary test case status 
that appears while the test case is running. 
After the test runs, the status returns to 
Ready.

◦ Run recommended: The topic's published 
date is more recent than the test 
cases latest run date so there may be 
published updates for the topic. A run 
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Column Description

is recommended because the latest 
published topic and its related test cases 
are potentially out of synchronization.

Last run Displays the date and timestamp of when 
the test was last run. Topics are grouped and 
sorted by the last test run date or if the same 
run happened across multiple topics, the 
topic's last published date.

Result Displays either Failed  or Passed. Pointing to 
the linked result displays a brief explanation 
of either the passing or failing step details. 
Selecting the linked result opens a new 
window and directs you to that test's Test 
Results  in the Automated Test Framework 
where you can view more specific step fail 
or pass details. If the test case has passed, 
no changes happened between the latest 
published topic and its saved test case. If 
the test case has failed, a change happened 
between the latest published topic and its 
saved test case. For more information, see 
View test results .

Tip: 
You can view the test suite of all topics 
created and tested through Virtual 
Agent Designer  by navigating to 
Automated Test Framework (ATF) 
> Suites, and then selecting Virtual 
Agent Topics. For more information, see 
Run an automated test suite .

Actions Displays the Delete  button that deletes the 
test case from this page and the Automated 
Test Framework.

4. Select one, multiple, or all test case check boxes, and then select Run.

Tip: 
The sn_atf.runner.enabled  property must be turned on to run test cases. After the 
property is turned on, you can select Run. Also, you can select the check box next to the 
Test case column header to select all test cases to be run.

An in-progress banner appears and changes to a completion banner after your test results 
are ready. The Last run column updates and the last run test cases are moved to the top of the 
table.

Handle failures caused by dynamic inputs in user testing of Virtual Agent  topics

Avoid failures when performing automated tests for topics in Virtual Agent  by controlling which 
inputs that you want to run as part of a test case.
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Before you begin
Set up a test case for a topic that includes dynamic inputs. See Create an automated test in 
Virtual Agent Designer  for more information.

Role required: virtual_agent_admin or admin

About this task
When running a test in Virtual Agent Designer, some tests may fail even when a topic has fully 
functional components. These failures can happen based on various cases, such as timestamps 
based on a function that always returns the current time. The timestamp is created correctly 
when the test runs, but isn’t a match with the recorded timestamp in the test case. Similar 
examples include different users entering different names, email or physical addresses, or other 
information specific to each user. Any topic that returns different data based on time or other 
changing conditions is a potential failing point in testing. By deactivating test steps that use 
dynamic input, you can run tests that won't fail due to a change in the data found in those steps.

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer.

2. Select Manage NLU/keyword test cases, followed by the test case that you want to work with.

3. Under the Test Steps  tab, select the Active column of the test step you want to exclude, and 
set its value to False.

4. Repeat Step 3 with as many test steps as you want to deactivate.

5. Run or debug your test case.

Debug a Virtual Agent  topic

Investigate and resolve unexpected behavior in your custom Virtual Agent  topics, topic blocks, 
and controls.

For information about topic discovery issues, see Resolve Natural Language Understanding 
(NLU) topic discovery issues.

Duplicate a live topic before debugging and changing it

Duplicate a topic rather than update a live topic. The unmodified original topic can serve as both 
a reference and a backup, and retaining the original enables you to restore the topic quickly. 
Remember to deactivate the original topic before publishing the duplicate.

Debug a topic while testing your conversations

As you create or update a topic in Virtual Agent Designer, use the Test  button in the topic header 
bar to preview the conversation. The chat test window shows the conversation as it appears 
within Service Portal. Elements in your conversation might appear differently in third-party 
messaging applications. Test your conversations in any third-party applications where you intend 
to deploy Virtual Agent.

The test chat window displays four tabs that provide detailed information for debugging and 
refining your topic: Analyze test phrases, Variables, Context, and Logs. For details on these 
tabs, see Testing NLU/Keyword topics. The following example shows the processing messages 
and errors logged during testing.
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Watch for warnings on controls within your topic

Warnings on a topic node in the Flow tab

Controls that are missing necessary information show a red incomplete badge in the upper left 
corner of the control. The badge shows a number indicating the number of issues in that control. 
Select this badge to see a list of the issues in the control.
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Another warning badge appears in the upper left corner of the designer to indicate the number 
of issues within the entire topic.

Check for errors when a topic preview does not run

Topic preview errors on the canvas

Additional information appears under the Virtual Agent Designer  canvas when an error prevents 
the topic from running. The total number of Issues are listed, along with details and a hyperlink 
for each. Select a hyperlink to go to the node, and use the information provided to correct any 
errors in your conversation.

Common Virtual Agent  issues

Issue Possible resolution

Cannot see module designer under 
conversational interfaces

• User might not have the 
virtual_agent_admin role.

• Virtual Agent  plugin might not be activated.

Cannot edit a topic Logged-in user must be in the same 
application scope as the topic.

Cannot preview topic • Make sure that all required fields are filled in 
on the node properties.

• Ensure that your browser is configured to 
permit pop-ups from your instance.

Web client stuck at Connecting... One or more of your topics might be missing. 
Check the Topics page to ensure that topics 
are present on the instance and in the Active 
state.

Review topics that run in a conversation flow

Each Virtual Agent  (VA) conversation in an instance automatically generates an interaction 
record in the Interactions [interactions] table, which logs the conversation between a requester 
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and virtual and live agent. You can review the transcript of the conversation between the 
requester and virtual agent, including live agent transfers (if using Agent Chat). For details, see 
Virtual Agent interaction records.

Resolve Natural Language Understanding  (NLU) topic discovery issues

If an intent is not being chosen when expected, you can troubleshoot NLU prediction errors.

Quick troubleshooting tips

If a Virtual Agent  is not being discovered, check the following:

Is NLU enabled for the session language?

Enable the language in Natural Language Understanding  (NLU) settings for Virtual 
Agent. For details, see Enable NLU languages in Virtual Agent settings.

Is the NLU Model trained and published for the session language?

Your topic may not be using the latest changes to your model. For ServiceNow® 

NLU, see Train and try your NLU model  and Publish a Virtual Agent topic.

Is the Virtual Agent  topic published, discoverable, and bound to a published NLU Model 
and Intent for the session language?

The topic should be bound to a single model and intent for a given language. Ensure 
there are no duplicate intents bound to other topics. Make sure that the topic, 
model, and intent are in the same domain. For more information, see Publish a 
Virtual Agent topic.

Are any roles or conditions specified for the Virtual Agent  topic on the Properties tab in 
Virtual Agent  Designer?

If the topic is shown only for certain roles or for certain conditions, this can impede 
topic discovery. For details, see Topic Properties tab.

Why did Virtual Agent  discover my topic in Spanish but not in French?

There are several possibilities:

• Not all languages are supported by all NLU providers. For details, see Language 
support for NLU services.

• Not all topics are bound to a language-specific NLU model and intent.

For example, Topic A may be mapped as follows:

◦ Bound to Model A and Intent A for English

◦ Bound to Model A and Intent A for Spanish

◦ NOT bound to a model or intent for French
In this scenario, create a French model and intent for the topic. For more 
information, see Multilingual model management .

Why did a topic variable NOT slot fill?

Check the following:
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• The topic's user input node was not configured with an associated entity. Use the 
NLU entity  property for the node in Virtual Agent Designer.

• The prediction result contained an NLU entity with a confidence score that was 
less than the configured confidence threshold.

• The NLU entity value for the node was invalid. For example, you can't apply the 
word "red" to a Date/Time entity type.

Test discovery from the topic.

Do one of the following:

• From the Topics page, select Test Active Topics. Enter your utterance, and watch 
the Analyze test phrases  tab.

• Open the topic in Virtual Agent Designer, then select Test. In the Test window, 
select the Include topic discovery  check box. Enter your utterance, and watch the 
Analyze test phrases  tab.

For details, see Testing NLU/Keyword topics. For an understanding of how topic 
discovery works, see Natural Language Understanding topic discovery logic in 
Virtual Agent.

Is "Setup Topic" the topic in question?

If so, it needs to be configured in Conversational Interfaces  Chat Settings for it to be 
discovered. For details, see Configure a Virtual Agent chat experience.

Questions or issues with mid-topic switching.

Why did the conversation return to Topic A after Virtual Agent  switched to 
Topic B?

The Resume topic flow after topic switching  attribute is enabled on 
the topic. You can find this toggle switch on the Properties  tab under 
Advanced properties  > Additional.

Why did the conversation NOT return to Topic A after Virtual Agent  switched 
to Topic B?

The Resume topic flow after topic switching  attribute is disabled on 
the topic. You can find this toggle switch on the Properties  tab under 
Advanced properties  > Additional.

If Virtual Agent  doesn't find an intent, will it use a keyword search in mid-
topic?

No.

Are Topic A's variables available to Topic B after switching?

No.

Are Topic B's variables available to Topic A when Topic A resumes?

No.

For additional troubleshooting, check the information in the following tables.
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Check NLU prediction information in the Open NLU tables

When reviewing or debugging topics that use Natural Language Understanding  (NLU), you can 
use various Open NLU tables to view the NLU prediction results for your topics. For example, 
the Open NLU Predict Intent Feedbacks and Open NLU Predict Entity Feedbacks tables provide 
detailed information on the NLU processing performed by applications (such as Virtual Agent) to 
determine topic intent and entities (slot filling).

Open NLU Predict Intent Feedbacks table

The Open NLU Predict Intent Feedbacks [open_nlu_predict_intent_feedback] table 
shows the intent processing that an application (in this case Virtual Agent) performs 
in response to an NLU intent prediction result. The goal for Virtual Agent  is to map 
a predicted NLU intent to a Virtual Agent  topic. Whenever Virtual Agent  suggests a 
topic, a record of the prediction result is added to this table. If Virtual Agent  doesn't 
find a topic, no prediction occurs, and a record marked Skipped  is added to this 
table.

To view the table, navigate to All, and then enter 
open_nlu_predict_intent_feedback.list  in the navigation filter.

Key fields in the Open NLU Predict Intent Feedbacks table

Field Description

App
Application using NLU. For example: VA  (Virtual Agent).

App 
Document

sys_id of the application record. For example: 
sys_cs_topic.sys_id.

App 
document 
table

Table of the application record. For example: sys_cs_topic 
(Topics table).

Auto-
Selected

Boolean indicating whether the system detected only one intent 
above the prediction threshold, and therefore the application chose 
to run the topic that matched the same intent: true  or false.

Current 
Intent NLU intent that was used by the application when the NLU prediction 

was submitted. This field can be empty (blank). For example, an 
intent used in the Virtual Agent  application could be Change 
password.

Domain The intent's domain. For example, Global or ITSM.

External 
Model 
Display 
Name

Name of the external NLU model. For example, the name of the IBM 
Watson Assistant  NLU application.

Intent 
Switch 
Causer

Name of the originating topic that prompts the user for confirmation. 
There are two possible scenarios for values in this column:

• The user is prompted for confirmation on the initial intent match for 
their utterance (Ask user if topic VA chose is correct  toggle switch 
is enabled in NLU Settings).

If the user is prompted for an initial utterance, this value may be 
the Greetings topic. If the value is empty, the user either was not 
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Key fields in the Open NLU Predict Intent Feedbacks table  (continued)

Field Description

prompted for the initial match, or the user rejected the initially 
matched topic intent.

• The user is prompted for confirmation for an intent switch in 
mid-topic (Ask user if switched topic is correct  toggle switch is 
enabled in NLU Settings).

If the user is prompted for a switch in mid-topic, this value is the 
name of the topic they were viewing at the time of the switch.

Note: 
System tasks may also display here, 
which you can ignore. For example: 
__silent_TerminateGoal_a3817a5f7ca7439b8.

Intent 
Switch 
Causer 
current 
Task

Name of the task (node) that the user switches from.

Note: 
System tasks may also display here, 
which you can ignore. For example: 
__silent_TerminateGoal_a3817a5f7ca7439b8.

Mapped
Boolean indicating whether the application (Virtual Agent) 
considered the prediction to be usable by matching the intent to an 
available topic: true  or false.

Model 
Display 
Name

Name of the ServiceNow  NLU model.

Model ID ID of the NLU model that the prediction was submitted for.

Model 
Name

Name of the NLU model that the prediction was submitted for.

NLU Topic 
Discovery 
Outcome

Prediction result for initial utterance in a conversation as part of topic 
discovery:

• AI Search Fallback: No prediction was made. AI Search  was used 
as the fallback.

• Correct: A single prediction was made. The user confirmed the 
topic was correct.

• Correct Among Multiple: Multiple predictions were made. This 
result indicates that the user selected this prediction. Other 
prediction records are marked as Uncategorized.

• Exited with no confirmation: The user exits with no confirmation.

• Incorrect: A single prediction was made. The user confirmed the 
topic was incorrect.

• Incorrect Among Multiple: Multiple predictions were made, 
but the user did not select any of the suggested topics. This 
result indicates that this prediction had the highest Prediction 
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Key fields in the Open NLU Predict Intent Feedbacks table  (continued)

Field Description

Confidence value. The other prediction records are marked as 
Uncategorized.

• Setup Topic Prediction: Setup topic related prediction was made 
without using AI Search.

• Skipped: No prediction was made.

• Skipped with New Utterance: When the Topic menu displayed, 
the user typed a new utterance.

• Uncategorized: None of the above conditions were met, or the 
user abandoned the conversation.

NLU Model 
Language

Language of the NLU model used for the prediction.

Prediction Name of the predicted intent.

Prediction 
Audit Log

Reference to the Open NLU Predict Logs [open_nlu_predict_log] 
table.

Prediction 
Confidence

Confidence value of the prediction.

Requester 
Session 
Language

Language code of the requester session language when Dynamic 
Translation  is enabled.

For example, if the user types in French, the code fr  is stored. If 
language detection is enabled and the user enters text in a language 
that is not the default, Virtual Agent  asks the user to confirm their 
language. If confirmed, the detected language becomes the default 
value for the session.

Selected Boolean indicating whether the multiple predicted intents shown 
to end users as matched topics were actually selected by the end 
users: true  or false.

Shown
Boolean indicating whether the application (Virtual Agent) displayed 
the predicted intent as a choice for the end user to select: true  or 
false.

Topic 
Switched

Name of the topic, if the user was prompted for confirmation 
(regardless of their choice, yes or no).

Utterance Phrase entered by the end user in the chat client window.

Open NLU Predict Entity Feedbacks table

The Open NLU Predict Entity Feedbacks [open_nlu_predict_entity_feedback] table 
shows the entity (slot-filling) processing that an application (in this case Virtual 
Agent) performs in response to an NLU entity prediction result. For example, the 
goal of Virtual Agent  is to map a predicted NLU entity to a Virtual Agent  topic input 
variable.

To view the table, enter open_nlu_predict_entity_feedback.list  in 
the navigation filter.
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Key fields in the Open NLU Predict Entity Feedbacks table

Field Description

App
Application using NLU. For example, VA (Virtual Agent).

App 
Document

sys_id of the application record. For example: 
sys_cs_topic.sys_id.

App 
Document 
Table

Table of the application record. For example: sys_cs_topic.

Auto Selected Boolean indicating whether the application automatically chose to 
use the entity without notifying the user: true  or false.

External 
Model Display 
Name

Name of the external NLU model. For example, the name of the 
IBM Watson Assistant  NLU application.

Mapped
Boolean indicating whether the application (Virtual Agent) 
considered the prediction to be usable: true  or false.

Mapped to Item in the application that the entity was mapped to.

Model Display 
Name Name of the ServiceNow  NLU model.

Model ID ID of the NLU model that the prediction was submitted for.

Model Name Name of the NLU model that the prediction was submitted for.

Prediction Name of the predicted entity.

Prediction 
Audit Log

Reference to the Open NLU Predict Logs [open_nlu_predict_log] 
table.

Prediction 
Confidence

Confidence value for the prediction.

Selected Boolean indicating whether the application selected to use the 
entity: true  or false.

Shown Boolean indicating whether the application displayed the 
predicted entity to the end user as a choice to select: true  or 
false.

Utterance User phrase entered in the chat client window.

Value Value of the predicted entity.

Open NLU Predict Logs

The Open NLU Predict Logs [open_nlu_predict_log] table provides a consolidated 
overview of the NLU prediction records for topics. Each record in the log identifies 
the utterance and corresponding intents (topics) and entities determined by the 
NLU service. Each record also includes the NLU prediction scores calculated during 
topic discovery (intent matching) and entity extraction.
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Note: 
NLU prediction node logs are generated automatically. If you're 
using node logs for debugging but you want to suppress the 
automatic generation of NLU prediction node logs, add the 
com.glide.opennlu.predict.node_logging_enabled  system 
property and set the value to false.

To view the Open NLU Predict Logs, enter open_nlu_predict_log.list  in 
the navigation filter.

Key fields in the Open NLU Predict Logs table

Field Description

Async
Indicator for asynchronous prediction processing: true  or false. 
True indicates that the prediction was performed asynchronously, 
allowing Virtual Agent  worker threads to continue.

Created Date and time the NLU prediction record was created.

Duration Length of processing time for the prediction to return intent and entity 
values.

Language The language of the NLU prediction request.

Level Type of message: Information level.

Message Prediction results returned: number of intents and entities.

Request NLU prediction parameter that contains the utterance and NLU model 
for the recognized intent.

Response NLU prediction results, which contain 0 (none) or more scored intents 
and scored entities.

Source Process or area: OpenNLU - Predict.

Utterance User statement recognized by the bot, which maps to an intent 
defined in an NLU model.

Note: 
You can view the detailed intent and entity results in the Open NLU Predict 
Intent Feedbacks and Open NLU Predict Entity Feedbacks tables.

Review HTTP connection information for Open NLU integrations

Use the Open NLU Driver HTTP Connection [open_nlu_driver_http_connection] table to quickly 
check the HTTP credentials, connection details, and methods for the intents, entities, NLU 
models, and predictions for your NLU service provider.

To view the table, enter open_nlu_driver_http_connection.list  in the navigation 
filter.

Natural Language Understanding  topic discovery logic in Virtual Agent

Understand how Virtual Agent  returns intents and how it selects which intents to show to the 
user.
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Prerequisites for topic discovery

Virtual Agent  can discover a topic when the following conditions are met:

• The topic must be published and active.

In the Topics [sys_cs_topic] table, the Active, Published, and Is Topic Discoverable  values are 
set to true.

Note: 
The Is Topic Visible  column does not affect topic discovery.

• The topic must be discoverable.

• Topic conditions must evaluate to true at runtime.

• If any roles are configured for the topic, the requestor must have at least one of those roles.

• The topic's NLU  model must have a binding for the session language.

NLU  topic discovery logic

Virtual Agent  sends a prediction request to the NLU  provider. The request contains the utterance 
and all registered NLU  model IDs that are bound to the session language. Matches return NLU 
intents that correspond with a topic. Virtual Agent  then responds in one of the following ways:

• Automatically selects a topic for the requester, based on the confidence score.

• Prompts the requester to pick a topic from the returned list of matches.

• Finds no matching topics.

If no matches are found but backup keywords are enabled (the 
com.glide.cs.nlu.keywords.enabled  property is true), Virtual Agent  searches for a 
topic based on keywords.

Virtual Agent  topic discovery logic
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Virtual Agent  NLU  confidence scores

Virtual Agent  uses confidence scores to return predicted intents. If an intent's confidence score 
is greater than or equal to the configured threshold, Virtual Agent  considers it a good match. The 
confidence threshold is set using the com.glide.cs.intent_confidence_threshold 
system property.

Virtual Agent  uses the following logic when selecting intents:

Auto-selects the highest predicted intent

This occurs when only one intent is matched, or in the event of a tie-breaker, when 
the next closest match is a distant second.

Note: 
If ServiceNow  NLU  is used and the 
com.glide.cs.intent_confidence_delta  system property is 0, 
there can be no tiebreaker.

Returns a topic list for the requester to choose from

This occurs if auto-select is not applicable. The length of the list is determined by 
the com.glide.cs.max_number_display_topics  system property.

No intents are matched

When zero NLU  Intents are predicted with a confidence score greater than 
or equal to the configured threshold, Virtual Agent  falls back to a keyword 
search if configured. (The com.glide.cs.nlu.keywords.enabled  and 
com.glide.cs.nlu.keywords.include_topics_bound_to_lang 
system properties are true).

Mid-topic NLU  topic discovery logic

While a topic is running, the requester can enter an utterance or phrase that results in a topic 
switch. For example:

1. The requester is in a Virtual Agent  conversation, and Topic A is running.

2. Topic A prompts the user to enter their date of birth.

3. Instead of choosing a date, the requester types, "I want to view my Incidents."

4. Virtual Agent  can't resolve this phrase to a date, so it issues an NLU  prediction request.

5. The NLU  predictor returns Intent B, and Virtual Agent  sees that Topic B is bound to Intent B.

6. Virtual Agent  switches the conversation to Topic B, which then presents information to the 
requester about their incidents.
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Virtual Agent  mid-topic discovery logic

Related topics

Resolve Natural Language Understanding (NLU) topic discovery issues

Publish a Virtual Agent  topic

Deploy an inactive topic or an updated topic to save it and make it available to users on Virtual 
Agent  clients.

Before you begin
If you're using Natural Language Understanding  (NLU) topic discovery, you can publish the model 
at the same time as the topic if the model meets publication criteria. Make sure that your model 
has passed through all phases of development and is ready to publish. If you haven’t refined, 
tested, and optimized your model, you may not be able to publish it in Virtual Agent Designer. For 
more information, see Model management .

Role required: virtual_agent_admin or admin

About this task
You can also publish topic blocks and custom controls to make them available for use in calling 
topics.

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer.

2. In the Topics page, select the topic, topic block, or custom control to publish or republish.

3. In the topic header bar, select Publish.

Selecting Publish  when there are issues present opens an Issues shelf at the bottom of the 
diagram, which counts up and details all issues needing correction. These details include a 
hyperlink for each incomplete item. If the issue is in a node, selecting the hyperlink opens the 
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property sheet for that node. As each issue is resolved, the list on the shelf updates to show 
the remaining errors. Once there are no issues to resolve, the publishing dialog box opens.

If you're using NLU  topic discovery, the Choose what to publish dialog box appears. Select the 
available items to publish with the topic, such as the NLU  model and language mappings, and 
then select Publish.

Note: 
If the Publish  option is unavailable, the model may need some work. For example, the 
model may not have enough intents or may need more utterances for some intents. Fix 
these issues before proceeding. Also, if a model language is unavailable, the language-
specific model has never been published. Publish it from the NLU Workbench. For more 
information, see Model management .

The topic header bar displays a Saving in progress...  message. The toast message 
Successfully saved your topic  appears in the lower-right corner afterward for four 
seconds, and can be closed by selecting the X  in the message.

For topics, the topic state is Active and the Published state changes to Published just now.

4. If you published a conversation topic using either keywords or NLU, verify that your keywords 
or NLU  utterances for the topic work as expected.

a. Return to the Topics page, and then select Test Active Topics.

Note: 
If Now Assist  is enabled, the Test Active Topics  button includes a drop-down menu to 
identify topic types and where you want to test:

▪ Test NLU/keyword topics

▪ Test LLM topics

▪ Test in Now Assist Panel

b. In the conversation window, verify that the topic opens.
You can enter keywords or NLU  utterances that correspond to the topic intent. For the pre-
built Virtual Agent  topics, the bot returns a list of topics that match the entered keyword or 
utterance. For more information about testing Now Assist  LLM topics, see LLM topic testing.

Result
The topic blocks and custom controls are published and are available for use in calling topics.

Note: 
Active topics, including setup topics and small talk topics, can also be available for use 
after the topics are published. For more information, see Control topic discovery and 
visibility.

Delete a Virtual Agent  topic

Delete a Virtual Agent  topic that is no longer needed.

Before you begin
Role required: virtual_agent_admin or admin
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Note: 

Sometimes, certain categories of topics can’t be deleted, such as the Greeting, Survey, Live 
Agent, Error, Explore help, and Closing setup topics.

If you want to remove a topic from your Virtual Agent  clients but don't want to delete it, 
consider making the topic inactive instead.

About this task
You can delete a topic using the Delete  option in the Virtual Agent Designer  header bar for the 
topic.

Procedure

1. If you're not working on the topic, navigate to All  > Conversational Interfaces  > Virtual Agent  > 
Designer  to display the Topics page.

2. Use one of the following methods based on either a card on the topic page or the header 
inside a topic.

3. In the Confirm Topic Deletion window, select Delete.
The tab closes and returns you to the Topics page.

Result
If the topic was active and is no longer listed in the Topics page, the topic is immediately 
removed from Virtual Agent  clients.

Promote or demote Virtual Agent  LLM topics

Promote topics in Virtual Agent Designer  after associating them with a large language model 
(LLM) assistant. Promoted topics are then suggested to the user by the LLM assistant.

Before you begin
Associate an LLM topic with an LLM assistant. For more information, see Create a Virtual Agent 
topic.

Role required: virtual_agent_admin or admin

About this task
When you create a topic in Virtual Agent Designer  or open a non-read-only topic, you can 
associate it with an LLM assistant. After linking your topic, you can promote the topic so the 
LLM assistant suggests it to the user. You can also find promoted topics on the topic page by 
selecting the Promoted  option from the Sort by drop-down list. Promoted topics can also be 
demoted to remove them from the list of suggested topics.

System topics, setup topics, topic blocks, custom controls, and small talk topics cannot be 
promoted.
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Promotion and demotion controls for LLM topics

The Promote  and Demote  controls appear if the topic is demoted or promoted, 
respectively. A Promoted  category also appears on a promoted topic's card.

For more information, see Create a Virtual Agent topic  and LLM assistants.

Procedure

1. Navigate to All  > Virtual Agent  > Designer.

2. Select the LLM assistant drop-down list, then select the LLM assistant that will promote the 
topic.
The list of topics reduces to LLM topics that are associated with the selected LLM assistant.

3. Find the card for the topic that you want to promote or demote.

4. Select the topic actions icon ( ), then select Promote  to add the topic to the list of promoted 
topics, or select Demote  to remove it from the list.
If the topic is already promoted, the topic has a Promoted  flag, and the Promote  option is 
replaced with a Demote  option.

Result

 The topic is added to the list of topics promoted by the LLM 
assistant, while a demoted topic is removed from the list.

Reorder promoted Virtual Agent  LLM topics

Arrange large language model (LLM) topics to a desired non-alphabetical order after promoting 
them for recommendation by the Virtual Agent.
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Before you begin
Promote an LLM topic or topics. For more information, see Promote or demote Virtual Agent LLM 
topics.

Role required: virtual_agent_admin or admin

About this task
Promoted LLM topics are presented in alphabetical order by default. You can rearrange 
promoted topics in any desired order by editing their records in the Promoted Skills 
[sys_cs_context_profile_promoted_skill] table.

Procedure

1. Navigate to All  > sys_cs_context_profile_promoted_skill.list.

2. Under the topic that you want to reorder, select the Order  value.

3. Input a value number.

Result
The list of promoted skills is presented in a Virtual Agent  conversation based on the order value 
of each topic from the lowest to highest number relative to other promoted topics.

What to do next
Repeat the previous steps to adjust any other promoted topics to sort them in a desired order.

Exploring other Virtual Agent  features

After creating topics with the basic Virtual Agent Designer  controls and scripting, you can also 
enhance conversation functionality and topic maintenance by using additional Virtual Agent 
features.

After learning the basics, here are some other Virtual Agent  features that may help you improve 
your authoring and end-user experience.

Deploy Virtual Agent in other channels

By default, Virtual Agent  runs in a web client, but you can also run it in other 
channels. While some features may not be available in certain channels (such 
as the carousel user input control), you can customize your conversation flow to 
accommodate these differences.

Use link unfurling in Virtual Agent

Virtual Agent  supports link unfurling on the web client, mobile devices, and various 
channels. Link unfurling generates a content-rich preview when a supported link is 
shared in a conversation with a user, a virtual agent, or in a text-based bot response.

Improve the user experience with AI Search

What happens when a user utterance isn't matched to a keyword or intent? Enable 
AI Search  as a fallback so that the user sees a list of search results as a response 
when no other match is found.

Maximize code reuse with topic blocks

Rather than duplicate common functionality in multiple topics, you can create 
reusable topic blocks that you can reference in many topics. This allows you to 
maintain frequently used functionality in one central location.

Customize Virtual Agent with custom controls

If a Virtual Agent Designer  control doesn't quite work for what you want to achieve, 
create a custom control. You can create your own controls to accept input from the 

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1897



conversation, as well as custom response controls to handle the output. Use these 
controls within topics to handle specialized tasks.

Integrate Virtual Agent with Flow Designer workflows

If your company is using Flow Designer  to create workflows, you can integrate them 
into Virtual Agent. You may need to do this if your conversations require you to pass 
secure inputs, such as a password. Flow Designer  actions and subflows support the 
password2 data type, which lets you pass the input securely.

Use Virtual Agent with Agent Chat

Customize Virtual Agent  to hand off some conversations to a live agent when 
needed.

Use Virtual Agent for Incident Auto-Resolution

Initiate a Virtual Agent  conversation with an end user after they submit an incident 
through email or the ServiceNow®  Service Portal  if an existing Virtual Agent  topic 
can resolve the issue.

Localize Virtual Agent topics

Use the ServiceNow  Localization Framework  to translate topics and NLU models into 
other languages.

NLU Workbench - Advanced Features

Expand the functionality of NLU Workbench  to help you manage and improve your 
models. NLU Workbench  - Advanced Features is available from the ServiceNow 
Store.

Integrate Virtual Agent with other portals and apps

Integrate and extend the capabilities of Virtual Agent  by connecting to your 
employees and customers where they already are.

Use Virtual Agent REST API in a standalone or multi-bot environment

Integrate any chat interface or bot using this REST API that is available in the 
ServiceNow Store.

Additional resources

Take advantage of the following ServiceNow®  resources to help you customize your Virtual 
Agent:

• Virtual Agent and Natural Language Understanding (NLU) community forum

• Virtual Agent Academy

Deploying Virtual Agent  topics in other channels

When creating a topic or topic block, you can specify the chat channels in which the topic 
or topic block will run. During conversation design, Virtual Agent Designer  provides built-in 
guardrails to help you tailor your conversations to those channels.

In Virtual Agent, a channel is a chat interface or application in which Virtual Agent  interacts 
with end users. Default channels are the chat applications natively supported by Virtual Agent, 
such as the Slack, Microsoft Teams, Workplace, and Facebook Messenger  applications, and 
the web and mobile clients. Virtual Agent  also supports custom channels created through the 
conversational custom chat integrations  feature, which enables third-party applications (other 
chat providers) to work in Virtual Agent.

For example, admins can build a custom conversational chat integration for a specific messaging 
provider, such as Skype. Admins also define the controls that can be used in topics that run 
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in these channels. For details about creating channels for chat providers and specifying the 
controls used in a channel, see Conversational custom chat integrations.

Specifying channels in your topics or topic blocks

When you create or edit a topic or topic block, you can specify the applicable channels in the 
Additional channel support  field of the Topic Properties page. Applicable channels are the 
custom channels created for your instance through the conversational custom chat integrations. 
Use this field to specify chat clients in which the topic or topic block will run.

Additional channel support field in the Topic Properties page

During conversation design, Virtual Agent  checks the various controls used to build the 
conversation flow to confirm that the control is valid for the channels in which the topic or block 
will run.

Design checks for specified channels during conversation design

When you're designing your conversation, built-in guardrails identify the Virtual Agent Designer 
controls that are not suited for the custom channels that you specified in the Topic Properties 
page. These messages are displayed in the following views:

• Properties  tab (Topic Properties page)

In the following example, Skype and SMS are the additional channels in which the topic will 
run. The banner message identifies the controls that are not supported on the channels for the 
topic. As you develop the conversation flow, you can revise your conversation so that it does 
not use any of the specified controls for your selected channels.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1899



Topic Properties tab with defined channels

• Flow  tab (Virtual Agent Designer  canvas)

In the following example flow, the banner message identifies the controls that are not 
supported for the specified channels. The property sheet for the affected nodes also displays 
a message indicating that the control is not supported. For example, when you highlight a 
particular node (control) in the flow, the associated property sheet for the node indicates that 
the control is not supported in the Skype and SMS channels.

If you have controls that cannot be used, you can branch the flow so that you can continue 
building the flow with the controls that are supported.

Topic Flow tab with channel warnings

Finding the channels available in your instance

To see a list of the available channels in your instance, use the Supported Channels  filter in the 
Topics page in Virtual Agent Designer  (Conversational Interfaces  > Virtual Agent  > Designer). 
The Messaging Channels [sys_cs_channel] table also shows the available channels.

Note: 
If no channels are configured for the instance, this filter is not displayed.
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Supported Channels filter in the Topics page

The default channels in Virtual Agent  are the web chat and mobile clients and also the Virtual 
Agent  messaging integrations for the Slack, Microsoft Teams, Workplace, and Facebook 
Messenger  messaging applications. In the previous example, SMS is an available chat channel 
that was created for your instance through a conversational chat integration. When you choose 
a channel, the Topics page lists your topics (cards) by channel type. For more information, see 
Conversational custom chat integrations.

Using link unfurling in Virtual Agent

Virtual Agent  supports link unfurling on the web client, mobile devices, and various channels. 
Link unfurling generates a content-rich preview when a supported link is shared in a 
conversation with a user, a virtual agent, or in a text-based bot response.

If the link is supported on the web client or channel, the generated content-rich previews can 
include text, images, and videos.

Note: 
Factors such as website availability, security policies, or response time of the link you 
want to unfurl are unpredictable. As a result, link unfurling may be delayed or unavailable. 
However, these performance-related issues don’t impact the user and don't affect the 
conversation flow.

How to determine if a link is supported

The ServiceNow  user interface currently supports link unfurling for OG tags only. A link is 
supported only if all the following conditions are met:

• The host or domain is included in the Hostname allow list table.

• The link uses standard, compliant Open Graph (OG) tags  in the page header as metadata. 
For example, og:image.

• The link was shared in a conversation with a user, a virtual agent, or in a text-based bot 
response.

Note: 
These conditions apply only to the web client and mobile devices on the ServiceNow® 

platform. Support requirements and conditions for clients on other platforms can vary. For 
client-specific support and requirement conditions, see the documentation for the client 
you're using.

Tip: 
Admins can add OG tags to ServiceNow  UI pages by following the instructions in the 
Adding meta tags to ServiceNow UI Pages  Knowledge Base article.

When a link meets the specified criteria, the ServiceNow  software does the following:

• Asynchronously fetches, if available, the OG tag at the provided link.

• Attaches a card-based, content-rich preview of the link based on the OG tag.
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The time required to complete these and any other required tasks can vary, depending on your 
network configuration and system performance.

Supported OG tags

The ServiceNow  user interface supports image, video, and text-based OG tags. When both an 
image OG tag and a video OG tag are fetched, the video is used instead of the image in the card-
based, content-rich preview.

Note: 
The specific OG tags supported on channels can vary. For example, the OG tags 
supported on Slack  may be different from the OG tags supported on Microsoft Teams, or 
Workplace from Facebook. For details about the OG tags supported on channels, see the 
documentation for the channel you're using.

Disabling link unfurling

Link unfurling is automatically enabled by default. To turn it off, Maint users change the 
com.glide.cs.enable_link_unfurling  system property to False.

Configure link unfurling using the Hostname allow list table

Use the Hostname allow list [sys_cs_hostname_allow_list] table to identify the list of hosts and 
domains that can be unfurled.

Before you begin
For security reasons, only the hosts and domains in the Hostname allow list table can be 
unfurled.
The Hostname allow list table includes the following hosts and domains by default:

• Instance URL/hostname: <instance>.service-now.com or <customURL>.com

• Instance root domain: *service-now.com or *.<yourdomain>.com

• servicenow.com

• *.youtu.be

• *.youtube.com

Role required: admin

Procedure

1. Navigate to All, and then enter sys_cs_hostname_allow.list  in the filter.

2. Click New.

3. On the form, fill in the fields.

Field Description

Active Select this option to enable the host or domain that can be unfurled.

Hostname Name of the host or domain that can be unfurled. You can use an asterisk (*) to 
specify a wildcard in the host or domain name.

For example, enter *.domain.com.
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Field Description

Domain Domain group. The default is global.

4. Click Submit.

Improving the user experience with AI Search

Virtual Agent  uses the ServiceNow AI Platform®  AI Search  application to return search results in 
bot conversations as a fallback when there are no relevant topics to display to end users. Virtual 
Agent  also provides a Run AI Search  topic block that topic authors can use to generate search 
results in a topic.

How Virtual Agent  uses AI Search

The AI Search  application, which is included with the ServiceNow AI Platform, provides relevant 
search results for queries and uses Machine Learning to continuously improve search results 
based on end-user selections. To learn more about AI Search, see AI Search .

In addition to normal search results, AI Search  can display Genius Result cards that show 
relevant catalog items, questions and answers (Q&A), and people (user) information. To learn 
more, see Genius Results .

Catalog Genius Results and Q&A Genius Results are automatically activated in the base system.

Virtual Agent  uses AI Search  to provide the following:

• The Run AI Search  topic block, which calls the AI Search  application in a conversation. Topic 
designers can add this block as a topic node, to generate and display search results in a 
conversation. For details about the Run AI Search  block and other topic blocks provided with 
Virtual Agent, see Virtual Agent platform topic blocks.

• The AI Search  Fallback setup topic that generates search results for end users when 
Virtual Agent  can't determine an intent and topic or the keyword to display the appropriate 
conversation for user requests.

Virtual Agent  provides base system (default) AI Search  configurations that determine how search 
results are generated and displayed:

• Search application configuration that defines:

◦ Index sources - Data sources to be used for search, such as catalog items or knowledge 
base (KB) articles.

◦ Search profile - Index source to be used and the type of results to show in Genius Result 
cards.

• Entity View Action Mapping  (EVAM) configuration that defines how search results and Genius 
Results are displayed.

The Virtual Agent  search configurations are part of the default chat experience set in Virtual 
Agent Designer, through the Custom Greetings and Setup feature. Use this feature to specify the 
context for running Virtual Agent. The chat experience defines the setup topics used in Virtual 
Agent  conversations and the search configuration that controls the AI Search  experience. The AI 
Search  Fallback setup topic controls the AI Search  experience. For details, see Setting up chat 
experiences for Virtual Agent users.

Virtual Agent  and Virtual Agent  Lite use AI Search  functionality. If you're a Virtual Agent  Lite 
admin, you can deactivate setup topics such as the AI Search  Fallback setup topic, but you can't 
change the Virtual Agent  search configurations set in chat experiences, the Run AI Search  topic 
block, nor the AI Search  Fallback setup topic.
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In order to use AI Search  in Virtual Agent, you must request it for your instance. For more 
information, see Activate AI Search for Virtual Agent.

When Virtual Agent  uses AI Search  fallback

Virtual Agent  uses AI Search  fallback in the following instances:

• Topic discovery can't find any matching topics for the user query.

Note: 
If you're using pre-built NLU conversations, such as ITSM Virtual Agent  conversations, 
topic discovery finds the topics that match the keywords or intents provided with those 
conversations, before falling back to AI Search. If your users select Ask something else 
after suggested topics are displayed, Virtual Agent takes the additional input and reruns 
topic discovery AI Search  to return relevant search results.

• Topic discovery returns too many topics for the user query. In this case, Virtual Agent  can't 
determine the best topic to display to the end user.

• Topic suggestions are displayed to the user, but the user selects the Ask something else 
option.

Note: 
If you deactivate the AI Search  Fallback setup topic in a chat experience, the Virtual Agent 
runs the Fallback setup topic when it can't find a matching topic.

What the AI Search  results look like

In Virtual Agent, the default chat experience or a custom chat experience determines the search 
experience, namely the search profile used and the format of the AI Search  results displayed:

• The search application specified in the Virtual Agent  default or custom chat experience 
defines certain aspects of the search experience, such as the search sources (searchable 
content) and synonyms used to improve search recall.

• The EVAM  configuration for Virtual Agent  controls the Genius card content presented in search 
results (Q&A, Catalog, and People). For information on how EVAM  works, see Entity View 
Action Mapping.

The default AI Search  results include these items:

Genius Result cards

When AI Search  generates a match (result) with a high confidence score, Virtual 
Agent  displays a single Genius card with the result. The cards display information 
returned from AI Search:

• Q&A - Provides an answer snippet from the Knowledge Base article determined 
as the top search result.

• Catalog items - Returns the most relevant catalog item with the related entities 
(catalog item name and catalog item category).
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• People - Returns the relevant person with the related entities (name, department, 
city).

Note: 
The default search application for Virtual Agent  is configured to include 
Q&A (Knowledge Base) and Catalog results, but not People card results. The 
People card is not available with the default Virtual Agent  search application. 
People card results are available if you're using the Employee Service 
Center  (ESC) app and the ESC search profile, which can be specified in a 
Virtual Agent  chat experience for ESC.

Genius card examples

List output

After a Genius Result is returned, users can indicate what they would like to do next. 
If they choose the option Show me more on <search item>, Virtual Agent  displays 
search results as a list output, which includes:

• Knowledge articles

• Catalog items

• People

• Other - Generic results determined by EVAM, for example results from Microsoft 
SharePoint  or Microsoft OneDrive  connectors

Admins can edit the prefix of these search result titles by navigating to 
EVAM  and searching for Virtual Agent  templates. Select the template for the 
applicable search result type and update the value for the key  attribute. 

Admins can expand the number of search results displayed up to 10, using 
the com.glide.cs.ai_search.max_regular_result  property. In 
order for the search results to display as expected, the search result limit in 
the search application configuration should be greater than or equal to the 
com.glide.cs.ai_search.max_regular_result  system property.
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Note: 
When admins specify 10 for the maximum regular results, 12 choice options 
display (10 results plus the actions “I need more help” and ”Ask something 
else”). However, the default total number of list options allowed on the web 
client is 10. In order for all 12 choices to display, the admin must adjust the 
com.glide.cs.picker_page_limit  system property accordingly. For 
optimal user experience, fewer list options are recommended.

Users can select a search result from the list and continue the Virtual Agent 
conversation. For example, when a user selects a catalog item from the search 
results list, Virtual Agent  provides an option to request the item directly from the 
chat.

Portals that display AI Search  links

Links in the Genius card and multi-link output search results are opened 
automatically in a portal that you can set in various ways. For example, you can use 
default or custom URL mappings to specify the portal in which links are opened. To 
learn more, see Configure URL navigation for chat links.

Custom search experiences

You can customize the AI Search  experience in a conversation, for example to run searches 
that return results relevant to a particular business application. To control the AI Search  results 
returned in a conversation, you can create a search application configuration that defines the 
search experience used by the AI Search  topic block. For details, see Create a custom AI Search 
experience for Virtual Agent conversations.
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Activate AI Search  for Virtual Agent

Once activated, AI Search  configurations that are part of the Virtual Agent  default chat 
experience become available. The AI Search  Fallback setup topic controls the AI Search 
experience.

Before you begin
Role required: admin or virtual_agent_admin

About this task
The default chat experience is defined in the Custom Greetings and Setup settings area in the 
Conversational Interfaces  admin console. The default experience uses the AI Search  Fallback 
setup topic, which requires AI Search  to be activated for Virtual Agent. You can request AI Search 
from the Conversational Interfaces  admin console Home page.

Procedure

1. Navigate to All  > Conversational Interfaces  > Home.

2. On the Home page, find the Request AI Search tile, and select Request AI Search.

3. On the page that opens, select Request AI Search  to request provisioning.

Result
Your request will be processed. Once activated, enable the AI Search  Fallback setup topic in 
the default or a custom chat experience. For instructions on configuring a chat experience, see 
Setting up chat experiences for Virtual Agent users.

If you want to customize the Virtual Agent  AI Search  results that are generated for your users, see 
Create a custom AI Search experience for Virtual Agent conversations.

Create a custom AI Search  experience for Virtual Agent  conversations

Define a custom AI Search  experience in a conversation using the AI Search  topic block. You 
create a Search Application Configuration used by the topic block to control the AI Search  results 
returned in the conversation. Or you can use the Search Application Configuration to control AI 
Search  results in a custom chat experience.
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Before you begin
Create the search profile  that defines the search experience to be used in the search 
application configuration. For details, see Search profiles  and Search application 
configurations .

Role required: virtual_agent_admin or admin with the search application administrator 
[search_application_admin] role

About this task
A search application configuration specifies the AI Search  profile used by the Run AI Search 
topic block or in a custom chat experience to control the search experience, such as the search 
source used to generate search results.

Note: 
As of the Utah  release, use the AI Search  topic block when creating an AI Search 
application. (The Run AI Search  topic block is used in releases from Rome to Tokyo.)

Procedure

1. Navigate to All  > AI Search  > Search Experience  > Search Applications  and select New  to 
create the search application configuration.

2. On the form, fill in the fields.

Search Applications Configuration form

Field Description

Name
Name for the search application to be used 
by the AI Search  topic block.

Search Engine
Search engine to use in this search 
application. Use AI Search  as the search 
engine.

Search Profile
Search profile that stores the search 
experience settings for generating AI Search 
results.

Search Results Limit Maximum number of search results that the 
application should display.

Note: 
The search query in Virtual Agent 
returns 3 results per query. However, 
the limit can be changed by using the 
com.glide.cs.ai_search.max_regular_result 
system property, for a maximum of 
10 results. For more information, see 
Improving the user experience with AI 
Search.

Genius Results Limit Maximum number of Genius Result cards to 
be displayed.
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Field Description

Note: 
Virtual Agent  supports only 1 or 0 card 
results per AI Search  query. If you 
change this field to a different value, 
Virtual Agent  still displays only 1 or 0 
card results.

Enable Typo Handling
Option to auto-correct search query terms to 
match terms found in the search profile's typo 
handling dictionary. For Virtual Agent, turn off 
this option by deselecting it.

3. Select Submit.

4. Apply the custom Search Application Configuration to the AI Search  topic block used in a 
conversation or to a custom chat experience.
Your custom Search Application Configuration is used in the AI Search  topic block in a 
conversation or a custom chat experience to generate the customized AI Search  experience.

Maximizing code reuse with topic blocks

Topic blocks are reusable components that you can create to run common tasks and 
conversational elements in Virtual Agent  conversations. Topic blocks simplify the topic authoring 
and maintenance process by enabling you to reuse standard procedures or actions across 
conversation topics.

How reusable topic blocks work

A topic block is basically a subflow that performs certain actions or conversational tasks in a 
topic. For example, you can build a topic block that creates or retrieves certain types of records. 
You create topic blocks with Virtual Agent Designer, similar to the way that you build conversation 
topics. With Virtual Agent Designer, you can do the following:

• Set topic block properties.

• Define the controls (nodes) used in the block.

• Test or preview the block.

• Publish the block to make it available for use in topics or other topic blocks.

Unlike topics, topic blocks are not discoverable by a large language model (LLM), Natural 
Language Understanding  (NLU), or keywords. The topic block's functionality can only be 
accessed by a topic.

A conversation that uses (consumes) a topic block is referred to as the calling topic. A topic block 
can call another topic block, but it cannot call itself. You can "nest" topic blocks in this manner, 
even if the flow returns to the initial topic, as in this example:

Chain of nested topic blocks
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Note: 
If Virtual Agent  detects an infinite loop, the conversation ends.

The Virtual Agent  platform and applications provide pre-built topic blocks for common tasks 
or subflows. You can use these pre-built topic blocks in your conversation topics "as is" in the 
appropriate application scope by duplicating them. You can then customize these pre-built topic 
blocks as needed. Some of the common topic blocks include the following.

Examples of pre-built topic blocks

Pre-built topic blocks Application scope

• Transfer to Live Agent: Transfers a bot 
conversation to a live agent.

• Survey: Presents a survey for collecting 
feedback for an agent.

• Geolocation: Gathers information about the 
user's location.

• Pause: Insert a pause (in seconds) in the 
conversation.

• Deflection: Tracks deflection metrics for the 
Virtual Agent.

Global. Provided with the Glide Virtual Agent 
plugin (com.glide.cs.chatbot).

Contextual search: Uses a search phrase to 
return search results in a card format, such as 
knowledge articles and catalog items.

Common topic block used by the CSM, 
HR Service Delivery, and ITSM business 
applications. Provided with the Service 
Management Virtual Agent Topic Blocks 
plugin (com.glideapp.cs.sm_topic_blocks). 
This plugin is included with the Virtual Agent 
conversation plugins  for these business 
applications.

Topic blocks are listed as cards in the Topics page. Use the Type  filter to list and view only topic 
blocks in the Topics page.
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List of topic blocks in the Topics page

After you create and publish a topic block, the block is available for use as a Topic Block utility in 
Virtual Agent Designer. You can add the topic block to a calling topic or to another topic block. In 
the following example, the calling topic uses the Contextual Search topic block.

Example of contextual search topic block in a calling topic
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What to do next

Working with topic blocks involves the following steps:

1. Create a reusable topic block.

Build a conversation component that performs a common function that can be reused in 
Virtual Agent  conversations.

2. Add a reusable topic block to a calling topic or topic block.

To run a specific subflow, add a reusable topic block to a calling (parent) topic or topic block. 
Specify the inputs that are used in the topic block and review outputs that are returned from 
the topic block.

3. Maintain topic blocks and associated calling topics (as needed).

When you update a published topic block, Virtual Agent Designer  performs certain checks. 
Displayed messages inform you of changes that you may want to make to calling topics that 
use the updated block.

Create a reusable topic block

Build a reusable component that performs a specific subflow of tasks and conversational 
elements in Virtual Agent  conversations.

Before you begin

Tip: 
Developers and topic authors may need to access topic blocks created in other application 
scopes. To give them access, see Create cross-scope access privileges for topic blocks 
and custom controls.

Role required: virtual_agent_admin or admin

About this task
Use topic blocks to run common steps, such as retrieving certain records.

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer.

2. In the Topics page, do one of the following:

◦ To create a topic block from scratch, select + Create.

◦ To create a topic block based on a pre-built topic block, open the topic block and do the 
following:

a. In the header bar, select Duplicate.

b. Enter the name of the new block and select Save.

3. On the sheet, fill in the fields.

Topic Block Properties sheet

Field Description

Type
List of items that you can create in Virtual Agent Designer.

Select Topic Block  and define the additional properties.
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Field Description

Note: 
Once you set this topic as a topic block, you cannot change it to a regular 
topic.

Name Unique name for the topic block that reflects its functional purpose. This name 
appears in the list of topic blocks that topic authors can choose from when 
creating or updating a topic.

Description Brief explanation of the purpose of the topic block. For example, to retrieve 
records.

Advanced properties (optional)

Who can access this topic

Channels
Chat clients in which the topic or topic block will run.

These channels are different from the default channels that are natively 
supported by Virtual Agent. Your instance may have additional channels for 
custom chat integrations  created for it. For more information about channels, 
see Deploying Virtual Agent topics in other channels.

Live agent

Live agent 
context 
variables

Live agent context variables that are defined in the General Chat Settings.

Select the variables that provide dynamic context, which means information 
from the Virtual Agent  chat. This information is transferred from the bot 
conversation to the live agent.

For information about the default list of live agent variables, see Live agent chat 
context variables.

Available 
for Agent 
Autopilot

Toggle switch that determines whether the topic block is available to a live 
agent.

When enabled, an agent can search for the topic and invoke the topic. For 
details, see Conversation Autopilot.

Available on the palette

Enable Toggle switch that determines whether the topic block appears as its own icon 
in the Utilities section of the palette on the Flow  tab. This provides easy access 
to the topic block for other authors.

Additional

Categories Category that contains this block. You can define custom topic categories  for 
your topic blocks.

4. Select Create.
The Flow  tab opens. The canvas displays a flow with a Start  and End  node.

5. To define an input to the block, do the following:

a. Select the Start  node in the canvas.

b. In the Start Segment Properties sheet, select + Add
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c. On the sheet, fill in the fields.

Add input dialog box

Field Description

Name Name of the input variable that stores the input value.

Type Type of data being passed to the topic block. For example, String, 
Boolean, and so on.

The fields change according to your choice. For more information, see 
Input data types in Virtual Agent topics.

Required Option to set the parameter as required.

Hint Tooltip that is visible when authoring a calling topic. See the following 
example:

Table ServiceNow  table that is used to query for input.

This field is available only when Reference  or Array.Reference  is selected 
from the Type  field.

Max Number 
of Rows

Maximum number of rows that the topic block is allowed to define.

This field is available only when Array  is selected from the Type  field.

Default Value Default value for the variable. This value can be used when previewing the 
block.

Duplicate default values are not allowed for array data types.

Example 
For example, the pre-built Contextual Search topic block provides the following input 
parameters:
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d. Select Save.

The calling topic or topic block passes input parameters to the topic block.

6. Drag Virtual Agent Designer  controls onto the canvas.
These controls include the input, bot responses, and utilities. Use them in combination to 
define the logic that is run in the topic block. For more information, see Virtual Agent Designer 
controls.

7. To define the output returned from the topic block, do the following:

a. Select the End  node in the canvas.

b. In the End Segment Properties sheet, click + Add New.

c. On the sheet, fill in the following fields.

▪ Name: Name of the value returned from the topic block.

▪ Value: Either a string with variables or a script that can be used within the calling topic. 
The Value  is presented as data pills for the input variables that you defined (the Default 
Value  specified in the Input Parameters and the input values from the node in the topic 
block).

Example 
For example, the pre-built Contextual Search topic block passes the following output 
parameters:

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1915



d. Click Save.

When the topic block finishes running in the calling topic, it can pass output variables to the 
calling topic.

8. To see how the topic block runs, select Test.

Example 
For example, the Contextual Search topic block returned the following results, including a 
preview-only message with the output values. The preview message helps you verify expected 
outputs and is not viewable to your users.
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9. If you're ready to make the topic block available for use in calling topics, then do the following:

a. Remove the default parameters that you used for testing.

b. Select Save, and then click Publish.
The topic block state changes to Active and is ready for use in calling topics.

What to do next
Add a reusable topic block to a calling topic or topic block.

Add a reusable topic block to a calling topic or topic block

Add a reusable topic block to a calling (parent) topic or topic block to run a specific function or 
task in the calling topic. You specify input parameters used in the topic block, and you specify 
output parameters that are used by the calling topic.

Before you begin
Review the topic blocks available in the Topics page in Virtual Agent). You can create a new 
topic block. You can also use a pre-built topic block, duplicate it, and customize it. Pre-built topic 
blocks are installed automatically with the Glide Virtual Agent  plugin, as well as the Virtual Agent 
conversation plugins  for Customer Service Management, HR Service Delivery, and ITSM.
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Verify that the topic block you want to use is published and active.

Role required: virtual_agent_admin or admin

About this task
You can specify the following types of variables:

• Input variables that are passed to the topic block.

• Output variables that are returned from the topic block to the calling topic.

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer.

2. In the Topics page, select the calling topic or topic block in which you will include the topic 
block.
The Flow  tab displays the conversation flow.

3. Depending on the type of topic block you are adding, add the appropriate Virtual Agent 
controls (nodes) to the conversation.
For example, if you are adding the Contextual Search topic block, you could add the Text 
user input control to request an item from the user. Drag that control before the node for the 
Contextual Search topic block.

4. From the Utilities section of the palette, drag the Topic Block control onto the canvas at the 
appropriate location in the conversation flow.

5. In the Topic Block properties sheet, select the name of the topic block that you want to add.
The property sheet for the selected topic block displays the input and output parameters. The 
name of the selected topic block automatically pre-populates the Node name  field. You can 
override the name if needed.

6. Set the required Input Mapping variables and, if applicable, the Output Mapping variables for 
the selected topic block.

7. In the header bar, click Save.

8. To preview your calling topic, click Test  in the header bar.
You can see how the calling topic runs in the chat window.

If the Now Assist  panel or Microsoft Teams  is configured for your environment, preview options 
for those channels display in the Test button list. Select Preview in Now Assist panel  or 
Preview in Microsoft Teams  in the list to test your topic in those environments.  For more 
information, see Integrating Virtual Agent with enterprise messaging apps.

9. If no further changes are needed, click Publish  in the header bar.

Maintain reusable topic blocks

When you update topic blocks, Virtual Agent Designer  provides built-in checks to help you 
identify changes to topic blocks that affect the calling topics that use them. Updates include 
changing input and output parameters, deleting topic blocks, and publishing inactive and active 
topic blocks and calling topics.

To help you maintain your topic blocks and associated calling topics, Virtual Agent Designer 
provides alerts that serve as guardrails. These alerts have many functions, including the 
following:

• They warn you of topic block updates that affect associated calling topics.

• They help prevent you from making unintentional changes.

• They let you know that you may need to make changes in associated calling topics.
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Changing the input or output parameters in a topic block that is used by calling 
topics

Virtual Agent Designer  helps prevent you from deleting output parameters that are being used in 
calling topics. Virtual Agent Designer  informs you that the changes will affect calling topics that 
use the topic block.

For example, suppose you added a new input parameter and made an existing parameter 
required in the Acme Contextual Search topic block. You can review the affected topics from a 
link on the topic block's Properties  tab. The View published topics that use this topic block link 
opens the Topic Library Usages [sys_cs_topic_library_usage] table. This table lists the published 
calling topics that use the topic block.

When you open an affected topic, Virtual Agent Designer  displays warnings and messages on 
the canvas indicating where you need to make changes. When you select the Topic Block node, 
warning messages are displayed in the properties sheet so that you can update parameters 
accordingly.

Messaging of input parameter changes

Virtual Agent  platform topic blocks

Virtual Agent  provides pre-built topic blocks that topic authors or admins can use to perform 
specific platform-related functions or tasks in bot conversations. For example, certain topic 
blocks enable you to check agent availability or generate AI Search  results.

Overview of pre-built topic blocks

Certain pre-built topic blocks are included automatically with the Glide Virtual Agent 
(com.glide.cs.chatbot) plugin and Virtual Agent Lite. If you're using Virtual Agent Lite, you have 
read access to the topic blocks but you can't create topic blocks or add them to calling topics.

You can duplicate pre-built topic blocks and modify the duplicates by using Virtual Agent 
Designer. For information about working with topic blocks and how to add them to calling topics, 

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1919



see Maximizing code reuse with topic blocks  and Add a reusable topic block to a calling topic or 
topic block.

The following sections describe the input and output parameters for calling different types of 
platform topic blocks. The topic block input parameters are passed from the calling topic, and the 
output parameters are returned from the topic block to the calling topic.

Note: 
Upgrades to the default topic blocks are not applied to the duplicated topic blocks.

Agent Availability topic block

Use this topic block to get relevant live agent information for use in agent handoff conversations. 
This information includes agent availability, wait time (how long before an agent is available), and 
queue information. You can use the information returned, such as a long wait time for an agent, to 
initiate a case or customer callback.

This topic block requires the Agent Chat  (com.glide.interaction.awa) plugin, which includes 
Advanced Work Assignment.

The following table lists the output parameters for this topic block.

Agent Availability output parameters

Parameter Description

agentAvailable Agent availability. The value is true if an agent is available for this queue. 
Otherwise, the value is false.

supportQueue sys_id of the queue that is associated with the conversation. The value is null if 
an agent is not available or if there is no associated queue.

waitingTime Average numeric wait time for the queue. The value is null if an agent is not 
available.

Deflection topic block

Use the deflection topic block in Virtual Agent  conversation topics to track the issues that Virtual 
Agent  helped to resolve or actually resolved for a user.

For example, the pre-built Auto Resolution Virtual Agent  topic uses a deflection topic block 
to track deflections. For more information, see Tracking deflections in Virtual Agent using the 
deflection topic block.

The following table lists the input parameters for this topic block.

Deflection input parameters

Parameter Description

Deflection 
Configuration

Group of deflection patterns.

Deflection 
Pattern

Deflection pattern in the deflection configuration that you have chosen.

Activity Table Table where the deflection activity occurs. This table is associated with 
the primary activity table. For more information, see Create deflection 
configurations and patterns.
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Deflection input parameters  (continued)

Parameter Description

Activity Ids
List of comma-separated activity system IDs. For example, incident ID or task ID. 
You can also add output from the AI Search  or Contextual Search topic block to 
create a link between a deflection occurrence and the content that contributed 
to the same deflection.

FAQ Conversation Builder topic block

Use this topic block to build bot conversations that use your existing FAQ content. With this topic 
block, you can enable topic authors to build simple conversations by using existing knowledge 
articles  that are published in the FAQ template or by using Q&A data that was imported from 
sources such as spreadsheets .

The FAQ Conversation Builder topic block uses contextual search  to find an appropriate match 
in the FAQ content. FAQ content is access-controlled based on requester role, access rights, and 
context.

Activate the Knowledge Management Advanced  plugin to use the FAQ Knowledge template.

Note: 
The default length of an FAQ snippet that is returned in the conversation is 
400 characters. The snippet length includes the HTML tags and links that are 
used in the snippet. To change the snippet length, change the value in the 
com.glide.cs.faq.display_size  system property. In addition to applying the 
specified length, the system applies word-wrap logic to prevent words and links in the 
snippet from being truncated arbitrarily.

The following tables list the input and output parameters for this topic block.

FAQ Conversation Builder input parameters

Parameter Description

query Search term or phrase that is passed to the topic block. 
Select Input Variables  or Script Variables.

portal Context for the search. Select Input Variables  or Script 
Variables.

kb_knowledge Knowledge base for the search. Select Input Variables  or 
Script Variables.

FAQ Conversation Builder output parameters

Parameter Description

Results_Returned Boolean value that indicates whether any results were 
returned from the query.

Results_Helpful Boolean value that indicates whether the user found the 
results helpful.
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Form Content Popup topic block

Use this topic block to open a form in a popup window from the web client. Once the user 
submits the required information, the record appears as a card in the Virtual Agent  chat window. 
If a new record is created, the sys ID for that record is sent to the server so that the Virtual Agent 
topic has that information. For information about creating a pop-up window from a link, see 
Create a smart link preference.

Form Content Popup topic block input parameters

Parameter Description

sysId Sys ID of the record you want to display from the table specified in the table 
parameter. If you don't want a specific record, enter -1to create a new record.

table Name of the table you want to query or create a record in.

view Name of a view that you created for the table. If not specified, the default view is 
used.

Geolocation topic block

Use this topic block to retrieve information about the location of users, if the users agree to that. 
Before the topic block is called in a conversation, the users are asked if they want their location 
to be known. For example, the users see a prompt similar to the following:

User permission prompt

Users can choose to block the request or allow their location to be known. If the users click 
Allow, they are later asked if they would like to share their location, as shown in the following 
example:
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Use of Geolocation in a chat

The following tables list the input and output parameters for this topic block.

Geolocation input parameters

Parameter Description

permissionPrompt (String) Text asking permission to use the user's location. This text is 
shown to the user.

isGeoPermissionGrantedForNextUseBoolean value that determines if users have granted 
permission to retrieve their location coordinates if this 
request is asked more than once during the conversation. 
The variable can be set as follows:

• True: Don't display permission prompt again because the 
user has granted permission on this device.

• False: Display the permission prompt because the 
user has either denied permission or has allowed the 
coordinates to be retrieved one time only.

Geolocation output parameters

Parameter Description

Latitude Latitude coordinates.

Longitude Longitude coordinates.

errormessage Message that is associated with the error if there are any 
errors.
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Geolocation output parameters  (continued)

Parameter Description

errortype Variable that is returned from the topic block. Types of errors 
include:

• PERMISSION_DENIED

• POSITION_UNAVAILABLE

• TIMED_OUT

• UNKNOWN_ERROR

status Variable that is returned from the topic block. The status can 
be:

• OK: Location coordinates were retrieved successfully.

• ERROR: Retrieval was unsuccessful.

Pause topic block

Use this topic block to create a pause to control the pacing of a conversation. To end users, this 
feedback is seamless and is displayed as a typing indicator.

For example, if the chat generated a list of knowledge base links, you may want to add a delay 
before continuing the conversation to give your end user time to read the information.

The Pause topic block appears on the Utilities section of the palette for easier access.

The following table lists the input parameter for this topic block.

Pause input parameter

Parameter Description

Seconds Number of seconds to wait before continuing the chat. The maximum value allowed 
is 60 seconds.

If the value entered is 30 seconds (the default value) or less, the block should 
unpause in near real time. If the value entered is greater than 30 seconds, expect 
the unpause to occur with a maximum latency of +30 seconds. For example, if you 
set the value to 31 seconds, it could take up to 61 seconds to unpause (at most).

Run AI Search  topic block

Note: 
If you're upgrading from Rome  or a prior release, you must replace the legacy AI Search 
topic block with the Run AI Search  topic block in order for it to work.

Use this topic block to generate AI Search  results in a conversation. This block doesn't 
require specific input parameters from a calling topic because it is controlled by the AI 
Search  application in Virtual Agent. The default Virtual Agent  Search Application and EVAM 
configuration set in the chat experience  control how AI Search  results are displayed in 
conversations.
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For information about how Virtual Agent  uses AI Search, see Improving the user experience with 
AI Search. To learn more about Virtual Agent  chat experiences and how to configure them, see 
Setting up chat experiences for Virtual Agent users.

You can control certain aspects of the Run AI Search  topic block:

• Optionally customize the AI Search  experience - You can customize the search experience 
by creating a custom Search Application Configuration to be used by the topic block, rather 
than the default Virtual Agent  Search Application Configuration. The Search Application 
Configuration defines the search results returned in the conversation. For details on using a 
custom Search Application Configuration in the topic block, see Create a custom AI Search 
experience for Virtual Agent conversations.

To use the default Virtual Agent  configuration for AI Search, leave the Search Application 
Configuration  field empty in the Topic Block Properties sheet when you're adding the Run AI 
Search  topic block to a topic.

• Specify an AI Search  flow action timeout value - The AI Search  flow action in 
the topic block automatically times out at 10 seconds. You can change the 
length of time before this flow action times out by adding the system property
com.glide.cs.fdih.atlassearch.timeout  and setting these fields to change the 
timeout value:

System property fields for com.glide.cs.fdih.atlassearch.timeout

Field Value

Name Enter the system property name: 
com.glide.cs.fdih.atlassearch.timeout

Description Enter an explanation for this property: AI Search action 
timeout (in seconds)

Type Select integer.

Value
Enter the number of seconds before the AI Search  action 
times out. The default value is 10 seconds.

The following tables list the input and output parameters for this topic block. For the output 
parameters, you have the option to deactivate any of the variables returned by the topic block.

Run AI Search  input parameters

Parameter Description

search_term Phrase entered by a user during the conversation.

Run AI Search output parameters

Parameter Description

genius_results Variable that identifies the Genius Results returned.

search_results Variable that identifies the regular search results (multi-list 
output) returned.
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Run AI Search output parameters  (continued)

Parameter Description

search_metadata Variable that identifies the search result metadata used for 
click metrics in Conversational Analytics, such as the search 
term used, query language, and more.

Runtime Language Detection topic block

Use this topic block to detect the user’s language during a conversation and switch to that 
language mid-conversation if the language is supported in the ServiceNow AI Platform.

For example, in conversations where guest users are interacting with the bot in a language 
different from the current conversation language, you can use this topic block to change the 
language accordingly. This topic block enables your bot to:

• Detect the language in conversations across all supported Virtual Agent  channels.

• Determine if the language is supported in the ServiceNow AI Platform, and if so, ask the user 
whether to switch to the detected language.

• Switch to the detected language during the conversation if the user agrees to the switch.

Activate the Virtual Agent Language Detection and Translation plugin 
[com.glide.cs.runtime_language_detection_translation] to use this topic block.

The following table lists the input parameters for this topic block.

Runtime Language Detection input parameters

Parameter Description

utterance (String) Text entered by the user.

Change language (Boolean) Option that displays a message to the user 
that does the following:

• Indicates the bot has detected that the user 
is typing in a different language.

• Asks whether to continue the conversation 
in the supported language. If the user 
responds yes, the conversation changes to 
the supported language.

Using geolocation in Virtual Agent

Topic authors can include a pre-built topic block called Geolocation in conversations with 
users. The Geolocation topic block retrieves the latitude and longitude coordinates of the user's 
location.

Topic authors can add this topic block to larger conversation flows. With the user's permission, 
the topic block retrieves the user's latitude and longitude location coordinates. Knowing these 
coordinates can help topic authors respond to customer requests or issues faster and more 
efficiently.

For example, you may need to send a technician to a customer site to resolve an incident. To 
quickly respond to the customer, you need to know which technicians are located nearby so you 
can dispatch the appropriate technician for the customer's location.
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For general information about how geolocation is used on the ServiceNow  platform, see 
Geolocation.

Share location details
The first time a user, such as a field technician, uses the Geolocation topic block in a 
conversation, they are asked if they would like to share details about their location.

Geolocation topic block flow

User 
choice

Topic block response

Yes The topic block sends the user's latitude and longitude coordinates from the server to 
the user's device.

If users want to allow the ServiceNow  instance to access their location, users may then 
see operating system-specific or browser-specific prompts. Examples of such prompts 
include the following:

• Allow (always)

• Allow (one time only)

• Block (don't allow)

Depending on the user's response, they may see this prompt one or more times, or they 
may never see it.

No The topic block does not retrieve user coordinates and displays a relevant error 
message for the topic author to resolve. The error is logged as an output parameter. For 
details, see Geolocation topic block parameters.

Modify the Geolocation topic block

If you are a topic author or an admin, you can modify the Geolocation topic block flow, as 
applicable. Simply duplicate the topic block and rename it. You can then use it as needed in the 
larger conversation flow you're designing.

The Geolocation topic block properties sheet lets topic authors specify the input and output 
mappings. You can also customize the prompt using data pills or scripts. For example, you can 
include an explanation or reason for asking the question. For information about using data pills 
and scripts, see Virtual Agent Designer controls.

Share location prompt in the Geolocation topic block properties
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Use the input mappings to customize how Virtual Agent  asks users for permission to share their 
location. The response is passed to the topic block.

Use the output mappings to specify the variables that are returned from the topic block in the 
conversation.

Output mapping properties in the Geolocation topic block

All the variables are selected by default. Keep the default choices, or select the variables you 
want returned from the topic block. At a minimum, you should select the latitude and longitude 
coordinates. However, error messages, error type, and status details could be useful when 
resolving problems. The output mappings you select are stored as variables on the server.

Geolocation topic block results

For more information about the Geolocation topic block properties, see Geolocation topic block 
parameters.

Customizing Virtual Agent  with custom controls

Custom controls are components that ServiceNow®  developers can create for use in Virtual 
Agent  topics or topic blocks. Such controls include sliders or video players. Custom controls 
complement the controls provided in Virtual Agent Designer.

Virtual Agent Designer  provides a default set of controls that represent user inputs, bot 
responses, and utilities  for building a Virtual Agent  conversation. As a developer, you can use 
Virtual Agent Designer  to create additional controls (interface components) for specific inputs or 
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output responses. For example, a slider is an example of a custom input control that enables end 
users to select a quantity.

Note: 
Custom controls do not work on Internet Explorer version 11. Custom controls are also not 
supported for Microsoft Teams.

Before building a custom control

Custom controls are based on customizable Next Experience Components  that you can create 
by using the Next Experience Design System.

Before building a custom component, you must have the following:

• Basic knowledge of the ServiceNow AI Platform®  and application table structures.

• General knowledge of web component concepts, development, and design.

• JavaScript knowledge to define component behavior and that of the custom control.

• Knowledge of the design process for creating custom components for use in Virtual Agent 
Designer.

To learn more about developing custom components for Virtual Agent, see Develop a component 
for Virtual Agent .

How custom controls work

To add your custom control to Virtual Agent, follow these main steps:

1. Create a custom control definition.

After building the custom component to be used for the control, create a custom control 
definition that maps an input or response control to the custom component.

2. Create a custom control using Virtual Agent Designer.

A custom control is an input or response control. Developers build a custom control in Virtual 
Agent Designer  by doing the following:

◦ Selecting a custom control definition.

◦ Defining the input parameters for using the control.

◦ Specifying the output parameters returned by the control.

An input control has callbacks that use input from the end user. A response control typically 
presents information to the end user and doesn't have callbacks.

3. Add a custom control to a topic or topic block.

Topic authors, virtual agent admins, or admins can add a custom control utility to a topic or 
topic block.

Secure inputs

Beginning with the San Diego  release, you can create custom input controls that can accept 
secure inputs, such as passwords, to pass through to Integration Hub  actions or subflows. To 
enable this, slide the Make inputs secure  toggle switch when you create your custom input 
control. For more information, see Create a Virtual Agent custom control.
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Create a custom control definition

Define a custom input or response control definition that maps to a custom component.

Before you begin
A custom control definition needs a custom component. For example, a slider input control uses 
a custom slider component. To begin, create the customizable component that you will use for 
your control.

Role required: virtual_agent_admin or admin

About this task
For a given custom control, create a separate control definition for each channel in which the 
control will be used.

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Custom Control Definitions.

2. Click New.

3. On the form, fill in the fields.

Custom Control form

Field Description

Name Name of the custom control to be created.

Type Type of custom control. Choices are as follows:

◦ Input

◦ Response

Domain Domain in which this control is used.

4. Click Submit.

5. Open the custom control record that you just created.

6. In the Custom Control Definitions related list, click New.

7. On the form, fill in the fields.

Custom Control Definition form

Field Descrlption

Channel
Channels in which your control can be used. The channel is a chat client, such 
as a web client or messaging app, that is supported in Virtual Agent.

If your control can be used in more than one channel, create a Custom Control 
Definition for each channel. If channels are defined, then the custom control 
can only run in the specified channels.

Application Scope that this control belongs to.

UX 
Component 
Definition

List of custom components that are created for use as custom controls in 
Virtual Agent.
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Field Descrlption

Choose an optional component for your custom control.

Domain Domain where this control is used.

8. Click Submit.

Result
The custom control definition is available for use. You can specify it when you create the 
appropriate control in Virtual Agent Designer.

What to do next
Create the custom control  in Virtual Agent Designer.

Create a Virtual Agent  custom control

Build a custom input or response control that topic authors can use in topics or topic blocks. 
In Virtual Agent  conversations, an input control gathers information from end users, while a 
response control displays information to end users.

Before you begin
Create the custom control definition.

Important: 
To implement secure (password2) inputs in your Virtual Agent  custom control, you must 
adhere to the scoped application requirements in Flow Designer. For details, see Flow 
Designer scoped application requirements for secure inputs.

Tip: 
Developers and topic authors may need to access custom controls created in other 
application scopes. To give them access, see Create cross-scope access privileges for 
topic blocks and custom controls.

Role required: virtual_agent_admin or admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer.

2. In the Topics page, click + Create.

3. On the form, fill in the fields.

Properties form

Field Description

Type
List of objects that you can create in Virtual Agent Designer.

Choose the type of custom control:

◦ Custom Input Control

◦ Custom Response Control

Name Unique name for the custom control that reflects its purpose.

Description Brief explanation of the purpose and functionality of the control.
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Field Description

Advanced properties (optional)

Make inputs secure

[Custom input controls only]

Enable Toggle switch that lets a custom input control pass secure inputs, such as 
passwords.

Available on the palette

Enable Toggle switch that determines whether the custom control appears as its own 
icon in the Utilities section of the palette on the Flow  tab. This provides easy 
access to the control for other authors.

Additional

Categories List of categories. Categories identify and group related topics, topic blocks, or 
custom controls. If applicable, choose a category for your control.

4. Click Create.
The Flow  tab opens and displays an initial flow that contains a custom control node.

5. Click the Start  node and define the input parameters to the control.
Topic authors will provide these input parameters and values from the calling topic.

a. Click + Add.

b. On the form, fill in the fields.

Add input dialog box

Field Description

Name Name of the input variable that stores the input value.

Type Type of data being passed to the topic block. For example, String, 
Boolean, and so on.

The fields change according to your choice. For more information, see 
Input data types in Virtual Agent topics.

Required Option to set the parameter as required.

Hint Tooltip that is visible when authoring a calling topic. See the following 
example:

Table ServiceNow  table that is used to query for input.

This field is available only when Reference  or Array.Reference  is selected 
from the Type  field.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1932



Field Description

Max Number 
of Rows

Maximum number of rows that the topic block is allowed to define.

This field is available only when Array  is selected from the Type  field.

Default Value Default value for the variable. This value can be used when previewing the 
block.

Duplicate default values are not allowed for array data types.

c. Click Save.

d. Repeat these steps for additional parameters.

6. Click the End  node and define the output parameters and values returned from the custom 
control.
Topic authors can use the output value in the calling topic.

a. Click + Add New.

b. Enter the name and value of the parameter.

c. Repeat these steps for additional parameters.

d. Click Save.

7. Click the custom control node and complete the property sheet as follows:

◦ For a custom input control, fill in the Custom input properties sheet.

◦ For a secure custom input control, fill in the Secure custom input properties sheet.

◦ For a custom response control, fill in the Custom output properties sheet.

8. To create the control, click Save  and then Publish.

Result
If you selected Available on the palette  in the Properties page, the Custom Control icon displays 
as its own icon in the Utilities section of the palette. The control is listed on the Topics page, and 
you can use the Type menu to show only custom controls.

What to do next
Add a custom control to a Virtual Agent topic or topic block.

Add a custom control to a Virtual Agent  topic or topic block

Add a custom control to a Virtual Agent  topic or topic block. During the conversation, you can 
gather inputs from the user or display outputs to the user.

Before you begin
Do the following before you start this task:

• Create and publish the custom input or response control.

• Create a calling topic or topic block in which the custom control will be embedded.

Role required: virtual_agent_admin or admin
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Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer.

2. In the Topics page, click the topic or topic block where you will add the custom control.

3. In the Flow  tab, drag the Custom Control icon from the Utilities section of the palette to the 
appropriate position in the topic flow.

Note: 
If you selected Available on the palette  in the custom control Properties page, the 
Custom Control displays as its own icon in the Utilities section of the palette.

4. Click the custom control node.

5. On the form, fill in the fields.

Custom control utility properties sheet

Property Description

Custom 
control The name of a custom control object that has been published in Virtual Agent 

Designer.

Node name
The name of the custom control you selected.

Input 
mapping The variables to be used as input to the selected custom control. For 

example, the following image has example variables:

The contents of this area change according to the custom control you 
selected. Options may include string input, referenced records, scripts, and 
so forth.

Output 
mapping The variables to be output by the selected custom control. For example, the 

following image has example variables that are enabled:
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Property Description

The contents of this area change according to the custom control you 
selected.

Advanced

Hide this node

Conditionally 
use this node 
if

A no-code condition statement or low-code script that specifies a condition 
for presenting this node in the conversation. The condition must evaluate to 
true.

6. Click Save.

7. To see how your custom control works in the topic, click Test  in the header bar.
Your topic runs in a chat test window.

8. If no further changes are needed, click Publish  in the Virtual Agent Designer  header bar.

Result
The topic is active. You can deploy it to your Virtual Agent  clients.

Custom input properties sheet

Use this sheet to define a custom input control in Virtual Agent.

Custom input properties sheet

Custom input 
property

Description

Custom 
Control 
Definition

List of custom control definitions for the controls.

Select the definition that defines how the control is rendered for the channel in 
which it runs. If you need to add a custom control definition, click the Custom 
control definitions  link.

Generate 
Control Data 
Function

Script function that provides the data used to render the custom control.

For example, if you're creating a slider input control, you would define the values 
for the slider. These values include the slider minimum and maximum values, 
slide default values, icon used in the slider, and so on.

Transcript 
Function

Script function that provides the message recorded in the transcript.
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Custom input 
property

Description

For example, a message for an input control could confirm that the control is 
rendered with specific data values.

Response 
Handler 
Function

Script function that defines how the input response is handled on the 
conversation server.

Response 
Transcript 
Function

Script function that provides the message for the input control response that is 
recorded in the conversation transcript.

Non-
supported 
channel 
response 
message

Default fallback message that is displayed when a user is running the control on 
an unsupported channel.

Advanced (optional)

Hide or skip this node

Conditionally 
show this 
node if

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.

Allow user 
to skip this 
node if

No-code condition statement or low-code script that specifies a condition 
for letting users skip this node in the conversation. The condition must 
evaluate to true. You can set this field using either the condition builder or 
a script. When this field is active, the node presents the user with a Skip 
option in the Virtual Agent conversation. Alternatively, in an LLM topic, you 
can reply with an utterance such as I want to skip this question. 

Secure custom input properties sheet

Use this sheet to specify secure inputs, such as a password, in a custom input control in Virtual 
Agent.

Important: 
To implement secure (password2) inputs in your Virtual Agent  custom control, you must 
adhere to the scoped application requirements in Flow Designer. For details, see Flow 
Designer scoped application requirements for secure inputs.
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Secure custom input properties sheet

Secure 
custom input 
property

Description

Custom 
Control 
Definition

List of custom control definitions for the controls.

Select the definition that defines how the control is rendered for the channel in 
which it runs.

Generate 
Control Data 
Function

Script function that provides the data used to render the custom control.

For example, if you're asking for one or more passwords, you would define the 
values for each password.

Transcript 
Function

Script function that provides the message recorded in the transcript.

For example, a message for an input control could confirm that the control is 
rendered with specific data values.

Non-
supported 
channel 
response 
message

Default fallback message that is displayed when a user is running the control on 
an unsupported channel.

Invoke Flow 
Designer 
object

The Flow Designer  action or subflow that secure inputs from the custom control 
can be passed into.

For more information about Flow Designer  actions and subflows, see Actions
and Subflows .

Spoke
Name of the scoped application that contains Flow Designer  content that is 
dedicated to a particular application or record type.

For a list of default spokes, see Spokes .

Action / 
Subflow The Flow Designer  action or subflow to be performed in the instance. The Input 

mapping  and Output mapping  areas change depending on your selection.

For details about the action or subflow, click the link beneath your selection to 
view it in Flow Designer.

Input 
mapping

Specifies the variables to be used as input to the selected action. The check 
boxes for secure fields (password2 type) are selected automatically, which 
makes them mandatory. If you select the check box for a String field, it will be 
mandatory, but not secure. Only fields that use the password2 data type are 
secure.

For each selected field, provide the corresponding input response variable 
name that is specified in the action or subflow. For example, a Flow Designer 
action contains an oldPassword  input and a newPassword  input. The input 
response object looks like this:
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Secure 
custom input 
property

Description

{
   “old_password”: “1234”,
   “new_password”: “5678”
} 

In this example, enter old_password  for the oldPassword  property, and 
then enter new_password  for the newPassword  property.

Output 
mapping

Specifies the variables to be output by the selected action. The contents of this 
area change according to the action you selected.

Advanced (optional)

Permissions

Run as
Permissions to use for the action. Select one of the following options:

• User who initiates session: When selected, the action runs using the same 
permissions that the current user has.

• System User: When selected, the action runs using system privileges, some 
of which may be unavailable to the current user.

Hide or skip this node

Conditionally 
show this 
node if

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.

Allow user 
to skip this 
node if

No-code condition statement or low-code script that specifies a condition 
for letting users skip this node in the conversation. The condition must 
evaluate to true. You can set this field using either the condition builder or 
a script. When this field is active, the node presents the user with a Skip 
option in the Virtual Agent conversation. Alternatively, in an LLM topic, you 
can reply with an utterance such as I want to skip this question. 

Related topics

Flow Designer Actions

Flow Designer Subflows

Password (2 Way Encrypted) design considerations

Custom output properties sheet

Use this sheet to define a custom response control in Virtual Agent.
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Custom output properties sheet

Custom 
response 
property

Description

Custom 
Control 
Definition

List of custom control definitions for the controls.

Select the definition that defines how the control is rendered for the channel 
in which it runs.

Generate 
Control Data 
Function

Script function that provides the data used to render the custom control.

For example, if you're creating a slider input control, you would define the 
values for the slider. These values include the slider minimum and maximum 
values, slide default values, icon used in the slider, and so on.

Transcript 
Function

Script function that provides the message recorded in the transcript.

For example, a message for an input control could confirm that the control is 
rendered with specific data values.

Non-supported 
channel 
response 
message

Default fallback message that is displayed when a user is running the control 
on an unsupported channel.

Advanced (optional)

Hide this node

Conditionally 
show this node 
if

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.

Integrating Virtual Agent  with Flow Designer  workflows

The conversation workflows of ServiceNow®  Virtual Agent  can be integrated with those of the 
ServiceNow  Flow Designer. You can then use these workflows in Virtual Agent  conversations.

You can integrate Flow Designer  actions and subflows as follows:

• Add the actions or subflows to Virtual Agent  conversations.

• Use actions created for another product in Virtual Agent  conversations.

• Create conversations that call workflows directly in the conversation. For example, users can 
place catalog requests, create incidents, or input information securely.

In Virtual Agent  conversations, you can use actions to trigger workflows that are custom-built in 
an application (such as Flow Designer) or workflows of the third-party applications and products 
available in the Integration Hub. Integrations built using Flow Designer  and Integration Hub  help 
to ensure a high level of resiliency and performance.

If an action in the workflow is slow to respond or appears to be waiting, topic authors see a 
relevant error message.

By default, a scheduled job checks the conversation flow every 120 seconds. For more 
information about scheduled jobs, see Scheduled jobs .
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You can change this interval as needed. To change the interval, see Specify the action workflow 
timeout.

Integrate workflows of third-party products available on the IntegrationHub

You can use the Integration Hub  to create end-to-end digital workflows and automate processes 
that integrate the ServiceNow AI Platform®  with any third-party application, platform, or data.

For example, you can use one of the 100 pre-built spokes available on the ServiceNow Store . 
These pre-built spokes include those for popular applications, such as Microsoft Azure, Workday, 
and Okta.

For information about the ServiceNow  Integration Hub, see ServiceNow IntegrationHub – natively 
integrate ServiceNow with anything .

Add workflows to topics

Use the Action utility to integrate ServiceNow  Flow Designer  workflows in Virtual Agent  topics. 
The Action node triggers the required Flow Designer  workflows used in the Virtual Agent 
conversation.

Before you begin
Create a Virtual Agent topic, if you don't already have one.

Be familiar with the following features:

• Flow Designer  concepts and tasks. For more information, see Flow Designer .

• Virtual Agent Designer  utilities, such as the Lookup utility, and the Script Action utility.

Use these utilities to control the actions within the Virtual Agent  conversation. For more 
information about these utilities, see Virtual Agent Designer utilities.

• Virtual Agent  controls. You may be asked to enter any of the following:

◦ Text strings

◦ Data pills

◦ Strings with embedded data pills

◦ Scripts that return strings

For more information, see Virtual Agent Designer controls.

Role required: virtual_agent_admin or admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer, and in the Topics 
page, click the topic you want to use.

2. From the Utilities  section of the palette, drag-and-drop the Action utility icon ( ) onto the 
canvas at the appropriate location on the conversation flow.
The Action utility is now a node in the conversation flow, and the Action utility properties panel 
appears.

3. On the form, fill in the fields.
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Action utility properties sheet

Property Description

Node name The name of this Action node.

Invoke Flow 
Designer 
object

Select one of the following Flow Designer  components:

◦ Action: A reusable operation.

◦ Subflow: An automated process that consists of a sequence of reusable 
actions, data inputs, and outputs.

Spoke
Name of the scoped application that contains Flow Designer  content that is 
dedicated to a particular application or record type.

For a list of default spokes, see Spokes .

Action/
Subflow The Flow Designer  action or subflow to be performed in the instance. The 

Input mapping  and Output mapping  areas change depending on your 
selection.

For details about the action, click the link beneath your selection to view it in 
Flow Designer.

Wait for 
response? Toggle switch that determines whether Virtual Agent  waits for a response from 

the specified action before continuing.

Input 
mapping

Specifies the variables to be used as input to the selected action. The 
contents of this area change according to the action you selected. Options 
may include string input, referenced records, scripts, and so forth.

For options that require a password, enable the Include a password input 
toggle switch to prompt the user for a password. Secure inputs must use the 
password2 data type. Input is securely masked and not viewable by others.

Note: 
The Array.Reference  input data type in Virtual Agent Designer 
corresponds to the List.[Table]  input data type in Flow Designer. 
For more information, see Action input and output data types .

Output 
mapping

Specifies the variables to be output by the selected action. The contents of 
this area change according to the action you selected.

Advanced (optional)

Permissions

Run as
Permissions to use for the action. Select one of the following options:

◦ User who initiates session: When selected, the action runs using the same 
permissions that the current user has.

◦ System User: When selected, the action runs using system privileges, some 
of which may be unavailable to the current user.

Hide this node
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Property Description

Conditionally 
show this 
node if

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.

4. Click Save.

Virtual Agent  secure password inputs

The Include a password input  toggle switch on the Action utility properties sheet lets you enter 
passwords securely for use in Virtual Agent  conversations.

If the workflow discovers a password2 type as an input, the Action utility properties sheet 
displays the Include a password input  toggle switch.

Note: 
In previous releases, inputs with a string data type would also display this toggle switch. 
Starting with the San Diego  release, only password2 data types are supported. If you have 
existing actions that use password inputs, update them to use password2.

Input mapping

If you enable this toggle switch, you see messages about clients that are supported, along with 
fields that let you do the following:

• Designate the field you want to make secure

• Enter the text you want to use for the password-related prompt

• Enter the text for a confirmation prompt

• Enter the text to use for messages about channels that aren't secure

Important: 
To implement secure (password2) inputs in your Virtual Agent  custom control, you must 
adhere to the scoped application requirements in Flow Designer. For details, see Flow 
Designer scoped application requirements for secure inputs.
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Password detail fields

These password input type fields are dynamic in the sense that the fields you see map to the 
fields set for the action when it was created in Flow Designer. Some of the password2 fields may 
also be read-only.

For password-related design considerations in Flow Designer, see Password (2 Way Encrypted) 
design considerations  .

Note the following points about how password-related inputs are handled securely:

• Only users can see the passwords. No one else can.

• The passwords are held in memory on the server and are passed securely to the Flow 
Designer  Action or Subflow.

• When users enter a password on a channel, users can toggle the Hide text icon ( ) to show 
or hide the password.

• ServiceNow  admins can mark a specific channel as secure. If topic authors attempt to include 
a channel that isn't marked as secure, a warning message appears.

For more information about creating secure channels, see Create a Virtual Agent 
conversational custom chat integration configuration.

• Passwords are masked (not readable) in queues, tables, and logs.

Flow Designer  scoped application requirements for secure inputs

Adhere to the following scoped application requirements to implement secure (password2) 
inputs in your Virtual Agent  topics.

You can add secure inputs to Virtual Agent  topics in two ways:
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• Create a secure custom input control  that uses a Flow Designer  action or subflow with secure 
(password2 type) inputs.

• Add an Action utility node  to a topic that refers to a Flow Designer  action or subflow that has a 
single password2 field as an input.

The Key Management Framework  (KMF) must be installed and configured for your instance. 
The scoped application that uses the secure fields must also have the following:

• A sys_kmf_crypto_module  record, with a related Symmetric Key Wrapping/Unwrapping 
sys_kmf_module_crypto_spec  record

• A sys_kmf_crypto_caller_policy  record with the following properties:

◦ Policy name: <modify the auto-generated name>

◦ Crypto module: com_glide_cs_glideencrypter

◦ Type: Scope

◦ Target Scope: <your application's scope>

◦ Application: <the name of your scoped application>

◦ Active: true

◦ Result: Track

• A Flow Designer  action or subflow that accepts one or more password2 input fields

• A Script step  in the Flow Designer  action that unwraps the password2/KMF passwords as 
follows:

var op = new
sn_kmf_ns.KMFCryptoOperation("global.com_glide_cs_glideencrypte
r","SYMMETRIC_UNWRAPPING").withAlgorithm("AES").withOutputForma
t("KMFNONE");
var old_pw_clear_data = op.doOperation(inputs.old_pw);
var new_pw_clear_data = op.doOperation(inputs.new_pw);
var new_pw_confirmed_clear_data = 
 op.doOperation(inputs.new_pw_confirmed);

For more information about password2 encryption with KMF, see Password2 encryption with 
KMF .

Test the action workflow

Use this task to make sure that the integrated action workflow completes as intended in the 
conversation.

Before you begin
Role required: virtual_agent_admin or admin

About testing the action workflow

Topic authors can also see the test results in the Conversation Task FDIH Invocations 
[sys_cs_fdih_invocation_list] table.

About this task
When you test the workflow, you will see a test results preview pane that includes preview-only 
messages. These messages include a link called View in Flow Designer. This link takes you to 
the Flow Execution Details report. You can use this report to do the following:
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• View the flow execution details.

• See the results of the action in Flow Designer.

• Verify what is being returned to Virtual Agent.

Note: 
Only topic authors have access to the View in Flow Designer  link. In non-production 
environments, this link is available by default. In production environments, topic authors 
need to enable access to this link by creating a record in the [sys_flow_execution_setting] 
table for each Flow Designer  object. This link is not available in conversations where 
password2 input is used.

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer.

2. In the Topics page, open the topic with the action you want to test.

3. Click Test.
If an action in the test window is slow to respond or appears to be waiting, you will see a 
relevant error message.

By default, a scheduled job checks the conversation flow every 120 seconds. For more 
information about scheduled jobs, see Scheduled jobs .

You can change this interval, as needed. To change the interval, see Specify the action 
workflow timeout.

4. Troubleshoot the Action utility node:

◦ View the flow execution details report.

◦ Look at the Conversation Task FDIH Invocations [sys_cs_fdih_invocation_list] table.

5. Click Save  when you're finished.

Specify the action workflow timeout

Set the length of time before the Flow Designer  Integration Hub  action workflow times out.

Before you begin
Role required: admin

Procedure

1. Navigate to All.

2. Enter sys_properties.list  in the filter.

3. Click New  to add the com.glide.cs.fdih.interactive.timeout  property.

a. On the form, fill in the fields.

Field Value

Name Enter the system property name: 
com.glide.cs.fdih.interactive.timeout.

Description Enter an explanation for this property, such as: Virtual Agent 
Flow Designer IntegrationHub workflow timeout (in 
seconds).
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Field Value

Type Enter integer.

Value Enter the number of seconds before the workflow action times out. The 
default value is 120 seconds.

b. Click Submit.

Using Virtual Agent  with a live agent

Sometimes a conversation requires human intervention. When this occurs, you can transfer the 
user to a live agent in Agent Chat.

Transferring Virtual Agent  conversations to a live agent

Manage live chat support, including the chat support interface used when a Virtual Agent 
conversation is transferred to a live agent.

Note: 
The Glide Virtual Agent  plugin (com.glide.cs.chatbot) automatically activates the Glide 
Conversation Server plugin (com.glide.cs) for chat support.

Conversations in Virtual Agent  are transferred to a live agent in several ways. This transfer 
happens automatically when an unrecoverable error occurs, but it can also be triggered by a 
script in a topic or when a user manually selects that option.

Automatic transfer to a live agent when an error occurs

When a conversation encounters an error, the conversation automatically transfers 
to a live agent.

Note: 
If you don't plan to use Agent Chat, be sure to deactivate it in the Agent Chat 
settings. For more information, see Setting up Agent Chat.

Automatic transfer to a live agent that is triggered by a script in a topic

In situations where you want a support agent to handle the conversation, you can 
create a script in your topic that uses the vaSystem.connectToAgent() 
method. This method triggers a transfer to a live agent. This option can be useful 
for conversations involving negative customer sentiment, high priority requests, or 
requests outside the scope of your topic process. For example:

(function execute() {
    if (vaInputs.urgency == 1 && vaInputs.impact == 3)
        if(vaSystem.isLiveAgentAvailable()) {
           vaSystem.connectToAgent()
        }
    })()
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This script action control transfers the conversation to a live agent 
based on the incident impact and user urgency. The script uses the 
vaSystem.isLiveAgentAvailable()  method as follows:

• In Agent Workspace, the vaSystem.isLiveAgentAvailable()  method 
checks the queue schedule and whether agents are online.

• In Connect Support, the vaSystem.isLiveAgentAvailable()  method 
only checks the queue schedule.

Note: 
The vaSystem.isLiveAgentAvailable()  method only checks 
whether agents are online, regardless of their skill set.

Manual transfer to a live agent using the Contact support option

You can choose the Contact support  option and then select Contact Live Agent  to 
transfer the conversation to a live agent.

Note: 
Users running a Virtual Agent  messaging integration must enter the command 
Hi  or agent  to access the live agent transfer option. If your environment 
isn't configured for live agents, the agent  command doesn't work. For more 
information, see Virtual Agent integration with messaging apps.

Contact Support options in Virtual Agent

How Virtual Agent  conversation transfers work

For a user engaged in a Virtual Agent  conversation, the switch to a live agent is a seamless 
transfer. When a transfer is triggered, either automatically or by a user manually, the conversation 
is automatically routed to the appropriate chat support interface, based on your Agent Chat 
settings. In Agent Chat  settings, admins also define the general messages that users see during 
live agent transfers.

If you're using Agent Workspace, the conversation is automatically routed and assigned to an 
available live agent. If you're using Connect Support, the conversation is routed to the chat 
support queue that you specify.

Note: 
At least one live agent must be available when transferring from Virtual Agent, otherwise the 
end user is presented with a no agents available  message and their conversation 
isn’t transferred.
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Transfer to a live agent in Agent Workspace

If you're using Agent Workspace, the Virtual Agent  conversation is automatically 
transferred to a qualified available agent, based on the Chat service channel 
configuration and the queues that the agent supports, as defined in Advanced Work 
Assignment.

For the user, the conversation with the agent continues in the Virtual Agent  (client) 
interface. In Agent Workspace, the chat assignment appears in the agent's inbox. 
When an agent accepts the assignment, the agent joins the conversation and 
interacts with the user.

Transfer to a live agent in Connect Support

If you're using Connect Support, the virtual agent conversation is routed to the 
appropriate chat support queue. For the user, the conversation with the agent 
continues in the Virtual Agent  client interface. In Connect Support, the agent 
accepts the queue with the transferred user to join the conversation and interact 
with the user.
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In earlier releases, admins used the Chat Setup form to assign the default chat 
queues for Customer Service Management, HR Service Delivery, and IT Service 
Management  or a global queue to which Virtual Agent  conversations were 
automatically routed if default queues weren’t assigned. These queues, which 
admins defined in Connect Support, are stored in the Chat Queues [chat_queue] 
table. If you're using Connect Support as the fulfiller interface and must change chat 
settings, see Setting up Agent Chat  for details.

User sentiment

When configured, user sentiment analysis is performed on Virtual Agent  and 
live agent conversations. The user sentiment is stored in the Interaction Insights 
[sys_cs_interaction_insight] table. For details, see Interaction Insights table.

Closing Virtual Agent  and Agent Chat  conversations

Virtual Agent  and Agent Chat  conversations that are abandoned by requesters remain open 
until they are automatically closed by the scheduled job, Time Out Abandoned VA 
Conversations. This job runs hourly each day.

The default timeout period for abandoned Virtual Agent  and live agent conversations is two 
hours (7200 seconds). The Time Out Abandoned VA Conversations  job runs hourly 
to find and close any conversations that have been open longer than the default (or configured) 
timeout period.

As admins, you can change the default timeout period for closing Virtual 
Agent  and live agent conversations by adding the system property
com.glide.cs.conversation_idle_timeout. The timeout value that you specify in 
this property applies to all conversations in supported Virtual Agent  and live agent channels, 
including chat channels (such as Microsoft Teams, Slack, and Workplace from Facebook) and 
messaging channels (such as SMS). For details, see Change the timeout period for Virtual Agent 
and live agent conversations.

If you're using Virtual Agent  and Agent Chat  on multiple chat channels, you can 
add a channel-level idle timeout value that overrides the timeout value set in the 
com.glide.cs.conversation_idle_timeout  property for chat channels. For details, 
see Override the conversation timeout period by channel.

If needed, you can also change the time at which the Time Out Abandoned VA Conversations job 
runs.

Note: 
If you're using keywords or NLU, you can initiate the Closing Conversation topic with 
phrases tied to the intent (End Conversations) such as Bye  or Exit. If the chat isn't closing 
when you enter an appropriate phrase, the NLU model for the setup topics might not be 
published or assigned.

Change the timeout period for Virtual Agent and live agent conversations

Add the com.glide.cs.conversation_idle_timeout  property to the System Property 
[sys_properties] table to specify the length of time that an abandoned Virtual Agent  or Live Agent 
conversation remains open (idle). When the Time Out Abandoned VA Conversations 
job runs hourly, it closes any Virtual Agent  and Live Agent  conversations that have been open 
longer than the specified time.

1. In the navigation filter, enter sys_properties.list.

2. Click New.
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a. Complete these fields:

Field Value

Name Enter the system property name: 
com.glide.cs.conversation_idle_timeout

Description Enter an explanation for this property: Idle 
timeout period (in seconds) for all 
conversations

Type Select integer.

Value
Enter the number of seconds that abandoned Virtual 
Agent  or Live Agent  conversations remain open, after the 
requester's last response. This value must be less than 
7200 seconds, since the Time Out Abandoned VA 
Conversations  job runs every 3600 seconds (hourly) 
to close idle conversations.

For example, a value of 1800 seconds (30 minutes) 
means that an abandoned conversation remains open 
for 1800 seconds (30 minutes). When the Time Out 
Abandoned VA Conversations  job runs, it closes 
any conversations that have been idle longer than 1800 
seconds.

b. Click Submit.

Override the conversation timeout period by channel

You can set the conversation timeout value for a channel by adding 
a channel-specific conversation timeout value that overrides the 
com.glide.cs.conversation_idle_timeout  property. When the Time Out 
Abandoned VA Conversations  job runs hourly, it closes any Virtual Agent  or Live Agent 
conversations in the channel that have been open longer than the specified time.

1. In the navigation filter, enter sys_cs_channel.list.

2. In the Messaging Channels table, locate the channel record to be changed and double click 
the Conversation Idle Timeout  field.

3. Enter the number of seconds that abandoned Virtual Agent  or Live Agent  conversations 
remain open in the channel, after the requester's last response.

For example, a value of 1800 seconds (30 minutes) means that an abandoned conversation 
in the channel remains open for 1800 seconds (30 minutes). When the Time Out 
Abandoned VA Conversations  job runs, it closes any conversations that have been 
idle longer than 1800 seconds.

4. Save the value.

Change the Time Out Abandoned VA Conversations scheduled job

To change the time that this hourly scheduled job runs or to make other adjustments to the 
scheduled job:
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1. Navigate to All  > System Definition  > Scheduled Jobs  and open the Time Out Abandoned VA 
Conversations record.

2. In the Scheduled Script Execution form, change the Time  at which the scheduled job runs. Or, 
depending on how you want to adjust the timing, change other fields in the form as needed.

For example, to change the interval at which the job runs, in the Run  field, select Periodically. 
You then specify the Repeat Interval  (Days  and Hours) that the job runs and the Starting 
date for the interval. For a description of the other fields that you can change in this form, see 
Automatically run a script of your choosing .

3. Click Update.

The job runs at the specified time and frequency.

Tracking deflections in Virtual Agent  using the deflection topic block

Use the pre-built deflection topic block in ServiceNow®  Virtual Agent  to track the issues that 
Virtual Agent  helped to resolve or actually resolved for a user. Incident deflection patterns and 
metrics can help you optimize and analyze the effectiveness of Virtual Agent.

A deflection occurs when Virtual Agent  automatically redirect users to self-service options 
or knowledge base articles that can help them solve their problems without requiring the 
assistance of a live agent. As a result, the user might not need to create an incident. If necessary, 
however, Virtual Agent  can ask relevant questions and then create an incident in the correct 
assignment group. This workflow becomes more efficient because no live agent has to get 
involved.

The Virtual Agent  deflection tracking is enabled by default, but you must set up the deflection 
configuration and deflection patterns to capture certain deflection metrics. For more information, 
see Create deflection configurations and patterns.

You use deflection configurations to group deflection patterns. A deflection configuration can 
consist of one or more deflection patterns. Deflection patterns categorize Virtual Agent  activities 
in conversations for tracking deflection metrics. For example, let's say that Virtual Agent  adds a 
user to an email list without creating a task in the Task table to complete the workflow. You can 
categorize this activity as a self-resolving deflection pattern.

You can view the deflection metrics for each deflection pattern. A deflection pattern can lead to 
these deflection outcomes in a conversation:

• Confirmed deflection: Virtual Agent  provided a resolution to the user, which prevented the user 
from creating an incident or transferring to a live agent.

• Potential deflection: It is unclear whether Virtual Agent  provided a resolution to the user. An 
example is when search results are displayed to a user in a conversation.

• No deflection: Virtual Agent  did not provide a resolution, and the user created an incident or 
transferred to a live agent.

You can either create new deflection patterns, or use these pre-built deflection patterns in the 
VA Default  deflection configuration:

Deflection pattern Activity Outcome

VA-Search-served Virtual Agent  showed search results 
to the user.

Potential deflection

VA-Triage & Created Virtual Agent  creates an incident in 
the correct assignment group. This 

Confirmed deflection
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Deflection pattern Activity Outcome

action improves the assignment 
accuracy. For example, Virtual Agent 
identifies a reimbursement-related 
intent in a user conversation and 
creates a reimbursement incident 
instead of a general incident.

VA-Self-Resolving Virtual Agent  completes the workflow 
on its own without creating an 
incident. For example, Virtual Agent 
adds a user to a distribution list.

Confirmed deflection

VA-Intercept & Resolved Virtual Agent  intercepts an incident 
that was created by a user and 
provides a resolution to close 
the incident. An example is when 
Incident Auto Resolution resolves an 
incident.

Confirmed deflection

The deflection configuration and deflection pattern that you create in the deflection settings are 
mapped to the deflection topic block. For example, the pre-built Issue Auto Resolution topic uses 
a deflection topic block to track deflections. For more information, see Maximizing code reuse 
with topic blocks  and Virtual Agent platform topic blocks.

The deflection metrics are generated and stored in the Deflection Metric [ssa_deflection_metric] 
table. To view the deflection metrics, navigate to the Deflection Metrics module in the Self-
Service Analytics framework.

Note: 
The Self-Service Analytics framework requires the Self-Service Analytics Core plugin 
(com.snc.self_service_analytics_core). For more information, see Activate Self-Service 
Analytics.

Deflection metrics

You can also view the visualization for deflection metrics in the Overview  tab of the 
Conversational Analytics Dashboard. For more information, see Conversational Analytics 
dashboard.

Create deflection configurations and patterns

Set up deflection settings to create deflection configurations and deflection patterns that you 
can map to deflection topic blocks in Virtual Agent  conversation topics. These deflections help 
you to track the issues that Virtual Agent  helped to resolve or actually resolved for a user.

Before you begin
Review Tracking deflections in Virtual Agent using the deflection topic block.

https://www.youtube.com/watch?
v=YMAaTSzPhwM&list=PLkGSnjw5y2U79gjQuQW-2GBqzEccwFkWH&index=21  Watch this 
video for more information about deflection tracking.
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Note: 
For information about configuring components of the Virtual Agent  Analytics dashboard 
(such as Performance Analytics widgets), see Add and configure components .

Role required: virtual_agent_admin or admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.
The Conversational Interfaces Settings  page opens in a new tab.

2. Navigate to Virtual Agent  > Deflection metrics  > View all.

3. To enable tracking of deflection metrics, turn on the toggle under Activate.

4. To create new Deflection Configurations, click New.

5. In the Create Deflection Configuration form, enter these deflection configuration properties:

Field Description

Name Short and meaningful name for the deflection 
configuration.

Description Short description about the deflection 
configuration.

6. Click Save.
A new Deflection Configuration is created.

7. To add new deflection patterns to a deflection configuration, select the deflection configuration 
in which you want to add the deflection pattern.

8. Click New.

In the Create Deflection Pattern form, enter these deflection pattern properties:

Field Description

Name Short and meaningful name for the deflection 
pattern.

Outcome Result of the deflection in a Virtual Agent 
conversation.

Primary Activity Table Table that is associated with the activity that 
you are categorizing in the deflection pattern. 
For example, if the Virtual Agent  is helping to 
prevent the creation of a task for the activity, 
then you can specify the task table.

Note: 
If you are creating a generic pattern that is used for tracking different deflections, you can 
leave the Primary Activity Table  field empty.

The primary activity table that is associated with each activity helps in calculating the 
deflection rate for a particular business area. For example, if Virtual Agent  resolves 42 VPN 
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issues and overall 100 VPN incidents are created, the deflection rate for VPN issues is 42/142 
or 30 percent.

9. Click Save.

Using Virtual Agent API

Use the ServiceNow®  Virtual Agent  API app to integrate any chat interface or a bot with 
ServiceNow®  Virtual Agent  or Agent Chat. The app is available from the ServiceNow®  Store.

Overview

The Virtual Agent  API is a REST API. This API is built on the conversational custom chat 
integration framework that is provided with Virtual Agent  starting in the Paris  release. The API 
enables ServiceNow  developers, advanced users, and admins to use Virtual Agent  in either of 
the following ways:

Standalone bot

Use Virtual Agent  as a standalone bot that you integrate with enterprise or with any 
other third-party chat interface that supports conversational interfaces.

Your end users can interact with the Virtual Agent  and Agent Chat  through multiple 
channels by using this integration.

Secondary bot

Use Virtual Agent  as a secondary bot in an environment that has multiple, 
specialized bots managed by a primary bot.

In this scenario, a primary bot manages communication with secondary bots on 
behalf of the end user. A primary bot could be IBM Watson Assistant, Microsoft 
LUIS, or a homegrown primary bot.

Your secondary bots, such as the ServiceNow  bot, might handle specific types of 
end-user requests, such as service tickets or reservations.

Bot Interconnect

Use Virtual Agent  Bot Interconnect  as the primary bot in a diverse chat environment. 
Bot Interconnect  creates a unified chat experience and gives your end users access 
to multiple channels and a wide variety of enterprise tasks that are available from 
ServiceNow.

The Virtual Agent  API is useful for creating server-to-server integrations. However, for integrations 
that require the transformation of unsupported controls that must be rendered in your existing 
chat interface, consider using the Custom Chat Integration Framework.

For information about features such as the URL format and the supported request and response 
parameters in the Virtual Agent  API, see Virtual Agent Bot Integration API .

 Augment your experiences with the Virtual Agent API  (Virtual Agent Academy video)

How the Virtual Agent  API works

The following diagram shows how the REST API processes user input from a third-party chat 
interface or a primary bot, and then generates a bot response.

1. The user provides input to a primary bot or third-party chat interface.

2. The bot sends a POST request JSON to the inbound REST endpoint (via scripted REST API).
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3. The ServiceNow AI Platform  authenticates and processes the request, which is sent to Virtual 
Agent  or a live agent.

4. The ServiceNow AI Platform  sends a POST response JSON from the outbound REST endpoint 
(via REST API) back to the bot.

5. The primary bot or third-party chat interfaces displays the response to the user.

Inbound and outbound REST endpoints in the Virtual Agent  API

To see a demonstration of the Virtual Agent  API and an FAQ, see Getting Started with Virtual 
Agent APIs  on the Community site.

Limitations

The Virtual Agent  API does not support the following features:

• Chat branding through this Virtual Agent  API integration

Version and release compatibility

Virtual Agent  API version and release compatibility

Version Compatible Releases

3.10.0 Washington DC

3.9.x Vancouver

3.8.x Vancouver

3.7.x Utah

3.5.x Tokyo

3.0.x San Diego

2.0.x Rome

A subset of features is compatible with Quebec.
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Virtual Agent  API version and release compatibility  (continued)

Version Compatible Releases

1.3.0 Quebec

1.0.12 Quebec

1.0.9 Paris

Note: 
The Virtual Agent  API requires a Pro license similar to that of Virtual Agent.

Virtual Agent  API features

You can use the Virtual Agent  API to integrate many of the same features that are available in 
Virtual Agent  and Agent Chat  into your chat environment. Feature support varies depending on 
your ServiceNow  release and the Store app version number of the API.

For information about the request and response templates for Virtual Agent  API, as well as 
examples of common use cases, see Virtual Agent Bot Integration API .

Key features

The main features in Virtual Agent  API starting with version 1.0.9 include the following:

• Provider authentication using static, hash, and token-based authentication

• Auto-linking user IDs to ServiceNow  accounts for a personalized experience

• Virtual Agent  transfer to a live agent in Agent Chat

• Intent classification in bot-to-bot integrations through the following strategies:

◦ The primary bot determines the user intent and sends the user request to Virtual Agent  so 
that the corresponding topic is displayed to the user.

◦ The primary bot sends the user utterance to Virtual Agent  so that it can discover the intent 
and return a prediction confidence score. A higher confidence score indicates that the 
predicted topic more accurately matches the user utterance.

Version 1.0.12 features

Automatically close idle bot-to-bot conversations

You can automatically close conversations that have been idle for more than one 
hour. The Time Out Abandoned B2B Conversations  job runs hourly each 
day and automatically closes idle conversations that requesters have abandoned.

Conversation states and reason codes in Virtual Agent interaction records

When a user or primary bot ends a conversation, Virtual Agent  records the state and 
reason codes in the interaction records. For example, an end user can type End  to 
stop the conversation or click the X  button to close the chat.

Notifying when a conversation ends

The primary bot is notified when Virtual Agent  or Agent Chat  conversations end. The 
primary bot is also notified when it must take control of a conversation. Virtual Agent 
uses the following flags:

• completed: Sent when the conversation with Virtual Agent  or a live agent is 
finished.

• takeControl: Sent when the primary bot must take control. This 
typically occurs when Virtual Agent  can't determine the conversation 
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intent after two consecutive attempts (the default value). You can add the 
va.bot.to.bot.take.control_times  system property to change the 
default number of attempts that Virtual Agent  tries to determine the conversation 
intent.

For more information, see Virtual Agent Bot Integration API .

Changes with intents

• Share the NLU confidence score for an intent match if NLU is enabled in Virtual 
Agent.

• Enable end users to jump directly into a topic based on intent matching by the 
primary bot.

Version 1.3.0 features

Starting with version 1.3.0, Virtual Agent  API supports logging as a system property 
(va.bot.to.bot.logging_enabled).

Virtual Agent  API features available in Store release 2.0.x

Virtual Agent  API version 2.0.x provides access to more of the same features that are available in 
Virtual Agent  and Agent Chat, including rich control support and notifications.

Support for additional rich controls

Virtual Agent  API now supports the following rich controls.

Boolean controls

Boolean controls return responses as strings (either Yes  or No) for easier 
localization.

For more information about topic localization, see Localizing Virtual Agent 
conversations.

Virtual Agent  API sends the following example JSON for a boolean control:

{
  "requestId": "asd2423-wrr434-weruyt-1234567",
  "clientSessionId": "",
  "nowSessionId": "",
  "message": {
    "text": "7a36412253a13010ff59ddeeff7b12fb",
    "typed": false,
    "clientMessageId": "ABC-123"
  },
  "userId": "beth.anglin",
  "body": [
    {
      "uiType": "Boolean",
      "group": "DefaultPicker",
      "required": true,
      "nluTextEnabled": false,
      "label": "Sample Response for boolean control",
      "options": [
        {
          "label": "Yes"
        },
        {
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          "label": "No"
        }
      ]
    }
  ],
  "score": 1
}

Custom controls

Topics that use custom controls are now supported. For more information about 
custom controls, see Customizing Virtual Agent with custom controls.

Table bot response controls

Topics that use table bot response controls are now supported. For more 
information, see Table bot response control.

All records are returned from Virtual Agent  API at once. Virtual Agent  will 
wait for a response from the API client to send the next control. Use the 
paginationBreak  property to display records in chunks to the user. For 
example, if paginationBreak  is set to 10, the user will see 10 records at a time. 
When the client is ready to move to the next control, it should send DONE.

Virtual Agent  API sends the following example JSON for a table bot response 
control:

{
  "requestId": "asd2423-wrr434-weruyt-1234567",
  "clientSessionId": "",
  "nowSessionId": "",
  "message": {
    "text": "Yes",
    "typed": false,
    "clientMessageId": "ABC-123"
  },
  "userId": "beth.anglin",
  "body": [
    {
      "uiType": "OutputTable",
      "group": "DefaultOutputTable",
      "label": "Sample Table Rich control",
      "headers": [
        "Number",
        "Short description"
      ],
      "data": [
        [
          "INC0000005",
          "CPU load high for over 10 minutes"
        ],
        [
          "INC0000015",
          "I can't launch my VPN client since the last 
 software update"
        ],
        [
          "INC0000025",
          "Need to add more memory to laptop"
        ],
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        [
          "INC0000035",
          "Reset my password"
        ],
        [
          "INC0000055",
          "SAP Sales app is not accessible"
        ],
        [
          "INC0009005",
          "Email server is down."
        ]
      ],
      "paginationBreak": 10,
      "totalSearchResultsCount": 6,
      "navigationBtnLabel": "Click for more"
    }
  ],
  "score": 1
}

HTML bot response controls

Topics that use HTML bot response controls are now supported. For more 
information, see HTML bot response control.

Virtual Agent  API sends the following example JSON for an HTML bot response 
control:

{
  "requestId": "asd2423-wrr434-weruyt-1234567",
  "clientSessionId": "",
  "nowSessionId": "",
  "message": {
    "text": "Yes",
    "typed": false,
    "clientMessageId": "ABC-123"
  },
  "userId": "beth.anglin",
  "body": [
    {
      "uiType": "OutputHtml",
      "group": "DefaultOutputHtml",
      "style": "inline",
      "height": 100,
      "width": 100,
      "value": "<html> <body> Sample Response for Html 
 control </body> </html> ",
      "imageUrl": null,
      "imageHeight": 0,
      "imageWidth": 0,
      "links": null
    },
    {
      "uiType": "InputText",
      "group": "DefaultText",
      "required": true,
      "nluTextEnabled": false,
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      "label": "some text",
      "maskType": "NONE"
    }
  ],
  "score": 1
}

Multi-response bot response controls

Topics that use multi-response bot response controls are now supported. For more 
information, see Multi-response bot response control.

Virtual Agent  API sends the following example JSON for a multi-response bot 
response control:

{
  "requestId": "asd2423-wrr434-weruyt-1234567",
  "clientSessionId": "",
  "nowSessionId": "",
  "message": {
    "text": "Done",
    "typed": false,
    "clientMessageId": "ABC-123"
  },
  "userId": "beth.anglin",
  "body": [
    {
      "uiType": "MultiPartOutput",
      "group": "DefaultMultiPartOutput",
      "navigationBtnLabel": "Click for more",
      "content": {
        "uiType": "OutputText",
        "value": "Text response from multiflow control 
 example",
        "maskType": "NONE"
      }
    }
  ],
  "score": 1
}

Rich text support

Topics that use rich text are now supported. Rich text includes bold or italicized text, 
hyperlinks, bulleted lists, and emojis.

Additional Agent Chat  features

The Virtual Agent  API now supports the following features when transferring to Agent Chat.

Pass agent name and avatar

When the primary bot transfers a chat to a live agent, Virtual Agent  can send the 
agent name and avatar to the primary bot. To enable this, activate Agent names and 
avatars  in Agent Chat settings.

An example message payload might look like this:

{
"requestId":"f42f3550-5b44-4cde-aa52-9b6756b3131c",
"clientSessionId":"U94CSJLEN",
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"message":{
"text":"Live Agent support.",
"typed":true
},
"userId":"U94CSJLEN",
"body":[
{
"uiType":"OutputText",
"group":"DefaultText",
"agentInfo":{
"sentFromAgent":true,
"agentName":"Beth Anglin",
"agentAvatar":"ee4eebf30a0004d963b5c5ac0d734dc4.iix?t=s
mall"
},
"value":"Thank you for contacting support. I am looking 
 into your question now and will be with you shortly."
}
],
"agentChat":true,
"score":1
}

For more information, see Configure Agent Chat.

Live agent wait time

When transferring to a live agent, the primary bot can receive the wait time and 
display this to the user. To enable this, select Wait Time  in the Live chat wait status 
field in Agent Chat settings. The spinnerType  value is set to wait_time. If the 
Live chat wait status  is set to None, the spinnerType  value is none.

Virtual Agent  API sends the following example JSON in the body  parameter of the 
payload.

{
"uiType":"ActionMsg",
"actionType":"StartSpinner",
"spinnerType":"wait_time",
"message":"Routing you to a live agent...",
"waitTime":"8 Seconds"
}

For more information, see Configure Agent Chat.

Send chat history from the primary bot to Virtual Agent

The primary bot can pass chat history to a live agent so that the agent can see the 
context of the conversation.

Virtual Agent  converts the message history to HTML and then to an image.

• The converted image is sent to the live agent as the first message of the chat.

• The primary bot should send the message history in the first request. In any other 
request after the first request, the message history payload will be ignored.

• Only text messages are supported.

• The primary bot can pass any URL as a value in the text message, but the live 
agent can only view it as part of the image. The live agent will not be able to click 
the link.
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Example message payload:

{ 
   "value": "Help me with password reset", 
   "displayName": "able", 
   "type": "text" 
   "isBotMessage": false, 
  } 

Note: 
In the previous example, type  is case sensitive and should have a value of 
text.

Enriched requests from the primary bot

The Virtual Agent  API now supports the following requests from the primary bot.

System parameters and context variables

The primary bot can pass system parameters and context variables as input, 
and Virtual Agent  will honor these  parameters. System parameters such as 
liveagent_devicetype, liveagent_requester_session_language, 
liveagent_topic, topic, live_agent_only, and 
liveagent_devicetimezone  are supported. Custom context variables and 
Agent Chat  context variables are also supported.

Example message payload:

{ 
"requestId": "f42f3550-5b44-4cde-aa52-xxxxxxxxxx", 
"clientSessionId": "xxxxxxxxxx", 
"token": "abcd", 
"message": { 
  "text": "Test", 
  "typed": true 
}, 
"contextVariables": { 
   "requester_session_language": "es" 
}, 
"userId": ""abel.tuter", 
"emailId": "abel.tuter@example.com" 
} 

For more information, see Live agent chat context variables  and Configure context 
variables for storing chat-related information.

User timezone

Set the user’s timezone by passing it in the request payload. Once set, that 
timezone setting is retained until it is reset.

Example message payload:

{ 
 
  "requestId": "xxxxxx-xxxxxx-xxxx-xxxx-xxxxxxxxxx", 
  "clientSessionId": "xxxxxxxx-xxxx", 
  "token": "xxxxx", 
   "action" : "SET_USER_TIMEZONE", 
  "userId": "able.tuter", 
  "emailId": "abel.tuter@example.com", 
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   "timezone":"Asia/Kolkata" 
} 

When using this functionality, consider the following:

• The conversation must be open (current) in order to convert date and time to the 
user's timezone.

• The primary bot must send date and time in one of the following formats:

◦ Timezone name. For example, Asia/Kolkata  or America/New_York.

◦ Date Time 24-hour format. For example: YYYY-MM-DD HH:MM:SS

• The Virtual Agent  API uses the timezone specified by the primary bot, even if the 
timezone it sets differs from the value stored in the [sys_user] table.

• To set the user timezone, send the SET_TIMEZONE  action. If the timezone name 
is not valid, the timezone value defaults to UTC time. For example, 2021-02-16 
20:13:13.

Support for node skipping

Virtual Agent  API supports skipping a node if it is designed to do so in the topic. For example, in 
Virtual Agent Designer, you can designate a user input control as skippable in the Advanced  > 
Hide or skip this node  area of the property sheet.

Condition or script that allows the user to skip the node

For more information about defining a node as skippable, see Virtual Agent Designer user input 
controls.

If a node is marked as skippable, the bot will present that option to the user. If the user skips it, 
the primary bot should pass the skip command as depicted in the following example.

{
"requestId": "f42f3550-5b44-4cde-aa52-9b6756b3131c",
"clientSessionId": "835607",
"token": "snow",
"message": {
"text": "_skip_",
"typed": false
},
"emailId": "beth.anglin@example.com",
"userId": "beth.anglin"
}
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Synchronous handshake support

Note: 
These requirements apply to version 2.0.x of the Virtual Agent  API. For greater synchronous 
handshake functionality, upgrade to version 3.0.x, which supports live agent transfer and 
other enhancements. For details, see Synchronous handshake enhancements.

When enabled, Virtual Agent  delivers responses to the primary bot synchronously. If you want to 
enable communication with Virtual Agent  in synchronous mode, you must manually turn off the 
following features in order for the handshake to work:

• Agent Chat

• Notifications

• Typing indicators

Note: 
Topics that use the following features are not supported in synchronous mode: file upload, 
the Action utility, and the Pause topic block.

To disable these features and enable synchronous support, follow these steps:

1. Exclude the Bot to Bot channel from Agent Chat.

a. Navigate to All, and then enter sys_properties.list  in the filter.

b. Select the com.glide.cs.exclude.liveagent.support  system property to open 
it.

c. Add Bot To Bot  to the Value  field.

Exclude the Bot To Bot channel from Agent Chat

d. Click Update.

2. Navigate to All, and then enter sys_cs_channel.list  in the navigation filter.

3. Select the Bot to Bot record.

4. Clear the Enable Notifications  check box to disable it.

5. Clear the Support typing indicator  check box to disable it.

6. Select the Synchronous  check box.
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Bot to Bot channel with synchronous support enabled

Note: 
If the Synchronous  field is not visible, you can configure the form layout  to show it.

7. Click Update.

Notifications support

Use Virtual Agent  API to send the following types of notifications in the Bot to Bot channel when it 
is enabled in asynchronous mode:

• Simple: Text-only notifications. Simple notifications are delivered as soon as they arrive.

• Image Card: An image that is uploaded to the server or specified with a URL.

• Record Card: Specified columns from a record in a table.

• Actionable: Provides the user with the opportunity to perform certain actions. Actionable 
notifications are queued. The user can retrieve them on demand by sending the Show 
Notification  command.

For more information, see Configuring Virtual Agent notifications.

Virtual Agent  API sends the following example JSON for a simple notification:

{
  "requestId": "asd2423-wrr434-weruyt-1234567",
  "clientSessionId": "",
  "nowSessionId": "",
  "message": {
    "text": "Done",
    "typed": false,
    "clientMessageId": "ABC-123"
  },
  "userId": "beth.anglin",
  "body": [
    {
      "uiType": "OutputCard",
      "group": "DefaultOutputCard",
      "templateName": "Notification",
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      "data": 
 "{\"sys_id\":null,\"recordDisplayValue\":null,\"messageHead
ing\":\"[Heading]A notification has arrived. You 
 can continue the conversation after viewing the 
 notification.\",
\"imageUrl\":null,\"tableLabel\":null,\"enableLink\":false,\"mes
sage\":\"[message]A notification has arrived. You 
 can continue the conversation after viewing the 
 notification.\",\"fields\":[],\"table_name\":null,\"url\":
\"http://192.168.1.9:8080/null.do?sys_id=null\"}"
    }
  ],
  "completed": true,
  "score": 1
}

Virtual Agent  API sends the following example JSON for an Image Card notification:

{
  "requestId": "asd2423-wrr434-weruyt-1234567",
  "clientSessionId": "",
  "nowSessionId": "",
  "message": {
    "text": "Done",
    "typed": false,
    "clientMessageId": "ABC-123"
  },
  "userId": "beth.anglin",
  "body": [
    {
      "uiType": "OutputCard",
      "group": "DefaultOutputCard",
      "templateName": "Notification",
      "data": 
 "{\"sys_id\":null,\"recordDisplayValue\":null,\"messageHead
ing\":\"[Heading]A notification has arrived. You 
 can continue the conversation after viewing the 
 notification.\",\"imageUrl\":
\"http://xxxxxx.service-now.com/2b2d0d2653a13010ff59ddeeff7b120d
.iix\",\"tableLabel\":null,\"enableLink\":false,\"message\":
\"[message]A notification has arrived. You can 
 continue the conversation after viewing the 
 notification.\",\"fields\":[],\"table_name\":null,\"url\":
\"http://192.168.1.9:8080/null.do?sys_id=null\"}"
    }
  ],
  "completed": true,
  "score": 1
}

Virtual Agent  API sends the following example JSON for a Record Card notification:

{
  "requestId": "asd2423-wrr434-weruyt-1234567",
  "clientSessionId": "",
  "nowSessionId": "",
  "message": {
    "text": "Done",
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    "typed": false,
    "clientMessageId": "ABC-123"
  },
  "userId": "beth.anglin",
  "body": [
    {
      "uiType": "OutputCard",
      "group": "DefaultOutputCard",
      "templateName": "Notification",
      "data": 
 "{\"sys_id\":
\"552c48888c033300964f4932b03eb092\",\"recordDisplayValue\":
\"INC0010112\",\"messageHeading\":\"[Heading]A notification has 
 arrived. You can continue the conversation after viewing the 
 notification.\",\"imageUrl\":null,\"tableLabel\":\"Incident\",
\"enableLink\":true,\"message\":\"[message]A notification has 
 arrived. You can continue the conversation after viewing the 
 notification.\",\"fields\":[{\"fieldLabel\":\"Number\",
\"fieldValue\":\"INC0010112\"},{\"fieldLabel\":\"Short 
 description\",\"fieldValue\":\"Assessment : ATF 
 Assessor\"}],\"table_name\":\"incident\",\"url\":
\"http://192.168.1.9:8080/incident.do?sys_id=552c48888c033300964
f4932b03eb092\"}"
    }
  ],
  "completed": true,
  "score": 1
}

Notifications for the Bot to Bot channel are disabled by default. To enable them, do the following:

1. Navigate to All, and then enter sys_cs_channel.list  in the navigation filter.

2. Open the Bot to Bot record.

If prompted, enable editing on the record.

3. Select the Enable Notifications  check box.

4. Click Update.

Admins can limit the number of recipients per notification by modifying the 
com.glide.cs.per_notification_user_limit  property. The default value is 1000.

Topic switching using the topic name

In addition to using the topic ID or topic intent ID to switch topics, you can use the topic or 
topic intent name. It is recommended that you only send either the topic ID or the topic name. 
Currently, if either is incorrect or if the bot is already in the specified topic, Virtual Agent  does not 
send any response. Usage depends on the mode you are using, as follows:

• NLU topic discovery: Use the topic intent name or ID.

• Keyword topic discovery: Use the topic name or ID.

The primary bot can send the SWITCH  action along with the topic name to switch directly to a
  particular  topic.

Example message payload:
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{ 
  "requestId": "xxxx-xxxx-xxxx-xxxx",
  "clientSessionId": "xxx-xxx-xxx-xxx",
  "action":"SWITCH",
  "topic":{
   "name": "Topic Name" 
   }, 
  "userId": "beth" 
} 

Typing indicator support

You can enable typing indicators for users and live agents. Currently, typing indicators are 
displayed as follows:

• Displayed to the agent when the user is typing

• Displayed to the user when the bot is preparing a response

When the typing indicator is enabled, Virtual Agent  API sends the StartTypingIndicator  and 
EndTypingIndicator   actions in the response payload. For example:

{ 
    "uiType":"ActionMsg", 
    "actionType":"StartTypingIndicator" 
} 

To send the user typing indicator to a live agent, the client should send  the TYPING   action. 
When the user finishes typing, the  client should  send the VIEWING   action. For example:

{ 
  "requestId": "xxxxxx-xxxxxx-xxxx-xxxx-xxxxxxxxxx", 
  "clientSessionId": "xxxxxxxx-xxxx", 
    "action": "TYPING/VIEWING", 
  "userId": "able.tuter", 
  "emailId": "abel.tuter@example.com", 
  "timezone":"Asia/Kolkata" 
} 

To enable typing indicators, follow these steps.

1. Navigate to All, and then enter sys_cs_channel.list  in the navigation filter.

2. Select the Bot to Bot record.

3. Select the Support typing indicator  check box.

4. Click Update.

Virtual Agent API  features available in Store release 3.0.x

Virtual Agent API  version 3.0.x provides access to more of the same features that are available 
in Virtual Agent  and Agent Chat, including the ability to upload files from a private URL and 
synchronous handshake enhancements.

Ending abandoned Virtual Agent  conversations

If a conversation is incomplete due to an error, Virtual Agent  can ask the primary bot to take 
control. If the takeControl  flag is true, Virtual Agent  (as the secondary bot) will close the 
conversation automatically. If the primary bot wants to start a conversation, it can send the 
following action message: "hi"/START_CONVERSATION.
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You can ask the primary bot to take control in the following situations:

• Idle time out: Interaction State is Closed Abandoned. State Reason is No Activity.

• Technical issues: Interaction State is Closed Abandoned. State Reason is Bot issues.

• Invalid user input: Interaction State is Closed Abandoned. State Reason is Invalid 
user input.

To request that the primary bot take control, send the takeControl  flag in the body of the 
payload to the primary bot with a value of true.

Example message payload:

{ 
  "requestId": "xxxx-xxxx-xxxx-xxxx",
  "clientSessionId": "xxx-xxx-xxx-xxx",
   "message": {
      "text":"invalid3",
       "typed":true
       }
   "body":[{
       "uiType":"OutputText",
       "group":"DefaultText",
       "value":"Sorry, I didn't get that. Could you help me by 
 answering this?"
       },
       {
       "uiType":"Boolean",
       "group":"DefaultPicker",
       "required":true,
       "nluTextEnabled": false,
       "label":"Choose a value",
       "options":[
          {"label":"Yes"},
          {"label":"No"}
          ]
       }],
    "takeControl":true,
    "score":0
} 

Improved Virtual Agent API  response time

Virtual Agent API  responses include parameters like Take Control and NLU Score. These 
parameters are processed while preparing the response.

Starting with version 3.9.0, you can exclude the Take Control and/or NLU Score parameters from 
the Virtual Agent API  response to improve the response time.

To exclude Take Control and NLU Score parameters from the Virtual Agent API  response, 
complete the following steps:

1. Navigate to All  > sys_cs_custom_adapter_property.list.

2. Search for enable_take_control  and send_nlu_score  properties.

3. Set the value of enable_take_control  property to false to exclude Take Control setting 
and send_nlu_score  property to false to exclude NLU Score calculation while processing 
the response. These properties are set to true by default.
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Improved topic switching errors and troubleshooting

Topic switching may fail for any of the following reasons:

• The request includes both the topic name and topic ID (keyword topic discovery) or the topic 
intent name and topic intent ID (NLU topic discovery). Specify one or the other.

• The request includes an invalid topic or intent name or ID.

• The topic/intent name or ID is valid, but Virtual Agent  can't run it because it's inactive or not a 
topic. For example, if the name or ID refer to a topic block or custom control object.

• The requested topic is already running.

• The requested topic is valid, but a security condition is preventing access. For example, the 
topic may not be permitted to run in the channel or some other access-control condition may 
apply.

If topic switching fails, Virtual Agent API  responds in the following ways, whether you're using it 
synchronously or asynchronously:

• If topic switching fails, the conversation is closed with a message stating that the conversation 
cannot continue. The conversation will no longer remain in an open state.

• The previous request is marked as processed so that a new request can be made without 
waiting for a timeout.

• The reason for the failure is logged in the system log table (Automated Test Framework  > 
System Logs  > Errors).

Synchronous handshake enhancements

Starting with version 3.0.x, Virtual Agent API  can transfer to a live agent synchronously. When a 
user or agent finishes a conversation, the transfer back to Virtual Agent  is done synchronously as 
well. Some system messages and wait time messages are also sent synchronously.

To use synchronous transfer to a live agent, be aware of the following guidelines:

• Configure the Virtual Agent  response endpoint. Agent Chat  messages will be delivered to the 
endpoint you specify.

• You must manually turn off Notifications for the instance.

• If you are using synchronous transfer to a live agent, Virtual Agent API  sends the typing 
indicator if it is enabled:

{
  "uiType": "ActionMsg",
  "actionType": "StartTypingIndicator",
}

• Topics that use the following features are not supported in synchronous mode: file upload, the 
Action utility, and the Pause topic block.

To disable these features and enable synchronous support, follow these steps:

1. Navigate to All  > sys_cs_channel.list.

2. Select the Bot to Bot record.

3. Clear the Enable Notifications  check box to disable it.

4. If you will not be transferring to a live agent in synchronous mode, clear the Support typing 
indicator  check box to disable it.

5. Select the Synchronous  check box.
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Bot to Bot channel with synchronous support enabled

6. Click Update.

Support for action messages

In addition to passing messages to a ServiceNow®  Virtual Agent  secondary bot, the primary bot 
or chat client can pass messages to an agent through Agent Chat. Use the action  parameter 
passed in the request body to specify how the content should be handled.

Virtual Agent API  supports the following action message types:

Supported action message types

actionType value Description

ChatSubHeader Outbound message indicating one of the following occurred:

• Dynamic translation failed.

• Live agent autopilot was initiated and completed.

StartSpinner Outbound message that starts a spinner when a message is in 
the pending state due to asynchronous processes, such as AI 
Search  or the profanity filter.

EndSpinner Outbound message that stops the spinner that was sent 
previously.

StartTypingIndicatorActionMsg Outbound message indicating that a user or agent has begun 
to type (after an agent has accepted the chat).

EndTypingIndicatorActionMsg Outbound message indicating that a user or agent has 
stopped typing.

SubscribeToSupportQueue Indicates that the conversation is set to the support queue.

SubscribeToChatPresence Outbound message indicating that a live agent conversation 
has begun.

SwitchToLiveAgent Outbound message indicating that a live agent has accepted 
the conversation.
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Supported action message types  (continued)

actionType value Description

SwitchToVirtualAgent Outbound message indicating that the live agent session has 
ended, and the conversation is returned to Virtual Agent.

SwitchConversation Outbound message indicating that a notification was sent. 
This creates a new conversation, so Virtual Agent  switches to 
the new conversation.

System Outbound message indicating one of the following:

• A live agent has entered the cat.

• Either the live agent or the user closed the chat.

• The conversation with a live agent has timed out.

Support for silentMessage flag

A silent message is a message that does not require a response. If Virtual Agent  receives a 
request with silentMessage=true, all subsequent bot messages are suppressed until 
Virtual Agent  receives a request to turn off silent mode (silentMessage=false).

Example message payload from the primary bot:

{
   "token": "BOT_TOKEN",
   "botToBot": true,
   "clientSessionId": "884502214730301027f83ee4070f589a",
   "clientVariables": {},
   "requestId": "48450221d23030107300b7756770bc9b",
   "silentMessage": "true",
   "timestamp": 1623916324820,
   "timezone": "GMT",
   "userId": "abel.tuter",
   "emailId": "abel.tuter@example.com"
}

Note: 
If silentMessage=true, notifications are not delivered.

Secure file uploads from a private URL

Virtual Agent API  supports file uploads up to 1 GB in size from a private URL. The primary bot 
must pass the user ID, optional provider application ID, and the name of the file. Observe the 
following guidelines:

• Provider application ID is optional.

• The user ID and provider application ID should be sent before the file name in the payload.

• The end user must have a role specified in the glide.attachment.role  property. For 
more information, see Require a role to attach files .

• Basic or OAuth authentication is supported, but Message Authentication is not.

Example message payload from the primary bot:
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curl -X POST \
  https://instance.service-now.com/api/now/v1/cccif/media/upload 
 \
  -H 'authorization: Basic YWRtaW46YWRtaW4=' \
  -H 'content-type: multipart/form-data; \
  -F user_id=xxxxxx \
  -F provider_application_id=optionalId \
  -F 'file=@SomeFile.png'

Virtual Agent API  sends the following example JSON:

{
  "result": {
    "mediaUrl": 
 "http://123.456.7.8:8080//api/now/v1/cs/media/string",
    "name":"imagefile.png",
    "state":"pending",
    "attachmentId":"abcdefghijklmno12345"
  }
}

Support for transformation of Virtual Agent API  request and response

Virtual Agent API  supports transformation of request and response payloads to and fro Virtual 
Agent API. This is helpful in cases where the primary bot has a common response template 
across all secondary bots. See Transform Virtual Agent API request and response  for more 
information.

Support for configuring multiple provider applications

Virtual Agent API  enables configuration of multiple provider applications to support use cases 
where there are multiple primary bots using Virtual Agent API  and you need to distinguish 
between them. See Configure multiple provider applications  for more information.

Support for Now Assist  experience

Now Assist  experience in Virtual Agent API  offers generative AI skills across multiple provider 
channels. See Enable Now Assist experience in Virtual Agent API  for more information.

Install the Virtual Agent  API

Install the Virtual Agent  API app to integrate any chat interface or a bot with ServiceNow®  Virtual 
Agent  or Agent Chat.

Before you begin
If you're upgrading from a version prior to version 2 and if authentication is required for your 
instance, you must revert the customization before upgrading. For these versions, the upgrade 
skips the Scripted REST Service when authentication is turned on. For more information, see 
Revert a customization .

You must meet the following requirements:

• Ensure that the application and all of its associated ServiceNow Store  applications have valid 
ServiceNow  entitlements. For more information, see Get entitlement for a ServiceNow  product 
or application .

• Review the Virtual Agent API  application listing in the ServiceNow Store  for information on 
dependencies, licensing or subscription requirements, and release compatibility.
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• Ensure that you activated the Glide Virtual Agent  (com.glide.cs.chatbot) plugin, which activates 
the Conversational Custom Chat Integration (com.glide.cs.custom.adapter) plugin.

For more information about this plugin, see Activate Virtual Agent.

Note: 
The Virtual Agent  API requires a Pro license similar to that of Virtual Agent.

Role required: admin or virtual_agent_admin

About this task
The Bot to Bot Control [sys_cs_bot_to_bot_control] table is installed with the Virtual Agent  API. 
This table tracks the number of times that a particular task in a topic is executed. You can use 
this table for debugging. For example, use it to determine whether Virtual Agent  is stuck on a 
particular control or topic.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the Virtual Agent  API application using the filter criteria and search bar.

You can search for the application by its name or ID. If you cannot find the application, you may 
have to request it from the ServiceNow Store.

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released 
apps, see the ServiceNow Store  version history release notes .

3. Select a version from the list and select Install.

In the Install dialog box that is displayed, any dependencies that are installed along with your 
application are listed.

4. If you're prompted, follow the links to the ServiceNow Store  to get any additional entitlements 
for dependencies.

What to do next
Review the inbound REST endpoint and configure inbound authentication

Review the inbound REST endpoint and configure inbound authentication

After you install the Virtual Agent  API, navigate to the Scripted REST API resource to review the 
endpoint and set up authentication.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Web Services  > Scripted Web Services  > Scripted REST APIs.

2. Select the VA Bot Integration  record to open it.

3. In the Resources  tab, open the BOT Integration  record.

4. Review the inbound REST API resource details.

The format is:  https://<customer instance>/api/sn_va_as_service/bot/
integration
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For a description of the request parameters and an example send request, see Virtual Agent 
Bot Integration API .

5. In the Security  tab on the same page, select the Requires authentication  check box.

6. Set up Provider Authentication using any of these methods: Basic, OAuth, Hash, or Static 
Token.

Note: 
Guest usage via Basic or OAuth is already supported out-of-box when you select 
Requires authentication. To support user account linking, you must use Static or Hash 
token-based authentication. You can use token-based authentication (Static or Hash) 
with or without Basic or OAuth authentication. The token can be passed in either the 
request body or the header. If the token is specified in both places, the one in the header 
is accepted.

Do one of the following:

◦ Set up Basic or OAuth authentication.

To learn more about OAuth authentication and the possible security configurations for 
scripted REST APIs, see Enable OAuth with inbound REST .

◦ Set up Message Authentication, which involves configuring either Static or Hash tokens, 
setting up Provider Authentication, and setting the channel identity. For details, see 
Configure Message Authentication for inbound communication.
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What to do next
If you are using Message Authentication, Configure Message Authentication for inbound 
communication.

Configure the output response REST endpoint and outbound authentication for the Virtual Agent 
API.

Configure Message Authentication for inbound communication

You can configure Message Authentication for the Virtual Agent  API instead of Basic or OAuth. 
Message Authentication involves configuring either Static or Hash tokens, setting up Provider 
Authentication, and setting the channel identity.

Before you begin
Follow the steps in Review the inbound REST endpoint and configure inbound authentication.

Role required: admin

Procedure

1. Configure the token by doing one of the following, depending on the token type:

◦ Static token:

a. Navigate to All, and then enter token_verification.list  in the filter.

b. Click New.

c. On the Token Verifications form, fill in the fields.

Field Description

Name Name of the authentication token, such as B2BTestAppAuthToken.

Description Description of the authentication token, such as B2B Testing 
application Auth Token.

Token Enter an authentication token that you generated using any general 
programming or scripting language, or click Generate Secure Token  in the 
Related Links.

d. Click Submit.

◦ Hash token:

a. Navigate to All, and then enter hash_message_verification.list  in the filter.

b. Click New.

c. On the Hash Message Verification form, fill in the fields.

Fields Description

Name Name of the authentication token, such as B2BTestAppAuthToken.

Description Description of the authentication token, such as B2B Testing 
application Auth Token.

Secret Authentication token (random string).

d. Click Submit.

2. Set up Provider Authentication for token-based authentication.
© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1976



a. Navigate to All, and then enter message_auth.list  in the filter.

b. Click New.

c. On the Message Auths form, fill in the fields.

Field Description

Name Name of the message authentication, such as B2B Auth token.

Provider Name of the provider.

Group name Not required.

Service Portal Not required.

Inbound 
message 
verification

Select the Static token or Hash message token that you created.

Outbound 
message 
creation

This field is currently not supported in the Virtual Agent  API. Select the 
Static token or Hash message token that you created.

Outbound 
service token

This field is currently not supported in the Virtual Agent  API.

d. Click Submit.

3. Set the channel identity.

a. Navigate to All, and then enter sys_cs_provider_application.list  in the filter.

b. Select the VA Bot to Bot Provider Application  record to open it.

c. In the Provider Channel Identity form, locate the Message auth  field and select the message 
auth that you set up previously.

d. Click Update.

4. For Hash token-based authentication only, send the x-b2b-signature  in the request headers.
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The value is the HmacSHA1  encoded value of the request payload, which uses the token 
created in the ServiceNow  instance. For example, in Postman, follow these steps:

a. In the Headers, set the x-b2b-signature  to {{hashValue}}.

b. In the Pre-request Script area, set the token as follows:

pm.environment.set('hashValue', 
 CryptoJS.HmacSHA1(JSON.stringify(JSON.parse(request.data)), 
 '<insert your token>').toString(CryptoJS.enc.Hex));

What to do next
Configure the output response REST endpoint and outbound authentication for the Virtual Agent 
API

Configure the output response REST endpoint and outbound authentication for the Virtual 
Agent  API

Specify the outbound endpoint URL to which the Virtual Agent  responses are posted. Configure 
outbound authentication.

Before you begin
If needed, specify the Message Authentication for token validation in the Provider Channel 
Identities [sys_cs_provider_application] table.
Role required: admin

Procedure

1. Navigate to All  > System Web Services  > Outbound  > REST Message.

2. Select the VA Bot to Bot  record to open it.

3. In the Endpoint  field, enter the response endpoint for the third-party bot, and then click 
Update.

This is the endpoint for the primary bot server, where the response will have to be sent from 
the ServiceNow  bot to another bot or another ServiceNow  instance.

For example: http://<customer instance>/demo/rest/service/nowbot/
processResponse

4. In the Authentication  tab, set the Authentication type  field to either Basic  or OAuth 2.0, and 
then click Update.
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◦ Basic:  In the Basic auth profile  field, select or create a Basic auth profile. It will contain a 
username and password.

◦ OAuth:  In the OAuth profile  field, select or create an OAuth profile. After saving your 
changes, click Get OAuth Token  in the related links list.

For details about configuring basic authentication, see Configure a REST message with basic 
auth . For information about configuring OAuth 2.0, see Configure a REST message with 
OAuth .

5. Review the JSON response returned from the endpoint call.
For a description of the Virtual Agent  API response parameters and an example of a successful 
response, see Virtual Agent Bot Integration API .

Virtual Agent  bot-to-bot integration

The Virtual Agent  API supports environments that use multiple bots. In this situation, a primary 
bot communicates with third-party secondary bots, such as a ServiceNow  bot.

There are two types of bot communication with the primary bot:

• If the primary bot understands an end user’s request (intent), the primary bot routes the 
request to the appropriate secondary bot, which displays the corresponding topic.

• If the primary bot cannot determine where to route a user request, the primary bot can 
broadcast a user’s request to all secondary bots. Each secondary bot returns a prediction 
confidence score for determining the end user’s intent. The primary bot then routes the 
request to the secondary bot with the highest prediction confidence score.

In both scenarios, the ServiceNow  bot informs the primary bot when the request is completed or 
when it cannot continue handling the request. The primary bot can then determine whether to 
inform the end user that the conversation is complete or provide further assistance.
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Bot-to-Bot ecosystem with ServiceNow  Virtual Agent  as a secondary bot

The ServiceNow  secondary bot uses a standard request and response through REST endpoints. 
When the request is received through the Bot Framework or an enterprise app seeking to 
integrate with the ServiceNow  bot, the response for a request is sent asynchronously via the API 
to the requesting system. Virtual Agent  supports Live Agent  in the channel as well.

Properties for bot-to-bot integrations

You can add system properties  to configure the following:

• Starting with version 1.3: Logging for the Virtual Agent  API

• Number of times that the Virtual Agent  bot tries to get a response

• Bot normalization score

Bot-to-bot properties

Property Description Default value

va.bot.to.bot.logging_enabled Starting with version 1.3: Option 
that enables logging for the 
Virtual Agent  API. To enable 
logging, set the value to True.

False

va.bot.to.bot.take.control_times Number of times that Virtual 
Agent  tries to get a response, 
after which control is returned to 
the primary bot.

2

va.bot.to.bot.score.normalization_factorA value used to normalize the 
prediction confidence score 
returned by Virtual Agent, if 
the primary bot does not use 
intents to route requests to the 
appropriate bot.

1
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Closing idle bot-to-bot conversations

In bot-to-bot integrations (Virtual Agent API), abandoned conversations that are "idle" for more 
than an hour are automatically closed by the scheduled job, Time Out Abandoned B2B 
Conversations. This job runs hourly each day.

The default timeout period for abandoned bot-to-bot conversations is one hour (3600 
seconds). The Time Out Abandoned B2B Conversations  job closes any bot-to-
bot conversations that have been open longer than one hour (3600 seconds). You (admins) 
can change the default timeout period for idle bot-to-bot conversations by adding the system 
property  com.glide.cs.b2b_conversation_idle_timeout.

The timeout value that you specify in this property applies to all bot-to-bot conversations 
involving the Virtual Agent.

Change the timeout period for idle bot-to-bot conversations

Add the com.glide.cs.b2b_conversation_idle_timeout  property to the 
System Property [sys_properties] table to specify the length of time that an abandoned 
bot-to-bot conversation remains open (idle). When the Time Out Abandoned B2B 
Conversations  job runs hourly, it closes any bot-to-bot conversations that have been idle 
longer than the specified time.

1. Navigate to All, and then enter sys_properties.list  in the navigation filter.

2. Click New.

3. On the form, fill in the fields.

Field Value

Name Enter the system property 
name:com.glide.cs.b2b_conversation_idle_timeout

Description Enter an explanation for this property: Idle 
timeout period (in seconds) for 
all bot-to-bot conversations

Type Select integer.

Value Enter the number of seconds that the 
abandoned bot-to-bot conversations remain 
open, after the requester's last response.

For example, a value of 1800 seconds (30 
minutes) means that an abandoned bot-
to-bot conversation remains open for 1800 
seconds (30 minutes). When the Time Out 
Abandoned B2B Conversations  job 
runs, it closes any conversations that have 
been idle longer than 1800 seconds.

4. Click Submit.

Change the Time Out Abandoned B2B Conversations scheduled job

To change the time that this hourly scheduled job runs or to make other adjustments to the 
scheduled job:
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1. Navigate to All  > System Definition  > Scheduled Jobs  and open the Time Out Abandoned B2B 
Conversations record.

2. In the Scheduled Script Execution form, change the Time at which the scheduled job runs. Or, 
depending on how you want to adjust the timing, change other fields in the form as needed.

For example, to change the interval at which the job runs, in the Run  field, select Periodically. 
You then specify the Repeat Interval  (Days  and Hours) that the job runs and the Starting 
date for the interval. For a description of the other fields that you can change in this form, see 
Automatically run a script of your choosing .

3. Click Update.

The job runs at the specified time and frequency.

Configure multiple provider applications

You can configure multiple provider applications to support use cases where there are multiple 
primary bots using Virtual Agent API  and you need to distinguish between them.

Before you begin
Role required: admin

Be sure you are in Virtual Agent API  application scope.

Procedure

1. Navigate to All  > sys_cs_provider_application.

2. Click New  to create a new provider application.

3. On the form, fill in the fields.

Field Description

Name Name of the provider application, such as VA API Custom Bot.

Provider Select the provider as VA Bot to Bot Provider.

Inbound 
Id

Unique inbound Id used in the request message, for example, custom_1.

Message 
Auth

Configure Message Authentication with a token for inbound communication. See 
Configure Message Authentication for inbound communication  for more details.

4. Click Submit.

5. Navigate to All  > System Web Services  > REST Message.

6. Click New  to create a new REST Message record.

7. In the REST Message record, fill in the form fields.

Field Description

Name Name of the REST Message record. This should be the same as the newly created 
provider application.

Endpoint The response endpoint of the primary bot.

8. Click Submit.
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9. In the HTTP Methods section, click New to create a new method or you can override the default 
GET method.

Field Description

Name Name of the HTTP Method. Enter postMessage.

HTTP method Select POST.

Endpoint Enter the response endpoint of the primary bot.

Authentication 
Type

Configure Basic or OAuth 2.0 authentication as per your requirement. 
For details about configuring basic authentication, see Configure a REST 
message with basic auth . For information about configuring OAuth 2.0, see 
Configure a REST message with OAuth .

10. To use the newly created provider application, pass the Inbound Id of the provider application 
in the appInboundId  parameter of the Virtual Agent API  request.
You need to pass the Inbound Id of the provider application in the appInboundId  parameter 
for every Virtual Agent API  request. The following is a sample Virtual Agent API  request that 
uses the newly created provider application.

 
{
    "userId": "adminuser1",
    "emailId": "admin@example.com",
    "action": "START_CONVERSATION",
    "message": {
        "text": "",
        "typed": true
    },
    "appInboundId": "custom_1",
    "contextVariables": {
        "app_name": "test"
    }
}

You can test the configuration by viewing the outbound HTTP logs to verify that your response 
endpoint was called.

Transform Virtual Agent API request and response

You can transform Virtual Agent API request and response into supported formats through the 
scripted extension points provided in Virtual Agent API.

Before you begin
Role required: admin
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Procedure

1. Navigate to All  > System Extensions Points  > Scripted Extension Points

◦ The sn_va_as_service.va_api_payload_transformation extension point transforms primary 
bot payload into standard Virtual Agent API supported format before processing the request. 
The sn_va_as_service.va_api_output_transformation extension point transforms Virtual 
Agent API response into a format supported by the primary bot.

◦ Both the scripted extension points have two parameters: shouldTransform  and 
transform. shouldTransform  is used to determine whether the implementation is 
executed. transform  is used to transform the request or response.

2. If you want to transform the request payload, complete the following steps.

a. Select sn_va_as_service.va_api_payload_transformation extension point

b. In the Related Links section, click Create implementation.

c. Update the extension point script as per your requirements.
In sn_va_as_service.va_api_payload_transformation extension point, the request parameter 
is an object with two keys: payload  and headers. payload  is the request payload 
received from the primary bot, and headers  are the headers sent in the request payload. 
The following is a sample implementation.

 
var va_api_payload_transformation = Class.create();
va_api_payload_transformation.prototype = {
    initialize: function() {},
 
    shouldTransform: function(request) {
        return request.payload.caller === "examplebot";
    },
 
    /*
    return object for transform function should be in the 
 following format
    transformedRequest = {
    payload: request.payload,
    headers: request.headers
    };
    */transform: function(request) {
    var payload = request.payload;
    var headers = request.headers;
 
    var vaAPIPayload = {
 "userId": payload.userId,
 "emailId": payload.email,
 "message": {
     "text": payload.message,
     "typed": true
 },
 "contextVariables": {
     "requester_session_language": payload.user_language
 },
 "appInboundId": "custom_1"
    };
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    return {
 payload: vaAPIPayload,
 headers: headers
    };
},

sn_va_as_service.va_api_payload_transformation extension point

d. Click Update.

3. If you want to transform the response payload, complete the following steps.

a. Select sn_va_as_service.va_api_output_transformation extension point

b. In the Related Links section, click Create implementation.

c. Update the extension point script as per your requirements.
In sn_va_as_service.va_api_output_transformation extension point, the response parameter 
is an object with two keys: inputPayload and responsePayload. inputPayload  is the 
request payload received from Virtual Agent API, and responsePayload  is the response 
from Virtual Agent API which you can use to build the transformed response. Use the 
appInboundId field of the request payload to determine whether to return true or false. The 
following is a sample implementation.

 
var va_api_output_transformation = Class.create();
va_api_output_transformation.prototype = {
    initialize: function() {},
 
    shouldTransform: function(response) {
 return (response.inputPayload.appInboundId === 'custom_1');
    },
 
    /*
    input object param for transform function should be in 
 the following format
    response = {
        inputPayload: response.inputPayload,
 responsePayload: response.responsePayload
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    };
    */
    transform: function(response) {
 //return only transformed payload
        return {
     'custom_structure': response.responsePayload
 };
    },
 
    type: 'va_api_output_transformation'
};

sn_va_as_service.va_api_output_transformation extension point

d. Click Update.

Enable Now Assist experience in Virtual Agent API

Enable Now Assist  experience in Virtual Agent API  to support generative AI skills across multiple 
provider channels.

Before you begin
Be sure you are on Washington DC  Patch 7 or above. If you are on an earlier version, see 
KB1699602  article in the Now Support  Knowledge Base .

Set up Now Assist  in Virtual Agent. See Configuring Now Assist in Virtual Agent  for more 
information.

Role required: admin

Procedure

1. Navigate to All, and then enter sys_now_assist_deployment_channel.list  in the 
navigation filter.

2. Click New.

3. On the form, fill in the fields.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1986

https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB1699602
https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB1699602
https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB1699602


Field Value

Document Table Select Provider Channel Identity from the 
dropdown.

Document Id Select the Provider Channel Identity 
[sys_cs_provider_application] record 
corresponding to Virtual Agent  API.

Now Assist Deployment Select Now Assist for Virtual Agent.

Active Select the Active  checkbox.

4. Click Submit.

Using Virtual Agent  Bot Interconnect  in your configuration

Use Virtual Agent  Bot Interconnect  to create a unified chat experience across multiple channels. 
You can support secondary bots, such as Google Dialogflow, Microsoft  Power Virtual Agents, and 
ServiceNow®  Virtual Agent.

Virtual Agent  Bot Interconnect  functions as the primary bot in a diverse chat environment. It 
can help you reduce complexity and create a unified chat experience for your end users. Virtual 
Agent  Bot Interconnect  gives your end users access to multiple channels and a wide variety of 
enterprise tasks that are available from ServiceNow.

Bot Interconnect  provides the following benefits:

• Ready integration with third-party bots such as Google Dialogflow  and Microsoft  Power Virtual 
Agents.

• Easy integration with ServiceNow  Virtual Agent  bots on other instances.

• The ability to add any other third-party bot as a secondary bot in the system.

• User authentication and account linking in Bot Interconnect.

• Intent discovery in Bot Interconnect  across topics that are supported by the primary and 
secondary bots.

• LLM topic conversations across primary and secondary bots

• Conversations occur with one bot at a time.

• Bot Interconnect  provides a common conversation model and data storage, which unifies 
reporting and analytics.

Note: 
The Virtual Agent  Bot Interconnect  requires a Pro license similar to that of Virtual Agent.

Supported Controls

All input controls and bot response controls are supported.

Features and default behavior

Language support

Responses in Bot Interconnect  are not translated. Bot Interconnect  passes the 
user language to the secondary bot and expects the secondary bot to return any 
responses in that language. For example, if the primary bot has a German-speaking 
user and the secondary instance is localized in German, then German responses 
are returned to the primary bot.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1987



Timeout value from the secondary bot

The timeout value is the maximum time the primary bot waits for a response from 
the secondary bot. You can pass a custom timeout value (in milliseconds) in the Bot 
Interconnect  Topic Block properties to override this.

1. Select the Bot Interconnect Topic Block  node in the shell topic on your primary 
instance.

2. In the Additional Params (String)  area, click the script icon .

3. Add the following script:

return JSON.stringify({ timeout : 30000 })

In this example, 30000 equals 30 seconds.

4. Save and publish the topic.

Closed conversations

Conversations are closed on the secondary bot when a user closes the 
conversation on Bot Interconnect  or when the Bot Interconnect  conversation times 
out.

Note: 
Conversations always remain open in Microsoft  Power Virtual Agents.

Debug logs

To enable debug logs in the Bot Interconnect  instance, set the 
sn_va_bot_ic.bot_interconnect.enable.logging  system property to 
true. You will see a conversation ID attached to most logs, as well as the file name.

Pass output from the secondary bot topic to the primary bot

You can apply custom logic to the output of the secondary bot conversation in the 
Bot Interconnect  shell topic.

Support for custom transformation maps

Developers can pass a custom transformation map using the 
getTransformerMap  method. A custom transformation map lets you override 
the default transformation logic.

Example in the DialogflowInboundTransformer script include for Google Dialogflow:

/** Custom transformation map based on control types in 
 DialogFlow messenger **/
 
getTransformationMap: function() {
 return {
  ‘text’: ‘transformText’,
  ‘info’: ‘transformInfoCards2’,
  ‘description’: ‘transformDescription’,
  ‘button’: ‘transformButtonLink’,
  ‘image’: ‘transformImage’,
  ‘chips’: ‘transformChips’,
 
  /* fallback logic in case VA API response format is 
 mentioned in Dialogflow custom response payload */
  ‘servicenow’: ‘transformServiceNowResponse’
 };
},
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In this example, text, info, description, and so forth are the control 
types that correspond to the secondary bot. The specified method (such as 
transformText  is called to do the transformation for the control type. For each 
secondary bot response, Virtual Agent  uses the getControlType  method to 
return the control type specified in the transformation map for the secondary bot 
message. The inbound transformer in Google Dialogflow  provides a good example 
for how to use this.

If the transformation method called does not exist, Virtual Agent API  logs it as an 
error.

Live agent connection

You can enable live agent connection to route a Virtual Agent  interaction in the 
primary instance to a live agent on the secondary instance. The following are the 
possible connection scenarios.

• If there are no matching agents available in the primary instance to cater to the 
interaction, Bot Interconnect  will evaluate the matching conditions configured in 
the live agent connection and route the interaction to the appropriate live agent in 
the secondary instance.

• If there is only one matching connection, the interaction is routed to that 
connection and agent availability is checked in the secondary instance.

• If there are multiple matching connections, the user is presented with options in 
the order defined and is connected to the selected connection.

• If there are no matching agents available in the secondary instance, the following 
message is displayed: "There are no agents available. Please try again later.".

• If there are matching agents available in the secondary instance, the user is 
redirected to the available live agent who can cater to the interaction.

Autopilot mode is currently not supported in the secondary instance when the 
conversation is initiated on the primary instance. Live agent connection in the 
secondary instance works only when the secondary instance is in asynchronous 
mode.

Install Virtual Agent  Bot Interconnect

You can install the Bot Interconnect  application if you have the admin role. The application is 
available from the ServiceNow®  Store.

Before you begin

• Ensure that the application and all of its associated ServiceNow Store  applications have valid 
ServiceNow  entitlements. For more information, see Get entitlement for a ServiceNow  product 
or application .

• Review the Bot Interconnect  application listing in the ServiceNow Store  for information on 
dependencies, licensing or subscription requirements, and release compatibility.

Role required: admin

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the Bot Interconnect  application (sn_va_bot_ic) using the filter criteria and search bar.

You can search for the application by its name or ID. If you cannot find the application, you 
might have to request it from the ServiceNow Store.
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In the list next to the Install  button, the versions that are available to you are displayed.

3. Select a version from the list and select Install.

In the Install dialog box that is displayed, any dependencies that are installed along with your 
application are listed.

4. If you're prompted, follow the links to the ServiceNow Store  to get any additional entitlements 
for dependencies.

5. Select Install.

Using Google Dialogflow  as a secondary bot with Virtual Agent  Bot Interconnect

With Bot Interconnect, you can use ServiceNow®  Virtual Agent  as the primary bot with a Google 
Dialogflow  secondary bot. All of the skills and topics available to Google Dialogflow  are made 
available to and executable from channels that are configured for ServiceNow®  Virtual Agent.

Prerequisites

This bot configuration requires the following:

• A Washington DC  ServiceNow  instance

• Virtual Agent  Bot Interconnect  Store application

• A Google Dialogflow  account

Create a new agent in Google Dialogflow

To use Google Dialogflow  with Virtual Agent  Bot Interconnect, you must first create a new agent in 
Google Dialogflow.

Before you begin
Role required: admin

Procedure

1. Create a new agent in Google Dialogflow: https://dialogflow.cloud.google.com/ /newAgent

This also creates a new Google  project.
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2. Click the agent settings icon, and then find the project ID on the General  tab.

3. Click the Project ID.
The project dashboard opens.

Create a service account and private key for the Google Dialogflow  project

To use Google Dialogflow  with Virtual Agent  Bot Interconnect, the second step is to create a 
service account and private key for the new agent in Google Dialogflow.

Before you begin
Role required: admin
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Procedure

1. On the project dashboard page, click Go to project settings.

2. On the IAM & Admin page, click Service Accounts.

3. Click + Create Service Account.

4. Provide a name, and then click Create and Continue.

5. Under Select a role, select Dialogflow  > Dialogflow API Client.

6. Click Continue.
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7. Click Done.

8. Click the link for the record in the Email  column.

The Service account details page opens.

9. Click the Keys  tab.

10. Click Add Key  > Create new key.
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11. When prompted for the key type, select JSON, and then click Create.
The JSON file is downloaded to your computer.

Generate a Java Keystore file from the JSON private key file

To use Google Dialogflow  with Virtual Agent  Bot Interconnect, the third step is to generate a JKS 
file from the JSON private key you created in the previous step.

Before you begin
Role required: admin

Procedure

1. In a text editor, open the JSON private key file you downloaded in the previous procedure.

2. Copy the private key text, starting with the BEGIN PRIVATE KEY section and ending with the 
END PRIVATE KEY section.
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3. Remove the line return characters (\n) from the key:

a. Paste the key text in a text editor, such as TextEdit or Notepad.

b. Click Edit  > Find  > Find & Replace  or Edit  > Replace.

c. In the Find  field, type \n.

d. In the Replace  field, press Ctrl + Enter  or Alt + Enter.

e. Click Replace All.
The key text will be formatted with line breaks.

4. Save the formatted private key text as a .pem  file.
For example, privatekey.pem.

5. In a web browser, open the URL that is listed in the JSON file for the 
client_x509_cert_url  parameter.
For example, https://www.googleapis.com/robot/v1/metadata/x509/my-srvc-account%40my-
agent-ukpy.iam.gserviceaccount.com. The certificates page opens.

6. Copy the certificate that has the same private key ID that appears in the JSON file.

7. Replace \n with line breaks in the certificate, as described in step 3.

8. Save the formatted certificate as a .pem  file.
For example, certificate.pem.

9. Navigate to the folder that contains both the private key and certificate files.

10. Open a terminal window:

a. In Mac OS, right-click or ctrl-click the folder and select New terminal at folder.

b. In Windows, right-click the folder and select Open in terminal.
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11. At the terminal's command prompt, create the JKS file as follows:

a. Enter the following command:

openssl pkcs12 -export -in [certificate file name] -inkey 
[private key file name] -certfile [certificate file name] -out 
testkeystore.p12

For example, if certificate.pem is the name of the certficate and privatekey.pem is the name 
of the private key:

openssl pkcs12 -export -in certificate.pem -inkey 
privatekey.pem -certfile certificate.pem -out testkeystore.p12

b. When prompted for a password, enter the password of your choice using a minimum of six 
characters.

A PKCS 12 file is created with the name testkeystore.p12.

c. Enter the following command:

keytool -importkeystore -srckeystore testkeystore.p12 
-srcstoretype pkcs12 -destkeystore dialogflow.jks 
-deststoretype JKS

You will be prompted for a password multiple times. Use the same password you created in 
the previous step.

Result
A JKS file is created.

Configure connections to Google Dialogflow  in your Virtual Agent  Bot Interconnect instance

To use Google Dialogflow  with Virtual Agent  Bot Interconnect, the fourth step is to configure the 
connection in your ServiceNow®  instance.

Before you begin
Generate a Java Keystore file from the JSON private key file.

Role required: admin

Procedure

1. Navigate to All  > Connections & Credentials  > Connection & Credential Aliases.

2. On the Connection & Credential Aliases page, click the Bot Interconnect Dialogflow 
Integration  record.

3. Under Related Links, click Create New Connection & Credential.

4. Use the JSON file you downloaded in a previous step  to fill in the form.

Connection & Credential Aliases New record form

Field Description

Connection 
Name

A name for your credential. For example, Dialogflow Connection.
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Field Description

Project ID 
(project_id)

The value that corresponds with the project_id  parameter in the JSON 
file. For example, my-agent-ukpy.

Service 
Account Email 
(client_email)

The value that corresponds with the client_email  parameter 
in the JSON file. For example, my-srvc-account@my-agent-
ukpy.iam.gserviceaccount.com.

Private Key ID 
(private_key_id)

The value that corresponds with the private_key_id 
parameter in the JSON file. For example, 
8347eb542980d21e0c22a3bd6cc577ce0ac3a1a1.

Keystore 
Password

The password that you used when you created the Java Keystore (JKS) file 
in a previous step.

Keystore Select the JKS file you created in a previous step.

5. Click Create and Get OAuth Token.

Create a Virtual Agent  Bot Interconnect  shell topic to call Google Dialogflow  topics

To access topics in the Google Dialogflow  secondary bot, you must create at least one Virtual 
Agent  Bot Interconnect  topic.

Before you begin
Create one or more intents in Google Dialogflow. For details, refer to the Dialogflow 
documentation .

Configure connections to Google Dialogflow in your Virtual Agent Bot Interconnect instance.

Role required: virtual_agent_admin or admin

About this task
There are two ways to integrate Google Dialogflow  intents with Bot Interconnect

• Create one Virtual Agent  Bot Interconnect  topic per Dialogflow intent.

In case of NLU topics, each Virtual Agent  topic has the same name as a single Dialogflow 
intent. For example, if you have two Dialogflow intents named order a drink  and book a ticket, 
then you would create two Virtual Agent  topics also named order a drink  and book a ticket.

In case of LLM topics, each Bot Interconnect  topic has the same name and description as the 
corresponding Google Dialogflow  topic.

• Map multiple Dialogflow intents to a single Virtual Agent  Bot Interconnect  topic. This scenario 
is applicable only for NLU topics.

Create a Virtual Agent  topic for your Dialogflow intents and name it accordingly. For example, 
DG ordering issues. In this scenario, the Dialogflow intents are mapped to the topic as either 
keywords or utterances, depending on your method of topic discovery. So if you have two 
Dialogflow intents named order a drink  and book a ticket, you would add both phrases to the 
topic as keywords or you would add them as utterances to the topic's corresponding intent.

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer.

2. Create a topic  for your Dialogflow intents.
In case of NLU topics, include the Dialogflow intent names as either keywords or utterances in 
the corresponding ServiceNow  Virtual Agent  intent. In case of LLM topics, the topic name and 
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description of the Bot Interconnect  topic should match the topic name and description of the 
Google Dialogflow  topic.

3. On the Flow  tab, drag a Topic Block utility node onto the canvas.

4. Select the node, and then fill in the form as follows:

Topic Block Properties form

Property Description

Topic Block Select Bot Interconnect  topic block for NLU topics and Bot Interconnect - LLM 
topic block for LLM topics.

Action 
Name

Enter: 
sn_va_bot_ic.dialogflow_bot_interconnect_integration

Action Type Enter subflow.

5. Click Save.

6. Click Publish.

What to do next
Test your configuration. You can execute the topics that are available in the secondary bot from 
channels where Bot Interconnect  is deployed.

Using Microsoft  Power Virtual Agents as a secondary bot with Virtual Agent  Bot Interconnect

With Bot Interconnect, you can use ServiceNow®  Virtual Agent  as the primary bot with a 
Microsoft  Power Virtual Agents secondary bot. All of the skills and topics available to Power 
Virtual Agents are made available to and executable from channels that are configured for 
ServiceNow®  Bot Interconnect.

Prerequisites

This bot configuration requires the following:

• A Washington DC  ServiceNow  instance

• Virtual Agent  Bot Interconnect  Store application

• A Microsoft  Power Virtual Agents account for testing

Create a JavaScript function in Microsoft Azure  using Visual Studio Code

To use Power Virtual Agents with Virtual Agent  Bot Interconnect, you must create a JavaScript 
function in Microsoft Azure  using the sample code files in Bot Interconnect.

Before you begin
You will need a Microsoft Azure  account.

Role required: admin

Procedure

1. Sign into Microsoft Azure  and create a JavaScript function.
This involves configuring your environment and creating a local project. Refer to the Microsoft 
documentation  for details.

2. Go to Create an Azure Function for Microsoft Power Virtual Agents as Secondary bot with 
ServiceNow Bot Interconnect setup (KB1112368) , and then do the following:
You are required to login to the Support portal to access the knowledge article.
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a. Copy the code in the index.txt  file in the Attachments section into the index.js  file in 
your Azure project.

b. Copy the code in the function.txt  file in the Attachments section into the 
function.json  file in your Azure project.

c. Save both files.

3. Install the request-promise  libraries.

a. In a command line window, change directories to the folder where you created the Azure 
project.
For example, enter cd DemoAzureFunction.

b. At the prompt, enter: npm install --save request

c. At the prompt, enter: npm install --save request-promise

The dependencies are added to the package.json  file in your project.

4. Deploy the project to Azure as described in the Microsoft  documentation .

5. From the Azure portal, navigate to All Resources.

6. Select the name of the function app that you created.

7. On the Overview page, select the function you've created in the Functions tab, and copy the 
function URL from the Get function URL option.

The Azure function URL will be used as the secondary bot endpoint in your ServiceNow 
instance.
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Locate and copy the Direct Line secret key in Microsoft  Power Virtual Agents

To use Power Virtual Agents with Virtual Agent  Bot Interconnect, you must locate and copy the 
Direct Line security key in your Power Virtual Agents account.

Before you begin
You must have a Microsoft  Power Virtual Agents account with at least one bot.

Create a JavaScript function in Microsoft Azure using Visual Studio Code.

Role required: admin

Procedure

1. Log into your Microsoft  Power Virtual Agents account.

2. Navigate to Manage  > Security.

3. Click the Web channel security  tile.

4. In the popover window, click Copy  under Secret 1.

Add the Direct Line secret key to your Virtual Agent  Bot Interconnect  instance

To use Power Virtual Agents with Virtual Agent  Bot Interconnect, you must add the Direct Line 
security key as a credential in your Bot Interconnect  instance.

Before you begin
Locate and copy the Direct Line secret key in Microsoft Power Virtual Agents.

Role required: admin

Procedure

1. Navigate to All  > Connections & Credentials  > Connection & Credential Aliases.

2. Click the Bot Interconnect DirectLine Credentials  record to open it.

3. On the Credentials related list, click New.
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4. When prompted for the type of credential to create, click Bot Interconnect Static Token 
Credential.

5. On the form, fill in the fields as follows:

Field Description

Name Any unique name for the credential, such as Power VA Direct Line key.

Header Leave as Authorization.

Static 
Token

Enter Bearer , with a white space, followed by the Direct Line secret key from 
Power Virtual Agents.

For example, enter:

Bearer 
 4km3D8s_6lY.rDVmxVm3k123nWibx3ciJeed2AKled9_ADuwsaN5
uCA

6. Click Submit.

7. Return to All  > Connections & Credentials  > Connection & Credential Aliases.

8. Click the Bot Interconnect DirectLine Fetch Msgs  record to open it.

9. Under Related Links, click Create New Connection & Credential.

10. In the dialog box, fill in the form.

Field Description

Secondary Bot 
Name

Any unique name that refers to the Power Virtual Agents bot.

Secondary Bot 
Endpoint

The Azure function URL that you copied in a previous step.

For example, enter https://
demoazurefunctionreceivemsgapp.azurewebsites.net.

Header Enter: dlsecret

Static Token The Direct Line key that you copied from Power Virtual Agents in the 
previous step.

11. Click Create.

Create a Virtual Agent  Bot Interconnect shell topic to call Microsoft  Power Virtual Agents 
topics

To access topics in the Power Virtual Agents secondary bot, you must create at least one Virtual 
Agent  Bot Interconnect  topic.

Before you begin
Create one or more topics in Microsoft  Power Virtual Agents.

Add the Direct Line secret key to your Virtual Agent Bot Interconnect instance.

Role required: virtual_agent_admin or admin
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About this task
There are two ways to integrate Microsoft  Power Virtual Agents topics with Bot Interconnect:

• Create one Virtual Agent  Bot Interconnect  topic per Power Virtual Agents topic.

In case of NLU topics, each Virtual Agent  topic has the same name as a single Power Virtual 
Agents topic. For example, if you have two Power Virtual Agents topics named order a drink 
and book a ticket, then you would create two Virtual Agent  topics also named order a drink 
and book a ticket.

In case of LLM topics, each Bot Interconnect  topic has the same name and description as the 
corresponding Power Virtual Agents topic.

• Map multiple Power Virtual Agents topics to a single Virtual Agent  Bot Interconnect  topic. This 
scenario is applicable only for NLU topics.

Create one Virtual Agent  topic for your Power Virtual Agents topics and name it accordingly. 
For example, PVA ordering issues. In this scenario, the Power Virtual Agents topics are 
mapped to the topic as either keywords or utterances, depending on your method of topic 
discovery. So if you have two Power Virtual Agents topics named order a drink  and book 
a ticket, you would add both phrases to the topic as keywords or you would add them as 
utterances to the topic's corresponding intent.

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer.

2. Create a topic  for your Power Virtual Agents topics.
In case of NLU topics, include the Power Virtual Agents topic names as either keywords or 
utterances in the corresponding ServiceNow  Virtual Agent  intent. In case of LLM topics, the 
topic name and description of the Bot Interconnect  topic should match the topic name and 
description of the Power Virtual Agents topic.

3. On the Flow  tab, drag a Topic Block utility node onto the canvas.

4. Select the node, and then fill in the form as follows:

Topic Block Properties form

Property Description

Topic 
Block

Select Bot Interconnect  topic block for NLU topics and Bot Interconnect - LLM  topic 
block for LLM topics.

Action 
Name

Enter: 
sn_va_bot_ic.direct_line_bot_interconnect_integration_handler

Action 
Type

Enter subflow.

Additional 
Params 
(String)

Follow these steps:

a. Click the script icon 

b. In the Additional Params (String) window, add this code:

(function execute() {
    return JSON.stringify({'quick': false});
})()

c. Click Save.
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5. Click Save.

6. Click Publish.

What to do next
Test your configuration. You can execute the topics that are available in the secondary bot from 
channels where Bot Interconnect  is deployed.

Note: 
Conversations always remain open in Power Virtual Agents.

Using ServiceNow  Virtual Agent  as a secondary bot with Virtual Agent  Bot Interconnect

Virtual Agent  Bot Interconnect  enables you to use ServiceNow®  Virtual Agent  as the primary bot 
with a ServiceNow  Virtual Agent  secondary bot.

Prerequisites

In order to configure ServiceNow  Virtual Agent  as a secondary bot with Virtual Agent  Bot 
Interconnect, you require the following setup:

• Two Washington DC  ServiceNow  instances.

• On the primary instance: Virtual Agent  Bot Interconnect  Store application

• On the secondary instance:

◦ Virtual Agent  API v3.8.x or later

◦ Virtual Agent  API on the secondary instance must be in synchronous mode or asynchronous 
mode.

Use ServiceNow  Virtual Agent  as a secondary bot in synchronous or asynchronous mode

Use ServiceNow  Virtual Agent  as a secondary bot in synchronous or asynchronous mode with 
Bot Interconnect.

You can use ServiceNow  Virtual Agent  as a secondary bot in synchronous or asynchronous 
mode. See Enable synchronous mode on the secondary ServiceNow Virtual Agent instance  or 
Enable asynchronous mode on the secondary ServiceNow Virtual Agent instance.

Enable synchronous mode on the secondary ServiceNow  Virtual Agent  instance

Enable synchronous mode on the secondary ServiceNow  Virtual Agent  instance to use 
ServiceNow®  Virtual Agent  as a secondary bot with Virtual Agent  Bot Interconnect.

Before you begin
Role required: admin

Procedure

1. On the secondary instance, navigate to All, and then enter sys_cs_channel.list  in the 
navigation filter.

2. Select the Bot to Bot record.

3. Select the Synchronous  check box.

4. Click Update.

Enable asynchronous mode on the secondary ServiceNow  Virtual Agent  instance

Enable asynchronous mode on the secondary ServiceNow  Virtual Agent  instance to use 
ServiceNow®  Virtual Agent  as a secondary bot with Virtual Agent  Bot Interconnect.
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Before you begin
Role required: admin

Procedure

1. On the secondary bot instance, navigate to All  > System Web Services  > Outbound  > REST 
Message.

2. Select the VA Bot to Bot record.

3. In the Endpoint field, specify the outbound endpoint URL of the primary ServiceNow®  instance 
to which the Virtual Agent  responses are posted. http://<primary instance>/api/
sn_va_bot_ic/bot_interconnect/va_api_response

4. In the Authentication tab, set the Authentication type field to either Basic or OAuth 2.0.
For more information on configuring a basic authentication profile and OAuth 2.0 profile, 
see Configure a REST message with basic auth and Configure a REST message with OAuth 
respectively.

5. Click Update.

6. In the HTTP Methods section, select the postMessage method and specify the endpoint URL. 
http://<primary instance>/api/sn_va_bot_ic/bot_interconnect/
va_api_response

7. Click Update.

Create a connection and credential in Virtual Agent  Bot Interconnect

To use ServiceNow®  Virtual Agent  as a secondary bot with Virtual Agent  Bot Interconnect, 
configure the connection and credential records in the Bot Interconnect  (primary) instance.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Connections & Credentials  > Connection & Credential Aliases.

2. Click the Bot Interconnect VA API Integration  record to open it.

3. In the Connections related list, click New.

4. On the form, fill in the fields.

Field Description

Name Enter a unique name, such as SNow Secondary Bot.

Credential Leave this blank for now.

Connection 
alias

Use the default value.

Connection 
URL

Enter the URL for Virtual Agent  API on your secondary instance. For example, 
enter https://secondary-instance-name.service-now.com/
api/sn_va_as_service/bot/integration.

5. Click Submit.

6. Navigate to All  > Connections & Credentials  > Credentials.

7. On the Credentials page, click New.
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8. Click either Bot Interconnect Hash Token Credential  or Bot Interconnect Static Token 
Credential  as the type.

9. On the form, fill in the fields.

Field Description

Name Enter a unique name for the credential. For example, 
SNowSecondaryBotToken.

Static token

Header Enter Token.

Static Token Enter a password.

Hash token

Header Enter x-b2b-signature.

Algorithm Select HmacSHA1.

Hash Secret Enter the hash secret.

Authorization 
Algorithm

Select the algorithm to use. For example, Secondary Bot Hash Token 
Auth.

10. Click Submit.

11. Navigate to All  > Connections & Credentials  > Connection & Credential Aliases.

12. Click the Bot Interconnect VA API Integration  record to open it.

13. In the Connections related list, open the new connection record you created in an earlier step.

14. In the Credential  field, enter the name of the record that contains the static token or hash 
token.
For example, SNowSecondaryBotToken.
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Connection and credential record in the ServiceNow  Bot Interconnect instance

15. Click Update.

Create a connection and credential in Virtual Agent  Bot Interconnect

Create a connection and credential in Virtual Agent  Bot Interconnect  (primary instance) to 
enable uploading of attachments in the secondary bot.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Connections & Credentials  > Connection & Credential Aliases.

2. Click the Bot Interconnect VA API Attachment  record to open it.

3. In the Connections related list, click New.

4. On the form, fill in the fields.

Field Description

Name Enter a unique name, such as SNowSecondaryBotAttachment.

Credential Leave this blank for now.

Connection 
alias

Use the default value.

Connection 
URL

Enter the URL of your secondary instance. For example, enter https://
secondary-instance-name.service-now.com/.
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5. Click Submit.

6. Navigate to All  > Connections & Credentials  > Credentials.

7. On the Credentials page, click New.

8. Click either Basic Auth Credentials  or OAuth 2.0 Credentials  as the type.

9. On the form, fill in the fields.

Field Description

Name Enter a unique name for the credential. For example, 
SNowSecondaryBotAttachmentToken.

Basic Auth Credentials

Username Enter the username you want to send as basic authentication credential..

Password Enter the password you want to send as basic authentication credential.

OAuth 2.0 Credentials

OAuth Entity 
Profile

In the OAuth profile field, select the OAuth 2.0 profile that specifies the 
credentials you want to send.

10. Click Submit.

11. Navigate to All  > Connections & Credentials  > Connection & Credential Aliases.

12. Click the Bot Interconnect VA API Attachment  record to open it.

13. In the Connections related list, open the new connection record you created in an earlier step.

14. In the Credential  field, enter the name of the record that contains the static token or hash 
token.
For example, SNowSecondaryBotAttachmentToken.

Connection and credential record in the ServiceNow  Bot Interconnect instance

15. Click Update.
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Create an auth token in the ServiceNow  secondary instance

To use ServiceNow®  Virtual Agent  as a secondary bot with Virtual Agent  Bot Interconnect, create 
an authentication token in the secondary instance.

Before you begin
Create a connection and credential in Virtual Agent Bot Interconnect.

Role required: admin

About this task
Ensure that the type of authentication (Static or Hash) and token or hash secret in the secondary 
instance is the same as the type and token or hash secret in the Bot Interconnect  instance.

Procedure

1. Navigate to All, and then enter token_verification.list  in the filter.

2. On the Token Verifications page, click New.

3. On the form, fill in the fields.

Token Verification form

Field Description

Name A unique name for the authentication token, such as SNSecondaryBotToken.

Token The static token or hash secret you provided in the Bot Interconnect  (primary) 
instance.

4. Click Submit.

5. Navigate to All, and then enter message_auth.list  in the filter.

6. On the Message Auth page, click New.

7. On the form, fill in the fields.

Message Auth form

Field Description

Name Name of the message authentication, such as SNtoSNAuthtoken.

Provider Name of the provider, such as ServiceNowProvider.

Group 
name

Name used to classify the provider.

Service 
Portal

Set this field to link users on Virtual Agent  integrations such as Slack  and 
Microsoft Teams  to a service portal login page. If the field is empty, Virtual Agent 
redirects the users to the instance login page.

Inbound 
message 
verification

The name of the authentication token you created in the secondary instance. 
For example, SNSecondaryBotToken.

Outbound 
message 
creation

The name of the authentication token you created in the secondary instance. 
For example, SNSecondaryBotToken.
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Field Description

Outbound 
service 
token

The name of the authentication token you created in the secondary instance. 
For example, SNSecondaryBotToken.

8. Click Submit.

9. Navigate to All, and then enter sys_cs_provider_application.list  in the filter.

10. Open the VA Bot to Bot Provider Application record.

11. In the Message auth  field, select the name of the message authentication record you created.
For example, select SNtoSNAuthtoken.

12. Click Update.

Create a Virtual Agent  Bot Interconnect  shell topic to call Virtual Agent  secondary topics

To use ServiceNow®  Virtual Agent  as a secondary bot with Virtual Agent  Bot Interconnect, you 
must create at least one shell topic in Bot Interconnect.

Before you begin
Create and publish topics in the secondary instance of ServiceNow  Virtual Agent.

Enable synchronous or asynchronous mode on the secondary ServiceNow  Virtual Agent 
instance.

Role required: virtual_agent_admin or admin

About this task
There are two ways to integrate secondary Virtual Agent  topics with Bot Interconnect:

• Create one Virtual Agent  Bot Interconnect  topic per secondary Virtual Agent  topic.

In case of NLU topics, each Bot Interconnect  topic has the same name as the corresponding 
secondary Virtual Agent  topic. For example, if you have two secondary Virtual Agent  topics 
named order a drink  and book a ticket, then you would create two Virtual Agent  Bot 
Interconnect  topics also named order a drink  and book a ticket.

In case of LLM topics, each Bot Interconnect  topic has the same name and description as the 
corresponding secondary Virtual Agent  topic.

• Map multiple secondary Virtual Agent  topics to a single Virtual Agent  Bot Interconnect  topic. 
This scenario is applicable only for NLU topics.

Create one Virtual Agent  Bot Interconnect  topic and name it accordingly. For example, SVA 
ordering issues. In this scenario, the secondary Virtual Agent  topics are mapped to the Bot 
Interconnect  shell topic as either keywords or utterances, depending on your method of topic 
discovery. So if you have two secondary Virtual Agent  topics named order a drink  and book 
a ticket, you would add both phrases to the Bot Interconnect  topic as keywords or you would 
add them as utterances to the Bot Interconnect  topic's corresponding intent.

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer.

2. Create a topic  in your primary instance of Virtual Agent.
In case of NLU topics, include the secondary Virtual Agent  topic names as either keywords or 
utterances in the corresponding Bot Interconnect  intent. In case of LLM topics, the topic name 
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and description of the Bot Interconnect  topic should match the topic name and description of 
the secondary Virtual Agent  topic.

3. On the Flow  tab, drag a Topic Block utility node onto the canvas.

4. Select the node, and then fill in the form as follows:

Topic Block Properties form

Property Description

Topic Block Select Bot Interconnect  topic block for NLU topics and Bot Interconnect - LLM  topic block 
for LLM topics.

Action 
Name

◦ If the secondary bot is configured in synchronous mode, enter 
sn_va_bot_ic.va_api_bot_interconnect_integration_handler

◦ If the secondary bot is configured in asynchronous mode, enter 
sn_va_bot_ic.va_api_bot_interconnect_async_integration_handler

Action Type Enter subflow.

Async 
Response 
Transformer

If the secondary bot is configured in asynchronous mode, enter 
sn_va_bot_ic.va_api_bot_interconnect_async_response_handler

5. Click Save.

6. Click Publish.

Enable live agent connection on the primary instance

Enable live agent connection on the primary instance to route an interaction to a live agent on 
the secondary instance.

Before you begin
Be sure to enable com.glide.cs.external.agent.chat.enabled  system property. 
It’s not enabled by default.

Role required: admin or virtual_agent_admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Live Agent Connections.

2. Select New  to create a connection.

3. On the form, fill in the fields.

Live Agent Connection form fields

Field Description

Name Name of the connection

Active Check box to enable the connection

Order If there are multiple matching live agent 
connections, the value entered in this field 
determines the order in which the matching 
connections are displayed to the user.
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Field Description

Advanced Selecting this check box opens the Script 
field. You can specify conditions using 
JavaScript in the script editor.

Condition Table Table used for selecting the matching 
condition. Interaction  table is selected by 
default.

Matching Condition Conditions to route the interaction to this live 
agent connection. Use the condition builder 
to add conditions. The fields used in the 
condition are from the Interaction table.

Script JavaScript script that specifies the conditions 
for the interaction to be routed to this live 
agent connection. The condition in the script 
editor must evaluate to true. This field is 
enabled only when you select the Advanced 
check box.

Subflow Subflow transforms the request into the 
secondary instance request format and 
routes the request to the secondary instance. 
Select VA API Bot Interconnect Integration 
Handler.

4. Click Submit.

Debug Virtual Agent  Bot Interconnect  with a ServiceNow  Virtual Agent  secondary bot

Debug Flow Designer executions of your Virtual Agent  Bot Interconnect  and Virtual Agent 
secondary bot integration.

Before you begin
Enable the following system properties:

• sn_va_bot_ic.bot_interconnect.enable.logging  = true

• glide.outbound_http_log.override  = true

• glide.outbound_http_log.override.level  = all

For more information, see Add a system property .

Role required: admin
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Procedure

1. In the Bot Interconnect  instance, modify the shell topic you created in Virtual Agent:

a. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer.

b. Open the shell topic you created in a previous step.

c. On the Flow  tab, select the Bot Interconnect Topic Block.

d. In the Additional Params (String)  field, click the Script icon ( ), and then add the following 
code:

(function execute() {
  return JSON.stringify({quick: false});
})()

e. Click Save.

f. Save the topic.

2. Enable execution context debugging in Flow Designer.

a. Navigate to All  > Process Automation  > Process Automation Designer  > Flow 
Administration  > Settings.

b. On the Settings page, click New.

c. In the Flow/Subflow/Action  field, click the Search icon ( ).

d. On the Select the document form, fill in the fields.
Add the following Flow Designer document settings if your secondary bot is in synchronous 
mode.

Add the following Flow Designer document settings if your secondary bot is in asynchronous 
mode.
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e. Click Ok.

f. In the Reporting  field, select Developer Trace.

g. Click Submit.

Result
You can view additional logs and Flow Designer  executions for debugging purposes.

Localization options for Virtual Agent

The ServiceNow  platform provides several methods for serving your international Virtual Agent 
users, regardless of their language and locale. Professionally localize your conversations, use 
dynamic machine translation, or a combination of the two.

Direct and dynamic language support

If your chat audience is diverse, you want to support them in their own language whenever 
possible. One option is to localize everything professionally using linguists who can translate 
your topics into the desired languages. While this option produces the best user outcomes, it is 
often the most expensive. Another option available to you is language detection combined with 
dynamic machine translation. Instead of using translated topics and models, dynamic translation 
connects to a third-party machine translator. During the conversation, user utterances and 
responses are translated into the primary language on the instance, and all results are translated 
back into the user's language for the session. There are benefits and drawbacks for all options, 
as described in the following list. Before activating machine translations, you should carefully 
weigh the costs and benefits and set proper expectations for your deployment objectives.

Direct language support (professional localization)

A direct language strategy employs an expert linguist to configure entities, intents, 
strings, keywords, and vocabulary, which are then used to match user utterances 
with configured content. Since an expert provides translations that directly match 
the conversation's content, the accuracy of the translated content will be high. 
In addition to the translations themselves, experts can use the NLU vocabulary 
feature  to further define words and phrases that it may encounter from your users. 
For example, a user may enter an acronym such as MS, which you can define as the 
vocabulary item Microsoft.

Professional translations are implemented directly in Virtual Agent Designer. For 
details, see Localizing Virtual Agent conversations.
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Using translations from professional linguists and corresponding ServiceNow 
language plugins

Benefits Constraints

• More accurate translations

• For supported languages, NLU intents 
and entities are localized

• Requires more resources to build 
and maintain

• Longer completion time

• Higher implementation costs

• 5 languages have NLU intent and 
entity support

• 12 languages have NLU intent 
support only

• Increased coverage is not typically 
scalable

• Not easily extensible

For more information, see Language 
support for NLU services.

Dynamic language detection and machine translation

Dynamic machine translation relies on the translation service to translate all content 
in real time. The accuracy of the translations is dependent on the translation 
service. Although translation services typically leverage algorithms to translate 
words based on the context of the conversation or sentence, there may be times 
when there is minimal context for the algorithm to leverage. Accuracy may be 
diminished in this situation. Check with your translation service provider about 
the ability to exclude words from translation or associate vocabulary with specific 
synonyms.

Using dynamic translation with the supported ServiceNow  language plugins

Benefits Constraints

• Lower implementation costs

• Faster completion time

• Less human maintenance

• ServiceNow  provides 22 language 
plugins with basic translations

• Limited scalability

• Limited extensibility

• 5 languages have NLU intent and 
entity support

• 12 languages have NLU intent 
support only

For more information, see Language 
support for NLU services.

Dynamic machine translation for languages that are not supported on the 
ServiceNow  platform provides coverage, but the quality of the user experience may 
be lower.
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Using dynamic translation with unsupported languages

Benefits Constraints

• Lower implementation 
costs

• Faster completion time

• Less human maintenance

• Support for many 
languages

• Highly scalable

• Highly extensible

• User experience may vary

• Potential for mistranslation may reduce user 
outcomes

Multi-language deployment strategies

Depending on the needs of your user base, you may want a mix of solutions to maximize both 
user experience and access. For example, you may choose to professionally localize prioritized 
languages and dynamically translate others. For example, if 95% of your users speak six 
languages, you may decide to use a linguist to translate your topics into those six. You might then 
use Dynamic Translation  for the remaining five percent.

You can also enable locale support by designating translated languages as fallback languages. 
For example, you can support Mexican Spanish users by designating Spanish as the fallback 
language for that locale.

In the following example, French, German, and Spanish are professionally localized, including 
the NLU models, intents, and entities. This localized content provides the best user experience. 
Polish is supported as a language on the ServiceNow  platform, and when the plugin is installed 
and activated, it includes some translated content. In this imaginary scenario, the business 
decision was made to dynamically translate Polish content because it accounts for a smaller 
percentage of users. The quality of this experience may vary since NLU models are not localized. 
Instead, utterances are dynamically translated to English, and NLU topic discovery is run through 
the English model. Since Czech is currently not a supported language on the ServiceNow 
platform, dynamic machine translation is the only option. Admins can add Czech as a language 
and enable Dynamic Translation  for the language in Virtual Agent.
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Example language support strategy

Localization insights

You can view dynamic translation and localization insights from the Virtual Agent Designer 
page. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer, and then click 
Localization Insights.

For more information, see Localization Insights dashboard .

Using language detection and dynamic machine translation in Virtual Agent

Enable a combination of language detection and machine translation for Virtual Agent  to improve 
the chat experience for diverse users. You can designate fallback languages for locales or 
dynamically translate languages that are not professionally localized or are not supported in NLU 
topic discovery.

Chat users are more comfortable having conversations in their preferred language. For example, 
Virtual Agent  greets users in the preferred language specified in their user profile. But if a 
user types an utterance in another language, Virtual Agent  can detect the change and offer to 
continue the conversation in that language instead. But in many cases users don't have control 
over the session language, particularly if they are guest users. Guest conversations do not 
support language detection if resumable guest sessions are not enabled. This is why language 
detection and dynamic machine translation can improve the chat experience, particularly if 
you have conversations that have not been localized in some languages. For example, your 
organization may routinely localize into Spanish and French, but you may also want to support 
Dutch and Danish. You can enable Dynamic Translation  on your ServiceNow®  instance for those 
languages.

You can use language detection to support custom or locale-specific language codes as well. 
For example, NLU topic discovery doesn't support Mexican Spanish (es-mx), but it does support 
Spanish (es). You can designate Spanish as the fallback language for Mexican Spanish, ensuring 
that these users have a good customer experience.

When a language is enabled in Dynamic Translation, Virtual Agent  ignores all platform 
translations and uses the configured machine translation service instead. If some conversations 
have been professionally translated, you should disable dynamic translation for those specific 
languages. Expert translations of your NLU models, keywords, and topics may be more accurate 
and of higher quality than machine translations. Prior to making a dynamic translation call, 
the Text Translations for Dynamic Translation [sys_cs_dynamic_translation_text] and Message 
[sys_ui_message] tables are checked to see if the text has been previously translated or already 
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has a localization record. A dynamic translation call is only made if no translation exists in either 
table. After a dynamic translation call is made and that text is translated, that translated text is 
stored in the Text Translations for Dynamic Translation [sys_cs_dynamic_translation_text] table 
for future use. Storing previously translated text results in fewer dynamic translation calls to third-
party translation services. For more information about localizing Virtual Agent  conversations, see 
Localizing Virtual Agent conversations.

You can use Dynamic Translation  during the localization process as well. If you are localizing 
conversations with professional linguists, you can enable Dynamic Translation  while some topics 
and strings remain untranslated. When your deployment in that language is complete, you can 
disable Dynamic Translation, since professional translations are likely more accurate.

 Virtual Agent Academy: Dynamically translate languages in Virtual Agent  Watch this video 
for a demonstration of using Virtual Agent with Dynamic Translation.

Note: 
You can use language detection independently of Dynamic Translation.

Language detection and Dynamic Translation  process in Virtual Agent

When you enable language detection and Dynamic Translation  for Virtual Agent  for other 
languages, a variety of diverse users gain access to your Virtual Agent  chat environment.

The default system language on your instance is the same as the default language in Virtual 
Agent. It is also the primary language in your NLU model, if NLU is enabled. When a user types 
an utterance that is not recognized as the system language, the results depend upon your 
configuration for that language.

Language detection and Dynamic Translation  process

Language 
configuration

Results in Virtual Agent

Language 
detection 
and 
Dynamic 
Translation 
are not 
configured

For unlocalized conversations, the default system language is used for topics 
and topic discovery.

Language 
detection 
is enabled, 
but not 
Dynamic 
Translation

If the detected language is a locale or other language code that has been 
configured with a fallback language, Virtual Agent  asks the user if they want to 
switch the conversation to the fallback language.

For example, if the detected language is Mexican Spanish (mx-es), and Spanish 
(es) has been designated as the fallback language, Virtual Agent  asks: Would 
you like to switch the conversation to Spanish? (Yes/
No)

If the user selects Yes, the fallback language is used for topic discovery and topic 
display. This continues until the conversation ends.

If the user selects No, Virtual Agent  will not prompt them again during the 
conversation.
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Language detection and Dynamic Translation  process  (continued)

Language 
configuration

Results in Virtual Agent

Language 
detection 
and 
Dynamic 
Translation 
are enabled

If the detected language is enabled for dynamic translation in Virtual Agent  Chat 
Settings, Virtual Agent  asks the user if they want to switch the conversation to 
their preferred language.

For example: Would you like to switch the conversation to 
Danish? (Yes/No)

If the user selects Yes, the utterance is translated to the default language in 
Virtual Agent. This process uses the machine translation software that was 
configured in Dynamic Translation. Topic discovery, whether keyword or NLU, is 
done in the default language. All topic matches are translated dynamically into 
the user's conversation language and displayed. Virtual Agent  will continue in 
that language, including expecting the user to continue typing their utterances 
in that language. Once the conversation is ended, Virtual Agent  uses the default 
language in the next session.

If the user selects No, Virtual Agent  will not prompt them again during the 
conversation.

Virtual Agent  detects an utterance in a different language

The language detection and dynamic machine translation process operates according to the 
following principles:

• Language detection occurs only once per conversation.

If a user tries to change the language in the middle of a conversation, Virtual Agent  returns an 
I didn't understand  message.

• When the conversation is closed, the primary language is restored in the next session.
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• If a user's detected language is the same as the primary language, the user is not asked to 
switch languages.

• If a user's detected language has no fallback language specified and dynamic translation is 
not enabled for it, the conversation continues in the primary language.

• If a user's detected language is not activated on the instance, the conversation continues in 
the primary language. For more information, see Activate a language .

Note: 
AI Search  results are not translated.

Dynamic Translation  and Agent Chat

If Dynamic Translation  is enabled on Virtual Agent  but turned off for Agent Chat, the live agent 
will see what the user sees. If the user started the conversation in another language and chose 
to switch when prompted, then the live agent will see the conversation in the user's chosen 
language. This may cause some confusion for both the agent and the customer. To resolve 
this issue, consider turning on Dynamic Translation  for Agent Chat  as well. For details, see 
Configuring Dynamic Translation for Agent Chat.

Supported languages

For better results, install the ServiceNow  language plugins for each language that uses dynamic 
translation. For a detailed list of language plugins, see Activate a language .

You can enable dynamic translation for languages that are not currently supported on the 
ServiceNow  platform. For details, see Enable Dynamic Translation for an unsupported language.

Supported channels

Dynamic Translation  for Virtual Agent  is currently supported in the following channels:

• ServiceNow  web client

• Microsoft Teams

• Slack

• Workplace from Facebook

• Facebook Messenger

Note: 
The Virtual Agent  topic test window may identify user utterances from Microsoft Teams 
or other adapters as sysparm_search_text. Dynamic Translation  will translate this 
content as well.

The following channels do not support Dynamic Translation  for Virtual Agent:

• ServiceNow  mobile client

• WhatsApp

• LINE

• Twilio  SMS

• Alexa

• Google Assistant

• Siri
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Prerequisites for using Dynamic Translation  in Virtual Agent

To enable dynamic machine translation, install ServiceNow®  language plugins and Dynamic 
Translation  plugins. Then configure Dynamic Translation  for your instance.

Before you can enable dynamic machine translation  for a language, you must install and 
configure Dynamic Translation  on your instance.

1. As an admin, install the following plugins:

◦ Glide Virtual Agent  (com.glide.cs.chatbot)

◦ Dynamic Translation  for Virtual Agent  (com.glide.cs.dynamic.translation.virtual_agent)

2. Activate language plugins  for each language that you want to deploy with dynamic 
translation.

Note: 
Languages for Dynamic Translation  are stored in the 
sys_cs_dynamic_translation_virtual_agent table.

3. Enable NLU languages in Virtual Agent settings, if you are using NLU topic discovery.

Note: 
NLU  detection and discovery values are stored in the sys_cs_general_settings table. As of 
Vancouver, ServiceNow NLU is the available NLU  driver.

The following translation service providers are pre-configured once the plugins are installed:

• Microsoft Azure

• Google Translate

Configuring other translation service providers

You can configure any other translation service provider in the Dynamic Translation  application 
as follows:

1. Integrate with a translation service provider .

2. Create a translator configuration in Dynamic Translation .

3. (Optional) Create a language code mapping  to map translator language codes to the 
ServiceNow®  language codes.

Next step

Configure Dynamic Translation service integration credentials

Configure Dynamic Translation  service integration credentials

Configure the credential and connection for your translation service.

Before you begin
Complete the prerequisites for using Dynamic Translation in Virtual Agent.

Role required: admin
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Procedure

1. Create a credential for the translator service alias.
For detailed information, see the following topics:

◦ Create a credential for the MicrosoftTranslation alias

◦ Configure the credential for the GoogleTranslation alias

2. Create a connection for the translator service alias.
For detailed information, see the following topics:

◦ Create a connection for the MicrosoftTranslation alias

◦ Configure the connection attributes for the GoogleTranslation alias

What to do next
Activate your translation service in Dynamic Translation

Activate your translation service in Dynamic Translation

Activate your preferred Dynamic Translation  provider and mark it as the default service for both 
translation and language detection.

Before you begin
Complete the prerequisites for using Dynamic Translation in Virtual Agent.

Configure Dynamic Translation service integration credentials.

Role required: admin

Procedure

1. Navigate to All  > Dynamic Translation  > Translator Configurations.

2. Select the name of the translation service to open the record.

3. On the Translator Configuration form, select the Active  check box.

4. On the Preferences tab, select Mark as default for translation.

5. On the Preferences tab, select Mark as default for detection.

6. Select Update.

What to do next
Enable Dynamic Translation for languages in Virtual Agent

Enable Dynamic Translation  for languages in Virtual Agent

Enable Dynamic Translation  for one or more languages in Chat Settings for Virtual Agent.

Before you begin
Install and configure the plugins for Dynamic Translation, as described in Prerequisites for using 
Dynamic Translation in Virtual Agent. If these prerequisites aren’t completed, the Multi language 
support card described in the following steps doesn’t appear.

Role required: virtual_agent_admin or admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. Select Virtual Agent.

3. On the Multi language support card, do the following:
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a. Slide the Language Detection  toggle switch to enable it.

b. Slide the Dynamic language translation  toggle switch to enable it.

c. Select View All.
The Multi-language support page opens. All languages that are installed on the instance are 
listed.

4. In the Dynamic Translation Enabled  column, select false  for the language you want to enable.

a. If prompted, select Edit record.

b. Select Dynamic Translation Enabled.

c. Select Update.

d. Return to the Multi-language support page and repeat these steps for any other language 
you want to enable.

5. Optional:  Enable language detection for guest users.
If this system property is set to off, Dynamic Translation  will not work for guest users.

a. Navigate to All, and then enter sys_properties.list  in the filter.

b. In the Name  field, search for com.glide.cs.guest_session_resumable.
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c. In the Value  column, change the setting to true.

Enable Dynamic Translation  for an unsupported language

The ServiceNow®  platform supports several languages, but you can enable dynamic machine 
translation for additional languages in Virtual Agent.

Before you begin
Install and configure the plugins for Dynamic Translation, as described in Prerequisites for using 
Dynamic Translation in Virtual Agent.

Role required: virtual_agent_admin or admin

About this task
You can configure Dynamic Translation  for any installed language plugin on the ServiceNow® 

platform. Once installed, the language is available for configuration in the Multi language support 
card in Virtual Agent  Chat Settings. But if you want to support a language that doesn't have a 
plugin, you can add it to the Languages [sys_language] table. Once added, you can enable 
dynamic machine translation for that language.

For more information about multi-language support options and their tradeoffs, see Localization 
options for Virtual Agent. For more information about custom localizations, see Custom 
translations .

Procedure

1. Navigate to All, and then enter sys_language.list  in the filter.

2. On the Languages page, click New.

3. On the form, fill in the fields.

Field Description

Name Name and locale of the language, if applicable. For example, Spanish (Mexican).

Active Check box indicating that the language is enabled on the instance.

ID The BCP 47  code for the language. For example, es-MX.

Text 
Direction

Direction of text for the language. Options are Left-to-Right  or Right-to-Left.

Fallback Language to be used if a translation is not available. The language plugin must 
be installed on the instance and activated for NLU, if you are using NLU topic 
discovery.
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Field Description

For example, if the language is Mexican Spanish, you can specify Spanish  as the 
fallback language.

4. Click Submit.

5. Optional:  For a better user experience, translate some of the Virtual Agent  system messages 
into the new language.

a. Navigate to All, and then enter sys_ui_message.list  in the filter.

b. Translate the following Keys:

▪ Are you sure you want to end the current conversation?

▪ Click here to start a new conversation

▪ Close contact options

▪ [language name] (for example, English  or German)

▪ Disable audio notifications

▪ End conversation

▪ I have detected you are typing in {0}. Would you like to continue the conversation in {0}?​

▪ Just now

▪ No

▪ No Chat Agents Currently Available

▪ Please pick an option.

▪ Please type your request

▪ Please type your response here

▪ Send

▪ Start a new conversation

▪ Start typing to filter the list of topics below...

▪ Support options

▪ Yes

Note: 
If you specify a supported fallback language for the language you're adding, you do 
not need to translate Keys in the Messages table. For example, if you add Mexican 
Spanish as a language, you can specify Spanish as the fallback language. The 
Spanish language plugin already contains translations of these messages. For more 
information, see Specify a fallback language for locale-specific languages and NLU 
prediction.

6. When the languages have been added, enable Dynamic Translation for them in Virtual Agent 
settings.

Specify a fallback language for locale-specific languages and NLU prediction

Provide language locale support by specifying a fallback language for Virtual Agent  to use for 
topics, keywords, and NLU prediction. For example, the ServiceNow®  platform doesn't support 
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Mexican Spanish (mx-es), but it does support Spanish (es), which you can designate as the 
fallback language for a better user experience.

Before you begin
The fallback language plugin must be installed on the instance. Once installed, the language will 
be available in the Languages [sys_language] table.

Role required: virtual_agent_admin or admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. Select Virtual Agent.

3. On the Multi language support card, slide the Language Detection  toggle switch to enable it.

4. Select View All.

5. Select the name of a language to open the record.

6. Select Edit Record  at the top of the page.

7. In the Fallback  field, click the Search icon ( ) and select an available language.

8. Click Update.

Result
Custom locales appear in the Languages [sys_language] table, along with their fallback 
language. The language code (ID) indicates a language that Virtual Agent  can detect. In the 
following example, three French locales use French as the fallback language. Only French 
Canadian remains unconfigured.
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Localizing Virtual Agent  conversations

The ServiceNow  platform provides several methods for localizing Virtual Agent  conversations, 
depending on your needs. Use the Localization Framework  to manage all aspects of the 
translation process, whether you are using machine translation, a third-party provider, or both.

Use the ServiceNow  Localization Framework  to standardize and track the translation process for 
Virtual Agent  topics. The framework enables you to define the business process for translating 
your conversations. Use it to configure the following:

• How localization requests are fulfilled.

Options include machine translation, a translation management system (TMS), and exporting 
and importing files.

• Who is responsible for each step in the process.

Virtual Agent  uses the following roles:

◦ Localization requestor

◦ Localization fulfiller

◦ Localization editor

• Business rules for the process:

◦ Auto translation and publication

◦ Approval required for translation and publication

To learn more, see Localization Framework . To learn more about localization roles, see 
Localization roles for Virtual Agent.
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Localizing topics

The localization process flow depends on the method of topic discovery that you are using for 
your topics. There are two main types of topic discovery:

• keyword topic discovery

When you use the Localization Framework, the chat conversation and the keywords associated 
with the topic are translated.

• Natural Language Understanding  (NLU) topic discovery

If your topics use NLU, both the topic and the model group must be localized. When you 
request a translation from Virtual Agent Designer, the topic and any optional keywords are 
translated. You must request translation for model groups from NLU Workbench. For more 
information about that process, see Translate a multilingual model .

Once the topic and secondary models are localized, you may need to map the models to the 
topic  before publishing them.

Prerequisites

Important: 
Currently, translatable strings such as topic text and bot responses cannot contain 
embedded quotes. Strings that contain embedded quotes cannot be localized.

Do the following before you begin managing translations:

• Activate the ServiceNow  plugin for each language you want to support.

The Localization Framework  is also installed by default. For more information, see Activate a 
language .

• Configure the translation mode that you want to use in the Localization Framework.

You can configure machine translation, a translation management system (TMS), or send via 
email. For more information, see Translation modes .

• If you are using Natural Language Understanding  (NLU), enable languages in Virtual Agent 
settings.

For more information, see Enable NLU languages in Virtual Agent settings.

• If necessary, add secondary languages to your NLU  model group. For more information, see 
Multilingual model management .

• Assign localization roles to team member groups.

Users are assigned different roles based on their responsibilities for the translation process. 
For more information, see Localization roles for Virtual Agent.

Manage languages by model

If NLU is enabled for your instance, you can view and manage translations by model and 
language. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer, and then click 
Manage languages. Choose a model and a language, and then you can do the following:

• View translation status

• Request translations
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• View or edit translations

• Test translations

Click Manage NLU translations  for easy access to the model management page in NLU 
Workbench.

For more information, see Localize Virtual Agent topics that use NLU topic discovery.

Enable NLU languages in Virtual Agent  settings

If you plan to use language-specific NLU models, you must enable the installed languages in 
the Supported NLU Languages list. A language is enabled if the Enabled  column displays true. 
English language is enabled by default.

Before you begin
Activate the ServiceNow  plugin for each language you want to support. For more information, see 
Activate a language .

Role required: virtual_agent_admin or admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. Click Virtual Agent.

3. Under Natural Language Understanding (NLU), click View settings.

4. Find the languages in the Supported NLU Languages list.

5. If the Enabled column displays false  for a language, select the link to open the language NLU 
properties.
For example, in the following image, German, Portuguese, and Japanese are not enabled.

6. Select the Enabled  check box.

7. Click Save.
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Localize Virtual Agent  topics that use keyword topic discovery

Use the ServiceNow  Localization Framework  to manage the process of localizing Virtual Agent 
conversations and keywords.

Before you begin
Check the prerequisites for translating Virtual Agent  components. For more information, see 
Localizing Virtual Agent conversations.

Make sure that your Virtual Agent topics are published and performing the way you want them to. 
Make any adjustments before you send them to localization.

Role required: virtual_agent_admin or admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer.

2. Open the topic that you want to translate.

3. Click the Languages  tab.
Only languages that are installed and activated are displayed. To learn how to activate 
localization plugins, see Activate a language .

Note: 
The ServiceNow AI Platform  provides translations for interface features and pre-built 
topics. So in some topics, languages may display as partially translated.

4. Do one of the following:
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◦ Request translation:

a. Select the applicable check boxes, and then click Request translations.

b. When prompted, confirm your choice.

A translation record is created, and the translation status changes to In progress. The 
translation task is assigned to a user with the localization fulfiller role. For information 
about the fulfillment process in the Localization Framework, see Fulfill a localization task .

◦ Edit translations directly in Virtual Agent Designer.

Result
When translations are complete, Virtual Agent admins can view, unlock, or edit them from the 
topic Languages tab or the Manage languages page.

Once translations are published, they are made available to Virtual Agent topics that use 
keywords dynamically.

Localize Virtual Agent  topics that use NLU  topic discovery

Use the ServiceNow  Localization Framework  to manage the process of localizing Virtual Agent 
conversations that use Natural Language Understanding  (NLU).

Before you begin
Check the prerequisites for translating Virtual Agent  components. For more information, see 
Localizing Virtual Agent conversations.

Make sure that your Virtual Agent topics are published and performing the way you want them to. 
Make any adjustments before you send them to localization.

Role required: virtual_agent_admin or admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer.

2. Click Manage languages.

3. In the Select NLU Model  list, select the model group you want to manage.
Intents that are mapped to a topic display on the page.

4. In the View language  list, select a language.
The translation status of each topic in the chosen language displays on the page. Select 
a topic name to open the topic in Virtual Agent Designer, view or edit translations, or test 
translated content. The Topic translation status  column shows the current status of the topic 
in the localization process.
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Manage languages page

If the Topic translation status  column shows Needs publishing, you must publish the topic 
before you can submit it for translation.

Note: 
The ServiceNow AI Platform  provides translations for interface features and pre-built 
topics. So in some topics, languages may display as partially translated.

5. Do one of the following:

◦ Select the check boxes for the topics you want to translate, and then click Request topic 
translations. When prompted, confirm your choice.

A translation record is created, and the translation status changes to In progress. The 
translation task is assigned to a user with the localization fulfiller role. For information about 
the fulfillment process in the Localization Framework, see Fulfill a localization task .

Note: 
If a topic is already in localization, the corresponding check box is not available.

◦ Edit translations directly.

6. Click Manage NLU translations.
The model opens in NLU Workbench. Request translations for your model group. For more 
information, see Translate a multilingual model .

Result
When translations are complete, Virtual Agent admins can view, unlock, or edit them from the 
topic Languages tab or the Manage languages page.

Once translations are published, they are made available to Virtual Agent topics that use 
keywords dynamically.  However, language-specific intent matching is not available until model 
groups are also translated and published.

What to do next
You may need to map a topic to secondary models or a language-specific model.

When translations are done, you can test localized NLU models.
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Map a topic to a secondary NLU  model

Map a Virtual Agent  topic to a secondary model in the model group or to a standalone, single-
language NLU  model for each supported language.

Before you begin
If you're using ServiceNow  NLU, review NLU model mapping in Virtual Agent Designer  for an 
understanding of NLU model groups.

If necessary, add secondary languages to the model group in NLU Workbench  to create 
language-specific versions of the model. For more information, see Multilingual model 
management .

Role required: virtual_agent_admin or admin

About this task
If you select a secondary model for a language that is part of a different model group, the 
mapping changes for the entire topic. Secondary models must be part of the same model group 
as the primary language. You can select a different model and intent for a secondary language 
when it is the only language in the model (and therefore the primary language).

Updated model group mappings message

Topic mapped to a model group with primary and secondary languages

For more information, see NLU model mapping in Virtual Agent Designer.

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer  and open a topic.

2. Open the Languages  tab, and then select the NLU language mapping  tab.
The first column is the NLU  mapping that is based on your current session language. For 
example, if you're using English, the first column is English.

3. In the Language to edit  list, select the language to map.
The languages listed are based on the NLU  languages that you enabled in Virtual Agent 
settings. After you select a language, a column displays in the Intent mapping section and, 
if applicable, in the Entity mapping section. For example, if you select Français, a French 
language column displays.
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4. Update the Intent mapping section.

a. In the Model row, select an NLU  model for the language that you selected.

b. In the Intent row, select an NLU  intent for the language that you selected.

5. If applicable, update the Entity mapping section.
For each language, map an entity from the model to an input node in the topic. In a 
conversation, these nodes are populated automatically with the entity value.

6. Click Save.

What to do next
Test topic and NLU model translations

Test topic and NLU model translations

Test a translated Virtual Agent  topic and the localized NLU model to ensure that it works as 
expected in a conversation.

Before you begin
Role required: virtual_agent_admin or admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer.

2. Click Manage languages.

3. In the Select NLU Model  list, select the model group to test.

4. In the View language  list, select a language.
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5. In the Test  column for an intent, click Test.

6. On the test window that appears, run the conversation and review the results in the test tabs.
For more information about using the chat test window, see Testing NLU/Keyword topics.

Example 
The following image illustrates how you can test a French translation.

7. End the test by closing the window.

What to do next
Use the test results to modify the topic as needed. Continue testing as you adjust your topic and 
the NLU  language mappings.

When the topic is ready, publish the topic to make it available to users. You can publish all or 
some of the NLU  mappings. For more information about publishing a topic, see Publish a Virtual 
Agent topic.

Tip: 
You can view localization insights from the Manage languages  page and the Virtual Agent 
Designer  Topics page. Navigate to All  > Conversational Interfaces  > Virtual Agent  > 
Designer, and then click Localization Insights.

Edit translations for Virtual Agent  topics

A Virtual Agent  admin user can edit and publish translations directly in Virtual Agent Designer.

Before you begin
Role required: virtual_agent_admin or admin
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Procedure

1. Do one of the following:

◦ Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer, open a published 
topic, and then click the Languages  tab.

◦ (NLU only) Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer, click 
Manage languages, and then choose a model and language.

2. In the Topic translations  column, click Edit.

Example 
The Edit Translations form opens.

3. On the Edit Translations form, you can do any of the following:

◦ Unlock fields and enter translations directly on the form.

◦ If it is configured in the Localization Framework, use machine translation to fill in the fields.

To set up machine translation, see Create a translator configuration .

◦ Export files to send to a third party for translation.

Click Export Source File, and then choose the file type. Click Export File  to begin the 
download.

◦ Import translated files received from a translation service.

From the Export Source file list, select Import Translated File.

4. When translations are ready to publish, click Publish Translations.

Result
Once translations are published, they are made available to Virtual Agent topics that use 
keywords dynamically.
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If your topic uses Natural Language Understanding (NLU), train your localized models. You may 
also need to map them to the topic. Then test and publish your localized models to ensure 
that native speakers can access localized intents.  For more information, see Map a topic to a 
secondary NLU model  and Test topic and NLU model translations.

Request bulk translations for multiple topics

If you need to translate many Virtual Agent  topics across multiple models at one time, you can 
use the [sys_cs_topic] table list view to request translations.

Before you begin
Role required: virtual_agent_admin or admin

Procedure

1. Navigate to All  > sys_cs_topic.list.

2. Select the topic records you want to translate.

3. From the Actions on selected rows  list at the bottom of the page, select Request Translations.

4. In the Request Translations dialog box, select the languages.

Only languages that are installed and activated in the Localization Framework  are displayed. To 
learn how to activate localization plugins, see Activate a language .

5. Click Submit.

Authoring Virtual Agent  conversations for localization

Use localization methods in your Virtual Agent  scripts to ensure that the content can be 
translated. Localization methods are designed to show the original text when no translation is 
found. These methods can be applied to your code before you have created translations.

Localization method for message content

The gs.getMessageLang  method checks the Message table [sys_ui_message] for a 
translated version of the text in the language selected for the current user. If a translated version 
isn't found, the default language (English) is returned.

This code provides a greeting that dynamically adds the value of the first_name  variable.

(function execute() {
        return 'Hi there ' + vaInputs.first_name;
})()

The following example shows that same code rewritten for localization.

(function execute() {
         return gs.getMessageLang('Hi there {0}', 
 vaContext.getRequesterLang()), [vaInputs.first_name]);
})()

The second example uses the gs.getMessageLang  method. The text is the same as the 
previous example, but the format is changed. The number in brackets acts as a placeholder for 
the variable, which is then listed in an array after the comma: [vaInputs.first_name]. 
The gs.getMessageLang  method searches for a record on the Message table with a key 
value matching Hi there {0}  and a language value matching the requester's language. The 
method returns the translated version of the text, which is stored in the Message  field of the 
record.
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Note: 
Language values use ISO standard two-character language codes. For more information, 
see ISO 639.1 language codes .

Example translation record in the Message table

Note: 
Content is translated only for published topics. Content does not appear translated when 
previewing unpublished topics.

Language support for NLU  services

Entity extraction is supported on ServiceNow®  NLU models for specific languages only. The 
remaining languages support intent matching only. If you are using IBM Watson Assistant  or 
Microsoft LUIS, supported languages vary.

You can see the list of currently supported languages in the Open NLU Driver Languages 
[open_nlu_driver_language] table.

The VA NLU Languages [sys_cs_nlu_language] table lists the languages that are currently 
enabled in Virtual Agent.

Note: 
If you choose a language that doesn't support full entity extraction, an error message 
appears.

For unsupported language codes, you can specify a fallback language for NLU prediction. For 
example, if a user's language detected language is Mexican Spanish (es-mx), you can specify 
Spanish (es) as the fallback language, if it is enabled on your instance. For more information, 
see Specify a fallback language for locale-specific languages and NLU prediction. You can also 
enable Dynamic Translation  for Virtual Agent. For details, see Using language detection and 
dynamic machine translation in Virtual Agent.

Supported NLU  languages

Service Supported languages

ServiceNow  NLU For intent matching and entity recognition:

• English

• French

• German

• Japanese

• Spanish

For intent matching only:

• English

• Chinese (Simplified)
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Supported NLU  languages  (continued)

Service Supported languages

• Danish

• Dutch

• Finnish

• French

• French (Canadian)

• German

• Italian

• Japanese

• Korean

• Norwegian

• Polish

• Portuguese (Brazilian)

• Spanish

• Swedish

IBM Watson Assistant • English

• Chinese (Simplified)

• Dutch

• French

• German

• Italian

• Japanese

• Korean

• Portuguese

• Spanish

Microsoft LUIS • English

• Chinese (Simplified)

• Dutch

• French

• French (Canadian)

• German

• Italian

• Japanese

• Korean

• Portuguese (Brazilian)
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Supported NLU  languages  (continued)

Service Supported languages

• Spanish

• Turkish

Google Dialogflow  ES • English

• Chinese (Simplified)

• Chinese (Traditional)

• Dutch

• Finnish

• French

• French (Canadian)

• German

• Italian

• Japanese

• Korean

• Norwegian

• Polish

• Portuguese

• Portuguese (Brazilian)

• Russian

• Spanish

• Swedish

• Thai

• Turkish

Localization roles for Virtual Agent

Assign localization roles according to a user's scope in the localization process. Users may 
request translations, fulfill translation requests, and edit translations, based on their role.

The localization process follows this basic flow:

1. Topics are developed and released in the source language (for example, English).

2. Topics are translated, either by request or by editing them directly in Virtual Agent Designer.

If you are using NLU models, the models must be translated as well. For more information 
about that process, see Multilingual model management .

3. Translations are tested and published.

Virtual Agent  role privileges vary with the user's function in this process. These roles are also 
defined in the Localization Framework. For more information, see Localization Framework roles .
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To learn more about managing subscriptions, see Managing per-user subscriptions in 
Subscription Management  and contact your account representative.

Virtual Agent  admin permissions

The Virtual Agent  admin role contains the localization requestor and localization editor roles by 
default. Users can do the following:

• Request translations

• View existing translated content

• Unlock and edit translated content (unless translation is in process)

The localization task is not available to this user.

Manage languages page with the Virtual Agent  admin role

Localization fulfiller permissions

The localization fulfiller role may not have Virtual Agent  privileges. In that case, the user would 
only have access to assigned Localization Framework  tasks.

If a Virtual Agent  admin has the localization fulfiller role, the Manage languages  page lets the 
user view the localization task that was created.

Manage languages page with Virtual Agent  admin and localization fulfiller roles
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Click View requested item  to open the localization fulfillment task in a new window.

Localization request task number

Localization requestor [localization_requestor]

Requests translations for all the Virtual Agent  components into one or more languages. Can also 
view localization insights. The Virtual Agent  admin [virtual_agent_admin] role contains this role 
by default.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

Localization fulfiller [localization_fulfiller]

Provides translations for the requested Virtual Agent  topics. Depending on the flow, duties may 
include editing the translations in the Localization Framework  task, interacting with third parties, 
and loading, verifying, and publishing translations.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

Localization editor [localization_editor]

Edits the translations directly in Virtual Agent Designer. The NLU admin [nlu_admin] and Virtual 
Agent  admin [virtual_agent_admin] roles contain this role by default.
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Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

Virtual Agent  admin [virtual_agent_admin]

Contains the localization requestor and localization editor roles by default.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

Note: 
Avoid granting an admin role when more specialized roles are available.

Virtual Agent  translation tables

Virtual Agent  uses the [sys_translated_text] and [sys_ui_message] tables to store translated text.

Translation tables used by Virtual Agent

Table Description

Translated Text 
[sys_translated_text]

Stores translations for fields with the field type 
translated_text or translated_html (see the dictionary 
entry).

The [sys_cs_topic] table contains the English 
keywords and topic titles. It pulls translations from the 
[sys_translated_text] table.

For details about translating text content into different 
languages, see Translated text table  and Translating text 
fields .

Message [sys_ui_message] Stores expert translations for messages in Virtual Agent 
topics.
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Translation tables used by Virtual Agent  (continued)

Table Description

Pre-built topics have already been translated, but you must 
provide translations for any content you create for your 
instance. For more information about the Message table, 
see Message table .

Text Translations for 
Dynamic Translation 
[sys_cs_dynamic_translation_text]

Stores copies of the translations found in the Message 
[sys_ui_message] table and previously dynamically 
translated messages.

This view-only table is only available when the Dynamic 
Translation for Virtual Agent  plugin is installed and the 
Dynamic Translation in Virtual Agent  feature is enabled. 
This table is cleared every 24 hours to ensure that the 
most up-to-date translations stored in the Message 
[sys_ui_message] table are being referenced. For more 
information about how the Text Translations for Dynamic 
Translation [sys_cs_dyamic_translation_text] table works 
with Dynamic Translation in Virtual Agent, see Using 
language detection and dynamic machine translation in 
Virtual Agent.

Integrating Virtual Agent  with other channels

Integrate and extend the capabilities of Virtual Agent  by connecting to your employees and 
customers where they already are. They are engaged in web portals, Now®  Mobile  apps, and 
collaboration tools such as Slack, Microsoft Teams, Facebook Messenger  consumer app, 
Workplace enterprise messaging app, and any other popular chat or messaging app.

Conversational custom chat integrations

Conversational custom chat integration framework is a powerful framework consisting of 
scriptable APIs and configurations to bring the ServiceNow®  Virtual Agent  to any conversational 
interface.

How custom chat integrations work

Virtual Agent  Chat Server (VACS) supports the following chat client integration without 
enhancements or plugins:

• Microsoft Teams

• Slack

• Workplace

• WhatsApp

• LINE

• Facebook Messenger

• Twilio

• Alexa

• Amazon Connect

• Google Assistant
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• ServiceNow®  Service Portal

• ServiceNow®  Now Mobile

• Apple Messages for Business

If you're using a chat client that is not in the list, you can create a custom integration using 
conversational custom chat integration framework.

You can use any channels that support conversational interfaces, such as Web Portals, Mobile 
Apps, Slack, Microsoft Teams, SMS, and any other channel and add ServiceNow®  Virtual Agent 
to them.

With a conversational custom chat integration, you can manage and control how your end users' 
chat experience. The framework helps transform messages from a chat client to VACS, and VACS 
back to the chat client in a format that renders well on your chat interface.

The transformation is carried out through a set of Flow Designer  scripts. If you want more 
information on how to use Flow Designer, see Flow Designer .

Basic integration using conversational custom chat integration framework

You can use the following links to configure a basic custom chat integration.

To see an example of a custom chat integration using Telegram Messenger, see the Telegram 
demo and integration  on the ServiceNow  Developer Site. (You may need to log in to access the 
demo.)

Create a Virtual Agent  conversational custom chat integration configuration

Use the Custom Chat Configuration Integration Framework (CCCIF) to create a conversational 
custom chat integration to support third-party chat clients so they can connect to the Virtual 
Agent  Chat Server (VACS).

Before you begin
Activate the Glide Virtual Agent plugin  (com.glide.cs.chatbot) if it's not already activated. 
This plugin automatically activates the Conversational Custom Chat Integration plugin 
(com.glide.cs.custom.adapter) for custom chat integrations.

Role required: admin

About this task
To integrate chat clients with Virtual Agent, follow these configuration steps and add action 
scripts to Flow Designer.

Note: 
The CCCIF uses Integration Hub. Transactions count against your Integration Hub  quota.
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Procedure

1. Create a new channel or update an existing channel for the integration.

2. Configure a new provider for the integration.

3. Set up message authentication.

4. Create a channel identifier.

5. Select rich controls for inbound (user input) and outbound (bot response) transformation.

6. Create and configure a scripted REST API for your custom chat integration.

7. Create the action scripts.

Create a new channel for your custom chat integration

Create a new channel or update an existing channel for your custom chat integration. Channels 
are defined in the Messaging Channels [sys_cs_channel] table.

Before you begin
Activate the Glide Virtual Agent plugin  (com.glide.cs.chatbot) if it's not already activated. 
This plugin automatically activates the Conversational Custom Chat Integration plugin 
(com.glide.cs.custom.adapter) for custom chat integrations.

Note: 
The Conversational Custom Chat Integration Framework (CCCIF) uses Integration Hub. 
Transactions count against your Integration Hub  quota.

Role required: admin

Procedure

1. Navigate to All, and then enter sys_cs_channel.list  in the navigation filter.

2. On the Messaging Channels page, click New.
Alternatively, select an existing channel to open it.

3. On the form, fill in the fields.

Field Description

Name Name of your channel, such as Mobile App or SMS.

Opted in all 
topics by 
default

Option to make all topics available in this channel.

Enable 
Notifications

Option to turn notifications on or off on this channel.

Live Agent 
Only

Option to initiate conversations with live agents, bypassing the Virtual Agent 
bot.

Store app 
page link

This field should be left empty.

Type Channel type.

◦ Chat: Standard chat experience

◦ Messaging: Long-running conversation
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Field Description

◦ Phone: Phone (audio) conversation

◦ Walk-up: In-person conversation

Conversation 
Idle Timeout Number of seconds that abandoned Virtual Agent  and Agent Chat 

conversations remain open in the channel, after the requester's last response.

This channel-specific value overrides the following settings:

◦ Default idle conversation timeout value, which is 7200 seconds

◦ Idle conversation time-out value set through the 
com.glide.cs.conversation_idle_timeout  system property to 
override the default timeout value

For more information about conversation idle timeouts, see Closing Virtual 
Agent and Agent Chat conversations.

Secure Option for the channel to be secure to support handling of sensitive data 
such as passwords.

Support 
typing 
indicator

Option to display typing indicators for this channel. Flag applies to both agent 
and bot indicators.

Icon This field should be left empty.

4. Click Submit.

What to do next
Configure a provider for your custom chat integration

Configure a provider for your custom chat integration

Create a new provider for your custom chat integration. Providers are defined in the Connections 
[sys_cs_provider] table.

Before you begin
Create a new channel for your custom chat integration.

Role required: admin

About this task
Configure a new provider for each integration that you set up.

Procedure

1. Navigate to All, and then enter sys_cs_provider.list  in the filter.

2. On the Connections page, select New Custom.

3. On the form, fill in the fields.

Field Description

Name Name of your provider application. For example: VA SMS Twilio 
Adapter
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Field Description

Provider 
attributes 
action

Name of the provider attributes action script. The provider attributes action 
script can return a Provider auth token, a user identifier, user input, and context 
variables.

Response 
processor 
action

Name of the response processor action script. The Response processor action 
script performs platform actions. For example, updating a message status 
based on the response received for an outbound message.

Version The version of the provider. The framework is able to send the expected 
inputs to actions and subflows and handle the expected outputs. There are 2 
versions:

◦ 1.0.0: The assumed version unless explicitly defined on the provider.

◦ 1.1.0: The outbound_token  input parameter (from the provider channel 
identity) was added to invocations of the sender subflow/action.

HTML to 
Image 
conversion 
required

Option to convert an HTML bot response into an image and link. Used for chat 
interfaces that do not support HTML rendering.

Allow 
account 
linking

Option to link your account to an existing ServiceNow®  profile.

Channel Channel that this provider supports and the one to which the integration is 
being built.

Sender 
action The sender action script. The sender action script bundles the request and 

then sends the response via Flow Designer  or Integration Hub  asynchronously.

Sender 
subflow The sender subflow bundles the request and sends the response via Flow 

Designer  (FD) or Integration Hub  (IH) asynchronously.

Contextual 
action

Name of the contextual action script. The contextual action script supports 
custom contextual actions.

4. Click Submit.

What to do next
Set up message authentication for your custom chat configuration

Set up message authentication for your custom chat configuration

Create a Hash Message Verification record and Message Auth record to set up message 
authentication for your custom chat integration. This is configured in the Hash Message 
Verifications [hash_message_verification] table.

Before you begin
Configure a provider for your custom chat integration.

Role required: admin

About this task
You can create a Hash Message Verification record and Message Auth record to set up message 
authentication.
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Procedure

1. Navigate to All, and then enter hash_message_verification.list  in the filter.

2. On the Hash Message Verifications page, click New.

3. On the form, fill in the fields.

Field Description

Name Name of the authentication token, such as TwilioSMSTestAppAuthToken.

Description Description of the authentication token, such as "Twilio SMS Testing application 
Auth Token."

Secret Authentication token (random string).

4. Click Submit.

5. Navigate to All, and then enter message_auth.list  in the filter.

6. On the Message Auths page, click New.

7. On the form, fill in the fields.

Field Description

Name Name of the message authentication, such as VA Twilio SMS Test App 
Message Authentication.

Provider Provider, such as Twilio.

Group name Name of the group or team of the provider channel.

Service Portal Option to redirect users to a service portal for authentication during account 
linking.

Inbound 
message 
verification

Hash message token that was created.

Outbound 
message 
creation

Hash message token that was created.

Outbound 
service token

Token passed to the sender subflow that is used to invoke REST endpoint for 
the chat client. Use the outbound token to send a message using the REST 
API.

8. Click Submit.

What to do next
Create a channel identifier for your custom chat integration

Create a channel identifier for your custom chat integration

Create a channel identifier for your custom chat integration in the Provider Channel Identities 
[sys_cs_provider_application] table.

Before you begin
Set up message authentication for your custom chat configuration.
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If you're using domain separation, change the scope to the domain you want to use before you 
create the channel identifier. The domain ID will be stored in the [sys_cs_provider_application] 
table and passed to the Virtual Agent  server as a context parameter, which will set the domain for 
the user.

Role required: admin

Procedure

1. Navigate to All, and then enter sys_cs_provider_application.list  in the filter.

2. On the Provider Channel Identities page, click New.

3. On the form, fill in the fields.

Name Name of the channel identity. For example: VA SMS Twilio Adapter

Provider Select the name of your provider application that you set up in a previous step. 
For example: VA SMS Twilio Adapter Pro.

Default 
Portal

Portal in which chat links to ServiceNow  records are opened by default, 
including links in cards used for Virtual Agent  notifications and AI Search 
results.

Message 
auth

Select message authentication for the channel identifier that you set up in a 
previous step.

Inbound ID Identifier for your bot. For example, the phone number.

Short 
description

Description for your channel identifier.

4. Click Submit.

5. Optional:  Follow these steps again to create additional channel identifiers.

What to do next
Map rich controls to the channel in your custom chat integration

Map rich controls to the channel in your custom chat integration

Create records for rich controls in the Custom Adapter Configurations 
[sys_cs_custom_adapter_config] table. If a rich control is missing an outbound transformer 
implementation, a response is not served to the end user and that user may get an 
unsatisfactory chat experience.

Before you begin
Create a channel identifier for your custom chat integration.

Role required: admin

About this task
You must create a mapping for any rich controls your conversations will use in the channel. 
For example, you may need a mapping for DefaultText, which supports input and output 
text response, along with file upload and image response. If your channel doesn't support a 
control, then you won't need to map it. For example, SMS doesn't support video responses. For 
a description of each default rich control, see Default input and output rich controls for a custom 
chat integration.
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Procedure

1. Navigate to All, and then enter sys_cs_custom_adapter_config.list  in the filter.

2. On the Custom Adapter Configurations page, click New.

3. On the form, fill in the fields.

Field Description

Provider Provider that you created.

Control type Default rich control type.

For example, the DefaultPicker rich control type maps to File Picker, Topic Picker, and Boolean controls. 
For more information about the types of controls, see Default input and output rich controls for a 
custom chat integration.

Inbound 
transformer 
action

Name of the inbound transformer action script for this rich control. For example: 
sn_va_sms_twilio.va_sms_twilio_adapter_input_text_inbound_transformer

Outbound 
transformation 
action

Name of the outbound transformer action script for this rich control. For example: 
sn_va_sms_twilio.va_sms_twilio_adapter_input_text_outbound_transformer

4. Click Submit.

What to do next
Create and configure a scripted REST API for your custom chat integration

Create and configure a scripted REST API for your custom chat integration

Create a scripted REST API, add a scripted REST resource, set security and content negotiation, 
and set REST API rate limits.

Before you begin
Map rich controls to the channel in your custom chat integration.

Role required: admin

Procedure

1. Create the REST API.

a. Navigate to All  > System web services  > Scripted Web Services  > Scripted REST APIs.

b. Click New.

c. On the form, fill in the fields.

Field Description

Name Name of your API. For example, ACME Mobile App Chat Adapter.

API ID API identifier. For example, acme_chat.

Protection 
policy

The protection policy for the script.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2050



Field Description

▪ Read-only: Script is viewable only.

▪ Protected: Users with password permissions can edit the script.

Application The application containing the script record. Global  is selected by default.

API 
namespace

The namespace the API belongs to. The value depends on the current 
application scope.

d. Click Submit.

e. Optional:  Open the new record, navigate to Related Links  and click Enable Versioning, and 
then click OK.
Click Update  to save your changes.

2. Add a scripted REST resource to your new REST API.
The scripted REST resource defines the scripted REST API definition that you created.

a. Open the REST API record you created, and then navigate to the Resources  tab under 
Related Links.

b. Click New.
Retrieve the payload from the request, and then write it to a hybrid queue.

c. On the form, fill in the fields.

Field Description

API Definition Name of the parent API.

Application The application containing the script record.

Name Name of your API REST Resource. For example, ACME chat.

API version API version. For example, v1.

This field displays only if you enabled versioning for the REST API.

Active Option to make the REST resource active.

HTTP method HTTP method, such as POST, GET, and so forth.

Relative path Relative path to the resource.

Script Script for the REST resource.

Protection policy The protection policy for the script.

▪ Read-only: Script is viewable only.

▪ Protected: Users with password permissions can edit the script.

Example of a scripted REST resource:

(function process(/*RESTAPIRequest*/ 
 request, /*RESTAPIResponse*/ response) {
    var body = request.body;
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    var queryParams = request.queryParams; // incoming 
 content is application/x-www-form-urlencoded in this example
    // get the provider application sys id. this can be done 
 via a glide query using incoming data such as where the 
 original message is being sent to. or it can be hard-coded 
 such as this example.
    var providerAppId = "a5f8b75b7377001042281188caf6a73a";
    // the time of receipt is recorded for analytics purposes
    var d = new Date();
    var logTime = d.getTime();
    // add this message to the VA Server queue for processing
    var queued = 
 sn_cs.VASystemObject.enqueueCustomAdapterMessage(providerApp
Id, JSON.stringify(queryParams), 
 JSON.stringify(request.headers), logTime);
    if (queued == false) {
 response.setError(new sn_ws_err.BadRequestError('Failed to 
 process the request.'));
    }
})(request, response);

3. Set security and content negotiation for your scripted REST resource.
Choose to set authentication and request formats. If your custom integration does not rely on 
authentication, you may want to remove it as follows.

a. In the new record for the Scripted REST Resource, navigate to the Security  tab.

b. Clear Requires authentication.

c. Click the Content Negotiation  tab, and then select Override supported request formats.

d. Click Submit.

4. Set REST API rate limits to define the rate of incoming requests.

a. Navigate to All  > System web services  > REST  > Rate Limit Rules.

b. Click New.

c. On the form, fill in the fields.

Field Description

Name Unique name for the rate limit rule.

REST API REST API that you created in an earlier step.

Version Version of the REST API. Values listed depend on the selected REST API.

Resource Resource for the specified Version. Values listed depend on the selected 
Version.

Active Check box to indicate that the rate limit rule is active.

Rate limit rules are activated by default as soon as you create them. You can 
deactivate rate limit rules to stop enforcing a rate limit or activate rate limit rules 
to resume enforcing a rate limit.
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Field Description

Request 
limit per 
hour

Maximum number of requests allowed per hour.

Note: 
Whenever you update the value of this field, the ServiceNow AI Platform 
resets the count of requests to 0 and deletes all violations for the current 
hour.

Apply to Users restricted by this rule. Select All users.

d. Click Submit.

What to do next
Create the action scripts for your custom chat integration

Create the action scripts for your custom chat integration

Set up the transforms that your custom chat integration needs to communicate through the chat 
process.

Before you begin
Create and configure a scripted REST API for your custom chat integration.

Note: 
All action messages relevant to the chat client are displayed to requesters during live agent 
conversations.

Role required: admin

Procedure

1. Navigate to the All  > Process Automation  > Flow Designer.

2. Click the Actions  tab.

3. Create the actions  you require to complete the conversational custom chat integration.
For details about the input and output used in action scripts, along with script examples, see 
Virtual Agent action scripts.

Default input and output rich controls for a custom chat integration

Input and output rich controls must be mapped to your custom chat integration in the Custom 
Adapter Configurations [sys_cs_custom_adapter_config] table. If a rich control is missing an 
outbound transformer implementation, a response is not served to the end user and that user 
may get an unsatisfactory chat experience.

The following default rich controls map to input and output rich controls. The uiType  parameter 
refers to a topic control used to build conversations in Virtual Agent Designer.

Default input and output rich controls

Rich control Description

ActionRichControl This component handles the different events and actions 
that occur in a conversation. Some actions may not apply 
to all channels. For example, StartSpinnerActionMsg is 
ignored in SMS.
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Default input and output rich controls  (continued)

Rich control Description

ServiceNow®  Virtual Agent  produces the following types 
of action messages through this framework. The custom 
chat interface only recognizes certain action message 
types.

• SeparatorActionMsg ||actionMsg instanceof

• SystemActionMsg ||actionMsg instanceof

• TopicFinishedActionMsg ||actionMsg instanceof

• SwitchToVirtualAgentActionMsg ||actionMsg instanceof

• SwitchConversationActionMsg ||actionMsg instanceof

• ChatSubHeaderActionMsg ||actionMsg instanceof

• StartSpinnerActionMsg ||actionMsg instanceof 
EndSpinnerActionMsg

• SubscribetoSupportQueue ||actionMsg instanceof

• SubscribeToChatPresence ||actionMsg instanceof

• SwitchToLiveAgentActionMsg ||actionMsg instanceof

ActionRichControl wraps these messages inside the 
actionMsg  element. So, a single outbound transformer 
for ActionRichControl can handle all of these messages. 
There is no need for an inbound transformer for this 
component.

agentInfo  parameter If the rich control is sent from a live agent, then the 
agentInfo  attribute is added to the rich control.

Example:

{
     uiType: "someType",
     group: "someGroup"
     agentInfo: { sentFromAgent: 
 true }  // please note that this 
 object may contain more info in 
 subsequent releases.
     ...
} 

DefaultPicker Maps to File Picker, Topic Picker, and Boolean  controls.

Example:

{
    uiType: 
 "Picker/TopicPicker/Boolean",
    group: "DefaultPicker",
    nluTextEnabled: true/false,
    promptMsg: "", // optional (needed 
 for TopicPicker)
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Default input and output rich controls  (continued)

Rich control Description

    label: "The question for the 
 list",   // always filled
    itemType: "Picture/List"  // 
 needed to user key to expect picture 
 attached
    options: [
        {
            label: "display label 
 prompt",
            value: "the value required 
 to satisfy the question",
            description: "a 
 description of value_1 item"
     attachment: "www.foo",
            enabled: true/false
        },
 ...
    ]
}

The optional order  parameter lets you specify the order 
in which promoted topics should display. For example:

"options": [
    {
      label: "Check IT Ticket Status",
      value: 
 "55720b465bf0201024f11fc40a81c72d",
      order: 100,
      enabled: true
    },
    {
      label: "Live Agent Support",
      value: 
 "ce2ee85053130010cf8cddeeff7b12bf",
      order: 200,
      enabled: true
    },
    {
      label: "Open IT Ticket 2",
      value: 
 "2a46cffbc7602010v088bbf603c260a7",
      order: 300,
      enabled: true
    }
]

DefaultText Maps to Input Text, Output Text, and File Upload controls.

Example:
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Default input and output rich controls  (continued)

Rich control Description

{
    uiType: 
 "InputText/OutputText/FileUpload/Pict
ure",
    group: "DefaultText",
    required: true/false,
    nluTextEnabled: true/false,
    itemType: 
 "file/image/inputtext/outputtext",
    maskType: "SECURE/SENSITIVE/NONE" 
  // null except for 
 InputText/OutputText
    label: "The Question?"
}

DefaultDate Maps to Date and Time  controls.

{
    uiType: "Date/DateTime/Time",
    group: "DefaultDate",
    required: true/false,
    nluTextEnabled: true/false,
    label: "The Question?"
 
}

DefaultOutputLink Maps to link response  controls.

Example:

{
    uiType: "OutputLink",
    group: "DefaultOutputLink",
    label: "link label",
    header: "link header",
    type: "link",
    value: {
        action: "www.foo",
    }
}
 
}

DefaultOutputImage Maps to image response  controls.

Example:

{
    uiType: "OutputImage",
    group: "DefaultOutputImage",
    value: "www.foo"
}

DefaultOutputCard Maps to card response  controls.
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Default input and output rich controls  (continued)

Rich control Description

Example:

{
    uiType: "OutputCard",
    group: "DefaultOutputCard",
    templateName: "Card",
    data: "some json data string"
}

DefaultOutputHtml Maps to HTML response  controls.

Example:

{
    uiType: "OutputHtml",
    group: "DefaultOutputHtml",
    style: "inline",
    height: 100,
    width: 100,
    value: "<div>html</div>"
}

DefaultOutputTable Maps to table response  controls.

Example:

{
    uiType: "OutputTable",
    group: "DefaultOutputTable",
    label: "Table Title",
    headers: ["Column 1", "Column 2"],
    navigationBtnLabel: "See next",
    data: [
        ["foo1", "foo2"],
        ["bar1", "bar2"]
    ]
}

DefaultGroupedPartsOutputControl Maps to multi-response  controls.

Example:

{
    uiType: 
 "GroupedPartsOutputControl",
    group: 
 "DefaultGroupedPartsOutputControl"
    groupPartType: "Link",
    header: "header message",
    values: [
 {
     action: "www.foo",
     description: "description",
     label: "link_1 label",
     context: "ITSM"
 },
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Default input and output rich controls  (continued)

Rich control Description

 ...
    ]
}

DefaultMultiPartOutput Maps to multi-response  controls.

Example:

{
    uiType: "MultiPartOutput",
    group: "DefaultMultiPartOutput"
    navigationBtnLabel: "Go next",
    content: {
        uiType: "OutputHtml",
        style: "inline",
        type: "html",
        height: 100,
        width: 100,
        value: "<div>html</div>"
     }
}

DefaultCustomControl Maps to custom controls.

Example:

{
    uiType: "CustomControl",
    group: "DefaultCustomControl",
    name: "The name 
 of the Custom Control 
 (sys_cs_custom_control.name)",
    required: true/false,
    uxComponentDefinitionSysId: 
 "seismicComponentId" // or null if 
 not
    isInput: true/false, // whether to 
 wait for a response value or if just 
 output
    serializedControlData: "User 
 defined JSON from generateControlData 
 function";
}

Modify adapter card styles for Virtual Agent

Adapter cards are defined in the Adapter Cards [sys_cs_adapter_card] table. Each card has a 
template for each supported channel to ensure it displays correctly. You can modify the channel 
templates to accommodate your organization's style requirements.

Before you begin
Adapter card templates are stored in the Adapter Card Templates 
[sys_cs_adapter_card_template] table, which is available from the Adapter Cards table as a 
related list. For example, the YouTube Video Card adapter has three default templates, for the 
Web client, iOS, and Android devices.
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Role required: virtual_agent_admin or admin

Procedure

1. Navigate to All, and then enter sys_cs_adapter_card.list  in the navigation filter.
The Adapter Cards page opens.

2. Select an entry in the Card Name  column.

3. In the Adapter Cards Template  related list, select the channel you want to view or modify.
For example, select the active link for Web Client  or Android Device  to view the corresponding 
style sheet.

4. Make any changes in the Template Definition  field.

5. Select Update.

Supported Virtual Agent  and Agent Chat  features for custom chat integrations

The chat integrations framework supports a multitude of Virtual Agent  and Agent Chat  features to 
provide a robust conversational experience.

User authentication, authorization, and secure connection setup

Synchronous authentication of messages

Provider authentication is synchronous. They will get an immediate response 
with the request successful or failure code. For configuration information, see 
Synchronous authentication of messages.

Note: 
As of the Paris  release, asynchronous authentication is no longer supported.

Account auto-linking

Allow a user's third-party account to be auto-linked to their ServiceNow®  profile. 
This feature bypasses the prompt for the user to link their accounts manually. 
Without account linking, conversations will take place in Guest mode. For 
configuration information, see Account linking in pre-built messaging integrations.

Configure the output response REST endpoint and outbound authentication for the 
Virtual Agent API

Specify the outbound endpoint URL to which the Virtual Agent  responses are 
posted and configure outbound authentication. For configuration information, see 
Outbound authentication using a token.

Secure data transfer

Sensitive data such as passwords can be masked and transferred via the 
integration framework securely.

Trusted media domains

Use trusted media domains to check the URLs of attachment files before uploading 
them. For configuration information, see Set up trusted media domains for secure 
file upload.

Rich control transformation

Design a rich and unique conversational experience for a channel through rich control 
transformation via inbound and outbound transformation scripts. All standard rich controls are 
supported. For detailed information about Virtual Agent  controls, see the following sections:
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• Virtual Agent Designer user input controls

• Virtual Agent Designer bot responses

• Virtual Agent Designer utilities

Supported Virtual Agent  chat features

No configuration or scripting required to implement these features in Custom Chat Integration 
Framework.

Support for all standard Virtual Agent  controls

• Pass context variables, system parameters, or a user's time-zone along with user 
input.

• By default the Virtual Agent  processes only one user request at a time. If a user 
sends a second request before the first request is finished, the second request is 
ignored. This does not apply when the user is connected to a live agent.

• Ignore duplicate requests from client.

Topic discovery using keywords or Natural Language Understanding

Custom chat integrations can avail topic discovery via keywords or NLU  depending 
on how Virtual Agent  is set up on your instance.

Standard chat and long-running conversations

Channels can be set up as either chat or messaging. For more information on long-
running conversations, see Using Asynchronous Chat in messaging channels.

Custom Virtual Agent chat experiences

Define a custom chat experience for a specific context in which your users run 
Virtual Agent.

Dynamic translation

Display a message in chat client that messages are being translated if dynamic 
translation is enabled.

Customize Virtual Agent and Agent Chat system messages

System messages are a set of pre-built messages that can be served as bot 
response in common conversation scenarios such as greeting a user or transferring 
to a live agent. Admins can override the message text to suit their business needs.

Notifications

Deliver both simple and actionable notifications via the integration framework.

Standard timeouts for idle agent conversations

You can change the default timeout period for closing Virtual 
Agent and live agent conversations by adding the system property 
com.glide.cs.conversation_idle_timeout.

Virtual Agent interaction records

The channel (sys_cs_channel.Name), channel type (sys_cs_channel.Type), 
provider (sys_cs_provider.Name), provider identifier name 
(sys_cs_provider_application.Name) and provider channel id 
(sys_cs_provider_application.InboundID) fields are available for reporting.

API rate limiting

Ability to control the rate at which API calls are made via the platform rate limiting 
feature.
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API versioning

Specify the version of the provider. The framework is able to send the expected 
inputs to actions and subflows and handle the expected outputs. See Configure a 
provider for your custom chat integration  for more information.

Specify the default portal for URL navigation at the Provider Channel Identities level

For a provider channel, specify the portal in which chat links, including links in 
output cards and cards for Virtual Agent notifications and AI Search results, are 
opened. For details on setting the default portal in the Provider Channel Identities 
[sys_cs_provider_application] table, see Create a channel identifier for your custom 
chat integration. To learn more about URL navigation, see Configure URL navigation 
for chat links.

Supported Agent Chat  features

Support for all standard live agent controls

• Transfer to live agent from Virtual Agent  or directly by user

• Persistent messages after live agent is initiated

• Interaction history (chat transcripts) for live agents

• Channel-level flag to initiate conversations with live agents, bypassing Virtual 
Agent

Live agent status for end users

• Agent availability

• Wait time for next agent

• Display agent name and avatar, if enabled in Agent Chat settings.

Channel-level flag to initiate conversations with live agents, bypassing Virtual Agent

Enable the Live Agent Only  option in the Messaging Channels [sys_cs_channel] 
table to route conversations directly to a live agent and skip the Virtual Agent 
conversation greeting. If an agent isn't available, the message No agent available 
is displayed to the user. For channel configuration information, see Create a new 
channel for your custom chat integration.

Pass the agent avatar and name if enabled in Agent Chat settings

When the Agent Names and Avatars  field is enabled in Agent Chat settings, the 
Custom Chat Integration Framework supports the display of the agent name and 
avatar in the chat. For more information, see Setting up Agent Chat.

Pre-chat and post-chat surveys

After an agent ends a chat, the post-chat survey runs automatically when the 
following criteria are met:

• The Virtual Agent  Feedback setup topic is enabled.

• The chat service channel and the queues that your live agents support are 
configured in Advanced Work Assignment.

Synchronous authentication of messages

Inbound message authentication is performed before the message is added to the hybrid queue.

This code has to be implemented in the provider attribute script. For more information, see 
Virtual Agent action scripts.
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Example: Synchronous authentication of messages

var validated = 
 sn_cs.VASystemObject.validateMessage(providerApp.sysId, 
 payload, JSON.stringify(headers));
if (validated === false) {
    response.setStatus(401);
    response.setContentType("test/xml")
    var writer = response.getStreamWriter();
    writer.writeString(

Outbound authentication using a token

Pass an outbound token from the authentication API to the sender script.

Secure Fields: Outbound Authentication Token Script

Secure fields contain the maskType  metadata field as "SECURE". The client can handle the 
following script appropriately.

Example: Outbound authentication token script

(function execute(inputs, outputs) {
    try {
        var results = inputs.result;
 
        var sendInputs = {
            app_inbound_id : inputs["app_inbound_id"],
            channel_user_id: inputs["channel_user_id"],
            messages: JSON.stringify(results)
        };
 
       
 sn_fd.FlowAPI.startSubflowQuick('sn_va_sms_twilio.va_sms_twilio
_adapter_send_sms', sendInputs);
        //return 
 sn_fd.FlowAPI.executeActionQuick('sn_va_sms_twilio.va_sms_twili
o_adapter_sender_handler', sendInputs);
 
 
    } catch (e) {
        gs.error("Messages: " + JSON.stringify(sendInputs));
        gs.error("Error is twilio sms sender : " + e.message);
    }
})(inputs, outputs);

Message delivery order

Control message delivery order by enabling the Maintain message ordering  option in the 
Provider Channel [sys_cs_provider] table. You can view the message order and status in the 
Custom Adapter Message [sys_cs_ca_message] table.

When you enable the Maintain messaging order  option in the Provider Channel table, a Sender 
Subflow occurs only after the previous Sender Subflow completes to ensure that messages are 
delivered in the order that they were sent.

Messages are stored in the Custom Adapter Message [sys_cs_ca_message] table, which is 
cleaned nightly. If the Custom Chat Integration Framework client is not receiving any messages, 
you can use this table to check the message delivery status:

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2062



• Processing

• Pending - not yet processed

• Completed

• Error - problem with processing an outbound message, possibly due to Integration Hub issues 
that could occur when the Sender Subflow is invoked

Virtual Agent  action scripts

You need to write a set of mandatory Flow Designer  action and subflow scripts to pass the 
user data to VACS, apply transformations and send the response back to your chat interface 
endpoint.

Provider and inbound/outbound scripts

A provider, such as Twilio, provides the chat capability. User action scripts perform provider 
actions, as well as conversational custom chat integration configuration for inbound and 
outbound transformer actions for your chatbot or custom conversations. Examples of each script 
are provided. They include a description of what each script does, as well as the action input and 
action output. You also see examples of the script JSON.

You use Flow Designer  to build these scripts to transform server and client messages. The 
provider, sender, and inbound/outbound transformer scripts are required. You can use the 
additional scripts to add more functionality to your chat.

Scripts

Script name Purpose Required (Y/N)

Provider attribute Contains a Provider Auth token, a user identifier, 
user input, and context variables.

Y

Sender action
Bundles the request, and sends a response 
asynchronously via Flow Designer  or Integration 
Hub.

Y

Response processor Performs platform actions, such as an update 
message status, that's based on a response 
received for an outbound message.​

N

Contextual action Supports contextual actions. N

Link account action Provides a callback about whether account 
linking was successful or not.

N

Outbound transformer Transforms a chat server's supported control to 
chat interface-specific rendering.

Y

Inbound transformer Optional. You can use the default rich controls 
if they apply to your chat provider. You do not 
need to provide a separate inbound transform 
for each input control. If a default behavior does 
not work, you can override the default with your 
own inbound transform for a specific Virtual 
Agent server control.

Y
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Provider attributes action script

The provider attributes action script extracts data from the incoming message. The script knows 
about the conversational custom chat integration protocol and outputs the content of the 
incoming message, the user ID of the sender, and an optional authentication token.

Note: 
If your provider attributes action script has a contextual action, your script must have both 
the request_context.contextual_action and request_context.typed_value so that the user 
input (which is matched to a contextual action) is included in the transcript. If you do not set 
the request_context.typed_value, that message content does not appear in the transcript.

Provider attributes action script input/output

Input Output

• Headers (JSON) - Request headers

• Payload (JSON) - Request body​

• Token (String) - Authentication token.

• provider_user_id (String) - Name of the sender, for 
example, a user name in a Slack message.

• request_context (JSON) - Actual content received.

◦ typed_value - Typed content such as an answer to 
a question.

◦ attachment_value.url - URL of the attachment.

◦ attachment_value.content_type - Content type of 
the attachment.

◦ attachment_value.name - File name of the 
attachment.

◦ contextual action - Action to perform, such as 
END_CONVERSATION, START_CONVERSATION, 
AGENT. This script looks at the incoming 
message. If there is a recognized keyword, 
then one of the actions can be set, such as 
outputs.request_context.contextual_action 
= "END_CONVERSATION";. The framework 
recognizes this keyword and invokes the 
contextual action script.

◦ context_vars - Contextual variables 
to pass into a conversation, such as 
`outputs.request_context.context_vars = 
{language: "en"};`.
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Example: Flow Designer  provider attributes action script input, including headers 
and payload

Example: Flow Designer  provider attributes action script output, including token, 
request_context, and provider_user_id

Example: Provider attributes action script.

(function execute(inputs, outputs) {
    var headers = (inputs.headers);
    var payload = (inputs.payload);
 
    // check if an authentication token was included. this is 
 optional.
    var smsUtil = new VASMSTwilioUtil();
    outputs.token = JSON.stringify(smsUtil.getToken(headers, 
 payload));
 
    var data = payload.data;
    var request_context = {};
    // inspect the actual message. it could be an MMS 
 (attachment) or raw text
    if (data['MediaUrl0']) {
        var attachment_value = {};
        attachment_value.url = data['MediaUrl0'];
        attachment_value.content_type = 
 data['MediaContentType0'];
        attachment_value.name = 
 smsUtil.getFileName(attachment_value.url , 
 attachment_value.content_type);
        request_context.attachment_value = attachment_value;
    } else {
       request_context.typed_value = data['Body'];
    }
 
    // set the mandatory outputs
    outputs.request_context = request_context;
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    outputs.provider_user_id = data.From;
})(inputs, outputs);

Sender subflow script

The sender subflow script knows how to send a message to the provider. The script should 
asynchronously invoke a Flow Designer  or Integration Hub  subflow. The Virtual Agent  is freed 
to continue processing messages rather than trying to send external requests. When creating a 
subflow do not have an action call an action within the subflow.

}else{
  outputs.sendmessage = true;
  messages = inputs.results.results;
  outputs.from = from;
  outputs.to = to;
  outputs.messages = getMessages(messages);
}

Contextual action script

The contextual action script performs special keyword actions such as typing agent  while 
inside a Virtual Agent  topic to get immediately handed off to a live agent.

Contextual action script Input

Input Output

• conversation_id (String) - The conversation ID.

• request_context (JSON) - Request passed from the provider 
attribute script that contains the action to perform, such as 
(END_CONVERSATION, START_CONVERSATION, AGENT).

None

Example: Contextual action script.

(function execute(inputs, outputs) {
  var contextual_action = 
 inputs.request_context.contextual_action;
  if (contextual_action === "END_CONVERSATION") {
   
 sn_cs.VASystemObject.endConversation(inputs.conversation_id);
  } else if (contextual_action === "AGENT") {
   
 sn_cs.VASystemObject.switchToLiveAgent(inputs.conversation_id);
  } else if (contextual_action === "START_CONVERSATION") {
   
 sn_cs.VASystemObject.startConversation(inputs.conversation_id);
  }
})(inputs, outputs);

Link account action script

The link account action script contains identifiers for the user who is linking. The script also 
contains the account that it is linked to.
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Link account action script Input

Input Output

• provider_user_id (String) - Identifier of the user who is linking, such as 
a phone number in an SMS case.

• status (String) - Success/failure.

• user_id (String) - ServiceNow user_sys_id for the account that was 
linked to.

None

Example: Link account action script.

(function execute(inputs, outputs) {
 
  var richControl = (inputs.rich_control);
  var value = richControl.value;
  outputs.result = richControl.header + ': ' + value.action;
 
})(inputs, outputs);

Response processor action script

The response processor action script performs specialty actions that are based on the response 
to a send message request. The framework already does basic message status tracking.

Response processor account action script input

Input Output

• message_id (String) - Identifier of sys_cs_message record that is 
associated with this response.

• headers (JSON) - Headers that are received.

• body (String) - Body that is received.

• status code (Integer) - The HTTP status code that is received.

None

Example: Response processor action script.

(function execute(inputs, outputs) {
    gs.debug("Response from provider: message_id = " + 
 inputs.message_id + ", status_code = " +
      inputs.status_code + ", headers = " + 
 JSON.stringify(inputs.headers) + ", body = " + inputs.body);
})(inputs, outputs);

Outbound transformer scripts

The outbound transformer scripts convert outgoing Virtual Agent  messages to a protocol that is 
related to the conversational custom chat integration.

Input.
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• rich_control (JSON) - Virtual Agent  server rich control component that must be transformed.

• payload (JSON) - Last response that was received from a requester.

Output.

result (String) - Provider-appropriate component message to send.

Examples: Outbound transformer scripts

Outbound transformer name Script example

Virtual Agent - SMS Twilio 
Adapter Default Text Outbound 
Transformer

(function execute(inputs, outputs) {
  var rich_control = 
 inputs.rich_control;
  outputs.result = 
 rich_control['label'];
})(inputs, outputs);

Virtual Agent - SMS Twilio 
Adapter Default Link Outbound 
Transformer

(function execute(inputs, outputs) {
  var richControl = 
 (inputs.rich_control);
  var value = richControl.value;
  outputs.result = richControl.header 
 + ': ' + value.action;
})(inputs, outputs);

Virtual Agent - SMS Twilio 
Adapter Default Picker Outbound 
Transformer

(function execute(inputs, outputs) {
  var rich_control = 
 inputs.rich_control;
  var options = 
 rich_control['options'];
  if (options && options.length > 0) {
      var optionsLength = 
 options.length;
      var picker = 
 rich_control['label'] || "";
      for (var x = 0; x < 
 optionsLength; x++) {
          picker += "\n" + (x+1) +  ": 
 " + options[x].label;
      }
  }
  outputs.text_message = picker;
})(inputs, outputs);

Virtual Agent - SMS Twilio Adapter 
Default Multi Link Outbound 
Transformer

(function execute(inputs, outputs) {
  var rich_control = 
 inputs.rich_control;
  var linkResult = 
 rich_control['header'];
  var totalValues = 
 rich_control['values'].length;
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Examples: Outbound transformer scripts  (continued)

Outbound transformer name Script example

  for (var i = 0; i < totalValues; 
 i++) {
    linkResult = linkResult + '\n';
    var linkValue = 
 rich_control['values'][i];
    linkResult = linkResult + '\n' 
 + linkValue['description'] + ': ' + 
 linkValue['action'];
  }
  outputs.result  = linkResult;
})(inputs, outputs);

Virtual Agent - SMS Twilio 
Adapter Default Card Outbound 
Transformer

(function execute(inputs, outputs) {
  var richControl = 
 (inputs.rich_control);
  var data = 
 JSON.parse(richControl.data);
  var tableTitle = data.title;
  var fields = data.fields;
  var subtitle = data.subtitle;
  var url = data.url;
  var message = subtitle ? 
 getCardLine(tableTitle, subtitle) : 
 tableTitle + "\n";
  for (var i= 0; i<fields.length; i++) 
 {
     message += 
 getCardLine(fields[i].fieldLabel, 
 fields[i].fieldValue);
  }
  message += url;
  outputs.result = message;
 
  function getCardLine(key, value) {
      if (value == '' || value == null 
 || key == '' || key == null)
          return;
      return key + ": " + value + 
 "\n";
  }
})(inputs, outputs);

Inbound transformer scripts

The inbound transformer scripts convert incoming conversational custom chat integration 
messages to a protocol that the Virtual Agent  recognizes. It determines the required value to be 
injected into the rich control that is presented to the user.

Input.
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• request_context (JSON) - The request passed from the Provider Attribute script.

• rich_control (JSON) - The last rich control sent to the requester that contains the original 
"question".

Output.

result (JSON) - The result expected by the Virtual Agent  server. If the requester is responding to a 
topic picker, it is the sys_id of the topic. If the requester is responding to an input text, it is the text 
response.

• value - sys_id or text value.

• search_text - Text that is used if the requester selected something that was unexpected. For 
example, a user typed something that the NLU could assist with, such as, "None of these 
options match what I want" in response to a topic picker component.

Examples: Inbound transformer scripts

Inbound transformer name Script example

Virtual Agent - SMS Twilio Adapter 
Default Text Inbound Transformer

Purpose: Find the text response to 
the InputText question posed

(function execute(inputs, outputs) {
  var requestContext = 
 inputs.request_context;
  var richControl = 
 inputs.rich_control;
  var typedValue = 
 requestContext['typed_value'];
  var attachmentValue = 
 requestContext['attachment_value'];
  var smsUtil = new 
 VASMSTwilioUtil();
  var result = {};
  if(richControl['itemType'] == 
 'image' || richControl['itemType'] 
 == 'file') {
    if (attachmentValue && 
 attachmentValue.content_type.include
s('image')) {
      result.url = 
 attachmentValue.url;
      result.content_type = 
 attachmentValue.content_type;
      result.name = 
 attachmentValue.name;
      result.headers = 
 attachmentValue.headers;
    } else if (typedValue) {
      result.url = typedValue;
      var contentType = 
 smsUtil.getContentType(typedValue);
      if (typeof contentType === 
 'undefined')
        gs.error('Please enter a 
 valid image link. Inbound image 
 link: {0}', typedValue);
      else
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Examples: Inbound transformer scripts  (continued)

Inbound transformer name Script example

        result.content_type = 
 contentType;
    } else {
      gs.error('Please upload 
 an image or enter a valid image 
 link.');
    }
  }
  result['value'] = typedValue;
  result['search_text'] = '';
  outputs.result = result;
})(inputs, outputs);

Virtual Agent - SMS Twilio Adapter 
Default Picker Inbound Transformer

Purpose: Find the sys_id of the 
option that the user selected for 
this picker question. This script 
uses the same algorithm of the 
outbound transformer. If no options 
are selected, and the user typed 
something instead, then the 
"search_text" is set and fed into 
NLU if it is enabled on this instance.

(function execute(inputs, outputs) {
  var request_context = 
 inputs.request_context;
  var rich_control = 
 inputs.rich_control;
  var selectedValue = 
 request_context["typed_value"];
  var result = {};
  result["value"] = "";
  result["search_text"] = "";
  if (rich_control['options']) {
    var options = 
 rich_control['options'];
    var optionsLength = 
 options.length;
    selectedValue === 
 Number(selectedValue)
    if (selectedValue > 0 && 
 selectedValue <= optionsLength) {
        var selectedOption = 
 options[selectedValue - 1];
        result["value"] = 
 selectedOption.value;
    } else {
        result["search_text"] = 
 request_context["typed_value"];
    }
  }
  outputs.result = result;
})(inputs, outputs);

Set up trusted media domains for secure file upload

Virtual Agent uses trusted media domains to check the URLs of attachment files before 
uploading them. If a URL is not from a trusted domain, Virtual Agent will not upload the 
attachment.

Before you begin
Role required: admin
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About this task
For custom chat integrations, specify trusted media domains in either the Provider 
[sys_cs_provider] table or the Provider Channel Identity [sys_cs_provider_application] table. The 
trusted media domain values in the Provider Channel Identity table override the corresponding 
values in the Provider table.

Pre-built integrations, such as Slack, Microsoft Teams, and Workplace from Facebook, have 
default trusted media domain values set at the provider level, in the Provider [sys_cs_provider] 
table. To change the default trusted values, specify the different trusted media domains in the 
Provider Channel Identity [sys_cs_provider_application] table.

Procedure

1. Navigate to All  > sys_cs_provider_application.list  > Provider Channel Identity  and click New.

2. On the form, fill in the fields.

Provider Channel Identity form

Name Name of the channel identity. For example: VA SMS Twilio 
Adapter

Provider Select the name of your provider application that you set up 
previously. For example: VA SMS Twilio Adapter Pro.

Message auth Message authentication for the channel identifier.

Inbound ID Identifier for your bot. For example, the phone number.

Trusted media domains
Comma-separated list of one or more trusted domains for the 
provider. For example: twilio.com, slack.com

Note: 
Subdomains under a trusted domain are also trusted. You do 
not need to specify subdomains in this list.

If this field is not visible, you can configure the form layout  to 
show it.

For security reasons, Virtual Agent  checks that the URLs for 
attachments in conversations are from trusted domains specified 
here. If the URL is not for a trusted domain, Virtual Agent  doesn't 
upload the attachment.

If an attachment upload fails because Virtual Agent  didn't trust 
the domain, Virtual Agent  does not inform the end user why the 
attachment upload failed.

Note: 
For Trusted Domains In custom chat integrations, the values 
specified in the Trusted media domains field of the Provider 
Channel Identities table [sys_cs_provider_application] takes 
precedence over the Connections table [sys_cs_provider] 
and hence overrides.

Short description Description for your channel identifier.
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3. Click Submit.

4. Optional:  Create additional channel identifiers using the same procedure.

Create bot messages

Create channel-specific bot messages.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Channel Integrations  > Connections  and select 
a connection.

2. In the Provider Channel Identity  tab, select a provider channel identity.

3. Select New  in the Bot Messages  table.

4. In the form, fill in the fields.

Bot Messages Form

Field Description

Name Name of your bot message

Value Text displayed when a bot message is 
triggered

Description Description of the bot message, such as 
Welcome message or Instructional message 
for image upload

Message Type Default selection is Bot Message

Provider Channel Identity Select the Provider Channel Identity

5. Select Submit.

Bot message implementation

Use the bot messages API to implement channel-specific bot messages.

Bot message API

Use the following API to incorporate bot messages into your custom chat integration.

Example: Bot message implementation

function getBotMessage(providerId, inboundId, botMessageName) {
    // fetch the bot message using bot messages api
    var botMessages = 
 sn_cs.VASystemObject.getAllBotMessages(providerId, inboundId);
    if (botMessages && botMessages[botMessageName]) {
        var botMessage = botMessages[botMessageName];
        botMessage = botMessage.trim();
        if (botMessage) {
            return botMessage;
        }
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    }
}

Integrate custom controls

Implement and leverage custom controls built using the custom control framework in your 
integration.

Before you begin
Role required: virtual_agent_admin or admin

About this task
Map custom controls to a provider channel.

Implement custom controls created in Flow Designer

Use the example script to implement custom controls created in Flow Designer.

Example: Custom controls support

{
    uiType: "CustomControl",
    group: "DefaultCustomControl",
    name: "The name of the Custom Control 
 (sys_cs_custom_control.name)",
    required: true/false,
    uxComponentDefinitionSysId: "seismicComponentId" // 
 or null if not
    isInput: true/false, // whether to wait for a 
 response value or if just output
    serializedControlData: "User defined JSON from 
 generateControlData function";
}

Example: Custom controls script

(function execute(inputs, outputs) {
    var rich_controls = inputs.rich_control;
    //this is the data returned from the 'serialized 
 control data function' defind in designer
    var serializedControlData = 
 rich_control['serializedControlData'];
    // if this rich control will require a response to 
 move forward in topic flow
    var isInput = rich_control['isInput'];
    // if the component is suggesting using a Seismic 
 control (web) that handles this
    var uxComponentDefinitionId = 
 rich_control['uxComponentDefinitionSysId'];
    // the name of the custom control
    var name - rich_control['name'];
 
    // 1) now perform some logic to transform this 
 data into a custom ui (slack/facebook/sms ascii 
 art/html/etc)
    // 2) attach to outputs, i.e. 
 outputs.text_message='foo :)'; for sms twillio
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    // basic flow is to take the 
 serializedControlData/Name/compId(optional) and create 
 a custom UI component here
    // that your client understands (i.e. a slack rich 
 form payload)
})(inputs, outputs);

Implement a provider-specific transformation of a custom control

You can implement a provider-specific transformation for each custom 
control by using the Sub type  field in the Custom Adapter Configuration 
[sys_cs_custom_adapter_config] table. You can publish a newer version of a custom 
control or a pre-built, ServiceNow  custom control, also referred to as a default 
custom control, if needed. This involves publishing the appropriate Inbound and 
Outbound Flow Designer action scripts and updating the configuration in the 
Custom Adapter Configuration [sys_cs_custom_adapter_config] table.

• If you're publishing your own version of a ServiceNow  custom control, overwrite 
the custom control record in the Custom Adapter Configuration table with your 
own Inbound and Outbound action script names.

• Only one record with the same Sub type  is allowed. If the same custom control 
is implemented by two different parties, only one can update the existing record 
with new Inbound and Outbound transformers.

Note: 
Once you override an existing custom control record, the system uses the 
new version of the custom control. For example, transformation scripts can 
transform multiple custom controls, such as Time Picker and Auth. If you add 
a Time Picker control with different inbound and outbound transforms, the 
newer Time Picker control is used. You cannot revert to the original version of 
the custom control.

Procedure

1. Navigate to All, and then enter  sys_cs_custom_adapter_config.list  in the filter.

2. Select New.

3. On the form, fill in the fields.

Custom Adapter Configurations form

Field Description

Provider The name of the channel identifier for your custom chat 
integration. For details, see Create a channel identifier for 
your custom chat integration.

Control type
Select the custom control that you designed. For custom 
controls, the type is always DefaultCustomControl.

To learn more about custom controls, see Customizing 
Virtual Agent with custom controls.

Sub type Name of the custom control.

Inbound transformer action Name of the inbound transformer action 
script for this rich control, such as, 
sn_va_sms_twilio.va_sms_twilio_adapter_input_text_inbound_transformer.
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Field Description

Outbound transformation 
action

Name of the outbound transformer 
action script for this rich control, such as, 
sn_va_sms_twilio.va_sms_twilio_adapter_input_text_outbound_transformer.

4. Select Submit.

Multi-step responses

An example of multi-step response is a set of images in a carousel or a date control.

Multipart Control Attributes for RichControl in UI Transformation

Multipart Control richControl has the following attributes, which can be used to transform control.

• content: Rich Control which must be presented in current step.

• navigationBtnLabel: Label for "next" or "more" button for user to click to move to next step.

Example:

{
        uiType: "MultiPartOutput",
        group: "DefaultMultiPartOutput",
        navigationBtnLabel: "Go next",
        content: {
                uiType: "OutputHtml",
                style: "inline",
                type: "html",
                height: 100,
                width: 100,
                value: "<div>html</div>"
        }
}

Outbound transformation script

(function execute(inputs, outputs) {
 
    try{
      var richControl = inputs.rich_control;
      var payload = inputs.payload;
 
      var content = richControl.content;
      var navigationBtnLabel = richControl.navigationBtnLabel;
      var uiType = content.uiType;
      var partResult = null;
 
      switch (uiType) {
        case "OutputText":
          partResult = 
 sn_fd.FlowAPI.executeActionQuick('example_default_text_outbound
_transformer', {
              rich_control : content,
              payload : payload
            });
          break;
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        case "OutputLink":
          partResult = 
 sn_fd.FlowAPI.executeActionQuick('example_default_output_link_o
utbound_transformer', {
              rich_control : content,
              payload : payload
            });
          break;
        case "OutputImage":
          partResult = 
 sn_fd.FlowAPI.executeActionQuick('example_default_image_outboun
d_transformer', {
              rich_control : content,
              payload : payload
            });
          break;
        case "OutputHtml":
          partResult = 
 sn_fd.FlowAPI.executeActionQuick('example_default_html_outbound
_transformer', {
              rich_control : content,
              payload : payload
            });
          break;
        default:
          break;
      }
      partResult =  partResult + 
 addButtonMore(navigationBtnLabel)
      outputs.result = JSON.stringify(outActivity);
    }
    catch(e){
      gs.error("Error in default multipart outbound 
 transformer : " + e.message);
      throw e;
    }
 
  })(inputs, outputs);

Inbound transformation script

  (function execute(inputs, outputs) {
    try {
      var requestContext = inputs.request_context;
      var typedValue = requestContext.typed_value;
      outputs.result = typedValue;
    } catch(e) {
       gs.error("Error in default multipart inbound 
 transformer : " + e.message);
       throw e;
    }
  })(inputs, outputs);

Multi-response output controls

Implement controls that involve multiple steps to get user input.
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Use the following API to configure context data for multi-output controls.

Common use cases

1. To achieve pagination of pickers: page_no, pagination_length updated in inbound based on 
next/previous button is read in outbound.

2. Step by step response of date picker like first year, then month, and then date selection.

The following APIs are only available in inbound and outbound transformers.

sn_cs.VASystemObject.setProviderUserContext( key, contextData, 
 providerAppId, providerUserId);
sn_cs.VASystemObject.getProviderUserContext(key, providerAppId, 
 providerUserId);
sn_cs.VASystemObject.removeProviderUserContext(key, 
 providerAppId, providerUserId);
sn_cs.VASystemObject.removeAllProviderUserContext(providerAppId, 
 providerUserId)

The outbound transformer of the picker control can store current page details in user 
contextData.

 var paginationData = {
          "page_index": 1,
          "pagination_length": 2
    }
};
sn_cs.VASystemObject.setProviderUserContext("picker_pagination", 
 paginationData, providerAppId, providerUserId, );

The inbound transformer of picker control can get current page details from user contextData.

var paginationData = 
 sn_cs.VASystemObject.getProviderUserContext("picker_paginatio
n", providerAppId, providerUserId);

Example code for picker control outbound transformer

(function execute(inputs, outputs) {
    var control = inputs.rich_control;
    var payload = inputs.payload;
    var appId = payload.appId;
    var userId = payload.userId;
 
    var paginationData = 
 sn_cs.VASystemObject.getProviderUserContext('picker_control', 
 appId, userId);
    paginationData = JSON.parse(paginationData);
    //First time when the outbound picker is called when 
 selecting the topic.
    if (paginationData == null) {
        paginationData = {
            'page_index': 1,
            'pagination_length': 5
        };
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 sn_cs.VASystemObject.setProviderUserContext('picker_control', 
 paginationData, appId, userId);
    }
 
    var page_index = paginationData['page_index'];
    var pagination_length = paginationData['pagination_length'];
    var start = (page_index - 1) * pagination_length;
    var end = page_index * pagination_length;
 
    if (control['options']) {
        var options = control['options'];
        var optionsLength = options.length;
        if (end > optionsLength)
            end = optionsLength;
        var picker = control["label"] + ":";
        if (start > 0)
            picker += "\n" + "*" + ": " + "prev";
        for (var x = start; x < end; x++) {
            gs.log("here " + x + " : " + options[x]);
            picker += "\n" + (x + 1) + ": " + options[x].label;
        }
        if (end < optionsLength)
            picker += "\n" + " " + ": " + "next";
    }
    outputs.text_message = picker;
})(inputs, outputs);
Example Picker Control Inbound Tranformer
(function execute(inputs, outputs) {
 
    var request_context = inputs.request_context;
    var rich_control = inputs.rich_control;
    var appId = request_context.appId;
    var userId = request_context.userId;
 
    var selectedValue = request_context["typed_value"];
    var result = {};
    result["value"] = "";
    result["search_text"] = selectedValue;
 
    var options = rich_control['options'];
 
    var paginationData = 
 sn_cs.VASystemObject.getProviderUserContext('picker_control', 
 appId, userId);
    paginationData = JSON.parse(paginationData);
 
    switch (selectedValue) {
        case 'prev': {
            --paginationData["page_index"];
            result["send_prev_control"] = true;
        }
        break;
    case 'next': {
        ++paginationData["page_index"];
        result["send_prev_control"] = true;
    }
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    break;
    default: {
        var selectedIndex = Number(selectedValue) - 1;
        if (paginationData["page_index"] != undefined && 
 paginationData["pagination_length"] != undefined) {
            var highestOptionInPage = 
 paginationData["page_index"] * 
 paginationData["pagination_length"];
            if (selectedIndex >= 0 && selectedIndex < 
 highestOptionInPage) {
                var selectedOption = options[selectedIndex];
                result["value"] = selectedOption.value;
                result["search_text"] = "";
            }
        } else {
            var selectedOption = options[selectedIndex];
            result["value"] = selectedOption.value;
            result["search_text"] = "";
        }
    }
    }
   
 sn_cs.VASystemObject.setProviderUserContext('picker_control', 
 paginationData, appId, userId);
    outputs.result = result;
})(inputs, outputs);

Send previous control to client

Provide the ability to send previous control to client.

There are two ways to send previous control back from the server when a client requests:

• In inbound transformation, set validation_message  in result. Previous control will be sent 
again with message provided in validation_message.

• In inbound transformer, set send_prev_control  in result to true, previous control will be 
sent again. Use this method for Multi-Step controls.

Example script:

(function execute (inputs, outputs) {
  var result = {};
  var request_context = inputs.request_context;
  var typed_value = request_context ['typed_value'];
  if (typed_value.index0f(" ") > -1)
    result["validation_message"] = "Invalid character, please 
 don't enter special character ' '";
  result["value"] = typed_value;
  result["search_text"] = "";
  outputs.result - result;
})(inputs, outputs);

Implement a skip option

Use a rich control to provide the option for users to skip a question.

Use the rich control \nType SKIP to skip question  to provide the option for a user to 
skip a question. There are two ways to configure a skip option:
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• In the provider attributes script, use _skip_internal  to trigger a contextual action service 
to skip the question.

• Map a contextual action for the provider and use 
//request_context.contextual_action = "SKIP"  to skip the question. See 
Contextual actions for custom chat integrations  to learn more about mapping user inputs to 
contextual actions.

Example script:

va_sms_twilio_adapter_default_text_outbound_transformer
(function execute(inputs, outputs) {
  try {
    var richControl = inputs.rich_control;
    outputs.result = richControl['label'];
    if (richControl['required'] === false && 
 richControl['uiType'] != "OutputText") { // new
      outputs.result += "\nType SKIP to skip question"; // new
    } // new
  } catch(e){
    gs.error('Error in default text outbound transformer: ' + 
 e.message);
    throw e;
  }
})(inputs, outputs);
va_sms_twilio_adapter_provider_attributes
(function execute(inputs, outputs) {
    try {
        var headers = (inputs.headers);
        var payload = (inputs.payload);
        var smsUtil = new VASMSTwilioUtil();
        outputs.token = JSON.stringify(smsUtil.getToken(headers, 
 payload));
        var data = payload.data;
        var request_context = {};
        if (data['MediaUrl0']) {
            var attachment_value = {};
            attachment_value.url = data['MediaUrl0'];
            attachment_value.content_type = 
 data['MediaContentType0'];
            attachment_value.name = 
 smsUtil.getFileName(attachment_value.url , 
 attachment_value.content_type);
            request_context.attachment_value = attachment_value;
        } else {
           var b = data['Body']; // new
           request_context.typed_value = b; // new
           if (b === "SKIP") { // new
             request_context.typed_value = "_skip_internal"; // 
 new
             //request_context.contextual_action = "SKIP"; // 
 new
           } // new
        }
        outputs.request_context = request_context;
        outputs.provider_user_id = data.From;
    } catch (e) {
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        gs.error("Error in 
 va_sms_twilio_adapter_provider_attributes : " + e.message);
    }
})(inputs, outputs);
contextual_action (all new)
(function execute(inputs, outputs) {
  var contextual_action = 
 inputs.request_context.contextual_action;
  if (contextual_action === "SKIP") {
     
 sn_cs.VASystemObject.skipOptionalQuestion(inputs.conversation_i
d);
  }
})(inputs, outputs);

Pass branding to a chat client

Pass custom branding to your custom chat integration.

See Set up your Virtual Agent bot's branding  for more information about branding. Use 
sn_cs.VASystemObject.getSettings  to apply branding.

Example script:

va_sms_twilio_adapter_default_text_outbound_transformer
(function execute(inputs, outputs) {
  try {
    var richControl = inputs.rich_control;
    var branding = 
 sn_cs.VASystemObject.getSettings("default_branding"); // new
    var header = "(" + branding["header_label"] + ") "; // new
    outputs.result = header; // new
    outputs.result += richControl['label'];
  } catch(e){
    gs.error('Error in default text outbound transformer: ' + 
 e.message);
    throw e;
  }
})(inputs, outputs);

Contextual actions for custom chat integrations

Commands with a pre-defined behavior can be mapped to certain user-friendly keywords 
and passed as user input. This input is mapped to supported contextual actions for the most 
appropriate response in the chat.

Getting started with contextual actions

User inputs can be mapped to a contextual action in two ways.

• UI-based mapping of comma-separated keywords to available contextual actions. For example: 
Hi, Hola - Start Conversation

• Script-based mapping of user actions to available contextual actions. For example: User clicks 
"Start" menu - Start Conversation
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Available contextual actions

Pre-built contextual actions

Name Description

Agent Command to request transfer to a live agent

Bye Command to end a conversation with a live 
agent or a virtual agent whenever you are 
outside of a topic-selection prompt

Help Command to request help using the bot

Hi Command to start or end a conversation

Logout Command to unlink the user messaging 
account from ServiceNow

Notifications Command to subscribe or unsubscribe from 
receiving notifications

Restart Command to end a bot conversation that is 
either in progress or runs into an error, and 
then begin a new conversation

Contextual action mapping

Map user inputs to base system contextual actions.

Before you begin
Role required: admin

About this task
Use the Contextual Actions [sys_cs_contextual_action] table to review the commands used in 
the chat integrations. You can add more keywords for a command. Each record for a pre-built 
command has this information:

Contextual Actions fields

Field Description

Name Name of the command.

Commands Keyword for the command. You can add multiple keywords, separated 
by commas.

Description Explanation of the command

Applicability Application in which the command is used:

• Virtual Agent  only

• Agent Chat  only

• Virtual Agent  and Agent Chat

Procedure

1. Navigate to All, and then enter sys_cs_contextual_action.list  in the filter.

2. Select a contextual action from the list.
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3. Add comma-separated keywords to the command  field.
For example: Agent, Live Agent, Transfer to agent.

4. Optional:  Exclude specific messaging channels from contextual actions.

a. Select the Insert a new row...  text.

b. Select the magnifying glass.

c. Select the messaging channel you would like to exclude from the contextual action.

d. Select the green checkmark to save.

5. Select Update.

What to do next
Create bot messages  specific to each channel.

Typing indicators

Display a typing indicator when a bot or live agent is preparing a response to a requester.

When Virtual Agent  processes a request, the Start typing indicator action is called. When Virtual 
Agent  completes the request processing, the End typing indicator action is called before Virtual 
Agent  processes any output or input controls.

These actions call the defaultText control outbound transformation. The following example shows 
how the typing indicator is handled in the defaultText control outbound transformation.

Example: Typing indicator script

(function execute(inputs, outputs) {
    try {
        var richControl = inputs.rich_control;
        var actionType = richControl.type;
        if(actionType == 'StartTypingIndicatorActionMsg'){
            outputs.result = '{activity:{type: "typing" }}'
        }else if(actionType == 'EndTypingIndicatorActionMsg'){
            outputs.result = '{activity:{type: "message" , text: 
 "Finished typing"}}'
        }
       /* Handle other type of control */
    } catch (e) {
        gs.error("Error in default action outbound transformer : 
 " + e.message);
        throw e;
    }
})

Virtual Agent  integration with messaging apps

Enable users to run Virtual Agent  bot conversations in supported third-party messaging apps. 
Use the Conversational Integration apps for Slack, Microsoft Teams, and Workplace that are 
available from the ServiceNow Store  to configure these messaging apps on your ServiceNow 
instance.

Note: 
Conversational Integration apps for Slack, Microsoft Teams, and Workplace, other 
consumer apps and voice apps are not supported for on-prem instances.
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Admin setup

Use the Virtual Agent  Conversational Integration apps to configure the messaging applications 
for your instance. Perform these basic installation steps to set up the Virtual Agent  bot.

1. Install the Conversational Integration messaging apps, that are pre-built with ServiceNow 
Virtual Agent from the ServiceNow Store  and then associate the app with your own ServiceNow 
instance.

For details, see Integrating Virtual Agent with enterprise messaging apps.

2. Install the Conversational Integration apps for Slack, Microsoft Teams, and Workplace, LINE, 
Twilio, WhatsApp, Facebook Messenger, Alexa, Google Assistant, Google Business Messages, 
Amazon Connect, on your ServiceNow  instance once they become available for installation 
after installing from the ServiceNow Store.

Channels and integrations

3. If needed, configure the system messages that users see in Virtual Agent  conversations. You 
can also customize the common commands used in these messaging integrations.

Conversational interface in messaging integrations

The Virtual Agent  interface for the Conversational Integration apps (Slack, Microsoft Teams, and 
Workplace) is similar to the web-based interface. However, there are some differences, such as 
commands used and how certain interface controls are displayed in these third-party messaging 
apps.

Common commands in messaging integrations

Command Description

Hi Begin a new conversation or end a 
conversation.

agent Begin a new conversation or request a 
transfer to a live agent.
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Command Description

bye Leave a live chat conversation at any 
time, for example before engaging with 
a live agent, during a live chat, or when 
live chat is about to end.

help Displays a short list of useful 
commands.

logout Unlink your ServiceNow  account from a 
messaging integration.

notification or 
notifications

Subscribe to or unsubscribe from 
notifications.

restart End the current conversation and begin 
a new one.

After you install the integration, you can customize these commands by using the 
Configure  button for the installed teams/communities in the channel specific 
pages.

1. Navigate to All  > Conversational Interfaces  > Settings.

2. In General Settings  under Channels and integrations, click View All.

3. On the Channels and integrations page, you can see the number of integrated 
channels and available channels for installation on your instance.

4. Click the Manage  button in the specific channel and navigate to the Settings tab.

5. Click the view settings  button against Contextual Actions.

6. Select the command record to be changed and update as needed.

Configuring Virtual Agent  system messaging in the Conversational Integration apps

You can modify the default messages displayed to your users in Virtual Agent  and 
Agent Chat  conversations. For details on customizing them, see Change Virtual 
Agent and Agent Chat system messages.

Rendering of input controls and bot responses in conversations

Input controls in Virtual Agent Designer, such as the Carousel render differently in 
bot conversations in messaging apps than in the web-based interface. For example, 
the Date Time picker control in Workplace presents buttons for users to select a 
date and time. Similarly, certain bot response controls, such as the Image response 
and Multi-response controls, also render differently in third-party messaging apps. 
For details on these differences, see the descriptions of the Virtual Agent Designer 
input controls, bot responses, and utilities.

Attachments

In live agent conversations, users and agents can upload and exchange any type of 
attachment file when prompted.

Redirect user authentication to a Service Portal

After installing a pre-built Conversational Integration (for messaging apps, Consumer apps or 
voice apps), you can specify a Service Portal  in which unauthenticated end users complete the 
user authentication step (user account linking), instead of in their ServiceNow  instance. Users 
who do not have linked accounts complete authentication before continuing with the virtual 
agent in the messaging application.
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Before you begin
Install the Virtual Agent  messaging integrations for your instance. The system creates a record 
in the Provider Auth [provider_auth] table for each integration that you install (Slack, Microsoft 
Teams, and Workplace, LINE, Twilio, WhatsApp, Facebook Messenger, Alexa, Google Assistant, 
Amazon Connect). You use the Provider Auth table to specify the Service Portal  in which user 
authentication occurs.

Role required: admin

Procedure

1. In the navigation filter, type provider_auth.list.

2. In the Provider Auth table, open the record for the messaging integration you installed.

3. In the Service Portal  field, select the Service Portal in which user authentication occurs.

4. Click Update.

Result
When unauthenticated users start a conversation with the virtual agent for the first time in the 
messaging integration, they are redirected to the Service Portal  specified for the provider in 
the Provider Auth table. After they log in to the Service Portal, they are prompted to link their 
ServiceNow  account to the messaging application.

Configure the IBM Watson Assistant  Chat integration

Set up the IBM Watson Assistant  topic to run dialog skills (conversations created in IBM Watson 
Assistant) in the web-based chat client. This topic returns information exchanged during the 
virtual agent conversation to IBM Watson Assistant.

Before you begin

• In IBM Watson Assistant:

◦ Create the dialog skill (conversation) in your IBM Watson Assistant  workspace. The skill 
includes the dialog and any intents and entities that you define.

◦ Navigate to your skill tile and in the tile menu, select View API Details. View the Skill Details 
and Service Credentials. Copy the following items: Skill ID, Workspace ID, Username, and 
Password. You need these items when setting up this integration.

• Activate the IBM Watson Assistant  Integration plugin (com.glide.cs.ibm.watson.assistant).

Role required: virtual_agent_admin or admin

About this task
This topic runs an IBM Watson Assistant  dialog in Virtual Agent. It doesn't require enabling 
Natural Language Understanding  (NLU) or setting IBM Watson Assistant  NLU  as the NLU  service 
provider for Virtual Agent.

Procedure

1. In your ServiceNow  instance, update the watson_assistant.workspaceID system property.

a. In the navigation filter, enter sys_properties.list.

b. In the System Properties [sys_properties] table, locate the watson_assistant.workspaceID 
property.

c. Replace the existing Value  with the Workspace ID  for your skill, and select Update.

2. Verify that the REST message for IBM Watson Assistant  provides the correct authentication 
endpoint for your IBM skill:
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a. Navigate to System Web Services  > Outbound  > REST Message.

b. Select the IBM Watson Assistant  record to open the REST Message IBM Watson Assistance 
form.

c. Confirm that the Endpoint  field and the Endpoint  column displayed on the Authentication 
tab have the correct endpoint URL for your IBM Watson account.

3. In the Basic auth profile  field on the Authentication  tab, open the Assistant Profile record.

4. In the Basic Auth Configuration form, enter the Username  and Password  values from your IBM 
Watson Assistant  Service Credentials, then select Update.

5. Publish the IBM Skill topic:
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a. Navigate to Conversational Interfaces  > Virtual Agent  > Designer.

b. In the Topics page, select the IBM Watson Assistant  topic to open the Topic Properties page.
Notice that the Keyword  for this topic is IBM Watson Assistant  and the Category  is IBM.

c. In the Topic Properties page, select Publish  to deploy the topic to your Virtual Agent  web 
client.

6. Configure the default topic for the Virtual Agent  web client in one of the following ways:

◦ Provide the URL that specifies the IBM Watson Assistant  topic as the default topic that 
opens in the Service Portal  client:

For example: https://<Your instance URL>$sn-va-web-client-
app.do?sysparm_skip_load_history=true&sysparm_topic=<sys_id>  
where <sys_id>  is the sys_id of the published IBM Watson Assistant  topic. The 
sysparm_skip_load_history  parameter doesn't load the conversation history in the 
web client.

◦ Configure the Service Portal  widget by selecting the edit (pencil) icon in the upper right 
corner of the Virtual Agent  widget.

To set the default topic using the widget instance parameters, enter 
sysparm_topic=sys_id  (where <sys_id>  is the sys_id of the published IBM Watson 
Assistant  topic) in the Virtual Agent Client URL Parameters  field, and select Save.

Note: 
You can find the sys_id of a topic in the Topics [sys_cs_topic] table.

Important: 

Use the sysparm_topic  parameter only to load the given topic in the Service 
Portal  chat client or when using the IBM Watson Assistant  chat integrations 
(com.glide.cs.ibm.watson.assistant.topic and com.glide.cs.ibm.watson.assistant.topicV2 
plugins). This parameter doesn’t allow users to start a new conversation or transfer to a 
live agent. It also disables the context menu and doesn't support other third-party chat 
clients.

Configure the IBM Watson Assistant  Chat integration for the Assistant V2 API

Configure the IBM Watson Assistant  Chat Integration to run a dialog skill (conversation) created 
in IBM Watson Assistant  with the Assistant V2 API. The V2 API enables the Virtual Agent  web 
chat client to run a topic that uses Watson Assistant's intent disambiguation feature to improve 
topic discovery.

Before you begin
With the IBM Watson Assistant  v2 API chat integration, the web chat client communicates 
with an assistant instead of with a workspace. Workspaces are referred to as dialog skills. For 
information on IBM Watson Assistant, see Migrating to the v2 API  in the IBM Watson Assistant 
documentation.

Role required: virtual_agent_admin or admin

About this task
This integration runs an IBM Watson Assistant  dialog as a Virtual Agent  topic in the web chat 
client. It doesn't require enabling Natural Language Understanding  (NLU) or setting IBM Watson 
Assistant  NLU  as the NLU  service provider for Virtual Agent.
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The IBM Watson Assistant  V2 API enables the web chat client to use the Watson Assistant intent 
disambiguation feature, which can potentially reduce false-positive intent predictions. If a user's 
utterance is ambiguous, IBM Watson Assistant  suggests additional intents that might better 
match the user's true intention. For example, if the user utterance is restaurant, IBM Watson 
Assistant  can suggest other possible intents, such as book a restaurant  or restaurant 
reviews.

Procedure

1. Configure IBM Watson Assistant.

a. Create your assistant, then add a dialog skill.
For details, see Creating an assistant  in the IBM Watson Assistant  documentation.

b. On the Resource list page, locate and record your API key and URL, which you need to set up 
the chat integration:

c. Select the three vertical dots icon  and select Settings.

▪ Select the API Details  tab.

▪ On the Assistant Settings page, find the Assistant ID  key.

2. Enable the disambiguation feature in IBM Watson Assistant  (for premium and plus users only).
You can enable (or disable) disambiguation for each skill, and also specify a disambiguation 
message and the number of suggestions to be displayed to the end user.

a. Access your skill by selecting the skill tree icon  in the panel.
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b. Navigate to Options  > Disambiguation  to enable disambiguation and set the disambiguation 
features.
The following example shows the disambiguation features that can be set, such as the 
disambiguation message and the number of suggested intents to be displayed to the end 
user.

3. Navigate to Dialog, select a node to which the disambiguation feature will apply, and provide a 
summary of the node that will be displayed to users if it's one of the intent suggestions.
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4. In your ServiceNow  instance, activate these plugins:

◦ Glide Virtual Agent (com.glide.cs.chatbot), if not already activated (requires a subscription)

◦ IBM Watson Assistant Integration V2 plugin (com.glide.cs.ibm.watson.assistant.topicV2)

5. In Virtual Agent Designer, publish the IBM Watson Assistant  V2 topic:

a. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer.

b. In the Topics page, select the IBM Watson Assistant  V2 topic to open the Topic Properties 
page.
Notice that the Keyword  for this topic is IBM Watson Assistant  V2.

c. In the Topic Properties page, select Publish  to deploy the topic to your Virtual Agent  web 
client.

6. Navigate to All, and then enter sys_properties.list  in the filter.

7. Update the following properties.
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◦ watson_assistant.v2.assistantID  — In the Value  field, enter the Watson 
Assistant ID for your assistant and select Update.

◦ watson_assistant.v2.service_endpoint  — In the Value  field, replace the 
existing value with your Watson Assistant URL and select Update.
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Note: 
You can specify just the location portion of the service instance URL in the Value 
field. For example, if the base URL for the IBM Watson service endpoint is https://
gateway.watsonplatform.net/assistant/api, you can enter just the location of the 
service instance, gateway.watsonplatform.net  in the Value  field.

If your Watson Assistant is hosted in a data center other than Dallas, such as 
Washington DC, your base URL is https://gateway-wdc.watsonplatform.net/assistant/
api. You would enter gateway-wdc.watston.platform.net  in the Value  field.

8. Set the Watson Assistant API key as the password in the IBM Watson Assistant  Profile.

a. Navigate to All, and then enter sys_auth_profile_basic.list  in the filter.

b. Open the IBM Watson Assistant  Profile record.

c. In the Basic Auth Configuration form, enter the Watson Assistant API key in the Password 
field and select Update.
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9. Add the Virtual Agent  (web chat) client to the Service Portal.

a. Navigate to Service Portal  > Service Portal Configuration.

b. Select Designer, and then select the Service Portal  landing page.

c. Search for the Virtual Agent  widget and drag the widget into the outlined area.
The purple chat icon appears in the bottom right corner.

10. Configure the Virtual Agent  widget by selecting the edit icon  in the upper right corner to set 
the URL parameters passed to the chat client and change the color of the floating chat button.

a. In the Virtual Agent Client URL Parameters  field, enter the 
sysparm_skip_load_history=true  parameter so that the topic history doesn't 
display in the chat client and the sysparm_topic  parameter with the sys_id of the 
published IBM Watson Assistant V2 topic to be run.
You can find the sys_id of a topic in the Topics [sys_cs_topic] table.

If you don't configure the instance behavior in Service Portal, you can specify your 
instance URL with the sysparm_topic  and sysparm_skip_load_history 
parameters when you open the chat web client. For example: https://
<Your instance URL>$sn-va-web-client-app.do?
sysparm_skip_load_history=true&sysparm_topic=<sys_id>   where 
<sys_id>  is the sys_id of the published IBM Watson Assistant  V2 topic to be run.

Important: 

Use the sysparm_topic  parameter only to load the given topic in the Service 
Portal  chat client or when using the IBM Watson Assistant  chat integrations 
(com.glide.cs.ibm.watson.assistant.topic and com.glide.cs.ibm.watson.assistant.topicV2 
plugins). This parameter doesn’t allow users to start a new conversation or transfer to a 
live agent. It also disables the context menu and doesn’t support other third-party chat 
clients.

b. To change the floating button color, enter the new color (RGB hex format) in the Floating 
Button Color  field.
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c. Select Save.

11. Test that the disambiguation feature is working for your topic.
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Be sure that disambiguation is enabled for your Watson Assistant skill and at least two dialog 
nodes. In the following example, the virtual agent provides four additional intents that the user 
can select.

Example topic with disambiguation

Account linking in pre-built messaging integrations

In Virtual Agent, account linking maps the users of a supported chat or messaging application to 
their ServiceNow  user profile. Account auto-linking authenticates your messaging users, which 
enables users to automatically access Virtual Agent  topics that involve ServiceNow  records. If 
needed, users can also manually unlink from or link to their ServiceNow  accounts.
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How account auto-linking works

In the Conversational Integrations for Slack, Microsoft Teams, and Workplace from Facebook, 
you have the option to enable account auto-linking, which automatically links messaging users 
to their ServiceNow  accounts. If you enable the account auto-linking feature on the Messaging 
Apps Integration page, your users are not prompted to link to their ServiceNow  accounts when 
they engage with the virtual agent.

In earlier releases, messaging users were prompted to link to their ServiceNow  accounts or 
continue as guests. However, for the Conversational Integrations for Slack, Microsoft Teams, and 
Workplace, if you enable account auto-linking, your users do not manually link their messaging 
accounts to their ServiceNow  accounts, provided that they use the same email account for 
their messaging and ServiceNow  accounts. During auto-linking, Virtual Agent  maps the email 
accounts of messaging users to their email accounts defined in their profiles in the Users 
[sys_user] table. When the email accounts match, the user is automatically linked (authenticated) 
and they do not see the Link to ServiceNow  button when they begin a bot conversation.

In messaging integrations, your users can still use the logout  command during bot conversations 
to unlink from their ServiceNow  accounts. However, in all subsequent conversations after 
unlinking, Virtual Agent  prompts them to link their accounts. When they engage with the virtual 
agent, they are prompted to link to their ServiceNow  account or continue as a guest user.

Account auto-linking

You can allow a user's 3rd party accounts to be auto-linked to their ServiceNow®  profile.

You can enable account auto-linking in the sys_cs_provider.list. This feature bypasses the 
prompt for the users to link their accounts manually.

Note: 
Account linking is possible only for users who belong to the same domain that was used for 
installing Microsoft Teams  on an instance. To auto-link users from other domains, ensure 
that Microsoft Teams  installation is done using the global domain.

In the navigation filter type sys_cs_provider.list. Select the connection record you 
wish to link. Check the Allow account linking  box, then check the Auto link users' ServiceNow 
profiles  box that appears. Fill in the Automatic link action  field with the corresponding account 
linking script.

Example: Account auto-linking script

var response_body = inputs['response_body'];
var status_code = inputs ['status_code'];
var email_id = '';
if(status_code>200 && status_code<=210){
    email_id = response_body && 
 JSON.parse(response_body).userPrincipalName;
}
var sysUserId = null;
 
if(email_id){
    var gr = new GlideRecord("sys_user");
    gr.addQuery("email",email_id);
    gr.query();
    while(gr.next()){
        sysUserId = gr.getUniqueValue();
    }
}
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if(sysUserId){
    outputs['status'} = 'Success';
    outputs['userid'] = sysUserId;
}
else{
    outputs['status'] = 'Failure';
}
 
})(inputs,outputs);

Unlink your ServiceNow  user account from a messaging application for Virtual Agent 
conversations

If needed, you can unlink your ServiceNow  user account from a messaging app used for the Now 
Virtual Agent.

Before you begin
Role required: user

About this task
Unlinking your account from a selected Conversational Integration for Slack, Microsoft Teams  or 
Workplace, deactivates the association between your ServiceNow  account and the messaging 
app. After you unlink your account, you can no longer engage in Virtual Agent conversations that 
query or change records in the ServiceNow  database.

Procedure

1. From within the messaging app, type logout.

2. From the application navigator, navigate to Self-Service  > My Profile.

3. Click the View Linked Accounts  related link.

4. In the Linked Accounts page, select the check box for the messaging integration to be 
unlinked.

5. Select Actions on selected rows, then click Unlink account.
The link between your ServiceNow  account and the Virtual Agent  messaging integration 
becomes inactive.

Note: 
Even though you unlinked your account, you can still run public Virtual Agent 
conversations.

6. To link your account again, repeat steps 1 through 3 for the associated messaging integration 
and in the Actions on selected rows..., click Link account.

Link your ServiceNow  user account to a messaging application for Virtual Agent 
conversations

Link your ServiceNow  account to a third-party messaging application to access non-public 
Virtual Agent  topics that use ServiceNow  records.

Before you begin
Role required: user

About this task
When you initially engage with the Virtual Agent bot, your messaging account is automatically 
linked to your ServiceNow account as long as the same email account is defined for both your 
messaging and ServiceNow accounts. However, if you unlinked your messaging account from 
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your ServiceNow account (using the logout  command), each time that you start a subsequent 
Virtual Agent session, the bot gives you the option to link to your ServiceNow account or 
continue as guest. The authentication step (linking) occurs in your instance or in a specific 
Service Portal, if set by your admin.

Procedure

1. Open the messaging application.

2. Find your Virtual Agent  bot.

3. Start a conversation with your Virtual Agent  bot.
The bot then presents a prompt that provides options to authenticate (Link to ServiceNow), 
continue as a guest user, or see the help menu (Check out Tips).

4. Select Link to ServiceNow  to authenticate.

Authentication directs you to your instance or a specific Service Portal  set by your admin. If 
you're not already logged in to your instance or a Service Portal, you are prompted to enter 
your login credentials.

Note: 
If a user is unlinked or continued as a guest, notifications will be disabled. Also, only the 
public topics are discoverable.

5. In the confirmation that appears prompting you to Confirm  or Deny  linkage between your 
accounts, select Confirm  to allow the account link.

6. After confirmation, you are directed to your instance user record.

A confirmation message is displayed at the top of the screen.

Related topics

Redirect user authentication to a Service Portal

Control topic visibility in Virtual Agent  messaging channels

Suppress the display of a topic in a Virtual Agent  messaging channel by using a condition script 
that excludes the topic from a channel.

Before you begin
Roles required:

• virtual_agent_admin and external_app_install_admin or admin

• Administrator for third-party applications
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About this task
In your condition script for the topic, use a context variable to identify the messaging channel 
that excludes this topic.

Procedure

1. Navigate to All  > Conversational Interfaces  > Virtual Agent  > Designer.

2. In the Topics page, select the topic for updating or create a new topic.

3. In the Condition  field on the Topic Properties page, enter a condition script that identifies 
the messaging channel (Slack, Microsoft Teams, Workplace from Facebook, or Facebook 
Messenger) from which the topic will be excluded.

You can use the following example script, which contains the vaContext.deviceType 
variable, to identify the messaging channel that excludes the topic: Slack, Microsoft Teams, 
Workplace, and Facebook Messenger.

(function execute()
{ if(vaContext.deviceType === 'Slack' || vaContext.deviceType 
 === 'Teams' || vaContext.deviceType=='Facebook' || 
 vaContext.deviceType=='Messenger'){
return false;
}
return true;
})()

4. To save the topic properties, click Save.

Result
Publishing the topic deploys it to the Virtual Agent  messaging channels, except for the Virtual 
Agent  channels that you specified in the topic condition script. A keyword or an intent (if using 
NLU) does not trigger the topic.

Integrating Virtual Agent with enterprise messaging apps

Integrating enterprise messaging apps such as Slack, Microsoft Teams, and Workplace  with 
ServiceNow®  Virtual Agent  associates the app with your ServiceNow  instance to facilitate 
conversations across the enterprise.

Conversational integrations are available for Slack, Microsoft Teams, and Workplace  from the 
ServiceNow Store.

Conversational Integration with Microsoft Teams

Enable requesters to chat with Microsoft Teams  or live agents using the Microsoft Teams 
application. Use the Conversational Integration with Microsoft Teams  app, available from the 
ServiceNow Store, to associate your instance with Microsoft Teams.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Overview

Use the Conversational Integration with Microsoft Teams  application to connect your end users 
with Virtual Agent  or live agents through your company’s Microsoft Teams  account. To get 
started, see Install Conversational Integration with Microsoft Teams.
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Important: 

• If your instance is in our GovtCommunityCloud  (GCC) environment, see to Integrating 
Virtual Agent with Microsoft Teams using the self-configured bot  for more information.

• If your instance is in our Australia SPP (ServiceNow Protected Platform) environment, 
see Enable Microsoft Teams integration in ServiceNow Protected Platform (SPP)  for more 
information.

• The Microsoft Teams Graph  spoke consumes Integration Hub  transactions, thus, usage 
of Virtual Agent  in Microsoft Teams  does count against Integration Hub  transactions. 
Microsoft is also monetizing Microsoft Teams  API usage, therefore such usage will also 
count against their Microsoft 365 subscription. For further information, see Sidebar and 
Microsoft Teams.

Workflow of Conversational Integration with Microsoft Teams

Integrating ServiceNow  Virtual Agent  with Microsoft Teams

Enables ServiceNow  Virtual Agent  to integrate with Microsoft Teams  application.

Install Conversational Integration with Microsoft Teams

You can install the Microsoft Teams  (sn_va_teams) application to integrate with Now Virtual Agent 
if you have the admin role.

Before you begin

• Ensure that the application and all of its associated ServiceNow Store  applications have valid 
ServiceNow  entitlements. For more information, see Get entitlement for a ServiceNow  product 
or application .

• If you're using an earlier release of Virtual Agent, you must upgrade to the 2023, February store 
release to use the features supported in this channel integration.
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• Conversational Integration with Microsoft Teams   requires the Glide Virtual Agent  plugin 
(com.glide.cs.chatbot) to activate full functionality in Virtual Agent  or the Virtual Agent  Lite 
plugin (com.glide.cs.chatbot.lite) to activate a limited version of Virtual Agent. Activate the 
appropriate plugin before you install the integration.

• Install the Conversational Integration with Microsoft Teams  app from the ServiceNow®  Store.

Important: 
Installing the Conversational Integration with Microsoft Teams  app from the ServiceNow 
Store  activates the app for integration on your ServiceNow  instance. If you have not 
installed the integration app, the Microsoft Teams  app is listed in the Available Channels 
section.

Channels and integrations page before Conversational Integration with 
Microsoft Teams  apps is installed

After you install the Conversational Integration with Microsoft Teams  app, Microsoft 
Teams  is seen in the Integrations section, and you can proceed with the configuration.

• Roles required:

◦ virtual_agent_admin and external_app_install_admin or admin.

◦ Microsoft Teams  administrator (one of the following): Global administrator, Application 
administrator, or Cloud Application administrator.

Note: 
These aren’t necessarily required. Microsoft allows non-admin users to give consent to 
some or all requested permissions. Granting non-admin consent is not recommended, 
as this may cause unexpected behavior in the Now Now Virtual Agent  application. 
Please review your user consent policies by consulting: https://learn.microsoft.com/en-
us/entra/identity/enterprise-apps/configure-user-consent?pivots=portal

About this task
Review these guidelines for using Virtual Agent  with Microsoft Teams.
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• The Microsoft Teams  app creates a one-to-one association between the ServiceNow  instance 
that you’re installing from and the Microsoft Teams  tenant in which the integration runs.

Use a separate Microsoft Teams  tenant for each instance that you plan to install the integration 
in. If you plan to test with a non-production instance and clone the instance, be sure to run the 
configuration steps again on the clone target to associate the bot to the new instance. Running 
the steps again disassociates the integration between the original non-production instance 
and the tenant.

• The Microsoft Teams  app doesn’t support the Microsoft Teams  premium account, which 
enables user email accounts other than Microsoft Office 365 accounts.

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. In General Settings  under Channels and integrations, select View All.

3. On the Channels and integrations page, in the Microsoft Teams  card, select Get Teams plugin.

You’re redirected to the Conversational Integration with Microsoft Teams  ServiceNow Store 
page.

4. Select Get.

Note: 
You must be logged in to the ServiceNow Store  portal to get the plugin.

5. On the Conversational Integration with Microsoft Teams  ServiceNow Store  page, select 
Request Install.

6. On the Request Install screen, provide the Instance Name  and Reason for request.
You can also validate the instance that you provided by selecting Validate Instance.

7. Select Request.
A message pops up on the Request Install screen that your request has been auto-approved.

What to do next
.

Integrate ServiceNow  Virtual Agent with Microsoft Teams

Add the Now Virtual Agent  bot to your ServiceNow  instance to integrate with Microsoft Teams.

Before you begin
Ensure that you’ve installed the Conversational Integration with Microsoft Teams  plugin 
(sn_va_teams) on your ServiceNow  instance before adding any integrations.

Role required: admin
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Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. In General Settings  under Channels and integrations, select View All.
The Channels and integrations page opens.

3. Under the Available Channels section in the Microsoft Teams  tile, select Add Integrations.

Note: 
The Add Integrations  drop-down is available only after installing the Conversational 
Integration with Microsoft Teams  plugin (sn_va_teams) on your ServiceNow  instance.

4. From the Add Integrations  drop-down, select Integrate with ServiceNow Virtual Agent.

5. In the Microsoft  Pick an account screen, select a Microsoft Teams  account that you would like 

to use for the integration.

6. Log in to the selected Microsoft Teams  account.
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7. In the ServiceNow  Virtual Agent screen, select Accept  to accept the permissions for the 

app.

8. If the selected tenant has already been assigned to Virtual Agent, you must first uninstall from 
the previously associated instance.

Note: 
Starting from Tokyo  release, if your Microsoft Teams  tenant is already associated 
with another ServiceNow instance. If you intend to associate it with a new instance, 
then you're asked to contact the administrator to first uninstall it from the previously 
associated instance. For more information, see Override Microsoft Teams integration.
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Installation starts in the background. After the installation completes, a message confirms that 
you successfully installed the Now Virtual Agent  integration for Microsoft Teams.

9. Select Go to Microsoft Teams  to manage your Microsoft Teams  app.

10. Select Continue to manage channels and integrations  to manage the integration on your 
ServiceNow  instance.

The Microsoft Teams  application appears in the list of integrations.
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What to do next
If you would like to integrate your ServiceNow®  instance with another Microsoft Teams bot, select 
the Add Integration for ServiceNow®  Virtual Agent  icon against the ServiceNow®  Virtual Agent 
bot or select the Add integration  drop-down on the Manage Microsoft Teams  channel page. .

For more information, see Manage the ServiceNow Virtual Agent integration with Microsoft 
Teams.

Override Microsoft Teams  integration

Override Virtual Agent integration with Microsoft Teams.

Before you begin
Role required: admin

About this task
Before Tokyo  release, an admin was able to override a Microsoft Teams  installation that is 
associated with an instance with a different ServiceNow  instance.

Starting from Tokyo  release, if you intend to associate your Microsoft 
Teams  tenant with a new ServiceNow  instance, contact the 
administrator to uninstall the tenant from the previously associated 

instance.

Important: 
The instructions in Remove Conversational Integration with Microsoft Teams  are only 
applicable when both instances are compatible with Tokyo  and following releases. If one of 
your ServiceNow  instances is on the Tokyo  release and another on a release prior to Tokyo, 
use the following steps.

Procedure

1. In the left navigation filter of your ServiceNow  instance, enter sys_properties_list.

2. Search and open the sn_va_teams.enable_va_override  system property.
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Note: 
If you don't find this system property, you (as an admin) must create one.

3. Set the system property value to true  to enable the Override  button.

Note: 
By default, the value of the system property is false.

4. Select Override  to associate the instance with a new 

tenant.

Manage the ServiceNow  Virtual Agent integration with Microsoft Teams

Manage your ServiceNow®  Virtual Agent  bot branding and customize the bot messages in your 
ServiceNow  instance after integration with Microsoft Teams.

Before you begin

• Roles required:

◦ virtual_agent_admin and external_app_install_admin or admin

◦ Microsoft Teams  administrator (one of the following): Global administrator, Application 
administrator, or Cloud application administrator

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. In General Settings  under Channels and integrations, select View All.

3. On the Channels and integrations page, in the Microsoft Teams  tile, select Manage.
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When you select Manage, you’re redirected to the Manage Microsoft Teams  channel page 
where you can manage the bots.

4. To integrate your ServiceNow instance with another Microsoft Teams  bot, select the Add 
integration for ServiceNow  Virtual Agent icon against the ServiceNow  Virtual Agent bot or 
select the Add integration  drop-down on the top-right of the Manage Microsoft Teams channel 
page and select Integrate with ServiceNow Virtual Agent.

5. Select the Manage Bot icon  and select Manage Virtual Agent.
You’re redirected to the Bot Configuration page for the selected bot.

6. Select the Branding  tab to brand your Now Virtual Agent  bot.
For more information about branding your bot, see Configure branding for your ServiceNow 
Virtual Agent bot in Microsoft Teams.

7. Select the Bot Messages  tab to create and edit a bot message.
For more information, see Create bot messages.

Configure branding for your ServiceNow Virtual Agent bot in Microsoft Teams

Enable users to configure branding for the published Microsoft Teams  bot app, the ServiceNow 
Virtual Agent. Users are provided with the flexibility to customize the default ServiceNow 
branding for the Microsoft Teams  production bot name and icon.

Before you begin

• Ensure that you have the admin access to your Microsoft Teams  tenant and Microsoft Teams 
admin center.

• Ensure that Virtual Agent is installed on your instance.

• Ensure that the Conversational Integration with Microsoft Teams  store app is installed.

Role required: admin

Procedure

1. Log in to Microsoft Teams  admin center.

2. Navigate to Teams apps  > Manage apps.

3. In the list of apps, search for the Now Virtual Agent  app using the Search bar and open it.

4. Click the pencil icon  to Customizable  to customize the app.

5. In the Customize panel, you can edit the app name, short description, color icon, outline icon, 
and accent color.

Note: 
Follow the tool tips for file size and format restrictions for each field. You can also refer to 
Microsoft documentation  on further details on the app customization functionality.

6. Click Apply.
You will see the Publish application  pop-up.

7. Click Publish.

Note: 
Please note that the changes you made to the app may take up to 24 hours to reflect.
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Integrating multiple ServiceNow  instances with a single Microsoft Teams  tenant

Enables ServiceNow®  Virtual Agent  to allow multiple ServiceNow  instances to integrate with 
single Microsoft Teams  tenant.

The Virtual Agent  integration with Microsoft Teams  creates a one-to-one association between 
the ServiceNow  instance that you are installing from and the Microsoft Teams  tenant in which 
the integration runs. By default, Virtual Agent  supports one-click installation that integrates one 
Microsoft Teams  tenant with one ServiceNow  instance. By enabling this integration, Virtual Agent 
allows integrating multiple ServiceNow  instances with a single Microsoft Teams  tenant. You can 
integrate multiple ServiceNow  instances with a single Microsoft Teams  tenant by creating a bot 
for each of the instances on the Microsoft Teams  tenant.

What to do next

1. Plugins for Conversational Integration with Microsoft Teams

2. Create a Bot in Microsoft Teams

3. Integrate your Self-configured bot with single Microsoft Teams tenant

4. Auto-generate the manifest file for uploading on Microsoft Teams

5. Upload the manifest package file to publish your bot

Create a Bot in Microsoft Teams

You must create a bot in Microsoft Teams  to be able to integrate with the Virtual Agent.

Before you begin
Role required: none

Procedure

1. Login into Microsoft Teams  and navigate to Developer Portal .

2. On the Developer Portal page, navigate to the Tools  > Bot Management.

3. Click Create a New bot  and provide a bot name of your choice and click Add.

4. Open the bot that you created and click the Configure  tab.

5. Under Endpoint address, provide the instance URL in the Bot endpoint address  field click 
Save.
For example: https://<instancename>.service-now.com/api/now/v1/cs/
adapter/msft/events.

Note: 
Replace the <instancename> with the name of your ServiceNow  instance where you are 
integrating with Microsoft Teams. In case of multi-instance single tenant integration, use 
the secondary ServiceNow  instance for integrating with a bot on Microsoft Teams  tenant.

6. Navigate to Client secrets  and click Add a client secret for your bot.

7. Copy the value of the client secret from the New client secret generated  pop-up for later use 
as it is displayed only during this step and click OK.

8. Navigate to Developer Portal  > Tools  > Bot management  and copy the Bot ID of the bot you 
created.

9. Retrieve the following details of your bot in Microsoft Teams  to integrate with Virtual Agent.
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◦ Tenant ID: Follow the instructions on Microsoft Teams  documentation , to fetch the Tenant 
ID.

◦ Client ID (App ID): Client ID is the Bot Id that you have copied as mentioned in Step 8.

◦ Client Secret: It is the secret that you have copied as mentioned in Step 7.

◦ Bot Name: The name of the bot that you entered in Step 3.

10. Press Enter  to save.

What to do next
Integrate your Self-configured bot with single Microsoft Teams tenant.

Integrate your Self-configured bot with single Microsoft Teams  tenant

Integrate multiple ServiceNow  instances with a single Microsoft Teams  tenant by creating 
multiple bots on the Microsoft Teams  tenant. Use your ServiceNow  Virtual Agent  application, 
which supports multiple bots on a single Microsoft Teams  tenant, to install Conversational 
Integration with Microsoft Teams  application.

Before you begin
Role required: virtual_agent_admin or admin and Microsoft Teams  Tenant admin

This installation requires a ServiceNow  instance other than the one integrated with the 
production bot to integrate with one bot (of the multiple bots) on a single Microsoft Teams  tenant.

Note: 
The ServiceNow  instance that you will use to integrate with a single Microsoft Teams  tenant 
must not be an instance that you have used for installing Conversational Integration with 
Microsoft Teams  in the primary method where you can integrate only one ServiceNow 
instance with one tenant.

Ensure that you created a bot on the Microsoft Teams  tenant for each ServiceNow  instance to be 
integrated. For more information, see Create a Bot in Microsoft Teams.

Procedure

1. Fetch the Tenant ID, Client ID (App ID), Client Secret, and Bot Name details for your bot created 
in Microsoft Teams.
For more information, see Retrieve bot details.

Note: 
Use this information when setting up the bot in your ServiceNow  instance.

2. As a ServiceNow  admin, set up the bot on the ServiceNow  instance in the global scope.

Note: 
The virtual_agent_admin can install bots with multiple instances or bots apart from 
production in the ServiceNow  instance and avail all the features of Virtual Agent  and the 
flexibility to integrate one of the multiple ServiceNow  instances with a bot on a single 
Microsoft Teams  tenant.

a. Log in to your ServiceNow  instance (secondary instance for integrating with a bot on single 
Microsoft Teams  tenant) and navigate to All  > Conversational Interfaces  > Settings.

b. In General Settings  under Channels and integrations, click View All.
The Channels and integrations page opens.
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c. Under the Available Channels section in the Microsoft Teams  tile, click Add Integrations.

Note: 
The Add Integrations  drop-down is available only after installing the Conversational 
Integration with Microsoft Teams  plugin (sn_va_teams) on your ServiceNow  instance.

d. From the Add Integrations  drop-down, select Integrate with Self-configured bot.

e. In the Integrate Microsoft Teams  with self-configured bot page, provide the Name of the bot, 
Tenant ID, Client ID (App ID), and Client Secret  that you made a note while creating the 
Microsoft Teams  bot and click Submit.

Integrate Microsoft Teams  with self-configured bot
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Note: 
For each additional bot to be integrated, repeat steps 1 and 2.

If you would like to integrate your ServiceNow  instance with another Microsoft 
Teams  bot, click the Add integration for Self-configured bot icon against the 
Self-configured bot or click the Add integration  drop-down on the Manage 
Microsoft Teams channel page and select Integrate with Self-configured 

bot.

User receives a message that the installation is successful.

What to do next

• Auto-generate the manifest file for uploading on Microsoft Teams.

• Upload the manifest package file to publish your bot

Configure Microsoft Teams  Message Extension

Configure Microsoft Teams  Message Extension to enable users to use AI Search to find content 
(Knowledge articles and catalog items), and share information in a one-on-one or group chat. 
For the base system Virtual Agent  integration with Microsoft Teams, this feature is enabled by 
default.

Before you begin
Role required: admin

About this task
Administrators have the option to configure the number of search results that appear in Message 
Extension and control the access level of a Guest user.

Procedure

1. Navigate to All  > AI Search  > Search Experience  > Search Applications  to configure the 
number of search results that appear in Message Extension.

2. In the Search Results Limit  field, adjust the number of search results that you want to appear 
in Messages Extension, and then select Update.
Message Extension then generates the new results limit when a user performs a search if 
AI Search is able to find that number of results. For example, a limit may be set to 8 but if AI 
Search only finds 6 results, then 6 items are shown.

3. Navigate to All> System Properties> All Properties  and select 
message_extension_guest_access_only  to control the access of the Guest user.
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When the flag is set to true, Message Extension returns the results that are only visible to the 
Guest users. Only the items that are publicly available are returned while the property is set 
to true. By default, this value is set to false, which means that a user can see all search results 
that they have access to. However, if you set the system property value to true, a user can 
only access the search results that are publicly available. This system property is useful if you 
want to avoid having a user accidentally sharing something that they shouldn't be sharing. You 
don't typically have to change the value. For self-configured bots, see the procedure in Auto-
generate the manifest file for uploading on Microsoft Teams  for more information.

Integrating Virtual Agent  with Microsoft Teams  using the self-configured bot

You can integrate Virtual Agent with Microsoft Teams  by configuring your own bots. The self-
configured method provides another way for customers to enable the integration without 
installing the default Now Virtual Agent app that is published on the Microsoft  Store. Unlike the 
pre-published app, the self-configured bot bypasses the collaboration proxy architecture.

The self-configured method offers a solution for the following cases:

• Commercial customers with a ServiceNow  instance running far away from the United States 
who may be having issues using the collaboration proxy.

• ServiceNow  Government Community Cloud (GCC) customers.

Note: 
Microsoft Azure  supports the bot framework in GCCHIGH and DOD (US Department of 
Defense). For more information about the bot framework support, see Integrating Virtual 
Agent with Microsoft Teams for GCC-H or DoD.

If you are a commercial customer who has already installed a pre-published bot but would like 
to integrate with multiple ServiceNow  instances within a single Microsoft Teams  tenant, see 
Integrate your Self-configured bot with single Microsoft Teams tenant.

Prerequisites

Before integrating Virtual Agent with your Microsoft Teams  tenant, ensure that the following 
prerequisites are met:

• Verify that your ServiceNow  instances have been upgraded to the San Diego  release.

• If you are a commercial user, verify that your Microsoft 365  is on the commercial environment. 
If you are a regulated market user, verify that your Microsoft 365  is on the GCC environment.

• You have not attempted previous installations of the Conversational Integration with Microsoft 
Teams  in your instances.

If you previously tried to install the integration in Quebec  and the above releases, refer to this 
Knowledge Base  article to remove the residual installation items.

If you previously tried to install the integration in a release prior to Quebec, contact Customer 
Service and Support  for help with cleaning up your instance manually.

• Verify that you have the admin permissions on ServiceNow  and Microsoft Azure  instances.

What to do next

1. Plugins for Conversational Integration with Microsoft Teams

2. Create a Bot in Microsoft Teams

3. Integrate your Self-configured bot with Microsoft Teams for GCC.
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4. Auto-generate the manifest file for uploading on Microsoft Teams

5. Upload the manifest package file to publish your bot

Plugins for Conversational Integration with Microsoft Teams

Activate the Glide Virtual Agent [com.glide.cs.chatbot] plugin, the Conversational Integration with 
Microsoft Teams  [sn_va_teams] plugin, and verify its additional plugins to enable other features 
for conversation design.

You must have either the virtual_agent_admin or admin role and the external_app_install_admin 
role to activate these additional plugins. For details, see Activate a plugin .

Note: 
Ensure that you have performed the following steps before verifying the activation of 
additional plugins required for Microsoft Teams.

• Installing of the Glide Virtual Agent [com.glide.cs.chatbot] plugin.

For more information about activating the Glide Virtual Agent plugin, see Activate Virtual 
Agent.

• Downloading the Conversational Integration with Microsoft Teams  app from the 
ServiceNow®  Store.

For more information about downloading the app, Visit the ServiceNow Store  website 
to view all the available apps and for information about submitting requests to the store. 
For cumulative release notes information for all released apps, see the ServiceNow Store 
version history release notes .

• Installing the Conversational Integration with Microsoft Teams  [sn_va_teams] plugin in 
your ServiceNow  instance.

For more information about installing Conversational Integration with Microsoft Teams, 
see Install Conversational Integration with Microsoft Teams.

Verify the following plugins for Conversational Integration with Microsoft Teams.

• Microsoft Teams Graph Spoke [sn_msteams_ahv2]: Plugin is auto installed as part of 
[sn_va_teams]. In your ServiceNow  instance, navigate to System Definition  > Plugin 
Installation History  and search for [sn_msteams_ahv2] to locate the plugin. If it has not been 
installed, you might have to request from the ServiceNow Store  first and install the plugin in 
your ServiceNow  instance.

• MS Teams - App Core [com.snc.msteams.app.core]: Plugin is auto installed as part of 
[sn_va_teams]. In your ServiceNow  instance, navigate to System Definition  > Plugin 
Installation History  and search for [com.snc.msteams.app.core] to locate the plugin. If the 
plugin is installed, you are all set to move forward. If it was not installed, reach out to Customer 
Service and Support.

Integrate your Self-configured bot with Microsoft Teams  for GCC

You must install the bot that you created in your Microsoft Teams tenant on your ServiceNow 
instance to integrate it with the Virtual Agent. Use your ServiceNow  Virtual Agent  application to 
install and configure Conversational Integration with Microsoft Teams.

Before you begin
Role required: virtual_agent_admin or admin and Microsoft Azure  admin.
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This installation requires a ServiceNow  instance to integrate with a self-configured bot on the 
Microsoft Teams  tenant.

Ensure that you created a bot on the Microsoft Teams  tenant to integrate with the ServiceNow 
instance. For more information, see Create a Bot in Microsoft Teams.

Procedure

1. Fetch the Tenant ID, Client ID (App ID), Client Secret, and Bot Name details for your bot created 
in Microsoft Teams.
For more information, see Retrieve bot details.

Note: 
Use this information when setting up the self-configured bot in your ServiceNow  instance.

2. As a ServiceNow  admin, set up the self-configured bot on the ServiceNow  instance in the 
global scope.

a. Log in to your ServiceNow  instance and navigate to All  > Conversational Interfaces  > 
Settings.

b. In General Settings  under Channels and integrations, select View All.
The Channels and integrations page opens.

c. Under the Available Channels section in the Microsoft Teams  tile, select Add Integrations.

Note: 
The Add Integrations  drop-down is available only after installing the Conversational 
Integration with Microsoft Teams  plugin (sn_va_teams) on your ServiceNow  instance.

d. From the Add Integrations  drop-down, select Integrate with Self-configured bot.

e. In the Integrate Microsoft Teams  with self-configured bot page, provide the Name of the bot, 
Tenant ID, Client ID (App ID), and Client Secret  that you made a note while creating the 
Microsoft Teams  bot and select Submit.
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Integrate Microsoft Teams  with self-configured bot

Note: 
If you own multiple ServiceNow  instances and would like to integrate additional bots for 
additional instances, repeat the preceding steps to add and integrate with bots.

If you would like to integrate your ServiceNow  instance with another Microsoft Teams 
bot, select the Add integration for self-configured bot icon against the Self-configured 
bot or select the Add integration  drop-down on the Manage Microsoft Teams  channel 
page and select Integrate with your self-configured bot. .

For more information, see Manage the ServiceNow Virtual Agent integration with 
Microsoft Teams.

User receives a message that the installation is successful.

What to do next
Auto-generate the manifest file for uploading on Microsoft Teams.

Auto-generate the manifest file for uploading on Microsoft Teams

Auto-generate the manifest file and customize the branding of your Microsoft Teams  app so that 
you can make Virtual Agent  available in your organization.

Before you begin
Role required: virtual_agent_admin or admin

About this task
An automated manifest file generator on the new Microsoft Teams  UI automatically fills in the bot 
ID and updates the other settings (such as branding) based on input from you, the administrator. 
The manifest file generator also enables a one-click download of the manifest package.

• Before you generate a manifest file, you must create a self-configured bot (or ensure that one 
has already been created) in the ServiceNow  instance. You can then generate a manifest 
package for each self-configured bot that you create.

• After you save the manifest form, you can download the manifest zip package, which contains 
the following three files:
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◦ manifest.json

◦ color.png

◦ outline.png
You can edit the manifest form and redownload it as many times as you want.​

Note: 
This feature is only applicable when you’re setting up the Virtual Agent  integration with 
Microsoft Teams. If you intend to use ServiceNow  for Microsoft Teams  with ITSM  or HR 
capabilities, select the Learn more  link next to Planning to enable additional ITSM and HR 
integrations  on the Bot Configuration page. That way, you can configure the manifest in a 
separate module instead of continuing to configure the manifest here. For more information, 
see Create and download the manifest file .

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. In General Settings, in the Channels and routing section, select View All.

3. On the Channels and integrations page, in the Microsoft Teams  tile, select Manage.

4. In the Self-configured bot section, select the Manage Bot  icon .
If you haven't enabled Message Extension and you are accessing it for the first time, you see 
a Turn on new feature alert message that informs you that the Message Extension feature for 
your Microsoft Teams  integration is now available to be turned on.

5. On the Configuration  tab, select Edit configuration  and on the form, fill in the fields.

Configure your Bot - VA Microsoft Teams Manifest

Field Description

Short Name Short display name for your app.

Note: 
Ensure that the name doesn’t exceed 
30 characters.

Full Name Full name of your app. Use the full name 
if the short name of the app exceeds 30 
characters.

Note: 
Ensure that the full name doesn’t 
exceed 100 characters.

Bot (Client) ID Unique Microsoft  generated identifier.

This field is automatically tied to the bot 
creation step and can't be altered.

Short description Short description of your app experience. 
Use a short description when space is 
limited.
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Field Description

Note: 
Ensure that the short description 
doesn't exceed 80 characters.

Full description Full description of your app.

Note: 
Ensure that the full description doesn't 
exceed 4000 characters.

Valid domains List of valid domains for websites that your 
app expects to load in Microsoft Teams.

Note: 
Currently only the ServiceNow  domain 
is supported.

Version Specific version of your app to track the 
incremental manifest submission to Microsoft 
Teams.

For example, 1.0.0. Use a maximum of 2 digits 
after each decimal.

Note: 
Ensure that you put a higher number for 
each new version.

Accent color Color to use as a background for your outline 
icons.

Note: 
The value must be a valid HTML color 
code starting with a hash-tag ( ). For 
example,  293E40.

Color icon Icon of your app that you want to appear in 
most Microsoft Teams  scenarios.

You can select the following options:

◦ Use Default icon: Changes the color of the 
icon back to the default color icon.

◦ Use Custom icon: Changes the color icon 
with an icon color of your choice.

Note: 
Ensure that you upload only the .png 
image files that have fewer than 192x192 
pixels to change the color of the icon.

Outline icon Icon that is seen on the app bar when the 
app is in use.
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Field Description

You can select the following options:

◦ Use Default icon: Changes the outline icon 
back to the default outline icon.

◦ Use Custom icon: Changes the outline icon 
with an icon of your choice.

Note: 
Ensure that you upload only the .png 
image files that have fewer than 32x32 
pixels to change the outline icon.

Message Extension Message extension that lets users search 
and share the results through the compose 
message area of the Microsoft Teams  client.

For more details about each field, refer to Microsoft Teams documentation .

6. Select Save.
You’re redirected to the Bot configuration page where the manifest file is saved and ready for 
you to download.

Note: 

You can also edit the manifest file by selecting Edit configuration  on the download page 
and downloading the file as many times as you would like. With each new manifest, 
ensure that you enter a higher version number in the Version  field so that the updated 
form can be saved successfully.

7. In the Bot configuration page, under Your package, select the Download  button to download 
your package file.

Note: 

You can also edit the manifest file by selecting Edit configuration  on the download 
page and downloading the file as many times as you would like. However, with each new 
manifest, ensure that you enter a higher version number in the Version  field so that the 
updated form to be saved successfully.

What to do next
Upload the manifest package file to publish your bot.

Upload the manifest package file to publish your bot

Upload the manifest file that you generated to the Microsoft Teams  and test your app experience 
to make it be available in the Microsoft  global app store.

Before you begin
Role required: admin

The self-configured bot that you created will not be available in the Microsoft  global app 
store unlike the ServiceNow  pre-published app - ServiceNow Virtual Agent. To test your app 
experience within Microsoft Teams, you must upload your app to Microsoft Teams. Uploading 
adds the app to the team that you selected and your team can participate in the end-to end 
conversations with the bot.
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Procedure

1. Log in to the Microsoft Teams Admin Center  using the admin credentials and navigate to 
Teams apps  > Setup policies.

2. Click Add  and turn on Upload custom apps  (if it has not 
been enabled already) and click Save  at the bottom of the 

page.

3. Open Microsoft Teams  app and navigate to Apps  > Manage your 

apps.

4. Select Upload a custom app  for testing purposes and select Upload an app to your org's app 
catalog  to release the self-configured bot to the entire organization.

5. Upload the zip file and click Add/Install.

6. After you successfully published the bot, click the 3-dot menu on the left pane to locate your 

app (search in the Find an app bar).
You have successfully published the bot on Microsoft Teams. It should now be available for 
your organization and you can start interacting with the bot.

7. Perform the following steps on the Microsoft Teams  Admin center.
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Note: 
If you have enabled pre-linking by turning on Automatically Link ServiceNow user 
profiles  on the Messaging App Integration UI page, users are pre-linked without typing 
hi. For more information about pre-linking your accounts, see Pre-link Virtual Agent 
requesters for integration with Microsoft Teams. If you have turned off the check box, use 
the following manual account linking process described.

a. Type hi  to start interacting with the bot.
The bot presents a prompt that provides options to authenticate, such as Link to 
ServiceNow, Continue as Guest, and Check out Tips.

Microsoft Teams  bot responses

The Link to ServiceNow  option requires users to enter their ServiceNow  instance 
credentials. If you choose to link to your ServiceNow  account, the following screen is 
displayed asking you to confirm the account linking.

Linking Microsoft Teams  account with ServiceNow  account
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Account linking associates your Microsoft Teams  account with your ServiceNow  account for 
the ServiceNow  instance that is integrated with the Conversational Integration with Microsoft 
Teams. Users with linked accounts can run Virtual Agent topics that use ServiceNow 
information and records.

ServiceNow  account linked with Microsoft Teams  tenant

If your users do not link their ServiceNow  accounts, they can access and run only the public 
topics.

b. Configure the bot on your ServiceNow  instance.
For more information, see Virtual Agent integration with messaging apps.

What to do next
You have successfully integrated Virtual Agent  with Microsoft Teams  using the self-configured 
method. If you are interested in getting additional ITSM  and HR capabilities in Microsoft Teams, 
see these instructions for using a self-configured bot  with ServiceNow  for Microsoft Teams.

Integrating Virtual Agent  with Microsoft Teams  for GCC-H  or DoD

You can integrate Virtual Agent with Microsoft Teams for GCC-H (Government Community 
Cloud - High) or DoD (Department of Defense) customers by configuring your own bots. The 
self-configured method provides another way for customers to enable the integration without 
installing the default Now Virtual Agent app that is published on the Microsoft  Store. The self-
configured bot bypasses the collaboration proxy architecture.

If you are a commercial customer who has already installed a pre-published bot but would like 
to integrate with multiple ServiceNow  instances within a single Microsoft Teams  tenant, see 
Integrate your Self-configured bot with single Microsoft Teams tenant.

If you are a  Microsoft  GCC (GovtCommunityCloud) customer, do not follow this step. Instead, 
refer to Integrating Virtual Agent with Microsoft Teams using the self-configured bot.

Prerequisites

Before integrating Virtual Agent with your Microsoft Teams  tenant, ensure that the following 
prerequisites are met:

• Verify that your ServiceNow  instances have been upgraded to the San Diego  release.

• Verify that you have not previously attempted installing the Conversational Integration with 
Microsoft Teams  app on your instances.
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If you previously tried to install the integration in Quebec  and the above releases, refer to this 
Knowledge Base  article to remove the residual installation items.

If you previously tried to install the integration in a release prior to Quebec, contact Customer 
Service and Support  for help with cleaning up your instance manually.

• Verify that you have the admin permissions on ServiceNow  and Microsoft Azure  instances.

What to do next

1. Plugins for Conversational Integration with Microsoft Teams.

2. Create a bot in Microsoft Teams for GCC-H or DoD.

3. Integrate your Self-configured bot with Microsoft Teams for GCC-H or DoD.

4. Auto-generate the manifest file and upload it into Microsoft Teams for GCC-H or DoD.

Create a bot in Microsoft Teams  for GCC-H  or DoD

Create a self-configured bot with Microsoft Teams  for GCC-H or DoD customers to be able to 
integrate with the Virtual Agent.

Before you begin
Role required: none

Procedure

1. Log in to Azure portal home page  and search for Bot Services  on the top search bar.

2. On the Bot services page, select Create  and select Azure Bot.
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3. On the Azure Bot page, select Create  next to the Plan menu.

4. On the form, fill in the Bot Handle, Subscription, Resource group, New resource group 
location, and Pricing  details.
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5. Under Microsoft App ID, select the type of application from the Type of App list.
You can create a multi tenant app or a single tenant app.

6. Select the Creation type  radio button.

Note: 
If an existing app is being used, make sure that the type of app is the same as the type of 
bot you’re creating. This verification is important because a multi tenant app will work with 
a multi tenant Microsoft Teams  bot and vice versa.

7. Select Review + create.

8. Review the Basic bot details provided and select Create.
When the bot is successfully created, you will receive the Deployment succeeded 
message.

9. On the left navigation, select Channels  and select the Microsoft Teams icon under Add a 
featured channel.
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10. On the Terms of Service pop-up, select Save  and select Agree.
The channel gets saved.

11. On the left navigation, select Configuration, complete the configuration form, and select 
Apply.

Note: 
In the Messaging endpoint  field, provide the instance URL address.

For example: https://<instancename>.service-now.com/api/now/
v1/cs/adapter/msft/events.

The domain might not be service-now.com  and could be different. For example, the 
domain for GCC is servicenowservices.com.

Replace the <instancename> with the name of your ServiceNow  instance where you are 
integrating with Microsoft Teams.

12. On the left navigation, select Overview.
You can also get to the Overview page by navigating to Azure Services  > Azure Active 
Directory  > Manage  > App Registrations  and locate your application from the list to retrieve 
the following details.

13. Perform the following steps to retrieve the secret value code:
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a. Copy the Application (client) ID  and Directory (tenant) ID  of your application and make a 
note of it.

b. On the left navigation bar under Manage, select Certificates & Secrets.

c. Select + New client secret, add your Description  and Expiration, and select Add.

d. Copy the secret value code in the Value  field and make a note of it.

Note: 
The secret value code is visible only once.

Integrate your Self-configured bot with Microsoft Teams  for GCC-H or DoD

Link your registered Microsoft Teams  bot with your ServiceNow  instance to integrate it with 
the Virtual Agent. Use your ServiceNow  Virtual Agent  application to install and configure 
Conversational Integration with Microsoft Teams.

Before you begin
Role required: virtual_agent_admin or admin and Microsoft Azure  admin.

Procedure

1. Fetch the Tenant ID, Client ID (Application ID), Client Secret, and Bot Name details for your bot 
created in Microsoft Teams.
For more information, see Retrieve bot details.

Note: 
Use this information when setting up the self-configured bot in your ServiceNow  instance.

2. As a ServiceNow  admin, set up the self-configured bot on the ServiceNow  instance in the 
global scope.

a. Log in to your ServiceNow  instance and navigate to All  > Conversational Interfaces  > 
Settings.

b. In General Settings  under Channels, select View All.
The Channels and integrations page opens.

c. Under the Available Channels section in the Microsoft Teams  tile, select Add Integrations.

Note: 
The Add Integrations  drop-down is available only after installing the Conversational 
Integration with Microsoft Teams  plugin (sn_va_teams) on your ServiceNow  instance.
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d. From the Add Integrations  drop-down, select Integrate with your self-configured bot.

e. In the Integrate Microsoft Teams  with self-configured bot page, provide the Name of the bot, 
Tenant ID, Client ID (App ID), and Client Secret  that you made a note while creating the 
Microsoft Teams  bot and select Submit.

Integrate Microsoft Teams  with self-configured bot

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2130



Note: 
If you own multiple ServiceNow  instances and would like to integrate additional bots for 
additional instances, repeat the preceding steps to add and integrate with bots.

If you would like to integrate your ServiceNow  instance with another Microsoft Teams 
bot, select the Plus icon against the Self-configured bot or select the Add integration 
drop-down on the Manage Microsoft Teams channel page and select Integrate with 
your self-configured bot.

For more information, see Manage the ServiceNow Virtual Agent integration with 
Microsoft Teams.

User receives a message that the installation is successful.

3. In your ServiceNow  instance, navigate to System OAuth  > Application Registry  and open the 
record that contains the sample-msteams-oauth-consumer.

4. Right-click on the grey bar header titled OAuth OIDC 
Entity  on the top of the page to select Configure  > Form 

Layout.

5. Search for Token URL  from the Available  field, add it to the Selected  field, and move it under 
Redirect URL.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2131



6. Select Save  to save the 

layout.
You’re redirected to the OAuth OIDC Entity record.

7. On the OAuth OIDC Entity form, select the lock icon to unlock the Token URL  field, and then 
update the default value:

◦ For multi-tenant application: https://login.microsoftonline.us/
MicrosoftServices.onmicrosoft.us/oauth2/v2.0/token

◦ For Single-tenant application: https://login.microsoftonline.us/<Tenant-
ID>/oauth2/v2.0/token

8. Scroll down the OAuth OIDC Entity form, select the OAuth Entity Scopes  tab, and update the 
OAuth scope's default value to https://api.botframework.us/.default.

9. On the OAuth OIDC Entity form, select the information icon next to the OAuth OIDC Provider 
Configuration  field and select Open Record.

10. On the OIDC Provider Configuration form, update the OIDC Metadata URL  to https://
login.botframework.azure.us/v1/.well-known/openidconfiguration 
and select Update.

Auto-generate the manifest file and upload it into Microsoft Teams  for GCC-H  or DoD

After you complete integrating the bot on the ServiceNow  instance, configure the manifest file, 
auto-generate it, and upload the package file to Microsoft Teams  to start conversing with the 
Virtual Agent.

Before you begin
Role required: admin

About this task
The self-configured bot that you created is not available in the Microsoft  global app store, unlike 
the ServiceNow  pre-published app - ServiceNow Virtual Agent. You must upload your app to 
Microsoft Teams. Uploading adds the app to the team that you select and you and your team can 
participate in the end-to end conversations with the bot.

Note: 

You need permission to upload custom apps in Microsoft Teams. To learn how to enable it, 
refer to the Microsoft  documentation.
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Procedure

1. To configure the bot, auto-generate the manifest file, and download the manifest configured file 
in your ServiceNow  instance, see Auto-generate the manifest file for uploading on Microsoft 
Teams.

2. To publish the manifest file, from Microsoft Teams, perform the following steps:

a. Open Microsoft Teams  app and navigate to Apps  > Manage your 

apps.

b. Select Upload an app to your org's app catalog  to release the self-configured bot to the 
entire organization.

c. Upload the zip file and click Add/Install.

d. After you successfully published the bot, click the 3-dot menu on the left pane to locate your 

app (search in the Find an app bar).
You have successfully published the bot on Microsoft Teams. It should now be available for 
your organization and you can start interacting with the bot.
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3. Note: 
If you have enabled pre-linking by turning on Automatically Link ServiceNow user 
profiles  on the Messaging App Integration UI page, users are pre-linked without typing 
hi. For more information about pre-linking your accounts, see Pre-link Virtual Agent 
requesters for integration with Microsoft Teams. If you have turned off the check box, use 
the following manual account linking process described.

Type hi  to start interacting with the bot.
The bot presents a prompt that provides options to authenticate, such as Link to ServiceNow, 
Continue as Guest, and Check out Tips.

Microsoft Teams  bot responses

The Link to ServiceNow  option requires you to enter their ServiceNow  instance credentials. If 
you choose to link to your ServiceNow  account, the following screen is displayed asking you to 
confirm the account linking.

Linking MS Teams account with ServiceNow  account

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2134



Account linking associates your Microsoft Teams  account with your ServiceNow  account for 
the ServiceNow  instance that is integrated with the Conversational Integration with Microsoft 
Teams. If your account is linked, you can run Virtual Agent topics that use ServiceNow 
information and records.

ServiceNow  account linked with Microsoft Teams  tenant

If you do not link your ServiceNow  accounts, you can access and run only the public topics.

4. Configure the bot on your ServiceNow  instance.
For more information, see Virtual Agent integration with messaging apps.

What to do next
You have successfully integrated Virtual Agent  with Microsoft Teams  using the self-configured 
method. If you are interested in getting additional ITSM  and HR capabilities in Microsoft Teams, 
see these instructions for using a self-configured bot  with ServiceNow  for Microsoft Teams.

Limitations in GCC-H  or DoD  for Microsoft Teams  integration with Virtual Agent

Learn about the limitations for Microsoft Teams Government Community Cloud - High (GCC-H) or 
the US Department of Defense (DoD) Microsoft Teams  integration with Virtual Agent.

Limitations

1. Manifest version: Up to v1.10. Ensure that the template that you create has version 1.10 or an 
earlier version.

2. Adaptive Cards: Enable the sn_va_teams.send_image_as_data  system property 
to upload images to your conversation on Microsoft Teams  that is integrated with GCC-High. 
Apply this system property to image and card controls. If you're using an image URL, ensure 
that its source is a ServiceNow  instance.

Create and integrate a self-configured bot for a single tenant page

Create a self-configured single tenant bot with Microsoft Teams  for integration with Virtual Agent.

Before you begin
Role required: virtual_agent_admin or admin and Microsoft Azure admin.

About this task
Creating and integrating a single tenant bot is similar to creating a GCC-H or DoD bot, with minor 
adjustments.
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Procedure

1. Follow the instructions in Create a bot in Microsoft Teams for GCC-H or DoD, with the following 
changes.

a. Follow steps 1 through 4 as normal.

b. In step 5, select Single tenant.

c. Follow the remaining steps as normal.

2. Follow the instructions in Integrate your Self-configured bot with Microsoft Teams for GCC-H or 
DoD, with the following changes.

a. Follow steps 1 through 6 as normal.

b. In step 7, select Single tenant, and add your tenant ID, but keep the .com  domain, for 
example: https://login.microsoftonline.com/<tenant-id>/oauth2/
v2.0/token.

c. Follow steps 8 through 10 as normal.

Result
Your single-tenant bot is ready for use in Virtual Agent.

Configure Virtual Agent settings for Microsoft Teams

Configure your Microsoft Teams  bots that are integrated with Virtual Agent to enable 
notifications, to link ServiceNow  user profiles, and to set up system messages and contextual 
actions.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. In General Settings  under Channels and integrations, click View All.

3. On the Channels and integrations page, in the Microsoft Teams  tile, click Manage.

4. Select the Settings  tab.

5. In the Enable Link Authentication section, configure the different link opening experiences 
using Smart Links.

For more information about enabling link authentication for your Microsoft Teams  bots, see 
Configure link authentication and opening experience in Microsoft Teams.

6. Swipe to the left the Enable Notification for all users  toggle button to disable notifications for 
the linked users.

Note: 
The Enable Notification for all users  toggle button is selected by default.

The Automatically Link ServiceNow user profiles  toggle button is selected by default 
and disabled for any further change. This option links all the active ServiceNow  accounts 
automatically to the associated Microsoft Teams  bot.

7. Set up the Global Messaging Settings.

Note: 
Any changes made to these settings will reflect in all the channels.
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◦ System Messages: Customize the default system messages displayed during Virtual Agent 
conversations.

For more information about changing or updating a system message, see Change system 
messages.

◦ Contextual Actions: Customize the supported actions per user command inputs.

For more information about updating a contextual action, see Contextual actions for custom 
chat integrations.

What to do next
The Virtual Agent  bot and Microsoft Teams  tenant are now integrated for use on your ServiceNow 
instance. Your messaging users are automatically linked to their ServiceNow  accounts.

• Notify your users that the Virtual Agent  bot for Microsoft Teams  is available for use.

• To improve the live agent experience for your users, you can activate the display of the 
estimated wait time for live chat support. When a user asks to chat with a live agent, a card 
shows the approximate wait time to talk with an agent, and gives the user the option to cancel 
the chat. For details on activating this feature, see Configure Agent Chat.

Configure link authentication and opening experience in Microsoft Teams

Link authentication and opening experience in Microsoft Teams  provides a seamless experience 
for end users to interact with ServiceNow links when you use Virtual Agent on Microsoft Teams.

Before you begin
Role required: virtual_agent_admin or admin

Ensure that your Microsoft Teams  integration is available in the All Integrations tab of the 
Channels and integrations page before enabling link authentication.

Ensure that your  Microsoft Teams  email ID matches with one of the system users' email.

Ensure that you are in the  Conversational Integration with Microsoft Teams  scope while 
completing this step (instead of the Global scope).

About this task
To configure smart links to open in a pop-up or Microsoft Teams tab, admins must first complete 
the following link authentication steps before moving on to configure smart links.

Note: 
When the status of link authentication is inactive, the link opening behavior falls back to 
New Browser Tab even when admins configure a link to be opened in a pop-up or Microsoft 
Teams  tab. Therefore, activating link authentication is a pre-requisite of using a pop-up and 
Microsoft Teams  tab.

Important: 
Be informed that Smart Links do not work for Now Virtual Agent  if your instance has a 
custom domain.

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. In General Settings  under Channels and routing, click View All.

3. On the Channels and integrations page, in the Microsoft Teams  tile, click Manage.
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4. In the Manage Microsoft Teams  channel page, select the Settings  tab.

5. In the Enable Link Authentication section, under Step 1. Configure SSO for tenant, click the 

Configure SSO   button.
The Single Sign-On (SSO) Configuration pop-up opens to inform you that the link directs you to 
a page to install your tenant and authorize it for SSO. Click Open.

For more information about configuring Single Sign-On, see Grant permissions to required 
Microsoft Azure apps .

Note: 

◦ SSO can only be enabled on one Microsoft Teams  tenant at any given time. If SSO is 
already enabled on another tenant, make sure to switch the tenant so that SSO can be 
enabled on the new tenant.​

◦ If you have already configured a tenant and would like to change it to another tenant, 
then you can do so by clicking Change tenant. Once you confirm to change the tenant, 
you are directed to the Microsoft Teams  login page for changing the tenant.

After entering the tenant information, ensure that 
you have clicked the Authenticate  button in the SSO 

section.

6. After you have configured SSO, you must enter an APP ID.
To Find your APP ID, log into the Microsoft Teams admin center , navigate to Manage apps, 
select the app you'd like to configure, and fetch the app ID.
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Note: 
If you are using ServiceNow for Teams app, search for the app ID for ServiceNow for 
Teams and make sure not to use External App ID.

7. On the Link Authentication section, at Step 2. Enter App ID, enter the app ID that you fetched 
from your Microsoft Teams  admin center, and click Save.
You receive a confirmation that your app ID has been saved successfully. You notice that the 
status of against SSO is green.

What to do next
Configuring smart links in Microsoft Teams.

Configuring smart links in Microsoft Teams

Configure smart links for your Virtual Agent  app in Microsoft Teams  to enable different link 
opening experiences.

Smart link settings in the admin console enable admins to define one of the three link opening 
options in Microsoft Teams.
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1. Microsoft Teams  task module/pop-up

2. Microsoft Teams  tab

3. New browser tab

Through link authentication and Single Sign-On (SSO) support, link content can be rendered in a 
pop-up, Microsoft Teams tab, or a new browser tab.

You can configure smart links for Microsoft Teams  from the URL navigation system action under 
Target Location. For more information about configuring smart links, see Create a smart link 
preference.

There are three valid link opening options that are applicable to Microsoft Teams  and the smart 
link settings in admin console enables admins to define where to open a link in Microsoft 

Teams.

1. Load in Place: Links open inside a Microsoft Teams  tab.

Note: 

◦ Only ServiceNow  links are supported currently.

◦ While Load in Place  is always an option for admins to choose from, this functionality is 
only supported when admins have already installed an additional tab within Microsoft 
Teams  (for example, Employee Center tab as part of the ITSM/HR plugins).

◦ Admins must ensure that the following steps are complete:

▪ MS Teams - App Core (com.snc.msteams.app.core) plugin is installed as part of 
ITSM/HR plugins and additional tab has already been enabled.

▪ The sn_va_teams.view_msft_tab  system property is set to true.

▪ The link authentication status on your ServiceNow instance is green.

2. New Browser Tab: Links open in a new browser tab (a new tab in Google Chrome, Safari, etc.).

3. Popup: Links open in a pop-up/task module in Microsoft Teams. When pop-up is selected, 
admins also have the option of selecting a pop-up size of Small, Medium, or Large. The default 
size is Large.​

Before you start configuring pop-up using Target location, double check that the value of 
sn_va_teams.view_non_video_msft_task_module  system property is true. When 
the link authentication status is active from the previous step, the value is automatically set to 
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true. When this system property is true, you can use the pop-up. If you want to disable pop-up 
in Microsoft Teams, you can manually set this property to false.

Note: 
Only ServiceNow  links are supported currently.

When no conditions are specified on the Target Location record, the valid link opening 
mechanism applies to both Web Client and Microsoft Teams  in a way that makes sense to its 
host application. For example, if admins specify a URL pattern to be opened using Load in Place 
without any conditions, the link on Web Client opens by refreshing the topmost browser frame 
(Web Client's unique behavior). However, the same link opens in a Microsoft Teams  tab.

If both Web Client and Microsoft Teams  are valid channels for the customer, then admins can 
define different target locations for each channel by specifying the device type in the condition 
field (such as Teams and mweb). If the device type is specified as Teams and no other device 
types are specified, then that particular target location record will only be applied in Microsoft 
Teams.

Enable Microsoft Teams  integration in ServiceNow  Protected Platform (SPP)

When installing Conversational Integration with Microsoft Teams, the ServiceNow AI Platform® 

makes the instance configuration simpler by dynamically determining the bot type for 
commercial and SPP (ServiceNow Protected Platform) environments from the Tokyo  release.

The process of installing and configuring Microsoft Teams  integration with Virtual Agent  in an 
SPP environment is similar to that of the installation and configuration of the pre-published bot 
in a commercial environment. But it is the environment in which you are installing makes the 
difference and the bot is available based on the installation environment.

After you complete the Microsoft Teams  integration with Virtual Agent  in an instance with SPP 
environment, the Now VirtualAgent Australia SPP  bot is available for Australian Govt customers.

For more information on the installation and configuration, see Install Conversational Integration 
with Microsoft Teams.

Virtual Agent  feature support in Microsoft Teams  conversations

The Microsoft Teams  app supports Virtual Agent  features, such as Virtual Agent Designer 
controls for creating conversations, notifications, AI Search  results, and more.

Emojis and text

Starting with Version 4.0.1, when a user chats with a live agent and sends a message that 
contains emojis, the text gets delivered and the emoji is displayed on the agent workspace.

Note: 
Due to the difference in the platforms (app or web browser) used by the end user and the 
live agent, there's a difference between the emojis that are sent by the end user and the 
emojis that are received by the live agent.

A user can understand how emojis look like in a chat conversation and in the Agent Workspace 
from the following examples.
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Emojis in a chat conversation

Emojis in Agent Workspace

Message pagination

Microsoft Teams  has a limit on the maximum message size before paginating the message. 
You can adjust the number of characters allowed in a message before paginating by going to 
the system properties [sys_properties] table and setting the number in the system property 
sn_va_teams.picker_char_limit.

AI Search  results

Now Assist  in Virtual Agent  can generate AI Search  results that are displayed as Genius result 
cards and multi-link outputs in conversations. For details on how Virtual Agent  generates 
AI Search  results, see Improving the user experience with AI Search. The default AI Search 
configuration for Virtual Agent  enables search results for Q&A (Knowledge Base  and catalog 
items). The user has the option to like or dislike the information presented in the card. For more 
information, see Genius Results .

URL navigation for chat links

In the Virtual Agent  and Live Agent  conversations on the Microsoft Teams  app, the links to 
ServiceNow  records open automatically in base system portals, including the links that are 
displayed in the output cards, Virtual Agent  notifications, and AI Search  results. If needed, as 
the administrator, you can change the portals where these links are opened in. For configuration 
details, see Configure URL navigation for chat links.

Masking of sensitive user data

Starting with Version 2.0.0, passwords that are entered by users and confirmed in bot responses 
are masked during the password reset conversations in the Microsoft Teams  app.

A user can understand how a password is masked in Microsoft Teams  from the following 
example.
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Example of password masking

Support for file uploads

Starting with Version 2.0.0, users can upload their file attachments with the paper clip  icon in 
the Microsoft Teams  conversations.

A user can learn to attach an icon in the Microsoft Teams  chat window from the following 
example.

File attachment support

Trusted domains

The values that are specified in the Trusted media domains field of the Provider Channel 
Identities table [sys_cs_provider_application] take precedence over the Connections table 
[sys_cs_provider] and overrides its values.

Catalog opening experience in Microsoft Teams  conversations

Starting with Version 4.1.0, users can request a catalog item from the Microsoft Teams  app during 
a conversation.

A user can select the Request this item  button in a conversation with Microsoft Teams  that 
opens the catalog item in a pop-up window, the Task Module, where the user can view the 
information of the item and submit the request within Microsoft Teams.

The following examples show how a user can request and then view a catalog item.
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Request Catalog item

View Catalog item

Custom branding in the Microsoft Teams  application

Microsoft Teams  supports app customization, which enables you, as the administrator, to 
customize the branding of the Now Virtual Agent  bot in the Conversational Integration with 
Microsoft Teams. To learn more about app customization, see these resources:

• Customize apps in Microsoft Teams  in the Microsoft Teams  documentation.

• MS Teams branding for the conversational integration  in the ServiceNow Community.

Virtual Agent Designer  user input and bot response controls in Microsoft Teams

The Virtual Agent Designer  user input and bot response controls for creating conversation topics 
are supported in Microsoft Teams  conversations, including the table bot response, the card 
control that can display images, and the image bot response controls.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2144

https://docs.microsoft.com/en-us/microsoftteams/customize-apps
https://docs.microsoft.com/en-us/microsoftteams/customize-apps
https://docs.microsoft.com/en-us/microsoftteams/customize-apps
https://community.servicenow.com/community?id=community_article&sys_id=3b4f487edbe17490904fa9fb1396195b
https://community.servicenow.com/community?id=community_article&sys_id=3b4f487edbe17490904fa9fb1396195b
https://community.servicenow.com/community?id=community_article&sys_id=3b4f487edbe17490904fa9fb1396195b


Starting with Version 2.0.0, the updated card and new video bot response controls are supported 
in Microsoft Teams  conversations. The video control displays a thumbnail image of the video that 
users select to open the video in their preferred web browser.

For more information about user input controls and bot responses, see Virtual Agent Designer 
user input controls  and Virtual Agent Designer bot responses, respectively.

Starting with Version 3.0.10, to improve the bot performance and enable a better conversational 
experience with Virtual Agent  on Microsoft Teams, the non-card bot response controls such as 
text, links, and date cards are converted into adaptive cards.

As part of converting all controls to adaptive cards, the content displayed on notifications 
received through bot responses is customized. The Microsoft Teams  bot displays a preview 
of the notification content on the card, such as the message content, card title, or description, 
where applicable.

Notification with title

Starting with Version 3.0.10, during a conversation with the Microsoft Teams  bot, you can search 
for a particular choice from the list using the drop-down picker controls.
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Starting from Version 4.1.0, you have the option to turn off the confirmation banner that appears 
when you send a response to Virtual Agent  in Microsoft Teams  conversation.

Set the sn_va_teams.hide_teams_response_message  system property value to true 
to turn off the confirmation banner (by default the value of the system property is set to false).

Virtual Agent  notifications supported in Microsoft Teams

Microsoft Teams  app supports Virtual Agent  notifications during conversations.

• Subscription management

◦ Requesters - Use the notification  (or notifications) command to subscribe to or unsubscribe 
from notifications.

◦ Admins - Enable notifications for messaging users in the Messaging Apps Integration page.

• Notification content - Create notifications with rich content, images, and action buttons. 
Actionable notifications enable recipients to perform certain actions and respond to the 
notification, such as adding a comment or requesting a live agent.

• Notification delivery

◦ Message notifications are delivered immediately to end users, even if the user is chatting 
with a virtual or live agent.

◦ Actionable notifications are delivered only when the user is not in an active conversation 
with a virtual or live agent. Users can do the following:
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▪ Review the notifications later by using the show notification  command.

Show notifications in Microsoft Teams

▪ Perform or skip the actions for the notification. If users decide to skip the actions, users 
can return later to the notification by using the show notification  command.

For detailed information on Virtual Agent  notifications, see Configuring Virtual Agent 
notifications.

Unsupported Virtual Agent  features in Microsoft Teams

Refer to the unsupported features of Virtual Agent  in Conversational Integration with Microsoft 
Teams.

Unsupported features

Virtual Agent  does not support the following functionalities during a conversation in Microsoft 
Teams.

• Connect Support

• Geo-location topic block

Pre-link Virtual Agent  requesters for integration with Microsoft Teams

Pre-link your Virtual Agent  requesters to a ServiceNow  instance before they run the 
Conversational Integration with Microsoft Teams. Batch pre-linking enables your Virtual Agent 
users to immediately chat with a virtual agent and receive notifications without going through the 
initial authentication linking process.
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Before you begin

• Install Conversational Integration with Microsoft Teams, with the Automatically Link 
ServiceNow user profiles  option enabled.

• Set up Microsoft Teams Graph spoke.

• Set up Microsoft Active Directory spoke .

Roles required:

• virtual_agent_admin

• external_app_install_admin

• One of the following Microsoft Teams  administrator roles:

◦ Global Administrator

◦ Application Administrator

◦ Cloud Application Administrator

• admin or schedule_admin to change the scheduled job script

About this task
When the Automatically Link ServiceNow user profiles  option is enabled on the Settings page 
of the Manage Microsoft Teams channel, a batch of up to 10,000 users is automatically pre-
linked to a ServiceNow  instance. Your existing users are pre-linked during the initial run. Newly 
added users are pre-linked during subsequent daily runs.

To prevent automatic batch pre-linking, disable the Automatically Link ServiceNow user 
profiles  option on the Messaging Apps Integration UI page.

Batch pre-linking of your Virtual Agent  users to a ServiceNow  instance before integrating with 
Microsoft Teams  includes the following benefits:

• Notifications are proactively sent by Virtual Agent  to users when their identity in Microsoft 
Teams  is associated with their identity in a ServiceNow  instance. This is also true when the 
user is already linked with ServiceNow  Virtual Agent.

• If a user is pre-linked, and when Microsoft Teams  notifications are enabled in the app, 
notifications are pushed to the app even when a user is not logged into a Microsoft Teams 
account.

Batch pre-linking happens automatically via the MS Teams Daily Pre Install Job  scheduled job. 
This job runs by default daily at 1:00 a.m., but you can change the time, if desired. To modify 
the default scheduled job run time or time zone, access the MS Teams Daily Pre Install Job 
Scheduled Script Execution form.

Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Search for the MS Teams Daily Pre Install Job  scheduled job and click to open the Scheduled 
Script Execution form for the selected record.

3. In the Run  field, change the run time to your desired time.

4. For a description of the other fields that you can change in this form, including Time zone, see 
Automatically run a script of your choosing .

5. Click Save.
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What to do next
You can also customize the auto-linking process for Conversational Integration with Microsoft 
Teams. For more information, see Customize auto-linking for Conversational Integration with 
Microsoft Teams.

Customize auto-linking for Conversational Integration with Microsoft Teams

Customize auto-linking for user profiles by defining the email Id of the user in any custom table 
rather than just the User [sys_user] table.

Before you begin

• Make the User [sys_user] table extensible.

• Create a custom table with custom email fields extending the User [sys_user] table.

• Ensure that the scope of the custom table is Microsoft Teams, or else, create a cross scope 
privilege.

• Populate the system property in the table_name.column_name  format.

Role required: admin

About this task
The auto-linking process searches the user table for the email ID and if found, links the 
user to the profile automatically. You can also customize the auto-linking process by 
defining the email Id for auto/pre-linking in any custom table rather than the current User 
[sys_user] table. You can customize the auto-linking process of user profiles by using the 
sn_va_teams.auto_link_email_attribute  system property that defines the column 
from which the email ID of the user must be read for auto-linking.

Note: 

• By default, the value of the system property is empty. If it is set to <empty>, then the email 
Id for the user is fetched from the [sys_user] table.

• If the value of the system property is specified in the format of 
table_name.column_name  (both table_name and column_name must be the 
physical names from their respective name fields), then the value is read from the column 
name specified. For example, sn_va_teams_extendeduser.u_custom_mail.

Procedure

1. In the navigation filter, enter sys_properties.list.

The entire list of properties in the System Properties [sys_properties] table is displayed.

2. Search and open the sn_va_teams.auto_link_email_attribute  system property.

3. Provide a value in the format of table_name.column_name  and save the record.
Once the record is saved, you can initiate the conversation with the bot.

Configure Microsoft Azure  Conditional Access for Microsoft Teams  tenant

You must configure conditional access in Microsoft Azure  to restrict users from accessing 
the production applications. Conditional access helps you from accidentally overriding your 
production integration with a custom or personal instance integration.

Before you begin
Roles required: virtual_agent_admin and user with Azure admin access.
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Procedure

1. Log in to Microsoft Azure  portal .

2. Search for Azure AD Conditional Access.

3. Navigate to New Policy  > Create New Policy  and provide the policy a 

name.

4. Under Users or Workload identities, click 0 users or workload identities selected.
A What does this policy apply to?  pop-up is displayed.
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5. Under Include, select All 

users.

Note: 
Selecting All users will include the users in the restriction policy.

6. Under Exclude, select Users and groups  to exclude admin users who have access to override 

the tenant.

7. Under Select excluded users, click 0 users and groups selected  to select an admin user and 
click Select.

8. Under Cloud apps or actions, choose which assets to protect.
For example, the NowBot or whatever the name of the ServiceNow  bot is in Azure.

9. Under Grant, click 0 controls selected  and select Block access.

10. In the Enable policy section, select On  to turn on the Report-only function.
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11. Click Create.
After the ACL (Access Control List) is configured, it takes about 15 minutes fr the 
synchronization.

Result
After the policy is created and the synchronization is complete, 
it restricts any user except the admins from overriding the tenant 

accidentally.

Note: 
The restriction does not affect the restricted users from using the Microsoft Teams  or the 
Now Virtual Agent.
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Configure promoted topics for Conversational Integration with Microsoft Teams

Configure promoted topics to push out important, common topics for users' quick consumption 
during a conversation with the Microsoft Teams  bot. You can configure up to six different 
promoted topics to be displayed on the Microsoft Teams  channel greeting message.

Before you begin
Role required: admin or va_admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings  > Virtual Agent.

2. In Virtual Agent settings  under Custom greetings and setup, click View All.
The promoted topics that you have previously configured will reside in the default chat 
experience. For more information, see Configure a Virtual Agent chat experience. If default 
chat experience is the only row that you have on your instance, then you observe that the 
promoted topics will be applied to Web Client, Microsoft Teams, and Slack  (unless you 
configure something unique for Microsoft Teams  as instructed below.)

If you want to set up unique promoted topics for Microsoft Teams  that have to be different from 
the Web Client, follow the procedure below.

3. In the Custom Greetings & Setup page, click New.

4. On the form, fill in the fields.

Create New Custom Greetings and Setup

Field Description

Name Name of the chat experience. For example, 
Microsoft Teams  chat experience.

Description Description of the chat experience.

Active Enable or disable the chat experience.

Order Order for the promoted topics to appear on 
the chat.

Domain Application scope of the chat experience.

Condition Mode Situation where your user gets this chat 
experience.

Available Conditions Modes:

◦ Advanced

◦ Simple

Condition Condition that defines the condition mode for 
the chat experience.

Set up a simple condition with [devicetype] 
[is] [teams].
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Field Description

Note: 
If you set up [devicetype] [is] [teams] 
in the Condition pop up with a higher 
order than the default chat experience, 
then Microsoft Teams  picks up the 
setup topics and promoted topics 
defined in this experience.

This change will not affect Web Client, 
which is still going to inherit the setup 
topics and promoted topics defined in 
the default chat experience.

5. Click Create custom experience.

6. Add promoted topics in the Microsoft Teams  chat experience form that you created.

a. On the Microsoft Teams  form, click the Promoted Topics  tab, and click Add topic.

b. On the form, fill in the fields.

Create New Promoted Topics

Field Description

Topic Name of the topic being chosen.

Use the Search icon to choose a topic.

Order Provide the order for the topic chosen.

Note: 
Similar to Web Client, you can configure a maximum of six promoted topics for the 
Microsoft Teams  channel.

c. Click Save.

What to do next
Start a conversation with the Microsoft Teams  bot and you should be able to see the promoted 
topics after the greeting message that you have setup for the Microsoft Teams  channel.

In you have not configured the promoted topics for Microsoft Teams, then the promoted topics 
from the default chat experience are displayed.

Set up your language preferences for the Virtual Agent  integration with Microsoft Teams

Set language preferences so that Virtual Agent  is in the same language as the user's preferred 
Microsoft Teams  language.

Before you begin
Role required: admin
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About this task
You set the Microsoft Teams  language preference in the Microsoft Teams  client. The ServiceNow 
language is the language that is typically used in the ServiceNow  instance. By default, a user's 
Microsoft Teams  language preference takes precedence over the user preference language of 
the base system if both languages are different. For more information, see Change Settings in 
Microsoft Teams .

To ensure consistency, use the same language. If the user preference language in Microsoft 
Teams  isn’t an available language in the ServiceNow  instance, then the instance language is the 
default language.

Procedure

Change which language takes precedence by configuring the following system property for 
users: sn_va_teams.use_teams_language.

Localize the bot messages

Localize the bot messages to receive them in a language of your choice during your 
conversations with the bot.

Before you begin
Role required: virtual_agent_admin

Procedure

1. Navigate to the provider channel identity record of your bot and select the Bot Messages  tab.

Confirm that the values for those bot messages are accurate.

2. Navigate to the Messages [sys_ui_message.list] table and click New.

Note: 
Before creating a new message, ensure that the message you want to create is not 
already created.

3. On the form, fill in the details.

New Message record

Field name Description

Key Message for the record. Make sure that this 
matches with the bot message value in step 
1. If you want to create multiple translations 
for the same message in different languages, 
add each translated message individually.

Language Your preferred language for the conversation/
message.

Message The equivalent of the key message translated 
into your preferred language.

4. Click Submit.
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Result
Start a new conversation with the bot. You will notice that the translated message is displayed 
by the bot in user’s preferred Microsoft Teams  language, if you have already provided the 
translation for that language.

Capture common errors and resolution steps for Microsoft Teams  using the Conversational 
Interfaces Diagnostic Tool

The Conversational Interfaces Diagnostic Tool runs a health report to define and capture 
information for different categories of the Conversational Integration with Microsoft Teams  app, 
such as plugin details, configuration settings, system properties, integration failures, and so on, 
and lets the user validate and review these settings to start a bot-conversation.

When a user runs the health check scan and if there are issues that are shown on the report, 
then the user can take actions to resolve the issues based on the recommendations that the bot 
provides through the CI Diagnostic Tool.

Grouping common errors

To provide a health report of the various aspects of the Conversational Integration with Microsoft 
Teams  application, the most common issues have been grouped into the following categories:

• Microsoft Teams  not responding

• Notifications

• Automatic Linking

• Image/HTML

• Performance

• Installation

• Live Agent

Resolution

The Conversational Interfaces Diagnostic Tool is used to resolve the errors that users come 
across with their Microsoft Teams  app. Knowledge Base articles are documented with resolutions 
to the issues and the records for these KB articles are created in the CI Diagnostic Tool.

Note: 
Microsoft Teams  requires the CI Diagnostics Tool of version 1.1.0 to make the diagnostic 
topic available for the user.

Resolving errors using the CI Diagnostic Tool includes the following steps:

1. Login into the Web Client and start the CI Diagnostic Tool.

The CI Diagnostic Tool presents the following groups to choose from:

◦ Error Message

◦ System Property Lookup

◦ Plugin/Functionality Issue

◦ General Question

2. Select Plugin/Functionality Issue  and type Conversational Integration with 
Microsoft Teams  or any related keyword to get the options of available plugins related to 
your search term.

The Microsoft Teams  application logo appears as a response.
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3. After Microsoft Teams  is provided as an input to the CI Diagnostic tool, a basic health check of 
the app gets executed and a report is generated for the user.

The health check is run to verify if:

◦ Microsoft Teams  app plugin installed

◦ Provider application record verification.

◦ Message auth table has all the records

◦ Dependant plugins are available

◦ OIDC token verification records are available

◦ Provider reference is missing in the [sys_cs_provider_application] table

After successful health check scan, verifications such as recent installation 
errors, recent syslog errors, and recent HTTP transactions are presented to the 

user.

4. The health check report also provides you with an option to view existing Knowledge Base 
articles that may be associated with your issue. Enter Yes  and provide a few words to describe 
your issue.

For example, if you enter image  as your issue description, then the CI Diagnostic tool 
presents you with the Knowledge Base articles related to images. Click the link to view the 
Knowledge Base article.

Click No  to proceed for additional support.

5. The CI Diagnostic Tool provides you with an additional support topic available for the Microsoft 
Teams  plugin. Click Yes  to proceed.
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You are presented with the following issue types to select 

from.

For example, if you select any one of the issue types, the CI Diagnostic Tool provides you 
with the resolution steps pertaining to that issue type to identify the cause of the issue and to 
resolve it. You will also be presented with the relevant Knowledge Base articles to get further 
details about the issue.

Finally, the CI Diagnostic Tool asks you to check if your issue is resolved. Click Yes  if the issue 
is resolved.

Remove Conversational Integration with Microsoft Teams

Remove the integrations between your ServiceNow  Virtual Agent bot or the Self-configured bots 
and Microsoft Teams  to disassociate the app with your ServiceNow  instance.

Before you begin
Roles required:

• Virtual_agent_admin and external_app_install_admin or admin

• Administrator for third-party applications

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. In General Settings  under Channels and integrations, select View All.

3. On the Channels and integrations page, on the Microsoft Teams  tile, select Manage

4. In the Manage Microsoft Teams channel page, find the integration (Now Virtual Agent  bot or 

the Self-configured bot) that you would like to remove, select the manage bot icon , and select 
Remove integration.

Remove integration with ServiceNow Virtual Agent
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Remove integration with Self-configured bot

5. In the Remove integration confirmation message, select Remove  to continue removing the 

integration.
The Virtual Agent integration with the selected Microsoft Teams  bot has been removed.

Conversational Integration with Slack

Enable requesters to chat with Virtual Agent  or live agents using the Slack  application.

Note: 
In earlier releases, the pre-built Virtual Agent  messaging integration for Slack  was part of 
the Virtual Agent  platform. This integration is now the Conversational Integration with Slack 
app, available from the ServiceNow Store .

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Overview

Use the Conversational Integration with Slack  application to connect your requesters with Virtual 
Agent  or live agents through your company’s Slack  workspace. To get started, see .

Integrating ServiceNow Virtual Agent with Slack

Enables ServiceNow®  Virtual Agent  to integrate with the Slack  application.

Install the Conversational Integration with Slack

You can install the Conversational Integration with Slack  (sn_va_slack) application if you have the 
admin role.
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Before you begin

• Ensure that the application and all of its associated ServiceNow Store  applications have valid 
ServiceNow  entitlements. For more information, see Get entitlement for a ServiceNow  product 
or application .

• If you're using an earlier release of Virtual Agent, you must upgrade to the Washington DC 
release to use the features supported in this channel integration.

• Conversational Integration with Slack  requires the Glide Virtual Agent  plugin 
(com.glide.cs.chatbot) to activate full functionality in Virtual Agent  or the Virtual Agent  Lite 
plugin (com.glide.cs.chatbot.lite) to activate a limited version of Virtual Agent. Activate the 
appropriate plugin before you install the integration.

• Install the Conversational Integration with Slack  app from the ServiceNow®  Store.

Important: 
Installing the Conversational Integration with Slack  app from the ServiceNow Store 
activates the app for integration on your ServiceNow  instance. If you have not installed 
the integration app, the Slack  app is listed in the Available Channels section.

Channels and integrations page before Conversational Integration with 
Slack  apps is installed

After you install the Conversational Integration with Slack  plugin (sn_va_slack), Slack  is 
seen in the Integrations section, and you can proceed with the configuration.

Role required: virtual_agent_admin and external_app_install_admin or admin

About this task
Review these guidelines for using Virtual Agent  with Slack  or with Slack  Enterprise Grid.

• The Slack  app creates a one-to-one association between the ServiceNow  instance that you are 
installing from and the Slack  workspace in which the integration runs.

◦ Use a separate Slack  workspace for each instance that you plan to install the integration in.

◦ If you use a non-production instance for testing, use a Self-configured bot.

For more information, see Integrate ServiceNow instance with Self-configured bot.
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• Slack  Enterprise Grid – If you have Slack  Enterprise Grid workspaces, your end users can 
move between workspaces and use the Virtual Agent  bot from any workspace.

◦ If you use a non-production instance for testing, use a workspace in a different grid or use a 
non-grid workspace.

◦ After installing this store release:

▪ Your messaging users are automatically linked to their ServiceNow  accounts.

▪ If you clone an instance for non-production testing, be sure to run the installation again on 
the cloned target.

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. In General Settings  under Channels and integrations, click View All.

3. On the Channels and integrations page, in the Slack  tile, click Get Slack 

plugin.
You are redirected to the Conversational Integration with Slack  ServiceNow Store  page.

4. On the top right corner for the screen, click Get.

Note: 
You must be logged into the ServiceNow Store  portal to get the plugin.

5. On the Conversational Integration with Slack  ServiceNow Store  page, click Request Install.

6. On the Request Install screen, provide the Instance Name  and Reason for request.
You can also validate the instance that you provided by clicking Validate Instance.

7. Click Request.
A message pops up on the Request Install screen that your request has been auto approved.

What to do next
Integrate ServiceNow Virtual Agent with Slack.

Integrate ServiceNow  Virtual Agent  with Slack

Add the Virtual Agent  bot to your ServiceNow®  instance to integrate with Slack.

Before you begin
Ensure that you have installed the Conversational Integration with Slack  plugin (sn_va_slack) on 
your ServiceNow  instance before adding any integrations.

Role required: admin
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Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. In General Settings  under Channels and integrations, select View All.
The Channels and integrations page opens.

3. Under the Available Channels section in the Slack  tile, select Add Integrations, and select 
Integrate with ServiceNow Virtual Agent.

Note: 
The Add Integrations  drop-down is available only after installing the Conversational 
Integration with Slack  plugin (sn_va_slack) on your ServiceNow  instance.

4. Enter your Slack  workspace URL to sign into your Slack  workspace, and select Continue.

Note: 
Ensure that you input the name of the Slack  workspace for which you have access.

5. Sign in to your ServiceNow®  instance.

6. Select Allow  when Slack  requests permission to access your workspace.
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7. If the selected workspace ant has already been assigned to Virtual Agent, you must first 
uninstall from the previously associated instance.

Note: 

Starting from Utah  release, if your Slack  workspace is already associated with another 
ServiceNow  instance, but if you intend to associate it with a new instance, then you're 
asked to reach out to the administrator to first uninstall it from the previously associated 
instance. For more information, see Override Slack integration.

When Virtual Agent  has been successfully installed on the Slack  workspace, a completion 
message appears.
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8. Select Go to Slack  to manage the Slack  app.

9. Select Continue to manage channels and integrations  to manage the integration on your 
ServiceNow  instance.

The Slack  application appears in the list of integrations.

What to do next
If you would like to integrate your ServiceNow instance with another Slack  bot, select the plus 
icon in the ServiceNow Virtual Agent tile, or select the Add integration  list on the Manage Slack 
channel page.

.

For more information, see Manage the ServiceNow Virtual Agent integration with Slack.

Override Slack  integration

Override Virtual Agent integration with Slack.

Before you begin
Role required: virtual_agent_admin or admin

About this task
Before Utah  release, an admin was able to override a Slack  installation that is associated with a 
particular instance with a different ServiceNow  instance.

Starting from Utah  release, if your Slack  workspace is already associated with another 
ServiceNow  instance, but you intend to associate it with a new instance, then you must reach out 
to the administrator to first uninstall it from the previously associated instance.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2164



Important: 
The instructions in Remove ServiceNow Virtual Agent integration with Slack  are only 
applicable when both instances are compatible with Utah  and the above releases. If one of 
your ServiceNow  instances is on the Utah  release and another on a release prior to Utah, 
follow the steps below.

Procedure

1. In the left navigation filter of your ServiceNow  instance, enter sys_properties_list.

2. Search and open the sn_va_slack.enable_slack_override  system property.

Note: 
If you don't find this system property, you (as an admin) must create one.

3. Set the system property value to true  to enable the Override  button.
By default, the value of the system property is false.

4. Select Override  to associate the instance with a new tenant.
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Manage the ServiceNow Virtual Agent integration with Slack

Manage your Conversational Integration with Slack  application, its branding, and customize the 
bot-specific messages in your ServiceNow  instance after integration.

Before you begin
Roles required:

• virtual_agent_admin and external_app_install_admin or admin

• Administrator for third-party applications

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. In General Settings  under Channels and integrations, select View All.

3. Click Manage  on the Slack  tile.
When you select Manage, you are redirected to the Manage Slack channel page where you 
can manage the bots.

4. To integrate your ServiceNow instance with another Slack  bot, select the Add integration for 
ServiceNow Virtual Agent icon against the ServiceNow Virtual Agent.
Additionally, you can also select the Add integration  drop-down on the top-right of the 
Manage Slack  channel page and select Integrate with ServiceNow Virtual Agent.

5. Select the Manage Bot icon and select Manage Virtual 

Agent.
You are redirected to the Bot Configuration page for the selected bot.

6. Select the Branding  tab to brand your ServiceNow Virtual Agent bot.
For more information about branding your bot, see Configure branding for your Virtual Agent 
bot in Slack.

7. Select the Bot Messages  tab to create and edit a bot message.
For more information, see Create bot messages.

Configure branding for your Virtual Agent  bot in Slack

You have the flexibility to customize the default ServiceNow  branding for your Slack  Virtual Agent. 
You can change the production bot's name and icon.

Before you begin
Role required: admin or virtual_agent_admin
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Note: 
The branding capability in Slack  is available from the August 2022 store release and is 
compatible with the Tokyo  release and above. Users must ensure that they are on the 
Tokyo  family release and have downloaded the August store release for the Conversational 
Integration with Slack  app to use this functionality.

Ensure that you set the com.glide.cs.enable_slack_branding  system property to 
true before configuring the branding settings for your bot.

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. On the General Settings  page under Channels and integrations, click View All.

3. On the Channels and integrations page, in the Slack  tile, click Manage.

4. Click the Manage Bot icon and select Manage Virtual 

Agent.

5. On the Branding tab, provide the following details:

◦ Bot name: Name that appears on the Slack  conversation body.

On the Configure your bot integration in Slack  page, change the default bot name to a bot 
name of your choice and click Save.

Note: 

▪ If you ever want to change the bot name back to the default bot name, delete the bot 
name that you provided and click Save. The bot name will be taken from the available 
bot name on Slack  admin center.

▪ If you want your bot name to be different from the header and the left pane, provide a 
different name.

◦ App name: Name that appears in the Slack header and left panel.

To change the App name on the Slack  header and left panel, perform the following steps.

▪ Log in to Slack admin center .

▪ Navigate to Slack app directory  and find your Slack  pre-published app.

▪ On your Slack  app page, click the Configuration  tab and navigate to the Bot User section.
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▪ Click Edit  to edit the bot name.

▪ In the Edit bot name pop-up, change the bot name to a name of your choice and click 
Save Changes.

Note: 
If you want the bot name to be consistent with the bot name in the conversation 
body, then provide the same bot name.

◦ Slack bot icon: Icon that appears in the Slack conversation body.

▪ Use default icon: Select the Use default icon  radio button and click Save  to change the 
bot icon back to the default bot icon.

▪ Use custom icon:

Select the Use custom icon  radio button to change the Slack  bot icon and click Save.

There are two ways to upload an image icon.

▪ Click Attach image  to browse for an image icon and click Save.

▪ Click the Use image URL instead  to provide a URL of the image icon and click Save.

Branded Slack conversation body

What to do next
Open your Slack  bot interface and start a new conversation. You will notice that the bot name has 
been updated on the Slack  conversation body, header, and in the left pane and the bot icon is 
updated only in the conversation body.

Remove ServiceNow Virtual Agent integration with Slack

Remove the ServiceNow Virtual Agent integration from your ServiceNow  instance to disassociate 
the Slack  app.

Before you begin
Roles required:

• Virtual_agent_admin and external_app_install_admin or admin

• Administrator for third-party applications
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Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. In General Settings  under Channels and integrations, click View All.

3. On the Channels and integration page, in the Slack  tile, click Manage.

4. In the Manage Slack channel page, find the ServiceNow Virtual Agent integration to remove 

from your ServiceNow  instance, click the manage bot icon , and select Remove integration.

Remove integration with ServiceNow Virtual Agent

5. In the Remove integration confirmation message, click Remove.
You are redirected to the Slack App Directory.

6. On the Slack app directory, navigate to the Configuration tab, and click See All  against 1 
authorized member.

7. Click Revoke  in the 1 Authorized member pop-up.

8. Click Revoke  in the confirmation 

message.
A message appears saying that You have successfully removed an authorization for Now 
Virtual Agent.
ServiceNow Virtual Agent integration with Slack  is removed from your ServiceNow instance.

Integrating Self-configured bot with Slack  workspace

Enables ServiceNow®  Virtual Agent  to allow multiple ServiceNow  instances to integrate with 
single Slack  workspace.

The Virtual Agent  integration with Slack  creates a one-to-one association between the 
ServiceNow  instance that you are installing from and the Slack  workspace in which the 
integration runs. By default, Virtual Agent  supports one-click installation that integrates one Slack 
workspace with one ServiceNow  instance. By enabling this integration, Virtual Agent  allows you 
to integrate multiple ServiceNow  instances with a single Slack  workspace. You can integrate 
multiple ServiceNow  instances with a single Slack  workspace by creating a bot for each of the 
instances on the targeted Slack  workspace.

Create a bot in Slack

You must create a self-configured bot in the targeted workspace in Slack  to be able to integrate 
with the Virtual Agent.
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Before you begin
Role required: none

Note: 
Users must have permissions to create a bot in the targeted workspace.

Procedure

1. Log in to Slack API .

2. Navigate to Your Apps  and click Create New App.

3. Enter an App Name, select your Slack Workspace  and click Create App.

4. Configure Interactive Components.

a. Navigate to Interactivity  > Shortcuts  in the left menu and turn on Interactivity.

b. Update the Request URL.
If you are setting up your self-configured bot on an ServiceNow  instance, then the request 
URL must be https://<instance-name>/api/now/v1/cs/adapter/slack/
actions.

c. Click Save.

5. Configure Event Subscriptions.

a. Click Event Subscriptions  in the left menu and turn on Enable Events.

b. Update the Request URL.
If you are setting up your self-configured bot on a ServiceNow  instance, then the request 
URL must be https://<instance-name>.service-now.com/api/now/v1/cs/
adapter/slack/events.

c. Wait for the Request URL to get 

verified.
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d. Under Subscribe to bot events, click Add Bot User Event  and add message.im.

e. Click Save.

6. Navigate to the Incoming Webhook  tab and slide the Activate Incoming Webhooks  toggle 
switch to enable it.

7. Configure OAuth & Permissions.

a. Click OAuth & Permissions from the left menu and navigate to Scopes  > Bot Scopes.

b. Select Add an OAuth Scope  and add the following scopes:

▪ chat:write

▪ files:read

▪ files:write

▪ im.history

▪ incoming-webhook

▪ team:read

▪ users:read

▪ users:read.email

8. Navigate to OAuth & Permissions, click Install to Workspace, and click Allow.
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Retrieve Self-configured bot details

Retrieve the details of the bot that you created in the Slack  workspace to integrate with the 
ServiceNow  instance.

Before you begin
Role required: admin

Procedure

1. Log in to Slack API .

2. Click Your Apps, select a bot and navigate to Settings  > Basic Information  > Display 
Information  to copy the App name  (Bot name).

3. Enter your Bot User OAuth Access Token  in the token argument, click Test Method, and copy 
the Team ID.

Note: 
You can find the Access token in OAuth & Permissions  in your Slack  app.
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4. Navigate to Basic Information in your Slack workspace (in 
api.slack.com) and copy the Signing Secret  under App 

Credentials.

5. Navigate to OAuth & Permissions in your Slack  workspace and copy the Bot User OAuth 
Access Token.

Result
You should now be able to interact with your Self-configured bot.
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If you do not see your bot under the Apps section, then click Add Apps  and search for your bot 
and select it. You can type hi  to receive a response.

Integrate ServiceNow instance with Self-configured bot

Add the Self-configured bot to your ServiceNow  instance to complete the integration with Slack.

Before you begin
Role required: virtual_agent_admin or admin and Slack  workspace admin

This installation requires a ServiceNow  instance other than the one integrated with the 
production bot to integrate one bot (of the multiple bots) with a single Slack  workspace.

Note: 
The ServiceNow  instance that you will use to integrate the Self-configured bot with a 
single Slack  workspace must not be an instance that you have used for integrating the 
ServiceNow Virtual Agent.

Ensure that you created a bot on the Slack  workspace and fetched the bot details to complete 
the integration. For more information, see Create a bot in Slack.

Fetch the Name of the bot, Team ID, Signing Secret, and Access Token details for your bot 
created in Slack. For more information, see Retrieve bot details. Use this information when 
setting up the bot in your ServiceNow  instance.

Procedure

As a ServiceNow  admin, set up the bot on the ServiceNow  instance in the global scope.

Note: 
The virtual_agent_admin can install bots with multiple instances or bots apart from the 
production bot in the ServiceNow  instance and avail all the features of Virtual Agent  and 
also have the flexibility to integrate one of the multiple ServiceNow  instances with a bot on 
a single Slack  workspace.

a. Log in to your ServiceNow  instance and navigate to All  > Conversational Interfaces  > Settings.

b. In General Settings  under Channels and integrations, click View All.
The Channels and integrations page opens.

c. Under the Available Channels section in the Slack  tile, click Add Integrations  and select 
Integrate with Self-configured bot.
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Note: 
The Add Integrations  button is available only after installing the Conversational 
Integration with Slack  plugin (sn_va_slack) on your ServiceNow  instance. For more 
information about getting the plugin installed, see Install the Conversational Integration 
with Slack.

d. In the Integrate Slack  with self-configured bot page, provide the following details that you 
made a note while creating the Slack  bot and click Submit.

◦ Name of the bot

◦ Team ID

◦ Signing Secret

◦ Access Token
For more information, see Retrieve bot details.

Integrate Slack  with self-configured bot page

Note: 
For each additional ServiceNow  instance to be integrated, repeat steps 1 and 2.

If you would like to integrate your ServiceNow  instance with another Slack  bot, click 
the Plus icon against the Self-configured bot or click the Add integration  button on the 
Manage Slack channel page and select Integrate with Self-configured bot.
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You will receive a message that the installation is successful.

Manage the self-configured bot integration with Slack

Manage your Conversational Integration with Slack  application, its branding, and customize the 
self-configured bot-specific messages in your ServiceNow  instance after integration.

Before you begin
Roles required:

• virtual_agent_admin and external_app_install_admin or admin

• Administrator for third-party applications (Slack)

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. In General Settings  under Channels and integrations, click View All.

3. Click Manage  on the Slack  tile.

If you would like to integrate your ServiceNow  instance with another Slack  bot, click 
the Plus icon against the Self-configured bot or click the Add integration  button 
on the Manage Slack channel page and select Integrate with Self-configured bot. 
For more information, see Integrate ServiceNow instance with Self-configured bot 

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2176



When you click Manage, you are redirected to the Manage Slack channel page where you can 
manage the bots.

4. Click the Manage Bot icon  and select Manage Bot.
You are redirected to the Bot Configuration page for the selected bot.

5. Click the Configuration  tab to brand your Self-configured bot.
For more information about branding your Self-configured bot, see Configure branding for your 
Self-configured bot.

6. Click the Bot Messages  tab to create and edit a bot message.
For more information, see Create bot messages.

Configure branding for your Self-configured bot

Configure your self-configured Slack  app's branding. You have the flexibility to customize the 
default ServiceNow  branding for the Slack  self-configured bot name and icon.

Before you begin
Ensure that you have completed integrating Virtual Agent with a Self-configured bot in Slack 
before customizing the branding options.

Role required: admin

Procedure

1. Log in to the Slack admin center .

2. Click Your apps  and select a bot from for which you want to change the branding settings.

3. Navigate to Settings  > Basic Information  > Display Information.

4. In the Display Information section, you can update the following details:

a. App name: Name of your Self-configured bot.

b. Short description: A short sentence describing your Self-configured bot.

c. App icon & Preview: Image representing your Self-configured bot on the conversation body.

Note: 
Ensure that the image you would like to upload as the app icon is in squares between 
512 px by 512 px and 2000 px by 2000 px.

d. Background color: Background color of your bot icon while on the conversation body.

e. Long description: Description of your Self-configured bot to show on your App Detail page.

5. Click Save Changes.

Remove Self-configured bot integration with Slack

Remove the Self-configured bot integration from your ServiceNow  instance to disassociate with 
the Slack  app.

Before you begin
Roles required:
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• Virtual_agent_admin and external_app_install_admin or admin

• Administrator for third-party applications

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. In General Settings  under Channels and integrations, click View All.

3. On the Channels and integration page, in the Slack  tile, click Manage.

4. In the Manage Slack Channel page, find the Self-configured bot integration to remove from 

your ServiceNow  instance, click the manage bot icon , and select Remove integration.

Remove integration with Self-configured bot

5. In the Remove integration confirmation message, click 

Remove.
The Self-configured bot integration with Slack  has been removed successfully.

Configure Virtual Agent settings for Slack

Configure your Slack  bots that are integrated with the Virtual Agent to enable notifications, to link 
ServiceNow  user profiles, and to set up system messages and contextual actions.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. In General Settings  under Channels and integrations, click View All.

3. On the Channels and integrations page, in the Slack  tile, click Manage.

4. Select the Settings  tab.
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5. Slide the Enable Notification for all users  toggle switch to disable notifications for the linked 
users.

Note: 

◦ The Enable Notification for all users  toggle switch is selected by default.

◦ The Automatically Link ServiceNow user profiles  toggle switch is selected by default 
and disabled for any further change. This option links all the active ServiceNow 
accounts automatically to the associated Microsoft Teams  bot.

6. Set up the Global Messaging Settings.

Note: 
Any changes made to these settings will reflect in all the channels.

◦ System Messages: Customize the default system messages displayed during Virtual Agent 
conversations.

For more information about changing or updating a system message, see Change system 
messages.

◦ Contextual Actions: Customize the supported actions per user command inputs.

For more information about updating a contextual action, see Contextual actions for custom 
chat integrations.

Virtual Agent  features supported in Slack  conversations

Virtual Agent  features, such as AI Search  results, Virtual Agent  notifications, and Virtual 
Agent Designer  controls for creating Virtual Agent  conversations are supported in Slack  bot 
conversations.

Note: 
Conversational Integration for Slack  is not supported for on-prem instances.

This section highlights key Virtual Agent  features that are supported in the Conversational 
Integration with Slack  app.

AI Search  results

Virtual Agent  can generate AI Search  results that are displayed as Genius result cards and multi-
link outputs in conversations. For details on how Virtual Agent  generates AI Search  results, see 
Improving the user experience with AI Search. The default AI Search  configuration for Virtual 
Agent  enables search results for Q&A (knowledge base) and catalog items.

URL navigation for chat links

In Virtual Agent  and Live Agent  conversations on the Slack  app, links to ServiceNow  records 
open automatically in base system portals—including links displayed in output cards, Virtual 
Agent  notifications, and AI Search  results. If needed, admins can change the portals in which 
these links are opened. For configuration details, see Configure URL navigation for chat links.

Trusted Domains

In custom chat integrations, the values specified in the Trusted media domains field of the 
Provider Channel Identities table [sys_cs_provider_application] takes precedence over the 
Connections table [sys_cs_provider] and therefore overrides.
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Chat Localization into Conversation Language

Starting from version 5.0.1, chat gets localized into the customer specified conversation language 
set in the Slack  UI, though the session language is different.

Translation of responses to the conversation language is done using the function 
gs::getMessageLang(str, lang), where the language retrieved from Slack  is passed 
through this function as a parameter. The translation process works with the following three use 
cases, when:

• The requested language plugin is available in the ServiceNow  instance.

When the requested language plugin is available in the ServiceNow  instance then the Session 
language honors the Conversation language set by the user.

• The requested language plugin is absent, but fallback is set and enabled.

When the requested language plugin is absent, then the fallback language specified in the 
[sys_language] table is used for the translation process. However, for the fallback mechanism 
to work, you must enable the glide_i18n.language_fallback_enabled  system 
property. By default, the value of the property is false. Set it to true  to enable the fallback 
mechanism. For more information, see Set a fallback language .

• The requested language plugin is absent, but fallback is not set/enabled.

When the requested language plugin is absent and fallback is also not set/enabled, the 
default translation language will be English.

Virtual Agent Designer  user input and bot response controls in Slack

The Virtual Agent Designer  user input controls and bot responses for creating conversation 
topics are supported in Slack  conversations, including the table bot response and the card 
control that can display images.

Virtual Agent Designer  user input controls and bot responses

Starting with Version 2.0.0, the card and video bot response controls are supported in Slack 
conversations. The video control displays a thumbnail image of the video that users select to 
open the video in their preferred web browser.

For more information about user input controls and bot responses, see Virtual Agent Designer 
user input controls  and Virtual Agent Designer bot responses, respectively.

Upload multiple file types

Starting from Version 5.0.2, you can upload multiple image files (up to 10 files) from your desktop 
or by providing the valid link for an image picker topic in Virtual Agent. You can also share 
multiple files (up to 10 files) to a Virtual Agent  topic via a link or by uploading it from your desktop.

To upload multiple image files or other attachments during your conversation with the bot, select 
Image file types  or All file types  respectively.

Note: 
You can also share multiple files with a Live Agent  from Slack.

Virtual Agent  notifications supported in Slack

Slack  app supports Virtual Agent  notifications during conversations.
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• Subscription management

◦ Requesters - Use the notification  (or notifications) command to subscribe to or unsubscribe 
from notifications.

◦ Admins - Enable notifications for messaging users in the Messaging Apps Integration page.

• Notification content - Create notifications with rich content, images, and action buttons. 
Actionable notifications enable recipients to perform certain actions and respond to the 
notification, such as adding a comment or requesting a live agent.

• Notification delivery

◦ Message notifications are delivered immediately to end users, even if the user is chatting 
with a virtual or live agent.

◦ Actionable notifications are delivered only when the user is not in an active conversation 
with a virtual or live agent. Users can choose to:

▪ Review the notifications later by using the show notification  command.

For example, with the show notification  command, users can select the notification they 
want to view.

▪ Perform or skip the actions for the notification. If users decide to skip the actions, users 
can return later to the notification by using the show notification  command.

For detailed information on Virtual Agent  notifications, see Configuring Virtual Agent 
notifications.

Unsupported Virtual Agent  features in Slack

Refer to the unsupported features of Virtual Agent  in Conversational Integration with Slack.

Unsupported features

Virtual Agent  does not support the following functionalities during a conversation in Slack.

• Connect Support

• Geo-location topic block

Pre-link Virtual Agent  requesters before integration with Slack

Pre-link your Virtual Agent  requesters to a ServiceNow  instance before they run the 
Conversational Integration with Slack. Batch pre-linking enables your Virtual Agent  users 
immediately to chat with a virtual agent and receive notifications without going through the initial 
authentication linking process.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2181



Before you begin

• Manage the ServiceNow Virtual Agent integration with Slack, with the Automatically Link 
ServiceNow user profiles  option enabled.

• Set up Slack Spoke .

Roles required:

• virtual_agent_admin

• external_app_install_admin

• One of the following Slack  administrator roles:

◦ Global Administrator

◦ Application Administrator

◦ Cloud Application Administrator

• admin or schedule_admin to change the scheduled job script

About this task
When the Automatically Link ServiceNow user profiles  option is enabled on the Messaging 
Apps Integration UI page, a batch of up to 10,000 users is automatically pre-linked to a 
ServiceNow  instance. Your existing users are pre-linked during the initial run. Newly added users 
are pre-linked during subsequent daily runs.

To prevent automatic batch pre-linking, disable the Automatically Link ServiceNow user 
profiles  option on the Messaging Apps Integration UI page.

Batch pre-linking of your Virtual Agent  users to a ServiceNow  instance before integrating with 
Slack  includes the following benefits:

• Notifications are proactively sent by the Virtual Agent  to users when their identity in Slack 
is associated with their identity in a ServiceNow  instance. This is also true when the user is 
already linked with the ServiceNow  Virtual Agent.

• If a user is pre-linked, and when Slack  notifications are enabled in the app, notifications are 
pushed to the app even when a user is not logged into a Slack  account.

Batch pre-linking happens automatically via the Slack Daily Pre-Link Job  scheduled job. 
This job runs by default at a scheduled time (time is displayed in the time zone of the system 
administrator) and you can change the time, if desired. To modify the default scheduled job run 
time or time zone, access the Slack Daily Pre-Link Job  Scheduled Script Execution form.

Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Search for the Slack Daily Pre-Link Job  scheduled job and click to open the Scheduled Script 
Execution form for the selected record.

3. In the Run  field, change the run time to your desired time.

4. For a description of the other fields that you can change in this form, including Time zone, see 
Automatically run a script of your choosing .

5. Click Save.

Configure promoted topics for Conversational Integration with Slack

Configure promoted topics to push out important, common topics for users' quick consumption 
during a conversation with the Slack  bot. You can configure up to six different promoted topics to 
be displayed on the Slack  channel greeting message.
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Before you begin
Role required: admin or va_admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. On the Virtual Agent settings page, navigate to the Custom greetings and setup and click View 
All.
The promoted topics that you have previously configured reside in the default chat experience. 
For more information, see Configure a Virtual Agent chat experience. If default chat experience 
is the only row that you have on your instance, then you observe that the promoted topics will 
be applied to Web Client, Microsoft Teams, and Slack  (unless you configure something unique 
for Slack  as instructed below.)

If you want to set up unique promoted topics for Slack  that have to be different from the Web 
Client, follow the procedure below.

3. On the Custom Greetings & Setup page, click New.

4. On the form, fill in the fields.

Create New Custom Greetings and Setup

Field Description

Name Name of the chat experience. For example, 
Slack  chat experience.

Description Description of the chat experience.

Active Enable or disable the chat experience.

Order Order for the promoted topics to appear on 
the chat.

Domain Application scope of the chat experience.

Condition Mode Situation where your user gets this chat 
experience.

Available Conditions Modes:

◦ Advanced

◦ Simple

Condition Condition that defines the condition mode for 
the chat experience.

Set up a simple condition with [devicetype] 
[is] [slack].
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Field Description

Note: 
If you set up [devicetype] [is] [teams] 
in the Condition pop up with a higher 
order than the default chat experience, 
then Slack  picks up the setup topics 
and promoted topics defined in this 
experience.

This change will not affect Web Client, 
which is still going to inherit the setup 
topics and promoted topics defined in 
the default chat experience.

5. Click Create custom experience.

6. Add promoted topics in the Slack  chat experience form that you created.
Review the character length of your promoted topics before adding them for Slack. When the 
text in the topic gets closer to ~30 characters, the text may get truncated. For more information, 
see Slack  document .

a. On the Slack  chat experience form, click the Promoted Topics  tab and click Add topic.

b. On the form, fill in the fields.

Create New Promoted Topics

Field Description

Topic Name of the topic being chosen.

Use the Search icon to choose a topic.

Order Provide the order for the topic chosen.

Note: 
Similar to the Web Client, you can configure a maximum of six promoted topics for the 
Slack  channel.

c. Click Save.

What to do next
Start a conversation with the Slack  bot and you should be able to see the promoted topics after 
the greeting message that you have setup for the Slack  channel.

In you have not configured the promoted topics for Slack, then the promoted topics from the 
default chat experience are displayed.

Conversational Integration with Workplace from Facebook

Enable requesters to chat with Virtual Agent  or live agents using the Workplace from Facebook 
application.
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Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Overview

Use the Conversational Integration with Workplace from Facebook  application to connect your 
requesters with Virtual Agent  or live agents through your company’s Workplace from Facebook 
application. To get started, see .

Install the Conversational Integration with Workplace from Facebook

You can install the Conversational Integration with Workplace from Facebook 
(sn_va_fb_workplace) application with the admin role.

Before you begin

• Ensure that the application and all of its associated ServiceNow Store  applications have valid 
ServiceNow  entitlements. For more information, see Get entitlement for a ServiceNow  product 
or application .

• If you're using an earlier release of Virtual Agent, you must upgrade to the Washington DC 
release to use the features supported in this messaging integration.

• Conversational Integration with Workplace from Facebook  requires the Glide Virtual Agent 
plugin (com.glide.cs.chatbot) to activate full functionality in Virtual Agent  or the Virtual Agent 
Lite plugin (com.glide.cs.chatbot.lite) to activate a limited version of Virtual Agent. Activate the 
appropriate plugin before you install the integration.
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• Install the Conversational Integration with Workplace from Facebook from the ServiceNow® 

Store.

Important: 
Installing the Conversational Integration app from the ServiceNow Store  store activates 
the corresponding Install  button in the Channels and integrations page. If you have not 
installed the integration app, the Workplace from Facebook  app is listed in the Available 
Channels section.

Channels and integrations page before Conversational Integration with 
Workplace from Facebook  is installed

After you install the Conversational Integration with Workplace from Facebook  app, the 
Workplace from Facebook  is seen in the Integrations section, and you can proceed with 
the configuration.

Roles required: virtual_agent_admin and external_app_install_admin or admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. In General Settings  under Channels and integrations, click View All.

3. On the Channels and integrations page, in the Microsoft Teams  tile, click Get Workplace 
plugin.

You are redirected to the Conversational Integration with Workplace from Facebook 
ServiceNow Store  page.
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4. On the top right corner of the screen, click Get.

Note: 
You must be logged into the ServiceNow Store  portal to get the plugin.

5. On the Conversational Integration with Workplace from Facebook  ServiceNow Store  page, 
click Request Install.

6. On the Request Install screen, provide the Instance Name  and Reason for request.
You can also validate the instance that you provided by clicking Validate Instance.

7. Click Request.
A message pops up on the Request Install screen that your request has been auto approved.

What to do next
Integrate ServiceNow Virtual Agent with Workplace from Facebook.

Integrate ServiceNow Virtual Agent with Workplace from Facebook

Add the Now Virtual Agent  bot to your ServiceNow  instance to integrate with Workplace from 
Facebook.

Before you begin
Roles required:

• virtual_agent_admin and external_app_install_admin or admin

• Administrator for third-party applications

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. In General Settings  under Channels and integrations, click View All.
The Channels and integrations page opens.

3. Under the Available Channels section in the Microsoft Teams  tile, click Add Integrations.

Note: 
The Add Integrations  button is available only after installing the Conversational 
Integration with Workplace from Facebook  plugin (sn_va_fb_workplace) on your 
ServiceNow  instance.

You are directed to the Workplace admin page to add a bot.

4. On the login screen for Workplace, enter your login credentials.
If you have multiple accounts for Workplace, a menu displays the accounts that you can log in 
to. Select the account in which you want to install the app.

5. In the window that requires your authorization to install the integration, click Add to 
Workplace.
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If the selected workspace has already been integrated with Workplace, click Save  or Cancel  to 
leave the current assignment in place.

To delete the Conversational Integration with Workplace from Facebook, see Uninstall the 
Conversational Integration with Workplace from Facebook.
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6. When you see a confirmation message about the installation, verify the installation.

Result
The Virtual Agent  bot and Workplace from Facebook  are now integrated for use on your 
ServiceNow  instance.

Manage ServiceNow Virtual Agent integration with Workplace from Facebook

Manage your Conversational Integration with Workplace from Facebook  application, its branding, 
and customize the bot-specific messages in your ServiceNow  instance after integration.

Before you begin
Roles required:

• virtual_agent_admin and external_app_install_admin or admin

• Administrator for third-party applications

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. In General Settings  under Channels and integrations, click View All.

3. On the Channels and integrations screen, in the Workplace  tile, click Manage.
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When you click Manage, you are redirected to the Manage Workplace channel page where 
you can manage the bots.

4. Click the Manage Bot icon and select Manage Virtual 

Agent.
You are redirected to the Bot Messages page where you can create and edit a bot message. 
For more information, see Create bot messages.

Configure Virtual Agent settings for Workplace from Facebook

Configure your Workplace from Facebook  bot that are integrated with Virtual Agent to enable 
notifications, to link ServiceNow user profiles, and to set up system messages and contextual 
actions.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. In General Settings  under Channels and integrations, click View All.

3. On the Channels and integrations page, in the Workplace  tile, click Manage.

4. Select the Settings  tab.
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5. Swipe to the right the Enable Notification for all users  toggle button to enable notifications for 
the linked users.

Note: 
The Enable Notification for all users  toggle button is selected by default.

The Automatically Link ServiceNow user profiles  toggle button is selected by default 
and disabled for any further change. This option links all the active ServiceNow accounts 
automatically to the associated Workplace from Facebook  bot.

6. Set up the Global Messaging Settings.

Note: 
Any changes made to these settings will reflect in all the channels.

◦ System Messages: Customize the default system messages displayed during Virtual Agent 
conversations.

For more information about changing or updating a system message, see Change system 
messages.

◦ Contextual Actions: Customize the supported actions per user command inputs.

For more information about updating a contextual action, see Contextual actions for custom 
chat integrations.

Virtual Agent  features supported in Conversational Integration with Workplace from 
Facebook

The Conversational Integration with Workplace from Facebook  app supports Virtual Agent 
features such as Virtual Agent Designer  controls for creating conversations, notifications, AI 
Search  results, and more.

Note: 
The Conversational Integration with Workplace from Facebook  is not supported for on-prem 
instances.

This section highlights relevant Virtual Agent  features that are supported in the Workplace from 
Facebook  app.

Virtual Agent Designer  user input and bot response controls

The Virtual Agent Designer  user input and bot response controls for creating conversation topics 
are supported in Workplace  conversations, including the table bot response and the card control 
that can display images.

Starting with Version 2.0.0, the card and video bot response controls are supported in Workplace 
conversations. The video control displays a thumbnail image of the video that users can select to 
open the video in their preferred web browser.

For more information about user input controls and bot responses, see Virtual Agent Designer 
user input controls  and Virtual Agent Designer bot responses, respectively.

AI Search  results

Virtual Agent  can generate AI Search  results that are displayed as Genius Result Cards and 
multi-link outputs in conversations. For details on how Virtual Agent  generates AI Search  results, 
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see Improving the user experience with AI Search. The default AI Search  configuration for Virtual 
Agent  enables search results for Q&A (knowledge base) and Catalog items.

Virtual Agent  notifications

For detailed information on Virtual Agent  notifications, see Configuring Virtual Agent 
notifications.

• Subscription management

◦ Requesters - Use the notification  (or notifications) command to subscribe to or unsubscribe 
from notifications.

◦ Admins - Enable notifications for messaging users in the Messaging Apps Integration page.

• Notification content - Create notifications with rich content, images, and action buttons. 
Actionable notifications enable recipients to perform certain actions and respond to the 
notification, such as adding a comment or requesting a live agent.

• Notification delivery

◦ Message notifications are delivered immediately to end users, even if the user is chatting 
with a virtual or live agent.

◦ Actionable notifications are delivered only when the user is not in an active conversation 
with a virtual or live agent. Users can:

▪ Review the notifications later by using the show notification  command.

For example, with the show notification  command, users can view their notifications.

▪ Perform or skip the actions for the notification. If users decide to skip the actions, users 
can return later to the notification by using the show notification  command.

URL navigation for chat links

In Virtual Agent  and Live Agent  conversations on the Workplace  app, links to ServiceNow  records 
open automatically in base system portals—including links displayed in output cards, Virtual 
Agent  notifications, and AI Search  results. If needed, admins can change the portals in which 
these links are opened. For configuration details, see Configure URL navigation for chat links.

Trusted Domains

In custom chat integrations, the values specified in the Trusted media domains field of the 
Provider Channel Identities table [sys_cs_provider_application] takes precedence over the 
Connections table [sys_cs_provider] and hence overrides.
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Unsupported features

• Promoted topics and Connect Support  are not supported.

• Geolocation topic block is not supported.

• Account pre-linking is not supported in Workplace from Facebook.

Uninstall the Conversational Integration with Workplace from Facebook

Uninstall the Conversational Integration with Workplace from Facebook  and disassociate the app 
with your instance.

Before you begin
Roles required:

• Virtual_agent_admin and external_app_install_admin or admin

• Administrator for third-party applications

Procedure

1. Log in to Workplace from Facebook.

2. Click Admin Panel.

3. Click Integrations.

4. In the list of Workplace from Facebook  integrations, click Now Virtual Agent.

5. In the window that displays the settings for Now Virtual Agent  click Uninstall.

6. In the window that requires authorization to uninstall the app, click Uninstall.

Result
Now Virtual Agent  no longer appears on the list of integrations in Workplace from Facebook. 
The instance receives uninstallation information from Workplace from Facebook, and the app 
configuration and user information are deleted within 15 days.

Integrating Virtual Agent with consumer messaging apps

Integrating consumer messaging apps such as LINE, Twilio, WhatsApp, Google Business 
Messages, and Facebook Messenger  with ServiceNow®  Virtual Agent  associates the app with 
your ServiceNow  instance to facilitate end-to-end conversations.

Setup Virtual Agent integration for consumer messaging apps

Engage customers where they are with rich conversations by enabling them to message anytime 
to your company's account using their choice of messaging apps.

Conversational integrations are available for SMS Twilio, WhatsApp  (powered by Twilio), LINE, 
and Facebook Messenger  consumer messaging apps from the ServiceNow  Store.

Conversational SMS Integration with Twilio

Host Virtual Agent  conversations on Twilio  SMS to chat with virtual agent or live agents. Use 
the Conversational SMS Integration with Twilio  app, available from the ServiceNow Store, to 
associate your instance with SMS Twilio.

Capturing information from a user in an SMS chat conversation

Conversational SMS Integration with Twilio enables users to initiate conversations with Virtual 
Agent  by messaging your Twilio  phone number.
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Note: 
Do not use the same ServiceNowTwilioDirect or Twilio  Notify phone number for 
Conversational SMS Integration with Twilio. Instead, use separate Twilio  numbers for 
Conversational SMS Integration with Twilio  and ServiceNowTwilioDirect.

Example SMS conversation with Virtual Agent

If a bot transfers the conversation to a live agent, the agent can respond to SMS messages in 
Agent Workspace.

After you set up the Conversational SMS Integration with Twilio, you can create SMS 
conversation topics in Virtual Agent Designer. For more information on using the tool, see Getting 
started with Virtual Agent Designer

Supported controls

The Conversational SMS Integration with Twilio does not support all the available controls in 
Virtual Agent Designer.

The following user input controls are supported in Twilio  SMS conversations:

Supported user input controls

User input 
control

Description

Text
User enters a plain text string in the conversation.
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Supported user input controls  (continued)

User input 
control

Description

Static 
Choice User selects an item from a predefined list.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2195



Supported user input controls  (continued)

User input 
control

Description

Dynamic 
Choice User selects an item from a list that is created dynamically. For example, the user 

can select from a list of cases that they opened.

Boolean
User enters a Boolean response to the bot. For example, the user can reply "Yes" or 
"No" in the conversation.
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Supported user input controls  (continued)

User input 
control

Description

File 
picker

User sends a file to the bot.

Note: 
Conversational SMS Integration with Twilio  doesn't support all file types. Only 
images can be sent in an SMS conversation.
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Supported user input controls  (continued)

User input 
control

Description

For more information on configuring user input controls, see Virtual Agent Designer user input 
controls.

The following bot responses are supported in Twilio  SMS conversations:

Supported bot responses

Bot response Description

Text Bot sends a plain text string to the user.
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Supported bot responses  (continued)

Bot response Description

Image Bot sends an image to the user.
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Supported bot responses  (continued)

Bot response Description

Link Bot sends a web link to the user.
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Supported bot responses  (continued)

Bot response Description

Card Bot sends selected information from a record on your instance.
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For more information on configuring bot responses, see Virtual Agent Designer bot responses.

Live agents can use the Text, Card, and Image response controls to reply to users in SMS 
conversations.

User subscriptions for SMS update notifications

Beginning with version 1.1.1, your users with ServiceNow  accounts (sys_user profiles) can choose 
to start or stop receiving SMS updates in their conversations.

Note: 
Notifications in messaging channels can be sent to users with ServiceNow accounts. Other 
recipients, such as consumer and customer contacts, are considered to be guests and 
cannot receive notifications on messaging channels.

To comply with privacy regulations, user notifications are turned off by default. Users can opt in or 
change their settings in the following ways:

• To check SMS notification settings for the account, send this text: Notification

• To receive SMS notifications, send this text: START

• To stop receiving SMS notifications, send this text: STOP

Changing SMS notification settings

To learn more about Virtual Agent  notifications, see Configuring Virtual Agent notifications.

For details about creating content for a messaging notification, see Define Virtual Agent 
notification contents.

Install Conversational SMS Integration with Twilio

You can install the Conversational SMS Integration with Twilio  (sn_va_sms_twilio) application to 
host Virtual Agent  conversations in the SMS Twilio  application.
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Before you begin

• Ensure that the application and all of its associated ServiceNow Store  applications have valid 
ServiceNow  entitlements. For more information, see Get entitlement for a ServiceNow  product 
or application .

• Review the Conversational SMS Integration with Twilio  application listing in the ServiceNow 
Store  for information on dependencies, licensing or subscription requirements, and release 
compatibility.

Role required: admin or virtual_agent_admin

Procedure

1. Navigate to System Applications  > All Available Applications  > All.

2. Find the Conversational SMS Integration with Twilio (sn_va_sms_twilio) application using the 
filter criteria and search bar.

You can search for the application by its name or ID.

If you cannot find the application, you may have to request it from the ServiceNow Store. 
Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released 
apps, see the ServiceNow Store  version history release notes .

3. Select a version from the list and select Install.

In the Install dialog box that is displayed, any dependencies that are installed along with your 
application are listed.

4. If you're prompted, follow the links to the ServiceNow Store  to get any additional entitlements 
for dependencies.

What to do next
Set up the Conversational SMS Integration with Twilio.

Set up the Conversational SMS Integration with Twilio

Integrate Twilio  with Virtual Agent  so that you can engage in SMS bot conversations.

Before you begin
Before you can set up the Conversational SMS Integration with Twilio, complete the following 
tasks:

1. Ensure that you have valid ServiceNow  entitlements for the following products and 
applications:

◦ Integration Hub

◦ Twilio  spoke

◦ Conversational SMS Service Channel

◦ Conversational SMS Integration with Twilio

For more information, see Get entitlement for a ServiceNow  product or application .

2. Install the following applications on your instance:

◦ Integration Hub

◦ Twilio  spoke
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◦ Conversational SMS Service Channel

◦ Conversational SMS Integration with Twilio

3. Set up Twilio spoke

4. Ensure that the Conversational Custom Chat Integration plugin (com.glide.cs.custom.adapter) 
is active on your instance.

Role required: external_app_install_admin or va_admin

Procedure

1. Create a Hash Message Verification record.

a. In the navigation filter, enter hash_message_verification.list  and click New.

b. On the form, fill in the fields.

Hash Message Verification form

Field Description

Name Name of the auth token, such as TwilioSMSTestAppAuthToken.

Description Description of the auth token, such as "Twilio SMS Testing 
application Auth Token."

Secret Auth token that is associated with your Twilio  phone number.

c. Click Submit.

2. Create a Message Auth record.

a. In the navigation filter, enter message_auth.list  and click New.

b. On the form, fill in the fields.

Message Auth form

Field Description

Name Name of the message auth, such as VA Twilio SMS Test App 
Message Auth.

Provider Provider of the auth token. Enter Twilio.

Group name Name of the recipient group. Leave this field blank.

Service Portal Service Portal  that is associated with the message auth. Leave this 
field blank.

Inbound message 
verification

Hash message token that you created.

Outbound message 
verification

Hash message token that you created.
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Field Description

Outbound service 
token

Authorized outbound service token. Leave this field blank.

c. Click Submit.

3. Create a Messaging Provider Application record.

a. Navigate to Conversational Interfaces  > SMS integration with Twilio  and click New.

b. On the form, fill in the fields.

Messaging Provider Application form

Field Description

Name Name of the entity that users are contacting, such as IT Service 
Desk.

Phone Number Twilio  phone number that users are contacting.

Note: 
Be sure to include the '+' symbol and the country code in front 
of the phone number. For example: +18185559485.

Message auth Message auth that you created.

c. Click Submit.

4. In the Twilio  Console, for the phone number that you specified in Step 3, update the SMS 
incoming web-hook.
To update the web-hook, navigate to the phone number in your Twilio  console: Phone 
Numbers  > Manager  > Active numbers. Click on the phone number and enter the following 
address in the Messaging web-hook field:

https://<instance-name>.service-now.com/api/sn_va_sms_twilio/me
ssage

What to do next
After you set up the Conversational SMS Integration with Twilio, you can create SMS 
conversation topics in Virtual Agent Designer. For more information on using the tool, see Virtual 
Agent Designer.

Related topics

Install Conversational SMS Integration with Twilio

Install a ServiceNow Store application

Activate a plugin

Using Conversational SMS Integration with Twilio

Enable a requester to converse with an agent using the SMS conversations.

An administrator can configure the Conversational SMS Integration with Twilio  application for 
integrating the SMS messaging app with a ServiceNow  application.
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A requester can initiate SMS conversations with a virtual agent or live agent.

A live agent can:

• Accept SMS conversations as work items from their Agent Workspace Inbox to converse with a 
requester.

• Initiate SMS chat conversations from interactions of type Chat from their Agent Workspace 
Inbox to converse with a requester.

• For logged in customers, the system automatically identifies the customer by matching their 
phone number against the customer contact.

Accepting SMS conversations

As a live agent interacting with a requester over the SMS service channel, you can:

• Converse with the requester through text messages.

• Share a knowledge article displayed as a link to the requester.

• Share a record, for example, a customer service case.

• Share any URLs as links.

• Share any images as attachments.

Note: 
You accept a work item from the SMS conversation in your Agent Workspace Inbox when 
an administrator has configured the SMS service channel for transfer of chat conversations. 
For more information, see Conversational SMS service channel.

Initiating SMS conversations

As a live agent, you can initiate an SMS conversation with a requester when the Agent-Initiated 
Messaging Interface  application is configured for the SMS messaging channel. By default, 
the application is configured for agent to initiate SMS conversations with consumers and 
customer contacts. For more information, see  Initiate messaging conversations from the CSM 
Configurable Workspace  and  Initiate SMS conversations from CSM Agent Workspace .

Configure SMS authentication

Authenticate all users using Conversational SMS Integration with Twilio  with Soft PIN (SN) and 
Google authenticators as the 2-factor authentication mechanisms for account linking.

Before you begin
Role required: virtual_agent_admin or admin

Procedure

1. On your ServiceNow  instance, enter sys_cs_provider.list  and open VA SMS Twilio 
Adapter Provider  record.

2. In the VA SMS Twilio  Adapter Provider record, select the Allow account linking  check box.
Selecting the Allow account linking  check box populates the Link account action  and 
Account linking type  options.

3. Select Verification question and MFA  from the Allow account linking  drop-down.

When Verification question and MFA  is selected, the Automatic link action  field populates 
with the sn_va_sms_twilio.va_sms_auto_link_account  value.
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With Verification question and MFA  selected, the end user is asked to enter the Soft Pin along 
with an MFA (Multi-factor Authentication) OTP (One Time Password) and Google authenticator 
is the default MFA method for SMS Twilio  for enhanced security.

If there is an invalid input/failure, you can continue the conversation as a guest user. Upon 
success, the session is elevated to the authenticated user session.

Also, you can also look up the automatic link flow action from the Flow Designer.

4. Navigate to the Define the identity and messages for this connection  section on the SMS 
Twilio provider channel record and click the Provider Properties  tab to configure the following 
mandatory MFA Provider Properties.

◦ verification_question_id: Default sys_id for SoftPIN verification. The default value 
can be customized.

◦ two_factor_methods: By default, Google authenticator is the two factor method if 
Verification question and MFA  is selected.

google_autheticator  or sms  are the supported values.

Note: 
If this property value is updated, then the mfa_question_id  property value must be 
updated to the sys_id of the corresponding verification Id.

◦ mfa_question_id: Corresponds to the two-factor method. The value is the default sys_id 
for the google authenticator verification type.

Note: 
If you set the value of two_factor_methods property to sms, then you must update the 
sys_id of this property to SMS verification type.

To get the SMS verification type sys_id, navigate to Verification Types  and copy the 
SMS Code Verification Type  sys_id record.

5. To use account linking in SMS Twilio, navigate to the User [sys_user] table by entering 
sys_user.list, pick a user, and update the user's mobile phone number with a valid 
incoming mobile phone number.
After the incoming phone number is authenticated, the system authenticates the user and 
links the phone number to the respective User [sys_user] ID.

6. To Enroll the Soft PIN, perform the following steps:
Setting up your Soft PIN enables you to use this PIN for identifying yourself when you try to 
have a conversation via SMS.

a. Impersonate the user that you picked in the Step 5 and navigate to Password Reset  > Enroll.

b. In the Password Reset Enrollment record, under the Soft PIN Verification tab, enter the Soft 
Pin in the Enter the Soft PIN  field.

c. Under the Authenticator App Verification  tab, click Generate a new QR code  to generate 
the QR code for your Google authenticator if you have downloaded one.

d. Click Submit.

When authentication is enabled for SMS, even when an actionable notification is triggered for 
the user in SMS conversation, user is expected to enter the Soft PIN and MFA to execute the 
action. For example, when an incident is updated, an actionable notification is triggered on the 
SMS app and you are asked to input your authentication code (Soft PIN or MFA code).
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Rate limiting policy for SMS Authentication

Rate limiting policy locks out a user when an invalid or incorrect Soft PIN is entered consecutively 
for 3 times in a span of 24 hours.

Rate limiting policy

Rate limiting policy is enabled by default for SMS for better security. To configure it, navigate 
to All, and then enter sys_cs_provider.list  in the filter. Open the SMS record, and 
configure the following properties on the Provider Properties  tab.

• softpin_lockout_enabled: Enables Soft PIN lockout functionality. The default Value is 
true.

• softpin_max_invalid_attempts_interval_hrs: The window where users can 
make the maximum Soft PIN attempts.

Note: 
The maximum window is 24  hours.

• softpin_max_retry_attempts: Number of attempts for the user to enter an incorrect 
Soft PIN after the user account is locked out.

Note: 
The maximum number of attempts is 3.

If your account is locked, you are treated as a guest user when you start a new 
conversation. The bot confirms that your account is locked. You are then provided 
with the public topics and you can also unlock the account using the Setup/Reset 
Verification Profile  Virtual Agent  topic to reset the Soft PIN and Google authenticator.

Conversational Integration with WhatsApp (powered by Twilio)

Engage with requesters who prefer the WhatsApp  messaging app to interact with your business. 
Requesters include customer contacts and consumers.
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Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Overview

Enable requesters to interact on WhatsApp  chat with a virtual agent or live agent using the 
ServiceNow®  Conversational Integration with WhatsApp (powered by Twilio)  application. 
The application connects a requester with a virtual agent or live agent using your company's 
WhatsApp-enabled Twilio  phone number. To get started with the Conversational Integration 
with WhatsApp (powered by Twilio)  application, see Configure Conversational Integration with 
WhatsApp (powered by Twilio).

Configure Conversational Integration with WhatsApp (powered by Twilio)

Install and set up the Conversational Integration with WhatsApp (powered by Twilio)  application 
to enable requesters to interact with virtual and live agents.

Before you begin
Role required: admin

About this task
This task provides the general steps to integrate the WhatsApp  messaging app with a 
ServiceNow  application using the Conversational Integration with WhatsApp (powered by Twilio) 
application.

Procedure

1. Install Conversational Integration with WhatsApp (powered by Twilio).

2. Set up Conversational Integration with WhatsApp (powered by Twilio).

3. Design virtual agent topics to capture information from a WhatsApp  chat conversation.

4. Optional:  Close idle WhatsApp  chat conversations.

5. Optional:  Transfer WhatsApp chat conversations to live agents.

Install Conversational Integration with WhatsApp (powered by Twilio)

Install the Conversational Integration with WhatsApp (powered by Twilio)  so that your business 
can interact with requesters on the WhatsApp  app. The application includes demo data and 
installs related ServiceNow Store  applications and plugins if they are not already installed.

Before you begin

• Ensure that the application and all of its associated ServiceNow Store  applications have valid 
ServiceNow  entitlements. For more information, see Get entitlement for a ServiceNow  product 
or application .

Role required: admin

About this task
The following applications or plugins are installed with Conversational Integration with WhatsApp 
(powered by Twilio):

Twilio Spoke (sn_twilio_spoke)

Provides Integration Hub actions that may be used to create, update, delete, and 
look up records on the Twilio  app.
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For more information on activating this application, see Twilio spoke.

Conversational Custom Chat Integration (com.glide.cs.custom.adapter)

Provides custom chat integration framework of scriptable APIs to enable the Virtual 
Agent  application on any conversational interface.

For more information on this plugin, see Conversational custom chat integrations.

ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)

Enables execution of Integration Hub  actions and flows.

Complex Object (com.glide.cobject)

Enables complex objects.

Agent-Initiated Messaging Interface (sn_agent_initiated)

Provides configurations for the agent-initiated messaging capabilities.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the Conversational Integration with WhatsApp (powered by Twilio)  application 
(sn_va_whatsapp_twi) using the filter criteria and search bar.

You can search for the application by its name or ID. If you cannot find the application, you 
might have to request it from the ServiceNow Store.

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released 
apps, see the ServiceNow Store  version history release notes .

3. In the Application installation dialog box, review the application dependencies.

Dependent plugins and applications are listed if they will be installed, are currently installed, or 
need to be installed. If any plugins or applications need to be installed, you must install them 
before you can install Conversational Integration with WhatsApp (powered by Twilio).

4. Optional:  If demo data is available and you want to install it, select the Load demo data  check 
box.
Demo data comprises the sample records that describe application features for the common 
use cases. Load the demo data when you first install the application on a development or test 
instance.

Important: 
If you don't load the demo data during installation, it's unavailable to load later.

5. Select Install.

Set up Conversational Integration with WhatsApp (powered by Twilio)

Set up the Conversational Integration with WhatsApp (powered by Twilio)  application so that you 
can engage requesters in bot conversations. Integrating with ServiceNow  Virtual Agent  enables 
you to interact on WhatsApp  chat with a Virtual Agent or Live Agent.

Before you begin
Before you begin, do the following:
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• Get ServiceNow  entitlements for the following products and applications:

◦ Integration Hub

◦ Twilio  spoke

◦ Conversational Integration with WhatsApp (powered by Twilio)

For more information, see Get entitlement for a ServiceNow  product or application .

• Install the following applications on your ServiceNow  instance:

◦ Integration Hub

◦ Twilio  spoke

◦ Conversational Integration with WhatsApp (powered by Twilio)

• Connect your Twilio Number to your WhatsApp Business Profile .

• Set up Twilio spoke.

Role required: external_app_install_admin or va_admin

Procedure

1. Connect your company's Twilio  account with your ServiceNow  instance.

a. Log in to your Twilio Console .

b. From the Project Info pane of the Console Dashboard page, note down the authentication 
token.
You will later use this token to authenticate the Twilio  account on your ServiceNow  instance. 
For more information, see the Twilio documentation .

c. To specify the webhook URL, in the Twilio  console, navigate to Programmable Messaging  > 
Senders  > WhatsApp Senders.
To enable your Twilio  account to send messages to your ServiceNow  instance, enter the 
webhook URL in the following format: https://<instance-name>.service-
now.com/api/sn_va_whatsapp_twi/message.

d. Click your WhatsApp-enabled Twilio  phone number.

e. In the A MESSAGE COMES IN  field of the Configure WhatsApp Number dialog box, enter 
the webhook URL of your ServiceNow  instance and click Configure.

2. To authenticate incoming hash messages from the Twilio  account, create a Hash Message 
Verification record that stores the Twilio  authentication token.

a. In the navigation filter of your ServiceNow  instance, enter 
hash_message_verification.list.

b. In the Hash Message Verifications list, click New.

c. On the form, fill in the fields.
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Hash Message Verification form

Field Description

Name
Name of the record in the Hash Message Verification 
[hash_message_verification] table that stores the 
authentication token that is associated with your company's 
WhatsApp-enabled Twilio  phone number. For example, 
TwilioWhatsappTestAppAuthToken.

Description Description of the record. For example, Twilio Whatsapp 
Testing application Auth Token.

Secret
Twilio authentication token that is associated with your company's 
WhatsApp-enabled Twilio  phone number.

d. Take note of the name of the Hash Message Verification record.

e. Click Submit.

3. Associate inbound message records with a Message Auth record.

a. In the navigation filter of your ServiceNow  instance, enter message_auth.list  and click 
New.

b. On the form, fill in the fields.

Message Auth form

Field Description

Name Name of the record in the Message Auth [message auth] table. 
For example, VA Twilio WhatsApp Test App Message 
Auth.

Provider Provider of the auth token. Enter Twilio.

Group name Name of the group that you created.

Service Portal Customer service portal that you created.

Outbound service 
token

Authorized outbound service token.

Inbound message 
verification

Name of the Hash Message Verification record that you created for 
the inbound hash messages in step 2.

Outbound message 
verification

Name of the Hash Message Verification record that you created for 
the inbound hash messages in step 2.

Note: 
The values for the Inbound message verification  and 
Inbound message verification  fields are the same.

c. Click Submit.
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4. Associate the Message Auth record with the WhatsApp-enabled Twilio  phone number.

a. In the navigation filter of your ServiceNow  instance, enter sys_cs_provider.list.

b. In the Provider Channels list, click Twilio  from the Name  column corresponding to the 
WhatsApp  channel.
If the Twilio  entry is not present, enter sys_cs_provider_application.list  in the 
navigation filter to create the list.

c. In the Provider Channel Identity related list, click New.

d. On the form, fill in the fields.

Provider Channel Identity form

Field Description

Name Name of the entity that users are contacting, such as IT Service 
Desk.

Inbound ID
Twilio  phone number that users are contacting.

Note: 
Be sure to include the '+' symbol and the country code in front 
of the phone number. For example: +18185559485.

Message auth Message auth that you created in step 3.

e. Click Submit.

Set the URL navigation for WhatsApp  chat

When agents share links in their WhatsApp  chat conversations, customize the portal that those 
links point to. For example, you can configure links to point to your brand’s portal, or to the 
ServiceNow  portal.

Before you begin
Install the Conversational Integration with WhatsApp (powered by Twilio)  application on your 
ServiceNow  instance.

Activate the Consumer Service Portal plugin (com.glide.service-portal.consumer-
portal).

Role required: admin

Procedure

1. In the navigation filter of your ServiceNow  instance, enter 
sys_cs_provider_application_list.do  and click New.

2. On the form, fill in the fields.
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Provider Channel Identity form

Field Description

Name Name of the channel you are using. Enter 
WhatsApp.

Provider Name of the provider. Enter WhatsApp.

Default Portal Portal to be used in the mapping. Select a 
portal from the list of portals.

Message Auth Message auth that you created.

Inbound ID Your WhatsApp  phone ID. For example: 
+1415XXXXXXX

3. Click Submit.

What to do next
For more information on setting up URL navigation, see Configure URL navigation for chat links.

Capturing information from a user in a WhatsApp  chat conversation

Use the collection of input controls provided by the Virtual Agent Designer  to prompt and capture 
information from a requester in a WhatsApp  chat conversation.

Virtual Agent Designer is a diagram tool for creating and managing topics, which are blueprints 
for conversations between a virtual agent and user. For more information, see Getting started 
with Virtual Agent Designer.

User notification consent

Users must opt in to receive notifications. No notifications can be delivered until the user grants 
consent.

There are two ways for users to grant consent to receive notifications:

• The user can enter Notification  into the WhatsApp  chat with your business. The user 
gets a bot response with the option to subscribe or unsubscribe from receiving notifications for 
your business on WhatsApp.

• As the administrator, you can set up the option for users to subscribe or unsubscribe from 
notifications from your portal. See Configure system settings  for more information.

User input controls

The Conversational Integration with WhatsApp (powered by Twilio)  application supports the 
following user input controls in Virtual Agent Designer.

Supported user input controls

User input control Description

Text User enters a plain text string in the conversation.

Static Choice User selects an item from a predefined list.

Boolean User enters a Boolean response to the bot. For example, the user can 
reply Yes  or No  in a chat conversation.
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Supported user input controls  (continued)

User input control Description

File Picker User sends a file to the bot.

Date Time User selects a calendar date, time (hours and minutes), or both.

Carousel User selects a single item from the carousel.

For more information about configuring user input controls, see Virtual Agent Designer user input 
controls.

The Conversational Integration with WhatsApp (powered by Twilio)  application supports the 
following bot responses in Virtual Agent Designer.

Supported bot responses

Bot response Description

Text Bot sends a plain text string to the user.

Image Bot sends an image to the user.

Link Bot sends a web link to the user.

Web UI image card 
output

Bot sends content from a record in a compact format, including an 
image with text.

Table Bot response is displayed as a table.

For more information about configuring bot responses, see Virtual Agent Designer bot 
responses.

Closing idle WhatsApp  chat conversations

Enable agents to effectively manage their active WhatsApp  chat conversations by automatically 
closing idle conversations after they have been inactive for a pre-configured amount of time.

The Virtual Agent  conversations are configured for the WhatsApp  messaging app. By default, 
any conversations abandoned by requesters remain open or idle until they are automatically 
closed daily by the Time Out Abandoned VA Conversations  scheduled job. For more 
information, see Closing Virtual Agent and Agent Chat conversations.

As an administrator, you can change the default timeout period for idle Virtual 
Agent  conversations configured for the WhatsApp  messaging app by setting the 
com.glide.cs.whatsapp_idle_timeout  system property to the number of seconds 
that abandoned conversations remain open after the requester's last response. The system 
property value must be less than the time interval set for the Time Out Abandoned VA 
Conversations  scheduled job, set to two hours (7200 seconds) by default. Because the 
com.glide.cs.whatsapp_idle_timeout  system property isn't available by default, you 
must add it with the data type set to integer. For more information, see Add a system property .

Transfer WhatsApp  chat conversations to live agents

Configure the Advanced Work Assignment  application to transfer a WhatsApp  chat conversation 
initiated by a requester to a live agent.

Before you begin
Your administrator must have completed the following tasks:
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• Install Conversational Integration with WhatsApp (powered by Twilio).

• Activate Advanced Work Assignment.

• Set the application scope to Conversational Integration with WhatsApp (powered by Twilio) 
using the application picker. For more information, see Application picker .

• Activate the Conversational Messaging plugin (com.glide.messaging.awa). For more 
information, see Activate Conversational Messaging.

Role required: admin

About this task

Procedure

1. Enable the WhatsApp  service channel.

a. Navigate to Advanced Work Assignment  > Settings  > Service Channels.

b. In the Name  column of the Queues list, search for WhatsApp.

c. Click WhatsApp.

d. On the Service Channel form, select the Active  check box.

e. Click Update.
For more information, see Service channels.

2. Automatically route work items for WhatsApp  chat conversations to agents by configuring the 
queue for the WhatsApp  service channel.

a. Navigate to Advanced Work Assignment  > Settings  > Queues.

b. In the Name  column of the Queues list, search for Agent WhatsApp Queue.

c. Click Agent WhatsApp Queue.

d. On the Queue form, select the Active  check box.

e. Click Update.

Note: 
By default, the WhatsApp - Most Capacity  assignment rule is associated with the 
Agent WhatsApp Queue. You can create another assignment rule and associate it with 
the queue. For more information, see Configure agent assignment rules  and Work item 
queues.

3. Configure agent presence states for the WhatsApp  service channel.

a. Navigate to Advanced Work Assignment  > Settings  > Presence States.

b. In the Name  column of the Presence States list, click an existing state.

c. In the Apply to groups section of the Presence State form, click the add icon (>) to move the 
Agent WhatsApp Group  group from the Available  column to the Selected  column.

Note: 
You can ignore this step if you have selected the Apply to all groups  check box.

d. Click Update.

For more information, see Configure agent presence states.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2216

https://www.webstg.servicenow.com/docs/access?context=c_ApplicationPicker&version=washingtondc&pubname=washingtondc-application-development&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=c_ApplicationPicker&version=washingtondc&pubname=washingtondc-application-development&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=c_ApplicationPicker&version=washingtondc&pubname=washingtondc-application-development&ft:locale=en-US


Using Conversational Integration with WhatsApp (powered by Twilio)

Enable a requester to converse with an agent at their convenience using the WhatsApp  chat 
conversations through Virtual Agent.

An administrator can configure the Conversational Integration with WhatsApp (powered by 
Twilio)  application for integrating the WhatsApp  messaging app with a ServiceNow  application. 
For more information, see Integrating the WhatsApp messaging app with other applications.

Agents and requesters can do the following:

• A live agent can initiate WhatsApp  chat conversations with a requester.

• A requester can initiate WhatsApp  chat conversations with a virtual agent or live agent.

• A live agent can accept WhatsApp  chat conversations as work items from their Agent 
Workspace Inbox to converse with a requester.

• For logged in customers, the system automatically identifies the customer by matching their 
phone number against the customer contact.

Initiating WhatsApp  chat conversations

As a live agent, you can initiate WhatsApp  chat conversations with a requester in two ways:

• Send a message from either an active interaction record, a contact record, or a consumer 
contact record. See Setting up Agent Chat  in legacy workspace.

• Set up notifications to be sent to the requester when a business event occurs or when a record 
is updated. See Create a provider notification.

Note: 
The requester must subscribe and opt in to receive notifications.

Accepting WhatsApp  chat conversations

As a live agent interacting with a requester over the WhatsApp  service channel, you can do the 
following:

• Converse with the requester through text messages.

• Share a knowledge article displayed as a link to the requester.

• Share a record. For example, a customer service case.

• Share any URLs as links.

• Share any files as attachments.

Note: 
If an administrator has configured the WhatsApp  service channel for transfer of chat 
conversations, then you can accept a work item from the WhatsApp  chat conversation 
in your Agent Workspace Inbox. For more information, see Transfer WhatsApp chat 
conversations to live agents  and Service channels.

Create a provider notification

Execute the following steps to create a provider notification for Virtual Agent and Workspace 
providers.

Before you begin
Role required: admin
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Procedure

1. Navigate to All  > System Notification  > Provider  > Notifications  and select New.

2. On the form, fill in the fields.

Notifications form

Field Description

Name Name of the notification.

Application Application scope of the notification.

Active Option to activate the notification. The notification is active by 
default.

Trigger

Triggered By System action that triggers the notification. You can send the 
notification after a record is changed or after an event is triggered.

Table Table to receive notifications about.

Inserted
Option to send the notification after a record is inserted.

This field appears when you select Record Change  in the Triggered 
By  field.

Updated
Option to send the notification after a record is updated.

This field appears when you select Record Change  in the Triggered 
By  field.

Event
Event that triggers the notification. For example, to send a notification 
after an incident is closed or resolved, you would select the 
incident.inactive  event. By default, this event is logged in the 
system each time a user resolves or closes an incident.

Note: 
You can select only an event that shares the same table as the 
notification.

This field appears when you select Event  in the Triggered By  field.

Conditions Filter to specify the table records that users receive notifications 
about. For example, to send notifications about top-priority incidents, 
you would select Incident [incident]  in the Table  field and set the 
conditions to [Priority] [is] [1 - Critical].

Recipients

Users Users who receive the notification.

Note: 
Notifications in messaging channels are sent only to users 
with ServiceNow  accounts (sys_user profiles). Consumers 
and customer contacts are considered as guests and cannot 
receive notifications in messaging channels.
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Field Description

Recipients in fields Record fields that include users who receive the notification. For 
example, to send the notification to the record assignee, select 
Assigned to.

Note: 
This field shows up only if you select a table.

Is originating user 
included?

Option to include the user who changed the record or triggered the 
event.

Event Parm1 contains 
recipient(s)?

Option to select if Parm 1 contains a list of comma separated sys_ids

Event Parm2 contains 
recipient(s)?

Option to select if Parm 2 contains a list of comma separated sys_ids

Resolve Parm1 
recipients from table

Table that is used to resolve the sys_id of the recipient

Note: 
This field appears only when you select Event parm 1.

Resolve Parm2 
recipients from table

Table that is used to resolve the sys_id of the recipient

Note: 
This field appears only when you select Event parm 2.

Advanced event 
condition

Option to select when the recipients are from more than 2 tables. 
These are dynamic conditions.

3. Select Submit.

Note: 
Use the Submit  button for Virtual Agent notifications. The Submit and Add Common 
Content  button is for other use cases.

All the validation messages given by different providers are retained. Warning messages 
of one provider is not overridden by warning messages of another provider.

Integrating the WhatsApp  messaging app with other applications

Other ServiceNow  applications and features can use the Conversational Integration with 
WhatsApp (powered by Twilio)  application.

As a live agent, when you accept a request from the WhatsApp  service channel, you can 
converse with the requester within the same channel.

Integrating with Customer Service Management

Integrate the Conversational Integration with WhatsApp (powered by Twilio)  application with 
the ServiceNow®  Customer Service Management  application to enable your customer contacts 
and consumers to initiate a WhatsApp  chat conversation with a virtual agent or live agent. 
An agent can initiate a conversation, or accept a conversation initiated from a WhatsApp 
chat conversation. For more information, see Integrate WhatsApp with Customer Service 
Management through Twilio .
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Conversational Integration with LINE

Engage with requesters who prefer the LINE  messaging app to interact with your business. 
Requesters include customer contacts and consumers.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Overview

Conduct user-initiated, system-initiated, or agent-initiated conversations using the 
Conversational Integration with LINE  application. The application connects a requester 
with a virtual agent or live agent using your company's LINE  account. To get started with the 
Conversational Integration with LINE  application, see Configure Conversational Integration with 
LINE.

Configure Conversational Integration with LINE

Install and set up the Conversational Integration with LINE  application to enable your users to 
interact with virtual and live agents.

Before you begin
Role required: admin

About this task
This task provides the general steps to integrate the LINE  messaging app with a ServiceNow 
application using the Conversational Integration with LINE  application.

Procedure

1. Install Conversational Integration with LINE.

2. Set up Conversational Integration with LINE.

3. Design virtual agent topics to capture information from a LINE  chat conversation.

4. Optional:  Close idle LINE  chat conversations.

5. Optional:  Transfer LINE chat conversations to live agents.

Install Conversational Integration with LINE

Install the Conversational Integration with LINE  so that your business can interact with 
requesters on the LINE  app. The application includes demo data and installs related ServiceNow 
Store  applications and plugins if they are not already installed.

Before you begin

• Ensure that the application and all of its associated ServiceNow Store  applications have valid 
ServiceNow  entitlements. For more information, see Get entitlement for a ServiceNow  product 
or application .

• For existing customers, ensure that you install the Conversational Integration with LINE 
application on ServiceNow  instances that have been upgraded to at least the Rome  release.

Role required: admin

About this task
The following applications or plugins are installed with Conversational Integration with LINE:
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Conversational Custom Chat Integration (com.glide.cs.custom.adapter)

Provides the custom chat integration framework of scriptable APIs to enable the 
Virtual Agent  application on any conversational interface.

For more information on this plugin, see Conversational custom chat integrations.

ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)

Enables execution of Integration Hub  actions and flows.

IHUB Spoke Util Pack (com.snc.ihub_spoke_util_pack)

Enables utility or global scripts that can be invoked from the Integration Spokes.

Agent-Initiated Messaging Interface (sn_agent_initiated)

Provides configurations for the agent-initiated messaging capabilities.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the Conversational Integration with LINE  application (sn_va_line) using the filter criteria 
and search bar.

You can search for the application by its name or ID. If you cannot find the application, you 
might have to request it from the ServiceNow Store.

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released 
apps, see the ServiceNow Store  version history release notes .

3. In the Application installation dialog box, review the application dependencies.

Dependent plugins and applications are listed if they will be installed, are currently installed, or 
need to be installed. If any plugins or applications need to be installed, you must install them 
before you can install Conversational Integration with LINE.

4. Optional:  If demo data is available and you want to install it, select the Load demo data  check 
box.
Demo data comprises the sample records that describe application features for the common 
use cases. Load the demo data when you first install the application on a development or test 
instance.

Important: 
If you don't load the demo data during installation, it's unavailable to load later.

5. Select Install.

Set up Conversational Integration with LINE

Set up the Conversational Integration with LINE  application so that you can engage customers in 
conversations with bots.

Before you begin
Before you begin, do the following:

• Get ServiceNow  entitlements for the following products and applications:

◦ Integration Hub

◦ Conversational Integration with LINE

For more information, see Get entitlement for a ServiceNow  product or application .
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• Install the following applications on your ServiceNow  instance:

◦ Integration Hub

◦ Conversational Integration with LINE

• Activate the IHUB Spoke Util Pack plugin (com.snc.ihub_spoke_util_pack). For more 
information, see Activate a plugin .

• Get a developer account in the LINE Developers console .

Role required: external_app_install_admin or va_admin

About this task
The LINE  messaging app supports only one LINE  channel for a ServiceNow  instance. If you would 
like to configure a different LINE  channel for your ServiceNow  instance, you must first remove the 
previously configured LINE  channel, and then set up the new channel.

Procedure

1. Connect your company's LINE  account with your ServiceNow  instance.

a. Log in to your LINE Developers Console .

b. Create a channel on the LINE Developers Console.

c. Take note of the channel secret and the channel access token.
You will use later use this information for authenticating the LINE  account on your 
ServiceNow  instance.

d. To enable your LINE  account to send data to your ServiceNow  instance, enter the webhook 
URL and click Verify
You specify the webhook URL in the Webhook URL  field on the Messaging API tab of the 
LINE Developers Console. Use the following format for the URL: https://<instance-
name>.service-now.com/api/sn_va_line/va_adapter_line.

2. On your ServiceNow®  instance, go to All  > Conversational Interfaces  > Channels and 
Integrations.

3. On the LINE  integration section, click Manage.
The Line Channel integration page opens.

4. Click the three dots on the right hand side and choose Edit Integration.

5. On the form, update the name of the bot if desired.

6. Enter the channel secret and the access token from your LINE  account.

7. Click Submit.
A success message displays confirming the integration with the LINE  app.

Capturing information from a user in a LINE  chat conversation

Use the collection of input controls provided by the Virtual Agent Designer  to prompt and capture 
information from the user in a LINE  chat conversation.

Virtual Agent Designer is a diagram tool for creating and managing topics, which are blueprints 
for conversations between a virtual agent and user. For more information, see Using Virtual Agent 
Designer.
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User notification consent

Users must opt in to receive notifications. No notifications can be delivered until the user grants 
consent.

There are two ways for users to grant consent to receive notifications:

• The user can enter Notification  into the LINE  chat with your business. The user gets a 
bot response with the option to subscribe or unsubscribe from receiving notifications for your 
business on LINE.

• As an administrator, you can set up the option for users to subscribe or unsubscribe from 
notifications from your portal. See Configure system settings  for more information.

User input controls

The Conversational Integration with LINE  application supports the following user input controls in 
Virtual Agent Designer.

Supported user input controls

User input control Description

Text User enters a plain text string in the conversation.

The maximum character limit is 5000 characters.

Static Choice User selects an item from a predefined list.

In a quick reply, the label has the maximum character limit of 20 
characters. At a time, a user can view only 13 quick replies. If there 
are more than 13 quick replies, the pagination format is used to view 
more options. The default value of the maximum number of replies 
for a page is set in the sn_va_line.max.picker.choices 
system property. The property is located in the System Property 
[sys_properties] table.

Boolean User enters a Boolean response to the bot. For example, the user can 
reply Yes  or No  in a chat conversation.

File Picker User sends a file to the bot.

The supported file types are JPG, PNG, BMP, and MP4. Files have a 
maximum size limit based on file type:

• For images, the maximum size limit is 10 MB.

• For videos, the maximum size limit is 200 MB.

Date Time User selects a calendar date, time (hours and minutes), or both.

Carousel User selects a single item from the carousel.

In a carousel, the title for an image has a maximum limit of 
40 characters and the text for the image has a maximum 
character limit of 60 characters. At a time, a user can view only 
10 images. If there are more than 10 images, the pagination 
format is used to view more options. The default value of the 
maximum number of images in the carousel for a page is set in the 
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Supported user input controls  (continued)

User input control Description

sn_va_line.max.carousel.cards  system property. The 
property is located in the System Property [sys_properties] table.

For more information about configuring user input controls, see Virtual Agent Designer user input 
controls.

The Conversational Integration with LINE  application supports the following bot responses in 
Virtual Agent Designer.

Supported bot responses

Bot response Description

Text Bot sends a plain text string to the user.

Image Bot sends an image to the user.

Link Bot sends a web link to the user.

Web UI image card 
output

Bot sends content from a record in a compact format, including an 
image with text.

Table Bot response is displayed as a table.

For more information about configuring bot responses, see Virtual Agent Designer bot 
responses.

Closing idle LINE  chat conversations

Enable agents to effectively manage their active LINE  chat conversations by automatically 
closing conversations after they have been inactive for a pre-configured amount of time.

The Virtual Agent  conversations are configured for the LINE  messaging app. By default, any 
conversations abandoned by requesters remain open or idle until they are automatically closed 
daily by the Time Out Abandoned VA Conversations  scheduled job. For more 
information, see Closing Virtual Agent and Agent Chat conversations.

As an administrator, you can change the default timeout period for idle Virtual 
Agent  conversations configured for the LINE  messaging app by setting the 
com.glide.cs.line_idle_timeout  system property to the number of seconds 
that abandoned conversations remain open after the requester's last response. The system 
property value must be less than the time interval set for the Time Out Abandoned VA 
Conversations  scheduled job, set to two hours (7200 seconds) by default. Because the 
com.glide.cs.line_idle_timeout  system property isn't available by default, you must 
add it with the data type set to integer. For more information, see Add a system property .

Transfer LINE  chat conversations to live agents

Configure the Advanced Work Assignment  application to transfer a LINE  chat conversation 
initiated by a requester (customer contact or consumer) to a live agent.

Before you begin
Your administrator must have completed the following tasks:

• Activate Advanced Work Assignment.

• Install Conversational Integration with LINE.
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• Set the application scope to Conversational Integration with LINE  using the application picker. 
For more information, see Application picker .

• Activate the Conversational Messaging plugin (com.glide.messaging.awa). For more 
information, see Activate Conversational Messaging.

Role required: admin

About this task

Procedure

1. Enable the Line service channel.

a. Navigate to Advanced Work Assignment  > Settings  > Service Channels.

b. In the Name  column of the Queues list, search for Line.

c. Click Line.

d. On the Service Channel form, select the Active  check box.

e. Click Update.
For more information, see Service channels.

2. Automatically route work items for LINE  chat conversations to agents by configuring the queue 
for the Line service channel.

a. Navigate to Advanced Work Assignment  > Settings  > Queues.

b. In the Name  column of the Queues list, search for Agent Line Queue.

c. Click Agent Line Queue.

d. On the Queue form, select the Active  check box.

e. Click Update.

Note: 
By default, the Line - Most Capacity  assignment rule is associated with the 
Agent Line Queue. You can create another assignment rule and associate it with the 
queue. For more information, see Configure agent assignment rules  and Work item 
queues.

3. Configure agent presence states for the Line service channel.

a. Navigate to Advanced Work Assignment  > Settings  > Presence States.

b. In the Name  column of the Presence States list, click an existing state.

c. On the Presence State form, in the Service channels section, click the add icon (>) to move 
the Line  service channel from the Available  column to the Selected  column.

d. In the Apply to groups section of the Presence State form, click the add icon (>) to move the 
Agent Line Group  group from the Available  column to the Selected  column.

Note: 
You can ignore this step if you have selected the Apply to all groups  check box.

e. Click Update.

For more information, see Configure agent presence states.
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Using Conversational Integration with LINE

Enable a requester to converse with an agent using the LINE  chat conversations.

An administrator can configure the Conversational Integration with LINE  application for 
integrating the LINE  messaging app with a ServiceNow  application. For more information, see 
Integrating the LINE messaging app with other applications.

The following options are available:

• An administrator can configure system-initiated messages to be delivered as LINE  chat 
conversations.

• A live agent can initiate LINE  chat conversations with a requester.

• A requester can initiate LINE  chat conversations with a virtual agent or live agent.

• A live agent can accept LINE  chat conversations as work items from their Agent Workspace 
Inbox to converse with a requester.

Initiating LINE  chat conversations

As a live agent, you can initiate LINE  chat conversations with a requester in two ways:

• Send a message from either an active interaction record, a contact record, or a consumer 
contact record. See .

• Set up notifications to be sent to the requester when a business event occurs or when a record 
is updated. See Create a provider notification.

Note: 
The requester must subscribe and opt in to receive notifications.

Accepting LINE  chat conversations

As a live agent interacting with a requester over the LINE  service channel, you can do the 
following:

• Converse with the requester through text messages.

• Share a knowledge article displayed as a link to the requester.

• Share a record, for example, a customer service case.

• Share any URLs as links.

• Share any files as attachments.

Note: 
If an administrator has configured the Line service channel for transfer of chat 
conversations, then you can accept a work item from the LINE  chat conversation in your 
Agent Workspace Inbox. For more information, see Transfer LINE chat conversations to live 
agents  and Service channels.

Integrating the LINE  messaging app with other applications

Other ServiceNow  applications and features can use the Conversational Integration with LINE 
application.

As an administrator, you can use the Conversational Integration with LINE  application to integrate 
the LINE  messaging app with other ServiceNow  applications. You can enable requesters and 
agents to converse with an agent using the LINE  messaging app.
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Integrating with Customer Service Management

Integrate the Conversational Integration with LINE  application with the ServiceNow®  Customer 
Service Management  application to enable your customer contacts and consumers to initiate 
a LINE  chat conversation with a virtual agent or live agent. An agent can initiate a conversation, 
or accept a conversation initiated from a LINE  chat conversation. For more information, see 
Integrate LINE with Customer Service Management .

Remove Conversational Integration with LINE

Users can remove the Conversational Integration with LINE  application when the app is no longer 
needed.

Before you begin
Role required: admin

Procedure

1. Go to All  > Conversational Interfaces  > Channels and Integrations.

2. On the LINE  integration section, click Manage.
The Line Channel integration page opens.

3. Click the three dots on the right hand side and choose Remove Integration.
A confirmation message displays.

4. Click Remove.
The Facebook Messenger  application and all of its data is removed.

Conversational Integration with Facebook Messenger

Engage with requesters including customer contacts and consumers who prefer the Facebook 
Messenger  app to chat with an agent.

As of July 31, 2025, Conversational Integration with Facebook Messenger  is being prepared for 
future deprecation. It will be hidden and no longer installed on new instances but will continue to 
be supported. For details, see the Deprecation Process [KB0867184]  article in the Now Support 
Knowledge Base.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Overview

Enable your users to initiate a Facebook Messenger  chat conversation with a virtual agent by 
using the Conversational Integration with Facebook Messenger  application. The application 
connects a requester with a virtual agent or live agent using your company's Facebook 
Messenger  account. To get started with the Conversational Integration with Facebook 
Messenger  application, see Configure Conversational Integration with Facebook Messenger.

Notice regarding use by customers

Customers are solely responsible for the implementation of the Conversational Integration with Facebook Messenger  application. The use of this application in 

a Facebook  app requires a review of the app by the Facebook  Developer Support team. It is the responsibility of customers to complete this app review process. 

The following links from the Facebook  site provide guidance on how to complete the app review process:
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1. Facebook  Platform Policy Overview: https://developers.facebook.com/docs/messenger-platform/policy/policy-overview

2. Facebook  Pre-Launch Checklist: https://developers.facebook.com/docs/messenger-platform/prelaunch-checklist

3. Facebook  review and submission process for applications: https://developers.facebook.com/docs/messenger-platform/ review---submission-process

Configure Conversational Integration with Facebook Messenger

Install and set up the Conversational Integration with Facebook Messenger  application to enable 
your users to interact with virtual and live agents.

Before you begin
Role required: admin

About this task
This task provides the general steps to integrate the Facebook Messenger  messaging app 
with a ServiceNow  application using the Conversational Integration with Facebook Messenger 
application.

Procedure

1. Install Conversational Integration with Facebook Messenger.

2. Set up Conversational Integration with Facebook Messenger.

3. Design virtual agent topics to capture information from a Facebook Messenger  chat 
conversation.

4. Optional:  Close idle Facebook Messenger  chat conversations.

5. Optional:  Transfer Facebook Messenger chat conversations to live agents.

Install Conversational Integration with Facebook Messenger

You can install the Conversational Integration with Facebook Messenger  application 
(sn_va_fb_messenger) if you have the admin role. The application includes demo data and 
installs related ServiceNow®  Store  applications and plugins if they are not already installed.

Before you begin

• Ensure that the application and all of its associated ServiceNow Store  applications have valid 
ServiceNow  entitlements. For more information, see Get entitlement for a ServiceNow  product 
or application .

Role required: admin

About this task
The following applications or plugins are installed with Conversational Integration with Facebook 
Messenger:

Conversational Custom Chat Integration (com.glide.cs.custom.adapter)

Provides custom chat integration framework of scriptable APIs to enable the Virtual 
Agent  application on any conversational interface.

For more information on this plugin, see Conversational custom chat integrations.

ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)

Enables execution of Integration Hub  actions and flows.
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Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the Conversational Integration with Facebook Messenger  application 
(sn_va_fb_messenger) using the filter criteria and search bar.

You can search for the application by its name or ID. If you cannot find the application, you 
might have to request it from the ServiceNow Store.

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released 
apps, see the ServiceNow Store  version history release notes .

3. In the Application installation dialog box, review the application dependencies.

Dependent plugins and applications are listed if they will be installed, are currently installed, or 
need to be installed. If any plugins or applications need to be installed, you must install them 
before you can install Conversational Integration with Facebook Messenger.

4. Optional:  If demo data is available and you want to install it, select the Load demo data  check 
box.
Demo data comprises the sample records that describe application features for the common 
use cases. Load the demo data when you first install the application on a development or test 
instance.

Important: 
If you don't load the demo data during installation, it's unavailable to load later.

5. Select Install.

Set up Conversational Integration with Facebook Messenger

Integrate Facebook Messenger  with your ServiceNow  instance using the Conversational 
Integration with Facebook Messenger  application. Use the application to engage customers in 
conversations with bots.

Before you begin

• Get ServiceNow  entitlements for the following products and applications:

◦ Integration Hub

◦ Conversational Integration with Facebook Messenger

For more information, see Get entitlement for a ServiceNow  product or application .

• Install the following applications on your ServiceNow  instance:

◦ Integration Hub

◦ Conversational Integration with Facebook Messenger

• Complete Facebook Messenger  settings.

1. Set up a Facebook  developer account .

2. Create a Facebook  app .

3. Review the Messenger Platform Policy  and Pre-Launch Checklist  prior to submission.

4. Submit the app for review .
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5. Create a Facebook  page within the Facebook  app you created earlier .

6. Enable Facebook Messenger .

Role required: external_app_install_admin or va_admin

Procedure

1. Connect your company's Facebook Messenger  service with your ServiceNow  instance.

a. Log in to your Facebook  developer account  and open the Facebook  app you created.

b. Enable your Facebook  app to send data to your ServiceNow  instance by entering the 
webhook URL.

i. Click Add Callback URL  in the Webhooks section of the app.

ii. In the Edit Callback URL dialog box, fill in the fields.

Field Description

Callback 
URL

Public URL for webhook.

Enter the webhook URL in the following format:

https://<instance-name>.service-now.com/api/now/
v1/cs/adapter/messenger/message

Token Token for webhook.

By default, the token for ServiceNow  webhook is 
nowbot. As a user with the admin role, you can set the 
glide.cs.facebook_messenger_verify_token  system property 
to a desired value and then enter that value in this field. Because the 
glide.cs.facebook_messenger_verify_token  system property 
isn't available by default, you must add it with the data type set to string. For 
more information, see Add a system property .

iii. Click Verify and Save.

c. Make a note of your Facebook  page ID and access token.

i. Click Add or Remove Pages  and select your Facebook  page.

ii. Make a note of the page ID displayed below the page name.

You can click the page ID to copy the ID to your clipboard.

iii. In the Access Tokens section, click Generate Token  for the Facebook  page you created.

Note: 
Make note of the page access token used later for authenticating the Facebook 
Messenger  on your ServiceNow  instance.

d. Subscribe your Facebook  app to your Facebook  page.
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i. In the Webhooks section, click Add Subscriptions.

For each authorized Page, the Webhooks section contains the fields the app can 
subscribe to.

ii. In the Edit Page Subscriptions dialog box, select messages  and messaging_postbacks.

iii. Click Save.

e. Make a note of the App secret from Basic Settings .

f. Optional:  Send messages with timestamp in the customer's time zone by navigating to Page 
settings  > Advanced messaging, selecting the Time zone  option in the Requested Features 
section, and clicking Request  displayed next to the selected option.

2. On your ServiceNow®  instance, go to All  > Conversational Interfaces  > Channels and 
Integrations.

3. On the Facebook Messenger  integration section, click Add.
The Facebook Messenger  Channel integration page opens.

4. Click the three dots on the right hand side and choose Edit Integration.

5. On the form, update the name of the bot if desired.

6. Enter the callback URL and the token from your Facebook Messenger  account.

7. Click Submit.
A success message displays confirming the integration with the Facebook Messenger  app.

Capturing information from a user in a Facebook Messenger  chat conversation

Use the collection of input controls provided by the Virtual Agent Designer  to prompt and capture 
information from the user in a Facebook Messenger  chat conversation.

Virtual Agent Designer is a diagram tool for creating and managing topics, which are blueprints 
for conversations between a virtual agent and user. For more information, see Getting started 
with Virtual Agent Designer.

The Conversational Integration with Facebook Messenger  application supports the following 
user input controls in Virtual Agent Designer.

Supported user input controls

User input control Description

Text User enters a plain text string in the conversation.

The maximum character limit is 5000 characters.

Static Choice User selects an item from a predefined choice list.

In a quick reply, the label has the maximum character limit of 20 
characters. At a time, a user can view only 13 quick replies. If there are 
more than 13 quick replies, the pagination format is used to view more 
options. The default value of the maximum number of replies for a 
page is set in the sn_va_fb_messenger.max_quick_replies 
system property (location: System Property [sys_properties] table).
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Supported user input controls  (continued)

User input control Description

Boolean User enters a Boolean response to the bot. For example, the user can 
reply Yes  or No  in a chat conversation.

File Picker User sends a file to the bot.

The supported file types are JPG, PNG, BMP, and MP4.

Note the following points about the maximum size limit for a file type:

• For images, the maximum size limit is 10 MB.

• For videos, the maximum size limit is 200 MB.

Date Time User selects a calendar date, time (hours and minutes), or both.

Note: 
If your administrator has set the option to request time zone 
from the customer, the selected date and time reflect customer's 
time zone. Else, they appear in the UTC time zone. For more 
information about the time zone setting, see 1.f.

Carousel User selects a single item from the carousel.

In a carousel, the title for an image has maximum limit of 40 
characters and the text for the image has maximum character 
limit of 60 characters. At a time, a user can view only 10 
images. If there are more than 10 images, the pagination 
format is used to view more options. The default value of the 
maximum number of images in a carousel for a page is set in the 
sn_va_fb_messenger.max_carousel_cards  system 
property (location: System Property [sys_properties] table).

For more information about configuring user input controls, see Virtual Agent Designer user input 
controls.

The Conversational Integration with Facebook Messenger  application supports the following bot 
responses in Virtual Agent Designer.

Supported bot responses

Bot response Description

Text Bot sends a plain text string to the user.

Image Bot sends an image to the user.

Link Bot sends a web link to the user.

Note: 
The web link appears as a URL button  in the conversation.

Card Bot sends selected information from a record on your instance.
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Note: 
You can also return search results as bot responses in Facebook Messenger  chat 
conversations when there are no relevant topics to display to end users. For more 
information, see Improving the user experience with AI Search.

For more information about configuring bot responses, see Virtual Agent Designer bot 
responses.

Closing idle Facebook Messenger  chat conversations

Enable agents to effectively manage their active Facebook Messenger  chat conversations by 
automatically closing conversations after they have been inactive for a pre-configured amount of 
time.

The Virtual Agent  conversations are configured for the Facebook Messenger  app. By default, 
any conversations abandoned by requesters remain open or idle until they are automatically 
closed daily by the Time Out Abandoned VA Conversations  scheduled job. For more 
information, see Closing Virtual Agent and Agent Chat conversations.

As an administrator, you can change the default timeout period for idle Virtual 
Agent  conversations configured for the Facebook Messenger  app by setting the 
com.glide.cs.facebook_messenger_idle_timeout  system property to the number 
of seconds that abandoned conversations remain open after the requester's last response. The 
system property value must be less than the time interval set for the Time Out Abandoned 
VA Conversations  scheduled job, set to two hours (7200 seconds) by default. Because the 
com.glide.cs.facebook_messenger_idle_timeout  system property isn't available 
by default, you must add it with the data type set to integer. For more information, see Add a 
system property .

Transfer Facebook Messenger  chat conversations to live agents

Configure the Advanced Work Assignment  application to transfer a Facebook Messenger  chat 
conversation initiated by a requester (customer contact or consumer) to a live agent.

Before you begin
Your administrator must have completed the following tasks:

• Activate Advanced Work Assignment.

• Install Conversational Integration with Facebook Messenger.

• Set the application scope to Conversational Integration with Facebook Messenger  using the 
application picker. For more information, see Application picker .

• Activate the Conversational Messaging plugin (com.glide.messaging.awa). For more 
information, see Activate Conversational Messaging.

Role required: admin

About this task

Procedure

1. Enable the Facebook Messenger service channel.

a. Navigate to Advanced Work Assignment  > Settings  > Service Channels.

b. In the Name  column of the Queues list, search for Line.

c. Click Facebook Messenger.

d. On the Service Channel form, select the Active  check box.

e. Click Update.
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For more information, see Service channels.

2. Automatically route work items for Facebook Messenger  chat conversations to agents by 
configuring the queue for the Facebook Messenger service channel.

a. Navigate to Advanced Work Assignment  > Settings  > Queues.

b. In the Name  column of the Queues list, search for Agent Facebook Messenger 
Queue.

c. Click Agent Facebook Messenger Queue.

d. On the Queue form, select the Active  check box.

e. Click Update.

Note: 
By default, the Facebook Messenger - Most Capacity  assignment rule 
is associated with the Agent Facebook Messenger Queue. You can create another 
assignment rule and associate it with the queue. For more information, see Configure 
agent assignment rules  and Work item queues.

3. Configure agent presence states for the Facebook Messenger service channel.

a. Navigate to Advanced Work Assignment  > Settings  > Presence States.

b. In the Name  column of the Presence States list, click an existing state.

c. On the Presence State form, in the Service channels section, click the add icon (>) to move 
the Facebook Messenger  service channel from the Available  column to the Selected 
column.

d. In the Apply to groups section of the Presence State form, click the add icon (>) to move 
the Agent Facebook Messenger Group  group from the Available  column to the Selected 
column.

Note: 
You can ignore this step if you have selected the Apply to all groups  check box.

e. Click Update.

For more information, see Configure agent presence states.

Using Conversational Integration with Facebook Messenger

Enable a requester to converse with an agent using the Facebook Messenger  chat 
conversations.

An administrator can configure the Conversational Integration with Facebook Messenger 
application for integrating the Facebook Messenger  app with a ServiceNow  application. For more 
information, see Integrating the LINE messaging app with other applications.

A requester can initiate Facebook Messenger  chat conversations with a virtual agent or live 
agent.

A live agent can accept Facebook Messenger  chat conversations as work items from their Agent 
Workspace Inbox to converse with a requester.
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Accepting Facebook Messenger  chat conversations

As a live agent interacting with a requester over the Facebook Messenger service channel, you 
can:

• Converse with the requester through text messages.

• Share a knowledge article displayed as a link to the requester.

• Share a record, for example, a customer service case.

• Share any URLs as links.

• Share any files as attachments.

Note: 
You accept a work item from the Facebook Messenger  chat conversation in your Agent 
Workspace Inbox when an administrator has configured the Facebook Messenger service 
channel for transfer of chat conversations. For more information, see Transfer Facebook 
Messenger chat conversations to live agents  and Service channels.

Integrating the Facebook Messenger  messaging app with other applications

Review this topic to see which ServiceNow  applications and features can use the Conversational 
Integration with Facebook Messenger  application.

As an administrator, you can use the Conversational Integration with Facebook Messenger 
application to integrate the Facebook Messenger  messaging app with other ServiceNow 
applications and enable requesters to converse with agents using the Facebook Messenger 
messaging app.

Integrating with Customer Service Management

Integrate the Conversational Integration with Facebook Messenger  application with the 
ServiceNow®  Customer Service Management  application to enable your customer contacts and 
consumers to initiate a Facebook Messenger  chat conversation with a virtual agent or live agent. 
For more information, see Integrate Facebook Messenger  with Customer Service Management .

Set up the Virtual Agent  integration with Facebook Messenger  (Legacy)

Configure the Virtual Agent  integration for Facebook Messenger  and associate the app with your 
instance.

Before you begin
You should already have the following:

• Facebook page (see https://www.facebook.com/pages/creation/  for more information)

• Facebook developer account (see https://developers.facebook.com/  for more information)

• Facebook app (see https://developers.facebook.com/quickstarts  for more information, make 
note of the app secret that is generated)

Roles required:

• virtual_agent_admin and external_app_install_admin or admin

• Administrator for third-party applications
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Procedure

1. In Facebook developer, navigate to Messenger  > Settings.

a. Locate the Token Generation section.

b. From the page list, select the Facebook page you created and make note of the Page Access 
Token that is generated.

c. Locate the Webhooks section and click Setup Webhooks.

d. On the New Page Subscription pop-up window that displays, enter these fields:

Field Value

Callback URL Your ServiceNow  instance URL followed 
by /api/now/v1/cs/adapter/
messenger/message

Verify Token nowbot

Subscription Fields Select messages  and 
messaging_postbacks

e. Click Verify and Save.

2. In your ServiceNow  instance, enter hash_message_verification.list  in the Filter 
navigator.

a. In the Hash Message Verifications form, click New  to create a new record.

b. Enter these fields:

Field Value

Name Name that helps to identify this record. 
This field may default to sample-fb-
messenger-inbound-app-token  but 
this default can be changed.

Description Description for the record

Secret App secret of your Facebook Messenger 
app (the secret was generated when you 
created the app)

c. Click Submit.

3. In your ServiceNow  instance, enter token_verification.list  in the Filter navigator.

a. In the Token Verifications form, click New  to create a new record.

b. Enter these fields:
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Field Value

Name Name that helps to identify this record. 
This field may default to sample-fb-
messenger-outbound-app-token 
but this default can be changed.

Description Description for the record

Token Page access token of your Facebook 
Messenger  app (from step 1b of this 
procedure)

c. Click Submit.

4. In your ServiceNow  instance, enter message_auth.list  in the Filter navigator.

a. In the Message Auth page, click New  to create a new record.

b. Enter these fields:

Field Value

Name Name that helps to identify this record. 
This field may default to sample-fb-
messenger-app  but this default can be 
changed.

Provider Name of the provider

Inbound message verification Name specified on the Hash Message 
Verifications form (this token verifies if the 
request is actually from the provider)

Outbound message creation Name specified on the Token Verification 
form (this token interacts with the provider 
on behalf of the user)

c. Click Submit.

5. In your ServiceNow  instance, enter 
sys_cs_adapter_configuration_page_messenger.list  in the Filter navigator.

a. In the Facebook Messenger Adapter Configuration Page, click New  to create a new record.

b. Enter these fields:

Field Value

App Type Defaults to Facebook Messenger and 
cannot be changed

Messenger Page ID Your page ID (the page ID can be found in 
the URL of the Facebook page)
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Field Value

Name Name that helps to identify this record. 
This field may default to sample-fb-
messenger-app  but this default can be 
changed.

Provider Auth Name specified on the Message Auth page

6. Click Submit.

7. Configure whether users should be prompted to link their profile to their ServiceNow  profile.

a. In the Navigation filter, enter sys_properties.list.

b. Navigate to and click va.messenger.account.auth.

c. In the Value  field, enter true  or false.

true Prompt users to link their account to their ServiceNow  profile. Users who 
link their account to their ServiceNow  profile can access all topics and 
also chat with a live agent. Users who do not link their account can access 
only guest topics.

false Do not prompt users to link their account to their ServiceNow  profile. 
Users can access only guest topics but can still chat with a live agent.

d. Click Update.

Configure the help link for the Virtual Agent  Facebook Messenger  integration (Legacy)

Use the va.messenger.help.url  system property to create the link that opens a web 
help page when requesters use the Help  command in the Virtual Agent Facebook Messenger 
integration.

Before you begin

• Determine the web page that provides the help content that your Facebook Messenger  users 
need.

• Role required: virtual_agent_admin or admin

Procedure

1. Set the application scope to Global.

2. In the Navigation filter, enter sys_properties.list.

3. Click New.

4. Complete the following:

a. In the Name  field, enter the system property name: va.messenger.help.url.

b. In the Description  field, enter a brief explanation of this property.

c. In the Value  field, enter the URL of the website page that the link opens.

d. Click Submit.
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Result
When your Facebook Messenger  users type help, they are directed to the URL of the website 
specified in the va.messenger.help.url  property.

Remove Conversational Integration with Facebook Messenger

Users can remove the Conversational Integration with Facebook Messenger  application when 
the app is no longer needed.

Before you begin
Role required: admin

Procedure

1. Go to All  > Conversational Interfaces  > Channels and Integrations.

2. On the Facebook Messenger  integration section, click Manage.
The Facebook Messenger  Channel integration page opens.

3. Click the three dots on the right hand side and choose Remove Integration.
A confirmation message displays.

4. Click Remove.
The Facebook Messenger  application and all of its data is removed.

Conversational Integration with Apple Messages for Business

The Conversational Integration with Apple Messages for Business  application allows customers 
to engage with your business using their Apple  devices. Conversational Integration with Apple 
Messages for Business  provides rich messaging capabilities such as Apple  pay, forms, time 
picker, and authentication.

Overview

Enable requesters to interact in a Apple Messages for Business  chat with a virtual agent or live 
agent using the ServiceNow®  Conversational Integration with Apple Messages for Business 
application. The application connects a requester with a virtual agent or live agent using your 
company's Apple Messages for Business  account. To get started with the Conversational 
Integration with Apple Messages for Business  application, see Install Conversational Integration 
with Apple Messages for Business.

Apple Messages for Business  entry points

Customers can start a conversation with an agent from a variety of entry points. From each of 
these entry points, customers can launch the Apple  messages app and compose a message. 
You can add custom buttons to a website, app, or social media page, so that customers can start 
a conversation with a Virtual Agent  or live agent. For a full overview of the options available, see 
the Apple  documentation .
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Apple  message example

• iMessage

• Apple  Maps

• Apple  Pay

• Search

• Apple  apps

• QR codes

• Social media

Apple Messages for Business  interactive features

Apple Messages for Business  includes a set of interactive features such as list picker, time 
picker, authentication, and Apple  pay.
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Interactive features

Feature Description

Rich links Adds a picture or video preview to a URL

Quick replies The user can make an inline choice with a single tap. This 
includes responses like star ratings or thumbs up or down.

List pickers Gives the user a list of options to choose from. For example, a 
travel site can show flights, accommodations, car rentals, and 
bookings.

Time pickers
Provides time slots for users to choose for appointments, 
deliveries, and services.

To use time pickers, you must have Conversational Appointment 
Booking  installed.

Apple  Pay
Send Apple  Pay requests over Messages.

For more information on setting up Apple  Pay, refer to the Apple 
documentation .

Authentication Apple Messages for Business  supports OAuth2 protocol to 
integrate sign-in authentication to the Messages app.

iMessage App Users can interact with your business directly from the Messages 
app on their iPhone, where they are accustomed to messaging 
their contacts.

Image sharing Users or live and virtual agents can send photos during a chat.

Video sharing Users or live or virtual agents can send videos during a chat.

Document attachments Users or live or virtual agents can send PDF documents during a 
chat.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Configure Conversational Integration with Apple Messages for Business

Install and set up the Conversational Integration with Apple Messages for Business  application 
to enable requesters to interact with virtual and live agents.

This task provides the general steps to integrate Apple Messages for Business  with your 
ServiceNow  instance using the Conversational Integration with Apple Messages for Business 
application.

1. Install Conversational Integration with Apple Messages for Business.

2. Set up the integration on Apple Messages for Business.

3. Capturing information from a user in a Apple Messages for Business chat conversation.

4. Enable authentication with your Identity Provider (IdP) by configuring the OAuth setup for 
Apple Messages for Business
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5. Enable Apple  Pay on Apple Messages for Business  interactions.

◦ Refer to the Apple  documentation  for details about configuring your Apple  merchant 
account.

◦ Refer to Complete the Payment Provider Configuration  to to connect your payment provider 
information to your ServiceNow®  instance.

Install Conversational Integration with Apple Messages for Business

Install the Conversational Integration with Apple Messages for Business  so that your business 
can interact with requesters on the Apple Messages for Business  app. The application installs 
related ServiceNow Store  applications and plugins if they are not already installed.

Before you begin

• Review the Conversational Integration with Apple Messages for Business  application 
listing in the ServiceNow Store  for information on dependencies, licensing or subscription 
requirements, and release compatibility.

• Create an Apple Messages for Business  account at Apple  Business Register .

Role required: admin

About this task
The following applications or plugins are installed with Conversational Integration with Apple 
Messages for Business:

Conversational Custom Chat Integration (com.glide.cs.custom.adapter)

Provides custom chat integration framework of scriptable APIs to enable the Virtual 
Agent  application on any conversational interface.

For more information on this plugin, see Conversational custom chat integrations.

ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)

Enables execution of Integration Hub  actions and flows.

IHUB Spoke Util Pack (com.snc.ihub_spoke_util_pack)

Enables utility or global scripts that can be invoked from the Integration Spokes.

Conversational Messaging (com.glide.messaging.awa)

Enables messaging actions that are performed when an event occurs.

The following applications and plugins are not installed with Conversational Integration with 
Apple Messages for Business, but are required in order to use specific features.

Conversational Appointment Booking (sn_va_appt_schedul)

Book, reschedule, and cancel appointments from Virtual Agent conversations. This 
application is required in order to use the time picker feature in Apple Messages for 
Business.

Payment framework for conversational channels (sn_va_payment_ctrl)

Enables the payment framework custom control for live agent and virtual agent 
conversations in Apple Messages for Business.

Procedure

1. Make sure that your Apple Messages for Business  account is set up and active.
See the Apple  documentation  for more information.
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2. Navigate to All  > System Applications  > All Available Applications  > All.

3. Find the Conversational Integration with Apple Messages for Business  application 
(sn.va.abc.adapter) using the filter criteria and search bar.

You can search for the application by its name or ID. If you cannot find the application, you 
might have to request it from the ServiceNow Store.

In the list next to the Install  button, the versions that are available to you are displayed.

4. Select a version from the list and select Install.

In the Install dialog box that is displayed, any dependencies that are installed along with your 
application are listed.

5. If you're prompted, follow the links to the ServiceNow Store  to get any additional entitlements 
for dependencies.

6. Optional:  If demo data is available and you want to install it, select the Load demo data  check 
box.
Demo data comprises the sample records that describe application features for the common 
use cases. Load the demo data when you first install the application on a development or test 
instance.

Important: 
If you don't load the demo data during installation, it's unavailable to load later.

7. Select Install.

Set up the integration on Apple Messages for Business

To integrate Apple Messages for Business  with your ServiceNow®  instance, you need to set up 
your Apple Messages for Business  account, and then link your Apple Messages for Business 
messaging service provider account to your ServiceNow®  instance.

Before you begin

• Role required: admin

• If your business doesn't already have an Apple  ID, create one. Make sure to use the 
ServiceNow®  Messaging Service Provider (MSP).

Note: 
For more information about creating a business Apple  ID, refer to the Apple 
documentation .

• Create a Apple Messages for Business  account.

Procedure

1. Go to Apple Messages for Business  (register.apple.com).

2. Click Messages for Business Accounts  to go to your business account.

3. Click Test your Messaging Service Provider connection, and Connect.
You are redirected to your Now Support  portal. Log in if necessary.

4. On your Now Support  portal, complete the connection of your Apple Messages for Business 
account with your ServiceNow  instance.
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a. Use the dropdown to select the instance that you want to connect to your Apple Messages 
for Business  account.
Ensure that the instance has the Conversational Integration with Apple Messages for 
Business  application installed.

b. If the connection is successful, the message "Your request on the instance <instance name> 
is successfully submitted" displays.
If the connection is not successful, you are redirected to the landing page on Now Support. 
Try again by repeating the connection steps.

5. Once the connection is complete, click Go to instance  to go to your customer instance and log 
in if necessary.

6. On the Apple Messages for Business  account page, enter the Provider Application name.
This should be a name that will help you identify this connection on your instance.

7. Click Complete installation.
If the installation was successful, you are redirected to the instance homepage and the 
following message displays: “Bot registration successful. View the provider record here.”

What to do next
If you want to integrate your Identity Provider (IdP), go to: OAuth setup for Apple Messages for 
Business.

OAuth setup for Apple Messages for Business

Integrate your Identity Provider (IdP) with Apple Messages for Business  using OAuth2 
authentication.

Connect Apple Messages for Business  to your ServiceNow®  instance

Complete the following steps on the Apple Messages for Business  site to connect your Apple 
Messages for Business  account to your ServiceNow®  instance.

1. Go to the Apple Messages for Business  page (register.apple.com) and log in to your Messages 
for Business account.

2. Go to the Integrated OAuth2 Authentication  section.

3. Add the Authorization URL from your Identity Provider (IdP) to the OAuth URL  field.

4. Add the Token URL from your IdP to the Token URL  field.

5. Add the Client ID from your IdP to the Client Identifier  field.

6. Refer to the Apple  documentation  for further instructions on configuring OAuth2 
authentication on your Apple Messages for Business  account.

Set up OAuth on your ServiceNow®  instance

1. Go to your ServiceNow®  instance to set up OAuth.

2. Create a new record in the Application Registries (oauth_entity) table using these instructions: 
Use a third-party OAuth provider .

◦ Use the grant type Authorization code.

◦ Add the Token URL.

3. Create a new record in the OAuth Entity Scopes (oauth_entity_scope) table using these 
instructions: Specify an OAuth scope . If you have multiple scopes, then add a new record for 
each scope, and create a corresponding Entity Profile Scope record for each scope.
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4. Create a new record in the Connection and Credential Aliases (sys_alias) table using these 
instructions: Create a Connection & Credential alias . This connection alias is used for 
fetching the http connection record which you create in the next step.

5. Create a new record in the HTTP(s) Connection (http_connection) table using these 
instructions: Create an HTTP(s) connection .

◦ Type of connection - Select HTTP(s) Connection

◦ Set the Connection alias to the sys_alias  record created in previous step.

◦ Set the connection url to fetch the user information API as per your IdP. (For example: 
https://<your-idp-app>.com/api/v1/users)

6. Create a Profile Parser Action using Action Designer. See the code snippets shown here for 
an example: Create a profile parser action for Apple Messages for Business. See Building 
actions  for more details.

7. Create a new record in the Provider Application Authentications 
(sys_cs_provider_app_authentication) table using these instructions:

◦ Set the Provider Channel Identity to your provider app 
(sys_cs_provider_application)

◦ Set the OAuth Entity Profile to the oauth_entity_profile  record created with your 
OAuth Provider (oauth_entity) record.

◦ Set the Profile API Connection to the http_connection  record created previously.

◦ Set the Profile Response Parser Action to the sys_hub_action_type_definition 
record that you have defined.

Create a profile parser action for Apple Messages for Business

Create an action to parse the user information response and find the corresponding user on the 
ServiceNow®  instance for Conversational Integration with Apple Messages for Business  using 
the information provided here.

Before you begin
Role required: admin

Procedure

1. Refer to the following procedure to create a new action. Create an action .

2. In the Flow Designer Integration Hub, set the Input  field to response_body (string).
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Flow designer example

3. You can use the following example script to help create your script for the action.

(function execute(inputs, outputs) {
    try {
        var profile = JSON.parse(inputs.response_body);
        var email = profile[0]['profile']['email'];
        var user_sys_id = "";
        var result = {
            "auth_success": false,
            "user_sys_id": ""
        };
        if (email) {
            result['auth_success'] = true;
            var userGr = new GlideRecord("sys_user");
            userGr.addQuery("email", email);
            userGr.query();
            if (userGr.getRowCount() == 1)
                if (userGr.next())
                    user_sys_id = userGr.getUniqueValue();
 
            result['user_sys_id'] = user_sys_id;
        }
        outputs.result = result;
    } catch (e) {
        gs.error("Error in Virtual Agent - Parse User Profile: 
 " + e.message);
        throw e;
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    }
})(inputs, outputs);

4. Set the Output  field to the following:

result = {
    "auth_success": false,
    "user_sys_id": "1234"
    };

Complete the Payment Provider Configuration

Fill out the information in the Payment Provider Configuration table to connect your payment 
provider information to your ServiceNow®  instance.

Before you begin
Role required: admin

About this task
Each payment provider has their own procedures for certification, or configuration of your 
merchant profile. Refer to the payment provider's documentation for more details.

Procedure

1. Navigate to sn_va_payment_ctrl_payment_provider_configuration.list.

2. On the form, fill in the fields.

All information must match the information you have input with the payment provider.

Payment Provider Configuration form

Field Description

Name The name of the payment provider.

For example: Apple Pay, Google Pay, Stripe

Merchant Name Your merchant name from your payment 
provider.

Merchant Identifier Your merchant id from your payment provider.

Payment Gateway URL The URL for the payment gateway you host 
which processes the customer credit card 
details.

Merchant Capabilities The types of payment you can accept.

For example: Debit, credit, 3DS

Supported Networks The types of credit cards supported by the 
payment provider.

For example: Mastercard, Visa, American 
Express

Protocol Profile The name of the profile you have configured 
for processing payments.
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Field Description

Order Tracking URL The URL that the user can access to track 
their order.

Shipping Contact Update URL This URL allows the user to update their 
shipping contact information.

Fallback URL An alternate URL to allow the user to access 
the order information.

Payment Method Update URL This URL allows the user to update their 
payment method preference.

Supported Countries Countries that you sell to.

Shipping Method Update URL This URL allows the user to update their 
shipping method preference.

3. Click Update.

Remove the integration for Apple Messages for Business

To remove the integration of Apple Messages for Business  with your ServiceNow®  instance, 
you need to log in to your Apple Messages for Business  account, and then unlink your Apple 
Messages for Business  partner account from your ServiceNow®  instance.

Before you begin

• Role required: admin

Procedure

1. Go to Apple Messages for Business  (register.apple.com).

2. Click Messages for Business Accounts  to go to your business account.

3. Select the Business Account that you want to unlink from your ServiceNow®  instance.

4. Click Test your Messaging Service Provider connection, and Connect.
You are redirected to your Now Support  portal. Log in if necessary.

5. On the Remove Apple Messages for Business Account connection  page, click Delete 
connection.
A new tab opens to confirm you want to remove the connection.

6. Click Remove connection.

7. Upon successful deletion, you are redirected to your the instance homepage and shown this 
message: “Business account registration was successfully deleted."

Capturing information from a user in a Apple Messages for Business  chat conversation

Virtual Agent Designer is a diagram tool for creating and managing topics, which are blueprints 
for conversations between a virtual agent and user.

Use the collection of input controls provided by the Virtual Agent Designer  to prompt and capture 
information from a requester in a Apple Messages for Business  chat conversation. For more 
information, see Getting started with Virtual Agent Designer.

For more information about displaying images along with external links, see Using link unfurling 
in Virtual Agent.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2248

https://register.apple.com/messages
https://register.apple.com/messages
https://register.apple.com/messages


Apple Messages for Business  has an array of interactive features that are native to the app. For 
more information about these interactive features, see Conversational Integration with Apple 
Messages for Business.

User notification consent

Note: 

Notifications are turned off by default for the Apple Messages for Business  channel. Make 
sure to enable notifications at the channel level.

Users must opt in to receive notifications. No notifications can be delivered until the user grants 
consent.

There are two ways for users to grant consent to receive notifications:

• The user can enter Notification  into the Apple Messages for Business  chat to get a bot 
response with the option to subscribe or unsubscribe from receiving notifications for your 
business on Apple Messages for Business.

• As the administrator, you can set up the option for users to subscribe or unsubscribe from 
notifications from your portal. See Configure system settings  for more information.

User input controls

The Conversational Integration with Apple Messages for Business  application supports the 
following user input controls in Virtual Agent Designer.

Supported user input controls

User input control Description

Text User enters a plain text string in the conversation.

Static Choice User selects an item from a predefined list.

Dynamic Choice User selects an item from a list that is created dynamically. For 
example, the user can select from a list of cases that they opened.

Boolean User enters a Boolean response to the bot. For example, the user can 
reply Yes  or No  in a chat conversation.

File Picker User sends a file to the bot.

Date Time User selects a calendar date, time (hours and minutes), or both.

Carousel User selects a single item from the carousel.

For more information about configuring user input controls, see Virtual Agent Designer user input 
controls.

The Conversational Integration with Apple Messages for Business  application supports the 
following bot responses in Virtual Agent Designer.

Supported bot responses

Bot response Description

Text Bot sends a plain text string to the user.

Image Bot sends an image to the user.
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Supported bot responses  (continued)

Bot response Description

Link
Bot sends a web link to the user.

Note: 
Any URLs must be added to the allowed domain list 
(sys_cs_hostname_allow_list) table.

Table
Bot sends information in a table format so that users can see 
information in a more organized way.

For example, you can organize and display information such as the 
following:

• Planned service changes

• Company holidays

• Contact information

• Testing sites

Card Bot uploads and displays selected information from a record on your 
instance. You can choose a record card, video card, or small or large 
image card.

For more information about configuring bot responses, see Virtual Agent Designer bot 
responses.

Transfer Apple Messages for Business  chat conversations to live agents

Configure the Advanced Work Assignment  application to transfer a Apple Messages for 
Business  chat conversation initiated by a requester to a live agent.

Before you begin
Your administrator must have completed the following tasks:

• Activate Advanced Work Assignment.

• Set the application scope to Conversational Integration with Apple Messages for Business 
using the application picker. For more information, see Application picker .

• Activate the Conversational Messaging plugin (com.glide.messaging.awa). For more 
information, see Activate Conversational Messaging.

Role required: admin
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About this task
Messaging with a virtual agent

Messaging with a live agent
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Procedure

1. Enable the Apple Messages for Business  service channel.

a. Navigate to Advanced Work Assignment  > Settings  > Service Channels.

b. In the Name  column of the Queues list, search for Apple Messages for Business.

c. Click Apple Messages for Business.

d. On the Service Channel form, select the Active  check box.

e. Click Update.

f. Add agents to the Agent Apple Messages for Business Queue.
For more information, see Service channels.

2. Automatically route work items for Apple Messages for Business  chat conversations to agents 
by configuring the queue for the Apple Messages for Business  service channel.

a. Navigate to Advanced Work Assignment  > Settings  > Queues.

b. In the Name  column of the Queues list, search for Apple Messages for Business 
Queue.

c. Click Agent Apple Messages for Business Queue.

d. On the Queue form, select the Active  check box.

e. Click Update.

Note: 
By default, the Apple Messages for Business - Most Capacity 
assignment rule is associated with the Agent Apple Messages for Business Queue. 
You can create another assignment rule and associate it with the queue. For more 
information, see Configure agent assignment rules  and Work item queues.

3. Configure agent presence states for the Apple Messages for Business  service channel.

a. Navigate to Advanced Work Assignment  > Settings  > Presence States.

b. In the Name  column of the Presence States list, click an existing state.

c. In the Apply to groups section of the Presence State form, click the add icon (>) to move 
the Agent Apple Messages for Business Group  group from the Available  column to the 
Selected  column.

Note: 
You can ignore this step if you have selected the Apply to all groups  check box.

d. Click Update.

For more information, see Configure agent presence states.

Using Conversational Integration with Apple Messages for Business

Enable a requester to converse with an agent using Apple Messages for Business  chat 
conversations. An administrator can configure the Conversational Integration with Apple 
Messages for Business  application for integrating the Apple Messages for Business  messaging 
app with a ServiceNow  application.

Agents and requesters can do the following:
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• A requester can initiate Apple Messages for Business  chat conversations with a virtual agent 
or live agent.

• A live agent can accept Apple Messages for Business  chat conversations as work items from 
their Agent Workspace Inbox to converse with a requester.

• A live agent can continue to interact with a customer conversation in Apple Messages for 
Business  for as long as the customer would like.

For more information, see Integrating Apple Messages for Business with Customer Service 
Management .

Accepting Apple Messages for Business  chat conversations

As a live agent interacting with a requester over the Apple Messages for Business  service 
channel, you can do the following:

• Converse with the requester through text messages or iMessages.

• Share a knowledge article displayed as a link to the requester.

• Share a record. For example, a customer service case.

• Share any URLs as links with photo or video previews.

• Share photos or videos.

• Share any files as attachments.

Note: 
If an administrator has configured the Apple Messages for Business  service channel for 
transfer of chat conversations, then you can accept a work item from the Apple Messages 
for Business  chat conversation in your Agent Workspace Inbox. For more information, 
see Transfer Apple Messages for Business chat conversations to live agents  and Service 
channels.

Integrating the Conversational Integration with Apple Messages for Business  app with other 
applications

Other ServiceNow  applications and features can use the Conversational Integration with Apple 
Messages for Business  application.

As a live agent, when you accept a request from the Apple Messages for Business  service 
channel, you can converse with the requester within the same channel.

Integrating with Customer Service Management

Integrate the Conversational Integration with Apple Messages for Business  application with the 
ServiceNow®  Customer Service Management  application to enable your customer contacts and 
consumers to initiate a Apple Messages for Business  chat conversation with a virtual agent or 
live agent. An agent can accept a conversation initiated from a Apple Messages for Business 
chat conversation.

Virtual Agent  integration with Voice  channels

Enable users to run voice-based Virtual Agent bot conversations by integrating with supported 
third-party Contact Center applications and voice-assistant-based applications. Use the 
Conversational Integration apps that are available from the ServiceNow®  Store  to configure 
these voice-based apps for your ServiceNow  instance.
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Conversational IVR (Interactive Voice Response) integrates third-party Contact Center 
applications with your ServiceNow  instance. This enables users to have voice-based 
conversations with your Virtual Agent.

The Virtual Agent  integration with voice assistant applications enables interactions with touch or 
speak commands. For more information, see Conversational Integration with Alexa

Conversational IVR with Amazon Connect

ServiceNow's Conversational IVR with Amazon Connect  enables Conversational Interactive 
Voice Response (IVR) to be conducted by your instance. Users will be able to conduct 
conversations with a bot via the phone channel, powered by ServiceNow  Virtual Agent. 
Conversational IVR with Amazon Connect  is available with the installation of Conversational IVR 
with Amazon Connect  (com.sn.va.amz.connect) plugin.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Enable your users to initiate an IVR (Interactive Voice Response) conversation with your Virtual 
Agent  Agent by building an integration with Amazon Connect. Using the Conversational IVR with 
Amazon Connect, you can enable a user to have a voice-based conversation with your Virtual 
Agent using Amazon Connect to help provide this functionality. This integration also provides the 
user the flexibility to connect with an agent using ServiceNow  AWA  Advanced Work Assignment 
(AWA) over SoftPhone.

Conversational IVR highlights

• Use Virtual Agent topics as a Conversational IVR to enable deflection in Phone channels, 
providing consistent end-user experience.

• Enable true-omnichannel flow including routing Phone to the Conversational VA-IVR.

• In case of escalations, route calls smoothly to live agents using AWA via conversational 
infrastructure.

To get started with the Conversational Integration with Amazon Connect  application, see Install 
Conversational IVR with Amazon Connect.

Setup Conversational Integration with Amazon Connect

Install and configure the Conversational Integration with Amazon Connect  application to enable 
users to have a conversational voice response with their Virtual Agent.

1. To install the pre-built adapter for Conversational Integration with Amazon Connect, see Install 
Conversational IVR with Amazon Connect.

2. To set up your Amazon Connect  account if not already configured, see Configuring your AWS 
account for use with Conversational IVR.

3. To configure Conversational Integration with Amazon Connect, see Configure Conversational 
IVR with Amazon Connect.

4. To set up Live Agent transfer for Conversational IVR, see Sync Agents to setup Live Agent 
transfer.

5. To configure user authentication, see Configure user authentication for Conversational IVR.
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6. To modify the Conversational Integration with Amazon Connect  settings for the best interactive 
voice response, see Manage bot messages for Conversational IVR.

7. To configure callback functionality, see Configure callback behavior for a channel.

Workflow of Conversational IVR with Amazon Connect

Install Conversational IVR with Amazon Connect

Install Conversational IVR with Amazon Connect  application, to use interactive voice response 
(IVR) with Virtual Agent.

Before you begin
Role required: admin

Note: 
Before installing Conversational IVR with Amazon Connect, ensure that you have installed 
the Glide Virtual Agent  (com.glide.cs.custom.adapter) plugin in your ServiceNow  instance.

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. Select Virtual Agent  on the left pane and navigate to Add virtual agent to your contact center.
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3. Click Install.
You are directed to the ServiceNow Store  where you can search and get the Conversational 
IVR with Amazon Connect  application to use IVR.

What to do next
To learn how to configure your AWS account for enabling Conversational IVR, see Configuring 
your AWS account for use with Conversational IVR.

Components installed with Conversational IVR with Amazon Connect

After installing the Conversational IVR with Amazon Connect  application from the ServiceNow 
Store, the additional dependant plugins and spokes get auto-installed to enable other features 
for interactive voice response.

Plugin Description

OpenFrame - (com.sn_openframe) An interface to integrate external 
communication systems with a ServiceNow 
instance. This plugin brings a UI frame that is 
accessible and available anywhere within a 
ServiceNow  screens.

Virtual Agent API - (sn_va_as_service) Connects a user with a Virtual Agent using the 
company's Amazon Connect  account.

Advanced Work Assignment - (com.glide.awa) Automatically assigns work items to agents 
based on their availability, capacity, and skills.

Amazon Connect Spoke - 
(sn_amzn_connect_spk)(ih-amazon-connect-
actions)

Simplifies how you integrate with Amazon 
Connect.

Amazon S3 Spoke - (ih-amazon-s3-action-
pack)(ih-s3-actions)

Simplifies how you integrate with Amazon S3.

Omnichannel Callback - (sn_omni_callback) 
(com.sn.omnichannel.callback)

Provides a consistent omnichannel 
experience for requesters whether they are 
coming from the digital channel or from the 
phone.

Configuring your AWS account for use with Conversational IVR

To enable the Conversational IVR functionality within your ServiceNow  instance, you must utilize 
a third-party Contact Center application. One such option is Amazon Connect, which is part of 
the Amazon Web Services (AWS) platform. You must configure your organization’s AWS account 
prior to making it available for use in the Conversational IVR feature.

Configure your AWS account

1. To grant a ServiceNow  user the required permissions to complete the Conversational 
Integration with Amazon Connect on the AWS Console, see Grant access to an IAM (Identity 
and Access Management) role.

2. To create an Amazon S3 bucket and to store objects within your AWS account, see Create an 
Amazon S3 bucket.

This will host the files required to complete the configuration.
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3. To create an AWS CloudFormation Stack and to provide a common language to describe and 
provision all the infrastructure resources required to enable the Conversational IVR feature in 
your environment in a safe and repeatable way, see Create an Amazon CloudFormation Stack.

You will be populating a template provided by ServiceNow  that will then generate the required 
configuration.

4. To claim a phone number for setting up Conversational IVR, see Claim a Phone number .

5. To configure Conversational IVR with Amazon Connect  application in your ServiceNow 
instance to store the conversation between the agent and the user over Softphone as a 
transcript, see Setup Transcript for Amazon Connect.

Grant access to an IAM (Identity and Access Management) role

Grant a ServiceNow  user the required permissions to complete the Conversational Integration 
with Amazon Connect  on the AWS  Console.

Before you begin
Role required: admin

Procedure

1. Log in to your AWS  (Amazon Web Services) account and search for IAM.

2. Navigate to Users.

3. Click Add users, provide the User name, and click Next.

4. On the Set permissions page, under Permissions options, select Attach policies directly  and 
select the following permissions:

◦ AWSLambdaExecute

◦ AmazonConnect_FullAccess

◦ AmazonS3FullAccess

Note: 
You can search and select the attachments at the Permissions policies  search 

bar.

5. After selecting the required roles, click Next.

6. Click Create user.
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Create an Amazon S3  bucket

Create an Amazon S3  bucket to store the files required for configuring Conversational IVR within 
your AWS  account.

Before you begin
Role required: admin

Note: 
Before creating the Amazon S3  Bucket, ensure that you have downloaded the Lambda 
function, Lex Bot, and HelperLambda  files from this Knowledge Base article .

For additional information about Amazon S3  Buckets, refer to the Amazon S3 documentation .

Procedure

1. Log in to the AWS  Admin Console.

2. Navigate to Amazon S3  and click Create bucket.

3. Provide a Bucket name  (for example: sn-ci-cc-amazon-connect-setup) and note it down.
This Bucket name will be used during the creation of a CloudFormation Stack at a later stage.

4. Select the AWS Region  from the drop-down and ensure that this region remains consistent 
throughout the setup process.

5. Click Create bucket.
You will be redirected to the list of Amazon S3  buckets that you have on your instance.

6. Search for the bucket that you created and click the bucket name to open it.
Clicking the bucket name takes you to the Objects  tab of the bucket.

7. On the Objects tab, click Upload.

8. Click Add Files  and browse for the following downloaded files:

◦ Lambda function

◦ Lex Bot

◦ HelperLambda

◦ Prompt

Note: 

▪ The Prompt file is not provided by ServiceNow. You must create your own Prompt 
file, note its name, and provide the name while creating the CloudFormation Stack. 
For more information about creating a Prompt, see https://docs.aws.amazon.com/
connect/latest/adminguide/prompts.html .

▪ Also make sure that you do not rename any files while uploading them.

9. Select all the files that you uploaded and select Upload.
Once the files are uploaded, you will receive the

Upload succeeded

message.

Create an Amazon CloudFormation Stack

Create an AWS CloudFormation stack to provision all the infrastructure resources required to 
enable the Conversational IVR feature. You will be populating a template provided by ServiceNow 
that will then generate the required configuration.
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Before you begin
Role required: admin

Ensure that you downloaded the Cloud Formation Template (CFT) YAML file from this Knowledge 
Article  before creating an Amazon CloudFormation Stack and also make sure that you select 
the same region as that of the S3 bucket region.

For more information about creating an Amazon CloudFormation stack, refer to Amazon 
CloudFormation documentation .

Procedure

1. Log in to the Amazon Web Services Console.

2. Navigate to CloudFormation  > Stacks.

3. Click the Create stack  drop-down and select With new resources (standard).

4. On the Create stack form, under Prepare template section, select Template is Ready.

5. In the Template resource section, select Upload a template file  to the choose your 
downloaded CFT template and click Next.
You will be directed to the Specify stack details page.

6. On the Specify stack details page, provide a Stack name  (for example: sn-ci-cc-amazon-
connect-setup-stack) and specify the following details in the Parameters section:

Parameters

Parameters Description Example Value

AWS Configuration

S3 Bucket Name The name of the S3 Bucket 
that you created during the 
IVR setup process.

S3 bucket must contain the 
required files to be uploaded. 
Populate this parameter with 
that bucket name.

sn-ci-cc-amazon-connect-
setup

ServiceNow  Instance Configuration

ServiceNow  Instance The URL of the ServiceNow 
instance being used in this 
configuration. Be sure to 
include https://.

https://[instance-
name].service-now.com

Username Name of the ServiceNow  user 
to be used for establishing 
a basic authentication 
configuration in your 
ServiceNow  instance.

The user with this 
username must have the 
'sn_va_as_service.contact_center_api' 
role.

n/a

Password ServiceNow  user's password 
to establish a basic 

n/a
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Parameters Description Example Value

authentication configuration 
in your ServiceNow  instance.

Token Type The type of token used in this 
connection.

If you do not know the token 
type, then use Static.

Static/Hash

Token Value The secure token value for 
the connection between 
Amazon Connect and 
ServiceNow.

Note: 
Ensure that the token 
you provide does 
not contain any non-
alphanumeric values 
and ensure that you 
save the token value for 
later use.

rLRU5tyNHVj39MdA

Amazon Connect Instance Configuration - (Ignore if there is an existing amazon connect 
instance)

Amazon connect instance 
alias

Name for the Amazon 
Connect instance that will be 
created.

n/a

Prompt audio S3 file key Provide the name of the 
Prompt file that you have 
uploaded in Create an 
Amazon S3 bucket.

The Prompt file is an audio 
file containing the ringtone 
when customer connects to 
an agent.

n/a

Amazon Connect Instance Admin Configuration (Optional)

Username Provide an Amazon Connect 
username to create the 
administrator for the newly 
created Amazon Connect 
instance.

n/a

Email Email of the administrator 
for the Amazon Connect 
instance.

n/a

First Name First name of the user who 
is the administrator of the 
Amazon Connect instance.

n/a
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Parameters Description Example Value

Last Name Last name of the user who 
is the administrator of the 
Amazon Connect instance.

n/a

Password Password to log into the 
Amazon Connect instance as 
an administrator.

n/a

7. Click Next.

8. Review the parameters that you provided for your Stack, select the I acknowledge that AWS 
CloudFormation might create IAM resources with custom names.  checkbox, and Submit.
The Stack creates the required resources needed for the Amazon Connect IVR setup.

9. Review the progress of the CloudFormation Stack to ensure that the process completes with a 
CREATE_COMPLETE status.
Once the Cloud Formation Stack is created, you will see the Amazon Connect instance.

What to do next
Claim a Phone number.

Configure localization in Conversational IVR with Amazon Connect

Configure localization in Conversational IVR to use localization with Virtual Agent in other 
supported languages.

Before you begin
Role required: admin

Ensure that you have completed the IVR setup on both AWS  Console and ServiceNow  instance.

Procedure

1. Log in to the AWS  Management Console and open the Amazon Lex  bot named 
SN_CI_CC_LexBot.

2. Change the language of the amazon IVR Contact.

a. Navigate to Amazon Connect  from the AWS Console.

b. On the instance page, open the connect instance.

c. Hover over the Routing icon  on the left navigation bar and select Contact flows.

d. Select the SN_CI_CC_Inbound_Contact_Flow.
SN_CI_CC_Inbound_Contact_Flow is the default contact that is shipped to the user for use 
with Conversation IVR.

e. On the Contact flow, click the Set voice  flow.

f. On the Set voice pop-up, select the language that you added from the Language  drop-down 
and select the Set language attribute  check box.
English (US) is the default voice language and the English (US) language code is sent to the 
LexBot. The LexBot then collects the intents from the English (US) language.
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Note: 
There are different dialects available for a language. Therefore, ensure that you select 
the correct language with its dialect that you have added previously.

g. Click Save.

h. Click Publish  to publish the Contact flow with the new language.

The entire process of setting up the language attribute in Set voice  block works only if you use 
Virtual Agent integration with one language.

If you wish to select the language dynamically for every conversation, you must manually add 
a list of language choices to get the input from the user and use Set voice  block to set the 
appropriate language code.

The following image illustrates the flow:

Workflow to set language attribute

Customize keywords in Conversational IVR

Customize the IVR integration-specific keywords that are provided by default for better 
conversation in another language with the Virtual Agent.

Before you begin
Role required: admin

Ensure that you have completed the IVR setup on both AWS  Console and ServiceNow  instance.

Note: 
Any customizations done to the Lex bot must be redone in case of any updates to the Lex 
bot resource in the future versions of the application.
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Procedure

1. Log in to the AWS  Admin Console and open the Amazon Lex  bot named SN_CI_CC_LexBot.

2. If you want to customize the default keywords, you can edit the amz_ivr_keywords  slot type 
and give preferred values, and here's how you can do that.

a. Under the Conversation structure section in Slot types, select View slot types.

b. On the Slot types page, select AMZ_IVR_KEYWORDS  slot type.
The slot type is used for customizing the IVR integration-specific keywords namely next, 
repeat, back, and skip. These keywords can be used when talking to the Virtual Agent to 
navigate the paginated options/list of choices to skip a control.

Important: 
Ensure that you are editing the values only on the right column. Do not edit the values 
on the left column as they should not be changed regardless of the language.

By default the slot type values (on the right column) are in English. If the 
values on the right are not suitable for the another, change them to equivalent 
appropriate values, which shall be spoken by you when talking to the Virtual 

Agent.

If you have edited the slot type values on the right column, you must also ensure that you 
edit their respective bot messages on your instance to reflect these changes. For more 
information, see Manage bot messages for Conversational IVR.

c. Click Save Slot type  and click Build  on the top right of the page.

Note: 
You must build the Slot types for any new changes you made.

The language is successfully built and on the All languages page, you can notice the 
Successfully built  status against the language you have customized.

3. Create a new version of the bot to include both the languages.
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a. On the left navigation, select Bot versions.

b. On the Versions page, select Create version  on the top-right.

Note: 
Ensure that all the languages that you need in this bot have the Successfully built 
status before creating the version as only the built languages will be included in the 
version.

c. On the Create version page, provide a Description  for the version and click Create.
A version gets created with the next number. For example, Version 2 when there is only the 
default version 1 on your AWS instance.

4. Associate the version that you created with the production alias.

a. One left pane, navigate to Deployment  > Aliases  and select 
SN_CI_CC_LexBot_Prod_Alias, the default production Alias associated with Version 1 for a 
newly set up integration.

b. On the Alias page, select Associate version with alias  and select the version you created 
for the language being customized.

Note: 
Ensure to always have the production alias to point to the latest version number.

c. On the Associate alias to version pop-up, select the version and select 

Associate.
At this step, the bot is available for use in the language that you customized.

Claim a Phone number

Claim a Phone number to set up IVR (Interactive Voice Response).

Before you begin
Role required: admin
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Procedure

1. Log into your AWS Console and look for the Amazon Connect Instance you created.

2. Log in as an administrator into your Amazon Connect instance.

3. Navigate to Channels  > Phone numbers  and click Claim a number.

4. On the Claim Phone number form, select either the Toll free  Country or the DID (Direct Inward 
Dialing)  Prefix and select the number.

5. Claim a phone number to the SN_CI_CC_Inbound_Contact_Flow from the Phone numbers 
section in the navigator.

6. Provide a description of your choice in the Description  field, select 
SN_CI_CC_Inbound_Contact_Flow from the Contact flow / IVR  drop-down, and click Save.
After the number is published, customers can make a call and start conversations with the 
Virtual Agent.

7. Navigate to Routing  > Queues  and select BasicQueue.

8. On the Edit BasicQueue page, under Settings, specify a name for Default caller ID name.

9. For the Outbound caller ID number, select the Phone number you claimed in Step 4.

10. Select SN_CI_CC_Outbound_Contact_Flow  for the Outbound whisper flow.

11. Click Save.

What to do next
Invoke an automated caller interaction with bots to fulfill the caller's request within the 
ServiceNow  instance. For more information, see Configure a contact flow for an automated caller 
interaction.

Create inbound and outbound Amazon Connect  contact flows

Create the inbound and outbound Amazon Connect  contact flows to set up IVR (Interactive Voice 
Response).

Before you begin
Role required: admin

Procedure

1. Log in to your AWS account and select Contact Flows.

a. Select the region where the Lambda function/LexBot was created.
For more information see, Create an Amazon S3 bucket.

Note: 
Ensure that the region that you selected matches across the Amazon Connect setup.

b. In the Amazon Lex section, search and select your bot (for example: SN_CI_CC_LexBot) in 
the Bot  drop-down, select SN_CI_CC_LexBot_Prod_Alias  file from the Alias  drop-down, 
and click Add Amazon Lex Bot.

c. In the AWS Lambda section, search for your Lambda function (for example: 
SN_CI_CC_Process_Request) from the drop-down and click Add Lambda Function.
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d. Navigate to the Approved Origins section, click Add Domain  to add your ServiceNow 
instance URL and click Add Domain.

Note: 
Do not select the Enable Contact flow logs  check box under the Contact flow logs 
section.

2. Log in to your Amazon Connect Instance as an Administrator.

a. Hover over the Routing   icon on the left navigation bar and select Prompts.

b. Click Create new prompt, upload a prompt file of your choice with .wav  file extension, and 
click Create.

Note: 
Ensure that the .wav  audio file is no more than 10 seconds for optimal results.

c. Hover over the Routing   icon on the left navigation bar and select Contact flows.

d. Click the drop-down next to Create contact flow button and select Create customer queue 
flow.

e. On the Contact flow form, click the drop-down next to the Save button and select Import 
flow (beta).

f. On the Import flow (beta) pop-up screen, select a contact flow JSON file of your choice (for 
example: SN_CI_CC_Inbound_Customer_Queue_Flow) and click Import.

g. After the JSON is uploaded, locate and click the Loop prompts  tile.

h. On the Loop prompts pop-up, select an audio file of your choice with the .wav  extension 
(for example: SN_CI_CC_Inbound_Prompt.wav) from the Audio recording drop-down and 
click Save.

Note: 
Ensure that the .wav  audio file which you upload, does not exceed more than five-
minutes duration.

i. Click Save  to save the Contact flow and click Publish  to publish the Contact flow.

j. Navigate to Routing  > Contact flows, click Create contact flow  and import the 
SN_CI_CC_Inbound_Contact_Flow JSON file that you downloaded from the KB article .

k. Locate and click the Set customer queue flow  tile.

l. In the Set customer queue flow pop-up, select the customer queue flow from the drop-down 
(for example: SN_CI_CC_Inbound_Customer_Queue_Flow) and click Save.

m. Locate and click the Invoke AWS Lambda function  tile.
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n. In the Invoke AWS Lambda function pop-up, select the SN_CI_CC_Process_Request lambda 
function file from the drop-down, that you have already added at Step 1, C, and click Save.

o. Locate and click the Get customer input  tile.

p. In the Get customer input pop-up, navigate to the Lex bot section and select the 
SN_CI_CC_LexBot file from the Name drop-down and SN_CI_CC_LexBot_Prod_Alias file from 
the Alias drop-down and click Save.

q. Click the Play Prompt  tile next to the Set Working Queue  tile.

r. In the Audio prompt drop-down, select the .wav  file of your choice and click Save.

s. Click Save  to save the Contact flow and click Publish  to publish the Contact flow.

t. Navigate to Channels  > Phone numbers  and click Claim a number.

u. On the Claim Phone number form, select either the Toll free  Country or the DID (Direct 
Inward Dialing)  Prefix and select the number.

v. Provide a description of your choice in the Description  field, select 
SN_CI_CC_Inbound_Contact_Flow from the Contact flow / IVR  drop-down, and click Save.
You can edit the number description and also associate it with a new contact flow on the 
Manage Phone numbers page.
After the number is published, customers can make a call and start conversations with the 
Virtual Agent.

For more information about creating a Contact Flow, see Amazon Contact flow 
documentation .

For more information about creating Prompts, see Create prompts  in Amazon Connect 
documentation.

What to do next
Invoke an automated caller interaction with bots to fulfill the caller's request within the 
ServiceNow  instance. For more information, see Configure a contact flow for an automated caller 
interaction.

Setup Transcript for Amazon Connect

Configure Conversational IVR with Amazon Connect  application to store the conversation 
between the Agent and the User over Softphone as a transcript.

Before you begin
Role required: admin

About this task

• The voice transcript is stored by Amazon Connect, a third-party provider, post the voice 
conversation in the [sys_cs_message] table.

• Messages between the User and the Agent are fetched by transcript API and attached to the 
Conversation. Also, the sentiment score from Amazon  for each message is considered to 
derive overall Sentiment of User and Agent Conversation.
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• From Utah, the voice transcription is available real-time with the APIs that persist transcribed 
messages of an on-going phone call in real time. The messages are displayed in the Agent 
workspace chat panel along with previous conversation history (if enabled) and allows the 
Agent to leverage features like agent assist and search while actively talking to the caller. For 
more information about using Transcript API for real-time transcription, see Voice Interaction 
Resource API .

To date, we ensure that performance is acceptable for the volume of transactions, about 5 
million utterances/day/customer.

We have also updated the system to store all details associated to a voice call in standard 
CI tables (e.g., conversation and interaction tables) instead of the sn_openframe_phone_log 
table.

Procedure

1. Open your Amazon Connect instance page in AWS Console.

2. Navigate to Analytics tools  page and click Enable contact lens.

3. Click Save.

4. Navigate to Data storage  > Call recordings  and click Edit.

5. On the Call recordings page, select Enable call recording.
To enable Call recordings, you can either create a new S3 bucket by selecting Create a new 
S3 bucket (recommended)  or use an existing s3 bucket by selecting Select an existing S3 
bucket.

Note: 
This procedure explains creating a transcript using an existing S3 bucket.

6. Select the Name  of the existing S3 bucket from the drop-down and click Save.

7. Copy the S3 bucket name from the Data storage page, under the Call recordings 

section.

8. Navigate to AWS Lambda  > Functions  and select theSN_CI_CC_ProcessRequest  Function 
name.

9. Click Add trigger  and select S3  from the Select a source drop-down.

10. In the Bucket  drop-down, paste the copied bucket name.

11. Select the acknowledgement check box and click Add.

12. Configure Google Sentiment Analysis.

a. Log in to your ServiceNow  instance and navigate to All  > System Applications  > All 
Available Applications  > All.

b. Find the Sentiment Analysis (com.glide.cs.sentiment) application using the filter criteria and 
search bar and click Install.
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c. Select the Enable Sentiment Analysis  check box on the Amazon Connect's 
messaging channel record to enable Sentiment Analysis in your ServiceNow 

instance.

d. Create a connection for the Google Sentiment Analysis API.

▪ Create a service account on Google Cloud and the Cloud Natural Language API. For more 
information, see https://cloud.google.com/natural-language/docs/sentiment-analysis-
gcloud .

▪ Download JSON file and create a JAVA Key Store Certificate. For more information, see 
Create a Java KeyStore certificate

▪ Navigate to Flow Designer  > Connections  > Google Sentiment Analysis.
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▪ Set the following fields using the JSON and generated .jks  file.

▪ Click Get Auth Token.

Note: 
The Connection details shared previously are related to the personal google 
service account. To set up a new account and get the JSON key file, use see Google 
Documentation .

After you get that JSON Key file, the .jks  file can be generated using the following 
code:

createJKS() {
 
  cd $(dirname $1)
 
  cat $1 | jq -r .private_key > GCPNaturalLanguage_pk.pem;
 
  kid=$(cat $1 | jq -r .private_key_id);
 
  cert_url=$(cat $1 | jq -r .client_x509_cert_url);
 
  curl ${cert_url} | jq -r --arg jq_kid "$kid" 
 '.[$jq_kid]' > GCPNaturalLanguage_cert.pem;
 
  openssl pkcs12 -export -in GCPNaturalLanguage_cert.pem 
 -inkey GCPNaturalLanguage_pk.pem 
 -certfile GCPNaturalLanguage_cert.pem -out 
 GCPNaturalLanguage_pkcs12.p12;
 
  keytool -importkeystore -srckeystore 
 GCPNaturalLanguage_pkcs12.p12 -srcstoretype pkcs12 
 -destkeystore GCPNaturalLanguage.jks -deststoretype JKS
 
}
 
createJKS /
Users/firstname.lastname/git/ServiceAccountKey/core-period
-341405-9e1ed1673139.json (Path of JSON Key)

Configure Conversational IVR with Amazon Connect

Configure Amazon Connect  service provider to integrate with Virtual Agent and use interactive 
voice response.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings  > Virtual Agent.

2. On the Virtual Agent Settings page, navigate to the Configure your interactive voice response 
(IVR)  tile.
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Note: 
To see the Configure your interactive voice response (IVR)  tile on your Virtual Agent 
Settings page, ensure that you have updated the Omni-Experience Standard Feature Set 
plugin (sn_oe_sfs).

3. In the Configure pre-built adapter section, click Configure IVR.

4. In the Select IVR service provider page, select VA Amazon Connect Adapter Provider  as the 
IVR service provider from the drop-down.

Note: 
VA Amazon Connect Adapter Provider is available by default, with the Conversational IVR 
with Amazon Connect  application installation. To use the Amazon Connect  adapter, get 
the Conversational IVR with Amazon Connect  app from the ServiceNow Store.

Conversational IVR with Amazon Connect supports multiple service provider applications 
and you can create new ones if you want.

5. To finish setting up Amazon Connect, select the application name from the Provider Channel 
Identities section.

6. On the form, fill in the fields.

Note: 
From the AWS Console, copy and paste the authentication information for Amazon 
Connect below:

Amazon Connect information form

Field Description

Identifier Type Indicates the type of identifier for the 
provider channel identity.

For example, you can configure Amazon 
Connect on your ServiceNow  instance via 
Phone number or ARN.

Phone number The phone number being configured for this 
provider channel identity.
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Field Description

Note: 

◦ The Phone number  field is available 
only when you select Phone Number 
in the Identifier Type  drop-down.

◦ From Vancouver  release, you can use 
multiple phone numbers from an AWS 
account and create provider identity 
channels for each configuration to 
accommodate multiple points of 
contact.

Instance ARN The instance ARN from the AWS Console.

Static/hash token Your static or hash token from AWS Console.

Token type Confirmation for the token provided in the 
Static/hash token  field.

Connect Login URL The login URL from the AWS Console.

7. Click Save.

What to do next

• Sync Agents to setup Live Agent transfer

• Configure user authentication for Conversational IVR

• Manage bot messages for Conversational IVR

Enroll user Soft PIN and Device in ServiceNow  instance

Enroll the user Soft PIN and Device in your ServiceNow  instance to setup callback authentication.

Before you begin
Role required: admin

Procedure

1. Log in to your ServiceNow  instance.

2. Impersonate the user whose Soft PIN and Device must be authenticated.

3. Navigate to Password Reset  > Enroll.

4. In the SoftPin Verification for Amazon Connect tab, provide the soft Pin in the Enter the 
SoftPIN  field and click Submit.

5. In the SMS Verification for Amazon Connect tab, authorize the user device.

a. Select Add Device.

b. On the form, fill in the details.
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Add an SMS Device pop up

Field Description

Device name Name of the device that you are 
authenticating.

Phone number Phone number of the user that you want to 
authenticate.

Service provider Name of the service provider that you want 
to authenticate the device with.

c. Click Submit.

What to do next
After adding the phone number, verify the device. An OTP is sent to the user's phone number.

Setup the Amazon Connect spoke for VA IVR

Set up the Amazon Connect spoke for Conversational IVR to integrate your ServiceNow  instance 
with Amazon Connect.

Before you begin
Role required: admin

Procedure

To set up the Amazon Connect spoke for Conversational IVR with Amazon Connect, see Setup 
Amazon Connect spoke .

Sync Agents to setup Live Agent transfer

After the installation and configuration of Amazon Connect, you must sync agents to enable live 
transfer. You can sync agents stored in Amazon Connect with the agents on your ServiceNow 
agents.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings  > Virtual Agent.

2. On the Virtual Agent Settings page, navigate to the Configure your interactive voice response 
(IVR) section and click Configure IVR  under Configure pre-built adapter.

3. On the Configure interactive voice response page, select VA Amazon Connect Adapter 
Provider  from the Select IVR service provider drop-down.

4. Under Provider Channel Identities, select the identity provider that you want to sync agents for.

5. On the Amazon Connect information form, in the Sync your call center agents tile, click Sync 
agents.

6. Add the following roles to the agents to sync them with your ServiceNow  instance and the 
Amazon Connect  account.

◦ sn_va_as_service.contact_center_api

◦ awa_agent
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◦ interaction_agent

◦ agent_workspace_user

◦ sn_openframe_user

◦ awa_integration_user

Add each user, who must handle a Live Agent Transfer, to the Agent Phone Group by 
navigating to System Security  > Users and Groups  > Groups.

7. In the filter navigation bar on your ServiceNow  instance, enter 
awa_presence_state.list  to find the Presence States table.

8. Open the Available  state, move the Phone  Service Channel from the Available field to the 
Selected field and click Update.
Login as the synced user and make sure that the agent is available in Agent Workspace and 
also login to the Amazon Connect  instance with the same ServiceNow  user to verify.

Configure user authentication for Conversational IVR

You must configure the authentication level for how the end-user can be authenticated to be the 
logged-in ServiceNow  user using Voice.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings  > Virtual Agent.

2. On the Virtual Agent Settings page, navigate to the Configure your interactive voice response 
(IVR) section and click Configure IVR  under Configure pre-built adapter.

3. On the Configure interactive voice response page, select VA Amazon Connect Adapter 
Provider  from the Select IVR service provider drop-down.

4. Under Provider Channel Identities, select the identity provider that you want to edit the user 
authentication for.

5. On the Amazon Connect information form, in the Configure user authentication tile, click 
Configure authentication.

6. On the User authentication method setup form, swipe the Enable authentication  toggle switch 
to the right.

Note: 
Ensure that the application scope of your ServiceNow  instance is set to the 
Conversational IVR with Amazon Connect  application before editing the User 
authentication method setup form.

7. Select the Authentication style.

◦ Phone: Customer's phone number.

Note: 
Only requires the incoming phone number to match the record in [sys_user] profile 
Business Phone  field, in order for user to log in.

◦ Phone + Soft PIN: Customer's phone number requiring a pre-configured Soft PIN to 
authenticate.
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Note: 
Requires not only the phone number to match, but also for end user to identify user's 
personal Soft PIN registered with the customer’s ServiceNow  record.

◦ Phone + Soft PIN + MFA: Customer's phone number, requiring a Soft PIN and adds an extra 
layer of security with MFA (Multi-factor Authentication).

Note: 
Requires the phone number to match and also for end user to identify user's personal 
Soft Pin registered with the customer’s ServiceNow  record, in addition to have the end 
user authenticate using MFA.

To set up your end users with Soft PIN or MFA, see Configure your Password Reset process to 
auto-enroll users.

8. Provide the authentication details as per the selected authentication style.

◦ Verification question: Add a verification question of your choice.

Note: 
This option is only available for Phone + Soft PIN.

◦ Verification PIN length: Set up the length of your Soft PIN.

Note: 
This option is only available for Phone + Soft PIN.

◦ One-time password length: Set up the length of the one-time password

Note: 
This option is only available for Phone + Soft PIN and Phone + Soft PIN + MFA.

◦ one-time-password expiration time: Set up the expiration time for the password.

Note: 
This option is only available for Phone + Soft PIN and Phone + Soft PIN + MFA.

Changing the values or messages updates the record on the Password Reset verification 
record. For more information, see Configure your Password Reset process to auto-enroll users

9. Click Save.

Manage bot messages for Conversational IVR

Edit your custom messages to ensure that your conversations are optimized for Conversational 
IVR.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings  and select Virtual Agent  from the Chat 
Settings tab.

2. On the Virtual Agent Settings page, navigate to the Configure your interactive voice response 
(IVR) section and click Configure IVR  under Configure pre-built adapter.
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3. On the Configure interactive voice response page, select VA Amazon Connect Adapter 
Provider  from the Select IVR service provider drop-down.

4. Under Provider Channel Identities, select the identity provider that you want to edit the custom 
messages for.

5. Under Review and edit your virtual agent messages section, click Review VA messages.

Additionally, you can also select the Manage  button in the VA Messages column against the 
identity provider.

Manage custom messages for Conversational IVR

6. On the Custom virtual agent messages page, select the custom message that you wanted to 
update.

7. Edit the Value  for the message and click Update.

Unsupported Virtual Agent features for Conversational IVR

Refer to the unsupported features of Virtual Agent  in Conversational IVR with Amazon Connect.

Unsupported features

Chat Surveys: Conversational IVR with Amazon Connect  supports surveys but it cannot read 
the contents of the survey summary card, which is a card type control that IVR does not support 
currently.

To effectively use a survey with Conversational IVR, you must ensure to turn off the Show 
Summary  check box when creating or configuring a survey that is applicable to IVR 
conversation.

Conversational Integration with Alexa

ServiceNow®  Conversational Integration with Alexa  enables ServiceNow®  Virtual Agent  to 
interact with requesters through the Amazon  Alexa  voice interface using the Virtual Agent  topics. 
Conversational Integration with Alexa  uses the custom conversational chat integration framework 
to interact with the Virtual Agent  chatbot.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .
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Overview

Enable your users to initiate an Alexa  voice chat conversation with a virtual agent by using the 
Conversational Integration with Alexa  application. The application connects a requester with a 
Virtual Agent  using your company's Alexa  account. You can name your Alexa  skill and manage 
it using your company's Amazon  account while enabling end users to link their accounts to the 
ServiceNow  instance. You can also customize the way that a virtual agent speaks to you in a 
voice-friendly manner without having to change the topic.

Note: 
The Conversational Integration with Alexa  supports both screen-less and screen-based 
Alexa-enabled devices.

To get started with the Conversational Integration with Alexa  application, see Configure 
Conversational Integration with Alexa.

Configure Conversational Integration with Alexa

Install and set up the Conversational Integration with Alexa  application to enable users to 
interact with a virtual agent.

Configure Conversational Integration with Alexa  to enable interaction with Virtual Agent  through 
the Alexa  voice interface.

1. To install Conversational Integration with Alexa, see Install Conversational Integration with 
Alexa.

2. To set up Conversational Integration with Alexa, see Set up Conversational Integration with 
Alexa.

3. To modify the Virtual Agent  settings for the best voice chat experience with Alexa, see Fine-
tune Virtual Agent settings and topics for the best Alexa voice chat experience.

Install Conversational Integration with Alexa

You can install the Conversational Integration with Alexa  application (sn.va.alexa) if you have the 
admin role. The application installs the related ServiceNow®  Store  applications and plugins if 
they are not already installed.

Before you begin

• Ensure that the application and all of its associated ServiceNow Store  applications have valid 
ServiceNow  entitlements. For more information, see Get entitlement for a ServiceNow  product 
or application .

• Role required: external_app_install_admin, va_admin, or admin

About this task
The following applications are installed with Conversational Integration with Alexa:

Conversational Custom Chat Integration (com.glide.cs.custom.adapter)

Provides the custom chat integration framework of scriptable APIs to enable the 
Virtual Agent  application on any conversational interface.

For more information, see Conversational custom chat integrations.

ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)

Enables the execution of ServiceNow®  Integration Hub  actions and flows.
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Procedure

1. All  > System Applications  > All Available Applications  > All

2. Find the Conversational Integration with Alexa  application (sn_va_alexa) using the filter criteria 
and search bar.

You can search for the application by its name or ID. If you cannot find the application, you 
might have to request it from the ServiceNow Store.

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released 
apps, see the ServiceNow Store  version history release notes .

3. In the Application installation dialog box, review the application dependencies.

All the dependent plugins and applications are listed if they will be installed, or currently 
installed, or must be installed. If any plugins or applications must be installed, you must install 
them before you can install Conversational Integration with Alexa.

4. Click Install.

Set up Conversational Integration with Alexa

Set up the Conversational Integration with Alexa  application so that you can engage customers 
in conversations with bots.

Before you begin

• Get ServiceNow  entitlements for the following products and applications:

◦ Integration Hub

◦ Conversational Integration with Alexa

For more information, see Get entitlement for a ServiceNow  product or application .

• Install the following applications on your ServiceNow  instance:

◦ Integration Hub

◦ Conversational Integration with Alexa

• Complete the Alexa  settings.

1. Create your Amazon  Developer account.

For more information, see the Alexa  documentation .

2. Create an Alexa skill.

For more information, see the Alexa  documentation .

3. Build an Alexa skill model.

For more information, see the Alexa  documentation .

4. Configure an Alexa  skill.

For more information, see Configure an Alexa skill

.

5. Test an Alexa skill on the developer console.
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For more information, see the Alexa  documentation .

6. Account linking with Alexa.

For more information, see the Alexa  documentation .

Role required: external_app_install_admin, va_admin, or admin

Procedure

1. Associate a provider channel identity record with your Alexa  account.
For more information, see Create a provider channel identity record for Alexa.

2. Associate inbound message records with a message auth record.
For more information, see Set up message authentication for Alexa.

Create an Alexa  skill

Create an Alexa-hosted skill using the Alexa  developer console. Creating an Alexa  skill helps you 
prepare to use the Alexa  app.

Before you begin
Role required: admin

Procedure

1. Log in to the Alexa  developer console with your Amazon  developer account.

2. Click Create Skill.

3. In the Skill name  field, enter a skill name.

4. From the Default language list, select a default language to add your skill.

5. Under Choose a model to add your skill, select Custom.

6. Under Choose a method to host your skill's backend resources, select Alexa-Hosted 
(Node.js).

7. Click Create skill.

8. To add your skill, select the Start from Scratch  template.

9. Click Continue with Template.

Note: 
Creating an Alexa-hosted skill takes a few minutes.

10. In the skill, navigate to Interaction Model  > Intents  > JSON Editor.

11. Replace the JSON Editor  with the following JSON script.

{
    "interactionModel": {
        "languageModel": {
            "invocationName": "now agent",
            "intents": [
                {
                    "name": "AMAZON.CancelIntent",
                    "samples": []
                },
                {
                    "name": "AMAZON.HelpIntent",
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                    "samples": []
                },
                {
                    "name": "AMAZON.StopIntent",
                    "samples": []
                },
                {
                    "name": "AMAZON.NavigateHomeIntent",
                    "samples": []
                },
                {
                    "name": "EverythingIntent",
                    "slots": [
                        {
                            "name": "EverythingSlot",
                            "type": "Bag_of_words"
                        }
                    ],
                    "samples": [
                        "{EverythingSlot}"
                    ]
                }
            ],
            "types": [
                {
                    "name": "Bag_of_words",
                    "values": [
                        {
                            "name": {
                                "value": "value: Hello world"
                            }
                        },
                        {
                            "name": {
                                "value": "name: bag_of_words"
                            }
                        }
                    ]
                }
            ]
        }
    }
}

12. Click Save Model.

13. Navigate to Invocations  > Skill Invocation Name.

14. In the Skill Invocation Name  field, provide the skill Invocation name.

Note: 
The skill name is the name which you use in your Alexa  device to invoke the skill.

For example: <ask <skill name>.

15. Navigate to Interfaces  and enable Alexa Presentation Language.
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Note: 
This option enables all the screen devices which you want to use in Alexa.

16. Click Save Interfaces.

Configure an Alexa  skill

Configure your Alexa  skill to talk to your ServiceNow  instance.

Before you begin
Note: 
Linking your Alexa  account with your ServiceNow  instance is optional and only the Virtual 
Agent  topics with the public role are accessible with guest user access.

Role required: admin

Procedure

1. Log in to the Alexa  developer console with your Amazon  developer account.

2. Click the Code  tab.

3. Click Import Code.

Note: 
Browse for the lambda_funtion_sn_va_alexa.zip  file that you downloaded 
from the Supporting Documents section of the Conversational Integration with Alexa 
application on the ServiceNow Store  and click Import.

4. In the endpoint  field, replace the hostname with the host name from your ServiceNow 
instance URL where your Alexa  store app is installed.

Example endpoint: xxxxxxxxx.service-now.com/api/v1/alexa/message.

5. In the secretkey  field, replace <Provide secret key>  with your token (static or hash-
based).

Use the following tokens as per your authentication type.

◦ Hash-based token

If you are using hash-based authentication, provide the hash token which you provided 
during the ServiceNow  instance setup.

`"var security = <Token>
          "var genratedHash = generateHmac(eventJSON, 
 secretKey);
          'X-Voice-Type': 'hash',
          'X-Voice-Token': genratedHash,"

Note: 
Hash-based authentication is provided by default.

◦ Static token

If you are using static authentication, provide the static token.
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`"var security = <Token>
          'X-Voice-Type': 'static',
         `'X-Voice-Token': <Token>,`

6. Click Deploy.

Build an Alexa  skill model

Build your Alexa-hosted skill on the Alexa  developer console. Building a saved Alexa  skill model 
helps you prepare the skill for testing.

Before you begin
Role required: admin

Procedure

1. Log in to the Alexa  developer console with your Amazon  developer account.

2. Select the skill that you want to build.

Note: 
Selecting a skill navigates you to the Alexa  Developer Console.

3. Click the Build  tab.

4. In the Skill builder checklist, click Build Model.

Note: 
Building the model takes a few minutes.

The build successful message appears and you can test the sample utterances while the build 
is being trained.

Get the Alexa  skill ID

Get the Alexa  Skill ID from your Alexa  developer console after configuring the skill. The Skill ID is 
the Alexa  identifier for the application.

Before you begin
Role required: admin

Procedure

1. Log in to the Alexa  developer console with your Amazon  developer account.
You can get the skill ID in two ways.

a. On the Alexa  developer console:

i. Click the Your Skills  tab.

ii. Navigate to the skill name for which you want to copy the skill ID.

iii. Under the skill name, click Copy Skill ID.

b. On the left Custom navigator pane of the Alexa  developer console:

i. Select a skill from the Your Skills  tab.

ii. Navigate to Assets  > Endpoint  on the Custom navigator pane.

iii. In the AWS Lambda ARN section, click Copy to Clipboard.
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2. In the Provider Channel Identity record of your ServiceNow  instance, paste the copied skill ID 
in the Inbound ID  field.

3. Click Update.

Test an Alexa  skill on the developer console

Test your Alexa  skill using the Alexa  simulator and developer account once the installation is 
complete and the skill is built.

Before you begin
Role required: admin

Note: 
The Conversational Integration with Alexa  application works for guest users. All published 
Virtual Agent  topics (set up topics or topic blocks) are presented even if account linking 
is not done. For any regular topic, you must specify the Alexa  channel in the Additional 
channel support  field of the Topic Properties page. For more information about adding 
channel support to a Virtual Agent  topic, see Deploying Virtual Agent topics in other 
channels.

Role required: admin

Procedure

1. Log in to the Alexa  developer console with your Amazon  developer account.

2. Click the Test  tab.

3. In the Alexa  Simulator, type or speak the invocation name of your skill.

For example, ask now virtual agent.

Alexa  responds to the Virtual Agent  and returns a greeting message.

Test a skill on the Alexa  mobile app

Test your Alexa  skill using the Alexa  mobile app.

Before you begin
Role required: none

Procedure

1. Log in to the Alexa  mobile application using your email address that you used for logging in to 
the developer console.

2. Speak the invocation name of your skill.

For example, alexa now virtual agent.

Alexa  responds to the Virtual Agent  and returns a greeting message.

Test a skill on the Alexa  Echo or Echo Show screen device

Test your Alexa  skill using the Alexa  Echo or Echo Show screen device.

Before you begin
Role required: none
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Procedure

1. Log in to the Alexa  Echo or Echo Show using your email address that you used for logging in to 
the developer console.

2. Speak the invocation name of your skill or use the touch screen option to select the list option.

For example, alexa now virtual agent.

Alexa  responds to the Virtual Agent  and returns a greeting message.

Supported Alexa  intents

Use the Alexa  intents supported by Conversational Integration with Alexa  to receive an 
appropriate response during custom chat integrations with Alexa.

Supported custom intents

Custom intents

Intent Utterance Language understanding

AMAZON.YesIntent yes, yeah Sends the message “yes”

AMAZON.NoIntent no, nope Sends the message “no”

AMAZON.HelpIntent help, help me, and can you 
help me

Help message is displayed

AMAZON.PauseIntent pause End conversation; End Alexa 
Session

AMAZON.StopIntent stop, off, and shut up End conversation; End Alexa 
Session

AMAZON.CancelIntent cancel, never mind, and forget 
it

End conversation; End Alexa 
Session

Create a provider channel identity record for Alexa

Create a provider channel identity record to connect to your Alexa  account.

Before you begin
Role required: va_admin or admin

Procedure

1. In the navigation filter of your ServiceNow  instance, enter 
sys_cs_provider_application.list.

2. Click New.

3. On the form, fill in the fields.

Provider Channel Identity form

Field Description

Name Name of your provider.

Provider Provider channel that you created.

Select VA Alexa Adapter Provider  as the 
provider channel.
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Field Description

Note: 
The provider is available with the 
installation of the Conversational 
Integration with Alexa  plugin 
(sn_va_alexa).

Default portal Default portal used in the mapping.

Short description Short description for your channel identifier.

For security reasons, the Virtual Agent 
checks that the URLs for attachments in 
conversations are from trusted domains 
specified here. If the URL is not from a trusted 
domain, the Virtual Agent  does not upload 
the attachment.

If an attachment upload fails because Virtual 
Agent  did not trust the domain, Virtual Agent 
does not inform the end user about the 
attachment upload failure.

Message auth Message authentication for the channel 
identifier.

Choose a message authentication type from 
the following options:

◦ ServiceNow Virtual Agent Alexa App - Static

◦ ServiceNow Virtual Agent Alexa App - Hash

Inbound ID Identifier for your bot.

In this field, provide your Alexa  Skill ID that 
you copied from the Amazon  developer 
console.

For example: 
amzn1.ask.skill.XXXXXXX-XXXX-
XXXX-XXXX-XXXXXXX.

4. Click Submit.

Set up message authentication for Alexa

Define a token in your ServiceNow  instance to set up a message authentication with your Alexa 
account.

Before you begin
Role required: admin
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Procedure

1. In the navigation filter of your ServiceNow  instance, enter message_auth.list  and click 
New.

2. Select a message authentication type for Alexa  and open the record.

Your ServiceNow  instance provides you with the following authentication types by default.

◦ ServiceNow Virtual Agent Alexa App - Static

◦ ServiceNow Virtual Agent Alexa App - Hash

3. On the form, fill in the fields.

Message Auth form

Field Description

Name Name of the record in the Message Auth 
[message auth] table.

For example, ServiceNow Virtual Agent 
Alexa App - Hash  or ServiceNow Virtual 
Agent Alexa App - Static

Provider Provider of the auth token. Enter Alexa.

Inbound message verification Name of the Hash or Static Message 
Verification record that you created for the 
inbound hash or static messages.

Select an inbound message verification 
option as per the selected authentication 
type.

Your ServiceNow  instance provides you 
with the following authentication tokens by 
default:

◦ ServiceNow Virtual Agent Alexa App 
Static Token

◦ ServiceNow Virtual Agent Alexa App 
Hash Token

Outbound message creation Name specified on the Token Verification 
form (this token interacts with the provider on 
behalf of the user).

Select an outbound message option as per 
the selected authentication type.

Your ServiceNow  instance provides you 
with the following authentication tokens by 
default:

◦ ServiceNow Virtual Agent Alexa App 
Static Token

◦ ServiceNow Virtual Agent Alexa App 
Hash Token
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Field Description

Note: 
Outbound message verification is not 
required for Alexa. However, select 
the same option provided for Inbound 
message verification because it is a 
required field.

Outbound service token Authorized outbound service token.

Navigate to the Inbound message verification 
record to procure the Outbound service 
token from the Alexa  setup and provide it in 
the Outbound service token  field.

4. Click Update.

Account linking with Alexa

Link your Alexa  account with your ServiceNow  instance to retrieve information from your custom 
skill.

Link your Alexa  account with your ServiceNow®  instance

1. Configure your ServiceNow  instance to link it with your Alexa  account.

For more information, see Create an OAuth API endpoint for external clients .

2. To configure your Alexa account for account linking, see Configure your Alexa account.

3. To link the Alexa events with your ServiceNow  instance using your macOS  Terminal, see Link 
Alexa events using the macOS Terminal.

4. To link your ServiceNow  instance with your Alexa  account using the Alexa  app, see Link your 
account using the Alexa app.

Configure your Alexa  account

Configure your Alexa  account to link it with your ServiceNow  instance.

Before you begin
Role required: admin

Procedure

1. Log in to your Alexa  developer console with your Alexa  developer account.

2. Navigate to the Build  > MODELS  > ACCOUNT LINKING.

3. On the Account Linking form, swipe the Do you allow users to create an account or link to an 
existing account with you?  toggle switch to the right.

4. In the Settings section of the form, swipe the Allow users to authenticate using your mobile 
application  toggle switch to the right.

5. In the Security Provider Information section of the form, click Auth Code Grant.

6. On the form, fill in the fields.
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Auth Code Grant form

Field Description

Your Web Authorization URI The URI that authorizes your web access.

For example:  https://<instance-
name>.service-now.com/
oauth_auth.do.

Note: 
The instance-name for Alexa  is voice.

Your iOS  App Authorization URI The URI that authorizes your iOS  app.

Provide voice  as the value.

Your Android  App Authorization URI The URI that authorizes your Android  app.

Provide voice  as the value.

Access Token URI The URI that authorizes the access to the API 
requests.

For example, https://<instance-
name>.service-now.com/
oauth_token.do

Note: 
The instance-name for Alexa  is voice.

Your Client ID Auto-generated unique ID of the client 
application requesting the access token.

Note: 
Provide the Client ID generated while 
creating an OAuth API endpoint for 
external clients.

Your Secret The shared secret string that the instance 
and the OAuth application use to authorize 
communications with one another.

7. Click Save.

8. Copy one of the URLs from the Alexa Redirect URLs  field in the Auth Code Grant section.

Note: 
Insert the copied URL in the Redirect URL field of the OAuth API record created in your 
ServiceNow  instance.

If you face an issue with one of the URLs, try to use the next available URL and pick the 
one that works.

9. Click Save.
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Link Alexa  events using the macOS  Terminal

Link Alexa  events using your macOS  Terminal to complete the Alexa  account linking process with 
your ServiceNow  instance.

Before you begin
Note: 
Copy the Skill ID of your skill from the Alexa  developer console. The Skill ID is the same 
inbound ID used in the sys_cs_provider_application record.

Role required: admin

Procedure

1. On your macOS, open the Terminal.

2. Execute the npm install -g ask-cli  command.
Executing this command installs the Alexa  command-line interface on your machine if it was 
not previously installed.

3. Execute the ask configure  command.

4. Log in with your Amazon  developer account credentials when prompted.

Note: 
Choose No  if you are asked the question Do you want to link your AWS account in order 
to host your Alexa skills?

5. To download the manifest file, execute the ask smapi get-skill-manifest -s 
{<provide skillId>} > skill.json  command.

6. To edit the skill.json  file, add the following JSON script inside the manifest object.

"events": {
      "endpoint": {
        "uri": <provide lambda ID>.
      },
      "subscriptions": [
        {
          "eventName": "SKILL_ENABLED"
        },
        {
          "eventName": "SKILL_DISABLED"
        },
        {
          "eventName": "SKILL_PERMISSION_ACCEPTED"
        },
        {
          "eventName": "SKILL_PERMISSION_CHANGED"
        },
        {
          "eventName": "SKILL_ACCOUNT_LINKED"
        }
      ]
    },
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Note: 
Be sure to edit the URL endpoint with the Lambda ID. You can copy one of the endpoints 
from the skill.json  file and replace it with the Lambda ID. You can also fetch it from 
the Alexa  console from Build  > Endpoints.

7. To upload the updated manifest file, execute the ask smapi update-skill-manifest 
-s {<provide skillId>} --manifest "$(cat skill.json)  command.

Result
Your Alexa  account is linked with your ServiceNow  instance.

Your Alexa  account is linked with your ServiceNow  instance.

Link your account using the Alexa  app

Link your ServiceNow  account using your Alexa  mobile application.

Before you begin
Role required: admin

Procedure

1. Download the Alexa  app on your Android  or iOS  device.

2. Log in with the same email address that you used for the Amazon  developer account.

3. In the lower-right area of the app, click More.

4. Select Skills & Games.

5. Select Your Skills  tab.

6. Click Dev.

7. Select the skill that you created.

8. If the enable skill  button does not appear, click Disable Skill.

9. Click Enable.

10. Log in with the ServiceNow®  instance credentials of any user of the instance.
You should see that the account is linked.

Note: 
Insert the user record in the provider_user_map record to complete the account linking.

Fine-tune Virtual Agent  settings and topics for the best Alexa  voice chat experience

Fine-tune your Virtual Agent  settings and topics provided by the Virtual Agent Designer  for the 
best voice chat experience with Alexa.

• Virtual Agent Designer  is a diagram tool for creating and managing topics, which are blueprints 
for conversation between a Virtual Agent  and a user. For more information, see Getting started 
with Virtual Agent Designer.

Note: 
Be sure that you specify Alexa  as the applicable channel in the Additional channel 
support  field if you want the topics that you designed using the Virtual Agent Designer  to 
work on Alexa. For more information about the channel selection, see Deploying Virtual 
Agent topics in other channels.
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• Bot messages help you to interact with Alexa. You can change the bot messages 
for interaction in a voice chat conversation. To access the bot messages, enter 
sys_cs_provider_application.list  in the navigation filter and navigate to your 
Alexa  application profile to find the bot messages.

Bot messages for Alexa

• You can change the greeting message and other messages only for the voice channels using 
the Custom Greeting and Setup page. For example, you can create a custom topic, edit it, 
and assign it to be used if the end user is on a voice channel. For more information about 
accessing the Custom Chat and to change the greeting section of the message, see Configure 
a Virtual Agent chat experience.

• You can also change the system-generated messages by entering sys_properties.list 
in the navigation filter, and filter them by the criteria com.glide.cs  to confirm that these 
messages work for voice channels. You can review the following key messages:

◦ com.glide.cs.topic_picker_msg

◦ com.glide.cs.no_topic_found_message

◦ com.glide.cs.no_topic_sorry_message

◦ com.glide.cs.link_account_msg

◦ com.glide.cs.topic_choice_list_message

◦ com.glide.cs.topic_confirmation_message

Note: 
Most of the messages unique to the voice channels are listed in the Bot Messages 
section of the Provider Channel Identity record.

For more information, see Change the Virtual Agent greeting messages in the Greeting setup 
topic.
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• Most components work for screen-based and screen-less devices accessed in Alexa. 
However, some components are not compatible especially for the screen-less devices.

Note: 
On the screen-based Alexa  enabled devices, the presentation of cards and images has 
limitations as per the Alexa  skill kit specification.

The Conversational Integration with Alexa  application supports the following user input 
controls in Virtual Agent Designer.

Note: 
Conversational Integration with Alexa  also supports touch input for screen-based 
devices.
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• User input controls

User input 
control

Description Screen No screen

Text input/
output

Text format that is 
validated when a user 
enters certain text 
items.

Yes. Yes.

Static Choice User selects an item 
from a predefined list.

Yes, touch scroll. Yes, voice pagination.

Dynamic 
Choice

User selects a choice 
from the list of 
dynamically created 
choices.

Yes, no clicking 
links.

Yes, voice pagination.

Boolean User enters a Boolean 
response to the bot. 
For example, the user 
can reply Yes  or No  in 
a chat conversation.

Yes. Yes.

Date Time User selects a 
calendar date, time 
(hours and minutes), 
or both.

Yes (NLU 
recommended at 
the node).

Yes (NLU recommended at 
the node).

File Picker User sends a file to the 
bot.

No. No.

Pause Breaks the 
conversation with 
Alexa.

No. No.

Carousel User selects a single 
item from the carousel.

Yes, touch scroll. Yes, reading labels.

Image/Link/
HTML output

Bot sends an image, a 
link, or an HTML to the 
user.

Yes, no clicking 
links.

error_msg

Video User can choose a 
video card from the 
header card.

video_screen_device_msgvideo_audio_device_msg

Card Type of header card. 
Choose the contents:

◦ Large image with 
text

◦ Small image with 
text

◦ YouTube Video Card
The fields in the dialog 
box change based on 
your choice.

Yes, no clicking. Yes, reading labels.
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User input 
control

Description Screen No screen

Table If you selected Record 
as the Reference 
Type, select the table 
to be searched.

Yes

Shows the table 
headers, followed 
by rows with column 
header: value 
pair, Speak (Table 
header). Please say 
Done to continue.

No, reading labels

Unfortunately, I cannot 
show you the content on 
this device. Please say 
Done to continue.
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• Note: 
To edit or change any of the following bot messages, enter 
sys_cs_provider_application.list in the navigation filter of your ServiceNow  instance, 
select Alexa  > Bot Messages, and click the name of the bot message that you want to 
edit.

◦ error_msg

◦ video_screen_device_msg

◦ video_audio_device_msg

◦ table_msg

If you find the message name <EMPTY> and want to add a Boolean confirmation message to 
the end users, you can configure the bot message with the value [0] or [1].

• Conversational Integration with Alexa  supports contextual actions that serve an appropriate 
response from custom chat integrations when user input is mapped to them. For more 
information, see Contextual actions for Alexa.

Contextual actions for Alexa

Use the contextual actions supported by Conversational Integration with Alexa  to receive an 
appropriate response during custom chat integrations with Alexa.

Hi

You can type or speak the hi  command to initiate a conversation, in the middle of a 
conversation, or even inside a specific topic.

When you type or say hi  in the middle of the topic, you are shown an option to either End 
conversation  or to Cancel. If you end the conversation, the Alexa  skill is reset and you can 
restart the skill by speaking your invocation name. If you cancel the conversation, you are 
redirected to the last topic that you were at.

Bye

The Bye  command is used to end a conversation.

You can type bye  or speak this command in the middle of a conversation to end the 
conversation.

Help

The help  command is used to request help using the bot.

You can type help  or speak this command to ask your Alexa  skill any questions. If you want to 
restart the conversation, say hi  or restart the conversation.

Restart

The restart  command is used to end a bot conversation that is either in progress or runs into 
an error, and then begin a new conversation.

You can type restart  or speak this command anywhere in the middle of a conversation.
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Closing idle Alexa  chat conversations

Enable virtual agents to effectively manage their active Alexa  chat conversations by 
automatically closing the conversations after they have been inactive for a preconfigured amount 
of time.

Virtual Agent  conversations are configured for the Alexa  application. By default, any conversation 
is closed once the session with Alexa  closes. Any conversation that is abandoned by requesters 
remains open or idle until they are automatically closed daily by the Time Out Abandoned 
VA Conversations  scheduled job. For more information, see Closing Virtual Agent and 
Agent Chat conversations.

Conversational Integration with Google Assistant

ServiceNow®  Conversational Integration with Google Assistant  enables ServiceNow®  Virtual 
Agent  to interact with requesters through the Google  voice interface using the Virtual Agent 
topics. Conversational Integration with Google Assistant  uses the custom conversational chat 
integration framework to interact with the Virtual Agent  chatbot.

Important: 
Conversational Integration with Google Assistant  is no longer deployed, enhanced, 
supported, or available for new activation. For details, see the Deprecation Process 
[KB0867184]  article in the Now Support  Knowledge Base.

Analyzing Virtual Agent  performance

Analyze the performance of Virtual Agent  through preconfigured dashboards.

A new build of Conversational Analytics dashboard on Platform Analytics  experience is available 
starting in Washington DC. The dashboard offers many of the same visualizations in the form of 
indicators and breakdowns, with no dependency on Usage Insights  for data aggregations. The 
dashboard also meets the compliance requirements of data regulated market environments, 
for example, Government Community Cloud (GCC), and thus FedRAMP authorized. See 
Conversational Analytics dashboard in Platform Analytics experience  for more information.

The existing Conversational Analytics dashboard  will be deprecated in Yokohama.

Conversational Analytics dashboard in Platform Analytics  experience

The Conversational Analytics dashboard in Platform Analytics  experience helps you improve 
Virtual Agent  (VA) interactions with users by providing insights into conversational data. The 
dashboard helps you refine topics and improve the deflection rate of VA.

Get started

Select a tile to get started with the Conversational Analytics dashboard.

Explore

For VA users and system administrators 
to learn about the dashboard.

Set up

For system administrators 
setting up the dashboard.
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Use

For VA users to learn how 
to use the dashboard.

Reference

Get information about the dashboard 
roles and system parameters

Exploring the Conversational Analytics dashboard in Platform Analytics  experience

Use Conversational Analytics dashboard to improve Virtual Agent  (VA) interactions with users. 
The dashboard provides insights into conversational data, and helps you refine topics and 
improve the deflection rate of VA.

Conversational Analytics dashboard

Conversational Analytics dashboard provides insights into conversations so you can see how 
well Virtual Agent  understood and resolved user issues. Virtual Agent  keeps conversational 
data, that is, records of conversations with the users, and analytics data for up to two years. The 
dashboard contains indicators which, for example, reveal:

• What percentage of users transfer from VA to a live agent

• How to increase engagement rate and reduce user drop-offs

• Whether the user reached the last node in a topic

• Most and least used topics

• Conversation details using advanced filters

• How to optimize conversation design

Key features

Underperforming topics
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See the underperforming VA topics to investigate and improve topic performance.

Conversation details

Discover metadata about each VA interaction, including the user, chat duration, 
conversation type, and channel.

Overview

The following sections provide a high-level overview of how to use each section of the 
dashboard from the top down.

Date range of data displayed

The Start date  and End date  fields at the top of the dashboard specify the data 
range of the data summarized on each page.
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All data is continually pushed from Virtual Agent  to the dashboard in real time, and 
retained for up to two years.

For information about setting the date range, see Set the date range of the data.

Certain data visualizations might not have data available for the start date and end 
date selected in the Start date  and End date  fields. In this case, the widget shows a 
start date and end date for the visualization based on the data availability within the 
selected date range.

Getting detailed data

The Overview  tab contains key indicators to help you evaluate the performance of 
VA. You can view more details in the following ways:

• Select a tab, for example, Usage.

• Select an indicator, for example, Active VA users.

Dashboard tabs

Dashboard tabs

Tab Description

Overview View the key indicators of the performance of VA.

Now Assist  in VA View key indicators to monitor the performance of Now Assist 
in Virtual Agent. This is visible only when Now Assist  in Virtual 
Agent  is enabled.

Usage View VA conversation usage, for example, the language and 
conversation type.

Conversations View conversation details and troubleshoot individual 
conversations. Advanced filtering enables you to filter the list 
of conversations by conversation type, duration, user, and 
language.

Users View how your users are conversing with VA. Advanced 
filtering enables you to filter the list by user, channel, and last 
conversation.

Topics View topic performance indicators. Some of the indicators 
are most and least used topics, topics corresponding to VA 
conversations that were transferred to a live agent, average 
length of conversations per topic, and topic blocks used.

NLU Prediction View NLU performance indicators such as number of times 
the NLU prediction model accurately understood the intent of 
the user's conversation or auto-selected a topic. The indicator 
links to the NLU Workbench  if your instance includes NLU.

Custom Events View the number of custom chat events that you created using 
the Events page.

Issue Auto-
Resolution

View details about the number of user issues intercepted by 
the auto-resolution service and resolved by the Virtual Agent.

Virtual Agent  performance
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This area of the dashboard contains key VA performance indicators that you can 
drill down into for more details.

The indicators show data trends, such as increase or decrease of the data values 
in the date range specified on the dashboard. Clicking on the info icon displays the 
description of the indicator.

Certain trend visualizations on the dashboard such as the trends in intent and topic 
matching do not support viewing monthly, weekly, and daily data.

Setting up the Conversational Analytics dashboard

Set up custom events and formula definitions to create more targeted analytics.

The Conversational Analytics dashboard enables you to customize the data you monitor in the 
following ways:

• Date range—Specify the date range for the data displayed on the dashboard.

• Custom events—The dashboard can display analytics about custom events you create. All 
events must relate to conversations. For example, you can store data about every conversation 
that used a specific channel, such as Slack.

• Formula Override—Customize parameter definitions used in analytic reports. For example, by 
default, duration  is the total time from the first to the last exchange in a conversation. You might 
like to override that formula by subtracting inactive times in the conversation.

Role requirements

For information on roles, see Conversational Analytics dashboard roles.

Dependencies

The Conversational Analytics Dashboard requires the Quebec or later version of Virtual Agent.

Install Conversational Analytics Dashboard

Get updates to the Conversational Analytics dashboard from the ServiceNow Store.

Before you begin

Note: 
Starting with the San Diego  release, the Conversational Analytics app is automatically 
installed when you initially activate the Glide Virtual Agent  (com.glide.cs.chatbot) plugin. 
Subsequent updates for this app must be downloaded and installed from the ServiceNow 
Store.

Role required: Chat Analytics Admin
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Procedure

1. Confirm that your instance has the Glide Virtual Agent  plugin [com.glide.cs.chatbot] activated.
Starting with the San Diego  release, the Conversational Analytics Dashboard app is 
automatically installed when you activate the Glide Virtual Agent  plugin [com.glide.cs.chatbot].

2. Go to the ServiceNow Store , and search for analytics .

3. Select the latest version of Conversational Analytics app.
The store installs the updates to the Conversational Analytics app and the analytics data 
configuration tools. The plugin name is com.sn.conversational.analytics and the scope name is 
sn_ci_analytics. Some of the main tables for the Conversational Analytics dashboard include:

Table Description

sn_ci_analytics_conversation The main table for conversations. It lists Virtual Agent 
conversations.

sn_ci_analytics_event List of events. An event is something that happens, for 
example, an actionable notification. The dashboard can 
display analytics about default events or ones you create. 
For more information, see Set up custom events.

sn_ci_analytics_event_prop List of values used in events.

sn_ci_analytics_formula_override Lists formula overrides for properties used by the 
dashboard. For more information, see Set up custom 
definitions.

Note: 
You do not need a license or a plugin for Performance Analytics.

Create custom events to monitor

Create custom events and monitor them in the Conversational Analytics dashboard.

Before you begin
Role required: Chat Analytics Admin.

About this task
An event is a combination of conditions that apply to a subset of Virtual Agent  (VA) 
conversations. For example, an event might be conversations originating on a Slack channel that 
VA transferred to a live agent.

Most metrics you see on the dashboard, for example topic and conversation details, are derived 
from pre-built events. The dashboard displays these events on the Topics  and Conversations 
tabs. To build custom events, you can use the Custom Events feature. Use custom events to 
create analytics about data you're interested in, for example:

• Number of conversations on a Slack channel that transferred to a live agent.

• Number of conversations on a Slack channel where the user never returned.
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Custom events appear on the Custom Events  tab. If you haven't configured any custom events, 
the dashboard won't display any. You can create up to 20 custom events.

Custom events take effect when you create them. You cannot use them to analyze data collected 
before you created the custom event.

Procedure

1. Navigate to All  > Conversational Analytics  > Event Configuration  and select New.
The Event New record page appears.

2. In the form, fill in the fields.

3. Click Submit.
The Events page appears, which lists all custom events. You've specified the table to look for 
custom events. Now, you must specify the parameter values that trigger the custom event.

4. Click the custom event you created.

5. In the Event Properties related list, select New.
The Event Property New Record page appears where you specify the properties for a custom 
event that you want to track on the dashboard.

In this example, the Custom Event  tab shows metrics for Updated by  for the custom event, 
Messages-from-Slack.
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6. In the form, fill in the fields.

7. Click Submit.
The Event page appears.

8. Click Update.
The Events page appears, which lists all custom events. You can open the Custom Events  tab 
on the dashboard to see the custom event. This custom event is not retroactive; the dashboard 
only displays new events that satisfy the custom event criteria.

Create custom override definitions

Use scripts to override the default formulas used to create the analytics on the Conversational 
Analytics Dashboard.

Before you begin
Role required: Chat Analytics Admin

Be sure to set the application scope to Conversational Analytics.

About this task
The Conversational Analytics Dashboard uses formulas to determine analytics, such as how to 
calculate duration. You can override the default formulas to tailor the analytics to your needs. For 
example, the default formula for duration in the dashboard is the time between the first and last 
exchanges in a conversation. You might like to override that formula by subtracting inactive times 
in the conversation.

The default formulas and formula overrides are in the sn_ci_analytics_formula_override table. 
You can only modify the existing formulas that are in the table by deactivating the default formula 
and creating a new formula override record. You cannot override some formulas because they 
are system dependent. You can, however, create custom events  to achieve a similar goal.

The default definitions are:

• Duration—Time from the start of a conversation session until the last message is sent, rather 
than when the conversation session closes. You cannot replace the supplied script for 
Duration. You can only turn it on or off. If you deselect the Active  check box, the duration is 
calculated until the end of the session. If you select the Active  check box, the duration is 
calculated to the last message sent.

• Self-solve rate—Number of conversations that did not have negative feedback, contained a 
topic that went through to the last node, and did not escalate to a live agent. The dashboard 
divides that number by the number of all conversations to get the rate.

• Feedback—Defined as positive, neutral, and negative. For example, to override this behavior, 
first, use Virtual Agent  (VA) Designer to create a ranking from 1 to 10. Then, you can use a script 
to override the dashboard's default behavior by grouping 1–4 as negative, 5–7 as neutral, and 
8–10 as positive.

• End state—Defined by default in 12 ways. For more information, see Formula override 
examples.

• Valid conversation—Defined as a conversation record that is included in the dashboard results 
for satisfying at least one of the following criteria.
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◦ Non-actionable notification conversations, which do not require validation from the user, are 
counted as active conversations.

◦ Actionable notifications that are not part of an existing conversation are considered valid 
conversations when the status of the notification is either Sent or Completed.

◦ Conversation engages Virtual Agent  topic discovery or direct live agent conversation.

Note: 
Formula overrides do not change the stored data. They only change how the dashboard 
displays the data by computing existing data in a different way.

Procedure

1. Navigate to All  > Conversational Analytics  > Formula Override.
Alternatively, you can enter sn_ci_analytics_formula_override.list  in the Filter 
Navigator to display the sn_ci_analytics_formula_override table.

2. Select the formula you want to override.
You cannot override the Duration formula, you can only activate or deactivate it. You can alter 
the scripts for other definitions. These are the only definitions you can alter.
The Formula Override page appears and shows the existing formula.

3. Copy the script in the Value Script field.
The default formulas are read-only. So, to modify them, you must make a copy.

4. Deselect the Active  check box to make the default formula inactive.

5. Click Update.

6. Click New  to create a formula override record that overrides the default formula.
The Formula Override New Record page appears.

7. In the form, fill in the fields.

8. Click Submit.

Formula override example

Use the following formula override example to craft your own formula overrides.
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Group End State definitions

The end state of a conversation specifies how a conversation ended. For example, it could end 
with the user not responding, or the user closed the chat window. There are 12 default definitions 
of end state. For more information on conversation end states, see Virtual Agent interaction 
records. The following script groups them as follows:

• VA closed the chat session

◦ System Closed VA – User No Response

◦ System Closed VA – Topic Complete

◦ System Closed VA – Left With AI Search

◦ System closed VA – Auto Closed

◦ System Closed VA – User Never Engaged

• Live agent closed the chat session

◦ System Closed LA – User No Response

◦ System Closed LA – Chat Complete

◦ Agent Closed LA – Clicked End/X

◦ System Closed LA – Before Agent Engagement

• User closed the chat session

◦ User Closed LA – Clicked End/X

◦ User Closed VA – Clicked End/X

◦ User Closed LA - Before Agent Engagement

To create these groupings of the 12 end states, follow the instructions for creating a formula 
override  and use the following script.

(function calc(convGr) {
    // Returns 'System Closed VA', 'System Closed LA', 'User 
 Closed' states.
    function getFinalEndState(state) {
        var arrayUtil = new global.ArrayUtil();
        VA_END_STATE = ['System Closed VA – User No Response',
            'System Closed VA – Topic Complete',
            'System Closed VA – Left With AI Search',
            'System closed VA – Auto Closed',
            'System Closed VA – User Never Engaged'
        ];
        LA_END_STATE = ['System Closed LA – User No Response',
            'System Closed LA – Chat Complete',
            'Agent Closed LA – Clicked End/X',
            'System Closed LA – Before Agent Engagement'
        ];
        USER_CLOSED_END_STATE = ['User Closed LA – Clicked 
 End/X',
            'User Closed VA – Clicked End/X',
            'User Closed LA - Before Agent Engagement'
        ];
        if (state) {
            if (arrayUtil.contains(VA_END_STATE, state))
                return 'System Closed VA';
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            if (arrayUtil.contains(LA_END_STATE, state))
                return 'System Closed LA';
 
            if (arrayUtil.contains(USER_CLOSED_END_STATE, 
 state))
                return 'User Closed';
        }
        return state;
    }
 
    var conversationId = convGr.getValue('sys_id');
    var interactionGr = new GlideRecord('interaction');
    interactionGr.addQuery('channel_metadata_document', 
 conversationId);
    interactionGr.addQuery('channel_metadata_table', 
 'sys_cs_conversation');
    interactionGr.query();
    if (interactionGr.next()) {
        var state = interactionGr.getValue('state');
        var reason = interactionGr.getValue('state_reason');
        var isVAChat = interactionGr.getValue('virtual_agent');
        var isLAChat = interactionGr.getValue('agent_chat');
        var endState = new CAUtil().getEndState(state, reason, 
 isVAChat, isLAChat);
        return getFinalEndState(endState);
    }
})(convGr);

Using the Conversational Analytics Dashboard

Use the Conversational Analytics dashboard to get insights into Virtual Agent  (VA) conversations.

The following sections explain how to use the dashboard to investigate VA interactions 
with users. You must have the Chat Analytics Viewer (chat_analytics_viewer) role to use the 
Conversational Analytics dashboard.

Set the date range of the data

Set the Start date  and End date  fields at the top of the Overview tab to specify the date range of 
the data visualizations on the page. The date range set on this tab applies to all the other tabs on 
the dashboard.

Before you begin
Role required: Chat Analytics Viewer (chat_analytics_viewer)

About this task

You can set the date range in two ways.

Procedure

1. Navigate to All  > Conversational Interfaces  > Analytics.

2. Optional:  Use the Start date  and End date  fields to set the date range.
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a. Select the Start date  calendar icon ( ).

b. Double-select the start date on the calendar.

c. Select OK.

d. Select the End date  calendar icon ( ).

e. Double-select the end date on the calendar.

f. Select OK.
The data displayed on the dashboard adjusts according to the data in the new date range.

3. Optional:  Use the Start date  date calendar to set the date range.

a. Select the Start date  calendar icon ( ).

b. Double-select the start date of the date range.

c. While holding down the control-key on the keyboard, double-select the end date.
The dashboard highlights the range of dates.

(Optional)

d. Select OK.

(Optional) The data displayed on the dashboard adjusts according to the new date range.

Overview tab

Use the Overview tab to view key indicators that help you evaluate the performance of Virtual 
Agent.

The Overview  tab is the landing page for the dashboard. The visualizations in the Overview 
tab are important indicators of how VA is performing. You must have the Chat Analytics Viewer 
(chat_analytics_viewer) role to use the Overview  tab.

Note: 
Now Assist  in Virtual Agent  Analytics appears in the left navigation only when you have Now 
Assist in Virtual Agent  enabled.
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Key performance indicators

Indicators Descriptions

Deflection Count Number of deflection occurrences measured 
by the execution count of the Deflection topic 
block. A deflection occurs when Virtual Agent 
resolves or helps to resolve an issue for a user.

Deflection Pattern Number of deflections per deflection patterns.

KB Breakdown Titles of KB articles with the number of times 
they were presented as part of deflections.

Active VA users Cumulative number of unique active end users 
(not agents) who used the conversational 
interface.

Conversations Count of all interactive conversations initiated 
from the Virtual Agent.

VA success Percentage of conversations that were 
completed without escalation and with an 
intended topic flow.

Completed conversations are those that 
reach the end of a Virtual Agent  topic or 
conversation, are closed by the user, or are 
automatically closed.

Completed without escalation means that the 
conversation was not routed to a live agent, 
and the user did not give negative feedback. 
(Feedback types include negative, positive, 
neutral, and no feedback.)

Topic flows completed Percentage of topics that end users 
completed till the last node out of all topics 
invoked and ran.
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Key performance indicators  (continued)

Indicators Descriptions

Topic Category - Complete Number of completed conversations shown 
per topic Category.

Topic Category - Incomplete Number of incomplete conversations shown 
per topic category.

Topic - Complete Number of occurrences per topic when the 
user completed to the last node.

Topic - Incomplete Number of occurrences per topic where users 
abandoned the conversation before the topic 
reached the last node.

User feedback Feedback results categorized as good, 
bad and neutral. The feedback results are 
calculated from the Feedback Setup topic.

Note: 
A user with Chat Analytics Admin 
role can change how frequently the 
Feedback Setup topic shows after the 
completion of chat using the system 
properties.

Channels Number of conversations executed across the 
configured channels of the Virtual Agent.

Conversation end state Number of conversations that have ended in 
the out-of-the-box conversation end state.

Typical actions on the Overview  tab include:

• Selecting a deflection configuration to view the deflection indicators such as deflection count, 
deflection patter, and KB Breakdown.

• Selecting the visualized data, for example, a bar in a bar chart, to get additional information 
about the data.

• Changing the date range of the data displayed.

Usage tab

The Usage  tab provides usage information related to conversation type, language used in the 
conversations, and engagement rate of actionable notifications delivered by Virtual Agent  (VA).

The indicators in the Usage  tab provide the following information.

Usage indicators

Indicators Descriptions

Conversation type Number of conversations escalated from VA to a live 
agent, initiated and completed in VA only, or initiated and 
completed by a live agent.

Topic sent via the Actionable 
notification

The number of actionable notifications delivered from virtual 
agent to the users for the selected time range, and the 
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Usage indicators  (continued)

Indicators Descriptions

number and percentage of actionable notifications that 
users engaged with, and did not engage with.

Languages Languages used by users and the number of conversations 
in each language.

You must have the Chat Analytics Admin or Chat Analytics Viewer role to access the Usage  tab.

Usage tab

Conversations tab

Use the Conversations  tab to view the list of Virtual Agent  conversations and details of each 
conversation that occurred during the selected date range.

All conversations from the Conversation table [sys_cs_conversation], that run on the Virtual 
Agent Designer  are listed on the Conversations page, except for notifications, open (ongoing) 
conversations, and previews.

Virtual Agent  conversations and analytics data is retained for a period of two years.

To access the Conversations  tab, you must have the Chat Analytics Viewer 
(chat_analytics_viewer) role.
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Conversations page

Conversations tab benefits

The Conversations  tab enables you to do the following:

• Filter the list of conversations based on specific conditions using the filter editor. For more 
information, see Use filters in the Conversation tab

• Learn more about each conversation by viewing conversation details. For more information, 
see Get conversation details.

• Export the list of conversations to a file. For more information, see Export the conversations list.

• Download the conversation transcript to troubleshoot individual conversations. For more 
information, see Download the conversation transcript.

Get conversation details

To get more information about a conversation, select one of the conversations in the list. The 
information appears on the side panel.
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Conversation details

To view and download  the conversation transcript, select the Transcript  tab.
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Conversation transcript

Export the conversations list

To export the conversations list on the Conversations page to a file, select Export. In the Export 
pop-up window, specify the format for the file such as Excel, CSV, JSON, or PDF, and the delivery 
type such as email or download.

Note: 
You can export up to 1000 records only from the list on the page. This limit is not 
configurable.

Conversation information

The following table describes details of conversations listed in the Conversations  tab.

User information

Column Description

Created Date of the conversation.
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User information  (continued)

Column Description

Duration Duration of the conversation.

User ID Unique identifier that the system creates and permanently assigns 
to a Virtual Agent  user. The Id becomes a part of conversation 
records.

This number is not the same as the system user ID.

Device Type Conversational channel used for the chat.

Language Language used for the conversation.

End state How the conversation ended. For more information on various 
conversation end states, see Virtual Agent interaction records.

Type Type of conversation, for example, VA Only (conversation initiated 
and completed in VA).

Conversation

Download the conversation transcript

To download the conversation transcript, select a conversation from the conversations list and 
click Download.

The conversation transcript .txt file includes various data elements such as user input, Virtual 
Agent  response, Flow Designer Integration Hub, flow action, custom controls, and topic block 
information for the selected conversation. This information helps Virtual Agent  administrators to 
troubleshoot conversations, for example, conversations where there were errors or transfers to a 
live agent. For more information on the .txt file, see Conversation transcript template.

Conversation transcript template

The conversation transcript .txt file contains information used to troubleshoot individual 
conversations.

Data element Description

Conversation 
ID (sys_id)

Unique identifier of the conversation, autogenerated by the Virtual Agent.

Conversation 
Start Time

Start time of the conversation.

Channel Channel from which the conversation was initiated. For example, the Slack 
application, Microsoft Teams, and so on.

User Name Name of the user who initiated the conversation.

User Status Status of the user in the ServiceNow AI Platform®  instance. For example, 
Active or Inactive.

Bot Response Control that displays Virtual Agent  responses in a conversation.

User Input Control that prompts and captures information from the user in a 
conversation.
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Data element Description

Message Date 
and Time

Timestamp of individual messages.

FDIH logs Action or Subflow

• Id: sys_id of the action or subflow.

• Inputs: Input passed to the action or subflow.

• Outputs: Output received from the action or subflow.

Topic Block Name of the topic block defined in the current topic.

• Id: sys_id of the topic block invoked.

• Inputs: Input passed to the topic block.

• Outputs: Output received from the topic block.

Use filters in the Conversation tab

You can filter out conversation for a deeper understanding.

Filtering using the Filter Editor

To filter the conversations, click filter icon and select Advanced view  button to use the filter 
editor. You can either select an existing filter from the list or create a new filter condition.

Building filters in the filter editor

The filter editor consists of the following:

• Field: A list based on relevant tables. For more information about the field options, see Field 
options in the Filter Editor.

• Operator: A list of operators that is contextually generated based on the selected field.

• Value: A text entry field or a list that is contextually generated based on the selected field.
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To add a dependent condition in the filter editor, either click or  or and. To filter the conversations 
list using the condition, click Update.

To remove a condition, click the delete icon ( ) next to the condition.

To save a condition that you created in the condition builder, click Save filter. In the Save Filter 
pop-up window, specify a name for the filter. You can also set permissions for the filter in the 
Save Filter window. Users having the Chat Analytics Viewer (chat_analytics_viewer) role can 
select and modify saved filters.

Field options in the Filter Editor

Field options

Option Description

Channel Conversations that used the specified channel.

Conversation Time Conversations within the specified date and time.

Duration Conversations within the specified time duration. You can edit the 
definition of duration to be a session duration, rather than an active 
messaging duration. For more information, see Create custom 
override definitions.

End State Conversations with the specified state that is based on how 
conversations ended. The values for the end states are stored in the 
Interactions [interactions] table. For more information, see Virtual 
Agent interaction records.

Events Specific events that are triggered in a conversation.

Feedback Result Conversations for the specified feedback type.

Language Conversations for the specified language based on the user's 
language setting.

Message Count Conversations for the specified message count in the chat.

Provider Name Conversations for the specified provider.

VA Success Conversations resolved by the Virtual Agent.

Setup Topic Types Conversations that used the specified setup topic type.

Topic Blocks Conversations that used the specified topic block.

Topic Categories Conversations that have topics which belong to a specified topic 
category.

Topic Count Conversations that used the specified topic count. Each conversation 
can use multiple topics and this option filters conversations based on 
the count of topics used in it.

Topics Conversations that used the specified topics in the chat.

Type Conversations that are of the specified type such as live agent only or 
Virtual Agent  only.

Users tab

Get detailed information on Virtual Agent  users such as the time of the last conversation and 
duration of the conversation.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2316



The Users  tab provides information about users interacting with Virtual Agent.

To access the Users  tab, you must have the Chat Analytics Viewer (chat_analytics_viewer) role.

Users page

Users tab benefits

The Users  tab enables you to do the following:

• Filter the list of users based on specific conditions using the filter editor. For more information, 
see Use filters in the Users tab

• View user details. For more information, see User information section on this page.

• Export the list of users to a file. For more information, see Export the list of users section on this 
page.

Export the list of users

To export the list of users in the Users page to a file, select Export. In the Export pop-up window, 
specify the format for the file such as Excel, CSV, JSON, or PDF, and the delivery type such as 
email or download.

Note: 
You can export up to 1000 records only from the list on the page. This limit is not 
configurable.

User information

The following table describes user details listed on the Users tab.

User information

Column Description

User ID User ID of the logged in user. If users don't log in, they appear in 
sessions as Anonymous.

Is Anonymous If users didn't log in, they appear in the sessions as anonymous.

Channel Conversation channel used by the user.
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User information  (continued)

Column Description

Last conversation Timestamp of the user's last conversation with the Virtual Agent.

Use filters in the Users tab

You can use filters to get a deeper understanding of User data.

Filter using the filter editor

The filter editor enables you to filter users based on one or more conditions. You can either 
select an existing filter from the list or create a new filter using the editor.

The filter editor consists of the following:

• Field: A list based on relevant tables.

• Operator: A list of operations that is contextually generated based on the selected field.

• Value: A text entry field or a list that is contextually generated based on the selected field.

To remove a condition, click the delete icon ( ) next to the condition. To add dependent 
conditions in the condition builder, either click or  or and. To filter the conversations list using the 
condition, click Update.

To save a condition that you created in the filter editor, click Save filter. In the Save Filter pop-
up window, specify a name for the filter. You can also set permissions for the filter in the Save 
Filter window. Users having the Chat Analytics Viewer (chat_analytics_viewer) role can select and 
modify your saved filters.

Saved condition
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Field options in the Filter Editor

User filters

Option Description

User ID User ID of the logged in user.

User Index Unique number that the system creates and permanently assigns 
to a Virtual Agent  user. This number becomes a part of conversation 
records.

Conversation Exists Container for subfilter properties. For example, in the previous 
image, the subfilter is Duration.

Channel Count Number of channels a user used. A channel is the client app the 
user used, such as Slack. For example, if all users have used only 
one channel to chat with Virtual Agent, then setting the filter value to 
2 eliminates all the users in the list.

Channels Only displays users that used the specified channel to chat.

Conversation Count Only displays users that have the number of conversations specified 
in the filter.

First Conversation Time Only displays users where the first conversation is within the time 
period specified.

Language Only displays users that chat using the specified language.

Last Conversation Time Only displays users where the last conversation is within the time 
period specified.

Time in Chat Only displays users whose chat durations are within the time period 
specified, for example, more than 30 seconds.

Topics tab

Use the Topics  tab in the Conversational Analytics dashboard to identify the best and 
underperforming topics.

The Topics  tab provides insights into which Virtual Agent  (VA) topics are performing 
well and which aren’t. To use the Topics tab, you must have the Chat Analytics Viewer 
(chat_analytics_viewer) role.
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Best performing topics

The Best performing topics indicator shows topics that are performing well. The horizontal axis 
lists the topics. The count on the vertical axis refers to the number of times the topic was invoked 
by VA.

• Most Used—Topics that were least invoked by VA in conversations.

• Complete—Number of times VA completed the topic without transferring to a live agent.

• Transfer to Live Agent—The topics that were transferred to a live agent because VA couldn't 
resolve user's query.

Underperforming topics

The Underperforming topics indicator shows topics that didn't perform well. The horizontal axis 
lists the topics. The count on the vertical axis refers to the number of times the topic was invoked 
by VA.

• Least used— Topics that were least invoked by VA in conversations.

• Incomplete—The topics the user abandoned without resolution.

Spokes

The Spokes indicator provides details of the spoke, actions, subflows, and topics that executed 
the spoke. For more information, see Spokes.

Spokes

Use the Spokes indicators to view details such as spoke usage, spoke actions, and subflows for 
the selected spoke.

In Virtual Agent, conversations contain topics, topics contain spokes, and spokes contain spoke 
actions or subflows. The Spokes  indicators show which spokes, actions, and subflows were used 
and how often.
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Spokes tab

The Spokes tab contains the following indicators.

• Spoke Usage—Spoke Usage indicator shows the number of times the selected spoke was 
executed in the date range.

• Actions—Actions indicator shows which actions were executed for the selected spoke, which.

• Subflows—Subflows indicator shows which subflows were executed for the selected spoke.

• Topics—Topics indicator shows which topics executed the selected spoke. The horizontal axis 
shows the topics that triggered the spoke. The vertical axis shows the number of times the 
spoke was triggered in a topic.

Topic categories

Use the Category page in the Conversational Analytics dashboard to view the performance of 
Virtual Agent  (VA) topics by the selected topic category.

Topic categories group related conversation topics. Topics can belong to more than one 
category. Select the drop-down list to show the categories that you can display in the 
visualizations. The visualizations show the aggregate performance of Virtual Agent  conversations 
that ran in the topics belonging to a category.
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For more information about creating or modifying VA categories, see Create or modify custom 
categories.

Topic category visualizations

Visualization Description

Conversation end state The number of users that reached a specific node in a topic in 
the VA category. In the example, six users reached the node 
labeled, System closed VA - Auto Closed. Use this field to see 
where topics stopped working for users.

For definitions of each conversation end state, see Virtual 
Agent interaction records.

Transfer to live agent The number of users that transferred from VA to a live agent in 
that VA category. A high number indicates that the topic is not 
meeting user needs.

Topic usage trend Number of topics users used in a specified topic category over 
the course of the date range. The example shows the number 
of topics per day users used in the IT category. Use this field to 
monitor updates to topics.

Channel The application the user used to chat with VA in that topic 
category, for example, Slack or web client.

Channel usage trend Number of users using a specified channel over the course of 
the date range for topics in that VA category.

Topics details

Use the Topic Details page in the Conversational Analytics dashboard to view key performance 
indicators of Virtual Agent  (VA) topics.
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Get additional information about the topics

Select a topic from the drop-down to view the indicators associated with the topic.

The Topic Details page provides the following indicators.

• Topic Usage—The number of times the topic was used each day.

• Topic completion—Number of times the user went to the final node in the topic.

• Live Agent Transfer—Number of VA chats transferred to a live agent.

• Last Visited Node—Last nodes users visited before leaving the chat.

The presumption is the users gave up after the last node they visited.

• NLU Prediction—NLU prediction stats for the selected topic.

• Topic block breakdown—Execution count of the selected topic block in different topics. Use 
this indicator to view which topic block is executed the most across topics.

Natural Language Understanding  of Virtual Agent  responses

Use the NLU Prediction  tab to see how well NLU predicts intents, and to improve the intents so 
NLU makes better predictions.

Virtual Agent  (VA) uses the Natural Language Understanding  (NLU) service to understand user 
input. NLU Prediction  tab on the Conversational Analytics dashboard shows how well NLU is 
understanding user input in VA conversations. Virtual Agent  comes with NLU models, but you can 
use the Activate the  NLU Workbench  to modify or create new models.
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To use the NLU Prediction tab, you must have the Chat Analytics Viewer (chat_analytics_viewer) 
role.

NLU Prediction indicator

The NLU Prediction indicator shows the daily performance of NLU predictions mapped against 
the user intent.

• Intent Unsupported—NLU did not recognize user intent.

• Intent Auto Selected—NLU predicted a single intent based and the user selected the same. 
Sometimes, NLU returns multiple topics, each from a separate intent, and the user selects one.

• Intent Correctly Predicted—NLU predicted multiple intents and the user selected one of them.

• Intent Incorrectly Predicted—NLU predicted multiple intents and the user indicated that none 
of them were what they were looking for.

Note: 
The vertical axis can have duplicate values because the axis has 10 increments. If the 
number of intents is less than 10, some values on the vertical axis appear more than once.

The dashboard collects the following data points to arrive at the indicators.

1. Did the NLU prediction model determine an intent?

2. Did the predicted intent match the topic bound in the model to the intent?

3. What's the prediction score and did the dashboard show multiple options to the end user 
to specify the correct intent, or did the dashboard just display the topic associated with one 
intent.

4. After showing the user multiple intents, did the user select one?

It's possible for intents to appear in several categories. For example, an intent can appear in the 
Intent Correctly Detected  and Intent Auto Selected  because NLU correctly predicted the intent 
and only presented a single response, which the user accepted.

Improving NLU predictions

Clicking anywhere on the NLU Prediction indicator opens the Model Performance page. It shows 
a summary of intents predicted or not predicted over the date range specified on the graph.
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See Activate the  NLU Workbench  for information on how to use NLU Workbench to improve 
NLU predictions.

Modify models

Test and modify the Virtual Agent  models so they more accurately predict user intents.

Before you begin
Role required: Chat Analytics Admin

About this task
Many ServiceNow  products, such as ITSM, HRSD, and CSM include NLU models for Virtual Agent 
(VA) topics. The NLU plugin contains entities that are common across all products. You can 
modify those models. To learn how to train and test the models used for VA conversations, see 
Natural Language Understanding .

Procedure

1. Navigate to All  > Conversational Interfaces  > Home  > Analytics  and select the NLU 
Prediction  tab.

2. Select  View more  .

The Models page opens that displays the models that predict intents in your setup.

3. Optional:  If none of the models contain intents and utterances you'd like in your setup, select 
Create Model  and follow the instructions in Create an NLU model .

4. Click a model to display the intents the model predicts.
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5. Optional:  Click an intent to display the utterances associated with it.

(Optional)

6. Optional:  To create a new intent and add it to the model:

a. Select New Intent.
The Create a new intent  dialog box opens.

b. Enter the name of the new intent in Intent Name, a description of it in the Description  field, 
and select Save.
A page for your new intent opens.

(Optional)

c. Enter an utterance for your new intent and select Add.
You can repeat this step multiple times to add multiple utterances.
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7. Optional:  Import one or more intents by selecting Import Intents.
The Import Intents  dialog box opens, which displays the intents you can 

import.

a. Find the intent(s) to import by entering a search term, or by clicking an arrowhead to display 
the intents in a folder, and then selecting one or more check boxes.

b. Select Import.

8. Optional:  If you added or imported intents:

a. Select Train  to add the intents to the model.

b. Select Train  to train the model.
If successful, a banner at the top reads, The model has been successfully trained.

9. To test all the utterances, select Test  and enter a sentence a user might enter in a chat to see if 
NLU understands the intent of your sentence.

10. If the models fail to predict the intent, add additional intents to the model, or utterances to the 
intents, as described in step 6.
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Using user search metrics with Virtual Agent

By using user search metrics with the Virtual Agent  application, you can see your users' queries 
and the results from their searches. With these metrics, you can identify the areas where you can 
improve Virtual Agent  to offer more meaningful search results.

Use the User Search Metrics  tab in the Conversational Analytics dashboard to view key 
indicators about the queries that users searched on and the corresponding search results. By 
using this tab, you can get the answers to the following questions:

• Which search results were not useful to the users?

• Which queries did not have any search results?

• Which were the most common queries from users?

• Which search results did the users select most often?

To access the User Search Metrics  tab, you must have the chat analytics admin role or the chat 
analytics viewer role. The following example shows the data included in the User Search Metrics 
tab.

User Search Metrics tab

AI Search

Virtual Agent  topics may use AI search to suggest helpful resources to the user. When a user 
enters a query, AI search provides the most relevant results by using intelligent query features. 
To know more about AI search, see AI Search  . To integrate Virtual Agent  with AI Search, see 
Improving the user experience with AI Search.

Contextual Search

Contextual search matches keywords to an existing database search to find potential matches to 
a query. Virtual Agent  topics may use contextual search to resolve queries. For more information, 
see Maximizing code reuse with topic blocks.

Topic Links

Some Virtual Agent  topics have links to useful resources that are embedded within them. When a 
user invokes one of these topics, the link shows up without having to do any back-end search.
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User Search information

The following table describes user search indicators visualized on the User Search Metrics  tab.

User search indicators

Visualization Description

Queries with no clicks Queries that users did not click on any of the 
search results.

Queries with no results Queries that did not yield any search result.

Trending queries Queries that users most commonly asked.

Trending content Search results that users clicked on the most.

Custom Events tab

Use the Custom Events tab to view the list of custom events created for Virtual Agent.

To use the Custom Events tab, you must have the Chat Analytics Viewer (chat_analytics_viewer) 
role.

The Custom Events tab shows the dates when custom events were triggered. If no one created 
custom events, the list of custom events is empty. The maximum number of custom events 
displayed is 20.

Use the drop-down list to specify the custom event you want view analytics for.

Issue auto-resolution tab

The Issue auto-resolution  tab helps you understand how well your Virtual Agent  (VA) chatbot 
anticipates user needs. It displays information about the number of user issues intercepted by 
the auto-resolution service and resolved by VA.

Issue auto-resolution takes place when a user is diverted to VA from a non-conversational 
interface. For example, a user might request a new keyboard through a service portal or email. 
The auto-resolution service can detect the user request and use VA to resolve the user's request 
in a VA chatbot session. For more information, see Auto Resolution for Virtual Agent.

The indicators in the Issue auto-resolution  tab display how well the auto-resolution service 
is working. This tab is available only when Issue Auto Resolution is enabled and the Auto 
Resolution Configuration  record is set as active.
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To access the Issue auto-resolution  tab, you must have the chat analytics admin role or the chat 
analytics viewer role.

Issue auto-resolution tab

Selecting the data or pointing to the data in the visualizations displays additional information 
about the data.

Auto-resolution visualizations

Visualization Description

Intents with Matched Topics Number of intents that match topics enabled 
for auto-resolution.

Intents without Matched Topics Number of intents that do not have matching 
topics.

Intents with Auto-resolution Disabled Number of intents that match topics not 
enabled for issue auto-resolution.

Intent and topic matching results Breakdown of incidents by intent matching. 
For example, incidents with matching intents 
and topics, and incidents without matching 
intents.

Trends in intent and topic matching Trend showing incidents that have intents with 
or without matching topics.

Auto resolution conversations Issue auto-resolution conversations that were 
resolved or unresolved. Resolved means 
incidents are in the resolved state after the 
users interacted with VA.

Auto resolution conversation trends Usage trend showing all the issue auto-
resolution conversations and how many 
incidents were successfully resolved.

Issue auto-resolution acceptance rate Shows the issue auto-resolution notifications 
that were accepted and declined by users.

Top topics in auto resolution conversations Frequently used topics in auto resolution 
conversations.
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Conversational Analytics dashboard reference

Reference topics provide descriptions about the Conversational Analytics dashboard roles and 
system parameters to configure the dashboard.

Conversational Analytics dashboard roles

Conversational Analytics dashboard is installed with these roles.

To learn more about managing subscriptions, see Managing per-user subscriptions in 
Subscription Management  and contact your account representative.

Virtual Agent administrator  [virtual_agent_admin]

Provides read and write access to all dashboard-related tables, for example, sys-conversation.

Contains Roles

List of roles contained within the role.

• chat_analytics_admin

• ui_builder_admin

• chat_analytics_viewer

Groups

List of groups this role is assigned to by default.

None.

Special considerations

Note: 
Avoid granting an admin role when more specialized roles are available.

Chat analytics administrator  [chat_analytics_admin]

Provides access to view dashboard-related tables, create custom events, create custom formula 
overrides, reconfigure the dashboard using UI Builder, and set system parameters.

Contains Roles

List of roles contained within the role: chat_analytics_viewer.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

Note: 
Avoid granting an admin role when more specialized roles are available.

UI builder administrator  [ui_builder_admin]

Enables you to add, remove, and rearrange dashboard contents. Needs UI Builder, which is a 
separate ServiceNow  product.
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Contains Roles

List of roles contained within the role.

• workspace_admin

• canvas_user

Groups

List of groups this role is assigned to by default.

None.

Special considerations

Note: 
Avoid granting an admin role when more specialized roles are available.

Chat analytics viewer  [chat_analytics_viewer]

Provides read access to view the dashboard.

Contains Roles

List of roles contained within the role: sn_ace.ace_user.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

System parameter configuration

Use system parameters to configure some of the Conversational Analytics Dashboard.

Use the following system parameters to reconfigure Conversational Analytics Dashboard 
functionality. You must have the role, Chat Analytics Admin.

Dashboard system parameters

Functionality System parameter Description

Debug sn_ci_analytics.logging.verbositySet this parameter to "debug" to see the 
debug logs for conversational analytics. The 
setting makes the logs verbose with debug 
information.

Reasons sn_ci_analytics.ca.reason_maxSets the maximum length of reason strings. 
The default is 1000 characters.
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Conversational Analytics dashboard

The Conversational Analytics dashboard helps you improve Virtual Agent  (VA) interactions with 
users by providing deep insights into conversational data. The dashboard helps you refine topics 
and increase the percentage of issues resolved by VA.

Get started

Select a tile to get started with the VA Analytics Dashboard.

Explore

For VA users and system administrators 
to learn about the dashboard.

Set up

For system administrators 
setting up the dashboard.

Use

For VA users to learn how 
to use the dashboard.

Reference

Get information about the dashboard 
roles and system parameters

Exploring the Conversational Analytics Dashboard

Use Conversational Analytics dashboard to improve Virtual Agent  (VA) interactions with users. 
The dashboard provides deep insights into conversational data, and helps you refine topics and 
increase the percentage of issues resolved by VA.

Virtual Agent  Analytics

Virtual Agent  keeps records of interactions with users for up to 90 days. The metrics extracted 
from the conversations are retained for a period of two years. The Conversational Analytics 
dashboard provides insights into those interactions so you can see how well Virtual Agent 
understood and resolved user issues. Dashboard metrics, for example, reveal:

• What percentage of users transfer from VA to a live agent

• How to increase engagement rate and reduce user drop-offs

• Whether the user reached the last node in a topic

• Most and least-used topics

• Conversation details using advanced filters

• How to optimize conversation design
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Key Features

Worst performing topics

See the worst-performing VA topics over a given time period.
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Conversation details

Discover metadata about each VA interaction, including the user, the chat duration, 
and which node a user stopped at in a topic.

User insights
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Get a history of a user's chats.

Overview

The following sections provide a high-level overview of how to use each section of the 
dashboard from the top down.

Date range of data displayed

The Start  and End  dates at the top of the dashboard specify the data range of the 
data summarized on each page.

All data is continually pushed from Virtual Agent  to the dashboard in real time, and 
retained for up to 3 months. The analytics dashboard can also accept conversation 
data up to 30 days old, to support scenarios involving temporary technical issues.

All dates and times on the dashboard are UTC. Even though the conversation 
table lists conversation dates and times in different time zones, Virtual Agent  (VA) 
converts them to UTC when displaying them on the dashboard. Additionally, if you 
select a preset date range, such as last week, the dates might be slightly different 
from what you expect.

For information about setting the date range, see Set the date range of the data.

Certain data visualizations might not have data available for the start date and end 
date selected in the Start  and End  fields. In this case, the widget shows a start date 
and end date for the visualization based on the data availability within the selected 
date range.

Getting detailed data
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The Overview  tab provides summaries of the data displayed on the other tabs. You 
can get to more detailed data in several ways:

• Click a tab, for example, Usage.

• Click the arrowhead in one of the cards.
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• Click a visualization.

Dashboard tabs

Dashboard tabs

Tab Description

Overview Landing page for the dashboard that shows summary 
information for all the other tabs.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2338



Dashboard tabs  (continued)

Tab Description

Usage Describes VA conversation usage, for example, the language 
of the conversations, their durations, and the types of 
conversations.

Conversations Summary information for a user's conversations. Advanced 
filtering enables you to filter by conversation nodes or topics, 
and get details about the conversation duration, the channel 
the conversation occurred in, and the number of messages 
exchanged. You can link to details about each conversation on 
this tab.

Users Lists the users who have had VA conversations. Advanced 
filtering provides analytics about usage frequency, by 
conversation, the duration of the conversation for each user, 
the user's first and last conversation, and the language used. 
You can link to user details from this tab, including their 
conversations.

Topics Shows metrics about topics used by VA in conversations. 
Metrics include how many VA conversations moved to a live 
agent, average length of conversations per topic, and topic 
blocks used.

NLU Prediction Shows the number of times the NLU prediction model 
accurately understood the intent of the user's conversation or 
auto-selected a topic. The chart links to the NLU Workbench  if 
your instance includes NLU.

Custom Events Displays the number of custom chat events that you create 
using the Events page. If you don't create custom events, the 
tab content is empty.

Funnels Provides metrics for conversation flows.

Issue Auto-
Resolution

Displays information about the number of user issues 
intercepted by the auto-resolution service and resolved by the 
Virtual Agent.

Trends and scores

Many tabs use scorecards that show the current value for a data point, for example, 
the number of conversations currently online.

Scorecards also show data trends, such as the increase or decrease of the data 
values over the date range specified on the dashboard. Hovering over the title of a 
scorecard displays a description of the scorecard.
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Certain trend visualizations on the dashboard such as the trends in intent and topic 
matching do not support viewing monthly, weekly, and daily data.

Visualizing data

Many tabs show visualizations of the recorded VA data.

The cards have a common setup.
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In each visualization, you can select:

• Subtabs to visualize different datasets in the visualization.

• Arrowhead icon ( ), which takes you to the corresponding tab that provides more 
detailed information.

For example, select the arrowhead in the Active Users  scorecard to go to the 
Users  tab, which shows a list of users currently using VA chat.
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• Click displayed data, such as a bar in a bar chart, to display detailed information 
about that data.

Tutorial

Now that you are familiar with the user interface, you can try the tutorial. It shows how the parts of 
the dashboard work together to provide insights for improving VA.

Trying out the dashboard

Use this tutorial to get familiar with the Conversational Analytics Dashboard.

Before you begin
Role required: Chat Analytics Viewer (chat_analytics_viewer)

Note: 
This tutorial is intended for use in your own instance. Test instances can be used but may 
not provide meaningful feedback unless they contain pre-loaded data.

Procedure

1. Navigate to All  > Conversational Interfaces  > Conversational Analytics  > Virtual Agent 
Dashboard.
The Overview  tab on the dashboard appears. The Topic flows completed  scorecard shows 
that the number of users completing all the nodes in a topic has decreased. I'd like to know 
why.

2. In the Topics  visualization, click Incomplete.
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I see that users did not complete the Testing Topic  the most times, 14. So, I want to find out 
where the user got lost.

3. Click the Testing Topic  bar to drill down on that topic.

The Topic details page opens. In the Total completion  scorecard, the example shows that 
Virtual Agent  (VA) resolved 15 conversations but couldn't resolve 5 conversations. The Live 
Agent Transfer  scorecard shows that no one transferred to a live agent. The Last visited node 
scorecard shows the three nodes in the topic where the user abandoned the conversation: 
Start, Testing, and link to requested screen. Review those nodes to clarify the communication 
or add a different intent.
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No conversations in this topic transferred from VA to a live agent. But I wonder if there are 
topics where users did transfer.

4. Click the Conversations  tab.
The Conversations  tab displays all the conversations within the specified date range. I decide 
to use filters to see only the conversations that VA transferred to a live agent.

5. Select Live Agent Transfer.

I notice that the condition builder automatically entered the filter parameters, setting Type  to 
VA to LA.

.

I'd like to know which topic node the user last visited before transferring to a live agent.

6. Click a conversation date.

The conversation details appear.

7. Expand the Greetings  action in the Timeline  tab.

I see that the last node the user visited was Send Topic Picker. Now, I know I should revise that 
node in that topic.
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I decide to see which topics are working better.

8. Select the VA Success  filter.
The list contains conversations that VA was able to resolve. Perhaps I want to find out if the 
problem resolution took too long.

9. To add a condition, click View/edit filter  and use the condition builder in the Filter Editor pop-
up window. You can either select a default filter from the list or create a new filter condition.

10. Select Duration  for the condition, the greater-than sign for the operator, enter 180 for the 
number of seconds, and click Run.
The list shows VA conversations that lasted over three minutes. It's a small percentage of all 
the conversations. So, I conclude the topic is working well.

Finally, I want to know which topics are most and least used so I know what topics to prioritize.

11. Click the Topics  tab.
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The Topics page shows the best and worst performing topics.

Setting up the Conversational Analytics Dashboard

Set up custom events and formula definitions to create more targeted analytics.

The Conversational Analytics Dashboard enables you to customize the data you monitor in the 
following ways:

• Date range—Specify the date range for the data displayed on the dashboard.

• Custom events—The dashboard can display analytics about custom events you create. All 
events must relate to conversations. For example, you can store data about every conversation 
that used a specific channel, such as Slack.

• Formula Override—Customize parameter definitions used in analytic reports. For example, by 
default, duration  is the total time from the first to the last exchange in a conversation. You might 
like to override that formula by subtracting inactive times in the conversation.

Role requirements

For information on roles, see Conversational Analytics dashboard roles.

Dependencies

The Conversational Analytics Dashboard requires the Quebec or later version of Virtual Agent.

Install Conversational Analytics Dashboard

Get updates to the Conversational Analytics dashboard from the ServiceNow Store. Use this 
dashboard to gain insights on Virtual Agent  (VA) chats with customers.

Before you begin

Note: 
Starting with the San Diego  release, the Conversational Analytics app is automatically 
installed when you initially activate the Glide Virtual Agent  (com.glide.cs.chatbot) plugin. 
Subsequent updates for this app must be downloaded and installed from the ServiceNow 
Store.

Conversational Analytics dashboard is not available for on-premise installation.

Using the Conversational Analytics dashboard may incur Integration Hub  transaction costs. This 
transaction metering was unintended and will be removed in an upcoming release. If the issue 
persists, please create a case for our Customer Service and Support  team.

Role required: Chat Analytics Admin
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Procedure

1. Confirm that your instance has the Glide Virtual Agent  plugin [com.glide.cs.chatbot] activated.
Starting with the San Diego  release, the Conversational Analytics Dashboard app is 
automatically installed when you activate the Glide Virtual Agent  plugin [com.glide.cs.chatbot].

2. Go to the ServiceNow Store , and search for analytics .

3. Select the latest version of Conversational Analytics Dashboard.
The store installs the updates to the Virtual Agent  Analytics Dashboard and the Analytics data 
configuration tools. The plugin name is com.sn.conversational.analytics and the scope name is 
sn_ci_analytics. Some of the main tables for the Conversational Analytics Dashboard include:

Table Description

sn_ci_analytics_conversation The main table for conversations. It lists Virtual Agent 
conversations.

sn_ci_analytics_event List of events. An event is something that happens, for 
example, an actionable notification. The dashboard can 
display analytics about default events or ones you create. 
For more information, see Set up custom events.

sn_ci_analytics_event_prop List of values used in events.

sn_ci_analytics_formula_override Lists formula overrides for properties used by the 
dashboard. For more information, see Set up custom 
definitions.

Note: 
You do not need a license or a plugin for Performance Analytics.

Reconfigure dashboard contents

Conversational Analytics Dashboard is created from Next Experience Components. You can 
use the UI Builder  to customize the dashboard provided you have chat_analytics_admin and 
ui_builder_admin roles.

The dashboard pages that ServiceNow®  ships with the Conversational Analytics Dashboard 
have a protection-policy, which makes the dashboard pages read-only. However, you can copy 
the dashboard pages using the Duplicate  menu option or create a variant of the default page in 
the UI Builder  tool. After copying a page, you can customize the page content according to your 
requirements.

For information about using UI Builder, see UI Builder .

Note: 
The protection-policy is enforced to preserve dashboard pages for future upgrades. At any 
point, if you want to fall back to the default pages, you can delete the duplicate pages.

Create custom events to monitor

Create custom events and monitor them in the Conversational Analytics Dashboard.

Before you begin
Role required: Chat Analytics Admin.
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About this task
An event is a combination of conditions that apply to a subset of Virtual Agent  (VA) 
conversations. For example, an event might be conversations originating on a Slack channel that 
VA transferred to a live agent.

Most metrics you see on the dashboard, for example topic and conversation details, are derived 
from pre-built events. The dashboard displays these events on the Topics  and Conversations 
tabs. To build custom events, you can use the Custom Events feature. Use custom events to 
create analytics about data you're interested in, for example:

• Number of conversations on a Slack channel that transferred to a live agent.

• Number of conversations on a Slack channel where the user never returned.

Custom events appear on the Custom Events  tab. If you haven't configured any custom events, 
the dashboard won't display any. You can create up to 20 custom events.

Custom events take effect when you create them. You cannot use them to analyze data collected 
before you created the custom event.

Procedure

1. Navigate to All  > Conversational Analytics  > Event Configuration  and select New.
The Event New record page appears.

2. In the form, fill in the fields.

3. Click Submit.
The Events page appears, which lists all custom events. You've specified the table to look for 
custom events. Now, you must specify the parameter values that trigger the custom event.

4. Click the custom event you created.

5. In the Event Properties related list, select New.
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The Event Property New Record page appears where you specify the properties for a custom 
event that you want to track on the dashboard.

In this example, the Custom Event  tab shows metrics for Updated by  for the custom event, 
Messages-from-Slack.

6. In the form, fill in the fields.

7. Click Submit.
The Event page appears.

8. Click Update.
The Events page appears, which lists all custom events. You can open the Custom Events  tab 
on the dashboard to see the custom event. This custom event is not retroactive; the dashboard 
only displays new events that satisfy the custom event criteria.

Create custom override definitions

Use scripts to override the default formulas used to create the analytics on the Conversational 
Analytics Dashboard.

Before you begin
Role required: Chat Analytics Admin

Be sure to set the application scope to Conversational Analytics.

About this task
The Conversational Analytics Dashboard uses formulas to determine analytics, such as how to 
calculate duration. You can override the default formulas to tailor the analytics to your needs. For 
example, the default formula for duration in the dashboard is the time between the first and last 
exchanges in a conversation. You might like to override that formula by subtracting inactive times 
in the conversation.

The default formulas and formula overrides are in the sn_ci_analytics_formula_override table. 
You can only modify the existing formulas that are in the table by deactivating the default formula 
and creating a new formula override record. You cannot override some formulas because they 
are system dependent. You can, however, create custom events  to achieve a similar goal.

The default definitions are:

• Duration—Time from the start of a conversation session until the last message is sent, rather 
than when the conversation session closes. You cannot replace the supplied script for 
Duration. You can only turn it on or off. If you deselect the Active  check box, the duration is 
calculated until the end of the session. If you select the Active  check box, the duration is 
calculated to the last message sent.

• Self-solve rate—Number of conversations that did not have negative feedback, contained a 
topic that went through to the last node, and did not escalate to a live agent. The dashboard 
divides that number by the number of all conversations to get the rate.

• Feedback—Defined as positive, neutral, and negative. For example, to override this behavior, 
first, use Virtual Agent  (VA) Designer to create a ranking from 1 to 10. Then, you can use a script 
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to override the dashboard's default behavior by grouping 1–4 as negative, 5–7 as neutral, and 
8–10 as positive.

• End state—Defined by default in 12 ways. For more information, see Formula override 
examples.

• Valid conversation—Defined as a conversation record that is included in the dashboard results 
for satisfying at least one of the following criteria.

◦ Non-actionable notification conversations, which do not require validation from the user, are 
counted as active conversations.

◦ Actionable notifications that are not part of an existing conversation are considered valid 
conversations when the status of the notification is either Sent or Completed.

◦ Conversation engages Virtual Agent  topic discovery or direct live agent conversation.

Note: 
Formula overrides do not change the stored data. They only change how the dashboard 
displays the data by computing existing data in a different way.

Procedure

1. Navigate to All  > Conversational Analytics  > Formula Override.
Alternatively, you can enter sn_ci_analytics_formula_override.list  in the Filter 
Navigator to display the sn_ci_analytics_formula_override table.

2. Select the formula you want to override.
You cannot override the Duration formula, you can only activate or deactivate it. You can alter 
the scripts for other definitions. These are the only definitions you can alter.
The Formula Override page appears and shows the existing formula.

3. Copy the script in the Value Script field.
The default formulas are read-only. So, to modify them, you must make a copy.

4. Deselect the Active  check box to make the default formula inactive.

5. Click Update.

6. Click New  to create a formula override record that overrides the default formula.
The Formula Override New Record page appears.

7. In the form, fill in the fields.
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8. Click Submit.

Formula override example

Use the following formula override example to craft your own formula overrides.

Group End State definitions

The end state of a conversation specifies how a conversation ended. For example, it could end 
with the user not responding, or the user closed the chat window. There are 12 default definitions 
of end state. For more information on conversation end states, see Virtual Agent interaction 
records. The following script groups them as follows:

• VA closed the chat session

◦ System Closed VA – User No Response

◦ System Closed VA – Topic Complete

◦ System Closed VA – Left With AI Search

◦ System closed VA – Auto Closed

◦ System Closed VA – User Never Engaged

• Live agent closed the chat session

◦ System Closed LA – User No Response

◦ System Closed LA – Chat Complete

◦ Agent Closed LA – Clicked End/X

◦ System Closed LA – Before Agent Engagement

• User closed the chat session

◦ User Closed LA – Clicked End/X

◦ User Closed VA – Clicked End/X

◦ User Closed LA - Before Agent Engagement

To create these groupings of the 12 end states, follow the instructions for creating a formula 
override  and use the following script.

(function calc(convGr) {
    // Returns 'System Closed VA', 'System Closed LA', 'User 
 Closed' states.
    function getFinalEndState(state) {
        var arrayUtil = new global.ArrayUtil();
        VA_END_STATE = ['System Closed VA – User No Response',
            'System Closed VA – Topic Complete',
            'System Closed VA – Left With AI Search',
            'System closed VA – Auto Closed',
            'System Closed VA – User Never Engaged'
        ];
        LA_END_STATE = ['System Closed LA – User No Response',
            'System Closed LA – Chat Complete',
            'Agent Closed LA – Clicked End/X',
            'System Closed LA – Before Agent Engagement'
        ];
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        USER_CLOSED_END_STATE = ['User Closed LA – Clicked 
 End/X',
            'User Closed VA – Clicked End/X',
            'User Closed LA - Before Agent Engagement'
        ];
        if (state) {
            if (arrayUtil.contains(VA_END_STATE, state))
                return 'System Closed VA';
 
            if (arrayUtil.contains(LA_END_STATE, state))
                return 'System Closed LA';
 
            if (arrayUtil.contains(USER_CLOSED_END_STATE, 
 state))
                return 'User Closed';
        }
        return state;
    }
 
    var conversationId = convGr.getValue('sys_id');
    var interactionGr = new GlideRecord('interaction');
    interactionGr.addQuery('channel_metadata_document', 
 conversationId);
    interactionGr.addQuery('channel_metadata_table', 
 'sys_cs_conversation');
    interactionGr.query();
    if (interactionGr.next()) {
        var state = interactionGr.getValue('state');
        var reason = interactionGr.getValue('state_reason');
        var isVAChat = interactionGr.getValue('virtual_agent');
        var isLAChat = interactionGr.getValue('agent_chat');
        var endState = new CAUtil().getEndState(state, reason, 
 isVAChat, isLAChat);
        return getFinalEndState(endState);
    }
})(convGr);

Using the Conversational Analytics Dashboard

Use the Conversational Analytics Dashboard to get insights into Virtual Agent  (VA) 
conversations.

The following sections explain how to use the dashboard to investigate VA interactions 
with users. You must have the Chat Analytics Viewer (chat_analytics_viewer) role to use the 
Conversational Analytics Dashboard.

Set the date range of the data

Set the Start  and End  dates at the top of the Overview tab to specify the date range of the data 
summarized on a page. The date range set on this tab applies to all the other tabs on the Virtual 
Agent  Analytics dashboard.

Before you begin
Role required: Chat Analytics Viewer (chat_analytics_viewer)

About this task
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All dates and times on the dashboard are UTC. Even though the conversation table lists 
conversation dates and times in different time zones, Virtual Agent  (VA) converts them to UTC 
when displaying them on the dashboard. Additionally, if you select a preset date range, such as 
last week, the dates might be different from what you expect.

You can set the date range in two ways.

Procedure

1. Navigate to All  > Conversational Interfaces  > Conversational Analytics  > Virtual Agent 
dashboard.

2. Optional:  Use the Start  and End  dates to set the date range.

a. Select the Start  calendar icon ( ).

b. Double-select the start date on the calendar.

c. Select OK.

d. Select the End  calendar icon ( ).

e. Double-select the end date on the calendar.

f. Select OK.
The data displayed on the dashboard adjusts according to the data in the new date range.

3. Optional:  Use the Start  date calendar to set the date range.

a. Select the Start  calendar icon ( ).

b. Double-select the start date of the date range.

c. While holding down the control-key on the keyboard, double-select the end date.
The dashboard highlights the range of dates.

(Optional)

d. Select OK.

(Optional) The data displayed on the dashboard adjusts according to the new date range.
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Overview tab

Use the Overview tab to get a snapshot of some of the information collected in the 
Conversational Analytics dashboard.

The Overview  tab is the landing page for the dashboard. It provides a summary of the 
information on all the other dashboard tabs. To use the Overview  tab, you must have the Chat 
Analytics Viewer (chat_analytics_viewer) role.

Note: 
Now Assist  in Virtual Agent  Analytics appears in the left navigation only when you have Now 
Assist  in Virtual Agent  enabled.

For directions about using the widgets on the Overview  tab, see Explore the Virtual Agent 
Analytics Dashboard.

Visualized overall data

Visualisation descriptions

Deflection Count Number of deflection occurrences measured 
by the execution count of the Deflection topic 
block. A deflection occurs when Virtual Agent 
resolves or helps to resolve an issue for a user.

Deflection Pattern Number of deflections per deflection patterns.

KB Breakdown Titles of KB articles with the number of times 
they were presented as part of deflections.

Active VA users Cumulative number of unique active end users 
(not agents) who used the conversational 
interface.

Conversations Count of all interactive conversations initiated 
from the Virtual Agent.

VA success Percentage of conversations that were 
completed without escalation and with an 
intended topic flow.
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Visualized overall data  (continued)

Visualisation descriptions

Completed conversations are those that 
reach the end of a Virtual Agent  topic or 
conversation, are closed by the user, or are 
automatically closed.

Completed without escalation means that the 
conversation was not routed to a live agent, 
and the user did not give negative feedback. 
(Feedback types include negative, positive, 
neutral, and no feedback.)

Topic flows completed Percentage of topics that end users 
completed till the last node out of all topics 
invoked and ran.

Categories Number of completed conversations shown 
per the Topic Category.

Topics Number of occurrences when the user 
completed to the last node or left a 
conversation midway through for each topic.

User feedback Feedback Results categorized as good, 
bad and neutral. The Feedback results are 
calculated from the Feedback Setup Topic.

Note: 
Analytics Administrator can change how 
frequently the Feedback Setup topic 
show post-chat by changing the system 
properties.

Channels Number of conversations executed across the 
configured channels of the Virtual Agent.

Conversation end state Number of conversations that have ended in 
the OOTB Conversation End state.

Typical actions on the Overview  tab include:

• Selecting the arrowhead icon ( ) in any of the widgets to open other dashboard tabs that 
display more detailed information.

• Selecting the visualized data, for example, a bar in a bar chart, to get additional information 
about the data.

• Changing the date range of the data displayed.

• Selecting a tab inside one of the widgets to change the set of data displayed. For example, in 
Categories   bar chart, select the Incomplete  tab.

Note: 
Your Overview  tab might look different because it can be configured.
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Edit the Overview page

Add or subtract the widgets on the Overview  page to suit your users.

Before you begin
Role required: admin

About this task
The Overview  page displays widgets with links to all the dashboard data. You can edit the page 
to remove or add back widgets.

Procedure

1. Navigate to All  > Conversational Interfaces  > Conversational Analytics  > Virtual Agent 
Dashboard.

2. To add or remove widgets from the Overview  page, select Edit page.

Edit Overview page

The UI Builder  opens.

3. To add or remove components in the Conversational Analytics Dashboard, use the UI Builder .

Usage tab

The Usage  tab provides summary information about conversations.

The Usage  tab answers questions such as:

• What languages are used in conversations?

• What is the average duration of conversations on different days?

• How many Virtual Agent  (VA) conversations transition to live agents?

To access the Usage  tab, you must have the chat analytics admin role or the chat analytics 
viewer role.
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Usage tab

Selecting the data or pointing to the data in the visualizations displays additional information 
about the data.

Visualized usage data

Visualization Description

Conversation type Number of conversations escalated from VA to a live 
agent, initiated and completed in VA only, or initiated and 
completed by a live agent.

Average conversation duration Average duration of conversations in minutes. The duration 
is calculated from the beginning of the conversation to the 
last message sent.

Languages Languages used by users and the number of conversations 
in each language.

Topic sent via the Actionable 
notification

The number of actionable notifications delivered from virtual 
agent to the users for the selected time range, and the 
number and percentage of actionable notifications that 
users engaged with, and did not engage with.

Conversations tab

Use the Conversations  tab to view the list of Virtual Agent  conversations and details of each 
conversation that occurred during the selected date range.

All conversations from the Conversation table [sys_cs_conversation], that run on the Virtual 
Agent Designer  are listed on the Conversations page, except for notifications, open (ongoing) 
conversations, and previews.

Virtual Agent  conversations data is retained for a period of 90 days. The analytics data extracted 
from the conversations is retained for a period of two years.
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To access the Conversations  tab, you must have the Chat Analytics Viewer 
(chat_analytics_viewer) role. Conversation dates and times are in UTC.

Conversations page

Conversations tab benefits

The Conversations  tab enables you to do the following:

• Filter the list of conversations easily by using pre-built filtering options. For more information, 
see Filtering using list options.

• Filter the list of conversations based on a specific condition and save conditions for filtering. 
For more information, see Filtering using the Filter Editor.

• Learn more about each conversation, view the conversation transcript, and mark a 
conversation as a favorite. For more information, see Get conversation details.

• Export the list of conversations to a file. For more information, see Export the conversations list.

• Download the conversation transcript to troubleshoot individual conversations. For more 
information, see Download the conversation transcript.

Get conversation details

To get more information about a conversation, select one of the conversations in the list. The 
information appears on the side panel.
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Conversation details

To view and download  the conversation transcript, select the Transcript  tab.
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Conversation transcript

To view the conversation timeline, select the Timeline  tab.
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Conversation timeline

To tag a conversation as a favorite, you can select the star icon on the side panel. On the 
Conversations page, you can easily list the conversations that are marked as favorite using the 
Filter Editor.

Export the conversations list

To export the conversations list on the Conversations page to a file, select Export. In the Export 
pop-up window, specify the format for the file such as Excel, CSV, JSON, or PDF, and the delivery 
type such as email or download.

Note: 
You can export up to 1000 records only from the list on the page. This limit is not 
configurable.

Conversation information

The following table describes the summarized Virtual Agent  conversation information on the 
Conversations  tab.

User information

Column Description

Date Date of the conversation.

Duration Duration of the conversation.

User index Link to go to the User Details page. It's a unique number that the 
system creates and permanently assigns to a Virtual Agent  user. 
This number becomes a part of conversation records.

This number is not the same as the system user ID.

Channel Client software that the user used to chat.

Language Language used for the conversation.

End state How the conversation ended. For more information on various 
conversation end states, see Virtual Agent interaction records.
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User information  (continued)

Column Description

Topics Virtual Agent  topics that were invoked during the chat conversation.

Favorites Indicates whether the user is tagged as favorite.

Download the conversation transcript

To download the conversation transcript, select a conversation from the conversations list and 
click Download.

The conversation transcript .txt file includes various data elements such as user input, Virtual 
Agent  response, Flow Designer Integration Hub, flow action, custom controls, and topic block 
information for the selected conversation. This information helps Virtual Agent  administrators to 
troubleshoot conversations, for example, conversations where there were errors or transfers to a 
live agent. For more information on the .txt file, see Conversation transcript template.

Use filters in the Conversation tab

You can filter out conversation for a deeper understanding.

Filtering using list options

You use the list options to filter the conversations.

Note: 
The dashboard converts the dates to UTC, which might not match the dates in the 
conversations list.

List options

Option Description

All Lists all conversations.

VA Success List all conversations that are considered successful. You can 
edit the default formula that defines successful conversations by 
using formula overrides. For more information, see Create custom 
override definitions. In the base system, the default formula is set as a 
percentage of conversations that did not escalate to a live agent, did 
not have negative feedback, and contained a topic that went through 
to the last node.

Fallback Lists all conversations where Virtual Agent  didn't understand the user 
and used fallback text to prompt the user for additional information.

Live Agent Transfer Lists all conversations where Virtual Agent  transferred the user to a 
live agent.

Filtering using the Filter Editor

To filter the conversations, click View/edit filter  and use the condition builder in the Filter Editor 
pop-up window. You can either select a default filter from the list or create a new filter condition. 
For example, the following image shows a condition in the Filter Editor pop-up window. This 
condition lists conversations that use the Pizza Order  topic, and that have the Pizza Type  topic 
node (a static choice control) in which the user has selected the Pepperoni  value.
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Condition using a static choice value

Another example condition is shown in the following image. This condition lists conversations 
that use the Pizza Order  topic and that have the Confirm  topic node (a boolean control) in which 
the user has selected the true  value.

Condition using a boolean value

The condition builder consists of the following:

• Field: A list based on relevant tables. For more information about the field options, see Field 
options in the Filter Editor.

• Operator: A list of operators that is contextually generated based on the selected field.

• Value: A text entry field or a list that is contextually generated based on the selected field.

To add a dependent condition in the condition builder, either click or  or and. To filter the 
conversations list using the condition, click Run.

To remove a condition, click the delete icon ( ) next to the condition.

To save a condition that you created in the condition builder, click Save Filter. In the Save 
Filter pop-up window, specify a name for the condition. Users having the Chat Analytics Viewer 
(chat_analytics_viewer) role can select and modify your saved filters.
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Saved condition

Field options in the Filter Editor

Field options

Option Description

Channel Conversations that used the specified channel.

Conversation Time Conversations within the specified date and time.

Duration Conversations within the specified time duration. You can edit the 
definition of duration to be a session duration, rather than an active 
messaging duration. For more information, see Create custom 
override definitions.

End State Conversations with the specified state that is based on how 
conversations ended. The values for the end states are stored in the 
Interactions [interactions] table. For more information, see Virtual 
Agent interaction records.

Events Specific events that are triggered in a conversation.

Favorite Conversations that are marked as favorite. You can also mark 
a conversation as favorite in the User Details page. For more 
information, see User Details page.

Feedback Result Conversations for the specified feedback type.

Language Conversations for the specified language based on the user's 
language setting.

Message Count Conversations for the specified message count in the chat.

Provider Name Conversations for the specified provider.

VA Success Conversations resolved by the Virtual Agent.

Setup Topic Types Conversations that used the specified setup topic type.

Topic Blocks Conversations that used the specified topic block.

Topic Categories Conversations that have topics which belong to a specified topic 
category.
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Field options  (continued)

Option Description

Topic Count Conversations that used the specified topic count. Each conversation 
can use multiple topics and this option filters conversations based on 
the count of topics used in it.

Topics Conversations that used the specified topics in the chat.

Type Conversations that are of the specified type such as live agent only or 
Virtual Agent  only.

Conversation transcript template

The conversation transcript .txt file contains information used to troubleshoot individual 
conversations.

Data element Description

Conversation 
ID (sys_id)

Unique identifier of the conversation, autogenerated by the Virtual Agent.

Conversation 
Start Time

Start time of the conversation.

Channel Channel from which the conversation was initiated. For example, the Slack 
application, Microsoft Teams, and so on.

User Name Name of the user who initiated the conversation.

User Status Status of the user in the ServiceNow AI Platform®  instance. For example, 
Active or Inactive.

Bot Response Control that displays Virtual Agent  responses in a conversation.

User Input Control that prompts and captures information from the user in a 
conversation.

Message Date 
and Time

Timestamp of individual messages.

FDIH logs Action or Subflow

• Id: sys_id of the action or subflow.

• Inputs: Input passed to the action or subflow.

• Outputs: Output received from the action or subflow.

Topic Block Name of the topic block defined in the current topic.

• Id: sys_id of the topic block invoked.

• Inputs: Input passed to the topic block.

• Outputs: Output received from the topic block.

Users tab

Get detailed information on Virtual Agent  users such as the time of the last chat, length of the 
chat, and other metrics.
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The Users  tab provides summary information about all users and detailed information about 
each user conversation with Virtual Agent.

To access the Users  tab, you must have the Chat Analytics Viewer (chat_analytics_viewer) role.

Users page

Users tab benefits

The Users  tab enables you to do the following:

• Filter the list of users by using pre-built filtering options. For more information, see Filtering the 
list of users.

• Filter the list of users based on a specific condition and save conditions for filtering. For more 
information, see Filter using the condition builder.

• View summarized information about users. For more information, see User information.

• Export the list of users to a file. For more information, see Export the list of users.

Export the list of users

To export the list of users in the Users page to a file, select Export. In the Export pop-up window, 
specify the format for the file such as Excel, CSV, JSON, or PDF, and the delivery type such as 
email or download.

Note: 
You can export up to 1000 records only from the list on the page. This limit is not 
configurable.

User information

The following table describes the summarized Virtual Agent  user information on the Users tab.

User information

Column Description

User Index Link to go to the User Details page. It is a unique number that the 
system creates and permanently assigns to a Virtual Agent  user. 
This number becomes a part of conversation records.
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User information  (continued)

Column Description

This number is not the same as the system user ID.

User ID User ID of the logged in user. If users don't log in, they appear in 
sessions as Anonymous.

First conversation How long ago the user first started the Virtual Agent  conversation.

Last conversation How long ago the user last had a Virtual Agent  conversation.

Time on Chat Duration of the Virtual Agent  chat.

Last Used Channel Client software the user last used to chat.

Last Used Language Language the user last used in a Virtual Agent  conversation.

Favorite Indicates whether the user is tagged as favorite.

Field options in the Filter Editor

User filters

Option Description

User ID User ID of the logged in user.

User Index Unique number that the system creates and permanently assigns 
to a Virtual Agent  user. This number becomes a part of conversation 
records.

Conversation Exists Container for subfilter properties. For example, in the previous 
image, the subfilter is Duration.

Channel Count Number of channels a user used. A channel is the client app the 
user used, such as Slack. For example, if all users have used only 
one channel to chat with Virtual Agent, then setting the filter value to 
2 eliminates all the users in the list.

Channels Only displays users that used the specified channel to chat.

Conversation Count Only displays users that have the number of conversations specified 
in the filter.

Favorite Only displays users that you marked as favorite, or conversely, not 
marked as favorite in the User Details page. For more information, 
see User Details page.

First Conversation Time Only displays users where the first conversation is within the time 
period specified.

Language Only displays users that chat using the specified language.

Last Conversation Time Only displays users where the last conversation is within the time 
period specified.

Time in Chat Only displays users whose chat durations are within the time period 
specified, for example, more than 30 seconds.

User Details page

Use the User Details page to see the history of a user's conversations.
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The User Details page lists all chats that a user had with the Virtual Agent. It also displays the 
summary such as the language used in the chats, the first and last chats, and the channels.

User details page

You can select the star icon on the User Details page to tag the user as a favorite. In the Users 
page, you can easily list the users that are marked as favorite using the Filter Editor.

Benefits

The User Details page enables you to do the following:

• View detailed information about each chat, and mark chats as favorite. For more information, 
see Get information about each chat.

• View details about each user. For more information, see Get information about each user.

Get information about each chat

You can get more information about a chat that a user had with the Virtual Agent. To get detailed 
information about one of the chats listed on the User Details page, select a date in the list of 
conversations. The information appears on the side panel.
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Chat details

To view the chat transcript for a user's conversation, select the Transcript  tab.

Conversation transcript

To view the chat timeline, select the Timeline  tab.
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Timeline

The Timeline  tab shows the topic flow in the chat. For example, the following image shows that 
the chat started in Virtual Agent  and moved to a live agent.

Topic flow

The timeline shows that the user chatted with Virtual Agent  until 5:25. Then the user requested 
to talk to a live agent, who joined the chat at 5:32. The timeline shows events such as how many 
responses Virtual Agent  made, and when the live agent closed the chat.

Timeline log
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To tag the chat as favorite, select the star icon on the side panel. On the Conversations page, you 
can easily list the chats that are marked as favorite using the Filter Editor. For more information, 
see Conversations tab.

Get information about each user

The following table explains the fields in the User Details page:

Details

Field Description

User ID User ID of the logged in user. If users don't log in, they appear in the 
sessions as anonymous.

First conversation How long ago the user first started the Virtual Agent  chat.

Last conversation How long ago the user last had a Virtual Agent  chat.

Time in chat Duration of the Virtual Agent  chat.

Languages Language the user used in the chats.

Channels Software that the user used to chat.

Use filters in the Users tab

You can use filters to get a deeper understanding of User data.

Filter using the condition builder

The condition builder enables you to filter users based on one or more conditions. You can either 
select a default filter from the list or create a new filter condition. In the following example, the 
condition lists users whose conversations with the Virtual Agent  lasted greater than 21 seconds.

Condition builder

The condition builder consists of the following:
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• Field: A list based on relevant tables.

• Operator: A list of operations that is contextually generated based on the selected field.

• Value: A text entry field or a list that is contextually generated based on the selected field.

To remove a condition, click the delete icon ( ) next to the condition. To add dependent 
conditions in the condition builder, either click or  or and. To filter the conversations list using the 
condition, click Run.

To save a condition that you created in the condition builder, click Save Filter. In the Save 
Filter pop-up window, specify a name for the condition. Users having the Chat Analytics Viewer 
(chat_analytics_viewer) role can select and modify your saved filters.

Saved condition

Filtering the list of users

Use the list options to filter users.

List options

Option Description

All All Virtual Agent  users.

New First conversation happened within the past seven days.

Returning Users who previously used Virtual Agent.

Never Returned Users who used Virtual Agent  once, but haven't used it again. The 
conversation count is 1.

Selecting a User Index  takes you to the User Details page  that provides detailed information 
about all of a user's conversations.
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Field options in the Filter Editor

User filters

Option Description

User ID User ID of the logged in user.

User Index Unique number that the system creates and permanently assigns 
to a Virtual Agent  user. This number becomes a part of conversation 
records.

Conversation Exists Container for subfilter properties. For example, in the previous 
image, the subfilter is Duration.

Channel Count Number of channels a user used. A channel is the client app the 
user used, such as Slack. For example, if all users have used only 
one channel to chat with Virtual Agent, then setting the filter value to 
2 eliminates all the users in the list.

Channels Only displays users that used the specified channel to chat.

Conversation Count Only displays users that have the number of conversations specified 
in the filter.

Favorite Only displays users that you marked as favorite, or conversely, not 
marked as favorite in the User Details page. For more information, 
see User Details page.

First Conversation Time Only displays users where the first conversation is within the time 
period specified.

Language Only displays users that chat using the specified language.

Last Conversation Time Only displays users where the last conversation is within the time 
period specified.

Time in Chat Only displays users whose chat durations are within the time period 
specified, for example, more than 30 seconds.

Topics tab

Use the Topics  tab in the Conversational Analytics dashboard to identify the least and best 
performing topics.

The Topics  tab provides insights into which Virtual Agent  (VA) topics are performing well 
and which aren’t. You can also select multiple topic categories using the Select Categories 
dropdown to visualize data based on your selection.  To use the Topics tab, you must have the 
Chat Analytics Viewer (chat_analytics_viewer) role.
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Worst performing topics

The Worst performing topics chart provides multiple ways of detecting chat topics that didn't 
work. The horizontal axis lists the chat topics. The subtabs include:

• Least used—The topics used least in chats.

• Incomplete—The topics the user abandoned without resolution.

• Transfer to Live Agent—The topics the user couldn't resolve with Virtual Agent. So, the user 
transferred to a live agent.

Best performing topics

The topics in this chart are performing well. The horizontal axis lists the topics. The count on the 
vertical axis varies depending on the subtab selected:

• Most Used—Number of times users used a topic.

• Complete—Number of times users completed a topic without the assistance of a live agent.

Spokes used

For more information about the spokes used, see Spokes.

List of topics

The Topics  page list the topics used in the date range specified in the Conversational Analytics 
Dashboard.
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Topic details

Topic information Description

Correct NLU Prediction 
%

Percentage of times this topic name was predicted correctly out of all 
times this topic name was predicted. A correct prediction means that 
VA showed that a predicted topic and a user selected it.

Initiated % Percentage of times this topic ran out of all the topics that ran.

Incomplete % Percentage of times the user didn't reach the last node in the 
topic out of all times this topic ran. For example, if the 2 users 
didn't complete all the nodes in a topic but 8 other users did, the 
incomplete percentage would be 20%.

Transfer to Live Agent % Percentage of occurrences where this topic transferred from VA to a 
live agent out of all the time this topic ran.

List of topic blocks

The Topic Blocks  page list the topic blocks used in the date range specified in the 
Conversational Analytics Dashboard.

The chart shows the number of times each topic block was executed.

Topic categories

Use the Category page in the Conversational Analytics dashboard to see the performance of 
Virtual Agent  (VA) topics divided into categories.

Topic categories group related conversation topics. Topics can belong to more than one 
category. Select the drop-down list to show the categories that you can display in the 
visualizations. The visualizations show the aggregate performance of Virtual Agent  conversations 
that ran in the topics belonging to a category.
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For more information about creating or modifying VA categories, see Create or modify custom 
categories.

Topic category visualizations

Visualization Description

Conversation end state The number of users that reached a specific node in a topic in 
the VA category. In the example, six users reached the node 
labeled, System closed VA - Auto Closed. Use this field to see 
where topics stopped working for users.

For definitions of each conversation end state, see Virtual 
Agent interaction records.

Transfer to live agent The number of users that transferred from VA to a live agent in 
that VA category. A high number indicates that the topic is not 
meeting user needs.

Topic usage trend Number of topics users used in a specified topic category over 
the course of the date range. The example shows the number 
of topics per day users used in the IT category. Use this field to 
monitor updates to topics.

Channel The application the user used to chat with VA in that topic 
category, for example, Slack or web client.

Channel usage trend Number of users using a specified channel over the course of 
the date range for topics in that VA category.

Topics details

Use the Topic Details page in the Conversational Analytics dashboard to see the details of the 
Virtual Agent  (VA) topics.

Get additional information about the topics

You can select the visualized data selecting the topic from the list. Details about the data you 
selected displays.
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Note: 
The Y axis is evenly divided over 10 increments. If there are fewer than ten values on the Y 
axis, some values repeat, for example, five 1's in the previous image.

Use the list menu to display one of the chat interactions in the topic you selected. This page 
shows:

• Topic Usage—The number of times the topic was used each day.

You can display the number of occurrences and user sessions of the selected topic by 
selecting Download.

In this example, one chat session happened on 2020-12-16.

• Topic completion—Number of times the user went to the final node in the topic.

• Live Agent Transfer—Number of VA chats transferred to a live agent.

• Last Visited Node—Last nodes users visited before leaving the chat.

The presumption is the user gave up after the last node they visited.
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Spokes

Use the Spokes page to see the details of the spoke actions and subflows for the Virtual Agent 
(VA) topic.

Spokes used

The Spokes used  chart shows which spokes, actions, and subflows were used and how often. 
In Virtual Agent, conversations contain topics, topics contain spokes, and spokes contain spoke 
actions or subflows. Selecting a spoke from the list displays the following details.

The three charts show:

• Spoke Usage—The number of times the specified spoke ran each day.

You can display the number of occurrences and user sessions of the selected topic by 
selecting Download.

• Actions and Subflows—Within the specified spoke, which actions and subflows were 
executed. In the previous Actions and Subflows  chart, one action, Create Freeform VTB was 
triggered 22 times.

• Topics—Which topics executed the spoke. The horizontal axis in the Topics  chart shows the 
topics that triggered the spoke. The vertical axis shows how many times the topic triggered the 
spoke.

Natural Language Understanding  of Virtual Agent  responses

Virtual Agent  (VA) uses the Natural Language Understanding  (NLU) service to understand user 
input. Use the NLU Prediction  tab to see how well NLU predicts intents, and to improve the 
intents so NLU makes better predictions.

The NLU Prediction  tab on the Conversational Analytics Dashboard shows how well NLU is 
understanding user input in chat conversations. Virtual Agent  comes with NLU models, but you 
can use the Activate the  NLU Workbench  to modify or create new models.
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To use the NLU Prediction tab, you must have the Chat Analytics Viewer (chat_analytics_viewer) 
role.

NLU Prediction graph

The graph shows the daily performance of NLU predictions. The graph can show up to three 
lines, which represent:

• Correct Predictions—NLU predicted multiple intents and showed them to users. They selected 
one.

• Incorrect Predictions—NLU predicted multiple intents and showed them to users. They 
indicated that none of them were what they were looking for.

• Auto Selected Predictions—NLU predicted a single intent based on chat input from the user. 
Sometimes, NLU returns multiple topics, each from a separate intent, and the user selects one.

The example graph only shows Auto Selected Predictions. On 2021-01-27, one intent was auto-
selected, and on 2021-01-31, two intents were auto-selected.

Note: 
The vertical axis can have duplicate values because the axis has 10 increments. If the 
number of intents is less than 10, some values on the vertical axis appear more than once. 
For example, in the previous image, the maximum number of intents of all the days in the 
date range is 5. So, on the vertical axis there are two 1s, two 2s, two 3s, and so forth.

How are these values determined? The dashboard collects the following data:

1. Did the NLU prediction model determine an intent?

2. Did the predicted intent match the topic bound in the model to the intent?

3. What's the prediction score and did the dashboard show multiple options to the end user 
to specify the correct intent, or did the dashboard just display the topic associated with one 
intent.

4. After showing the user multiple intents, did the user select one?

The Conversational Dashboard uses the following algorithms on the data to populate the intent 
lists:
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• Correct Predictions—1, 2, 3, and 4 are true.

• Incorrect Predictions—4 was false.

• Auto Selected Predictions—3 was auto-selected, and there was no 4.

It's possible for intents to appear in several categories. For example, the Activate Account (Ben) 
intent appears in the Correct Predictions  and the Auto Selected Predictions  columns because 
NLU correctly predicted the intent and only presented a single response to the user.

Improving NLU predictions

Clicking anywhere on the graph opens the Model Performance page. It shows a summary of 
intents predicted or not predicted over the date range specified on the graph.

See Activate the  NLU Workbench  to see how to use the NLU Workbench to improve NLU 
predictions.

Modify models

Test and modify the Virtual Agent  models so they more accurately predict user intents.

Before you begin
Role required: Chat Analytics Admin

About this task
Many ServiceNow  products, such as ITSM, HRSD, and CSM include NLU models for Virtual Agent 
(VA) topics. The NLU plugin contains entities that are common across all products. You can 
modify those models. To learn how to train and test the models used for VA conversations, see 
Natural Language Understanding .

Procedure

1. Navigate to All  > Conversational Interfaces  > Conversational Analytics  > Virtual Agent 
Dashboard  and select the NLU Prediction  tab.

2. Select  View more  .

The Models page opens that displays the models that predict intents in your setup.
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3. Optional:  If none of the models contain intents and utterances you'd like in your setup, select 
Create Model  and follow the instructions in Create an NLU model .

4. Click a model to display the intents the model predicts.

5. Optional:  Click an intent to display the utterances associated with it.

(Optional)

6. Optional:  To create a new intent and add it to the model:

a. Select New Intent.
The Create a new intent  dialog box opens.

b. Enter the name of the new intent in Intent Name, a description of it in the Description  field, 
and select Save.
A page for your new intent opens.
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(Optional)

c. Enter an utterance for your new intent and select Add.
You can repeat this step multiple times to add multiple utterances.

7. Optional:  Import one or more intents by selecting Import Intents.
The Import Intents  dialog box opens, which displays the intents you can 

import.

a. Find the intent(s) to import by entering a search term, or by clicking an arrowhead to display 
the intents in a folder, and then selecting one or more check boxes.

b. Select Import.

8. Optional:  If you added or imported intents:

a. Select Train  to add the intents to the model.

b. Select Train  to train the model.
If successful, a banner at the top reads, The model has been successfully trained.

9. To test all the utterances, select Test  and enter a sentence a user might enter in a chat to see if 
NLU understands the intent of your sentence.
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10. If the models fail to predict the intent, add additional intents to the model, or utterances to the 
intents, as described in step 6.

Using user search metrics with Virtual Agent

By using user search metrics with the Virtual Agent  application, you can see your users' queries 
and the results from their searches. With these metrics, you can identify the areas where you can 
improve Virtual Agent  to offer more meaningful search results.

Use the User Search Metrics  tab in the Conversational Analytics dashboard to see the key 
details about the queries that your users searched on and their search results. By using this tab, 
you can get the answers to the following questions:

• Which search results were not useful to the users?

• Which queries did not have any search results?

• Which were the most common queries from users?

• Which search results did the users select most often?

Note: 
You can also use Financial Services Remote Tables  to view user-search data in 
Dashboards. For more information, see Remote tables.

To access the User Search Metrics  tab, you must have the chat analytics admin role or the chat 
analytics viewer role. The following example shows the data included in the User Search Metrics 
tab.
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User Search Metrics tab

AI Search

Virtual Agent  topics may use AI search to suggest helpful resources to the user. When a user 
enters a query, AI search provides the most relevant results by using intelligent query features. 
To know more about AI search, see AI Search  . To integrate Virtual Agent  with AI Search, see 
Improving the user experience with AI Search.

Contextual Search

Contextual search matches keywords to an existing database search to find potential matches to 
a query. Virtual Agent  topics may use contextual search to resolve queries. For more information, 
see Maximizing code reuse with topic blocks.

Topic Links

Some Virtual Agent  topics have links to useful resources that are embedded within them. When a 
user invokes one of these topics, the link shows up without having to do any back-end search.

User Search information

The following table describes the summarized User Search information that is visualized on the 
User Search Metrics  tab.

User search data

Visualization Description

Queries with no clicks Queries that users did not click on any of the 
search results.

Queries with no results Queries that did not yield any search result.

Trending queries Queries that users most commonly asked.

Trending content Search results that most users clicked on.
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Custom Events tab

Use the Custom Events tab to see the list of custom events created for Virtual Agent.

To use the Custom Events tab, you must have the Chat Analytics Viewer (chat_analytics_viewer) 
role.

The Custom Events tab shows the dates when custom events were triggered. If no one created 
custom events, the list of custom events is empty. The maximum number of custom events 
displayed is 20.

Use the drop-down list to specify the custom event you want analytics for.

The graphics are unique for each custom event. For more information about them, consult the 
person who created the custom event.

Funnels tab

Funnels provide cumulative filtering of conversation flows. Using funnels, you can identify 
whether your conversation flows are performing effectively when users chat with Virtual Agent.

Funnels page

 Funnels demo  Watch this video for an overview of Funnels.

Overview of funnels

Funnels filter conversation flows using steps that are defined when a user creates the funnel.
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A funnel can contain up to 10 filtering steps for a conversation flow. Each subsequent step further 
refines the results from the previous step. This type of cumulative filtering helps you to easily 
narrow down on the data of interest at each step of the conversation flow.

When you run a funnel for a particular date range, the system displays the following metrics that 
show the number of users at each step:

• The percentage and number of users who have used the specified conversation flow.

• The percentage and number of users who proceeded to the next conversation step specified 
in the funnel.

• The percentage of users who dropped off at a particular conversation step.

• The percentage and number of users who completed all specified conversation steps in the 
flow.

• The biggest drop-off point or step where users left the conversation flow.

Each step in a funnel consists of the following:

• Field: The item on which the step is evaluated.

• Operator: A list of operators that is contextually generated based on the selected field.

• Value: A text entry field or a list that is contextually generated based on the selected field.

For more information about filtering options in steps, see Filter options in funnels.

Use case for funnels

Consider an example scenario where an admin has to get insights about how Virtual Agent  is 
handling user queries in a conversation flow. To review the efficiency of the conversation flow, 
the admin might look for information such as the following:

• What percentage or number of users have interacted with Virtual Agent.

• Out of the users who interacted with Virtual Agent, what percentage or number of users have 
followed a specific node in the topic during the conversation.

• Out of the users who used the specific node, what number of users requested for a transfer to 
a live agent.

For example, see the following funnel for fetching metrics on a conversational flow that provides 
software access.

Funnel

Here, the funnel has three filtering steps:
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• Step 1 fetches users who have followed the Software Access  topic while interacting with the 
Virtual Agent.

• Out of the retrieved users from step 1, step 2 fetches users who requested for a drive access in 
the Drive Flow Executed  node.

• Out of the retrieved users from step 2, step 3 fetches users who requested transferring to a live 
agent.

Metrics for funnels

Using Funnels, you can easily filter conversation flows and get information as metrics. Metrics 
indicate what percentage or number of users are active at each step of the conversation flow.

You can improve the conversation flows based on the performance metrics derived from using 
funnels. The metrics help identify opportunities for improving conversation flows so that Virtual 
Agent  can handle your user queries better.

Using the previous example, that funnel displays the following metrics:

Metrics for funnels

Here, the metrics indicate the following for the selected date range:

1. 134 users followed the Software Access topic.

2. Out of these 134 users, 85 users requested for a drive access.

3. Out of these 85 users, 23 users requested for transferring to a live agent.

These example metrics indicate an opportunity for improvement because 23 users requested for 
a transfer to a live agent.

Other benefits of using funnels

Users can create funnels to get insights on their conversation flows. Additionally, they can 
edit and delete existing funnels created by other users. For more information, see Create and 
manage funnels.
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You can compare the performance of previous and current conversation flows. Funnels show 
metrics for the specified date range. Additionally, it shows the comparison for the same number 
of days in the date range prior to the specified start date. You can know the increase or decrease 
in users who have made through all the steps.

Previous metrics

Create and manage funnels

Use funnels to review the performance of your conversation flows.

Before you begin
Role required: chat_analytics_viewer, virtual_agent_admin, chat_analytics_admin, or admin

About this task
You can create, edit, and delete funnels.

Procedure

1. Navigate to All  > Conversational Interfaces  > Conversational Analytics  > Virtual Agent 
Dashboard.

2. Click the Funnels  tab.

3. Click New funnel.
The Create a new funnel page appears.

4. In the Give this funnel a name  field, provide a meaningful and short name for the funnel.

Note: 
Funnel names must be unique, so provide a different name for each funnel.

5. To create steps for filtering the conversation flow, click Add new step.
A funnel can contain up to 10 filtering steps. Each subsequent step further refines the results 
from the previous step. This type of cumulative filtering helps you easily narrow down on the 
data of interest in the conversation flow. For more information about the filtering options, see 
Filter options in funnels.

6. To define a step, click or  and add an OR condition.

If needed, you can do any of the following with your steps:

◦ To remove an OR condition, click the delete icon ( ) next to it.

◦ To reset a step, click the delete icon next to it.

◦ To remove the step, click the delete icon again.

7. Click Create funnel.
The metrics for the conversation flow appear. You can select a date range in the Start  and End 
fields for reviewing the metrics.

8. Optional:  To edit a funnel, click the funnel name on the Funnels page, and then click Edit 
funnel.

9. Optional:  To remove a funnel, click the funnel name on the Funnels page, and then click 
Delete.
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Filter options in funnels

Use filter options for creating steps in funnels. You can create steps in funnels for cumulative 
filtering of a conversation flow.

Overview of filter options

You can define each step depending on your data of interest in the conversation flow. For more 
information, see Funnels tab.

A step consists of the following:

• Field: The item on which the step is evaluated.

• Operator: A list of operators that is contextually generated based on the selected field.

• Value: A text entry field or a list that is contextually generated based on the selected field.

The field options are listed in the following table:

Field options

Option Description

Conversation start (1st) New users who had a conversation with Virtual Agent.

Conversation start (Any) All users who had conversations with Virtual Agent. This 
option includes all users regardless of the number of times 
the users have interacted with Virtual Agent.

Events Events that are triggered in a conversation.

Topic List of all topics that were used in the conversation flow. The 
list of topics can be refined further to these topic types:

• Setup topics: List of topics that provide basic 
conversational flows such as the conversation greeting or 
closing.

• Standard topics: List of topics only and not topic blocks or 
pre-built topics.

• Topic blocks: List of topic blocks only.

Note: 
When a funnel contains topics that were modified, 
for example, nodes were added or removed, after the 
funnel was created, the funnel does not consider those 
changes. You have to create a new funnel to account for 
those changes.

Issue auto-resolution tab

The Issue auto-resolution  tab helps you understand how well your Virtual Agent  (VA) chatbot 
anticipates user needs. It displays information about the number of user issues intercepted by 
the auto-resolution service and resolved by VA.

Issue auto-resolution takes place when a user is diverted to VA from a non-conversational 
interface. For example, a user might request a new keyboard through a service portal or email. 
The auto-resolution service can detect the user request and use VA to resolve the user's request 
in a VA chatbot session. For more information, see Auto Resolution for Virtual Agent.
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The data visualizations in the Issue auto-resolution  tab displays how well the auto-resolution 
service is working. This tab is available only when Issue Auto Resolution is enabled and the Auto 
Resolution Configuration  record is set as active.

To access the Issue auto-resolution  tab, you must have the chat analytics admin role or the chat 
analytics viewer role.

Issue auto-resolution tab

Selecting the data or pointing to the data in the visualizations displays additional information 
about the data.

Auto-resolution visualizations

Visualization Description

Intents with Matched Topics Number of intents that match topics enabled 
for auto-resolution.

Intents without Matched Topics Number of intents that do not have matching 
topics.
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Auto-resolution visualizations  (continued)

Visualization Description

Intents with Auto-resolution Disabled Number of intents that match topics not 
enabled for issue auto-resolution.

Intent and topic matching results Breakdown of incidents by intent matching. 
For example, incidents with matching intents 
and topics, and incidents without matching 
intents.

Trends in intent and topic matching Trend showing incidents that have intents with 
or without matching topics.

Auto resolution conversations Issue auto-resolution conversations that were 
resolved and unresolved. Resolved means 
incidents are in the resolved state after the 
users interacted with VA.

Auto resolution conversation trends Usage trend showing all the issue auto-
resolution conversations and how many 
incidents were successfully resolved.

Issue auto-resolution acceptance rate Shows the issue auto-resolution notifications 
that were accepted and declined by users.

Top topics in auto resolution conversations Frequently used topics in auto resolution 
conversations.

Conversational Analytics dashboard reference

Reference topics provide descriptions about the Conversational Analytics dashboard roles and 
system parameters to configure the dashboard.

Conversational Analytics dashboard roles

Conversational Analytics dashboard is installed with these roles.

To learn more about managing subscriptions, see Managing per-user subscriptions in 
Subscription Management  and contact your account representative.

Virtual Agent administrator  [virtual_agent_admin]

Provides read and write access to all dashboard-related tables, for example, sys-conversation.

Contains Roles

List of roles contained within the role.

• chat_analytics_admin

• ui_builder_admin

• chat_analytics_viewer

Groups

List of groups this role is assigned to by default.

None.
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Special considerations

Note: 
Avoid granting an admin role when more specialized roles are available.

Chat analytics administrator  [chat_analytics_admin]

Provides access to view dashboard-related tables, create custom events, create custom formula 
overrides, reconfigure the dashboard using UI Builder, and set system parameters.

Contains Roles

List of roles contained within the role: chat_analytics_viewer.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

Note: 
Avoid granting an admin role when more specialized roles are available.

UI builder administrator  [ui_builder_admin]

Enables you to add, remove, and rearrange dashboard contents. Needs UI Builder, which is a 
separate ServiceNow  product.

Contains Roles

List of roles contained within the role.

• workspace_admin

• canvas_user

Groups

List of groups this role is assigned to by default.

None.

Special considerations

Note: 
Avoid granting an admin role when more specialized roles are available.

Chat analytics viewer  [chat_analytics_viewer]

Provides read access to view the dashboard.

Contains Roles

List of roles contained within the role: sn_ace.ace_user.
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Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

System parameter configuration

Use system parameters to configure some of the Conversational Analytics Dashboard.

Use the following system parameters to reconfigure Conversational Analytics Dashboard 
functionality. You must have the role, Chat Analytics Admin.

Dashboard system parameters

Functionality System parameter Description

Debug sn_ci_analytics.logging.verbositySet this parameter to "debug" to see the 
debug logs for conversational analytics. The 
setting makes the logs verbose with debug 
information.

Reasons sn_ci_analytics.ca.reason_maxSets the maximum length of reason strings. 
The default is 1000 characters.

Virtual Agent  reference

Reference topics provide descriptions about the Virtual Agent Designer  interface components 
and technical details to learn more about scripting methods, Natural Language Understanding 
system entities, and the Virtual Agent  Interactions table.

Virtual Agent Designer  interface reference

The Virtual Agent Designer  interface lets you create, modify, test, publish, and localize topics, 
topic blocks, and custom controls.

Virtual Agent Designer  provides the following views. Some tabs may not be available, depending 
on how you configured your instance or the type of topic you are working with.

• Virtual Agent Designer Topics page

• Create a topic form

• Topic Properties tab

• Topic Flow tab

The topic Flow tab contains the following elements:

◦ Virtual Agent Designer controls

◦ Virtual Agent Designer user input controls

◦ Virtual Agent Designer bot responses

◦ Virtual Agent Designer utilities

• Topic NLU Intent tab  (visible if the topic type is NLU)

• Topic Languages tab
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Virtual Agent Designer  Topics page

The Virtual Agent Designer  Topics page lists all objects in your instance. These objects include 
topics, topic blocks, custom controls, setup topics, and small talk topics.

Topics page

Topic cards

Each topic is represented by a card on the topic page. A description of the topic 
(from the Properties tab) appears when you hover on the title, and all categories 
are shown when you hover on the list of tags. Options to promote or demote (if it 
uses LLM topic discovery) or delete the topic appears when you hover on the Topic 

actions ( ) icon. For more information, see Promote or demote Virtual Agent LLM 
topics

Filters and options in the Topics page

Field Description

Migrate Topics to 
LLM

Button that opens the NLU  to LLM topic migration workflow. For more 
information, see LLM topic migration.

Localization 
Insights

Button that opens the Localization Insights dashboard. It shows reports 
of topics with their translation statuses. For more information, see 
Localization Insights dashboard .
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Filters and options in the Topics page  (continued)

Field Description

See Topic 
Recommendations

Button that opens Topic Recommendations (if installed). Review 
recommendations and manage jobs. For more information, see Using 
Virtual Agent Topic Recommendations.

LLM Assistant Filter that lets you view objects associated with a large language model 
(LLM) assistant. If a topic block or custom control isn’t associated with 
an LLM assistant, but is called by a topic that's associated with an LLM 
assistant, those objects appear in this filtered LLM assistant view. Nested 
topic blocks or custom controls don’t appear in the filtered view unless 
they’re directly associated with an LLM assistant. If you select an LLM 
Assistant, the Manage languages  and Manage NLU/keyword test cases 
options disappear from the Topics page.

This option is only visible when Now Assist  in Virtual Agent  is installed. For 
more information, see Configuring Now Assist in Virtual Agent.

Tip: 
Either a Settings  or Manage  option appears next to the LLM 
Assistant  filter. Settings  appears if there is a specific LLM assistant 
selected in the LLM Assistant  filter and Manage  appears if no 
assistant is selected in the filter. Use this option to quickly navigate to 
the Conversational Interfaces guided setup area to review or update 
your LLM assistants.

Manage 
languages

Button that opens the Manage languages page. You can view the 
localization status of an NLU  model and request translations for the model 
and related topics.

This field is available only when NLU  discovery is enabled on the instance.

Manage 
NLU/keyword test 
cases

Button that opens the Manage test cases page, where you can manage 
automated testing for Virtual Agent  topics. For more information, see 
Automated testing for Virtual Agent topics that use NLU topic discovery.

Test Active Topics
Button that opens the chat test window, which runs active topics in the 
Virtual Agent  web client. This option becomes a drop-down menu only 
when Now Assist  for Virtual Agent  is installed. The drop-down menu 
options specify which types of topics you want to test:

• Test NLU/keyword topics

• Test LLM topics

Note: 
Topics must be associated with the Now Assist  in Virtual Agent 
LLM assistant prior to testing from the Topics page. For more 
information about this assistant, see LLM assistants.

Use this feature to test and verify that your active topics work as intended.

Search by topic 
name

Option for finding a topic that matches the name or search string that you 
enter.
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Filters and options in the Topics page  (continued)

Field Description

Explore additional 
topics

Link that opens the All prebuilt topics page, which shows prebuilt topics 
that are available when you activate their dependent spokes or plug-ins. 
For more information, see Virtual Agent Designer All pre-built topics page.

Model Type
Filter that displays either NLU/Keyword or large language model (LLM) 
topics. If this option is cleared, both topic types are displayed.

This option is only visible when Now Assist  in Virtual Agent  is installed. For 
more information, see Configuring Now Assist in Virtual Agent.

Topic Type
Filter for displaying Virtual Agent  objects:

• Topics: Lists only topics (and not blocks or custom controls), including 
prebuilt topics.

• Topic Blocks: Lists prebuilt and custom topic blocks.

• Setup Topics: Lists topics that are basic conversational elements, such 
as the conversation greeting or closing.

• Small Talk Topics: Lists topics that serve as casual conversations 
between the bot and end users, where the bot answers questions 
generally not related to the original task or issue.

• Custom Controls: Lists custom controls that represent custom 
components used in a conversation.

By default, the Topics page lists all active (published) and inactive (in 
development) objects, unless you use filters to list only certain object 
types.

Category
Filter that displays a list of topics belonging to a category that you specify. 
A category is a label that identifies a group of objects, such as setup topics 
or prebuilt topics for a particular business application.

You can also define your own custom categories. For details, see Create or 
modify custom categories.

Status
Filter that displays a list of objects by their state:

• Active: Display only published objects

• Inactive: Display only objects in development

NLU Language
Filter that displays only if you're using multi-language NLU  models. Lists 
Natural Language Understanding (NLU)-enabled topics by the language 
that you select.

Enable the languages for the NLU  service in NLU settings.

This field is available only when NLU  discovery is enabled on the instance.
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Filters and options in the Topics page  (continued)

Field Description

Channel
If other channels are configured for the instance, filter that lists topics by 
the channel (chat client) that you select. The default channels for Virtual 
Agent  are the web chat client and the messaging integrations for Slack, 
Microsoft Teams, Workplace, and Facebook Messenger. Your instance 
may have other channels, such as SMS that were created using custom 
chat integrations.

Created by me Option that, when enabled, displays only the topics that you created.

Sort by
Filter that displays topics by the sort filter that you select:

• Name: Specified topic or object.

• Updated time: Recently updated topics.

• Promoted Topics: Topics promoted by an LLM assistant. This sort filter 
option is only available if an LLM assistant is selected in the LLM 
Assistant  filter.

+ Create Option that opens the Properties page to create a topic or topic element 
and define the topic properties.

Topic actions ( ) Button that opens a drop-down menu with the following options:

• Promote topic: Adds a Promoted  flag to the topic when you select an 
LLM Assistant  to associate with the topic. The option is deactivated and 
a tool tip appears when you try to promote any of the following:

◦ Setup topics

◦ Topic blocks

◦ Small talk topics

◦ Unpublished topics

◦ Topics with no LLM Assistant selected

◦ Saved but unpublished topics with an LLM Assistant associated

◦ [store-future: BEGIN review]The LLM Assistant has reached the 
maximum number of associated topics[End]

◦ Any NLU/Keyword topics

Note: 
You can promote NLU topics in Conversational Interfaces 
settings, under Virtual Agent Custom Greetings and Setup. for 
more information, see Configure a Virtual Agent chat experience

• Demote topic: Replaces the Promote  option in a promoted topic, to 
remove the Promoted  flag.

• Delete topic: Opens a confirmation dialog box to delete the topic.
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Filters and options in the Topics page  (continued)

Field Description

For more information, see Promote or demote Virtual Agent LLM topics 
and Delete a Virtual Agent topic.

Virtual Agent Designer  All pre-built topics page

When you install pre-built conversations, such as ITSM Virtual Agent, some topics may not 
appear on the Topics page unless you install their dependent plugins. This page shows the 
additional topics that are available.

For more information about ITSM pre-built topics, see ITSM Virtual Agent .

Explore all pre-built topics page

Field Description

Topic Name of the topic. If its Status is Available 
to use, select the topic to open it in the 
conversation builder.

Documentation Link to related ServiceNow  documentation for 
the topic, if available.

Dependencies The plugins that are needed to use the 
topic. Select a dependency to go to its 
documentation and learn how to install it.

Note: 
Some plugins may require the admin role 
to install.

Status Value denoting whether you need to install a 
spoke or plugin, or if the requirements are met 
and the topic is available to use.

Create a topic form

The Create a topic form is used to set the properties for a new conversational topic for Virtual 
Agent.

The Create a topic form layout is similar to the Edit topic properties form layout found in the Topic 
Properties tab.

Note: 
Large language model (LLM) topics are faster and easier to set up and configure compared 
with NLU  topics. The LLM model type doesn't need you to select, configure, or train models 
or intents. For more information, see LLM topic discovery in Virtual Agent.
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Example of the Create a topic form compared between NLU/Keyword and LLM 
model types

Field Description

Type
List of objects that you can create. Select Topic.

Internal 
name

Internal name for topics, small talk topics, and setup topics that reflects its 
business purpose. Internal name displays on the Virtual Agent Designer  Topics 
page and must be unique across the platform.

Display 
name

Topic name that displays to users when they interact with Virtual Agent. Display 
name must be unique for either NLU/Keywords or LLM model type.

Model 
Type The LLM  value is used for topic discovery within LLMs, and the NLU/Keywords 

value is used for either keyword or NLU discovery. For more information, see LLM 
topic discovery in Virtual Agent.
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Field Description

Note: 
If this field doesn't appear, ensure that both the Now Assist  panel and Now 
Assist  in Virtual Agent  are turned on. For more information, see Turn on the 
Now Assist panel  and Configuring Now Assist in Virtual Agent.

LLM topics

[LLM topic discovery only]

Topic 
description

A detailed explanation of the LLM topic's purpose to differentiate it from other 
topics. For example: Help users see how many vacation days 
they have left.

Topic 
will be 
available 
in these 
assistant(s)

The LLM assistant that you associate with the topic for more accurate topic 
discovery.

If you associate a topic block and a related topic with the same LLM assistant, 
both are shown as associated with that assistant.

When you add an LLM assistant or remove one from your topic, the topic reverts 
to unpublished.

When you associate an LLM topic with an LLM assistant and publish it, a 
record for the association is created in the Profile and Document Mapping 
[sys_cs_document_context_profile] table. If you dissociate the Setup topic from 
the LLM assistant before republishing, the record is deleted.

For more information, see LLM assistants.

Natural Language Understanding  (NLU) topics

[NLU/Keywords topic discovery only]

Topic 
description

Brief explanation of the topic purpose and functionality.

If you use single quotes (‘ ’) in your description, do the following to avoid problems 
with your conversation:

1. Navigate to All, then enter sys_properties.list  in the filter.

2. Search for and select glide.ui.escape_all_script, then set its value 
to True.

NLU Model
Natural Language Understanding model to be mapped to the topic. The model 
contains the user utterances that are associated with the trained intents and 
entities. This combination enables your bot to understand what a user says. Do 
one of the following:

• Choose an existing model.

• Select Create Model  to create a new model group.

1. In the Model Name  field, enter a name for the new model group.

2. In the Intent name  field, accept the default value or enter a name for the new 
intent.

Note: 
New models are created in Draft  state.
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Field Description

Tip: 
To see how and where the NLU  model is used, navigate to NLU Workbench  > 
Models, and sort on the Created for  column.

Associated 
Intent The intent, when recognized by Virtual Agent, that launches this topic. If you 

specified or created a model, the intent is required. Do one of the following:

• Choose an existing intent.

• Select Create intent  to create a new intent.

In the Intent Name  field, accept the default value or enter a name for the new 
intent.

Note: 
This option is not available for read-only models.

Enable 
DialogActs

Toggle switch (active by default in new topics) to enable Virtual Agent  to detect 
when a user modifies utterances or applies updates in an NLU  model, and 
dynamically reacts to unexpected utterances and modifications. Slide this toggle 
to the off position to prevent users from using the keyboard instead of the options 
available in the topic. For more information, see Dialog Acts for Virtual Agent.

Note: 
This toggle is decoupled from the topic switching option found in all User 
Inputs aside from Grouped Choice and File Picker. It's available for all topic 
types aside from a Topic Block. This feature is currently available only for 
English.

Confirm 
modified 
values with 
users

Toggle switch to enable Virtual Agent  to send a confirmation message to the user 
when the Virtual Agent  detects a value change. This value is Active by default.

Note: 
This toggle appears when Enable DialogActs  is activated.

Advanced properties (optional)

Who can access this topic

System 
Roles Roles that a user must have to view and run the topic. If a topic is public (available 

to users, including guest users, who aren't authenticated in the ServiceNow 
platform), select only the Public role.

Channels
Chat clients in which the topic or topic block will run.

These channels are different from the default channels that are natively 
supported by Virtual Agent. Your instance may have additional channels for 
custom chat integrations  created for it. For more information about channels, see 
Deploying Virtual Agent topics in other channels.

Context
Expression logic to specify a condition for presenting this topic to users. The 
condition must evaluate to true. You can set this field using either the condition 
builder or a script.
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Field Description

• Condition: Use the condition builder to add or edit conditions.

• Script: Use the script editor to create or edit a script that contains a condition 
statement.

Live agent

Live agent 
context 
variables

Live agent context variables that are defined in the General Chat Settings.

Select the variables that provide dynamic context, which means information from 
the Virtual Agent  chat. This information is transferred from the bot conversation to 
the live agent.

For information about the default list of live agent variables, see Live agent chat 
context variables.

Available 
for Agent 
Autopilot

Toggle switch that determines whether the topic is available to a live agent.

When enabled, an agent can search for and invoke the topic. For details, see 
Conversation Autopilot.

Applicable to only keyword or NLU  topic discovery.

Additional

Resume 
flow after 
topic 
switching

Toggle switch that lets the user return to the original conversation after changing 
topics during a conversation.

Applicable to only keyword or NLU  topic discovery. Not applicable to Small Talk 
topics.

Categories Label used to identify and group-related topics, topic blocks, or custom controls.

Keywords

[NLU/
Keywords 
topic 
discovery 
only]

List of key phrases or terms that users enter to initiate the conversation with 
the Virtual Agent. Press Enter  after each phrase. Keywords are also used for 
languages that are currently not available in NLU.

Topic Properties tab

Use the Topic Properties  tab to identify a topic and how it's used. You can control who uses the 
topic and what channels it can run in.

The properties that you can specify depend on the method of topic discovery.

Two methods are available in Virtual Agent Designer: Large Language Model (LLM) or Natural 
Language Understanding  (NLU).

For example, if you enable NLU  in Virtual Agent  settings, the topic Properties  tab includes fields 
for identifying the NLU  model and intent for the topic.

For a complete description of topic properties, see Create a Virtual Agent topic.
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Topic Properties tab with LLM topic discovery
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Topic Properties tab with NLU  topic discovery

Topic Flow tab

Use the topic Flow  tab to build the conversation flow. Use the controls for user inputs, bot 
responses, and utilities to define the flow.
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Flow tab (default view)

Example Flow tab in the default view

Legend (default view)

Feature Description

1. Navigation bar Breadcrumbs to navigate from your design back to the Topics 
page. When updating designs, a message in the corner 
indicates the status of the design. For example, a message 
might indicate that you have unpublished changes for your 
topic or Natural Language Understanding  (NLU) language 
mappings.

2. Topic header bar Tabs and design options for your topic:

• Tabs: Each tab provides a different view for working on your 
conversation.

◦ Flow: Displays the canvas for building your conversation 
flow.

◦ Topic NLU Intent tab  (NLU topics only).

◦ Topic Properties tab.

◦ Topic Languages tab  (available if multiple languages are 
configured for Virtual Agent.

For more information, see Localizing Virtual Agent 
conversations.

• Table View: Option that displays a table view of the nodes 
in the conversation flow. You can use this option to switch 
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Legend (default view)  (continued)

Feature Description

between table view and diagram view as you design your 
conversation.

• Active/Inactive: Option that changes the design state so that 
it's active (available to users) or inactive (in development and 
not available to users). Select it to see the following options:

◦ Included in Topic Discovery: Option to make the topic 
discoverable via keywords, NLU, or Now LLM Service. If 
inactive, the topic is included when performing search 
fallback.

◦ Included in List of Topics: Option to make the topic visible 
under the “show me everything” list of topics.

• Save: Saves the current design.

• Test: Opens the design in a chat test window so that you can 
preview and test the conversation. If the Now Assist  panel or 
Microsoft Teams  is configured for your environment, preview 
options for those channels display in the Test button list. 
Select Preview in Now Assist panel  or Preview in Microsoft 
Teams  in the list to test your topic in those environments.

• Publish: Activates the design and makes it available to the 
chat clients. If you're using language-specific NLU  models, 
select Review and publish  from the Publish list to specify 
languages.

• More actions on topics icon ( ).

◦ Duplicate: Copy the current design to create an 
unpublished version of the design.

◦ Delete: Remove the current and published version of the 
design.

3. Palette Collapsible sidebar with Components  and Variables  tabs.

The Components  tab shows a list of controls that you can drag 
onto the canvas to build a conversation. The following types of 
controls are available:

• User Input: Controls used to prompt and capture information 
from the user in a conversation. When Now Assist  is enabled 
and you're working with a large language model (LLM) topic, 
the LLM-enabled User Input section indicates which controls 
are LLM compatible.

• Bot Response: Controls for showing Virtual Agent  responses 
in a conversation.

• Utilities: Controls for performing actions within a topic, such 
as running a script, adding different conversation paths 
(branches) in a topic, or adding topic blocks.

The Variables  tab includes inputs and scripts.

Input section
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Legend (default view)  (continued)

Feature Description

• Live agent variables specified on the topic 
Properties  tab to provide contextual information 
from the Virtual Agent  session to the live agent.

• Input variables defined by User Input controls 
and Utilities that are added to the flow on the 
canvas.

• "Nodeless" NLU  entities added by the topic 
author that are used as slot-filled input variables 
for the topic.

Script section

The Script section includes the scripts found in 
nodes on the canvas. The topic author can add 
further script variables to store values outside of 
control variables. Scripting variables enable more 
complex scripting scenarios.

4. Canvas Area that displays the conversation flow graphically. As you drag 
a control onto the canvas, that control becomes a node in the 
conversation flow. The canvas includes a related property sheet 
that opens in a pane when you select a node. Each flow has 
a Start  and End  node. When you add or remove controls, the 
layout of controls on the canvas is adjusted automatically.

5. Node search Option for quickly finding specific nodes in the conversation 

flow. Select the node search icon ( ) to expand the search 
field and enter the name of the node that you want to find. When 
a matching node is found, the node is highlighted in the flow. 
Use the arrows next to the search bar to go to the previous or 
subsequent node that matches the search node name.

Node search showing highlighted node

6. Property sheet Properties specific to the selected node on the canvas. The 
list of properties changes based on the node you select. Each 
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Legend (default view)  (continued)

Feature Description

node has its own set of properties that you can define, which 
can include scripts that control the behavior or processing that 
is performed in the node. If NLU  is enabled, the property sheets 
for Input controls contain additional NLU  fields. For further 
information, see Virtual Agent Designer controls.

7. Data pill picker A tool for selecting data pills from input variables or script 
variables to use in the property field. Select the data pill picker 
to select from the existing variables accessible in the topic. You 
can also drag data pills directly into property fields.

8. Script editor A tool for adding or editing JavaScript scripts used in a property. 
Provides scripting assistance, including a list of valid elements 
at the insertion point. Elements include function names, object 
names, and variable names available for the topic. For more 
information, see the JavaScript syntax editor .

9. Property sheet tab Opens the property sheet view for the currently selected node 
on the canvas.

10. Resources tab Opens the Helpful resources view, containing resources 
including Guided tours on the canvas, and links to videos for 
LLM-enabled nodes and product documentation.

Flow tab with the Table View enabled

Most of the functionality of the Flow  tab is the same in the Table View. The following figure and 
table highlight the differences.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2408

https://www.webstg.servicenow.com/docs/access?context=c_SyntaxEditor&version=washingtondc&pubname=washingtondc-application-development&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=c_SyntaxEditor&version=washingtondc&pubname=washingtondc-application-development&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=c_SyntaxEditor&version=washingtondc&pubname=washingtondc-application-development&ft:locale=en-US


Example Flow tab in the Table View

Legend (Table View)

Feature Description

Palette: 
Variables 
sidebar

The Components  tab is not shown. Only the Variables sidebar is visible.

Table 
view

A list of table rows, where each row corresponds to a node in the conversation flow. 
You can add nodes in this section. When you add or remove nodes, the table rows 
adjust automatically. A node can be any of the following controls, aside from the 
Start  and End  nodes:

• User Input: Controls used to prompt and capture information from the user in a 
conversation.

• Bot Response: Controls for displaying Virtual Agent  responses in a conversation.

• Utilities: Controls for performing actions within a topic, such as running a script, 
adding different conversation paths (branches) in a topic, or adding topic blocks.

Select Add new node  to add a node. You can specify the type of control in the 
dialog box.

Search 
table

Option for searching nodes in the conversation (table).

LLM components guided tour

When you create or open an LLM topic, a dialog box appears and displays an option to take a 
guided tour of the LLM-enabled components in Virtual Agent Designer. Select the close icon 

( ) to close the window or Start guided tour  to be shown the various components. To stop 
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seeing the dialog box open each time that you open an LLM topic, select Do not show this 
again  before closing the dialog box or starting the tour. To restore the dialog box, navigate to All 
> sys_cb_user_preference_list.do  and set the value for LLM_INTRO_MODAL_ENABLED  to 
true. You can also take a tour by selecting Guided tour for LLM enabled nodes  on the Helpful 
resources  tab.

LLM guided tour dialog box

Incomplete property warnings

Controls on the canvas have required properties. If required properties are missing, Virtual Agent 
Designer  displays the total number of missing required properties and the controls that are 
missing them. All incomplete warnings must be addressed to test or publish the topic.

In the following example, the topic is missing two required properties. Two nodes are affected, 
and each is missing one property. The Text response node is missing the Message response.

Flow tab with incomplete properties
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Point to the incomplete message to see a tooltip that describes what is missing.

Select the message to get more information

Topic NLU Intent tab

You can edit and refine ServiceNow  NLU  models from within Virtual Agent Designer. When a 
conversation topic is bound to an associated NLU  model and intent, use the NLU Intent  tab to 
review and edit utterances and associated entities.

If your topic uses NLU  discovery, the topic NLU Intent  tab appears on the Virtual Agent Designer 
interface. Test your topic to see the prediction results for topic discovery and the corresponding 
confidence scores for the results. Depending on the results, you can modify the associated 
utterances and entities in the NLU  model for your topic intent.

Utterances tab

Use the Utterances  tab to perform the following tasks.

Using the Utterances tab

I want to... Do this

Add an 
utterance

Use the Add  field to enter an utterance for an intent. Each utterance must be 
unique and contain fewer than 200 characters.

Edit an 
utterance

Select the Edit icon  next to the utterance.

Duplicate 
an 
utterance

Select the Copy icon  next to the utterance.

Move an 
utterance 

Select the Menu icon , and then select Move this utterance to another intent.
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Using the Utterances tab  (continued)

I want to... Do this

to another 
intent

Delete an 
utterance

Select the Menu icon , and then select Delete this utterance.

Define a 
new entity

1. Select a word in an utterance to use as an entity.

2. In the Create New Entity picker, select the type of entity to be created, such as 
a simple or system-derived entity.

For information about the types of entities that you can define, see NLU 
entities . For information about system entities, see NLU system entities. 
When you add an entity, it is also displayed in the Associated Entities  tab.

Example utterances on the NLU Intent tab
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Adding entities on the Utterances tab

Associated Entities tab

Use the Associated Entities  tab to view the entities defined for the intent. Select the name to 
view the utterances that the entity is associated with.

Entities defined for an intent named UpdatePhoneNumber

You can also associate system entities, such as date and time, with an intent. For more 
information about supported system entities, see NLU system entities.

Conflicts tab

Use the Conflicts  tab to view conflicts among your intents. For example, if two different intents 
use the same utterance, this will appear as a conflict in both Virtual Agent Designer  and 
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NLU Workbench. Identifying and resolving conflicts improves the effectiveness of NLU topic 
discovery.

Utterance conflict between two intents

Topic Languages tab

Use the Languages  tab to view the topic's translation status for languages that have been 
activated in Virtual Agent. If NLU is enabled on your instance, you can also view model mappings 
for each language.

Some features on the Languages tab require the appropriate localization roles. For more 
information, see Localization roles for Virtual Agent.
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Translations tab

Example Translations tab

Translations tab columns

Column Description

Language
List of available languages in Virtual Agent.

Only installed languages are displayed (the language plugins are activated). If a 
language appears as unavailable, it means the language plugin is installed, but it 
has not been activated in Virtual Agent  settings or in the Localization Framework. 
For more information, see Configure Natural Language Understanding in Virtual 
Agent  and Languages table .

Topic 
translation 
status

Indicates translation status:

• Complete: Topic is completely translated

• Partial: Topic is partially translated

• In progress: Translation is in progress

• Not started: Translation has not begun

• Needs publishing: Topic is unpublished or in Draft state

The ServiceNow  platform provides translations for interface features and pre-built 
topics, so languages may display as partially translated.

Topic 
translations

Depending on the state of the localization process and your role, you can either 
view the current content for the language, or you can edit the language content.

Only users with the Localization editor [localization_editor] role  can edit 
translated content.

Localization 
request Click Request translation  to create a Localization Framework  task. Translation will 

begin depending on how the flow was set up in the Localization Framework.
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Translations tab columns  (continued)

Column Description

If translation has already begun and you have the Localization fulfiller 
[localization_fulfiller] role, click View requested item  to view the task.

Test Click the link to test the topic in a particular language.

NLU language mapping tab

If you've enabled NLU on your instance, you can view or modify the topic mappings on this tab. 
You can also map your entities and test the translated topic here.

Note: 
Unless you're using legacy, single-language models, all secondary languages in a topic 
must be mapped to the same model group. In most cases, changing the mapping for one 
secondary language will change the mappings for all secondary languages in the topic. For 
more information, see NLU model mapping in Virtual Agent Designer.

Example NLU language mapping tab
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Virtual Agent Designer  controls

A Virtual Agent  topic consists of a collection of controls within a topic flow. Use these controls 
to collect, process, and present information to your users. Controls can also read, create, and 
update records on your instance.

Each set of controls performs specific functions in a conversation flow.

Control types

Category Description

Start 
segment

Appears automatically in a topic flow and cannot be added to or removed from a 
conversation. This control can be configured with a greeting response that appears 
when a conversation begins.

End 
segment

Appears automatically in a topic flow and cannot be added to or removed from a 
conversation. This control can be configured with a final confirmation message 
before the end of a conversation. Ensure that all branches of your topic eventually 
connect to this control.

User 
Input

Prompts and captures information from the user in a conversation.

Bot 
Response

Displays bot responses in a conversation.

Utilities Handles actions and logic within a topic, such as running a script or adding 
different conversation paths (branches) in a topic. You can also use them to call 
automated Flow Designer  workflows.

For controls that have prompts, messages, default values, or confirmation messages, you can 
enter any of the following input values:

• Text strings

• Data pills

• Strings with embedded data pills

• Scripts that return strings

Data pills

Use data pills to quickly and easily add dynamic information to your controls without using a 

script. Click the data pill icon ( ) to open the data pill picker interface. In this interface, you can 
select data from script variables and from input variables set by your User Input controls.

Using data pills enables you to quickly and easily access the data in your variables. In contrast, 
scripting provides more complex options, like handling translation. The following examples 
illustrate how to use a text bot response that includes the name of the customer, handled both as 
a data pill and a script.
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Data pill and scripted responses

Method Result

Data pill

Script

The first example uses the data pill selector to choose Get Name, an input variable that contains 
the name of the customer. The second example accomplishes the same thing using a script. The 
script example also uses gs.getMessage  to handle translating the message.

Hide or skip this node (condition property)

Almost all controls have a condition property. The exceptions are the Decision utility and the 
Start and End nodes.

In user input controls, the condition property determines whether the control is used or skipped 
in a conversation. To always use the control, leave the condition field empty. To determine the 
conditions under which the control is used, do one of the following:

• Create a condition using the condition builder interface, which lets you add data pills to 
specify conditions built using this interface.

• Provide a script for the condition property that returns a value of true or false. If the return value 
is false, the control is not used and the conversation will continue to the next control along that 
branch of the topic.

Use conditions to make your conversations more dynamic based on context, data, or scripted 
logic.
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Scripted condition Condition builder condition

Sample script for conditionally showing the 
node:

(function execute() {
   var gr = new 
 GlideRecord('incident');
   return gr.canCreate();
})()

In this example, a condition script returns a value of true if the current user is able to create 
incident records. This condition prevents a utilities control from creating an incident when the 
user does not have permission to do so.

Virtual Agent Designer  user input controls

Use the collection of input controls provided by Virtual Agent Designer  to prompt and capture 
information from the user in a conversation.

Common input control properties

In addition to data pills and condition controls, each input control has the following common 
properties:

Input variable for the user response

Each control stores the user response in an input variable that is accessible 
from other controls within the same topic using the getValue  and 
getDisplayValue  methods. The variable name is based on the name that you 
assign to the input control. For example, if you assign the name First prompt 
to an input control, the variable name is first_prompt. The variable name is 
lowercase, with an underscore character instead of a space. For more information 
on these methods, see Virtual Agent scripts.

The Variable name field is populated automatically

Natural Language Understanding  (NLU) entity properties

If NLU  is enabled, the following properties are displayed in the property sheet for 
the Text, Static Choice, Dynamic Choice, Boolean, Date Time, and Carousel  input 
controls. To view or enable these properties, go to the Advanced options section.

• NLU entity: The entity that corresponds to the input variable for the control. 
You select the entity from the list of entities associated with the topic intent, as 
defined in the NLU  model that you’re using for the topic. When Virtual Agent 
recognizes the entity value in user utterances and if the value meets the entity 
prediction confidence threshold, then Virtual Agent  extracts the value. The value 
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is stored in the input variable for the node. This storing action is called slot filling. 
Slot filling recognizes when multiple values for the same NLU  entity occur in a 
conversation. Users are prompted with a list to confirm which node value to select 
when multiple nodes are tied to the same NLU  entity. This property is available 
only for NLU  topic discovery.

NLU  entity property

• Enable NLU to switch topics: Enables NLU  prediction for the node. If enabled, 
users can enter text to answer questions, regardless of the type of input control 
being used. Virtual Agent  uses this utterance to match another existing intent, 
letting the user switch topics. To enable this property on a node, navigate to 
Advanced options  > Topic switching.

Enable NLU  to switch topics property

Default value

An input prompt can have a preset value that you define. This value can be either 
a string or a script that returns a string. This property is in the Advanced options 
section.

Default value property

Confirmation messages

These bot response messages signal the end of the node interaction and ask the 
users to confirm their response. This property is in the Advanced options section.
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Confirmation messages properties

Input Collector user input control

Use the Input Collector control to gather data for use by Now Assist  or other AI chat systems.

[store-future: BEGIN review]

Overview

For an overview of the Input Collector from a user perspective, watch this video.

Virtual Agent Designer Input Collector user input control video

[End]

Input Collector properties

The Input Collector is only available for topics that use large language model (LLM) discovery.

The Input Collector can hold up to 5 of any of the LLM-enabled user inputs aside from another 
Input Collector. Place multiple Input Collector nodes in sequence to collect more than 5 user 
inputs. You can reorder nodes inside the Input Collector on both the canvas and table views. 
To reorder nodes on the canvas, select a given node inside the Input Collector and drag it up 
or down in the list. You can add or remove nodes from an Input Collector, or nodes between 
multiple Input Collectors, by selecting a node and dragging it into or out of an Input Collector 
node on the canvas. To reorder nodes in an Input Collector in the table view, select a given node 
in the list, then select the up or down arrow next to the node.

Specify the flow action properties for the node that you want to create.

Property Description

Node name Name of the node.

Advanced

Additional 
instructions 
for LLM

Further instructions to the LLM, such as adding data formats, restrictions, or 
default values for user responses. You can create additional instructions in plain 
language, input a script, or define conditions with the data pill picker.

Confirmation 
message

Toggle switch to display a summary of collected inputs to the user at the end 
of a conversation. If Summary message is activated, the Virtual Agent, when 
activated, presents the information that you have entered and asks if everything 
is correct. Select Yes  to continue the chat or No  to restart collecting user input. 
You can also reply by typing a response in the chat window, to confirm or deny 
the summary or to change your answer.
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Property Description

This option is active by default, and shows an enabled icon  when activated.

Hide or skip this node

Conditionally 
show this 
node if

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.

Allow user 
to skip this 
node if

No-code condition statement or low-code script that specifies a condition 
for letting users skip this node in the conversation. The condition must 
evaluate to true. You can set this field using either the condition builder or 
a script. When this field is active, the node presents the user with a Skip 
option in the Virtual Agent conversation. Alternatively, in an LLM topic, you 
can reply with an utterance such as I want to skip this question. 

Example Input Collector
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Input Collector canvas view

Input Collector table view
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Channel support

Channel support for the Input Collector control

Channel Support Constraints

Web UI Supported None

Mobile UI Supported None

Now Assist  panel Supported None

Microsoft Teams Supported None

Slack Not supported Not applicable

Workplace Not supported Not applicable

Facebook Messenger Not supported Not applicable

SMS Twilio Not supported Not applicable

LINE Not supported Not applicable

WhatsApp Not supported Not applicable

Apple Messages for Business Not supported Not applicable

Alexa  (Voice) Not supported Not applicable

Text user input control

The Text user input control in a Virtual Agent  topic prompts the user for a text string.

Text user input control properties for LLM topic discovery

Property Description

Node name Name that identifies this Text user input control node in the topic flow.

Detail 
description The one piece of information needed from the user. For example, Ask the 

user which service catalog item they need.

Input format
Text format that is validated when a user enters certain text items. If the user 
doesn't enter the expected format, an error message indicates that the format is 
not valid and asks the user to reenter the text.

Choose the format of the text item to be validated:

• Text: Any text string (no validation)

• Email: Format that consists of an email prefix (user name), the @ symbol, and 
domain.

• IP address (IPV4, IPV6): Data communication delivery format for Internet 
Protocol version 4 or version 6.

• Phone number (E.164): Internationally recognized standard phone number 
format.
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Property Description

• URL: Web address format

• Custom: A script that provides a validation rule for a custom text format. The 
script should include related error messages that are displayed when the 
expected format is not entered.

For phone and IP address format examples, see E.164 phone formats  and IP 
address field types .

Advanced

Enforce user 
prompt Toggle to open a field for a custom message shown to the user instead of the 

message generated by the LLM. You can create custom messages in plain 
language, input a script, or define conditions with the data pill picker.

Additional 
instructions 
for LLM

Further instructions to the LLM, such as adding data formats, restrictions, or 
default values for user responses. You can create additional instructions in plain 
language, input a script, or define conditions with the data pill picker.

Hide or skip this node

Conditionally 
use this 
node if

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.

Allow user 
to skip this 
node if

No-code condition statement or low-code script that specifies a condition 
for letting users skip this node in the conversation. The condition must 
evaluate to true. You can set this field using either the condition builder or 
a script. When this field is active, the node presents the user with a Skip 
option in the Virtual Agent conversation. Alternatively, in an LLM topic, you 
can reply with an utterance such as I want to skip this question. 
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Example Text user input control for LLM topic discovery

LLM topic input control properties

Input properties Input prompt

Web UI Text user input prompt

Text user input control properties for NLU topic discovery

Property Description

Node name Name that identifies this Text user input control node in the topic flow.

Variable 
name

Name of the variable that stores the user response to this prompt. The variable 
name is automatically created from the Node name  property.

Prompt
Prompt or question for the user. The prompt can be either a text string or a script 
that returns text. This value is used only when the default value is not specified. 
For example: What's your name?

Input format
Text format that is validated when a user enters certain text items. If the user 
doesn't enter the expected format, an error message indicates that the format is 
not valid and asks the user to reenter the text.

Choose the format of the text item to be validated:
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Property Description

• Text: Any text string (no validation)

• Email: Format that consists of an email prefix (user name), the @ symbol, and 
domain.

• IP address (IPV4, IPV6): Data communication delivery format for Internet 
Protocol version 4 or version 6.

• Phone number (E.164): Internationally recognized standard phone number 
format.

• URL: Web address format

• Custom: A script that provides a validation rule for a custom text format. The 
script should include related error messages that are displayed when the 
expected format is not entered.

For phone and IP address format examples, see E.164 phone formats  and IP 
address field types .

NLU entity
Option to associate an NLU entity with the node. If an NLU entity is associated 
with the input variable for this node, Virtual Agent can slot-fill the specified 
value based on the user's utterance. Select an entity from the list of entities 
associated with the topic intent.

When you specify an entity for the node, the Do not ask users to confirm 
recognized entity  toggle switch displays. When enabled, users are not prompted 
to confirm the extracted entity.

Advanced

Make this input secure

Enable Toggle switch that encrypts the Text bot user input. When enabled, the user 
input is masked and appears as a series of dots in the chat window.

Hash 
function

[Visible 
when Make 
this input 
secure is 
enabled]

The method digest algorithm based on the standard WS-security standard. 
Choose one of the following:

• SHA-256 (lower case)

• SHA-1 (lower case)

For more information about the WS-security standards, see WS-Security 
properties .

Encryption 
salt

[Visible 
when Make 
this input 
secure is 
enabled]

Random data that is used as an additional input to a one-way function that 
hashes data.

Default value

Predefine 
a value for 
user input

Predefined value for the user response to the question or prompt. The response 
defined in the Default value confirmation  field asks the user to confirm the 
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Property Description

default value. If the user responds with no, the value becomes null. The default 
value can be either a text string or a script that returns text. For example, if 
you're using dot-walking, the default value might be: Script Variables 
> Last username. Or if you're using a script, the default value might be: 
{{vaScripts.lastUsername}}.

Confirmation messages

Input 
completion 
confirmation

Bot response shown to the user when the node interaction is complete. 
The message can be either a text string or a script that returns text. For 
example, if you're using dot-walking: Thanks, (Input Variables > 
Username)!  Or if you're using a script, the acknowledgement might be: 
Thanks, {{vaInputs.username}}!

Default value 
confirmation Message that asks the user to verify that the value in the Default value  field 

is correct. This message is used instead of a value in the Prompt  field. It can 
contain either a text string or a script that returns text. For example, if you're 
using dot-walking: Are you (Input Variables > Username)? 
Or if you're using a script, the confirmation message might be: Are you 
{{vaScripts.lastUsername}}?.

Conversation switching

Turn on to 
let users 
change the 
subject

Option to enable NLU prediction for this node. If enabled, users can enter text 
to answer questions, regardless of the type of input control being used. Virtual 
Agent uses this utterance to match another existing intent, letting the user 
switch topics.

Hide or skip this node

Conditionally 
show this 
node if

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.

Allow user 
to skip this 
node if

No-code condition statement or low-code script that specifies a condition 
for letting users skip this node in the conversation. The condition must 
evaluate to true. You can set this field using either the condition builder or 
a script. When this field is active, the node presents the user with a Skip 
option in the Virtual Agent conversation. Alternatively, in an LLM topic, you 
can reply with an utterance such as I want to skip this question. 

Skip 
reprompting 
if

No-code condition statement or low-code script that specifies a condition for 
letting users skip reprompting in the conversation. When a preceding node is 
revisited through a topic loopback or Dialog Act, the Virtual Agent bypasses this 
node and automatically retain its original value.
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Example Text user input control for NLU topic discovery

Input properties Input prompt

Web UI Text user input promptText input control basic 
properties

Make this input secure 
(Advanced properties)

User input prompt on a mobile 
app with the Make this input 
secure toggle switch enabled
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Channel support

Note: 
Virtual Agent Designer  controls may display and function differently in other channels.

Channel support for the Text user input control

Channel Support Constraints

Web UI Supported None

Mobile UI Supported None

Now Assist 
panel

Supported None

Microsoft 
Teams

Supported None

Slack Supported Slack  users can edit text previously entered in a conversation. 
However, Virtual Agent  processes messages as they are first entered. 
If a Slack user edits text input, such as a comment to update a case, 
then Virtual Agent  does not evaluate the edited update.

Workplace Supported None

Facebook 
Messenger

Supported The maximum character limit is 5000 characters.

SMS Twilio Supported None

LINE Supported The maximum character limit is 5000 characters.

WhatsApp Supported None

Apple 
Messages 
for 
Business

Supported None

Alexa 
(Voice)

Supported For screen devices, character limits may apply. For more information, 
see the Alexa developer documentation .

Static Choice user input control

Use the Static Choice user input control in a Virtual Agent  topic to list predefined choices 
available to the user. You can select only one item from a choice list.

Choice display

The choice list contains up to 10 items per page. When more than 10 items exist, you have 
the option to display the additional items and filter the search results. The choice list prompt 

contains a search icon  that users can select to filter the results.

The Static Choice control provides the option to add a header card that displays above the 
choice list. Header cards are supported in web and mobile channels.
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• The header card can contain a large or small image or a YouTube video card, along with 
descriptive text. The choice list contains up to five items by default, but the search feature is 
suppressed. If there are more than five items, users can choose to show the additional items.

• To control the number of items displayed below a header card, add the 
com.glide.cs.web_header_picker_page_limit  system property. Use the Value 
to specify the number of items displayed in the choice list. For details about creating a system 
property, see Add a system property .

Static Choice user input control properties for LLM topic discovery

Property Description

Name Name that identifies this Static Choice user control node in the topic flow.

Detail 
description The one piece of information needed from the user. For example, Ask the 

user which service catalog item they need.

Choices

Display 
name For each choice, the text that appears to the user for that choice. Use short 

phrases in your choice lists.

• Slack has a limit of 30 characters for choice list labels.

• Workplace has a limit of 20 characters for choice list labels.

Value For each choice, the string that is stored in the variable when the corresponding 
choice is selected.

Advanced

Header card
Toggle to open a field to add cards which may include images or YouTube 
videos. For more information, see Insert a header card in a Static Choice or 
Dynamic Choice control

Additional 
instructions 
for LLM

Further instructions to the LLM, such as adding data formats, restrictions, or 
default values for user responses. You can create additional instructions in plain 
language, input a script, or define conditions with the data pill picker.

Enforce user 
prompt Toggle to open a field for a custom message shown to the user instead of the 

message generated by the LLM. You can create custom messages in plain 
language, input a script, or define conditions with the data pill picker.

Hide or skip this node

Conditionally 
use this 
node if

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.

Allow user 
to skip this 
node if

No-code condition statement or low-code script that specifies a condition 
for letting users skip this node in the conversation. The condition must 
evaluate to true. You can set this field using either the condition builder or 
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Property Description

a script. When this field is active, the node presents the user with a Skip 
option in the Virtual Agent conversation. Alternatively, in an LLM topic, you 
can reply with an utterance such as I want to skip this question. 

Example Static Choice user input control for LLM topic discovery

Note: 
Virtual Agent Designer  controls may display and function differently in other channels.
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Input properties List prompt

Web UI Static Choice list prompt

Web UI Static Choice list prompt with more 
than 10 items

The choice list displays 10 items per page. When 10 or 
more results are returned, the following occurs:

• The list includes a link at the end of the list to show more 
results.

• A search icon displays in the prompt for filtering search 
results. Select the icon to open a search box and enter 
the filter.

Static Choice user input control properties for NLU topic discovery

Property Description

Node name Name that identifies this Static Choice user control node in the topic flow.
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Property Description

Detail 
description

The one piece of information needed from the user. For example, Ask the 
user which service catalog item they need.

Variable 
name

Name of the variable that stores the user response to this prompt. The variable 
name is automatically created from the Node name  property.

Prompt
Prompt or question for the user. The prompt can be either a text string or a script 
that returns text. This value is used only when the default value is not specified. 
For example: What's your name?

NLU entity
Option to associate an NLU entity with the node. If an NLU entity is associated 
with the input variable for this node, Virtual Agent can slot-fill the specified 
value based on the user's utterance. Select an entity from the list of entities 
associated with the topic intent.

When you specify an entity for the node, the Do not ask users to confirm 
recognized entity  toggle switch displays. When enabled, users are not prompted 
to confirm the extracted entity.

This field is available only when NLU  discovery is enabled on the instance.

Choices

Display 
name For each choice, the text that appears to the user for that choice. Use short 

phrases in your choice lists.

• Slack has a limit of 30 characters for choice list labels.

• Workplace has a limit of 20 characters for choice list labels.

Value For each choice, the string that is stored in the variable when the corresponding 
choice is selected.

Advanced

Header card
Toggle to open a field to add cards which may include images or YouTube 
videos. For more information, see Insert a header card in a Static Choice or 
Dynamic Choice control

Default value

Default Value
Predefined value for the user response to the question or prompt. The response 
defined in the Default value confirmation  field asks the user to confirm the 
default value. If the user responds with no, the value becomes null. The default 
value can be either a text string or a script that returns text. For example, if 
you're using dot-walking, the default value might be: Script Variables 
> Last username. Or if you're using a script, the default value might be: 
{{vaScripts.lastUsername}}.

Confirmation messages

Input 
completion 
confirmation

Bot response shown to the user when the node interaction is complete. 
The message can be either a text string or a script that returns text. For 
example, if you're using dot-walking: Thanks, (Input Variables > 
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Property Description

Username)!  Or if you're using a script, the acknowledgement might be: 
Thanks, {{vaInputs.username}}!

Default value 
confirmation Message that asks the user to verify that the value in the Default value  field 

is correct. This message is used instead of a value in the Prompt  field. It can 
contain either a text string or a script that returns text. For example, if you're 
using dot-walking: Are you (Input Variables > Username)? 
Or if you're using a script, the confirmation message might be: Are you 
{{vaScripts.lastUsername}}?.

Conversation switching

This section is available only when NLU discovery is enabled on the instance.

Turn on to 
let users 
change the 
subject

Option to enable NLU prediction for this node. If enabled, users can enter text 
to answer questions, regardless of the type of input control being used. Virtual 
Agent uses this utterance to match another existing intent, letting the user 
switch topics.

Hide or skip this node

Conditionally 
show this 
node if

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.

Allow user 
to skip this 
node if

No-code condition statement or low-code script that specifies a condition 
for letting users skip this node in the conversation. The condition must 
evaluate to true. You can set this field using either the condition builder or 
a script. When this field is active, the node presents the user with a Skip 
option in the Virtual Agent conversation. Alternatively, in an LLM topic, you 
can reply with an utterance such as I want to skip this question. 

Skip 
reprompting 
if

No-code condition statement or low-code script that specifies a condition for 
letting users skip reprompting in the conversation. When a preceding node is 
revisited through a topic loopback or Dialog Act, the Virtual Agent bypasses this 
node and automatically retain its original value.

Example Static Choice user input control for NLU topic discovery

Note: 
Virtual Agent Designer  controls may display and function differently in other channels.
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Input properties List prompt

Static choice input control basic 
properties

Web UI Static Choice list prompt

Web UI Static Choice list prompt 
with more than 10 items

The choice list displays 10 items per page. 
When 10 or more results are returned, the 
following occurs:

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2436



Input properties List prompt

• The list includes a link at the end of the list 
to show more results.

• A search icon displays in the prompt for 
filtering search results. Select the icon to 
open a search box and enter the filter.

Add card dialog box (Header 
card advanced option)

Web UI Static Choice list with 
header card

The choice list contains five 
items per page. When five or 
more results are returned, the list 
provides an option to show more 
results.

Note: 
The search feature is 
suppressed when a header 
card is used.

Channel support

Channel support for the Static Choice user input control

Channel Support Constraints

Web UI Supported None
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Channel support for the Static Choice user input control  (continued)

Channel Support Constraints

Mobile UI Supported None

Now Assist 
panel

Supported None

Microsoft 
Teams

Supported None

Slack Supported Header cards aren’t supported.

When a choice list has three or fewer choices, Slack displays the list 
as buttons.

Workplace Supported Header cards aren’t supported.

Facebook 
Messenger

Supported In a quick reply, the label has the maximum character limit 
of 20 characters. You can view only 13 quick replies at a 
time. If there are more than 13 quick replies, the pagination 
format is used to view more options. The default value of 
the maximum number of replies for a page is set in the 
sn_va_fb_messenger.max_quick_replies  system property. 
This property is located in the System Property [sys_properties] table.

SMS Twilio Supported Header cards aren’t supported.

LINE Supported In a quick reply, the label has a maximum limit of 20 characters. You 
can view only 13 quick replies at a time. If there are more than 13 
quick replies, the pagination format is used to view more options. The 
default value of the maximum number of replies for a page is set in 
the sn_va_line.max.picker.choices  system property. The 
property is located in the System Property [sys_properties] table.

WhatsApp Supported None

Apple 
Messages 
for 
Business

Supported None

Alexa 
(Voice)

Supported For screen devices, use touch scroll. For nonscreen devices, use 
voice pagination.

Grouped Choice user input control

Use the Grouped Choice user input control in a Virtual Agent  topic to list multiple groups of 
choices in one message.

Grouped Choice list display

The Grouped Choice list prompts users to select related choices in one message through the 
default Select a choice  button. You can enable multi-select for each choice's group and also 
provide images and short descriptions to create a richer user experience. Users are presented 
with groups of choices where they're required to submit one selection before returning to the 
Virtual Agent  topic.

Inputs are recorded on the Interactions [interactions] table. For more information, see .
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Grouped Choice user input control properties

Property Description

Node name Name that identifies this Grouped Choice user control node in the topic flow.

Prompt
Prompt or question for the user. The prompt can be either a text string or 
a script that returns text. For example: Please select your meal 
preference.

Group name Name that identifies the grouped choice list in the property sheet. Add one 
(required) or multiple groups of related choices. Users must select one choice 
out of all groups.

Use short phrases in your choice lists.

Choices Number of choices added to each group.

Add a group of choices dialog box

This dialog box only appears after Add  is selected.

Group name Name that identifies the grouped choice list in the property sheet. A limit of 40 
characters for choice list labels exists.

The Variable name  field is automatically generated from the group name. 
This read-only variable name appears in all lower-case text and substitutes 
any spaces in the group name for underscores. If multiple lists with the same 
name exist, the variable name is appended with _1, _2, _3, and so on. Use this 
variable in your conversation flow to retrieve user responses for each group 
within the Grouped Choice node.

Display as Group heading title that appears in the rendered client.

Display 
name

Choice name that is displayed to users. At least two unique choices are 
required.

Value String that is stored in the variable when the corresponding choice is selected. 
This value is automatically generated from the display name, but you can edit 
the field as needed.

Image Option to an add image for the choice.

Individual choice images are entered after you select Add details.

To set this field, do one of the following:

• Specify the URL link by either entering the link text, using a data pill, or using a 
script.

• Upload an image file by selecting Upload Image.

Description
Option to provide additional information about the choice.

Individual choice descriptions are entered after you select Add details.

For example: If the grouped choice list is about passengers selecting airplane 
amenities, like headphones, you could include a description about the type of 
headphones such as Over-ear wired headphones.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2439



Property Description

Allow the 
user to 
select more 
than one 
choice

Option to allow users to choose multiple options from the choice list by 
selecting Yes.

Advanced

Customize group selection

Update title Option to customize the title of the grouped choice's prompt button. A limit of 40 
characters for choice list labels exists. If this field is left empty, the default title 
that users see is Select a choice.

Image Option to add an image for the grouped choice's prompt button.

To set this field, do one of the following:

• Specify the URL link by either entering the link text, using a data pill, or using a 
script.

• Upload an image file by selecting Upload Image.

Confirmation messages

Input 
completion 
confirmation

Bot response shown to the user when the node interaction is complete. 
The message can be either a text string or a script that returns text. For 
example, if you're using dot-walking: Thanks, (Input Variables > 
Username)!  Or if you're using a script, the acknowledgement might be: 
Thanks, {{vaInputs.username}}!  .

Hide this node

Conditionally 
show this 
node if

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.

Example Grouped Choice user input control

Note: 
Virtual Agent Designer  controls may display and function differently in other channels.
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Input properties List prompt

Grouped choice input control 
basic properties

Add a group of choices dialog 
box

Web UI Grouped Choice list 
default prompt

Web UI Grouped Choice list with 
customized title and image

Web UI Grouped Choice list
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Channel support

Channel support for the Grouped Choice user input control

Channel Support Constraints

Web UI Supported None

Mobile UI Not supported Not applicable

Now Assist  panel Supported None

Microsoft Teams Not supported Not applicable

Slack Not supported Not applicable

Workplace Not supported Not applicable

Facebook Messenger Not supported Not applicable

SMS Twilio Not supported Not applicable

LINE Not supported Not applicable

WhatsApp Not supported Not applicable

Apple Messages for Business Not supported Not applicable

Alexa  (Voice) Not supported Not applicable

Dynamic Choice user input control

Use the Dynamic Choice user input control in a Virtual Agent  topic to dynamically create a list of 
available choices for your users. Create these choices by querying a table or by using a script to 
dynamically create them.

Choice list display

The Dynamic Choice list contains up to 10 items per page. When more than 10 items exist, users 
have the option to display the additional items and also filter the search results. The choice list 
prompt contains a search icon that users can select to filter the results.

Tip: 
If you want to change the default number of listed items per page, you can modify the 
com.glide.cs.picker_page_limit  system property. The default value is 10.

If selecting multiple choices is turned on, you can search within the Search for options  field for 

filtering search results. Select or type all choices that apply, and then select the send icon . 
When you send your choices through an LLM-enabled Virtual Agent, the LLM responds with 
whether your choices meet the validation criteria.

You can also select a choice or choices from a list in an LLM-enabled conversation by entering 
an utterance in the chat window. If there is no match for your input, the Virtual Agent  informs you 
that it is not a valid choice, and prompts you to try a different input.

The Dynamic Choice control also provides the option to add a header card that displays above 
the choice list. Header cards are supported in web and mobile channels.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2442



• The header card can contain a large or small image or a YouTube video card, along with 
descriptive text. The choice list contains up to five items by default, but the search feature is 
suppressed. If there are more than five items, users can choose to show the additional items.

• To control the number of items displayed below a header card, add the 
com.glide.cs.web_header_picker_page_limit  system property. Use the Value  to 
specify the number of items in the choice list. For details about creating a system property, see 
Add a system property .

Note: 

If you populate a Dynamic Choice list node with only one choice, when testing or using the 
node, you receive a message reading We have [choice] as [node name], is 
this correct?. Use multiple choices in the Dynamic Choice list node to avoid receiving 
this message.

You can also alter the message content by navigating to ALL  > sys_properties.list  and 
editing the glide.cs.retry_question_message  system property. This message 
value is by default a string We have {0} as {1}, is this correct?  and is used 
for slot-filling in multiple cases outside the Dynamic Choice list. Any changes you make are 
reflected in every use of this property.

Dynamic Choice user input control properties for LLM topic discovery

Property Description

Node name Name that identifies this Dynamic Choice user control node in the topic flow.

Detail 
description

The one piece of information needed from the user. For example, Ask the 
user to select an incident.

Choices

Populate 
choices by

Type of dynamic variable to be used. Select one of the following options:
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Property Description

• Record: Returns records from the table selected. The values for these options 
are GlideRecord objects.

• Script: Expression that returns an array of options.

Note: 

For more efficient pagination return results for a large data set when 
using a script expression, review the following script and determine 
whether you want to use this script:

(function execute() {
 
var pagingUtil = new 
 global.VirtualAgentChoicePagingUtil(null, 
 "sys_user", null, "user_name,name",
"active=true", null, vaVars);
 
var gr = 
 pagingUtil.getPagingGlideRecordSecure("name", 
 false);
 
var options = pagingUtil.getSecureOptions(gr, 
 null,'user_name', ['user_name','name']);
 
return options;
})()

For more information about the preceding scripting details, review 
information about GlideRecords  and the additional information:

◦ fieldName: Field name is optional information. Pass with null.

◦ table: Table name to query for displaying the available options.

◦ pageSize: Page size is optional information. Pass with null.

◦ searchColumns: Table columns in a comma-delimited list that 
applies to any searchText.

◦ encodedQuery: Initial query to apply to table rows. For example, 
active=true.

◦ searchText: Search text is optional information. Pass with null.

◦ vaVars: Reference to virtual agent context variables (vaVars).

◦ orderByColumn: Table column used to order the options.

◦ orderDescending: Options appear in descending order. Only 
true  or false  values accepted.

◦ gr: Glide record name.

◦ startRow: Starting row is optional information. Pass with null.

◦ valueColumn: Table column name to use as the value of each 
option.

◦ labelColumns: Array of table columns to use for each option 
display.
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Property Description

Table If you selected Record  as the method to populate choices, select the table to be 
searched.

This field is available only when the Record  option is selected.

Filter 
choices

Option to use the Virtual Agent Designer  condition builder or provide a script. 
Select one of the following:

• Condition Builder: Creates a filter used to select a subset of records from the 
table.

• Script: Defines the enumeration list for the options (choice list) to be 
displayed. The name-value pair is stored as a string object.

This field is available only when the Record  option is selected.

Advanced

Header card
Toggle to open a field to add cards which may include images or YouTube 
videos. For more information, see Insert a header card in a Static Choice or 
Dynamic Choice control

Enforce user 
prompt Toggle to open a field for a custom message shown to the user instead of the 

message generated by the LLM. You can create custom messages in plain 
language, input a script, or define conditions with the data pill picker.

Additional 
instructions 
for LLM

Further instructions to the LLM, such as adding data formats, restrictions, or 
default values for user responses. You can create additional instructions in plain 
language, input a script, or define conditions with the data pill picker.

Hide or skip this node

Conditionally 
show this 
node if

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.

Allow user 
to skip this 
node if

No-code condition statement or low-code script that specifies a condition 
for letting users skip this node in the conversation. The condition must 
evaluate to true. You can set this field using either the condition builder or 
a script. When this field is active, the node presents the user with a Skip 
option in the Virtual Agent conversation. Alternatively, in an LLM topic, you 
can reply with an utterance such as I want to skip this question. 
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Example Dynamic Choice user input control for LLM topic discovery

Note: 
Virtual Agent Designer  controls may display and function differently in other channels.

Input properties List prompt

Web UI Dynamic Choice list 
prompt

The choice list displays 10 items per page. 
When 10 or more results are returned:

• The list includes a link at the end of the list 
to show more results.

• A search icon ( ) displays in the prompt for 
filtering search results. Users select the icon 
to open a search box and enter the filter.

• When selecting multiple choices, you can 
search within the Search for options  field 
for filtering search results. Select or type all 
choices that apply, and then select the send 

icon . When you send your choices, the 
LLM responds with whether your choices 
meet the validation criteria.

Header card
Toggle to open a field to add cards which may 
include images or YouTube videos. For more 
information, see Insert a header card in a 
Static Choice or Dynamic Choice control
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Dynamic Choice user input control properties for NLU topic discovery

Property Description

Node name Name that identifies this Dynamic Choice user control node in the topic flow.

Variable 
name

Name of the variable that stores the user response to this prompt. The variable 
name is automatically created from the Node name  property.

Prompt
Prompt or question for the user. The prompt can be either a text string or a script 
that returns text. This value is used only when the default value is not specified. 
For example: What's your name?

NLU entity
Option to associate an NLU entity with the node. If an NLU entity is associated 
with the input variable for this node, Virtual Agent can slot-fill the specified 
value based on the user's utterance. Select an entity from the list of entities 
associated with the topic intent.

When you specify an entity for the node, the Do not ask users to confirm 
recognized entity  toggle switch displays. When enabled, users are not prompted 
to confirm the extracted entity.

This field is available only when NLU  discovery is enabled on the instance.

Choices

Populate 
choices by

Type of dynamic variable to be used. Select one of the following options:

• Record: Returns records from the table selected. The values for these options 
are GlideRecord objects.

• Script: Expression that returns an array of options.

Table If you selected Record  as the method to populate choices, select the table to be 
searched.

This field is available only when the Record  option is selected.

Filter 
choices

Option to use the Virtual Agent Designer  condition builder or provide a script. 
Select one of the following:

• Condition Builder: Creates a filter used to select a subset of records from the 
table.

• Script: Defines the enumeration list for the options (choice list) to be 
displayed. The name-value pair is stored as a string object.

This field is available only when the Record  option is selected.

No records 
response 
message

Message displayed to the user when the table search doesn’t return any 
records. The message can be either a text string or a script that returns text.

Advanced
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Property Description

Header card
Toggle to open a field to add cards which may include images or YouTube 
videos. For more information, see Insert a header card in a Static Choice or 
Dynamic Choice control

Default value

Default Value
Predefined value for the user response to the question or prompt. The response 
defined in the Default value confirmation  field asks the user to confirm the 
default value. If the user responds with no, the value becomes null. The default 
value can be either a text string or a script that returns text. For example, if 
you're using dot-walking, the default value might be: Script Variables 
> Last username. Or if you're using a script, the default value might be: 
{{vaScripts.lastUsername}}.

Confirmation messages

Input 
completion 
confirmation

Bot response shown to the user when the node interaction is complete. 
The message can be either a text string or a script that returns text. For 
example, if you're using dot-walking: Thanks, (Input Variables > 
Username)!  Or if you're using a script, the acknowledgement might be: 
Thanks, {{vaInputs.username}}!

Default value 
confirmation Message that asks the user to verify that the value in the Default value  field 

is correct. This message is used instead of a value in the Prompt  field. It can 
contain either a text string or a script that returns text. For example, if you're 
using dot-walking: Are you (Input Variables > Username)? 
Or if you're using a script, the confirmation message might be: Are you 
{{vaScripts.lastUsername}}?.

Conversation switching

This section is available only when NLU discovery is enabled on the instance.

Turn on to 
let users 
change the 
subject

Option to enable NLU prediction for this node. If enabled, users can enter text 
to answer questions, regardless of the type of input control being used. Virtual 
Agent uses this utterance to match another existing intent, letting the user 
switch topics.

Hide or skip this node

Conditionally 
show this 
node if

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.

Allow user 
to skip this 
node if

No-code condition statement or low-code script that specifies a condition 
for letting users skip this node in the conversation. The condition must 
evaluate to true. You can set this field using either the condition builder or 
a script. When this field is active, the node presents the user with a Skip 
option in the Virtual Agent conversation. Alternatively, in an LLM topic, you 
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Property Description

can reply with an utterance such as I want to skip this question. 

Skip 
reprompting 
if

No-code condition statement or low-code script that specifies a condition for 
letting users skip reprompting in the conversation. When a preceding node is 
revisited through a topic loopback or Dialog Act, the Virtual Agent bypasses this 
node and automatically retain its original value.

Example Dynamic Choice user input control for NLU topic discovery

Note: 
Virtual Agent Designer  controls may display and function differently in other channels.
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Input properties List prompt

Web UI Dynamic Choice list 
prompt

The choice list displays 10 items per page. 
When 10 or more results are returned:

• The list includes a link at the end of the list 
to show more results.

• A search icon ( ) displays in the prompt for 
filtering search results. Users select the icon 
to open a search box and enter the filter.

• When selecting multiple choices, you can 
search within the Search for options  field 
for filtering search results. If you input the 
script to enable secondary fields found in 
this topic, the search filter results apply to 
the secondary fields, too. Select or enter all 
choices that apply, and then select the send 

icon  .

Dynamic Choice user input 
control basic properties

Web UI Dynamic Choice list 
prompt with header card
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Input properties List prompt

The choice list contains five items per page. 
When five or more results are returned, the list 
provides an option to show more results.

Note: 
The search feature is suppressed when a 
header card is used.

Dynamic Choice script examples

The following script example can be used in the Define choices  field only if the value for 
Populate choice by  is set to Script. This script enables requesters to see their previously 
selected choices if they choose to edit their choices later in the conversation. This script also 
displays secondary fields to requesters, such as an email address, gender marker, or both, 
to help them further differentiate their available choices. Displaying the secondary field to 
requesters can be especially helpful when dealing with similar values, such as selecting the 
correct employee name when working with the same or similar names (that is, Christopher Smith 
or Chris Smith).

(function execute() {
    var pagingUtil = new 
 global.VirtualAgentChoicePagingUtil(null, "sys_user", 10, 
 "user_name,name",
      "active=true", null, vaVars);
    var selectedOptions = 
 pagingUtil.getSavedSelectedOptions("user", vaSystem);
    if (!selectedOptions || selectedOptions.length == 0) {
      // Secondary labels can be passed to selected options
       selectedOptions.push({ "value": "abel.tuter", "label": 
 "Abel Tuter"
        ,"secondary_label": ["abel.tuter@example.com", "male"]
        });
       selectedOptions.push({ "value": "Beth.anglin", "label": 
 "Beth Anglin"
        ,"secondary_label": ["beth.anglin@example.com", 
 "female"]
        });
    }
    vaSystem.setSelectedOptions(selectedOptions, "user", false);
    // Topic authors have the ability to define which values 
 should go in the
    // secondary labels by adding secondary label functions
    pagingUtil.addSecondaryLabelFunction(function (gr) {
      return gr.getValue("email");
    });
    pagingUtil.addSecondaryLabelFunction(function (gr) {
      return gr.getValue("gender");
    });
    var gr = pagingUtil.getPagingGlideRecordSecure("name", 
 false);
    var options = pagingUtil.getSecureOptions(gr, 
 null,'user_name', ['user_name']);
    return options;
})()
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Example Dynamic Choice list value expression

(function execute(table) {
        var options = [];
        var gr = new GlideRecordSecure(table);
        gr.addEncodedQuery('active=true');
        gr.setLimit(5);
        gr.query();
        while(gr.next()) {
            options.push({ 'value': gr.getUniqueValue(), 
 'label': gr.getValue('short_description') });
        }
        return options;
})(table)

The script in the Choice Value Expression  property defines and returns an array of choices. 
In the example, the script creates an array called options, and adds each record found in a 
GlideRecord query to this array. Each element in the array is given a value in the value  and 
label  keys using data from that GlideRecord. The Table  property of the control defines the 
table used by the script. This example script uses gr.setLimit(5)  to limit the number of 
records returned to 5. Using this method helps prevent returned records from creating an overly 
large choice list.

Dynamic choice control value expression keys

Key Description

value The value for the choice. When a user selects 
a choice from the control, this value is stored 
in the variable named in the Variable name 
property.

label The label that appears for this choice in the 
choice list.

Channel support

Channel support for the Dynamic Choice user input control

Channel Support Constraints

Web UI Supported None

Mobile UI Supported None

Now Assist 
panel

Supported None

Microsoft Teams Supported None

Slack Supported Header cards aren’t supported.

Workplace Supported Header cards aren’t supported.

Facebook 
Messenger

Not 
supported

Not applicable

SMS Twilio Supported Header cards aren’t supported.
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Channel support for the Dynamic Choice user input control  (continued)

Channel Support Constraints

LINE Not 
supported

Not applicable

WhatsApp Supported None

Apple 
Messages for 
Business

Supported None

Alexa  (Voice) Supported For screen devices, use touch scroll; selecting links not 
supported. For nonscreen devices, use voice pagination.

Boolean user input control

Use the Boolean user input control in a Virtual Agent  topic to present a Yes/No prompt to the 
user.

Boolean user input controls prompt the user to answer a Yes/No question, and store the 
response as a string with a value of true  or false. Use this value in topic utilities, such as the 
prompted Decision utility, to branch the topic flow based on the answer.

Boolean user input control properties for LLM topic discovery

Property Description

Node name Name that identifies this Boolean user input control node in the topic flow.

Detail 
description

The one piece of information needed from the user, presented as a binary 
choice. For example, Ask the user if they have performed the 
latest software update to their machine.

Advanced

Enforce user 
prompt Toggle to open a field for a custom message shown to the user instead of the 

message generated by the LLM. You can create custom messages in plain 
language, input a script, or define conditions with the data pill picker.

Additional 
instructions 
for LLM

Further instructions to the LLM, such as adding data formats, restrictions, or 
default values for user responses. You can create additional instructions in plain 
language, input a script, or define conditions with the data pill picker.

Hide or skip this node

Conditionally 
show this 
node if

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.

Allow user 
to skip this 
node if

No-code condition statement or low-code script that specifies a condition 
for letting users skip this node in the conversation. The condition must 
evaluate to true. You can set this field using either the condition builder or 
a script. When this field is active, the node presents the user with a Skip 
option in the Virtual Agent conversation. Alternatively, in an LLM topic, you 
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Property Description

can reply with an utterance such as I want to skip this question. 

Example Boolean user input control for LLM topic discovery

Note: 
Virtual Agent Designer  controls may display and function differently in other channels.

Input properties Input prompt

Web UI Boolean user input prompt

Slack Boolean user input prompt

Boolean user input control properties for NLU topic discovery

Property Description

Node name Name that identifies this Boolean user input control node in the topic flow.

Variable 
name

Variable that stores the choice selected by the user. The variable name is 
automatically created from the Node name  property.
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Property Description

Prompt
Prompt or question for the user. The prompt can be either a text string or a script 
that returns text. This value is used only when the default value is not specified. 
For example: What's your name?

NLU entity

[NLU topic 
discovery 
only]

Option to associate an NLU entity with the node. If an NLU entity is associated 
with the input variable for this node, Virtual Agent can slot-fill the specified 
value based on the user's utterance. Select an entity from the list of entities 
associated with the topic intent.

When you specify an entity for the node, the Do not ask users to confirm 
recognized entity  toggle switch displays. When enabled, users are not prompted 
to confirm the extracted entity.

Advanced

Default value

Predefine 
a value for 
user input

Predefined value for the user response to the question or prompt. The response 
defined in the Default value confirmation  field asks the user to confirm the 
default value. If the user responds with no, the value becomes null. The default 
value can be either a text string or a script that returns text. For example, if 
you're using dot-walking, the default value might be: Script Variables 
> Last username. Or if you're using a script, the default value might be: 
{{vaScripts.lastUsername}}.

Confirmation messages

Input 
completion 
confirmation

Bot response shown to the user when the node interaction is complete. 
The message can be either a text string or a script that returns text. For 
example, if you're using dot-walking: Thanks, (Input Variables > 
Username)!  Or if you're using a script, the acknowledgement might be: 
Thanks, {{vaInputs.username}}!

Default value 
confirmation Message that asks the user to verify that the value in the Default value  field 

is correct. This message is used instead of a value in the Prompt  field. It can 
contain either a text string or a script that returns text. For example, if you're 
using dot-walking: Are you (Input Variables > Username)? 
Or if you're using a script, the confirmation message might be: Are you 
{{vaScripts.lastUsername}}?.

Conversation switching

This section is available only when NLU discovery is enabled on the instance.

Turn on to 
let users 
change the 
subject

Option to enable NLU prediction for this node. If enabled, users can enter text 
to answer questions, regardless of the type of input control being used. Virtual 
Agent uses this utterance to match another existing intent, letting the user 
switch topics.

Hide or skip this node
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Property Description

Conditionally 
show this 
node if

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.

Allow user 
to skip this 
node if

No-code condition statement or low-code script that specifies a condition 
for letting users skip this node in the conversation. The condition must 
evaluate to true. You can set this field using either the condition builder or 
a script. When this field is active, the node presents the user with a Skip 
option in the Virtual Agent conversation. Alternatively, in an LLM topic, you 
can reply with an utterance such as I want to skip this question. 

Skip 
reprompting 
if

No-code condition statement or low-code script that specifies a condition for 
letting users skip reprompting in the conversation. When a preceding node is 
revisited through a topic loopback or Dialog Act, the Virtual Agent bypasses this 
node and automatically retain its original value.

Example Boolean user input control for NLU topic discovery

Note: 
Virtual Agent Designer  controls may display and function differently in other channels.
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Input properties Input prompt

Web UI Boolean user input promptBoolean user input control basic properties

Slack Boolean user input prompt

Channel support

Channel support for the Boolean user input control

Channel Support Constraints

Web UI Supported None

Mobile UI Supported None

Now Assist  panel Supported None

Microsoft Teams Supported None

Slack Supported None

Workplace Supported None

Facebook Messenger Supported None

SMS Twilio Supported None

LINE Supported None

WhatsApp Supported None

Apple Messages for Business Supported None
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Channel support for the Boolean user input control  (continued)

Channel Support Constraints

Alexa  (Voice) Supported None

Date Time user input control

Use the Date Time user input control in a Virtual Agent  topic to enable the user to select a 
calendar date, time (hours and minutes), or both.

Date Time user input control properties for LLM topic discovery

The Date Time user input control accepts inputs from a calendar selection, or by entering plain 
language in the Virtual Agent  chat window. If you type your answer, the Virtual Agent  accepts 
different inputs depending on how your region handles dates. For example, if you're in the United 
States, the input control supports the MM-DD-YYYY format, while a user in Spain enters the date 
in DD-MM-YYYY format.

Date Time 
property

Description

Name Name that identifies this Date Time user input control node in the topic flow.

Detail 
description

The one piece of information requested from the user. For example, Ask the 
user when they would like to schedule their departure.

Input format Type of Date Time control to be displayed. Select one of the following formats:

• Date: Shows only the monthly calendar for the user to select the date.

• DateTime: Shows both a monthly calendar and time picker.

• Time: Shows only the time picker for the user to select the time (hours and 
minutes).

Advanced

Enforce user 
prompt Toggle to open a field for a custom message shown to the user instead of the 

message generated by the LLM. You can create custom messages in plain 
language, input a script, or define conditions with the data pill picker.

Additional 
instructions 
for LLM

Further instructions to the LLM, such as adding data formats, restrictions, or 
default values for user responses. You can create additional instructions in plain 
language, input a script, or define conditions with the data pill picker.

Hide or skip this node

Conditionally 
show this 
node if

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.

Allow user 
to skip this 
node if

No-code condition statement or low-code script that specifies a condition 
for letting users skip this node in the conversation. The condition must 
evaluate to true. You can set this field using either the condition builder or 
a script. When this field is active, the node presents the user with a Skip 
option in the Virtual Agent conversation. Alternatively, in an LLM topic, you 
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Date Time 
property

Description

can reply with an utterance such as I want to skip this question. 

Example Date Time user input control for LLM topic discovery

Note: 
Virtual Agent Designer  controls may display and function differently in other channels.

Input properties Date Time prompt

Web UI Date Time prompt
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Date Time user input control properties for NLU topic discovery

Date Time 
property

Description

Name Name that identifies this Date Time user input control node in the topic flow.

Variable 
Name

Name of the variable that stores the user response to this prompt. The variable 
name is automatically created from the Name  property.

Prompt
Prompt or question for the user. The prompt can be either a text string or a script 
that returns text. This value is used only when the default value is not specified. 
For example: What's your name?

NLU entity

[NLU topic 
discovery 
only]

Option to associate an NLU entity with the node. If an NLU entity is associated 
with the input variable for this node, Virtual Agent can slot-fill the specified 
value based on the user's utterance. Select an entity from the list of entities 
associated with the topic intent.

When you specify an entity for the node, the Do not ask users to confirm 
recognized entity  toggle switch displays. When enabled, users are not prompted 
to confirm the extracted entity.

Input format Type of Date Time control to be displayed. Select one of the following formats:

• Date: Shows only the monthly calendar for the user to select the date.

• DateTime: Shows both a monthly calendar and time picker.

• Time: Shows only the time picker for the user to select the time (hours and 
minutes).

Advanced

Default value

Predefine 
a value for 
user input

Predefined value for the user response to the question or prompt. The response 
defined in the Default value confirmation  field asks the user to confirm the 
default value. If the user responds with no, the value becomes null. The default 
value can be either a text string or a script that returns text. For example, if 
you're using dot-walking, the default value might be: Script Variables 
> Last username. Or if you're using a script, the default value might be: 
{{vaScripts.lastUsername}}.

Confirmation messages

Input 
completion 
confirmation

Bot response shown to the user when the node interaction is complete. 
The message can be either a text string or a script that returns text. For 
example, if you're using dot-walking: Thanks, (Input Variables > 
Username)!  Or if you're using a script, the acknowledgement might be: 
Thanks, {{vaInputs.username}}!

Default value 
confirmation Message that asks the user to verify that the value in the Default value  field 

is correct. This message is used instead of a value in the Prompt  field. It can 
contain either a text string or a script that returns text. For example, if you're 
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Date Time 
property

Description

using dot-walking: Are you (Input Variables > Username)? 
Or if you're using a script, the confirmation message might be: Are you 
{{vaScripts.lastUsername}}?.

Conversation switching

This section is available only when NLU discovery is enabled on the instance.

Turn on to 
let users 
change the 
subject

Option to enable NLU prediction for this node. If enabled, users can enter text 
to answer questions, regardless of the type of input control being used. Virtual 
Agent uses this utterance to match another existing intent, letting the user 
switch topics.

Hide or skip this node

Conditionally 
show this 
node if

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.

Allow user 
to skip this 
node if

No-code condition statement or low-code script that specifies a condition 
for letting users skip this node in the conversation. The condition must 
evaluate to true. You can set this field using either the condition builder or 
a script. When this field is active, the node presents the user with a Skip 
option in the Virtual Agent conversation. Alternatively, in an LLM topic, you 
can reply with an utterance such as I want to skip this question. 

Skip 
reprompting 
if

No-code condition statement or low-code script that specifies a condition for 
letting users skip reprompting in the conversation. When a preceding node is 
revisited through a topic loopback or Dialog Act, the Virtual Agent bypasses this 
node and automatically retain its original value.

Example Date Time user input control for NLU topic discovery

Note: 
Virtual Agent Designer  controls may display and function differently in other channels.
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Input properties Date Time prompt

Date Time user input control 
basic properties

Web UI Date Time prompt

Channel support

Channel support for the Date Time user input control

Channel Support Constraints

Web UI Supported None

Mobile UI Supported None

Now Assist 
panel

Supported None

Microsoft 
Teams

Supported None

Slack Supported None

Workplace Supported
The Workplace  interface does not natively support a date selection 
widget. Date and time selection is instead done with the buttons that 
are supported in these interfaces.
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Channel support for the Date Time user input control  (continued)

Channel Support Constraints

The Date Time user input control prompts the user for a date, showing 
the current date and time. The user clicks the month, day, year, or time 
button to modify that value. The time and day fields prompt the user to 
type in a new value. The month and year fields show a set of buttons 
with the current and upcoming months or years. Select one of these 
buttons or type in a value to set the time or year.

Facebook 
Messenger

Supported If your administrator has set the option to request the time zone 
from the customer, the selected date and time reflect the customer's 
time zone. Otherwise, they appear in the UTC time zone. For more 
information about the time zone setting, see Set up Conversational 
Integration with Facebook Messenger.

SMS Twilio Not 
supported

Not applicable

LINE Supported None

WhatsApp Supported None

Apple 
Messages 
for 
Business

Supported None

Alexa 
(Voice)

Supported For best results, enable NLU at the node.

File Picker user input control

Use the File Picker user input control in a Virtual Agent  topic to prompt a user to upload an image 
or any file type. After the user uploads an image file, the image appears immediately in the Virtual 
Agent  client.

File Picker user input control properties

All file types are supported by the file picker, except the SVG format for image files. Although the 
image can be high resolution, the image displayed in the Virtual Agent  client is scaled based on 
the aspect ratio. Images scale to fit within the chat window.

In Microsoft Teams, a file can be uploaded through the paper clip (attachment) icon, or using 
drag-and-drop. Copying and pasting only works for image files. Users can share attachments 
on Microsoft Teams  through the Virtual Agent  file picker user input control, and by sending 
attachments while chatting with a live agent. Multi-attachments are supported for both live agent 
and file picker scenarios.

Learn what the live agent picker scenario supports or doesn't support:

• Supports multiple files.

• Doesn't support the SVG format for image files.

• Supports a combination of text, files, and emojis. However, orders may show up differently 
between how a user sends these items versus how an agent views these items.

• Doesn't support formatted text.
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When a file upload is in progress, you can't upload or enter text for the live agent picker scenario. 
The uploaded files go through a virus scan and validation.

Learn what the File Picker control supports or doesn't support:

• Supports multiple files.

• Doesn't support the SVG format for image files.

When a file upload is in progress, you can't upload or enter text for the file picker control. The 
uploaded files go through a virus scan and validation.

You can link an uploaded file to a case you create using the Record Action utility. For more 
information, see Record Action utility.

The following table lists the details about the properties of the File Picker.

File Picker properties

Property Description

Node name Name that identifies the File Picker user input control node in the topic flow.

Variable 
name

Name of the variable that stores the user response to this prompt. The variable 
name is automatically created from the Node name  property.

Prompt Prompt or question asking the user to upload the item. The prompt can be a text 
string that includes variables or a script that returns text.

Allow user to 
upload

Type of file to upload. All file types are supported, except the SVG format for 
image files.

Advanced

Confirmation messages

Input 
completion 
confirmation

Bot response shown to the user when the node interaction is complete. 
The message can be either a text string or a script that returns text. For 
example, if you're using dot-walking: Thanks, (Input Variables > 
Username)!  Or if you're using a script, the acknowledgement might be: 
Thanks, {{vaInputs.username}}!

Default value 
confirmation Message that asks the user to verify that the value in the Default value  field 

is correct. This message is used instead of a value in the Prompt  field. It can 
contain either a text string or a script that returns text. For example, if you're 
using dot-walking: Are you (Input Variables > Username)? 
Or if you're using a script, the confirmation message might be: Are you 
{{vaScripts.lastUsername}}?.

Hide or skip this node

Conditionally 
show this 
node if

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.

Allow user 
to skip this 
node if

No-code condition statement or low-code script that specifies a condition 
for letting users skip this node in the conversation. The condition must 
evaluate to true. You can set this field using either the condition builder or 
a script. When this field is active, the node presents the user with a Skip 
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File Picker properties  (continued)

Property Description

option in the Virtual Agent conversation. Alternatively, in an LLM topic, you 
can reply with an utterance such as I want to skip this question. 

Skip 
reprompting 
if

No-code condition statement or low-code script that specifies a condition for 
letting users skip reprompting in the conversation. When a preceding node is 
revisited through a topic loopback or Dialog Act, the Virtual Agent bypasses this 
node and automatically retain its original value.

Using the File Picker control in different client interfaces

The process to select an image differs based on the Virtual Agent  client interface. Use the 
following steps to select an image in the client interface of your choice.

The following table lists details about the File Picker control in different client interfaces.

File Picker control in different client interfaces

Platform Steps to select an image or file

Web UI 1. Select Click here to upload an image.  or 
Click here to upload a file.

2. Select a file from your local computer. All file 
types are supported.

Slack 1. Select the Green +  icon.

2. Select Your computer.

3. Select an image file from your local 
computer.

All file types are supported.

Microsoft Teams 1. On your local computer, copy an image file.

2. Paste the image file into the text input field 
in Microsoft Teams.
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File Picker control in different client interfaces  (continued)

Platform Steps to select an image or file

Workplace 1. Select the Workplace image icon .

2. Select an image file from your local 
computer.

All file types are supported.

ServiceNow mobile 1. Touch Upload an image.

2. Select an image file from the photo library 
on your mobile device.

Note: 
The Upload a file  button is only available 
when you enable the All file types  file 
picker property.

Example of a File Picker user input control

Note: 
Virtual Agent Designer  controls may display and function differently in other channels.

File Picker properties File Picker prompt

Web UI file picker prompt 
(image)File Picker user input control 

basic properties

ServiceNow mobile  file picker 
prompt
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Channel support

The following table lists the details about the channel support for the File Picker user input 
control.

Channel support for the File Picker user input control

Channel Support Constraints

Web UI Supported None

Mobile UI Supported
Prompt that users see asking for permission for the app to access 
a camera or file system if the user has not already given the 
permission.

Now Assist 
panel

Supported None

Microsoft 
Teams

Supported None

Slack Supported None

Workplace Supported None

Facebook 
Messenger

Supported
Supported file types are JPG, PNG, BMP, and MP4. The files have a 
maximum size limit based on the file type:

• For images, the maximum size limit is 10 MB.

• For videos, the maximum size limit is 200 MB.

SMS Twilio Partial 
support

Image files only

LINE Supported
Supported file types are JPG, PNG, BMP, and MP4. The files have a 
maximum size limit based on the file type:

• For images, the maximum size limit is 10 MB.

• For videos, the maximum size limit is 200 MB.

WhatsApp Supported None

Apple 
Messages for 
Business

Supported None

Alexa  (Voice) Not 
supported

Not applicable
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Carousel user input control

Use the Carousel user input control in a Virtual Agent  topic to present a prompt and a horizontal 
series of labeled images. The user can select a single item from the carousel.

Tip: 
If you want to change the default number of listed items per page, you can modify the 
com.glide.cs.picker_page_limit  system property. The default value is 10.

Carousel input control properties for LLM topic discovery

Property Description

Node name Name that identifies this Carousel user input control node in the topic flow.

Variable 
name

Name of the variable that stores the selection made by the user. The variable 
name is automatically created from the Node name  property.

Detail 
description

Description of the information that you need from users.

Define 
carousel 
items

Use a script to create items for selection in your carousel. The script should 
return an array containing one or more items. See the Example carousel item 
expression section in this topic.

Advanced (optional)

Enforce user prompt

Enforce user 
prompt

Toggle to open the User prompt  field. The value in the User prompt  field is 
shown to users rather than the LLM-generated message. You can create custom 
messages using plain language, scripts, or define conditions with the data pill 
picker.

Additional 
instructions 
for LLM

Further instructions to the LLM, such as adding data formats, restrictions, or 
default values for user responses. You can create additional instructions in plain 
language, input a script, or define conditions with the data pill picker.

Hide or skip this node

Conditionally 
show this 
node if

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true. 
This field is not applicable when the Carousel node is used within the Input 
Collector node.

Allow user 
to skip this 
node if

No-code condition statement or low-code script that specifies a condition 
for letting users skip this node in the conversation. The condition must 
evaluate to true. You can set this field using either the condition builder or 
a script. When this field is active, the node presents the user with a Skip 
option in the Virtual Agent conversation. Alternatively, in an LLM topic, you 
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Property Description

can reply with an utterance such as I want to skip this question. 

Example Carousel input control for LLM topic discovery

Carousel properties Carousel prompt

Web UI carousel prompt

Carousel input control properties for NLU topic discovery

Property Description

Node name Name that identifies this Carousel user input control node in the topic flow.
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Property Description

Variable 
name

Name of the variable that stores the selection made by the user. The variable 
name is automatically created from the Node name  property.

Prompt
Prompt or question for the user. The prompt can be either a text string or a script 
that returns text. This value is used only when the default value is not specified. 
For example: What's your name?

NLU entity
Option to associate an NLU entity with the node. If an NLU entity is associated 
with the input variable for this node, Virtual Agent can slot-fill the specified 
value based on the user's utterance. Select an entity from the list of entities 
associated with the topic intent.

When you specify an entity for the node, the Do not ask users to confirm 
recognized entity  toggle switch displays. When enabled, users are not prompted 
to confirm the extracted entity.

This field is available only when NLU  discovery is enabled on the instance.

Define 
carousel 
items

Use a script to create items for selection in your carousel. The script should 
return an array containing one or more items. See the Example carousel item 
expression section in this topic.

No records 
response 
message

Message to the user indicating that no records were found. The message can be 
either a text string or a script that returns text.

Advanced

Default value

Default value
Predefined value for the user response to the question or prompt. The response 
defined in the Default value confirmation  field asks the user to confirm the 
default value. If the user responds with no, the value becomes null. The default 
value can be either a text string or a script that returns text. For example, if 
you're using dot-walking, the default value might be: Script Variables 
> Last username. Or if you're using a script, the default value might be: 
{{vaScripts.lastUsername}}.

Confirmation messages

Input 
completion 
confirmation

Bot response shown to the user when the node interaction is complete. 
The message can be either a text string or a script that returns text. For 
example, if you're using dot-walking: Thanks, (Input Variables > 
Username)!  Or if you're using a script, the acknowledgment might be: 
Thanks, {{vaInputs.username}}!.

Default value 
confirmation Message that asks the user to verify that the value in the Default value  field 

is correct. This message is used instead of a value in the Prompt  field. It can 
contain either a text string or a script that returns text. For example, if you're 
using dot-walking: Are you (Input Variables > Username)? 
Or if you're using a script, the confirmation message might be: Are you 
{{vaScripts.lastUsername}}?.

Conversation switching
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Property Description

This section is available only when NLU discovery is enabled on the instance.

Turn on to 
let users 
change the 
subject

Option to enable NLU prediction for this node. If enabled, users can enter text 
to answer questions, regardless of the type of input control being used. Virtual 
Agent uses this utterance to match another existing intent, letting the user 
switch topics.

Hide or skip this node

Conditionally 
show this 
node if

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.

Allow user 
to skip this 
node if

No-code condition statement or low-code script that specifies a condition 
for letting users skip this node in the conversation. The condition must 
evaluate to true. You can set this field using either the condition builder or 
a script. When this field is active, the node presents the user with a Skip 
option in the Virtual Agent conversation. Alternatively, in an LLM topic, you 
can reply with an utterance such as I want to skip this question. 

Skip 
reprompting 
if

No-code condition statement or low-code script that specifies a condition for 
letting users skip reprompting in the conversation. When a preceding node is 
revisited through a topic loopback or Dialog Act, the Virtual Agent bypasses this 
node and automatically retain its original value.

Example Carousel input control for NLU topic discovery

Note: 
Virtual Agent Designer  controls may display and function differently in other channels.
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Carousel properties Carousel prompt

Web UI carousel prompt

ServiceNow mobile  carousel 
prompt
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Example carousel item expression

(function execute() {
    var options = [];
       options.push(
            {
                'Name': 'Item 1',
                'Value': 'item_1',
                'Description': 'Acme keyboard model 200',
                'Body': 
 'https://images.pexels.com/photos/688666/pexels-photo-688666.jp
eg'
            }
       );
       options.push(
            {
                'Name': 'Item 2',
                'Value': 'item_2',
                'Description': 'Acme keyboard model 300',
                'Body': 
 'https://images.pexels.com/photos/916472/pexels-photo-916472.jp
eg'
            }
       );
       return options;
 
})()

The script in the Carousel Item Expression  property defines and returns an array containing the 
items that appear in your carousel. The elements of this array must contain name, value, and 
body  keys. In the example, the script creates an array called options  and adds two elements, 
each with the required keys. The images here are hard-coded as an example.

Example code key

Key Description

Name Name of the carousel item. This name is shown below the image on the carousel.

Value Value for the item. When a user selects a carousel item, this value is stored in the 
variable named in the Variable name  property.

Description Text string that describes the carousel item. The description is shown below 
the image name. A carousel with more than three items displays left and right 
arrows for scrolling through the images and a Select  button under each item. If a 
description is over 140 characters, users can expand the content.

Body Image used in the carousel item. The value is a URL for an image file.

Channel support

Channel support for the Carousel user input control

Channel Support Constraints

Web UI Supported None

Mobile UI Supported None
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Channel support for the Carousel user input control  (continued)

Channel Support Constraints

Now Assist 
panel Supported None

Microsoft 
Teams

Supported None. If the carousel contains more than 10 items, users must select 
Next  to review the remaining items.

Slack Supported None

Workplace Supported None

Facebook 
Messenger

Supported The title for an image has a maximum limit of 40 characters. The text 
for the image has a maximum character limit of 60 characters. A user 
can view only 10 images at a time. If there are more than 10 images, 
the pagination format is used to view more options. The default 
value of the maximum number of images in a carousel for a page 
is set in the sn_va_fb_messenger.max_carousel_cards 
system property. This property is found in the System Properties 
[sys_properties] table.

SMS Twilio Not 
supported

Not applicable

LINE Supported The title for an image has a maximum limit of 40 characters. The text 
for the image has a maximum character limit of 60 characters. A user 
can view only 10 images at a time. If there are more than 10 images, 
the pagination format is used to view more options. The default value 
of the maximum number of images in the carousel for a page is set in 
the sn_va_line.max.carousel.cards  system property. The 
property is located in the System Properties [sys_properties] table.

WhatsApp Supported None

Apple 
Messages 
for 
Business

Supported None

Alexa 
(Voice)

Supported For screen devices, use touch scroll. For nonscreen devices, use 
voice pagination.

Secure Text user input control

The Secure Text control provides a means to encrypt sensitive information provided as simple 
text or other formats. Use this control to encrypt sensitive information in topics that use large 
language model (LLM) discovery.

Use this control to gather and encrypt user information for topics using large language model 
(LLM) topic discovery. The Secure Text input also avoids sensitive information from being sent 
through an LLM.

Secure Text user input control properties

Property Description

Node name Name that identifies this Secure Text user input control node in the topic flow.
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Property Description

Prompt Text string or script that returns text. This value is used only when the default 
value isn’t specified. For example: What is your password?

Input format
Text format that is validated when a user enters certain text items. When the 
input isn’t valid, the bot asks the user to reenter the text.

Choose the format of the text item to be validated:

• Text: Any text string (no validation).

• Email: Format that consists of an email prefix (user name), the @ symbol, and 
domain.

• IP address (IPV4, IPV6): Data communication delivery format for internet 
Protocol version 4 or version 6.

• Phone number (E.164): Internationally recognized standard phone number 
format.

• URL: Web address format.

• Custom: A script that provides a validation rule for a custom text format. The 
script should include related error messages that are displayed when the 
expected format isn’t entered.

For phone and IP address format examples, see E.164 phone formats  and IP 
address field types .

Hash 
function

The method digest algorithm based on the standard WS-Security specification.

Encryption 
salt

Random data that is used as an additional input to a one-way function that 
hashes data.

Advanced

Default value A value for the user response to the prompt. For example, if you already know 
the user name, the default value might be (Script Variables > Last 
username).

Confirmation messages

Input 
completion 
confirmation

Bot response shown to the user when the node interaction is complete. 
The message can be either a text string or a script that returns text. For 
example, if you're using dot-walking: Thanks, (Input Variables > 
Username)!  Or if you're using a script, the acknowledgement might be: 
Thanks, {{vaInputs.username}}!

Default value 
confirmation

Message that asks the user to verify that the value in the Default value field 
is correct. This message is used instead of a value in the Prompt field. For 
example: Are you (Script Variables > Username)?

Hide or skip this node

Conditionally 
show this 
node

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.
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Property Description

Allow user 
to skip this 
node if

No-code condition statement or low-code script that specifies a condition 
for letting users skip this node in the conversation. The condition must 
evaluate to true. You can set this field using either the condition builder or 
a script. When this field is active, the node presents the user with a Skip 
option in the Virtual Agent conversation. Alternatively, in an LLM topic, you 
can reply with an utterance such as I want to skip this question. 

Skip 
reprompting

No-code condition statement or low-code script that specifies a condition for 
letting users skip reprompting in the conversation. When a preceding node is 
revisited through a topic loopback or Dialog Act, the Virtual Agent bypasses this 
node and automatically retain its original value.
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Example Secure Text user input control

Input properties Input prompt

Secure Text input control basic properties Web UI Secure Text user input prompt

Channel support

Note: 
Virtual Agent Designer  controls may display and function differently in other channels.

Channel support for the Text user input control

Channel Support Constraints

Web UI Supported None.

Mobile UI Supported None.

Now Assist 
panel

Supported None.

Microsoft 
Teams

Supported None.
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Channel support for the Text user input control  (continued)

Channel Support Constraints

Slack Supported Slack  users can edit text previously entered in a conversation. 
However, Virtual Agent  processes messages as they’re first entered. 
If a Slack user edits text input, such as a comment to update a case, 
then Virtual Agent  doesn’t evaluate the edited update.

Workplace Supported None.

Facebook 
Messenger

Supported The maximum character limit is 5000 characters.

SMS Twilio Supported None.

LINE Supported The maximum character limit is 5000 characters.

WhatsApp Supported None.

Apple 
Messages 
for 
Business

Supported None.

Alexa 
(Voice)

Supported For screen devices, character limits may apply. For more information, 
see the Alexa developer documentation .

Virtual Agent Designer  bot responses

Virtual Agent Designer  offers various controls for displaying bot responses in a conversation. 
Because the bot responses occur in third-party platforms, the format for each output may vary.

The following bot response controls are available for use within a Virtual Agent  topic.

Text bot response control

Use the Text bot response control in a Virtual Agent  topic to display a bot response as text. You 
can format the Text bot responses using the text editor controls. For example, you can bold or 
italicize the text, as well as include links, bulleted lists, and emojis.

Text bot response properties

Property Description

Node name Name that identifies this Text bot response node in the topic flow.

Response 
message

The Text bot response to the user. The response can be one of the following:

• Rich text message.

• Script, which can include Glide record variables or script variables.

Note: 
The script can also include a temporary password for the end user.

You can format the text messages using the text editor controls. For example, 
you can use the icons on the Response Message  field to bold or italicize the 
text, as well as include links, bulleted lists, numbered lists, and emojis.
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Property Description

You can also include an input variable, such as a temporary password, in the 
response message.

To include a link, do one of the following:

• Click the link icon: .

• Add your response message. Select the text to use as a link, and then click 
the link icon.

Fill in the fields in the Confirmation window. Enter the text to use as the link, and 
then enter the URL in the Link field.

Enter the display label for the link and a static URL, or use the data pill picker to 
create a dynamic URL.

Add 
alternate 
message

Add one or more alternate response messages for the user. Virtual Agent 
randomly chooses one of your responses for each conversation.

Advanced

Make this response secure

Enable When enabled, the bot response is displayed to the user, but thereafter securely 
masked and not viewable by others.

Hide this node

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2479



Property Description

Conditionally 
show this 
node if

A no-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.

Channel support

Channel support for the Text bot response control

Channel Support Constraints

Web UI Supported None

Mobile UI Supported None

Now Assist  panel Supported None

Microsoft Teams Supported None

Slack Supported None

Workplace Supported None

Facebook Messenger Supported Plain text string only

SMS Twilio Supported None

LINE Supported None

WhatsApp Supported None

Apple Messages for 
Business

Supported None

Alexa  (Voice) Supported For screen devices, full support. For nonscreen devices, 
the header is read.

Example Text bot response script

In this example, the script returns a string that greets the user. The 
gs.getUser().getFirstName()  property is used to append the first name of the current 
user.

(function execute() {
    return 'Hello ' + gs.getUser().getFirstName();
})()

In this example, the script returns links to three instances in the response. Use Markdown  to 
include multiple links in the script.

(function execute() {
    var output = 'Hello\n';
    output += '\n- [Instance 1](http://instance1.com)';
    output += '\n- [Instance 2](http://instance2.com)';
    output += '\n- [Instance 3](http://instance3.com)';
    return output;
})()
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Example Text bot response control

Note: 
Virtual Agent Designer  controls may display and function differently in other channels.

Response properties Text bot response output

Text bot response control basic 
properties

Web UI Text bot response output

Image bot response control

Use the Image bot response control in a Virtual Agent  topic to upload and display an image from 
a URL link. The image aspect ratio determines how the image is sized in the bot chat bubble.

Image bot response control properties

Property Description

Node name Name that identifies this Image bot response control node in the topic flow.

Image URL 
link

The URL link to an image file you want to include in the conversation. To set a 
value, do one of the following:

• Specify the image URL by using the text field, data pill, or script.

• Upload an image by clicking Upload Image.

If you upload an image, then the selected image is uploaded to the server and 
is stored in the Images [sys_db_image] table and in the update sets. When the 

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2481



Property Description

image is stored in the Images table and the update sets, then you can use the 
image in a production or non-production instance, as needed.

After the image is uploaded, the URL link is included in theResponse Properties 
sheet:

Click the link to view the image.

The URL is generated dynamically. The name of the instance is inserted at the 
front of the URL path.

You can change or delete the link to the image. If you delete the link on this 
property sheet, only the reference to the URL is deleted. The image remains on 
the server for future use.

Image alt 
text

Alternative, screen-readable text included for accessibility. This text is used 
along with the image. Enter the text using the text field, data pill, or script. For 
more information about using data pills or scripts, see Virtual Agent Designer 
controls.

Advanced

Hide this node

Conditionally 
show this 
node if

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.

Channel support

Channel support for the Image bot response control

Channel Support Constraints

Web UI Supported The maximum image size is determined by the 
com.glide.attachment.max_size  system property. The 
default value is 1024 MB.

Mobile UI Supported The maximum image size is determined by the 
com.glide.attachment.max_size  system property. The 
default value is 1024 MB.

Now Assist 
panel

Not 
supported

Not applicable

Microsoft 
Teams

Supported None
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Channel support for the Image bot response control  (continued)

Channel Support Constraints

Slack Supported For details about the maximum image size allowed, check the Slack 
documentation.

Workplace Supported For details about the maximum image size allowed, check the 
Workplace  documentation.

Facebook 
Messenger

Supported For details about the maximum image size allowed, check the 
Facebook Messenger  documentation.

SMS Twilio Supported File size limits may vary. For Twilio  limitations, check their Accepted 
Content Types for Media .

LINE Supported File size limits may vary. For details, see the LINE  documentation.

WhatsApp Supported File size limits may vary. For details, see the WhatsApp 
documentation.

Apple 
Messages 
for 
Business

Supported None

Alexa 
(Voice)

Partial 
support

Supported on devices with screens. For nonscreen devices, the user 
receives a message: We found an image. For details, see Fine-
tune Virtual Agent settings and topics for the best Alexa voice chat 
experience.

Example Image bot response control

Note: 
Virtual Agent Designer  controls may display and function differently in other channels.
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Response properties Image bot response output

Web UI Image bot response 
output

Image bot response control 
basic properties

ServiceNow mobile  Image bot 
response output

Link bot response control

Use the Link bot response control in a Virtual Agent  topic to present a bot response. The 
response contains a header prompt with either a single URL link to an item or multiple URL links 
for up to three items.

Note: 
If you are using the link bot response control for Virtual Agent  conversations on Now mobile 
apps, web links open in the mobile browser. If you want links to open in a native mobile 
screen within the mobile app, create deep links for items in your conversation topics. For 
details about deep linking in mobile apps, see the MobileDeepLinkGenerator - Global  API.

Link bot response control properties

Property Description

Node name Name that identifies this Link bot response control node in the topic flow.

Link list Type of links returned in the output result.
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Property Description

• Select Single Link  to return one item in the output results.

• Select Multiple Links  to return up to three items in the output results.

Single link properties

Header Message displayed above the URL link. The message can be a string with 
variables or a script.

Label Text that identifies a single link in the bot bubble. The text can be a string with 
variables or a script.

Link Link to a single item, such as a website page or a particular record. The 
link can be a string with variables or a script that returns a valid URL as a 
string. For example, you can enter the complete URL, such as https://
servicenow.com.

Multiple links properties

Header 
Message

Text prompt that is displayed above the list of links. The prompt can be a string 
with variables or a script.

Link List 
Value 
Expression

Script that creates a list of links to display. The script includes the following 
parameters: link URL, link display label, link description, and link context.

Advanced

Hide this node

Conditionally 
show this 
node if

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.

Channel support

Channel support for the Link bot response control

Channel Support Constraints

Web UI Supported None

Mobile UI Supported None

Now Assist 
panel

Supported None

Microsoft 
Teams

Supported None

Slack Supported None

Workplace Supported None

Facebook 
Messenger

Supported The web link appears as a URL button  in the conversation.

SMS Twilio Supported None

LINE Supported None

WhatsApp Supported None
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Channel support for the Link bot response control  (continued)

Channel Support Constraints

Apple 
Messages 
for 
Business

Supported Any URLs must be added to the allowed domain list 
[sys_cs_hostname_allow_list] table.

Alexa 
(Voice)

Partial 
support

Supported on devices with screens. For nonscreen devices, the user 
receives a message: We found a link. For details, see Fine-
tune Virtual Agent settings and topics for the best Alexa voice chat 
experience.

Example single-link bot response control

Note: 
Virtual Agent Designer  controls may display and function differently in other channels.

Single link bot response properties Link bot response output

Single Link bot response control 
basic properties

Web UI Link bot response output
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Example multiple-link bot response control properties

Multi-link bot response properties Link bot response output

Multi-link bot response control 
basic properties

Web UI Link bot response output 
- multiple URL links

Note: 
Multi-link bot output is also supported in 
Microsoft Teams, Slack, Workplace, and 
Facebook Messenger.

HTML bot response control

Use the HTML bot response control to display static HTML text in the Virtual Agent  bot response.

Note: 
If you created conversations in earlier releases that use this bot response control to 
generate card layouts, consider updating your conversations to use the Card bot response 
control. The Card displays information from a record in your instance and contains a link to 
that related record.

Security considerations for HTML markup

For security reasons, an HTML sanitizer script runs automatically and checks all HTML markup 
used in the instance, including Virtual Agent  conversations. The sanitizer script removes 
elements or attributes that might enable cross-site scripting attacks. You can edit the HTML 
sanitizer script to change the list of markup items to be preserved or removed. For details, see 
HTML sanitizer . For examples of adding markup items to the exclusion or inclusion lists, see 
Configure HTML sanitizer .

To disable the HTML sanitizer script only for Virtual Agent  conversations, add the 
com.glide.cs.html.sanitizer.enabled  system property and set the value to false. 
For details about creating a system property, see Add a system property .
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HTML bot response control properties

Property Description

Node name Name that identifies this HTML bot response 
control node in the topic flow.

HTML message HTML output to be displayed. Click the Script 

icon  to open the HTML editor and enter the 
HTML text.

Height (Pixel) Maximum height of the area for displaying 
HTML output in third-party messaging 
applications.

Width (Pixel) Maximum width of the bot bubble for 
displaying HTML output in third-party 
messaging applications.

Advanced

Hide this node

Conditionally show this node if
No-code condition statement or low-code 
script that specifies a condition for presenting 
this node in the conversation. The condition 
must evaluate to true.

Channel support

Note: 
As shown in the examples, HTML output can vary in third-party messaging applications. 
Determine an appropriate Height  and Width  area by setting initial height and width values, 
previewing the HTML output in the messaging applications you intend to use, and then 
adjusting the height and width values.

Channel support for the HTML bot response control

Channel Support Constraints

Web UI Supported None

Mobile UI Supported None

Now Assist 
panel

Supported None

Microsoft 
Teams

Supported Since HTML is rendered as an image in Microsoft Teams, other 
controls are recommended. For example, use images or cards instead 
of HTML for Microsoft Teams.

Slack Supported None

Workplace Supported None

Facebook 
Messenger

Not 
supported

Not applicable

SMS Twilio Not 
supported

Not applicable
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Channel support for the HTML bot response control  (continued)

Channel Support Constraints

LINE Not 
supported

Not applicable

WhatsApp Not 
supported

Not applicable

Apple 
Messages 
for 
Business

Not 
supported

Not applicable

Alexa 
(Voice)

Partial 
support

Supported on devices with screens. For nonscreen devices, the user 
receives a message: We found a link. For details, see Fine-
tune Virtual Agent settings and topics for the best Alexa voice chat 
experience.

Example HTML bot response output

The HTML bot response shows a static HTML as a chat response. This example includes an 
image, headings, and paragraph text. The web UI presents this content as HTML. The Slack, 
Microsoft Teams, and Workplace  user interfaces display the same content as a PNG image. URL 
links within the HTML are extracted and displayed below the image. The URL can be either an 
absolute or a relative link. If you use a relative link, it must be relative to the ServiceNow  instance.

Note: 
Virtual Agent Designer  controls may display and function differently in other channels.
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HTML bot response properties HTML bot response output

HTML bot response control 
basic properties

Web UI HTML output

Multi-response bot response control

Use the Multi-response bot response control in a Virtual Agent  topic to sequentially display two 
or more outputs. Outputs can be text, image, link, or HTML. Users can move from one output to 
the next through a provided navigation button.

Multi-response bot response control properties

Property Description

Node name The name that identifies this Multi-response control node in the 
topic flow.

Add a response One or more bot responses. For each output type, select + Add a 
Response  to specify the output and define the output properties.

1. In the Add a Response dialog box, select the Type, and specify 
the associated values:

◦ Text: In the Value  field, enter the text to be displayed in the 
response.

◦ HTML: Enter the Height  and Width, in pixels, to set the 
dimensions of the HTML block. In the HTML editor, enter the 
HTML markup to be displayed.
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Property Description

◦ Image: Enter a URL in the Image  field, or select Upload Image 
and choose the image file to upload.

◦ Link: Enter the Header, Label  (label for the link), and the Link 
(path or URL for the link).

2. Select Save.

Advanced

Navigation button label

Label the button that lets 
the user continue the 
conversation

The label for the button displayed below the output. The button 
enables the user to move to the next output in the flow.

Hide this node

Conditionally show this 
node if No-code condition statement or low-code script that specifies 

a condition for presenting this node in the conversation. The 
condition must evaluate to true.

Channel support

Channel support for the Multi-response bot response control

Channel Support Constraints

Web UI Supported None

Mobile UI Supported None

Now Assist 
panel

Not 
supported

Not applicable

Microsoft 
Teams

Supported None

Slack Supported None

Workplace Supported None

Facebook 
Messenger

Not 
supported

Not applicable

SMS Twilio Not 
supported

Not applicable

LINE Not 
supported

Not applicable

WhatsApp Not 
supported

Not applicable

Apple 
Messages 
for 
Business

Not 
supported

Not applicable
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Channel support for the Multi-response bot response control  (continued)

Channel Support Constraints

Alexa 
(Voice)

Partial 
support

Supported on devices with screens. For non-screen devices, the user 
receives a message if unsupported elements are used: We found a 
link. For details, see Fine-tune Virtual Agent settings and topics for 
the best Alexa voice chat experience.

Example Multi-response control

Note: 
Virtual Agent Designer  controls may display and function differently in other channels.

Output properties Multi-response output

Multi-response bot response 
control basic properties

Web UI Multi-response bot 
response output

Script bot response control

Use the Script bot response control in a Virtual Agent  topic to run a script that returns a single 
response or a multi-part response.
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Use the Script bot response control when creating a more complex response that relies on 
scripted calculations or requires a multi-part response. Scripted output can include text, image, 
cards, links, and HTML to create a versatile response.

Script bot response control properties

Property Description

Node name The name that identifies this Script bot response control node in the topic flow.

Script output 
type

The type of output returned by the script, either single-part or multi-part.

Script 
response 
message

The script that generates the selected output type.

Advanced

Hide this node

Conditionally 
show this 
node if

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.

Channel support

Channel support for the Script bot response control

Channel Support Constraints

Web UI Supported None

Mobile UI Supported None

Now Assist 
panel

Not 
supported

Not applicable

Microsoft 
Teams

Supported None

Slack Supported None

Workplace Supported None

Facebook 
Messenger

Not 
supported

Not applicable

SMS Twilio Not 
supported

Not applicable

LINE Not 
supported

Not applicable

WhatsApp Not 
supported

Not applicable

Apple 
Messages 
for 
Business

Not 
supported

Not applicable
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Channel support for the Script bot response control  (continued)

Channel Support Constraints

Alexa 
(Voice)

Partial 
support

Support depends on the type of response. For example, images and 
links may only be available on devices with screens. For details, see 
Fine-tune Virtual Agent settings and topics for the best Alexa voice 
chat experience.

Example script

In this example, the script calculates the time two hours from the current time and outputs a 
multi-part message that includes this information.

(function execute() {
      var gdt = new GlideDateTime();
      var gt = new GlideTime();
      gdt.addSeconds(7200);
      gt = gdt.getTime();
      var multiOutMsg = new sn_cs.MultiPartOutMsg();
      multiOutMsg.addPlainTextPart('Thank you for submitting an 
 incident.');
      multiOutMsg.addPlainTextPart('You should receive a 
 response from a technician by ' + gt.getByFormat('HH:mm'));
      return multiOutMsg;
})()

Example Script bot response control

Note: 
Virtual Agent Designer  controls may display and function differently in other channels.
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Script properties Script bot response output

Script bot response control 
basic properties

Web UI Script bot response 
output

Card bot response control

Use the Card bot response control in a Virtual Agent  topic to upload and display selected 
information from a record on your instance, along with rich content, such as a video or image.

A card can contain record information, an image, or a YouTube video content in a compact 
format. The compact format is designed for readability within the chat window.

The Card bot response can show the following types of content:

• Record: Displays content from a single record on your instance. This record can be referenced 
from variables in the flow or queried using a script that returns a single Glide record from a 
selected table. The record content includes the display field for the table at the top of the card, 
followed by any other fields specified by the properties of the bot response.

• Image: Displays a large or small image that you provide, along with a title and description. 
The property sheet provides a pre-configured template for the card layout. Specify the title, 
description, and the image source.

• YouTube video: Displays in an inline video player if supported on the channel. The image is 
displayed along with a title, description, and hyperlink to relevant content.

In the Washington DC  release, only YouTube videos are supported.

Tip: 
You can also use the Video bot response control  to include YouTube videos in 
conversations. The Video bot response control includes a navigation button that pauses 
the conversation. If you want the user to watch the video before continuing with the 
conversation, use this navigation button. When users have finished watching the video, 
they can click this navigation button to continue with the conversation.
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Note: 
If you previously created conversations that use the HTML bot response control  to generate 
card layouts, consider updating your conversations to use the Card bot response control. 
The Card displays information from a record in your instance and contains a link to that 
related record. Or, it can display images and can include rich content such as a video.

Card bot response control properties

Property Description

Node name Name that identifies this Card bot response control node in the topic flow.

Card type Type of card to be used. Choose one of the following options:

• Record

• Large image with text

• Small image with text

• YouTube Video Card

Note: 
In the Washington DC  release, only YouTube video cards are supported.

Type: Record

Record Reference to a specific record. Data for the card comes from a record referenced 
in a variable from another node in the flow. For example, the reference could be 
a Choice List or Glide Action.

1. Select a variable from the current flow that contains a record object.

2. Use the fields  list to determine the fields displayed in the card.

Table Table that references a single Glide record that contains the data shown in the 
card.

Filter this 
table by 
using

Enter the condition or script to filter data in the table and return the record.

• Condition: Condition statement that returns the table record.

• Script: Glide record query that returns the glide record.

fields
Fields from the ServiceNow  record to be displayed in the card. Specify each 
field by clicking Add Field.

Note: 
If you're using Workplace, a maximum of four fields is rendered on the 
card. If you have more than four fields, the remaining fields are displayed 
on a subsequent card, with up to four fields per card.

Type: Large image with text or Small image with text

Template A visual representation that shows the image card layout. Each area of the 
template is numbered.
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Property Description

Map data to 
fields on the 
card

Fields that correspond to the numbers shown on the template. These fields are 
the following:

1. Title: Name or label for the card

2. Description: Explanation of the image

3. Image URL link: Specify the image displayed in the card in one of the 
following ways:

◦ Specify the image URL, using the text field, data pill, or script.

◦ Upload the image by clicking Upload Image.

If you upload an image, the selected image is uploaded to the server and 
is stored in the Images [sys_db_image] table and in the update sets. When 
the image is stored in the Images table and the update sets, you can use the 
image in a production or non-production instance, as needed.

After the image is uploaded, the URL link is included in theResponse 
Properties  sheet.

Click the link to view the image.

The URL is generated dynamically. The name of the instance is inserted at the 
front of the URL path.

You can change or delete the link to the image. If you delete the link on this 
property sheet, only the reference to the URL is deleted. The image remains 
on the server for future use.

4. Image alt text: Alternative, screen-readable text that describes the image for 
accessibility programs. This text is used along with the image. Enter the text 
using the text field, data pill, or script.

Type: YouTube Video card

Template A visual representation of the layout of the video included in the card.

Map data to 
fields on the 
card

Fields that correspond to the numbers shown on the template. These fields are 
the following:

• Title: Title of the card.

• Title Link: URL to any relevant content.

• Description: Description the card, such as the topic the video addresses.
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Property Description

• YouTube Video ID: Unique identifier for the video used in the card. This 
identifier is the string following the equal sign (=) at the end of the video's URL 
path.

For example, in the path shown below, the video identifier is FVgtjdEOa5M.

Advanced

Hide this node

Conditionally 
show this 
node if

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.

Channel support

Channel support for the Card bot response control

Channel Support Constraints

Web UI Supported None

Mobile UI Supported None

Now Assist 
panel

Partial 
support

Record cards and record cards with action only.

Microsoft 
Teams

Supported The video control displays a thumbnail image of the video that users 
select to open the video in their preferred web browser.

Slack Supported Conversational Integration with Slack  Version 2.0.0 and later.

The video control displays a thumbnail image of the video that users 
select to open the video in their preferred web browser.

Workplace Partial 
support

Image card output not available.

Facebook apps no longer support vertical list templates. The card 
layout uses a horizontal, scrollable carousel template effective August 
15, 2019. Cards also feature a button template.

Facebook 
Messenger

Supported None

SMS Twilio Supported Records and image cards only.

LINE Partial 
support

Records and image cards only.

WhatsApp Partial 
support

Records and image cards only.

Apple 
Messages 

Supported None
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Channel support for the Card bot response control  (continued)

Channel Support Constraints

for 
Business

Alexa 
(Voice)

Partial 
support

Some types of output are only available on devices with screens. 
For nonscreen devices, the card title is read. For details, see Fine-
tune Virtual Agent settings and topics for the best Alexa voice chat 
experience.

Example Glide record query

(function execute(table) {
    /* Write a glide record query, and return the glide record.
       For example:
 
       var now_GR = new GlideRecord(table);
       gr.addEncodedQuery('active=true^number=INC0010099');
       gr.query();
       if(gr.next()) {
          return gr;
    }
    */
})(table)

In this example, the script creates a GlideRecord object, populates this object using a query that 
should return a single result, then returns the object. The Table  property defines the table used 
in this query.

Example Card bot response output for records

Note: 
Virtual Agent Designer  controls may display and function differently in other channels.
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Response properties Card output

Card bot response control basic 
properties

Web UI Card output

MS Teams Card output

Example Card bot response for a large image
The Card response layout for images may vary across channels.
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Response properties Card output

Web UI image card output

MS Teams UI image card
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Example Card bot response for a small image

The Card response layout for images may vary across channels.

Response properties Card output

Web UI image card output
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Example Card bot response with video content

The way the Card bot response displays videos may vary across channels. For example, the 
display you see in Slack  messages may be different from what you see on Microsoft Teams  or 
Workplace from Facebook. Also, if an embedded player is supported on that channel, the player 
is included in the display. For more information about channels, see the documentation for the 
channel that you're using.
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Response properties Card output

Card bot response output with 
video on the Web client

Card bot response output with 
video on Microsoft Teams
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Table bot response control

Use the Table bot response control in a Virtual Agent  topic to display a bot response as a table.

Table bot responses enable users to see information in a more organized way.

For example, you can organize and display information such as the following:

• Planned service changes

• Company holidays

• Contact information

• Testing sites

Output tables can have between one and four columns and may include optional column 
headers. You can populate tables using the conditioner builder or scripts.

Table bot response properties

Property Description

Node name Name that identifies this Table bot response control node in the topic flow.

Populate this 
table by

Options for populating the table. Select one of the following:

• Table: Select the ServiceNow  table that contains the data to be displayed.

• Script: Enter code in the Define rows dialog box.

Table The name of the table that contains the data.

This field is available only when the Table  option is selected.

Filter rows Options for filtering the contents of the table. Choose one of the following:

• Condition: Specify a no-code condition statement using the condition builder. 
For more information, see Condition builder .

• Script: Enter a low-code script that specifies a condition.

This field is available only when the Table  option is selected.

No records 
response 
message

Message displayed if no records are found.

Columns and rows

Columns 
(left to right)

Table columns that you want to display in the conversation. You can have up to 4 
columns.

• Field: Select a field from the ServiceNow  table to be displayed in the column.

• Display name: Reflects the selected column name. Use the default name or 
change the name.

This field is available only when the Table  option is selected.

Sort rows by Option for sorting returned rows by column. You can sort by one of the selected 
columns, or by a column not shown in the response to the user. Choose 
Ascending  or Descending  order for the sort.
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Property Description

If you don't specify a sort order, rows are sorted by creation date in descending 
order. If you specify a different sort order, creation date is used as a secondary 
sort order.

This field is available only when the Table  option is selected.

Advanced

Headers

Header Header or title for the table when the table is displayed in the response output. 
The header can be a text string, variables, or a script.

Display 
Column 
Headers

Toggle switch that enables the display of column headings.

Hide this node

Conditionally 
show this 
node if

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.

Channel support

Channel support for the Table bot response control

Channel Support Constraints

Web UI Supported None

Mobile UI Supported None

Now Assist 
panel

Not 
supported

Not applicable

Microsoft 
Teams

Supported None

Slack Supported None

Workplace Supported None

Facebook 
Messenger

Not 
supported

Not applicable

SMS Twilio Not 
supported

Not applicable

LINE Supported None

WhatsApp Not 
supported

Not applicable

Apple 
Messages 
for 
Business

Supported None

Alexa 
(Voice)

Partial 
support

Supported on devices with screens. For nonscreen devices, the 
table will be read, if possible. For details, see Fine-tune Virtual Agent 
settings and topics for the best Alexa voice chat experience.
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Example Table bot response output

Note: 
Virtual Agent Designer  controls may display and function differently in other channels.
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Response properties Table bot response output

Table bot response control basic 
properties

Web UI Table bot response 
output
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Video bot response control

Use the Video bot response control in a Virtual Agent  topic to include a video in the conversation.

The Video bot response control includes a navigation button, which gives users time to watch 
the video. If you want the user to the watch the video before continuing with the conversation, 
use this navigation button.

When users have finished watching the video, they can click the navigation button to continue 
with the conversation.

Note: 
Topic authors can also use the Card bot response control  to include a video in 
conversations. However, the Card bot response control doesn't include the navigation 
button, which gives users time to watch the video.

Video bot response control properties

Property Description

Node name Name that identifies this video bot response control node in the topic flow.

Card type Type of card. Select YouTube Video Card.

Note: 
In the Washington DC  release, only YouTube video cards are supported.

Template A visual representation of the layout of the video included in the card.

Map data to 
fields on the 
card

Fields that correspond to the numbers shown on the template. These fields are 
the following:

• Title: Title of the card.

• Title Link: URL to any relevant content.

• Description: Description the card, such as the topic the video addresses.

• YouTube Video ID: Unique identifier for the video used in the card. This 
identifier is the string following the equal sign (=) at the end of the video's URL 
path.

For example, in the path shown below, the video identifier is FVgtjdEOa5M.

Advanced

Navigation 
button label

Navigation button used to continue with the conversation.

By default, the button is labeled Got it, but you can change it. For example, you 
change the label to Continue.

Users click this navigation button in the chat window to continue with the 
conversation.

Hide this node
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Property Description

Conditionally 
show this 
node if

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.

Node 
Conditions Expression logic to specify a condition for presenting this topic to users. The 

condition must evaluate to true. You can set this field using either the condition 
builder or a script.

• Condition: Use the condition builder to add or edit conditions.

• Script: Use the script editor to create or edit a script that contains a condition 
statement.

Channel support

Note: 
The way the Video bot response displays videos may vary across channels. For example, 
the video display you see in Slack  messages may be different from what you see on 
Microsoft Teams  or Workplace from Facebook. Also, if an embedded player is supported 
on that channel, the player is included in the display. For more information about channels, 
see the documentation for the channel you're using.

Channel support for the Video bot response control

Channel Support Constraints

Web UI Supported None

Mobile UI Supported None

Now Assist 
panel

Not 
supported

Not applicable

Microsoft 
Teams

Supported The video control displays a thumbnail image of the video that 
users select to open the video in their preferred web browser.

Slack Supported Conversational Integration with Slack  version 2.0.0 and later.

The video control displays a thumbnail image of the video that 
users select to open the video in their preferred web browser.

Workplace Supported None

Facebook 
Messenger

Not 
supported

Not applicable

SMS Twilio Not 
supported

Not applicable

LINE Not 
supported

Not applicable

WhatsApp Not 
supported

Not applicable

Apple 
Messages for 
Business

Not 
supported

Not applicable
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Channel support for the Video bot response control  (continued)

Channel Support Constraints

Alexa  (Voice) Not 
supported

Not applicable

Example Video bot response control

Note: 
Virtual Agent Designer  controls may display and function differently in other channels.
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Response properties Card output

Video bot response 
output on the Web 
client with the 
navigation button

Video bot response control basic 
properties

Video bot response 
output on the Web 
client without the 
navigation button
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Virtual Agent Designer  utilities

You can control interactions within a topic by using utilities in Virtual Agent Designer. These 
utilities perform various actions such as adding topic blocks (reusable components), running a 
script, or adding different conversation paths (branches) in a topic. Utilities are represented as 
nodes in a conversation flow but do not display anything to the user.

The following utilities are available for use within a Virtual Agent  topic.

Lookup utility

Use the Lookup utility in a Virtual Agent  topic to return a ServiceNow  record query.

Lookup utility properties

Property Description

Node name The name that identifies this Lookup utility node in the topic flow.

Variable name The variable that stores the record returned by the script. The variable name is 
automatically created from the Node name  property.

Table The table used for the query.

Filter this table 
by using

The query to retrieve the record. Use the condition builder or a script to specify 
a query condition.

Advanced

Hide this node

Conditionally 
show this 
node if

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.
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Example Lookup utility

Lookup utility basic properties

Example Lookup script

(function execute(table) {
 
       var now_GR = new GlideRecord(table);
       gr.addEncodedQuery('active=true');
       gr.setLimit(1);
       gr.query();
       if(gr.next()) {
          return gr;
    }
})(table)

In this example, a table is queried for the first active record. The table to be queried is defined in 
the Table  property found in the lookup utility control. The setLimit()  method ensures that 
only a single record is returned from the database. If a record is found, it is returned. For more 
information on GlideRecord queries, see Querying tables in script  .

Script Action utility

Use the Script Action utility in a Virtual Agent  topic to run a script.

Script Action utility properties

Property Description

Node name The name that identifies this Script Action node in the topic flow.
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Property Description

Action 
expression

The script that performs an action.

Advanced

Hide this node

Conditionally 
show this 
node if

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.

Example Script Action utility

Script Action utility basic properties

Example script action

(function execute() {
    var list = [];
    if (vaInputs.case_number != "") {
        var gr = new GlideRecord("sn_customerservice_case");
        gr.addQuery("number", "CONTAINS", vaInputs.case_number);
        gr.addQuery("active", "true");
        gr.orderBy("number");
        gr.query();
        while (gr.hasNext()) {
            gr.next();
            list.push(gr.getUniqueValue().toString());
        }
    }
    vaVars.case_list = list;
})()

This example performs a search on the [sn_customerservice_case] table for a specific case 
number based on the input from another control called case_number. The script then places 
the results in an array and stores them in the case_list  variable, which is accessible by other 
nodes in the same topic. Because vaVars  only supports string, number, and Boolean values, 
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the script uses toString()  to store these values as strings. The code is contained in an if 
statement, so it only executes if the case_number  variable has a value. This if  statement 
prevents the code from running if the user has not entered a number.

For more information about writing scripts for Virtual Agent, see Virtual Agent scripts.

Record Action utility

Use the Record Action utility in a Virtual Agent  topic to create or update a ServiceNow  record in a 
table.

Record Action utility properties

Property Description

Node name Name that identifies this record action node in the topic flow.

Variable 
name

Name of the variable that stores the created or updated record values. The 
variable name is automatically created from the Node name  property.

This option is not visible when the Action Type is Update a Record.

Action type The type of action to perform. Select one of the following:

• Create a Record: Creates a new record in the table that you specify.

• Update a Record: Updates an existing record based on the context of the 
conversation.

Table If you’re creating a record, select any table that is available in the instance.

If you’re updating a record, select a variable for a record that is referenced in the 
conversation. For example, User.

Field Select one or more fields in the ServiceNow  table to be modified. For each field, 
select a valid value or specify input variables or script variables.

Advanced

Attach file to 
record A low-code method of attaching an image or other file to a record of your 

choosing.

Note: 
Ensure that you've an uploaded file using the File Picker node before 
attaching it to a record with the Record Action node. The uploaded file is 
initially linked to the conversation table. When the incident is created with 
the uploaded file using the Record Action node, the file is linked to the 
incident table. It is no longer referenced through the conversation table, 
but the incident instead.

Hide this node

Conditionally 
show this 
node if

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.
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Example Record Action utility

Record Action utility basic properties

Decision utility

Use the Decision utility in a Virtual Agent  topic to add two or more branches that represent 
different paths in a conversation.

Use scripts or variable conditions to set decision branches

Each branch below a Decision utility node has a condition property. You can define the condition 
using the condition builder or a script that returns a value of true or false. A branch that returns 
a value of true is followed, while a branch returning a value of false is not. When creating these 
scripts or conditions, ensure that only one branch in each Decision utility node evaluates to true.

Note: 
If you insert a Boolean  user input control, you're prompted to add a Decision  utility directly 
after the Boolean node on the canvas. Selecting Yes  on the Boolean node's Decision utility 
prompt automatically generates two branches named True  and False. The two branches 
conditions are automatically set through the condition builder.

For more information, see Branch a Virtual Agent conversation with a Decision utility.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2517



Example Decision utility node with branches

In this example, a static choice control prompts the user to select from three available colors 
and the selection is stored in a variable. The Decision utility control is configured with a branch 
for each possible selection. Each branch uses the condition builder, which returns true when 
the corresponding color is selected. In the example, the condition builder returns true when the 
choice is Red.

You can also use the Script option for branch conditions. In the following example, the script 
provides the same functionality as the condition builder.

Topic Block utility

Use a Topic Block in a Virtual Agent  conversation to perform a specific function or subflow that 
runs certain steps in a calling topic.

Topic Block utility properties

For more information, see Add a reusable topic block to a calling topic or topic block.

Property Description

Use dynamic 
Topic Block

Set this toggle to activate dynamic Topic Block options.

Topic block A list of published topic blocks. Select a topic block to add to the calling topic.
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Property Description

With Use dynamic Topic Block  active, use the condition builder to input a 
condition or script instead.

Node name Name of the topic block node. The name is automatically assigned based on 
the topic block that you select. For example, if you choose the Acme Contextual 
Search topic block, the Name  is Acme Contextual Search.

With Use dynamic Topic Block  active, input a name of your choice.

Input 
mapping The variables to be used as input to the selected topic block. For example, the 

following image has example variables:

The contents of this area change according to the topic block you selected. 
Options may include string input, referenced records, scripts, and so forth.

With Use dynamic Topic Block  active, you add all input mappings manually 

instead by selecting the Manage inputs to define icon ( ). Inputs are handled 
similarly to the Input Parameters dialog box in the Start segment of a reusable 
topic block.

Output 
mapping The variables to be output by the selected topic block. For example, the 

following image has example variables that are enabled:

The contents of this area change according to the topic block you selected.
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Property Description

With Use dynamic Topic Block  active, you add all input mappings manually 

instead by selecting the Manage outputs to define icon ( ). Inputs are handled 
similarly to the Input Parameters dialog box in the Start segment of a reusable 
topic block.

Advanced

Hide this node

Conditionally 
use this 
node if

A no-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.
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Example Topic Block utilities
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Using dynamic Topic Blocks

Toggling the dynamic setting on the Topic Block enables you to programmatically choose which 
topic block or blocks to invoke, based on any number of conditions. You can pass in a dynamic 
set of inputs without an explicit, one-to-one match for a Topic Block definition.

For example, assume you have two Topic Blocks. One sets your password by taking your 
username and returning a success or fail message. The other resets your password, but requires 
that you send two-factor authentication (2FA) token with the request before returning a success 
or fail message and a temporary password.

You can create two separate Topic Block invocations to handle the password-reset procedure, or 
you can create one Topic Block with the dynamic setting active and defined as follows:

• Add a script that checks if the reset type is includesTwoFactor = true. If the 
statement evaluates to true, then you return TwoFactorReset, otherwise you return 
NormalPasswordReset.

• Define two input mappings: password  and twoFactorToken, both set equal to an object 
passed in which contains their values.

• Define two output mappings: successful  and tempPass, the latter of which is only set if it 
exists in the return value for the Topic Block.

• Define two output nodes to output success or failure, and an output to confirm to you whether 
the tempPass  value is true.

Example dynamic Topic Block expression

(function execute() {
    /* Return the name of the topic block to run. For example:
        switch (vaVars.car_make) {
            case 'Ford':
                return 'Ford troubleshooting';
            case 'Toyota':
                return 'Toyota troubleshooting';
            default:
                return 'General car troubleshooting';
        }
    */
})()

The sample script in the dynamic Topic Block script field returns a value based on your input. 
In this example, if you input Ford  or Toyota, the Virtual Agent will call for the appropriate 
troubleshooting topic. If you input any other value, the Virtual Agent returns a general 
troubleshooting topic instead.

Custom control utility

Use the Custom Control utility in a Virtual Agent  topic or topic block to reference a custom input 
control or a custom response control. Custom controls complement the controls provided in 
Virtual Agent Designer.

Custom control utility properties

Specify the properties of the custom input control or custom response control that you are 
adding to a topic or topic block. For more information about custom controls and their use, see 
Customizing Virtual Agent with custom controls.
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Note: 
Custom controls do not work on Internet Explorer version 11.

Custom control utility properties sheet

Property Description

Custom 
control The name of a custom control object that has been published in Virtual Agent 

Designer.

Node name
The name of the custom control you selected.

Input 
mapping The variables to be used as input to the selected custom control. For example, 

the following image has example variables:

The contents of this area change according to the custom control you selected. 
Options may include string input, referenced records, scripts, and so forth.

Output 
mapping The variables to be output by the selected custom control. For example, the 

following image has example variables that are enabled:

The contents of this area change according to the custom control you selected.

Advanced

Hide this node

Conditionally 
use this node 
if

A no-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.
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Example custom control utility

Action utility

Use the Action utility in a Virtual Agent  topic to select the flow action properties that the node 
should create. The Action utility integrates Virtual Agent  with the ServiceNow  Flow Designer 
product.

Action utility properties

Specify the flow action properties for the node you want to create.

Property Description

Node name The name of this Action node.

Invoke Flow 
Designer 
object

Flow Designer  component type. Select one of the following:

• Action: A reusable operation.

• Subflow: An automated process that consists of a sequence of reusable 
actions, data inputs, and outputs.

Spoke
Name of the scoped application that contains Flow Designer  content that is 
dedicated to a particular application or record type.
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Property Description

For a list of default spokes, see Spokes .

Action/
Subflow The Flow Designer  action or subflow to be performed in the instance. The Input 

mapping  and Output mapping  areas change depending on your selection.

For details about the action, click the link beneath your selection to view it in 
Flow Designer.

Wait for 
response? Toggle switch that determines whether Virtual Agent  waits for a response from 

the specified action before continuing.

Input 
mapping

The variables to be used as input to the selected action. The contents of this 
area change according to the action you selected. Options may include string 
input, referenced records, scripts, and so forth.

For options that require a password, enable the Include a password input 
toggle switch to prompt the user for a password. Secure inputs must use the 
password2 data type. Input is securely masked and not viewable by others.

Note: 

If a field is locked and you can’t enter a string, the pill picker value must 
match the field type. For example, if the field type is document_id, the 
referenced value type must also be document_id. If no matching field 
exists, reference a field created in another FDIH action output or use a 
script.

Output 
mapping

The variables to be output by the selected action. The contents of this area 
change according to the action you selected.

Advanced

Permissions

Run as
Permissions to use for the action. Select one of the following options:

• User who initiates session: When selected, the action runs using the same 
permissions that the current user has.

• System User: When selected, the action runs using system privileges, some 
of which may be unavailable to the current user.

Hide this node

Conditionally 
show this 
node if

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.
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Example Action utility
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Deflection utility

Use the Deflection utility in Virtual Agent  to track issues that Virtual Agent  helped to resolve or 
actually resolved for a user.

Deflection utility properties

Specify the flow action properties for the node that you want to create.

Property Description

Node name Name of the Deflection node.

Input mapping

Deflection 
configuration

Select from a list of pre-defined deflection configurations. For more information, 
see Create deflection configurations and patterns.

Deflection 
pattern

Select from a list of pre-defined deflection patterns. Ensure that your selection 
is tied to a pre-defined deflection. See Create deflection configurations and 
patterns  for more.

Activity table Table name where the deflection activity occurs. Add incident or task tables 
related to the deflection.

Activity IDs List of comma-separated Activity IDs. Add AI Search  results or related tasks in 
the deflection occurrence.

Advanced

Hide this node

Conditionally 
show this 
node if

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.
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Example Deflection utility
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Diagnostic Topic Executor utility

Use the Diagnostic Topic Executor utility in Virtual Agent  to ensure the proper function of 
components in a topic.

Diagnostic Topic Executor utility properties

Specify the flow action properties for the node that you want to create.

Property Description

Node name Name of the node.

Input mapping

Diagnostic 
content

String that is passed to the component being diagnosed.

Output mapping

Is topic 
executed

Option to confirm that the topic executed properly, with variable data returned 
by the component. Select Enable  to activate, and enter a custom variable name 
for the value if desired.

Is data 
collection 
topic 
executed

Option to confirm that the data collection executed properly, with variable data 
returned by the component. Select Enable  to activate, and enter a custom 
variable name for the value if desired.

Advanced

Hide this node

Conditionally 
show this 
node if

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.
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Example Diagnostic Topic Executor utility
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Geolocation utility

Use the Geolocation utility to gather map coordinates from a user, to personalize topics to a 
user's location, provide data for navigation or on-site tasks, and other services.

Geolocation utility properties

Specify the flow action properties for the node that you want to create.

Property Description

Node name Name of the Geolocation node.

Input mapping

Permission 
prompt

String for the custom prompt requesting geolocation from a user.

Output mapping

Latitude User's latitude returned after the Permission prompt.

Note: 
All Output Mappings are customizable. Select Enable  to activate each 
one, and input a custom variable name to store the value under if 
desired.

Longitude User's longitude returned after the Permission prompt.

Error message Message returned if the geolocation attempt encounters an error.

Error type Type of error returned based on the error message.

Status Status of the geolocation data.

Advanced

Hide this node

Conditionally 
show this 
node if

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.
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Example Geolocation utility
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Multi File Upload utility

Use the Multi File Upload utility to upload more than one file at a time in a Virtual Agent 
conversation.

Multi File Upload utility properties

Specify the flow action properties for the node that you want to create.

Note: 
The Multi File Upload utility is supported in Microsoft Teams, Slack, and Virtual Agent API 
only.

Property Description

Node name Name of the Multi File Upload node.

Input mapping

Prompt Text string prompting the user to upload files.

Allow user to 
skip

Option to skip uploading files if a user has none.

Max file count Maximum number of files that can be uploaded.

Max file size Maximum size of individual files uploaded, measured in megabytes.

Try Again 
message

Message sent to a user if the file upload fails.

User 
confirmation 
message

Message sent to a user confirming that files uploaded.

Allow all file 
types

Option to allow uploading all file types.

Output mapping

Files The message sent to the user that lists files uploaded. Select Enable  to 
activate this output, and input a custom variable name to store the value under 
if desired.

Advanced

Hide this node

Conditionally 
show this 
node if

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.
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Example Multi File Upload utility
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Pause utility

Use the Pause utility to create a temporary halt in your Virtual Agent  conversations.

Pause utility properties

Specify the flow action properties for the node that you want to create.

Property Description

Node name Name of the Pause node.

Input mapping

Seconds Duration of pause.

Note: 
Any duration value greater than the maximum defined in the system 
reverts to the maximum, or 60 seconds if not defined.

Advanced

Hide this node

Conditionally 
show this 
node if

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.
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Example Pause utility

[store-future: BEGIN review]

Virtual Agent Designer  capabilities

Add in-depth functions to Virtual Agent  conversations with Virtual Agent Designer  capabilities. 
Available from the Vancouver  release onward, these controls provide special filters and abilities 
to your Virtual Agent topics.

The ServiceNow  platform offers various products (such as Dynamic Translation) that can be 
used in Virtual Agent Designer  along with other areas of the ServiceNow AI Platform. For Virtual 
Agent, these capabilities function as no-code topic blocks, performing complex functions in a 
conversation.

Unlike the User Inputs, Bot Responses, and Utilities, capabilities are features that are part of the 
ServiceNow AI Platform, which have been mapped to nodes in Virtual Agent Designer. The nodes 
are available for use in the Conversation Builder when you Use Generative AI Controller with 
Virtual Agent Designer .

The following capabilities are available for use within a Virtual Agent  topic.

[End]
[store-future: BEGIN review]

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2536

https://www.webstg.servicenow.com/docs/access?context=use-generative-ai-controller-with-virtual-agent-designer&version=washingtondc&pubname=washingtondc-intelligent-experiences&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=use-generative-ai-controller-with-virtual-agent-designer&version=washingtondc&pubname=washingtondc-intelligent-experiences&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=use-generative-ai-controller-with-virtual-agent-designer&version=washingtondc&pubname=washingtondc-intelligent-experiences&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=use-generative-ai-controller-with-virtual-agent-designer&version=washingtondc&pubname=washingtondc-intelligent-experiences&ft:locale=en-US


Dynamic Translation capability

Use the Dynamic Translation capability to perform on-demand translation of languages in your 
Virtual Agent  conversations.

Dynamic Translation capability properties

Specify the flow action properties for the node that you want to create.

Property Description

Node name Name of the Dynamic Translation node.

Input mapping

Wait for 
response?

Toggle to wait for a response from the action before continuing the 
conversation.

Text to 
translate

String of text to be handled by Dynamic Translation.

Source 
language

Input language of the text to translate.

Target 
language

Output language of the text to translate.

Output mapping

Error 
message

Error message returned if the translation fails or other error occurs. Select 
Enable  to activate, and input a custom variable name to store the value under if 
desired.

Detected 
language

Language detected by Dynamic Translation. Select Enable  to activate, and 
input a custom variable name to store the value under if desired.

Translated 
text

String of text in target language. Select Enable  to activate, and input a custom 
variable name to store the value under if desired.

Error code Type of error returned if the translation fails or another error occurs. Select 
Enable  to activate, and input a custom variable name to store the value under if 
desired.

Advanced

Hide this node

Conditionally 
show this 
node if

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.
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Example Dynamic Translation capability
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[End]

[store-future: BEGIN review]

Sensitive Data Masking capability

Use the Sensitive Data Masking capability node to conceal protected information and avoid 
sensitive information leakage.

Sensitive Data Masking capability properties

Specify the flow action properties for the node that you want to create.

Property Description

Node name Name of the Sensitive Data Masking node.

Input mapping

Wait for 
response?

Toggle to wait for a response from the action before continuing the 
conversation.

PI categories Protected Information categories.

Language Language in which sensitive data is delivered.

Utterance Recorded utterance.

Output mapping

Is sensitive Boolean denoting whether the data is sensitive information. Select Enable  to 
activate, and input a custom variable name to store the value under if desired.

Anonymized 
text

Protected information text in anonymized form. Select Enable  to activate, and 
input a custom variable name to store the value under if desired.

Status Status of the protected information. Select Enable  to activate, and input a 
custom variable name to store the value under if desired.

Advanced

Hide this node

Conditionally 
show this 
node if

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.
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Example Sensitive Data Masking capability
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[End]

[store-future: BEGIN review]

Natural Language Query  Parser capability

Use the Natural Language Query  (NLQ) Parser capability to ask questions in naturally expressed 
language in your Virtual Agent  conversations.

Natural Language Query Parser capability properties

Specify the flow action properties for the node that you want to create.

Property Description

Node name Name of the parser node.

Input mapping

Wait for 
response?

Toggle to wait for a response from the action before continuing the 
conversation.

Table name Name of the Natural Language Query  table used.

Utterance Utterance recorded by the Natural Language Query  Parser.

Output mapping

Encoded 
query

Message Select Enable  to activate, and input a custom variable name to store the value 
under if desired.

Status Status of the query. Select Enable  to activate, and input a custom variable 
name to store the value under if desired.

Advanced

Hide this node

Conditionally 
show this 
node if

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.
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Example Natural Language Query  Parser capability
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[End]

[store-future: BEGIN review]

Profanity Filtering capability

Use the Profanity Filtering capability in Virtual Agent Designer  to keep unwanted language out of 
your Virtual Agent  conversations.

Profanity Filtering capability properties

Specify the flow action properties for the node that you want to create.

Property Description

Node name Name of the Profanity Filtering node.

Input mapping

Wait for 
response?

Toggle to wait for a response from the action before continuing the 
conversation.

Message text Text message potentially containing profanity.

Source 
language

Language in which the message is delivered.

Sender 
userID

ID of the user who is sending the message.

Output mapping

Profanity 
detected

Boolean denoting whether the Virtual Agent  has detected profane language. 
Select Enable  to activate, and input a custom variable name to store the value 
under if desired.

Status Status of the filtered unwanted language. Select Enable  to activate, and input a 
custom variable name to store the value under if desired.

Advanced

Hide this node

Conditionally 
show this 
node if

No-code condition statement or low-code script that specifies a condition for 
presenting this node in the conversation. The condition must evaluate to true.
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Example Profanity Filtering capability

[End]
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Virtual Agent  technical reference

Use these topics to learn more about scripting methods, NLU system entities, and the Virtual 
Agent  Interactions table.

Virtual Agent  utilizes a queuing system to process incoming messages coming from 
asynchronous channels. Dedicated worker threads pull from this queue and process 
the messages in their own transactions. This enables Virtual Agent  to scale to meet 
traffic volume. Virtual Agent  transactions run as non-interactive (the scriptable method 
gs.isInteractive()  will return false).

Various roles and tables are available when you activate Virtual Agent. For more information, see 
Installed with Virtual Agent. Virtual Agent also has a data retention policy to manage table size. 
For more information, see Data management in Conversational Interfaces

The following technical reference topics are available.

Domain separation and Virtual Agent

Domain separation is supported in the Virtual Agent  application. Domain separation enables you 
to separate data, processes, and administrative tasks into logical groupings called domains. You 
can control several aspects of this separation, including which users can see and access data.

Support level: Standard

• Includes all aspects of Basic  level support.

• Application properties are domain-aware as needed.

• Business logic: The service provider (SP) creates or modifies processes per customer. The use 
cases reflect proper use of the application by multiple SP customers in a single instance.

• The instance owner must configure the minimum viable product (MVP) business logic and data 
parameters per tenant as expected for the specific application.

Sample use case: An admin must be able to make comments required when a record closes for 
one tenant, but not for another.

For more information on support levels, see Application support for domain separation .

Overview

Domain separation allows you to partition your organization's data and administrative control 
into separate domains. This lets you isolate the data and control access to it, which is particularly 
important in environments where multiple tenants share a common platform.

Domain separation in Virtual Agent  works by creating separate Virtual Agent  views that are 
isolated from each other. The chat configuration, branding, NLU settings, and topics and 
components can be assigned to a given domain within Virtual Agent. Users within a domain 
can only access the Virtual Agent  conversations that are associated with their domain. This 
means that users in one domain cannot access data or functionality that belongs to another 
domain, including Virtual Agent  conversations. Additionally, administrators who are assigned to a 
domain cannot see or manage Virtual Agent  conversations in other domains, ensuring complete 
separation and security.

Domain separation is best for customers with any of the following requirements:

• You need to enforce absolute data segregation between business entities (data separation).

• Customize business process definitions and user interfaces for each domain (delegated 
administration).
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• Maintain some global processes and global reporting in a single instance.

• Separate data between customers or sub-organizations.

• The session scope is set upon session establishment to the domain listed in the user's user 
record. Users can manually change their session domain scope with the domain picker.

• The record scope uses the domain of the record and is active when viewing the form of any 
record.

By default, the record scope takes precedence over the session scope so that users in higher-
level domains adhere to each record's data and process constraints. However, these users can 
choose to expand or collapse the domain scope to show or hide data from other domains. For 
example, a user in the service provider (SP) global domain also has visibility into child domains 
such as the ACME domain. When looking at an incident record from the ACME domain, 
the user can choose to expand the domain scope to show values from the MSP domain or 
collapse the domain scope to show only record values that match the record's ACME domain.

Note: 
Users always have access to data from domains that have been explicitly granted to them 
by domain visibility.

When domain separation is used, guest users are restricted to the domain used in the session. 
For custom chat channels, the domain of the provider application  is used. For the web client, you 
can associate a domain ID with the chat portal. For details, see Associate a domain ID with a chat 
portal.

For more information, see Domain scope .

Requirements

All domain support features require the Domain Support - Domain Extensions Installer 
[com.glide.domain.msp_extensions.installer] plugin. For details, see Request domain 
separation .

Configuring Virtual Agent  with domain separation

Branding

Service providers can create a chat branding configuration  per domain.

Chat experiences

Chat experiences, including the default experience and any custom experiences, 
allow for domain separation. Each chat experience profile belongs to a domain. 
Each child customization, such as a setup topic change, belongs to a domain. Each 
child customization implements system overrides so that sub-domains can override 
parent-domain customizations.

NLU settings

Only one NLU service provider can be set per domain-separated instance for 
all Virtual Agent  clients. The managed service provider (MSP) logs in as a global 
user for the domain to configure NLU. For details, see Configure Natural Language 
Understanding in Virtual Agent.

Creating topics in subdomains in Virtual Agent Designer

Roles required:  admin or virtual_agent_admin
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The service provider either logs in to one of the subdomains and creates and publishes topics or 
allows subdomain admin users to create  and publish  their own topics.

Topic names within a domain must be unique, but Virtual Agent  does allow you to create topics 
with the same name in other domains. For example, each domain might have a topic called 
Greeting.

Only service provider admins can do the following:

• Activate Virtual Agent  conversation plugins or store apps for other ServiceNow  business 
applications, such as ITSM, CSM, or HRSD, to enable pre-built topics for the subdomain.

• Assign roles on a particular subdomain to control which topics can be run by users.

Admin users assigned to the subdomain can do the following:

• Create topics in the instance.

• Be logged into the global domain and impersonate a user in the subdomain.

• Publish all available topics in the subdomain to web clients and messaging applications.

Domain separation in the web client channel

The web client does not support domain separation. However, you can provide a domain-
separated chat experience in the web client channel by using separate, domain-separated 
portals. For example, you can create two separate support portals that are restricted to separate 
domains. Use the domain_id  in the portal script to designate the domain. This gets passed as 
the sysparm_domain_id  parameter in the portal URL.

To configure the portal, see Associate a domain ID with a chat portal.

For information about URL parameters, see Virtual Agent URL parameters.

Domain separation and Virtual Agent  messaging app integrations

Roles required:  admin or virtual_agent_admin

The domain-separated instance has one setup record for Slack, Microsoft Teams, Workplace, or 
Facebook Messenger.

Customers on the subdomain license either Slack, Microsoft Teams, or Workplace  independently 
of the ServiceNow  instance.

The admin of the subdomain installs the integrations within the subdomain and configures the 
appropriate credentials to access Virtual Agent  from the third-party client. For details, see Virtual 
Agent integration with messaging apps.

For Facebook Messenger, the admin manually configures the integration. For details, see 
Conversational Integration with Facebook Messenger.

Related topics

Domain separation for service providers

Associate a domain ID with a chat portal

The Service Portal platform is not domain-separated, but you can create different versions of 
a portal and restrict each version's use to a single domain for chat purposes. For example, you 
could create two employee service portals and define a different domain for each.
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Before you begin
Role required: admin

About this task
Elements of the Service Portal platform such as settings, portals, pages and widgets are 
not domain-separated. However, the data within widgets does display when based on the 
appropriate domain. To provide different experiences, admins should create separate service 
portals, each with unique URLs, that they can redirect users to. For a domain-separated chat 
experience in the web client channel, create a portal and use the sysparm_domain_id 
parameter in the URL to designate the domain. For more information, see Virtual Agent URL 
parameters.

Procedure

1. Optional:  Create a new domain  and assign roles to the domain as needed.

2. Copy the domain's sys ID.

a. Navigate to All  > Domain Admin  > Domains.

b. Right-click the name of a domain, and then select Copy sys_id.

c. Paste the ID in a text editor and save it for later.

3. Navigate to All  > Service Portal  > Agent Chat.

4. Select the name of the portal that you want to restrict to a domain, or create a new one .
If prompted, open the record for editing.

5. In the Server script  area, add the domain_id  parameter and the domain's sys ID that you 
copied earlier.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2548

https://www.webstg.servicenow.com/docs/access?context=t_CreateADomain&version=washingtondc&pubname=washingtondc-platform-security&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=t_CreateADomain&version=washingtondc&pubname=washingtondc-platform-security&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=t_CreateADomain&version=washingtondc&pubname=washingtondc-platform-security&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=create-a-portal&version=washingtondc&pubname=washingtondc-platform-user-interface&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=create-a-portal&version=washingtondc&pubname=washingtondc-platform-user-interface&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=create-a-portal&version=washingtondc&pubname=washingtondc-platform-user-interface&ft:locale=en-US


6. Select Update  or Submit  to save your changes.

Result
The sysparm_domain_id  parameter gets passed in the portal URL.

Virtual Agent  interaction records

Each time a Virtual Agent  conversation occurs, an interaction record captures the entire 
conversation in the Interactions [interaction] table. The record includes all topic elements used in 
the conversation, as well as live agent transfers.

Interactions [interaction] table

Each conversation in an instance generates an interaction record in the Interactions 
[interactions] table, which logs the conversation between a requester and Virtual Agent. The 
interaction records include conversations that occur across the supported chat channels: web 
client, native mobile app, and messaging integrations.

Note: 
The Interactions table is part of the Interaction Management  plugin (com.glide.interaction). 
Virtual Agent, Agent Chat, and Connect Support  use this plugin.

These interaction records provide administrators, Virtual Agent  administrators, support agents, 
and support managers with a convenient way to review what happened during a conversation. 
The records also provide a quick way to see the type of conversations that occur: Virtual Agent, 
live agent transfers to Agent Chat, and live agent transfers to Connect Support.

Interactions [interaction] table
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Note: 
Conversation transcripts are available only for Virtual Agent  records that have Virtual Agent 
conversations and live agent transfers to Agent Chat.

• When a conversation transcript for live chat exceeds 4000 characters, the transcript is 
handled as an attachment to the interaction record.

• File attachments that the user uploads are recorded in the Attachments [sys_attachment] 
table, which corresponds to the interaction record. Attachments are automatically 
displayed in the activity stream.

• For Virtual Agent  conversations that have live agent transfers to Connect Support, 
only the Virtual Agent  conversation is included in the interaction transcript. Live agent 
conversations in Connect Support  are recorded in the activity stream.

Key fields in the Interactions table

To view the Interactions table, navigate to All, and then enter interaction.list  in the 
navigation filter. You can configure the fields displayed in the table using the list collector
(slushbucket).

Field Description

Agent 
average 
response 
time

Average time based on how long the agent takes to respond to each message 
sent by a requester. For example:

00:00 Requester: I have a question.
00:01 Agent: What is it?
00:04 Requester: How do I reset my password?
00:05 Requester: I forgot it and can't access my 
 account.
00:07 Agent: Here is the answer.

Pair  1 00:01-00:00 = 00:01

Pair  2 00:07-00:04 = 00:03

(00:01 + 00:03) / 2 = 00:02 average

Agent chat Flag that indicates the conversation was transferred to a live agent in Agent Chat: 
true or false.

Application Scope of the application. Scope determines the accessible files and data 
available to other applications.

Assigned 
to

Name of the fulfiller: Live agent name or Virtual Agent

Domain The domain the conversation took place in. For more information, see Domain 
separation and Virtual Agent.

Number Number of the interaction record.

Opened Date and time that the conversation started.

Opened 
for

Name of the requester. Anonymous users are identified as Guests.

Sentiment Shows the sentiment level of the interaction, if sentiment analysis is enabled 
on the instance. This value can be shown to agents in the Agent Chat  interface. 
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Field Description

Business rules can be created based on this value at handoff (Virtual Agent  to live 
agent, live agent to live agent, or live agent to queue). Valid values are as follows:

• Positive

• Neutral

• Negative

• null (no value assessed)

This value is also entered in the Interaction Insights table.

State Conversation states:

• In Progress: Conversation between requester and virtual agent is in progress.

• Closed Complete: Virtual agent ends the conversation.

• Closed Abandoned: Requester ends the conversation before completing the 
conversation with the virtual agent.

Note: 
There are different State Reasons for the Closed Complete and Closed 
Abandoned states, depending on whether you're using Virtual Agent only, 
Virtual Agent with Live Agent, or Live Agent only. For details on the State 
Reasons, see Reasons for Closed Complete and Closed Abandoned states.

State 
Reason

Detailed explanations (reasons) for the conversation states Closed Complete and 
Closed Abandoned. To learn more, see Reasons for Closed Complete and Closed 
Abandoned states.

Transcript Log of the conversation between the requester and agents (virtual or live).

Type Type of interaction record. Virtual Agent  conversations are record type Chat.

Updated Date and time that the conversation record was last updated.

Virtual 
agent

Flag that indicates whether the conversation is for Virtual Agent: true or false. A 
Virtual Agent  conversation is flagged when a requester selects a conversation 
topic or when the topic discovery process starts the appropriate conversation.

Reasons for Closed Complete and Closed Abandoned states

Virtual Agent closes completed and abandoned conversations for various reasons, depending 
on whether the conversation is for Virtual Agent  (VA) only, Virtual Agent  with Live Agent (VA-LA), 
or Live Agent (LA).
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Interactions table with State Reason column

The State Reason  field provides details on the different ways in which a conversation ends. The 
following table describes the reasons and also the related message displayed for dashboard 
analytics. For details about how Virtual Agent  and Agent Chat  handle idle conversations and the 
corresponding default timeout periods, see Closing Virtual Agent and Agent Chat conversations.

State State Reason Virtual Agent
Virtual Agent & Live Agent or Live 
Agent only

Closed 
Abandoned

Left Before 
Engagement

Not applicable
Requester chose to be routed 
to a live agent, but closed the 
conversation (selecting + End) 
before an agent was assigned.

Dashboard message:

User closed LA - before 
Agent engagement

Closed 
Abandoned

No Activity
Requester opened a 
conversation, but didn't 
engage with the bot (for 
example, closed the browser) 
and didn't initiate topic 
discovery. The system 
closed the Virtual Agent idle 
conversation after the default 
timeout.

• Virtual Agent idle chat 
timeout: Two hours (default)

• Dashboard message: 
System closed VA - 
user never engaged

Requester chose to be routed 
to a live agent (not through 
pre-chat setup) but didn't 
engage with the agent. If the 
conversation timed out and the 
Time Out Abandoned VA 
Conversationsscheduled job 
ran, the interaction state is Closed 
Abandoned with No Activity.

Dashboard message: System 
closed LA - before 
Agent engagement

Closed 
Complete

User Ended
After engaging with the 
bot (requester entered at 
least one utterance during a 
conversation or completed 
a conversation), requester 
closed the conversation 
session by selecting End.

Requester started to chat with live 
agent but closed the chat client by 
selecting End.

Dashboard message: User 
closed LA - Clicked 
End/X
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State State Reason Virtual Agent
Virtual Agent & Live Agent or Live 
Agent only

Dashboard message: User 
closed VA - Clicked 
End/X

Closed 
Complete

Auto Closed
Requester interacts with 
VA topic and completes the 
conversation. No live agent 
interaction.

Dashboard message: 
System closed VA - 
Auto Closed

Not applicable.

Closed 
Complete

No User 
Response Requester engaged with 

the bot (entered at least 
one utterance), but left 
without actively closing the 
conversation. The system 
closes the idle conversation 
after two hours (default).

• Virtual Agent idle chat 
closed: Two hours

• Dashboard message: 
System closed VA - 
User no response

Requester engaged with live 
agent but stopped and left the 
agent hanging (idle live chat). The 
system closes the idle live chat 
after six minutes (default).

• Idle live chat closed: Six minutes

• Dashboard message: System 
closed LA - User no 
response

Closed 
Complete

Topic 
Complete Requester engaged with 

the bot in a topic but didn't 
respond to the Anything Else 
setup topic, or chose Yes to 
continue but didn't respond. 
The Time Out Abandoned 
VA Conversations  job 
closes the interaction after the 
default timeout.

• Virtual Agent idle chat 
closed: Two hours

• Dashboard message: 
System closed VA - 
Topic complete

Not applicable.

Closed 
Complete

Left for 
search

Requester engaged with 
the bot (entered at least 
one utterance), but selected 
Search in the middle of the 
conversation and didn't 
return to the conversation. 
The system closes the 
conversation because of 
inactivity.

Not applicable.
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State State Reason Virtual Agent
Virtual Agent & Live Agent or Live 
Agent only

Dashboard message: 
System closed VA- 
Left with AI search

Closed 
Complete

Agent 
Ended

Not applicable After requester started a chat with 
a live agent, the agent actively 
closed the conversation by 
selecting End Chat.

Dashboard message:  Agent 
closed LA - Clicked 
End/x

Faulted Error A runtime exception occurred 
while processing a message.

Requester’s conversation was 
closed due to a runtime error.

Detailed view of a Virtual Agent  interaction record

From the Interactions table, you can open a specific record to see additional details about the 
Virtual Agent  interaction: a transcript of the conversation, related tasks, and interaction logs.

Note: 
If a field is not visible, you can add it to the form view. For more information, see Configuring 
the form layout .

Conversation transcript

The transcript shows the dialog exchange between the agent (virtual or live) and 
requester, as well as the time stamp for each dialog turn.
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Related Tasks

Any cases, incidents, or requests created or updated during the conversation are 
automatically attached to the interaction record as a Related Task. To ensure that 
these tasks are included with the interaction record, design your conversation 
topics using certain Virtual Agent Designer  utilities and the system method 
vaSystem.attachRecordToConversation. For details, see Topic design 
considerations  below.

Interaction Logs

The Interaction Logs  tab lists all the topics that run in a conversation, including the 
setup topics and the topics executed by topic discovery or by user selection. Each 
topic element is assigned a number that indicates the sequential order in which the 
topics run.
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Security considerations

Information in conversation transcripts is viewable to all users. If you need to control access 
to records containing sensitive information, you can use scoped access control lists (ACLs) 
and lock scripted access to those records by using the Restricted Caller Access (RCA) feature. 
For details, see Set application scope, application resource, and event access  and Manage 
Restricted Caller Access .

Topic design considerations

If your Virtual Agent  conversations create or update incidents, cases, or requests, consider 
designing your topics with the following Virtual Agent Designer utilities  and system method:

• Action utility  to create or update incidents or cases

• Lookup utility  to view information

• System method vaSystem.attachRecordToConversation(String tableName, 
String sysId)  to attach the task to the interaction record

Use these utilities and system method so that incidents, cases, or requests created during a 
Virtual Agent  conversation are included in the Related Tasks  list of the interaction record.

Note: 
Records created or updated using the Script Action utility  are not captured as related tasks 
in the interaction record.

Virtual Agent  scripts

Use ServiceNow®  Virtual Agent  script methods and variables to write chat scripts, such as 
response, trigger, and flow scripts. Variables can also provide context for your live support topics 
and conversations.

Virtual Agent  scripts can provide context for topics, such as retaining information about a user 
or a user's input. You can use this information to personalize a conversation, such as to present 
a scripted greeting or confirmation. Scripts can also specify certain actions to be performed on 
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information that was obtained during a conversation. These actions can be used for creating or 
updating ServiceNow  records.

Scripts run on the server in the scope in which a topic is defined. All scope protections apply. If 
you're developing a conversation for a scoped application, you must use the scoped API. You 
can use most APIs that run in server scripts.

User input and ServiceNow  record variables

In Virtual Agent, the following variables are available for use in scripts that you create for a topic.

User input variables

When you add an input control to a topic, the system automatically creates a 
variable to store the user input (a string, Boolean value, and so on.). The syntax is 
vaInputs.myvar  where myvar  is the name that you assigned to the input node.

For example, a text input prompt with the name First prompt  has a system-
defined variable called vaInputs.first_prompt. Spaces in the name are 
replaced with an underscore character, and uppercase characters are changed to 
lowercase.

ServiceNow  record variables

If you create a script for a topic that queries a ServiceNow  table, then the record 
object (GlideRecord) returned is automatically available for use in the topic. The 
variable syntax is vaInputs.myvar  where myvar  is the record object. For 
details on querying ServiceNow  tables to return a record object, see Querying 
tables in script .

Use dot-walking in variables that contain a ServiceNow  record to specify a particular 
field in the table. The syntax is vaInputs.myvar.field. For details on dot-
walking within a script, see Dot-walking examples .

Accessing user input and ServiceNow  record variables

Use vaInputs  objects to access ServiceNow  record variables in scripts. For 
example, the vaInputs.myvar == "expected value". To access values 
from user inputs that are not records, use vaInputs.myvar.getValue().

The following methods are available.

vaInputs methods

Method Description

vaInputs.myvar == "expected value" Evaluates whether myvar  matches an expected value.

Note: 
Values for user input variables are assigned using 
user input controls. These values can’t be changed in 
your scripts.
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vaInputs methods  (continued)

Method Description

• The Washington DC  release supports additional data 
types. For more information, see Input data types in 
Virtual Agent topics.

• By default, the user variable is available and is a 
reference to the sys_user record for the user.

vaInputs.myvar.getValue(); Returns the value.

vaInputs.myvar.getDisplayValue();
Returns the display value if the stored value is not a 
ServiceNow  record. For variables that contain ServiceNow 
records, this method returns the display value, as defined 
by the display field for that table.

The following example shows the label and choice values 
for a user input. In this case, myVar.getValue() 
would return a value of 10, 20, or 30, while 
myVar.getDisplayValue()  would return Apple, 
Orange, or Pear.

Example choice list

vaInputs.myvar.getDefaultValue(); Returns the default value in a confirmation message.

vaInputs.myvar.getDefaultDisplayValue(); Returns the display value for the default value in a 
confirmation message.

vaInputs.myvar.unbindEntity(); Removes the value of input variables that the NLU 
prediction service slot-filled with extracted entities 
(unbinds it from the initial input value).

For example, if the user decides to change their choice on 
a confirmation prompt, you can unbind the entity's value 
from the input variable. The user will then be prompted 
again when they loop back to the corresponding input 
node.

Note: 
NLU  must be enabled on the topic. In the Virtual 
Agent Designer, select the Properties  tab to set up 
NLU. For information about defining NLU  entities, see 
Entities .

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2558

https://www.webstg.servicenow.com/docs/access?context=entities&version=washingtondc&pubname=washingtondc-intelligent-experiences&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=entities&version=washingtondc&pubname=washingtondc-intelligent-experiences&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=entities&version=washingtondc&pubname=washingtondc-intelligent-experiences&ft:locale=en-US


Script variables

You can define script variables for information that is not stored in ServiceNow  tables but 
that can be used to share that information elsewhere in a topic. Script variables are similar to 
workflow scratchpad variables that store primitives such as integers, Boolean values, or strings. 
A string value can be either a static or dynamic scripted value. Use the Variables sidebar to 
define script variables for a topic in Virtual Agent Designer.

Variables sidebar

Note: 
Script variables are intended for use by topic authors with advanced scripting skills.

The variable syntax is vaVars.myvar, where myvar  is the name that you assign to the 
variable. For example, you can assign a value to the variable using vaVars.myvar = 
value;. Unlike user input variables, script variables can be assigned values in a script.

For information about defining a script variable in a topic, see Define script variables for a topic.

Context variables

Context variables work in a global scope whereas system variables work within the scope of 
the topic. You can use context variables in system parameters within the web client URL. These 
variables can be used anywhere in the conversation using the vaContext  object. Use these 
options to create links to Virtual Agent  with predefined variables.

The following example link contains a parameter, sysparm_city=milan. In addition to 
opening a Virtual Agent  conversation, using this link creates a variable called city  with a value 
of milan. This variable can be accessed in a script using vaContext.city.

https://<instance>.service-now.com/$sn-va-web-client-app.do?sysp
arm_city=milan
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A number of Live Agent  variables are available for use in topic scripts. These variables include 
the following:

• application

• language

• portal

• search_text

• short_description

The variable syntax is vaContext.LiveAgent_myvar, where myvar  is one of the available 
live agent context variables. Access the variable using vaContext.LiveAgent_myvar = 
value;.

To use Live Agent  variables in topic scripts, open the topic in Virtual Agent Designer. On the 
Properties  tab, select the pencil icon next to Live Agent Variables  to add them to the topic.

For information about live agent context variables that are included with Virtual Agent, see Live 
agent chat context variables.

vaVars methods

Method Description

vaVars.global_utterance Updates when skill picker renders and an 
utterance is typed in.

vaSystem methods

You can use methods in the vaSystem object to do various tasks. Some of these tasks include 
the following:

• Attach images to records.

• Access the search string that was used to find the current topic.

• Verify that a live agent is available to receive a conversation.

• Connect the user to a live agent.

Note: 
The use of undocumented system methods is not recommended, as they are unsupported 
and may be discontinued or altered at any time without prior notice.

Methods used in Virtual Agent  topic scripts

Method Description

vaSystem.applyLinkTemplate(String sysId, 
String tableName, String actionName)

Creates an external link that is specific to a portal.

vaSystem.attachRecordToConversation(String 
tableName, String sysId) Attach ServiceNow  records to the Related Tasks 

list in a Virtual Agent  interaction record. These 
records are updated or created during a Virtual 
Agent  conversation.
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Methods used in Virtual Agent  topic scripts  (continued)

Method Description

vaSystem.attachToRecord(String mediaId, 
String tableName, String sysId) Attach an uploaded image to a ServiceNow  record. 

The method uses the following parameters:

• mediaId: The path for the image to 
be attached. To use an image entered 
by the customer, use getValue()  on 
an image input variable. For example, 
vaInputs.image_input.getValue().

• tableName: A string that contains the name of 
the table.

• sysId: The sys_id of the record.

vaSystem.connectToAgent() Connects the customer to a live agent. For more 
information on this method, see Transferring Virtual 
Agent conversations to a live agent.

vaSystem.didConnectToLiveAgent() Returns a Boolean (true or false) value whether the 
current conversation was connected to a live agent.

vaSystem.getClosingMessage() Returns a closing message for a 
conversation from system property: 
com.glide.cs.general.closing_message. 
(The message is different for third-party messaging 
apps such as Microsoft Teams  and Slack).

vaSystem.getConversationId() Returns the conversation ID of the current 
conversation.

vaSystem.getGreetingMessage() Returns a greeting message from UI Message with 
the key "Hi, I'm your Virtual Agent. Let me know how I 
can help you today."

vaSystem.getInteractionSysId() Returns the interaction ID of the current 
conversation.

vaSystem.getSearchText() Returns the last utterance typed by the user.

vaSystem.getTopicSelectionMessage() Returns a UI message with the key "What's your 
issue or request? Or take a look at what I can help 
with." (The message is different for third party 
messaging apps such as Microsoft Teams  and 
Slack). This method is returned from the system 
property com.glide.cs.topic_picker_msg.

vaSystem.getTranscript() Gets the conversation transcript.

vaSystem.isLiveAgentAvailable() Checks whether a live agent is available to 
receive a conversation that is transferred 
from the bot. To transfer a conversation to 
a live agent, call this method before using 
vaSystem.connectToAgent().

vaSystem.isLiveAgentConfigured() Returns whether live chat is enabled.

vaSystem.resetAllEntities() Resets all entities logged in the conversation.

vaSystem.sendBatchedMessages() Immediately sends queued messages.
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Methods used in Virtual Agent  topic scripts  (continued)

Method Description

vaSystem.sendSeparatorMessage() Sends a separator message line and returns the 
closing message from getClosingMessage().

vaSystem.sendSystemMessage(String message, 
Boolean showAvatar)

Sends a system message and returns greetings 
message from getGreetingMessage().

vaSystem.sendTopicPickerControl(String 
topicSelectionMessage, String 
topicPickerButtonLabel)

Sends a topic picker control with associated values 
for the message and "Show me everything" button 
label.

vaSystem.switchTopicByName() Enables the user to jump from the current 
conversation topic to the specified topic name. 
The X  button is available, so that the user can end 
the conversation. After the topic ends, the user 
resumes the global topic. When the conversation 
ends, the user can select Click here to start a new 
conversation  at the bottom of the chat window to 
restart the topic.

The optional resumeBehavior  parameter 
specifies how the conversation flow resumes, as 
follows:

• If resumeBehavior=resume, Virtual Agent 
resumes the calling topic.

• If resumeBehavior=skip, Virtual Agent  skips 
the calling topic.

If resumeBehavior  is not specified, the default 
behavior for the instance is used.

vaSystem.switchTopicById(sysid) This method is the sysid of sys_cb_topic, 
and enables the user to jump from the current 
conversation topic to the specified topic ID. The 
X  button is available, so that the user can end 
the conversation. After the topic ends, the user 
resumes the global topic. When the conversation 
ends, the user can select Click here to start a new 
conversation  at the bottom of the chat window to 
restart the topic.

The optional resumeBehavior  parameter 
specifies how the conversation flow resumes, as 
follows:

• If resumeBehavior=resume, Virtual Agent 
resumes the calling topic.

• If resumeBehavior=skip, Virtual Agent  skips 
the calling topic.

If resumeBehavior  is not specified, the default 
behavior for the instance is used.
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Methods used in Virtual Agent  topic scripts  (continued)

Method Description

vaSystem.topicDiscovery(String 
searchTextOverride, Boolean keywordImpl)

Performs topic discovery based on term in the 
searchTextOverride  parameter. The method 
uses the following parameters:

• searchTextOverride: A string on which to 
run topic discovery.

• keywordImpl: A Boolean that determines 
whether to use keywords.

Method that can be used outside Virtual Agent  topics

Method Description

sn_cs.VASystemObject.getTranscriptById(<conversation 
sysId>) Gets the transcript for the current Virtual Agent 

conversation.

Input data types in Virtual Agent  topics

You can define inputs of commonly used Glide Virtual Agent  (com.glide.cs.chatbot) data types in 
Virtual Agent Designer  without writing a script. Define the input data type on the Start node of a 
custom control or topic block.

Data types in Virtual Agent Designer

The data type designation allows Virtual Agent  to perform secondary validation on NLU predicted 
values. For example, if your choice list has red, white, and blue, but the NLU prediction service 
returns green, the input won't be slot-filled because that wasn't a valid choice.

When you specify an input with a data type on a calling topic, you can use the data pill picker to 
specify information collected from the user or previously looked up in a custom control or topic 
block.

Data type Description

String Alphanumeric text. The value uses JavaScript data conventions.

Boolean Boolean value of true or false (yes or no).

Reference Table record by sys_id.

Select a ServiceNow  table in the Table  field. You can define conditions for the 
returned record.

Date/Time Date and time values.

Array.String Sequence of alphanumeric text values.

To limit the number of strings that authors can specify, use the Max Number 
of Rows  field.

Array.Datetime Sequence of date and time values.
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Data type Description

To limit the number of dates that authors can specify, use the Max Number of 
Rows  field. Click +  to specify more than one default value.

Array.Reference Sequence of table records by sys_id.

Select a ServiceNow  table in the Table  field. You can define conditions for the 
returned record.

To limit the number of records that authors can specify, use the Max Number 
of Rows  field.

Note: 
The Array.Reference  input data type in Virtual Agent Designer 
corresponds to the List.[Table]  input data type in Flow Designer. 
For more information, see Action input and output data types .

Array.Choice Sequence of choice list values for a specific choice field.

For example, printer, computer, and monitor.

Note: 
Duplicate default values are not allowed with array data types.

Example data type definition

This User Name Array.Reference input variable limits the number of records to 5. It references the 
sys_user table with the condition that all names must start with a.

NLU  system entities

Use globally defined NLU  entities to identify system information that Virtual Agent  can extract 
from the conversation. You can define entities as "nodeless" input variables for a topic. These 
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variables can be slot-filled from NLU  service provider predictions or provided outside of the 
scope of the topic.

System entities are enabled in NLU  models by default. You can view them on the model Entities 
tab in NLU Workbench.

GLOBAL.DATE system entity

The DAY SubType returns a date string that is accurate to a specific date.

GLOBAL.DATE SubType = DAY usage

Usage Example

Format YYYY-MM-DD

Regular expression \\d\\d\\d\\d-\\d\\d-\\d\\d

Input example Mr. Smith left Friday, February 4, 2019.

Normalized value 2019-02-04

Code example
{
"name": "DATE",
"value": "...",
"score": 1.0,
"normalization": "2019-02-04"
}

The WEEK SubType returns a date string of a specific week of a year.

GLOBAL.DATE SubType = WEEK usage

Usage Example

Format YYYY'W'WW

Regular 
expression

\\d\\d\\d\\d\\dW\\d\\d

Input 
example

Mr. Smith left the third week of 1999.

Normalized 
value

1999W3

Code 
example {

"name": "entity:GLOBAL.DATE",
"value": "...",
"score": 1.0,
"normalization": {"type": "GLOBAL.DATE", "subType": 
 "WEEK", "value":"1999W3"}
}

The MONTH SubType returns a date string of a specific month of a year.
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GLOBAL.DATE SubType = MONTH usage

Usage Example

Format YYYY'M'MM

Regular 
expression

\\d\\d\\d\\dM\\d\\d

Input 
example

Mr. Smith left in February of 1999.

Normalized 
value

1999M02

Code 
example {

"name": "entity:GLOBAL.DATE",
"value": "...",
"score": 1.0,
"normalization": {"type": "GLOBAL.DATE", "subType": 
 "MONTH", "value": "1999M02"}
}

The YEAR SubType returns a date string of a specific year.

GLOBAL.DATE SubType = YEAR usage

Usage Example

Format YYYY

Regular 
expression

\\d\\d\\d\\d

Input 
example

Mr. Smith left in 1999.

Normalized 
value

1999

Code 
example {

"name": "entity:GLOBAL.DATE",
"value": "...",
"score": 1.0,
"normalization": {"type": "GLOBAL.DATE", "subType": 
 "YEAR", "value": "1999"}
}

The SEASON SubType returns a date string of a specific season of the year.

GLOBAL.DATE SubType = SEASON usage

Usage Example

Format One of the following:

• Winter: YYYYWI

• Spring: YYYYSP
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GLOBAL.DATE SubType = SEASON usage  (continued)

Usage Example

• Summer: YYYYSU

• Fall: YYYYFA

Regular 
expression

One of the following:

• Winter: \\d\\d\\d\\dWI

• Spring: \\d\\d\\d\\dSP

• Summer: \\d\\d\\d\\dSU

• Fall: \\d\\d\\d\\dFA

Input 
example

Mr. Smith left in the fall of 1999.

Normalized 
value

1999FA

Code 
example {

"name": "entity:GLOBAL.DATE",
"value": "...",
"score": 1.0,
"normalization": {"type": "GLOBAL.DATE", "subType": 
 "SEASON", "value": "1999FA"}
}

GLOBAL.TIME system entity

The TIME SubType returns a time string that is accurate to an hour and a minute.

GLOBAL.TIME SubType = TIME usage

Usage Example

Format 'T'HH:mm

Regular 
expression

T\\d\\d:\\d\\d

Input 
example

Mr. Smith left at ten minutes to three.

Normalized 
value

T02:50

Code 
example {

"name": "entity:GLOBAL.TIME",
"value": "...",
"score": 1.0,
"normalization": {"type": "GLOBAL.TIME","subType": 
 "TIME", "value": "T02:50"}
}
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The PARTSOFDAY SubType returns a time string that specifies parts of the day.

GLOBAL.TIME SubType = PARTSOFDAY usage

Usage Example

Format One of the following:

• Morning: TMO

• Afternoon: TAF

• Evening: TEV

• Night: TNI

Regular 
expression

One of the following:

• Morning: TMO

• Afternoon: TAF

• Evening: TEV

• Night: TNI

Input 
example

Mr. Smith left in the morning.

Normalized 
value

TMO

Code 
example {

"name": "entity:GLOBAL.TIME",
"value": "...",
"score": 1.0,
"normalization": {"type": "GLOBAL.TIME", "subType": 
 "PARTSOFDAY", "value": "TMO"}
}

GLOBAL.DATE_TIME system entity

The DATE_TIME SubType returns a date string that is accurate to a specific date and time string 
that is accurate to an hour and a minute.

GLOBAL.DATE_TIME SubType = DATETIME usage

Usage Example

Format YYYY-MM-DD'T'HH:mm

Regular 
expression

\\d\\d\\d\\d-\\d\\d-\\d\\dT\\d\\d:\\d\\d

Input example Mr. Smith leaves on October 31st at 5:00 p.m.

Normalized value 2022-10-31T17:00

Code example
{
"name": "DATE_TIME",
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GLOBAL.DATE_TIME SubType = DATETIME usage  (continued)

Usage Example

"value": "October 31st at 5:00 p.m",
"normalization": "2022-10-31T17:00","confidence": 
 "1"
}

GLOBAL.DURATION system entity

This entity returns a duration string that specifies the duration of the activity.

GLOBAL.DURATION usage

Usage Example

Format One of the following:

• Second: 's'ss

• Minute: 'm'mm

• Hour: 'h'hh

• Day: 'D'DD

• Week: 'W'WW

• Month: 'M'MM

• Year: 'Y'YY

Regular 
expression

One of the following:

• Second: s\\d\\d

• Minute: m\\d\\d

• Hour: h\\d\\d

• Day: D\\d\\d

• Week: W\\d\\d

• Month: M\\d\\d

• Year: Y\\d\\d

Input example Mr. Smith stayed in Boston for 48 hours.

Normalized 
value

h48

Code example
{
"name": "entity:GLOBAL.DURATION",
"value": "...",
"score": 1.0,
"normalization": {"type": "GLOBAL.DURATION", 
 "value": "h48"}
}
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GLOBAL.LOCATION system entity

This entity returns a location string.

GLOBAL.LOCATION usage

Usage Example

Format String value. Example: Santa Clara

Regular 
expression

Not applicable.

Input example Mr. Smith works in Santa Clara.

Normalized 
value

Santa Clara

Code example
{
"name": "entity:GLOBAL.LOCATION",
"value": "...",
"score": 1.0,
"normalization": {"type": "GLOBAL.LOCATION", 
 "value":"Santa Clara"}
}

GLOBAL.PERSON system entity

This entity returns a name string.

Usage Example

Format String value. Example: Joe Smith

Regular 
expression

Not applicable.

Input example Joe Smith works in Santa Clara.

Normalized 
value

Joe Smith

Code example
{
"name": "entity:GLOBAL.PERSON",
"value": "...",
"score": 1.0,
"normalization": {"type": "GLOBAL.PERSON", 
 "value":"Joe Smith"}
}

GLOBAL.MONEY system entity

This entity returns a currency string.
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GLOBAL.MONEY usage

Usage Example

Format String value. Example: USD 2000

Regular 
expression

Not applicable.

Input 
example

Show me laptops for less than $2000.

Normalized 
value

USD 2000

Note: 
The normalized value uses the three-letter ISO 3166 country code of the 
source currency.

Code 
example {

"name": "entity:GLOBAL.MONEY",
"value": "...",
"score": 1.0,
"normalization": {"type": "GLOBAL.MONEY", 
 "value":"2000", “currency”:”USD”}
}

GLOBAL.NUMBER system entity

This entity returns a number.

Usage Example

Format String value. Example: 5.0

Regular 
expression

Not applicable.

Input example I want to see the previous 5 transactions from my account.

Normalized 
value

5.0

Code example
{
"name": "entity:GLOBAL.NUMBER",
  "value": "...",
  "score": 1.0,
  "normalization": {"numericValue":"5", 
 “normalizedValue”: “5”}
}

GLOBAL.SOFTWARE

Returns a software string.
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Usage Example

Format String value. Example: Java

Regular 
expression

Not applicable.

Input example How do I install Java?

Normalized value Java

Code example
{
  "name": "entity:GLOBAL.SOFTWARE",
  "value": "Java",
  "score": 0.99930537,
  "normalization": 
 {"type":"entity:GLOBAL.SOFTWARE",
                     "subType":"SOFTWARE",
                     "value":"Java"}
}

GLOBAL.HARDWARE

Returns a hardware string.

Usage Example

Format String value. Example: printer

Regular 
expression

Not applicable.

Input example How do I order a printer?

Normalized value printer

Code example
{
  "name": "entity:GLOBAL.HARDWARE",
  "value": "printer",
  "score": 1.0,
  "normalization": 
 {"type":"entity:GLOBAL.HARDWARE",
                     "subType":"HARDWARE",
                     "value":"printer"}
}

Example NLU  prediction result using Software system entity

{"status":"success",
   "response":{
      "utterance":"How do I install Java?",
      "intents":[
         {
            "intentName":"test intent",
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 "nluModelName":"ml_x_snc_global_global_268a97a9dbd23c107906265d
1396191a",
            "score":0.90401393,
            "intents":[
 
            ],
            "entities":[
               {
                  "name":"entity:GLOBAL.SOFTWARE",
                  "value":"Java",
                  "score":0.99930537,
                  "normalization":{
                     "type":"entity:GLOBAL.SOFTWARE",
                     "subType":"SOFTWARE",
                     "value":"Java"
                  },
                  "startingPosition":-1
               }
            ]
         }
      ],
      "properties":{
        
 "all:ml_x_snc_global_global_268a97a9dbd23c107906265d1396191a":"
0.55",
         "entity:all":"0.01",
         "inference.sspace.time":"4",
         "inference.time":"33",
         "intent:all":"0.01",
         "nluPlatformLanguage":"en",
         "nluPlatformVersion":"rome.0"
      }
   }
}

Example NLU  prediction result using DATE system entity

{
    "utterance": "We should meet next Sunday at Starbucks.",
    "intents": [
        {
            "intentName": "intent:Desire.Desire",
            "score": 0.83452,
            "entities": []
        },
        {
            "intentName": "intent:Meeting.MeetRequest",
            "score": 0.8919042,
            "entities": [
                {
                    "entityName": 
 "entity:Meeting.MeetRequest.Where",
                    "value": "Starbucks",
                    "score": 1
                },
     {
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                    "entityName": "entity:GLOBAL.DATE",
                    "value": "Sunday",
                    "normalization": { "type": "DATE",
                        "subType": "DAY",
                        "value": "1999-10-01"
                     },
                    "score": 0.87
                }
            ]
        }
    ]
}

Virtual Agent  URL parameters

Virtual Agent  provides various system parameters that admins can add to an instance URL to 
control how page content is rendered.

Virtual Agent  URL structure

You can control the page rendered for an instance by adding URL parameters to the instance 
URL, which is https://<instancename>.service-now.com.

System parameters for Virtual Agent  web client

The Virtual Agent  web client is supported for use in portals or embedded in third-party pages. 
The following system parameters control the conversation content rendered in the Virtual Agent 
web client.

Parameter Description Example

sysparm_branding_key
Applies a chat branding 
configuration to the web chat 
client.

Value: branding key for the 
configuration

• Apply the branding 
configuration 
to a destination 
page:  https://
<instancename.service-
now.com/$sn-va-
web-client-app.do?
sysparm_branding_key=acme

• Apply the branding 
configuration to an 
embedded web 
client:  https://
<instancename.service-
now.com/$sn-
va-web-client-
app._embed.do?
sysparm_branding_key=acme

sysparm_default_topic Sets the default topic on 
launch via topic sys_ID.

https://
<instancename>.service-
now.com/$sn-va-
web-client-app.do?
sysparm_default_topic=1f5ac6dfc34020105a61d7de76400001

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2574



Parameter Description Example

sysparm_domain_id Restricts the chat to the 
specified sys ID for a domain.

https://
<instancename>.service-
now.com/$sn-va-
web-client-app.do?
sysparm_domain_id=c90d4b084a362312013398f051272c0d

sysparm_live_agent_only Takes user directly to a live 
agent, if available.

https://
<instancename.service-
now.com/$sn-
va-web-client-
app._embed.do?
sysparm_live_agent_only=true

sysparm_load_active_only Loads the current active 
conversation.

Values:

• true: Loads only the active 
conversation

• false: Doesn't load active 
conversations

•

Note: 
If the 
sysparm_skip_load_history 
and 
sysparm_load_active_only 
parameters are both 
set to true, the existing 
sysparm_skip_load_history 
parameter takes 
precedence.

https://
<instancename.service-
now.com>$sn-va-
web-client-app.do?
sysparm_load_active_only=true

sysparm_nowassist Loads the Now Assist in Virtual 
Agent client.

https://
<instancename>.service-
now.com/$sn-
va-web-client-
app._embed.do?
sysparm_nowassist=true

sysparm_search_text Sets the search text for the 
conversation.

https://
<instancename>.service-
now.com/$sn-va-
web-client-app.do?
sysparm_search_text=request&laptop

sysparm_skip_load_history Skips the previous message 
history and starts a new 
conversation.

Values:

https://
<instancename.service-
now.com>$sn-va-
web-client-app.do?
sysparm_skip_load_history=true
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Parameter Description Example

• true: Doesn’t load message 
history

• false: Loads message 
history

Note: 
If the 
sysparm_skip_load_history 
parameter is set 
to false and the 
sysparm_load_active_only 
is set to true, the 
sysparm_load_active_only 
loads the current active 
conversation.

sysparm_ preview_mode Displays the conversation in 
test mode.

//https://
<instancename.service-
now.com>$sn-va-
web-client-app.do?
sysparm_preview_mode=true

sysparm_requester_session_languageSpecifies the requester's 
language for the conversation 
session when Dynamic 
Translation for Virtual Agent  is 
installed and configured.

https://
<instancename.service-
now.com>$sn-va-
web-client-app.do?
sysparm_requester_session_language=<two-
letter language 
code>

Latency feedback in Virtual Agent

The com.glide.cs.message.processing.enabled  system property notifies 
requesters whenever the generative AI large language model (LLM) is processing their request in 
the Virtual Agent  web client and Now Assist  panel.

Latency feedback messages

The com.glide.cs.message.processing.enabled  property is off by default, but 
can be turned on in the System Properties [sys_properties] table. After turning on this system 
property, users receive a temporary response to indicate that the LLM call is running and that 
their request is being processed. One of the following messages appears to users:

• Looking into your request...

• Reviewing key details...

• Gathering the needed info...

The latency feedback messages can’t be customized and disappears after the LLM generates a 
response.
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Example of a latency feedback message

Now Assist  in Virtual Agent
Use generative AI skills in your conversational experiences. Now Assist  in Virtual Agent  uses 
large language models (LLMs) to create a natural-language conversational experience that can 
improve the success of your self-service workflows.

Get started

For an introduction to building a Virtual Agent with Now Assist, watch this video.

https://player.vimeo.com/video/995581833?
h=177e4bc9f8&badge=0&autopause=0&player_id=0&app_id=58479
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Explore

Learn about the generative 
AI skills available in Now 
Assist in Virtual Agent.

Configure

Activate Now Assist in 
Virtual Agent and configure 

generative AI skills.

Use

Learn about the requester 
conversational experience.

Analyze

Monitor the performance 
of Now Assist

in Virtual Agent.

Reference

Get details about user 
input and bot responses 

supported by Now 
Assist in Virtual Agent.

Important: 
Some Now Assist  products/features are currently unavailable for customers in the 
FedRAMP, NSC DOD IL5, or Australia IRAP-Protected data centers, self-hosted customers, 
or in other restricted environments. For more information, see the KB0743854  article in 
the Now Support  Knowledge Base. Please check for availability updates in future releases.

Troubleshoot and get help

• Virtual Agent community forum

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support

AI limitations

This application uses artificial intelligence (AI) and machine learning, which are rapidly evolving fields of study that generate predictions based on patterns in 

data. As a result, this application may not always produce accurate, complete, or appropriate information. Further, there is no guarantee that this application has 

been fully trained or tested for your use case. To mitigate these issues, it is your responsibility to test and evaluate your use of this application for accuracy, harm, 

and appropriateness for your use case, employ human oversight of output, and refrain from relying solely on AI-generated outputs for decision-making purposes. 

This is especially important if you choose to deploy this application in areas with consequential impacts such as healthcare, finance, legal, employment, security, 

or infrastructure. You agree to abide by ServiceNow’s AI Acceptable Use Policy , which may be updated by ServiceNow.

Data processing

This application requires data to be transferred from ServiceNow  customers' individual instances to a centralized ServiceNow  environment, which may be located 

in a different data center region from the one where your instance is, and potentially to a third-party cloud provider, such as Microsoft Azure. This data is handled 

per ServiceNow's internal policies and procedures, including our policies available through our CORE Compliance Portal .
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Data collection

ServiceNow  collects and uses the inputs, outputs, and edits to outputs of this application to develop and improve ServiceNow  technologies including ServiceNow 

models and AI products. Customers can opt out of future data collection at any time, as described in the Now Assist  Opt-Out page .

For more information, see the Now Assist  documentation .

Exploring Now Assist  in Virtual Agent

Now Assist  in Virtual Agent  uses large language models (LLMs) and generative AI skills to 
improve deflection rates and reduce the amount of time-consuming work that Natural Language 
Understanding  (NLU) topic discovery requires.

Now Assist  capabilities bring generative AI to Virtual Agent. Using LLMs for topic discovery 
simplifies the amount of setup and configuration required for Virtual Agent. Topics that use 
keyword and Natural Language Understanding  (NLU) discovery often require months of 
development and the involvement of dedicated subject matter experts. Unusual issues or 
questions may lead a user to contact a live agent instead.

Use the guided setup to configure Now Assist  in Virtual Agent  in a few minutes. No expertise is 
necessary to launch the experience. For more information, see Configuring Now Assist in Virtual 
Agent.

Now Assist  in Virtual Agent  is available through portals on the web client, the mobile app, and 
Microsoft Teams.

Now Assist  skills in Virtual Agent

Now Assist  skills in Virtual Agent  enhance the user experience by combining AI Search  with chat. 
These skills can increase issue resolution in Virtual Agent  and reduce deflections to a live agent.

The following figure shows how the requester uses natural language rather than keywords in the 
chat. Now LLM Service  determines the most likely option based on the requester's input and 
sends a synthesized response with possible action items. Queries can apply to both information 
searches and service catalog requests.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2579

https://www.webstg.servicenow.com/docs/access?context=opt-out-of-data-sharing-for-now-assist&version=washingtondc&pubname=washingtondc-intelligent-experiences&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=opt-out-of-data-sharing-for-now-assist&version=washingtondc&pubname=washingtondc-intelligent-experiences&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=opt-out-of-data-sharing-for-now-assist&version=washingtondc&pubname=washingtondc-intelligent-experiences&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=opt-out-of-data-sharing-for-now-assist&version=washingtondc&pubname=washingtondc-intelligent-experiences&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=platform-now-assist-landing&version=washingtondc&pubname=washingtondc-intelligent-experiences&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=platform-now-assist-landing&version=washingtondc&pubname=washingtondc-intelligent-experiences&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=platform-now-assist-landing&version=washingtondc&pubname=washingtondc-intelligent-experiences&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=platform-now-assist-landing&version=washingtondc&pubname=washingtondc-intelligent-experiences&ft:locale=en-US


A synthesized response example with conversational and non-conversational 
catalog options

The Now Assist  Q&A Genius Results skill shows users the best possible answer to a query, in 
the form of actionable options displayed along with the results. The bot may generate answers 
based on what it found, or return actionable options or links. Users have the option to see more 
results as needed.
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The Now Assist  Multi-Turn Catalog Ordering skill gives users access to available options in the 
Service Catalog. Users can request an item, such as a mobile phone. The user can then provide 
more information to refine the search. For example, they may refine their request to a blue 256-
GB iPhone. They can even request a new item instead, all in the same conversation, and the 
generative AI creates its responses using natural language.

The Now Assist  Topics skill enables admins to create LLM topics for Now Assist  in Virtual Agent. 
For more information, see LLM assistants. Activate the Now Assist  Topics skill in the Now Assist 
guided setup. For more information, see Configuring Now Assist in Virtual Agent.

For more examples of having a conversation with Now Assist  in Virtual Agent, see Using Now 
Assist in Virtual Agent.

An example of the View all topics option from within the chat widget

Now Assist  in Virtual Agent  skills are available in the Now Assist Admin  console. For full catalog 
functionality in the chat window, enable the generative AI experience for catalog item request 
submissions. For more information, see Configure Now Assist in Conversational Catalog 
Request.
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Now Assist  in Virtual Agent  skill in the Now Assist Admin  console

Benefits

Now Assist  in Virtual Agent  provides the following benefits.

Benefit Feature User

Configure Now Assist  in Virtual Agent  in a few 
minutes, from either the Conversational Interfaces 
console or the Now Assist Admin  console.

Guided setup 
experience

virtual_agent_admin 
or admin

Now Assist  skills can be turned on within the 
guided setup.

Activate a Now 
Assist skill

virtual_agent_admin 
or admin

Deploy Now Assist  in Virtual Agent  on multiple 
portals using the web client, the mobile app, and 
Microsoft Teams.

Configuring Now 
Assist in Virtual 
Agent

virtual_agent_admin 
or admin

Generative AI enhances the user search 
experience with the ability to generate answers 
and enabling the user to select the Show more 
results  option for a new search.

Now Assist Q&A 
Genius Results skill

requesters

Give users in-chat access to available options in 
the Service Catalog.

Now Assist Multi-
Turn Catalog 
Ordering skill

requesters
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Benefit Feature User

Now Assist  lets Virtual Agent  switch easily between 
requests, using plain language when new queries 
are made in the same conversation.

Mid-topic switching 
during Now Assist 
in Virtual Agent 
conversations

requesters

Monitor performance metrics for Now Assist  in 
Virtual Agent  from the Conversational Interfaces 
console.

Conversational 
Interfaces console

virtual_agent_admin 
or admin

Monitor value metrics (Now Assist  usage versus 
Now Assist  in Virtual Agent) from the Now Assist 
Admin  console.

Now Assist Admin 
console

virtual_agent_admin 
or admin

LLM assistants

LLM assistants help with large language model (LLM) topic discovery. The Now Assist  in Virtual 
Agent  assistant is the default LLM assistant created during the Conversational Interfaces 
Assistants guided setup.

After Now Assist  in Virtual Agent  or other custom assistants are active, you can associate any 
object type to the LLM assistants. Completing the Now Assist  in Virtual Agent  guided setup, as 
detailed in Configuring Now Assist in Virtual Agent, creates the Now Assist  in Virtual Agent  LLM 
assistant and enables you to create additional custom LLM assistants. Associating topics to an 
assistant makes that topic discoverable with that assistant. For topic discovery results, associate 
LLM topics with an assistant. Associate LLM topics to at least one assistant when creating new 
topics or editing topics on the topic's Properties  tab. For more information about selecting LLM 
assistants when creating a topic, see Create a Virtual Agent topic.

If LLM topics aren't associated with an LLM assistant, they aren't discoverable and can't be 
tested from the Topics page via Test active topics  or the Test active topics  > Test LLM assistant 
topics  drop-down list. The Test active topics  option only appears if you have an assistant 
selected in the Topics page LLM Assistant  filter. The Test active topics  > Test LLM assistant 
topics  drop-down list appears if you don't specify the LLM Assistant  in the Topics page LLM 
Assistant  filter. When using the LLM Assistant  filter, topic blocks or custom controls that 
aren’t associated with an LLM assistant, but are called by a topic that's associated with an LLM 
assistant, appear in this filtered LLM Assistant  Topics page view. Nested topic blocks or custom 
controls don’t appear in the filtered Topics page view unless they’re directly associated with an 
LLM assistant. For more information about testing LLM topics, see LLM topic testing. When a 
topic is associated with the only active LLM assistant, the Assistant drop-down list defaults to 
that assistant name. If you have multiple assistants, select which assistant you want to work with 
using the Assistant drop-down list. For more information about creating multiple LLM assistants, 
see Manage LLM virtual agents on the Assistants screen.

Tip: 
On the Virtual Agent Designer  Topics page, there is either a Settings  or Manage  option 
next to the LLM Assistant  filter. Settings  appears if there is a specific LLM assistant 
selected in the LLM Assistant  filter and Manage  appears if no assistant is selected in the 
filter. Use this option to quickly navigate to the Conversational Interfaces guided setup area 
to review or update your LLM assistants. For more information on the guided setup, see 
Configuring Now Assist in Virtual Agent.

If you want your LLM setup topic to be discoverable in an LLM assistant, you must flag the active 
setup topic as discoverable. For example, if you create an LLM setup topic by duplicating the 
Now Assist  Live Agent  setup topic and want to associate the setup topic with an LLM assistant, 
you must flag the duplicated topic as discoverable. Flag the topic as discoverable by going to the 
duplicated topic’s Flow  tab, and then select Active  > Included in topic discovery. After enabling 
the Included in topic discovery  toggle, the topic is now discoverable.
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Included in topic discovery option in Virtual Agent Designer

Now Assist  in Virtual Agent  Domain Separation

Domain separation is supported for Now Assist  in Virtual Agent. Domain separation enables you 
to separate data, processes, and administrative tasks into logical groupings called domains. You 
can control several aspects of this separation, including which users can see and access data.

Support level: Basic

• Business logic: Ensure that data goes into the proper domain for the application’s service 
provider use cases.

• The application supports domain separation at run time. The domain separation includes 
separation from the user interface, cache keys, reporting, rollups, and aggregations.

• The owner of the instance must set up the application to function across multiple tenants.

Sample use case: When a service provider (SP) uses chat to respond to a tenant-customer’s 
message, the customer must be able to see the SP's response.

For more information on support levels, see Application support for domain separation .

Overview

The goal of Now Assist in Virtual Agent is to enable Now Assist conversations in Virtual Agent. 
Only the data and business logic level separation is done.

Related topics

Domain separation for service providers

Configuring Now Assist  in Virtual Agent

Use Now Assist  in Virtual Agent  to provide a content-driven generative AI experience for users.

Before you begin
There are two entry points used to set up Now Assist  in Virtual Agent: You can set it up from 
within the Conversational Interfaces console (see step 1), or from the Now Assist  admin console. 
If you're already within the Now Assist  Admin console, select Set up Now Assist in Virtual Agent.
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The Assistants  tab as seen in the image of step 1 appears.

Role required: virtual_agent_admin or admin

About this task
Virtual Agent  admins and admins can easily configure more than one Now Assist  in Virtual Agent 
with this guided setup.

Procedure

1. Navigate to All>Conversational Interfaces>Assistants.
By default, a Now Assist  in Virtual Agent  is listed.

2. Select Turn on or off  the Now Assist  in Virtual Agent  or create a Virtual Agent.
If you create a Virtual Agent, the Get started page is displayed.
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3. In the Add some details section, provide a name and description for your Virtual Agent  then 
select Save and continue.
The Assign Now Assist  skills page is displayed.

At the top of the page, the name of your Virtual Agent  appears. In this example, it's Now Assist 
in Virtual Agent  - TEST.

By default, all Now Assist  skills are turned on and shown in this list as active. You can deselect 
a skill if needed, and it will be unassigned for this Virtual Agent. However, if you want to 
deactivate a skill across the entire instance, select Manage skills.

Note: 
At least one skill must be active.

4. Select Save and continue.
The Choose where to display page appears.
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If a portal was previously selected for a different assistant, an informational message is 
displayed in the Alert column.

5. Select one or more portals or integrate with a messaging channel to display your Virtual Agent.

NLU-based Virtual Agent  doesn't co-exist with Now Assist  in Virtual Agent. They can co-exist in 
the same instance, but not within the same portal.

For Microsoft Teams, if it's not installed, go to Conversational Interface> Settings> Channels 
to install the Conversational integration with Microsoft Teams. Getting the plugin redirects you 
to the ServiceNow store. After the store app is installed, select the Teams channels to enable 
Now Assist  in Virtual Agent.
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If the application for mobile in the Now Assist  Admin console is turned on, it enables Now 
Assist  large language model (LLM) in Virtual Agent  for those applications on mobile.

6. Select Save and continue.
The Choose information sources page is displayed.

7. From the drop-down menu, choose a search profile to be used by the Virtual Agent.
If a search profile is selected, change the settings based on the link provided. The selected 
profile is copied over so that the Now Assist  in Virtual Agent  search profile is the same as the 
selected profile. Search sources, dictionaries, and result improvement rules are mirrored from 
the selected search profile to the default search profile that's associated with the assistant.
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8. Select Show conditions  to show the current conditions, make modifications, or add a new 
condition set.
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Note: 
You can also quickly see the number of catalog items that are supported conversationally 
in Virtual Agent.

a. If you have a Now Assist  Q&A Genius Results section, determine the content that is 
searched by configuring this information source.

b. If you have a Now Assist  Multi-Turn Catalog Ordering section, the following conditions 
appear. To design a topic conversation in Virtual Agent, see Create a Virtual Agent 
topic.

c. If you have a Now Assist  topics section, see Create a Virtual Agent topic  to create or 
configure more topics.
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9. Select Save and continue.

The Virtual Agent  branding page appears where you can select a default branding or an 
existing customized branding. To create a branding, see the Conversational Interface console 
settings.

10. Select Save and continue.
The Define your chat experience page appears where you manage your greeting, closing, 
and fallback messages. The fallback options are Live Agent, Reset Conversation, and Record 
Producer.

Use the simple settings type to define the default chat experience.

For fallback options,
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a. Live agent support routes you to an available agent if configured.

b. Reset conversation restarts the conversation to the beginning to ask another question.

c. A record producer directs the user to a catalog record producer to create an incident or a 
case.

Note: 
For this fallback option to work for guest users, create a public record producer. For 
more information, see Create a record producer. If the public record producer is set to 
active, it automatically appears in the Now Assist  in Virtual Agent  Fallback options > 
Record producer drop-down menu.

More configurations are available in Advanced settings, replacing the default. You can select 
from a pre-filtered list to override setup topics defined in Virtual Agent Designer. If you change 
one of your setup topics, and you return to the simple setting, that topic is unavailable.

On the Promoted topics  tab, you can navigate to Virtual Agent Designer  (VAD) to define 
promoted topics for this assistant. Once you have defined the topics in VAD, you can then use 
the up or down arrows to reorder the topics.
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11. Select Save and continue.

The Review page is displayed where you can review all your settings and test your Virtual 
Agent. It's important to test your Virtual Agent  to judge the quality of results for common 
use cases before moving your experience into a production environment. Validate the user 
interface experience, use case results, and fallback options.

a. Now Assist  skills shows the active skills.

b. Display experience shows which portals have Virtual Agent.
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c. Information sources shows the conditions for each source.

d. Branding shows the type of branding that you have selected.

e. Chat experience shows your greeting, closing messages, and fallback options.

In the Additional Resources  section, the following appears depending on your setup.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2594



a. Now Assist  Topics is visible if the Now Assist  Topics skill is enabled for your assistant. The 
View all topics link brings you to Virtual Agent Designer.

b. Now Assist  in AI Search always remains visible. The View all portals links brings you to the 
Set up Now Assist  in AI Search console to enable Genius Results generated by Now Assist  in 
portal search.

c. Monitor your Virtual Agent  is visible once you turn on at least one assistant for the first time. 
The View performance link brings you to Now Assist  in Virtual Agent  Analytics.

12. Select Turn on  after you have tested your Virtual Agent  to confirm that everything is working 
fine.
A message appears showing that Now Assist  in Virtual Agent  is successfully turned on.

13. Select Got it.

Result
Now Assist  in Virtual Agent  is active and topics can be associated with the Now Assist  in Virtual 
Agent  LLM assistants.

Configure Now Assist  in Conversational Catalog Request

Speed up and provide a conversational and streamlined experience based on generative AI 
while submitting a catalog item request in Virtual Agent. Your organization can increase self-
service and reduce operating costs.

Before you begin
Role required: admin or catalog_admin, and flow_designer (to edit the subflow)

About this task
Generative AI capabilities are leveraged to provide a human-like and efficient catalog request 
experience over the Virtual Agent  conversational interface. It reduces the turnaround time for the 
request submission.

When the generative AI experience is configured for catalog item request submission, the 
following experience is available for a requester:

• Contextual question prompts that enable a more human-like conversation based on answers 
to previous questions.

• Slot filling that recognizes answers to 1 or more questions on the requester's input. For 
example, if the search keyword is I’d like to request for a Windows Virtual 
Machine with 1TB disk space  and if the catalog item has questions about operating 
system and hard disk space, then the requester doesn't have to answer these questions again.
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• Ability to answer multiple catalog item questions at the same time.

• Multi-turn catalog ordering where requesters can change answers at any point. For example, 
while answering a question about a phone's memory size, the requester can mention about 
changing the phone model selected in the previous question.

• Validation of questions' answers.

• Ability to exit the request submission process at any point.

Note: 

• Read-only questions, questions with pre-filled answers, and questions that are already 
answered in the requester’s search keyword are skipped.

• Though the following catalog item question types are supported in the conversation 
mode, natural language responses aren't supported for them:

◦ Reference

◦ Lookup select box

◦ Lookup multiple choice

◦ Requested For

◦ Attachment

◦ Multiple choice question with more than 10 choices

Procedure

1. To configure the Now Assist  for Virtual Agent  application that installs the Now Assist  in 
Conversational Catalog Request application, see Configuring Now Assist in Virtual Agent.
With this configuration, the 
sn_now_assist_cr.llm.conversational.request.question.limit  system 
property value is set to 500 by default if that property wasn't edited earlier.

2. Enable the generative AI experience for a catalog item request submission in Virtual Agent.

a. Navigate to All  > Service Catalog  > Catalog Definition  > Maintain Items.

b. Select a catalog item that must be requested in the conversation mode.
For information about catalog items that are supported in the conversation mode, see 
Service Catalog topic blocks in Virtual Agent powered by LLM.

c. On the catalog item form, confirm that the Make the item non-conversational in VA  check 
box isn’t selected.

d. On the catalog item form, confirm that the Turn off Now Assist conversation for this item 
check box isn't selected.
If you select this check box, LLM isn’t used and the data isn't sent to LLM. The item might 
become non-conversational.
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Note: 

▪ If you want the catalog item non-conversational, then select the Make the item non-
conversational in VA  check box. But if the catalog item contains some sensitive 
information that you don’t want to send to LLM, then select the Turn off Now Assist 
conversation for this item  check box.

▪ If you clear the Make the item non-conversational in VA  check box, the item 
will become conversational only if all the conditions are met for making an item 
conversational. For more information about such conditions, see Service Catalog 
topic blocks in Virtual Agent powered by LLM.

e. Select Update.

3. Confirm that the fallback record producer is configured in the Fetch generic ticket producer 
for conversational catalog request  subflow.

In a few cases, when a requester is searching for a catalog item, AI Search  might not be able 
to return any results. For example, when the catalog item isn't available or when the requester 
has no access to view the catalog item. In such cases, the fallback mechanism is activated for 
the Virtual Agent  conversation. Virtual Agent  tries to connect the requester to a live agent. If a 
live agent isn't available, then the Create a generic ticket  record producer, which creates an 
incident to resolve the issue, is triggered.

◦ The Now Assist Fallback  topic controls the fallback mechanism. This topic triggers the 
record producer returned by the Fetch generic ticket producer for conversational catalog 
request  subflow.

◦ This subflow returns the value of the 
sn_nowassist_va.now.assist.generic.ticket.fallback.record.producer 
property. By default, this property's value is the sys_id of the Create a generic ticket  record 
producer.

Note: 
Both the 
sn_nowassist_va.now.assist.generic.ticket.fallback.record.producer 
property and the Create a generic ticket  record producer are available in an instance 
when the Now Assist  for Virtual Agent  application is installed.

Additionally, you can customize the fallback process by configuring your own record producer 
or by building additional logic in a new subflow.

4. Optional:  Configure URL navigation settings to specify where the generated ticket link in the 
Virtual Agent  chat opens, see Configure URL navigation for chat links.
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(Optional) For information about URL navigation in Virtual Agent, see URL navigation in 
Conversational Interfaces. For information about Virtual Agent  scripts, see Virtual Agent 
scripts.

Related topics

Service Catalog topic blocks in Virtual Agent powered by NLU

Service Catalog topic blocks in Virtual Agent powered by LLM

Using Now Assist  in Virtual Agent

Now Assist  in Virtual Agent  enhances the user experience by combining AI Search  with 
generative AI chat skills. These skills can speed up issue resolution and reduce deflection to a 
live agent.

Now Assist  in Virtual Agent  provides your users with an interactive generative AI experience. A 
friendly, natural language conversation is easier to understand and helps make requesters more 
comfortable with talking to a bot.

The following examples highlight how a conversation powered by generative AI might look in 
Virtual Agent.

Starting the conversation

The following figure shows an example of the beginning of a new conversation.
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Now Assist  greeting
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Now Assist  greeting elements

Element Description

1: Bot 
greeting Note: 

The Answers generated by AI. Review for accuracy. 
message prior to the greeting can't be edited or turned off.

After greeting the user, the bot provides an explanation of what the user can 
expect. Because the large language model (LLM) is still learning, the bot indicates 
that it may make mistakes, and that the user should check answers for accuracy.

2: User 
request

The user can enter any utterance.

3: 
Response 
indicator

While the LLM processes the utterance, animated dots in the chat window let the 
user know that the bot is working.

Conversing with the Virtual Agent

After the user enters an utterance and a search result is found, a synthesized response may 
appear. A synthesized response includes a brief summary of the requested information and 
search results along with Genius Results. For more information on how these search results are 
found, see Now Assist Actions Genius Results  and Now Assist Q&A Genius Results .

If multiple results are found, they are presented to users, and users can view the Sources section 
at the bottom of the synthesized response. The Sources section also includes any relevant 
Knowledge Base  article's attachments. Users can view Knowledge Base  articles, Virtual Agent 
topics, subflows or actions, and complete catalog request items. Virtual Agent  can only return 
available catalog items that match a user's request when the Now Assist  Multi-Turn Catalog 
Ordering skill is enabled. Users can follow up on a synthesized response and receive an answer 
that considers the previous context. For example, if you previously were chatting about the 
company's travel policy and then enter International, the system recognizes that you are 
wanting additional information on the company's international travel policy.

Note: 
For full catalog functionality in the chat window, enable the generative AI experience for 
catalog item request submissions. For more information, see Configure Now Assist in 
Conversational Catalog Request.

Whenever a single Virtual Agent  topic is found within a synthesized response, users 
are brought directly into that action's flow. You may consider bypassing the synthesized 
response and options by automatically launching catalog items, too. For more 
information on automatically launching single search result actions, search for the 
sn_nowassist_va.synthesized_autostart_items  system property in Available 
system properties .

The following options may appear depending on what search results are returned:

• Conversational catalog: The Start request  option appears and if selected, the requester can 
launch the catalog request flow within the Virtual Agent.

• Non-conversational catalog: The Go to request  option appears with an external link that if 
selected, either redirects the requester to a new browser or pop-up window for them to order 
the catalog item.
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• Topic, subflows, or action: The [Asset's name]  option appears and if selected, the requester is 
launched into that flow within the Virtual Agent.

• Q&A Knowledge Base: The answer is generated by Now Assist  with the option to view your 

sources through the numbered citations icon ( ). After selecting the numbered citations icon 
to display the sources, you can select each Now Assist  link to review the source in depth.

• Need something else: The View other options  option appears and if selected, a list of 
standard search results in list formatting appears along with one fallback topic. If there are no 
standard search results, only the fallback topic appears.
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A synthesized response example with conversational and non-conversational 
catalog options
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A conversational catalog response flow example

Each Virtual Agent  response includes feedback icons. The user can indicate if the response 

was helpful by selecting the like thumbs up icon ( ). If the response wasn't helpful, the user 

can select the dislike thumbs down icon ( ). This feedback is used to train the LLM model and 
improve responses over time.

When the catalog order is complete, Virtual Agent  displays a card for the order.
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A summary confirmation example for a completed catalog request

If the user needs more help, Now Assist  in Virtual Agent  directs the user to either a live agent, 
resets the conversation, or creates an incident. The option is determined by the admin in the 
Now Assist  in Virtual Agent  guided setup. For more information, see Configuring Now Assist in 
Virtual Agent.
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1. Live agent support routes the user to an available agent when configured.

2. Reset the conversation restarts the conversation to the beginning to ask another question.

3. Record producer directs the user to a catalog record producer to create an incident or case.

If a user doesn't have any skills configured for them by the administrator, no available skills are 
shown. However, the chat bar remains available for the user to enter an utterance. This triggers AI 
Search  for a Knowledge Base  article or catalog item.

Example of an open chat widget with no skills activated

For information about configuring a Now Assist  skill, see Activate a Now Assist skill .

Engaging with small talk

Small talk topics and small talk utterances from the Semantic Filter Framework are recognized. 
Small talk is supported by your primary and fallback languages. The semantic filtering recognizes 
these types of small talk:

• Greetings: For example, Hi, how are you today?

• Gratitude: For example, Thanks, this was helpful!

• Complaint: For example, This answer doesn't help me.

Chat conversations with complaints may prompt you to request a live agent or another fallback 
topic, for example, a create a support request topic.
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• Closure: For example, That's all I needed. Bye.

The conversation ends when closure small talk is recognized.

More information

Want to learn more? Visit these resources.

• For more information on topic switching during a conversation, see Mid-topic switching during 
Now Assist in Virtual Agent conversations.

• For more information on Now Assist, see Now Assist .

• For more information on Now Assist  in AI Search, see Now Assist in AI Search .

• For more information on Now Assist  in Virtual Agent  analytics, see Analyzing Now Assist in 
Virtual Agent.

Mid-topic switching during Now Assist  in Virtual Agent  conversations

Mid-topic switching easily lets you switch between requests, using plain language whenever new 
queries are made in the same Now Assist  in Virtual Agent  conversation.

During a Now Assist  in Virtual Agent  conversation, you can switch the conversation request 
without having to restart the conversation. For example, you are in the middle of a conversational 
catalog item and ordering an iPad when you remember open enrollment is coming up at your 
company. You can ask Virtual Agent  about when open enrollment is without having to exit out of 
your existing conversation. The Virtual Agent  provides a synthesized response which includes 
a summary about open enrollment, but also informs you that you can either continue with the 
existing conversation (ordering an iPad) or switch the conversation to focus on your new request 
(open enrollment).
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Example of topic switching

If you decide to continue with your original request, you return to the conversational node that 
you were previously on. If you decide to switch the conversational focus to something else, you 
can view additional information about your new request.

Integrating Now Assist  in Virtual Agent  with Microsoft Teams

Now Assist  in Virtual Agent  uses large language models (LLMs) and generative AI to improve 
the deflection rates and reduce the amount of time-consuming work that Natural Language 
Understanding (NLU) topic discovery once required.

Now Assist  in Virtual Agent  is available through portals on the web client, the mobile app, and 
Microsoft Teams. To integrate Now Assist  in Virtual Agent  with Microsoft Teams, see Configuring 
Now Assist in Virtual Agent. In step 12 of the procedure to Configuring Now Assist in Virtual Agent, 
there's the option to choose where to display Virtual Agent. Select Microsoft Teams.

Now Assist  in Virtual Agent  with Microsoft Teams  relies on AI Search  fallback topics. Within AI 
Search  fallback topics, two types of results can appear:
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1. Genius Results: Catalog items (conversational and non-conversational) and knowledge base 
articles (single-turn and multi-turn Q&A).

2. Regular search results (multi-link outputs in conversations).

For more information, see Exploring Now Assist in Virtual Agent  and Virtual Agent feature support 
in Microsoft Teams conversations.

Analyzing Now Assist  in Virtual Agent

Use the Now Assist  in Virtual Agent  Analytics dashboard to monitor the performance of Now 
Assist  in Virtual Agent.

Now Assist  in Virtual Agent  Analytics

The Now Assist  in Virtual Agent  Analytics dashboard provides indicators that track the 
performance of AI Search in Now Assist  in Virtual Agent. The indicators, for example, can reveal 
the following:

• Percentage of user queries that Now Assist  in Virtual Agent  responded to given the total 
number of queries

• Resolution status of user queries based on the feedback provided by the user

• Deflection rate in a given period

Use the Dates filter to select the date range for which you want to view the performance 
indicators. Use the Assistant filter to select the LLM assistants for which you want to view the 
indicators and breakdowns for analysis.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2608



You can view the dashboard at All  > Conversational Interfaces  > Conversational Analytics  > 
Dashboard  > Now Assist in VA

Now Assist  in Virtual Agent  Analytics dashboard

The following indicators show the performance of AI Search in Now Assist  in Virtual Agent.

• This area of the dashboard shows the total number of user queries received by Now Assist 
in Virtual Agent. In a conversation, when the user selects other list items such as Show next 
answer  and Show more results, the user input is considered as part of the same query. When 
Now Assist  detects an intent switch, for example, if the user types a different query or selects 
Start a new conversation, it's counted as a new query.

Total Number of Queries widget

• This area of the dashboard shows the total number of responses where Now Assist  in Virtual 
Agent  presented content for the users to review. If no content is presented in the response, the 
query is marked as No Response Provided.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2609



Total Number of Query Responses widget

• This area of the dashboard shows the resolution status of user queries that is determined 
based on the feedback provided by users on the query response.

◦ Resolved: Indicates that the user found the response to be useful and effective or the user 
didn't provide any feedback.

◦ Not Resolved: Indicates that the user didn't find the response presented by Now Assist  to be 
useful and indicated this response through negative feedback.

◦ No Response Provided: Indicates that no response was presented to the user query.

Query Resolution Status widget
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• This area of the dashboard shows the percentage of user queries resolved by Now Assist  in 
Virtual Agent. The deflection percentage is calculated using the following formula: (Number of 
resolved queries/Total number of query responses) x 100.

Deflection Rate widget

You can drill down for a detailed analysis by clicking anywhere on the indicators. See Examining 
indicators with KPI Details  for more information on exploring the indicators.

Understanding conversation deflection rate

Now Assist  in Virtual Agent  Analytics calculates the conversation deflection rate based on the 
resolution status associated with Now Assist  query responses.

Sample conversation scenario

Conversation flow Query Resolution status

The user enters "New laptop" Query 1 None

Now Assist  returns a choice list Query 1 None

The user selects Show next answer Query 1 None

Now Assist  presents a non-conversational item "New phone" Query 1 None

The user selects Show more results" Query 1 None

The user selects one of the SRs Query 1 None

The user selects the thumbs up icon on one of the SR cards. Query 1 Resolved

The user enters "parental leave policy" Query 2 None

Now Assist  presents a QA card for parental leave policy for US Query 2 None

The user enters "parental leave policy for Canada" Query 2 None

The user selects Something else Query 3 Resolved

The user enters "iPhone broken" Query 3 None

Now Assist  presents a choice list of items Query 3 None

The user selects one of the list items Query 3 Resolved

The user enters "outage" Query 4 None

Now Assist  presents a list of SRs Query 4 None
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Conversation flow Query Resolution status

The user selects Get more help Query 4 Not resolved

In the sample conversation scenario, the deflection rate is calculated as (Number of resolved 
queries/Total number of query responses) x 100, which is, (3/4) x 100 = 75%.

Now Assist  in Virtual Agent  reference

Virtual Agent  topic developers can create topics for use in the Now Assist  panel channel. The 
following Virtual Agent Designer  controls are currently supported.

For more information about the Now Assist  panel channel, see Channels in Conversational 
Interfaces.

Supported controls for the Now Assist  panel channel

Control type Supported controls

User input controls • Input Collector

• Text

• Static choice

• Dynamic choice

• Boolean

• Date Time

• Carousel

For more information, see Virtual Agent Designer user input controls.

Bot response controls • Text

• Link

• HTML

• Card (record card and record card with action only)

For more information, see Virtual Agent Designer bot responses.

Agent Chat
Agent Chat  provides features that streamline the agent and requester chat experience and 
enables managers to monitor and assist agents.

Provide your agents with a workspace that has built-in productivity features for engaging with 
customers. Your agents can do the following:

• Use shortcuts, known as quick actions, for common activities, such as transferring a chat to 
another queue or displaying contextual info related to the chat.

• Reuse common responses, such as greetings or answers to frequent questions, with response 
templates.

• Get possible solutions for issues, derived from searches of related issues in Knowledge 
articles, Q&A, and previous incidents or cases with Agent assist.

• Interact with customers in their native language using Dynamic Translation for Agent Chat.
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• Manage work assignments delivered to agents' inboxes, enabling them to set their availability 
and accept, reject, or transfer chats.

• Trigger a Virtual Agent  self-service topic that walks end users through a task with Conversation 
Autopilot.

• Provide agents with the option to add work notes or updates after they finish a support session 
with Interaction wrap up.

Get started

Explore

Learn about Agent Chat
concepts and features.

Configure

Install and configure Agent Chat
and activate relevant plugins.

Use

Use Agent Chat to help 
agents have discussions with 
others to solve issues faster.

Reference

Get Agent Chat details for domain 
separation, building reports, 

and interaction related records.

Exploring Agent Chat

Agent Chat  enables live agents to interact directly with end users through chat. Your end users 
can chat with a live agent to ask questions and receive information.

Agent Chat  overview

The chat system starts with virtual chat, which is an autonomous chat powered by artificial 
intelligence. The requester can then ask to chat with a live agent using Agent Chat. Using Agent 
Chat, agents can communicate with requesters, create incident or case records, or transfer chats 
to another agent or queue.

Agent Chat  uses a persistent widget for chat conversations on any portal page of the portal 
that you're using. You can establish assignment rules to enable chat conversations to reach the 
best agent available who has the capacity and skills to handle the job or the agent can transfer 
the chat to another agent. Agents can use response templates to enable reusable, consistent 
messages to requesters.

Virtual chat conducts a survey before and after the Agent Chat. The pre-survey gets preliminary 
information about the requester to aid in the chat session. The post-chat survey gets feedback 
on the requester's satisfaction with the agent who helped.
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Agent Chat  benefits

Benefit Feature Users

Agents and chat managers have a 
conversation without the requester knowing.

Agent Whisper Agents, chat 
managers

Gather important information from end users 
through conversational questionnaires.

Chat surveys Agents

Download a transcript of the conversation 
between the agent and the requester.

Chat transcript 
downloads for 
requesters

Requester

Carry out a conversation in another language. Dynamic Translation 
for Agent Chat 
overview

Agent, requester

Initiate conversations with requesters on a 
messaging app of the requester's choice.

Agent-Initiated 
Messaging Interface

Agent, requester

Read a summarization of the chat (this 
is available only if you have Now Assist 
installed).

Chat summarization Agent

Routing chats

Requesters start chats with virtual chat. When they request to chat with a live agent on Agent 
Chat, their request goes into a queue controlled by Advanced Work Assignment  (AWA), which 
routes chats to different agents based on availability, queue length, and expertise.

Unfurling links

If an agent or requester enters a link during an Agent Chat  conversation, the links are "unfurled" 
or displayed with a preview of the website's content. Links in Agent Chat  conversations are 
unfurled in the same manner as Virtual Agent. For more information, see Using link unfurling in 
Virtual Agent.

Cross-channel conversation history and cross-channel message-level 
sentiment

Agents can see cross-channel conversation history and cross-channel message-level sentiment 
in real time when an agent is having a live conversation with a requester in the chat panel in 
Agent Chat. For more information, see Getting work from chats .

Agent Whisper

Agent Whisper  lets agents and chat managers have a conversation without the requester 
knowing.

During a chat between a requester and an agent, the agent may want to privately ask a chat 
manager for assistance or a chat manager and an agent may want to converse without the 
requester knowing. Using Agent Whisper, the agent can request help and the chat manager and 
agent can send messages to each other without the requester knowing.

For example, if an agent is newly hired, still in training, or unsure about how to proceed with a 
requester's request, the agent can ask a chat manager to join the conversation to help walk the 
agent through the steps of the procedure privately.
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Another scenario is if an agent needs to escalate a customer conversation to a chat manager. 
Agents can request help and chat managers can join the chat conversations publicly to 
communicate directly with the customer to help deescalate the situation.

You activate Agent Whisper  in Agent Chat settings. For details, see Setting up Agent Chat.

Using the Help quick action

Agents can ask chat managers to join chat conversations with requesters by raising the help flag. 
Agents can open the Quick Action menu or enter /help  to request for help. When using the 
help quick action, agents can also type a brief private message explaining what they need help 
with. This way, when a chat manager enters the conversation, they already know what the agent 
needs.

Chat managers can view the conversations with help requested from different views: interactions 
list view, manager dashboard, and lists.

• Interactions list view: Agents can navigate to the interactions list view and add in the help 
requested column to see which conversations agents have requested help in. From here, 
managers can click directly into the interaction record and join the conversation with the agent 
and requester.

• Manager dashboard: With the Workforce Optimization for Customer Service (com.snc.wfo.csm) 
plugin installed, managers can see that the Help requested tile on the manager dashboard 
homepage.
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• Lists: From Conversation Monitoring > Help Requested, managers can view a list of chat 
interactions in which agents have requested help.

To learn more about Workforce Optimization for CSM, see Workforce Optimization for Customer 
Service .

Sending and receiving messages in Private Chat

The agent and chat manager can converse without the requester knowing that they are having 
a conversation. Messages that only seen by the agent and chat manager are private messages. 
The requester does not see private messages. The agent and chat manager can toggle between 
the public and private messages using the Public Chat and Private Chat tabs. The Private 
Chat tab has a yellow background with "Message only visible internally" and private messages 
appear on the yellow background. When someone types in the Private Chat tab, the typing event 
indicator does not display. For example, when the chat manager types in the Private Chat tab, the 
agent's and requester's screen do not display the typing event indicator.

The tab that the agent types on and sends the message from determines whether a message is 
posted privately or publicly. If an agent starts typing a message on the Public Chat tab and then 
switches to the Private Chat tab, the Private Chat tab does not display the message. If the agent 
then goes back to the Public Chat tab, the message is still there. However, agents can see private 
messages regardless of whether they are on the Private Chat tab or the Public Chat tab.
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Public versus Private chat

Example of Public Chat Example of Private Chat
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Example of public and private messages

Joining a chat conversation in Private Chat

The first time a chat manager switches from a private conversation (on the Private Chat tab) to 
a public conversation (on the Public Chat tab), a dialog box displays. The dialog box informs 
the chat manager that they are about to join the public conversation and the requester will be 
notified that the chat manager is joining the conversation. The chat manager can select Yes, I'm 
sure  to join the public conversation or select Cancel  to remain in the private conversation.
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Sharing attachments in Private Chat

If agents send an attachment while on the Private Chat tab, the attachment is sent only to 
the agent and chat manager. Message Sent confirmation messages do not display for private 
message conversations.

Private messages stored in internal chat transcripts

Once the conversation ends, one external transcript and one internal chat transcript are 
generated.

The public chat transcript does not include private messages and is accessible for the requester 
to download if the Download Transcript capability has been enabled.

The private chat transcript is shown on the interaction record by default and does include private 
messages exchanged between agents and managers. Private messages are prefixed with the 
word [PRIVATE] to clearly indicate when a message came through the Private Chat.
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To learn more about downloading the chat transcript, see Chat transcript downloads for 
requesters.

Custom report

Admins can build a custom report to track the number of help requests, see Build a report to 
track the number of help requests  for instructions.

Chat surveys

Display conversational questionnaires to your end users to gather important information from 
them, before and after they chat with a live or virtual agent.

How chat surveys work

Instead of using forms to collect information from your requesters, you can create different 
questionnaires that run in the chat client to capture preliminary user information or post-chat 
feedback. The questions in the following pre-chat survey example ask users to identify their 
service issue and to provide additional details.
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Example pre-chat survey conversation

Survey administrators and administrators use Survey Designer  to:

• Build survey content: Survey Designer provides various controls for defining survey questions. 
The example above shows the choice list control, which displays a list of items that your users 
can choose from. Each survey question has corresponding properties that you can set to 
manage survey behavior. For instance, you can make a survey response mandatory. If you 
make a survey response optional, users can skip the question in the survey. You can also 
configure your survey so that an introductory note starts the survey and an end note displays 
after users finish the survey.

• (Optional) Save certain survey responses as chat context: When defining your survey, you can 
map a particular survey question to a chat context variable so that survey responses are stored 
in the context variable. You can then use these variables to route chats to live agents in certain 
queues, by specifying the chat context variables in routing conditions or to the virtual agent.

After creating the surveys, administrators configure the surveys to run as conversations in the 
chat client. The chat client renders the chat survey as a live chat conversation.

What to do next

Setting up chat surveys involves these main steps:
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1. (Optional) Define chat context.

Configure the chat context variables for storing survey responses using Context 
Variables  in Chat Settings.

2. Create chat surveys

In Survey Designer, build your conversational questionnaires for gathering pre-
chat information and post-chat feedback from your requesters. If you defined chat 
context variables to store certain survey responses, you can map the appropriate 
survey question to the corresponding chat context variable.

3. Define pre-chat survey configurations.

Determine the pre-chat questionnaire to be presented to your requesters based on 
conditions that you apply.

4. Define post-chat survey configurations.

Control the post-chat questionnaire displayed to your requesters to gather 
feedback on their experience with live agents.

5. If using Virtual Agent, define context topic intent configurations.

Use pre-chat survey information to determine the appropriate Virtual Agent 
conversation topic automatically displayed to your requesters, rather than 
prompting them to choose from a list of conversation topics.

The Interaction Related Records list stores the post-survey chat results and creates a related 
record that links the assessment to the live agent (fulfiller).

Chat transcript downloads for requesters

Once a conversation between a requester and a live agent ends, the requester can download a 
transcript of the conversation.

After a conversation between a requester and a live agent ends, the requester’s chat window 
displays a Download  button that enables the requester to download a chat transcript. If the 
requester clicks the Download  button, a .txt file is automatically downloaded from the window 
of the requester’s current web browser. The chat transcript contains only the written text from 
the conversation; attachments and images from the conversation appear as URLs. Even after 
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the requester starts a new chat session, the Download  button from the previous session is still 
available if the requester scrolls up. The chat transcript files are generated at the end of each 
chat session and multiple chat sessions are not combined into one file.

The requester must be configured for chat transcript downloads for the Download  button to 
appear. For information about configuring the download of chat transcripts, see Setting up Agent 
Chat.

Two types of chat transcripts are generated from the conversation: internal and external.

Internal chat transcripts:

• Are available only to the agent and chat supervisor.

• Include any conversations between the requester and virtual agent.

• Include any conversations between the agent and chat supervisor that occurred through 
Agent Whisper.

• Include customer sentiments (if Agent Chat  is configured to display customer sentiments).

The internal transcript field in the interaction table contains all private and public messages and 
is populated as soon as the chat is close completed.

External chat transcripts:

• Are available to the requester.

• Include only conversations between the requester and the live agent.

• Do not include pre- or post-chat survey information.

Profanity Filter  for Agent Chat  overview

The Profanity Filter  for Agent Chat  prevents agents from sending messages to requesters that 
include profane language (also known as forbidden keywords). If an agent is upset and tries to 
send a message with offensive language, the Profanity Filter  prevents the requester from seeing 
the message.

If an agent tries to send a message with profane language, the Profanity Filter  blocks the 
message and flags the forbidden keywords. The Profanity Filter  warns the agent that the 
message contains forbidden keywords and alerts the chat manager to the agent's use of profane 
language.
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When the Profanity Filter  detects forbidden keywords in a message entered by the agent:

• the message containing the forbidden keywords is highlighted in the agent's chat window.

• the agent receives a notification that they have used a forbidden keyword.

• the message with the forbidden keyword is not sent to the requester.

• if the agent has exceeded the number of forbidden keywords in a specified amount of time, a 
message is sent to the chat manager.

• the forbidden keyword is marked in the transcript of the chat conversation.

Notifying the chat manager

You can configure the Profanity Filter  to notify the chat manager if an agent tries to use more 
than the specified number of forbidden keywords over the specified time. The Profanity Filter 
considers all conversations owned by the agent when determining the number of forbidden 
keywords used. If the agent tries to send a message with a forbidden keyword, the chat manager 
receives a notification. If the Manager Workspace or Agent Workspace is the active window, a 
real-time notification displays. If the Manager Workspace or Agent Workspace isn't the active 
window, a notification displays on the summary view in the Workspace notification menu. In the 
incident entry, the chat manager can review the incident and the chat log and privately message 
the agent.

Machine learning-based or keyword-based

The Profanity Filter  uses a machine learning-based model or a keyword-based model to 
determine whether a message includes forbidden keywords. The machine learning-based model 
analyzes keywords and phrases in the context of the agent's entire message before determining 
whether any forbidden keywords in the message should be considered profane. For example, 
the statement "I made a silly mistake" would be considered not profane while "You sound so silly" 
would be considered profane. The machine learning-model is not on each instance individually – 
you cannot change the model directly to account for customized keywords and phrases.
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The keyword-based model compares a message against a list of forbidden keywords to 
determine whether something should be considered profane. You can allow certain keywords or 
phrases even if those keywords are considered profane in a generic sense. Common examples 
are book or movie titles that might contain forbidden keywords and but should still be allowed 
in a conversation. Conversely you can configure the Profanity Filter  to block certain keywords 
or phrases even if the words may not always seem profane. The Profanity Filter  analyzes each 
message against the list of allowed and forbidden keywords before running it through the model-
based mode.

Example of machine learning-based model

Allowed keyword Forbidden keyword Message to be analyzed System behavior

You are a dummy. Message is blocked.

UNIX for Dummies The reference book 
"UNIX for Dummies" 
might be useful.

Message is allowed.

UNIX for dummies stupid "UNIX for Dummies" is 
a stupid book.

Message is blocked.

foolish I feel so foolish for not 
knowing the answer to 
your question.

Message is blocked.

I feel so foolish for not 
knowing the answer to 
your question.

Message is allowed.

Example of keyword-based model

Allowed keyword Forbidden keyword Message to be analyzed System behavior

dummy You are a dummy. Message is blocked.

You are a dummy. Message is allowed.

Domain separation

The Profanity Filter  works with domain separation. If the domain is set to Global, then the 
keywords apply to both the agent and requester domains. For the agent and requester to see 
each other's domain, the administrator must do one of the following:

• Include the domain where the regular expression should be visible as a child domain to the 
corresponding parent domain.

• Grant necessary access to the appropriate domain if it's a sister domain.

• Set the keywords under a global domain.

Sensitive Data Handler

During an Agent Chat  or Virtual Agent  conversation, the agent or requester may accidentally 
enter sensitive data. The Sensitive Data Handler detects and masks the sensitive data so it is not 
viewed by the agent or requester. The Sensitive Data Handler can also collect sensitive data as 
part of a business process, such as user authentication.

Possible situations when the Sensitive Data Handler might detect and mask sensitive data 
include:
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• A requester enters sensitive data, such as a social security number, during a conversation with 
a live agent or virtual agent.

• An agent enters company information, such as a manager's confidential email address, that 
the requester should not have access to.

• A requester enters sensitive data in a pre-chat or post-chat survey.

The Sensitive Data Handler detects and masks sensitive data when the requester is conversing 
through the web client, mobile (iOS/Android), or any of the supported adapter channels (SMS/
Slack/Teams/Workplace).

You can configure the following:
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• Regular expressions for each type of sensitive data (for example, social security number or 
credit card number).

• Whether sensitive data handling works only for inbound (from requester) messages, outbound 
(from live agent) messages, or both.

• Messages that displays to the requester or agent informing them that sensitive data has been 
masked.

If the requester sends a message containing sensitive data to an agent, a system message is 
sent to the requester and agent notifying both that the message contained sensitive data. The 
sensitive data is masked on the transcript and marked as sensitive on the internal transcript.

If an agent tries to send a message containing sensitive data to a requester, the message is not 
sent to the requester. Instead, an error is displayed to the agent and the message is tagged as 
sensitive in the internal transcript.

The Sensitive Data Handler can be configured to pass user authentication information to another 
entity. The requester might provide sensitive data during a conversation to prove their identity 
(for example, social security number, date or birth, email address).

The Sensitive Data Handler plugin [com.glide.sensitive_data_handling] can be installed by itself, 
without a Glide Virtual Agent  or Agent Chat  plugin. Regular expressions can be added, edited, 
and deleted from the Sensitive Data Handling module.

Regular Expressions

The base system of the Sensitive Data Handler comes with pre-defined regular expressions for 
credit/debit card numbers, social security numbers, and email addresses. When the Sensitive 
Data Handler detects a regular expression, it uses the defined masking pattern to mask sensitive 
data. To define your own regular expressions and patterns to mask other sensitive data, see 
Configuring Sensitive Data Handler. If a regular expression is not properly configured, the system 
may get stuck while attempting to match the regular expression with the message. To prevent the 
system from getting stuck, the system times out after one second.

Pre-defined Regular Expressions

Name Regular expression Details

Credit Card - Visa \b4[0-9]{12}(?:[0-9]{3})?\b • Card number starts with 4.

• New card number has 16 
digits, old card number has 
13 digits.

Credit Card - American 
Express

\b3[47][0-9]{13}\b • Card number starts with 34 
or 37.

• Card number has 15 digits.

Credit Card - Mastercard \b(?:5[1-5][0-9]{2}|222[1-9]|
22[3-9][0-9]|2[3-6][0-9]{2}|
27[01][0-9]|2720)[0-9]{12}\b

• Card number starts with a 
number between 51-55 or 
2221-2720.

• Card number has 16 digits.
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Pre-defined Regular Expressions  (continued)

Name Regular expression Details

Credit Card - Diners Club \b3(?:0[0-5]|[68][0-9])[0-9]
{11}\b

• Card number starts with 36, 
38, or 300-305.

• Card number has 14 digits.

• Cards that start with 5 
and have 16 digits should 
be processed like a 
MasterCard.

Credit Card - Discover \b6(?:011|5[0-9]{2})[0-9]{12}\b • Card number starts with 65 
or 6011.

• Card number has 16 digits.

Social security number \b(?!666|000|9\d{2})\d{3}-(?!
00)\d{2}-(?!0{4})\d{4}\b

• First 3 digits cannot be 000, 
666, or 900-999.

• Hyphen (-)

• Middle 2 digits should be 
01-99 and cannot be 00.

• Hyphen (-)

• Last 4 digits should be 
0001-9999 and cannot be 
0000.

Email \b[\w! $%&'*+/=?`{|}~^-]+(?:\.
[\w! $%&'*+/=?`{|}~^-]+)*@(?:
[a-zA-Z0-9-]+\.)+[a-zA-Z]
{2,6}\b

• Word

• Period (.)

• Word

• @ symbol

• String of alphanumeric 
characters at least one 
character long.

• Period (.)

• Alphabetical string 2-6 
characters long.

Dynamic Translation for Agent Chat  overview

Dynamic Translation for Agent Chat  (DTAC) translates chat conversations from one language to 
another. This translating enables agents and requesters to have chat conversations with each 
other without the need of a shared language.

Dynamic translation for Agent Chat overview video
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For example, a requester who speaks only French starts a chat conversation with a live agent 
who speaks only English. From the requester’s view, the entire conversation is conducted in 
French, while from the agent’s view, the entire conversation is conducted in English.

DTAC  enables cross-locale support teams and merger and acquisition projects to save time and 
money by handling larger volumes of chat conversations from other regions.

Note: 

• DTAC  is supported on Agent Workspace, not on Connect Support.

• DTAC  is currently not supported when autopilot is in progress. When the requester 
responds to prompts from autopilot topics, these responses are not translated for the 
agent, even if DTAC  is turned on for that conversation. See Conversation Autopilot  for 
more information.

How DTAC  works

DTAC  uses Dynamic translation  and a translation service provider to translate chat 
conversations in real time. Available translation service providers include:

• Set up Google cloud translator service spoke

• IBM Translator Service

• Microsoft Azure Translator Service spoke

Mobile clients

DTAC  is available for requesters on Agent Chat in mobile for iOS  and Android.

Language limitations

Even though the corresponding I18N plugins are activated, DTAC  does not support the following 
language translations:

• Brazilian Portuguese

• Canadian French

Translation support limited to one language

DTAC  can only support translation from one language to another therefore additional agents or 
managers joining chat sessions should speak the same language as the primary agent.

• Agent chat transfers – Agents transferring a chat conversation should both speak the same 
language.

• Managers joining chat conversation – Managers joining chat conversation to monitor or assist 
agents should speak the same language as the primary agent.

Agent presence states

DTAC  does not translate agent presence states.

Attachments within DTAC

When inserting an attachment into a chat, DTAC  does not translate the file name or the contents 
of the attachment.
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Agent-Initiated Messaging Interface

Enable agents to initiate conversations with customers on a messaging app of customers' choice 
by using the ServiceNow®  Agent-Initiated Messaging Interface  application.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Overview

The Agent-Initiated Messaging Interface  application supports agent-initiated conversations for 
any type of messaging channels such as SMS.

Note: 
The messaging channels are available based on the application associated with the 
service channel you install. For more information, see Service channels.

By default, the application is configured for the Conversational SMS service channel in the CSM 
Configurable Workspace. For more information, see Conversational SMS service channel  and 
Initiate messaging conversations from the CSM Configurable Workspace .

Configuring Agent Chat

Configure Agent Chat  to enable customers to ask questions and receive information by chatting 
with a live agent.

Review these sections on configuring Agent Chat  features.

Setting up Agent Chat

Configure Agent Chat  to enable live agents to chat with customers and manage various 
conversation features for agents and end users. Through Agent Chat, agents interact with end 
users, create incident or case records, or transfer chats to another agent or queue.

Before you begin
Configure the following before starting this task:

• Install the Agent Chat  plugin (com.glide.interaction.awa).

• If you want to use the Profanity Filter, activate the Profanity Filter plugin (sn_va_profanity).

• In Advanced Work Assignment:

◦ Configure service channels.

◦ Define work item queues.

◦ Set up work assignments.

• Update your Live Feed profile  to display agent names and avatars in the chat client.

• Configure Agent Chat in Service Portal

Role required: workspace_admin

Note: 
You must be in the global view to edit the settings.

About this task
Use Agent Chat  settings to do the following:
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• Activate or deactivate:

◦ Agent Chat  (enabled by default).

◦ Display of agent names and avatars the chat window.

◦ Display of the agent name in the header.

◦ Chat transcript downloads.

◦ Display of estimated wait time for live chat support (transfer from the virtual agent to a live 
agent).

◦ Agent Whisper, which enables supervisors to message agents privately when agents are 
interacting with an end user. For new instances, Agent Whisper  is enabled by default.

◦ Emojis.

◦ Conversation history.

◦ Conversational autopilot client system messages.

• Set the system messages that are displayed when a live agent transfer occurs.

• Manage Quick Action controls.

Procedure

1. Navigate to All  > Conversational Interfaces  > Home.

2. Select the Agent Chat  tile.
The Agent Chat  settings screen titled "Customize how your users chat with live agents" 
appears.

Note: 
Agent Chat  is automatically activated when the Agent Chat  plugin is installed. If you're 
not using Agent Chat, slide the toggle switch to deactivate it and select Save.

3. Activate Agent Chat  by enabling the Activate  option.

4. Configure the options.

User chat settings

Field Description

Agent names and avatars
Slide the toggle switch to activate or deactivate the 
display of the agent names and avatars in the Agent Chat 
client when a live agent enters, transfers, or exits a chat. 
Agents set their names and pictures in their Live Feed 
profiles.

◦ If activated, the Agent name in header  is automatically 
activated and displays the agent name at the top of the 
chat client.

◦ If deactivated, agent identities remain anonymous. No 
names or avatars are displayed in the chat window.

Agent name in header
Slide the toggle switch to activate or deactivate the 
display of the agent name in the header of the chat 
window. This option is active by default.
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Field Description

This field appears if Agent names and avatars  is active.

Transcripts Slide the toggle switch to activate or deactivate the 
ability for requesters to download a transcript of the 
conversation they had with an agent.

Chat statuses and messages

Field Description

Live chat wait status
Select whether to display the estimated wait time for 
live agent support in the chat menu for web clients. If 
you're using the Conversational Integration with Microsoft 
Teams, the wait time displays in a card that shows the 
approximate wait time to chat with an agent.

◦ The wait time is the estimated time, in minutes, for the 
transfer from the virtual agent to a live agent.

◦ The wait time updates once per minute. Wait time is 
based on the Queue Average Wait Time minus the 
waiting time.

Agent Transfer Message
Enter the message that users see when they are 
transferred to a live agent or another queue. For example: 
"Please stand by while I connect you to a live agent."

Note: 
You can define only one transfer message and it is 
displayed for all queues in your instance. The Agent 
Transfer message does not support HTML, only 
plain text.

"No agent available" message
Enter the message that users see when a live agent is not 
available. For example: "No agents are available at the 
moment. Please try again later."

Note: 
You can define only one agent availability message 
and it is displayed for all queues in your instance.

Agent chat features

Field Description

Agent Whisper
Slide the toggle switch to activate or deactivate Agent 
Whisper, which enables supervisors to message agents 
privately when agents are interacting with a requester.

Note: 
If you deactivate Agent Whisper, you must manually 
deactivate the /help quick action.
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Field Description

Emojis
Slide the toggle switch to activate or deactivate emojis.

Conversation Autopilot
Slide the toggle switch to activate or deactivate 
notifications related to Conversation Autopilot, which 
enables agents to use autopilot quick actions to invoke 
Virtual Agent  topics.

Dynamic language translation Slide the toggle switch to activate or deactivate the 
dynamic translation of end user's messages.

Profanity detection
Select View all  to display the Profanity Filter settings 
screen. This option only displays if the Profanity Filter 
plugin has been installed. For more information, see 
Configuring the Profanity Filter settings.

Conversation History
Select View all  to display the Conversation History 
screen.

Set maximum number of past conversation to display in 
the conversation window and apply filters to only show 
what is most relevant to agents based on channel type, 
assignment group, and more.

For details on configuring the Conversation History 
options, see Setting up conversation history.

Quick action configurations

Field Description

Quick action configurations
Select View all  to display the Quick Action Toolbar 
Controls screen.

For details on configuring the toolbar controls, see 
Setting up quick action toolbar controls.

5. Select Save.

Configuring Agent-Initiated Messaging Interface

Set up the Agent-Initiated Messaging Interface  application to enable agents to send messages to 
customers through different messaging channels.

Agent-Initiated Messaging Interface  configuration tasks

Task Description

1. Install agent-initiated messaging 
interface.

Install the Agent-Initiated Messaging Interface 
application to integrate a messaging channel with 
your ServiceNow  instance.
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Agent-Initiated Messaging Interface  configuration tasks  (continued)

Task Description

2. Set up agent-initiated message 
interface for a messaging channel.

Set up the Agent-Initiated Messaging Interface 
application to send messages from a messaging 
channel.

3. (Optional) Associate user profiles 
with agent-initiated messages.

Use scripted extension points to call custom scripts 
for associating user profiles with agent-initiated 
messages.

4. (Optional) Validate recipient IDs 
for agent-initiated messagesValidate 
recipient IDs for agent-initiated 
messages .

Use scripted extension points to call custom scripts 
for validating the format of a recipient ID associated 
with a messaging channel.

5. (Optional) Determine whether 
messaging channels are available for 
agent-initiated messages.

Use scripted extension points to call custom scripts 
for determining whether a messaging channel is 
applicable to a user profile in an agent-initiated 
message.

Install Agent-Initiated Messaging Interface

You can install the Agent-Initiated Messaging Interface  application (sn_agent_initiated) if you 
have the admin role. The application installs related ServiceNow®  Store  applications and plugins 
if they are not already installed.

Before you begin

• Ensure that the application and all of its associated ServiceNow Store  applications have valid 
ServiceNow  entitlements. For more information, see Get entitlement for a ServiceNow  product 
or application .

Role required: admin

About this task
The following items are installed with Agent-Initiated Messaging Interface:

• Plugins

• Store applications

• Tables

For more information, see Components installed with Agent-initiated messaging interface.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the Agent-Initiated Messaging Interface  application (sn_agent_initiated) using the filter 
criteria and search bar.

You can search for the application by its name or ID. If you cannot find the application, you 
might have to request it from the ServiceNow Store.

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released 
apps, see the ServiceNow Store  version history release notes .

3. In the Application installation dialog box, review the application dependencies.
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Dependent plugins and applications are listed if they will be installed, are currently installed, or 
need to be installed. If any plugins or applications need to be installed, you must install them 
before you can install Agent-Initiated Messaging Interface.

4. Optional:  If demo data is available and you want to install it, select the Load demo data  check 
box.
Demo data comprises the sample records that describe application features for the common 
use cases. Load the demo data when you first install the application on a development or test 
instance.

Important: 
If you don't load the demo data during installation, it's unavailable to load later.

5. Select Install.

Set up Agent-Initiated Messaging Interface  for a messaging channel

Set up the Agent-Initiated Messaging Interface  application to send messages from a messaging 
channel.

Before you begin

• Install agent-initiated messaging interface.

• Review the list of messaging channels available for the Agent-Initiated Messaging Interface 
application.

• Set the application scope to the application associated with the messaging channel using the 
application picker. For more information, see Application picker .

For example, for using the SMS messaging channel, set the application scope to the 
Conversational SMS service channel  application.

Role required: admin

About this task
A messaging channel is available when you install the application associated with a service 
channel.
For example, use the SMS messaging channel to send an SMS message to a customer. The 
SMS messaging channel is available when you have installed the Conversational SMS service 
channel  application.

Procedure

1. In the navigation filter, enter sn_agent_initiated_msg_config.list.

2. In the Agent initiated messaging configurations list, modify an existing configuration or create 
another configuration for a messaging channel.

◦ To modify an existing configuration, in the Active  column, click the value link corresponding 
to the messaging channel displayed in the Channel  column.

For example, to send messages by using the SMS messaging channel, click the link in the 
Active  column corresponding to the SMS  channel.

◦ To create another configuration for a messaging channel, click New  in the Agent initiated 
messaging configurations list.

3. On the form, fill in the fields.
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Agent initiated messaging configuration form

Field Description

Channel Messaging channel using which agents can initiate messages to connect with 
requesters.

Check 
if active 
recipient 
profile 
exists

Option to ensure that an active channel user profile exists when sending 
messages to the user from the channel.

If there are no active channel user profiles, the associated channel is not 
available for agent-initiated messages. In this case, the channel does not 
appear in the Channel  field of the Compose Message form. For information on 
the Compose Message form available in CSM Configurable Workspace, see 
Initiate messaging conversations from CSM Configurable Workspace .

Show 
option 
to enter 
recipient 
ID 
manually

Option to display the field to manually enter recipient ID.

For example, select this check box to enable agents to enter a phone number 
manually for sending an SMS message to a consumer.

Application Scope of the application that contains the channel. This field is automatically 
set based on the application scope selected in the application picker.

Active Option to activate the use of the channel for agent-initiated messages.

Order Order number for each channel in which they appear for agent on the Compose 
Message form when composing messages. The channel that has the lowest 
order number is displayed first.

For information on the Compose Message form available in CSM Configurable 
Workspace, see Initiate messaging conversations from CSM Configurable 
Workspace .

4. Save the configuration setting.

◦ If you created a new configuration setting, click Submit.

◦ If you modified an existing configuration setting, click Update.

Associate user profiles with agent-initiated messages

Use scripted extension points to call custom scripts for associating user profiles with agent-
initiated messages.

Before you begin
Install the Agent-Initiated Messaging Interface  application. For more information, see Install 
agent-initiated messaging interface.

Role required: admin

About this task
An agent can compose messages from an interaction of type other than Message in the CSM 
Configurable Workspace. By default, the AgentMessagingInteractionUserDocument 
script include is available for retrieving user profiles associated with consumers and customer 
contacts in an interaction record.
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By using extension points, you can easily integrate customizations without having to alter the 
base code. You can extend standard base functionality using customized scripts. For more 
information, see Using extension points to extend application functionality .

Procedure

1. Navigate to All  > System Extension Points  > Scripted Extension Points.

2. In the API Name  column, search for and select 
sn_agent_initiated.AgentInitiatedMessagingUserDocument.

3. On the Extension Point form, either modify a script include to use the 
sn_agent_initiated.AgentInitiatedMessagingUserDocument  extension 
point or create and register a custom script include.

◦ Create and register a custom script include.

◦ Modify the existing script include by going to the Implementations related list and selecting 
a script include in the Class  column.

Note: 
By default, the AgentMessagingInteractionUserDocument  script include 
that use the 
sn_agent_initiated.AgentInitiatedMessagingUserDocument 
extension point is available for the Agent-Initiated Messaging Interface  application. 
This script include is configured to retrieve user profiles associated with consumers 
and customer contacts from the Interaction [interaction] table record.

4. Associate user profiles for an agent-initiated messages by adding the 
sn_agent_initiated.AgentInitiatedMessagingUserDocument  extension 
point to the script include.
You can create multiple implementations for an extension point and provide an order number 
for each implementation. The implementation that has the lowest order number is executed 
first.

Customization Implementation

Associate a 
table record 
from which 
the message 
was initiated

Include the isValidForTableRecord  method in the 
sn_agent_initiated.AgentInitiatedMessagingUserDocument 
extension point.

Retrieve the 
user details 
associated 
with the 
table record 
from which 
the message 
was initiated

Include the getUserDocument  method in the 
sn_agent_initiated.AgentInitiatedMessagingUserDocument 
extension point.

Note: 
Based on the table record set in the isValidForTableRecord  method, the user 
details are retrieved for sending agent-initiated messages in the getUserDocument 
method.

5. On the Extension Point form, click Update.
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Validate recipient IDs for agent-initiated messages

Use scripted extension points to call custom scripts for validating the format of a recipient ID 
associated with a messaging channel.

Before you begin
Install the Agent-Initiated Messaging Interface  application. For more information, see Install 
agent-initiated messaging interface.

Role required: admin

About this task
By using extension points, you can easily integrate customizations without having to alter the 
base code. You can extend standard base functionality using customized scripts. For more 
information, see Using extension points to extend application functionality .

Procedure

1. Navigate to All  > System Extension Points  > Scripted Extension Points.

2. In the API Name  column, search for and select global.ChannelSendToValidation.

3. On the Extension Point form, either modify a script include to use the 
global.ChannelSendToValidation  extension point or create and register a custom 
script include.

◦ Create and register a custom script include.

◦ Modify the existing script include by going to the Implementations related list and selecting 
a script include in the Class  column.

Note: 
The PhoneNumberValidationExtPointImpl  script include that use the 
global.ChannelSendToValidation  extension point is available for validating 
recipient IDs profiles associated with the Conversational SMS service channel 
application.

4. Associate user profiles for an agent-initiated messages by adding the 
global.ChannelSendToValidation  extension point to the script include.
You can create multiple implementations for an extension point and provide an order number 
for each implementation. The implementation that has the lowest order number is executed 
first.

Customization Implementation

Associate 
a channel 
ID for which 
the message 
was initiated

Include the isValid  method in the 
global.ChannelSendToValidation  extension point.

Retrieve the 
recipient ID 
associated 
with the 
channel for 
which the 
message 
was initiated

Include the channelSendToValidation  method in the 
sn_agent_initiated.AgentInitiatedMessagingUserDocument 
extension point.
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Note: 
Based on the channel ID set in the isValid  method, the recipient details are retrieved 
for validating a recipient ID in the channelSendToValidation  method.

5. On the Extension Point form, click Update.

Determine whether messaging channels are available for agent-initiated messages

Use scripted extension points to call custom scripts for determining whether a messaging 
channel is applicable to a user profile in an agent-initiated message.

Before you begin
Install the Agent-Initiated Messaging Interface  application. For more information, see Install 
agent-initiated messaging interface.

Role required: admin

About this task
By using extension points, you can easily integrate customizations without having to alter the 
base code. You can extend standard base functionality using customized scripts. For more 
information, see Using extension points to extend application functionality .

Procedure

1. Navigate to All  > System Extension Points  > Scripted Extension Points.

2. In the API Name  column, search for and select 
sn_agent_initiated.ChannelsQualifyingFoAgentMessaging.

3. On the Extension Point form, create and register a custom script include.

4. Determine whether a messaging channel is applicable to 
a user profile in an agent-initiated message by adding the 
sn_agent_initiated.ChannelsQualifyingForAgentMessaging  extension 
point to the script include.
You can create multiple implementations for an extension point and provide an order number 
for each implementation. The implementation that has the lowest order number is executed 
first.

Customization Implementation

Associate a 
messaging 
channel ID 
for agent-
initiated 
messages 
with the 
custom 
script

Include the isValidForChannel  method in the 
sn_agent_initiated.ChannelsQualifyingForAgentMessaging 
extension point.

Check 
whether a 
user qualifies 
for the 
messaging 
channel 
for agent-

Include the isChannelValidForAgentInitiatedMessaging  method 
in the 
sn_agent_initiated.ChannelsQualifyingForAgentMessaging 
extension point.
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Customization Implementation

initiated 
messages

Note: 
Based on the messaging channel ID set in the isValidForChannel 
method, the users are evaluated for sending agent-initiated messages in the 
isChannelValidForAgentInitiatedMessaging  method.

5. On the Extension Point form, click Update.

Components installed with Agent-Initiated Messaging Interface

Several types of components are installed with installation of the Agent-Initiated Messaging 
Interface  application, including tables, plugins, and ServiceNow Store  applications.

Note: 
The Application Files table lists the components that are installed with this application. 
For instructions on how to access this table, see Find components installed with an 
application .

Tables installed

Table Description

Agent initiated 
messaging configuration 
[sn_agent_initiated_msg_config]

Extends the application file. Base table for all service 
channel configurations for composing agent-initiated 
messages.

Plugins installed

Plugin Description

Conversational Messaging 
(com.glide.messaging.awa

Enables messaging actions that are performed when 
an event occurs.

ServiceNow Store  applications installed

Application Description

Agent Messaging 
Component

Contains UI components for composing agent-initiated 
messages.

Messaging channels for Agent-Initiated Messaging Interface

Install and configure applications to enable a messaging channel for use with the Agent-Initiated 
Messaging Interface  application.

The following table describes the messaging channels available for use with the Agent-Initiated 
Messaging Interface  application and applications required for using those messaging channels.
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Messaging channels for Agent-Initiated Messaging Interface

Channel Required applications

SMS • Conversational SMS service channel

• Twilio spoke

• Conversational SMS Integration with Twilio

Note: 
The Conversational SMS Integration with Twilio  application installs the 
Conversational SMS service channel  and Twilio spoke  applications, if not 
already installed.

Associating user profiles on messaging interactions

Use extension points to call custom scripts.

Before you begin
Role required: admin

About this task
When a requester sends a message, the system checks if there is an existing user profile that 
has a matching identifier (such as a phone number) and channel details. If there is a matching 
user, then the system will populate the interaction record with the identifier, channel details, and 
the user profile in the Opened for field. If there is no user profile that matches the identifier and 
channel, then the system creates a channel user profile.

Procedure

1. Navigate to All  > System Extension Points  > Scripted Extension Points.

2. Click the desired extension point to view the record details.
You can create multiple implementations for each extension point and assign an order 
number for each implementation. The implementation that has the lowest ordered applicable 
implementation is executed first.

Extension point Description

global.ChannelUserProfileExtPoint Use channel_user_id to find record 
to channel_user_profile user_table/
user_document

global.InteractionChannelUserProfileExtPoint Defines how users are synchronized between 
the interaction and channel_user_profile 
tables

global.AgentInitiatedConversationUtil Get From and To options to show in UI for 
agent initiated conversations

Controlling idle live chat sessions

Configure how active chat sessions are handled by the system when live chats become idle.

By default, the system automatically checks live chat sessions every two minutes through the 
Idle Chat Timer Task scheduled job to ensure that chat sessions are still active. If the requester 
does not respond within 180 seconds (three minutes) during an active chat session, the session 
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becomes idle. The user receives a reminder message that the conversation is timing out and 
asks if they are still there. If they don't respond, the system automatically cancels (times out) the 
chat session 360 seconds (six minutes) after the requester's last response.

You can change the idle chat reminder message and the default time after which the system 
displays the reminder message and closes an idle chat.

Important: 

Idle live chats are not available for Connect Support. Starting with the Paris release, 
Connect Support no longer receives enhancements or non-priority bug fixes. Consider 
moving to ServiceNow®  Advanced Work Assignment  and Agent Chat  in workspace to 
automatically assign chat requests and other work items to agents. For details, see Move 
from Connect Support to Advanced Work Assignment and Agent Chat.

Change the idle chat reminder message

The default idle chat reminder message displayed to requesters is: The conversation is 
timing out, are you still there?  Agents receive the message: User response 
will indicate if they want to continue the chat.

You can modify the default message sent to requesters by updating the 
com.glide.cs.idle_chat_reminder_message  property.

1. As admin, navigate to All, and then enter sys_properties.list  in the filter.

2. Open the com.glide.cs.idle_chat_reminder_message  property.

3. In the Value  field, enter the new reminder message to be displayed.

4. Select Update.

Change the idle chat timeout values

Add the com.glide.cs.idle_chat_reminder_timeout  and the 
com.glide.cs.idle_chat_cancel_timeout  properties to the System Property 
[sys_properties] table to set the chat reminder message timeout and the idle chat cancel timeout 
values. Create both properties at the same time.

1. As admin, navigate to All, and then enter sys_properties.list  in the filter.

2. Select New  to add the com.glide.cs.idle_chat_reminder_timeout  property.

a. On the form, fill in the fields.

Field Value

Name System property name. Enter: 
com.glide.cs.idle_chat_reminder_timeout

Description Explanation for this property. For example: Idle chat 
reminder timeout (in seconds)

Type Data type. Select integer.

Value Enter the number of seconds before the idle chat reminder 
message is displayed, after the requester's last response. 
This value must be equal to or greater than 120 seconds, 
since the Idle Chat Timer Task job runs every 120 seconds 
to check active chat sessions.
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Field Value

For example, if the idle chat reminder message is to be 
displayed 5 minutes after the requester's last response, 
enter 300 seconds.

Note: 
If you want to set an idle chat message reminder 
timeout that is under 120 seconds, you must also 
change the time at which the Idle Chat Timer Task 
job runs. The job must check for idle chats within 
a shorter time frame. For example, if the reminder 
message timeout is 60 seconds after the requester's 
last response, set the Idle Chat Timer Task job to run 
every 60 seconds. For more information on base 
system scheduled jobs, see System scheduler .

b. Select Submit.

3. In the System Properties table, select New  to add the 
com.glide.cs.idle_chat_cancel_timeout  property.

a. On the form, fill in the fields.

Field Value

Name System property name. Enter: 
com.glide.cs.idle_chat_cancel_timeout

Description Explanation for this property. For example: Idle chat 
cancel timeout (in seconds)

Type Data type. Select integer.

Value Number of seconds before an idle chat is canceled 
(times out). This value must be larger than 
com.glide.cs.idle_chat_reminder_timeout, 
where the difference between this value and 
com.glide.cs.idle_chat_reminder_timeout 
is larger than or equal to 120 seconds (2 minutes, which is 
when the Idle Chat Timer Task job runs).

For example, if the reminder message timeout value is 300 
seconds (5 minutes), the idle chat cancel timeout value 
must be 420 seconds or greater.

Note: 
If you changed the Idle Chat Timer Task job, the 
difference between the chat cancel timeout value and 
the idle chat reminder timeout must be larger or equal 
to the Idle Chat Timer Task job time. For example, 
if the reminder timeout is 60 seconds and the Idle 
Chat Timer Task job is also 60 seconds, the idle chat 
cancel timeout value must be 120 seconds or greater.

b. Select Submit.
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Set the inactivity timeout behavior

The com.glide.cs.start_idle_timeout_after_agent_response  property 
determines the timeout behavior when inactivity is triggered. When this property is true, the 
inactivity timer does not start until the agent sends a non-automated response to the requester.

1. As admin, navigate to All, and then enter sys_properties.list  in the filter.

2. Select New  to add the 
com.glide.cs.start_idle_timeout_after_agent_response  property.

a. On the form, fill in the fields.

Field Value

Name System property name. Enter: 
com.glide.cs.start_idle_timeout_after_agent_response

Description Explanation for this property. For example: Timeout 
behavior when inactivity should be 
triggered.

Type Data type. Select true/false.

Value Either true  or false.

b. Select Submit.

Set the server disconnect timeout for guest conversations

The com.glide.cs.chat_disconnect_timeout  property determines how long 
the system will wait to reconnect a disconnected conversation before it ends the chat. If 
communication is reestablished during that timeframe, the conversation resumes.

1. As admin, navigate to All, and then enter sys_properties.list  in the filter.

2. Select New  to add the com.glide.cs.chat_disconnect_timeout  property.

a. On the form, fill in the fields.

Field Value

Name System property name. Enter: 
com.glide.cs.chat_disconnect_timeout

Description Explanation for this property. For example: Timeout 
behavior for disconnected guest 
conversations.

Type Data type. Select integer.

Value Number of seconds before a disconnected guest chat is 
canceled (times out). The client will try to reconnect during 
that time.

b. Select Submit.
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Examples

These examples show how the 
com.glide.cs.start_idle_timeout_after_agent_response  system setting may 
affect how the system handles idle chats. In the following examples, the inactivity timeout is set 
to 60 seconds and the inactivity reminder is set to 30 seconds.

Example 1: In this example, 
com.glide.cs.start_idle_timeout_after_agent_response  does not affect how 
the system handles an idle chat.

1. Agent enters the chat.

2. System sends automated message Thank you for contacting support. I am 
looking into your question now and will be with you shortly.

3. Agent sends the message What can I help you with today?

4. If the requester does not respond after 30 seconds, then the system sends the message The 
conversation is timing out, are you still there?

5. If the requester does not respond within 60 seconds after the agent's message, then the 
system sends the message It seems you have left the conversation  and 
ends the chat.

Example 2: In this example, 
com.glide.cs.start_idle_timeout_after_agent_response  affects how the 
system handles an idle chat.

1. Agent enters the chat.

2. System sends automated message Thank you for contacting support. I am 
looking into your question now and will be with you shortly.

3. If the agent does NOT send a message, one of the following occurs:

◦ If com.glide.cs.start_idle_timeout_after_agent_response  is not set or is 
set to false, then

a. The system starts the inactivity timer.

b. If the requester does not respond after 30 seconds, then the system sends the message 
The conversation is timing out, are you still there?

c. If the requester does not respond within 60 seconds after the automated message, then 
the system sends the message It seems you have left the conversation 
and ends the chat.

◦ If com.glide.cs.start_idle_timeout_after_agent_response  is set to true, 
the system does not start the inactivity timer and the chat will not time out.

Controlling the browser experience for chat guest sessions

Anonymous users (unauthenticated guests) can chat with support agents in the web chat client, 
without logging in to a service portal. Admins can control certain aspects of the conversational 
experience for unauthenticated guest users, such as enabling resumable chat sessions after a 
browser refresh.

When guest users refresh the browser window while chatting with an agent, the refresh 
automatically starts a new conversation and chat session. By default, the ongoing conversation 
and chat session history are not retained.

You can change the default guest session behavior to let your guest users resume an ongoing 
conversation and see the chat session history after a browser refresh. You can also set the 
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duration of the guest chat session user cookie, to let guest users resume chat sessions after they 
close and reopen their browser.

Enable resumable guest sessions

As admin, use the com.glide.cs.guest_session_resumable  system property to the 
change the default chat guest session behavior for guest users.

1. Navigate to All, and in the Filter enter sys_properties.list.

2. Open the com.glide.cs.guest_session_resumable  property.

3. In the Value  field, enter true  to enable resumable guest chat sessions and retain the chat 
session history.

4. Select Update.

After a browser refresh, your guest users can continue their conversations with agents and see 
the chat session history in the chat panel.

Change the guest chat session cookie time

The guest chat session cookie time is the length of time (duration), in seconds, of the guest 
session user cookie. Use the com.glide.cs.guest_session_cookie_max_age 
property to change the guest session cookie time, in case your guest users want to resume a 
chat after closing and reopening their browser.

For security reasons, the default property value is -1, which means the guest session cookie is 
immediately deleted when the browser is closed. But you can specify a maximum time length 
that sets the duration of the guest session cookie, for example 900 seconds (15 minutes).

1. As admin, navigate to All, and in the Filter enter sys_properties.list.

2. Open the com.glide.cs.guest_session_cookie_max_age  property.

3. In the Value  field, enter the maximum length of time (seconds) for the guest session cookie.

For example, the value 900  is the duration of the guest session cookie in seconds (15 
minutes), to give your guest users time to resume a chat session after closing and reopening 
the browser.

4. Select Update.

Configuring quick actions

Quick actions are shortcuts that perform Agent Chat  tasks. Agents can work more efficiently 
with customers by using quick actions because they don't have to enter as many characters to 
perform a task.

Activate quick actions

To enable your agents to use quick actions, you must activate the and related plugins for 
Advanced Work Assignment, which is required for chat in Workspace.

Default quick actions

The following quick actions are available by default with Workspace  chat:
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Command 
name

Toolbar 
button

Action Default parameter

autopilot
Starts a Virtual Agent  topic 
(Conversation Autopilot).

Available topics

help
Indicates to the chat supervisor 
that an agent needs help with a 
conversation. To use this quick 
action, new customers must enable 
Agent Chat  and Agent Whisper  and 
update customers must enable 
Agent Whisper  on chat setup.

r Uses Response templates  to insert 
as text in a conversation.

Note: 
Only response templates that 
have a condition of [Type]
[is][Chat]  are available in 
Agent Chat.

Available response templates

search-
kb

Starts a KB article search. The 
agent is prompted to search for 
the relevant KB article. Based on 
the search term the agent enters, 
the agent is able to view the KB 
articles that match the search term. 
The agent can then select the KB 
article.

ta
Transfers the conversation to 
another agent.

Available agents

tq
Transfers the conversation to 
another queue.

Available queues

Creating a quick action

Create a quick action so that agents can use shortcuts for performing actions in Agent Chat.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Quick Actions  > Actions, and then select New.

2. On the form, fill in the fields.
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Field Description

Name Name of the quick action.

Active Option for activating the quick action.

Description Description of the quick action.

Command Name Text that triggers the quick action when entered after the forward slash 
(/) in a conversation.

Applies to
Work item that the quick action is available for. Filter the table that you 
select in the Table  field to qualify a certain kind of work item.

For example, to make the quick action available only for conversations 
that are assigned to Beth Anglin, you would first select the Interaction 
[interaction] table in the Table. Then, in the Applies to  field, you would 
create the following filter: [Assigned to] [is] [Beth Anglin].

Table Work item table that the quick action is available for.

Note: 
Quick actions are supported only in the Interaction [interaction] 
table.

Apply to all groups Option for making the quick action available to all user groups.

Apply to groups List of which groups can use the quick action. This field appears only if 
you clear the Apply to all groups  option.

Script
JavaScript code to control what the quick action does.

In this script, you have access to:

◦ The record  variable, which for Agent Chat  is the Interaction 
[interaction] record

◦ The params  array, if you defined quick action parameters

If provided, all free-form text entered after all the other parameters are 
captured as the last item in the params  array.

Set the value of answer  as follows:

answer = {
                success: <Boolean>,
                message: 
 <success_or_error_message>
};

Note: 
If you do not script a message, the agent receives a default 
message instead.

Application Application scope of the quick action.

Accepts string 
parameter

Option to indicate that the script accepts text input after any defined 
parameters.
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Field Description

Parameter label Parameter name that displays next to the quick action.

Parameter hint text Text that displays as a hint when the agent enters a quick action.

3. Select Submit.

What to do next
If your quick action requires a secondary menu, define a quick action parameter so that agents 
can further control the quick action. For more information, see Define a quick action parameter.

Optionally, you can make the quick action available in Agent Chat  as a button. For more 
information, see Configuring a quick action button.

Defining a quick action parameter

Define a quick action parameter to allow agents to further control a quick action in Workspace 
chat.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Quick Actions  > Parameters, and then click New.

2. On the form, fill in the fields.

Field Description

Name Name of the parameter.

Action Quick action that uses the parameter.

No Matching 
Results Message

Message to agents if no records match the record query. If you do 
not create a No Matching Results Message, a default message is 
provided.

Display value field
Field from the parameter record that appears in Workspace  chat.

This field appears when you select Basic  in the Query mode  field.

Query mode Type of query. You can select Scripted  or Basic. To query records with 
a script, select Scripted. To query records by whichever table that you 
specify in the Table name  field, select Basic.

Table name
Table to query for parameters.

This field appears when you select Basic  in the Query mode  field.

No Results 
Message

Message to agents if there are no available records to query. If you do 
not create a No Results Message, a default message is provided.

Value field
Field from the parameter record that agents can enter in 
Workspace  chat to invoke the parameter item. For example, to 
transfer a conversation to Beth Anglin, an agent would enter /ta 
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Field Description

"beth.anglin". In this case, the User ID  field in the User [sys_user] 
record is the Value field.

This field appears when you select Basic  in the Query mode  field.

Query Script
JavaScript code to determine which records qualify for your parameter.

You are given a query  variable that represents the search query that 
the agent provided. Set the value of the answer  variable as follows:

answer = {
  items: [ { value: <value>, displayValue: 
 <displayValue>} ]
};

The array of items should contain objects with a value  and a 
displayValue.

Note: 
This field shows only if you select Scripted  in the Query mode 
field.

Application Application scope of the parameter.

Order Order that the parameter is available for the quick action.

3. Click Submit.

Configuring a quick action button

Configure a quick action button so that agents can perform actions in Agent Chat  with a single 
click.

Before you begin
Role required: admin

About this task

The toolbar of the Workspace  chat window contains three buttons. Selecting the left button ( ) 

attaches a file in a conversation, selecting the center button ( ) initiates a queue transfer, and 

selecting the right button ( ) initiates an agent transfer. You can't configure the left button, but 
you can assign different quick actions to the center and right buttons.
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Toolbar in the Workspace  chat window

Procedure

1. Navigate to All  > Conversational Interfaces  > Chat Settings  > Agent Chat.

2. In the Agent Experience section, select View all  next to Quick actions.

◦ To configure the arrow button ( ), select Transfer to Queue.

◦ To configure the add user button ( ), select Transfer to Agent.

◦ To create a new button, select New.

3. On the form, fill in the fields.

Field Description

Quick Action Action that is performed when the button is selected.

Name Name of the quick action

Use custom icon Select this if you want to specify what image should be used for the 
icon

Icon Button icon that appears on the toolbar of the Workspace  chat window.

Active Select if you want this quick action to be active.

Application Name of the application for which the icon display on the toolbar.

Order Position of the button on the toolbar. If the value is 100, the button 
appears at the center of the toolbar. If the value is 101, the button 
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Field Description

appears at the right side of the toolbar. You can't change the button 
order.

Available on private 
chat tab

Select this to have the icon display on the Agent Chat toolbar.

Parameter value(s)

Auto-submit

Apply to all groups

4. Save your changes.

◦ To update an existing record, select Update.

◦ To create a new record, select Save.

Setting up quick action toolbar controls

Customize the quick actions that appear on the chat toolbar.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. Select Agent Chat  and then on the Agent Experience card, select View All  next to Quick 
actions.

3. Do one of the following:

◦ To create a quick action workspace action, select New.

◦ To modify a quick action workspace action, select the quick action workspace action record 
you want to update.

4. On the screen, fill in the fields.

Configurable Toolbar Control

Field Definition

Quick Action Quick action performed.

Name Name of the quick actions workspace action.

Use custom icon Option to display a custom, downloaded icon 
in the toolbar.

Icon Image to display on the toolbar when Use 
custom icon  is selected. Select Click to 
add...  and on the Choose an image screen, 
select an image file.

Note: 
Use an image with a square aspect ratio.

Active Indicates whether this configurable toolbar 
control is active.
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Field Definition

Application Application scope of the quick action.

Order Value of this quick action. Quick actions 
are executed from lowest order to highest 
order, so a quick action with an order of 100 is 
considered before a quick action of 200.

Available on private chat tab Option that defines whether the quick action 
is available on the private chat tab.

Applies to
Condition that determines when the quick 
action is available.

◦ Add Filter Condition- Filter the table that 
you select in the Table  field to qualify a 
certain type of work item.

◦ Add "OR" Clause- Add an "or" clause to the 
condition.

For example, to make the quick action 
available only for conversations assigned 
to Beth Anglin, you select the Interaction 
[interaction] table in the Table. Then, in the 
Applies to  field, you create the following filter: 
[Assigned to] [is] [Beth Anglin].

Parameter value(s) Parameters needed for the quick action.

Auto-submit Option for the agent to select a button and 
have the quick action and parameter post to 
the chat.

Apply to all groups Option for making the quick action available 
to all user groups.

5. Select Submit  or Update.

Activating chat context quick actions

Activate context quick actions to enable agents to view context relevant to a chat interaction. 
When launched in a chat, display cards show: sysparm_portal, sysparm_page, table, sys_id, or 
sysparm_language.

Before you begin
Role required: admin

About this task
Context quick actions are a default quick action, but require activation.
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Procedure

1. Navigate to All  > Quick Actions  > Actions.

2. In the Get Chat Context Variables  record, use the list editor to set the Active  value to 

true.

Sending missed chat activity emails

Send email to users with summaries of chat messages sent to them while they were offline.

Before you begin
Role required: virtual_agent_admin

About this task
You can send email summaries to an authenticated user or users who are verified by a live agent.

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. Select the General tab.

3. In the Missed activity emails  card, select View Settings.

4. Enable the Missed activity emails feature by toggling Activate  option.

5. In the Offline threshold drop-down, set the time duration that the user is inactive before 
sending email notification.

◦ 15 minutes (default)

◦ 2 hours

◦ 8 hours

◦ Custom (enter a custom duration of minutes or hours)

6. Select Save.

Result
Email notifications of missed chat messages are automatically sent at the specified time interval.

Configuring Sensitive Data Handler

Detect and mask sensitive information that is shared in Agent Chat  or Virtual Agent 
conversations.

Before you begin
Activate the Sensitive Data Handler plugin (com.glide.sensitive_data_handling).

Role required: admin, virtual_agent_admin
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Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. Under Sensitive data detection, select View all.

3. Slide the Active  toggle switch to enable sensitive data detection.

4. Select the appropriate conversation flow:

a. Requester to agent - detect and mask sensitive data entered by the requester in an Agent 
Chat  conversation.

b. Agent to requester - detect and mask sensitive data entered by the agent in an Agent Chat 
conversation.

c. Requester to Virtual Agent  - detect and mask sensitive data entered by the requester during 
a Virtual Agent  conversation.

Note: 
You must select at least one conversation flow.

5. The Regular Expressions tab displays the existing expressions:

Regular Expressions

Field Description

Name Name of the regular expression.

Regular Expression Pattern that defines the expression.

Number of characters to mask Number of characters in the regular expression that are 
masked.

Start masking from Direction the regular expression is masked: left to right or 
right to left.

Status ◦ Active - this expression is masked.

◦ Inactive - this expression isn't masked.

Order Order in which the active regular expressions are 
analyzed against a message to determine if there are any 
matches.

6. Either select an existing expression to modify or create a new regular expression by selecting 
New  and filling in the fields.

Sensitive Data Regex form

Field Description

Name Name of the regular expression.

Number of characters to mask Number of characters in the regular expression that are 
masked.

Masking symbol Symbol used in place of the sensitive data.

Status ◦ Active - this expression is masked.

◦ Inactive - this expression isn't masked.
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Field Description

Domain Name of the domain that this regular expression affects. If 
you select Global, then the regular expression applies to 
both the agent and requester domains. For the agent and 
requester to see each other's domain, the administrator 
must do one of the following:

◦ Include the domain where the regular expression 
should be visible as a child domain to the 
corresponding parent domain.

◦ Grant necessary access to the appropriate domain if 
it's a sister domain.

◦ Set the regular expression under a global domain.

Regular Expression Pattern that defines the expression. Check your regular 
expression on a regex validation site such as https://
regex101.com/

Order Order in which the active regular expressions are 
analyzed against a message to determine if there are any 
matches.

Start masking from Indicates whether the regular expression is processed 
from left to right or right to left.

7. On the Agent system messages tab, enter information for the message that the agent sees if 
they enter sensitive data:

Agent system messages

Field Description

Description Description of the system message.

Value Exact wording of the system message that displays to the 
agent.

Updated Date and time the message was most recently updated.

Updated by Name of the user who most recently updated the 
message.

8. On the Requester system messages tab, enter information for the message that the requester 
sees if they enter sensitive data:

Requester system messages

Field Description

Description Description of the system message.

Value Exact wording of the system message that displays to the 
requester.

Updated Date and time the message was most recently updated.
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Field Description

Updated by Name of the user who most recently updated the 
message.

9. Select Save.

Configuring Profanity Filter

Configure the Profanity Filter  for Agent Chat  to detect flagged words in the manner that best suits 
your company's needs.

Before you begin
Role required: admin, virtual_agent_admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings  > Chat Settings  > Agent Chat.

2. On the Chat settings card, select View settings  next to Profanity detection.

3. On the Profanity detection page, slide the Active  toggle switch to activate the profanity filter.

4. In the Choose how to detect flagged words card, configure the settings:

Option Description

Use Machine Learning model to 
detect flagged words

Use model-based mode to determine which words 
should be marked as flagged words.

Use list of flagged words if no 
matches are found

Use a keyword-based approach to determine which 
words should be marked as flagged words. The list of 
flagged words can be configured on the Flagged Words 
tab.

Number of messages before 
notifying manager If the number of messages with flagged words that an 

agent has sent is equal to or exceeds this number within 
the time threshold, the Profanity Filter  sends a message 
to the manager.

Time threshold (in hours) Number of hours during which the number of messages 
with flagged words is tracked.

5. On the Flagged Words tab, specify words that the Profanity Filter  should flag:

Flagged words
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Word
Word that the Profanity Filter  should flag.

Keywords
Similar words that the Profanity Filter  should also flag.

Allowed ◦ Forbidden  - the word is considered profane and will be 
flagged.

◦ Allowed  - the word is not considered profane and will 
not be flagged.

Language
Language that the Profanity Filter  applies to.

Status ◦ Active  - if the Profanity Filter  detects this word, it will 
determine whether it is forbidden or allowed.

◦ Inactive  - if the Profanity Filter  detects this word, it will 
not do anything.

6. On the Agent system messages tab, configure the messages that the agent might see:

Agent system messages

Description Description of the system message.

Value Exact wording of the system message that displays to the 
agent.

Updated Date and time the message was most recently updated.

Updated by Name of the user who most recently updated the 
message.

7. On the Manager system messages tab, configure the messages that the manager might see:

Manager system messages

Description Description of the system message.
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Value Exact wording of the system message that displays to the 
manager.

Updated Date and time the message was most recently updated.

Updated by Name of the user who most recently updated the 
message.

Configuring Dynamic Translation for Agent Chat

Activate Dynamic Translation for Agent Chat  (DTAC) so chat conversations can be translated 
from one language to another.

 Dynamic Translation for Agent Chat  Watch this video for more information on global support 
with Dynamic Translation for Agent Chat.

Prerequisite steps

These tasks must be completed prior to activating DTAC:

• Integrate with a translation service provider

• Migrate to version v3 of a translator configuration

• Translate a knowledge article

Activating DTAC

DTAC  translates chat conversations from one language to another. The preferred languages for 
the agent and requester are based on their user profiles and a translation service translates 
the messages into the defined language of the other participant. Translation service providers 
support language detection for requesters who are not logged in to ServiceNow®, also referred 
to as guest users.

DTAC  is inactive by default. Before activating DTAC, the following requirements must be 
completed:

• Dynamic translation

• Set up Agent Chat

• Activate a language

Activate the Dynamic Translation for Agent Chat  plugin 
(com.glide.cs.dynamic.translation.agent.chat).

This also activates these plugins:

• Dynamic Translation  (com.glide.dynamic_translation)

• Conversational Dynamic Translation  (com.glide.dynamic_translation.va_async)

and these system properties:

• true - sync

• false - async

• absence of this property - async
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Transferring from Virtual Agent  to a live agent

Once an agent accepts a chat, they can see the chat history between the Virtual Agent  and 
requester in their preferred language for more context.

Virtual Agent  topics must be set up in the desired languages prior to using DTAC. To learn more 
about how to set up topics, see Virtual Agent Designer.

Translation support in chat conversations

When DTAC  is enabled, these items are translated in chat conversations:

• Users' messages

• System messages

• Virtual Agent  chat history

• Record card field values

• Rich controls

Type Rich Control

User input String

User input Static choice list

User input Reference choice

User input Boolean

User input Date time

User input File picker

User input Carousel

Bot response Text

Bot response Single link

Bot response Multiple links

Bot response Multi-flow output
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Type Rich Control

Bot response Script output

Bot response Record card

DTAC  does not support record card labels. For this functionality to operate, system localization 
properties must be configured. Navigate to System Properties  > System Localization. For more 
information, see ServiceNow®  product documentation on Localization settings.

Analytical reports for DTAC

You can generate a report that counts the number of DTAC  chats, to assess how many 
conversations use the DTAC  option.

Monitor the number of true values in the Translated column in the Interaction table. For more 
information, see the ServiceNow®  product documentation on Interaction records in Workspace
Interaction records in Agent Workspace.

Setting up conversation history

Enable and customize the conversation history options that are available on the conversation 
history screen.

Before you begin
Conversation history provides the capability to easily access historical conversations on the 
same channel. The agent can be more efficient by reviewing those conversations without 
opening multiple tabs and reviewing the transcripts. This page provides options to enable 
conversation history and to configure how many to display and optional filtered view for the 
agents.

Role required: admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. Select Agent Chat  and then on the Agent Experience card, select View Settings  next to 
Conversation History.

3. To turn on conversation history, toggle on the Activate switch.

4. In the Number of conversations to display field, enter the number of previous conversations 
that should display on the screen.
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The maximum number of conversations that can display is 25.

5. To create a conversation history filter, select New.

6. On the Create New Conversation History Filter screen, fill in the fields.

Field Definition

Name Name of the conversation history filter.

Active Select the check box if this filter should be 
applied.

Description Description of the conversation history filter.

Order Order in which the filters should be 
prioritized. The filter with the lowest order 
matching the agent's groups is used to filter 
the interactions.

Apply to all groups Option for making the conversation history 
filter available to all user groups.

7. Select Set conditions  to display the Condition dialog.

8. On the Condition dialog, build a filter for the conversation history.
For more information, see Condition builder .

9. Select Set.

10. On the Create New Conversation History Filter screen, select Submit  or Update.

Using Agent Chat

Agent Chat  enables live agents to have conversations with requesters and for managers to help 
agents and monitor them.

Workspace displays a chat inbox icon ( ) that agents use to enter chats. Agents set their status 
to Available  or Away  to open or close their inbox for chat requests. The icon displays numbers 
when chats are waiting to be answered.

The chat interface is integrated into the workspace so agents can chat while working onscreen 
with all of the other features provided by the workspace.
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The following sections explain how to use Agent Chat.

Using quick actions

Use shortcuts, known as quick actions, for common activities that are performed frequently.

In Agent Chat, an agent can insert a quick action in any of the following ways:

• Enter a command after the forward slash (/).

• Select the lightning bolt icon ( ) and select a quick action from the menu.

• If available, select the quick action button on the toolbar.

For example, an agent can transfer a conversation to another queue by entering /tq  in the 
message input field.
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Initiate a queue transfer by typing

An agent can also initiate a queue transfer by selecting the lightning bolt icon and then selecting 
/tq  from the menu.
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Initiate a queue transfer from the quick action menu

Alternatively, an agent can transfer to another queue by selecting the arrow button ( ) on the 
toolbar.
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Initiate a queue transfer from the toolbar

Note: 
Agents must have the quickactions_user role to use quick actions.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2666



Display chat context details

An agent can view context relevant to a chat interaction. An agent can use a context 
quick action to show a card with context variables: sysparm_portal, sysparm_page, 
table, sys_id, and sysparm_language. The agent can initiate this quick action by 
typing /context  in the message input field.

Parameters

Some quick actions require a secondary menu so that agents can further control the quick 
action. For example, after an agent initiates a queue transfer, the agent must select which queue 
to transfer to. The items that appear on the secondary menu are called parameters.

The following figure shows that, after an agent inserts a quick action to transfer to another queue, 
the agent sees a list of available queues. The default parameters for the quick action are queues 
that are available to agents.
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To create a quick action that requires a secondary menu, you must define parameters for the 
quick action. For more information, see Define a quick action parameter.

Automatically displaying topics with Conversation Autopilot

Agents can use Conversation Autopilot to display Virtual Agent  topics during Agent Chat 
conversations. While the requester interacts with the Virtual Agent  topics, agents can multitask 
and work on other items. Conversation Autopilot is not available for HR Service Delivery  (HRSD).

While talking to a requester in an Agent Chat  conversation, agents can start Conversation 
Autopilot by using autopilot quick actions to invoke Virtual Agent  topics. Depending on the 
information entered by the requester, agents can search for a specific Virtual Agent  topic and 
display it with parameters. The requester views the topic and responds as needed and Virtual 
Agent  captures the requester’s input.

Note: 
For the best experience, enable the Agent Chat setting that turns on system messages 
during autopilot. For details, see Setting up Agent Chat.

Configuring Autopilot

You must have the Glide Virtual Agent  plugin and the Agent Chat  plugin installed to view and 
access the quick action for Autopilot. Admins can setup which Virtual Agent  topics are available 
to agents in Agent Chat.

Note: 
Admins must be able to configure a quick action based on their organization's business 
need and set it up for agents to use as required.

For information on using quick actions in Agent Chat, see Using quick actions.

Using Autopilot

The agent is able to use quick actions to search for and invoke an Autopilot topic of their choice 
during their conversation with a requester. The agent can only select Autopilot topics that 
are relevant to the channel. For example, only topics optimized for SMS are selectable when 
conversing with a requester who is using SMS.
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The agent is informed by system messages when an Autopilot topic has been initiated and 
ended. These messages can be configured by admins.

While Autopilot is on

While Autopilot is on, the requester can use the rich controls for text but agents see a read-only 
version of the rich controls rendered to the requester.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2669



When Autopilot is in use, public chat with the requester is disabled, but agents can contact other 
agents and supervisors for help. If Agent Whisper  is on, the Private Chat tab in Agent Whisper 
functions normally during Autopilot. While Autopilot is in use, the agent's capacity is not freed up 
and messaging actions configured by customers are disabled.

When Autopilot is ended

The agent receives a desktop notification in the Notifications tab in Workspace  stating that 
the Virtual Agent  topic has ended or been completed by the requester. At this point, the agent 
resumes control of the conversation.
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Conveying emotions using emojis

Use emojis in Agent Chat  conversations to convey emotions to requesters. This helps requesters 
feel like they're having a conversation with a friend and builds customer brand loyalty.

Before you begin
Emojis must be enabled before agents can use them in Agent Chat. See Setting up Agent Chat 
for instructions on enabling emojis.

Role required: admin

Procedure

1. While in an active chat, there are several ways to include an emoji:

◦ Select the Insert emoji icon  to display the emoji palette. Then select an emoji from the 
palette or search for an emoji by entering a name in the search bar of the emoji palette.

◦ Enter a colon followed by the first few characters of the emoji name. When the pop-up menu 
of emojis displays, select one.
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◦ Enter a special character combination or short name which is automatically converted into 
an emoji after entering a space or enter.

2. Display the short name of an emoji as a tooltip by positioning the cursor over the emoji.

Conversing in a different language with Dynamic Translation for Agent Chat

Use Dynamic Translation for Agent Chat  (DTAC) to have a chat conversation with a requester who 
uses a different language.

Translation indicators

When DTAC  is enabled, both the agent and the requester will see a banner at the top of the chat 
conversation that indicates the conversation is being translated. Bilingual agents can determine 
if they’re fluent enough in the requester’s language to temporarily turn off DTAC  for individual 
chat sessions as needed.
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Dynamic translations control for bilingual agents

When a bilingual agent accepts a chat conversation to which they’re fluent in the requester’s 
language, DTAC  is not necessary. With the Dynamic translations chat session control, agents can 
turn of DTAC  for individual chat sessions.

Agents can select the ellipsis ( ) at the bottom of the chat window then select the Dynamic 
translations control  to the off position.

When DTAC  is switched off, a notification displays at the top of the agent’s and the requester's 
chat windows, highlighting the change in status, for this chat session.

The translation capability is switched off for both the requester and the agent, for this specific 
chat session. The selection in one chat session does not affect the selection in other chat 
sessions and the agent can turn DTAC  off and back on within one chat session.

Troubleshoot translated messages

Translation services do not understand idioms or jargon and it is possible that some user 
messages are lost in translation. You can use the translation-indicator icon to view the 
requester’s original message and look up its meaning as needed.

You can navigate to the individual chat message and select the translation-indicator icon ( ) to 
see the requester’s original, untranslated message.

Translated chat transcripts

Two chat transcripts are generated at the end of each DTAC  chat session. One for the requester 
to download and save in the requester’s language. The other is the agent’s transcript which 
contains the text as seen in the agent’s chat window. If an agent used DTAC  in part of the chat, 
the transcript contains both the translated and non-translated text. For more information, see 
Chat transcript downloads for requesters.

Chat transferred from Virtual Agent

Once you accept a chat from a requester, you can see the chat history between the Virtual Agent 
and requester in their preferred language for more context.
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Attachments within DTAC

When inserting an attachment into a chat, DTAC  does not translate the file name or the contents 
of the attachment.

Sending an agent-initiated message during an async chat

Send a message to a requester even when the requester isn't online while working on issues 
in Workspace. A long-running conversation between an an agent and a requester who are not 
online concurrently is called an asynchronous, or async, chat.

Before you begin
Role required: admin

Procedure

1. On the Interaction record, select Compose Message.
The Compose message form displays for interactions that aren't Chat or Messaging.

2. On the form, fill in the fields.

Compose Message form

Field Value

Channel Messaging channel with which agents can 
initiate messages to connect with requesters. 
For async chat, select mweb.

From ID of the agent who is sending the message.

To ID of the requester who will receive the 
message.

Message Enter the message you want to send to the 
requester.

Attachment Select Attach File  to specify a file to attach to 
the message.

3. Select Send.
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Related topics

Asynchronous chat

Configure asynchronous chat for the web channel

Agent Chat  reference

Reference topics provide descriptions about Agent Chat.

Domain separation and Agent Chat

Domain separation is supported in the Agent Chat  application. Domain separation enables you 
to separate data, processes, and administrative tasks into logical groupings called domains. You 
can control several aspects of this separation, including which users can see and access data.

Support level: Standard

• Includes all aspects of Basic  level support.

• Application properties are domain-aware as needed.

• Business logic: The service provider (SP) creates or modifies processes per customer. The use 
cases reflect proper use of the application by multiple SP customers in a single instance.

• The instance owner must configure the minimum viable product (MVP) business logic and data 
parameters per tenant as expected for the specific application.

Sample use case: An admin must be able to make comments required when a record closes for 
one tenant, but not for another.

For more information on support levels, see Application support for domain separation .

Requirements

All domain support features require the Domain Support - Domain Extensions Installer 
[com.glide.domain.msp_extensions.installer] plugin. For details, see Request domain 
separation .

Configuring Agent Chat  with domain separation

Domain separation allows organizations to segment their data and processes based on specific 
criteria such as business unit, geography, or other factors.

A service provider (SP) has one chat setting (Agent Chat) record in the global domain when the 
instance is provisioned.

The admin of a subdomain can specify Agent Chat  settings for that subdomain, such as work 
queues and assignment groups. For details, see Setting up Agent Chat.

When a user logs into a subdomain, a seeded Agent Chat  settings record is created.

When using domain separation in Agent Chat, keep the following points in mind:

• Domain Separation applies to both the agent side and the customer side of the chat. This 
means that agents will only be able to access chat records and data that are in their domain, 
and customers will only be able to see chat records that are associated with their domain.

• Agent Chat  records are automatically tagged with the domain of the agent who handled the 
chat. This ensures that the chat record is associated with the correct domain, and that agents 
can only view chat records that are associated with their domain.
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• When an agent is assigned to a chat, the chat is automatically assigned to the domain of the 
agent. This ensures that the chat record is associated with the correct domain from the start.

• If an agent needs to transfer a chat to another agent or escalate the chat to a higher level of 
support, the chat is transferred to an agent who is in the same domain as the original agent. 
This ensures that the chat record stays within the correct domain.

Building a report to track the number of help requests

Create a report that tracks the number of help requests.

Before you begin
Role required: admin

Procedure

1. Activate the Interaction Events business rule.

a. Navigate to Interaction  > All.

b. Right-click the Number  heading.

c. Click Configure  > Business Rules.

d. On the Business Rules screen under the Name  column, click Interaction Events.

e. On the Business Rules - Interaction Events screen, select the Active  check box if it is not 
already selected.

f. Click Update.

2. Create a new metric definition for Interaction "help requested" on the Metric Definition - New 
record screen by entering Interaction  in the Table  field and selecting Help Requested 
from the Field  list.
For detailed steps on creating metric definitions, see Define a metric .

3. Create a new chat as a requester.

4. Accept the same chat as an agent.

5. While still logged in as that agent, enter the quick action /help.

6. Navigate to Metrics  > Instances  and record the ID of the single instance record created for 
help_requested=true.

7. Navigate to the Admin window and open the interaction from the previous step.

8. Join the conversation (either privately or publicly).

9. Navigate to Metrics  > Instances  and observe that one instance record was created for 
help_requested=true.
For more information about using the Metric Instance Table, see Metric instance .

Agent Chat  Interaction related records

The Interaction related record [interaction_related_record] table tracks tasks and Knowledge 
Base (KB) articles that are created, updated, or viewed in the context of a particular interaction. 
The Interaction related record table references the interaction, related document, whether the 
relationship is to a task or KB article, and what type of operation on the related document formed 
the basis for the relationship.

Interaction related record table overview

The Interaction related record table tracks task and KB article records that were created, 
updated, or viewed in a particular interaction. The Interaction related record table records
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• the interaction

• the related document

• whether the relationship is to a KB article or a task

• what type of operation on the related document formed the basis of the relationship

Creating Interaction related records

Interaction related records can be created manually or automatically.

• Manually - records are manually created via an Interaction related record form. The form is 
opened on a workspace through an Associated record UI action. When this form is used to 
create the relationship, the operation field is not set to any value.

• Automatically created via business rules

• Automatically created via client calls from a workspace

Configuring automatic creation of interaction related records

You can update or create entries in the Interaction relationship policy 
[interaction_relationship_policy] table to manage which types of operations result in the auto-
creation of interaction related records. These determine whether interaction related records may 
be created for each of the following actions:

• Insert - record created from workspace in the context of the interaction.

• Update - record updated from workspace in the context of the interaction.

• Mention - record number mentioned in a chat, resulting in the rendering of a record card.

• Open - record opened in workspace in the context of the interaction.

• Unknown - interaction related record created by automated logic other than via agent actions 
from workspace.

Two policies that are included with the base system govern behavior for 
relationships to the task and kb_knowledge table. To override behavior for a 
particular task type, you can add an additional entry for the appropriate Document 

table.

The com.glide.interaction.autocreate_relationships property is set to true by default. If it is set to 
false, only relationships created via the interaction_related_record form are created. All others 
are blocked by the "Block relationship autocreation" business rule.

Sidebar
Sidebar  enables agents to collaborate with others when working on a task-based or interaction-
based Workspace record.

Getting started with Sidebar
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Get started

Explore

Learn about Sidebar
concepts and features.

Configure

Install and configure Sidebar
and activate relevant plugins.

Use

Use Sidebar to help agents 
have discussions with 

others to solve issues faster.

Reference

Get Sidebar details for domain separation.

Troubleshoot and get help

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support

Exploring Sidebar

Using Sidebar, agents can have real-time collaboration with others based around a Workspace 
task-based or interaction-based record. These Sidebar  discussions facilitate the exchange of 
information and knowledge to help resolve issues faster and with higher-quality outcomes.

Sidebar  overview

An agent can initiate a group discussion from a task-based record or interaction-based record. 
The agent enters preliminary information and context for the discussion and adds subject matter 
experts to help. The agent can create multiple discussions for one record.

Sidebar  workspaces

Sidebar  is supported in these workspaces:

• Customer Service Management (CSM) Configurable Workspace

• CSM Manager Workspace

• Human Resources (HR) Agent Workspace

• IT Service Management (ITSM) Manager Workspace

• Vendor Management Workspace
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For information on adding the Discuss  button to one of the supported workspaces above, see 
Adding the Discuss button.

For information on adding the Discuss  button to any workspace not listed (such as the Service 
Operation Workspace), see KB article KB1213249 .

Sidebar  components

Sidebar  discussion panel

When you select the Sidebar  discussion icon , the Sidebar  discussion panel 
appears:

The Sidebar  discussion panel includes:

Icon Description

1 - Display Sidebar  discussions dialog. 
If a number in a blue square appears, 
the number indicates the number of 
Sidebar discussions that are currently 
active.

2- Search within the Sidebar  discussions. 
When you select the Search icon, the 
Search  field appears and you can enter 
the text you want to locate. The search 
results display below the search field 
and are grouped by user message then 
file name. Select Cancel  to clear the 
search field and return to the Sidebar 
discussion. You can have all search 
results display or filter by discussions, 
messages, and attachments. You can 
sort search results by most relevant, old 
to new, or new to old.

To use the Search KB quick action, 
enable AI Search. For more information, 
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Icon Description

see AI Search  and AI Search 
Availability [KB0867751] .

3 - Permanently pin the menu to the side of 
the screen.

4 - Select what types of discussions that 
you want to view:

• All - all discussions.

• Unread - all unread discussions.

• This record - all discussions related 
to the record that's currently open 
in the background. The most recent 
information displays and is updated 
when a new message is received, 
there’s an unread message, or a new 
discussion is created for the record. 
You can also create new discussions 
for the record by selecting New 
discussion.

• Mentions - discussions that mention 
you with @yourusername.

• Favorites - discussions that you 
marked as favorites.

5 - Marks the Sidebar  discussion as a 
favorite. Discussions that have been 
marked as favorites display under 
the Favorites tab. You can undo a 
discussion as a favorite by selecting the 
star icon again.

6 - Displays options for the discussion:

• Dismiss discussion - close the 
discussion dialog (but don't exit the 
discussion).

• Leave discussion - exit the 
discussion.

Docked chat windows

You can access multiple Sidebar  discussions at the same time using the docked 
windows feature. Docked chat windows include these features:
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Header icons

Icon Description

1 - Marks the Sidebar  discussion as a 
favorite. Discussions that have been 
marked as favorites display under 
the Favorites tab. You can undo a 
discussion as a favorite by selecting the 
star icon again.

2 - Opens the Discussion info panel 
that includes the About submenu, 
Participants submenu, and Leave 
discussion  button. On the About 
submenu, you can view information 
about the discussion. On the 
Participants submenu, you can add 
and remove participants. If you want 
to exist the discussion, select Leave 
discussion.

3 - Collapses the discussion so it displays 
only as a tab at the bottom of the 
screen.

4 - Closes the window.

User avatar and presence

User avatar and presence Description

Displays the user's avatar and presence 
(online status). The dot indicates the 
user's presence depending on whether 
they’re logged in to the platform:
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User avatar and presence  (continued)

User avatar and presence Description

• Green dot - user is logged in.

• No dot - user isn’t logged in.

• Orange dot - user recently logged out.

If Sidebar  and Microsoft Teams  are 
integrated, Microsoft Teams  users are 
differentiated from Sidebar  users with a 

Microsoft Teams   icon.

More actions icon

Icon Description

Display additional actions for this 
message including:

• Post to activity stream

• Remove from activity stream

• Edit message

• Delete message

Text input box icons

Icon Description

A - Access base system or custom quick 
actions.

The agent can start a KB article search 
by selecting the quick actions icon 
and then entering search-kb. The 
agent is prompted to search for the 
relevant KB article. Based on the search 
and the term that the agent enters, the 
agent is able to view the KB articles 
that match the search term. The agent 
can then select the KB article and 
include it in the discussion. The KB 
article is displayed as a record card 
in the Sidebar  discussion. The KB 
article search is available with the base 
system.

B - Display the emoji menu so you can add 
emojis to the discussion.

C - Add attachments to the current 
discussion so they can be shared with 
others in the discussion. You can drag 
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Text input box icons  (continued)

Icon Description

and drop files and select the send arrow 
icon or you can use the attachment 
icon.

D - Send the message.

If you minimize a docked window, it appears as a tab in the overflow menu at the 
bottom of the screen. If you hover over a minimized docked window, the record 
number and chat title appear to help you identify the content. You can select any of 
the tabs to access that discussion again. The maximum number of docked windows 
you can have in the overflow menu is 25 and this amount can be configured. If there 
are too many docked windows to display as tabs in the overflow menu, a tab with a 
number displays indicating how many extra docked windows aren’t displayed.

Activity stream and Sidebar

You must integrate Sidebar  with activity stream if you want agents to be able to post Sidebar 
discussions to the activity stream. For instructions on integrating Sidebar  with the activity stream, 
see Integrating Sidebar and activity stream. For information on using Sidebar  with the activity 
stream, see Activity stream in Sidebar.

Sidebar  installing and configuring

The Sidebar  configuration settings are available via the Sidebar  tab under Conversational 
Interfaces  > Settings. See Installing Sidebar  for instructions. After Sidebar  is installed, you must 
configure the admin settings. See Configuring Sidebar  for instructions.

Using Sidebar

For information on how to use Sidebar, see Using Sidebar  for more information.

Key features include:

• Creating custom discussion buttons

• Viewing Core UI forms with Sidebar

• Sidebar  panel

• Sidebar  unread conversation badge count

• Docked chat window

• Favoriting discussions

• Discussion information panel

• Discussion participant suggestions

• Quick actions

• Integrating with activity stream

• Integrating with AI search

• Drag-and-drop file sharing

• Using emojis

• Mentioning a user with @
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Using Sidebar  and Microsoft Teams

After Sidebar  and Microsoft Teams  are integrated, users of both applications can collaborate with 
each other. For more information on integrating Sidebar  with Microsoft Teams, see Sidebar and 
Microsoft Teams.

Core UI

You can create Sidebar  discussions on interaction records from Next Experience Core UI.

Domain Separation

For information about domain separation in Sidebar, see Domain separation and Sidebar.

More information

To learn more, see the Now learning course on Sidebar.

Activity stream in Sidebar

If Sidebar  is integrated with the activity stream, you can create links to discussions and post 
discussion messages directly to the related record as an activity stream record.

Note: 
Sidebar  and discussion tiles are available only with Next Experience  and not in Core UI.

When a Sidebar  discussion is created, a corresponding Sidebar  discussion tile is automatically 
added to the activity stream. Users who have access to the task-based record can also access 
the discussion from the activity stream. Sidebar  users can post messages from discussions 
into the activity stream as Sidebar  posted messages. These messages can be posted to the 
activity stream as editable entries that can be added and removed as necessary. For generalized 
information about activity streams, see Activity streams .

When you start a Sidebar  discussion, a tile corresponding to the discussion is automatically 
added to the activity stream.
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Sidebar tile

1 Sidebar  discussion name, type of 
conversation, date/time discussion started.

2 Profile pictures of the participants (if there 
are more than 5 participants, then a badge 
displays the number of additional participants 
whose profile photos can’t be seen.)

3 Name of user who created the Sidebar 
discussion.

The primary record card appears as part of the activity stream and displays the following:

• Record ID

• Short description

• Type

• State

• Assigned to

• Link that opens the record

• Priority (for task-based record cards)

Starting a discussion

If you select Open Discussion, then the Sidebar  panel opens and displays the Sidebar 
discussions. Customers and non-fulfiller roles don’t have access to the record don’t have access 
to the conversation tile, similar to work notes.
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Posting a message

You can select any message in the Sidebar  discussion panel and post it to the activity stream. 
When you post a message from the Sidebar  discussion to the primary records activity stream, 
the most important information is tied directly to the record. This enables you to access 
collaborative conversations from a record so that you can add yourself to the discussion and 
view the conversation history.

If Sidebar  messages posted to the activity stream aren’t appearing, ensure Sidebar discussion 
and Sidebar posted message  are selected in the activity stream filter.
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Pinning a discussion tile

To pin a discussion tile in the activity stream, select the pushpin icon to pin a discussion tile to 
the activity stream. Pinning a discussion tile ensures that the discussion always stays at the top 
of the activity stream.
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Editing or Deleting a message in Sidebar

If you edit a message in a Sidebar  discussion that was already posted to the activity stream, then 
any changes that you made to the message are reflected in the activity stream.

If you posted a message with an attachment in a Sidebar  discussion and the message was 
already posted to the activity stream, any changes made to the attachment will be reflected 
in the activity stream. For example, if you post a message with an attachment in a Sidebar 
discussion and it’s posted to the activity stream and you later delete the attachment and replace 
it with a different one, the activity stream displays the new attachment.

If you delete a message in a Sidebar  discussion after the original message was already posted to 
the activity stream, then the message is removed from the activity stream.

Deleting a message from the activity stream

To remove a message from the activity stream, select the More Actions  menu for each chat 
bubble within a Sidebar  discussion and then select Remove from activity stream.

Participant suggestions in Sidebar

Activate Participant suggestions to display a list of users who may be helpful additions to a 
Sidebar  discussion.

When you add participants to a Sidebar  discussion, a drop-down list displays a list of users who 
can be added. If Participant suggestions is activated, a list of "top suggestions" displays at the 
top of the list. The participant suggestions are users who may be helpful because they may have 
expertise related to the record and also have access to the record.
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Requirements

Participant suggestions has the following requirements:

• Plugin requirements: In order to access the base Participant suggestions service, you need 
to download the Participant suggestions plugin (com.glide.sn_participant_suggestions). 
Participant suggestions are optimized only for interactions, tasks, and the task's child tables. 
If you want to receive participant suggestions for any other table, you have to customize the 
Participant suggestions service. The Participant suggestions plugin works in conjunction with 
the Sidebar/Omni-Experience Standard Feature Set plugin. Both the Participant suggestions 
plugin and the Sidebar plugin must be installed before you can view the list of suggested 
users.

• Lookup table: The lookup table (suggestion_service_lookup) for participant suggestions 
applies only to the base Participant suggestion service and not to any third-party participant 
suggesting services.

Configuring Sidebar

Install and configure Sidebar  so agents can have real-time collaboration with others.

Configuration overview

Configuring Sidebar  involves installing Sidebar, adding the Discuss button, configuring the 
Sidebar  member query, and configuring participant finder. There are also additional steps if you 
want to integrate Sidebar  with Microsoft Teams.

1. Install Sidebar.

You can install Sidebar, which is part of the Omni-Experience Standard Feature Set, if you have 
the admin role.
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2. Set up Sidebar.

Activate and configure options.

3. Add the Discuss button.

Add the Discuss button to objects that do not have it installed and to custom workspaces 
where you need to enable Sidebar  on an object.

4. Configure the Sidebar member query.

Configuring the Sidebar  member query causes the participants list on the Start a Sidebar 
discussion screen to be pre-populated.

5. Enable Sidebar  and Microsoft Teams  users to communicate with each other by integrating the 
applications:

a. Sidebar and Teams integration overview.

b. Integrate Sidebar and Microsoft Teams.

c. Enable or configure the Microsoft Teams integration.

Installing Sidebar

You can install Sidebar, which is part of the Omni-Experience Standard Feature Set, if you have 
the admin role.

Before you begin
Ensure that the application and all of its associated ServiceNow®  Store applications have valid 
ServiceNow®  entitlements. For more information, see Get entitlement for a ServiceNow  product 
or application .

Role required: admin

About this task
The following items are installed with Sidebar:

• Plugins

• Roles

• Tables

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. To find the Sidebar  application, enter omni-experience standard feature set  in 
the filter criteria.

If you cannot find the application, you might have to request it from the ServiceNow Store.

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released 
apps, see the ServiceNow Store  version history release notes .

3. In the Application installation dialog box, review the application dependencies.

Dependent plugins and applications are listed if they will be installed, are currently installed, or 
need to be installed. If any plugins or applications need to be installed, you must install them 
before you can install Sidebar  feature.
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4. Optional:  If demo data is available and you want to install it, select the Load demo data  check 
box.
Demo data comprises the sample records that describe application features for the common 
use cases. Load the demo data when you first install the application on a development or test 
instance.

Important: 
If you don't load the demo data during installation, it's unavailable to load later.

5. Select Install.

6. If you want to use the Search KB quick action, enable AI Search.
For more information, see AI Search  and AI Search Availability [KB0867751] .

Setting up Sidebar

Activating the participant suggestions causes Sidebar  to display a list of knowledgeable users 
who may be able to help address an issue. After you activate participant suggestions, you can 
configure who Sidebar  decides is knowledgeable user and which groups have access. After 
installing Sidebar, activate and configure Sidebar  so agents can collaborate with others to 
resolve issues.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Home.

2. Select the Sidebar  tile.
The Sidebar  setting screen titled "Adjust how live agents collaborate to support your users" 
appears.

3. Activate Sidebar  by enabling the Activate  option and selecting Save.
The screen with the Sidebar  configuration options appears.
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4. Configure the options.

User chat settings

Field Description

Emojis
Slide the toggle switch to activate or deactivate emojis.

Participants

Field Description

User query
If you select View settings  one of the following lists 
displays:

◦ Users that are automatically pre-filled for the agent to 
add to a discussion

◦ Users that display when the agent searches for 
participants to add to a discussion

For more details, see Configuring Sidebar member query.
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Participant suggestions

Field Description

Activate
Slide the toggle switch to activate or deactivate 
participant suggestions.

Use the participant suggestions to display a list of users 
who may be helpful in the Sidebar  discussion.

For detailed information on participant suggestions, see 
Participant suggestions in Sidebar.

Configure settings
If you activate participant suggestions, the Manage drop-
down list appears. Select a configuration option:

◦ View Configuration - displays the Participant 
suggestions table and related lists.

◦ View Permissions - displays the Participant 
suggestions permissions page where you configure 
whether participant suggestions should display for 
specific groups or all groups. To enable all groups to 
view participant suggestions, select Allow all groups 
and then Save. Since permissions can't be configured 
at an individual user level, ensure that any users you 
want to be included belong to a relevant group.

For detailed information on participant suggestions 
configuration settings, see Participant suggestions in 
Sidebar.

Integrations

Field Description

Microsoft Teams
If Sidebar  isn't already integrated with Microsoft Teams, 
select Set up  to configure the options for the first time. 
See Enable or configure the Microsoft Teams integration 
for more information.

If Sidebar  has already been integrated with Microsoft 
Teams, the Manage drop-down list appears. Select a 
configuration option:

◦ View configuration (for more information, see Enable or 
configure the Microsoft Teams integration).

◦ View permissions (for more information, see Manage 
Microsoft Teams permissions)
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Field Description

◦ Remove integration - if you select this option, a warning 
message displays that the integration between Sidebar 
and Microsoft Teams will be removed. Select Cancel 
if you do not want to remove the integration or select 
remove if you want to remove the integration.

5. Select Save.

Integrating Sidebar  and activity stream

For agents to post Sidebar  discussions in the activity stream, Sidebar  must be integrated with the 
activity stream and Sidebar  options must display in the post filters. If the Sidebar  options don’t 
display in the post filters, you must add them.

Before you begin
Role required: admin

Note: 
List of post types without Sidebar  options:
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Procedure

1. If Sidebar  was automatically installed in the workspace:

a. Check the sys_properties  file for the record glide.ui.{table_name}_activity.fields where 
{table_name} is the parent record table name.

b. If the sys_properties  file record exists for the record table, check whether it includes 
Sidebar discussion  and Sidebar posted message. If it doesn't, add Sidebar discussion  and 
Sidebar posted message  at the end of the existing value.

2. If Sidebar  was manually added for a record in a workspace:

a. Check the sys_properties  file for glide.ui.{table_name}_activity.fields where 
{table_name} is the parent record table name.

b. If the sys_properties  file record exists for the record table, check whether it includes 
Sidebar discussion  and Sidebar posted message. If it doesn't, add Sidebar discussion  and 
Sidebar posted message  at the end of the existing value.
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c. If the sys_properties  file record doesn’t exist for the record table, it loads the default 
filters which contain Sidebar  filters.

Note: 
List of post types with Sidebar  options:

Adding the Discuss button

To use Sidebar, you must add the Discuss  button to objects that do not have it automatically 
installed and to custom workspaces where you need to enable Sidebar  on an object. After you 
add the Discuss  button, you can create Sidebar  discussions.

Before you begin
Role required: admin

About this task
You do not need to add the Discuss  button to these workspaces because it is automatically 
installed:

• Customer Service Management (CSM) Configurable Workspace

• CSM Manager Workspace
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• Human Resources (HR) Agent Workspace (Configurable only)

• IT Service Management (ITSM) Manager Workspace

• Vendor Management Workspace

Note: 
After you add the Discuss  button, you must configure the activity stream. For more 
information, see Activity stream in Sidebar.

Procedure

1. Navigate to All  and in the filter field, enter ux form actions configs.

2. On the UX Actions Configurations screen, select the workspace where you want to create the 
Discuss  button.

3. On the UX Actions Configuration - Workspace Action Config screen, select the UX Form 
Actions Layouts  tab.

4. On the UX Form Actions Layouts tab, select Task Actions.

5. On the Task Actions screen, select the UX Form Action Layout Items  tab.

6. On the UX Form Action Layout Items tab, select Edit.

7. On the Edit Members screen, enter discuss  in the Collection field.
Discuss  appears in both the Collection and the Task Actions columns.

8. Select the Collection column.

9. Select Save.
The UX Form Actions Layout - Task Actions screen redisplays.

10. On the UX Form - Action Layout Items tab, select Discuss  from the UX Form Action Layout Item 
column.

11. On the UX Form Actions Layout Item - Discuss screen, check the value in the Table field:

◦ If the Table field displays Task, then the Discuss button has been added.

◦ If the Table field displays Interaction, then select the back arrow. Perform steps 6 through 10 
again, but select the Task Actions column.

12. Select Save.

Configuring Sidebar  member query

Configuring the Sidebar  member query pre-populates the participants list on the Start a Sidebar 
discussion screen.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. From the left-side menu on the CI Admin Experience page, select Sidebar.
The Sidebar  settings screen with the heading "Adjust how live agents collaborate to support 
your users" displays.

3. From the Participants section on the Sidebar  settings screen, select View Settings.
The Sidebar  Member Query screen displays.

4. Do one of the following:
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◦ To edit an existing query, select the name of the query.

◦ To create a new query, select New.

5. Fill in the fields:

Field Description

Name
Name of the member query.

Active
Indicates whether the query is activated.

Type From the drop-down list, select Pre-fill  or Search.

◦ Pre-fill: automatically select all members of the assignment group.

◦ Search: add members of the assignment group and no one else.

Order
Order in which the routing condition for this queue is considered, in 
comparison to other queues.

Application Type of scoped application.

Condition Mode
Type of condition for routing work items in the query. From the drop-
down list, select Advanced  or Simple.

◦ Simple: specify a routing condition using the condition builder.

◦ Advanced: specify a JavaScript scripted condition.

Condition table
This field displays if you selected Simple  for the Condition Mode. From 
the drop-down list, select the table.

Condition
This field displays if you selected Simple  for the Condition Mode. Use 
the Add Filter Condition  and Add "OR" Clause  buttons to create the 
condition for the query.

Condition Script
This field displays if you selected Advanced  for the Condition Mode. 
Enter a JavaScript script to build the query.

User Query Mode
From the drop-down list, select Advanced  or Simple.

◦ Simple: Specify a routing condition using the condition builder.

◦ Advanced: Specify a JavaScript scripted condition.

User Query 
Condition This displays if you select Simple  for the User Query Mode. Use the 

Add Filter Condition  and Add "OR" Clause  buttons to create the 
condition for the query.
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Field Description

User Query Script
This displays if you select Advanced  for the User Query Mode. You can 
specify a JavaScript script to build the query.

6. Select Submit.

Sidebar  and Microsoft Teams

Sidebar's integration with Microsoft Teams  enables Sidebar  users and Microsoft Teams  users to 
communicate with each other from their respective platforms.

Monetization by Microsoft

The Sidebar-Microsoft Teams  integration is available as a standard ServiceNow  feature, however 
Microsoft  intends to monetize any use of their Microsoft Teams  API based on a rate charge per 
message:

• The rate charge applies each time the Microsoft Teams  API is called. Charges apply for 
messages sent from your ServiceNow  instance to Microsoft Teams  and vice versa.

• The rate charge doesn’t apply to “means to an end" actions such as searching for or adding 
users to a Microsoft Teams  group chat, user presence, or reactions.

Microsoft  bills ServiceNow  customers directly via their Microsoft Azure  account. For more 
information, see Licensing and payment requirements for the Microsoft Teams API .

Authenticating Sidebar  users in Microsoft Teams

A Sidebar  user must already have a Microsoft Teams  account to communicate with a Microsoft 
Teams  user. Microsoft Teams  authenticates each Sidebar  user to confirm that they have a 
Microsoft Teams  account. This authentication ensures that Microsoft Teams  can create a 
group chat that includes the Sidebar  user's Microsoft Teams  account. If the Sidebar  user has a 
Microsoft Teams  account but isn’t signed in, they’re prompted to sign in.

Differentiating between Sidebar  and Microsoft Teams  users

To differentiate Sidebar  users from the Microsoft Teams  users, a Microsoft Teams  icon 
displays next to the Microsoft Teams  user name. The Microsoft Teams  icon displays next to 
Microsoft Teams  user names in discussion windows and search results, but not in the activity 
stream.
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Examples with Microsoft Teams  icon

Discussion window with Microsoft Teams  icon

All tab on the Discussion window with 
Microsoft Teams  icon

Discussion window with Microsoft Teams  icon 
next to search results
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Examples with Microsoft Teams  icon  (continued)

Discussion info window with Microsoft Teams 
icon

Adding users to a discussion

Sidebar  users can enter the partial or full name of a user that they want to add to the discussion. 
If the user exists in the system, the user's name appears and can be selected to be added to the 
discussion. Users who have access to Microsoft Teams  but not ServiceNow  can be identified by 
the Microsoft Teams  logo in their avatar image. Microsoft Teams  users can add participants to the 
discussion by adding them to the group chat on Microsoft Teams. Doing this automatically adds 
those users to the discussion in Sidebar.

Sending messages between Sidebar  and Microsoft Teams

After Sidebar  and Microsoft Teams  are integrated, you can send these types of messages 
between the two applications:

• Messages with plain text

• Messages with emojis

• Messages with URLs

• Messages with attachments

Actions performed in the Sidebar  discussion are reflected in Microsoft Teams  and actions 
performed in Microsoft Teams  are reflected in Sidebar. If you reply to a message in a Microsoft 
Teams  group chat, the message displays in Sidebar  however, it doesn't display as a reply to the 
original message.

Errors messages appear in these situations:

• If Sidebar  is unable to deliver a message to a Microsoft Teams  user, the message "Not 
delivered in Teams" displays. Depending on how error message notifications in Sidebar  are 
configured, the message displays to just the Sidebar  user who sent the message or to all 
Sidebar  users in the discussion.
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• If you delete a message that you previously sent from Sidebar  to Microsoft Teams  but Microsoft 
Teams  is unable to delete the message, then the message "Not deleted in Teams" displays.

• If you edit a message that you previously sent from Sidebar  to Microsoft Teams  but Microsoft 
Teams  is unable to update the message, then the message "Not updated in Teams" displays.

Removing users from a discussion

Sidebar  users can remove a Microsoft Teams  user from a Sidebar  discussion. When a Microsoft 
Teams  user is removed from a discussion, Sidebar  and Microsoft Teams  users see a message 
that the user has been removed from the discussion. After a Microsoft Teams  user is removed 
from the discussion, that user can still access the group chat on Microsoft Teams  and view older 
messages, but they can no longer participate in the discussion. If a Microsoft Teams  user leaves 
a discussion on their own, both Sidebar  and Microsoft Teams  users see a message that the 
Microsoft Teams  user has left the discussion.

Message history

If the admin enables Microsoft Teams  group chats for a user, the message history of any Sidebar 
discussions that the user is already participating in aren't preloaded in the Microsoft Teams 
group chat. In the Microsoft Teams  group chat, the user will only receive messages that are sent 
after the admin enables them to receive Microsoft Teams  group chats.

ServiceNow's access to Microsoft Teams  messages

ServiceNow's access to Microsoft Teams  group chats and messages is restricted to the ones 
generated as part of the Sidebar  and Microsoft Teams  integration.

Synchronizing of participants

The discussion participants aren’t synchronized if the integration between Sidebar  and Microsoft 
Teams  is changed multiple times.
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Synchronizing example

Domain separation with Sidebar-Microsoft Teams  integration

If Sidebar  is integrated with Microsoft Teams, you can't have domain separation on the Microsoft 
Teams  instance. For example, if you’ve configured two domains on ServiceNow  but use only one 
Microsoft Teams  instance, you can't partition the Microsoft Teams  instance to have part of it point 
to one domain and the other part to another domain.

Integrate Sidebar  and Microsoft Teams

Enable conversations between Sidebar  and Microsoft Teams  users by integrating Sidebar  with 
Microsoft Teams.

Follow these steps to integrate Sidebar  and Microsoft Teams.

Note: 
Some resources below require you to log in to sites like ServiceNow University, Now Create, 
or the ServiceNow Community. If the expected resource does not load, please log in and try 
to access the resource again.

1. Install the store app  on the Washington DC  instance.

2. Create the Microsoft Teams developer account and Azure app. See KB article KB1225842  for 
more information.

3. Create the Microsoft Teams app. See KB article KB1225842  for more information.

4. Enable the Microsoft Teams integration using the information in Enable the Microsoft teams 
integration.

Enable or configure the Microsoft Teams  integration

Enable or configure the Microsoft Teams  integration as part of integrating Sidebar  with Microsoft 
Teams.
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Before you begin
Role required: admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. Select Sidebar.

3. On the Integrations card:

◦ If Sidebar  and Microsoft Teams  are not already integrated, select Set up.

◦ If Sidebar  and Microsoft Teams  are already integrated, select View configuration  from the 
Manage drop-down list.

4. On the Microsoft Teams  Integration screen, slide the activate toggle to allow or prevent 
Microsoft Teams  users from participating in Sidebar  discussions.

◦ When this is switched on, Microsoft Teams  users that previously had access to Sidebar  will 
regain access and any Microsoft Teams  users that are newly included will gain access to 
Sidebar.

◦ When this is switched off:

▪ Microsoft Teams  users that previously had access to Sidebar  will no longer have access to 
Sidebar.

▪ Any Microsoft Teams  users that are newly included will not gain access to Sidebar.

▪ Existing discussions will become inactive in Microsoft Teams. Microsoft Teams  users will 
still be able to access older messages in a Microsoft Teams  group chat, but any messages 
sent in those group chats will not be sent to Sidebar.

▪ Existing discussions will remain active for Sidebar  users.

5. Enter Client Secret, Callback URL, and Redirect URL.

Note: 
For more information about the Microsoft Azure  Portal fields needed, see Use the portal 
to create an Azure AD application .

Field Description

Application (client) ID
ID associated with the app created in the portal.

Directory (tenant) ID
ID associated with the Microsoft Teams  organization that 
will be linked to Sidebar  discussions.

App ID
ID used to subscribe to Sidebar  conversations from 
Microsoft Teams.

Client Secret
Auto-assigned credentials used to authenticate the 
Microsoft Azure  app with Microsoft. If this field is 
changed, then a new integration setup will be triggered.

Callback URL
Web location Microsoft Teams  uses to send a response 
to Sidebar. For your own instance, add the value like 
https://your-instance.service-now.com/api/now/
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Field Description

collaboration_chat_event_processor/chats. If this field is 
changed, then a new integration setup will be triggered.

Redirect URL
Web page that appears after you successfully log in 
to Microsoft Teams. If this field is changed, then a new 
integration setup will be triggered.

6. Select Save.

Manage Microsoft Teams  permissions

Configure which groups or users can access Sidebar  discussions in Microsoft Teams.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings.

2. Select Sidebar.

3. From the Manage  drop-down list on the Integrations card, select View permissions.
The Microsoft Teams  permissions page appears.

4. Select the Groups tab or the Users tab.

Groups tab

Field Description

Filter by
Use the filter fields to limit which users display in the 
Available users list.

Apply Filter button Select Apply Filter  to limit the groups in the Available 
Groups list using the filter fields.

Available groups
Select the groups that can access the Sidebar 
discussions in Microsoft Teams.

Selected groups
List of the groups that can access Sidebar  discussions in 
Microsoft Teams. To remove access, select X next to the 
group name.

Note: 
All of the users in the selected group will have 
access to the discussions.
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Users tab

Field Description

Filter by
Use the filter fields to limit which groups display in the 
Available groups list.

Apply Filter button Select Apply Filter  to limit the users in the Available 
users list using the filter fields.

Available users
Select the users that can access the Sidebar  discussions 
in Microsoft Teams.

Selected users
List of the users that can access Sidebar  discussions in 
Microsoft Teams. To remove access, select X next to the 
user name.

5. Select Save.

Using Sidebar

You can create a Sidebar  discussion for a task-based or interaction record from either a 
configurable workspace or a Next Experience  Core UI record page.

Before you begin
Role required: users with access to the record associated with the Sidebar  discussion

Procedure

1. Navigate to the workspace in which you want to start a Sidebar  discussion.
If you want to initiate a Sidebar  discussion in a Customer Service Management (CSM) 
workspace, the CSM plugin for that workspace must be activated.

2. Select the list icon .

3. From Lists, navigate to and select the case, interaction, or incident for which you would like to 
start a Sidebar  discussion.

4. On the Details screen, you can start a new discussion or join an existing discussion by 
selecting Discuss.

◦ If the Sidebar  discussion exists, the corresponding discussion dialog appears.

◦ If a Sidebar  discussion doesn't exist, the Start a Sidebar discussion dialog appears. Fill out 
the fields and then select Start discussion:
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▪ Record number - the task or incident number associated with the Sidebar  discussion.

▪ Subject - this field is pre-populated with the record's short description. If the Subject starts 
with a number in parentheses, the number indicates what number this discussion is for 
the record. For example, if the subject line has "(2) Email issue," the "2" indicates this is the 
second discussion for the email issue record. You can edit or add to the Subject field.

▪ Add participants - if an assignment group was entered for this case/interaction/incident, 
this field is pre-populated with the members of the assignment group. You can also 
manually enter the participants you would like to include in the discussion. Only users 
who have access to the record can be added as participants. For more information, see 
Configuring Sidebar member query.

▪ Include a brief message for participants - enter a short message for the participants of the 
Sidebar  discussion.

5. To return to a previous Sidebar  discussion, you can select the Discussion icon  or select 
one of the tabs in the overflow menu.

6. After a discussion has been started, you can edit and delete messages.

7. To call out a user, enter @user  (where user  is the name of the user).

◦ If you don't know the user's name, enter @  to display a list of users and select someone from 
that list.

◦ Only users who have access to the underlying record display in the list.

◦ The list is divided into users who are currently participating in the discussion (participants) 
and users who aren’t (non-participants).

◦ The user is notified that they were mentioned in a Sidebar  discussion message. The Sidebar 
discussions chat icon displays a number indicating unread messages or mentions.
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◦ If the user selects the Mentions tab, the messages in which the user was mentioned using 
@user display.

◦ If the user selects the message preview card, the corresponding message displays with the 
exact message containing the @mention highlighted.

◦ If Sidebar  and Microsoft Teams  are integrated, Microsoft Teams  users are differentiated from 

Sidebar  users with a Microsoft Teams   icon.

8. When you’re finished, close or exit the discussion.

◦ To close the discussion dialog (but not exit the discussion), select .

◦ To exit the discussion, select Leave discussion.

Sidebar  reference

Read information about how Sidebar  works with domain separation.

Domain separation and Sidebar

Domain separation and  Sidebar

Domain separation is supported for  Sidebar  . Domain separation enables you to separate data, 
processes, and administrative tasks into logical groupings called domains. You can control 
several aspects of this separation, including which users can see and access data.

Support level: Standard

• Includes all aspects of Basic  level support.

• Application properties are domain-aware as needed.

• Business logic: The service provider (SP) creates or modifies processes per customer. The use 
cases reflect proper use of the application by multiple SP customers in a single instance.

• The instance owner must configure the minimum viable product (MVP) business logic and data 
parameters per tenant as expected for the specific application.
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Sample use case: An admin must be able to make comments required when a record closes for 
one tenant, but not for another.

For more information on support levels, see Application support for domain separation .

Overview

To set up domain separation for Sidebar, enable domain separation for your instance. If your 
instance has multiple domains, you can turn Sidebar  on or off for each domain. No special 
configuration is needed to configure a domain-separated environment with Sidebar. Domain 
separation for Sidebar  is supported only when domains are set up using a parent-child domain 
hierarchy.

Sidebar  discussions are domain separated according to the base record (task or interaction 
record). You can see and create sidebar discussions only if you have access to the task or 
interaction record.

For example, say INC00001 belongs to the record created in the ACME domain and the Cisco 
domain doesn't have access to INC00001. Users that belong to the Cisco domain can't interact 
with Sidebar  discussions based on INC00001.

Sidebar  versions for domain separation

To fully utilize domain separation, you must be on both the Vancouver version and August 
version of the Sidebar  store app (Omni Experience Standard Feature Set).

If you are a first time Sidebar  user in Vancouver (you did not use Sidebar  earlier and are not trued 
up to the Vancouver store app) and want to leverage domain separation, Sidebar  is inactive by 
default. Navigate to the Conversational Interfaces settings page for each domain and activate 
Sidebar  manually. Alternatively, you can access the sys_cs_collab_settings table and manually 
insert a new record for each domain.

There is a known issue with emojis not working as expected when used with domain separation. 
A workaround for this issue is to go to the Enable Emojis ACE Content block and update the 
record field with the sys_cs_collab_settings record's sys_id for the given domain.

Domain separation with the Sidebar  and Microsoft Teams  integration

If Sidebar  and Microsoft Teams  are integrated and configured, activating Sidebar  prompts 
a message stating that the Microsoft Teams  integration must be manually turned on and 
deactivating Sidebar  prompts a message stating that the integration with Microsoft Teams  will 
also be turned off.

Domain separation will not work with Microsoft Teams  if multiple domains are configured. Pairing 
a unique Microsoft Teams  with each domain is not supported.

Related topics

Domain separation for service providers

Conversational Interfaces  Diagnostic Tool
Use the Conversational Interfaces  Diagnostic Tool to identify, troubleshoot, and find solutions for 
issues with conversational interfaces, before reaching out to Now Support.
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Get started

Explore

Learn about the features 
of the diagnostic tool.

Use

Use the tool to resolve errors and solve 
configuration issues with Microsoft 

Teams and Advanced Work Assignment.

Troubleshoot and get help

• Virtual Agent and Natural Language Understanding (NLU) community forum

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support

Exploring Conversational Interfaces  Diagnostic Tool

The Conversational Interfaces  Diagnostic Tool lets admins search for, identify, and resolve issues 
with conversational interfaces.

Overview

The Conversational Interfaces  Diagnostic Tool lets admins search for, identify, and resolve issues 
with conversational interfaces.

Technical support engineers set up the Conversational Interfaces  Diagnostic Tool on the server. 
Technical support engineers create and manage the Conversational Interfaces  diagnostic 
category records and content that the Conversational Interfaces  Diagnostic Tool uses.

After the technical support engineers create the diagnostic categories and content, admins can 
start using the Conversational Interfaces  Diagnostic Tool on the web client. Admins must have 
the admin or virtual_agent_admin role.

The Conversational Interfaces  Diagnostic Tool is available for both Virtual Agent  and Virtual 
Agent Lite.

Note: 
Before using the Conversational Interfaces  Diagnostic Tool, admins must activate the 
Conversational Interfaces - Diagnostics plugin (sn_ci_diagnostics) available on the 
ServiceNow®  Store  store.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .
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Conversational Interfaces  Diagnostic Tool workflow

After you've described the issue you want to solve, the Conversational Interfaces  Diagnostic Tool 
workflow begins using the relevant diagnostic topics and topic blocks. These topics and topic 
blocks are used for identifying, diagnosing, solving, and collecting data for the issue described.

For example, the diagnostic workflow does the following:

• Prompts you for the required data, based on the issue you want to solve.

• Includes a list of Knowledge Base (KB) articles where you can find more information, as 
applicable. If you aren't finding the information you need, you can also search for additional KB 
articles.

• Gives you the option of downloading diagnostic support information.

• Lets you select another issue to solve.

The diagnostic workflow and the options and prompts you see correspond to the issue you are 
trying to diagnose and solve. The diagnostic workflow uses an AI Search  filter as part of the 
diagnosis. For more information about AI Search  and how to configure it, see Configuring AI 
Search .

The diagnostic topic block workflow also includes solutions for messaging integrations, such as 
Microsoft Teams. It also helps with Advanced Work Assignment  configuration issues.

Conversational Interfaces  Diagnostic Tool workflow

In the workflow, the admin describes the issue. The tool runs a health check and returns 
available troubleshooting information, as well as contact information for Now Support  if the 
problem was not solved.

Conversational Interfaces  Diagnostic Tool benefits

Benefit Feature Users

Diagnose general errors, such as error 
messages and system property issues.

Diagnose 
Conversational 
Interfaces errors

Admins

Identify and solve Microsoft Teams 
configuration issues.

Diagnose Microsoft 
Teams configuration 
issues

Admins

Identify and resolve common Advanced Work 
Assignment  (AWA) configuration issues.

Diagnose Advanced 
Work Assignment 
configuration issues

Admins

Using the Conversational Interfaces  Diagnostic Tool

Use the tool to diagnose general Conversational Interfaces  errors and system property settings, 
as well as issues with Microsoft Teams  and Advanced Work Assignment  configuration.
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Diagnose Conversational Interfaces  errors

Use the Conversational Interfaces  Diagnostic Tool to resolve issues related to conversational 
interfaces such as error messages and system property issues before reaching out to Now 
Support.

Before you begin
Role required: virtual_agent_admin or admin

About this task
Use this task to resolve errors and find and change system property values.

Procedure

1. Start a conversation with the Virtual Agent  chatbot.

2. At the greeting message, type diagnostic pre chat.

3. Describe the issue that you want to solve.

If it is an error message issue, you can copy-and-paste or type the error message into the 
chatbot conversation.

For system properties, you don't need to know the exact name of the system property. Type a 
feature name related to the property to see a list of matching system properties.

When your input matches an existing system property, but that property isn't in your 
instance, you see the system property name followed by two dash lines. For example: 
some.property.name--

Find or create the system property on your instance and make changes, as applicable.

The tool displays a list of solutions.

4. Select the solution that you want to use.
The Diagnostic Tool asks if you want to proceed with the diagnosis.

Proceed or search again chat response

5. Select Yes  to continue.
The tool initiates the workflow and leads you through the relevant prompts. The prompts you 
see depend on the issue you want to diagnose and solve.

6. Answer the prompts.
When the diagnosis is complete, the Diagnostic Tool displays a recommended solution.
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Issue recommendation

Issue confirmation

7. Select Yes  to confirm, or select No  to end the workflow.
The Diagnostic Tool guides you through the relevant workflow. The options and prompts you 
see depend on the issue you want to solve. Reply to the prompts, as applicable. You may also 
see a link to the relevant Knowledge Base (KB) article where you can find more information.

8. Provide feedback.
When asked whether the solution was helpful, select one of the following:

◦ Select Yes, if the solution wasn't helpful.

You are asked to provide additional information that helps fine-tune the solution.

The prompts you see vary by the issue that you want to solve.

◦ Select No  to confirm that the solution was helpful and to exit the workflow.

◦ You may see a link that you can use to download support data.

Prompt to download support data

9. Optional:  Click the link to download support data.

Diagnose Microsoft Teams  configuration issues

Use the Conversational Interfaces  Diagnostic Tool to identify and help solve Microsoft Teams 
configuration issues before reaching out to Now Support.

Before you begin
Role required: virtual_agent_admin or admin
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Procedure

1. Start a conversation with the Virtual Agent  chatbot.

2. At the greeting message, type diagnostic pre chat.

3. Describe the issue that you want to solve.
For example, if the Microsoft Teams  application isn't responding, you can type no 
response.
The tool displays a list of solutions.

Example solutions for "no response"

4. Select the solution that you want to use.
The Diagnostic Tool asks if you want to proceed with the diagnosis.

Proceed or search again chat response

5. Select Yes  to continue.
Lists of Health Check Parameters and MS Teams Tenant Configurations display.
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Health check parameters and tenant configuration status

6. Review the values for any parameters that are set incorrectly.
For example, if a value is set to False  when it should be set to True.
When the diagnosis is complete, the Diagnostic Tool displays a recommended solution.

Issue recommendation

Issue confirmation

7. Select Yes  to confirm, or select No  to end the workflow.
The Diagnostic Tool guides you through the relevant workflow. The options and prompts you 
see depend on the issue you want to solve. Reply to the prompts, as applicable. You may also 
see a link to the relevant Knowledge Base (KB) article where you can find more information. 
For example, you may see a link to the Master KB article  for common and known issues with 
Microsoft Teams.

8. Provide feedback.
When asked whether the solution was helpful, select one of the following:
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◦ Select Yes, if the solution wasn't helpful.

You are asked to provide additional information that helps fine-tune the solution. For 
example, you may be asked to provide the MS Teams Bot tenant ID, or asked if the instance 
has been cloned from another instance.

The prompts you see vary by the issue that you want to solve.

◦ Select No  to confirm that the solution was helpful and to exit the workflow.

◦ You may see a link that you can use to download support data.

Prompt to download support data

9. Optional:  Click the link to download support data.

Diagnose Advanced Work Assignment  configuration issues

Use the Conversational Interfaces  Diagnostic Tool to identify and resolve common Advanced 
Work Assignment  (AWA) configuration issues before reaching out to Now Support.

Before you begin
Role required: virtual_agent_admin or admin

About this task
Solve issues with your AWA  configuration. For example, you can solve issues such as No Agents 
Available  messages.

Procedure

1. Start a conversation with the Virtual Agent  chatbot.

2. At the greeting message, type diagnostic pre chat.

3. Describe the issue that you want to solve.
You can type or paste the error message into the chatbot conversation. For example, you can 
type No Agents Available.
The tool displays a list of solutions.

4. Select the solution that you want to use.
The solutions correspond to the issue that you want to solve.
The Diagnostic Tool asks if you want to proceed with the diagnosis.
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Proceed or search again chat response

5. Select Yes  to continue.
The tool initiates the workflow and leads you through the relevant prompts. The prompts you 
see depend on the issue you want to diagnose and solve.

6. Answer the prompts.
When the diagnosis is complete, the Diagnostic Tool displays a recommended solution.

Issue recommendation

Issue confirmation

7. Select Yes  to confirm, or select No  to end the workflow.
The Diagnostic Tool guides you through the relevant workflow. The options and prompts you 
see depend on the issue you want to solve. Reply to the prompts, as applicable. You may also 
see a link to the relevant Knowledge Base (KB) article where you can find more information.

8. Provide feedback.
When asked whether the solution was helpful, select one of the following:

◦ Select Yes, if the solution wasn't helpful.

You are asked to provide additional information that helps fine-tune the solution.

The prompts you see vary by the issue that you want to solve.

◦ Select No  to confirm that the solution was helpful and to exit the workflow.

◦ You may see a link that you can use to download support data.
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Prompt to download support data

9. Optional:  Click the link to download support data.

Additional resources for Conversational Interfaces
If you’re looking for Conversational Interfaces  (CI) best practices, troubleshooting, or other 
implementation guidelines, select a feature or resource type to discover ServiceNow®  resources 
on other relevant websites.

Resource links

CI features Resource type Resources

Agent Chat
Release notes

Agent Chat release notes

Agent Chat
Getting Started

Agent Chat quick start guide (ServiceNow 
Community)

Agent Chat
FAQs Agent Chat FAQ

Now Assist  in Virtual 
Agent Tips and 

examples
When to consider Now Assist in Virtual Agent

How to request catalog items in Now Assist in Virtual 
Agent

Now Assist in Virtual Agent conversational catalog 
ordering

Sidebar
Release notes

Sidebar release notes

Sidebar Getting Started Sidebar - Product Briefing

Sidebar
Tips and 
examples

Enable Sidebar users to collaborate with Microsoft 
Teams users

Sidebar
FAQs

Sidebar FAQ

Virtual Agent
Release notes

Virtual Agent release notes
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https://learning.servicenow.com/nowcreate?id=nc_asset&asset_id=d88d7340c3e9021843395230a0013157&nc_source=copy_asset_link
https://www.youtube.com/watch?v=dxo-o0AKReo
https://www.youtube.com/watch?v=dxo-o0AKReo
https://www.youtube.com/watch?v=dxo-o0AKReo
https://www.youtube.com/watch?v=dxo-o0AKReo
https://www.servicenow.com/community/agent-chat-routing-and-sidebar/sidebar-faqs/ta-p/2309527
https://www.servicenow.com/community/agent-chat-routing-and-sidebar/sidebar-faqs/ta-p/2309527
https://www.servicenow.com/community/agent-chat-routing-and-sidebar/sidebar-faqs/ta-p/2309527
https://www.webstg.servicenow.com/docs/access?context=virtual-agent-rn&version=washingtondc&pubname=washingtondc-release-notes&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=virtual-agent-rn&version=washingtondc&pubname=washingtondc-release-notes&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=virtual-agent-rn&version=washingtondc&pubname=washingtondc-release-notes&ft:locale=en-US


Resource links  (continued)

CI features Resource type Resources

Virtual Agent
Getting Started Virtual Agent Fundamentals (ServiceNow University)

Virtual Agent Implementation (ServiceNow 
University)

Virtual Agent Integrations (ServiceNow University)

Virtual Agent and NLU Quick Start Guide

Virtual Agent - Deployment Guide

Virtual Agent
Best practices

The 7 habits for a highly effective chatbot

Virtual Agent
Tips and 
examples

Virtual Agent - Tips for Implementation Success

Virtual Agent implementation checklist - a deeper 
dive

Virtual Agent
FAQs Virtual Agent FAQs

Virtual Agent NLU FAQs

Manage instance data sources
Data management is critical to success in all aspects of your business. Platform tools give you full 
control over your data, whether in instances, databases, or third-party applications.

Instance Data 
Replication  IDR

Synchronize data between 
instances in one-to-
one or one-to-many 

database relationships.

MetricBase

Simplify working with large 
amounts of data and create 

time-based analyses.

MID Server

Communicate and 
transmit data between 
ServiceNow instances 

and external applications.
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https://learning.servicenow.com/lxp/en/pages/servicenow?id=learning_course_prev&course_id=0f6c56a94766f5d0db63fb25126d4332
https://learning.servicenow.com/lxp/en/pages/servicenow?id=learning_course_prev&course_id=0f6c56a94766f5d0db63fb25126d4332
https://learning.servicenow.com/lxp/en/pages/servicenow?id=learning_course_prev&course_id=0f6c56a94766f5d0db63fb25126d4332
https://learning.servicenow.com/lxp/en/now-platform/virtual-agent-implementation-tokyo?id=learning_course_prev&course_id=43663b2d4739bd94123f3975d36d43e6
https://learning.servicenow.com/lxp/en/now-platform/virtual-agent-implementation-tokyo?id=learning_course_prev&course_id=43663b2d4739bd94123f3975d36d43e6
https://learning.servicenow.com/lxp/en/now-platform/virtual-agent-implementation-tokyo?id=learning_course_prev&course_id=43663b2d4739bd94123f3975d36d43e6
https://learning.servicenow.com/lxp/en/now-platform/virtual-agent-implementation-tokyo?id=learning_course_prev&course_id=43663b2d4739bd94123f3975d36d43e6
https://learning.servicenow.com/lxp/en/now-platform/virtual-agent-integrations-tokyo?id=learning_course_prev&course_id=8337e720938bf5585402393d6cba106f
https://learning.servicenow.com/lxp/en/now-platform/virtual-agent-integrations-tokyo?id=learning_course_prev&course_id=8337e720938bf5585402393d6cba106f
https://learning.servicenow.com/lxp/en/now-platform/virtual-agent-integrations-tokyo?id=learning_course_prev&course_id=8337e720938bf5585402393d6cba106f
https://www.servicenow.com/community/virtual-agent-nlu-articles/virtual-agent-and-nlu-quick-start-guide/ta-p/2308061
https://www.servicenow.com/community/virtual-agent-nlu-articles/virtual-agent-and-nlu-quick-start-guide/ta-p/2308061
https://www.servicenow.com/community/virtual-agent-nlu-articles/virtual-agent-and-nlu-quick-start-guide/ta-p/2308061
https://learning.servicenow.com/nowcreate?id=nc_asset&asset_id=f90f577297a24a9ce4fb72de2153afb4&nc_source=copy_asset_link
https://learning.servicenow.com/nowcreate?id=nc_asset&asset_id=f90f577297a24a9ce4fb72de2153afb4&nc_source=copy_asset_link
https://learning.servicenow.com/nowcreate?id=nc_asset&asset_id=f90f577297a24a9ce4fb72de2153afb4&nc_source=copy_asset_link
https://www.servicenow.com/community/virtual-agent-nlu-articles/7-habits-for-a-highly-effective-chatbot/ta-p/2308345
https://www.servicenow.com/community/virtual-agent-nlu-articles/7-habits-for-a-highly-effective-chatbot/ta-p/2308345
https://www.servicenow.com/community/virtual-agent-nlu-articles/7-habits-for-a-highly-effective-chatbot/ta-p/2308345
https://www.servicenow.com/community/virtual-agent-nlu-articles/virtual-agent-tips-for-implementation-success/ta-p/2310400
https://www.servicenow.com/community/virtual-agent-nlu-articles/virtual-agent-tips-for-implementation-success/ta-p/2310400
https://www.servicenow.com/community/virtual-agent-nlu-articles/virtual-agent-tips-for-implementation-success/ta-p/2310400
https://www.servicenow.com/community/virtual-agent-nlu-articles/virtual-agent-implementation-checklist-a-deeper-dive/ta-p/2306564
https://www.servicenow.com/community/virtual-agent-nlu-articles/virtual-agent-implementation-checklist-a-deeper-dive/ta-p/2306564
https://www.servicenow.com/community/virtual-agent-nlu-articles/virtual-agent-implementation-checklist-a-deeper-dive/ta-p/2306564
https://www.servicenow.com/community/virtual-agent-nlu-articles/virtual-agent-implementation-checklist-a-deeper-dive/ta-p/2306564
https://www.servicenow.com/community/virtual-agent-nlu-articles/virtual-agent-faqs-up-to-vancouver-release/ta-p/2349558
https://www.servicenow.com/community/virtual-agent-nlu-articles/virtual-agent-faqs-up-to-vancouver-release/ta-p/2349558
https://www.servicenow.com/community/virtual-agent-nlu-articles/virtual-agent-faqs-up-to-vancouver-release/ta-p/2349558
https://www.servicenow.com/community/virtual-agent-nlu-articles/nlu-faq-best-practices-and-general-troubleshooting/ta-p/2305991
https://www.servicenow.com/community/virtual-agent-nlu-articles/nlu-faq-best-practices-and-general-troubleshooting/ta-p/2305991
https://www.servicenow.com/community/virtual-agent-nlu-articles/nlu-faq-best-practices-and-general-troubleshooting/ta-p/2305991


Financial Services 
Remote Tables

Connect your instance on 
the ServiceNow AI Platform

to third-party sources.

Entity View Action 
Mapper (EVAM)

Standardize and 
chart out all data from 

multiple sources.

Instance Data Replication  (IDR)

Keep your records consistent across any instances or organizations in your business. Instance 
Data Replication lets you transfer data from one producer instance to one or more consumer 
instances. Bidirectional (consumer-to-producer) replication is available with IDR, along with 
specific data table selection, localization or translation, and other options.

MetricBase

Make large data easier to handle with MetricBase. This app summarizes information from larger 
data sources, and provides time-based records, analytics, and timed or event-based actions. 
Create graphs of data over time with Reporting  to analyze system trends or incidents, or use 
Workflow Studio  to trigger automated data flows.

MID Server

Communicate and share data with external servers, databases, and applications. The 
Java-based Management, Instrumentation, and Discovery (MID) Server handles various 
communications from your instance to third-party systems. Maintain optimum performance with 
automated upgrades, active server monitoring, and a full troubleshooting knowledge base—all 
included in the MID Server package.

Financial Services Remote Tables

Bring external data into your instance and process it to your specifications with Financial 
Services Remote Tables. Retrieve data from third-party servers or other ServiceNow AI Platform 
instances, with options for caching in local memory. View external data without storage, or use 
script definitions to set up instance cache parameters.

Entity View Action Mapper (EVAM)

Get a standard view of all the data that you work with, using Entity View Action Mapping. The 
EVAM  application enables you to bring multiple data sources together into one view, create 
templates to map data to UX components, write scripts for triggers based on user interaction, 
and more.

Entity View Action Mapper
Entity View Action Mapper (EVAM)  is an application that standardizes how different data sources 
display in cards and lists.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2720



EVAM  enables you to show information as a card grid view or as a list of information in a list 
view. Users can page through large data sets of search results and see different views based on 
filtering.

Prior to EVAM, lists were restricted to a single type of data source. If there were more data 
sources, you would have to write a custom implementation. EVAM enables you ingest multiple 
lists from different data sources, and then configure specific views without the need for 
customization.

EVAM  flow

EVAM  consists of the following:

• Entity (datasource) - The entity that has associated data that you intend to display. For 
example, a community post or a user.

• Map – The mapping process maps the datasource data to component properties that display 
on the card. You can also associate actions that trigger from the card view.

• View – A view is how a card displays data and actions.

• Actions – An entity can have an action that performs on the card. For example, you can 
activate a user into your system.
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Features of EVAM

Use multiple datasources for a single list view

EVAM  can accept multiple disparate datasources and configure the data through 
sorting and filtering to return the data as a single list.

Define view templates

Map the datasource output to a UX component view by using view templates. You 
can configure multiple view templates per datasource based on a condition to 
customize how data displays for users.

Create view configurations to combine conditions, database fields, and declarative 
actions

Create a view configuration to combine conditions, database fields, and declarative 
actions with an associated view template. You can also group view configurations 
together to create configuration bundles.

Enable user interactions to trigger actions

EVAM  enables user interactions to trigger a server script or UXF client action.

What to do

• Define a datasource

• Create an EVAM definition

• Associate a view configuration, view template, and action.

Activation information

EVAM  is a ServiceNow AI Platform  application that is active by default.
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Create a multi-data source list display in Entity View Action Mapper

Use EVAM to take in different datasources, configure views, and show them in a card display 
view.

Before you begin
Role required: admin or evam_admin

About this task
A typical scenario is showing user requests and incidents in a single display view. A user might 
want to see requests that can be made from a catalog, such as a computer order. They also might 
want to see open or closed incidents. These items come from different datasources, but need to 
display through a consistent standard that can be easily configured.

This tutorial runs through creating an EVAM definition with two datasources, a configuration 
bundle for each datasource which contains two view configurations, and associated actions and 
view templates. Many tasks are repeated, instead of repeating each step, the following table lists 
the unique configurations and definitions:

EVAM 
Definition

Datasource 
[Table]

Configuration 
Bundle

Action
Configuration 
View

View Template

Open 
Requests

Open 
Request 
Template

Catalog 
Requests 
[Requested 
Item]

Catalog 
Request 
Bundle

Closed 
Requests

Closed 
Request 
Template

Open 
Incidents

Open 
Incidents 
Template

User 
Requests

Incidents 
Submitted 
[Incidents]

Incidents 
Submitted 
Bundle

Navigation

Closed 
Incidents

Closed 
Incidents 
Template

Procedure

1. Create an EVAM definition for user requests.
An EVAM definition houses datasources, configuration bundles with associated view 
configurations, data filters, actions, and templates. After you initially submit your EVAM 
definition, you will see the related lists to add datasources, configuration bundles, and data 
filters.
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2. Define datasources for your EVAM definition.
Create and link each datasource to the User Request definition. The initial datasource is for 
catalog requests. You can also make one for incidents submitted.

3. Create and link a view configuration bundle.
You should create two configuration bundles, a catalog request bundle and an incidents 
submitted bundle.
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4. Use the Create and Link to add create and add view configurations.

The first one view configuration will be for Open Requests.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2725



5. Create an action definition.
You can use the create and link related list.

6. Create view templates  for requested items and associate with the view configuration.
Here is the template info for the Requested Items Template:

{
 "component": "now-card-evam-record",
 "staticValues": {
  "highlightedHeaderIcon": {
   "key": "clock-outline"
  },
  "highlightedHeaderBkgColor": {
   "key": "positive"
  },
  "imageType": {
   "key": "image"
        },
  "detailLabelOne": {
   "translatable": true,
   "key": "created"
  },
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  "detailLabelTwo": {
   "translatable": true,
   "key": "number"
        }
 },
 "mappings": {
  "highlightedHeaderLabel": "state",
  "titleLabel": "cat_item.name",
  "imageURL": "cat_item.picture",
  "subtitle": "cat_item.short_description",
  "detailValueOne": "sys_created_on",
  "detailValueTwo": "number"
 },
 "actionMappings": {
  "clickAction": "navigation"
 }
}

7. Repeat steps 3-5 to add another view configuration for closed requests.
You created a configuration bundle with one view configuration. Add another configuration 
called Closed requests. This view configuration references the same datasource [requested 
item], but uses different conditions to show ().

8. Associate view templates to view configurations, click Update.

9. View your finished product.

Create an EVAM  definition

Define the list of data sources to render. The EVAM  definition is the main record for an EVAM 
configuration.

Before you begin
Role required: admin or evam_admin

Procedure

1. Navigate to All  > Entity View Action Mapper (EVAM)  > EVAM Definitions, and then click New.

2. On the form, fill in the fields.

Field Description

Name Name of the EVAM  configuration.

Active Option to activate the EVAM  definition.

Sort Order Order the data is ordered on the EVAM  definition. You can select 
Ascending  or Descending.

Application Application scope of the EVAM  definition.

3. Click Submit  and then select your EVAM definition.
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4. In the EVAM Datasource M2Ms  related list, add a datasource.

Option Description

Create and Link
You can define a new data source  and then 
link this datasource to your EVAM definition.

Link Existing
You can add a pre-defined datasource to your 
EVAM definition.

Unlink Selected
You can remove the selected datasource 
from your EVAM definition.

5. Click Submit.

6. In the EVAM View Config Bundle M2Ms  related list, add a configuration bundle.

Option Description

Create and Link
You can define a new configuration bundle 
and then link this bundle to your EVAM defini­
tion.

Link Existing
You can add a pre-defined configuration bun­
dle to your EVAM definition.

Unlink Selected
You can remove the selected configuration 
bundle from your EVAM definition.

After you link the configuration bundles, you can define an order to prioritize the bundles, with 
the lowest number receiving the higher precedence.

7. In the EVAM Data Filters  related list, click New  and fill in the form to add data filters:

Field Description

Label Label name of the EVAM  data filter.

Active Option to activate the EVAM  data filter.

Order Priority that the EVAM  view configuration takes over other view 
configurations. To give higher priority to a view configuration, enter a 
lower number.

Application Application scope of the EVAM  view configuration.

EVAM Definition Associate an EVAM definition with the data filter.

8. Click Submit.

Define a datasource

The datasource is an entity that has associated data that you intend to display. For example, a 
community post or a user.

Before you begin
Role required: admin or evam_admin
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Procedure

1. Navigate to All  > Entity View Action Mapper (EVAM)  > Datasources, and then click New.

2. On the form, fill in the fields.

Field Description

Application Application scope of the datasource.

Active Option to activate the datasource.

Name Name of the datasource.

Table Choose a table to use for the datasource.

Condition Condition to define how to filter the data from the selected table.

Sort By Table column to use for sorting the table data. For example, you can 
select to sort knowledge articles by the creation date.

Note: 
You can only use Sort By  for datetime fields when sorting 
different records.

3. Click Submit.

View configurations, view templates, and configuration bundles for EVAM

A view configuration combines conditions, database fields, and declarative actions with 
an associated view template. You can also group view configurations together to create 
configuration bundles.

EVAM has pre-defined view configurations, view templates, and configuration bundles to make it 
easier to use the feature. The OOB configuration bundles include:

• Service Portal Search Bundle

• Service Portal bundle (sp_bundle)

These bundles have view configurations attached that are anticipated to fit the business unit 
associated. You can also create or edit configuration bundles to meet your needs.

View configurations have an associated view template, tables and conditions, designated table 
field with data, and associated declarative actions. You can look at the demo_evam_dataset for 
examples of OOB configuration views. These view configurations are ready to use and are meant 
to work with many use cases. You can also create or edit view configurations to meet specific 
needs.

The OOB view templates match an associated view configuration. The templates contain the 
JSON used to give the necessary information for the card display and use. For example, the 
Attachment Search Template contains the following:

{
    "component": "sn-search-result-evam-card",
    "staticValues":  {
        "detailLabelType": {
            "translatable": false,
            "key": "inline"
        },
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        "textHeaderLabelOne": {
            "translatable": true,
            "key": "Attachment"
        },
        "detailLabelOne": {
            "translatable": true,
            "key": "From:"
        }
    },
    "mappings": {
        "imageType": "doctype_image_type",
        "icon": "doctype_image",
        "imageURL":"doctype_image",
        "textHeaderLabelTwo": "doctype",
        "title": "ai_search_teaser_title",
        "summary": "ai_search_teaser_text",
        "detailValueOne":"parent_title"
    },
    "actionMappings": {
        "clickAction": "navigation",
        "footerLinkAction": "navigation_to_parent_record"
    }
}

The JSON structure has the following sections:

Template Description

component The card component name.

staticValues The static text mapping to component 
properties. These values have the following 
properties:

• translatable – Determines whether the key 
text should be translated based on the users 
language.Can be either True or False.

• key – The value the property is set to.

mappings The mapping of the datasource field to the 
component properties.

actionMappings The actions that you can associate to the card.

These view templates are ready to use and are meant to work with many use cases. You can also 
create or edit view templates to meet specific needs.

Define an EVAM  view configuration

Create a view configuration to combine conditions, database fields, and declarative actions with 
an associated view template.

Before you begin
Role required: admin or evam_admin
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Procedure

1. Navigate to All  > Entity View Action Mapper (EVAM)  > View Definitions  > View 
Configurations, and then click New.

2. On the form, fill in the fields.

Field Description

Name Name of the EVAM  view configuration.

Active Option to activate the EVAM  view configuration.

View Template Template to associate with the EVAM  view configuration.

Application Application scope of the EVAM  view configuration.

Order Priority that the EVAM  view configuration takes over other view 
configurations. To give higher priority to a view configuration, enter a 
lower number.

Table Table to associate with the EVAM  view configuration.

Condition Conditions for when to use the EVAM  view configuration.

Table Fields Table fields to display on the EVAM  view configuration.

Custom Fields A custom field to display on the EVAM  view configuration.

3. Click Submit.

Define an EVAM  view template

You can configure multiple view templates per datasource based on conditions to customize how 
data displays for users. The view template maps fields from the view configuration to component.

Before you begin
Role required: admin or evam_admin

About this task
The view template is referenced from the EVAM view configuration record. For more information, 
see Define an EVAM view configuration.

Procedure

1. Navigate to All  > Entity View Action Mapper (EVAM)  > View Definition  > View Templates, 
and then click New.

2. On the form, fill in the fields.

Field Description

Name Name of the EVAM  view template.

Application Application scope of the EVAM  view template.

Active Option to activate the EVAM  view template.

Template A JSON template that defines the view for a mapped datasource.

For example, the default search template contains the following:
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Field Description

{
    "component": "sn-search-result-evam-card",
    "staticValues":  {
      },
    "mappings": {
        "title": "ai_search_teaser_title",
        "summary": "ai_search_teaser_text"
    },
    "actionMappings": {
        "clickAction": "navigation"
    }
}

Use sn-search-result-evam-card  as the component for 
search result pages.

3. Click Submit.

Create an EVAM  action definition

You can associate a declarative action with a view template. EVAM  also enables user interactions 
to trigger a server script or UXF client action.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Entity View Action Mapper  > Action Definition, and then click New.

2. On the form, fill in the fields.

Field Description

Action label Display label of the EVAM  action.

Action name Database name for the EVAM  action name.

Implemented as Implementation of the EVAM  action definition. Select one of the 
following:

Server Script

Executes a script on the server, for example, to assign a 
record to someone, or delete a record.

UXF Client Action

Takes action on the client side, such as opening a 
record or making a phone call.

Specify client action
You can choose a pre-defined action. For example, SC Content Items 
KB Article Navigation, to display KB articles.

Note: 
This field appears only if you select to implement the action as a 
UXF client action.
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Field Description

Application Application scope of the EVAM  action.

Active Option to activate the EVAM  action.

Description Description of the EVAM  action.

3. Click Submit.

Define an EVAM  configuration bundle

Create a view configuration to combine conditions, database fields, and declarative actions with 
an associated view template.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Entity View Action Mapper (EVAM)  > View Definitions  > View 
Configurations, and then click New.

2. On the form, fill in the fields.

Field Description

Name Name of the EVAM  view configuration.

Active Option to activate the EVAM  view configuration.

Required Roles Roles to define who can view the EVAM  view configuration

View Template Template to associate with the EVAM  view configuration.

Application Application scope of the EVAM  view configuration.

Order Priority that the EVAM  view configuration takes over other view 
configurations. To give higher priority to a view configuration, enter a 
lower number.

Table Table to associate with the EVAM  view configuration.

Condition Conditions for when to use the EVAM  view configuration. Click Add 
Filter Condition  to select which conditions should be met.

Table Fields Table fields to display on the EVAM  view configuration. You can 
choose from available table fields and move them to Selected. You 
can also order the order they are shown.

Custom Fields A custom field to display on the EVAM  view configuration. You must 
supply a comma-separated list of table fields are required for the 
template.

Instance Data Replication
ServiceNow®   Instance Data Replication  (IDR) copies data updates from one instance, called the 
producer instance, to one or more other instances called the consumer instances. IDR  enables 
you to maintain consistent data across different instances. For example, you can synchronize 
data between different organizations in your company or even between different companies with 
separate instances.
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• Data that is updated on consumer instances can be replicated to the producer instance.

Data, such as problem requests, can be copied to consumer instances for third parties to use. 
The third party can update the problem issue on the consumer instance. The data can then be 
updated on the producer instance.

• Business rules can trigger post-replication workflows, such as generating notifications or 
validating the replication.

• Data that is in transit during a crash is recoverable.

How Instance Data Replication  works

You use the Instance Data Replication  plugin (com.glide.idr) to replicate data updates on one 
instance, called the producer instance, to one or more other instances, called the consumer 
instances.

By configuring a producer replication set, you can specify the tables and table columns on the 
producer instance to replicate. When you configure a consumer data set, you can specify the 
tables and table columns on the consumer instances that receive the producer replication set 
data.

Next, you activate both producer and consumer replication sets to turn on the IDR  functionality. 
The data that is updated in a producer replication set automatically updates the corresponding 
data in the consumer replication sets.

Syncing the producer and consumer replication sets requires that you do a one-time download 
(called seeding) of all the producer replication set data to the consumer instances.

You can initiate seeding requests on a consumer instance when you activate a consumer 
replication set. Beginning with the Rome  release, you can use a filter criterion feature (called 
partial seeding) to restrict the number of records that are seeded. Use partial seeding to divide 
large jobs into smaller jobs when you have a large number of records to duplicate.

After seeding, replication involves data updates only. An audit trail contains a history of those 
record updates.

By default, the table data on a producer instance goes into the tables of the same name on 
consumer instances. Transformation  is the process of replicating producer data in tables or table 
columns that have a different name on the consumer instances.

IDR  adapters  modify data before storing it on consumer instances. Adapters perform string and 
mathematical operations, such as converting one currency to another, or converting one time 
zone to another.
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IDR  overview

Warning: 
IDR  overwrites data on instances and can replicate sensitive data. Avoid potential data loss 
and data exposure, by testing your IDR  implementation in a pre-production environment. 
See data privacy in IDR  for more information.

IDR  and instance upgrades

Upgrading your instance with IDR  enabled is a seamless process.

• IDR  doesn't consume or produce messages during an instance upgrade. IDR  jobs are 
automatically stopped when the upgrade begins.

• The data_replication_queue tracks the timestamp of the last message sent. This ensures that 
replication resumes from the last change made prior to the upgrade.

• Any seeding in progress before the upgrade will be automatically paused when the upgrade 
starts and will resume once the upgrade is completed. To ensure that seeding completes 
without interruptions, avoid initiating a seeding request before an upgrade.

• Seeding requests can't be initiated during an instance upgrade.

• Replication resumes immediately after the upgrade is completed. There is no need to make 
any adjustments to IDR  for record replication to continue.

IDR  limitations and when not to use IDR

• Do not use IDR  to clone instances.

IDR  does not replicate metadata tables, child metadata tables, and most user and system 
tables. IDR  is designed to replicate data, not to clone instances. For example, the Application 
File [sys_metadata] table and tables that extend [sys_metadata] (including the Business Rules 
[sys_script], Catalog [sc_catalog], and Workflow [wf_workflow] tables) are excluded and can't 
be replicated. For details on cloning, see System clone .

• Avoid using IDR  to replicate a series of large attachments on a regular basis. If you need to 
include attachments that are larger than 10 MB regularly, monitor IDR  to ensure that the lag 
time doesn't exceed expectations.

• Avoid continuous replication of CMDB  tables. Replicating CMDB  data as changes occur can 
create performance issues or unforeseen consequences with replication due to the number 
of records involved. If you must replicate CMDB  tables, consider scheduling replication or use 
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conditions to constrain the count of replicated records and ensure all required columns are 
included in the replication set.

• You cannot replicate Edge Encrypted, Column Level Encryption, and Password (2-Way 
Encrypted) fields.

• Additional replication limitations:

◦ Maximum record size is 10 MB.

◦ IDR  supports replicating approximately 1 million records per day.

• Limitations for seeding records:

◦ Replication seeding must not take longer than seven days to complete.

◦ Initial seeding of the tables must not exceed 3 million records per replication set.

Note: 
To overcome these limitations, reduce the number of tables in the seeding request, 
reduce the size of the records, or use partial seeding.

Bidirectional replication for Instance Data Replication

Bidirectional replication in Instance Data Replication  (IDR) enables data to flow from a producer 
instance to a consumer instance and accept data from a consumer instance to flow back to the 
producer instance.

All inserts and changes to records on either instance are sent to the other instance to keep the 
tables identical on both instances. For example, you can enable bidirectional replication for the 
Incidents table to keep incident records synchronized between two instances.

To make data flow bi-directionally, the system creates a producer replication set on the consumer 
instance and a consumer replication set on the producer instance.

Bi-directional replication

If you look at the replication sets on the original producer instance, you see the replication set 
name and the automatically generated consumer instance. It has the same name appended with 
the suffix, -<long-number>-reverse, where <long-number>  is a randomly generated 
number. For example, if Test is the producer replication set name, Test-2034802-reverse 
might be the name of the consumer replication set that is automatically created on the same 
instance. On the original consumer instance, you see the same names. Replication sets with the 
reverse  suffix are read-only.
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You can verify a consumer on a producer instance and a producer on a consumer instance by 
running https://<producer-instance-name>/xmlstats.do?include=idr 
and https://<consumer-instance-name>/xmlstats.do?include=idr  on the 
producer and consumer instances. In the following image, the original producer instance is on 
the left and the original consumer instance is on the right.

Bidirectional replication has the following limitations:

• Auto-conflict resolution is unsupported.

• Merge conflicts happen if producer and consumer instances modify the same record at the 
same time.

The most recent update wins, which means that the data on the consumer and producer 
tables might be different.

• Bidirectional replication supports the Number  adapter but none of the other adapters.

• Bidirectional replication keeps data in sync between producer and consumer instances. 
However, in some scenarios, avoid using bidirectional replication and use one-way replication 
instead.

◦ If you plan to use adapters to differentiate data replicated between two instances, use two 
one-way replication sets to replicate data back and forth instead of using bidirectional sets.

◦ If you need to seed data from one instance to another and vice versa, use two one-way 
replication sets.

• With bidirectional replication, records created on the producer instance are replicated to a 
consumer instance and vice versa. When the record is inserted on the consumer instance and 
it triggers a business rule that updates the record, that update is not replicated back to the 
producer instance.

If you must understand the implications of bi-direction and data transfer between instances, see 
data privacy in IDR  for more information.

Discrete mapping in producer replication sets for Instance Data Replication

Adding discrete mapping to producer replication sets in Instance Data Replication  (IDR) enables 
different consumer replications to be distinguishable.

Every producer replication set has a unique relationship with each consumer subscription. One 
way of distinguishing this relationship is by mapping discrete field values for producer replication 
sets.

Once you enable discrete mapping, you can define for each outbound entry of a replication set 
a discrete value field. An administrator of the producer replication set can define the mapping of 
each consumer subscription by the setting this discrete value.

For example, you might have an ACME corporation as the producer instance, and have 
consumer subscribers of ACME US and ACME Europe. You could set a discrete value of region 
on the outbound replication entries for the incident table. While both of these entries reference 
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the same company table, a rule set for the discrete value can display US for ACME US, and 
Europe for ACME Europe.

If you have bi-direction enabled with discrete mappings, different consumer subscriptions:

• Should never receive records sent from other consumer subscribers

• Should never receive records from a producer intended for other consumers subscribers

With bidirectional replication, records created on a consumer instance are replicated to the 
producer instance and vice versa. When the consumer replicates a record to the producer, the 
consumer's discrete field value that you defined in the producer replication set overrides the 
discrete field value in the consumer record if it's different. For example, say you define a discrete 
mapping using separate regions for each consumer instance as follows:

Discrete mapping using the Region field

Consumer instance Region

Consumer instance A Asia

Consumer instance B Europe

Consumer instance C USA

When a record is manually added to consumer instance B with the Region field set to Asia, bi-
directional replication sends the record from the consumer to the producer to be inserted, but 
the region field is overwritten and the value is changed to Europe. The discrete value that is 
defined in the producer replication set is used instead.

For details on the implications with discrete mappings and data transfer between instances, see 
data privacy in IDR.

Coalesce columns in Instance Data Replication

The coalesce columns feature is used to identify records when you perform data inserts, 
updates, and deletions across instances using Instance Data Replication  (IDR).

By default, the sys_id  field is used to coalesce records in IDR. Beginning with the San Diego 
release, you can choose to use a different field.

Use the coalesce columns feature when records on the consumer instance have a different 
sys_id than the same record on the producer instance. For example, when the record is created 
by Discovery  and loaded into multiple instances. You select the Coalesce  field in the Replication 
Entry form on the producer.

When you select the Coalesce  field, you must verify the following:

• The field that you selected is in the Included Fields on the Replication Entry form on the 
producer instance.

• The field exists with the same name, length, and type on the consumer instance.

Note: 
The Coalesce  field can be different on the consumer instance if you create a valid 
transform for the field.

• The Unique  column value for the field that you selected is set to true  in the Dictionary Entry 
[sys_dictionary] table.

Don’t change the value of the field after it’s set as the Coalesce  field.
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To change the Coalesce  field after it has been set, you must delete the Replication Entry on the 
producer instance and create a new Replication Entry.

If the Coalesce  field doesn’t exist on the consumer instance, the following error is displayed on 
the Consumer Replication Set form. The consumer instance does not recognize 
the <column_name> coalesce field as a valid member of the 
<table_name> table. Create this field or enable a transformation 
with this table to receive updates from the producer table to the 
consumer instance.

Transforms

If transform is enabled on the producer instance, the Coalesce  field on the target table must 
have the same name, type, and length. If any of those parameters don’t match, an error is 
displayed.

If transform is enabled on the producer instance, the mapping is invalid for the Coalesce  field, 
and the consumer syncs entries, the system displays an error on the Consumer Replication Set 
form.

If transform is enabled for a replication entry with a valid mapping of the Coalesce  field and 
then the table schema for the target table is updated so that the mapping is no longer valid, the 
system displays an error on the Replication Entry form.

If a replication entry attempts to enable transform and a valid mapping for the Coalesce  field 
doesn’t exist from the source table to the target table, the system displays an error on the 
Replication Entry form.

Instance Data Replication  set up

Request Instance Data Replication  (IDR) and prepare for IDR  by analysing your data and 
planning your strategy.

Request an Instance Data Replication  subscription

The Instance Data Replication  (IDR) plugin requires a separate subscription and must be 
activated by ServiceNow  personnel.

Before you begin
Role required: admin

About this task
Beginning with the New York  release, IDR  is supported. The IDR  plugin ID is com.glide.idr. When 
purchasing an IDR  subscription, ServiceNow, Inc.  personnel also activate the following plugins 
that IDR  depends upon:

• com.snc.db.data_replicate

• com.glide.transform

• com.glide.kmf

IDR  runs in ServiceNow  data centers only, which means there is no support for using IDR with on-
premise instances.

To purchase a subscription, contact your ServiceNow  account manager. The account manager 
can arrange to have the plugin activated on your organization's production and subproduction 
instances, generally within a few days.

If you don't have an account manager, decide to delay activation after purchase, or want to 
evaluate the product on a subproduction instance without charge, follow these steps.
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Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. On the All Applications page, select Request Plugin  to open the Activate Plugin  form on Now 
Support.

3. On Now Support, select the link to access the Now Support  Service Portal  Service Catalog.

4. Select your instance.

5. Select Actions > Activate Plugin.

6. On the Activate Plugin  form, provide the following information.

Activate Plugin form

Field Description

What is your target instance Instance on which to activate the plugin.

Which plugin would you like to activate Name of the plugin to activate.

Note: 
If the system does not list the plugin you 
want or if you are activating the plugin 
on an OEM or on-premise instance, 
select the Plugin I'm looking for is not 
listed  check box and then enter the 
name of the plugin.
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Field Description

Select Maintenance Date and Time The date and time to activate the plugin.

Note: 
Plugins are activated in two batches, 
once in the morning and once in the 
evening, on every business day in the 
US Pacific time zone. If the plugin must 
be activated at a specific time, enter the 
request in the Reason/Comments  field.

Example 

For example, see the following form to activate the CSM Workspace plugin on an instance 
named My Instance.

Activate Plugin form

7. Select Submit.
For additional details about requesting a plugin, see Requesting a Plugin from the Service 
Catalog [KB0751715] article in the Now Support  Knowledge Base.

What to do next
Create and activate a producer replication set.

Related topics

List of plugins (Washington DC)

Preparing for Instance Data Replication

Before you set up Instance Data Replication  (IDR), analyze the tables and columns in the 
producer and consumer instances to replicate data successfully.

Deciding which tables to replicate

Before you create a producer replication set, decide which tables to replicate. Avoid replicating 
system tables (tables with a sys_ prefix). If you replicate system tables (like sys_user, 
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sys_user_group, or sys_user_grmember) that have existing data in the consumer instance, insert 
and update failures can occur during replication. If you decide to replicate these tables, you may 
have additional work afterwards to clean these tables.

Avoid replicating CMDB  tables. Replicating CMDB tables can create performance issues 
or unforeseen consequences with replication due to the number of records involved. If you 
determine the CMDB tables must be replicated, use conditions to constrain the count of 
replicated records and ensure all required columns are included in the replication set.

For a list of tables you should avoid replicating, see Excluded tables in Instance Data Replication.

Analyzing table hierarchies

For each table you want to replicate, determine if the table is a parent or child table. If the table 
belongs to a parent-child hierarchy, decide if you want to preserve the hierarchy and what 
strategy you want to use to move the hierarchy from the producer to the consumer.

Important: 
To maintain data integrity and ensure that reference fields are populated on the consumer 
as you'd expect, you must replicate all of the parent and child tables in the table hierarchy.

See Preserving table hierarchy in Instance Data Replication.

Analyzing table relationships

For each table you want to replicate, determine if the table has reference fields that point to other 
tables. If you are replicating a table with a reference field that points to another table, but you 
don’t include that table in your replication set, the reference field will be empty in the record on 
the consumer instance. Replicating table relationships maintains data integrity and ensures that 
reference fields are populated on the consumer as you'd expect.

Organizing replication sets

As part of the planning phase, determine how you want to organize your replication sets and the 
tables they contain.

• Create a single replication set for each table. This option requires more setup, configuration, 
and time management, but allows you to pause replication for a single table without impacting 
other tables.

◦ Replication is performed in parallel using multiple jobs.

◦ Throughput metrics are easier to track with separate replication sets.

◦ When an error occurs, replication for a single table is affected instead of all multiple tables.

• Create a replication set for a group of related tables. This option is easier to set up and 
manage, but oversight and potential issues impact all tables in the group.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2743



◦ If you need find information about replication status, the logical name you use for this 
replication set might be easier to find and understand compared to using distinct replication 
sets for each table.

◦ If you want to pause replication, you can do so for the entire group of tables by pausing 
replication from one replication set.

◦ If a replication issue occurs on one table and replication stops, this stops replication for all 
tables in the replication set.

If you decide to group tables in a single replication set, try to limit it to five or fewer tables. If you 
have more than five tables to replicate, use multiple replication sets with five or fewer tables in 
each set.

Deciding which columns to replicate

For each table you want to replicate, decide which columns to include. Avoid including every 
column in your replication set by default. Instead, decide which columns are necessary, and 
exclude any sys_ columns or other columns that are updated by scripts automatically.

For example, if you include a column updated by the system automatically on a frequent basis, 
IDR  may replicate data more often than necessary. When the system replicates this data, it can 
negatively impact the capacity subscription. Periodically check the IDR License and Usage 
Details  dashboard to monitor the message count that is generated from the producer.

Preparing target tables on the consumer instance

By default, IDR  uses a record's sys_id field as the lookup value to keep data synchronized 
between the producer and consumer instance. If the target table contains existing data or 
records from prior data imports, the sys_id values in the consumer don't match the sys_ids from 
the producer instance.

Always consider the producer instance as the source of truth. For optimal replication results, 
follow these guidelines:

• Make the producer instance the exclusive data source for the consumer instance.

• Prior to replication, ensure that the target table in the consumer instance is empty. Ideally, the 
initial records in the target instance are created from data sent exclusively from the producer 
via a replication set or a clone.

• Ensure that there are no other ongoing data imports or updates to target tables on the 
consumer instance after replication starts.

For example, if users from LDAP are imported to the consumer instance using a different data 
source, the sys_ids for those records don't match the sys_id values in the producer instance. 
In this scenario, existing user records in the target table on the consumer aren't updated and 
duplicate records are created.

In situations where this cannot be avoided, clean the tables on the consumer instance prior 
to replication. You must delete the records in the target table or ensure the sys_id values in 
producer and consumer are the same.

Alternatively, you can use a custom Coalesce  field to identify unique records (instead of the 
default sys_id column) for replication. Use a custom Coalesce  column when records on the 
consumer instance have a different sys_id for the same records on the producer instance. 
For more information on using a custom Coalesce, see Coalesce columns in Instance Data 
Replication.
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Reviewing business rules

You can use business rules to trigger workflows after replication, such as sending a notification 
or validating the replicated data. Review any business rules on the consumer instance that might 
prevent the idr.system user from inserting, updating, or deleting records in the target table.

If failures related to business rules occur, they appear in the Instance Data Replication  > 
Replication Payload Error  table on the consumer instance. View the Error Message  field for 
details on the script that is causing the failure.

With bidirectional replication, records created on the producer instance are replicated to a 
consumer instance and vice versa. When the record is inserted on the consumer instance and 
it triggers a business rule that updates the record, that update is not replicated back to the 
producer instance.

Reviewing ACLs

Review the ACLs in place on the target table in the consumer instance to ensure that IDR  can 
replicate data successfully. Confirm that the idr.system user has the appropriate roles for the 
target table.

If failures related to ACLs occur, they appear in the Instance Data Replication  > Replication 
Payload Error  table on the consumer instance. View the Error Message  field for details on the 
ACL that is causing the failure.

Reviewing data policies

Review any data policies in place on the target table in the consumer instance to ensure that IDR 
can replicate data successfully. Confirm that the data you are replicating satisfies the data policy.

If failures related to data policies occur, they appear in the Instance Data Replication  > 
Replication Payload Error  table on the consumer instance. View the Error Message  field for 
details on the data policy that is causing the failure.

Preserving table hierarchy in Instance Data Replication

Decide if you want to replicate a parent-child table hierarchy and what strategy to use for 
replicating the data in Instance Data Replication  (IDR).

Before you create a replication set, determine if the table that you want to replicate is part of a 
parent-child table hierarchy. If it is, decide if you want to preserve the hierarchy and whether to 
replicate the data from the parent perspective (retaining only columns belonging to the parent 
table) or from the child perspective (retaining all columns that belong to the child tables). Review 
the following available strategies.

Strategy 1: Preserve the entire hierarchy and replicate child columns

You can preserve the entire hierarchy, including all of the child table columns, by 
creating an outbound entry for each child table, and specifying a sys_class_name 
filter for each child table.

For example, to replicate the Task table and ensure that all of the columns from all of 
the child tables are included, specify the following:

Outbound entries

Table Filter

Task sys_class_name=task
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Outbound entries  (continued)

Table Filter

Incident sys_class_name=incident

Problem sys_class_name=problem

Change Request sys_class_name=change

And so forth, for all of the child tables, including filters with each table for the 
sys_class_name.

With this strategy, records are inserted into each child table on the consumer, 
including data from the columns that belong to each child table on the producer.

Strategy 2: Preserve the hierarchy, but don't replicate child columns

To preserve the hierarchy but only replicate columns from the parent table, replicate 
the parent table and include the Class Name [sys_class_name] field in the Included 
Fields  list. Including the Class Name field maintains the distinction between parent 
and child records on the consumer instance.

For example, if you want to replicate the Task table and its children (Incident, 
Problem, Change Request), but only replicate the columns that belong to the Task 
table, specify the following:

Outbound entry

Table Included Fields

Task Class Name

In this strategy, the sys_class_name column on the consumer Task table receives 
entries for the parent table (task) and child tables (incident, problem, and change), 
and records are inserted into the respective child tables on the consumer. However, 
without the sys_class_name filter, the columns that are unique to each child table 
are not replicated.

Strategy 3: Ignore the hierarchy, and only replicate parent table data

To ignore the hierarchy and only replicate parent records, replicate the parent table 
and exclude the Class Name [sys_class_name] field from the Included Fields  list. 
Excluding the Class Name field removes the distinction between parent and child 
records on the consumer instance. All replicated records on the consumer will be 
parent table records.

For example, if you want to replicate records from the Task table and simply 
consider all records as tasks for reporting or auditing purposes, specify the 
following:

Outbound entry

Table Included Fields

Task Any fields except for Class Name

In this strategy, when you replicate the Task table, all replicated records have a 
value of task in the sys_class_name column, and no columns belonging to the child 
tables are replicated.
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Upgrading legacy replication sets to V2 in Instance Data Replication

Improve message processing and replication performance by upgrading your legacy replication 
sets in IDR  to V2.

Legacy and V2 replication sets

Important: 
Legacy replication sets are planned for deprecation by the Zurich release. To continue 
replicating data, you must upgrade all legacy replication sets to V2.

• Legacy replication sets use a ServiceNow  Kafka message transport and delivery 
implementation that was created prior to the Utah  release. All replication sets created prior to 
the Utah  release are considered legacy replication sets.

Beginning with the Washington DC  release, you can no longer create legacy replication sets.

• V2 replication sets use the ServiceNow  Hermes Messaging Service  for Kafka message 
transport and delivery, which replicates data faster, at scale, and with high reliability. The 
Hermes Messaging Service  is a ServiceNow AI Platform  capability that's automatically 
enabled when the IDR  plugin (com.glide.idr) is activated. All replication sets created after the 
Washington DC  release are V2 replication sets.

Note: 
Data sent from a V2 producer replication set is retained in the message queue for 24 hours.

Upgrading legacy replication sets

Upgrade your eligible legacy replication sets to V2 to take advantage of the benefits provided 
by Hermes. Upgrading replication sets from legacy to V2 is a seamless process. Active data 
replication from the producer to consumer continues throughout the upgrade, which means you 
don't need to pause replication before you begin. Replication continues using the V2 replication 
sets after the upgrade is finished.

You can either create new V2 replication sets or upgrade existing legacy replication sets to V2. 
See Upgrade legacy replication sets in Instance Data Replication.

Upgrade eligibility

Legacy replication sets are eligible for upgrade to V2 when both the producer and consumer 
instance are on Utah  or higher. Note that some Utah  legacy replication sets aren't eligible for 
upgrade to V2, depending on their configuration (for example, the replication set can't be 
bidirectional or discrete).

You can confirm upgrade eligibility by viewing the producer replication set and checking the 
Upgrade Eligibility  column in the Consumer Subscriptions related list.

• If the value for each subscribed consumer is Eligible, you can begin the upgrade process by 
following the steps in Upgrade legacy replication sets in Instance Data Replication.

• If the value for a subscribed consumer is Not eligible, this means that either the consumer 
instance isn't on Utah  or higher, or the consumer replication set is on Utah, but isn't eligible for 
upgrade to V2 because of its configuration.

For details on which types of legacy replication sets are eligible for upgrade in Utah, refer to the 
"Upgrading legacy replication sets to V2" topic in the Utah  version of the IDR  documentation.
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Compatibility

V2 producer replication sets are compatible only with V2 consumer replication sets.

If you upgrade a producer replication set to V2, you must upgrade the subscribed consumer 
replication sets to V2 as well to take advantage of the V2 processing improvements.

Upgrade legacy replication sets in Instance Data Replication

Replicate high volumes of data faster and more reliably by upgrading your Instance Data 
Replication  (IDR) legacy producer and consumer replication sets to V2.

Before you begin
Role required: admin

About this task

Important: 
Legacy replication sets are planned for deprecation by the Zurich release. To continue 
replicating data, you must upgrade all legacy replication sets to V2.

Procedure

1. On the producer instance, navigate to Instance Data Replication  > Producer Replication Sets.

2. Select a producer replication set that you want to upgrade.

3. Verify that the producer replication set is eligible for upgrade by checking the Upgrade 
Eligibility  column on the Consumer Subscriptions related list.

◦ If the value for each consumer is Eligible, you can upgrade the replication set.

◦ If the value for any consumer Not eligible, this means that either the consumer instance isn't 
on Utah  or higher, or the consumer replication set is on Utah, but isn't eligible for upgrade to 
V2 because of its configuration. See Upgrade eligibility  for more information.

4. Create a V2 producer replication set.

a. On the Producer Replication Set form, select Upgrade.

b. In the dialog box, either accept the default name or enter a unique replication set name.
By default, the system appends -V2 to the legacy replication set name, but you can use any 
valid set name to differentiate the V2 version from the legacy version.

c. Select OK.

The legacy producer replication set is copied to create a V2 producer replication set. The 
producer instance sends metadata to the consumer instance, which enables you to upgrade 
the legacy consumer replication set.

5. On the consumer instance, navigate to Instance Data Replication  > Consumer Replication 
Sets.

6. Select the legacy consumer replication set that's subscribed to the producer replication set 
you upgraded.

7. Upgrade the legacy consumer replication set.
If the Begin upgrade  button doesn't appear on the Consumer Replication Set form, resend the 
metadata from the producer replication set:
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a. Select Begin upgrade.

b. On the producer instance, navigate to Instance Data Replication  > Producer Replication 
Sets.

c. Select the new V2 producer replication set.

d. Select the check box next to the consumer subscription in the Consumer Subscriptions 
related list.

e. Select the Actions on selected rows  list.

f. Select Resend Metadata.
The V2 consumer replication set is created, and the producer instance sends metadata 
replication entries to the consumer instance. After all the entries are received, the Start dry 
run  button appears on the Consumer Replication Set form.

8. Confirm that the consumer instance can connect to the Hermes Messaging Service  and that 
replication succeeds by selecting Start dry run.
Data is consumed from the Kafka topic by the consumer instance but not persisted in the 
database yet.

9. Complete the upgrade by activating the V2 consumer replication set with or without data 
integrity checks.

◦ Ensure that the legacy and V2 topics are in sync by selecting Finish upgrade.

This option ensures that IDR performs all necessary data integrity checks before activating 
the V2 consumer replication set. If any data integrity checks fail, the upgrade is automatically 
rolled back to prioritize data consistency.

◦ Complete the upgrade without data integrity checks by selecting Finish upgrade without 
sync.

This option allows you to complete the upgrade for replication sets where the consumer 
replication is lagging or no records have been replicated to the V2 topic. However, it may skip 
replicated records or attempt to duplicate replication. If you have concerns over missing or 
mismatched records, you can create a data comparison request to reseed those records.

Note: 
If the Finish upgrade  button doesn't appear on the Consumer Replication Set form, 
contact Customer Service and Support.

The V2 consumer replication set is activated and the legacy consumer replication set is 
automatically deactivated.

10. After all subscribed consumers are upgraded to V2, deactivate the legacy producer replication 
set.

Note: 
Legacy consumer replication sets stop consuming when you deactivate the legacy 
producer, so you must ensure all subscribed consumers are upgraded to V2 before you 
deactivate it.

a. On the producer instance, navigate to Instance Data Replication  > Producer Replication 
Sets.

b. Select the legacy producer replication set that you upgraded.

c. Select Deactivate.

d. Confirm deactivation by selecting OK.
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Result
The legacy producer and consumer replication sets are upgraded to V2 and the upgrade 
status changes to Up to date. Data replication continues based on the last message ID that was 
processed by the legacy replication set.

Rolling back an upgrade in Instance Data Replication

If a problem occurs during an upgrade to V2, the upgrade is rolled back in Instance Data 
Replication  (IDR).

Important: 
Legacy replication sets are planned for deprecation by the Zurich release. To continue 
replicating data, you must upgrade all legacy replication sets to V2.

If you upgrade a legacy replication set to V2 and a problem occurs with the upgrade, the upgrade 
is automatically rolled back to ensure data consistency. If a processing delay caused the issue, 
you can try the upgrade again.

For example, when the consumer instance identifies the most recent message in the legacy 
topic, but can’t find that same message in the Hermes  topic, the upgrade is rolled back. If you 
attempt the upgrade again and the consumer instance successfully finds the most recent 
message in the Hermes  topic, the upgrade continues, and processing begins only from the 
Hermes  topic.

• If the legacy consumer job is still processing records that were replicated prior to when the 
upgrade started replicating to both the legacy and the Hermes  topics, the upgrade is rolled 
back. In this scenario, allow time for the consumer to process the replication backlog and then 
try the upgrade to V2 again. For example, if the lag persists after 30 minutes, wait another 2 
hours and try again, or wait 24 hours and try again.

• If no records are being replicated from the producer to the Hermes  topic after the upgrade 
starts, wait and retry the upgrade after allowing at least one record to replicate from the 
producer to the consumer. Alternatively, you can manually trigger replication by making a 
change to at least one record.

• If you want to complete the upgrade without data integrity checks, you can use the Finish 
upgrade without sync  option after performing the dry run.

This option allows you to complete the upgrade for replication sets where the consumer 
replication is lagging or no records have been replicated to the V2 topic. However, it may skip 
replicated records or attempt to duplicate replication. If you have concerns over missing or 
mismatched records, you can create a data comparison request to reseed those records.

Configuring Instance Data Replication

Configure producer and consumer replication sets, and then modify records or mappings as 
necessary in Instance Data Replication  (IDR).

Create a producer replication set in Instance Data Replication

Specify the tables and columns on the producer instance that you want to replicate in Instance 
Data Replication  (IDR).

Before you begin
Verify that the producer and consumer instances belong to the same customer.

Plan your data replication strategy by reviewing the important considerations described in 
Preparing for Instance Data Replication.

Role required: idr_admin or admin

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2750



About this task
Creating the producer replication set is the first step of setting up Instance Data Replication. 
Seeding is the initial download of all the records in the producer replication set to the tables in 
the consumer replication set. After seeding, Instance Data Replication  (IDR) only replicates data 
updates. The seeding limitations are:

• The maximum record size is 10 MB.

• The maximum seeding size is 3 million records.

Note: 
If your replication set contains more than 3 million records, seeding cannot start. To fix 
this situation, break the replication set into multiple replication sets with fewer records in 
each or use partial seeding.

• The maximum seeding time is 7 days.

Seeding replication sets

Procedure

1. On the producer instance, navigate to Instance Data Replication  > Producer Replication Sets 
and click New.

2. On the form, fill in the fields.

Producer Replication Set form

Field Description

Name Names can only contain alphanumeric 
characters and hyphens.
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Field Description

Note: 
The consumer replication set must 
have the same name as the producer 
replication set, so the name should not 
be producer-specific.

Bi-Directional Option to enable bi-directional replication 
on consumer instances. Bi-directional 
replication enables changes to records made 
on the consumer instance to propagate to 
the producer instance. If you want to set up 
a producer replication set with bi-direction 
for consumer instances, see Bidirectional 
replication.

Discrete Option to enable discrete mapping from 
a producer replication set. This mapping 
distinguishes different consumer instances. 
For more information, see create discrete 
mappings for a producer replication set.

Description Description of the replication set.

Entry Set Set of outbound entries. If you imported an 
update set from another instance or you 
created one earlier on your instance, you can 
choose an existing entry set.

After you submit the Producer Replication Set form, the system auto-generates the producer 
ID. The Producer ID  field identifies the producer instance in the system.

3. To add outbound entries to your producer replication set, click the Outbound Entries  tab and 
click New.

4. On the form, fill in the fields.
For each outbound entry, you must select a source table from the producer instance to 
replicate data records. You can also select associated table columns, include attachments to 
records, and set filter conditions for each source table.
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Replication entry form

Field Description

Source Table Name Name of one of the tables on the producer instance to replicate. For 
example, SAN Disk [cmdb_ci_san_disk].

Filter Filter criteria to control the records in the table that the system is 
replicating.

◦ Use the filter to limit the number of records in your replication set. 
For example, if the table has an Active  field, add a filter condition 
like [Active] [is] [True]  to replicate only active records.

◦ If you want to replicate and preserve a parent and child table 
hierarchy, add a filter for the sys_class_name column to each 
outbound entry. This ensures that all of the child table columns are 
replicated, and not just the parent the columns.

For example, to replicate both the Task [task] parent table and the 
Incident [incident] child table, you must add [Task type] [is] [Task] 
as a filter in the parent table entry and [Task type] [is] [Incident] 
as a filter in the child table entry. In this example, Task type is the 
label for the sys_class_name column on each table. For details, see 
Preserving table hierarchy in Instance Data Replication.

Include Attachments Option to replicate the files associated with the records that you are 
replicating.

Included Fields Fields to include. Move table fields into the Selected column to 
replicate them or into the Available column to prevent replicating 
them.

Note: 
The system must replicate some fields, such as sys_id 
(Mandatory). The system cannot replicate some fields, such as 
Edge Encrypted  and Password1. They do not appear in either 
column.

Enable Custom 
Coalesce

Option to enable you to choose a field other than the default sys_id 
field to coalesce IDR.

Coalesce Field
Choose a field to use to coalesce IDR. Only unique fields are 
available. See Coalesce columns in Instance Data Replication.

This field only displays if you select Enable Custom Coalesce.

5. Select Submit.

Note: 
If the table that you add to the replication set has child tables, add the child tables to the 
replication set to maintain data integrity.

6. Repeat step 3 for each table that you want to include in the replication set.
After you submit, the Activate  button is added to the form.

7. Select Activate.
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Replication can't happen until you link the producer replication set to one or more consumer 
replication sets. Activating the producer replication set makes the producer data available for 
replication to consumers.

8. Select the Notification Configuration  related link and choose a tab to configure notification 
details.

Option Description

When to send

Specify the conditions for sending a notifica­
tion.

◦ Record inserted or updated— You can 
send notifications when records are updat­
ed or inserted.

◦ Event is fired—Specify the event type that 
sends the notification.

◦ Triggered—A notification is sent when trig­
gered by a ServiceNow®  Flow Designer 
flow. For more information, see Flow Design­

.

Who will receive
Send notifications to users, groups, or user 
groups in the fields on the ServiceNow  record 
that generates the notification.

What it will contain

You can choose an email template to popu­
late the Subject and Message HTML. You can 
also override the template and customize the 
text as appropriate.

What Digest will contain
If you select Allow Digest, you can configure 
an email digest interval through the Digest In­
terval module in System Notification.

9. Select Update.

10. To see a preview of the notification, select Preview Notification.

11. To discard the Producer Replication Set, select Delete.

Result
The producer is ready to send the data that is specified in the replication set to one or more 
consumer instances.

What to do next

• For information about creating and activating the consumer replication set, see Create and 
activate a consumer replication set.

• For information about granting access to the replication data, see Grant access to replication 
data.

After creating a consumer replication set, you must ask for permission to receive the producer 
replication data. See Grant access to replication data  to learn how to grant or deny access.

• If you believe that a consumer set should no longer receive replication data, you can revoke 
the consumer set access.
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Create a consumer replication set for Instance Data Replication

Create a consumer replication set to specify the tables and columns on a consumer instance 
that receive the producer data in Instance Data Replication  (IDR).

Before you begin

• Create and activate a producer replication set.

• Reduce latency by ensuring that the producer and consumer instances are in the same 
geographic region and belong to the same customer. You can replicate data between 
instances across different geographic regions. However, replication latency can occur when 
instances are located in data centers in separate regions.

• Role required: idr_admin or admin

About this task
Create a consumer replication set and link it to a producer replication set. IDR  replicates data 
from the producer to the tables and table columns of the same name on the consumer instance. 
The administrator of the producer replication set must grant the consumer instance access to the 
replication data.

If the producer replication set administrator generates a new encryption key, the encryption key 
value that is stored in the consumer replication set might not automatically update. If it does not 
update, replication stops. To restore access, see Restore access to replication data.

Procedure

1. On a consumer instance, navigate to Instance Data Replication  > Consumer Replication Sets.

2. Select New.

3. On the form, fill in the fields.

Consumer Replication Set form

Field Description

Producer Instance URL URL of the producer instance. For example, 
https://<producer_instance>.servicenow.com.

Producer Replication Set Name Name of the consumer replication set. The 
name on the consumer must match the name 
on the producer. Obtain the name from the 
producer administrator.

Description Description of the purpose of the replication.

4. Select Submit.
The list of all consumer replication sets appears. The system sends a request to the producer 
replication set administrator to approve or deny your request for a shared encryption key.

Warning: 
Do not change any of the values.

5. In the list of all consumer replications sets, select the replication set.
The Consumer Replication Set displays the replication set information.
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The Consumer Approval Status shows Approval Pending. The producer administrator must 
approve your request to be a consumer.

Note: 
If you receive an error saying that your encryption key does not work, contact Customer 
Service and Support.

6. Wait until the producer administrator approves the request.
The Consumer Approval Status changes to Approved. For more information, see Grant access 
to replication data.

7. Refresh the browser page.
The system replaces the Request Producer Approval  button with the Activate  button.

8. To update the Consumer Replication Entries configuration on the consumer to match 
the configuration on the producer after you receive confirmation, click the Synchronize 
Replication Entries  related link.
If you do not see this option, refresh the page.
A dialog box confirms the synchronization. The tables that you select for replication in the 
producer replication set are replicated in the consumer replication set and appear on the 
Inbound Entries  tab. The initial seeding of all the table data may take some time. After initial 
seeding, only data updates are replicated to consumer replication sets. For more information 
about seeding, see Seed a consumer instance.

9. To configure who receives replication notifications, click the Notification Configuration  related 
link.

10. On the form, fill in the fields.

Replication Set Error Notification form

Field Description

When to send Trigger for sending a notification.

Who will receive Person who receives the notifications.
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Field Description

What it will contain Notification content.

11. Select Update.

12. Activate the consumer replication set.

a. Select the consumer replication set that you want to activate.

b. Open the Inbound Entries  tab.

c. Select Activate.

After some time, the Status is Active Replication, and the Partial Seeding  and Full Seeding 
buttons are displayed. With both seeding options, IDR  generates audit trails of all record 
updates. If you encounter an error during seeding, see Fix seeding errors. For more information 
about seeding, see Seed a consumer instance.

13. Optional:  To discard your seeding request before clicking Activate:

a. On the Seeding Requests  tab, click a seeding request.

b. On the Seeding Request form, click Cancel.

14. Optional:  To modify the behavior of the consumer, click a source table name on the Inbound 
Entries  tab.

a. To preserve the user name in an Activities entry, select the Preserve Modified By  option on 
the Inbound Entry form.

(Optional) For example, the Work Notes  field is an Activity type in change request records. 
When a user updates a change request, the work note moves into the Activities stream.

▪ If you do not select Preserve Modified By, Instance Data Replication  appears in place of 
the user name in the consumer records.

▪ If you select Preserve Modified By, the user who updated the change request is identified 
in the entry and the system prepends IDR  to their name.

When replicating changes, Preserve modified by  affects values for the Updated by, 
Updated, Created, and Created by  system fields:
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▪ When Preserve modified by  is enabled and you include system fields in the producer 
replication entry, producer system field values are replicated to the consumer records. If 
you do not include system fields in the producer replication entry, default system values 
from the consumer instance are used instead.

▪ When Preserve modified by  is disabled, default system field values from the consumer 
instance are used, which means they may not match the system field values in records on 
the producer.

When seeding data, the Preserve modified by  setting has no effect:

▪ If you include system fields in the producer replication entry, producer system field values 
appear in the seeded records.

▪ If you do not include system fields in the producer replication entry, null values appear in 
the system fields for seeded records.

b. To run business workflows after a replication, select the Run Business Rule  option.

(Optional) A business rule is a server-side script that is associated with a table. Use 
business rules to trigger workflows that are associated with replications, such as sending 
a notification or validating the replicated data. For more information, see Trigger workflows 
after replication.

c. To replicate the data from the producer tables into tables with different names on the 
consumer instance, click Enable Transform.
For more information, see Transform replication data.

d. Click Update.

What to do next
The consumer instances contain, at a minimum, the current data in the producer replication set 
tables. The consumer instances are now ready to accept replicated data updates. By default, the 
data in the producer tables is replicated into tables and table columns of the same name on the 
consumer instances. For more information about how to map the data into different tables and 
table columns and how to modify the data as it is replicated, see Transform replicated data.

• Map the replication data to different tables  on the consumer instance.

• Modify the values  during replication.

• Set up business rules to trigger post-replication workflows.

Seed a consumer instance for Instance Data Replication

Seed all or some of the tables in your Instance Data Replication  (IDR) replication sets depending 
on the needs of your consumer instance.

Before you begin
Role required: idr_admin or admin

About this task
Seeding replicates existing records from the producer instance to the consumer instance. You 
can initiate seeding requests on a consumer instance while you are activating a consumer 
replication set. Seeding options are not available in bi-directional or discrete replication sets by 
design.

You can select either full seeding or partial seeding.
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• Full seeding replicates all existing records from a table in the producer instance. Perform a full 
seeding when you want to replicate all existing records.

• Partial seeding enables you to filter and replicate specific records from the producer. Perform a 
partial seeding when you want to replicate only some of the records from the producer.

The producer instance handles one seeding request at a time. When the producer instance is 
busy with a seeding request, subsequent seeding requests are queued and initiated in the order 
that they are received.

• Records that exist on the producer instance and not on the consumer instance are copied to 
the consumer instance.

• If the sys_id on the producer matches an existing record on the consumer instance, the entire 
record on the consumer instance is updated to match the producer.

• The sys_id of the record identifies the record on both instances. If you use the custom 
coalesce option, the field you select is used to coalesce records in both instances.

• If a replication set changes and no longer includes a table, IDR  does not alter the records in 
the corresponding table on the consumer instances.

If you encounter an error during seeding, see Fix seeding errors.

• Seeding continues even if errors occur on some consumer tables. You can restart seeding 
specifically on the tables that have errors or on all tables in a replication set.

• The maximum for a retry reseeding request is 10,000 errors. If you have more errors, perform a 
full seeding.

Do not retry full seeding if the data set exceeds any of the following limitations:

• Record size exceeds 32 MB

• Seeding request exceeds 3 million records

• Replication takes longer than seven days to complete

Note: 
Seeding is not a replacement for cloning. Do not use IDR  to clone instances.

Procedure

1. On the consumer instance, navigate to Instance Data Replication  > Consumer Replication 
Sets  and click a consumer replication set.

2. On the Inbound Entries  tab, select the entry or entries that you want to initiate seeding for.

3. To initiate a full seeding, click Full Seeding.
A dialog box opens stating that the system is requesting all matching records.

4. To configure a partial seeding, click Partial Seeding.

a. If you selected more than one entry, select the Replication entry that you want to configure 
and select Configure Seeding.

b. Configure one or more Custom Filter conditions, operators, and values.

c. To download the current field values and to replicate the files that are associated with the 
records, select Include Attachments.

d. To download the current field values and the history of all field updates, select Include 
History.
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e. In the Included Fields columns, use the arrows to move table fields into the Selected column 
to replicate them or into the Available column to prevent replicating them.

f. Click Save Configuration.

g. Configure other Replication entries as needed.

h. When you are ready to initiate seeding, click Request Partial Seeding.

Note: 
The Custom Filter determines which records to include in the partial seeding request.

The system must replicate some fields, such as Sys ID. The system cannot replicate 
some fields, such as Edge Encrypted  and Password. They do not appear in either 
column.

5. To discard your seeding request before you click Request Partial Seeding, click Cancel.

Result
In a successful seeding, all selected data on a producer instance is replicated on a consumer 
instance. After seeding, the consumer instance maintains a history of all field updates.

Trigger a workflow after replication using Instance Data Replication

Use platform business rules to trigger workflows after replication using Instance Data Replication 
(IDR).

Before you begin
Role required: idr_admin or admin

About this task
Inserts and updates that are replicated to a consumer instance can trigger business rules 
configured on the target table. A business rule is a server-side script that is associated with 
a table. Use business rules to trigger workflows that are associated with replications, such as 
sending a notification or validating the replicated data.
Business rules are part of the ServiceNow AI Platform. For more information, see Business 
rules .

Procedure

1. On a consumer instance, navigate to Instance Data Replication  > Consumer Replication Sets 
and click a consumer replication set.

2. On the Inbound Entries  tab, click a replication set table.

3. Select the Run Business Rule  option.

4. Repeat this procedure for the other tables in the replication set.

5. Click Update.
IDR  invokes the business rules that are associated with the specified table after replicating the 
data to the table.

Reconfigure a replication set in Instance Data Replication

If you must change or update your original replication set, reconfigure Instance Data Replication 
(IDR) replication sets on the producer instance.

Before you begin
Role required: idr_admin or admin
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About this task
After activating a revised producer replication set, update the producer replication set name, 
shared key, producer ID, and producer set ID on each consumer instance.
Note the following important information:

• Make sure that a seeding request is not in progress before you reconfigure a producer 
instance. Check the consumer replication sets seeding requests status.

• If you make a change to the producer replication set, you must re-synchronize the consumer 
replication set. On the consumer instance, click Synchronize Replication Entries, and then 
click Activate.

Procedure

1. Reconfigure a producer instance:

a. On the producer instance, navigate to Instance Data Replication  > Producer Replication 
Sets.

b. Select a producer replication set and make one or more of the following changes to the set:

▪ To add a table to the set, on the Replication Entries  tab, click New.

▪ On the Replication Entries  tab, click a replication set. In the Replication Entry form, modify 
the columns that are included in the replication set, and click Update.

▪ To remove the table from the replication set, on the Replication Entries  tab, click a 
replication set and click Delete.

▪ To change the shared encryption key, click Generate New Shared Key.

Only generate new shared keys when you discover that they are compromised or if 
you want to stop sending data to a consumer. After changing the encryption key on the 
producer instance, consumers that have the Consumer Approved Status of Denied must 
reapply for access to the producer replication set. For more information, see Grant access 
to replication data.

These changes stop replication and produce this status message on the consumer instance: 
Producer Replication Set configuration has been modified.

2. Navigate to Instance Data Replication  > Consumer Replication Sets  and click the consumer 
replication set and each consumer instance that you want to update with the changes made 
on the producer.
The status of the replication set is Replication Error. The following table lists the action to take 
according to the status message.

3. Optional:  Discard the entire IDR  configuration and start over, delete the replication set on the 
producer and the consumer.

◦ To delete a producer replication set from the producer instance, navigate to Instance Data 
Replication  > Producer Replication Sets. Click the producer replication set that you want to 
delete, and click Delete.

◦ To delete a consumer replication set on a consumer instance, navigate to Instance Data 
Replication  > Consumer Replication Sets. Click the consumer replication set that you want 
to delete, and click Delete.
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Grant access to the replicated data for Instance Data Replication

Approve or deny a request to grant access to the replication data in Instance Data Replication 
(IDR).

Before you begin
Role required: admin, idr_admin

About this task
You can review consumer access requests for all of your producer replication sets or for a 
specific producer replication set. The administrators of consumer sets must apply for access 
before they can receive the replication data.

Procedure

1. On the producer instance, navigate to Instance Data Replication  > Consumers Pending 
Approval.

2. Select the option for each consumer replication set that you want to approve.

3. On the Actions on selected rows list, select Approve.
The approved consumer sets start receiving the replicated data.

Note: 
You can change the Consumer Approval Status to Denied to prevent the consumer from 
receiving the replicated data.

4. Approve a consumer access request for a specific producer replication set.

a. On the producer instance, navigate to Instance Data Replication  > Producer Replication 
Sets.

b. Select the producer replication set where you want to approve consumer access.

c. Under Related Links, on the Consumer Subscriptions  tab, select the option for the 
consumer replication set that you want to approve.

d. On the Actions on selected rows list, select Approve.
The approved consumer set starts receiving replicated data.

Note: 
You can change the Consumer Approval Status to Denied to prevent the consumer 
from receiving the replicated data.

Revoke access to replicated data for Instance Data Replication

Revoke a consumer's access to replicated data if you believe that consumer instance should no 
longer receive data in Instance Data Replication  (IDR).

Before you begin
Role required: admin, idr_admin

About this task
When you generate a new, shared encryption key, approved consumer sets automatically 
receive the new key and data replication is not interrupted. Any consumer set with a status of 
Denied or Pending Approval does not receive the new encryption key, and replication ceases.
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Procedure

1. On the producer instance, navigate to Instance Data Replication  > Producer Replication Sets.

2. Select the producer replication set that has consumers whose access needs to be revoked.
The instance identifies the consumers under the Consumer Subscriptions  tab.

3. On the Consumer Subscriptions  tab, select the option for the consumer instance whose 
permissions you want to revoke.

4. In the Actions on selected rows list, select Revoke.
Instance Data Replication  generates a new encryption key and shares it with all approved 
consumer sets. All other consumer sets stop receiving replication data. Admins of those 
consumer replication sets must reapply to restore access to the replication data.

Restore access to replication data for Instance Data Replication

Restore Instance Data Replication  (IDR) access to replicated data by sending a request to the 
producer replication set admin.

Before you begin
Role required: admin

About this task
When the producer replication set administrator generates a new encryption key, consumer 
sets with a status of Approved automatically receive the new key and data replication is 
uninterrupted. Consumer sets with a status of Denied or Pending Approval do not receive the 
new encryption key and replication stops.

Procedure

1. On the consumer instance, navigate to Instance Data Replication  > Consumer Replication 
Sets.

2. Select the consumer replication set to restore access to.

3. Click the Request Shared Key  related link.
The system sends a request to the producer replication set administrator. If you are granted 
access, the consumer Approval Status changes to Approved.

4. If the producer replication set has changed, click the Synchronize Replication Entries  related 
link.

5. To get the latest data in the producer replication set, on the Inbound Entries  tab, select all the 
tables and click Activate.

Transform replication data for Instance Data Replication

Transform producer instance data for tables or table columns that are named differently on 
consumer instances in Instance Data Replication  (IDR).
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Before you begin

• Create and activate a producer replication set.

• Create, activate, and seed one or more consumer replication sets.

• Role required: idr_admin or admin

About this task
The replicated data from producer tables and table columns goes into tables and table columns 
of the same name on consumer instances. You can map the producer data into any table or table 
column on consumer instances. If existing tables or table columns have different names, you can 
replicate the data to a different table or table column. Adapters modify the data before storing 
it on consumer instances. For example, adapters can localize data from the producer instance 
before it is consumed by the consumer instance.

You can also use adapters to modify the producer data during replication. For example, you can 
localize the data or populate the data that has been labeled differently in consumer tables.

Transformations have the following limitations:

• sys_created, sys_created_by, sys_domain, sys_updated_by, sys_id, sys_mod_count, and other 
systems are automatically mapped to the consumer and can't be remapped.

No other sys_ fields can be replicated.

• Adapters can't operate on the sys_journal field type such as Comments or Worknotes columns 
in a Task table.

• Calculated fields won't be transformed.

A calculated field, such as the name field from sys_user, will replicate but cannot be 
transformed. Allowing a transformation breaks the calculation for the resulting field.

Note: 
Calculated fields will not show as an option to transform.

Procedure

1. Choose a producer or consumer instance and navigate to the replication set.

Option Description

Consumer Instance
Navigate to Instance Data Replication  > Con­
sumer Replication Sets  and click a consumer 
replication set.

Producer instance
Navigate to Instance Data Replication  > Pro­
ducer Replication Sets  and click a producer 
replication set.

2. Choose an inbound or outbound entry.

Option Description

Consumer Instance
On the Inbound Entries  tab, click an inbound 
entry.

Producer instance
On the Outbound Entries  tab, click an out­
bound entry.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2764



An entry appears.

3. Select the Enable Transform  option.

4. In the Target Table Name list, select the table into which you want to replicate the source table 
data and click Update.

5. On the Inbound Entries  or the Outbound Entries  tab, click the same entry.

6. Click the lock icon next to Transform Map  to unlock it.
The image shows a Transform Map, with the field names from the source table appearing in the 
left column. The middle column shows matching field names in the target table. All fields that 
do not have the same names in both tables appear in the – choose source field – or – choose 
target field – lists.
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Note: 
If a table in a producer replication set is not on a consumer instance, the consumer 
instance will fill the first column with the producer schema definition sent during 
synchronization.

7. Map a producer column to a consumer column that has a different name:

a. Click – choose source field –  and select the source field that you want to map.

b. Click – choose target field –, select the target field into which you want to map the data, and 
then click Add.

c. If you want to remove a field from replicating the producer instance to the consumer 
instance, click the X  at the end of the row to delete the field.

8. To modify the producer data before replicating it in the consumer instance, click Add Adapter.
The image shows the type of Adapter rules that you can create.

9. Click the adapter that you want to use and then configure it.
For more information about configuring adapters, see Adapter descriptions.

Note: 
Adapters do not modify the data on the producer instance.
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Warning and error messages for schema validation in Instance Data Replication

Understand error and warning messages relating to schema definitions. You can then 
troubleshoot or fix Instance Data Replication  (IDR) replication issues.

Warning and Error Messages

Message Type Action

The consumer 
instance does not 
recognize the 
[specified] table 
from the associated 
IDR schema.

Error The replication entry 
cannot process any 
messages. Please enable 
a transformation with this 
table to receive updates from 
this table to the consumer 
instance.

The consumer 
instance does not 
recognize the 
[specified] column 
from the associated 
IDR schema.

Warning The replication entry cannot 
process any of the specified 
columns. Please enable a 
transformation with this table 
in order to receive updates 
from this column to the 
consumer instance.

The consumer 
instance does not 
recognize the column 
type or length from 
the associated IDR 
schema for these 
columns: [specified 
columns].

Warning The consumer instance 
might lose data for those 
columns. Please enable a 
transformation with this table 
in order to receive updates 
from these table columns.

Set up bidirectional replication in Instance Data Replication

Replicate updated data on a consumer instance to the producer instance using bidirectional 
replication in Instance Data Replication  (IDR).

Before you begin
Role required: idr_admin or admin

Procedure

1. On the producer instance, navigate to Instance Data Replication  > Producer Replication Sets:

◦ Click New  for a new replication set

◦ Click on a producer replication set.

2. Check the Bi-Directional  checkbox to enable bi-direction for your producer replication set.
Bi-directional replication enables changes to records that are made on the consumer instance 
to propagate to the producer instance.

Note: 
Bi-directional replication works for records that originate on the producer or consumer.
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3. On a consumer instance, navigate to Instance Data Replication  > Consumer Replication Sets 
and click a consumer replication set that is connected to the producer replication set.

4. On the Consumer Replication Set pane, click the Synchronize Replication Entries  related 
link to update the Consumer Replication Entries configuration on the consumer to match the 
configuration on the producer.

Result
Data that is updated on this consumer instance automatically replicates on the producer 
instance, which then replicates the updates to its other consumer instances.

Create a discrete producer replication set for Instance Data Replication

Distinguish consumers for a producer replication set in Instance Data Replication  (IDR).

Before you begin
Role required: admin

Procedure

1. On the producer instance, navigate to Instance Data Replication  > Producer Replication Sets:

◦ Click New  for a new replication set

◦ Click on a producer replication set.

2. Check Discrete  to enable discrete mappings for your producer replication set.
Once you enable discrete mapping, each outbound entry for a replication set has a discrete 
value column. You can define the mapping of each consumer subscription by setting a 
discrete value.

3. Navigate to Outbound Entries  tab and click New.

Options Description

Source Table Name Select one of the tables on the producer instance to replicate. For 
example, .NET Application [cmdb_ci_dot_net]

Discrete Field Choose a reference field that defines the mapping for each 
consumer subscription. For example, if you choose the Assigned 
To  field in the Incident source table, you can distinguish user 
assignments for specific consumers.

[Optional] Filter Within the Filter  section, you can use the Add Filter Condition  to 
select filter criteria to control the records in the table that are being 
replicated.

For example, you might want to replicate only active records. In that 
case, select Active  in the – choose field –  list, Is  in the – oper –  list, 
and True  in the – value –  list. If you do not use a filter, all the fields in 
the producer replication set table appear in the Available column.

Note: 
The Available column contains the fields in the Source Table 
that you specified. That table may not contain the Active  field.

[Optional] Include 
Attachments

Select this option to replicate files that are associated with the 
records that are being replicated.
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Options Description

[Optional] Included 
Fields

In the Included Fields columns, use the arrows to move table fields 
into the Selected column to replicate them or into the Available 
column to prevent replicating them.

Note: 
Some fields, such as SYS ID (Mandatory), must be replicated. 
Other fields, such as Edge Encrypted  and Password1, can't be 
replicated and do not appear in either column.

4. Navigate to Discrete Mappings  tab, click New, and fill in the form fields.

Field Description

Discrete Value This field sets a rule for what displays for 
the selected consumer instance within the 
producer replication set. For example, an 
Assigned To  discrete value gives choices 
from a designated table of a specific user to 
show assignments.

Outbound Replication Entry Select an outbound replication entry that 
you configured with a source table for this 
producer replication set.

Replication Subscription Choose the consumer instance that displays 
the discrete value assignment.

Note: 
For each consumer that subscribes to a producer replication set with discrete mapping 
enabled, they must have a discrete value set.

Administering Instance Data Replication

Monitor data replication activities and troubleshoot potential issues in Instance Data Replication 
(IDR).

Comparing replicated data between instances in Instance Data Replication

You can find missing or mismatched records by comparing replication data between instances in 
Instance Data Replication  (IDR).

IDR  synchronizes data between a producer instance and one or more consumer instances. 
After you activate a producer replication set and subscribe at least one consumer, you can 
send existing records from the producer to the consumer by seeding records. After seeding 
is finished, IDR  maintains data synchronization between the instances by replicating new and 
changed records from the producer to the consumer.

If an insert fails on the consumer or when producer and consumer records don’t match after 
replication, you can use the data comparison feature in IDR  to find these records and reseed 
them from the producer to the consumer.
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Key benefits

• Identify records missing from the consumer instance after seeding.

• Identify mismatched records and view their differences.

• Keep data synchronized between instances by reseeding records.

Comparing transformed data

When comparing transformed data, note the following details:

• The data comparison can return mixed results if records are added to a table on the producer 
and then a transformation replicates to a different table on the consumer instance.

• Mapped fields with different field definitions are skipped. For example, if a field on the 
producer has a different column type or column length than the mapped field on the 
consumer, the field is skipped.

• All fields that are modified by an adapter are skipped except for modifications made by the 
Task number adapter. For example, if a string is appended using the Concatenate String 
adapter, the data comparison can't undo the concatenation and compare the data using the 
original string, so the field is skipped.

Compatibility

Beginning in the Washington DC  release, you can compare replicated data in bidirectional 
replication sets, discrete replication sets, and replication sets with transformations configured on 
either the producer or the consumer.

When comparing data on different family releases, note the following compatibility options.

Producer to consumer compatibility

Data comparison Producer Consumer
Supported replication 
sets

Producer to consumer Washington DC  or 
later

Utah  and earlier None

Producer to consumer Washington DC  or 
later

Vancouver Supports 
unidirectional 
replication sets, but 
not the following:

• bidirectional 
replication sets

• discrete replication 
sets

• replication sets 
configured with 
transformations

Producer to consumer Washington DC  or 
later

Washington DC  or 
later

All replication sets
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Consumer to producer compatibility

Data comparison Consumer Producer
Supported replication 
sets

Consumer to producer Washington DC  or 
later

Utah  and earlier None

Consumer to producer Washington DC  or 
later

Vancouver Supports bidirectional 
replication sets, but 
not the following:

• unidirectional 
replication sets

• discrete replication 
sets

• replication sets 
configured with 
transformations

Consumer to producer Washington DC  or 
later

Washington DC  or 
later

All replication sets, 
but not unidirectional 
replication sets

Limitations

• Journal fields are excluded from the comparison due to the potential size of their content.

• Attachments are not included in data comparisons.

• Sys Audit [sys_audit] table records are excluded from the comparison.

Find missing or mismatched records in Instance Data Replication

Find records missing from the consumer instance or mismatched records after data has been 
replicated by creating a data comparison request in Instance Data Replication  (IDR).

Before you begin
Make sure the following conditions are met:

• The producer replication set is active.

• Seeding isn't in progress.

• No other data comparison requests are running.

Role required: admin

About this task
Note the following:

• Data comparison requests are purged after three months.

• A data comparison request can have a maximum of 500,000 records.

• There are limitations when comparing transformed data. See Comparing replicated data 
between instances in Instance Data Replication.
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Procedure

1. On the producer instance, navigate to All  > Instance Data Replication  > Producer Replication 
Sets.

2. Select an active producer replication set with replicated data that you want to compare.

3. Create a data comparison request.

a. Navigate to the IDR  Data Comparison Requests related list.

b. Select New.

c. On the form, fill in the fields.

IDR  Data Comparison Request form

Field Description

Replication Set Name of the producer replication set.

Target Instance Name Name of the consumer instance.

Target Instance URL URL of the consumer instance.

Table Name Name of the table in the outbound entry of 
the producer replication set.

Start Time Start date and time for comparing data. 
Records with a sys_updated_on value after 
the date you select are included in the 
comparison.

End Time End date and time for comparing data. 
Records with a sys_updated_on value 
before the date you select are included in 
the comparison.

d. Select Submit.

4. View a summary of the data comparison in the IDR  Data Comparison Results form.

◦ Determine the percentage of missing or mismatched by viewing the pie chart.

◦ View the total number of missing and mismatched records in the Mismatched Records 
Count  field.

5. Optional:  Identify records that are missing from the consumer instance after seeding through 
the pie chart or list.

◦ View the missing records by selecting the missing records portion of the pie chart.

◦ View records that have a Missing  value in the Record Type  column in the IDR  Instance 
Comparison Results related list.

Tip: 
Save copies of the missing record IDs in case you need to provide them to Customer 
Service and Support.

6. Optional:  View the differences between mismatched records after data replication.
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a. Navigate to the IDR  Instance Comparison Results related list.

b. Select the check box next to any record with a Mismatched  value in the Record Type 
column.

c. Select the Actions on selected rows  list.

d. Select Compare records.

e. View the highlighted differences between the records in the Compare Record Payloads 
dialog box.

Note: 
Journal fields are excluded from the comparison due to the potential size of their 
content.

Save a copy of the payload difference in case you need to provide it to Customer Service 
and Support.

What to do next
Reseed missing or mismatched records in Instance Data Replication.

Reseed missing or mismatched records in Instance Data Replication

Synchronize data between instances by reseeding records missing from the consumer instance 
or mismatched records between the producer and consumer instance in Instance Data 
Replication  (IDR).

Before you begin
Role required: admin

About this task
Note the following:

• Data comparison results and logs are purged after five days.

• A reseeding request can have a maximum of 100,000 records.

Procedure

1. On the producer instance, navigate to All  > Instance Data Replication  > Producer Replication 
Sets.

2. Select a producer replication set with data that you want to reseed to the consumer.

3. View the data comparison results.

a. Navigate to the IDR  Data Comparison Requests related list.

b. Select a data comparison.

4. Synchronize the data between the producer and the consumer instance by reseeding.

◦ Reseed all records by selecting All  in the Reseed mismatched records  field.

◦ Reseed only the mismatched or missing records by selecting Mismatched  in the Reseed 
mismatched records  field.

5. Select Reseed.
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Result
Records are reseeded from the producer to the consumer and the results are displayed when 
the job is finished.

What to do next
If records are still missing or mismatched, contact Customer Service and Support  for assistance.

Deploying a replication configuration from one instance to another in Instance Data 
Replication

You can copy a replication configuration from one instance to another through an update set in 
Instance Data Replication  (IDR).

In IDR, you can capture a snapshot of a replication configuration, including selected fields, 
filters, or data transformations using the Track in Update Set  option, and then copy it to another 
instance using an update set.

Important: 
The Track in Update Set  option in IDR  is the only supported method for capturing a 
replication configuration that you want to copy to another instance.

Key benefits

• Save time by defining a replication configuration once and using it as a template for new 
replication sets on other instances.

• Minimize potential impact to your production instance by developing a replication 
configuration in your sub-prod instance first.

• Verify a replication configuration in a sub-prod instance before rolling it out to a production 
instance.

Configuration entities

The following configuration entities are captured in an active update set when you select the 
Track in Update Set  option.

Entry set

An entry set is a bundle of replication entries (like a replication set), that doesn't 
contain any instance-specific metadata like the Producer ID. A new Producer ID is 
used in the target instance when you create a producer replication set based on an 
entry set.

Replication options that are tracked in an entry set and their status (active or 
inactive) include:

• Bi-directional replication

• Discrete value mapping

Replication entries

A replication entry contains configuration settings for each table that you want to 
replicate. Replication entries are either outbound or inbound.

• Outbound entries from a producer instance contain the source table, filter, fields 
you want to replicate, and data transformation settings.

• Inbound entries from a consumer instance include the target table, the option to 
run business rules after replication, and data transformation settings.
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Viewing an entry set and replication entries

When you create a replication set, a new record is added to the Entry Sets [idr_entry_set] table. 
New records are added to the Replication Entries [idr_replication_entry] table for each outbound 
entry that you add to the replication set.

After selecting Track in Update Set, you can view the entry set and its replication entries in the 
current update set by navigating to All  > System Update Sets  > Local Update Sets, selecting the 
update set, and then viewing the Customer Updates  tab.

Deploy a replication configuration through an update set in Instance Data Replication

Export a replication configuration from one instance and import it on another instance through an 
update set in Instance Data Replication  (IDR).

Before you begin
Role required: idr_admin or admin

About this task
You can copy a replication configuration from one instance to another using an update set. For 
details on using update sets, see Get started with update sets .

Procedure

1. On the source instance, create an update set.

a. Navigate to All  > System Update Sets  > Local Update Sets.

b. Select New.

c. Enter a name for the update set.

d. Select Submit and Make Current.
An update set is created and selected as the current update set on the source instance.

2. Capture a producer or consumer replication configuration in the update set.

Note: 
You can capture the following types of configurations on a producer instance:

◦ Producer replication (one-way)

◦ Producer replication with bi-directional replication

◦ Producer replication with discrete replication

◦ The replication set configuration is added to the Entry Sets [idr_entry_set] table.

◦ The replication entries in the replication set are added to the Replication Entries 
[idr_replication_entry] table.

◦ The entry set and its replication entries are captured in the current update set.

3. Optional:  Continue modifying the replication configuration as needed.
Additional changes that you make aren't captured until you select Track in Update Set  again.

a. Modify the producer replication set and select Update.

b. Capture the latest changes by selecting Track in Update Set.
The latest changes are captured in the update set.

4. Export the update set to XML.

a. Navigate to All  > System Update Sets  > Local Update Sets.

b. Select the current update set.
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c. In the State  drop-down list, select Complete.

d. Select Update.

e. In the Update Sets list, select the update set that you marked as complete.

f. Select the Export to XML  related link.
The update set is exported to an XML file on your local machine.

5. On the target instance, import the update set.

a. Navigate to All  > System Update Sets  > Update Sets to Commit.

b. Select the Import Update Set from XML  related link.

c. Select Choose File  and browse to the XML file that you exported.

d. Select Upload.

e. In the Retrieved Update Sets list, select the update set that you imported.

f. Select Preview Update Set.

Note: 
If you receive sys_record_transform errors during the preview, select all the error 
records that are listed in the Update Set Preview Problems  tab, and then select 
Accept Remote Update. Repeat this action for any additional sys_record_transform 
errors that appear.

g. Exit the preview by selecting Close.

h. On the update set form, select Commit Update Set.

The update set is imported on the target instance, including the entry set and replication 
entries that you captured from the source instance. If you exported the configuration for a uni-
directional producer replication set, a new producer replication set is automatically created on 
the target instance.

6. On the target instance, perform the following steps based on the type of replication set that 
you want to set up.

Result
The replication configuration that you exported from the source instance is imported to the target 
instance. A new replication set based on the exported configuration is created on the target 
instance.

What to do next

• If you're setting up a producer replication set, create and subscribe one or more consumers.

• If you're setting up a consumer replication set, approve the consumer's request on the 
producer instance, and then activate the consumer replication set on the consumer instance.

• If you're setting up a bi-directional replication set, synchronize the consumer by selecting the 
Synchronize Replication Entries  related link in the connected consumer replication set.

• If you're setting up a discrete replication set, create and subscribe one or more consumers.
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Cloning with Instance Data Replication

Ensure that certain tables are preserved or excluded to clone your database from one instance 
to another successfully with Instance Data Replication  (IDR).

There are multiple methods for copying an IDR  configuration from one instance to another.

Capture the configuration in an update set

An update set captures a group of configuration changes that you can move from 
one instance to another but doesn’t include data that a producer replicates to a 
consumer. You can capture a snapshot of an IDR  replication configuration, including 
selected fields, filters, or data transformations using the Track in Update Set 
option, and then copy it to another instance using an update set. See Deploying a 
replication configuration from one instance to another in Instance Data Replication.

Copy the configuration using a clone profile

Cloning your instance copies everything in the database from one instance to 
another, including the data and the IDR  replication configuration.

Before you clone your instance, you must determine whether to exclude or include 
your IDR  replication configuration.

For details on cloning, see System clone .

IDR  cloning use cases

You must preserve and exclude different sets of IDR  tables in your cloning profile depending on 
your cloning use case.

Recurring clone

In this use case, you clone your source instance regularly without affecting the 
existing IDR  configuration on the target instance.

For example, you configure IDR  to replicate data from instance A to instance B. You 
determine that you must clone the database from instance A to another instance 
called instance C. Instance A and instance C both have IDR  configured with 
different replication configurations. When you clone the database from instance A 
to instance C, you don’t want to clone any of the IDR  replication configuration from A 
to C.

Note: 
If you regularly clone data from your source instance to your target instance, 
and find that you need to copy the IDR  replication configuration from the 
source instance to the target instance, use the Track in update set  feature to 
copy the IDR  to the target instance.

To clone your database from one instance to another without affecting the IDR 
configuration on the target instance, you must update the preserve and exclude 
lists in your cloning profile according to the Recurring Clone use case described in 
KB0965218 .

True clone

In this use case, you clone your source instance to your target instance and include 
the complete IDR  replication configuration. The target instance inherits everything 
from the source. After the clone is finished, you must resubscribe all consumer 
instances to the target instance.

For example, you decide to provision a new production instance from a non-
production instance that already has IDR  configured. When you clone the non-
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production instance, the new production instance inherits everything from the non-
production instance. To ensure that data replicates from the production instance 
and not the non-production instance, you resubscribe all consumer instances to the 
new production instance.

To clone your database and copy the current IDR  configuration to the target 
instance, you must update the preserve and exclude lists in your cloning profile 
according to the True Clone use case described in KB0965218 .

Migration clone

In this use case, you clone your source instance to the target instance, including the 
complete IDR  replication configuration from the source instance, while preserving 
the target instance’s replication configuration.

The migration clone involves performing a true clone, but with additional steps.

1. On the target instance, you create an update set and use the Track in update 
set  feature to upload the existing replication sets on the target instance into the 
update set.

2. Perform a true clone.

3. After performing the true clone, you import the update set to the target instances, 
and you set up replication sets using entry sets to preserve the configuration.

Comparing IDR  cloning use cases

Use case Description Prerequisites Post requisites

Recurring clone Clone your source 
instance to your 
target instance 
regularly but exclude 
your IDR  replication 
configuration.

When 
complete,replication 
sets on the target 
instance should not 
be changed.

Verify that IDR  is 
configured correctly, 
and that replication 
is successful on both 
the source and target 
instances.

After performing 
a recurring clone, 
you can copy the 
IDR  replication 
configuration from the 
source instance to the 
target instance using 
the Track in update 
set  feature.

True clone Clone your source 
instance to your target 
instance and copy 
your IDR  configuration 
to the target instance.

When complete, entry 
sets from the source 
instance should be 
cloned to the target 
instance.

Verify that IDR  is 
configured correctly, 
and that replication 
is successful on the 
source instance.

After performing a 
true clone, you must 
perform the following 
actions on the target 
instance:

1. Re-create the 
replication sets 
using the cloned 
entry sets from the 
source instance.

2. Resubscribe each 
consumer to the 
newly-provisioned 
producer.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2778

https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0965218
https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0965218
https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0965218


Comparing IDR  cloning use cases  (continued)

Use case Description Prerequisites Post requisites

Migration clone Clone your source 
instance to your 
target instance 
and copy your IDR 
configuration to the 
target instance, while 
preserving the target 
instance’s replication 
configuration.

When complete, entry 
sets from the source 
instance should be 
cloned to the target 
instance.

1. Capture the existing 
replication sets on 
the target instance 
in an update set 
using the Track in 
update set  feature.

2. Perform a true 
clone.

After performing the 
true clone, you must 
perform the following 
actions on the target 
instance:

1. Import the update 
set.

2. Re-create the target 
replication sets 
using the entry sets 
captured in the 
update set.

3. Re-create the 
source replication 
sets using the 
cloned entry sets 
from the source 
instance.

Delays in replicating data with Instance Data Replication

Delays in replicating data from the producer instance to the consumer instance can occur with 
Instance Data Replication  (IDR).

After IDR  has been set up on the producer instance, the IDRProducerJob  job runs on 
producer instances to detect data updates. When there are updates to replicate, the producer 
instance sends the updates to consumer instances.

The IDRConsumerJob job runs on the consumer instances to detect the data updates from a 
producer. When the IDRConsumerJob job detects updates, it updates the data in consumer 
tables.

IDR data updates flow

It takes some time for the data updates in a producer replication set to appear in consumer 
replication sets. You can look on the monitoring dashboard  to see how long data updates take 
from a producer replication set to consumer replication sets. Look at the queue dashboard  to see 
the replication record queue, message queue, and messages processed for all replications sets.

If you have significant data delays, contact Customer Service and Support.
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Monitoring Instance Data Replication

You can monitor the status of active producer and consumer replication sets, scheduled jobs, 
seeding requests, and license or usage details through the Instance Data Replication  (IDR) 
Monitoring Dashboard.

Accessing the IDR  Monitoring dashboard

Users with the admin or idr_admin role can access the dashboard.

Access the IDR  Monitoring dashboard in the following way:

• Navigate to Instance Data Replication  > Monitoring Dashboard.

• Choose either: IDR Overall Monitoring  or IDR License and Usage Details  dashboard.

IDR  Overall Monitoring dashboard

The IDR  Overall Monitoring dashboard monitors the following:

• Active Producer Replication Sets

• Active Consumer Replications Sets

• Suite of IDR  Scheduled Jobs

• Producer Seeding Requests Within Last 7 Days

• Consumer Seeding Requests Within Last 7 Days

IDR overall monitoring dashboard

Active Producer Replication Sets

The Active Producer Replication Sets monitors your producer replication set status 
and reports the data lag time between your instance and the replication queue.

Field Description

Name Name of the producer replication set

Replication Queue Reading Lag Time between a record change on the 
producer instance and the moment that 
it’s sent over the outbound replication 
queue

Status Status of a replication set, either active 
or in error

Status Message Message that describes the error status
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Field Description

Message Queue Version Version of the Message Queue. Either 
V1 (Legacy) or V2 (Hermes)

Active Consumer Replication Sets

Active Consumer Replication Sets monitors your consumer replication set status, 
reports the network lag time, and reports the data lag time between the producer 
instance and consumer instance.

Field Description

Name Name of the consumer replication set.

Data Lag Time between a record change on the 
producer instance and the moment that 
it’s recorded in the consumer instance.

Network Lag Time between a record change log in 
the outbound replication queue and 
the moment that it’s recorded in the 
consumer instance.

Status Status of a replication set, either active 
or in error.

Status Message Message that describes the error status.

Message Queue Version Version of the Message Queue. Either 
V1 (Legacy) or V2 (Hermes)

Suite of IDR  Scheduled Jobs

The suite of IDR  scheduled jobs poll for data changes, requests, and check the 
health of your producer and consumer instances. You can monitor the following 
jobs:

Jobs Description

Hermes  Metrics Collection Collects metrics related to the Hermes 
Messaging Service.

Hermes  Periodic Purge Cleans obsolete cached data in the 
Hermes  API.

Hermes  Topics Util Synchronizes topics across Hermes 
clusters. Initially, topics are created in a 
single Hermes  cluster. This job detects 
new topics and creates the same topics 
in the remaining Hermes  clusters.

IDRConsumerJob Polls for record changes and seeding 
requests on the consumer instance in 
15-second intervals.

IDRDeltaConsumerJob Beginning in the San Diego  release, 
when a consumer instance subscribes 
to a producer instance that is 
outside the local datacenter, the 
IDRDeltaConsumerJob job is created 

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2781



Jobs Description

on the producer instance. The function 
is the same as the IDRConsumerJob. 
The three-letter code denotes the 
datacenter location.

IDRHermesDeltaConsumer Polls for consumer record changes from 
the Hermes delta topic in 15-second 
intervals.

IDRHeartBeatJob Updates information about the health of 
every active producer or consumer set.

IDRMetadataConsumerJob Polls for metadata record changes on 
the consumer instance in 15-second 
intervals.

IDRProducerJob Polls for new, updated, or deleted 
records in the data replication queue 
for a producer instance in 15-second 
intervals.

IDRSeedingProducerJob Checks for new seeding requests 
coming from consumer instances.

Note: 
You can set when your IDR  scheduled jobs run and configure a periodic trigger 
that specifies how often the job runs.

IDR  Scheduled Jobs field types

Field Description

Name Scheduled job name.

Next Action Date and time when the job next runs.

Trigger type Job that you can configure to run daily, 
weekly, monthly, periodically, once, on-
demand, or business calendar start or 
end date. The trigger can repeat daily, 
hourly, by minute, or by second.

Job ID ID of the scheduled job.

State State of the job, for example, ready.

Producer Seeding Request Within Last 7 Days

You can monitor the status of a producer seeding request within the last seven 
days.

Field Description

Replication Set Producer set and the consumer set.

Status Status of the seeding request. The 
status can be completed, in progress, or 
failed.
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Field Description

Start Time Time that the seeding begins.

End Time Time that the seeding ends.

Percent Complete Percentage of the seeding request job 
that is complete.

Consumer Seeding Request Within Last 7 Days

You can monitor the status of a consumer seeding request within the last seven 
days.

Field Description

Replication Set Corresponding consumer set.

Status Status of the seeding request. The 
status can be completed, in progress, or 
failed.

Start Time Time that the seeding begins.

End Time Time that the seeding ends.

Percent Complete Percentage of the seeding request job 
that is complete.

IDR  dashboard properties

You can access the IDR  dashboard properties by navigating to Instance Data 
Replication  > Properties.

You can change the following properties on your dashboard:

Property field Description

Minutes of lag before the Data Lag 
field are highlighted in red on the IDR 
Monitoring Dashboard

Data Lag  field that is part of the Active 
Consumer Replication set. If the 
actual lag time is greater than the time 
threshold that you set, the system 
highlights the field. The default is 15 
minutes.

Minutes of lag before the Network Lag 
field is highlighted in red on the IDR 
Monitoring Dashboard

Network Lag  field that is part of the 
Active Consumer Replication set. If 
the actual lag time is greater than the 
time threshold that you set, the system 
highlights the field. The default is 15 
minutes.

Minutes of lag before the system 
highlights the Replication Queue 
Reading Lag field in red on the IDR 
Monitoring Dashboard

Replication Queue Reading Lag  field 
that is part of the Active Consumer 
Replication set. If the actual lag time is 
greater than the time threshold that you 
set, the system highlights the field. The 
default is 15 minutes.
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Note: 
You can set the colors on the fields through the personalize list columns 
(v_idr_dashboard_list.do).

IDR  License and Usage Details dashboard

The IDR  License and Usage Details dashboard monitors the following:

• Subscriber Sent Messages

• Subscriber Received Messages

• IDR  License Details

• IDR  Messages Sent

• IDR  Messages Received

Subscriber Sent Messages

The number of messages each subscriber instance sent, by month.

Subscriber messages sent

Subscriber Received Messages

The number of messages each subscriber instance received, by month.

Subscriber messages received

IDR  License Details

You can monitor the status of a consumer seeding request within the last seven 
days.

Field Description

Name Name of the IDR  license.
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Field Description

Type Type of subscription: Per-User  for user 
subscriptions, Capacity  for data driven 
subscriptions, or Unrestricted User  for 
subscriptions capped by the maximum 
user count.

Category License category: ServiceNow  license 
or Store App license.

Start date Start of the licensing period.

End date End of the licensing period.

Display only Does not support resource allocation or 
monitoring.

Purchased Number of purchased licenses.

Allocated Number of allocated licenses.

IDR  Messages Sent

The number of messages sent, per license, monthly.

IDR  messages sent

IDR  Messages Received

The number of messages received, per license, monthly.

IDR  messages received

Monitoring queues in Instance Data Replication

You can monitor the replication record queue, message produced queue, message consumed 
queue, and the messages processed for all replications sets through the Instance Data 
Replication  (IDR) Queue Dashboard.
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Accessing the IDR  Queue Dashboard

Users with the admin or idr_admin role can access the dashboard.

Access the IDR Queue Dashboard by navigating to Instance Data Replication  > Queue 
Dashboard.

IDR  Queue Dashboard

The IDR  Queue Dashboard enables you to monitor the following:

• IDR Queued Producer Records which are hourly records queued for all tables over a 24-hour 
time period.

• Outbound Messages Remaining which are messages remaining in the replication queue that 
are not yet sent to the message queue.

• Outbound Messages Processed which are messages produced from this instance to the 
message queue.

• Inbound Messages Remaining which are messages remaining in the message queue, that 
have not yet been processed.

• Inbound Messages Processed which are messages consumed on this instance.

In any chart, select Last 24 Hours  or Last 5 Days  as the time period. For the 24-hour period, the 
number of messages is per hour. For the 5-day period, the number of messages is per day.

Select the legend link under the chart to exclude that data source.

IDR  Queue Dashboard
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IDR Queued Producer Records

With the IDR  Queued Producer Records chart, you can see the number of records queued for 
each table over an hourly or daily period. It shows which tables account for the highest amount 
of traffic within IDR  over time. Use this chart to identify activity spikes that cause predictable 
performance lags on the consumer instance.

For example, if you see that a large spike of activity occurs every day at 3:00 a.m. due to a 
business rule on a table, you should expect a performance lag to occur on the consumer around 
that time.

Select All Tables  or a specific table. Position your cursor over a point in the chart to see the 
queue count and tables for that point.

Outbound Messages Remaining

With the Outbound Messages Remaining chart, you can determine whether a producer instance 
is catching up to real-time replication after a large spike in activity.

When replication is working correctly, the messages remaining count should be very low. If there 
is a spike in activity, you can expect a large value. For example, when a business rule is changing 
tens of thousands of records within a minute.

You can also expect messages remaining to decrease over time as the jobs process the 
messages.

If the messages remaining count continues to grow without resolution, it might indicate:

• An issue processing the messages. For example, the IDRProducerJob  is not running, or 
cannot send messages to the message queue.

• The instance is recording changes faster than IDR  can produce them.

Select All Sets  or a specific set. Position your cursor over a point in the chart to see the message 
count and replication set name for that point.

Outbound Messages Processed

With the Outbound Messages Processed chart, you can see the flow of records from a producer 
instance to the message queue over time.

Trends for messages processed and the messages remaining over time indicates if replication is 
recovering from a lag or if there are issues sending data to the message queue.

Along with the Data Replication Queued Producer records chart, you can see if the instance is 
sending data. If your instance has queued records that are not being sent, it might indicate:

• The instance is not able to run the producer job. For example, due to other resource-intensive 
processes running on the instance and all worker threads being busy.

• There is an issue connecting to the message queue.

To see the message count and replication set name for a graph point, select All Sets  or a specific 
set and position your cursor over a point in the chart.

Inbound Messages Remaining

With the Inbound Messages Remaining chart, you can determine whether a consumer instance 
is catching up to real-time replication after a large spike in activity.
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You can expect a temporary large value when there is a spike in activity. The value normally 
decreases as the messages are processed.

If this value continues to grow without resolution, it might indicate:

• An issue processing the messages. For example, the IDRConsumerJob  is not running, or 
cannot read messages from the message queue.

• The instance is recording changes faster than IDR  can consume them.

Select All Sets  or a specific set. Position your cursor over a point in the chart to see the message 
count and replication set name for that point.

Inbound Messages Processed

With the Inbound Messages Processed chart, you can see the flow of records for each consumer 
set over time.

Use the inbound messages chart to determine which replication sets have the most traffic and 
see trends for messages processed and the messages remaining.

If the producer is sending records to the message queue and the consumer is not processing 
them, it might indicate issues with the producer or the consumer instance.

Position your cursor over a point in the chart to see the message count and replication set name 
for that point.

Preventing insert and update errors in Instance Data Replication

You can prevent insert and update failures in Instance Data Replication  (IDR) by specifying a 
class name filter in the producer replication set.

Important: 
This topic only applies to producer replication sets created prior to the Utah  release.

When you replicate a parent table and one or more child tables, you must add a sys_class_name 
filter to the parent table in the outbound entry of your producer replication set. If the 
sys_class_name filter is missing, insert and update failures appear in Instance Data Replication 
> Replication Payload Error  in the following scenarios:

• A failed insert occurs when a record in the child table is replicated because the system 
attempts two inserts with the same sys_id to the parent table. Adding the sys_class_name filter 
to the parent prevents the unique key violation during the INSERT into the parent table.

• A new record is added to a replicated child table on the producer instance. Instance Data 
Replication  (IDR) initially creates the record in the parent table on the consumer, but not the 
child table. If the child record is changed on the producer instance, during replication a failed 
update occurs on the child table in the consumer instance because the record only exists in 
the parent table.

If the table is a parent, decide if you want to replicate any of its child tables.

• If you want to replicate one or more child tables, you must identify the sys_class_name value 
for the parent table, and then add a corresponding sys_class_name filter to the parent table.

For example, Task Type  is the label for sys_class_name on the Task [task] table. To start 
replicating the incidents in addition to tasks, you must add [Task Type] [is] [Task]  to the 
outbound entry for the Task [task] table.
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• If you only want to replicate the parent table, the filter is optional.

• If the parent table is already being replicated, you must edit the parent and add the 
sys_class_name filter.

If the table is a child, decide if you want to replicate its parent.

• If you want to replicate the parent table as well, you must identify the sys_class_name value for 
the parent table, and then add a corresponding sys_class_name filter to the parent table.

For example, Task Type  is the label for sys_class_name on the Task [task] table. To start 
replicating tasks in addition to incidents, you must add [Task Type] [is] [Task]  to the outbound 
entry for the Task [task] table.

• If you only want to replicate the child table, the filter is optional.

• If one or more child tables are already being replicated, you must add the sys_class_name filter 
to the parent.

Resolving data replication errors in Instance Data Replication

Resolve errors and monitor the status of Instance Data Replication  (IDR) replication sets.

Monitoring and diagnostic checklist

When you notice that the system is not replicating data, you can use the diagnostics checks to 
investigate the problem. To monitor the overall health of all replication sets, see IDR  Monitoring 
dashboard.

IDR  diagnostics checks

Check Description

Monitor

Check connectivity Test your IDR  instance connectivity to 
determine the connectivity of your instance to 
the message queue.

Check IDR monitoring dashboard to see if 
replication jobs are active

For the dashboard to properly display 
replication set information, these IDR 
scheduled jobs must be available and running 
on your instance:

• Hermes Metrics Collection

• Hermes Periodic Purge

• Hermes Topics Util

• IDRConsumerJob

• IDRDeltaConsumerJob-<instanceid>

• IDRHeartbeatJob

• IDRMetadataConsumerJob

• IDRProducerJob

• IDRSeedingProducerJob

If any of these jobs are missing or not running, 
contact Customer Service and Support.
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IDR  diagnostics checks  (continued)

Check Description

Note: 
The system only creates the 
IDRDeltaConsumerJob-<instanceid> 
when a consumer instance subscribes 
to a producer instance that is outside the 
local datacenter.

Producer replication set

Check activation of the producer replication 
set

If the status of your producer replication set is 
In Draft, click Activate.

Check consumer subscription approval Review the consumer access requests for 
your producer replication sets. A consumer 
replication set must request access before it 
can receive replication data.

Check producer replication log errors Identify IDR  errors by viewing the metadata for 
messages between producer and consumer 
instances, payload error logs, and message 
logs.

Consumer replication set

Check the activation status of a consumer 
replication set

If the status of your consumer replication set is 
In Draft, click Activate.

Check if you need to synchronize replication 
sets

A synchronization issue occurs when a 
producer instance doesn't send data or a 
consumer instance doesn't receive data. 
Synchronization errors appear in the Status 
field on the consumer instance as Replication 
Error.

Check your consumer replication set status Review the status of your consumer replication 
set and what that means for your replication.

Error and status messages

Check replication or replication metadata log 
errors

Identify IDR  errors by viewing the metadata for 
messages between producer and consumer 
instances, payload error logs, and message 
logs.

Check status messages Review these status messages with recovery 
information.

Run Instance Data Replication  diagnostics

Verify the status of services and the connection between your instance and the Instance Data 
Replication  (IDR) message queue.

Before you begin
Role required: admin or idr_admin
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Procedure

1. Navigate to All  > Instance Data Replication  > Diagnostics.
The dashboard loads and the IDR  diagnostic tests run automatically.

2. View the following diagnostic tests.

Option Description

Key Management Service

Checks the status and setup of the key man­
agement service.

Note: 
IDR  requires a key management service 
to be up and running.

Certificate Management Service

Checks the status and setup of your certifi­
cate management service.

Note: 
IDR  requires a certificate management 
service to be up and running.

EJBCA Service Status
Checks the status and setup of the EJBCA 
service as part of the Key Management Frame­
work  (KMF) health.

VAULT Service Status
Checks the status and setup of the VAULT ser­
vice as part of Key Management Framework 
(KMF) health.

3. Test the connection to the message queue and confirm the replicator is working by running the 
Message Queue Connection Test.

Option Description

Test the connection to the Legacy message 
queue

a. Select Legacy.

b. In the Legacy Message Queue Test Con­
figuration section, select Local  or Remote 
to run diagnostics on a local or remote in­
stance. For a remote instance, enter the 
URL of the remote instance, and a user­
name and password for any of the following 
roles:

▪ idr_rest

▪ idr_read

▪ idr_admin

Note: 
The local datacenter to your producer 
instance regional proximity is the de­
fault.

c. Select Run Legacy Message Queue Test.
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Option Description

Test the connection to the V2 message 
queue

a. Select V2.

b. Confirm that Hermes  is enabled and that 
the Hermes  cluster configuration is opera­
tional.

c. Select Run Message Queue Connection 
Test.

Result
The resulting messages validate enabled services or the connection to the message queue.

Review synchronization errors in Instance Data Replication

Review the status field to check if synchronization is working correctly on the Instance Data 
Replication  (IDR) consumer instance.

Before you begin
Before identifying synchronization errors, complete the tasks in check for common issues.

Role required: idr_admin or admin

About this task
Synchronization errors occur when a producer instance doesn't send data or a consumer 
instance doesn't receive data. Synchronization errors appear in the Status  field on the consumer 
instance as Replication Error.

Procedure

1. Determine if the consumer successfully sent the synchronize request to the producer:

a. On the consumer instance, navigate to Instance Data Replication  > Consumer Replication 
Sets.

b. Select a consumer replication set.

c. Click the Replication Metadata Logs  related link.

d. Sort the logs in a descending order in the Log Sequence column.

e. Find the most recent payload with the REPL_SET_DETAIL_REQUEST type and open it.
If you do not see this payload type, refresh the log until you see a payload with the 
REPL_SET_DETAIL_REQUEST type.

f. Verify that you see the correct producer instance ID in the To column.
If the producer instance ID is incorrect, update the ID  and click Activate.

g. Verify that you see Sent in the Status column.
If you don't see Sent in the Status column, the producer didn't send any updates.

2. Determine if the producer received the synchronize request from the consumer:
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a. On the producer instance, navigate to Instance Data Replication  > Producer Replication 
Sets.

b. Select a producer replication set.

c. Click the Replication Metadata Logs  related link.

d. Sort the logs in a descending order in the Log Sequence column.

e. Find the most recent payload with the REPL_SET_DETAIL_REQUEST type and open it.
If you don't see this payload type, refresh the log until you see the 
REPL_SET_DETAIL_REQUEST type.

f. Verify that you see the correct consumer instance ID in the From column.
If the consumer instance ID is incorrect, update the ID.

g. Verify that you see Received in the Status column.

Discover replication delays in Instance Data Replication

Monitor possible data replication issues by using the Instance Data Replication  (IDR) Monitoring 
Dashboard.

Before you begin
Role required: admin

About this task

Procedure

1. To view the time lag on a producer instance, navigate to Instance Data Replication  > 
Monitoring Dashboard, and check the Active Producer Replication Sets for the following 
details.

Option Description

Name Name of the producer replication set.

Replication Queue Reading Lag
Time between a record change on the produc­
er instance and the moment it is sent over the 
outbound replication queue.

Status
Status of a replication set, either active or in 
error.

Status Message Message that describes the error status.

Message Queue Version
Version of the Message Queue. Either V1 
(Legacy) or V2 (Hermes)

To get additional information, view the producer instance xmlstats at https://
<producer-instance-name>/xmlstats.do?include=idr.
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The xmlstats shows:

◦ The producer_last_run  indicates the last time that the replication job ran on the 
producer instance.

◦ The last_message_sent_on  indicates the last time that the producer sent updated 
data to consumers.

Note: 
The timestamps are GMT.

2. To view the time lag on a consumer instance, navigate to Instance Data Replication  > 
Monitoring Dashboard  and check the Active Consumer Replication Sets for the following 
details.

Option Description

Name Name of the consumer replication set.

Data Lag
Time between a record change on the produc­
er instance and the moment it is recorded in 
the consumer instance.

Network Lag
Time between a record change logs in the out­
bound replication queue and the moment it is 
recorded in the consumer instance.

Status
Status of a replication set, either active or in 
error.

Status Message Message that describes the error status.

Message Queue Version
Version of the Message Queue. Either V1 
(Legacy) or V2 (Hermes)

To get additional information, view the consumer instance xmlstats at https://
<consumer-instance-name>/xmlstats.do?include=idr. 

The xmlstats shows:

◦ The consumer_last_run  indicates the last time that the consumer job ran and received 
changes from the producer.

◦ The last_heartbeat_received_on  shows the timestamp when the consumer last 
received a heartbeat from the producer instance.

Note: 
The timestamps are GMT.
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Fix seeding errors in Instance Data Replication

Retry Instance Data Replication  (IDR) seeding on tables with seeding errors, which occur from 
network problems and failed inserts, so that you don't have to do a full seeding.

Before you begin
Role required: idr_admin or admin

About this task
The maximum for a retry reseeding request is 10,000 errors. If you have more errors, perform a 
full seeding.

Note: 
Seeding is not a replacement for cloning. Do not use IDR  to clone instances.

Do not retry full seeding if you exceed any of the following limitations:

• Record size exceeds 10 MB

• Seeding request exceeds 3 million records

• Replication takes longer than seven days to complete

Note: 
To avoid these limitations, reduce the number of tables in the seeding request, reduce the 
size of the records, or use partial seeding.

Procedure

1. On the consumer instance, navigate to Instance Data Replication  > Consumer Replication 
Sets.

2. On the Seeding Requests  tab of the Consumer Replication Set pane, click a seeding request 
that failed.

3. On the Seeding Request pane, click the Payload Errors  tab and examine the values in the 
Message column.

4. Click Retry All Errors  or select specific errors, and then click Retry Selected Errors.
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The image shows areas where you can retry errors.

Find Instance Data Replication  errors

Identify Instance Data Replication  (IDR) errors by viewing the metadata for messages between 
producer and consumer instances, payload error logs, and message logs.

Before you begin
Role required: idr_admin or admin

Procedure

1. View the producer or consumer metadata logs.

Option Description

Producer

Navigate to Instance Data Replication  > Pro­
ducer Replication Sets, select a producer 
replication set and click the Replication Meta­
data Logs  related link.

Consumer

Navigate to Instance Data Replication  > Con­
sumer Replication Sets, select a consumer 
replication set and click the Replication Meta­
data Logs  related link.

2. On either the producer instance or the consumer instance, to view transformation errors and 
replications that failed to load:

a. Navigate to Instance Data Replication  > Replication Payload Error.
If the Source  value is Seeding, the error occurred during seeding. If the source value is 
different, the error occurred during a replication set update. If any column breaks during 
transformation, transformation for the entire table breaks and data is not replicated in the 
table.

b. Select an error in the Created column.
The Error Message  field on the Payload Error pane describes the payload error.

3. View the replication log on either the producer instance or the consumer instance:
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a. Navigate to Instance Data Replication  > Replication Log.

b. Select an entry.
The Instance Data Replication Log form shows the message and message level.

Status messages and status errors for a consumer replication set in Instance Data Replication

Review the status of your consumer replication set and research error messages to identify or fix 
Instance Data Replication  (IDR) replication issues.

Consumer replication set status and status message

Navigate to Instance Data Replication  > Consumer Replication Sets  to access a consumer 
replication set, and view the status and status messages.

Consumer Replication Set

Status

Status Description

In Draft To use your consumer replication set, click 
Activate.

Activation Requested After you initiate an activation, you must wait 
for the producer instance to respond to your 
request. If the wait time is excessive, then 
check the replication log for errors.

Seeding The seeding job must complete before 
replication can resume.

Seeding Paused The seeding job must resume before the 
seeding can continue.

Active Normal status.
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Status  (continued)

Status Description

Replication Stopped Check the Status Messages in the following 
table for a specific message and associated 
fix.

Replication Paused The replication process must resume before 
the replication can continue.

Replication Error Check the Status Messages in the following 
table for a specific message and associated 
fix.

Replication Deactivated Activate the producer and consumer 
instances.

Subscription Requested Approve the request for a consumer 
subscription on the producer instance.

Status Messages

Message Action

All Producer Replication Sets 
have been deactivated due to 
fatal replication error

All consumer replication sets are moved to 
the error state. Contact Customer Service and 
Support.

Consumer replication set 
received out of order messages

Contact Customer Service and Support.

Error while seeding data. 
Please refer to the Replication 
Payload Error table for details

On the consumer instance, more than one 
record failed to seed. To recover, go to the 
Replication Payload Error  table to find and fix 
the error, and then activate the replication set.

Error while seeding data. 
Please retry seeding this table

To recover, reseed the table.

Producer has encountered an 
error while seeding

To recover, contact the administrator of the 
producer instance to determine the cause of 
the problem.

Producer Replication Set 
configuration has been modified

On the consumer instance, click Synchronize 
Replication Entries  and then click Activate.

Producer Replication Set 
has been deactivated due to 
replication error

Contact Customer Service and Support.

Producer Replication Set has 
been deactivated

To recover, activate the producer replication 
set, and then activate the consumer 
replication.

Producer Replication Set has 
been deleted

To recover, delete the consumer replication 
set.

Producer Replication Set is 
inactive

To recover, activate the producer replication 
set, and then synchronize and activate the 
consumer replication set.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2798



Status Messages  (continued)

Message Action

Producer Replication Set not 
found

To recover, delete the consumer replication 
set.

Replication Set Paused To recover, click Resume  or Activate.

Replication set was in pause/
error/seeding pause state for 
more than 7 days

The consumer replication set has been in the 
pause state, error state, or seeding pause 
state for more than the timeout period. The 
replication set is put into the disabled state. To 
recover, check for seeding errors  and activate 
the replication  with seeding.

Seeding has been terminated due 
to timeout

To recover, retry the seeding request or 
contact Customer Service and Support.

Seeding request for a Producer 
Replication Set containing more 
than X number of records is not 
supported

To recover, change the filter criteria to reduce 
the number of records to be seeded or use 
partial seeding. The default limit is 10 million 
records. Contact Customer Service and 
Support  to change the default limit.

Seeding was cancelled by a 
consumer admin

To recover, activate the replication set.

Seeding was cancelled by a 
producer admin

To recover, activate the consumer replication 
set. Only seeding requests in the queued, 
paused, or started states can be canceled. In 
this case, the consumer replication state is 
Replication Error.

Shared key not matching The producer and consumer replication sets 
have different shared keys. To recover, copy 
the shared encryption key on the producer 
replication set, paste it into the consumer 
replication set, and activate the replication set.

Instance Data Replication  XML stats

Extract Instance Data Replication  (IDR)-related data from your instance to monitor replication 
status.

IDR  XML Stats

You can view key metrics from your IDR  producer and consumer instances to monitor 
performance and the status of IDR  processing.

In a browser where the instance is running, append the following text to the instance URL: 
xmlstats.do?include=idr. The following output is an example of the IDR  XML stats.

<idr status="enabled">
<producer producer_last_run="2020-11-06 13:45:30" 
replication_queue_position="data_replication_queue0001@2020-11-0
5T22:58:32Z,2732,0,1" 
replication_queue_reading_lag="00:01:00">
<replset last_message_sent_on="2020-11-06 13:44:31" 
last_position="data_replication_queue0001@2020-11-05T22:58:32Z 
 2731,0,1" 
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last_sent_message_id="f339a84ac818201050bec7cf110d4135" name="N-
2NormalStickyReplicaiton" 
status="active" topic_name="d59f4226db6680504d2bac44d49619a0.570
532d91b582010ef39fcc4cc4bcba1">
<subscriber name="persistencetestingora9" remote="false"/>
</replset>
<replset last_message_sent_on="2020-11-06 13:44:31" 
last_position="data_replication_queue0001@2020-11-05T22:58:32Z,2
732,0,1" 
last_sent_message_id="7f39a84ae5182010fad1a90f50fcd335" 
name="N-1NormalTransformerReplication" 
status="active" 
topic_name="d59f4226db6680504d2bac44d49619a0.6f0572d91b582010ef3
9fcc4cc4bcb01"/>
</producer>
<consumer consumer_last_run="2020-11-11 14:22:36">
<replset data_lag="00:00:22" 
 last_heartbeat_received_on="2020-11-11 14:22:36" 
 last_message_received_network_time="00:00:05"
last_position="data_replication_queue0002@2020-11-11T18:50:47Z,2
12,0,1" name="N-2NormalTransformerReplication"
producer_name="byungidrorlandonightlyconsumer6" remote="false" 
 status="active" 
 topic_name="07f85510db93005407072f17d496196a.21247ddddb182010ed
02e3e2ca9619c9"/>
<replset data_lag="00:00:22" 
 last_heartbeat_received_on="2020-11-11 14:22:36" 
 last_message_received_network_time="00:00:06"
last_position="data_replication_queue0000@2020-11-10T23:28:58Z,1
374,0,1" name="N-1NormalStickyReplication"
producer_name="byungidrparis1" remote="false" status="active" 
 topic_name="559cd6d2db6ad458a667cac505961973.bdc33951db9020107c
fe200c0b9619ea"/>
</consumer>
</idr>

IDR  Metrics

Metric Description

idr status Shows whether IDR  is enabled for your 
instance.

Producer instance

producer producer_last_run The last time that the IDRProducerJob 
scheduled job ran (GMT).

producer 
replication_queue_position

Position of the cursor in the replication queue.

replication_queue_reading_lag The time between when a change is made, 
and when the IDRProducerJob  scheduled 
job sends that change to the network.

replset last_message_sent_on The last time data was sent to the network 
from this replication set.
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IDR  Metrics  (continued)

Metric Description

replset last_position The cursor position in the 
data_replication_queue when the last 
message was sent for this replication set.

last_sent_message_id The message ID of the last sent message from 
the data_replication_queue.

name The name of the replication set.

status The replication set status.

topic_name The topic name in the message queue for this 
replication set.

Consumer instance

consumer_last_run The last time the IDRConsumerJob 
scheduled job (local) or 
IDRDeltaConsumerJob-
<instanceid>  scheduled job (remote) ran 
(GMT).

replset data_lag Time since the last heartbeat was received. 
Heartbeats should occur every minute for a 
replication set.

last_heartbeat_received_on Time of the last heartbeat for this replication 
set.

last_message_received_network_time For the last received message, the time 
difference between when it was sent to the 
message queue and when it was picked up by 
the consumer instance.

replset last_position The cursor position in the 
data_replication_queue, at which the last 
message was sent for this replication set.

name The name of the replication set.

status The replication set status.

topic_name The topic name in the message queue for this 
replication set.

Instance Data Replication  reference

These reference topics provide additional information about data privacy in Instance Data 
Replication  (IDR) and domain separation.

Data privacy in Instance Data Replication

The ability of replication sets to host multiple remote consumers in Instance Data Replication 
(IDR) means that there are potential data privacy issues to consider.

Replications sets in IDR  serve multiple instances with multiple consumers. A replication set can 
have a single customer or can have multiple customers. A consumer could also be located within 
the same geographic region as the producer or located in a different geographical region.
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Depending on how you configure your replication set, you can have data sharing internally, 
between offices of the same company, or externally, extending across multiple companies. You 
can also confine data sharing to a single location or region, or you can share data across all 
regions.

An active replication set occurs after the producer instance administrator approves a consumer 
subscription. An active replication set involves data transfer, which could include transfer of 
personal data, between geographical regions. The data transfer between different geographical 
regions could subject the data to differing personal data regulations.

During the approval process, if IDR  determines that the consumer and producer instances are 
in different geographical regions, it alerts the producer before activation. This alert should make 
administrators aware of the potential for differing data transfer regulations between regions.

Once a replication set is active, a replication set with multiple consumers might have specific 
discrete rules which direct specific data to specific consumers. Any modification of a discrete 
rule on an active replication set which spans multiple consumers has the potential to expose 
data. This data exposure can include personal data, which might be viewable by unintended 
consumers that subscribe to the replication set.

If you set bi-direction between a producer and consumer instance, the consumer can originate 
data that shares back to the producer instance. This data can also potentially reach any other 
consumer that is part of the replication set.

Adapter descriptions for Instance Data Replication

Adapters modify the producer data before inserting the data on consumer instances in Instance 
Data Replication  (IDR).

Adapter fields

Each adapter has Name  and Description  fields. The name appears in the Adapter column. Use 
the Description  field to explain the purpose of the data conversion.

Calculation adapter

Use the calculation adapter on the producer data to specify the operation and the value that is 
used in the operation.

Parameter examples

Parameter and value Source data Adapter output

Operation: Multiply

Constant Value: 1.08

10 10.80

Operation: Max

Constant Value: 1000

1020 1000

Operation: Floor

Constant Value: 0

5.5 5

Max  specifies the highest and Min  specifies the lowest possible values. Values above or below 
those limits are set to those limits. Value types such as int  and long  have maximum and minimum 
values. Values above or below those limits cause precision errors.
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Concatenate String adapter

Use the concatenate string adapter to append a specified string to the source data.

Parameter example

Parameter and value Source data Adapter output

String: _v2 Patch10236 Patch10236_v2

Fixed-width format adapter

Use the fixed-width format adapter to reformat fixed-width input data. Use    to represent any 
positive integer, @  to represent any character, and \  as the literal escape character.

Parameter examples

Parameter and value Source data Adapter output

Match:           

Output: (   )    -    

7605551212 (760) 555-1212

Match:      

Output:    .  

10000 100.00

Match:   \,   

Output:      

10,000 10000

Map adapter

Use the map adapter for comma-separated pairs of literals to map source-to-target conversions. 
Matches must be exact. For example, PRB=TASK would not convert PRB1000 to TASK1000.

Parameter examples

Parameter and value Source data Adapter output

Map: PRB=TASK, done=complete PRB TASK

Map: PRB=TASK, done=complete done complete

Map: PRB=TASK, done=complete PRB1000 (no mapping)

Pattern adapter

Use the pattern adapter for regular expressions to identify input patterns. Use parentheses in the 
Regex  to identify groups. In Output Pattern, use $  to specify groups. $0  represents the entire 
input, $1  represents the first group, $2  represents the second group, and so on. You can also 
insert, prefix, and append literal characters, including spaces so they appear in the adapter 
output.
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Parameter examples

Parameter and value Source data Adapter output

Regex: (.*),(.*)

Output pattern: $2 $1

Smith, John John Smith

Regex: (ABC[a-zA-z][a-zA-z])(ABC[a-zA-z][a-zA-
z])

Output pattern: $1 $0

ABCDEABCFG ABCDE ABCDEABCFG

Regex: (ABC[a-zA-z][a-zA-z])(ABC[a-zA-z][a-zA-
z])

Output pattern: $1 release $0

ABCDEABCFG ABCDE release 
ABCDEABCFG

In the second example, the match is ABC followed by two letters, followed by ABC  and two 
letters. $1  of this input is ABCDE. $2  of this input is ABCFG. $0  is the entire input string. So $1 
$0  is ABCDE ABCDEABCFG.

Replace adapter

Use the replace adapter to replace a specified input string or substring with a specified 
string. Use $  to replace only some of the occurrences of the string. $1  replaces only the first 
occurrence; $2  replaces only the second. Use curly braces to replace the first N occurrences. 
For example, ${3}  replaces the first three occurrences.

Parameter examples

Parameter 
and value

Source data Adapter output

Find: 
London

Replace: 
Madrid

The product is London. The product is 
London. The product is London.

The product is Madrid. The product is 
Madrid. The product is Madrid.

Find: $2 
London

Replace: 
Madrid

The product is London. The product is 
London. The product is London.

The product is London. The product is 
Madrid. The product is London.

Find: ${2} 
London

Replace: 
Madrid

The product is London. The product is 
London. The product is London.

The product is Madrid. The product is 
Madrid. The product is London.
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Split adapter

Use the split adapter for a specified delimiter, such as a space, to break a string into two or more 
strings. In Output Pattern, use $  to specify groups. $0  represents the entire input, $1  represents 
the first group, $2  represents the second group, and so on. You can repeat a group in an output 
pattern, for example, $2, $1, $1. Multiple instances of a delimiter in source data create three 
or more groups.

Parameter examples

Parameter and value Source data Adapter output

Delimiter: “ “

Output Pattern: $2, $1

John Smith Smith, John

Delimiter: “ “

Output Pattern: $2, $1, $1

John Harry Smith Harry, John, John

Delimiter: “ “

Output Pattern: $3

John Harry Smith Smith

Task number adapter

Use the task number adapter to add a prefix or suffix to a task number or replace the task 
number's prefix.

Parameter examples

Parameter and value Source data Adapter output

Modification: Replace

Number Prefix: PRB

New Number Prefix: STRY

PRB80899 STRY80899

Modification: Add Prefix

Prefix: STRY

08099 STRY80899

Time zone conversion adapter

Use the time zone conversion adapter to convert one time zone to another.

Parameter example

Parameter and value Source data Adapter output

Output time zone: PDT 07:00:00 am GMT 00:00:00 am PDT
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Excluded tables in Instance Data Replication

You can't replicate certain tables in Instance Data Replication  (IDR). Child tables of tables in the 
exclusion list are also excluded.

Excluded tables
These tables are excluded from IDR:

• Tables with the prefixes V_PREFIX, SYSX_, sys, ts_, ua_, usageanalytics_, wf_, ecc_, clone_, 
jrobin_, rrd_, imp_, pf_, pfd_, idr_

sys_domain is an exception.

• Rotated tables, including syslog, sys_querystat, ecc_queue, ecc_event, cmdb_metric, sysevent

• Tables without a sys_id

• sso_federation

• saml2_update1_properties

• sso_properties

• digest_properties

• Instance

Child tables that extend these tables are also excluded from IDR  and should not be included in 
replication sets because replication fails if they are included. For example, sc_cat_item extends 
sys_metadata, which is an excluded table. This makes sc_cat_item an excluded table due to 
inheritance.

Tables to avoid replicating:

• cmdb

• cmdb_ci

If you determine the CMDB tables must be replicated, you must use conditions to constrain the 
count of replicated records and ensure all required columns are included in the replication set.

Domain separation and IDR

Instance Data Replication  (IDR) functions at the data level, which means it does not explicitly 
support domain separation.

For a typical use case, data moves from a producer instance to a consumer instance and back 
without regard to which domain the instance is in. You can use IDR  to filter data, enabling you to 
segregate specific data between instances. If you must go beyond the IDR  record-level filtering 
capability, you can use business rules to convert data from one domain to another. For more 
information, see Before Query business rules .

Instance Data Replication  properties

These system properties control the behavior of the Instance Data Replication  (IDR) application.

To set IDR  system properties, navigate to the System Properties [sys_properties] table and add 
the property.
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IDR  data comparison properties

Property Description

The record batch size for data comparison 
results

idr.instance.comparison.batch.size

If the data comparison results exceed 1 million 
records within the given date range, the 
request is divided into batches of 10,000 
records.

• Type: integer

• Default value: 10,000

The threshold for missing or mismatched 
records

idr.dct.mismatched.missing.percentage.threshold

If the number of missing or mismatched 
records exceeds 50% of the total records 
found within the given data range, the 
comparison stops and partial seeding is 
recommended for the given date range 
instead.

• Type: integer

• Default value: 50

The maximum number of records

idr.instance.comparison.max.records

The maximum number of records allowed for 
processing a data comparison.

• Type: integer

• Default value: 500,000

The maximum runtime

idr.instance.comparison.max.runtime

The maximum amount of time allowed for 
running a data comparison.

• Type: integer

• Default value: 15 minutes

Fields to skip

idr.dct.comparison.skip.fields

The list of fields to skip when comparing 
records between instances.

• Type: string

• Default value: 
caller_id,sys_created_on,sys_created_by,sys_updated_on,sys_updated_by

System properties

Property Description

Stop replication if an out-of-order issue occurs

idr.message.gap.order_enforcement.enabled

By default, IDR  stops replication if an out-or-
order issue occurs on the consumer.

You can change the default behavior when an 
out of order issue occurs on the consumer by 
adding this property and setting it to false. 
This automatically re-queues and replicates 
missing messages using the most recent 
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System properties  (continued)

Property Description

record details from the producer without 
stopping replication.

• Type: string

• True: Stop replication

• False: Don't stop replication and re-queue

Note: 
Each producer and consumer instance 
must be on the same family version to 
use this property. Both instances must be 
on Vancouver  or higher.

Set attachment size limit

idr.cdc.replication.table.reader.attachment.size

By default, IDR  doesn't restrict the size of 
attachments.

You can change the default behavior by 
adding this property and entering a maximum 
size for attachments.

• Type: integer (size in bytes)

• Default value: 100,000,000

Instance Data Replication  roles

Instance Data Replication  (IDR) is installed with these roles.

To learn more about managing subscriptions, see Managing per-user subscriptions in 
Subscription Management  and contact your account representative.

IDR  administrator  [idr_admin]

Admin role for accessing all IDR  tables.

Contains Roles

List of roles contained within the role: idr_rest.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

Note: 
Avoid granting an admin role when more specialized roles are available.

IDR  read  [idr_read]

Read role for reviewing IDR  tables.
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Contains Roles

List of roles contained within the role: idr_rest.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

IDR  rest  [idr_rest]

Role required for making a diagnostic request.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

MetricBase
The MetricBase  application stores time-series data, which is data that is sampled at regular 
intervals. You can graph the stored data or use it with triggers to execute Flow Designer  flows.

Get started

Explore

Learn about MetricBase
features and concepts

Configure

Set up MetricBase
and create a time-

series specification

Define and collect data

Create a time-series 
definition, access 

MetricBase data, and 
detect anomalies using 

predictive models.
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MetricBase  users

Users

User Description

Administrator An administrator collects, retains, analyzes, and acts on time-
series data using MetricBase.

MetricBase  workflow

The following figure shows that machine-generated data is sampled every 4 seconds. You send 
the average of the values in each sampling period to the MetricBase  database, which stores the 
data until its expiration date.

Storing time series data

1. The administrator specifies a metric to store and how often to collect it by creating a time-
series definition in MetricBase.

2. The administrator sends data from the instance to the MetricBase  server using the MetricBase 
REST or JavaScript APIs.

3. The administrator configures trigger definitions that execute flows based on time-series data in 
MetricBase.

4. The administrator configures and trains predictive models in MetricBase  to detect anomalies 
and execute flows when new data is significantly different than the trained data.

5. The administrator monitors collected data using time-series charts in MetricBase. Time-
series data remains in the MetricBase  database for a prescribed amount of time, after which 
MetricBase  deletes the data.
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MetricBase  benefits

MetricBase  benefits

Benefit Feature Users

Store time series summary of a large collection 
of data

Create a time-
series definition in 
MetricBase

Administrator

Insert and retrieve time-series data from the 
MetricBase  database

Developer resources Administrator

Access and visualize time-series data in the 
MetricBase  database

Accessing MetricBase 
data

Administrator

Trigger flows when new data is significantly 
different than the trained data

Detecting anomalies 
in MetricBase data 
using predictive 
models

Administrator

Trigger flows that can log incidents, send 
emails, and create other alerts

Triggering flows using 
MetricBase data

Administrator

What to explore next

To learn more about configuring and using MetricBase, see:

• Configuring MetricBase

• Defining and collecting MetricBase data

• Triggering flows using MetricBase data

• Managing MetricBase

• MetricBase reference

Configuring MetricBase

Plan and configure your MetricBase  implementation.

Requesting the MetricBase  product

The MetricBase  plugin [com.snc.clotho] requires a separate subscription and must be 
activated by ServiceNow  personnel.  Be sure to also request the MetricBase  Demo plugin 
[com.snc.clotho.demo], which includes sample tables, metrics, triggers, and data.

To purchase a subscription, contact your ServiceNow  account manager. The account manager 
can arrange to have the plugin activated on your organization's production and subproduction 
instances, generally within a few days.

When ServiceNow  personnel install the MetricBase  Demo plugin, they also connect your 
instance to the server that contains the MetricBase  database. A MetricBase  database can 
connect with only one other instance. For example, a clone of the original instance can't talk to 
the same database as the original instance.

Working with MetricBase  demo data

Familiarize yourself with MetricBase  by exploring the MetricBase  demo.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2812



Overview of the MetricBase  demo

With the MetricBase  Demo plugin, you can experiment with MetricBase  without configuring it or 
knowing much about it. The demo plugin is separate from the MetricBase  plugin. Make sure to 
request both.

Use the MetricBase  demo to explore MetricBase  before you set it up for production purposes.

• Visualize sample time-series data.

• Access sample metrics, triggers, and a scheduled job that collects and stores data.

• Test the functionality of included triggers. The plugin includes scheduled time-series data 
updates, as if they had been received from an instance.

• Experiment with the MetricBase  JavaScript APIs using the Data Explorer.

In the demo, a fictional fleet of drones has been outfitted with sensors that broadcast their 
metrics, including their speed, altitude, and battery life over time.

Getting familiar with MetricBase

After ServiceNow  personnel install the MetricBase  and MetricBase  Demo plugins, you can use 
the demo to get familiar with MetricBase.

Prerequisites

• MetricBase  and the MetricBase  demo plugins must be installed by ServiceNow  personnel.

• Role required: admin

1. Navigate to MetricBase Demo  > Drones  to see the name, model, 
length, width, altitude, and speed for all drones in the fleet. 

2. Select MetricBase Demo  > Metrics  to see how the metrics are defined. In the Time Series 
Metrics list, the column values specify the table where the drone's time-series metrics are 
stored, the names of all the metrics that are stored for each drone, and the retention policy for 
each metric. The retention policy specifies how frequently measurements are taken, and how 
long MetricBase  retains that data.

Now that you've seen the drone data and learned how to find it, let's see how the data was 
collected using a retention policy.
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3. Select a retention policy. The Retention Policy form shows the definition for the policy. In the 
following example, this metric is measured once a minute for the first 8 days, then once every 
10 minutes for the following 94 days, and then once an hour for the following 397 days. After 
that, the system discards the data.

See MetricBase retention policies.

4. To see how the data is aggregated during the Retention Durations, select the left arrow (<) at 
the top of the Retention Policy Schedules window to return to the Time Series Metrics list.

5. Select a table name. The Time Series Metric definition shows the Retention policy aggregator. 
This aggregator summarizes the data as, for example, the average, maximum, or minimum 
value in the aggregation period. In the following example, the admin clicked the table for the 
speed metric. The result is that MetricBase  stores the speed averages during each sampling 
period in the MetricBase  database.

Now that you understand how the data was collected using retention policies, let's see how to 
display the data in lists and graphs.

6. Notice the parameter fields that start with Display. In this example, they mean that the speed 
values that are displayed in the list view of drones are the last speeds recorded in every hour 
interval for each drone. These Display  fields control what appears in the list view of the drones 
only. They have nothing to do with the retention policy.

7. Display the list view of a table by entering <table-name>.list  in the Field navigator 
field. For example, mb_demo_drone.list. All drone data appears. In the example from the 
previous step, the speed column would contain the Last  value of the sampling period.

8. Select MetricBase Demo  > Drones  and look at the speed (kph) column. From the previous 
step, you know that these values are the last speeds recorded for each drone up to an hour 
ago. The values are the same as you would get by using the .list  command.

9. Select the speed value of the first drone. The following graph shows the speed of the drone 
that was measured hourly.
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Note: 
You might need to select a different Time Span  field value to get a clearer graph. For 
example, try 1 Day. The speed is a sine wave because it's artificially generated. Hover 
over the sine wave to see the actual measurements.

10. Select the left arrow (<) to return to the list of drone metrics, right-click on one drone type 
(Model  column), and select Show Matching. Only the drones of the selected type appear.

11. Select the menu icon next to the Altitude column heading and select Time Series Chart. You 
see a graph that shows the altitude measurements of the Warbler-T7-type drones.

You might like to change the Time Span  value for a clearer graph.

12. Select the left arrow (<) to return to the list of drone metrics.
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13. Click the menu icon next to the Altitude column heading and select 
Time Series Chart Designer  to see another way of visualizing the data. 

14. In the Create a Report page that displays in the Reporting  application, vary the graph 
parameters.

Note: 
In the following steps, to stay on the same page, select Run. To advance to the next page 
when designing the graph, select Next.
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a. In the Type pane, select the kind of graph to display, and then click Next. 

b. In the Configure pane, try changing the parameters. Click Run  to view the results with each 
change.

▪ Change the Report Title  to Warbler Altitude.

▪ Apply a condition to filter the view. For example, [Model] [is] [Warbler T7].

▪ Change the Last  value to 1  day.

▪ Select Envelope  in the Transform  list. You see the minimum and maximum (envelope) 
altitudes for the fleet of Warbler T7 drones over time.

▪ select the time line to display on the graph using the Time range  list.

Note: 
Relative  uses the Last  timespan relative to the present time. For example, if Last  is 
1 hour, the time line in the graph always spans the previous hour. You can add this 
report to your dashboard to show the metrics in the previous hour.
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c. In the Style pane, change the Chart color  value, and then click Run. 

You've displayed drone data in lists and graphs. Now, let's define a trigger that executes 
when data that you monitor reaches a threshold value.

15. Select MetricBase Demo  > Trigger Definitions. The MetricBase  Trigger Definitions 
list shows the name (Name) of the trigger, the metric (Metric) the trigger monitors, 
the table (Table name) the metric that it is in, the trigger description, and whether 
the trigger is active. Triggers kick off flows when metrics meet trigger thresholds. An 
example is when a drone flies too low. For more information about triggers, see Trigger 

Workflows.
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16. Select Low-Battery Drone. The MetricBase  Linear Predictor 
trigger form displays the definition of the Low-Battery Drone 

trigger.

In this example, the trigger monitors the Remaining Battery (%)  metric (Metric) in the Drone 
table (Table name) every 10 minutes (Window). If the battery life is trending downward 
(Trend) and is 80% likely (Confidence Level) to reach 20% (Threshold) within 20 minutes 
(under Window  for Level  1), the trigger executes. Although it fires, nothing happens until you 
associate this trigger with a flow. The flow defines the actions to take.

17. Select MetricBase  > Trigger Flows.

18. Select New flow  to associate a trigger that is defined in the system to a flow.

19. In the Flow name  field, name the flow and select Submit. 
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20. Click Add a Trigger  and select MetricBase  in the list. 

21. In MetricBase Trigger, select a trigger that already exists and select Done. Alternately, 
select the plus sign to the right of MetricBase Trigger  to create a new trigger. 

22. Select Add an Action, Flow Logic, or Subflow.

23. Select Action  to specify the actions to take when the trigger fires. The Action dialog box 
appears.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2820



24. Select a domain of actions from the left column and the specific action to take in the right 
column.

25. Select Save  and Activate. The flow doesn't execute unless it is activated. For more information 
about Workflow Studio, see Workflow Studio .

The following table summarizes the modules in the MetricBase  demo.

MetricBase demo modules

Module Description

Drones Table that keeps metrics on drones, such as speed and altitude. 
Each record is a different drone. You can add records.

Fleets Table that maintains metrics about groups of drones. Each record is 
a different fleet. You can add records.

Data Generators Table that defines how data is created for the drone records. This 
field is provided for informational purposes. You cannot change or 
add records.

Metrics List of metrics that are defined in the system. This list is the same 
table as MetricBase  > Time Series Metrics. You can add metric 
fields.

Scheduled Jobs Scheduled job that is created for the demonstration application. The 
job runs every five minutes to add data to the demo tables in the 
MetricBase  database. You can change the schedule.

Trigger Definitions List of triggers that are defined in the demo. This list is the same 
table as MetricBase  > MetricBase Triggers  > Trigger Definitions. 
You can create additional triggers.
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MetricBase demo modules  (continued)

Module Description

Anomaly Logs List of logs that result from triggers firing. The Low-Flying Drone 
trigger creates the anomaly logs.

Data Explorer Widget that enables you to experiment with MetricBase  JavaScript 
APIs using the demonstration application data. See Get Familiar 
with MetricBase APIs  for more information.

Get familiar with MetricBase  APIs

Experiment with MetricBase  APIs using Data Explorer  that is part of the MetricBase  Demo 
application. Data Explorer  uses the data installed with the MetricBase  Demo application.

Before you begin
Role required: clotho_admin

About this task
Data Explorer  is a playground where you can see and edit example scripts that visualize data 
included with the MetricBase  Demo application. The example scripts use the MetricBase 
JavaScript APIs. For information on the MetricBase  JavaScript APIs, see Client , Data , 
DataBuilder , Transformer , TransformPart , TransformResult .

Note that the now/v1/clotho/transform/topic API endpoint is reserved for internal use only.

Example scripts use either:

• Transforms, which use the Transformer  method.

• Machine Language, trained models that predict expected behavior. All the scripts without 
"Transform" in their title use Machine Language.

Procedure

1. Navigate to All  > MetricBase Demo  > Data Explorer.
The Data Explorer  displays.
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When you run a script, the data visualization appears under Data Explorer Script Result 
Display.

2. Select one of the sample scripts to run in the Example Script  menu.

3. Click Load Example.

4. Click Run.
The script displays the data visualization under Data Explorer Script Result Display.

5. Optional:  Change the values or statements in the script or write an entirely new script and 
click Run.

Note: 
If you want to save the changes you made in the script, click Save.

6. Under Server Output, look at the server's response that might include error information.
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Example:

Example scripts

Example script Definition and visualization

Simple Transform Uses the transformer API to display a single time-
series metric, the average speed of the drones: 
transformer.metric('mb_demo_mt_speed').avg().

Simple Transform with 
Grouping

Uses the transformer API to display a group of time-series 
metrics, the average altitude of the fleet of the drones:

transformer.groupBy("fleet").metric("mb_d
emo_mt_altitude").
      avg().label('avg - %g:fleet:')

Normal Model Models normal data, which approximates a bell-shaped or 
Gaussian curve for distributed values.

Linear Model Creates a line to summarize the current data and predict 
future values. This example, about the remaining charge in 
drone batteries, graphs both the trained model values and the 
average of the values.

var builder = new 
 sn_clotho.Transformer(drones);
var fit = 
 builder.metric("mb_demo_nt_rem_battery")
.resample(100).
         
 fit({model:"linear"}).label("Fitted");
builder.metric("nb_demp_mt_rem_battery").
avg().label("Original")
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Example scripts  (continued)

Example script Definition and visualization

Seasonal Trend 
Decomposition Model

Uses a seasonal trend model so that data can be subtracted to 
reveal non-seasonal trends. This model is similar in purpose to 
the Holt Winters model but arrives at the result using different 
algorithms.

var builder = new 
 sn_clotho.Transformer(drones);
var metric = "nb_demo_mt_rem_battery";
var fit = 
 builder.metric(metric).fit({model:"STL",
periodicity:"PT2H",
          innerCycles:1, outerCycles:10})

Holt Winters Model Uses the Holt Winters, seasonal trend model so that data can 
be subtracted to reveal non-seasonal trends. This model is 
similar in purpose to the Seasonal Trend Decomposition model 
but arrives at the result using different algorithms.

ARIMA Model The most general class of models for predicting time-series 
data that has no trend, meaning all the data has the same 
value or the values fluctuate sinusoidally around the mean.

Deviation Model Uses chisquare model to show the differences between the 
real data and the model's prediction.

var metric = "nb_demo_mt_rem_battery";
builder.metric(metric).deviation(model, 
 "chiSquare");

Defining and collecting MetricBase  data

Store time-series summaries of much larger data collections.

Overview of creating a time-series definition

In MetricBase, you specify the metric that you want to store and how often to collect it. You 
can also determine how long to store it in the MetricBase  database. Then, you send the data 
from an instance to the MetricBase  server at the rate that you define using MetricBase  REST 
or JavaScript APIs. In this way, you can monitor a much larger data collection with MetricBase 
summaries of it.
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MetricBase  collects the metrics of how often you send data and what the aggregation of that 
data is, for example, maximum, minimum, average, or last. This data is called time-series data. 
For example, if you collect drone speeds on an instance, you can send the average drone speed 
for every two minutes to the MetricBase  database. You can also collect altitude and battery life. 
MetricBase  stores each metric as a column in its database.

Sending information from an instance to a MetricBase  server

Retention policy schedules

Retention policy schedules  specify how long MetricBase  stores the time-series data in the 
MetricBase  database. You can create, edit, and delete retention policy schedules. To create, edit, 
or delete retention policy schedules, navigate to MetricBase  > Retention Policy Schedules.

When creating a retention policy schedule, the following limitations apply:

• Maximum retention duration: 26 months (794 days)

• Maximum sampling period: 1 day

• Maximum data points (calculated as retention duration * sampling period): 160,000 data points

In addition, the retention duration must be a multiple of the sampling period.

Retention policies

Retention policies  include multiple retention schedules with coarser granularity the longer that 
the data is kept. For example, the Coarse retention policy stores sampled data every:

• Hour for one week (7 Days per 1-hour period)

• Two hours for one month (31 days per 2-hour period)

• Day for 13 months (397 Days per 1-day period)

In this policy, the specified metric is measured every hour for the first 7 days. It is then measured 
every other hour for the next 31 days, and once a day for the next 397 days. MetricBase  deletes 
data that is older than 435 days.

To see the list of all supported retention policies, navigate to MetricBase  > Retention Policies.
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Create a time-series definition in MetricBase

Specify the metric that you want to store, how often to collect it, and how long to store it in 
MetricBase.

Before you begin

• Install MetricBase

• Role required: clotho_admin

Procedure

1. Navigate to MetricBase  > Time Series Metrics.

2. Select New.

3. On the form, fill in the fields.

Time series metric form

Field Description

Label Intuitive name for the Metric field name. For example, altitude could 
be the label for the metric field name, mb-altitude.

Table name Name of the table to add the metric to in the MetricBase  database. 
For example, in the MetricBase  Demo, the mb_drone table stores 
the drone data. Each column in the table is a different metric, for 
example, altitude, length, and speed.

Metric field name Name of the time-series metric that records. For example, mb-
altitude. You can think of it as the name of a column in the MetricBase 
database table.

Retention policy Sampling frequency and how long MetricBase  keeps the values in 
the database. You cannot customize the value. For a definition of the 
values, click the magnifying glass and then a policy. The coarser the 
sampling rate, the less data that stores. Use the coarsest sampling 
rate that works for your dataset. For example, do not collect data 
every minute if collecting it once an hour suffices. See MetricBase 
retention policies  for a description of the policies you can select.

Retention policy 
aggregator

Operator that aggregates the data in a sampling period. For example, 
last, minimum, maximum, and average.

Display value 
aggregator

The aggregation method in use when using <table-name>.list 
where <table-name> is a table in the MetricBase  database. This value 
is unrelated to the retention policy. For a definition of the options, see 
MetricBase transforms .

Display value 
aggregate duration

Duration that is used to calculate the aggregation only when using 
the list view. For example, <table-name>.list  where <table-
name> is a table in the MetricBase  database. This value is unrelated 
to the retention policy.

Subject field You can select a unique table column as your subject for the metric. 
The unique column must be designated on the table before you 
select it. For example, if your metric tracks temperatures in different 
houses, you can make the house address column the subject of your 
metric. The house address column on your table must be unique 
before you set the subject field.
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Field Description

Note: 
The sys_id column is the default unique column.

Data Type You can specify the data type of the subject field.

4. Select Submit.

Result
You've created a time-series specification for a metric that you want to track.

What to do next
Sample the data according to the time-series specification and send it from an instance to the 
MetricBase  database server.

Use the REST or JavaScript APIs to send the data to the MetricBase  database at the rate that is 
prescribed by the time-series definition. See Developer resources.

Important: 
Send the data at the rate that the time-series definition prescribes. If you send the data 
at a different rate or for a different duration, you receive an error. Make sure to aggregate 
the data according to the time-series metric definition. Also, the MetricBase  database only 
stores values of data type float.

MetricBase  retention policies

Retain data in MetricBase  according to retention policies.

MetricBase  Retention Policies

Policy Description

Coarse
This policy retains data for 1 week at 1-hour 
period, 1 month at 2-hour period, and 13 
months at 1-day period.

This policy is suitable for metrics that change 
less often or metrics that do not require high 
resolution, such as disk usage.

Dense This policy retains data for 8 days at 1-minute 
period, 94 days at 10-minute period, and 13 
months at 1-hour period.

This policy is suitable for metrics that require 
higher resolution for longer terms.

High
This policy retains data for 1 week at 1-minute 
period, 1 month at 10-minute period, and 13 
months at 1-hour period.

This policy is suitable for metrics that require 
higher resolution for longer terms.
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MetricBase  Retention Policies  (continued)

Policy Description

Medium
This policy retains data for 1 week at 10-minute 
period, 1 month at 30-minute period, and 13 
months at 2-hour period.

This policy is suitable for metrics that change 
less often such as job processing throughput.

Medium High This policy retains data for 13 months at 1-hour 
period.

Operational Intelligence Operational Intelligence (OI) policy retains 
data for 8 days at 1-minute period, 94 days 
at 10-minute period, and 13 months at 1-hour 
period.

Sparse This policy retains data for 13 months at 1-day 
period.

Ultra Dense This policy retains data for 1 day at 10-second 
period, 3 months at 1-minute period, and 1 year 
at 1-hour period.

Accessing MetricBase  data

Access the time-series data that you sent to the MetricBase  database in the way that is 
convenient to you.

You can access and visualize time-series data in the MetricBase  database by using:

• Reporting  application

You can generate reports and graphs from the time-series data that is stored in the MetricBase 
database. For more information, see Create reports from MetricBase time-series data .

• Table lists using the .list  command

For more information, see View MetricBase  data using the list command.

• REST or JavaScript APIs

For more information, see Retrieve MetricBase  data using REST and JavaScript.

Access MetricBase  data using the list command

Use the list command on a table in the MetricBase  database to view time-series data. The data 
reveals the behavior of the entity that supplies the data.

Before you begin
Role required: admin

Procedure

1. On the MetricBase  instance, in the application navigator, type <table-name>.list, and 
press the Enter key.
<table-name> is the name of the table in the MetricBase  database that contains the metric you 
want to view.
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2. Click the menu icon ( ) above the metric column, and select Time Series Chart.

3. Change the Time Span  and Transform  fields to evaluate the data.

4. Optional:  Adjust the data:

a. Select one of the transforms: Add, Multiply, or Divide.

b. In the Value  field, enter the number to add, multiply, or divide the metric data by and click 
Submit.

Note: 
The adjusted data is not saved in the MetricBase  database.

Retrieving MetricBase  data using REST and JavaScript

Use JavaScript or REST APIs to insert and retrieve time-series data from the MetricBase 
database and to run transforms on the data. The transformations enable you to visualize time-
series data in a variety of ways.

For more information about MetricBase  time-series data transformations, see MetricBase 
transforms .

Using REST

For information about the MetricBase  REST APIs that return time-series data from the MetricBase 
database, see MetricBase Time Series API .

Using JavaScript

For information about the MetricBase  JavaScript APIs that return time-series data from the 
MetricBase  database, see:

• Client  — Execute transforms on the MetricBase  database and receive the results.

• Data  — Return the object that contains the result of a transform.

• DataBuilder  — Create a series of data points for a metric.

• Transformer  — Manipulate time-series data to prepare the data for evaluation and analysis.

• TransformPart  — Specify details of the transform to be done.

• TransformResult  — Return the object that contains the result of the transformation.

Experiment and get familiar with the JavaScript APIs by using the MetricBase  Data Explorer  that 
comes with the MetricBase  Demo.

Detecting anomalies in MetricBase  data using predictive models

MetricBase  creates a model by training a representative sample of your time series data to 
determine the model parameters. The training process determines the model parameters that 
best fit your data, to distinguish normal data from anomalous data.

MetricBase  supports the following model types:

• Probabilistic Exponentially Weighted Moving Average (PEWMA), a moving average algorithm 
that uses a probability factor to determine how it reacts to change in data

• Autoregressive Integrated Moving Average (ARIMA), a moving average algorithm that factors in 
previous errors and values
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• Seasonal Trend decomposition using Loess (STL), a seasonal algorithm for decomposing time 
series data into seasonal and trend components

• Holt-Winters (HW), a seasonal algorithm that decomposes the trend and seasonal 
components to determine the level

Note: 
MetricBase  selects the most appropriate model type when you select Find Best Fit 
Model  from the model class list.

After you have a model trained from your data, you can trigger flows when new data is 
significantly different than the trained data.

Create and train a predictive model

Use statistical models to determine significant anomalies in real-time using MetricBase  triggers. 
You will need to train a model using representative data that has already been stored in 
MetricBase.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > MetricBase  > MetricBase Models.

2. Select New.

3. On the form, fill in the fields.

Model New Record form

Field Description

Model name Name of the model. The name can be any combination of alphanumeric 
characters. This model name is not the same as the model class. In 
general, the name relates to the value in Group by.

Table name Name of the table that contains the training data.

Metric Name of the metric that you use to train the model. The metric must 
belong to the table.

Created Date that you trained the model.

Filter Filters that you use to exclude some of the data in the dataset.

Note: 
When choosing data to train your model, try to select data that 
demonstrates an expected behavior to reduce anomalies in the 
training set.

Group by You can use Group by  as a discriminator field for your model data. For 
example, if you want to create a data model over a group of production 
servers whose performance differs by role (such as database or 
application server roles) then you would choose role as the Group by 
field. The training process creates one model per role in the group of 
records selected by the filter. You do not have to manually create a model 
for each role.
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Field Description

Model Class The algorithm to use when training data. Select a moving average 
algorithm (PEWMA, ARIMA), a seasonal algorithm (STL, HW), or choose 
Find Best Fit Model. The default is Find Best Fit Model, which tries each 
algorithm and selects the one which appears to have the best fit over the 
training set.

Training Dataset 
Start Date

MetricBase  time series data for the metric starting with this date.

Training Dataset 
End Date

MetricBase  time series data for the metric ending with this date.

Valid until Date that serves as a reminder to consider retraining the model. If the 
model is performing well, there's no need to retrain it. The model can 
continue working past this date.

Active Option to use the trained model. Once the model is active it becomes 
available for use as a Workflow Studio  trigger.

4. Click Submit and Train.
MetricBase  trains the model. When complete, the model appears on the MetricBase Model 
Instances  tab.

5. Click the model name.
The modeling data appears as does the model string with the parameters optimized by the 
training.

6. Optional:  Click the model name and then click Set Model  to change the model parameters.
You can edit the model parameters when you want to override the settings for training your 
model. The graph does not update, you are saving the revised model string.

What to do next
You can create a Workflow Studio  trigger for this model. For more information, see Create a 
model trigger.

Triggering flows using MetricBase  data

Time-series data that is stored in the MetricBase  database can trigger Workflow Studio  flows. 
These triggers can log incidents, send emails, and create other alerts.

A trigger definition is a set of conditions that automatically executes a Workflow Studio  flow. 
When you create a trigger definition in MetricBase  and associate it with a flow, the trigger 
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definition transfers from your instance to the MetricBase  server. After you activate the trigger and 
flow, MetricBase  monitors time-series data in the MetricBase  database. When time-series data 
matches the initial triggering condition, and then transitions from one condition to the next, a 
transition trigger is generated and added to the queue. The instance polls the queue, processes 
the transition trigger, and then executes the Workflow Studio  flow.

Trigger workflow

For more information about time-series policies, see Create a time-series definition in 
MetricBase.

High-level overview of implementing triggers

1. Define one or more triggers on an instance.

Band trigger

Triggers when a metric value falls within a range of values.

Linear predictor trigger

Triggers when a series of values trend toward and are expected to reach a 
specified value.

Gap trigger

Triggers when values are not received for a specified period.

Model trigger

Triggers when a trained model detects anomalous behavior.

2. Create a trigger condition to add additional requirements for a trigger to execute a flow.

(Optional) For example, data often fluctuates over time. Small fluctuations can cause 
unwanted, duplicate triggering events. A Condition Script can prevent that erroneous 
duplication.

3. Associate the trigger with the flow it executes using Workflow Studio.

4. Test the trigger and workflow.

5. Activate the trigger.
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Deleting triggers

If a trigger is associated with a flow, you can't delete it in MetricBase. To delete a trigger, you must 
first delete the flow in Workflow Studio  and then you can delete the trigger in MetricBase.

Legacy triggers

Legacy triggers are deprecated. You can't create legacy triggers; you can only carry forward 
legacy triggers that exist.

Create a MetricBase  band trigger

Create a MetricBase  band trigger that detects when a metric value falls within a range of values.

Before you begin
Role required: admin

About this task
Band triggers execute when metrics fall outside of or within a range of values.

Band trigger values

Procedure

1. Navigate to All  > MetricBase  > MetricBase Triggers  > Trigger Definitions.

2. Select New.

3. On the MetricBase  Trigger Creation form, select the Band Trigger  option.

4. On the form, fill in the fields.
The trigger levels are not initially visible on this form. You configure the levels later.

MetricBase  Band Trigger form

Field Description

Name Name of the band trigger.

Table name
Table in the MetricBase  database that 
contains the metric that you want to monitor. 
The only tables that appear when you click 
the search icon are the tables that you 
specified in the time-series metrics.

If you select a metric before you select 
a table, only tables that have that metric 
appear in the Table name  dialog box.
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Field Description

Metric
Table metric that you want to monitor that 
is specified by the Table name. The only 
metrics that appear when you click the 
search icon are the metrics in that table.

If you select a metric before you specify a 
Table name, the metrics in all your time-
series metrics appear. After you select a 
metric, only the tables that contain that 
metric appear when you click the search icon 
that is next to the Table name.

Active Option to activate the trigger.

Description Description of the trigger.

Aggregator Aggregation value that you select: None, 
Max, Min, or Average. None  means that you 
use the last value in the collection period.

Window Length of time used to calculate the 
aggregation function. For example, assume 
the Window  is 1 hour and the aggregator 
is Min, and a new data point is added to 
the series. The system calculates the new 
minimum using the new data window (the 
last hour of data including the new data 
point). The new minimum is compared to the 
different trigger levels to determine whether 
to execute the trigger.

5. Select Save.
A new record is created.

6. In the MetricBase  Band Trigger Levels section on the record you just created, double-click 
each cell to add values that specify trigger parameters.

MetricBase Band Trigger Levels

Field Description

Level Numbers that indicate increasing severity. 
For example, you might define the altitude for 
level 1 to be less than 50 meters, but above 
25 meters, and the altitude for level 2 to be 
less than or equal to 25. Each level should 
trigger a different flow. Level  is often used 
in Condition Scripts. See Execute triggers 
conditionally.

Function Function that makes the Value  the maximum 
or minimum of the lower end of the band. 
Therefore, the function defines whether 
trigger values are inside or outside of the 
band. For example, if the Function  is Less 
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Field Description

than, the trigger executes when the metric 
goes below the band value.

Value Lower end of the band. See the following 
image.

Band Function Function that makes the Band Value  the 
maximum or minimum value of the upper end 
of the band. Therefore, the band function 
defines whether trigger values are inside 
or outside of the band. For example, if the 
Band Function  is Greater than, the trigger 
executes when the metric goes above the 
band value. See the following image.

Band Value Upper end of the band. See the following 
image.

Tolerance Sets tolerance margins around the Value 
and Band Value  to prevent repeatedly 
executing a trigger for small fluctuations in 
the data. After a trigger executes, the data 
must exceed the tolerance to execute the 
trigger again. See the following image.

For example, assume the Function  is Greater than, the Value  is 25, and the Band Value  is 50.

◦ If the Tolerance  is 0, the trigger executes for all values that are less than 50 and greater than 
25.

◦ If the Tolerance  is 5, the ranges are 50 ± 5 (45-55) and 25 ± 5 (20-30).

◦ If the last two data points in order were 51 and 49, the trigger executes because 49 is below 
the Band Value.

◦ If the next two data points in order are 51 and 49, the trigger doesn't execute again because 
the values are within the tolerance range since the last trigger execution.

7. Add one or more rows to the table to create multi-layered triggering behavior.

Note: 
You must define at least two levels in a band trigger so that there are levels to transition 
between.
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Typically, each additional row (level) indicates a more severe condition. The Flow Designer  flow 
associated with the level should warn with increasing severity.

8. Select Update.

9. Optional:  Add a triggering condition that determines whether a trigger executes a Workflow 
Studio  flow.
See Execute triggers conditionally.

Example: Band Trigger form

What to do next
Associate this trigger with a Workflow Studio  flow. For more information, see Assign a trigger to a 
flow.

Create a MetricBase  linear predictor trigger

Create a MetricBase  linear predictor trigger to detect when a metric is likely to cross a specified 
threshold within a specified period of time.

Before you begin
Role required: admin

About this task
The linear predictor trigger uses past data to generate a line that predicts future values. When 
MetricBase  predicts that the linear value reaches a threshold, the trigger executes.

Linear predictor crosses the threshold

If the most recent data point reaches the threshold, the trigger executes regardless of the linear 
prediction.

Trigger parameters include how much past data to use in the calculation of the prediction, how 
far ahead to look, and the level of confidence that you accept.
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Procedure

1. Navigate to All  > MetricBase  > MetricBase Triggers  > Trigger Definitions.

2. Select New.

3. On the MetricBase  Trigger Creation form, select the Linear Predictor Trigger  option.

4. On the form, fill in the fields.
The trigger levels are not initially visible on this form. You configure the levels later.

MetricBase Linear Predictor Trigger form

Field Description

Name Name of the linear predictor trigger.

Table name
Table in the MetricBase  database that contains the metric that 
you want to monitor. The only tables that appear when you 
click the search icon are the tables that you specified in the 
time-series metrics.

If you select a metric before you select a table, only tables that 
have that metric appear in the Table name  dialog box.

Metric
Table metric that you want to monitor that is specified by the 
Table name. The only metrics that appear when you click the 
search icon are the metrics in that table.

If you select a metric before you specify a Table name, the 
metrics in all your time-series metrics appear. After you select 
a metric, only the tables that contain that metric appear when 
you click the search icon that is next to the Table name.

Active Option to activate the trigger.

Window Length of time used to calculate the line that predicts the 
future course of the value. For example, you might want to use 
the last 10 minutes of data to calculate the linear predictor. If 
the value is too long, the line does not reflect current trends. 
If the value is too short, the line might follow the raw values 
too closely and not accurately reflect the overall trend of 
the values. The value must be at least 10 times the sampling 
period that is defined by the sampling rate of your Metric.

Warning: 
Do not confuse this value with the Window  value in the 
trigger level. That value specifies how far into the future 
that you want the linear predictor to look to see if the 
Metric  is likely to cross the Threshold.

Confidence Level (%) A measure of how closely the real data fits the linear prediction 
of the data. A confidence level of 95% means that the real 
value must be within 5% of the predicted value to execute 
a trigger. If you only want to trigger when the real values are 
close to the predicted values, choose a high confidence 
percentage. If you are willing to accept real data that varies 
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Field Description

more significantly from the predicted values as being valid, 
select a lower confidence level, for example, 80%.

Trend Direction of the trend: upward or downward. For example, the 
value is increasing or decreasing toward the Threshold.

Threshold Target value that the metric is expected to reach before the 
trigger executes.

Description Description of the trigger.

5. Select Save.
A new record is created.

6. In the MetricBase  Linear Predictor Trigger Levels section on the record you just created, 
double-click each cell to add values that specify trigger parameters.

MetricBase  Linear Predictor Trigger Levels

Field Description

Level Numbers that indicate increasing severity. Each level should trigger 
a different flow. For example, you might define the following:

Level 1

Battery is predicted to reach 20% in 30 minutes.

Level 2

Battery is predicted to reach 20% in 5 minutes.

Level  is often used in Condition Scripts. See Execute triggers 
conditionally.

Function Comparative function to use on the threshold value. Less than or is 
is the only available option. For example, battery life Less than or is 
30 minutes.

Window How far into the future that you want the linear predictor to look to 
see if the metric is predicted to cross the threshold.

Warning: 
Do not confuse this value with the Window  value in the trigger 
definition form. That value specifies how much data to use 
(measured in time) to calculate the slope of the predictor line.

7. Optional:  Add rows to the table to create multi-layered triggering behavior.
Typically, each additional row (level) indicates a more severe condition. The Workflow Studio 
flow associated with the level should warn with increasing severity.

8. Select Update.

9. Optional:  Add a triggering condition that determines whether a trigger executes a Workflow 
Studio  flow.
See Execute triggers conditionally.
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Example: Linear Predictor form

What to do next
Associate this trigger with a Workflow Studio  flow. For more information, see Assign a trigger to a 
flow.

Create a MetricBase  gap trigger

Create a MetricBase  gap trigger to alert you when MetricBase  stops receiving data.

Before you begin
Role required: admin

About this task
Gap triggers execute when MetricBase  stops receiving data for a specified period.

Gap trigger executes on missing data

You can define multiple trigger levels to indicate different severities. For example, you can set a 
gap of 10 minutes as level 1, a gap of 20 minutes as level 2, and so on. Each level should trigger a 
different Workflow Studio  flow. The difference between gap durations on different levels must be 
at least 10 minutes. For example, if you set level 1 to a gap of 10 minutes, you must set level 2 to a 
gap of 20 minutes or more.

Note: 
If you make the gap durations between levels less than 10 minutes, MetricBase  displays an 
error message and deletes the level that you added.

Polling frequency is calculated using the difference between gap durations on different levels 
and dividing by 2 (rounded down). For example, given the following:

• Level 1 triggers after 5 minutes of missing data

• Level 2 triggers after 30 minutes of missing data

The polling frequency is 12 minutes, because Floor((30-5)/2) = 12 minutes.
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The maximum polling frequency is every 5 minutes, and the minimum frequency is every 30 
minutes. If a trigger has only one level, the polling frequency is 30 minutes.

MetricBase  searches through the data that is stored in the MetricBase  database, not through 
incoming data. Therefore, a gap trigger might execute after the gap when data is missing. For 
example, if MetricBase  polls every 10 minutes and the gap is 30 minutes of missing data, the 
trigger might execute as late as 40 minutes after the data was last received.

Procedure

1. Navigate to All  > MetricBase  > Workflow Studio  > Trigger Definitions.

2. Select New.

3. On the MetricBase  Trigger Creation form, select the Gap Trigger  option.

4. On the form, fill in the fields.
The trigger levels are not initially visible on this form. You configure the levels later.

MetricBase Gap Trigger form

Field Description

Name Name of the trigger.

Table name
Table in the MetricBase  database that contains the metric that 
you want to monitor. The only tables that appear when you click 
the search icon are the tables that you specified in the time-
series metrics.

If you select a metric before you select a table, only tables that 
have that metric appear in the Table name  dialog box.

Active Option to activate the trigger.

Metric
Table metric that you want to monitor that is specified by the 
Table name. The only metrics that appear when you click the 
search icon are the metrics in that table.

If you select a metric before you specify a Table name, the 
metrics in all your time-series metrics appear. After you select a 
metric, only the tables that contain that metric appear when you 
click the search icon that is next to the Table name.

Description Description of the trigger.

5. Select Save.
A new record is created.

6. In the MetricBase  Gap Trigger Levels area on the record you just created, double-click each 
cell to add values that specify trigger parameters.

Field Description

Level Numbers that indicate increasing severity. For example, you might 
define level 1 to be no data for 10 minutes. Level 2 might be no data 
for 20 minutes. Each level should trigger a different flow. Level  is 
often used in Condition Scripts. See Execute triggers conditionally.
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Field Description

Function Function, Greater than or is, which means that this trigger executes 
when the gap in received data is greater than the value that you 
specify in the Window  field. There is only one option for the 
function, and it cannot be left empty or MetricBase  displays an error 
message.

Window Length of time that no data has been received that executes 
the trigger. The format is hours:minutes:seconds. For example, 
00:20:00 means that this trigger executes after 20 minutes of 
missing data.

7. Optional:  Add rows to the table to create multi-layered triggering behavior.
Typically, each additional row (level) indicates a more severe condition. The Workflow Studio 
flow associated with the level should warn with increasing severity.

8. Select Update.

9. Optional:  Add a triggering condition that determines whether a trigger executes a Workflow 
Studio  flow.
See Execute triggers conditionally.

Example: Gap Trigger form

What to do next
Associate this trigger with a Workflow Studio  flow. For more information, see Assign a trigger to a 
flow.

Create a MetricBase  model trigger

Model triggers execute when the time-series data deviates from expected values.

Before you begin
Role required: admin

About this task
There are four model types supported: autoregressive integrated moving average (ARIMA), 
probabilistic exponentially weighted moving average (PEWMA), Holt-Winters, and seasonal 
trend decomposition using Loess (STL).  MetricBase   uses the model to create a definition of 
expected, normal values.

Procedure

1. Navigate to All  > MetricBase  > MetricBase Triggers  > Trigger Definitions.

2. Select New.

3. On the MetricBase  Trigger Creation form, select the Model Trigger  option.

4. On the form, fill in the fields.
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The trigger levels are not initially visible on this form. You configure the levels later.

Field Description

Name Name the model trigger.

Model Trained model this trigger uses. See Create and train a predictive 
model.

Metric
Table metric that you want to monitor. This value is set automatically 
based on the model, which means you cannot set it yourself.

Table name
Table in the  MetricBase   database that contains the metric that you 
want to monitor. This value is set automatically based on the model, 
which means you cannot set it yourself.

Active Option to activate the trigger.

Description Description of the trigger.

Spike Direction Specify whether you want to trigger only on anomalies that 
occur above predicted values (upward), below predicted values 
(downward), or both (either).

5. Select Save.
A new record is created.

6. In the MetricBase  Model Trigger Levels area on the record you just created, double-click each 
cell to add values that specify trigger parameters.

Column Description

Level Numbers that indicate increasing severity. For example, you 
might define level 1 to be 2 standard deviations from the mean. 
Level 2 might be 4 standard deviations. Each level should 
trigger a different Workflow Studio  flow. Level  is often used in 
Condition Scripts. See Execute triggers conditionally.

Function Always Greater than or is, meaning that in order to trigger, the 
time-series metric must be greater than or equal to the number 
of standard deviations from the mean specified in Number of 
Standard Deviations.

Number of Standard 
Deviation

Float value specifying the number of standard deviations the 
time-series metric must be away from the mean to trigger an 
alert at this level.

7. Optional:  Add rows to the table to create multi-layered triggering behavior.
Typically, each additional row (level) indicates a more severe condition. The Workflow Studio 
flow associated with the level should warn with increasing severity.

8. Select Update.

9. Optional:  Add a triggering condition that determines whether a trigger executes a Workflow 
Studio  flow.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2843



See Execute triggers conditionally.

10. Test your model and trigger on real data before deploying to production.

Example: Model Trigger form

What to do next
Associate this trigger with a Workflow Studio  flow. For more information, see Assign a trigger to a 
flow.

Execute triggers conditionally

MetricBase  triggers execute based on a single metric. Condition Scripts impose additional 
requirements that determine whether a trigger kicks off a flow.

Before you begin
Role required: admin

About this task
Condition Scripts execute when conditions for a trigger are met but before the trigger executes a 
Flow Designer  flow. In that way, Condition Scripts can prevent triggers from executing flows even 
when trigger conditions are met. For example, data often fluctuates over time. Small fluctuations 
can cause unwanted, duplicate triggering events. A Condition Script can prevent that erroneous 
duplication.

Condition scripts are sometimes also referred to as moderator scripts.

Condition Scripts always return true  (trigger) or false  (do not trigger). To learn how to write 
these scripts, see Scripting in ServiceNow  Fundamentals . To experiment with scripts, see Get 
familiar with MetricBase  APIs.

Procedure

1. Navigate to All  > MetricBase  > MetricBase Triggers  > Trigger Condition Script.

2. Select New.

3. On the form, fill in the fields.

Field Description

Name Name for the Condition Script.

Application Scope of the Condition Script. The value, Global, means that the 
action applies to all applications.

Description Explanation of what the Condition Script does. When does it 
return True or False?
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Field Description

Script Field to enter the JavaScript. Make it returns true  to execute a 
flow.

4. Write the Condition Script.

When writing a script, think about the conditional statements (what cases it should execute 
for and what cases it shouldn’t). If all evaluate true, the script returns true  and the flow 
executes, otherwise it does not. The following example script triggers a flow when a drone is 
traveling too fast at a low altitude (defined by level 1). The example shows a typical approach to 
writing a condition script.

a. Get the trigger definition, passed in as a filter function parameter.

b. Get the record (current) that is causing the triggering event, passed in as a filter function 
parameter.

c. Get the time from the record that the trigger conditions were satisfied, passed in as a filter 
function parameter.

d. Get the trigger level, passed in as a filter function parameter.

e. Use these parameters to return true  if the level 1 trigger conditions are met and 
travel_state  equals traveling or speeding.

function filter(/*GlideRecord*/ 
 triggerDefinition, /*GlideRecord*/ 
 current, /*GlideDateTime*/ start, /*int*/ level) {
 // retrieve current travel state of drone
 var travel_state = String(current.travel_state);
 
 // the drone is traveling at a significant speed, and the 
 altitude just went below the threshold
 if (((travel_state === 'traveling') || (travel_state === 
 'speeding')) && (level === 1)){
  return true; //process this trigger
 }
 
 return false; // don't process this trigger
}

Note: 
Condition Scripts must execute quickly.

5. Select Submit.

What to do next
Use Flow Designer  to associate a flow with a trigger. When configuring a flow, you can select a 
Condition Script you created.
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Add a Condition Script to a trigger definition in Flow Designer

You can also associate a condition script with a trigger flow in the MetricBase  Trigger Flows 
[sys_flow_metric_trigger] table. If you associate a condition script with a trigger flow here, it won’t 
appear in Flow Designer, but it will still execute with the trigger.

Associate a Condition Script in MetricBase  Trigger Flows

Assign a trigger to a flow

Now that you created a trigger, use Workflow Studio  to specify the flow a trigger executes. The 
flows can provide alerts for unexpected behavior.

Before you begin
Role required: admin

About this task
Triggers, by themselves, execute nothing. After defining a trigger in MetricBase, you use 
Workflow Studio  to associate the trigger with a flow.

Procedure

1. Navigate to All  > MetricBase  > Trigger Flows..

2. Select New Flow.

3. Fill in the fields.

4. Select Submit.

5. Select Add a trigger  to specify the trigger that kicks off this flow.

6. In the dialog box that appears, scroll, and select MetricBase  for the trigger type.

7. Under TRIGGER, fill in the form to define the trigger to associate with this flow.

a. In the MetricBase Trigger  list, select a trigger by either selecting the magnifying glass to 
select an existing trigger or selecting the plus sign (+) to define a new trigger.

b. Optional:  Add requirements for the flow to execute by adding filter conditions.
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c. Optional:  Beside Condition Script, select the magnifying glass to select a Condition Script 
or click the plus (+) to create a script.
Condition scripts add additional requirements for a trigger to execute a flow.

8. Under ACTIONS, select Click to add an Action, Flow Logic, or Subflow

a. When selecting an action, select an action category in the first column of the dialog box, and 
a flow action in the second column.

b. Create combinations of different actions, flow logics, and subflows to get the desired 
behavior.

c. Select Done  to complete each part of the flow action.

9. Select Save.

10. Test the flow.
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a. In the flow tab in Workflow Studio, select Test.

b. Select the trigger Level  to test, provide the time of metric event, and what record  is 
triggering.
Different triggers may execute different flows. 

Note: 
When you test a flow, the system does not execute the trigger, and therefore does not 
create a record. By selecting a record in the Test flow dialog box, the system acts as if 
that record was just created. For more information, see Test a flow .

c. Select Submit.
The test completes. Select the message to view the flow execution details. Edit the settings if 
necessary, save again, and then retest.

11. Select Activate  to activate the trigger.
The flow does not execute unless you activate it.

View trigger logs

Trigger logs show different levels of trigger malfunctions.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > MetricBase  > MetricBase Triggers  > Trigger logs.

2. Click one of the trigger logs.

3. Under Related Links, click Show Log Entries.

4. Optional:  Change the default values in the Enter parameters for log file entries to browse 
form to select the log entries to view and click Submit.
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Managing MetricBase

View the overall health and performance of MetricBase, and debug its triggers and scripts.

View MetricBase  database status

View the status and health of the connection to your MetricBase  database.

Before you begin
Role required: clotho_admin

Procedure

1. Navigate to All  > MetricBase  > MetricBase Health Dashboard.

2. In the list, select Health.

3. View the status of the database connection.
If the database is offline, contact Customer Service and Support.

4. Monitor the lag time between your instance and the database by viewing the MetricBase Lag 
Statistics  value.
If the lag time is reported in multiple seconds, contact Customer Service and Support.

5. Optional:  Select Refresh  to view the latest status.

View MetricBase  data usage and efficiency

Monitor the usage and efficiency of your MetricBase  time series data.

Before you begin
Role required: clotho_admin

Procedure

1. Navigate to All  > MetricBase  > MetricBase Health Dashboard.

2. In the list, select Series.
The MetricBase Series Information page displays the Total Series Count, which is the total 
number of series registered in MetricBase.

3. Determine whether any series aren't being used by calculating the stale series ratio.
This ratio is the percentage of series that haven't received a value within a specified number of 
days.

a. Enter the number of days (greater than or equal to 1) in the Staleness Time Period  field.

b. Select the Refresh icon ( ).
The closer the ratio is to 0%, the fewer unused series there are within the given time period. 
You determine your own threshold for an acceptable stale series ratio. To lower the ratio, adjust 
the metric's sampling schedule or remove unused metrics or series. For help with removing a 
stale series, contact Customer Service and Support.

4. Determine how efficiently your time series data is used by viewing the Data Utilization 
Efficiency  value.
The value is the percentage of data points per metric that have a non-null value. The closer this 
value is to 100%, the fewer null data points there are. To increase the efficiency, review each 
metric to ensure that data is being posted at a similar rate to the first schedule of its retention 
policy. See MetricBase retention policies  for more information.
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5. Determine how often values are published to MetricBase  by viewing the Average Unutilized 
Data Gap  value.
The gap value is the average number of entries between two non-null data points. To decrease 
the gap value, change the metric's schedule to publish data more often or update the metric's 
sampling period in its retention policy. See MetricBase retention policies.

View MetricBase  status and statistics

You can view the status of the MetricBase  database.

Before you begin
Role required: admin

Procedure

1. View the status of the MetricBase  instance.

a. Navigate to System Diagnostics  > Stats  > Stats.

b. Scroll down to find MetricBase Statistics

2. View the metrics monitored by MetricBase  and statistics about them.

a. Click MetricBase  > MetricBase Status
The MetricBase  Status page displays all of the metrics tracked in MB.
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b. Click the gear icon.
The Personalize List Columns dialog box displays.

c. Select and move metrics from the Available  column to the Selected  column to display the 
metric and click OK.
The metrics display on the MetricBase  Status page.

Debug MetricBase

You can display the results of debugging scripts in MetricBase.
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Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Diagnostics  > Session Debug  > Debug MetricBase.
When the page you are on submits queries to MetricBase, you see the transforms and how 
long they took on the bottom of the page. Submitting a lot of MetricBase  queries may slow 
down the page load time significantly.

2. To view a history of the debug script's execution, click available here.

3. Click Update.
Session debug tracking for MetricBase  activities starts and the MetricBase  Status page 
displays.

MetricBase  reference

These reference topics provide additional information about MetricBase  developer resources 
and domain separation.

Developer resources

Developers can use JavaScript or REST APIs to insert and retrieve time-series data from the 
MetricBase  database and to run transforms on the data. The transformations enable you to 
visualize time-series data in a variety of ways.

REST APIs

For information about the MetricBase  REST APIs that return time-series data from the MetricBase 
database, see MetricBase Time Series API .

JavaScript APIs

For information about the MetricBase  JavaScript APIs that return time-series data from the 
MetricBase  database, see:

• Client  — Execute transforms on the MetricBase  database and receive the results.

• Data  — Return the object that contains the result of a transform.

• DataBuilder  — Create a series of data points for a metric.

• Transformer  — Manipulate time-series data to prepare the data for evaluation and analysis.

• TransformPart  — Specify details of the transform to be done.

• TransformResult  — Return the object that contains the result of the transformation.

Transformations

For more information about MetricBase  time-series data transformations, see MetricBase 
transforms .

Data Explorer

Experiment and get familiar with the JavaScript APIs by using the MetricBase  Data Explorer  that 
comes with the MetricBase  Demo.
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Domain separation and MetricBase

Domain separation is supported in the MetricBase  application. Domain separation enables you 
to separate data, processes, and administrative tasks into logical groupings called domains. You 
can control several aspects of this separation, including which users can see and access data.

Support level: Basic

• Business logic: Ensure that data goes into the proper domain for the application’s service 
provider use cases.

• The application supports domain separation at run time. The domain separation includes 
separation from the user interface, cache keys, reporting, rollups, and aggregations.

• The owner of the instance must set up the application to function across multiple tenants.

Sample use case: When a service provider (SP) uses chat to respond to a tenant-customer’s 
message, the customer must be able to see the SP's response.

For more information on support levels, see Application support for domain separation .

Related topics

Domain separation for service providers

MetricBase  roles

MetricBase  is installed with these roles.

To learn more about managing subscriptions, see Managing per-user subscriptions in 
Subscription Management  and contact your account representative.

MetricBase  administrator  [clotho_admin]

Administrative role for time series-related functionality.

Contains Roles

List of roles contained within the role.

• flow_designer

• clotho_rest_accumulate

• clotho_rest_put

Groups

List of groups this role is assigned to by default.

None.

Special considerations

Note: 
Avoid granting an admin role when more specialized roles are available.

MetricBase  plus reader  [mbplus_reader]

Lets users query MetricBase  plus data.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2853

https://www.webstg.servicenow.com/docs/access?context=domain-separated-apps&version=washingtondc&pubname=washingtondc-platform-security&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=domain-separated-apps&version=washingtondc&pubname=washingtondc-platform-security&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=domain-separated-apps&version=washingtondc&pubname=washingtondc-platform-security&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=domain-sep-landing-page&version=washingtondc&pubname=washingtondc-platform-security&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=domain-sep-landing-page&version=washingtondc&pubname=washingtondc-platform-security&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=domain-sep-landing-page&version=washingtondc&pubname=washingtondc-platform-security&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=managing-user-subscriptions-v2&version=washingtondc&pubname=washingtondc-platform-administration&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=managing-user-subscriptions-v2&version=washingtondc&pubname=washingtondc-platform-administration&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=managing-user-subscriptions-v2&version=washingtondc&pubname=washingtondc-platform-administration&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=managing-user-subscriptions-v2&version=washingtondc&pubname=washingtondc-platform-administration&ft:locale=en-US


Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

MetricBase  plus writer  [mbplus_writer]

Lets user modify tables in MetricBase  plus.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

MetricBase  REST accumulate  [clotho_rest_accumulate]

MetricBase  REST accumulate role.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

MetricBase  REST put  [clotho_rest_put]

MetricBase  REST PUT role.
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Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

MID Server
The Management, Instrumentation, and Discovery (MID) Server is a Java application that runs 
as a Windows  service or UNIX  daemon on a server in your local network. The ServiceNow®  MID 
Server  enables communication and the movement of data between a ServiceNow  instance and 
external applications, data sources, and services.

The MID Server initiates all communications with the ServiceNow®  instance. This communication 
is recorded as records in the MID Server ECC Queue, which acts as the communication log 
between the instance and the MID Server. The MID Server picks up any work it has to do from the 
ECC Queue and returns the results of that work to the queue.

This video gives you an overview of the MID Server:

MID Server overview

Setting up the MID server

1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

This documentation provides detailed instructions for setting up a functioning MID Server for 
use with ITOM applications. Click the icons to go to each task's portal page. These procedures 
help you prepare your system, download and run the installer, and configure MID Servers to run 
in your environment. After you get a valid MID Server up and running, you can add security and 
encryption to protect your data.

At the bottom of each page is a link to the reference materials you need, such as MID Server 
system requirements, MID Server parameters, and instructions for monitoring your MID Server. 
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Use the additional links at the bottom to move through the content within a specific category or 
return to the MID Server setup to access a different portal.

If you are new to the MID Server or an experienced user who wants to set up a MID Server 
quickly, you can use the Use MID Server guided setup. This wizard walks you through the 
process of installing and configuring a MID Server with default settings in just a few steps.

Upgrading the MID Server

The MID Server checks with the instance periodically to see if an upgrade is necessary. If the 
MID Server detects that a new version is available for upgrade, it downloads the installer from 
install.service-now.com  and runs the package automatically. You can also elect to 
upgrade the MID Server manually. See MID Server upgrades  for details.

Resolving MID Server issues

You can search the HI Knowledge Base for troubleshooting articles or monitor the MID Server 
status and track active issues from within the instance. Many articles on resolved MID Server 
issues have been collected on Servicenow MID Server Landing page [KB0960404] . For more 
information about common resolution procedures, see Resolving MID Server issues.

ServiceNow applications that use the MID Server

• Discovery

• Orchestration

• Service Mapping

• Event Management

• Operational Intelligence

• Cloud Management

• IntegrationHub

• Cloud Cost Management

• Agent Client Collector

External applications that use the MID Server

• Import Sets

• Microsoft SMS/SCCM

• LANDesk Maintenance Suite

• Microsoft System Center Operations Manager (SCOM)

• Microsoft MIIS

MID Server version compatibility

The version of the MID Server must be compatible with the version of the instance. Otherwise, 
the MID Server cannot process commands or communicate with the instance.

The instance determines which version of the MID Server is allowed. The MID Server version 
must at a minimum belong to the same major release, such as Madrid. If the MID Server version 
belongs to the same major release, it can, but does not have to, belong to the same minor 
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version, such as Madrid Patch 1. In this case, communication with the instance might still be 
possible, but it is always suggested that you upgrade to the latest version.

During upgrades, there may be times when the instance has been upgraded, but the MID Server 
has not. In that situation, Integration Hub  operations are not sent to the MID Server until it is 
upgraded to the same version. The Integration Hub  operations are requeued and sent to the MID 
Server once it is upgraded.

Warning: 
You can Pinning a MID Server to a specific version  to a specific version, but you should be 
aware that the version might become out of date.

Configure MID Server network connectivity

Prepare the network for MID Servers to connect with the instance and access the download site. 
The network must be prepared before installing or configuring the MID Server. If computers or 
devices have additional security measures, that security may interfere with MID Servers on those 
systems.

Before you begin
Role required: admin

1. Ensure that the MID Server can connect to elements inside and outside your network

2. Ensure that the MID Server can connect to elements inside and outside your network

3. Configure MID Server security

4. Configure your MID Server

5. Download and install the MID Server on a Linux or Windows host

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

Make sure that the host machine meets the requirements specified in the MID Server system 
requirements.

About this task
The MID Server host computer must have access to the ServiceNow download site at 
install.service-now.com  to upgrade automatically. If you have a self-hosted ServiceNow 
environment that blocks access to the download site, you must import the MID Server installer 
package into your MID Server hosts manually. For instructions, see KB0760123  in the Self-
Hosted knowledge base.

Firewalls and proxy configurations may block calls to the OCSP Entrust and DigiCert servers, 
which prevents the MID Server from working. You may need to change your firewall permissions 
so that the OCSP traffic goes through. For more information and resolutions, see the HI 
Knowledge Base article [KB1216223] .

The host machine must have these network privileges:
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• Firewall access: Configure any firewalls between the MID Server and the target devices to 
allow a connection. If your network uses a DMZ, and if your network security protocols limit 
port access from within the network to the DMZ, you might have to deploy a MID Server to a 
machine within the DMZ to probe the devices there.

• Network access: Configure target devices to allow the MID Server probe to connect. If network 
security prevents you from configuring new machines that can connect to the targets, install 
the MID Server on an existing machine with connection privileges.

• Network account: Install the MID Server with the proper account, either local or domain 
administrator.

Additionally, for the MID Server to access your ServiceNow  instance, satisfy these prerequisites:

• Network access to the ServiceNow  instance: Configure the network that the MID Server uses to 
allow traffic over TCP port 443.

• A MID user: Create a ServiceNow  user record for the MID Server to use. This user record must 
have the mid_server and import_admin roles.

Note: 
Verify that the baseline public page InstanceInfo  is active for the MID Server to connect to 
the instance.

Procedure

1. Configure the network to allow MID Server network connectivity to the ServiceNow  instance 
over TCP port 443.

2. Configure basic authentication for SOAP communications with the ServiceNow  instance.

3. Navigate to System Web Services  > Scripted Web Services  > Scripted SOAP Services.

4. Confirm that the following web services are active:

◦ GetMIDInfo

◦ InstanceInfo

◦ MIDAssignedPackages

◦ MIDFieldForFileProvider

◦ MIDFileSyncSnapshot

◦ MIDServerCheck

◦ MIDServerFileProvider

5. Type sys_public.list  in the navigation search field and press Enter.
The Public Pages record list appears.

6. Verify that the InstanceInfo  public page is active, to allow the MID Server to validate its version.

7. Ensure that the MID Server host computer can access the download site at 
install.service-now.com.

What to do next
After the network is prepared, proceed to Installing the MID Server.

Prepare network connections for MID Servers

Before you install the MID Server, perform the necessary prerequisites that it needs to connect 
to elements inside and outside your network. This includes network privileges and security 
considerations.
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Security considerations

Sometimes computers or devices have additional security measures configured, and these 
measures may interfere with the MID Server's ability to run commands or queries on those 
systems.

For example, a Linux  server might be configured to allow only certain IP address to connect to it 
via SSH. Similarly, a network router might be configured to allow only certain IP address to query 
SNMP on it. To allow access in such cases, use one of the following methods:

• Update the configuration of those computers or devices to allow the desired MID Server to run 
commands or query them. For example, a network router may be configured to only allow the 
network management systems to query SNMP on it. In that case, add the MID Server as though 
it were another network management system.

• Install a MID Server on a computer that already has access to the computers or network 
devices with such restrictions. For example, to use Discovery  within a DMZ (where 
communication from outside the DMZ will be severely restricted), install a MID Server on a 
computer that is already in the DMZ.

Credential spray

The MID Server  uses its host’s Windows  Server Message Block (SMB) client and configuration 
to connect to other Windows  machines. If Windows  is configured to use legacy protocols, 
the connection is vulnerable to man-in-the-middle attacks that can result in weak password 
disclosure and remote code execution.

Use the following host configuration to limit the impact of an attacker with a man-in-the-middle 
vantage point:

• Ensure that SMB Signing is configured to be Required  on the client MID Server  to limit 
potential attacks on the integrity.

• Ensure that SMB Signing is required by all SMB servers within the environment.

• Use strong passwords to limit offline dictionary attacks if the host machine must support 
legacy authentication protocols such as NetNTLM.

• Use a unique account for each relevant host to limit the impact of compromised credentials on 
the end systems.

External connectivity requirements

These requirements are specifically for the use of MID Servers with the ServiceNow®  Discovery 
and Orchestration  products.

The MID Server communicates securely on port 443 to the instance and requires no inbound 
connections. In some cases, it might be necessary to allow this communication through the 
firewall if the MID Server fails to register on the instance. To determine if the application or a 
network security restriction is to blame for connection failure, attempt to telnet to the instance 
on port 443 from the server that is hosting the MID Server application. If this connection fails, 
then the problem could be a web proxy (since 443 is an https connection) or a Firewall rule 
preventing external TCP connections from that host. Contact network security personnel for the 
proxy information to add to the config.xml file, or request that the firewall be configured to allow 
access using one of the following syntaxes:
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• <source IP> to <any>

• <source IP> to <ServiceNow> any established

• <source IP> to <instance_name.service-now.com> 443

Important: 
The MID Server host computer must have access to the ServiceNow download site at 
install.service-now.com  to upgrade automatically. If you have a self-hosted 
ServiceNow environment that blocks access to the download site, you must import the 
MID Server installer package into your MID Server hosts manually. For instructions, see 
KB0760123  in the Self-Hosted knowledge base.

Internal connectivity requirements

These methods are used for discovering various devices on a network and are specifically for the 
use of MID Servers with the Discovery  and Orchestration  products.

• SSH: For UNIX-like machines, Discovery  and Orchestration use SSH protocol, version 2 to 
access target machines. SSH is a network protocol that allows data to be exchanged using 
a secure channel between two networked devices. SSH communicates on port 22 within an 
encrypted datastream and requires a login to access the targets using two available methods 
of authentication: a user name and password combination and a user name and shared 
private key. Specify SSH authentication information and type in the Credentials  module. 
If multiple credentials are entered, the platform tries one after the other until a successful 
connection is established or all are ultimately denied. To provide for application relationships 
a limited number of SUDO commands must be available to be run. Additional details to these 
requirements can be found in UNIX/Linux  commands requiring root privileges  for Discovery 
and Orchestration.

• WMI: For Windows  machines, Discovery  uses the Windows  Management Instrumentation 
(WMI) interface to query devices. Due to security restrictions for WMI, the MID Server 
application executing the WMI queries must run as a domain user with local (target) 
administrator privileges. When Discovery  detects activity on port 135, it launches a WMI query. 
The response from the Windows  device is sent over a Distributed Component Object Model 
(DCOM) port configured for WMI on Windows  machines. This can be any port . Ensure that 
the MID Server application host machine has access to the targets on all ports due to the 
unique nature of the WMI requirements.

• Windows PowerShell: PowerShell  is built on the Windows .NET Framework and is 
designed to control and automate the administration of Windows  machines and applications. 
Orchestration uses PowerShell to run Workflow activities on Windows  machines. PowerShell 
must be installed on any MID Server that executes these activities. MID Servers using 
PowerShell must be installed on a supported Windows  operating system. ServiceNow  supports 
PowerShell 3.0 to 5.1. Orchestration activities for PowerShell require a credentials Type  of 
Windows.

• SNMP - Network: For network devices, Discovery  uses an SNMP scan to get device specific 
MIBs and OIDs. SNMP is a common protocol used on most routers, switches, printers, load 
balancers and various other network enabled devices. Use a community string  (password) for 
authentication when scanning a device via SNMP. Many devices have a default community 
string of public  which Discovery  uses by default when querying a target. Define additional 
community strings in the SNMP credentials  form which are tried in succession, along with 
public, until a successful query returns. In addition to the credentials, the platform also 
requires the ability to make SNMP requests on port 161 from the MID Server to the target. 
If Access Control Lists (ACLs) are in place to control the IP addresses that can make these 
queries, ensure that the IP address of the MID Server is in the ACL. Discovery  supports SNMP 
versions 1, 2c, and 3.
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• WBEM:  Web-Based Enterprise Management (WBEM) defines a particular implementation 
of the Common Information Model (CIM), including protocols for discovering and accessing 
each CIM implementation. WBEM requires either of two ports, 5989 or 5988 and uses the 
HTTP transport protocol. WBEM supports SSL encryption and uses CIM user name/password 
credentials. Discovery  launches a WBEM port probe to detect activity on the target ports and 
to append gathered data to a classification probe that explores CIM Servers.

Installing the MID Server

Download and install the MID Server on the host machine, test the connection, and then validate 
the MID Server. Use the manual procedures or the guided setup. Set up multiple MID Servers for 
load balancing and domain separation. These procedures prepare it for use with any application.

1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

Prerequisites: Ensure the MID Server system requirements  and MID Server connection 
prerequisites  are met before you install the MID Server manually or use the guided setup utility.

MID Server manual installation

The manual process requires these setup tasks, performed in the order shown here:

1. Create the MID Server user account  and grant the appropriate role to this user.

2. Download the installer file  for the host machine.

3. Install the MID Server on a Linux  or Windows  host.

4. Validate the MID Server  to ensure that it is trusted to access credentials used by the instance 
for automations.

5. Test connectivity  between the MID Server and the instance for automatic upgrades.

6. Optionally, deploy multiple MID Servers  in your network for load balancing or when domain 
separation is enabled.

MID Server guided setup

Alternatively, the MID Server Guided Setup  streamlines the process and allows you to set up a 
basic MID Server quickly.
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Create the MID Server user and grant the role

To communicate with the instance, MID Servers need a user ID and the appropriate role. 
Create the user ID for a MID Server and grant the ID the mid_server  role. To prevent MID Server 
validation failure, the system runs business rules to monitor the settings selected for MID Server 
users.

Before you begin
Role required: admin

1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

About this task
The MID Server connects to an instance by using the SOAP web service. To allow authentication 
with the instance, create a separate user account for each MID Server or share the same 
account across multiple MID Servers. Grant each MID Server user the mid_server role, which is 
required for the MID Server user on any instance on which basic authentication is enabled. The 
mid_server role allows the MID Server to access protected tables when strict SOAP security is in 
place. The system adds the necessary SOAP roles automatically with this role.

Note: 
The strict SOAP security feature, enabled by default for any instance that uses basic 
authentication, protects all tables with Access Control Lists (ACL).

If multiple MID Servers are using the same logged in user, an issue record is created when more 
than one is Up  at a time. It is recommended that MID Servers use a unique logged in user. See 
(KB1552863) MID Server Unique Logged In User  for more information and remediation steps.

Important: 
Improve security by using MID Server mutual authentication instead of basic 
authentication. See Enable MID Server mutual authentication  for more information.

Procedure

1. From the instance, navigate to User Administration  > Users.

2. Click New.

3. Complete the fields in the form.
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Field Description

User ID
User name for the MID Server 
user. This name is specified in the 
mid.instance.username  parameter 
of the configuration file that the MID Server 
installer creates. For details, see MID Server 
parameters.

Note: 
Avoid using the same MID Server 
logged in user across multiple MID 
Servers.

First name The user's first name.

Last name The user's last name.

Password Password for the MID Server user. 
This password is specified in the 
mid.instance.password  parameter 
of the configuration file that the MID Server 
installer creates.

Web service access only
Check this box if you are using basic 
authentication. The web_service_access_only 
field is used to restrict user access to the 
ServiceNow instance, ensuring that a user 
can only interact with the platform through 
web services (REST or SOAP APIs) rather 
than the user interface.

When this field is set to true for a user with 
the mid_server role, it prevents that user 
from logging into the ServiceNow UI, which 
is crucial for security and proper MID server 
operations.

4. Right-click the header and select Save.

5. Under the Roles  related list, click Edit.

6. Select the mid_server  role for this user.
Each MID Server account must have this role to access protected tables.

7. Click Save.

8. Confirm that the MID Server account was created successfully and the account has 
connectivity to the instance.
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a. On the host machine where you intend to install the MID Server, open a browser and 
navigate to the instance.

b. Use your new MID Server user credentials to log in.
If the login is successful, then any MID Servers you install on that host will be able to 
connect to the instance.

MID Server role validation

Real-time system validation of MID Server role assignments prevents incompatible settings.

To prevent MID Server validation failure and ensure that your MID Server is configured correctly, 
the system runs several business rules that monitor the roles and settings you select for your 
MID Server user. The instance displays a warning and blocks the change when you attempt to 
save an incompatible configuration.

Elevated privileges not permitted

The mid_server role cannot be configured for elevated privileges. The Invalid MID 
Server settings  business rule runs on the Role [sys_user_role] table and prevents the 
elevated_privileges  field from being set to true for the mid_server role.

Warning for elevated privileges on the mid_server role

Relationship table protection

The User Role [sys_user_has_role] table creates the relationship between the User [sys_user] 
and the Role [sys_user_role] tables.

• Incompatible role

The mid_server and security_admin roles are incompatible and cannot be assigned to the 
same user. The system determines the user's current role and runs the Security Admin 
incompatible with MID  business rule on the User Role [sys_user_has_role] table. This rule 
prevents an administrator from adding the security_admin role for a user who currently has the 
mid_server role.
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Warnings for incompatible security_admin role assignment

• Incompatible user role and user record settings

The Incompatible MID Server user role  business rule runs on the User Role 
[sys_user_has_role] table to protect its data from incompatible configurations. Validation for 
this related table ensures that an administrator cannot assign the mid_server role to a user 
who already holds the security_admin role.

What to do next

Download  the MID Server files for your operating system.

Download the MID Server files

Download the MID Server installer package through the instance and make it available for 
installation on the host. Allow the local network to access the authorized IP addresses to ensure 
that you can download the installation package and receive automatic upgrades.

Before you begin
Role required: admin

1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

About this task
The IP address of the MID Server download site (install.service-now.com) can change 
without notice. To ensure that you can download the MID Server installation package and receive 
automatic MID Server upgrades, allow local network access to these IP addresses:
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• 149.96.5.98

• 149.96.6.98

A maint user can change the MID Server download site URL with the MID Server system property 
mid.install_server.base_uri. The MID Server downloads the update files from the new URL 
instead. Users with closed environments can direct MID Servers to update through hosts in 
their environment. See MID Server properties  and [KB1546609] Configure Custom MID server 
Upgrade URL  for more information.

Note: 
Download the MID Server first and then enable Discovery, Orchestration, or any integration 
that requires the use of the MID Server.

Procedure

1. On the ServiceNow  instance, navigate to Mid Server  > Downloads.

2. Select and download the MID Server for the appropriate operating system.
For the best performance, install the 64-bit MID Server for your operating system.

Note: 
ServiceNow  no longer supports new installations of 32-bit MID Servers or upgrades to 
version Rome. New MID Server installation are blocked through RPM and MSI installer on 
the following operating systems:

◦ CentOS 7

◦ Windows server 2008

◦ Windows server 2008 R2

◦ Windows 8

◦ Windows 10
MID Servers can be manually installed to any operating system with the ZIP file, however 
Windows 10 is unsupported. Unsupported MID Servers auto-upgrading to Rome create 
an issue record in MID Server Issues (ecc_agent_issue). For more information, see 
Supported platform changes for MID Server [KB0863694] .

MID Server downloads

3. Save the download file to a temporary file on the local drive.

4. Move the file into the designated MID Server folder you create for your operating system and 
run the installer from that location.
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What to do next
You can manually verify the signature of an installation package with the jarsigner tool to ensure 
its authenticity. For more information about verifying the signature, see the MID Server upgrades 
section on manual verification.

Install the MID Server on the host computer.

• Linux

• Windows

Install a MID Server on Linux

Install MID Servers with the MID Server installer and verify it is active. The package includes an 
installer that automatically configures JRE to run in the environment. The MID Server can use an 
existing JRE rather than the provided JRE. Uninstall the MID Server to redeploy it.

Before you begin
Verify that the host computer satisfies the MID Server system requirements.

Role required: admin, mid_server

1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

About this task
To install Linux on MID Server, the RedHat/CentOS systems require RPM while Debian (Ubuntu) 
systems require DEB. The default installation location is /opt/servicenow/mid. Installing 
DEB in user defined directories is not supported.

To improve security, this procedure installs and run the MID Server service as a non-root user. 
Root privilege is required to deploy and configure a MID Server on a Linux server. A non-root user 
can manage a service only if they have the required permissions. For more details, see PolicyKit 
issues with Linux MID Servers using non-admin accounts [KB0815542] .
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Note: 
ServiceNow  no longer supports new installations of 32-bit MID Servers or upgrades to 
version Rome. New MID Server installation are blocked through RPM and MSI installer on 
the following operating systems:

• CentOS 7

• Windows server 2008

• Windows server 2008 R2

• Windows 8

• Windows 10

MID Servers can be manually installed to any operating system with the ZIP file, however 
Windows 10 is unsupported. Unsupported MID Servers auto-upgrading to Rome create an 
issue record in MID Server Issues (ecc_agent_issue). For more information, see Supported 
platform changes for MID Server [KB0863694] .

Java 11.0.17 is bundled with the MID Server  installer package and is installed on the host for all 
new MID Servers. The installer automatically configures Java 11.0.17 to run in your environment. 
No additional configuration is required. This version supports both 64-bit Windows  MID Servers 
and 64-bit Linux  MID Servers. The MID Server  requires a minimum JRE version 11.0.8, and 
recommended version 11.0.17. If you are using a lower version than 11.0.8, you may see encryption 
related issues.

Note: 
Linux MID Servers require glibC version 2.17. The library must be updated for JRE 11. On 
64-bit Linux systems, you must install the 32-bit GNU C library  (glibc). The installation 
command for CentOS is: yum install glibc.i686

Testing showed that the MID Server  works as expected with Oracle  Java 11 version 11.0.5. If you 
need to upgrade the JRE to a different version, then coordinate with the appropriate account 
representative for support.

Procedure

1. On the instance, navigate to MID Server  > Downloads  and download either the MID Server 
installer RPM file for RedHat/CentOS or the DEB file for Debian (Ubuntu) systems.

Note: 
Use the copy link button to copy the download link and use the following wget  command 
to directly download the installers in Linux machines.

wget <copied link of the installer>

2. Optional:  Manually verify the authenticity and integrity of the downloaded file.
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a. Download the signature ZIP files for RPM/DEB.

b. Run the following commands for either RPM or DEB.

(Optional) RPM

▪ Extract the public key, ServiceNow_Digicert_DGST.pem, and signature file from 
the downloaded signature zip file.

▪ Run the following command to verify the signature of the RPM file.

openssl dgst -sha256 -verify <Extracted .pem file> 
 -signature <Extracted bin file path> <RPM file path> 

DEB

▪ Extract the public key, ServiceNow_Digicert_Public.gpg, from the downloaded 
signature zip files.

▪ Import the public key and verify the signature of the DEB file with the following commands.

gpg --import <public key>
dpkg-sig --verify <DEB file path>

3. Use the following commands to install either the RPM or DEB installer:

RPM

◦ Install the RPM package for RedHat systems with the following command:

sudo rpm -ivh --nodeps package_name.rpm.

◦ Install the RPM package for RedHat systems in a user defined location with the following 
command:

sudo rpm -ivh --nodeps package_name.rmp 
 --prefix=/path/to/user/directory.

DEB

Install the DEB package for Debian systems with the following command:

sudo dpkg -i package_name.deb.

4. To configure the MID Server service, run the following command from the agent folder as a 
user with root privilege and provide the required inputs.

./installer.sh
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5. The installer.sh  script takes the following inputs.

Instance URL

Enter the full URL of your instance, for example: https://
mycompanyinstace.service-now.com

MID-Server Username

Enter the user name of the MID Server user that you already created. The MID 
Server user must have the mid_server role.

MID-Server Password

Set the password for the current MID Server user.

MID-Server Name

Set the name of the MID Server.

Proxy Server Information (optional).

mid.proxy.use_proxy

Enables the MID Server to use a web proxy to access the ServiceNow instance.

mid.proxy.host

Set this parameter to define the web proxy's host.

mid.proxy.port

Set this parameter to define the web proxy's port.

mid.proxy.username

If the web proxy requires a user name, set this parameter to define that username.

mid.proxy.password

If the web proxy requires a password, set this parameter to define that password.

The MID Server can bypass proxy servers whose DNS/IP address is listed in the configuration 
parameter mid.cloud.discovery.proxy.exclusion.list. See MID Server property  for more 
information.

To run a MID Server as a daemon service, the following properties are also required.

app_name

Set a unique name for the current MID Server

app_long_name

Set a unique long name for the MID Server.
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run_as_user

Set the username to run the service as a non-root user.

Result
Once all the inputs are entered, the MID Server automatically runs as a daemon service and 
starts the service.

Linux MID Server silent installation

Silently installing the MID Server uses predefined parameters and requires no user input after 
it is initiated. You can use silent installation on several machines at once to quickly set up a 
network and to ensure all MID Servers have the same installation settings.

To perform a silent installation with the Linux installer, run the following command:

./installer.sh -silent -INSTANCE_URL 
 https://instance_name.service-now.com -MUTUAL_AUTH 
 N -MID_USERNAME username -MID_PASSWORD password 
 -USE_PROXY N -MID_NAME mid -APP_NAME mid -APP_LONG_NAME 
 ServiceNow_MID_Server_Mid -NON_ROOT_USER nonrootuser 

The following fields can be passed through the command line:

INSTANCE_URL

Enter the URL of your instance, for example: https://
mycompanyinstance.service-now.com

MUTUAL_AUTH

Set this value to Y to use mutual authentication instead of basic authentication. 
Otherwise, set it to N.

Note: 
If MUTUAL_AUTH  = Y then provide the path to the certificate with 
CERTIFICATE_PATH.

CERTIFICATE_PATH

If mutual authentication is enabled, provide the path to the certificate.

MID_USERNAME

Enter the user name of the MID Server user that you already created. The MID 
Server user must have the mid_server role.

MID_PASSWORD

Enter the password for the user.

USE_PROXY

Set this value to Y if your MID Server communicates through a proxy to connect to 
the instance.

Note: 
If USE_PROXY  = N then skip the other proxy details.

PROXY_HOST

Enter the proxy server host name or IP address. Do not include the protocol in the 
host name. For example: proxyserver.domain.com  is correct, but https://
proxyserver.domain.com  is incorrect.

PROXY_PORT
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Enter the port the proxy server uses to communicate. If this value is blank, the 
installer uses the proxy server's default port number.

PROXY_USERNAME

Enter the username that has administrator rights to the proxy server.

PROXY_PASSWORD

Enter the password for the username.

MID_NAME

Enter the MID Server name.

APP_NAME

Provide the service name. It must be unique for the current MID Server.

APP_LONG_NAME

Provide the service long name.

NON_ROOT_USER

Provide the username to run the service as a non-root user.

The following is an example command for a MID Server which uses a proxy and mutual 
authentication:

./installer.sh -silent -INSTANCE_URL 
 https://instance_name.service-now.com MUTUAL_AUTH Y 
 –CERTIFICATE_PATH <path-to-certificate> -USE_PROXY Y 
 -PROXY_HOST <ip> -PROXY_PORT <port> -PROXY_USERNAME <username> 
 -PROXY_PASSWORD <password> -MID_NAME proxymid -APP_NAME 
 proxymid -APP_LONG_NAME servicenow_proxy_mid -NON_ROOT_USER 
 nonrootuser 

Note: 
To reconfigure the MID Server, run the installer.sh  command 
again. Reconfiguring the MID Server deletes the old configuration. 

Run Linux MID Servers as non-root users

Run MID Servers as non-root user on a Linux machine to improve security. Multiple MID Server 
can be installed as services so they can start by themselves after system reboots.

Before you begin
Role required: root
This process is only applicable if you installed the MID Server manually using the ZIP file. If you 
installed the MID Server with the procedure in Install a MID Server on Linux, then the MID Server 
is already running as a non-root user.

Supported versions for this procedure are Linux Red Hat 6 or newer, Ubuntu 1404 or newer, and 
CentOS 6 or newer.
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Procedure

1. Stop any MID Server running on the host with the command bin/mid.sh stop.

2. Remove any MID Servers on the host with the command bin/mid.sh remove.

3. Edit the file mid.shconf_override.

4. Add the MID Server's name using the lines APP_NAME=  and APP_LONG_NAME=  to run it as 
a service.
To prevent errors, the APP_NAME  of each MID Server must be unique.

5. Optional:  To run multiple MID Servers as services on the same host, add an APP_NAME  and 
APP_LONG_NAME  for each instance.

6. Add the name of the non-root user to operate the account using the line RUN_AS_USER=.

7. Optional:  Add the name of the group to own the entire agent directory using the line 
GROUP_NAME=.
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8. Set the line PROMPT_BEFORE_OWNERSHIP_CHANGE=  to true  to prompt the user for 
confirmation before any changes to file permissions are applied.
The file permission change is applied to the entire agent folder and everything inside 
recursively. The changes include blocking other users' the access to the entire agent 
folder, changing the owner to $RUN_AS_USER  if specified, and changing the group to 
$GROUP_NAME  if specified.

9. Reinstall the MID Server with the command bin/mid.sh install.

Note: 

To prevent errors, make sure to stop and remove any existing MID Server services before 
starting new ones. During the first installation, a root user is required to call bin/mid.sh 
install. Reinstalling the MID Server applies the changes in mid.shconf_override. 
Then the non-root user specified in mid.shconf_override  is able to start/stop/
restart the service without elevated privileges.

What to do next
For more information about managing the allow list and file permission enforcement, see File 
permission enforcement for Windows MID Servers. Running a Linux MID Server with a non-root 
account may result in issues with PolicyKit in some systems. See PolicyKit issues with Linux MID 
Servers using non-root accounts  for more information.

Configure a Linux MID Server to use an existing JRE

You can choose to use an existing JRE for your MID Server rather than the OpenJDK provided 
with the MID Server installer.

Before you begin
Ensure that your JRE version is supported. See MID Server system requirements  for details.

Role required: admin

About this task
By electing to use your own JRE, you are responsible for upgrading it as necessary. For a detailed 
procedure and cautions regarding changing the JRE, see KB0778272 .

Procedure

1. Navigate to this file in the MID Server installation directory:
agent/conf/wrapper-override.conf

2. To specify the existing Java executable that you want to use, add this line to the file:
wrapper.java.command={your_java_executable}

For more information, see the Java service wrapper property documentation .

3. Save the file.

Uninstall a Linux MID Server

The MID Server runs as a stand-alone service. You can remove a stand-alone MID Server service 
to accommodate such tasks as redeploying the MID Server to another host machine or changing 
the unique name of a MID Server when deploying multiple MID Servers.

Before you begin
Role required: admin
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Procedure

Run the uninstall.sh  script in the agent folder to remove the service and uninstall the RPM/DEB.

Result
The MID Server service is uninstalled.

What to do next
Validate  the MID Server to prepare it for use.

Install a MID Server on Windows

Install MID Servers with the MID Server guided Windows installation package. The package 
includes an installer that automatically configures OpenJDK to run in the environment. The MID 
Server can use an existing JRE rather than the provided OpenJDK. Uninstall the MID Server to 
redeploy it.

1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

• Verify that the host computer satisfies the MID Server system requirements.

• The MID Server requires the minimum PowerShell version 3.0 and supports versions up to 
PowerShell 5.1.

• Ensure that the Microsoft Application Experience Lookup Service is enabled on the MID Server 
host. If this service is disabled, the MID Server auto-upgrade might fail, causing the MID Server 
to go down. For information on managing issues with the Application Experience service, see 
KB0597552 .
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Java 11.0.17 is bundled with the MID Server  installer package and is installed on the host for all 
new MID Servers. The installer automatically configures Java 11.0.17 to run in your environment. 
No additional configuration is required. This version supports both 64-bit Windows  MID Servers 
and 64-bit Linux  MID Servers. The MID Server  requires a minimum JRE version 11.0.8, and 
recommended version 11.0.17. If you are using a lower version than 11.0.8, you may see encryption 
related issues.

Note: 
ServiceNow  no longer supports new installations of 32-bit MID Servers or upgrades to 
version Rome. New MID Server installation are blocked through RPM and MSI installer on 
the following operating systems:

• CentOS 7

• Windows server 2008

• Windows server 2008 R2

• Windows 8

• Windows 10

MID Servers can be manually installed to any operating system with the ZIP file, however 
Windows 10 is unsupported. Unsupported MID Servers auto-upgrading to Rome create an 
issue record in MID Server Issues (ecc_agent_issue). For more information, see Supported 
platform changes for MID Server [KB0863694] .

Testing showed that the MID Server  works as expected with Oracle  Java 11 version 11.0.5. If you 
need to upgrade the JRE to a different version, then coordinate with the appropriate account 
representative for support.

Upgraded MID Servers might use different Java versions depending on their operating system 
versions.

• MID Servers upgraded from earlier versions use the OpenJDK provided with the MID Server 
installer. This version of the OpenJDK was tested and certified for use with these MID Servers.

• MID Servers  upgraded on any other operating system versions also automatically upgrade the 
JRE to the version provided with the installation package.

Install a MID Server on Windows with guided installation

Install MID Servers with the MID Server guided Windows installation package. The package 
includes an installer that automatically configures OpenJDK to run in the environment.

Before you begin
Role required: admin or mid_server

About this task
The MID Server guided native Windows installer will configure the MID Server with provided 
settings. The installer creates the MID Server Service and assigns it to the provided user. The 
installer sets the file permissions on the MID Server Install folder. The installer allows for the 
configuration of proxy settings. Optionally, the installer can start the MID Server automatically.

Procedure

1. On the instance, download the MID Server installation .msi file from MID Server  > Download.

2. Log in to the Windows host machine where you want to install the MID Server.

3. Place the installer .msi on the desired MID Server host.

4. Open the installer with Administrator level privileges.
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5. Use the installer to enter the following information.

Field Description

Authentication Type Basic

Username and password based 
authentication.

Mutual

Client certificate based 
authentication. See MID 
Server unified key store  for 
more information on mutual 
authentication.

Note: 
Selecting mutual authentication 
disables the MID Server username and 
password fields. The disabled fields are 
not written to config.xml.

ServiceNow instance URL Enter the full URL of your instance, for 
example:
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Field Description

https://
mycompanyinstace.service-
now.com

ServiceNow MID Server username Enter the name of the MID Server user  that 
you already created. The MID Server user 
must have the mid_server role.

ServiceNow MID Server password Enter the password for the user in the 
ServiceNow MID Server username.

Certificate Revocation
This check box is selected by default to 
enable certificate revocation policies to 
improve security. For more information 
on certificate revocation, see MID Server 
certificate check policies.

When testing a connection with certificate 
revocation enabled, the installer checks if 
OCSP port 80 is open and the entrust page is 
accessible.

If the connection test fails due to the 
certificate revocation check, the error 
must either be corrected and re-tested or 
the certificate revocation check must be 
disabled. The certificate revocation check is 
not required for successful installation.

Use proxy Select this check box if your MID Server 
communicates through a proxy to connect to 
the instance.

Note: 
Your proxy server must use Basic 
Authentication for the MID server to 
connect to the instance.

The MID Server can bypass proxy 
servers whose DNS/IP address is 
listed in the configuration parameter 
mid.cloud.discovery.proxy.exclusion.list. 
See MID Server property  for more 
information.

Proxy host Enter the proxy server host name or IP 
address. Do not include the protocol 
in the host name. For example, enter 
proxyserver.domain.com, not 
https://proxyserver.domain.com.

Proxy port Enter the port through which the proxy server 
communicates. If you leave this field blank, 
it should use the proxy server's default port 
number.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2878



Field Description

Proxy username Enter the user name that has administrator 
rights to the proxy server.

Proxy password Enter the password for the user name.

6. Click Test your connection  to validate the credentials and instance information.
If you encounter any errors, verify the information that you input.

7. Click Next.

8. Configure the MID Server  name and Service Account parameters (see table).

Field Description

MID Server name Enter a MID Server name.

Warning: 
MID Server names cannot begin with 
mid.server.

Service Account Name
Username of the service account that will 
be used to run the MID Server service. For 
information on creating service accounts, see 
Create a Windows service account with "Log 
on as Service" [KB0867669] .
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Field Description

Service Account Name field is an editable 
drop-down menu. Either select a value 
from the drop-down or type a new value in 
the text field. Only the accounts with log 
on as service  policy are displayed in 
the drop-down. Group Managed Service 
Accounts (gMSA) that inherit the log on 
as service  policy from their groups are 
not displayed in the drop-down. However, you 
can install the MID Server service using those 
accounts by manually entering the service 
account name in the editable drop-down. The 
name can follow three formats.

a. If the service account is local to the 
computer, you can give just the name.

Example: My_Local_Service_Account

b. If the service account is local to the 
computer, you can provide “.” as the 
domain name for the account.

Example: .\My_Local_Service_Account

c. Any account can follow the format 
{domain}\{username}.

Example: MY-COMPUTER-DOMAIN
\My_Domain_Service_Account

Add a new local service account by 
selecting the +  button. This button opens the 
Configure New Local User  window, which 
has three fields.

◦ Service Account Name:  Enter the name of 
the new service account.

◦ Service Account Password:  Enter the 
password of the new service account.

◦ Re-enter Password:  Confirm the password 
of the new service account.

When a group Managed Service Account 
(gMSA) user is selected, the password field is 
removed because passwords for gMSA users 
are managed by the Active Directory.
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Field Description

Note: 

The provided service account 
credentials must meet the following 
requirements in addition to being a valid 
account.

◦ The user cannot be a local system or 
an administrator level account (local 
admin, domain admin, etc.)

◦ The service account provided has the 
log on as service  right, which 
is required for an account to be used 
as the log on user  for a service.

Service Account Password Password of the service account that will be 
used to run the MID Server service.

Set Service Name Manually
Select this check box if you want to manual 
set the service name and display name for 
your MID Server.

Note: Your proxy server must use Basic 
Authentication for the MID server to connect 
to the instance.

MID Service wrapper name Modify this field if necessary. It is populated 
automatically by prefixing snc_mid_  to the 
MID Server name. In most cases, you do not 
need to modify this.

MID Server wrapper display name Modify this field if necessary. It is populated 
automatically by prefixing ServiceNow 
MID Server_  to the MID Server name. In 
most cases, you do not need to modify this.

9. Click Next  and select a destination folder for the installation.

Users can manually enter an existing, valid file path, or use the “Change” button to open up a 
browsing page where they can choose the install location.

10. Click Next  to view the summary.
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Select Start MID Server after installation  if you want to start the MID Server immediately 
after installation. If you wish to make additional configuration changes, before starting the 
MID server, leave this box unchecked. If mutual authentication was selected, the MID Server 
username and password fields are removed.

Note: 
If the MID Server fails to start, the cause might be a duplicate name or multiple services 
that point to the same executable path. This can happen when you have MID servers 
previously not installed through the installer. See MID Server fails to start  for details.

11. Click Mid Servers List Page.
The installer opens the MID Server list from your instance.

12. Select the MID Server name from the list.

Note: 
It may take a few seconds for the MID Server time to establish a connection with your 
instance.

The system displays the MID Server record.

13. From Related Links, click Validate.
The MID Server Validated  changes to Yes.

What to do next
To upgrade the MID Server, see MID Server upgrades  for procedures and requirements.
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Uninstall a Windows MID Server with the guided installer

The MID Server guided native Windows installer also supports guided uninstallation of the MID 
Server.

Before you begin
Role required: admin
There are three ways to uninstall a MID Server after installing it with the guided native Windows 
installer.

Procedure

1. On the MID Server host, navigate to the Control Panel  > Programs  > Programs and Features  > 
Uninstall a program.

a. Uninstall the program with the MID Server's name.

2. Optional:  Alternatively, navigate to Settings  > Apps

a. Uninstall the program with the MID Server's name.

3. Optional:  The MID Server can also be uninstalled with the silent uninstall script.
This is useful for uninstalling multiple MID Servers. For more information, see Windows MID 
Server silent installation and uninstallation

Configure Windows MID Server service credentials

MID Server service credentials are required to manage the MID Server service on the host 
machine, including its ability to successfully auto-upgrade.

Before you begin
Role required: admin

About this task
If you installed the MID Server using the native installer, you will not need to complete this 
procedure. However, to change the service user after the installation for any reason, use this 
procedure.

Windows service credentials control the level of privilege on the device. The user should not be 
a local system or an administrator level account (local admin, domain admin, etc.) The service 
account provided should have the log on as service  right, which is a requirement for an account 
to be used as the log on user  for a service.

Note: 

Windows service credentials are not the same as the MID Server user credentials, which 
allow communication between the MID Server and the instance. You must configure both 
of these credentials separately. See Create the MID Server user and grant the role  for 
instructions on MID Server user credentials.

Procedure

1. Open the Windows Services console.

2. Double-click the  ServiceNow   <MID Server name>  service for each MID Server.

3. Select the Log On  tab.

4. Choose a non-admin user and provide the password for that user.

5. In the General  tab, set the Startup type.
The field is set to Automatic  by default.

6. Click OK.
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7. Restart the ServiceNow  <MID Server name> service, and make sure that ServiceNow\<MID 
Server name>\agent\logs\agent0.log does not have error messages.
If the MID Server does not start, see the ServiceNow  knowledge article Review the agent log 
for MID Server errors (article KB0535148 ).

8. On the instance to which this MID Server is connected, navigate to MID Server  > Servers.

If Discovery  is installed, alternately navigate to Discovery  > MID Servers. All MID Servers 
connected to this instance are listed.

9. Make sure that the Status of the MID Server that you just installed is Up.

Windows MID Server silent installation and uninstallation

Silently installing the MID Server uses predefined parameters and requires no user input after 
it is initiated. You can use silent installation on several machines at once to quickly set up a 
network and to ensure all MID Servers have the same installation settings.

MID Server silent installation

Note: 
All silent install/uninstall commands must be run with administrator level privileges.

To silently install the MID Server on a Windows system, download the script attached to the 
Knowledge Base article Windows MID Server silent installation and uninstallation . Place the 
file on the target MID Server host machine and run the following command from the command 
prompt. You can also run the script directly from powershell.

powershell -command “.\SilentInstall.ps1 -<parameter_name1> 
 ‘<value for parameter1>’ -<parameter_name2> ‘<value for 
 parameter2>’ etc…”

The script checks the following mandatory parameters:

• MSI_FILE_NAME: the name of the MSI file used for the installation.

• INSTALL_LOCATION : the location to install the MID Server.

• INSTANCE_URL: the target ServiceNow instance the MID Server will connect to.

• MID_USERNAME: the instance account name.

• MID_PASSWORD: the instance account password.

• MID_NAME: the name of the MID Server.

• SERVICE_ACCOUNT_NAME: the name of the service account.

• SERVICE_ACCOUNT_PASSWORD: the password of the service account.

The following parameters are optional:

• LOG_NAME: enables logging and puts logs into the file named by this parameter.

• START_MID: sets the MID Server to start automatically after the installation finishes.

• USE_PROXY: enables the use of a proxy. If you choose this command, the following 
parameters become mandatory.

◦ PROXY_HOST: the name of the proxy host.

◦ PROXY_PORT: the port number of the proxy.

◦ PROXY_USERNAME: the proxy username. If there is no username, input ‘’.

◦ PROXY_PASSWORD: the proxy password. If there is no password, input ‘’.
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• MANUAL_SERVICE_NAME: the service name. If you choose this command, the following 
parameters become mandatory:

◦ SERVICE_NAME: the service name.

◦ SERVICE_DISPLAY_NAME: the service display name.

• MUTUAL_AUTH: enables mutual authentication. If this switch is enabled, MID_USERNAME 
and MID_PASSWORD  are not required. See MID Server unified key store  for more information.

Note: 
The parameters START_MID, USE_PROXY, MUTUAL_AUTH, and 
MANUAL_SERVICE_NAME  are switches. They use the format -<switch_param_name> 
and are not followed by a value.

After the script runs, verify the MID Server files, service, and entry in Programs and Features 
are installed. If you enabled logging, verify the log info in the file specified by the LOG_NAME 
parameter.

An example MID Server silent installation command:

powershell -command ".\SilentInstall.ps1 -MSI_FILE_NAME 
 'MID-Installer.msi' -INSTALL_LOCATION 'C:\Users\Administrator' 
 -INSTANCE_URL 'https://my-instance-name.service-now.com' 
 -MID_USERNAME 'mid_server' -MID_PASSWORD 'mid_password' 
 -MID_NAME 'Silent_Install_MID' -SERVICE_ACCOUNT_NAME 
 'DOMAIN\My_Service_Account' -SERVICE_ACCOUNT_PASSWORD 
 'Service_Account_Password' -LOG_NAME 'Silent_Install_Log.txt'"

An example command using the START_MID  switch:

powershell -command ".\SilentInstall.ps1 -MSI_FILE_NAME 
 'MID-Installer-Wix.msi' -INSTALL_LOCATION 
 'C:\Users\Administrator' -INSTANCE_URL 
 'https://my-instance-name.service-now.com' -MID_USERNAME 
 'DOMAIN\My_Service_Account' -MID_PASSWORD 'mid_password' 
 -MID_NAME 'Silent_Install_MID' -SERVICE_ACCOUNT_NAME 
 'DOMAIN\My_Service_Account’ -SERVICE_ACCOUNT_PASSWORD 
 'Service_Account_Password' -LOG_NAME 'Silent_Install_Log.txt' 
 -START_MID"

MID Server silent uninstallation

To silently uninstall the MID Server on a Windows system, download the script attached to the 
Knowledge Base article Windows MID Server silent installation and uninstallation . Then run the 
script using the command prompt. It can also be run directly from powershell.

powershell -command “.\SilentUninstall.ps1 -MID_NAME ‘<value 
 for MID_NAME>’ -LOG_NAME ‘<value for LOG_NAME>’”

The script requires the mandatory parameter MID_NAME, which is the name of the MID Server 
you want to uninstall.

The optional parameter LOG_NAME  enables logging of the uninstallation and puts logs into the 
file named by this parameter.
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After the script runs, verify the MID Server files, service, and entry in Programs and Features 
are uninstalled. If you enabled logging, verify the log info in the file specified by the LOG_NAME 
parameter.

An example MID Server silent uninstall command:

powershell -command ".\SilentUninstall.ps1 -MID_NAME 
 'silent_install_cmd' -LOG_NAME
      'uninstall.txt'"

Manually install a MID Server on Windows

Install MID Servers with the ZIP file installation package and verify it is active.

Before you begin
Role required: admin or mid_server

About this task
Click this link to view the installation video:  Installing the MID Server on Linux

Procedure

1. Log in to the Windows host machine where you want to install the MID Server.

2. Create a folder for the MID Server on the top level of the drive such as ServiceNow\MID 
Server1.

3. Download the MID archive file into the new folder.

4. Right-click the archive and select Extract All.

5. Navigate to the service-now\<mid server name>\agent  folder that was created when 
the file was extracted.

6. To configure the MID Server manually, edit the config.xml  file with a text editor such as 
WordPad:

a. Find the element  <parameter name="url" value="https://
YOUR_INSTANCE.service-now.com" />  element and change the value to the URL 
of your instance.

b. Enter the MID user credentials in the mid.instance.username  and 
mid.instance.password  parameters.
By default, the MID Server, uses basic authentication for SOAP messages. The password 
value is also encrypted authentication.

c. Optional:  Find the  <parameter name="name" 
value="YOUR_MIDSERVER_NAME_GOES_HERE" />  element and change the value 
for the MID Server name.

d. Optional:  Enter connection information for the proxy server.
Remove the appropriate comment tags from the proxy configuration information.

Example 
For example, you can configure these parameters:

▪ mid.proxy.use_proxy

▪ mid.proxy.host

▪ mid.proxy.port
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▪ mid.proxy.username

▪ mid.proxy.password

7. Run start.bat  to start the MID Server.

8. On the instance, in the Related Links, select Validate.
The MID Server Validated  changes to Yes.

Run a Windows MID Server as a non-admin after manual installation

MID Servers can be configured to run using non-administrative accounts. Using non-admin 
accounts in conjunction with file permission enforcement can improve security by restricting 
access to MID Server files.

Before you begin
Role required: admin

Note: 
In a future release, non-admin accounts will be mandatory for the MID Server, and support 
for using an administrative account will be deprecated.

This procedure is only for users who install the MID Server using the ZIP file. The Windows 
MID Server installer already requires the MID Server run as a non-admin user. As part of the 
MID Server installer's installation process, the access control lists for the MID Server folder are 
restricted to the following users and groups.

• System

• Administrator

• The configured service account

When installing using the ZIP file, install the MID Server on a Windows machine using an 
administrator account. Create a Windows user account without administrative privileges.

Running a MID Server with a non-admin account has limitations and changes the behavior of 
other applications. The following behavior changes can occur:

• The MID Server account needs appropriate credentials to run a Discovery schedule. If the 
credentials are insufficient, the MID Server falls back to the user account's privileges. A non-
admin user account may not have the necessary privileges to access the Discovery target.

• Enhanced Application Dependency Mapping (ADME) and File Based Discovery (FBD) may not 
work by default. To correct this issue, non-admin users need to be given permission to read/
write to the Admin Share folder.

• Non-admin accounts cannot initiate upgrade services in versions prior to the Orlando release.

Procedure

1. Run the MID Server service as LocalSystem or as a user with admin rights.

2. Create a file entitled GrantStartStopPerm.ps1  with the following code.

Function GrantStartStopPerm
{
    Param( [string]$username, [string]$servicename )
    $user = New-Object 
 System.Security.Principal.NTAccount($username)
    $sid = 
 $user.Translate([System.Security.Principal.SecurityIdentifier]
).Value
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    Write-Output "Sid : $sid"
 
    $sd = sc.exe sdshow $servicename
    Write-Output "SD value   : $sd"
 
    if( !($sd -like "*$sid*") ){
        $permsToAdd = [string]::Format(")(A;;RPWPCR;;;{0})S:(", 
 $sid);
        if($sd -match [regex]::Escape(")S:(")){
            $sd = $sd -replace 
 [regex]::Escape(")S:("),"$permsToAdd"
            $result = sc.exe sdset $servicename $sd
            Write-Output "SD changed : $sd";
            Write-Output "Result : $result";
        }
    }else{
        Write-Output "Sid is already part of SD"
    }
}

3. Start the PowerShell console as an administrator.

4. Load the file by using the dot-source function from the GrantStartStopPerm.ps1  file.
For example: C:\Users\mid_account\Desktop> . .
\GrantStartStopPerm.ps1

5. Run PowerShell sourced function with non-admin account and the service name as input.
For example:

GrantStartStopPerm mid_account snc_mid_test
Output line expection in success :
Result : [SC] SetServiceObjectSecurity SUCCESS

6. Add the non-admin account name to the MID Server parameter 
mid.windows_host.file_permissions.allow_list  in the MID Server host's 
config.xml  file.
This step adds the non-admin account to the allow list. See MID Server parameters  for more 
information about mid.windows_host.file_permissions.allow_list  as well as 
instructions for adding a parameter to the config.xml  file.

7. Restart the MID Server.
The new file permission enforcement rules take effect when the MID Server starts.

8. Switch the MID Server to the non-admin service account.

9. Restart the MID Server.

What to do next
For more information about managing the allow list and file permission enforcement, see File 
permission enforcement for Windows MID Servers.

Uninstall a Windows MID Server after manual installation

The MID Server runs as a stand-alone service. You can remove a stand-alone MID Server service 
to accommodate such tasks as redeploying the MID Server to another host machine or changing 
the unique name of a MID Server when deploying multiple MID Servers.

Before you begin
Role required: admin

This procedure is only for users who install the MID Server using the ZIP file.
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Procedure

1. Stop the running MID Server service, using either of these procedures:

◦ Windows command line: From the MID Server home (agent) directory, run stop.bat.

◦ Windows Services console: From the Windows Services console, right-click the 
ServiceNow  MID Server name  and then select stop.

2. From a command prompt, go to the \agent\bin  directory in the MID Server installation 
directory and double-click the UninstallMID-NT.bat  file.

What to do next
Validate  the MID Server to prepare it for use.

Configure a MID Server on Windows to use an existing JRE

You can choose to use an existing JRE for your MID Server rather than the OpenJDK provided 
with the MID Server installer.

Before you begin
Ensure that your JRE version is supported. See MID Server system requirements  for details.

Role required: admin

About this task
By electing to use your own JRE, you are responsible for upgrading it as necessary. For a detailed 
procedure and cautions regarding changing the JRE, see KB0778272 .

Procedure

1. Navigate to this file in the MID Server installation directory:
agent/conf/wrapper-override.conf

2. To specify the existing Java executable that you want to use, add this line to the file:
wrapper.java.command={your_java_executable}

For more information, see the Java service wrapper property documentation .

3. Save the file.

Validate the MID Server

You must manually validate the MID Server after it is installed to enable it to execute automation 
tasks. You can invalidate a MID Server you suspect has been compromised to prevent it from 
accessing automation credentials in the instance or executing outbound ECC probes.

Before you begin
Role required: agent_admin, admin
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1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

Make sure that the MID Server version  is compatible with the instance.

About this task
Validation restricts access to automation credentials to trusted MID servers only.

When you validate a MID Server, you specify the capabilities it can use, the applications that 
use it, and the IP ranges it is allowed to explore. You will be prompted to set the initial selection 
criteria when you validate MID Servers that do not already have capabilities, applications, or IP 
ranges already configured. You do not have to set the initial selection criteria to actually validate 
the MID Server. See MID Server selection  for more information on capabilities, applications, and 
IP ranges.

Note: 
When you upgrade, MID Servers that are already configured in your instance are 
automatically validated. This prevents the interruption of automation tasks that MID Servers 
might be performing. See MID Server upgrades  for more information.

Procedure

1. Navigate to All  > MID Server  > Servers.

2. Open the new MID Server you created from the list of MID Servers.

3. Under Related Links  click Validate.
The Set Initial Selection Criteria window appears if there are no records in the Supported 
Applications, IP Ranges, or Capabilities related lists.

4. On the Set Initial Selection Criteria window, use the switches to enable or disable selection 
criteria for this MID Server:

◦ Allow ALL capabilities: Allow all capabilities for Orchestration and Event Management to 
use this MID Server.

Note: 
Service Mapping and Event Management alert aggregation and RCA, which used 
capabilities in previous releases, rely on the application for MID Server selection.

◦ Allow ALL applications: Allow all applications that use MID Servers to use this MID Server.

◦ Allow ALL IP ranges: Make all IP ranges valid for this MID Server, meaning that it can target 
any IP address.
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Setting initial selection criteria

If you click Cancel, the validation continues but none of the capabilities, applications, or IP 
ranges are added.

5. Click OK.

The Validated  field on the dashboard is set to Validating, and then set to Yes  after the 
validation completes.

6. To invalidate a MID Server, open the record for the MID Server you suspect has a security 
issue.

7. Under Related Links, click Invalidate.
Invalidating a MID Server forces it to clear its memory and restart. The MID Server generates a 
new keypair on restart.

What to do next
Test network connectivity  to ensure that the MID Server can upgrade automatically.

Related topics

Rekey a MID Server

Test MID Server connectivity

Confirm that the MID Server host is able to communicate with the instance. Resolve any issues 
with the network connectivity such as conflicts with firewalls, access control lists, and routing 
errors. Successful communication is necessary for automatic upgrades.

Before you begin
Role required: admin

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2891



1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

About this task
The computer that hosts the MID Server must be able to access one of these URLs to upgrade 
automatically:

• HTTPS: https://install.service-now.com on the default HTTPS port 
(443)

• HTTP: http://install.service-now.com on the default HTTPS port 
(80)

Procedure

1. Use PING to test connectivity with the host on the network (ping<host IP>).

2. If no ping response is returned, use TRACEROUTE to see where traffic might be stopped 
(traceroute<host>).

3. Use TELNET to connect to any of the TCP ports (telnet<host> <port>).

4. Use an SNMP scanning tool to determine if a potential network device is responsive.

5. Resolve the most likely issues around network connectivity:

◦ Routing:  Confirm that the MID Server host has network access to the IP ranges you are 
attempting to discover.

◦ Firewalls:  Confirm access to the physical firewalls that protect a large environment such as 
the Data Center. Confirm access to any logical firewalls that protect an individual computer. 
MID Server communications are initiated inside the firewall and therefore do not require any 
special firewall rules or VPNs.

◦ Access Control Lists (ACL):  Confirm that ACLs contain the IP addresses based list on SNMP 
network devices that allows communication to a particular target.

◦ Resolve all issues with your network teams to better understand your topology.  Deploy 
additional MID Servers if necessary to help keep your network secure. Configure access 
from your existing MID Server host to networking components.

6. Verify that the MID Server service is running on the host:

◦ Windows: In the Windows Services console, locate the ServiceNow [MID Server name]  and 
confirm that each MID Server has the Started Status  value.

◦ Linux: Ensure that the agent0.log.0.lck  appears in the /servicenow/ MID 
Server name]/agent  folder.
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7. After each MID Server restart, open the agent0.log.0  and address all error messages.

8. From the ServiceNow  instance, navigate to MID Server  > Servers.

9. Review and verify that all MID Servers that are connected to the instance are listed.

10. Verify that the Status  is Up  for the MID Servers.

What to do next
This concludes the installation of a single MID Server. If necessary, continue to deploy multiple 
MID Servers from a single host  in your network. Otherwise, begin configuring your MID Server.

Install multiple MID Servers on a single system

Install multiple MID Servers on the same host computer. Multiple MID Servers can support 
each other with load balancing, as well as use domain separation. The number of MID Servers 
required is determined by factors like network policies, security restraints, and the reliability of 
the host computer.

Before you begin
Role required: admin, mid_server

1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

About this task
You can install multiple MID Servers on a Linux  or Windows  host or on a virtual machine. 
Installing multiple MID Servers may involve other setup steps depending on your network 
configuration.

Important: 
Only one MID Server service can be a daemon on a Linux host. This is a limitation of the 
Tanuki wrapper service.

Procedure

1. Log in to the host system or virtual machine where you want to install multiple MID Servers.

2. Create a directory for each MID Server on the top level of the drive.

Make sure you create a unique and descriptive name for each MID Server, such as 
MIDServer_SMS_Int or MIDServer_Disc1.

3. Extract the downloaded MID Server archive file into each MID Server directory.
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When the extract completes, there should be a directory path similar to the following for each 
MID Server: ServiceNow<MID Server name>\agent.

4. For each MID Server, run the installer appropriate to the host's operating system.

MID Server installers

Operating System Installer path

Windows /agent/start.bat

Linux /agent/installer.sh

5. Use the installer to enter the following information.

◦ URL to your instance

◦ User credentials to run the MID Server

◦ Proxy server connection details

◦ MID server name

◦ MID server service wrapper name and display name (Windows systems only)

Note: 
The MID Server user must have the mid_server role.

6. From the installer, click Start MID Server.

The local host starts the MID Server.

7. Click Mid Servers List Page.
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The installer opens the MID Server list from your instance.

8. Select the MID Server name from the list.

Note: 
It may take a few seconds for the MID Server time to establish a connection with your 
instance.

The system displays the MID Server record.

9. From Related Links, click Validate.
The MID Server Validated  changes to Yes.

What to do next
All MID Server installation procedures are complete. Proceed to configure your MID Server.

Multiple MID Server deployments

Depending upon how you use the MID Server (for an external integration, Discovery, Service 
Mapping, or Orchestration) and the load placed on it, you might find it necessary to deploy 
multiple MID Servers in your network.

Factors determining the number of MID Servers your network will require to support external 
applications that integrate with ServiceNow  include the following:

• The security constraints in your network.

• Your network policies.

• The amount of traffic between ServiceNow  and the integrations.

• The reliability of the MID Server machines.

Network policies and security

Security policies in your network (firewalls between network segments, for example) might make 
direct communication impossible between your instance and an integration's data source (JDBC, 
LDAP, etc.). To retrieve data for the instance, you can install a MID Server that has access to both 
the data source and the instance.

These network policies can determine if you need to install multiple MID Servers in your 
environment:

• Access control lists (ACL): If your security policy controls access to network devices (e.g. 
switches and routers) with an ACL, it might be necessary to install one or more MID Servers on 
a machine in the network that is already on the ACL.

• DMZ: Your network policy might require you to install one or more MID Servers in your DMZ 
to probe the devices there. This is common in networks that tightly regulate the ports that are 
opened on the inside firewall.

• Probe types: If you are conducting probes of different operating systems, your network policy 
might require a separate MID Server for each type of probe (e.g., one MID server for Windows 
WMI probes and another for SSH probes on UNIX).

Load balancing

Deploy multiple MID Servers where capacity is an issue, as when Discovery  has to gather 
information about thousands of configuration items quickly. In a high volume environment, it 
might be necessary to deploy multiple MID Servers as load balancers for certain transactions. 
For example, JDBC data transfers can tie up the resources of a MID Server, making it unable 
to respond to other requests. The following operations between an integration might require 
separate MID Servers in a busy network:
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• File exports

• Running scripts

• JDBC data sources

• Reading files

High availability model

Avoid installing MID Servers for critical integrations on a machine that might experience any type 
of planned outage or an outage caused by overloaded processes. If necessary for reliability, 
consider deploying these types of MID Servers to dedicated machines for high reliability

Note: 
Do not integrate with an external application on a MID Server provisioned for ServiceNow 
Discovery  or Orchestration.

Wide area network (WAN)

When determining where to deploy MID Servers in a WAN, consider the bandwidth available 
between your local area networks. In most cases, install a MID Server on each LAN to probe 
devices locally, rather than deploying MID Servers that must probe devices across slow WAN 
connections. An alternative to this type of deployment is to install MID Servers that probe other 
LANs via VPN connections that take advantage of fast Internet connections. If the bandwidth 
of your WAN connections is comparable to that of your Internet connection, then there is no 
performance impact in running MID Server probes across WAN connections.

Domain separation

In deployments where domain separation is enabled and domains are configured to form a 
hierarchy, place the MID Servers at the lowest domain level.

Deploying MID Servers with domain separation
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Use MID Server guided setup

MID Server guided setup provides a sequence of tasks that help you install a MID Server with the 
proper user account and validate the MID Server. If you are setting up a MID Server for the first 
time, this is a good way to get one up and running in your environment quickly.

Before you begin
Role required: admin

1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

About this task
You are guided through a series of configuration activities that create a fully qualified MID Server. 
A progress indicator on each screen allows you to monitor your progress on each task.
Each configuration activity provides the following resources to help you:

• Contextual embedded help.

• Links to comprehensive documentation on the ServiceNow product documentation site.

Important: 
You must complete MID Server configuration before you can launch any other IT 
Operations Management guided setup.

Procedure

1. Navigate to All  > Guided Setup  > ITOM Guided Setup.
The IT Operations Management Guided Setup welcome screen appears.

2. Take one of the following actions:

◦ If none of the MID Server installation and configuration tasks are complete, click Get Started.

◦ If you have completed any of the MID Server installation and configuration tasks, click 
Continue  to return to the task list.
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◦ Select the MID Server icon in the progress bar on the left side of the category screen to 
display the MID Server category pane at any time.

Continuing MID Server guided setup from the progress bar

3. Click Continue.
The IT Operations Management Guided Setup category screen appears. The controls for 
starting the MID Server tasks are at the top of the list. These task must be completed before 
you can set up the other applications that rely on the MID Server.

4. In the MID Server pane, click Get Started.
The MID Server task list appears with a description of each task.
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5. Click Configure  to create the MID Server user and follow the instructions in the help pane that 
appears on the right side of the screen.

Important: 
If you configured MID Servers manually prior to starting Guided Setup, select from that 
information to complete each specific task.

6. When you have provided the requested information for the MID Server user, click Submit, and 
then click Mark as Complete  at the bottom of the help pane.
The view returns to the task list. Notice that the circular progress indicator for the category 
shows 33% of the MID Server configuration complete. The progress indicator on the left side of 
the screen shows the completion percentage for all the IT Operations Management tasks.

7. Click Configure  for the next task, Download & Install MID.

Java 11.0.17 is bundled with the MID Server  installer package and is installed on the host for all 
new MID Servers. The installer automatically configures Java 11.0.17 to run in your environment. 
No additional configuration is required. This version supports both 64-bit Windows  MID 
Servers  and 64-bit Linux  MID Servers. The MID Server  requires a minimum JRE version 11.0.8, 
and recommended version 11.0.17. If you are using a lower version than 11.0.8, you may see 
encryption related issues.

8. Validate your new MID Server.

What to do next
If necessary, deploy multiple MID Servers from a single host  in your network. Otherwise, proceed 
to configure your MID Server.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2899



Configuring MID Servers

After installing and validating your MID Servers, ensure that they have access to sufficient 
system resources, probe the proper targets, and communicate with the instance as expected. 
Configure MID Server selection criteria, create clusters for failover protection, and set up MID 
Servers in different domains to protect data.

1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

Some of these configuration procedures rely on data found in the MID Server references home 
page. See that page for links to the parameters, properties, and privileged commands you need 
to fine tune the behavior of your MID Servers. You can apply controls to individual MID Servers 
or to all the MID Servers in your environment. Remember to restart the MID Server after any 
configuration change for those changes to take effect.

MID Server selection

MID Servers are selected for use based on three criteria: applications, IP address or range, and 
capabilities. You can designate specific applications for a given MID Server, such as Discovery 
or Orchestration. You can specify an IP address or a range that a MID Server is allowed to work 
within. Some applications require specific capabilities, and so are restricted to MID Servers with 
those capabilities.

MID Server selection

Configure the way your instance selects a MID Server, either by application, IP 
address ranges, network capability, or behavior.

MID Server capabilities

Create capabilities that define the specific functions of a MID Server within an IP 
address range.

MID Server IP range auto-assignment

Configure the system to automatically assign a qualified MID Server to a subnet by 
that subnet's IP address range.

Map an IP address to a DNS name

Map host server DNS names to IP addresses if your MID Server manages resources 
within defined IP ranges.

Configure MID Server as WinRM trusted host
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Add servers, which are part of WinRM, as trusted hosts on all MID Servers that 
Discovery or Service Mapping use for discovery.

File permission enforcement for Windows MID Servers

To improve security, Windows MID Servers will enforce Windows file permission 
restrictions. This will prevent compromised accounts from accessing unauthorized 
files by restricting their permissions to the minimum necessary for their role.

MID Server clusters

MID Server clusters are groups of MID Servers which provide support to each other in the forms 
of load balancing and fail-over protection. Work sent to a MID Server that is part of a cluster is 
automatically balanced between all the MID Servers in that cluster. MID Servers in a fail-over 
cluster each have a configured order that the platform uses to determine which MID Server to 
use next in case of failure.

Create a MID Server cluster

Create a MID Server cluster for load balancing and fail-over protection.

Set thread use

Set the number of threads your MID Server uses for the desired MID Server speed, 
based on hardware capabilities and competing applications running on the host.

Domain separation

Domain separation segregates MID Servers based on the records they can access. The 
credentials configured in a MID Server's config.xml file determine which records that MID Server 
can read, update, or create. You can specify MID Server policy records that only MID Servers 
from the same domain can use.

MID Server domain separation

Set up your MID Servers in different domains to restrict the records and credentials 
that a MID Server can access.

Synchronize a JAR file to MID Servers

Upload a JAR file to an instance and synchronize it to all MID Servers connected to 
that instance. Use JAR file synchronization to create policies that only a MID Server 
from the same domain can use.

MID Servers used for credential-less Discovery

MID Servers that are used for credential-less Discovery  require special configuration to run 
Network Mapper (Nmap) commands on target computers.

Install and uninstall Nmap on a MID Server

You must install Nmap on each MID Server running on a Windows host. When given the proper 
capability, those MID Servers can discover some basic information about CIs in your network if 
normal authentication fails.

MID Server extensions

vCenter event collector

The vCenter event collector listens for vCenter-related events and updates 
the CMDB accordingly. The event collector allows the CMDB to be updated 
with changes to virtual machines (VMs), in addition to the updates detected 
by Discovery. A change to a VM is sent as an event from the vCenter server to 
the vCenter event collector. When an event is received, the CMDB is updated 

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2901

https://www.webstg.servicenow.com/docs/access?context=nmap-credential-less-discovery&version=washingtondc&pubname=washingtondc-it-operations-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=nmap-credential-less-discovery&version=washingtondc&pubname=washingtondc-it-operations-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=nmap-credential-less-discovery&version=washingtondc&pubname=washingtondc-it-operations-management&ft:locale=en-US


accordingly. Full vCenter Discovery does not need to rerun. For some events, such 
as powered on and powered off events, Discovery does not need to run again at all. 
For most events, Discovery runs only on the necessary vCenter resource.

SNMP trap collector extension

The SNMP trap collector is a MID Server extension that listens for SNMP traps from 
the devices on your network.  Upon receiving a trap, the MID Server sends the trap 
to the instance for further processing by Event Management. If Event Management 
is not active, traps are not processed and are discarded by the instance.

MID Server selection

You can configure MID Server selection by application, IP address ranges, network capability, 
or behavior. Specific MID Servers can be assigned to particular tasks, or the MID Server can be 
selected automatically. MID Servers can use domain separation to limit the scope of discoveries 
and event management.

1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

The MID Selector used by most applications has three modes to select a MID Server:

• Auto-select MID Server: Selects from MID Servers based on MID Server criteria, regardless of 
whether they are members of a cluster.

• Use specific MID Server: Automatic reassignment to another MID Server is not supported.

• Use specific MID Server cluster: Automatic reassignment to another MID Server only selects 
from members of the specified cluster.

For Agent Client Collector, refer to Automatic MID Server selection .

MID Server criteria

MID Servers offer these types of criteria that help an application determine which MID Server to 
use:

• Application: The application that you specify on the MID Server. You can designate these 
applications for a specific MID Server:

◦ Discovery

◦ Orchestration

◦ Service Mapping
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◦ Event Management

◦ Operational Intelligence

◦ Cloud Management
An ALL  application option is also available. By default, this option includes all applications. You 
can configure which applications  are included in the ALL  designation.

• IP address or range: The IP address or the IP ranges that the MID Server is allowed to work 
within. You can specify an IP address or IP range in the application, such as on a Discovery 
schedule or an Orchestration activity, and for the MID Server. If the IP configured in the 
application matches the IP address or falls within the allowable IP range configured on the 
MID Server, a match is possible, and that MID Server passes this criteria. To have the instance 
automatically assign IP ranges (subnets) to available MID Servers, see Using MID Server IP 
range auto-assignment.

• Capabilities: The network capability  an application needs to use, such as the PowerShell 
Orchestration activity  or the Flow Designer  PowerShell step . Some applications, like Cloud 
Management, require a specific capability.

Note: 
Discovery and Service Mapping can also use behaviors, which determine the type of 
port probes used during the port scan phase of Discovery. Both Discovery and Service 
Mapping use a behavior to discover Create a discovery behavior for Unix-based load 
balancers . Other applications do not use behaviors. Behaviors are not used for 
auto-selection, default MID Servers, or specific MID Servers as described below. See 
Discovery behaviors  for more information.

How an application selects a MID Server
If you do not specify a specific MID Server for an application to use, the application tries to select 
one. Each application relies on different criteria to select an appropriate MID Server.

Application
Supported Application on the MID 
Server

IP address range Capability

Discovery

(Select Auto-
Select MID 
Server  on 
the Discovery 
schedule)

The Discovery  or ALL 
application must be specified 
on the MID Server.

Discovery uses IP 
ranges that you 
configure on the 
Discovery Schedule 
form  to see if they fall 
within the IP ranges 
that you configure on 
the MID Server, or the 
ALL  IP ranges option 
must be selected on 
the MID Server.

N/A

Note: 
Any configured 
behaviors are 
ignored.

Orchestration The Orchestration  or ALL 
application must be specified 
on the MID Server.

The target IP address 
that you configure 
in an Orchestration 
activity must fall within 
the IP ranges that 
you configure on the 
MID Server, or the 
ALL  option must be 
selected on the MID 
Server.

The capability that 
is required for an 
Orchestration activity 
must match the 
capabilities you 
configure on the MID 
Server, or the MID 
Server capability 
must be set to ALL.
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Application
Supported Application on the MID 
Server

IP address range Capability

Service 
Mapping

The Service Mapping  or ALL 
application must be specified 
on the MID Server.

The endpoint IP 
address must fall 
within the IP range 
that you configure on 
the MID Server, or the 
ALL  option must be 
selected on the MID 
Server.

One of the supported 
Service Mapping 
capabilities (for new 
installs) must be 
configured on the 
MID Server, or the 
MID Server capability 
must be set to ALL.

Event 
Management

The Event Management  or 
ALL  application must be 
specified on the MID Server.

The IP configured in 
the event connector 
instances, such as 
Configure event 
collection from 
HPOM , must fall 
within the IP range 
configured on the MID 
Server.

Cloud 
Management

N/A N/A The Cloud 
Management  or ALL 
capability must be 
added.

Mode: Auto-select MID Server

During initial work assignment to a MID Server, or when failing over existing work from a down 
MID Server to another MID Server, the MID selector picks a set of suitable MID from a given 
status level by traversing the steps below once. If at any step it finds at least one server, all 
remaining steps are skipped.

1. Suitable MID Servers with status = Up.

2. Default MID Server (if it was defined) with status = Up.

3. Suitable MID Servers with status = Upgrading or Paused.

4. Default MID Server (if it was defined) with status = Upgrading or Paused.

5. Suitable MID Servers with status = Upgrade Failed, Draining, Drained, Drain Failed, or Down.

6. Default Mid Server (if was defined).

All steps which are below an application's minimum status level are skipped. Many applications 
(such as Discovery) allow Up or Degraded MID Servers, other applications only allow Up MID 
Servers.
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Mode: Use specific MID Server cluster

During initial work assignment to a MID Server, or when failing over existing work from a down 
MID Server to another MID Server, the MID selector picks a set of suitable MID from a given 
status level by traversing the steps below once. If at any step it finds at least one server, all 
remaining steps are skipped.

1. Suitable Mid Servers with status = Up.

2. Suitable Mid Servers with status = Upgrading or Paused.

3. Suitable Mid Servers with status = Upgrade Failed, Draining, Drained, Drain Failed, or Down.

All steps which are below an application's minimum status level are skipped. Many applications 
(such as Discovery) allow Up or Degraded MID Servers, other applications only allow Up MID 
Servers.

A MID server is picked from set of MID servers at the highest status level as follows depending 
on cluster type:

• Load Balance Cluster: picks a MID Server within the status level randomly.

• Fail-over Cluster: picks a MID Server with best cluster records' order number (0 = best).

Mode: Use a specific MID Server

Discovery and Event Management can use a MID Server that you specifically call out.

Note: 
Selecting a specific MID Server is not the same as specifying the default MID Server for 
an application. A specific MID Server is always used. If it is Down  or not validated, the 
application does not execute commands against the MID Server. A default MID Server is 
fallback that is used when the auto-selection of MID Servers does not find any eligible MID 
Server.

Application How you specify a specific MID Server Criteria that the default MID Server must meet

Discovery Choose the MID Server on the Discovery 
schedule.

Note: 
You can also specify a cluster of MID 
Servers.

If you select a MID Server without the Discovery  or 
ALL  application, it automatically adds the Discovery 
application.

Orchestration N/A N/A

Service Mapping N/A N/A

Event Management Choose one or more MID Servers on the 
connector instance event collection, such 
as Configure event collection from HPOM .

N/A

Cloud Management N/A N/A
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Note: 
If a MID Server manages resources within defined IP ranges for Orchestration, you must 
map the fully-qualified domain name (FQDN) of a server with its IP address to run certain 
activities, such as Exchange activities.

Domain separation
If you are using domain separation, you can configure MID Servers to be in separate domains. 
The domain that the MID Server is in affects how the application selects the domain:

Discovery and Service Mapping: On the Discovery schedule, the MID Servers and clusters 
that available for selection are limited to the same domain of the user who is configuring the 
schedule. This also applies to the auto-selection option: only MID Servers in the same domain as 
the user can be automatically selected.

MID Server selection test for Service Mapping

If Service Mapping is active, you can preview which MID Server that Service Mapping uses for a 
specific target device or computer. To do this, navigate to Service Mapping  > MID Servers  and 
click MID Selection Test. Enter the IP address and an optional application and capability, and 
then click OK. The name of the MID Server that Service Mapping will use appears in the window.

Related topics

Configure a default MID Server for each application

You can configure a default MID Server that an application can use if all other possible MID 
Servers are unavailable. You can narrow down the list of applications that are included in the 
definition of ALL.

Before you begin
Role required: agent_admin or admin

1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

About this task
Applications are only available when their respective plugins are activated.

The default MID Server is used when applications fail to find a suitable MID Server that matches 
configured criteria during auto-select. The default MID Server for the ALL  application is used if 
the default MID Server for the specific application is not available. Some applications also offer a 
property to set the default MID Server.
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Important: 
If you configure a MID Server for ALL IP ranges (type Include) and also create an IP range 
of type: Exclude  for the same MID Server, the system ignores the excluded IP range for that 
MID Server.

The default MID Server does not need to meet any criteria (application, IP range, behavior, or 
capability) to be used. Specifying a default MID Server is optional, and you can use a MID Server 
as the default for more than one application.

Application Additional notes

Discovery Discovery attempts to use the default MID Server when the Discovery 
schedule specifies Auto-Select MID Server  and Discovery cannot find 
any MID Servers with the correct application and IP range.

Orchestration Orchestration attempts to use the default MID Server when it cannot 
find any MID Servers with the capabilities that you define in the 
Orchestration activity.

You can also specify a default MID Server. The value in that property 
automatically synchronizes with the default MID Server you select in 
the Orchestration application.

Alert aggregation and 
RCA

Not applicable. The MID Server is selected if it has the RCA capability. 
Route to right MID by domain.

Service Mapping If there are no MID Servers with matching application, capability, or IP 
range, Service Mapping  uses the default MID Server.

Event Management You can specify a default MID Server for Event Management using the 
mid.server.connector_default system property. Event Management 
does not use the default MID Server in the application record.

Cloud Management N/A

Procedure

1. Navigate to All  > MID Server  > Applications.
The list of installed applications that can use MID Servers appears.

2. Click the name of an installed application.

3. Select a MID Server from the list in the Default MID Server  field.

4. To select additional MID Servers for this application, click Edit  in the MID Servers  related list 
and select alternate MID Servers that this application is allowed to use.

5. Click Update.

Select applications to include in the definition of ALL for a MID Server

You can narrow down the list of applications that are included in the definition of ALL.

Before you begin
Role required: agent_admin or admin

About this task
You can specify the ALL application for a MID Server, which means that the MID Server is 
allowed to work with any of the applications that require MID Servers, such as Discovery, Event 
Management, Service Mapping, and so on. But you might not want all applications to be included 
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in the definition of ALL. For example, you might want to exclude Service Mapping from the ALL 
definition if you already have a dedicated MID Server to work with Service Mapping.

Procedure

1. Navigate to All  > MID Server  > Applications.
The list of installed applications that can use MID Servers appear.

2. If you do not see the Included in application ALL  column, you can personalize the list and add 
it.

Included in application ALL

3. For each application, double-click the value in the Included in application ALL  column.

4. Change the value to true  (to include) or false  (to exclude).

Configure an IP address range for the MID Server

You can manually configure an IP address range for the MID Server to explore.

Before you begin
Role required: agent_admin or admin

1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

About this task
Applications, such as Discovery and Orchestration, can specify an IP range or the specific IP 
address of a target. When the application looks for a MID Server to use during auto-selection, it 
chooses a MID Server whose IP range includes the application's range or specific IP address. 
Applications also use other criteria, such as the MID Server's supported application or capability. 
See MID Server selection  for more information.
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Note: 
This is a manual configuration procedure. To learn how the system can assign IP address 
ranges to selected MID Servers automatically, see Using MID Server IP range auto-
assignment.

These applications use IP ranges as follows:

• Orchestration: Use the IP address of the target machine (together with the capability) to select 
the correct MID Server for Orchestration activities. See the procedure in this topic to configure 
the IP address.

• Service Mapping: Select the MID Server whose IP address range matches the IP in the 
discovery request. See MID Server configuration for Service Mapping  for more information.

• Discovery: Can select an IP address range using the same criteria as Service Mapping. 
Discovery can also use a quick IP range  that you specify in the Discovery schedule.

Tip: 
You can also use the ALL  IP range, which allows the MID Server to be used with any range 
of IP addresses that an application specifies. This only allows the MID Server to access 
IP ranges, it does not mean that the MID Server can actually reach all of the IP ranges. To 
function with an application, the MID server must have access to the IP ranges that the 
application needs.

Valid IP address ranges can be as follows:

An IP address in dotted decimal or hexadecimal format. The hexadecimal format can be explicitly 
prefixed with 0x, this is not mandatory. Here are examples:

• 10.11.144.155

• 0x0A0B909B

• 0A0B909B

An IP address range in dotted decimal or hexadecimal format. Here are examples:

• 10.11.144.150-10.11.144.160

• 0x0A0B9096-0x0A0B90A0

• 10.11.144.150-0x0A0B90A0

An IP network address with the net mask specified after a slash (/) in regular notation (0-32 
inclusive) or in IP address notation. Here are examples:

• 10.11.144.0/24 10.11.144.0/255.255.255.0

• 10.11.144.0/0xFFFFFF00

• 0x0A0B9000/24

• 0x0A0B9000/0xFFFFFF00

Procedure

1. Navigate to All  > MID Server  > IP Ranges.

2. Click New.

3. Complete the form, using the fields in the table.
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IP address ranges

Field Description

Name Enter a descriptive name.

Application Application scope for this IP range. The default is Global.

Type Select the type of range:

◦ Include: Include the specified IP range.

◦ Exclude: Exclude the IP address range.

Note: 
If a MID Server is configured for ALL  applications, any IP addresses 
configured for exclusion are ignored by the system. If your goal is to 
configure default MID Servers for separate applications in your system, 
see Configure a default MID Server for each application.

Range Enter the range in a valid format.

Related list

MID 
Servers

The MID Servers that can use this IP address range.

4. Click Save.

Important: 
IP ranges assigned manually prior to using auto-assignment in the Discovery Quick 
Start  are affected as follows:

◦ Individual IP ranges are retained and appended to the ranges assigned automatically 
by the system for the designated MID Server.

◦ If the MID Server was configured with the ALL  ranges selection, the auto-assignment 
feature overwrites that designation with the ranges it finds.
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What to do next
Open the ALL  IP range record and configure the MID Servers that you want to use with any set of 
IP addresses.

Override the MID Server selection filter

You can use the override feature to write your own filter condition that overrides the normal MID 
Server selection criteria for an application. An override has precedent over the default filter and 
can be defined for a specific selection condition.

Before you begin
Before attempting to create an override filter, be sure you understand the criteria the platform 
uses to select MID Servers. See MID Server selection  for details.

Role required: admin

1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

About this task
Note: 
The override feature is intended for Cloud Management and Cloud Discovery only. The 
Override by capability  filter is provided by default.

There are four MID Server selection filters included in the base ServiceNow system. These filters 
are applied to all MID Servers in order until the system finds a matching condition:

• Status Filter

• App Filter

• Capability Filter

• IP Filter

Important: 
The override feature allows multiple filter types but only one override filter for each filter 
type. The Override selector  filter type overrides all other filters and takes complete control 
of the MID Server selection. If this type is active, it is the only filter applied.

Procedure

1. Navigate to All  > MID Server  > Mid Selector Override.
The list of MID Server overrides appears.
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2. Click New  to create a new filter.

3. Complete these fields:

◦ Name: Unique name for this override. Ensure that you can identify the override type by the 
name.

◦ Script: Condition for this filter. Create the MID Server selection logic for your override in 
this field, using the directions provided in the function template. Look at the Override by 
capability  filter as an example before starting to create your filter.

◦ Type: Type of override being configured. Select one of the four default filters to override with 
your condition, or select Override selector  to create a filter that overrides all the others.

4. Click Submit.

Example:
The Cloud Discovery schedule selects MID Servers based on Applications and 
Capabilities. To select different MID Servers for different service accounts, you can 
customize the MID Selector Override. After the line (function filter(/
* MIDServerJS Array */ candidateMIDList, /* MIDServerJS 
Array */ defaultSelectedMIDList, /* Native JS object */ 
midSelectorContext, /* MIDSelectorParamJS */ requestedParameters) 
{ add the following code with your information:

var result = [];
 
 if (JSON.parse(midSelectorContext).service_account_id == 
 '[example-account-id]') {
  for (var mid in defaultSelectedMIDList) {
   if (defaultSelectedMIDList[mid].sysId == '[example-MID-1]' || 
 defaultSelectedMIDList[mid].sysId == '[example-MID-2]')
    result.push(defaultSelectedMIDList[mid]);
  }
  return result;
 }
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Using MID Server IP range auto-assignment

Discovery Quick Start can automatically assign ranges of IP addresses, called subnets, to 
qualified MID Servers. This subnet auto-assignment requires SNMP credentials for read-only 
access to routers Discovery uses. The Automation Status Set form shows summary details of 
subnet Discoveries and the IP range assignments for associated MID Servers.

1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

To be automatically assigned to a subnet, a MID Server must be:

• In a running (Up)  state.

• Successfully validated.

• Able to access one or more subnets in your network.

The subnet assignments that the instance makes for your MID Servers are stored in the 
Automation Status Set [automation_status_set] table. For details about MID Server auto-
assignment, see Discovery Quick Start .

Important: 
You must auto-assign at least one MID Server to create a schedule automatically.

Required SNMP OIDs for MID Server IP range auto-assignment

Customers who use network service providers must request specific SNMP access to use MID 
Server IP range auto-assignment.

IP range auto-assignment requires SNMP credentials for read-only access to all routers that 
Discovery uses to identify subnets. In addition, your service provider must grant the following 
SNMPWALK access:

• iso.org.dod.internet.mgmt.mib-2.ip.ipRouteTable (1.3.6.1.2.1.4.21)

◦ ipRouteDest (1.3.6.1.2.1.4.21.1.1)

◦ ipRouteNextHop (1.3.6.1.2.1.4.21.1.7)

◦ ipRouteType (1.3.6.1.2.1.4.21.1.8)

◦ ipRouteMask (1.3.6.1.2.1.4.21.1.11)

• iso.org.dod.internet.mgmt.mib-2.ip.ipForward.ipCidrRouteTable (1.3.6.1.2.1.4.24.4)
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◦ ipCidrRouteDest (1.3.6.1.2.1.4.24.4.1.1)

◦ ipCidrRouteMask (1.3.6.1.2.1.4.24.4.1.2)

◦ ipCidrRouteNextHop (1.3.6.1.2.1.4.24.4.1.4)

◦ ipCidrRouteType (1.3.6.1.2.1.4.24.4.1.6)

View automation status sets and IP range assignments

The Automation Status Set form shows summary details of a subnet Discovery and the 
subsequent IP range assignments for MID Servers selected for automatic subnet assignment.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > MID Server  > Automation Status Sets.

2. Select a status record for a subnet Discovery you want to view.
The form contains read-only status information about the selected Discovery, the subnets 
found, and the range assignment process for the MID Servers you selected for auto 
assignment.

Important: 
IP ranges assigned manually prior to using auto-assignment in the Discovery Quick 
Start  are affected as follows:

◦ Individual IP ranges are retained and appended to the ranges assigned automatically 
by the system for the designated MID Server.

◦ If the MID Server was configured with the ALL  ranges selection, the auto-assignment 
feature overwrites that designation with the ranges it finds.
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Automation Status Set form

3. Select the Subnets Discovered  related list to view the list of subnets available for assignment.

4. Select the IP Range Assignments  related list to view the IP ranges that were assigned to a MID 
Server.
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Warning: 
IP ranges identified by Discovery are stored in the IP collection [ip_address_collection] 
table, which is only used for MID Server IP range auto-assignment in the Jakarta 
release. This table is intended for future development and should not  be used in any 
customizations, including column additions, business rules, or scripting actions.

File permission enforcement for Windows MID Servers

To improve security, Windows MID Servers enforce Windows file permission restrictions. The 
enforcement limits access to the MID Server files to a restricted allow list of users and groups.

1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

File permission enforcement for Windows MID Servers goes into effect on the MID Server on 
start up in Orlando. By default the agent folder is locked to four user accounts and groups: the 
local admin group, the system account, creator owner, and the user account the Windows MID 
Server is using. The list of permitted user accounts is managed by a allow list, which is controlled 
by the MID Server parameter mid.windows_host.file_permissions.allow_list. 
This parameter takes a string of comma separated group names, user names, and security 
identifiers (SID). Group and user names must follow SAM account naming requirements. Domain 
accounts must be specified by using the SID.

Roll back file permission changes

Changes to the file permissions are recorded, and the last used settings are saved in the /
etc  folder as a backup. The file is fileperm.aclsave. Open a command prompt and 
run the command icacls <agent_folder> /restore <agent_folder>/etc/
fileperm.aclsave  where <agent_folder> is name of your agent folder.
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Run a MID Server as a non-admin

To run a MID Server as a non-admin user, it must first be installed using an admin account. Then 
add the non-admin user to allow list and restart the MID Server. Once the new enforcement rules 
run, the MID Server can be switched to the non-admin service account. See Run a Windows MID 
Server as a non-admin after manual installation  for more information on setting up non-admin 
Windows MID Servers, or Run Linux MID Servers as non-root users  for Linux MID Servers.

Map an IP address to a DNS name

Associate the IP address to a DNS name to ensure the appropriate MID Server is selected. The 
IP Address range configuration determines which MID Server is selected. If the MID Server 
manages resources within defined IP ranges, all host servers must have their DNS names 
mapped to an IP address.

Before you begin
Role required: admin

1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

The association of an IP address to a DNS name ensures that the appropriate MID Sever is 
selected based on the IP Address range configuration. If this is not done, Orchestration reverts to 
the default MID Server.

If Discovery cannot discover the server and resolve the DNS name to an IP address, you must 
create the mapping manually.

Important: 
The platform does not map localhost  to 127.0.0.1 automatically. You must create that 
mapping using this procedure.

Procedure

1. Enter cmdb_ci_dns_name.list  in the navigation filter.

A list of DNS names appears.

2. Check the list for your host server.

If the server does not appear in the list, continue with this procedure.

3. Click New.
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4. Enter the fully-qualified domain name (FQDN) of the host server in the Name  field.

5. Right-click in the form header and select Save  from the context menu.

6. In the IP Address  related list, click New.

7. In the IP Address  field, enter the IP address of your host server.

8. In the Nic  field, select eth0  or your preferred network interface controller.

9. Leave the Netmask  field blank.

10. Click Submit.

Configure MID Server capabilities

MID Server capabilities define the specific functions of a MID Server within an IP address range, 
allowing an application to select the most appropriate MID Server. Configure capabilities on MID 
Servers for applications like Orchestration, Cloud Management, and Service Mapping.

Before you begin
Role required: admin or sm_admin

1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

About this task
Several applications use capabilities, IP ranges, and MID Server selection  to narrow the pool of 
MID Servers the applications need.

Note: 
At least one capability is required for each MID Server used by Orchestration. See MID 
Servers for Orchestration  for more information.

The following capabilities are available by default with Discovery:

All IBM Resolve DNS

Ansible JDBC REST

AWS NetApp SNMP

Azure Nmap SOAP

Chef OpenStack SSH
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Cloud Management PowerShell VMware

Google RCA WMI

Procedure

1. Navigate to All  > MID Server  > Capabilities.

2. Select an existing capability or select ALL  to include all capabilities.

Note: 
Ensure that each IP address range has MID Servers with the necessary capabilities to 
complete the Orchestration activities on that network segment.

3. Create a new capability:

a. Select New.

b. Configure the value for a custom capability.

Example 
An example is a capability for DOMAIN, with a value of service-now.

c. Select Submit.

4. Select Edit  in the MID Servers related list to add MID Servers to the capability.

5. Select one or more MID Servers for this capability from the Available  list.

6. Select Save.

The capability defined here also appears in the primary record for this MID Server.

MID Server capabilities

MID Server capabilities define the specific functions of a MID Server within an IP address range.

Nmap capability

The Nmap  capability is only assigned to MID Servers for which the Network Mapper (Nmap) 
scanner has been installed for credential-less Discovery . This capability cannot be added to or 
removed from any MID Server manually. For instructions on installing or uninstalling Nmap, see 
Install and uninstall Nmap on a MID Server

MID Server capability values

Capabilities provided in the base system do not have a defined value string. The capability 
value can be blank, a single value, or a * (wildcard). A MID Server configured to use a capability 
that has no value can locate any device using that capability's protocol. If a capability has a 
defined value, the MID Server using that capability finds only those devices using that protocol 
that match the value string exactly. The exception to this is the Resolve DNS capability, which 
is configured to resolve any DNS name into an IP address using a partial string match. The * 
(wildcard) will match a request capability specifying any non-blank value.

Starting with the Madrid release, the [capability name]:[value]  combination appears in the 
slushbucket when you add a capability to a MID Server. This combination allows you to see all 
the capabilities that have different values, even if the capability name is the same. For example, 
if you are using the Cloud Management capability, and you use the value field to specify the us-
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west logical datacenter on one of the capability records, you can see the combination in the 
Collection  list.

MID Server selection

The MID Server is selected using an algorithm based on the capabilities available. The selector 
produces a list of suitable MIDs using filters in the following order: server status  > applications  > 
IP range  > capabilities. The algorithm searches the capabilities in the following sequence and, if 
a step finds at least one MID server, the remaining steps are skipped:

1. Exact value match:  Find each MID Server containing capabilities with name/value pairs with 
an exact match to all requested capability name/value pairs. Blank is a valid value. * (wildcard) 
values are ignored.

2. Wildcard value match:  The same as an exact value match, but also allows a non-blank request 
value to match MID server capability records containing value *.

3. Special capability name ALL:  Find each MID Server containing the special capability name 
ALL, ignoring capability's value field.

Note: 
If the requested capability name does not exist in the ecc_agent_capability table, 
BadArgumentException  is thrown rather than falling back to the ALL capability.

Scripted MID Server capability value matching

You can use value tests to create capabilities that find devices using values without requiring 
exact string matching. Action on these values is controlled by a user-defined script.

The Resolve DNS capability is provided in the base system and is configured to resolve DNS 
names into IP addresses for devices whose names end with a specified domain name. The 
capability Value  entered is automatically prefaced with a dot during processing to match domain 
syntax. This value can contain one or more sub-domains, but must include the end of the 
domain string. Matching devices must end with the identical syntax. The script for the Resolve 
DNS capability determines if a device name matches the criteria defined by Value. If a match 
exists, the platform performs the address resolution automatically. For example, if the value for 
the Resolve DNS capability is service-now.com, the MID Server with this capability finds 
lnxlab01.sandiego.service-now.com  and dbsrv101.sanjose.service-
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now.com. If the value is changed to sandiego.service-now.com, then the MID Server 
finds only lnxlab01.

Note: 
If Value  in the Resolve DNS capability is blank, then all domains match.

To view the script for evaluating this capability, navigate to MID Server  > Capability Value Tests 
and select Resolve DNS  from the list.

Configure a MID Server cluster

Group multiple MID Servers to form clusters, then configure clusters for fail-over protection 
or load balancing. Load-balancing clusters automatically balance work between each MID 
Server to improve stability and performance, as well as handle fail-over. Fail-over clusters have a 
configured order used to determine which MID Server to use next if a failure occurs.

Before you begin
Ensure that all MID Servers in the cluster have the same capabilities  (Supported Applications, IP 
Ranges, and Capabilities). A MID Server should not belong to more than one cluster.

Role required: admin
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1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

About this task
Create a new cluster or edit an existing cluster.

Procedure

1. Navigate to All  > MID Server  > Clusters.

2. Click New  to create a new cluster, or open an existing cluster's record to edit.

3. Name the cluster and select the cluster type: Failover  or Load Balance.

4. Right click in the header bar and select Save  from the context menu.

5. Click Edit  in the Includes MID Servers  Related List.

6. Select appropriate MID Servers for this cluster from the slushbucket.

MID Server clusters

MID Server clusters enable multiple MID Servers with the appropriate capabilities to be grouped 
together for load balancing and fail-over protection.

External data sources

For performance and reliability reasons, these data sources should not be used with MID Server 
clusters. These external data sources should only be used with dedicated MID Servers.

• LDAP

• Export sets

• JDBC data sources

Note: 
If a MID Server in a cluster fails, the fail-over MID Server starts over at the beginning of the 
ECC queue task even if much of the information from the JDBC data source was already 
returned. This can result in duplicate data. For more details, see the Using MID Server 
clusters for JDBC data sources can cause duplicate and out-of-date data [KB0727739]
article in the HI Knowledge Base.
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How clusters work

MID Servers in clusters must be able to connect to the instance and to all the devices with which 
they are expected to communicate. If all MID Servers in a cluster are down, the discovery is 
canceled. Make sure all the MID Servers are added to any Access Control List (ACL) in use. MID 
Server clusters are managed by a business rule called MID Server Cluster Management, which 
checks to see if the MID Server assigned to a job in the ECC Queue belongs to a cluster.

Load balancing

If the cluster business rule determines that a MID Server is part of a load balancing 
cluster, the application using the MID Server automatically balances the work 
between the MID Servers in that cluster. It is good practice to put MID Servers with 
the same capabilities  in a load balancing cluster.

Fail-over protection

MID Servers in a fail-over cluster each have a configured order that the platform 
uses to determine which MID Server to use next in case of failure. MID Servers 
in a fail-over cluster work independently and do not load balance with other MID 
Servers in that cluster (although they might also be members of load balancing 
clusters). When a MID Server fails, the MID Server Cluster Management business 
rule selects the highest available MID Server in the order to take over the work. The 
selected MID Server checks the ECC Queue and starts with jobs that are either 
Processing or Ready.

Note: 
MID Server clustering does not support the ECC queue topics Command 
or SystemCommand. If these commands are received, the clustered MID 
Servers do not redirect the ECC queue to another MID Server. The ECC queue 
records stay on the ECC queue without being processed.

Configure a fail-over MID Server with at least the same capabilities as the MID 
Server it is intended to relieve.

Note: 
If a MID Server fails while the Shazzam probe  is running and auto-selection 
is configured, failover is not available. The Shazzam discovery stops. Discovery 
does not automatically choose another MID Server.

MID Server cluster event

The following event is triggered when the platform cannot find a MID Server with the appropriate 
capabilities to replace a MID Server in a fail-over cluster. Use this event to create an email to 
notify appropriate users that the cluster has failed.

MID Server cluster event

Event Table Description Business Rule

mid_server.cluster.down MID Server Cluster 
[ecc_agent_cluster]

A MID Server 
cluster has failed

MID Server Cluster 
Management

Combining clusters

A MID Server can be added to both types of clusters at the same time. This diagram shows a 
scenario in which a MID Server from a load balancing cluster (MID Server D) is also present in a 
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fail-over cluster. If MID Server D fails, MID Server E in the failover cluster is available to the load 
balancing cluster to perform the tasks previously assigned to MID Server D.

Specifying a specific MID Server cluster

You can specify a specific MID Server cluster for a Discovery schedule. The discovery process 
uses that cluster only. You cannot chain clusters or specify a single MID Server that belongs to 
multiple clusters.

Distributed MID Server clusters for Operational Intelligence

The distributed  MID Server cluster type is used exclusively in Operational Intelligence, which 
analyzes Event Management events and generates anomaly alerts. These MID Servers 
communicate with one another to distribute and balance the workload. For details, see MID 
Server distributed clusters for Operational Intelligence

Set MID Server thread use

Change the number of threads used by the MID Server according to performance requirements. 
MID Servers which compete with other programs for CPU time can use fewer threads than the 
default. MID Servers which need more speed, and have a host computer powerful enough, can 
use more threads.

Before you begin
Role required: admin

1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

About this task
The three parameters define the maximum numbers of worker threads that can run 
simultaneously in each pool: threads.interactive.max, threads.expedited.max, 
and threads.max. Changing the thread parameters can affect the MID Server performance.
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The interactive thread pool is designed for executing interactive messages including system 
commands and heartbeats. They are typically lightweight, so usually there is no need to 
change the default value. The expedited thread pool is designed for executing messages that 
have higher priority than the standard ones but less than interactive ones. Unless you have 
applications that produce a lot of expedited messages, there is no need to change the default 
value for threads.expedited.max.

The standard thread pool is the busiest pool. Most probes are using it and they can take a lot of 
system resources such as CPU, memory, and so on. You can set the MID Server to use as few as 
five threads without issue. To increase the speed of the MID Server if the host is powerful enough 
or lightly loaded with other programs, you can increase the threads setting.

The threads setting depends on the limitation of the CPU speed, memory, and operating system 
of the host machine. You might have to experiment to find the optimal threads count that works 
best when the MID Server is busy so it does not exhaust the host machine’s hardware limitations. 
This means you may have to refine the thread count to best meet your situation. The following 
general observations may be useful:

• PowerShell is resource intensive and threads may not scale linearly.

• Most MID Server tasks require file handles to do their job.

◦ Windows: On the Windows  operating system, file handles are available in a fixed quantity. 
If you configure too many MID Server threads on a Windows  host, the MID Server can 
consume all the file handles before approaching maximum CPU usage. This situation 
appears as an Out of file handles  error in the MID Server log and indicates that the MID 
Server is trying to use too many threads.

◦ UNIX  and Linux: UNIX  and Linux  hosts have a much different scheme for allocating file 
handles. Generally, you can increase MID Server thread use on these operating systems 
until the CPU of the host is overloaded. See your OS documentation for monitoring CPU 
usage.

• Each thread on the MID Server requires some memory. Exactly how much memory varies 
considerably from task to task and depends on the equipment being discovered. To increase 
the number of threads, you might have to increase the amount of memory  that Java uses. If you 
configure insufficient memory, an Out of memory  error appears in the MID Server log.

• You can set threads.max as high as 200, however, this setting may need to be changed 
depending on the OS. For example, Windows-based MID Servers running Discovery uses 
Powershell which is resource intensive. In this case, you may exhaust the CPU power of the 
host machine with just 50 threads count.

Follow the steps below to change the config.XML  file. Alternatively, use the threads.max 
connection parameter. See MID Server Connection parameters  for more details.

Procedure

1. Open the \agent\config.xml  file using any text editor.

2. Locate the following lines:

<!-- MID Server Threads --><parameter name="threads.max" 
 value="25"/>

3. Edit the value.
Keep in mind the cautions described above.

4. Save the record.

5. Restart the MID Server service.
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Install and uninstall Nmap on a MID Server

If you decide to use credential-less Discovery in your network, you must install Nmap on each 
Windows MID Server that you want to use for this purpose. Self-hosted customers whose 
network security does not permit downloads from install.service-now.com  must use a 
specific manual process to install and configure Nmap.

Before you begin
Role required: mid_admin

1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

• Assign MID Server IP ranges to all deployed MID Servers. The quickest and most reliable 
way to do this is with the Using MID Server IP range auto-assignment  feature available in the 
Discovery Quick Start  wizard. This method ensures that the set of MID Servers configured to 
access an IP address range is comprehensive.

• Identify the IP ranges you want to explore with credential-less Discovery. Ensure that these 
ranges can only be accessed by MID Servers with Nmap installed, running on supported 
Windows hosts.

• Use the All  option for selecting IP ranges and observe these requirements:

◦ Restrict the use of this feature to Windows MID Servers only.

◦ Ensure that Nmap is installed on each of these MID Servers.

◦ Ensure that the MID Servers can access the entire customer network.

• When you create a Discovery schedule with Nmap enabled, observe these requirements for 
the MID Server selection options:

◦ Specific MID Cluster: Verify that Nmap is installed on all MID Servers in the cluster, where 
each MID Server in the cluster is configured to access the same set of IP ranges.

◦ Auto-Select Mid Server: When running horizontal Discovery, verify that Nmap is installed 
on at least one of the MID Servers that can access the Discovery schedule’s configured MID 
Server IP ranges.

◦ Specific MID Server: Verify that Nmap is installed on each MID Server that can access the 
schedule’s configured MID Server IP Ranges.

Note: 
To use credential-less Discovery for Service Mapping, install Nmap on all MID Servers 
that can access the Discovery schedule’s configured MID Server IP ranges.
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Role required: agent_admin

About this task
The Discovery - IP Based [com.snc.discovery.ip_based] plugin provides connection to the 
installer for Nmap and the programming elements that allow a Windows MID Server to run 
approved scripts on target CIs for credential-less Discovery. MID Servers on which Nmap is 
installed can execute an Nmap command configured to perform reverse DNS name resolution, 
discover MAC addresses, or gather OS information on target CIs without using credentials. The 
Discovery - IP Based plugin is activated automatically when the Discovery [com.snc.discovery] or 
Event Management and Service Mapping Core [com.snc.service-watch] plugins are activated.

Service Mapping and Nmap

Service Mapping does not check for the presence of the Nmap  capability and 
selects the MID Server based on the IP address only. To ensure that Service 
Mapping does not select a MID Server without the Nmap  capability, install 
Nmap on all MID Servers assigned to the IP address ranges for which you want 
credential-less Discovery to be available. If Service Mapping selects a MID Server 
for credential-less Discovery that does not have Nmap capabilities, this error 
message appears in the map at the site of the CI being discovered: Nmap is not 
installed on MID Server. Verify all MIDs configured to 
handle selected IP Address have Nmap Capability. Nmap 
root directory path does not exist: <path>

Amazon Web Service AWS

Running Nmap scans to or from any resource within the Amazon Web Service AWS 
environment is tightly regulated and requires the permission of AWS through the 
AWS Vulnerability/Penetration Testing Request  form. AWS only permits testing 
of EC2 and RDS instances that you own. Tests against any other AWS services or 
AWS-owned resources are prohibited. In addition, any Nmap scan of a permitted 
instance must be performed within an approved time window. For these reasons, 
credential-less Discovery within an AWS environment is not appropriate, and if a 
violation of their policy occurs, could result in expulsion from the service.

Supported operating systems

Nmap is supported on all editions of these operating systems, including virtual 
machines and 64 bit systems:

• Windows 2012

• Windows 2016

MID Server requirements

Nmap can be installed on MID Servers that meet these requirements:

• Status is Up.

• MID Server is validated.

• MID Server does not already have the Nmap  capability.

• MID Server must be logged in as a local admin if Nmap is not already installed. 
Administrative privleges are only necessary for the installation process. Once 
Nmap is installed, non-admin users can use and run credential-less discovery.

Note: 
If there are multiple MID Servers installed on the same host machine and 
one of them has already installed Nmap using an admin user, the other MID 
Servers can enable credential-less discovery using a non-admin user.
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Warning: 
The MID Server installation path must not contain the following characters:

• ( )

• { }

• [ ]

The Nmap installer replaces these characters with spaces. This prevents the 
installer from finding the correct path, and the installation fails. An example of 
a path that will fail is C:\MIDServers\MID(1)\agent.

Procedure

1. Navigate to All  > MID Server  > Servers.

2. Open the desired MID Server record.

3. Under Related Links, select Enable Credential-less Discovery.
A confirmation dialog box appears.

4. Click Yes  to continue with the installation.
The instance runs the Nmap installer from https://install.service-now.com, a site 
within a ServiceNow datacenter that contains installers for the platform. This progress notice 
appears during installation:

The Logs  tab in the MID Server record shows the message: Running system command: 
installNmap.

5. Click OK  if you want to hide the dialog box while the installer continues to run in the 
background.
Installing Nmap also installs Npcap on the host, if it is not already installed. Npcap is Nmap's 
packet capture library for Windows that allows Nmap to perform port scans quickly and to 
identify the family of the operating system running on the target. Npcap is installed once on the 
host and can be used by any other application that requires it, such as Wireshark.
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Note: 
If a more recent version of Npcap is already installed on the Windows MID Server host, 
Nmap is installed without Npcap. If an older version of Npcap is installed on the host, the 
Nmap installer upgrades it to the newer version.

The installation process has either of these outcomes:

◦ Success: These conditions indicate a successful installation:

▪ The version of Nmap that is installed appears in the Nmap version  field in the MID Server 
record

▪ The Related Link  changes to Disable Credential-less Discovery.

▪ The Nmap  capability is assigned to the MID Server and appears in the Capabilities  tab of 
the MID Server record.

◦ Failure: If the installation fails, an error message is logged to the MID Server Issue 
[ecc_agent_issue]  table. If you run the installer again with success, the issue is marked as 
Resolved.

6. To uninstall Nmap for a selected MID Server, select Disable Credential-less Discovery  under 
Related Links  in the MID Server record.
This dialog appears during the uninstallation process:

The Logs  tab in the MID Server record shows the message: Running system command: 
uninstallNmap.

Important: 
Because Npcap can be used by other applications, uninstalling Nmap does not 
automatically uninstall Npcap. You must uninstall Npcap manually, after determining that 
no other dependencies exist.

Related topics

Credential-less Discovery

Install Nmap on a self-hosted system

Use this procedure to install Nmap on MID Server host machines in a self-hosted environment 
that does not allow network access to the ServiceNow®  install.service-now.com 
download site.

Before you begin
Role required: admin, maint

About this task
You must install Nmap manually on each MID Server host and then configure the instance to 
execute credential-less Discovery.

Note: 
This procedure does not apply to self-hosted customers whose MID Server hosts can 
access install.service-now.com  from within their network.
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Procedure

1. Navigate to All  > MID Server  > Properties  (MID Server Property [ecc_agent_property] table) 
and open the record for the mid.nmap.version  property.
This property contains the version of Nmap that you must install. Record the version number.

2. Download the correct installer executable from one of these URLs:

◦ https://nmap.org/dist/ : If the Nmap version in the property is 7.94, the executable you need 
is https://nmap.org/dist/nmap-7.94-setup.exe.

◦ https://install.service-now.com/glide/distribution/builds/
package/thirdparty/nmap/nmap-setup-xxx-windows.exe. If the 
Nmap version in the property is 7.94, the executable you need is https://
install.service-now.com/glide/distribution/builds/package/
thirdparty/nmap/nmap-setup-7.94-windows.exe

3. Create a folder called nmap  in the MID Server agent  folder of every MID Server you want to 
use for credential-less Discovery.

4. Copy the Nmap installer file that you downloaded to the nmap  folder and rename it to 
nmapInstaller.exe.

5. Run the agent\scripts\PowerShell\NmapInstallation.ps1  script and pass it 
the following parameters in the order in which they appear.
This script runs the nmapInstaller.exe  file.
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a. $operation: Task that NmapInstallations.ps1  will process. To install Nmap, the 
task is install.

b. $nmap_root_path: Complete path for the nmap  folder that you create in step 4.

c. $nmap_self_installer: Complete path for nmapInstaller.exe  file that you 
copied in step 5.

d. $nmap_command: Complete path for the Nmap install command. The 
NmapInstallations.ps1  script installs Nmap in the nmap  folder created in step 4. This 
parameter is $nmap_root_path\nmap.exe.

e. $nmap_uninstall_command: Complete path for the Nmap uninstall command. This 
command is $nmap_root_path\Uninstall.exe.

f. $nmap_npcap_version: The Npcap version installed with Nmap. This value must be 
the same as the value of the mid.nmap.npcap.version  property in the MID Server 
Property [ecc_agent_property] table.

g. $nmap_safe_scripts: List of safe scripts that Nmap uses. You can retrieve this 
list from the  mid.nmap.safe.scripts  property in the MID Server Property 
[ecc_agent_property] table.

6. Set up the parameters in the NmapInstallation.ps1  script in this order:
./NmapInstallations.ps1 $operation $nmap_root_path 
$nmap_self_installer $nmap_command $nmap_uninstall_command 
$nmap_npcap_version $nmap_safe_scripts

For example, the script might look like this:

PS 
 C:\MidServers\mid1\agent\scripts\PowerShell> .
\NmapInstallation.ps1 "install"
"C:\MidServers\mid1\agent\nmap" 
 "C:\MidServers\mid1\agent\nmap\nmapInstaller.exe"
"C:\MidServers\mid1\agent\nmap\nmap.exe"
"C:\MidServers\mid1\agent\nmap\Uninstall.exe" "0.91"
"allseeingeye-info.nse,amqp-info.nse,db2-das-info.nse,drda-info
.nse,freelancer-info.nse,
ike-version.nse,mcafee-epo-agent.nse,mqtt-subscribe.nse,openloo
kup-info.nse,oracle-tns-version.nse,
quake1-info.nse,quake3-info.nse,rfc868-time.nse,rpcinfo.nse,snm
p-info.nse,ventrilo-info.nse,
weblogic-t3-info.nse,xmpp-info.nse"

7. After installation is complete, add the Nmap  capability to each MID Server you want to use for 
credential-less Discovery.

Important: 
Only a maint  user can add the Nmap  capability to a MID Server. Contact Customer 
Service and Support  to request temporary maint  access to your instance.

a. On the instance, open the MID Server record.

b. Select the Capabilities  related list.

c. Click Edit.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2931



d. Select Nmap  from the list of available capabilities and click Save.

Uninstall Nmap on a self-hosted system

Use this procedure to uninstall Nmap in a self-hosted environment that does not allow network 
access to the ServiceNow install.service-now.com  download site.

Before you begin
Role required: admin, maint

About this task
Nmap must be manually uninstalled from each MID Server host machine and then disabled on 
the ServiceNow instance.

Procedure

1. Run Uninstall.exe  in the nmap  folder on each MID Server host configured for credential-
less Discovery.

2. After uninstallation is complete, delete the nmap  folder from the agent  folder.

3. Remove the Nmap  capability from each MID Server record.

Attention: 
Only a maint  user can remove the Nmap  capability from a MID Server. Contact Customer 
Service and Support  to request temporary maint  access to your instance.

a. On the instance, open the MID Server record.

b. Select the Capabilities  related list.

c. Click Edit.

d. Remove Nmap  from the active capabilities list and click Save.

Configure MID Server as WinRM trusted host

In environments using Windows Remote Management (WinRM), Discovery  or Service Mapping 
can discover servers using the WinRM protocol. Add servers, which are part of WinRM, as trusted 
hosts on all MID Servers  that Discovery  or Service Mapping  use for discovery.

Before you begin
Role required: mid_admin
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1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

About this task
MID Server  cannot access servers using the WinRM protocol unless these servers are 
configured as trusted hosts for this MID Server.

Perform this procedure on each MID Server  used by Service Mapping  or Discovery.

Procedure

1. On the MID Server, open the command-line shell.

2. To add all servers to the TrustedHosts lists, run the following command:
winrm s winrm/config/client '@{TrustedHosts="*"}'

3. To add specific servers to the TrustedHosts list, run the command with the comma-separated 
hosts instead of the asterisk (*), for example:
winrm s winrm/config/client 
'@{TrustedHosts="serverA,serverB,serverC"}'

MID Server domain separation

Use the MID Server user role to configure MID Servers to access separate domains. The 
credentials in the config.xml  file of a MID Server determine which domains it can access. 
Specific MID Server policy records can be restricted for use only by MID Server from the same 
domain.
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1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

The records that can be read, updated, or created by a MID Server are determined by the 
credentials configured for that MID Server in the config.xml  file. These are the user 
credentials that a MID Server uses to access the instance and specify which domain's records 
that MID Server can access.

You can create versions of these specific MID Server policy records that only a MID Server from 
the same domain can use. This process separation is supported for records in tables that extend 
MID Server Synchronized Files [ecc_agent_sync_file]:

• MID Server MIB File [ecc_agent_mib]

• MID Server JAR File [ecc_agent_jar]

• MID Server Script File [ecc_agent_script_files]

Note: 
Attachments on MIB or JAR file records might not appear as they did in a non-domain 
separated environment. The attachments do not appear because the Attachments 
[sys_attachment] table is data separated. When data is separated between domains, a 
record in a child domain cannot access records in a parent domain.

Set up domain separation for MID servers

Set up domain separation through the MID server user role and the MID Server configuration file.

Before you begin
Role required: agent_admin or admin

Procedure

1. Configure a MID Server user  within a specified domain with the proper mid_server  role.

2. Specify this user within the MID Server config.xml  file.
When you set the MID Server user credentials  in the config.xml  file, make sure they are in 
the proper domain.

What to do next
If you must change the MID Server domain:
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1. Stop the MID Server and delete the ecc_agent record.

2. Update the MID Server config.xml  with the new user in the new domain and restart the 
MID Server service.

If you need to create versions of specific MID Server files that only MID Servers in your domain 
can use:

1. Open or create a record in one of these MID Server modules:

◦ SNMP MIBs

◦ JAR Files

◦ Script Files

2. Update an existing domain policy or submit a new record.

Note: 
Attachments on MIB or JAR file records might not appear as they did in a non-domain 
separated environment. The attachments do not appear because the Attachments 
[sys_attachment] table is data separated. When data is separated between domains, a 
record in a child domain cannot access records in a parent domain.

Configure a multi-domain MID Server

You can create a MID Server in the global domain that can explore targets in other domains.

Before you begin
Before configuring a multi-domain MID Server:

• Activate the Domain Support - Domain Extensions Installer 
[com.glide.domain.msp_extensions.installer] plugin.

• Ensure that your instance is domain separated .

Role required: admin

Procedure

1. Type sys_properties.list  in the navigation filter and press Enter.

2. Locate the glide.ecc.enable_multidomain_mid  property.

3. Set the value of the property to true.

Note: 
Enabling this property has no effect on existing MID Servers. MID Servers in a domain 
prior to setting this property, remain in that domain.

4. Create a MID Server in the global domain.
A MID Server created in the global domain after this property is set to true  can explore any 
domain for which it has the credentials. However, this MID Server is restricted to trying only the 
credentials for the target domains requested by ECC Queue inputs.

Warning: 
If you reset the glide.ecc.enable_multidomain_mid  property to false  after creating 
a multi-domain MID Server in the global domain, that MID Server writes all the data it 
receives to the global domain and not to the correct domains.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2935

https://www.webstg.servicenow.com/docs/access?context=c_DomainSeparation&version=washingtondc&pubname=washingtondc-platform-security&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=c_DomainSeparation&version=washingtondc&pubname=washingtondc-platform-security&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=c_DomainSeparation&version=washingtondc&pubname=washingtondc-platform-security&ft:locale=en-US


Synchronize a JAR file to MID Servers

You can upload a JAR file to an instance and synchronize it to all MID Servers, or write custom 
probes that use the synchronized JAR file.

Before you begin
Role required: admin, agent_admin

1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

The MID Server JAR File [ecc_agent_jar] table is domain separated. You can create versions of 
these policies that only a MID Server from the same domain can use.  For instructions, see Set up 
domain separation for MID servers.

Warning: 
Synchronizing a JAR file with this procedure causes all MID Servers connected to the 
instance to restart automatically.

Procedure

1. Navigate to All  > MID Server  > JAR Files.

2. Click New.

3. Complete the following fields:

◦ Name:A unique and descriptive name for identifying the file in the instance.

◦ Version:  A version number for the file, if one is available.

◦ Source:  Location of the JAR file for reference purposes. Source information is not used by 
the system.

◦ Description:  Short description of the JAR file and its purpose in the instance.

4. Click the paper clip icon in the banner.

5. In the Attachments dialog box, click Browse  and select the file you want to attach.

The platform attaches the JAR file to the record and restarts the MID Servers to synchronize 
the file. It is not necessary to update the record to attach the file.
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vCenter event collector

The vCenter event collector is a MID Server extension that listens for vCenter-related events and 
updates the CMDB accordingly.

1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

The event collector allows the CMDB to be updated with changes to virtual machines (VMs), 
in addition to the updates detected by Discovery. A change to a VM is sent as an event from 
the vCenter server to the vCenter event collector. When an event is received, the CMDB is 
updated accordingly. Full vCenter Discovery does not need to rerun. For some events, such 
as powered on and powered off events, Discovery does not need to run again at all. For most 
events, Discovery runs only on the necessary vCenter resource.

For example, if a VM is turned off, the vCenter server sends the event VmPoweredOffEvent. 
The vCenter event collector receives and processes the event and the CMDB is updated to 
reflect that the state of the corresponding VM is set to off.

Important: 

With this extension, Discovery can only modify the state of a VM which exists in the CMDB. 
When an event with "CreatedEvent" occurs in its name, such as VmCreatedEvent, Discovery 
scans that VM and then creates the CI using the data it collects. When a new event occurs 
involving that CI, Discovery can update the existing record without launching another scan.

vCenter event collector supports domain separation  by inheriting the domain of the specified 
Mid Server in the event collector context. However, it does not support multi-domain Mid Server 
configuration.

See Discovery for VMware vCenter  for supported versions of vCenter.

How vCenter events are processed

The MID Server listens for the vCenter events configured in the vCenter Event Collector form. 
When one of these events is returned from vCenter, the instance parses the payload with a 
business rule that converts the vCenter event into a system event (sysevent). The instance then 
uses that sysevent to perform tasks, such as email notification.

Note: 
If the MID server is paused when a vCenter event occurs, the MID server still processes the 
event. In this case, it is possible for the event collector to display a status of Started.
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The resulting sysevents contain these values:

• Name: Name of the system event created from the vCenter event. This value is always 
automation.vcenter.

• Parm1: vCenter event that was returned. This event must be associated with an event collector 
record.

• Parm2: Event data provided by vCenter, in JSON format.

Log entries for vCenter events

Supported vCenter events

The following events are the only vCenter events handled by the base system when Discovery 
is activated. If you have upgraded your instance from an earlier version, you might not have the 
default events added with later releases. To use the missing events, manually add them.

vCenter events

Event name Description Launches probe

VM events

VmPoweredOnEvent The VM has been powered on 
from the powered off state or 
resumed from the suspended 
state. This event is sent when 
the VM is powered on. It does 
not account for the time it 
may take to boot the host 
operating system.

None

DrsVmPoweredOnEvent The VM has been powered 
on by a distributed resource 
schedule (DRS), which 
balances workload between 
available resources.

None

VmRestartedOnAlternateHostEventThe VM was restarted on 
another host because the 
original host failed.

None

VmPoweredOffEvent The VM has been powered off. 
If the host OS is shut down, 
this event is sent after the 
host OS shuts down and the 
VM enters the powered off 
state.

None
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vCenter events  (continued)

Event name Description Launches probe

VmPowerOffOnIsolationEvent The VM has been powered off 
on an isolated host in an HA 
cluster.

None

VmShutdownOnIsolationEvent The VM has been shut down 
on an isolated host in an HA 
cluster.

None

VmSuspendedEvent The VM is suspended. This 
event is sent after the VM 
suspension is complete.

None

VmRelocatedEvent The VM has been relocated 
while offline (either 
suspended or powered off). 
A VM migration of the VM to a 
different host, or the migration 
of any storage used by the 
VM triggers the event. Moves 
relationships.

None

VmMigratedEvent One or both of the following 
occurs:

• The VM has been hot-
migrated, with vMotion, to 
another ESX server.

• The storage for the VM has 
been hot migrated.

Only Updates relationship and 
Deep Discovery.

None

DrsVmMigratedEvent Migration of a VM 
recommended by a DRS. 
Moves relationships.

None

VmRemovedEvent The VM instance has been 
deleted from vCenter.

None

VmClonedEvent The VM was cloned 
successfully.

Creates new records and 
performs Quick Discovery.

VMWare - vCenter VMs

VmCreatedEvent The VM was successfully 
created.

Creates new records and 
performs Quick Discovery.

VMWare - vCenter VMs

VmDeployedEvent The VM was deployed 
successfully.

VMWare - vCenter VMs
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vCenter events  (continued)

Event name Description Launches probe

Creates new records and 
performs Quick Discovery.

VmDiscoveredEvent The vCenter successfully 
discovers the VM.

Creates new records and 
performs Quick Discovery.

VMWare - vCenter VMs

VmRegisteredEvent The VM was successfully 
registered.

Creates new records and 
performs Quick Discovery.

VMWare - vCenter VMs

VmReconfiguredEvent The VM was reconfigured.

Creates new records and 
performs Quick Discovery.

VMWare - vCenter VMs

VmInstanceUuidAssignedEvent A new instance UUID was 
assigned to the VM. Updates 
VM instance UUID.

None

VmRenamedEvent The VM was successfully 
renamed. Changes the name.

None

VmUuidAssignedEvent A new BIOS UUID was 
assigned to the VM. Adds the 
UUID of the VM.

None

VmMacAssignedEvent A new MAC address was 
assigned to the VM. Assigns 
MAC address to event and 
triggers VMware-VM nics 
probe.

VMWare - vCenter VM NICs

VmMacChangedEvent The MAC address of a VM 
was changed. Assigns MAC 
address to event and triggers 
VMware-VM nics probe.

VMWare - vCenter VM NICs

VmGuestShutdownEvent* The guest VM shut-down. None

VmStoppingEvent The VM stopped. None

VmResettingEvent The VM reset. None

Cluster events

ClusterCreatedEvent A cluster was created. VMWare - vCenter Clusters

ClusterReconfiguredEvent A cluster was reconfigured. VMWare - vCenter Clusters

ClusterDestroyedEvent A cluster was destroyed. None

Datastore events
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vCenter events  (continued)

Event name Description Launches probe

DatastoreRenamedEvent A datastore was renamed. None

VMFSDatastoreCreatedEvent A VM File System (VMFS) 
datastore was created.

VMWare - vCenter Datastores

DatastoreDiscoveredEvent A host was added to 
VirtualCenter and datastores 
were discovered.

VMWare - vCenter Datastores

NASDatastoreCreatedEvent An Network Attached Storage 
(NAS) datastore was created.

VMWare - vCenter Datastores

LocalDatastoreCreatedEvent A local datastore was created. VMWare - vCenter Datastores

VMFSDatastoreExpandedEvent A datastore was expanded. VMWare - vCenter Datastores

DatastoreDestroyedEvent A datastore was removed from 
VirtualCenter.

None

Network events

DVPortgroupCreatedEvent A port group was created. VMWare - vCenter Networks

DVPortgroupRenamedEvent A port group was renamed. None

DVPortgroupDestroyedEvent A port group was destroyed. None

Resourcepool events

ResourcePoolDestroyedEvent A resource pool was 
destroyed.

None

ResourcePoolCreatedEvent A resource pool was created. VMWare - vCenter Clusters

ResourcePoolMovedEvent A resource pool was moved. VMWare - vCenter Clusters

ResourcePoolReconfiguredEventA resource pool was 
reconfigured.

VMWare - vCenter Clusters

DVS events

DvsCreatedEvent A distributed virtual switch 
was created.

VMWare - vCenter Networks

DvsRenamedEvent A distributed virtual switch 
was renamed.

None

DvsDestroyedEvent A distributed virtual switch 
was destroyed.

None

Datacenter events

DatacenterCreatedEvent A datacenter was created. VMWare - vCenter 
Datacenters

DatacenterRenamedEvent A datacenter was renamed. None

Configure and run the vCenter event collector extension

Configure the vCenter event collector extension in the MID Server module, and then add or 
remove supported events.
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Before you begin
Before configuring event collectors, perform these tasks:

• Deploy and start a MID Server.

• Ensure that the MID Server has access to the vCenter.

• Run discovery on the vCenter.

Role required: agent_admin, admin

About this task
Multiple MID Servers  can listen to the same vCenter instance, and you can add multiple Event 
Collectors for different vCenters to a single MID Server. Make sure you configure the events on 
the event collector record that specify the correct MID Server.

Note: 
You can add events to the vCenter event collector. However, not every event is supported 
by the base system event handlers. If you want to handle events other than those 
supported in the base Discovery system, you must create a script action to process the 
events. For instructions, see Script actions . As a reference, the instance processes the 
vCenter events in the base system with a script action called Discovery: Process 
vCenter events. Do not edit or delete this script action.

To configure the vCenter event processor extension:

Procedure

1. Navigate to All  > MID Server  > Extensions  > vCenter Event Collectors.

2. Click New  or open an existing extension.

3. Fill in the fields, as appropriate from the table.

4. Right-click in the header bar and click Save  in the context menu.
The vCenter Event  related list appears, containing the default events that the system is 
configured to handle.

5. To select a different vCenter event, click Edit  in the vCenter Event  related list and browse for 
the event.

The slushbucket does not display all the available events in the opening list. Use the filter to 
browse for events not displayed.

6. Under Related Links  click Start  to save the events in this collection and start the collector.
The Related Links in this form work as follows:

Commands available in the vCenter event processor extension

Related Link Description

Start Starts the collector if it is not running. The extension connects to the specified 
vCenter server by enumerating the VMware credentials in the credential set 
until a connection can be made. Next, the extension tells the vCenter server to 
supply the events specified in the Collector Context.

Stop Stops the running collector on the configured MID Server. No action is taken if 
the extension is not running.

Restart Stops, then starts the collector on the configured MID Server.

Test Tests the parameters for validity. If the IP address, hostname, and the set of 
events is valid then the test returns a successful status. If any of the parameters 
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Related Link Description

are incorrect, an error is shown. Running a test does not affect any extensions 
that are currently running.

Update 
parameters

Sends updated parameters to the collector. Any changes you make to the 
collector while the MID Server is running do not take effect immediately when 
they are saved. If you click this control when the collector is not running, no 
update is made.

In the case of the vCenter extension, the collector first tests the parameters for 
validity. If the parameters are valid, the extension disconnects from the vCenter 
server and reconnects with the new parameters.

Field Description

Name
A unique name for this vCenter event 
collector extension for easy identification.

Short description
A description of this collector.

Extension
[Read-Only] The collector type is 
automatically set to vCenterExtension.

Status
This field auto-populates with the status 
of the collector. This field is blank until the 
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Field Description

collector is started. After issuing a command 
to the collector, you see one of these values:

◦ Started: The collector is running.

◦ Stopped: The collector is not running.

◦ Offline: The MID Server is down.

◦ Error: The collector failed with an error.

Note: 
The MID Server continues to process 
vCenter events, even if it is paused. The 
status of the event collector may show 
as Started.

Error Message
Message describing any error that causes 
a command, such as Start  or Stop, to fail. 
This field only appears when the value in the 
Status  field is Error.

Execute on
Location for running this collection. The 
possible options are Specific MID Server  or 
Specific MID Server Cluster.

MID Server
The name of the designated MID Server if 
you selected Specific MID Server  in the 
Execute on  field. The name of the designated 
MID Server cluster if you selected Specific 
MID Server Cluster. If you selected the 
MID Server cluster option, an algorithm 
determines which server in the cluster runs 
the collector.

vCenter
The IP address or hostname of the vCenter 
server.

Executing on
[Read-Only] The name of the MID Server 
on which the collector is running. This field 
shows the name of the MID Server even if 
the MID Server is down. If the collector is 
stopped by the user, this field is empty.

Related topics

VMware discovery

SNMP trap collector extension

The SNMP trap collector is a MID Server extension that listens for SNMP traps from the devices 
on your network.
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1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

Upon receiving a trap, the MID Server sends the trap to the instance for further processing 
by Event Management. If Event Management is not active, traps are not processed and are 
discarded by the instance.

For the SNMP trap collector extension to receive traps from network devices, each device must 
designate the MID Server that runs the SNMP trap collector extension as a recipient of the trap. 
See the documentation for the network device to configure your hardware to do this. Generally, 
the SNMP trap collector extension should run on only one MID Server per VLAN. Multiple MID 
Server recipients on the same VLAN causes duplicate data in the CMDB. If network devices are 
separated by VLANs, multiple MID Servers may have trap collectors installed.

To configure multiple SNMP trap collector extensions, configure each in a separate record, with a 
unique name, and a designated MID Server.

Configure the SNMP Trap Collector Extension

For the SNMP trap collector extension to receive traps from network devices, each device must 
designate the MID Server that runs the SNMP trap collector extension as a recipient of the trap.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > MID Server  > Extensions.  > MID SNMP Trap Listener

2. Click New  or open an existing extension.

3. Fill in the fields from the table, as appropriate.

4. Click Submit  or Update.
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Field name Description

Name
A unique name for this SNMP trap collector extension for easy identification.

Short 
description A description of the MID Server extension, if more description than the Name  is 

necessary.

Extension
[Read-Only] The extension type is automatically set to TrapExtension.

UDP port
The port number that your network hardware uses when sending a trap to the 
designated MID Server. Port numbers 1024 and above are recommended. Port 
numbers 1023 and lower may be system reserved and can result in access 
violations for MID Servers that are not running with administrative credentials.

Status
[Read-Only] The status of the trap collector extension. This field is blank until 
the extension is run. After it is run, the value may be:

◦ Started:  The extension is running.

◦ Stopped:  The extension is not running.

◦ Offline:  The MID Server is down.

◦ Error:  The extension failed with an error.

Execute on
The location for running this extension: a Specific MID Server  or a Specific 
MID Server Cluster. The recommended setting is Specific MID Server. Network 
hardware typically has to be configured to send to a specific IP address. If the 
listener moved to a different MID Server in the cluster, the trap would not be 
received.

MID Server
The name of the designated MID Server if you selected Specific MID Server 
in the Execute on  field. The name of the designated MID Server cluster if you 
selected Specific MID Server Cluster  in the Execute on  field. If you selected 
Specific MID Server Cluster, a ServiceNow algorithm determines which server 
in the cluster runs the extension.

Executing 
on [Read-Only] The name of the MID Server on which the extension is running. This 

field shows the name of the MID Server even if the MID Server is down. If the 
extension is stopped by the user, this field is empty.

5. In Related Links, run any of the following actions against the SNMP trap collector extension:

Related Link Description

Start Starts the extension if it is currently not running. The extension is started on the 
configured MID Server and port number.

Stop Stops the running extension on the configured MID Server. No action is taken if 
the extension is not running.
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Related Link Description

Restart Stops, then starts the extension on the configured MID Server and port number.

Test Verifies that the configured MID Server can run the SNMP trap collector 
extension on the specified port. Running a test does not affect any extensions 
that are currently running.

Update 
parameters

If you make changes to the extension configuration, use this option to update 
the parameters of the currently running extension. First, the parameters are 
tested for validity. If the parameters are valid, the extension disconnects and 
reconnects with the new parameters.

MID Server  Resource Reservation

This feature allows resources to be reserved before a task is assigned to a thread. If the 
resources the task needs aren’t available, then that task waits in the MID Server  work queue 
while other tasks are assigned to the thread.

1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

For Discovery, the MID Server  tasks are the probes or patterns it executes. While probes are 
waiting to be executed on the MID Server, they provide resource requirements (CPU, memory, 
and so on) and if they cannot be met, the probe waits in the work queue until the resources are 
available.

Note: 
MID Server  Resource Reservation delays probe execution until resources are available. 
This is based on extremely flexible criteria. The MID Server  Resource Reservation feature 
is for advanced users and should not be configured until a problem is identified. This 
configuration depends entirely on the problem details.

Using the MID Server  Resource Reservation allows for better use of threads since the threads are 
not assigned a task it cannot complete.

Features:

• Resource reservations apply to a single MID Server  only

• Resources can depend on system or MID Server  properties

• Resources can depend on probe parameters, allowing you to limit the number of active probes 
and patterns against a given IP
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• Reports resource usage

• Extensible (the customer defines their own resources)

• Scriptable

Benefits:

• Keeps PowerShell probes from impacting execution of other probes

• Can be used to limit the impact Discovery  has on a target system

• Can be used to limit the number of ”large” probes being executed by a MID Server  at the same 
time

• Can be used to throttle Discovery  (to minimize impact on the instance)

Use MID Server  Resource Reservation

A resource is just a name and a count. Define the name of the resource, which probes use it, and 
how many of the resources those probes should use.

Before you begin
Role required: admin

• Make sure the MID Server  property mid.probe.wait.resources  is set to true to enable MID 
Server  Resource Reservation. Changing this property requires restarting the MID Server.

• Choose a resource name. Anything in { } in the name is replaced by the probe parameter with 
that name. This name is typically used for per-host resources, for example, ssh{source} means 
a separate resource named “ssh” is available on every host being discovered. (“source” is the 
name of the probe parameter that contains the IP address being probed.)

• Decide how to specify the number of the resource used by probes or patterns.

◦ Every probe uses a constant number of the resource: Create a “simple value” resource.

◦ The number of resources used depends on a system property: Create an “expanding” 
resource.

◦ The number depends on multiple factors: Create a “scripted” resource.

◦ Expanding: Anything in { } is replaced by the system or MID Server 
property with that name. Logical operators are allowed, for example, 
"{mid.windows.management_protocol}".toLowerCase() == "winrm" ? 1:0

◦ Scripted: the script is evaluated. The return value is expanded.

Procedure

1. Create a new resource.

a. Navigate to Discovery Definition  > Limited Resources> Simple Value  and click New.

b. Enter a resource name.

c. Enter the number of resources used and click Save.

2. Define which probes use the resource.

3. Navigate to the desired tab and select from the list.
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◦ Used by Topic  tab: Includes all probes with that topic. Click Invert Topic  to include all probes 
without that topic. For example: SSHCommand with Invert Topic, means all probes except for 
SSH. Heartbeat and queue messages are always excluded.

◦ Used by probes  tab: Includes a list of probes. Click Invert Probes List  to include all probes 
without that probe. Horizontal Discovery probe means apply to all patterns.

◦ Used by patterns  tab: Includes a list of patterns. You can also click Invert Pattern list.

4. Define availability on the MID Server.

5. Navigate to Discovery Definition  > Limited Resources  > MID Resources.

◦ Resource: This is the reference to the resource.

◦ Available: Number available. Anything inside brackets, is replaced by the system or MID 
Server  property.

◦ MID Server: MID Server  to apply this to. (Empty) means all.

6. Set the resource order.

a. Click in the Order  field of each resource.

b. Type in the number.

c. Click the check mark to Save.

Note: 
Less valuable resources should have a lower order – these resources are reserved and 
held until higher order resources can be obtained. For example, both the total PowerShell 
sessions (resource is “PowerShell”) and the number of simultaneous sessions to any host 
(resource is “PowerShell{host}”) are limited. Therefore, PowerShell{host} resource should 
have a lower order. Obtaining PowerShell first would impact all other PowerShell probes. 
Obtaining “PowerShell{host}” first only impacts other PowerShell probes to that host.

7. Review the Resource State that you have set up.

a. Run a Discovery.

b. Observe Resource State.

c. Click Get resource state  from the MID Server  page or view in an ECC input payload.

Result of Get resource state:

▪ PowerShell{source} has additional entries for every {source} with a current allocation.

▪ “Reserved by” may show multiple resources if the probe requires more than one resource.

Result of ECC input payload:

▪ The resource_wait attribute only exists if the probe had to wait for a resource.

▪ The time displayed is in milliseconds.

▪ The probe may have waited on multiple resources, with different wait time for each.

How MID Server  Resource Reservation works

In addition to the work queue, the MID Server contains a waiting queue. When picking a task for 
execution, the waiting queue is always checked first. If no task in the waiting queue can execute, 
then the work queue is tried. Probes and patterns in the waiting queue reserve all necessary 
resources until they’re able to execute.
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The first probe or pattern in the queue is offered available resources. It takes any of the lowest 
order resource that is available. After getting the required number of lowest order resources, the 
probe or pattern goes to the next lowest order resources, and so on. The order allows the user to 
configure which resources are more or less important. Lowest order resources are gathered first 
because holding these resources has less impact on execution of other probes and patterns.

Tables

mid_limited_resource

• Defines the resources used by a probe or pattern.

• Extended by mid_limited_resource_value, mid_limited_resource_expanded, and 
mid_limited_resource_script each containing a single additional field.

◦ mid_limited_resource_value adds a single field named “value” to the base table.

◦ mid_limited_resource_expanding adds a field named “expanding.”

◦ mid_limited_resource_script adds a field named “script”.

mid_resource

• Sets the resources available on a MID Server.

• Values from this table are copied to ecc_agent_property.

• A business rule on this table creates the corresponding MID Server  properties.

• It has a reference to a resource and the number available. If the number available is inside { } 
then it’s the name of a system property, MID Server  config, or MID Server  property (all three 
places are checked). So {mid.powershell_api.session_pool.max_size} is the value of that MID 
Server  config that sets the size of the PowerShell session pool.

Base: mid_limited_resource table

Label Column Type Size Information

Resource Name name String 100 Unexpanded 
name of the 
resource

Active active Boolean Allows temporary 
disable

Invert Topic invert_topic Boolean

Invert Probe List invert_probe_list Boolean

Invert Pattern List invert_pattern_list Boolean

Note: 
There are m2m tables that associate a mid_limited_resource record with topics, probes, 
and patterns. The “invert_” fields change the list from inclusion to exclusion.

Extensions: mid_limited_resource_value, mid_limited_resource_expanding, and 
mid_limited_resource_script tables

Label Column Type Size Information

Value value Integer
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Extensions: mid_limited_resource_value, mid_limited_resource_expanding, and 
mid_limited_resource_script tables  (continued)

Label Column Type Size Information

Expanding expanding String 1000 A slightly 
extended version 
of the availability 
number because 
it accepts logical 
and ternary 
operations, 
for example, 
"{mid.windows.management_protocol}" 
== "WinRM" ? 
1 : 0. If the 
management 
protocol is 
WinRM this 
evaluates to 1, 
otherwise it’s 0.

Script script String 4000 The script is 
evaluated. If 
the result is a 
string, then it’s 
expanded

mid_resource table

Label Column Type Size Information

Active active Boolean Allows temporary 
disable

Available available String 255 Number of 
this resource 
available on MID 
Server

MID Server ecc_egent Reference Reference to MID 
Server  or empty 
for all

Order order Integer Order in which 
resources are 
allocated

Resource resource Reference Reference to the 
resource

Containerized MID Server

Containerized MID Server uses a Docker image of the MID Server that allows you to quickly 
deploy MID Servers at scale. MID Servers are deployed using orchestration tools like OpenShift 
or Kubernetes. Orchestration tools can automate their deployment and maintenance and add 
new containers on demand or replace failed containers automatically.
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1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

To use Containerized MID Servers, you can download Docker recipes for Linux from the MID 
Server download page. Use the recipes to build the Docker images for the current release. The 
recipes are zipped and signed. Some features have been deprecated for the Washington DC 
family release. See [KB1559617] Deprecated Containerized MID Server Features in Washington 
DC  for more information.

Containerized MID Server system requirements:

• AlmaLinux is supported.

• The recipes cannot be used to build images for previous MID Server versions.

• Discovery of NMAP and CyberArk are not supported.

• Other applications such as Orchestration and Integration Hub are not certified.

Once the Docker images are available, you can create new MID Server containers and configure 
them with configuration parameters passed through environment variables or secret files. 
Docker, Openshift, and Kubernetes secrets are supported. The MID Server application inside the 
container is run as a process by a non-admin user.

When a containerized MID Server record is first created on the instance, a random UUID is 
created and set to the container_id  column. During the start-up sequence, this value is replaced 
by the actual container ID. The container ID can be used to differentiate between containerized 
and regular MID Servers. Non-containerized MID Servers' container ID have a null or empty 
value.

In order to automatically clean up the down MID Servers on Instance, a scheduled job called 
Purge Orphaned Containerized MID Servers is scheduled to run daily. This job removes 
orphaned containerized MID Servers if they are down longer than the value set by the 
max_retention_days  property. The job also creates a warning MID Server issue each day before 
the removal day, if there are equal to or less than the value of warn_days  remaining. The default 
values for max_retention_days  and warn_days  are 30 and 7, respectively.
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Auto-upgrade

Auto-upgrade works the same way for containerized MID Servers as it does for regular MID 
Servers. However, it is recommended to disable the auto-upgrade for containerized MID Servers. 
Whenever a new image is needed, build a new image and deploy it by updating the deployment 
YAML file then re-apply it.

Containerized MID Server auto-upgrade is controlled by the 
mid.container.autoupgrade.enabled  config parameter and is set to true by default. The config 
parameter is read-only, therefore it can not be synced down from the instance.

Add the config parameter to a MID Server profile and use it with new deployment requests. The 
settings are then included in deployment YAML file when the deployment request is exported, or 
when it is manually added to an existing deployment YAML file and re-applied.

HealthCheck

A HEALTHCHECK rule is implemented to check MID Server health status based on heartbeat 
every 5 minutes. If there was no heartbeat activity in last 30 minutes, it is considered a failure. 
After 3 consecutive failures, it becomes unhealthy in the docker ps command output.

To see more HealthCheck details, run the following docker inspection command : docker 
inspect --format='{{json .State.Health}}' <container-id>

Basic Container Operations

Basic operations are supported on container side. For example, you can stop, start, or restart a 
running container using Docker commands.

docker stop <container_id>

This command shuts down the containerized MID Server.

docker start <container_id>

This command starts a containerized MID Server if it is stopped.

docker restart <container_id>

This command shuts down a MID Server and restarts it.

Build MID Server Docker Image

Build a MID Server Docker Image  with the provided recipes to deploy a Containerized MID 
Server. Containerized MID Server uses a Docker image of the MID Server that allows you to 
quickly deploy MID Servers at scale.

Containerized MID Server Deployment and Auto-configuration

With the deployment and auto-configuration feature, an agent admin can enter all required MID 
Server  settings in a MID Server Profile on the instance and then submit a deployment request 
to K8s cluster. After the request is  processed, the new MID servers are automatically created 
and auto-configured. They are ready  to use in seconds.  If the MID Server profile is changed, 
the related Containerized MID Servers can also be updated on demand.

Build MID Server Docker Image for Linux

Deploy Containerized MID Servers on Linux by creating a Docker image with the provided 
recipes. Containerized MID Server uses a Docker image of the MID Server that allows you to 
quickly deploy MID Servers at scale.
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Before you begin
Role required: admin

1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

Prerequisites:

The host must use Docker engine and command-line interface (CLI) 20.10.4 or later .

Update the library to the newest version available, or at least the highest version with a security 
fix. If issues identified are part of a transitive dependency, find a version of the dependent library 
which includes a newer transitive version. If the transitive dependency cannot be upgraded by 
upgrading the dependent library, consider excluding the dependency and directly including a 
secure version.

Note: 
Check docker availability by running the docker version command as administrator. See the 
the docker version command documentation  for more information.

Procedure

1. Download the Linux Docker recipe ZIP file from the MID Server download page and verify its 
signature.
For more information about the MID Server download page and signature verification, see 
Download MID Server files.

2. Unzip the ZIP file to a folder.

3. Optional:  You can change the current directory to the new folder.

4. To build an image, run the build command: > docker build <path-to-docker-
recipe> [ --tag <docker-tag> ]

For more information on the command, see the Docker build command documentation . The 
path to the Docker file can be a relative path or the current directory if the file is in the Docker 
recipe directory.

The default image tag is provided out-of-the box in the .env file with the DOCKER_TAG 
parameter. You can export this parameter before executing any docker command by running 
the command: > export $(grep DOCKER_TAG .env). You can replace <docker-
tag>  with the DOCKER_TAG  value in all the following commands.

The build command takes the following build arguments:
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Property Description

MID_INSTALLATION_URL The link to download the MID Server 
installation file. By default, it is set to the 
download link for the Linux 64 bit Installation 
ZIP file provided on the MID Server  download 
page.

MID_INSTALLATION_FILE The name of a local MID Server  installation 
file. The default value is empty. If this 
parameter is not empty, the recipe uses the 
local file instead of downloading from the 
installation server. This parameter uses the 
file name only, not the full path. Before the 
build, the local file must be copied to the 
asset/  sub-folder of the recipe directory. 
MID Server  releases prior to Rome  are not 
supported.

For example: > docker build <path-
to-dockerfile> --build-arg 
MID_INSTALLATION_FILE=<mid.installation.file.name>) 
--tag <docker-tag>

MID_SIGNATURE_VERIFICATION The signature of the MID Server  installation 
file must be verified. The default value is 
TRUE. If it is TRUE, the build process always 
verifies the digital signature of the MID Server 
installation file whether it is downloaded from 
the remote server or a local file. Otherwise, 
the signature verification is skipped.

For example: > docker build <path-
to-dockerfile> --build-arg 
MID_SIGNATURE_VERIFICATION=false 
--tag <docker-tag>

USER_ID and GROUP_ID
By default, when not specified, Docker 
creates a   MID Server  user with user id = 
1001 and group id = 1001. You may pass a 
custom user id and group id into container by 
using the USER_ID and GROUP_ID build 
arguments. Docker creates an user for the
  MID Server   with the provided user id and 
group id. Inside the container image, all files 
under the MID Server  installation folder are 
owned by this user and the root group (id=0).

When the image is deployed on Kubernetes 
platform, this MID Server  user becomes the 
container user who runs the MID Server.

When the image is deployed on an 
OpenShift platform, OpenShift may assign 
an arbitrary non-admin user id as the 
container user who runs the MID Server. 
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Property Description

However, that user always belongs to the root 
group.

In both cases, the container user has full 
access to the MID Server  files. That way, the 
same image can be deployed on Kubernetes 
as well as on OpenShift.

5. Optional:  After the image is built successfully, you can list the image built with command: > 
docker image ls

What to do next
To save disk space, if there are unused or intermediate images, run the following commands to 
remove those dangling images:

$ docker rmi $(docker images --filter "dangling=true" -q 
 --no-trunc)

For example, before removing dangling images, the command docker image ls  may show 
something similar to the following:

REPOSITORY                                TAG                   
                        IMAGE ID       CREATED              SIZE
mid                                      
 trackdiscocopper-10-09-2020_10-14-2021_2200   4542b6ab34af   21 
 seconds ago       1.01GB
<none>                                    <none>             
                           1cdae087a970   About a minute ago  
 1.38GB

After removing the dangling images, the command docker image ls  shows the following:

REPOSITORY                                TAG                   
                        IMAGE ID       CREATED              SIZE
mid                                      
 trackdiscocopper-10-09-2020_10-14-2021_2200   4542b6ab34af  
 About a minute ago   1.01GB

Launch Containerized MID Server

Containerized MID Server uses a Docker image of the MID Server that allows you to quickly 
deploy MID Servers at scale. MID Servers are deployed using orchestration tools like Docker 
Swarm.

Before you begin
Role required: admin

Prerequisites:
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• Linux hosts must use AlmaLinux distribution 64 bit architecture, and AlmaLinux distro is 
recommended.

• The host must use Docker engine and command-line interface (CLI) 20.10.4 or later .

Note: 
Check docker availability by running the docker version command as administrator. See 
the the docker version command documentation  for more information.

Procedure

1. Once the image is available, launch the new MID Server using the docker run command 
and specify an env file or env variable options: docker run --env-file 
<env_file_name_here> <docker_tag or image_id>

Note: 
Do not pass sensitive data using this command, as there may be security vulnerabilities. 
To pass sensitive data, use the procedures Pass sensitive data to a containerized MID 
Server with Docker Secrets  and Pass sensitive data to a containerized MID Server with 
Kubernetes Secrets.

For more information, see the Docker documentation pages for the docker image ls 
command , the docker run command , and specifying an env file or env variable options . 
The env file is a simple text file using the name=value format. If a variable is specified in both 
env file and in the --env  option, the variable defined in the command line takes precedence.

While deployment requests are the recommended method to launch containerized MID 
Servers, they can be alternatively configured with environmental variables. When the container 
is first started, the initialization script will take the environment variables and configure the MID 
Server application using the following environment variables:

MID_INSTANCE_URL

This variable sets the ‘url’ config parameter.

MID_INSTANCE_USERNAME

This variable sets the ‘mid.instance.username’ config parameter.

MID_INSTANCE_PASSWORD

This variable sets the ‘mid.instance.password’ config parameter.

MID_SERVER_NAME

This variable sets the ‘name’ config parameter.

MID_PROXY_HOST

This variable sets the ‘mid.proxy.host’ config parameter. This variable is not 
mandatory and is only necessary when a proxy is set up.

MID_PROXY_PORT

This variable sets the ‘mid.proxy.port’ config parameter.

MID_PROXY_USERNAME

This variable sets the ‘mid.proxy.username’ config parameter.

MID_PROXY_PASSWORD

This variable sets the ‘mid.proxy.password’ config parameter.

MID_SECRETS_FILE
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This variable specifies the full secret filename that contains sensitive data like 
passwords or certificate.

MID_MUTUAL_AUTH_PEM_FILE

This variable specifies the full filename of the client certificate file used for auto 
validation setup.

2. Optional:  To see a list of containers, run the docker container ls command: docker 
container ls [-a]

Pass sensitive data to a containerized MID Server with Docker Secrets

You can configure containerized MID Servers with configuration parameters passed through 
environment variables or secret files.

Before you begin
Role required: Docker Swarm admin

About this task
You can pass sensitive data, such passwords or certificates, into a containerized MID Server 
using Docker Secret . Setup and start Docker Swarm  before using this procedure.

When creating deployments, ensure that the replicas are kept to 1.

Procedure

1. Place the sensitive data in mid-secrets.properties

2. Create a docker secret using the docker secret create command: docker secret create 
mid-secrets mid-secrets.properties

The first mid-secrets  represents the secret in docker swarm, while the second mid-
secrets.properties  parameter represents the file path to read the secret on the host 
machine’s filesystem. You can list all created secrets by running the command docker 
secret ls.

For more information on the docker secret command, see the docker secret documentation .

3. Update the MID_SECRETS_FILE  environment variable with the path to the secret file inside 
the container.
The default path for Docker Swarm secrets on Linux is /run/secrets/mid-
secrets.properties.

4. Deploy the MID Server Image Container to Swarm using the docker service create 
command: docker service create --name mid-service --secret mid-
secrets.properties --env-file mid.env <docker-tag or image-id>

Make sure that the --secret flag  is provided for the container service to associate with 
the specified secrets.

Pass sensitive data to a mutual authenticated containerized MID Server with Docker Secrets

You can configure containerized MID Servers with configuration parameters passed through 
environment variables or secret files.

Before you begin
Role required: admin

Role required: Docker Swarm admin
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About this task
If certificate based authentication  is enabled on the instance, the MID Server can be 
configured to auto-validate using a mutual authentication client certificate  (PEM file). This 
can be done via setting the full path to the PEM certificate file inside container with the 
MID_MUTUAL_AUTH_PEM_FILE  environment variable. For example, you can update variable 
to MID_MUTUAL_AUTH_PEM_FILE= /run/secrets/certificate.pem  in the 
mid.env  file.

You can pass the PEM certificate file into a container using Docker or Kubernetes secret. The 
following is an example command to pass the PEM certificate file into a container: docker 
service create --name mid-service --secret mid-secrets.properties 
--secret <certificate-secret-name> --env-file mid.env <docker-tag 
or image-id>

The mutual PEM certificate is installed on the MID Server during initialization. MID Server then 
connects to the instance and auto-validates. When the MID Server connects to the instance with 
mutual authentication successfully enabled, you might observe some of the following entries in 
the MID agent log:

• Installed custom certificate into the MID keystore

• Configured MID to use mutual authentication

Procedure

1. Prepare the mutual authentication PEM bundle.

2. Create a docker secret using the docker secret create command: docker secret create 
mutual-auth-secret <mutual-auth-pem-file-on-local-filesystem> .

You can list all created secrets by running the command docker secret ls.

3. Update the MID_MUTUAL_AUTH_PEM_FILE  environment variable with the path to the secret 
file inside the container.

The default path for Docker Swarm secrets on Linux is /run/secrets/<mutual-auth-
pem-file-name>.

4. Deploy the MID Server Image Container to Swarm using the docker service create command: 
docker service create --name mid-service --secret mutual-auth-
secret --env-file mid.env <docker-tag or image-id>

Ensure the --secret  flag is provided for the container service to associate with the specified 
secrets.

5. Deploy the containerized MID Server to the pod with the deployment.yml  and run the 
command: kubectl create -f deployment.yml

Pass sensitive data to a containerized MID Server with Kubernetes Secrets

You can configure containerized MID Servers with configuration parameters passed through 
environment variables or secret files.

Before you begin
Role required: Kubernetest admin

Setup and start Kubernertes cluster  before using this procedure. For more information on 
Kubernetes Secrets, see the Kubernertes secrets documentation .
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Note: 
Kubernetes doesn’t work directly with a local image. Upload the MID Server image to a 
public registry or setup a local registry. See the official Docker instruction  on building a 
docker registry.

When creating deployments, ensure that the replicas are kept to 1.

Procedure

1. Place the sensitive data in mid-secrets.properties accordingly.

2. Create a Kubernetes secret with the command: kubectl create secret generic 
mid-secret --from-file=mid-secrets.properties

3. Optional:  You can list all created secrets by running the command: kubectl get 
secrets

4. Update the MID_SECRETS_FILE  environment variable with the path to the secret file inside 
container.
The path is defined in data field when creating a configuration file for a Secret .

5. Create a deployment with the following sample YML content:

apiVersion: apps/v1
kind: Deployment
metadata:
  name: basic-example
spec:
  selector:
    matchLabels:
      app: MIDServerManagement
      provider: ServiceNow
  replicas: 1
  template:
    metadata:
      labels:
        app: MIDServerManagement
        provider: ServiceNow
    spec:
      containers:
        - name: basic-example-container
          imagePullPolicy: IfNotPresent
          image: "mid:imageTag"
          env:
            - name: MID_INSTANCE_URL
              value: " 
 https://exampleinstance.service-now.com/"
            - name: MID_INSTANCE_USERNAME
              value: "mid_server_user_name”
            - name: MID_SECRETS_FILE
              value: 
 "/opt/snc_mid_server/secrets/mid-secrets.properties“
            - name: MID_SERVER_NAME
              value: "Basic-Example-MID"
          volumeMounts:
            - mountPath: "/opt/snc_mid_server/secrets"
              name: "mid-mount-secret"
              readOnly: true
      volumes:
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      - name: "mid-mount-secret"
        secret:
          secretName: "mid-secret"

Note: 
There are many ways to create a deployment or pod. For more information, see the 
Kubernetes deployment instructions .  

6. Deploy the containerized MID Server to the pod with the deployment.yml and run the 
command: kubectl create -f deployment.yml

Pass sensitive data to a mutual authenticated containerized MID Server with Kubernetes 
Secrets

You can configure containerized MID Servers with configuration parameters passed through 
environment variables or secret files.

Before you begin
Role required: Kubernetest admin

Prerequisites:

If certificate based authentication  is enabled on the instance, the MID Server can be 
configured to auto-validate using a mutual authentication client certificate  (PEM file). This 
can be done via setting the full path to the PEM certificate file inside container with the 
MID_MUTUAL_AUTH_PEM_FILE  environment variable. You can pass the PEM certificate file 
into a container using Kubernetes secret.

The mutual PEM certificate is installed on the MID Server during initialization. MID Server then 
connects to the instance and auto-validates. When the MID Server connects to the instance with 
mutual authentication successfully enabled, you might observe some of the following entries in 
the MID agent log:

• Installed custom certificate into the MID keystore

• Configured MID to use mutual authentication

Procedure

1. Prepare the mutual authentication PEM bundle.

2. Create a Kubernetes secret with the command: kubectl create secret generic 
mutual-auth-secret --from-file=<mutual-auth-pem-file>

3. Optional:  You can check all created secrets by running the command: kubectl get 
secrets

4. Update the MID_MUTUAL_AUTH_PEM_FILE  environment variable with the path to the secret 
file inside container.

5. Create a deployment with the following sample YML content:

6. apiVersion: apps/v1
7. kind: Deployment
8. metadata:
9.   name: mutual-auth-example
10. spec:
11.   selector:
12.     matchLabels:
13.       app: MIDServerManagement
14.       provider: ServiceNow
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15.   replicas: 1
16.   template:
17.     metadata:
18.       labels:
19.         app: MIDServerManagement
20.         provider: ServiceNow
21.     spec:
22.       containers:
23.         - name: mutual-auth -container
24.           imagePullPolicy: IfNotPresent
25.           image: "mid:imageTag”
26.           env:
27.             - name: MID_INSTANCE_URL
28.               value: 
 "https://exampleinstance.service-now.com/"
29.             - name: MID_INSTANCE_USERNAME
30.               value: "mid_server_user_name”
31.             - name: MID_SERVER_NAME
32.               value: "Mutual-Auth-Deployment-MID"
33.             - name: MID_MUTUAL_AUTH_PEM_FILE
34.               value: 
 "/opt/snc_mid_server/mutual-auth/yourpemfile.pem"
35.           volumeMounts:
36.             - mountPath: "/opt/snc_mid_server/mutual-auth"
37.               name: "mid-mount-mutual-auth"
38.               readOnly: true
39.       volumes:
40.       - name: "mid-mount-mutual-auth"
41.         secret:
42.           secretName: "mid-mutual-auth-secret"

6. Deploy the containerized MID Server to the pod with the deployment.yml  and run the 
command: kubectl create -f deployment.yml

Containerized MID Server Deployment and Auto-configuration

An agent admin can enter a MID Server Profile and create a deployment request on the instance. 
She/he can then export the deployment request to a YAML file and use it to deploy MID Servers 
to Kubernetes or OpenShift cluster.
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1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

Containerized MID Servers use a Docker image of the MID Server that allows you to quickly 
deploy MID Servers. The documentation for Build MID Server Docker Image for Linux  provides 
steps for manually preparation and deployment. The following Containerized MID Server auto-
configuration simplifies the process and makes it scalable.

MID Server profile

A MID Server profile contains all the settings required to configure a new MID Server, excluding 
sensitive data such as passwords and certificates. Sensitive data should be passed through 
Secrets created on the K8s cluster. The user only enters secret names and locations in the 
deployment request. An agent_admin  role is required to create or change profiles. MID Server 
profiles are stored in the following tables:

• mid_server_profile

• mid_profile_config

• mid_profile_wrapper_config

• mid_profile_property

• mid_profile_application_m2m

• mid_profile_capability_m2m

• mid_profile_ip_range_m2m

• mid_profile_cluster_m2m

During deployment, the mid_profile_config  and mid_profile_wrapper_config  parameters 
are sent to the K8s cluster. These parameters populate the config.xml  and wrapper-
override.conf  of the new MID Server. The other parameters are used by the auto-
configuration on the instance. The user can access the MID Server profile from the module MID 
Server Profiles  on the instance.

The MID Server name is not required in a profile because a profile can be used to deploy multiple 
MID Servers. Instead, the user is asked to enter MID Server names as part of a new deployment 
request. For the mid_profile_wrapper_config, the user can enter any parameters that they want 
to see in wrapper-override.conf. For example:

Name Value
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wrapper.java.maxmemory 2048

wrapper.java.additional.3 -Djavax.net.debug=ssl:handshake

Other profile settings can be entered the same way as on a MID Server record.

MID Server Deployment Request

After creating a MID server profile, the user can make a new deployment request to prepare the 
deployment process. A deployment request can be different for different container orchestrators. 
See MID Server Deployment Request  for more information.

Export MID Deployment Request for Manual Deployment

The user can export it to a K8s deployment YAML file. The user can download the YAML file to the 
K8s cluster and deploy new MID Servers with the following command: kubectl apply –f 
<yaml_file>

Docker image preparation

To prepare a Docker image, first build a MID Server image on a K8s cluster as explained in Build 
MID Server Docker Image. Upload the built image to an image registry and pull the image to a 
local image with the command: docker pull registry/mid:<tag>. Refer to Docker 
Registry Setup for Containerized MID Server II: Auto Configuration [KB1001380]  for information 
on limitations on pulling an image directly from a remote registry.

Kubernetes preparation

See also How to build and deploy Containerized MID Servers in Kubernetes using StatefulSets 
[KB1325173] .

Kubernetes service account setup

Ensure the service account has the proper RBAC set up to create, delete, and list permission for 
resources. The following example YAML file uses the default service account:

apiVersion: rbac.authorization.k8s.io/v1
 kind: ClusterRoleBinding
 metadata:
    name: default-service-acccount-as-cluster-admin
 subjects:
 
  - kind: ServiceAccount
      Reference to upper's `metadata.name`
    name: default
      Reference to upper's `metadata.namespace`
    namespace: default
 roleRef:
    kind: ClusterRole
    name: cluster-admin
    apiGroup: rbac.authorization.k8s.io

You may choose a custom service account and assign a ClusterRole  to that service account and 
name space. The default name space is default. The following example YAML file uses a custom 
name space, mynamespace.

apiVersion: rbac.authorization.k8s.io/v1
 kind: ClusterRoleBinding
 metadata:

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2964

https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB1001380
https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB1001380
https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB1001380
https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB1001380
https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB1325173
https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB1325173
https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB1325173
https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB1325173


    name: custom-serviceacccount-as-cluster-admin
 subjects:
 
  - kind: ServiceAccount
      Reference to upper's `metadata.name`
    name: mycustomserviceaccount
      Reference to upper's `metadata.namespace`
    namespace: mynamespace
 roleRef:
    kind: ClusterRole
    name: cluster-admin
    apiGroup: rbac.authorization.k8s.io

Kubernetes Secret setup

Secrets are created for mid-secrets.properties  or PEM files for mutual authentication. For more 
information about how to create a Secret, see the section in Containerized MID Server.

Auto-configure new Containerized MID Servers

When a MID server is connected to the instance for the first time, a MID Server record is created. 
The MID Server record is populated with the container ID, profile ID and deployment name. The 
Auto-Configure MID from profile  business rule is triggered when the new MID Server record is 
updated with a profile ID in the profile_id  field. The business rule looks up the profile settings 
associated with that profile ID and configures the new MID server accordingly.

Sync MID Server Profile to existing MID Servers

The MID Server profile can be out-of-sync with the settings of existing MID Servers if the user 
updates the profile long after the related MID Servers were auto-configured. The user can 
synchronize the profile settings to the existing MID Server by selecting Sync to MID Servers  on 
the instance.

MID Server Deployment Request

After creating a MID server profile, the user can make a new deployment request to prepare the 
deployment process. A deployment request can be different for different container orchestrators.

Before you begin
Role required: agent_admin
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About this task
The user can access MID Server deployment request from the app module MID Deployment 
Requests.​

Currently, only K8s deployment is supported. The K8s deployment request includes a reference 
to a MID Server profile, information about a MID Server docker image, K8s secrets, K8s 
deployment labels, and a list of MID Server names to assign to the new MID Servers.

Procedure

1. Enter information about the container image.

In this section, you will specify which image is used with this deployment request and where it 
can be pulled from.

Image Registry Path and Repository

Enter a registry address and port, as well as a repository name where the image is 
stored. The syntax is my.registry.address:port/repositoryname.

Image Tag

Enter a tag that identifies the container image.

2. Specify the MID Server names.

A deployment request can be made to create multiple MID Servers. You can choose to enter 
the MID Server names manually, otherwise the system automatically generates them. If you 
enter the names manually, each MID Server name must be unique.

3. Enter the Kubernetes cluster Information.

K8s Namespace

Enter a K8s namespace where the new MID servers are located. The default value 
is default.

K8s Service Account

Enter a K8s service account name that processes this deployment request. The 
default value is default.
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MID Secrets Name

Enter the name of a K8s secrets object that holds MID Server secrets.

MID Secrets File Path

Enter the absolute path of the MID Server secrets file inside the container.

MID Mutual Auth PEM Secrets Name

Enter the name of a K8s secrets object that holds the MID Mutual Auth PEM 
certificate.

MID Mutual Auth PEM File Path

Enter the absolute path of the MID Mutual Auth PEM file inside container.

K8s Deployment Label

Enter a deployment label which is a list of key/value pairs. The label is attached 
to K8s deployment. A valid label must be 63 characters or less and can be empty. 
Unless the label is empty, it must begin and end with an alphanumeric character 
and contain only dashes, underscores, dots, and alphanumeric characters.

What to do next
When a request is ready, the user can choose Export to YAML file  to generate a K8s deployment 
YAML file and attach it to the same record. Once a request is processed, the entire record is set 
to read-only. There is a scheduled job that removes deployment requests older than 365 days.

Containerized MID Server Autoscaling

MID Servers can be deployed via StatefulSet with any number of replicas. They can scale 
automatically by leveraging Kubernetes Horizontal Pod Autoscaler (HPA). Horizontal Pod 
Autoscaler automatically updates a workload resource (such as a Deployment or StatefulSet) to 
match demand.
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Kubernetes can add or remove any numbers of stateful MID Server replicas as required by 
the workload. HPA only supports CPU and memory metrics. MID Servers can be deployed as 
a stateful application by providing the following information in the StatefulSet section of the 
deployment request form:
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• Name

• Headless service name

• Persistent volume claim (PVC)

• Parameters, such as storage class, access modes, and storage request

• The resource request/limit

The PVC declares the desired persistent volume where the MID Server stores config.xml, meta 
data files, and several of its sub-folders.

During workload fluctuations, a pod with a running MID Server container can be removed and 
replaced by a new one. StatefulSet ensures the same persistent volume is attached to the new 
pod, which allows the MID Server to resume its state.

The only sub-folders that can be mounted to the persistent volume are those that are initially 
empty with a new MID Server installation. The config.xml  file and other meta data files must be 
backed up when the pod is shut down and restored during start-up.

Deployment requests exported as YAML files can be used to create a StatefulSet workload and 
new MID Server pods in the Kubernetes cluster.

When you make changes to the deployment YAML file and re-apply it, the existing pods of the 
deployment are recreated. With StatefulSet deployment, the configuration files are restored from 
the backup folder. The init script must detect the deployment environment changes and apply 
them to the configuration files before MID server is started.

HPA Autoscaling activation

HPA Autoscaling can be activated for any existing StatefulSet workload by creating an HPA 
controller.

When you create a deployment request, you can choose either HPA version 1 or version 2.

When creating a deployment request on the instance with an HPA configuration, apply the 
exported YAML file and HPA autoscaling begins working immediately.

Containerized MID Server Properties and Parameters

Containerized MID Servers have several properties and parameters unique to their features.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2968



1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

Glide Properties

mid.container.deployment.volume_mount.subpaths

• Type: String

• Default value: mid_container,agent/extlib,agent/logs,agent/scripts,agent/
security, agent/security_backup,agent/work

Specifies a comma-separated list of persistent volume mount sub-paths.

mid.container.deployment.headless_service_yaml_included

• Type: True | False

• Default value: True

Specifies if the Headless Service Resource is included in the exported YAML file.

MID Server configuration parameters

mid.drain.timeout

• Type: Integer

• Default value: 900

Specifies the timeout in seconds for the drain operation.

mid.drain.run_before_container_termination

• Type: Boolean

• Default value: true

Specifies if the containerized MID Server is drained before container termination.

mid.container.autoupgrade.enabled

• Type: True | False

• Default value: True
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Controls the containerized MID Server auto-upgrade feature. The config parameter 
is read-only, therefore it can not be synced down from the instance.

Configure a MID Server for IPv6

A MID Server  configured for IPv6 can connect to ServiceNow  and use Discovery  over IPv6 for 
specific addresses.

Before you begin
Role required: admin

1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

About this task
A pure IPv6 MID Server  does not need to be configured for IPv6. It connects to IPv6 by default, 
and the ecc_agent  record for the MID Server is automatically populated with IPv6. Contact 
Support to ensure your instance is IPv6 enabled.

On a dual stack host, the MID Server  defaults to using IPv4. The following procedure configures 
a dual stack MID Server  to use IPv6. The following tables are automatically updated during 
upgrade to Tokyo to support IPv4 and IPv6:

• ecc_agent

• ecc_agent_router

• ecc_agent_ip_address

• ecc_agent_command_audit_log

When using Discovery  over IPv6, the following requirements apply:

Windows Discovery

Only WinRM is supported as of the Washington DC  release. The requirements for 
WinRM over IPv6 are the same as IPv4. WinRM must be running on both the MID 
Server  host and target, and the target must be configured as a trusted host on that 
MID Server.

Unix Discovery

Only SNC SSH is supported as of the Washington DC  release. No additional 
configuration is needed to use SNC SSH over IPv6. J2SSH and Maverick are not 
supported but, if their protocols are used over IPv6, the command is executed 
without guaranteeing the correct results. In that case, the following error message is 
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reported in the MID Server logs: IPv6 is currently not supported for 
MID Server using Maverick (J2SSH), however the command 
will be executed.

Procedure

1. Navigate to the Java VM configuration wrapper in agent/conf/
wrapper.override.conf.

2. Open the file, then uncomment and change the following line of code to true:

 wrapper.java.additional.109=-Djava.net.preferIPv6Addresses=fa
lse

Change the previous line to read as follows:

wrapper.java.additional.109=-Djava.net.preferIPv6Addresses=true

3. Restart the MID Server.
The MID Server  is now configured to connect to the instance over IPv6.

Note: 
For dual stack MID Servers, changing the wrapper does not affect the data populated in 
the ecc_agent  record, which is IPv4 by default.

4. To update the ecc_agent  record to prefer IPv6 over IPv4, specify the following MID Server 
configuration parameter and set it to true: mid.prefer_ipv6_addresses.

5. Restart the MID Server.
The dual stack MID Server  populates the relevant fields in the ecc_agent  record with IPv6 
addresses. The tables ecc_agent_router  and ecc_agent_ip_address  are populated with both 
IPv4 and IPv6 entries on a dual stack host.

Securing and encrypting MID Server data

After configuring your MID Server, you can add security by encrypting MID Server parameter 
values in the config.xml  file. Encryption protects data that the MID Server returns to the 
ECC Queue. Other available security options include the authorization of SOAP requests, 
restricting access to the MID Server configuration file, and establishing secure socket layer (SSL) 
connections.
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How MID Server password encryption works

The username  and password  are initially set in the config.xml  file on the MID Server. 
When the MID Server retrieves the credentials, it replaces the clear-text password with an 
encrypted password automatically, using an AES256 encryption algorithm. In continued efforts 
to improve MID Server security, the encryption algorithm has been enhanced. The MID Server 
also maintains an encryption key that is generated each time it starts and remains in memory 
and not on the hard disk. When credentials need to be sent from the instance to the MID Server, 
the following process takes place:

1. The instance retrieves the encrypted password  and the unencrypted username  from the 
instance database table.

2. The instance decrypts the encrypted password, and then re-encrypts it using the MID Server 
encryption key.

3. The username  and re-encrypted password  are sent to the MID Server through the 
encrypted TLS session was already established between the MID server and the instance.

4. The MID Server receives the credentials and decrypts the password  in memory before using 
the credentials for remote operations. At no point is the credential password stored on the disk 
in an unencrypted format.

Security options

The MID Server provides built-in security options for other content in the configuration file, such 
as the default encryptor, Windows Data Protection API, and options for custom encryption.

MID Server certificate check policies

Control the MID Server with the certificate check policies table to secure external 
traffic.

Encrypt or decrypt MID Server configuration file values

You can encrypt and decrypt any value in the MID Server config.xml  file.

MID Server configuration file security

Protect sensitive MID Server configuration data in the config.xml  file using internal 
and external data encryption and external data storage.

MID Server authentication credentials and SOAP requests

Set basic authentication credentials to update the web service invocation data and 
enforce basic authentication on each incoming SOAP request to the MID Server.

MID Server unified key store

The MID Server unified key store allows all products on the MID Server to use a 
common certificates and key pairs.

MID Server command audit log

The command audit log records the commands run by the MID Server  for the 
Discovery  application.

Rekey a MID Server

Rekey a MID Server to force it to restart and generate a new private key. Typically, 
this process is only necessary if the MID Server keystore is compromised.

Add SSL certificates for the MID Server

Add certificates to the MID Server to communicate over SSL.

MID Server SSH cryptographic algorithms
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The MID Server utilizes SSH clients to perform many discovery actions. The MID 
Server automatically determines the best cryptographic algorithm to use.

MID Server authentication credentials and SOAP requests

For added security, enforce basic authentication on each incoming SOAP request to 
the MID Server.

Attach a script file to a file synchronized MID Server

Attach a script file and synchronize it to a MID Server to prevent Windows enhanced 
security from blocking MID Server download files it determines are dangerous.

MID Server certificate check policies

MID Server uses three kinds of security checks to secure external traffic. The security checks use 
TLS/SSL certificate validation, hostname validation, and OCSP validation to improve security. 
Control these security checks with the MID Server certificate check policies table.
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TLS/SSL certificate validation

TLS/SSL encryption security uses asymmetric encryption, also called public-key encryption. 
This encryption uses two cryptographic keys: the public key and the private key. The public key 
is used for encryption of data and is publicly visible. The private key is used for decryption of 
data and its security is essential to verifying authenticity. For more information about preparing 
your network, see MID Server  TLS/SSL certificate check policy Quebec upgrade information 
[KB0867397] .

In TLS/SSL certificate validation, the MID Server attempts to connect to a web server secured 
with a TLS or SSL certificate. The web server sends a copy of its TLS/SSL certificate to the MID 
Server. The MID Server checks the authenticity of the certificate and sends a message to the 
webserver. The webserver responds with a digitally signed acceptance for initiating an TLS/SSL 
encrypted session. After which the MID Server can begin encrypted communication with the 
web server.

Hostname validation

Hostname verification is a part of HTTPS that involves a server identity check to ensure that the 
client is talking to the correct server. This check prevents sending information to a server after 
being redirected by a man in the middle attack.
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The check involves verifying that the dnsName  of the certificate sent by the server matches 
the URL used to make the request. According to RFC 6125, hostname verification should 
be done against the certificate's subjectAlternativeName's dNSName field. In some legacy 
implementations, the check is done against the certificate's commonName field. If the names 
don't match, the connection is terminated.

Note: 
Hostname validation derives the hostname from the validated certificate presented by the 
server. Therefore, TLS certificate validation is a pre-requisite for hostname validation.

Online Certificate Status Protocol (OCSP)

OCSP involves contacting the remote certificate authority server and verifying the certificate 
before the MID Server communicates further with the target server. Compromised certificates 
can be a security vulnerability, especially if those certificates have the ability to sign other 
certificates. If certificates have been broken or forged, then a certificate authority can inform a 
client which certificates are invalid and should not be used.

An OCSP responder (a server typically run by the certificate issuer) returns a signed response 
that the certificate is 'good', 'revoked', or 'unknown'. If it cannot process the request, it may return 
an error code.

The certificate's issuer may delegate another authority to be the OCSP responder. This creates 
a chain of certificates that must be verified. The responder's certificate must be issued by the 
issuer of the certificate in question. The responder’s certificate must include a certain extension 
that marks it as an OCSP signing authority.

Note: 
OCSP checks are secondary HTTP calls made to an OCSP responder. The primary call may 
discontinue the connection based on the response from the OCSP responder.

MID Server security policy

MID Server security policies control all HTTPS traffic originating from the MID Server. This 
includes HTTPS connections from the MID Server to an internet endpoint, ServiceNow URLs, 
intranet endpoints, as well as cloud endpoints.

These connections can be further classified into 4 security policies:

ServiceNow endpoint policy

This policy is the system default exclusively for ServiceNow URLs. On the MID 
Server config.xml, there are bootstrap properties which are only used to make 
first connection to the instance and will get updated with the system_default policy.

Internet policy
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These policies cover all HTTPS connections initiated from MID Server to any 
endpoint on the internet.

Intranet policy

These policies cover the reserved IP subnets, such as self-hosted networks.

Overridden policy

You can override specific endpoints or URLs with this policy definition. Overridden 
policies take the highest order of precedence during operation.

Both tables are editable to include or exclude IP ranges, as well as control what kind of certificate 
validation checks need to be done. Enable all certificate validation checks to maximize security. 
The Quebec version has all policies and checks turned on by default for fresh installations.

For upgrading customers, the intranet policy has the certificate validation checks disabled by 
default. To improve security, configure and enable the policy for endpoints within the internal 
network.

Note: 
Internal endpoints or URLs need to possess a valid CA signed certificate for a successful 
connection.

For endpoints that host a self-signed certificate, either import the certificate to the MID Server 
trust store or disable the policy checks which validate that host. For more information about 
adding certificates, see Add SSL certificates for the MID Server.

After upgrading to Quebec, go to the certificate check policies table and make changes to 
policy configuration if necessary. Once the MID Server starts up and connects to the instance, 
any subsequent HTTPS connection originating from the MID server will start applying these 
certificate checks at runtime. Insecure connections are broken with appropriate error messages.

Use Instance Security Policy

The MID Server configuration parameter mid.ssl.use.instance.security.policy  controls whether 
the MID Server uses its bootstrap parameters rather than the security policy from the instance. 
By default, mid.ssl.use.instance.security.policy  is set to false in the config.xml  so the bootstrap 
policies are not overwritten by the instance's.

This default setting can prevent some problems during MID Server setup. For example if the host 
is unable to reach the OCSP responder, then a new MID Server installation is not disrupted by an 
instance's policy of requiring OCSP connection.

The configuration parameter mid.ssl.use.instance.security.policy  can be set for each MID 
Server. When set to true, the MID Server syncs all policies with the instance and the bootstrap 
configuration parameters are overwritten by the *.servicenow.com  policy on the instance 
mid_cert_check_policy  table. The final policies update the policy map in the MID Server 
memory as well as the config.xml.

The default parameters in the config.xml  are:

• <parameter name="mid.ssl.bootstrap.default.check_cert_hostname" 
value="true"/>

• <parameter name="mid.ssl.bootstrap.default.check_cert_chain" 
value="true"/>
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• <parameter 
name="mid.ssl.bootstrap.default.check_cert_revocation" 
value="false"/>

• <parameter name="mid.ssl.use.instance.security.policy" 
value="false"/>

Self-hosted or on-prem instances must add the following parameter for the config.xml: 
<parameter name="mid.ssl.bootstrap.default.target_endpoint" 
value="FQDN_OF_THE_INSTANCE"/>

Encrypt or decrypt MID Server configuration file values

The value of any MID Server parameter in the config.xml  file can be encrypted. The 
attributes for all encrypted values are managed from within the configuration file, including the 
security attribute of the login password.

Before you begin
Role required: admin
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Procedure

1. Navigate to the agent  directory that was created when the MID Server was installed and open 
the config.xml  file using a text editor such as WordPad.

2. Locate or add the parameter you want to encrypt.
For example, you might want to protect your proxy server passwords by configuring this 
parameter:

<parameter name="mid.proxy.password" value="securepassw0rd"/>

3. Add the encryption attribute secure="true".

<parameter name="mid.proxy.password" secure="true" 
 value="securepassw0rd"/>

4. Restart the MID Server.

5. Open the config.xml  file.
The encrypted password appears as follows:
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<parameter name="mid.proxy.password" secure="true" 
 value="encrypted:rhrfUNYRzZAI8/BkTtZmNA=="/>

.

6. To decrypt this or any other value in the config.xml  file and display the value in clear text:

a. Stop the MID Server.

b. Set the secure="true"  attribute to false.

c. Replace the encrypted value with the clear text value.

d. Restart the MID Server.

MID Server configuration file security

Sensitive MID Server configuration data can be protected using several different schemes, 
including internal and external data encryption and external data storage.
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The MID Server provides the following built-in security options for content in the config.xml  file:

• Default security provider: Secures the data in the config.xml  file by encryption. When the MID 
Server is restarted, any unencrypted data is encrypted and written to the config.xml  file. The 
default security provider offers these encryption options:

◦ Default encryptor: Default process for encrypting data in the MID Server config.xml  file. See 
Encrypt or decrypt MID Server configuration file values  for details.

◦ Windows Data Protection API (DPAPI): The operating system performs the data encryption, 
rather than the MID Server. DPAPI encryption is based on the logged in user's account. 
When this scheme is used, the data can only be decrypted by the same user account. If the 
account changes, the data must be re-encrypted.

◦ Custom encryption: Implement the IMidServerEncrypter interface  to create your own 
custom encryption scheme to manage sensitive config.xml  data.

•

• CyberArk: Data security is provided by CyberArk integration configuration , which moves 
sensitive data from the config.xml  file to a secure CyberArk vault. This solution does not 
encrypt the data.

• Custom external storage: Implement the ISecuredConfigProvider interface  to create your own 
custom external storage system to manage sensitive config.xml  data.
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Secured content and encryption schemes

Encrypt MID Server configuration data with DPAPI

Windows Data Protection API (DPAPI) encrypts sensitive data from the config.xml  file, based on 
the MID Server user account.

Before you begin
Role required: admin

About this task
DPAPI encryption provides another level of security for data such as credentials, IP addresses, 
and URLs in the MID Server config.xml  file. The operating system performs the data encryption, 
rather than the MID Server. DPAPI encryption is based on the logged in user's account. When 
this scheme is used, the data can only be decrypted by the same user account. If the account 
changes, the data must be re-encrypted.

Procedure

1. Open the config.xml  file in a text editor.
This file is located in the /agent  folder in your MID Server installation path.

2. Enable this parameter and value:
<parameter name="mid.secure_encrypter" 
value="com.service_now.mid.services.config.WindowsDPAPIEncrypter"/
>

3. Save the configuration file.

4. Restart the MID Server.
Any values in clear text in the config.xml  file are encrypted by the operating system.

5. Follow this procedure if you need to change the MID Server user account that is used for 
encryption.
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a. Stop the MID Server service.

b. Open the config.xml  file in a text editor.
This file is located in the /agent  folder in your MID Server installation path.

c. Re-enter all the encrypted values in clear text.

d. Make the changes to the MID Server user account in the ServiceNow®  instance.

e. Restart the MID Server service.
The data is re-encrypted by the operating system, based the new MID Server user account.

Use CyberArk as a secure configuration provider

You can use a CyberArk vault to secure any sensitive data from the MID Server config.xml  file.

Before you begin
Role required: admin

Before configuring CyberArk as secured config provider, make sure that JavaPasswordSDK.jar 
is available in the <mid_installation_folder>/agent/extlib  folder.

About this task
CyberArk is commonly used to secure credentials in its external vault. However, a MID Server 
parameter in the config.xml  file enables you to store other types of data in CyberArk.

Procedure

1. Open the config.xml  file in a text editor.
This file is located in the /agent  folder in your MID Server installation path.

2. Enable this parameter and value:
<parameter name="mid.secure_config.provider" 
value="com.service_now.mid.services.config.CyberArkSecuredConfigProvider"/
>

3. Configure specific data to secure in the CyberArk vault.
Use the following example as a guide.

a. Secure the MID Server credentials by setting this parameter to match the ID  and Type  for 
that data in your CyberArk integration configuration .

<parameter name="mid.instance.username" secure="true" 
 value="cyberark: id=<CyberArk ID>, type=<CyberArk type>"/>
<parameter name="mid.instance.password" secure="true" 
 value="cyberark: id=<CyberArk ID>, type=<CyberArk type>"/>

b. Secure the URL of the instance by setting this parameter to match the ID  and Type  for that 
data in your CyberArk configuration.
<parameter name="url" secure="true" value="cyberark: 
id=<CyberArk ID>, type=<CyberArk type>"/>

4. Save the configuration file.

5. Restart the MID Server.
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Change MID Server configuration file security schemes

The MID Server provides several schemes for securing sensitive data in the config.xml  file and 
allows you to switch between these options to suit your security requirements.

Before you begin
Role required: admin

Procedure

1. Stop the MID Server service.

2. Open the config.xml  file in a text editor.
This file is located in the /agent  folder in your MID Server installation path.

3. Re-enter all the encrypted values in clear text.

4. Disable the previous security scheme and configure the MID Server to use the new provider.

5. Restart the MID Server service.
The data is re-secured or encrypted, based on the security scheme you have selected.

MID Server ISecuredConfigProvider interface

Use the methods in this interface to create custom providers that manage secured parameter 
values in the MID Server config.xml  file.

Note: 
These methods are contained in the snc-automation-api.jar  file, located in the MID Server 
installation folder.

initialize

This method initializes the provider with additional configuration parameters and does not return 
a value.

Example

void intialize(java.util.Properties properties,
               IMidServerEncrypter encrypter)
        throws java.lang.Exception

Parameters

Parameters Description

properties Initialization properties.

encrypter Encrypter to use if the provider is encryption 
based.

Exception

java.lang.Exception
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isParameterValueSecured

This method checks to see if the parameter value has been secured or not. This method returns 
a boolean  type value.

Example

boolean isParameterValueSecured(java.lang.String paramValue)

Parameters

Parameter Description

paramValue The parameter value.

Returns

The parameter returns true  if the parameter value is secured.

secureParameterValue

This method secures the parameter value if it has not been secured. This method returns a 
string  type value.

Example

java.lang.String secureParameterValue(java.lang.String 
 unsecuredParameterValue)
                               throws java.lang.Exception

Parameters

Parameter Description

unsecuredParameterValue The unsecured parameter value.

Returns

This method returns the unsecuired parameter value.

Exception

java.lang.Exception

unsecuredParameterValue

This method returns the unsecured value of the parameter. This method returns a string  type 
value.
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Example

java.lang.String unsecuredParameterValue(java.lang.String 
 parameterName)
                                  throws java.lang.Exception

Parameters

Parameter Description

parameterName The parameter name.

Returns

This parameter returns the unsecured value.

Exception

java.lang.Exception

MID Server IMidServerEncrypter interface

Use the methods in this interface to create a custom external encrypter for the MID Server 
config.xml  file.

Note: 
These methods are contained in the snc-automation-api.jar  file, located in the MID Server 
installation folder.

initialize

This method initializes the encrypter with additional configuration parameters and does not 
return a value.

Example

void intialize(java.util.Properties properties)
        throws java.lang.Exception

Parameters

Parameter Description

properties Initialization properties.
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Exception

java.lang.Exception

encrypt

This method encrypts the unencrypted data and returns a byte[ ]  type value.

Example

byte[] encrypt(byte[] unencryptedData)
        throws java.lang.Exception

Parameters

Parameter Description

unencryptedData The data unencrypted.

Returns

Encrypted data

Exception

java.lang.Exception

decrypt

This method decrypts encrypted data and returns a byte[ ]  type value.

Example

byte[] decrypt(byte[] encryptedData)
        throws java.lang.Exception

Parameters

Parameters Description

encryptedData The data decrypted.

Returns

Decrypted data.
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Exception

java.lang.Exception

MID Server authentication credentials and SOAP requests

Set basic authentication credentials to update the web service invocation data. For added 
security, you can enforce basic authentication on each incoming SOAP request to the MID 
Server.

1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

Basic authentication credentials and SOAP requests

You can enforce basic authentication on each request. The MID Server is not able to 
communicate through a proxy server if the proxy server supports only NTLM authentication. You 
can use basic authentication with a proxy server or create an exception for the MID server host.

Supplying basic authentication information, regardless of whether it is required, has an added 
advantage. The web service invocation creates or updates data using the supplied credentials. 
For example, when you create an incident record, the journal fields have the user id of the basic 
authenticated user instead of the default Guest user. This behavior allows you to identify data 
added by a specific MID Server.

You can set basic authentication credentials for SOAP requests. Each SOAP request contains an 
Authorization header as specified in the Basic Authentication protocol .

The setting for enforcing strict security controls how the instance uses the credentials you 
provide for the MID Server. When the setting is enabled, you must provide a user ID with access 
to the tables the MID Server is trying to access. When the setting is disabled, any valid user ID 
allows the MID Server to access to all tables.

To learn more about properties that affect SOAP request processing, see Basic auth: SOAP 
requests  in Instance Security Hardening Settings.

Require basic authorization for incoming SOAP requests

Enforce basic authentication on each incoming SOAP request to the MID Server.
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Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Properties  > Web Services.

2. Select the check box for Require basic authorization for incoming SOAP requests.

3. Click Save.

4. To provide basic authentication credentials for a MID Server, navigate to C:\Program Files
\ServiceNow\<MID Server name>\agent and edit the config.xml  file, as follows:

a. Find the element <parameter name="mid.instance.username" value=""/> 
and enter the instance administrator user name as the value.

Example 
For example, you might enter <parameter name="mid.instance.username" 
value="admin"/>.

b. Find the element <parameter name="mid.instance.password" value=""/> 
and enter the configured password for this instance as the value.

Example 
For example, you might enter <parameter name="mid.instance.password" 
value="abc123"/>.

MID Server unified key store

The MID Server unified key store allows all products on the MID Server to use common 
certificates and key pairs. This feature allows applications to use the same secure 
communication channel to the MID Server that the MID Server uses to connect to the instance.

1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

When the MID Server starts, the common name (CN) of the certificate is inspected to identify 
if a custom certificate has been installed. If a custom certificate is detected, the creation of the 
certificate/keypair will be skipped and an attribute is set on the ecc_agent record to indicate the 
usage of a custom certificate.
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When a custom certificate is used, the Re-key  UI-action is disabled on the instance for the MID 
Server. A new UI action called Remove custom keypair  is available to switch back to using a self-
signed certificate. Using this action will cause the MID Server to remove the custom certificate 
and generate a new self-signed certificate, similar to the re-key option.

When a MID is upgraded, any custom certificates that were installed will be retained.

PEM bundle support

MID Server unified key store supports PEM bundle certificate and key pairs.

Sample PEM bundle

-----BEGIN PRIVATE KEY-----
 
MIIEvQIBADANBgkqhkiG9w0BAQEFAASCBKcwggSjAgEAAoIBAQC0pj5O8QKFpHy9
 
...
 
oPdU+h0grs9SJp6rFx0PzDY=
 
-----END PRIVATE KEY-----
 
Bag Attributes
 
    friendlyName: <myCustomCert>
 
    localKeyID: 54 69 6D 65 20 31 35 39 35 33 35 34 32 30 38 30 
 35 31
 
subject=/C=US/ST=CA/L=Santa Clara/CN=epic1016883
 
issuer=/C=US/ST=CA/L=Santa Clara/CN=epic1016883
 
-----BEGIN CERTIFICATE-----
 
MIIDKzCCAhOgAwIBAgIEPqMQqDANBgkqhkiG9w0BAQsFADBGMQswCQYDVQQGEwJV
 
...
 
4g53RN+LqtJVeeQkZvIbZOfuSqypdVfudkS8dqxQALb8IuHUV7JOcBvOT79mSTs=
 
-----END CERTIFICATE----- 

Install custom certificates in the MID Server unified key store

Install custom certificates to unify the security channels for various applications.

Before you begin
Role required: admin

When installing the certificate on a MID Server hosted in Linux, install-certificate.sh 
can be unresponsive if the Linux entropy pool count is less than a few hundred. Check the 
entropy count of the Linux pseudo random number generator (PRNG) with the following 
command:

cat /proc/sys/kernel/random/entropy_avail
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If the entropy count is too low, you can install an entropy generator such as RNGD or Haveged. 
For more information about installing Haveged for CentOS and Ubuntu, see How to Setup 
Additional Entropy for Cloud Servers Using Haveged .

Procedure

1. If the MID Server is running, stop the MID Server.

Note: 

If the entry for alias DefaultSecurityKeyPairHandle  is being modified, you must 
invalidate the MID Server before stopping it.

2. Create a PEM bundle certificate and keypair by running one of the following commands in the 
MID Server install folder.

◦ Generate self-signed certificates for non-MTLS use cases with the command:

openssl req -newkey rsa:2048 -nodes -keyout key.pem -x509 
 -days 365 -out certificate.pem

◦ Export the key store to a PEM bundle using the command:

openssl pkcs12 -in <myCustomCert>.p12 -nodes -out 
 <myCustomCert>.pem

◦ Get only certificates in the PEM format with the command:

openssl pkcs12 -in <myCustomCert>.p12 -out <myCustomCert>.pem 
 -clcerts -nokeys

◦ Get only keys in the PKCS 8 format with the command:

openssl pkcs12 -in <myCustomKey>.p12 -out <myPrivateKey>.key 
 -nocerts -nodes

◦ Install the certificate, or certificate chain, and private key for Windows hosts using the 
command:

bin/scripts/manage-certificates.bat -a <alias> <file path to 
 PEM bundle>

◦ Install the certificate, or certificate chain, and private key for Linux hosts using the command:

bin/scripts/manage-certificates.sh -a <alias> <file path to 
 PEM bundle>

Note: 

The header and footer of the PEM syntax must be the following:

 -----BEGIN CERTIFICATE----- 

 -----END CERTIFICATE----- 

The header and footer of the PKCS 8 syntax must be the following:

 -----BEGIN PRIVATE KEY----- 

 -----END PRIVATE KEY----- 
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3. Start the MID Server.

4. Validate the MID Server with the instance.

5. Optional:  To revert the MID Server to use a self-generated certificate, select the MID Server in 
the instance and use the UI action Remove custom certificate.

Note: 
The MID Server can also be reverted using the Invalidate  UI action. Invalidating a MID 
Server removes any custom certificates that are installed and creates a new self-signed 
certificate for the MID Server.

What to do next
The manage-certificates  has the following functions and the scripts must be run from the 
agent folder.

Enable mutual authentication​

For Windows, use the command: bin/scripts/manage-
certificates.bat -m

For Linux, use the command: ./bin/scripts/manage-certificates.sh 
-m

Remove mutual authentication and restore back basic authentication

For Windows, use the command: bin/scripts/manage-
certificates.bat -b <myUserName myPassword>

For Linux, use the command: ./bin/scripts/manage-certificates.sh 
-b <myUserName myPassword>

Add new certificates and certificate chains with a specified alias​

For Windows, use the command: bin/scripts/manage-
certificates.bat -a <alias> <fileName>

For Linux, use the command: ./bin/scripts/manage-certificates.sh 
-a <alias> <fileName>

The alias  is a unique name given to the certificate being imported. The MID 
Server requires a custom certificate for mutual authentication, with the default alias 
name defaultsecuritykeypairhandle. To configure MTLS communication 
between the MID Server and instance, the certificate entry must be added to the 
key store using the alias name defaultsecuritykeypairhandle.

The fileName  is a file path that can contain a PEM certificate, or certificate chain, 
and a PCKS 8 private key. The file path to the PEM bundle can contain multiple 
certificates and a single private key. The header and footer of each PEM certificate 
must be the following:

 -----BEGIN CERTIFICATE----- 

 -----END CERTIFICATE----- 

The header and footer of the PKCS 8 syntax must be the following:

 -----BEGIN PRIVATE KEY----- 

 -----END PRIVATE KEY----- 
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An exception is thrown if the certificate chain fails validation. If the file contains 
multiple certificates, they must be ordered: leaf certificate, intermediate certificates, 
then root certificates.

Display certificate details for the specified alias

For Windows, use the command: bin/scripts/manage-
certificates.bat -g <alias> 

For Linux, use the command: ./bin/scripts/manage-certificates.sh 
-g <alias> 

This command displays information such as subject distinguished name, issuer 
name, and expiry date from the certificate.

List all existing aliases

For Windows, use the command: bin/scripts/manage-
certificates.bat -l

For Linux, use the command: ./bin/scripts/manage-certificates.sh 
-l

This command lists all the alias names available in the agent_keystore.

Delete certificates using an alias​

For Windows, use the command: bin/scripts/manage-
certificates.bat -d <alias>

For Linux, use the command: ./bin/scripts/manage-certificates.sh 
-d <alias>

This command deletes the alias and record from the keystore. The entry for alias 
DefaultSecurityKeyPairHandle  can be deleted using this command.

Remove all entries from the keystore

For Windows, use the command: bin/scripts/manage-
certificates.bat -r 

For Linux, use the command: ./bin/scripts/manage-certificates.sh 
-r 

This command deletes the existing entries from the keystore, except alias 
DefaultSecurityKeyPairHandle. 

Related topics

Enable MID Server mutual authentication

Restore the MID Server key store with a backup

If the key store becomes corrupted or is accidentally deleted you can restore a backup of the 
MID Server key store. This is especially useful for key stores with custom key-pairs, because 
otherwise recreating custom key-pair data can be difficult and time consuming.

Before you begin
Role required: Agent admin

About this task
Starting with the Tokyo release, the MID Server automatically makes a backup of the 
agent_keystore  file when it is changed. Backups are stored in security_backup  under the agent 
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folder. They are stored outside the security folder to protect against accidental deletions or 
corruptions of the security folder.

In the backup folder, there is a dedicated backup log file: keystore_backup_audit_trail.log. 
This log keeps track of backup files and backup activities. Each backup log entry has backup 
file name with a time stamp, a matching keypairs.mid_id, and a list of aliases of key-pairs in the 
backup.

Note: 
For security purposes, the backup key store should have the same attributes as the original 
key store, such as owner, group, and permissions. Those attributes ensure the MID Server 
has the same protection at file system level.

The key store backups can be modified with the MID Server properties 
mid.keystore.max_backups, mid.keystore.max_live_backups, and 
mid.keystore.backup_overwrite_timespan. See MID Server properties  for more information.

Procedure

1. Stop MID Server.

2. Navigate to the security_backup  and view the keystore_backup_audit_trail.log  to choose 
which backup to restore.

3. Copy that backup to the agent_keystore  file in the security folder.
Check the file permissions to make sure that it has the same owner and permissions as the 
original one. If agent_keystore  already exists in that location, overwrite it with the backup.

4. Check config.xml  to make sure that the keypairs.mid_id  matches the one in the audit log file.

5. Optional:  If the keypairs.mid_id  do not match, update config.xml  to match them.

6. Navigate to the instance and invalidate the MID server.
This will create a delete_mid_keypair  system command in the ecc_queue.

7. Find all delete_mid_keypair  output messages for the MID Server and mark them as 
processed.
The goal is to mark the MID Server as invalidated without triggering the key-pair deletion. 
Unless the system commands are marked as processed, MID Server deletes the 
defaultsecuritykeypairhandle  key-pair regardless of whether it is custom or auto-generated.

8. Restart MID Server.

9. Navigate to the instance and validate the MID Server.

Enable MID Server mutual authentication

Configure the MID Server to use a client certificate for authenticating to the instance. This avoids 
the need to create a basic authentication credentials in the Key Store for the MID Server's 
configuration.

Before you begin
Role required: admin
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1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

About this task
MID Server mutual authentication removes the MID Server user name and password and 
provides a client certificate for authentication. Whenever a server requests authentication, this 
certificate is sent instead. To use mutual authentication, certificate based authentication must be 
enabled. See Set up Certificate-based authentication  for the procedure.

If a new MID Server is created with mutual authentication, it does not add capabilities 
automatically. An administrator must add capabilities to its record on the instance. However, 
existing MID Servers using basic authentication with capabilities are preserved when switching 
to mutual authentication.

A MID Server using mutual authentication cannot be re-keyed or validated as a UI action on the 
instance.

Self-signed certificates are not supported with mutual authentication. Internally signed 
certificates are only supported when signed by a private certificate authority. Commercially 
signed certificates are supported when signed by a commonly trusted certificate authority, such 
as those trusted by browsers and operating systems.

In the Quebec release, a MID Server using the Health Log Analytic application cannot be 
configured with mutual authentication.

Procedure

1. Contact ServiceNow support to request mutual authentication on the MID Server.

2. Obtain a certificate and private key from a respected certificate authority.

MID Server mutual authentication only supports the PEM bundle format and private key 
in PCKS 8 format. The bundle must have both the private key and certificate. Open the 
certificate using a text editor and see if it is in text format. The header and footer of the PEM 
syntax is the following:

 -----BEGIN CERTIFICATE----- 

 -----END CERTIFICATE----- 
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You can read the contents of a PEM certificate using the openssl  command on Linux or 
Windows as follows: openssl x509 -in cert.crt -text . The private key must be 
in the PKCS 8 format. The header and footer of the PKCS 8 syntax is the following:

 -----BEGIN PRIVATE KEY----- 

 -----END PRIVATE KEY----- 

  You can check the contents of a private key using the openssl  command on Linux or 
Windows as follows:  openssl rsa -in private.key -check

Note: 
If your certificate is not in PKCS 8 format, you get an error: - main SEVERE *** 
ERROR *** Could not find valid private key

3. Split up the PEM certificate into 3 different PEM files.

a. Private key and leaf certificate

b. Leaf certificate

c. Intermediate certificates and root certificate

4. On the instance, upload file containing the intermediate and root certificates to the CA 
Certificate Chain table: sys_ca_certificate.list.

Note: 
If uploading individually instead of a bundle, start with the root certificate, and then the 
intermediate certificate(s). It is preferrable to uploade this file as a PEM bundle, whose 
type is set to CA Cert, instead of splitting it into multiple files.

5. Check the uploaded CA Cert record on the instance and wait for the Publish Status  to change 
to Exists.
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Note: 
Do not proceed until the publish status is updated to Exists.

6. On the instance, navigate to sys_user_certificate.list.

7. Attach only the leaf certificate to sys_user_certificate.list  without including the private key.

8. If the MID Server is validated, invalidate the MID Server before continuing.

9. Create a new record.

Note: 
The record must have the MID Server's name and the User Role  must be MID Server.

10. Attach the original, unsplit PEM certificate to the record.

Note: 
Ensure that the attached file contains only the certificate.

11. If the MID Server is running, stop the MID Server.

12. On the MID Server host machine, run the following commands to install and manage the 
certificate and private key.

Run the script from the root of the agent directory because it requires the jar files in the class 
path. The security directory is then created in the agent root folder and is used by MID Server. 
For example: bin/scripts/manage-certificates.bat -m.

The manage-certificates  has the following functions and the scripts must be run from 
the agent folder.

Enable mutual authentication​

For Windows, use the command: bin/scripts/manage-
certificates.bat -m

For Linux, use the command: ./bin/scripts/manage-
certificates.sh -m

Remove mutual authentication and restore back basic authentication

For Windows, use the command: bin/scripts/manage-
certificates.bat -b <myUserName myPassword>
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For Linux, use the command: ./bin/scripts/manage-
certificates.sh -b <myUserName myPassword>

Add new certificates and certificate chains with a specified alias​

For Windows, use the command: bin/scripts/manage-
certificates.bat -a <alias> <fileName>

For Linux, use the command: ./bin/scripts/manage-
certificates.sh -a <alias> <fileName>

The alias  is a unique name given to the certificate being imported. 
The MID Server requires a custom certificate for mutual authentication, 
with the default alias name defaultsecuritykeypairhandle. To 
configure MTLS communication between the MID Server and instance, 
the certificate entry must be added to the key store using the alias name 
defaultsecuritykeypairhandle.

The fileName  is a file path that can contain a PEM certificate, or certificate 
chain, and a PCKS 8 private key. The file path to the PEM bundle can contain 
multiple certificates and a single private key. The header and footer of each PEM 
certificate must be the following:

 -----BEGIN CERTIFICATE----- 

 -----END CERTIFICATE----- 

The header and footer of the PKCS 8 syntax must be the following:

 -----BEGIN PRIVATE KEY----- 

 -----END PRIVATE KEY----- 

An exception is thrown if the certificate chain fails validation. If the file contains 
multiple certificates, they must be ordered: leaf certificate, intermediate 
certificates, then root certificates.

Display certificate details for the specified alias

For Windows, use the command: bin/scripts/manage-
certificates.bat -g <alias> 

For Linux, use the command: ./bin/scripts/manage-
certificates.sh -g <alias> 

This command displays information such as subject distinguished name, issuer 
name, and expiry date from the certificate.

List all existing aliases

For Windows, use the command: bin/scripts/manage-
certificates.bat -l

For Linux, use the command: ./bin/scripts/manage-
certificates.sh -l

This command lists all the alias names available in the agent_keystore.

Delete certificates using an alias​

For Windows, use the command: bin/scripts/manage-
certificates.bat -d <alias>
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For Linux, use the command: ./bin/scripts/manage-
certificates.sh -d <alias>

This command deletes the alias and record from the keystore. The entry for alias 
DefaultSecurityKeyPairHandle  can be deleted using this command.

Remove all entries from the keystore

For Windows, use the command: bin/scripts/manage-
certificates.bat -r 

For Linux, use the command: ./bin/scripts/manage-
certificates.sh -r 

This command deletes the existing entries from the keystore, except alias 
DefaultSecurityKeyPairHandle. 

13. Start the MID Server.

Related topics

Install custom certificates in the MID Server unified key store

MID Server unified key store

MID Server  command audit log

The command audit log records the commands run by the MID Server  for the Discovery 
application. Review the commands to check for anomalies or errors.

1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

The MID Server command audit log is a record of the commands the MID Server  runs during 
discovery. For example, executing one pattern may run many separate commands. The MID 
Server  command audit log supports Powershell commands for WMI and WinRM. For SSH 
commands, the audit log supports SSNC but not J2SSH. In Quebec, the command audit log only 
supports recording the commands run during discovery.

Enable the command audit log

The MID Server  audit log is enabled with the MID Server  property 
mid.log.command_audit.enable, which is set to false by default. Add the property in 
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the MID Server Properties  table [ecc_agent_property_list.do]. Once enabled, the MID Server 
command audit logs are accessed in the instance by navigating to MID Server  > Command 
Audit Logs  [ecc_agent_command_audit_log_list.do]. To see or change this table, the user must 
have the role agent_security_admin.

Data recorded in the command audit logs

The MID Server  command audit log records the name of the command and the command hash. 
If, for example, during discovery a probe does not run a command but instead runs a script then 
the script name is recorded. The command hash is calculated based on the content of the script, 
regardless of the name. Therefore, changing the name does not affect the command hash.

When a probe, such as a WMIRunner, runs a command with multiple WMI fields then WMI 
creates one script to query those fields. The script is created temporarily on the MID Server  host 
in the temp folder. After the script is run, it is removed from the temp folder. The script is given a 
name based on the fields and a random number. However, the hash key is always the same given 
the same contents.

The command audit log reports the execution status as either a success or failure. The record 
entry is a success if the command was run, or a failure if it was unable to run. The command audit 
log does not consider the result of the command being run. For example, a command which runs 
but fails gather data is still listed in the execution status as a success.

Discovery supports JEA profiles for WinRM. The MID Server  command audit log records the JEA 
profile of the discovery command, if it is available. See Microsoft Just Enough Administration 
(JEA) for Discovery  for more information on JEA profiles.

By default, the table is rotated every seven days. For more information, see Table Rotation .

Rekey a MID Server

Rekey a MID Server to generate a new private key. Private keys are used to decrypt automation 
credentials, so that MID Servers can transmit information securely. Key pairs are initially 
generated when a MID Server is validated, and MID Servers should be rekeyed periodically to 
meet security requirements.

Before you begin
Role required: admin
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1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

About this task
When the MID Server comes back online, the system automatically validates the new key, and 
the MID Server resumes processing automation tasks.
Automation credentials are secured by encrypting them in the instance with the MID Server’s 
trusted public key prior to transmission. When the MID Server is created, it generates a keypair, 
consisting of a public and private key. After the MID Server is validated, it can use the private key 
to decrypt automation credentials. You should occasionally rekey the MID Server to meet your 
organizations security requirements.

Procedure

1. Navigate to All  > MID Server  > Servers.

2. Open the MID Server whose keypairs you want to rotate.

3. Under Related Links, click Rekey.

Related topics

Validate the MID Server

Add SSL certificates for the MID Server

Configure the MID Server to connect to a source over SSL.

Before you begin
Role required: admin
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1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

About this task
You can add certificates to the MID Server to communicate over SSL/TLS in one of two ways:

• Add certificates directly to the bundled JRE TrustStore file, using the following procedure.

• Specify a different TrustStore file for the MID Server to use. For more information, see Specify 
an external TrustStore for the MID Server.

Review both methods to evaluate which best meets your needs.

During MID upgrade the bundled TrustStore is overwritten. The MID Server attempts to migrate 
certificates from the existing TrustStore to the incoming one. To be migrated, certificates must 
meet the following criteria:

Quebec (backported to Orlando Patch 10 and Paris Patch 4)

• X.509 v3 certificates

• Basic Constraints Extension evaluates to false (or is not present)

Rome (backported to Paris Patch 7 and Quebec Patch 2)

• X.509 certificates

• Any certificate present in the source, but not the destination TrustStore

Certificates that do not meet the criteria are overwritten. Alternatively, you can specify an 
external TrustStore file which is unaffected by MID Server upgrades. For more information, see 
Specify an external TrustStore for the MID Server

In Rome and later families, the migration strategy utilized during upgrade is configurable via the 
MID Server configuration parameter mid.truststore.migration.strategy. It can take 
the following values:

• migrate_delta: the default strategy (outlined above for Rome)

• migrate_non_ca: a strategy matching the one outlined above for the Quebec family

• do_not_migrate: disables the TrustStore migration during upgrade, though a backup of the 
original TrustStore is made in the event of overwrite
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During this migration process, a backup of the original and upgrade TrustStores are made and 
stored in the agent’s work directory: …\agent\work\truststore_migration\<time 
epoch seconds>\. The original TrustStore is renamed to cacerts_before  and the 
upgrade TrustStore is renamed to cacerts_from_upgrade.

Procedure

1. Open a command prompt and navigate to the folder containing the JRE keytool .
This is the location of the JRE you installed. An example path might be: C:\Program Files
\Java\jre1.8.0_161\bin

2. Import a certificate into the MID Server's cacerts keystore, using this command:
keytool -import -alias <certificate alias> -file "<path to 
certificate>" -keystore "<path to the JRE>\lib\security\cacerts"

For example, you might enter: keytool -import -alias MyCA -file "C:
\myca.cer" -keystore "C:\Program Files\Java\jre1.8.0_161\lib
\security\cacerts"

Note: 
The keytool prompts you for a certificate password. If the certificate is for a CA, the 
keytool also asks whether to trust the certificate authority. To add a certificate to an 
instance, see Upload a certificate to an instance .

3. Optional:  Display a list of the current certificates by running the command: keytool.exe 
-list -keystore "C:\Mid Server\agent\jre\lib\security\cacerts"

Specify an external TrustStore for the MID Server

The MID Server JVM can utilize a TrustStore external to the MID installation directory so any 
certificates added to the TrustStore are not overwritten during an upgrade. It is important that this 
TrustStore file reside outside of the MID installation directory, and the Truststore location can be 
specified by adding additional parameters to the MID Server's wrapper-override.conf 
file.

Before you begin
Role required: admin

Procedure

1. In the MID Server host, navigate to the wrapper-override.conf  file.

2. Specify an external TrustStore by appending a custom parameter to the end of your MID’s 
wrapper-override.conf  file.
For example, on a Windows MID with an external TrustStore found at C:
\external_truststore\cacerts, the end of the file would appear similar to:

  Add additional custom parameters below
 
wrapper.java.additional.3=-Djavax.net.ssl.trustStore=C:\externa
l_truststore\cacerts
 
wrapper.java.additional.4=-Djavax.net.ssl.trustStorePassword=<t
ruststore’s password>

Note: 
If you have specified other additional parameters in this file then the numerical identifier, 
in this case 3 and 4, may differ.
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MID Server SSH cryptographic algorithms

The MID Server utilizes SSH clients to perform many discovery actions. During the SSH 
handshake, both the client and server first determine which algorithms both parties support, 
then client picks the highest priority algorithm. For the Host Key Algorithm, the client picks 
highest priority algorithm which both parties support that matches the key type.

1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

Default supported SSH algorithms by priority

Key Exchange Algorithm 

1. ecdh-sha2-nistp256

2. ecdh-sha2-nistp384​

3. ecdh-sha2-nistp521​

4. diffie-hellman-group-exchange-sha256​

5. diffie-hellman-group14-sha256​

6. diffie-hellman-group16-sha512​

7. diffie-hellman-group14-sha1​

8. diffie-hellman-group1-sha1​

9. diffie-hellman-group-exchange-sha1

Host Key Algorithm  (used for public key signature during authentication)

1. ecdsa-sha2-nistp256​

2. ecdsa-sha2-nistp384​

3. ecdsa-sha2-nistp521​

4. rsa-sha2-256​

5. rsa-sha2-512​

6. ssh-rsa​

7. ssh-dss

Cipher Algorithm​
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1. aes128-ctr​

2. aes192-ctr​

3. aes256-ctr​

4. aes128-cbc​

5. aes192-cbc​

6. aes256-cbc​

MAC Algorithm

1. hmac-sha2-256​

2. hmac-sha1​

3. hmac-sha2-512​

4. hmac-sha1-96​

5. hmac-md5-96​

6. hmac-md5

Customize the SSH algorithms priority list

The MID Server SSH algorithm priorities can be customized based on security needs. Each 
algorithm is controlled by one of the following MID Server properties.

Note: 
Glide Import on the instance uses the default algorithm list. The four MID Server properties 
do not affect Glide Import because it is not run on the MID server. SNCSSH is used for Glide 
Import on instance for SFTP and SCP.

• Key Exchange algorithms: mid.ssh.algorithms.kex 

• Host Key algorithms: mid.ssh.algorithms.host_key 

• Cipher algorithms: mid.ssh.algorithms.cipher 

• MAC algorithms: mid.ssh.algorithms.mac 

The properties accept comma separated lists with operators. The first name in the list is highest 
priority, last name in list is lowest priority. Adding a comma separated list without any operators 
replaces the default algorithm list. The following operators are based on the OpenSSH standard 
syntax and modify the algorithm priority list.

• The +  operator appends the comma separated list of algorithms to the default algorithm list.

• The -  operator removes the comma separated list of algorithms from the default algorithm list.

• The ^  operator places the comma separated list of algorithms at the front of the default 
algorithm list.
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Attach a script file to a file synchronized MID Server

You can attach a script file to synchronize to a connected MID Server. Windows  Internet Explorer 
enhanced security blocks downloaded files that it determines are potentially dangerous. 
However synchronizing the files avoids this security problem.

Before you begin
Role required: admin

1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

About this task
Enhanced security in Windows  browsers, such as Internet Explorer, blocks downloaded files that 
it determines are potentially dangerous. This would block files downloaded for use by the MID 
Server. You would need to unblock each file manually through the browser.

To get around this issue, use file synchronization. File synchronization requires you to proactively 
take script files from your instance and save them on the MID Server. The files on the instance 
and the MID server stay synchronized, but there is no longer any need for the MID Server to 
download the whole file. File synchronization also protects any updates you make in those script 
files from being overwritten during the upgrade of an instance.

You can attach multiple files, but the last attached file gets synchronized to the MID Server. If you 
delete the attachment, the script file becomes inactive, and the synchronized file is deleted from 
the MID Server.

Procedure

1. Navigate to All  > MID Server  > Script Files.

2. Open the file to which you would like to attach the script file, or click New  to create a new file.

3. Select Use attachment, and then click the paperclip icon to add the attachment.
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When Use attachment  is checked, an attached script file overrides the script contained in 
the Script  field. If this check box is cleared, the script in the Script  field is used instead of the 
attachment.

The script file attachment name must match the MID Server script file name, since the record 
can contain other attachments.

4. Click Update  to initiate the synchronization process.
Ensure that the file name matches the script name. If you receive the error message: File 
type not permitted or mime type does not match the file content, 
request that your administrator turn off mime type validation on attachments. The system 
property glide.security.file.mime_type.validation  controls this setting.

Enable script file synchronization for Windows  enhanced security

Windows  Internet Explorer enhanced security blocks downloaded files that it determines are 
potentially dangerous.

Script files synchronized with the MID Server are stored on the instance in the MID Server Script 
File  [ecc_agent_script_file]  table, which you can access in the MID Server  > Script 
Files  module.

When the MID Server first connects to the instance, the instance creates a directory called 
\scripts  in the MID Server root. The instance then creates a parent directory in the path 
\scripts\<parent name>  using definitions from the ecc_agent_script_file table. Finally, 
the instance creates the script files themselves inside the parent directory using the records 
from the ecc_agent_script_file table.

The record for the parent directory looks like this:

The instance creates each script file in the parent directory on the MID Server using the record 
Name  from the ecc_agent_script_file table as the file name and the Script  field payload as the file 
contents. A script file record looks like this:
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The synchronization of the script file continues to work as if the script was manually added to the 
form.

See Attach a script file to a file synchronized MID Server  for instructions on how to attach a script 
file.

Note: 
The MID Server Script File [ecc_agent_script_file] table is domain separated. You can 
create versions of these policies that only a MID Server from the same domain can use. For 
instructions, see Set up domain separation for MID servers.

MID Server FIPS Enforced Mode

The MID Server supports the National Security Cloud (NSC) IL-5 environment, which requires all 
utilized cryptography to be FIPS validated. The MID server can be run in FIPS Enforced Mode, 
where only cryptographic algorithms which are FIPS validated are utilized.

1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

The Federal Information Processing Standards are a group of standards compiled by the 
National Institute of Standards and Technology for use in computer systems. There are many 
FIPS publications, but for the sake of this discussion we are specifically referring to FIPS 140-2: 
Security Requirements for Cryptographic Modules . Cryptographic algorithms can proceed 
through a validation process specified by the NIST. For the purposes of our new secure cloud 
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environment, the MID server will be utilizing algorithms that have been validated by such 
process.

Only MID Servers of the Rome release family or later with a JRE version of 11.0.9+11 or later can be 
set to run in FIPS Enforced Mode.

FIPS Enforced Mode

The following algorithms are not available for use in these SSH functions by the MID Server in 
FIPS Enforced Mode.

Key Exchange:

diffie-hellman-group1-sha1

Mac:

• hmac-md5

• hmac-md5-96

The following restrictions are now in place for SNMP for use by the MID Server in FIPS Enforced 
Mode.

• SNMP v1 and v2 are completely disabled.

• For SNMP v3, the following protocol uses are not permitted by the MID Server in FIPS Enforced 
Mode:

◦ auth protocol: none or MD5

◦ privacy protocol: none or DES

Other functionality that utilizes the MID Server may be impacted when run in FIPS Enforced 
Mode. Please refer to that functionality's specific documentation for details.

Enable MID Server FIPS Enforced Mode

The MID server can be run in FIPS Enforced Mode, where only cryptographic algorithms which 
are FIPS validated are utilized.

Before you begin
Role required: admin

Procedure

1. Deploy a new MID Server or upgrade existing MID Servers to the Rome family release or later.

2. Shut down the MID Server.

3. Execute the following bundled script provided to convert the MID to run in FIPS Enforced 
Mode:

◦ For Windows hosts: > <MID install directory>\agent\bin\scripts\set-
fips-enforced-mode.bat on

◦ For Linux hosts: $ <MID install directory>/agent/bin/scripts/set-
fips-enforced-mode.sh on

Success will be logged to the console including the location of modified files and any backups 
generated during the conversion process. If invoked programmatically, success will be 
indicated by a 0 return code.

4. Start the MID Server.
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What to do next
The mode the MID is running in can be confirmed via two methods:

1. Check the agent logs after start-up and look for the following log line: Running in FIPS 
Enforced mode

2. Check the ecc_agent table on the instance and look for the value of the FIPS Enforced 
boolean column.

Manually convert the MID Server to FIPS Enforced Mode

The MID server can be run in FIPS Enforced Mode, where only cryptographic algorithms which 
are FIPS validated are utilized.

Before you begin
Role required: admin

About this task
To manually convert the MID Server to FIPS Enforced Mode while using an external JRE, you 
must perform the following steps while the MID Server is shut down:

• Convert the JRE’s TrustStore to BCFKS type.

• Set the JRE’s default KeyStore type to be BCFKS.

• Set the FIPS Enforced Mode flag in the MID Server's configuration file.

Procedure

1. Convert the JRE’s cacerts file type to BCFKS by using the Java Keytool  with a command 
similar to:
$ keytool -importkeystore -srckeystore <source keystore 
path>  -srcstoretype <source keystore type>  -srcstorepass 
changeit -destkeystore <destination keystore path> 
-deststoretype BCFKS -deststorepass changeit -provider 
org.bouncycastle.jcajce.provider.BouncyCastleFipsProvider 
-providerpath <BouncyCastle FIPS jar path>

Note: 
Rome and later MID installations contain a BouncyCastle jar suitable for this purpose. It 
can be found at: …/agent/lib/bc-fips.jar

2. The JRE’s default KeyStore type can be set in the <JRE installation directory>
\conf\security\java.security  file.

3. In that file find the keystore.type  line and set its value as follows: 
keystore.type=bcfks

4. In the MID Server's …/agent/conf/wrapper-override.conf  file, uncomment the 
FIPS line and set its value to true.
The line should read: wrapper.java.additional.106=-
Dorg.bouncycastle.fips.approved_only=true

MID Server Governance

Improve MID Server  security by setting an automatic timeout to invalidate and shut down inactive 
MID Servers. You can enable this feature and set the inactivity timeout period globally and for 
each MID Server.
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1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

Introduction

MID Server Governance prevents forgotten MID Servers connected to ServiceNow instances 
from being utilized if the instance is compromised. MID Server Governance keeps a record of the 
last status change of the MID Server validation/invalidation process.

This feature is not enabled by default, and is available out-of-the-box as part of the MID Server 
plugin. Once enabled, MID Server authentication is expired after a predetermined period of 
inactivity unless explicitly configured to never expire.

Enable and Configure MID Server Governance

MID Server Governance is enabled for all MID Servers by setting the following true/false 
system property: mid.inactivity.timeout.enabled. This property is not defined by default. 
The global inactivity timeout is specified by setting the following integer system property: 
mid.inactivity.timeout.days. The property takes an integer which specifies the timeout in days. 
The default timeout is 30 days if unspecified.

You can override the timeout for a particular MID Server by specifying 
mid.inactivity.timeout.days  as a configuration parameter on that MID Server. A timeout value of 
0 disables MID Server Governance on that MID Server. Therefore, you can set a global timeout 
and also change or disable timeouts for certain MID Servers.

You do not need to restart the MID Server after changing the Governance configuration. 
Governance works with either basic or mutual authentication.

Activity Tracking

The MID Server analyzes activity by tracking incoming and outgoing ECC queue messages​
. Once per hour, the MID Server reports the last activity to instance, which is stored in the 
ecc_agent record, and checks if the inactivity timeout has been reached. If the inactivity timeout 
has been reached and the MID Server is up, the MID Server is invalidated and shuts down. If the 
timeout is reached when the MID Server is down, a job on the instance determines if the MID 
Server is idle and invalidates it on the instance.

When MID server is approaching auto-invalidation timeout due to inactivity, the MID Server page 
will display a message indicating:​
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• An info message when 3-7 days remain before inactivity timeout.

• An error message when less than 3 days remain before inactivity timeout.

• After a MID has been auto-invalidated, an error message is displayed indicating the date the 
MID was auto-invalidated.

Clearing the auto-invalidated state

After a MID Server has been auto-invalidated, the auto-invalidated status must be manually 
cleared in order to bring the MID back up successfully. The MID Server shuts down immediately 
if it is restarted without clearing this state. In addition, a MID issue will be logged indicating this 
occurrence.

The auto-invalidated state of a MID Server can be cleared by selecting the Clear auto 
invalidated  UI action from the MID Server instance page. After invoking this UI action, the user 
should start their MID Server and continue with the usual validation process.

Purpose field

The purpose is a text field that the customer can update at any point to indicate the intended 
usage for the MID Server. This field is purely descriptive and has no further interactions.

MID Server upgrades

Upgrade MID Servers manually, or automatically through the instance. MID Server automatic 
upgrade is triggered when the instance upgrades and the MID Server no longer has the same 
version. The new MID Server package is downloaded from install.service-now.com, replaces the 
old one, and the MID Server starts with the new version.

Warning: 
The MID Server can't auto-upgrade on a Windows host if the Windows Application 
Experience service is turned off. For information on the error that is displayed and 
instructions for re-enabling this service, see KB0597552 .

MID Server upgrade requirements

Access to the MID Server download site

The MID Server host computer must have access to the ServiceNow download site 
at install.service-now.com  to upgrade automatically. If you have a self-
hosted ServiceNow environment that blocks access to the download site, you must 
import the MID Server installer package into your MID Server hosts manually. For 
instructions, see KB0760123  in the Self-Hosted knowledge base.

MID Server access to OCSP blocked

Firewalls and proxy configurations may block calls to the OCSP Entrust and DigiCert 
servers, which prevents the MID Server from working. You may need to change your 
firewall permissions so that the OCSP traffic goes through. For more information and 
resolutions, see the HI Knowledge Base article [KB1216223] .

MID Server operating system compatibility

Upgrading Windows or Linux MID Servers with 32-bit operating systems isn't 
supported. For more information, see [KB0863694] .
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The MID Server can't upgrade on a Windows host if the Windows Application Experience service 
is turned off. For information on the error that is displayed and instructions for re-enabling this 
service, see KB0597552 .

The MID Server upgrade is blocked by some antiviruses running on Windows hosts. For 
information on the errors and list of these antiviruses, see KB0870329 .

Any Linux MID Server upgrade that's service is installed under system in Madrid or lower needs 
to re-install the service after upgrade. If you didn’t manually reinstall the service in previous 
upgrades and your MID Server service is still installed on Madrid or lower versions, during 
upgrade the MID Server automatically re-installs the service. To re-install the service MID Server 
needs to run as an admin user. If your MID Server upgrade needs to re-install the service, make 
sure that the MID Server user is admin, or you can manually re-install the service before upgrade. 
For information about manually re-install the service, see KB0821436 .

When does the MID Server need to upgrade

Any MID Server with a version different from the instance version needs to upgrade. The 
following two system properties control the version of all MID Servers:

• mid.buildstamp: Identifies the MID Server version with an identifier based on the date of 
the build. This property uses the format of mm-dd-yyyy-hhmm. The MID Server checks for 
version information hourly. If no override version is configured, the MID Server looks at the 
mid.buildstamp  property for the version to use. This property resets itself to the default 
version (the version that matches your instance version) when the instance is restarted or 
upgraded, so any user changes are lost at that time. The system appends the release name 
and patch information to the date and time format.

Warning: 
This property is not visible by default and should not be configured.

• mid.version.override: Sets an override condition for the current version for all MID Servers 
in your environment. This action pins the MID Servers to a single version and disables the 
automatic upgrade feature. This property is not visible in the base system and must be added 
to the System Property [sys_properties] table when it is set. For details, see Add a system 
property .

When the MID Servers check the version each hour, they look at the mid.version.override 
property first. If this property is empty, the MID Servers get their version information from the 
mid.buildstamp  property. If an override version is configured, the MID Servers use this value and 
ignore the version information in the mid.buildstamp  property. This override value remains when 
the instance is restarted and is passed to the MID Servers. The value in the mid.version.override 
property is cleared during an upgrade, which forces the MID Server to reset itself to the version 
in the mid.buildstamp  property.

In addition to mid.version.override, the MID Server version can also be controlled with the 
configuration parameter mid.pinned.version  which pins the MID Server to a specific version.To 
pin a MID Servers, set the mid.pinned.version  parameter with the name of that version in the 
config.xml  file of each MID Server. Use the format <version>-mm-dd-yyyy. This setting overrides 
the property setting for the pinned MID Server version. For instructions, see Add a MID Server 
parameter. The value set in this parameter is not affected by an upgrade.

Warning: 
Using mid.version.override  and mid.pinned.version  is not recommended. The different 
versions on the MID Server and instance can cause outage issues on the MID Server.
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Upgrade methods

Automatic

Automatic upgrade can be triggered by the instance or the MID Server itself. This 
functionality is available by default. Automatic upgrade occurs:

• When the instance is upgraded and the MID Server for that version is 
different than the version currently on the MID Server. The instance sends 
autoUpgradesystem command to the connected MID servers.

• Every hour, the MID Server checks with the instance to see if there is a different 
version available for upgrade. You cannot modify this time period.

Manual

Manually start the upgrade by clicking a related link on the MID Server record. Use 
this method when you do not want to wait until the next hourly automatic update or if 
your upgrade failed and you want to force an upgrade. See Upgrade the MID Server 
manually  for instructions.

Upgrade process

1. Pre-upgrade Check:Before starting the actual MID Server upgrade process, the MID Server 
runs a set of tests to make sure that the host machine meets the minimum requirements. Any 
errors encountered during this automatic test prevent the upgrade from occurring until the 
issues are resolved. The pre-upgrade test is enabled by default but can be disabled by adding 
and setting a system property. See MID Server pre-upgrade check  for more information.

2. Download the packages:The MID Server downloads upgrade packages from install.service-
now.com. These packages are in zip format and are downloaded to the agent folder in the 
package/incoming  folder.

3. Digital Signature Verification

After downloading every package, MID Server verifies the digital signature of the package. It 
throws an exception if the verification fails. The error will be recorded in the agent log and the 
MID Server issue table.

If the packages are downloaded and replaced manually you can verify the signature manually. 
To manually verify the signature of an installation or upgrade package, use the jarsigner tool 
which is available for free with JDK. The following is the jarsigner command to initiate the 
verification: Jarsigner -verify -verbose -certs -strict <zip-file>

The output should be similar to the following example:

- Signed by "CN=ServiceNow Inc., O=ServiceNow Inc., L=Santa 
 Clara, ST=California, C=US"
Digest algorithm: SHA-256
Signature algorithm: SHA256withRSA, 2048-bit key
Timestamped by "CN=Symantec SHA256 TimeStamping Signer - G3, 
 OU=Symantec Trust Network, O=Symantec Corporation, C=US" on 
 Tue Nov 05 19:55:37 UTC 2019
Timestamp digest algorithm: SHA-256
Timestamp signature algorithm: SHA256withRSA, 2048-bit key
 
jar verified.
 
The signer certificate will expire on 2021-08-09.
The timestamp will expire on 2029-03-22.
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4. Extracting Zip Files:After downloading all required packages, the MID Server extracts the zip 
files.

◦ Before Rome: The zip files are extracted in a folder under the operating system defined 
temporary folder. The folder name is a randomly generated number. The operating system 
temporary folder is specified by system property java.io.tmpdir. On a UNIX host, the value 
for this property is typically is /tmp  or /var/tmp.

◦ From Rome onward: The MID Server avoids using operating system defined temporary 
folders during MID Server upgrade. The zip files are extracted in a folder in the work/
upgrade_temp  folder under the agent folder. The folder name format is a randomly 
generated number. If you want to switch to the previous behavior and use an operating 
system defined temporary folder you can add mid.upgrade.use_os_temp_folderto MID 
Server’s config.xml  file and set it to true. To switch the behavior for all MID Servers, you can 
add it to the MID Server property [ecc_agent_property] with MID Server field blank.

Note: 
If you are using KB0747569  to change thejava.io.tmpdirand you want to keep it for 
future upgrades from Rome, set mid.upgrade.use_os_temp_folderto true after upgrading 
to Rome. If mid.upgrade.use_os_temp_folder  is not set to true then java.io.tmpdir 
isn’t applied during the MID Server upgrade and the folder under  agent\work
\upgrade_temp  will be used.

5. Replace old packages with the upgraded packages:After downloading and extracting the 
upgrade packages, the MID Server replaces old files with the new files and starts with the 
new version. To replace the packages, the MID Server starts a process named ServiceNow AI 
Platform  Distribution Upgrade  and shuts down. ServiceNow AI Platform  Distribution Upgrade 
waits for the MID Server to shut down properly, then replaces the required files as follows:

◦ Before Rome:The process deletes all files and folders in the bin, lib and jre folders and 
copies the new files into those folders.

◦ From Rome onward:  The process replaces the files in the bin, lib and jre only if the new 
version of the file is different from the old version. ServiceNow Platform Distribution 
Upgrade  does not clean the upgrade files and the unchanged files are kept.

If the reinstalling service was required as a part of MID Server upgrade, ServiceNow Platform 
Distribution Upgrade reinstalls the service before starting the MID Server. For more information 
refer to KB0821436 .

Note: 

If the MID Server upgrade fails in this step the MID Server stays Down. Some anti-viruses 
block the file replacement in this step. For more information refer to KB0870329 .

6. Start the MID Server:After replacing all required files with the new version, the ServiceNow AI 
Platform  Distribution Upgrade starts the MID Server. When the MID Server comes Up with the 
new version, it cleans up all temporary folders used to extract the upgrade files.

Upgrade log messages

The MID Server log messages are available in the following log files:

• Pre-upgrade check log messages are available in agent.log file under agent/logs folder. The 
message Performing pre-upgrade validation tests.  indicates that the pre-upgrade check 
has started. If all mandatory tests are passed, the message Pre-upgrade validation tests 
successful. Continuing with upgrade process.  indicates the end of the pre-upgrade check.
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• Log messages for downloading missing files are also available in agent.log. Every package 
download starts with Downloading package to PACKAGENAME.ZIP from https://
install.service-now.com/ PACKAGEINFO  message. The download progress and the size 
of downloaded file is monitored in the log. After downloading every package, Package was 
successfully downloaded from https://install.service-now.com/ PACKAGEINFO  indicates 
the successful download.

• Extracting the zip files is the last step available in the agent.log. The message Upgrading MID 
server  indicates the start of this step, and the message Extracting package PACKAGE.ZIP 
to EXTRACT_TMP_FOLDER  is shown for every package extraction. When all required zip 
files are successfully extracted, the MID Server starts the ServiceNow AI Platform  Distribution 
Upgrade process and the message Stopping MID server. Bootstrapping upgrade  shows the 
end of this step before MID Server goes Down.

ServiceNow AI Platform  Distribution Upgrade logs include log messages for the process 
start up and for replacing files during the MID Server upgrade. The upgrade log messages 
are placed between the messages ***********UPGRADE MAIN LOGIN START***********  and 
***********UPGRADE MAIN LOGIN END***********. ServiceNow AI Platform  Distribution Upgrade log 
messages can be found in the following log files:

• In the glide-dist-upgrade.log  file under temp extract folder. This file is available in upgrade-
wrapper/logs folder under temp extract folder. This log file includes process log messages and 
upgrade log messages.

• In the dist-upgrade.log  file in agent\logs  folder. This file only includes the upgrade portion 
of log messages. If there was some issue with the process startup you need to look at glide-
dist-upgrade.log.

• In wrapper.logunder agent\logs  folder. After replacing files, ServiceNow AI Platform 
Distribution Upgrade appends glide-dist-upgrade.log  to the wrapper.log file.

Update the wrapper configuration with upgrade-wrapper-override.conf

The wrapper configuration for glide-dist-upgrade  can be updated using a 
upgrade-wrapper-override.conf  file. Create a file named upgrade-wrapper-
override.conf  in the agent/conf  folder. Any configurations in the upgrade-wrapper-
override.conf  are used during the upgrade process.

By modifying the configuration with upgrade-wrapper-override.conf, debug logs can 
be enabled at the dist-upgrade  wrapper level and changes can be tested.

For example, the default timeout may not be long enough for certain JVM level commands. 
The timeout can be increased with upgrade-wrapper-override.conf  for the dist-
upgrade  wrapper configuration.

MID Server states

Upgrading

The MID Server status is changed to Upgrading while the upgrade is running. 
The Upgrading state is similar to the Paused  state. This is avoids potential 
miscommunication between the new version of the instance and the previous 
version of the MID Server during upgrade. While in the Upgrading state, you cannot 
resume or restart the MID Server. However, you can perform the same actions that 
you can when the MID Server is in the Paused state.
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Note: 
If you are using an Istanbul instance but you are upgrading a pre-Istanbul 
MID Server to Istanbul, these upgrade states are not available. They are only 
available for MID Servers that are already on Istanbul.

Upgrade Failed

If the upgrade failed in pre-upgrade check step or download/extract packages step, 
failed upgrades are handled differently based on the version you are upgrading.

• Upgrade to another major release (such as Istanbul to the next full release): the 
status changes to Upgrade Failed.

• Upgrade from a minor version within a release (such as Jakarta patch 1 to patch 
2): the MID Server continues using the version it is currently running. It does not 
perform the upgrade and the status eventually changes to Up, assuming the MID 
Server was already functioning properly.

• If the upgrade failed in last step, replacing old version of packages with the new 
version of packages, the MID Server stays Down.

MID Server upgrade history

Use the MID Server Upgrade History module for troubleshooting problems with MID Server 
upgrades. The module contains a record of each instance upgrade. Those records provide step-
by-step status details for each MID Server's upgrade process. If an error occurs, it is noted in 
the step and a message is dynamically generated with further details. The table cleanup job 
automatically deletes issues that haven't been detected for 30 days, regardless of their state. For 
further information, see MID Server Upgrade History.

JRE TrustStore certificate migration during JRE updates

For JRE updates after upgrading to Quebec, the MID Server migrates existing self-signed 
certificates in the JRE TrustStore to the new JRE version's TrustStore. When these certificates are 
migrated, their aliases are prepended with the string "snc_".

In order for a certificate to be migrated it must be:

• an X509 certificate

• certificate standard v3

• have the basic constraint extension set to false (i.e. it is not CA issued)

The MID Server identifies when a JRE upgrade is about to take place and begins the migration 
process. Before the migration, the MID Server creates a backup of the original TrustStore as 
a fall-back in the event of failure. If there is a failure, the backup TrustStore can be manually 
restored.

MID Server pre-upgrade check

Prior to an upgrade, the MID Server runs tests to identify issues that could cause the upgrade 
process to fail or result in a MID Server outage.

Each MID Server contains an AutoUpgrade monitor that compares the MID Server version with 
that of the instance to determine if the MID Server needs to upgrade. If the AutoUpgrade monitor 
discovers that the MID Server version is out of date, the monitor runs pre-upgrade validation 
tests for that MID Server. If an issue is detected, a message is logged to the MID Server Issue 
[ecc_agent_issue] table, and the upgrade is blocked. The AutoUpgrade monitor continues to run 
every hour, until all the tests pass. If there are no blocking issues, the MID Server downloads the 
appropriate upgrade package and begins the upgrade process. The MID Server pre-upgrade 
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check also runs for the upgrades triggered by the instance when the instance was upgraded, as 
well as for manual upgrades.

Pre-upgrade tests

The pre-upgrade runs two sets of tests: Mandatory testsand Alert tests. Every mandatory test 
is required to pass to start MID Server upgrade. If a mandatory test was not passed, the test 
is recorded in the agent log and a MID Server active issue  is created in the MID Server issue 
[ecc_agent_issue] table. These errors are published before the actual MID Server upgrade 
occurs and must be resolved before the upgrade can continue. MID Server stops the Upgrade 
process and changes the status based on MID Server states. If any alert test was not passed, 
a message is added in the agent log and MID Server issue table, but the pre-upgrade check 
continues and MID Upgrade doesn’t stop.

Pre-upgrade validation tests check the following mandatory tests:

• At least 1 GB of free disk space

• Access to the download site at install.service-now.com

• Verify the digital signature of a sample downloaded file

• Permission to execute, which involves the following:

◦ Extract a Zip archiver to a temp folder

◦ Copy file from temp folder to the agent folder

◦ Read a text file and validate the content

◦ Delete the pre-upgrade check contents

• MID Server host machine is not a 32 bit system

• On Linux MID Servers, the glibC version is at least 2.17

On Windows MID Servers, the pre-upgrade validation runs the following alert tests:

• Any MID Server Upgrade blocker services is running on the host machine

• Status of Application Experience on the host machine

• The MID Server must run as a non-administrator user. If the current Log On As user  account 
for the MID Server is LocalSystem  or is a user that is part of the Administrators group, then the 
upgrade fails and generates an error log.

Errors that block the upgrade

These messages describe failing a mandatory test and are published to the MID Server Issue 
[ecc_agent_issue] table. Failure of any of these tests blocks the upgrade.

Not enough free disk space. The system reports <n> bytes free

This message is displayed when less than 1 GB of free disk space is detected on the 
MID Server host. This error is also written to the MID Server agent log.

Unable to download updates from the install server

This message indicates that either the MID Server host does not have permission 
to download the installation package from install.service-now.com, or network 
problems prevent connection. This error is also written to the MID Server agent log.

Signature verification failed:<message>

This message indicates that a Verification Exception has occurred when pre-
upgrade check tries to verify the digital signature of the downloaded check file.

Unable to verify digital signature:<message>
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This message indicates that the verification signature process was interrupted by 
an exception.

Unable to extract contents of pre upgrade check zip

This message indicates that the service account on the MID Server host does not 
have permission to extract the pre-upgrade ZIP archive to the temporary folder.

Unable to create folder <upgrade check file path>

This message indicates that the MID Server service account does not have 
permission to create the upgradeCheck folder for the pre-upgrade checking files in 
the agent/package path.

Unable to verify file permissions: <message>

This message indicates an exception has occurred when checking file permissions, 
such as a file that does not exist or access failure.

MID Server Windows Service is not running as LocalSystem or a local Administrator

This message warns that the Windows service is not running with the desired 
permissions.

Upgrade Failure: The host machine does not meet the minimum system requirements to 
upgrade the MID server.

MID upgrade is not supported on 32-bit host. Please refer to KB0863694  for more 
information.

Upgrade Failure: Host does not meet the minimum system requirements to upgrade the 
MID server. Please refer to MID Server product documentation on GlibC library for more 
information

This error can only occur for Linux MID Servers. Refer to Java version support  for 
more information.

Non-blocking warnings

These warnings are displayed in the MID Server Issue [ecc_agent_issue] table and do not 
prevent a Windows MID Server from upgrading:

Unable to parse $logOnAsUser

This message warns that the Log On As User value for the Windows service is not in 
either of these expected formats:

• user@domain.company.com

• domain\user

Unable to look up Log On As user's groups

When the instance attempts to look up the logged on user's group memberships, 
it executes the net user <username>  command. The instance expects a certain 
output structure by the Windows service from this command and issues this 
warning if the expected output does not match the actual output.

These PowerShell warnings are written only to the MID Server agent log. Because 
PowerShell is not required to use a MID Server, these configuration issues do not 
prevent a Windows MID Server from upgrading. However, these warnings might 
indicate issues in your environment that require attention.

Skipping PowerShell upgrade checks since PowerShell is not usable

PowerShell 3.0 (at a minimum) is not installed or powershell.exe is not available to 
the MID Server service user.
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Skipping Powershell test: Target folder has not been initialized

Skipping Powershell test: Unable to detect the service name

Service CiscoAMP running on the MID Server host machine is identified as a MID Server 
upgrade blocker

For more information, refer to KB0870329 .

The Application Experience is disabled on the MID Server host, which can cause the auto-
upgrade process to fail and the MID Server to go down. Enable the service on the host to 
ensure successful auto-upgrade

For more information, refer to KB0597552 .

Continuing with upgrade, but the following issue was encountered during upgradeCheck: 
<exception message>

This message indicates that there was an issue running the PowerShell portion of 
the pre-upgrade tests.

Disabling the pre-upgrade check

A MID Server configuration parameter called mid.upgrade.run_precheck  is set to true  by 
default, which allows the automatic pre-upgrade test to run. To disable these tests for a 
single MID Server, add this parameter to that MID Server's config.xml file and set it to false. 
To disable these tests for all MID Servers, add a new record to the MID Server Property 
[ecc_agent_property] table called mid.upgrade.run_precheck. Set the value of this property to 
false  and leave the MID Server  field blank.

Pinning a MID Server to a specific version

You can pin  all the MID Servers in your environment to a specific version by setting a system 
property, or you can configure specific versions for individual MID Servers.

Note: 
Under most circumstances, do not pin the MID Server to a specific version. Pinning the MID 
server can make it out of sync with the instance, and lead to broken functionality. Instead, 
let the instance determine which MID Server version to use.

Version control properties

These system properties control the version for all MID Servers:

• mid.buildstamp: Identifies the MID Server version with an identifier based on the date of 
the build. This property uses the format of mm-dd-yyyy-hhmm. The MID Server checks for 
version information hourly. If no override version is configured, the MID Server looks at the 
mid.buildstamp  property for the version to use. This property resets itself to the default version 
(the version that matches your instance version) when the instance is restarted or upgraded, 
so any user changes are lost at that time. The system appends the release name and patch 
information to the date and time format.

Warning: 
This property is not visible by default and should not be configured.

• mid.version.override: Sets an override condition for the current version for all MID Servers 
in your environment. This action pins the MID Servers to a single version and disables the 
automatic upgrade feature. This property is not visible in the base system and must be added 
to the System Property [sys_properties] table when it is set. For details, see Add a system 
property .
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When the MID Servers check the version each hour, they look at the mid.version.override 
property first. If this property is empty, the MID Servers get their version information from the 
mid.buildstamp  property. If an override version is configured, the MID Servers use this value 
and ignore the version information in the mid.buildstamp  property. This override value remains 
when the instance is restarted and is passed to the MID Servers.

Important: 
The value in the mid.version.override  property is cleared during an upgrade, which 
forces the MID Server to reset itself to the version in the mid.buildstamp  property.

Version control configuration parameter

To pin specific MID Servers on a desired version, set the mid.pinned.version  parameter with the 
name of that version in the config.xml  file of each MID Server. Use the format <version>-mm-
dd-yyyy. This setting overrides the property setting for the pinned MID Server version. The MID 
Server version is checked every 20 minutes or whenever the MID Server restarts, at which point 
the pinned version is applied. For instructions, see Add a MID Server parameter.

Note: 
The value set in this parameter is not affected by an upgrade.

Upgrade the MID Server manually

You can manually upgrade MID Servers at any time if you do not want to wait for the automatic 
upgrade.

Before you begin
Role required: mid_server or admin
For the upgrade to run, MID servers must be in the Up  state and must be validated. The MID 
Server automatically runs the pre-upgrade test  before upgrading. Any errors encountered during 
this test must be resolved for the upgrade to proceed.

About this task
The MID Server is upgraded to the version specified by build stamp on the instance, or by the 
upgrade property  that you specify.

Procedure

1. Navigate to All  > Discovery  > MID Servers  or Orchestration  > MID Server Configuration  > 
MID Servers.

2. Open the record of the MID Server that you want to upgrade.

3. Click Upgrade MID  under Related Links.

4. Confirm that you want to perform the upgrade.

Resolving MID Server issues

Troubleshoot problems with the MID Server to find solutions. Monitor the MID Server to 
receive alerts about issues as they occur. Troubleshooting procedures exist to resolve specific 
problems with the MID Server. The Knowledge Base on Hi contains several articles to help you 
troubleshoot MID Server issues.

Monitor the MID Server

Monitoring a MID Server involves verifying entries in log files, confirming network connectivity, 
and checking MID server status.
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• If the MID Server is on a Windows host, navigate to the Windows Services console, locate the 
service name that matches the name that appears from the wrapper-override.conf  file. 
If the MID Server process is the only Java process running on the host, monitor the memory 
used by java.exe and alert on less than the maximum configured memory defined in the ~
\agent\conf\wrapper-override.conf  folder.

• Ensure that the agent0.log.0.lck  file appears in the ~\agent\logs  folder to confirm 
that the MID Server running and logging system activity in the agent0.log.0  file.

• Review the following logs for warning, critical, and severe errors: ~\agent\logs
\agent0.log.0  ~\agent\logs\wrapper.txt  See Manage ECC Queue content for a 
MID Server  to see how to open log entries from the instance.

• Test MID Server connectivity  to confirm that the MID Server host is able to communicate with 
the instance. Resolve any issues with the network connectivity such as conflicts with firewalls, 
access control lists, and routing errors.

• From the MID Server instance, navigate to the MID Servers  page, and review the status of the 
MID Server. For additional information, click a Name.

• Set up email, SMS, and push notifications to alert you when issues occur with MID servers. The 
MID Server Down  notification is enabled by default. See Notifications  for details.

Java Flight Recorder

Java Flight Recorder (JFR) uses an articulate data model to analyze Java Virtual Machine (JVM) 
internal and application specific memory usage and thread related details. On hosts with Java 14 
or later, Event Streaming enables analysis of specific JVM or application events.

The JFR file actions Start JFR Recording, Stop JFR Recording, or Write JFR File, are accessed 
on the instance in the MID Server's Related Links. By starting and stopping the JFR recording, 
you can dump JFR data to the disk on demand. While JFR recording is on, you can write to the 
JFR file from the MID Server instance page.

The JFR file is deleted by a scheduler to clean the data after 24 hours. This default behavior can 
be overridden by adding the following configuration parameter in the config.xml: <parameter 
name="mid.jfr.data.clean.interval" value="<time in milisec>"/>

Custom JFR events can be written to JFR file. To disable event writing, add 
the following configuration parameter to the config.xml: <parameter 
name="mid.jfr.record.aprobe" value="false”/>

Troubleshooting procedures

The following procedures provide information on resolving specific problems with the MID 
Server. Knowledge Base articles also cover a wide range of issues. If you are encountering 
problems which are not covered in these procedures, search the Knowledge Base for related 
articles. For instance, if you are experiencing symptoms such as the MID Server going down or 
not responding, or CIs being duplicated during discovery, see KB0597571  for information and 
recommended solutions.

MID Server active issues
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The ServiceNow®  instance has a dedicated table that publishes active issues with 
MID Servers and alerts administrators when a MID Server is in danger of exceeding 
its resources.

Active MID Server post-cloning credential issues

The system provides automatic processes to detect and notify you of possible MID 
Server credential issues after instance cloning.

MID Server resource threshold alerts

The instance displays warnings when a MID Server breaches its resource 
thresholds for CPU and JVM memory usage, enabling users to create email 
notifications or custom scripts when a breach occurs.

MID Server user connectivity issues

The instance writes issues involving MID Server user logins and network 
connectivity to the MID Server Issue [ecc_agent_issue] table and creates events 
you can use in custom scripts or to send email notifications.

Interpreting MID Server user debugging output

Debugging output from the system log is available in either a summary or detailed 
view for MID Server user issues, but must be enabled manually.

MID Server Upgrade History

Use this module to troubleshoot errors that occur during the MID Server upgrade 
process. The MID Server Upgrade Histories table contains a record of each instance 
upgrade. The MID Server Upgrade Stages table shows the status of each MID 
Server and its upgrade progress, including any errors encountered.

MID Server active issues

The ServiceNow®  instance has a dedicated table that publishes active issues with MID Servers 
and alerts administrators when a MID Server is in danger of exceeding its resources.

The MID Server Issue [ecc_agent_issue] table displays a number of common issues that a MID 
Server can experience, as they occur. Error checking processes attempt to pinpoint the most 
likely cause of the issue. Informative error messages name the affected MID Server and explain 
the possible cause of the issue. The ecc_agent_issue table retains its records for 30 days.

To access records in this table, navigate to MID Server  > Server Issues.

Supported MID Server active issues:

• Bad user credentials after instance cloning.

• Unsupported Java Runtime Environment (JRE)  on the MID Server host.

• Approaching resource thresholds  for CPU usage and JVM memory.

• Errors detected during pre-upgrade testing.

• User authentication  and authorization failures.

• Network connectivity interruptions  and role configuration errors.
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Example MID Server Issue record

MID Server fails to start

When a newly installed MID Server fails to start or shuts down prematurely, improper 
configuration could be to blame.

Duplicate MID Server names

When the MID Server service starts, it verifies that it is the only active (not down) MID Server 
with that name. If the MID Server discovers another active MID Server with the same name, 
the starting MID Server waits 5 minutes and sends another query. The MID Server repeats this 
query 12 times and logs each attempt in the agent log. If the IP address or home directory of an 
existing MID Server is changed, then that MID Server is invalidated. If the MID Server still detects 
a duplicate after this cycle, it creates a record in the MID Server Issue [ecc_agent_issue]  table 
and shuts down.

Note: 
The record in the MID Server Issue [ecc_agent_issue] table cannot be resolved 
automatically by the instance. Close this record manually for accounting purposes. Either 
mark the issue Resolved  or delete it.

Upgraded MID Servers running multiple services

Beginning with the New York release, a batch file in the MID Server installer package ensures 
that only one Windows MID Server service is configured for an executable path (MID Server 
installation folder). Previous versions have not checked for this configuration. Upgraded MID 
Servers that run multiple services with the same executable path are prevented from starting. If 
you experience this issue, follow this procedure to reconfigure the MID Server to use only one 
service:

1. Delete the unwanted Windows service by running sc.exe delete <service name>  from the 
command line.

2. Open the wrapper-override.conf  file in the MID Server installation folder.
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3. Change the wrapper.name  and wrapper.displayname  parameters to the service name that 
you want to keep.

4. Restart the MID Server.

Active MID Server post-cloning credential issues

The system provides automatic processes to detect and notify you of possible MID Server 
credential issues after instance cloning.

During an instance clone, the MID Server [ecc_agent] table is not copied from the source 
instance, but the User [sys_user] table is copied. As a result, the source MID Server user 
credentials copied into the target instance might not match those used by the existing set of 
MID Servers used by the target. Bad credentials can cause those MID Servers to be down for the 
target instance. Processes on the instance notify you if a MID Server is down from suspected bad 
credentials following an instance clone.

Table for post-cloning credential issues

The MID Server Issue [ecc_agent_issue] table stores active MID Server issues after an instance 
clone. Records in this table show a MID Server's current state, evaluation times, and the 
Issue source. For cases in which a MID Server for a cloned instance is down because of 
possible bad credentials, the Issue source  is InstanceClone. Data from the MID Server Issue 
[ecc_agent_issue] table are displayed in a related list on a MID Server record. Records in this 
table are removed if they have not been detected for 30 days. Ongoing issues reappear as they 
occur.

Post-cloning cleanup script and scheduled jobs

A cleanup script called Bad MID Server credentials after clone 
runs on the target instance after cloning and calls a script include called 
BadMIDCredentialAfterClone. This script include schedules the execution of the 
following jobs on the Schedule Item [sys_trigger] table:

• BadMIDCredentialAfterClone-1: Runs 15 minutes after clone execution.

• BadMIDCredentialAfterClone-2: Runs 75 minutes after clone execution.

These jobs log to the MID Server Issue [ecc_agent_issue] table any MID Servers that existed on 
the target instance prior to the clone that are in the Down  state. These MID Servers are not ready 
for normal processing and might be down due to invalid credentials resulting from the cloning 
process. The state of MID Servers added to the target instance after the clone is not evaluated.

Note: 
The MID Server log  shows that the MID Server user associated with the target instance 
could not be authenticated or was missing the proper role.

Business rule that checks for bad credentials

The Check for bad MID credential after clone  business rule monitors the MID Server 
[ecc_agent] table for MID Servers that are transitioning from Down  to Up. If the business rule 
finds a MID Server making that transition, the rule attempts to find a matching MID Server in the 
MID Server Issue [ecc_agent_issue] table that has an issue source of InstanceClone  and a state 
other than Resolved. If a match is found, the business rule updates the state of the MID Server in 
the [ecc_agent_issue] table to Resolved.
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Resolving MID Server issues

The error message in the MID Server Issue [ecc_agent_issue] table names the affected MID 
Server user. This message appears each time the business rule runs and finds a MID Server that 
is down from suspected bad credentials:MID Server not operational (status: 
Down), possibly due to recent clone. Verify credentials for 
logged in User 'local-midserver'.

Attempt to resolve the issue first by comparing the user's credentials with the credentials that the 
affected MID Server is expecting. If the credentials are incorrect, fix the problem and check the 
MID Server status again. If the credentials are correct, but the MID Server remains down, check 
the Knowledge Base  for other possible causes.

MID Server resource threshold alerts

The instance displays warnings when a MID Server breaches its resource thresholds for CPU 
and JVM memory usage, enabling users to create email notifications or custom scripts when a 
breach occurs.

The MID Server Issue [ecc_agent_issue] table warns users when a MID Server exceeds 
configured thresholds of its allocated CPU and memory resources. These warnings are 
published before the MID Server experiences performance degradation or an out-of-memory 
error, enabling the administrator to increase resources and avoid downtime. Administrators can 
use a registered event to send email notification to selected recipients, advising them of any 
threshold breaches, or to create a custom script to do some other type of work. The instance 
continues to update the MID Server Issue [ecc_agent_issue] table to keep unresolved issues 
current.

By default, CPU and memory threshold alerts are disabled and no alerts are published to the MID 
Server Issue [ecc_agent_issue] table. To enable both types of alerting, add these properties to 
the System Property [sys_properties] table, and then set their values to true:

• mid.threshold.resource.breach.enable.cpu.alerts

• mid.threshold.resource.breach.enable.memory.alerts

For details on adding system properties to the platform, see Add a property using 
sys_properties.list .

Evaluation process

This processing occurs whether or not alerting is enabled:

1. Every 10 minutes, each MID Server transmits its CPU and memory consumption metrics to the 
instance. The instance inserts CPU metrics into the Mean CPU used %  field of the ECC Agent 
Scalar Metrics [ecc_agent_scalar_metric] table and memory metrics into the Max memory 
used %  field of the ECC Agent Memory Metrics [ecc_agent_memory_metric] table.

2. After a successful insert, the following business rules run on each table, invoking a script 
include that calls an appropriate function. Each function takes an average of the metric sets 
inserted into the tables, based on the configured sampling intervals.

◦ Update cpu mean on MID Server Status: Calls the 
MIDResourceThresholdBreach.checkCpuUsage()  script include.

◦ Update max memory on MID Server Status: Calls the 
MIDResourceThresholdBreach.checkMemoryUsage  script include.

Each function takes an average of the metric sets inserted into the tables, based on the 
configured thresholds and sampling intervals. The instance first looks at each MID Server for 
configuration parameters that set custom threshold values or sampling intervals for that MID 
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Server. If no configuration parameters for these attributes are found, the instance looks in the 
System Properties [sys_properties] table for custom values to use. If no properties are found, 
the instance uses the default threshold and interval values from the code.

Note: 
Both the threshold percentages and the sampling intervals are configurable. See 
Configuring thresholds and sampling intervals  for details.

Alerting process

When alerting for CPU or memory thresholds is enabled, this processing occurs:

1. If the aggregated average metric value equals or exceeds the configured percent threshold, 
the instance triggers the mid.threshold.resource.breach  event. Administrators can 
use this event to create email notifications  for threshold breach alerts or to create a custom 
script.

2. The instance inserts a record of the breach into the MID Server Issue [ecc_agent_issue] 
table with a State  value of New  and a Count  of 1, and then publishes a message containing 
all the pertinent details of the breach. An example of this message is Mean CPU used % 
has exceeded threshold (96>=91) for a 40 minute interval span, 
occurring after start date 2017-01-11 14:25:19. This message appears 
in the Short description  field of the MID Server Issue form and in the event. You can copy any 
part of the message into your email notifications.

MID Server issue states

When the administrator first examines an issue in the MID Server Issue [ecc_agent_issue] 
table, the administrator can change the State  of the issue to Acknowledged  to indicate that 
the issue is being addressed. Each time the instance detects a breach, it attempts to match the 
breach with an existing issue. If a MID Server already has an issue record for that breach in a 
State  of New  or Acknowledged, the instance updates the Last Detected  field with the current 
date/time and increments the Count  field in the existing record. This prevents the creation of 
duplicate records in the MID Server Issue [ecc_agent_issue] table and records the number of 
times after the initial incident that the breach reoccurred. The administrator can increase MID 
Server resources gradually and watch the effect on the Count  field. When the counter stops 
incrementing, the administrator knows that the MID Server has adequate resources. When 
the MID Server resource have been adjusted appropriately, the administrator sets the State  to 
Resolved. If a new threshold breach is logged that matches a MID Server issue with a State  of 
Resolved, the instance creates a new issue record.

Note: 
Any record in the MID Server Issue [ecc_agent_issue] table that has not been updated in 
30 days is deleted, regardless of its state.

Recommendations for resolving resource issues

Administrators have the opportunity to resolve any resource issues with a MID Server when they 
receive notification of the event. Follow these recommendations for reducing the strain on MID 
Server resources:

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3023

https://www.webstg.servicenow.com/docs/access?context=t_CreateANotification&version=washingtondc&pubname=washingtondc-platform-administration&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=t_CreateANotification&version=washingtondc&pubname=washingtondc-platform-administration&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=t_CreateANotification&version=washingtondc&pubname=washingtondc-platform-administration&ft:locale=en-US


• JVM memory:

◦ Allocate more max memory to the MID Server. For more information, see Set the MID Server 
JVM memory size.

◦ Add additional MID Servers to share the workload. For more information, see MID Server 
clusters.

◦ Reduce the amount of concurrent processing for the MID Server. This includes segmenting 
IP Address ranges into smaller segments for a Discovery schedule or loading smaller 
segments of data within an import job.

• CPU: Reduce the activity on the host or migrate the MID Server to a new host with more 
available resources.

Note: 
MID Server can create a resource usage spike during Discovery, especially discovering 
against a large number of targets or executing multiple Power Shell sessions 
concurrently. The MID Server host’s resource utilization automatically returns to normal 
after the Discovery execution successfully stops. To decrease CPU utilization, host the 
MID Server on a dedicated machine. If you encounter resource usage issues, make sure 
only one MID Server is run on each dedicated host machine. If the MID Server is hosted 
on a public cloud, add more CPU resources and avoid the noisy neighbor issue. For more 
information, see High CPU Usage on Host with MID Server(s) [KB0597639] .

Tables used for resource threshold evaluation

Table Description

MID Server Issue [ecc_agent_issue] Stores data on various types of MID Server 
issues, including breaches of configured 
CPU and memory thresholds. Fields used for 
resource threshold breaches are:

• count: Number of times a previously 
reported threshold breach occurs, if the 
event is not marked Resolved.

• last_detected: Current date and time a 
threshold breach is detected. This field is 
updated each time a previously detected 
breach is found, if it is not marked Resolved.

• message: Descriptive message 
summarizing the conditions that triggered 
the threshold breach event. This message 
includes the actual percentage of CPU and 
memory calculated and the configured 
thresholds that were breached.

• mid_server: Name of the MID Server 
experiencing the resource threshold breach.

• source: The issue source for the breach. 
These are the possible sources:
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Table Description

◦ CpuMIDResourceThresholdBreach: CPU 
threshold issue sources.

◦ MemoryMIDResourceThresholdBreach: 
Memory threshold issue sources.

MID Server Status [ecc_agent_status] Stores the percentages used for the CPU 
and memory resources, averaged over 
configurable intervals for each resource. The 
fields used are:

• Mean CPU used %

• Max Memory used %

ECC Agent Scalar Metric 
[ecc_agent_scalar_metric]

Stores the CPU usage data inserted by each 
MID Server every 10 minutes. The table field 
used by resource threshold alerting is mean.

ECC Agent Memory Metric 
[ecc_agent_memory_metric]

Stores the memory usage data inserted by 
each MID Server every 10 minutes. The table 
field used by resource threshold alerting is 
max_used_pct.

Business rules that check for threshold breaches

Business rule Description

Update cpu mean on MID Server Status Runs after the MID Server inserts 
a record into the ECC Agent Scalar 
Metric [ecc_agent_scalar_metric] 
table. This business rule triggers the 
MIDResourceThresholdBreach  script 
include function that evaluates threshold 
settings to determine if the MID Server 
has breached its configured CPU resource 
thresholds.

Update max memory on MID Server Status Runs after the MID Server inserts a 
record into the ECC Agent Memory 
Metric [ecc_agent_memory_metric] 
table. This business rule triggers the 
MIDResourceThresholdBreach  script 
include function that evaluates threshold 
settings to determine if the MID Server has 
breached its configured memory resource 
thresholds.

Configuring thresholds and sampling intervals

You can use the default threshold percentages and sampling intervals or configure custom 
values using either of these methods:
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• Add system properties  to the instance and change the default values for all MID Servers.

• Add configuration parameters  to change the default resource values for individual MID 
Servers.

The system properties and the configuration parameters use the same names.

Property/configuration parameter Description

mid.threshold.mean_cpu.aggregate_interval_spanNumber of 10 minute units in the interval for 
sampling CPU usage data. The default interval 
is 30 minutes (3 x 10 min.)

Default: 3

mid.threshold.mean_cpu.percent Usage percentage of the total CPU resources 
that initiates a threshold breach alert.

Default: 95

mid.threshold.mean_max_memory.aggregate_interval_spanNumber of 10 minute units in the interval for 
sampling memory usage data. The default 
interval is 30 minutes (3 x 10 min.)

Default: 3

mid.threshold.mean_max_memory.percent Usage percentage of the total memory 
resources that initiates a threshold breach 
alert.

Default: 95

MID Server resource reporting

The MID Server dashboard  contains two reports that give you views into the consumption of CPU 
and JVM memory resources. These reports show usage over the previous 30 days.

• Avg Percentage of CPU Used: Trending the daily average on CPU usage helps illustrate the 
amount of CPU processing that the MID Server host consumes. MID Servers deployed on the 
same host will report the same CPU usage.

• Avg Percentage of Max Memory Used: The maximum used percentage (max_used_pct) is 
a useful metric for determining if the MID Server has enough memory resources. This metric is 
a percentage of the max used memory over the total available memory. Trending this over time 
provides a visualization of how much memory is needed by the MID Server.

MID Server user connectivity issues

The instance writes issues involving MID Server user logins and network connectivity to the MID 
Server Issue [ecc_agent_issue] table and creates events you can use in custom scripts or to 
send email notifications.

Records in the MID Server Issue [ecc_agent_issue] table can provide insight into why your 
MID Server user cannot log in or why a MID Server cannot connect to the instance. The system 
displays records for connectivity problems in this table that include informative error messages 
suggesting possible causes. By default, a scheduled job called MIDUserConnectivity runs 
every four hours and launches the MIDUserConnectivity script include to evaluate MID Server 
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connection activity. Records in the MID Server Issue [ecc_agent_issue] table reflect the status of 
MID Server login attempts and connectivity at the time the scheduled job runs.

From the perspective of the instance, the MID Server is Down  when:

• User authentication fails

• User authorization fails.

• Network issues prevent MID Server from establishing a TCP/IP connection.

Note: 
To associate a user with a MID Server, navigate to the servicenow/<mid 
server name>/agent/config.xml  file and enter the user credentials in the 
mid.instance.username  and mid.instance.password  parameters. Make sure to restart the 
MID Server to activate your changes.

How issues are logged

User authentication failures and authorization issues are logged automatically to the MID Server 
agent log file. The message for both is the same: User cannot be authenticated or is missing the 
proper roles.  If the issue is related to authorization, the agent.log  file shows the list of missing 
roles.

When debugging is enabled, MID Server issues are logged to the system log (syslog) and are 
available for display in either a summary or a detailed  format. You can also change the sampling 
interval from the default 4 hours to something shorter for tracking your remediation efforts. 
For instructions on enabling and configuring debugging for MID Server user issues, see Test 
remediation efforts for MID Server user connectivity issues.

Data provided

When the instance encounters user connectivity issues, it opens a record in the MID Server 
Issue [ecc_agent_issue] table.

Example user authentication error message
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The MID Server Issue table contains these fields:

MID Server issue fields

Field Description

Last detected Date and time the issue was last detected.

Short description Contents of the generated message that 
specifies a possible issue with the named user 
or the MID Server.

MID Server Empty in the Jakarta release.

Issue source The process that identified the issue. For all 
issues with MID Server user connectivity, the 
source is MIDUserConnectivity.

State The current state of the issue. Possible states 
are:

• New: Starting state when the instance 
creates the issue.

• Acknowledged: State set when the 
administrator first examines the issue.

• Resolved: Ending state, set by the instance, 
indicating that the issue has been resolved. 
If the scheduled job does not encounter 
the issue when it runs again, the instance 
automatically sets this value.

Domain Domain associated with the MID Server user 
account.

Count Number of times an issue has been detected. 
Each time the scheduled job runs and 
encounters the same issue, it increments this 
field.

User authentication failure

The credentials that the instance uses to authenticate a MID Server user are configured in the 
MID Server Configuration Parameters [ecc_agent_config] table. If the MID Server user attempts 
to log into the instance with invalid credentials, the instance rejects the connection, and writes 
the login.failed  event to the Events [sysevents] table for the user. Administrators can use this 
event in a custom script or in email notifications  for authentication failure.

Note: 
If user authentication fails, user authorization is not attempted.

User accounts associated with a MID Server

Either of the following messages in the MID Server Issue [ecc_agent_issue] table indicate 
authentication failure for user accounts that are associated with a MID Server:
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• Login authentication failure for User <user name> associated with 1 down MID Server. 
Check password on MID server.

• Login authentication failure for User <user name> associated with <n> down MID Servers. 
Check password on MID servers.

The necessary conditions for these messages to appear are:

• The Status  field in the MID Servers [ecc_agent] table that is associated with the MID Server 
indicates that the MID Server is Down.

• The user identified in the MID Server Configuration Parameters [ecc_agent_config] table is the 
user that one or more MID Servers is configured to use for authentication and authorization 
when connecting to the instance. The record in the [ecc_agent_config] table must have these 
values:

◦ Parameter name [param_name] field set to mid.instance.username.

◦ Value [value] field set to the user’s name, corresponding to the User ID [user_name] field in 
Users [sys_user] table.

• The Events [sysevent] table contains posts showing that the last login attempt associated with 
the user failed during the scheduled time period. The record created in the [sysevent] table 
contains these field values:

◦ Event Name [name] field is set to login.failed.

◦ Parm1 [parm1] field is set to the user’s name.

Note: 
The MID Server [mid_server] field in the MID Server Issues [ecc_agent_issue] table is 
empty (=NULL).

User accounts with the mid-server role not associated with a MID Server

The following message appears when a user with the mid_server role who is not associated 
with a MID Server fails to authenticate: Login authentication failure for User <user name> with 
mid_server role not associated with a MID Server.

The necessary conditions for this message to appear are:

• The User Roles [sys_user_has_role] table contains a record linking the sys_id associated with 
the user record stored in the [sys_user] table, with the sys_id associated with the mid_server 
role record stored in the [sys_user_role] table.

• The user is not identified in the MID Server Configuration Parameters [ecc_agent_config] 
table as the user whom one or more MID Servers are configured to use for authentication and 
authorization when connecting to the instance.

• The Events [sysevent] table contains posts showing that the last login attempt associated with 
the user failed during the scheduled time period.

◦ The [sysevent] table contains a record with the Event Name [name] field set to login.failed.

◦ The Parm1 [parm1] field is set to the user’s name, corresponding to the User ID [user_name] 
field in Users [sys_user] table.

Note: 
The MID Server [mid_server] field in the MID Server Issues [ecc_agent_issue] table is 
empty (=NULL).
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User authorization failure

The user authorization check occurs after the MID Server has successfully authenticated on the 
instance. In this step, the system ensures that the user account associated with a MID Server is 
granted the minimum roles required. A SOAP web service called MIDServerCheck  performs 
the role checking on the instance. If the MID Server user has the proper roles, the connection is 
allowed and a login  event is written to the Events [sysevents] table. If the user does not have 
the proper roles, the instance writes a login.authorization.failed  event to the Events [sysevents] 
table. This event provides a comma separated list of the user's missing roles. Administrators can 
use this event in custom scripts or in email notifications  for authorization failure.

Authorization can fail if a user is missing the mid_server role or any of the important SOAP roles, 
as in these cases:

• If the user has the soap_script role, the MIDServerCheck  SOAP web service runs to check 
for the appropriate MID Server roles. If the user lacks the mid_server role or any of the other 
SOAP roles, authorization fails, and the login.authorization.failed  event is created.

• If the user is missing the soap_script role, that user is not authorized to launch the 
MIDServerCheck  SOAP web service, which checks for all required MID Server roles. 
Authorization fails, but the login.authorization.failed  event is not created. When this occurs, 
the instance displays this message: Connectivity of MID Server user <user name> cannot be 
detected by the instance.

Users associated with one or more down MID Servers

Either of the following messages in the MID Server Issue [ecc_agent_issue] table indicate 
authorization failure for user accounts that are associated with a MID Server that is Down:

• Login authorization failure for User <user name> associated with 1 down MID Server. Re-
assign mid_server role to grant all required roles.

• Login authorization failure for User <user name> associated with <n> down MID Servers. Re-
assign mid_server role to grant all required roles.

The MIDUserConnectivity  script include identifies active users associated with one or more 
down MID Servers whose last login attempt within the reporting period failed user authorization. 
This message is generated when user authorization failures are detected and reported by the 
MIDServerCheck scripted web service. However, user authorization failures are not reported for 
users who are not assigned the soap_script role. Should this occur, problems with the user are 
reported by the network connectivity message.

This message appears in the MID Server Issue [ecc_agent_issue] table when:

• The user may or may not have the mid_server role.

• The user is identified in the MID Server Configuration Parameters [ecc_agent_config] table 
as the user whom one or more MID Servers are configured to use for authentication and 
authorization when connecting to the instance.

• The Events [sysevent] table contains posts showing that the last login attempt associated with 
the user failed during the scheduled time period. The [sysevent] table contains a record with 
these settings:

◦ Event Name [name] field set to login.authorization.failed.

◦ Parm1 [parm1] field set to the user’s name, corresponding to the User ID [user_name] field in 
Users [sys_user] table.

Note: 
The MID Server [mid_server] field in the MID Server Issues [ecc_agent_issue] table is 
empty (=NULL).
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Users with the proper role not associated with a MID Server

The following message appears when a user with the mid_server role who is not associated 
with a MID Server fails authorization: Login authorization failure for User <user name> with 
mid_server role not associated with a MID Server.

This message is generated when user authorization failures are detected in which the user 
account, with the mid_server role, is not identified as a configured MID Server user in the 
[ecc_agent_config] table. It is possible that the user account was associated with a MID Server at 
the time of the failure.

This message appears in the MID Server Issue [ecc_agent_issue] table when:

• The user has the mid_server role. The User Roles [sys_user_has_role] table has a record 
linking the sys_id associated with the user record stored in the [sys_user] table, with the sys_id 
associated with the mid_server role record stored in the [sys_user_role] table.

• The user is not identified in the MID Server Configuration Parameters [ecc_agent_config] 
table as the user whom one or more MID Servers are configured to use for authentication and 
authorization when connecting to the instance.

• The Events [sysevent] table contains posts showing that the last login attempt associated with 
the user failed during the scheduled time period. The [sysevent] table contains a record with 
these settings:

◦ Event Name [name] field set to login.authorization.failed.

◦ Parm1 [parm1] field set to the user’s name, corresponding to the User ID [user_name] field in 
Users [sys_user] table.

Note: 
The MID Server [mid_server] field in the MID Server Issues [ecc_agent_issue] table is 
empty (=NULL).

Network issues

A network issue can prevent the MID Server from connecting to the instance's TCP/IP server to 
begin a session. In this case, the instance marks the MID Server as Down, because the instance 
failed to receive the MID Server heartbeat within the prescribed 5 minute interval.

Users associated with down MID Servers who have not attempted to log in

Either of the following messages in the MID Server Issue [ecc_agent_issue] table name users 
associated with MID Servers who have not attempted to log in during the reporting period:

• User <user name> is associated with 1 down MID Server. No login attempts within reporting 
period.

• User <user name> is associated with <n> down MID Servers. No login attempts within 
reporting period.

The MIDUserConnectivity script include reports active users associated with down MID Servers 
where network connectivity cannot be detected by the instance.

This message appears in the MID Server Issue [ecc_agent_issue] table when:
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• The user may or may not have the mid_server role.

• The user is identified in the MID Server Configuration Parameters [ecc_agent_config] table 
as the user which one or more MID Servers are configured to use for authentication and 
authorization when connecting to the instance.

• There are no login attempts, either failed or successful, recorded in the Events [sysevent] table 
for the user during the scheduled reporting period.

Note: 
The MID Server [mid_server] field in the MID Server Issues [ecc_agent_issue] table is 
empty (=NULL).

Users not associated with MID Servers who have not attempted to log in

The following message appears when a user with the mid_server role who is not associated with 
a MID Server has not attempted to login during the configured reporting interval: User <user 
name> with mid_server role is not associated with a MID Server. No login attempts within 
reporting period.

The MIDUserConnectivity script include reports active users with the mid_server role not 
associated with a MID Server, where connectivity cannot be detected by the instance.

This message appears in the MID Server Issue [ecc_agent_issue] table when:

• The user has the mid_server role. The User Roles [sys_user_has_role] table has a record 
linking the sys_id associated with the user record stored in the [sys_user] table, with the sys_id 
associated with the mid_server role record stored in the [sys_user_role] table.

• The user is not identified in the MID Server Configuration Parameters [ecc_agent_config] 
table as the user whom one or more MID Servers are configured to use for authentication and 
authorization when connecting to the instance.

• There are no login attempts, either failed or successful, recorded in the Events [sysevent] table 
for the user during the scheduled reporting period.

Note: 
The MID Server [mid_server] field in the MID Server Issues [ecc_agent_issue] table is 
empty (=NULL).

Configuration issues

Any of the following messages, discussed above, can indicate a configuration issue:

• Login authentication failure for User <user name> with mid_server role not associated with a 
MID Server.

• Login authorization failure for User <user name> with mid_server role not associated with a 
MID Server.

• User <user name> with mid_server role is not associated with a MID Server. No login 
attempts within reporting period.

These are some common configuration errors:

• An administrator neglected to associate the user record with the MID Server record as shown 
in the MID Server Configuration Parameters [ecc_agent_config] table. This table is read-only 
and cannot be updated directly. To associate a user with a MID Server, configure the user 
name and password in the MID Server's config.xml  file and restart the MID Server.
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• During the process of reconfiguring a MID Server to use a different account for TCP/IP 
connection, the administrator has not yet removed the mid_server role from the account or 
deleted the account.

• A multipurpose user account was created and granted a large number of roles, including 
the mid_server role, although this account was never intended to be used as a MID Server 
account.

User who successfully authenticates and authorizes but might not need mid_server role

The following message appears when a user with the mid_server role who is not associated 
with a MID Server successfully logs in: User <user name> with mid_server role successfully 
connected but not associated with a MID Server. The mid_server role should be reserved for 
MID Server use only.

The MIDUserConnectivity script include reports active users with the mid_server role who are not 
identified as a configured MID Server user, and whose last login attempt was successful during 
the scheduled time period. This message suggests that the user’s credentials are being used 
by a system administrator or a process that is not running on a MID Server. The assumption here 
is that the mid_server role should only be used for applications deployed to a MID Server. The 
presence of this message reminds the system administrator to remove extraneous mid_server 
roles from user accounts that do not require them.

This message appears in the MID Server Issue [ecc_agent_issue] table when:

• The user has the mid_server role.

• The user is not identified in the MID Server Configuration Parameters [ecc_agent_config] 
table as the user whom one or more MID Servers are configured to use for authentication and 
authorization when connecting to the instance.

• The Events [sysevent] table contains posts showing that the last login attempt associated with 
the user succeeded during the scheduled time period. The [sysevent] table contains a record 
with these settings:

◦ Event Name [name] field set to login.

◦ Parm1 [parm1] field set to the user’s name, corresponding to the User ID [user_name] field in 
Users [sys_user] table.

Note: 
The MID Server [mid_server] field in the MID Server Issues [ecc_agent_issue] table is 
empty (=NULL).

Test remediation efforts for MID Server user connectivity issues

After attempting to resolve a user connectivity issue that appears in the MID Server Issue 
[ecc_agent_issue] table, you can test your remediation efforts without having to wait until the 
next scheduled reporting period by shortening the sampling interval.

Before you begin
Role required: admin

About this task
Reconfigure the sampling interval using this procedure and then examine the results in the MID 
Server Issue [ecc_agent_issue] table. You can set any time span for the sample, but you should 
define a window of not less than 5 minutes, since this is the default interval of the MID Server 
heartbeat that reports its status. The recommended method for configuring a shorter sampling 
interval is to copy and modify the code from the MIDUserConnectivity scheduled job, and then 
run it manually in the background script utility.
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Warning: 
Avoid editing the script in the MIDUserConnectivity schedule record. If you make any 
change to this record, it will not be updated when you upgrade the instance.

Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Open the MIDUserConnectivity scheduled job.

3. Copy this line from the Run this script  field:
MIDUserConnectivity(0).checkConnectivity(4 * (60 * 60 * 1000));

This code sets the 4 hour sampling interval in milliseconds and turns debugging off with the 
MIDUserConnectivity(0)  value.

4. Navigate to System Definition  > Scripts - Background.

5. Paste the code from the scheduled job into the Run script  field.

6. Set the sampling interval to 5 minutes by changing the time calculation to (5 * 60 *1000).
The modified command looks like this: 
MIDUserConnectivity(0).checkConnectivity (5 * 60 *1000);

7. Click Run script.

8. Open the record of the MID Server that had the issue and select the MID Server Issues  related 
list.
The issue is updated as follows:

◦ If the issue persists, the Count  column is incremented, and the Last detected  column shows 
the current date and time.

◦ If the issue no longer exists, the system changes the State  to Resolved.

9. Optional:  You can enable debugging by selecting a level, and then run the script again to see 
the breakdown for each condition evaluated.
Use these settings to select a debugging level:

◦ For a summary view, enter MIDUserConnectivity(1).

◦ For a detailed view, enter MIDUserConnectivity(2).

For details about the type of debugging information provided, see Interpreting MID Server user 
debugging output.

Interpreting MID Server user debugging output

Debugging output from the system log is available in either a summary or detailed view for MID 
Server user issues, but must be enabled manually.

To enable debugging and display all connectivity issues in either of the available formats, you 
must run a method manually on your instance. For instructions on enabling debugging, see Test 
remediation efforts for MID Server user connectivity issues. For information about each error 
condition and how records are created in the MID Server Issue [ecc_agent_issue] table, see MID 
Server user connectivity issues.

Available formats

You can configure the instance to generate a simple summary of the issue or a detailed output 
that identifies users and MID Servers. Summaries provide a quick look at the issue conditions, 
by count, while the detailed view allows you to examine roles, MID Server associations, and login 
activity by named users.
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In this summary example of an authorization issue, the instance evaluates each condition and 
indicates how many users met that condition. You can see that a MID Server is down and that 
one of two users configured for a MID Server failed authorization. Because this is a summary, 
neither the MID Server nor the users are named.

Sample summary debug output

Authentication failure

When a MID Server user cannot authenticate on the instance, the system displays these error 
messages in the detailed output:

• Login authentication failure for User <user name> associated with 1 down MID Server. 
Check password on MID server.

• Login authentication failure for User <user name> associated with <n> down MID Servers. 
Check password on MID servers.

• Login authentication failure for User <user name> with mid_server role not associated with a 
MID Server.

In this example, three users with the mid_server role, midserver2, local-midserver, and 
ardis.maison, failed to authenticate. Two of these users were configured for MID Servers that 
were Down, and the other user was not configured for any MID Servers. Each of these users has 
an authentication failure and is named in the appropriate error message.
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Detailed debugging log for authentication failure

MID Server ID map

The debugging output lists all MID Servers that are marked as Down  and maps them to their 
user accounts by the MID Server sys_id. This map includes all user accounts that have the 
mid_server role, whether or not they are associated with a MID Server. If there are no Down  MID 
Servers, the map is not displayed in the debugging output.

The map is presented in three sections:

• User accounts not associated with any MID Servers.

• User accounts associated with Down  MID Servers, identified by their sys_id.

• The sys_id  of each Down  MID Server, identified by name.

MID Server ID map

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3036



Authorization failure

If a user is missing any of the required roles, the instance generates these authorization failure 
messages:

• Login authorization failure for User <user name> associated with 1 down MID Server. Re-
assign mid_server role to grant all required roles.

• Login authorization failure for User <user name> associated with <n> down MID Servers. Re-
assign mid_server role to grant all required roles.

• Login authorization failure for User <user name> with mid_server role not associated with a 
MID Server.

In this example, three users with the mid_server role, midserver2, local-midserver, and 
ardis.maison  have failed authorization. One user is not associated with any MID Server, but the 
other two users are. The system has logged an authorization failure, indicating that the user is 
missing at least one critical role. To see what roles are missing, look at the comma separated list 
in the Parm2  field in the login.authorization.failed  event record. This record is the most recent 
login attempt in the Event [sysevent] table for the user account within the reporting period.

Detailed debugging log for authorization failure

Network issues

Network issues may exist for these users who are associated with MID Servers, but who have not 
attempted to log in during the reporting period:

• User <user name> is associated with 1 down MID Server. No login attempts within reporting 
period.

• User <user name> is associated with <n> down MID Servers. No login attempts within 
reporting period.

Network issues may also exist for these users who are NOT associated with MID Servers, and 
who have not attempted to log in during the reporting period: User <user name> with mid_server 
role is not associated with a MID Server. No login attempts within reporting period.
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In this example, no login attempts have been detected for midserver2, local-midserver, and 
ardis.maison, all of whom have the mid_server role. Two of those users are associated with 
MID Servers that are marked Down. The other user is not associated with any MID Server. None 
of these users has attempted to log in to the system within the configured reporting interval. 
The system assumes that these users would make an attempt to log in unless network issues 
prevented them from doing so.

Note: 
By default, the sampling period is 4 hours. However, during debugging or remediation, the 
sampling period can be reset to a value that matches the MID Server heartbeat interval of 5 
minutes, or greater.

Detailed debugging log for network connection issues

Configuration issues

Any of the following messages can indicate a user configuration issue:

• Login authentication failure for User <user name> with mid_server role not associated with a 
MID Server.

• Login authorization failure for User <user name> with mid_server role not associated with a 
MID Server.

• User <user name> with mid_server role successfully connected but not associated with a 
MID Server. The mid-server role should be reserved for MID Server use only.

• User <user name> with mid_server role is not associated with a MID Server. No login 
attempts within reporting period.
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In this example, a user with the mid_server role has logged in successfully within the configured 
sampling interval. However, this user is not configured for a MID Server and might have the role in 
error.

Detailed debugging log for MID Server user account login

MID Server Upgrade History

Use this module to troubleshoot errors that occur during the MID Server upgrade process. The 
MID Server Upgrade Histories table contains a record of each instance upgrade. The MID Server 
Upgrade Stages table shows the status of each MID Server and its upgrade progress, including 
any errors encountered.

MID Server Upgrade Histories

Users with admin or agent-admin roles can find detailed information for any MID Server upgrade 
in the Upgrade History module for MID Server. Whenever an instance is upgraded, all MID 
Servers in the Up state are upgraded automatically. The Upgrade History module uses the MID 
Server Upgrade Histories table [ecc_agent_upgrade_history]. This table shows the following 
information:

• The old instance version.

• The new version.

• The number of successfully upgraded MID Servers.

• The number of MID Servers with pending upgrades. MID Servers have pending upgrades if the 
upgrade has failed or is in progress.

MID Server Upgrade Stages

Select an instance record to see more details about the MID Servers upgraded with that 
instance. The Pending Upgrades and Complete Upgrade Details related lists use the MID Server 
Upgrade Stages table [ecc_agent_upgrade_history_stage]. MID Servers pinned to a specific 
version generate an entry with a blank MID Upgrade History on the MID Server Upgrade Stages 
table [ecc_agent_upgrade_history_stage].

MID Upgrade History Refers to a corresponding record in the 
[ecc_agent_upgrade_history] table.

Stage Shows the progress of the MID Server through 
each stage of the upgrade process.

State Shows the status of each stage.

Message Displays dynamically generated messages 
about the upgrade stages, such as the file 
path to download directories or extract folders. 

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3039



It also displays information about any errors 
encountered, even if those errors do not block 
the upgrade.

MID Server reference information

MID Server reference information includes system requirements and other information you need 
to configure a MID Server for your specific needs.

1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

System clones and the MID server

See KB0547597  for information on what to do with MID Servers when you are cloning your 
instance.

Reference topics

System requirements

Use the minimum system requirements to allocate resources for computers hosting 
MID Servers.

ECC Queue

Learn about the External Communication Channel (ECC) Queue, which is the 
connection point between the MID Server and the instance. Jobs that the MID 
Server needs to perform are saved in this queue until the MID Server is ready to 
handle them.

MID Server Dashboard

Use the reports and gauges in the MID Server dashboard to monitor ongoing 
operations.

MID Server properties

Use MID Server properties to control the behavior of all MID Servers or a particular 
MID Server.

MID Server parameters

Use MID Server parameters to control the behavior of a particular MID Server.

MID Server protected records and reserved characters
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Some MID Server records cannot be altered. Certain special characters are pre-
defined in XML and cannot be used in passwords.

MID Server privileged commands

To discover certain information on a host server, the MID Server must run SSH 
commands with higher privileges. The platform provides default privileged 
commands for the MID Server to use and the ability to add additional commands to 
the system.

MIDSystem methods

MIDSystem variables (referred to by the variable name ms.) provide a variety of 
methods to get information about the MID Server.

MID Server heartbeat

Configure the interval that the instance uses when it checks the "heartbeat" of 
MID Server. By default, the instance checks the MID Server for a response every 5 
minutes.

Set JVM memory size

Modify the JVM setting for your MID Server from the default size to suit the amount 
of work your MID Server does in your network.

Pause the MID Server

Pause the MID Server to temporarily prevent it from polling the ECC Queue for work 
or sending Discovery results back to the instance.

MID Server system requirements

Use these minimum system requirements to allocate resources for computers hosting MID 
Servers.

1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

MID Server  supported systems

Windows  server

To discover Windows-based servers, run Service Mapping  patterns, or execute 
Orchestration  commands on Windows  devices, the MID Server  must be installed 
on a Windows  server. The MID Server  supports these Windows  operating systems, 
including virtual machines and 64-bit systems:
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• Windows  Server 2012

• Windows  Server 2016

• Windows  Server 2019

• Windows  Server 2022

Linux

The MID Server  is supported on these Linux  versions for virtual machines and 64-bit 
systems:

• Linux  Red Hat 6 and above

• Ubuntu 1404 (Ubuntu 14) and above

• CentOS 7 and above

Note: 
ServiceNow  no longer supports new installations of 32-bit MID Servers or upgrades to 
version Rome. New MID Server installation are blocked through RPM and MSI installer on 
the following operating systems:

• CentOS 7

• Windows server 2008

• Windows server 2008 R2

• Windows 8

• Windows 10

MID Servers can be manually installed to any operating system with the ZIP file, however 
Windows 10 is unsupported. Unsupported MID Servers auto-upgrading to Rome create an 
issue record in MID Server Issues (ecc_agent_issue). For more information, see Supported 
platform changes for MID Server [KB0863694] .

Security requirements

To meet high security standards, the MID Server  performs x.509 certificate validation on HTTPS 
traffic when connecting to ServiceNow®. If a network appliance or proxy exists between the MID 
Server  and the instance, that appliance needs to present a digital certificate signed by a trusted 
CA. If you are using a self-signed certificate or a certificate signed by an internal CA, import the 
certificate to the MID Server  trust store. For more information on adding SSL certificates, see Add 
SSL certificates for the MID Server.

OCSP connectivity requirements

The Online Certificate Status Protocol (OCSP) is the protocol used to determine the revocation 
status of SSL/TLS certificates. When certificates are exchanged and validated, the MID Server 
needs to determine if the certificate has been revoked and shouldn't be trusted.

OCSP works by using a client, such as a MID Server, to receive a certificate from an HTTP 
website. The client sends a request to an OCSP responder: a server operated by the certificate 
authority (CA) that issued the certificate. The OCSP responder’s response to the client indicates 
whether the certificate is valid or has been revoked.

In order to connect, the MID Server requires access to:
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• *.service-now.com or <instance_name>.service-now.com

• install.service-now.com

• http://ocsp.entrust.net

• http://ocsp.digicert.com (or other CA OCSP Responder)

While SSL/TLS certificates are always issued with an expiration date, there are certain 
circumstances in which a certificate must be revoked before it expires (for example, if its 
associated private key may have been compromised). Therefore, the current validity of a 
website’s certificate must always be checked by clients regardless of its expiry date.

Clients fail a connection when they can’t check the revocation status of a certificate. Firewalls 
and proxy configurations may block calls to the OCSP Entrust and DigiCert servers, which 
prevents the MID Server from working. You may need to change your firewall permissions so that 
the OCSP traffic goes through. For more information and resolutions, see the HI Knowledge Base 
article [KB1216223] .

PowerShell requirements

The MID Server  requires the minimum PowerShell version 3.0 and supports versions 
up to PowerShell 5.1. See Microsoft's documentation for more information about 
PowerShell requirements. To find your current PowerShell version using the instance, go to 
ecc_agent_list.do. Using the Update Personalize List  gear icon, add Host PowerShell Version 
to the Selected column. Then sort the list of MID Servers by their PowerShell version to find 
outdated MID Servers. Alternatively, you can find the PowerShell version on the host machine by 
using the command $Host.Version  in the host's PowerShell console. The PowerShell version is 
listed as PSVersion.

Java version support

Java 11.0.17 is bundled with the MID Server  installer package and is installed on the host for all 
new MID Servers. The installer automatically configures Java 11.0.17 to run in your environment. 
No additional configuration is required. This version supports both 64-bit Windows  MID Servers 
and 64-bit Linux  MID Servers. The MID Server  requires a minimum JRE version 11.0.8, and 
recommended version 11.0.17. If you are using a lower version than 11.0.8, you may see encryption 
related issues.

Testing showed that the MID Server  works as expected with Oracle  Java 11 version 11.0.5. If you 
need to upgrade the JRE to a different version, then coordinate with the appropriate account 
representative for support.

Upgraded MID Servers might use different Java versions depending on their operating system 
versions.

• MID Servers upgraded from earlier versions use the OpenJDK provided with the MID Server 
installer. This version of the OpenJDK was tested and certified for use with these MID Servers.

• MID Servers  upgraded on any other operating system versions also automatically upgrade the 
JRE to the version provided with the installation package.

Note: 
Linux MID Servers require glibC version 2.17. The library must be updated for JRE 11. On 
64-bit Linux systems, you must install the 32-bit GNU C library  (glibc). The installation 
command for CentOS is: yum install glibc.i686
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MID Server  JRE downgrade support

If the ServiceNow®  instance is downgraded from Quebec, then the MID Server  is also 
downgraded. However, the JRE may not be downgraded unless the instance is downgraded to 
one of the following patches. 

• New York Patch 12

• Orlando Patch 9

• Paris Patch 3

If the MID Server  is downgraded from Quebec to a different patch than specified, follow the 
instructions in Install Java 11 on MID Servers [KB0752451] .

Java Service Wrapper

The MID Server  installer includes the Tanuki Software Java Service Wrapper, version 3.5.40.

Setting the JVM Memory size

The MID Server  installs with 1 GB of JVM memory. If the suggested memory size for your product 
is greater than 1 GB, see Set the MID Server JVM memory size  for the procedure to override the 
default setting.

Deployment types

System requirements for your instance are determined by the needs of the individual products 
you use that require a MID Server. Some applications, such as Health Log Analytics , have 
additional system requirements listed in their documentation.

Standard deployments

The following products are considered "standard" because their MID Servers  share 
the same minimum disk space and memory requirements:

• Discovery

• Event Management

• Integrations

• Orchestration

• Service Mapping

The minimum standard requirements pertain to both a single product and a 
combined product deployment. You can deploy a single MID Server  for multiple 
standard products without significantly increasing the disk or memory requirements.

High resource deployments

Cloud Management Platform (CMP) and Operational Intelligence are processing 
intensive and require more resources for each MID Server  than the standard 
products. Install MID Servers  for these products on dedicated hosts that do not 
support MID Servers  for other products.

Recommended MID Server  minimum requirements

MID Server  performance and system requirement are driven my multiple factors including but 
not limited to:
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• The size of the customer infrastructure and specific function (Capability) MID Server  is 
configured to perform.

• The number of MID Servers  installed on the host.

• The number of threads per MID Server.

• The number and nature of other applications running on MID Server  host.

• Architectural and design enhancements over ServiceNow  releases. For example, using 
PowerShell for Windows  Discovery  in Orlando or changing default Java Garbage Collection 
policy in Quebec.

As a result, there is no one size requirement that fits for all MID Server  deployments. The 
following documented sizing guidelines can be a starting point for deployments. However, 
customers need to monitor MID Server  performance and resource utilization continuously, then 
tune and scale up their MID Servers  as needed.

MID Server  minimum system requirements

The minimum CPU configuration required for a MID Server  is a quad core processor 
with a speed of 2+ GHz for a Windows  Server 2012 R2 host with a single MID Server 
deployed and with standard configuration of 25 concurrent threads.

MID Server  CPU utilization

Most of the MID Server  applications, such as Discovery, are designed for 
maximizing their performance which results in maximizing the resource utilization 
for the MID Server. As a result, some customers might observe very high CPU 
utilization segments in the range of 90-100% while the MID Server  is running 
Discovery  schedules or similar applications.

The very high CPU utilization segments should not be a cause for concern because 
it aligns with architectural design of maximizing the throughput and does not have 
any negative impact on the Discovery performance. The MID Server  host’s resource 
utilization automatically returns to normal after the Discovery  execution successfully 
stops.

Customers who notice frequent and long very high CPU utilization segments should 
avoid:

• Running more than one MID Server  on same host when these MID Servers  are 
expected to process active workloads at the same time, such as overlapping 
Discovery  schedules.

• Sharing the MID Server  host with other applications.

• Configuring performance alerts, which are purely based on CPU utilization, on 
MID Server  host. If required, these alerts need to be used in conjunction with 
other performance monitors.

Configuring additional performance monitoring on MID Server  host

While CPU utilization on MID Server  is a good indicator of load on the host, it gives 
only limited visibility. Additional monitoring with System Processor Queue Length 
on Windows  Operating Systems and Load Averages on UNIX  Operating Systems is 
crucial.

• Processor Queue Length (Windows OS):  the number of threads that are ready 
but currently unable to run on the processor due to another active thread. A 
bottleneck on the processor may occur where the number of threads in the queue 
is more than twice the number of processor cores over a continuous period.
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• Load Averages (Unix OS):  the average system load on a Linux server for a 
defined period. It is the CPU demand on a server that includes sum of the running 
and the waiting threads. Typically, the top or the uptime command provides the 
load average of the server with output.

MID Server  CPU Performance Case Studies

The impact of modifying number of MAX threads on MID Server  CPU utilization

Based on internal benchmarking, the following is sample data for 
MID Server  CPU utilization while running Cloud Discovery  for 10,000 

servers.

In these tests, the maximum CPU utilization was observed to be 100% independent 
of number of threads and OS. The average CPU utilization was observed to be 
proportional to number of threads. Increasing number of threads did not necessarily 
result in immediate CPU pressure. Increasing the number of threads from the 
default 25 to 50 did not create additional CPU pressure, as shown by the max 
processor queue length. However, increasing the max threads value to 100 caused 
a significant increase in processor queue length, indicating CPU pressure.

The impact of sharing MID Server  with other applications or MID Servers  on CPU 
utilization

Running Discovery is a CPU intensive operation for MID Server. Deploying other 
applications or MID Servers  on same host creates additional CPU pressure on 
the host. This pressure results in a performance impact for running applications, 
including the MID Server. The following examples are sample CPU utilization data 
points for MID Server  with different load patterns:

Dedicated host for a single MID Server:  the average CPU usage is 

48%.
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Host shared between a MID Server and another 
application with moderate load:  the average CPU usage is 

77%.

Host shared between a MID Server and another application with heavy load:  the 
average CPU usage is 97%.

Scaling up MID Server  and its impact on MID Server  CPU resource utilization

When the MID Server  is heavily constrained on CPU resources, scaling up the 
MID Server  host, by adding more CPUs, helps ease resource pressure. However, 
this may not necessarily eliminate the very high CPU usage segments. MID Server 
applications like Discovery, which are designed for maximizing the performance, 
will continue to use additional available CPU resources. The following examples are 
sample CPU utilization data points for a 4 CPU MID Server  host and an 8 CPU MID 
Server  host running same Discovery  schedules:

Parameter 4 CPU 8 CPU

Average CPU% 48% 28%

Max CPU % 98% 98%
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MID Server CPU utilization when deployed on a 4 CPU host: 

MID Server CPU utilization when deployed on an 8 CPU host: 

Monitoring performance

To ensure that the MID Server  resource allocations are sufficient for your environment, monitor 
performance during peak periods of product execution from the MID Server dashboard.

MID Server ECC Queue

The External Communication Channel (ECC) Queue is a connection point between an instance 
and the MID Server. Jobs that the MID Server needs to perform are saved in this queue until the 
MID Server is ready to handle them.
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3. Configure your MID Server
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6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

Asynchronous Message Bus

The MID Server subscribes to messages published by the Asynchronous Message Bus (AMB), 
which notifies the MID Server that it has pending task records in the ECC Queue. If a task exists 
in the ECC Queue for that MID Server, the MID Server sets the status to "Processing". When 
finished working on a requested job, the MID Server reports back to the ECC queue with the 
results.

The MID Server opens a persistent connection to the instance through the AMB Client and 
listens on the /mid/server/<mid_sys_id>  AMB channel. When an output record is 
inserted into the Queue [ecc_queue] table, an AMB message is sent to the MID Server's channel. 
The MID Server receives this message and immediately polls the ecc_queue table for work, 
unless the MID Server is busy and the message priority level is not Interactive.

The MID Server polls the ECC queue at the maximum regular interval defined in the 
mid.poll.time  configuration parameter (40 seconds by default), regardless of AMB message 
activity. If the MID is busy and receeives an AMB message witrh a priority level other than 
Interactive, the queue poll time changes to mid.poll.time.standard  (5 seconds by default). This 
polling of the ECC queue at a regular interval is done in case the AMB connection is dropped.
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MID Server ECC queue polling process

Note: 
The AMB client on the MID Server does not work in all environments and might need to 
be disabled to avoid performance issues. To disable AMB in your environment, set the 
mid.disable_amb  parameter to true. When you disable AMB, the MID Server no longer 
receives notifications for each new ECC queue output record. See mid.poll.time  in  MID 
Server parameters  for more information.

ECC Queue information

You can access the ECC Queue by navigating any of these paths:

• Discovery  > Output and Artifacts  > ECC Queue

• Discovery  > Discovery Schedules  > {schedule name}  > {Discovery status record}

• ECC  > Queue

• {Discovery Status record}  > ECC Queue

An ECC Queue provides the following information:

Field Input value

Agent The name of the external system that this messages is either from or to. 
If the message is from or to a MID Server, the agent name is in the form 
mid.server.xxx, where xxx is the name of a particular MID Server.

Topic The name of the probe the MID server ran. If you are using a pattern for discovery, 
the Horizontal Pattern probe  Horizontal Pattern probe  appears.
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Field Input value

Name The actual command the probe ran. For example, if Topic  is SSHCommand, then 
the Name  field contains the actual shell command to run. If you are using a pattern 
for discovery, the following appears:

Pattern Launcher:  followed by the name of the pattern and the multipage number.

Source The IP address that the discovery is to run against. A few probes run against 
multiple IP addresses; in those cases, this field contains a human-readable 
description.

Response 
to

This optional field contains a reference (sys_id) to the ECC Queue message that 
this message is in response to. Discovery makes extensive use of this field to track 
the hierarchy of messages that result from a given scheduled Discovery. Click the 
record icon for the value in this field to open the ECC Queue record for the activity 
that spawned the current probe or sensor record.

Queue An indicator of whether this message was is an input message or an output 
message.

State The state of the current ECC queue record. States update automatically.

Processed The time when this message was processed.

Created The time when this message was created.

Sequence The unique sequence number for this message. This value is automatically 
generated when an ECC Queue record is inserted. Its use is deprecated.

Error 
string

An error message, if an error occurred during processing. This field is hidden on 
the standard form unless there was an error.

Payload The body of the message in XML format. The returned XML has a root 
tag of <results>  containing one or more <result>  tags and a single 
<parameters>  tag. The parameters are simply an echo of those sent to the 
MID server in the probe; they vary from probe to probe, but in general they tell the 
probe the details of what it is to do and how it should behave. The result tags are 
the most interesting ones: they contain the actual data generated by the probe.

ECC queue controls

The ECC Queue form contains these related links:

Related link Description

Run again Runs the probe again. You can re-run probes when you encounter a failed 
discovery or other unexpected results.

Go to 
CMDB item

Open the CI record for the CI that was updated during the discovery.

Go to 
Sensor

Open the record for the associated sensor.

ECC Queue retry policy

The following Plugin needs to be activated to be able to view the ECC Queue Retry Policy and 
Queue Retry Activity modules:
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• Plugin Name: ECC Queue Retry Policy

• ID: com.glideapp.ecc_retry_policy

Manage ECC Queue content for a MID Server

The ECC Queue allows you to create ECC Queue messages, access MID Server log entries, and 
retrieve statistics from an individual MID Server record.

Before you begin
Role required: admin, mid_server

Procedure

1. Send remote commands through a MID Server to a hosting device directly from the ECC 
Queue without running Discovery.

a. Navigate to the ECC Queue and click New.

b. Create a message with these settings:

▪ Agent: The name of the MID Server that executes the command.

▪ Topic: Command

▪ Name: The actual command that you want to process. For Windows, this is expressed in a 
DOS command line structure. For Linux, the structure could be a bash command line entry.

▪ Queue: Output

▪ Payload: With proper XML tags, you can specify the command here instead of in the 
Name  field. The advantage to this is that the command is not restricted by the Name  field 
length of 120 characters. Use the following XML format for the command:

<parameters>
   <parameter name="name" value="ACTUAL_COMMAND_LINE"/>
</parameters>

2. Access entries in the ECC Queue that show agent0.log.0  logs and wrapper.log  logs for an 
individual MID Server.

a. Open a MID Server record.

b. Under Related Links, click Grab MID logs, files and thread dump.
ECC queue records appear in the list using the following filter:

▪ [Topic] [is] [SystemCommand]

▪ [Source] [is] [grabLog]

▪ [Agent] [is] [your MID Server]

Only agent0.log.0  and wrapper.log  entries appear. These logs are also accessible in the ~
\agent\logs\  file path.

c. To open a log entry, click the link under the Created  column.
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3. Access the queue.stats  topic for useful information about individual MID Servers, such as 
memory and CPU usage data.

a. Open a MID Server record.

b. Under Related Links, click MID Statistics.
ECC queue records appear in the list using the following filter:

▪ [Topic] [is] [queue.stats]

▪ [Agent] [is] [your MID Server]

MID Server dashboard

The MID Server dashboard is a central place for MID Server users to monitor ongoing operations. 
The dashboard consists of reports and gauges that display information from the MID Server 
Status table.

1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

The MID Server Dashboard is available from the MID Server  > Dashboard  module.

After upgrading to Discovery Admin Workspace version 1.3.1 (August 2024 Store), you can 
navigate to Workspaces  > Discovery Admin Workspace  > Insights  and use the enhanced 
dashboard.

MID Server Overview tab

The Overview tab provides graphs showing the status of MID Servers, including any validation 
issues or pending upgrades and jobs. The tab also displays which MID Servers by capability.
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MID Server Performance tab

The Performance tab displays information relating to the MID Server CPU and memory usage, 
including the life-cycle event history.

MID Server Custom performance tab

The Custom performance tab enables users to set custom MID Server selection criteria to show 
particular MID Servers in a select time frame.
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MID Server status gauge

The MID Server Status gauge on the dashboard displays basic information about each MID 
Server. This information comes from the MID Server Status [ecc_agent_status] table.

MID Server Dashboard gauge

If the version is not compatible, the MID Server status is not changed to Down  in the MID Server 
dashboard. So it might still appear to be processing commands when it actually is not doing so. 
You must check the MID Server Version  on the dashboard.

See KB0535181  for additional MID Server troubleshooting information.

The icons in the Version  column indicates the following:

• Red: Incompatible. The MID Server and instance do not belong to the same release. You 
must upgrade the MID Server  and verify that it is not pinned to an older version with the 
mid.version.override  property. The MID Server will not be upgraded until the parameter is 
cleared.

• Yellow: Compatible, but an upgrade is recommended. This indicates that the MID Server 
version belongs to the same family as the instance, but not the same version.

• Green: Compatible. No upgrade necessary.

• Gray: Incompatible. The instance cannot detect the version.

Column Description

Name The name of the MID Server.

Host name The name of the system that hosts the MID Server.
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Column Description

Status The status of the MID Server.

Validated Whether or not the MID Server was validated.

Max 
memory 
used %

The highest percent usage of memory on the system that hosts the MID Server, in 
the configured sampling interval. The default interval is 30 minutes, but this value 
is user configurable. See MID Server resource threshold alerts  for details.

Mean CPU 
used %

The average percent usage of CPU on the system that hosts the MID Server, in the 
configured sampling interval. The default interval is 30 minutes, but this value is 
user configurable. See MID Server resource threshold alerts  for details.

Pending 
jobs

Number of pending ECC queue jobs for that MID Server.

Processing 
jobs

Number of processing ECC queue jobs for that MID Server.

Version The version of the MID Server. An icon indicates the validity of the MID Server:

• Red: Incompatible. The MID Server and instance do not belong to the same 
release. You must upgrade the MID Server  and verify that it is not pinned to an 
older version with the mid.version.override  property. The MID Server will not be 
upgraded until the parameter is cleared.

• Yellow: Compatible, but an upgrade is recommended. This indicates that the 
MID Server version belongs to the same family as the instance, but not the same 
version.

• Green: Compatible. No upgrade necessary.

• Gray: Incompatible. The instance cannot detect the version.

User The login name of the user. An icon indicates the validity of the user:

• Red: Incompatible. The user does not have themid_server role  or the user 
does not match the value in the mid.instance.username parameter  (in the 
config.xml  configuration file). Reconfigure the MID Server user and verify 
that it works.

• Green: Compatible. The user has the mid_server role and matches the user in 
the configuration file.

Note: 
The user can also have any of the SOAP roles that the mid_server role 
inherits.

MID Server properties

Properties control the behavior of all MID Servers or a particular MID Server.
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1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

The MID Server properties are in the MID Server Property [ecc_agent_property] table and can be 
accessed by navigating to MID Server  > Properties. To set these properties, you must add them, 
if they are not already present.

MID Server properties

alias_filtering_behavior

Sets the behavior of Discovery aliases. Behaviors define how strictly the system 
enforces the use of credential aliases in Discovery schedules.

• Type: string

• Default value: loose

The choices for behaviors are:

• strict: Aliases defined for the credential must match the aliases configured for the 
probe.

• loose: The probe's credential is used if it contains all the aliases specified in the 
schedule.

com.glide.closure_max_rows_per_table

Sets the maximum number of rows allowed in a table. This property is not visible by 
default and must be added.

• Type: integer

• Default value: 200000

concurrent.dist.download

Sets the number of concurrent MID Server auto-upgrades permitted by the 
instance. The default value of this property is 2, which allows the MID Server to use 
2 of the 4 semaphores available on the instance for upgrading. If your instance has 
more than 4 INT semaphores, you can increase the value in this property to allow 
more concurrent upgrades.

• Type: integer

• Default value: 2

glide.stored_proc.data_type.validation
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Stops validation of data types in stored procedure parameters. Use this property if 
you use Orchestration to run a stored procedure on MySQL, Oracle DB, and MS-
SQL databases and you want to avoid performing data type validation. Restart the 
MID Server service after you change the value of this property.

• Type: true | false

• Default value: false

mid.discovery.max_ci_count_per_page

Defines the maximum CI count per page.

• Type: integer (bytes)

• Default value: 500

You can also configure this as a configuration parameter on a individual MID Server.

mid.discovery.max_related_count_per_page

• Type: integer

• Default: 100

mid.discovery.max_relation_count_per_page

Splits the payload based on the number of relations in it.

• Type: integer

• Default: 10000

mid.discovery.max_total_items_size_per_page

Splits the payload based on the size of the items.

• Type: integer

mid.aws.sts.assume_role.disable_credential_caching

Set this property to true  to prevent the caching of temporary credentials for Cloud 
Discovery. For more information, see Access setup for AWS service accounts
Access setup for AWS  service accounts .

• Type: true | false

• Default: false

mid.aws.sts.assume_role.credential_ttl_minutes

Set the number of minutes you want to cache temporary credentials for Cloud 
Discovery. For more information, see Access setup for AWS service accounts
Access setup for AWS  service accounts .

• Type: integer

• Default: 60

mid.ca.certificate.api.request.retry.count

Indicates how many times the Certificate Import query will retry after the rate limit 
has occurred.

• Type: integer

• Default: 3
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mid.ca.certificate.api.request.retry.interval

Used to delay Certificate import from CAs when the rate limit has occurred.

• Type: integer

• Default: 30000

mid.cloud.discovery.bypass.proxy

This configuration parameter accepts a comma separated list of DNS/IP addresses 
of proxy servers. The listed proxy servers are bypassed during Cloud Discovery. 
To bypass proxies on multiple cloud service providers (such as AWS or Azure), a 
separate MID Server must be set up for each provider. Otherwise, the MID Server 
proxy configuration is followed normally.

• Type: string

• Default value: none

mid.discovery.file_transfer_protocol

Used to determine the file transfer method used for probes or patterns.

• Type: Choice (SCP or SFTP)

• Default: SCP

mid.discovery.max_pattern_payload_size

Defines the maximum overall payload size for the payload of results that come from 
patterns.

• Type: integer (bytes)

• Default value: 50000000

You can also configure this as a configuration parameter on a individual MID Server.

mid.discovery.max_payload_size

Specifies the maximum string length of Discovery  results that the MID Server sends 
to the instance. If the Discovery  probe results exceed the limit, the MID Server 
discards them and returns a warning message.

For probes, this applies only to those probes where the Used by Discovery  field is 
true. For patterns, this applies to the Horizontal Pattern probe .

Set the value to any negative number to disable the payload limit and allow 
payloads of any size to be sent to the instance. For example, -1.

• Type: integer (bytes)

• Default value: 5000000

You can also configure this as a configuration parameter on a individual MID Server.

mid.discovery.multiprobe.skip_others_on_error

Prevents probes in a multi-probe  from iterating through available credentials when 
another member probe has already failed or timed out. If this property is set to 
false, each probe in the multi-probe attempts to connect to the target with the same 
invalid credentials. This condition results in longer probe execution times on the 
MID Server.
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This property is not visible by default and must be added to the sys_properties table 
to change the value.

• Type: true | false

• Default value: true

mid.eccq.max_payload_size

Specifies the maximum string length of a payload that the MID Server sends to 
the instance. The MID Server verifies the size of the payload before sending it to 
the instance. If the payload size exceeds the limit, the MID Server discards it and 
returns an error message in the payload.

• Type: integer (bytes)

• Default value: 20000000

You can also configure this as a configuration parameter on a individual MID Server.

mid.install_server.base_uri

Modifying this system property requires maint privileges. The MID Server uses the 
value provided as the base URL when making requests for update files.

• Type: string

• Default value: https://install.service-now.com

mid.jdbc.datastream.max.record.size

Specifies the maximum record size in KB.

• Type: integer

• Default value: 64

• Maximum value: 128

mid.jdbc.datastream.fail.when.attachement.limit.exceeded

Specifies if the data up to 4GB (four attachments, each of size 1GB) can be retrieved 
from the RDBMS. By default, a flow or action fails with an error, when there is data 
of more than 4GB to be retrieved. Set value to false  to retrieve data of size 4GB 
without an error.

• Type: string

• Default: true

mid.keystore.max_backups

Specifies the maximum number of backups from manual key store operations 
through the manage_certificate  script. If it is 0 or negative, no backup will be made.

• Type: Integer

• Default value: 3

mid.keystore.max_live_backups

Specifies the maximum number of live backups from running MID server. If it is 0 or 
negative, no backup will be made.

• Type: Integer

• Default value: 2
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mid.keystore.backup_overwrite_timespan

Specifies the number of seconds from the current backup time to determine if a the 
most recent backup in that time span should be replaced by the new one instead of 
creating a new backup and so removing the oldest backup, should the number of 
backups exceed the maximum limit.

• Type: Integer

• Default value: 60

mid.log.command_audit.enable

Enables the MID Server command audit log.

• Type: string

• Default value: false

mid.powershell.target_base_dir

Specifies the location of the target base folder used for Discovery using WMI. If 
another network share is mounted on each Window's target, the folder may be 
changed by updating this property.

• Type: string

• Default value: admin$\temp

mid.probe.collect_debug_info

An optional property to collect debug information. If this property is set to true, the 
probe collects credential debug information when it runs and puts that information 
in the payload of ECC input message. It doesn't affect how Discovery works.

• Type: true | false

• Default value: false

mid.probe.use_legacy_forward_dns

Enables the legacy DNSNameResolver probe and disables the default 
DNSNameResolver probe. See Probes used by Orchestration  for more information.

• Type: true | false

• Default value: false

mid.probe.use_legacy_reverse_dns

Enables the legacy DNS probe and disables the default DNS probe. If you 
experience problems with the features of the default DNS probe, use this property 
to disable those features. The default DNS probe's features include being 
lightweight and faster due to executing in parallel, while the legacy probe is throttled 
by the MID Server because it executes in serial. The default probe utilizes DNS 
lookup by the MID Server host OS to make use of the OS maintained DNS cache, 
while the legacy probe does not. Consequently, after a DNS lookup by the default 
probe fails in Windows systems, the OS also tries looking up by NETBIOS name.

• Type: true | false

• Default value: false

mid.process_flow.log_listener.max_size
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Sets the maximum size in bytes of memory available to save log messages for Flow 
Designer  actions running on a MID Server. The MID Server  stores up to the limit in 
memory and discards additional log messages, then sends the messages back to 
the instance along with the execution plan.

• Type: integer (bytes)

• Default value: 10485760

mid.property.jdbc_operations

Tells the JDBCOrchestrationProbe what JDBC operations it is allowed to execute. 
Edit this property value to allow JDBC Orchestration activities to perform more 
operations. All operations are comma separated. Select a MID Server in the MID 
server  field to define specific operations for that MID Server, or leave the field 
empty to apply the list of operations to all MID Servers. This property requires the 
Orchestration plugin.

• Type: string

• Default value: 
select,update,insert,delete,show,create,describe,begin,if,end,not,exists

mid.property.jms.command.allowed_factory_names

Comma delimited list of Java Messaging Service (JMS) connection factories that the 
MID Server requires for a custom JMS activity or action. This property requires the 
Orchestration plugin.

• Type: string

• Default value: connectionFactory, queueConnectionFactory, 
topicConnectionFactory

mid.property.ssh.use_snc

Enables the use of the SNCSSH client for Discovery and Orchestration. Change this 
property to false  to use J2SSH. This property applies to all MID Servers connected 
to the instance.

• Type: true | false

• Default value: true

mid.property.powershell.use_base64_password

If the Credential is set to be specific to certain MID Servers, then the property can 
also be set to those same MID Servers. Leaving the MID Servers field empty will 
apply to all MID Servers.

• Type: true | false

• Default value: false

mid.sa.prefer_powershell

Enables MID Server  to use PowerShell Remoting.

Note: 
It is not recommended to change this property as it is being deprecated.

• Type: True | False

• Default value: true
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mid.sa.ssh.use_sncssh

Toggles SSH between non-interactive and interactive modes. True corresponds 
to non-interactive mode and allows probes to open sessions with the device 
without waiting for a prompt. False corresponds to interactive mode, which requires 
interactive sessions with the device for network devices and servers.

• Type: True | False

• Default value: true

mid.servicewatch.max_concurrent_connections

Defines the maximum number of concurrent tasks sent to an individual host by a 
single MID Server.

• Type: integer

• Default value: 7

mid.shazzam.regulator.interval_ms

Sets the interval, in milliseconds, in which Shazzam can launch packets.

• Type: integer

• Default value: 1

mid.shazzam.regulator.packets_per_interval

Sets the number of packets that Shazzam can launch in the time interval specified 
by the mid.shazzam.regulator.interval_ms property.

• Type: integer

• Default value: 1

mid.shazzam.threads

Specifies the number of concurrent threads that Shazzam uses. Setting this or the 
mid.shazzam.max_scanners_per_thread parameter to 0 disables Shazzam multi-
thread optimization.

• Type: Integer

• Default value: 5

mid.shazzam.max_scanners_per_thread

Specifies the number of concurrent scanners processed by each Shazzam 
thread. Setting this or the mid.shazzam.threads parameter to 0 disables Shazzam 
optimization.

• Type: Integer

• Default value: 100

mid.sm.discolog.max_log_size

Limits the length of the log statements in the Horizontal Discovery Log. If the 
results are truncated, the Command results  reports, "Result is larger than [value] 
characters and was truncated by the logger."

• Type: integer (characters)

• Default value: 1000

mid.sm.discolog.max_object_size
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Limits the length of the object in the Horizontal Discovery Log. Objects in the log 
statement are truncated to the number of characters set by this property's value. 
This property only affects the object character size in the Horizontal Discovery Log. 
The following message appears if an object is limited by this property "The max 
object size reached the maximum limit of [value]. To adjust this use the mid property 
mid.sm.discolog.max_object_size."

• Type: integer (characters)

• Default value: 5000

mid.snmp.use_getbulk

Specifies whether to use GETBULK to receive a large amount of data in batches. 
This can be used to globally configure all MID servers.

• Type: true | false

• Default value: true

GETBULK can also be set at the probe level or for an individual MID Server. Settings 
are listed in the order of precedence:

• SNMP probe parameter

• MID Server configuration parameter

• MID Server properties

mid.ssh.algorithms.kex

Modifies the Key Exchange SSH algorithm priority list. The property accepts a 
comma separated lists with operators. The first name in the list is highest priority, 
last name in list is lowest priority. Adding a comma separated list without any 
operators replaces the default algorithm list. For more information, see MID Server 
SSH cryptographic algorithms.

• Type: string

• Default value: ecdh-sha2-nistp256,ecdh-sha2-nistp384,ecdh-sha2-nistp521,diffie-
hellman-group-exchange-sha256,diffie-hellman-group14-sha256,diffie-hellman-
group16-sha512,diffie-hellman-group14-sha1,diffie-hellman-group1-sha1,diffie-
hellman-group-exchange-sha1

mid.ssh.algorithms.host_key​

Modifies the Host Key SSH algorithm priority list. The properties accept comma 
separated lists with operators. The first name in the list is highest priority, last 
name in list is lowest priority. Adding a comma separated list without any operators 
replaces the default algorithm list. For more information, see MID Server SSH 
cryptographic algorithms.

• Type: string

• Default value: ecdsa-sha2-nistp256,ecdsa-sha2-nistp384,ecdsa-sha2-
nistp521,rsa-sha2-256,rsa-sha2-512,ssh-rsa,ssh-dss

mid.ssh.algorithms.cipher

Modifies the Cipher SSH algorithm priority list. The properties accept comma 
separated lists with operators. The first name in the list is highest priority, last 
name in list is lowest priority. Adding a comma separated list without any operators 
replaces the default algorithm list. For more information, see MID Server SSH 
cryptographic algorithms.
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• Type: string

• Default value: aes128-ctr,aes192-ctr,aes256-ctr,3des-ctr,aes128-cbc,aes192-
cbc,aes256-cbc,3des-cbc

mid.ssh.algorithms.mac

Modifies the MAC SSH algorithm priority list. The properties accept comma 
separated lists with operators. The first name in the list is highest priority, last 
name in list is lowest priority. Adding a comma separated list without any operators 
replaces the default algorithm list. For more information, see MID Server SSH 
cryptographic algorithms.

• Type: string

• Default value: hmac-sha2-256,hmac-sha1,hmac-sha2-512,hmac-sha1-96,mac-
md5-96,hmac-md5

shazzam.chunk_size

Maximum number of IP addresses Shazzam can scan in parallel. This property 
primarily controls outbound port consumption.

• Type: integer

• Default value: 100

mid.use_net_tools

Enables or disables the use of net-tools commands during discovery of devices 
running on the Linux  operating system. Starting from Quebec, ITOM Visibility 
supports the iproute2 commands for discovery. By default, ITOM Visibility  and 
discovery patterns first use net-tools commands, and only then, as a fallback, 
may use iproute2 commands. If all Linux-based devices and applications in your 
IT network use iproute2 commands, disable net-tools commands to make the 
discovery process more efficient.

• Type: true | false

• Default value: true

mid.servicewatch.use_full_linux_netstat_path

Controls if the netstat  command is executed with its full installation path. This 
command lists open ports on Linux  servers during the process detection phase of 
the top-down discovery.

• Type: true | false

• Default value: true

mid.servicewatch.num_paths_linux_netstat_to_check

Define the maximum number of installation paths to use during discovery 
of Linux  servers. This property is relevant when you run the top-down 
discovery on Linux  servers with several netstat installation paths, and the 
mid.servicewatch.use_full_linux_netstat_path  property is set to 
true.

The top-down discovery attempts to execute the netstat  command using each 
of these installation paths. The result of the first successful execution is used to 
determine the list of open ports.
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• Type: true | integer

• Default value: 5

mid.servicewatch.use_full_linux_ss_path

Controls if the ss  command is executed with its full installation path. This command 
lists open ports on Linux  servers during the process detection phase of the top-
down discovery.

• Type: true | false

• Default value: false

mid.servicewatch.num_paths_linux_ss_to_check

Define the maximum number of installation paths to use during discovery 
of Linux  servers. This property is relevant when you run the top-down 
discovery on Linux  servers with several ss installation paths, and the 
mid.servicewatch.use_full_linux_netstat_path  property is set to 
true.

The top-down discovery attempts to execute the ss  command using each of these 
installation paths. The result of the first successful execution is used to determine 
the list of open ports.

• Type: true | integer

• Default value: 5

Create a MID Server property

Use a MID Server property to control either the behavior of all MID Servers or a particular MID 
Server.

Before you begin
Role required: admin

About this task
You set MID Server properties to override MID Server parameters. Configure MID Server 
properties in the MID Server plugin. Do not configure MID Server properties in the 
glide.properties  file that is located in the properties folder of the agent. The glide.properties  file 
gets overwritten during the upgrade process.

Procedure

1. Navigate to All  > MID Server  > Properties.

2. Click New.

3. Fill in the fields, as appropriate (see table).

MID Server properties fields

Field Description

Name Enter the property name.

Value You can enter the value you want the property to have.
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Field Description

Note: 
If you are amending JDBC operations through the mid.property.jdbc_operations 
properties, you can enter verbs like BEGIN, END, IF, or common PL/SQL 
block statements. This will assist in being able to run CREATE or ALTER 
statements. You might have to restart the MID server before running some of 
the statements.

MID 
Server

Leave this field blank to set a MID Server property that affects all MID Servers. To set 
a MID Server property for a particular MID Server , select the MID Server.

4. After setting any MID Server properties, restart the MID Server to ensure the properties sync 
with the instance.

MID Server parameters

Parameters control the behavior of a particular MID Server and have lower precedence than MID 
Server properties.

1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

To add a parameter to a MID Server, see Add a MID Server parameter.

Important: 
Changes to parameters only take effect when the MID Server is started (or restarted).

Note: 
The value of any MID Server  parameter in the config.xml file can be encrypted. See Encrypt 
or decrypt MID Server configuration file values  for more information.

Required parameters

Note: 
Using special characters in an XML configuration file requires you to encode them.

url
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Specifies the URL to the associated instance. Normally the URL is similar to https://
instance.service-now.com, where you replace instance  with the instance name. If 
you host your own instance, use the URL set by your organization.

• Type: string

• Default value: none

mid_sys_id

Records the MID Server record's unique identifier. This parameter should be empty 
when you initially configure a MID Server. Do not change the value.

• Type: string

• Default value: automatically set (GUID)

name

Use this parameter to supply a name that is meaningful for you. If you do not supply 
this parameter, the MID Server uses the default value. A set of business rules 
synchronizes the name in the configuration file with the name in the MID Server 
record. The business rules ensure that changing the name in one location also 
changes the name in the other location.

• Type: string

• Default value: YOUR_MIDSERVER_NAME_GOES_HERE

mid.instance.username or glide.glidesoap.username

If the ServiceNow  instance has authentication enabled, as it is by default, set 
this parameter to define the user name the MID Server should use to log in to the 
instance. This user should have the mid_server role on the ServiceNow  instance in 
order to access necessary tables and fields. You can use this parameter to define 
user names with special characters.

• Type: string

• Default value: none

mid.instance.password or glide.glidesoap.password

If your ServiceNow instance has authentication enabled, as it is by default, set 
this parameter to define the password the MID Server should use to log in to the 
instance. You can use this parameter to define passwords with special characters.

• Type: string

• Default value: none

CIM parameters

mid.cim.batch.size

Specifies the maximum number of messages sent at once to a CIM server.

• Type: integer

• Default value: 1

mid.cim.request.interval

Specifies the number of milliseconds to wait between requests to the same 
Common Information Model Object Manager (CIMOM).
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• Type: integer

• Default value: 0

mid.cim.host.connection.limit

Specifies the maximum number of simultaneous connections to each CIMOM. A 
value of zero disables simultaneous connections.

• Type: integer

• Default value: 0

Connection parameters

glide.mid.fast.responses

Instructs the MID Server to try sending messages to the instance as soon as they 
are ready. Normally the MID Servers end messages to the ServiceNow  instance 
serially (that is, one message at a time). Since many probes can be run in parallel, 
there can be multiple messages transmitted simultaneously to the instance. Setting 
this parameter to true  may decrease the time between a probe's completion and 
its response arriving at the instance. However, the multiple simultaneous messages 
consume resources, decreasing the overall instance responsiveness. If there are 
communications problems, this parameter's value can also cause a logjam on the 
MID Server, as threads normally used for running probes may become consumed 
for sending messages. Generally, leave this parameter out of your configuration. 
Setting it to true  is meaningful only under very special circumstances.

• Type: true | false

• Default value: false

glide.mid.max.sender.queue.size

Places an upper limit on how large the queue is allowed to get. The MID Server 
starts deleting queued messages if this limit is exceeded. When the MID Server 
generates messages to the ServiceNow  instance faster than it can send them, it 
queues them temporarily on the file system of the MID Server's host. This queue 
is normally quite small, and is completely emptied as soon as the MID Server 
processing slows for a short period. However, this queue can grow in size when 
there are communication problems between the MID Server and the instance, and 
especially if there is an integration running on the MID Server.

The parameter is of the form {number}{multiplier}, where {number} is any positive 
decimal number including non-integers, and the optional multiplier is any spelling 
of bytes, kilobytes, megabytes, gigabytes, or terabytes (only the first character 
is tested, and the test is case-insensitive). The default multiplier is bytes. White 
space is liberally tolerated. The following strings all represent valid parameters: 
"1000000000", "0.5m", "5 GB", "7.67gigas", "145.69392 meg", and "1.1 terra".

• Type: string

• Default value: 0.5 GB

instance.date.format

Specifies the format the instance uses for dates and times. The primary impact of 
setting this parameter is to allow the MID Server to correctly refresh its start and 
stop times on the MID Server record in ServiceNow. The format of this date/time 
string is identical to that used by the Java SimpleDateFormat class.
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• Type: string (Date format)

• Default value: yyyy-MM-dd HH:mm:ss

mid.disable_amb

Disables the Asynchronous Message Bus (AMB) notifications for new ECC queue 
output messages. For more information, see the Asynchronous Message Bus 
section inAsynchronous Message Bus. When AMB is enabled the MID Server uses 
a different default polling interval than when AMB is disabled. See the mid.poll.time 
parameter for more details. If you set a polling interval with the mid.poll.time 
parameter, the MID Server uses that value whether or not the AMB client is enabled.

• Type: true | false

• Default value: false

mid.https.truststore.password

Sets the trustStore password that is required for HTTPS connections with the 
Asynchronous Message Bus (AMB) Client.

• Type: string

• Default value: none

mid.https.truststore.path

Path to the trustStore to be used by the MID Server for TLS transactions 
(Asynchronous Message Bus (AMB) Client). Add this parameter only if you want to 
change the default path.

• Type: string

• Default: Path to the JRE trustStore bundled with the MID Server

mid.instance.skip_basic_auth

Allows the MID Server to connect to an instance using cookies instead of basic 
authentication credentials. When set to true, it uses cookies first. However, if the 
connection fails, the MID Server will try to connect again using basic authentication 
credentials.

• Type: true | false

• Default value: true

mid.jmx.enabled

Enables a JMX server on the MID Server, which exposes some management 
information to JMX consoles. Implementing JMX requires additional configuration of 
the Java runtime environment. Setting this parameter to true  is only recommended 
for those with detailed knowledge of the Java security architecture and a specific 
need for JMX.

• Type: true | false

• Default value: false

mid.poll.time

Sets the default MID Server polling interval (in seconds). The polling interval is the 
amount of time the MID Server waits before checking the ECC queue for work when 
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the MID Server is not busy. For more information, see the Asynchronous Message 
Bus section in.

When mid.disable.amb  is set to false (the default setting), see the Asynchronous 
Message Bus section in Asynchronous Message Bus  for more information about 
how mid.poll.time  is used.

When mid.disable.amb  is set to true, polling occurs on a fixed mid.poll.time 
interval, but polling switches to using mid.poll.time.standard  (5 seconds by default) 
when the MID Server is busy.

• Type: integer (seconds)

• Default value: 40 when mid.disable.amb  is false, or 5 when mid.disable.amb  is 
true.

mid.probe.wait.resources

Indicates whether probe execution is delayed until resources are available. Used to 
enable MID Server Resource Reservation.

Note: 
Requires MID Server restart.

• Type: true | false

• Default value: true

mid.property.long_runner

Identifies the name of a script include that manages long running commands.

Note: 
This property is applicable till the Rome  version only. If your instance 
is of a later version, you must configure the system property, 
glide.eccprobe.longrunner.class.

• Type: string

• Default value: LongRunner

threads.interactive.max

Sets the maximum number of interactive worker threads that can run 
simultaneously in the interactive thread pool. See Set MID Server Thread Use.

• Type: integer

• Default value: 10

threads.expedited.max

Sets the maximum number of expedited worker threads that can run simultaneously 
in the expedited thread pool. See Set MID Server Thread Use.

• Type: integer

• Default value: 20

threads.max

Sets the maximum number of standard worker threads that can run simultaneously 
in the standard thread pool. This parameter provides direct control over what CPU 
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resources the MID Server consumes on the computer that hosts it. See Set MID 
Server Thread Use.

• Type: integer

• Default value: 25

Important: 
You can set threads.max as high as 200, however, this setting may need to be 
changed depending on the OS. For example, Windows-based MID Servers 
running Discovery uses Powershell which is resource intensive. In this case, 
you may exhaust the CPU power of the host machine with just 50 threads 
count.

Credentials parameters

mid.aws.instance_profile_name

Name of the AWS IAM role configured on the EC2 instance. When configured, the 
MID Server uses the temporary credentials granted to this role by the AWS instance 
profile to Discover cloud resources.

• Type: string

• Default value: None (User must provide a non-blank value)

mid.credentials.provider

Specifies the Java class name of the credentials provider.

• Type: string

• Default value: com.service_now.mid.creds.standard.StandardCredentialsProvider

mid.secure_credentials.key_pairs.provider

Class that the MID Server uses to generate secure key pairs.

• Type: string

• Default value: 
com.service_now.mid.keypairs.provider.standard.StandardKeyPairsProvider

Debug parameters

debug.logging

[Deprecated] Specifies whether to enable logging of MID Server events and 
messages (both sent and received). Normally this parameter is only used by 
developers, but it is occasionally useful when troubleshooting a problem. Be aware 
that setting this parameter to true  causes intensive logging on the MID Server, 
potentially using considerable disk space.

• Type: true | false

• Default value: false

This parameter has been replaced by the mid.log.level  parameter.

debug

[Deprecated] Specifies whether to enable debug logging on the MID Server. 
Normally this parameter is only used by developers, but it is occasionally useful 
when troubleshooting a problem. Be aware that setting this parameter to true 
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causes intensive logging on the MID Server, potentially using considerable disk 
space.

• Type: true | false

• Default value: false

This parameter has been replaced by the mid.log.level  parameter.

file.probe.template.debug

Specifies whether to debug file probe templates.

• Type: true | false

• Default: false

mid.cim.debug

Specifies whether to enable debug logging for CIM, WBEM, SLP, or SMI-S.

• Type: true | false

• Default value: false

mid.ssh.debug

Enables SSH debug information in the log file. The parameter usage depends on 
whether the ServiceNow  SSH client is enabled.

When the ServiceNow  SSH client is enabled, the parameter functions as follows:

• Type: string

• Default value: false

The following string values are valid for the ServiceNow SSH client:

◦ true: Enables SSH debug information in the log file.

◦ false: Disables SSH debug information in the log file.

◦ <IP Addresses>: Specify which IP ranges to enable SSH debug information in 
the log file. You can enter IP addresses in the following formats:

▪ An IP range defined by a slash and the number of bits in the subnetwork. For 
example, the string 10.10.10.0/24 scans 24 bits of IP addresses from 10.10.10.0 
to 10.10.10.254.

▪ An IP range defined by a dash. For example, the string 10.10.11.0-10.10.11.165 
scans the IP addresses from 10.10.11.0 to 10.10.11.165.

▪ A comma-separated list of specific IP addresses. For example the string 
10.10.11.200,10.10.11.235 scans the IP addresses 10.10.11.200 and 10.10.11.235.

◦ deferred: Logs SSH debug information in memory unless an error or warning 
occurs. If an error or warning occurs, the platform publishes the debug 
information to the log file. This ensures that only the part of the log file 
pertaining to the error or warning is recorded. If no error or warning is detected, 
the platform deletes the unused log data from memory when the session 
closes. Each session stores up to 1000 log messages. If the session exceeds 
1000 log messages, the deferred log discards the oldest log message to make 
room for the newest log message.

When the ServiceNow  SSH client is disabled, the parameter enables or disables 
SSH debug information in the log file:
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• Type: true | false

• Default value: false

Note: 
The MID Server parameter mid.ssh.debug  only affects SNCSSH and J2SSH. 
To enable Maverick client debug logging, set the MID Server configuration 
parameter mid.log.level  to debug, com.maverick=debug.

mid.log.level

Specifies the logging level for the MID Server. Possible values are:

• debug

• info

• warn

• error

Note: 
Values are case insensitive.

• Type: string

• Default value: info

mid.http.idle_connection_monitor.debug

Enables debug logging for the Idle Connection Monitor.

• Type: true | false

• Default value: false

DNS parameters

mid.dns_scan.regulator.interval_ms

Specifies the interval between DNS scans in milliseconds.

• Type: integer

• Default value: 10

mid.dns_scan.regulator.packets_per_interval

Specifies the number of regulator packets per DNS scan.

• Type: integer

• Default value: 1

mid.dns_scan.default_name_servers

Specifies the host names or IP addresses of the default name servers.

• Type: string

• Default value: none

mid.dns_scan.default_name_servers

Specifies the host names or IP addresses of the default name servers.
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• Type: string

• Default value: none

mid.dns_scan.additional_name_servers

Specifies the host names or IP addresses of any additional name servers.

• Type: string

• Default value: none

mid.dns_scan.load_balancing_enable

Specifies whether to enable load balancing of name servers.

• Type: true | false

• Default value: false

mid.probe.use_legacy_forward_dns

Enables the legacy DNSNameResolver probe and disables the default 
DNSNameResolver probe. See Probes used by Orchestration  for more information.

• Type: true | false

• Default value: false

mid.probe.use_legacy_reverse_dns

Enables the legacy DNS probe and disables the default DNS probe. If you 
experience problems with the features of the default DNS probe, use this parameter 
to disable those features. The default DNS probe's features include being 
lightweight and faster due to executing in parallel, while the legacy probe is throttled 
by the MID Server because it executes in serial. The default probe utilizes DNS 
lookup by the MID Server host OS to make use of the OS maintained DNS cache, 
while the legacy probe does not. Consequently, after a DNS lookup by the default 
probe fails in Windows systems, the OS also tries looking up by NETBIOS name.

• Type: true | false

• Default value: false

Event Management parameters

mid.probe.event.bulk_size

Specifies the maximum size of an event payload, in MB.

• Type: integer

• Default value: 120

mid.probe.event.wait_time

Waiting period on an empty queue for sending events.

• Type: integer

• Default value: 1000

mid.probe.event.send.enabled

Enables or disables the sending of events.
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• Type: true | false

• Default value: true

mid.probe.event.queue.max_size

Specifies the maximum size permitted for the event queue before incoming events 
are rejected.

• Type: integer

• Default value: 100,000

mid.probe.event.max.retry_time

The maximum number of seconds MID retries sending events.

• Type: integer

• Default: 1800

mid.probe.event.queue.use_bulk

Specifies whether events are sent to the server singly or in bulk. If this parameter 
evaluates to true  then events are sent to the server in bulk.

• Type: true | false

• Default value: true

mid.probe.event.suppress.whitespaces

Allows line breaks in description fields for multi-line events. Apply this parameter to 
each MID Server used with event connector instances. Choices are:

all

This setting removes all whitespaces.

leave_as_is

This setting keeps all whitespaces.

keep_newline

This setting keeps only new_line and removes all other whitespaces.

• Type: string

• Default: all

mid.em.metric.metric_to_ci_map_limit

Specifies the maximum number of active metrics allowed per CI map.

• Type: integer

• Default value: 200,000

mid.em.metric_binding_timeout_seconds

Specifies the number of seconds to wait before resending unhandled events

• Type: integer

• Default value: 300

mid.em.metric_binding_timeout_max_seconds
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Specifies the maximum number of seconds to wait before resending unhandled 
events.

• Type: integer

• Default value: 10800

mid.em.metric_max_elapsed_time_before_refresh

Specifies the maximum number of seconds before the metric source type cache is 
refreshed in memory.

• Type: integer

• Default value: 60

mid.em.matric_max_sql_string_length_for_types

Specifies the maximum length of the string (composed of types) used for an SQL 
command

• Type: integer

• Default value: 30000

mid.em.statistics_report_perioon_sec

Specifies the period, in seconds, between statistics reports to the instance. Use 0  to 
disable reporting. This parameter requires a restart.

• Type: integer

• Default value: 60

mid.em.metric_connector_max_run_time_seconds

Specifies the maximum number of seconds to collect metrics in every cycle.

• Type: integer

• Default value: 300

mid.em.metric_connector_history_min

Specifies the number of minutes to go back in history to retrieve metrics.

• Type: integer

• Default value: 180

mid.em.metric_event_logging

Specifies the level of metric and event logging. Choices are:

• none

• all

• events

• metrics

• metrics:<filter>

• events:<filter>

• Type: string

• Default value: none
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mid.em.metric_connector_late_arrivals_delay

Specifies the number of seconds to delay when collecting metrics.

• Type: integer

• Default value: 30

FTP connection parameters

mid.ftp.max_pool_size

Specifies the maximum size of the FTP Connection Pool, in megabytes.

• Type: integer

• Default value: 25

mid.ftp.max_per_target

Specifies the maximum number of the FTP connections per target.

• Type: integer

• Default value: 5

mid.ftp.max_conn_idle_time

Specifies the maximum amount of time, in milliseconds, that an FTP connection can 
sit idle in the pool.

• Type: integer

• Default value: 300000

mid.filesystem.max.ls

Specifies the maximum number of files that can be returned in the filesystem list 
directory command.

• Type: integer

• Default value: 10000

Logging parameters

disable_monitors

Specifies whether to disable the MID Server from actively checking for monitors on 
the instance.

• Type: true | false

• Default value: true

mid.show.queries

Instructs the MID Server whether to log details about every query it makes to the 
ServiceNow instance. Typically this parameter is only used by developers, but it 
is occasionally useful when troubleshooting a problem. Be aware that setting this 
parameter to true  causes intensive logging on the MID Server, potentially using 
considerable disk space.

• Type: true | false

• Default value: false

disable.remote.logging
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Prevents the MID Server from logging any information to the MID Server log on 
the instance. Relatively little information is logged on the instance in any case, but 
setting this parameter to true  eliminates all logging to the instance.

• Type: true | false

• Default value: false

disable.status

Prevents the MID Server from sending a status report to the instance every 10 
minutes.

• Type: true | false

• Default value: false

mid.file_cleaner.disabled

Files and empty folders within the following folders may be deleted by this MID File 
Cleaner. Files last accessed more than 30 days ago are deleted. It runs on start-
up, and then every 24 hours after that. You can force the File Cleaner to run by 
restarting the MID Server service.

Folders/files cleaned:

• \agent\import

• \agent\export- Used by the Export Set feature.

• \agent\work\monitors\ECCSender\output_error  - Used for ECC 
input payloads that cannot be inserted for any reason

• \agent\work\monitors\ECCSender\output_oversize  - Used 
for saving copies of payloads that are not sent to the instance because they 
are larger than the limit set by mid.eccq.max_payload_size, which defaults to 
20000000 bytes

• \agent\logs- Specifically JFR Dumps

• Type: true | false

• Default value: false

mTLS protocol parameters

Add these parameters to the config.xml  file in the /agent  directory, in the MID Server 
installation directory.

mid.httpclient.protocol.myprotocol.path

Specifies the path to the keystore. The path can be absolute or relative. In the 
parameter name, make sure you replace myprotocol  with the name of your protocol.

Type: String.

mid.httpclient.protocol.myprotocol.port

Specifies the port number for the protocol. In the parameter name, make sure you 
replace myprotocol  with the name of your protocol.

Type: String.

mid.httpclient.protocol.myprotocol.password
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Specifies the mTLS credential password. In the parameter name, make sure you 
replace myprotocol  with the name of your protocol. Add the encryption attribute 
secure="true"  to encrypt the password using standard MID Server  encryption.

Type: String.

Pattern parameters

mid.parsing.max_field_size

Sets the maximum character length of strings stored as temporary variables while 
patterns are run. Strings longer than this parameter's value are truncated to equal 
the value. Use the parameter to increase the limit when parsing longer strings.

Warning: 
Exceeding the max field size limits of the SQL database implementation cause 
errors.

• Type: integer

• Default value: 1024

mid.sa.discovery.pattern_string_attributes.deduplicate

Reduces memory consumption for pattern execution context attributes by 
eliminating duplicate strings.

• Type: true | false

• Default: true

Proxy server parameters

mid.instance.use_proxy or mid.proxy.use_proxy

If your MID Server must go through a web proxy to access the ServiceNow  instance, 
set this parameter to true  to instruct the MID Server to use the proxy. You must also 
set the proxy server's host and port, and perhaps the user name and password as 
well.

• Type: true | false

• Default value: false

mid.proxy.host

If your MID Server must go through a web proxy to access the ServiceNow  instance, 
set this parameter to define the proxy's host.

• Type: string

• Default value: none

mid.proxy.password

If your MID Server must go through a web proxy to access the ServiceNow  instance, 
and your proxy requires a password, set this parameter to define that password.

• Type: string

• Default value: none

mid.proxy.port
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If your MID Server must go through a web proxy to access the ServiceNow  instance, 
set this parameter to define the proxy's port.

• Type: integer (0-65535)

• Default value: 80

mid.proxy.username

If the MID Server must go through a web proxy to access the ServiceNow  instance, 
and the proxy requires a user name, set this parameter to define that user name.

• Type: string

• Default value: none

Request timeout override parameters

mid.sa.cloud.request_timeout

Sets the timeout in milliseconds for cloud requests. This parameter overrides 
the glide.http.timeout  system property, which specifies the maximum number of 
milliseconds to wait before an outbound REST transaction times out.

• Type: integer

• Default value: 30000

mid.http_classy.request_timeout

Sets the timeout in milliseconds for HTTP classification requests with the HTTP - 
Classify probe. This parameter overrides the glide.http.timeout  system property, 
which specifies the maximum number of milliseconds to wait before an outbound 
transaction times out.

• Type: integer

• Default value: 30000

Security parameters

mid.windows_host.file_permissions.allow_list

Sets an inclusion list for Windows file permissions enforcement to improve security. 
The parameter takes a string of comma separated group names, user names, and 
SIDs. Group and user names must follow SAM account naming requirements. 
Domain accounts can be specified by using the SID.

• Type: string (comma separated group and user names)

• Default value: None

mid.windows_host.file_permissions.enforce

Enables the MID Server to use Windows file permissions enforcement to improve 
security. Setting this parameter to false  will prevent the MID Server from updating 
the file permissions inclusion list, but will not revert the file permissions.

• Type: true | false

• Default value: true

Shazzam parameters

mid.shazzam.regulator.interval_ms
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Sets the interval, in milliseconds, in which Shazzam 
can launch packets. This parameter works with the 
mid.shazzam.regulator.packets_per_interval  parameter to set 
the number of packets allowed in this interval. By default, Shazzam launches one 
packet each millisecond.

• Type: integer

• Default value: 1

mid.shazzam.regulator.packets_per_interval

Sets the number of packets that Shazzam can launch in the configured time interval. 
This parameter works with the mid.shazzam.regulator.interval_ms 
parameter, which sets that interval. By default, Shazzam launches one packet each 
millisecond.

• Type: integer

• Default value: 1

mid.shazzam.chunk_size

Specifies the maximum number of IP addresses that Shazzam scans in parallel. This 
parameter primarily controls outbound port consumption.

• Type: integer

• Default value: 100

mid.shazzam.threads

Specifies the number of concurrent threads that Shazzam uses. Setting this or the 
mid.shazzam.max_scanners_per_thread parameter to 0 disables Shazzam multi-
thread optimization.

• Type: integer

• Default value: 5

mid.shazzam.max_scanners_per_thread

Specifies the number of concurrent scanners processed by each Shazzam thread. 
Setting this or the mid.shazzam.threads parameter to 0 disables Shazzam multi-
thread optimization.

• Type: integer

• Default value: 500

SNMP configuration parameters

mid.snmp.enable_auto_public

Specifies whether to use the SNMP public community string automatically if no 
other SNMP credentials were successful.

• Type: true | false

• Default value: true

mid.snmp.request.timeout

Specifies the timeout value for the first OID request, in milliseconds. For subsequent 
requests (for example, table OIDs), the mid.snmp.session.timeout 
configuration  parameter (see below) takes effect.
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Note: 
You can override this parameter with the timeout  SNMP probe parameter.

• Type: integer

• Default value: 1500

mid.snmp.session.timeout

Specifies the timeout value for subsequent OID request, in milliseconds. SNMP 
communication is stateless and does not have a session or connection in the 
normal sense. The system regards a positive response from the first OID request as 
a sign that it should expect prompt responses to subsequent requests. While the 
default is short, it may be useful to increase this parameter value to the same value 
as that used for mid.snmp.request.timeout.

Note: 
You can override this parameter with the establish_session_timeout 
SNMP probe parameter.

• Type: integer

• Default value: 500

mid.snmp.use_getbulk

Specifies whether to use GETBULK to receive a large amount of data in batches. 
This can be used to configure an individual MID Server.

• Type: true | false

• Default value: True

GETBULK can also be set at the probe level or globally for all MID servers. Settings 
are listed in the order of precedence:

• SNMP probe parameter

• MID Server configuration parameter

• MID Server properties

mid.snmp.use_snmp4j

Use the Snmp4j library for SNMP communication. This is a strict requirement 
for SNMPv3. This parameter should only be set to false  based on advice from 
Customer Service and Support.

• Type: true | false

• Default value: true

mid.snmp.use_snmp_v1_v2c

Attempt communication using the SNMPv1 and SNMPv2c protocol versions. It 
may require configuration of SNMP community credentials . This parameter is an 
alternative and  not a strict requirement for SNMPv3.

• Type: true | false

• Default value: true

mid.snmp.use_snmp_v3
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Attempt communication using the SNMPv3 protocol version. Requires configuration 
of SNMPv3 credentials.

• Type: true | false

• Default value: true

SSH Discovery parameters

By default, the MID Server is configured to search for SSH commands in the following paths and 
the logged-on user's default paths:

• /usr/sbin

• /usr/bin

• /bin

• /sbin

mid.connection_cache

Specifies whether to cache connections. Set to false  to disable connection caching. 
This parameter applies to SSH connections only.

• Type: true | false

• Default value: true

mid.ssh.set_path

Specifies whether to set the PATH environment variable for SSH commands.

• Type: true | false

• Default value: true

mid.ssh.local

Specifies whether to execute commands for the MID Server host machine 
(localhost) via SSH rather than from a console. This allows long-running commands 
to execute properly. This parameter applies to the legacy SSH client only.

• Type: true | false

• Default value: false

mid.ssh_connections_per_host

Controls the number of concurrent probes the MID Server can run against a given 
host. Lowering the number of concurrent connections can slow Discovery.

• Type: integer

• Default value:

7 for the ServiceNow  client

3 for the legacy SSH client.

mid.ssh.sudo_preserve_environment

Specifies whether to use sudo to preserve the environment for SSH.

• Type: true | false

• Default value: false
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mid.ssh.terminal.width

Controls the maximum characters per line when handling sudo -l in the terminal. 
If the value is too low, the output can be broken into multiple lines and affect the 
parser. Set the value to a sufficient size to handle outputs as needed.

• Type: int

• Default value: 255

mid.ssh.path_override

Overrides the default paths set before executing a command. Enter one or more 
override paths delimited by a colon (:). The default path is /usr/sbin: /usr/bin: /bin: /
sbin.

• Type: string (a colon-separated list of directories)

• Default value: None

The ServiceNow  SSH client accepts the following prefixes in front of the 
path_overide value.

• append: Appends the override path to the end of the host’s path. This is the 
default behavior.

• replace: Replaces the host path with the path_overide value.

• prepend: Appends the override path to the front of the host path.

mid.ssh.use_snc

Enables the ServiceNow  SSH client (SNCSSH) on individual MID Servers. SNCSSH 
is a ServiceNow  implementation of an SSH client and is active by default for all MID 
Servers on new instances, via a MID Server property. Enabling the ServiceNow  SSH 
client disables the legacy J2SSH client.

Important: 
Mixing SSH client types for MID Servers connected to the same instance is not 
a good practice.

• Type: true | false

• Default value: false

mid.ssh.max_retries

Specifies the maximum amount of times to retry an SSH operation after a time-out. 
The system sleeps two seconds between each connection attempt. By default, the 
MID Server retries once only. Set the parameter to 0  to disable retries.

• Type: integer

• Default value: 1

mid.ssh.alt_rm

Sets a different SSH remove file command.

• Type: string

• Default value: none

mid.ssh.initial_delay_ms
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Delays sending any SSH probe commands to a server after connecting to the target 
for the time specified, in milliseconds. This parameter applies to the legacy SSH 
client only.

• Type: integer (milliseconds)

• Default value: 0

mid.ssh.suppress_history

Suppresses the generation of the SSH history file. This parameter applies to the 
legacy SSH client only.

• Type: true | false

• Default value: false

mid.ssh.socket_timeout

Specifies the timeout value for the SSH socket to prevent issues created by a socket 
timeout. Some devices, such as systems with embedded controllers like UPSs and 
PDUs, that have SSH enabled require more time to respond to an authentication 
request. The default value of 2 minutes ensures such requests do not timeout 
prematurely.

• Type: integer (milliseconds)

• Default value: 120000 (2 minutes)

mid.ssh.channel_timeout

Specifies the amount of time that the MID Server waits for activity on the SSH socket 
before closing the connection. If there has been no activity on the SSH socket for 
the specified timeout value, the MID Server closes the connection. Some devices, 
such as systems with embedded controllers like UPSs and PDUs, that have SSH 
enabled may require more time to respond to an authentication request.

• Type: integer (milliseconds)

• Default value: 120000 (2 minutes)

mid.ssh.session_timeout

Specifies the amount of time that a cached session remains in memory after last 
use. Excessively small values tend to decrease performance. This parameter 
applies to the ServiceNow  SSH client only.

• Type: integer (milliseconds)

• Default value: 300000 (5 minutes)

mid.ssh.command_timeout_ms

The timeout duration, in milliseconds, for the execution of an SSH command.

• Type: integer (milliseconds)

• Default value: 300000 (5 minutes)

mid.ssh.use_keyboard_interactive

Uses the keyboard interactive authentication mode in SSH daemons on which it is 
activated.

• Type: true | false

• Default value: false
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Warning: 
An issue exists in Mac OS X Sierra and later with the authentication order of 
the password  and keyboard-interactivemodes that can cause Discovery to 
fail. For details about this issue and the configuration required for proper SSH 
authentication, see KB0623600 .

mid.ssh.dh_group_length_min

Specifies the minimum group length in bits used for generating a "shared secret" 
key in Diffie-Hillman key exchange. The larger the key the more secure the SSH 
connection is but at the cost of performance.

• Type: integer (bits)

• Default value: 1024

mid.ssh.dh_group_length_max

Specifies the maximum group length in bits used for generating a "shared secret" 
key in Diffie-Hillman key exchange. The larger the key the more secure the SSH 
connection is but at the cost of performance.

• Type: integer (bits)

• Default value: 8192

mid.ssh.shells_supported

Defines the bourne-compatible shells supported by the MID Server. This value is a 
comma-separated list of supported shells, such as ksh, dsh, bash  and sh.

• Type: string

• Default value: ksh,bash,sh

mid.ssh.discard_lrc_error

Discard long running command error output, emulating legacy behavior.

• Type: string

• Default value: j2ssh - true, sncssh - false

mid.ssh.pool_thread_ratio

Ratio of the SSH session pool capacity to the configured MID Server thread number 
(threads.max), expressed as a percentage. The number of permitted pool capacity 
sessions is set in this parameter. Regardless of the value set in this parameter, the 
system never permits the pool capacity to fall below 25 sessions.

• Type: integer

• Default value: 150

mid.ssh.disable_privilege_check

This parameter has no effect if the target is using a privileged command other than 
sudo. For more information, see MID Server privileged commands.

The remainder of this section only applies to targets which run sudo. When this 
parameter is set to true, the MID Server assumes that the user configured in the 
credential has the privilege to run the given command using sudo. The MID Server 
assumes the target user can run any command string following sudo on the target. 
When this parameter is set to false, the MID Server runs "sudo -l" on the target 
to verify the command which follows sudo has permission to run on the target. 
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Regardless of this parameter's value, the MID Server always validates that sudo by 
itself can be run on the target.

Some releases do not show this parameter in the MID Configuration Parameters pull 
down list. In this case, you may optionally add this parameter in MID Properties.

• Type: true | false

• Default value: false

Upgrade parameters

mid.pinned.version

Name of the version to which this MID Server is pinned.

• Type: string

• Default value: MID buildstamp

Note: 
To see the MID buildstamp for your instance, type stats.do  in 
the navigation filter. An example of the buildstamp format is 
london-06-27-2018__patch3-10-24-2018_11-11-2018_0542.

mid.upgrade.use_proxy

If your MID Server must go through a web proxy to access the upgrade URL, set this 
parameter to true  to instruct the MID Server to use the proxy. You must also set the 
proxy server's host and port. If the instance proxy user name and password are set, 
they are used for the upgrade proxy as well.

Note: 
This parameter is not intended to control proxy details configured with 
glide.mid.autoupgrade.proxy*  parameters.

• Type: true | false

• Default value: true

glide.mid.autoupgrade.proxy_host or glide.glidesoap.proxy_host

If your MID Server must go through a web proxy to access the upgrade URL, define 
the proxy's host here.

• Type: string (URL)

• Default value: none

glide.mid.autoupgrade.proxy_port or glide.glidesoap.proxy_port

If your MID Server must go through a web proxy to access the upgrade URL, define 
the proxy's port here.

• Type: integer (0-65535)

• Default value: 80

glide.mid.autoupgrade.proxy_user

If your MID Server must go through a web proxy to access the upgrade URL, define 
the proxy's user name here.
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• Type: string (URL)

• Default value: none

glide.mid.autoupgrade.proxy_password

If your MID Server must go through a web proxy to access the upgrade URL, define 
the proxy's password here.

• Type: string

• Default value: none

Windows Discovery parameters

mid.powershell_api.session_pool.max_size

Specifies the maximum number of sessions allowed in the session pool.

Note: 
Setting or changing this parameter requires restarting the MID Server.

• Type: integer

• Default value: 25

mid.powershell_api.session_pool.target.max_size

Specifies the maximum number of sessions allowed in the pool per target host.

Note: 
Setting or changing this parameter requires restarting the MID Server.

• Type: integer

• Default value: 2

mid.sa.prefer_powershell

Enables MID Server  to use PowerShell Remoting.

• Type: true | false

• Default value: false

mid.powershell_api.winrm.use_ssl

Requires the use of SSL certificates for HTTPS connections using WinRM.

• Type: true | false

• Default value: false

mid.powershell_api.winrm.additional_pssesion_options

Controls advanced options for a PSSession. For more information about advanced 
PSSession options, see https://docs.microsoft.com/en-us/powershell/module/
microsoft.powershell.core/new-pssessionoption?view=powershell-6 .

mid.powershell_api.winrm.remote_https_port

Configures the port for connecting to Windows servers using PowerShell over 
HTTPS.
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• Type: integer

• Default value: 5986

mid.powershell_api.winrm.remote_port

Configures the port for connecting to Windows servers using PowerShell over HTTP.

• Type: integer

• Default value: 5985

mid.powershell_api.winrm.skip_ssl_cert_check

Skips the SSL certificate check when using WinRM for HTTPS connections.

• Type: true | false

• Default value: false

mid.powershell_api.winrm.skip_ssl_cert_check_options

Skips specific SSL certificate checks when using WinRM for HTTPS connections. 
Configure the MID Server  to skip checks for certificates from a Certification 
Authority (CA), from the Common Name (CN) that identifies the host associated with 
the certificate, and for revoked certificates.

• Type: string

• Default value: -SkipCACheck -SkipCNCheck -SkipRevocationCheck

mid.powershell.use_credentials

Determines the credentials to use for Discovery  with PowerShell. A setting of 
true  directs the MID Server  to run probes with the Windows  credentials from the 
credentials table. To run probes with the credentials of the user for the MID Server 
service, set this parameter to false.

• Type: true | false

• Default value: true

mid.powershell.path

Enables an administrator to point to a specific PowerShell on a MID Server  in 
cases where more than one PowerShell is installed. Supply the path to the folder 
containing the PowerShell executable, for example, C:\mypowershell  or C:
\mypowershell\. ServiceNow  automatically appends the string powershell.exe 
to the path. Configure this parameter when both a 32-bit and 64-bit PowerShells 
are active on the same MID Server, and it becomes necessary to launch the correct 
PowerShell for the context. 64-bit Windows  employs file system redirection and 
the MID Server  runs as a 32-bit application. If trying to specify a path in %WinDir%
\System32, Windows  automatically redirects to %WinDir%\SysWOW64. To avoid 
redirection, specify the path as %WinDir%\Sysnative. For example, instead of C:
\WINDOWS\system32\WindowsPowerShell\v1.0\, specify C:\WINDOWS\sysnative
\WindowsPowerShell\v1.0\.

Note: 
On a 64-bit version of Windows  XP, a Microsoft  hotfix may be required to 
enable this.

To discover applications running on a 64-bit Windows machine, the MID Server 
must be running on a 64-bit Windows host machine.
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• Type: string (path)

• Default value: none

mid.powershell.enforce_utf8

Enable this parameter to force commands on a target Windows system to return 
UTF-8 encoded output. Disabling it allows the target system to use its default 
encoding. This parameter is only valid when PowerShell is enabled.

Setting this value to false  may result in incorrect values in the CMDB when non-
ASCII characters are returned by a probe.

• Type: true | false

• Default value: true

mid.powershell.local_mid_service_credential_fallback

Enables automatically falling back to MID Server  service credentials if all other 
credentials fail.

• Type: true | false

• Default value: true

mid.powershell_api.idle_session_timeout

Specifies the timeout value of idle PowerShell sessions in seconds.

Note: 
Setting or changing this parameter requires restarting the MID Server.

• Type: integer

• Default value: 60

mid.powershell.command.parameter_passing

Enable this parameter to allow passing PowerShell parameters from the command 
line.

• Type: true | false

• Default value: false

mid.powershell.command.script.parameter_passing

Enable this parameter to allow passing PowerShell scripts from the command line.

• Type: true | false

• Default value: true

mid.windows.management_protocol

Enables administrators to select the Windows management protocol used for 
device and process classification. Options include: WMI and WinRM.

• Type: string

• Default value: WMI

mid.windows.probe_timeout
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Sets the timeout interval for all Windows probes on a specific MID Server. This value 
is overridden by the values configured for individual probes with the wmi_timeout 
probe parameter.

• Type: integer

• Default value: 300

mid.powershell.jea.append_username

Specifies whether user name of the current user will be appended to the JEA 
endpoint.

• Type: true | false

• Default value: False

mid.powershell.jea.endpoint

JEA configuration name (endpoint) on remote servers that the MID Server will 
connect to. Set to JEA_DISCO_BASIC.

• Type: string

• Default value: ""

Add a MID Server parameter

Use a MID Server parameter to control the behavior of a particular MID Server.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > MID Server  > Servers.

2. From the list of MID Servers, select a MID Server to configure.

3. Select the Configuration Parameters  related list.

This shows all the parameters currently in the MID Server's configuration file. If there are any 
passwords, they are displayed in asterisks for security reasons. See MID Server parameters  for 
a list of available parameters.

Defining MID Server configuration parameters
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4. To add parameters, click New, and then complete the form.
After the form is submitted, the configuration file for that MID Server is modified to include the 
new parameter. Changes to existing parameters are reflected in the MID Server configuration 
file as well. Changes made to the MID Server configuration file do not take place immediately, 
but rather the next time the MID Server is restarted. The MID Server form has a related link for 
restarting the MID Server.

Note: 
ServiceNow  prevents you from saving changes, such as modifying or deleting 
parameters, that would cause the MID Server to lose communications with the instance. 
For example, you cannot change the url parameter. Any changes to these protected 
parameters must be made directly in the config.xml  file for that MID Server.

5. Optional:  Set parameters in the config.xml  file.
MID Server configuration is controlled by an XML file called config.xml. This file is located 
in the /agent  directory, in the MID Server isntallation directory. You can edit this file directly 
to make any configuration changes to protected parameters. Many configuration changes, 
such as those that do not disrupt communication between the MID Server and the ServiceNow 
instance, may also be made from the instance.

The structure of the config.xml  file is simply an outer parameters tag and a series of inner 
parameter tags. Each parameter tag has name and value  attributes.

◦ To change the value of a parameter, edit the value attribute.

◦ To add a parameter, add another parameter tag with its name and value.

◦ To delete a parameter, delete the entire parameter tag.

The order of the parameters within the file is not important. Notice the green comment sections 
in the sample. Use these elements to add useful comments to the configuration file.

Note: 
When configuring the MID Server for use with a proxy server, be sure to remove the 
comment tags around the proxy sections that you configure.
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MID Server config.xml file

Note: 
The sample file here is from a Firefox browser. Conventional text editors, such as 
Notepad, WordPad, or TextEdit, do not display colors and variable fonts.

MID Server Configuration Parameter settings and priority

The MID Server's settings reside in multiple tables and the MID Server prioritizes them in a set 
order. MIDConfigParameter must be defined with the correct type-style builders.

MID Server settings priority

MID Server settings can reside in both the Configuration Parameter table and Properties tables. 
MID Servers prioritize the settings in the following order:

1. MID Configuration Parameter

2. MID Property (specific MID)

3. MID Property (global)

Invalid Record Prevention

Avoid creating duplicate records in the MID Property table because they can invalid records. 
Duplicate properties have the same name and are assigned to the same MID Server.

Similarly, avoid creating global configuration parameters because they are unsupported. Global 
configuration parameters are configuration parameters with no assigned MID Server. If a setting 
should be applied to all MID Servers, then use a global MID Property.
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MID Server File Cleaner

A monitor thread runs in the MID Server to clean up old files, to keep the size and quantity of files 
within the install folder manageable, and to prevent performance issues with the MID Servers.

Files and empty folders within the following folders may be deleted by this MID File Cleaner. Files 
last accessed  more than 30 days ago are deleted.

It runs on startup, and then every 24 hours after that. You can force the File Cleaner to run by 
restarting the MID Server service.

Folders/files cleaned:

• \agent\import

• \agent\export - Used by the Export Set feature.

• \agent\work\monitors\ECCSender\output_error - Used since San Diego for ECC input 
payloads that cannot be inserted for any reason (see PRB1521761/KB0995569 ).

• \agent\work\monitors\ECCSender\output_oversize - Used since Eureka/Fuji for saving copies 
of payloads that are not sent to the instance because they are larger than the limit set by 
mid.eccq.max_payload_size, which defaults to 20000000 bytes (see PRB598334)

• \agent\logs - Specifically JFR Dumps (Utah release)

Logging

The MID Server agent log shows this monitor starting and shutting down with the MID Server.

2022-10-21T13:08:58.330+0200 INFO (MIDServer) [Main:265] 
 Initializing MID Server
2022-10-21T13:10:36.527+0200 INFO (StartupSequencer) 
 [Monitors:307] Enabling monitor: FileCleanerMonitor
...
2022-10-24T09:29:35.193+0200 INFO (MIDServer) 
 [MIDServerState:160] MID Server stopping
2022-10-24T09:29:38.591+0200 INFO (MIDServer) [Instance:928] 
 interrupting thread FileCleanerMonitor.21600

To see exactly when it runs, enable debug with parameter mid.log.level=debug

2022-11-17T02:49:13.201-0800 DEBUG (FileCleanerMonitor.21600) 
 [AFileCleaner:103] Scanning directory to delete files: 
 C:\...\agent\import
2022-11-17T02:49:13.201-0800 DEBUG (FileCleanerMonitor.21600) 
 [AFileCleaner:103] Scanning directory to delete files: 
 C:\...\agent\export
2022-11-17T02:49:13.201-0800 DEBUG (FileCleanerMonitor.21600) 
 [AFileCleaner:103] Scanning directory to delete files: 
 C:\...\agent\work\monitors\ECCSender\output_error
2022-11-17T02:49:13.201-0800 DEBUG (FileCleanerMonitor.21600) 
 [AFileCleaner:103] Scanning directory to delete files: 
 C:\...\agent\work\monitors\ECCSender\output_oversize
2022-11-17T02:49:13.201-0800 DEBUG (FileCleanerMonitor.21600) 
 [AFileCleaner:103] Scanning directory to delete files: 
 C:\...\agent\logs

There is no logging for individual file/folder deletes.
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Disabling the MID File Cleaner

Export Sets write files to the MID Server agent\export folders. The idea is then that a custom 
implementation on the customer side takes those files and moves them elsewhere, so that these 
files only need to remain in the MID Server application's install directory for a short time.

The MID File Cleaner can be disabled completely for all folders, by adding the MID Server 
Configuration Parameter mid.file_cleaner.disabled=true. When the parameter is not present, 
which is the out-of-box state, it defaults to false, and the file cleaner runs.

On the MID Server form, click New on the "Configuration Parameters" related list, select 
mid.file_cleaner.disabled, and enter the value "true".

This can also be manually added to the config.xml file: <parameter 
name="mid.file_cleaner.disabled" value="true"/>. See MID Server 
parameters  for more information.

MID Server protected records and reserved characters

Some MID Server records cannot be altered. Certain special characters are pre-defined in XML 
and cannot be used in passwords.

1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

MID Server Records that cannot be altered

These records cannot be modified or deleted.

Table Record

Public Page [sys_public] InstanceInfo

Scripted Web Service [sys_web_service] • InstanceInfo

• GetMIDInfo

• MIDAssignedPackages

• MIDFieldForFileProvider

• MIDFileSyncSnapshot
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Table Record

• MIDServerCheck

• MIDServerFileProvider

Using special characters in an XML file

The XML specification defines five predefined entities that represent special characters, and 
requires that all XML processors honor them. If these characters are used in a password, you will 
experience unexpected results.

The following characters represent the five pre-defined entities:

• "

• &

• '

• <

• >

If you use the pre-defined entity characters in an XML file, such as the MID Server configuration 
file, you need to encode them. To encode pre-defined entities into an XML document:

• replace "  with &quot;

• replace &  with &amp;

• replace '  with &apos;

• replace <  with &lt;

• replace >  with &gt;

For example, to specify the password as test&  in the MID Server config.xml file:

<parameter encrypt="true" name="mid.instance.password" 
 value="test&amp;"/>

MID Server privileged commands

To discover certain information on a host server, the MID Server must run SSH commands with 
higher privileges. The platform provides default privileged commands for the MID Server to use 
and the ability to add additional commands to the system.
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1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

An example of information that requires elevated privileges is information about storage disks 
on a host server, retrieved with the fdisk -l  command. If your system cannot use sudo 
commands, you must configure the hosts in your network to use one of the other privileged 
commands. You can configure different privileged commands for different hosts. However, 
Discovery  supports only one privileged command per host.

Important: 
You can edit supported privileged commands, but do not delete them.

For a list of possible SSH commands requiring root privileges, see SSH credentials .

SSH privileged escalation command requirements

Command Description

sudo • Host must support the sudo -S -p <password>  command and return the 
correct list of allowed SSH commands.

• Credentials provided for Discovery must be able to run the command sudo -S 
-p <password> <commands>.

pbrun • Host must support the pbrun -v  command and return the correct version of 
PowerBroker.

• Credentials provided for Discovery must be able to run pbrun <commands>.

• Discovery does not support any other pbrun -  options, such as a password 
prompt.

• The instance must be able to reach the target host via SSH.

pfexec • Host must support the pfexec id -a  command and return the correct ID.

• Credentials provided for Discovery must be able to run pfexec <commands>.

• Discovery does not support any other pfexec -  options, such as a password 
prompt.
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SSH privileged escalation command requirements  (continued)

Command Description

dzdo • Host must support the command –v dzdo  command and return the path to 
dzdo in standard output.

• Credentials provided for Discovery  must be able to run dzdo <commands>.

• Discovery does not support any other dzdo –  options, but Discovery  supports 
password authentication for dzdo.

Long-running commands with sudo

Configure J2SSH and ServiceNow  SSH to prevent long running commands using sudo from 
failing when the MID Server disconnects.

ServiceNow  SSH allows probes to run sudo against individual commands or an entire, long-
running script. This is also supported for the pbrun  and pfexec  privileged commands.

Sudo for individual commands

You can run sudo against individual commands within a probe, but only if all the following sudoer 
configurations are performed on the target:

• The !requiretty  option is required.

• Allow individual commands to be run by the user in the provided credential with NOPASSWD 
configured.

• The target specifies an individual sudo call in the command or referenced scripts. For example, 
set sudo as "sudo fdisk -I"  or "${sudo:fdisk -I}"  rather than "must_sudo" 
for the entire script.

Note: 
Running sudo against individual commands with ServiceNow  SSH produces detailed and 
useful entries in the sudo logs on the target computer.

Running sudo on an entire script

If any of the required sudoer configuration requirements for individual commands is not in place, 
Discovery applies sudo to the initial and complete probes, and does not execute sudo remotely 
inside the command. This condition can be forced by setting must_sudo  on the probe and 
eliminating any sudo commands within the probe.

This approach prevents long running commands from failing when the probe disconnects, but 
cannot specify individual commands in the sudoers configuration.

Logging

The logs from ServiceNow  SSH sudo activity run against an entire script show cryptic entries, 
such as /tmp/.run.aef13123fe124123, which prevent administrators from controlling 
permissible commands and knowing the exact command that was run. Sudo run against 
individual commands produces more detailed log entries, such as /sbin/fdisk –l.

Add a new privileged command for use by the MID Server

Add a new privileged command to the Privileged Command [privileged_command] table that is 
available to your MID Servers.
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Before you begin
Role required: admin

About this task
Important: 
Do not delete any of the supported commands.

Procedure

1. Navigate to All  > MID Server  > Privileged Command  and click New.

2. Complete these fields:

◦ Command: The name of the privileged command.

◦ Password Prompt: The password prompt displayed to the user for this privileged command, 
or a regular expression that matches this password prompt. If this field is empty, no 
password is required for this privileged command, and no prompt is displayed. SUDO 
commands do not require a password prompt.

3. Click Submit.

Configure the MID Server to use specific privileged commands

You can configure the MID Server to use specific commands in a defined order.

Before you begin
Role required: admin

Procedure

1. Navigate to the list of MID Servers using one of the following paths:

◦ MID Server  > Servers

◦ Discovery  > MID Servers

◦ Orchestration  > MID Servers

2. Select the MID Server you want to configure.

3. Click the menu icon in the header bar and select View  > Advanced  from the context menu.
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Selecting the Advanced view

4. In the Privileged Command  related list, click Edit.

5. Select the command you want this MID Server to use and click Save.
The default order of privileged commands is 100, but you can change the order as necessary. 
The privileged command with the smallest order number is tried first.

List of privileged commands to use for a MID Server

Create a pbrun profile privileged command

You can create a special configuration for the pbrun  privileged command that allows it to run as 
a profile.

Before you begin
Role required: discovery_admin, admin

About this task
Of all the privileged commands, only the pbrun  command can be configured to run as a profile, 
and only one of these special pbrun  configurations can function on a MID Server.

Important: 
Edit the existing pbrun  record for this purpose. The system ignores any additional 
commands you create for pbrun.
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Procedure

1. Navigate to All  > MID Server  > Privileged Command.

2. Select pbrun  from the list.

3. In the Privileged Command record, edit the value in the Command  field to use the format 
pbrun -u <profile>.
For example, you can set pbrun -u admin  as a command to run with an admin profile.

4. Click Update.

What to do next
Return to Configuring MID Servers.

MIDSystem methods

MIDSystem variables (referred to by the variable name ms.) provide a variety of methods to get 
information about the MID Server.

1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

Method summary Description

log(String message) Logs the given message with a standard prefix to indicate that the 
message was generated by JavaScript.

getConfigParameter(String 
parameter name)

Returns the value of the named configuration parameter.

include(String script 
include)

Include the MID Server script include with the given name into the 
current context.

getName() Returns the name of the MID Server.

getSysID() Returns the sys_id of the MID Server.

toJavaScript(Object) Converts the given Java object into the equivalent JavaScript 
object.

This example writes a message to the log:

ms.log('Attempting to log in with user: ' + 
this.getParameter('user'));
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Manually start, stop, and restart a MID Server

If you did not start the MID Server  at the end of the installation procedure, you can manually start 
the MID Server.

Before you begin
Role required: MID Server Service account user or a Windows Admin account

This procedure is only for users who install the MID Server using the ZIP file. The Windows MID 
Server installer completes the installation automatically.

Procedure

1. Open the agent directory in the directory you created for the MID Server  installation files.
For example, the path might be C:\ServiceNow\MID Server1\agent.

2. Start the MID Server by executing the start.bat  file.

3. To stop the MID Server, execute the stop.bat  file.

4. To restart a stopped MID Server, either:

◦ If the MID Server is stopped, execute the start.bat  file.

◦ If the MID Server is running, execute the restart.bat  file.

MID Server heartbeat

The instance checks the MID Server for a response every 5 minutes, using a synthetic 
transaction monitoring system.

1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

Checking for a heartbeat

ServiceNow  instances send a synthetic transaction via the Heartbeat probe to every MID Server 
every 5 minutes. The Heartbeat probe functions exactly as a normal probe does and is sent by 
writing an output record to the ECC queue. A MID Server retrieves the record when it queries the 
ECC queue for work. The MID Server processes the probe just as it would any other probe and 
responds back to the instance. If the instance does not detect a response from a MID Server, the 
instance marks that MID Server as Down. If the MID Server responds, the instance considers the 
MID Server to be functioning and communicating properly with the instance.
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Note: 
Make sure that your MID Server can communicate on port 443. See Configure MID Server 
network connectivity  and MID Server system requirements  for more information.

System events

When a MID Server transitions from one state to another, one of these events is triggered:

• mid_server.up: The MID Server goes from a status of Down, Paused, or Upgrading  to a status 
of Up.

• mid_server.down: The MID Server goes from a status of Up  to a status of Down.

• mid_server.paused: The MID Server is paused.

• mid_server.upgrading: The MID Server is being automatically upgraded because the instance 
is being upgraded.

You can use these events to send notifications or trigger actions that you specify in scripts.

Scheduled job

To change the trigger interval for the Heartbeat probe, navigate to System Scheduler  > 
Scheduled Jobs  > Scheduled Jobs. Open the MID Server Monitor  record and edit the interval.

MID Server heartbeat trigger interval

Set the MID Server JVM memory size

The MID Server starts with a default JVM memory allocation, but you can modify this setting in 
the configuration file.

Before you begin
Role required: admin
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1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

About this task
In the base ServiceNow  system, the MID Server JVM memory is set to 1024 MB, which is 
configured in the \agent\conf\wrapper-override.conf  file in the MID Server 
installation directory. This setting might not be appropriate for the way your organization uses the 
MID Server. If you want the MID Server to work harder, allocate more resources to it. If the MID 
Server is located in a small branch office and runs in an environment where memory allocation is 
shared between a print server, mail server, or web proxy server, the allocation might have to be 
reduced.

Note: 
For a complete list of minimum MID Server requirements, see MID Server system 
requirements.

Procedure

1. Open the \ServiceNow\<MID Server name>\agent\conf\wrapper-
override.conf  file in a text editor.
For more information about this file, see Installing Multiple MID Servers on a Single System.

2. Locate the following lines in the file:

  OPTIONAL: Maximum Java Heap Size (in MB)
wrapper.java.maxmemory=1024

3. Edit the memory allocation.

4. Remove the comment tag ( ) from the memory allocation parameter.

5. Save the file.

6. Restart the MID Server service.

Pause the MID Server

Pause the MID Server to temporarily prevent it from polling the ECC Queue for work or sending 
Discovery results back to the instance.

Before you begin
Role required: agent_admin
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1. Ensure that the MID Server can connect to elements inside and outside your network

2. Download and install the MID Server on a Linux or Windows host

3. Configure your MID Server

4. Configure MID Server security

5. Ensure that the MID Server can connect to elements inside and outside your network

6. Download and install the MID Server on a Linux or Windows host

7. Configure your MID Server

8. Configure MID Server security

About this task
You can only pause validated MID Servers. You might want to pause the MID Server when your 
network infrastructure is undergoing changes. This prevents applications like Discovery from 
throwing errors during a particular maintenance window.

A paused MID Server continues processing commands that it had already retrieved before it was 
paused. When you resume the MID Server, the MID Server starts retrieving new commands to 
process.

Note: 
Discovery continues to assign jobs to MID Servers that are Paused. MID Servers that are 
Down  are not assigned jobs.

Procedure

1. Open the MID Server record.

2. Select a running MID Server that has been validated.

3. On the MID Server form, select Pause MID  under Related Links.
The state of the MID Server changes to Paused.

A paused MID Server

4. To resume MID Server processing, select Resume MID  under Related Links.

MID Server pause

The MID server can be put into a Paused  state to temporarily prevent it from polling the ECC 
Queue for work or sending Discovery results back to the instance.

Unlike stopping the MID Server from the Windows  or Linux  server command line on the MID 
Server machine, pausing the MID server is something that you can do from the instance. The 
MID Server pause feature is available starting with the Istanbul release.
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Note: 
You can only pause validated MID Servers.

You can still perform these actions when the MID Server is paused:

• Access the MID Server logs  and delete log entries.

• View MID server statistics. While the MID Server is in the Paused  state it stops generating 
statistics. But you can still view the statistics generated before you paused the MID Server.

• Retrieve the MID Server thread dump.

• Make and save configuration changes  and property changes to the server. The changes take 
effect after the MID Server is resumed.

• Clear the ECC queue.

The MID server heartbeat  continues to function while the MID Server is in the Paused  state. If 
the MID Server is upgraded while it is in the Paused  state, the MID Server state automatically 
changes to Up  after successful upgrade. It does not return to the Paused  state.

During MID Server selection, paused MID Servers can still be selected but are prioritized below 
MID Servers that are not paused.

Events that occur during MID Server pause

The vCenter  and SNMP  event collectors, continue to run and process events when you pause 
the MID Server. These events are not part of the normal synchronous communication that the 
MID Server has with the instance that you see in the ECC queue. Events are still relayed to 
the instance and can even trigger actions on records in the instance, such as a CI update. For 
example, if vCenter detects that a virtual machine goes down or is deleted, a vCenter event 
makes a change to the status of the corresponding CI record for that virtual machine.

To prevent these events from being processed, stop the extensions from running. For more 
information, see:

• Configure and run the vCenter event collector extension

• Configure the SNMP Trap Collector Extension

Remote tables
Connect the ServiceNow AI Platform  to third-party sources, or to another instance, so that you 
can retrieve external data and optionally cache it in memory. You can view external data in lists 
or forms and process it with standard Glide scripts. You can also group, sort, aggregate, and filter 
the data just like you would for standard internal tables.

Remote table components

Use the following components to build an external data framework:

Remote tables

You create remote tables to describe the schema for the data that you want to 
retrieve from an external source.

The table definition is in the ServiceNow AI Platform, but its rows, or external 
records, live in memory. You create a remote table the same way that you would 
create a standard internal table. You define columns and controls and designate 
application access for it just like you would do for an internal table.  Unlike an internal 
table, a remote table does not get its records from the ServiceNow AI Platform 
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database. It gets its records from running an associated script against an external 
data source.

To learn more about creating remote tables, see Create a remote table.

Script definitions

You create and associate a script definition with a remote table. The external data 
that you've retrieved using the script can be cached in memory. You can also 
designate how this data is cached and how long the data is cached in memory. 
Every time that you refresh a list that contains the external data from a remote table, 
the associated script runs again.

To learn more about script definitions and how to associate them with a remote 
table, see Create a script definition for a remote table.

How remote tables work

By using a remote table, you can retrieve the data from external sources or from another instance 
with REST or SOAP services. The external data lives in memory in read-only mode, which makes 
the data temporary, or transient, within the ServiceNow AI Platform. You can then view and 
manipulate the external data without importing or storing it.

You view the external data in lists or forms in the same way that you view internally stored data. 
You can manipulate this data by using standard Glide records, business rules, remote APIs, 
scripting, table reference fields, services, and development tools in the ServiceNow AI Platform.

Important: 
If the data size that is retrieved from the external source is small, use the 1000 rows default 
limit in a remote table to minimize query times. If the retrieved data size is large and could 
be less performative, in the script definition, you can select the advanced Enhanced 
Capacity  field to support a large number of rows.

External data life cycle within the ServiceNow AI Platform

The data that you retrieve from an external source has a finite duration, or life cycle, within the 
ServiceNow AI Platform.

• When you run a script that is associated with a remote table, the retrieved data lives in memory 
for as long as the list or form appears. After you close the list or form, that external data is 
purged from memory. The next time that you use or view the external data in this remote table, 
memory is repopulated from the external system.

• However, if you have defined caching parameters for the script, the external data remains 
cached in memory for the specified caching duration.

For example, if you designate that the external data should be cached for 300 seconds, it 
remains cached in memory for 5 minutes. After that time expires, the cached data is purged 
from memory. The next time that you use or view the external data in this remote table, the 
cache is refreshed from the external system.

Practical applications for remote tables

Set up and use remote tables in your enterprise when:

• You want to fetch external data for temporary use without storing it in the ServiceNow AI 
Platform. For example, you can create a remote table that fetches weather-related data that 
appears on a homepage when a user logs in. You would then create an associated script 
definition that retrieves this data from a third-party weather source that is based on the user's 
location.
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• You want to retrieve customer details that are stored in an external Customer Relationship 
Management (CRM) application for viewing in Customer Service Management  functions such 
as Agent Workspace.

Note: 
To learn more about data retrieval for Customer Service Management, see Third-party 
data integration for CSM .

• You want to retrieve and view personnel data from Human Capital Management (HCM) 
applications such as Workday or SAP SuccessFactors for use in HR Service Delivery  functions.

Post-filtering and sorting

When you run a remote table script, it applies post-filtering and sorting query conditions after it 
adds rows to a table. These applied conditions support any other required queries that the script 
does not handle. When you apply post-filtering and sorting, the remote table queries work like 
standard internal table queries.

When you create remote table scripts, you generally handle the most frequent and expansive 
queries in the script. Post-filtering queries and sorting can take a long time and may adversely 
affect how your instance performs. Use a small data set instead so that it doesn't take much time 
to do post-filtering and sorting.

Based on your use cases, determine if you should try a narrower query in the external call or 
a more expansive query. Because the internal filtering and sorting can be expensive to run on 
large result sets, use a narrower query when the data doesn't require extra filtering. Use a more 
expansive query when a more general query would return a small result set and would require 
extra filtering and sorting.

Differences between remote tables and the Integration Hub

Choose whether to use a remote table or Integration Hub  to process external data.

• When you want to temporarily cache external data, use remote tables.

• If you want more advanced importing and transformation options, including Flow Designer, or if 
you want to develop custom integrations, use the Integration Hub.

Note: 
If you create a remote table that uses the data from an external source that is outside of 
the ServiceNow AI Platform, you must have an Integration Hub  subscription entitlement. To 
learn more about the Integration Hub, see Integration Hub .

Activate the remote tables plugin

If you have the admin role, you can activate the Remote Tables plugin (com.glide.script.vtable). 
This plugin includes demo data and activates related plugins if they are not already active.

Before you begin
Role required: admin

About this task
Remote Tables activates these related plugins if they are not already active.
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Plugins for Remote Tables

Plugin Description

Remote Tables

[com.glide.script.vtable]

Supports remote tables and associated script definitions that can be 
used to retrieve and optionally cache data from external sources.

Transformation Service

[com.glide.transform]

Supports use of Transform APIs that are associated with the remote 
tables.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.

Note: 
When domain separation and delegated admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .

Related topics

List of plugins (Washington DC)

Create a remote table

Create a remote table so that you can see the data that you retrieved from an external source.

Before you begin
Role required: admin

About this task
When you designate a table as a remote table, keep the following points in mind:

• You can create a remote table using this form, or by using the standard Create Tables form that 
you access from System Definition  > Tables.

Note: 
To learn more about creating tables in an instance, see Create a table .

• Before you create a remote table, you must have a good understanding of external data 
sources.

For example, if you want to retrieve CRM data for use in Customer Service Management, you 
must understand how the data is structured in the external CRM source.

• Unlike standard internal tables, you can't extend a remote table from another table.
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• A remote table needs an external primary key to relate its temporary data to the data that is 
stored in the external source. When you designate a table as remote, only a sys_id field is auto-
generated and appears in the Columns section, which it uses as its primary key for use in Glide 
records. All external table primary key values are converted to string values. CRUD (Create, 
Read, Update, Delete) fields are not generated for a remote table, as they are for standard 
internal tables.

Procedure

1. Navigate to System Definition  > Remote Tables  > Tables.

2. Click New.

3. On the form, fill in the fields.

Note: 
You create a remote table in the same manner as a normal table, but designate it as a 
remote table. The following controls differ in how they operate and what you enter into 
them when you create a remote table:

Control Description

Name
Table name, which is automatically populated based on the table label and a prefix 
as follows:

◦ For a remote table in a scoped application, the name is prefixed with a 
namespace identifier and the string st_  to indicate that it is remote and part of 
an application.

◦ For a remote table in the global application, the name is prefixed with the string 
u_st_.

You can't modify the prefix; however, you can modify the rest of the table name. 
The name can contain only lowercase, alphanumeric ASCII characters and 
underscores (_).

Extends 
Table

Option that is not available if you select the Remote Table  option to designate that 
this table is remote. It no longer appears because you can't extend remote tables 
from other tables.

Remote 
Table

Option to designate this table as a remote table. A remote table is a table to which 
you can associate a script definition for retrieval of data from an external data 
source. Unlike a standard internal table, the data does not come from records in the 
current instance.

To learn more about remote tables, see Remote tables.

4. In the Columns section, use the Table Columns  embedded list to add columns to the remote 
table like you do when you create columns for a standard internal table.

5. In the Controls section, define additional remote table options like you do when you define 
additional table options for a normal table.

6. In the Application Access section, define the scope protection for the remote table like you do 
when you define additional table options for a normal table.
For more information, see Application access settings .

7. Click Submit.
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Result
A remote table is created in the instance.

Create a script definition for a remote table

Define and associate a script with a remote table so that you can retrieve data from an external 
source with it. The ServiceNow AI Platform  retrieves and caches the data for the remote table 
by running the script against an external data source so you can view or modify it. You can also 
designate how this external data is cached and how long the data is cached in memory until the 
script must run again.

Before you begin
Role required: admin

About this task
You create script definitions for remote tables like you do for other scripts. To learn more about 
entering, modifying, and debugging scripts, see JavaScript syntax editor .

Procedure

1. Navigate to All  > System Definition  > Remote Tables  > Definition.

2. Click New.

3. On the form, fill in the fields.

Control Description

Name
Name of the script that you are creating to associate with the selected remote 
table.

Table
Name of the remote table that you want to associate the script that you are 
creating.

◦ For a remote table in a scoped application, the name is prefixed with a 
namespace identifier and the string st_  to indicate that it is remote and part 
of an application.

◦ For a remote table in the global application, the name is prefixed with the 
string u_st_.

Application Application that is associated with this remote table. If you are working on an 
application or are creating a remote table from an application record, the field 
defaults to that application. Otherwise, the field defaults to Global. Any records 
that are created from the table record, such as modules and security rules, are 
assigned to this application by default.

Active Option for activating the script that you are associating with the remote table. 
You can have multiple inactive script definitions for a remote table, but can only 
have one active script definition.

Advanced Option to access the Caching section to designate how the memory caching 
should operate in the ServiceNow AI Platform  for this remote table.

Note: 
Only advanced users should set caching parameters for a remote table.
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4. In the Script section, add your JavaScript syntax to the skeleton template:

Note: 
The Script section shows up only when the Flow field is empty.

Note: 
To learn more about entering, modifying, and debugging scripts, see JavaScript syntax 
editor .

5. In the Caching section, designate how this data is cached and how long the data is cached in 
the memory of the ServiceNow AI Platform:

Field Description

Cache 
TTL

Cache time to live, expressed in seconds, that external data is cached in memory 
for this remote table script definition. For example, enter 300  to cache the data in 
the memory for 5 minutes.

The maximum value you can enter is 60 minutes (3600 seconds).

Enhanced 
Capacity

Option to select the enhanced capacity to support more than 1000 rows in a 
remote table.

Note: 
If the data size that is retrieved from the external source is small, use the 
1000 rows default limit in a remote table to minimize query times. You can 
select the Enhanced Capacity  field if the retrieved data size is large and 
can be less performative.

Note: 
By default, the external data is cached in the memory by user.

6. Click Submit.

Result
When you activate a script definition, you associate it with the remote table so that you can 
retrieve and cache the external data.
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Related topics

v_query – Scoped, Global

v_table – Scoped, Global

Example 1: Retrieving all incident records from an external source

These are examples of script definitions you might create for retrieval and caching of data from 
sources external to your current instance. In this first example, we create a script to load all 
incident records from an external source.

For Remote Table API information, refer to:

• v_table()

• v_query()

/**
 * Using `v_query`, add the rows to `v_table`
 */
(function executeQuery(v_table, v_query) {
 fetchAllIncidents(v_table, v_query);
 /**
  * fetch all incidents records from the remote instance
  */
 function fetchAllIncidents(v_table, v_query) {
  // Uses RestMessage with name 'Remote Instance Incidents' and 
 function 'All Incidents'
  // Create a RestMessage first which calls an external REST 
 service
  try {
   var restMessage = new sn_ws.RESTMessageV2('Remote Instance 
 Incidents', 'All Incidents');
   var response = restMessage.execute();
   var responseBody = response.getBody();
 
   // if REST call ends up in an error, set the last error 
 message which shows up
   // at the bottom of the list view
   if (response.haveError()) {
    v_query.setLastErrorMessage(response.getErrorMessage());
    // can use gs.error() or gs.addErrorMessage() while 
 debugging
    // gs.debug() messages visible in session debugger
    // gs.debug(response.getErrorMessage());
    return;
   }
  } catch (ex) {
   v_query.setLastErrorMessage(ex.message);
   // gs.debug(ex.message);
   return;
  }
  var transformerDefinition = getTransformerDefinition();
  var transformer = new 
 sn_tfrm.Transformer(transformerDefinition, responseBody);
  // transformer parses the responseBody and extracts rows
  while (transformer.transform()) {
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   // row is field-value map e.g. { active:"true", number: 
 "INC0000001"}
   var row = transformer.getRow();
   // you may do any additional transformations to the row like 
 GlideDuration, GlideDataTime etc. For example,
   // row.duration = new GlideDuration(row.duration);
   // finally add the row to the remote table
   v_table.addRow(row);
  }
 }
 /**
  * returns a sn_tfrm.TransformerDefinition, which defines the 
 mapping of the table fields and elements in the response body
  */
 function getTransformerDefinition() {
  // create a rule list to map a field to its element path
  var ruleList = new sn_tfrm.TransformerRuleList()
   .fromJSON() // the response body is a JSON
   // 'active' field maps to path '$.active'
   .addRule("active", "$.active")
   .addRule("caller_id", "$.caller_id.value")
   .addRule("number", "$.number")
   .addRule("short_description", "$.short_description")
   .addRule("sys_id", "$.sys_id")
   .addRule("updates", "$.sys_mod_count");
  var recordPath = "$.result";
  return new sn_tfrm.TransformerDefinition(ruleList, 
 recordPath);
 }
 
})(v_table, v_query);

These code snippets are of note in this script:

function fetchAllIncidents(v_table, v_query) {
  // Uses RestMessage with name 'Remote Instance Incidents' and 
 function 'All Incidents'
  // Create a RestMessage first which calls an external REST 
 service
  try {
   var restMessage = new sn_ws.RESTMessageV2('Remote Instance 
 Incidents', 'All Incidents');
   var response = restMessage.execute();
   var responseBody = response.getBody();
 
   // if REST call ends up in an error, set the last error 
 message which shows up
   // at the bottom of the list view
   if (response.haveError()) {
    v_query.setLastErrorMessage(response.getErrorMessage());
    // can use gs.error() or gs.addErrorMessage() while 
 debugging
    // gs.debug() messages visible in session debugger
    // gs.debug(response.getErrorMessage());
    return;
   }
  } catch (ex) {
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   v_query.setLastErrorMessage(ex.message);
   // gs.debug(ex.message);
   return;
  }

You can create a RestMessage and directly use it in the script. In this example, it uses a 
RESTMessageV2 API with the name of Remote Instance Incidents, and the function 
All Incidents, which gets all incident data. Once a response is returned from the server, an 
error message appears if problems are encountered in the data retrieval.

Note: 
To learn more about use of RESTMessageV2 and how to define a direct message, see 
RESTMessageV2 - Scoped, Global  and Direct RESTMessageV2 example .

If no problems are encountered in the data retrieval, it gets the data body for the records.

  var transformerDefinition = getTransformerDefinition();
  var transformer = new 
 sn_tfrm.Transformer(transformerDefinition, responseBody);
  // transformer parses the responseBody and extracts rows
  while (transformer.transform()) {
   // row is field-value map e.g. { active:"true", number: 
 "INC0000001"}
   var row = transformer.getRow();
   // you may do any additional transformations to the row like 
 GlideDuration, GlideDataTime etc. For example,
   // row.duration = new GlideDuration(row.duration);
   // finally add the row to the remote table
   v_table.addRow(row);

It then uses the Transformer API to perform any required data transformations, extracts rows, and 
then adds a row for each record to the remote table.

/**
  * returns a sn_tfrm.TransformerDefinition, which defines the 
 mapping of the table fields and elements in the response body
  */
 function getTransformerDefinition() {
  // create a rule list to map a field to its element path
  var ruleList = new sn_tfrm.TransformerRuleList()
   .fromJSON() // the response body is a JSON
   // 'active' field maps to path '$.active'
   .addRule("active", "$.active")
   .addRule("caller_id", "$.caller_id.value")
   .addRule("number", "$.number")
   .addRule("short_description", "$.short_description")
   .addRule("sys_id", "$.sys_id")
   .addRule("updates", "$.sys_mod_count");
  var recordPath = "$.result";
  return new sn_tfrm.TransformerDefinition(ruleList, 
 recordPath);
 }
 
})(v_table, v_query);

getTransformerDefinition  defines the schema of the record in the external API 
response body. It maps each of the fields in the table script to an element in the external record. 
Any external data elements outside of this mapping are not supported or retrieved.
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Note: 
You must map a sys_id in the transformer definition to an element in the external data. In 
this case, the sys_id is mapped to the external incident sys_id. The maximum length of the 
sys_id is 32 characters. You do this sys_id mapping so forms that use the external data can 
operate properly.

Related topics

Debugging remote table script definitions

TransformerDefinition API - Scoped, Global

TransformerRuleList API - Scoped, Global

TransformerScripted API - Scoped, Global

Example 2: Retrieving specific records from a third-party source

In this example, we create a script to retrieve specific types of incident records from a third-party 
source.

For Remote Table API information, refer to:

• v_table()

• v_query()

/**
 * Using `v_query`, add the rows to `v_table`
 */
(function executeQuery(v_table, v_query) {
 if (v_query.isGet()) {
  bySysId(v_table, v_query, v_query.getSysId());
 }
 else if (v_query.getParameter("caller_id")) {
  byCallerId(v_table, v_query, 
 v_query.getParameter("caller_id"));
 }
 else {
  fetchAllIncidents(v_table, v_query);
 }
 /**
  * fetch all incidents records from the remote instance
  */
 function fetchAllIncidents(v_table, v_query) {
  // Uses RestMessage with name 'Remote Instance Incidents' and 
 function 'All Incidents'
  // Create a RestMessage first which calls an external REST 
 service
  var restMessage = new sn_ws.RESTMessageV2('Remote Instance 
 Incidents', 'All Incidents');
  loadData(v_table, v_query, restMessage);
 }
 /**
  * fetches a specific record from the remote instance with Sys 
 Id being `sys_id`
  */
 function bySysId(v_table, v_query, sys_id) {
  // Uses RestMessage with name 'Remote Instance Incidents' and 
 function 'By SysId'
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  var restMessage = new sn_ws.RESTMessageV2('Remote Instance 
 Incidents', 'By SysId');
  // sets variable 'sys_id'
  restMessage.setStringParameterNoEscape("sys_id", sys_id);
  loadData(v_table, v_query, restMessage);
 }
 /**
  * fetches records from the remote instance with Caller 
 (caller_id) being `caller_id`
  */
 function byCallerId(v_table, v_query, caller_id) {
  var restMessage = new sn_ws.RESTMessageV2('Remote Instance 
 Incidents', 'By CallerId');
  restMessage.setStringParameterNoEscape("caller_id", 
 caller_id);
  loadData(v_table, v_query, restMessage);
 }
 /**
  * Adds rows to `v_table` using `restMessage`
  */
 function loadData(v_table, v_query, restMessage) {
  try {
   var response = restMessage.execute();
   var responseBody = response.getBody();
 
   // if REST call ends up in an error, set the last error 
 message which shows up
   // at the bottom of the list view
   if (response.haveError()) {
    v_query.setLastErrorMessage(response.getErrorMessage());
    // can use gs.error() or gs.addErrorMessage() while 
 debugging
    // gs.debug() messages visible in session debugger
    // gs.debug(response.getErrorMessage());
    return;
   }
  } catch (ex) {
   v_query.setLastErrorMessage(ex.message);
   // gs.debug(ex.message);
   return;
  }
  var transformerDefinition = getTransformerDefinition();
  var transformer = new 
 sn_tfrm.Transformer(transformerDefinition, responseBody);
  // transformer parses the responseBody and extracts rows
  while (transformer.transform()) {
   // row is field-value map e.g. { active:"true", number: 
 "INC0000001"}
   var row = transformer.getRow();
   // you may do any additional transformations to the row like 
 GlideDuration, GlideDataTime etc. For example,
   // row.duration = new GlideDuration(row.duration);
   // finally add the row to the remote table
   v_table.addRow(row);
  }
 }
 /**
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  * returns a sn_tfrm.TransformerDefinition, which defines the 
 mapping of the table fields and elements in the response body
  */
 function getTransformerDefinition() {
  // create a rule list to map a field to its element path
  var ruleList = new sn_tfrm.TransformerRuleList()
   .fromJSON() // the response body is a JSON
   // 'active' field maps to path '$.active'
   .addRule("active", "$.active")
   .addRule("caller_id", "$.caller_id.value")
   .addRule("number", "$.number")
   .addRule("short_description", "$.short_description")
   .addRule("sys_id", "$.sys_id")
   .addRule("updates", "$.sys_mod_count");
  var recordPath = "$.result";
  return new sn_tfrm.TransformerDefinition(ruleList, 
 recordPath);
 }
})(v_table, v_query);

These code snippets are of note in this script:

function fetchAllIncidents(v_table, v_query) {
  // Uses RestMessage with name 'Remote Instance Incidents' and 
 function 'All Incidents'
  // Create a RestMessage first which calls an external REST 
 service
  var restMessage = new sn_ws.RESTMessageV2('Remote Instance 
 Incidents', 'All Incidents');
  loadData(v_table, v_query, restMessage);
 }

You can create a RestMessage and directly use it in the script. In this example, it uses a 
RESTMessageV2 API with the name of Remote Instance Incidents, and the function 
All Incidents, which gets all incident data. Once a response is returned from the server, an 
error message appears if problems are encountered in the data retrieval.

 function bySysId(v_table, v_query, sys_id) {
  // Uses RestMessage with name 'Remote Instance Incidents' and 
 function 'By SysId'
  var restMessage = new sn_ws.RESTMessageV2('Remote Instance 
 Incidents', 'By SysId');
  // sets variable 'sys_id'
  restMessage.setStringParameterNoEscape("sys_id", sys_id);
  loadData(v_table, v_query, restMessage);
 }

When you query a specific record using GlideRecord.get(“<sys_id>“), then 
v_query.isGet()`  is `true`. It fetches the specific record from the external service.

function byCallerId(v_table, v_query, caller_id) {
  var restMessage = new sn_ws.RESTMessageV2('Remote Instance 
 Incidents', 'By CallerId');
  restMessage.setStringParameterNoEscape("caller_id", 
 caller_id);
  loadData(v_table, v_query, restMessage);
 }
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You can also handle any other specific query conditions in the script, such as using caller_id 
in the preceding code snippet. The remainder of this script operates in a manner similar to 
Example 1.

 function getTransformerDefinition() {
  // create a rule list to map a field to its element path
  var ruleList = new sn_tfrm.TransformerRuleList()
   .fromJSON() // the response body is a JSON
   // 'active' field maps to path '$.active'
   .addRule("active", "$.active")
   .addRule("caller_id", "$.caller_id.value")
   .addRule("number", "$.number")
   .addRule("short_description", "$.short_description")
   .addRule("sys_id", "$.sys_id")
   .addRule("updates", "$.sys_mod_count");
  var recordPath = "$.result";
  return new sn_tfrm.TransformerDefinition(ruleList, 
 recordPath);
 }
})(v_table, v_query);

If no problems are encountered in the data retrieval, it gets the data body for the records. It then 
uses the Transformer API to perform any required data transformations, extracts rows, and then 
adds a row for each record to the remote table.

getTransformerDefinition  defines the schema of the record in the external API 
response body. It maps each of the fields in the table script to an element in the external record. 
Any external data elements outside of this mapping are not available in the remote table.

Create a flow definition for a remote table

Build and create a flow for a remote table so that you can retrieve data from an external source 
with it.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Definition  > Remote Tables  > Definition.
A list of all remote tables definitions shows up.

2. Click New  to create a new flow definition.

3. On the form, fill in the fields.

Control Description

Name
Name of the script that you are creating to associate with the selected remote 
table.

Table
Name of the remote table that you want to associate the script that you are 
creating.
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Control Description

◦ For a remote table in a scoped application, the name is prefixed with a 
namespace identifier and the string st_  to indicate that it is remote and part 
of an application.

◦ For a remote table in the global application, the name is prefixed with the 
string u_st_.

Flow Option to build and define your own flow by leveraging the existing functions. 
Configure the mapping of the flow and tie it to thee required remote table. When 
the remote table is queried, the flow is triggered and the data is retrieved. See 
Defining the flow for more information.

Note: 
The Script section doesn't show up when the Flow  field has an entry.

Application Application that is associated with this remote table. If you are working on an 
application or are creating a remote table from an application record, the field 
defaults to that application. Otherwise, the field defaults to Global. Any records 
that are created from the table record, such as modules and security rules, are 
assigned to this application by default.

Active Option for activating the script that you are associating with the remote table. 
You can have multiple inactive script definitions for a remote table, but can only 
have one active script definition.

Advanced Option to access the Caching section to designate how the memory caching 
should operate in the ServiceNow AI Platform  for this remote table.

Note: 
Only advanced users should set caching parameters for a remote table.

4. In the Caching section, designate how this data is cached and how long the data is cached in 
the memory of the ServiceNow AI Platform:

Field Description

Cache 
TTL

Cache time to live, expressed in seconds, that external data is cached in memory 
for this remote table script definition. For example, enter 300  to cache the data in 
the memory for 5 minutes.

The maximum value you can enter is 60 minutes (3600 seconds).

Enhanced 
Capacity

Option to select the enhanced capacity to support more than 1000 rows in a 
remote table.

Note: 
If the data size that is retrieved from the external source is small, use the 
1000 rows default limit in a remote table to minimize query times. You can 
select the Enhanced Capacity  field if the retrieved data size is large and 
can be less performative.
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Note: 
By default, the external data is cached in the memory by user.

5. Click Submit.

Define a flow logic

Set the triggers and actions to define a remote table flow logic.

Before you begin
Role required: admin

Procedure

1. Select the Flow  field on the flow definitions form.
The Flow properties dialog box shows up.

2. Set the Trigger  and link the required remote table.
For the set trigger, the flow pills get created in the right nav.

3. Set the action items in the Create Remote Table Record section.

a. Set the Action as Create Remote Table Record.

b. Drag and drop the Query ID pill from the right nav.

Note: 
The Query ID is the id of the query that triggered the execution of the flow. It is a 
mandatory step to pass the Query ID to the Create Remote Table Record action to 
associate the Trigger to the Action.

c. Select Done  to save the action.

4. Optional:  Add conditions to the flow logic if you want to create a different flow path.

a. Fill up the Condition Label field.

b. Set the condition by dragging and dropping the Query Parameter pill from the right nav.

c. Select the add function icon next to the Query Parameter pill to add specifics.
The Search Transform Functions dialog box shows up.

d. Go to Utilities  and select the next function depending on the Query Parameter type.
For example, if the condition is set to search for a name, you can go to Utilities  > Get Item 
from Name/Values. Fill up the Key  details and select Apply. The Key  field needs to specify 
the parameter you are looking for.

Note: 
Ensure that the Key  is the same as the Column name and not the Label name.

5. Optional:  Add a log to the flow logic.

a. Select Log as the Action  and select a Level.

b. Set the Message field by dragging and dropping the Query Parameter pill from the right nav.

c. Select Done  to create logs for the set condition.
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Debugging remote table script definitions

You can enable session debugging for remote table script definitions. To enable script definition 
logging in a session debug log, set the glide.script.vtable.log.debug  property to 
true.

When you create remote table script definitions, you can use the gs.debug()  command to 
add debug logs that are visible in the session debugger. The session debugger also contains 
debug logs with [RemoteTable] tags, each with the following information:

• Query definition

• Number of rows loaded in the remote table

• Number of aggregate rows (if GlideAggregate)

Prolonged use of the glide.script.vtable.log.debug  property can affect 
performance, so it is best to set its value to false  when you finish a debugging session.

Note: 
If you are not on the application node that processed your remote table script, you may not 
see the resulting log statements. In this case, contact Technical Support.

Use the v_query.setLastErrorMessage(message)  API to set the last error message 
that appears at the bottom of the list view. In script, you can retrieve this message using the 
glideRecord.getLastErrorMessage()  API. To learn more about these APIs, see Text-
To-Display .

Related topics

Available system properties

Script Debugger and Session Logging

Domain separation and remote tables

Domain separation is unsupported in remote tables. Domain separation enables you to separate 
data, processes, and administrative tasks into logical groupings called domains. You can control 
several aspects of this separation, including which users can see and access data.

Support level: No support

• The domain field may exist on data tables but there is no business logic to manage the data.

• This level is not considered domain-separated.

For more information on support levels, see Application support for domain separation .

Overview

Domain separation provides complete data isolation for domain-specific users.

How domain separation works with remote tables

When you create standard internal tables, you can add a sys_domain field, which results in 
domain separation of the data that is stored in the table. This functionality is not supported when 
you natively create remote tables, which results in lack of domain separation for rows that are 
added to a remote table.

However, script definitions that you create and associate with a remote table can be domain 
(data) separated. When you create the script, you can include DomainSupport APIs that provide 
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domain separation support. If the script definition is domain separated, only users that belong to 
the designated domain can view the data in the remote table.

Related topics

Create a script definition for a remote table

Domain separation

Manage content capabilities
Handle all the necessary aspects of document and knowledge base management for your 
enterprise with several ServiceNow  products.

Document Services

Create, maintain, and 
update your documents 

with this suite of products 
available for your instance.

Knowledge Management

Create and share 
knowledge articles, and 

provide information 
for user self-help 

and troubleshooting.

Response templates

Leverage reusable text 
to display standard chat 
response messages to 

requesters in Agent Chat.

Document Services

Take care of all your documentation through ServiceNow®  Document Services. Get storage 
space and tracking for large amounts of documents with Document Management. Examine files 
up to 50 MB without downloading, by using Document Viewer. Access to electronic documents is 
easily controlled through Managed Documents, with adjustable user parameters. Integrate third-
party providers for document handling, including Microsoft OneDrive, Microsoft Azure AD, and 
more.

Knowledge Management

Keep your users up to date with knowledge bases crafted to fit with your ServiceNow  instance. 
The Knowledge Management  plugin enables sharing of articles for task resolution, self-help, 
troubleshooting, and any other information pertinent to your enterprise. Create and maintain 
articles, control access for reading, contribution, and feedback, and delegate administrative 
roles as needed for multiple groups and separate workflows.

Response templates

Resolve cases or support issues faster and more efficiently with response templates, which are 
reusable snippets of text. Use response templates in Agent Chat  sessions to provide quick and 
consistent messages to your users.
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Document Services
Document Services  provides a broad range of services related to document management, 
creation, maintenance, and conversion, and integrating with third parties such as Microsoft 
SharePoint.

Document Management

Manage large numbers 
of documents efficiently

Document Viewer

View documents directly in 

the ServiceNow AI Platform®

Managed Documents

Control documents within your instance

Multi Provider Document 
Services Framework

Integrate providers with 
your ServiceNow instance

Document Management

Manage large numbers of documents efficiently. Document Management  provides 
storage space and a tracking system to easily upload, retrieve, and delete 
documents.

Document Viewer

View documents directly in the ServiceNow AI Platform®  rather than having to 
download them. Document Viewer  supports viewing various file types in the 
platform. The maximum document file size is 50 MB. Enable  Document Viewer  and 
the tables you want to use with it at the instance level.

Managed Documents

Control electronic documents within your instance. Documents can move 
through the managed document cycle after the parameters have been set by the 
administrator and the Knowledge Document plugin installed.

Multi Provider Document Services Framework

Integrate providers with your ServiceNow  instance to store files, upload, add 
versions, and download information with document providers.

• Upgrade to Washington DC

• Developer training

• Domain separation and Document Management
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Document generation apps

• PDFGenerationAPI API

• Document API

• DocumentListService API

• DocumentService API

Troubleshoot and get help

• Ask or answer questions in the Platform  community

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support

Document Management

The Document Management  applications allows management of large numbers of documents 
efficiently. With the Document Management application, you can create, share, upload, track, 
and manage documents throughout the life-cycle of the workflow.

Get started

Explore

Explore Document 
Management

Activate

Activate Document 
Management

Access

Access Document 
Management

Use

Use Document 
Management

Reference

Reference Document 
Management

Troubleshoot and get help

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support
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Exploring Document Management

With the ServiceNow®  Document Management  application, you can manage large numbers of 
documents efficiently. Easily upload, retrieve, share and delete documents.

Document Management  overview

With the Document Management  application, you can create, upload, track and manage 
documents throughout the lifecycle of the workflow.

Use the document repository to easily upload, retrieve, share, delete and sign documents. 
Documents can also be linked to other records in the system.

Document Management  benefits

Benefit Feature

Classify documents for organization. Share documents to 
collaborate with internal and external users.

Document repository

Secure your documents by limiting who can access them. 
Share documents with selected users and user groups who 
have Reader, Writer, and Owner permissions.

Document security and 
access

Maintain versions of documents. Versions can be a file or a 
URL.

Document versions

Link a document record to other records, which can be any 
other table or record on the platform.

Document references

Link documents to other records on the platform. Linking documents to a parent 
record

Create document lists and add multiple documents to a single 
list.

Document Management lists

Include documents in activity streams to include and track 
updates on attached documents to any record.

Document attachments in an 
activity stream

Send documents for review and approval before publishing. Document approval and 
publish process

Digitally sign PDF documents by using your Personal Identity 
Verification (PIV) or Common Access Card (CAC) card.

Digital signature for PDF 
documents using CAC or PIV 
smart cards

Document Management  plugin

With the ServiceNow®  Document Management  plugin 
(com.snc.platform_document_management), you can create documents, manage large 
numbers of documents efficiently, and track each version. The plugin is independent, with 
no dependencies on existing plugins and has been built on the existing sys_attachment 
framework.

Overview

There are Document Management  roles the system admin can assign to maintain the lifecycle of 
documents. The system admin installs the plugin and then assigns one or more of these roles to 
users.
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The system admin installs the Document Management  plugin 
(com.snc.platform_document_management).

The application contains four modules:

• Documents

• References

• Lists

• List Entries

Activate  Document Management

Activate the Document Management  plugin.

Before you begin
Role required: admin

About this task
The following items are installed with Document Management:

• Roles

• Tables

For more information, seeComponents installed with Document Management.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the Document Management  plugin (com.snc.platform_document_management) using the 
filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.

Note: 
When domain separation and delegated admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .

Document security and access

Document access permissions for users and groups provide you with security for your 
documents.

Owner access to documents

By default, the document owner has all privileges to the document and can do the following:

• Update the document parameters

• Upload document versions

• Create document references
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• Share a document with other users

• Delete a document

Note: 

If the document owner changes, the new owner obtains all rights to the document and the 
previous owner loses access. If the previous owner wants to keep access to the document, 
the document should be shared instead of transferring owner access.

Document access settings

You can access documents through three different settings.

Document access settings

Access Description

By referenced records When a document is referenced to a parent 
record, any user with access to the parent 
record has access to the document.

Admin access All document users with admin access can 
access the document.

Shared permissions Enables sharing a document with other 
users as Reader, Writer, or Owner at different 
permission levels such as:

• User Permissions

• Group Permissions

• Role Permissions

• User Criteria Permissions

Sharing permissions and roles

Users can give permissions to other users based on their own access to the document. The 
permission levels are:

• Owner

• Writer

• Reader

To share documents with other users and groups you must have write access to the document 
record and roles to share at different levels.

Sharing permissions and roles

Sharing permissions User permissions required Role required

User Permissions All users even if they don’t 
have a role assigned

No role required. All users can 
share documents with other 
user
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Sharing permissions and roles  (continued)

Sharing permissions User permissions required Role required

Group Permissions Writers and Owners can 
assign access based on their 
access permissions

dm_user_group_read

Role Permissions Writers and Owners can 
assign access based on their 
access permissions

dm_user_role_read

User Criteria Permissions Writers and Owners can 
assign access based on their 
access permissions

dm_user_criteria_read

Share documents with users

Assign Reader, Writer or Owner permissions to users to enable them to read, download, update, 
or delete documents.

Before you begin
Role required: none

About this task
User permission is assigned to all users, even if they don’t have a role assigned.

Procedure

1. Navigate to Documents  > Documents.

2. Open the document record.

3. Select the Sharing Permissions  check box.

4. Select the User Permissions  tab.

5. Select New  and select the permission level from the drop-down list.

6. Select the record for the user you want to assign permission to.

7. Click Submit.

Share documents with groups

As a Writer or Owner, assign access to user groups based on your access permissions.

Before you begin
Role required: dm_user_group_read

Procedure

1. Navigate to Documents  > Documents.

2. Open the document record.

3. Select the Sharing Permissions  check box.

4. Select the Group Permissions  tab.

5. Select New  and select the permission level from the drop-down list.

6. Select the user group you want to assign permission to.

7. Click Submit.
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Share documents with roles

As a Writer or Owner, assign access and permissions based on user roles.

Before you begin
Role required: dm_user_role_read

Procedure

1. Navigate to Documents  > Documents.

2. Open the required document record.

3. Select the Sharing Permissions  check box.

4. Select the Role Permissions  tab.

5. Select New  and select the permission level from the drop-down list.

6. Select the user role you want to assign permission to.

7. Click Submit.

Share documents with user criteria

As a Writer or Owner assign access to a document based on the user criteria permissions.

Before you begin
Role required: dm_user_criteria_read

Procedure

1. Navigate to Documents  > Documents.

2. Open the document record.

3. Select the Sharing Permissions  check box.

4. Select the User Criteria Permissions  tab.

5. Select New  and select the permission level from the drop-down list.

6. Select the user criteria you want to assign permission to.

7. Click Submit.

Using Document Management

Use Document Management  to easily upload, retrive, share, publish, and delete documents.

Document repository

In the Document Management  application, you can create, view, update, share documents in 
the document repository. When new documents are created, they’re placed into a record with 
metadata such as name, description, type, and so on. The record contains all the versions of the 
document so you can track and update the documents.

You can access the document by opening one of its versions. A document can contain numerous 
versions. The document record contains references to the documents and not contain actual 
document files.

When you want to add a document to a record, upload it as an attachment. Each time you 
update the document, you can create a new version. Alternatively, you can provide the link to a 
document in the URL field. You can include the review and approval workflow before publishing a 
document.
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You can generate and share the document link with authorized users for collaboration or to 
include the link on any page. The default version of the shared document will have public access 
and can be accessed by anyone within or outside the organization.

Create a document record

Create document records and include default versions for the documents.

Before you begin
Role required: none

Procedure

1. Navigate to All  > Documents  > Documents.

2. Select New.

3. On the form, fill in the fields.

New document record fields

Field Description

Name Name of the document.

Owner Name of the document owner.

Reviewers Name of the reviewers if any.

Template Option to determine whether the document is 
a template.

Department Name of the department that created the 
document.

Type The type of document based on the content: 
guideline, policy, procedure, or contract.

Classification Classification of the document: public, 
restricted, or confidential.

Audience Audience of the document, either internal or 
external.

Note: 
The Audience  field is hidden in the 
default view.

State The state the document is in: Draft, Submit, 
Review, or Complete.

Description A brief description about the document.

Default Version
The document version that is used for 
document download.

By default, the latest version is the default 
version.

4. Select the access setting.

5. Select Submit.
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Document versions

In the ServiceNow®  Document Management  application, documents display as versions in the 
record. You view these versions as a related list within the document record. A document can 
have many versions.

The term "document" refers to the container record that holds document information such as 
its name, description, type and other metadata. While the document record doesn’t contain the 
actual document file, it does contain versions in the record, which you can open, update, and 
track.

Use the Attachment icon ( ) to add documents to a record.

Alternatively, you can provide the link to a document in the URL field. You then access the actual 
documents by selecting the versions in the related list.

Document version review and approval

All approver and reviewer users have read access to the documents that they’re approving.

A document can have a reviewer or multiple reviewers and no approvers and vice versa. Users 
with admin and platform_document_management_admin roles have the option to create 
approval and review rules.

Document owners have the option to:

• Initiate approval and review workflow for a document version.

• Publish the approved version.

• See the activity stream of the approval and review workflow.

• Track the document Version State.

For multiple document versions, the latest reviewed and approved version gets published and 
the previous versions are retired.

Create a document version

Create a document version for each document.

Before you begin
Role required: none

Procedure

1. Navigate to All  > Documents  > Documents  and click the document record.

2. Scroll down to Versions  tab.

3. Select New.

4. Select the file type you want to upload and add any information related to the file under Notes.

◦ To upload a file, select Attachment, select the file icon, and select the file.

◦ To link to a document, select URL  and provide the link.

5. Select Submit.

6. To submit the version for review and approval, go back and select the version and select 
Submit Version.

Download a document

Download an attached document version based on the selected default version.
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Before you begin
Role required: none

About this task
Note: 
To download a document, the version file type must be an attachment and not a URL.

Procedure

1. Navigate to All  > Documents  > Documents.

2. Select the record.

3. Select the Documents  tab.

4. Select the documents you want to download.

5. In the Actions on selected rows  drop-down menu, select Download Document.

Share a document link

Create a shared link with public access to share and download a document for collaboration.

Before you begin
Role required: owner or writer

About this task
The Share document  button is visible only when the document has a valid default version.

Procedure

1. Navigate to All  > Documents  > Documents.

2. Select the record that you want to share the document link for.

3. In the record, select Share Document.

4. For Link Validity, select Permanent  to keep the link permanently, or select Expire Link On, and 
select the link expiry date.

5. Select the copy link icon ( ) to copy and share the document link to download the document.

6. Select Done.

Modify a shared link access

Modify the document shared link access to make the link inactive or change the expiration date.

Before you begin
Ensure that the Permalinks table is added in the related list.

Role required: owner or writer

Procedure

1. Navigate to All  > Documents  > Documents.

2. Scroll down to the Documents Permalinks  tab.

3. For the document:

◦ To make the link inactive, in the Active column, select false.

◦ To add or modify the expiry date, in the Expiration column, select the date.
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Delete a document link

Delete a shared link to remove existing user access to the document.

Before you begin
Role required: owner or writer

Procedure

1. Navigate to All  > Documents  > Documents.

2. Select the record that you want to share the link for.

3. In the record, select Share Document.

4. Select the delete icon ( ) to delete the shared link.

5. In the dialog box, select Delete  to confirm.

Delete documents

Delete documents in the document repository.

Before you begin
Role required: admin with admin access

or

Access permission: owner

or

User: owner

Procedure

1. Navigate to All  > Documents  > Documents.

2. Either delete a single document or multiple documents.

◦ To delete a single document, open the document record and select Delete.

◦ To delete multiple documents, select the document record entries, and from the Actions on 
selected rows drop-down menu, select Delete.

Document approval and publish process

A reviewer approves or rejects the document. A document can have multiple reviewers. During 
the approval process, the approver approves or rejects the document. A document goes through 
the approval process after the review process. A document is published after the review and 
approval process.

A document can have a reviewer or multiple reviewers and no approvers and vice versa. You 
must have the platform_document_management_admin or admin role to create approval and 
review rules.

Users who can create documents have the option to do the following:

• Add approvers and reviewers to a document.

• Initiate the approval and review workflow for a document version.

• Publish the approved version.

• See the activity stream of the approval and review workflow.
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All approvers and reviewers have read access to the documents that they’re approving.

Document approval revision rule

The document approval and revision rule is created based on the conditions defined in the 
condition builder to determine which documents use the approval rule. After the approval rule is 
saved, reviewers and approvers are added if the conditions in the Condition field are met.

Note: 
Document reviewer and approver directly added from the document record aren’t added to 
the Document approval and revision rule.

Document review

If the reviewer rejects the document, the author and owner are notified and the review is 
canceled. The author, owner, and reviewer should discuss what changes must be made to the 
document. If the reviewer approves the document, the author and owner are notified that the 
review was successful, and the document can move to the approval stage. If multiple reviewers 
are assigned to a document, the first reviewer to act dictates what happens to the document. For 
example, there are two reviewers, A and B.

If reviewer A acts first and rejects the document, the review process stops and the revision 
state is set to Canceled. Reviewer B receives a notification email stating that the review was 
rejected and the status is changed to No Longer Required. If reviewer A acts first and approves 
the document, the review process stops and the document can move to the approval stage. 
Reviewer B's status is changed to No Longer Required.

Document approval

After the document has been reviewed, submit the document for approval. If the document 
doesn’t have an approver, the approval process is omitted.

If the final approver approves the document, the author and the owner are notified. After the final 
approval is successful, the document stage changes to Ready for Publishing in the Document 
versions list.

If there are multiple approvers, the approval process works in sequence, and multiple approvers 
can be assigned to a single sequence. For example:

• Sequence 1: Approvers A and B

• Sequence 2: Approvers C and D

• Sequence 3: Approver E

The sequences take place in ascending chronological order, approvers A and B receive the 
approval request first (approvers C, D, and E aren’t part of the process yet). Similar to the review 
process, the first approver to act within a sequence dictates what happens to the document. If 
approver A acts first and rejects the document, the approval process stops and the state is set 
to Canceled. Approver B's status is changed to No Longer Required. If approver A acts first and 
approves the document, the process stops and approver B's status is changed to No Longer 
Required. The document then moves to approval sequence 2. After at least one approver in each 
sequence approves the document, the author and the owner are notified that the document has 
been approved.

Publish a document

After a document has been created and edited, the revision can be submitted for draft review 
and final approval. After final approval, the document can be published.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3136



If the approval and publishing process is repeated, the published revision is retired when the 
new revision is published. Any workflows running against previous revisions are canceled when 
the document is published.

Create a document approval revision rule

Create a document approval revision rule for the document review and approval process.

Before you begin
Role required: platform_document_management_admin or admin

Procedure

1. Navigate to All  > Documents  > Approval and Revision Rules.

2. On the form, fill in the fields.

Approval revision rule form

Field Description

Name A unique identifier for the approval rule.

Description A short description of the approval rule.

Document Conditions A condition builder that determines which 
documents use this approval rule.

Active Activates the rule.

3. Select Submit.

Add a reviewer

Add a single or multiple reviewers to the document approval and review rule for document 
review.

Before you begin
Role required: platform_document_management_admin or admin

About this task
The procedure described in this task applies to newly created records. For existing records, go to 

the document record, select the additional actions icon ( ) and select Refresh Approvers and 
Reviewers  to match the rules and add reviewers.

Note: 
Document reviewers can be directly added through the document record but they aren't 
added to the Document approval and revision rule.

Procedure

1. Navigate to All  > Documents  > Approval and Revision Rules.

2. Go to the rule that you want to add a reviewer or approvers to.

3. Select the Reviewers  tab.

4. Select New.

5. In the Reviewer  field, enter the name of the reviewer.
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6. Select Submit.

7. Repeat steps 3–6 to add multiple reviewers.

Add an approver

Add a single or multiple approvers to the document approval and review rule for document 
approval.

Before you begin
Role required: platform_document_management_admin or admin

About this task
The procedure described in this task applies to newly created records. For existing records, go to 

the document record, select the additional actions icon ( ) and select Refresh Approvers and 
Reviewers  to match the rules and add approvers.

Note: 
The document reviewer and approver can be directly added through the document record 
but they aren't added to the Document approval and revision rule.

Procedure

1. Navigate to All  > Documents  > Approval and Revision Rules.

2. Go to the rule that you want to add a reviewer or approvers to.

3. Select the Approvers  tab.

4. Select New.

5. In the Approvers  field, enter the name of the reviewer.

6. In the Sequence  field, enter the sequence for the approver.

Note: 
The document is sent to approvers in ascending order based on the sequence number 
entered. If two approvers have the same sequence number, only one approver's approval 
is needed to move on to the next approver in the sequence or to publish the document if 
there’s no approver in the sequence.

7. Select Submit.

8. Repeat steps 3–7 to add multiple approvers.

Send a document version for review and approval

Send a document version for review and approval before publishing the document.

Before you begin
Role required: none

Procedure

1. Navigate to All  > Documents  > Documents.

2. Select the document record.

3. Select the version and select Submit Version.

Approve or reject a document version

Approve or reject a document version after the review process is complete.
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Before you begin
Role required: approver_user

Procedure

1. Navigate to All  > Self-Service  > My Approvals.

2. Select the requested document for approval.

3. Select Approve  to approve the document version or select Reject  to reject the document 
version.

Approve or reject a document version through email

Approve or reject a document version request directly from your email.

Before you begin
Role required: approver_user

Procedure

1. Open the approval request email.

2. Select Click here to approve  to approve the document version or select Click here to reject  to 
reject the document version.

Publish a document

Publish a document revision that has been approved.

Before you begin
Role required: none

About this task
After a document has been created and edited, a version can be submitted for draft review and 
final approval. After the final approval, the document can be published. The published version 
becomes the default version of the document.

Procedure

1. Navigate to All  > Documents  > Documents.

2. Select the document record.

3. Scroll down to the Versions  tab.

4. Select the document version that has been approved.

5. Select Publish Version.

Digital signature for PDF documents using CAC or PIV smart cards

Use digital signatures to make the document signing experience seamless and to eliminate 
manual intervention by using your Personal Identity Verification (PIV) or Common Access Card 
(CAC) smart card.

CAC or PIV cards

The Common Access Card (CAC) and Personal Identification Verification (PIV) are smart cards 
used for general identification and authentication of user access. CAC and PIV hold a unique 
digital certificate and user information such as a photograph, personal identification number 
(PIN), and signature to identify each user.
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Sign PDF documents

ServiceNow  enables you to integrate with Adobe, as well as configure and use PIV or CAC smart 
cards as an authenticator for digital signing of PDF documents. This integration provides the 
flexibility to use PIV or CAC cards to safeguard critical and valuable assets.

The Adobe Acrobat Reader  desktop application enables you to digitally sign a PDF with CAC or 
PIV smart cards.

Note: 
You should do the following to digitally sign a PDF with CAC or PIV smart cards:

• Install Adobe Acrobat Reader  on your desktop.

• Configure your Google Chrome  or Mozilla Firefox  browser to open downloaded PDFs in 
Adobe Acrobat Reader.

Document template for digital signature

Digital signing for documents is configured with a document template. You must define 
document templates and signing workflows for digital signature using smart cards to generate 
and send auto-filled documents to be signed by different participants.

To configure digital signing for CAC or PIV smart cards, the following must be done:

• Use Document Templates  to create and upload a PDF document

• Set up certificates in the sys_ca_certificate table

• Set up a map certificate in the sys_user_certificate table

• Review the com.snc.pdfsigning.validation.method  property

Note: 
This property is available from Washington DC Patch 3.

• Sign and review the PDF document

Install Document Template integration with digital signatures using a smart card

You can install the Document Template integration with Digital Signatures using Smart Cards 
application (com.sn.dt-digital-signature-smart-card-integration) if you have the admin role.

Before you begin

• Ensure that the application and all of its associated ServiceNow Store  applications have valid 
ServiceNow  entitlements. For more information, see Get entitlement for a ServiceNow  product 
or application .

Role required: admin

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the Document Template integration with Digital Signatures using Smart Cards  application 
(com.sn.dt-digital-signature-smart-card-integration) using the filter criteria and search bar.

You can search for the application by its name or ID. If you cannot find the application, you 
might have to request it from the ServiceNow Store.

In the list next to the Install  button, the versions that are available to you are displayed.
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3. Select a version from the list and select Install.

In the Install dialog box that is displayed, any dependencies that are installed along with your 
application are listed.

4. If you're prompted, follow the links to the ServiceNow Store  to get any additional entitlements 
for dependencies.

5. Select Install.

Set up a document template for signing documents using a CAC or PIV smart card

Set up a document template for PDF using a Common Access Card (CAC) or Personal 
Identification Verification (PIV) card. Set up certificates to automate and simplify the process of 
filling, reviewing, and signing a document online.

Before you begin
Adobe Acrobat Reader  must be installed on your desktop.

The Document Templates  application must be installed. For more information, see Setting up 
Document Templates .

Role required: sn_doc.admin, sn_doc.reader, or admin

Procedure

1. Create a document template.

a. Configure a PDF document template .

Note: 
The Signing type  field should be Digital Signature Smart Cards.

b. Map fields for the PDF document template

c. Select Edit Document Preview  to define the label and placement of the button to submit the 
signature.

d. Create participants for the PDF document template .

e. To map templates to participants, go to the Template Mapping  tab, select the field name, 
and add the participant name, and to map fields, select the field from the Mapping field 
drop-down menu.

Note: 
The text fields can have pre-filled values mapped, and the digital signature field types 
should be mapped to the participants.

f. Select Update.

g. Select Publish.

2. Set up Certificate-based authentication .

3. Configure your browser settings to automatically open the downloaded PDF documents in 
Adobe Acrobat Reader.
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For Google Chrome, see PDF download setting for Google Chrome .

For Mozilla Firefox  and Apple Safari, see Configure browser to use the Adobe PDF plug-in to 
open online PDF files .

4. Configure Adobe Acrobat Reader  to add your download location as your Privileged Location.

a. In Adobe Acrobat Reader, go to Preferences  > Security (Enhanced).

b. Select Add Folder Path  and add your download location as your Privileged Location.

c. Select OK.

What to do next
Sign document templates for PDF documents using CAC or PIV smart card

Property value for digital signature using CAC or PIV smart cards

Specify the method that will be used to identify and validate the user who has signed the PDF 
using the com.snc.pdfsigning.validation.method  property.

The property value com.snc.pdfsigning.validation.method  is used for identifying 
and validating the user who has signed the PDF. Identifying the user is necessary to validate 
whether the correct user has signed the PDF. The IT team of a customer can define the way to 
validate a PDF depending on their policies and issued certificates.

Property value and action

Value Action

common_name Uses the Common Name (CN) field in 
the Subject of the certificate to check if a 
certificate exists in the sys_user_certificate 
table that is associated with a user.​

email Uses the email IDs in the certificate to locate a 
user in ServiceNow with a matching email ID.

any (default value) Utilizes both of the above validation methods 
to resolve a user.

ignore No user validation is performed on the signing 
fields.

Sign document templates for PDF documents using CAC or PIV smart card

Use the PDF document template to initiate digital signing, review, and generate a filled PDF 
document using a Common Access Card (CAC) or Personal Identification Verification (PIV) card.

Before you begin
Adobe Acrobat Reader  must be installed on your desktop.

A document template must be set up for signing documents. For more information, see Set up a 
document template for signing documents using a CAC or PIV smart card.

Role required: none
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About this task

Procedure

1. Initiate the PDF document signing process with a custom implementation using script.
For more information, see Using Document Templates: Generic use case .

Note: 
HR cases can skip this step as custom implementation using scripts is for cases related 
to non-HR applications.

2. Sign the PDF document in Service Portal.

◦ To navigate through the Employee Center, navigate to All  > Self-Service  > Employee Center.

◦ To navigate through My Document Tasks, navigate toSelf-Service  > My Document Tasks.

3. Select the document task that is assigned to you.

4. Review the PDF document and select Sign Document  to sign the document or Reject  to reject 
the document.
The signed document opens as a PDF document in Adobe Acrobat Reader.

5. Go to the sign location to click and select the mapped certificate or Digital ID file.

6. Enter the password for the Digital ID file, select Sign, and save the signed copy.

7. In the PDF document, select send to send the signed PDF document.
The signed document is uploaded to the document task for verification.

8. Go to the My Document Tasks  and select the document, review and select Validate 
Document  to validate the document or select Reject  to reject the document.
The signature is successfully captured and authenticated after document validation.

Review the digitally signed document

Review the digitally signed PDF document to either approve or reject it.

Before you begin
Role required: none

Procedure

1. Navigate to your Document Tasks through either the Employee Center or through My 
Document Tasks.

◦ To navigate through the Employee Center, navigate to All  > Self-Service  > Employee Center.

◦ To navigate through My Document Tasks, navigate toSelf-Service  > My Document Tasks.

2. Select the document template task assigned to you and review the document.

3. To approve or reject the document, do one of the following.

◦ To approve the document, select Approve.

◦ To reject the document, select Reject  and provide a reason for the rejection.

Document references

References are used for linking a document record to other records, which can be any other 
table or record on the platform.

A reference is a link or mapping between a document and a target or a parent record.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3143

https://www.webstg.servicenow.com/docs/access?context=doc-temp-gen&version=washingtondc&pubname=washingtondc-employee-service-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=doc-temp-gen&version=washingtondc&pubname=washingtondc-employee-service-management&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=doc-temp-gen&version=washingtondc&pubname=washingtondc-employee-service-management&ft:locale=en-US


You can add references directly and view all document references in other records across the 
platform by navigating to Documents  > References.

You can create and link document references directly from references or from the document 
record.

Create document references from document record

Link the document record to other records in any other table or record.

Before you begin
Role required: none

Procedure

1. Navigate to Documents  > Documents.

2. Select the document.

3. In the Document References  tab, select New.
In the dialog box, the Document  field reflects the document you selected.

4. In the Target Record  field, select the Lookup documents using list icon .

5. In the Select the document dialog box, for the Table name  field, select the table for the record 
you want to link the document to.

6. In the Document  field, select the Lookup using list icon ( ) and select the record to which 
you are linking the document.

7. Select OK.

8. Select Submit.

Create document reference from References

Link document references to any record directly from the References list. You can easily see all 
documents linked to tables and target records.

Before you begin
Role required: admin

About this task

Procedure

1. Navigate to Documents  > Documents  > References.

2. Select New.

3. Select the document.

4. In the Target Record  field, select the Lookup documents using list icon .

5. In the Select the document dialog box, for the Table name  field, select the table for the record 
you want to link the document to.

6. In the Document  field, select the Lookup using list icon ( ) and select the record to which 
you are linking the document.

7. Select OK.

8. Select Submit.
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Delete a document reference from document record

Remove and unlink a document reference from a document record.

Before you begin
Role required: admin with admin access

or

Access permission: owner

or

User: owner

About this task
Note: 
This action unlinks the document but does not delete the document.

Procedure

1. Navigate to Documents  > Documents.

2. Select the document.

3. In the Document References  tab, select the documents you want to unlink.

4. In the Actions on selected rows  drop-down menu, select Remove.

Linking documents to a parent record

Documents can be linked to records referred to as "parent records." You can create a document 
version and reference it through a parent record. You can also view, edit, download, or delete 
document references in the parent record.

Note: 

The terms "other record" and "parent record" are used interchangeably and refer to any 
records to which documents are linked.

You can use references to link a document record to any other table or record on the platform.

Enable viewing related documents in a parent record

Add the Documents related list to the record to be able to link and view documents related to the 
record.

Before you begin
Role required: admin

Procedure

1. Navigate to the record, (for example, Incident, Interaction, and so on).

2. Select the Additional Actions icon ( ) and select Configure  > Related Lists .

3. Move Documents  from the Available list to the Selected list.

4. Select Save.

Result
The Documents related list is added to the related lists available in the record.
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Create a document record in a parent record

Add documents to a parent record so they are available for downloading, sharing, or viewing 
directly from the record.

Before you begin
Role required: none

Procedure

1. Navigate to the record (for example, Incident).

2. Select the Documents  tab.

3. Select New.

4. On the form, fill in the fields.

New document record fields

Field Description

Name Name of the document.

Owner Name of the document owner.

Reviewers Name of the reviewers.

Template Option to determine whether the document is 
a template.

Department Name of the department.

Type The type of document based on the content, 
for example, guideline, policy, procedure, or 
contract.

Classification Classification of the document such as 
public, restricted, or confidential.

Audience Audience of the document, either internal or 
external.

State The state the document is in: Draft, Submit, 
Review, or Complete.

Description A brief description about the document.

Default Version
The document version used for document 
download.

By default, the latest version is the default 
version.

5. Select the access settings.

6. Click Submit.

Upload a document version in a parent record

Upload a document version for each document in the parent record.

Before you begin
Role required: none
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Procedure

1. Navigate to the record (for example, Incident).

2. Select the Documents  tab.

3. Right-click the document name.

4. Select Upload Version.

5. Select the file type you want to upload and add any information related to the file under Notes.

◦ To upload a file, select Attachment, select the file icon, and select the file.

◦ To link to a document, select URL  and provide the link.

6. Select OK.

Related topics

Create a document version

Download a document from its parent record

Download documents related to a parent record directly from the record.

Before you begin
Role required: none

About this task
Note: 
To download a document, the version file type must be an attachment and not a URL.

Procedure

1. Navigate to the required record (for example, Incident).

2. Select the Documents  tab.

3. Select the documents you want to download.

4. In the Actions on selected rows  drop-down menu, select Download Document.

Link existing documents to a parent record

Link documents that are in your repository to a parent record.

Before you begin
Role required: none

You must have sufficient permissions to access the document.

Procedure

1. Navigate to the required record (for example, Incident).

2. Select the Documents  tab.

3. Select Edit.

4. Select the documents you want to link.

5. In the Actions on selected rows  drop-down menu, select Link Documents.

Unlink documents from a parent record

Remove and unlink documents from a parent record when they are no longer relevant.
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Before you begin
Role required: admin

About this task
Note: 
This action unlinks the document from the parent record but doesn’t delete it from the 
repository.

Procedure

1. Navigate to the record (for example, Incident).

2. Select the Documents  tab.

3. Select the documents you want to unlink.

4. In the Actions on selected rows  drop-down menu, select Remove.

Delete a document from a parent record

Delete documents directly from a parent record.

Before you begin
Role required: admin with admin access

or

Access permission: owner

or

User: owner

Procedure

1. Navigate to the required record (for example, Incident).

2. Select the Documents  tab.

3. Select and open the documents you want to delete.

4. Select Delete.

Document Management  lists

Lists are a collection of template documents you can use to create documents that are linked to 
other target records. Only users with the admin role can access lists.

Document lists

A user with the admin role can create document lists and add multiple documents to a single list. 
Only users with the admin role can access lists.

Example: New hire onboarding

During new hire onboarding, employees must upload multiple documents such as ID, training 
certificates, and so on. Your organization can create documents as templates and group them 
under a list. Then when you reference this list to a target record, all the template documents 
under the list are created and linked to the target record.
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Document List Entries

List entries

Lists entries are a mapping of a template document with a document list. Only template 
documents can be linked to a list, such as when documents have the Template  option selected 
in the document record. The Document List Entries related list displays the list entries.

Note: 
Users can link only documents that they have access to.

List entries

Related topics

Group document templates in a list for creating and linking documents to a target record

Add a document template to a document list

Group document templates in a list for creating and linking documents to a target record

Group document templates in a list to enable all the template documents in the list to 
automatically be created and linked to the target record when the list is referenced.

Before you begin
Role required: platform_document_management_admin

Procedure

1. Navigate to Documents  > Documents  > Lists.

2. Select New.
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3. Provide a name and description of the list.

4. Select Submit.

What to do next
Create a document template

Related topics

Add a document template to a document list

Add a document template to a document list

Add a template document to a document list that groups document templates for creating and 
linking to a parent record.

Before you begin
Role required: platform_document_management_admin

About this task
Note: 
Only document templates can be linked to a list.

Procedure

1. Navigate to Documents  > Documents  > List Entries.

2. Select New.

3. On the form, fill in the fields.

List entry fields

Field Description

Document Name of the document template.

Document List Name of the list.

Description A brief description about the document list 
entry.

4. Click Submit.

Create documents using document lists for a target table record

You can create and reference documents on a target table record through the 
DocumentListService  API.

Before you begin
See the DocumentListService API  topic

Role required: admin

Note: 
You cannot create documents through Document Lists with the user interface (UI). It must 
be done with APIs.

Document attachments in an activity stream

Include documents in activity streams to include and track updates on attached documents to 
any record.
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You can include and track attached documents in activity stream journal fields like work notes or 
comments that display task records.

To add and attach documents to a record's activity stream, you would need to complete the 
following tasks:

• Enable Document actions in activity stream

• Enable Documents in the record

• Add documents to the record

Include document actions in an activity stream

Include document actions in an activity stream to view and track updates to attached documents 
in a record.

Before you begin
Role required: admin

About this task
To add and attach documents to a record's activity stream, you would need to complete the 
following tasks:

• Enable Document actions in activity stream

• Enable Documents in the record

• Add documents to the record

Procedure

1. Enter sys_properties.list  in the navigation filter.

2. Select the glide.documents.journal.enabled  property.

3. On the form, set the Value  field to true.

4. Select Update.

5. Select the glide.documents.attach.fields.

6. On the form, in the Value  field, add the field name that you want the record to reflect.
For example, you would enter work_notes for the Work notes  field.

Use a comma to add multiple field names.

Note: 
Document updates are pushed only if the field names exist.

7. Select Update.

References

The following sections describe the installed components and roles for Document Management, 
along with domain separation and supported browser information.

Components installed with Document Management

Several types of components are installed with activation of the Document Management  plugin, 
including tables and user roles.

Demo data is available for this feature.
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Roles installed

Role 
title 
[name]

Description Contains roles

Admin
Provides Create, Read, Update, and Delete 
access to the document and its related 
tables.

Admin users have access to List and List 
Entries modules.

platform_document_management_admin

Sharing permission roles

Role Name Description

dm_sharing_levels_user
This role contains the following roles:

• dm_user_role_read

• dm_user_group_read

• dm_user_criteria_read

Provides the ability to share documents at all 
levels (group, role, and user criteria).

dm_user_role_read Provides read access to the user role table 
and the ability to share documents based on 
user roles.

dm_user_group_read Provides read access to the User Group table 
and the ability to share documents based on 
user groups.

dm_user_criteria_read Provides read access to the User Criteria table 
and the ability to share documents based on 
user criteria.

Tables installed

Table Description

ds_document Stores document records containing 
document metadata.

ds_document_version Stores document versions containing the 
actual document file or URL to the file.

ds_document_references
Stores references between document records 
and other records.
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Table Description

Note: 
The records can be from any other table 
and record on the platform

Supports a many-to-many relationship 
between documents and target records.

ds_document_lists Stores document lists, which are a collection 
of template documents used to create and link 
documents to other records.

ds_document_list_entry Stores mappings between template 
documents and document lists.

ds_document_user_can_access_mtom Stores permissions provided to users to 
access documents as a Reader, Writer, or 
Owner.

ds_document_ug_can_access_mtom Stores permissions provided to user groups 
to access documents as a Reader, Writer, or 
Owner.

ds_document_ur_can_access_mtom Stores permissions provided to user roles 
to access documents as a Reader, Writer, or 
Owner.

ds_document_uc_can_access_mtom Stores permissions provided to user criteria 
to access documents as a Reader, Writer, or 
Owner.

ds_document_permalink Stores the permalink and expiration date for 
the document.

Note: 
The Documents [ds_document] and Versions [ds_document_version] tables can be 
extended.

Document Management  roles

Document Management  is installed with these roles.

To learn more about managing subscriptions, see Managing per-user subscriptions in 
Subscription Management  and contact your account representative.

Administrator  [platform_document_management_admin]

Provides Create, Read, Update, and Delete access to the document. Admin users have access to 
List and List Entries modules.

Contains Roles

List of roles contained within the role.

• dm_sharing_levels_user

• dm_user_role_read

• dm_user_group_read

• dm_user_criteria_read
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Groups

List of groups this role is assigned to by default.

None.

Special considerations

Note: 
Avoid granting an admin role when more specialized roles are available.

Domain separation and Document Management

Domain separation is supported for Document Management. Domain separation enables you to 
separate data, processes, and administrative tasks into logical groupings called domains. You 
can control several aspects of this separation, including which users can see and access data.

Support level: Standard

• Includes all aspects of Basic  level support.

• Application properties are domain-aware as needed.

• Business logic: The service provider (SP) creates or modifies processes per customer. The use 
cases reflect proper use of the application by multiple SP customers in a single instance.

• The instance owner must configure the minimum viable product (MVP) business logic and data 
parameters per tenant as expected for the specific application.

Sample use case: An admin must be able to make comments required when a record closes for 
one tenant, but not for another.

For more information on support levels, see Application support for domain separation .

Overview

Document Management  provides an access level approach to controlling the document access 
and providing security to the users.

How domain separation works in Document Management

When domains are separated in Document Management, users can see and manage documents 
and give access privileges only in their own (tenant) domain.

A user in the parent domain has access to documents in the child domain.

When a user creates a document, document list or document entries, then their domain is the 
same as the user's domain.

When the owner of the document changes then the related versions, references, and permission 
record's domain is updated with the domain of the parent document.

Use cases

• Documents

Documents can be edited or accessed only within their domain. Access to a document can 
become void if a user belongs to a different domain from the document's domain.
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◦ Users in the global domain can access documents in all domains when the read access is 
granted to the user.

◦ Users in a non-global domain can access documents only in the same domain and global 
domain when document access is granted to the user.

• Versions, References and Permissions table

◦ Users can access the versions, references, and, permissions table records only if they have 
access to the parent document.

◦ If a user has access to the target record in the references table, access to the parent 
document is granted only if inherited access is enabled for the document and the user is in 
the same domain as the parent document.

• List and List Entries

List and List Entries have domain pointing to the current user domain and can be accessed by 
the users with document admin rights.

Known issues

If a document contains references and if the owner of the document is changed and does not 
have access to the target record of one of the references, then the reference record might not be 
visible to the new owner.

For example, if the document owner, User A (Domain: D1) is changed to User B (Domain: D2) and 
User B does not have access to the target record of the reference table, User B might not be able 
to see the reference record.

Related topics

Domain separation for service providers

Document Viewer

Document Viewer  enables you to view documents directly in the ServiceNow AI Platform  rather 
than having to download them.

Document Viewer  supports viewing various file types in the platform including UTF-8 character 
encoded PDF file. The maximum document file size is 50 MB. To use Document Viewer, enable it 
at instance level and for the tables for which you want to use it.

Note: 
Document Viewer  now supports FedRAMP instances.

You can view the following file types:

• MS Word (.doc) and (.docx)

• MS PowerPoint (.ppt) and (pptx)

• MS Excel (.xls) and (.xlsx)

• PDF

• PNG

• JPEG

Note: 
The rotate option doesn’t work for images.
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Other document types, for example, .zip or .exe files, are automatically downloaded without 
requiring Document Viewer. Document viewer converts word documents and spreadsheets to 
pdf first in order to view them. This might take some time to render the file the first time.

PDF view in Document Viewer

The following table describes the icons used in Document Viewer.

Icons in Document Viewer

Icon Description

Toggle the sidebar to see a preview of all the 
pages in the document.

Download the attachment.

Page up or down using the arrow buttons. You 
can also scroll or use your keyboard arrow 
keys.

Rotate the page to the right.

Rotate the page to the left.

Zoom in or out of the document.

Increase the page to the full width of 
Document Viewer.

Search for keywords in the document. Use the 
arrows to toggle to the next search result.
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Related topics

View attachments with Document Viewer

Enable Document Viewer

Enable Document Viewer

Enable Document Viewer to view documents directly rather than download them to view them in 
their native applications.

Before you begin
Role required: admin

About this task
Document Viewer is enabled by default. Activate it at the instance level and then enable it 
at the table level for the tables where you want to use it. Ensure that the system property 
com.snc.documentviewer.enable_document_viewer  is set to true or create it if it 
does not already exist. To de-activate Document Viewer, create the system property 
com.snc.documentviewer.enable_document_viewer  manually and set it to false.

Procedure

1. Activate Document Viewer  at the instance level

a. Navigate to All  > System Definition  > All Available Applications  > All.

b. Enter ServiceNow Document Viewer  or com.snc.documentviewer  in the 
Search field.

c. Select Install.

2. Activate Document Viewer  for the tables where you want to use it.

a. Navigate to System Definition  > Dictionary.

b. Search for the table, open the record with the type field Collection.

c. Enter Use Document Viewer  in the Attribute  field.

d. Enter true  in the Value  field.
Document Viewer is enabled at the table level. Repeat this procedure for each table for which 
you want to enable Document Viewer.

Related topics

Disable Document Viewer

Document Viewer  plugins

With Document Viewer, you can view documents directly in the ServiceNow  Platform rather than 
having to download them. Two new plugins enhance the experience and provide more options 
for document viewing. You can collaborate with other people, copy, delete, restore, and view 
version history directly in a ServiceNow  instance.

Overview

In previous ServiceNow  releases, not all documents could be shared and used for team 
collaboration. With new plugins for the Platform Document Viewer, now you can:

• Collaborate (edit, share) with Microsoft OneDrive  and copy documents to your ServiceNow 
instance. 

• Upload a policy document authored in your ServiceNow  instance as a Microsoft 365  document 
in Microsoft 365  SharePoint.​
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• Attach shared links to a record. Clicking the link opens the document in Microsoft 365 
SharePoint.

•◦ The link can be shared with a co-worker, who can view and edit the document in real time.​

◦ The current version is also viewable in the ServiceNow  instance.​

• Use collaboration tools such as Microsoft 365  for review and co-authoring documents.​

Plugins

To use this feature, install the following plugins:

• Microsoft OneDrive  Spoke​

• Microsoft OneDrive  document service Spoke

• Microsoft Azure  AD Spoke for Integration Hub

• Multi Provider Document Service Framework

See List of plugins (Rome)  for a complete list of ServiceNow  plugins.

After installation, you can use the base system subflows or customize them. Configure the 
subflows in the Document actions table. Once configured, they can be invoked as UI actions 
from List views or can be invoked through Script Include APIs.​

Microsoft OneDrive  integration plugin

Collaborate in Microsoft OneDrive  and perform copy, delete, restore, and version 
actions on documents directly in a ServiceNow  instance. This integration is bi-
directional (performs in both directions): Changes are reflected in both Microsoft 
OneDrive  and in the instance.

Microsoft Azure AD Spoke for IntegrationHub

The Microsoft Azure AD Spoke  for Integration Hub  provides actions that a Process 
Analyst can use when designing flows. The actions allow them to automate the 
management of users, security groups, and office groups. User management 
includes applying licenses that result in user provisioning into Office 365.

Multi Provider Document Service Framework plugin (glide plugin)

Plugin contains the data model needed to integrate with third-party document 
service providers.

Note: 
To activate a plugin:

1. Navigate to System Definition  > Plugin.

2. Enter the plugin name in the Search field.

3. Select install.

Tables

mp_provider_details

• Provider Details Name

• Provider Name

• Attributes

mp_document_version
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• Version 

• Document

• Version Modified By​

• Version Last Modified​

mp_document_activity​

• Document Name​

• Document sys_id​

• Document Version sys_id

• Document Action​

• Provider Detail​

• Notes

mp_documents

• Document name​

• Provider Details

• Attachment

• URL

• Description

mp_document_action​

• document_action_name​

• provider_detail​

• subflow

• provider_permission​

mp_permission_configuration​

• Entity_type​

• Entity_id

• Attributes

• Provider_group_id​

• Provider_group_name​

• permission

mp_provider_permission​

• permission

• provider

• Attributes

• description

mp_collaborator​
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• collaborator_attributes​

• collaborator_email​

• collaborator_id​

• collaborator_name​

• Provider_detail​

• user

Related topics

Document Viewer

View attachments with Document Viewer

View documents within the platform using Document Viewer  rather than having to download 
them to your own file system.

Before you begin
Make sure that Document Viewer  is enabled for the table containing the record. For more 
information, see Enable Document Viewer.

Role required: none

About this task
Document Viewer  supports inline viewing of certain document types  within the platform.

Procedure

1. Navigate to a record (incident, form, list, and so on) with an attachment.

2. Click View next to the file attachment name.

Document Viewer  displays the document.

If the document does not display, Document Viewer  does not support inline viewing in your 
situation and a message instructs you to download the document. The possible reasons are:

◦ The document uploaded is platform encrypted or edge encrypted.

◦ The file size exceeds the maximum allowed value of 50 MB.

◦ The document is password-protected but it is not a PDF file.

Click Download Document  to view the document in the relevant external application.

Related topics

Enable Document Viewer

Disable Document Viewer

Disable Document Viewer  at the instance level to disable it or at table level to disable it for 
specific tables within the instance.

Before you begin
Ensure the Add a system property  (com.snc.documentviewer.enable_document_viewer) exists 
in your instance.

Role required: admin
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Procedure

Disable Document Viewer  at the instance level or for specific tables.

Related topics

Enable Document Viewer

Managed Documents

Use the ServiceNow®  Managed Documents application to control electronic documents within 
your instance.

After parameters have been set by the administrator and the Knowledge Document plugin 
installed, documents can move through the managed document cycle.

Managed Document features

Managed Documents is a lightweight, ITIL-based solution for creating and managing electronic 
documents within your instance.

This application adds a layer of control around any document by providing workflow, storage, 
security, and categorization options. It can be used for a variety of internal documents, such 
as policies and procedures, compliance documentation, and knowledge articles. Because it is 
integrated within the instance, Managed Documents offers a seamless alternative to 3rd-party 
systems.

Features

Feature Description

Check-
in/Check-out

Track revisions, approval history, and automated notifications for approvers 
and reviewers. Useful for compliance and risk authors, policy and procedure 
writers, and contract administrators.

Categorization Classify documents for organization and search.

Access 
control

Share documents with selected users.

Revision 
control

Track changes to documents.

Digital 
signature for 
approval

Integration with the Approval with E-Signature plugin.

Workflow Support consistent content review and approval.

Security Use high security setting.

Managed Document concepts

The following concepts explain Managed Documents: Managed Document, Document 
Collection, Document Revisions, and Document Parameters.
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Concepts

Concept Description

Managed 
Document

The Document [dms_document]  table contains the documents controlled 
through the managed documents process.

Document 
Collection

The Document Collection [dms_collection]  table allows related documents to be 
grouped together.

Document 
Revisions

Because managed documents must have clear records of individual versions of 
a document, revisions (including the file) are attached to the primary document 
record through a related list. Document revisions are controlled to keep a standard 
naming scheme and consistent version numbers. Once a document revision is 
ready, it can be submitted for review.

Document 
Parameters Important: 

Parameters do not control application or document security. Parameters only 
organize documents, they do not affect who can access documents. To grant 
access to the Managed Documents application, you can assign a role. To 
grant access to a specific document, set user and group permissions.

Each document can be associated with predefined parameters. The parameters 
can help with grouping documents.

• Type: Defines the type of document being controlled. Documents of the same 
type use the same controls.

• Classification: Defines document restriction level, such as public, restricted, or 
confidential.

• Audience: Defines the groups with access to the document, such as internal or 
external.

• Name Formats: Defines the format of document names, ensuring that 
documents of the same type have the same name scheme assembled from 
name components.

• Name Components: Defines the document values used in the name formats.

• Approval Rules: Defines the approvals the document must have before it can be 
published.

Defining Document Workflow

In the base system, all managed documents use the Managed Documents  workflow after the 
Active  check box is selected.
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Document workflow

The document parameters defined in the workflow are often used as conditions to trigger 
more specific workflows, such as type-specific workflows or classification-specific workflows. If 
different kinds of documents should follow different workflows, use the Graphical Workflow Editor 
to create new workflows.

Defining Document Parameters

Before using the Managed Documents application, the user with the 
document_management_admin  role needs to set the parameters that define the kinds of 
documents to be managed through the application. Managed Documents provides both base 
and custom parameter options.

Defining Document Parameters

The following document parameters should be defined:

• Type:  identifies the purpose of the document. The type also determines the default document 
format and name format.

• Classification:  indicates the security level assigned to the document and determines who can 
view or edit the document.

• Audience:  specifies the intended readers of the document.

• Name format:  specifies the name format to use when a document revision is added.

• Name components:  are individual identifiers used inside a name format. Name components 
define a reference path (often by dot-walking) that holds the value specific to the document.

• Approval rules:  determine which approvers are added to documents (in addition to the 
Reviewers  specified on the document record).

Defining Types

To define a new type, navigate to Managed Documents  > Administration  > Type  and click New.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3163



Field Description

Name A unique name for the type.

Code A short code for the type. Referenced as a name component for the name 
format.

Label A label to display in the Type  choice list.

Name 
Format

The name format that documents of this type will use.

Order A number indicating the type's sequence in the choice list.

The following types are available in the base system.

Name Code Label Name format Order

-- None -- null -- None -- null 1

policy POL Policy Default Policy 2

guideline GUI Guideline Default 3

procedure PROC Procedure Default 4

contract CON Contract Default 5

Note: 
For documents with a Type  of Contract, a Contracts  related list appears on the document 
record, listing any contracts the document is associated with.

Defining Approval Rules

To define a new approval rule, navigate to Managed Documents  > Administration  > Approval 
Rules  and click New.

Field Description

Name A unique identifier for the approval rule.

Active A check box indicating whether this approval rule is used.

Condition A condition builder that determines which documents use this approval rule.

Description A short description of the approval rule.

Once the approval rule is saved, the Approvers  related list defines which approvers are added if 
the conditions in the Condition  field are met.

The following approval rules are available in the base system.

Name Condition

Internal policy type=Policy ^ audience=Internal

Development policy type=Policy ^ department=Development

Related topics

Defining Document Parameters
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Defining Audiences

To define a new audience, navigate to Managed Documents  > Administration  > Audience  and 
click New.

Field Description

Audience 
Name

A unique name for the audience.

Audience 
Code

A short code for the audience. Referenced as a name component for the name 
format.

Label A label to display in the Audience  choice list.

Order A number indicating this audience's sequence in the choice list.

The following audiences are available in the base system.

Audience Audience code Label Order

internal INT Internal 1

external EXT External 2

Related topics

Defining Document Parameters

Defining Classifications

Define a new classification on the Classification form.

Navigate to Managed Documents  > Administration  > Classification  and click New.

Field Description

Name A unique name for the classification.

Code A short code for the classification. Referenced as a name component for the name 
format.

Label A label to display in the Classification  choice list.

Order A number indicating this classification's sequence in the choice list.

The following classifications are available in the base system.

Name Code Label Order

public P Public 1

restricted R Restricted 2

confidential C Confidential 3

Defining Name Components

Name components define the document values used in the name format.
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For example, the name component document.audience.code  dot-walks from the 
document record to the audience Code.

To define a new name component, navigate to Managed Documents  > Administration  > 
Components  and click New.

Field Description

Name A unique identifier for the name component.

Short 
Description

A short description of the name component value.

Value The path to the field holding the value used for the name format. Defined relative 
to a current revision record.

For example:

• Enter revision  to use the revision Number  field on the revision record.

• Enter document.name  to use the Name  field on the revision's referenced 
document.

• Enter document.audience.code  to use the Code  field for the audience 
referenced by the document.

This dot-walking approach makes it possible to get any value related to the 
revision into the name format.

Note: 
The revision  component is a special component replaced by the appropriate revision 
number (rather than querying a value related to the current record). The revision is either 
automatically incremented or uses the latest revision number, depending on the setting on 
the document form.

The following components are defined in the base system.

Name Short description Value

Audience code Displays the code assigned to the document 
audience.

document.audience.code

Classification 
code

Displays the classification code. document.classification.code

Document 
name

Displays the document name. document.name

Revision Displays the document revision. revision

Type code Displays the code assigned to the document 
type.

document.type.code

Defining Name Formats

The name format automatically generates a name for a document revision by arranging name 
components in a standard code to match naming conventions.

For example, a name format with the name components Type Code, Document Name, and 
Revision Number  and the separator -, would be formatted as:
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TYPECODE-Name-RevNumber.fileformat

In this example, a policy (code POL) named IT Off-Boarding Policy, with revision 
number 1.0, and uploaded as a .docx  file would have the name:

POL-IT Off-Boarding Policy-1.0.docx

To define a new name format, navigate to Managed Documents  > Administration  > Name 
Formats  and click New.

Field Description

Name A unique name for the name format.

Separator A separator to put between each of the components. Hyphens (-) and 
underscores (_) are commonly used. Using alphanumeric characters can create a 
confusing name format.

Description A description of the name format.

Use the related list to add name components. Use the Order  field to set the sequence in which 
name components are used.

The following name formats are defined in the base system.

Name Separator Description

Default _ The default format. Document name and revision separated 
by an underscore.

Default Policy _ The format for the policy document type.

Development 
documentation

(no 
separator)

The format for the software documentation type.

Development 
Sources

(no 
separator)

The format for the development and code sources type.

Intranet Improvement (no 
separator)

The format for documents that describe intranet use.

Domain separation and Managed Documents

Domain separation is unsupported in Managed Documents. Domain separation enables you to 
separate data, processes, and administrative tasks into logical groupings called domains. You 
can control several aspects of this separation, including which users can see and access data.

Support level: No support

• The domain field may exist on data tables but there is no business logic to manage the data.

• This level is not considered domain-separated.

For more information on support levels, see Application support for domain separation .

Related topics

Domain separation for service providers

Managed Documents plugin

This page describes the applications and modules, database table structure, scripts, and roles.
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Database table structure

The following tables are added:

Tables

Display Name (Table 
Name)

Description

Document 
[dms_document]

The document details.

Revision 
[dms_revision]

The document revisions.

Audience 
[dms_audience]

The intended document readers.

Classifications 
[classification]

The document restriction level, such as public or confidential. (Does not 
define access to the document. Document security is set in user and 
group permissions.)

Type [dms_type] The document purpose.

Component 
[dms_component]

The components of name formats. The value field is a dot-walking 
expression that is evaluated. An exception is made for the revision 
because it does not exist when the revision name is generated.

Name format 
[dms_name_format]

The composition of components to generate revision names.

Approval sequence 
[approval_sequence]

The approval sequences that users must follow.

Approval Rule 
[dms_approval_rule]

The criteria that records of the dms_document table must match. Used 
to automatically add approvers to a document.

Collection 
[dms_collection]

The document groups created by the user.

Scripts

Business rules that are added to sys_script

Rule Description

Update Document Changes the state of a document depending on its revisions.

Add Approvers Populates the list of approvers in the document.

Script includes that will be added to sys_script_include

Script include Description

DocumentManagement Contains the main logics for the Managed 
Documents plugin.

DocumentManagementDB Contains methods to perform CRUD operations on 
the database.
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Script includes that will be added to sys_script_include  (continued)

Script include Description

DocumentManagementSecurity Helps manage the security of the Managed 
Documents system.

DocumentManagementAjax Updates the details of the temporary revision that is 
created when opening the upload/check in revision 
form.

DocumentAttachmentAjax Renames an attachment file.

DocumentRevisionWorkflowHelper Helps perform basic workflow operations on a 
revision.

DocumentManagementApprovalMatcher Helps obtain the user and group approvers for a 
document that matches approval rules.

DocumentApproverHelper Contains logics to handle document approvers.

DocumentManagementUtils Useful methods.

DocumentReferenceQualifiers Static methods that return reference qualifiers.

Client script that is added to sys_script_client

Rule Description

Document type 
change

Updates the name format field in the revision settings section of the 
document. Each type has a default name format.

Roles

This plugin introduces two new roles:

Roles

Role Description

document_management_user This role enables a user to access the Managed 
Documents plugin, create documents, and search for 
documents. Document reviewers and approvers need the 
document_management_user role to access the Managed 
Document plugin. (Please note that reviewers and approvers 
can also access a document revision from an approval 
record.)

document_management_admin This role enables a user to change administrative settings for 
the Managed Documents plugin.

Note: 
Each document has individual permissions, so even if a user is given the 
document_management_user role and has permissions to the application, the user can 
only view documents to which they have been given access.

Install the Managed Documents plugin

The Managed Documents plugin is available for activation by users with the admin role.
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Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Application  > All Available Applications  > All.

2. Find the Managed documents (com.snc.document_management) plugin and select Activate/
Upgrade.

If the plugin depends on other plugins, these plugins and their activation status are listed.

3. Optional:  Select the Load demo data  check box.

(Optional) Some plugins include demo data—sample records that are designed to illustrate 
plugin features for common use cases. Loading demo data is a good policy when first 
activating the plugin on a development or test instance. You can load demo data after the 
plugin is activated by repeating this process and selecting the check box.

4. Select Activate.

Knowledge Document plugin

The Knowledge Document plugin extends the Managed Documents plugin by providing the 
functionality for managed documents to be published to the Knowledge Base.

Installed with Knowledge Document plugin

These elements are installed with the Knowledge Document plugin.

Dependencies

The Knowledge Document plugin depends on the Managed Documents plugin. Activating 
Knowledge Document activates Managed Documents.

Tables

Tables

Display Name [table_name] Description

Knowledge Records 
[m2m_document_knowledge]

A many-to-many table storing the relationship between a 
document and a knowledge article.

UI Actions

UI actions

UI action Description

Link to 
Knowledge

Creates or updates a knowledge article related to the current document, 
depending on whether a knowledge article already exists.
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Scripts

Script includes

Script include Description

KnowledgeDocument Holds the main logic for the Knowledge Document plugin.

KnowledgeDocumentDB Class that gets, inserts, and updates data for the Knowledge 
Document plugin.

Link documents to Knowledge articles

Manage a document and access the latest version of the document from an article by linking the 
document to a Knowledge article.

Before you begin
Your administrator must have activated the following plugins:

• Knowledge Document plugin (com.snc.knowledge_document)

• Knowledge Management Advanced plugin (com.snc.knowledge_advanced)

The document is already uploaded and published. For more information, see Upload a document 
and Publish an approved revision.

You must have contribute access to the Knowledge Base within which the article linked to the 
document is stored.

If a Knowledge article is already linked to the document, you must have contribute access to the 
article.

Role required: document_management_user and knowledge

About this task
You can link the initial or revised version of a document to a Knowledge article. The document 
appears as an attachment to the linked article. Revising a document doesn't automatically 
update the document attached to the linked Knowledge article. Therefore, every time you revise 
a document, you must again link the revised document to the Knowledge article.

Note: 

As the owner of a document or an administrator, you can link the document to a published 
article. If the article is checked out by another user, you can't link the document to the 
associated article, unless the article is published.

A managed document can only be linked to one article.

Procedure

1. Navigate to Managed Documents  > Documents  > All.

2. Click the document.

3. In the Knowledge Settings related list, fill in the fields.

Knowledge settings

Field Description

Behavior Process performed when the Link to Knowledge  related link is clicked.

A behavior is one of the following types:
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Field Description

◦ Always create record: A new Knowledge article is created and linked with the 
latest published revision of the document as an attachment.

◦ Update existing record: The linked Knowledge article is updated with the 
latest published revision of the document as an attachment. If no Knowledge 
articles exist for the document, a new Knowledge article is created.

Note: 
Once you select a behavior setting for a document, you can't modify it later 
when revising the document.

Knowledge 
Base

Knowledge Base in which the Knowledge article is stored. You can associate 
a Knowledge article with one Knowledge Base only. If you are using an article 
template, you can modify this value only if the template is available in the other 
Knowledge Base.

Type Article template to create a Knowledge article using defined fields and values.

Note: 
when a Knowledge article is created, the Type  field becomes read-only.

Valid to Date that the article expires. Adds valid to date information to the same field in 
the Knowledge article.

Short 
description

A few words or short phrase describing the Knowledge article. Adds the short 
description to the same field in the Knowledge article.

4. Click the Link to Knowledge  related link.

5. Optional:  In the information message that is displayed, click the message link to view the 
Knowledge article.

Result
The uploaded document is added as an attachment to a Knowledge article. Depending on the 
Behavior  field value specified in the Knowledge settings related list, the Knowledge article is 
created or updated with the document.

Create a document

After Managed Documents parameters have been set by the administrator, documents can be 
created, requested, checked out, edited, checked in, copied, and, if necessary, rolled back to an 
earlier version.

Once documents have been added to the Managed Documents application, they can be 
grouped into document collections.

Document approval

During the approval process, the approver approves or rejects the document. A document goes 
through the approval process after the review process.

Approval workflow

After the document has been reviewed, submit the document for approval. If the document does 
not have an approver, the approval process is omitted.
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When the document is Active, the workflow Document Management Default  is used to manage 
approvals:

Document Management Default workflow

If the approver rejects the document, the author and owner are notified and the document review 
is cancelled. The author, owner, and approver should discuss what changes need to be made to 
the document. When the document is ready, a new review can be initiated.

If the final approver approves the document, the author and the owner are notified. Once final 
approval is successful, the document stage changes to Ready for Publishing  in the Document 
Revisions list:

Document Management Default workflow result

Process modification for multiple approvers

If there are multiple approvers, the approval process works in sequence and multiple approvers 
can be assigned to a single sequence. For example:

• Sequence 1: approvers A and B

• Sequence 2: approvers C and D

• Sequence 3: approver E

Because the sequences take place in ascending chronological order, approvers A and B receive 
the approval request first (approvers C, D, and E are not part of the process yet). Similar to 
the review process, the first approver to act within a sequence dictates what happens to the 
document. If approver A acts first and rejects the document, the approval process stops and 
the state is set to Cancelled. Approver B's status is changed to No Longer Required. If approver 
A acts first and approves the document, the process stops and approver B's status is changed 
to No Longer Required. Then, the document moves to approval sequence 2. After at least one 
approver in each sequence approves the document, the author and the owner are notified that 
the document has been approved.
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Review process

During the review process, the reviewer approves or rejects the document. Sometimes a 
document will have multiple reviewers.

If the reviewer rejects the document, the author and owner are notified and the review is 
cancelled. The author, owner, and reviewer should discuss what changes need to be made to 
the document. If the reviewer approves the document, the author and owner are notified that the 
review was successful and the document can move to the approval stage.

If multiple reviewers are assigned to a document, the first reviewer to act dictates what happens 
to the document. For example, there are two reviewers, A and B. If reviewer A acts first and 
rejects the document, the review process stops and the revision state is set to Cancelled. 
Reviewer B receives a notification email stating that the review was rejected and their status is 
changed to No Longer Required. If reviewer A acts first and approves the document, the review 
process stops and the document can move to the approval stage. Reviewer B's status is changed 
to No Longer Required.

Enable electronic signature for approval

Enabling electronic signatures for approval. Electronic signatures are helpful if you must obtain a 
digital signature for compliance or auditing purposes.

Before you begin
Role required: admin

About this task
You can activate the Approval with e-signature plugin  to require that users type in a user name 
and password when reviewing and approving documents.

The digital signature is not tracked or stored in the document record. Users must simply type in a 
user name and password after clicking the Approve  or Reject  button.

Digital signature

After activating the Approval with E-Signature plugin, ensure that a row in the e-signature registry 
table is created for the dms_document_revision table.

Procedure

1. Navigate to All  > System Definition  > e-Signature Registry.

2. Check if dms_document_revision  is already listed and Enabled  is set to true.

3. If not listed, click New.

4. In Table name, select Document Revision.

5. Select Enabled.
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6. Click Submit.

Publish an approved revision

Publish a document revision that has been approved.

Before you begin
Role required: document_management_admin

or

Role required: document_management_user

About this task
Once a document has been created and edited, a specific revision can be submitted for draft 
review and final approval. After final approval, the document can be published.

Publish the approved revision from the Document Revisions list.

Note: 
Publishing documents to the Knowledge Base requires the Knowledge Document Plugin.

Procedure

1. Navigate to the document record.

2. In the Document Revisions List, click the revision marked Ready for Publishing.

3. Click Publish Revision  to display the Publish  dialog box.

The revision number matches the latest revision number. If your standard is to change the 
revision number when the document is published, such as incrementing the version number to 
1.1 or 1.0.1, the change can be made on this dialog box manually.

4. Click Publish.

The published revision is highlighted in green and the stage of previous revisions is 
automatically changed to Retired:

Note: 
If the approval and publishing process is repeated, the published revision is retired when 
the new revision is published. Any workflows running against previous revisions are 
canceled when the document is published.

Submit a revision for draft review

Submit a document draft for review.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3175



Before you begin
Role required: document_management_admin

or

Role required: document_management_user

About this task
Once a document has been created and edited, a specific revision can be submitted for draft 
review and final approval. After final approval, the document can be published.

When a draft of the document is ready, submit the draft for review. If the document does not have 
reviewers identified in the Reviewers field of the document record, the review process is omitted.

Procedure

1. Navigate to the document record.

2. Right-click the appropriate revision.

3. Select Submit Revision.

The revision stage is set to Awaiting Review.

The document name and parameters are changed to read-only. The document state is set to 
Active.

Create or request a new document

Once an administrator has set parameters for the Managed Documents application, you can 
create or request new documents.

Before you begin
Role required: document_management_admin

or

Role required: document_management_user

Procedure

1. Navigate to All  > Managed Documents  > Create New.

2. Complete the following fields:

New document fields

Field Input value

Number An identifying number for the document. Automatically generated using 
number maintenance.

Name A name for the document. Note that the name for the document is combined 
with other naming components (as defined by the name format) to create the 
names for each document revision.

Requested 
by

The person asking that the document be created or updated.

Owner The approver of the document request. Also responsible for setting 
completion date with requesters and authors.

Reviewers The user or users who review the document and provide feedback to owners 
and authors.
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Field Input value

Department The department responsible for the document.

Type The document purpose. This is a choice list derived from the type parameters.

Classification The document classification, based on security, audience, and confidentiality. 
This is a choice list derived from the classification parameters.

Note: 
This does not drive any functionality.

Audience The document readers, such as external or internal. This is a choice list 
derived from the audience parameters.

Note: 
This does not drive any functionality.

State The current status of the document in the editing and publication process.

Checked out 
by

The user who currently has the document checked out.

Description A short description of the document.

Revision Settings

Name format The format for the name of each individual revision of the document. For more 
information, see name format.

Revision 
format

A choice between the two digit (0.x) or the three digit (0.0.x) revision format.

Auto 
increment 
revision

If selected, the revision number automatically increments each time the 
document is revised.

The User Permissions  related list determines which users have rights to view and contribute to 
the document:

User permissions

Field Input value

User A reference to a user who is entitled to read but not contribute to a document.

Type A choice list describing how the user can interact with the document. Options are:

◦ Reader - The user can read the document versions.

◦ Editor - The user can upload new versions.

◦ Owner - The user can edit the document.

The Group Permissions  related list determines which groups have rights to view and 
contribute to the document:
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Group permissions

Field Input value

Group A reference to a group of users who are entitled to read and contribute to the 
document.

Type A choice list describing how group members can interact with the document. Options 
are:

◦ Reader - Group members can read the document versions.

◦ Editor - Group members can upload new versions.

◦ Owner - Group members can edit the document.

Specify an approver

You can specify approvers for a document record after you save it.

Before you begin
Role required: document_management_admin

or

Role required: document_management_user

About this task
You can have one approver or multiple approvers. For example, set multiple approvers to have 
one person do a quality check of the document and a different individual to serve as a final 
approver. Approvers are assigned a number. The lowest number (usually number one) approver 
always goes first, then any other approvers in ascending chronological order. Multiple approvers 
can have the same sequence number. For example, two approvers can do a quality check and 
be assigned sequence number 1. Then, two individuals can be final approvers and be assigned 
sequence number 2.

Procedure

1. Navigate to the document record.

2. Select the additional actions icon  and select Add Approver.

3. Add a user name.

4. Select a sequence number from the drop-down list.
Lower numbers approve before higher numbers. For example, approver number one approves 
before number two.

5. Click Add User.

6. Repeat steps 2-5 to add more approvers.

Check in a document

Check in the document after you revise it so other users can check out the document.

Before you begin
Role required: document_management_admin

or

Role required: document_management_user
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Procedure

1. Navigate to the document record.

2. Select the Upload/Check In Revision  related link.

3. Click Browse  and navigate to the revised file.

4. Click Open.

5. Check the Name and Revision Number.

6. Click OK.

Copy a document

A document can be duplicated at any time. This is useful if you have an existing document that 
you want to use as a base for a new document.

Before you begin
Role required: document_management_admin

or

Role required: document_management_user

Procedure

1. Navigate to the document record.

2. Right-click the header bar and select Copy Document.

An information message with a link to the new document displays:

3. Click OK.

The new document is renamed and includes the word "Copy."

Note: 
Only the latest revision is copied.

Deactivate a document

To change the document state to Inactive, deactivate the document. This is useful when changes 
to a document have been put on hold. An inactive document can be reopened at any time.

Before you begin
Role required: document_management_admin

or

Role required: document_management_user

Procedure

1. Navigate to the document record.

2. Right-click the header bar and select Deactivate Document.

Note: 
To activate a document, right-click on the header and click Reopen Document.

Reopen a deactivated document

A document that has been deactivated can be reopened.
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Before you begin
Role required: document_management_admin

or

Role required: document_management_user

Procedure

1. Navigate to the document record.

2. Right-click the header bar and select Reopen Document.

Roll back a document

A document can be rolled back to an earlier revision at any time. Before rolling back to an 
earlier revision, ensure that the document is not checked out and that you have Editor or Owner 
permissions for the document.

Before you begin
Role required: document_management_admin

or

Role required: document_management_user

Procedure

1. Navigate to the document record.

2. In the Document Revisions list, click the revision that you want to roll back to.

3. Right-click the header bar and select Rollback.
The Rollback to Revision dialog box displays. The name and revision number are new. The note 
specifies the revision to which you are rolling back.

4. Change any information on the Rollback to Revision dialog box as necessary.

5. Click OK.
The latest revision is now the revision that you selected for rollback.

Cancel a document

Change the document state to Cancelled  when no more changes will be made to the document.

Before you begin
Role required: document_management_admin

or

Role required: document_management_user

About this task
When canceling a document, there is no confirmation message, so ensure that you want to 
cancel the document.

Procedure

1. Navigate to the document record.

2. Right-click the header bar and select Cancel Document.

An info message confirms the cancellation:

The State  is set to Cancelled.
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Check out a document

Documents in the Managed Documents application can only be revised by one user at a time. 
Check out the document to revise it.

Before you begin
Role required: document_management_admin

or

Role required: document_management_user

Procedure

1. Navigate to the document record.

2. Select the Check Out Document  related link.

3. Select Download file  to download the current version of the document when it is checked out.

4. Click Check Out.

After checking out a document, you can edit the document and make any necessary changes.

Create a document collection

A document collection is a set of individual documents. After documents have been uploaded 
into Managed Documents, organize the documents by grouping them into collections.

Before you begin
Role required: document_management_admin

or

Role required: document_management_user

Procedure

1. Navigate to All  > Managed Documents  > Document  > My Collections.

2. Select New.

3. Enter a Name.

4. Optional:  Enter a Description.

5. Click Submit.

6. Click the name of the collection that you created.

7. Click Edit.
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8. On the left, double-click an available document or select a document and click Add.

9. Click Save.
The Document Collection page displays and the individual documents in the collection are 
listed.

Upload a document

Upload a document into a saved record. You can upload text files, spreadsheets, presentations, 
PDF files, and more.

Before you begin
Role required: document_management_admin

or

Role required: document_management_user

Procedure

1. Navigate to the document record.

2. Click the Upload/Check In Revision  related link.

3. Click Choose File  and navigate to the file.

4. Click Open.

5. Check the Name and Revision Number.

6. Click OK.

After the initial document is uploaded, subsequent revisions can be created by checking out 
the document.

Create a new managed document record

Configure the properties and policies for a managed document.

Before you begin
Role required: document_management_admin

or

Role required: document_management_user

Procedure

1. Navigate to All  > Managed Documents  > Create New.

2. In the Name  field, type Policy.

3. In the Requested by  field, add your name.

4. In the Owner  field, add your name.

5. In the Reviewer  field, add your name.

6. In the Type  field, select Policy.

7. In the Classification  field, select Confidential.

8. In the Audience  field, select Internal.

9. Under Revision Settings, select the Auto increment revision  option.
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10. Click Submit.

Check in a document after making changes

After making changes to a document, check the revised document into Managed Documents.

Before you begin
Role required: document_management_admin

or

Role required: document_management_user

Procedure

1. Open the document record.

2. Click the Upload/Check in Revision  related link.

3. Click Choose File, select the revised file, and click Open.

4. Check that the Name  and Revision Number  contain the updated number.

5. Ensure that the Check in  option is selected.

6. Click OK.
The Document Revisions list updates to contain the most recent revision.

Check out a document to make changes

After a document is added to a managed document record, check the file out to make changes. 
Checking documents in and out keeps a record of document changes and ensures that only one 
person at a time is editing the document.

Before you begin
Role required: document_management_admin

or

Role required: document_management_user

Procedure

1. Open the document record.

2. Select the Check Out Document  related link.
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3. Select Download file.

4. Click Check Out.

5. Open the file and make a small change.

6. Save the document with the same name, but a new revision number.
For example, Policy_POL_02.txt.

Publish a document in Managed Documents

After the document is reviewed and approved, publish the document within Managed 
Documents.

Before you begin
Role required: document_management_admin

or

Role required: document_management_user

Procedure

1. Open the document record.

2. In the Document Revisions list, click the name of the revision that was approved and is listed in 
the Ready for Publishing stage.

3. In the header bar, click Publish Revision.

4. In the Publish revision dialog box, check that the name and revision number are correct and 
click Publish.
In the Document Revisions list, the revision you just published is now in the Published stage.

Send a document out for review and approval

When a document is ready, send it out for review and approval. If a reviewer or approver is not 
identified in the document record, the document is moved directly to the publishing stage.

Before you begin
Role required: document_management_admin

or

Role required: document_management_user
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Procedure

1. In the Document Revisions list, right-click the revised document and select Submit Revision.
Because you identified yourself as the reviewer, you receive an approve request email 
message.

2. In the email message, click the link next to Click here to view Approval Request.

3. Optional:  View the document by clicking the attachment name under Document Revision.

4. Click Approve.
The Approvals page displays and lists the document you just approved.

5. Open the document record.

6. In the Document Revisions list, the revision you approved is now in the Ready for Publishing 
stage.

Upload a document as an attachment

After creating a document record, add the document to the record as an attachment.

Before you begin
Role required: document_management_admin

or

Role required: document_management_user

Procedure

1. Open the document record.

2. Select the Upload/Check in Revision  related link.

3. Click Choose File.

4. Select a simple document, such as a text file, and click Open.

5. Check that the name reads Policy_POL_0.1.

6. Click OK.

The document is listed under Document Revisions.

Multi Provider Document Services  Framework

Enable your team to collaborate in real time and add versions, store, copy, delete, restore, and 
upload documents by integrating document providers with your ServiceNow  instance.

Activate Multi Provider Document Services  Framework

You can activate the Multi Provider Document Services Framework  plugin 
(com.snc.multiprovider_documents) for Document Services  if you have the admin role.

Before you begin
Role required: admin

About this task
The following items are installed with the Multi Provider Document Services Framework:

• Plugin

• Roles

• Tables

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3185



Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the Multi Provider Document Services Framework  plugin 
(com.snc.multiprovider_documents) using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.

Note: 
When domain separation and delegated admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .

Installed with Multi Provider Document Services Framework

Several types of components are installed with activation of the Multi Provider Document 
Services Framework  plugin, including tables and user roles.

Roles installed

Roles installed with multi provider framework

Role Description

Admin

mp_document_admin

Configures multiple providers, remote 
document actions, and corresponding 
subflows.

Document User

mp_document_user

Creates, updates, and deletes documents 
managed for providers

Tables installed

Tables installed with multi provider framework

Table Description

Multi Provider Document

mp_document

The documents connected with the third-party 
provider.

Multi Provider Document Version

mp_document_version

The versions related to documents.
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Tables installed with multi provider framework  (continued)

Table Description

Multi Provider Document Activity

mp_document_activity

Logs the activity for document and 
document versions table and can be used to 
troubleshoot the actions taken on documents 
and versions.

Multi Provider Collaborators

mp_collaborators

Third-party users collaborating on the 
ServiceNow  instance.

Multi Provider Detail

mp_provider_detail

Details of the thirty-party providers that have 
been configured.

Multi Provider Document Action

mp_document_action

The actions associated with each subflow.

Multi Provider Permission

mp_provider_permission

Permissions allowed by the provider.

Multi Provider Permission Configuration

mp_permission_configuration

Role/group mapping to permissions provided 
from the mp_permission table for each 
provider.

Multi Provider Document Services Framework  Framework roles

Multi Provider Document Services Framework  Framework  is installed with these roles.

To learn more about managing subscriptions, see Managing per-user subscriptions in 
Subscription Management  and contact your account representative.

Administrator  [mp_document_admin]

Configure multi provider, remote document action, and corresponding subflows.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.
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Special considerations

Note: 
Avoid granting an admin role when more specialized roles are available.

User  [mp_document_user]

Create, update, and delete documents managed for providers.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

Microsoft OneDrive  integration with Document Services

Use Microsoft OneDrive  to copy, delete, restore, and get version actions on documents directly in 
your ServiceNow  instance.

Benefits of Microsoft OneDrive  integration

Increase collaboration by integrating Microsoft OneDrive  with your ServiceNow  instance.

With Microsoft OneDrive  integration you can do the following:

• Edit, share, and copy documents from Microsoft OneDrive  to your ServiceNow  instance.

• Edit, share, and copy documents from a ServiceNow  instance to Microsoft OneDrive.

• Push a document authored in your ServiceNow  instance to Microsoft SharePoint.

• Attach a shared link to a record.

• Share links to collaborate and edit documents in real time.

• Fetch the current version of the document.

• Collaborate with Microsoft 365  for reviewing, approving, or co-authoring documents.

• Migrate documents from Microsoft SharePoint  to your ServiceNow  instance.

Activation information

To integrate Microsoft OneDrive  with Document Services, install the Multi Provider Document 
Services Framework plugin (com.snc.multiprovider_documents). For more information, see 
Activate Multi Provider Document Services Framework.

You also need to install the Document Services  Framework for Microsoft OneDrive.

Document Services  Framework for Microsoft OneDrive

Integrate the Document Services  Framework with Microsoft OneDrive.
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Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Integration Hub  subscription

This spoke requires an Integration Hub subscription. For more information, see Legal schedules - 
IntegrationHub overview .

Spoke version

Microsoft OneDrive spoke for Document Services Framework spoke  v 1.2.2  is the latest version.

Supported versions

This spoke was built for  Microsoft OneDrive  Spoke for Document Services  Framework  V1.1, but 
might be compatible with later versions.

Key features

Microsoft OneDrive  Spoke for Document Services  Framework  enables a flow designer to do the 
following:

• Upload documents to Microsoft OneDrive

• Collaborate

• Manage versions

• Download documents

Spoke dependencies

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

• Complex Object (com.glide.cobject)

• IHUB Spoke Util Pack (com.snc.ihub_spoke_util_pack)

• Multi Provider Document Services  Framework (com.snc.multiprovider_documents)

• Remote Directory Sync (com.snc.remote_directory_sync)

• ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)

• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)

• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)

Note: 
Some of these plugins are licensable features and require appropriate licenses if used 
outside the spoke implementation.

Spoke subflows

The  Microsoft OneDrive  Spoke for Document Services  Framework  provides sample subflows to 
demonstrate the automation of Document Services  tasks. To customize a sample subflow, copy it 
to a new application scope. The following tables list the available sample subflows for V1 and V2.
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Note: 
Only V2 subflows support the Microsoft SharePoint  site.

V1 Subflows

Subflow Description

Add 
Collaborator 
To Group

Adds the supplied CollaboratorID as the Member or Owner specified by Type.

Collaborate 
Document

Associates a document with a group or a user on Microsoft OneDrive.

Collaborate 
Document 
With 
Recipient 
Type

Associates a document with a specified Recipient Type

Connect 
Document 
From 
OneDrive 
Using Path

Connects the Microsoft OneDrive  document.

Copy 
OneDrive 
Document 
Version

Copies the document with the specified version from Microsoft OneDrive  to an 
attachment in the ServiceNow  instance.

Create 
Document

Copies the document to Microsoft OneDrive, creates a record in the Multi 
Provider Document [mp_document] table, and adds a version in the Multi 
Provider Document Version [mp_document_version] table.

Create 
Group

Creates a group as specified in Microsoft OneDrive  and updates the Multi 
Provider Permission Configuration [mp_permission_configuration] table.

Delete 
Document

Deletes the document in Microsoft OneDrive  and removes its corresponding 
records in the Multi Provider Document Version [mp_document_version] tables.

Delete 
Document 
Version

Deletes the specified version of the document in Microsoft OneDrive  and the 
ServiceNow  instance and deletes a record in the Multi Provider Document 
Version [mp_document_version] table.

Get All 
Document 
Version

Retrieves all document versions from Microsoft OneDrive  and 
creates and updates records in the Multi Provider Document Version 
[mp_document_version] table.

Get 
Document 
from 
OneDrive

Copies the document from Microsoft OneDrive  to the specified document 
name. It also creates a record in the Multi Provider Document [mp_document] 
table and in all document versions in the Multi Provider Document Version 
[mp_document_version] table.

Restore 
Document 
Version

Restore the document to the version in Microsoft OneDrive.

Sync 
Collaborators

Syncs all Microsoft Azure  users into the Multi Provider Collaborators 
[mp_collaborators] table.
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V1 Subflows  (continued)

Subflow Description

If the user is deleted or updated, the user's record in the Multi Provider 
Collaborators [mp_collaborators] table is checked, if it’s present then the record 
is deleted or updated.

If the user is newly added, then it creates an entry in the Multi Provider 
Collaborators [mp_collaborators] table under Multi Provider Documents.

Note: 
The scheduled job with the name Sync Collaborators  triggers the subflow 
for Sync Collaborators. You can choose from the available run a script 
option. The default option is On Demand. The job is run based on the 
set schedule and collaborators are synchronized accordingly. For more 
information, see Automatically run a script of your choosing .

Delete 
Collaborator 
Record

Deletes the specified collaborator record from the Multi Provider Collaborators 
[mp_collaborators] table.

Update 
Document 
Content

Updates the specified document with the provided attachment in Microsoft 
OneDrive  that corresponds to the document ID. The attachment name should 
match the name of the document in Microsoft OneDrive.

Upload Large 
File

Uploads an attachment to Microsoft OneDrive. The maximum size of the file 
can’t exceed 60 MB.

Get Latest 
URL

Gets the latest URL to a document in the Microsoft OneDrive.

Reconnect 
Document 
from 
Microsoft 
OneDrive

Reconnects to a document in Microsoft OneDrive.

Note: 
Before using the subflow, ensure that the corresponding Microsoft 
OneDrive  connection and credential are created and the Microsoft 
OneDrive  authorization token is available.

V2 Subflows

Subflow Description

Get Document Latest URL V2 Gets the latest URL from Microsoft OneDrive 
for the referred document ID.

Update Document Content V2 Updates the specified document with the 
provided attachment content in Microsoft 
OneDrive  corresponding to the document ID 
from table Multi Provider Document sys_id. 
The attachment name should match with the 
name of the document in Microsoft OneDrive.

Collaborate Document V2 Associates a document with a specified 
recipient type.
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V2 Subflows  (continued)

Subflow Description

Connect Document From OneDrive Using Path 
V2

Connects the Microsoft OneDrive  document 
that can also be tracked under Multi Provider 
Documents.

Copy OneDrive Document Version V2 Copies the document with the specified 
version from Microsoft OneDrive  to an 
attachment in the ServiceNow  instance.

Create Document V2 Copies the document to Microsoft OneDrive 
and creates a record in the Multi Provider 
Document [mp_document] table and 
the Multi Provider Document Version 
[mp_document_version] table for Multi 
Provider Documents.

Delete Document V2 Deletes the document in Microsoft OneDrive 
and removes its corresponding records in 
the Multi Provider Document [mp_document] 
table and the Multi Provider Document Version 
[mp_document_version] tables.

Delete Document Version V2 Deletes the particular version of the document 
in bothMicrosoft OneDrive  and deletes a 
record in the Multi Provider Document Version 
[mp_document_version] table under Multi 
Provider Documents.

Get All Document Versions V2 Retrieves all the document versions from 
Microsoft OneDrive  and creates or updates 
records in the Multi Provider Document 
Version [mp_document_version] table under 
Multi Provider Documents. This subflow 
supports documents from different sources 
supported by Microsoft OneDrive.

Get Document from OneDrive V2 Copies the document from Microsoft 
OneDrive  to the specified document name. 
It also creates a record in the Multi Provider 
Document [mp_document] table and all its 
versions in the Multi Provider Document 
Version [mp_document_version] table under 
Multi Provider Documents.

Reconnect Document from Microsoft 
OneDrive  V2

Reconnects to a document in the Microsoft 
OneDrive.

Note: 
Before using the subflow, ensure that 
the corresponding Microsoft OneDrive 
connection and credential are created 
and the Microsoft OneDrive  authorization 
token is available.

Restore Document Version V2 Restores the document to the version 
provided in the Microsoft OneDrive.
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V2 Subflows  (continued)

Subflow Description

Sync Collaborators V2 Syncs all Microsoft Azure  users into the 
Collaborators [mp_collaborators] table under 
Multi Provider Documents.

Upload Large File V2 Uploads an attachment to Microsoft OneDrive. 
The maximum size of the file can't exceed 60 
MB.

Remove Document Collaboration Removes collaboration on a Microsoft 
OneDrive  document.

Update Document Collaboration Updates collaboration on a Microsoft 
OneDrive  document.

Note: 
The V2 subflows work only for documents attached to the platform using the Create 
Document V2 or Connect Document V2 subflows.

.

Spoke Actions

The  Microsoft OneDrive  Spoke for Document Services  Framework  provides sample actions to 
automate Document Services  tasks when events occur in ServiceNow. The following table lists 
the available sample actions.

Action Description

Delete 
Collaborator 
Record

Deletes the specified collaborator record from the Multi Provider 
Collaborators [mp_collaborators] table.

Delete document Deletes the document record from the Multi Provider Document 
[mp_document] table.

Delete document 
and versions

Deletes the specified document and all of its versions from the Multi 
Provider Document Version [mp_document_version] table.

Delete document 
version

Deletes specified versions of a document from the Multi Provider 
Document Version [mp_document_version] table.

Delete versions of 
document

Deletes all versions of a specified document.

Look up Target 
Record Existence

Checks for the existence of a target record in the specified target table.

Look Up Files and 
Folders

Retrieves the list of files and folders under the given Folder ID for the 
selected Source and Source ID. If no source is selected, then it lists the 
contents of the root folder by default.

Look up Sites 
Based On Query 
String Stream

Lists all the sites satisfying the specified query string.

Update Delta 
Token

Updates the system property deltaToken  with the specified delta token.
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Connection and credential alias requirements

Integration Hub  uses aliases to manage connection and credential information. Using an alias 
eliminates the need to configure multiple credentials and connection information profiles when 
using multiple environments. If the connection or credential information changes, you don't 
need to update any actions that use the connection. For more information, see Connections and 
Credentials .

For information about setting up the spoke, see  .

Setup Microsoft OneDrive  for Document Services

Integrate the ServiceNow  instance and Microsoft OneDrive  for Document Services  by creating a 
custom OAuth application in Document Services  to authenticate ServiceNow  requests.

Before you begin

• Request an Integration Hub  subscription.

• Set up and connect Microsoft Azure AD  Spoke, see Set up Microsoft Entra ID spoke  and .

Microsoft OneDrive  requirements:

• Microsoft OneDrive  account

• Microsoft Azure  account

• Microsoft OneDrive  tenant administrator credentials

Role required: admin

About this task
Complete these steps from your Azure  Developer account. See the Azure  product 
documentation for instructions on creating and configuring custom applications.

Procedure

1. Log in to the Microsoft Azure  registration portal with your organization credentials.
For more information, see the Microsoft  documentation on the Microsoft Azure App 
registration portal .

2. Register a new custom application.

a. Provide the application name and the supported account type.

b. Select Register.

c. Enter the redirect URL in the following format: https://<instance>.service-
now.com/oauth_redirect.do.

An overview of the application's basic information is Displayed.

3. Copy the application ID to a text file.
You will use this ID and the client secret generated in the next step to register the app as a 
third-party OAuth provider on your ServiceNow  instance. The application ID is the client ID 
when you connect the application to your ServiceNow  instance.

4. Add a client secret.

a. In Microsoft Azure, navigate to Manage  > Certificates & secrets.

b. Provide a description and an expiration date.

c. Select Add.

5. Enable the permissions you want the application to support.
For more information, see the Microsoft Graph permissions reference  documentation.
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a. In Microsoft Azure, navigate to Manage  > API permissions.

b. Click the Microsoft Graph tile.

c. Select the delegated or application permissions that the application supports.

Delegated permissions enable the application to access the API as a signed-in user.

Application permissions enable the application to run as a background service or daemon 
without a signed-in user.

You must mention these API permissions in the OAuth Entity scopes  tab while configuring 
the application registry.

d. Ensure that required API permissions are provided for your custom app.

Name OAuth scope

Files.Read Files.Read

Files.Read.All Files.Read.All

offline_access offline_access

Files.ReadWrite Files.ReadWrite

Files.ReadWrite.All Files.ReadWrite.All

AuditLog.Read.All AuditLog.Read.All

Directory.AccessAsUser.All Directory.AccessAsUser.All

Directory.Read.All Directory.Read.All

User.Read User.Read

e. Select Add permissions.

Register Microsoft OneDrive  as an OAuth provider for Document Services

Use the information generated during Microsoft OneDrive  account configuration to register 
Microsoft OneDrive  as an OAuth provider and allow the instance to request OAuth 2.0 tokens.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System OAuth  > Application Registry.

2. Select New.

3. On the screen titled What kind of OAuth application, select Connect to a third-party OAuth 
Provider.

4. On the form, fill in the fields.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3195



Application Registries form

Field Value required

Name Name to uniquely identify the record.

Client ID Application ID of the OneDrive application 
you created in Microsoft Azure.

Client Secret The Client Secret you generated when you 
created the application in Microsoft Azure.

Default Grant type This value should be Authorization Code.

Authorization URL
https://
login.microsoftonline.com/
common/oauth2/v2.0/authorize

Note that you have to unlock this field and 
then lock it again.

Token URL
https://
login.microsoftonline.com/
common/oauth2/v2.0/token

Note that you have to unlock this field and 
then lock it again.

Redirect URL
https://<instance>.service-
now.com/oauth_redirect.do

Note that you have to unlock this field and 
then lock it again.

5. Right-click in the form header and select Save.
An OAuth Entity Profile record is created.

6. In the OAuth Entity Scopes related list, add scopes to match the permissions you defined 
when you configured the Microsoft OneDrive  application.

a. Select Insert a new row.

b. Enter the name and the OAuth scope of the permission, which for these Document Services 
scopes are the same for both values.

▪ Files.Read

▪ Files.Read.All

▪ offline_access

▪ Files.ReadWrite

▪ Files.ReadWrite.All

7. Right-click in the form header and select Save.

8. Select Update.
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Result
The system validates the OAuth credentials.

Google Drive  integration with Document Services

Use Google Drive  to manage and sync your documents, and get version actions on documents 
directly in your ServiceNow  instance. You can also collaborate on documents and manage 
attachments hosted within Google Drive.

Benefits of Google Drive  integration

Increase collaboration by integrating Google Drive  with your ServiceNow  instance.

With the Google Drive  integration, you can do the following:

• Edit, share, copy, and delete documents from Google Drive  to your ServiceNow  instance.

• Edit, share, copy, and delete documents from a ServiceNow  instance to Google Drive.

• Fetch the current version of the document.

• Collaborate for reviewing, approving, or co-authoring documents.

• Integrate with Google Drive  to create, update, and collaborate on documents within the 
platform

Activation information

To integrate Google Drive  with Document Services, install the Multi Provider Document Services 
Framework plugin (com.snc.multiprovider_documents). For more information, see Activate Multi 
Provider Document Services Framework.

Document Services  Framework for Google Drive

Integrate the Document Services  with Google Drive.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Integration Hub  subscription

This spoke requires an Integration Hub subscription. For more information, see Legal schedules - 
IntegrationHub overview .

Supported versions

This Spoke was built for Document Services  Framework V1.0, but may be compatible with Utah 
and later versions.

Key features

Document Services  Framework for Google Drive  enables a flow designer to:

• Upload document to Google Drive

• Collaborate

• Manage versions

• Download documents
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Spoke requirements

• Google Drive Spoke

• Google Directory Spoke

Spoke dependencies

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

• IHUB Spoke Util Pack (com.snc.ihub_spoke_util_pack)

• Multi Provider Document Services  Framework (com.snc.multiprovider_documents)

• Remote Directory Sync (com.snc.remote_directory_sync)

• ServiceNow Flow Designer - Dynamic Inputs (com.glide.hub.dynamic_inputs)

• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)

• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)

Note: 
Some of these plugins are licensable features and require appropriate licenses, if used 
outside the spoke implementation.

Spoke subflows

The Document Services  Framework for Google Drive  provides sample subflows to demonstrate 
automating Google Drive  tasks. To customize a sample subflow, copy it to a new application 
scope. Available sample subflows include:

Subflow Description

Create 
Document Copies the document to Google Drive  and creates a record in Documents table 

with the folder ID and created version in Version table under Multi Provider 
Documents.

Create 
Document 
V1

Copies the document to Google Drive  and creates a record in Documents table 
with shareable folder URL and created version in Version table under Multi 
Provider Document Services Framework  Documents.

Create 
Group

Creates a group as specified in Google Drive  and update the Permission 
Configurations table under Multi Provider Documents.

Add 
Collaborator 
To Group

Given a Group ID from Google Drive, this subflow will add the given collaborator 
as specified by role.

Collaborate 
Document

Adds a permission to a given user, group or domain, or to anyone, for a file. This 
permission is based on a permission type and role and is how collaboration is 
configured in Google Drive. If User  or Group  is selected, the email address is 
required for those users and groups. If Domain  is selected, the domain name 
to create permission for is required. If Anyone  is selected, then anyone has 
permission to the file or folder.

Connect 
Document 
From 

Connects the Google Drive  document using the ID can be tracked under Multi 
Provider Document Services Framework  documents
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Subflow Description

Google 
Drive  Using 
ID

Connect 
Document 
From 
Google 
Drive  V1

Connect the Google Drive  document using the sharable URL for the document 
can be tracked under Multi Provider Document Services Framework  documents.

Copy 
Google 
Drive 
Document 
Version

Copies the document with the given version from Google Drive  to attachment in 
ServiceNow.

Delete 
Document

Deletes the document in Google Drive  and remove its corresponding records in 
documents and versions tables.

Delete 
Document 
Version

Deletes the document in Google Drive  and remove its corresponding records in 
documents and version tables.

Get All 
Document 
Versions

Gets all the document versions from Google Drive  and creates or updates 
records in Versions table under Multi Provider Documents.

Get 
Document 
From 
Google 
Drive

Copies the document from Google Drive  to the Document Name referred by 
creating a record in documents table and all its versions in Versions table under 
Multi Provider Documents.

Get 
Document 
Latest URL

Constructs the web view URL and web edit URL for the file without verifying if the 
file actually exists in Google Drive. Consuming APIs are required to verify if the 
file is present or not.

Get Oldest 
Document 
Version

Returns the oldest version of the document.

Reconnect 
Document 
From 
Google 
Drive

Reconnects the Google Drive  document that can be tracked under Multi Provider 
Documents.

Sync 
Collaborator

Syncs all Google Drive  users in a domain with the Collaborators table under Multi 
Provider Documents.

Update 
Document 
Content

Updates the document with the attached content in Google Drive  corresponding 
with the document ID from table Multi Provider Documents sys_id.

Spoke actions

The Document Services  Framework for Google Drive  provides actions to automate Document 
Services  tasks when events occurs in your ServiceNow  instance. Available actions include:
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Action Description

Delete document and 
versions

Deletes the specified document along with versions from Multi 
Provider document and versions table.

Look Up Incremental 
Files and Folders

Returns a list of Google Drive  files and folders under the given folder 
ID.

Look Up Files and 
Folders Stream

Retrieves the list of files and folders under the given folder.

Copy File Revision as 
Attachment

Copies the given Revision ID for a File ID to any record in 
ServiceNow.

Delete document version Deletes the specified versions of a document from Multi Provider 
document versions table.

Look Up Target Record 
Existence

Checks for the existence of the target record in the specified target 
table.

Connection and credential alias requirements

Integration Hub  uses aliases to manage connection and credential information, and OAuth 
credentials. Using an alias eliminates the need to configure multiple credentials and connection 
information profiles when using multiple environments. If the connection or credential 
information changes, you don't need to update any actions that use the connection.

For information about setting up the spoke, see  Set up Document Services framework for Google 
Drive.

Set up Document Services  framework for Google Drive

Integrate a ServiceNow  instance and Google Drive spoke  for Google Drive  by using Google Drive 
credentials to authenticate ServiceNow  requests.

Before you begin
Request a Integration Hub  subscription. For more information, see Legal schedules - 
IntegrationHub overview .

Role required: admin

Procedure

1. Set up and connect Google Drive  Spoke.
For more information, see Set up Google Drive spoke .

2. Set up and connect Google  Directory Spoke.
For more information, see Google Directory Spoke .

3. Activate Document Services  for Google Drive  Spoke.
For more information, see Document Services Framework for Google Drive.

Knowledge Management
The ServiceNow®  Knowledge Management  (KM) application enables the sharing of information 
in knowledge bases. These knowledge bases contain articles that provide users with information 
such as self-help, troubleshooting, and task resolution.
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Get started

Explore

Explore Knowledge 
Management

Configure

Plan and configure your 
Knowledge Management

implementation

Use Knowledge 
Management

Search and find 
information on self-

help, troubleshooting, 
and task resolution

Create and 
maintain articles

Create and maintain 
articles in the 

knowledge base

Knowledge 
Management Reference

Additional information to 
configure and administer 
Knowledge Management

Analytics and 
Reporting Solutions

Platform Analytics 
Solutions and Demand 
Insights dashboards to 
improve your business 

processes and practices

Troubleshoot and get help

• Ask or answer questions about Knowledge Management  and review getting started 
recommendations and more in the ServiceNow Community

• View the Knowledge Management  Process Guide on Now Create

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support

Exploring Knowledge Management

Learn more about Knowledge Management  with a sample workflow and review the benefits it can 
provide for different users in your organization.

Knowledge Management  overview

Knowledge Management  supports processes for creating, categorizing, reviewing, and 
approving articles. Users can search and browse articles as well as provide feedback.

To support multiple groups, knowledge bases can be assigned to individual managers. Separate 
workflows can be used for publishing and retiring articles, and separate access controls can be 
used to control reading and contributing.
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Knowledge Management  workflow

This infographic shows a sample end-to-end workflow of how different users in an organization 
work together to create, share, use, and manage articles.

Knowledge Management

In this workflow:

1. The knowledge user needs a new or updated knowledge article and requests it.

2. The knowledge contributor creates or updates an article and then submits it for review.

3. The knowledge manager reviews the article and either publishes it or sends it back to the 
knowledge contributor for revisions.

4. The knowledge user reads and shares the article. In parallel, a knowledge manager 
continuously reviews articles to determine their relevancy.

5. The knowledge manager marks articles that are no longer needed for retirement.

6. A knowledge manager reviews and approves or rejects the article retirement.

Knowledge Management  benefits

Benefit Feature Users

Create a consistent structure 
for knowledge articles

Knowledge article templates Knowledge manager

Create multiple knowledge 
bases for different groups 
within your organization

Knowledge bases Knowledge administrator and 
manager

Create a category structure 
for each knowledge base with 
any number of levels

Knowledge article categories Knowledge manager
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Benefit Feature Users

Define permissions per 
knowledge base

User criteria, Scoped 
knowledge bases

Knowledge administrator and 
manager

Integrate with and search 
external knowledge sources

External content integration 
feature  and Indexing and 
searching external content in 
AI Search

Administrator

Create knowledge articles 
using generative AI

Now Assist in Knowledge 
Management

Knowledge contributor

Import Word documents into 
knowledge articles and/or 
author knowledge in Word

Knowledge Management - 
Add-in for Microsoft Word, 
Word document importing

Knowledge contributor

Subscribe to relevant articles Knowledge subscriptions Knowledge user

Provide feedback and rate 
articles

Feedback and ratings Knowledge user

Maintain a high quality of 
content and enable constant 
improvement

Article quality index (AQI) Knowledge administrator 
(creates AQI), knowledge 
coach or domain expert 
(performs AQI reviews)

Identify knowledge gaps and 
improve the content of your 
knowledge base

Knowledge demand insights Knowledge manager or 
domain expert

Determine the usage of 
knowledge content and 
confirm that the proper 
processes and procedures 
are being followed for content 
creation

Knowledge Management 
Platform Analytics Solutions

Knowledge manager

Sitemap Generator  for the Knowledge  Portal

The ServiceNow®  Sitemap Generator  application enables you to efficiently define and 
automatically generate XML sitemaps.

Sitemap Generator  configuration requirements for the Knowledge  Portal

The sitemap is generated from a script or static XML. Validating sitemaps isn't handled 
automatically, so verify when creating a sitemap that its contents meet the following 
requirements:

• Includes only the knowledge base configured for the Knowledge  Portal

• Includes only Knowledge  Portal pages with unauthenticated user access

• Excludes Knowledge  Portal URLs that aren't publicly accessible

• Excludes pages that respond with a 301 redirect

• Excluded retired and expired knowledge base articles

For information about sitemap requirements for search engine optimization (SEO), see Build and 
submit a sitemap  in the Google  documentation.
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I18N - Knowledge internationalization

The optional knowledge internationalization features enable knowledge users to view articles in 
multiple languages.

Beginning with the San Diego release, the I18N: Knowledge Management Internationalization 
v2 (com.glideapp.knowledge.i18n2) plugin is installed when any language pack is activated. 
In versions prior to San Diego, this plugin was installed along with the Internationalization 
(com.glide.i18n) plugin.

Knowledge internationalization enables the knowledge management team to create language-
specific knowledge articles and keep translations of the same article related to each other so 
they are easy to manage. Users can view and search within their own language while still being 
able to view articles in other languages when necessary.

Set a custom language for the article

Beginning with the San Diego release, users with elevated privileges can add a custom language 
by adding language entries in the Choice [sys_choice] table to display the selected article in 
multiple languages. On the article page, the Language  list shows all the languages for which the 
article language translation is available.

Set the search language for articles

You can set the default language for searching articles to a language different 
from the logged-in language by specifying the language as the value of the 
glide.knowman.search.default_language  system property. For example, if French is 
the logged-in language and you want to set English as the default language for searched articles, 
specify English in the system property. You can also switch to French in the UI to see the French 
articles. If the system property is not set, the logged-in language of the user is set as the default 
article language. For more information, see Other knowledge properties.

To enable search for different languages simultaneously, navigate to Knowledge Administration 
> Knowledge Search  > Properties  > Enable multi language search  and select the Yes  check 
box. For information about performing a search on all available languages simultaneously, see 
Search using Knowledge Management v3.

Note: 
If the glide.knowman.search.default_language  system property is inactive, 
you can search one language at a time. If the property is enabled, you can search for 
multiple languages simultaneously.

Scoped knowledge bases

To protect knowledge bases containing sensitive articles, use a scoped knowledge base. Even 
system administrators and knowledge administrators can't administer scoped knowledge bases 
unless explicitly authorized through user criteria.

For example, say you have a knowledge article with sensitive payroll information that should 
be seen only by the Payroll department and not by a system administrator or knowledge 
administrator. You could create a knowledge article with the sensitive information in a scoped 
knowledge base within the Human Resources: Core application.

Only users with the admin role of an application and the knowledge_admin role can administer 
a scoped knowledge base. You control access to knowledge bases of an application with 
application administration enabled, such as HR, through the ACLs of the knowledge tables 
in the application instead of global ACLs. To define access to a scoped knowledge base, 
specify appropriate user criteria for users, including system administrators and knowledge 
administrators.
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Note: 
For Scope Master tables to derive scope and execute scoped ACLS, you must set the 
glide.enforce_security_scope.<scope_name>  system property to true.

You can't modify the scope of existing knowledge bases. They remain in the global scope. 
However, you can create a scoped knowledge base to protect sensitive knowledge articles.

To create a scoped knowledge base for an application, in addition to the knowledge_admin or 
admin role, you must have access to view and select that application in the application picker 
(see Application picker ). For example, before you create a knowledge base in the Human 
Resources: Core application, you must select the Human Resources: Core application in the 
application picker, and then create the knowledge base. Then, when you create a knowledge 
base, on the Knowledge base form, the application scope of the knowledge base is set in the 
Application  field.

Related topics

Create a knowledge base

Select an application from the application picker

Application administration

Control access at the knowledge base level through user criteria

Machine learning solutions for Knowledge Management

Machine learning in Knowledge Management  helps improve knowledge governance and quality 
of your knowledge base.

Machine learning in Knowledge Management  has the following benefits:

• Improves the quality of your knowledge base by avoiding duplicate articles and makes the 
knowledge base more Knowledge-Centred Service (KCS) compliant.

• Suggests related articles to help you solve an issue or resolve a question.

• Identifies knowledge gaps and improves content of your knowledge base using the Knowledge 
Demand Insights feature.

Predictive Intelligence  for Knowledge Management

The Predictive Intelligence  for Knowledge Management  capability uses machine-learning 
algorithms to provide various Knowledge Management  capabilities, such as similar articles and 
knowledge demand insights.

Solution definitions for Predictive Intelligence  for Knowledge Management

The solution definitions for Predictive Intelligence  for Knowledge Management 
capability are available in the Predictive Intelligence for Knowledge Management plugin 
(com.snc.knowledge_ml). For more information about the plugin, see Additional plugins for 
Knowledge Management.

Solution definition and solution type

Solution Definition Solution Type Description

Knowledge Similar Articles Similarity Suggests related articles 
based on the short 
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Solution definition and solution type  (continued)

Solution Definition Solution Type Description

Note: 
This solution definition is 
available as a template 
on instances where 
both the Predictive 
Intelligence for 
Contextual Search plugin 
(com.snc.contextual_search_ml) 
and Predictive 
Intelligence 
for Knowledge 
Management plugin 
(com.snc.knowledge_ml) 
are activated.

description of articles. You can 
see the results in the following 
places:

• The Knowledge results 
section on the Knowledge 
form when creating an 
article in the Knowledge 
Management  Service Portal.

If the Knowledge results 
section isn't displayed on 
the Knowledge form, you 
may need to configure the 
form, to add the Contextual 
Search Results  field. 
For more information, 
see Configuring the form 
layout .

• The Related Articles section 
on the knowledge article 
view page in the Knowledge 
Management Service 
Portal and Now Mobile 
applications.

• The Agent assist  in Agent 
Workspace  when the 
Similar Articles (ML)  option 
is selected.

Demand Insights: Case 
Clusters Need Knowledge

Clustering Populates collections of 
closed and resolved customer 
service cases on the Demand 
Insights for Cases dashboard.

Demand Insights: Incident 
Clusters Need Knowledge

Clustering Populates collections of 
closed and resolved incidents 
on the Demand Insights for 
Incidents dashboard.

Demand Insights: Similar 
Cases and Knowledge

Similarity Compares similarity of 
incidents with knowledge 
bases and identifies similar 
closed and resolved customer 
service cases as candidate 
knowledge gaps.

Demand Insights: Similar 
Incidents and Knowledge

Similarity Compares similarity of 
incidents with knowledge 
bases and identifies similar 
closed and resolved incidents 
as candidate knowledge gaps.
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Related topics

Train the similarity solution for Knowledge Management to find related articles

Create a knowledge article in Agent Workspace

Knowledge demand insights

Demand Insights for Cases dashboard

Knowledge article templates

Article templates have pre-defined fields structured in a specific order. These templates help 
create a consistent structure for knowledge articles.

Using the Knowledge Article Templates feature, as a knowledge administrator (a user with 
knowledge_admin role), you can create article templates, add or customize fields in a template, 
and activate or deactivate a template.

As a security administrator (a user with security_admin role), you can configure field-level 
security in any template to make it visible to specific users.

As an author, you can create articles using pre-defined article templates or any newly created 
article templates.

Pre-defined knowledge article templates

Use either the standard template or one of the pre-defined How To, What Is, FAQ or KCS article 
templates.

Note: 

When you upgrade Knowledge Management  to Kingston or later releases, all the existing 
articles from the earlier version automatically use the standard template of the upgraded 
version. For example, if you upgrade Knowledge Management  from Jakarta to Kingston, all 
existing articles use the standard template available in the Kingston version.

All pre-defined templates are inactive by default. If you do not activate a template, the 
articles automatically use the standard template. As a knowledge admin, you can activate 
a template by navigating to Knowledge  > Administration  > Article Templates. Then in the 
article template list, set the Active  field to true for one or more templates you would like to 
activate.

Templates are associated with knowledge bases. Only templates which are active and 
associated with a knowledge base are shown.

The template structure is stored in kb_article_template while the fields for each template are 
stored in kb_article_template_definition. For creating and manipulating templates navigate to 
Knowledge  > Article Templates.

The table below lists the fields available in each template and the name of the template table.

Pre-defined knowledge article templates

Template name Template fields Maps to table SEO Description Tag

FAQ • Question

• Answer

FAQ [kb_template_faq] Question
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Pre-defined knowledge article templates  (continued)

Template name Template fields Maps to table SEO Description Tag

How To • Introduction

• Instructions

How To [kb_template_how_to] Introduction

What Is • Introduction

• Explanation

What Is 
[kb_template_what_is]

Introduction

KCS Article • Issue

• Environment

• Cause

• Resolution

KCS Article 
[kb_template_kcs_article]

Issue

Standard Text kb_knowledge Text

Activating knowledge article templates

The Knowledge Article Templates feature is activated with the Knowledge Management 
Advanced (com.snc.knowledge_advanced) plugin. After the feature is activated, when creating 
an article, option to choose a template for the article appears. For details, see Activate the 
Knowledge Management Advanced plugin.

Deactivating knowledge article templates

You cannot delete an article template because article templates have an associated child table. 
Deleting a template would also require deleting the child table. Due to the limitations on dropping 
tables, article templates and template columns are explicitly made non-deletable. Instead, you 
can disable the Knowledge Article Templates feature by clearing the Active  check box on the 
Article Template form.

Note: 
The Standard template is available by default and can’t be made inactive.

Related topics

Configure knowledge article templates

Knowledge blocks

Simplify knowledge authoring for writers and knowledge consumption for readers with 
knowledge blocks. Knowledge blocks are reusable pieces of content secured by user criteria that 
you can add to knowledge articles in a knowledge base. The user criteria controls which users 
can read or not read the block content in an article or search, enabling users to more easily view 
content that is relevant to them.

Knowledge blocks are available for use in ServiceNow AI Platform  only.

How to use knowledge blocks

To use knowledge blocks, a knowledge administrator or manager must enable the knowledge 
blocks feature for each knowledge base in which the blocks will be used.
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Enable knowledge blocks for each knowledge base

Knowledge contributors can create knowledge blocks and insert them into articles in a 
knowledge base:

Note: 
Knowledge blocks are not supported in articles of type wiki. By default, knowledge block 
doesn't show files attached to it. However, you can see images and text are visible on KB's 
created from block files.

• Create a knowledge block

• Add knowledge blocks to a knowledge article

• Preview a knowledge article with knowledge blocks by user or date

Knowledge block content can be read or not read in an article or search based on user criteria 
set at the knowledge base and knowledge block level. See Select user criteria for a knowledge 
block  for more information.

Example: Holiday calendar with location-specific knowledge block content

You are part of an enterprise HR organization that maintains a company knowledge base. You 
want to create a holiday calendar so that employees know which days of the year are company 
holidays. Since the company has multiple locations and holiday dates vary based on where the 
employee is located, there are several ways that you could create the knowledge article.

One way is that you could create a knowledge article for each location, with an article for 
Location A, Location B, and so on.

• Pros: simplified consumption. Employees have a single article to search for and read.

• Cons: more work for HR. HR has multiple articles to manage and update for each location 
where the company has employees.

Another way is that you could create a single knowledge article that includes sections for each 
location.

• Pros: simplified authoring. HR has a single article to manage and update.

• Cons: more work for employees. Employee must scroll through and disregard extraneous 
content to find the section in the article that pertains to them.

With knowledge blocks, you can create a single knowledge article with location-specific block 
content secured by user criteria. This approach helps to reduce the workload for both HR and 
employees. As an HR agent, you have a single article to manage and update. Employees have a 
single article to search for and read, with the user criteria ensuring that they only view content 
that is relevant to them.

If you are using a custom search or knowledge article viewer

If you are using a custom search or knowledge article viewer with your application, you should 
integrate it with the appropriate knowledge or knowledge blocks API. (Integration is only 
necessary if you are using a custom search or knowledge article viewer.)

Integrating a custom search or knowledge article viewer with knowledge blocks
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Activation information

To use knowledge blocks in your application, you must activate knowledge blocks. For 
information on what components are installed with the feature, see Components installed with 
knowledge blocks.

Note: 
Activating knowledge blocks automatically activates Knowledge Management Advanced, 
which enables advanced features such as article versioning. Knowledge blocks can be 
used with or without the article versioning feature. To disable the feature, see Disable the 
article versioning feature.

Knowledge subscriptions

Subscribe to knowledge bases and knowledge articles to receive email notifications about new 
articles and article revisions or comments.

• Subscribed to a knowledge base:

◦ Knowledge base owners are auto-subscribed to all articles in the knowledge bases they 
own. They receive email notifications when new articles are created or revised (published) in 
the knowledge base.

◦ Users who subscribe to a knowledge base receive email notifications when new articles are 
created in the knowledge base or if the existing articles are revised (published).

• Subscribed to a knowledge article:

◦ Knowledge authors are auto-subscribed to the articles they create. They receive email 
notifications when the articles they created are checked out or revised (published) by other 
authors, and if the articles receive user comments.

◦ Users who subscribe to an article receive email notifications when the article is revised 
(published).

Users can set their Knowledge notification preferences using System Settings. For more 
information, see Managing email notifications in Knowledge Management  and Set knowledge 
notification preferences.

The knowledge subscription feature is available for both the Knowledge Management v3 user 
interface and the Knowledge Management Service Portal.

If the article versioning feature is enabled, the following notifications are also sent:

• An article is checked out

• An article is revised

• A new version of an article is published

Activation information

The knowledge subscriptions feature requires the Knowledge Management Advanced plugin 
(com.snc.knowledge_advanced). For more information, see Configure knowledge subscriptions.

Related topics

Use knowledge subscriptions

Knowledge article version numbers

Article versioning
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Knowledge demand insights

Identify knowledge gaps and improve content of your knowledge base using the Knowledge 
Demand Insights feature.

The Knowledge Demand Insights feature automates the discovery of knowledge gaps in your 
knowledge bases. Knowledge gaps are topics on which knowledge bases are missing knowledge 
articles.

Addressing knowledge gaps has the following benefits:

• Improve effectiveness of self-service: Self-service users get more relevant information for 
research, troubleshooting, and how to queries.

• Increase case or incident resolutions: Having relevant information available helps you deflect 
future cases.

• Improved case resolution: Agents can find more relevant knowledge articles to solve cases, 
incidents, problems, and so on.

Activation information

The Knowledge Demand Insights feature requires the Predictive Intelligence for Knowledge 
Management plugin (com.snc.knowledge_ml). For more information, see Predictive Intelligence 
for Knowledge Management  and Additional plugins for Knowledge Management.

Demand insights dashboards

You can use a demand insights dashboard for your tasks to analyze candidate knowledge gaps 
and create knowledge gap feedback tasks. By default, the Knowledge Demand Insights feature 
includes Demand Insights for Incidents, Demand Insights for Cases, and Demand Insights: 
Similar HR Cases and Knowledge  dashboards for incidents, customer service cases, and HR 
cases, respectively. For other tasks, you can create a dashboard. To access a demand insights 
dashboard, you must have read access to the tasks and the sn_km_ml.knowledge_curation_user 
role. For more information, see Analyze knowledge gaps from a demand insights dashboard and 
create knowledge gap feedback tasks.

Related topics

Demand Insights for Cases dashboard

Demand Insights for Incidents dashboard

Demand Insights for HR Cases dashboard

Self-Service Analytics

The Self-Service Analytics  framework enables you to gather information about user activities and 
deflection outcomes related to those activities.

Display the effectiveness of self-service channels by using reports and dashboards based on 
the data generated by the Self-Service Analytics  framework. This Self-Service Analytics  data is 
used by the Self-Service Analytics dashboard for customer service. You can also use the Self-
Service Analytics  framework in dashboards of other applications that use the Subscriptions 
and Activity Feed Framework. For more information, see Self-Service Analytics dashboard for 
customer service .

Analyzing self-service deflection metrics has the following benefits:
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• Measure self-service effectiveness through self-service KPIs.

• Quantify successful self-service engagements to take corrective actions.

• Define custom self-service KPIs tailored to your organization.

Activation information

The Self-Service Analytics  framework requires the Self-Service Analytics Core plugin 
(com.snc.self_service_analytics_core). For more information, see Activate Self-Service Analytics.

Note: 
The data for the Communities and Virtual Agent channels are generated when 
the Communities plugin (com.sn_communities) and Glide Virtual Agent plugin 
(com.glide.cs.chatbot) are activated respectively.

Related topics

Configure Self-Service Analytics

Self-Service Analytics concepts

Platform Analytics Solutions  for Self-Service Analytics for Customer Service

Self-Service Analytics concepts

You can quantify your self-service effectiveness by measuring case deflections.

The Self-Service Analytics  framework enables you to measure case deflection by defining user 
activity patterns for a deflection outcome. A case deflection is when you are able to provide a 
resolution using one of the self-service channels, such as Knowledge, Communities, Catalog, 
and Virtual Agent, to a user who intended to create a case and as a result, no case is created.

By default, the Self-Service Analytics  framework is used by the Self-Service Analytics dashboard 
for customer service. The framework can also be used in dashboards of other applications that 
use the Subscriptions and Activity Feed Framework.

The system includes predefined configurations for the Self-Service Analytics  framework 
components associated with consumers and customer contacts. You can also configure these 
components for other user entities.

Self-service analytics components

Self-service analytics is based on the activity pattern associated with a deflection outcome. It 
consists of the following main components:

• Activity pattern (see Activity pattern components)

• Deflection outcome (see Deflection outcome components)

Activity pattern components

Activity pattern

A combination of pattern element, pattern element group, or both for a user entity 
such as consumers or customer contacts that is linked to an outcome. Each pattern 
element or pattern element group is implemented as regular expressions.

Example: The activity pattern Contacts: Case: Confirmed Deflection is a 
combination of pattern element groups Self-Service: Helpful and Self-service 
actions: Optionally Many.

Deflection outcome
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An activity pattern can lead to a deflection outcome. See Deflection outcome 
components.

Primary activity

The final activity that determines the outcome associated with an activity pattern 
based on whether it happens or not.

Example: For the primary activity Customer created a case if the system does not 
find a match (that is a case was not created), the outcome Confirmed deflection is 
associated with the activity pattern Contacts: Case: Confirmed Deflection.

Pattern element group

A logical combination of two pattern elements, pattern element group, or both and 
how many times the combination occurs. For more information, see Pattern element 
group components.

The following figure illustrates the components of the activity pattern Contacts: Case: Confirmed 
Deflection.

Pattern element group components

Pattern element group

A logical combination of two pattern elements, pattern element group, or both 
and how many times the combination occurs. Each pattern element group is 
implemented as regular expressions.

The occurrence of the logical combination result is one of the following types:

• Once

• Optionally Once

• Optionally Many
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• At Least Once

• Range

Example 1: In the following table, the Knowledge engagements once pattern 
element group is true when it occurs only once and either Article viewed once is 
true or Article marked with positive feedback once is true.

Pattern element group example 1

Pattern element 
group

First 
Element

Second Element​ Operator Occurrence​

Knowledge 
engagements 
once

Article 
viewed 
once

Article marked with 
positive feedback once

Or Once​

Example 2: In the following table, the Self-service engagements optionally many 
pattern group is true when engagements either have not occurred or have occurred 
multiple times and either the Knowledge or catalog engagements once is true or the 
Communities or virtual agent engagements once is true.

Pattern element group example 2

Pattern element 
group

First Element Second Element​ Operator Occurrence​

Knowledge 
or catalog 
engagements once

Knowledge 
engagements 
once

Catalog 
engagements once

Or Once

Communities 
or virtual agent 
engagements once

Communities 
once

Virtual agent 
engagements once

Or Once

Self-service 
engagements 
optionally many

Knowledge 
or catalog 
engagements 
once

Communities 
or virtual agent 
engagements once

Or Optionally 
Many

Pattern element

Denotes a single activity type and how many times it occurs. Each pattern element 
is implemented as regular expressions.

Example: The pattern element Article viewed once denotes that the activity Viewed 
a knowledge article must occur once.

Activity type

An action that a user (consumer or customer contact) performs.

Example: The activity type Viewed knowledge article occurs when a user views a 
knowledge article.

The following figure illustrates the components of the pattern element group Knowledge 
engagements once.
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Activity context components

Activity context

A collection of activity groups a user might perform such as Catalog, Knowledge, 
Case, Communities, and Virtual Agent.

Example: The activity context Contact is a collection of activity groups Catalog, 
Knowledge, Case, Communities, and Virtual Agent associated with the customer 
contact.

Activity group

A logical grouping of activity types performed on the same object type such as a 
knowledge article, community answer, or customer service case.

Example: The activity group Knowledge is a logical grouping of the activities Viewed 
knowledge article and Marked the article helpful performed on a knowledge article.

Activity context group

An activity group that has been added to a context.

The following figure illustrates the components of the activity context Contact.
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Deflection outcome components

Deflection outcome

In the context of deflection, an activity pattern can lead to one of the following three 
outcomes:

Confirmed deflection

The self-service content definitely prevented a case from getting 
created.

Potential deflection

The self-service content was viewed and no case was created, but it's 
unclear whether the content is the factor that prevented the case from 
getting created.

No deflection

A case was created after the self-service content was viewed.

Deflection configuration

Associates a window (duration) with an activity context. The window defines how 
long a system will wait for a case to be created to match with a deflection pattern.

Example: To track the create case activity for a consumer within a day, set the 
window as 1 day.

• If the consumer created a case within that window, the deflection pattern 
matched is a No deflection.

• If the consumer did not create a case within that window, the deflection pattern 
matched is a Potential deflection.

• If the consumer did not create a case and the last activity is submitted positive 
feedback for any self-service channel content within that window, the deflection 
pattern matched is a Confirmed deflection.

Deflection metrics

A transactional table that stores the outcome of matched patterns. By default, the 
scheduled job for Self-Service Analytics captures data and stores the generated 
data in the Deflection Metric [ssa_deflection_metric] table.

Deflection pattern

Associates deflection configuration with an activity pattern. A deflection pattern is 
implemented as a table.
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Related topics

Configure Self-Service Analytics

Translation management

Knowledge articles are authored and published in many languages and translating these articles 
to languages other than the language they are authored in requires creating translation tasks. 
Translation management enables you to manage these translation tasks.

The translation management feature enables the following translation activities:

• Translate published knowledge articles that are missing translations manually or use the 
machine translation option to automatically translate them.

• Create translation tasks automatically for specified languages.

• Configure assignment rules and auto-assigned tasks for a language, knowledge base, or 
category to a translator or a group of translators.

For information about activating translation management, see Activate translation management.

Enabling the glide.knowman.translation.enable_translation_task  property 
adds the following menu options to the Translation Management submenu under the Knowledge 
menu:

• All Open Tasks

• My Assigned Tasks

• Translator Mapping

You can choose a default language when you log in to an instance. The available languages are 
based on the internationalization language plugins you have installed.

Related topics

Translate a knowledge article from a translation task

I18N - Knowledge internationalization

Activate the knowledge management internationalization plugin

Knowledge-Centered Service configuration

Knowledge-Centered Service (KCS) is a method for the creation and continuous improvement of 
knowledge based on the experience of agents and the patterns observed by knowledge reuse.

ServiceNow  Knowledge Management  is a KCS (V6) verified product. As a KCS (V6) verified 
product, Knowledge Management  provides features to improve knowledge, such as article 
quality reviews, in-context knowledge capture, and feedback management.

Visit the following page on the ServiceNow Community  for information about getting started with 
Knowledge Management  and KCS: Knowledge Management Getting Started .

Activation information

The Knowledge-Centered Service configuration is activated with the Knowledge Management 
KCS Capabilities plugin (com.snc.knowledge_kcs_capabilities). For more information, see 
Activate Knowledge Management KCS Capabilities.

Related topics

Managing KCS article states
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Article quality index for knowledge management

Assess the quality of knowledge articles with the article quality index (AQI). The AQI helps 
maintain consistent quality of knowledge articles attached to a knowledge base where articles 
are written by various authors.

Using AQI feature, a knowledge administrator (a user with knowledge_admin role) creates 
a checklist and adds a set of true or false questions to the checklist to assess the quality of 
knowledge articles. For each question, the knowledge_administrator assigns a weight based on 
its importance to the quality measurement and then attaches the checklist to a knowledge base.

A knowledge reviewer (a user with knowledge_coach and knowledge_domain_expert role) 
performs AQI review on knowledge articles attached to the knowledge base by answering the 
true or false questions in the checklist. The article quality is then scored based on the cumulative 
weight of all answers set to true in the checklist.

The average AQI scoring is displayed on the Content Quality tab of the Knowledge Management 
dashboard (see Knowledge Management dashboard).

Activating article quality index

The article quality index feature is activated with the Knowledge Management Advanced 
(com.snc.knowledge_advanced) plugin. For details see, Activate the Knowledge Management 
Advanced plugin.

Related topics

Use Article Quality Index

Article versioning

Use the Knowledge Management article versioning feature to create and maintain multiple 
versions of a knowledge article.

Knowledge contributors can create a new version of a knowledge article from an existing 
published version. This existing version can be either the latest published version or an older 
outdated version. All changes are stored in the new version of the article and the information in 
the existing article remains the same.

If you import published knowledge articles from a ServiceNow  instance that does not support 
article versioning, you must run the Initialize Versions on Articles  fix script to 
enable article checkout and editing.

With the article versioning feature, a knowledge user can:

• Check out a published article and create another version.

Note: 
Only an author (who checks out an article for revision), knowledge base owner, and user 
with knowledge_admin role can edit an article in the draft state.

• Select a previously published (outdated) version of an article and make it current.

• Recall an article that is being reviewed or scheduled for publication.

• Retire the latest published version of an article.

Note: 
Only an author (who checks out an article for revision), knowledge base owner, and user 
with knowledge_admin role can edit an article in the draft state.
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There are two types of article revisions: major and minor. Minor revisions include updates to 
an article that has not yet been published. Major revisions include updates to an article that 
has been published and is available to customers. To track the different revisions, the article 
versioning feature introduces version numbering. For more information, see Knowledge article 
version numbers

With the article versioning feature, the knowledge article number also includes the version 
number. All references to knowledge articles use this number format. For example, KB0010003 
v2.0. To access all the versions of knowledge article, navigate to All  > Knowledge  > Articles  > All 
and open article with multiple versions. In the Related list, you can access all the versions.

Versioning control

Activation information

The article versioning feature requires the Knowledge Management 
Advanced plugin (com.snc.knowledge_advanced) to be activated and the 
glide.knowman.versioning.enabled  property to be set to true (default value). For more 
information, see Activate the Knowledge Management Advanced plugin  and Article versioning 
properties.

Related topics

Use article versioning

Knowledge Management FAQ

Ownership groups

Configure ownership groups and associate them with knowledge articles to maintain article 
quality, manage approvals, and for timely resolution of feedback.

For the ease of maintenance of knowledge articles, you can assign an ownership group to 
a knowledge article and shift the ownership of an article from a single person to a group. An 
ownership group consists of a group of members and a manager who are responsible for 
knowledge articles. Responsibilities include: approving knowledge articles, performing AQI 
checks to ensuring article quality, and managing feedback tasks for knowledge articles.

When a knowledge article is assigned to an ownership group:

• Only ownership group members have contribute access to the article even if they don't have 
contribute access to the knowledge base of the article. They can edit, approve, publish, and 
retire the knowledge article with which they are associated.

• Users who aren't a member of the ownership group can't contribute to the article even if they 
have contribute access to the knowledge base of the article.
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When Create a knowledge article from an incident in ITSM Agent Workspace  or editing  a 
knowledge article, you may need to configure the Knowledge form to add the Ownership Group 
field.

Activation information

To enable the use of ownership groups, enable the 
glide.knowman.ownership_group.enabled  property. This property is available when 
the Knowledge Management Advanced plugin (com.snc.knowledge_advanced) is activated. By 
default, the property is disabled.

Note: 
If you use ownership groups, try not to disable the 
glide.knowman.ownership_group.enabled  property later. If you must disable 
the property later, ensure that you manually reassign all knowledge articles associated with 
any ownership group, close all article approvals sent to ownership groups, and resolve all 
open feedback tasks assigned to ownership groups.

Contribute access to published articles

If an ownership group is associated with a knowledge article, the author or reviser of the article 
can't contribute to the article after the article is published. You can override this behavior by 
enabling the glide.knowman.ownership_group.override  property. When the 
property is set to true, the authors or revisers of knowledge articles associated with ownership 
groups retain contribute access to their published articles. By default, the property is set to false.

Approval of self-authored articles for ownership group members

With an ownership group associated with a knowledge article, ownership group members can 
approve self-authored articles for publication. You can override this behavior by disabling the 
glide.knowman.ownership_group.allow_self_approval  property. By default, 
the property is set to true. When the property is set to false, ownership group members can't 
approve self-authored knowledge articles.

Related topics

Manage ownership groups

Knowledge Management properties

Automating feedback management to improve content

Manage high volumes of article feedback by enabling task generation for negative feedback. 
When an article is rated poorly or marked as unhelpful, a feedback task is generated.

If an ownership group is assigned to the article, the feedback task is assigned to the manager of 
the ownership group. Ownership group managers can reassign tasks to another group member, 
or group members can assign a feedback task to themselves.

If no ownership group is assigned to the article, the feedback task is assigned to the author or 
reviser of the article.

The task assignee can update the article, create a new article, request additional feedback, or 
reassign the task and receives notification after the feedback is updated or resolved.
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Note: 
The actionable feedback feature is available in the Knowledge Management Service Portal 
and Agent Workspace. To use the actionable feedback feature in other service portals, you 
can activate the Knowledge Article View  page route map.

Beginning with New York, the Knowledge Article View  page route map is activated 
by default. Existing customers on release versions prior to New York can activate the 
Knowledge Article View  page route map. For more information, see Activate the 
Knowledge Article View page on upgrade .

Related topics

Enable actionable knowledge feedback

Work on a feedback task

Track the progress on a feedback task

Migrate to Knowledge Management  v3

When you migrate to Knowledge Management v3 from v2, you must migrate legacy knowledge 
content and any customizations you have made to the Knowledge Base applications.

The following video provides more information on how to migrate from Knowledge Management 
v2 to v3.

Migrating from Knowledge Management v2 to v3

Knowledge Management  v3 migration process

When you upgrade from knowledge v2, consider a multi-step migration process. This process 
ensures you can access existing knowledge content and allows you to fully migrate at your own 
pace.

Review automatic changes before upgrading. These changes are applied immediately when 
upgrading and may impact existing functionality.

1. Migrate knowledge functionality to use your customized functionality with the Knowledge 
Management  v3 enhancements.

2. Migrate knowledge content to use the Knowledge Management  v3 enhancements with your 
existing knowledge articles.

Configuring Knowledge Management

Plan and configure your Knowledge Management  implementation.

Configuration overview

Visit the following page on the ServiceNow Community  for information on setting up Knowledge 
Management: Knowledge Management Getting Started .

You can also use Knowledge Management  capabilities within a website built on Adobe 
Experience Manager (AEM). For more information, see Integration with Adobe Experience 
Manager .

Using guided setup to implement Knowledge Management

Guided setup provides a sequence of tasks that help you configure Knowledge Management 
on your instance. To open guided setup for Knowledge Management, navigate to Knowledge  > 
Administration  > Guided Setup. For more information, see Using guided setup .
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Activate the Knowledge Management Advanced plugin

Activate the Knowledge Management Advanced plugin (com.snc.knowledge_advanced) to 
enable advanced features for Knowledge Management.

Before you begin
Role required: admin

About this task
The Knowledge Management  Advanced plugin includes feature code and demo data.

The Knowledge Management  Advanced Installer plugin (com.snc.knowledge_advanced.installer) 
is used to activate the Knowledge Management  Advanced plugin.

Note: 
The Knowledge Management  Advanced plugin is not automatically activated with the 
Knowledge Management v3 application.

The Knowledge Management  Advanced Installer plugin performs two validation steps prior to 
activation.

• Determines if there are any active Knowledge Management  v2 knowledge bases.

• Determines if there is a unique database index on the Number  field. If a unique constraint has 
been added to the Number  field, the plugin activation fails. Follow the instructions listed in 
KB0634959  to perform corrective steps to resolve the issue.

You need access to HI  to be able to view KB articles.

Note: 

Starting with the Washington DC  release, the Knowledge Management  v3 
homepage (com.snc.knowledge3) is being prepared for deprecation in the 
future Y release. It is replaced by the Knowledge Management  Service Portal 
(com.snc.knowledge_serviceportal), which is active by default for customers on Madrid 
and later releases. For more information about the new experience, see Knowledge 
Management Service Portal homepage features.

The Knowledge Management  Advanced plugin activates the following features:

• Article versioning: Enables maintaining multiple versions of a knowledge article. For more 
information, see Article versioning.

Note: 
Migrate to Knowledge Management  v3 completely to use article versioning.

• Article subscriptions: Enables managing knowledge base and knowledge article subscriptions. 
For more information, see Knowledge subscriptions.

Note: 
The Knowledge Management  Advanced plugin activates the Subscriptions and Activity 
Feed Framework plugin (com.snc.activity_subscriptions).

• Article quality index: Enables maintaining consistent quality of knowledge articles within a 
knowledge base where articles are written by various authors. For more information, see Article 
quality index for knowledge management.

• Article templates: Enables creating article templates for consistent structure of knowledge 
articles. For more information, see Knowledge article templates.
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• Ownership group: Enables creating ownership groups for knowledge articles. For more 
information, see Ownership groups.

• In-context article creation: Enables creating a knowledge article from a customer service case. 
For more information, see Enable creating an article from a customer service case.

• Translation management: Enables managing translation tasks created for published 
knowledge articles. For more information, see Translation management.

Demo data is included as part of the Knowledge Management Advanced plugin. If the 
validation step performed by the Knowledge Management Advanced Installer plugin completes 
successfully, the Knowledge Management Advanced plugin is activated automatically. However, 
the demo data is not included in this activation. To load the demo data, go to the Knowledge 
Management Advanced plugin page, click the Load Demo Data Only  related link, and then click 
OK.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.

Note: 
When domain separation and delegated admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .

Knowledge Management setup guide for admins

Before users in your organization can start creating knowledge bases and knowledge articles, 
you must set up Knowledge Management. Work with stakeholders to define requirements for 
setting up Knowledge Management  effectively to meet the needs of users.

Requirements

Role required: admin.

Before you begin

Meet with the stakeholders

Stakeholder Responsibilities

Knowledge 
manager

Defines and oversees the knowledge management processes for 
day-to-day operations related to content publishing and usage.

Knowledge 
admin

Configures advanced settings for specific Knowledge 
Management features

Knowledge 
coach

Enables users to adhere to content standards.
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Stakeholder Responsibilities

Knowledge 
domain expert

Provides domain knowledge expertise.

Version author Contributor to a particular version of an article.

Content 
creators and 
reviewers

Create, review, and update articles in the knowledge bases.

Community 
managers

Focus on the creation and curating of social content.

Line managers Manage teams that create and use knowledge articles

With stakeholders, determine the following requirements

• Who are the consumers of the content in the knowledge bases?

• Who are the writers, editors, and managers for the knowledge base articles?

• What are the required workflows to publish and retire articles?

• What are the unique behaviors required for your knowledge management 
implementation? For example, should attachments appear in search results?

• Do you want to translate knowledge articles into other languages?

What to do

Assign knowledge roles to users and groups

Determine which Knowledge Management roles  are appropriate for each user, and 
then assign those roles  .

Create custom Knowledge workflows

If the default knowledge workflows  for publishing and retiring knowledge articles 
are not appropriate for your knowledge bases, create custom workflows  for those 
knowledge bases.

Configure Knowledge properties

If the default knowledge properties  do not fulfill the requirements of users, 
reconfigure the properties as necessary.

Activate support for other languages besides English

If languages other than English must be supported, activate the Knowledge 
Management Internationalization  plugins.

Coordinate with knowledge managers for knowledge base setup

Let knowledge managers and administrators know that they can start configuring 
their knowledge bases. For details, refer them to the Knowledge base setup guide 
for knowledge admins and managers.

Next steps

Depending on any other requirements for the knowledge bases, you may be asked to help with 
additional tasks, such as configuring knowledge landing pages.
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Using guided setup to implement Knowledge Management

Knowledge Management guided setup provides a sequence of tasks that help you configure 
Knowledge Management  on your instance. To open Knowledge Management  guided setup, 
navigate to Knowledge  > Administration  > Guided Setup.

For more information about using the guided setup interface, see Using guided setup .

Knowledge base setup guide for knowledge admins and managers

After basic Knowledge Management  setup is completed, you can set up a knowledge base for 
users to create and publish knowledge articles.

Create multiple knowledge bases for different groups within your organization to share 
information within and between those groups. Create scoped knowledge bases to enable only 
application administrators to administer the knowledge bases and restrict unauthorized access 
to application-specific data.

Administrators create knowledge bases, and assign them to individual managers responsible for 
controlling the behavior and organization scheme of each knowledge base.

Each knowledge base contains knowledge articles that provide information for users, such as 
policy, release notes, or instructions for a task. Each knowledge base can also use a separate 
workflow for publishing and retiring articles.

Requirements

Role required: knowledge_administrator, knowledge_manager, or admin.

Before you begin

Determine the following requirements for each knowledge base that you want to set up:

• Whether to create a scoped knowledge base? For more information, see Scoped 
knowledge bases.

• Who are the knowledge base managers that are responsible for approving 
articles?

• Who are the users and contributors for that knowledge base? Access for these 
users is defined through user criteria.

• What are the categories to be used to classify articles? Will users be able to 
create categories?

• Will users of the knowledge base be able to create new content?

What to do

Set up the knowledge base

1. Create the knowledge base.

2. Set up which users can read, create, or edit knowledge articles by selecting user 
criteria  for the knowledge base.

3. Define the approval process for articles using workflows.

4. Define the knowledge categories  that are needed for organizing articles in the 
knowledge base.

5. If you want a custom knowledge homepage, ask your ServiceNow  administrator to 
create it.
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Next steps

Let users in your organization know that they can start creating and searching articles in the 
knowledge base. For details, refer users to the Knowledge Management guide for users.

If you have the knowledge_manager role, there are many other tasks that you can perform to 
maintain the knowledge base. You can pin articles so they are featured prominently in the search 
results and on landing pages. You can also assign other users as managers of a knowledge base. 
For details, see Configuration tasks for knowledge managers.

Activate the sitemap configuration and definition records for the Knowledge  Portal

Include knowledge articles in your sitemap by activating the sitemap configuration and definition 
records.

Before you begin

• Activate Sitemap Generator

• Verify that an unauthenticated user can access the knowledge base article by accessing it as a 
guest user.

• Verify that the Public option is selected on the Knowledge  Article View form.

Role required: admin

About this task
Beginning with the Washington DC  release, the Sitemap Generator  configuration is available with 
the base system and is inactive by default.

Procedure

1. Navigate to All  > Sitemap Generator  > Sitemap Configuration.

2. In the UX Sitemap Configurations [sys_ux_seo_sitemap_config] table, select the 
sitemap_config_KB record.

3. Enable the generation of sitemaps.

a. On the form, select the Active  check box.

b. In the Sitemap Config Definition related list, double-click the Type  field and select the true 
option from the list.

c. Select the Save icon ( ).

4. Select Update.

Result
All active sitemaps regenerate once in a day and include content from any of their active sitemap 
definitions.

Activate the knowledge management internationalization plugin

To enable translation of knowledge articles, you must activate multiple plugins.

• Knowledge Management Advanced (com.snc.knowledge_advanced) plugin. For more 
information, see Activate the Knowledge Management Advanced plugin

• I18N:Knowledge Management Internationalization Plugin v2 (com.glideapp.knowledge.i18n2) 
plugin. For more information, see Activate a plugin .
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• Internationalization plugins for each appropriate language. For more information, see Activate 
a language .

Note: 

◦ Activating internationalization plugins for the available languages automatically 
activates the I18N: Internationalization plugin (com.glide.i18n) that instead 
activates the I18N: Knowledge Management Internationalization Plugin v2 
(com.glideapp.knowledge.i18n2) plugin.

◦ Beginning with the San Diego  release, you can request ServiceNow  personnel to 
customize your Languages [sys_language] table. You can create translations of 
knowledge articles into any combination of language and region configured in the 
table. These combinations must be in compliance with the Internet Engineering Task 
Force (IETF) BCP-47 standard. For more information, see The region subtag .

Installed components

The I18N:Knowledge Management Internationalization Plugin v2 (com.glideapp.knowledge.i18n2) 
plugin installs the following components:

• A relationship named Translated Versions  that creates a related list on the Knowledge form 
showing other articles that have the same parent article.

• A business rule named knowledge query  that automatically filters the knowledge portal and 
search results based on the user's selected language.

• A UI macro named kb languages.

• Two fields, named Language  and Parent, in the Knowledge [kb_knowledge] table and the 
Knowledge form.

Knowledge form changes

The I18N:Knowledge Management Internationalization Plugin v2 (com.glideapp.knowledge.i18n2) 
plugin adds the following fields to the Knowledge form:

• Language: Language in which you are creating the knowledge article. The list is populated 
based on the languages enabled for the selected knowledge base.

• Parent: The article number that represents the base language article. This setting keeps 
translations of the same article related to each other. Consider choosing the same language 
consistently for the parent article.

Note: 
The Parent  field tracks translations of articles.

Additionally, the Translated Versions related list is automatically added to the Knowledge form 
after you save an article.

Activate knowledge blocks

You can activate knowledge blocks [com.snc.knowledge_blocks] if you have the admin role. This 
plugin includes demo data and activates related plugins if they are not already active.

Before you begin
Role required: admin

About this task
Knowledge blocks activates these related plugins if they are not already active.
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Plugins for knowledge blocks

Plugin Description

Knowledge Management 
Advanced

[com.snc.knowledge_advanced]

Enables advanced features for Knowledge Management, 
such as article versioning. For a full list of features, see 
activate the Knowledge Management Advanced plugin.

Note: 
Knowledge blocks can be used with or without the 
article versioning feature. To disable the feature, see 
Disable the article versioning feature.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.

Note: 
When domain separation and delegated admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .

Enable knowledge blocks for each knowledge base

Enable the knowledge blocks feature for each knowledge base where you plan to use the 
blocks. Once enabled, you can create knowledge blocks to add to knowledge articles within a 
knowledge base.

Before you begin
Make sure that the knowledge blocks [com.snc.knowledge_blocks] plugin is activated.

Role required: knowledge_admin or knowledge_manager

Procedure

1. Navigate to All  > Knowledge  > Administration  > Knowledge Bases.

2. Open the knowledge base record.

3. In the Knowledge Base form, select the Enable blocks  check box.

Note: 
If the Enable blocks  check box is not visible, you can add the field to the form by right-
clicking the form header and navigating to Configure  > Form Layout.
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4. Click Update.

Note: 
If you decide to later disable the knowledge blocks feature, all knowledge blocks within 
the knowledge base must be deleted before you can clear the box.

What to do next
Create knowledge blocks to use within the enabled knowledge base.

Related topics

Knowledge blocks

Using knowledge blocks

Knowledge blocks authoring in Agent Workspace

Configure translation management

Configure translation management to create translation tasks.

Activate translation management

You can activate the Knowledge Management Advanced (com.snc.knowledge_advanced) and 
I18N:Knowledge Management Internationalization Plugin v2 (com.glideapp.knowledge.i18n2) 
plugins for translation management if you have the admin role.

Before you begin
Role required: admin

• Translation management requires the following plugins. Ensure that these plugins are activated 
before you install translation management.

Required ServiceNow  plugins

Knowledge Management Advanced plugin 
[com.snc.knowledge_advanced]

I18N:Knowledge Management Internationalization Plugin v2 
[com.glideapp.knowledge.i18n2]

The internationalization plugin for the languages you want to make 
available. The is automatically activated once any of the language 
plugins are activated.
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Translation management also requires enabling the 
glide.knowman.translation.enable_translation_task  property to add 
translation task options to the Translation Management submenu under Knowledge menu.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.

Note: 
When domain separation and delegated admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .

Add a custom Localization Framework  setting to enable bulk translations

Add a custom Localization Framework  setting to translate multiple knowledge articles manually.

Before you begin

• Activate the Knowledge Management Advanced plugin.

• Activate Localization Framework .

• Activate a language .

• Bulk Translation is available with the base Washington DC  release. If you are upgrading from a 
previous release, you must configure the following settings:

◦ Enable the Localization Framework  by setting the 
glide.knowman.translation.enable_lf_article_translation  system 
property to true.

◦ Set the glide.knowman.translation.enable_translation_task  system 
property to false.

◦ Set the glide.knowman.translation.enable_localization_framework 
system property to true.

Role required: admin

Procedure

1. Navigate to All  > Localization Framework  > Settings.

2. In the Setting list, select New.

3. Enter a name for the setting.

4. Select Knowledge  from the Artifact  list.

5. Select the languages into which you want the articles translated.

6. Select the Workflow Preferences  tab.

7. Select Translation -> Publish  from the Workflow  list.
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8. Select the Project Preferences  tab.

9. Enable the creation of bulk translation localization projects.

◦ To enable manual creation, select Enable projects. For more information, see Create 
translation projects .

◦ To enable the auto-creation of the localization projects, select Enable projects  and Enable 
auto creation.

If auto creation is enabled, selected localization requested items (LRITMs) are automatically 
bundled into a single localization project.

10. Select Update.

What to do next
Request bulk translations for multiple knowledge articles.

Add a custom Localization Framework  setting to enable machine translation

Add a custom Localization Framework  setting to enable machine translation for bulk translations 
of knowledge articles.

Before you begin

• Activate the Knowledge Management Advanced plugin.

• Activate Localization Framework .

• Activate a language .

• Bulk Translation is available with the base Washington DC  release. If you are upgrading from a 
previous release, you must configure the following settings:

◦ Enable the Localization Framework  by setting the 
glide.knowman.translation.enable_lf_article_translation  system 
property to true.

◦ Set the glide.knowman.translation.enable_translation_task  system 
property to false.

◦ Set the glide.knowman.translation.enable_localization_framework 
system property to true.

Role required: admin

Procedure

1. Navigate to All  > Localization Framework  > Settings.

2. In the Setting list, select New.

3. Enter a name for the setting.

4. Select Knowledge  from the Artifact  list.

5. Select the languages into which you want the articles translated.

6. In the Translation Preferences  tab, select the Enable machine translate  check box to enable 
machine translation for knowledge articles.

7. Select the desired translator in the Translator  field.

8. Select the Workflow Preferences  tab.

9. Select Auto Translation  > Auto Publish  from the Workflow list.
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10. Select the Project Preferences  tab.

11. Enable the creation of bulk translation localization projects.

◦ To enable manual creation, select Enable projects. For more information, see Create 
translation projects .

◦ To enable the auto-creation of the localization projects, select Enable projects  and Enable 
auto creation.

If auto creation is enabled, selected localization requested items (LRITMs) are automatically 
bundled into a single localization project.

12. Select the group that includes the localization_manager role in the Localization manager 
group  field.
The Localization manager group  field appears only when the Enable projects  and the Enable 
auto creation  options are selected.

13. Select Update.

What to do next
Translate knowledge articles using Dynamic Translation

Activate Knowledge Management KCS Capabilities

You can activate the Knowledge Management KCS Capabilities plugin 
(com.snc.knowledge_kcs_capabilities) to enable the use of certain KCS roles and KCS article 
states.

Before you begin
Role required: admin.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.

Note: 
When domain separation and delegated admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .

Enable languages for a knowledge base

Select the languages you want enabled at a knowledge base level. Users can then create articles 
only for selected languages.
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Before you begin
You must activate the Knowledge Management Advanced (com.snc.knowledge_advanced) 
plugin, and I18N: Knowledge Management Internationalization Plugin v2 
(com.glideapp.knowledge.i18n2) plugin.

Role required: knowledge_admin or admin

Procedure

1. Navigate to All  > Knowledge  > Administration  > Knowledge Bases.

2. Select an existing knowledge base.

3. Click the lock icon to unlock the Languages  field in the Knowledge base form.

Note: 
You may need to configure the knowledge base form to include the Languages  field. 

Click the form context menu icon ( ) and navigate to Configure  > Form layout. Use 
slushbucket to add the Languages field.

4. Click Submit.

Configure the Knowledge Management Service Portal

The Knowledge Management Service Portal enables users to perform the same operations 
that are available with the Knowledge Management V3 plugin. From the portal, users can view 
knowledge bases and articles, search for information, sort and filter search results, and provide 
feedback.

• For new customers on the Madrid and later releases, the Knowledge Management Service 
Portal plugin (com.snc.knowledge_serviceportal) is active by default.

• For existing customers on release versions prior to Madrid, activate the plugin, if required.

• Configure the Knowledge Management Service Portal properties, including the property that 
directs users to the Knowledge Management  homepage in the Knowledge Management 
Service Portal.

• Navigate to Service Portal  > Portals  and click Knowledge Portal  (Knowledge Management 
Service Portal is named as Knowledge Portal). See Service Portal  for more information about 
creating a custom interface.

• System administrators can configure portal pages and configure widgets for searching, sorting, 
and filtering knowledge base information. To configure widget instance options and configure 
search, sort, and filter features, see Knowledge Management Service Portal widgets

• To add knowledge bases to the Knowledge Service Portal, complete the following steps.

1. Navigate to Service Portal  > Portals, and click Service Portal.

2. Click the Knowledge Bases  related list.
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3. Click Edit  to map one or more knowledge bases to the portal.

Note: 
If no knowledge bases are added, all knowledge bases are available in the portal.

If knowledge bases are mapped, only those knowledge bases are available in the 
portal. All search results and all widgets display results from the mapped knowledge 
bases only.

• Note: 

Starting with the Washington DC  release, the Knowledge Management  v3 
homepage (com.snc.knowledge3) is being prepared for deprecation in the 
future Y release. It is replaced by the Knowledge Management  Service Portal 
(com.snc.knowledge_serviceportal), which is active by default for customers on Madrid 
and later releases. For more information about the new experience, see Knowledge 
Management Service Portal homepage features.

Section 508 compliance features

Users can view and interact with the Knowledge Management  article view page in the Knowledge 
Management  Service Portal  using Section 508 compliance features. See Enabling accessibility 
features  for more information.

Related topics

Knowledge Management FAQ

Import a Word document to a knowledge base

Import a Word document to a knowledge base using Knowledge Management v3

Enable external or public users to view knowledge articles from the Knowledge Management 
Service Portal

Enable knowledge articles on the Knowledge Management Service Portal to be visible to external 
or public users.

Before you begin
The Knowledge Management Service Portal plugin (com.snc.knowledge_serviceportal) must be 
enabled.
Role required: admin

About this task
If you are using Knowledge Management within the Customer Service Management (CSM) 
application, you can automatically make knowledge articles public by activating and running 
the Make KM Service Portal Pages Public  fix script after you install the Customer 
Service Management plugin (com.sn_customerservice).

If you are using Knowledge Management as a standalone application, perform the steps in this 
procedure.

Procedure

1. Navigate to All  > Service Portal  > Pages.

2. In the Pages list, search for and select kb_home.
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Note: 
If the application scope isn't set to Knowledge Management - Service Portal, you cannot 
edit the form and a warning message appears. To make the form editable, click the word 
here  at the end of the message.

3. Enable public or external users to view knowledge articles from the Knowledge Management 
Service Portal.

Action Description

Make knowledge service portal pages visible 
to public users

a. On the Page form, select the Public  check 
box.

b. Click Update.

Make knowledge service portal pages visible 
to external users

a. On the Page form, in the Roles  field, click 
the edit user roles icon .

b. On the Roles form, move snc_external  from 
the available roles in the Available  column 
to the Selected  column.

c. On the Roles form, click Done.

d. On the Page form, click Update.

4. Repeat the steps 2 and 3 for kb_article_view  and kb_search  pages.

5. Manage access to the articles for the Knowledge Management Service Portal pages.

Action Description

Enable access to the knowledge base 
for public.

After you set the page to public as described 
in step 3, ensure that the Cannot Read and 
Can Read user criteria are not set and the 
glide.knowman.block_access_with_no_user_criteria 
property is set to false for the knowledge bases you 
want to give access to public users.

Enable access to the knowledge base 
for external users.

After you add the snc_external role to the page as 
described in step 3, ensure that external users have 
read access to the knowledge bases for which you 
want to give access.

For more information about providing access to knowledge bases, see Managing access to 
knowledge bases and knowledge articles.

Knowledge Management Service Portal widgets

The Knowledge Management Service Portal uses a number of widgets to enable searches, 
display search results, and display articles, related articles, and related items.

In the Knowledge Management  Service Portal, the Knowledge Management  homepage, search 
results page, and article view page honor the Knowledge Management V3 system properties. If 
configured, widget instance options can override the system properties.
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Note: 

Starting with the Washington DC  release, the Knowledge Management  v3 
homepage (com.snc.knowledge3) is being prepared for deprecation in the 
future Y release. It is replaced by the Knowledge Management  Service Portal 
(com.snc.knowledge_serviceportal), which is active by default for customers on Madrid 
and later releases. For more information about the new experience, see Knowledge 
Management Service Portal homepage features.

Users with the knowledge_admin or admin role can configure the widget instance options used 
on the Knowledge Management Service Portal pages. Use the control + right-click menu to 
access the widget instance options and configure a widget instance. For more information, see 
Configure widget instance options .

Note: 
Before configuring widget instance options, switch to the Knowledge Management - Service 
Portal scope.

Homepage widgets:

• Knowledge Homepage Search

Customize search features for the homepage.

• Knowledge Bases Browse

Displays knowledge base tiles in the homepage.

• Knowledge Featured Articles

Displays a list of featured articles in the homepage.

• Knowledge Most Useful Articles

Displays a list of most useful articles in the homepage.

• Knowledge Most Viewed Articles

Displays a list of most viewed articles in the homepage.

Search results page widgets:

• Knowledge Breadcrumbs

Displays navigation path to the current page and a search box for users to search the 
knowledge base.

• Knowledge Search

• Knowledge Facet Header

Displays the title for the filter facets.

• Knowledge Field Facet

Display search results filtered by knowledge base, knowledge category, and author.

• Knowledge Tags Facet

Display search results filtered by article tags.
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• Knowledge Resource Facet

Display search results filtered by article resource.

• Knowledge Query Facet

Display search results filtered by article rating, number of article views, and last modified.

• Knowledge Result Sort

Displays search results filtered by sort options for returned results.

• Knowledge Selected Filter

Displays the selected facet filters and allows you to clear the selections.

• Knowledge Result

Displays search results filtered by returned results.

Article view page widgets:

• Knowledge Breadcrumbs

Displays navigation path to the current page.

• Knowledge Article Content

Customize what information users can view and what actions they can perform in the article 
view page.

• Knowledge Article Helpful

Enables users to mark the article as helpful.

• Knowledge Article Comments

Enables users to add comments for the article.

• Knowledge Attachments

Displays article attachments if the Display Attachment  field for the article is enabled.

Note: 
You must add the Knowledge Attachments widget to any page in addition to Knowledge 
Article Content widget. After upgrade, if this widget does not get added automatically, you 
must add it manually.

• Related Catalog Item

Displays a list of catalog items mapped to the article. The widget appears only when the 
related catalog items are available for the selected article.

• Knowledge Related Articles

Displays a list of related articles with information similar to the selected article. The related 
articles are manually mapped, automatically predicted, or both. The manually mapped articles 
appear first in the widget. The widget appears only when the related articles are available for 
the selected article.
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• Affected Products

Displays the products related to the knowledge articles available in the Affected Products 
related list for the article. The widget appears only when the affected products are available for 
the selected article.

• Most Recent Tasks

Displays the tasks attached to the articles available in the Attached Tasks  related list for that 
article. The widget appears only when the related tasks are available for the selected article.

• Most Useful

Displays a list of knowledge articles that users found most useful.

Activate the Knowledge Management Service Portal plugin

The Knowledge Management - Service Portal plugin (com.snc.knowledge_serviceportal) is active 
by default for customers on Madrid and later releases. Existing customers on release versions 
prior to Madrid can activate the plugin, if required.

Before you begin
Role required: admin

About this task
This plugin requires the following plugins:

• Knowledge Management V3 (com.snc.knowledge3)

• Service Portal for Enterprise Service Management (com.glide.service-portal.esm)

Note: 

Starting with the Washington DC  release, the Knowledge Management  v3 
homepage (com.snc.knowledge3) is being prepared for deprecation in the 
future Y release. It is replaced by the Knowledge Management  Service Portal 
(com.snc.knowledge_serviceportal), which is active by default for customers on Madrid 
and later releases. For more information about the new experience, see Knowledge 
Management Service Portal homepage features.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.

Note: 
When domain separation and delegated admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .
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Configure search widget instance options

Configure widget instance options for the search widgets on the Knowledge Management 
Service Portal homepage and search results page.

Before you begin
Role required: sp_admin or admin

About this task
The homepage uses the Knowledge Homepage Search widget and the search results page uses 
the Knowledge Search widget. Use the widget instance options to customize the search feature 
for these pages.

Procedure

1. Navigate to the Knowledge Management Service Portal homepage or search results page.

2. Control + right-click the search bar.

3. Click Instance Options.

4. Configure the search widgets settings.

Instance option Page(s) Description

Title Knowledge Management 
Service Portal homepage

The title of the search widget. 
The default for the homepage 
is Welcome to Knowledge.

Search Placeholder Knowledge Management 
Service Portal homepage

Default text that appears in 
the search bar.

Bootstrap color Search result page The color of the search 
widget.

Bootstrap size Search result page The size of the search widget.

Allow Empty Search Search result page Allow empty knowledge base 
searches. The default for the 
homepage uses the system 
property. The default for the 
search results page is Yes.

Allow Instant Search On 
Keypress

Search result page Enables instant search 
results as you type a search 
term. The default for the 
search results page uses the 
system property.

Wait time (ms) between 
searches, if instant search is 
enabled

Search result page The time, in milliseconds, 
to wait between searches if 
the instant search feature 
is enabled. The default wait 
time is 500 ms.

Alternate URL Parameters for 
Search

Search result page Alternate parameters that 
appear in the search results 
URL. By default these 
parameters include keyword 
and query.
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Instance option Page(s) Description

Alternate URL Parameters for 
Language

Search result page Alternate parameters that 
appear in the URL denoting 
the selected language.

Minimum Number of 
Characters for Search

Both The minimum number of 
characters required to 
generate a search.

Glyph Both An icon that appears in the 
search bar.

CSS Both Custom configurations that 
determine the look and feel 
of the elements in the widget. 
For more information, see 
Service Portal SCSS Primer .

5. Click Save.

Configure knowledge base tile widget instance options

Configure widget instance options for the knowledge base tile widgets on the Knowledge 
Management Service Portal homepage.

Before you begin
Role required: sp_admin or admin

About this task
The homepage uses the Knowledge Bases Browse widget to display knowledge base tiles.

Procedure

1. Navigate to the Knowledge Management Service Portal homepage.

2. Control + right-click a knowledge base tile.

3. Click Instance Options.

4. Configure the desired settings for the knowledge base tile widgets.

Instance option Description

Title The title that appears above the knowledge 
base tiles. The default is Explore our 
Knowledge Bases.

Bootstrap color The color of the widget.

CSS Custom configurations that determine the 
look and feel of the elements in the widget. 
For more information, see Service Portal 
SCSS Primer .

Order By The order in which the knowledge base tiles 
appear on the homepage. Use any field on 
the Knowledge table. If this field is empty, 
tiles are displayed in alphabetical order. 
Other available options include article_count.
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Instance option Description

Reverse Order Enable this check box to display knowledge 
base tiles in the reverse order.

Post Question Label The label on the button used to post a 
question. The default is Ask a Question.

Create Article Label The label on the button used to create an 
article. The default is Create Article.

Post Question URL The parameters that appear in the URL when 
posting a question.

Create Article URL The parameters that appear in the URL when 
creating an article.

5. Click Save.

Configure the home page widget instance options

Configure widget instance options for the widgets used to display popular articles on the 
Knowledge Management Service Portal homepage.

Before you begin
Role required: sp_admin or admin

About this task
The homepage displays links to the featured, most viewed, and most useful articles using several 
widgets. The featured articles are displayed based on the keywords associated with the articles. 
For information on displaying articles in the Featured content section, see Pin a knowledge 
article. Most viewed and most useful articles are displayed based on the highest view and use 
count of the articles.

Procedure

1. Navigate to the Knowledge Management Service Portal homepage.

2. Control + right-click one of the widgets.

3. Click Instance Options.

4. Configure the desired settings for the widget.

Instance option Description

Title The title of the widget.

Bootstrap color The color of the widget.

Glyph An icon that appears in the widget.

CSS Custom configurations that determine the 
look and feel of the elements in the widget. 
For more information, see Service Portal 
SCSS Primer .

Table The table that contains the Source Field 
used to provide the featured, most viewed, 
and most useful articles widget options. The 
default table is Knowledge (kb_knowledge).
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Instance option Description

Display Field The title displayed for each article in the list. 
By default, this is the article short description.

Secondary Fields Additional information displayed for each 
article in the list below the title. By default, 
this information includes the author, view 
count, the date that the article was last 
modified, and the article rating.

Max number of records to show The maximum number of articles to include in 
the list.

Show even when empty Enable this check box to display the widget 
even if there are no articles in the list.

Show Secondary Fields Label Enable this check box to display the 
field labels for the additional information 
displayed for each article.

Knowledge Base To restrict the articles that appear in this 
list to a specific knowledge base, select the 
knowledge base from the knowledge base 
list.

5. Click Save.

Configure sort widget instance options

Configure widget instance options for the knowledge sort widget on the Knowledge Management 
Service Portal search results page.

Before you begin
Role required: sp_admin or admin

About this task
The search results page uses the Knowledge Result Sort widget to provide sort options for the 
returned list of results. Use the widget instance options to customize the sort options.

Procedure

1. Navigate to the Knowledge Management Service Portal search results page.

2. Control + right-click the sort options at the top of the results list.

3. Click Instance Options.

4. Configure the desired settings for the sort widget.

Instance option Description

Bootstrap color The color of the search widget.

CSS Custom configurations that determine the 
look and feel of the elements in the widget. 
For more information, see Service Portal 
SCSS Primer .

Hide Relevancy Removes the relevancy sort option.
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Instance option Description

Table The table that contains the fields used to sort 
the list of knowledge items. The default table 
is Knowledge.

Sort Fields The fields used for sorting the list of 
knowledge items.

Sort Field Labels The labels for the fields that appear 
in the sort options. The default is 
Views:desc,Newest:desc,Alphabetical.

The sort order for the sort field labels is 
ascending. To use a descending order, 
denote :desc.

5. Click Save.

Configure article list widget instance options

Configure widget instance options for the article lists on the Knowledge Management Service 
Portal homepage.

Before you begin
Role required: sp_admin or admin

About this task
The homepage uses the Article List widget to display different lists of articles, including Featured, 
Most Useful, and Most Viewed.

Procedure

1. Navigate to the Knowledge Management Service Portal homepage.

2. Control + right-click one of the article list headers.

3. Click Instance Options.

4. Configure the desired settings for the article list widget.

Instance option Description

Title The title of the article list.

Bootstrap color The color of the widget.

Glyph An icon that appears in the widget.

CSS Custom configurations that determine the 
look and feel of the elements in the widget. 
For more information, see Service Portal 
SCSS Primer .

Table The table that stores the list articles.

Display Field The title displayed for each article in the list. 
By default, this is the article short description.

Secondary Fields Additional information displayed for each 
article in the list below the title. By default, 
this information includes the author, view 
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Instance option Description

count, the date that the article was last 
modified, and the article rating.

Max number of records to show The maximum number of articles to include in 
the list.

Show even when empty Enable this check box to display the article 
list even if it does not contain any articles.

Show Secondary Fields Label Enable this check box to display the 
field labels for the additional information 
displayed for each article.

Knowledge Base To restrict the articles that appear in this 
list to a specific knowledge base, select the 
knowledge base from the knowledge base 
list.

5. Click Save.

Configure search results list widget instance options

Configure widget instance options for the results list widget on the Knowledge Management 
Service Portal search results page.

Before you begin
Role required: sp_admin or admin

About this task
The search results page uses the Knowledge Result widget to provide display options for the 
returned list of results. Use the widget instance options to customize the display options.

Procedure

1. Navigate to the Knowledge Management Service Portal search results page.

2. Control + right-click the list of returned search results.

3. Click Instance Options.

4. Configure the desired settings for the results list widget.

Instance option Description

Glyph An icon that appears in the search bar.

CSS Custom configurations that determine the 
look and feel of the elements in the widget. 
For more information, see Service Portal 
SCSS Primer .

Show Relevancy Score Shows how relevant each search result is 
based on the search term. The default setting 
uses the system property.

Breadcrumb: Hide Categories Hides the category in the breadcrumb that 
appears below the article short description 
in the results list. The default setting uses the 
system property.
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Instance option Description

Breadcrumb: Knowledge Base Separator The character used as a separator between 
the knowledge base and the category in the 
breadcrumb.

Breadcrumb: Category Separator The character used as a separator between 
categories in the breadcrumb.

Default Sort Order The default sort order for the list of 
returned results. The default sort order is 
sys_view_count:desc, which sorts the results 
by the number of views in descending order.

How to Display Attachments in Knowledge 
Search Results

How attachments are shown in the list of 
returned results. The default uses the system 
property.

Label for Show Pinned Articles Link The text used for the pinned articles link.

Table The table that stores the information returned 
in the search results.

Knowledge Secondary Fields Fields that display additional information for 
each article in the search results.

Show Secondary Fields Label Enable this check box to display the 
field labels for the additional information 
displayed for each result.

Pagination Type Controls how additional knowledge article 
search results are displayed.

◦ Standard Pagination:  displays the search 
results in multiple pages.

◦ Infinite Scroll:  displays the search results 
while scrolling.

The default pagination type is set to Infinite 
Scroll.

Maximum no. of articles displayed per page 
with standard pagination

The maximum number of items included in a 
page when the search results list is displayed 
using standard pagination.

Maximum no. of articles displayed after first 
fetch during infinite scroll

The maximum number of items included 
when the search results list is first displayed 
using infinite scroll.

Maximum no. of articles displayed at 
subsequent fetches during infinite scroll

The maximum number of items included 
when the search results list updates as the 
user scrolls to the bottom.

No. of links in pagination bar The number of links displayed in the 
pagination bar.

5. Click Save.

Configure filter facet widget instance options

Configure widget instance options for the filter facet widgets on the Knowledge Management 
Service Portal search results page.
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Before you begin
Role required: sp_admin or admin

About this task
The homepage uses several widgets to filter the items in the search results list. There are two 
types of facet widgets:

• Simple field facets based on the Knowledge table fields

• Advanced query facets based on custom queries of the Knowledge table

Use the widget instance options to customize these facet widgets:

• Knowledge Field Facet (for filtering by knowledge base, knowledge category, and author)

• Knowledge Tags Facet (for filtering by tag)

• Knowledge Resource Facet (for filtering by resource, such as articles)

• Knowledge Query Facet (for filtering by rating, last modified, and number of views)

Note: 
Query facets are displayed when there's at least one knowledge field facet added to the 
page.

Use default Knowledge Language Widget to include language filters in the knowledge Search 
Result page. To add a custom language widget, you need to deactivate the Knowledge Language 
Widget on the Knowledge Search Result page.

Procedure

1. Navigate to the Knowledge Management Service Portal search results page.

2. Control + right-click a filter facet widget.

3. Click Instance Options.

4. Configure the desired settings for the selected type of facet widget.

Instance option Description

Title Title of the filter facet widget.

Glyph Icon that appears to the left of the title.

Order Order in which the filter facet widgets 
appear on the left side of the search results 
page. If empty, the filter facet widgets sort 
alphabetically.

Bootstrap color Color of the filter facet widget header.

CSS Custom configurations that determine the 
look and feel of the elements in the widget. 
For more information, see Service Portal 
SCSS Primer .

Source Table Table that contains the Source Field  used to 
provide the filter facet widget options. The 
default table is Knowledge (kb_knowledge).

Source Field Field in the Source Table  that provides the 
filter facet widget options. Field types that 
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Instance option Description

can be used as a source field include string, 
glide list, integer, reference, and boolean.

Facet Identifier Unique name for the custom query facet that 
can be used in script code.

Facet Template Template that determines the type of facet 
interaction.

Knowledge Field Facet widget templates:

◦ Single Select: users can select only one 
filter from this widget.

◦ Multi Select: users can select more than 
one filter from this widget.

◦ Dropdown Select: users can select more 
than one filter from a drop-down menu.

Knowledge Query Facet widget templates

◦ Simple Query: shows a label for each facet 
value.

◦ Rating: shows rating stars.

Custom Template Custom template that determines facet 
interaction and value selection.

Facet Options Custom query in JSON format for the label, 
ID, order, and query for each facet value. 
Includes the table, value (encoded query), 
and display value (encoded query).

Order by Order of the filter options within the facet 
widget. The default order is label, which 
sorts the options in alphabetical order. For 
reference fields, you can also state an order 
from the reference field table.

Minimum results for showing filter search bar Minimum number of results required to 
display a search bar at the top of the filter 
facet widget.

Minimum results for showing scroll bar Minimum number of results required to 
display a scroll bar in the filter facet widget.

Maximum length for string field Maximum field length. Only fields whose 
length is less than this value are allowed to 
be added as a filter facet.

Alternate URL Parameters Names of the URL parameters used to 
initialize this filter facet, if used in the URL as 
a search parameter.

Fetch Maximum Values
Option to fetch filter values from all 
knowledge articles in the search results.

Selecting the Fetch Maximum Values 
option might impact the load time for 
search results. If this option is disabled, 
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Instance option Description

the load time improves based on the 
glide.knowman.search.facet_depth 
property value.

If the 
glide.knowman.search.apply_acls 
property is set to true, a filter value can 
appear in a filter facet even when there 
are no search results for that filter value. 
For example, a knowledge base without 
any articles might appear as a value in the 
knowledge base filter facet.

Show Empty Value If enabled, shows an empty filter facet option 
that users can select to filter for articles that 
do not have this field set.

For example, if an article does not have an 
assigned category, clicking the empty option 
lists all articles with no assigned category.

Show Only Facet Values Matching Results Creates a dynamic filter facet widget that 
displays only those filter values that match 
the search results rather than showing all 
values. If you disable this instance option, 
the time needed to load the filter facet data is 
reduced.

Show category hierarchy (valid for 
kb_category only)

If enabled, shows categories with their 
hierarchy list up to the fourth-level. When 
you enable this option, you can select only 
one category at a time. Any articles that are 
included in the subcategories beyond the 
fourth-level also appear in the fourth-level 
of category. The search results filtered on 
a selected parent category include articles 
within that category and all the associated 
child categories.
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Instance option Description

Note: 

◦ If the number of knowledge articles 
returned in search results is greater 
than the search facet depth, all 
categories are displayed in this facet. 
Therefore, some categories shown 
in this facet might not be associated 
with any knowledge articles in 
the search results. By default, 
the facet depth is set to 300 and 
configured by an administrator in the 
glide.knowman.search.facet_depth 
property.

◦ To configure the knowledge Search 
Results page widgets by adding 
more filters. Specifically if filters on 
language need to be applied they 
should be using the OOB Knowledge 
Language Widget. The field facet 
widget can be configured using 
language field in instance options 
for similar behaviour but in that case 
OOB Knowledge Language Widget 
instance should be inactivated on the 
Knowledge Search Results page.

5. Click Save.

Related topics

Knowledge Management properties

Configure a user action for the article view page

Configure a user action for the Knowledge Management  article view page in the Knowledge 
Management  Service Portal.

Before you begin
Role required: sp_admin or admin

About this task
The article view page uses the Knowledge Article Content widget to provide user actions. Use the 
widget instance options to customize these actions.

Ensure that the application scope on the ServiceNow AI Platform  is set to Knowledge 
Management Service Portal.

User actions available for the article view page appear in a menu after clicking the overflow icon 

( ) in the article header. These actions enable users to flag an article, edit an article, or create 
an incident for an article.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3249



Procedure

1. Navigate to the Knowledge Management Service Portal article view page.

2. Control + right-click the article header.

3. Click Instance Options.

4. Configure the desired settings for the Knowledge Article Content widget.

Instance option Description

Bootstrap color The color of the widget header.

CSS Custom configurations that determine the 
look and feel of the elements in the widget. 
For more information, see Service Portal 
SCSS Primer .

Hide All Actions Hides the user actions in the article header 
including the Subscribe/Unsubscribe  button 
and the overflow icon.

Show Version Information Displays version information for the 
selected article. Requires the Knowledge 
Management Advanced plugin 
(com.snc.knowledge_advanced).

Show Create Incident Action Displays the Create Incident  user action 
when a user clicks the overflow icon in the 
article header.

Create Incident Action Label The label for the user action that appears in 
the overflow icon menu. The default is Create 
Incident.

Create Incident Action URL The target URL for the Create Incident  user 
action.

If no URL is specified, the 
system uses the URL in the 
glide.knowman.create_incident_link 
system property.

Redirect to the latest article Redirects the article view page to the latest 
accessible version of the article, if available. 
Disable the Show Version Information  option 
to hide the version information on the article 
view page because any version link will 
redirect to the latest version only.

5. Click Save.

Configure article helpful widget instance options

Configure the Knowledge Article Helpful widget instance options for the Knowledge 
Management  article view page in the Knowledge Management  Service Portal.

Before you begin
Role required: sp_admin or admin
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About this task
The article view page uses the Knowledge Article Helpful widget to allow users to provide 
feedback on the helpfulness of the article, display a confirmation message after a feedback is 
provided, and display the percentage of users who found the article to be useful. Use the widget 
instance options to customize these actions.

Procedure

1. Navigate to the Knowledge Management  article view page in the Knowledge Management 
Service Portal.

2. Control + right-click Helpful?

3. Click Instance Options.

4. Configure the desired settings for the Knowledge Article Helpful widget.

Instance option Description

Bootstrap color The color of the widget header.

CSS Custom configurations that determine the 
look and feel of the elements in the widget. 
For more information, see Service Portal 
SCSS Primer .

Show helpful percentage information Check box to enable the display of 
percentage of users who found this article to 
be helpful.

Helpful Action Label Label for marking this article as helpful or not.

Feedback Message Text that displays when the user marks the 
article as helpful or not.

5. Click Save.

Configure article comments instance options

Configure the Knowledge Article Comments widget instance options for the Knowledge 
Management  article view page in the Knowledge Management  Service Portal.
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Before you begin
Role required: sp_admin or admin

About this task
The article view page uses the Knowledge Article Comments widget to allow users to rate an 
article, add a comment, or view existing comments for the article. Use the widget instance 
options to customize these actions.

Procedure

1. Navigate to the Knowledge Management  article view page in the Knowledge Management 
Service Portal.

2. Control + right-click the comments section.

3. Click Instance Options.

4. Configure the desired settings for the Knowledge Article Comments widget.

Instance option Description

Bootstrap color The color of the widget header.

CSS Custom configurations that determine the 
look and feel of the elements in the widget. 
For more information, see Service Portal 
SCSS Primer .

Other Options

Show User Comments Displays the field for users to enter 
comments.

Available options:

◦ Yes - displays the field that enables users 
to enter comments for the article.

◦ No - hides the field that enables users to 
enter comments for the article.

◦ Use system property - display or hide 
the comments field using article view 
properties.

Add Comment Label Label for the field to add comments.

Maximum number of attachments that can be 
attached to a comment

Maximum number of attachments that can 
be attached to a comment included for a 
knowledge article.

Maximum attachment file size in MB that can 
be attached to a comment

Maximum attachment file size in MB that can 
be attached to a comment included for a 
knowledge article.

5. Click Save.

Configure related catalog item widget instance options

Configure the Related Catalog Item widget instance options for the Knowledge Management 
article view page in the Knowledge Management  Service Portal. These options relate to the list of 
catalog items mapped to an article.
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Before you begin
Role required: sp_admin or admin

About this task
The knowledge article view page displays the Related Items section when an article has related 
catalog items. Use the widget instance options to customize the Related Items section on the 
article view page.

Procedure

1. Navigate to the Knowledge Management  homepage in the Knowledge Management  Service 
Portal  by adding /kb  to the end of your instance URL.

Note: 
Your administrator might have changed this default navigation.

2. Search for and click the article for which you want to modify the instance options for the 
Related Catalog Item widget.

3. Press Control and right-click the Related Items section.

4. Click Instance Options.

5. Configure settings for the Related Catalog Item widget.

Instance option Description

Source Table Source table containing related catalog 
items. The source table specified in the base 
system is Related Catalog Items (kb_2_sc).

Source Column Field in the source table referring to the 
source record. The source column specified 
in the base system is Knowledge article 
(kb_knowledge).

Title Title that appears on the widget header. The 
default title is Related Items.

Max Number Maximum number of catalog items to include 
in the Related Items section on the article 
view page. The maximum number specified in 
the base system is 5.

Use Full Width Option for displaying the widget in a 12-
column grid at 100% of the available width. If 
you clear the check box, the widget displays 
at 75% of the available width.

Target Column Field in the source table referring to the target 
record. The target column specified in the 
base system is Catalog item (sc_cat_item).

Source Id URL parameter containing the unique record 
identifier (sys_id) of the source record. For 
the article view page, the URL parameter 
containing the source ID is sys_kb_id.

6. Click Save.
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Related topics

Map catalog items related to an article

Configure knowledge related articles widget instance options

Configure the Knowledge Related Articles widget instance options for the Knowledge 
Management  article view page in the Knowledge Management  Service Portal. These options 
relate to the list of related articles mapped to an article.

Before you begin
Role required: sp_admin or admin

About this task
The knowledge article view page displays the Related Articles section when an article has 
related articles. Use the widget instance options to customize the Related Articles section on the 
article view page.

Procedure

1. Navigate to the Knowledge Management  homepage in the Knowledge Management  Service 
Portal  by adding /kb  to the end of the URL for your instance.

Note: 
You can change the default navigation by configuring the property 
sn_km_portal.glide.knowman.serviceportal.portal_url.

2. Click to open the article for which you want to modify the instance options for the Knowledge 
Related Articles widget.

3. On the article page, press Control+right-click and select Page in Designer.

4. In the Service Portal Designer page, click the edit icon ( ) on Knowledge Related Articles 
widget to add the related articles.

Note: 
You can also add Knowledge Related Articles  widget using Widgets  search field and 
drag-and-drop the widget to the blank field.

5. Configure settings for the Knowledge Related Articles widget.

Instance option Description

Title Title that appears on the widget header. The 
default title is Related Articles.

Bootstrap color Color scheme of the widget header. Select 
a color for your widget from a list of common 
bootstrap colors.

Glyph Icon that appears beside each list item 
displayed in the widget. To skip this field, 
select the empty glyph.

CSS Custom configurations that determine the 
look and feel of the elements in the widget. 
For more information, see Service Portal 
SCSS Primer .
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Instance option Description

Use Full Width Option for displaying the widget in a 12-
column grid at 100% of the available width. If 
you clear the check box, the widget displays 
at 75% of the available width.

Table The table that contains the knowledge 
articles associated with the Display Fields 
and Secondary Fields. By default, the table is 
Knowledge (kb_knowledge).

Display Field The title displayed for each article in the 
related articles list. The display field specified 
in the base system is the article short 
description.

Secondary Fields Additional information displayed for 
each article in the list below the title. The 
secondary fields specified in the base system 
are author, view count, the last modified date 
of the article, and the article rating.

Max number of records to show The maximum number of articles to include 
in the Related Articles section on the article 
view page. The maximum number specified in 
the base system is 5.

Show even when empty Option for displaying the widget even if no 
articles are in the list.

Show Secondary Fields Label Options for displaying the field labels for the 
additional information displayed for each 
article.

Knowledge Base To restrict the articles that appear in this 
list to a specific knowledge base, select the 
knowledge base from the knowledge base 
list.

Source Table Source table containing related articles. The 
source table specified in the base system is 
Knowledge (kb_2_kb).

Source Column Field in the source table referring to the 
source record. The source column specified 
in the base system is Knowledge article 
(kb_knowledge).

Target Column Field in the source table referring to the 
target record. The target column specified 
in the base system is Knowledge article 
(kb_knowledge).

Source Id URL parameter containing the unique record 
identifier (sys_id) of the source record. For 
the article view page, the URL parameter 
containing the source ID is sys_kb_id.

6. Click Save.
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Related topics

Map related articles

Knowledge Management Service Portal properties

Search using the Knowledge Management Service Portal

Enter one or more words in the search bar on the Knowledge Management  Service Portal 
homepage to view all search results.

Search results include items in which the short description, content, or attached files include the 
search term. By default, knowledge search results include articles, pinned articles, and social 
Q&A.

You can also filter the search results.

Enable multi-language search

The multi-language search facet is available when more than one supported language is 
enabled. All available languages are displayed in the facet and you can select which languages 
you want your search results to appear in. Your selection is maintained per session, but not 
across logins.

1. To enable different languages, activate the I18N: Knowledge Management  Internationalization 
Plugin v2 plugin (com.glideapp.knowledge.i18n2) or activate one of the internationalization 
plugins for the language you require.

Note: 
Activating internationalization plugins for any of the available languages automatically 
activates the I18N: Knowledge Management  Internationalization Plugin v2 plugin.

2. Navigate to Knowledge  > Administration  > Knowledge Search Properties  > Enable multi 
language search.

3. Select the Yes  check box to enable the feature.

Note: 
If this property is not enabled, you can only search for one language at a time.

Search auto-correct feature

The Knowledge Management  Service Portal homepage search tool also includes an auto-correct 
feature. When enabled, users can auto-correct a typing error in a search term by clicking one of 
the suggestions.

When a search term contains a misspelling, the search tool displays the search results page and 
includes one or more suggested terms at the top of the page under the heading Did you mean. 
Clicking one of these suggestions shows all the search results that match the selected term.

Users with the system administrator role can enable this feature.

1. Navigate to System Properties  > Text Search.

2. Set the following properties to true:

◦ Suggest alternate search spellings for knowledge or global search 
(glide.ts.dym.enable_spell_correct).

◦ Suggest related searches for knowledge or global search 
(glide.ts.dym.enable_chain_suggest).

3. Click Save.
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Integrating Knowledge Management  features with the Service Portal

To create a consistent user experience for Knowledge Management, integrate Knowledge 
Management  Service Portal  in your end-user facing Service Portal.

The Knowledge Management  Service Portal  includes the following features:

• Multiple knowledge bases

• A Knowledge Management  article view page with feedback options

• A Knowledge Management  search results page with options to filter and sort search results

• A number of widgets to enable searches, display search results, display knowledge articles, 
and so on

By default, all knowledge articles in the Service Portal  are redirected to the Knowledge 
Management  article view page using the Knowledge Article View  page route map. If upgrading 
from a previous release, a system administrator can activate the Knowledge Article View  page 
route map to take advantage of the features of the Knowledge Management  article view page. 
For more information, see Activate the Knowledge Article View page on upgrade .

Note: 
The Knowledge Management  Service Portal  supports only Zing search and not AI search.

System administrators perform the following tasks to integrate the Knowledge Management 
Service Portal  features with the Service Portal:

• Integrate the Knowledge Management  homepage with the Service Portal  homepage.

• Integrate the Knowledge Management  search results page with the Service Portal  search 
results page.

• Add the Knowledge Management  Service Portal  widgets to quickly access knowledge articles 
from the Service Portal  homepage  (Optional).

Note: 
These configurations apply to the base system pages within the Service Portal  only.

Related topics

Service Portal pages

Knowledge Management Service Portal homepage features

Knowledge Management Service Portal search results page features

Knowledge Management Service Portal article view page features

Integrate the Knowledge Management  homepage with the Service Portal  homepage

Use a page route map to access the enhanced Knowledge Management  homepage from the 
Service Portal  homepage.

Before you begin
The Knowledge Management - Service Portal plugin (com.snc.knowledge_serviceportal) is 
activated.

Note: 
This plugin is activated by default for customers on Madrid and later releases. Existing 
customers on release versions prior to Madrid must activate the plugin to perform this 
configuration task. For more information, see Activate the Knowledge Management Service 
Portal plugin.
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Role required: admin

About this task
The Knowledge Management  homepage displays knowledge articles organized by knowledge 
base and category, featured content, and popular articles. You use a page route map to access 
the Knowledge Management  homepage from the Service Portal  homepage.

Procedure

1. Navigate to All  > Service Portal  > Page Route Maps.

2. Click New.

3. On the Page Route Map form, fill in the fields.

Page Route Map form

Field Value

Service Portal(s) Service Portal

Route from kb_view2

Route to kb_home

Active Selected

Note: 
On the Page Route Map form, you can fill in the Short Description  and Order  fields as 
appropriate.

4. Click Submit.

Result
You can now open the Knowledge Management  homepage from the Service Portal  homepage by 
clicking the Knowledge link or Knowledge Base icon link.

Integrate the Knowledge Management  search results page with the Service Portal  search 
results page

Use a custom knowledge search widget to access the enhanced Knowledge Management 
search results page from the Service Portal  search results page.

Before you begin
Role required: admin

About this task
The Knowledge Management  search results page in the Knowledge Management  Service Portal 
includes options to filter and sort search results and a number of widgets to enable searches, 
display search results, display articles, and so on. In this procedure, to access the Knowledge 
Management  search results page from the Service Portal  search results page, you create a 
custom knowledge search widget named Search Within and add it to the Service Portal  search 
results page.
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Procedure

1. Create a custom knowledge search widget named Search Within.

a. Navigate to Service Portal  > Service Portal Configuration.

b. On the Service Portal page, click Widget Editor.

c. Click Create a new widget.

d. In the Add a Widget dialog box, in the Widget Name  field, enter Search Within.
The Widget ID  field is automatically populated based on the widget name.

e. Click Submit.

The widget HTML template, client script, and server script display in the widget editor.

f. In the widget editor, enter the following field values to replace any existing text.

▪ In the HTML Template  field, enter the following code to add a link to the Knowledge 
Management  search results page in the Search Within widget from the Service Portal.

<div role="list" class="list-group">
  <span class="list-group-item active">${Search 
 Within}</span>
  <a role="link" class="list-group-item" 
 ng-href="{{data.url}}">${Knowledge}</a>
</div>

▪ In the Server Script  field, enter the following code to set the URL parameters for the 
Knowledge Management  search results page:

(function(){
 var q = encodeURIComponent($sp.getParameter('q'));
 var kb = $sp.getValue('kb_knowledge_base') || "";
 data.url = '/sp?id=kb_search';
 if(q)
  data.url += "&keyword="+q;
 if(kb)
  data.url += "&kb_knowledge_base="+kb;
})();

Note: 
For more information about these fields, see Widget developer guide .

g. Click Save.

2. Add the custom knowledge search widget to the Service Portal  search results page.

a. Navigate to Service Portal  > Service Portal Configuration.

b. Click Designer.

c. In the Filter by title or Id  field, enter sp_search, the ID for the Service Portal  search results 
page, and then select Search.
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d. In the Filter Widget  field, search for the Search Within widget and drag it onto the 
container where you want the widget to appear on the Service Portal  search results 

page.

Tip: 
To verify the location and appearance of the newly added Search Within widget on the 
Service Portal  search results page, click the Preview  tab.

The Search Within knowledge search widget is added to the Service Portal  search results 
page. Clicking Knowledge  in the widget and searching for a keyword will redirect you to the 
Knowledge Management  search results page in the Knowledge Management  Service Portal.

Add widgets to access knowledge articles from the Service Portal  homepage

Add the Knowledge Management  Service Portal  widgets Featured Articles, Most Useful Articles, 
and Most Rated Articles to the Service Portal  homepage to quickly access knowledge articles.

Before you begin
Role required: admin

About this task
For more information about Knowledge Management  Service Portal  widgets, see Knowledge 
Management Service Portal widgets.

Procedure

1. Navigate to All  > Service Portal  > Service Portal Configuration.

2. Click Designer.

3. Select the Service Portal  homepage.

4. In the Filter by title or Id  field, enter index, the ID for the Service Portal  homepage, and then 
select Service Portal.

5. In the Filter Widget  field, search for the following Knowledge Management  Service Portal 
widgets, and then drag them onto the container where you want them to appear on the Service 
Portal  homepage.

Tip: 
To verify the location and appearance of the added widgets on the Service Portal, click 
the Preview  tab.

Result
Clicking a knowledge article link from one of the added widgets on the Service Portal  homepage 
opens the Knowledge Management  article view page in the Knowledge Management  Service 
Portal.

Configure custom SEO tags for canonical URLs and localized knowledge articles

Discover relevant knowledge articles through search engines by adding custom SEO tags for 
canonical URLs and hreflang  tags to the knowledge article view page.
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Before you begin
Role required: admin

About this task
Update the SPSEOHeaderTagsArticleView  script include to add canonical URLs and 
hreflang  tags to the knowledge article view page. You can also add custom header tags to the 
knowledge article view page by implementing the generateCustomTagsForSEO  function.

Note: 
The metatags will be added to the Knowledge Article View 
[kb_article_view] only when viewed by the user agents mentioned in 
glide.knowman.serviceportal.seo_user_agent  system property. For more 
information, see Create and edit a page using the Service Portal Designer .

For information about the default behavior of canonical URLs and hreflang  tags for the 
knowledge article view page, see SEO for canonical URLs and localized versions of knowledge 
articles.

Procedure

1. Navigate to All  > System Definitions  > Script Includes.

2. Search for SPSEOHeaderTagsArticleView.

3. In the Name  column, click the SPSEOHeaderTagsArticleView  link.

4. On the Script Include form, modify the functions for knowledge articles.

Functionality Implementation

Return a 
canonical URL 
for a knowledge 
article

Modify the generateCanonicalURL  function to return the fully 
qualified canonical URL of a knowledge article as a string.

For example, use the following URL format for a knowledge 
article in the customer service portal: "https://
<instance name>.servicenow-com/csp?
id=kb_article_view&sysparm_article=<article 
number>"

Return an 
hreflang  tag 
for translated 
versions of 
a knowledge 
article

Modify the generateHrefLangArray  function to return an 
hreflang  array for the current language and the available translations 
for a knowledge article.

For example, use the following format for a knowledge article translated 
in French in the customer service portal: [{locale:'fr', href: 
'https://<instance name>.servicenow-com/csp?
id=kb_article_view&sysparm_article=<article 
number>'}]

Return a custom 
header for a 
knowledge 
article

Modify the generateCustomTagsForSEO  function to return any 
custom header tags as an array of strings used for the knowledge article 
view page.

For example, use the following format for a custom tag for a knowledge 
article: ['<meta custom-tag="" property="og:title" 
content="Service Portal">']

Return a SEO 
optimized HTML 

Modify the generateSEOTags  function to return the SEO optimized 
HTML content in items.customSEOHTML.
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Functionality Implementation

content for SEO 
bots

For more information about configuring script includes, see Script includes .

5. Click Update.

Create a knowledge base

Create a knowledge base to provide a self-service platform for users to store, share, and manage 
content. Configure knowledge bases into product or service categories and manage user access 
based on permissions. Customize workflows for publishing and retiring articles in the knowledge 
base.

Before you begin
Understand the requirements  for setting up a knowledge base.

Role required: knowledge_admin or admin

Procedure

1. Navigate to All  > Knowledge  > Administration  > Knowledge bases.

2. In the Knowledge Bases list, click New.

3. On the Knowledge base form, fill in the following fields as appropriate:

Knowledge base form

Field Description

Title Unique name for the knowledge base.

Article Validity Number of default days articles will be valid 
for after their created date.

Note: 
The Article Validity  field is configured 
to set the Valid to  date for an article. 
The Valid to  date is the date this 
knowledge article expires. When you 
create an article within a knowledge 
base, the date value in the Valid to  field 
of the article is calculated as follows: 
Created (sys_created_on) + Article 
Validity (in days). An article author or 
editor can select whether to keep or 
change the Valid to  date  (see Create a 
knowledge article). If the Article Validity 
field is blank, the date in the Valid to 
field date is set to  January 1, 2100.

Icon An image that provides a visual reference to 
describe the knowledge base. This image 
is displayed next to all articles from this 
knowledge base in the article search results 
page.
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Field Description

Disable commenting Option to disable commenting. If selected, 
users cannot comment on articles in the 
knowledge base.

Disable suggesting Option to disable edit suggestions. If 
selected, users cannot suggest edits to 
articles in the knowledge base.

Disable category editing Option to disable editing of knowledge 
categories. If selected, only knowledge 
managers can add or edit knowledge 
categories for the knowledge base.

Disable rating Option to disable the rating for knowledge 
articles. If selected, users cannot rate the 
article in the knowledge base.

Disable mark as helpful Option to disable the mark as helpful. If 
selected, user cannot mark any article as 
helpful in the knowledge base.

Enable blocks Option to enable the knowledge blocks 
feature. If selected, you can create 
knowledge blocks to add to knowledge 
articles within a knowledge base.

Checklist Checklist to evaluate the quality of articles in 
the knowledge base.

Application Application scope of the knowledge base.

Note: 
This field is automatically set to the 
application selected in the application 
picker. For information about a 
scoped knowledge base, see Scoped 
knowledge bases.

Owner The user responsible for the knowledge base. 
A knowledge base owner can assign other 
roles  to the knowledge base.

Managers Users who perform administrative functions 
on the knowledge base.

Publish workflow The workflow for publishing the articles in the 
knowledge base.

◦ Knowledge - Instant Publish:  publishes 
articles in the knowledge base without 
requiring an approval.

◦ Knowledge - Approval Publish:  requests 
approval from the manager of the 
knowledge base before moving the articles 
to the published state.

Retire workflow The workflow for retiring the articles in the 
knowledge base.
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Field Description

◦ Knowledge - Instant Retire:  retires articles 
in the knowledge base without requiring an 
approval.

◦ Knowledge - Approval Retire:  requests 
approval from the manager of the 
knowledge base before moving the articles 
to the retired state.

Active Option to indicate that the knowledge base 
is active. If not selected, only users with the 
admin role or knowledge administrators can 
create, search for, or view its articles.

Description A short description to describe the 
knowledge base.

Set default knowledge field values Default configuration settings for the 
knowledge base.

Related products List of products related to the knowledge 
base content.

Auto-create translation tasks Option to enable creating translation tasks 
automatically after an article is published. If 
this option is selected, when a knowledge 
article is published in this knowledge base, 
translation tasks are automatically created for 
the configured languages.

This field appears only when the 
translation management feature and 
glide.knowman.translation.enable_translation_task 
property are enabled. For more information, 
see Translation management  and Knowledge 
Management properties.

Languages Languages enabled for the knowledge 
articles in this knowledge base.

If your system has more languages, use 
this option to select only those languages 
in which you want to translate knowledge 
articles in this knowledge base.

You can add more languages later. However, 
you can remove languages only when no 
knowledge articles exist in that language.

This field appears only when the 
translation management feature and 
glide.knowman.translation.enable_translation_task 
property are enabled. For more information, 
see Translation management  and Knowledge 
Management properties.

4. Right-click the form header and click Save.
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5. In the related list section, view or configure the following items related to the knowledge base:

Name Description

Knowledge List of knowledge articles stored in this 
knowledge base.

Can Read List of user criteria that grants read access 
and enables user matching the criteria to 
read articles in a knowledge base.

Note: 
It is recommended to assign 
appropriate user criteria to secure read 
access. See, Select user criteria for a 
knowledge base.

Can Contribute List of user criteria that grants contribute 
access and enables user matching the 
criteria to create and modify articles in a 
knowledge base.

Note: 
It is recommended to assign 
appropriate user criteria to secure 
contribute access. See, Select user 
criteria for a knowledge base.

Article Templates If you have activated the 
Knowledge Management Advanced 
(com.snc.knowledge_advanced) plugin, the 
Article Templates  related list is displayed.

If there are article templates in the related 
list, articles in that knowledge base can only 
be created using one of the article templates 
listed.

If the Article Templates  related list is empty, 
articles can be created using any article 
template.

Click Edit  to map article templates to the 
knowledge base.

Note: 
Admins, knowledge admins, and 
knowledge managers can edit the 
article templates for the knowledge 
base.

Featured Content List of knowledge articles that appear in the 
homepage Featured Content  section based 
on the corresponding keyword search set for 
each article.
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Name Description

Knowledge Categories List of knowledge categories associated with 
this knowledge base.

Note: 
If the category is marked as inactive 
then you can't associate articles to the 
category. However, it does not have any 
effect on the existing articles of that 
category.

6. Click Submit.

Related topics

Control access at the knowledge base level through user criteria

Explicit roles

Knowledge workflows

Knowledge Management properties

Create a custom knowledge homepage

I18N - Knowledge internationalization

Configure knowledge bases for a portal

Select which knowledge bases are displayed in a portal to view the associated knowledge 
articles. If no knowledge bases are configured, users can view articles from all knowledge bases 
in the portal.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Service Portal  > Portals.

2. Select the portal for which you want to enable search for the desired knowledge bases.

3. In the Knowledge Bases related list, click Edit.

4. On the Edit Members form, move the desired knowledge bases from the available items in the 
Collection  column to the Knowledge Bases List  column.

5. Click Save.

Related topics

Create a knowledge base

Configure knowledge subscriptions

Configure knowledge subscriptions by activating the Knowledge Management Advanced plugin 
and setting the subscription properties.

Before you begin
Ensure that the Knowledge Management Advanced plugin (com.snc.knowledge_advanced) is 
activated.
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Note: 
The Knowledge Management Advanced plugin activates the Subscriptions and Activity 
Feed Framework plugin (com.snc.activity_subscriptions).

Role required: knowledge_admin or admin

Procedure

1. Navigate to All  > Knowledge  > Administration  > Properties.

2. In the KM Subscription Properties  section, configure the following properties.

Property Description

Enable subscribe feature for KM

[glide.knowman.enable_km_subscription]

Enables or disables the Knowledge 
Management knowledge subscriptions 
feature.

List of roles (comma-separated) who can 
have subscription feature

[glide.knowman.enable_km_subscription.roles]

A comma-separated list of the roles that can 
use the knowledge subscriptions feature and 
subscribe to knowledge bases and articles.

List of workflow states (comma-separated) 
that can have subscription feature

[glide.knowman.enable_km_subscription.workflow_state]

A comma-separated list of the article states 
for which the knowledge subscription feature 
is available. The default states include Draft, 
Review, and Published.

3. Select Save.

Configuration tasks for knowledge managers

Having multiple knowledge bases allows an organization to spread management responsibilities 
across multiple users, known as knowledge managers.

As a knowledge manager, you can assign other managers, define category structures, configure 
which users can read and contribute articles, move and pin articles, and modify most fields on 
the Knowledge Base form. You can also approve the publishing or retiring of knowledge articles 
in those knowledge bases.

The primary manager of a knowledge base is the owner of that knowledge base. Each knowledge 
base must have one owner. There may be any number of additional managers for each 
knowledge base. The owner and all managers of a knowledge base automatically receive the 
knowledge_manager role. If the knowledge base is made inactive later, the knowledge_manager 
role is not automatically removed for these users.

Add a knowledge article to featured content

Add a knowledge article to appear in the Featured content section of the knowledge homepage 
and at the top of knowledge search results page.

Before you begin
Role required: knowledge_manager, knowledge_admin, or admin

About this task
Adding an article to featured content requires associating an article to specific keywords. You 
can search a keyword in the knowledge service portal or search results page to display articles in 
the Featured content section or at the top of the knowledge search results list.
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Note: 
The articles added to the Featured content section do not appear in the global search 
results and Virtual Agent conversations.

• To display articles in the Featured content section, add a default keyword in the 
glide.knowman.default_keyword  property Value  field and add the same keyword to all 
articles you want to display in that section.

• To display articles at the top of the knowledge search results list, add a list of keywords to each 
article you want to display at the top of the list (it is not applicable for AI search).

Procedure

1. Navigate to All  > Knowledge  > Knowledge Bases.

2. Select a knowledge base.

3. On the Knowledge form, click the Featured content related list.

4. Select New.

5. On the Knowledge keyword form, in the Knowledge field, search for and select the article.

6. In the Keywords field, click the unlock keywords icon ( ).

7. Select the lookup icon ( ) to open the Knowledge keywords  list.

8. Select the keyword to add for this article.

Note: 
If you're creating a new keyword, it must be a single word and cannot contain spaces.

9. Select the unlock keywords icon ( ) to add the keywords to the article.

10. Select Submit.

Result
The featured content on the knowledge service portal displays the article.

Define a knowledge article category

Each knowledge base has a hierarchy of categories that organizes the articles.

Before you begin
Role required: knowledge_admin, knowledge_manager, CanContribute  access to the knowledge 
base

About this task
Define a hierarchy for categories by creating parent-child relationships. Each hierarchy consists 
of a top-level category and a structure of subcategories, which are also named the child 
categories. The category hierarchy is saved in the Full category  field in the Knowledge Category 
[kb_category] table.

You can create and edit categories separately for each knowledge base.

Procedure

1. Navigate to All  > Knowledge  > Administration  > Knowledge Bases.

2. Select a knowledge base you manage.

3. Create a top-level category.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3268



a. In the Knowledge Categories related list, click New.

b. On the Knowledge Category form, fill in the fields.

Knowledge Category form

Field Description

Label Label for the category.

The label appears as the name of the category.

Value Value for the category you use when referencing the category in scripts.

Parent ID Top-level component associated with the category.

This field is automatically set to the top-level component ID.

Active Option to enable the category.

c. Click Submit.

4. Optional:  Create a child category.

a. Expand an existing category and click New  within the expanded section.

b. Fill in the Knowledge Category form.

c. Click Submit.

What to do next
In addition to using categories defined by a knowledge manager, knowledge contributors can 
add and edit categories when editing an article.

Related topics

Select a knowledge article category

Assign a knowledge base manager

You can assign users as managers of a knowledge base.

Before you begin
Role required: knowledge_admin, or admin

Procedure

1. Navigate to All  > Knowledge  > Knowledge Bases.

2. Select a knowledge base you manage.

3. In the Managers  field, click the unlock icon.

4. Add one or more users.

5. Click Update.
After you save the knowledge base record, users selected as managers automatically receive 
the knowledge_manager role if they do not have it already.
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What to do next
You can remove a knowledge base manager by removing that user from the Managers  field. If 
the user is not a manager of any other knowledge base, the knowledge_manager role is removed 
from that user.

Configure Self-Service Analytics

Configure the Self-Service Analytics  framework so you can use the generated metrics in a 
dashboard.

Before you begin
Role required: admin

About this task
Complete the following tasks to use the metrics generated by the Self-Service Analytics 
framework in a dashboard of an application:

Procedure

1. Activate Self-Service Analytics.

2. Configure activity contexts for Self-Service Analytics.

3. Configure pattern elements for Self-Service Analytics.

4. Configure pattern element groups for Self-Service Analytics.

5. Configure activity patterns for Self-Service Analytics.

6. Set up the deflection configuration for Self-Service Analytics.

7. Configure scheduled jobs for Self-Service Analytics.

Related topics

Self-Service Analytics dashboard for customer service

Activate Self-Service Analytics

Activate the Self-Service Analytics Core plugin (com.snc.self_service_analytics_core) if you have 
the admin role. This plugin activates related plugins if they are not already active.

Before you begin
Role required: admin

About this task
The Self-Service Analytics Core plugin provides the Self-Service Analytics  framework for 
configuring deflection contexts and activity patterns to collect the case reduction (deflection) 
metrics. The metrics are used in the Self-Service Analytics dashboard.

The Self-Service Analytics Core plugin activates these related plugins if they are not already 
active.

Plugins for Self-Service Analytics Core

Plugin Description

Subscriptions and Activity Feed 
Framework

[com.snc.activity_subscriptions]

Provides a generic set of artifacts to handle subscriptions 
for any defined subscribable object. Any entity can be 
defined as a subscribable object and a set of subscribers 
can subscribe to the objects. When a event occurs related 
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Plugins for Self-Service Analytics Core  (continued)

Plugin Description

to the subscribable object, activities can be tracked and 
subscribers can be notified.

Note: 
The Self-Service Analytics Core plugin is also installed when you activate the Platform 
Analytics Solution  for Self-Service Analytics for Customer Service. For more information, 
see Activate the Platform Analytics Solution  for Self-Service Analytics for Customer 
Service .

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.

Note: 
When domain separation and delegated admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .

Configure activity contexts for Self-Service Analytics

Define the type of activities you want to collect as Self-Service Analytics  data for a user entity 
such as consumers and customer contacts.

Before you begin
Role required: sn_ssa_core.self_service_manager

About this task
The activity types you add to an activity context are already predefined for use in applications 
that use the Subscriptions and Activity Feed Framework. This framework is available when you 
install the Subscriptions and Activity Feed Framework plugin (com.snc.activity_subscriptions). 
The plugin is activated when you activate the Self-Service Analytics Core plugin 
(com.snc.self_service_analytics_core).

Procedure

1. Navigate to All  > Self-Service Analytics  > Configuration  > Activity Context.

2. In the Activity Contexts list, search for and select the activity context for your user entity.

◦ For consumers, select Consumer.

◦ For customer contacts, select Contact.

◦ For user entities other than consumers and customer contacts, click New  to create another 
activity context.
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Note: 
To get the activity contexts Consumer and Contact by default, you must install Self-
Service Analytics for Customer Service (com.snc.pa.self_service_analytics_csm) plugin.

3. On the Activity Context form, verify the default field values for consumers and customer 
contacts, or fill in the values for a custom configuration.

Activity Context form

Field Description

Name Unique name for your activity context.

Context 
Table

Table that includes the user entity whose actions need to be tracked and 
displayed on the Self-Service Analytics  dashboard.

For example, if you want to track all actions for a customer contact, select the 
Contact [customer_contact] table. Similarly, if you want to track all actions for a 
consumer, select the Consumer [csm_consumer] table.​

Module Module associated with the application that stores the activities data.

Application Scope of the application. This field is automatically set based on the application 
scope selected in the application picker.

Domain Domain in which the activities records exist.

4. If you are creating a new activity context, click Submit  and then select the newly created 
activity context link from the Activity Contexts list.

5. In the Activity Context Groups related list, map an activity context with activity groups.

◦ For consumers and customer contacts, verify the default field values for an existing 
configuration.

◦ For user entities other than consumers and customer contacts, click New  to create another 
activity group or map with an existing activity group.

For a new activity group mapping, on the Activity Group form, fill in the fields and click Submit. 
In the Activity Context Groups related list, you then have to select the newly created activity 
group and add available activity types to the activity group.

Activity Group form

Field Description

Activity 
Context

Activity context associated with the activity group.

Activity 
Group

Option to search for and select an activity group.

Application Defines the scope of the application. This field is automatically populated 
based on the application scope.

Domain Domain in which the activities records exist.

6. In the Activity Context Types related list, map an activity context with an activity type.
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◦ For consumers and customer contacts, verify the default field values for an existing 
configuration.

◦ For user entities other than consumers and customer contacts, click New  to create another 
mapping or use an existing configuration.

For a new activity type mapping, on the Activity Source Context Mapping form, fill in the fields 
and click Submit.

Activity Source Context Mapping form

Field Description

Activity 
Context

Activity context associated with the activity source.

Context 
Table

Table that includes the user entity whose actions need to be tracked and 
displayed on the Self-Service Analytics dashboard.

This field is auto-populated based on the selected activity context.

Activity Type Activity type you want to associate with the activity context.

Source Table Table from which the data for the activity context is populated.

Filter Criteria Filter conditions applied on the source table.

Advanced 
Mapping

Option to enable advanced mapping of activity source and activity context.

You enter a script in the Advanced Mapping Script  field.

Advanced 
Mapping 
Script

Script to use if the source and context mapping is not sufficient. This field 
appears only when the Advanced Mapping  option is selected.

Module Module associated with the application that stores the activities data.

Application Scope of the application that contains the user entity. This field is 
automatically set based on the application scope selected in the application 
picker.

Domain Domain in which the activities records exist.

Fetch from 
Activities

Option to enable a business rule defined for an activity type.

7. On the Activity Context form, click Update.

What to do next
Configure pattern elements for Self-Service Analytics.

Configure pattern elements for Self-Service Analytics

Configure a pattern element to specify a single activity type and how many times it occurs. Each 
pattern element is implemented as regular expressions.

Before you begin
Configure activity contexts for Self-Service Analytics.

Role required: sn_ssa_core.self_service_manager
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About this task
By default, the system includes pattern elements for analyzing activity patterns within 
Knowledge, Catalog, Communities, or Virtual Agent self-service channels. These pattern 
elements are available with the Self-Service Analytics for Customer Service plugin 
[com.snc.pa.self_service_analytics_csm].

Procedure

1. Navigate to All  > Self-Service Analytics  > Configuration  > Pattern Element.

2. In the Pattern Elements list, modify an existing pattern element or click New  to create another 
pattern element.

3. On the Pattern Element form, fill in the fields.

Pattern Element form

Field Description

Name Name to identify the pattern element.

Activity 
Type

Activity type you want to associate with the pattern element.

Application Scope of the application that contains the user entity. This field is automatically 
set based on the application scope selected in the application picker.

Occurrence Frequency with which an activity should occur. An activity occurrence is one of 
the following types:

◦ Once: An activity must have occurred only once. For example, an article was 
marked with positive feedback only once.

◦ Optionally Once: An activity might not have occurred, but if it has, then it has 
occurred only once. For example, either no catalog request was created or 
only one was created.

◦ Optionally Many: An activity might not have occurred but if it has, then it has 
occurred multiple times. For example, either no catalog request has been 
created or multiple requests have been created.

◦ At Least Once: An activity has occurred at least once. For example, a 
community blog was viewed one or more times.

◦ Range: An activity has occurred as many times as is specified in a range. You 
specify a range using the Minimum  and Maximum  fields. For example, if you 
specify a range of 2 to 4 Virtual Agent  interactions, only 2, 3, or 4 interactions 
can have occurred.

Minimum Minimum occurrence of an activity. This field appears only when Range  is 
selected from the Occurrence list.

Maximum Maximum occurrence of an activity. This field appears only when Range  is 
selected from the Occurrence list.

4. Submit or update the pattern element.

◦ Click Submit  if you created a new pattern element.

◦ Click Update  if you modified an existing pattern element.

What to do next
Configure pattern element groups for Self-Service Analytics.
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Configure pattern element groups for Self-Service Analytics

Define a logical combination of two pattern elements, pattern element group, or both and how 
many times the combination occurs. Each pattern element group is implemented as regular 
expressions.

Before you begin
Configure pattern elements for Self-Service Analytics.

Role required: sn_ssa_core.self_service_manager

About this task
By default, the system includes pattern element groups for analyzing activity patterns within 
the Knowledge, Catalog, Communities, and Virtual Agent self-service channels. These 
pattern elements are available with the Self-Service Analytics for Customer Service plugin 
[com.snc.pa.self_service_analytics_csm].

Procedure

1. Navigate to All  > Self-Service Analytics  > Configuration  > Pattern Element Group.

2. Either configure an existing group or create a new group.

◦ Select an existing group in the Pattern Element Groups list.

◦ Create a new group by clicking New.

3. On the Pattern Element Group form, fill in the fields.

Pattern Element Group form

Field Description

Name Name to identify the pattern element group.

First 
Element

Conditional regular expression consisting of a pattern element or pattern 
element group.

Second 
Element

Another conditional regular expression consisting of a pattern element or 
pattern element group.

Application Scope of the application that contains the user entity. This field is automatically 
set based on the application scope selected in the application picker.

Operator Logical operator that returns the result of the combination of the first and 
second elements. Valid values are:

◦ And: Both the first and second elements are true.

◦ Or: Either the first or second element is true.

Occurrence Frequency with which a pattern element or pattern element group must occur.

An occurrence is one of the following types:

◦ Once: Must have occurred only once.

◦ Optionally Once: Might not have occurred but if it has, then it has occurred 
only once.

◦ Optionally Many: Might not have occurred but if it has, then it has occurred 
multiple times.
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Field Description

◦ At Least Once: Has occurred at least once.

◦ Range: Has occurred within a range. You specify a range using the Minimum 
and Maximum  fields.

Minimum Minimum occurrence of the result of the logical combination of the first and 
second elements. This field appears only when Occurrence is set to Range.

Maximum Maximum occurrence of the result of the logical combination of the first and 
second elements. This field appears only when Occurrence is set to Range.

4. Save the pattern element group settings.

◦ Save a new pattern element group by clicking Submit.

◦ Save the changes to an existing pattern element group by clicking Update.

What to do next
Configure activity patterns for Self-Service Analytics.

Configure activity patterns for Self-Service Analytics

Configure an activity pattern to combine the pattern element, pattern element group, or both for 
a user entity and link them to an outcome.

Before you begin
Configure pattern element groups for Self-Service Analytics.

Role required: sn_ssa_core.self_service_manager

About this task
By default, the system includes activity patterns for the activities Consumer created a case and 
Customer created a case. These pattern elements are available with the Self-Service Analytics 
for Customer Service plugin [com.snc.pa.self_service_analytics_csm].

Procedure

1. Navigate to All  > Self-Service Analytics  > Configuration  > Activity Pattern.

2. Either configure an existing activity pattern for your user entity or create a new one.

◦ Select an existing activity pattern in the Activity Patterns list.

◦ Create a new activity pattern by clicking New.

3. On the Activity Pattern form, verify the default field values for an existing activity pattern or fill 
in the values for a custom configuration.

Activity Pattern form

Field Description

Name Name to identify the activity pattern.

Description Summary of the activity pattern.

Primary 
Activity

Activity to be tracked in the activity sequence after a pattern matches with an 
outcome using the pattern recognition. An activity sequence is a stream of 
activities a user performs.

Outcome Result of an activity pattern.
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Field Description

Application Scope of the application that contains the user entity. This field is automatically 
set based on the application scope selected in the application picker.

Match If Pattern recognition using the Match If function to associate the pattern with an 
outcome.

For example, you can indicate that if the activity Consumer created a case is not 
found, you want to match it with the Confirmed Deflection outcome.

Domain Domain in which the activities records exist.

4. Click Submit  and then select the newly created activity pattern link from the Activity Patterns 
list.

5. In the Elements related list, select elements to map with the primary activity and use the Order 
column to decide the order of each element mapping.

◦ To use an existing element, select an element, modify the fields and click Update.

◦ To create another pattern element or pattern element group, click New  and select the type of 
element, fill in the fields on the form, and then click Submit.

An element can be a pattern element or pattern element group. For more information, see 
Configure pattern elements for Self-Service Analytics  and Configure pattern element groups 
for Self-Service Analytics.

In the Order  column, the following conditions apply:

◦ If there is only one matching table map, the system uses that map.

◦ If there are multiple matching table maps with the same order, the system uses the map with 
the older created date.

◦ If there are multiple matching table maps with different orders, the system uses the map with 
the highest order.

6. On the Activity Pattern form, click Update.

What to do next
Set up the deflection configuration for Self-Service Analytics.

Set up the deflection configuration for Self-Service Analytics

Associate a period of time with an activity context that defines how long a system will wait for a 
case to be created to match a deflection pattern.

Before you begin
Configure activity patterns for Self-Service Analytics.

Role required: sn_ssa_core.self_service_manager

Procedure

1. Navigate to All  > Self-Service Analytics  > Configuration  > Deflection Configuration.

2. In the Deflection Configurations list, search for and select the deflection configuration for your 
activity context.
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◦ For customer contacts, select Contact Case Deflection Configuration.

◦ For consumers, select Consumer Case Deflection Configuration.

◦ For user entities other than consumers and customer contacts, click New  to create another 
deflection configuration or modify an existing configuration.

3. On the Deflection Configuration form, verify the default field values for an existing 
configuration or fill in the values for a custom configuration.

Deflection Configuration form

Field Description

Name Name for your deflection configuration.

Activity 
Context

Type of activities for which you want to collect data. For more information, see 
Configure activity contexts for Self-Service Analytics.

Description Summary of the configuration.

Application Scope of the application that contains the user entity. This field is automatically 
set based on the application scope selected in the application picker.

Window Activity context window (duration) for tracking activities that match a deflection 
pattern.

Example: To track the create case activity for a consumer within a day, set the 
window as 1 day.

◦ If the consumer created a case within that window, the deflection pattern 
matched is not a deflection.

◦ If the consumer did not create a case within that window, the deflection 
pattern matched is a potential deflection.

◦ If the consumer did not create a case and the last activity is submitted 
positive feedback for any self-service channel content within that window, the 
deflection pattern matched is a confirmed deflection.

4. In the Deflection Patterns related list, add or modify existing deflection patterns to associate 
them with the deflection configuration or add a new pattern.
This related list appears only if a deflection configuration exists.

5. In the Deflection Metrics related list, add or modify an existing deflection metric table that 
stores the deflection data for an activity pattern associated with a deflection type.
This related list appears only if a deflection configuration exists. Alternatively, you can also 
configure a deflection metric table by navigating to Self-Service Analytics  > Deflection Metric.

6. On the Deflection Configuration form, click Update.

What to do next
Configure scheduled jobs for Self-Service Analytics.

Configure scheduled jobs for Self-Service Analytics

Schedule when to run the deflection configuration to generate the activities that match an 
activity pattern within an activity window.

Before you begin
Set up the deflection configuration for Self-Service Analytics.

Role required: admin
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About this task
You configure the duration of processing the deflection configuration for a user entity. This 
configuration is optional for consumers and customer contacts. The scheduled job captures 
data for Self-Service Analytics  and stores the generated data in the Deflection Metric 
[ssa_deflection_metric] table.

Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Configure the scheduled script processed for a user entity in a scheduled job.

◦ For consumers, select Deflection Analytics for Consumers.

◦ For customer contacts, select Deflection Analytics for Contacts.

◦ For user entities other than consumers and customer contacts, click New  and select 
Automatically run a script of your choosing  to create another scheduled job or modify an 
existing schedule job.

3. On the Scheduled Script Execution form, verify the default field values for consumers and 
customer contacts or fill in the values for a custom configuration.

Scheduled Script Execution form

Field Description

Name Name to identify the scheduled script execution.

Active Option to activate the script at the scheduled date and time. By default the job is 
inactive.

Run Type of schedule to execute the script on. Choices are:

◦ Daily

◦ Weekly

◦ Monthly

◦ Periodically

◦ Once

Day ◦ If you select Weekly  as the Run  value, the day of the week.

◦ If you select Monthly  as the Run  value, the day of the month.

Repeat 
Interval

If you select Periodically  as the Run  value, the duration between each script 
execution.

Note: 
This setting does not account for Daylight Savings Time changes. For 
example, if you select a period of one day, this adds 24 hours to the starting 
time of the job. If the start time was configured during a period with Daylight 
Savings Time, the job executes with a one hour offset on days when that 
time zone is not in Daylight Savings Time.

Time If you select Daily, Weekly, or Monthly  as the Run  value, the time of day, based 
on a 24-hour clock.

Starting Date and time of the first scheduled script execution.

Application Application that contains the script.
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Field Description

Conditional Option to run a scheduled job if certain conditions are met in the associated 
script.

Condition Conditional script that determines whether a scheduled job must run. The last 
expression of the script should evaluate to a Boolean (true or false) value. This 
field appears only when the Condition  check box is selected.

Run this 
script

Script to run at the scheduled date and time.

For a new scheduled script, copy the script from the existing script (Deflection 
Analytics for Consumers or Deflection Analytics for Contacts) and modify the 
deflectionAnalyticsService.captureDeflectionAnalytics('sys_ID') 
field value to include the sys_id of your deflection configuration record. For 
information about identifying the sys_id, see The unique record identifier 
(sys_id) .

4. Click Update  for consumers and customer contacts or Submit  to save a custom configuration.

Managing access to knowledge bases and knowledge articles

Determine whether certain users or categories of users can access knowledge bases and 
knowledge articles by controlling contribute and read access.

As a knowledge administrator, manager of a knowledge base, or owner of a knowledge base, 
you can assign user criteria to control contribute and read access at the knowledge base level, 
where:

• Read access determines the ability to view knowledge articles in a knowledge base.

• Contribute access determines the ability to create, modify, and retire knowledge articles in a 
knowledge base.

As a knowledge administrator, manager of a knowledge base, or owner of a knowledge base, you 
can assign user criteria, or roles, or both, to control read access at the knowledge article level.

Try to use only user criteria, which were introduced in Knowledge Management  v3, to control 
access to knowledge articles. Roles were used for this purpose in Knowledge Management  v2. If 
no user criteria is selected for a knowledge base, all users can read and all users with roles can 
contribute to that knowledge base.

Note: 
By default, when contribute access isn't provided for a knowledge base, a user must meet 
both roles and user criteria conditions for read access. However, you can override roles 
set for a knowledge article and provide access through user criteria only by setting the 
glide.knowman.search.apply_role_based_security  system property 
to false. Because this property isn't available by default, you must add it. For more 
information, see Add a system property .

User criteria for knowledge access

As a knowledge administrator, manager of a knowledge base, or owner of a knowledge base, you 
control access to knowledge bases or knowledge articles for a user through user criteria, which 
are described in the following table.
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User criteria definitions

User criteria Result

Cannot Contribute Cannot contribute (that is can't create, modify, or retire) 
knowledge articles within a knowledge base. The Cannot 
Contribute user criteria is available only for knowledge bases.

Can Contribute Can contribute (that is can view, create, modify, or retire) 
knowledge articles within a knowledge base. The Can 
Contribute user criteria is available only for knowledge bases.

Cannot Read
At the knowledge base level, cannot view knowledge articles 
within a knowledge base.

At the knowledge article level, cannot view a knowledge article.

Can Read
At the knowledge base level, can view knowledge articles 
within a knowledge base.

At the knowledge article level, can view a knowledge article.

The access to knowledge base and its articles are defined based on the user criteria status for a 
user as described in the following table.

Combining knowledge base and knowledge article user criteria

Status Access

The user matches both Can Contribute and 
Cannot Contribute at the knowledge base 
level

The user is denied contribute access to the 
knowledge base and its articles.

The user matches both Can Read and Cannot 
Read at the knowledge base level

The user is denied read access to the 
knowledge base and its articles.

The user matches Can Read at the knowledge 
base level and Cannot Read at the knowledge 
article level

The user is denied read access to the 
knowledge article.

The user matches Cannot Read and Can Read 
at the knowledge article level

The user is denied read access to the 
knowledge article.

Users with special knowledge privileges

Users with special knowledge privileges aren't evaluated based on user criteria and have 
knowledge bases and knowledge articles access as described in the following table.

Access of users with special privileges to knowledge bases and knowledge articles

User Access

Knowledge 
administrator

• Contribute to and read all knowledge bases and their articles.

• Modify the definition of all knowledge bases and assign user criteria 
to them.
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Access of users with special privileges to knowledge bases and knowledge articles 
(continued)

User Access

Note: 
This access doesn't apply to scoped knowledge bases. For more 
information, see Scoped knowledge bases.

Owner of a knowledge 
base

• Contribute to and read that knowledge base.

• Modify the definition of that knowledge base and assign user 
criteria to it.

Manager of a 
knowledge base

• Contribute to and read that knowledge base.

• Modify the definition of that knowledge base and assign user 
criteria to it.

Note: 
If the article versioning feature is enabled, the manager of 
a knowledge base can’t modify knowledge articles of other 
authors that are in the Draft  state. For more information, see 
Article versioning.

Members of an 
ownership group 
associated with a 
knowledge article

Read, modify, approve, and retire that knowledge article (see 
Ownership groups).

Explicit roles and user criteria

Explicit roles (snc_external and snc_internal) are added to your instance when your administrator 
installs a plugin, such as the Customer Service plugin (com.sn_customerservice), that also 
activates the Explicit Roles plugin (com.glide.explicit_roles). If you create a knowledge base with 
the Explicit Roles plugin (com.glide.explicit_roles) activated, the application automatically adds 
the following predefined user criteria at the knowledge base level:

• Users with 'snc_internal' role  – Added to the Can Read user criteria enabling only users with 
the snc_internal role have read access to the knowledge base.

• Users with snc_internal' and another role  – Added to the Can Contribute user criteria 
enabling only users with the snc_internal role and at least one additional role have contribute 
access to the knowledge base.

When you upgrade to product versions (from Rome  onwards) that offer the Explicit Roles plugin 
(com.glide.explicit_roles), the predefined user criteria Users with 'snc_internal' role  and Users 
with 'snc_internal' and another role  aren't automatically added to any existing knowledge bases 
created prior to the activation of the Explicit Roles plugin. To add these predefined user criteria 
to an existing knowledge base, run the Fix unsecured knowledge bases  fix script. For 
more information about explicit roles and fix scripts, see Explicit Roles  and Fix scripts .
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Determining contribute access to a knowledge base and its articles using user 
criteria

The flowchart in this section illustrates the user criteria checks that determine contribute access 
at the knowledge base and article levels.

Note: 
In order for an unauthenticated user to view knowledge articles within the knowledge base, 
ensure that the audience for the Knowledge Management Service Portal pages is set to 
public; that is, the page can be accessed without the need for authentication. For more 
information, see Create and edit a page using the Service Portal Designer .

Contribute access to a knowledge base and its article flowchart

When either Cannot Contribute isn’t set or a user doesn’t match 
Cannot Contribute and additionally Can Contribute is not set, the 
glide.knowman.block_access_with_no_user_criteria  property value is further 
evaluated to determine contribute access, as explained in the following table.

Contribute access to a knowledge base when user criteria for a knowledge base aren't set

Property 
value

Result

true No user has contribute access to the knowledge base except users with special 
knowledge privileges.

false All users, including unauthenticated users, with at least one role can contribute to the 
knowledge base.

If the Explicit Roles plugin (com.glide.explicit_roles) is activated, users who have at 
least one role other than snc_internal can contribute to the knowledge base.
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Contribute access to a knowledge base when user criteria for a knowledge base aren't set 
(continued)

Property 
value

Result

To check knowledge bases accessible to unauthenticated users, use the User Criteria 
Diagnostics feature. For more information, see Configure access to knowledge bases 
for unauthenticated users.

When a user has contribute access to a knowledge base, the 
glide.knowman.apply_article_read_criteria  property is evaluated to determine 
contribute access to an article in the knowledge base, as explained in the following table.

Contribute access to an article when a user has contribute access to a knowledge base

Property 
value

Result

true Article-level read access overrides the default contribute permission granted by 
contribute access at the knowledge base level.

false Contribute access at the knowledge base level takes precedence over article-level 
user criteria and the user has contribute access to every article in the knowledge 
base.

Determining read access to articles in a knowledge base using user criteria

The following flowchart illustrates the user criteria checks that determine read access to a 
knowledge article.
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Read access to a knowledge article flowchart

When either Cannot Read isn’t set or a user doesn’t match Cannot Read and additionally Can 
Read is not set, the glide.knowman.block_access_with_no_user_criteria 
property value is further evaluated to determine read access, as explained in the following table.

Read access when user criteria for a knowledge base aren't set

Property 
value

Result

true No user has read access except users with special knowledge privileges  and users 
who have contribute access to the knowledge base.

false All users, including unauthenticated users, have read access to the knowledge base 
and the article-level user criteria are further evaluated.

To check knowledge bases accessible to unauthenticated users, use the User Criteria 
Diagnostics feature. For more information, see Configure access to knowledge bases 
for unauthenticated users.

When a user has contribute access to a knowledge base, the 
glide.knowman.apply_article_read_criteria  property is evaluated to determine 
read access to an article in the knowledge base, as explained in the following table.
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Read access to an article when a user has contribute access to a knowledge base

Property 
value

Result

true Article-level read access overrides the default read permission granted by contribute 
access at the knowledge base level.

false Contribute access at the knowledge base level takes precedence over article-level 
user criteria and the user has read access to every article in the knowledge base.

Important: 
After you add user criteria, you can use the user criteria diagnostics feature to verify the 
access that users have to a knowledge base or a knowledge article. For more information, 
see User criteria diagnostics for Knowledge Management.

Related topics

Knowledge Management properties

Configuration tasks for knowledge managers

Knowledge Management FAQ

Create user criteria for controlling access to knowledge bases and articles

Create user criteria for controlling access to knowledge bases and articles

Control access to knowledge bases and articles by creating user criteria.

Before you begin
Role required: user_criteria_admin

Note: 
To create a user criteria record from the Knowledge module, you must have the 
user_criteria_admin role in addition to the knowledge role. For more information about 
access, see Managing access to knowledge bases and knowledge articles.

Procedure

1. Navigate to All  > Knowledge  > Administration  > User Criteria.

2. Click New.

3. On the User Criteria form, fill in the fields.

User Criteria form

Field Description

Name Unique name of the user criteria.

Users Users that must match the user criteria.

Groups Groups that must match the user criteria.

Roles Roles to match the user criteria.
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Field Description

Note: 

◦ Because the evaluation of a role is cached in the session, any change 
in the role requires you to log in again.

◦ User criteria are not applicable for elevated privilege roles.

Advanced Option to display or hide the advanced option that includes the Script  field on 
the User Criteria form.

Script Script to define any additional user criteria that returns true or false. This field 
is available when the Advanced  option is selected on the User Criteria form.

Note: 

◦ A script is evaluated in the scope that the user criteria are created in.

◦ The evaluation of a script is cached in the session, so any change in 
the evaluation requires you to log in again. If a scripted user criterion 
is defined for a knowledge base, user access to knowledge bases is 
evaluated once per session. If the script results in changes after a 
session cache is built, the result takes effect in the next session.

◦ Don’t use gs.getUser()  or other session APIs because they cause 
conflicts when used in diagnostic tools. Use the predefined user_id 
variable available in the script to get the user ID of the user being used 
to evaluate the script.

◦ Scripts are evaluated dynamically. Therefore, including scripts in a 
user criteria can impact performance.

Active Option to activate or deactivate the user criteria.

Companies Companies that the user record must match.

Locations Locations that the user record must match.

Departments Departments that the user record must match.

Match All Option to determine whether all elements from each populated user criteria 
field must match. If selected, only users who match all user criteria are given 
access. If cleared, the user must meet one or more of the set user criteria to be 
given access.

By default, this check box is cleared so that any condition met provides a 
match.

For example, consider a user criteria record for the following:

◦ Locations A or B

◦ Company C or D
With Match All  selected, only users that meet all of these conditions are 
matched. For example, a user with a location A and a company C.

If Match All  isn’t selected, users meeting any of these conditions are 
matched. For example, a user with a location B.
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Field Description

Note: 
If you select Match All, ensure that you don't create contradictory 
conditions that can never be met. For example, if all users in location A 
work for company G, the conditions in this example can never be met.

4. Click Submit.

Related topics

Control access at the knowledge base level through user criteria

Control access at the knowledge article level through user criteria

Control access at the knowledge base level through user criteria

You specify user criteria for a knowledge base to control which users are granted access to read 
and contribute knowledge articles to that knowledge base.

Before you begin
Role required: knowledge_manager, knowledge_admin, or admin

Note: 
To administer a scoped knowledge base, you must have the application-specific admin 
role in addition to the knowledge_admin or admin role. For more information, see Scoped 
knowledge bases.

About this task
You can assign user criteria to control read or contribute access. For example, you could enable 
all users in your Support department to have contribute access to a knowledge base by creating 
a user criteria record with the required department set to Support, and then including the user 
criteria record in the Can Contribute user criteria. For more information, see Managing access 
to knowledge bases and knowledge articles. Try to use only user criteria, which were introduced 
in Knowledge Management v3, to control access to knowledge bases. Roles were used for this 
purpose in Knowledge Management v2.

Note: 

Starting with the Washington DC  release, the Knowledge Management  v3 
homepage (com.snc.knowledge3) is being prepared for deprecation in the 
future Y release. It is replaced by the Knowledge Management  Service Portal 
(com.snc.knowledge_serviceportal), which is active by default for customers on Madrid 
and later releases. For more information about the new experience, see Knowledge 
Management Service Portal homepage features.

Procedure

1. Navigate to All  > Knowledge  > Administration  > Knowledge Bases.

2. Click the link to knowledge base you manage.

3. Add user criteria to the knowledge base.
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a. Depending on the user criteria you want to set, select one or more of the relevant related 
lists.

Related list Description

Can Read Users can read knowledge articles in the 
knowledge base.

Cannot Read Users can't read knowledge articles in the 
knowledge base.

Can Contribute Users can create, modify, and retire 
knowledge articles in a knowledge base. 
Contribute access to a knowledge base also 
provides read access to all articles in the 
knowledge base.

Cannot Contribute Users can't create, modify, retire, or read 
knowledge articles in the knowledge base.

Note: 
If the related lists aren't visible, configure the Knowledge form to display them. For more 
information, see Add a related list to a form .

b. In the selected related list, add the required user criteria.

▪ As a user with the admin role, to add a new user criteria record, click New, specify the 
required fields, and then click Submit.

▪ As a user with the knowledge_manager, knowledge_admin, or admin role, to add an 
existing user criteria record, click Edit, move the required user criteria from the Collection 
column to the Knowledge  column, and then click Save.

4. On the Knowledge Base form, click Update.

What to do next
After you add user criteria, you can use the user criteria diagnostics feature to verify the access 
that users have to a knowledge base or a knowledge article. For more information, see User 
criteria diagnostics for Knowledge Management.

Important: 
After making user criteria additions or changes, you may need to log out and log back in to 
clear the prior configuration.

Related topics

Create a knowledge base

Create user criteria for controlling access to knowledge bases and articles

Control access at the knowledge article level through user criteria

Control access at the knowledge article level through user criteria

You specify user criteria for a knowledge article to control which users are granted read access to 
the knowledge article.

Before you begin
Role required: knowledge_manager, knowledge_admin
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Note: 
You may need to configure the form to add Can Read  and Cannot Read  fields.

About this task
Try to use only user criteria, which were introduced in Knowledge Management v3, to control 
access to knowledge articles. Roles were used for this purpose in Knowledge Management v2. 
For more information, see Managing access to knowledge bases and knowledge articles.

Note: 

Starting with the Washington DC  release, the Knowledge Management  v3 
homepage (com.snc.knowledge3) is being prepared for deprecation in the 
future Y release. It is replaced by the Knowledge Management  Service Portal 
(com.snc.knowledge_serviceportal), which is active by default for customers on Madrid 
and later releases. For more information about the new experience, see Knowledge 
Management Service Portal homepage features.

Procedure

1. Open a knowledge article.

Note: 
You can update only the latest version of the knowledge article.

2. Assign access based on user criteria.

Note: 
If the Can Read  and Cannot Read  fields aren't visible, configure the Knowledge form to 
display them. For more information, see Configuring the form layout .

3. On the Knowledge form, click Update, and then click Publish  to apply the changes.

What to do next
After you add user criteria, you can use the user criteria diagnostics feature to verify the access 
users have to a knowledge base or a knowledge article. For more information, see User criteria 
diagnostics for Knowledge Management.

Important: 
After making user criteria additions or changes, you may need to log out and log back in to 
clear the prior configuration.

Related topics

Create user criteria for controlling access to knowledge bases and articles

Control access at the knowledge base level through user criteria

Configure Knowledge Management - Add-in for Microsoft Word

Configure the Knowledge Management - Add-in for Microsoft Word to author and access 
knowledge articles in Microsoft  Word.

Before you begin
Complete the following tasks to use the Knowledge Management - Add-in for Microsoft Word.
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Procedure

1. Activate Knowledge Management - Add-in for Microsoft Word.

2. Deploy Knowledge Management - Add-in for Microsoft Word.

3. Configure the security for Knowledge Management add-in for Microsoft Word.

4. Optional:  Enable downloading of the source Microsoft Word document for a knowledge 
article.

Related topics

Authoring a knowledge article in Microsoft Word

Activate Knowledge Management - Add-in for Microsoft Word

Activate the Knowledge Management - Add-in for Microsoft Word plugin 
(com.snc.knowledge.ms_word) if you have the admin role. This plugin activates related plugins if 
they are not already installed.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.

Note: 
When domain separation and delegated admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .

Deploy Knowledge Management - Add-in for Microsoft Word

Deploy the Knowledge Management - Add-in for Microsoft Word for authoring knowledge articles 
from within the Microsoft  Word.

Before you begin
In addition to having one of the following roles on the ServiceNow  instance, you must be an 
Office365 administrator to deploy the Knowledge Management - Add-in for Microsoft Word.

Role required: admin, sn_outlook_addin.outlook_addin_setup

Procedure

1. Navigate to All  > ServiceNow Add-Ins for Office  > Office Add-In-Manifests.

2. In the Add-In Name column, click Knowledge Management.

3. Click Download Manifest  to download the add-in manifest file to your desktop.
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Note: 
For releases prior to the Paris Patch 3 release, the downloaded manifest reports 
validation errors in Office 365. For more information about resolving such errors, see 
the Enabling Knowledge MS-Word add-in fails validation [KB0858357]  article in the HI 
knowledge base.

4. Deploy the Knowledge Management- Add-in for Microsoft Word.
For more information, see Deploy add-ins in the admin center .

Related topics

Import a Word document to a knowledge base

Import a Word document to a knowledge base using Knowledge Management v3

Configure the security for Knowledge Management add-in for Microsoft Word

Use the sn_km_word.glide.knowman.word.xframe  property to specify all the parent 
domains in the Microsoft  Word Online application in which Knowledge Management - Add-in for 
Microsoft Word is embedded.

Before you begin
Ensure that you have activated the Knowledge Management - Add-in for Microsoft Word plugin 
and the application scope is set to Knowledge Management - Add-in for Microsoft Word.
Role required: admin

About this task
The domains you specify for the Microsoft  Word application in the 
sn_km_word.glide.knowman.word.xframe  property are used for setting the x-frame-
options  and content-security-policy  headers. These settings securely display the Knowledge 
Management add-in for Microsoft Word in the online version of Microsoft  Word documents.

Note: 
If you don't set the sn_km_word.glide.knowman.word.xframe  correctly, the 
Knowledge Management - Add-in for Microsoft Word fails to load in the Word document. For 
more information about resolving such errors, see the Knowledge Word Office Manifest fails 
validation [KB0860916]  article in the HI knowledge base.

Procedure

1. In the navigation filter, enter sys_properties.list.

2. Search for the sn_km_word.glide.knowman.word.xframe  property.

3. In the Value  field, enter a domain.
For multiple entries, separate the domains with commas.

For example, to enter the Microsoft SharePoint  and Microsoft OneDrive  domains: 
https://sitename.sharepoint.com,https://sitename-
my.sharepoint.com,https://word-edit.officeapps.live.com

4. Click Update.

Enable downloading of the source Microsoft  Word document for a knowledge article

Set the sn_km_word.glide.knowman.enable_document_download  property to 
enable users to download the source Microsoft  Word document of a knowledge article from the 
knowledge article view page in a portal or workspace.
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Before you begin
Role required: admin

About this task
When a knowledge article is created using Microsoft  Word, users accessing the knowledge 
article view page in a portal or workspace can download the source Microsoft  Word document 
when the sn_km_word.glide.knowman.enable_document_download  property is set 
to true.

Note: 
After you enable the 
sn_km_word.glide.knowman.enable_document_download  property, the 
Microsoft  Word source document of a knowledge article also might appear in search results 
as an attachment to the article. Therefore, enabling this property might affect the search 
relevancy of a knowledge article.

Procedure

1. In the navigation filter, enter sys_properties.list.

2. Search for the sn_km_word.glide.knowman.enable_document_download 
property.

3. In the Value  field, enter true.

4. Click Update.

User criteria diagnostics for Knowledge Management

Manage user access to a knowledge base or an article using user criteria diagnostics. 
Understand what access users have to a knowledge base or an article and determine which user 
criteria define those permissions.

User access to a knowledge base or an article can be restricted based on:

• Domain separation

• Access control list (ACL) rules

• Knowledge workflows

• User criteria set for a knowledge base  or an article

This feature considers domain separation and user criteria to determine the user access to 
knowledge bases and articles.

Activation information

The user criteria diagnostics feature is activated with the Knowledge Management v3 plugin 
(com.snc.knowledge3). For more information, see Activate a plugin .

Note: 

Starting with the Washington DC  release, the Knowledge Management  v3 
homepage (com.snc.knowledge3) is being prepared for deprecation in the 
future Y release. It is replaced by the Knowledge Management  Service Portal 
(com.snc.knowledge_serviceportal), which is active by default for customers on Madrid 
and later releases. For more information about the new experience, see Knowledge 
Management Service Portal homepage features.
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Diagnose user access to a knowledge base

Identify which users have access to a knowledge base and what enables that access.

Before you begin
Role required: knowledge_manager, knowledge_admin, or admin

Procedure

1. Access the User Criteria Diagnostics  landing page using one of these options:

To access Navigate to

Using the application 
navigator

Knowledge  > Administration  > User Criteria Diagnostics

From a knowledge base a. Knowledge  > Administration  > Knowledge Bases.

b. Select the knowledge base to diagnose user access.

c. In the Related Links  section, click Run User Criteria 
Diagnostics.

The User Criteria Diagnostics  landing page appears with the 
Select knowledge base  field pre-populated.

2. To diagnose user access:

a. In the Select user  field, select a user.

b. From the Select record type  choice list, select Knowledge base.

c. In the Select knowledge base  field, select a knowledge base.
Every time you select a different user, record type, or knowledge base, the page refreshes 
and displays data for the selected user.

d. Click Diagnose.
The page displays these details:

▪ Whether the user has access to the knowledge base based on their domain. Only system 
administrators can view domain information and change the domain to give access to a 
user.

▪ Which user criteria provides read or read and contribute access for this user to the 
knowledge base and what type of user criteria definition  enables this access.

▪ Whether a role that the user has (knowledge_manager, knowledge_admin, or owner of the 
knowledge base) enables this access.

▪ For a user with no access to this knowledge base, which user criteria may be modified to 
grant the access.

Example:
The following image shows an example of a diagnosis where the user Alene Reback does not 
have access to the IT knowledge base.

Alena can get access to the knowledge base if:
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• Alena is added to one of the existing user criteria defined in the knowledge base.

• Alena is added to a new user criteria that is defined and added to the knowledge base.

Click the IT knowledge base link and provide the access by adding Alena to a user criteria for 
this knowledge base.

Diagnose user access to an article

Identify which users have access to an article and what enables that access.

Before you begin
Role required: knowledge_manager, knowledge_admin, or admin

Procedure

1. Access the User Criteria Diagnostics  landing page using one of these options:

To access Navigate to

Using the application 
navigator

Knowledge  > Administration  > User Criteria Diagnostics.

From an article a. Knowledge  > Administration  > Knowledge Bases.

b. Select the knowledge base that has the article to diagnose 
for user access.
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To access Navigate to

c. In the Knowledge  related list, select the article.

d. In the Related Links  section, click Run User Criteria 
Diagnostics.

The User Criteria Diagnostics  landing page appears with the 
Select article  field pre-populated.

2. To diagnose user access:

a. In the Select user  field, select a user.

b. From the Select record type  choice list, select Article.

c. In the Select article  field, select an article.
Every time you select a different user, record type, or knowledge base, the page refreshes 
and displays data for the selected user.

d. Click Diagnose.
The page displays these details:

▪ Whether or not the user has access to the knowledge article based on their domain. 
Only system administrators can view domain information and change the domain to give 
access to a user.

▪ Which user criteria provides read or read and contribute access for this user to the article 
and what type of user criteria definition  enables this access.

▪ Whether a role of the user has (knowledge_manager, knowledge_admin, or owner of the 
knowledge base) enables this access.

▪ For a user with no access to this article, which user criteria may be modified to grant the 
access.

Note: 
Members of an ownership group are automatically given Can Contribute  access to 
knowledge articles that their ownership group is associated with.

Example:
The following image shows an example of a diagnosis where the user Adela Cervantsz has read 
access to the KB article, KB0000001 v5.0, in the IT knowledge base because Adela belongs to 
one of the Can Read  user criteria defined in the knowledge base.
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Configure access to knowledge bases for unauthenticated users

Identify knowledge bases accessible to unauthenticated users based on the user criteria and the 
system property settings.

Before you begin
You must activate the Knowledge Management v3 plugin (com.snc.knowledge3).

Role required: knowledge_manager, knowledge_admin, or admin

Note: 

Starting with the Washington DC  release, the Knowledge Management  v3 
homepage (com.snc.knowledge3) is being prepared for deprecation in the 
future Y release. It is replaced by the Knowledge Management  Service Portal 
(com.snc.knowledge_serviceportal), which is active by default for customers on Madrid 
and later releases. For more information about the new experience, see Knowledge 
Management Service Portal homepage features.

Procedure

1. Navigate to All  > Knowledge  > Administration  > User Criteria Diagnostics.

2. Click the View knowledge bases accessible to unauthenticated users  related link.

3. Review knowledge bases accessible to unauthenticated users.

4. Optional:  Restrict unauthenticated users to access a knowledge base by selecting the 
knowledge base and configuring its access settings.
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◦ Use user criteria to determine access to the knowledge base for unauthenticated users.

(Optional) For more information, see Managing access to knowledge bases and knowledge 
articles.

◦ If no user criteria is specified for the knowledge base, as an administrator, you can set the 
value of the glide.knowman.block_access_with_no_user_criteria  system 
property to true.

For more information, see Knowledge Management properties.

Collect knowledge usage metrics

Capture metrics such as article views, page views, and portal searches to track aggregated 
knowledge usage by users.

Before you begin
Set the duration over which the metrics are aggregated through the 
glide.knowman.usage_metrics_duration  property. For more information, see Other 
knowledge properties. By default, the property value is set to 60 minutes.

You must activate the Knowledge Management v3 plugin (com.snc.knowledge3).

Role required: admin

About this task
Monitor the knowledge usage metrics to improve the overall effectiveness of the knowledge 
usage across the portals.

Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Search and open the Knowledge Usage Metrics  scheduled job.

3. In the Knowledge Usage Metrics  form, select the Active  check box to activate the scheduled 
job.
The scheduled job is inactive by default.

4. In the Run  field, select Periodically  as the frequency of the scheduled job.
See the Scheduled jobs  topic for other frequency options.

5. In the Repeat Interval  field, enter the repeated time interval at which the scheduled job should 
run.
By default, the duration is set to 60 minutes.

6. Click Update.

What to do next
Modify the data retention policy for knowledge usage metrics  to remove unwanted and older 
data from the knowledge usage metrics [kb_usage_metrics] table.

Modify the data retention policy for knowledge usage metrics

Remove unwanted and older data from the knowledge usage metrics [kb_usage_metrics] table 
through the data retention policy.

Before you begin
Role required: maint and admin
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About this task
Activating the data retention policy for the kb_usage_metrics table deletes records that you no 
longer need.

Procedure

1. Navigate to All  > System Maintenance  > Table Cleanup.

2. In the Tablename  column, search for kb_usage_metrics  and click the kb_usage_metrics 
link.

3. On the Auto Flush form, activate the kb_usage_metrics table cleanup job by selecting the 
Active  check box.

4. Optional:  Adjust the duration the system waits before deleting the records by modifying the 
value in the Age in seconds  field.
By default, the Age in seconds  field value is set to 2,592,000 seconds (equivalent to 30 days). 
For more information, see Autoflush form .

5. Click Update.

Configure knowledge article templates

Configure knowledge article templates to customize and display content as per your 
requirements.

Create an article template and use it to create a knowledge article

Create new article templates in addition to the pre-defined templates. Add new fields based on 
how you want to customize and display your content.

Before you begin
You must activate following plugins:

• Knowledge Management Advanced (com.snc.knowledge_advanced)

• Knowledge Management Advanced Installer (com.snc.knowledge_advanced.installer)

Role required: knowledge_admin or admin

About this task
For each new article template, a child table of the Knowledge [kb_knowledge] table is created. 
When you add a new field to the template, a new column is added to that table created for the 
template.

Procedure

1. Navigate to All  > Knowledge  > Administration  > Article Templates, and click New.

2. On the Article Template form, fill in fields.

Article Template form

Field Description

Name Name for the article template. The name can 
contain only lowercase, alphanumeric ASCII 
characters and underscores (_).

Description Description for the article template.

Note: 
The Active  check box is selected by default making the template available for use.
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3. Right-click the form header and click Save.

4. In the Article Templates Field related list, add fields to the template.

a. Click New.

b. On the Article Template Field form, fill in the fields.

Article Template Field form

Name Description

Field Name Title to display on the template form.

Field Type Available field types:

▪ HTML

▪ String

▪ Integer

▪ Date

▪ Date and time

Order Position of the field in the article page view 
and the article edit view.

Article Template (Read-only) Name of the article template 
associated with this field.

Template Table (Read-only) Name of the table for this 
template.

Template Field (Read-only) Name of the template column 
associated with this field.

Mandatory Option to make this field as mandatory. 
When selected, this field is required to be 
filled.

Expand/Collapse Defines whether the template field displays 
as collapsed or expanded by default.

Active Option to display the field on the template.

Heading style CSS formats applied to the template header. 
For example, to display the background 
of the template header in red, with a 
24-px font size, Arial font family, and 
white text color, enter the following code: 
background-color:red; font-
size:24px; font-family:Arial; 
color:white;

Field style CSS formats applied to the template fields. 
Any CSS format applied at the field level 
is automatically applied to the header if 
not already specified in the Heading style 
field. For example, to display the 300px 
page width, 25px solid green border, 25px 
padding, and 25px page margin, enter 
the following code: width:300px; 
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Name Description

border:25px solid green; 
padding:25px; margin:25px;

Preview text Preview text displayed on the article 
template selector. Empty value will display 
random text.

c. Click Submit.

The field is added to the template.

5. Optional:  In the SEO Description Tag  field, search for and add article template field name.
The content in this field is used as meta description tags to search for articles created using 
this article template.

6. Configure the Knowledge form to display the fields that you added to the template.

a. Navigate to Knowledge  > Articles  > Create New.

b. Select a knowledge base, and then the newly added article template.

c. Right-click the header and select Configure  > Form Layout.

d. Select and move the fields you added to the article template from the Available  column to 
the Selected  column.

e. Click the up or down icon to arrange the fields in the order in which you want them to appear 
in the Knowledge form.

f. Click Save.

Note: 
Authors who started a session before a template was created or activated will see the 
newly added template upon their next login.

What to do next
If you want to search for duplicate articles when creating an article from a new template, you 
must configure the article template table for contextual search. On the Table Configuration 
form, the Search context  field must be set to Knowledge ML Search. For more information, see 
Configure table for a contextual search .

Configure the preview text setting for a standard article template

Configure the preview text setting to customize the default preview text for a standard article 
template.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Definition  > Script Includes.

2. On the Script Includes page, in the Name  field, enter ArticleTemplateUtilSNC.

3. Open the ArticleTemplateUtilSNC record.

4. On the ArticleTemplateUtilSNC page, copy the following code from the Script  field.

setPreviewTextForStandardArticle: function(){
              return null;
       },
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5. On the Script Includes page, in the Name  field, enter ArticleTemplateUtil.

6. Open the ArticleTemplateUtil record.

7. On the ArticleTemplateUtil page, modify the code in the Script  field by pasting the copied code 
as shown.

var ArticleTemplateUtil = Class.create();
                 ArticleTemplateUtil.prototype = 
 Object.extendsObject(ArticleTemplateUtilSNC,{
                 type: 'ArticleTemplateUtil',
      setPreviewTextForStandardArticle: function(){
                         return null;
                 },
                 });

8. In the Script  field, remove null  and enter a preview text.

9. Select Update.

Result
The modified preview text displayed on the standard article template selector.

Example:
The following code is modified to show custom preview text. You can also include HTML tags to 
modify the appearance of preview text.

var ArticleTemplateUtil = Class.create();
                 ArticleTemplateUtil.prototype = 
 Object.extendsObject(ArticleTemplateUtilSNC,{
                 type: 'ArticleTemplateUtil',
      setPreviewTextForStandardArticle: function(){
                         return 'Demo for standard article';
                 },
                 });

Restrict access to fields in an article template

Use encryption modules to set field-level security in article templates and display the fields 
based on role permissions.

Before you begin
Role required: security_admin

Note: 
Use Knowledge blocks to restrict the content within the same field. For more information, 
see Knowledge blocks.

Procedure

1. Create an encryption module for the article template field to be encrypted.
See Create a cryptographic module  for details.

2. Associate the article template field with the encryption module.
See Encrypting fields and attachments  for details.

a. Navigate to System Security  > Field Encryption  > Encryption Field Configurations  and click 
New.

b. On the form, fill in the fields.
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Encrypted Field Configuration form

Field Description

Table Table associated with the article template fields. For example, for the How to 
article template fields, select How To [kb_template_how_to].

Column Article template field to be encrypted. Only String, Date, Date/Time, and URL 
fields are supported.

▪ String and URL fields: You can add a new encryption configuration to either 
a parent table or a child table.

▪ Date and Date/Time fields: You can create encrypted field configurations to 
encrypt existing Date and Date/Time fields. You can add a new encryption 
configuration to a parent table only. You cannot add a new encryption 
configuration to a child table.

Note: 
Depending on the number of records affected by the Date and 
Date/Time fields you are encrypting, it may take up to a few minutes 
to create the encryption configuration. Make sure that you create 
the encryption configuration for Date and Date/Time fields when 
transaction volume on the instance is low.

Encryption 
module

Encryption module you created for the article template field.

Method ▪ Single Encryption Module: Enables data to be encrypted with a single 
encryption module only. The field is encrypted with the encryption module 
defined in the Encryption module  field. Users that do not have the 
encryption module cannot view or update field values.

▪ Multiple Encryption Module: Enables data to be encrypted with more than 
one encryption module. The field is encrypted by the encryption context 
of the first user to enter data. If the user has multiple encryption modules, 
the context defined in the encryption module selector is used. Because 
the encryption module is set on a per record basis, fields in a list can have 
different encryption modules. However, within a single record, the field can 
be encrypted by only one module.

Note: 
Mass encryption is not available when using the Multiple Encryption 
module  method.

After a configuration is created using the single encryption module method, 
you can update the record to use multiple encryption modules. However, 
you cannot change a field using multiple encryption modules to use a single 
encryption module.

c. Click Submit.

3. Define role permissions for the encrypted field.

a. Navigate to User Administration  > Roles.

b. In the Name  column, click the link to the role you want to allow to view this field.
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c. In the Encrypted context  field, search for and select the name of the encryption context for 
the article template field to apply for the selected role.

Note: 
You may need to configure the Role form to add the Encrypted context  field.

d. Click Update.

Result
Depending on their role permissions defined for the encrypted field, users can view the field on 
the article template.

Related topics

Encryption support

Generate SEO information for articles using article templates

Improve the searchability of knowledge articles by using the content in an article template field 
to generate SEO tags for articles created using that template. Search Engine Optimization (SEO) 
optimise searches in public search engine.

Before you begin
Role required: knowledge_admin or admin

About this task
Note: 
If you are using the Standard  article template, the content of the Text field is used to 
generate the tags.

You can define the number of characters to be used as tags in the 
glide.knowman.seo.pages.meta_description.length  system property.

Procedure

1. Navigate to All  > Knowledge  > Administration  > Article Templates.

2. Select an article template.

3. In the SEO Description Tag  field, search and select an article template field.
The content in this field is used as meta description tags to search for articles created using 
this article template.

4. Click Update.
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Note: 
You can change which article template field is used for generating SEO. Changes are 
applied only to knowledge articles created or updated after the change was made. To 
apply the update to all existing published articles created using this template, run the 
Populate Meta Description on KB Articles  fix script.

Article template page

Integration with external knowledge sources

Use the external content integration feature to integrate content from various external sources 
and enable unified knowledge search results.

Users store and manage knowledge using various external sources and search each source 
separately for relevant results. External content integration enables acquiring and searching all 
WebDAV-compliant source content from a single location. This provides users with a seamless 
search experience across multiple knowledge sources and drives more usage to the platform.

Using this feature, knowledge administrators can define the external content to be imported 
into a knowledge base and periodically run a job to import the content. Knowledge users have a 
seamless user experience searching for relevant content across multiple knowledge sources.

Activate the External Content Integration plugin

The External Content Integration feature is activated with the Knowledge Management - External 
Content Integration plugin (com.snc.knowledge.external_integration).

Before you begin
Role required: admin
The Knowledge Management - External Content Integration plugin is not active by default.

The following plugins are automatically activated when the Knowledge Management - External 
Content Integration plugin is activated:

• Centralized Connection and Credentials plugin 
(com.snc.core.automation.connection_credential)

• Knowledge Management V3 plugin (com.snc.knowledge3)

• Knowledge Management Advanced Installer plugin  (com.snc.knowledge_advanced.installer)

The Knowledge  > Administration  module displays the External Knowledge Sources  and 
External Knowledge Jobs  sub-modules when the Knowledge Management - External Content 
Integration plugin is activated.
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Note: 

Starting with the Washington DC  release, the Knowledge Management  v3 
homepage (com.snc.knowledge3) is being prepared for deprecation in the 
future Y release. It is replaced by the Knowledge Management  Service Portal 
(com.snc.knowledge_serviceportal), which is active by default for customers on Madrid 
and later releases. For more information about the new experience, see Knowledge 
Management Service Portal homepage features.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.

Note: 
When domain separation and delegated admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .

Define an external knowledge source

Before you import content, create and configure the connection between the a Web Distributed 
Authoring and Versioning (WebDAV) - compliant external knowledge source and the ServiceNow 
knowledge base into which you want to import content. Define import parameters for the external 
knowledge source.

Before you begin
Define Basic authentication credentials  and Getting started with connections  to the external 
source.

Caution: 
This feature expects that the external source endpoint is a publicly accessible endpoint. 
Mid-server configuration is not supported.

Role required: admin

About this task
Only basic authentication is supported for the external content integration feature.

Procedure

1. Define the connection from the external source and the target knowledge base.

a. Navigate to Knowledge  > Administration  > External Knowledge Sources.

b. Click New.

c. Fill in the following fields:
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Field Instruction

Name Enter unique name for the external source.

Target Knowledge Base Select the knowledge base in which you 
want to create articles for the external 
content.

Connection Alias Select the connection alias to connect to the 
external source.

d. Right-click the form header and click Save.

2. Set import parameters for the external content.

a. In the Parameter  related list, click New.

b. In the Name  field, select the name of the parameter from the drop-down list.

c. In the Value  field, enter the desired value for the parameter.
The table below lists the parameters and the corresponding values that can be set for the 
external source.

Parameter Name Instructions

Maximum size limit (in MB) for this source Set maximum allowed content size for this 
source. Once this limit is reached, no further 
content is processed. Default value is 400 
MB.

Maximum size limit (in KB) per file/content in 
this source

Set maximum allowed size limit for each file 
from this external source. If a file exceeds 
this limit, that file is not processed. Default 
value is 4000 KB.

Open search results in the original source 
system

Set value to true  to open search results in 
the external source system. Set value to 
false  to open search results in the target 
knowledge base. Default value is set to 
false.

Include folders with names that match these 
regex patterns

Enter a comma-separated list of regular 
expressions for folder names that need to 
be included from this external source.

Exclude folders with names that match 
these regex patterns

Enter a comma-separated list of regular 
expressions for folder names that need to 
be excluded from this external source.

Create articles when file names match these 
regex patterns

Enter a comma-separated list of regular 
expressions for file names that need to be 
included to create articles.

Do not create articles when file names 
match these regex patterns

Enter a comma-separated list of regular 
expressions for file names that need to be 
excluded to create articles.
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Parameter Name Instructions

Maximum retry limit Maximum number of retries to send request 
to the external source.

d. Click Submit.

Import content from an external knowledge source

Run an import job manually or set up a schedule to process the integrated external content.

Before you begin
Role required: admin or knowledge_admin

About this task
Each external source is associated with two handlers: the Acquire handler  and the Process 
handler, for running the import job. The acquire handler uses a WebDAV client to acquire 
external content to create articles. You can customize the process handler to assign categories to 
articles or populate additional metadata for the knowledge articles. For more information refer

Options for Importing External Articles into ServiceNow Knowledge Management

Procedure

1. Navigate to All  > Knowledge  > Administration  > External Knowledge Sources.

2. Select the external knowledge source from which you would like to import content.

3. In the Handlertab, set a schedule to run the acquire and process handlers.

4. In the Related Links section, click Run Scheduled Job.

5. To view all jobs scheduled to run to import content for the external source, click the Jobs.
You can open the most recent job to monitor the status.

Result
For each file in the external content source, a blank knowledge article is created and the external 
file is added as an attachment to the article. The short description of the article is derived from 
the file name of the external content source.

Note: 
If the externally imported content is infected, a notification about each infected file is sent 
to the users with the knowledge_admin role and Knowledge Base  owners. The notified 
users can then take required actions on the infected files.

Open knowledge search results in source system

While search results are aggregated within your instance, your users can also utilize features 
available in the source system (being able to edit in Microsoft SharePoint, for example). To open 
knowledge search results in a host system, configure the URL to the external source system to 
open articles from search results directly in the source system.

Before you begin
Make sure the Open search results in the original source system  import parameter for the 
external knowledge source  is set to true.

You can follow this procedure when you have a file as a knowledge article in Microsoft 
SharePoint, for example.

Role required: admin
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Procedure

1. Navigate to All  > System Definition  > Script Includes.

2. Open KBWebDAVContentHandler.

3. In the Script  window, override the function getFileURL  using script shown below.
The getFileURL  function is shown below.

 //fileObj.getName() - Returns name of the file
      //fileObj.getPath() - Returns path to the file from root 
 folder
      //fileObj.getAbsolutePath() - Returns Absolute WebDAV URL 
 of the file
      //fileObj.getCreationDate() - Returns creation date of 
 the file as GlideDateTime object
      //fileObj.getModifiedDate() - Returns last modified date 
 of the file as GlideDateTime object
      //fileObj.getContentType() - Returns content type of the 
 file as GlideDateTime object
      //fileObj.getSize() - Returns size of the file

getFileURL: function(fileObj) {
      //write your logic here
},

4. Click Update.

Sample configuration for integrating external knowledge content

You can integrate content from multiple external sources so your users can acquire and search 
knowledge from a single location. Use this sample configuration to create a connection to your 
external account, configure external knowledge sources, and import content to enable search 
results for unified content.

Requirements for integrating external content

Make sure the Knowledge Management -- External Content Integration plugin 
(com.snc.knowledge.external_integration) is enabled and your external source is WebDAV- 
compliant.

Integrate external knowledge sources into the Knowledge Management application

Create authentication credentials and a connection alias to connect your external knowledge 
source to the ServiceNow  Knowledge Management application. Define import parameters for 
your external source to import integrated content.

Before you begin
Role required: admin

Procedure

1. Enable basic authentication on your external account.

Note: 
Your external account password is not affected when you enable basic authentication.

2. Create the connection to your external account using the basic authentication credentials.
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a. Navigate to Connections and Credentials  > Credentials.

b. Click New.

c. Click Basic Auth Credentials.
Fill in the following fields:

Field Description

Name Name for the credential. For example, Demo_Auth.

User name The external account user name created for basic authentication.

Password The external account password for the user name.

d. Click Submit.

3. Create an HTTP connection to your external account.

a. Navigate to Connections & Credentials  > Connection & Credential Aliases.

b. Select New.

c. In the Name  field, enter the name of the connection alias.

Example 
For example, Demo_Account.

d. Right-click the form header and click Save.

e. In the Connections  related list, click New.
Fill in the following fields:

Field Description

Name Name for the HTTP connection. For example, Demo_Connection.

Credential Credential created to connect to the external account. For example, 
Demo_Auth.

Connection URL WebDAV URL to your external account. This is the WebDAV end point 
of your external account.

Note: 
You can also import contents from a specific folder by appending 
the folder path to the URL. For example, https://<web link to your 
extermal_account>/KnowledgeIT.

f. Click Submit.

4. Configure the external knowledge source for importing content.
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a. Navigate to Knowledge  > Administration  > External Knowledge Sources.

b. Click New  and fill in the following fields:

Field Description

Name Unique name for the external source. For example, 
Demo_knowledge.

Target Knowledge 
Base

Knowledge base in which you want to create articles for the external 
content. For example, IT.

Connection Alias Connection alias to connect to the external source. For example, 
Demo_Account.

c. Right-click the form header and select Save.

d. In the Parameter related list, click New.

e. On the Parameter form, select the name of the import parameter that you want to configure 
for your external source and then set the value for the parameter.
The table below lists the parameters and the corresponding values that can be set for the 
external source.

Parameter name Value

Maximum size limit (in MB) for this source Maximum allowable content size to import 
from your external source. For example, 250 
MB.

Maximum size limit (in KB) per file/content in 
this source

Maximum allowable size for each article, 
including attachments, that you can import 
from this external source. For example, 
2000 KB.

Open search results in the original source 
system

Opens search results in the external source 
system if this value is set to true.

Include folders with names that match these 
regex patterns

Comma-separated list of regular 
expressions for folder names to include from 
this external source. For example, to include 
all folders names that start with the letters a 
and b, enter a.*,b.*.

Exclude folders with names that match 
these regex patterns

Comma-separated list of regular 
expressions for folder names to exclude 
from this external source. For example, to 
exclude all folders names that start with the 
letters a and b, enter a.*,b.*.

Create articles when file names match these 
regex patterns

Comma-separated list of regular 
expressions for file names that to include 
when creating articles. For example, to 
include all file names have .docx  and 
.pdfextensions, enter .*\.docx,.*
\.pdf.
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Parameter name Value

Do not create articles when file names 
match these regex patterns

Comma-separated list of regular 
expressions for file names to exclude when 
creating articles. For example, to exclude file 
names have .docx  and .pdfextensions, 
enter .*\.docx,.*\.pdf.

Maximum retry limit Maximum limit for the number of times 
a connection request can be sent to the 
external source. For example, 5.

What to do next
Import content from an external knowledge source.

Related topics

Open knowledge search results in source system

Knowledge Management Service portal search results page

Duplicate knowledge article numbers

Importing knowledge articles into an instance can create articles with duplicate numbers.

The Knowledge Number  field is auto-generated and is incremented every time you create a new 
article in an instance. The initial value for the Number  field is 10,000. To customize this number:

1. Navigate to System Definition  > Number Maintenance.

2. In the Table  column, search for and select Knowledge.

3. In the Controls related list, in the Number  field, enter a new number.

4. Click Update.

Importing knowledge articles from another instance or as part of the demo data for another 
application may introduce an article with a number that is already in use. Because the 
Knowledge Number  field is not uniquely indexed, the import completes without error.

With duplicate knowledge article numbers present, links to article view pages that use the 
knowledge number can behave inconsistently. For example, if there are two articles with the 
same Knowledge number KB0000033, the following link may open either of these two articles 
randomly: kb_view.do?sysparm_article=KB0000033. This can happen in Knowledge 
search results where clicking on a result opens a different article instead of the article displayed 
in the search results.

Avoiding duplicate Knowledge article numbers

To avoid inserting Knowledge articles with duplicate numbers into a production environment:

• Do not import demo data articles in production environment.

• Verify the numbers of the articles to be inserted to make sure they are not already in use.

• Create a before insert business rule on the Knowledge table (kb_knowledge) to ensure the 
new number is not already in use.

You can also update the initial value for the Knowledge Number  field so that newly created 
articles do not conflict with existing articles.

1. Navigate to System Definition  > Number Maintenance.

2. In the Table  column, search for and select Knowledge.
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3. In the Controls related list, in the Number  field, update the count to a number greater than the 
largest value already in the system.

4. Click Update.

Create a custom knowledge homepage

As a system administrator, you can create a module allowing users to open a knowledge 
homepage for a specific knowledge base or category.

Before you begin
Role required: admin

About this task
Note: 
This topic creates a legacy v3 knowledge homepage. You can create a portal homepage 
and configure it to get a new look and feel. For information, see Configure the Knowledge 
Management Service Portal.

Procedure

1. In the application navigator, point to the application name and click the edit application icon 

( ).

2. In the Modules  related list click New.

3. Enter a Title  for the module.

4. In the Link type  field, select URL (from Arguments).

5. In the Arguments  field, append one or more of the following values to $knowledge.do /
search?.

Option Description

sysparm_kb=<knowledge base sys_id>

Enter the sys_id of a knowledge base to show 
knowledge articles from that knowledge base 
by default.

If the specified knowledge base does not ex­
ist, the default knowledge homepage appears 
when accessing the custom homepage mod­
ule.

sysparm_category=<knowledge category 
sys_id>

Enter the sys_id of a knowledge category to 
show knowledge articles from that category 
by default.

If the specified category does not exist, the 
default category for the selected knowledge 
base appears when accessing the custom 
homepage module.
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Option Description

Note: 
The category passed in this parame­
ter must belong to the knowledge base 
passed in the sysparm_kb  parameter.

sysparm_order=<view_count, last_modi­
fied, or relevancy>

Enter the default sort order for articles to ap­
pear in.

Example:

Related topics

Configuring Knowledge Management

I18N - Knowledge internationalization

View knowledge logs

Knowledge logs display information about which users have viewed knowledge articles, what 
they looked for, and where.

Before you begin
Role required: knowledge_admin, knowledge_manager

About this task
Knowledge logs capture information from all the available sources where users can access 
knowledge articles, such as Customer Service  Portal, Knowledge Management  Service Portal, 
Now Mobile, Agent Workspace, and Knowledge Management  v3.

Note: 

Starting with the Washington DC  release, the Knowledge Management  v3 
homepage (com.snc.knowledge3) is being prepared for deprecation in the 
future Y release. It is replaced by the Knowledge Management  Service Portal 
(com.snc.knowledge_serviceportal), which is active by default for customers on Madrid 
and later releases. For more information about the new experience, see Knowledge 
Management Service Portal homepage features.

Procedure

1. Navigate to All  > Knowledge  > Administration  > Search Log  or View Log.

2. View the Search or View logs.

Knowledge logs

Log Description

Search 
Log

View records of the search source, search terms, the highest click rank, and the 
number of search results of knowledge searches from all the available sources 
where users can access knowledge articles. The Search log displays data from the 
Knowledge Searches [ts_query_kb] table. For more information about the search 
source, see View the source of a knowledge article search.

View 
Log

View records showing who has viewed which knowledge articles, who has attached 
a knowledge article to a task and when, and identify final search terms when the 
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Log Description

type-ahead search suggestions feature is enabled. The View log displays data from 
the Knowledge Use [kb_use] table.

Note: 

◦ An administrator can activate the kb_use table cleanup job to delete any 
older records from the Knowledge Use [kb_use] table and improve the table 
performance. For more information, see Modify the data retention policy for 
View logs.

◦ The View log record doesn't display information for a knowledge article 
accessed and viewed from the global search results.

Search Log fields and description

The knowledge search log stores the history of all knowledge searches performed by the users.

The Search log stores information from all the available sources where users can access 
knowledge articles. It displays data from the Knowledge Searches [ts_query_kb] table.

Note: 
The Knowledge Search log captures data only from Zing searches. It does not work with AI 
searches.

As an administrator and knowledge manager, you can access the search log by navigating to All 
> Knowledge  > Administration  > Search Log.

The following table describes some of the fields in the Search log.

Search 
log field

Description

Search 
term

Search term used to perform the search.

Results Number of matching knowledge articles returned by the search.

User User ID of the user who performed the search.

Sort 
Order

Sort order (relevance, views, newest, or alphabetical) while performing the search.

Final 
Search 
Term

When this value is true, the value in Search term  is the final successful search term 
used in the search session.

Highest 
Click 
Rank

The rank of the first search result the user clicked on to get the relevant search 
results. A lower search count indicates that the search operation is efficient.

Session 
Id

Unique identifier for the user session.

For information about finding the source used for searching a knowledge article, see View the 
source of a knowledge article search.

View Log fields and description

The knowledge View log stores the history of knowledge articles views and their usage.
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The View log shows who has viewed which knowledge articles and who has attached a 
knowledge article to a task and when. It identifies final search terms when the type-ahead search 
suggestions feature is enabled. The View log displays data from the Knowledge Use [kb_use] 
table.

As an administrator and knowledge manager, you can access the view log by navigating to All  > 
Knowledge  > Administration  > View Log.

The following table describes some of the fields in the View log.

View log 
field

Description

Created Date and time when the article was viewed or used by the user.

Article Article that was viewed or used by the user.

User User who viewed or used the article

Used If set to true, the article was attached to a task (case, incident, and the like).

Viewed If set to true, indicates that the article was viewed.

Search 
Id

Reference ID of the Search log (ts_query_kb). This links the search performed by a 
user to the article viewed from the search results.

Session 
Id

Unique identifier for user session.

Times 
Viewed

How many times the article was viewed.

View the source of a knowledge article search

Analyze knowledge searches by finding the source used for searching a knowledge article.

Before you begin
Role required: knowledge_admin, knowledge_manager

Procedure

1. Navigate to All  > Knowledge  > Administration  > Search Log.

2. View the following data for a search record in the corresponding column of the Search log.

Search source details

Column Search record data

Source 
Doc

Source record in the source table.

For example, Problem: problem_number, Case: case_number, Incident: 
incident_number, Service Portal: Customer Support

Source 
Table

Label and name of the source table.

For example, Knowledge [kb_knowledge], Service Portal [sp_portal], Case 
[sn_customerservice_case], Incident [incident], Problem [problem], KCS Article 
[kb_template_kcs_article]

Source 
Type

Application where the knowledge article search was performed.
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Column Search record data

The Source Type  column is set to one of the following values:

◦ Portal: Service Portal application

◦ Classic: ServiceNow AI Platform  application

◦ Workspace: Agent assist  in Workspace

◦ Knowledge Classic: Knowledge Management  v3 or v2

◦ Other: Unidentifiable source

Source 
URL

URL of the searched text query.

Related topics

View knowledge logs

Modify the data retention policy for View logs

Remove unwanted and older data from the Knowledge Use [kb_use] table through the data 
retention policy.

Before you begin
Role required: admin

About this task
The View log displays data from the Knowledge Use [kb_use] table. By default, all the records 
in the Knowledge Use [kb_use] table are retained. Activating the data retention policy for the 
kb_use table deletes records that you no longer need. The deleted data is not visible on the 
reports used in dashboards such as Self-Service Analytics for customer service and Knowledge 
Management dashboards.

Procedure

1. Navigate to All  > Instance Scan  > Table Cleanup.

2. In the Tablename  column, search for kb_use  and click the kb_use  link.

3. On the Auto Flush form, activate the kb_user table cleanup job by selecting the Active  check 
box.

4. Optional:  Adjust the amount of time the system waits before deleting the records by modifying 
the value in the Age in seconds  field.
By default, the Age in seconds  field value is set to 31,536,000 seconds (equivalent to 365 
days). For more information, see Autoflush form .

If the glide.knowman.view_age.days  property, which sets the number of days used 
when summing article views, is active, the Age in seconds  field value must be larger than that 
property's value. For more information, see Knowledge Management properties

.

5. Click Update.

Use extension points for Knowledge Management

Use UI extension points to add knowledge article headers and footers to knowledge articles and 
to customize the email template for notifications when a knowledge article is commented on. 
Use scripted extension points to customize the feedback object used in the email template for 
notifications when a knowledge article is commented on.
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Before you begin
The Knowledge Management  Advanced plugin (com.snc.knowledge_advanced) must be 
activated to view the KMFeedbackNotification UI extension point and the KMFeedbackObject 
scripted extension point. These notifications are part of the Subscriptions feature, which is 
activated with this plugin.

Starting with the Washington DC  release, the Knowledge Management  v3 homepage 
(com.snc.knowledge3) is being prepared for deprecation in the future Y release. It is replaced 
by the Knowledge Management  Service Portal  (com.snc.knowledge_serviceportal), which is 
active by default for customers on Madrid  and later releases. For more information about the new 
experience, see Knowledge Management Service Portal homepage features.

Role required: admin

About this task
Using extension points makes it easier to integrate customizations without actually altering the 
base code. You can extend standard base functionality using customized scripts.

To use UI extension points in Knowledge Management, create an implementation and change 
the data as required. You can create multiple implementations per extension point, but for 
these scenarios, the use is limited to one implementation only. Example code is provided in the 
extension point, which can be edited, as required.

An implementation is delivered in the base system for scripted extension points. You can change 
the data and add additional fields, as required.

Procedure

1. To use UI extension points to customize headers and footers in knowledge articles, and the 
email notification that is sent when a knowledge article is commented on:

a. Navigate to System Extension Points  > UI Extension Points.

b. Click the UI extension point you want to use.

Note: 

▪ Use the KMArticleViewFooter and KMArticleViewHeader UI extension points to 
add knowledge article headers and footers to the knowledge article view pages 
(kb_view.do) in Knowledge Management  v3.

▪ Use the KMFeedbackNotification UI extension point to customize the email template 
for notifications when a knowledge article is commented on.

c. Click Create Implementation.

d. Change the data as required.

e. Click Update.

2. To use scripted extension points to update the feedback object used in the email template for 
notifications when a knowledge article is commented on:
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a. Navigate to System Extension Points  > Scripted Extension Points.

Note: 
Use the KMFeedbackObject scripted extension point to customize the feedback object 
used in the email template for notifications when a knowledge article is commented on.

b. In the API Name  column, click global.KMFeedbackObject.

c. In the Implementations  related list, click the KMFeedbackObjectBaseImpl  class.

d. Change the data and add additional fields, as required.

e. Click Update.

Related topics

Using extension points to extend application functionality

Using scripted extension points in server-side scripts

Using UI extension points in server-side UI macros

Using client extension points in client-side UI scripting

Train the similarity solution for Knowledge Management to find related articles

Train the Knowledge Similar Articles solution definition included within the Predictive Intelligence 
for Knowledge Management capability to find related knowledge articles when creating or 
viewing a knowledge article.

Before you begin
Ensure that the Predictive Intelligence for Contextual Search plugin 
(com.snc.contextual_search_ml) and Predictive Intelligence for Knowledge Management plugin 
(com.snc.knowledge_ml) are activated.
Role required: admin

Note: 
This solution is only applicable to OOB (Out of Box) similarity solution and not to knowledge 
articles that are created manually.

Procedure

1. Navigate to All  > Predictive Intelligence  > Similarity  > Solution Definitions.

2. In the Similarity Definitions list, search for and select the Knowledge Similar Articles solution 
definition (ml_sn_global_knowledge_similar_articles).

3. On the Similarity Definition form, verify the default field values for knowledge articles.

For more information about the Similarity Definition form fields, see Create and train a similarity 
solution .

Note: 
If the application scope isn't set to Knowledge Management - Machine Learning, you 
cannot edit the form and a warning message appears. To make the form editable, click 
the word here  at the end of the message.

4. Click Update & Retrain.
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5. Open the Similarity Definition form for the Knowledge Similar Articles solution definition 
(ml_sn_global_knowledge_similar_articles).

6. In the ML Solutions related list, view the training solution progress in the Progress  column.
When Progress  is 100%, in the ML Solutions related list, you can include more useful related 
articles by reviewing the similarity examples based on the similarity score and updating the 
similarity score threshold value.

7. Optional:  Update the similarity score threshold.

a. In the Active  column, click the link for the solution.

b. Review the similarity examples by clicking the Similarity Examples  related link on the ML 
Solution form.
For more information, see Review solution similarity examples .

c. In the Solution Statistics related list on the ML Solution form, enter the required value in the 
Similarity Score Threshold  field, right-click the ML Solution form, and then click Save.
For more information, see Update your similarity score threshold .

Result
When the solution is complete, the related knowledge articles appear in the Knowledge results 
section on the Knowledge form in the ServiceNow AI Platform, in the Related Articles section 
on the knowledge article view page in the Knowledge Management  Service Portal, and in Agent 
assist  when the Similar Articles (ML)  option is selected.

Related topics

Predictive Intelligence for Knowledge Management

Knowledge Management Service Portal article view page features

Create a knowledge article

Create a knowledge article in Agent Workspace

Using Now Mobile for Knowledge Management

Enable actionable knowledge feedback

The actionable knowledge feedback feature is available when the Knowledge Management 
Service Portal (com.snc.knowledge_serviceportal) plugin is activated and the actionable 
knowledge feedback properties are enabled.

Before you begin
Role required: admin

About this task
The actionable feedback feature is available in the Knowledge Management  Service Portal 
and Agent Workspace. To use the actionable feedback feature in other service portals, you can 
activate the Knowledge Article View page route map. For new customers, the Knowledge Article 
View page route map is activated by default.

Note: 
The actionable knowledge feedback is not supported in Knowledge Management  v3.

A feedback task is created for an article when the article is flagged. For generating feedback 
tasks when an article is marked as not helpful or rated below a set value, you must set the 
following associated properties.
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Note: 
When you select No  on the article form, an actionable feedback pop-up window appears. 
On the Actionable feedback form, choose one of the reasons to provide feedback. If you 
choose Other  as a reason consider providing feedback details.

Procedure

1. Navigate to All  > Knowledge  > Administration  > Properties.

2. In the Actionable Feedback Properties  section, configure the following properties:

Property Setting

Create actionable 
feedback task when an 
article is flagged

By default, the property is set to Yes  and feedback tasks are 
created when the article is flagged.

Create actionable 
feedback task when an 
article is marked as not 
helpful

Select Yes.

Create actionable 
feedback task when 
an article is rated at or 
lower than this value. 0 
or no value indicates that 
actionable feedback tasks 
are not enabled for Rating 
type feedback

Enter a value from 1 to 5 to specify the rating threshold for 
generating a feedback task.

For example, if you set this value to 3, a feedback task is 
generated when a user selects three or less stars to rate an 
article.

Note: 
If you enter '0', a negative article feedback does not 
generate a feedback task.

3. Click Save.

Related topics

Actionable Knowledge Feedback Properties

Create field mapping from an HR case to a knowledge article

Copy information from an HR case into a knowledge article by creating custom mapping between 
the HR case table and the KCS article table.

Before you begin
Role required: admin

• Ensure that the Knowledge Advanced plugin (com.snc.knowledge_advanced) is active.

• Ensure that the Developer Application is set to Human Resources: Core.

• Ensure that the KCS Article template is active.

1. Navigate to Knowledge  > Administration  > Article Templates.

2. Set the Active  field to true  for the KCS Article template.
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Procedure

1. In the filter navigator, type csm_table_map.list.

2. Click New.

3. In the Mapping Name  field, enter HR Case KCS Article.

4. In the Source Table  field, enter HR Case.

5. In the Target Table  field, enter KCS Article.

6. Right-click the form header and Save.

7. In the Basic Field Mapping  related list, click New.

8. Create mappings for the following fields.

Source Field Target Field

Sys ID Source Task

Short description Short description

Close notes Resolution

Description Cause

Note: 
You can create field mappings for more fields, as required.

◦ In the Source  field, select the field in the source HR Case table that contains the 
information to be copied to the field in the article template target table.

◦ In the Target  field, select the field in the article template target table to which you need 
information copied to from the field in the source Incident table.

9. To customize when and how the Knowledge  check box is displayed, click the Condition  tab.

10. To map fields using advanced scripts, select the Advanced Field Mapping  check box.

11. On the Advanced field Mapping  tab, paste in the following code.

(function (source) {
   // Get the first comments from HR case and use it as Issue 
 description for article
   target.short_description=source.short_description+“”;
   target.kb_resolution=source.close_notes+“”;
   target.kb_cause=source.description+“”;
  var notes = source.comments.getJournalEntry(-1);
  var entries = notes.split(“\n\n”);
  var comment = “”;
  if(entries[entries.length-2]){
      comment = entries[entries.length-2];
      var part = comment.toString().indexOf(“)”);
      if(part != -1){
comment = 
 comment.toString().substring(part+2).replaceAll(“\r\n”,“<br/>
“);
  }
  }if(comment)
      target.kb_issue = comment;
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   //Only if selected article type is active
   var tem =  new GlideRecord("kb_article_template");
   tem.addQuery("child_table","kb_template_kcs_article");
   tem.addActiveQuery();
   tem.query();
   if(!tem.hasNext())
       return false;
 
   //Do not allow to create the knowledge again
   var now_GR = new GlideRecord("kb_knowledge");
   gr.addQuery("source",source.sys_id);
   gr.query();
   if(gr.next())
       return false;
 
   return true;
})(source);

The first comment on an HR case is mapped to the Issue Description  field in the knowledge 
article.

Note: 
If the same source or target field is configured in both the basic and advanced field 
mappings, the advanced field mapping overrides the basic field mapping.

If the fields configured in the basic and advanced field mapping are different, the field 
configurations in the advanced field mapping are appended to the field configurations in 
the basic field mapping.

Add a property to enable creating knowledge articles from HR cases

Add a property, which is required to allow users to create a knowledge article from an HR case.

Before you begin
Role required: admin
Ensure that the Developer Application is set to Human Resources: Core.

Procedure

1. In the Filter navigator, enter sys_properties.list.

2. Click New.

3. Fill in the following fields.

System Property form

Field Description

Name enable_kcs_hr

Description Enable Knowledge Centered Services (KCS) 
for HR Service Delivery.

Type true|false

Value true

4. Click Submit.
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Create a UI action to enable creating knowledge articles from HR cases

Create a UI action to add the Knowledge check box to the HR case form.

Before you begin
Role required: admin
Ensure that the Developer Application is set to Human Resources: Core.

Procedure

1. Navigate to All  > System UI  > UI Actions.

2. Click New.

3. Fill in the following fields.

UI Action form

Field Description

Name Create Knowledge

Table HR Case

Action name create_knowledge

4. Select the Client  check box.

5. Select the List v3 Compatible  check box.

6. Select the Form button  check box.

7. In the Onclick  field, enter createKnowledgeClient().

8. In the Condition  field, enter gs.getProperty("sn_hr_core.enable_kcs_hr") 
== 'true' && new global.CSMTableMapUtil 
(current).findMapByName("sn_hr_core.hr_case_kcs_article") && new 
global.KBKnowledge().canCreate().

9. In the Script  field, enter the following code.

function createKnowledgeClient() {
    if (g_form.modified) {
        alert(new GwtMessage().getMessage('You have unsaved 
 changes. Please save them to continue.'));
    }else{
        //Call the UI Action again but skip the 'onclick' 
 function
        gsftSubmit(null, g_form.getFormElement(), 
 'create_knowledge');
//MUST call the 'Action name' set in this UI Action
    }
}
 
//Code that runs without 'onclick'
//Ensure call to server-side function with no browser errors
if (typeof window == 'undefined')
    CreateKnowledgeServer();
 
    function CreateKnowledgeServer(){
    current.update();
 
    var map = new global.CSMTableMapUtil (current);
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    map.findMapByName("sn_hr_core.hr_case_kcs_article");
    var targetURL = map.getTargetURL();
    var referenceLink =
"&sysparm_collection=sn_hr_core_case&sysparm_collectionID="+cur
rent.sys_id+"&sysparm_collection_key=task&sysparm_link_collecti
on=m2m_kb_task&sysparm_collection_related_field=kb_knowledge&sy
sparm_referring_url=sn_hr_core_case.do%3fsys_id%3d"+current.sys
_id;
    if(targetURL)
        action.setRedirectURL(targetURL[0]+referenceLink);
}

10. Click Submit.

Enable creating an article from a customer service case

You can enable authors to reuse information in a case by copying case details into an article 
template. Use the pre-defined customer service source case table to article template target table 
configuration or create custom configurations between the two tables to copy information from a 
case to an article.

Before you begin

• The Knowledge Management Advanced plugin  must be active.

• The Properties installed with Customer Service Management  must be enabled

• The pre-defined KCS article template or a newly created article template must be active.

Note: 
You can do one of the following to create an article from a case:

◦ Use the pre-defined Case KCS Article  mapping as is or modify the field mappings between 
the case source table and article template target table.

◦ Create a new article template target table and map it to the case source table and customize 
the field mappings between them. For information on creating article templates, refer to 
Create an article template.

• Knowledge users use the Create Knowledge  button in a case form to create an article 
from a case and must have "can contribute" permission for at least one active knowledge 
base to create an article from a case. For information on user permissions, see Knowledge 
Management roles.

Role required: sn_customerservice.customer_admin or admin

About this task
The pre-defined Case KCS Article  mapping is stored in the CSM Table Map [csm_table_map] 
table. This configuration has the sn_customerservice_case source case table configured to the 
kb_template_kcs_article target article template table with the four field mappings pre-configured 
between the tables. You can customize the existing field mappings or map additional fields 
between the tables.

Procedure

1. In the application filter navigator, type csm_table_map.list.

2. Click Case KCS Article.

3. From the Target Table  list, use the pre-defined KCS article template table or select the newly 
created article template table.
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4. Map each customer service case field that must be used to create knowledge articles.

a. In the Basic Field Mapping  related list, click New.
To map fields, fill in the following fields:

Customer service case table to article template target table field mapping

Field Instructions

Source Field Select the field in the source case table that 
contains the information to be copied to the 
field in the article template target table.

Target Field Select the field in the article template target 
table to which you need information copied 
to from the field in the source case table.

b. Click Submit.

c. To map fields using advanced scripts, select the Advanced Field Mapping  check box and 
then map the fields between the source and the target table using advanced scripts in the 
Advanced Field Mapping  tab.

Note: 

If the same source or target field is configured in both the basic and advanced field 
mappings, the advanced field mapping overrides the basic field mapping.

If the fields configured in the basic and advanced field mapping are different, the field 
configurations in the advanced field mapping are appended to the field configurations 
in the basic field mapping.

d. To customize when and how the Create Knowledge  button is displayed, use the condition 
builder in the Condition  tab or select Use Advanced Condition  check box and configure 
using advanced scripts.

Note: 
If you change the target table in the Case KCS Article  mapping, also update the scripts 
with the configuration changes for display of this button.

5. Click Update.

Configuration tasks for knowledge demand insights

Review the following configurations tasks for knowledge demand insights.

Configure Knowledge Demand Insights

Configure the Knowledge Demand Insights feature to identify which topics are missing 
knowledge articles and creating actionable knowledge gaps for missing topics.

Before you begin
Activate the Predictive Intelligence for Knowledge Management plugin (com.snc.knowledge_ml). 
For more information, see Predictive Intelligence for Knowledge Management  and Additional 
plugins for Knowledge Management.
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About this task
To configure the Knowledge Demand Insights feature, use the Knowledge Management  guided 
setup. The guided setup takes you through the entire setup and configuration process.

This task provides general steps to configure the Knowledge Demand Insights feature. For more 
information about the feature, see Knowledge demand insights.

Procedure

1. Configure similarity and clustering solution definitions to enable comparing knowledge bases 
with a task type.

2. Configure the combination of the task table and similarity and clustering solution definitions 
that are processed in a scheduled job for a task type.

3. Configure scheduled jobs for each task.

4. Configure assignment rules to automatically assign feedback tasks of type Knowledge gap.

Note: 
If no assignment rules are configured, a knowledge admin or knowledge manager can 
later use the Feedback Management feature in the Knowledge module to manually 
assign a feedback task.

Related topics

Analyze knowledge gaps from a demand insights dashboard and create knowledge gap 
feedback tasks

Configure solution definitions to find gaps in a knowledge base

The Knowledge Demand Insights feature finds knowledge gaps by comparing knowledge 
bases with existing tasks. To enable comparing knowledge bases with a task type, you must first 
configure similarity and clustering solution definitions.

Before you begin
This task describes the process for configuring a solution definition.
Instead of doing the configuration through this procedure, consider using a guided setup. 
Navigate to Knowledge  > Administration  > Guided Setup, click Get Started, and then scroll to 
the Knowledge Demand Insights section.

Role required: admin

About this task
Configure one similarity type and one clustering type solution definitions for each task type: 
incidents, customer service cases, or other tasks. A similarity solution definition collects and 
compares your existing records to new similar records. A clustering solution definition groups 
similar records into clusters so you can address them collectively or identify patterns.

Procedure

1. Navigate to Knowledge Demand Insights  > Solution Definitions.

2. In the Solution Definitions (ML view) list, search for and select the similarity solution definition 
for the task type.

◦ For customer service cases, select Demand Insights: Similar Cases and Knowledge 
(ml_sn_global_similar_cases_and_kbs).

◦ For incidents, select Demand Insights: Similar Incidents and Knowledge 
(ml_sn_global_similar_incidents_and_kbs).
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◦ For HR cases, select Demand Insights: Similar HR Cases and Knowledge 
(ml_x_sn_hr_core_global_demand_insights_similar_hr_cases_and_knowledge).

◦ For tasks other than customer service cases, incidents, and HR cases, click New  to create 
another similarity solution definition.

3. On the Similarity Definition form, verify the default field values for customer service cases or 
incidents, or fill in the values for a custom configuration.

Note: 
If the application scope isn't set to Knowledge Management - Machine Learning, you 
cannot edit the form and a warning message appears. To make the form editable, click 
the word here  at the end of the message.

Similarity Definition form

Field Description

Label Unique name for your similarity solution.

Word 
Corpus

Defines which knowledge articles and tasks are selected for knowledge gap 
analysis.

If you don’t have a relevant word corpus, follow the steps in Create a word 
corpus .

Table Table that contains the knowledge article records. Set the value to Knowledge 
[kb_knowledge] unless you use a different table for storing knowledge articles.

After you assign a table value, the number of records that match the filter 
conditions is displayed as a link.

Fields Fields from the Knowledge table selected for knowledge gap analysis.

Filter Filter conditions applied on the Knowledge table to filter knowledge article 
records for knowledge gap analysis.

Test Table Table that contains the task records that you want to compare with knowledge 
article records.

Test Fields Fields from the task table selected for knowledge gap analysis.

Processing 
Language

Dominant language of the dataset you're training on the solution definition. By 
default, English processing is applied to all datasets. For example, if you select 
Italian, the system processes the data in both English and Italian.

Note: 
The term processing indicates some of the language-specific steps used 
as part of training a solution. These steps might include tokenizing words, 
removing stop words, and stemming.

Stopwords Common terms in the processing language that are excluded from the search, 
for example, prepositions.

When you select your processing language, the system automatically adds a 
Stopwords list that uses the same language. For example, if your processing 
language is Italian, the Default Italian Stopwords  list appears. The Default 
English Stopwords  list also appears in your selection as well.
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Field Description

Training 
Frequency

Frequency with which the model for similarity solution definition must be 
retrained.

Update 
Frequency

Frequency with which to include new records in the model for the similarity 
solution definition.

4. Submit and train the solution definition.

◦ For a new solution definition record, click Submit & Train.

◦ For an existing solution definition record, click Update & Retrain.

5. Optional:  Include more useful related articles by reviewing the similarity examples based on 
the similarity score and updating the similarity score threshold value.
For more information, see Review solution similarity examples  and Update your similarity 
score threshold .

6. In the Solution Definitions (ML view) list, search for and select the clustering solution definition 
for the task type.

◦ For customer service cases, select Demand Insights: Case Clusters Need Knowledge 
(ml_sn_global_cases_need_knowledge_cluster).

◦ For incidents, select Demand Insights: Incident Clusters Need Knowledge 
(ml_sn_global_incidents_need_knowledge_cluster).

◦ For HR cases, select Demand Insights: HR case clusters need knowledge 
(ml_x_sn_hr_core_global_demand_insights_hr_case_clusters_need_knowledge).

◦ For tasks other than customer service cases and incidents, click New  to create another 
clustering solution definition.

7. On the Clustering Definition form, verify the default field values for customer service cases or 
incidents, or fill in the values for a custom configuration.

Note: 
If the application scope isn't set to Knowledge Management - Machine Learning, you 
cannot edit the form and a warning message appears. To make the form editable, click 
the word here  at the end of the message.

Clustering Definition form

Field Description

Label Unique name for your clustering solution.

Word 
Corpus

Which tasks are selected for collections.

Table Table that contains the filtered tasks that require knowledge articles. Set the 
value to Task knowledge coverage [kb_task_knowledge_coverage] unless you 
use a different table for storing filtered tasks.

After you assign a table value, the number of records that match the filter 
conditions is displayed as a link.

Fields Fields from the Task knowledge coverage table selected for knowledge gap 
analysis.

Filter Filter conditions applied on the Task knowledge coverage table to filter 
knowledge article records for knowledge gap analysis.
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Field Description

Processing 
Language

Dominant language of the dataset you're training on the solution definition. By 
default, English processing is applied to all datasets. For example, if you select 
Italian, the system processes the data in both English and Italian.

Note: 
The term processing indicates some of the language-specific steps used 
as part of training a solution. These steps might include tokenizing words, 
removing stop words, and stemming.

Stopwords Common terms in the processing language that are excluded from the search, 
for example, prepositions.

When you select your processing language, the system automatically adds a 
Stopwords list that uses the same language. For example, if your processing 
language is Italian, the Default Italian Stopwords  list appears. The Default 
English Stopwords  list also appears in your selection as well.

Update 
Frequency

Frequency with which to include new and updated records in the model for the 
clustering solution definition.

Training 
Frequency

Frequency with which the model for clustering solution definition must be 
retrained.

8. Submit and train the solution definition.

◦ For a new solution definition record, click Submit & Train.

◦ For an existing solution definition record, click Update & Retrain.

What to do next
Complete the KB curation configuration form to define the scheduled jobs for demand insights. 
For more information, see Configure the mapping of solution definitions with task tables.

Related topics

Predictive Intelligence for Knowledge Management

Create and train a similarity solution

Create and train a clustering solution

Analyze knowledge gaps from a demand insights dashboard and create knowledge gap 
feedback tasks

Configure the mapping of solution definitions with task tables

Configure the combination of the task table and similarity and clustering solution definitions 
that are processed in a scheduled job for a task type. You can create another demand insights 
configuration or modify an existing configuration to define a scheduled job for demand insights.

Before you begin
This task describes the process for configuring a scheduled job.
Instead of doing the configuration through this procedure, consider using a guided setup. 
Navigate to Knowledge  > Administration  > Guided Setup, click Get Started, and then scroll to 
the Knowledge Demand Insights section.

Ensure that you have configured a similarity type and clustering type solution definitions for a 
task type. For more information, see Configure solution definitions to find gaps in a knowledge 
base.
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Role required: admin

About this task
A scheduled job for each task type runs business rules and then executes the similarity and 
clustering solution definitions. In the Demand Insights Configuration module, you configure the 
combination of the task table and similarity and clustering solution definitions that are processed 
in a scheduled job for a task type. This configuration is optional for customer service cases and 
incidents.

Note: 
For task types other than customer service cases and incidents, a user with the admin role 
must also perform the following tasks:

• Assign the sn_km_ml.knowledge_curation_user role and the appropriate roles for 
the task type to the users performing the knowledge gap analysis. To assign roles, 
perform the Assign knowledge curator roles guided setup task, which are available in the 
Knowledge Demand Insights section of the Knowledge Management  guided setup.

• Create a demand insights dashboard for the task type. To create a dashboard, see Create 
or configure a responsive dashboard .

Procedure

1. Navigate to All  > Knowledge Demand Insights  > Demand Insights Configuration.

2. Configure the combination of the task table and similarity and clustering solution definitions 
that are processed in a scheduled job.

◦ For customer service cases, select sn_customerservice_case.

◦ For incidents, select incident.

◦ For HR cases, select sn_hr_core_case.

◦ For tasks other than customer service cases, incidents, and HR cases, click New  to create 
another combination.

3. On the KB curation configuration form, verify the default field values for customer service 
cases or incidents or fill in the values for a custom configuration.

KB curation configuration form

Field Description

Curation 
table

Name of the table you want the data to pull information from. For example, 
for customer service cases, select Case [sn_customerservice_case] and for 
incidents select Incident [incident].

Fields Fields in the curation table that include the ID of knowledge articles, for 
example, the knowledge article ID KB07276660 in the field resolution notes,

Query 
condition

Conditions for filtering the number of tasks from the curation table. You can 
create conditions using the condition builder (see Condition builder ).

Similarity 
solution 
definition

Similarity solution definition for your task type. For example, for customer 
service cases, select Demand Insights: Similar Cases and Knowledge.
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Field Description

Clustering 
solution 
definition

Clustering solution definition for your task type. For example, for customer 
service cases, select Demand Insights: Case Clusters Need Knowledge.

4. Click Update  for incidents or customer service cases or Submit  to save a custom 
configuration.

What to do next
Set the frequency of the scheduled job for your task. For more information, see Set the frequency 
of knowledge gap analysis.

Related topics

Configure solution definitions to find gaps in a knowledge base

Set the frequency of knowledge gap analysis

Set the frequency of the scheduled job for your task to automatically run knowledge gap 
analysis.

Before you begin
This task describes the process for setting the frequency of knowledge gap analysis.
Instead of doing the configuration through this procedure, consider using a guided setup. 
Navigate to Knowledge  > Administration  > Guided Setup, click Get Started, and then scroll to 
the Knowledge Demand Insights section.

Role required: admin

Procedure

1. Navigate to All  > Knowledge Demand Insights  > Scheduled Jobs.

2. In the Scheduled Jobs list, select the scheduled job for your tasks in the Name  column.

◦ For customer service cases, select [Knowledge Curation]: Generate Case Clusters.

◦ For incidents, select [Knowledge Curation]: Generate Incident Clusters.

◦ For HR cases, select [Knowledge Curation]: Generate HR Case Clusters.

◦ For tasks other than customer service cases, incidents, and HR cases, create another 
scheduled job. For more information, see Create a scheduled job .

3. On the Scheduled Script Execution form, either accept the default value of running the 
analysis once a quarter (every 90 days) or change the frequency.

Note: 
For best performance results, try not to perform knowledge gap analysis more frequently 
than once a month.

4. Click Update.

Note: 
If the application scope is not set to Knowledge Management - Machine Learning, a 
warning message appears and the Update  button is not available. Click the word here  at 
the end of the message to change the scope and click Update.

5. Optional:  To run the job immediately, click Execute Now.
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Result
The knowledge gap analysis is repeatedly run at the duration as configured in the scheduled job.

What to do next
Create assignment rules to assign knowledge gap feedback tasks. For more information, see 
Assign knowledge gap feedback tasks to content authors.

Related topics

Analyze knowledge gaps from a demand insights dashboard and create knowledge gap 
feedback tasks

Assign knowledge gap feedback tasks to content authors

Create assignment rules to assign knowledge gap feedback tasks to authors or groups of 
content creators.

Before you begin
Role required: admin or assignment_rule_admin

About this task
Knowledge gap feedback tasks created through the Knowledge Demand Insights feature create 
feedback tasks of type Knowledge gap.

Procedure

1. Navigate to All  > Knowledge Demand Insights  > Knowledge Gap Assignment.

2. In the Assignment Rules list, click New.

3. On the Assignment rule form, fill in the fields.

Assignment rule form

Field Description

Name Descriptive name for the assignment rule.

Active Option to activate the assignment rule. Only active assignment rules take effect.

Applies to tab

Table Table to store the feedback tasks on knowledge articles. This field is 
automatically set to Knowledge Feedback Task [kb_feedback_task].

Conditions Conditions for assigning feedback tasks of the Knowledge gap type. This field is 
automatically set to [Feedback Task Type] [is] [Knowledge gap]. You can add 
more conditions as appropriate.

Assign to tab

User User assigned the feedback task type of knowledge gap.

Group Ownership group assigned the feedback task type of knowledge gap.

Script tab

Script Script you can use to specify more complex conditions for assignment rules 
using dynamic variables and loops.

4. Click Submit.
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Related topics

Create an assignment rule

Analyze knowledge gaps from a demand insights dashboard and create knowledge gap 
feedback tasks

Analyze knowledge gaps from a demand insights dashboard and create knowledge gap 
feedback tasks

Use the demand insights dashboard for your tasks to analyze candidate knowledge gaps and 
create knowledge gap feedback tasks.

Before you begin
You must have read access to the tasks that you want to analyze and the 
sn_km_ml.knowledge_curation_user role.

About this task
A demand insights dashboard displays tasks as topics for which your knowledge bases do 
not have adequate knowledge coverage. You can create and assign knowledge gap feedback 
tasks for a topic so your knowledge bases can better be used to solve and deflect any issues 
described in a task. Tasks represent customer service cases, incidents, problems, and so on.

Procedure

1. Navigate to Knowledge Demand Insights  and select the demand insights dashboard for your 
tasks, or navigate to All  > Self-Service  > Dashboards.

◦ For customer service cases, select Demand Insights for Cases.

◦ For incidents, select Demand Insights for Incidents.

◦ For HR cases, select Demand Insights for HR cases.

Note: 
For tasks other than customer service cases, incidents, and HR cases, you can create 
another dashboard or update an existing dashboard. For more information, see Create 
and use dashboards .

2. To view similar tasks grouped together, click a bar in the Pareto chart.
Each bar represents a collection of similar tasks grouped together because they are likely to 
be on the same topic. The bars covering the largest number of tasks start from the left in a 
descending order. The blue line indicates how many bars you must analyze to cover 80% of 
all tasks that don't have good knowledge coverage. For more information, see Pareto chart for 
Knowledge Demand Insights.

3. Optional:  To generate a representative sample to see a smaller list, in the Knowledge Curation 
Tasks list, click Generate Representative Sample.
If the Knowledge Curation Tasks list is large, you can generate a representative sample 
subset of a Knowledge Curation Tasks list. This smaller list aims to accurately reflect the 
characteristics of the tasks included in the main list.

4. Analyze the sample to create a knowledge gap feedback task or ignore the tasks within a 
collection.

Result
If tasks within a collection are reported as knowledge gaps, a common feedback task for all 
the selected tasks is created and appears in the Knowledge Management  application. You can 
use the assignment rules to assign a feedback task to an ownership group or author. In the 

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3334

https://www.webstg.servicenow.com/docs/access?context=t_AssignmentModuleRule&version=washingtondc&pubname=washingtondc-application-development&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=t_AssignmentModuleRule&version=washingtondc&pubname=washingtondc-application-development&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=t_AssignmentModuleRule&version=washingtondc&pubname=washingtondc-application-development&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=create-and-edit-dashboards&version=washingtondc&pubname=washingtondc-now-intelligence&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=create-and-edit-dashboards&version=washingtondc&pubname=washingtondc-now-intelligence&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=create-and-edit-dashboards&version=washingtondc&pubname=washingtondc-now-intelligence&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=create-and-edit-dashboards&version=washingtondc&pubname=washingtondc-now-intelligence&ft:locale=en-US


Knowledge Curation Tasks list, the Is knowledge gap created  column value for the selected 
tasks is set to true.

If you select an ignored collection from the demand insights dashboard, you can no longer report 
tasks within the collection as knowledge gaps.

Related topics

Demand Insights for Cases dashboard

Demand Insights for Incidents dashboard

Using Knowledge Management

Use Knowledge Management  to search and find information on self-help, troubleshooting, and 
task resolution in knowledge bases.

Knowledge Management guide for users

After knowledge bases are set up, you can start searching and creating articles.

Requirements

Role required: All users can read knowledge articles. Users with the knowledge or any other 
fulfiller role, such as sn_customerservice_agent, can create and edit knowledge articles in a 
knowledge base, unless the knowledge manager has restricted access to the knowledge base or 
knowledge articles.

If you need these permissions, contact the knowledge manager or knowledge administrator for 
the knowledge base.

What to do

Create knowledge articles

If you have the required permissions for a knowledge base, you can create articles 
for it. You can Create a knowledge article from an incident in Service Operations 
Workspace  or by importing Word documents.

You can also create knowledge articles from incidents and problems.

Search for knowledge articles

From the Knowledge homepage, you can select a knowledge base to search for 
articles and answers. You can view only the knowledge bases to which you have 
access.

Access to knowledge using your mobile device  is supported.

Next steps

After articles are created, you can perform the following tasks to make sure that articles are 
organized in the right knowledge bases and retired when appropriate. If existing knowledge 
bases do not fit your needs, you can request a new knowledge base.

• Move a knowledge article

• Retire a knowledge article

• Request a knowledge base
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Knowledge Management Service Portal homepage features

The Knowledge Management  Service Portal homepage displays knowledge articles organized 
by knowledge base and category, as well as featured content and popular articles. Learn how to 
navigate the homepage to search for and find useful and relevant information quickly.

To use the Knowledge Management Service Portal, the Knowledge Management — Service Portal 
plugin (com.snc.knowledge_serviceportal) must be activated.

Note: 
It’s active by default for customers on the Madrid and later releases. 
Existing or upgrade customers must activate the plugin and enable the 
glide.knowman.serviceportal.enable_redirect  property.

To see the Knowledge Management Service Portal homepage, add /kb  to the end of the URL 
for your instance. You can change the default navigation by configuring the system property 
sn_km_portal.glide.knowman.serviceportal.portal_url.

Your organization can customize the homepage, so it may look different to the following image. 
You must be logged in to view the knowledge homepage.

Knowledge Management Service Portal homepage features

UI 
component

Description

Knowledge 
profile 
menu

Click your profile photo to either view your knowledge profile or logout.

Search Enter a search term to search knowledge bases.

Counters Displays the number of available knowledge bases and the total number of 
knowledge articles.

Ask a 
question

This action is available to logged-in users with the knowledge role. Click Ask a 
Question, which opens a question page. Fill in the Question  and Question details 
fields, and click Post question  to post the question.

Overflow 

icon ( )

Click the Overflow icon and select Create Article  to create a knowledge article.

Browse 
knowledge 
bases

Click a knowledge base to view knowledge articles and questions stored in it.

View counters of how many articles and questions are stored in the knowledge 
base.

Click Show All  to view up to eight available knowledge bases.

Subscribe Click Subscribe  to subscribe to that knowledge base. Unsubscribe by clicking 
Unsubscribe.

Featured Lists any knowledge articles that were pinned. For more information, see Add a 
knowledge article to featured content.

Most 
Useful

Lists the top five articles that were marked as helpful.

Most 
Viewed

Lists the top five articles with the most views.
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Note: 
The Knowledge Management Service Portal homepage is mobile responsive.

Knowledge Management Service Portal search results page features

View a list of search results as well as options for sorting and filtering the items in the list. You can 
also use knowledge search in other Service Portals.

Note: 
When you perform a new search, the filters you selected earlier on the Knowledge 
Management search results page are not saved. Further, this search feature supports only 
Zing search and not AI search. You must reselect the filters that you want to apply for every 
search.

Knowledge Management Service Portal search results page

UI 
component

Description

Search bar Use the search bar at the top of the page to search for additional information.

Sort Sort the items in a knowledge base or search results list using the Sort by options 
at the top of the list.

• Views: sorts by number of article views.

• Newest: sorts by the date created or updated.

• Alphabetical: sorts alphabetically by the article Short description field.

• Relevancy: sorts by relevance to the search term.

The header displays the number of search results, which updates as the user 
selects and de-selects filters.

When you navigate away from the search results page and then return, your last 
sort selection is retained.

Search 
results list

View knowledge articles and pinned articles.

Knowledge article search results include articles in which the short description, 
text content, or attached file content includes the search term.

View the knowledge article short description, the knowledge base in which the 
article is stored, author name, number of views, and rating information.

Language 
filter facet 
widget

Language: lists the languages that have been activated. Select one or more 
languages to display search results in. Your selection is maintained across logins. 
If multi-language search is enabled, you can search for multiple languages 
simultaneously.

Knowledge 
base filter 
facet 
widget

Knowledge Base: lists the available knowledge bases
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Knowledge Management Service Portal search results page  (continued)

UI 
component

Description

Category 
filter facet 
widget

Category: lists the available knowledge categories.

Note: 
Shows a hierarchy of categories if the administrator configured the Show 
category hierarchy (valid for kb_category only) instance option for the facet 
widget.

Other 
filter facet 
widgets

Use filter facets to refine your search results.

The selections you make filter the items displayed in the search results list. The 
search results list updates to display only those items that match your selections. 
Deleting a selection from the filter facet or breadcrumb reverses the filtering in the 
list.

Clear selected filter options by:

• Deleting a single option from the search results list header.

• Clicking Clear all in the search results list header.

• Clicking Clear in the filter facet widget header.

• Author: lists the names of the authors for the knowledge articles included in the 
search results list

• Tags: lists the available knowledge tags

• Resource: lists the types of items available, such as knowledge articles

• Rating: lists article ratings from 0-5 stars (clicking a rating displays articles that 
have the selected rating and higher)

• Last Modified: lists selections based on the timing of knowledge item 
modifications such as Past Month or Past Week

• View Count: lists the knowledge item view counts such as More Than 50 or Less 
Than 10. Set the number of days to consider when calculating view count using 
the glide.knowman.view_age.days  property. For more information on 
this property, see Knowledge portal properties.

View 
additional 
search 
results

Depending on the system setup, view additional search results using one of these 
options:

• Standard Pagination: displays the search results in multiple pages.

• Infinite Scroll: displays the search results while scrolling.
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Note: 
If a custom widget on the knowledge search results page uses the 
KnowledgeSearchService  angular service, you must add the 
sn.knowledgeApplication  dependency to enable the functionality of the custom 
widget.

1. Navigate to Service Portal  > Dependencies.

2. In the Name  field, search for the sn.knowledgeApplication  dependency.

3. If a message appears, click here  to edit.

You have to be in the Knowledge Management - Service Portal  application to edit.

4. Click Update.

The search functionality in Knowledge Management  Service Portal  pages uses the 
Knowledge Base Search  search context to fetch results. As an administrator, you must not 
update the definition of this search context because it may impact the search behavior. For 
more information about contextual search, see Contextual search concepts .

Knowledge Management Service Portal article view page features

The knowledge article view page in Knowledge Management Service Portal displays the 
knowledge article details, including the article number, short description, and article content. You 
can also give feedback or comment on an article.

Knowledge article view page in Knowledge Management Service Portal

UI component Description

Breadcrumb View which knowledge base the knowledge article is in.

Header View the knowledge article number.

Subscribed Click Subscribe  to subscribe to the knowledge article. Unsubscribe by clicking 
Unsubscribe.

Actions Edit the knowledge article or flag an article that contains incorrect or 
inappropriate content. To edit the article, you must have contribute access to the 
knowledge article.

Note: 
The flagged comment appears in the comment section without reloading 
the page.

If the article was created using Microsoft  Word, download the article as 
a Microsoft  Word document to your computer by clicking Download as 
Word. This option appears only when the article was originally created 
using Microsoft  Word and the system administrator has enabled the 
sn_km_word.glide.knowman.enable_document_download 
property.

Article title View the short description of the article as the title of the article.

Language 
list

Select a language for the selected article. This field appears if the translations of 
the knowledge article in other languages are available.

Knowledge 
article 
content

View the text and images of the knowledge article.
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Knowledge article view page in Knowledge Management Service Portal  (continued)

UI component Description

View who authored the article and when as well as the number of views 
(including multiple views from the same user) the article has.

Copy 
Permalink

Click Copy Permalink  to copy the URL of the latest article version to the 
clipboard.

Note: 
The version of the article that loads for the user using the permalink 
depends on their level of access to the article. Users with view access will 
see the most recent published version. Users with contribute access will 
see the most recent version of the article, even if it is a draft.

Helpful? Provide feedback on an article by marking it as helpful or not.

View a percentage value of how many other users found the article helpful.

Rate this 
article

Rate a knowledge article.

Click here to 
comment to 
this article

Add a comment to an article

Attachments View a list of article attachments if the Display Attachment  field for the article is 
enabled.

Related 
Items

View a list of catalog items mapped to the article. The section appears only when 
the related catalog items are available for the selected article.

Related 
Articles

View a list of related articles with information similar to the selected article. The 
related articles are manually mapped, automatically predicted, or both. The 
manually mapped articles appear first in the section. The section appears only 
when the related articles are available for the selected article.

Affected 
Products

View a list of which products were affected.

Most Recent 
tasks

View a list of tasks, such as incidents, cases, problems, and so on, recently 
associated with the article.

Most Useful View a list of knowledge articles that users found most useful.

Search bar Use the search bar to start a new search. The search is executed in the current 
portal where you are viewing the article.

Note: 

• If enabled, users can subscribe to articles, view article versions, and create feedback for 
articles that are rated as not helpful.

• The dynamic titles don’t apply to the knowledge article view page in the Knowledge 
Management Service Portal.

Knowledge article URL parameters

You can add parameters to an article URL to view the latest version and an existing translation.
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Knowledge article URL structure

The knowledge article URL appears in the following structures:

• Accessed from Service Portal: https://<instance-name>.service-
now.com/kb?id=kb_article_view&sysparm_article=<article 
number>&sysparm_language=<language code>

For example, the URL https://yourbusiness.service-now.com/kb?
id=kb_article_view&sysparm_article=KB0010053&sysparm_language=EN 
returns the article with the most recent version in the selected language, if the translation for 
the selected language exists.

Note: 
If you open an article with sysparm_article and sys_kb_id parameters that belong to 
different articles, the article loads based on a sysparm_article.

• Accessed from Knowledge Base View (kb_view) UI page: kb_view.do?
sysparm_article=<article number>&sysparm_language=<language 
code>’

For example, the URL https://yourbusiness.service-now.com/kb_view.do?
sysparm_article=KB0010044&sysparm_language=enreturns the article with 
the most recent version in the selected language, if the translation for the selected language 
exists.

Note: 
The listed parameters can include the sys_id in the url parameter.

Parameters

The following parameters are available for knowledge article URLs.

Parameter Possible values

sysparm_article Returns the most recent article 
version. For example, https://
yourbusiness.service-
now.com/kb?
id=kb_article_view&sysparm_article=KB0010053.

sysparm_language Returns the most recent article version 
in the input language if a translation 
exists. For example, https://
yourbusiness.service-
now.com/kb?
id=kb_article_view&sys_id=3b07857187032100deddb882a2e3ec20&sysparm_language=EN.

Managing email notifications in Knowledge Management

Reminders enable relevant users to review knowledge articles and complete tasks associated 
with them.

By default, the Knowledge Management  application includes the following types of email 
notifications:
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• Email notifications for knowledge article feedback tasks.

• Email notifications for knowledge subscriptions.

• Email notifications for knowledge article approval publishing workflow.

• Email notifications for translation tasks.

• Email notifications for expiring knowledge articles.

• Email notifications for article quality index (AQI) reviews.

You can decide if you must receive any knowledge notifications by setting notification 
preferences. For more information, see Set knowledge notification preferences.

Email notifications for knowledge article feedback tasks

The email notifications for knowledge article feedback tasks are available when your 
administrator activates the Knowledge Management Core plugin (com.glideapp.knowledge).

The following table describes the recipient list of notifications for knowledge article feedback 
tasks and the associated conditions when a notification is sent.

Recipient list of the email notification for knowledge article feedback tasks

Notification Condition Recipients

KM Feedback Task: 
Commented

A comment was added to a user feedback 
task.

User who was assigned 
the feedback task

KM Feedback Task: 
Created

A user feedback task was created. User who was assigned 
the feedback task

KM Feedback Task: 
Info from Submitter

More information was requested from the 
submitter of a user feedback task.

User who submitted the 
feedback task

KM Feedback Task: 
Reassigned

A user feedback task was reassigned. User who was 
reassigned the feedback 
task

KM Feedback Task: 
Resolution Accepted

A resolution described in a user feedback 
task was accepted.

User who was assigned 
the feedback task

KM Feedback Task: 
Resolution Rejected

A resolution described in a user feedback 
task was rejected.

User who was assigned 
the feedback task

KM Feedback Task: 
Resolved

A user feedback task was set as resolved. User who submitted the 
feedback task

Email notifications for knowledge subscriptions

The email notifications for knowledge subscriptions are available when your administrator 
activates the Knowledge Management Core plugin (com.glideapp.knowledge). For notifications 
associated with ownership groups, your administrator must also activate the Knowledge 
Management Advanced plugin (com.snc.knowledge_advanced).

The following table describes the recipient list of notifications for knowledge subscriptions and 
the associated conditions when a notification is sent.
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Recipient list of the email notification for knowledge subscriptions

Notification Condition Recipients

KM Subscription 
Group: Article 
checkout

A subscribed knowledge 
article was checked out

• Author (if no Ownership group is 
associated with the article)

• Ownership group manager and 
members (if an Ownership group is 
associated with the article)

• Revisers

Note: 
The user who checked out the article 
does not receive the notification.

KM Subscription 
Group: Article 
commented

A comment was added to 
a subscribed knowledge 
article

• Author (if no Ownership group is 
associated with the article)

• Ownership group manager and 
members (if an Ownership group is 
associated with the article)

• Revisers

KM Subscription: 
Article published

A knowledge article was 
created in a subscribed 
knowledge base

• knowledge base owner

• Knowledge base subscribers

KM Subscription: 
Article revised

A subscribed knowledge 
article was edited

• Knowledge base owner

• Knowledge article subscribers

• Author

• Revisers

KM Subscription: 
Article revised in 
subscribed KB

A knowledge article in a 
subscribed knowledge base 
was edited.

• Knowledge base owner

• Knowledge article subscribers

• Author

• Revisers

• Knowledge base subscriber

Note: 
An email notification is sent to a reviser of a knowledge article when the article versioning 
feature is enabled.

Email notifications for knowledge article approval publishing workflow

The email notifications for knowledge article approval publishing workflow are available when 
your administrator activates the Knowledge Management Core plugin (com.glideapp.knowledge).
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The following table describes the recipient list of notifications for the knowledge article approval 
publishing workflow and the associated conditions when a notification is sent.

Recipient list of the email notification for the knowledge article approval publishing 
workflow

Notification Condition Recipients

A knowledge article was approved for 
publishing with the ownership group feature 
disabled.

Knowledge base owner and 
managers

KM: Approve 
article for 
publishing

A knowledge article was approved for 
publishing with the ownership group feature 
enabled.

Ownership group manager 
and members

KM: Article 
approved for 
publish

A knowledge article was approved for 
publication.

User (author or reviser) who 
submitted the article for 
approval

KM: Article 
rejected for 
publish

A knowledge article was rejected for 
publication.

User (author or reviser) who 
submitted the article for 
approval

Note: 
An email notification is sent to a reviser of a knowledge article when the article versioning 
feature is enabled.

Email notifications for translation tasks

The email notifications for translation tasks are available when your administrator activates 
the Knowledge Management Advanced plugin (com.snc.knowledge_advanced) and I18N: 
Knowledge Management Internationalization Plugin v2 plugin (com.glideapp.knowledge.i18n2). 
The 18N: Internationalization plugin (com.glide.i18n) activates the I18N: Knowledge Management 
Internationalization Plugin v2 plugin.

The following table describes the recipient list of notifications for translation tasks on knowledge 
articles and the associated conditions when a notification is sent.

Recipient list of the email notification for translation tasks

Notification Condition Recipients

KM Translation 
Task: Assigned to 
me

A translation task was assigned. User who was 
assigned the 
translation task

KM Translation 
Task: Closed

A translation task was closed after the translated 
version of the knowledge article was published.

• User who was 
assigned the 
translation task

• User who submitted 
the translation task
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Email notifications for expiring knowledge articles

The email notifications for expiring knowledge articles are available when your administrator 
activates the Knowledge Management Core plugin (com.glideapp.knowledge) and sets the value 
of the glide.knowman.enable_article_expiry_notification  property to true. 
By default, the property value is set to false.

Knowledge articles have an expiration date set using the Valid to  field when creating the article. 
Articles do not appear in search results after the Valid to date.

On the first day of each month, the application sends an email notification to a list of authorized 
recipients to remind them about articles that are scheduled to expire in the next month. The 
user can then determine whether to extend the Valid to  date to continue providing access to the 
article.

Note: 
To extend the Valid to  date of a knowledge article, see Edit a knowledge article

The content of the email notification is determined by the number of articles expiring in the 
coming month.

• Up to 10 – The email notification includes a list of article links displayed in a tabular format 
and arranged in ascending order by their Valid to date. Clicking a link opens the article in 
ServiceNow AI Platform.

• More than 10 – The email notification includes a View the list of expiring articles  link, which 
when accessed opens a list in ServiceNow AI Platform  of all articles expiring in the next month.

The following table describes the recipient list of notifications for expiring knowledge articles and 
the associated conditions when a notification is sent.

Recipient list of the email notification for expiring knowledge articles

Notification Condition Recipients

An article is scheduled to expire in the next month 
with the ownership group feature disabled.

• Author

• Knowledge base owner 
and managers

• Reviser for the updated 
and checked-out 
versions

KM: Article 
Expiry 
Warning

An article is scheduled to expire in the next month 
with the ownership group feature enabled.

• Author

• Knowledge base owner 
and managers

• Reviser for the updated 
and checked-out 
versions

• Ownership group 
manager and members
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Note: 
An email notification is sent to a reviser of a knowledge article when the article versioning 
feature is enabled.

Email notifications for article quality index (AQI) reviews

The email notifications for an article quality index review on knowledge articles are 
available when your administrator activates the Knowledge Management Advanced plugin 
(com.snc.knowledge_advanced).

The following table describes the recipient list of notifications for an AQI review on knowledge 
articles and the associated conditions when a notification is sent.

Recipient list of the email notification for AQI reviews

Notification Condition Recipients

KM: AQI on 
Article

An AQI was performed and submitted on a 
knowledge article with the ownership group 
feature disabled.

User (author or reviser) 
who last updated the 
article

KM: AQI on 
Ownership 
Group Article

An AQI was performed and submitted on a 
knowledge article with the ownership group 
feature enabled.

• User (author or reviser) 
who last updated the 
article

• Ownership group

Note: 
An email notification is sent to a reviser of a knowledge article when the article versioning 
feature is enabled.

Related topics

Activate the Knowledge Management Advanced plugin

Additional plugins for Knowledge Management

Ownership groups

Validity of a knowledge article

Knowledge subscriptions

Set knowledge notification preferences

Set notification preferences for knowledge bases and knowledge articles.

Before you begin
Role required: knowledge

About this task
Users can set notification preferences from the Knowledge menu or from the Knowledge 
Management Service Portal.

Procedure

1. Navigate to the Notification Settings page.
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2. Click the Notification Preferences tab.

3. Click Knowledge Base  and enable or disable the knowledge base notification options.

4. Click Knowledge Articles  and enable or disable the knowledge article notification options.

Using the homepage of Knowledge Management v3

The Knowledge Management v3 homepage displays knowledge articles organized by knowledge 
base and category, as well as featured content and popular articles.

To view the default knowledge homepage, navigate to Self-Service  > Knowledge.

Note: 

• The knowledge homepage is not compatible with Internet Explorer 9 or earlier. Using one 
of these browsers will cause you to be redirected to the legacy knowledge portal.

• The Knowledge v3 home page is not customizable. Use the Knowledge Management 
Service Portal  for an easily configurable user experience.

• Starting with the Washington DC  release, the Knowledge Management  v3 
homepage (com.snc.knowledge3) is being prepared for deprecation in the 
future Y release. It is replaced by the Knowledge Management  Service Portal 
(com.snc.knowledge_serviceportal), which is active by default for customers on Madrid 
and later releases. For more information about the new experience, see Knowledge 
Management Service Portal homepage features.

If you access knowledge from a service management application, the knowledge homepage for 
the associate application opens.

Only published and not yet expired knowledge articles (that is the valid do date not yet reached) 
appear on the homepage.

From the homepage, you can import a Word document to a knowledge base by clicking Import 
Articles.

Note: 
From Madrid, you can import a word document from the Import Articles module available 
in the Application Navigator. This feature is active by default for customers on Madrid and 
later releases. Existing customers on release versions prior to Madrid use the Word import 
functionality on the Knowledge V3 homepage. Upgrade customers use the Word import 
functionality on the Knowledge V3 homepage by default. If required, add the Import Articles 
module to the Application Navigator. If you add the module, the Import Articles  button does 
not appear on the Knowledge v3 homepage.

You can also create a new article using the Create An Article  button.

• Import a Word document

• Create a knowledge article from an incident in Service Operations Workspace

Note: 
You must have contribute access to at least one active knowledge base, otherwise these 
buttons do not appear. See Configuration tasks for knowledge managers.

You can select a knowledge base to browse articles within that knowledge base. You can view 
only knowledge bases you can access.
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Articles are organized by category or by tag. Categories are listed alphabetically. You can sort 
content by most recent update or by number of views.

You can comment on an article. There is no HTML formatting available for comments on the 
Knowledge V3 homepage.

Existing customers on release versions prior to New York can view knowledge article feedback 
comments in the following ways.

• On the Knowledge v3 homepage.

• If the Knowledge Management — Service Portal plugin (com.snc.knowledge_serviceportal) is 
installed, on the Knowledge Service Portal.

• If the Use Live Feed for knowledge feedback property is active, in the Live Feed.

For new customers on New York and later releases, comments can only be viewed in the 
Knowledge Service Portal.

An administrator can configure the knowledge homepage to display the number of articles within 
each category. This count includes articles from subcategories. To display the article count, set 
the glide.knowman.show_number_on_categories  property to true.

Related topics

Define a knowledge article category

Import a Word document to a knowledge base using Knowledge Management v3

Import a Word document to a knowledge base

Search using Knowledge Management  v3

Search for knowledge articles from the knowledge homepage using the search bar on the 
Knowledge Management v3 homepage.

Search results include only articles and questions you are authorized to read. The search results 
count do not take into consideration any security rules set for the articles. The number of articles 
you can access may be lower than the count displayed in the search results page. Documents 
that are attached to articles are also listed in the search results.

Note: 

• To change how the attachments are displayed in the search results, 
set the How to display attachments in Knowledge Search Results 
glide.knowman.search.attachment  property. Attachments can be displayed 
with a text snippet, link only, or not at all.

Warning: 
Attachments set to display with a text snippet may cause slowness.

• To use wildcards in your search, navigate to Contextual Search  > Search Contexts  > 
Knowledge Base Search  and select Enable wildcard searches.

Sort knowledge content by relevancy, most recent update, or number of views.

Filter results using the check boxes that appear. Filtering options appear depending on the 
search text.  Knowledge homepage; browsing and searching for articles; viewing articles, 
providing feedback; posting questions; importing/creating articles

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3348



Filtering options

Field Description

Knowledge 
Bases

Select a knowledge base to search. You can select only knowledge bases you 
can access. If you do not select a specific knowledge base, search results include 
articles and questions from all knowledge bases that you can access. You can also 
select a knowledge base from the choice list in the search bar.

For pinned articles, only those in the selected knowledge base in the 
corresponding language appear.

Categories Select one or more knowledge categories. Categories are listed alphabetically.

Authors Select one or more authors.

Language
The multi-language search feature is available when more than one supported 
language is enabled.

1. To enable multi-languages, activate the I18N: Knowledge Management 
Internationalization Plugin v2 plugin (com.glideapp.knowledge.i18n2) or activate 
one of the internationalization plugins for the language you require.

Note: 
Activating internationalization plugins for any of the available 
languages automatically activates the I18N: Knowledge Management 
Internationalization Plugin v2 plugin.

2. To display search results in all available languages simultaneously, enable the 
glide.knowman.enable_multi_language_search  property.

a. Navigate to Knowledge  > Administration  > Properties  > Knowledge Search 
Properties  > Enable multi language search  and select the Yes  check box.

b. Enter sys_properties.listin the filter navigator, search for the property 
to configure, and in the Value  field, enter true.

Note: 
By default, the 
glide.knowman.enable_multi_language_search  property 
is not enabled. Search results are displayed based on the language you 
select in the language filter on the Search page.

Note: 

Starting with the Washington DC  release, the Knowledge Management  v3 
homepage (com.snc.knowledge3) is being prepared for deprecation in the 
future Y release. It is replaced by the Knowledge Management  Service Portal 
(com.snc.knowledge_serviceportal), which is active by default for customers on Madrid 
and later releases. For more information about the new experience, see Knowledge 
Management Service Portal homepage features.

Related topics

Knowledge Management properties

Import a Word document to a knowledge base using Knowledge Management v3

Import a Microsoft Word document using Knowledge Management v3 homepage to create a 
knowledge article.
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Before you begin
You must have contribute access for at least one active knowledge base.

Note: 

Starting with the Washington DC  release, the Knowledge Management  v3 
homepage (com.snc.knowledge3) is being prepared for deprecation in the 
future Y release. It is replaced by the Knowledge Management  Service Portal 
(com.snc.knowledge_serviceportal), which is active by default for customers on Madrid 
and later releases. For more information about the new experience, see Knowledge 
Management Service Portal homepage features.

The Import Articles  button does not appear in the following conditions:

• The Import Articles module is available in the application navigator.

Note: 
Beginning with Madrid, the Import a Word document feature is enabled by default 
and the Import Articles module is displayed in the application navigator. The Import a 
Word document feature isn’t enabled automatically for the existing customers who can 
continue using the Import Articles  option on the Knowledge Management v3 page. For 
more information, see Import a Word document to a knowledge base.

• You cannot contribute to any knowledge base.

Note: 
An administrator can control the visibility of the Import Articles  button by setting the other 
knowledge property Hide the 'Import' functionality (button and drag-n-drop) for all users 
(glide.knowman.import.hide_import_functionality) to true.

Role required: None

About this task
You can import Microsoft Word documents in the .doc and .docx file formats.

Note: 
The file extension must be lowercase.

When you import a document, text content from the document is used to create the knowledge 
article. The articles support all editing functions supported by the TinyMCE editor . All HTML 
supported by TinyMCE such as tables, lists, and links, as well as styling such as bold and italics, 
are preserved. Images from the document are added as attachments to the knowledge article 
and embedded in the article body.

Note: 

You can import multiple files at a time. Closing the browser or navigating away cancels any 
in-progress uploads but does not delete articles created from completed imports.

You cannot import documents to knowledge from mobile devices.

The following styles and elements are preserved when importing a .doc or .docx file into a 
knowledge base. Styles and elements not included in this list may not be preserved when 
importing a document.

• Titles

• Headings
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Note: 
Only default heading settings are supported. For any headings and subheadings with 
numbers, the numbers are not imported.

• Images

Note: 
Images may not be aligned exactly as in the Word document you import.

• Links

Note: 
Links are preserved for documents with .docx format only.

• Bold text

• Italic text

• Underlined text

• Ordered and unordered lists

Note: 
After import, the bullets in an unordered list are replaced with dots.

• Tables

Note: 
Only default heading settings are supported. Custom heading styles are imported using 
the default settings for those styles. Table styling and borders are not supported.

Procedure

1. Navigate to All  > Self-Service  > Knowledge.

2. Select one or more document files and drag onto the knowledge homepage.

3. Select the Knowledge base  to add the new article to.
You can select only knowledge bases you can contribute to.

4. Optional:  Select a Category  from within that knowledge base.

Note: 
Use the category picker to add a category. The picker does not differentiate between 
the different category levels. You can select a category or sub category and add it to the 
Category  field.

5. Optional:  Select the Publish  check box to start the publishing workflow for each imported 
article immediately after the import finishes.
This check box applies only when importing to v3 knowledge bases and only if the Show 
publish checkbox on the knowledge import pop-up  property is set to Yes  on the Knowledge 
Management properties form. You cannot automatically publish articles imported to v2 
knowledge bases.

Knowledge v2 articles go into Draft  state. Knowledge v3 articles go into Review  or Published 
state, depending on the workflow attached to the knowledge base (Approval Publish or Instant 
Publish).
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6. Select Import.

A new article is created in the selected knowledge base and category using the content from 
the uploaded document. If you uploaded multiple documents, one article is created for each. 
If you use knowledge internationalization, the language of the new article is set to the currently 
selected system language.

After the upload completes, a popup window appears displaying the number and short 
description of the newly-created articles. Click an article to view the full record.

If any errors occur during the upload, a popup window appears to display the error.

Related topics

Import a Word document to a knowledge base

Request a knowledge base

If existing knowledge bases do not fit your needs, you can request a new knowledge base 
through the service catalog. If the request is approved, you are added as the owner of the new 
knowledge base.

Before you begin
Role required: none

About this task
If no knowledge base exists that fit your needs, all users can request a new knowledge base.

Procedure

1. Navigate to All  > Self-Service  > Service Catalog.

2. Select Can We Help You?.

3. Select the Request Knowledge Base  catalog item.

4. Enter the reason you want the knowledge base, and a name for the knowledge base.

5. Click Submit.

What to do next
You are notified when the request is approved or rejected. If the request is approved, you are 
added as the owner of the new knowledge base. You can then assign managers and manage 
articles in the new knowledge base.

Knowledge bases created through this request process are inactive by default, so you must 
activate the knowledge base to make it available for users.

Related topics

Assign a knowledge base manager

Add a knowledge article to featured content

Create a knowledge article

Import a Word document to a knowledge base

Import a Word document to create a knowledge article.

Before you begin
You must have Can Contribute  access to at least one active knowledge base.

Role required: knowledge
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About this task
Beginning with Madrid, the Import a Word document feature is enabled by default and the Import 
Articles module is displayed in the application navigator.
These styles and elements are preserved when importing a .doc or .docx file into a knowledge 
base. Styles and elements not included in this list may not be preserved when importing a 
document.

• Titles

• Headings

Note: 
Only default heading settings are supported. For any headings and subheadings with 
numbers, the numbers are not imported.

• Images

Note: 
Images may not be aligned exactly as in the Word document you import.

• Links

• Bold text

• Italic text

• Underlined text

• Ordered and unordered lists

Note: 
After import, the bullets in an unordered list are replaced with dots.

• Tables

Note: 
Only default heading settings are supported. Custom heading styles are imported using 
the default settings for those styles. Table styling and borders are not supported.

Note: 

Starting with the Washington DC  release, the Knowledge Management  v3 
homepage (com.snc.knowledge3) is being prepared for deprecation in the 
future Y release. It is replaced by the Knowledge Management  Service Portal 
(com.snc.knowledge_serviceportal), which is active by default for customers on Madrid 
and later releases. For more information about the new experience, see Knowledge 
Management Service Portal homepage features.

Procedure

1. Navigate to All  > Knowledge  > Articles  > Import Articles.

2. Enter the knowledge base to add the article to.

3. Optional:  Select a Category  from within the knowledge base.

Note: 
Use the category picker to add a category. The picker does not differentiate between 
the different category levels. You can select a category or sub category and add it to the 
Category  field.
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4. Optional:  Select the Publish  check box to start the publishing workflow for each imported 
article immediately after the import finishes.

Note: 
The Publish  check box appears only when the Show publish checkbox on the 
knowledge import pop-up  property is enabled. To enable the property, navigate to 
Knowledge  > Administration  > Properties  and select the check box for the Show 
publish checkbox on the knowledge import pop-up  property.

5. Select one or more Word files to import.

6. Click Import.

An article is created in the selected knowledge base and category using the content from the 
uploaded document.

◦ If you uploaded multiple documents, one article is created for each.

◦ If you use knowledge internationalization, the language of the article is set to the system 
language selected.

◦ When the upload completes, a pop-up window displays the number and short description of 
the articles. Click an article to view the full record.

◦ If any errors occur during the upload, a pop-up window displays the error.

◦ If the Publish  check box is activated, knowledge articles go into Review  or Published  state, 
depending on the workflow attached to the knowledge base.

◦ If the Publish  check box is not activated, the knowledge articles go into Draft  state and are 
then reviewed before publishing.

Related topics

Import a Word document to a knowledge base using Knowledge Management V3

Use knowledge on mobile devices

All users can access knowledge from mobile devices to search for and view knowledge articles.

You can also view recently viewed and most popular articles, search for articles, browse articles 
by category, and provide feedback to knowledge articles from Now Mobile. For information, see 
Using Now Mobile for Knowledge Management.

Browse knowledge on mobile devices

You can browse knowledge bases using a mobile device.

Navigate to SELF-SERVICE  > Knowledge Base.
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Mobile Knowledge View

Browse Knowledge by tapping on a category and browsing articles or subcategories.
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Mobile Knowledge Categories

Note: 

Select the desired category and click the close icon ( ) for the selected category to 
reflect in the search results.

View knowledge articles on mobile devices

You can read knowledge content using a mobile device.

Tap a title to view the article.

Note: 
You cannot edit or add comments to knowledge articles on the mobile interface.
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Mobile Knowledge Article View

Search knowledge on mobile devices

Find a specific article by searching on a particular term.

Mobile Knowledge Search
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Using Now Mobile  for Knowledge Management

Access knowledge articles from anywhere using the Information applet on the Now Mobile  app. 
You can view recently viewed and most popular articles, search for articles, browse articles by 
category, and provide feedback for articles.

To access articles from the Information applet on the Now Mobile  app, you must first download 
the ServiceNow  mobile application on an iOS platform from the Apple App Store or on an 
Android platform from the Google Play Store.

Now Mobile  Information applet

Make sure your administrator has activated the Now Mobile  app. For more information, see Now 
Mobile app .

After you access an article, you can view the author, published date, number of views, and the 
overall rating details of the article. In addition, you can respond to and evaluate articles and view 
related items, related articles, and attachments.

Using Now Mobile  app, even external users can access and provide feedback to the knowledge 
articles. For more information about external user functionalities and capabilities, see Mobile 
external users .

Activation information

The Information applet is available on the Now Mobile  app. The ServiceNow 
Mobile Request - Knowledge Management Screens and Applet Launcher plugin 
(com.glideapp.knowledge.mobile_requestor) activates the Information applet. The Information 
applet is activated by default for both new and upgrade customers.
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Related topics

Configure knowledge bases

Now Mobile app

View the most popular or recently viewed articles in the Now Mobile Information applet

View an article in the Now Mobile Information applet

Provide feedback for a knowledge article in the Now Mobile Information applet

View the most popular or recently viewed articles in the Now Mobile  Information applet

The Information applet on the Now Mobile  app enables you to access knowledge articles from a 
mobile device.

Before you begin
You can specify user criteria for an article to control which users can read the article. If no user 
criteria is defined for an article, all users can read the article.

Procedure

1. Access your instance using the mobile application.

2. On the Now Mobile  app, tap Information.

3. Access your recently viewed or the most popular knowledge articles

Information applet article views

Section Description

Recently Viewed Up to five of the articles you viewed within the 
last 30 days.

Popular Up to five of the most popular knowledge 
articles.

The Now Mobile  app homepage includes a 
similar section that displays up to three of the 
most popular articles.

Note: 
Tap See All  to view the complete list of articles within the selected section.

Related topics

Browse articles in the Now Mobile Information applet

Search for an article in the Now Mobile Information applet

Control access at the knowledge article level through user criteria

Browse articles in the Now Mobile  Information applet

You can browse articles within a category in the Now Mobile  Information applet to see articles 
related to a particular subject or grouping.

Before you begin
You can specify user criteria for an article to control which users can read the article. If no user 
criteria is defined for an article, all users can read the article.
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Procedure

1. Access your instance using the mobile application.

2. On the Now Mobile  app, tap Information.

3. In the Browse section, tap a category from the categories list to view articles and child 
categories associated with the selected category.

Note: 
Tap See All  to view the complete categories list.

4. Tap further categories until you view the articles list associated with the desired category.
The articles associated with a parent category are grouped under a dummy child category 
labeled as Other.

Other category

5. To view an article, tap the article in the articles list.

Related topics

View an article in the Now Mobile Information applet

Control access at the knowledge article level through user criteria

Search for an article in the Now Mobile  Information applet

You can search for an article in the Now Mobile  Information applet.

Before you begin
You can specify user criteria for an article to control which users can read the article. If no user 
criteria is defined for an article, all users can read the article.

Procedure

1. On the Now Mobile  app, tap Information.

2. Tap Search for Services, Articles or People, and enter a search term related to the article.

3. Tap the search icon on your app keyboard.
The app displays search results.

4. Tap Articles  to view only articles in the search results.

5. Tap an article in the search results to view the article content.

Related topics

View an article in the Now Mobile Information applet

Control access at the knowledge article level through user criteria
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View an article in the Now Mobile  Information applet

You can view the author, published date, number of views, and the overall rating details of 
the article in the Now Mobile  Information applet. In addition, you can respond to and evaluate 
articles and view related items and related articles.

Before you begin
You can specify user criteria for an article to control which users can read the article. If no user 
criteria is defined for an article, all users can read the article.

Procedure

1. On the Now Mobile  app, tap Information.

2. Search for or select the desired article from the sections available in the Information applet.
The article page displays the content and associated information for the selected article such 
as author, published date, number of views, and the overall rating. The page also displays the 
following sections:

UI component Description

Related Articles Up to five related articles that are manually 
mapped, automatically predicted, or both. 
The manually mapped articles appear first 
in the Related Articles section. This section 
appears only when related articles are 
available for the selected article.

Related Items Up to five related items that are manually 
mapped. This section appears only when 
related items are available for the selected 
article.

Attachments Files attached to an article. This section 
appears only when the attachments are 
available for the selected article.

To view a file, tap the file name. If an article 
contains more than two attachments, tap the 
number of attachments indicator and then 
tap the file name.

Note: 
Tap See All  to view the complete list of articles within the Related Articles or Related 
Items section.

3. Optional:  Respond to and evaluate the article.

Related topics

Provide feedback for a knowledge article in the Now Mobile Information applet

Control access at the knowledge article level through user criteria

Provide feedback for a knowledge article in the Now Mobile  Information applet

You can contribute to feedback on knowledge articles by rating an article, marking an article as 
helpful or not helpful, and posting and replying to comments for an article in the Now Mobile 
Information applet.
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Before you begin
You can specify user criteria for an article to control which users can read the article. If no user 
criteria is defined for an article, all users can read the article.

Procedure

1. On the Now Mobile  app, tap Information.

2. Select the desired article.

3. Contribute to the article feedback by rating it, marking it as helpful or not helpful, or leaving a 
comment.

Action Description

Rate the article Tap the star icons displayed on the article to indicate its effectiveness 
on a scale of 1 to 5.

For ratings between 1 to 3 stars, a feedback task is automatically 
created for the article and assigned to the author or ownership group, 
as configured.

Mark an article as 
helpful or unhelpful

Tap the helpful icon ( ) or the not helpful icon ( ).

Enter your 
comment

Enter a comment in the Type your comment here  box and tap Submit.

View all comments 
and replies posted 
for the article

Scroll down to the Comments section.

Like a comment on 
the article

Underneath a comment, tap the like icon ( ).

Reply to a 
comment on the 
article

Underneath a comment, tap the reply icon ( ), enter your comment in 
the text box that appears, and then tap Submit.

Delete any 
previous comments 
or replies you 
posted earlier

Go to a comment or reply, and then tap the delete icon ( ). If a 
message appears, tap OK. Only users who have posted the comment, 
knowledge administrators, and knowledge owners can delete a 
comment.

View an attachment 
to a comment

View files, if available, attached to a comment.

To view a file, tap the file name. If a comment contains more than two 
attachments, tap the number of attachments indicator and then tap the 
file name.

Related topics

View an article in the Now Mobile Information applet

Control access at the knowledge article level through user criteria

Manage ownership groups

Create ownership groups and associate them to knowledge articles. Knowledge group managers 
or knowledge administrators can edit ownership groups.
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Before you begin
The Knowledge Management  Advanced plugin (com.snc.knowledge_advanced) must be 
activated.

Role required: Users with the knowledge_domain_expert or knowledge_admin roles can create 
ownership groups.

Users with the knowledge_group_manager or knowledge_admin roles can edit ownership 
groups.

About this task
Create an ownership group by adding members and a manager. Knowledge administrators 
approve ownership groups.
When knowledge articles are created, ownership groups can be associated to them. Ownership 
groups manage article approvals and feedback and can edit and retire knowledge articles that 
they are associated with.

Knowledge group managers can edit ownership groups managed by them by adding or removing 
members without the need for approval. They cannot change the manager assigned in their 
groups. Only knowledge administrators can reassign managers.

Procedure

1. Navigate to All  > Knowledge  > Ownership Groups  > Manage Group.

2. To create an ownership group, from the Request Type list, select Create Ownership Group.

Note: 
To edit an existing ownership group, from the Request Type list, select Edit Ownership 
Group.

3. Fill in the fields on the form.

Manage Knowledge Ownership Group form

Field Description

Name Name of the ownership group.

Group email An email address for the ownership group. Emails are sent to group members 
in these cases.

◦ Activity on articles they are associated with, for example, comments.

◦ Article quality checks (AQI) performed on articles they are associated with.

If no group email is defined, emails are sent to individual group member 
emails.

Description Description that defines the ownership group.

Manager Manager for the ownership group.

Group 
members

Members of the ownership group.

4. Click Order Now.
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The ownership group is sent to the knowledge administrator for approval. Once approved, the 
ownership group is ready to use and associate to a knowledge article.

Note: 
You can also create an ownership group from an existing group.

a. Navigate to System Security  > Users and Groups  > Groups.

b. Click a group.

c. In the Type  field, enter Knowledge.

Note: 
If the Type  field does not appear on the form, configure the form layout to add it.

d. In the Manager  field, enter a manager and add the role knowledge_group_manager.

e. In the Roles related list, click Edit  and add the role knowledge_group_member to the 
group.

Use article versioning

Use article versioning to create and maintain multiple versions of a knowledge article.

Manually update customized files

If you have customized any of the files that are updated as part of the Knowledge Management 
Advanced Installer plugin, these files are skipped during plugin activation and must be updated 
manually.

Manually update your customization to include the article versioning-related changes.

• Add the Version  field to the Knowledge form layout and the Knowledge list view, if it is not 
already present.

• Add the outdated  choice to the Workflow  choice list field on the Knowledge form, if it is not 
already present. Keep the value as outdated  because of dependencies that article versioning 
functionalities have on this choice.

• Update the Knowledge  > My Flagged  and Self-Service  > My Knowledge Articles  modules to 
include the following condition in the Filter  field, if these modules do not already reflect this 
change: Revised by is (dynamic) me.

If you have customized any of the Knowledge Management Overview dashboard reports, these 
files are also skipped during plugin activation and must be updated manually.

Check out a published article and create a new version

Create a new version of a knowledge article by checking out the latest published version.

Before you begin
Roles required: knowledge owner, knowledge manager, or knowledge administrator

About this task
You cannot check out a published article unless there is already a checked out version. If a 
version has been checked out, the Checkout  button does not appear on the Knowledge form 
header and you cannot edit the knowledge article. To make changes, you must first publish the 
knowledge article.

When you check out an article, the default value of Valid to  field of the article is derived from the 
Article Validity  field configured for the knowledge base (see Create a knowledge base). If the 
Article Validity  field is blank, the date in the Valid to  field date is set to January 1, 2100. An article 
author or editor can select whether to keep or change the default Valid to  date.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3364



When you check out an article, attachments from the article's base version are copied into the 
new article version and relative paths to these attachments are also updated.

Note: 
For article versions that were created in the previous releases, the relative paths 
to the attachments may not be updated. To update them, activate and run the Fix 
attachment links on article versions  fix script.

Procedure

1. Navigate to All  > Knowledge  > Articles  > Published.

2. Select the desired article from the list.

3. Click Checkout  in the Knowledge form header.
The system creates a new version of the knowledge article and displays a message to the user. 
The article number for the new version remains the same, the version number is increased by 
0.01, and the state changes to Draft.

4. Make your changes and click Publish.
The new version of the article is added to the Knowledge list and to the Article Versions 
related list on the Knowledge form.

Revert an outdated article to the current state

Use an outdated version of an article to create a new version.

Before you begin
Roles required: knowledge base owner, knowledge_manager, knowledge_admin

About this task
This action is available for earlier published version that have a state of Outdated  and only when 
there is no checked out version. If a version has been checked out, the Make this current  button 
does not appear on the Knowledge form header.

Procedure

1. Navigate to Knowledge  > Articles  > All.

2. Open an article in the Outdated  state.

3. Click Make this current  in the Knowledge form header.
The system displays the Knowledge form. The version number increments to the latest version 
number plus 0.01 and the state changes to Draft. For example, if the latest published version 
of an article is 3.0 and you select the outdated 1.0 version to become the current version, the 
version number increments to 3.01.

View all versions of an article

View a list of all available versions for a selected knowledge article and then view the selected 
version in a new tab.

About this task
The list of all available versions for a selected knowledge article is displayed in the Article 
Versions  related list on the Knowledge form. Users with read access can see major versions. 
Users with contribute access can see major and minor versions.

Procedure

1. Navigate to Knowledge  > Articles  > All.

2. Open the desired article.
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3. Click the Article Versions  tab to display the related list.

4. Click Version  to display the desired article version in a new tab.

5. If desired, click the View Version  related link to see the article view page.

Compare two versions of an article

Select and compare two versions of a knowledge article.

Before you begin
Role required: knowledge_manager, knowledge_admin

Note: 
For better comparison experience of the knowledge article versions, see Compare 
knowledge article versions in Agent Workspace.

Procedure

1. Navigate to a Knowledge  > Articles  > All.

2. Click a knowledge article with multiple versions.

3. In the Article Versions related list, select the check boxes for the two versions of the article to 
compare.

Article Versions

4. In the Actions on selected rows list, select Compare  from the list.
The Compare versions page opens and lists the fields (including Article body) for the selected 
article versions in a side-by-side format. Differences between the two article versions are 
highlighted.
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Compare versions page

5. Click Done  to return to the Knowledge form.

Retire a versioned article

You can retire the latest published version of a knowledge article. Retiring a knowledge article 
doesn’t create a version. It simply marks the article as Retired.

Before you begin
Role required: knowledge administrator, knowledge manager, and latest publisher of the 
versioned knowledge article (not available for kcs_candidate or kcs_contributor)

About this task
You can only retire an article, which has no checked out version. If a version has been checked 
out, the Retire  button doesn’t appear on the Knowledge form header.

Note: 
For the Knowledge - Approval Retire workflow, this happens only when the retire request is 
approved.

You can still access outdated articles that have been attached to incidents by navigating to 
the article view page with the sys_id of the article. Outdated articles include a message that an 
updated article is available.

If versioning is disabled, only the latest version of the article is shown in search results and list 
views.

Retired knowledge articles can’t be searched by external users or customers. To reuse a retired 
article, create an article with the same content, which is published once approved.

Beginning with the Utah  release, you can give a replacement article while retiring a knowledge 
article. When the retired article is accessed, you will automatically be redirected to the 
replacement article with a display message The article KBxxx is retired and has 
been replaced with the knowledge article KBxxx. If no replacement article is 
available, the page displays the message Knowledge record not found.

• Article with replacement returns a 301 code.

• Article without any replacement returns a 404 code.

• By default, the glide.knowman.enable_article_replacement_on_retire 
system property is set to true to give a replacement article for a retired article. The setup to 
redirect an article to a replacement article is set by default.
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Procedure

1. Navigate to All  > Knowledge  > Articles  > Published.

2. Select an article.

3. Click Retire  in the Knowledge form header.
The system returns to the Knowledge list. The state of the article changes to Pending 
retirement  and the state of previously published versions change to Outdated.

Note: 
You can’t check out or edit a retired article.

Result
The selected article is retired and can be accessed from Knowledge  > Articles  > Retired

Disable the article versioning feature

Users with the system administrator role can disable the article versioning feature by setting a 
property.

Before you begin
Role required: admin

About this task
The Enable article versioning feature(glide.knowman.versioning.enabled) property controls the 
article versioning feature. Setting this property to false  disables the article versioning feature. 
Once disabled:

• The Version  field is removed from the Knowledge form. The Version  column remains on the 
Knowledge list and can be removed manually.

• The Article Versions  related list is removed from the Knowledge form.

• The Recall, Checkout, and Make this current  buttons are removed from the Knowledge form.

• Outdated articles are removed from Knowledge list views.

• The version history does not appear on the article view page.

Articles continue to be versioned in the background. Minor versions are incremented until an 
article is published and then the version number is increased to the next major version.

Users can still access outdated articles that have been attached to incidents. Outdated articles 
include a message that an updated article is available.

Procedure

1. Navigate to All  > Knowledge  > Administration  > Properties.

2. Locate the Enable article versioning feature  property in the Article Versioning Properties 
section.

3. Click the check box to disable the property.

4. Click Save.

Using knowledge blocks

Use knowledge blocks to simplify knowledge authoring for writers and knowledge consumption 
for readers.
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Create a knowledge block

Create or modify a knowledge block to define a reusable piece of content that can be inserted 
into knowledge articles in a knowledge base. The knowledge block is secured by user criteria, 
which controls what users, groups, roles, companies, locations, or departments can read or 
not read the content in an article or search, enabling users to more easily view content that is 
relevant to them.

Before you begin
Activate knowledge blocks

Role required: user must have contributor access to the knowledge base.

Procedure

1. Navigate to All  > Knowledge  > Knowledge Blocks  > Create New.

2. Click New  or open a record.

3. Fill in the fields on the form.

Knowledge Block form

Field Description

Number This field is automatically set to a knowledge block number.

Knowledge base Name of the knowledge base.

The knowledge blocks feature must be enabled for each 
knowledge base that you plan to create blocks. See Enable 
knowledge blocks for each knowledge base.

Category Name of the knowledge category or subcategory.

Ownership Group Ownership group for the knowledge block. This field appears 
when the ownership groups feature is enabled.

Knowledge blocks can be used with or without the ownership 
groups feature. To learn more about ownership groups, 
including how to enable the feature, see Ownership groups.

Can read User criteria to apply for read access at the knowledge block 
level.

User criteria set at the knowledge base and knowledge 
block level controls which users can read or not read block 
content within an article. To learn more about selecting user 
criteria for a knowledge block, see Select user criteria for a 
knowledge block.

Cannot read User criteria to apply for cannot read access at the 
knowledge block level.

User criteria set at the knowledge base and knowledge 
block level controls which users can read or not read block 
content within an article. To learn more about selecting user 
criteria for a knowledge block, see Select user criteria for a 
knowledge block.

Valid to Date that the knowledge block expires. After the valid to date:
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Field Description

◦ Knowledge article viewer will no longer display expired 
knowledge block content in the associated knowledge 
article.

◦ Search will no longer return knowledge articles if the 
keywords are contained in the expired blocks.

Short Description Description of the knowledge block.

Text Text of the knowledge block.

Version This field is automatically set to a version number when the 
article versioning feature is enabled.

Knowledge blocks can be used with or without the article 
versioning feature. To learn more about article versioning, 
including how to disable the feature, see Article versioning.

Article type This field is automatically set to HTML.

Note: 
Knowledge blocks are only supported with HTML 
knowledge articles.

Workflow This field is automatically set to the publication state of the 
block, such as Draft, Published, or Retired.

Source task Not applicable.

4. Click Save  or Update  to create or update the block.

5. Click Publish  to publish the block.

Note: 
Any additional steps required to publish the knowledge block, such as approvals, 
depend on the publishing workflow for the knowledge base. See Knowledge workflows 
for more information.

What to do next
After the knowledge block is published, you can add the block to an article within the knowledge 
base.

Select user criteria for a knowledge block

Control which users can read or not read knowledge block content within an article in a 
knowledge base by setting user criteria at the knowledge base and knowledge block level. As a 
knowledge contributor, you can apply user criteria at the knowledge block level.

Before you begin
Activate knowledge blocks

Role required: knowledge_admin or admin

Procedure

1. Navigate to Knowledge  > Knowledge Blocks  > All.

2. Open a knowledge block.
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3. Apply the desired user criteria for the Can Read  and Cannot Read  fields.

Name Description

Can Read User criteria to apply for read access at the knowledge block 
level.

Cannot Read User criteria to apply for cannot read access at the 
knowledge block level.

Note: 

◦ You can use existing or create new user criteria records. To create a new record, see 
Create a user criteria record in Knowledge Management.

◦ If a user meets any Can Contribute  criteria at the knowledge base level, they can read 
all knowledge block content, regardless of the Can read  and Cannot read  criteria set at 
the knowledge block level.

◦ If a user meets any Cannot read  criteria at the knowledge block level, they cannot read 
the block content, regardless of the Can read  criteria set at the knowledge block level.

◦ If a user has access to knowledge article and doesn't have access to one or more 
blocks within article then user can still read the content but without specify block 
content.
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4. Right-click the form header and click Save.

What to do next

• To finish and publish the block, see Create a knowledge block.

• To add the block to an article, as well as preview the article by impersonating different users, 
see Add knowledge blocks to a knowledge article.

Retire a knowledge block

You can retire a published knowledge block so that it's no longer available for users to view or 
search.

Before you begin
Role required: user must have contributor access to the knowledge base.

Procedure

1. Navigate to All  > Knowledge  > Knowledge Blocks  > Published.

2. Open the applicable record.
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3. Select Retire  to retire the knowledge block.

Note: 

◦ Starting from the Washington DC  release, you can retire the knowledge block attached 
to an article by setting the (glide.knowman.allow_retire_block) system 
property to true.

◦ Any additional steps required to retire the knowledge block, such as approvals, 
depend on the workflow for the knowledge base. See Knowledge workflows  for more 
information.

◦ A knowledge block can only be deleted if it's not being used in any knowledge article, 
including any retired article or previous version of an article.

Result
The retired knowledge block is no longer visible in the article.

Add knowledge blocks to a knowledge article

You can insert one or more knowledge blocks into a knowledge article within a knowledge base. 
Each knowledge block is secured by user criteria, which controls who can read or not read the 
content in an article.

Before you begin
Activate the Knowledge Management Advanced plugin

Role required: user must have contributor access to the knowledge base.

Procedure

1. Navigate to All  > Self-Service  > My Knowledge Articles.

2. Click New  or open a record.
On clicking New, you are provided options to select an article template. The article templates 
appear when you activate them in the Knowledge  > Article templates.

3. Select an article template.

Note: 
You can add or remove knowledge blocks in more than one HTML field of any article 
template including custom templates.

4. Fill in the fields on the form, as appropriate.
For more details on creating a knowledge article, see Create a knowledge article from an 
incident in ITSM Agent Workspace.

Note: 
Knowledge blocks are only supported with HTML knowledge articles. Make sure that the 
Article type  field is set to HTML.

5. In the article body, click where a block needs to be inserted and then click Add Blocks.

If the Add Blocks  button is not visible, make sure that the knowledge blocks feature is enabled 
for the knowledge base that the article is in. See Enable knowledge blocks for each knowledge 
base  for more information.

Note: 
Blocks can be added to only the text field.
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In the Add Blocks  side panel, you can search for, do an advanced search, view, and insert 
knowledge blocks into the article. To use condition builder with advanced search, see 
Condition builder . You can also create blocks directly from the side panel.

◦ You can configure the number of search results displayed in the Add Blocks  side panel 
using the glide.knowman.add_blocks.search_results  property. By default, 
the minimum number of search results displayed is 6 and the maximum number of search 
results displayed is 25. See Knowledge properties  for more information.

◦ If there are knowledge blocks you cannot find, make sure that the blocks are 
published, in the same language, and in the same knowledge base as an 

article.

6. Optional:  Rearrange knowledge block in the article body.

Example 

(Optional) The following GIF shows an example of a user moving a knowledge block within an 
article using a keyboard.
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7. Click Save  or Update  to create or update the article.

Note: 
You can preview the article with the blocks by user or, if published, date. See Preview a 
knowledge article with knowledge blocks  for more information.

8. Click Publish  to publish the article.

Note: 
Any additional steps required to publish the knowledge article, such as approvals, 
depend on the publishing workflow for the knowledge base. See Knowledge workflows 
for more information.

Preview a knowledge article with knowledge blocks

Preview a knowledge article with knowledge blocks by user or, if published, by date. For an 
unpublished article, you can preview the article by user by impersonating different users to see 
how the article displays or hides block content (based on the user criteria set at the knowledge 
base and knowledge block level). For published articles, you can preview the article by both user 
and date to see how the article appears in past versions for different users.

Before you begin
Role required: user must have contributor access to the knowledge base.

Procedure

1. Navigate to All  > Knowledge  > Articles, and open one of the modules, such as Unpublished  or 
Published.

2. Open the knowledge article with knowledge blocks.

3. In the Related Links  section, click Preview Article with Blocks.
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4. Preview the article as one of the following.

Knowledge blocks authoring in Agent Workspace

Reuse content by creating, editing, and publishing knowledge blocks in Agent Workspace.

You can perform the following knowledge blocks-related tasks in Agent Workspace:

• Create a knowledge block for a knowledge base.

• Manage all unpublished and published knowledge blocks authored by you.

• Add knowledge blocks to a knowledge article.

When adding a knowledge block to a knowledge article, you can also add knowledge blocks to 
any fields associated with an article template if used for an article.

• Retire a knowledge block not used in any knowledge articles.

View a knowledge block in Agent Workspace

View a knowledge block in Agent Workspace, including the block number, short description, and 
block content.

Before you begin
You must have read access to the knowledge base that stores the knowledge block you want to 
view.
Role required: agent_workspace_user and knowledge

Procedure

1. Navigate to All  > Agent Workspace  > Agent Workspace Home.

2. View knowledge blocks authored by you or by other people.

◦ View all blocks by navigating to Lists  > Knowledge Blocks  > All.

◦ View blocks authored by you by navigating to either Lists  > Knowledge Blocks  > Published 
or Lists  > Knowledge Blocks  > Unpublished.
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3. Click the link to the knowledge block that you want to view.

4. Optional:  View another version of the knowledge block by selecting the version in the Version 
list.

Note: 
The Version list appears only when the article versioning feature is enabled. For more 
information, see Article versioning.

Result
The selected version of the knowledge block opens within Agent Workspace. Any earlier version 
of the knowledge block is indicated as outdated. When viewing an earlier version, click the 
version number of the knowledge block to view a list of all versions.

Related topics

Knowledge block details displayed in Agent Workspace

Create a knowledge block in Agent Workspace

Edit a knowledge block in Agent Workspace

Publish a knowledge block in Agent Workspace

Knowledge block details displayed in Agent Workspace

View the details of a knowledge block in Agent Workspace.

The knowledge block view page in Agent Workspace  provides several details about a displayed 
block.

Sample knowledge block view page in Agent Workspace
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Article information displayed on the knowledge block view page in Agent Workspace

Details Description

Knowledge 
base

Knowledge base that stores the knowledge article and the article category. In the 
figure, Knowledge is the knowledge base and Policies is the knowledge block 
category.

Read time Average time to read the knowledge block, which can help you decide whether 
you have time to read the block.

The read time is calculated based on an average reading speed of 200 words per 
minute. For blocks in languages such as Chinese, Japanese, and Korean, the read 
time is calculated based on an average speed of 500 characters per minute.

If images are present in an article, the read time is calculated using the following 
rules:

• For the first image add 12 seconds, for the second image add 11 seconds, and so 
on.

• If there are more than 10 images, after the tenth image add 3 seconds for each 
image.

Last 
updated 
time

Last time the knowledge block was updated in number of days for the current 
week, number of weeks, or number of years.

Knowledge 
block 
content

Text and images in the knowledge block.

Authored 
by

Author of the knowledge block. This field appears only in the first version of a 
knowledge block.

Revised by User who revised the knowledge block. This field appears if a knowledge block 
was later edited.

Knowledge 
block 
number

Unique number automatically assigned to the knowledge block. In the figure, 
KBB0000101 is the block number.

Version Selected version of the knowledge block. This field appears when the article 
versioning feature is enabled. In the figure, 2.0 is the selected version of the 
knowledge block.

Related topics

View a knowledge block in Agent Workspace

Create a knowledge block in Agent Workspace

Edit a knowledge block in Agent Workspace

Publish a knowledge block in Agent Workspace

Create a knowledge block in Agent Workspace

Create a knowledge block for a knowledge base in Agent Workspace  to reuse a piece of content 
in knowledge articles in that knowledge base.
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Before you begin

• Enable the knowledge blocks feature for the knowledge base where you plan to create blocks. 
For more information, see Enable knowledge blocks for each knowledge base.

• You must have contribute access to the knowledge base within which you want to create the 
knowledge block.

Role required: agent_workspace_user and knowledge

About this task
You can also create blocks when accessing an article panel. For more information, see Add a 
knowledge block to a knowledge article in Agent Workspace.

Procedure

1. Navigate to All  > Agent Workspace  > Agent Workspace Home.

2. Optional:  Check whether a knowledge block on this subject is already available.

a. Navigate to Lists  > Knowledge Blocks  > All.

b. Set a filter to search for possible matching knowledge blocks.

▪ Click a column header. Based on the data type included in the column, in the Filter 
section, select the filter options or enter the filter conditions you want to apply. For 
example, for the Workflow column, you can select the following states:

▪ Draft

▪ Review

▪ Scheduled for publish

▪ Published

▪ Pending retirement

▪ Retired

▪ Outdated

▪ Click the show filter panel icon ( ), and click Advanced view. In the Advanced view 
dialog box, specify conditions in the All of these conditions must be met  field and click 
Update.

3. Click New  in a Knowledge Blocks list.

4. On the Knowledge Block form, fill in the fields.

Field Description

Number Unique number for identifying the knowledge block. This field 
is automatically populated.

Knowledge base Name of the knowledge base to which you are adding the 
knowledge block.

Category Name of the knowledge category or subcategory associated 
with the knowledge base.
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Field Description

Ownership Group Ownership group for the knowledge block. This field 
appears when the ownership groups feature is enabled (see 
Ownership groups).

Note: 
Knowledge blocks can be used without the ownership 
groups feature.

Can Read User criteria to apply for read access at the knowledge block 
level.

Note: 
User criteria set at the knowledge base and knowledge 
block level control which users can read block content 
within an article. (For more information, see Select user 
criteria for a knowledge block.)

Cannot Read User criteria to apply for cannot read access at the 
knowledge block level.

Note: 
User criteria set at the knowledge base and knowledge 
block level controls which users can read block content 
within an article. (For more information, see Select user 
criteria for a knowledge block.)

Valid to Date that the knowledge block expires. Once the valid to date 
has passed:

◦ The Knowledge article view page no longer displays 
expired knowledge block content in the associated 
knowledge article.

◦ Knowledge article searches no longer return knowledge 
articles if the keywords are contained only in the expired 
blocks.

Short description Description of the knowledge block.

Article body Content of the knowledge block.

Version Version number of the knowledge block. This field is 
automatically set to a version number when the article 
versioning feature is enabled.

Note: 
Knowledge blocks can be used without the article 
versioning feature. To learn more about article 
versioning, including how to disable the feature, see 
Article versioning.

Article type Markup language used for formatting the block. This field is 
automatically set to HTML because
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Field Description

Note: 
knowledge blocks are supported only with HTML 
knowledge articles.

Workflow Publication state of the block. This field is automatically set to 
the publication state of the block, such as Draft, Published, or 
Retired.

Note: 
You can ignore the Source Task  field, which is not used.

5. Click Save.
The knowledge block is saved and appears in the Unpublished list of Knowledge Blocks in 
Agent Workspace  and additional functionality becomes available on the form.

6. Optional:  Publish the block by clicking Publish.

(Optional) A knowledge block is published depending on the workflow setting of its knowledge 
base.

◦ Knowledge - Instant Publish: The knowledge block is immediately published.

◦ Knowledge - Approval Publish: The knowledge block is published on approval completion.

When published, your knowledge block appears in the Published and All lists under 
Knowledge Blocks in Agent Workspace. If the article versioning feature is enabled, the version 
number of the knowledge block is incremented.

Related topics

Edit a knowledge block in Agent Workspace

Edit a knowledge block in Agent Workspace

Edit knowledge blocks within a knowledge base in Agent Workspace  to update the reused 
content across articles within the knowledge base.

Before you begin
You must have contribute access to the knowledge base that stores the knowledge block you 
want to edit. By default, the knowledge block doesn't show attached files and it only shows as a 
link.
Role required: agent_workspace_user and knowledge

Procedure

1. Navigate to All  > Agent Workspace  > Agent Workspace Home.

2. Go to Lists  > Knowledge Blocks  > All.

3. Click a knowledge block link.

4. Modify the fields on the Knowledge Block form.
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◦ For an unpublished knowledge block, the Knowledge Block form opens when you select the 
article.

◦ For a published knowledge block, click Edit  to access the Knowledge Block form.

Note: 
If the article versioning feature is enabled, you can edit only the latest version of a 
knowledge block. Click Checkout  after you click Edit.

5. Click Save.
The knowledge block is saved and appears in the Unpublished list under Knowledge Blocks. If 
the article versioning feature is enabled, the version of the knowledge block is incremented by 
0.01.

6. Optional:  Publish the knowledge block by clicking Publish.
The knowledge block is published depending on the workflow setting of its knowledge base.

◦ Knowledge - Instant Publish: The knowledge block is immediately published.

◦ Knowledge - Approval Publish: The knowledge block is published on approval completion.

When published, your knowledge block appears in the Published and All lists under 
Knowledge Blocks in Agent Workspace. If the article versioning feature is enabled, the version 
number of the knowledge block is updated to the next whole number (for example, from 2.02 to 
3.0).

Publish a knowledge block in Agent Workspace

Publish a knowledge block to make it available to add to knowledge articles.

Before you begin
You must have contribute access to the knowledge base that stores the knowledge block you 
want to publish.
Role required: agent_workspace_user and knowledge

Procedure

1. Navigate to All  > Agent Workspace  > Agent Workspace Home.

2. Go to Lists  > Knowledge Blocks  > Unpublished.

3. Click a knowledge block link.

4. On the Knowledge Block form, click Publish.

Result
A knowledge block is published depending on the workflow setting of its knowledge base.

• Knowledge - Instant Publish: The knowledge block is immediately published.

• Knowledge - Approval Publish: The knowledge block is published on approval completion.

When published, your knowledge block appears in the Published and All lists under Knowledge 
Blocks in Agent Workspace. If the article versioning feature is enabled, the version of the block is 
incremented.

Related topics

View a knowledge block in Agent Workspace

Approve a knowledge block in Agent Workspace

Approve a knowledge block that is awaiting your review in Agent Workspace.
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Before you begin
Role required: agent_workspace_user and knowledge

Procedure

1. Navigate to All  > Agent Workspace  > Agent Workspace Home.

2. Go to Lists  > Knowledge Blocks  > Unpublished.

3. Click a knowledge block link that is in the Review  workflow state.

4. Click Edit.

5. In the Approvals related list, in the State  column, click Requested.
The Approval form opens in another tab within Agent Workspace.

6. From the State list, select Approved.

7. Click Save.

Result
The approved knowledge block is published immediately. If the article versioning feature is 
enabled, the version number of the knowledge block increments to the next whole number 
(for example, from 2.02 to 3.0). On the Knowledge Block form, the workflow state changes to 
Published. The new published version of the knowledge block is added to the Block Versions 
related list on the Knowledge Block form. The version is also available in the All list under 
Knowledge Blocks in Agent Workspace, go to Knowledge Blocks  > All.

Add a knowledge block to a knowledge article in Agent Workspace

Add a knowledge block to a knowledge article in Agent Workspace.

Before you begin

• Both the knowledge article and the knowledge block must be in the same knowledge base.

• You must have contribute access to the knowledge base.

• Ensure that the knowledge blocks feature is enabled for the knowledge base that the article is 
in. For more information, see Enable knowledge blocks for each knowledge base.

Role required: agent_workspace_user and knowledge

Procedure

1. Navigate to All  > Agent Workspace  > Agent Workspace Home.

2. Go to Lists  > Knowledge Articles  > All.

3. Click an existing article link.
For more information, see Edit a knowledge article in Agent Workspace.

Note: 

◦ Knowledge blocks are supported only with HTML knowledge articles. Make sure that 
the Article type  field is set to HTML.

◦ If a knowledge article uses an article template, you can add knowledge blocks to any 
fields associated with the article template.

4. In the contextual side panel, click the add blocks icon ( ).

5. Search for the article to which you want to add the knowledge block.
To use condition builder with advanced search, see Condition builder .

6. Click Insert  to add the knowledge block to the article.
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If there are no knowledge blocks, click Create New Block  and follow the procedure to create 
another block. For more information, see Create a knowledge block in Agent Workspace.

7. Click Update  to save your changes.

Note: 
You can preview the article with the blocks. For more information, see Preview a 
knowledge article with knowledge blocks in Agent Workspace.

8. Click Publish  to publish the article.

The knowledge article is published depending on the workflow setting of its knowledge base. 
For more information, see Publish a knowledge article in Agent Workspace.

Preview a knowledge article with knowledge blocks in Agent Workspace

Preview a knowledge article with knowledge blocks in Agent Workspace.

Before you begin
You must have contribute access to the knowledge base that stores the knowledge article.
Role required: agent_workspace_user and knowledge

Procedure

1. Navigate to All  > Agent Workspace  > Agent Workspace Home.

2. Go to Lists  > Knowledge Articles  > All.

3. Select the article in which you want to preview a knowledge block and click Edit.

4. Click Preview with Blocks.
The article edit page refreshes to show options for previewing a knowledge block.

5. Optional:  Click Show Blocks  to highlight the knowledge blocks added to the article.

6. Click OK.

Retire a knowledge block in Agent Workspace

Retire a published knowledge block if you no longer want it to be available for users to view or 
search.

Before you begin
You must have contribute access to the knowledge base that stores the knowledge block you 
want to retire.
Role required: agent_workspace_user and knowledge

About this task
You can retire knowledge blocks only if they are not used in any knowledge articles.

Procedure

1. Navigate to All  > Agent Workspace  > Agent Workspace Home.

2. Go to Lists  > Knowledge Articles  > Published.

3. Select the knowledge block you want to retire.

4. Click Edit.

5. Click Retire.

Result
The knowledge block is retired depending on the workflow setting of its knowledge base.
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• Knowledge - Instant Retire: The knowledge block is immediately retired.

• Knowledge - Approval Retire: The knowledge block is retired on approval completion.

When retired, your knowledge block no longer appears in the Published list under Knowledge 
Blocks in Agent Workspace.

Integrating a custom search or knowledge article viewer with knowledge blocks

If you are using a custom search or knowledge article viewer with your application, you can 
integrate that custom search or viewer with the appropriate knowledge or knowledge blocks API.

Note: 
Integration is only necessary if you are using a custom search or knowledge article viewer.

KBPortalServiceImpl - Global

The KBPortalServiceImpl  API is included with Knowledge Management V3 
[com.snc.knowledge3] as a script include. It provides methods to use with knowledge, such as 
integration with a custom search.

KBPortalServiceImpl - KBPortalServiceImpl()

Instantiates a KBPortalServiceImpl object in a global application.

Parameters

Name Type Description

None

KBPortalServiceImpl - getResultData(Object request)

Returns search results based on keywords from the knowledge article and from relevant 
knowledge block content that the user has access to read.

If you have activated the knowledge blocks feature and are using a custom search for knowledge 
with your application, your search may not return relevant articles when keywords are contained 
in the blocks. To return search results based on keywords from the article and from relevant block 
content that the user has access to read, you must call the getResultData()  method inside 
your custom search.

Parameters

Name Type Description

request Object JSON object to refine the search.

Returns

Type Description

Object Array of search results in JSON format based on keywords from the knowledge article 
and from relevant knowledge block content that the user has access to read.

Example: Integrating a custom search with knowledge blocks

function doKeywordSearch(queryText, count, queryLocation) {
  var results = [];
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  // To set up the request.
  var request = {
    keyword: queryText,
    language: "",
 
    // To pass data to filter on different metadata.
    variables: {
      kb_knowledge_base: ['Knowledge'],
      kb_category: '',
      author: ['']
    },
 
    // Provide the following.
    context: gs.getProperty('glide.knowman.sp.search_context', 
 'Knowledge Search'),
    resource: 'Knowledge',
    order: "relevancy,true",
 
    // Provide the pagination variables.
    start: queryLocation,
    end: queryLocation+count,
 
    attachment: false,
 
    // Provide any additional metadata you want to include in 
 your results.
    knowledge_fields: [
      "number",
      "sys_id",
      "published"
    ]
  };
 
  // To execute the search.
  var response = new KBPortalServiceImpl();
  response.getResultData(request);
 
  // To send the search results back to the UI or to store 
 results in your object.
  for (var i = 0; i < response.results.length; i++) {
    result = response.results[i];
    var article = {};
    article.sys_id = result.meta.sys_id.display_value;
    article.number = result.meta.number.display_value;
    article.short_description = article.short_description;
    article.title = result.title;
    article.published = result.meta.published.display_value;
    article.publishedUTC = result.meta.published.display_value;
    article.text = article.text;
    article.score = result.meta.score;
    article.label = article.short_description;
    article.shortDescription = article.short_description;
    results.push(article);
  }
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  return results;
}

KBBlock - Global

The KBBlock  API is included with knowledge blocks [com.snc.knowledge_blocks] as a script 
include. It provides methods to use with the knowledge blocks feature, such as integration with a 
custom knowledge article viewer.

KBBlock - KBBlock()

Instantiates a KBBlock object in a global application.

Parameters

Name Type Description

None

KBBlock - getArticleContent(GlideRecord knowledgeRecord)

Gets knowledge articles with relevant knowledge block content that a user has access to read.

If you have activated the knowledge blocks feature and are using a custom knowledge article 
viewer with your application, your viewer may not display articles that expand the relevant 
block content. To expand block content that a user has access to read, you must call the 
getArticleContent()  method inside your custom viewer.

Parameters

Name Type Description

knowledgeRecord GlideRecord GlideRecord of the knowledge article to display.

Returns

Type Description

String Knowledge article with relevant knowledge block content that a user has access to 
read.

Example: Integrating a custom knowledge article viewer with knowledge blocks

 
// This function returns the article text with expanded block 
 content.
function getArticleText(kbSysId) {
  var knowledgeRecord = new GlideRecord('kb_knowledge');
  var kbText='';
  if(knowledgeRecord.get(kbSysId)) {
    if(new 
 GlidePluginManager().isActive('com.snc.knowledge_blocks')) {
      kbText = new KBBlock();
      kbText.getArticleContent(knowledgeRecord);
    }
    else
      kbText = knowledgeRecord.getValue('text');
    }
  return kbText;
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}
 
// This is an example of how to call the function defined above.
var kbText = getArticleText('01a1ca5b6710130038876c3b5685efd3');

Use knowledge subscriptions

Use knowledge subscriptions to receive email notifications about new articles and article 
revisions or comments.

Subscribe to a knowledge base

Subscribe to a knowledge base and receive notifications when articles are added to that 
knowledge base.

Before you begin
You must activate the Knowledge Management Advanced (com.snc.knowledge_advanced) 
plugin. For more information, see Configure knowledge subscriptions.

Role required: knowledge

About this task
Users can subscribe to a knowledge base from either the Knowledge Management v3 user 
interface or the Knowledge Management Service Portal.

Note: 

Starting with the Washington DC  release, the Knowledge Management  v3 
homepage (com.snc.knowledge3) is being prepared for deprecation in the 
future Y release. It is replaced by the Knowledge Management  Service Portal 
(com.snc.knowledge_serviceportal), which is active by default for customers on Madrid 
and later releases. For more information about the new experience, see Knowledge 
Management Service Portal homepage features.

Procedure

1. Navigate to All  > Knowledge  > Homepage.

2. Click the Subscribe  link on the knowledge base tile.
The link changes to Subscribed  and includes a check mark.

Result
Receive notifications when articles are added to the subscribed knowledge base.

Unsubscribe from a knowledge base

Unsubscribe from a knowledge base.

Before you begin
Role required: knowledge

About this task
Users can unsubscribe from a knowledge base from either the Knowledge Management v3 user 
interface or the Knowledge Management Service Portal.
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Note: 
If you subscribe to an article and then subscribe to the knowledge base, unsubscribing 
from the knowledge base also unsubscribes you from the article.

Starting with the Washington DC  release, the Knowledge Management  v3 
homepage (com.snc.knowledge3) is being prepared for deprecation in the 
future Y release. It is replaced by the Knowledge Management  Service Portal 
(com.snc.knowledge_serviceportal), which is active by default for customers on Madrid 
and later releases. For more information about the new experience, see Knowledge 
Management Service Portal homepage features.

Procedure

1. Navigate to All  > Knowledge  > Homepage.

2. Point to and click the Subscribed  link on the knowledge base tile, which toggles to 
Unsubscribe.
After unsubscribing you from the knowledge base, the link toggles to Subscribe.

Subscribe to a knowledge article

Subscribe to a knowledge article within a knowledge base to receive email notifications about 
new articles and article revisions or comments.

Before you begin
Role required: Check with your admin

About this task
Users can subscribe to a knowledge article from either the Knowledge Management  V3 user 
interface or the Knowledge Management Service Portal.

Note: 

• Users who are already subscribed to a knowledge base are also subscribed to the 
articles within that knowledge base.

• To subscribe to articles from the base service portal (https://<instance name> 
/sp?), you must navigate to the Knowledge Management Service Portal  pages (for 
example, https://<instance name>  /sp?id=kb_home)  from the base service 
portal.

• To manage the knowledge subscription for knowledge base and knowledge article, see 
Manage knowledge subscriptions.

• Starting with the Washington DC  release, the Knowledge Management  v3 
homepage (com.snc.knowledge3) is being prepared for deprecation in the 
future Y release. It is replaced by the Knowledge Management  Service Portal 
(com.snc.knowledge_serviceportal), which is active by default for customers on Madrid 
and later releases. For more information about the new experience, see Knowledge 
Management Service Portal homepage features.

Procedure

1. Navigate to All  > Knowledge  > Homepage.

2. Click Subscribe  at the top of the knowledge article.
The system shows an information message about the article subscription and the button 
toggles to Subscribed. If the email notification contains an article link, the link points to the 
Knowledge Management  Service Portal. The email notification for a subscribed article includes 
the knowledge article ID, short description, and link to the article.
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Unsubscribe from a knowledge article

Unsubscribe from a knowledge article.

Before you begin
Role required: knowledge

About this task
Users can unsubscribe from a knowledge article from either the Knowledge Management v3 user 
interface or the Knowledge Management Service Portal.

Note: 
If you are subscribed to a knowledge base and you unsubscribe from an article in that 
knowledge base, you must also unsubscribe from the parent knowledge base.

Starting with the Washington DC  release, the Knowledge Management  v3 
homepage (com.snc.knowledge3) is being prepared for deprecation in the 
future Y release. It is replaced by the Knowledge Management  Service Portal 
(com.snc.knowledge_serviceportal), which is active by default for customers on Madrid 
and later releases. For more information about the new experience, see Knowledge 
Management Service Portal homepage features.

Procedure

1. Navigate to All  > Knowledge  > Homepage.

2. Point to and click Subscribed, which toggles to Unsubscribe.
If you are subscribed to the knowledge article, this action results in an information message 
that the article subscription has been removed. If you are also subscribed to the parent 
knowledge base, proceed to the next step.

3. If you are subscribed to the parent knowledge base, click Yes  on the Unsubscribe pop-up 
window.
This action results in an information message that the knowledge base subscription has been 
removed.

Manage knowledge subscriptions

Manage knowledge base and knowledge article subscriptions from the Notification Settings 
page.

Before you begin
Role required: knowledge

About this task
Users can manage knowledge subscriptions from the Knowledge application or from the 
Knowledge Management Service Portal.

Procedure

1. Navigate to the Notification Settings page.

2. Click the Subscriptions tab.

3. Click Knowledge Base  or Knowledge Articles  to see a list of current subscriptions.

4. To unsubscribe from a knowledge base or knowledge article, click Subscribed.
The link toggles to Unsubscribed.
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Use translation management

Use translation management to create and manage translation tasks.

Create translation assignments for knowledge articles

Assign knowledge articles to language experts to ensure accurate translations. Identify the 
language experts and create assignment rules so that translation tasks are automatically 
assigned to language experts and groups.

Before you begin
Role required: knowledge_admin or admin

About this task
Translation tasks are automatically assigned once the assignment rules are created. Assignment 
rules are applied only if a task is not already assigned to another user or group.

Procedure

1. Navigate to All  > Knowledge  > Translation Management  > Translator Mapping.

2. Click New  to create a new assignment rule.

3. Enter a name for the assignment rule in the Name  field.

4. In the Applies To  tab, choose the task type you want to assign by setting a condition.

a. Select the Knowledge Translation Task [kb_translation_task]  table from the Table  drop-
down list.

b. Set a condition for assigning tasks in the Conditions  field.
For example, to assign tasks for translation into English, you would set the condition 
to[Translated language][is][English].

5. In the Assign To  tab, select the user or group you want to assign the task to.

6. Optional:  Click the Script  tab to enter a script to further customize the assignment rule.

7. Click Submit.

Result
An email notification is sent to the user or group that has been assigned the task with a link to the 
translation task and source article.

Auto-create translation tasks

Auto-create translation tasks in specified languages to avoid having to manually create 
translation tasks after an article is published. The available languages are determined by the 
language plugins that have been installed on your instance.

Before you begin
Role required: knowledge_admin or admin

Procedure

1. Navigate to All  > Knowledge  > Administration  > Knowledge Bases.

2. Select an existing knowledge base.

3. Display the languages you have installed by clicking the lock icon to unlock the Languages 
field.

4. Select the languages for which you want to create tasks from the drop-down list.
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5. Select Auto-create translation tasks.

6. Click Submit.

What to do next
Open a knowledge article and access the Knowledge Translation Tasks related list to view the 
associated translation tasks.

Bulk Translation for knowledge articles

Perform bulk translations of knowledge articles in multiple languages using the Localization 
Framework  application.

The Bulk Translations feature extends the localization service in Knowledge Management  to 
support customers across geographies by localizing knowledge articles in the language they 
speak. You can select multiple knowledge articles and translate them into different languages 
by using the ServiceNow®  Localization Framework  application. Once the translation process is 
complete, you can access the translated article from the Knowledge [kb_knowledge] table. You 
can request translations for up to 200 articles at a time.

Translation workflow

You can define a workflow to determine the actions required to complete a translation. For 
information, see Workflows in the Localization Framework  .

Preferences configuration

Through preferences, define the translations, workflow, and project preferences to request 
translation for activated languages. For more information, see Configure the Localization 
Framework preferences .

Artifact configuration

The Knowledge artifact is included in the Artifact Configurations [sn_lf_config] table and is active 
by default. For more information, see Localization Framework support for Knowledge Base  .

Translation validations

Translation validation enables you to review and manage the translation request before 
submitting knowledge articles for translation. The validations to be executed are:

• The requested language is allowed in the knowledge base.

• Blocks used in the article have translations present in the target language.

• Source articles are not in the retired or outdated state.

• The article's source language is different from the requested language.

• The source article shouldn’t be a translated article.

• The total number of selected articles is less than 200.

Use Bulk Translation for manual translation

Translate knowledge articles into different languages through bulk translations.

Bulk Translation uses the ServiceNow®  Localization Framework  application, which enhances 
the translation process of knowledge artifacts through configurable workflows. You can select 
multiple knowledge articles and the preferred language into which you want to localize your 
content.
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Request bulk translations for multiple knowledge articles

Request translations for multiple knowledge articles through Bulk Translations to localize them 
into one or more languages.

Before you begin
Add a custom Localization Framework setting to enable bulk translations.

Role required: Localization requester to request translations

Procedure

1. Navigate to All  > Knowledge  > Articles.

2. Select the articles you want to translate.

3. Select Request Translations.

Note: 
. Check the validation list to ensure that all articles to be translated have been validated. 
For more information, see Bulk Translation for knowledge articles.

4. In the Request Translations  dialog box, select the languages into which you want to translate 
the articles.

5. Select Submit.

Result
Localization tasks are created for the selected items in all the selected languages. A success 
message with a link to the list of requested items is displayed. Select the link to see the list of 
requested items.

Translate multiple knowledge articles into different languages

Translate multiple knowledge articles to localize your content into different locales.

Before you begin

• Add a custom Localization Framework setting to enable bulk translations.

• Request bulk translations for multiple knowledge articles.

Role required: Localization fulfiller to fulfill translation request

Procedure

1. Navigate to All  > Knowledge  > Knowledge Translations  > My translation request.

2. On the Localization Request Items page, select the gear icon ( ) to add the Localization task 
to your task list.

3. Open any localization task.

4. On the Localization Task page, select Translate  in the form header.
A two-column comparison UI page displays a Source Language  column on the left and Target 
Language  column on the right. You can set the display as follows:

◦ Select Expand all  to expand all the groups on the comparison UI.

◦ Select Collapse all  to collapse all the groups on the comparison UI.

◦ Select Show groups with missing translations  to see only the groups that have missing 
translations when the content is translated.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3393



5. In the comparison UI page, copy the content from Source Language  column and paste it in 
Target Language  column.

6. Repeat the copy and paste process for each listed article.

7. Select Publish Translation.

8. In the Publish Translations  dialog box, select Publish Translations.

Result
The selected articles are translated into the selected languages and marked as version 0.01. The 
articles can be accessed from the Knowledge [kb_knowledge] table.

Use Bulk Translation for Dynamic Translation

Translate knowledge articles into different languages using machine translations.

Dynamic Translation  for Bulk Translation translates knowledge articles content in real-time and 
offers a seamless localization experience to your customer. With the help of language translator, 
dynamic translation automatically detects the language of the user-entered texts and displays 
translated text in the comparison UI page.

Translate knowledge articles using Dynamic Translation

Use machine translation to automatically translate knowledge articles into different languages.

Before you begin
Add a custom Localization Framework setting to enable machine translation.

Role required: Localization requester to request translations

About this task
Dynamic Translation  uses the ServiceNow®  Localization Framework  to translate knowledge 
articles into different locales without any manual intervention.

Procedure

1. Navigate to All  > Knowledge  > Articles.

2. Select the articles you want translated.

3. Select Request Translations.

Note: 
.Check the validation list to ensure that all articles to be translated have been validated. 
For more information, see Bulk Translation for knowledge articles.

4. In the Request Translations  dialog box, select the languages into which you want the articles 
translated.

5. Select Submit.
Dynamic Translation  automatically initiates a translation process and creates a translated 
article.

Result
The selected articles are translated in selected languages and marked as version 0.01. The 
article can be accessed from the Knowledge [kb_knowledge] table.

Translate a knowledge article from a translation task

Start translating articles once they are published and assigned to you for translation.
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Before you begin

• Activate the Dynamic Translation plugin (com.glide.dynamic_translation).

• Enable the glide.knowman.translation.enable_translation_task  property. 
For more information, see Translation management.

Role required: admin, knowledge_admin, or knowledge

About this task

Note: 
This procedure has been superseded by the Localization Framework. For more information 
see Localization Framework support for Knowledge Base . This information is provided for 
legacy context.

For information about how administrators configure the translation API, see DynamicTranslation 
API .

Procedure

1. Navigate to All  > Knowledge  > Translation Management  > My Assigned Tasks.

2. In the Knowledge Translation Tasks page, select one of the listed translation tasks assigned to 
you.

3. Select Translate.
The Translate from  and Translate to  panes are side-by-side for easy comparison, as shown in 
the following figure.

4. Select Machine translate  to automatically translate to the targeted languages.

5. Select Create draft article  to create a draft version of the translated article.
If a translated article is already present for that language, a new draft version overwrites the 
existing translated content.

6. Select Publish.

Note: 
By default, the translated version is always created as v1.0 so that the parent version 
remain same for all the translated versions. For more information, see Translated KB 
articles always show Parent version 1.0 regardless of version used for translation .

Result
The newly created draft is listed in the Translated Versions  tab.

Translate knowledge blocks within an article

If a selected article indicates that a knowledge block is missing a translation, you must translate 
the knowledge block before you can translate the article.
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Before you begin
Role required: translator

Procedure

1. Navigate to All  > Knowledge  > Translation Management  > My Assigned Tasks.

2. In the Knowledge Translation Task page, select a translation task and click Translate.
A message stating that the knowledge article contains one or more knowledge blocks that 
have missing translations is displayed.

3. Click on the link in the message to view the list of blocks that require translation.

4. Click the block that requires translation and click Translate.
The newly translated blocks appears in the Translated Block Versions  related list.

Related topics

Add knowledge blocks to a knowledge article

Request missing translations for available languages

Manually create translation tasks if an article does not have translation tasks created for all the 
languages you have configured.

Before you begin

• Role required: none

• Verify that the glide.knowman.translation.enable_translation_task 
property is set to true.

Procedure

1. Navigate to All  > Knowledge  > Articles  > Published.

2. Select an article from the list of published articles.

3. Click the Request translations  related link.

4. Select the languages from the list that are unselected, which indicates they do not have 
associated translation tasks.

5. Click Submit.

Result
The translation tasks for the languages are created and listed in the Knowledge Translation Tasks 
tab.

Work on a feedback task

You can change the state of a task and resolve or reassign tasks generated by article feedback.

Before you begin
Role required: knowledge

About this task

• If no ownership group is assigned to the article, the feedback task is available to you as the 
author or reviser of the article.

• If an ownership group is assigned to the article, a feedback task is assigned to you as an 
ownership group manager. As a manager, you can reassign the task to another group member. 
All group members see the feedback task in All Open Tasks. As a group member, you can 
reassign the task to yourself to appear in My Assigned Tasks.
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Procedure

1. Navigate to All  > Knowledge  > Feedback Management  > My Assigned Tasks.

2. Select a feedback task.

3. Review the feedback given by the submitter.
When a feedback task is generated, the information in the article feedback form is copied to 
the feedback task form as follows:

Feedback task form field
Information from 
article feedback form

Reason The selected 
reason for the 
feedback.

Description

Note: 
If feedback is negative and the Details  field is left blank, this field 
indicates whether the article was not helpful or rated poorly.

Text in the Details 
field.

4. To work on the feedback task:

Track the progress on a feedback task

Monitor open and closed feedback tasks and track the duration of time a feedback task remains 
in each state.

Before you begin
Role required: Owner of the knowledge base, knowledge_manager, knowledge_admin, or admin

Procedure

1. Navigate to the open or closed tasks you want to track.

2. In the Knowledge Feedback Task Metrics  related list section, select a feedback task metric to 
view the start and end time and the duration of the feedback task.

Note: 

◦ If you are a knowledge administrator, you can view the feedback tasks and task 
metrics of articles in the knowledge bases. If you are a knowledge owner or knowledge 
manager, you can view feedback tasks and task metrics of all articles in the knowledge 
bases you own or manage.

◦ You may need to configure the form to add Knowledge Feedback Task Metrics  in the 
related list section. For more information, see Add a related list to a form .

◦ The feedback task state is unaffected by changes in the article state. Therefore, when 
the article is retired, the feedback owner or group assigned to the feedback task has to 
close or resolve the feedback task.

Use Article Quality Index

Use article quality index (AQI) to assess the quality of knowledge articles.
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Create an AQI checklist

Create a checklist of questions that reviewers can use to evaluate the quality of knowledge 
articles.

Before you begin
Role required: knowledge_admin or admin

Procedure

1. Navigate to All  > Knowledge  > Article Quality Index  > AQI checklists, and click New.

2. Fill in the following fields:

Field Description

Checklist Name for the checklist.

Description Description for the checklist.

3. Right-click the form header and click Save.

4. In the Checklist Questions  related list, add questions to the checklist.
Add questions and adjust the weight of the questions until the combined weight of all 
questions is equal to 100. The weight defines the score that is added to the total AQI review 
score of the article when the answer for that question is set to true. The maximum score that 
can be applied to an article in an AQI review is 100.

Note: 
The default AQI pass score is 70. You can change the pass score in the Article Quality 
Index properties.

To add a question:

a. Click New.

b. Fill in the following fields:

Checklist Question form

Field Description

Question Text for the question to evaluate articles.

Description Short description for the question.

Order Value for the display order of questions in 
the checklist.

The lower the value in the Order  field, the 
higher the question displays in the checklist.
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Field Description

Note: 
Before you assign a value for the 
display order, think about how many 
questions you would create for the 
checklist. For example, if you have 
five questions in a checklist, you can 
assign the value in increments of 20. 
This ensures that you have enough 
values to assign if you add questions 
to the checklist later.

Weight A value for the question to score the article 
quality. This value is added to the AQI score 
when the answer for the question is set to 
true.

Note: 

▪ The combined weight of all 
questions cannot exceed 100.

▪ The sum of weights of all questions 
in a checklist must be equal to 100 to 
be assigned to a knowledge base.

c. Click Submit.

5. After you finish adding questions to the checklist, click Update  on the AQI Checklist form.

What to do next
After you create a checklist, assign it to a knowledge base.

Assign an AQI checklist to a knowledge base

Before a knowledge reviewer can start performing the AQI review, you must assign an AQI 
checklist to a knowledge base.

Before you begin
You can only assign a checklist to a knowledge base when the weight of all questions in the 
checklist is equal to 100. Each knowledge base can have one assigned checklist. However, a 
checklist can be assigned to more than one knowledge base.
Role required: knowledge_admin or admin

About this task

Procedure

1. Navigate to All  > Knowledge  > Administration  > Knowledge Bases.

2. Click a knowledge base to which you want to assign a checklist.

3. On the Knowledge Base form, click the search icon in the Checklist  field and select the AQI 
checklist to apply.

4. Click Update.
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What to do next
After you assign an AQI checklist to a knowledge base, you can start performing AQI reviews.

Remove an AQI checklist from a knowledge base

Before you can edit a checklist that is assigned to a knowledge base, you must remove it from the 
knowledge base.

Before you begin
A checklist with pending AQI reviews cannot be removed from the knowledge base until all AQI 
reviews associated with the checklist are complete.
Role required: knowledge_admin or admin

Procedure

1. Navigate to All  > Knowledge  > Administration  > Knowledge Bases.

2. Click a knowledge base from which you want to remove a checklist.

3. On the Knowledge Base form, delete the name of the AQI checklist from the Checklist  field.

4. Click Update.

Delete questions from an AQI checklist

Deleting a question in a checklist deletes the text in the question of previously performed AQI 
reviews that use the checklist. Deleting an AQI question from a checklist will not affect the score 
of the previously performed AQI reviews. However, the text of the question will not be displayed 
in the checklist.

Before you begin
You can delete questions from a checklist if the following conditions are met:

• The checklist is not attached to a knowledge base. For more information, see Remove an AQI 
checklist from a knowledge base.

• There are no AQI reviews using the checklist in progress.

Role required: admin

Procedure

1. Navigate to All  > Knowledge  > Article Quality Index  > AQI checklists.

2. Click the AQI checklist from which you want to delete one or more questions.

3. In the Checklist Questions related list, select the check box next to the questions that you want 
to delete.

4. From the Actions on Selected Rows  choice list, select Delete.

5. In the Confirmation window, click Delete.

Perform the Article Quality Index review

Perform the Article Quality Index (AQI) review to evaluate the quality of the article.

Before you begin
The knowledge base must have an assigned AQI checklist.
Role required: knowledge_domain_expert, knowledge_coach, knowledge_admin, or admin

About this task
Configure the glide.knowman.aqi.article_workflow_states  property to set the 
article workflow states where you could perform AQI reviews. You can perform several AQI 
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reviews for an article. If you perform several AQI reviews for the same version of the article, the 
latest AQI score appears in the Latest AQI  field in the article.

Procedure

1. Navigate to All  > Knowledge  > Articles  and click Published.

2. Click an article link.

Note: 
To read the article and perform the AQI review simultaneously, open the article in two 
separate tabs or window in your browser. You can then read the article from one tab or 
window and perform the AQI from another tab or window.

3. Perform the AQI review.

4. In the Article Checklist Answers  related list, read the questions and evaluate which ones are 
true.

Double-click the Answer  cell for each question that is true, select true, and select the green 
check mark.

Note: 
The associated Weighted Score  is applied to the AQI score when the answer is set to 
true.

Note: 

◦ If you perform several AQI reviews for the same version, the latest AQI score appears in 
the Latest AQI  field in the article.

◦ If you’re using Knowledge Management  within the Customer Service Management 
application, you can automatically make knowledge public by running the Make KM 
Service Portal Pages Public  fix script after you install the Customer Service 
Management  plugin (com.sn_customerservice).

Standard Pagination - Displays the search results in multiple pages.

Infinite Scroll - Displays the search results while scrolling.

5. Perform one of the following actions:
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What to do next
To view all the AQI reviews you completed, navigate to Knowledge  > My Completed AQI 
Checklists.

View all pending and completed AQI reviews

View checklists of all users to monitor the pending and completed reviews.

Before you begin
Role required: knowledge_admin or admin

Procedure

1. Navigate to All  > Knowledge  > Article Quality Index

2. Do one of the following:

◦ To view all completed AQI checklists, select All Completed AQI Checklists.

◦ To view all pending AQI checklists, select All Pending AQI Checklists .

Delete AQI reviews

Delete an AQI review that was created by mistake or is no longer required.

Before you begin
Roles required:

• To delete an AQI in a submitted state: admin or knowledge admin

• To delete an AQI not in a submitted state: knowledge admin or the reviewer who initiated the 
AQI

Procedure

1. Navigate to All  > Knowledge  > Articles  > My Pending AQI Checklists.

2. Select all checklist reviews you would like to delete.

3. Click Delete.

Managing KCS article states

Manage the readiness of KCS articles and comply with regulated information using KCS article 
states.

For information about the KCS article states, see KCS v6 Practices Guide .

For information about all the KCS roles, see Knowledge Management roles.

Activation information

Activate the Knowledge Management KCS Capabilities plugin 
(com.snc.knowledge_kcs_capabilities) to enable the use of KCS roles (kcs_contributor, 
kcs_publisher, and kcs_candidate) and metadata fields for the KCS article state (governance and 
confidence). For more information, see Activate Knowledge Management KCS Capabilities.

Note: 
If you are not an admin and has either kcs_contributor or kcs_candidate roles, you cannot 
retire an article.
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Article confidence

The confidence state of an article indicates where the article is in its life cycle. Only users with 
the knowledge_coach, knowledge_admin, kcs_contributor or kcs_publisher role can modify the 
value of the Confidence  field.

For articles existing before the Knowledge Management KCS Capabilities plugin 
(com.snc.knowledge_kcs_capabilities) was activated, the Confidence  field is automatically set to 
None.

If an article is created after the Knowledge Management KCS Capabilities plugin 
(com.snc.knowledge_kcs_capabilities) is activated, the Confidence  field is automatically set 
based on the workflow state of the article.

Article workflow states and confidence values

Workflow state Confidence field value

Draft, Review, or 
Scheduled for publish

Work in Progress

Published • Validated: For articles published by users with the knowledge_coach, 
kcs_contributor, or kcs_publisher role.

• Not Validated: For articles published by users with a role other than 
knowledge_coach, kcs_contributor, or kcs_publisher.

Pending retirement or 
Outdated

Same as in the Published workflow state.

Retired Archived

Article governance

The governance state of an article indicates which users can manage articles specific to a 
regulatory requirement, either experience based or compliance based. Users with contribute 
access to a knowledge article can modify the value of the Governance  field.

Related topics

Create a knowledge article from an incident in ITSM Agent Workspace 

Create a knowledge article in Agent Workspace

Knowledge article creation from an incident

Enable users to quickly and easily reuse information from an incident in a knowledge article.

Perform the following steps to enable creating a knowledge article from an incident. You can 
create a knowledge article from an incident using Incident KCS Article template. For more 
information, see Create a knowledge article from an incident using an article template .

Create field mapping from an incident to a knowledge article

Copy information from an incident into a knowledge article by creating custom mapping between 
the Incident table and the KCS article table.

Before you begin
Role required: admin
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• You must activate the Knowledge Advanced plugin (com.snc.knowledge_advanced).

• You must activate the KCS Article template.

1. Navigate to Knowledge  > Administration  > Article Templates.

2. Set the Active  field to true  for the KCS Article template.

Procedure

1. In the filter navigator, type csm_table_map.list.

2. Click New.

3. In the Mapping Name  field, enter Incident KCS Article.

4. In the Source Table  field, enter Incident.

5. In the Target Table  field, enter KCS Article.

6. Right-click the form header and Save.

7. In the Basic Field Mapping  related list, click New.

8. Create mappings for the following fields.

Source Field Target Field

Sys ID Source Task

Short description Short description

Resolution notes Resolution

Note: 
You can create field mappings for more fields, as required.

◦ In the Source  field, select the field in the source Incident table that contains the 
information to be copied to the field in the article template target table.

◦ In the Target  field, select the field in the article template target table to which you need 
information copied to from the field in the source Incident table.

9. To customize when and how the Knowledge  check box is displayed, click the Condition  tab.

10. To map fields using advanced scripts, select the Advanced Field Mapping  check box.

11. On the Advanced field Mapping  tab, paste in the following code.

(function (source,target) {
    // Get the first comments from incident and use it as Issue 
 description for article
    var notes = source.comments.getJournalEntry(-1);
    var entries = notes.split("\n\n");
    var comment = "";
    if(entries[entries.length-2]){
        comment = entries[entries.length-2];
        var part = comment.toString().indexOf(")");
        if(part != -1){
comment = 
 comment.toString().substring(part+2).replaceAll("\r\n","<br/>
");
    }
    }if(comment)
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        target.kb_issue = comment;
})(source,target);

The first comment on an incident is mapped to the Issue Description  field in the knowledge 
article.

Note: 
If the same source or target field is configured in both the basic and advanced field 
mappings, the advanced field mapping overrides the basic field mapping.

If the fields configured in the basic and advanced field mapping are different, the field 
configurations in the advanced field mapping are appended to the field configurations in 
the basic field mapping.

Add a property to enable creating knowledge article from incidents

Add a property, which is required to allow users to create a knowledge article from an incident.

Before you begin
Role required: admin

Procedure

1. In the Filter navigator, enter sys_properties.list.

2. Click New.

3. Fill in the following fields.

System Property form

Field Description

Name enable_kcs_incident

Description Enable Knowledge Centered Services (KCS) 
for Incident Management.

Type true|false

Value true

4. Click Submit.

Create a UI action to enable creating knowledge articles from incidents

Create a UI action to add the Knowledge check box to the Incident form.

Before you begin
Role required: admin

Procedure

1. Navigate to System UI  > UI Actions.

2. Click New.

3. Fill in the following fields.
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UI Action form

Field Description

Name Create Knowledge

Table Incident

Action name create_knowledge

4. Select the Client  check box.

5. Select the List v3 Compatible  check box.

6. Select the Form button  check box.

7. In the Onclick  field, enter createKnowledgeClient().

8. In the Condition  field, enter gs.getProperty("enable_kcs_incident") 
== 'true' && new global.CSMTableMapUtil 
(current).findMapByName("incident_kcs_article") && new 
global.KBKnowledge().canCreate().

9. In the Script  field, enter the following code.

function createKnowledgeClient() {
    if (g_form.modified) {
        alert(new GwtMessage().getMessage('You have unsaved 
 changes. Please save them to continue.'));
    }else{
        //Call the UI Action again but skip the 'onclick' 
 function
        gsftSubmit(null, g_form.getFormElement(), 
 'create_knowledge');
//MUST call the 'Action name' set in this UI Action
    }
}
 
//Code that runs without 'onclick'
//Ensure call to server-side function with no browser errors
if (typeof window == 'undefined')
    CreateKnowledgeServer();
 
function CreateKnowledgeServer(){
    current.update();
 
    var map = new global.CSMTableMapUtil (current);
    map.findMapByName("incident_kcs_article");
    var targetURL = map.getTargetURL();
        if(targetURL)
        action.setRedirectURL(targetURL[0]);
}

Knowledge content migration from v2 to v3

To use the new functionality available in knowledge v3 with legacy articles, you must migrate 
these articles out of the default knowledge base.

To migrate knowledge content, move articles out of the default knowledge base by changing 
the Knowledge Base  value for each article. The state of the article remains unchanged when 
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moving articles. After selecting a new knowledge base, assign a category to each article using 
the category structure defined in the new knowledge base.

After you migrate a knowledge article, the legacy feedback functionality is automatically 
replaced with the new knowledge feedback mechanisms. Legacy feedback is copied to the Live 
Feed Message [live_message] table to ensure previously submitted feedback is available for 
knowledge v3 articles.

Move a knowledge article

You can move articles between knowledge bases.

Before you begin
Role required: User must have contributor access to the knowledge base.

Note: 

• When versioning is enabled, and you move an article from one knowledge base to 
another, the latest version of an article is moved to the new knowledge base. However, 
the previous versions of the article remain in the old knowledge base. It is recommended 
to retire the article from the old knowledge base. For more information, see Retire a 
knowledge article.

• Although you can move an article from one knowledge base to another consider creating 
an article in new knowledge base.

Procedure

1. Edit a knowledge article.

2. Change the Knowledge Base  field value.
After moving an article, the Apply Default Values dialog box prompts you to populate certain 
fields in the article with default values from the new knowledge base. If the new knowledge 
base has no default values, the dialog box does not appear.

3. Click OK  to overwrite fields with the default values, or Cancel  to leave all fields unchanged.

A knowledge manager can define default values for articles in knowledge bases you manage 
using the Set default knowledge field values  field on the Knowledge Base form.

4. Click Update.

Creating and maintaining articles

Share your ideas and experience by creating a knowledge article. Review and provide feedback 
on knowledge articles, and resolve issues yourselves rather than contacting customer service or 
an internal helpdesk.

Create a knowledge article

Knowledge contributors can create and edit knowledge articles within a knowledge base to 
share information across your organization.

Before you begin
To view an article template, you must activate the article templates feature and enable the 
desired templates.

Role required: knowledge, knowledge_manager, knowledge_admin, knowledge_coach, 
knowledge_domain_expert, knowledge_group_member, admin. You must have contribute access 
to at least one active knowledge base.
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About this task
Users with at least one role can create and edit knowledge articles. These users are known as 
knowledge contributors. Users without any role can read articles and submit feedback, but can’t 
create or edit articles.
Some knowledge bases may allow only certain users to contribute. For example, a member of the 
IT department can create knowledge articles in the IT knowledge base, such as desktop support 
information or articles describing company IT processes.

Procedure

1. There are three ways of creating knowledge articles.

◦ Navigate to Self-Service  > Knowledge  and select the Create an Article icon.

◦ Navigate to Knowledge  > Articles  > Create New.

◦ From the Knowledge Management homepage, select the more icon ( ) and then select 
Create Article.

2. On the Create new article page, select a knowledge base.
The list of article templates to select in the next step is filtered according to the article 
templates available for the selected knowledge base.

Note: 

On the Create new article page, you can select to Switch to older version of this page  or 
Switch to updated version of this page (recommended).

3. Select an article template.

4. Select Next.
The Knowledge form is displayed based on the article template selected.

5. On the Knowledge form, fill in the fields.

Knowledge form

Field Description

Number Number of the article. This field is automatically set to a number. For more 
information, see Duplicate knowledge article numbers.

Knowledge 
Base

The knowledge base selected for this article.

Note: 
An article can only be associated with one knowledge base.

You can change the knowledge base, but only if the selected article 
template is available in the knowledge base.

Category The category for this article. Select a Knowledge Base  before you can select 
a category. Articles without a category appear on the knowledge homepage in 
the (empty) category.

Ownership 
Group

The ownership group for this knowledge article. An ownership group is a group 
of members and a manager who are responsible for approvals, ensuring article 
quality, and feedback tasks. Ownership groups can publish, edit, and retire 
knowledge articles that they’re associated with.
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Field Description

Note: 
If no ownership group is assigned, the article automatically goes to the 
knowledge administrator and knowledge manager for approval.

Language Language in which you’re creating the article. The list is populated based on 
the languages enabled for the selected knowledge base.

Schedule 
publish date

Date in future when the article is published automatically. If approvals are 
enabled, the approval process must be completed before this date.

Valid to The date this knowledge article expires. Articles don’t appear in search results 
after the Valid to  date or if the Valid to  date is empty.

The default value of the Valid to  field is derived from the Article Validity  field 
configured for the knowledge base (see Create a knowledge base). The Valid 
to  date starts from the date that the article was created until the number of 
days specified in the Article Validity  field. If the Article Validity  field is empty, 
the default date in the Valid to  field for the knowledge article is set to January 
1, 2100.

An article author or editor can select whether to keep or change the default 
Valid to  date. For more information, see Validity of a knowledge article.

On the first day of each month, the application sends an email notification to 
a list of authorized recipients to remind them about articles that are expire in 
the next month. The recipient can then extend the Valid to  date to continue 
using the article. For more information, see Managing email notifications in 
Knowledge Management.

Note: 
If the system date format or user preferences is set to use yy  year format, 
you might face issues when the Valid to  date is set to the default date. 
Contact your administrator or modify the user preferences to use a date 
format with the yyyy  year format. For more information, see Global date 
and time field format  and Personalize the system date format  topics.

Confidence Maturity of an article based on its completeness and reusability.

Version Version of the article. This field appears only when the article versioning 
feature is enabled. For more information, see Article versioning.

Parent Number of the article that represents the base language article. This setting 
keeps translations of the same article related to each other. Consider choosing 
the same language consistently for the parent article. This field appears only 
when the I18N:Knowledge Management Internationalization Plugin v2 plugin 
(com.glideapp.knowledge.i18n2) is activated. For more information, see I18N - 
Knowledge internationalization.

Note: 
The Parent  field contains the first version of the parent article only. This 
field is used by the translation management feature to maintain the 
relationship between the source article and its translations.

Article type The type of article, either HTML or wiki.
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Field Description

Note: 
This field is only visible in the standard template.

Workflow [Read-Only] The publication state of the article, such as Draft, In Review, or 
Published. When inserting a new article from an existing article, the state of 
the new article is reset to Draft.

Source The task this knowledge article was created in response to, if any. This field is 
set automatically when you create the knowledge article from a task record.

Attachment 
link

Option for downloading an attached file automatically when a user accesses 
the article, instead of opening the article view. Add one or more attachments to 
the article to use this option.

Note: 
You may attach multiple files, but most web browsers permit users to 
download only the first one. To ensure download of all the files, bundle 
them into an archive, such as with WinZip, and attach the archive. The 
Attachment link option applies to articles accessed from search links 
only. Articles accessed as links within other knowledge articles won’t 
replicate this behavior.

Display 
attachments

Option for displaying attachments to users viewing this knowledge article. 
Attachments appear below the article text. Add one or more attachments to the 
article to use this option.

Governance An attribute of an article that enables you to control sensitive, critical, 
or regulated information. Not all articles have the same requirement for 
compliance reviews. Some articles are based on the collective experience of 
the people who use the articles (experience-based). Other articles have policy 
or legal information that require tight control (compliance-based).

Short 
description

The title of the article. This title appears when browsing and searching for a 
knowledge article, and at the top of the article.

You can enter up to 100 characters in this field.

Note: 
If contextual search is enabled, the knowledge articles similar to the 
entered short description text appear in the Knowledge results section.

Article body Content for the article. A preview of the content appears when browsing and 
searching for a knowledge article.

Use the editing functions in the HTML editor to create content. For more 
information, see Editing functions for knowledge articles in the HTML editor.

Meta Tags for optimizing search from external search engines. Separate multiple 
entries by commas. You may need to configure the form to add this field. For 
more information, see Configuring the form layout .
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Field Description

Note: 
If AI Search  is enabled for the Knowledge Management Service Portal, 
the tags you add to the Meta  field aren't indexed. To fine-tune AI Search 
results, your administrator can configure result improvement rules. For 
more information, see AI Search in Service Portal .

Note: 
The Confidence  and Governance  fields appear when the Knowledge Management 
KCS Capabilities plugin (com.snc.knowledge_kcs_capabilities) is activated. For more 
information, see Managing KCS article states.

6. To preview the article select the View Article  link in the Related Links section located below 
the form.

Note: 

Viewing the article through this link is only to facilitate a preview of the edited article and, does 
not add to the actual view count of the article on the document site.

7. Optional:  To search for similar articles, enter the text in the Related Search  field or continue 
with the default text in the Knowledge results section.
If the Knowledge results section isn’t displayed on the Knowledge form, an administrator can 
configure the form layout to add the Contextual Search Results  field to the form.

◦ To find knowledge articles that have high text similarity with the entered search text, choose 
Similar Articles (ML).

Note: 
This option is available only when the Predictive Intelligence  feature is enabled and 
your administrator has trained the similarity solution for Knowledge Management. For 
more information, see Train the similarity solution for Knowledge Management to find 
related articles.

◦ To find knowledge articles that match the entered search text, choose Search Articles.

8. Optional:  To view the entire article in a pop-up window, select the link to the article title.

9. Select Submit  to create the article.

10. Optional:  Select Search for Duplicates  for any redundant content in existing articles.

11. Optional:  Select the link in the For SEO suggestions on this article, click here  message, if 
available, to review suggestions for improving your article.
Suggestions are provided to help you improve the search engine optimization and accessibility 
of your article, such as removing multiple Heading 1  or <H1>  tags. Suggestions are provided 
for the heading 1 <h1>, anchor <a>, and image <img>  tags.

12. Optional:  Either add to or modify the article details or publish the article.

◦ Add to or modify the article details.

(Optional) For more information, see Edit a knowledge article.

◦ Publish the article by selecting Publish.

A knowledge article is published depending on the workflow setting of its knowledge base:
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▪ Knowledge - Instant Publish: The knowledge article is immediately published unless it’s 
scheduled to be published at a later date.

▪ Knowledge - Approval Publish: The knowledge article is published on approval 
completion unless it’s scheduled to be published at a later date.

Note: 
With an ownership group associated with a knowledge article, 
ownership group members can approve self-authored articles for 
publication. An administrator can override this behavior by disabling the 
glide.knowman.ownership_group.enable_self_approval  property. 
For more information, see Ownership groups.

For more information, see Schedule a knowledge article for publishing.

If an article is visible to a guest user, a message appears that reads This article may 
be visible to unauthenticated users after it is published. Do 
you still want to proceed?

When published, the knowledge article appears in the Published and All lists. To view the 
Published list, navigate to Knowledge  > Articles  > Published. To view the All list, navigate to 
Knowledge  > Articles  > All.

If the article versioning feature is enabled, the version number of the knowledge article 
increments to the next whole number (for example, from 2.02 to 3.0). For more information, 
see Knowledge article version numbers.

What to do next
After saving the article record, you can add tags to organize the article.
After you create and publish a knowledge article, you can perform the following actions related to 
the article:

• Request translations for the knowledge article. For more information, see Request missing 
translations for available languages.

• Retire the knowledge article. Select Retire  to enable the retirement workflow. For more 
information, see Retire a knowledge article.

• Translate the knowledge article directly from the knowledge article. For more information, see 
Translate a knowledge article from a translation task.

• Delete the published knowledge article. Select Delete. If the Delete  button isn't displayed, 

select the more actions icon ( ), and then select Delete.

Note: 
Only users with the admin role can delete a published knowledge article.

Related topics

Map related articles

Predictive Intelligence for Knowledge Management

Edit a knowledge article

Edit knowledge articles within a knowledge base to update information shared across your 
organization.

Before you begin
Role required: knowledge
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About this task
Users with at least one role can edit knowledge. These users are known as knowledge 
contributors. Users without any role can read articles and submit feedback, but cannot edit 
articles.

However, knowledge managers can configure User Criteria to restrict access to certain 
knowledge bases. For example, only members of the IT department can create or edit knowledge 
articles in the IT knowledge base, such as desktop support information or articles describing 
company IT processes.

Note: 

• If the article versioning feature is enabled, the author cannot edit the article 
if it is already checked out by the contributor. If the feature is disabled, any 
users with contribute access to an article can edit the draft version of the 
article. An administrator can disable the article versioning feature by setting the 
glide.knowman.versioning.enabled  property (from the System Property 
[sys_properties] table) to false.

• If an ownership group is associated with a knowledge article, the author 
or reviser of the article can't contribute to the article after the article is 
published. An administrator can override this behavior by enabling the 
glide.knowman.ownership_group.override  property. For more information, 
see Ownership groups.

• If the glide.knowman.translation.enable_translation_task  property is 
enabled, you can’t modify the knowledge base of existing articles.

Procedure

1. Navigate to All  > Knowledge  > Articles.

2. Select an article from the Published  or Unpublished  category.

3. On the Knowledge form, click Edit.

Note: 
If the knowledge article was created using Microsoft  Word, you can edit the article only in 
Microsoft  Word. In this case, select Open in Word  to open the article in Word Online. For 
more information, see Edit a knowledge article in Microsoft Word.

If you want to edit the article using the HTML editor, you can unlink the article from 
Word. For more information, see Unlink knowledge articles from linked Microsoft Word 
documents.

4. If the article versioning feature is enabled, click Checkout  for a published knowledge article.
You can only edit the latest version of a knowledge article.

5. Click Update.
When you edit a knowledge article, a default value appears in the Valid to  field. You can select 
whether to keep or change the default Valid to  date.
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Note: 
If the article versioning feature is enabled, the default value of the Valid to  date in the 
updated article version is automatically set based on the following criteria:

◦ If the Article Validity  field in the knowledge base associated with the article is blank, 
the Valid to  date value from the earlier version of the article is retained.

◦ If the Article Validity  field in the knowledge base associated with the article is not 
blank, the Valid to  date is automatically updated to start from the date the article was 
updated until the number of days specified in the Article Validity  field (Article updated 
date + article validity).

If you move a knowledge article to another knowledge base, the default value of the Valid 
to  date in the updated article is automatically set based on the following criteria:

◦ If the Article Validity  field in the selected knowledge base is blank, the earlier Valid to 
date value is retained for the knowledge article.

◦ If the Article Validity  field in the selected knowledge base isn't blank, the Valid to  date 
is automatically updated to start from the date the article was updated until the number 
of days specified in the Article Validity  field (Article updated date + article validity).

If the dictionary value of the Valid to  field is modified, this dictionary value overrides the 
default value of the Valid to  field calculated according to the Article Validity  field. For 
more information, see Validity of a knowledge article.

The article is saved. If the article versioning feature is enabled, the version of the knowledge 
article is incremented by 0.01. For more information, see Knowledge article version numbers

6. Optional:  Select the link in the For SEO suggestions on this article, click here  message, if 
available, to review suggestions for improving your article.
Suggestions are provided to help you improve the search engine optimization and accessibility 
of your article, such as removing multiple Heading 1  or <H1>  tags. Suggestions are provided 
for the heading 1 <h1>, anchor <a>, and image <img>  tags.

7. Optional:  Publish the article by clicking Publish.
The knowledge article is published depending on the workflow setting of its knowledge base:

◦ Knowledge - Instant Publish: The knowledge article is immediately published unless it is 
scheduled to be published at a later date.

◦ Knowledge - Approval Publish: The knowledge article is published on approval completion 
unless it is scheduled to be published at a later date.

Note: 

▪ With an ownership group associated with a knowledge article, 
ownership group members can approve self-authored articles for 
publication. An administrator can override this behavior by disabling the 
glide.knowman.ownership_group.enable_self_approval  property. 
For more information, see Ownership groups

▪ If an article is visible to a guest user, a message appears that reads This article 
may be visible to unauthenticated users after it is 
published. Do you still want to proceed?

For more information, see Schedule a knowledge article for publishing.
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When published, the knowledge article appears in the Published and All lists. To view the 
Published list, navigate to Knowledge  > Articles  > Published. To view the All list, navigate to 
Knowledge  > Articles  > All.

If the article versioning feature is enabled, the version number of the knowledge article 
increments to the next whole number (for example, from 2.02 to 3.0). For more information, see 
Knowledge article version numbers.

Related topics

Article versioning changes

Editing functions for knowledge articles in the HTML editor

Improve the readability and usefulness of knowledge articles by formatting the article text using 
the HTML editor.

The HTML editor available in knowledge articles uses the built-in TinyMCE editor. The text 
formatting is preserved when the content is displayed on a portal.

The HTML toolbar within the HTML editor contains an array of icons that enable you to edit and 
format the body text of your knowledge article. You can also use the HTML Editor to add images, 
links, audio, and video to the knowledge article.

Note: 
Your administrator can configure the HTML toolbar within the HTML editor. For more 
information, see Customize TinyMCE attributes .

You can perform the following functions using the HTML editor:

• Spell check as you type in the Article body section of a knowledge article.

The HTML editor automatically checks spelling as you type and underlines spelling and 
grammar mistakes in red.

• View the style applied to the selected text and the word count from the bottom pane of the 
HTML editor.

• Apply formatting.

• Paste without formatting.

• Insert tables and modify cells, rows and columns of a table.

• Include HTML content.

• Insert or edit a code snippet.

• Insert a basic table of contents at the cursor's current position.

• Find and replace text.

• Revert changes that you have made during the current session of content editing.

Managing HTML content in knowledge articles

You can manage HTML content in knowledge articles by using the HTML editor.

You can perform the following functions for HTML content in knowledge articles:
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• Insert a hyperlink by using the insert/edit link icon ( ) available on the HTML toolbar. For 
more information, see Link to a website in HTML fields .

• Insert an image by using the insert/edit image icon ( ) available on the HTML toolbar. For 
more information, see Embed images in HTML fields .

• Embed a video from the video library, an attachment, or URL by using the insert/edit video 
icon ( ) available on the HTML toolbar. You can also add videos to the video library. For more 
information, see Embed videos in HTML fields .

• Copy content from external sources and paste them as simple text into the editor. For more 
information, see Paste content into the HTML editor .

• View and edit the HTML source code by using the source code icon ( ) available on the HTML 
toolbar. For more information, see Extended functions .

Note: 
To insert or edit a code snippet, see Format a code snippet automatically in knowledge 
articles.

• Expand the HTML field to use the full form view for easier editing by using the fullscreen icon 

( ). For more information, see Extended functions .

Formatting options for knowledge articles

You can apply formatting to a knowledge article using the HTML editor.

You can use the icons on the HTML toolbar to apply the following formatting in knowledge article 
text:

• Change the font or font size of knowledge articles.

• Format text as bold, italicized, underlined, or strikethrough.

• Change the text color and text background color.

• Create bulleted and numbered lists.

• Change paragraph indentation.

• Apply styles to text.

• Identify and resolve accessibility related issues in a knowledge article using the Accessibility 
checker in the toolbar.

For more information, see Formatting icons for HTML fields .

Paste content without formatting into the knowledge article

Paste content into the body of a knowledge article without copying the content formatting.

Before you begin
Open the knowledge article in which you want to use the HTML editor.

About this task
You can also use the HTML editor when creating or editing a knowledge article using the 
Knowledge Management  application in the ServiceNow AI Platform  interface or in Agent 
Workspace. To create or edit a knowledge article in the ServiceNow AI Platform  interface, see 
Create a knowledge article  or Edit a knowledge article. To create or edit a knowledge article 
in Agent Workspace, see Create a knowledge article in Agent Workspace  or Edit a knowledge 
article in Agent Workspace.
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Procedure

1. Copy your text from a content source.

2. Click the paste as text icon ( ) on the HTML toolbar.

3. In the Article body section, place your cursor at the point where you want to paste the content, 
right-click, and select Paste  from the context menu.

Adding tables to knowledge articles

You can insert tables and modify the cells, rows, and columns of a table in a knowledge article.

You can add tables to your knowledge articles by clicking the table icon ( ) on the HTML toolbar 
and selecting your desired table options. For example, you can adjust the height and width of 
rows and column, the spacing between cell text and cell borders, and change the colors of cells.

For more information, see Add a table to the HTML field .

Insert an image in a knowledge article

Insert an image in a knowledge article using the HTML editor.

Before you begin
Role required: user with contribute access

Procedure

1. Navigate to All  > Knowledge  > Articles  > All.

2. Select a knowledge article.

3. On the knowledge article form, in the Article body  field, place the cursor where you want to 
insert an image.

4. On the HTML editor toolbar, select the Insert/edit image icon ( ).

5. On the Insert/Edit Image dialog box, select the Upload icon ( ).

6. Select an image.

7. Select Open.

8. Select Save.

Result
The image is included in the knowledge article.

Format a code snippet automatically in knowledge articles

Add syntax highlighting to a code snippet in knowledge articles using the HTML editor.

Before you begin
Open the knowledge article in which you want to use the HTML editor.

Role required: knowledge

About this task
You can also use the HTML editor when creating or editing a knowledge article using the 
Knowledge Management  application in the ServiceNow AI Platform  interface or in Agent 
Workspace. To create or edit a knowledge article in the ServiceNow AI Platform  interface, see 
Create a knowledge article  or Edit a knowledge article. To create or edit a knowledge article 
in Agent Workspace, see Create a knowledge article in Agent Workspace  or Edit a knowledge 
article in Agent Workspace.
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Procedure

1. In the Article body section, place the cursor where you want to insert the code snippet.

2. Click the insert/edit code sample icon ( ) on the HTML toolbar.

3. In the Insert/Edit code sample dialog box, select a markup or programming language from the 
Language list.

4. In the text box after the Language list, enter your code.
Alternatively, you can copy the code from an external source and paste it.

5. Click Ok.

6. Optional:  Edit the code by clicking the code snippet, and then clicking the insert/edit code 
sample icon ( ).

Insert a table of contents in knowledge articles

Insert a hierarchical table of contents (toc) based on the headings in your knowledge article.

Before you begin
Open the knowledge article in which you want to use the HTML editor.

Role required: none

About this task
You can also use the HTML editor when creating or editing a knowledge article using the 
Knowledge Management  application in the ServiceNow AI Platform  interface or in Agent 
Workspace. To create or edit a knowledge article in the ServiceNow AI Platform  interface, see 
Create a knowledge article  or Edit a knowledge article. To create or edit a knowledge article 
in Agent Workspace, see Create a knowledge article in Agent Workspace  or Edit a knowledge 
article in Agent Workspace.

You can generate a table of contents only if your article uses heading levels from Heading 1 to 
Heading 3 and is a standard article.

Note: 
Use Format select to set heading levels in the article. You can 
also configure the HTML toolbar using TinyMCE attributes. 
For more information, see Customize TinyMCE attributes . 

Procedure

1. In the Article body section, place the cursor where you want to insert the table of contents.

2. Click the table of contents icon ( ) on the HTML toolbar.
If you do not see the table of contents icon on the toolbar, add it using steps available in 
Customize TinyMCE attributes .

3. Optional:  Update an existing table of contents by selecting it and then clicking the update 

icon ( ) on the HTML toolbar.

Result
The HTML editor searches for the headings in your content including their levels (such as 
Heading 2 or Heading 3). It then automatically generates a table of contents that contains links to 
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the heading levels from Heading 1 to Heading 3 only. The links to heading levels are indented to 
show the heading hierarchy.

Find and replace text in knowledge articles

Make global changes to the content of a knowledge article by finding and replacing specific text 
using the HTML editor.

Before you begin
Open the knowledge article in which you want to use the HTML editor.

About this task
You can also use the HTML editor when creating or editing a knowledge article using the 
Knowledge Management  application in the ServiceNow AI Platform  interface or in Agent 
Workspace. To create or edit a knowledge article in the ServiceNow AI Platform  interface, see 
Create a knowledge article  or Edit a knowledge article. To create or edit a knowledge article 
in Agent Workspace, see Create a knowledge article in Agent Workspace  or Edit a knowledge 
article in Agent Workspace.

Procedure

1. In the Article body section, place the cursor anywhere.

2. Click the find and replace icon ( ) on the HTML toolbar.

3. In the Find and Replace dialog box, in the Find  field, enter the search term you want to find.

4. Enter replacement text for the search term in the Replace with  field.
If you want to delete repeated occurrences of the search text, leave the Replace with  field 
blank.

5. Optional:  Refine the scope of the search.

◦ To limit the search to text that exactly matches the case of the search term, select the Match 
case  check box.

◦ To limit the search to text that matches one or more complete words only, select the Whole 
words  check box.

6. Find or replace the search term.

Result
When no more occurrences of the term can be found or if the search term is not found at all in 
the content, a message appears indicating that the specified string wasn't found.

Undo or redo typing actions or formatting while authoring knowledge articles

Quickly revert typing actions or formatting that you made during the current session of editing a 
knowledge article using the HTML editor.

Before you begin
Open the knowledge article in which you want to use the HTML editor.

About this task
You can also use the HTML editor when creating or editing a knowledge article using the 
Knowledge Management  application in the ServiceNow AI Platform  interface or in Agent 
Workspace. To create or edit a knowledge article in the ServiceNow AI Platform  interface, see 
Create a knowledge article  or Edit a knowledge article. To create or edit a knowledge article 
in Agent Workspace, see Create a knowledge article in Agent Workspace  or Edit a knowledge 
article in Agent Workspace.
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Procedure

1. Place the cursor in the Article body section.

2. Undo or redo a typing action or format change.

◦ To undo the previous change, click the undo icon ( ).

◦ To redo a change that has been undone, click the redo icon ( ).

Note: 

The undo ( ) and redo ( ) icons are available based on the number of actions that are 
saved to be undone or certain actions that can't be undone.

Map related articles

Discover similar information across articles on a topic while viewing an article. You can manually 
map related articles or have the application automatically present related articles using machine 
learning (ML) algorithms.

Before you begin
Role required: knowledge
To edit the article, you must have knowledge contributor access for the associated Knowledge 
Base.

About this task
If you have manually mapped related articles when editing an article, those articles are listed in 
the Related Articles section on the knowledge article view page before the related articles that 
are predicted thorough the Knowledge Management  similarity solution.

Note: 
An administrator can train the solution definition for Knowledge Management  within the 
Predictive Intelligence  feature to find related articles. For more information, see Train the 
similarity solution for Knowledge Management to find related articles.

This task provides steps to manually map related articles when editing an article.

Procedure

1. On the ServiceNow AI Platform, open the knowledge article for which you want to map related 
articles.

2. On the Knowledge form, click the Related Articles related list.

3. Click Edit.

4. On the Edit Members form, move the desired articles from the available articles in the 
Collection  column to the Related Articles List  column.

5. Click the up or down icon to arrange the articles in the order in which you want them to appear 
in the Related Articles section on the article view page, and then click Save.

Note: 
Knowledge administrators can configure the number of articles shown in the Related 
Articles section using the instance options.
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Related topics

Edit a knowledge article

Train the similarity solution for Knowledge Management to find related articles

Configure knowledge related articles widget instance options

Map catalog items related to an article

Manually map catalog items related to a knowledge article to enable employees to request the 
related product or service.

Before you begin
Role required: knowledge
To edit the article, you must have knowledge contributor access for the associated Knowledge 
Base.

Procedure

1. Navigate to All  > Knowledge  > Articles  > All.

2. Open the knowledge article for which you want to map related catalog items.

3. On the Knowledge form, click the Related Catalog Items related list.

4. Click Edit.

5. On the Edit Members form, move the desired catalog items from the available catalog items in 
the Collection  column to the Related Catalog Items List  column.

6. Click the up or down icon to arrange the articles in the order in which you want them to appear 
in the Related Items section on the article view page, and then click Save.

Note: 
Knowledge administrators can configure the number of catalog items shown in the 
Related Items section using the instance options.

Related topics

Edit a knowledge article

Service Catalog items

Configure related catalog item widget instance options

Schedule a knowledge article for publishing

Set a specific time and day for a knowledge article to be published automatically.

Before you begin
You must have contribute access to the knowledge base that stores the knowledge article you 
want to schedule for publishing.
Ensure that the system administrator verifies the following settings:

• Knowledge Management Advanced plugin (com.snc.knowledge_advanced) is activated. For 
more information, see Activate the Knowledge Management Advanced plugin.

• The article versioning feature is enabled. For more information, see Article versioning.

Role required: knowledge
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Procedure

1. Navigate to All  > Knowledge  > Articles  and click Unpublished.

2. Select an article link.

3. In the Scheduled publish date  field, click the select date and time icon .

You may need to configure the knowledge block form to include the Scheduled publish date 

field. Click the form context menu icon ( ) and navigate to Configure  > Form Layout. Use 
slushbucket to add the Scheduled publish date field.

Important: 
You must set the Scheduled publish date  at least 24 hours from the current date. To 
publish the article earlier than 24 hours, click Publish article  available in the form.

4. Select any future date from the calendar.

5. In the Time  field, enter a time in the format hh:mm:ss.

6. Select the save (enter) icon .

7. Select Publish  to enable the publishing workflow.
The article is available in the All list. Go to Knowledge  > Articles  > All.

Tip: 
If you want to cancel an article's scheduled publication and move the article back to the 
Draft state, click Recall.

Result
The knowledge article is published on the scheduled publish date depending on the following 
workflow settings of its knowledge base:

• If the knowledge base workflow is set to Knowledge - Instant Publish, the knowledge article is 
automatically published on the scheduled publish date. The Workflow  field on the Knowledge 
form of the article is updated to Scheduled for publish.

• If the knowledge base workflow is set to Knowledge - Approval Publish, the knowledge article 
is published on approval completion. The Workflow  field on the Knowledge form of the article 
is updated to Review.

The approval completion affects the scheduled publishing as follows:

◦ If the approvals are completed before the scheduled publish date, the Workflow  field on 
the Knowledge form of the article is updated to Scheduled for publish  and the article is 
published on the scheduled publish date.

◦ If the approvals are completed after the scheduled publish date, the article is published 
immediately on the approval completion.

Related topics

Edit a knowledge article

Recall an article that is being reviewed

Recall an article that is being reviewed to make additional changes.

About this task
If ownership groups is not enabled, only the author of the article, knowledge administrators, or 
system administrators can recall the article.
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If ownership groups is enabled, the author of the article, the ownership group manager, 
ownership group members, knowledge administrators, or system administrators can recall an 
article.

Recalling an article in the Review  state results in a minor version increment.

When a revised article is in Review  state, only the corresponding versions reviser can recall the 
article to make additional changes.

Procedure

1. Navigate to Knowledge  > Articles  > All.

2. Open an article in the Review  state.

3. Click Recall  in the Knowledge form header.
The system returns the state of the article to Draft, increments the version number by 0.01, and 
displays a message to the user.

Approve an article that is being reviewed

Approve an article that is being reviewed and create a new published version.

Before you begin
Role required: Owner and knowledge manager

About this task
When an article is in the Review  state, only those users who are included in the Approvals 
related list can modify the article.

Procedure

1. Navigate to All  > Knowledge  > Articles  > Unpublished.

2. Open an article in the Review  state and review the text.

3. In the Approvals  related list, click Requested  in the State  column to display the Approval form 
for the article.

4. Click Approve.

Result
The system displays the Knowledge form. The version number of the article increments to the 
next whole number (for example, from 2.02 to 3.0) and the state changes to Published. The new 
published version of the article is added to the Knowledge list and to the Article Versions  related 
list on the Knowledge form.

Retire a knowledge article

Initiate the retirement workflow to retire a knowledge article. Knowledge base owners and 
managers can view articles after they are retired but cannot search for retired articles on the 
Knowledge homepage and portal.

A knowledge article has an associated retirement workflow, similar to the publishing workflow. 
This allows administrators to configure these workflows, defining an approval and review process 
for retiring knowledge if appropriate.

When editing an article, click Retire  to launch the retirement workflow associated with that 
article. Only knowledge administrator, knowledge manager, and the latest publisher of the 
versioned knowledge article (not available for kcs_candidate or kcs_contributor) can retire a 
knowledge article. For more information, see Retire a versioned article. If the article requires 
approval prior to retirement, the article goes to a pending approval state, and the workflow 
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either finishes upon approval or cancels if rejected by a required approver. The article number 
associated with the retired article is not available for reuse. For information on the status of a 
knowledge article see Knowledge article states.

Note: 

• Only administrators and knowledge administrators can view the retired knowledge 
articles. To reuse a retired article, administrators and knowledge administrators can 
republish the article. For more information, see Republish a retired article.

• An article and its translations have a parent-child relationship. Retiring a parent article 
does not automatically retire all its translated child articles.

Beginning with the San Diego  release, you can provide a replacement article while retiring 
a knowledge article. When the retired article is accessed, the user will automatically be 
redirected to the replacement article with a display message The article KBxxx is 
retired and has been replaced with the knowledge article KBxxx. If 
no replacement article is available, the page displays the message Knowledge record not 
found. The retire with replacement feature is not supported on classic workspace.

Note: 

• Article with replacement returns a 301 code.

• Article without any replacement returns a 404 code.

• By default, the glide.knowman.enable_article_replacement_on_retire 
system property is set to true  to provide a replacement article for a retired article.

• The retire action on classic workspace will just retire the article 
and not provide a replacement irrespective of the setting of 
glide.knowman.enable_article_replacement_on_retire.
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Instant retire and Approval retire workflows

Republish a retired article

Instantly republish a retired article.

Before you begin
You must activate the Knowledge Management Advanced (com.snc.knowledge_advanced) 
plugin.

Role required: admin or knowledge admin

Note: 
You need a scoped admin role to republish a retired article in the Scoped knowledge bases.

About this task
There may be cases where you will need to republish a retired article. For example, an admin may 
want to temporarily retire an article when its information doesn't currently apply, but will at a later 
date. An administrator or knowledge administrator who can view retired articles can instantly 
republish these without having to go through an approval workflow.

Procedure

1. Navigate to All  > Knowledge  > Articles  > Retired.

2. Select a retired article and click Republish.
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Result
The article is instantly published as the previous last published version.

Move a knowledge article

You can move articles between knowledge bases.

Before you begin
Role required: User must have contributor access to the knowledge base.

Note: 

• When versioning is enabled, and you move an article from one knowledge base to 
another, the latest version of an article is moved to the new knowledge base. However, 
the previous versions of the article remain in the old knowledge base. It is recommended 
to retire the article from the old knowledge base. For more information, see Retire a 
knowledge article.

• Although you can move an article from one knowledge base to another consider creating 
an article in new knowledge base.

Procedure

1. Edit a knowledge article.

2. Change the Knowledge Base  field value.
After moving an article, the Apply Default Values dialog box prompts you to populate certain 
fields in the article with default values from the new knowledge base. If the new knowledge 
base has no default values, the dialog box does not appear.

3. Click OK  to overwrite fields with the default values, or Cancel  to leave all fields unchanged.

A knowledge manager can define default values for articles in knowledge bases you manage 
using the Set default knowledge field values  field on the Knowledge Base form.

4. Click Update.

Comment on a knowledge article

Comment on a knowledge article or reply to a comment.

Before you begin
You must activate the Knowledge Management V3 plugin (com.snc.knowledge3).

Role required: User with Can Read access. Unauthenticated users and users with only the 
snc_external role can’t add or view attachments for comments.

Note: 

Starting with the Washington DC  release, the Knowledge Management  v3 
homepage (com.snc.knowledge3) is being prepared for deprecation in the 
future Y release. It is replaced by the Knowledge Management  Service Portal 
(com.snc.knowledge_serviceportal), which is active by default for customers on Madrid 
and later releases. For more information about the new experience, see Knowledge 
Management Service Portal homepage features.

Procedure

1. Navigate to the Knowledge Management Service Portal.

2. Click the article you want to comment or reply to a comment on.
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3. Select Post a comment.
If you want to reply to an existing comment, select Reply

Post a comment

4. Enter your comment or reply and add links, images, and attachments as required.

Note: 
Attachments to comments posted in the Knowledge Management Service Portal are not 
displayed in the Live Feed. If attachments to comments are posted in Live Feed, they are 
displayed in the Knowledge Management Service Portal.

If antivirus protection is enabled, all attachments are automatically scanned for viruses 
once the comment is posted. Attachments are only displayed once the scan is finished 
and successful.

If you are the author of the comment, you can delete it. All comments and replies 
underneath are automatically deleted.

5. Click Submit.

Note: 
When the Use Live Feed for Knowledge Feedback property is enabled, you can only view 
comments in the Live Feed. By default, it is set to inactive.

Comments posted in Live Feed before upgrading to release version New York are not 
shown hierarchically in the Knowledge Management Service Portal. Comments posted 
in Live Feed after upgrading to release version New York are shown hierarchically in the 
Knowledge Service Portal.

The following table illustrates how comments and replies to comments are displayed 
depending on where you are viewing them.

Display of comments and replies to comments

Viewing from HTML formatting Hierarchy Attachments

Knowledge 
Management Service 
Portal

Yes Yes Yes

Live Feed No Yes Yes

Knowledge 
Management v3

No No No
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Create knowledge from incident or problem

Create a knowledge article, so the next time the issue comes up the resolution is easy to find.

Before you begin
Role required: knowledge

About this task
To create a knowledge article from an incident, see Create a knowledge article from an incident .

To create a knowledge article from problem, see Create a known error article .

Depending on the value of the glide.knowman.submission.workflow  property, 
knowledge created from an incident or problem may require additional approval. When this 
property is true, a submission record is created instead of a knowledge article. A user with the 
knowledge role must approve the submission to create a knowledge article.

Procedure

1. Open a resolved incident or problem.

2. Select the Knowledge  check box on the form.
You may need to configure the form to include the Languages  field. Click the form context 

menu icon ( ) and navigate to Configure  > Form layout. Use slushbucket to add the 
Languages field.

3. Close the incident or problem.
A new draft knowledge article is created.

4. If additional approval is required, navigate to Knowledge  > Articles  > Open Submissions.

5. Select a submission record.

6. Review the submission to ensure the content and settings are correct.

7. Click Create Article.
A new draft knowledge article is created. Articles created this way are added to the knowledge 
base specified in the property glide.knowman.task_kb.

Create an article version by importing a Word document

Import a Word document to a knowledge article to create a new version.

Before you begin

• Ensure that the Knowledge Management Advanced plugin (com.snc.knowledge_advanced) is 
installed.

• You can only upload new versions to articles that are in Draft  or Published  state.

• You cannot upload new versions to articles that are created using an article template or if the 
article type is Wiki.

Role required: admin

Procedure

1. Navigate to All  > Knowledge  > Articles.

2. Click an article.

3. Click the Upload New Version  related link.

Note: 
Any text written in TinyMCE is overwritten once the file is imported.
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4. Add the file you want to import.

5. Optional:  Select the Copy Attachments  check box to copy all attachments to the knowledge 
article.

Note: 
If the article is published, the attachments are added to a new article version. If the article 
is in draft, the attachments are added to the existing knowledge article. The draft article 
does not appear in the knowledge base (KB) for users until it is reviewed and published.

6. Click Import.
A draft version is created and sent to approvers to approve or reject. Once the article is 
approved, it is displayed in the Article Versions  related list.

Using human readable URLs for the Knowledge  article page

Human readable URLs include more readable keywords to the URL structure.

Human readable URLs are short and simple web addresses that use relevant keywords from the 
knowledge article page that are easier to understand. Users have a better idea of what they will 
find when they access the link.

The benefits of using human readable URLs rather than technical URLs include:

• Improves the readability of the URL to make it easier for a human to understand

• Improves search engine optimization (SEO) rankings and the click-through rate

Enable Human Readable URLs for the Knowledge  Article View page

Update a human readable URL structure in the Knowledge  Article View page to improve search 
ranking and click-through rates.

Before you begin
Role required: admin, sp_admin

About this task
If you are upgrading from a release earlier than the Washington DC  release, you must enable 
the Human Readable URLs feature for the Knowledge  Article View page. Beginning with the 
Washington DC  release, this feature is enabled by default.

Note: 
To disable the Human Readable URLs feature, change the 
glide.service_portal.enable_human_readable_urls  system property 
value to false.

Procedure

1. Navigate to All  > Service Portal  > Pages.

2. On the Pages form, search for the ID kb_article_view  and select it.

3. In the information message on the Page form indicating that you have to change the current 
application to edit the record, select the word here.

4. On the Knowledge Article View form, in the Human readable url structure  field enter the 
%short_descr  variable.
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Note: 
You can also create a variable to add information from various data sources. For more 
information, see Add human readable keywords to page URLs .

5. Select Update.

Result
The %short_descr  variable is added to the URL structure and will enable simpler, non-
technical words in the URL.

Example: Knowledge Article View page with human readable keywords in the 
URL

The following sample URL shows the keywords from the Knowledge  article KB0000007. The 
URL considers en  as the preferred language and displays the Knowledge  article content in the 
English language.

https://<instance>.com/kb/en/faq/what-is-a-cookie?id=kb_article_
view&sysparm_article=KB0000007

This article URL contains the field variables, and keywords in the following table.

Field variables in the URL structure

Field Variable Keywords

Category %category faq

Short description %short_descr What is a cookie?

Select a knowledge article category

Knowledge articles within a knowledge base are grouped by category. These groups can help 
you define the knowledge base taxonomy, and can help users find articles within that knowledge 
base.

Before you begin
Role required:

About this task
As a knowledge contributor, when editing a knowledge article you can select categories using 
the Category picker, and add or edit categories if enabled for the knowledge base.

Procedure

1. Click the reference lookup icon beside the Category  field.

2. Select an existing category, or click the add category icon (+) to add a new category.
After you select a category, you can click the pen icon to rename that category. Press the enter 
key or click outside the selected category to save the change.

Note: 
Clicking Cancel  while selecting a category cancels selecting a new category, but does 
not revert any changes you make to the categories such as renaming or adding new 
categories.

3. Fill in the fields on the form, as appropriate.
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4. Optional:  Select or add a subcategory.

5. Click OK.

Associate a knowledge article with a taxonomy category

Associate a knowledge article with a taxonomy topics to create a uniform classification structure 
across different kinds of content.

Before you begin
You must have contribute access to the knowledge base that contains the knowledge article.

Role required: knowledge

About this task
The taxonomy feature enables you to link an article to one or more topics from multiple 
taxonomies. It helps you maintain a unified content categorization across content types such 
as catalog items, knowledge articles, and community posts. For more information, see Unified 
taxonomy for Employee Center

Note: 
You can associate only articles in the Draft, Review, or Published state.

Procedure

1. Navigate to All  > Knowledge  > Articles.

2. On the article page, click the article you want to associate to a taxonomy topic.

3. In the Assigned Topics related list, click Add.

Note: 
As an admin, you may need to configure the form to include the Connected Content 

→ Knowledge in the related list. Click the form context menu icon  and navigate to 
Configure  > Related Lists. Using slushbucket, add the Connected Content → Knowledge.

4. Select a Taxonomy category from the list in the topic picker dialog box.
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5. Select a topic from a topic picker list and click OK.

Result
The selected article is associated with a taxonomy category for better content browsing.

Authoring a knowledge article in Agent Workspace

Complete your job efficiently by creating, editing, and publishing knowledge articles in Agent 
Workspace.

Knowledge Management  features specific to agents and authors are available in Workspace. 
Perform any knowledge administration-related tasks such as creating a knowledge base, 
managing access to knowledge articles, enabling an article template, and so on using the 
ServiceNow AI Platform  interface.

You can perform the following Knowledge-related tasks in Workspace:

• Create a knowledge article using a default or custom article template.

• Manage all unpublished and published knowledge articles authored by you.

• Address feedback tasks assigned to you.

• Compare two knowledge article versions.

• Request translations for published untranslated knowledge articles.

• Complete translation tasks assigned to you.

• Map related articles and related catalog items to a knowledge article.

• Add affected products to a knowledge article.

• Use Agent assist  to avoid creating knowledge articles with duplicate content.

The authoring experience for knowledge articles in Workspace  is similar to the one in 
ServiceNow AI Platform  with the following exceptions:
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• Knowledge blocks can't be created or associated with knowledge articles. However, you can 
view articles containing knowledge blocks.

• Knowledge articles of type Wiki aren't supported.​

• Knowledge article categories can't be created.

Activation Information

The Knowledge list in Workspace  is available with the activation of the Agent Workspace plugin 
(com.glide.core-ui-components). When you install and activate the Agent Workspace plugin, the 
sn-component-workspace-knowledge plugin for using Knowledge Management  in Workspace  is 
also installed and activated.

Related topics

View a knowledge article in Agent Workspace

Create a knowledge article in Agent Workspace

Edit a knowledge article in Agent Workspace

Schedule a knowledge article for publishing in Agent Workspace

Work on a feedback task in Agent Workspace

Compare knowledge article versions in Agent Workspace

Request translations for missing languages in Agent Workspace

View a knowledge article in Agent Workspace

View a knowledge article in Agent Workspace, including the article number, short description, 
and article content.

Before you begin
You must have read access to the knowledge article.
Role required: agent_workspace_user

Procedure

1. Navigate to All  > Agent Workspace  > Agent Workspace Home.

2. View knowledge articles authored by you or by other people.

◦ View all articles by navigating to Lists  > Knowledge  > All Articles.

◦ View articles authored by you by navigating to either Lists  > Knowledge  > My Articles - 
Published  or Lists  > Knowledge  > My Articles - Unpublished.

3. Click the link to the knowledge article that you want to view.

4. Optional:  View the knowledge article in another language by selecting a language in the 
Language list.

Note: 
The Language list is populated based on the available translated versions of the article.

5. Optional:  Copy the link to the knowledge article to your clipboard by clicking the more actions 

icon ( ) and then clicking Copy link.

6. Optional:  Download the article as a Microsoft  Word document to your computer by selecting 

the more actions icon ( ) and then selecting Download as Word.
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Note: 
This option appears only when the article was originally created 
using Microsoft  Word and the administrator has enabled the 
sn_km_word.glide.knowman.enable_document_download  property.

7. Optional:  View another version of the knowledge article by selecting the version of the 
knowledge article in the Version list.

Note: 
The Version list appears only when the article versioning feature is enabled.

Result
The selected version of the article opens in a knowledge article view page displayed in another 
tab within Agent Workspace. The tab name includes the knowledge article number and its 
version number.

Related topics

Viewing knowledge article details in Agent Workspace

Managing access to knowledge bases and knowledge articles

Provide feedback for a knowledge article in Agent Workspace

Edit a knowledge article in Agent Workspace

Viewing knowledge article details in Agent Workspace

View the details of a knowledge article in Agent Workspace.

The knowledge article view page in Agent Workspace  provides several details about a displayed 
article.
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Sample knowledge article view page in Agent Workspace

Article information displayed on the knowledge article view page in Agent Workspace

Details Description

Knowledge 
base

Knowledge base that stores the knowledge article and the article category. In the 
figure, IT is the knowledge base and Announcements is the knowledge article 
category.

Read time Average time to read the knowledge article, which can help you can decide 
whether you have time to read the article.

The read time is calculated based on an average reading speed of 200 words 
per minute. For articles in languages such as Chinese, Japanese, and Korean, 
the read time is calculated based on an average speed of 500 characters per 
minute. If images are present in an article, the read time is calculated using the 
following rules:
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Article information displayed on the knowledge article view page in Agent Workspace 
(continued)

Details Description

• For the first image add 12 seconds, for the second image add 11 seconds, and 
so on.

• If there are more than 10 images, after the tenth image add 3 seconds for each 
image.

Last 
updated 
time

Last time the knowledge article was updated in number of days for the current 
week, number of weeks, or number of years.

Number of 
views

Number of times the knowledge article was viewed in the past number of days 
set by your system administrator in the glide.knowman.view_age.days 
property. For more information on this property, see Knowledge portal properties.

Average 
rating

Result of the weighted average rating of the knowledge article based on numeric 
1 through 5 ratings. The average rating is carried on the next version of the 
article.

Knowledge 
article 
content

Text and images of the knowledge article.

Authored by Author of the knowledge article. This field appears only in the first version of a 
knowledge article.

Revised by User who revised the article. This field appears if a knowledge article was later 
edited.

Article 
number

Unique number automatically assigned to the knowledge article. In the figure, 
KB0010090 is the article number.

Version Selected version of the knowledge article. This field appears when the article 
versioning feature is enabled. In the figure, 1.01 is the selected version of the 
article.

Language Language of the selected article. This field appears if the translations of the 
knowledge article in other languages are available.

Attachments List of article attachments. This field appears if the knowledge administrator has 
enabled it to be displayed on the knowledge article view page.

Related topics

View a knowledge article in Agent Workspace

Create a knowledge article in Agent Workspace

Edit a knowledge article in Agent Workspace

Publish a knowledge article in Agent Workspace

Provide feedback for a knowledge article in Agent Workspace

Provide feedback on a knowledge article by rating the article, marking the article as helpful or not 
helpful, and posting and replying to comments for the article in Agent Workspace.

Before you begin
You must have read access to the knowledge article.
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Role required: agent_workspace_user

Procedure

1. Navigate to All  > Agent Workspace  > Agent Workspace Home.

2. Go to Lists  > Knowledge  > All articles.

3. Click the link to the knowledge article that you want to view.

4. Provide feedback for the article.

Related topics

View a knowledge article in Agent Workspace

Work on a feedback task in Agent Workspace

Create a knowledge article in Agent Workspace

Create a knowledge article in Agent Workspace  to share information across your organization.

Before you begin
You must have contribute access to the knowledge base within which you want to create the 
knowledge article.
Role required: agent_workspace_user

About this task
You can also create a knowledge article when adding a knowledge block. For more information, 
see Add a knowledge block to a knowledge article in Agent Workspace.

Procedure

1. Navigate to All  > Agent Workspace  > Agent Workspace Home.

2. Optional:  Check whether a knowledge article on this subject is already available by going to 
Lists  > Knowledge  > All Articles  and setting a filter to search for possible matching articles.

3. Click New.

4. Create the knowledge article by either selecting an article template or using the default 
template.

Option Description

Selected article template

Select an article template to create a knowl­
edge article using defined fields and values.

In the Create Article dialog box:

a. From the Knowledge Base list, select a 
knowledge base.

b. From the Article Template list, select the de­
sired article template.

Note: 
The Article Template list is populated 
based on the article templates config­
ured for the selected knowledge base.

c. Select Create Article.
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Option Description

The Create Article dialog box is available if 
the article versioning and the Knowledge Arti­
cle Templates features are enabled. For more 
information, see Article versioning  and Knowl­
edge article templates.

Default Standard template
Create a knowledge article using the default 
Standard template.

5. On the form, fill in the fields.

Note: 
If you’re using an article template, the available fields will vary.

Knowledge form

Field Description

Knowledge 
base

Knowledge base in which the knowledge article is stored. You can associate 
a knowledge article with one knowledge base only. If you’re using an article 
template, you can modify this value only if the template is available in the other 
knowledge base.

Category Category for the knowledge article. This value helps users find the article 
within a selected category. You can select only categories available within the 
selected knowledge base. Articles without a category appear in the (empty) 
category.

Ownership 
Group

Ownership group for the knowledge article. An ownership group consists of 
a group of members and a manager who are responsible for approvals and 
feedback tasks. Ownership groups can publish, edit, and retire knowledge 
articles that they’re associated with.

Note: 
This field is available only if the 
glide.knowman.ownership_group.enabled  property is 
enabled. If no ownership group is assigned and approvals are required 
to publish a knowledge article, it’s automatically submitted for approval 
to the knowledge administrator and knowledge manager. For more 
information, see Ownership groups.

Version Automatically generated article version number. This number is incremented 
when changes are made to a published article.

Note: 
This field is available if the article versioning feature has been enabled.

Workflow Publishing workflow state of the knowledge article, such as Draft, In Review, or 
Published. For a new article, the workflow state is set to Draft.

Language The language in which you’re creating the knowledge article. The list is 
populated based on the languages enabled for the selected knowledge 
base. This field appears only when the I18N:Knowledge Management 
Internationalization Plugin v2 plugin (com.glideapp.knowledge.i18n2) is 
activated. For more information, see I18N - Knowledge internationalization.
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Field Description

Short 
description

Title of the knowledge article. This title appears when browsing and searching 
for knowledge article, and at the top of the article.

You can enter up to 100 characters in this field.

Note: 
Knowledge articles similar to the short description text will appear in 
Agent assist.

Article body Content for the knowledge article.

Use the editing functions in the HTML editor to create content. For more 
information, see Editing functions for knowledge articles in the HTML editor.

Source Task Task this knowledge article was created from. This field is set automatically 
when you create the knowledge article from a task, such as an incident or a 
customer service case, or from a submission record.

Scheduled 
publish date

Future date when the knowledge article will be published automatically. For 
more information, see Schedule a knowledge article for publishing in Agent 
Workspace.

Valid to The date this knowledge article expires. Articles don’t appear in search results 
after the Valid to  date or if the Valid to  date is empty.

The default value of the Valid to  field is derived from the Article Validity  field 
configured for the knowledge base (see Create a knowledge base). The Valid 
to  date starts from the date that the article was created until the number of 
days specified in the Article Validity  field. If the Article Validity  field is empty, 
the default date in the Valid to  field for the knowledge article is set to January 
1, 2100.

An article author or editor can select whether to keep or change the default 
Valid to  date. For more information, see Validity of a knowledge article.

On the first day of each month, the application sends an email notification to 
a list of authorized recipients to remind them about articles that are expire in 
the next month. The recipient can then extend the Valid to  date to continue 
using the article. For more information, see Managing email notifications in 
Knowledge Management.

Note: 
If the system date format or user preferences is set to use yy  year format, 
you might face issues when the Valid to  date is set to the default date. 
Contact your administrator or modify the user preferences to use a date 
format with the yyyy  year format. For more information, see Global date 
and time field format  and Personalize the system date format  topics.

Confidence Maturity of an article based on its completeness and reusability.

Article type Type of the article, which is automatically set to HTML. This field is available in 
the Standard template only.

Note: 
The Wiki article type isn't supported in Agent Workspace.
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Field Description

Display 
attachments

Option to display attachments in the knowledge article. If the article has 
attachments, they’re listed below the text of a knowledge article on the 
knowledge article view page.

Attachment 
link

Option to automatically download an attached article when a user accesses 
it instead of opening the article. The Attachment link option applies to articles 
accessed from search links only.

Note: 
Although you may attach multiple files, most web browsers permit users 
to download only the first attachment. To ensure download of all the files, 
bundle them into an archive and attach the archive. Articles accessed as 
links within other knowledge articles will not replicate this behavior.

Governance An attribute of an article that enables you to control sensitive, critical, 
or regulated information. Not all articles have the same requirement for 
compliance reviews. Some articles are based on the collective experience of 
the people who use the articles (experience-based). Other articles have policy 
or legal information that require tight control (compliance-based).

Issue Brief description about an issue.

Note: 
This field is available in the KCS Article template only.

Environment Details of the environment in place when the issue occurred.

Note: 
This field is available in the KCS Article template only.

Cause The cause of the issue.

Note: 
This field is available in the KCS Article template only.

Resolution Method used to resolve the issue.

Note: 
This field is available in the KCS Article template only.

Question Text to display as a question.

Note: 
This field is available in the FAQ template only.

Answer Text to display as an answer to an included question.

Note: 
This field is available in the FAQ template only.

Introduction Introduction to the topic.
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Field Description

Note: 
This field is available in the How To and What Is templates only.

Instructions Instructions for a how-to topic.

Note: 
This field is available in the How To template only.

Explanation Explanation of a what-is topic.

Note: 
This field is available in the What Is template only.

Note: 
The Confidence  and Governance  fields appear when the Knowledge Management 
KCS Capabilities plugin (com.snc.knowledge_kcs_capabilities) is activated. For more 
information, see Managing the KCS article state.

6. Optional:  Research for content related to knowledge article you're authoring using Agent 
assist.

a. In the contextual side panel, select the agent assist icon ( ).
The search results in Agent assist  display default content based on the text-based search.

b. Click the select a search resource icon ( ), and then select a search resource.
For example, to view knowledge articles, select Knowledge Articles.

c. Optional:  In the search results, you can click a resource item, such as a knowledge article, 
to view its content in Agent assist.

Tip: 
For better readability, you can resize the contextual side panel for Agent assist. For a 
full view of the selected resource item content, select Full View. The resource item 
content opens in another tab within the Agent Workspace.

7. Optional:  Check whether your content matches the content in an existing article.

a. Enter your search text in the text box available in Agent assist  or retain the default text, which 
is the short description of the knowledge article.

b. Select the lookup icon ( ).

c. Select a search resource by clicking the Select a search resource icon ( ).
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▪ To find knowledge articles that have high text similarity with the entered search text, 
choose Similar Articles (ML).

Note: 
This option is available only when the Predictive Intelligence  feature is enabled and 
your administrator has trained the similarity solution for Knowledge Management. For 
more information, see Train the similarity solution for Knowledge Management to find 
related articles.

▪ To find knowledge articles that match the entered search text, choose Knowledge 
Articles.

8. Optional:  Attach a file with supporting information by clicking the attachments icon ( ) in the 
contextual side panel and selecting the file.

9. Optional:  Add a knowledge block.
For more information, see Add a knowledge block to a knowledge article in Agent Workspace.

10. Click Save.
The article is saved and appears in the My Articles - Unpublished list and additional 
functionality becomes available on the form.

11. Optional:  Either add to or modify the article details or publish the article.

◦ Add to or modify the article details.

(Optional) For more information, see Edit a knowledge article in Agent Workspace.

◦ Publish the article by clicking Publish.

A knowledge article is published depending on the workflow setting of its knowledge base:

▪ Knowledge - Instant Publish: The knowledge article is immediately published unless it is 
scheduled to be published at a later date.

▪ Knowledge - Approval Publish: The knowledge article is published on approval 
completion unless it is scheduled to be published at a later date.

Note: 
With an ownership group associated with a knowledge article, 
ownership group members can approve self-authored articles for 
publication. An administrator can override this behavior by disabling the 
glide.knowman.ownership_group.enable_self_approval  property. 
For more information, see Ownership groups.

For more information, see Schedule a knowledge article for publishing in Agent Workspace.

When published, your knowledge article appears in the My Articles - Published and 
All Articles lists. If the article versioning feature is enabled, the version number of the 
knowledge article is updated. For more information, see Knowledge article version numbers.

What to do next
After you create and publish a knowledge article, you can perform the following actions related to 
the article:

• Request translations for the knowledge article. For more information, see Request translations 
for missing languages in Agent Workspace.

• Retire the knowledge article. Click Retire  to enable the retirement workflow. For more 
information, see Retire a knowledge article.
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• Translate the knowledge article directly from the knowledge article. For more information, see 
Translate a knowledge article in Agent Workspace.

• Delete the published knowledge article. Click Delete. If the Delete  button isn't displayed, click 

the more actions icon ( ), and then click Delete.

Note: 
Only users with the admin role can delete a published knowledge article.

Related topics

View a knowledge article in Agent Workspace

Edit a knowledge article in Agent Workspace

Work on a feedback task in Agent Workspace

Provide feedback for a knowledge article in Agent Workspace

Managing access to knowledge bases and knowledge articles

Knowledge workflows

Knowledge article templates

Using Agent Assist in Agent Workspace

Create knowledge from incident or problem

Publish a knowledge article in Agent Workspace

Publish a knowledge article to make it available to users.

Before you begin
You must have contribute access to the knowledge base that stores the knowledge article you 
want to publish.
Role required: agent_workspace_user

Procedure

1. Navigate to All  > Agent Workspace  > Agent Workspace Home.

2. Go to Lists  > Knowledge  > My Articles - Unpublished.

3. Click a knowledge article link.

4. On the Knowledge form, click Publish.

Result
A knowledge article is published depending on the workflow setting of its knowledge base:

• Knowledge - Instant Publish: The knowledge article is immediately published unless it is 
scheduled to be published at a later date.

• Knowledge - Approval Publish: The knowledge article is published on approval completion 
unless it is scheduled to be published at a later date.

Note: 
With an ownership group associated with a knowledge article, 
ownership group members can approve self-authored articles for 
publication. An administrator can override this behavior by disabling the 
glide.knowman.ownership_group.enable_self_approval  property. For 
more information, see Ownership groups.
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For more information, see Schedule a knowledge article for publishing in Agent Workspace.

When published, your knowledge article appears in the My Articles - Published and All Articles 
lists. If the article versioning feature is enabled, the version of the article is incremented based 
on the version number pattern.

Related topics

Create a knowledge article in Agent Workspace

Edit a knowledge article in Agent Workspace

Knowledge workflows

Edit a knowledge article in Agent Workspace

Edit knowledge articles within a knowledge base in Agent Workspace  to update information 
shared across your organization.

Before you begin
You must have contribute access to the knowledge base that stores the knowledge article you 
want to edit.

Note: 

• If the article versioning feature is enabled, only the knowledge administrator, knowledge 
managers, and author can edit the checked-out version of an article. If the feature is 
disabled, any users with contribute access to an article can edit the draft version of 
the article. An administrator can disable the article versioning feature by setting the 
glide.knowman.versioning.enabled  property (from the System Property 
[sys_properties] table) to false.

• If an ownership group is associated with a knowledge article, the author 
or reviser of the article can't contribute to the article after the article is 
published. An administrator can override this behavior by enabling the 
glide.knowman.ownership_group.override  property. For more information, 
see Ownership groups.

• If the glide.knowman.translation.enable_translation_task  property is 
enabled, you can’t modify the knowledge base of existing articles.

Role required: agent_workspace_user

Procedure

1. Navigate to All  > Agent Workspace  > Agent Workspace Home.

2. Go to Lists  > Knowledge  > All Articles.

3. Click a knowledge article link.

4. On the Knowledge form, click Edit.

Note: 
If the knowledge article was created using Microsoft  Word, you can edit the article only in 
Microsoft  Word. In this case, select Open in Word  to open the article in Word Online. For 
more information, see Edit a knowledge article in Microsoft Word.

If you want to edit the article using the HTML editor, you can unlink the article from 
Word. For more information, see Unlink knowledge articles from linked Microsoft Word 
documents.

5. If the article versioning feature is enabled, click Checkout  for a published knowledge article.
You can only edit the latest version of a knowledge article.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3444



6. Access the relevant related lists to modify the information.

Knowledge form related lists

Related list Description

Details Knowledge article content and its metadata.

Note: 
If the article versioning feature is enabled, the default value of the Valid 
to  date in the updated article version is automatically set based on the 
following criteria:

◦ If the Article Validity  field in the knowledge base associated with the 
article is empty, the Valid to  date value from the earlier version of the 
article is retained.

◦ If the Article Validity  field in the knowledge base associated with the 
article isn’t empty, the Valid to  date is automatically updated to start from 
the date the article was updated until the number of days specified in the 
Article Validity  field (Article updated date + article validity).

If you move a knowledge article to another knowledge base, the default 
value of the Valid to  date in the updated article is automatically set based 
on the following criteria:

◦ If the Article Validity  field in the selected knowledge base is empty, the 
earlier Valid to  date value is retained for the knowledge article.

◦ If the Article Validity  field in the selected knowledge base isn't empty, 
the Valid to  date is automatically updated to start from the date the 
article was updated until the number of days specified in the Article 
Validity  field (Article updated date + article validity).

If the dictionary value of the Valid to  field is modified, this dictionary value 
overrides the default value of the Valid to  field calculated according to the 
Article Validity  field. For more information, see Validity of a knowledge 
article.

Feedback Feedback received on the published versions of the article. To view more details 
about the feedback, in the Comments  column, select a link for the desired 
version of an article.

Feedback 
Tasks

Details about the feedback task created for a knowledge article version.

Approvals Approval history of the knowledge article.

Article 
Versions

Version history of the knowledge article.

Translated 
Versions

Translated versions of the knowledge article.

This related list appears only when the translation management 
feature is enabled. To translate a knowledge article, select 
New. The New  button on this related list appears when the 
glide.knowman.translation.enable_translation_task 
property is inactive.

Translation 
Tasks

Tasks submitted for translating the article.
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Related list Description

This related list appears when the Translation Management feature and the 
glide.knowman.translation.enable_translation_task 
property to enable creation of translation tasks are enabled. For more 
information, see Knowledge Management properties.

Related 
Articles

Related articles mapped to the knowledge article. For more information, see 
Map a related article in Agent Workspace.

Related 
Catalog 
Items

Related catalog items mapped to the knowledge article. For more information, 
see Map a related item in Agent Workspace.

Affected 
Products

Products mapped to the knowledge article. For more information, see Add an 
affected product to a knowledge article in Agent Workspace.

7. Optional:  Research for content related to knowledge article you're authoring using Agent 
assist.

a. In the contextual side panel, select the agent assist icon ( ).
The search results in Agent assist  display default content based on the text-based search.

b. Click the select a search resource icon ( ), and then select a search resource.
For example, to view knowledge articles, select Knowledge Articles.

c. Optional:  In the search results, you can click a resource item, such as a knowledge article, 
to view its content in Agent assist.

Tip: 
For better readability, you can resize the contextual side panel for Agent assist. For a 
full view of the selected resource item content, select Full View. The resource item 
content opens in another tab within the Agent Workspace.

8. Optional:  Check whether your content matches the content in an existing article.

a. Enter your search text in the text box available in Agent assist  or retain the default text, which 
is the short description of the knowledge article.

b. Select the lookup icon ( ).

c. Select a search resource by clicking the Select a search resource icon ( ).

▪ To find knowledge articles that have high text similarity with the entered search text, 
choose Similar Articles (ML).

Note: 
This option is available only when the Predictive Intelligence  feature is enabled and 
your administrator has trained the similarity solution for Knowledge Management. For 
more information, see Train the similarity solution for Knowledge Management to find 
related articles.

▪ To find knowledge articles that match the entered search text, choose Knowledge 
Articles.
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9. Optional:  Work with attachments.

◦ Attach a file with supporting information by clicking the attachments icon ( ) in the 
contextual side panel and selecting the file.

◦ Download, remove, or rename an existing attachment by clicking the menu icon ( ) displayed 
for the attachment.

10. Click Save.
The article is saved and appears in the My Articles - Unpublished list. If the article versioning 
feature is enabled, the version of the knowledge article is incremented by 0.01. For more 
information, see Knowledge article version numbers.

11. Optional:  Publish the article by clicking Publish.
The knowledge article is published depending on the workflow setting of its knowledge base:

◦ Knowledge - Instant Publish: The knowledge article is immediately published unless it is 
scheduled to be published at a later date.

◦ Knowledge - Approval Publish: The knowledge article is published on approval completion 
unless it is scheduled to be published at a later date.

Note: 
With an ownership group associated with a knowledge article, 
ownership group members can approve self-authored articles for 
publication. An administrator can override this behavior by disabling the 
glide.knowman.ownership_group.enable_self_approval  property. For 
more information, see Ownership groups.

For more information, see Schedule a knowledge article for publishing in Agent Workspace.

When published, the knowledge article appears in the My Articles - Published and All Articles 
lists. If the article versioning feature is enabled, the version number of the knowledge article 
increments to the next whole number (for example, from 2.02 to 3.0). For more information, see 
Knowledge article version numbers.

Related topics

Create a knowledge article in Agent Workspace

View a knowledge article in Agent Workspace

Using Agent Assist in Agent Workspace

Create knowledge from incident or problem

Map a related article in Agent Workspace

Discover similar information across articles on a topic while viewing a knowledge article. You can 
manually map related articles or have the application automatically present related articles using 
machine learning (ML) algorithms.

Before you begin
You must have contribute access to the knowledge base that stores the knowledge article for 
which you want to add related articles.
Role required: agent_workspace_user

About this task
If you have manually mapped related articles when editing an article in Agent Workspace, those 
articles are listed in the Related Articles section on the knowledge article view page in the 
Knowledge Management  Service Portal  before the related articles that are predicted thorough 
the Knowledge Management  similarity solution.
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Note: 
An administrator can train the solution definition for Knowledge Management  within the 
Predictive Intelligence  feature to find related articles. For more information, see Train the 
similarity solution for Knowledge Management to find related articles.

This task provides steps to manually map related articles when editing an article in Agent 
Workspace. You can also manually map related articles when editing an article from the 
Knowledge Management  application in the ServiceNow AI Platform  interface. For more 
information, see Map related articles.

Procedure

1. Navigate to All  > Agent Workspace  > Agent Workspace Home.

2. Go to Lists  > Knowledge  > All Articles.

3. Click the link to the knowledge article for which you want to map related articles.

4. In the Related Articles related list, click New.

5. On the Related Articles form, fill in the fields.

Related Articles form

Field Description

Active Option to enable the mapping to the related knowledge article.

Related 
knowledge 
article

Knowledge article that contains related information.

You can click the search for record icon ( ), to access the list of available 
knowledge articles.

Knowledge 
article

Number of the knowledge article for which you are adding the related 
knowledge article.

Order Order in which you want the article to appear in the Related Articles section 
on the Knowledge Management  article view page.

A lower value means that a knowledge article has the greater priority to 
appear in the Related Articles section. The default value is 100.

6. Click Save.

Result
The mapped articles are available in the Related Articles section on the Knowledge Management 
article view page in the Knowledge Management  Service Portal. See Knowledge Management 
Service Portal article view page features.

Note: 
Because system administrators can configure the number of knowledge articles shown in 
the Related Articles section, not all mapped related articles might appear in the Related 
Articles section. For more information, see Configure knowledge related articles widget 
instance options.

Related topics

Edit a knowledge article in Agent Workspace
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Map a related item in Agent Workspace

Manually map catalog items related to a knowledge article in Agent Workspace  to enable 
employees to request the related catalog item.

Before you begin
You must have contribute access to the knowledge base that stores the knowledge article for 
which you want to add related articles.
Role required: agent_workspace_user

About this task
This task provides steps to map related catalog items when editing an article in Agent 
Workspace. You can also map related catalog items when editing an article from the Knowledge 
Management  application in the ServiceNow AI Platform  interface. For more information, see Map 
catalog items related to an article.

Procedure

1. Navigate to All  > Agent Workspace  > Agent Workspace Home.

2. Go to Lists  > Knowledge  > Published  for a published article or Lists  > Knowledge  > 
Unpublished  for an unpublished article.

3. Click the link to the knowledge article for which you want to map a related item.

4. On the Knowledge form, click the Related Catalog Items related list.

5. Click New.

6. On the Related Catalog Items form, fill in the fields.

Related Items form

Field Description

Active Option to enable the mapping to the related catalog item.

Catalog 
item

Catalog item related to the knowledge article.

You can click the search for record icon ( ) to access a list of available catalog 
items.

Knowledge 
article

Number of the knowledge article for which you are adding the related catalog 
item.

Order Order in which you want the catalog item to appear in the Related Items section 
on the Knowledge Management  article view page.

A lower value means that a catalog item has the greater priority to appear in the 
Related Items section. The default value is 100.

7. Click Save.

Result
The mapped catalog items are listed in the Related Items section on the Knowledge 
Management  article view page in Knowledge Management  Service Portal.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3449



Note: 
Because system administrators can configure the number of catalog items shown in the 
Related Items section, not all mapped related catalog items might appear in the Related 
Items section. For more information, see Configure related catalog item widget instance 
options.

Related topics

Edit a knowledge article in Agent Workspace

Service Catalog items

Add an affected product to a knowledge article in Agent Workspace

Add affected products to a knowledge article to view the products associated with the 
knowledge article

Before you begin
The Knowledge Product Entitlements plugin (com.snc.kb_product_entitlements) must be 
activated to use the Knowledge Product Entitlements application. Installing this plugin adds 
the Affected Products related list to the Knowledge form. For more information, see Knowledge 
product entitlements .

You must have contribute access to the knowledge base that stores the knowledge article for 
which you want to add affected products.

Role required: agent_workspace_user

About this task
This task provides steps to add affected products to a knowledge article in Agent Workspace. 
You can also add affected products to a knowledge article using the Knowledge Management 
application in the ServiceNow AI Platform  interface. For more information, see Add a related 
product to a knowledge base or knowledge article .

Procedure

1. Navigate to All  > Agent Workspace  > Agent Workspace Home.

2. Go to Lists  > Knowledge  > All Articles.

3. Click the link to the knowledge article for which you want to add a related product.

4. On the Knowledge form, in the Affected Products related list, click New.

5. On the Knowledge Related to Products form, in the Configuration item  field, click the search 
for record icon ( ).

6. In the Configuration item dialog box, click the related product.

7. Click Save.

Related topics

Edit a knowledge article in Agent Workspace

Schedule a knowledge article for publishing in Agent Workspace

Set a specific time and day for a knowledge article to be published in Agent Workspace 
automatically.

Before you begin
You must have contribute access to the knowledge base that stores the knowledge article you 
want to schedule for publishing.
Ensure that the system administrator verifies the following settings:
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• Knowledge Management Advanced plugin (com.snc.knowledge_advanced) is activated. For 
more information, see Activate the Knowledge Management Advanced plugin.

• The article versioning feature is enabled. For more information, see Article versioning.

Note: 
You can also schedule a knowledge article for publishing from the Knowledge Management 
application in the ServiceNow AI Platform  interface. For more information, see Schedule a 
knowledge article for publishing.

Role required: agent_workspace_user

Procedure

1. Navigate to All  > Agent Workspace  > Agent Workspace Home.

2. Go to Lists  > Knowledge  > My Articles - Unpublished Articles.

3. Click an article link.

4. In the Scheduled publish date  field, click the show calendar icon ( ).

5. Select any future date in the calendar.

6. In the Select Time  field, enter a time in the format hh:mm:ss.

7. Click OK.

8. Click Publish  to enable the publishing workflow.

Tip: 
If you want to cancel an article's scheduled publication and move the article back to the 
Draft state, click Recall.

Result
The knowledge article is published on the scheduled publish date depending on the following 
workflow settings of its knowledge base:

• If the knowledge base workflow is set to Knowledge - Instant Publish, the knowledge article is 
automatically published on the scheduled publish date. The Workflow  field on the Knowledge 
form of the article is updated to Scheduled for publish.

• If the knowledge base workflow is set to Knowledge - Approval Publish, the knowledge article 
is published on approval completion. The Workflow  field on the Knowledge form of the article 
is updated to Review.

The approval completion affects the scheduled publishing as follows:

◦ If the approvals are completed before the scheduled publish date, the Workflow  field on 
the Knowledge form of the article is updated to Scheduled for publish  and the article is 
published on the scheduled publish date.

◦ If the approvals are completed after the scheduled publish date, the article is published 
immediately on the approval completion.

Related topics

Edit a knowledge article in Agent Workspace

Knowledge workflows

Work on a feedback task in Agent Workspace

Start working on a feedback task, request clarifications, and resolve or close the feedback task in 
Agent Workspace. You can view all feedback tasks assigned to you or your ownership group.
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Before you begin
You must have contribute access to the knowledge base that stores the knowledge article you 
want to work on.
Role required: agent_workspace_user

About this task
A feedback task is created based on the following types of feedback sources.

Source Description

User 
feedback

Knowledge article was marked as not helpful or given low ratings.

Internal 
feedback

Knowledge article was flagged.

Knowledge 
gap

Knowledge gap feedback task was created for one or more tasks using the 
Knowledge Demand Insights feature.

Knowledge 
gap - manual

Knowledge gap feedback task was created manually from a task, such as a 
customer service case or an incident.

Unsuccessful 
search

Knowledge gap feedback task was created from the Unsuccessful Searches 
report in the Self-Service Analytics for Customer Service dashboard.

Other Feedback for a knowledge article from other sources.

Note: 
When you upgrade your instance, for any existing records that don't have 
any feedback task type set or don't match with supported types, the 
feedback task type is automatically set to Other.

Procedure

1. Navigate to All  > Agent Workspace  > Agent Workspace Home.

2. Click Lists  > Knowledge  > My Tasks - Feedback.

3. Click the link to a feedback task number.

4. On the Knowledge Feedback Task form, review the feedback given by the submitter.

5. Work on the feedback task.

6. Optional:  In the Compose section, enter comments, which all viewers can see, or work notes, 
which only internal users can see.

7. Optional:  Track the time spent on each state for a feedback task by clicking the Knowledge 
Feedback Task Metrics  tab and then clicking a link to the state in the Value  column.

8. Click Save.

Result
The feedback task is updated.

Related topics

View a knowledge article in Agent Workspace
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Create a knowledge article from a feedback task in Agent Workspace

When working on a knowledge article feedback task, if the current knowledge article doesn't 
address the issue, you can create another knowledge article from within the task. A feedback 
task is created for a knowledge article when the article is flagged, marked as not helpful, or rated 
low, or a knowledge gap feedback task is created on a topic.

Before you begin
You must have contribute access to the knowledge base that stores the knowledge article.
Role required: agent_workspace_user

About this task
A feedback task is created in the following ways:

• When a user provides a feedback for the knowledge article. For more information, see Provide 
feedback for a knowledge article in Agent Workspace.

• When knowledge gap feedback tasks are created on a topic from a demand insights 
dashboard. For more information, see Analyze knowledge gaps from a demand insights 
dashboard and create knowledge gap feedback tasks.

Procedure

1. Navigate to All  > Agent Workspace  > Agent Workspace Home.

2. Go to your tasks list.

◦ For feedback tasks created through knowledge gaps or if a knowledge article was marked as 
not helpful or rated low, go to Knowledge  > My Tasks - Feedback.

◦ For tasks created when an article was flagged, go to Knowledge  > My Tasks - Flagged.

3. In the Number  column, click the link to a feedback task assigned to you or your ownership 
group.

4. Click Create Article.

5. Create the knowledge article by either selecting an article template or using the default 
template.

Option Description

Selected article template

Select an article template to create a knowl­
edge article using defined fields and values.

In the Create Article dialog box:

a. From the Knowledge Base list, select a 
knowledge base.

b. From the Article Template list, select the de­
sired article template.

Note: 
The Article Template list is populated 
based on the article templates config­
ured for the selected knowledge base.

c. Select Create Article.

The Create Article dialog box is available if 
the article versioning and the Knowledge Arti­
cle Templates features are enabled. For more 

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3453



Option Description

information, see Article versioning  and Knowl­
edge article templates.

Default Standard template
Create a knowledge article using the default 
Standard template.

6. On the form, fill in the fields.

Note: 
If you’re using an article template, the available fields will vary.

Knowledge form

Field Description

Knowledge 
base

Knowledge base in which the knowledge article is stored. You can associate 
a knowledge article with one knowledge base only. If you’re using an article 
template, you can modify this value only if the template is available in the other 
knowledge base.

Category Category for the knowledge article. This value helps users find the article 
within a selected category. You can select only categories available within the 
selected knowledge base. Articles without a category appear in the (empty) 
category.

Ownership 
Group

Ownership group for the knowledge article. An ownership group consists of 
a group of members and a manager who are responsible for approvals and 
feedback tasks. Ownership groups can publish, edit, and retire knowledge 
articles that they’re associated with.

Note: 
This field is available only if the 
glide.knowman.ownership_group.enabled  property is 
enabled. If no ownership group is assigned and approvals are required 
to publish a knowledge article, it’s automatically submitted for approval 
to the knowledge administrator and knowledge manager. For more 
information, see Ownership groups.

Version Automatically generated article version number. This number is incremented 
when changes are made to a published article.

Note: 
This field is available if the article versioning feature has been enabled.

Workflow Publishing workflow state of the knowledge article, such as Draft, In Review, or 
Published. For a new article, the workflow state is set to Draft.

Language The language in which you’re creating the knowledge article. The list is 
populated based on the languages enabled for the selected knowledge 
base. This field appears only when the I18N:Knowledge Management 
Internationalization Plugin v2 plugin (com.glideapp.knowledge.i18n2) is 
activated. For more information, see I18N - Knowledge internationalization.

Short 
description

Title of the knowledge article. This title appears when browsing and searching 
for knowledge article, and at the top of the article.
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Field Description

You can enter up to 100 characters in this field.

Note: 
Knowledge articles similar to the short description text will appear in 
Agent assist.

Article body Content for the knowledge article.

Use the editing functions in the HTML editor to create content. For more 
information, see Editing functions for knowledge articles in the HTML editor.

Source Task Task this knowledge article was created from. This field is set automatically 
when you create the knowledge article from a task, such as an incident or a 
customer service case, or from a submission record.

Scheduled 
publish date

Future date when the knowledge article will be published automatically. For 
more information, see Schedule a knowledge article for publishing in Agent 
Workspace.

Valid to The date this knowledge article expires. Articles don’t appear in search results 
after the Valid to  date or if the Valid to  date is empty.

The default value of the Valid to  field is derived from the Article Validity  field 
configured for the knowledge base (see Create a knowledge base). The Valid 
to  date starts from the date that the article was created until the number of 
days specified in the Article Validity  field. If the Article Validity  field is empty, 
the default date in the Valid to  field for the knowledge article is set to January 
1, 2100.

An article author or editor can select whether to keep or change the default 
Valid to  date. For more information, see Validity of a knowledge article.

On the first day of each month, the application sends an email notification to 
a list of authorized recipients to remind them about articles that are expire in 
the next month. The recipient can then extend the Valid to  date to continue 
using the article. For more information, see Managing email notifications in 
Knowledge Management.

Note: 
If the system date format or user preferences is set to use yy  year format, 
you might face issues when the Valid to  date is set to the default date. 
Contact your administrator or modify the user preferences to use a date 
format with the yyyy  year format. For more information, see Global date 
and time field format  and Personalize the system date format  topics.

Confidence Maturity of an article based on its completeness and reusability.

Article type Type of the article, which is automatically set to HTML. This field is available in 
the Standard template only.

Note: 
The Wiki article type isn't supported in Agent Workspace.
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Field Description

Display 
attachments

Option to display attachments in the knowledge article. If the article has 
attachments, they’re listed below the text of a knowledge article on the 
knowledge article view page.

Attachment 
link

Option to automatically download an attached article when a user accesses 
it instead of opening the article. The Attachment link option applies to articles 
accessed from search links only.

Note: 
Although you may attach multiple files, most web browsers permit users 
to download only the first attachment. To ensure download of all the files, 
bundle them into an archive and attach the archive. Articles accessed as 
links within other knowledge articles will not replicate this behavior.

Governance An attribute of an article that enables you to control sensitive, critical, 
or regulated information. Not all articles have the same requirement for 
compliance reviews. Some articles are based on the collective experience of 
the people who use the articles (experience-based). Other articles have policy 
or legal information that require tight control (compliance-based).

Issue Brief description about an issue.

Note: 
This field is available in the KCS Article template only.

Environment Details of the environment in place when the issue occurred.

Note: 
This field is available in the KCS Article template only.

Cause The cause of the issue.

Note: 
This field is available in the KCS Article template only.

Resolution Method used to resolve the issue.

Note: 
This field is available in the KCS Article template only.

Question Text to display as a question.

Note: 
This field is available in the FAQ template only.

Answer Text to display as an answer to an included question.

Note: 
This field is available in the FAQ template only.

Introduction Introduction to the topic.
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Field Description

Note: 
This field is available in the How To and What Is templates only.

Instructions Instructions for a how-to topic.

Note: 
This field is available in the How To template only.

Explanation Explanation of a what-is topic.

Note: 
This field is available in the What Is template only.

Note: 
The Confidence  and Governance  fields appear when the Knowledge Management 
KCS Capabilities plugin (com.snc.knowledge_kcs_capabilities) is activated. For more 
information, see Managing the KCS article state.

7. Optional:  Research for content related to knowledge article you're authoring using Agent 
assist.

a. In the contextual side panel, select the agent assist icon ( ).
The search results in Agent assist  display default content based on the text-based search.

b. Click the select a search resource icon ( ), and then select a search resource.
For example, to view knowledge articles, select Knowledge Articles.

c. Optional:  In the search results, you can click a resource item, such as a knowledge article, 
to view its content in Agent assist.

Tip: 
For better readability, you can resize the contextual side panel for Agent assist. For a 
full view of the selected resource item content, select Full View. The resource item 
content opens in another tab within the Agent Workspace.

8. Optional:  Check whether your content matches the content in an existing article.

a. Enter your search text in the text box available in Agent assist  or retain the default text, which 
is the short description of the knowledge article.

b. Select the lookup icon ( ).

c. Select a search resource by clicking the Select a search resource icon ( ).
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▪ To find knowledge articles that have high text similarity with the entered search text, 
choose Similar Articles (ML).

Note: 
This option is available only when the Predictive Intelligence  feature is enabled and 
your administrator has trained the similarity solution for Knowledge Management. For 
more information, see Train the similarity solution for Knowledge Management to find 
related articles.

▪ To find knowledge articles that match the entered search text, choose Knowledge 
Articles.

9. Click Save.
The article is saved and appears in the My Articles - Unpublished list and additional 
functionality becomes available on the form.

10. Optional:  Either add to or modify the article details or publish the article.

◦ Add to or modify the article details.

(Optional) For more information, see Edit a knowledge article in Agent Workspace.

◦ Publish the article by clicking Publish.

A knowledge article is published depending on the workflow setting of its knowledge base:

▪ Knowledge - Instant Publish: The knowledge article is immediately published unless it is 
scheduled to be published at a later date.

▪ Knowledge - Approval Publish: The knowledge article is published on approval 
completion unless it is scheduled to be published at a later date.

Note: 
With an ownership group associated with a knowledge article, 
ownership group members can approve self-authored articles for 
publication. An administrator can override this behavior by disabling the 
glide.knowman.ownership_group.enable_self_approval  property. 
For more information, see Ownership groups.

For more information, see Schedule a knowledge article for publishing in Agent Workspace.

When published, your knowledge article appears in the My Articles - Published and 
All Articles lists. If the article versioning feature is enabled, the version number of the 
knowledge article is updated. For more information, see Knowledge article version numbers.

What to do next
After you create and publish a knowledge article, you can perform the following actions related to 
the article:

• Request translations for the knowledge article. For more information, see Request translations 
for missing languages in Agent Workspace.

• Retire the knowledge article. Click Retire  to enable the retirement workflow. For more 
information, see Retire a knowledge article.

• Translate the knowledge article directly from the knowledge article. For more information, see 
Translate a knowledge article in Agent Workspace.
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• Delete the published knowledge article. Click Delete. If the Delete  button isn't displayed, click 

the more actions icon ( ), and then click Delete.

Note: 
Only users with the admin role can delete a published knowledge article.

Related topics

View a knowledge article in Agent Workspace

Finding solutions using Agent assist

Edit a knowledge article from a feedback task in Agent Workspace

When working on a knowledge article task, you can edit the knowledge article from within the 
task. A feedback task is created for a knowledge article when the article is flagged, marked as not 
helpful, or rated low, or a knowledge gap feedback task is created on a topic.

Before you begin
Role required: You must have contribute access to the knowledge base that stores the 
knowledge article.

Note: 
If the article versioning feature is enabled, only the knowledge administrator, knowledge 
managers, and author can edit the checked-out version of an article. If the feature is 
disabled, any users with contribute access to an article can edit the draft version of 
the article. An administrator can disable the article versioning feature by setting the 
glide.knowman.versioning.enabled  property (from the System Property 
[sys_properties] table) to false.

Role required: agent_workspace_user

Procedure

1. Navigate to All  > Agent Workspace  > Agent Workspace Home.

2. Go to your tasks list.

◦ For feedback tasks created through knowledge gaps or if a knowledge article was marked as 
not helpful or rated low, go to Knowledge  > My Tasks - Feedback.

◦ For tasks created when an article was flagged, go to Knowledge  > My Tasks - Flagged.

3. In the Number  column, click the link to a feedback task assigned to you or your ownership 
group.

4. Click Edit Article.

5. If the article versioning feature is enabled, click Checkout  for a published knowledge article.
You can only edit the latest version of a knowledge article.

6. Access the relevant related lists to modify the information.

Knowledge form related lists

Related list Description

Details Knowledge article content and its metadata.
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Related list Description

Note: 
If the article versioning feature is enabled, the default value of the Valid 
to  date in the updated article version is automatically set based on the 
following criteria:

◦ If the Article Validity  field in the knowledge base associated with the 
article is empty, the Valid to  date value from the earlier version of the 
article is retained.

◦ If the Article Validity  field in the knowledge base associated with the 
article isn’t empty, the Valid to  date is automatically updated to start from 
the date the article was updated until the number of days specified in the 
Article Validity  field (Article updated date + article validity).

If you move a knowledge article to another knowledge base, the default 
value of the Valid to  date in the updated article is automatically set based 
on the following criteria:

◦ If the Article Validity  field in the selected knowledge base is empty, the 
earlier Valid to  date value is retained for the knowledge article.

◦ If the Article Validity  field in the selected knowledge base isn't empty, 
the Valid to  date is automatically updated to start from the date the 
article was updated until the number of days specified in the Article 
Validity  field (Article updated date + article validity).

If the dictionary value of the Valid to  field is modified, this dictionary value 
overrides the default value of the Valid to  field calculated according to the 
Article Validity  field. For more information, see Validity of a knowledge 
article.

Feedback Feedback received on the published versions of the article. To view more details 
about the feedback, in the Comments  column, select a link for the desired 
version of an article.

Feedback 
Tasks

Details about the feedback task created for a knowledge article version.

Approvals Approval history of the knowledge article.

Article 
Versions

Version history of the knowledge article.

Translated 
Versions

Translated versions of the knowledge article.

This related list appears only when the translation management 
feature is enabled. To translate a knowledge article, select 
New. The New  button on this related list appears when the 
glide.knowman.translation.enable_translation_task 
property is inactive.

Translation 
Tasks

Tasks submitted for translating the article.

This related list appears when the Translation Management feature and the 
glide.knowman.translation.enable_translation_task 
property to enable creation of translation tasks are enabled. For more 
information, see Knowledge Management properties.
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Related list Description

Related 
Articles

Related articles mapped to the knowledge article. For more information, see 
Map a related article in Agent Workspace.

Related 
Catalog 
Items

Related catalog items mapped to the knowledge article. For more information, 
see Map a related item in Agent Workspace.

Affected 
Products

Products mapped to the knowledge article. For more information, see Add an 
affected product to a knowledge article in Agent Workspace.

7. Optional:  Research for content related to knowledge article you're authoring using Agent 
assist.

a. In the contextual side panel, select the agent assist icon ( ).
The search results in Agent assist  display default content based on the text-based search.

b. Click the select a search resource icon ( ), and then select a search resource.
For example, to view knowledge articles, select Knowledge Articles.

c. Optional:  In the search results, you can click a resource item, such as a knowledge article, 
to view its content in Agent assist.

Tip: 
For better readability, you can resize the contextual side panel for Agent assist. For a 
full view of the selected resource item content, select Full View. The resource item 
content opens in another tab within the Agent Workspace.

8. Optional:  Check whether your content matches the content in an existing article.

a. Enter your search text in the text box available in Agent assist  or retain the default text, which 
is the short description of the knowledge article.

b. Select the lookup icon ( ).

c. Select a search resource by clicking the Select a search resource icon ( ).

▪ To find knowledge articles that have high text similarity with the entered search text, 
choose Similar Articles (ML).

Note: 
This option is available only when the Predictive Intelligence  feature is enabled and 
your administrator has trained the similarity solution for Knowledge Management. For 
more information, see Train the similarity solution for Knowledge Management to find 
related articles.

▪ To find knowledge articles that match the entered search text, choose Knowledge 
Articles.

9. Click Save.
The article is saved and appears in the My Articles - Unpublished list. If the article versioning 
feature is enabled, the version of the knowledge article is incremented by 0.01. For more 
information, see Knowledge article version numbers.
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10. Optional:  Publish the article by clicking Publish.
The knowledge article is published depending on the workflow setting of its knowledge base:

◦ Knowledge - Instant Publish: The knowledge article is immediately published unless it is 
scheduled to be published at a later date.

◦ Knowledge - Approval Publish: The knowledge article is published on approval completion 
unless it is scheduled to be published at a later date.

Note: 
With an ownership group associated with a knowledge article, 
ownership group members can approve self-authored articles for 
publication. An administrator can override this behavior by disabling the 
glide.knowman.ownership_group.enable_self_approval  property. For 
more information, see Ownership groups.

For more information, see Schedule a knowledge article for publishing in Agent Workspace.

When published, the knowledge article appears in the My Articles - Published and All Articles 
lists. If the article versioning feature is enabled, the version number of the knowledge article 
increments to the next whole number (for example, from 2.02 to 3.0). For more information, see 
Knowledge article version numbers.

Related topics

Work on a feedback task in Agent Workspace

Create a knowledge article from a feedback task in Agent Workspace

View a knowledge article in Agent Workspace

Provide feedback for a knowledge article in Agent Workspace

Using Agent Assist in Agent Workspace

Compare knowledge article versions in Agent Workspace

Select and compare two versions of a knowledge article in Agent Workspace  to view the 
differences between them.

Before you begin
You must have contribute access to the knowledge base that stores the knowledge article.
Role required: agent_workspace_user

Note: 
For comparison of the knowledge article versions in the Next Experience UI, see Compare 
two versions of an article.

Procedure

1. Navigate to All  > Agent Workspace  > Agent Workspace Home.

2. Click Lists  > Knowledge  > All Articles.

3. Click the link to a knowledge article for which you want to compare two versions.

4. Click Edit  to open the Knowledge article form.

5. In the Article Versions related list, select the two versions of the article to compare.

6. Click Compare.
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Result
The Compare versions  tab opens within Agent Workspace  and lists the fields for the selected 
versions in a side-by-side format. Any differences between the two versions are highlighted as 
shown in the following example image.

Example: Compare article versions

Related topics

Article versioning

Recall an article that is being reviewed in Agent Workspace

Recall an article that is being reviewed to stop the approval process.

Before you begin
You must have contribute access to the knowledge base that stores the knowledge article you 
want to recall.
Ensure that the article versioning feature is enabled. For more information, see Article versioning.

Role required: agent_workspace_user

About this task
The author of a knowledge article, knowledge administrators, and system administrators can 
recall the article. If an ownership group is assigned to a knowledge article, the ownership group 
manager and ownership group members can also recall the knowledge article.

If a version of a knowledge article is in the Review  workflow state, you can recall only the 
corresponding version to make additional changes. Recalling the article results in a minor 
version increment.

Procedure

1. Navigate to All  > Agent Workspace  > Agent Workspace Home.

2. Go to Lists  > Knowledge  > All Articles.

3. Click the link to the article in Review  workflow state that you want to recall.

4. On the Knowledge form, click Recall.
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Result
The article opens in edit mode and the workflow state of the article is changed to Draft. The 
version number of the article increments by 0.01.

Related topics

Edit a knowledge article in Agent Workspace

Knowledge workflows

Approve a knowledge article in Agent Workspace

Approve a knowledge article that is awaiting your review in Agent Workspace.

Before you begin
Role required: agent_workspace_user

About this task
If the article versioning feature is enabled, only users who are assigned as approvers can modify 
a knowledge article that is in the Review  state. If you are not an approver but need to modify 
the article, consider recalling the article. For more information, see Recall an article that is being 
reviewed in Agent Workspace.

Procedure

1. Navigate to All  > Agent Workspace  > Agent Workspace Home.

2. Go to Lists  > Knowledge  > My Articles - Unpublished.

3. Click an article link in Review  workflow state.

4. Click Edit.

5. In the Approvals related list, in the State  column, click Requested.
The Approval form opens in another tab within Agent Workspace.

6. From the State list, select Approved.

7. Click Save.
The approved knowledge article is published immediately or on the scheduled publish date, if 
the article is scheduled for publishing. If the article versioning feature is enabled, the version 
number of the knowledge article increments to the next whole number (for example, from 
2.02 to 3.0). On the Knowledge form of the article, the workflow state changes to Published. 
The new published version of the article is added to the Article Versions related list on the 
Knowledge form. The version is also available in the All Articles list in Agent Workspace, go to 
Knowledge  > All Articles.

Related topics

View a knowledge article in Agent Workspace

Request translations for missing languages in Agent Workspace

Request to translate a published knowledge article in available languages by creating a 
translation task in Agent Workspace.

Before you begin
You must have contribute access to the knowledge base that stores the knowledge article.
Ensure that the system administrator verifies the following settings:

• Knowledge Management Advanced plugin (com.snc.knowledge_advanced) is activated.

• I18N: Knowledge Management Internationalization Plugin v2 plugin 
(com.glideapp.knowledge.i18n2) is activated.
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Note: 
The 18N: Internationalization plugin (com.glide.i18n) activates the I18N: Knowledge 
Management Internationalization Plugin v2 plugin.

• The glide.knowman.translation.enable_translation_task  property is 
set to true  in the ServiceNow AI Platform  interface. For more information, see Knowledge 
Management properties.

Role required: agent_workspace_user

Procedure

1. Navigate to All  > Agent Workspace  > Agent Workspace Home.

2. Click Lists  > Knowledge  > All Articles.

3. Click the link to a knowledge article for which you want to create a translation task.

4. On the Knowledge form, click Edit.

5. Click Request translations.

6. In the Request translation dialog box, select one or more available languages in the Select 
languages list.
If a language appears grayed out, a translation is already in progress or has been completed 
for that language. Some languages might not be available if the system administrator has 
configured only specific languages for the knowledge base in which the article is contained.

7. Click Submit.

Result
The translation task is created for the article in the selected languages and assigned to a group 
or user based on assignment rules, if configured.

Related topics

Create translation assignments for knowledge articles

Translate a knowledge article from a translation task in Agent Workspace

Translate a knowledge article in Agent Workspace

Translate published knowledge articles to make them available in other languages.

Before you begin
You must have contribute access to the knowledge base that stores the knowledge article.
Ensure that the system administrator verifies the following settings:

• Knowledge Management Advanced plugin (com.snc.knowledge_advanced) is activated.

• I18N: Knowledge Management Internationalization Plugin v2 plugin 
(com.glideapp.knowledge.i18n2) is activated.

Note: 
The 18N: Internationalization plugin (com.glide.i18n) activates the I18N: Knowledge 
Management Internationalization Plugin v2 plugin.
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• The glide.knowman.translation.enable_translation_task  property is 
set to true  in the ServiceNow AI Platform  interface. For more information, see Knowledge 
Management properties.

Note: 
When the glide.knowman.translation.enable_translation_task 
property is set to false, translate the knowledge article by clicking New  in the 
Translated version related list of a Knowledge form. The Knowledge form that is displayed 
to translate the article is based on the article template of the source knowledge article. 
You can enter your translation content in the Knowledge form. For more information about 
the Knowledge form, see Create a knowledge article in Agent Workspace.

Role required: agent_workspace_user

About this task
If you have contribute access to a knowledge article, you can translate a knowledge article 
directly from the knowledge form.
If your system administrator has configured languages for the knowledge base, you can translate 
into those languages only. For more information, see Create a knowledge base.

Note: 
The translation management feature isn't available for knowledge blocks in Agent 
Workspace.

Procedure

1. Navigate to All  > Agent Workspace  > Agent Workspace Home.

2. Click Lists  > Knowledge  > All Articles.

3. In the Number  column, click the link to a knowledge article that you want to translate.

4. Click Edit.

5. Click Translate.

Note: 
The Translate  button is not available if the 
glide.knowman.translation.enable_translation_task  property is 
disabled, translations of the knowledge article are available in all available languages, or 
a translation task has already been created for all the available languages.

The Original language and Translated language sections appear side by side for easy viewing, 
as shown in the following figure. The text in the Translated language section still appears in the 
original language content.
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6. Provide the translation in the Translated language section.

◦ If dynamic translation is enabled, click Machine translate  to automatically replace the draft 
content in the Translated language section with machine-translated content in the targeted 
language.

Note: 
A default translator configuration should be available. For configuring the translation 
API, see Dynamic translation .

When you click Machine translate, any draft content in the Translated language section is 
automatically replaced with the machine-translated content.

◦ If dynamic translation is not available, replace the draft content in the Translated language 
section with your translated text.

7. Click Create draft article  to create a draft version of the translated article.

8. Click Publish.

Result
When the translated version of the knowledge article is published, a new knowledge number 
is assigned to the translated version. The translated version is available in the All Articles list in 
Agent Workspace. Also, the Translated Versions related list on the Knowledge form of the original 
and translated knowledge article is updated with all the translated versions.

Related topics

Request translations for missing languages in Agent Workspace

Translation management

Translate a knowledge article from a translation task in Agent Workspace

Translate a published knowledge article for which you have been assigned a translation task.

Before you begin
You must have contribute access to the knowledge base that stores the knowledge article.
Ensure that the system administrator verifies the following settings:
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• Knowledge Management Advanced plugin (com.snc.knowledge_advanced) is activated.

• I18N: Knowledge Management Internationalization Plugin v2 plugin 
(com.glideapp.knowledge.i18n2) is activated.

Note: 
The 18N: Internationalization plugin (com.glide.i18n) activates the I18N: Knowledge 
Management Internationalization Plugin v2 plugin.

• The glide.knowman.translation.enable_translation_task  property is 
set to true  in the ServiceNow AI Platform  interface. For more information, see Knowledge 
Management properties.

Role required: agent_workspace_user

About this task
A translation task is created for a knowledge article when a request for translation is submitted or 
its knowledge base is configured to automatically create translation tasks. For more information, 
see Request translations for missing languages in Agent Workspace  and Create a knowledge 
base.

Note: 
The translation management feature isn't available for knowledge blocks in Agent 
Workspace.

Procedure

1. Navigate to All  > Agent Workspace  > Agent Workspace Home.

2. Click Lists  > Knowledge  > My Tasks - Translation.

3. In the Number  column, click the link to a translation task.

4. Click Translate.

Note: 
The Translate  button is not available if the 
glide.knowman.translation.enable_translation_task  property is 
disabled, translations of the knowledge article are available in all available languages, or 
a translation task has already been created for all the available languages.

The Original language and Translated language sections appear side by side for easy viewing, 
as shown in the following figure. By default, the Translated language section includes the 
original language content.
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5. Provide the translation in the Translated language section.

◦ If dynamic translation is enabled, click Machine translate  to automatically replace the draft 
content in the Translated language section with machine-translated content in the targeted 
language.

Note: 
A default translator configuration should be available. For configuring the translation 
API, see Dynamic translation .

When you click Machine translate, any draft content in the Translated language section is 
automatically replaced with the machine-translated content.

◦ If dynamic translation is not available, replace the draft content in the Translated language 
section with your translated text.

6. Click Create draft article  to create a draft version of the translated article.

7. Click Publish.

Result
When the translated version of the knowledge article is published, a new knowledge number 
is assigned to the translated version. The translated version is available in the All Articles list in 
Agent Workspace. Also, the Translated Versions related list on the Knowledge form of the original 
and translated knowledge article is updated with all the translated versions.

Related topics

Request translations for missing languages in Agent Workspace

Translation management

Authoring a knowledge article in Microsoft  Word

Author and access knowledge articles in Microsoft  Word by deploying the Knowledge 
Management - Add-in for Microsoft Word.

User with contribute access to a knowledge base can open, create, edit, publish, and search 
for knowledge articles from within the Knowledge Management pane in Microsoft  Word. A user 
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with read access to a knowledge base, can view the article in Microsoft  Word. The Knowledge 
Management - Add-in for Microsoft Word is available in the online version of Microsoft  Word only.

The Knowledge Management - Add-in for Microsoft Word works with applications that are 
integrated with the online version of Microsoft  Word such as Microsoft SharePoint  and Microsoft 
OneDrive.

Consider the following points when using the Knowledge Management - Add-in for Microsoft 
Word to maintain knowledge articles:

• The URL is automatically generated for Word documents created in Microsoft SharePoint  and 
Microsoft OneDrive  with business accounts only.

For other applications and account types, you must manually enter the URL in the Document 
URL  field on the Knowledge form in Microsoft  Word. For more information, see Create a 
knowledge article in Microsoft Word.

• The conversion time of a knowledge article from a Microsoft  Word document depends on the 
document size.

• Headers and footers corresponding to pages in the Microsoft  Word document appear as is in 
the knowledge article. You can remove headers and footers in the Microsoft  word document 
before creating or updating the knowledge article.

Note: 
As an admin, you must create a Restricted Caller Access Privileges record for the Microsoft 
Word add-in to publish a knowledge article content in scoped knowledge bases. For more 
information, see Restricted caller access privilege settings .

Activation information

Activate the Knowledge Management - Add-in for Microsoft Word plugin 
(com.snc.knowledge.ms_word) to access knowledge articles from within the Microsoft  Word 
online application. For more information, see Activate Knowledge Management - Add-in for 
Microsoft Word.

Related topics

View a knowledge article in Microsoft Word

Create a knowledge article in Microsoft Word

Edit a knowledge article in Microsoft Word

Publish a knowledge article in Microsoft Word

Configure Knowledge Management - Add-in for Microsoft Word

Log in to your ServiceNow  instance for authoring knowledge articles in Microsoft  Word

Author and collaborate on knowledge articles in Microsoft  Word by logging in to your ServiceNow 
instance from the Word Online application.

Before you begin
You must have contribute access to the knowledge base within which you want to create the 
knowledge article.
The system administrator and Office 365 administrator have configured the Knowledge 
Management - Add-in for Microsoft Word. (For more information, see Configure Knowledge 
Management - Add-in for Microsoft Word.)
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About this task
You need to authenticate with your ServiceNow  instance credentials for accessing and creating 
knowledge articles using Microsoft  Word. You might also need to re-authenticate if your session 
has expired.

Procedure

1. Sign in to your Office 365 account.

2. From the Microsoft 365 app launcher, select the icon to launch the Microsoft  Word app.
For more information, see Use the Office 365 app launcher .

3. In the New section, click New blank document, or open any existing Microsoft  Word 
document.

4. On the Home tab, click the Knowledge icon ( ).

5. In the Knowledge Management pane of the Word document, click Log in to ServiceNow.
The ServiceNow  login page opens in a separate tab of your browser.

6. On the ServiceNow  login page, enter your ServiceNow  credentials.

Result
After successful authentication, the ServiceNow  instance browser tab closes and you are 
redirected to the Microsoft  Word browser tab. On the Microsoft  Word document, the Knowledge 
Management pane displays the welcome screen.

View a knowledge article in Microsoft  Word

View a knowledge article in Microsoft  Word, including the article number, short description, and 
article content.

Before you begin

• Ensure that the administrator has configured the Knowledge Management - Add-in for 
Microsoft Word. (For more information, see Configure Knowledge Management - Add-in for 
Microsoft Word.)

• You must have logged in to your ServiceNow  instance from the Word Online application. For 
more information, see Log in to your ServiceNow instance for authoring knowledge articles in 
Microsoft Word.

• You must have read access to the knowledge article.

• You must have signed in to your Office 365 account.

Procedure

1. From the Microsoft 365 app launcher, select the icon to launch the Microsoft  Word app.
For more information, see Use the Office 365 app launcher .

2. In the New section, click New blank document, or open any existing Microsoft  Word 
document.

3. On the Home tab of the Word document, click the Knowledge icon ( ).

4. Access the article in the Knowledge Management pane of the Word document.
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◦ In the Knowledge Management pane, in the Search  box, enter the knowledge article number 
or description.

◦ In the Knowledge Management pane, click a knowledge base to view a list of knowledge 
articles within the knowledge base. All knowledge bases and associated knowledge articles 
for which you have contribute or read access appear in the Knowledge Management pane

5. In the Knowledge Management pane, click the link to the knowledge article that you want to 
view.

Tip: 
To go back to the previous view in the Knowledge Management pane, click the left caret 

icon ( ). To go back to the landing screen, click the home icon ( ).

Result
If a knowledge article was created from the Knowledge Management  application in the 
ServiceNow AI Platform  interface, the article content appears in the Document pane and the 
article details appear in the Knowledge Management pane of the Microsoft  Word document.

If a knowledge article was created using another Word document, the document opens in a new 
browser tab with the content in the Document pane and the article details in the Knowledge 
Management pane of that document.

Note: 
If the article uses a template, the article opens in the ServiceNow AI Platform  interface in a 
new browser tab. You can’t edit articles with templates in Microsoft  Word.

The following article details appear in the Knowledge Management pane.

Knowledge form

Field Description

Number Automatically generated knowledge article number.

Knowledge 
base

Knowledge base in which the knowledge article is stored. You can associate a 
knowledge article with one knowledge base only.

Category Category for the knowledge article. This value helps users find the article within 
a selected category. You can select only categories available within the selected 
knowledge base. Articles without a category appear in the (empty) category.

Ownership 
Group

Ownership group for the knowledge article. An ownership group consists of 
a group of members and a manager who are responsible for approvals and 
feedback tasks. Ownership groups can publish, edit, and retire knowledge articles 
that they are associated with.

Note: 
This field is available only if the 
glide.knowman.ownership_group.enabled  property is enabled. 
If no ownership group is assigned and approvals are required to publish a 
knowledge article, it is automatically submitted for approval to the knowledge 
administrator and knowledge manager. For more information, see Ownership 
groups.

Workflow Publishing workflow state of the knowledge article, such as Draft, In Review, or 
Published. For a new article, the workflow state is set to Draft.
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Knowledge form  (continued)

Field Description

Short 
description

Title of the knowledge article. This title appears when browsing and searching for 
knowledge article, and at the top of the article.

You can enter up to 100 characters in this field.

Document 
URL

URL of the article for accessing the online version in Microsoft  Word.

The URL is automatically generated for Word documents created in Microsoft 
SharePoint  and Microsoft OneDrive  with business accounts only. For other 
applications and account types, you must manually enter the URL in the 
Document URL  field.

Note: 
Avoid copy-pasting the browser URL, because it might not always work. 
Depending on the collaboration tool for your Word document use the URL 
generated specifically for sharing with other users.

When manually entering the URL:

• For Microsoft SharePoint, use the URL generated by the Word Online 
application for specific users you want to have access to the document.

• For Box, use the Box Shared Link. For more information, see Creating 
Shared Links .

Version Automatically generated article version number. This number is incremented 
when changes are made to a published article.

Note: 
This field is available if the article versioning feature has been enabled.

Valid to The date this knowledge article expires. Articles do not appear in search results 
after the Valid to  date or if the Valid to  date is blank.

The default value of the Valid to  field is derived from the Article Validity  field 
configured for the knowledge base (see Create a knowledge base). The Valid to 
date starts from the date the article was created until the number of days specified 
in the Article Validity  field. If the Article Validity  field is blank, the default date in 
the Valid to  field for the knowledge article is set to January 1, 2100.

An article author or editor can select whether to keep or change the default Valid 
to  date.

On the first day of each month, the application sends an email notification to a list 
of authorized recipients to remind them about articles that are about to expire in 
the next month. The recipient can then extend the Valid to  date to continue using 
the article. For more information, see Managing email notifications in Knowledge 
Management.
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Knowledge form  (continued)

Field Description

Note: 
If the system date format or user preferences are set to use the yy  year 
format, you might face issues when the Valid to  date is set to the default 
date. Contact your system administrator or modify the user preferences 
to use a date format with the yyyy  year format. For more information, see 
Global date and time field format  and Personalize the system date format
topics.

Scheduled 
publish 
date

Future date when the knowledge article will be published automatically. For more 
information, see Schedule a knowledge article for publishing in Microsoft Word.

Related topics

Create a knowledge article in Microsoft Word

Edit a knowledge article in Microsoft Word

Create a knowledge article in Microsoft  Word

Create a knowledge article in Microsoft  Word to author and collaborate on content using Word.

Before you begin

• Ensure that the administrator has configured the Knowledge Management - Add-in for 
Microsoft Word. (For more information, see Configure Knowledge Management - Add-in for 
Microsoft Word.)

• You must have logged in to your ServiceNow  instance from the Word Online application. For 
more information, see Log in to your ServiceNow instance for authoring knowledge articles in 
Microsoft Word.

• You must have contribute access to the knowledge base within which you want to create the 
knowledge article.

• You must have signed in to your Office 365 account.

Procedure

1. From the Microsoft 365 app launcher, select the icon to launch the Microsoft  Word app from 
your Office 365 account and open a Word document.
For more information, see Use the Office 365 app launcher .

2. In the New section, click New blank document, or open any existing Microsoft  Word 
document.

3. On the Home tab of the Word document, click the Knowledge icon ( ).

4. In the Knowledge Management pane of the Word document, click Create Article.

5. On the Knowledge form, fill in the fields.
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Knowledge form

Field Description

Number Automatically generated knowledge article number.

Knowledge 
base

Knowledge base in which the knowledge article is stored. You can associate a 
knowledge article with one knowledge base only.

Category Category for the knowledge article. This value helps users find the article within 
a selected category. You can select only categories available within the selected 
knowledge base. Articles without a category appear in the (empty) category.

Ownership 
Group

Ownership group for the knowledge article. An ownership group consists of 
a group of members and a manager who are responsible for approvals and 
feedback tasks. Ownership groups can publish, edit, and retire knowledge 
articles that they are associated with.

Note: 
This field is available only if the 
glide.knowman.ownership_group.enabled  property is 
enabled. If no ownership group is assigned and approvals are required 
to publish a knowledge article, it is automatically submitted for approval 
to the knowledge administrator and knowledge manager. For more 
information, see Ownership groups.

Workflow Publishing workflow state of the knowledge article, such as Draft, In Review, or 
Published. For a new article, the workflow state is set to Draft.

Short 
description

Title of the knowledge article. This title appears when browsing and searching 
for knowledge article, and at the top of the article.

You can enter up to 100 characters in this field.

Document 
URL

URL of the article for accessing the online version in Microsoft  Word.

The URL is automatically generated for Word documents created in Microsoft 
SharePoint  and Microsoft OneDrive  with business accounts only. For other 
applications and account types, you must manually enter the URL in the 
Document URL  field.

Note: 
Avoid copy-pasting the browser URL, because it might not always work. 
Depending on the collaboration tool for your Word document use the URL 
generated specifically for sharing with other users.

When manually entering the URL:

◦ For Microsoft SharePoint, use the URL generated by the Word Online 
application for specific users you want to have access to the document.

◦ For Box, use the Box Shared Link. For more information, see Creating 
Shared Links .

Version Automatically generated article version number. This number is incremented 
when changes are made to a published article.
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Field Description

Note: 
This field is available if the article versioning feature has been enabled.

Valid to The date this knowledge article expires. Articles do not appear in search results 
after the Valid to  date or if the Valid to  date is blank.

The default value of the Valid to  field is derived from the Article Validity  field 
configured for the knowledge base (see Create a knowledge base). The Valid 
to  date starts from the date the article was created until the number of days 
specified in the Article Validity  field. If the Article Validity  field is blank, the 
default date in the Valid to  field for the knowledge article is set to January 1, 
2100.

An article author or editor can select whether to keep or change the default 
Valid to  date.

On the first day of each month, the application sends an email notification 
to a list of authorized recipients to remind them about articles that are about 
to expire in the next month. The recipient can then extend the Valid to  date 
to continue using the article. For more information, see Managing email 
notifications in Knowledge Management.

Note: 
If the system date format or user preferences are set to use the yy  year 
format, you might face issues when the Valid to  date is set to the default 
date. Contact your system administrator or modify the user preferences 
to use a date format with the yyyy  year format. For more information, 
see Global date and time field format  and Personalize the system date 
format  topics.

Scheduled 
publish 
date

Future date when the knowledge article will be published automatically. For 
more information, see Schedule a knowledge article for publishing in Microsoft 
Word.

6. In the Document pane of the Word document, enter the article content.

7. In the Knowledge Management pane of the Word document, click Submit.

8. Optional:  Publish the article by clicking Publish.

(Optional) A knowledge article is published depending on the workflow setting of its 
knowledge base:

◦ Knowledge - Instant Publish: The knowledge article is immediately published unless it is 
scheduled to be published at a later date.

◦ Knowledge - Approval Publish: The knowledge article is published on approval completion 
unless it is scheduled to be published at a later date.

For more information, see Schedule a knowledge article for publishing in Microsoft Word.

If the article versioning feature is enabled, the version number of the knowledge article is 
updated. For more information, see Knowledge article version numbers.
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What to do next
You can share the document URL so that users can co-author the document. For more 
information, see Document collaboration and co-authoring .

Edit a knowledge article in Microsoft  Word

Use Microsoft  Word to edit a knowledge article originally created in Microsoft  Word.

Before you begin

• Ensure that the administrator has configured the Knowledge Management - Add-in for 
Microsoft Word. (For more information, see Configure Knowledge Management - Add-in for 
Microsoft Word.)

• You must have logged in to your ServiceNow  instance from the Word Online application. For 
more information, see Log in to your ServiceNow instance for authoring knowledge articles in 
Microsoft Word.

• You must have contribute access to the knowledge article.

• You must have signed in to your Office 365 account.

About this task
Note: 
You can’t edit a knowledge article that uses an article template in Word.

Procedure

1. From the Microsoft 365 app launcher, select the icon to launch the Microsoft  Word app.
For more information, see Use the Office 365 app launcher .

2. In the New section, click New blank document, or open any existing Microsoft  Word 
document.

3. On the Home tab of the Word document, click the Knowledge icon ( ).

4. Access the article in the Knowledge Management pane of the Word document.

◦ In the Knowledge Management pane, in the Search  box, enter the knowledge article number 
or description.

◦ In the Knowledge Management pane, click a knowledge base to view a list of knowledge 
articles within the knowledge base. All knowledge bases and associated knowledge articles 
for which you have contribute or read access appear in the Knowledge Management pane. 
However, you can edit knowledge articles for which you have contribute access.

5. In the Knowledge Management pane, click the link to the knowledge article that you want to 
edit.

6. If the Document pane of the Word document contains any content, retain or replace the 
content.

◦ To overwrite the existing content in the Word document with content from the article you 
selected, click Replace.

◦ To keep the existing content in the Word document, click Retain.

Note: 
When you save the article, the Word document content will replace the article content.

7. If the article versioning feature is enabled, click Checkout  for a published knowledge article.
You can edit only the latest version of a knowledge article.
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8. Edit the content of the article in Microsoft  Word.

◦ Edit the article content online using Microsoft  Word in your browser.

◦ Edit the article content using the Word Desktop app on your computer. In this case, after you 
complete editing the desktop version of the article content, you must return to the online 
version in your browser to save the article content in your ServiceNow  instance.

Tip: 
If multiple people with contribute access to the knowledge article need to co-author the 
same document, you can share the document URL. For more information, see Document 
collaboration and co-authoring .

9. In the Knowledge Management pane, click Save.

10. Optional:  Publish the article by clicking Publish  in the Knowledge Management pane.
The knowledge article is published depending on the workflow setting of its knowledge base.

◦ Knowledge - Instant Publish: The knowledge article is immediately published unless it is 
scheduled to be published at a later date.

◦ Knowledge - Approval Publish: The knowledge article is published on approval completion 
unless it is scheduled to be published at a later date.

For more information, see Schedule a knowledge article for publishing in Microsoft Word.

If the article versioning feature is enabled, the version number of the knowledge article 
increments to the next whole number (for example, from 2.02 to 3.0). For more information, see 
Knowledge article version numbers.

Unlink knowledge articles from linked Microsoft  Word documents

Unlink a knowledge article from a linked Microsoft  Word document to edit the article directly from 
the Knowledge form in the ServiceNow AI Platform.

Before you begin
Ensure that the article was created using the Knowledge Management - Add-in for Microsoft 
Word.
Role required: admin

About this task
If a knowledge article is created using the Knowledge Management - Add-in for Microsoft Word, 
you can edit the article using only the linked Word document in the Word Online application. 
However, if you delete or move the linked Word document, the URL to the Word document and 
article is broken. Therefore, you will no longer be able to edit the article using the linked Word 
document. To continue editing such articles:

• Manually enter the new document URL for the Word document in the Document URL  field 
on the Knowledge form in Microsoft  Word. For more information about the field, see Create a 
knowledge article in Microsoft Word.

• Unlink the article from its linked Word document by following the steps in this procedure.

Procedure

1. Navigate to All  > Knowledge  > Articles.

2. Select an article from the Published  or Unpublished  category.
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3. On the Knowledge form, click the Unlink from Word  related link.

Important: 

When you unlink an article from Microsoft  Word, it may affect the HTML formatting in the 
editor. This formatting change can impact how knowledge articles appear and function 
during editing and display.

Publish a knowledge article in Microsoft  Word

Use the Word Online application to publish a knowledge article originally created in Microsoft 
Word to make it available to users.

Before you begin

• Ensure that the administrator has configured the Knowledge Management - Add-in for 
Microsoft Word. (For more information, see Configure Knowledge Management - Add-in for 
Microsoft Word.)

• You must have logged in to your ServiceNow  instance from the Word Online application. For 
more information, see Log in to your ServiceNow instance for authoring knowledge articles in 
Microsoft Word.

• You must have contribute access to the knowledge base within which you want to publish the 
knowledge article.

• You must have signed in to your Office 365 account.

Procedure

1. From the Microsoft 365 app launcher, select the icon to launch the Microsoft  Word app.
For more information, see Use the Office 365 app launcher .

2. In the New section, click New blank document, or open any existing Microsoft  Word 
document.

3. On the Home tab of the Word document, click the Knowledge icon ( ).

4. Access the article in the Knowledge Management pane of the Word document.

◦ In the Knowledge Management pane, in the Search  box, enter the knowledge article number 
or description.

◦ In the Knowledge Management pane, click the knowledge base to view a list of knowledge 
articles within the knowledge base.

5. In the Knowledge Management pane, click the link to the knowledge article that you want to 
publish.

6. On the Knowledge form, click Publish.

Result
A knowledge article is published depending on the workflow setting of its knowledge base:

• Knowledge - Instant Publish: The knowledge article is immediately published unless it is 
scheduled to be published at a later date.

• Knowledge - Approval Publish: The knowledge article is published on approval completion 
unless it is scheduled to be published at a later date.

For more information, see Schedule a knowledge article for publishing in Microsoft Word.
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If the article versioning feature is enabled, the version of the article is incremented based on the 
version number pattern.

Schedule a knowledge article for publishing in Microsoft  Word

Set a specific time and day for the draft version of a knowledge article created in Microsoft  Word 
to be published automatically.

Before you begin

• You must have contribute access to the knowledge base that stores the knowledge article you 
want to schedule for publishing.

• You must have logged in to your ServiceNow  instance from the Word Online application. For 
more information, see Log in to your ServiceNow instance for authoring knowledge articles in 
Microsoft Word.

• You must have signed in to your Office 365 account.

Ensure that the system administrator verifies the following settings:

• Knowledge Management Advanced plugin (com.snc.knowledge_advanced) is activated. For 
more information, see Activate the Knowledge Management Advanced plugin.

• The article versioning feature is enabled. For more information, see Article versioning.

• The Knowledge Management - Add-in for Microsoft Word is enabled. (For more information, 
see Configure Knowledge Management - Add-in for Microsoft Word.)

Procedure

1. From the Microsoft 365 app launcher, select the icon to launch the Microsoft  Word app.
For more information, see Use the Office 365 app launcher .

2. In the New section, click New blank document, or open any existing Microsoft  Word 
document.

3. On the Home tab of the Word document, click the Knowledge icon ( ).

4. In the Knowledge Management pane of the Word document, in the Search  box, enter the 
knowledge article short description.

5. Click the link to the knowledge article in the Draft state that you want to schedule for 
publishing.

Note: 
The knowledge article must have been originally created using Microsoft  Word.

6. In the Scheduled publish date  field, click the show calendar icon .

7. Select any future date from the calendar.

8. In the Select Time  field, enter a time in the format hh:mm:ss.

9. Click OK.

10. Click Publish  to enable the publishing workflow.

Tip: 
If you want to cancel an article's scheduled publication and move the article back to the 
Draft state, click Recall.
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Result
If approvals are disabled, the state of the knowledge article is changed to Scheduled for Publish 
and the article is automatically published on the scheduled publish date.

If approvals are enabled, the state of the knowledge article is changed to Review. If the article is 
approved, the state of the article is changed to Scheduled for Publish. If the article was approved 
after the scheduled publish date, the article is published immediately.

The version number of the knowledge article increments based on the publishing workflow. For 
more information, see Knowledge article version numbers.

Related topics

Knowledge workflows

Approve an article that is being reviewed

Recall an article that is being reviewed in Microsoft  Word

Recall a knowledge article that is being reviewed and created using Microsoft  Word to stop the 
approval process.

Before you begin

• You must have contribute access to the knowledge base that stores the knowledge article you 
want to recall.

• You must have logged in to your ServiceNow  instance from the Word Online application. For 
more information, see Log in to your ServiceNow instance for authoring knowledge articles in 
Microsoft Word.

• You must have signed in to your Office 365 account.

Ensure that the system administrator verifies the following settings:

• Knowledge Management Advanced plugin (com.snc.knowledge_advanced) is activated. For 
more information, see Activate the Knowledge Management Advanced plugin.

• The article versioning feature is enabled. For more information, see Article versioning.

• The Knowledge Management - Add-in for Microsoft Word is enabled. (For more information, 
see Configure Knowledge Management - Add-in for Microsoft Word.)

About this task
The author of a knowledge article, knowledge administrators, and system administrators can 
recall an article. If an ownership group is assigned to a knowledge article, the ownership group 
manager and ownership group members can also recall the knowledge article.
If a version of a knowledge article is in the Review state, you can recall only the corresponding 
version to make additional changes. Recalling the article results in a minor version increment.

Procedure

1. From the Microsoft 365 app launcher, select the icon to launch the Microsoft  Word app.
For more information, see Use the Office 365 app launcher .

2. In the New section, click New blank document, or open any existing Microsoft  Word 
document.

3. On the Home tab of the Word document, click the Knowledge icon ( ).

4. In the Knowledge Management pane of the Word document, in the Search  box, enter the 
knowledge article title or description.
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5. Click the link to the article in Review state that you want to recall.

6. On the Knowledge form, click Recall.

Result
The article opens in edit mode and the state of the article is changed to Draft. The version 
number of the article increments by 0.01.

Create a knowledge article from a customer service case

Reuse information from a customer service case by creating knowledge articles from cases.

Before you begin
Your administrator must enable creation of articles from customer service cases.

Role required: sn_customerservice_agent or knowledge

Procedure

1. Navigate to Customer Service  > Cases  > All.

2. Select a case from which you want to create a knowledge article.

3. Click Create Knowledge.
The relevant fields are automatically copied from the case to the record that opens.

4. In the Knowledge base  field, enter the name of the knowledge base in which you want this 
article to display.

5. Click Submit.

Provide feedback on knowledge articles

You can view and contribute to feedback on knowledge articles.

Feedback options

You can submit feedback for knowledge articles in these ways:

• Flag an article as incorrect or inappropriate.

• Provide a rating value for the article.

• Mark an article as helpful or not helpful.

• View comments, add a new comment, or reply to existing comments.

Users can view comments directly on the article. Knowledge managers can view the other types 
of feedback by navigating to Knowledge  > Feedback.

Note: 
To know more about Knowledge article view properties and rating options that appear with 
articles, see Knowledge article view properties.

Administrators and knowledge managers can disable some feedback options using fields on the 
Knowledge Base form. Administrators can configure feedback options using properties.

Flagging articles

You can flag an article for incorrect or inappropriate content. Click Flag Article  in the article 
header to open a new window, allowing you to enter suggested changes.
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• Flagged comments do not appear on the Article View page. Users with the admin, 
knowledge_admin, and knowledge_manager roles can access flagged articles by navigating 
to All  > Knowledge  > Articles  > All Flagged. Users with the knowledge role can access their 
flagged articles by navigating to All  > Knowledge  > Feedback Management  > My Flagged.

• If disabled, the author of the article and users with the admin, knowledge_admin, and 
knowledge_manager roles can see all flagged comments. Other users can see only their own 
flagged comments.

Note: 

• You cannot disable flagging for an article until you have disabled the flagging for all 
feedback comments for that article.

• If Disable Suggesting is checked at the Knowledge Base level, the Flag Article  button 
does not appear for any knowledge article

Flagged comments are stored in the Knowledge Feedback (kb_feedback) table but not the Live 
Feed Messages (live_message) table.

Rating articles

The five stars below the article title allow you to indicate the article's effectiveness on a scale of 1 
to 5.

Note: 
If the Disable rating  is checked at the Knowledge Base level, the Rating Article button does 
not appear for any knowledge article.

Marking articles

The question Helpful? at the bottom of the article allows you to indicate the usefulness of the 
article with a simple Yes  or No  answer. The Yes  and No  options are always available on the 
knowledge article view page even when you had selected an option earlier.

Note: 
If the Disable Mark as helpful  is checked at the Knowledge Base level, the Marking Article 
button does not appear for any knowledge article.

Comments

Knowledge comments at the bottom of the article use live feed to enable a conversation around 
a knowledge article. For example, you can post replies to comments, add attachments, or 
Like comments. The glide.knowman.use_live_feed  property controls the display of 
knowledge article comments. If enabled, the system uses live feed to manage and display 
feedback on knowledge articles.

Note: 
Unauthenticated users and users with only the snc_external role can’t add or view 
attachments for comments.

Related topics

Automating feedback management to improve content

Request a knowledge base

Create a knowledge article from an incident in ITSM Agent Workspace 
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Knowledge Management reference

Reference topics provide additional information that you can use to configure and administer 
Knowledge Management.

Domain separation and Knowledge Management

Domain separation is supported in Knowledge Management. Domain separation enables you to 
separate data, processes, and administrative tasks into logical groupings called domains. You 
can control several aspects of this separation, including which users can see and access data.

Support level: Standard

• Includes all aspects of Basic  level support.

• Application properties are domain-aware as needed.

• Business logic: The service provider (SP) creates or modifies processes per customer. The use 
cases reflect proper use of the application by multiple SP customers in a single instance.

• The instance owner must configure the minimum viable product (MVP) business logic and data 
parameters per tenant as expected for the specific application.

Sample use case: An admin must be able to make comments required when a record closes for 
one tenant, but not for another.

For more information on support levels, see Application support for domain separation .

Overview

Domain separation works differently at different access levels of an application. In Knowledge 
Management, data, requester, and fulfiller access to knowledge bases are domain separated.

How domain separation works in Knowledge Management

In Knowledge Management, the following rules apply:

Data: At the data level of domain separation, data visibility is separated from one domain to 
another. Knowledge bases, user criteria, articles, categories, article feedback, article versions, 
article templates, and external sources are domain separated in the base system.

Note: 
The data in one domain cannot be seen in any other domain. For example, if you create 
a Knowledge Management  article in a domain A using an article template which is not in 
domain A, the article will not be visible in domain A. Similarly, if you create a Knowledge 
Management  article in the global domain using a template that is not in global, the article 
might not be visible in all the domains.

Requester: Requester activities are supported within tenant domains. Users can search; view; 
comment; and rate articles of their domain, any child domain, and global domains, if feedback is 
enabled and the knowledge base settings grant them read access to articles.

• Users in the global domain can access articles in all the domains if read access is granted at 
knowledge base and/or article level.

• Users in the parent domain can access articles in that domain, global, and all its child domains 
if read access is granted at knowledge base and/or article level.

• Users in the child domain can access articles in that domain and the global domain if read 
access is granted at knowledge base and/or article level.
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Fulfiller: The application can be used by the Fulfiller within the tenant domains as a tenant 
domain-owned application. Users are allowed to author articles in knowledge bases of their 
domain, any child domain, and the global domain if the knowledge base has user criteria set up 
to grant contribute access.

• Articles are automatically saved to the user’s current domain when the article is created.

• If the glide.knowman.allow_edit_global_articles  system property is enabled, 
users from a domain other than the global domain can check out and edit global articles. 
Otherwise, system administrators and users from a domain other than the global domain 
cannot check out global articles and are shown a warning message to that effect. Depending 
on their access, users can change their domain to the global domain to check out and edit the 
global articles.

• Domains of versioned articles will be maintained as per the latest article version's domain. 
This includes updating the domain for kb_version, kb_knowledge, kb_feedback, and 
sys_attachment tables.

• If domains contain another domain: If Domain A contains Domain B, users with access to 
Domain A can author articles in Domain B by toggling the domain scope. To learn more about 
toggling domain scope, see Visibility domains and Contains domains .

See Managing access to knowledge bases and knowledge articles  to learn how to control 
contribute and read access to knowledge bases and knowledge articles.

Use cases

This image demonstrates a basic domain hierarchy that is available in the base system.
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Fulfiller use cases
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Known Issues

• The following AQI tables are not domain separated:

◦ AQI Checklist [kb_quality_checklist]

◦ Checklist Question [kb_checklist_question]

◦ Article Checklist Answer [kb_article_checklist_answer]

Note: 
The Article Checklist Answer table does not contain the Order field. The application 
shows the list in a random order.

• Comment provided by a user on an article is stored in article's domain instead of user domain.

Related topics

Domain separation for service providers

Additional plugins for Knowledge Management

After Knowledge Management  is activated, you can activate additional plugins that provide 
access to various additional Knowledge Management features.

You must have the admin role to activate these additional plugins. For details, see Activate a 
plugin .

Note: 

Starting with the Washington DC  release, the Knowledge Management  v3 homepage 
(com.snc.knowledge3) is being prepared for deprecation in the future Y release. It is replaced 
by the Knowledge Management  Service Portal  (com.snc.knowledge_serviceportal), which is 
active by default for customers on Madrid  and later releases. For more information about the new 
experience, see Knowledge Management Service Portal homepage features.

Plugin Description

Knowledge Management Core 
(com.glideapp.knowledge)

Installs the core Knowledge Management  items used to 
allow other Knowledge-related plugins to work, such as 
Knowledge V3, Knowledge Advanced, and Knowledge 
Service Portal. This plugin is activated by default.
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Plugin Description

Knowledge Management 
Advanced Installer 
(com.snc.knowledge_advanced.installer)

Installs the Knowledge Management Advanced plugin. 
Activating/upgrading to this plugin validates the 
knowledge articles and knowledge bases to make 
sure that the Knowledge Advanced plugin can be 
successfully installed. If validation fails, check the Plugin 
Activation logs and follow instructions given to fix any 
errors. Once you fix all the issues, re-run this plugin.

Knowledge Management Advanced 
(com.snc.knowledge_advanced)

Adds advanced features to Knowledge Management 
such as version control and subscriptions. This 
plugin requires that all knowledge bases are version 
Knowledge V3. Use the Knowledge Management 
Advanced Installer plugin to activate this plugin.

Predictive Intelligence for 
Knowledge Management 
(com.snc.knowledge_ml)

Provides various Knowledge Management  capabilities 
driven by machine-learning solutions. For example, 
capabilities such as similar articles and knowledge 
demand insights. Activation of this plugin on production 
instances may require a separate license. Contact 
ServiceNow  for details.

Note: 
When you install and activate the Predictive 
Intelligence for Knowledge Management 
plugin (com.snc.knowledge_ml), the Predictive 
Intelligence for Contextual Search plugin 
(com.snc.contextual_search_ml) is also activated.

Performance Analytics - Content 
Pack - Knowledge Management 
(com.snc.pa.knowledge_v2)

Enables the Performance Analytics content pack for 
the Analytics and Reporting Knowledge Management 
Solution. Activation of this plugin on production 
instances might require a separate Performance 
Analytics license. Contact ServiceNow for details.

Knowledge Management V3 
(com.snc.knowledge3)

Enables support for Knowledge Management  V3. 
Activate this plugin when you upgrade from Eureka or 
earlier versions.

I18N: Knowledge Management 
Internationalization Plugin v2 
(com.glideapp.knowledge.i18n2)

Helps create and maintain translations of an article 
in various languages in a way that is easy to manage 
translations while authoring as well as viewing articles. 
Activating internationalization plugins for any of the 
available languages automatically activates this plugin.

Knowledge Document 
(com.snc.knowledge_document)

Adds knowledge-based functionalities to the Managed 
Documents plugin. You can create a knowledge article 
from a document or update a knowledge document to a 
newer revision.

Knowledge Management - 
External Content Integration 
(com.snc.knowledge.external_integration)

Adds external content search capabilities to the 
Knowledge Management  application. Once configured, 
this feature creates a copy of the external content on 
ServiceNow as knowledge articles, and then indexes the 
articles through Zing Search. You must have appropriate 
reuse and copy privileges before you configure an 
external source to be searchable using this feature.
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Plugin Description

Knowledge Management 
Wiki Support 
(com.glideapp.knowledge2.wiki)

Enables support to save Knowledge articles in wiki type 
field instead of html type field.

Knowledge Management 
KCS Capabilities 
(com.snc.knowledge_kcs_capabilities)

Enables the use of KCS roles (kcs_contributor, 
kcs_publisher, and kcs_candidate) and use the 
metadata fields for the KCS article state (governance 
and confidence).

Knowledge Management - 
Add-in for Microsoft Word 
(com.snc.knowledge.ms_word)

Enables authoring content in Microsoft  Word and 
publishing it as a knowledge article using a Word add-in.

Knowledge Blocks 
(com.snc.knowledge_blocks)

Enables you to create re-usable content blocks that can 
be included in existing knowledge articles. This feature 
is capable to display only pieces of an article to specific 
users.

Knowledge Overview 
(com.sn_knowledge_overview)

Enables you to generate reports to provide an overview 
of knowledge base and article data.

Components installed with Knowledge Management Core

Several types of components are installed with activation of the Knowledge Management Core 
plugin (com.glideapp.knowledge) including user roles and tables.

Note: 
The Application Files table lists the components that are installed with this application. 
For instructions on how to access this table, see Find components installed with an 
application .

Demo data is available.

Roles installed

Role Description
Contains 
roles

Knowledge

[knowledge]

Users with the knowledge role can contribute to the 
default knowledge base and access the Knowledge 
application menu. The knowledge role is a fulfiller role 
and not a requester role.

None.

Knowledge 
administrator

[knowledge_admin]

Knowledge administrator can create new knowledge 
bases and manage all knowledge bases.

Knowledge 
administrator 
contains the 
knowledge 
role.

Knowledge manager

[knowledge_manager]

Knowledge managers perform administrative functions 
for knowledge bases they manage such as defining 
categories, pinning important articles, and approving 
changes to articles. Users selected as managers of a 
knowledge base receive this role automatically.

Knowledge 
manager 
contains the 
knowledge 
administrator 
role.
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Tables installed

Table Description

CSM Table Map

[csm_table_map]

Stores information about the mapping source and target 
table. For example, while creating a knowledge article from a 
customer service case, the source table would be customer 
service case [sn_customerservice_case] and the target 
table would be Knowledge [kb_knowledge].

CSM Field Map

[csm_field_map]

Stores information about the fields that are mapped 
from the source table to the target table in a given table 
map (CSM Table Map). For example, when creating 
a knowledge article from a customer service case 
[sn_customerservice_case], the source field value would be 
case.short description and the target field value would be 
knowledge.short description.

Related Articles

[kb_2_kb]

Stores information about related knowledge articles.

Related Catalog Items

[kb_2_sc]

Stores information about related catalog items.

Knowledge Category

[kb_category]

Stores the category of a knowledge article.

Knowledge Feedback Task

[kb_feedback_task]

Stores information about the feedback task on a knowledge 
article.

Knowledge Feedback

[kb_feedback]

Stores information about flagged comments on a 
knowledge article.

Knowledge Keyword

[kb_keyword]

Stores information about keywords associated with the 
featured knowledge articles on the homepage of the 
Knowledge Management Service Portal.

Knowledge Base

[kb_knowledge_base]

Stores information about knowledge bases that store 
knowledge articles.

Knowledge keyword

[kb_knowledge_keyword]

Stores information related to mapping between knowledge 
articles and keywords.

Knowledge

[kb_knowledge]

Stores knowledge articles organized by knowledge base 
and category, as well as featured content and popular 
articles.

Who Can Contribute To 
Knowledge Base

[kb_uc_can_contribute_mtom]

Stores information about who can read and write to a 
knowledge base.
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Table Description

Who Can Read Knowledge Base

[kb_uc_can_read_mtom]

Stores information about who can read a knowledge base.

Who Cannot Contribute To 
Knowledge Base

[kb_uc_cannot_contribute_mtom]

Stores information about who cannot read and write to a 
knowledge base.

Who Cannot Read Knowledge 
Base

[kb_uc_cannot_read_mtom]

Stores information about who cannot read a knowledge 
base.

Knowledge Use

[kb_use]

Stores information about the number of times articles are 
viewed and the number of times knowledge articles are 
used in an incident, problem, or case.

Knowledge Related to Products

[m2m_kb_ci]

Stores information about the products related to knowledge 
articles.

Knowledge Comment Likes

[m2m_kb_feedback_likes]

Stores information about users who like a comment in 
knowledge feedback.

Knowledge Applied to Tasks

[m2m_kb_task]

Stores information about articles attached to tasks 
(incident, case, or problem).

Components installed with knowledge blocks

Several types of components are installed with activation of the knowledge blocks plugin, 
including tables.

Note: 
The Application Files table lists the components that are installed with this application. 
For instructions on how to access this table, see Find components installed with an 
application .

Demo data is available for this feature.

Tables installed

Table Description

Knowledge Block

[kb_knowledge_block]

Knowledge blocks table.

Note: 
This table extends the Knowledge [kb_knowledge] table.

KB Knowledge to Block

[m2m_kb_knowledge_to_block]

KB knowledge to block table.

KB Knowledge to Block History KB knowledge to block history table.
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Table Description

[m2m_kb_to_block_history]

For further information on table administration and how to manage data, see Table 
administration .

Knowledge Management  roles

Certain roles are required to use Knowledge Management functionality.

Note: 
The user criteria determine the access to knowledge articles. For more information, see 
Managing access to knowledge bases and knowledge articles.

The kcs_candidate, kcs_contributor, and kcs_publisher roles also include the knowledge role. For 
more information about these KCS-related roles, see KCS v6 Practices Guide .

Knowledge [knowledge]

Users with the knowledge role can contribute to the default knowledge base and access the 
Knowledge application menu. The knowledge role is a fulfiller role and not a requester role. 
Requesters can view, comment, and give feedback to the knowledge articles. However, a 
requester cannot create or edit articles.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

Knowledge manager [knowledge_manager]

Knowledge managers perform administrative functions for the knowledge bases they manage 
defining categories, pinning important articles, and approving changes to articles. Users 
selected as managers of a knowledge base receive this role automatically. Knowledge role 
comes as a subordinate role.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.
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Special considerations

None.

Knowledge administrator [knowledge_admin]

Knowledge administrator can perform all the administrative tasks associated with maintaining 
the Knowledge Management system. User selected as a knowledge admin can make changes 
to all the knowledge bases except the scoped knowledge base. Knowledge role comes as a 
subordinate role.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

Knowledge coach [knowledge_coach]

Knowledge coaches can perform Article Quality Index (AQI) surveys on articles, write, edit and 
review knowledge articles, and coach the team on best practices. Knowledge role comes as a 
subordinate role.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

Note: 
Avoid granting an admin role when more specialized roles are available.

Knowledge domain expert [knowledge_domain_expert]

Knowledge domain experts perform AQI surveys on articles and can write, edit and review 
knowledge management articles. A knowledge domain expert keeps track of the health of 
knowledge base. Knowledge role comes as a subordinate role.

Contains Roles

List of roles contained within the role.
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None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

Administrator [admin]

Administrators can configure knowledge workflows, set knowledge properties, and manage 
knowledge forms and dashboards.

Contains Roles

List of roles contained within the role.

• sn_templated_snip.template_snippet_admin

• sn_employee.admin

• taxonomy_admin

• sn_ace.ace_user

Groups

List of groups this role is assigned to by default.

None.

Special considerations

Note: 
Avoid granting an admin role when more specialized roles are available.

Knowledge group manager [knowledge_group_manager]

Knowledge group managers can add or remove members in ownership groups managed by 
them. They cannot change the manager assigned in their groups. The manager can only be 
reassigned by the knowledge administrator. Knowledge group managers are assigned feedback 
tasks by default. They can reassign tasks to another group member, or group members can 
assign a feedback task to themselves. Knowledge_group_member role comes as a subordinate 
role.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.
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Special considerations

None.

Knowledge group member [knowledge_group_member]

Knowledge group members are part of an ownership group that can be associated to knowledge 
articles. They can approve knowledge articles, assign feedback tasks to themselves and work on 
them as well as edit any knowledge articles that their ownership group is assigned to. Knowledge 
role comes as a subordinate role.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

KCS candidate [kcs_candidate]

Knowledge-Centered Service (KCS) candidates understand the basics of Knowledge-Centered 
Service (KCS). Knowledge role comes as a subordinate role.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

KCS contributor [kcs_contributor]

Knowledge-Centered Service (KCS) contributors can create or validate knowledge articles in 
their product areas without being reviewed by a knowledge coach. They may also author and 
approve articles for broad audience visibility. Knowledge role comes as a subordinate role.

Contains Roles

List of roles contained within the role.

None.
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Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

KCS publisher [kcs_publisher]

Knowledge-Centered Service (KCS) publishers are authors who are well versed in KCS standards 
and create more external-facing articles. Knowledge role comes as a subordinate role.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

Knowledge Management  properties

As an administrator, you can configure the look and functionality of many knowledge base 
features with Knowledge Management  properties.

You can access Knowledge Management  properties by navigating to Knowledge  > 
Administration  > Properties.

Knowledge portal properties

Knowledge portal properties control the look and functionality of the legacy portal page. This 
portal page lists recent knowledge articles and their publishing dates, organized by topic.

Property Description

Number of columns on Knowledge portal pages (glide.knowman.columns) Set the number of columns for arranging 
topics on the knowledge portal.

Note: 
This property applies only to 
Knowledge Management  v2 pages. 
This property is not supported on 
Knowledge Management  v3 pages.

Maximum number of articles per content block on the home page 
(glide.knowman.content_block_limit)

Enter the maximum number of articles to 
display in the Most Useful and Most Viewed 
sections of the knowledge homepage.
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Property Description

Note: 
This property applies only to 
Knowledge Management  v2 pages. 
This property is not supported on 
Knowledge Management  v3 pages.

Omit empty Knowledge topics and categories 
(glide.knowman.show_only_populated)

Select the check box to display topic 
sections only if there are articles for the 
topic. Clear the check box to show all topic 
sections, even those with no assigned 
articles.

Note: 
This property does not apply to the 
New category.

This property applies only to the 
default knowledge base and the 
legacy knowledge portal. Knowledge 
Management  v3 articles do not specify 
a topic. Therefore, this property 
applies only to Knowledge v2 pages. 
This property is not supported on 
Knowledge Management  v3 pages.

Show Knowledge section descriptions 
(glide.knowman.show_descriptions)

Select the check box to display topic 
descriptions in the knowledge portal. To 
enter these descriptions:

1. Edit an existing knowledge article.

2. Right-click the Topic field label and choose 
Show Choice List.

3. Open the record for the topic name and 
enter the description into the Hint field.

Clear the check box to omit section 
descriptions from the knowledge portal.

Note: 
This property applies only to 
Knowledge Management  v2 pages. 
This property is not supported on 
Knowledge Management  v3 pages.

Number of Knowledge Base items to preview in a section 
(glide.knowman.section_limit)

Set the maximum number of articles per 
topic for the knowledge portal. The specific 
articles shown depends on the Knowledge 
section sort field property setting.
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Property Description

Note: 
This property applies only to 
Knowledge Management  v2 pages. 
This property is not supported on 
Knowledge Management  v3 pages.

Knowledge section sort field (glide.knowman.section_sort) Select the default order for articles within 
each topic section on the knowledge portal.

• Published: uses the date published.

• View count: uses the number of times 
articles have been viewed during the 
period specified in the Number of days 
used when summing article views 
property ( applicable only in Knowledge 
Management  v2.)

• Alphabetically: uses the first letter of the 
article title (Short description field).

Note: 
This property applies only to 
Knowledge Management  v2 pages. 
This property is not supported on 
Knowledge Management  v3 pages.

Knowledge Base section sort direction 
(glide.knowman.section_sort_direction)

Select the order, ascending or descending, 
in which articles are listed within each topic 
section on the knowledge portal. The value 
used for sorting is set in the Knowledge 
section sort field property.

Note: 
This property applies only to 
Knowledge Management  v2 pages. 
This property is not supported on 
Knowledge Management  v3 pages.

Show unpublished articles in Knowledge Base portal and topic lists 
(glide.knowman.show_unpublished)

Select the check box to allow users to see 
unpublished articles in the knowledge 
portal and knowledge search results. Use 
the subsequent List of roles... properties to 
designated which users can see articles 
in various unpublished states. If this is not 
selected, users with appropriate roles can 
access unpublished articles through other 
modules of the Knowledge Base application.

List of roles (comma separated) that can see articles in the 
Review workflow state in the Knowledge portal and Topic list 
(glide.knowman.section.view_roles.review)

Enter role names exactly as they appear 
in User Administration  > Roles. If Show 
unpublished articles in Knowledge Base 
portal and topic lists is selected, users 
with these roles see articles in the Review 
workflow state in the knowledge portal, in the 
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Property Description

topic list that appears when they click a topic 
title on the portal, and in knowledge search 
results.

List of roles (comma separated) that can see articles in the 
Draft workflow state in the Knowledge portal and Topic list 
(glide.knowman.section.view_roles.draft)

Enter role names exactly as they appear 
in User Administration  > Roles. If Show 
unpublished articles in Knowledge Base 
portal and topic lists is selected, users with 
these roles see articles in the Draft workflow 
state in the knowledge portal, in the topic list 
that appears when they click a topic title on 
the portal, and in knowledge search results.

Define roles that can view articles in other/custom workflow states 
(glide.knowman.section.view_roles.stagesAndRoles)

Enter role names exactly as they appear 
in User Administration  > Roles. If Show 
unpublished articles in Knowledge Base 
portal and topic lists is selected, define 
the custom field and role as workflow 
state:[roles];. The users with these 
roles see articles in the custom workflow 
state on the knowledge portal.

The property is not applicable to the retired 
knowledge articles. Only users with the 
knowledge_admin role can view retired 
articles.

The number of articles that are asynchronously loaded when scrolling down in the 
new search results page (glide.knowman.search.articles_per_page)

Enter the number of articles to be displayed 
during a search.

Note: 
This property applies only to 
Knowledge Management  v3 pages. 
This property is not supported on 
Knowledge Management  v2 pages.

Show only Knowledge topic titles on portal page (no article links) 
(glide.knowman.home_titlesonly)

Select the check box to omit all article titles 
from the knowledge portal and show only the 
topic names. Users can click the topic title to 
see the list of related articles.

Note: 
This property applies only to 
Knowledge Management  v2 pages. 
This property is not supported on 
Knowledge Management  v3 pages.

Number of days (integer, default 30) used when summing article views 
(glide.knowman.view_age.days)

Enter a number of days to consider when 
calculating view count. The View count 
field in the Knowledge form will be updated 
periodically to reflect the view count based 
on this property. For example, if you enter 
60, the view count is the total number of 
views in the past 60 days. Enter 0 to have 
ServiceNow  consider all views, regardless of 
date.
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Note: 
If you edit this property, run the Count 
Knowledge Use scheduled job to see 
the changes immediately. By default, 
the Count Knowledge Use scheduled 
job runs daily and updates the view 
counts on the knowledge articles. To 
view the scheduled job, navigate to 
System Scheduler  > Scheduled Jobs  > 
Scheduled Jobs.

New customers as of the Paris release 
will not have access to the View count 
property and Count Knowledge scheduled 
job. Existing customers prior to the Paris 
release can continue to use the property and 
scheduled job.

If you set the property value to 0:

• The Count Knowledge scheduled job does 
not run.

• The View count of an article does not have 
a rolling count, the existing view count 
gets incremented for every article view

Note: 
Beginning Vancouver  release, 
glide.knowman.view_age.days 
and Count Knowledge scheduled 
job is deprecated. So, set the 
glide.knowman.view_age.days 
to zero and do not use it.

Automatically place cursor in Knowledge portal search box 
(glide.knowman.portal_search_focus)

Select the check box to have ServiceNow 
place the cursor in the search field when a 
user opens the knowledge portal. Clear the 
check box to have users click in the search 
field before entering a search term.

Note: 
This property applies only to 
Knowledge Management  v2 pages. 
This property is not supported on 
Knowledge Management  v3 pages.

Session level cache in "Most useful 
article" (glide.knowman.use_session_cache_for_most_useful_articles)

Set the property to True to enable session 
level cache in 'Most useful Articles' portal 
widget.

• Type: true | false

• Default value: true

• Location: System Properties
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Enable SEO for selected portal for article view page. 
(glide.knowman.serviceportal.seo_portals)

Value contains a comma-separated list 
of service portal record sys_ids. The SEO 
indexing of knowledge articles is enabled 
on the portals mentioned in the list and is 
blocked by the noindex metatag for other 
portals. If at least one portal is listed, SEO 
suggestions display when users author or 
edit knowledge articles.

• Type: string

• Default value: none

• Location: System Properties

Note: 
If the property value is empty, the 
indexing is enabled for all portals.

Comma-separated list of service portal record sys_ids 
(glide.knowman.serviceportal.use_numbered_url.portals) Configure the property value to include 

sys_id of any portal so that article URLs 
in portal widgets (for example Most 
Useful, Featured, Most viewed articles, 
related article) and search results use 
sysparm_number parameter instead of 
sys_kb_id parameter.

• Type: string

• Default value: None

• Location: System Properties

Note: 
If there are multiple portals, delimit 
their sys_ids by comma (,).

View article as another user (glide.knowman.enable_view_as_user) Set the property to true  to search and view 
an article as another authorized user.

• Type: true | false

• Default value: false

• Location: System Properties

(glide.knowman.serviceportal.seo_user_agent) This property contains the bots' name 
patterns, which are used to determine 
whether the user-agent is a Search Crawler 
bot.

• Type: string

• Default value: None

• Location: System Properties
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Knowledge search properties

Knowledge search properties give you control over the search options available to users and the 
presentation of search results.

Note: 
Knowledge search properties is only applicable to Zing search. To configure AI search 
implementation, see Configuring AI Search .

Property Description

Knowledge search result order 
(glide.knowman.order.search)

Select the order for displaying search results:

• Number of Views: orders search results based on the Number 
of days used when summing article views  property.

• Relevancy: orders search results based on content that is similar 
to the search term.

• Last Modified: orders search results based on modification 
date.

This property is applicable for search within the Knowledge 
Management  application and not the ServiceNow AI Platform 
global search.

Search method to find Knowledge articles 
from a task or directly in the Knowledge Base 
(glide.knowman.search.operator)

Select the search approach to use when the search term includes 
multiple words.

• OR query: returns articles that contain at least one word from the 
search term.

• AND then OR query: first searches for articles that include all 
words in the search term (an AND query). If no matches are 
found, an OR query is performed.

Show author in knowledge search results 
(glide.knowman.search.show_author)

Select the check box to include the author of each article in 
knowledge search results.

If the article versioning feature is enabled, articles with a version 
number less than or equal to 1.0 display Authored by <name>  and 
articles with a version number greater than 1.0 display Revised by 
<name>.

Show last modified date and 
time in knowledge search results 
(glide.knowman.search.show_last_modified)

Select the check box to show the date and time article was last 
edited in knowledge search results.

Show publish date in knowledge search results 
(glide.knowman.search.show_published)

Select the check box to show the date article was published in 
knowledge search results.

Show category in knowledge search results 
(glide.knowman.search.show_category)

Select the check box to show the category breadcrumbs of each 
article in knowledge search results.

Show number of views in knowledge search results 
(glide.knowman.search.show_view_count)

Select the check box to include the number of times each article 
was viewed in knowledge search results.

How to display attachments in Knowledge Search Results 
(glide.knowman.search.attachment)

Select the behavior of how the attachments are shown in the 
search results:
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Property Description

• Do not show attachment

• Show only link for attachment  (default)

• Show attachment with text snippet

For best performance, select Do not show attachment, or Show 
only link for attachment.

Note: 
Starting with the San Diego release, Show only link for 
attachment  is activated by default. For existing customers 
prior to the San Diego release, the default selection is Show 
attachment with text snippet.

Show relevancy in knowledge search results 
(glide.knowman.search.show_relevancy)

Select the check box to show how relevant each search result is 
based on the search string.

Relevancy  value is only shown when knowledge search result 
order property is set to Relevancy.

Show number of knowledge blocks in the knowledge block 
search results when creating or updating a knowledge article 
(glide.knowman.add_blocks.search_results

Define how many search results can be displayed when a 
knowledge block is searched for. By default, the minimum value is 
6 and the maximum is 25.

Enable instant search results for knowledge 
(glide.knowman.search.instant_results)

Select the check box to enable instant search for search results. 
The default value is set to No.

Show Knowledge Base name in Knowledge search results 
(glide.knowman.search.show_knowledgebase)

Select the check box to display the knowledge base to which the 
knowledge article belongs. For example, IT.

Show average rating from knowledge search results 
(glide.knowman.search.show_rating)

Select the check box to display the average star ratings for 
knowledge base articles.

This property is applicable to the search results for knowledge 
articles that appear on the Knowledge Management Service 
Portal search results page and service portal widgets such as 
Knowledge Featured Articles and Knowledge Most Viewed Articles. 
For more information, see Knowledge Management Service Portal 
search results page features  and Configure the home page widget 
instance options.

Show article number in knowledge search results 
(glide.knowman.search.show_article_number)

Select the check box to display the article number for each article 
in the search result.

If the article versioning feature is enabled, the article number and 
the version number are displayed for each article in the search 
result.

Specify default language for searching articles 
(glide.knowman.search.default_language)

Set the property to the default language for searching articles.

• Type: String

• Default value: user-specified

• Location: System Properties
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Property Description

Note: 
If the 
glide.knowman.enable_multi_language_search 
property is set to True, then the multi-language search 
capability overrides the default language search capability.

Enable multi-language search 
(glide.knowman.enable_multi_language_search)

Set the property to True  to enable search for multiple languages 
simultaneously.

• Type: true | false

• Default value: false

• Location: System Properties

Note: 
If this property is set to True, it overrides the setting for 
the glide.knowman.search.default_language 
property.

Disable Knowledge blocks feature 
(glide.knowman.blocks.enable)

Allows you to disable Knowledge blocks feature partially.

• Type: true | false

• Default value: true

• Location: System Properties

Note: 

If the property is set to True  and Enable Blocks  field is 
selected:

• You can create new blocks in the Knowledge Bases.

• You can add blocks to an article in the Knowledge Bases.

If the property is set to False:

• You cannot create new blocks.

• You cannot add blocks to new or existing articles.

• Enable Blocks  field is inactive on the Knowledge Bases 
form.

• Any existing articles with block content will continue to 
show the content.

Knowledge article view properties

Article view properties give you control over the meta data and rating options that appear with 
articles. They also enable you to grant access to individual feedback options based on user role.

Property Description

Show tasks to which an article has been recently attached 
(glide.knowman.recent_tasks.display)

Select the check box to have 
article view include a list of 
tasks associated with the 
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Property Description

article. The list of associated 
tasks appears on the Most 
Recent Tasks widget on the 
article view page. The widget 
appears only when a task is 
attached to the article and 
this property is set to Yes. 
Knowledge articles can be 
attached to a task by clicking 
the Attach to Task  button after 
searching from a form.

Number of attached tasks to display when viewing an article 
(glide.knowman.recent_tasks)

Specify the maximum number 
of tasks to list in article view.

Show article rating section, which may optionally 
include yes/no rating, star rating, and flagging options 
(glide.knowman.show_rating_options)

Select the check box to display 
the rating options for users with 
specific roles. Clear this check 
box to omit the rating section 
for all users, regardless of role.

The Feedback  field is always 
displayed for all users.

List of roles (comma separated) that can see an 
article's rating section, which may optionally include 
yes/no rating, star rating, and flagging option 
(glide.knowman.show_rating_options.roles)

Enter role names exactly 
as they appear in User 
Administration  > Roles. If 
Show article rating section  is 
selected, users with the roles 
listed here see the yes/no 
rating, star rating, and flagging 
options, according to related 
property settings.

Be sure to include all roles that 
should be permitted to see 
any of these rating options. 
Separate properties enable 
you to identify specific roles for 
each option separately. All roles 
in those properties must also 
be listed here.

Show the "Was this article helpful?" yes/no rating option. 
(glide.knowman.show_yn_rating)

Select the check box to display 
the "Was this article helpful?" 
rating to users with roles set 
in the associated property. 
This appears only if the Show 
article rating section  property 
is selected.

List of roles (comma separated) that can see 
yes/no "Was this article helpful?" rating option. 
(glide.knowman.show_yn_rating.roles)

Enter role names exactly 
as they appear in User 
Administration  > Roles. If both 
Show article rating section 
and Show the "Was this 
article helpful?"  properties are 
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Property Description

selected, users with the roles 
listed here see the "Was this 
article helpful?" rating in article 
view.

All roles listed here must also 
be listed in the List of roles 
that can see an article's rating 
section  property.

Show "Create Incident" link 
(glide.knowman.create_incident_link.display)

Select the Yes  check box to 
display the Create Incident 
link.

URL used for the "Create Incident" link 
(glide.knowman.create_incident_link)

Enter the URL for the page 
where users can create an 
incident only if the Show 
"Create Incident" link" 
property is selected.

To find the URL, open the 
appropriate page, then right-
click the header bar and 
choose Copy URL. Highlight 
the URL that appears and use 
the browser's copy and paste 
feature to place it into this 
property field.

Show five-star rating option 
(glide.knowman.show_star_rating)

Select the check box to display 
the five-star rating to users 
with roles set in the associated 
property. This appears only if 
the Show article rating section 
property is selected.

This property is applicable 
to the knowledge article 
view page in the Knowledge 
Management Service Portal. 
For more information, see 
Knowledge Management 
Service Portal article view page 
features.

List of roles (comma separated) that can see five-star rating 
option (glide.knowman.show_star_rating.roles)

Enter role names exactly 
as they appear in User 
Administration  > Roles. If both 
Show article rating section 
and Show five-star rating 
option  properties are selected, 
users with the roles listed here 
see the five-star rating option in 
article view.
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Property Description

All roles listed here must also 
be listed in the List of roles 
that can see an article's rating 
section  property.

Show "Flag Article" option to identify incomplete/inaccurate 
articles (glide.knowman.show_flag)

Select the check box to display 
the flag article option to users 
with roles set in the associated 
property. This appears only if 
the Show article rating section 
property is selected.

List of roles (comma separated) that 
can flag incomplete/inaccurate articles 
(glide.knowman.show_flag.roles)

Enter role names exactly 
as they appear in User 
Administration  > Roles. If both 
the Show article rating section 
and Show "Flag Article" option 
properties are selected, users 
with the roles listed here see 
the flag article option in article 
view.

All roles listed here must also 
be listed in the List of roles 
that can see an article's rating 
section  property.

Show user comments on knowledge articles 
(glide.knowman.show_user_feedback)

Select an option for showing 
user comments When article 
loads, When user clicks link 
to show comments, or Never 
for users with roles set in the 
associated property.

List of roles (comma separated) that 
can see user comments on an article 
(glide.knowman.show_user_feedback.roles)

Enter role names exactly 
as they appear in User 
Administration  > Roles. If 
the Show user comments on 
knowledge articles  property is 
selected, users with the roles 
listed here can add and view 
user comments in article view.

Maximum number of user comments 
displayed on a knowledge article 
(glide.knowman.feedback.display_threshold)

Set the maximum number of 
user comments to display. If 
no value is set, all comments 
are displayed. This property 
does not apply to live feed 
comments on the article view 
page.

Use Live Feed for Knowledge feedback 
(glide.knowman.use_live_feed)

Set the property to True  to 
use live feed to manage and 
display feedback on knowledge 
articles.
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Property Description

• Type: true|false

• Default value: false

• Location: System Properties

Determines the maximum number of knowledge 
article feedbacks that user can post per day 
(glide.knowman.max_comments_per_user_daily).

Enter the value to define the 
maximum feedbacks per day.

• Type: integer

• Default value:

• Location: System Properties

Note: 
If no value is defined, 
then no restrictions are 
applied to the number of 
feedbacks.

Knowledge homepage properties

Knowledge homepage properties control the featured content on the knowledge homepage.

Table title

Property Description

Display or hide the count of articles and questions in the Knowledge 
Homepage (glide.knowman.show_number_on_homepage)

Select to display or 
hide the count of 
knowledge articles 
and questions on 
the Knowledge 
homepage.

Default keyword for getting pinned articles 
(glide.knowman.default_keyword)

Enter a default 
keyword for 
pinned articles. 
Articles pinned 
with the specified 
keyword appear 
in the Featured 
Content section 
of the knowledge 
homepage.

Display or hide the count of articles and 
questions in the category and child categories 
(glide.knowman.show_number_on_categories)

Select to display 
the count of articles 
and questions 
within each 
category, including 
subcategories, 
when browsing or 
searching knowledge 
bases.
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Table title  (continued)

Property Description

Show Knowledge Home page when user has access to only one 
Knowledge Base (glide.knowman.show_home_if_one_kb)

Select to display 
the Knowledge 
homepage when 
the current user has 
access to only one 
knowledge base.

Default header title for the pinned articles 
section on knowledge home pages 
(glide.knowman.default_pinned_section_header_title)

Enter a title for 
the Featured 
Content section 
of the knowledge 
homepage.

Other knowledge properties

Other knowledge properties let you control general knowledge management features.

Property Description

When attaching an article to an incident, copy the content into this field 
(glide.knowman.attach.fields)

When a user searches knowledge from a task form (such as an incident, problem, 
or change) and clicks the Attach to Task  button for an article, the system copies the 
article number and content into the field specified in the Value  column here. This 
field is generally a journal field such as Comments  or Work notes.

Use dot walking to copy the article content into related records. If a specified field 
does not exist, that field is ignored.

If the property has no value, comments is used.

Displays a read-only article view page when 
articles are viewed from contextual search ( 
glide.knowman.contextual_search.show_read_only_article)

Displays a read-only article view page when knowledge articles are viewed from 
contextual search.

• Type: true|false

• Default value: true

Note: 
The 
glide.knowman.contextual_search.show_read_only_article 
property is activated by default. If the property isn’t available, add it manually 
and set its value to true  to display read-only knowledge articles accessed from 
the contextual search. For more information, see Add a system property .

Knowledge Management logo to display if running out of the ServiceNow 
frames (glide.knowman.frameless_logo)

Click the reference lookup tool  and choose an image file to be displayed on 
knowledge pages that are used outside of the ServiceNow  application frames. For 
example, the logo image selected here appears if you create a Content Management 
System site that includes knowledge pages. You can also enter the Name  of an 
image stored in the database to use that image.

Note: 
This property applies only to Knowledge v2 pages. This property is not 
supported on Knowledge v3 pages.
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Property Description

Hide the 'Import' functionality (button and drag-n-drop) for all users 
(glide.knowman.import.hide_import_functionality)

Select Yes  to hide the Import Articles  button.

If you have not yet migrated to Knowledge v3 and are using legacy Knowledge v2, 
you can configure the visibility of the Import Articles  button to prevent users from 
importing articles to knowledge bases.

Show publish check box on the knowledge import pop-up 
(glide.knowman.import.show_publish_checkbox)

Select No  to remove the Publish  check box on the knowledge import form so that an 
article cannot be published as part of the import process. Default is yes.

Use submission workflow (glide.knowman.submission.workflow) Select the Yes  check box to use the knowledge submission workflow instead of the 
standard knowledge workflow. If this option is selected, each time a user creates 
knowledge from an incident or problem, the content is placed into a submission 
record instead of a draft article. Transforming knowledge submissions into articles 
follows a specific workflow.

The sys_id of the knowledge base when creating knowledge from task records 
(glide.knowman.task_kb)

Enter the sys_id of the knowledge base to put new knowledge articles created from 
tasks in.

Before displaying the text of the article in search results or 
the article view, check field-level ACLs on appropriate field: 
kb_knowledge.text (HTML article) or kb_knowledge.wiki (wiki text article) 
(glide.knowman.text.check_can_read)

Select this check box if users must have ACL-based permission to view text fields on 
the Knowledge [kb_knowledge] table to read article previews in knowledge search 
results.

Defines the number of results to be considered when building the search filters 
(glide.knowman.search.facet_depth)

Define maximum number of knowledge articles to be considered from search results 
for populating search filters.

• Type: string

• Default value: 300

• Location: System Properties

Send notification to approvers and authors in article approval workflow 
(glide.knowman.enable_approval_notification)

Select this check box to send approval email notifications. By default, the property is 
enabled.

Allow articles in the global domain to be checked out or edited by users in 
another domain (glide.knowman.allow_edit_global_articles)

Enter the value as true  to enable checking out and editing global articles for users 
from a domain other than the global domain.

• Type: true | false

• Default value: true

• Location: System Properties

When showing a list of articles through the Knowledge portal (using the 
kb_list UI Page), remove articles the user cannot see before building the list 
(glide.knowman.list.filter)

Enter the value as true  to enable removal of articles that user cannot see before 
building the articles list in the knowledge portal.

• Type: true | false

• Default value: false

• Location: System Properties

If you have large number of articles in your knowledge base, setting this property to 
true  will negatively impact performance.

Create translation task when an article is published 
(glide.knowman.translation.enable_translation_task)

Enter the value as true  to enable creation of translation tasks.

• Type: true | false

• Default value: false

• Location: System Properties
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Property Description

Note: 
When you enable this property, you can’t modify the knowledge base of 
existing articles.

Deny access to a knowledge base when either Can Read or Can 
Contribute user criteria list for the knowledge base isn't specified 
(glide.knowman.block_access_with_no_user_criteria)

Enter the value as true  to deny contribute access to a knowledge base when Can 
Contribute or Can Read user criteria isn’t set.

• Type: true | false

• Default value: true

• Location: System Properties

Override contribute access based on Can Read and Cannot Read user criteria 
at article level (glide.knowman.apply_article_read_criteria)

Enter the value as true  to override contribute access to a knowledge article based 
on Can Read and Cannot Read user criteria at the article level.

• Type: true | false

• Default value: false

• Location: System Properties

Send email notifications on the first day of each 
month for articles expiring in the next month 
(glide.knowman.enable_article_expiry_notification)

Enter the value as true  to send email notifications to a list of recipients about 
articles expiring next month on the first day of each month. The recipients list 
depends on the ownership group and article versioning features. For more 
information, see Knowledge subscriptions.

• Type: true | false

• Default value: false

• Location: System Properties

Determines whether to apply ACLs on the search results 
(glide.knowman.search.apply_acls)

Enter the value as true  to apply knowledge ACLs on knowledge article search 
results.

• Type: true | false

• Default value: true

• Location: System Properties

Note: 
If the glide.knowman.search.apply_acls  is set to true, a knowledge 
base without any articles present in the search results might appear in the 
Knowledge Field Facet when filtering by knowledge base. For more information, 
see Configure filter facet widget instance options.

Comma separated list of all domains of office365 online sites, in 
which the Knowledge management Word add-in will be available 
(sn_km_word.glide.knowman.word.xframe)

Enter a list of all the parent domains in the Microsoft Word Online application in 
which Knowledge Management - Add-in for Microsoft Word is embedded. For 
multiple entries, separate the domains with commas.

• Type: string

• Default value: None

• Location: System Properties

Download the original Word document from the article 
view page in a portal and Workspace. Enabling the 

Enter the value as true  to download the original Word document from the 
knowledge article view page in a portal and Workspace.
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Property Description

property might affect the search relevancy of the article 
(sn_km_word.glide.knowman.enable_document_download)

• Type: true | false

• Default value: false

• Location: System Properties

Determines the duration required to capture the metrics 
(Article Views, Portal page views, and Portal searches). 
glide.knowman.usage_metrics_duration

Enter the value to change the duration to capture the knowledge usage metrics.

• Type: integer

• Default value: 60

• Location: System Properties

Translate a knowledge article from a translation task 
(glide.knowman.translation.enable_translation_task)

Enter the value as true  to enable the translation.

• Type: true|false

• Default value: true

Default language for searching Knowledge Articles 
(glide.knowman.search.default_language)

Enables you to set the default language for searching articles different from the 
logged-in language.

• Type: string

• Default value: None

• Location: System Properties

Following are the two character values to set the default searching language:

• en - English US

• fr - Francais

• es - Español

• it - Italiano

• de - Deutsch

To enable search for different languages simultaneously, navigate to All  > 
Knowledge  > Administration  > Properties  > Enable multi language search  and 
select the check box.

Note: 
If the glide.knowman.search.default_language  system property is 
inactive, you can search one language at a time. If the property is enabled, you 
can search for multiple languages simultaneously.

Provides replacement article for a retired article 
(glide.knowman.enable_article_replacement_on_retire)

Enables you to provide a replacement article to a retired knowledge article. By 
default, the property value is set to true.

• Type: true | false

• Default value: true

• Location: System Properties

Retire the knowledge block attached to an article 
(glide.knowman.allow_retire_block)

Enter the value as true  to retire the knowledge block attached to an article.
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Property Description

• Type: true | false

• Default value: true

• Location: System Properties

Note: 
If you set the (glide.knowman.allow_retire_block) system property 
as true and if:

• An article is associated with the knowledge block a pop-up window displays 
There are articles using this block. Do you still 
want to retire this block?.

• No article is associated with the knowledge block a pop-up window displays 
Are you sure you want to retire this block?.

Determines the recommended document size 
(glide.knowman.import.max_document_size)

Enables you to set the recommended file size (in megabytes) while importing a 
document. By default, the value is set to 30.

• Type: integer

• Default value: 30

• Location: System Properties

Article versioning properties

The knowledge administrator can set knowledge properties that enable users to edit specific 
fields on published articles without creating new versions.

The article versioning feature requires the Knowledge Management Advanced plugin 
(com.snc.knowledge_advanced). For more information, see Activate the Knowledge 
Management Advanced plugin  and Article versioning.

Property Description

Enable article versioning feature 
(glide.knowman.versioning.enabled)

Select the check box to 
enable the article versioning 
feature.

• Type: true | false

• Default value: true

• Location: Knowledge 
> Administration  > 
Properties

Enable minor edits to a published 
article without creating a new version 
(glide.knowman.versioning.enable_minor_edits)

Select the check box to 
enable minor edits to 
published articles and 
associated attachments 
without creating a new 
version.

• Type: true | false

• Default value: false
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Property Description

• Location: Knowledge 
> Administration  > 
Properties

Note: 
To perform the minor 
edits to the published 
articles, the user must 
be the knowledge 
base owner or 
the knowledge 
administrator or the 
knowledge base 
manager.

A comma-separated list of fields that can be edited 
on published articles without creating a new version 
(glide.knowman.versioning.minor_edit_fields)

Enter the fields in a comma-
separated list that can be 
edited on published articles 
without creating a new 
version.

• Type: String

• Default value: valid_to

• Location: Knowledge 
> Administration  > 
Properties

You can also enter 
the property value 
attachments  to add or 
remove any attachments 
associated with a knowledge 
article without checking out 
the article.

Knowledge subscription properties

The knowledge administrator can set configuration properties that enable users to subscribe to 
knowledge bases and knowledge articles.

Property Description

Enable subscribe feature for KM 
(glide.knowman.enable_km_subscription)

Select the check box to 
enable the Knowledge 
subscription feature.

• Type: true | false

• Default value: true

• Location: Knowledge 
> Administration  > 
Properties
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Property Description

List of roles (comma-separated) who can have subscription feature 
(glide.knowman.enable_km_subscription.roles)

Enter the roles in a 
comma-separated 
list that can use the 
Knowledge subscription 
feature.

• Type: String

• Default value: 
knowledge

• Location: Knowledge 
> Administration  > 
Properties

List of workflow states (comma-separated) 
that can have subscription feature 
(glide.knowman.enable_km_subscription.workflow_state)

Enter the workflow 
states for knowledge 
articles in a comma-
separated list that users 
can subscribe to.

• Type: String

• Default value: 
draft,review,published

• Location: Knowledge 
> Administration  > 
Properties

Article quality index properties

The knowledge administrator can set the pass score for AQI reviews using the knowledge 
properties page.

Properties for Article Quality Index

Property Description

Pass score for AQI reviews 
(glide.knowman.aqi_pass_score)

Set the pass score for AQI 
reviews.

• Type: Integer

• Default value: 70

• Range of values possible: 
1-100

List of article workflow states to perform AQI reviews 
(glide.knowman.aqi.article_workflow_states)

Enter the article workflow states, 
in a comma-separated list, where 
users can perform AQI reviews.

• Type: String

• Default value: 
draft,review,published
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External Content Integration Properties

Administrators can configure the properties to add allowed content types and change the UI 
label for the external content integration feature.

Properties for External Content Integration

Property Description

Maximum limit for total size of external content in Knowledge Management (in GB) 
(sn_km_intg.glide.knowman.external.max_content_size)

Note: 
This is a read-only field.

• Type: Integer

• Default value: 2

Maximum size of an external article including its attachments (in MB) 
(sn_km_intg.glide.knowman.external.max_article_size)

Note: 
This is a read-only field.

• Type: Integer

• Default value: 8

An editable, comma-separated list of allowed content types to be processed from the source 
system (sn_km_intg.glide.knowman.external.allow_content_types)

• Type: Comma separated values

• Default value:application/
msword,application/vnd.openxmlformats-
officedocument.wordprocessingml.document,application/
vnd.ms-excel,application/vnd.openxmlformats-
officedocument.spreadsheetml.sheet,application/
vnd.ms-powerpoint,application/vnd.openxmlformats-
officedocument.presentationml.presentation,application/
pdf,text/plain,text/html,image/gif,image/jpeg,image/png

• Other possible values: application/xml, video/mp4, 
audio/mpeg

List of content types not allowed to be processed from the source system 
(sn_km_intg.glide.knowman.external.reject_content_types)

Note: 
This property is read-only and takes precedence over allowed content types.

• Type: Comma-separated values

• Default value: application/octet-stream,application/x-
apple-diskimage,application/vnd.microsoft.portable-
executable

UI Label for indicating external articles in Search Results and Article View Pages 
(sn_km_intg.glide.knowman.external.ui_label_for_external_content)

• Type: String

• Default value: External Content

Actionable Knowledge Feedback Properties

The Knowledge administrator can set configuration properties that would create actionable 
feedback tasks.

Properties for Actionable Knowledge Feedback

Property Description

Create actionable feedback task when an article is flagged. Select the check 
box to enable 
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Properties for Actionable Knowledge Feedback  (continued)

Property Description

(glide.knowman.feedback.enable_actionable_feedback_for_flag)
actionable 
feedback task 
generation 
when an article 
is flagged for 
incorrect or 
inappropriate 
content.

• Type: true|false

• Default value: 
true

• Location: 
Knowledge  > 
Administration 
> Properties

Create actionable feedback task when an article is marked as not helpful 
(glide.knowman.feedback.enable_actionable_feedback_for_helpful)

Select the check 
box to enable 
actionable 
feedback task 
generation when 
an article is 
marked as not 
helpful.

• Type: true|false

• Default value: 
false

• Location: 
Knowledge  > 
Administration 
> Properties

Create actionable feedback task when an article is rated at or 
lower than this value. 0 or no value indicates that actionable 
feedback tasks are not enabled for Rating type feedback 
(glide.knowman.feedback.enable_actionable_feedback_for_rating)

An actionable 
feedback task is 
created when an 
article is rated 
at or lower than 
this value. The 
article is rated on 
a scale of 1-5.

• Type: Integer

• Default value: 
none
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Properties for Actionable Knowledge Feedback  (continued)

Property Description

• Location: 
Knowledge  > 
Administration 
> Properties

Create actionable feedback task only when feedback details are provided for the 
negative feedback 
(glide.knowman.feedback.enable_explicit_feedback)

Select the check 
box to enable 
actionable 
feedback task 
generation for 
the negative 
feedback.

• Type: true|false

• Default value: 
false

• Location: 
Knowledge  > 
Administration 
> Properties

Note: 
Set the 
property 
to True  to 
deactivate 
feedback 
task 
generation 
if:

• The 
feedback 
dialog 
box is 
close or 
cancel

• Other 
option is 
chosen 
and no 
reason 
provided

Group ownership properties

The knowledge administrator can set group ownership properties that enable the use of 
ownership groups for knowledge articles and decide who can edit and approve a published 
knowledge article.
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Property Description

Enable ownership group for Knowledge articles 
(glide.knowman.ownership_group.enabled)

Select the check box 
to enable associating 
ownership groups 
with knowledge 
articles.

Note: 
Once you 
have set this 
property 
to true, try 
not to change 
it to false. 
Before setting 
this property 
back to false, 
manually 
reassign all 
knowledge 
articles 
associated with 
any ownership 
group, close 
all article 
approvals sent 
to ownership 
groups, and 
resolve all open 
feedback tasks 
assigned to 
ownership 
groups.

• Type: true | false

• Default value: false

• Location: 
Knowledge  > 
Administration  > 
Properties

Retain contribute access for author or reviser 
of knowledge article linked to ownership group 
(glide.knowman.ownership_group.override)

Select the check 
box to enable the 
author and reviser 
of a knowledge 
article to retain 
contribute access to 
the article even when 
an ownership group 
is associated with the 
article.
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Property Description

• Type: true | false

• Default value: false

• Location: 
Knowledge  > 
Administration  > 
Properties

Allow approval of self-authored article as ownership group member 
(glide.knowman.ownership_group.allow_self_approval)

Select the check box 
to allow ownership 
group members 
to approve self-
authored articles for 
publication.

• Type: true | false

• Default value: true

• Location: 
Knowledge  > 
Administration  > 
Properties

Quick start tests for Knowledge Management

Validate that Knowledge Management  still works after you make any configuration change, such 
as apply an upgrade or develop an application. Copy and customize these quick start tests to 
pass when using your instance-specific data.

Knowledge Management  quick start tests require activating the Knowledge Management 
Core plugin (com.glideapp.knowledge), the Knowledge Management Advanced 
Installer plugin (com.snc.knowledge_advanced.installer), the Knowledge Blocks plugin 
(com.snc.knowledge_blocks), and the Customer Service Management Demo Data plugin 
(com.snc.customerservice.demo).

KM: Knowledge Management test suite

Test Description Release version

KM : Create KCS Template 
Article with Approval Publish 
workflow

Verify the creation of a KCS 
template article with approval 
publish workflow.

Note: 
Requires the Knowledge 
Management Advanced 
Installer plugin.

Madrid

KM: Create MultiVersioned 
standard Article with approval 
publish workflow

Verify the creation of a 
multi-versioned standard 
article with approval publish 
workflow.

Madrid
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KM: Knowledge Management test suite  (continued)

Test Description Release version

Note: 
Requires the Knowledge 
Management Advanced 
Installer plugin.

KM: Article level subscription Verify that users can 
subscribe to a knowledge 
article.

Note: 
Requires the Knowledge 
Management Advanced 
Installer plugin.

New York

KM: User criteria covering 
canRead and canContribute 
for KnowledgeBase and 
canRead at Article level

Verify the creation of canRead 
and canContribute user 
criteria for knowledge base 
and canRead user criteria for 
article.

Note: 
Requires the Knowledge 
Management Core 
plugin.

Madrid

KM: Create a KCS article from 
a case

Verify the creation of a KCS 
article from a case.

Note: 
Requires the Knowledge 
Management Advanced 
Installer and Customer 
Service Management 
Demo Data plugins.

Madrid

KM: Knowledge Base Level 
Subscriptions

Verify that users can 
subscribe to a Knowledge 
Base.

Note: 
Requires the Knowledge 
Management Advanced 
Installer plugin.

New York

KM: AQI Verify the creation, 
assignment, and review of an 
AQI checklist.

New York
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KM: Knowledge Management test suite  (continued)

Test Description Release version

Note: 
Requires the Knowledge 
Management Advanced 
Installer plugin.

KM: Requestor performs 
search, view the article, 
provide feedback (Helpful No 
with Feedback Task)

Verify the search request, 
review, provision of feedback 
as not helpful, and creation 
of a feedback task for an 
article on the Knowledge 
Management  Service Portal.

Note: 
Requires the Knowledge 
Management Advanced 
Installer plugin.

New York

KM: Create and edit an article 
from Feedback Task form

Confirm the availability 
of the Create Article  and 
Edit Article  buttons on a 
Knowledge Feedback Task 
form.

Note: 
Requires the Knowledge 
Management Advanced 
Installer plugin.

New York

KM: Search for pinned articles 
and checking the highest click 
rank

Verify the search request and 
that the click rank value of 
a pinned article was added 
to the Knowledge Searches 
(ts_query_kb) table.

Note: 
Requires the Knowledge 
Management Advanced 
Installer plugin.

New York

KM: Create an Ownership 
Group and check 
edit permissions and 
subscriptions

Verify the assignment of 
an article to an ownership 
group, that all members of 
the ownership group are 
subscribed to the article, and 
have permission to edit.

New York
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KM: Knowledge Management test suite  (continued)

Test Description Release version

Note: 
Requires the Knowledge 
Management Advanced 
Installer plugin.

KM: Create, search for, and 
view knowledge articles with 
knowledge blocks

Verify the creation of a 
knowledge block and its 
addition to a knowledge 
article. Also, verify that the 
knowledge block content is 
searchable.

Note: 
Requires the Knowledge 
Blocks plugin.

Orlando

KM: Validate the Knowledge - 
Approval Retire workflow

Verify the success of 
Knowledge - Approval 
Retire workflow by retiring a 
published knowledge article.

Note: 
Requires the Knowledge 
Management Advanced 
Installer plugin.

Orlando

KM: Validate feedback task 
assignment to the ownership 
group manager

Verify the assignment of 
a feedback task to the 
ownership group manager of a 
knowledge article.

Note: 
Requires the Knowledge 
Management Advanced 
Installer plugin.

Orlando

KM: Validate that the article 
template selector includes 
knowledge bases and article 
templates

Verify that the article 
template selector includes 
all knowledge bases with 
contribute access and article 
templates applicable to each 
knowledge base.

Note: 
Requires Knowledge 
Management Advanced 
Installer.

Orlando

KM: Validate the Knowledge - 
Approval Publish workflow

Verify the success of a 
Knowledge - Approval 

Orlando
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KM: Knowledge Management test suite  (continued)

Test Description Release version

Publish workflow by recalling, 
rejecting, and then approving 
a knowledge article through 
the approval process.

Note: 
Requires the Knowledge 
Management Advanced 
Installer plugin.

KM: Make an outdated version 
of an article the latest version

Verify that an outdated version 
of a knowledge article is made 
the latest version.

Note: 
Requires the Knowledge 
Management Advanced 
Installer plugin.

Orlando

KM: Validate that the mapped 
related articles appear in the 
Related articles widget

Verify that the related articles 
mapped to a knowledge 
article appear in the Related 
articles widget on the 
knowledge article view page.

Note: 
Requires the Knowledge 
Management Advanced 
Installer plugin.

Orlando

KM: Validate that the mapped 
related catalog items appear 
in the Related items widget

Verify that the related 
catalog items mapped to a 
knowledge article appear in 
the Related items widget on 
the knowledge article view 
page.

Note: 
Requires the Knowledge 
Management Advanced 
Installer plugin.

Orlando

KM: Validate that a versioned 
article is created, published, 
checked out, and retired

Verify the success of UI 
actions on a versioned 
knowledge article by creating, 
publishing, updating, and 
retiring the knowledge article 
in Agent Workspace.

Quebec

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3524



KM: Knowledge Management test suite  (continued)

Test Description Release version

Note: 
Requires the Knowledge 
Management Advanced 
Installer plugin.

KM: Verify the scheduled 
publish feature for knowledge 
articles

Verify the scheduled publish 
feature for knowledge articles 
by creating an article in 
approval publish workflow, 
putting it for scheduled for 
publish and observing the 
change in workflow state from 
theScheduled for publish 
state to the Published  state.

Note: 
Requires the Knowledge 
Management Advanced 
Installer plugin.

Quebec

KM: Validate the Knowledge - 
Approval Publish workflow in 
Agent Workspace

Verify the success of a 
Knowledge - Approval Publish 
workflow by recalling and then 
approving a knowledge article 
through the approval process 
in Agent Workspace.

Note: 
Requires the Knowledge 
Management Advanced 
Installer plugin.

Quebec

Related topics

Quick start tests

Understanding access to the Knowledge knowledge base

User criteria are available to manage access to the Knowledge knowledge base.

The Knowledge knowledge base is provided as a demo example in the Knowledge Management 
application. Starting from the Paris release, user criteria were added to the Knowledge 
knowledge base to enable you to control access for guest (unauthenticated) users:

• Any User user criteria in Can Read, which enables any user to read articles in the Knowledge 
knowledge base.

• Guest User in Cannot Read, which prevents guest or unauthenticated users from reading 
articles in the Knowledge knowledge base.
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Note: 
If you are on a release version prior to the Paris release, see Configure access to knowledge 
bases for unauthenticated users  for information about managing access without any user 
criteria.

Although you can continue to use the Knowledge knowledge base consider creating your 
own knowledge base to store, share, and manage content. You can configure access to your 
knowledge bases through user criteria. For more information, see Create a knowledge base.

Knowledge workflows

The publishing and retirement processes for a knowledge article are controlled by workflows 
defined for the knowledge base that the article belongs to.

You can assign different workflows to each  Knowledge Base  .

You can use one of the default workflows, or create your own workflows to define custom 
publishing and retirement processes for different types of knowledge.

For the workflows that require approval, you can configure which users can approve or reject by 
editing the getApprovers()  function in the KBWorkflow  script include.

Default knowledge workflows

Workflow Description

Knowledge - Approval Publish Requests approval from a manager of the 
knowledge base. Articles in approval are In 
Review state before moving to Published state 
once approved or to Scheduled for publish 
if set to publish later. If the manager rejects 
the request, the workflow is canceled and the 
article remains in Draft state.

If ownership groups is enabled, email 
notifications with a link to the article are sent to 
the ownership group members for approval.

If ownership groups is not enabled, email 
notifications with a link to the article are sent to 
knowledge base managers for approval.

A notification is also sent to authors or revisers 
of articles to inform them that their article has 
been approved or rejected.

To turn on approval email notifications, set the 
glide.knowman.enable_approval_notification 
property to true.

Note: 
Only the active user receives the 
notifications.

Knowledge - Approval Retire Requests approval from a manager of the 
knowledge base before moving the article to 
the retired state. The workflow is canceled and 
the article remains in the published state if any 
manager rejects the request.
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Default knowledge workflows  (continued)

Workflow Description

If ownership groups is enabled, email 
notifications with a link to the article are sent to 
the ownership group members for approval.

If ownership groups is not enabled, email 
notifications with a link to the article are sent to 
knowledge base managers for approval.

Knowledge - Instant Publish Immediately publishes a draft article without 
requiring an approval, or publishes on the 
scheduled publish date if set to publish later.

Knowledge - Instant Retire Immediately retires a published article without 
requiring an approval.

Knowledge - Publish Knowledge A subflow that moves the knowledge article to 
the published state. You can use this subflow 
when defining your own workflow.

Knowledge - Retire Knowledge A subflow that moves the knowledge article 
to the retired state. You can use this subflow 
when defining your own workflow.

Note: 

• Only administrators and knowledge administrators can view the retired knowledge 
articles. To reuse a retired article, administrators and knowledge administrators can 
republish the article. For more information, see Republish a retired article.

• An article and its translations have a parent-child relationship. Retiring a parent article 
does not automatically retire all its translated child articles.

Email notifications for approval workflows

You can send email notifications for approval workflows.

• Notify approvers about knowledge articles submitted for their approvals.

• Notify authors about the approval status of their knowledge articles.

To send email notifications for approval workflows, enable the Send 
notification to approvers and authors in article approval workflow  property 
(glide.knowman.enable_approval_notification). Beginning with New 
York, the property is enabled by default. Existing customers on release versions 
prior to New York can enable this property to send email notifications. Disable 
any custom notifications for article approvals before enabling this property. If the 
glide.knowman.enable_approval_notification  property is not available, an 
administrator can create the property and set its value to true. For more information, see 
Knowledge Management properties.

Related topics

Knowledge article states

Approve an article that is being reviewed

Retire a versioned article
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Knowledge Management Service Portal properties

Knowledge Management Service Portal properties determine how information is displayed on 
the Knowledge portal. You must have the admin role to set configuration properties.

The following system properties are set to direct users to the Knowledge Management Service 
Portal homepage, and to specify the URL suffix for the homepage.

Property Description

sn_km_portal.glide.knowman.serviceportal.enable_redirect Directs users 
to the desired 
Knowledge 
homepage.

• Type: true|false

• Default value: 
false

Set to true  to 
redirect users 
navigating to v2 
or v3 pages to 
the Knowledge 
Management 
Service Portal 
homepage.

Note: 
This 
property is 
not honored 
for the 
following 
use cases:

• Contextual 
search 
in the 
Incident 
form

• Connect

• Global 
search

sn_km_portal.glide.knowman.serviceportal.portal_url The URL suffix for 
the Knowledge 
Management 
Service Portal. 
The default is kb.

The Knowledge Management Service Portal supports the Knowledge Management V3 
properties. Configuring widget instance options on the portal pages can override these 
properties.
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Note: 

Starting with the Washington DC  release, the Knowledge Management  v3 
homepage (com.snc.knowledge3) is being prepared for deprecation in the 
future Y release. It is replaced by the Knowledge Management  Service Portal 
(com.snc.knowledge_serviceportal), which is active by default for customers on Madrid 
and later releases. For more information about the new experience, see Knowledge 
Management Service Portal homepage features.

Knowledge Management v3 homepage and Knowledge Management Service Portal 
comparison

A comparison of the features available on the Knowledge Management v3 homepage and the 
Knowledge Management Service Portal.

Note: 

Starting with the Washington DC  release, the Knowledge Management  v3 
homepage (com.snc.knowledge3) is being prepared for deprecation in the 
future Y release. It is replaced by the Knowledge Management  Service Portal 
(com.snc.knowledge_serviceportal), which is active by default for customers on Madrid 
and later releases. For more information about the new experience, see Knowledge 
Management Service Portal homepage features.

Page Component V3 Homepage
Knowledge 
Management 
Service Portal

Create an article Y Y

Import an article Y N

Knowledge bases Y Y

Featured content Y Y

Most useful Y Y

Most viewed Y Y

Language 
selection menu

Y N

Home page

Search text box Y Y

Create an article Y N

Import an article Y N

Search box 
with language 
selection

Y Y

Relevancy Y Y

Last updated 
(newest)

Y Y

Views Y Y

Sort by

Alphabetical N Y

Search results 
page

Filter by Knowledge bases Y Y
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Page Component V3 Homepage
Knowledge 
Management 
Service Portal

Categories Y Y

Authors Y Y

Tags N Y

Resource N Y

Rating N Y

View count N Y

Authored by Y Y

Article number Y Y

Last modified Y Y

Category Y Y

Number of views Y Y

Star rating Y Y

Relevancy rank Y Y

Tags Y N

Article meta data

Attachments Y Y

Back button Y N

Create Favorite 
icon

Y N

Navigation 
hierarchy path

Y Y

Article meta data

• Article number

• Article version

• Authored by

• Last modified

• Number of 
views

• Star rating

Y Y

Subscribe option Y Y

Flag article 
option

Y Y

Create incident 
option

Y Y

Edit option Y Y

Article view page

Article language 
selection option

Y Y
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Page Component V3 Homepage
Knowledge 
Management 
Service Portal

Helpful yes/no 
option

Y Y

Star rating Y Y

Text box for 
comments

Y Y

Live feed 
comment

Y N

Copy permalink Y Y

Most Recent 
Tasks widget

N Y

Affected 
Products widget

N Y

Most Viewed 
widget

N Y

Most Useful 
widget

N Y

The sn_km_portal.glide.knowman.serviceportal.enable_redirect  property 
is not honored for the following use cases:

• Contextual search in the Incident form

• Connect

Related topics

Import a Word document to a knowledge base

Import a Word document to a knowledge base using Knowledge Management v3

SEO for canonical URLs and localized versions of knowledge articles

Improve the searchability of knowledge articles by adding tags for canonical URLs and 
hreflang  tags for translated knowledge articles.

You can add the default tags for canonical URLs and hreflang  tags by selecting the Use 
SEO script  check box on the Knowledge Article View [kb_article_view] page record. For more 
information, see Enable SEO for canonical URLs and localized versions of a portal page .

When the Use SEO script  option is selected:

• The canonical URLs for a knowledge article are added to the knowledge article view page.

Example canonical URL: https://<instance name>.servicenow-com/csp?
id=kb_article_view&sysparm_article=<article number>

• The hreflang  tags for the translated versions of a knowledge article are added to the 
knowledge article view page.

Example URL with an hreflang  tag: <link rel=“alternate” 
href=“https://<instance name>.servicenow-com/csp/fr?
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id=kb_article_view&sysparm_article=<article number>” 
hreflang=“fr”/>

Note: 
A self-referencing hreflang  URL is also added for the language of current knowledge 
article.

For example, an English knowledge article is viewed by visiting a URL with the following 
format:

https://<instance name>.servicenow-com/csp/?
id=kb_article_view&sys_kb_id=<sys_id>

In addition to the hreflang  tags added for translations, the English language self-
referencing hreflang  tag is added:

<link rel=“alternate” href=“https://
<instance name>.servicenow-com/csp/?
id=kb_article_view&sys_kb_id=<sys_id>” hreflang=“en”/>

Script includes for canonical URLs and hreflang tags

By default, the knowledge article view page uses the SPSEOHeaderTagsArticleViewSNC 
script include to add the SEO tags for canonical URLs and hreflang  tags.

The following table describes the script includes for adding canonical URLs and hreflang  tags 
to Service Portal pages, including the knowledge article view page.

Script includes for canonical URLs and hreflang tags

Script include Description

SPSEOHeaderTagsSNC Includes the default implementation for the canonical 
URLs and hreflang  tags for Service Portal pages.

This script include is read-only.

For more information, see Enable SEO for canonical URLs 
and localized versions of a portal page .

SPSEOHeaderTags Facilitates overriding the default implementation in the 
SPSEOHeaderTagsSNC  script include for Service 
Portal pages.

The SPSEOHeaderTags  script include extends the
  SPSEOHeaderTagsSNC  script include.

 SPSEOHeaderTagsArticleViewSNC Overrides the generateHrefLangArray  and 
generateCanonicalURL  functions for the 
knowledge article view page configured in the 
SPSEOHeaderTags  script include.

The SPSEOHeaderTagsArticleViewSNC 
script include is read-only and extends the
   SPSEOHeaderTags  script include.
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Script includes for canonical URLs and hreflang tags  (continued)

Script include Description

SPSEOHeaderTagsArticleView Facilitates overriding the default implementation in the 
SPSEOHeaderTagsArticleViewSNC  script include 
for the knowledge article view page.

The SPSEOHeaderTagsArticleView  extends 
the  SPSEOHeaderTagsArticleViewSNC  script 
include.

As an administrator, you can add canonical URLs, hreflang  tags, and any custom headers for 
knowledge articles by updating the SPSEOHeaderTagsArticleView  script include. For 
more information, see Configure custom SEO tags for canonical URLs and localized knowledge 
articles.

Article versioning changes

Article versioning introduces new actions that allow knowledge users to create and revise 
versions of existing articles. It also introduces new fields and related lists to the Knowledge form, 
new columns to the Knowledge list, and updates to Knowledge dashboard reports.

New user actions

As part of creating article versions, users can:

• Check out a published article and create another version by clicking Checkout  on the 
Knowledge form.

Note: 
Only the author, knowledge base owner, and users with the knowledge_admin role can 
edit an article in the Draft state.

• Recall an article that is being reviewed or scheduled for publish by clicking Recall  on the 
Knowledge form.

• Select a previously published article in the Outdated state and make it the current published 
version by clicking Make this currentin the Knowledge form header.

Note: 
To edit a published article without having to create a new version, make sure the 
glide.knowman.versioning.enable_minor_edits  property is enabled.

Changes to the Knowledge list

The article versioning feature adds the following to the Knowledge list:

• The Version  column displays the article version number. The Knowledge list displays multiple 
versions of an article.

• The Workflow  column includes the new Outdated  state.

Changes to the Knowledge form

The article versioning feature adds the following to the Knowledge form:
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• The Version  field displays the article version number.

• The Display number  field displays a combination of the article number and the version 
number. For example, KB0010004 v1.02. All references to a knowledge article use this display 
number.

• The Base Version  field displays the knowledge article number and version on which the 
current article is based.

• The Revised By  field displays the name of the user who checked out a published article and 
created a new version.

• The Article Versions  related list displays a list of all versions for an article. From this list,you 
can:

◦ Click the Version  to view a specific version of an article.

◦ Click the View Article  related link to see the article page view.

Note: 
If necessary, configure the form to display the fields and the related list.

Changes to Knowledge modules

The article versioning feature introduces the following Knowledge module changes:

• My Knowledge Articles

◦ For a knowledge user, this module includes records for the articles authored by the user as 
well as records for each article revised by the user.

◦ For a knowledge reviser, this module includes records for the articles published by the user 
as well as records for each article revised by the user.

• My Flagged

◦ For a knowledge user, this module includes records for each revision made to articles 
authored by the user.

◦ For a knowledge reviser, this module includes records for each article revised by the user.

Note: 
Users that have customized these modules do not see these changes.

Changes to Knowledge Management dashboard reports

The Knowledge Management Overview dashboard reports have been updated to include article 
versioning-related changes when the Knowledge Management Advanced plugin is activated.

• Articles Flagged in the Last 30 Days

• Articles Marked Not Useful in the Last 30 Days

• Articles Used per Month

• Knowledge use

• Knowledge view

• Knowledge updated in past 30 days

• Knowledge flagged in past 30 days

• Knowledge by Workflow state

• Knowledge created by Author

• Knowledge created in past 30 days
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• New Knowledge Articles Created in the Last 30 Days

• Knowledge Ratings for past 30 days

Versioning information available in the Knowledge Management Service Portal

Knowledge search results show the article number and the version number for each article.

Note: 

To display the article version number next to the article number in the search results, 
enable the glide.knowman.search.show_article_number  property in the 
Knowledge Search Properties section of the Knowledge Management Properties page.

If you are accessing an article from the base system or knowledge service 
portals using the URL to a KB article, you must also include the article version 
number in the URL. For example, to access the KB0000005 knowledge 
article, instead of using the https://<instance name>/sp?
id=kb_article&sys_id=KB0000005  as the URL, you must use https://
<instance name>/sp?id=kb_article&sys_id=KB0000005%20V1.0  to view 
the article.

The article view page shows a version history section for articles that have been updated. This 
section includes the version numbers, date updated, and the name of the author or reviser.

• Click Latest version  or the version number and current state to expand the version history 
section.

• Click the version number to open that particular version of the article.

• When viewing an outdated article, a message informs the user that a newer updated version is 
available. The message includes a link to the latest version.

Feedback on article versions

With the article versioning feature, users can view and contribute to feedback on the current 
versions of knowledge articles.

For more information about feedback options, see Knowledge feedback.

Feedback option How this option works with article versioning

Rating an article The average rating for an article is carried 
over to the checked out version. The average 
rating calculation updates and displays on the 
current version of the article.

Marking an article as helpful The helpfulness percentage of a previous 
version of an article is also considered 
for a new version when displayed in the 
helpfulness column on the homepage.

Comments The Comments section at the bottom of an 
article displays comments from previous 
versions unless Live Feed is enabled. Live 
Feed only shows comments for the current 
version.
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(continued)

Feedback option How this option works with article versioning

Flagging an article Checking out an article or setting a previous 
version to the current version resets the 
flagged value to false.

View count The view count is carried over to the checked 
out article. Any view of a version of an 
article increments the view count of all the 
subsequent published versions. Views to a 
newer version of an article do not affect the 
view count of previous versions. When a draft 
article is published, the total view count shows 
sum of previous published article view count 
and its own standalone view count.

Use count The use count is carried over to the checked 
out article. Any use of a version of an article 
increments the use count of all subsequent 
versions. Any use of a newer version of 
an article does not affect the use count of 
previous versions.

Knowledge article version numbers

Knowledge article version numbers follow a specific pattern. Increments to the version number 
depend on the revision type.

Article version numbers follow this pattern: <major release number.minor release number>.

The type of revision being made to an article determines the increment. A minor revision 
increments the version number by 0.01. A major revision, such as publishing an article, 
increments the version to the next whole number, for example, from version 2.02 to 3.0.

The following example illustrates the life cycle of a versioned article and the changes to the 
version number.

User action Article state Version number

Knowledge author creates a 
new article

Draft 0.01

Knowledge author makes 
a change and updates the 
article.

Draft 0.01

Knowledge author submits the 
article for review.

Review 0.02

Knowledge author recalls 
the article to make another 
change.

Draft 0.03

Knowledge article submits the 
article for review

Review 0.04

Approver rejects the article 
and requests a change.

Draft 0.05
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User action Article state Version number

Knowledge author makes 
the change and submits the 
article for review.

Review 0.06

Approver approves the article Scheduled for publish 0.07

Article is published Published 1.0

Knowledge author checks out 
the published article.

Draft 1.01

Knowledge author submits the 
article for review.

Review 1.02

Approver approves the article Scheduled for publish 1.03

Article is published

When the version 2.0 article 
is published, the state of the 
version 1.0 article changes to 
Outdated.

Published 2.0

Any change to the state of an article results in a version increment, except to and from the 
Pending retirement, Retired, and Outdated  states.

Note: 
To know more about minor version edits, see Article versioning changes.

Knowledge article version information

Users can view version information for a knowledge article from the Knowledge view page.

The knowledge article number and the version number appear at the top of the article, just below 
the title. Clicking the version number expands the version history section, which includes a list of 
the available article versions. User roles determine what is included in this list:

• Users with read access to a knowledge base can see the latest published version and previous 
major versions.

• Users with read and contribute access to a knowledge base can see the latest published 
version, previous major versions, and any draft or review versions.

You can view any of the previous versions of an article by clicking the version number in the list. 
When you view a previous version, a message at the top of the article indicates that an updated 
version is available.

At the bottom of a knowledge article, you can see additional information about an article, 
including the name of the author or revisor and the date that the article was last modified.

Validity of a knowledge article

Knowledge article validity is the date a knowledge article expires. Articles do not appear in 
search results after the Valid to  date or if the Valid to  date is blank.

Decide when to expire a knowledge article by using the Valid to  field in the Knowledge form. The 
Knowledge form is available when creating or editing a knowledge article.

When you create or edit a knowledge article, a default value appears in the Valid to  field. As an 
article author or editor, you can select whether to keep or change the default Valid to  date.
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Note: 
If the system date format or user preferences is set to use yy  year format, you might face 
issues when the Valid to  date is set to the default date. Contact your system administrator 
or modify the user preferences to use a date format with the yyyy  year format. For more 
information, see Global date and time field format  and Personalize the system date 
format  topics.

Default article validity when creating a knowledge article

The default value of the Valid to  field is derived from the Article Validity  field configured for the 
knowledge base (see Create a knowledge base). The Valid to  date starts from the date the article 
was created until the number of days specified in the Article Validity  field. If the Article Validity 
field is blank, the default date in the Valid to  field for the knowledge article is set to January 1, 
2100.

Default article validity when editing a knowledge article

If the article versioning feature is enabled, the default value of the Valid to  date in the updated 
article version is automatically set as described in the following table.

Valid to date in the updated article version

Article Validity 
value in the 
associated 
knowledge 
base

Valid to 
default 
value

Notes

Blank Earlier 
version 
Valid 
to  date 
value

If the Article Validity  field in the knowledge base associated with 
the article is blank, the Valid to  date value from the earlier version of 
the article is retained.

Is not blank Article 
updated 
date + 
article 
validity

If the Article Validity  field in the knowledge base associated with 
the article is not blank, the Valid to  date is automatically updated to 
start from the date the article was updated until the number of days 
specified in the Article Validity  field.

If you move a knowledge article to another knowledge base, the default value of the Valid to  date 
in the updated article is automatically set as described in the following table.

Valid to date when moving a knowledge article to another knowledge base

Article Validity 
value in the 
updated 
knowledge 
base

Valid to 
default 
value

Notes

Blank Earlier 
Valid to 
date value

If the Article Validity  field in the selected knowledge base is blank, 
the earlier Valid to  date value is retained for the knowledge article.

Is not blank Article 
updated 

If the Article Validity  field in the selected knowledge base isn't 
blank, the Valid to  date is automatically updated to start from the 
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Valid to date when moving a knowledge article to another knowledge base  (continued)

Article Validity 
value in the 
updated 
knowledge 
base

Valid to 
default 
value

Notes

date + 
article 
validity

date the article was updated until the number of days specified in 
the Article Validity  field.

Note: 
If the dictionary value of the Valid to  field is modified, this dictionary value overrides the 
default value of the Valid to  field calculated according to the Article Validity  field.

Email notifications for expiring knowledge articles

On the first day of each month, the application sends an email notification to a list of authorized 
recipients to remind them about articles that are about to expire in the next month. The recipient 
can then extend the Valid to  date to continue using the article. For more information, see 
Managing email notifications in Knowledge Management.

Knowledge article states

Knowledge article versions can be in one of several states as it progresses through the creation 
cycle.

Note: 
You need to activate the Knowledge Management Advanced 
plugin (com.snc.knowledge_advanced) and set the 
glide.knowman.versioning.enabled  system property to true. For more 
information, Activate the Knowledge Management Advanced plugin  and Article versioning 
properties.

State Description

Draft The article is in the process of being created.

Note: 
A versioned knowledge article in the 
Draft  state can be modified only by the 
author or reviser with the contribute 
access to the knowledge base, owner 
of a knowledge base, users with the 
admin and knowledge_admin role, and 
ownership group members, if ownership 
group is added to the article.

Review The draft version of the article is sent to 
reviewers to approve or reject.

Scheduled for publish The draft version of a knowledge article is 
scheduled for publishing on a future date.

Published The article is approved and published. When 
the state of an article changes to Published, 
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State Description

the state of any previous published versions of 
that article changes to Outdated.

Note: 
After a knowledge article with an 
ownership group is approved, only 
the owner of a knowledge base and 
ownership group members have 
contribute access to the article.

Pending retirement The published article is selected for 
retirement, pending approval.

Retired The published article is retired.

Retired knowledge articles cannot be 
searched for by external users or customers. 
To reuse a retired article, create a new article 
with the same content, which is published 
once approved.

Outdated A more recent version of the article has been 
published. End users can read published 
articles as well as the outdated versions.

Related topics

Knowledge access controls

Knowledge subscription email notification templates

The knowledge subscription feature uses email notification templates to send subscription 
notifications to knowledge users.

Email template Subscription type

KM Subscription: Article published Knowledge base

KM Subscription: Article revised in KB Knowledge base

KM Subscription: Article checked out Knowledge article

KM Subscription: Article revised Knowledge article

KM Subscription: Article commented Knowledge article

Users with the admin or knowledge_admin role can customize these email notification templates. 
To locate the template, navigate to System Notifications  > Email  > Notifications. For more 
information about customizing a template, see Create an email notification .

Subscription notifications include a link at the bottom of the email to the user's Notification 
Preferences page.

Analytics and Reporting Solutions for Knowledge Management

The following topics provide information on Platform Analytics Solutions  and Demand Insights 
dashboards for Knowledge Management.
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Knowledge Management  Platform Analytics Solutions

Platform Analytics Solutions  contain preconfigured dashboards. These dashboards contain 
actionable data visualizations that help you improve your business processes and practices.

Platform Analytics Solutions

Platform Analytics  data visualizations use Performance Analytics  indicator data to show you data 
over time, helping you analyze your business processes and identify areas of improvement. With 
Platform Analytics Solutions, you can get value from Performance Analytics  for your application 
with minimal setup. You can always create your own objects as well.

Important: 
Set up and test Platform Analytics Solutions  on a non-production instance before enabling 
them in production.

To enable the solution for Knowledge Management, an admin can navigate to Performance 
Analytics  > Guided Setup. Click Get Started  then scroll to the section for Knowledge 
Management. The guided setup takes you through the entire setup and configuration process.

Note: 
You must Activate the Knowledge Management Advanced plugin.

Domain separation and 'Run As' user

In some solutions, System Administrator is the Run As  user for data collection jobs in the 
Platform Analytics Solutions. In other solutions, the Run As  user for data collection jobs is left 
blank. Verify that the Run As  user exists on the instance, and that this user has the appropriate 
level of access. An inappropriate Run As  user can cause errors or limit the data that is collected. 
This setting only has an effect if domain separation is enabled.

New and deprecated versions of this solution

In London , this Solution was replaced with a new version, com.snc.pa.knowledge_v2. If 
you activated an earlier version of the Solution and then upgraded your instance, you still have 
and can still use the earlier Solution. You can also activate the newer version without losing data 
from existing indicators and breakdowns. If you activate the newer version, run a historical data 
collection job to populate any new indicators and breakdowns.

Add Self-Service Analytics to Knowledge Management dashboards

If you have Self-Service Analytics activated on an instance, you can add Self-Service 
analytics widgets to your Performance Analytics  dashboards or a Service Portal. To obtain 
a ready-made set of indicators and breakdowns, activate the Self-Service Analytics PA 
(com.snc.pa.self_service_analytics) plugin. Find the Self-Service indicators 
through the Performance Analytics  Admin Console, then create widgets and add them to your 
dashboard or portal. Also activate the [SSA] Self-Service Analytics data collection job.

Related topics

Platform Analytics Solutions  

Activate your Performance Analytics subscription

Knowledge Management dashboard

The Knowledge Management dashboard helps knowledge content owners and managers 
to determine the usage and quality of their knowledge content and confirm that the proper 
processes and procedures are being followed for content creation.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3541

https://www.webstg.servicenow.com/docs/access?context=content-packs-in-form-analytics&version=washingtondc&pubname=washingtondc-now-intelligence&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=content-packs-in-form-analytics&version=washingtondc&pubname=washingtondc-now-intelligence&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=content-packs-in-form-analytics&version=washingtondc&pubname=washingtondc-now-intelligence&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=c_PremiumPerformanceAnalytics&version=washingtondc&pubname=washingtondc-now-intelligence&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=c_PremiumPerformanceAnalytics&version=washingtondc&pubname=washingtondc-now-intelligence&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=c_PremiumPerformanceAnalytics&version=washingtondc&pubname=washingtondc-now-intelligence&ft:locale=en-US


Note: 

• This documentation refers to the Performance Analytics Content Pack for Knowledge 
Management v2, introduced in London. It does not refer to the older, deprecated version.

• To enable the solution for Knowledge Management, an admin can navigate to 
Performance Analytics  > Guided Setup. Click Get Started then scroll to the section 
for Knowledge Management. The guided setup takes you through the entire setup and 
configuration process.

• To access the Knowledge Management dashboard, navigate to All  > Self-Service  > 
Dashboard. In the Search dashboard  field, search for the Knowledge Management 
dashboard.

Knowledge Management dashboard - Content Usage tab
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Knowledge Management dashboard - Content Governance tab

Knowledge Management dashboard -Content Quality tab
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End users and roles

End user and goal Required role Benefits

Knowledge Manager: Needs 
to identify areas of concern 
and direct resources optimally.

knowledge_manager Can review the velocity of 
content publication and see 
what content customers are 
searching for, to direct the 
efforts of content owners more 
efficiently.

Knowledge Administrator: 
Needs clear visibility into 
the usage and quality of 
knowledge content.

knowledge_admin Can plan and direct content 
creation.

Content creator: Needs to see 
the usage of content they own 
and areas for improvement

pa_viewer Can see what content in their 
subject area that customers 
are looking for.

CSM Knowledge Management dashboard indicators

The CSM Knowledge Management dashboard provides three views, into content usage, content 
governance, and content quality.

The Knowledge Management dashboard presents the following key performance indicators:

% of Knowledge Articles Published

A daily calculation using the formula [[Number of knowledge articles 
published]] / [[Number of knowledge articles active]]

Monthly Average Article Rating

A monthly calculation of the sum of all article ratings for the month divided by the 
number of knowledge articles rated for the month.

Average Click Rank

A monthly calculation using the formula [[Sum of knowledge search 
ranks]] / Number of knowledge searches with rank]]

Click Through Rate

A monthly calculation using the formula Number of knowledge searches 
with rank]] / [[Number of knowledge searches]]

Average Time to Publish

The average time to publish is recalculated daily, as a number of days. The goal of 
the indicator is for scores to minimize.

Number of Active Users Who Performed Searches - Monthly

The number of authenticated users who performed at least one search of the 
knowledge base in the preceding month. The goal is for the number to maximize.

Number of Active Users Who Viewed Articles - Monthly

The number of authenticated users who viewed at least one knowledge article in 
the preceding month. The goal is for the number to maximize.

Number of Knowledge Searches with Rank - Monthly

The number of knowledge searches in a month where the Highest Click Rank has a 
value higher than zero. The goal is for the number to maximize.

Number of Knowledge Searches - Monthly
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The number of knowledge searches in a month. The goal is for the number to 
maximize.

Number of Knowledge Articles Rated - Monthly

The number of knowledge feedback records created in a month, excluding records 
where the Rating field is empty. The goal is for the number to maximize.

Number of Knowledge Articles Published

A daily count of the total number of knowledge articles that have entered the 
Published state. The goal is for the number to maximize.

Number of Knowledge Articles Active

A daily count of the number of active knowledge articles with up-to-date workflows. 
The goal is for the number to maximize.

Sum of Knowledge Article Rating - Monthly

The monthly sum of all knowledge article ratings. This indicator is used only to 
calculate the average monthly article rating.

Sum of Knowledge Search Ranks - Monthly

The sum of feedback rankings of knowledge searches made in a month, excluding 
empty Highest Click Rank values. The goal is for the number to maximize.

Average Click Rank for Unauthenticated Users

A monthly calculation of the average click rank for the unauthenticated user 
activity. The score is calculated according to the formula [[Sum of Knowledge 
Search Ranks by Unauthenticated Users - Monthly]]/
[[Number of Knowledge Searches by Unauthenticated user 
with Rank - Monthly]]. A lower value is better.

Click Through Rate for Unauthenticated Users

A monthly calculation of the percentage of click through rate for the 
unauthenticated user activity. The score is calculated according to the formula 
[[Number of Knowledge Searches by Unauthenticated user 
with Rank - Monthly]]/[[Number of Knowledge Searches by 
Unauthenticated user - Monthly]] * 100. A higher value is better.

Number of Knowledge Searches by Unauthenticated Users - Monthly

A monthly count of the knowledge searches by unauthenticated users.

Number of Article Views by Unauthenticated Users - Monthly

A monthly count of the knowledge articles viewed by unauthenticated users.

Sum of Knowledge Search Ranks by Unauthenticated Users - Monthly

A monthly sum of the knowledge search ranks for the unauthenticated user activity.

Number of Knowledge Searches with Rank for Unauthenticated Users - Monthly

A monthly count of the knowledge searches with click rank for the unauthenticated 
user activity.

Breakdowns

The following breakdowns apply to the indicators on the dashboard:

• Time to Publish Groups

• Knowledge Base

• Knowledge Category
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Data visualizations

The dashboards include the following visualizations:

Title Type Description

Articles with 
Inactive 
Authors

Column Active = true and Author.Active = False

Invalid Articles Column Active = true and Workflow is one of Draft, Review, Published, or 
Pending Retirement and Valid to is before today and latest = true

Articles 
Created Over 1 
Year

Column Active = true and Created = before 1 year ago

Articles not 
Published

Column Active = true and Workflow is Draft or Review

Related topics

Dashboards

Knowledge Management  Overview dashboard

The Knowledge Management  Overview dashboard provides an overview of various usage 
metrics associated with knowledge articles. You can view and track knowledge usage and views 
and direct the efforts of content owners more efficiently.

Note: 

If you are upgrading from a previous release, you must activate the Knowledge Overview 
(com.sn_knowledge_overview) plugin to enable the Knowledge Management  Overview 
dashboard. You also need to update the navigation path. For more information, see Update 
the navigation path for the Knowledge Management Overview dashboard.

Enable the responsive dashboard to optimize analytics by setting the 
glide.cms.enable.responsive_grid_layout  system property to true

To access the Knowledge Management  Overview dashboard, navigate to All  > Knowledge  > 
Administration  > Overview. By default, the Article Lifecycle  tab is shown when you first visit the 
dashboard.
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Knowledge Management Overview dashboard

End user and roles

End user and goal Required role Benefits

Knowledge Manager: Identify 
areas of concern and direct 
resources optimally.

knowledge_manager Can review the velocity of 
content publication and see 
what content customers are 
searching for.

Knowledge Administrator: 
Needs clear visibility into 
the usage and quality of 
knowledge content.

knowledge_admin Can plan and direct content 
creation.

Reports

The Knowledge Management  Overview dashboards include various reports.

Title Type Description

Article Lifecycle

Articles created in 
the last 30 days

Single 
score 

( )

Total number of articles created in the last 30 days.

Number of articles 
in review

Single 
score 

( )

Total number of articles in the review state.

Articles by 
workflow state

Pie ( ) Displays articles by their workflow state.
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Title Type Description

Articles in review 
for more than 30 
days

Horizontal 
bar ( )

Shows the articles that have been in the review state for more 
than 30 days.

Articles created in 
the last 30 days

Pivot 
table 

( )

Shows the articles created in the last 30 days and the 
knowledge bases and workflows associated with the articles.

Articles updated in 
the last 30 days

Pivot 
table 

( )

Shows the articles updated in the last 30 days and the 
knowledge bases and workflows associated with the articles.

Articles in Draft 
state

Horizontal 
bar ( )

Shows the articles in the draft state.

Article Feedback

Articles flagged in 
the last 30 days

Single 
score 

( )

Total number of articles flagged in the last 30 days.

Articles marked Not 
Helpful in the last 
30 days

Single 
score 

( )

Total number of articles marked as not helpful in the last 30 
days.

Comments added 
in the last 30 days

Single 
score 

( )

Total number of articles that have received comments in the 
last 30 days.

Article ratings in 
the last 30 days

Pivot 
table 

( )

Displays the ratings for articles that are in different workflow 
states. It also shows the average rating of articles from 
different knowledge bases.

Average article 
rating

Single 
score 

( )

Shows the average rating of articles that have been rated.

Article Usage

Knowledge use Vertical 
bar ( )

Shows the count of articles used as attachments.

Article views Vertical 
bar ( )

Shows the count of articles viewed by knowledge base.

Knowledge use 
trended by month

Line ( ) Shows the count of articles used as attachments trended by 
month.

Article view count 
trended by month

Line ( ) Shows the count of viewed articles trended by month.

Author Metrics

Monthly 
knowledge use by 
author

Trend 

( )

Shows the count of articles used as attachments trended by 
month with respect to the author.
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Title Type Description

Monthly 
knowledge views 
by author

Trend 

( )

Shows the count of viewed articles trended by month per 
author.

Articles created by 
author

Trend 

( )

Shows articles created per knowledge author trended by 
month.

Update the navigation path for the Knowledge Management  Overview dashboard

Update the navigation path to access the Knowledge Management  Overview dashboard.

Before you begin

• Activate the knowledge overview (com.sn_knowledge_overview) plugin.

• If you are upgrading from a previous release, you must update the knowledge overview entry in 
the Modules (sys_app_module) table.

Role required: admin

Procedure

1. Navigate to All  > System Definition  > Modules.

2. On the Modules page, in the Title  field, enter overview.

3. In the Application menu  field, enter knowledge.

4. Open the Overview  module.

5. In the Module Overview page, click Link Type.

6. In the Link type  field, select URL (from Arguments)  from the list.

7. In the Arguments  field, enter $pa_dashboard.do?
sysparm_dashboard=bcaa1278c30101107b15f97c9840ddf7.

8. Select Update.

Result
The navigation path for the Knowledge Management  dashboard is updated to All  > Knowledge  > 
Administration  > Overview.

Pareto chart for Knowledge Demand Insights

The Pareto chart for Knowledge Demand Insights enables you to visualize candidate knowledge 
gaps and prioritize the order in which knowledge gaps should be resolved.

The following information is available in the Pareto chart for Knowledge Demand Insights:

• The left Y axis is the count of tasks with no or insufficient knowledge coverage.

• The right Y axis is the cumulative percentage of the total number of tasks evaluated.

• Each bar represents a collections of similar tasks that don't have good knowledge coverage. 
The bars are arranged in a descending order such that the collection with most number of 
tasks appears in the left. This order enables you to resolve the largest collection first. When 
you point to a bar, you view the number of tasks included within the bar and the cumulative 
percentage.
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• The line graph shows the cumulative percentage of tasks that are included in each collection.

• The blue line indicates the 80% of total number of tasks that have no or insufficient knowledge 
coverage. The intersection of the blue line and the line graph indicates the minimum number of 
collections that need to be resolved so that 80% of tasks can be covered.

Example: Pareto chart for demand insights

The following figure displays a Pareto chart for identifying candidate knowledge gaps for 
incidents.

Related topics

Demand Insights for Cases dashboard

Demand Insights for Incidents dashboard

Demand Insights for HR Cases dashboard

Knowledge demand insights

Demand Insights for Cases dashboard

The Demand Insights for Cases dashboard enables you as a customer service case manager to 
identify which cases have no or insufficient knowledge coverage. You can then create feedback 
tasks for knowledge gaps to deflect such cases.

The Predictive Intelligence for Knowledge Management plugin (com.snc.knowledge_ml) includes 
the Demand Insights for Cases dashboard. For more information, see Predictive Intelligence for 
Knowledge Management  and Additional plugins for Knowledge Management.
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Demand Insights for Cases dashboard

End user and roles

End user and goal Required roles

Customer service case manager: Needs 
to identify which cases don't have good 
knowledge coverage.

sn_km_ml.knowledge_curation_user and 
sn_customerservice_manager

Reports

Title Type Description

Candidate Knowledge Gaps 
for Case

Pareto Chart Displays data from the 
Knowledge Curation Task 
[kb_curation_task_cluster] 
table with the following 
conditions:

Curation configuration = 
sn_customerservice_case 
AND Solution.Active = true

Related topics

Pareto chart for Knowledge Demand Insights

Knowledge demand insights

Demand Insights for Incidents dashboard

The Demand Insights for Incidents dashboard enables you as an incident manager to identify 
which incidents have no or insufficient knowledge coverage. You can then create feedback tasks 
for knowledge gaps to deflect such incidents.

The Predictive Intelligence for Knowledge Management plugin (com.snc.knowledge_ml) includes 
the Demand Insights for Incidents dashboard. For more information, see Predictive Intelligence 
for Knowledge Management  and Additional plugins for Knowledge Management.
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Demand Insights for Incidents dashboard

End user and roles

End user and goal Required role

Incident manager: Needs to identify which 
incidents don't have good knowledge 
coverage.

sn_km_ml.knowledge_curation_user and 
incident_manager

Reports

Title Type Description

Candidate Knowledge Gaps 
for Incident

Pareto Chart Displays data from the 
Knowledge Curation Task 
[kb_curation_task_cluster] 
table with the following 
conditions:

Curation configuration = 
incident AND Solution.Active = 
true

Related topics

Pareto chart for Knowledge Demand Insights

Knowledge demand insights

Demand Insights for HR Cases dashboard

The Demand Insights for HR cases dashboard enables you as an HR agent to identify which 
HR cases have no or insufficient knowledge coverage. You can then create feedback tasks for 
knowledge gaps to deflect such HR cases.

Note: 
For Demand Insights for HR cases dashboard, activate the Human Resources Scoped 
App: Core plugin [com.sn_hr_core] and Predictive Intelligence for Knowledge Management 
plugin [com.snc.knowledge_ml].
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Demand Insights for HR Cases dashboard

End user and roles

End user and goal Required role

HR agent: Needs to identify which HR cases 
don't have good knowledge coverage.

sn_km_ml.knowledge_curation_user and 
sn_hr_core.admin

Reports

Title Type Description

Candidate Knowledge Gaps 
for HR cases

Pareto Chart Candidate Knowledge Gaps 
for HR cases.

Now Assist  in Knowledge Management
Use ServiceNow  Now Assist  in Knowledge Management  to generate a new knowledge article for 
a case or incident via the Now Assist  panel, classic environment, or the respective configurable 
workspace. Agents can use these articles to propose quicker resolutions to customers.
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Get started

Explore

Learn about the 
generative AI skills 

available in Now Assist in 
Knowledge Management.

Configure

Activate Now Assist in 
Knowledge Management

and configure the 
generative AI skills

.

Use

Generate new articles 
with Now Assist in 

Knowledge Management.

Troubleshoot and get help

• Knowledge Management community forum

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support

Exploring Now Assist  in Knowledge Management

Use the Now Assist  in Knowledge Management  application to help agents generate a new 
knowledge article for a case or incident via the Now Assist  panel, classic environment, and 
configurable workspace.

Now Assist  in Knowledge Management  Overview

Once activated and configured, Now Assist  in Knowledge Management  makes the following 
generative AI capabilities available to an agent:

• Agents can generate articles from the Now Assist  panel.

• Agents can generate articles from their respective configurable workspace.

• Agents can also edit and publish articles in the knowledge base.

Now Assist  in Knowledge Management  Skills

The Now Assist  in Knowledge Management  application includes the KB generation skill that 
enables agents to generate knowledge articles when working on a case or incident. Agents 
can document the resolutions and relay them to customers, providing quick resolutions to their 
queries and issues.

Now Assist  panel

Agents can use the Now Assist  panel available in their workspace. This conversational interface 
enables agents to generate a new knowledge article related to a case or incident. For more 
information about the Now Assist  panel, see Now Assist panel .
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Related topics

Generate a knowledge article from the CSM Configurable Workspace and classic environment 
with Now Assist

Generate a knowledge article from the Service Operations Workspace for ITSM and classic 
environment with Now Assist

Generate a knowledge article from Now Assist for HR Service Delivery (HRSD)

Generate a Knowledge article from the classic environment with Now Assist

Configuring Now Assist  in Knowledge Management

If you have the admin role, you can configure the Now Assist  in the Knowledge Management 
application, enabling agents to use its generative AI skills within their application workspace and 
the classic environment.

Configuration overview
Configure how agents use generative AI capabilities to generate new knowledge articles.

Configuring the KB generation skill

Configure the KB generation skill that agents can use to draft a knowledge article with Now 
Assist.

Before you begin
Before configuring the KB generation skill, the following applications and their respective plugins 
must be installed.

• The latest Now Assist  in Knowledge Management  and Knowledge  Capabilities in UI Builder 
store apps must be installed prior to the following configuration steps.

• For ServiceNow Store  installation steps, see Install a ServiceNow Store application .

Role required: admin
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Procedure

1. Navigate to All  > Now Assist Admin  > Features.

2. Select the application that you want to configure the KB generation skills for.

3. On the Knowledge  feature card, select View details.

4. In the Activate Skills section, select the more actions icon ( ), then select Edit  to open the 
skill configuration window for KB generation.

5. Review the values in the Choose input window, then select Save and Continue.
Review the read-only fields for more information.

◦ Input Table: The record type used for KB generation. For example, the value is case  for Now 
Assist for CSM.

◦ Input Fields: The fields from which information is gathered to draft the Knowledge  article. 
Based on the Input Table, the Input Fields can be configured. Together, they serve as an 
input to Now LLM Service  from the case or incident where the article is created.

◦ Default Knowledge Base for NAP: The Knowledge Base  in which the Now Assist  panel 
generates the article.
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6. Configure whether the KB generation skill should always 
be available or available based on a set of conditions. 

7. Select where you want to display the KB generation skill.
You can select In-product, Now Assist  panel, or both.

◦ In-product: When selected, Now Assist  skills are displayed on forms and workspaces. Select 
the arrow next to the toggle switch to define the roles that can use this skill in-product.

◦ Now Assist panel: When selected, Now Assist  skills are available in the Now Assist  panel. 
Select the arrow next to the toggle switch to define roles that can use this skill in the Now 
Assist  panel.
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8. Select Save and continue to go to the next step.

9. Review your choices and select Activate  to complete the configuration. 

Result
Your skill is configured.

Related topics

Skill inputs and triggers for Now Assist for Customer Service Management (CSM)

Skill inputs and triggers for Now Assist for IT Service Management (ITSM)

Skill inputs and triggers for Now Assist for HR Service Delivery (HRSD)

Using Now Assist  in Knowledge Management

Now Assist  in Knowledge Management  enhances the agent experience by using artificial 
intelligence (AI) to generate a new knowledge article based on the resolution provided to a case 
or an incident.

Generating knowledge articles

You can generate knowledge articles in Now Assist for Customer Service Management (CSM), 
Now Assist for IT Service Management (ITSM), and Now Assist for HR Service Delivery (HRSD)  in 
several ways:

• To generate knowledge articles based on cases in CSM Configurable Workspace, see 
Generate a knowledge article from the CSM Configurable Workspace and classic environment 
with Now Assist .

• To generate knowledge articles based on incidents in Service Operations Workspace  for 
ITSM, see Generate a knowledge article from the Service Operations Workspace for ITSM and 
classic environment with Now Assist .

• To generate knowledge articles based on cases in Agent Workspace for HR Case 
Management, see Generate a knowledge article from Now Assist for HR Service Delivery 
(HRSD) .

• To generate knowledge articles based on cases or incidents from the Now Assist  panel, see 
Generate a Knowledge article from the Now Assist panel.

• To generate knowledge articles based on cases or incidents in the classic environment, see 
Generate a Knowledge article from the classic environment with Now Assist.
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Generate a Knowledge  article from the Now Assist  panel

Generate a new knowledge article for a case or an incident from the Now Assist  panel.

Before you begin
For Now Assist for HR Service Delivery (HRSD), Knowledge  articles are only supported on the HR 
case record (sn_hr_core_case), not on the record from extended tables.

Role required: agent

Procedure

1. Open a case or an incident that is assigned to you.

2. Open the Now Assist  panel by selecting the Now Assist  icon ( ).

3. In the Now Assist  panel, select or enter Generate Article.

Now Assist  generates a Knowledge  (KB) article.

4. View the draft article by selecting the View KB article  link in the chat window.
The article appears in a new tab, with a unique ID number for the article.

5. Review the article and edit it if necessary.

6. View, edit, and publish the article by using the respective buttons on the screen.
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7. Optional:  Provide feedback on whether the article is helpful or not by selecting the liked icon 

( ) or the not liked icon ( ).

Note: 
Feedback plays a vital role in improving the generative AI performance. Consider giving 
feedback every time you use Now Assist  to help improve responses.

Generate a Knowledge  article from the classic environment with Now Assist

Generate a new knowledge article using Now Assist  on cases and incidents within the classic 
environment.

Before you begin
To see the Now Assist  experience on the Create Article page, the following KB generation criteria 
should be configured:

• Confirm that the KB generation skills are installed.

• In Now Assist Admin  confirm with your admin that the following criteria are in place:

◦ The table record and input fields must be specified.

◦ The conditions for skill availability must be specified from the list of attributes.

◦ The display of the KB generation feature In-product or Now Assist  panel must be specified.

Role required: agent

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3560



Procedure

1. Open a case or an incident that is assigned to you.

2. Generate an article by using the UI actions that appear in the record.

Note: 
Based on the template selection made by your admin during the configuration of 
the Knowledge Management  system properties, you can apply one of the following 
supported templates to the article: KCS article, Incident KCS HTML, or Standard template.

3. In the Use AI to draft this article? dialog box, select Yes, draft with Now Assist.

The completed article is displayed in the chosen template, along with a success message: 
This article was drafted by Now Assist. Be sure to review it for 
accuracy before saving.

Note: 
After you select Yes, draft with Now Assist, the article generation can’t be stopped. Now 
Assist  continues to generate the article even if you close the dialog box.
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4. Review the Now Assist  generated article and select Save  or Publish.

Note: 
After you save or publish the article, the message indicating that it was authored by Now 
Assist  is removed.

Related topics

Generate a knowledge article from the Service Operations Workspace for ITSM and classic 
environment with Now Assist

Generate a knowledge article from the CSM Configurable Workspace and classic environment 
with Now Assist

Generate a knowledge article from Now Assist for HR Service Delivery (HRSD)

Response templates
Resolve cases or support issues faster and more efficiently with response templates. Response 
templates (formerly known as templated snippets) are reusable messages that can be copied 
to case or task forms to provide quick and consistent messages to users, or to display standard 
chat response messages to requesters in Agent Chat.

Note: 
Response templates are available only for existing records.

Assign response template roles

The following roles are installed when you activate the response templates plugin.

Response template role Description

Response template administrator

[sn_templated_snip.template_snippet_admin]

Grants access to scoped administration of the 
response templates feature.

Response template writer

[sn_templated_snip.template_snippet_writer]

Grants access to create, read, update, and 
delete (CRUD) response template content.

Response template reader

[sn_templated_snip.template_snippet_reader]

Grants access to read response template 
content.

System Administrator

[admin]

Response template administrator

[sn_templated_snip.template_snippet_admin]
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Response template role Description

Note: 
Admin inherits this role by default. 
When the Templated Responses 
[com.sn_templated_snip] plugin is 
activated without activating related HR 
applications, you can still use response 
templates.

• Admin can reassign this role to other 
users.

• Admin can also remove the Contained 
Role [sys_user_role_contains] table so 
Admin users do not inherit this role by 
default. Or:

1. Enter sys_store_app_list.do 
in the Filter navigator search 
bar of an instance, or 
https://YOUR_INSTANCE/
sys_store_app_list.do  from a web 
browser.

2. Search for and select Templated 
Snippets.

3. Scroll down to Related Links.

4. Click Remove from the role 
contained by admin.

Before you begin using response templates, you must assign these roles to the appropriate 
roles, groups, or users in your application.

• To assign a role to another role, see Add a role to an existing role .

• To assign a role to a group, see Assign a role to a group .

• To assign a role to a user, see Assign a role to a user .

For example,

• In the HR Service Delivery  application, users with the HR administrator role are assigned 
the response template administrator role, users with the HR manager role are assigned 
the response template writer role, and users with the HR case writer role are assigned the 
response template reader role.

• In the Customer Service Management  application, users with the customer service manager 
role (sn_customerservice_manager) inherit the response template writer role. Users with the 
customer service agent role (sn_customerservice_agent) inherit the response template reader 
role and can access response templates assigned to all groups to which they belong.

How to use response templates

Users with the response template writer [sn_templated_snip.template_snippet_writer] role can 
create response templates. Each template is associated with a table that is an extension of 
the Task [task] or Interaction [interaction] table. Response templates include a short name for 
specifying a shortcut that can be used to identify the message. For chat response templates 
used in Agent Workspace, agents use the slash command with a short name to present the 
standard message during a chat. You can also configure the template to
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• Include variables pulled from a table

• Specify a condition builder to specify the conditions that must be met for the template to be 
available for use, such as for a specific HR service

For more information, see Create or modify a response template.

Users with the response template reader [sn_templated_snip.template_snippet_reader] role 
can then copy response template content and use it in their responses to users when working 
on case or task forms that meet the specified conditions. For example, a response template for 
payroll discrepancy cases enables HR agents to use a standardized message when responding 
to that case type. See Copy a response template to an HR case  for an HR-specific example.

Example: Response template to escalate payroll discrepancy cases

You are part of an enterprise HR organization using the HR Service Delivery  application. You want 
your HR agents to respond to and, when necessary, escalate payroll discrepancy cases quickly 
and consistently. Create a response template so that HR agents have a reusable message to use 
when responding to employees about that case type.

One of your HR managers with the response template writer role is responsible for creating the 
template to escalate payroll discrepancy cases. The template is associated with the HR Payroll 
Case [sn_hr_core_case_payroll] table, and a condition filters on cases that match the appropriate 
HR service called Payroll Discrepancy. In the template body, the response text appears with 
variables, such as the subject person name in the salutation.

HR case writers with the response template reader role can copy the response template content 
and use it in their responses to employees when working on cases. Response templates provide 
a faster and efficient way to resolve cases.

Activation information

To use response templates in your application, you must activate response templates. For 
information on what components are installed with the feature, see Components installed with 
response templates.

Activate response templates

You can activate response templates (formerly known as templated snippets) 
[com.sn_templated_snip] if you have the admin role. This plugin includes demo data and 
activates related plugins if they are not already active.

Before you begin
Role required: admin

Note: 
If you are using Agent Chat, the Agent Chat  (com.glide.interaction.awa) plugin automatically 
activates response templates.

About this task
Response templates activate these related plugins if they are not already active.

Plugins for response templates

Plugin Description

Scoped Application Restricted Caller 
Access

Allows scoped applications to restrict access to 
public tables and script includes.
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Plugins for response templates  (continued)

Plugin Description

[com.glide.scope.access.restricted_caller]

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.

Note: 
When domain separation and delegated admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .

Related topics

List of plugins (Madrid)

Components installed with response templates

Several types of components are installed with activation of the Templated Responses 
(com.sn_templated_snip) plugin, including tables and user roles.

Note: 
The Application Files table lists the components that are installed with this application. 
For instructions on how to access this table, see Find components installed with an 
application .

Demo data is available for this feature.

Roles installed

By default, the following HR roles contain the following response template roles.

Note: 
The Templated Responses [com.sn_templated_snip] plugin activates the 
sn_templated_snip.min_admin_count system property [sys_properties.list]. This property 
prevents you from deleting your only Response Template admin user by requiring a 
minimum number (default is two) of active users with this role.

Roles installed with response templates

Role title [name] Description Contains roles

Response templates administrator Grants 
access to 

sn_templated_snip.template_snippet_writer
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Roles installed with response templates  (continued)

Role title [name] Description Contains roles

[sn_templated_snip.template_snippet_admin]
scoped 
administration 
of the 
response 
templates 
feature.

Response templates writer

[sn_templated_snip.template_snippet_writer]

Grants 
access to 
create, read, 
update, and 
delete (CRUD) 
response 
template 
content.

sn_templated_snip.template_snippet_reader

Response templates reader

[sn_templated_snip.template_snippet_reader]

Grants 
access 
to read 
response 
template 
content.

None

You can assign these roles to the appropriate roles, groups, or users in your application.

• To assign a role to another role, see Add a role to an existing role .

• To assign a role to a group, see Assign a role to a group .

• To assign a role to a user, see Assign a role to a user .

For further information on user administration and how to manage users, see User 
administration .

Tables installed

Tables installed with response templates

Table Description

Response Template

[sn_templated_snip_note_template]

Stores response template information. Response 
templates are reusable messages that can be copied 
to case or task forms. Response templates provide 
quick and consistent messages to users, or display 
standard chat response messages to requesters in 
Agent Chat.

M2M Response Template to Channel

[m2m_response_template_to_channel]

Maps channels to response templates.

Response Template Channel

[sn_templated_snip_channel]

Stores information about response template channels.
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Tables installed with response templates  (continued)

Table Description

Note Template for Table

[sn_m2m_note_template_for_table]

Maps notes to response templates.

For further information on table administration and how to manage data, see Table 
administration .

Create or modify a response template

Create or modify a response template (formerly known as a templated snippet) to define a 
reusable message that can be copied to case or task forms or used in Agent Chat  sessions to 
provide quick and consistent messages to users.

Before you begin
Role required: sn_templated_snip.template_snippet_writer

About this task
Each response template is associated with a table that is an extension of the Task [task] table 
or, if using Agent Workspace, the Interaction [interaction] table. The template can be configured 
to include variables pulled from that table. You can also use a condition builder to specify the 
conditions that a case must meet for the template to be available for use, such as for a specific 
HR service or for chat. For chat response templates, you specify a short name (shortcut) that is 
used with the slash command as a quick way to present the response message to a user.

Procedure

1. Navigate to All  > System Definition  > Response template configuration.

2. Select New  to create a response template.
Or, select an existing response template to modify from the list.

3. Fill in the fields on the form.

Response template form

Field Description

Name Name of the response template.

Short Name Short description that identifies the 
response template when using chat in Agent 
Workspace.

Use the short name with a quick command 
(/) to show the text from the template body 
of the response template while in chat. This 
feature provides a fast and consistent way to 
populate text while in chat.

For example, the short name gm  identifies the 
chat response template for a Good Morning 
greeting. Enter /gm  in a chat window to show 
the text from this response template.

Table Name of the table that the response template 
is associated with.
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Field Description

If you are creating a response template for 
Agent Workspace chat, the associated table 
is the Interaction [interaction] table. For other 
response templates, the table must be an 
extension of the Task [task] table.

Note: 
Creating custom COE tables do not 
allow you to add the Copy to Clipboard 
UI action. Users can still use the copy 
and paste function.

Condition Conditions that determine when the 
response template is available for use.

When defining conditions like case sensitivity 
or null values, see APIGlideFilter - Scoped, 
Global .

Note: 
The conditions available depend on 
the table you select. For chat response 
templates, specify the condition: [Type] 
[is] [Chat]

Application The application that created the response 
template.

Group visibility Indicates what groups have access to the 
response template.

Adding groups filters who can view the 
response template.

Note: 
Leaving this field empty makes the 
response template available to all 
groups.

Template body Text of the response template providing 
instructions to the agent on how to respond 
to a specific case or task.

You can reference field values by selecting 
variables from the variables list based on the 
table you select.

You can manually enter custom variable 
references:

◦ Current user: ${current_user}

◦ Current date: ${Date}

Or, place your mouse where you want the 
custom variable reference to appear and 
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Field Description

select the Insert Current User  or Insert 
Current Date  buttons.

Note: 
Response templates do not support rich 
text.

Select variables Variables you can add to the template body. 
For example, if you choose the HR Case 
(sn_hr_core_case) table, you can select the 
Subject person variable to appear in the 
Template body and it will replace the variable 
with the actual name of the subject person 
when the response template is used.

Note: 
The variables available depend on the 
table you select.

Example 

The following GIF shows an example of an HR manager in the HR Service Delivery  application 
creating a response template to escalate payroll discrepancy cases. The template is 
associated with the HR Payroll Case [sn_hr_core_case_payroll] table, and a condition is set to 
filter on cases that match the Payroll Discrepancy HR service. The template text is pasted into 
the body, and then a variable for the subject person is added to the salutation.
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4. Click Submit  or Update.
Channels limit the response template to only the channels you add. If you leave this blank, 
the response template is available to no channels. This feature allows you to have different 
messages for chats, emails, or form. For more information, see Create a response template 
channel .
The Channels related list appears.

What to do next
You can copy response template content to any field on a form that meets the specified 
conditions.

The following GIF shows an example of an HR case writer in the HR Service Delivery  application 
opening a payroll discrepancy case and copying a payroll discrepancy escalation template to 
the comments field in the HR case form for the employee to read.
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Manage service capabilities
Give your customers tailored catalogs for products, and create portals for service requests, using 
the ServiceNow®  Service Catalog  app.

Self-service

Design an efficient 
front-end for your 

organization's IT support.

Service administration

Control settings in all the 
support services for your 

business apps on the 
ServiceNow AI Platform.

Service Catalog

Create and manage 
catalogs to give 

your customers self-
service options.

Self-service

Make use of various common actions and catalog requests with Self-service. The ServiceNow AI 
Platform  gives you access to homepages, knowledge articles, and catalogs, along with handling 
incidents and surveys. Go even farther with Service Delegation, and select other users to work 
with your approvals, tasks, and communications.

Service administration

Give tailored support to your business infrastructure with Service Administration. Use 
Assessments and Surveys to collect data from recipients or assess data from tables in your 
system. Track tasks with Approvals, and assign authorizing roles to users or groups. Customize 
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data changes with State Flows, and create system work triggers based on those transitions. Give 
your team efficient travel routes and travel times with Geolocation.

Service Catalog  management

Give your customers tailored self-service options, using the ServiceNow®  Service Catalog  app. 
Develop, test, and deploy catalogs with various products and services. The portals provide a 
quick and easy means to make those requests. With standardized fulfillment and inventory 
tracking, your catalog offerings stay accurate and efficient.

Password Reset

Maintain login security and user verification with the ServiceNow®  Password Reset  system. Give 
users self-service and agent-assisted options for handling their passwords, along with multiple 
verification and authentication types, and enrollments for various reset programs.

Self-service
The Self-Service application gives supported end users a clean, simple front end to their IT 
support organization.

Get started

Explore Self-service

The Self-Service application gives 
supported end users a clean, simple 

front end to their IT support organization.

Configure Self-Service

Use ServiceNow's web-based interface 
to add new items to a request.

Explore Service Delegation

Service delegation is the ability 
to designate other users to view 

and interact with approvals 
sent or tasks assigned to you

Configure Service Delegation

Learn how to delegate approvals and tasks 
to another user, configure your user profile 
form to display the Delegates related list.

Exploring Self-service

The Self-Service application gives supported end users a clean, simple front end to their IT 
support organization.
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By default, the Self-Service application provides access to common actions, such as viewing 
your homepage, accessing the Service Catalog, viewing knowledge articles, working with 
incidents, and taking surveys.

Service catalog requests

This page contains links to content on service catalog requests.

Add new request items

Use ServiceNow's web-based interface to add new items to a request.

Before you begin
Roles required: Only an administrator or a user with the catalog_admin role can add a new item 
to a submitted request.

About this task
Modifying a request does not resubmit it to the approval process.

Procedure

1. Navigate to All  > Service Catalog  > Open Records  > Requests  and open an existing request.

2. Click Add New Item.

Note: 
The Add New Item  button appears only if the current Request state  is Pending 
Approval. After the request is approved, this button is no longer available and you will not 
be able to add new items.

3. In the dialog box that appears, choose an item and a quantity to add.

4. Click OK.

Amazon EC2 instance request from the Service Catalog

Users can request the provisioning and deletion of virtual computers (Linux  or Windows) in the 
Amazon EC2 virtual computing environment through the ServiceNow  Service Catalog.

The Amazon EC2 offering requires the purchase and activation of ServiceNow  Orchestration 
Automaton.

Request an instance

Request the provisioning of a new Amazon EC2 instance through the service catalog.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Self-Service  > Service Catalog.

2. Select Amazon EC2 Instance  from the Request Application Infrastructure  category.
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EC2 Service Catalog 2

3. Select the operating system, the type of instance (Large or Small), and the number of 
instances requested.

See the specifications for Large and Small instances in Amazon EC2 Instance Types.

4. Type a reason for the request.

EC2 Service Catalog

5. Click Order Now  to order the instance.

The Order Status form appears, summarizing the request. A status bar tracks the progress of 
the approval and provisioning of the EC2 instance.

EC2 Order Status

Upon successful creation of the instance, you receive an email containing the instance ID, IP 
address, and the public DNS for the instances created.
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Terminate an instance

Shut down an Amazon EC2 instance through the service catalog.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Service Catalog  > Routine Changes  > Terminate Amazon EC2 Instance.

A list appears displaying the instances that are assigned to you.

2. Select an instance from the list and click Order.

This list does not support multi-line selection, and there is no undo  feature.

Check-out redirect property

A property called One-step checkout redirect (glide.vm.checkout_redirect) controls 
the view presented to virtual machine requesters in the service catalog.

By default, this property is set to false, which redirects the view to the Order Status form when 
the requester clicks Order Now. When this property is set to true, ServiceNow  redirects the 
requester to their My Virtual Assets portal. This property is located in Cloud Management  > 
Administration  > Properties.

Delete request items

Use ServiceNow's web-based interface to delete items from a request.

Before you begin
Role required: admin

About this task
All users can delete items from their own requests any time prior to delivery. Modifying a request 
does not resubmit it to the approval process.

Procedure

1. Navigate to All  > Service Catalog  > Open Records  > Requests  and open an existing request.

2. In the Requested Items  related list, select the check box beside the item to delete.

3. In the Actions  choice list, select Delete.

ServiceNow  recalculates the price and delivery date for the order.

Place a request

Use ServiceNow's web-based interface for ordering predefined goods and services.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Self-Service  > Service Catalog.

The default catalog view organizes items in categories and subcategories.
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Default catalog view

2. Select an item to order.

Note: 
Some items are order guides, which combine related items for easier ordering. For 
example, an order guide called New Employee Hire presents a list of items that new 
employees typically receive (desk, phone, computer, email account). After you select the 
items you want to order, the order guide requests the information required and shows a 
separate time to delivery for each item ordered.

The order screen requests any additional information that's needed, such as the requester's 
name or location and the date the item is needed. It also displays the item's delivery time after 
approval.

Delivery time
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3. Enter complete and accurate information to expedite your order.

4. Order any other items required.

5. Click Order Now  when the order is complete.

ServiceNow  displays a confirmation screen for your order:

Order submitted

You can view the order's progress in the Stage  column.

Note: 
It may be useful to note the order number for future reference.

ServiceNow  automatically notifies the approvers if approval is required and creates work 
orders to fulfill the order according to your organization's process. For example, if you order 
a new notebook computer, the purchasing group might receive a work order to order the 
computer, and the desktop services group might receive a work order to configure the new 
computer and deliver it to your office after it arrives.

Create incidents and change requests from a requested item

You can quickly open an incident or a change request from a requested item. It also maintains a 
relationship between the requested item, and its associated incidents or change requests.

Before you begin
The administrator must enable the Create Change  and Create Incident  UI actions for the 
Requested Item [sc_req_item] table. The administrator must set the Active  field to true  when 
editing these UI actions  .

Role required: itil

Procedure

1. Navigate to All  > Self-Service  > Requested Items.

2. Open a requested item.

3. Click the Additional actions menu icon  and select Create Change  or Create Incident

Related topics

Record Producer

Service catalog requests
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View request status

View the status of a request to see its progress, and determine when it may be fulfilled.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Self-Service  > Requested Items.

2. Click your order number to view details.

3. View the order's progress in the Stage  field.

4. Check the Backordered  field, and if the item is backordered, review comments for information 
about its return to stock.

Service Delegation

Service delegation is the ability to designate other users to view and interact with approvals sent 
or tasks assigned to you, and to receive copies of all email notifications sent to you.

Note: 
Users to whom you delegate responsibility see all pending tasks and approvals regardless 
of the delegation period.

Note: 
Delegation does not cascade. When a user acts as a delegate for another user, the 
delegate cannot in turn delegate to a third party. The original delegate is the only user who 
receives assignments and notifications. Delegation does not grant the delegate access to 
tasks where the caller or requester is the user for whom the delegate was created.

Add the Delegates related list to a user profile

To delegate approvals and tasks to another user, configure your user profile form to display the 
Delegates related list.
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Before you begin
Role required: personalize_form or admin

Procedure

1. Navigate to All  > Self-Service  > My Profile.

2. On the form context menu, navigate to Configure  > Related Lists, and then add the Delegate-
>User  related list.

Result
The Delegates related list displays at the bottom of the user profile form.

Delegate approvals and tasks to another user

If you're out of the office, you can delegate responsibilities to another active user for a period of 
time.

Before you begin
Role required: none

Procedure

1. Navigate to All  > Self Service  > My Profile.

2. In the Delegates  related list, click New.

If the Delegates related list is not visible, do one of the following:

◦ Select a different view, such as the ITIL or Default view, by selecting the Additional actions 
menu  > View  > (name of view).

◦ Configure the form to add the Delegates related list. For more information, see Configuring 
the form layout .

3. Select an active user as your Delegate.

4. Select date values from the Starts  and Ends  fields to set the period of time during which a 
delegate can work on your behalf.

5. Specify the responsibilities the delegate will assume by selecting the following check boxes.
You can delegate:

◦ Approvals: The delegate can approve items on your behalf.

◦ Assignments: The delegate can view and work on tasks assigned to you.
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◦ All notifications: The delegate receives a copy of email notifications sent to you, except 
those marked as Meeting Invitation.

Note: 

▪ If the Approvals  check box is selected but All notifications  is not, the delegate does 
not receive approvals.

▪ If your delegate gets email notifications, they will be the same email notifications sent 
to you. The delegate may be confused to see "Incident assigned to you" emails, so 
make sure they know they are a delegate.

◦ Meeting invitations: The delegate receives a copy of email notifications sent of the type 
Meeting Invitation.

Service Administration
Give tailored support to your business infrastructure with Service Administration.

Service Administration applications

Assessments and Surveys

Assessments and Surveys application 
helps you create, send, and collect 
responses for surveys. It also helps 

you evaluate, score, and rank 
records from any table in the system.

Classic approvals

Classic approvals are a legacy 
process to require authorization 

on tasks before the work is done.

State Flows

State flows enable an administrator 
to customize transitions from one 
state to another and configure the 

system to perform work during 
transitions to specific states.

Geolocation

The geolocation feature uses Google 
Maps to track users, plan efficient 

routes between locations, and assist 
in finding accurate travel times 

for applications that require this 
information, such as Work Management.

Exploring Service Administration

Configure settings for services that support business applications or the platform.
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Assessments and Surveys

The Assessments and Surveys  application helps you create, send, and collect responses for 
surveys. The application also helps you evaluate, score, and rank records from any table in the 
system.

The difference between assessments, surveys, and quizzes, and when to use each; also 
provides a quick look at the three stages in the survey process: designing, sharing, and 
evaluating.

Get started

Explore

Learn about Assessments and 
Surveys concepts and features.

Use surveys

Learn how you can use surveys.

Surveys reference

Get details about surveys, 
such as fields and properties.

Use assessments

Learn how you can use assessments.

Assessments reference

Get details about assessments, 
such as fields and properties.

Use quizzes

Learn how you can use assessments.

Quizzes reference

Get details about quizzes, 
such as fields and properties.

Troubleshoot and get help

• Ask or answer questions in the IT Service Management forum

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support
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Exploring Assessments and Surveys

The Assessments and Surveys  application helps you create, send, and collect responses for 
surveys. The application also helps you evaluate, score, and rank records from any table in 
the system. Create questionnaires that you can assign to one or more users to assess their 
knowledge of any subject.

Create basic surveys to obtain collective data for analysis

You can create, send, and collect responses for basic surveys. If installed, you can also use a 
survey widget to set up a survey on Service Portal.

Evaluate, rank, and score the data to provide summarized results using 
Assessments

You can assess projects that executives want to evaluate for effective management, or rate and 
compare a vendor's goods and services. Use assessments to send custom questionnaires to 
selected users or write scripts that query the database directly.

Use quizzes to test user knowledge

The quiz functionality is built on the assessment engine and provides many of the same features 
as assessments and surveys.

Surveys

With Surveys, you can create, send, and collect responses for basic surveys. If installed, you can 
also use the Survey widget to set up a survey within Service Portal.

Two versions of the application are supported, Surveys, which is the latest version, and Legacy 
Surveys. Survey improves the user interface and extends the capabilities of the Legacy Surveys 
application.

Surveys | Getting started

Configuring surveys

There are many options for advanced configuration in Surveys:

• Create a survey, add questions, and choose recipients, all in one interface.

• Create conditional questions, which appear only when users answer other questions a certain 
way.

• Restrict a survey so only specific survey users can take it, and send invitations to those users 
simultaneously. Alternatively, make the survey a public survey so that any user can take the 
survey, even anonymous users (users who have not logged in to the ServiceNow  system).

Tip: 
The assessment_take2 UI page should be public for public surveys. If that page is not 
public, anonymous users do not have access to the page and public surveys do not work.

• Set a schedule to automatically assign a survey to users and to limit how often the same user 
can take a survey.

• Customize the look and feel of survey questionnaires.

• Save anonymous survey responses.

• Convert survey responses to numerical scores and view them on scorecards.

• Deactivate a survey for maintenance or to retire it without deleting it.
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Note: 
Because surveys use the same tables and other back-end components as assessments, 
you may see assessment elements such as table and field names in certain places 
throughout the survey feature.

Legacy Surveys

Survey administrators can continue to use legacy survey functionality and data, however, it is 
recommended that you migrate legacy surveys to the Surveys application. Concurrent use of 
both survey applications can cause confusion and redundancy.

Survey wizards are not impacted and cannot be migrated.

Note: 
The Legacy Surveys application is not described in the documentation that you are viewing. 
It is documented on the ServiceNow  wiki.

Version comparison

Capability Surveys Legacy Surveys

Surveys in Service Portal.

Save new survey responses each time a user takes the same survey.

Create question templates to reuse sets of answer options.

Categorize survey questions and report on category results.

Deactivate a survey without deleting it.

Create conditional questions.

Send surveys automatically based on a schedule.

Customize survey questionnaire color scheme.

Save anonymous survey responses for logged-in users.

View survey responses on graphical scorecards.

Save surveys in a draft state until they are ready to publish.

Create and send surveys from one page.

Allow only specific users to access a survey.

Send surveys based on conditions.

Send survey email notifications.

Limit how often a user can take the same survey.

Add introduction and end note text.

Create survey modules.

Public survey: Allow persons to take a survey without logging in.

Use update sets to track changes.
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Related topics

Legacy survey migration

Survey designer

Survey roles

Surveys in Service Portal and the Now Mobile app

Service Portal

Using surveys

Survey administrators—users with the survey_admin role—create and maintain surveys and 
configure how they are distributed and published. Surveys on Service Portal are also supported.

Survey questionnaires

All surveys that are assigned to you appear in your personal assessment and survey queue.

No special role is required to complete a survey but you must be logged in and the survey must 
be assigned to you. When you submit a survey, the system stores your responses.

Survey notification

If the system is configured to send email, it sends you a notification when a survey is assigned to 
you. The message contains a link to the survey and instructions for viewing the assessment and 
survey queue.

Take a survey

Take an assigned survey that appears in your assessment and survey queue.

Before you begin
Role required: none

About this task
Each assessment or survey appears as a clickable card in the queue, which can be launched by 
clicking the card. The card includes helpful information, including the survey name, state, and 
due date. You must answer every required question, indicated by a red asterisk, before you can 
submit the survey. If you start to take a survey but can't complete it, save your responses and 
return to it later. When you've answered all the questions and you're happy with the responses, 
submit the survey.

Note: 
If you've signed in as a user who doesn't have access to the trigger record, and you access 
a survey using the URI parameters, the associated record number isn't displayed. You can 
still take the survey.

Procedure

1. Navigate to All  > Self-Service  > My Assessments & Surveys.
Users with the assessment_admin role, including survey administrators, can display other 
users' assessments and surveys in addition to their own. Use the Show all  and Show assigned 
to me  related links at the bottom of the queue to show and hide assessments and surveys. 
Click a card assigned to another user to open the associated metric type or survey definition.

2. Click the survey card to open the questionnaire.

If there is more than one survey category, click the collapse icon ( ) or expand icon ( ) to 
hide or show the questions in the category.

3. Answer each question to the best of your ability.
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If you're unsure of how to respond to a question or if a question doesn't apply to a particular 
record, select Not Applicable, if available.

4. Complete one of the following steps.

Option Description

Save your responses without submitting 
them

Click Save. You can close the questionnaire 
and access it later from your queue.

Note: 
The system doesn't save the survey 
when there are invalid responses, such 
as a letter in a date field. You must en­
ter valid responses or remove invalid 
responses before you can save the sur­
vey.

Submit the survey after answering all ques­
tions

Click Submit. You can't return to the question­
naire after submitting.

Note: 
If there's an unanswered required ques­
tion or an invalid response, an error mes­
sage appears and the problematic ques­
tions are temporarily highlighted.

Survey responses and results

There is a metric result record for each user response to each question on every survey instance. 
Survey results for each question and category are calculated automatically based on the metric 
result records.

If you use survey result calculations for results and scorecards, ensure that the positive indicator 
field for the question is set appropriately, based on the answer options. To have any results, a 
category must contain scored questions.

Survey responses

Survey responses are stored in the Metric Result [asmt_metric_result] table and display the 
recipients' answers to each question in a category. To view general results, navigate to Survey 
> Survey Responses. To view results for a particular criterion, use a filter on the Metric Result 
[asmt_metric_result] table. For example, to view results based on the assignment group, apply a 
filter condition for assignment group.
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Survey metric results

Category results

Category results are stored in the Assessment Category Result [asmt_category_result] table 
and display the overall ratings for each category based on the weighted value for each scored 
question. To view these results, navigate to Assessments  > Results  > Category results  and filter 
the results using the [Type.Evaluation method] [is] [Survey]  condition.

Assessment category results

Survey scorecards

A scorecard provides a visual breakdown of survey responses, based on the way questions were 
answered, by category. To access a scorecard, see View a survey scorecard.

Related topics

View a survey scorecard

Survey designer elements

Configure category weights for a survey
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View results for all surveys

You can view the survey responses that are stored on the Metric Result [asmt_metric_result] 
table.

Before you begin
Role required: survey_admin or survey_reader

Procedure

1. Navigate to All  > Survey  > Survey Responses.
Do not confuse this module with Survey  > Legacy Surveys  > Survey Responses, which 
displays legacy survey responses.

The Type  column displays the survey definition each response is associated with.

2. Select a response to view its details.

View the results for a survey

You can view the responses for one survey definition. Survey results are stored on the Metric 
Result [asmt_metric_result] table.

Before you begin
Role required: survey_admin or survey_reader

Procedure

1. Navigate to All  > Survey  > View Surveys.

2. Open a survey definition.

3. Under Related Links, click View Responses, which is available only if there are results.
The results are grouped by metric, which is what questions are called in assessments.

4. Open a metric result to view more detail.
The metric result contains the user's response and calculated values of interest to advanced 
survey administrators. Because the Metric Result table is also used by the assessment feature, 
many field names are not clear in the context of surveys.

Example 

For a description of the field values, see .
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View a survey scorecard

A survey scorecard provides a visual breakdown of survey responses by category, based on the 
way questions were answered.

Before you begin
Role required: survey_admin or survey_reader

About this task
A scorecard displays charts for survey results, in which category and question responses are 
analyzed and current ratings are compared with previous ratings. Users can examine ratings over 
time, compare question ratings, or compare the ratings of all categories. All ratings are averages 
for the time range selected. The system dynamically updates a scorecard each time you view it, 
so the ratings reflect recently completed surveys.

Procedure

1. Navigate to All  > Survey  > View Surveys.

2. Open a survey definition.

3. Select the View Scorecard  related link.

Note: 
The View Scorecard  related link is available only if there are survey results to report.

The interactive scorecard displays the following filters:

◦ Question Results: Displays the result of all questions or an individual question.

◦ Category Results: Displays the results of all questions associated with an individual category 
or all categories.

◦ Average Ratings: Displays the result of weighted average rating for each survey question in 
an individual category or all categories.

◦ History: Displays the result of all questions in comparison with their history (by calendar year 
or quarters).

◦ Sentiment Analysis Results: Displays the results of sentiment analysis for the survey.

Survey scorecard category results

The Category Results view is a stacked bar chart showing survey results for all questions in an 
individual category or all categories by respondent count.

Select a category from the list to display the questions from that category in the chart.

This view displays responses that use the following data types:

• Checkbox

• Choice

• Likert Scale

• Number

• Template

• Yes/No

• Multiple selection
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• Image Scale

• Numeric Scale

Note: 
The Checkbox  and Yes/No  data types are combined into the Boolean  data type in the 
Survey Designer

Survey category results

To view details about a specific response, point to the colored bar to display the response, the 
number of responses, and the percentage it represents of all the responses to that question.

Survey scorecard category results detail

Survey scorecard question results

The Question Results filter displays the result of all questions or an individual question using 
charts or lists. For the String, Attachment, Date, Date/time, Reference, and Ranking data types, 
the results are displayed in the list view. The results of all other data types are displayed in the 
pie chart view.

Pie chart

The pie chart shows question results for all data types other than those that are displayed in the 
list view. See Survey question data types.

• Checkbox.

• Boolean.
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• Choice.

• Likert Scale.

• Number.

• Percentage.

• Yes/No.

• Image Scale.

• Multiple Selection.

• Template. The question result shows the aggregated net promoter score (NPS) with promoters, 
detractors, and passives.

Net promoter score categories

Question score NPS category

9 or 10 Promoter

7 or 8 Passive or Neutral

0 to 6 Detractor

The result is calculated as:

◦ %Promoters = Number of promoters / Sample size

◦ %Detractors = Number of detractors / Sample size

◦ %Passives = Number of passives / Sample size

◦ NPS = %Promoters - %Detractors

Note: 
The Checkbox  and Yes/No  data types are combined into the Boolean  data type in the 
survey designer.

When a user submits a survey, three records (one for each Timeframe) will be created/ updated- 
Year, Quarter, and Monthly  in the asmt_nps_result  table. For example, if a user submits 
a survey on November month of 2023, which falls under Quarter 3. Then three records are 
generated for the dates.

• Year: 2023-01-01

• Quarter: 2023-10-01

• Monthly: 2023-11-01

Now if a second user submits in December month of 2023, which falls under same Quarter 3, as 
above scenario. Then only a single record is created for Monthly Time frame.
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Survey scorecard question results - pie chart

Survey scorecard average ratings

The Average Ratings view displays the weighted average rating for each survey question in an 
individual category or all categories.

Use this view to learn how individual questions affect the overall rating for the category. Select a 
survey category from the choice list to display the chart for that category.
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Survey scorecard average ratings

To view the effect of each question's ratings on the entire category's ratings, point to the colored 
bar. The pop-up box shows the percentage of the total ratings represented by each individual 
question's weighted average.

Average ratings detail

Survey scorecard history

The History view compares the current ratings for the categories and their questions with ratings 
from the previous three years or four quarters.

Ratings that have declined are highlighted in red and display negative numbers. Ratings that 
have improved are highlighted in green with positive numbers. Arrow icons beside the values in 
the Diff  column indicate the trend of the current survey against the previous survey.

Point to a category to display a line chart that shows the rating trend for that category. Click a 
category to view the Survey Category form containing the survey questions.
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Survey scorecard trend chart

3 years

To calculate the current ratings, the system averages the ratings from the trailing twelve month 
(TTM) period. The Diff  column shows the discrepancy between the current ratings and the 
previous calendar year's ratings.

Survey scorecard history - 3 years

4 quarters

Quarterly surveys compare the average rating for each question and category in the current 
quarter against the average ratings from the previous four quarters. The Diff  column shows the 
discrepancy between the current ratings and the previous quarter's ratings. The column labels 

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3593



count backward, by quarter from the current quarter. For example, if the current quarter is the 
3rd  quarter of 2015, then the previous quarters appear as 2nd  [2015], 1st  [2015], 4th  [2014], and 
3rd  [2014]. All four of the previous quarters appear, whether or not there was any data for those 
quarters.

Survey scorecard history - 4 quarters

Export a survey scorecard as an image

You can export a scorecard as an image to use in presentations or other documents.

Before you begin
Role required: admin or survey_admin
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Procedure

1. Click the menu icon ( ) and select Save as PNG  or Save as JPEG  and wait for the export to 
complete.

Example 

2. Click Download  and save the scorecard image to a storage location.

Export a quiz scorecard as an image

You can export scorecards as images.

Before you begin
Role required: assessment_admin or admin
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Procedure

1. Click the menu icon and select Save as PNG  or Save as JPEG  as the download format.

2. When the export is complete, select Download  to save the scorecard image to a storage 
location.

Request translations for surveys

Request translations for surveys to localize them into one or more languages. Localization 
requested items that are created for the selected surveys in all the selected languages.

Before you begin
Role required: localization_requestor

Procedure

1. Navigate to All  > Survey  > View Surveys.

2. Select one or more surveys that you want to translate.

3. From the Actions on selected rows  list, select Request Translations.

4. In the Request Translations  dialog box, select the languages.

5. Click Submit.

Localization requested items are created for the selected surveys in all the selected languages. 
A success message with a link to the list of requested surveys is displayed. You can click the 
link to see the list.

Edit translations for surveys

Edit the translations for surveys, and after you make the changes, you can publish the translation.
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Before you begin
You must install the Localization Framework Installer plugin 
(com.glide.localization_framework.installer) before you begin to edit the translations for a survey. 
To know more, see Localization Framework .

Role required: localization_editor

Procedure

1. Navigate to All  > Survey  > View Surveys.

2. Open a survey for which you want to edit translations.

3. Click Edit Translations.

You can do the following actions while editing translations:

◦ Edit translations manually.

◦ Use machine translation (if you have configured in Localization Framework  settings) 
to translate the fields, which are not translated. For more information about machine 
translation, see Create a translator configuration .

◦ Export files for translation. To export files, click Export Source File, choose the file type, and 
then click Export File.

◦ Import translated files to update the translations. To import files, from the Export Source File 
list, select Import Translated File.

4. After your changes are completed, click Publish Translations.

After survey translations are published, they are made available to any user who takes a 
survey.

Survey responses in a database view

You can view survey responses in a database view for reporting purposes. For each survey 
instance, you can view the instance as a single row and the answers to each survey question 
(metric) in the corresponding columns. Analyze the responses easily and, if you want, export the 
survey responses.

You can create a database view on the Survey Definition form. After the database view is created, 
you can either export the survey response using the standard capabilities of the ServiceNow® 

platform or choose to create a report of the survey responses using the Reporting module.

Use the View Responses in Rows  related link on the Survey Definition form to view each 
survey instance response in a separate row and each survey question as the name of the 
corresponding column. The answer to the question is displayed in that column. To export the 
survey response in a tabular form, in the context menu, click Export.

The first three columns of the form show the number of the survey instance (instance ID), who 
the survey is assigned to, and the task. A maximum of five active metrics are displayed in the 
view by default. The Survey Definition form doesn’t show the View Responses in Rows  related 
link when the following conditions occur.

• There are more than five active metrics.

• There are no responses to the survey instance.

• There are more than 100 K responses for that particular survey. To view this database view of 
the survey responses, the number of responses must be less than or equal to 100 K. But, the 
database view is still accessible for more than 100 K responses when it’s already open in a 
new tab.
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The database view can show the start date, due date, expiry date, and completed date, but this 
information is not available by default. If the survey instance is triggered, then the trigger record 
is displayed in the Task column. The total number of survey responses isn’t displayed in the 
database view. For the ranking and multiple-choice metrics, based on user survey responses, 
multiple records are displayed instead of one record per survey instance.

Note: 
Any change or update to survey configuration or metadata (For example, addition or 
deletion of a new metric or category) might affect the database view. In such cases, an 
event (survey.results_view.updated) is generated so that users can take necessary actions 
to synchronize the data.

Survey administration

Survey administrators—users with the survey_admin role—create and maintain surveys and 
configure how they are distributed and published. Surveys on Service Portal are also supported.

Survey administration includes the following procedures.

• Create, customize, and publish surveys.

• Write and maintain survey questions.

• Define trigger conditions for when surveys are sent to users, such as when an incident closes.

• Maintain surveys and survey questions as the organization's needs change.

To set up surveys in Service Portal , you must first install Service Portal and then Create and edit 
a page using the Service Portal  Designer  on the page. The base system  includes the Survey 
widget.

View survey reports

Use the Survey Overview dashboard to view various survey reports, such as Surveys by Metric 
Type and State.

Before you begin
Role required: survey_admin, survey_reader, or admin

About this task
The dashboard displays your survey reports arranged in widgets. You can add new widgets to the 
dashboard.

Procedure

1. Navigate to All  > Survey  > Overview.

2. Click the elements within the reports to view more information.

For more information about working with dashboards, see Dashboards .

Survey designer

Users with the survey_admin role can use the survey designer. The survey designer lets you 
create survey categories and questions, configure the details, and publish the survey to specific 
users or groups.

You can assign a survey to individual users or groups who receive all the questions from all the 
categories. You can also customize each question and make it dependent on the response to 
another question. The following describes the procedures you follow to create and publish a 
survey.
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• Create survey categories.

• Create questions within each category.

• Configure survey details, such as introductory and closing remarks and time limit.

• Select recipients for the survey.

• Publish the survey to the selected users or groups.

Note: 
The survey designer replaces the survey creator in the Legacy Surveys application. If 
you are using Internet Explorer version 8 or earlier, the system redirects you to the survey 
creator.

Related topics

Create a survey designer template question

Select recipients for a survey in the Survey Designer

Publish a survey in the Survey Designer

Survey designer elements

The survey designer is accessible from Survey  > Survey Designer.

The survey designer contains the Controls  tab, the Questions  tab, the Categories  tab,a header 
bar, and the design canvas.

Controls tab

To create a question, drag the appropriate data type control from the Controls  palette and drop it 
onto the designer canvas.
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Controls

The assessment engine provides a built-in result calculation feature that converts responses to 
scored question data types to a score from 0 through 10.

Question data types

Data type Scored Description

Attachment No Question with a Manage Attachments icon that allows users to attach one 
or more files.

Boolean Yes Question with a check box or Yes  and No  choices for user responses.

Choice Yes List of predefined options. For more information, see the definition of the 
Choices  field in Create a question in the survey designer.

Date No Date field.
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Question data types  (continued)

Data type Scored Description

Date/Time No Date and time field.

Number No Number field with predefined minimum and maximum values. The default 
is 1-10.

Percentage No Percentage field with a prescribed range.

Scale Yes Predefined Likert scale. Answer options appear as radio buttons.

Numeric 
Scale

Yes Selectable number scale. The default is 1-5. Answer options appear as 
radio buttons.

String No Single or multi-line text field.

Template Yes Choice list of templates that provide a predefined scale of options. For 
details, see Quiz scorecards.

Reference No Choice list of fields from a specified reference table. This data type does 
not support reference qualifiers.

For example, a user could select a user name if you specify sys_user as 
the reference table.

Image 
Scale

Yes Question with a choice of images that can be selected.

A template can be used to apply the same images to multiple questions.

Multiple 
Selection

Yes Question with multiple check boxes that can be selected.

Ranking Question with an order number to be selected for each option.

One order number cannot be selected twice. This question can be 
mandatory and it can also be dependent on a parent question, but not 
vice versa.

Questions tab

This tab displays all metrics added to the question bank for surveys. Use the Filter  field to search 
for questions. Each metric is displayed with its name and type.

Categories tab

This tab displays all metric categories added to the question bank for surveys. All metrics in the 
question bank are group under the corresponding metric category. Use the Filter  field to search 
for categories or questions.

Header bar

The tabs on the header bar display views and a menu of functions. Click a tab to change the view 
on the canvas:

• Design: Add and configure the properties of categories and questions. This is the default view.

• Configuration: Create introductions and end notes for surveys and select a signature.

• Availability: Select the recipients for each category in the survey.
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Point to the menu icon ( ) to select an option. The list of options depends on the currently 
open survey.

• Save: Save the current survey without changing its state.

• Preview: Display a preview of the survey as it appears to recipients.

• Publish: Distribute the survey to the selected recipients.

• Save and Publish: Save the survey to the Draft  state and distribute the survey in one step.

• New Survey: Open a fresh canvas for a new survey.

• Load Survey: View the list of existing surveys.

• Copy Survey: Copy the current survey.

Design canvas

New surveys open in the canvas of the Design  view. The survey Name  field appears above first 
category in the canvas. A blank question field appears in the category container.

Initial appearance of the Survey Designer canvas

Configure a survey in the survey designer

Configuration settings apply to the entire survey.

Before you begin
Role required: survey_creator, survey_admin, or admin

Procedure

1. Navigate to All  > Survey  > View Surveys.

2. Open a survey definition in Survey Designer.

3. Select the Configuration  tab.

4. On the Survey Designer Configuration form, fill in the fields.
For a description of the field values, see Survey Designer Configuration form.

5. Select the Availability  tab and complete the form.

Related topics

View a survey scorecard

Create a survey designer template question

Select recipients for a survey in the Survey Designer

Publish a survey in the Survey Designer

Event scheduling

Create an assessment signature

Survey categories

Survey categories provide a way to group questions of a similar theme for a given survey.
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There must be at least one survey category per survey definition and every survey question must 
be associated with a category. When you create a survey, the system generates one category, 
which all the questions belong to.

For simple surveys, one category is usually enough. Consider creating additional categories if 
you want to accomplish any of the following tasks.

• Separate groups of questions into collapsible sections by category on the survey 
questionnaire.

• Report on category scores, which are calculated based on responses for all questions within 
each category.

Create a category in the survey designer

A category represents a theme for evaluating a specific element of the survey topic and contains 
questions pertaining to that theme.

Before you begin
Role required: admin or survey_admin

About this task
When you create a survey, the system creates a default category, using the name of the survey. 
You can use this category, modify it, and create additional categories as needed. To have any 
results, a category must contain scored questions.

Procedure

1. Navigate to All  > Survey  > Survey Designer.

2. Enter the name of the survey in the Name  field.
The system uses this name as the name of the survey and of the first category.

3. To configure the category, click the gear icon in its title bar and complete the following steps in 
the Properties dialog box.

a. Enter a new name and a description for the category.

b. Enter text in the Details  field that introduces or explains the category to recipients.

c. Click the X  icon to close the Properties dialog box and save your settings.

4. To add a new category, click the +  icon in the title bar of an existing category.
The new category appears below the category that you selected to create it. You can click the 
X  icon in a category header to delete a category that you added in error.

Create a survey category in a survey

You can modify an existing survey to add one or more survey categories.

Before you begin
Role required: admin or survey_admin

About this task
Only one category is required for each survey, but you can add additional categories as needed.

Procedure

1. Navigate to All  > Survey  > View Surveys.

2. Open a survey definition.

3. In the Metric Categories  related list, open a category or click New.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3603



Each survey category is stored as a record on the Metric Category [asmt_metric_category] 
table with a modified view for survey use.

4. Enter the survey category name and description.
The category name appears on questionnaires when either of the following is true.

◦ There is more than one category for the survey.

◦ There is only one category and its name is different from the survey definition name. If 
you create a survey using the survey creator, the category name is the same as the survey 
definition name.

5. Right-click the form header and click Save.
The Assessment Metrics  and Users  related lists appear.

6. Click Update.

Create a question in the survey designer

You can create multiple questions for each category in the survey designer, but each question 
can only be associated with one category.

Before you begin
Role required: admin or survey_admin

About this task
The data type that you select for each question determines how it can be answered by survey 
recipients.

Procedure

1. In the Design view, drag a data type icon from the Controls palette and drop it into a category 
container.

2. To configure the question, click the gear icon in its title bar.
The Properties dialog box opens.

3. On the Properties form, fill in the fields.
For a description of the field values, see Properties form.

4. To create any special conditions that must be met before the question appears on the survey, 
click the Dependency tab.
The question must have a data type of Boolean, Choice, Scale, or Template.

For example, the question, “How many states have you visited in India”, is a dependent 
question for the current question “Have you visited any other state in India?”. The dependent 
question appears exactly below the current question only if your answer satisfies the condition 
in the current question. If not, the dependent question does not appear anywhere in the 
survey.

5. Select a question in the Displayed when  field.
The system selects the appropriate operator and displays the possible answers for the 
selected question.

6. Select the answer that satisfies the condition.
You can select more than one answer. Selected answers are indicated by a check mark.

The system prevents recursive dependencies between questions. For example, if Question A 
depends on Question B, Question B cannot depend on Question A.

7. Click the X  icon to close the question properties dialog box and save your settings.

8. To add a question with the same data type as an existing question in the category, click the + 
icon in the title bar of the existing question.
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9. Drag and drop questions to change their order within a category or move them between 
categories.

10. To delete a question, click the X  icon in its title bar.

Related topics

Survey question template

Create a survey designer template question

Survey question data types

You must choose a data type for each survey question. The data type determines the format of 
the question and the kind of data that is collected on survey questionnaires.

The following data types are available for surveys:

Attachment data type

On questionnaires, users can attach one or more files to a question.

Users click the Manage Attachments icon and select one or more files in the Attachments pop-
up window to attach to the question. From this window, users can:

• View a list of the attached files.

• View an attached file in a separate window.

• Rename an attached file.

• Add or delete files

Once a survey has been submitted, attachments cannot be updated or deleted.

Any type of file supported by the platform can be attached to a question. One or more files can 
be attached a question while taking a survey or completing an assessment.

The assessment administrator can see the attachments associated with an individual question 
as well as those associated with the survey.

See Administering attachments  for more information.

Boolean data type

On questionnaires, users select a check box beside a statement or leave it cleared.

Boolean data type question

If you select Boolean, you must fill in the Scale definition  field. Select High  if it is best when 
users select the check box.

Choice data type

On questionnaires, users select a value from a list of choices.
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Choice data type question

If you select Choice, you must fill in the Scale definition  field and create answer options. Select 
High  for the scale definition if the answer option with the largest metric definition Value  is best.

Note: 
The system sets the Min  and Max  fields automatically based on the Value  settings for the 
associated metric definitions.

Date and Date/Time data types

The Date  and Date/Time  data types are similar.

• Date:  On questionnaires, users select a date.

Date data type question
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• Date/Time:  On questionnaires, users select a date and time.

Date/time data type question

Likert Scale data type

On questionnaires, users select a multiple choice value from a custom Likert scale. Each answer 
option is represented by a radio button on the scale. A Likert scale question that evaluates an 
application's ease of use might have the answer options Easy, Average, and Difficult.

Likert scale data type question

If you select Likert Scale, you must fill in the Scale definition  field and create answer options. 
Select High  for the scale definition if the answer option with the largest metric definition Value  is 
best.

Note: 
The system sets the Min  and Max  fields automatically based on the Value  settings for the 
associated metric definitions.

Number data type

On questionnaires, users enter a number.

Number data type question

If you select Number, you must fill in these additional fields:
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• Scale definition: Select High  if a larger number is better, such as for a question that measures 
the number of sales made in a quarter.

• Min  and Max: Enter the smallest and largest numbers users can enter. State the range of 
acceptable answers in the question text.

Percentage data type

On questionnaires, users enter a number.

Percentage data type question

If you select Percentage, you must fill in these additional fields:

• Scale definition: Select High  if a larger percentage is better, such as for a question that 
measures the percentage of work an agent has completed.

• Min  and Max:  Enter the smallest and largest numbers users can enter. Generally 0  and 100 
are appropriate minimum and maximum values. If you choose values other than 0  and 100, it is 
usually best to state the range of acceptable answers in the question text.

Reference data type

On questionnaires, users select a value from a list that is generated from a specified reference 
table. The response field supports auto-completion.

Note: 
Reference qualifiers are not supported.

For example, a user could select a user name in response to a question if you specify User 
[sys_user] as the reference table.

Reference data type question

String data type

On questionnaires, users enter text. When you select String, the String option  field appears. 
Select one of the following options to determine how the string field appears on questionnaires:
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• Single line

• Single line wide

• Multiline

Template data type

On questionnaires, users select a value from a predefined series of answer options. To use this 
data type, a question template must be defined.

If you select Template, you must fill in these additional fields:

• Template: Select a template.

• Scale definition: Select High  if the answer option with the largest template definition Value  is 
best.

Yes/No data type

On questionnaires, users select Yes  or No  from a list.

Yes/no data type question

If you select Yes/No, you must fill in the Scale definition  field. Select High  if Yes  is the best 
answer.
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Image Scale data type

On questionnaires, users select an image from a predefined set of images as their response. 
Image scale questions can also be used in a template for better performance with surveys that 
have the same type of answer options.

Five emojis, similar to the Likert scale (very dissatisfied to very satisfied) are provided. However, 
you can upload additional images in JPG, PNG, or GIF format. Two images can be uploaded, 
one for selected case and another for unselected case. For example, the selected image can be 

, and the unselected image can be . Larger size images are reduced to 64 x 
64 pixels.

Image Scale data type question

The result behavior depends on the presence of uploaded images. If no selected image is 
uploaded, then the question shows up blank.

Selected image Unselected image Result

Yes Yes Unselected image loads. Clicking the image 
changes it to the selected image.

Yes No Selected image loads with 50% opacity. Clicking 
the image changes the opacity to 100%.

No Yes A blank placeholder box is displayed.

No No A blank placeholder box is displayed.

Note: 

• N/A option is not supported for image scale type question.

• For an image scale type question, an empty string is saved as an answer for a hidden and 
dependent question of an unselected image.

Multiple selection data type

On questionnaires, users can select multiple check boxes indicating all answers that apply. For 
instance, a user can be instructed to "Select all that apply" in a multiple selection question.
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Multiple Selection data type question

Ranking data type

On questionnaires, users can select a different order number for each option to rank them. Drag-
and-drop functionality is also supported, which allows a user to either fill in the number, or simply 
drag an option.

Setting the order of the options

One order number cannot be selected twice. This question can be mandatory and it can also be 
dependent on a parent question, but not vice versa.

Related topics

Survey question template

Create custom metric type

Create your own custom metric type if you don’t find the metric type that you want in Survey 
Designer while designing surveys.

Before you begin
Role required: survey_admin, survey_creator, or admin

About this task
You can use the Custom Metric Type module for surveys to create the custom metric type. If 
you set the custom metric type using the Now Mobile app, ensure that the widgets support the 
current theme of Mobile Employee Service Portal.

Procedure

1. Navigate to All  > Survey  > Administration  > Custom Metric Type.

2. On the Custom Metrics page, click New.
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3. On the Custom Metric form, fill in the fields.
For a description of the field values, see Custom Metric form.

4. Select Submit.

Note: 

◦ Updating or deleting existing values in the Macro, Widget, and Result type  fields might 
cause inconsistent effects.

◦ The custom metric type that you created doesn’t appear for the public surveys. To 
make it visible for the public surveys, open the Service Portal  configuration and 
configure your survey widget to make it public. For more information about configuring 
widget security, see Configure widget security .

◦ If the custom metric type is inactive or deleted, the question is not rendered on the 
survey form.

◦ If the value in the Macro  or Widget  field is updated, the updated value is used to 
render a survey form even if an instance was created before updating the values for 
macros or widgets.

Edit a survey in the survey designer

You can modify surveys using the survey designer.

Before you begin
Role required: admin or survey_admin

About this task
You can edit a survey even after it has been distributed, with the following results.

• Added questions are available only on surveys that are distributed after this change.

• Changes to existing questions are immediately available to users before the survey is 
submitted or during the retake period. This includes changes to the answers, such as 
additional choices or changes to the data type.

• Deleted questions are also deleted from the distributed surveys in user queues.

Note: 
You can only edit a survey that has the same application scope as that of your current 
session.

Procedure

1. Navigate to All  > Survey  > Survey Designer.

2. Point to the menu icon in the survey header bar, and select Load Survey.

3. Select a survey from the list and modify it as needed.

4. Point to the menu icon in the survey header bar, and select Save  or Save and Publish.
When you publish the edited survey, the system generates survey instances for any 
associated survey users.

Configure category weights for a survey

You can assign a weight to each category in a survey. The system calculates results from the 
weight that you configure.

Before you begin
Configure the Survey Category form to display the Weight  field.
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Role required: admin or survey_admin

About this task
Weights are set to a value of 10  by default but can be changed.

Procedure

1. Navigate to All  > Survey  > View Surveys  and select a survey from the list.

2. In the Survey Definition form, select a category from the Metric Categories  related list.

3. Edit the default weight value.

4. Click Update.

View a survey instance

A survey instance represents one questionnaire assigned to one user. You view an instance to 
verify that survey instances were created, to check the state of a survey instance, or to reassign a 
survey instance.

Before you begin
Role required: admin or survey_admin

Procedure

1. Navigate to All  > Survey  > Survey Instances.

The following sub-modules are available based on the state of the instances:

◦ Ready to take: Displays survey instances that are ready to be taken by the user. By default, 
these instances are sorted in ascending order by the Number  field.

◦ In progress: Displays survey instances that are in progress. By default, these instances are 
sorted in ascending order by the Number  field.

◦ Completed: Displays survey instances that are complete. By default, these instances are 
sorted in descending order by the Taken on  field.

◦ Cancelled: Displays survey instances that are cancelled. By default, these instances are 
sorted in ascending order by the Number  field.

◦ All: Displays survey instances in all states. By default, these instances are sorted in 
ascending order by the Number  field.

2. Open a survey instance from the required sub-module.

By default, the following fields are displayed in the Survey Instance form for all sub-modules 
other than Completed.

Note: 

◦ When you open an instance in the Completed  sub-module, you are redirected to the 
User's Response page.

◦ Each survey instance is stored as a record on the Assessment Instance 
[asmt_assessment_instance] table with a modified view for survey use.

For a description of the field values, see Survey Instance form.

Related topics

Schedule periods

Event scheduling
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Survey users and groups

Survey users and survey user groups help survey administrators control who can take a survey.

Survey administrators can restrict a survey so that only specified users can access it unless a 
survey administrator manually assigns the survey to a different user. Survey user groups provide 
a way to quickly designate multiple survey users.

Administering survey users

The list of survey users for a survey is visible on the Survey Definition and Survey Category forms. 
You can add or remove users from the list of survey users at any point. Note that designating a 
survey user does not automatically generate a survey instance for that user unless both of the 
following conditions are true:

• The survey definition Schedule  period is set to Daily, Weekly, Monthly, or Yearly. In this 
case the system assigns a new survey instance to each survey user at the beginning of each 
schedule period.

• The user has no instances of the survey that are incomplete or that have not yet reached their 
expiration date.

You can designate survey users from the Survey Designer, the Survey Definition form, or the 
Survey Category form.

Note: 
If there are trigger conditions for a survey, do not create survey users. Instead, use the 
Trigger Conditions form to assign users.

Related topics

Send survey invitations to users

Survey trigger conditions

Survey categories

Survey definitions

Create a survey user group

Survey user groups are groups that have the Type  field set to survey and display only the 
information most relevant to surveys. You can assign survey groups or any user group to surveys.

Before you begin
Role required: admin or user_admin

About this task
Though it is possible to designate members of any group as survey users, one reason to create a 
survey group is to view it conveniently in the survey User Groups  module.

By default, the Survey Creators user group is available. When you add a user to this group, the 
user will be assigned the survey_creator role to create surveys, quizzes, or assessments and 
view only those surveys, quizzes, or assignments created by the user.

Procedure

1. Navigate to All  > Survey  > Administration  > User Groups.

2. Click New.

3. Complete the Group form.

4. Right-click the form header and click Save.
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The Group Members  and Groups  related lists appear.

5. To add group members, complete the following steps.

a. In the Group Members  related list, click Edit.

b. Select users from the list on the left and add them to the Group Members List  on the right.

c. Click Save.

Related topics

Create a group

Select recipients for a survey in the Survey Designer

You can assign survey users while designing or modifying the survey.

Before you begin
Role required: admin or survey_admin

Procedure

1. In the Survey Designer, click the Availability  tab.

2. Under Accessible by:, select the Specific users  option, then select users.

3. If desired, select the Survey groups only  check box, then select survey user groups or other 
groups.

4. Click Save.

Designate a survey user

You can designate one survey user at a time from the Survey Definition form.

Before you begin
Role required: admin or survey_admin

Procedure

1. Navigate to All  > Survey  > View Surveys.

2. Open a survey definition.
There must be at least one category.

3. In the Survey Users  related list, click New.

4. Select a User.

5. Click Submit.
The Survey Definition form reopens.

6. Optional:  To remove survey users, in the Survey Users  related list, select the check box 
beside the user, and then select Delete  from the action list below the list.

Designate or remove multiple survey users at one time

Use the Survey Category form to designate or remove multiple survey users at a time.

Before you begin
Role required: admin or survey_admin
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Procedure

1. Open a survey definition.

2. In the Metric Categories  related list, open a category.
You can choose any category. The system applies survey user changes to all the survey's 
categories automatically.

3. In the Users  related list, click Edit.

4. Use the slushbucket to add or remove survey users.

5. Click Save  to return to the survey category.
The changes are also reflected in the Survey Users  related list on the survey definition.

Allow recipients to retake a survey

You can configure a survey to allow recipients to resubmit their answers as many times as they 
like, up to the survey's due date.

Before you begin
Configure the Survey Definition form to display the Allow retake  field. For more information, see

Configure the form .

Role required: admin or survey_admin

About this task
Results are not calculated for the survey until the configured duration has elapsed. The card in 
the user's queue remains visible until the due date of the survey, and a button is displayed to 
allow retakes.

Procedure

1. Navigate to All  > Surveys  > View Surveys.

2. Select a survey from the list.

3. Select the Allow retake  check box.

4. Click Update.

Copy a survey

Create a copy of a survey with at least one category to reduce the effort of creating another 
survey with similar data.

Before you begin
Role required: survey_admin or admin

About this task
All associated questions (type), configurations, categories, metrics, domain separation rules, 
and role-based categories are copied. Assigned users, category users, instances, and trigger 
conditions are not copied.

Procedure

1. Navigate to All  > Survey  > View Surveys.

2. Open a survey definition.

3. Perform any of the following steps.
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Publish a survey

You must publish a survey to enable people to receive and complete survey instances.

Before you begin
Role required: admin or survey_admin

About this task
The State  field on the Survey Definition form indicates whether the survey is in the Draft  or 
Published  state.

Note: 
You cannot return a survey to the Draft  state after it has been published. You do have the 
option to deactivate a survey by clearing the Active  check box.

Procedure

1. Navigate to Survey  View Surveys  and select a survey to publish.

2. Click Publish.
When you publish a survey, the system generates survey instances for any associated survey 
users. You can assign  the survey to other users manually.

Publish a survey in the Survey Designer

You must save changes to a survey before you can publish it to the specified recipients or 
groups.

Before you begin
Role required: admin or survey_admin

Procedure

1. In the Survey Designer, point to the menu and select Load Survey.

2. Select a survey to publish.

3. To preview the survey as a user, point to the menu icon and click Preview.

4. When you are satisfied with the survey, click either Save and Publish  or Publish  to distribute it.
When you publish a survey, the system sends email notifications to the recipients and to 
their managers. The system displays a link to the survey on a card in each recipient's My 
Assessments & Surveys portal.

Customize the appearance of a survey

As an assessment and survey administrator, set properties to customize the color of various 
elements on the questionnaires.

Before you begin
Role required: survey_admin or admin

About this task
For color properties, enter either an HTML color name or hexadecimal (hex) value. For hex 
values, the    character is required. Values aren't case-sensitive.

For example, if all the following formats are valid: LightGray, lightgray, and  D3D3D3, a 
preview of the color appears next to the field.

The customizations that you make apply to all assessments and surveys.
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Procedure

1. Navigate to either of the following modules.

◦ Assessments  > Admin  > Assessment Properties

◦ Survey  > Administration  > Properties
For a description of the properties, see .

2. On the Properties page, edit the properties as needed.
Refer to the following screenshot to see which parts of the assessment questionnaires are 
controlled by the properties.

Note: 
You can customize the Caption font color, Caption background color, and Question 
header background color  only if Next Experience  is turned off.

3. Click Save.
Clear the browser's cache to see updates.

Survey definitions

A survey definition is the root record upon which a survey is built.

The survey designer generates a survey definition automatically when you save or publish the 
survey. Survey administrators may want to modify the survey definition to configure additional 
options for the survey, or to publish the survey when it is ready for distribution.

Survey administrators and survey readers can also send survey invitations directly to users from 
the survey definition.

Related topics

Send survey invitations to users

Modify a survey definition

You can configure additional options for a survey definition.

Before you begin
Role required: admin, survey_creator, or survey_admin

Procedure

1. Navigate to All  > Survey  > View Surveys.
Each survey definition is stored as a record on the Assessment Metric Type 
[asmt_metric_type]  table with a modified view for survey use.

2. Open a survey definition.
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The Response Trend  chart with the weekly trend of the survey instance count, and the Survey 
Summary  chart with the overall summary response based on instance states are displayed.

3. Modify the fields on the Survey Definition form.

Note: 
You can only edit a survey that has the same application scope as that of your current 
session.

Survey Definition form

Field Description

Name Name of the survey which appears on the questionnaire.

Description Helpful information about the survey.

Active Check box to activate the survey definition. When the Active  check box 
is cleared, new survey instances cannot be generated and users cannot 
complete existing survey instances. Use the Active  check box to deactivate or 
activate a published survey.

Owners Owners of the survey. You can add a user with the survey_creator, 
survey_admin, or assessment_admin role.

Anonymize 
responses

Check box to ensure that all responses for this survey are stored without the 
submitting user names. When a user submits a survey, the system clears the 
Assigned to  field for the associated survey instance. Also, survey responses 
for anonymous surveys do not contain Assigned to  values.

Note: 
The Assigned to  field is cleared. However, each response record 
includes the Created By  and Updated By  fields that are accessible to 
users with the survey_admin role.

State Status of the survey: Draft  or Published.

Allow retake Check box that allows users to modify their answers to a completed survey. 
Users can resubmit a survey as many times as they want until the due 
date. After that date, the system removes the survey from the user's My 
Assessments & Surveys page.

Scheduled 
job

Scheduled job that the system creates for this survey definition when the 
schedule period is a repeating interval. The system sets the scheduled job to 
run according to the selected schedule period.

◦ If you change the schedule period and save the survey definition, the 
system deletes the old scheduled job.

◦ If you selected a recurring schedule period, a new scheduled job is created.
For example, if you change the schedule period from Daily  to Weekly  and 
save the record:

◦ The system deletes the daily scheduled job.

◦ Creates a weekly one set to run a week from the current date.

This field is visible to administrators only if the schedule period is Daily, 
Weekly, Monthly, or Yearly.

Assessment 
duration

The length of time to complete assigned survey instances, starting from the 
time the survey instance is generated. The assessment duration sets the Due 

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3619



Field Description

date for each survey instance. The default duration is 14 days. Configure the 
form  to view this field.

Send 
notifications

Sends notifications to the assigned users when the survey is published if 
there is an active notifications setup. Configure the form to see the field.

Other Options

Sample 
Metric

A metric of the current survey that you can include as an image in the email or 
invitation sent to a survey user. When the survey user clicks the image in the 
email or while previewing the HTML body, the entire survey is available to be 
taken.

Note: 
You cannot edit or delete a metric that is selected in this field.

Signature Acknowledgement by a survey recipient of requirements, admonitions, or 
policies related to the survey. The signature may require the recipient to select 
a check box or to type in a full signature to verify having read these assertions. 
You can display assertions without requiring a signature. Select an existing 
signature from the list or click New  to create a new one. The signature form 
contains these fields:

◦ Name: Descriptive name for this signature.

◦ Signature type: Type of signature required. The selections are Check box, 
Full name, or Assertion only. If Assertion only  is selected, no signature is 
required to submit the survey.

◦ Assertion: Text you want to display to recipients.

By default, a property called Require authentication for user signature 
(com.snc.assessment.signature_authentication) requires 
users to authenticate when providing a full name signature.

Schedule 
period

Option that determines how often a user can take the same survey and 
whether the system generates survey instances on a schedule.

Note: 
If you use a trigger condition for a survey, ensure the schedule period is 
set to No Limit. Trigger conditions use a different method to regulate how 
often users can receive survey instances.

Do not show 
survey 
introduction 
notes

Check box to skip the introduction notes when a survey is launched. This 
functionality is applicable in both the ServiceNow AI Platform  and Service 
Portal  product versions.

Pagination 
setting for 
Service 
Portal view

The setting on which the pagination is based for desktop or tablet view in 
Service Portal.

◦ Category: default

◦ Question: 1 question per page (automatic for mobile)

◦ None: no pagination

Note: 
This field is displayed only when Service Portal is installed.
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Field Description

One Click 
Survey

Enables a One Click survey in Service Portal.

Note: 
This option can be selected if the Pagination setting for Service Portal 
view  is set to None.

Source Table Table whose field is used as a dynamic value for a question in a triggered 
survey.

Note: 
When you select a source table, ensure that its relevant field is selected 
as Source Field  value of a metric.

Chat Survey Option to validate if survey questions are supported in a chat survey. Enables 
conversational questionnaires (pre-chat and post-chat surveys) in the chat 
client. Also enables you to map chat context variables to survey questions. For 
information on a chat survey in ITSM Virtual Agent, see Surveys in ITSM Virtual 
Agent.

Note: 
This field is available only when the Glide Conversation Server plugin 
(com.glide.cs) is activated.

Outlook 
Actionable 
Message

Includes an embedded survey in the survey email notification. After you select 
this check box and save the survey, a validation is run to ensure all survey 
questions are supported.

Note: 
This field is available only when the Outlook Actionable 
Messages(sn_ms_oam) plugin is installed.

Allow 
Sentiment 
Analysis

Enables sentiment analysis for this survey.

Introduction & End Notes

Introduction Introductory content to display on survey questionnaires. Consider adding 
a company logo, a welcome message, background information about the 
survey, or instructions.

End note End note that appears when someone submits a survey questionnaire. 
Consider adding a thank you message, follow-up instructions, or other 
applicable information.

Related Links

Enable 
Public 
Access

Remove 
Public 
Access

Link that enables/disables the survey as a public survey. No login is required 
to take a public survey (including a survey with a trigger condition) and users 
or non-users can respond anonymously. For completed public surveys, the 
Assigned to  field value is Guest.

Note: 
You can use the View Survey URL  related link to share the URL with 
users.
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Field Description

View 
Responses

Link that opens the list of responses  for this survey. This related link is 
available only if there are results for the survey.

View 
Scorecard

Link that opens the scorecard  for this survey. This related link is available only 
if there are results for the survey.

View Survey 
URL

Link that opens a dialog box that displays a URL  for this survey. The URL is 
useful for sharing a public survey.

This related link is available only if the Active  check box is selected. The URL 
does not work until the survey definition is published.

Show 
Benchmarks

Opens the Benchmarks Dashboard that provides visibility into your key 
performance indicators (KPIs) and trends.

Note: 

◦ This related link is available only for survey_admin, assessment_admin 
and survey_reader with bm_viewer role.

◦ You must opt in to Benchmarks to view the dashboard. See Enable 
Benchmarks

◦ This is applicable only for a published survey.

Create 
Improvement 
Initiative

Opens the Improvement Initiative window to create an improvement initiative 
record that helps in improving the performance of the survey.

Note: 

◦ This related link is available only for the survey_admin and 
assessment_admin role. A survey_reader can only view the created 
improvement initiative records.

◦ You should activate the Continual Improvement Management plugin 
(com.sn_cim).

Retry 
Sentiment 
Analysis

Checks all survey instances of this survey that do not have sentiment analysis 
data and sends them for analysis.

Related Lists

Trigger 
Condition

Displays all the trigger conditions associated with the survey.

Survey 
Responses

Displays all the responses associated with the survey.

Metric 
Categories

All survey categories  for this survey.

Survey Users All survey users  who are authorized to take this survey. If no users are listed, 
any user can take this survey.

Assessment 
Instances All survey instances  for this survey. Configure the form to add this related list 

to see it.
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Field Description

Note: 
If you add a related list to the form, use list control to omit the New 
button. The system generates survey instances to produce functional 
surveys.

Improvement 
Initiatives

Displays improvement initiatives associated with the survey.

Note: 
This related list is available only when there is at least one improvement 
initiative record.

Survey 
Recipients 
Lists

Recipients lists that are added to the survey.

4. Save the record.

Related topics

Survey trigger conditions

Publish a survey

Event scheduling

Schedule periods

The available schedule periods are Only Once, No Limit, Daily, Weekly, Monthly, and Yearly.

The default schedule period is No Limit. When you set the schedule period to anything except 
Only Once  or No Limit, the system creates a corresponding scheduled job. The scheduled job 
performs the following actions.

• Ensures that a user can take one survey instance of the same survey per schedule period.

• Generates a new survey instance for each survey user at the beginning of the new schedule 
period, as long as the survey user does not have an incomplete instance of that survey. A 
survey instance is incomplete if the state is not Complete.

For example, if you set the schedule period to Monthly  and someone attempts to send survey 
invitations  twice in the same day, the system generates survey instances for the survey users 
the first time only. At the beginning of the next schedule period, the system generates another 
survey instance for each survey user who completed the previous one.

Schedule periods are enforced by the Expiration date  field on the survey instance. As long as 
the survey instance expiration date has not passed, the assigned user cannot receive a new 
survey instance. When the system generates a survey instance and the schedule period is 
anything except No Limit, the Expiration date  field is automatically set to the appropriate date. 
For example, if the schedule period is Weekly, the expiration date is a week after the survey 
instance is generated.

If you change the schedule period, the scheduled job updates automatically to the correct 
schedule. However, users who have survey instances for the survey cannot receive new survey 
instances until their existing survey instances expire, regardless of the new schedule period.
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Consider the following example: Sal Pindell receives a survey instance when the schedule 
period is Weekly. The next day, a survey administrator changes the schedule period to No Limit. 
Sal cannot receive another survey instance until one of the following actions occurs.

• Seven days pass from the time Sal's survey instance was generated.

• A survey administrator deletes Sal's survey instance.

After one of these actions occurs, Sal can receive a new survey instance anytime, as long as he 
has no incomplete instances of the survey.

Note: 
If you use a trigger condition for a survey, ensure the schedule period is set to No Limit. 
Trigger conditions use a different method to regulate how often users can receive survey 
instances.

Related topics

Publish a survey

Survey trigger conditions

Create a survey designer template question

You can create a question that uses choice lists from a template.

Before you begin
Role required: admin or survey_admin

Procedure

1. Navigate to All  > Survey  > Survey Designer  and load a survey or create a new survey.

2. Drag the Template  data type icon into a category container.

3. Click the gear icon in the question title bar to open the template properties dialog box.

4. Select a predefined scale from the list.

Question entry fields appear for that template.
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5. Enter one or more questions that are appropriate for the template.

6. Click the arrow to the right of a question to configure its properties.
You must provide a name for each question.

7. Click the back arrow to return to the template properties dialog box.
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8. Configure the properties for the remaining questions.

9. Click the X  icon to close the template properties dialog box and save your settings.

Related topics

Survey designer elements

Survey designer

Edit a survey in the survey designer

Survey questions

Survey questions appear on survey questionnaires for the associated survey definition.

The survey creator generates questions and answer options automatically. However, it provides 
only the basic configuration options for questions, such as the question text and the data type. 
You may want to create additional questions or set advanced configuration options for the 
questions, including making a question appear conditionally or making a question mandatory. 
You can also use question templates to define reusable sets of answer options.

Survey questions are available from Survey  > Questions. The list displays information about 
each question, including the associated survey definition listed in the Type  column, and the data 
type. Survey administrators can modify these questions.

Create or modify survey questions

You can create and administer survey questions.

Before you begin
Role required: admin or survey_admin

About this task
Changes to a survey, such as the addition of questions or the modification of question templates, 
do not apply immediately to the existing survey instances. However, the changes apply 
immediately to any new survey instances that are created after the changes are saved.

Procedure

1. Navigate to All  > Survey  > View Surveys.

2. Open a survey definition.

3. In the Metric Categories  related list, open a category.

4. In the Assessment Metrics  related list, open an existing question or click New.
Each survey question is stored as a record on the Assessment Metric [asmt_metric] table with 
a modified view for survey use.

5. On the Survey Question form, fill in the fields.
The fields that appear depend on the selected Data type.

For a description of the field values, see Survey Question form.

6. Save the record.

Note: 

◦ Be sure to create answer options if you select the Choice  or Likert Scale  data type.

◦ You cannot delete a survey question (metric) with user responses. To delete a survey 
question with user responses, you should delete the responses, and then delete the 
survey question.
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Related topics

Survey question template

Trigger condition example

Survey trigger conditions

Survey question data types

You must choose a data type for each survey question. The data type determines the format of 
the question and the kind of data that is collected on survey questionnaires.

The following data types are available for surveys:

Attachment data type

On questionnaires, users can attach one or more files to a question.

Users click the Manage Attachments icon and select one or more files in the Attachments pop-
up window to attach to the question. From this window, users can:

• View a list of the attached files.

• View an attached file in a separate window.

• Rename an attached file.

• Add or delete files

Once a survey has been submitted, attachments cannot be updated or deleted.

Any type of file supported by the platform can be attached to a question. One or more files can 
be attached a question while taking a survey or completing an assessment.

The assessment administrator can see the attachments associated with an individual question 
as well as those associated with the survey.

See Administering attachments  for more information.

Boolean data type

On questionnaires, users select a check box beside a statement or leave it cleared.

Boolean data type question

If you select Boolean, you must fill in the Scale definition  field. Select High  if it is best when 
users select the check box.

Choice data type

On questionnaires, users select a value from a list of choices.
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Choice data type question

If you select Choice, you must fill in the Scale definition  field and create answer options. Select 
High  for the scale definition if the answer option with the largest metric definition Value  is best.

Note: 
The system sets the Min  and Max  fields automatically based on the Value  settings for the 
associated metric definitions.

Date and Date/Time data types

The Date  and Date/Time  data types are similar.

• Date:  On questionnaires, users select a date.

Date data type question
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• Date/Time:  On questionnaires, users select a date and time.

Date/time data type question

Likert Scale data type

On questionnaires, users select a multiple choice value from a custom Likert scale. Each answer 
option is represented by a radio button on the scale. A Likert scale question that evaluates an 
application's ease of use might have the answer options Easy, Average, and Difficult.

Likert scale data type question

If you select Likert Scale, you must fill in the Scale definition  field and create answer options. 
Select High  for the scale definition if the answer option with the largest metric definition Value  is 
best.

Note: 
The system sets the Min  and Max  fields automatically based on the Value  settings for the 
associated metric definitions.

Number data type

On questionnaires, users enter a number.

Number data type question

If you select Number, you must fill in these additional fields:
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• Scale definition: Select High  if a larger number is better, such as for a question that measures 
the number of sales made in a quarter.

• Min  and Max: Enter the smallest and largest numbers users can enter. State the range of 
acceptable answers in the question text.

Percentage data type

On questionnaires, users enter a number.

Percentage data type question

If you select Percentage, you must fill in these additional fields:

• Scale definition: Select High  if a larger percentage is better, such as for a question that 
measures the percentage of work an agent has completed.

• Min  and Max:  Enter the smallest and largest numbers users can enter. Generally 0  and 100 
are appropriate minimum and maximum values. If you choose values other than 0  and 100, it is 
usually best to state the range of acceptable answers in the question text.

Reference data type

On questionnaires, users select a value from a list that is generated from a specified reference 
table. The response field supports auto-completion.

Note: 
Reference qualifiers are not supported.

For example, a user could select a user name in response to a question if you specify User 
[sys_user] as the reference table.

Reference data type question

String data type

On questionnaires, users enter text. When you select String, the String option  field appears. 
Select one of the following options to determine how the string field appears on questionnaires:
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• Single line

• Single line wide

• Multiline

Template data type

On questionnaires, users select a value from a predefined series of answer options. To use this 
data type, a question template must be defined.

If you select Template, you must fill in these additional fields:

• Template: Select a template.

• Scale definition: Select High  if the answer option with the largest template definition Value  is 
best.

Yes/No data type

On questionnaires, users select Yes  or No  from a list.

Yes/no data type question

If you select Yes/No, you must fill in the Scale definition  field. Select High  if Yes  is the best 
answer.
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Image Scale data type

On questionnaires, users select an image from a predefined set of images as their response. 
Image scale questions can also be used in a template for better performance with surveys that 
have the same type of answer options.

Five emojis, similar to the Likert scale (very dissatisfied to very satisfied) are provided. However, 
you can upload additional images in JPG, PNG, or GIF format. Two images can be uploaded, 
one for selected case and another for unselected case. For example, the selected image can be 

, and the unselected image can be . Larger size images are reduced to 64 x 
64 pixels.

Image Scale data type question

The result behavior depends on the presence of uploaded images. If no selected image is 
uploaded, then the question shows up blank.

Selected image Unselected image Result

Yes Yes Unselected image loads. Clicking the image 
changes it to the selected image.

Yes No Selected image loads with 50% opacity. Clicking 
the image changes the opacity to 100%.

No Yes A blank placeholder box is displayed.

No No A blank placeholder box is displayed.

Note: 

• N/A option is not supported for image scale type question.

• For an image scale type question, an empty string is saved as an answer for a hidden and 
dependent question of an unselected image.

Multiple selection data type

On questionnaires, users can select multiple check boxes indicating all answers that apply. For 
instance, a user can be instructed to "Select all that apply" in a multiple selection question.
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Multiple Selection data type question

Ranking data type

On questionnaires, users can select a different order number for each option to rank them. Drag-
and-drop functionality is also supported, which allows a user to either fill in the number, or simply 
drag an option.

Setting the order of the options

One order number cannot be selected twice. This question can be mandatory and it can also be 
dependent on a parent question, but not vice versa.

Related topics

Survey question template

Survey question template

Question templates define reusable sets of answer options for survey questions.

Question templates define reusable rating scales for answering questions, where each answer 
option on the scale is a template definition. For example, the template named Satisfaction 
represents a satisfaction scale and contains the following template definitions: Very Satisfied, 
Satisfied, Neutral, Dissatisfied, and Very Dissatisfied.

Template definition
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Templates are available for survey questions that have Data type  set to Template. The following 
question templates are available in the base system. You can create or update a template as 
described in Create a survey question template.

Default question templates

Name Template definitions

Amount None, Few or little, Average amount, Many, Quite a lot

Complexity Very Complex, Complex, Moderate, Simple, Very Simple

Frequency Never, Seldom, Sometimes, Most of the time, All of the time

Likert 5 Strongly Disagree, Disagree, Neutral, Agree, Strongly Agree

Quality Very Poor, Poor, Average, Good, Very Good

Satisfaction Very Dissatisfied, Dissatisfied, Neutral, Satisfied, Very Satisfied

Size Very Small, Small, Average, Large, Very Large

Create a survey question template

You can create and administer question templates.

Before you begin
Role required: admin or survey_admin

About this task
Changes to a survey, such as the modification of question templates, apply to existing survey 
instances immediately. Templates that you create are available for use with both surveys and 
assessments.

Procedure

1. Navigate to All  > Survey  > Templates.
Each template is stored as a record on the Assessment Metric Template [asmt_template] table.

2. Click New.

3. Enter a Name.

4. Right-click the form header and click Save.

5. In the Assessment Template Definitions  related list, click New.
Create a template definition for each answer option you want to appear on a question.

6. Complete the form.

Field Description

Display Enter the text to appear as the answer option.

Value Enter a numeric value, greater than or equal to zero, to which the answer option 
equates. Values are used in results calculations.

When you view questions that use templates, answer options appear in order from 
smallest to largest Value. Each template definition for a given template must have a 
unique Value.

7. Click Update.
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Update min and max values to match templates

If you use survey result calculation data, ensure that the Min  and Max  values for a question that 
uses a template are equal to the smallest and largest template definition Value.

Before you begin
Role required: admin or survey_admin

About this task
When you create a question of the Template  data type, the system sets the Min  and Max  fields 
based on the template definition values. The fields for existing questions are not updated if you 
add a new template definition to a template or if you update the Value  of an existing template. 
If the new Value  is less than the minimum value or greater than the maximum value of any 
questions that use the template, update the questions accordingly.

Procedure

1. Navigate to All  > Survey  > Questions.

2. Configure the list to show the Min  and Max  columns.

3. Add the following list filter condition: [Template] [is] [<select the template you updated>].

4. Ensure the Min  and Max  values match the smallest and largest template definition Value  for 
the selected template.
If the values do not match, edit the Min  and Max  values directly from the list.

Note: 
When the data type is Template, a UI policy prevents the editing of Min  and Max  from the 
form.

Add a metric category and metric in the question bank for surveys

Reuse the question categories (metric categories) and questions (metrics) added in the question 
bank for surveys. You can add metric categories or metrics from the question bank to a survey, or 
from the survey to a question bank.

Before you begin
Role required: admin or survey_admin
Activate the Survey Question Bank Sample Data plugin (com.snc.question_bank_data) to access 
the demo data for the question bank.

Procedure

1. Navigate to All  > Survey  > Question Bank.

2. Click New.

3. On the Metric Category form, fill in the fields.

Metric Category fields

Field Description

Name Name of the metric category.

Description Description of the metric category.

Total 
metrics

Total number of metrics in the metric category. This number is automatically 
updated when you add or delete metrics from the category.

4. Right-click on the title bar and click Save.
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5. In the Assessment Metrics related list, click New.

6. In the Survey Question form, fill the fields.
For information on these fields, see Create or modify survey questions.

7. Click Submit.

Configure metric categories or metrics for a survey using the question bank

Reuse question categories (metric categories) and questions (metrics) from the Question Bank 
module while creating or updating a survey.

Before you begin
Role required: admin or survey_admin
Activate the Survey Question Bank Sample Data plugin (com.snc.question_bank_data) to access 
the demo data for the question bank.

Procedure

1. Navigate to All  > Survey  > View Surveys.

2. Open a survey definition.

3. Optional:  To add metric categories to a survey from the question bank in Platform, perform the 
following steps.

a. In the Metric Categories related list, click New Category from Bank.
The New Category from Bank dialog box is displayed with a list of all metric categories added 
in the question bank.

b. Select the required categories and click Add Selected.
A copy of the metric category and the corresponding metric definitions is created in the 
Metric Categories related list.

4. Optional:  To add metrics to a survey from the question bank in Platform, perform the following 
steps.

a. In the Metric Categories related list, open a metric category definition.

b. In the Assessment Metrics related list, click New Metric from Bank.
The New Metric from Bank dialog box is displayed with a list of questions available in the 
question bank.

c. Select the required metrics and click Add Selected.
A copy of the metric and the corresponding metric definitions is created in the Assessment 
Metrics related list of the category.

5. Optional:  To add a metric category to the question bank from a survey in Platform, perform the 
following steps.

a. In the Metric Categories related list, open a metric category definition.

b. Click Add to question Bank.
A copy of the category is created along with its metrics and metric definitions in the question 
bank.
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6. Optional:  To add a metric to the question bank from a survey in Platform, perform the following 
steps.

a. In the Metric Categories related list, open a metric category definition.

b. In the Assessment Metrics related list, open the required metric definition.

c. Click Add to Question Bank.
The Add to Question Bank dialog box is displayed.

d. In the Choose a question bank to add this question/metric  field, select a metric category 
that you want to add this metric to, and click OK.
A copy of the metric and the corresponding metric definitions is created for the selected 
category in the question bank.

7. Optional:  To add a metric category or metric to a survey from the question bank in Survey 
designer, perform the following steps.

a. Open the survey in Survey Designer.

b. Optional:  To add a metric category from the question bank, from the Categories  tab in the 
left panel, drag the required category banner and drop in the Design  tab.

c. Optional:  To add a metric from the question bank, drag and drop the required metric from 
the Questions  tab or the Categories  tab.

Note: 

◦ When you drag and drop a metric category, all dependencies within the category are 
also added to the survey.

◦ From the Categories  tab, you can drag and drop an individual metric within a metric 
category.

◦ When you drag and drop a parent metric, all dependent questions are also added to 
the metric category.

◦ When you drag and drop a child metric, only the child question is added to the metric 
category.

Create or modify answer options

You must create answer options, called metric definitions, for survey questions that have Data 
type  set to Choice  or Likert Scale.

Before you begin
Role required: admin or survey_admin

About this task
Changes to a survey, such as the addition or modification of answer options, apply to existing 
survey instances immediately.

Procedure

1. Navigate to All  > Survey  > Questions.

2. Open a choice or Likert scale survey question.

3. In the Assessment Metric Definitions  related list, open a metric definition or click New.
Each answer option is stored as a record on the Assessment Metric Definition 
[asmt_metric_definition] table.
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4. Complete the Assessment Metric Definition form.

Assessment Metric Definition fields

Field Description

Display Text to appear as the answer option.

Value Numeric value, greater than or equal to zero, to which the answer option equates. 
Values determine the order in which answer options appear. See the example 
below.

Values are also used to calculate survey results. Each metric definition for a given 
question must have a different Value.

5. Click Submit.

Example:
On survey questionnaires, the answer options for a question appear in order from smallest to 
largest Value. For example, consider the survey question How do you feel?  with the answer 
options Good, Neutral, and Bad. The following table shows the answer option order based on 
the Value.

Answer option order based on value

Answer option Value Order

Good 1 First

Neutral 3 Second

Bad 5 Third

If you use survey result calculations, ensure the question Scale definition  is set appropriately 
based on the answer options. In the previous example, if you want the answer option Good  to 
earn the highest score, the scale definition should be Low  because Good  has the smallest value.

Change the order of survey questions

You can easily reorder survey questions at the category level or the question level.

Before you begin
Role required: admin or survey_admin

About this task
You can change the order in which the questions in one category appear relative to those in 
other categories for the same survey definition. If you add a new question manually after you 
create other questions, you may want to change the order of questions.

When you create questions using the survey creator, the system sets the Order  field for the first 
question to 101, the second to 102, and so on. After you create a new question outside of the 
survey creator, the Order  is set to 100  by default, which means it appears before all questions 
generated by the survey creator.

Procedure

1. Navigate to All  > Survey  > View Surveys  and open the appropriate survey definition.

2. In the Metric Categories  related list, edit the values in the Order  column.
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3. To change the order of questions within a category, complete the following steps.

a. Open the Assessment Metrics  related list.

b. Edit the values in the Order  column.

4. Click Update.

Survey trigger conditions

Trigger conditions specify when to send a particular survey and the persons to send it to.

Survey administrators can use trigger conditions to configure the system to generate a survey 
instance each time a specified action occurs on a specified table, for example, when an incident 
or change request closes. The system sends the survey to users that are related to the triggering 
record, for example, incident callers or change request assignees. You can choose to send 
a survey every time the condition is met, or you can set a probability for the system to send a 
survey at random when the condition is met.

Trigger conditions are ideal for sending transactional surveys. Transactional surveys generally 
measure satisfaction with a recent experience, such as closing an incident or purchasing an 
item.

Note: 
Trigger conditions are comparable to survey conditions in legacy surveys. If you migrate a 
legacy survey that has survey conditions, ensure that the survey conditions are deactivated 
before you recreate them as trigger conditions.

Configure a trigger condition for a survey

Configure trigger conditions to specify when to send a particular survey and the persons to send 
it to.

Before you begin
Role required: admin or survey_admin or survey_creator

Procedure

1. Navigate to All  > Survey  > Administration  > Trigger Conditions.

2. Click New.

Note: 
Do not specify particular users for a triggered survey because only the specified users 
are allowed to take the survey.

3. On the Trigger Condition form, fill in the fields.

For a description of the field values, see Trigger Condition form for surveys.

You can also create a trigger condition directly from the survey creator. If you select Certain 
users can take this survey, based on conditions  in the Survey User Access section, the Trigger 
Condition form opens automatically when you click Save as Draft  or Publish.
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Example:

Survey Trigger Condition form

Related topics

Schedule periods

Trigger condition example

You can send out auto-triggered surveys when an incident is closed or resolved.

A trigger condition is configured as follows:

• Assessment: Service Desk Satisfaction Survey

• Table: Incident [incident]

• User field: Caller

• Repeat interval: 30 days

• Active: true

• Trigger randomly: false

• Related Field 1: Assigned to

• Related Field 2: Problem

• Condition: [State] [is] [Closed] [or] [State] [is] [Resolved]

C is the caller on incident INC00004305 that is assigned to B, a service desk technician. B 
creates PRB010101 based on C's complaint and closes the incident. The system creates a survey 
instance assigned to C so C can rate satisfaction with the incident experience.

Because two related fields were selected as part of the trigger condition, the survey instance 
stores the following information from the incident:

• User (Related Field 1): Boris Catino

• Problem (Related Field 2): PRB010101

• Task (automatically created): INC00004305
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Because the task field is automatically populated, UI-based filtering by dot-walking on incidents 
(or any task-based table) is supported when creating a report on survey results. For example, 
you can query all survey instances related to incidents assigned to a group (survey reports on all 
incidents assigned to networking  group, for instance).

Even though the trigger condition is set to be triggered each time that the conditions are met, 
the Repeat interval  setting ensures that C does not receive another survey for another of its 
incidents closes within 30 days of the first incident.

Survey report example based on task field

One of the most common use cases for Surveys is to send out an auto-triggered survey when 
an incident, request, or task is closed. Once you get the survey results back, you can filter the 
results by users and groups related to the ticket, such as Assignment Group, or Assignee.

Filtering the survey results provides more detail on how people and teams are performing based 
on ticket data. Since this information is automatically captured, you can dot-walk while filtering 
the data (instead of utilizing a related field on the Survey trigger condition form, as previously 
required).

Using the Task as a filter for survey results

To create a report on incident-triggered survey responses by Assignment group, set up the 
report on the Task Assessment Details by navigating to Reports  View/Run  and clicking Create a 
report.

Defining a report on survey responses that are triggered by an incident

Survey distribution

There are several ways for survey administrators to distribute surveys to users.

Surveys are distributed using any of the following methods.

• Send survey invitations to users.

• Share a survey URL that opens the survey directly.

• Create a module that opens a survey.
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Email notifications for surveys

When an administrator creates a survey and assigns it to a user, an email notification is sent to 
the user. Selecting the survey link in the email notification redirects the user to the survey page, 
where the user can take the survey. This type of survey is called a non-triggered survey.

Triggered surveys are the surveys that users get when the trigger condition is met. For a triggered 
survey, an event is inserted in the event queue. The event can be configured for specific teams 
to determine whether an email notification  should be sent to users. If the event is configured 
to send an email notification, an automated email is sent when the trigger condition is met. For 
more information about configuring the trigger condition, see Configure a trigger condition for a 
survey.

Note: 
You can includes an embedded survey in the survey email notification by using the 
Outlook Actionable Message  check box. After you select this check box and save the 
survey, a validation is run to ensure all survey questions are supported. This field is 
available only when the Outlook Actionable Messages (sn_ms_oam) plugin is installed. For 
more information, see Outlook Actionable Messages.

Send survey invitations to users

You can send survey invitations using the Assign Survey  or Send Invitations  buttons on the 
Survey Definition form.

Before you begin
Role required: admin or survey_admin

About this task
Use the Send Invitations  button to immediately assign survey instances to each survey user that 
is listed in the survey definition. Use the Assign Survey  button to assign a survey instance to any 
one user at a time.

Each of the buttons generates survey instances assigned to the appropriate users. In addition, 
if the instance is configured to send email, the system generates survey notifications. For either 
button to be available, the survey definition must meet all of the following conditions.

• Active  check box is selected.

• State  is Published.

• Survey is associated with at least one question.

Note: 
You (or a trigger) can send more than one instance of a survey to a user at any time.

Procedure

1. Navigate to All  > Survey  > View Surveys.

2. Select an active, published survey.

3. Complete one of the following actions.

Option Description

Assign a survey to users listed in the Sur­
vey Users related list

Click Send invitations.
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Option Description

Assign a survey to any user
Click Assign Survey  and select one or more 
users, and then click OK.

The system creates a survey instance assigned to the user or users, assuming the user 
is eligible to receive a new survey instance. When you use the Assign Survey  button, the 
selected user is not saved as a survey user.

Define a recipients list for surveys

Use a recipients list to define targeted set of users for whom the survey invite can be sent. You 
can use a recipients list for multiple surveys.

Before you begin
Role required: admin or survey_admin or survey_creator

Procedure

1. Navigate to All  > Survey  > Administration  > Recipients Lists.

2. Click New.

3. On the Recipients List form, fill in the fields:
For a description of the field values, see Recipients List form.

4. Click Submit.
For recipients lists created by the file upload, clicking Submit  validates the records in the 
Excel file. Following validation, the system displays a pop-up window with the upload results, 
including valid and invalid user records.

5. Optional:  To get the updated user list, navigate to the recipient list and click Refresh 
Recipient List.

Add a recipients list to a survey

Send the survey invites to targeted sets of users by adding a recipients list to a survey.

Before you begin
Role required: admin or survey_admin
Recipients lists should be pre-defined in the Recipients Lists submodule. For more information 
on defining recipients lists, see Define a recipients list for surveys.

Procedure

1. Navigate to All  > Survey  > View Surveys.

2. Open a survey definition.

3. Perform any of the following steps.

4. To send survey invites to all survey users and recipients lists, click Send Invitations.

Note: 

◦ The Send Invitations  UI action is available when there is at least one recipients list or 
survey user for the survey.

◦ If a user is available in the Survey Users  related list and multiple recipients lists, the 
survey invite is sent only once to the user.
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Embed a survey within the Outlook email client

Embed an interactive survey in the email notification sent to a user. The user can answer the 
survey questions and submit the survey from the email client instead of opening the survey in a 
new browser tab.

Before you begin
Role required: admin or survey_admin
The Outlook Actionable Messages plugin (sn_ms_oam) should be activated.

Note: 

• The Outlook Actionable Messages (OAM) feature is not supported in all Microsoft mail 
products and versions. To verify whether your version of Outlook supports OAM, refer to 
the Microsoft  website.

• Actionable messages are supported only for emails sent from the @service-
now.com email address. If you are sending an email from a customized email 
address, you should register as a new service in the Microsoft  website 
setting the scope as Organization. Specify the provider ID value in the 
sn_ms_oam.outlookactionable.originator  property.

• Actionable messages are based on the Sender Policy Framework (SPF)/DomainKeys 
Identified Mail (DKIM) validation for the email sender verification. If an email recipient 
receives email via an external provider, emails may not be rendered as adaptive cards.

• You cannot customize the default actionable message templates.

Procedure

1. Navigate to All  > System Notification  > Email  > Notifications.

2. For the Survey Invitation  notification, in the What it will contain  tab, add the following script in 
the Message  field in addition to the existing information.

${mail_script:include_survey_actionable} 

This script includes the Outlook actionable message in the email notification sent to the user.

3. Navigate to Survey  > View Surveys, and open a survey.

4. To send an email notification to the survey user, select the Send notifications  check box.

5. Select the Outlook Actionable Message  check box and save the survey.
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Note: 

◦ The Image Scale type question is supported only if there is a single question in the 
survey.

◦ Template type question with image option is supported only if there is a single question 
in the survey.

◦ Date/Time type question is supported in web client of Outlook and not in desktop 
client as Microsoft doesn't support Date/Time for Outlook desktop client.

◦ Two duplicate choice display values should not be used as the internal value may not 
be submitted incorrectly.

◦ The answer for String type question can be validated based on the option selected in 
the Field Validation field. For example, if you select the option as email address, then 
the answer entered can only be in the email-id format. Answers in any other format will 
not be accepted.

◦ The version of Microsoft Outlook does not support the following question types to 
create an embedded survey:

▪ Attachment

▪ Reference

▪ Ranking

◦ Dependent questions are not supported.

◦ Signature is not supported.

◦ Mandatory questions are supported.

In both the Platform UI and Survey Designer, a validation is run to ensure all survey questions 
are supported.

6. Click Assign Survey  and assign the survey to a user.
An email notification with the embedded survey is sent to the user. The user can take the 
survey and submit it from the email client instead of opening the survey in a new browser tab.

Enable localization for a survey

Enable a survey user to take a survey in multiple languages.

Before you begin
Role required: admin or survey_admin
The plugin for the language that you want the survey to be available in should be installed.

Note: 
Localization is applicable only for public surveys.

Procedure

1. Navigate to All  > Survey  > Administration  > Properties.

2. Enable the Enable/Disable whether to show language picker when a public survey is taken 
(show_lang_picker_for_publicsurveys) property.

3. In the System Settings window, from the Language  list, select the language that you want the 
survey to be available in.

Note: 
The Language  list is available only when a language plugin is installed.
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4. Navigate to Survey  > View Surveys  and open a public survey.

5. Enter the translated text for the survey title, questions, and answers.

6. Save and publish the survey.

Note: 
The localization is also applicable in Service Portal if the Assessment Properties 
Allow survey link from email to open in service portal view (applies only for surveys) 
(sn_portal_surveys.sp_survey.email_redirection) property is enabled.

◦ The survey is available for survey users in the translated language.

◦ Users can change the language of the survey using the language picker.

Survey URLs

You can distribute a survey by giving survey users a survey URL.

Survey administrators can obtain one of the following types of URLs.

• A general URL for a survey, which users can open to take the survey questionnaire. The 
following process occurs.

◦ When someone opens the URL, the system ensures that the person is logged in. It then 
searches for an instance of the associated survey that is assigned to the logged-in user.

◦ If a survey instance is found, the appropriate action occurs based on the State  of the 
survey instance (see table). If there are multiple active survey instances (Ready to take  or In 
progress), the instance with the earliest due date opens.

◦ If no survey instance is found, the system creates a new instance for the survey, assigns it to 
the user, and opens the survey questionnaire.

• A URL for a specific survey instance, which the assigned user can open to take the survey 
questionnaire. The following process occurs.

◦ When someone opens the URL, the system ensures the person is logged in as the user the 
survey instance is assigned to. Only the assigned user can access the survey questionnaire.

◦ The appropriate action occurs, depending on the State  of the survey instance (see table).

Survey states

Survey instance state Action upon opening URL

Ready to take: User 
has not saved any 
responses.

The survey questionnaire appears for the user to begin. The user can 
save or submit responses.

In progress: User 
has saved at least 
one response.

The survey questionnaire appears for the user to continue. Any 
previously saved responses are displayed. The user can save or submit 
responses.

Complete: User 
has submitted 
all required 
responses.

If the schedule period is No Limit  or if the period restriction has expired, 
the survey questionnaire for a new survey instance appears for the user 
to begin.

If the schedule period restricts the number of times a user can take the 
same survey, and the period restriction has not expired since the user 
last completed survey, an error message appears.
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If someone opens a URL for an unpublished or deactivated survey, an error message appears.

Obtain and distribute a general survey URL

You can distribute a general survey URL to allow any eligible user to open a survey questionnaire.

Before you begin
Role required: admin or survey_admin

About this task
The general URL is available on the Survey Definition form and on the survey creator. You can 
also email the URL for a public survey that is published.

Procedure

1. Navigate to All  > Survey  > View Surveys.

2. Open a survey definition from the Assessment Metric Types list.

3. To view or copy the URL, click the View Survey URL  related link.
This related link is visible only if the survey definition is Active.

4. To distribute the URL to users, paste the copied URL as desired, or click the Email  button to 
send via email.
The Email  button is visible only for a public survey that is published.

What to do next
When a survey user clicks the general survey URL, the system creates a survey instance for the 
survey user as long as the user does not have an instance in the Ready to take  state. The system 
is configured by default to send an email notification when a survey instance is generated.

As a result, the survey user receives a second notification in addition to the notification that you 
sent with the general survey URL. This may confuse the survey user. To avoid this issue, you can 
deactivate auto-notification.

Deactivate auto-notification for surveys

Deactivate an auto-notification to avoid a problem that causes a second system-generated email 
notification being sent to a user.

Before you begin
Role required: admin or survey_admin

About this task
When a survey is assigned to a user, an email notification containing a general survey URL is sent 
to the user. But sometimes, the user might receive a second system-generated notification.

Procedure

1. Navigate to All  > System Notification  > Email  > Notifications.

2. Open the Survey Invitation  notification.

3. Configure the form to add the Send to event creator  option to the Who will receive section.
The Send to event creator  option is selected by default.

4. Clear the Send to event creator  check box.
The system no longer sends auto-notification messages to survey users.

Obtain a survey instance URL

You can distribute a survey instance URL to allow the assigned user to open a survey 
questionnaire.
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Before you begin
Role required: admin or survey_admin

About this task
The survey instance URL is available on the survey instance record.

Procedure

1. Navigate to All  > Survey  > Survey Instances.

2. Open the instance for the survey.

3. To view or copy the URL, click View Instance URL  related link.
The related link is available only when the survey instance State  is Ready to take  or In 
progress  and the associated survey definition is Active.

4. In the dialog box, select and copy the URL then click OK  or Cancel.

5. Distribute the URL to the assigned user.

Test a survey URL

When there are survey users associated with a survey, the survey is restricted so only those 
users can use the survey URL. You can test the survey URL to ensure it is restricted.

Before you begin
Role required: admin or survey_admin

Procedure

1. Navigate to All  > Survey  > View Surveys  and open a survey for which you are not a survey 
user.

2. Under Related Links, click View Survey URL.

3. Copy the URL and click OK  or Cancel.

4. Navigate to the URL.
You see a message that you are not authorized to take the survey.

Create a survey module

You can create a module that opens a survey.

Before you begin
Role required: admin or survey_admin

About this task
When a user clicks a survey module, the system performs one of the following actions, 
depending on the configuration options for the survey and other factors.

• Creates a new survey instance

• Opens an existing survey instance

• Displays an error message.
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Procedure

1. Perform the appropriate action for your version of the UI:

◦ Core UI: Point to the application menu that contains the module to which you want to add 
the survey module and click the edit application (pencil) icon.

◦ UI15: Right-click the application menu you want to add the module to and select Edit 
Application Menu

2. In the Modules  related list, click New.

3. Complete the following fields.

◦ Link type: Assessment

Do not select Survey, which is used for legacy surveys only.

◦ Assessment: Select the survey you want the module to open.

4. Complete and save the form.

Sharing surveys

You can export a survey and then import it to a different ServiceNow  instance.

Note: 
Update sets are available in the Helsinki release and should be used to move data from one 
instance to another. For information about update sets, see System update sets .

The system exports a single XML file that contains a survey definition [asmt_metric_type] and the 
associated records, including the following.

• Assessment Metric Template [asmt_template]

• Assessment Template Definition [asmt_template_definition]

• Metric definitions [asmt_metric_definition] (survey question answer options)

• Scheduled Jobs associated with the Survey [sys_trigger]

• Survey categories [asmt_metric_category]

• Survey questions [asmt_metric]

• Survey users [asmt_m2m_category_user]

• Trigger Condition [asmt_condition]

Export a survey

You can export a survey and then import it to another instance.

Before you begin
Role required: admin, survey_reader, or survey_admin
For information about update sets, see System update sets .

Procedure

1. Navigate to All  > Survey  > View Surveys.

2. Right-click the name of a record to show the context menu.

3. Select Export Assessment.

4. If applicable, follow the prompt in your browser to save the XML file.
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Import a survey

You can import a survey that has been exported as an XML file. The exported XML file does not 
contain result data.

Before you begin
Role required: admin or survey_admin

Note: 
Update sets are available in the Helsinki release and should be used to move data from one 
instance to another. For information about update sets, see System update sets .

About this task

Procedure

1. Verify that the target instance has assessments enabled.

2. Import the assessment.

Use update sets for surveys and assessments

Use an update set to capture changes to surveys and assessments.

Before you begin
Role required: admin or survey_admin

Procedure

Create an update set and use it to make changes on a development instance.

Note: 
For more information, see System update sets .

When developing surveys and assessments, use an update set to capture the changes and 
move them from a development instance to a production instance. Once an update set is 
created and marked current, all of the updates to the following tables are recorded in the update 
set.

The following tables are now update set enabled and also extend the application file:

• Assessment Metric Templates [asmt_template]

• Assessment metric type [asmt_metric_type]

• Assessment Template Definitions [asmt_template_definition]

• Assessment Metric Definitions [asmt_metric_definition]: survey question answer options

• Schedule [sys_trigger]: scheduled jobs associated with the survey

• Assessment Metric Categories [asmt_metric_category]: survey categories

• Assessment Metrics [asmt_metric]: survey questions

• Assessment Category Users [asmt_m2m_category_user]: survey users

• Trigger Conditions [asmt_condition]

Configure a survey in the Connect chat support

Enable a user to take a survey after chatting with a support agent.
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Before you begin
Role required: admin or survey_admin

Note: 
The Connect Support plugin (com.glide.connect.support) should be activated.

Procedure

1. Navigate to All  > Connect Support  > Support Administration  > Chat Survey.

2. Click New.

3. In the Chat Survey form, fill the fields.

Chat Survey form fields

Field Description

Survey Survey whose instance should be available in Connect Support.

Type Type of chat where the survey is available. Connect: Survey is available in 
Connect Support.

Chat 
queue

Chat queue where the survey is available.

Active Specifies if the chat survey configuration is active.

Description Description of the chat survey configuration.

4. Click Submit.
When a support agent of the assignment group associated with the chat queue ends a chat 
with a user, the survey instance is available in the chat window for the users.

Note: 
The survey URL displayed after a connect chat is not a clickable link in the Virtual Agent 
web client. Copy and paste the URL to access the survey.

Related topics

Monitor incoming Connect Support conversations

Outlook Actionable Messages

Outlook actionable messages plugin enables users to respond to the survey from within the 
Microsoft Outlook application.

Install Outlook Actionable Messages plugin

Install Outlook Actionable Messages(sn_ms_oam) plugin to configure actionable messages.

Before you begin
Role required: oam_admin

Procedure

1. Navigate to System Application  > All Available Applications  > All.

2. In the search field, enter Outlook Actionable messages.
You can search for the application by its name or ID. If you cannot find an application, you 
may have to request it from ServiceNow store. Visit the ServiceNow Store  website to view all 
the available apps and for information about submitting requests to the store. For cumulative 
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release note information for all released apps, see the ServiceNow Store version history 
release notes .

3. Click Install.

Customize fields for the approval message

Customize the body message for a request, change, and request item approval sent in Microsoft 
Outlook.

Customize fields in the approval message for request

Customize the body message for a request and request item sent in Microsoft Outlook.

Before you begin
Role required: oam_admin

Procedure

1. Navigate to All  > Actionable Messages  > OAM Definition.

2. Choose one of the following:

OAM definition

Option Action

Request Click OAM Request Approval

Request Item Click OAM RITM Approval

3. In the OAM Container section, customize the following fields as required:

a. Title: Title of the Outlook approval notification.

b. Requester info: User who created the request.

c. Request Details: This field can be customized. You can also add additional fields as per the 
requirement.

4. Click Update.

The approval message is displayed in Microsoft Outlook as shown below. Click View Details 
button to view the request in ServiceNow instance.

Customize fields in the approval message for change request

Customize the body message for a change request approval sent in Microsoft Outlook.
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Before you begin
Role required: oam_admin

Procedure

1. Navigate to All  > Actionable Messages  > OAM Definition.

2. Click OAM Change Approval.

3. In the OAM Container section, customize the following fields as required:

a. Title: Title of the Outlook approval notification.

b. Requester info: User who created the request.

c. Request Details: This field can be customized. You can also add additional fields as per the 
requirement.

4. Click Update.

The approval message is displayed in Microsoft Outlook as shown below. Click View Approval 
Request  to view the request in ServiceNow instance.

Enable Advanced view for Outlook Actionable Message definition

Enable the advanced view to customize the actionable message as per the requirement for 
Microsoft Outlook.

Before you begin
Role required: oam_admin

Procedure

1. Navigate to All  > Actionable Messages  > OAM Definition.

2. Choose one of the following:

OAM definition

Option Action

Request Click OAM Request Approval

Request Item Click OAM RITM Approval

Change Click OAM Change Approval

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3653



3. Click Advanced OAM  under Related Links.

4. In the OAM Definition form, perform the following actions:

a. Modify the script as required.

b. Click Update.

Sentiment analysis for surveys

You can use sentiment analysis to determine whether user responses for a survey are 
considered positive, negative, or neutral.

Activate the Sentiment Analysis (com.snc.sentiment_analysis) plugin.

For a survey, you can select questions that should be used for analysis. The survey responses of 
these questions are sent to the thirdparty platforms for analysis through the specified connector 
configurations.

Note: 
You can only use string type questions for sentiment analysis.

The sentiment analysis results are displayed under Survey  > Question Sentiment Results. The 
sentiment label is based on the normalized score:

Sentiment label

Normalized score Sentiment label

-1 to 0 Negative

0 Neutral

0 to 1 Positive

Configure a sentiment connector

Specify the service URL and other configuration information for third party APIs that are used for 
sentiment analysis.

Before you begin
Role required: admin

Procedure

1. Change the scope of the current session to Sentiment Analysis.

2. Navigate to Sentiment Analysis  > Sentiment Connector Configurations.

3. Add or edit the connector configuration for a third party vendor such as Google, IBMWatson, 
and MSAzure.

Note: 
By default, placeholders are available for configuring connectors for Google, IBMWatson, 
and MSAzure.

Sentiment connector fields

Field Description

Name Name of the sentiment analysis connector configuration.
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Field Description

Active Check box to activate the connector configuration.

Credential 
Alias

Credential alias associated with the connector configuration. It has a reference 
to the system level table (sys_alias_list).

Default Check box to make this as the default connector configuration.

Description Description of the connector configuration.

Script Script to call the Sentiment Analysis API and the normalize the values.

4. Configure the connector credentials

a. Open the record referred in the Credential Alias  field.

b. Under the Connections  tab, select the connection.

c. In the Connection URL  field, enter the value.

d. Open the record referred in the Credentials  field.

e. Enter the credential information.

Note: 

▪ You should obtain the connection credentials from the respective third-party 
vendors.

▪ If the credential is an API key, specify its value. If the credential is basic 
authentication, that is, user name and password, specify the corresponding 
information.

f. Select the Active  check box and click Update.

5. Select the Active  check box for the connector configuration and click Update.

Sentiment analysis property

You can use the sentiment analysis property to customize the Sentiment Analysis  module.

Sentiment analysis property

Name Description

Response time for the outbound call of Sentiment Analysis API 
( sn_nlp_sentiment.glide.sentiment.transaction.timeout)

Maximum time 
(milliseconds) 
expected for 
executing the 
outbound call 
for Sentiment 
Analysis API 
before it’s 
timeout.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3655



Related topics

Sentiment analysis for surveys

Sentiment analysis results

The sentiment analysis results view contains a bar chart that displays the percentage of positive, 
negative, and neutral results, along with the instance count for each category.

Color indicators

Following are the color indicators in the bar chart:

• Green: Positive

• Red: Negative

• Blue: Neutral

Surveys in Service Portal  and the Now Mobile app

If you've installed Service Portal, you can use the My Assessments and Surveys  widget in Service 
Portal. Users can view surveys in Service Portal. Service Portal  also supports surveys for users 
on mobile devices that have the Now Mobile app  installed. The My Assessments and Surveys 
widget is available by default on the Service Portal  home page.

Surveys in Service Portal

To create an intuitive interface for your users, you can set up surveys in Service Portal  . Activate 
Service Portal  to view the My Assessments and Surveys  widget, which appears on the Service 
Portal  home page.

To learn more about activating Service Portal, see Activate Service Portal .

To learn more about configuring a widget, see configure widget instances  .

To configure a survey widget on a Service Portal  page, press the CTRL key, right-click the widget 
heading, and select Instance Options.

Instance options (properties) for the survey widget on Service Portal

Property Description

Max records Maximum number of surveys to list in the widget on the Service 
Portal  home page. Click the View all  link to view all surveys.

Default: 5

Title of the widget Text that appears in the title bar of the surveys widget.

Default: My Assessments and Surveys
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My Assessments and Surveys  widget on the Service Portal  home page

Surveys in the Now Mobile app

Users can view and take the surveys on mobile devices using the My Assessments and Surveys 
applet launcher that is available by default in the Now Mobile app.

When you assign a survey to a user an email notification about taking the survey is sent to 
the user. If users have installed the Now Mobile app, a mobile push notification is also sent 
on mobile devices. Tapping the notification opens an introduction page for a survey in the 
Mobile Employee Service Portal  in the Now Mobile app. The page shows a Get started  link. The 
introduction page and the Get started  link are available only if the related settings are enabled. 
Users can tap the link to view and take the survey. You can activate push notifications by setting 
the glide.sg.universal_links.enabled  system property to true.

Note: 
A push notification doesn't apply for a triggered survey. For a triggered survey, an event is 
inserted in the event queue. The event can be configured to determine whether to send a 
notification or not.
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My Assessments and Surveys  applet on a mobile device

Note: 
In the Washington DC  version, you now see the assessments and surveys assigned in 
the card view instead of the item view. If you customize the styles of the legacy card item 
views in older versions of  Assessments and Surveys, the card continues to appear in the 
item view even after you upgrade to Washington DC. You can view the new card view in 
Washington DC  only if no customizations were made to the legacy cards.

When users open a survey either in Service Portal  or the Now Mobile app, the surveys provide 
the following features:
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• A survey page shows breadcrumb navigation on the Service Portal. Users can click the links in 
the breadcrumb to navigate to previous pages or a home page. For example, clicking the My 
Surveys  link in the breadcrumb navigates users to a page, which shows a list of all the surveys.

• When the survey is in progress, the progress bar, which is available on each page of the 
survey, shows the progress in percentage. The percentage of completion is based on the 
pages on the survey. For example, suppose that there are three pages of a survey. The third 
page shows 66% completion of the survey. But giving a response to one of the questions on 
the third page opens a new question on a separate page, which is the fourth page. The fourth 
page shows the progress of the survey as 75% completed, which affects the overall progress 
and page indicators. Users can see the pagination (total number of pages) for the entire survey 
as well as the current page that the users are on. To hide or show this progress bar, you can 
use the sn_portal_surveys.sp_survey.show_progress_bar  property.

• Each user response is saved automatically when users move to the next page in the survey. 
If users don't answer the required survey questions before clicking Next, the page shows 
an error message at the top for all required and unanswered questions. This error message 
helps users find the exact location of the unanswered and required question. Any question 
that is not required and is not responded to before clicking Next  is considered answered. The 
question is counted as completed.

• When the details of a survey question contain more than four or five lines of text, the text after 
these lines disappears. In such cases, users can see the complete details by clicking the 
Show more  link. Users can go back to the default behavior by clicking the Show less  link.

• For a question that has the answer options of Yes, No, and Not Applicable, the Not Applicable 
option appears last in the list of options. The Not Applicable  option can be configured while 
creating a question.

• When the survey users leave the survey without submitting it, they can start the survey later 
from the same page where they left off in the previous session.

Note: 
For mobile users, the pagination is always by question for surveys. For more information 
about pagination settings, see Configure a survey in the survey designer.

One Click survey

A One Click survey has no introduction page in Service Portal. This survey doesn’t have the 
Submit  and Cancel  buttons in the desktop and iPad view.

Note: 

• The One Click Survey is not supported in the mobile device view.

• The One Click Survey  field should be selected in the survey definition.

• When the public access is enabled for a One Click survey, a user can submit the survey 
without having to log in.

• When the public access is enabled for a survey, you can't configure a signature or an 
attachment for the survey.

• For a published public survey, the Signature field is hidden and you can’t add an 
attachment.

A kiosk survey is a One Click survey with only one question of any of the following types:

• Image Scale

• Choice
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• Likert Scale

• Numeric Scale

• Yes/No

When users click the answer for the kiosk survey question in Service Portal, the survey is 
submitted, and the end note is displayed on the same page that contains the survey questions. 
The kiosk survey becomes read-only after it's clicked.

Note: 

• A kiosk survey doesn't have any Submit  or Cancel  buttons.

• A kiosk survey can't have a signature, dependent questions, or additional information.

• A kiosk survey doesn't display introduction notes.

URI parameters for One Click survey

Pass these URI parameters through the createAssessment()  API to store their values in the 
asmt_assessment_instance table for both platform view and Service Portal  view.

URI parameters

Parameter Description

sysparm_refresh_interval Refresh the time, in seconds, after the survey 
submission to create another instance. For example, 
sysparm_refresh_interval=5.

sysparm_trigger_table Location that is stored as the Trigger Table  field in 
the asmt_assessment_instance table. For example, 
sysparm_trigger_table=incident.

sysparm_trigger_id Location sys_id that is stored as the Trigger ID  field in 
the asmt_assessment_instance table. For example, 
sysparm_trigger_id=1c741bd70b2322007518478d83673af3.

sysparm_kiosk When set to true, both the sysparm_trigger_table and 
sysparm_trigger_id parameters should be specified. This 
parameter is required for kiosk requests. For example, 
sysparm_kiosk=true.

Related topics

Service Portal

Create and edit a page using the Service Portal  Designer

Survey designer

Configure a survey in the survey designer

Surveys in ITSM Virtual Agent

You can use surveys in ITSM Virtual Agent  to collect survey responses from users through 
conversational questionnaires (pre-chat and post-chat surveys) in the chat client.

A chat survey is available in ITSM Virtual Agent  through the Provide Virtual Agent Feedback topic. 
The logic that renders the survey dynamically is called from the re-usable Survey topic block. It is 
common to use the Provide Virtual Agent Feedback topic as the survey setup topic in the general 
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definitions of ITSM Virtual Agent, so that users automatically receive a survey at the end of their 
conversations. For information about the Survey topic block, see ITSM Virtual Agent .

When you select the Chat Survey  check box for a survey, the following conditions are validated 
for surveys on ITSM Virtual Agent.

• Survey should contain only one metric category.

• Survey can contain only these metric types.

◦ Attachment

◦ Boolean

◦ Check box

◦ Choice

◦ Date

◦ Date/Time

◦ Image scale

◦ Number

◦ Numeric scale

◦ Percentage

◦ Scale

◦ String

For information on configuring a survey, see Modify a survey definition  and Configure a survey in 
the survey designer.

The following capabilities are supported for the survey:

• Dependent survey fields

• Introduction and end notes

Association between a survey and Virtual Agent  chat

After a survey is submitted in a Virtual Agent  conversation, a survey instance is created. This 
instance displays the following information:

• Trigger ID, which is the sys_id of the associated interaction ID created in the Virtual Agent  chat

• Trigger table, which is the interaction table

Related topics

ITSM Virtual Agent

Legacy survey migration

Users with the survey_admin role can migrate legacy survey data to create copies of legacy 
surveys and their related records in assessment tables. The Survey Management application, 
which is built on the assessment engine, is available as an alternative to legacy surveys.

The following legacy survey components are migrated:

• Survey masters

• Supported survey questions and question choices
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• Survey instances

• Survey responses

Legacy survey conditions are not migrated and must be recreated as trigger conditions.

Note: 

• The Legacy Surveys  and Legacy Administration  modules are available on instances 
upgraded from a previous release but not available for new instances. Customers 
using legacy survey or survey wizard should plan to migrate to the Survey Management 
application to create modern and high quality surveys for their users.

• The following legacy survey plugins are inactive by default, and are available upon 
request:

◦ Best Practice - Task Survey Management (ID: com.snc.bestpractice.task_survey)

◦ Survey Management (ID: com.glideapp.survey)

◦ Assessment Components (ID: com.snc.assessment)

◦ Survey Wizard (ID: com.glideapp.survey_wizard)

• Survey wizards cannot be migrated.

Migrate a legacy survey

Migrate a legacy survey and its related records to take advantage of a more powerful feature set.

Before you begin
Role required: admin or survey_admin

About this task
To avoid timing out for very large surveys, you can disable the transaction quota. See Transaction 
quotas .

Procedure

1. Navigate to All  > Survey  > Legacy Surveys  > Masters.

The list of legacy survey masters appears. By default, the list shows only survey masters 
that have not been migrated. To show all survey masters, remove the Assessment is empty 
breadcrumb.

2. Open a survey and click the Migrate to New Survey Management  related link or Migrate to 
New Survey Management  in the title bar.
A dialog box describes what happens when you migrate the survey. Note that certain types of 
survey questions cannot be migrated.

3. Click OK.

The system generates records on assessment tables based on the survey master, eligible 
questions and choices, results, and other related survey components. The original survey 
components are unaffected.

System messages may appear at the top of the Survey form to notify you of questions that 
could not be migrated and to advise you to review migrated Multiple Choice  questions.

4. Optional:  Click the reference icon beside the Assessment  field to view the new survey 
definition.
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5. Optional:  Remove survey users from the assessment survey if you want all users to be able to 
take it.
When you migrate a survey, any users who have taken it are automatically associated with the 
assessment survey and become survey users. When there are survey users associated with an 
assessment survey, only those users can take it.

6. Deactivate any survey conditions associated with the survey by completing the following 
steps.

a. Navigate to Survey  > Legacy Administration  > Survey Conditions.

b. In the Active  column, ensure the value is false for any survey conditions that reference the 
migrated survey.

7. Navigate to Survey  > Administration  > Trigger Conditions  to create new trigger conditions for 
the migrated survey.

Result
The Migrate to Assessment  related link on the legacy survey record becomes unavailable after 
the migration. However, if you delete the record referenced in the Assessment  field, the related 
link reappears and you can migrate the legacy survey again.

Survey question migration

Before you migrate a legacy survey, understand that some legacy survey questions cannot be 
migrated due to incompatible question types.

Legacy survey questions are migrated from the Survey Question [survey_question_new] 
table to the Assessment Metric [asmt_metric] table. In legacy surveys, the Type  field on the 
Survey Question table determines how the question renders on the survey questionnaire. 
In assessment surveys, the Data type  field on the Assessment Metric table serves a similar 
purpose. Certain legacy survey types are not supported in assessment surveys.

The following table shows the conversion path for each legacy survey question type to an 
assessment data type, if there is one.

Survey question migration

Legacy survey type Assessment data type

Break Not available

CheckBox Checkbox

Date Date

Date/Time Date/Time

HTML Not available

Label Not available

List Collector Not available

Lookup Multiple Choice Not available

Lookup Select Box Not available

Macro Not available

Macro with Label Not available

Multi Line Text String (String  option set to Multiline)
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Survey question migration  (continued)

Legacy survey type Assessment data type

Multiple Choice Likert Scale

Numeric Scale Number

Reference Not available

Select Box Choice

Single Line Text String (String  option set to Single line)

UI Page Not available

Wide Single Line Text String (String  option set to Single line wide)

Yes / No Yes/No

Migrated components

When you migrate a survey, the system maps records from survey tables to assessment tables.

To create a functional survey on the assessment framework, the system converts survey records 
to the most logical equivalent assessment survey records. This may mean multiple assessment 
survey records represent one legacy survey record.

Migrated components

Survey component Assessment survey components

Survey master [survey_master] • Survey definition [asmt_metric_type]

• Assessable record [asmt_assessable_record], for 
system use only

• Survey category [asmt_metric_category]

Survey question 
[survey_question_new]

Survey question [asmt_metric]

Question choice 
[question_choice]

Assessment metric definition [asmt_metric_definition]

Survey instance [survey_instance] • Assessment group [asmt_assessment], for system use 
only

• Survey instance [asmt_assessment_instance]

Survey response 
[survey_response]

• Survey instance question 
[asmt_assessment_instance_question]

• Survey response [asmt_metric_result]

• Category result [asmt_category_result], for system use 
only
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Migrated question review

To maintain accurate result calculations, you may need to make minor adjustments to some of 
the migrated survey records to ensure results are calculated correctly.

Note: 
The assessment engine provides a built-in result calculation feature that converts each 
survey response to a score between 0 and 10. The configuration required to maintain 
accurate result calculations is advanced and is not recommended for basic survey 
implementations. If you do not plan to use result calculation data, ignore the information in 
this section.

For each legacy question migrated, the system creates a survey question record on the 
Assessment Metric [asmt_metric] table. For legacy questions of the Multiple Choice  and 
Select Box  types, the system also creates a metric definition record, on the Assessment Metric 
Definition [asmt_metric_definition] table, for each legacy question choice.

Comparable metric definitions and survey question choices

Survey question choice field Related metric definition field

Text Display

Value (can be any string value) Value (must be a numerical value)

Order Value (metric definition with smallest Value  is first)

When the system migrates legacy survey question choices, it uses the legacy Order  to set 
each metric definition Value. For the legacy question choice with the smallest Order, the 
corresponding metric definition Value  is set to 1. For the legacy question choice with the next 
smallest Order, the metric definition Value  is 2, and so on.

The Scale definition  field on the migrated Survey Question form determines whether smaller or 
bigger metric definition values equate to a good score in survey result calculations. By default, 
the scale definition is set to High, meaning bigger values are good. When you migrate a legacy 
survey, check that the default scale definition makes sense for each question.

For example, the following tables depict a sample migrated question and the metric definitions 
automatically created for it. Recall that the system uses the order of the legacy survey question 
choices to set the metric definition value. Excellent  has the lowest Order  value, so when the 
system creates a metric definition for this question choice, the Value  is set to 1. In this case the 
default scale definition value, High, does not make sense, as the system will calculate the worst 
scores for responses of Excellent.

Legacy question: Please rate the overall quality of your service

Question choice text Question choice vlue Question choice order

Excellent A 100

Good B 200

Fair C 300

Poor D 400
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Migrated question: Please rate the overall quality of your service

Metric definition display Metric definition value

Excellent 1

Good 2

Fair 3

Poor 4

If there are no Order  values for the legacy survey question choices, the system sets each 
corresponding metric definition Value  based on the alphanumeric order of the legacy Text  value.

Migrated question: Please rate the overall quality of your service

Metric definition display Metric definition value

Excellent 1

Good 2

Fair 3

Poor 4

You may also need to change the Scale definition  setting for other migrated questions. For 
details, see the scale definition recommendations for each survey question data type.

Surveys reference

Reference topics provide additional information about the forms, fields, and properties you use 
while working with surveys.

Survey roles

The Survey application uses the following roles.

To learn more about managing subscriptions, see Managing per-user subscriptions in 
Subscription Management  and contact your account representative.

No role is required to take assigned survey questionnaires.

Survey administrator [survey_admin]

Create and administer surveys. Survey administrators know what types of surveys are necessary, 
when to send a survey, and to whom. Survey administrators can use all modules in the Survey 
application menu.

Contains Roles

List of roles contained within the role.

• survey_reader

• assessment_admin

Groups

List of groups this role is assigned to by default.
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None.

Special considerations

None.

Survey reader [survey_reader]

View surveys and related information, such as survey responses, survey groups, scorecards, and 
reports.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

Survey creator [survey_creator]

Create a survey and assign it to the user who can take the survey and submit it. A survey creator 
can also create assessments.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

Key survey terms

These survey terms are used throughout the documentation to describe survey management 
functions and capabilities.

Key survey terms

Term Description

Survey 
definition

Root record on which a survey is built. A survey definition contains information 
such as the survey name, state, and distribution schedule. Each survey definition 
has its own categories and questions.
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Key survey terms  (continued)

Term Description

Survey definitions are comparable to legacy survey masters.

Public 
survey

Any user can take a public survey, even users who have not logged in to the 
ServiceNow  system. For a completed survey, the Assigned to  field value is Guest.

Survey 
category

Represents a theme for survey questions. Categories contain one or more 
questions. The system creates one category per survey by default. Additional 
categories are optional.

Survey 
question

A question that appears on a survey questionnaire for the associated survey 
definition.

Survey questions are comparable to legacy survey questions.

Survey 
user

User who is authorized to receive invitations for a restricted survey.

Survey 
instance

Represents one survey questionnaire assigned to one user.

Survey instances are comparable to legacy survey instances.

Trigger 
condition

Defines a rule that enables the system to send a survey when an action occurs on a 
table, such as when an incident closes.

Trigger conditions are comparable to legacy survey conditions.

Scorecard Visual representation of survey responses. Scorecards display a variety of data 
summaries for one survey definition.

Survey Overview dashboard

The Survey Overview dashboard displays various survey reports, such as Surveys by Metric Type 
and State.

Survey Overview dashboard reports

Report Table

Assignment Group Customer Satisfaction 90 
Day Average

Metric Results [asmt_metric_result]

Service Desk Survey 'Timely Response' 90 Days Metric Results [asmt_metric_result]

Surveys by Metric Type and State Assessment Instances 
[asmt_assessment_instance]

Service Desk Survey 'Overall Experience' 60 
Days

Metric Results [asmt_metric_result]

Service Desk Survey 'Tech Courteous' 90 Days Metric Results [asmt_metric_result]

Service Desk Survey 'First Call Resolve' 60 Days Metric Results [asmt_metric_result]

Service Desk Survey 'Tech Competence' 60 
Days

Metric Results [asmt_metric_result]
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Survey report

Metric Result form

Description of the field values for the Metric Result form.

Metric Result form

Field Description

Assessment 
group

Assessment group to which the metric result belongs. An assessment group is a 
container for survey instances and results generated in a single occurrence. The 
system generates an assessment group every time at least one survey instance 
is created. If multiple survey instances are created at once, such as when a 
survey administrator sends invitations to a list of survey users, they are all stored 
in the same assessment group.

Metric Question that the user answered.
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Metric Result form  (continued)

Field Description

Data type Data type of the question the user answered.

Method Assessment method. Always Assessment  for surveys.

Updated Date and time the metric result was last updated.

Source Survey definition from which the associated survey instance was generated.

Assigned to User who completed the survey questionnaire.

Instance Survey instance completed by the Assigned to  user.

Actual value
Value obtained from the user response to the question. The actual value is 
determined by the question data type:

• Checkbox:  The actual value is 0  if the check box is cleared and 1  if it is 
selected.

• Choice  or Likert Scale:  The actual value is equal to the Value  of the metric 
definition associated with the chosen answer option.

• Date, Date/Time, or String:  The actual value is -1  to indicate that these data 
types do not contribute to category result calculations.

• Template:  The actual value is equal to the Value  of the template definition 
associated with the chosen answer option.

• Yes/No:  The actual value is 0  if the response is No  and 1  if it is Yes.

Normalized 
value

Adjusted value that accounts for the Scale definition  setting, minimum and 
maximum values, and other factors.

The equation that generates the value and an example calculation appear in 
Normalized value for an assessment.

String value Value that displays the response as it appears on a questionnaire. In some cases 
this is the same as the Actual value, such as when the question data type is 
Percentage. The string value is N/A  for unanswered questions of certain data 
types.

Normalized value for an assessment

The normalized value is calculated based on a linear equation and the scale definition of the 
metric. This value can be used for risk assessment.

Normalized value for any metric

The normalized value is directly proportional to the scale definition of the metric. If the scale 
definition is low, that is, the lower scale values are better, then Normalized value = 1.0 
– Normalized value.

For the reporting purpose, use the Metric Result [asmt_metric_result] table.

Normalized value = (Input Value - Min value defined in metric) / 
(Max value defined in metric - Min value defined in metric) * 
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(current metric weight * bias / (sum of all metric weight in the 
metric category)) * scale_factor

Bias is the ratio of total metric weight in the category and the sum of valid metric weight in the 
metric category. While calculating bias, the scripted metrics are excluded.

Note: 

• If a metric is skipped when taking the assessment, its weight is excluded when 
calculating sum of valid metric weight in the metric category.

• The following metric types are excluded in the normalized value calculation:

◦ String

◦ Date

◦ Date/Time

◦ Reference

◦ Attachment

◦ Ranking

For example, consider the following scenario.

Calculate the normalized value for the Please rate the competency of the technician  metric.

Values of the metric

Input value 3

Minimum value 1

Maximum value 6

Current metric weight 10

Number of metrics in the metric category 6

• 4 of type=number

• 1 of type=yes/no

• 1 of type=string (invalid data type; value cannot 
be calculated)

Valid metric weight of each response 10

Scale factor 10

Normalized value = (3 - 1) / (6 - 1) * (10 / (10 + 10 + 10 + 10 + 
10)) * 10 = 0.8

Normalized value for a multiple selection metric

The normalized value for a multiple selection metric is calculated by using the weight of the 
metric and the score for each choice of the metric.

In a multiple selection metric, for each choice that should be used for the normalization 
calculation, define the normalization input value.
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Normalized value = (Score of all choices) * (current metric 
weight / (sum of valid metric weight in the metric category)) * 
scale_factor

Here, score of all choices of the metric is the sum of individual scores of each choice.

• Score of each choice in a multiple selection metric= 
Normalization input of the choice / max value of the metric

• max value of the metric = Sum of the normalization input for all 
choices of the metric

• min value of the metric is always 0

For example, consider the following scenario.

Calculate the normalized value for the multiple selection metric, Please rate the competency of 
the technician, with three choices, A, B, and C.

Values of the metric

Choice A Normalization input is 1

Choice B Normalization input is 1

Choice C Normalization input is 2

Minimum value 0

Maximum value 4

Current metric weight 10

Number of metrics in the metric category 5

Valid metric weight of each metric 10

Scale factor 10

If Choice A and B are selected, Normalized value = ((1 / 4) + (1 / 4)) * 
(10 / (10 + 10 + 10 + 10 + 10)) * 10 = 1

Weighted value for a risk assessment

For a risk assessment, the weighted value from metric results table is calculated as following.

weighted_value = metric.weight * result.actual_value

Domain separation and Surveys

Domain separation is supported in Surveys. Domain separation enables you to separate data, 
processes, and administrative tasks into logical groupings called domains. You can control 
several aspects of this separation, including which users can see and access data.

Support level: Basic
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• Business logic: Ensure that data goes into the proper domain for the application’s service 
provider use cases.

• The application supports domain separation at run time. The domain separation includes 
separation from the user interface, cache keys, reporting, rollups, and aggregations.

• The owner of the instance must set up the application to function across multiple tenants.

Sample use case: When a service provider (SP) uses chat to respond to a tenant-customer’s 
message, the customer must be able to see the SP's response.

For more information on support levels, see Application support for domain separation .

Overview

As a survey creator, survey_admin can create surveys in the assigned domain. A Global domain 
survey_admin can create or edit survey in any domain.

As a survey taker, a user can access the survey record and take the survey based on the domain 
of the survey record and user. Global domain users can take a survey in any domain.

How domain separation works in Surveys

There are several main areas to consider in how domain separation works in Surveys.

Surveys in domain-separated instances

The following domains are available by default after activating the Domain Support-Domain 
Extensions Installer [com.glide.domain.msp_extensions.installer] plugin. Only ServiceNow 
employees can activate this plugin.

• Global

• Acme

• Cisco

Access to surveys in domain-separated instances

Based on the domain of the survey record and users, users can access the survey record and 
take the survey.

Global domain users can access survey records in any domain. Users in any other domain can 
access records in their domain and Global domain. For example, users in the Acme domain can 
access records in the Acme domain and the Global domain.

Global domain users can take a survey in any domain. Users in any other domain can take 
surveys in their domain as well as the Global domain. For example, users in Acme domain can 
take surveys in the Acme domain and the Global domain.

Location of the 
survey record

Users who can access and take the survey

N/A Global Acme Cisco

Global Yes Yes Yes

Acme Yes Yes No

Cisco Yes No Yes
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Any domain user can assign a survey in that domain to the same domain user or a Global domain 
user. For example, an Acme domain user can assign a survey to a Global domain user or an 
Acme domain user. Users from other domains are not visible to the Acme domain user.

Although the Global domain user can view a survey from other domains, this user cannot assign 
the survey of one domain to a user from a different domain. For example, a Global domain user 
can assign a survey from the Acme domain to another Global domain user or an Acme domain 
user, but not to a Cisco domain user.

Note: 
When a task is closed in a child domain and the assigned survey is either in the child 
domain or the global domain, the user from the child domain can then take the survey.

Trigger conditions in domain-separated instances

A Global domain user can create a triggered condition for a survey from any domain. The Global 
domain user can create an incident and trigger the survey by selecting a user from the other 
domain in the User field  under Caller. However, the Global user cannot assign the survey to the 
user of different domain.

A user can assign a trigger condition to a survey if the user belongs to the Global domain or the 
Survey domain.

If there is no domain path for a trigger condition, users from any domain can view the trigger 
condition. For example, in the asmt_condition  table that has no column for the domain path, 
users from the Acme domain can view the trigger condition created by the Cisco domain users.

Related topics

Domain separation for service providers

Survey Designer Configuration form

Description of the field values for the Survey Designer Configuration form.

Configuration tab fields

Field Description

Active Select the check box to enable the distribution of this survey to recipients.

Survey 
Owners

Owners of the survey. You can add a user with the survey_creator, survey_admin, 
or assessment_admin role.

Anonymize 
responses

Select the check box to collect survey responses anonymously. Recipients are 
not listed with survey results. When a user submits a survey, the system clears 
the Assigned to  field for the associated survey instance. Also, survey responses 
for anonymous surveys do not contain Assigned to values.

Note: 
The Assigned to  field is cleared. However, each response record includes 
the Created By  and Updated By  fields that are accessible to users with the 
survey_admin role.

Description Description of this configuration or the survey to which it is attached.

Do not 
show 
survey 

Check box to skip the introduction notes when a survey is launched. This 
functionality is applicable in both the ServiceNow AI Platform  and Service Portal 
product versions.
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Configuration tab fields  (continued)

Field Description

introduction 
notes

Introduction Introductory content to display on surveys. You can add a welcome message or 
background information about the survey.

Signature Acknowledgement by a survey recipient of requirements, admonitions, or 
expectations related to a survey.

Return URL Destination address of a web page that is presented to users after they submit a 
completed survey. When a return URL is configured, the End note  content does 
not appear.

End note Content that is displayed to recipients after they submit a completed survey. 
You can add a thank you message, follow-up instructions, or other applicable 
information. End notes are not displayed if a Return URL  is specified.

Public 
Survey

Enables public access to the survey. No login is required to take a public survey 
and users or non-users can respond anonymously. For completed public surveys, 
the Assigned to  field value is Guest.

Note: 
This check box is available only after you save the survey.

Survey 
Publish URL

Specifies a URL of the survey that can be shared with users.

Note: 
This field is available only after you publish the survey.

Pagination 
setting for 
Service 
Portal view

Specify how the user will see pages on the desktop or tablet view in Service 
Portal.

• Category: Display each category on a separate page.

• Question: Display each question on a separate page. This happens for mobile 
regardless of this setting.

• None: All items on a single page—no pagination

Default: Category

Note: 
This field appears only when Service Portal is installed.

Chat 
Survey

Option to validate if survey questions are supported in a chat survey. Enables 
conversational questionnaires (pre-chat and post-chat surveys) in the chat 
client. Also enables you to map chat context variables to survey questions. For 
information on a chat survey in ITSM Virtual Agent, see Surveys in ITSM Virtual 
Agent

Note: 
This field is available only when the Glide Conversation Server plugin 
(com.glide.cs) is activated.
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Configuration tab fields  (continued)

Field Description

One Click 
Survey

Enables a One Click survey in Service Portal.

Note: 
This option can be selected if the Pagination setting for Service Portal 
view  is set to None.

Source 
Table

Table whose field is used as a dynamic value for a question in a triggered survey.

Note: 
When you select a source table, ensure that its relevant field is selected as 
Source Field  value of a metric.

Allow 
Sentiment 
Analysis

Enables sentiment analysis for this survey.

Duration Amount of time that recipients are given to complete this survey, starting from the 
time that the survey is generated. The default duration is 14 days.

Outlook 
Actionable 
Message

Includes an embedded survey in the survey email notification. After you select 
this check box and save the survey, a validation is run to ensure all survey 
questions are supported.

Availability tab fields

Accessible by Defines who can access the survey. Possible values are

• Anyone: Accessible by anyone with the survey link.

• Specific users: Accessible by specified users.

Survey groups 
only

If selected, a survey is available for survey groups only.

Note: 
This field is displayed only if the Accessible by  is Specific 
users.

Add group users Group users for whom the survey is available.

Note: 
This field is displayed only if the Accessible by  is Specific 
users.

Add users Users for whom the survey is available.

Note: 
This field is displayed only if the Accessible by  is Specific 
users.

Add recipients 
lists

Recipients lists for whom the survey is available.
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Availability tab fields  (continued)

Note: 
This field is displayed only if the Accessible by  is Specific 
users.

Properties form

Description of the field values for the Properties form of survey designer.

Question property fields

Field Description

Name Concise name of the question. The system uses this value to identify the question 
in Assessment Metric lists and in scorecard charts.

Question Text to display as the question on surveys. Enter a clear, straightforward question 
that is easy to understand.

Type Data type selected for this question. See the table in Controls  for the available 
data types.

Active Check box that determines whether this question is available on a survey. A 
question does not appear on surveys that are generated after the question 
becomes inactive.

Mandatory Check box to require users to answer the question. Mandatory questions are 
denoted by a red field status indicator and must be answered before the survey 
can be submitted.

This field is available when the question does not have a dependency and the 
question type is not Boolean  with a check box option.

Allow 
Additional 
Information

If selected, the Additional Information Label  field is enabled. The Additional 
Information Label  field value is displayed as a field on the survey response page 
to provide additional information for a question.

Note: 
This is not applicable for the String and Template data types.

Boolean 
option

Whether a check box or a Yes/No  list appears as the option for a Boolean 
question.

String 
option

Setting for the appearance of a string field in a question. This field is available 
when the question type is String. The string options include the following.

• Single line: Single-line text field 40 characters in length that allows strings of 
any length.

• String line wide: Full page width text field that allows a single-line entry of any 
length.

• Multiline: Full page width multiline text field that allows word wrap and returns
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Question property fields  (continued)

Field Description

Min Lowest positive whole number that users can enter or select to answer the 
question. This field is available when the question type is Number, Percentage, or 
Numeric Scale.

Max Highest positive whole number that users can enter or select to answer the 
question. This field is available when the question type is Number, Percentage, or 
Numeric Scale.

Allow not 
applicable

Check box for including Not Applicable  as an option for this question. Users 
can select Not Applicable  if they do not have sufficient information to respond 
to a question. User responses of Not Applicable  are excluded from results 
calculations.

This field is available when the question does not have a dependency and the 
question type is not Boolean  with a check box option.

Randomize 
answers

Check box for displaying answer options in a random order. Answer preference is 
sometimes influenced by the order in which options appear, which can result in 
biased results. Randomizing options can help prevent this bias.

Note: 
Randomizing options for certain questions may make those questions 
confusing for users. In general, only randomize options that do not follow a 
logical order.

Positive 
indicator

Setting that determines whether smaller or larger numerical values equate to a 
good score in result calculations. Select Low values  if smaller numerical values 
are better, such as for a question that measures the number of incidents for a 
vendor. Select High values  if larger numerical values are better, such as for a 
question that measures user satisfaction on a scale of one to five.

Source 
Field

Source table field that appears as a dynamic value for the question in a triggered 
survey. When this field value is selected, a ${param}  placeholder is added at 
the end of the question label.

Note: 
You can move this placeholder anywhere in the question label.

When a user takes the survey, the question with dynamic value is included in the 
survey instance and ${param}  placeholder is replaced with the source field 
value.

If the record table specified in the trigger condition does not match the source 
table specified for the survey, or if the system fails to get the dynamic value from 
the source record, the ${param}  placeholder is not replaced by any value and is 
displayed as is in the question.

For example, if the survey is triggered from a PRB  record and the survey question 
is configured with a dynamic value from Incident, the ${param}  placeholder in 
the survey question label is not replaced by any dynamic value and is displayed 
as is.

When survey questions are translated to other languages by a survey admin, the 
${param} placeholder should not be translated.
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Question property fields  (continued)

Field Description

Allow 
Sentiment 
Analysis

Includes this question for the sentiment analysis of a survey.

Note: 
This field is available only for String type questions.

Details Information about the question that is displayed on the survey. Include details that 
help users understand how to answer the question.

Choices Options for a question with a data type of Choice  or Scale. The system 
automatically adds text and values that you can edit for each option. You must 
have at least two options, and each option must have a unique value.

Click the +  icon to add an option, or click the X  icon to delete an option. By 
default, the system arranges options in the order established by their values. To 
change the order, drag and drop the options.

Note: 
Value numbers also contribute to the calculations of survey response 
scores, which can be used by advanced survey administrators.

Custom Metric form

Description of the field values for the Custom Metric form.

Custom Metric form

Field Description

Name Name of your custom metric type. The name appears on the Custom Metrics page.

Application Name of the application that you are creating the custom metric type for.

Icon An icon for the custom metric type. The custom metric type appears as the 
selected icon in Survey Designer.

Active Option to enable or disable the custom metric type. If selected, the Survey 
Designer shows the custom metric type.

Macro A macro that is used to render the custom metric type.
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Custom Metric form  (continued)

Field Description

Note: 

• If the Macro  field is empty, the question is not rendered on the platform 
form.

• The macro record that you select must contain an input element with the 
following attributes. This input element holds the value for the metric.

◦ datatype=”custom”

◦ name= “${jvar_question_name}”

• Value parameters can be accessed in a macro using the 
${jvar_value_params}  object.

Widget The widget is used to render the custom metric.

Note: 

• If the Widget  field is empty, the question is not rendered on the portal 
form.

• The widget record that you select must contain an input element with the 
following attributes. This input element holds the value for the metric.

◦ ng-model="page.fieldValue"

◦ ng-model-options="{getterSetter: true}"

• The client script must have $scope  as one of the parameters in the 
function definition. The value parameters can be accessed using the 
$scope.page.field.value_params  object.

Result type Result type for the custom metric type.

If a value is changed, the new results are stored as per the new value and the 
previous results remain unchanged. If a value is changed from string to number, 
the reports might not show the charts properly. If a value is changed from number 
to string, the scorecard is shown in a list view.

Value 
parameters

Value pairs that are passed to the custom metric type renderers. For example, in 
star ratings, you can pass a value as 5 for 5 stars or 10 for 10 stars.

Survey Instance form

Description of the field values for the on the Survey Instance form.

Survey Instance form

Field Description

Number Automatically generated record number.

Metric type Survey definition this survey instance was created from. Survey definitions are 
stored on the Assessment Instance table, and the field label on that table is 
Metric type.
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Survey Instance form  (continued)

Field Description

Due date Date by which the survey instance should be completed. The system populates 
the due date based on the Assessment duration  of the associated survey 
definition, which is set to 14 days by default.

The survey due date is not enforced in the base system. If you want to enforce 
the due date, consider using a workflow or other mechanism to send survey 
recipients reminders when a survey is overdue.

Note: 
By default, the system runs the Cancel Expired Assessments  script 
every 30 days to cancel expired survey, assessment, and quiz instances 
that are in the Work in progress or Ready to take states.

State State of the survey instance.

Assigned to User this survey instance is assigned to. This field becomes read-only when the 
state is In progress, Complete, or Canceled.

Domain Domain associated with the instance.

Expiration 
date

Date on which the assigned user can receive a new instance of the same survey 
definition. The system automatically populates the expiration date based on the 
Schedule period  of the associated survey definition.

Related Link

View User's 
Response

Shows a read-only version of the survey responses completed by the user.

Retry 
Sentiment 
Analysis

Sends the survey instances for sentiment analysis.

Note: 
This link is available only if any sentiment analysis result is not available for 
this instance under Survey  > Question Sentiment Results

Related List

Assessment 
Instance 
Questions

All instance question records, which store user response values for each 
question on the survey questionnaire. The following columns are relevant to 
surveys:

• Category: Displays the survey categories the questions belong to.

• Metric: Displays the survey questions.

Related topics

View a survey instance

Survey Question form

Description of the field values for the Survey Question form.
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Survey Question form

Field Description

Name Name of the question. When you create a survey, the question name is the same 
as the text in the Question  field.

Question Text to use for the question, which appears on survey questionnaires.

Data type Data type of the question. The fields for the response depend on the data type.

Note: 
If another question depends on this question, you cannot change the data 
type.

Template Question template to use for the answer options.

This field is visible and required only if the data type is Template.

Note: 
If another question depends on this question, you cannot change the 
template.

Scale 
definition

Setting that determines whether smaller or larger numerical values equate to 
a good score in result calculations. Select Low  if smaller numerical values are 
better, such as for a question that measures the number of incidents for a vendor. 
Select High  if larger numerical values are better, such as for a question that 
measures user satisfaction on a scale of one to five.

This field is visible and required only when certain data types are selected.

Randomize 
answers

Check box that determines whether to present the answer options for this 
question in a random order each time a user opens the survey. Answer 
preference is sometimes influenced by the order in which answer options 
appear, which can result in biased results. Randomize answer options to help 
prevent this bias.

This field is visible only if the data type is Choice  or Likert Scale.

Note: 
Randomizing answer options may make a question confusing. In general, 
only randomize answer options that do not follow a logical order.

Mandatory Check box that makes the question mandatory (selected) or optional (cleared) 
on survey questionnaires. Users cannot submit questionnaires until they provide 
valid responses to all mandatory questions, which are denoted by a red field 
status indicator.

This field is visible only when the Depends on  field is empty and the data type 
is not Checkbox. Questions that depend on other questions and check box 
questions cannot be mandatory.

Allow not 
applicable

Check box that determines whether to include a Not Applicable  answer option 
for this question on survey questionnaires. User responses of Not Applicable  are 
excluded from results calculations.
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Survey Question form  (continued)

Field Description

This field is visible only if the data type is Choice, Likert Scale, Template, or Yes/
No.

Allow 
Additional 
Information

If selected, the Additional Information Label  field is enabled. The Additional 
Information Label  field value is displayed as a field on the survey response page 
to provide additional information for a question.

Note: 
This is not applicable for the String and Template data types.

Depends on Setting used to make this a conditional question, meaning that it only appears 
when users answer another question a certain way.

To make a question depend on another question, select an existing question 
from the list, which displays Checkbox, Choice, Template, and Yes/No  questions 
of the same category as this question. Then, use the Displayed when  field to set 
the conditions that cause this question to appear on surveys.

The system prevents the creation of recursive dependencies between questions. 
For example, if Question A depends on Question B, Question B cannot depend 
on Question A.

Displayed 
when

Answer options for the selected Depends on  question which, when chosen on 
surveys, display this question. This field is visible and required only when the 
Depends on  field is set.

Min Smallest numerical value to be used as an answer option for this question. This 
field is visible and required only if the data type is Choice, Likert Scale, Number, 
or Percentage.

Max Largest numerical value to be used as an answer option for this question. This 
field is visible and required only if the data type is Choice, Likert Scale, Number, 
or Percentage.

String 
option

Selection that determines what kind of response text box appears for this 
question on survey questionnaires. This field is visible and required only if the 
data type is String.

Source 
Field

Source table field that appears as a dynamic value for the question in a triggered 
survey. When this field value is selected, a ${param}  placeholder is added at 
the end of the question label.

Note: 
You can move this placeholder anywhere in the question label.

When a user takes the survey, the question with dynamic value is included in the 
survey instance and ${param}  placeholder is replaced with the source field 
value.

If the record table specified in the trigger condition does not match the source 
table specified for the survey, or if the system fails to get the dynamic value from 
the source record, the ${param}  placeholder is not replaced by any value and 
is displayed as is in the question.

For example, if the survey is triggered from a PRB  record and the survey question 
is configured with a dynamic value from Incident, the ${param}  placeholder in 
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Survey Question form  (continued)

Field Description

the survey question label is not replaced by any dynamic value and is displayed 
as is.

When survey questions are translated to other languages by a survey admin, the 
${param} placeholder should not be translated.

Allow 
Sentiment 
Analysis

Includes this question for the sentiment analysis of a survey.

Note: 
This field is available only for String type questions.

Condition Condition to filter the reference records from the table specified in the Reference 
field.

Note: 
This field appears only for the Reference metric type.

Field 
validation

Validate the value entered for a String type metric of a survey. Possible 
validations are:

• Email

• IP Address(IPV4,IPV6)

• Phone Number (E.164)

• URL

Note: 
This field appears only for the String metric type.

Related Lists

Assessment 
Metric 
Definitions

Answer options for this question.

This related list is available only if the Data type  is Choice  or Likert Scale.

Related topics

Create or modify survey questions

Trigger Condition form for surveys

Description of the field values for the Trigger Condition form for surveys.

Trigger Condition form

Field Description

Assessment Survey to send.

Table Table to run the trigger condition on. You can select only tables in the current 
application scope. For example, to send a survey whenever an incident closes, 
select the Incident [incident] table.
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Trigger Condition form  (continued)

Field Description

User field Field that stores the users you want to send the survey. You can select any 
field, on the selected table or on a referenced table, that references the User 
[sys_user] table. Use the tree picker to select a field.

Note: 
To avoid requiring users to log in to take a survey with a trigger condition, 
set the survey to Public.

Repeat 
interval

Minimum period that must pass before the trigger condition can resend the 
survey to the same user. For example, assume the repeat interval is set to 
30 days. Even if the same user qualifies for multiple surveys from this trigger 
condition, the system can send only one survey every 30 days.

Note: 

• Ensure that the Schedule period of the selected survey definition is set to 
No Limit. If the schedule period is set to a different value, it prevents the 
trigger condition from sending surveys as expected.

• Trigger condition creates a survey instance irrespective of the repeat 
interval if the survey is set as anonymous.

Application [Admin only] Application is set to Core.

Active Check box that determines whether this trigger condition is active (selected).

Business 
rule

[Admin only] Business rule the system creates to monitor the selected table. 
When the condition is met, the business rule sends the survey to the correct 
user. No configuration is necessary for this business rule.

Trigger 
randomly

Check box that determines whether to send the survey to the appropriate 
user every time the condition is met (cleared) or only a percentage of the time 
(selected).

Probability 
(%)

Approximate probability that the survey is sent each time the condition is 
met. For example, if the probability is set to 50, the system sends the survey 
approximately 50% of the time the conditions are met. There are no repeat 
interval restrictions is assumed. This field is visible and required only when 
Trigger randomly  is selected.

Related 
Field 1- 4

Field that contains a value you want to store for reporting purposes. You can pick 
any reference field on the selected table. When the trigger condition generates a 
survey instance, the system stores the value from the triggering record. Specify 
up to four fields.

For example, select the Incident table, Assigned to  and Problem  as related 
fields. The system stores the assigned user and problem associated with the 
incident as Related record 1 and Related record 2 in the survey instance record. 
To view the fields, configure the form for any survey instance.

Note: 
You cannot use a related field for the ticket number because you cannot 
select the Number column. You can, however, use the trigger_id column of 
the table.

Description Summary information to identify the trigger condition.
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Trigger Condition form  (continued)

Field Description

Note: 
For a triggered record, the table title is used for the survey description.

Condition Condition builder that defines the criteria that must be true to send the survey. 
For example, to send a survey whenever an incident closes, create the condition 
[State] [is] [Closed].

Note: 
When defining conditions like case sensitivity or null values, see 
APIGlideFilter - Scoped, Global .

Related topics

Configure a trigger condition for a survey

Recipients List form

Description of the field values for the Recipients List form.

Recipients List form

Field Description

Name Name of the recipients list.

Type Type of users to include in the list. Possible values are:

• Contacts

• Internal Users

The selection of each type changes the dynamic conditions. For example, if you 
select Internal Users, the Table  field displays the value as User [sys_user].

State State of the recipients list.

• New: List has not yet been generated.

• In Progress: List is currently being generated. (You can see this state only when 
generating a very large list of recipients.)

• Complete: List is generated.

Setup

Method Method used to generate the recipients list. Possible values are:

• Upload File: Upload an Excel file with the recipients list using the specified 
template.

• Dynamic Condition: Run a script or condition builder to create the 
recipients list.
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Recipients List form  (continued)

Field Description

Note: 
When the Method  is Dynamic Condition, you can either use a script or 
a condition builder to create the recipients list.

Choose 
File

Allows you to download an Excel template, and then upload the Excel file with user 
information using the specified template.

Note: 

• This field is available only if the Method  is Upload File.

• The templates vary based on the entity selected in the Type  field. For 
accounts, the template includes columns for sys_id and account number 
values. For contacts, consumers, and internal users, the template includes 
columns for sys_id and email values.

Show 
Script

If selected, displays the script to create the recipients list.

Note: 
This field is available only if the Method  is Dynamic Condition.

Script Script to create the recipients list.

Note: 
This field is available only if the Method  is Dynamic Condition  and the 
Show Script  check box is selected.

Table Table that stores the user information. The table is selected based on the Type 
field.

Note: 
This field is available only if the Method  is Dynamic Condition.

User Field Table field that refers to users.

Note: 
This field is available only if the Method  is Dynamic Condition.

Conditions Condition builder to create the recipients list based on the specified table and 
user field. A condition is made up of a selected field, an operator, and a value. Add 
conditions using the AND and OR buttons. Delete conditions by clicking the Delete 
button to the right of a condition.

Note: 
This field is available only if the Method  is Dynamic Condition.

Related topics

Define a recipients list for surveys

Create a recipients list
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Assessments

Use assessments to evaluate, score, and rank records from any table in the system.

You can assess projects that executives want to evaluate for effective management, or rate 
and compare a vendor's goods and services. Use assessments to send custom questionnaires 
to selected users or write scripts that query the database directly. You can then compare 
assessment results for the records using unique graphical views designed to highlight key 
performance information. Share an assessment between ServiceNow  instances by using update 
sets, which is the recommended way to move assessment data from one instance to another.

The Assessments plugin is enabled by default.

You can only edit an assessment that has the same application scope as that of your current 
session.

The difference between assessments, surveys, and quizzes, and when to use each; also 
provides a quick look at the three stages in the survey process: designing, sharing, and 
evaluating.

Using assessments

Before you create assessments, assign the assessment_admin role to the appropriate users in 
your organization and determine your objectives for the assessment.

Assessment administrator tasks

Before you create assessments, assign the assessment_admin role to the appropriate users in 
your organization and determine your objectives for the assessment.

Decide which sets of records in the system to assess, which themes you are interested in, 
and which traits to measure. Consider your organization's options for obtaining the data to 
compare. If you intend to use assessment questionnaires, consider which people can answer 
the questions.

Assessment terminology

Assessment admins use several terms when working with assessments.

Term Description

Metric type A metric type  defines a set of records to evaluate, such as vendors, projects, or 
employees.

Assessable 
record

An assessable record  links a record to evaluate, such as the company record for 
Amazon or the user record for a sales representative, to a metric type, such as 
vendors or employees. You define sets of assessable records when you create 
metric types.

Metric 
category

A metric category  represents a theme for evaluating assessable records. 
Categories contain one or more individual metrics, which define specific traits or 
values that comprise the theme. Examples of categories include overall vendor 
performance or quality of delivery services. You can also set filter conditions that 
control which assessable records to evaluate for the metrics in a category.

Metric A metric  is a trait or value used to evaluate assessable records. A metric 
can measure subjective values in an assessment questionnaire, or gather 
objective values in a database query run by a script. Examples of metrics include 
perceived courtesy of sales representatives or number of incidents per vendor.
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Term Description

Category 
user

A category user  is a person who knows about a specific category. One person 
can be a category user for multiple categories. Examples of category users 
include a vendor manager who oversees all purchasing operations or a 
supervisor of a sales team.

Stakeholder A stakeholder  is a category user who knows about a specific assessable record. 
Examples of stakeholders include a vendor manager who coordinates purchases 
from Amazon or a supervisor of a sales team who manages a specific employee.

Assessment 
instance

An assessment instance  represents one assessment questionnaire assigned to 
one user. The system generates a new assessment instance for each assigned 
user when:

• The assessment generation scheduled job runs.

• An assessment administrator creates an on-demand assessment.

Scorecard A scorecard  provides a visual illustration of an assessable record's performance, 
based on assessment results. Use scorecards to view a variety of data 
summaries for one assessable record and to compare the ratings with other 
assessable records.

Decision 
matrix

A decision matrix  is a graph with two axes that plots the assessment results for 
multiple assessable records. Use decision matrixes to determine the relative 
standing of assessable records in selected categories.

Bubble 
chart

A bubble chart  is a graph with three axes that plots the assessment results 
for multiple assessable records. Use bubble charts to determine the relative 
standing of assessable records in selected categories, with an emphasis on one 
category.

Assessment roles

The Assessments application requires certain roles to perform assessment tasks. No role is 
required to take assessment questionnaires that are assigned to you.

Role Title Role Name Description

Assessment 
administrator

assessment_admin Assessment administrators set up assessments. They 
know which records to evaluate, the criteria on which to 
evaluate the records, and who to assign assessments to.

Note: 
By default, users with the assessment_admin role 
have limited system rights and might not have access 
to all source records to assess. When planning 
assessments, grant additional roles to assessment 
administrators as needed. For example, to create 
and manage vendor assessments, the assessment 
administrator must also have the vendor_manager 
role, which grants access to the Company table and 
other relevant tables.

ITIL user Base system 
roles

ITIL users perform basic technician operations in the 
system. In the Assessments application, they have read 
access to the Assessable Record table.
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Role Title Role Name Description

Administrator Base system 
roles

Administrators have access to all aspects of the 
assessment process. Only administrators can set up 
assessment schedules.

Assessment methods

The available methods are Assessment, for non-scripted metrics, and Script, for scripted 
metrics. Each method serves a different function and can be used with certain data types.

Use the Method  field to specify how to use the metric.

Assessment method

Metrics with the Method set to Assessment are called non-scripted metrics. Use each non-
scripted metric to define a question for assessment questionnaires. Non-scripted metrics are 
useful if you want to obtain subjective data like personal opinions.

You can use the Assessment method with these Data type  values:

• Attachment

• Checkbox

• Choice

• Date

• Date/Time

• Likert Scale

• Number

• Percentage

• String

• Template

• Yes/No

Script method

Metrics with the Method set to Script are called scripted metrics. Use each scripted metric to 
define a custom script for database queries. Scripted metrics are useful if your system contains 
reliable data for the traits you want to evaluate.

You can use the Script method with these Data type  values:

• Duration

• Number

• Percentage

Use the Script field to write JavaScript code. By default, the field contains information about 
available variables and an example, which you can use as the basis of your script or replace 
entirely:
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Metric form script field

You must use the following variables in your script:

• primary: Input variable used to access the sys_id of the record being assessed.

• actual_result: Output variable that contains the actual value for this metric. The system 
uses this variable to populate the Actual value field on the Metric Result form. For each 
actual_result,  you must specify a corresponding scaled_result  value.

• scaled_result: Output variable that contains a numerical scaled value to represent an 
actual value. The system uses this variable to populate the Scaled value  field on the Metric 
Result  form. Ensure the scaled values you specify are between or equal to the Min  and Max 
values for the metric. The Scale definition  field determines how the system uses the scaled 
value. A scale definition of Low  means smaller numbers are better, such as for a metric that 
measures the number of incidents for a vendor. High  means larger numbers are better, such as 
for a metric that measures user satisfaction on a scale of one to five.

Script example

The metric Number of active devices uses the script pictured below. The primary  variable is 
used to find CIs that are associated to the vendor record being assessed. The script retrieves 
the actual_result, the number of CIs associated to the vendor, then calculates the correct 
scaled_result. The script uses a series of scaled values, from the Min  to the Max  value, to 
represent actual values. Because the Scale definition  is set to High, the greatest scaled values 
are best, meaning a vendor associated to the most CIs scores highest. The system stores the 
actual and scaled values in a metric result record for the vendor.

Scripted metric example

Related topics

Assessment metrics

Create an assessment metric for a category
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Create an assessment metric definition

Update a metric minimum and maximum value to match a template

Configure an assessment

You can create a new assessment on a selected assessable records to evaluate, score, and rank 
records from any table in the system. Then create a metric category and assessment metrics for 
the assessment, publish the assessment, and assign it to the selected users.

Before you begin
Role required: admin, survey_creator, or assessment_admin

Procedure

1. Navigate to All  > Assessments  > Metric Definition  > Types.

2. Click New.

3. On the Assessment Metric form, fill in the fields.
For a description of the field values, see Assessment Metric form.

4. Create a new assessment and assign it to the assessors.
Do the following in the Assessment Metric form.

a. Add a condition: In the Condition  tab, add a condition to define the assessable records on 
which the assessment is created.

b. Add decision matrix fields: In the Decision Matrix  tab, add the required filter field to identify 
filter menu choices on decision matrices and scorecard averages for this type. For more 
information, see Decision matrixes .

c. Select the Assessors: In the Assessors  tab, select the users to whom the assessment will be 
assigned.

d. Generate Assessable records: When you save the assessment and click Generate 
Assessable Records, an assessable record is created for each unique user of the user field.

Note: 

▪ You must generate the assessable records, each time you update the condition.

▪ You can generate the assessable records only after updating the condition.

A new assessment is created. You must now create metric category and add assessment 
metrics to each metric category. Then publish the assessment and assign the assessment to 
the selected users.

e. Create a metric category: To create a metric category, do the following:

i. Open the assessment you just created and click New  in the Metric Categories  tab. Fill the 
form.

For more information about form fields, see Metric Category formform.

Tip: 
To know how to create metric category alternatively, see Create a category for 
assessable records.

ii. Open a metric category, add a condition, and click Assessable records  tab. The 
assessable records appear based on the selection made in the metric category form.

iii. Open a metric category, click Assessment Metric  tab to add the questions. Click New.
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For more information about form fields, see Assessment Metric form for a category.

Tip: 
To know how to create assessment metric category alternatively, see Create an 
assessment metric for a category.

f. Click Publish, to publish the assessment. For more information, see Publish a metric type.

g. Assign the Assessment to the required users. Do the following:

i. For an on-demand Assessments, click either the Assign Assessment  or Assign to 
Assessors  link to assign the assessment. For more information, see Generate an on-
demand assessment for multiple assessable records.

ii. For a scheduled Assessment, click the Generate Assessments  link to trigger the 
scheduled job immediately. For more information, see Generate a scheduled assessment 
manually.

Assessment generation

In the Assessments application, administrators or assessment administrators can trigger 
the system to generate scheduled assessments or on-demand assessments when all the 
prerequisite steps are completed.

An assessment administrator must publish the metric type to enable assessment generation.

The system performs these tasks when it generates assessments:

• Creates assessment questionnaires from non-scripted metrics and assigns the questionnaires 
to users. When users complete their assigned questionnaires, the system uses their 
responses to calculate assessment results.

• Runs scripted metrics from each category to query the database and calculate assessment 
results.

Each time the system generates assessments, it creates some or all of the following 
components. Consider having an administrator set a schedule for recurring data cleanup, as the 
system can potentially generate a considerable amount of assessment data.

• Assessment group

• Assessment instances

• Assessment results

Assessment groups

An assessment group is a container for assessment instances and assessment results 
generated in a single occurrence.

The system generates an assessment group every time the scheduled job runs or the API is 
called, when there is at least one assessable record associated to a category in the type. You can 
find assessment group records in Assessments  > Assessment Groups.

The Assessment Group form displays the group Number, the associated Metric type, and these 
related lists:

• Assessment Instances: Lists all assessment instances within this group. There may be no 
records in this related list. The system does not generate assessment instances if there are 
only scripted metrics for the type.

• Metric Results: Lists all metric results  for this group. There may be no records in this related 
list initially. The system generates metric results immediately for scripted metrics, but not for 
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non-scripted metrics, which appear as questions on assessments and require user response. 
The system dynamically updates the records in this list as users complete assessment 
questionnaires.

• Assessment Category Results: Lists all category results  for this group. There may be no 
records in this related list initially. The system generates category results immediately if there 
are only scripted metrics in a category. Otherwise, the system does not calculate category 
results until a user completes an assessment questionnaire that contains questions from the 
category.

Note: 
To prevent the loss of important assessment data, you cannot delete an assessment group 
if it contains any assessment instances, metric results, or category results.

View an assessment metric category

View assessment metric categories that are used with assessment metric types and assessment 
metrics in generating the bubble charts on the Demand Workbench. The bubble charts help the 
demand managers to visually assess the demands.

Before you begin
Role required: it_pps_admin

About this task
The Demand Management  application comes with an assessment metric type named Demand, 
five default assessment metric categories, and assessment metrics.

Procedure

1. Navigate to All  > Project Administration  > Settings  > Assessments Metric Categories.

2. Open an assessment metric category to review it.
The following default assessment metric categories are available with the Demand 
Management.

Demand assessment metric categories

Assessment 
metric 
category

Data source Description

Size T-Shirt size  field on the Demand  form. Assesses demand size relative to the 
size of other demands.

Strategic 
Alignment

View an assessment category result  field 
in the assessment category result for the 
Strategic Alignment metric category.

Assesses how closely the demand 
aligns with strategic goals of the 
organization compared to other 
demands.

Risk Rating  field in the assessment category 
result for the Risk metric category.

Assesses demand risks compared to 
other demands.

ROI Impact  and Financial return  fields on 
the Demand form.

Assesses demand return on 
investment compared to other 
demands.

Cost Labor costs, Capital expense, and 
Operating expense  fields on the 
Demand form.

Assesses demand cost compared to 
other demands.
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Assessment metric categories

In the Assessments application, a metric category represents a theme for evaluating assessable 
records in a given metric type.

Each category has a numeric weight value to indicate its importance relative to other categories. 
Within a category, records called metrics  are the traits or values used to evaluate assessable 
records. For example, there are many categories within the Vendor  metric type, including 
Support Rating, which contains metrics that measure the quality of vendors' customer support 
services. Assessable records must be associated to categories to be eligible for evaluation. 
Assessment administrators create categories and manage which assessable records each 
category is associated to.

Weight categories and metrics

When you create a metric category or metric, you must specify a weight, a numeric value that 
indicates the importance of the category or metric relative to other categories and metrics.

The greater the weight value, the more important the item is. The system uses weight values in 
assessment result  calculations. Consider these recommendations when choosing weight values.

• Determine a weighting scale and use it consistently. In general, use a scale with a small 
numeric range. A standard 1-10 scale is usually appropriate, where 1 is least and 10 most 
important. Understand that increasing the maximum value of a weighting scale impacts all 
related result calculations.

• Use the same weighting scale for metric categories and metrics. Though there is no limitation, 
consider using the same or very similar weighting scales for both categories and metrics to 
make it easier to remember which values to use. A scale of 1-10 is an effective and simple 
weighting system, but may not be suitable for all organizations.

Note: 
If you do not want to use weighting, set the same weight value for all categories and 
metrics. The default weight value is 10.

Related topics

Assessment metrics

Create an assessment metric for a category

Create an assessment metric definition

Metric templates

Update a metric minimum and maximum value to match a template

Create a category for assessable records

After you create a metric type and generate assessable records, create categories for the 
themes you are interested in using to evaluate the assessable records.

Before you begin
Role required: none

Procedure

1. Navigate to All  > Assessments  > Metric Definition  > Categories.

2. Click New  to create a new metric category.

3. On the Metric Category form, fill in the fields.
For a description of the field values, see Metric Category form.
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Related topics

Assessment metrics

Assessment metric categories

Assessable record associations

Assessable record associations

Only the assessable records associated to a category can be evaluated using metrics in that 
category. Manage which assessable records you evaluate for each category by creating and 
removing the associations.

Only the assessable records associated to a category can be evaluated using metrics in that 
category. Manage which assessable records you evaluate for each category by creating and 
removing the associations.

Note: 
You can also manage which categories an assessable record is associated to using the 
Assessable Record  form.

Related topics

Assessment metrics

Create a category for assessable records

Manage an assessable record automatically

Define at least one filter condition in the Metric Category form to automatically associate 
assessable records with the category.

Before you begin
Role required: assessment_admin or admin

Procedure

1. Navigate to All  > Assessments  > Metric Definition  > Categories.

2. Open a category.

3. In the Filter  field, create a condition statement that defines the records you want to associate 
to this category.

The available fields are from the table defined for the metric type. For example, for a category 
in the Vendor  type, you might create the condition [Country] [is] [Germany]. Metrics in the 
category will be used only to evaluate vendors that are located in Germany.

4. Save the record.

The system associates this category to all assessable records that match the filter condition. 
As the system generates new assessable records that match the condition, it associates them 
to this category. If you change the filter condition, the system removes and creates assessable 
record associations, as appropriate.

Note the following:

◦ The system does not remove assessable record associations created manually, even if the 
assessable records do not match the filter conditions.

◦ The system deletes any related stakeholders, if applicable, when it disassociates assessable 
records from a category.
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◦ The system does not create or remove assessable record associations if the related source 
records change. For example, consider the previous example in which all assessable 
records for vendors based in Germany were associated to a particular category. Assume that 
a user changes the Country  of one of the vendor records from Germany  to Canada. The 
system does not disassociate the related assessable record from the category, even though 
it no longer matches the filter condition.

Note: 
To configure the system to automatically associate all assessable records from a metric 
type to a category, use the same category condition as the metric type condition. For 
example, if the Vendor  metric type has the condition [Vendor] [is] [true], create the same 
condition for the category. If the metric type does not have a condition specified, you can 
use the category condition [Sys ID] [is not empty], which includes all records from any 
table.

Related topics

Assessment metrics

Create a category for assessable records

Manage an assessable record manually

You can manually create and remove assessable record associations for a category using a 
related list on the Metric Category form.

Before you begin
Role required: assessment_admin or admin

About this task
Keep in mind that when you disassociate an assessable record from a category, the system 
deletes any related stakeholders, if applicable, and you can no longer evaluate the assessable 
record using metrics in that category.

Procedure

1. Navigate to All  > Assessments  > Metric Definition  > Categories.

2. Open a category.

3. In the Assessable records  related list, click Edit  and use the slushbucket to add or remove 
one or more assessable records.

Only assessable records associated to this category's metric type are available for selection.

Related topics

Assessment metrics

Create a category for assessable records

Delete a category

When you delete a category, the system also deletes the associated category users and 
stakeholders.

Before you begin
Role required: assessment_admin or admin
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Procedure

1. Navigate to All  > Assessments  > Metric Definition  > Categories.

Alternatively, navigate to a record that contains a related list for categories.

2. Open a record from the list.

3. On the Metric Category form, click Delete.

4. Click OK  when asked to confirm the action.

The system displays messages at the top of the form describing the actions taken.

Related topics

Assessment metrics

Create a category for assessable records

Assessment metrics

In the Assessments application, a metric is a trait or value used to evaluate assessable records.

Depending on the metric method, a metric can be used as either of the following:

• A question on assessment questionnaires, to obtain a subjective value such as how much 
people enjoy using each cell phone offered in the service catalog.

• A script that queries the database, to obtain an objective value such as the number of 
incidents related to each cell phone.

Each metric is associated to one metric category  and can be used to evaluate assessable 
records for that category only. For example, the Support Rating category contains metrics that 
measure the quality of vendors' customer support services. One metric addresses the quality of 
product documentation. Others address the strength of the user community, self-service options, 
online training, and other support services. Each metric has a numeric weight value to indicate its 
importance relative to other metrics in the same category.

Assessment administrators can create and administer metrics and metric templates, which 
define reusable sets of answer options for metrics used as assessment questions. If you decide 
to use metric templates, you may want to create them before you create metrics.

Note: 
Changes to assessment metrics and metric templates are reflected in assessment 
questionnaires and results, even if users have saved responses already. If possible, avoid 
changing the original meaning of a metric question, the data type, or any metric templates 
in use by existing assessments.

Related topics

Update a metric minimum and maximum value to match a template

Create an assessment metric for a category

After you create a category, create metrics you can use to evaluate the assessable records for 
that category.

Before you begin
Role required: assessment_admin or admin
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About this task
When you create metrics, consider the focus of the category and what characteristics you want 
to measure for the items you will assess.

Procedure

1. Navigate in one of the following ways.

Option Description

Assessments  > Metric Definition  > Cate­
gories

Open a category, and locate the Assessment 
Metrics  related list.

This is the suggested navigation path, as the 
system links metrics to the category from 
which they are created.

Assessments  > Metric Definition  > Metrics  

2. Click New.

3. On the Assessment Metric form, fill in the fields.
For a description of the field values, see Assessment Metric form for a category.

4. Save the record.
When you create a Choice  or Likert Scale  question, reopen the Assessment Metric form after 
you submit it to create a metric definition. If you distribute a questionnaire without creating the 
answers for questions with these data types, recipients are unable to answer the quesitons. If 
the questions are mandatory, the recipients are unable to submit their questionnaires.

Related topics

Assessment metrics

Create an assessment metric definition

Update a metric minimum and maximum value to match a template

Create an assessment metric definition

Metrics with Choice or Likert Scale data types must have metric definitions defined to represent 
answer options on questionnaires.

Before you begin
Role required: assessment_admin or admin

About this task
Each metric definition appears as one answer option for a question on an assessment 
questionnaire. For example, a metric for the question "How satisfied are you with the quality 
of this vendor?" has three metric definitions to create these answer options: Very satisfied, 
Somewhat satisfied, and Not at all satisfied.

Procedure

1. Open the metric record you want to edit.

2. In the Assessment Metric Definitions  related list, click New  to create a new metric definition.

3. Fill in the fields:

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3699



◦ Display:  Enter the text you want to appear as the answer option.

◦ Value:  Enter the numeric value, greater than or equal to zero, to which the answer option 
equates. Values are used to calculate metric results. When you view assessment questions, 
metric definitions appear in order from least to greatest value.

▪ The system sets the minimum and maximum values according to the metric definition 
values.

▪ To prevent reporting confusion, no two metric definitions for a given metric should have 
the same Value.

4. Click Submit.

Related topics

Assessment metrics

Metric templates

Change the order of an answer

By default, the order of answer options is established when a question is created with a data 
type of Choice  or Likert Scale.

Before you begin
Role required: assessment_admin or admin

About this task
The system creates an Order value for each choice based on where it appears in the original 
list when you submit it. This order corresponds to the Value  setting you give the answer. The 
choice with the lowest order number appears first, and the choice with the highest order number 
appears last. If you want to reconfigure the order of the answer options, you must do so by 
editing the Order  field and not the Value  field.

The Order  column is hidden in the base system.

Procedure

1. Access the question record.

2. Configure the Assessment Metric Definitions related list to display the Order  column.

3. Edit the order number in the list.

Note: 
The Value  setting remain the same for each answer option after reorganization.

Related topics

Assessment metrics
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Metric types and assessable records

In the Assessments application, assessment administrators create and administer metric types 
and assessable records.

A metric type defines a set of records an organization wants to evaluate, such as vendors, 
projects, or employees. For each type, the system generates unique assessable records that 
link the type to records that need to be evaluated, such as the individual records for the vendors 
Amazon and Intel. There may be multiple assessable records for the same source record if the 
source record meets the criteria for more than one type.  For example, you might want to evaluate 
a record on the Company table, such as Intel, as a vendor and as a manufacturer, with different 
categories  and metrics.

For configuration suggestions, see Assessment administrator tasks.

Assessable records

An assessable record links a source record you want to evaluate, such as the company record 
for Amazon or the user record for a sales representative, to a metric type, such as vendors or 
employees.

You use assessments to evaluate the assessable record. The system generates assessable 
records from the source records that match the table and conditions set on the Assessment 
Metric Type form. You evaluate the assessable records with metric categories and metrics, 
which define traits and values to assess. For metric types with the On demand  schedule type, 
you can generate on-demand assessments  from the Assessable Record form. This method of 
assessment generation makes it easy to create and preview short questionnaires or to quickly 
obtain assessment results for specific assessable records.

You can set up an assessment description that includes information from multiple fields on an 
assessable record and is displayed on multiple lines. This set up provides the user who is taking 
the assessment with a more detailed and understandable description of the information being 
requested on the assessment questionnaire. Create a multi-line description using table titles, 
which can be defined to use one or more fields from the selected table.

Related topics

Use update sets for surveys and assessments

Metric types and assessable records

View an assessable record

Create metric types and generate assessable records

Create a metric type, which sets a table and filter conditions that define a set of records to 
evaluate.

Before you begin
Role required: assessment_admin or admin

About this task
For example, the Vendor Performance application provides the Vendor  metric type, which 
defines an assessable record for each source record in the Company [core_company] table that 
has the Vendor  field selected. Create a metric type for each set of records you want to evaluate, 
such as vendors, users within an organization, or projects.

In addition to defining assessable records, metric types also determine how to filter decision 
matrix data and set the schedule type, which determines whether assessments are on-demand 
or scheduled.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3701



Procedure

1. Navigate to All  > Assessments  > Metric Definition  > Types.

2. Click New.

3. On the form, fill in the fields.

Metric types form

Field Description

Name [Required] Name of the type. It may be practical to give the type a name that 
indicates which records it defines.

Assessment 
duration

Amount of time assessors have to complete their assigned questionnaires, 
starting from the time the assessment is generated. The assessment duration 
sets the Due date  that appears on assessment instances. Changes made 
to the duration of an attestation in the GRC Control Test Definition form are 
updated dynamically in this field. The default duration is 14 days.

Live feed Check box that determines whether to enable (selected) or disable (cleared) 
the Live Feed view in scorecards for all assessable records created from this 
type.

Notify 
manager if 
overdue

Check box that determines whether to send (selected) email notifications a 
user's manager when that user fails to submit an assigned questionnaire on 
time.

Assessment 
manager

Manager for this assessment metric type. These users are responsible only for 
managing the assessment process and not the results. The system notifies the 
assessment manager when an assessment for this metric type is past due.

Scoring 
type

Scoring method to use for questions with a data type of attestation. The 
possible selections are:

◦ Percent: Attestation score as a weighted percentage of correct answers 
for scored questions. When you select this scoring type, categories can be 
scored as Percent  or All or nothing.

◦ All or nothing: Requires all answers for attestation type questions to be 
correct, or the score is zero for the entire attestation. When you select this 
scoring type, all categories are scored automatically as All or nothing.

Scale factor [Required] Number to represent the best possible score for assessment 
results. All results for assessments of this type are scaled to this number. 10 is 
generally a good scale factor.

Note: 
This field becomes read-only when it contains a value and you save the 
metric type. Choose a scale factor you are satisfied with before you save 
the metric type.

Pagination 
setting for 
Service 
Portal view

Specify how the user will see pages on the desktop or tablet view in Service 
Portal.
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Field Description

◦ Category: Display each category on a separate page. The categories appear 
in the following order:

▪ Each category appears in sequence on a separate page for the first 
assessable record

▪ Then each category appears in sequence on a separate page for the next 
assessable record

▪ and so on

◦ Question: Display each question on a separate page. Questions appear on 
separate pages for mobile devices regardless of this setting. Each question 
appears for each category as described for the Category  setting.

◦ None: All items on a single page—no pagination
Default: Category

Note: 
This field appears only when Service Portal is installed.

Roles Additional user roles that can view the results and access records associated 
with this type. Users with the specified roles have read access to this type 
record as well as to associated categories, metrics, assessable records and 
scorecards, category users, stakeholders, and decision matrixes.

Note: 
Users with these roles do not have access to Assessments modules 
unless they are also assessment administrators. Users with these roles 
can navigate to the records by other means, such as from reference 
fields on assessment instances. This field provides the option to easily 
grant certain users access to specific assessment data in special cases. 
For example, the Vendor  metric type provides access to users with the 
vendor_manager role so they can view results and compare assessable 
records when they open scorecards or decision matrixes in the Vendor 
Performance application.

Signature [Optional] Acknowledgement by a survey recipient of requirements, 
admonitions, or expectations related to an assessment. For more information, 
see Create an assessment signature.

Return URL Destination address of a web page that is presented to users after they submit 
an assessment for this metric type. When a return URL is configured, the end 
note content does not appear.

State [Read-Only] Status of the assessment: Draft  or Published.

Business 
rule

[Admin only] Business rule the system creates to monitor the specified table. 
When a new record is added to the table that meets the metric type conditions, 
the business rule generates a corresponding assessable record.

If someone changes the table or conditions of the metric type, the system 
updates the business rule to reflect the changes. Existing assessable records 
associated with the metric type are not affected.

Schedule 
type

Setting that determines which assessment process to use. Select On demand 
or Scheduled.
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Field Description

Scheduled 
job

[Admin only] Scheduled job the system creates to generate assessments for 
this metric type. This field is populated the first time you save the record. The 
scheduled job name follows the format <type name> Assessment Creation. 
Administrators can configure a recurring assessment generation schedule for 
the metric type.

This field is visible only when the schedule type is Scheduled.

Note: 
If you change the schedule type from Scheduled  to On demand, the 
system deletes the scheduled job. If you change the schedule type back 
to Scheduled, the system creates a new scheduled job. The previous 
assessment generation schedule is not saved, but can be reconfigured if 
desired.

Evaluation 
method

[Admin only] Indicates the evaluation method for this metric type. The system 
sets this field based on how the metric type is created. The possible evaluation 
methods are:

◦ Assessment: Default filter value for metric types. Only this evaluation 
method uses assessable records, conditions, and stakeholders.

◦ Attestation: For details, see

Attestations - Legacy .

◦ Survey: For details, see Survey definitions.

Scale factor [Required] Number to represent the best possible score for assessment 
results. All results for assessments of this type are scaled to this number. 10  is 
generally a good scale factor.

Note: 
This field becomes read-only when it contains a value and you save the 
metric type. Choose a scale factor that you are satisfied with before you 
save the metric type.

Allow retake Check box that allows users to modify their answers to a completed 
assessment, quiz, survey, or attestation. After the due date, the system 
removes the assessment from the user's My Assessments and Surveys page.

Active Check box that determines whether the metric type is active. When the metric 
type is inactive (cleared), assessment generation is disabled and users cannot 
take existing assessments.

Description Helpful information about this type. Enter a clear description of the type and its 
purpose.

Introduction Introductory content to display on assessment questionnaires. Consider 
adding a company logo, a welcome message, background information about 
the survey, or instructions. You may need to configure the form to see this field.

End note Content to display on the screen that appears when someone submits an 
assessment questionnaire. Consider adding a thank you message, followup 
instructions, or other applicable information. You may need to configure the 
form to see this field. End notes are not displayed if a Return URL  is specified.

Send 
notifications

Select the check box to send notifications for this assessment, survey, or 
attestation. You may need to configure the form to see this field.
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Field Description

Condition section

Table [Required] Table that contains the records you want to evaluate. The system 
creates assessable records for records on this table that meet the conditions 
you specify, if any. The number of matching records appears as a link by the 
Condition  field. The link dynamically updates if you change the table selection. 
Click the link to open the list of matching records in a new tab or window.

Note: 
Additional roles are required to view the records on certain tables. If you 
select a table that you do not have access to, a warning message appears 
by the Condition  field where the number of matching records would 
be. You cannot generate assessable records for tables you do not have 
sufficient roles for.

Enforce 
condition

Check box that determines what happens to assessable records when you 
change the selected table or conditions.

Condition Condition builder that defines specific records to assess from the selected 
table. If you do not specify any conditions, the system creates assessable 
records for all records on the selected table. Click the refresh icon to update 
the adjacent record count.

Note: 
If you change the table or conditions, you must click Generate 
Assessable Records  to create new assessable records.

Decision Matrix section

Filter field [Required] Field on the selected table that can be used to filter results on 
decision matrixes and scorecards. For example, if the selected table is 
Company  [core_company]  and you choose Vendor type  as the filter field:

◦ When you view decision matrixes for this type, the decision matrix menu to 
filter plotted items lists vendor types: Applications, Hardware, Services, 
and Software.

◦ On scorecards for this type, the Averages view displays ratings by vendor 
type.
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Field Description

Filter 
condition

Condition builder that defines which records from the table are available as 
choices on the filter menu. For example, if the filter field is Vendor type  and you 
create the filter condition [Name] [does not contain] [Hardware], only records 
with vendor types of Applications, Services, and Software  are possible 
choices as decision matrix filters.

Default 
matrix filter

Record to use as the default filter choice on decision matrixes and scorecards. 
The selected Filter field  and Filter condition  control the available record 
choices. To see the records, if any, click the refresh icon next to the field. 
Consider the case that the filter field is Vendor type  and you select 
Applications  as the default matrix filter. The filter choice on decision matrixes 
for this type is set to Applications  by default.

If you change the value of the Table  or Filter condition  field, you must click the 
refresh icon to view the updated Default matrix filter  choices. If you do not, the 
system selects the first available choice from the updated field choices when 
you save the record.

Related Lists

Metric 
Categories

All metric categories associated with the type.

Assessable 
Records

All assessable records associated with the type. This related list is hidden in 
the Attestation view of this form.

The Generate Assessments  button is visible to administrators in certain cases for scheduled 
assessments. Do not click the button until after completing the prerequisite tasks.

4. When you are satisfied with the type settings, click Generate Assessable Records  to save the 
record and create assessable records.
You must click Generate Assessable Records  to create the initial set of assessable records 
based on the table and conditions specified on the type record. After that, the system creates 
an assessable record each time a new matching record is created. Generate Assessable 
Records  is located under Related Links.

Note: 
Clicking Generate Assessable Records  can trigger the deletion of existing assessable 
records under certain circumstances. For more information, see Enforce a condition to 
delete an assessable record.

The page redirects to the list of assessable records created.

Related topics

Assessment scorecard averages

Schedule an assessment

Schedule types

Set an assessment generation schedule

On-demand assessments

Enforce a condition to delete an assessable record

Metric types and assessable records

Configuring the form layout
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Delete a metric type

Deleting a metric type entails deleting many related records.

Before you begin
Role required: assessment_admin or admin

About this task
You must delete some of these records manually before deleting the type, while the system 
deletes others automatically with the type.

Procedure

1. Delete the records associated with the type to delete:

◦ Assessment results  (metric and category results)

◦ Assessment instance  (questions and assessment instances, in that order)

◦ Assessment groups

2. Delete the type.

A confirmation dialog box appears and alerts you that certain records associated with the type 
will also be deleted.

3. Click OK  to delete the type and these related records:

◦ Scheduled job for assessment generation

◦ Business rule for assessable record generation

◦ Assessable records

◦ Metric categories

◦ Category users

◦ Stakeholders

◦ Metrics

◦ Metric definitions

◦ Decision matrixes

Related topics

Metric types and assessable records

Export an assessment

You can share assessments between ServiceNow  instances by exporting an assessment and 
then importing the assessment on another instance.

Before you begin
Role required: assessment_admin or admin

Note: 
Update sets are available in the Helsinki release and should be used to move data from one 
instance to another. For information about update sets, see System update sets .

About this task
Note: 
The system exports a single XML file that does not contain result data.
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The XML file contains a metric type [asmt_metric_type]  and the following records that are 
associated with the type:

• Assessable records [asmt_assessable_record]

• Metric categories [asmt_metric_category]

• Metrics [asmt_metric]

• Metric definitions [asmt_metric_definition]

• Category users [asmt_m2m_category_user]

• Stakeholders [asmt_m2m_stakeholder]

• Decision matrixes [asmt_decision_matrix], [asmt_m2m_xcategory_matrix], 
and [asmt_m2m_ycategory_matrix]

Procedure

1. Navigate to All  > Assessments  > Metric Definition  > Types.

2. Right-click the record and select Export Assessment.

3. Save the XML file.

Related topics

Import an assessment

Metric types and assessable records

Import an assessment

Share assessments between ServiceNow  instances by importing a previously exported 
assessment.

Before you begin
Role required: admin

Note: 
Update sets are available in the Helsinki release and should be used to move data from one 
instance to another. For information about update sets, see System update sets .

Procedure

1. Ensure that the target instance has assessments enabled.

2. Import the assessment.

Related topics

Export an assessment

Use update sets for surveys and assessments

Use an update set to capture changes to surveys and assessments.

Before you begin
Role required: admin or survey_admin

Procedure

Create an update set and use it to make changes on a development instance.
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Note: 
For more information, see System update sets .

When developing surveys and assessments, use an update set to capture the changes and 
move them from a development instance to a production instance. Once an update set is 
created and marked current, all of the updates to the following tables are recorded in the update 
set.

The following tables are now update set enabled and also extend the application file:

• Assessment Metric Templates [asmt_template]

• Assessment metric type [asmt_metric_type]

• Assessment Template Definitions [asmt_template_definition]

• Assessment Metric Definitions [asmt_metric_definition]: survey question answer options

• Schedule [sys_trigger]: scheduled jobs associated with the survey

• Assessment Metric Categories [asmt_metric_category]: survey categories

• Assessment Metrics [asmt_metric]: survey questions

• Assessment Category Users [asmt_m2m_category_user]: survey users

• Trigger Conditions [asmt_condition]

Create an assessment signature

A signature on an assessment questionnaire contains assertions  that can communicate 
directions, a legal statement, or any text that you want the recipient to consider.

Before you begin
Role required: assessment_admin or admin

About this task
You can require the recipient to select a check box or provide a full signature to acknowledge 
acceptance of the assertion before submitting the form. You can display assertions without 
requiring a signature. An assessment property called Require authentication for user signature 
allows you to require users to provide their user name and password when an assessment asks 
for a full name signature.

Procedure

1. Navigate to All  > Assessments  > Metric Definition  > Signatures.

All signatures in the system appear in this list.

2. Click New.

3. Complete and submit the form using the fields in the table.

Assessment signature fields

Field Description

Name Descriptive name for this signature

Signature 
type

Type of signature required. The selections are Checkbox, Full name, or Assertion 
only. If Assertion only  is selected, no signature is required to submit the 
questionnaire. By default, the system requires user authentication for a full name 
entry.

Assertion Text to present to recipients that requires acknowledgement.
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Assessable records

An assessable record links a source record you want to evaluate, such as the company record 
for Amazon or the user record for a sales representative, to a metric type, such as vendors or 
employees.

You use assessments to evaluate the assessable record. The system generates assessable 
records from the source records that match the table and conditions set on the Assessment 
Metric Type form. You evaluate the assessable records with metric categories and metrics, 
which define traits and values to assess. For metric types with the On demand  schedule type, 
you can generate on-demand assessments  from the Assessable Record form. This method of 
assessment generation makes it easy to create and preview short questionnaires or to quickly 
obtain assessment results for specific assessable records.

You can set up an assessment description that includes information from multiple fields on 
an assessable record and is displayed on multiple lines. This provides the user who is taking 
the assessment with a more detailed and understandable description of the information being 
requested on the assessment questionnaire. Create a multi-line description using table titles, 
which can be defined to use one or more fields from the selected table.

Related topics

Metric types and assessable records

View an assessable record

View an assessable record

View the Assessable Record form to edit preferences and perform various actions.

Before you begin
Role required: assessment_admin or admin

Procedure

1. Navigate to All  > Assessments  > Assessable Records.

2. Open a record from the list.
By default, the list displays only assessable records with Active  metric types.

3. On the Assessable Record form, edit fields and perform other actions as necessary (see table).

Viewing Assessable Records

Field Description

Name [Read-Only] Assessable record name based on the Select a field as the 
table display value  of the source record. The name appears on assessment 
questionnaires.

Source [Read-Only] Source record the assessable record is linked to. The Source 
reflects the table name and source record display value. For example, if the 
Name  field is the display value for the Company table, the assessable record for 
a company record named Amazon  has the Source  value Company: Amazon.

Live feed Check box that, when selected, creates a live feed group for the assessable 
record, which appears on the scorecard. If you clear the check box after a live 
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Field Description

feed group has been created, the system deletes the live feed group and all its 
messages.

Type [Read-Only] Metric type from which the assessable record was generated.

Decision 
matrix

Check box that, when selected, enables this assessable record's results data 
to appear on decision matrixes of the same metric type. Decision matrixes are 
graphs that plot the assessment results for multiple assessable records. If you 
clear the check box, the assessable record still appears on the default decision 
matrixes if you click the View Matrix  related link on the assessable record's 
scorecard.

Live feed 
group

[Read-Only] Live feed group for this assessable record. When you select the Live 
feed  check box and save the record, the system populates this field.

Related Links

View 
Scorecard

Opens the scorecard for the assessable record.

Related Lists

Category All metric categories associated with the assessable record. An assessable 
record must be associated to a category to be evaluated. Click Edit  to add or 
remove category associations. Note that it is often more efficient to associate 
assessable records  to categories using the Metric Category form.

Category 
users

All stakeholders who can take assessment questionnaires about this assessable 
record. Click Edit  to create and delete stakeholders. For more information about 
this and other methods of creating stakeholders, see Stakeholders.

This related list is available only when the associated metric type has the 
Scheduled  schedule type.

Related topics

Metric types and assessable records

Enforce a condition to delete an assessable record

By default, the system does not delete assessable records, even if you change the table or 
conditions for the type and the existing assessable records no longer match.

Before you begin
Role required: assessment_admin or admin

About this task
The system can be configured so you can trigger the deletion of assessable records that do not 
match the type table and conditions.

Procedure

1. On the Assessment Metric Type form, select the Enforce condition  check box to enable 
deletion of existing assessable records of this type that do not match the table or conditions 
specified.

When the check box is cleared, the system retains existing assessable records of this type, 
even if they do not match the table and conditions specified.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3711



2. Click Generate Assessable Records  to delete all assessable records associated with the type 
that do not match the current table and conditions.

The system does not automatically delete assessable records, even if the Enforce condition 
check box is selected. You must click Generate Assessable Records  with the check box 
selected every time you want the system to delete non-matching assessable records.

Related topics

Metric types and assessable records

Delete an assessable record

When you delete an assessable record, the system deletes any stakeholders for the record.

Before you begin
Role required: assessment_admin or admin

About this task
Note: 
If a source record is deleted, the system deletes the associated assessable record. To 
delete the source record, you must first delete all associated metric results and category 
results.

Procedure

Delete the assessable record:

• To delete a single record, open the record and click Delete.

• To delete multiple records, use the Assessable Records list.

Related topics

Metric types and assessable records

Add a metric category and metric in the question bank for assessments

Reuse the question categories (metric categories) and questions (metrics) added in the question 
bank for assessments. You can add metric categories or metrics from the question bank to an 
assessment, or from the assessment to a question bank.

Before you begin
Role required: admin or assessment_admin

Procedure

1. Navigate to All  > Assessments  > Question Bank.

2. Click New.

3. In the Metric Category form, fill in the fields.

Metric Category fields

Field Description

Name Name of the metric category.

Description Description of the metric category.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3712



Field Description

Total 
metrics

Total number of metrics in the metric category. This number is automatically 
updated when you add or delete metrics from the category.

4. Right-click on the title bar and click Save.

5. In the Assessment Metrics related list, click New.

6. In the Assessment Metric form, fill the fields.
For more information on assessment metric fields, refer to .

7. Click Submit.

Configure metric categories or metrics for an assessment using the question bank

Reuse question categories (metric categories) and questions (metrics) from the Question Bank 
module while creating or updating an assessment.

Before you begin
Role required: admin or assessment_admin

Procedure

1. Navigate to All  > Assessments  > Metric Definitions  > Types.

2. Open an assessment definition.

3. Optional:  To add metric categories to an assessment from the question bank in Platform, 
perform the following steps.

a. In the Metric Categories related list, click New Category from Bank.
The New Category from Bank dialog box is displayed with a list of all metric categories added 
in the question bank.

b. Select the required categories and click Add Selected.
A copy of the metric category and the corresponding metrics is created in the Metric 
Categories related list.

4. Optional:  To add metrics to an assessment from the question bank in Platform, perform the 
following steps.

a. In the Metric Categories related list, open a metric category definition.

b. In the Assessment Metrics related list, click New Metric from Bank.
The New Metric from Bank dialog box is displayed with a list of questions available in the 
question bank.

c. Select the required metrics and click Add Selected.
A copy of the metric and the corresponding metric definitions is created in the Assessment 
Metrics related list of the category.

5. Optional:  To add a metric category to the question bank from an assessment in Platform, 
perform the following steps.
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a. In the Metric Categories related list, open a metric category definition.

b. Click Add to Question Bank.
A copy of the category is created along with its metrics and metric definitions in the question 
bank.

6. Optional:  To add a metric to the question bank from an assessment in Platform, perform the 
following steps.

a. In the Metric Categories related list, open a metric category definition.

b. In the Assessment Metrics related list, open the required metric definition.

c. Click Add to Question Bank.
The Add to Question Bank dialog box is displayed.

d. In the Choose a question bank to add this question/metric  field, select a metric category 
that you want to add this metric to, and click OK.
A copy of the metric and the corresponding metric definitions is created for the selected 
category in the question bank.

Copy an assessment

Create a copy of an assessment with at least one category to reduce the effort of creating 
another assessment with similar data.

Before you begin
Role required: assessment_admin or admin

About this task
All associated questions (type), configurations, categories, metrics, domain separation rules, 
and role-based categories are copied. Assigned users, category users, instances, and trigger 
conditions are not copied.

Procedure

1. Navigate to All  > Assessments  > Metric Definition  > Types.

2. Select an assessment metric type.

3. In the title bar, click Copy, or click the menu icon, and select Copy.

Create a metric template

Create a metric template to define reusable rating scales for evaluating non-scripted metrics.

Before you begin
Role required: assessment_admin or admin

Procedure

1. Navigate to All  > Assessments  > Metric Definition  > Templates.

2. Click New.

3. Fill in the Name  field on the Assessment Metric Template form.

4. To use images for template choices, such as for image scale questions, select Allow Image.
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5. Click Submit.

6. Under the Assessment Template Definitions  related list, click New.
Create a template definition for each answer option you want to appear on an assessment 
question.

7. Fill in the following fields:

◦ Display:  Enter the text to appear as the answer option.

◦ Value:  Enter a numeric value, equal to or greater than zero, that you want the answer option 
to equate to. Values are used in results calculations.

◦ Selected Image: Click to add the image to use for selected state.

◦ Unselected Image: Click to add the image to use for unselected state.

When you view assessment questions that use templates, answer options appear in order 
from least to greatest Value.

Tip: 
To prevent reporting confusion, no two template definitions for a given template should 
have the same Value.

8. Click Update.

Related topics

Assessment metrics

Create an assessment metric for a category

Create an assessment metric definition

Metric templates

Metric templates define reusable rating scales for evaluating non-scripted metrics.

Each answer option on the scale is defined as a template definition, much like a metric definition. 
For example, the metric template named Satisfaction contains the template definitions: Very 
Satisfied, Satisfied, Neutral, Dissatisfied, and Very Dissatisfied.

Metric templates are available for metrics that have Template  as the Data type.  The following 
metric templates are available by default.

Default metric templates

Name Assessment template definition

Likert 5 Strongly Disagree, Disagree, Neutral, Agree, Strongly Agree

Satisfaction Very Dissatisfied, Dissatisfied, Neutral, Satisfied, Very Satisfied

Frequency Never, Seldom, Sometimes, Most of the time, All of the time

Amount None, Few or little, Average amount, Many, Quite a lot

Size Very Small, Small, Average, Large, Very Large

Quality Very Poor, Poor, Average, Good, Very Good

Complexity Very Complex, Complex, Moderate, Simple, Very Simple
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Related topics

Assessment metrics

Create an assessment metric definition

Update a metric minimum and maximum value to match a template

For assessment results to be properly calculated, the Min and Max values of a metric that uses a 
template must be equal to the smallest and largest template definition Value, respectively.

Before you begin
Role required: assessment_admin or admin

About this task
The system sets the Min  and Max  fields automatically when you create a metric of the Template 
data type, based on the template definition values. However, the system does not update these 
fields for existing metrics if you add a new template definition to a template or if you update the 
Value of an existing template definition. If the new Value is less than the minimum value of any 
metrics that use the template or greater than the maximum value, update the metrics accordingly.

To edit the minimum and maximum values for a question that has the Template data type:

Procedure

1. Navigate to All  > Assessments  > Metric Definition  > Metrics.

2. Configure the Configure the list layout  to show the Min  and Max  columns.

3. Run the following list filter condition: [Template] [is] [<select the template 
you updated>]

4. Ensure the Min and Max values match the smallest and largest template definition Value for 
the selected template, respectively.

If the values do not match, edit the Min and Max directly from the list.

Note: 
When the data type is Template, a UI policy prevents the editing of Min and Max from the 
form.

Related topics

Assessment metrics

Create an assessment metric for a category

Create an assessment metric definition

Category users and stakeholders

Users who take assessments are individuals in your organization who have specific knowledge of 
the assessment categories and the records being assessed.

A person who is qualified to answer assessment questions from metrics in a specific category 
becomes a category user when associated to that category. A category user then becomes a 
stakeholder when associated to a specific assessable record.

The system determines which assessable records and questions a user receives by looking 
at the metric categories and assessable records for which those users are stakeholders. 
Assessment administrators can create and manage category users and stakeholders.

Note: 
Category users and stakeholders are used only for scheduled assessments.
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Category users

Category users are users who can potentially answer assessment questions about a particular 
metric category for scheduled assessments. Category users should have special knowledge of 
the categories and the metrics those categories contain. A category user becomes a stakeholder 
when associated to an assessable record. Create at least one category user for each category 
you want to use for assessment questionnaires.  There is no need for category users if the 
category contains only scripted metrics.

Stakeholders
A stakeholder is a category user with specific product or service knowledge, who is associated 
to an assessable record. A stakeholder is familiar with the assessable record and all the metrics 
within a specific category. The same category user can be associated to multiple assessable 
records, in which case the system creates a stakeholder record for each association.

There are multiple ways to create stakeholders:

• Configure the system to create stakeholders automatically.

• Associate multiple category users to multiple assessable records.

• Associate multiple category users to one assessable record.

• Associate one category user to one assessable record.

Note: 
Ensure you establish the desired user and assessable record associations to categories 
before attempting to creating stakeholders.

Related topics

Create a category user

Associate multiple category users to multiple assessable records

Associate multiple category users to one assessable record

Associate one category user to one assessable record

Delete a stakeholder for multiple assessable records

Delete a stakeholder for one assessable record

Create a category user

Create category users by associating users in the system to metric categories.

Before you begin
Role required: assessment_admin or admin

About this task
When you create category users, choose users who are knowledgeable and can answer 
questions from that category. For example, a purchasing agent is a good category user for 
metrics that evaluate a vendor's discount practices.

Procedure

1. Navigate to All  > Assessments  > Metric Definitions  > Categories.

2. Open a category record.

Note: 
The category must be associated to a metric type that has the Schedule type  set to 
Scheduled.
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3. In the Users  related list, click Edit.

4. Select the appropriate users for this category.

Related topics

Category users and stakeholders

Associate multiple category users to multiple assessable records

Associate multiple category users to one assessable record

Associate one category user to one assessable record

Delete a stakeholder for multiple assessable records

Delete a stakeholder for one assessable record

Create stakeholders automatically

You can configure the system to create stakeholders automatically from all category users and 
assessable records associated with a category using the Create stakeholders  check box on the 
Metric Category form.

Before you begin
Role required: assessment_admin or admin

About this task
If you associate a user to the category, the system makes the resulting category user a 
stakeholder for all the assessable records associated to the category. Similarly, if you associate a 
new assessable record to the category, the system makes all category users stakeholders for that 
record if they are not already stakeholders.

Note: 
Use the Create stakeholders  check box with caution. You can end up with more 
stakeholders than you want and a large amount of unnecessary assessment data. 
Automatic stakeholder creation is best suited to assessment implementations in which 
category users are knowledgeable about all or most of the assessable records associated 
to each category.

Procedure

1. Navigate to All  > Assessments  > Metric Definition  > Categories.

2. Select a category.

3. Associate category users and assessable records to the category.

4. Select the Create stakeholders  check box.

5. Click Update.
All the category users are associated to all the assessable records as stakeholders.

6. In the Assessable Records  related list, click Edit.

7. Using the slushbucket, associate an assessable record to the category.
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8. Click Save.
The system makes all category users stakeholders for the new assessable record.

9. Delete stakeholders as needed.

Related topics

Category users and stakeholders

Create a category user

Associate multiple category users to multiple assessable records

Associate multiple category users to one assessable record

Associate one category user to one assessable record

Delete a stakeholder for multiple assessable records

Delete a stakeholder for one assessable record

Associate multiple category users to multiple assessable records

The stakeholder list helper in the create stakeholders module is the most efficient way to 
associate multiple category users to multiple assessable records in a single interface.
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Before you begin
Role required: assessment_admin or admin

About this task
You can select category users from one category at a time.

Note: 
You cannot edit or delete stakeholders using the list helper.

Procedure

1. Navigate to All  > Assessments  > Advanced  > Create Stakeholders.
The stakeholder list helper appears.

2. Select a metric type from the list of available types.

Note: 
Only metric types for scheduled assessments are available. On-demand assessments do 
not use category users or stakeholders.

3. Select a category from the list of available categories.

Note: 
Only categories within the selected metric type are available.

The system populates the Category User  and Assessable Records  lists with category users 
and assessable records associated to the selected category.

4. Select one or more category users from the Category Users  list.

5. Select one or more assessable records from the Assessable Records  list.

6. Click the Associate  arrow between the lists to complete the association.
A message above the list helper advises you that the selected category users are now 
stakeholders for the selected assessable records.

Related topics

Category users and stakeholders

Create a category user

Associate multiple category users to one assessable record

Associate one category user to one assessable record
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Delete a stakeholder for multiple assessable records

Delete a stakeholder for one assessable record

Delete a stakeholder for multiple assessable records

You can delete stakeholders for multiple assessable records.

Before you begin
Role required: assessment_admin or admin

Procedure

1. Navigate to All  > Assessments  > Advanced  > Assessment Stakeholders.

2. Sort the list by Assessable Record  or Category User  depending on the perspective you want.

3. Select the check box for each stakeholder you want to delete.

4. Select Delete  in the Actions  choice list.

5. Click OK  to confirm the action.
The system deletes the stakeholders.

Related topics

Category users and stakeholders

Create a category user

Associate multiple category users to multiple assessable records

Associate multiple category users to one assessable record

Associate one category user to one assessable record

Delete a stakeholder for one assessable record

Associate one category user to one assessable record

Create a single stakeholder using the list in the Assessment Stakeholders module.

Before you begin
Role required: assessment_admin or admin

About this task
Associate any category user to any assessable record.

Procedure

1. Navigate to All  > Assessments  > Advanced  > Assessment Stakeholders.

2. Click New.

3. On the Assessment Stakeholders form, fill in these fields:

◦ Category user: Select a category user.

◦ Assessable record: Select an assessable record.

4. Click Submit.

Result
The selected category user becomes a stakeholder for the selected assessable record. To verify 
the association, navigate to the assessable record and note that the selected category user is on 
the Category users related list.
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Note: 
Do not create stakeholders from category users and assessable records of different metric 
types.

Related topics

Category users and stakeholders

Create a category user

Associate multiple category users to one assessable record

Associate multiple category users to multiple assessable records

Delete a stakeholder for multiple assessable records

Delete a stakeholder for one assessable record

Associate multiple category users to one assessable record

Create many stakeholders for a single assessable record from the Assessable Record form.

Before you begin
Role required: assessment_admin or admin

About this task
You can also edit or delete stakeholders from the form.

Procedure

1. Navigate to All  > Assessments  > Assessable Records.

2. Open a record from the list.

3. In the Category users  related list, click Edit.
These category users are the stakeholders for this assessable record.
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4. Add category users to create stakeholders or remove category users to delete stakeholders.
The system shows only category users for categories associated to the assessable record. 
For example, if an assessable record is associated only to the Compliance Score and Support 
Rating categories, User Satisfaction category users will not be listed.

Related topics

Category users and stakeholders

Create a category user

Associate multiple category users to one assessable record

Associate one category user to one assessable record

Delete a stakeholder for multiple assessable records

Delete a stakeholder for one assessable record

Delete a stakeholder for one assessable record

You can delete stakeholders for one assessable record.

Before you begin
Role required: assessment_admin or admin

Procedure

1. Navigate to All  > Assessments  > Assessable Records.

2. Open an assessable record.

3. In the Category Users  related list, select the check box for each stakeholder you want to 
delete.

4. Select Delete  in the Actions  choice list.
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5. Click OK  to confirm the action.
The system deletes the stakeholders.

Related topics

Category users and stakeholders

Create a category user

Associate multiple category users to multiple assessable records

Associate multiple category users to one assessable record

Associate one category user to one assessable record

Delete a stakeholder for multiple assessable records

On-demand assessments

On-demand assessments can be generated for metric types with the Schedule type  field set to 
On demand.

For the system to properly generate on-demand assessments, the metric type must be active 
and published. The metric type must also be associated to at least one metric category. That 
metric category must be associated to one or more of each of the following items:

• Assessable record

• Metric

By default, an assessment administrator can generate an on-demand assessment for one 
assessable record or multiple assessable records.

Related topics

Assessment generation

Scheduled assessments

Generate an on-demand assessment for multiple assessable records

View an assessment instance

Clean up assessment data

Generate an on-demand assessment

Use on-demand assessments to familiarize yourself with the basic assessment process and test 
your questionnaires using minimal configuration.

Before you begin
Role required: assessment_admin or admin

About this task
Select the assessable records  to evaluate, create the categories and questions, and then assign 
an assessment to a user in the system. Pre-configured stakeholders  are not used for on-demand 
assessments.

Procedure

1. Create a metric type  and set the Schedule type  to On demand  to allow for testing of your 
assessment configuration.

2. Generate the assessable records for the metric type you created.

3. Create the metric categories  required to evaluate the assessable records selected.
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4. Create one or more assessment questions, or metrics, for each category.

5. Publish the assessment.

6. Perform an on-demand assessment  to test your categories and metrics.

7. Analyze the assessment ratings in an assessment scorecard  or decision matrix.

Related topics

Assessments

Generate an on-demand assessment for one assessable record

When you generate an on-demand assessment from the Assessable Record form, the resulting 
assessment contains questions from the categories associated to the assessable record.

Before you begin
Role required: assessment_admin or admin

Publish the assessment.

Procedure

1. Navigate to All  > Assessments  > Assessable Records.

2. Open an assessable record associated to a metric type that has the On demand  schedule 
type.

3. To assign the assessment to users configured in the Assessors  tab of the assessment, and 
other specified users, perform these steps.

a. On the Assessment Metric Type form, click Assign Assessment.

b. Select a user from the Recent Assessors list or select a different user.

c. Click OK.

4. To assign the assessment to users configured in the Assessors  tab of the assessment, click 
Assign to Assessors.

Result
The system generates an assessment instance assigned to the selected users.

Related topics

Assessment generation

Scheduled assessments

Clean up assessment data

Generate an on-demand assessment for multiple assessable records

When you generate an on-demand assessment from the Assessment Metric Type form, the 
resulting assessment contains questions from all categories associated to any assessable 
records for the metric type.

Before you begin
Role required: assessment_admin or admin
Publish the assessment.

About this task
For example, if there are 15 assessable records associated to at least one category with 
assessment metrics, the assessment contains questions for all 15 assessable records.
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Procedure

1. Navigate to All  > Assessments  > Metric Definition  > Types.

2. Open a metric type that has the On demand  schedule type.

3. To assign the assessment to users configured in the Assessors  tab of the assessment, and 
other specified users, perform these steps.

a. On the Assessment Metric Type form, click Assign Assessment.

b. Select a user from the Recent Assessors list or select a different user.

c. Click OK.

4. To assign the assessment to users configured in the Assessors  tab of the assessment, click 
Assign to Assessors.

Result
The system generates an assessment instance assigned to the selected users.

Related topics

Assessment generation

Generate a scheduled assessment manually

Assessment groups

Clean up assessment data

Generate an assessment with the on-demand API

The Assign Assessment buttons call an API to generate on-demand assessments.

Before you begin
Role required: assessment_admin or admin

About this task

Procedure

1. To generate an assessment, call the AssessmentCreation API  from any script in the system, 
such as a business rule or client script.

2. Use the sys_ids of these items:

◦ An assessable record to evaluate. The assessable record must be associated with an on-
demand type and at least one category that contains non-scripted metrics.

◦ One or more users who should perform the assessment. The API generates a questionnaire 
about the specified assessable record for each user.

Related topics

Assessment generation

Scheduled assessments

Generate a scheduled assessment manually

Generate a vendor type assessment manually

Set an assessment generation schedule

Assessment instances
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View an assessment instance

Clean up assessment data

Scheduled assessments

The system generates a unique scheduled job for each metric type with the Schedule type  field 
set to Scheduled.

The system generates a unique scheduled job for each metric type with the Schedule type 
field set to Scheduled. Each scheduled job generates assessment components for the related 
metric type. By default, the scheduled job runs when an administrator executes it manually, but 
administrators can set a schedule to generate assessments automatically on a recurring basis.

For the system to properly generate scheduled assessments, the metric type must be active and 
published. The metric type must also be associated to at least one metric category. That metric 
category must be associated to one or more of each of the following items:

• Assessable record

• Stakeholder  associated to one of the assessable records

• Metric

Related topics

Assessment metrics

Schedule an assessment

After you have evaluated your questionnaires using on-demand assessments, edit your 
categories and metrics as needed, reset your metric type record, and select the users who are 
qualified to evaluate the assessable records.

Before you begin
Role required: assessment_admin or admin

Procedure

1. Open the metric type you created for the on-demand assessment  and set the Schedule type 
to Scheduled.

2. Make sure the categories and metrics you created for the on-demand assessment are correct.

3. Create category users  who have special knowledge of your categories.

4. Create stakeholders  by associating category users to specific assessable records.

5. Set a schedule  for automatic assessment generation or generate the assessment manually.

Note: 
This procedure must be done by a system administrator.

6. Configure email notifications  to remind users of their assigned assessments and to report to 
managers when an employee misses an assessment deadline.

7. Analyze the assessment ratings in an assessment scorecard or decision matrix.

Related topics

Assessments

Schedule types

You can schedule assessments for preconfigured users or send them to any user on demand.
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On-demand assessments require less setup. Scheduled assessments define users, or 
stakeholders, who have specific knowledge of the records being evaluated, and automatically 
send out assessment questionnaires to those users at scheduled intervals. The best practice 
is to configure an on-demand assessment first to familiarize yourself with the process and test 
your questionnaires. When you are satisfied with your categories and questions, reconfigure for 
a scheduled assessment. These configuration paths are the easiest for both assessment types. 
Refer to Key Terms for definitions of the terms used in these procedures.

Related topics

Assessments

Set an assessment generation schedule

You can set assessment generation schedules. You must set a schedule for each metric type 
individually.

Before you begin
Role required: assessment_admin or admin

Procedure

1. Navigate to All  > Assessments  > Metric Definition  > Types.

2. Open the appropriate metric type record.

3. Click the reference icon next to the Scheduled job  field to open the Schedule Item record.

4. Locate the Trigger type  field and set a recurring schedule for the scheduled job.

For example, if you want to generate assessment components each month, select the Interval 
or Repeat  trigger type and specify a Repeat  value of 30 days. Alternatively, select Day in 
Month  and specify a Run time and Run day of month.

The optimal frequency of assessment generation is subjective. When you set the schedule, 
keep in mind the number of records to evaluate, how often your organization requires updated 
assessment results, the time and effort required of users to complete assessments, and other 
relevant factors.

Publish a metric type

Before it is possible to generate assessments, an assessment administrator must publish the 
associated metric type.

Before you begin
Role required: assessment_admin or admin

About this task
The State  field on the Assessment Metric Type form indicates whether the type is published. The 
default state is Draft, which disables the system from generating assessments.

Procedure

1. Navigate to All  > Assessments  > Metric Definition  > Types.

2. Open a metric type record, and click Publish.

The Publish  button is available only if the state is Draft  and there is at least one metric 
associated with the type.

Note: 
A metric type cannot be moved back to the Draft  state after it has been published.
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Generate a scheduled assessment manually

Administrators can generate scheduled assessments manually.

Before you begin
Role required: assessment_admin or admin

About this task
Use this option, for example, if you have set a schedule but want to generate assessments before 
the next scheduled run date.

Procedure

1. Navigate to All  > Assessments  > Metric Definition  > Types.

2. Open the appropriate metric type record.

3. Click Generate Assessments  to trigger the scheduled job immediately.

Note: 
Be careful to click Generate Assessments, not Generate Assessable Records.

Generate a vendor type assessment manually

The Vendor Performance feature provides a direct method of generating assessments for the 
Vendor metric type.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Vendor Performance  > Admin  > Generate Assessments.

2. Click Generate Assessments  to execute the scheduled job for the Vendor  type.

Clean up assessment data

The assessment process generates a considerable amount of data, some of which is not useful 
after a short time.

Before you begin
Role required: assessment_admin or admin

About this task
The assessment process generates a considerable amount of data, some of which is not useful 
after a short time. Assessments include a scheduled job called Remove Old Assessment 
Data  that is available to administrators only. The scheduled job removes these items if they are 
more than a year old:

• Assessment instance questions

• Assessment instances

• Metric results

By default, the scheduled job is executed manually. Administrators can configure the scheduled 
job to run automatically on a recurring schedule.
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Procedure

1. Navigate to All  > System Scheduler  > Scheduled Jobs  > Scheduled Jobs.

2. Open the Remove Old Assessment Data  record.

3. On the Schedule Item form, set the Trigger type  field to run the scheduled job on a recurring 
schedule.

It is recommended to set the scheduled job to run on a weekly or monthly basis.

4. Optional:  Click Execute Now  to run the scheduled job.

Assessment instances

An assessment instance represents one occurrence of a questionnaire assigned to one user.

The system generates assessment instances only when the required conditions are met, as 
described in Scheduled assessments  and On-demand assessments, and there are non-scripted 
metrics in at least one category.

When the system generates scheduled assessments for a metric type, each assessment 
instance contains questions about assessable records and categories related to the stakeholder 
to which it is assigned.

Example:

Recall that there can be multiple stakeholder records associated with one user record. Minh 
Leclare is a stakeholder for these items related to the Vendor  metric type:

Assessable records

Assessable record Category

Amazon User Satisfaction

Acme User Satisfaction

Acme Reliability

Cisco Reliability

When the system generates a scheduled assessment, Minh is assigned one assessment 
instance to evaluate Amazon, Acme, and Cisco by answering questions from the categories as 
a stakeholder. Assuming that there are three questions in the User Satisfaction category and 
six questions in Reliability, Minh's questionnaire contains three questions about Amazon, nine 
questions about Acme, and six questions about Cisco.

When the system generates an on-demand assessment for a specific assessable record, the 
assessment instance contains questions about that assessable record and all its associated 
categories. When the system generates an on-demand assessment for a metric type, the 
assessment instance contains questions about all that metric type's assessable records and 
their associated categories.

View an assessment instance

An assessment instance represents one occurrence of a questionnaire assigned to one user.

Before you begin
Role required: survey_admin, assessment_admin, or admin
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Procedure

1. Navigate to All  > Assessments  > Assessment Instances.
The following sub-modules are available based on the state of the instances:

◦ Ready to take: Displays assessment instances that are ready to be taken by the user. By 
default, these instances are sorted in ascending order by the Number  field.

◦ In progress: Displays assessment instances that are in progress. By default, these instances 
are sorted in ascending order by the Number  field.

◦ Completed: Displays assessment instances that are complete. By default, these instances 
are sorted in descending order by the Taken on  field.

◦ Cancelled: Displays assessment instances that are cancelled. By default, these instances 
are sorted in ascending order by the Number  field.

◦ All: Displays assessment instances in all states. By default, these instances are sorted in 
ascending order by the Number  field.

2. Open the record from the required sub-module by clicking an assessment instance number.

By default, the fields in the following table are displayed in the Assessment Instance form for 
all sub-modules other than Completed.

Note: 
When you open an instance in the Completed  sub-module, you are redirected to the 
User's Response page.

Field Description

Number Auto-generated record number.

Metric type Metric type of this assessment.

Assessment 
group

Assessment group to which this assessment belongs.

Due date Date by which the assessment instance must be completed. The system 
populates the due date from the value in the metric type Assessment duration 
field. The system generates email notifications related to the due date.

Note: 
By default, the system runs the Cancel Expired Assessments 
script every 30 days to cancel expired survey, assessment, and quiz 
instances that are in the Work in progress or Ready to take states.

State State of the assessment.

Domain Domain associated with the instance.

Assigned to User this assessment is assigned to. This field becomes read-only when the 
state is In progress, Complete, or Canceled.

Signature Name of the signature record  attached to this assessment. A signature requires 
that assessment recipients acknowledge that they have read any assertions 
attached to a questionnaire.

Signature 
result

Verification provided by the recipient when a signature is required. This value 
is either the recipient's full name from the User [sys_user] table or checked, 
indicating that the recipient acknowledged reading the assertion by selecting a 
check box.
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3. Click Take assessment  to open the questionnaire.
For more information, see Take an assessment.

This button is available if all the following conditions are true for the assessment instance:

◦ It is Assigned to  you.

◦ The State  is Ready to take  or In progress.

◦ The associated metric type is Active.

Related topics

Assessment generation

Generate a scheduled assessment manually

Event scheduling

Configure trigger conditions for an assessment

Trigger conditions specify when to send a particular assessment and who to send the 
assessment to.

Before you begin
Role required: assessment_admin or admin

Procedure

1. Navigate to All  > Assessments  > Admin  > Trigger Conditions.

2. On the Trigger Condition form, fill in the fields.
For a description of the field values, see Trigger Condition form for assessments.

Related topics

Survey trigger conditions

Assessable records

Assessment trigger conditions

A trigger condition tells the system who to send a designated assessment to and when, based 
on specific conditions.

With trigger conditions, assessment administrators can configure the system to generate 
assessments each time a specific action occurs, such as when an incident or change request 
closes. The trigger condition sends the assessment to specified users who are related to the 
triggering record, such as incident callers or change request assignees. You can choose to send 
the assessment every time the condition is met, or set a probability for the system to send the 
assessment at random when the condition is met.

For a description of the field values in Trigger Condition form, see Trigger Condition form for 
assessments.

Trigger condition configuration

Assessment Vendor

Table Incident [incident]

User field Assigned to
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Trigger condition configuration  (continued)

Repeat 
Interval

30 days

Active true

Trigger 
randomly

false

Assessable 
Record Field

Vendor

This is a field in the table that is selected from the Table  field. The reference 
record selected in the field specified must have an assessable record.

Note: 
The values in this field must have assessable records of the selected 
metric type. If this condition is met, then only the assessment is triggered.

Related 
Field 1

Caller

Related 
Field 2

Vendor

Condition [State] [is] [Closed] and [Vendor] [is not empty]

Trigger condition example

Modesto Scroggie is the caller on an incident that is assigned to Boris Catino, a service desk 
technician. Boris contacts a vendor to resolve Modesto's issue and sets the Vendor  field to 
Microsoft. When the incident closes, the system creates an assessment instance assigned to 
Boris so Boris can evaluate Microsoft  as a vendor.

Because two related fields were selected as part of the trigger condition, the assessment 
instance stores the following information from the incident:

• Related record 1:  User: Modesto Scroggie

• Related record 2:  Company: Microsoft

Note: 
Even though the trigger condition is set to be triggered every time the conditions are met, 
the Repeat Interval  setting ensures that Boris does not receive another assessment if 
another vendor incident assigned to him closes within 30 days of the first one.

Enable manager notifications

Users with the assessment_admin role can enable the Notify manager assessment is overdue 
email notification.

Before you begin
Role required: assessment_admin or admin

About this task
This notification sends emails to assessors' managers when assessors do not complete their 
assigned assessments on time. For more information, see the table of assessment notifications. 
You must enable or disable this email notification separately for each metric type.
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Procedure

1. Navigate to All  > Assessments  > Metric Definition  > Types.

2. Open a metric type.

3. Select the Notify if overdue  check box.

To disable manager notifications, clear the check box.

4. Save the record.

Note: 
The assessor's user record must have a manager specified in the Manager  field to use 
this notification. You might need to configure the form to use this field.

Assessment notifications

You can configure the system to send email notifications for assessments.

You can configure any of the following types of notification during the process of generating 
assessable records:

• Notify assessment user: This messages notifies you of an assigned an assessment and 
includes the type, the due date, and basic instructions. The message also contains a link to the 
record where you take the assessment.

Note: 
If a user has a pending assessment, then the system will not generate another instance 
of the same assessment.

• Remind assessment user: This message reminds you of the due date if half the time passes 
and you have not completed the assessment. The message content is the same as the first 
notification.

• Notify manager assessment is overdue: If you do not complete an assessment by the due date, 
the system may send a notification to your manager, depending on configuration.

Note: 
By default, the system runs a script every 30 days to cancel expired assessment and survey 
instances that are in the Work in progress  or Ready to take  states.

Related topics

Create metric types and generate assessable records

Event scheduling

Assessment notification workflow

The system sends assessment notifications according to the Notify assessment user workflow. 
Users with the workflow_admin, workflow_creator, or workflow_publisher roles can view 
workflows.
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1. To open the graphical Workflow Editor, navigate to Workflow  > Workflow Editor.

2. In the activity menu, click the link to choose an existing workflow.

Workflow Window

3. Select Notify assessment user  from the Workflow Versions list.

The workflow appears.

Notify Assessment User Workflow

Related topics

Assessment notifications

View a metric result

Metric results contain values that represent an evaluated record's performance for a specific 
metric, based on a single evaluation from one user or from the execution of a script. Metric 
results contain actual values as well as calculated values. The system uses values from metric 
results to calculate category results.

Before you begin
Role required: assessment_admin or admin

About this task
If there is an active scripted metric when the assessment is generated, the system automatically 
produces a metric result for each associated assessable record. The system produces 
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an additional metric result for each question a user answers on a completed assessment 
questionnaire. If multiple users complete questionnaires with the same questions on the same 
assessable records, the system produces metric results for each user's responses.  For example, 
three users complete questionnaires that contain the same four questions about the Acme 
Corporation record. The system produces 12 metric results: one per user for each question.

Procedure

1. Navigate to All  > Assessments  > Results  > Metric Results.

2. Open the metric result record you want to view.
All fields on the form except Updated  and String value  are read-only.

Metric Result form fields

Field Description

Assessment 
group

Assessment group  to which the metric result is associated.

Metric Name of the metric to which these metric result values apply.

Data type Data type of the metric.

Method method  of the metric.

Updated Date and time the metric result was last updated.

Source Source record of the assessable record evaluated.

Assigned to User who completed the assessment questionnaire. This field is blank when 
the method is Script.

Instance Assessment instance  completed by the Assigned to  user. This field is blank 
when the method is Script.

Actual value
Unscaled value from a user response or script, depending on the method:

◦ Assessment: Value obtained from the user response to the assessment 
instance question. The actual value is determined by the metric data type:

▪ Checkbox: The actual value is 0 if the check box is cleared and 1 if it is 
selected.

▪ Choice  or Likert Scale: The actual value is equal to the Value of the metric 
definition associated with the chosen answer option.

▪ Date, Date/Time,  or String: The actual value is -1 to indicate that these 
data types do not contribute to category result calculations.

▪ Template: The actual value is equal to the Value  of the template definition 
associated with the chosen answer option.

▪ Yes/No: The actual value is 0 if the response is No  and 1 if it is Yes.

◦ Script: Value the script placed in the actual_result  variable.

This field is hidden and left blank when the data type is Duration.

Duration 
value

Specific kind of actual value that is only applicable if the data type is Duration. 
The duration value is the value obtained by the script query from the 
actual_result  parameter, such as the average duration of outages for a 
vendor.
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Field Description

Scaled 
value Appropriate value from the scaled_result  variable in the associated 

metric script. The code in a scripted metric defines a scaling scheme for the 
actual values it obtains. For example, a scripted metric queries the CMDB  to 
return the number of configuration items (CIs) for a vendor. The code includes 
this scaling scheme, where  actual_result  is the number of CIs, and 
scaled_result  is a representation of the quantity of CIs:

if (actual_result < 1)
 scaled_result = 0;
else if (actual_result < 1000)
 scaled_result = 1;
else if (actual_result < 10000)
 scaled_result = 2;
else if (actual_result < 25000)
 scaled_result = 3;
else if (actual_result < 100000)
 scaled_result = 4;
else
 scaled_result = 5;

If the script detects 315 CIs for the vendor, the Actual value  is 315 and the 
Scaled value  is 1 for this metric result.

Note: 
Although this field is visible only when the method is Script, the system 
populates the field with the Actual value  when the method is 
Assessment, as the scaled value is used in the Normalized value 
calculation.

Normalized 
value

Adjusted value that accounts for weights, scale definition, minimum and 
maximum values, and other factors that impact the metric (like the survey 
responses or the input value—the actual value given by the user). See the 
example for Normalized value  in View an assessment category result.

String value Value that displays the response as it appears on a questionnaire. In some 
cases this is the same as the Actual value, such as when the metric 
data type is Percentage. The string value is N/A  for unanswered questions of 
certain data types. For the Attachment  data type, the names of the attached 
files are displayed as comma-separated values.

Assessment results

In the Assessments application, when the system processes completed questionnaires or 
gathers values returned from scripted metric queries, it generates assessment result records 
called metric and category results.

Assessment administrators can view assessment results.

The system calculates metric results  first, normalizes the scores, and then calculates category 
results. Each metric and category result record stores data from one assessment group, for a 
particular category and source record evaluated. Specifically:

• Metric results: store data calculated from one evaluation of one metric.

• Category results: store data calculated from a weighted average of all metrics in the category.
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Note: 
Although results data is available to view in the form of metric and category result records, 
the most meaningful way to view results is in scorecards  and decision matrixes. These tools 
display only the most pertinent data in graphical, comparative formats.

Excluded Responses

The system creates metric results for responses but does not include them in category result 
calculations if any of the following are true:

• The user selects the Not Applicable  answer option on a questionnaire.

• The user does not answer the question and the data type  is not Checkbox.

• The question data type is one of the following: Date, Date/Time, or String.

• The metric result Actual value, Scaled value, and Normalized value  fields are set to -1.

Metric Attachments

After a survey or assessment is submitted, any attachments that have been added by a user are 
moved to the metric result record. The names of the attached files are added to the String value 
field on the Metric Result form.

Note: 
You cannot add or remove attachments from a metric result.

Assessment Overview dashboard

The Assessment Overview dashboard displays various assessment reports, such as Assessable 
Records by Type, Total Metrics by Metric Type, and Assessments by State.

The dashboard might not show all these reports. If you want to view a particular report, you can 
add that report to the dashboard.

Assessment Overview dashboard reports

Report Table

Assessable Records by Type Assessable Records [asmt_assessable_record]

Assessment Instances by 
Assessment Group

Assessment Instances [asmt_assessment_instance]

Assessments by State Assessment Instances [asmt_assessment_instance]

Answered Questions by Assigned 
User

Assessment Instance Questions 
[asmt_assessment_instance_question]

Average Rating by Type Assessment Category Results [asmt_category_result]

Category Result Ratings by 
Category

Assessment Category Results [asmt_category_result]

Metrics by Data Type Assessment Metrics [asmt_metric]

Stakeholders per Category Assessment Stakeholders [asmt_m2m_stakeholder]

Top Rated Items Metric Results [asmt_metric_result]

Total Metrics by Metric Type Assessment Metrics [asmt_metric]]

Unanswered Questions by 
Assigned User

Assessment Instance Questions 
[asmt_assessment_instance_question]
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Assessment Overview dashboard

View assessment reports

Use the Assessment Overview dashboard to view your assessment reports.

Before you begin
Role required: assessment_admin or admin

About this task
The dashboard displays reports arranged in widgets. You can add new widgets to the dashboard.

Procedure

1. Navigate to All  > Assessments  > Overview.

2. Click the elements within the reports to view more information.

For more information about working with dashboards, see Dashboards .

Assessment results calculation

For every assessment group, there are assessment results.
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Data calculated from an evaluation of one metric is classified as a metric result. Data calculated 
from the weighted average of all metric results in a category is classified as a category result. 
The system calculates some assessment results when the assessment is generated, and others 
when users complete questionnaires.

Related topics

Generate a scheduled assessment manually

Generate a vendor type assessment manually

Assessment groups

View a bubble chart for assessments

Assessment administrators can view bubble charts to compare the relative standing of 
assessable records in three metric categories.

Before you begin
Role required: assessment_admin or admin

Procedure

1. Navigate to All  > Assessments  > Admin  > Bubble Charts.

2. Click a Name  to open the bubble chart record.

3. Under Related Links, click View Bubble Chart.

Note: 
Demand managers and vendor managers can view bubble charts through the Demand 
Management and Vendor Performance applications. See Project Portfolio Suite  for more 
information.

Bubble charts for assessments

A bubble chart is a dynamically updated graph that plots assessment results for multiple 
assessable records.

Assessment administrators can create and use bubble charts to compare the relative standing 
of assessable records in three metric categories. The X- and Y-axes each represent a different 
category. Assessable records are plotted on the chart as circular markers, or bubbles, which vary 
in size according to scores for the third category.

Create a bubble chart

Assessment administrators can create bubble charts to compare the relative standing of 
assessable records in three metric categories.

To create a bubble chart, navigate to Assessments  > Admin  > Bubble Charts  and create a 
record (see table for field descriptions).

Note: 
For color fields, either HTML color names  or hexadecimal  (hex) values are acceptable. 
For hex values, the   character is optional. Values are not case-sensitive. For example, all of 
the following values are valid: LightGray, lightgray,  D3D3D3, d3d3d3.
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Bubble Chart form

Bubble Chart form fields

Field Description

Name Descriptive name for the bubble chart. Bubble Chart  is appended to the name 
when you view the bubble chart.

• Top left 
label

• Top right 
label

• Bottom 
left label

• Bottom 
right 
label

Label text for the top left, top right, bottom left, and bottom right quadrants, 
respectively. Choose labels that help interpret results. For example, a bubble chart 
that displays vendor assessment results might have the following quadrant labels, 
where vendors in the top right quadrant have the best scores:

• Top left label: Resource

• Top right label: Essential Partner

• Bottom left label: Poor Performer

• Bottom right label: Reevaluate

• Top left 
color

• Top right 
color

• Bottom 
left color

• Bottom 
right 
color

Border colors for the top left, top right, bottom left, and bottom right quadrants, 
respectively. Bubbles are the color of the quadrant they are in.

Type Metric type associated with this bubble chart. Only results for assessable records 
of the selected metric type are plotted on the bubble chart.
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Bubble Chart form fields  (continued)

Field Description

• X-Axis 
label

• Y-Axis 
label

• Z-Axis 
label

Label text for the X-, Y-, and Z-axis categories of the bubble chart. These labels 
appear along the X- and Y-axes, if applicable, and in bubble score summary 
windows. The metric category name is usually a good label. If these fields are left 
empty, the bubble chart automatically displays the selected category names as 
the labels.

• Metric X 
category

• Metric Y 
category

• Metric Z 
category

Metric category each axis represents. Results for the Z-axis category determine 
the size of each bubble. The Z-axis should generally represent the most important 
category out of the three.

Quadrant 
label color

Color of the label text for the quadrant borders.

Default Check box that enables (selected) or disables (cleared) the bubble chart as the 
default. There can be only one default bubble chart per metric type.

Bubble chart components

The X- and Y-axes each represent a different metric category. Assessable records are plotted 
on the chart as circular markers, or bubbles, which vary in size according to scores for the third 
category.

The bubble chart page has these components:

• Bubble Chart

◦ X- and Y-axes: Each axis represents a metric category.

◦ Bubbles: Each labeled bubble represents an average of category result data for an 
assessable record. Point to a bubble to view an assessable record score summary. Click a 
bubble or bubble label to view the scorecard for the assessable record.

• Source record list: List of all records defined by the Table  and Condition  fields for the 
associated metric type. Note that the bubble chart only plots records for which there are 
assessment results. The assessment results are actually associated with the assessable 
records for each of the listed source records.
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Bubble chart

Assessable record score summaries

Point to a bubble to display a score summary for the assessable record the bubble represents.

The summary displays the assessable record's average score for each category in the following 
order: X-axis category, Y-axis category, Z-axis category. The scores are based on data from the 
last 12 months.

Bubble chart score summary
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View an assessment scorecard

The Assessments application prepares printable scorecards. A scorecard displays easy-to-
interpret assessment results, in which the current calculated ratings for an assessable record are 
compared to previous ratings or to the ratings of other records.

Before you begin
Role required: assessment_admin or admin

About this task
Users can examine ratings over time, compare ratings for one assessable record with all 
assessable records in a table, or compare the ratings of two assessable records. All ratings are 
averages for the time range selected. The system dynamically updates a scorecard each time 
you view it, so the ratings reflect recently completed assessments and scripted metrics.

Administrators can display a scorecard for any table by creating a Related Link  on assessable 
records. The system provides this link on the Company form by default when Vendor 
Performance is active.

The Vendor Performance application provides an enhanced scorecard view for vendors.

See Vendor Performance in . Project Portfolio Suite .

Procedure

1. Navigate to All  > Assessments  > Assessable Records.

2. Open a record.

3. Under Related Links, click View Scorecard.

Create a link to a scorecard

Users with the admin role can create UI actions that allow users to view scorecards from tables.

Before you begin
Role required: assessment_admin or admin

Procedure

1. Generate assessable records  you want to evaluate.
For example, you might create a metric type called Project  to assess project management 
records.

2. Navigate to System Definition  > UI Actions.

3. Open the View Scorecard record.

4. Right-click the header bar and select Insert and Stay  from the context menu to create a 
duplicate record.

5. Change the Table  name to the table on which you want the UI action to appear.
For example, you might select Project [pm_project].
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6. Do not edit the Action name  field or the Condition  script.

7. Save the record.

8. Navigate to the table on which you created the UI action and open an assessable record.

a. In this example, navigate to Project  > Projects  > All.

b. Open any record in the list.

c. Click View Scorecard  under Related Links  to open the scorecard for that assessable record.
The scorecard appears with the title in the form of  <table display name>   Scorecard. For 
example, a scorecard for an assessable record in the Project [pm_project]  table is named 
Project Scorecard.

Note: 
Content does not appear in the scorecard unless the associated assessable record has 
assessment results or related live feed conversations.

9. Insert a new View Scorecard  UI action record for each table where you want the related link to 
appear.

Assessment scorecard averages

The Averages view compares the current ratings for an assessable record in each metric 
category with the average, minimum, and maximum values from all assessable records in the 
filter. All ratings are from assessments generated over the trailing twelve months (TTM).

Select a filter option to compare the current record against all assessable records in that filter. 
An assessment administrator configures these options in the Filter field  field in the Assessment 
Metric Type form.

Rating variances are highlighted as follows:

• Red: Ratings are below average in this category. The Diff  value displays a negative number.

• Green: Ratings are above average in this category. The Diff  value displays a positive number.

• White: Ratings are average in this category. The Diff  value is 0.0.

In the following example, the ratings of the current group are compared against other groups for 
which Don Goodliffe is the manager.
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Group scorecard with ratings filter

Assessment scorecard categories

The Categories view displays a bar chart showing the average ratings for each category in the 
selected time interval.

Select from these reporting periods:

• All History

• Last 3 Months

• Last 12 Months

Scorecard categories

Assessment scorecard category metrics

The Category Metrics view displays the weighted average results for each metric within a 
category. Use this view to learn how individual metrics affect the overall rating for the category.

Select a metric category from the choice list to display the chart.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3746



Scorecard category metrics

Assessment scorecard head-to-head compare view

The Head to Head Compare view allows you to compare the ratings of two assessable records of 
the same type. Select an assessable record from the choice list to compare against the current 
record's trailing twelve month (TTM) ratings.

Head to head compare

The Diff column displays the difference between each assessable record's most recent TTM 
ratings. By default, the system selects the first assessable record in the list when you open this 
view. The scorecard displays three years of ratings for the comparison record. All ratings are 
expressed as averages.

Scorecard head to head compare

Overall Rating
The Overall Rating is calculated as:

(sum of normalized values in category result) / (number of 
 assessment groups)

In the following example, the calculation is

(2.13 + 2.86 + 3.79 + 1.43 + 2.39 + 3.7) / 2 = 8.15
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Normalized values

Overall Rating on the group scorecard

Assessment scorecard history

The History view compares the current ratings for each category with ratings from the previous 
three years or four quarters.

Ratings that have declined are highlighted in red and display negative numbers. Ratings that 
have improved are highlighted in green with positive numbers. Arrow icons beside the values in 
the Diff  column indicate the trend of the current assessment against the previous assessment.

• 3 Years: To calculate the current ratings, the system averages the ratings from the trailing 
twelve month (TTM) period. The Diff  column shows the discrepancy between the current 
ratings and the previous calendar year's ratings.

Scorecard history - 3 years
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• 4 Quarters: Quarterly assessments compare the average rating for each category in the 
current quarter against the average ratings from the previous four quarters. The Diff  column 
shows the discrepancy between the current ratings and the previous quarter's ratings. The 
column labels count backward, by quarter from the current quarter. For example, if the current 
quarter is the 3rd  quarter of 2013, then the previous quarters appear as 2nd  [2013], 1st  [2013], 
4th  [2012], and 3rd  [2012]. All four of the previous quarters appear, whether or not there was 
any data for those quarters.

Scorecard history - 4 quarters

Live feed view of assessable records

The live feed view displays live feed conversations that apply to the assessable record. Users 
can view the group feed, including tagged comments, and add comments of their own.

To configure a live feed view, an assessment administrator selects the Live feed  check box on 
the Assessable Record form. Live feed is available on the scorecard even if there are no category 
results for the other views.

The live feed view provides these viewing options:

• My Feed: Displays the user's My Feed preferences.

• Company: Displays the user's company feed.

• Groups: Displays all available groups and gives the logged in user the option to leave or join a 
group. Select a group to display that group's conversations.

• Tags: Displays all the tags found in live feed comments. Click a tag to display the 
conversations containing that tag.
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Live Feed group scorecard

Assessment scorecard ratings

The scorecard ratings section displays various ratings for the assessable record.

Select one of several views that present different ratings:

• Averages

• Categories

• Category Metrics

• Head to Head Compare

• History

• Live Feed

Some views display an overall rating column, which lists categories used to evaluate the 
assessable record. Only categories in which the assessable record has been evaluated appear 
on the scorecard. If the ratings section does not display any data, the assessable record or 
category results associated to the assessable record have been deleted.

Click a category to view the category record. Point to a category to display a line chart that shows 
the rating trend for that category.
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Vendor scorecard trend chart

Create a decision matrix

The name and labels on a decision matrix are closely linked to the categories you choose for the 
axes. For that reason, first select the metric type and define the X and Y axes before you fill in 
other fields on the Decision Matrix form.

Before you begin
Role required: assessment_admin or admin

Procedure

1. Navigate to All  > Assessments  > Admin  > Decision Matrixes.

2. Click New.

3. Select the metric Type  to plot results for.

4. Right-click the form header and select Save.
The X Axis and Y Axis related lists appear.

5. Define which metric categories the axes represent.
Each axis can represent a single category or multiple categories. You must specify at least one 
category per axis in order for the decision matrix to render properly. The available categories 
are limited to those associated to the metric type selected. To avoid confusion, always update 
the text for the axis and quadrant labels after editing or adding metric categories to an axis.
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Decision matrix axes

6. Fill in the remaining fields on the Decision Matrix form and save the record.

Note: 
For color fields, either HTML color names or hexidecimal (hex) values are acceptable. For 
hex values, the   character is optional. Values are not case-sensitive. For example, all of 
the following values are valid: LightGray, lightgray,  D3D3D3, d3d3d3.

Decision Matrix form

Field Description

Name Name of the decision matrix, which appears as the title on the decision matrix 
page. It is recommended to include the axis categories in the name. For example, 
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Field Description

if you selected Importance Rating  as the X-axis and User Satisfaction  as the Y-
axis, you might name the matrix Importance vs. User Satisfaction.

Type Metric type associated with this decision matrix. Only results for assessable 
records of the selected metric type are plotted on the decision matrix.

Default Determines whether or not this is the default decision matrix. The default decision 
matrix opens when you click View Matrix  on a scorecard. Select the check box to 
set the matrix as the default decision matrix.

The system prevents you from creating more than one default decision matrix 
per metric type. If there is already a default decision matrix for the type and 
you try to save a different matrix with the check box selected, an error message 
appears. The maximum values for the default decision matrix are controlled by 
the Maximum number of items to show for a decision matrix field filter  property 
(com.snc.assessment.decision_matrix_filter_max_entries), 
which has a default value of 1000.

Quadrant Design Section

Quadrant 
label 
color

Color of the label text for the quadrants. Each quadrant label displays in the 
center of the quadrant. You can enter an HTML color name or hex value for this 
and the other color fields.

X-Axis 
label

Label text for the X-axis of the decision matrix. It is recommended to include the 
metric category name in the label text. For example, for an X-axis category of 
Importance Rating, the X-axis label is Importance.

Plotted 
item 
color

Color used to display plotted items.

Top left 
label

Label text for the top left quadrant. For an X-axis labeled Importance  and Y-axis 
labeled Support, you might label the top left quadrant Low importance, high 
support.

Top left 
color

Fill color for the top left quadrant.

Bottom 
left label

Label text for the bottom left quadrant.

Bottom 
left color

Fill color for the bottom left quadrant.

Bottom 
left label

Label text for the bottom left quadrant.

Bottom 
left color

Fill color for the bottom left quadrant.

Y-Axis 
label

Label text for the Y-axis of the decision matrix.

Highlight 
item 
color

Color of highlighted plotted items. When you view a decision matrix from an 
assessable record's scorecard, the assessable record plotted item appears in 
the highlight color. Specify a highlight color that is different than the Plotted item 
color.
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Field Description

Top right 
label

Label text for the top right quadrant.

Top right 
color

Fill color for the top right quadrant.

Bottom 
right 
label

Label text for the bottom right quadrant.

Bottom 
right 
color

Fill color for the bottom right quadrant.

Related Lists

X Axis Lists categories that define the X-axis of the decision matrix.

Y Axis Lists categories that define the Y-axis of the decision matrix.

Decision matrixes

Assessment results obtained by questionnaires and scripted metrics can be mapped to decision 
matrixes.

Assessment administrators can view and create these dynamically updated graphs, which make 
it possible to compare assessable records by category. Decision matrixes display data from a 
trailing twelve month (TTM) period.

Note: 
Assessment administrators can access decision matrixes through the Assessment 
application and vendor managers can access them through the Vendor Management 
Workspace  application.

Decision matrix components

The decision matrix page has these components:

Component Description

Options

Filter Select the subset of assessable records you want to view. The filter options 
available vary by metric type, based on the Filter  field and Filter condition  field 
settings for each type.
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Component Description

Decision matrix components

The maximum values in the filter are controlled by the Maximum 
number of items to show for a decision matrix field filter  property 
(com.snc.assessment.decision_matrix_filter_max_entries), 
which has a default value of 1000.

Scale Select the scale for the decision matrix. The greater the scale, the larger the 
decision matrix appears.

Decision matrix

X- and Y-
axes

Each axis represents one or more metric categories. If multiple categories are used 
for an axis, their respectiveweights  determine the positioning of the plotted items.

Plotted 
items

The labeled points you see on a decision matrix, called plotted items, represent 
averages of category result  data for assessable records. Point to a plotted item 
label to view a rating summary for that assessable record. Click a plotted item label 
to view the scorecard  for the assessable record.

Vendor decision matrix

Plotted item rating summaries

If you point to a plotted item label on a decision matrix, a rating summary appears. The summary 
displays the assessable record's average ratings for each axis. If an axis represents one metric 
category, the ratings are calculated averages from results for that category. If an axis represents 
multiple categories, the ratings are calculated averages from weighted results for all of the 
categories.

The summary shows:
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• Current rating

• Difference between the current rating and the rating from the previous year

• Ratings from each previous year, going back three years

Decision matrix rating summary

Take an assessment

Take the assessments assigned to you from the assessment and survey queue.

Before you begin
Role required: none

About this task
An assessment card displays the assessment name, state, due date, and associated incident 
number. Click the card to take the assessment when you're ready.

You must answer every required question, indicated by a red asterisk, before you can submit 
the assessment as complete. If you start to take an assessment but can't complete it, save your 
responses and return to it later. When you've answered all the questions and you're happy with 
the responses, submit the assessment.

Note: 
The expired assessments and surveys no longer appear in the My surveys  widget and 
the My Assessments and Surveys list  page.

By default, you can't modify your answers to an assessment after submission. However, if the 
administrator has configured an assessment to allow retakes, you can edit your answers and 
resubmit the questionnaire. Completed assessments configured for retake remain in the queue 
until their due date and display Modify Assessment at the top of the card. Click the card to 
modify the assessment.
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Note: 
If you don’t have access to the assessable record for which an assessment is created, the 
associated record number isn't displayed. You can still take the assessment.

Procedure

1. Navigate to All  > Self-Service  > My Assessments & Surveys.

Note: 
Users with the assessment_admin role can display other users' assessments and surveys 
in addition to their own. Use the Show all  and Show assigned to me  related links to show 
and hide assessments and surveys. Click a card assigned to another user to open the 
associated metric type or survey definition.

2. On the assessment card, note the due date.

Note: 
Depending on the configuration, you may receive email notifications to remind you of the 
due date.

3. Click the card to open the questionnaire.
Assessment questionnaires are arranged in sections: first by record, then by category. Each 
record appears as a section title. Questions for the record appear underneath the record, 
grouped by category. Each category appears as a subsection underneath the record name. 

Click the collapse icon ( ) or expand icon ( ) to hide or show the questions in a category, 
or all the categories and questions for a record. Colored bars indicate the status of each 
question.

4. Answer each question to the best of your ability.
Point to a question for more information.
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If you're unsure of how to respond to a question or if a question doesn't apply to a particular 
record, select Not Applicable, if available.

5. Read any assertions present at the end of the assessment and acknowledge with a signature, 
if required.

A signature can require you to select a check box or authenticate your full name, which the 
system displays in a read-only field. You can't submit your answers to the assessment until you 
provide the required signature.

6. Save or submit the assessment.

◦ Save: Saves your responses without submitting them. You can close the questionnaire and 
access it later from your queue.

◦ Submit: Submits the completed assessment when you're finished.

7. If prompted, enter your user name and password to verify your full name signature.

If all the questions are answered with valid values, a  success  message appears. If the 
system detects an unanswered required question or invalid response, the assessment isn't 
submitted, and a message appears at the top of the questionnaire explaining the error. 
Questions with problems are temporarily highlighted.

8. You can modify your responses to the assessment until its due date.
To update your answers and resubmit an assessment that permits retakes, click the card to 
modify it.

Related topics

Metric types and assessable records

Survey definitions
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Assessments in Service Portal  and the Now Mobile app

If you've installed Service Portal, you can use the My Assessments and Surveys  widget in Service 
Portal. Users can view and take assessments in Service Portal. Service Portal  also supports 
assessments for users on mobile devices that have the Now Mobile app  installed. The My 
Assessments and Surveys  widget is available by default on the Service Portal  home page.

Assessments in Service Portal

To create an intuitive interface for your users, you can set up assessments in Service Portal. 
Activate Service Portal  to view the My Assessments and Surveys  widget, which appears on the 
Service Portal  home page.

To learn more about activating Service Portal, see Activate Service Portal .

To learn more about configuring a widget, see configure widget instances  .

To configure an Assessments and Surveys  widget on a Service Portal  home page, press the 
CTRL key, right-click the widget heading, and select Instance Options.

Instance options (properties) for the assessments and surveys widget on Service Portal

Property Description

Max 
records Maximum number of assessments to list in the widget on the Service Portal  home 

page. Users can click the View all  link to view all assessments.

Default number of assessments: 5

Title 
of the 
widget

Text that appears in the title bar of the survey widget.

Default title: My Assessments and Surveys

My Assessments and Surveys  widget on the Service Portal  home page

Assessments in the Now Mobile app

Your users can view and take the assessments on mobile devices using the My Assessments 
and Surveys  applet launcher that is available by default in the Now Mobile app.

When you assign an assessment to a user, an email notification about taking the assessment is 
sent to the user. If users installed the Now Mobile app, a mobile push notification is also sent on 
mobile devices. Tapping the notification opens an introduction page for an assessment in the 
Mobile Employee Service Portal  in the Now Mobile app. The page displays a Get started  link. The 
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introduction page and the Get started  link are available only if the related settings are enabled. 
Users can tap the link to view and take the assessment. You can activate push notifications by 
setting the glide.sg.universal_links.enabled  system property to true.

My Assessments and Surveys  applet on a mobile device

Note: 
In the Washington DC  release, you now see the assessments and surveys assigned in 
the card view instead of the item view. If you customize the styles of the legacy card item 
views in older versions of Assessments and Surveys, the card continues to appear in the 
item view even after you upgrade to Washington DC. You can view the new card view in 
Washington DC  only if no customizations were made to the legacy cards.

When users open an assessment either in Service Portal  or the Now Mobile app, the assessment 
provides the following features:
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• An assessment page shows breadcrumb navigation on the Service Portal. Users can click the 
links in the breadcrumb to navigate to previous pages or a home page. For example, clicking 
the My Surveys  link in the breadcrumb navigates users to a page, which shows a list of all the 
assessments.

• When the assessment is in progress, the progress bar, available on each page of the 
assessment, shows the progress in percentage. The percentage of completion is based 
on the number of pages in the assessment. For example, suppose that there are three 
pages in the assessment. The third page shows 66% completion of the assessment. But 
giving a response to one of the questions on the third page opens a new question on 
a separate page, which is the fourth page. The fourth page shows the progress of the 
assessment as 75% completed, which affects overall progress and page indicators. Users 
can see the pagination - total number of pages - for the entire assessment as well as the 
current page that the users are on. To hide or show this progress bar, you can use the 
sn_portal_surveys.sp_survey.show_progress_bar  property.

• Each user response is saved automatically when users move to the next page in the 
assessment. If users don't answer the required assessment questions before clicking Next, 
the page shows an error message at the top for all required and unanswered questions. This 
error message helps users find the exact location of the unanswered and required question. 
Any question that is not required and is not responded to before clicking Next  is considered 
answered. The question is counted as completed.

• When the details of an assessment question contains more than four or five lines of text, the 
text after these lines disappears. In such cases, users can see the complete details by clicking 
the Show more  link. Users can go back to the default behavior by clicking the Show less  link.

• For a question that has the answer options of Yes, No, and Not Applicable, the Not Applicable 
option appears last in the list of options. The Not Applicable  option can be configured while 
creating a question.

• Your users can take assessments for multiple incident records generated. For example, 
suppose that users have two incident records generated. The user can take an assessment for 
both the incident records generated using the same assessment instance.

• When the assessment users leave the assessment without submitting it, they can start the 
assessment later from the same page where they left off in the previous session.

Note: 
For mobile users, the pagination is always by question for assessments.

Related topics

Activate Service Portal

Assessment questionnaires

In the assessment process, users complete assessment questionnaires on topics of interest to 
provide subjective data for future business decisions.

No special role is required to complete an assessment. You are eligible to complete assessments 
that are assigned to you. For example, you might be expected to evaluate vendors your 
organization works with, based on traits related to customer service. The system stores your 
responses so decision makers can compare the performance of the items you evaluate. You and 
your manager may receive email notifications as reminders of important assessment information.

Related topics

Assessment notifications

Take an assessment
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Metric types and assessable records

In the Assessments application, assessment administrators create and administer metric types 
and assessable records.

A metric type defines a set of records an organization wants to evaluate, such as vendors, 
projects, or employees. For each type, the system generates unique assessable records that 
link the type to records that need to be evaluated, such as the individual records for the vendors 
Amazon and Intel. There may be multiple assessable records for the same source record if the 
source record meets the criteria for more than one type.  For example, you might want to evaluate 
a record on the Company table, such as Intel, as a vendor and as a manufacturer, with different 
categories  and metrics.

For configuration suggestions, see Assessment administrator tasks.

Assessable records

An assessable record links a source record you want to evaluate, such as the company record 
for Amazon or the user record for a sales representative, to a metric type, such as vendors or 
employees.

You use assessments to evaluate the assessable record. The system generates assessable 
records from the source records that match the table and conditions set on the Assessment 
Metric Type form. You evaluate the assessable records with metric categories and metrics, 
which define traits and values to assess. For metric types with the On demand  schedule type, 
you can generate on-demand assessments  from the Assessable Record form. This method of 
assessment generation makes it easy to create and preview short questionnaires or to quickly 
obtain assessment results for specific assessable records.

You can set up an assessment description that includes information from multiple fields on an 
assessable record and is displayed on multiple lines. This set up provides the user who is taking 
the assessment with a more detailed and understandable description of the information being 
requested on the assessment questionnaire. Create a multi-line description using table titles, 
which can be defined to use one or more fields from the selected table.

Related topics

Use update sets for surveys and assessments

Metric types and assessable records

View an assessable record

Delete an assessable record

When you delete an assessable record, the system deletes any stakeholders for the record.

Before you begin
Role required: assessment_admin or admin

About this task
Note: 
If a source record is deleted, the system deletes the associated assessable record. To 
delete the source record, you must first delete all associated metric results and category 
results.

Procedure

Delete the assessable record:
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• To delete a single record, open the record and click Delete.

• To delete multiple records, use the Assessable Records list.

Related topics

Metric types and assessable records

View an assessable record

View the Assessable Record form to edit preferences and perform various actions.

Before you begin
Role required: assessment_admin or admin

Procedure

1. Navigate to All  > Assessments  > Assessable Records.

2. Open a record from the list.
By default, the list displays only assessable records with Active  metric types.

3. On the Assessable Record form, edit fields and perform other actions as necessary (see table).

Viewing Assessable Records

Field Description

Name [Read-Only] Assessable record name based on the Select a field as the 
table display value  of the source record. The name appears on assessment 
questionnaires.

Source [Read-Only] Source record the assessable record is linked to. The Source 
reflects the table name and source record display value. For example, if the 
Name  field is the display value for the Company table, the assessable record for 
a company record named Amazon  has the Source  value Company: Amazon.

Live feed Check box that, when selected, creates a live feed group for the assessable 
record, which appears on the scorecard. If you clear the check box after a live 
feed group has been created, the system deletes the live feed group and all its 
messages.

Type [Read-Only] Metric type from which the assessable record was generated.

Decision 
matrix

Check box that, when selected, enables this assessable record's results data 
to appear on decision matrixes of the same metric type. Decision matrixes are 
graphs that plot the assessment results for multiple assessable records. If you 
clear the check box, the assessable record still appears on the default decision 
matrixes if you click the View Matrix  related link on the assessable record's 
scorecard.

Live feed 
group

[Read-Only] Live feed group for this assessable record. When you select the Live 
feed  check box and save the record, the system populates this field.

Related Links

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3763

https://www.webstg.servicenow.com/docs/access?context=t_SelectTheDisplayValue&version=washingtondc&pubname=washingtondc-platform-administration&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=t_SelectTheDisplayValue&version=washingtondc&pubname=washingtondc-platform-administration&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=t_SelectTheDisplayValue&version=washingtondc&pubname=washingtondc-platform-administration&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=t_SelectTheDisplayValue&version=washingtondc&pubname=washingtondc-platform-administration&ft:locale=en-US


Field Description

View 
Scorecard

Opens the scorecard for the assessable record.

Related Lists

Category All metric categories associated with the assessable record. An assessable 
record must be associated to a category to be evaluated. Click Edit  to add or 
remove category associations. Note that it is often more efficient to associate 
assessable records  to categories using the Metric Category form.

Category 
users

All stakeholders who can take assessment questionnaires about this assessable 
record. Click Edit  to create and delete stakeholders. For more information about 
this and other methods of creating stakeholders, see Stakeholders.

This related list is available only when the associated metric type has the 
Scheduled  schedule type.

Related topics

Metric types and assessable records

Assessments reference

Reference topics provide additional information about the forms, fields, and properties you use 
while working with assessments.

Data types for assessments

Metric data types have functions that depend on the method that you select.

Assessment data types

Data type
Compatible 
methods

Description

Attachment Assessment
On questionnaires, users attach one or more files to a question.

Checkbox Assessment
On questionnaires, users select a check box next to a statement or 
leave it cleared.

Check box

Set the Scale definition  field to High  if a selected check box 
equates to a good score.

Choice Assessment On questionnaires, users select a value from a list of custom 
answer options. Create a metric definition for each answer option.

Choice
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Assessment data types  (continued)

Data type
Compatible 
methods

Description

Date Assessment On questionnaires, users select a date.

Date

Date/Time Assessment On questionnaires, users select a date and time.

Date/Time

Duration Script When the script runs, the system populates the Duration value  and 
Scaled value  fields on the Metric Result form with the appropriate 
values from the actual_result  and scaled_result 
variables in the metric script.

Likert Scale Assessment On questionnaires, users select a value from a custom scale of 
answer options. Create a metric definition for each answer option, 
which is represented by a radio button on the scale. A Likert scale 
metric that evaluates an application's ease of use might have the 
metric definitions Easy, Average, and Difficult.

If you want to reuse a series of answer options for multiple metrics, 
create a metric template and use the Template data type instead of 
the Likert Scale data type.

Likert Scale

Number Assessment, 
Script

Assessment: On questionnaires, users enter a number.

Number
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Assessment data types  (continued)

Data type
Compatible 
methods

Description

Script: When the script runs, the system populates the Actual 
value  and Scaled value  fields on the Metric Result  form 
with the appropriate values from the actual_result  and 
scaled_result  variables in the metric script.

Percentage Assessment, 
Script Assessment  On questionnaires, users enter a number.

Percentage

Script  When the script runs, the system populates the Actual 
value  and Scaled value  fields on the Metric Result form 
with the appropriate values from the actual_result  and 
scaled_result  variables in the metric script.

String Assessment
On questionnaires, users enter text. The size of the string field 
depends on the String option you select:

String

String single line wide data type

Additional comments

Template Assessment On questionnaires, users select a value from a predefined series of 
answer options. There must be at least one template defined to use 
this data type. For a template, there is a template definition for each 
answer option, which is represented by a radio button.

Yes/No Assessment
On questionnaires, users select Yes  or No  from a list.

Yes/No
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Assessment data types  (continued)

Data type
Compatible 
methods

Description

Set the Scale definition  field to High  if selecting Yes  equates to a 
better score.

Related topics

Assessment metrics

Create an assessment metric definition

Update a metric minimum and maximum value to match a template

Assessment Metric form

Description of the field values for the Assessment Metric form.

Assessment Metric form

Field Description

Name Name of the assessment.

Assessment 
duration

Allowed duration to complete an assignment after its generation.

Live feed Checkbox that automatically creates live feed groups for newly generated 
assessable records of this type.

Notify 
manager if 
overdue

Checkbox to send a notification to the manager when the assessment 
becomes overdue.

Scale factor Scale value for all assessment results.

Pagination 
setting for 
Service Portal 
view

The setting on which the pagination is based for desktop or tablet view in 
Service Portal.

• Category: default

• Question: 1 question per page (automatic for mobile)

• None: no pagination

Note: 
This field is displayed only when Service Portal is installed.

Business rule Business rule that is automatically created for assessable record generation.

Schedule type Scheduled or on-demand assessment type.

Scheduled job Scheduled job the system creates for this assessment definition when the 
schedule period is a repeating interval. The system sets the scheduled job to 
run according to the selected schedule period.

• If you change the schedule period and save the survey definition, the 
system deletes the old scheduled job.

• If you selected a recurring schedule period, a new scheduled job is created.
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Assessment Metric form  (continued)

Field Description

For example, if you change the schedule period from Daily  to Weekly  and save 
the record:

• The system deletes the daily scheduled job.

• Creates a weekly one set to run a week from the current date.

This field is visible to administrators only if the schedule period is Daily, 
Weekly, Monthly, or Yearly.

Evaluation 
method

Type of assessment.

Roles Roles with read access for this metric type.

Active Check box to enable the distribution of this assessment to recipients.

Owners Owners of the assessment. You can add a user with the survey_creator, 
survey_admin, or assessment_admin role.

Description Description of the assessment.

Conditions

Table Table that contains records to assess for this type.

Enforce 
condition

Checkbox to delete the existing assessable records of this type that do not 
meet the specified conditions.

Condition Conditions that the assessable records of this type should meet.

Decision Matrix

Filter field Field on the Filter table to identify filter menu choices on decision matrices and 
scorecard averages for this type.

Filter 
condition

Conditions to filter results on decision matrices and scorecard averages for 
this type.

Default matrix 
filter

Default filter menu choice on decision matrix of this type.

Assessors

User field User field from the table specified in the Conditions  tab. The assessment will 
be assigned to all users of this user field in the table.

When you save the assessment and click Generate Assessable Records, 
an assessable record is created for each unique user of the user field. This is 
applicable for Scheduled and On-demand assessments.

For an on-demand assessment, each assessor assesses all assessable 
records. For a scheduled assessment, each assessor assesses only the 
corresponding assessable record.

Related Links

Generate 
Assessable 
Records

Creates assessable records for this metric type.
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Assessment Metric form  (continued)

Field Description

Show 
Benchmarks

Opens the Benchmarks Dashboard that provides visibility into your key 
performance indicators (KPIs) and trends.

Note: 

• This related link is available only for survey_admin, assessment_admin 
and survey_reader with bm_viewer role.

• You must opt in to Benchmarks to view the dashboard. See Enable 
Benchmarks

• This is applicable only for a published survey.

Create 
Improvement 
Initiative

Opens the Improvement Initiative window to create an improvement initiative 
record that helps in improving the performance of the assessment.

Note: 

• This related link is available only for the survey_admin and 
assessment_admin role. A survey_reader can only view the created 
improvement initiative records.

• You should activate the Continual Improvement Management plugin 
(com.sn_cim).

Related Lists

Metric 
Categories

All metric categories for this assessment.

Assessable 
Records

All assessable records for this assessment.

Improvement 
Initiatives

Displays improvement initiatives associated with the survey.

Note: 
This related list is available only when there is at least one improvement 
initiative record.

Related topics

Configure an assessment

Metric Category form

Description of the field values for the Metric Category form.

Metric Category form

Field Description

Name
Name of the metric category. The name appears on assessment questionnaires.
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Metric Category form  (continued)

Field Description

Type [Required] Metric type this category is used for. Metrics in this category can be 
used to evaluate assessable records for the type you select. This field becomes 
read-only after you save the record.

Create 
stakeholders

Check box that enables (selected) or disables (cleared) automatic stakeholder 
creation for this category. When the check box is selected, the system makes 
all associated category users stakeholders for each assessable record 
associated to this category. This saves the time required to manually create 
stakeholders. For more information, see Create Stakeholders Automatically. 
Existing stakeholders are not impacted if you clear the check box.

Table
[Read-Only] Table that contains the records to evaluate with metrics in this 
category. The system automatically populates this field with the same table as 
the metric type selected. The table does not appear in the field until you save 
the form.

This field is visible depending on whether a Type  is selected.

Weight [Required] Numerical value that represents the importance of this category 
relative to other categories. A greater value indicates greater importance. For 
more information, see weight categories and metrics. The default value is 10.

Scoring type Scoring method for an attestation category. This field appears only when the 
metric type  is an attestation with a Scoring type  of Percent. Use this field to 
configure different scoring types for specific attestation categories. Possible 
selections are:

• Percent: Attestation score as a weighted percentage of correct answers for 
scored questions.

• All or nothing: All answers for attestation type questions must be correct or 
the score is zero for the entire category.

Total metrics [Read-Only] Number of metrics associated to this category.

Filter
Filter conditions that assessable records must meet to be evaluated using 
metrics in this category.

The filter operates on fields on the selected table.

If you specify a filter condition, the system automatically associates matching 
assessable records to the category when you save the record. If you change 
the filter conditions, the system removes and creates assessable record 
associations as needed. The system also deletes stakeholders for assessable 
records it disassociates. The system does not remove assessable record 
associations created by users, even if the assessable records do not match the 
filter conditions.

This field is visible only when a Type  is selected.

Description Descriptive information about the category that appears on assessment 
questionnaires.
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Metric Category form  (continued)

Field Description

Roles Only those users with the specified roles can perform the assessment for 
this category. If no role is specified, then users with any role can perform the 
assessment for this category.

Note: 
If the Roles  property does not appear on the form, ask your admin to add 
the property.

Details Text field containing an HTML editor. Use this field to present important details 
about this category to assessment recipients. Details can include formatted lists, 
images, videos, or links to external websites. You may need to configure the form 
to see this field.

Related Lists

Assessment 
Metrics

All metrics associated to this category. There must be at least one metric 
associated to the category to use any assessments with the category.

Assessable 
records

All assessable records associated to this category. There must be at least one 
assessable record associated to the category  to use any assessments with the 
category. This related list is hidden if the Evaluation method  is Attestation.

Note: 
Category users are automatically generated based on the user field is 
specified in the Assessors  tab of the assessment after publishing the 
assessment.

Users
All users associated to this category. There must be at least one category user to 
create scheduled assessments using metrics in this category.

If any user field is specified in the Assessors  tab of the assessment, the 
corresponding users are automatically generated after publishing the 
assignment.

This related list is available only when the associated metric type has schedule 
type set to Scheduled. Category users are not a part of the on-demand 
assessment  process.

Related topics

Create a category for assessable records

Assessment Metric form for a category

Description of the field values for the Assessment Metric form. Use the fields when you create an 
assessment metric for a category.

Assessment Metric form

Field Description

Name Name of the metric.
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Assessment Metric form  (continued)

Field Description

Category Metric category that the metric belongs to. The system automatically populates 
this category if you create a new metric from the Metric Category form.

Note: 
You cannot change the category if the Depends on  field is set or if another 
metric depends on this metric

Method
Determines how to use the metric.

• Assessment : Non-scripted metric. Make the metric available as a question on 
an assessment questionnaire. The Assessment  method is compatible with all 
data types except Duration.

• Script: Scripted metric. Obtain values by writing a custom script. The Script 
method is compatible with the Duration, Number, and Percentage  data types.

• Default answer from field: This option appears only if you have selected an 
Assessment Metric Type  that contains a table. The General  tab adds two 
fields:

◦ Default answer: Select the default answer for the question. The list comes 
from the selected table.

◦ Ask question: Specifies when to ask the question: always or only if the 
default answer is empty.

• Default answer from script: The General  tab adds a field:

Ask question: Specifies when to ask the question: always or only if the script 
does not contain a default answer. The script is defined on the Field Type  tab.

Note: 
If you select a Data type  that is incompatible with the selected Method, the 
system automatically changes the Method  to the correct value.

Weight
Numeric value that represents the importance of this metric relative to other 
metrics in the same category. By default, the weight is 10. For weighting 
suggestions, see Weight Metrics and Metric Categories.

This field is visible and required unless the Data type  is Date, Date/Time, or 
String. These data types are not included in results calculations.

Order Numeric value that determines the order of the metric question on assessment 
questionnaires, relative to other metric questions in the same category. The 
metric with the smallest order value appears as the first question in the category 
section. By default, the order is 100. For more information about questionnaire 
layout, see Complete Assessment Questionnaires.

Note: 
It does not matter which order value you use for metrics with the Script 
method, as they do not appear on questionnaires.

Active Check box that determines whether this metric is used to gather assessment 
results. If a non-scripted metric (Assessment method) is inactive, the question 
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Assessment Metric form  (continued)

Field Description

does not appear on assessment questionnaires generated after the metric 
becomes inactive. If a scripted metric (Script method) is inactive, the script does 
not run.

Mandatory
Check box that makes the metric question mandatory (selected) or optional 
(cleared) on assessment questionnaires. Users cannot submit questionnaires 
until they provide valid responses to all mandatory questions, which display a red 
field status indicator.

This field is visible only if the Method  is Assessment, the Depends on  field is 
empty, and the data type is not Checkbox.

Allow not 
applicable Check box that determines whether to include a Not Applicable  answer option 

for this metric question on assessment questionnaires. Users can select Not 
Applicable  if they do not have sufficient information to respond to a question or 
if a question does not apply to a particular assessable record. User responses of 
Not Applicable  are excluded from results calculations.

This field is visible only if the Method  is Assessment  and certain data types are 

selected.

Additional fields you can add by customizing the form

Details
Text field containing an HTML editor. Use this field to present important 
details about this metric to assessment recipients. Details can 
include formatted lists, images, videos, or links to external websites. 

General Section

Question Text to use as the question on assessment questionnaires. Enter a clear, 
straightforward question that is easy to answer, such as How likely are you to 
recommend this vendor for the purchase of office supplies?

Description Information about the metric and what it evaluates. If the Method  is Assessment, 
include details that help users understand how to answer the question. 
This text appears as a hint when a user points to the question text on the 

questionnaire.
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Assessment Metric form  (continued)

Field Description

Depends on
Setting used to make this metric a conditional question. Select an existing 
metric question from the list, which displays Checkbox, Choice, Likert Scale, 
Template, and Yes/No  metrics of the same category as this metric. Then, use 
the Displayed when  field to set the conditions that display this metric question 
on questionnaires. The system prevents the creation of recursive dependencies 
between metrics. For example, if Metric A depends on Metric B, Metric B cannot 
depend on Metric A.

This field is visible only if the Method is Assessment.

Displayed 
when Answer options for the selected Depends on  metric question that, when chosen 

on questionnaires, display this metric question.

This field is visible and required only if the Depends on  field is set.

Field Type Section

Data type [Required] Format of the expected response data. The function of the data type 
depends on the selected Method. If the method is Assessment, the data type 
determines how users answer the corresponding question on questionnaires. 
If the method is Script, the data type determines how the system calculates 
assessment results.

Note: 
If another metric depends on this metric, you cannot change the data type.

Randomize 
answers Check box that determines whether to present the answer options for this metric 

question in a random order. The order of answer options can influence users, 
which creates biased results. Randomizing answer options can help prevent this 
bias.

This field is visible only if a data type that requires metric definitions is selected.

Note: 
Randomizing answer options for certain questions can make those 
questions confusing for the person answering. In general, only randomize 
answer options that do not follow a logical order. For example, the following 
question is confusing when randomization is enabled:

Template
Metric template to use for the metric question. A metric template is a set of 
predefined answer options.

This field is visible and required only if the Data type  is Template.

Note: 
If another metric depends on this metric, you cannot change the template.
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Assessment Metric form  (continued)

Field Description

Dependent 
plugin Plugin that contains the tables queried in the script. The system executes the 

metric script only if the plugin is active. The default available values are Asset 
Management, CMDB, Core, Cost Management, Procurement, and Software 
Asset Management. If the Method  is Script, select a plugin.

This field is visible only if the Method  is Script.

Note: 
An administrator may need to add more Define an option for a choice list
of plugins to the field.

Scale 
definition Setting that determines whether lesser or greater numerical values equate to 

a good score in assessment result calculations. Select Low  if lesser numerical 
values are better, such as for a metric that measures the number of incidents for 
a vendor. Select High  if greater numerical values are better, such as for a metric 
that measures user satisfaction on a scale of one to five. The default value is 
High.

This field is visible and required unless the Data type  is Date, Date/Time, or 
String. The results for these data types are not included in results calculations.

Note: 
For information about how to set the scale definition for data types that do 
not require you to set a numerical value, see Data Types.

Min
Lowest numerical value to be used as an answer option on assessments or as a 
scaled value in a scripted metric.

This field is visible and required only if certain data types are selected. If the 
data type is Choice  or Likert Scale, this field is read-only and is set automatically 
based on the smallest metric definition Value.

Max
Highest numerical value to be used as an answer option or scaled value.

This field is visible and required only if certain data types are selected. If the 
data type is Choice  or Likert Scale, this field is read-only and is set automatically 
based on the largest metric definition Value.

Script Script that obtains the desired system information.

This field is visible and required only if the Method  is Script.

Related List

Assessment 
Metric 
Definitions

Lists all metric definitions, which appear as answer options for questions on 
assessment questionnaires. Click New  to create a new metric definition.

This related list is available only if the Data type is Choice  or Likert Scale.
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Related topics

Create an assessment metric for a category

Trigger Condition form for assessments

Description of the field values for the Trigger Condition form for assessments.

Trigger Condition form

Field Description

Assessment [Required] Metric type to generate assessment instances for. Triggered 
assessments only work if the metric type is set to the On demand  schedule type.

Table [Required] Table to run the trigger condition on. You can select only tables in the 
current application scope.

The table must have a connection to the assessable records for the selected 
Assessment. For example, you might want to send a vendor assessment when 
incidents close that are related to vendors you assess. In this case, select the 
Incident [incident] table. After you select a table, ensure there is at least one 
option for the Assessable Record Field. If there is not, select a different table.

User field [Required] Field that stores the users you want to send the assessment. 
You can select any field, on the selected Table  or on a related table, 
that references the User [sys_user] table. Use the tree picker to select a 

field.

Repeat 
Interval

Minimum period that must pass before the trigger condition can resend the 
assessment to the same user. For example, assume the repeat interval is set 
to 30 days. Even if the same user is eligible for multiple assessments from this 
trigger condition, the system can only send the user one assessment every 30 
days.

Active Check box that determines whether this trigger condition is active (selected).

Business 
rule

[Admin only] Business rule the system creates to monitor the selected table. 
When the condition is met, the business rule sends the assessment to the 
correct user. No configuration is necessary for this business rule.

Trigger 
randomly

Check box that determines whether to send the assessment to the appropriate 
user every time the condition is met (cleared) or only a percentage of the time 
(selected), as specified in the Probability (%)  field.

Probability 
(%)

Probability out of 100 that the assessment will be sent each time the condition is 
met. For example, if the probability is set to 50, the system sends the assessment 
approximately 50% of the time the conditions are met, assuming there are 
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Trigger Condition form  (continued)

Field Description

no repeat interval restrictions. This field is visible and required only when the 
Trigger randomly  check box is selected.

Assessable 
Record 
Field

[Required] Field on the selected Table  that determines which assessable record 
will be the subject of the assessment. Only appropriate reference fields on the 
selected Table  are available to select. If there are no Assessable Record Field 
options available, you must select a different Table.

If the selected Assessment  evaluates records on the Company 
[core_company]  table and the selected Table  is Incident, the only 
Assessable Record Field  options are fields on the Incident table that reference 
the Company table. For example, Company  or, if vendor ticketing is enabled, 
Vendor. If you select Vendor, the trigger condition sends an assessment 
about the Vendor  for the incident, assuming there is an assessable record for 
the associated company. The assessment contains questions from all metric 
categories associated with the assessable record.

Note: 
This field is not available if the selected Assessment  is a metric type used 
for surveys. See Survey trigger conditions.

Related 
Field 1 – 
Related 
Field 4

Field that contains a value you want to store for reporting purposes. You can pick 
any reference field on the selected Table. When the trigger condition generates 
an assessment instance, the system stores the value from the triggering record. 
Select up to four fields.

For example, if you select the Incident table, you might select Caller  and Vendor 
as related fields. That stores the caller and vendor associated with the incident 
as Related record 1  and Related record 2  in the assessment instance record. To 
view these fields, configure the Assessment Instance form.

Description Summary information to identify the trigger condition.

Condition [Required] Condition builder that defines the criteria that must be true to send 
the assessment. For example, if you want to send an assessment whenever an 
incident closes, create the condition [State] [is] [Closed].

Related topics

Configure a trigger condition for a survey

Domain separation and Assessments

Domain separation is supported for Assessments. Domain separation enables you to separate 
data, processes, and administrative tasks into logical groupings called domains. You can control 
several aspects of this separation, including which users can see and access data.

Support level: Standard

• Includes all aspects of Basic  level support.

• Application properties are domain-aware as needed.
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• Business logic: The service provider (SP) creates or modifies processes per customer. The use 
cases reflect proper use of the application by multiple SP customers in a single instance.

• The instance owner must configure the minimum viable product (MVP) business logic and data 
parameters per tenant as expected for the specific application.

Sample use case: An admin must be able to make comments required when a record closes for 
one tenant, but not for another.

For more information on support levels, see Application support for domain separation .

Related topics

Domain separation for service providers

Installed with Assessments and Surveys

Several types of components are installed with the activation of Assessments and Surveys.

• Demo data is available for Assessments and Surveys.

• ServiceNow®  Vendor Performance  offers an extra set of vendor assessment demo data.

Tables

Table Description: Assessments Description: Surveys

Assessable Record

[asmt_assessable_record]

Stores all assessable 
records.

For system use only.

Assessment Category Result

[asmt_category_result]

Stores all category 
results.

For system use only.

Assessment Category User

[asmt_m2m_category_user]

Stores associations 
between users and 
metric categories that 
they can evaluate. A 
user that is associated 
to a category is a 
category user.

Stores associations 
between users and surveys. 
A user that is associated 
to a survey is a survey 
user  and is automatically 
associated to all the 
survey's categories.

Assessment Group

[asmt_assessment]

Stores all assessment 
groups.

For system use only.

Assessment Instance

[asmt_assessment_instance]

Stores all assessment 
instances.

Stores all survey instances.

Assessment Instance Question

[asmt_assessment_instance_question]

Stores all assessment 
instance questions, 
each of which 
represents one question 
on one assessment 
instance.

Stores all survey instance 
questions, each of which 
represents one question on 
one survey instance.

Assessment Metric Stores all metrics. Stores all survey questions.
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Table Description: Assessments Description: Surveys

[asmt_metric]

Assessment Metric Definition

[asmt_metric_definition]

Stores all metric 
definitions.

Stores all answer options 
for survey questions.

Assessment Metric Template

[asmt_template]

Stores all metric 
templates.

Stores all question 
templates.

Assessment Metric Type

[asmt_metric_type]

Stores all metric types. Stores all survey definitions.

Assessment Stakeholders

[asmt_m2m_stakeholder]

Stores associations 
between assessable 
records and category 
users. A category user 
that is associated to an 
assessable record is a 
stakeholder.

Not used for surveys.

Assessment Template Definition

[asmt_template_definition]

Stores all metric 
template definitions.

Stores all question template 
definitions.

Assessment X Category Matrix

[asmt_m2m_xcategory_matrix]

Users can specify metric 
categories as the X axis 
of a decision matrix.

Not used for surveys.

Assessment Y Category Matrix

[asmt_m2m_ycategory_matrix]

Users can specify metric 
categories as the Y axis 
of a decision matrix.

Not used for surveys.

Bubble Chart

[asmt_bubble_chart]

Stores all bubble chart 
definitions.

Not used for surveys.

Category Assessable Records

[asmt_m2m_category_assessment]

Stores associations 
between assessable 
records and metric 
categories.

For system use only.

Decision Matrix

[asmt_decision_matrix]

Stores all decision 
matrixes.

Not used for surveys.

Metric Category

[asmt_metric_category]

Stores all metric 
categories.

Stores all survey categories.

Metric Result

[asmt_metric_result]

Stores all metric results. Stores all survey 
responses.

Signature Stores all signature 
records  for assessments 

Stores all signature records 
forSurveys.
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Table Description: Assessments Description: Surveys

[asmt_signature]
and [[Attestations|GRC 
attestations]].

Trigger Condition

[asmt_condition]

Stores all assessment 
trigger conditions.

Stores all survey trigger 
conditions.

Properties

You can configure various properties to customize the appearance of Assessments and Surveys 
questionnaires, require authentication for user signatures, open surveys in the Service Portal 
view from emails, and limit the number of items shown in a decision matrix field filter.

Assessments and Surveys  installs the following properties. You can find these properties by 
navigating to the following locations:

• All  > Assessments  > Administration  > Assessment Properties

• All  > Survey  > Administration  > Properties

Important: 
You can customize the css.assessment.question.header.background.color, 
assessment.caption.background.color, and the css.assessment.caption.font.color fields 
only if Next Experience  is turned off.

Property Description

sn_portal_surveys.sp_survey.email_redirection When this property is enabled, users 
can use a link in an email to open 
a survey or assessment in Service 
Portal.

• Type: Yes  or No

• Default value: Yes

com.snc.assessment.signature_authentication When this property is enabled, an 
authentication is required by user 
signature. When Yes  is selected, this 
property requires credentials for a 
full name signature.

• Type: Yes  or No

• Default value: Yes

For more information about working 
with signatures, see Signatures.

com.snc.assessment.collect.stats List of Assessments for which 
Recent Sent & Recent Completed 
stats must be collected in an 
asmt_assessment_stat table. 
Comma-separated list of eligible 
Assessment Metric Type Sys IDs.
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Property Description

css.assessment.question.header.background.color Background color of question 
headers on assessment and survey 
questionnaires.

• Type: Color

• Default value: #767676

sn_portal_surveys.sp_survey.show_progress_bar Shows or hides a progress bar on 
the survey pages on Service Portal.

• Type: Yes  or No

• Default value: Yes

Note: 
If the Pagination setting is 
set to None, the survey is 
displayed in a single page, and 
no progress bar is shown.

show_lang_picker_for_publicsurveys Enable or disable whether to show 
language picker when a public 
survey is taken.

• Type: Yes  or No

• Default value: Yes

css.assessment.caption.background.color Sets the background color of the 
caption on assessment and survey 
questionnaires.

• Type: Color

• Default value: #eee

com.snc.assessment.decision_matrix_filter_max_entries Maximum number of items to show 
for a decision matrix field filter.

• Type: integer

• Default value: 1000

css.assessment.caption.font.color Sets the font color of the caption 
text on assessment and survey 
questionnaires.

• Type: color

• Default value: #ffffff

For more information about customizing the appearance of a survey, see Customize the 
appearance of a survey.
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User roles

Role title [name] Description
Contains 
roles

assessment 
administrator

[assessment_admin]

Can administer the Assessments application. Can access all 
the modules of the Assessments application.

Note: 
The assessment_admin role is contained by the 
itil_admin role. This role is also contained by the 
survey_admin role.

None

Script includes

Name Description

AssessmentUtils Core code for assessment functionality.

AssessmentUtilsAJAX AJAX-based code for displaying scorecard data.

MigrateSurveyToAssessment Code for migrating legacy surveys  to assessment surveys.

RatingUtilsAJAX Reserved for future use.

SurveyUtils Core code for survey functionality.

Client scripts

Name Table Description

Calculate 
Assessable 
Record Field 
choice list

Trigger Condition

[asmt_condition]

Limits the Assessable Record 
Field choices to those choices that 
are compatible with the selected 
assessment.

Check survey 
schedule 
period

Trigger Condition

[asmt_condition]

Checks the selected survey definition's 
Schedule period. If Schedule period 
is set to Only Once, this client script 
displays a warning message that each 
user can only take the selected survey 
once.

Clear 
display_when 
when 
depends 
changed

Assessment Metric

[asmt_metric]

Shows the Display when  field when 
the Depends on  field is set. Clears the 
Display when  field when the Depends 
on  field changes and the options must 
change.

Conditionally 
Set Type for 
Surveys

Group

[sys_user_group]

Sets the user group Type to survey if 
you create a new group from the User 
Groups module.

Data type -- 
Hide choices 
for surveys

Assessment Metric

[asmt_metric]

Ensures only Data type options that are 
valid for surveys are available on the 
Survey Question form.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3782



Name Table Description

Data type 
-- Show/
Hide Not 
Applicable

Assessment Metric

[asmt_metric]

Hides the Allow not applicable  field 
and sets its value to false  if the metric 
method is Assessment and the data 
type is Percentage, Checkbox, Date, 
Date/Time, Number, or String.

Data type 
defaults to 
String for 
surveys

Assessment Metric

[asmt_metric]

Sets the default Data type  field value 
to String  on the Survey Question form.

Fetch Min/
Max

Assessment Metric

[asmt_metric]

Updates the Min  and Max  fields to 
match the least and greatest metric 
template definition values if an 
assessment administrator selects or 
changes the Template value.

Hide 
Assessable 
Record Field

Trigger Condition

[asmt_condition]

Hides the Assessable Record  field 
unless the evaluation method of 
the metric type selected in the 
Assessment  field is Assessment.

Hide Survey 
Instance 
Trigger ID if 
empty

Assessment Instance

[asmt_assessment_instance]

Hides the Trigger ID  field and makes it 
read-only unless it contains a value.

Hide user 
lists

Assessable Record

[asmt_assessable_record]

Hides the Category users  related list 
if the associated metric type schedule 
type is On demand.

Hide user 
related lists

Metric Category

[asmt_metric_category]

Hides the User related list if the 
associated metric schedule type is On 
demand  and the Evaluation method 
isn't Survey.

Hide value or 
String value

Assessment Instance Question

[asmt_assessment_instance_question]

Hides the Value  field and shows the 
String value  field if the associated 
metric data type is Date, Date/Time, 
or String. Does the opposite if the data 
type is anything or else.

Live feed 
deletion 
warning

Assessable Record

[asmt_assessable_record]

Displays a warning message if an 
assessment administrator clears the 
Live feed  check box.

Method 
-- Show/
Hide Not 
applicable

Assessment Metric

[asmt_metric]

Hides the Mandatory  and Allow 
not applicable  fields and sets both 
values to false  if the metric method 
is Script. Shows the Mandatory  field 
if the metric method is Assessment. 
Shows the Allow not applicable  field 
if the method is Assessment, except 
when the data type is Percentage, 
Checkbox, Date, Date/Time, Number, 
or String.
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Name Table Description

Min/Max 
Control

Assessment Metric

[asmt_metric]

Makes the Min  and Max  fields 
mandatory except when the data type 
is Template.

Min/Max 
Read-only

Assessment Metric

[asmt_metric]

Makes the Min  and Max  fields read-
only when the data type is Choice  or 
Likert Scale.

Populate 
Groups

Assessment Metric Type

[asmt_metric_type]

Populates the available values for the 
Filter  field with fields from the selected 
metric type table.

Read only 
Type

Metric Category

[asmt_metric_category]

Makes the Type  field read-only when it 
contains a value.

Reload 
Decision 
Matrix Filter 
Columns

Assessment Metric Type

[asmt_metric_type]

Populates the available choices for the 
Default matrix  filter as appropriate if 
the Filter  field value changes.

Reload 
default filters

Assessment Metric Type

[asmt_metric_type]

Populates the available choices for 
the Default filter  as appropriate if the 
Display all filters  value changes.

Set scale 
factor

Assessment Metric Type

[asmt_metric_type]

Reserved for future use.

Set table 
field

Metric Category

[asmt_metric_category]

Sets the category Table value to that of 
the metric type.

Show 
and Hide 
Scheduled 
Job

Assessment Metric Type

[asmt_metric_type]

Hides the Scheduled job  field if the 
Schedule type is On demand  and 
shows the Scheduled job  field if the 
Schedule type is Scheduled.

Show 
and Hide 
Scheduled 
Job Survey 
View

Assessment Metric Type

[asmt_metric_type]

Shows the Scheduled job  field on the 
Survey Definition form if the Schedule 
period is Daily, Weekly, Monthly, or 
Yearly.

Toggle Metric 
Definitions 
(Load)

Assessment Metric

[asmt_metric]

Displays the Assessment Metric 
Definitions related list if the data type 
is Choice  or Likert Scale.

Toggle Metric 
Definitions 
(Update)

Assessment Metric

[asmt_metric]

Displays the Assessment Metric 
Definitions related list if the data type 
is Choice  or Likert Scale. Sets the 
Method  field to the appropriate value 
if the data type is compatible with one 
method only.

Update Min 
And Max 

Assessment Metric

[asmt_metric]

Sets reasonable default values for the 
Min  and Max  fields, based on the data 
type.
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Name Table Description

Default 
Values

Validate 
Probability

Survey Trigger Condition

[asmt_condition]

Ensures that the Probability (%)  value 
is a whole number between 1  and 100.

Verify Max Assessment Metric

[asmt_metric]

Verifies that the Max  value is greater 
than the Min  value and greater than 
or equal to zero if the metric method is 
Assessment.

Verify Min Assessment Metric

[asmt_metric]

Verifies that the Min  value is less than 
the Max  value and greater than or 
equal to zero if the metric method is 
Assessment.

Verify Value Assessment Metric Definition

[asmt_metric_definition]

Verifies that the Value is greater than or 
equal to zero.

Verify Value Assessment Template Definition

[asmt_template_definition]

Verifies that the Value is greater than or 
equal to zero.

Business rules

Business rules for Assessments

Name Table Description

Assessable domain 
matches type

Assessable Record

[asmt_assessable_record]

Ensures that all new assessable 
records are in the same domain as 
the metric type. This is a special 
requirement of assessment domain 
separation, that all records must be 
in the same domain.

Auto stakeholder 
creation

Assessment Category User

[asmt_m2m_category_user]

Assigns new category users 
as stakeholders automatically 
for assessable records if the 
associated category has the 
Create stakeholders  option 
selected.

Auto stakeholder 
creation

Category Assessable Records

[asmt_m2m_category_assessment]

Creates stakeholders from all 
of a category's category users 
automatically for new assessable 
records if:

• The Create stakeholders 
option is selected for the metric 
category.

• The same metric category 
is associated to the new 
assessable record.
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Business rules for Assessments  (continued)

Name Table Description

Auto stakeholder 
creation

Metric Category

[asmt_metric_category]

Assigns all of a category's category 
users as stakeholders for each 
assessable record associated 
to the category when the Create 
stakeholders  option is selected for 
the category.

Calculate category 
max weight

Assessment Metric

[asmt_metric]

Calculates the sum of all metric 
weights in a category.

Cancel notification 
workflow

Assessment Instance

[asmt_assessment_instance]

Cancels the workflow that 
generates assessment email 
notifications when an assessment 
instance is deleted or changes the 
state to Complete  or Canceled.

Category domain 
matches type

Metric Category

[asmt_metric_category]

Ensures that all new categories are 
in the same domain as the metric 
type. This is a special requirement 
of assessment domain separation, 
that all records must be in the 
same domain.

Check Live Feed 
Groups

Assessable Record

[asmt_assessable_record]

Selects the Live feed  option if a 
live feed group is associated with 
the source record. If the Live feed 
option is selected and no live feed 
group is associated with the source 
record, this business rule clears 
the check box.

Check only one 
default

Bubble Chart

[asmt_bubble_chart]

Ensures that there is only one 
default bubble chart for a metric 
type.

Check only one 
default

Decision Matrix

[asmt_decision_matrix]

Ensures that there is only one 
default decision matrix for a metric 
type.

Create actual results Assessment Instance

[asmt_assessment_instance]

Generates assessment and 
category results from the user 
responses if a user completes an 
assessment.

Create Business 
Rule on Remote 
table

Assessment Metric Type

[asmt_metric_type]

Generates the following 
business rules if an assessment 
administrator creates or updates a 
metric type:

• Business rule called Auto 
business rule for Assessments, 
which monitors the Table 
selected for the metric type. 
When someone adds a record 
that meets the metric type 
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Business rules for Assessments  (continued)

Name Table Description

conditions, this business rule 
generates an assessable record. 
If someone changes the metric 
type's Table or conditions, the 
Create Business Rule on Remote 
table business rule updates the 
automatic business rule script to 
reflect the changes.

• Business rule called Auto 
deletion rule for Assessments, 
which prevents users from 
deleting a record on the metric 
type's Table if the record is 
associated to metric or category 
results. If the record has no 
associated results and a 
user deletes it, this business 
rule deletes any associated 
assessable records.

The Create Business Rule on 
Remote table business rule 
generates automatic business 
rules only for metric types 
with Evaluation method set to 
Assessment.

Create Scheduled 
Job

Assessment Metric Type

[asmt_metric_type]

Assessments: Generates a 
scheduled job for the creation of 
assessment components if either 
of these conditions is met:

• Someone creates a new metric 
type with the schedule type set 
to Scheduled.

• The schedule type changes from 
On demand  to Scheduled.

Surveys: Generates a scheduled 
job for the creation of survey 
components if the schedule period 
for a survey definition is set to 
Daily, Weekly, Monthly, or Yearly.

Create Survey 
Records

Assessment Metric Type

[asmt_metric_type]

Generates various records and 
populates certain fields on those 
records when someone creates a 
new survey definition, which is a 
metric type with Evaluation method 
set to Survey. More specifically, this 
business rule generates a survey 
category and assessable record, 
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Business rules for Assessments  (continued)

Name Table Description

both associated to the survey 
definition.

Create UI Action on 
Remote table

Assessment Metric Type

[asmt_metric_type]

Reserved for future use.

decision_matrix_axis Global

[global]

Limits available categories for X- 
and Y-axes to those that belong 
to the type if there is a metric type 
specified on the Decision Matrix 
form.

Delete Live Feed 
Group

Assessable Record

[asmt_assessable_record]

Deletes the assessable record's 
live feed group, if there is one, 
when an assessment administrator 
deletes an assessable record.

delete related users Category Assessable Records

[asmt_m2m_category_assessment]

Deletes any stakeholders for the 
assessable record and category 
when an assessment administrator 
disassociates a category from an 
assessable record.

Do not allow 
category to change

Assessment Metric

[asmt_metric]

Prevents the Category  field 
from being changed if there 
are any conditional question 
dependencies related to the 
current record.

Do not allow 
datatype to change

Assessment Metric

[asmt_metric]

Prevents the Data type  and 
Template  fields from being 
changed if there are any 
conditional questions that depend 
on the current record.

Ensure Types Match Assessment Metric

[asmt_metric]

Sets the type of a metric to the type 
of the associated category.

Ensure types match Assessment Stakeholders

[asmt_m2m_stakeholder]

Ensures that users can only create 
a stakeholder from a category user 
and assessable record of the same 
type.

Ensure types match Category Assessable Records

[asmt_m2m_category_assessment]

Prevents users from associating 
categories of one type to an 
assessable record of a different 
type.

Evaluate filters Assessable Record

[asmt_assessable_record]

Performs the following after 
the system generates a new 
assessable record:
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Business rules for Assessments  (continued)

Name Table Description

• Checks all filter conditions for 
categories in the type.

• Automatically associates the 
new assessable record to all 
categories for which it meets the 
category filter conditions.

Generate 
assessment trigger 
condition

Trigger Condition

[asmt_condition]

Generates a business rule that 
the survey or assessment trigger 
condition uses to send surveys or 
assessments.

getStakeholders Global

[global]

Ensures that only category users 
for categories associated with the 
assessable record are available 
on the Assessable Record form 
when users edit the Category users 
related list.

Link assessable 
record and category

Metric Category

[asmt_metric_category]

Sets these hidden fields as 
follows for a newly created survey 
category:

• Table: Assessment Metric Type 
[asmt_metric_type]

• Filter: <sys_id of the survey 
definition the new survey 
category is associated with>

Live Feed Group Assessable Record

[asmt_assessable_record]

Creates a live feed group for the 
assessable record, if one doesn't 
exist, when the record is saved with 
the Live feed  option selected. If the 
check box is then cleared and the 
record saved, this business rule 
deletes an existing live feed group.

Metric domain 
matches category

Assessment Metric

[asmt_metric]

Ensures that all new metrics are in 
the same domain as the category 
to which they belong. This rule is a 
special requirement of assessment 
domain separation, that all records 
must be in the same domain.

Notify assessment 
user

Assessment Instance

[asmt_assessment_instance]

Starts a workflow that sends an 
email notification to the assigned 
user when an assessment 
instance changes to the Ready 
state or the user to which it is 
assigned changes. The workflow 
generates other assessment email 
notifications at later stages.
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Business rules for Assessments  (continued)

Name Table Description

Prevent recursive 
dependencies

Assessment Metric

[asmt_metric]

Prevents the Depends on  field 
from being set in a way that creates 
a recursive conditional question 
dependency.

Publish Survey Assessment Metric Type

[asmt_metric_type]

Generates survey instances and 
assigns them to the associated 
survey users when the survey 
definition state changes from Draft 
to Published.

Remove auto create 
Business Rules

Assessment Metric Type

[asmt_metric_type]

Deletes the automatically created 
business rule for a metric type 
when an assessment administrator 
deletes that metric type.

Remove auto create 
UI actions

Assessment Metric Type

[asmt_metric_type]

Reserved for future use.

Remove auto 
created business 
rule

Survey Trigger Condition

[asmt_condition]

Deletes the automatically created 
business rule when someone 
deletes the survey trigger 
condition.

Remove Scheduled 
Job

Assessment Metric Type

[asmt_metric_type]

Assessments: Deletes the 
scheduled job for a metric type if 
either of these conditions is met:

• Someone deletes the metric 
type.

• Someone changes the schedule 
type from Scheduled  to On 
demand.

Surveys: Deletes the scheduled 
job for a survey definition if the 
schedule period is set to Only 
Once or No Limit.

Reset Min/Max for 
metric

Assessment Metric Definition

[asmt_metric_definition]

Updates the Min  and Max  fields 
for metrics and survey questions 
based on the metric definition 
value.

Set Domain for M2M 
Cat Assessable 
Recs

Category Assessable Records

[asmt_m2m_category_assessment]

Ensures that assessable records 
are only associated to categories 
in the same domain. This rule is a 
special requirement of assessment 
domain separation, that all records 
must be in the same domain.

Set Domain for M2M 
Category Users

Assessment Category User

[asmt_m2m_category_user]

Ensures that users are only linked 
to categories in the same domain. 
This is a special requirement of 
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Business rules for Assessments  (continued)

Name Table Description

assessment domain separation, 
that all records must be in the 
same domain.

Set Domain for M2M 
Stakeholders

Assessment Stakeholders

[asmt_m2m_stakeholder]

Ensures that assessable records 
are only linked to category users in 
the same domain. This is a special 
requirement of assessment domain 
separation, that all records must be 
in the same domain.

Set scratchpad 
fields

Assessment Metric Type

[asmt_metric_type]

Caches field values for use by 
other scripts that run on the 
Assessment Metric Type form.

Store view type Metric Category

[asmt_metric_category]

Ensures that the Type  field only 
allows users to select metric types 
used for assessments.

Synchronize 
category survey 
users

Assessment Category User

[asmt_m2m_category_user]

Ensures that the same users are 
associated with all of a survey's 
categories.

Synchronize 
survey users and 
stakeholder.

Metric Category

[asmt_metric_category]

Adds all users associated with a 
survey's existing categories to any 
newly created category for that 
survey.

Update Category 
Count

Assessment Metric

[asmt_metric]

Updates the value in the Total 
metrics  field on the Metric 
Category form when metrics are 
added to and deleted from the 
category.

Update records that 
match filter

Metric Category

[asmt_metric_category]

Automatically performs these tasks 
when an assessment administrator 
edits the Filter  field:

• Associates the category to 
assessable records that meet the 
filter conditions.

• Disassociates the category from 
assessable records that don't 
meet the filter conditions.

The Assessable records related list 
reflects these changes when the 
record is saved.

Update scheduled 
job on schedule 
change

Assessment Metric Type

[asmt_metric_type]

Updates the survey creation 
scheduled job to reflect schedule 
period changes.

Validate mandatory 
and not applicable

Assessment Metric Sets the Mandatory  and Allow 
not applicable  fields to false  if 
the metric method is Script. If the 
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Business rules for Assessments  (continued)

Name Table Description

[asmt_metric]
metric data type is Percentage, the 
business rule sets the Allow not 
applicable  field to false.

Verify min/max Assessment Metric

[asmt_metric]

Ensures that the Min is greater than 
or equal to zero and less than the 
Max. Sets the Min to 0 and the Max 
to 1 if the data type is Checkbox  or 
Yes/No.

Verify value Assessment Template Definition

[asmt_template_definition]

Ensures that the metric template 
definition Value is:

• Greater than or equal to zero.

• Different from the Value for all 
other metric template definitions 
related to the template.

Verify value Assessment Metric Definition

[asmt_metric_definition]

Ensures that users can only enter a 
metric definition Value greater than 
or equal to zero. Ensures that the 
metric definition value is different 
from the Value for all other metric 
definitions related to the metric.

Quick start tests for Assessments and Surveys

Validate that Assessments and Surveys  still works after you make any configuration change such 
as apply an upgrade or develop an application. Copy and customize these quick start tests to 
pass when using your instance-specific data.

Assessments and Surveys  quick start tests require activating the Automated Test Framework for 
Survey plugin (com.glide.automated_testing_impl. Survey).

Note: 
In the Washington DC  release, all the buttons on the assessments or surveys cards have 
been removed. To run the Automated Test Framework  tests successfully, the Click the Take 
Survey button  step must be replaced with Click the Survey card  for all tests that have this 
step.

Test Suite for Survey

Name Description Release version

Survey: Basic Platform Based 
Test

Create a survey using Platform 
UI actions.

Madrid

Survey: Platform test for 
Dynamic Validation

Validate a survey dynamically. Madrid

Survey: Clone Action Clone a survey and validate 
the records of the original 
survey and the cloned survey.

New York
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Test Suite for Survey  (continued)

Name Description Release version

Survey: Question Bank Flow Verify the addition of a 
question bank to a survey.

New York

Survey: Survey Creator Work 
Flow

Survey creator can create a 
survey and assign to the user 
who can take the survey and 
submit it.

New York

Assessment: Assign 
assessment to assessor

Assign an assessment to an 
assessor and verify that the 
instance is created for the 
assessor.

Orlando

Assessment: Create 
assessment as survey creator

Create an assignment as a 
survey creator.

Orlando

Assessment: Scale and 
Template support

Create, publish, and assign 
the assessment. Then take the 
assessment.

Rome

Assessment: Basic test flow Verify the basic flow of an 
assessment.

Orlando

Related topics

Quick start tests

Quizzes

Quizzes are questionnaires that you can assign to one or more users to assess their knowledge 
of any subject. The quiz functionality is built on the assessment engine and provides many of the 
same features as assessments and surveys.

Each question is scored, and the overall score indicates the percentage of questions the user 
answered correctly. A quiz may have categories of questions that are assigned only to some 
users. You can assign weighting values to individual questions or categories of questions that 
make them more or less important when calculating the overall score. Quizzes require activation 
by a system administrator.

The difference between assessments, surveys, and quizzes, and when to use each; also 
provides a quick look at the three stages in the survey process: designing, sharing, and 
evaluating.

• An administrator can create a quiz for any purpose and assign it to a single user or multiple 
users.

• A quiz can contain one or more categories of questions. Each category can be assigned to 
users who answer only the questions in that category.

• The system can send email notifications to these users:

◦ Recipients: The recipient can receive notification of an assigned quiz, a quiz whose allowed 
duration is at 50%, and a quiz that is overdue.

◦ Recipient's manager: The recipient's manager can receive notification when a quiz is 
overdue.

◦ Quiz manager: The quiz manager can receive notification of an overdue quiz that is assigned 
to them.
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• Quizzes can contain questions that are scored or not scored. Unscored questions assess 
opinions or involve dates and are not counted in the final score. Scored questions specify 
correct answers and are scored either as 0% or 100%. You can apply a weighting scale to 
scored questions to establish their relative importance. You can designate questions with 
these data types as scored questions:

◦ Checkbox

◦ Choice

◦ Duration

◦ Likert Scale

◦ Numeric Scale

◦ Template

◦ Yes/No

• A quiz question can be dependent on the response to any scored question. For example, 
you can create a dependent question requesting additional information that appears only if a 
recipient answers No  to a specific question.

Important terms

The quiz application involves several terms.

Terms used in quiz application

Quizzes A quiz contains information such as duration, state, and notification controls and 
lists the existing categories. Text fields on the quiz form allow an administrator to 
create introductory content and end notes that are displayed to the recipient.

Categories A quiz category represents a theme for quiz questions. Each category contains 
one or more questions and names the recipients for the questions in that category. 
By default, the system creates one category with the same name as the quiz. You 
can create additional categories as needed. Categories can be weighted higher or 
lower to determine the importance of that category in the overall score.

Questions A quiz question is a question configured for a category and sent only to the 
users for that category. Questions have a wide variety of data types and can be 
individually weighted higher or lower. Questions may be scored or unscored.

Category 
user

A category user is the recipient of questions for a specific category. You can select 
different users to answer the questions for each category.

Templates A template is a question data type that provides reusable rating scales for answers 
to questions. For example, the answer template named Satisfaction contains a 
satisfaction scale ranging from Very Satisfied to Very Dissatisfied.

Quiz roles

The Quizzes application uses these roles. No role is required to take quizzes that are assigned to 
you.
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Quiz roles

Role Title [Name] Role Description

assessment 
administrator 
[assessment_admin]

Can administer the Assessments application and all quiz records. Can 
access all the modules of the Assessments application.

Note: 
The itil_admin role and the survey_admin role contain the 
assessment_admin role

Administrator 
[admin]

Can access all aspects of the assessment and survey processes. Only 
administrators can modify survey notifications, create survey modules, 
and import surveys.

Related topics

Assessment metrics

Using Quizzes

You can use quizzes.

Set up and administer quizzes

Set up and administer quizzes.

Before you begin
Role required: assessment_admin or admin

The difference between assessments, surveys, and quizzes, and when to use each; also 
provides a quick look at the three stages in the survey process: designing, sharing, and 
evaluating.

Procedure

1. Optional:  Create reusable question templates for quizzes.

2. Create the quiz using the Quiz Designer or with forms accessed from the navigation menu.

The quiz record includes specifics such as duration, notification preferences, a questionnaire 
introduction, and ending notes displayed to recipients.

3. Edit the default category or create additional categories as needed.
The system creates a category with the same name as the quiz.

4. Define users for each category.

These are the recipients who answer the questions in a category. You can define different 
users for each category.

5. Create the questions for each category.

6. Create the answers for each question and determine if the questions are scored.

You can create unique answers or select preconfigured answers from a template.

What to do next
Publish and distribute the quiz. You can send the quiz to a single user or all users in each 
category.
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Review the results from the submitted quizzes in reports and scorecards.

Related topics

Create a quiz

Metric templates

Data types for quizzes

You need to choose a data type for each quiz question. Various data types helps you collect and 
analyze different kinds of data.

Available data types

Data type Description

Attachment Question with a Manage Attachments icon that allows users to attach one or more 
files.

Boolean Question with a check box or a Yes/No  list for user responses.

Choice List of predefined options. For more information, see the definition for Choices  in 
the Create quiz questions  topic. Multiple correct answers are supported.

Date Date field.

Date/Time Time and date field.

Number Number field with predefined minimum and maximum values. The default is 1-10.

Percentage Percentage field with a prescribed range.

Scale Predefined Likert scale. Answer options appear as radio buttons. Multiple correct 
answers are supported.

Image 
Scale

Predefined set of images. Five emojis similar to the Likert scale (very dissatisfied 
to very satisfied) are provided. However, you can upload additional images in JPG, 
PNG, or GIF format. Multiple correct answers are supported.

Numeric 
scale

Selectable number scale. The default is 1-5. Answer options appear as radio 
buttons. Multiple correct answers are supported.

String Single or multi-line text field.

Template Choice list of templates that provide a predefined scale of options. For details, 
see Configure a template question. Multiple correct answers are supported.

Reference Choice list of fields from a specified reference table. This data type does not 
support reference qualifiers.

Related topics

Create quizzes with forms

Create a quiz

Change the order of an answer

Activate the quiz designer

Administrators can activate the Quiz Designer plugin.

Before you begin
Role required: assessment_admin or admin
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Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.

Note: 
When domain separation and delegated admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .

View quiz reports

Use the Quiz Overview dashboard to view various reports on data such as Quizzes by State, 
Questions by Data Type, and Number of Correct Answers.

Before you begin
Role required: assessment_admin or admin

About this task
You can view the Quiz Overview dashboard to refresh the view and add new widgets.

Procedure

1. Navigate to All  > Quizzes  > Overview.

2. Click the elements within the reports to view more information.

The Quiz Overview dashboard displays the following reports.

Quiz Overview dashboard reports

Report Table

Quizzes by State Assessment Instances [asmt_assessment_instance]

Total Questions by Quiz Assessment Metrics [asmt_metric]

Questions by Data Type Assessment Metrics [asmt_metric]

Correct Answers by Assigned User Metric Results [asmt_metric_result]

Number of Correct Answers Metric Results [asmt_metric_result]

Incorrect Answers by Assigned User Metric Results [asmt_metric_result]

Number of Incorrect Answers Metric Results [asmt_metric_result]

For more information about working with dashboards, see Dashboards .

Quiz designer

The quiz designer provides a single interface that users with the assessment_admin role can use 
to create, edit, and distribute quizzes.
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You can also use it to edit existing quizzes and change scoring parameters.

Alternatively, you can use the modules of the assessment engine  to create and edit the records 
that make up a quiz. All quiz records are stored in assessment tables and displayed in Quiz views 
of those tables. For details, see Create quizzes with forms.

Tools on the Quiz Designer

The quiz designer includes a design canvas, a header bar, and many controls that you can use to 
create quizzes.

To open the quiz designer, navigate to Quizzes  > Quiz Designer.

The designer contains the following elements:

• Controls tab

• Questions tab

• Categories tab

• Header bar

• Design canvas

Controls tab

Controls for the supported question data types are available in the Controls palette. Drag and 
drop a control onto the designer canvas to create a question of that type.
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Question controls

Question controls

Data type Description Scored

Attachment Question with a Manage Attachments icon that allows users to attach one 
or more files.

Y

Boolean Question with a check box or a Yes/No  list for user responses.

Choice List of predefined options. For more information, see the definition for 
Choices  Create quiz questions. Multiple correct answers are supported.

Y

Date Date field. N

Date/Time Date and time field. N

Number Number field with predefined minimum and maximum values. The default 
is 1-10.

N

Percentage Percentage field with a prescribed range. N

Scale Predefined Likert scale. Answer options appear as radio buttons. Multiple 
correct answers are supported.

Y

Numeric 
Scale

Selectable number scale. The default is 1-5. Answer options appear as 
radio buttons. Multiple correct answers are supported.

Y

Image 
Scale

Predefined set of images. Five emojis similar to the Likert scale (very 
dissatisfied to very satisfied) are provided. However, you can upload 

Y
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Question controls  (continued)

Data type Description Scored

additional images in JPG, PNG, or GIF format. Multiple correct answers are 
supported.

String Single or multiline text field. N

Template Choice list of templates that provide a predefined scale of options. For 
details, see Configure a template question. Multiple correct answers are 
supported.

Y

Reference Choice list of fields from a specified reference table. This data type does 
not support reference qualifiers.

Questions tab

This tab displays all metrics added to the question bank for quizzes. Use the Filter  field to search 
for questions. Each metric is displayed with its name and type.

Categories tab

This tab displays all metric categories added to the question bank for quizzes. All metrics in the 
question bank are group under the corresponding metric category. Use the Filter  field to search 
for categories or questions.

Header Bar

The header bar contains tabs that display different views and a menu of various functions.

Click one of the following tabs to change the view in the canvas:

• Design: Add categories and questions, and configure the properties of each. This is the default 
view of the canvas when you open the designer.

• Configuration: Create introductions and end notes for quizzes, and select a signature.

• Availability: Select the recipients for each category in the quiz.

Point to the menu icon ( ) in the in the upper right of the quiz designer to select the following 
options:

• Save: Saves the current quiz.

• Preview: Displays a preview of the quiz as it appears to the recipients.

• Publish: Distributes the quiz to the selected recipients.

• Save and Publish: Saves and distributes the quiz in one step.

• New Quiz: Opens a fresh canvas for a new quiz.

• Load Quiz: Opens a list of existing quizzes that you can select and edit.

• Copy Quiz: Creates a copy of the quiz.

The availability of each option depends on the status of the quiz that is opened in the quiz 
designer.
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Design Canvas

New quizzes open in the Design  view. The quiz Name  field appears above first category in the 
canvas. A blank question field appears in the category container.

Related topics

View an assessment category result

View a quiz scorecard

Create a quiz

Edit a quiz

Create a quiz

When you create a quiz, you can create one or more categories and then add questions to each 
category.

Before you begin
Role required: assessment_admin or admin

About this task
Each category can be assigned to a different user or the same users. You can also customize 
each question and make it dependent on the response to another question.

Procedure

Create a quiz using these procedures.

Create quiz categories

Create quiz categories, which represent a theme for evaluating a specific element of the quiz 
topic and contain questions pertaining to that theme.

Before you begin
Role required: assessment_admin or admin

About this task
When you create a quiz, the system creates a default category using the name of the quiz. You 
can use this category, modify it, or create additional categories as needed. To have any results, a 
category must contain scored questions.

Procedure

1. Navigate either Quizzes  > Quiz Designer  or Quizzes  > Quizzes  and click Quiz Designer  in the 
list header.

2. Enter the name of the quiz in the Name  field.
The system uses this name as the name of the quiz and the first category.

3. Configure the category.

a. Click the gear icon in its title bar.

b. In the Properties  dialog box, set or modify the properties.
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You can change the name of the category, add a description for it, and enter text in the 
Details  field that introduces or explains the category to the recipients. The system updates 
the category as you type.

c. Click the X icon to close the category properties dialog box and save your settings.

4. Optional:  Add a new category by clicking the +  icon in the title bar of an existing category.

Related topics

Quiz designer

Create a quiz

Create quiz questions

Create multiple questions for each category. Each question can be associated with only one 
category.

Before you begin
Role required: assessment_admin or admin

About this task
The data type  that you select for each question determines how it can be answered by quiz 
recipients.

You can designate questions to be scored. Only scored questions are shown in the quiz results 
and considered when calculating the category results. You must also specify a correct answer for 
scored questions.

Note: 

To designate a question as scored, you must use Assessment forms. For instructions, see 
Configure a scored question.
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Procedure

1. In the Design view, drag a data type icon from the Controls palette and drop it into a category 
container.

2. Configure the question.

Note: 
To add a question with the same data type as an existing question in the category, click 
the +  in the title bar of the existing question.

a. Click in the gear icon in its title bar.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3803



b. On the Properties form, fill in the fields.
For a description of the field values, see Question Properties form.

c. Create any special conditions that must be met for a question to appear on the quiz by 
clicking the Dependency  tab and filling in the fields.

Dependent questions appear on the quiz when a recipient selects a specific answer or 
combination of answers to another question in the same category.

d. Select a question in the Displayed when field.
The system selects the appropriate operator and displays the possible answers for the 
selected question.

e. Select the answers that satisfy the condition.

Selected answers are indicated by a check mark.

f. Click X  to close the question properties dialog box and save your settings.

3. Optional:  Drag questions to change their order within a category or move them between 
categories.

4. Optional:  Delete a question by clicking the X in its title bar.

Configure a template question

You can configure template questions when designing quizzes.

Before you begin
Role required: assessment_admin or admin

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3804



Procedure

1. Drag the Template  data type icon into a category container.

2. Click the gear icon in the question title bar to open the template properties dialog box.

3. Select a predefined scale from the list.

Question entry fields appear for that template.

4. Enter one or more questions that are appropriate for the template.

5. Click the arrow to the right of a question to configure its properties.

You must provide a name for each question.
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6. Click the up or down arrow to move between questions, or click the back arrow to return to the 
template properties dialog box.

7. Configure the properties for the remaining questions.

8. Click the X  icon to close the template properties dialog box and save your settings.

Related topics

Quiz designer

Create a quiz

Configure a scored question

Only scored  questions are considered when calculating category and quiz results.

Before you begin
Role required: assessment_admin or admin

About this task
A question must have a correct answer specified to be scored. Only results for scored questions 
are displayed in the quiz scorecard.

Procedure

1. Navigate to All  > Quizzes  > Quizzes.

2. Open the quiz containing the questions you want to mark as scored.

3. In the Metric Categories  related list on the Assessment Metric Type  form, select the category 
for the questions you want to mark as scored.

4. In the Assessment Metrics  related list on the Metric Category  form, select a question from 
the list.

5. In the Question Type  section of the Assessment Metric  form, select the Scored  check box.

This check box is not available if the question's data type is not supported for scoring.

6. Select the Correct answer  for the question.
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Note: 
Multiple correct answers are supported for a few data types. See Data types for quizzes.

7. Click Update.

8. Repeat the process for all the questions in the category that you want the system to score.

9. Return to the list of metric categories, select another category, and configure scoring for the 
appropriate questions in that category.

Configure a quiz

You can configure an entire quiz.

Before you begin
Role required: assessment_admin, survey_creator, or admin

About this task
The values you enter and select on this page are applied to the entire quiz.

Procedure

In the quiz designer, click Configuration  and then fill in the fields as described in the table.

Quiz designer configuration

Field Description

Active Check box for enabling the distribution of this quiz to recipients.

Description Description of this configuration or the quiz to which it is attached.

Introduction Introductory content to display on quizzes. You can add a welcome message or 
background information about the quiz.

Owners Owners of the quiz. You can add a user with the survey_creator, survey_admin, or 
assessment_admin role.

Signature [Optional] Acknowledgement by a quiz recipient of requirements, admonitions, 
or expectations related to a quiz.

Return URL Destination address of a web page that is presented to users after they submit a 
completed quiz. When a return URL is configured, the End note  content does not 
appear.

End note Content that is displayed to recipients after they submit a completed quiz. 
You can add a thank you message, follow-up instructions, or other applicable 
information. End notes are not displayed if a Return URL  is specified.

Duration Amount of time that recipients are given to complete this quiz, starting from the 
time that the quiz is generated. The default duration is 14 days.

Manager Assessment manager for this quiz. These users are only responsible for 
managing the quiz process and not the results. The system notifies the manager 
when submissions for this quiz are past due.

Notify 
manager if 
overdue

Check box for sending email notifications  to a recipient's manager when that 
user fails to submit an assigned quiz before the due date.

Related Links
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Field Description

Show 
Benchmarks

Opens the Benchmarks Dashboard that provides visibility into your key 
performance indicators (KPIs) and trends.

Note: 

• This related link is available only for survey_admin, assessment_admin 
and survey_reader with bm_viewer role.

• You must opt in to Benchmarks to view the dashboard. See Enable 
Benchmarks

• This is applicable only for a published quiz.

Select a quiz recipient

When the system distributes a quiz, it sends email notifications to the category users and their 
managers.

Before you begin
Role required: assessment_admin or admin

About this task
A category can have one or more assigned users, and the same user can be assigned to more 
than one category.

The system also creates a link to the quiz in the recipients' My Assessments & Surveys  portal. 
Users can only answer questions in the categories that they are assigned to.

Procedure

To select the recipients for each quiz category, click Availability  and then fill in the fields as 
described in the table.

Select recipients

Field Description

Select 
category

Category for which the selected users are recipients.

Add users Users selected as recipients for this category. The choice list shows all users in 
the system.

Related topics

Quiz designer

Publish a quiz

When you publish a quiz, the system sends email notifications to the recipients and to their 
managers. A card in each recipient's My Assessments & Surveys  portal displays a link to the 
quiz.

Before you begin
Role required: assessment_admin or admin
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Procedure

1. If you want to see the quiz as the recipients will see it, point to the menu icon in the upper right 
of the quiz designer and click Preview.

2. When you are satisfied with the quiz, click Save and Publish  or Publish  to distribute it.

Related topics

Quiz designer

Copy a quiz

Create a copy of a quiz with at least one category to reduce the effort of creating another quiz 
with similar data.

Before you begin
Role required: assessment_admin or admin

About this task
All associated questions (type), configurations, categories, metrics, domain separation rules, 
and role-based categories are copied. Assigned users, category users, instances, and trigger 
conditions are not copied.

Procedure

1. Navigate to All  > Quizzes  > Quizzes.

2. Select a quiz.

3. Perform any of the following steps.

Edit a quiz

You can update a quiz after the quiz has been distributed.

Before you begin
Role required: assessment_admin or admin

About this task
You can only edit a quiz that has the same application scope as that of your current session.

• Questions that you add are available only on quizzes that are distributed after the update.

• Before a quiz is submitted or during the retake period:

◦ Changes to existing questions are immediately available to users. This includes changes to 
the answers, such as additional choices or changes to the data type.

◦ Deleted questions are deleted from distributed quizzes in users' queues.

Procedure

Open the quiz: Group the Service Details form with one of the following options.

Related topics

Quiz designer

Configure a scored question

Only scored  questions are considered when calculating category and quiz results.
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Before you begin
Role required: assessment_admin or admin

About this task
A question must have a correct answer specified to be scored. Only results for scored questions 
are displayed in the quiz scorecard.

Procedure

1. Navigate to All  > Quizzes  > Quizzes.

2. Open the quiz containing the questions you want to mark as scored.

3. In the Metric Categories  related list on the Assessment Metric Type  form, select the category 
for the questions you want to mark as scored.

4. In the Assessment Metrics  related list on the Metric Category  form, select a question from 
the list.

5. In the Question Type  section of the Assessment Metric  form, select the Scored  check box.

This check box is not available if the question's data type is not supported for scoring.

6. Select the Correct answer  for the question.

Note: 
Multiple correct answers are supported for a few data types. See Data types for quizzes.

7. Click Update.

8. Repeat the process for all the questions in the category that you want the system to score.

9. Return to the list of metric categories, select another category, and configure scoring for the 
appropriate questions in that category.

Configure a template question

You can configure template questions when designing quizzes.

Before you begin
Role required: assessment_admin or admin

Procedure

1. Drag the Template  data type icon into a category container.

2. Click the gear icon in the question title bar to open the template properties dialog box.

3. Select a predefined scale from the list.
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Question entry fields appear for that template.

4. Enter one or more questions that are appropriate for the template.

5. Click the arrow to the right of a question to configure its properties.

You must provide a name for each question.
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6. Click the up or down arrow to move between questions, or click the back arrow to return to the 
template properties dialog box.

7. Configure the properties for the remaining questions.

8. Click the X  icon to close the template properties dialog box and save your settings.

Related topics

Quiz designer

Create a quiz

Enable a quiz retake

You can configure a quiz to allow recipients to resubmit their answers as many times as they like, 
until the quiz's due date.

Before you begin
Role required: assessment_admin or admin

About this task
Results are not calculated until the quiz's configured duration has elapsed. The card in the user's 
queue remains visible until the quiz's due date and displays a button to allow retakes.

Procedure

1. Navigate to All  > Assessments  > Metric Definition  > Types.

2. Remove the Evaluation method = Assessment  filter condition so you can see all the records in 
the list.

3. Open the quiz.

4. In the Assessment Metric Type  form, select the Allow retake  check box and save the record.

Related topics

Quiz designer

Publish a quiz
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View a quiz result

You can view quiz results for each question and category, or view the quiz scorecard for a 
detailed breakdown.

Before you begin
Role required: assessment_admin or admin

About this task
Quiz results are stored in the Metric Result [asmt_metric_result] table and display recipients' 
answers to each question in a category.

Procedure

Navigate to All  > Quizzes  > Quiz Results.

Related topics

Quiz designer

Publish a quiz

View a quiz designer scorecard

The quiz scorecard opens in the Category Results view.

Before you begin
Role required: none

About this task
For detailed information about scorecards, see Quiz Scorecards.

Procedure

1. Navigate to All  > Quizzes  > Quizzes.

2. Open the quiz whose results you want to view.

3. Under Related Links, select View Scorecard.

The scorecard for the selected quiz opens in the Category Results view.
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4. Select a category to view from the choice list above the chart.

Related topics

Quiz designer

View a quiz scorecard

View scorecards for a quiz record.

Before you begin
Role required: assessment_admin or admin

About this task
For detailed information about scorecards, see Quiz scorecards.

Procedure

1. Navigate to All  > Quizzes  > Quizzes.

2. Open a quiz record.

3. Select the View Scorecard  related link.

Note: 
The scorecard link is hidden if there are no quiz results to report.
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The scorecard contains a header that displays the name of the quiz and a section that displays 
results or a comparison of ratings.

4. Determine the information you want to view.
The available views are:

◦ Category Results

◦ Question Results

◦ Average Ratings

◦ History

View an assessment category result

Category results contain values that represent an evaluated record's performance in a specific 
metric category. Each category result record stores data from one assessment group. Category 
result values are calculated based on category and metric weights and from metric result values 
for the same category.

Before you begin
Role required: assessment_admin or admin

About this task
Note: 
The system does not include metric results from certain responses in category result 
calculations. To compensate, the system adjusts the weight of the other normalized metric 
result values within the same category.

Procedure

1. Navigate to All  > Assessments  > Results  > Category Results.

2. Click the reference icon ( ) next to an assessment group number to open the category result 
record.

3. View the Assessment Category Result form.
All fields on the form are read-only.
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Assessment Category Result form

Field Description

Category Name of the metric category that the category result values apply to.

Rating Rating is used on scorecards and decision matrixes. Rating is updated 
dynamically as users complete assessments. Rating is calculated as:

(Sum of all normalized values that share a 
 particular assessment group, category, and 
 assessable record) / (Number of assessment 
 instances for the assessment group)

For example: In the Assessment Category Results table example, the 
assessment group ASG0000801  with category Politeness  from group NY DB 
(the assessable record) has a Rating  value 8.86.

On the associated Metric Results table, you can see that there are 4 
instances of this group: AINST0000801, AINST0000802, AINST0000803, 
andAINST0000804.

The system calculated the rating using

(5.14+5.14+1.43+5.71+5.14+4.29+4.29+4.29) / 4 = 8.86

Assessment 
group

Assessment group to which the category result is associated. The category 
result Rating  and Normalized value  are calculated from metric results in this 
assessment group only.

Normalized 
value Calculated value that measures the Rating  relative to the weights of categories 

used to assess the record evaluated.

The normalized value is calculated as follows:

Normalized value = Rating x (Associated category weight / Sum of weights of 
all categories the source record has category results for in this assessment 
group)

Example: A source record has four associated category results in assessment 
group ASG0000907, one for each of these categories:

◦ Importance Rating (weight = 10)

◦ Product Reliability (weight = 9)

◦ Company Alignment (weight = 9)

◦ Compliance Score (weight = 9)
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Field Description

If this source record's category result for Product Reliability has a Rating of 7.81, 
the normalized value calculation is:

7.81 x [9 / (10+9+9+9)] = 1.9

Weight Weight of the associated category. You may need to configure the form to see 
this field.

Source Record evaluated as the assessment subject. You may need to configure the 
form to see this field.

Related topics

Assessment results

Configuring the form layout

View a metric result

Quiz scorecards

The Quizzes application prepares printable scorecards.

A scorecard analyzes category and question responses and compares current ratings with 
previous ratings. You can examine ratings over time, compare question ratings, or compare the 
ratings of all categories. All ratings are averages for the time range selected.

The system dynamically updates a scorecard each time you view it, so the ratings reflect recently 
completed quizzes.

Category results

The Category Results view is a stacked bar chart of responses to all questions in a category.

Select the category to display from the choice list above the chart. Category results are only 
calculated for scored questions

This view displays responses that use the following data types:

• Checkbox

• Choice

• Likert Scale

• Number

• Template

• Yes/No

Note: 
The Checkbox  and Yes/No  data types are combined into the Boolean  data type in the Quiz 
designer.
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Quiz category results

To view details about a specific response to a question, point to the colored segment 
representing a specific response. The chart displays the count for those responses and the 
percentage it represents of the total responses to that question.

Quiz category result details

Question results

The Question Results view shows the results for all questions in a quiz.

Select a question by name from the choice list to display the results in a pie chart or a bar chart, 
based on the data type.

Pie chart

The pie chart shows question results for these data types:

• Checkbox

• Choice
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• Likert Scale

• Number

• Template

• Yes/No

Note: 
The Checkbox  and Yes/No  data types are combined into the Boolean  data type in the Quiz 
designer

Quiz scorecard question results - pie chart

Bar chart

A bar chart appears when question results use this data type:

Percentage

By default, all results for percentage questions use a report range of 20% segments. To configure 
a report range, navigate to Reports  > Administration  > Report Ranges.

Average ratings

The Average Ratings view displays a bar chart of the weighted average rating for each question 
in a category.
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Use this view to learn how individual questions affect the overall rating for the category. Select 
a category from the second choice list above the chart. Ratings are only calculated for scored 
questions

Average Ratings view

To view the effect of each question's ratings on the entire category's ratings, point to the colored 
bar. The pop-up box shows the percentage of the total ratings represented by each individual 
question's weighted average.

Quiz scorecard rating detail

Scorecard history

The History view compares the current ratings for the categories and their questions with ratings 
from the previous three years or four quarters..

Ratings that have declined are highlighted in red and display negative numbers. Ratings that 
have improved are highlighted in green with positive numbers. Arrow icons beside the values in 
the Diff  column indicate the trend of the current ratings against the previous ratings. Ratings are 
only calculated for scored questions  questions.

Point to a category to display a line chart that shows the rating trend for that category. Click a 
category to view the Metric Category form containing the questions.
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Scorecard trend chart

3 Years: To calculate the current ratings, the system averages the ratings from the trailing twelve 
month (TTM) period. The Diff  column shows the discrepancy between the current ratings and 
the previous calendar year's ratings.

Scorecard history - 3 years

4 Quarters: Quarterly quizzes compare the average rating for each question and category in 
the current quarter against the average ratings from the previous four quarters. The Diff  column 
shows the discrepancy between the current ratings and the previous quarter's ratings. The 
column labels count backward, by quarter from the current quarter. For example, if the current 
quarter is the 3rd quarter of 2013, then the previous quarters appear as 2nd [2013], 1st [2013], 4th 
[2012], and 3rd [2012]. All four of the previous quarters appear, whether or not there was any data 
for those quarters.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3821



Scorecard history - 4 quarters

Modify the weight of a category

View category results stored in the Assessment Category Result [asmt_category_result] table, 
which display the overall ratings for each category based on the weighted value for each scored 
question, and edit the default Weight value.

Before you begin
Role required: none

Procedure

1. Navigate to Quizzes  > Category Results.

The system calculates results from the weight configured for each category. Weights are set to 
a value of 10 by default but can be changed.

2. Navigate toQuizzes  > Categories, and select a category from the list.

3. In the Metric Category form, edit the default value in the Weight  field.

4. Click Update.

Note: 
You can also edit the weight of a question in the Quiz view of the Assessment Metric 
form.

Related topics

Quiz designer
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Take a quiz

All available quizzes assigned to you appear in your personal assessment and survey queue. 
When you submit a quiz, the system stores your responses. If a quiz allows retakes, you can 
resubmit it as many times as you like until its due date.

Before you begin
Role required: none

About this task
No special role is required to complete a quiz, but you must be logged in and the quiz must be 
assigned to you.

If configured to send email, the system sends you a notification when a quiz is assigned to you. 
The message contains a link to the quiz and instructions for viewing the assessment and survey 
queue.

Each quiz assigned to you appears in your assessment and survey queue as a card that contains 
information about the quiz, including a launch button. Overdue quizzes are marked with a red 
icon and red due date.

You must answer every required question, indicated by a red star, before you can submit the quiz. 
If you start to take a quiz but cannot complete it, save your responses and return to it later. When 
you have answered all the questions and are satisfied with the responses, submit the quiz.

By default, you cannot modify your answers to a quiz after submission. However, if the 
administrator has configured this quiz to allow retakes, the quiz remains in your queue after you 
finish it and the card shows a Modify Quiz button. You can retake the quiz as many times as you 
like before the due date.

Procedure

1. Navigate to All  > Self-Service  > My Assessments & Surveys.

2. Click Take Quiz  on a quiz card to open the questionnaire.
If there is more than one quiz category, you can click the collapse or expand icon to hide or 
show the questions in the category.

3. Answer each question to the best of your ability.
If you are unsure of how to respond to a question or if a question does not apply to you, select 
Not Applicable if that choice is available.

4. Click Save  at any time to save your responses without submitting them.
You can reopen the quiz from your queue when you are ready to work on it again.

5. When you are ready to submit the completed quiz, read any assertions that require your 
attention.

6. If present, select the check box to acknowledge the assertion.

Note: 
If your full name is displayed, you are required to provide authentication to acknowledge 
the assertion after you submit the quiz.

7. Click Submit.

8. If prompted, enter your user name and password to verify your signature.
If you provided valid answers for all mandatory questions, a success message appears, 
displaying any end note that was configured. If the quiz allows retakes, the card remains in 
your queue with a Modify Quiz  button after submission. If retakes are not permitted, the card 
disappears from your queue.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3823



9. If the system displays an error message indicating that a question has an invalid response or 
must still be answered, correct the error and resubmit the quiz.

10. Optional:  Edit your answers and resubmit a quiz that permits retakes by clicking Modify Quiz.
You can modify your responses to the quiz until its due date.

View a quiz instance

View an instance to verify that quiz instances were created, to check the state of a quiz instance, 
or to reassign a quiz instance. A quiz instance represents one questionnaire assigned to one 
user.

Before you begin
Role required: admin or assessment_admin

Procedure

1. Navigate to All  > Quizzes  > Quiz Instances.
The following submodules are available based on the state of the instances:

◦ Ready to take: Displays quiz instances that the user can take. By default, these instances are 
sorted in ascending order by the Number  field.

◦ In progress: Displays quiz instances that are in progress. By default, these instances are 
sorted in ascending order by the Number  field.

◦ Completed: Displays quiz instances that are complete. By default, these instances are 
sorted in descending order by the Taken on  field.

◦ Cancelled: Displays quiz instances that are canceled. By default, these instances are sorted 
in ascending order by the Number  field.

◦ All: Displays quiz instances in all states. By default, these instances are sorted in ascending 
order by the Number  field.

2. From the required submodule, click a quiz instance.

By default, the fields listed in the following table are displayed for all submodules other than 
the Completed  submodule.

Note: 
When you select an instance in the Completed  submodule, you are redirected to the 
User's Response page.

3. In the form, fill the fields.

Quiz instance form

Field Description

Number Automatically generated record number.

Metric type Metric type of this quiz.

Due Date Date by which the quiz instance should be completed. The system populates 
the due date based on the Assessment duration  of the associated quiz 
definition, which is set to 14 days by default.

The quiz due date is not enforced in the base system. If you want to enforce 
the due date, consider using a workflow or other mechanism to send survey 
recipients reminders when a survey is overdue.
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Field Description

State State of the quiz.

Assigned to User that the quiz instance is assigned to. This field becomes read-only when 
the state is In progress, Complete, or Canceled.

Domain Domain associated with the instance.

Related Link

View User's 
Response

Shows a read-only version of the survey responses completed by the user.

Related List

Assessment 
Instance 
Questions

All instance question records that store user response values for each 
question on the quiz questionnaire. The following columns are relevant to quiz:

◦ Category: Displays the quiz categories the questions belong to.

◦ Metric: Displays the quiz questions.

Related topics

Event scheduling

Add a metric category and metric in the question bank for quizzes

Reuse the question categories (metric categories) and questions (metrics) added in the question 
bank for quizzes. You can add metric categories or metrics from the question bank to a quiz, or 
from the quiz to a question bank.

Before you begin
Role required: admin or assessment_admin

Procedure

1. Navigate to All  > Quizzes  > Question Bank.

2. Click New.

3. In the Metric Category form, fill the fields.

Metric Category fields

Field Description

Name Name of the metric category.

Description Description of the metric category.

Total 
metrics

Total number of metrics in the metric category. This number is automatically 
updated when you add or delete metrics from the category.

4. Right-click on the title bar and click Save.

5. In the Assessment Metrics related list, click New.

6. In the Assessment Metric form, fill the fields.

7. Click Submit.
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Configure metric categories or metrics for a quiz using the question bank

Reuse question categories (metric categories) and questions (metrics) from the Question Bank 
module while creating or updating a quiz.

Before you begin
Role required: admin or assessment_admin

Procedure

1. Navigate to All  > Quizzes  > Quizzes.

2. Open a quiz definition.

3. Optional:  To add metric categories to a quiz from the question bank in Platform, perform the 
following steps.

a. In the Metric Categories related list, click New Category from Bank.
The New Category from Bank dialog box is displayed with a list of all metric categories added 
in the question bank.

b. Select the required categories and click Add Selected.
A copy of the metric category and the corresponding metric definitions is created in the 
Metric Categories related list.

4. Optional:  To add metrics to a quiz from the question bank in Platform, perform the following 
steps.

a. In the Metric Categories related list, open a metric category definition.

b. In the Assessment Metrics related list, click New Metric from Bank.
The New Metric from Bank dialog box is displayed with a list of questions available in the 
question bank.

c. Select the required metrics and click Add Selected.
A copy of the metric and the corresponding metric definitions is created in the Assessment 
Metrics related list of the category.

5. Optional:  To add a metric category to the question bank from a quiz in Platform, perform the 
following steps.

a. In the Metric Categories related list, open a metric category definition.

b. Click Add to Question Bank.
A copy of the category is created along with its metrics and metric definitions in the question 
bank.

6. Optional:  To add a metric to the question bank from a quiz in Platform, perform the following 
steps.

a. In the Metric Categories related list, open a metric category definition.

b. In the Assessment Metrics related list, open the required metric definition.

c. Click Add to Question Bank.
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The Add to Question Bank dialog box is displayed.

d. In the Choose a question bank to add this question/metric  field, select a metric category 
that you want to add this metric to, and click OK.
A copy of the metric and the corresponding metric definitions is created for the selected 
category in the question bank.

7. Optional:  To add a metric category or metric to a quiz from the question bank in Quiz Designer, 
perform the following steps.

a. Open the quiz in Quiz Designer.

b. Optional:  To add a metric category from the question bank, from the Categories  tab in the 
left panel, drag the required category banner and drop in the Design  tab.

c. Optional:  To add a metric from the question bank, drag and drop the required metric from 
the Questions  tab or the Categories  tab.

Note: 

◦ When you drag and drop a metric category, all dependencies within the category are 
also added to the quiz.

◦ From the Categories  tab, you can drag and drop an individual metric within a metric 
category.

◦ When you drag and drop a parent metric, all dependent questions are also added to 
the metric category.

◦ When you drag and drop a child metric, only the child question is added to the metric 
category.

Create quizzes with forms

As an alternative to the Quiz Designer, you can create a complete quiz using records in the 
Assessment application.

All the elements of a quiz, the categories, questions, and answers, are stored in tables used by 
the assessment engine and are displayed in quiz views  of these tables. Users creating quizzes 
in the Assessment application must have the assessment_admin role.

Create a quiz using assessment forms by following the procedures in the order shown here:

• Create the quiz.

• Set up the categories.

• Create the questions for the quiz.

• Create the answers for the questions.

• Distribute the quizzes to recipients.

Note: 
The recommended method of creating and editing quizzes is to use the quiz designer, 
which provides a single, intuitive interface for creating and editing quizzes quickly. If you 
determine that you need to add specific features to your quiz not offered through the quiz 
designer, you can do so by using some of the specific procedures described here.

Related topics

Create a quiz

Create a category for assessable records
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Set up a category

A category represents a theme for evaluating a specific element of the quiz topic and contains 
questions pertaining to that theme.

Before you begin
Role required: none

About this task
When you create a quiz, the system creates a default category with the name of the quiz. You can 
use this category, modify it, or create additional categories as needed. Categories are records in 
the Quiz view  of the Metric Category table.

Categories have weighting values  that contribute to the overall score for the quiz. By default, all 
categories are given a weighting value of 10. You can assign any weight to your categories. To 
have any results, a category must contain scored questions.

Procedure

You can create a new category or edit an existing one from the Metric Categories  related list of a 
quiz record.

Related topics

Create quizzes with forms

Create a quiz

Select a user for a category

Data types for quizzes

Change the order of an answer

Distribute a quiz

Modify a published quiz

Select a user for a category

Category users are the recipients of the questions for each category.

Before you begin
Role required: none
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About this task
A category can have one or more assigned users, and the same user can be assigned to 
more than one category. When the system distributes a quiz, it sends an email notification, if 
configured, to the category users and creates a link to the appropriate questionnaire in their 
assessments and surveys portal. Users can only answer questions attached to their assigned 
categories.

Procedure

To select users for a category, select the Users  related list in a category record, and click Edit.

Related topics

Create quizzes with forms

Create a quiz

Set up a category

Data types for quizzes

Change the order of an answer

Distribute a quiz

Modify a published quiz

Create questions

Create quiz questions. A category can have multiple questions associated with it.

Before you begin
Role required: none

About this task
Each question can only be associated with one category. Each question has an answer data type 
that determines how recipients answer the question. Questions are records in the Quiz view of 
the Assessment Metric table.

Procedure

1. Open a category record.

2. Create a question record in one of the following ways:

◦ By accessing the Assessment Metrics related list and selecting New.

◦ Navigate to Quiz Management  > Questions  and select New.
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Warning: 
When you create a Choiceor Likert Scale  question, you must reopen the Assessment 
Metric form after you submit it to create answers. If you distribute a questionnaire without 
creating the answers for questions with these data types, recipients are unable to answer 
the questions. If the questions are mandatory, the recipients are unable to submit their 
questionnaires.

On the form, fill in the fields.

Field Description

Name [Required] Name of the question.

Category [Required] Category the question belongs to. The system populates this 
category if you create a new question from the Metric Category form.

Note: 
You cannot change the category if the Depends on  field is set or if 
another metric depends on this metric.

Method Setting that determines how to use the question.

◦ Assessment: Makes the question available on a quiz distributed to users. 
The Assessment  method is compatible with all data types except Duration.

◦ Script: Queries the database without user participation. Scripted questions 
are of limited value for quizzes, because they do not assess a user's 
knowledge of a topic.

Note: 
If you select a Data type  that is incompatible with the selected Method, 
the system automatically changes the Method  to the correct value.
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Field Description

Weight Numeric value that represents the importance of this question relative to other 
questions in the same category. By default, the weight is 10. For weighting 
suggestions, see weight categories and metrics. This field is available and 
required unless the Data type  is Date, Date/Time, or String. These data types 
are not included in results calculations.

Order [Required] Numeric value that determines the order of the question in the 
category. The question with the smallest order value appears as the first 
question in the category's section. By default, the order is 100.

Note: 
It does not matter which order value you use for metrics with the Script 
method, because they do not appear on questionnaires.

Active Check box that determines whether this question appears on quizzes. If a 
question is inactive, it does not appear on quizzes generated after the question 
becomes inactive.

Mandatory Check box for requiring users to answer the question. Users cannot submit 
questionnaires until they provide valid responses to all mandatory questions, 
which are denoted by a red field status indicator.

This field is available only if the Method  is Assessment, the Dependson field is 
empty, and the Data type  is not Checkbox.

Allow not 
applicable

Check box for including Not Applicable  as a possible answer for this question. 
Users can select Not Applicable  if they do not have sufficient information to 
respond to a question. User responses of Not Applicable  are excluded from 
results.

Question

Question The question that is displayed in quizzes. Enter a clear, straightforward 
question that is easy to understand.

Details Information about the question and what it evaluates. Include details that 
help users understand how to answer the question or when you need HTML 
enhanced details for your question. You can create HTML text in this field with 
the WYSIWYG editor, such as embedding links and images.

Depends on An existing question that this question is dependent on. You can select 
Checkbox,Choice, Likert Scale, Template, and Yes/No  questions from the 
same category as this question. Then use the Displayed when field to set 
the conditions for displaying this question. The system prevents the creation 
of recursive dependencies between questions. For example, if Question A 
depends on Question B, Question B cannot depend on Question A.

Question Type

Data type [Required] Format of the expected response data. See the table of data types 
for details.

Note: 
You cannot change the data type if another question depends on this 
question

Randomize 
answers

Check box for displaying the possible answers for this question in a random 
order whenever the question appears. Answer preference is sometimes 
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Field Description

influenced by the order in which answer options appear, which can result in 
biased results. Randomizing answer options can help prevent this bias. This 
check box is available only if the Data type  is Choice  or Likert  Scale.

Note: 
Randomizing answer options for certain questions may make those 
questions confusing for users. In general, only randomize answer options 
that do not follow a logical order.

Scale 
definition

Setting that determines whether lesser or greater numerical values equate to 
a good score in quiz result calculations. Select Low  if lesser numerical values 
are better. Select High  if greater numerical values are better. The default value 
isHigh. This field is available and required unless the Data type  is Date, Date/
Time, or String. The results for these data types are not included in results 
calculations. When the Scored check box is selected, the scale value is set to 
High  and the field is hidden.

Note: 
For information about how to set the scale definition for data types 
that do not require you to set a numerical value, see Data types for 
assessments.

Min Lowest numerical value that can be used as an answer option. This field is 
available and required only if Data type  is Number, Duration, or Percentage.

Max Highest numerical value that can be used as an answer option or scaled 
value. This field is available and required if Data type  is Number, Duration, or 
Percentage.

String 
option

Setting for the appearance of a string field in a question. This field is available 
when the question type is String. The string options are:

◦ Single line: Single line text field 40 characters in length that allows strings of 
any length.

◦ String line wide: Full page width text field that allows a single line entry of 
any length.

◦ Multiline: Full page width multiline text field that allows word wrap and 
returns.

Scored Check box for using answers in scoring the category results and showing them 
in the quiz results. Scored questions are available for these data types:

◦ Choice

◦ Likert Scale

◦ Template

◦ Checkbox

◦ Yes/No
Selecting this check box hides the Scale definition  field and sets the value in 
that field to High.

Correct 
answer

[Required] Desired answer to a scored question. This field is available when 
the Scored  check box is selected. Multiple correct answers are supported for a 
few data types. See Data types for quizzes.
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Field Description

Template Answer template to use with this question. This field is available when the Data 
type  is Template.

Related List

Assessment

Metric 
Definitions

List of options for this question. This related list is available only if the Data 
type  is Choice  or Likert Scale.

Related topics

Assessment metrics

Create quizzes with forms

Create a quiz

Set up a category

Select a user for a category

Data types for quizzes

Create questions

Create answers for questions

Create answer options for questions with the Choice or Likert Scale data type.

Before you begin
Role required: none

About this task
When you create a question with one of these data types, the Assessment Metric Definitions 
related list appears. Each metric definition appears as one answer option for a question on a 
quiz. For example, the question What type of men's trousers are not permitted by company 
policy?  might have these three answers configured as metric definitions: Slacks, Jeans, and 
Casual cotton.

Procedure

1. Open the question record you want to edit.

2. Click New  in the Assessment Metric Definitions  related list.

3. Set the order in which the answers appear in the quiz by providing a hierarchical number in the 
Value  field.
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Related topics

Create quizzes with forms

Create a quiz

Set up a category

Select a user for a category

Data types for quizzes

Change the order of an answer

Distribute a quiz

Modify a published quiz

Distribute a quiz

When you finish configuring the answers for the quiz questions, you are ready to distribute the 
quiz.

Before you begin
Role required: none

About this task
You can send the quiz to all the category users configured for the quiz or to a single category 
user.

Procedure

1. Navigate to All  > Quiz Management  > Quizzes.

2. Open the quiz record, and click Publish.
The quiz is placed in the Published state, and it is sent to all its category users.

3. Optional:  Edit the published quiz.
See Modifying Published Quizzes  to learn how various modifications affect the quiz contents.

4. Optional:  Resend a quiz to either on category user or all category users.

◦ Send the quiz to one category user by clicking Assign Quiz.

◦ Send the quiz to all of its category users by clicking Send Quizzes.
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Note: 
These buttons are hidden if there are no category users defined for the quiz.

Related topics

Create a quiz

Modify a published quiz

Modify a published quiz

Post changes to existing questions immediately. Make new questions available to users who 
have not started the quiz.

Before you begin
Role required: none

Procedure

You can edit a quiz even after it has been distributed, with these results:

• Added questions are available only on quizzes that are distributed after this change.

• Changes to existing questions are immediately available to users before the quiz is submitted 
or during the retake period. This includes changes to the answers, such as additional choices 
or changes to the data type.

• Deleted questions are also deleted from the distributed quizzes in users' queues.
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Related topics

Create a quiz

Change the order of an answer

Quizzes reference

Reference topics provide additional information about the forms, fields, and properties you use 
while working with quizzes.

Quiz scorecards

The Quizzes application prepares printable scorecards.

A scorecard analyzes category and question responses and compares current ratings with 
previous ratings. You can examine ratings over time, compare question ratings, or compare the 
ratings of all categories. All ratings are averages for the time range selected.

The system dynamically updates a scorecard each time you view it, so the ratings reflect recently 
completed quizzes.

Category results

The Category Results view is a stacked bar chart of responses to all questions in a category.

Select the category to display from the choice list above the chart. Category results are only 
calculated for scored questions

This view displays responses that use the following data types:

• Checkbox

• Choice

• Likert Scale

• Number

• Template

• Yes/No

Note: 
The Checkbox  and Yes/No  data types are combined into the Boolean  data type in the Quiz 
designer.
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Quiz category results

To view details about a specific response to a question, point to the colored segment 
representing a specific response. The chart displays the count for those responses and the 
percentage it represents of the total responses to that question.

Quiz category result details

Question results

The Question Results view shows the results for all questions in a quiz.

Select a question by name from the choice list to display the results in a pie chart or a bar chart, 
based on the data type.

Pie chart

The pie chart shows question results for these data types:

• Checkbox

• Choice
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• Likert Scale

• Number

• Template

• Yes/No

Note: 
The Checkbox  and Yes/No  data types are combined into the Boolean  data type in the Quiz 
designer

Quiz scorecard question results - pie chart

Bar chart

A bar chart appears when question results use this data type:

Percentage

By default, all results for percentage questions use a report range of 20% segments. To configure 
a report range, navigate to Reports  > Administration  > Report Ranges.

Average ratings

The Average Ratings view displays a bar chart of the weighted average rating for each question 
in a category.
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Use this view to learn how individual questions affect the overall rating for the category. Select 
a category from the second choice list above the chart. Ratings are only calculated for scored 
questions

Average Ratings view

To view the effect of each question's ratings on the entire category's ratings, point to the colored 
bar. The pop-up box shows the percentage of the total ratings represented by each individual 
question's weighted average.

Quiz scorecard rating detail

Question Properties form

Description of the field values for the Question Properties form.

Question Properties form

Field Description

Name [Required] Name of the question. Create a concise and easily recognizable 
name for your question. The system uses this value to identify the question in 
Assessment Metric lists and in scorecard charts.
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Question Properties form  (continued)

Field Description

Question Text to display as the question on quizzes. Enter a clear, straightforward question 
that is easy to understand.

Type [Read-only] Data type selected for this question. See the table in Controls  for 
possible data types.

Active Check box that determines whether this question is available on a quiz. If a 
question is marked inactive, it does not appear on quizzes generated after the 
question becomes inactive.

Boolean 
option

Whether a check box or a Yes/No  list appears as the option for the Boolean 
question.

Mandatory Check box for requiring users to answer the question. Users cannot submit 
quizzes until they answer all mandatory questions, which are denoted by a red 
Introduction_to_Fields Field_Status_Indicator" --> field status indicator.

This field is available when the question does not have a dependency and the 
question Controls  is not Boolean  with a check box option.

String 
option

Setting for the appearance of a string field in a question. This field is available 
when the question type is String. The string options are:

• Single line: Single line text field 40 characters in length that allows strings of 
any length.

• String line wide: Full page width text field that allows a single line entry of any 
length.

• Multiline: Full page width multi-line text field that allows word wrap and returns.

Min Lowest positive whole number that users can enter or select to answer the 
question. This field is available when the question type is Number, Percentage, or 
Numeric Scale.

Max Highest positive whole number that users can enter or select to answer the 
question. This field is available when the question type is Number, Percentage, or 
Numeric Scale.

Allow not 
applicable

Check box for including Not Applicable  as an option for this question. 
Users can select Not Applicable  if they do not have sufficient information to 
respond to a question. User responses of Not Applicable  are excluded from 
results calculations. This field is available when the question does not have a 
dependency and the question data type  is not Boolean  with a check box option.

Randomize 
answers

Check box for displaying answer options in a random order whenever the 
question appears in a quiz. Answer preference is sometimes influenced by the 
order in which options appear, which can result in biased results. Randomizing 
options can help prevent this bias.

Randomizing options for certain questions may make those questions confusing 
for users. In general, only randomize options that do not follow a logical order.

Details Information about the question that is displayed on the quiz. Include details that 
help users understand how to answer the question. You can also enter HTML text 
in this field with the WYSIWYG editor. For example, include HTML to embed links 
and images.
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Question Properties form  (continued)

Field Description

Correct 
answer

Answer option that you want to be selected by users. When you specify a correct 
answer for a question, the system scores the question. This field is available for 
all data types except Date, Date/Time, and String. Multiple correct answers are 
supported for a few data types. See data types.

Choices Options for a question with a data type of Choice  or Scale. The system 
automatically adds text and values that you can edit for each option. Click the 
+  icon to add an option, or click the X  icon to delete an option. By default, the 
system arranges options in the order established by their values. To change the 

order, drag and drop the options. 

Dependency

Displayed 
when

Condition builder that hides or displays the question depending on the answer to 
another question in the same category. Select an existing question from the list 
with a data type of Boolean, Choice, Scale, or Template. Create the condition that 
must exist for recipients to see the dependent question, using the is  or is one of 
operator. The system prevents recursive dependencies between questions. For 
example, if Question A depends on Question B, Question B cannot depend on 
Question A.

Related topics

Create quiz questions

Quiz reports

Quizzes provide several global reports so that assessment administrators can view important 
statistics.

You can share these reports with specific users or groups and change the display options.

For detailed field information and reporting options, click the link for the chart Type. To sort a 
column in ascending or descending order, click the arrow in the column heading

Quiz reports

Type Description

Quizzes by State State of distributed quizzes. This chart displays the percentage of 
distributed quizzes that are ready to take, in progress, complete, or 
canceled.

• Type: Pie Chart

• Table: Assessment Instance [asmt_assessment_instance]

Total Questions 
by Quiz

Total number of questions for all categories in each quiz.
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Quiz reports  (continued)

Type Description

• Type: Bar Chart

• Table: Assessment Metric [asmt_metric]

Questions by Data 
Type

Total number of questions in all quizzes by data type.

• Type: Bar Chart

• Table: Assessment Metric [asmt_metric]

Correct Answers 
by Assigned User

Total number of scored questions answered correctly by each assigned 
user.

• Type: Bar Chart

• Table: Metric Results [asmt_metric_result]

Number of Correct 
Answers

Total number of correct answers for each scored question.

• Type: Bar Chart

• Table: Metric Results [asmt_metric_result]

Incorrect Answers 
by Assigned User

Total number of scored questions answered incorrectly by each assigned 
user.

• Type: Bar Chart

• Table: Metric Results [asmt_metric_result]

Number of 
Incorrect Answers

Total number of incorrect answers for each scored question.

• Type: Bar Chart

• Table: Metric Results [asmt_metric_result]

Classic approvals

Classic approvals are a legacy process to require authorization on tasks before the work is done. 
In earlier releases, you could create approval records to define approval tasks and associate 
users or groups to approve or reject them.

Administrators can define classic approval logic by navigating to All  > System Policy  > Rules  > 
Approvals.

Important: 
Classic approval rules have been replaced by the Flow Designer  Ask for Approval action . 
Use Flow Designer  to create workflow-driven approval logic that is easier to maintain and 
provides better reporting information.

Administrators can see all approval requests by navigating to All  > Self-Service  > My Approvals 
and removing the list filter.

An approval record consists of these fields:
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Approval record components

Field Input value

Approver A reference to the user who is responsible for approving the related record.

State Choices are:

• Not Yet Requested (This state indicates that you are not yet asking your 
approvers to approve this request. Until you set the status to Requested  they 
will receive no email notifications about the request.)

• Requested

• Approved

• Rejected

Approving A document_id reference field to the record being approved, on any table.

Comments A journal field for storing comments regarding the approval.

Approval 
Summarizer

A Create a formatter and add it to a form  that displays key fields relevant to the 
approval from the referenced document. This summarizer will not display if there 
is no record referenced.

Approval engines

The differences in the way that companies handle their approvals, as well as the differences 
between approvals for the various applications (such as Service Catalog Requests and Change 
Management), calls for supporting flexibility in setting up approvals within applications.

Important: 
Classic approval rules have been replaced by the Flow Designer  Ask for Approval action . 
Use Flow Designer  to create workflow-driven approval logic that is easier to maintain and 
provides better reporting information.

This flexibility is provided through the selection of an ''approval engine'' that is used to manage 
the approvals for each of the Task tables (that is, all tables that extend the Task table).

There are three different approval engine options available for each Task table.

Approval engine options

Option Description

Approval 
Rules

A simple set of rules that are evaluated until one matches for the Task table. The 
matching approval rule is used to create the users that are to approve the task. Set 
up approval rules by navigating to System Policy  > Approvals.

Process 
Guides

A sequence of approval steps over which you may control how approvals and 
rejections are handled. This option is deprecated and should not be used.

Turn off 
Engines

Turn off both approval engines for this Task table. This option should be selected 
and is made read-only when a workflow is used to manage the approval process for 
the table.

Note: 
Not turning off the approval engines might have a performance or behavioral 
impact on your instance.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3843

https://www.webstg.servicenow.com/docs/access?context=t_CreateAFormatter&version=washingtondc&pubname=washingtondc-platform-administration&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=t_CreateAFormatter&version=washingtondc&pubname=washingtondc-platform-administration&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=t_CreateAFormatter&version=washingtondc&pubname=washingtondc-platform-administration&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=ask-approval-flow-designer&version=washingtondc&pubname=washingtondc-build-workflows&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=ask-approval-flow-designer&version=washingtondc&pubname=washingtondc-build-workflows&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=ask-approval-flow-designer&version=washingtondc&pubname=washingtondc-build-workflows&ft:locale=en-US


Set up an approval engine

To manage the approvals for each of the Task tables in the system, set up an approval engine.

Before you begin
Role required: none

Procedure

1. Navigate to All  > System Properties  > Approval Engines.

The following page appears with the Approval Engine  option for each Task table in the system. 
If the Approval Engine  option is greyed out and shows Turn engines off, read the Notes  in 
the same row. The most common reason an approval engine is turned off is that a workflow is 
managing the approvals on the table. Having the approval engine turned off prevents conflicts 
with the workflow that could cause a range of issues. If you want to use an approval engine on 
the table, set the workflow to inactive.

2. Select the approval engine option  for each Task table from the choice list.

3. Click Save.
These preferences are saved as system properties that are named 
glide.approval_engine.<table_name>.

Approval rules

Many organizations rely on an approval process to ensure that requests are reasonable and fit 
an organization's budget.

Important: 
Classic approval rules have been replaced by the Flow Designer  Ask for Approval action . 
Use Flow Designer  to create workflow-driven approval logic that is easier to maintain and 
provides better reporting information.

The service catalog can use these classes of approvals:
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Approvals

Title Description

Gating 
approvals

Must occur before a request can be initiated. For example, allow a manager to reject 
an employee's request for a company car.

Process 
approvals

Take place within an execution plan process that has been initiated. For example, 
allow the security group to reject a request for access to SSN even though the 
employee's manager approved it.

Note: 
To enable approval processes to operate smoothly, make sure that the appropriate users 
have the correct role, and that the role grants access to the necessary tables for users in all 
the relevant departments and domains.

Set automatic approval rules

Approval rules can automatically set the approval state to something other than Not yet 
requested. As a result, an approval rule can create a set of approvers. You can also start the 
approval process by setting the approval state to Requested.

Prerequisites

Role required: admin

Approval rules have two new fields:

• Run rule before: If true, the approval rule runs before the record is inserted/updated.

• Set State: If this rule applies, then the task record's approval state is automatically set to this 
value.

Note: 
The Set State  field only behaves as expected if the Run rule before  check box is 
enabled.

• In the example below, this rule automatically sets the state of the task to Approved  thereby 
auto-approving the task.

Approval Rules fields

Gating approvals

A gating approval acts as a gate through which a request must pass before it can start.

Until all gating approvals are met, no notifications go out, no tasks get sent to technicians, and 
nobody starts working on the request in question.

Generate gating approvals with:
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Gating approvals

Title Description

Approval 
rules

Can apply to the service catalog as well as any other task table.

Item-based 
approvals

Flag specific catalog items as requiring specific approvals. Any requests for 
these items automatically require these approvals.

Set up a gating approval via an approval rule

You canset up a gating approval via an approval rule.

Before you begin
Role required: admin

Procedure

1. From the left navigation pane, select System Policy  > Approval Rules.

2. Click New.

Approval rules

Field Description

Name Name of this rule.

Table
Task table to which this rule applies. For most service catalog approvals, select 
Request.

Note: 
The list shows only tables and database views that are Application scope
as the approval rule.

Active Indicator of whether the rule is active (defaults to true).

Run Rule 
Before

Indicator of whether the rule runs before or after the request record is saved. For 
most approvals, select this check box.

User User who must approve this request (can be empty).

Group Group that must approve this request (can be empty).

Set State Value of the approval field on the task in after this rule runs. In most cases, select 
Requested.

Condition Condition under which the rule applies.
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Field Description

Script An optional server script to programmatically specify who 
the approver should be. For example, for the one-line script 
current.requested_for.manager, ServiceNow  checks the 
requested_for reference field on the current record. It then locates the manager 
field on the referenced record and assigns that person as the approver. For other 
examples, see the Script field on approval rules provided by ServiceNow.

Notes and limitations:

a. You can have as many rules as you want on a given table. If more than one rule applies, you 
will get more than one approver.

b. You can't get duplicate approvers, for example, if two rules both want Fred Luddy to approve 
a particular request, the system will only create one approval entry for him.

c. By default all requests start out in a Not yet requested  approval state. Approval notifications 
will not go out until the request's approval state is set to Requested. You can do that 
manually, or you can do it in script, but the easiest way to do it is to use the Set State  field to 
automatically set the request to Requested.

Set up a gating approval based on the item being ordered

In addition to adding approvals via approval rules, you can also add approvals based on what 
kind of item is being ordered.

In addition to adding approvals via approval rules, you can also add approvals based on what 
kind of item is being ordered. We can, for example, specify that all Blackberrys need to be 
approved by David Loo.

To do so, navigate to the item in question and scroll to the related list of required approvers. 
There are two lists:

• Approved By Group: A list of groups that have to approve requests for this item

• Approved By: A list of users who have to approve requests for this item

Approve list

In the example above, this request must be approved by all members of the Hardware group and 
by David Loo.

Notes and limitations:
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1. As with approval rules, you are protected against duplicate entries. Thus if a person is a 
member of the hardware group, as well as being a standalone approver, the person will only 
get one approval request.

2. Item-based approved work in addition to rather than instead of approval rules so you can (and 
probably will) use both.

Process approvals

Once a request has passed its gating approvals, any relevant execution plans are initiated.

Those plans, in turn, create a sequence of required tasks. You can add an approval step to an 
execution plan, which is configured to occur at the appropriate point.

From the left navigation pane, select Service Catalog  > Execution Plans, and then select the 
plan to which to add an approval step. Then click the New Approval  button.

Add approval

The Approval Task screen appears. Just like a regular Service Catalog execution task, an 
approval execution task has:

• Name: The name of this task

• Order: Sequence of this task within the plan

• SLA: SLA to which this task applies

• Delivery Time: Time allowed for the completion of this task

After you create the task, right click the title bar and select Save. Two related lists appear at the 
bottom of the screen:

• Approved By Group: A list of groups that must approve the request before this task is 
complete

• Approved By: A list of users who must approve the request before this task is complete
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Approval task

In the example above, this security approval task must be approved by Fred Luddy.

Note: 
When an in-process approval is rejected, that particular line item is canceled as well, but 
the request itself isn't necessarily canceled. Thus if one ordered a blackberry and a laptop, 
and the blackberry was rejected, the laptop request would continue being processed.

Approve with a process guide

Process guides work similarly to approval rules in that their execution is controlled via a 
condition.

Before you begin
Role required: none

About this task
The default version of approval tasks allows you to specify that the approval in question be 
approved by:

1. One or more specific people

2. One or more groups of people

You can optionally use Process Guides instead of approval tasks. Process guides are more 
flexible in that they allow for:

1. "Any of" or "All of" approvals

2. Sequenced approvals

You can link a process guide to a execution task.
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Procedure

1. From the left navigation pane, select System Policy  > Process Guides.

2. Create a new guide.

3. Set the table to Catalog task.

4. Fill in a condition under which this guide should attach.

Example  1: Apply to all "Capacity Review" tasks.

Example  2: Apply to all "Capacity Review" tasks where there requester is in Atlanta.

Process guide tips and tricks:

a. All catalog tasks are generated when a request is first submitted, but tasks which aren't 
active yet have a state of "pending". So if you do not want to send out approval requests until 
a task has actually started, add "state=open" as part of your condition.

b. There is a "Default" process guide in the system for catalog tasks with a sequence number 
of 10,000. It behaves exactly the same way the old, pre-process guide code did in regards to 
approvals. Approvals are based on the execution of task-related lists.

Schematic of a hypothetical approval process

In the diagram below of a hypothetical approval process, the gating approval is color coded blue 
and an in-process approval is orange.
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Approval process

Approval summarizer formatter

The approval summarizer formatter creates the summary at the bottom of an approval form.

The approval summarizer displays different information depending on what is being approved, 
such as a change request or a service catalog request. Following are two examples.
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Summary of a change request

Summary of a catalog request

The Reject  button allows the approver to deny one or more requested items in a multi-item 
request, before approving the overall request. If a requested item is denied, the workflow for that 
item never starts. The approver can then choose to Accept  the item.
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Note: 
When the overall request is approved, you must ensure this Reject  button is hidden. If this 
button is used after request approval, the requested item workflow is canceled, leaving the 
stage in an inconsistent state. Similarly, the Accept  button on requested items should only 
appear before the overall request is approved or rejected.

Summarizers

Approval summarizers are stored in the Macro [sys_ui_macro] table.

From the left navigation pane, select System UI  > UI Macros. Summarizers use 
a naming convention of approval_summarizer_ + '<table_name> (for example, 
approval_summarizer_change_request is the summarizer for change requests, while 
approval_summarizer_sc_request is the summarizer for service catalog requests).

Each summarizer is written in Jelly script, which is used to define internal forms. The script is 
stored in the large XML field at the bottom of the UI Macro form.

Change an approval summarizer

You can modify existing approval summaries to include additional information.

Before you begin
Role required: none

About this task
These are advanced customizations that might not be appropriate for all implementations, and 
require creating a custom form.

Procedure

1. Navigate to All  > System UI  > UI Macros.

2. Open the summarizer you want to change.

3. Copy the script to another location before editing, in case you need to revert it.

4. Modify the script.

5. Click Update.

Create a new custom approval summarizer

After you add a new table that has approvals to an instance, you can add a custom activity 
formatter by creating a new UI macro and then add it to the appropriate form.

Before you begin
Role required: admin

About this task
approval_summarizer can only be used on approval forms in the global scope.

Procedure

1. Navigate to All  > System UI  > UI Macros

2. Click New.

3. Give the macro a name that follows the summarizer naming convention: 
approval_summarizer_<tablename>

4. Complete the rest of the form and click Submit.
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5. Create a formatter and add it to a form  and add it to the appropriate form.
To learn more about activity formatters, see Activity formatter .

Approval with e-signature

Approve or reject an approval record by re-entering your login credentials. See the history of an 
approval from its activity stream or its audit history.

Support for Title 21 Code of Federal Regulations (CFR) Part 11

The Approval with e-signature plug-in is validated for Title 21 CFR Part 11 electronic signature 
requirements. This plug-in is required for compliance to 21 CFR Part 11.

Each time someone approves a record, the system stores this information.

• The printed name of the signer

• The date and time when the signature was made

• The meaning of the signature (approval or rejection)

This information is stored as part of the activity stream and audit history of the record.

Approval tables

By default, Approval with e-signature supports these tables.

• Change Request [change_request]

• Standard Change Proposal [std_change_proposal]

When you add an approval table, any approval for the table needs an e-signature authorization. 
See Select an approval table  to add or remove a table from supporting Approval with e-signature.

Approver Authentication dialog

Approvers must enter their user credentials to change the approval state. If the credentials fail, 
then the approval remains unchanged. The system checks the user credentials against local 
user records or an active single sign-on integration.

Approval History

Each Approval [sysapprover_approver] record has an activity stream that tracks changes to it. 
Approvals made by e-signature are stored as field changes.
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Example activity stream

Available approval options

The Change Request [change_request] table provides these approval options.

List options

The Change Request table provides context menu options to approve or reject 
records. When someone selects either the Approve or Reject context menu option, 
the system displays the Approver Authentication confirmation dialog.

UI actions

The Change Request form provides UI actions to approve or reject a record. When 
someone selects either the Approve or Reject UI action, the system displays the 
Approver Authentication confirmation dialog.

Change record state

The Change Request table provides a State field to approve or reject a record. 
When someone selects either the Approved or Rejected state, the system displays 
the Approver Authentication confirmation dialog.

User credential sources

Approval with e-signature supports these types of user credential sources.

• A set of local User [sys_user] records.

• A remote identity provider service accessed by the Multi-Provider Single Sign-On (SSO) 
integration.

User credentials must be set up before enabling Approvals with e-signature. See Creating 
users  to create local User records.

See Multi-Provider Single sign-on (SSO)  to create an integration to a Security Assertion Markup 
Language (SAML) 2.0 identity provider.
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Activate Approval with e-Signature plugin

The Approval with e-Signature plugin (com.glide.e_signature_approvals) allows users to approve 
requests by re-entering their login credentials.

Before you begin
Role required: admin

Note: 
You must install the Code Signing Signatures 
(com.glide.code_signing.signatures) to install the E-signature plugin.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.

Note: 
When domain separation and delegated admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .

De-activate e-signatures

Use this procedure to de-activate e-signatures.

Although plugins cannot be removed, e-signatures can be disabled.

1. Navigate to System Definition  > E-Signature Registry.

2. Set Enabled  to False  on any tables where e-signatures are no longer required.

Select an approval table

By default, activating the Approval with E-signature plugin enables e-signature for all tables for 
which an approval exists.

Before you begin
Role required: admin

About this task
E-signature approvals can also be enabled on a table-by-table basis.

Procedure

1. Navigate to All  > System Definition  > e-Signature Registry.

2. Select New.

3. In Table name, use the drop-down list to select a specific table.
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Table Descriptions

Field Input Value

Table Table that requires e-signatures for approvals.

Enabled Option to require e-signature for approvals. Clear this option to remove the e-
signature requirement.

4. Select Submit.

Set up an approval from a local database

Enable users to authorize e-signature approvals using local database credentials.

Before you begin
Role required: none

Procedure

1. Activate the Approval with e-signatures  plugin.

2. Create user records for approval users.

Use Multi-Provider SSO to set up an SSO approval for a SAML 2.0 authentication

An SSO approval with e-signature requires configuration on the SAML IdP and the ServiceNow 
instance.

Before you begin
Role required: admin

About this task
The SAML IdP must support and honor the forceAuthn attribute in SAML assertion requests. E-
signature doesn’t function without this IdP setting. Set up an approval with e-signature using 
credentials from a SAML 2.0 authentication.

Procedure

1. Activate or upgrade to SAML 2.0 with the Activate Multi-Provider SSO plugin .

2. Activate the Approval with E-Signature plugin.

3. Navigate to Multi-Provider SSO  > Identity Providers  and verify your 2.0 SAML IdP 
configuration Advanced tab shows the Force AuthnRequest  attribute checked.
Your SAML 2.0 IdP must support the Force AuthnRequest  attribute, or e-signature isn’t 
supported.

4. On the eSignature Approval tab, enter the following e-signature SAML properties.

Option Description

Assertion Consumer URL for eSignature au­
thentication

This property defaults to the appropriate URL. 
To configure this property, select the lock 
icon to make this field editable. After edits, se­
lect the icon to lock the field.

Assertion Consumer Index for eSignature 
authentication

If your Service Provider has more than one 
URL set for the AssertionConsumerURL, you 
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Option Description

can set the index to use for eSignature, start­
ing with index 1 or more.

AuthnRequest URL for eSignature Authenti­
cation

You can enter the URL that points to the 
SAML 2.0 IdP AuthnRequest URL for eSigna­
ture authentication. If the URL is the same as 
the Assertion Consumer URL, you can leave 
this setting empty.

Authentication pop-up Dialog Width

When a user approves a request using eSig­
nature, a dialog opens and a user can enter 
credentials. This setting controls the width of 
that dialog box. The default is 500.

Authentication pop-up Dialog Height

When a user approves a request using eSig­
nature, a dialog opens and a user can enter 
credentials. This setting controls the height of 
that dialog box. The default is 300.

5. Select the Generate Metadata  button underneath the tabs to regenerate the service provider 
metadata.

6. Copy the service provider metadata, and update it on the SAML IdP.

Installed with approval with e-signature

Installing approval with e-signature installs certain properties.

• Module - E-Signature Registry

• UI Action - Approve (on table sysapproval_approver, with no action name)

• UI Action - Approve (on table sysapproval_approver, with no action name)

• UI Action - Approve (on table sysapproval_approver, with the action name 
authenticated_list_approval)

• UI Page - form_login_validate_dialog

• UI Page - login_validate_dialog

• UI page: saml2_esignature_login, the re-authentication page that appears when an approver 
tries to approve a request.

• Properties: see E-signature SAML properties

• Client Script - Authenticate Approver

• Script Include - User
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• Script Include - UserAuthentication

• Processor: eSigSaml2AssertionConsumer

Installing the plugin also disables the two out-of-the-box Approve UI Actions on the 
sysapproval_approver  table.

Approval status

The approval status of a change request is determined by looking at the current status of all the 
approvers.

If any approver has rejected the change, the approval status will be Rejected. If all approvers 
have approved the change, the approval status will be Approved. If all approvers are in the 
Not Requested status or if there are no approvers, the change status will be Not Requested, 
otherwise the status will be Requested.

For added flexibility when creating approvals, including the ability to set up an "one of" approval 
where only one person of a group of approvers needs to approve, consider using Workflows .

Related topics

Classic approvals

Generate an approval using approval rules

The system can automatically generate an approval request to individuals or groups when 
specific criteria are met. The automatic generation of approval requests is driven using the 
System Policy feature.

In the sample below, a change opened in the category network  is assigned to the System 
Administrator:

Approval Rules

When an approver is automatically added based on approval rules, the status of the approval 
automatically defaults to "Requested".

Related topics

Classic approvals

Generate approvals using the approvers related list

It is possible to manually add approvers to a request.

Additional approvers can be added by clicking the Edit  button in the Approvers section near the 
bottom of a request. When an approver is added manually, the status for that approver defaults 
to Not Yet Requested. When the status of the approver changes to Requested, the approver is 
sent an email requesting approval action.
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Related topics

Classic approvals

Generate approvals using workflows

Workflows are a powerful and flexible method of generating approvals. Use workflows to create 
group approvals and user approvals.

A variety of variables are available to fine-tune the approval process, including the actions that 
occur when approval or rejection take place. When a workflow activity generates an approval 
record, the system populates the Workflow activity  field on the approval record with a reference 
to the activity. Do not use this field when creating business logic. For more information, see 
Approval and Rollback Activities.

Note: 
Conflicts can arise when the approval process for a table is managed by both the workflow 
engine and the approval engine. In general, if there is a workflow that manages the approval 
process for a table, the approval engine  should be turned off for that table.

Related topics

Classic approvals

Multiple approvers

With multiple approvers, all approvers must authorize the request before the status will change to 
"Approved".

Should any approver reject the request, the status will immediately be set to "Rejected".

Related topics

Classic approvals

Receive notifications

Individuals who are designated approvers automatically receive approval notifications, including 
approval status updates.

Approval notifications will be sent at the following times:

• When an individual is assigned as an approver either automatically or manually. If a group is 
chosen, then all members of the group will be sent an email. By default, the email an approver 
receives will contain a "mailto" link that will allow the approver to either approve or reject the 
request directly from their email system.

• When the request reaches approved status, the person assigned to the request will receive an 
email indicating it has been approved.

The details contained in the emails and the points at which they are sent can be tailored using 
System Definition  > Business Rules  and System Policy.

Note for Blackberry users: In order to see the "mailto" links mentioned above to approve or 
reject a request (i.e. 'Click here to approve CHG55555' or 'Click here to reject CHG55555'), your 
Blackberry device must be using version 4.5 of their software which supports HTML emails. 
If your Blackberry device is using an earlier version, you will not be able to view or use the 
"mailto" links. However, as a workaround, users can reply to the email and add the statements 
state:approved  or state:rejected  within the body of the email before sending it to 
force the automatic approval/rejection functionality.
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If you create an appropriate Inbound Email Action, you can let approvers respond to approval 
email notifications with a simple "yes" or "no" answer.

Embed an approval request within the Outlook email client

Embed an interactive approval request for service catalog requests in the email notification sent 
to a user. The user can accept or reject the approval request from the email client.

Before you begin
Role required: admin
The Outlook Actionable Messages plugin (com.sn_ms_oam) should be activated.

Note: 

• The Outlook Actionable Messages (OAM) feature is not supported in all Microsoft  mail 
products and versions. To verify whether your version of Outlook supports OAM, refer to 
the Microsoft  documentation.

• Actionable messages are supported only for emails sent from the @service-
now.com email address. If you are sending an email from a customized email 
address, you should register as a new service in the Microsoft  website 
setting the scope as Organization. Specify the provider ID value in the 
sn_ms_oam.outlookactionable.originator  property.

• Actionable messages are based on the Sender Policy Framework (SPF)/DomainKeys 
Identified Mail (DKIM) validation for the email sender verification. If an email recipient 
receives email via an external provider, emails may not be rendered as adaptive cards.

• You cannot customize the default actionable message templates.

Procedure

1. Navigate to All  > System Notification  > Email  > Notifications.

2. For the approval notification that requires user approval, in the What it will contain  tab, add 
the following script in the Message  field in addition to the existing information, or to the 
Message  field in the configured email template if applicable.

${mail_script:include_approval_actionable}

For example, for the Catalog Approval Request and Approval Request notifications, 
you can include the script in request.itil.approve.role  and 
change.itil.approve.role  email templates.

This script includes the Outlook actionable message in the email notification sent to the user 
for approvals.

3. Click Update.

Dynamic approval forms

When you are looking at an approval request, the form has a context-appropriate summary of the 
item to be approved.

For example, if you're looking at a Change Management approval request, you will see details 
from the relevant change request. For a Service Catalog  approval request, you will get details of 
the request.
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Change request approval example

Service Catalog approval example

Scripts and engines execution order

Scripts, assignment rules, business rules, workflows, escalations, and engines all take effect 
in relation to a database operation, such as insert or update. In many cases, the order of these 
events is important.

Note: 
Client-based code that executes in the browser, using Ajax or running as JavaScript, will 
always execute before the form submission to the server.

The order of execution is as follows:

1. Before  business rules: Scripts configured to execute before the database operation with an 
order less than 1000.

2. Before  engines. The following are not executed in any specific order:

◦ Approval engine (for task and sys_approval_approver tables)

◦ Assignment rules engine (for task tables)

◦ Escalation engine

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3862



◦ Data policy engine

◦ Field normalization engine

◦ Role engine - keeps role changes in sync with sys_user_has_role table (for sys_user, 
sys_user_group, sys_user_grmember, and sys_user_role tables)

◦ Execution plan engine (for task tables)

◦ Update version engine - creates version entry when sys_update_xml entry is written (for 
sys_update_xml table)

◦ Data lookup engine inserts or updates

◦ Workflow engine (for default workflows)

3. Before  business rules: Scripts configured to execute before the database operation with an 
order greater than or equal to 1000.

4. The data base operation (insert, update, delete).

5. After  business rules: Scripts configured to execute after the database operation with an order 
less than 1000.

6. After  engines. The following are not executed in any specific order:

◦ Label engine

◦ Listener engine

◦ Table notifications engine

◦ Role engine - keeps role changes in sync with sys_user_has_role table (for sys_user, 
sys_user_group, sys_user_grmember and sys_user_role tables)

◦ Text indexing engine

◦ Update sync engine

◦ Workflow engine (for deferred workflows)

◦ Trigger engine (for all Flow Designer  flows)

7. Email notifications. The following are executed based on the weight of the notification record:

◦ Notifications sent on an insert, update, or delete

◦ Event-based notifications

8. After  business rules (Only active records). Scripts configured to execute after the database 
operation with an order greater than or equal to 1000.

Note: 
Like After  business rules, Async  business rules execute their logic after a database 
operation occurs. Unlike After  business rules, Async  business rules execute 
asynchronously, running in the background simultaneously with other processes. Async 
business rules run after the user submits the form and after the scheduler runs the 
scheduled job created from the business rule. The system creates a scheduled job from the 
business rule after the user submits the form but before any action is taken on the record in 
the database.

Fulfiller experience in Mobile Agent

Approve catalog requests, requested items, or change requests from anywhere using the ITSM 
ServiceNow Agent  application.

As an ITSM  agent or technician, you can use the mobile app when connected online to 
accomplish the following:
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• Accept or reject the pending approval requests.

• View the completed approval requests.

Note: 

• The request experience is not available in this mobile app.

• On-load catalog UI policies (non-scripted) are supported for variables in record views, for 
example, requested item and incident.

◦ Only the visibility condition is considered.

◦ A variable with no value is not displayed.

◦ These policies are also applicable for container variables and a group of check boxes.

◦ Since the multi-row variable set is displayed with a message that it is not viewable, 
these policies can be used to display or hide that message.

Watch this three-minute video to learn how to manage approval requests in the mobile app. 
This video covers: Accessing the Approvals mobile app and viewing and approving or rejecting 
requests.

Activation information

This mobile application runs on the ServiceNow®  mobile platform. You should activate the ITSM 
Mobile Experience (com.sn_itsm_mobile) plugin that enables the ITSM  mobile application.

Get started with the mobile app for Approvals

Access the My Approvals application instance on your mobile app to manage approval requests 
using your mobile device.

Before you begin
Role required: business_stakeholder or approver_user

About this task
Download the ServiceNow®  mobile application on an iOS  platform from the Apple  App Store or 
on an Android platform from the Google  Play Store.

Procedure

1. Open the mobile app and tap the plus icon ( ).

2. Add a ServiceNow  instance.
For more information on adding the instance, refer to Add a ServiceNow instance .

3. Tap My Approvals  to start managing your requests.

Related topics

Agent mobile app

Manage a catalog request approval

Manage your assigned catalog request or requested item by approving or rejecting it from 
anywhere using your mobile device.

Before you begin
Role required: business_stakeholder or approver_user
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Procedure

1. Tap My Approvals  on your mobile app.

2. To approve or reject a pending approval request, perform the following steps.

a. Tap the Pending Approvals applet.
All approvals in the Requested state are displayed.

b. Swipe a request and tap Approve  or Reject.

Note: 
You should specify the reason while rejecting a request.

c. Optional:  To view the details of a pending approval request, tap it.

Note: 
To approve or reject a request, tap the menu icon ( ) and tap Approve  or Reject.

3. To view a completed approval request, perform the following steps.

a. Tap the Completed Approvals applet.
All approval requests that are either accepted or rejected are displayed.

b. To view the details of the request, tap it.

State flows

State flows enable an administrator to customize transitions from one state to another in tables 
derived from the Task [task] table and configure the system to perform work during transitions to 
specific states.

An example of a state transition is when the State  field in an incident changes from Active  to 
Awaiting User Info. An administrator might want to trigger an event during this transition or make 
a specific field mandatory when the incident reaches the end state.

State transitions in the Field Service Management application were reimplemented to use state 
flows. For information about customizing Field Service Management state flows, see State Flow 
Customization .

Installed with state flows

Several types of components are installed with state flows.

Tables installed with state flows

Tables are added with state flows.

Table Description

State Flow 
[sf_state_flow]

Contains state flow definitions. This table contains all state flow definitions, 
including those for work orders and work order tasks.

Work Order Flow 
[sf_work_order]

Contains state flow definitions for work orders. This table is installed when 
Field Service Management is activated.

Work Task Flow 
[sf_work_task]

Contains state flow definitions for work order tasks. This table is installed 
when Field Service Management is activated.
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Business rules installed with state flows

Business rules are added with state flows.

Business rule Table Description

Assert Field 
Uniqueness in 
State Flow

State Flow

[sf_state_flow]

Ensures that business rules and UI actions are not 
accidentally copied to new state flows.

Check Client 
Script

State Flow

[sf_state_flow]

Adds a client script to new records.

Check Event Rule State Flow

[sf_state_flow]

Adds or deletes event rules, as the event field is updated.

Check Work 
Notes Rule

State Flow 
[sf_state_flow]

Adds or deletes work note rules, as the work notes for a 
state flow are updated.

Create Business 
Rule

State Flow

[sf_state_flow]

Automatically creates a business rule when automatic 
conditions or script are present.

Create script for 
Field controls

State Flow

[sf_state_flow]

Create scripts for field controls, when they are in use.

Create UI Action State Flow

[sf_state_flow]

Automatically creates a UI action when manual conditions 
or script are filled in.

Delete Related 
Elements

State Flow

[sf_state_flow]

When state flows are deleted, delete all related client 
scripts, business rules, UI actions and overrides.

Remove script for 
Field controls

State Flow

[sf_state_flow]

If all field controls are disabled, see if any of the client 
scripts should be removed.

State Change State Flow

[sf_state_flow]

Get the correct state choice value when the state is 
changed.

Update 
dependent 
records

State Flow

[sf_state_flow]

When a state flow is made active or inactive, ensure the 
business rule and UI actions are made active or inactive as 
well.

Script includes installed with state flows

Script includes are added with state flows.

Script includes for state flows

Script include Description

StateFlow Implements state flows and supports creation of state flow elements, such as 
business rules, UI actions, dictionary overrides, and client scripts.
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Script includes for state flows  (continued)

Script include Description

StateFlowAJAX Allows access to state flow functionality from client scripts.

Use state flows

You can create custom state flows for any table that uses states.

Make state transitions occur in any order or skip specific states according to your business 
practices. State flows can manage the behavior of fields and field visibility on a task form. 
State flows can also trigger system events that perform work such as sending Email and SMS 
notifications .

Administrators can configure state flows to:

• Limit the choice list  for the State  field to contain only those states that are valid for the flow.

• Define the behavior and visibility  of specific fields on a task form when state transitions occur 
and for certain end states.

• Configure events that are triggered when a task changes states.

• Set up  UI actions and business rules to implement certain state transitions, or while the task is 
in certain states.

The State Flow plugin installs records used by work management to control state transitions for 
work orders and work order tasks. For detailed information about using work management state 
flows, see State flow customization .

Creating and customizing state flows requires scripting knowledge. Users with the admin role can 
create state flow records.

Dictionary overrides for state flows

A dictionary override in a state flow defines the starting state for all new records in a specific 
table.

You set an override in tables that extend a base table only, so that your customizations are 
applied only to the extended table.

1. In a state flow record, select an Ending state.

This is the override value which becomes the starting state for all new records in the table 
named.

2. Click Create Default Value.

The system populates the Dictionary override  field with a value of state, which is the field in the 
task table affected by the override. The Dictionary override  field is read-only. After the override 
is created, the system hides the Create Default Value  button on all subsequent state flow 
forms for that table.

Events triggered on state changes

You can configure a state flow to trigger a registered system event when a task transitions from a 
starting state to a specified end state.

For example, you can use events to trigger email notifications and create script actions. When 
you attach an event to a state flow, the system creates a business rule called State Flow Events 
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for <table name> for the table specified in the state flow. If you specify a start and end state, the 
business rule executes when the record transitions from the start state to the end state. If the 
state flow only specifies an end state, the business rule executes whenever that end state is 
reached. The system creates one business rule for all state flows containing events on a single 
table. When all events or all state flows on a table are deleted, the system deletes the business 
rule.

Field controls

You can define controls for individual fields that are enforced when a record transitions between 
states.

Settings in the Field Controls section of the State Flow form enable you to apply field controls 
when the system detects a specified state transition or when the end state is the current state 
when the form is opened. The control is applied only to existing fields on the form. State flows 
cannot add fields to the form.

For example, you might want the Problem  field to be visible when an incident moves to the 
Awaiting Problem  state. If the incident state changes to Awaiting User Info, you hide the Problem 
field and make the Caller  field mandatory.

When creating field controls, configure state flow records with an ending state only and to create 
the correct behavior for every ending state you want to control. This configuration ensures that 
the field controls are set properly when the user selects a new state, and also when the user 
returns a record's State  field to the original state. Only specify a full state transition, with both a 
starting and ending state, when you want a particular behavior for that precise state transition.

Note: 
State flows use client scripts to enforce field controls. It is possible that your settings can be 
changed by existing UI policies, which execute after client scripts.

The system creates the following objects, as needed, to enforce field properties in state flows:

Field Controls

Type Name Description

Business rule State Flow Notes 
for <table name>

Enforces mandatory fields for the table on which that field 
behavior is defined.

Client script 
(onLoad)

<table name> state 
flow

Sets possible states and initial mandatory, read-only, and 
visible properties when a record is loaded.

Client script 
(onChange)

<table name> 
change state flow

Sets updated mandatory, read-only, and visible properties 
when a record is changed.

Rebuild state flows

You can rebuild state flows when a mismatch between existing and new sys_ids occurs.

When you use an XML file to import a state flow record into an instance, the system attempts to 
match the incoming states with existing states by comparing sys_ids. Because the sys_ids of 
items in a choice list can vary between instances, the system can fail to match the states, even 
though they are otherwise identical.

When matching fails, the start and end states of affected records are left blank or contain 
numeric values. To repair these records navigate to State Flows  > Admin  > Rebuild State Flows. 
This module runs a script that compares the numerical value of each item in the State  field 
choice list until it finds a match in the imported state flow record.
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State flow cleanup

Work notes

Related topics

Use state flows

Create a state flow

Create a state flow

Creating State Flows.

Before you begin
Role required: none

Procedure

1. Navigate to All  > State Flows  > State Flows  and click New.

2. Fill in the fields, as appropriate.

The system enforces the field controls with the same client script that filters the choice list for 
the State  field.

Creating state flows

Field Description

Number Automatically generated record number

Table [Required] Table on which the state flow record runs. Only tables that extend the 
Task [task]  table are available in the list.

Starting 
state

Name of the state at the beginning of the transition. The selections in this field 
are filtered by the possible states for the table selected.

Ending 
state

Name of the state at the end of the transition. The selections in this field are 
filtered by the possible states for the table selected.

Client 
script

Client script to run for this transition. The client script controls the available 
states you can select by limiting the contents of the State  choice list to valid 
states. This client script also controls specific field behavior configured for state 
changes in the Field Controls section of the form.

Event Name of an existing event to trigger when this transition occurs. See evernts 
triggered on state changes  for more information.

Name Name of this record. Make sure the name is descriptive of the state transition 
or the processing that the record is performing. This name does not have to be 
unique.

Roles Not used for any processing.

Active Enables or disables this state flow record.

Class Defines the state flow class for this record. The system selects the appropriate 
class from these options:
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Field Description

◦ State Flow: Records created for state flows in all task-based tables except 
those in work management.

◦ Work Order Flow: Records created for state flows in the Work Order 
[wm_order]  table. This class is available when work management is 
activated.

◦ Work Task Flow: Records created for state flows in the Work Order Task 
[wm_task]  table. This class is available when work management is 
activated.

Dictionary 
override

Sets the starting value for the State  field on all new records for the table named 
in the state flow record. See dictionary overrides  for configuration procedures.

Work 
notes

Noteworthy comments about this state flow transition. For details about how 
these notes are used, see Work Notes.

Comment Details about the customized record.

Manual (Runs scripts from a UI action that require the user to click a button or related link.)

Manual 
condition 
string

Conditions for enabling a UI action that cannot be defined with the condition 
builder. For example, you can use this string to define UI actions for mobile 
devices. This condition has an [and] relationship with the condition in the 
Manual condition  field.

Manual 
condition

Conditions for enabling a UI action that can be defined for fields in the target 
table. This condition has an [and] relationship with the condition in the Manual 
condition string  field.

Manual 
script

Script that defines what the UI action does when the conditions are true. This 
script runs when the user clicks a button or a related link.

UI action [Read Only] Name of the button that the system creates to enable this transition. 
The system creates the label using the same name as the state flow record that 
created it.

Automatic (Runs a business rule automatically when a task record is changed and updated.)

Automatic 
condition 
string

Conditions for running the business rule that cannot be defined with the 
condition builder, such as evaluating if the proposed transition is a valid flow. 
This condition has an [and] relationship with the condition in the Automatic 
condition  field.

Automatic 
condition

Conditions for running the business rule that can be defined for fields in the 
target table. This condition has an [and] relationship with the condition in the 
Automatic condition string  field.

Automatic 
script

Script that performs additional work when the condition is true. This script can 
do tasks such as update the date and time the transition occurred or notify 
someone using email when a specific state change occurs. Automatic state 
transitions occur when changes are made to the task record.

Business 
rule

Name of the business rule created for this transition. Two conditions must 
be satisfied before this business rule can run. The task must be on a specific 
starting state, and the Automatic condition  must be true. If both of these 
conditions are satisfied, the business rule performs the transition requested, 
using the starting and ending states from the State Flow form.

Field Controls (Determines field properties  when a record transitions between states or 
reaches a specific end state.)
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Field Description

Mandatory 
fields

Makes the selected fields required when this transition occurs, or when the end 
state is the current state.

Read only 
fields

Prevents the selected fields from being edited when this transition occurs, or 
when the end state is the current state.

Visible 
fields

Displays the selected fields when this transition occurs, or when the end state is 
the current state.

Not 
mandatory

Makes the selected fields optional when this transition occurs, or when the end 
state is the current state.

Not read 
only

Makes the selected fields editable when this transition occurs, or when the end 
state is the current state.

Not visible Hides the selected fields when this transition occurs, or when the end state is 
the current state.

3. Determine if you want the state transition method to be manual or automatic and open the 
appropriate section on the form.

◦ Manual: Click Create UI Action  to create a button on the task form that enables users to 
execute the transition manually. The system uses the value in the Name  field as the label 
for the UI action. The UI action executes the script in the Manual Script  field when the 
conditions are true. For example, a manual transition can create an Activate  button when an 
incident is in the New  state that enables a user to mark the incident as active.

◦ Automatic: Click Create Business Rule  to create the business rule. The business rule 
executes the script in the Automatic Script  field when the conditions are true. For example, 
a business rule created by the system can set an incident state to Assigned  when the 
Assigned to  field is populated. Business rules are automatically deleted when the state flow 
record is deleted. For more information, see Business rules .

4. Optional:  Click Create Client Script  to create the script that limits the values offered in a task 
record's State  field to valid states for that transition.

5. Configure the fields in the Field Controls  section to control how specific fields display when a 
task record changes states.

Related topics

Use state flows

State flow cleanup

The business rules, client scripts, and UI actions that the system creates automatically to perform 
custom transitions exist only while the state flow records that use them are present.

When all the state flows on a table are deleted, the system attempts to delete any unnecessary 
programming elements that were created on that table, using these criteria:

State Flow Cleanup

Element Deleted When

UI action

Business rule

Dictionary override

The state flow that created it is deleted.
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State Flow Cleanup  (continued)

Element Deleted When

Business rule that processes events 
triggered by a state flow

All state flows for the table specified that have 
events configured are deleted.

Client script (onLoad) All state flows for the table are deleted.

Client script (onChange) All state flows with field controls are deleted.

Work notes business rule All state flows with field controls or work notes are 
deleted

Related topics

Use state flows

Create a state flow

Work notes

Work notes are an important part of the state flow process and are used to communicate 
information about state transitions.

The state flow adds these work notes to the Work notes  field of any task making this transition.

These rules apply to state flow work notes:

• For a state flow with no Starting state, the work note is added every time the task transitions to 
the Ending state.

• For a state flow with a Starting state and an Ending state, the work note is added only when the 
task transitions from that starting state to that ending state.

• If two state flows with work notes have the same Ending state, but only one has a Starting state, 
the system adds the work notes from the state flow with the starting state. This better matches 
the state flow work note to the more important transition between specific starting and ending 
states.

Related topics

Use state flows

Create a state flow

Domain separation and State Flows

Domain separation is unsupported in State Flows. Domain separation enables you to separate 
data, processes, and administrative tasks into logical groupings called domains. You can control 
several aspects of this separation, including which users can see and access data.

Support level: No support

• The domain field may exist on data tables but there is no business logic to manage the data.

• This level is not considered domain-separated.

For more information on support levels, see Application support for domain separation .

Overview

Domain separation provides complete data isolation for domain-specific users.
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Related topics

Domain separation for service providers

Geolocation

The geolocation feature uses Google Maps to track users, plan efficient routes between 
locations, and assist in finding accurate travel times for applications that require this information, 
such as Work Management.

The system locates users from latitude and longitude information provided by their mobile 
devices or browsers. Tracking the location of certain users can improve business processes 
such as the completion of work order tasks. For example, in work management geolocation, 
the system updates an agent's position each time that agent updates a task record. When the 
system updates an agent's location frequently, agents and dispatchers can use features like 
auto-routing to create efficient schedules.

Geolocation features can be configured by users with the admin role.

Related topics

Geolocation Google key

Geolocation history

Location tracking

Activate geolocation

Activate geolocation

An administrator can activate the Geolocation plugin.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the Geolocation plugin (com.snc.geolocation) using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.

Note: 
When domain separation and delegated admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .

Related topics

Geolocation

Installed with geolocation

Several component types are installed with Geolocation.
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The Geolocation plugin adds a field called Geolocation tracked  to the User [sys_user]  table. 
This field allows the system to track individual users by their geographical coordinates.

Business rules installed with geolocation

Business rules are added with activation of Geolocation.

Name Table Description

GeoLocation 
Data 
updated

User

[sys_user]

Populates the Latitude  and Longitude  fields on the Geolocation 
History [geo_history] table when the Latitude  and Longitude  fields 
are updated on the User [sys_user] table.

Related topics

Installed with geolocation

Client scripts installed with geolocation

Client scripts are added with activation of Geolocation.

Name Table Description

Update 
Geolocation 
on Task

Task

[task]

Populates the Latitude  and Longitude  fields on a user record with GPS 
coordinates when that user loads any record on the Task table or a table 
that extends Task. This occurs only when geolocation tracking is enabled 
for the user.

Related topics

Installed with geolocation

Properties installed with geolocation

Geolocation provides the following configurable properties in Geolocation  > Administration  > 
Geolocation Properties.

The Google Maps plugin provides additional map properties  that are used to implement and 
control specific geolocation features. You must have a private key  for Google Maps API for 
Business to take advantage of the properties listed here.

Properties

Name Description

glide.geolocation.allow.toll.roads Allow toll roads to be used. Allows the system to use toll 
roads when auto-routing or optimizing task routes for 
agents.

• Type: True/false

• Default value: True

glide.geolocation.default.start.time Default start time for all agents when no schedule is 
set. This value sets the start time for a day other than 
the current day, when no scheduled task exists or is 
continued from the previous day. This property uses a 
24 hour clock.
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Properties  (continued)

Name Description

• Type: String

• Default value: 08:00

glide.geolocation.evening.rush.hours Evening rush hour span, formatted as 14:30-16:00. 
All times are expressed as a range, separated 
by a dash with no spaces. Times not using this 
format are ignored. This property must be used 
with the work.management.morning.rush.hours and 
work.management.rush.travel.buffer properties and 
uses a 24 hour clock.

• Type: String

• Default value: 0

glide.geolocation.history.cleanup Number of days to keep history data. ServiceNow  keeps 
agent geolocation history records for the number of 
days specified by this value.

• Type: Integer

• Default value: 30

glide.geolocation.morning.rush.hours Morning rush hour span, formatted as 06:30-08:00. 
This property uses a 24 hour clock. All times 
are expressed as a range, separated by a dash 
with no spaces. Times not using this format 
are ignored. This property must be used with 
the work.management.evening.rush.hours and 
work.management.rush.travel.buffer properties.

• Type: String

• Default value: 0

glide.geolocation.proximity Minimum distance an agent must move to be 
considered in a new location (in meters). This setting 
establishes a geolocation perimeter that prevents 
ServiceNow  from creating unnecessary history records 
when an agent has multiple tasks in the same vicinity. 
An example of this might be when an agent has several 
tasks in one building. The system assumes that all task 
activity within the specified radius is part of a single 
record and does not create additional records when the 
agent moves from task to task around the building.

• Type: Integer

• Default value: 500
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Properties  (continued)

Name Description

Note: 
The iOS  version of the app updates geolocation 
only when the mobile device detects a significant 
location change, which is determined by the your 
device's operating system. When the operating 
system updates its location, your app updates with 
that location change. Distance and time property 
values are not honored for the iOS  version of 
ServiceNow  apps.

glide.geolocation.proximity.location Maximum distance an agent can be from a specific 
location and still be placed at that location (in meters). 
This setting defines the maximum distance that an 
agent can be from a specified location and still be 
placed at that location by the system.

• Type: Integer

• Default value: 200

glide.geolocation.rush.travel.buffer Percentage to add to all rush hour travel times. The 
system uses this percentage to calculate schedules 
when auto-routing an agent. Use this property when 
both morning and evening rush hour times are defined. 
An example of a valid time buffer percentage is 15.

• Type: Integer

• Default value: 0

glide.geolocation.tracking.frequency Sets the length of the recurring interval, in seconds, 
that the system waits between attempts to update a 
user's geographic coordinates. The system updates 
geographic coordinates only for users who have 
geolocation tracking enabled.

Minimum amount of time between updating the user's 
location (in seconds). This setting defines how long 
the system waits before updating an agent's location, 
regardless of task activity or travel. This prevents 
ServiceNow  from creating unnecessary history records 
if an agent in one location views a task multiple times.

• Type: Integer

• Default value: 300

Note the following:

• The Android  version of the app updates geolocation 
data at 15 minute intervals. The app collects a user's 
location using the interval set in this property, but 
that data is still uploaded to your instance every 15 
minutes.
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Properties  (continued)

Name Description

• The iOS  version of the app updates geolocation only 
when the mobile device detects a significant location 
change, which is determined by the your device's 
operating system. When the operating system 
updates it's location, your app updates with that 
location change. Distance and time property values 
are not honored for the iOS  version of ServiceNow 
apps.

glide.geolocation.travel.buffer Percentage to add to all travel times. An example of a 
valid percentage value is 15.

• Type: Integer

• Default value: 0

glide.geolocation.work.spacing Amount of time (in minutes) to add between the end of 
a task and the travel start of the next. An example of a 
valid time value is 10.

• Type: Integer

• Default value: 0

Script includes installed with geolocation

Script includes are added with activation of Geolocation.

Name Description

GeolocationAJAX Utilities the system uses when making geolocation AJAX calls.

GeolocationUtils Core utilities for geolocation functionality.

Related topics

Installed with geolocation

Geolocation Google key

Geolocation functions in the ServiceNow AI Platform®  require a Google  Maps API for Business 
license, or a Google  Maps Javascript API Key, to enable use of Google  Maps.

The auto-routing or auto-dispatch functions in Field Service Management require this license 
or Javascript API Key to calculate precise travel time estimates. Without these values, precise 
driving times cannot be calculated, and it uses rough estimates or fixed times instead.

In System Properties  > Google Maps, enable the Geolocation feature using the appropriate 
entries from a Google  Maps API for Business license, or a Google  Maps Javascript API Key. To 
learn more, see Set up Google Maps API

Related topics

Geolocation
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Geolocation history

The Geolocation History [geo_history] table contains the history of each tracked user's location 
over time.

To view geolocation history, navigate to Geolocation  > Geolocation History. The record list 
shows time stamped location data for all users configured for geolocation tracking.

The following system properties, located in Geolocation  > Administration  > Geolocation 
Properties, control the data that appears in this table.

• Minimum distance an agent must move to be considered in a new location (in meters): 
Perimeter that defines a single location in which multiple tasks are present. This property 
prevents the system from creating unnecessary history records when multiple tasks are in the 
same general location.

Note: 
A user's geo_history will not be logged if the user remained at approximately the same 
location, even if this property is set to 0.

• Maximum distance an agent can be from a specific location and still be placed at that location 
(in meters): Distance that a user can be from a specified location and still be placed at that 
location when the system creates history data.

• Number of days to keep history data: Time period for which the system retains history data.

• Minimum amount of time between updating the user's location (in seconds): Time period the 
system waits before updating a user's location, regardless of how often the user accesses 
tasks.

Location tracking

Geolocation adds the Geolocation tracked  field to the User form. In the default view of a user 
record, select the Geolocation tracked  check box to enable location tracking for the user.

When a user has geolocation tracking enabled, the system updates the user's geographic 
coordinates whenever the user opens, or loads, a record from the Task [task] table or from a table 
that extends Task. After this initial update, the system continues to update the user's geographic 
coordinates at a recurring interval if the user does not close or reload the record. To edit the 
length of this interval, navigate to Geolocation  > Administration  > Geolocation Properties  and 
change the setting for the property  that regulates the update interval for the user's location. The 
default setting for this property is 300  seconds (5 minutes).

Note: 

• The system can update geographic coordinates only for users who have location 
services enabled in their browsers. Even users who have the Geolocation tracked  check 
box selected may be prompted by their browsers to share or withhold their location.

• A user's geo_history will not be logged if the user remained at approximately the same 
location, even if the Minimum distance an agent must move to be considered in a new 
location (in meters) property is set to 0.

Related topics

Geolocation

Service Catalog
Use the ServiceNow®  Service Catalog  application to create service catalogs that provide your 
customers with self-service opportunities. Customize portals where your customers can request 
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catalog items such as service and product offerings. You can also standardize request fulfillment 
to ensure the accuracy and availability of the items in the catalogs.

Get started

Explore

Learn about the Service 
Catalog concept, types 

of catalog items, Catalog 
Builder, and catalog items.

Configure

Configure Service Catalog. 
Learn about setup, 

categories, scoping, 
request fulfillment, and 

Service Catalog security.

Integrate

Learn about the integration 
of Service Catalog with 

other applications, such as 

ServiceNow®  Employee 

Center, ServiceNow®

Service Portal, Now® 

Mobile, and ServiceNow®

Virtual Agent.

Create a Service 
Catalog Wizard

Learn about Service 
Catalog wizards that you 
can use when the input 

required is huge and 
complex. The wizard offers 
a step-by-step experience 
for the requester and also 
provides a side panel to 
provide contextual help.

Set up catalog builder

Learn about setting 
up the catalog item 
building process.

Create or edit a 
catalog item template

Pre-specify values or 
provide restrictions for 

attributes such as catalogs, 
categories, variable 

types, and portal settings, 
which are applicable 

during the catalog item 
creation or editing process.
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Debug

Debug user criteria 
of catalog items, UI 

customizations for Service 
Catalog pages, actions 

on catalog item variables, 
performance diagnostics of 

a catalog item, and so on.

Reference

Get details about 
components like 

fields and properties.

Troubleshoot and get help

• Ask or answer questions in the Service Catalog community

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support

• Developer training

• Developer documentation

Exploring Service Catalog

You can use Service Catalog  to customize portals where your customers can request catalog 
items such as service and product offerings. You can also standardize request fulfillment to 
ensure the accuracy and availability of the items in the catalogs.

Service Catalog  overview

You can set up one or more service catalogs and provide self-service opportunities. Organize 
your catalog offerings by using the ability to publish multiple catalogs targeted to specific 
audiences.

Service Catalog  terms and roles

The Service Catalog  application uses these roles to manage different aspects of the application.

Service Catalog  terms

Execution Plans

Define how something gets delivered. For example, a PDA could go through 
procurement / activation / and installation of the desktop software.

Execution Plan Tasks

Plan Tasks represent a step in the Execution Plan, are associated with a Fulfillment 
Group, and have an approximate duration.

Fulfillment Groups

Fulfillment Groups work execution tasks. For example, one group can activate a cell 
phone while a different group installs the desktop software.
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Tickets

Tickets represent work done by Fulfillment Groups as part of an Execution Plan.

Administrator [admin]

Can manage all aspects of the Service Catalog  application, including scripting functions such as 
creating UI macros or business rules.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

Note: 
Avoid granting an admin role when more specialized roles are available.

Catalog administrator [catalog_admin]

Can manage the Service Catalog  application, including catalogs, categories, and items, but not 
including scripting functions available to administrators.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

Note: 
Avoid granting an admin role when more specialized roles are available.

Catalog manager [catalog_manager]

Can edit and update a service catalog, as well as the categories and catalog items within the 
catalog. The manager can assign editors and also a different manager for the service catalog. 
You can perform these actions only on catalogs for which you are assigned as the manager.

Contains Roles

List of roles contained within the role.

None.
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Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

Catalog editor [catalog_editor]

Can edit and update a service catalog, as well as categories and catalog items within the catalog. 
The editor can assign other editors, but cannot change the catalog manager. You can perform 
these actions only on catalogs for which you are assigned as the editor.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

Catalog builder editor [catalog_builder_editor]

Can create and maintain items in the catalog builder using the templates that the user has 
access to.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

Types of catalog items

Service Catalog  offers a few types of catalog items.

The basic Service Catalog  item types include:
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• Record producers: giving alternative ways of adding information such as Incidents via the 
service catalog.

• Order guides: to group multiple catalog items in one request.

• Content Items: catalog items which provide information instead of goods or services.

• Standard catalog items

Record Producer

A record producer is a specific type of catalog item that allows end users to create task-based 
records, such as incident records, from the service catalog.

Use record producers to provide a better end-user experience instead of using the regular task-
based form for creating records. The look and feel of a record producer is similar to that of a 
catalog item. But the record producer generates a task record such as incident, instead of a 
requested item.

You can create a record producer for tables and database views that are in the same scope as 
the record producer. You can also create a record producer for tables that allow create access 
from applications in other scopes.

Define a record producer in the service catalog or from the table record.

Note: 

• Use a record producer to create task-based records only.

• To ensure that standard service catalog processes are followed, such as initiating 
workflows as expected, do not create requested item records from record producers. 
Instead, create requested item using catalog items.

• If the record producer script aborts the record generation, no record is generated in the 
Item Produced Record [sc_item_produced_record] table.

Note: 
Do not call the update, setAbortAction method, or set the sys_class_name on 
current record to avoid unexpected behavior.

Create a record producer

You can create a record producer for tables and database views that are in the same scope as 
the record producer. Also for tables that allow create access from applications in other scopes.

Before you begin
Role required: catalog_admin or admin

About this task
An overview of record producers in the Service Catalog: what they are, and how to create them 
and define variables and templates for them.

Procedure

1. Navigate to All  > Service Catalog  > Catalog Definition  > Record Producers.

2. Click New  or select the record producer to edit.

3. Complete the Record Producer form.

For more information about the fields and their descriptions on the Record Producer form, see 
Record Producer form.
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4. To add attachments such as information and instruction documentation to the catalog item, 
see Add an attachment  .

5. Click Submit.

After you submit the form, the Variables, Variable Sets, Categories, and Catalogs  related lists 
become available.

6. Open the record again to define variables for the record producer.

Create record producers from tables

You can create Service Catalog  record producers directly from a table record.

Before you begin
Role required: admin

About this task
To create a record producer from a table record:

Procedure

1. Navigate to All  > System Definition  > Tables  and open the table record.

Note: 
When using a workflow with a Record producer, set the condition to Run the workflow.

2. Under Related Links, click Add to Service Catalog.

3. Complete the Name, Short Description, and Category  fields as you would for service catalog 
items.

4. Use the list to select the fields and the order in which you want them to appear.

5. To use container variables, select |- container start -|  and |- container end -|.
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6. Click Save and Open  to open the record producer and define additional options.
Alternatively, click Save  to return to the table record.

◦ A record producer is created with these values:

▪ Table name: table record opened in step 1

▪ Name, Short Description, and Category: information entered in step 3

◦ A variable is created for each of the selected fields with these values:

▪ Name: Column name of the field

▪ Type: Variable type that corresponds to the field type

▪ Order: Position selected in the slushbucket (for example, 100 for the first field and 200 for 
the second field)

▪ Question: Column label of the field

◦ If the field type is Choice, a corresponding question choice is created for each field choice.

◦ The new record producer is added to the Record Producers  related list on the table record.

Populate record producer data and redirect users

You can enter data for all records created by the record producer, and redirect an end user to a 
particular page after the record producer is submitted.

To enter data with a record producer, use any combination of the following methods:

• Create a variable on the record producer with the same name as the field in the target 
record. For example, a variable named caller_id on a Create a New Incident  record producer 
populates the caller_id  field on the new incident record. Use a variable type that 
corresponds to the field type.

• Define a template  to assign a static field value for all records created by the record producer.

• Define a script that uses any variable or server-side objects and functions to assign values.

◦ Use current.*FIELD_NAME*  to reference fields on the record being created.

◦ Use producer.*VARIABLE_NAME*  to reference values entered by the end user.

◦ Use RP.getParameterValue  to return specified parameter values passed on the URL. The RP 
stands for Render Properties, not Record Producer.

Redirect after submitting a record producer

To redirect an end user to a particular page after the record producer is submitted, define the 
redirect link in the Script  field using any of the following:

• producer.redirect: Enables the redirect behavior within the Platform UI.

• producer.portal_redirect: Enables the redirect behavior within Service Portal.

For example, the following code redirects users to their homepage after the record producer is 
submitted:

• Within the Platform UI:

producer.redirect="home.do";

• Within Service Portal:

producer.portal_redirect = "sp?id=sc_home"
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The following code gives the id of the record producer:

RP.getParameterValue('sysparm_id')

Order guides

Order guide submits a single service catalog request that generates several items.

For example, a New Employee Hire order guide can contain several items that new employees 
commonly need, such as business cards, computer, and cell phone. After selecting this order 
guide, the customer can then provide information about the new employee, including location 
and job title. The order guide then submits an order for catalog items like business cards, based 
on the details provided.

Order guides determine which catalog items to order by evaluating order guide rule conditions. 
Information the customer enters within the order guide can be passed as cascading variables to 
the ordered items, allowing common information to be reused across multiple items.

Administrators and catalog administrators can create order guides for the service catalog.

Order guides can be run automatically, generating a set of ordered items without needing to 
manually submit a service catalog request. For example, an onboarding workflow for a new 
employee can automatically run an order guide to order items for that employee. Order guides 
can also be configured to order the items of an order guide in a logical sequence. For example, 
you can configure your order guide to run the request for a new laptop before running the 
request for a new email.

Use the Script  field in an order guide to add or remove catalog items to or from the order guide. 
Add catalog items to the order guide form by configuring the form layout.

• To add a catalog item that is not added to the order guide via a rule base, write the following 
code in the script field:

guide.add(“<sys_id_of_cat_item>")

• To remove a catalog item that is added to the order guide via a rule base, write the following 
code in the script field:

guide.remove(“<sys_id_of_cat_item>")

Create an order guide

You can create an order guide with a two-step or three-step ordering process.

Before you begin
Role required: catalog_admin or admin

Procedure

1. Navigate to All  > Service Catalog  > Catalog Definition  > Order Guides.

2. Click New.

3. Fill in the fields as appropriate.

For more information about the fields and their descriptions on the Order guide form, see 
Order guide form.

4. Right-click the form header and click Save.

5. In the Rule base related list, define the rules that determine which items are included in an 
order.
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For more information, see Create a rule.

6. Optional:  Configure the sequence in which the items in a rule base of an order guide must be 
fulfilled by selecting the Generate sequence  button.

(Optional) For more information, see Configure a sequence to fulfill items in order guides.

7. Optional:  In the Variables  related list, define any variables required.

Configure a sequence to fulfill items in order guides

Configure a sequence in Playbooks  to fulfill items in order guides. Once you define a sequence, 
you don't have to manually check whether required items have been fulfilled before fulfilling their 
dependent items.

Before you begin
The Order Guide Sequential Fulfillment (com.glideapp.servicecatalog.order_guide_sequencing) 
plugin must be installed. Navigate to System Plugin  and search for this plugin. The plugin form 
allows you to activate or repair the plugin.

The order guide must contain at least one item in the rule base.

Role required: admin or both catalog_admin and pd_admin

About this task
A sequence can be defined for an order guide so that all the items in the order guide do not 
move to the in-progress state immediately after order guide fulfillment is started. You can 
configure when an item must be fulfilled. The requested items will remain in the pending state 
until the time order guide fulfillment reaches the point where the requested item must be fulfilled. 
Any record generated through record producers will only be generated when order guide 
fulfillment reaches the point where the record is processed.

Sequence generated for order guides with only record producers as rule base items will not be 
considered.

Procedure

1. Navigate to All  > Service Catalog  > Catalog Definition  > Order Guides.

2. Select the order guide for which you want to create a sequence in which the items must be 
fulfilled.

3. On the form, select the Generate sequence  button in the top-right corner.

4. Enter a name for the sequencing process in the Process name  field.

5. Select Generate.
The Playbooks  page is displayed on a new tab and items are added to Lane 1  according to 
their sequence in the rule base.

You can change the default name of the first lane, Lane 1, by selecting Lane actions > 
Configure lane  and modifying the name.
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6. In the lane, select an activity card for the item you want to configure.

7. Configure the activity's properties.

Activity properties

Field Description

Label Name of the rule base in the sequence.

Description Description of the activity.

When to start Determines whether the activity must be run immediately, with the 
previous activity, or after the previous activity.

Order Guide Item Item in the order guide for which the activity must be run.

End the activity 
without waiting for 
the completion of 
task record

Option to end the activity before completion of the task record. For 
example, you can select this option for an incident activity when you 
want to end the activity before the incident is closed so that the next 
activity can be started.

8. Optional:  Add a condition for an activity that is configured to run after the previous activity by 
selecting Add Condition.
The outputs (Generated Task Record, Record Id, Table) of the previous activity are available 
as options on which you can apply a condition. The Generated Task Record output is only 
available for catalog items and record producers whose target table is an extension of the Task 
table.

9. Optional:  View the configured properties of the activity by selecting View all properties.

10. Optional:  Add new items to the lane by selecting Add another process activity  and then 
select an activity in the Add activity  dialog box.

(Optional) If an order guide contains more than 20 rule base items, only the first 20 items are 
added to the first lane. You can manually add the remaining ones to the sequence by selecting 
the Fulfill Order Guide  activity in the Add activity  dialog box. Items added via order guide 
script also needs to be added manually.

11. Select Save and close.
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Note: 
If the same activity is added multiple times in a sequencing process, the activity runs only 
once when it occurs for the first time in the sequence.

12. Optional:  Create a lane to group similar catalog items by selecting Add another lane.

13. Optional:  Change the sequence of the activities by dragging the activity cards within or 
between the lanes.

14. Optional:  Determine when the lane will run by selecting an option from the When to start 
drop-down menu.

15. Optional:  View the properties of the configured sequence by selecting the Properties  button 
in the top-right corner.

16. Publish the sequencing process by selecting Activate.

Watch this six-minute video to understand how to configure a sequence to fulfill items in order 
guides.  Configure a sequence to fulfill items in order guides

Related topics

Process Automation Designer

Request an order guide

Once created, order guides present the customer with a three-step ordering process by default.

Before you begin
Role required: admin

Procedure

1. Describe Needs: Enter information as prompted.
Order guide rules evaluate this information to determine which catalog items to order.

2. Choose Options: Select configuration options for the ordered items and provide any additional 
information needed, including attachments.

3. Check Out: Review and edit item information, then click Submit Order  to place the request.
If the requested item was ordered as part of an order guide, the Order Guide  field on the 
Requested Item form shows the order guide name.

Note: 
The Check Out  step can be omitted from an order guide to provide a quicker two-step 
process. To omit this third step, select the Two step  check box when creating the order 
guide.

Review an order guide example

Consider a scenario where you have a New Employee Hire order guide that provides services 
and items as part of the onboarding process.

Before you begin
Role required: admin
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About this task

Procedure

1. Describe Needs: The order guide prompts the end user for information.

2. Choose Options: The order guide uses the information entered and predefined rules to 
generate options.

The end user selects configuration options for the ordered items, and provides any additional 
information needed.
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3. Check Out: The end-user reviews and edits item information, then click Submit Order  to place 
the request.

Create an order guide rule to add a catalog item

You can add a catalog item to an order guide using specific rules.

Before you begin
Role required: admin

About this task
Order guide rules define conditions that must be met for a specific item to be included in an 
order. For example, a New Employee Hire order guide rule can state that if the new employee job 
title is CTO or Director, and the department is IT, then add an executive desktop item to the order.

Procedure

1. Navigate to All  > Service Catalog  > Catalog Definition  > Order Guides.

2. Open an order guide.

3. In the Rule base  related list, click New.

4. On the form, fill in the fields.

Rule guide

Field Description

Guide The order guide to which the created rules are applied.

At this 
position

Tab positions are numbered in order from left to right, with the lowest number 
appearing at the left of the screen.

Application Name of the application that is being used.

If this 
condition 
is true

Conditions that must be true for this rule to apply. Create conditions using the 
condition builder  . Conditions can be evaluated against Keywords, Requested 
By, Requested For, or any variables defined for that order guide.

Include 
this item

Item to include in the order if all conditions defined in If this condition is true  are 
matched.
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Field Description

Note: 
You can also include record producers in the order guide.

Ignore 
Mandatory 
Evaluation

Option to allow customers to proceed without completing mandatory fields for 
the Describe Needs and Choose Options screens. The mandatory status of a 
field is determined by the variable defining that field.

If mandatory fields are not enforced, then relevant information is not passed on 
to the ordered items. For example, in a New Employee Hire order guide, if the 
address is not provided then this information is not included in business cards 
ordered.

Use cart 
layout

Option to use the cart layout that has been configured.

Show 
quantity

Option to display the ordered quantity of a catalog item in the Choose Options 
section when a customer requests for an order guide through the Service Portal 
or Now Mobile app.

Note: 
If the Hide Quantity  portal setting is selected while creating or editing a 
catalog item, the ordered quantity is displayed in the Summary section but 
not in the Choose Options section.

Quantity Option to select the default quantity of a catalog item for the order guide. When 
quantity is shown, this value can be modified during checkout.

5. Click Submit.

Create an order guide variable

You can create variables within an order guide.

To create or edit order guide variables, open an order guide, then select an entry from the 
Variables  related list.

Service catalog variables within order guides define the questions and potential answers 
presented to the customer while ordering. This information is used by order guide rules. 
Variables can also be cascaded, which passes the variable values along to individual ordered 
items.

Pricing is not supported for an order guide variable, even when you define the pricing for the 
variable though a variable set, and associate the variable set to the order guide.

Create an item variable assignment

Create an item variable assignment that enables the catalog admin set up a default value 
mechanism in the order guide context so that the user can focus only on required values.

Before you begin
Role required: admin

About this task
For example, you can set the default storage of an iPhone to 64 GB for Sales, and to 16 kB for 
Development. This setting is configured in the new hire order guide by using mutually exclusive 
rules and setting the storage variable accordingly for Sales and Development.
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The value for an item variable is determined in the following order:

1. Item variable assignment

2. Cascading value (if no item variable assignment exists)

3. Default value defined in the variable definition (if no cascading value or item variable 
assignment exists)

Procedure

1. Navigate to All  > Service Catalog  > Catalog Definition  > Order Guides.

2. Open an order guide.

3. Open a rule.

4. In the Item Variable Assignments  related list, click New.

5. On the form, fill in the fields.

Item Variable Assignment form

Field Description

Item 
Variable

Name of the Item variable. Select an item variable from the list or create one.

Active Check box to make the record active.

Assignment 
Type

Name of the assignment type. Select either Order Guide Variable or Value. 
When Order Guide Variable is selected, the Order Guide Variable  field is 
enabled.

Order 
Guide 
Variable

Name of the order guide variable. Select an order guide variable from the list 
or create one. (This field is only visible if Assignment Type  is Order Guide 
Variable.)

6. Click Submit.

What to do next
Set an item variable value to match an order guide variable value, or an order guide default value, 
using an item variable assignment.

Cascade an order guide variable

Cascading enables values entered for variables in the initial order form to be passed to the 
equivalent variables in the ordered catalog items.

Cascading allows values entered for variables in the initial order form to be passed to the 
equivalent variables in the ordered catalog items. For example, a variable on the initial order form 
prompts the customer to enter a delivery location value. If you enable cascading, the value for 
this variable then populates delivery location fields on each of the ordered items.

To enable cascading, select the Cascade variables  check box when creating the order guide. 
Then, create variables on the catalog items that match the names of the corresponding variables 
in the order guide. When a customer places an order, the variables on the ordered items inherit 
the values of the identically named variables in the order guide.

Use a variable set

You can use a variable set with an order guide.
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Before you begin
Role required: admin

About this task
Cascading variables require that the same variable be on both the order guide and the ordered 
items. It can be useful to define each variable once in a variable set, then assign the variable set 
to both the order guide and the individual catalog item. This approach avoids duplication and 
ensures that the variable is the same in both locations.

To use a variable set with an order guide:

Procedure

1. Create the variable set.

2. In the Variable Set form, create each variable.

3. Add the variable set to the order guide and to each catalog item involved.

Note: 
The individual variables in a variable set do not appear in the Order guide or Catalog Item 
forms. To view the variables in a variable set, open the variable set record.

Hide cascaded variables

You can hide the duplicated variables on the Choose Options  screens to keep your screen 
clean.

When cascading variables, you can hide the duplicated variables on the Choose Options 
screens, making these screens simpler.

To hide duplicate variables on all screens after the initial Describe Needs screen in the Service 
Catalog Platform UI, run an onLoad catalog client  script.

function onLoad(){
  var item = g_form.getControl("current_item");
  var guide = g_form.getControl("sysparm_guide");
 
  if (item == null && guide == null )
  return;
 
  if(item != null && guide != null && item.value == guide.value)
    return;
  g_form.setDisplay('YOUR_VARIABLE_NAME',false);
}

To hide duplicate variables on all screens after the initial Describe Needs screen in Service 
Portal, use the isOrderGuide()  method.

if(g_service_catalog.isOrderGuide())
  g_form.setDisplay(‘variable_name’, false);

Avoid enforcement of a mandatory field

You can avoid enforcing a mandatory field within tabs.

Before you begin
Role required: admin
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About this task
By default, mandatory fields must be filled in before switching tabs in the Choose Options 
section of order guides.

Order guide mandatory fields

In this example, if the customer attempts to select another tab without filling in the Street 
Address  field, a warning prompt appears. The customer cannot switch tabs without entering this 
information.

To avoid this enforcement in all order guides:

Procedure

1. Navigate to All  > Service Catalog  > Catalog Administration  > Properties.

2. Locate the property Validate mandatory fields when switching tabs in 'Choose Options' 
section of Order Guides  (glide.sc.guide.tab.validate).

3. Clear the Yes  check box.

If you make this change, mandatory fields are still mandatory, but the customer can switch 
between tabs before filling in the mandatory fields. Enforcement is then checked when the 
customer chooses to proceed to the next step.

To avoid enforcement of mandatory fields altogether, use the Ignore Mandatory Evaluation 
check box within the relevant order guide rule.

Run order guides automatically

You can run an order guide automatically from within a workflow or a server script, passing 
parameters to that order guide to define variable values.

Automatically generate a set of ordered items as part of a wider process, without needing to 
manually submit a service catalog request and reenter existing information.

For example, you can run an order guide to fulfill HR onboarding requests, passing parameters 
such as the new employee's position and department. The order guide then generates a set of 
requested items such as laptop and email account, based on those parameters.
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Related topics

Service Catalog API

Define a content item

A content item is a service catalog item that provides information instead of goods or services.

Before you begin
Role required: admin

About this task
Content items can reference knowledge articles, static blocks of text, or external web-based 
content.

To define content items:

Procedure

1. Navigate to All  > Service Catalog > Catalog Definition > Content Items.

2. Click New.

3. Fill in the form to define the item.

Content Item form

Field Description

Name, 
Category, Icon, 
Roles, Active,

As for standard catalog items.

Content type The type of information to display when a user selects the item.

◦ KB Article: a ServiceNow  knowledge article available to users with the 
specified roles.

◦ Catalog Content: a static block of text, formatted with HTML.

◦ External Content: documents or web pages stored outside the base 
system instance.

Target Location where the content appears.

◦ Within Catalog: displays the content within the catalog iframe window 
(which may not render some external websites properly).

◦ New Window/Tab: displays the content in a new browser window or tab. 
Choose this option if the content does not display properly within the 
catalog.

URL The full URL (including the prefix http:// or https://) for external content 
to display when a user selects the item. This field is available only if the 
Content type  is External Content.

Note: 
Since base system instances are accessed via HTTPS, links to 
HTTP sites could result in a mixed mode content error or warning, 
depending on browser security settings.

KB article The knowledge article to display when a user selects the item. This field is 
available only if the Content type  is KB Article.
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Field Description

Short 
description, 
Description, 
Picture

As for standard catalog items. These fields are only available if the Content 
type  is Catalog Content.

Meta Comma-separated list of tags used to search for the content item. See 
Configure keyword search for catalog items.

Hide on 
Service Portal

If selected, the content item is not available on Service Portal.

4. Click Submit.

Configure a default width for service catalog variables

Configure the default width for variables on a catalog item page to specify what percentage of 
the screen size that it can span.

Before you begin
Role required: admin

About this task
The following figure shows how the variables for the different Apple iPhone 5 options are set to 
different widths.

Page for iPhone 5 catalog item with variables of varying widths

A default width size cannot be set or does not apply to the following variables:

• The break, container end, container split, container start, and label variables.

• Any variable placed in a container with two-column layout.

• A variable set with a two-column layout.

• Any variable that is created with a custom width set in the Variable width  field on the Variable 
form. For details, see Create a service catalog variable. The custom width for the variable 
overrides the default width set for the variable type.
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Note: 
Custom variable widths are not supported in either Mobile or Service Portal.

Procedure

1. Navigate to All  > Service Catalog  > Catalog Variables  > Variable Default Size.

2. For each variable type, select a default width.

Option Description

25%
Configures the variable to span 25% of the 
available screen size.

50%
Configures the variable to span 50% of the 
available screen size. By default, some vari­
ables require a minimum of 50% width.

75%
Configures the variable to span 75% of the 
available screen size.

100%
Configures the variable to span 100% of the 
available screen size.

3. Click Save.

Define a regular expression for a variable

Define a regular expression (regex) to validate a variable value.

Before you begin
Role required: catalog_admin or admin

Procedure

1. Navigate to All  > Service Catalog  > Catalog Variables  > Variable Validation Regex.

2. Click New.

3. On the form, fill the fields.

Field Description

Name Name of the regular expression.

Validation 
message

Message that appears when the validation fails.

Active Specifies if the regex is active.

Regular 
Expression

Sequence of characters that define the format of the variable value.

For example:

◦ Invalid Regex: /(((ftp|http|https):\/\/)|(www\.))([-\w\.\/ $\?=+@&%_:;]+)/i

◦ Valid Regex: (((ftp|http|https):\/\/)|(www\.))([-\w\.\/ $\?=+@&%_:;]+)
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Field Description

Note: 

◦ Ensure that the regex does not cause catastrophic backtracking.

◦ You should not use embedded flag expressions.

◦ Use the Regex Flag  list for the ignore case.

Regex Flag Character set that is considered while validating the regular expression.

◦ None: No regex flags are applied.

◦ Case Insensitive: Enables case insensitive matching. Case insensitive 
matching assumes that only characters in the US-ASCII charset are being 
matched. Unicode-aware case-insensitive matching can be enabled by 
selecting Both  as the regex flag.

◦ Unicode Case: (Reserved for future use) Same behavior as None.

◦ Both: Case insensitive matching is done in a manner consistent with the 
Unicode Standard.

4. Click Submit.

Related topics

Create a service catalog variable

Pass variables between tasks

Pass variables from one step of the fulfillment process to another.

Before you begin
Role required: admin

About this task
Variables can be processed by any workflow or execution plan that is associated with the 
requested items.

Note: 
To pass a variable between tasks, select the Global  check box when you create a Service 
Catalog variable.

For example, consider the following tasks within the fulfillment process for a New PC catalog 
item.

Procedure

1. Procure a PC.

2. Install corporate standard software.

3. Set up email account.

4. Deliver and set up PC for requester.
Step 4 may require a piece of information from step 3 (the email account credentials for setting 
up email on the PC). If steps 3 and 4 are executed by different fulfillment groups, you can use 
variables to make this information visible in the tasks for steps 3 and 4. You can then pass 
the information between groups so that the second group can access the email account 
credentials.
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Create or edit a catalog item

Define individual catalog items using Service Catalog. You can create, edit, and copy catalog 
items.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Service Catalog  > Catalog Definition  > Maintain Items.

2. Click New.

3. On the Catalog Item form, fill in the fields.

For more information about the fields and their descriptions on the Catalog Item form, see 
Catalog Item form.

4. Click Submit.

What to do next

• Assign the item to additional catalogs and categories, if required.

• Define variables  for the item, if applicable.

• To add attachments such as information and instruction documentation to the catalog item, 
see Add an attachment .

Here are some additional topics that might help.

• Create a service catalog variable

• Apply user criteria to items

• Set a recurring price

Edit a catalog item

Catalog administrators can edit an item from the service catalog listing. Catalog managers and 
catalog editors can also edit an item if they are assigned to the item.

Before you begin
Role required: admin

About this task
To edit a catalog item from the service catalog listing:

Procedure

Right-click the header and select one of the following options:

• Configure Variables: Add or remove variables from an item.

• New Variable: Create a new variable for the item.

• Configure Item: Edit the item definition.

• Configure Client Scripts: Edit the catalog client scripts for the item.

• Configure UI Policies: Edit the catalog UI policies for the item.
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Copy a catalog item

Copy an item to create a full duplicate of the item, including the item details, attachments, 
variables, client scripts, and approvals.

Before you begin
Role required: admin

About this task
Copying can be more useful than using the Insert function because the function only copies the 
item details.

Procedure

1. Open a catalog item form.

2. Use the Copy  button to create a new copy of a catalog item, named Copy of [item name].

Note: 

◦ If you copy an active catalog item, the copy is also active. Consider deactivating the 
copy by clearing the Active  check box until your changes are complete.

◦ When you specify a table in the Relationship tables which should be part of the 
Copy Item Action. Table names should be comma separated  property in the Service 
Catalog  > Catalog Administration  > Properties  page, the table records that have a 
reference to a catalog item are also copied. It is applicable only when you copy the 
catalog item using the Copy  UI action. Table names should be comma-separated 
without any spaces.

Add a catalog item

Service catalog enables you to add a catalog item to multiple catalogs and categories.

Before you begin
Role required: admin

About this task
A catalog item may be available in more than one catalog and category. For example, a laptop 
carrying case can be available from both Laptops and Cases and Accessories categories.
Within an item:

• The Catalogs related list defines the catalogs where the item is available.

• The Categories related list defines the categories where the item is available.

Procedure

To assign an item to another category or catalog, enter the new details in the appropriate related 
list.

Note: 
The values in these lists override the values of the Catalogs   and Category  fields in the 
catalog item form. If you change values for either related list, these changes automatically 
update the values in those fields.

Share catalog items across catalogs

You can share a catalog item, enabling users to order that item from different catalogs. For 
example, you can share a Password Reset item across catalogs serving different teams.
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Before you begin
Role required: admin

About this task
To share a catalog item across several catalogs:

Procedure

1. Navigate to All  > Service Catalog  > Catalog Definition  > Maintain Items

2. Open the item to share.

3. Select the additional catalogs for that item in the Catalogs  field.

Shared Catalog Item
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4. Select Update.

The shared item then appears in the Catalog Items related list for each catalog selected.

Service Catalog for managers and end users

Every user with a login can view and order items from the Service Catalog from departments 
within your organization. These catalog items can include goods, services, and information.

Anything that can be ordered individually can be ordered as a catalog item. Anything that only 
exists as a part of a larger whole cannot be a catalog item. For example, a laptop can be a catalog 
item, but a high-resolution display for a laptop cannot.

After placing an order, its progress can be tracked by the requester. Fulfillment groups complete 
a predefined series of tasks in a fulfillment process that includes required approvals.

Managers can review record history and run reports to improve the service catalog process. For 
example, the manager can see most commonly ordered items, or those that are on backorder.

Service Catalog home page

The home page for a service catalog lists the goods and services available to order from that 
catalog.
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Catalog items are grouped into categories, which can also contain one or more subcategories. 
By default, the first 10 items in a category appear under the category name on the service catalog 
home page.

To access the default service catalog home page, navigate to Self-Service  > Service Catalog.

Service Catalog home page

Click a category name to see a list of all subcategories and items in the category.
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Service Catalog Subcategories and Items

Searching a service catalog

If your organization has multiple service catalogs, you can search for the required catalogs 
using the Search  field. The search results list items in active categories along with their short 
description.

Note: 
If your organization has multiple service catalogs, searches return results only from the 
currently viewed catalog.

To find a specific item in a catalog, use the Search  field. Click the down arrow to see a list of 
previous searches. Catalog search is available on catalog and category pages.

Service catalog search field
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Search results list items in active categories along with their short description. Use the 
breadcrumbs in the header bar or below the short description to quickly navigate to a different 
page. The Found In  list shows the categories related to the search results in hierarchical format.

Service catalog search results

You can control the number of results shown on one page with the search results selection list.

Search results selection list

In the catalog listing, click a link in the breadcrumbs at the top of the screen to quickly navigate 
back one or more levels in the hierarchy.

To remove the search term from the breadcrumbs, click the x  next to the term.

If a search returns multiple results, obtain details about a specific catalog item by clicking 
Preview.

Note: 
The system performs the type-ahead search based on keywords only.

Related topics

Service Catalog for managers and end users

Service Catalog request screens

To place a request from a service catalog, navigate to the catalog home page and select the item 
to order.

When an item is ordered, the base system generates a request to track the order and displays a 
summary that includes the order status in the Stage  column:
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Service Catalog Request Status

Each individual catalog item in a request creates a discrete request item. For example, a request 
for 2 PCs, 1 chair, and 1 desk would produce four request items on a single request.

Shopping cart screens

The shopping cart screen displays previews of the cart immediately before an order is placed.

You can configure the layout for either the one-step or two-step catalog checkout process.

Order status screens

The order status screen is the final summary screen a user sees in the service catalog after 
placing an order successfully.

Request generation for a Service Catalog item

When a customer orders something from the catalog, a request is generated to track the order.

The user specified in the Opened By  field of a Requested Item (sc_req_item) record has read 
access to it.

Service catalog request

Each individual catalog item that is part of a request creates a discrete request item with the 
request.

For example, a request for 2 PCs, 1 Chair, and 1 Desk would produce:
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• Request REQ0000001 -- 4 Things

◦ Requested item RITM0000001 -- 2 X PC

◦ Requested item RITM0000002 -- 1 X Chair

◦ Requested item RITM0000003 -- 1 X Desk

After a service catalog request is submitted, a fulfiller may determine that the item is not in stock. 
The full filler can select the Backordered  check box, and enter comments about when the item 
may be back in stock. The backorder status can be used in reports and dashboards.

If a service catalog request is canceled, all associated purchase orders and transfer orders that 
have not been received are canceled.

Related topics

Service Catalog home page

Clone a request

You can clone a request for up to 10 users on the notification list.

Before you begin
Your admin must enable cloning of requests before you can clone a request. For more 
information, see Clone requests.

Role required: admin

About this task
When you clone a request that contains a multi-row variable set, the information that is specified 
in the multi-row variable set is available in all cloned requests. All UI policies and client scripts on 
the multi-row variable set are also cloned.

Procedure

1. Create a Service Catalog  request.

2. On the checkout page, enter the users for whom to copy the request, up to a maximum of 10, in 
the Copy this Request for:  reference fields.

3. Click Order Now.
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View catalog item audit history

You can view the audit history of changes to items you requested. For example, you can view 
changes to variable values to find out who made the changes. Fulfillers and administrators can 
view history for any requested item.

Before you begin
Role required: admin (history list or calendar), itil (calendar only)

Procedure

1. Complete one of the following actions for the history to view.

Option Description

View history for your requested items
Navigate to Self-Service  > Requested Items 
and open the item you requested.

View history for any requested item
Navigate to Service Catalog  > Open Records 
> Items  and open the requested item to view.

2. Open the form context menu and select History  > Calendar, or History  > List  (with 
permission).
The history calendar shows you the days where the record was changed, who made the 
change, and when. The history list displays each change in a list view. History records of 
variables are prefixed with "VARIABLE:."

3. Click the day number to get a view of the changes for that day, or click the week number to get 
the week view.

Saving catalog items to a wish list

You can save catalog items to your wish list and visit them later to complete the ordering process.

For example, you need a laptop with specific software installed on it. Add the laptop to your wish 
list, then visit it when you have the complete software configuration list. Data you enter is saved 
when you add items to your wish list.

Users with catalog_admin or admin role can enable/disable the wish list feature and configure 
the wish list cart  for end users. By default, the wish list is always disabled for a catalog.

To enable the wish list feature for catalog end users, select the check box for Enable Wish List  in 
the catalog record.

The wish list feature does not function if the property glide.ui.doctype  is set to false.

Catalog homepage displaying wish list feature
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Note: 
When the wish list feature is disabled for a catalog, any items in its wish list are deleted. 
The items in the wish list are retained only if the item is associated with another wish list-
enabled catalog.

Working with wish lists

To save an item to your wish list, click Add to Wish List  on the catalog item page. A pop-up dialog 
informs you that the item is added to your wish list. Duplicate entries of an item are not added to 
your wish list. If you try to add an item that is already in your wish list, the latest entry of that item 
gets updated in the wish list.

Wish list popup dialog

To access your wish list of catalog items, click View Wish List  on the popup dialog. You can also 
click the link to wish list items on the header. The wish list cart  allows you to update or delete 
wish list items.

To update a wish list item, go to wish list cart and click View  for the item. Change the information, 
and then click Update  to save the changes. To proceed with ordering the item, click Add to Cart. 
The item is removed from your wish list and added to the shopping cart for final checkout.

Service Catalog  customization

Service Catalog  enables you to customize the catalog in various ways.

No updates are supported on the following internal service catalog tables, either directly or 
through business rules.

• Options [sc_item_option]

• Variable Ownership [sc_item_option_mtom]

• Question Answer [question_answer]

• Item Produced Record [sc_item_produced_record]

• Multi Row Question Answer [sc_multi_row_question_answer]

Cart layout

Service catalog enables catalog administrators to configure the layout and functionality of the 
service catalog cart used in your organization to place requests for catalog items.

You cannot check out a cart item that is no longer available.

You can perform the following:

• Remove components. For example, hide prices throughout the cart if your catalog does not 
use pricing.

• Change labels. For example, change the Order now  button label to Request Item  in the 
shopping cart.
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• Change the order of elements. For example, change the order of the columns on the order 
status screen.

• Configure, hide, or create functionality. For example, add a Requested For  reference field to 
the shopping cart.

Configure the cart layout

Configure cart layout records to define functionality for widgets or screens in the shopping cart.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Service Catalog  > Catalog Definitions  > Maintain Cart Layouts.

2. Select a widget or screen.

◦ Cart widgets: Item Ordering Widget, Shopping Cart Widget, or Item Ordering Widget (Order 
Guide)

◦ Preview screens: Cart Preview Screen, Cart Preview Screen (Two Step), Cart Preview Screen 
(Wish List), or Cart Preview Screen (Classic Mobile)

◦ Order status screens: Order Status Screen or Order, Status Screen (Classic Mobile)

3. Update the Title  field to change the title that appears on the widget.

4. Leave the default Target  value.
Do not change this value because it identifies the cart element being defined.

5. Update the other sections of the cart layout record, as required.
The availability of these sections varies for each widget and screen record.

◦ In the Components  section, select the components to display, such as delivery times, item 
descriptions, and prices.

◦ In the Columns  section, select which columns to display, such as the item description 
column, delivery time column, or price column.

◦ In the Buttons  section, select the buttons to display, such as Add to Cart, Edit Cart, and 
Delete Item.

◦ In the Button Labels  section, enter new labels to replace the default button labels.

A new label is used on all screens that the button appears on. For example, the Continue 
Shopping  button is used on several screens, so changing its label affects all those screens.

6. If required, configure the widget and column macros.

7. Save the record, and then test the results of your configuration by ordering items from your 
service catalog.

Some settings and properties in your instance can override or affect your cart layout.

Cart layout considerations

When you enable cart layouts, service catalog properties are impacted. Consider the possible 
outcomes and alter the settings or properties to achieve the cart layout and functionality you 
require.
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Some of these properties are impacted when you use cart layouts. For example, with the 
order status screen, the When to show prices and sub-totals on the Service Catalog Cart 
(glide.sc.price.display) property overrides cart layout settings for displaying prices.

Table title

Property Impact

Allow ESS users the option to 
cancel their requests from the 
checkout screen.

[glide.sc.checkout.cancel]

Overridden when the Cancel Request  check box in cart 
layout settings is selected. If this check box is selected, 
the Cancel  button is displayed even if the property is set 
to No.

Enable cloning requests during 
checkout.

[glide.sc.allow.checkout.clone]

Not used (deprecated) if cart layouts are enabled. 
Replaced by the Clone Checkoutcheck box in cart layout 
settings.

The Clone Checkout  check box is cleared by 
default for new instances. For upgraded instances, 
the check box is set to the existing value of the 
glide.sc.allow.checkout.clone property.

List of roles (comma-separated) 
that can use the quantity selector 
in the shopping cart

[glide.sc.allow.quantity]

Overrides any relevant cart layout settings.

Show the request item number 
for each line item on the checkout 
screen (default false).

[glide.sc.checkout.request.number]

Not used (deprecated) if cart layouts are enabled. 
Replaced by the Request Item Number column  check 
box in cart layout settings.

Show the 'Back to Catalog' button 
on the two-step checkout screen.

[glide.sc.checkout.twostep.back]

Not used (deprecated) if cart layouts are enabled. 
Replaced by the Back to Catalog  check box in cart layout 
settings.

When to show prices and subtotals 
on the Service Catalog Cart.

[glide.sc.price.display]

Overrides any relevant cart layout settings.

Configure widget and column macros

Configure macros that define functionality for elements within each widget or screen.

Before you begin
Role required: admin

About this task
Some widgets or screens also have column macros that define the horizontal layout and 
configuration of shopping cart contents.

You can configure these macros to alter the display order of elements, or hide elements, within 
the widget or screen. You can also create new macros to implement any extra requirements.
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Procedure

1. Navigate to All  > Widget Macros  > Column Macros  related list.

2. Click the order number entry of a macro to edit its display order, or to activate or deactivate it.

3. Click Update.

4. Click the Widget / View Macro  entry of a macro to view its functionality settings.
You cannot edit functionality settings for default macros, but these settings can be a useful 
reference for creating your own widget macros.

Create macros for cart layout

Create macros for cart layout records using Jelly scripts to define customized behavior and 
display within a widget or screen.

Before you begin
Role required: admin

About this task
Macros that you create do not affect upgrades because customized widget functionality is 
isolated from general cart behavior.

Procedure

1. Open the relevant cart layout record.

2. Navigate to Widget Macros  or Column Macrorelated list.

3. Click New.

4. Enter details for the macro.

Macro form

Field Description

Name The name for the new macro.

Active A check box to indicate whether the macro is displayed or not.

Description A summary of how the macro is used.

Active A check box to indicate whether the macro is displayed or not.

XML The Jelly script to apply for your macro.

5. Save the macro record.
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Example:
This example demonstrates the script to add a Requested for reference  field as a widget macro 
to a cart layout record.

<?xml version="1.0" encoding="utf-8" ?>
<j:jelly trim="false" xmlns:j="jelly:core" xmlns:g="glide" 
 xmlns:j2="null" xmlns:g2="null">
    <j:set var="ref" value="sc_cart" />
    <j:set var="jvar_ref" 
 value="${jvar_cart.getRequestedFor()}" />
    <j:set var="jvar_ref_display" 
 value="${jvar_cart.getRequestedForDisplayName()}" />
    <tr>
        <td colspan="3">
            ${gs.getMessage('Requested for')}:
        </td>
    </tr>
    <tr>
        <td colspan="3" style="padding: 4px;">
            <g:catalog_requested_for />
        </td>
    </tr>
</j:jelly>

Configure cart layout for specific items

Set fields in the Catalog Item form to configure the cart layout for specific items.

Before you begin
Role required: admin

About this task
Overrides any general cart layout settings. For example, you can hide the price of an item by 
setting the Omit price in cart  field to true  for that item.

Procedure

1. Navigate to All  > Service Catalog  > Catalog Definition  > Maintain Items.

2. Select the catalog item.

3. Configure the form to add both Use cart layout  and any of the following item configuration 
fields you require:

◦ Omit price in cart

◦ No cart

◦ No order

◦ No order now

◦ No proceed checkout

◦ No quantity

4. Clear the Use cart layout  check box to display the configuration fields for that item.

5. Set the item configuration field values as required.
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6. Click Update.

Override cart layouts for items

Service catalog enables you to use additional methods to configure cart behavior or layouts, 
which override cart layout record settings.

For example, your cart layout record settings can hide item prices, but you might decide to 
display the price of the Sales Laptop. In that case, you would set the relevant configuration 
values on that catalog item. Be aware of the impact of these additional methods, to ensure that 
your cart behaves in the way you want.

Note: 

If you are migrating to cart layouts, you can have defined additional settings and properties 
that impact your cart layout settings.

Configure Service Catalog  cart widgets

You can configure widgets for the shopping cart, catalog items, and order guides.

Before you begin
Role required: admin

About this task
Overview of configurable options in the Service Catalog on the Service Portal and explains how 
to perform those configurations.

Configure order guide widgets

You can customize the widget that provides details of the current catalog item on an order guide 
or wizard.

Before you begin
Role required: admin, catalog_admin

About this task
Order guide cart widget is visible when an order guide item is ordered.

Procedure

1. Navigate to All  > Service Catalog  > Catalog Definitions  > Maintain Cart Layouts.

2. Open the Item Ordering Widget (Order Guide)  record.
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3. You can add/remove components and rename widget title.

4. Click Update.

Cart widget displayed for an order guide item

Note: 
By default, order guides use a two-step process, and catalog items use a one-step 
checkout process. If you configure the checkout process, keep in mind that order guides 
and catalog items provide different cart experiences if they use different checkout 
processes.

Configure catalog item widgets

You can customize widgets that appear for catalog items.

Before you begin
Role required: admin, catalog_admin

About this task
Both shopping cart and item ordering widgets are visible on the standard catalog page and any 
ESS catalog page. The shopping cart widget is also available in additional locations, such as the 
catalog homepage.

Procedure

1. Navigate to All  > Service Catalog  > Catalog Definitions  > Maintain Cart Layouts.

a. Open the Item Ordering Widget  record to modify the widget for ordering item.

b. Open the Shopping Cart Widget  record to modify the widget for shopping cart.

2. You can add/remove components, buttons, rename widget title and button labels.
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3. Click Update.

Item ordering and shopping cart widgets

Configure Service Catalog  preview screens

You can configure shopping cart preview screens for the one-step and two-step carts, for the 
wish list, and for the Classic Mobile app.

Configure the wish list screen

Using Service Catalog, customize the cart preview screen for wish list items.

Before you begin
Role required: admin, catalog_admin

About this task

Procedure

1. Navigate to All  > Service Catalog  > Catalog Definitions  > Maintain Cart Layouts.

2. Open the Cart Preview Screen (Wish List)  record.

3. You can add/remove components, columns, buttons, and rename labels.
For more information, see Configure cart layout.
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4. Click Update.

Cart preview screen for wish list items

Configure Classic Mobile shopping cart screen

Using Service Catalog, customize the shopping cart screen that is displayed on mobile devices.

Before you begin
Important: 

Mobile Classic Is Deprecated!

The App Has Been Removed From The Stores And Can No Longer Be Activated. We Are 
Not Offering Enhancements, Bug Fixes, Or Support For The App. See ServiceNow Classic 
Mobile App Deprecation Effective September 15, 2022.

Role required: admin, catalog_admin

About this task
The shopping cart on Classic Mobile devices always uses a two-step checkout process. You 
cannot modify widget macros or button labels on Classic Mobile devices.

Procedure

1. Navigate to All  > Service Catalog  > Catalog Definitions  > Maintain Cart Layouts.

2. Open the Cart Preview Screen (Classic Mobile)  record.

3. You can add/remove components and buttons.
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4. Click Update.

Shopping cart screen on Classic Mobile

Configure a one-step shopping cart screen

Using Service Catalog, customize the shopping cart display screen for a one-step checkout 
process.

Before you begin
Role required: admin, catalog_admin

About this task
One-step checkout is the default checkout process for catalog items.

Procedure

1. Navigate to All  > Service Catalog  > Catalog Definitions  > Maintain Cart Layouts.

2. Open the Cart Preview Screen  record.

3. You can add/remove components, columns, buttons, and rename title and button labels.
See Configure cart layout.
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4. Click Update.

Shopping cart screen displayed for default one-step checkout process

Configure a two-step shopping cart screen

Using Service Catalog, customize the shopping cart display screen for a two-step checkout 
process.

Before you begin
Role required: admin, catalog_admin

About this task
Changes made to the two-step record are visible only if the two-step checkout process is 
enabled  in properties. By default, catalog items use a one-step checkout process.

Procedure

1. Navigate to All  > Service Catalog  > Catalog Definitions  > Maintain Cart Layouts.

2. Open the Cart Preview Screen (Two Step)  record.

3. You can add/remove components, columns, buttons, and rename title and button labels.
For more information, see Configure cart layout.

In the Components  tab, both Shipping Location  and Shipping Address  are not supported 
simultaneously. Deselect the selected component to select the other component.

If you enable Shipping Address  in the Components  tab, the editable Shipping address  field is 
displayed in the cart preview screen. If you enable Shipping Location  in the Components  tab, 
the editable Shipping location  field and a read-only Shipping address  field are displayed in 
the cart preview screen.

4. Click Update.
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Shopping cart preview screen for a two-step checkout process when shipping 
address in enabled

Shopping cart preview screen for a two-step checkout process when shipping 
location in enabled

Configure Service Catalog  status screens

You can configure shopping cart status screens for desktop and Classic Mobile orders.

Configure desktop order status screen

Using Service Catalog, customize the order status screen that is displayed on desktops.
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Before you begin
Role required: admin, catalog_admin

Procedure

1. Navigate to All  > Service Catalog  > Catalog Definitions  > Maintain Cart Layouts.

2. Open the Order Status Screen  record.

3. You can add/remove components, columns, buttons, and rename labels.
See Configure cart layout.

4. Click Update.

Order status screen on a desktop

Configure Classic Mobile order status screen

Using Service Catalog, customize the order status screen that is displayed on Classic Mobile 
devices.

Before you begin
Role required: admin, catalog_admin

About this task
You cannot modify widget macros or button labels on Classic Mobile devices.

Procedure

1. Navigate to All  > Service Catalog  > Catalog Definitions  > Maintain Cart Layouts.

2. Open the Order Status Screen (Classic Mobile)  record.

3. You can add/remove components and buttons.
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4. Click Update.

Order status screen on Classic Mobile

Migrating to cart layouts

Service catalog enables you to configure cart layouts to add, remove, or change elements of the 
service catalog shopping cart. Before you migrate your system to use cart layouts, familiarize 
yourself with existing configurations for catalog content and decide whether to discard or retain 
these configurations.

This feature is enabled by default in new instances and the default cart layout settings are 
implemented. For upgrades, an upgrade script checks to see if your current cart macros are 
customized. Only a user with an admin role can migrate cart layouts.

• If cart macros are not customized, cart layout configuration is enabled by default.

• If cart macros are customized, cart layout configuration is disabled. Migrate your system to use 
this feature.

Cart configuration settings

Check your current configurations for:

• UI macros defining custom shopping carts that have been linked to items.

• Service catalog properties impacted by cart layouts.

• Item-specific settings that can override cart layout record settings.

Item-specific settings

Some catalog items can have cart layout settings that are specific to them.
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For example, these items can show prices even though the general cart layout record settings 
hide prices.

To retain item-specific settings, clear the Use cart layout  check box in the catalog item form.

Item-specific settings

Note: 
You can configure the form to display the Use cart layout  check box.

Migrate customizations and enable cart layouts

Move customization to cart layout widgets, and then enable cart layouts.

Before you begin
Role required: admin

About this task
When you customize a few UI macros, you should migrate the customizations to cart layout 
widgets before you enable cart layouts.
Following are the UI macros whose customizations need migration before you enable cart 
layouts:

• sc_catalog_homepage_cart

• sc_catalog_requested_for

• catalog_item

• catalog_cart_default

• sc_cart_main

In addition, if you have customized the com.glideapp.servicecatalog_category_view UI page, or 
the Catalog Cart dynamic content, you must migrate these customizations before you enable cart 
layouts.
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Procedure

1. Save copies of the customizations for later reference.

2. Revert the customizations to restore the customized macros or other content to their standard 
state.

3. Remove the record for the customization from the Customer Update [sys_update_xml] table.

4. Run the following script in Background Scripts to set the property and set the correct state for 
all the items in the catalog:

var cm = new 
 CartLayoutMigration();cm.configureLayoutProperty();cm.setLayou
tFalse();cm.setEmptyLayout();

5. Reimplement any cart layout customizations that you want to maintain in the upgraded 
instance by configuring widget macros.

6. To enable cart layouts, set the service catalog system property 
glide.sc.use_cart_layouts  to Yes.

Legacy flexible checkout and delivery forms

ServiceNow  includes several options that provide administrators some control over content in 
service catalog template-driven forms.

Some service catalog forms, such as the checkout form, are generated from templates, instead of 
being data-driven like other forms in the system, such as the Incident form.

Template-driven forms provide enhanced look-and-feel over standard data-driven forms, but 
they provide more limited control over the form content.

Note: 

It is recommended that you use cart layout records to configure cart layouts. Using cart 
layout records lets you configure the service catalog cart without writing and maintaining 
scripts.

Modifications in the delivery screen

In the final checkout step, a summary screen provides a list of all items and services ordered.

Warning: 
Modifying the Order Status or Summary screen requires advanced scripting and a 
knowledge of Jelly . Also, the upgrade process skips updates to the summary screen after 
a customization. With these constraints in mind, you can modify the summary screen by 
editing the com.glideapp.servicecatalog_checkout_view  UI page.
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Catalog order summary status

Requester search results

After you enable the two-step checkout process, the Requested for  field appears on the Request 
form.

The Requested for  field references the User [sys_user]  table and has an auto-complete 
feature. Two service catalog properties (Service Catalog  > Catalog Administration  > Properties) 
enable an administrator to add columns to the search results for this field and to order the list by 
one of the columns.

Service catalog properties

Property Description

Additional columns for the "request for" 
Service Catalog widget.

(glide.sc.request_for.columns)

Choose fields from the User [sys_user]  table. 
Must be semicolon separated.

Ordering of matches for the "request for" 
Service Catalog widget.

(glide.sc.request_for.order_by)

Choose fields from the User [sys_user]  table.

Modifications in the checkout form

You can modify the checkout form to use an alternate description field or to add request item 
number for each line.

By default, the checkout forms list the Description, Delivery Date, Stage, Price, Quantity,  and 
Total  columns. An example of default checkout form is shown:
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Checkout default

Add the request item number on checkout form

Add the request item number to display this number as an extra column on the checkout form. By 
default, the request item number is not displayed in the list.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Service Catalog  > Catalog Administration  > Properties.

2. Locate the property: Show the request item number for each line item on the checkout 
screen (default false).

3. Select the Yes  check box to add the number column to the checkout form.

Checkout number

Use an alternate description field on the checkout form

Use an alternate description field to describe your category item in the checkout form. By default, 
the short_description  column of the catalog item appears as the item description.

Before you begin
Role required: admin
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Procedure

1. Navigate to All  > Service Catalog  > Catalog Policy  > Properties.

2. Locate the property Field name to use for the description column of the checkout form. If 
blank, the default (short_description) is used.

3. Enter the name of the alternative field (a column in the Catalog Item [sc_cat_item]  table) 
and save it.
For example, if you've selected name:

Checkout name

Define item quantity choices

In the Service Catalog, the default quantity choices are 1–10. You can configure the quantity 
selector with additional choices. This configuration is also applicable in Service Portal.

Before you begin
Role required: admin

About this task

Procedure

1. Navigate to All  > System Definition  > Choice Lists.

2. Search for the table sc_cart_item  and the element quantity.
The existing quantity choices appear.

3. Add quantity choices, modeling them after the existing ones.
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To reduce the quantities available for catalog items, delete the relevant quantity records. For 
example, to reduce the quantity range to 1-3, delete the records for 4 and 5.

To restrict the roles allowed to change quantities, edit the List of roles (comma-separated) 
that can use the quantity selector in the shopping cart  (glide.sc.allow.quantity) 
service catalog property. For example, you can limit this ability to the admin and catalog_admin 
roles.

Related topics

Service Catalog administration

Remove item restrictions

Service Catalog  enables you to remove or apply restrictions on all order guides, record 
producers, and wizard launchers.

Before you begin
Role required: admin

About this task
Catalog administrators can use Service Catalog  properties to configure the behavior and usage 
of a catalog item.

By default, all order guides, record producers, and wizard launchers have these restrictions:

• They cannot be added to a requested item

• They do not provide a Try It  action

• They are not added to the cart as items

To remove these restrictions or apply these restrictions to other types of items:

Procedure

Modify the comma-separated lists of tables in the following properties:

• List of class names for catalog items that cannot be added to an existing 
request(glide.sc.item.cannot_add_to_request): restricts the items that can be 
added to a requested item, after an end user places a request. For example, to restrict content 
items from being added to an existing request, add sc_cat_item_content to the list for this 
property.

• List of class names for catalog items that do not use the default "Try It" UI 
Action(glide.sc.item.cannot_try_it): restricts the items which allow you to click Try 
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It  on the item form to preview how it appears in the service catalog. Items with such restrictions 
do not display Try It  on the form.

• List of class names for catalog items that do not generate a normal cart 
item(glide.sc.item.not_normal_cart_item): restricts which item types are added 
to the cart by default.

Using variables for price setup

You can define a price for every service catalog item. The price or recurring price of a catalog 
item can be modified with variables, increasing the base price for that item.

This pricing is useful if you want the price or recurring price dynamically calculated based on 
how a user completes the ordering form. For example, the cost of an item can be increased 
based on options the user selects, such as extra memory in a PC.

The following variable types  can be configured to modify the total cost of an item:

• Check box

• Multiple choice

• Reference

• List collector

• Select box

• Lookup select box

Check box

A check box variable helps to set the price or recurring price of the item being ordered.

You can Create a check box variable  and set the price of the item. Use the Price if checked  or 
Recurring price if checked  field to specify the price or recurring price difference for that variable 
when the option is selected.

Under the Type Specifications  tab, you can specify the price in different currency types. Also, 
you can configure the price in the following pricing models:

• Calculated

• Fixed

• Multiple

For information on the pricing models, see Price fields  .

Multiple choice

For a multiple choice variable, there are two options for pricing.

• Specify the price difference in the Price  field on the question choices.

• Specify the recurring price difference in the Recurring Price  field on the question choices.

Note: 
Select boxes operate the same as multiple choice variables but are displayed as select 
boxes.

Reference

A reference variable includes a Pricing implications  field.
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If this field is selected and there is a price, u_price, recurring_price, or u_recurring_price 
field on the referenced table, the value of that field is used to modify the cost of the item being 
ordered when a reference value is selected.

For example, suppose that computers in Phoenix cost $100 more than the ordering price, and 
computers in Boise cost $100 less than the ordering price.

1. Set up a reference variable to the Location [cmn_location] table.

2. Put a u_price  field on the Location table.

3. Set that field to 100  for the Phoenix location.

4. Set that field to -100  for the Boise location.

When ordering a computer, if Phoenix  is selected as the location for this variable, the ordering 
price is increased by $100. If Boise  is selected, the ordering price is decreased by $100.

Note: 
List collectors operate the same as a reference variable, but use the List table  field to 
specify the table being referenced. Since it is a list collector variable, multiple selections 
can be made that all modify the ordering price or recurring price.

Lookup select box

A lookup select box variable is more powerful than a reference variable.

Specify the following when creating a lookup select box variable:

• Lookup from table: the table from which values are queried.

• Lookup value field: the field on the lookup table whose value is used as the value of the 
variable (typically sys_id).

• Lookup label field(s): a comma-separated list of fields on the lookup table whose values 
are used to display the selections in the select box. For example,manufacturer,name  for the 
Software [cmdb_ci_spkg] table would display selections as:

◦ Microsoft | Excel

◦ Adobe | Photoshop Elements

• Lookup price field: the field whose value is used to modify the price of the item being ordered.

• Lookup recurring price field: the field whose value is used to modify the recurring price of the 
item being ordered.

Set a recurring price

A catalog item can have a recurring price in addition to an initial price.

Before you begin
Role required: admin

About this task
The price and the recurring frequency are set on the catalog item record. After the price and 
frequency are set, the recurring price appears in the catalog, catalog search results, catalog 
page for the item, shopping cart, and order summary screen.

For example, a subscription to a mobile phone contract could cost $500.00, with a $30.00 
monthly recurring price.
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If multiple items with the same recurring price frequency are placed in the shopping cart, they 
are grouped. The grouping makes it easier to view how much items cost for each frequency (for 
example, weekly, monthly, and annually). If the shopping cart contains items with and without 
recurring costs, they are grouped separately.

If multiple items with the same recurring price frequency are placed in the shopping cart, they 
are grouped. The grouping makes it easier to view how much items cost for each frequency (for 
example, weekly, monthly, and annually). If the shopping cart contains items with and without 
recurring costs, they are grouped separately.

On a request record, recurring prices are grouped by frequency and shown in the Recurring 
Prices  related list. In the example below, two items each have a monthly recurring cost of 
$100.00 and their prices are grouped as a single record of $200.00 monthly. Another item with 
an annual recurring cost of $500.00 is listed as a separate record.
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If a request record contains multiple items with the same recurring frequency, click the arrow 
next to the corresponding recurring prices record to view details.

Extend the pricing model

The pricing model is useful if you want the price or recurring price to be dynamically calculated 
based on how a user completes the ordering form. You can extend the pricing model of a catalog 
item by editing the item price or the recurring price.

Before you begin
Role required: admin

Procedure

1. From the left navigation pane, select System Definition  > Script Includes.

2. Edit the CatalogPriceCalculator script to customize the item price and the 
CatalogRecurringPriceCalculator script to customize the recurring price.

Hiding prices in the service catalog

Administrators can configure options to hide catalog item prices in the service catalog for listings 
of specific items, for specific types of items, or for all items.

Item prices can appear in the following locations:

• A catalog item listing in the Order This Item  panel.

• Catalog item listings in categories and subcategories.

• The Shopping Cart  panel.

• The Edit Cart, Order Confirmation, and Order Status pages.

Hide prices globally

Configure service catalog properties to hide prices globally.
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To view and edit service catalog properties, navigate to Service Catalog  > Catalog 
Administration  > Properties.

Hiding prices by item types

By default, prices do not appear for order guides, record producers, and wizard launchers.

You can change which catalog item types show prices using the List of class 
names for catalog items that do not show the price in listings  property 
(glide.sc.item.cannot_show_price). Provide a comma-separated list of table names 
for item types that you want to hide prices for.

For example, to hide prices for standard catalog items, add sc_cat_item  to the list.

You can also remove an existing entry to display prices for that item type. For example, to display 
prices for order guides, remove the order guide entry sc_cat_item_guide  from the list.

Hiding prices for all items

By default, zero-priced items have prices hidden in listings and carts.

You can configure this behavior to always hide or show prices, using the When to show prices 
and sub-totals on the Service Catalog Cart  property (glide.sc.price.display).

Set this property to Always show prices  to display prices for all items on all service catalog 
screens, or to Never show prices  to hide prices for all items on all service catalog screens.

Hide prices for specific items

You can hide prices for specific items to match your organizational requirements.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Service Catalog  > Catalog Definition  > Maintain Items.

2. Open the relevant item definition.

3. Select the Omit Price on Cart  check box.

The price does not appear in the catalog listing or when the item is added to the cart. The price 
is listed as "-" on the edit cart, order confirmation, and order status screens.

Clone requests

Clone a request to create up to ten copies (clones) of the same Service Catalog  request, for 
different users, without having to enter the same information multiple times. For example, 
you can request a new piece of equipment for several specified people, generating multiple 
individual requests quickly from a single initial request.

Before you begin
Role required: admin or catalog_admin

Procedure

1. Navigate to All  > Service Catalog  > Catalog Definitions  > Maintain Cart Layouts

2. Under the Target type: Browser Screen  section, select Order Status Screen.

3. In the Components  tab, select the Clone Checkout  check box.
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4. Navigate to Service Catalog  > Catalog Administration  > Properties.

5. In the Cart  category, perform the following:

◦ Enable the Enable cloning requests during checkout  property.

◦ For the List of roles (comma-separated) that can use bulk ordering functionality  property, 
enter the roles for which you want to enable bulk request capability for all users with these 
roles, or leave the field blank to enable the capability for all users.

6. Click Save.

Related topics

Clone a request

Request a catalog item from Service Portal

Request an order guide from Service Portal

Delegated request experience

Create scripts

Service Catalog  enables you to use certain scripts.

Some functions are available, specifically for Service Catalog:

• Client-side scripting allows catalog designers to use the same functionality available on other 
forms.

• The Service Catalog  Script API makes catalog ordering easier from inside business rules.

• Scriptable Assignment of Execution Plans allows selection of an execution plan at the time of 
ordering, based on scripted conditions.

Create a custom cart

Administrators with a knowledge of Jelly can customize the look and feel of service catalog carts, 
either globally or for specific catalog items, using the UI macro capability.

Before you begin
Role required: admin

About this task
Note: 
You can configure cart layouts without scripting.

Procedure

1. Navigate to All  > System UI  > UI Macros.

2. Click New  to create a new macro.

3. Fill in the details and write the script to define your custom cart.

Note: 
Designing a custom cart requires knowledge of the Jelly expression 
language. For reference purposes, the default cart script appears in the list as 
catalog_cart_default.

4. Click Submit.
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What to do next
After creating a custom card, you can reuse it and link it to catalog items.

Link a cart to an item

Link the default cart or a custom cart to an item so the requester sees the pertinent information.

Before you begin
Role required: catalog_admin or admin

Procedure

1. Navigate to All  > Service Catalog  > Catalog Items.

2. Open an item to test the new cart.

3. In the Cart  field, select the cart to use.
You can configure the form layout to add this field to the form.

4. Save the changed form.

Service catalog home page configuration

The home page for a service catalog provides the primary front end for ordering items within that 
catalog. You can configure various elements of the pages within the Service Catalog.

Important: 

The functionality found in homepages, arranging information from your instance to tell a 
story about your data, is found in dashboards on new instances. On upgraded instances 
with Next Experience  enabled, users can view existing homepages if they have a direct 
URL, but they can't create or edit them. Responsive dashboards and Analytics Center 
dashboards take over homepage functionality.

Use the Homepage deprecation help tool  to convert the homepages on your instance to 
responsive dashboards.

For more information, see:

• Dashboards in the Analytics Center .

• Working with responsive dashboards .

Administrators and catalog administrators can design a home page in any of the following ways.

• Customizing the catalog home page.

• Adding, removing, and arranging categories.

• Enabling content types.

• Using catalog properties to provide additional control over behavior and appearance.

• Using renderers to define the appearance of categories.

Note: 
End users can access the catalog through the customizable user home page, or with 
content management pages that use content blocks for categories.

Configure search and navigation

You can use service catalog properties to configure search and navigation within the service 
catalog homepage.
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Navigate to Service Catalog  > Catalog Administration  > Properties  to view service catalog 
properties.

Restrict search access

Each catalog homepage provides a search bar to help locate items not displayed on the 
homepage. By default, any user who can access the catalog homepage can search using this 
search bar.

To restrict access to this search function by role, use the List of roles (comma-separated) that 
can search the service catalog  property (glide.sc.can_search).

For example, to only allow logged-in users to access search, set this field to blank. To remove the 
search function for all users, set this field to None.

Note: 
Search results only show items that the logged-in user can access.

Hide search results from inactive categories

By default, search results are returned from all categories, including inactive categories.

To avoid returning results from inactive categories, set the Service catalog searches return 
items in inactive categories  property (glide.sc.search.disabled_cats) to No. For 
example, when designing a new category, you can avoid users seeing search results from this 
category until you are ready to make it active.

Note: 
Security constraints can also make a category or catalog item inaccessible.

Restrict search by item type

By default, a search field does not appear when viewing order guides, record producers, and 
wizard launchers.

To define which catalog item types do not show the search field, list these types in 
the List of class names for catalog items that do not have the search field displayed 
(glide.sc.item.cannot_show_search) property.

For example, to enable searching when viewing record producers, remove 
sc_cat_item_producer  from this list.
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Service catalog search bar removed

Service catalog search bar enabled

Enable breadcrumb links

By default, breadcrumbs appear without links when using content management pages as service 
catalog homepages.

To display these breadcrumbs with links, set the Use links for breadcrumbs 
rendered in Service Catalog pages accessed via a CMS site  property 
(glide.sc.use_breadcrumb_links.cms) to Yes. This setting provides greater 
navigational control for end users.

Disable search suggestions

By default, service catalog searches display "Did you mean?" suggestions if a search does not 
return any results and an alternate spelling or similar recent search does.

To disable these suggestions, set the Specify whether search suggestions should be enabled 
property (glide.sc.search.suggestions) to No.
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Refine search results

Use properties to refine search results in Service Catalog.

Before you begin
Role required: admin

About this task
The auto-completion feature returns values that contain an exact match to the letter combination 
entered.

Catalog auto complete

Administrators can use the Additional columns for the "request for" Service Catalog widget 
(glide.sc.request_for.columns) property to add columns to this list, to further refine 
the search results, and help determine which user to select when two users have the same 
name.

In this example, the property is set to display two additional columns, Department  and Title:
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Catalog auto complete using department

Administrators can use the Ordering of matches for the "request for" Service Catalog widget. 
(glide.sc.request_for.order_by) property to configure the columns to sort by one of 
the values.

In this example, the is set to sort the results list by department.
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Catalog auto complete results by department

Auto-completion also applies to the Request for  field, which can be added to the service catalog 
homepage.

Procedure

1. Navigate to All  > Service Catalog  > Catalog.

2. Click Add Categories.

3. Select Request for.
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4. Place the category on the page.

Add requested for catalog section

Configure keyword search for catalog items

When you search for a catalog item by a keyword in Service Catalog, the search results are 
displayed by considering a few fields of the catalog table.

Before you begin
Role required: admin

About this task
If the keyword doesn’t have exact matches, its closest matches are displayed as Did you mean 
suggestions. This search functionality is also applicable in Service Portal.

The search results are sorted in the following order based on the frequency of the keyword:

• Catalog items whose Name  field contains the keyword (top).

• Catalog items whose Meta  field contains the keyword.

Note: 
The Meta  field is used only for the Zing search and not for the AI search. If the Meta  field 
isn’t filled, the Zing search uses other sources, such as short description and name, for 
searching.

• Catalog items whose Description  or Short description  field contains the keyword.

• Categories whose Name  or Description  field contains the keyword.

• Catalogs whose Name  or Description  field contains the key term, or the catalog items whose 
Class  field contains the keyword (bottom).
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Note: 

• If your organization has multiple service catalogs, a search returns a result only from the 
catalog being viewed.

• Search results return an item only when the item is active, has a valid catalog and 
category association, and you’re authorized to view the item.

Procedure

1. Complete the following steps to regenerate a text index for the sys_metadata table.

a. Navigate to System Definition  > Text Indexes.

b. Open the text index for the Application File [sys_metadata] table.

c. Select the Regenerate Text Index  related link and select OK.
The system schedules the table for the text indexing.

2. Complete the following steps to enable the Did you mean  suggestions.

a. Navigate to System Properties  > Text Search.

b. Under the Did You Mean Properties  section, enable the Suggest alternate search spellings 
for knowledge, catalog or global search  property.

Related topics

Search administration

Service Catalog for managers and end users

Regenerate a text index for a table

Configure a "Did You Mean?" suggestion

Create or edit a catalog item

Create a record producer

Create an order guide

Define a content item

Configure AI-based catalog search experience

Improve employee engagement with an AI-based catalog search experience in Service Portal 
and Now Mobile. Intelligent query features enable users to quickly and easily find the answers 
they need.

Before you begin
Role required: admin

About this task
You can configure AI-based catalog search experience in portals and Now Mobile. Following are 
the default search application configurations for Service Portal and Now Mobile:

• Service Portal Default Search Application. For information about AI Search in Service Portal, 
see AI Search  in Service Portal .

• NowMobile App Search Configurations. For information about AI Search in Now Mobile, see AI 
Search in mobile .
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Each of these search application configurations have an associated search profile based on 
which the search results are filtered and displayed.

Note: 
If the AI Search is enabled for Now Mobile, the Experience for items not available in NOW 
Mobile  (glide.sc.mobile.unsupported_discover) property is not applicable. 
For information on Now Mobile  properties, see Service Catalog properties.

Following are a few limitations for AI-based catalog search experience:

• The facets in Service Portal  always show the primary category of the catalog item (even if the 
user does not have access to the primary category and the accessible path to the item is via 
another category that the item is associated with).

• If the user does not have read permissions for the category record and its fields, the search 
results cards in Now Mobile  do not show the category of the item.

Procedure

1. Navigate to All  > AI Search  > Search Experience  > Search Applications.

2. To edit the searchable catalogs in a portal or Now Mobile, perform the following steps.

Note: 
Items are searched for only in the catalogs configured in the search source, irrespective 
of the catalogs associated with the portal. For information on associating a catalog with a 
portal, see Configure a catalog in Service Portal .

a. In the Search Application Configurations list, select the search application configuration 
associated with the portal.
For example, Service Portal Default Search Application  for Service Portal.

b. On the Search Application Configuration form, open the search profile.
For example, Service Portal Default Search Profile  specified for Service Portal.

Note: 
To avoid conflicts with future upgrades, it is recommended that you create a search 
profile instead of using the search profile available in the base system.

c. From the Search Sources related list, select a search source.
For example, Service Portal Catalogs.

d. In the Conditions  field, add catalogs where you want the items to be searched for.
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Searchable catalogs in Service Portal

e. Click Update.

Related topics

AI Search

Configure preview

Configure the number of items that have the Preview  section expanded to display item details. 
You can also change the default number (5) of items and categories that display, and hide the 
Exists in categories  information.

Before you begin
Role required: admin

About this task
By default, if not showing item details using pop-ups, the first two items listed in the category 
display have the Preview  section expanded to display item details.

To change the number of items with this information expanded, set the Number of Catalog 
Items to expand in browsing and search when not using pop-up icons to view details 
(glide.sc.auto_expand) property to the number required.

Expanding to 2 items Expanding to 1 item
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Set number of items and categories to preview

By default, up to five items or categories appear in each category on the homepage.

About this task
To change this number, set the Number of Catalog Items/Categories to 
preview in a section  (glide.sc.max_items) property to the required value.

Previewing five items Previewing two items

Hide the existing categories in the categories display

By default, catalog items that are in several categories show Exists in categories  information that 
shows other categories that the items are available in. You can hide this information.

Before you begin
Role required: admin

Procedure

Set the Show the additional categories section when viewing a catalog 
item(glide.sc.show_additional.cats) property to No.
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Showing additional categories Hiding additional categories

Create a renderer

Create or modify renderers using UI macros to provide the rendering instructions. Renderers 
define a specific look and feel for a catalog or category.

Before you begin
Role required: catalog_admin or admin

About this task
Use renderers to specify the following formats:

• How catalogs appear on the multi-catalog homepage.

• How categories appear on a catalog homepage.

For example, you can create a renderer showing the category homepage image, the description, 
and the first two catalog items in a category.

Procedure

1. Optional:  Create a UI macro to define specific rendering instructions.

2. Navigate to Service Catalog  > Catalog Definition  > Renderers.

3. Click New.

4. Select to create a catalog or category renderer.

5. Enter the renderer details.

Renderer Details

Field Description

Name A name for the renderer.

Macro The UI Macro to use.

Render 
catalog title

Appears for catalogs renderers. A check box to display the catalog title bar on 
the multi-catalog homepage.

Render title Appears for category renderers. A check box to display the category title bar 
on the catalog homepage.

Note: 
The admin  and catalog_admin  roles can view the Render title  even 
when the check box is not selected.
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Service Catalog  Renderers

6. Click Submit.

Note: 
To modify a default catalog or category renderer, follow a similar process, by selecting 
one of the default renderers listed.

This new renderer is added to the list of available choices when applying a renderer.

Select a renderer for a catalog

Select a renderer and apply them to a catalog to change its appearance.

Before you begin
Role required: catalog_admin or admin

About this task
The following default catalog renderer schemes are available:

• All Details: shows desktop image, title, and categories.

• Image Only: shows desktop image only.

• Title and Image: shows title and desktop image.

• Title Only: shows title only.

Procedure

1. Navigate to All  > Service Catalog  > Catalogs.

2. Click the add content icon (+) on the upper right.

3. Select a catalog in the middle panel of the pop-up window.
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Service Catalog  home page layout

4. Select a renderer from the list displayed in the right-hand panel, for example Title Only.

5. Click Close  to save the catalog with the renderer settings you defined.

Select a renderer for a category

Select a renderer scheme for your categories.

Before you begin
Role required: catalog_admin or admin

About this task
The following default category renderer schemes are available:

• Category Items: shows desktop image, title, and description.

• Category Items No Title: shows desktop Image and description.

• Category Details: shows the subcategories and items in that category.
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Procedure

1. Navigate to All  > Service Catalog  > Catalog.

2. Click the add content icon (+) on the upper right.

3. Select a category in the middle panel of the pop-up window.

4. Select a renderer from the list displayed in the right-hand panel, for example Category Items.

5. Click the close icon (x) to save the catalog with the selected renderer.

Customize a catalog homepage

Customize a catalog homepage to provide end users with access to catalogs from one 
homepage.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Service Catalog  > Catalog.

2. Click the add content icon (+) at the top of the page to add a category.

3. Select a category in the middle panel of the pop-up window that appears.

Service Catalog  add categories pop-up window

4. Click Add here  in the location where the category appears on the homepage.

5. Optional:  Repeat steps 3–4 to add more categories.
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6. Close the pop-up window.

7. Optional:  To change a category location, drag it to the appropriate place.

8. Optional:  To remove a category, click the (X) icon on the top right of the category header.

9. Optional:  Add a shopping cart on the page.

Display subcategories in a panel

By default, subcategories are displayed in a panel at the bottom of the category page. You can 
change a system property to list subcategories at the top.

Before you begin
Role required: admin

Procedure

Use the In category view display subcategories in a panel  property 
(glide.sc.use_sub_cat_section).

Name of form

When set to Yes, the subcategories appear in a 
panel at the bottom.

When set to No, the subcategories appear as 
a list at the top.

Set to Yes Set to No

Customize the multi-catalog homepage

Customize the multi-catalog homepage to provide end users with access to multiple catalogs 
from one homepage.

Before you begin
Role required: admin

About this task
This task is similar to customizing the homepage for an individual catalog. In this task, you are 
adding catalogs, not catalog categories.
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Procedure

1. Navigate to All  > Service Catalog  > Catalogs.

2. Select Add Catalogs  at the top of the page to add catalogs to this page.

3. Select a catalog in the middle panel of the pop-up window.

Multi-catalog home page arrangement

Note: 
Only administrators can see catalogs that do not contain active categories or items.

4. Optional:  Select a renderer from the right-hand panel, for example Title Only.

5. Click Add here  in the location where the catalog appears on the homepage.

6. Optional:  Repeat steps 3–5 to add more catalogs.

7. Close the pop-up window to save the changes.

Multi-catalog home page

You can modify the arrangement of catalogs within the homepage:
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◦ To change a catalog location, drag it to the appropriate place.

◦ To remove a catalog, click the X in the catalog title bar.

◦ To edit details for a catalog, click the pencil icon in the catalog title bar.
The catalogs appear on the homepage.

Show item details in sections or pop-ups

By default, a service catalog category displays the first two items with the preview section 
expanded to show item details. You can change the number of items that are previewed, or 
change the preview to appear in a pop-up window.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Service Catalog  > Catalog Administration  > Properties.

2. To change the number of items previewed, set the Number of Catalog Items to 
expand in browsing and search when not using pop-up icons to view details 
(glide.sc.auto_expand) property to the desired number.

Example 

Expanded to 2 items. Expanded to 1 item.

2 items 1 item

3. To use the preview icon, set the When browsing a category use the pop-up icon to show item 
details  (glide.sc.cat_view_use_popup_for_details) property to Yes.
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When set to No, the item details appear when 
you click Preview.

When set to Yes, the item details appear as a 
pop-up when the cursor hovers over the item 
icon.

Set to No Set to Yes

Configure Classic Mobile devices

When you configure Service Catalog on a Classic Mobile device, you can define the layout and 
presentation of catalogs. You can then perform actions such as ordering products and services, 
submit incidents and problems using record producers.

Before you begin
Important: 

Mobile Classic Is Deprecated!

The App Has Been Removed From The Stores And Can No Longer Be Activated. We Are 
Not Offering Enhancements, Bug Fixes, Or Support For The App. See ServiceNow Classic 
Mobile App Deprecation Effective September 15, 2022 .

Role required: admin

About this task
Users can access the service catalog on Classic Mobile devices to:

• View and order products and services.

• Submit incidents and problems using record producers.

Note: 
Users cannot access order guides, wizards, or content items from Classic Mobile devices.

Administrators and catalog administrators can configure the layout, presentation, and other 
aspects of the service catalog for Classic Mobile devices.

Including:

• Defining rendering options for Classic Mobile categories.

• Defining rendering options for Classic Mobile catalog items.

Accessing the Service Catalogon Mobile Devices

To access the service catalog, navigate to Self-Service  > Catalog.
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Service Catalog  homepage Classic Mobile

Catalog items are grouped into categories, which can also contain one or more subcategories.

You can browse and select an item. To browse for an item within a category, tap the category filter 
to select the category or subcategory.
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Sample service catalog category

To request an item:
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Procedure

1. Select an item.

Order Item Classic Mobile

2. Tap any field with an arrow (>) to add information, such as the name or location of the 
requestor, the need-by date, or item quantity.

3. Tap Add to Cart  to add the item to your cart.
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Order Item Classic Mobile 2

The order screen appears.

4. Tap Edit  to edit your order, if required.

5. To order the item as specified, tap Order, then tap OK  when prompted to confirm ordering.
A confirmation message appears.
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Classic Mobile Order Confirmation

6. Tap the item to see further details.
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Classic Mobile Order Requested Item Details

7. Tap the back arrow to return to the confirmation message.

8. Tap Continue Browsing  to return to the service catalog.

After the request is submitted, ServiceNow  follows request fulfillment processes to fulfill the 
ordered item.

Define the mobile layout

You can configure the Classic Mobile layout for categories within a service catalog.

Before you begin
Role required: admin

About this task
By default, service catalog categories appear on mobile devices in the same order as on desktop 
devices.

Procedure

1. Navigate to All  > Service Catalog  > Classic Mobile Admin  > Classic Mobile Layout  to display 
a list of service catalogs.

2. Click the lookup icon for the service catalog you want to configure.
The mobile layout displays details for the catalog.

3. Click Edit  to select which categories appear on mobile devices, and in which order.
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Service Catalog  Classic Mobile layout catalogs

4. Add, remove, or reorder the selected mobile categories, and then click Save.

Note: 
To return the display to the default desktop layout settings for the portal page associated 
with that catalog, click the Replace categories with desktop layout  related link.

Limit description sizes in the Classic Mobile UI

By default, item descriptions in the smartphone interface are truncated to a maximum of two 
lines.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Service Catalog  > Catalog Administration  > Properties.

2. Set the Limit descriptions in category and item listings to two rows in the Mobile UI  property 
(glide.sc.mobile.limit.description) to No.
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If set to Yes, descriptions are limited to two lines If set to No, the full descriptions are given

Set to Yes Set to No

Using the content management system with the service catalog

Use the content management system (CMS) to create a custom interface for the service catalog.

Important: 
Use Service Portal  for new development instead of CMS. Service Portal  is an alternative to 
CMS with a refined user experience, and is active by default in the base system. For more 
information, see Service Portal  and Content Management and Service Portal .

Manage catalogs in CMS sites

When your organization uses the content management system (CMS) as well as Service Catalog, 
you can select which catalogs are supported within the CMS sites.

Before you begin
Role required: catalog_admin or admin

About this task
Associating catalogs with sites ensures that users can always access an appropriate catalog.

Procedure

1. Navigate to All  > Service Catalog  > Catalog Definitions  > Maintain Catalogs  and open the 
catalog to associate with a site.

2. In the Sites related list, click Edit, select the site to associate with the catalog, and then click 
Save.

3. Click the reference icon beside the site name, and then click Open Record.
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Service catalog details - catalog sites details

4. Enter values in the fields, as appropriate.

Field Description

CMS 
homepage

The homepage for this site.

CMS search 
page

The location of the search page for the site.

CMS 
'Continue 
Shopping' 
page

The location to direct end users to when they click the Continue Shopping 
button in that CMS site. This field is designed to reference a content page 
URL suffix.

5. Click Update.

Set up catalog portal pages

The Catalog Portal Page [sc_catalog_view_mtom]  table links catalogs to CMS portal 
pages and defines the default catalog to portal page combination used by URLs.

For example, the default portal page for the service catalog is the catalog_default page.

Catalog portal page records appear in the Catalog Portal Pages  related list on the Catalog 
form. The Catalog Portal Page table generates two values in a URL: sysparm_catalog_view  and 
sysparam_catalog. Use the Catalog Portal Page form  to enter a custom link, if required.

Resolve missing catalog portal pages

If a catalog record is not associated to a catalog portal page record, ServiceNow  attempts to 
present a view based on a set prefix of: catalog_<catalog name>.

For example, if the default service catalog has no catalog portal page record, the system sets 
sysparm_view  to catalog_Service_Catalog. With this setting, when you navigate to Self-Service 
> Service Catalog, you view a new and apparently blank catalog_Service_Catalog  portal page, 
instead of the existing and populated catalog_default  portal page.

To correct, go to the Sites  related list on the Catalog form and add a new catalog portal page 
record  manually.
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For example, for the default service catalog, add a record with the following values:

• Catalog: Service Catalog

• Portal Page: Catalog (catalog_default)

• Default: true

Manage catalog portal pages

Using Service Catalog, you can create and manage multiple portal pages for a catalog.

Before you begin
Role required: admin

About this task
A catalog portal page provides a homepage  for a specific catalog. You can use portal pages to 
create different catalog views for different user groups. Each portal page accesses the same 
catalog content and presents that content in different ways.

Catalog portal page details include the owner, title, and view to use for that page.

Procedure

1. The Catalog Portal Pages related list shows portal pages available for that catalog.
Each catalog has a default page, created automatically when the catalog is created.

2. Select an appropriate action:

◦ Click New  to create a new portal page.

◦ Click Edit  to select another portal page for the catalog.

◦ Select a portal page to view and edit details for that page.

Service Catalog  items

The overall catalog is made up of a collection of discrete catalog items.

The basic Service Catalog  item types include:

• Standard catalog items

• Record producers: Provide alternative ways to add information such as Incidents via 
the service catalog.

• Order guides: Enable grouping multiple catalog items in one request.

• Content Items: These are the catalog items which provide information instead of goods or 
services.

Standard catalog item

A catalog item can be a good or service. If something can be ordered by itself, it is a catalog item. 
If something only makes sense as part of a greater whole, it is part of an item, rather than an item 
in and of itself. For example, a new Dell server is a catalog item, as is a new Executive Desk.

Use a catalog item to publish a service to your users. Add a service description, images, and a 
workflow to determine the approval and fulfillment processes for the catalog items.

Use the variables to present and gather information from the users. Catalog UI Policies and 
Catalog Client Scripts can also be added to control the item behavior based on user input.
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Specify related items and articles for a catalog item

Specify related items and articles for a catalog item to provide alternatives and additional 
information. These items and articles are displayed in the catalog item page in Service Portal  and 
Now Mobile.

Before you begin
Role required: admin, catalog_admin, or catalog_editor

About this task
You cannot specify related items and articles for an order guide.
You cannot specify these types of items as related items for a catalog item.

• Wizard Launcher

• Content Item

• Standard Change Template

• Any item in Admin Home catalog

Procedure

1. Navigate to All  > Service Catalog  > Catalog Definitions  > Maintain Items.

2. Select the required catalog item.

3. To specify a related article, perform these steps.

a. In the Related Articles related list, click Edit.

b. On the Edit Members form, move the required articles from the Collection  column to the 
Related Articles List  column.

c. Click the up or down icon to arrange articles in the required order and click Save.

4. To specify a related catalog item, perform these steps.

a. In the Related Catalog Items related list, click Edit.

b. On the Edit Members form, move the required items from the Collection  column to the 
Related Catalog Items List  column.

c. Click the up or down icon to arrange items in the required order and click Save.

Note: 
In Service Portal, use the instance options to configure the number of articles and items 
shown in the Related Articles  and Related Items  section. See Configure related catalog 
item widget instance options  or Configure knowledge related articles widget instance 
options.

Related topics

Map related articles

Add an ordered item link to an item

Use ordered item links to provide a link on the ordered item screen that provides more 
information about an item.

Before you begin
Role required: Catalog administrator
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About this task
After you order the catalog item, you can click the link to see relevant information about the item 
ordered, for example, for standard delivery terms and conditions. The URL text and link can be 
defined once and reused across multiple items.

Links are rendered with an added parameter providing the sys_id of the requested item. For 
example, if the link is mylink.com, it is rendered as mylink.com?req_item=abcde12345. This 
added parameter can be useful for virtual provisioning situations.

Note: 
Ordered item links cannot be configured for Classic Mobile devices.

Procedure

1. Navigate to All  > Service Catalog  > Catalog Definition  > Ordered Item Links.

2. Click New.

3. Enter a Name  for the ordered item link.

4. Enter Link text  to display as the link.
For example, Click here to see more information about the iPhone.

5. Enter the exact Link URL.
For example, http://www.mylink.com.

6. Select the Target.
You can choose to open the link in a new window or tab, or within the catalog. If Within Catalog 
is chosen, the link must be within the same site. An HTTP site cannot be called from within 
HTTPS.

7. Click Submit.

8. Navigate to Service Catalog  > Catalog Definition  > Maintain Items.

9. Click an item Name.

10. In the Ordered Item Link  field, click the reference lookup icon.

11. Click an ordered item link Name.

12. Click Update.

Create a Service Catalog client script

You can create client scripts to customize the catalog.

Before you begin
Role required: admin

About this task
Use catalog client scripts to control the behavior of the catalog items when presented to your 
users. Catalog client scripts can be applied to a catalog item or a variable set. These scripts run 
on the browser instead of the server, allowing you to better control the information that the user 
submits.

The priority order for g_form APIs is:

1. Mandatory (highest)

2. ReadOnly/Display

If a variable is set to mandatory and does not have value, readonly or hide do not work on 
that variable. If a variable is hidden or readonly, and then set to mandatory, the variable field 
becomes visible or editable.
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This priority order is also applicable for variable sets and containers. If a variable set or container 
has a mandatory variable without any value, then the container or variable set cannot be hidden.

Procedure

1. Navigate to All  > Service Catalog  > Catalog Administration  > Catalog Client Scripts.
A list of current custom catalog client scripts appears.

2. Click New.

3. On the form, fill in the fields.

Field Description

Name Unique name for the catalog client script.

Applies to Item type this client script applies to:

◦ A Catalog Item: enables the Catalog item field.

◦ A Variable Set: enables the Variable set field.

Active Check box to enable the client script. Clear the check box to disable the 
script.

UI Type Whether to apply this field to desktop, Classic Mobile, or both.

Script Enter the client script to run on the service catalog item.

Type Select when the script runs, such as onLoad  or onSubmit.

Catalog item or 
Variable set

Select a catalog item or variable set from the list. The field name and options 
available depend on the selection in the Applies to  field.

Applies on a 
Catalog Item 
view

Check box to apply the catalog client script to catalog items displayed within 
the order screen on the service catalog. Available in the requester view.

Applies on 
Requested 
Items

Check box to apply the catalog client script on a Requested Item form, after 
the item is requested. Available in the fulfiller view. See VEditor.

Applies on 
Catalog Tasks

Check box to apply the catalog client script when a Catalog Task form for the 
item is being displayed. Available in the fulfiller view. See VEditor.

Applies on the 
Target Record

Check box to support the catalog client script on a record created for task-
extended tables via record producers. See Default variable editor.

4. Click Submit.

Translation of Service Catalog  items

You can translate Service Catalog  items into multiple languages using the ServiceNow® 

Localization Framework.

Localization Framework standardizes and enhances the translation process of artifacts such as 
Service Catalog  items through configurable workflows. For more information, see the Localization 
Framework  topic. You can translate Service Catalog items by activating the Localization 
Framework Installer plugin (com.glide.localization_framework.installer). For information about the 
plugin activation, see the Activation of Localization Framework  topic.

You can request translation for a single or multiple items from a catalog item list. For more 
information, see Request translations for Service Catalog items
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Note: 

• When you translate a catalog item from a form or list, the corresponding variables, 
variable sets, catalog client scripts and catalog UI polices associated with the catalog 
item also get translated.

• You can create catalog items only in the primary language. If you change the language 
and edit a catalog item using catalog builder, the corresponding content of the catalog 
item does not get translated.

You can monitor the overall localization health of the Service Catalog items from the Localization 
Insights dashboard . The dashboard provides the localization health of the system with reports 
that are generated from the localization insights records as per the scheduled jobs.

Watch this six-minute video to learn more about the process of localizing catalog items.

Localization framework overview

Monitoring aggregated catalog item data

Monitor aggregated catalog item data like fulfillment automation coverage, translation coverage, 
and conversational coverage using the Service Catalog  Overview dashboard.

Aggregated catalog item data graphs

You can access the aggregated catalog item data graphs in the Service Catalog Overview 
dashboard by navigating to All > Service Catalog > Service Catalog Overview  if you have the 
catalog_admin role.

The Catalog item translation coverage graph is displayed only if you have enabled the 
Localization framework. For more information, see Localization Framework .

Service Catalog  Overview dashboard

Graph Description

Catalog request channel analytics - last 12 
months

Vertical bar graph representing the count 
of catalog requests made through different 
channels such as Virtual Agent, Service Portal, 
Mobile in the last 12 months.

Catalog item best practice deviations Pie-chart representing the Item Diagnostic 
Results report scores for catalog items, which 
indicate the health of items. A higher score 
means that an item has more deviations 
from best practices. For example, duplicate 
variables for a catalog item will represent a 
higher score. Each score is represented by a 
different color.

Catalog item VA render type Horizontal bar graph representing the 
individual count of the way catalog items are 
rendered in Virtual Agent. It specifies whether 
an item is rendered as a pop-up, window, or 
conversation in Virtual Agent.

Catalog item fulfillment automation coverage Vertical bar graph representing the count of 
fulfillment automation coverage of catalog 
items. It specifies whether items are fully 
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Service Catalog  Overview dashboard  (continued)

Graph Description

automated, semi-automated, manual, 
unspecified, or empty.

Catalog item translation coverage Vertical bar graph representing the count 
of the translation status of catalog items. 
It specifies whether items are completely 
translated, partially translated, not translated, 
or in-progress.

Related topics

Dashboards overview

Service Catalog  item designer

The Service Catalog  item designer enables non-administrators to create, maintain, and publish 
catalog items. It uses a structured design and publishing process to ensure consistency of 
usage.

Starting with the Washington DC  release, Service Catalog  Item Designer is no longer deployed, 
enhanced, or supported. For details, see the Deprecation Process [KB0867184]  article in the 
Now Support  Knowledge Base.

The item designer is best suited to manage items that have basic questions, approvals, and 
tasks.

Note: 
To create and manage more complex items, use the Service Catalog  features for creating 
items.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3969

https://www.webstg.servicenow.com/docs/access?context=dashboards-overview&version=washingtondc&pubname=washingtondc-now-intelligence&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=dashboards-overview&version=washingtondc&pubname=washingtondc-now-intelligence&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=dashboards-overview&version=washingtondc&pubname=washingtondc-now-intelligence&ft:locale=en-US
https://support.servicenow.com/kb_view.do?sysparm_article=KB0867184
https://support.servicenow.com/kb_view.do?sysparm_article=KB0867184
https://support.servicenow.com/kb_view.do?sysparm_article=KB0867184


Item designer process flow

• Administrators or catalog administrators set up the design environment to enable a controlled 
item design process, and process category requests.

• Catalog managers request categories, then manage their categories. A user requests a 
category, either requesting to become the manager of that category, or assigning another user 
as the category manager.

1. An administrator or catalog administrator processes that request, creating the category with 
a selected category manager.

2. The category manager optionally assigns catalog editors to a category that they manage.

• Catalog managers and catalog editors use the catalog item design to perform the following 
activities.

1. Create items within a category that they are assigned to.

2. Create questions, approvals, tasks, and sections, for the item.

3. Publish items to the category after review.

• Self-service users can use the Service Catalog  to request items in the category, like any 
Service Catalog  item.

Catalog item designer roles

Role title [name] Description

Administrator [admin]

Catalog administrator 
[catalog_admin]

Can set up the catalog item designer environment and process 
requests for categories. Can also perform other service catalog 
functions.

Catalog Item Designer 
[catalog_item_designer]

Can view the status of category requests.

Catalog Manager 
[catalog_manager]

Can view and assign catalog editors to their categories. Can also 
create, modify, and publish items within their categories.

Catalog Editor 
[catalog_editor]

Can create, modify, and publish items within the categories that they 
are assigned to.

Configuring catalog item designer options

Administrators and catalog administrators can control the options for catalog managers and 
editors who use the catalog item designer.

Starting with the  Utah   release, Item Designer is being prepared for future deprecation. It will 
be hidden and no longer activated on new instances but will continue to be supported. Catalog 
Builder provides the latest experience for this functionality. For details, see the Deprecation 
Process [KB0867184]  article in the Now Support  Knowledge Base.

Configuration includes defining question types, approval types, and task assignment types. You 
can restrict these options to ensure that items are designed consistently and with few variations, 
or expand them to enable greater design flexibility.

You can also process category creation requests and view or modify definitions of notifications 
used by the catalog item designer.
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Process Flow

The catalog item designer uses the records in three distinct areas for creating, publishing, and 
requesting items:

1. Creating: The catalog item designer uses staging records for items that are being 
created, with staging records for any associated questions, approvals, and tasks. For 
example, a staging item [sc_ic_item_staging] record can have associated staging approval 
[sc_ic_aprvl_defn_staging] records. These records are staging only, and are not available to 
order from the Service Catalog.

2. Publishing: A published item can be requested from the Service Catalog. When item editors 
publish an item, the following actions occur:

◦ Staging items create or update the corresponding catalog items.

◦ Questions are copied into variables on that catalog item.

◦ Associated approvals and tasks are copied into corresponding published tables. For 
example, approval [sc_ic_aprvl_defn_staging] records are copied to equivalent approval 
definition [sc_ic_aprvl_defn] records for the item.

3. Requesting: Requested items and associated records are created when a published catalog 
item is ordered by a self-service user.

◦ A requested item is generated based on the last-published item and the last-published 
versions of any variables used by that item.

◦ Associated approvals and tasks are copied from the published records into equivalent 
requested item tables. For example, Approval Definition [sc_ic_aprvl_defn] records are 
copied to equivalent Approval Definition (Requested Item) [sc_ic_req_item_aprvl_defn] 
records.

Define question types

Question types define the options available to catalog editors or catalog managers when they 
create questions for a catalog item.

Before you begin
Role required: admin

About this task
To meet requirements for your design environment, you can modify question types by expanding 
or restricting the list of types available. For example, you can deactivate date-based question 
types.

Note: 
This list of available question types is also used when you create a new service in service 
creator. For example, if you deactivate Multi-Line Text, it is deactivated for both the catalog 
item designer and the service creator.

Procedure

1. Navigate to All  > Item Designer  > Administration  > Question Types.

2. Click New  or open an existing question type.
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New Question Type form

3. Fill in the fields, as appropriate.

Question Type form

Field Description

Name The question type name.

Question 
class

The base variable type to use as the class for this question type. The most 
common variable types are available, but some complex types, such as 
macros, are available only when you use the Catalog Item form.

The following classes are available:

◦ Checkbox

◦ Date

◦ Date/Time

◦ Label

◦ Multi-Line Text

◦ Multiple Choice

◦ Numeric Scale

◦ Reference
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Field Description

Note: 
Reference fields are only available as preconfigured questions. If you 
set the question class to Reference, the Preconfigured Question 
check box is automatically selected and made read-only.

◦ Select Box

◦ Single-Line Text

◦ Yes / No

Order The sequence in which the question type appears.

Active A check box to indicate whether the question type is active or not. Clear 
this check box to deactivate a question type, so that it cannot be used when 
creating a question or a new service.

Note: 
Deactivating a question type that is in use does not affect catalog items 
that are already using that question type.

Preconfigured 
question

A check box to indicate whether users can select this question as a 
preconfigured type when defining a question. This field is checked by 
default, and only one active non-preconfigured question type is available per 
question class.

Some preconfigured question types are provided by default, such as a list of 
users.

If Preconfigured Question  is selected, the Read only, Question, Help text, 
and Default value  fields also appear. Depending on the question class, 
additional fields can also appear to define variable attributes for that class. 
For example, if you select a preconfigured question type based on the 
Multiple Choice  question class, the Question Type Choices  field appears, 
allowing you to select the choices available for that question type.

Description A description of the question type.

Read only Whether the question type can be selected or not. Appears if Preconfigured 
Question  is selected.

Question The question itself, as displayed. Appears if Preconfigured Question  is 
selected.

Help text Help text to appear with the question. Appears if Preconfigured Question  is 
selected.

Default value The default value for the question. Appears if Preconfigured Question  is 
selected.

4. Click Submit  or Update.

Manage approval types

Approval types are available to catalog editors or catalog managers when they define approvals 
for an item. Add and change approval types, publish them, and expire them when they are no 
longer useful.
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Before you begin
Role required: admin

About this task
For example, you can defineFacilities Items Approvers, a specific list of approvers for facilities 
items.

Procedure

1. Navigate to All  > Item Designer  > Administration  > Approval Type Definitions.

2. Click New.

New Approval Type form

3. Fill in the fields, as appropriate.

Approval Type form

Field Description

Name The name for the approval type.

Version [Read-Only] The version of the approval type. The version number gets 
incremented whenever you save a change to that type.

State [Read-Only] The approval type state. It is initially set to Draft. When you publish 
the approval type, the state changes to Published.

Description A brief description of the approval type.

Type The method for approving items that use the approval type. Can be User, 
Group, or Script. This selection determines which other fields are available.

User(s) The individual users who can approve catalog items that use this approval type. 
This field is available only if the Type  is set to User.

Group(s) The groups who can approve catalog items that use this approval type. This 
field is available only if the Type  is set to Group.
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Field Description

Script 
output

The result of the script, creating either a set of users or groups. This field is 
available only if the Type  is set to Script.

Approver 
script

A script to define that approval type, such as a script to define the manager of 
the requester. This field is available only if the Type  is set to Script.

4. Click Submit.

Publish approval types

Publish an approval type after it is defined correctly for catalog editors or catalog managers to 
use when they create items.

• To publish an approval type, navigate to Item Designer  > Administration  > Approval Type 
Definitions, open an entry, and then click Publish.

• To view a list of published approval types, navigate to Item Designer  > Administration  > 
Published Approval Type Definitions.

Change approval types

Service Catalog  enables you to change the details of an approval type.

• To change details for an approval type, navigate to Item Designer  > Administration  > Approval 
Type Definitions, open an entry, then edit the details and save your changes.

Note: 
After you save your changes, the version number for that approval type increases by 1.

• To make your changes live, publish the changed approval type.

Expire approval types

To remove an approval type from use, you can expire it, making it inactive.

To expire an approval type, navigate to Item Designer  > Administration  > Approval Type 
Definitions, open an entry, and then click Expire.

Manage task assignment types

Task assignment types define the assignment options available to catalog editors and catalog 
managers when they define tasks for an item. You can add, change, publish, and expire task 
assignment types.

Before you begin
Role required: admin

About this task
When a user then requests that item, these assignment options determine which users are 
assigned to complete these tasks. For example, you can use information the user enters when 
requesting an item to dynamically assign a task to the on-call IT support contact of the requester.

Procedure

1. Navigate to All  > Item Designer  > Administration  > Task Assignment Definitions.

2. Click New.
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New Task Assignment form

3. Fill in the fields as appropriate.

Task Assignment form

Field Description

Short Description A brief summary of the task assignment type.

Description A longer description of the task assignment type.

Active [Read Only] A check box that indicates whether the task 
assignment type is active or not. To deactivate a task 
assignment type, expire it.

Assignment type The type of assignment. Set to Direct assignment  to define 
users or groups explicitly, or Scripted assignment  to 
calculate assignments dynamically using a script.

State The state of the task definition. Set to Draft  if the record 
is being created or modified, or Published  if the task 
assignment type is published.

Group The group to assign to tasks that use this assignment type. 
This field is available only if the Assignment type  is set to 
Direct assignment.

User The specific user to assign to tasks that use this assignment 
type. This field is available only if the Assignment type  is set 
to Direct assignment.

Assignment script A script to determine who performs tasks that use 
this assignment type. This field is available only if the 
Assignment type  is set to Scripted assignment. For 
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Field Description

example, a script to identify the on-call support team for the 
requestor as the group to assign.

4. Click Submit.

Publish task assignment types

You can publish task assignment types after defining them.

• To change details for a task assignment type, navigate to Item Designer  > Administration  > 
Task Assignment Definitions, open an entry, then edit the details and save your changes.

Note: 
After you save your changes, the version number for that task assignment type increases 
by 1.

• To make your changes live, publish the changed task assignment type.

Change task assignment types

Service Catalog  enables you to change the details of a task assignment type.

• To change details for a task assignment type, navigate to Item Designer  > Administration  > 
Task Assignment Definitions, open an entry, then edit the details and save your changes.

Note: 
After you save your changes, the version number for that task assignment type increases 
by 1.

• To make your changes live, publish the changed task assignment type.

Expire task assignment types

To remove an assignment type from use, you can expire it, making it inactive.

To expire an assignment type, navigate to Item Designer  > Administration  > Task Assignment 
Definitions, open an entry, and then click Expire.

Review category requests from self-service users

The Item Designer Category Request  catalog item can be enabled to allow self-service users 
to request service catalog categories. If the category request is approved, the Item Designer 
application becomes available for the user to create and manage catalog items in the category.

Before you begin
Role required: catalog_admin or admin

About this task
A catalog administrator reviews category requests and takes an action to create the category 
or reject the request. For example, a category request is rejected if it duplicates an existing 
category.

Procedure

1. Navigate to All  > Item Designer  > Administration  > All Category Requests.

2. Open a category request.
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3. Perform one of the following actions.

Option Description

To approve the request

Click Create Category.

The category is created, the nominated cat­
egory manager receives an email notifica­
tion, and is granted the catalog manager role 
for that category. The category manager can 
then manage the new category and create 
catalog items in it.

To reject the request

Click Reject.

Category request rejections cannot be re­
versed. To create a new category, the original 
requester must submit a new request.

Using the catalog item designer

Users with the catalog_manager role use the catalog item designer to manage their categories, 
assign editors to those categories, and create, modify, and publish catalog items.

For example, a facilities team leader can manage a Facilities  category. Facilities team members 
with the catalog_editor role can create, edit, and publish items within the Facilities  category.
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Note: 
You can only manage standard catalog items using the catalog item designer, not more 
complex items such as order guides. In addition, UI policies and client scripts are not 
supported by the item designer. To implement these more advanced functions, use the 
service catalog features for creating items.

To view and manage catalog items created with the item designer, navigate to Item Designer  > 
Administration  > All Items.

For an overview of the catalog item designer process flow, see Service Catalog item designer.

Request a category

Self-service users can request a new category within a service catalog.

Before you begin
Role required: admin

About this task
For example, a facilities team leader who manages office furniture could request the Office 
Furniture Requests  category within the Facilities  catalog.

To request a category:

Procedure

1. Navigate to All  > Self-Service  > Service Catalog.

2. Select the Can We Help You?  > Item Designer Category Request  item.

3. Fill in the request form.
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4. Click Submit.
The catalog request record state is set to Requested, and you are granted the catalog item 
designer role so you can view the status of the request. Log out and back in to access the Item 
Designer application in the navigator.

5. Navigate to Item Designer  > My Item Categories  to view the status of the request.

Result
After the category is approved, new modules under Item Designer are provided to create and 
manage catalog items in the category.

Manage a category

After an administrator approves a category request, the category is immediately created with the 
selected category manager. The category manager can create and manage items in the category.

Before you begin
Role required: admin

About this task
New categories do not appear in the catalog until items are added to them.

Category managers can also create and manage items in their categories, and publish items to 
make them available to users.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3980



Procedure

1. Navigate to All  > Item Designer  > My Item Categories  to view and edit categories you manage.

2. Click the category number to open that category.

Item designer category form

3. Complete any of the following actions.

Create an item

Category managers and catalog editors can create items using the item designer.

Before you begin
Role required: admin
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Procedure

1. Navigate to All  > Item Designer  > Create New.

2. Fill in the fields as appropriate.

Item designer view

Field Description

Name The name of the item.

State [Read-Only] The state of the item. Initially the state is set to Draft. When you 
publish the item, the state changes to Published.

Details tab or section

Availability The interface where this item is available. Choose from Desktop and Mobile, 
Desktop Only, or Mobile only.

Catalogs The catalogs the item is published to.

Categories The categories the item is published to within the selected catalogs.

Short 
Description

A brief description of the item.

Desktop 
image

An image of the item. This field is available only if Availability  is set to either 
Desktop Only  or Desktop and Mobile.

Mobile 
image

An image of the item for the smartphone interface. This field is available only if 
Availability  is set to either Mobile Only  or Desktop and Mobile.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

3982



Field Description

Description A full description of the item. This description appears in the catalog when a 
user selects the item or clicks the associated More Information  link.

Costs tab or section

One off 
cost

The price for the item and the currency for that price.

3. Click Next  to save the record.

4. Under Related Links, click the appropriate link to add questions, approvals, sections, or tasks 
for the item.

Define an item question

Item questions appear in the catalog when a user requests the item.

Before you begin
Role required: admin

About this task
The user answers the questions to provide the information to fulfill the request. For example, 
a request for a new laptop can have a multiple choice question to specify the screen size. The 
requester can select one from a set of options.

You can organize questions into sections, to provide a logical flow for a multi-question item. If 
you plan to use sections, consider creating the sections so that you can select the appropriate 
section when defining the questions.

To add a question:
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Procedure

1. On the Item form, click the Add a Question  related link.

2. Fill in the fields, as appropriate.

Add question

Field Description

Type The type for the question, defining the format you would like to receive the 
information in. By default, the options are:

◦ Checkbox

◦ Date

◦ Date/Time

◦ Label

◦ Multi Line Text

◦ Multiple Choice

◦ Numeric Scale

◦ Reference
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Field Description

◦ Select Box

◦ Single Line Text

◦ Yes/No

Each type allows you to create your own option, using the Option  field.

Administrators and catalog administrators determine the question types 
available.

Option The standard questions available within the selected question type, as set by 
the value of the Type  field.

By default, all question types contain Create your own <type>  as an option, 
allowing you to define your own question of that type. These types can contain 
additional fields, allowing you to further define the question options. For 
example, Create your own Numeric Scale  allows you to define Scale Min  and 
Scale Max  values.

Some types also have additional preconfigured options available. By default, the 
following extra options are available:

◦ Comments: allow the user to enter a short message. Available if the Type is 
Multi Line Text.

◦ Contact preference: ask the user to select a preferred contact method: email, 
telephone, or SMS. Available if the Type is Multiple Choice.

◦ Configuration item: allow the user to select a single configuration item from 
those items defined in the system. Available if the Type field is Reference.

◦ Active user: allow the user to choose from a list of active user records. 
Available if the Type is Reference.

Administrators and catalog administrators define the options available for each 
question type.

Mandatory A check box to indicate whether users are required to provide an answer before 
they can submit the request. Only available for some question types.

Read only A check box for indicating whether the question is read only. Only available for 
some question types.

Section The section this question appears in. Sections allow you to group questions 
logically. Choose from the sections that have already been defined for the item.

Column The column this question appears in within the selected section. Fields appear 
in the left column by default, but can be moved to a right column.

Question The text of the question.

Order The numeric sequence for the question. Questions appear in the selected 
column in the order defined here.

Default 
value

The default answer for the question, if any. Only available for some question 
types.

Note: 
If you use a choice list, ensure that the default value matches a choice list 
value.
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Field Description

Help text Text that helps the user decide how to answer this question. Help text appears 
under the More information  link below the question.

Question 
Choices

The choices a user can choose for answering the question. Double-click the row 
to add an entry to the list. This field appears only for question types which have 
choices, such as Multiple Choice.

3. Click Submit.

The new question is added to the Questions  related list.

4. To edit a question, open it from the related list.

Define an item approval

An approval for an item identifies a user or group that must approve each request for this item.

Before you begin
Role required: admin

About this task
An approval for an item identifies a user or group that must approve each request for this item. 
All listed approvers must approve this request for it to be fulfilled. A rejection halts the process 
immediately. For example, you could define approvers for a facilities item to be the facility 
management team.

Users can view their open approvals by navigating to Self-Service  > My Approvals, or by 
opening the requested item and viewing the approval in the Group approvals  related list.

To add an approval to an item:

Procedure

1. On the Item form, click the Add an Approval  related link.
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2. Fill in the fields, as appropriate (see table).

3. Click Submit.

The new approval is added to the Approvals  related list.

4. To edit an approval, open it from the related list.

Define an item approval

Field Description

Active A check box for indicating whether this approval is active.

Order
The sequence in which the approvals are requested. Approvals are only created 
when any approvals with lower-order numbers are completed. For example, 
if Approval 1 has order 100 and Approval 2 has order 150, Approval 2 is only 
created when Approval 1 is completed.

If multiple approvals have the same order number, they are requested at the 
same time.

Type The approval type. Set to User  for a specific user, Group  for a specific group, or 
Predefined Approval  to select approvers from a predefined list.

User A specific user to be the approver. Appears if the approval type is set to User.

Group A specific group to be the approver. Appears if the approval type is set to Group. 
The first group member who responds to the approval request responds for the 
entire group.

Predefined A check box allowing you to select an approval type created by the administrator 
or catalog administrator. Appears if the approval type is set to Predefined.

For example, if you select the default predefined approval of Requester's 
Manager, the approval is sent to the manager of the person who requests the 
item.

Define an item task

Item tasks describe the work required to fulfill a request for an item.

Before you begin
Role required: admin

About this task
Item tasks are generated as standard catalog tasks when an item is ordered, like the tasks 
generated by workflows. Tasks are assigned to users or groups as part of the fulfillment process 
when that item is ordered. For example, an item to request a laptop can have a task to deliver the 
laptop to the user.

Users can view their open tasks by navigating to Service Catalog  > Open Records  > Tasks, or 
can open the requested item and view the task in the Catalog Tasks  related list.

To add a task to an item:
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Procedure

1. On the Item form, click the Add a Task  related link.

2. Fill in the fields, as appropriate (see table).

3. Click Submit.

The new task is added to the Tasks  related list.

4. To edit a task, open it from the related list.

Add task

Field Description

Short 
Description

A brief description of the task.

Description A more detailed description that provides details and instructions for the 
people performing the task.

Assignment The assignment type. Select User specified  to select your own assignment 
options, or Predefined  to select from predefined task assignment definitions 
set by an administrator.
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Field Description

Group The group to perform the task. Appears if the assignment is set to User 
specified.

User
The user to perform the task. Appears if the assignment is set to User 
specified.

If you select a group first, only users from that group are available in the User 
selection list.

Assign to
A predefined assignment option. Appears if Assignment  is set to Predefined.

Select from the task assignment types  created by the administrator or catalog 
administrator. Assignment types commonly base the task assignment on 
information provided with the request. For example, if you select Local 
database team for the requestor, the system assigns the task to someone from 
the designated team.

Order
The sequence in which tasks are created. Tasks are only created when any 
tasks with lower-order numbers are completed. For example, if Task 1 has order 
100 and Task 2 has order 150, Task 2 is only created when Task 1 is completed.

If multiple tasks have the same order number, they are created at the same 
time, so the tasks can be performed at the same time.

Define an item section

You can add sections to organize questions into logical groups, each with its own heading, which 
can streamline the request process.

Before you begin
Role required: admin

About this task
For example, an item to request a new laptop can have sections for the hardware specifications 
and software requirements.
Add the sections before you add the questions to simplify the layout process.
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Procedure

1. On the Item form, click the Add a Section  related link.

2. Fill in the fields as appropriate.

Item section

Field Description

Label The section title that describes the type of questions in the section. For example, 
you can define sections such as User Details.

Position A number indicating the vertical position of the section. Position 1 shows at the top, 
position 2 is below Position 1, and so on.

3. Click Submit.

The new section is added to the Sections  related list.

4. To edit a section, open it from the related list.
By default, a single two-column section is created for each item.

Publish an item

When you publish an item, it is available in the catalog for ordering.

Before you begin
Role required: admin

About this task
When you create an item, it is in a Draft  state. You can review the item, make changes, and refine 
the layout as many times as necessary to get the details exactly right.

When the item is ready, a category manager or catalog editor can publish it, making it available 
as a catalog item in the service catalog.

Procedure

1. Navigate to All  > Item Designer  > Administration  > All Items.

2. Open the item record.

3. Click Publish.
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The item is now a live catalog item, available for ordering.

4. To view a list of published catalog items, navigate to Item Designer  > Published Items.

It is best not to edit an item record from the Published Items module. Doing so directly 
accesses that catalog item using standard service catalog functions, not the catalog item 
designer, losing the benefits of the controlled publishing environment.

For example, if you copy an item, the copied catalog item is not listed in the Published Items 
module. To access this copy, navigate to Service Catalog  > Catalog Definition  > Maintain 
Items  and locate the item named Copy of [item name]. The copied item is an active catalog 
item. Consider deactivating it by clearing the Active  check box until your changes are 
complete.

Republish an item

Each time you make changes to an item, you must republish it in order for the changes to reflect 
in the item catalog.

Before you begin
Role required: admin

About this task
When you edit an item, the item state returns to Draft. The live catalog item remains available to 
order, but does not have the changes you made. This process enables you to make changes to 
the item in a staging area, then apply those changes to the live catalog item after review.

Procedure

1. Navigate to All  > Item Designer  > Administration  > All Items.

2. Open and edit the item record.

3. Click Publish.

Unpublish an item

When you unpublish an item, it is removed from the service catalog.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Item Designer  > Administration  > All Items.

2. Open the item record and select Unpublish.
The item is then inactive within the service catalog, but remains available for editing and 
republishing. This state is useful if you do not want customers to order the catalog item while 
you are making changes to them.

Expire an item

When you expire an item, it is removed from both the service catalog and the item designer.

Before you begin
Role required: admin
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Procedure

1. Navigate to All  > Item Designer  > Administration  > All Items.

2. Open the item record.

3. Click Expire.
The item is removed from the list of active items, and cannot be edited or republished.

Item version

The system can create a new version of the item and deactivate the previous version to ensure 
that items currently being requested are not affected by these changes.

If you alter a question associated with an item, then you can republish the item. For example, if 
you change the default value of a question associated to an item, a new version of that item is 
automatically created when the changed item is published.

As a result, you can see multiple records with the same item name in the Catalog Item Table 
[sc_cat_item]  when viewing all items. The published version of the item is the only active 
one.

Installed with catalog item designer

The catalog item designer adds or modifies tables, user roles, script includes, and other 
components.

Demo data is available with the catalog item designer.

Tables installed with catalog item designer

Tables are added with activation of the catalog item designer.

Tables

Display Name [Table Name] Description

Requesting Item Designer Category Request 
[sc_ic_category_request]

Requests made by users for a new category.

Item [sc_ic_item_staging] Item definitions, used when designing the 
item.

Approval 
[sc_ic_aprvl_defn_staging]

Approvals for items.

Approval Definition [sc_ic_aprvl_defn] Approvals for catalog items.

Approval Definition (Requested Item) 
[sc_ic_req_item_aprvl_defn]

Approvals for requested items.

Approval Type 
[sc_ic_aprvl_type_defn_staging]

Approval types for items.

Approval Type Definition 
[sc_ic_aprvl_type_defn]

Approval types for catalog items and 
requested items.

Task Assignment 
[sc_ic_task_assign_defn_staging]

Task assignment types for items.

Task Assignment Definition 
[sc_ic_task_assign_defn]

Task assignment types for catalog items and 
requested items.
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Display Name [Table Name] Description

Task [sc_ic_task_defn_staging] Tasks for items.

Task Definition [sc_ic_task_defn] Tasks for catalog items.

Task Definition (Requested Item) 
[sc_ic_req_item_task_defn]

Tasks for requested items.

Question [sc_ic_question] Questions for items. Stored as Variables 
[sc_item_variables_task]  records 
for catalog items and requested items.

Question Choice 
[sc_ic_question_choice]

Choices if the question is a choice type 
(select box, multiple choice, or checkbox).

Question Class 
[sc_ic_question_class]

Base variable types to use as the class for a 
question type.

Question Type [sc_ic_question_type] Question types for items.

Question Type Choice 
[sc_ic_question_type_choice]

Choices if the question type is a choice type 
(select box, multiple choice, or checkbox).

Table relationships installed with catalog item designer

Some equivalent information is stored as records in different tables in creating, publishing, or 
requesting areas to provide a controlled environment for item design.

For example, catalog items are stored as Item [sc_ic_item_staging]  records in the 
creating area, as Catalog Item [sc_cat_item]  records in the publishing area, and as 
Requested item [sc_req_item]  records in the requesting area.

This table illustrates the relationships for these records.

Creating Publishing Requesting

Task [sc_ic_task_defn_staging] Task Definition 
[sc_ic_task_defn]

Task Definition (Requested Item) 
[sc_ic_req_item_task_defn]

Item [sc_ic_item_staging] Catalog item 
[sc_cat_item]

Requested item [sc_req_item]

Approval 
[sc_ic_aprvl_defn_staging]

Approval Definition 
[sc_ic_aprvl_defn]

Approval Definition (Requested Item) 
[sc_ic_req_item_aprvl_defn]

Approval Type 
[sc_ic_aprvl_type_defn_staging]

Approval Type Definition [sc_ic_aprvl_type_defn]

Question [sc_ic_question] Variables  [sc_item_variables_task]

Task Assignment 
[sc_ic_task_assign_defn_staging]

Task Assignment Definition  [sc_ic_task_assign_defn]

Roles installed with catalog item designer

Roles are added with activation of the catalog item designer.
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Role
Contains 
Roles

Description

catalog_editor none Can create, modify, and publish items within categories to 
which they are assigned.

Can also perform the following for items and categories to 
which they are assigned:

• Apply existing user criteria.

• Attach a variable set.

• Create a UI policy.

• Edit a catalog item in a catalog client script.

catalog_item_designer none Can view the status of category requests.

catalog_manager none Can request a category, view and assign catalog editors to 
their categories, and create, modify, and publish items within 
their categories.

Can also perform the following for items and categories to 
which they are assigned:

• Apply existing user criteria.

• Attach a variable set.

• Create a UI policy.

• Edit a catalog item in a catalog client script.

UI policies installed with catalog item designer

UI policies are added with activation of the catalog item designer.

UI Policy Table Description

Allow category entry Item [sc_ic_item_staging] Allow category 
entry only if a 
catalog is selected.

Show Mobile Image Item [sc_ic_item_staging] Make the mobile 
image field visible 
if availability is set 
to Both Desktop 
and Mobile  or 
Mobile Only.

Show Desktop Image Item [sc_ic_item_staging] Make the desktop 
image field visible 
when availability 
set to Both 
Desktop and 
Mobile  or Desktop 
Only.

Show Published Item Item [sc_ic_item_staging] Show the catalog 
item if the staged 
item is published.
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UI Policy Table Description

Hide Item field on Item 
Designer - Approval view

Approval [sc_ic_aprvl_defn_staging] Hide the catalog 
item field from 
the item designer 
approval view.

Show "User" field when 
Type=User

Approval [sc_ic_aprvl_defn_staging] Make the user 
field visible and 
mandatory if a 
user approval is 
selected.

Show "Group" field when 
Type=Group

Approval [sc_ic_aprvl_defn_staging] Make the group 
field visible and 
mandatory if a 
group approval is 
selected.

Show "Predefined 
approval" field when 
Type=predefined_approval

Approval [sc_ic_aprvl_defn_staging] Make the 
Predefined 
approval  field 
visible if a 
predefined 
approval is 
selected and the 
predefined type is 
selected.

Show Predefined approval 
description when 
appropriate

Approval [sc_ic_aprvl_defn_staging] Make the 
predefined 
approval 
description visible 
and mandatory 
if a predefined 
approval is 
selected.

Show "User(s)" field when 
Type=User

Approval Type 
[sc_ic_aprvl_type_defn_staging]

Make the User(s) 
field visible and 
mandatory if a 
user approval is 
selected.

Show "Group(s)" field 
when Type=Group

Approval Type 
[sc_ic_aprvl_type_defn_staging]

Make the Group(s) 
field visible and 
mandatory if a 
group approval is 
selected.

Show "Script" fields when 
Type=Script

Approval Type 
[sc_ic_aprvl_type_defn_staging]

Make the Script 
output  and 
Approver script 
fields visible if a 
script approval is 
selected.

Show published 
information

Approval Type 
[sc_ic_aprvl_type_defn_staging]

Make the approval 
definition and 
approval definition 
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UI Policy Table Description

version visible 
if the published 
definition is not 
empty.

Show assignment type 
fields

Task Assignment 
[sc_ic_task_assign_defn_staging]

Make the 
Assignment type 
field visible if it is a 
direct assignment.

Show published 
assignment definition

Task Assignment 
[sc_ic_task_assign_defn_staging]

Make the 
published 
assignment 
definition visible 
if the published 
definition is not 
empty.

Show custom assignment 
fields

Task [sc_ic_task_defn_staging] Make the User(s) 
and Group(s) 
fields visible if the 
assignment has a 
user specified.

Hide Item field Task [sc_ic_task_defn_staging] Hide the Item  field 
if the item is not 
empty.

Hide meta fields Question [sc_ic_question] Hide fields used by 
underlying logic, 
but not requiring 
user input.

Hide Mandatory Question [sc_ic_question] Hide field if type is 
checkbox  or label.

Show default value Question [sc_ic_question] Show default 
values, depending 
on the type of 
variable selected.

Numeric Scale type fields Question [sc_ic_question] Show numeric 
scales: Maximum 
and Minimum  if 
the preconfigured 
variable type 
Number  is 
selected.

Show Choices related list 
when appropriate

Question [sc_ic_question] Show the Choices 
related list if the 
variable type 
Multiple Choice 
or Select Box  is 
selected.

Hide Read Only Question [sc_ic_question] Hide the Read only 
field if the variable 
type Label, Date, 
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UI Policy Table Description

or Date/Time  is 
selected.

Read only question type Question [sc_ic_question] Hide field if the 
variable type Read 
only  is selected.

Hide Item field on Item 
Designer - Question view

Question [sc_ic_question] Hide Staging item 
field if the item is 
selected.

Force preconfigured 
Reference type fields

Question [sc_ic_question] Set the value of 
preconfigured field 
to true and read-
only if the variable 
type reference  is 
selected.

Show Choices related list 
when appropriate

Question [sc_ic_question] Show Choices 
related list if the 
variable type 
Multiple Choice 
or Select Box  is 
selected.

Preconfigured checkbox 
type fields

Question Type [sc_ic_question_type]

Preconfigured Reference 
fields

Question Type [sc_ic_question_type] Show reference 
and reference 
qualifier fields if 
the question type 
is preconfigured 
reference type.

Preconfigured Questions Question Type [sc_ic_question_type] Show question 
text, read only, help 
text, and default 
value fields if the 
preconfigured 
question type is 
selected.

Preconfigured Numeric 
Scale type fields

Question Type [sc_ic_question_type] Show numeric 
scales: Maximum 
and Minimum  if 
the preconfigured 
variable type 
Number  is 
selected.

Show "Predefined 
Approval" field when 
Type=predefined_approval

Approval Definition [sc_ic_aprvl_defn] Make the 
Predefined 
Approval  field 
visible and 
mandatory if no 
type is selected.
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UI Policy Table Description

Show "Group" field when 
Type=Group

Approval Definition [sc_ic_aprvl_defn] Make the Group 
field visible and 
mandatory if no 
type is selected.

Show "User" field when 
Type=User

Approval Definition [sc_ic_aprvl_defn] Make the User 
field visible and 
mandatory if 
the user type is 
selected.

Show "Script" fields when 
Type=Script

Approval Type Definition 
[sc_ic_aprvl_type_defn]

Make the Script 
field visible and 
mandatory if the 
script type is 
selected.

Show "User(s)" field when 
Type=User

Approval Type Definition 
[sc_ic_aprvl_type_defn]

Make User(s) 
field visible and 
mandatory if 
the user type is 
selected.

Show "Group(s)" field 
when Type=Group

Approval Type Definition 
[sc_ic_aprvl_type_defn]

Make Group(s) 
field visible and 
mandatory if the 
group type is 
selected.

Show assignment type 
fields

Task Assignment Definition 
[sc_ic_task_assign_defn]

Make the User(s) 
and Group(s) 
fields visible 
and hide the 
Script  field if the 
direct assignment 
variable type is 
selected.

Custom task fields Task Definition [sc_ic_task_defn] Make the User(s) 
and Group(s) 
fields visible 
and hide the 
Assignment 
Definition  field 
if variable type 
Create my own 
selected.

Script includes installed with catalog item designer

Script includes are added with activation of the catalog item designer.

Note: 
Many of the business rules link to these script includes.
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Name Description

sc_ic_Section Wrapper class for item designer question layout 
sections.

sc_ic_Factory Entry point for all customization of the service 
catalog item designer script.

sc_ic_ColumnSecurityManager Security manager for the Column table 
[sc_ic_column].

sc_ic_QuestionSecurityManager Security manager for the Question table 
[sc_ic_question].

sc_ic_CatalogItemRecordProducer Wrapper class for Record Producer table 
[sc_cat_item_producer] for the item creator.

sc_ic_Base Base class for all item designer wrapper classes.

sc_ic_QuestionClass Wrapper class for the Question class table 
[sc_ic_question_class].

sc_ic_TaskDefnStagingSecurityManage Security manager for the Task table 
[sc_ic_task_defn_staging].

sc_ic_SectionSecurityManager Security manager for the Section table 
[sc_ic_section].

sc_ic_CategoryRequest Wrapper for the category request table.

sc_ic_ApprovalDefnStagingAJAX Helper function which can be called from client 
scripts.

sc_ic_QuestionChoiceSecurityManager Security manager for the Question Choice table 
[sc_ic_question_choice].

sc_ic_ApprovalDefnStagingSecurityManager Security manager for staged approval definitions.

sc_ic_TaskAssignDefnStaging Wrapper class for 
sc_ic_task_type_definition_staging.

sc_ic_TaskDefnStaging Wrapper class for staged task definitions.

sc_ic_Question Wrapper class for item designer questions. 
Subclass to modify and inject using 
sc_ic_Factory. See sc_ic_Factory  for 
more information.

sc_ic_SectionAJAX Service dealing with sections that can be called 
from client scripts.

sc_ic_CatalogTask Wrapper class for Catalog Task table [sc_task] for 
item designer functionality.

sc_ic_CatalogItem Wrapper class for Catalog Item table 
[sc_cat_item] for the item designer.

sc_ic_QuestionChoice Wrapper class for Question Choice table 
[sc_ic_question_choice].

sc_ic_CatalogItemVariable Wrapper for catalog item variables.

sc_ic_ApprovalDefnStaging Wrapper for that approval definition staging table.

sc_ic_ReqItemApprovalDefn Wrapper for requested item approval definitions.
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Name Description

sc_ic_Item Subclasses, injected using sc_ic_Factory. 
For more information, see sc_ic_Factory.

sc_ic_CatalogItemVariableChoice Wrapper class for variable choices.

sc_ic_ReqItemTaskDefn Wrapper for requested item approval definitions.

sc_ic_ItemStagingSecurityManager Security manager for the Item table 
[sc_ic_item_staging].

sc_ic_BaseTypeDefnStaging Base class for all type definition staging classes

sc_ic_Column Wrapper class for item designer question layout 
columns.

sc_ic_ApprovalTypeDefnStaging Wrapper class for staged approval type 
definitions.

sc_ic_CatalogItemRecordProducerService Wrapper class for Service table 
[sc_cat_item_producer_service] for the item 
designer.

sc_ic_QuestionAJAX Service for item designer questions that can be 
called from the client.

sc_ic_QuestionType Wrapper class for item designer question 
types. Subclass to modify and inject using 
sc_ic_Factory. See sc_ic_Factory  for 
more information.

sc_ic_TaskDefnStagingAJAX Service for staged task definitions that can be 
called from client scripts.

sc_ic_RequestedItem Item creator wrapper class for the Requested 
Item table [sc_req_item].

sc_ic_ApprovalTypeDefn Wrapper class for the approval type definition 
table.

sc_ic_TaskAssignDefn Wrapper class for task assignment definitions.

sc_ic_TaskDefn Wrapper class for task definitions.

sc_ic_SecurityManager Base security manager class for the item 
designer tables.

sc_ic_BaseFactory Base factory class. Make all customizations in the 
sc_ic_Factory  class. See sc_ic_Factory 
for more information on how to mount 
customizations.

sc_ic_ApprovalDefn Wrapper for approval definitions.

sc_ic_getCategoriesForModule Class that gets categories.

Client scripts installed with catalog item designer

Client scripts are added with activation of the catalog item designer.
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Script Table Description

Get next 
order 
number

Approval 
[sc_ic_aprvl_defn_staging]

Populates the Order  field by adding 100 to the 
biggest order on an approval definition defined 
against the item.

Get 
Approval 
Type 
Description

Approval 
[sc_ic_aprvl_defn_staging] 
sc_ic_aprvl_defn_design

Displays or hides the approval type description on 
change of the predefined field value.

Reload 
when an 
image is 
deleted 
true

Item [sc_ic_item_staging] Reloads the Item designer form when a Desktop 
or Classic Mobile image is deleted. If it has been 
Published, sets the record back to state Draft.

Process 
Dialog 
action

Item [sc_ic_item_staging] Prompts to make a decision about keeping the 
modifications to the item before completing the 
selected action which causes an update. Performs 
the prompt if the state of the item is set to Published 
and there are unsaved changes to the item record.

Dialog 
functions

Item [sc_ic_item_staging] Defines available dialog functions for actions such as 
display, process, and refresh.

Force 
update of 
Column 
dropdown

Question [sc_ic_question] Updates the Section  choice list values on load of the 
Question  dialog box.

Mandatory 
checked

Question [sc_ic_question] Ensures read only is not true if the question is 
mandatory.

Read only 
checked

Question [sc_ic_question] If the question is read only, ensures mandatory is not 
true.

Populate 
meta fields 
["Type" 
changed]

Question [sc_ic_question] Populates the meta field values on change of Type on 
the Add Question form.

Populate 
meta fields 
["Option" 
changed]

Question [sc_ic_question] Populates the meta field values on change of Option 
on the Add Question form.

Get 
Question 
Type 
Description

Question [sc_ic_question] Displays the Question type description on change of 
the Option field value for the following Types: Multi-
Line Text, Multiple Choice, Reference.

Update 
Order on 
Section 
change

Question [sc_ic_question] Updates the Order value on the question record 
to the next question order number available for a 
selected Section on change.

Hide 
Question 
Type 

Question Type 
[sc_ic_question_type]

Controls the visibility of Question Type Choice related 
list for questions of type Select Box and Multiple 
Choice.
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Script Table Description

Choices 
related list

Adjust 
position for 
display

Section [sc_ic_section] Adjusts the position value on a section record to 
determine the correct display order.

Validate 
and adjust 
Position

Section [sc_ic_section] Validates that the position on a section record value 
is greater than 0 and displays a field message if not.

Get next 
position

Section [sc_ic_section] Populates the position field by adding 1 to the biggest 
position number on a section defined against the 
item.

Get next 
order 
number

Task 
[sc_ic_task_defn_staging]

Populates the Order  field by adding 100 to the 
biggest order on an approval definition defined 
against the item.

Business rules installed with catalog item designer

Business rules are added with activation of the catalog item designer.

Name Table When Description

Validate 
Category

Item [sc_ic_item_staging] BEFORE Abort action if category is invalid.

Set Question 
for non-
preconfigured 
types

Question Type 
[sc_ic_question_type]

BEFORE For non-preconfigured question types, 
set the label using the class name.

Prevent 
multiple non-
preconfigured

Question Type 
[sc_ic_question_type]

BEFORE Abort the insert/update action and 
display an error message to the user if a 
non-preconfigured question type exists.

Set Name 
field

Section [sc_ic_section] BEFORE Set name field to label field and add 
additional message detail.

Set value if nil Question Choice 
[sc_ic_question_choice]

BEFORE Set text field to empty string when value is 
null.

Check for 
duplicate

Section [sc_ic_section] BEFORE Abort the insert/update action and 
display an error message to the user if a 
section exists.

Check for 
Questions 
before 
deleting

Section [sc_ic_section] BEFORE Prevent deletion of columns by aborting 
the delete action and display an error 
message to the user if the column 
contains questions.

Position must 
be between 0 
or 1

Column [sc_ic_column] BEFORE Show message to user.

Check for 
Questions 
before 
deleting

Column [sc_ic_column] BEFORE Show message to user.
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Name Table When Description

Group/user 
required 
for user 
specified

Task 
[sc_ic_task_defn_staging]

BEFORE Show message to user.

The following business rules do not contain independent logic, but simply call methods in script 
includes, as indicated. To find out which business rules call which script includes, refer to the 
default class registrations within the sc_ic_BaseFactory script include.

Name Table When

sc_ic: Copy Approval 
Definitions

Requested Item [sc_req_item] AFTER

sc_ic: Copy Task Definitions Requested Item [sc_req_item] AFTER

Approval definition changed Approval [sc_ic_aprvl_defn_staging] AFTER

Update detail field Approval [sc_ic_aprvl_defn_staging] BEFORE

Set the item to draft Approval Type 
[sc_ic_aprvl_type_defn_staging]

BEFORE

Check and update manager/
editor roles

Item Designer Category Request 
[sc_ic_category_request]

AFTER

Copy changes to real Category Item Designer Category Request 
[sc_ic_category_request]

AFTER

Add Item Designer role on 
insert

Item Designer Category Request 
[sc_ic_category_request]

AFTER

Column changed Column [sc_ic_column] AFTER

Set layout changed on delete Column [sc_ic_column] AFTER

Create default Section Item [sc_ic_item_staging] AFTER

Set draft if changed Item [sc_ic_item_staging] BEFORE

Check for Valid Name Question [sc_ic_question] BEFORE

Question definition changed Question [sc_ic_question] AFTER

Question meta changed Question [sc_ic_question] AFTER

Set definition changed on 
delete

Question [sc_ic_question] AFTER

Set Question Type and Base 
Type

Question [sc_ic_question] BEFORE

Set question name Question [sc_ic_question] BEFORE

Question Choice changed Question Choice 
[sc_ic_question_choice]

AFTER

Set Order number Question Choice 
[sc_ic_question_choice]

BEFORE

Set layout changed on delete Section [sc_ic_section] AFTER

Create default Columns Section [sc_ic_section] AFTER
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Name Table When

Section changed Section [sc_ic_section] AFTER

Set Draft Task Assignment 
[sc_ic_task_assign_defn_staging]

BEFORE

Set assignment details Task Assignment 
[sc_ic_task_assign_defn_staging]

BEFORE

Set assignment details Task [sc_ic_task_defn_staging] BEFORE

Set task definition changed on 
item

Task [sc_ic_task_defn_staging] AFTER

Email notifications installed with catalog item designer

Email notifications are added with activation of the catalog item designer.

Name Table Condition Recipients

Item Designer Category 
Request Opened

Item Designer Category Request 
[sc_ic_category_request]

state EQUALS 
requested

manager

Item Designer Category 
Rejected

Item Designer Category Request 
[sc_ic_category_request]

state CHANGES 
TO rejected

manager

Item Designer Category 
Published

Item Designer Category Request 
[sc_ic_category_request]

state CHANGES 
TO created

manager, 
editors

Configuring Service Catalog

Service Catalog  enables users with the Catalog Administrators role (catalog_admin) to set up the 
service catalog.

Configuration overview

Set up one or more service catalogs and provides self-service opportunities. You can organize 
your catalog offerings by using the ability to publish multiple catalogs targeted to specific 
audiences.

Service catalog categories

Categories organize service catalog items into logical groups.  Administrators and catalog 
administrators can create and configure categories, defining their characteristics and adding 
content such as catalog items to them.

Categories can have a parent-child relationship, for example, IT  and Laptops. A child category 
is a subcategory of its parent category. Each catalog item, order guide, record producer, content 
item, and subcategory appears as a single item within the category. A catalog item can exist in 
multiple categories, giving you the flexibility to offer the same service from multiple places within 
your catalog.

Introduces creating categories in a ServiceNow Service Catalog.
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Service Catalog Categories

Certain system properties control the following Service Catalog  category configuration.

• How categories are displayed to users. For example, are subcategories displayed in a panel or 
as a list in the category view.

• What content types and search and navigation elements are available on the homepage. For 
example, searching the service catalog can be enabled or disabled for all users.

• How catalog items, item class names and item categories appear to users. For example, what 
number of catalog items or categories are previewed in a section.

Catalog managers and catalog editors can also configure categories, but only categories to 
which they are assigned.

Note: 

• If there are no active items in a category’s hierarchy, that category does not appear in the 
catalog, and cannot be added to the catalog.

• Users with the admin or catalog_admin roles can view categories only if there is an active 
item in the category and Availability  is set to either Desktop  or Both.

• Configure the glide.sc.category.canview.override  property to change the 
roles for this behaviour.

Create a category

Administrators and catalog administrators can create or edit a category.

Before you begin
Role required: admin

About this task
To create or edit a category:

Procedure

1. Navigate to All  > Service Catalog  > Catalog Definition  > Maintain Categories.
A list of existing categories appears. If the Parent  field is blank, the category does not have a 
parent category.

2. Click New  or select the category to edit.
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Note: 
The visibility of a category is controlled by user criteria. See Apply user criteria to items 
and categories.

Service Catalog  categories

3. Fill in the fields on the form, as appropriate.

Service Catalog  category form

Field Description

Title Descriptive name for the category.
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Field Description

Application The application scope in which the category is applicable.

Catalog The catalog this category belongs to.

Active Check box to indicate that the category is available to add to the service 
catalog homepage.

Location Any location information relevant for the category.

Parent Any parent category for which this category is a subcategory.

Description Information about the category. The description appears when the category is 
collapsed on the service catalog homepage. The description also appears in 
the Related Categories  list when a user clicks the parent category title.

Icon The small icon displayed beside the category name, when the category is 
listed as a subcategory.

Header icon The icon displayed beside the category header, when the category is a top-
level category.

Desktop 
image

A larger image to display with the category on the Service Catalog  homepage. 
This image is visible only if the relevant renderer defines it to be used (the 
default renderer does not display this field).

Classic 
Mobile image

A picture to use on Classic Mobile devices for this category. If a mobile 
image is not selected, the Desktop image  appears if the Classic Mobile 
Subcategory Render Type  is set to Cards.

Classic 
Mobile 
Subcategory 
Render Type

The rendering option to control how subcategories are displayed. Select List 
for a single-column list, or Cards  for a multi-column display.

Hide 
description 
(classic 
mobile 
browsing)

Option for displaying the description at the top of the list on Classic Mobile 
devices.

Configure dynamic categories

Dynamic categories let you organize and display commonly requested items and knowledge 
articles. Dynamic categories appear on the right side of the service catalog homepage by 
default.

Before you begin
Role required: admin

About this task
Use dynamic categories to provide users with an access option that automatically adjusts to 
changing request trends.

To configure dynamic catalog categories:

Procedure

1. Navigate to All  > Service Catalog  > Catalog Definition  > Maintain Dynamic Categories.

2. Select New  or open an existing dynamic category.

3. Fill in the fields on the Dynamic category  form, as appropriate.
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The Dynamic category  form contains many of the same fields as the Category form. Additional 
fields are:

Name of form

Field Description

Type The kind of items to display. Can be Requested items  or KB Articles

Search 
how 
long?

For catalog items only, the period during which to search for the most common 
requests. For example, enter 7 00:00:00 to display the most commonly requested 
items in the previous seven days.

Number 
of 
Entries

The number of items to display in the dynamic category.

4. Use this example of a step with additional info.
The results displayed are limited to those items or knowledge articles available in the currently 
viewed catalog.

Service catalog setup

Service Catalog enables users with the Catalog Administrators role (catalog_admin) to set up the 
service catalog.

Service Catalog  enables you to set up one or more service catalogs and provides self-service 
opportunities. You can organize your catalog offerings by using the ability to publish multiple 
catalogs targeted to specific audiences.

An overview of ServiceNow service catalog administration.

Set up a service catalog

To set up a Service Catalog, plan the way your organization defines and maintains Service 
Catalog items, and how it fulfills them.

Before you begin
Role required: admin

About this task
Administrators and catalog administrators, users with the catalog_admin role, can use the 
Service Catalog application to define service catalog content and layout. Catalog managers, 
users with the catalog_manager role, can define and manage a single service catalog. Catalog 
editors, users with the catalog_editor role, can manage a single service catalog.

Administrators and catalog administrators can define and manage multiple service catalogs. 
A catalog manager can define and manage a single catalog. One or more catalog editors can 
manage a single catalog.

Follow these steps to plan for your service catalog:

Procedure

1. Assign roles to the users working with the service catalog.

2. Define content to provide in the service catalog:

Catalog items The goods and services available within the catalog.
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Categories The groups of items displayed on the catalog home page

Variables The options available for tailoring a catalog item to meet specific needs.

3. Customize the service catalog homepage to meet your requirements such as defining a 
Classic Mobile layout.

4. Define the request fulfillment processes your organization uses to deliver ordered catalog 
items.

5. Optional:  Create a navigation module for the new catalog.

6. Optional:  Add the catalog to the multi-catalogs home page.

What to do next
Administrators and catalog administrators can further extend the service catalog to provide more 
powerful features, using specialized catalog items, configuration options, and scripting functions. 
For example, administrators can customize the checkout process used when ordering catalog 
items.

Related topics

Service Catalog terms and roles

Set up Platform URLs for catalog modules

You can direct users to a specific catalog via a URL to a module in that particular catalog.

Before you begin
Role required: admin

About this task
When you create a module for your catalog page, you can direct users to a specific catalog and 
view from this module via a URL.

Procedure

In the Link Type  section, select URL (from Arguments), then in the Arguments  field, enter 
a URL of the form catalog_home.do?sysparm_catalog=id of sc_catalog 
record&sysparm_catalog_view=view name of sys_portal_page.

For example,  catalog_home.do?
sysparm_catalog=742ce428d7211100f2d224837e61036d&sysparm_catalog_view=catalog_technical_catalog

Note: 
If you make the default catalog inactive, then deactivate the Catalog  module otherwise 
users can continue to access the inactive catalog using that module.

If a URL has a valid sysparm_catalog parameter, but an invalid or missing 
sysparm_catalog_view  parameter, the view with the default value from the corresponding 
Catalog Portal Page record is used.

If a URL has a valid sysparm_catalog_view  parameter, but an invalid or missing 
sysparm_catalog  parameter, the corresponding Catalog Portal Page record is used to set 
the catalog.

Note: 
To ensure peak performance, define both parameters correctly.
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Multiple service catalogs setup

Multiple service catalogs enable your organization to offer different sets of services to different 
teams within the organization, such as IT services, human resources, and facilities management.

Administrators and catalog administrators can define and manage multiple service catalogs. End 
users can access multiple catalogs from a single homepage, can search across all catalogs, or 
can search directly within each catalog.

Enabling access for catalogs

You can enable read access to the catalogs by applying the rule read ACL  on Catalog 
(sc_catalog) table. See Access Control Rules  for more information.

Create a catalog

Using Service Catalog, you can create a catalog and define items and categories within the 
catalog.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Service Catalog  > Catalog Definitions  > Maintain Catalogs.

2. Select New.

3. Enter the new catalog details (see table).

4. Right-click the form header and select Save.

5. Define catalog items and categories to include in the catalog.

6. Optional:  Define additional portal pages for the catalog.

7. Optional:  Manage sites  if you are using a CMS system.

Field Description

Title Descriptive name for the catalog.

Application The application scope for this catalog. For information on the application scope, 
see Application scope  .
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Field Description

Manager Name of the catalog manager assigned to this catalog.

(Optional) The manager is able to edit and update the catalog, as well as the 
categories and catalog items within the catalog. The manager can assign 
editors and also a different manager for the catalog, if desired.

Only one manager can be assigned to a catalog and must have the catalog 
manager role or catalog_admin role assigned.

Active Select the check box to make the catalog available to end users.

Editors Name of the catalog editor.

(Optional) The editor is able to edit and update the catalog, as well as 
categories and catalog items within the catalog. The editor can assign other 
editors, but cannot change the manager.

Multiple editors can be assigned to a catalog. Each user must have the catalog 
editor role assigned.

Enable 
Wish List

Select the check box to enable the wish list feature for the catalog.

Description Information about the catalog, displayed on the multi-catalog homepage.

Background 
Color

The background color used for the catalog on the multi-catalog homepage.

Desktop 
image

The larger image to display with the catalog on the multi-catalog homepage. 
This image is only shown if image display is included in the renderer  selected, 
such as the default Title and Image  renderer.

'Catalog 
Home' page

The location to direct service catalog users to when they click the Catalog 
Home  button. This field is designed to reference a content page url suffix.

'Continue 
Shopping' 
page

The location to direct service catalog users to when they click the Continue 
Shopping  button. This field is designed to reference a content page url suffix.

What to do next
To add a module in the navigator for the new catalog, see Create a module .

Manage items in a catalog

Using Service Catalog, you can view and manage items within a catalog.

Before you begin
Role required: admin

About this task
Use the Catalog Items  related list on the Catalog form to view and manage the items available in 
the catalog.
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To define a new catalog item for the catalog, click New  and enter the details  for the item.

Manage catalog portal pages

Using Service Catalog, you can create and manage multiple portal pages for a catalog.

Before you begin
Role required: admin

About this task
A catalog portal page provides a homepage  for a specific catalog. You can use portal pages to 
create different catalog views for different user groups. Each portal page accesses the same 
catalog content and presents that content in different ways.

Catalog portal page details include the owner, title, and view to use for that page.

Procedure

1. The Catalog Portal Pages related list shows portal pages available for that catalog.
Each catalog has a default page, created automatically when the catalog is created.

2. Select an appropriate action:

◦ Click New  to create a new portal page.

◦ Click Edit  to select another portal page for the catalog.

◦ Select a portal page to view and edit details for that page.

Tables provided with multiple service catalogs

Administrators and catalog administrators must consider these points before they upgrade to 
multiple service catalogs.

Before upgrading, be aware of changes made to the underlying Service Catalog  data model. 
These changes are made to implement multiple catalogs and do not affect a standard upgrade. 
However, if you have made customizations, such as changes to the data model, the changes can 
impact the instance.

The following tables are provided with multiple service catalogs:
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Tables provided with multiple service catalogs

Table [name] Description

Catalog Site 
[sc_catalog_site]

Associates catalogs to sites.

Catalog Portal Page 
[sc_catalog_view_mtom]

Links catalogs to CMS portal pages. Defines the default catalog to 
portal page combination used by default links.

Catalog Items Catalog 
[sc_cat_item_catalog]

Stores the catalogs an item is available in.

Catalog Item Category 
[sc_cat_item_category]

Stores the categories an item is available in.

Catalog site records

Catalog site records appear in the Sites  related list on the Catalog form.

The Catalog Site [sc_catalog_site] table associates catalogs with CMS web sites .

Several service catalog system properties  are used to specify values for different sites used by 
different catalogs.

Catalog site records properties

Property Catalog site field [name]

glide.sc.home.cms_page CMS homepage [cms_home]

glide.sc.search.cms_page CMS search page [cms_search]

glide.sc.continue.shopping.target CMS 'Continue Shopping' page [cms_continue_shopping]

Service Catalog scoping

Scoping support is available to define the limits of entities in Service Catalog.

• A catalog can have categories from different scopes.

• A category can only be in the same scope as its parent category.

• You can associate a catalog item with categories of a different scope.

• Catalog items can contain variable sets from a different scope.

• Variables can only be in the same scope as the catalog item or variable set.

• Catalog UI policies can only be in the same scope as the catalog item or variable set.

• Catalog client scripts can only be in the same scope as the catalog item or variable set.

• Catalog data lookup can only be in the same scope as the catalog item or variable set.

• The rule base of an order guide can have items from different scopes.

• The scope of the record producer and the target table should be the same.

Scriptable service catalog variables

You can use scripting to reference any request item variable from a table in scoped and non-
scoped environment.

An example of a variable reference follows.
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current.variables.<variable_name>

Where current refers to the current record, and <variable_name>  is the name of your 
variable.

Note: 
In order to reference a variable from JavaScript, it must have a name.

When a variable is part of a variable set, you can reference it as 
current.variables.<variable_name> or current.variables.<variable_set_name>.<variable_name>.

Variable set is also a first-class citizen in Service Catalog. Like variables, a variable set has read, 
write, and create roles. If roles are provided for a variable set, the roles are applicable for the 
variables within the set. Roles of an individual variable are overridden by the roles of the variable 
set.

Print a variable

var original = current.variables.original_number;
gs.print(original);

Set a variable

current.variables.name = "Auto-Generated:" + 
 current.variables.asset_tag;

Create an inventory item with fields set from variables

doCreation();
 
function doCreation ( ) {
var create = current.variables.create_item;
if (create == 'true') { // we want to create an asset
  var computer = new GlideRecord('cmdb_ci_computer');
  computer.initialize();
  computer.asset_tag = current.variables.asset_tag;
  computer.serial_number = current.variables.serial_number;
  computer.name = current.variables.name;
  computer.manufacturer = current.variables.company;
  computer.insert(); } }

Get GlideElementVariable of variables and variable sets associated with a 
GlideRecord

now_GR.variables

Get the name value pair of variables associated with a GlideRecord

now_GR.variables.getVariableValue();

Get a list of GlideElementVariable for variables within a task record

now_GR.variables.getElements();
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Get a list of GlideElementVariable for variables (including multi-row variable set) 
within a task record

now_GR.variables.getElements(true);

Note: 
The getElements()  method returns all the variables present on the given task record 
except for the formatter variables like label, break, container end, container split, and so on.

APIs for GlideElementVariable

• now_GR.variables.<var_name>.isMultiRow(): Get whether the 
GlideElementVariable is a multi-row variable set or a variable.

• now_GR.variables.<var_name>.getQuestion(): Get the Question object for 
a variable. Applicable only for a variable (isMultiRow()  is false) and not for a multi-row 
variable set.

• now_GR.variables.<var_name>.getLabel(): Get the label of the 
GlideElementVariable. For a variable, the label of the variable is returned. For multi-row variable 
set, the title of the variable set is returned.

• now_GR.variables.<var_name>.canRead(): Get whether the user can view a 
variable or multi-row variable set.

• now_GR.variables.<var_name>.canWrite(): Get whether the user can edit a 
variable or multi-row variable set.

• now_GR.variables.<var_name>.getDecryptedValue(): Get the decrypted value 
for a masked variable. Applicable only for a masked variable.

• now_GR.variables.<var_name>.getRows(): Get the list of row objects for a multi-
row variable set. Applicable only for a multi-row variable set (isMultiRow()  is true).

• now_GR.variables.<var_name>.getRowCount(): Get the number of rows for multi-
row variable set. Applicable only for a multi-row variable set (isMultiRow()  is true).

Example to access variables of GlideRecord for the Task table

var now_GR = new GlideRecord('sc_req_item');
if (now_GR.get('635a1f5387320300e0ef0cf888cb0b73')) {
    var variables = now_GR.variables.getElements();
    for (var i=0;i<variables.length;i++) {
        var question = variables[i].getQuestion();
        gs.log(question.getLabel() + ":" + question.getValue())
    }
}

Example to access a multi-row variable set of GlideRecord for the Task table

var now_GR = new GlideRecord('sc_req_item');
now_GR.get('02c38dcd87013300e0ef0cf888cb0bb2');
 
var vars = now_GR.variables.getElements(true);
 
for (var i=0; i<vars.length; i++) {
    var now_V = vars[i];
    if (now_V.isMultiRow()) {
        var rows = now_V.getRows();
        for (var j=0; j<now_V.getRowCount(); j++) {
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            var row = rows[j];
            var cells = row.getCells();
            for (var k=0; k<cells.length; k++) {
                var cell = cells[k];
                gs.info(cell.getLabel() + ":" + 
 cell.getCellDisplayValue())
            }
        }
    }
}

Multi-row variable set

Multi-row variable set

Operation Usage

Table operations

Return JSON array value as String
now_GR.variables.table_var

Set value of a multi-row variable set
now_GR.variables.table_var = 
 <val>

Note: 
An array of ordered (key, value) pairs is 
also applicable as input.

Get value of column, var1, of a multi-row 
variable set now_GR.variables.table_var.v

ar1

Set value of a variable set, var1
now_GR.variables.table_var.v
ar1 = <val>

Note: 
An array of ordered (key, value) pairs is 
also applicable as input.

Row operations

Get the current row count
now_GR.variables.table_var.get
RowCount()

Returns the row specified by the variable "i" - 
getRow(<int> i) var row = 

 now_GR.variables.table_var.ge
tRow(<int> i);

Get the cell value for a question column 
mapped to <var_name> row.<var_name>

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4016



Multi-row variable set  (continued)

Operation Usage

Set the cell value for a question column 
mapped to <var_name> row.setCellValue('<var_name>',

value)

Set the cell value for a question column 
mapped to <var_name> row.<var_name> = value

Add an empty row at the end of the table and 
return a scriptable object var row = 

 now_GR.variables.table_var.ad
dRow()

Delete a row
row.deleteRow()

Notes and limitations

• //Single column of table_Var

• now_GR.variables.table_var.var1

• now_GR.variables.table_var.var1 = <val>

1. You can only set  a variable in a before  business rule. Variables set in an after  rule are not 
written to the database.

2. There is nothing in place to prevent namespace collision with variables. Creating two variables 
named computer_speed would result in only one of them showing up; the second one would 
overwrite the first one.

3. Date/time variables use the same time zone formatting and storage rules as all other dates in 
the system. They are stored internally in GMT, but translated into the user's local time zone and 
format for display.

Define filters for My Requests

Define request filters to filter incidents, requests, or tasks under the Self-Service  > My Requests 
module in ServiceNow AI Platform, the My Requests  widget in Service Portal, and the My 
Requests applet in the Now®  Mobile  app.

Before you begin
Role required: catalog_admin or admin

Since the My Request Filter [request_filter] table has been reparented to the Filter [sys_filter] 
table, a few fields from the My Request Filter table have been migrated to fields in the Filter table. 
The Short Description  field from the My Request Filter table has been migrated to the Title  field 
in the Filter table. The Table Name  field from the My Request Filter table has been migrated to 
the Table  field in the Filter table.

Note: 
If the My Request Filter form is modified, the form still displays the Short Description  and 
Table Name  fields that are no longer valid. Delete these invalid fields from the form and add 
the Title  and Table  fields to the form.
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Procedure

1. Navigate to Service Catalog  > Catalog Administration  > My Request Filter.

2. On the form, fill the fields.

My Request Filter form

Field Description

Title Name of the filter.

Table Table on which the filter condition is applied.

Application Application scope of the filter.

Active If set to true, the filter is active.

Applies to Interface for which the filter is applicable. Possible values:

◦ Desktop

◦ Service Portal

◦ Desktop/Service Portal

◦ Mobile

Filter Conditions to filter requests.

Portal Settings

This section is displayed when the Applies to  field is set to Service Portal  or All.

Portal page Portal page that opens when you click the request.

Primary 
field to 
display

Primary information displayed for the request.

Secondary 
fields to 
display

Secondary information displayed for the request.

Note: 

◦ Add a maximum of three secondary fields.

◦ Do not add an image field.

◦ If the Request [sc_request] table is selected, secondary field is not 
configured. If the request contains only one item, the Requested Item 
name is displayed. Else, it contains the requested item count.

3. Click Submit.

Related topics

My Requests widget

Activate the page route map for the standard ticket page

Delegated request experience

You can request a catalog item on behalf of another user or multiple users using the Requested 
For variable.

Delegated request experience comprises of the following entities:
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• Requested For variable for a catalog item. For information about this variable, see Requested 
For.

• Requested For field on a requested item (RITM)

Note: 
The form views, list views, and email notifications are not updated to reflect the 
Requested For field on a RITM.

Configuration options

The following configuration options are available:

• Specify who you want to submit the request for using the Requested For variable. You can also 
map the Requested For variable to a field on the table for record producers.

• If required, configure the Requested For  field on the RITM form. This field automatically stores 
the value of the Requested For variable.

• Allow delegated requests for a catalog item using its Access Type  field, where you can specify 
if a request can be submitted for a user who does not have access to the catalog item.

• Submit a single request for an item on behalf of multiple users in Service Portal

Important: 
If two-step checkout is enabled, the delegated request experience is not supported.

Request Management

After you submit a catalog item request, the Requested For variable value is copied to the 
Requested For  field of the RITM. In case this field is not available on the RITM form, you should 
configure it.

Note: 
After you submit a catalog item, the Requested For  field value is not automatically updated 
when the Requested For variable is modified, and vice versa.

In Service Portal,

• If RITMs have different Requested For users, the following information is displayed in the 
order status page.

◦ The Requested For  column to display the RITM's Requested For user.

◦ When the user viewing the Order Status page is not the user who submitted the 
request, the Requestor  information to display the request's Requested For user. This 
is also applicable in Now Mobile, when the user viewing the RITM is not the user who 
requested it.

• If the RITM's Requested For user is different from the request's (REQ) Requested For 
user, My Requests menu displays the RITM records to the user who the RITM is being 
requested for. If the RITM Requested for is the same as the REQ requested for user, My 
Requests menu displays REQs.

• When you create a bundle from the cart by adding a catalog item with a Requested 
For variable, the item preserves the variable value. When you later add it to the cart to 
request for another user, you should edit the Requested For variable value as required.
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Request experience for a record producer

After you submit a record producer, the Requested For variable value is copied to the target 
record's field based on the Map To Field  configuration.

Request experience for an order guide

This experience is supported in an order guide only if the following conditions are met:

• Order guide has a Requested For variable

• All items in the order guide have a Requested For variable

A catalog item is included in an order guide based on the Requested For user's access to a 
catalog item.

• When the user has no access to the catalog item and its Access Type  is set as Restricted, 
that item is not included in the order guide.

• When the user has no access to the catalog item and its Access Type  is set as Delegated, 
that item is included in the order guide.

The Requested For variable value from the Describe Needs  section is always cascaded to the 
Requested For variable of catalog items in rule bases.

• The cascading of the Requested For variable value depends just on the variable type, but not 
the variable name.

• The Requested For variable value is cascaded even when the Cascade Variables  check box is 
not selected for the order guide.

• The Requested For variables in the included catalog item cannot be edited.

Submitting a catalog item request for multiple users

To support submitting a request for multiple users, you can configure the Requested For variable 
of a catalog item.

1. From the Type Specifications  tab, select the Enable also request for  check box.

2. Specify the roles in the Roles to use also request for  field that can submit a catalog item 
request for multiple users. If no role is specified, anyone who has access to the catalog item 
can submit the request.

After you configure the Requested For variable of a catalog item, the Also request for  field is 
displayed for that item in Service Portal. After you specify multiple users in this field, you can:

• Add the item to the cart

◦ Separate cart items are created for each user specified in the Also request for  field.

◦ The Requested For variable of each cart item is populated with the corresponding user.

• Submit the request

◦ A single request is created and assigned to the current logged-in user requesting the item

◦ Separate RITMs are created, one for each user specified in the Enable also request for  field 
and the Requested For variable.
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Note: 

• This experience is available in Service Portal.

• This experience is not available in Now Mobile and Workspace.

• This experience is not available for a record producer and order guide.

• The Also request for  field is not displayed in the wish list and cart.

• Catalog client scripts, catalog UI policies, and g_form() APIs are not applicable for the 
Also request for  field.

• The Also request for  field is displayed only if the Requested For variable is editable. For 
example, the field is not displayed if the requesting user has no write permissions for the 
Requested For variable, or if the variable is made read-only via catalog client scripts.

• You can add up to a maximum of 50 users in the Also request for  field.

• If any of the users does not have access to a catalog item with Access Level  set as 
Restricted, then the item cannot be added to cart.

Request cloning

When you clone a request:

• The Requested For value for the cloned request is updated with the user for whom the request 
is being cloned.

• The Requested For value for cloned RITMs (with or without a Requested For variable) is 
updated with the user for whom the request is being cloned for the following entities:

◦ RITM Requested For user

◦ Requested For variable value

For information about cloning requests, see Clone requests.

Important: 

• You can clone a request only when all RITMs are requested for the same user.

• You cannot clone a request for a user who does not have access (based on Access Type) 
to any item in the request.

• Variable dependencies on the Requested For variable are not considered when a 
request is cloned.

Cart behavior

Using the Requested For variable, you can add multiple catalog items to the cart for different 
users and submit the cart as one request. When you submit a request for a cart with multiple 
items, a single request is created with separate RITMs, one for each catalog item. In this case, 
the Requested for  field of each RITM inherits the corresponding Requested For variable value.

When you add multiple items to the cart for different users and submit the request, a single 
request is created with a separate RITM for each catalog item with the corresponding Requested 
For user.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4021



Cart submission scenarios

Scenario Cart behavior

All items in the cart have a Requested 
For variable and are requested for the 
same user

• Requested For value of the RITM is the Requested 
For variable value.

• Requested For value of the request is the Requested 
For variable value.

All items in the cart have a Requested 
For variable and are requested for 
different users

• Requested For value of the RITM is the Requested 
For variable value.

• Requested For value of the request is the logged-in 
user or the default Requested For user specified in 
the cart.

No items in the cart have a Requested 
For variable

• Requested For value of the RITM is the default 
Requested For user specified in the cart.

• Requested For value of the request is the logged-in 
user or the default Requested For user specified in 
the cart.

Few items in the cart have a 
Requested for Variable while others do 
not

• Requested For value of the RITM is one of the 
following:

◦ If a Requested For variable exists, it is the variable 
value.

◦ If no Requested For variable value exists, it is the 
logged-in user or the default Requested For user 
specified in the cart

• Requested For value of the request is the logged-in 
user or the default Requested For user specified in 
the cart.

Passing parameters for the Requested For variable

You can use parameters in ServiceNow AI Platform  and Service Portal  to specify the default 
Requested For variable value for a catalog item.

• In Platform, pass a user's sys_id as the sysparm_requested_for  value in the URL.

• In Service Portal, specify the requested_for_id  and requested_for_display 
parameters in widget instance options.

For example, navigate to a catalog item widget, press Ctrl+click to select Instance in Page 
Editor, and specify the following parameters in the Additional options, JSON format  field.

"requested_for_id": "a8f98bb0eb32010045e1a5115206fe3a
"requested_for_display": "Abraham Lincoln"

Note: 
The Requested For value is set after the catalog form is loaded.
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Related topics

Types of service catalog variables

Configure the default behavior to request items for other users

Define the default behavior when no roles are specified in the glide.sc.req_for.roles 
property.

Before you begin
Role required: admin

About this task
The glide.sc.req_for.roles  property specifies the list of roles who can request 
items for other users. When no roles are specified, then the default behavior is defined 
by the glide.sc.req_for.roles.default  property. For information about the 
glide.sc.req_for.roles  property, see Service Catalog properties.

Following are the possible values for the glide.sc.req_for.roles.default  property.

• When the property is set to allow, then any user can request items for other users.

• When the property is set to deny, then no user can request items for other users.

The value of the glide.sc.req_for.roles.default  property is considered as allow  in 
any of the following scenarios and any user can request an item for other users:

• The glide.sc.req_for.roles.default  property is not defined.

• The value of the glide.sc.req_for.roles.default  property is empty, allow, or any 
string other than deny.

A user with the admin role can request an item for other users. In this case, values of both the 
properties, glide.sc.req_for.roles and glide.sc.req_for.roles.default, are not considered.

For zBoot customers, the glide.sc.req_for.roles.default  property is available in 
the base system with the default value as deny. Upgrade customers can add and modify the 
property if required.

Procedure

1. Navigate to sys_properties.list.

2. Select the glide.sc.req_for.roles.default  property.

3. On the System Property form, in the Value  field, specify the value.

4. Click Update.

Service Catalog  request fulfillment

When a user orders a catalog item, a request is created that follows a fulfillment process. A 
fulfillment process defines the steps to request approval, assign fulfillment tasks, and fulfill 
requests. Flow Designer  flows, workflows, or execution plans are used to define fulfillment 
processes.

Preparing to fulfill catalog item requests involves the following activities.

• Set up fulfillment groups to assign to tasks.

• Define the fulfillment processes using Flow Designer  flows, workflows, or execution plans.

• Assign the fulfillment process to catalog items.
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Using Flow Designer flows

The Flow Designer application enables process owners to automate work, such as approvals, 
tasks, and notifications, without having to code. Build multi-step flows from reusable 
components. For more information, see Exploring Flow Designer .

Using workflows

Workflows provide greater flexibility than execution plans, which are linear. Workflows allow for 
different paths to the end of the process. For example, an approver can reject a request, ending 
the process. If the request is approved, the process continues through fulfillment to the end of 
the process.

Use the Workflow Editor to define fulfillment workflows. The Workflow Editor offers the following 
features.

• Edit workflows graphically.

• Modify activities and conditions.

• Define transitions between workflow activities.

• Summarize workflow progress through stages.

• Validate workflows to identify potential problems.

• Publish workflows for other users.

Service catalog workflows

Two service catalog workflows are provided in the base system. Use the Graphical Workflow 
Editor to modify the default workflows or to create additional service catalog workflows. Service 
catalog workflows support domain separation.

Default service catalog workflows

• Service Catalog Request: a simple workflow that fulfills a simple order.

• Service Catalog Item Request: a more complex workflow that fulfills a more complex order.

Service Catalog Request workflow
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Service Catalog Item Request workflow

Defining service catalog workflows

Creating a workflow involves the following processes:

• Create a workflow to process the catalog item.

• Define the workflow activities to process the catalog item.

• Publish the catalog item workflow.

• Create or edit a catalog item  to call the catalog item workflow

Note: 
If your catalog workflow requires catalog tasks to access catalog variables, create the 
catalog tasks from a parent workflow. A catalog workflow cannot access catalog variables 
from catalog tasks created by a subflow.

Deleting catalog workflow records

Workflow stage fields for service catalog workflows display when a user deletes a record 
required by the workflow. If a user deletes a catalog item and that catalog item has active request 
workflows running, the workflow stage field displays Catalog item removed. Similarly, deleting 
the associated workflow context causes the stage field to display Workflow context removed.

Associating items with the domain-specific workflow

When using service catalog workflows with domain separation, ensure your catalog items use 
the domain-specific workflow. If you create a domain-specific version of a workflow, existing 
catalog items continue to use the original workflow. To configure the catalog item to use the 
domain-specific workflow, select the new workflow in the Workflow  field on the catalog item 
record.

Create a catalog workflow

Create service catalog workflows when the default workflows are not appropriate for a fulfillment 
process.

Before you begin
Role required: workflow_creator, workflow_admin, or admin
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About this task
This example describes the procedure to set up fulfillment for a laptop request.

Procedure

1. Navigate to All  > Workflow  > Workflow Editor

2. Click New Workflow.

Service catalog workflow form

3. Complete the form with the following information.

Field Input value

Name Laptop Fulfillment

Table Requested Item [sc_req_item]

Consider the following information:

◦ Workflows on the Service Catalog  Requested Item [sc_req_item] table fulfill 
the request of a single catalog item. Each requested item triggers its own 
fulfillment workflow when the item is ordered. Use the Requested Item table to 
add workflows for requested items.

Note: 
To enable approval-type workflows to operate smoothly, make sure that 
the appropriate users have the correct role to access necessary tables 
in all domains.

◦ Use caution when using before query  business rules, as they can restrict 
access to the requested item record.

◦ Workflows on the Request [sc_request] table always run when a service 
catalog request is submitted, regardless of what item was ordered. These 
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Field Input value

workflows control the entire request process, which can involve delivering 
several requested items.

Therefore, Request table workflows are not assigned to a specific item from 
the maintain item form. If you do use the Request table for service catalog 
requests, add conditions to the workflow to ensure it runs when the correct 
item is requested.

Expected 
time

Days  7, Hours  00:00:00. Workflows cannot calculate the end time because 
not all the activities within the workflow have defined times. Therefore, the 
Expected time  on the workflow becomes the Delivery Time  on the catalog 
request.

Note: 
When both Expected time  and Schedule  are filled in, the catalog delivery 
time is then calculated based on the combination of both. For example, 
if you put 2 days as Expected time, it is calculated as 48 hours. If you 
then add a schedule that defines a work day as 8 hours, the delivery 
time becomes 48 / 8 = 6 days. If your schedule excludes weekends, the 
calculation also add 2 days for the weekend, making the delivery time 8 
days.

Schedule 8–5 weekdays.

Timezone US/Pacific. The timezone that the schedule applies to.

Description A workflow for the fulfillment of laptop requests.

4. Click Submit.

Service catalog workflow form activities

What to do next
After initiating a workflow, add workflow activities to it. Workflow activities are listed on the Core 
tab in the right pane.
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Add an activity to a catalog workflow

You can add activities to a workflow to perform tasks such as running a script, sending 
notifications, or requesting approvals. Activities can succeed or fail, which can result in actions 
performed by other activities.

Before you begin
Role required: workflow_creator, workflow_admin, or admin

About this task
After creating the workflow to add a laptop fulfillment process, add the activities.

Procedure

1. Complete the following steps to add an activity that requests manager approval.

a. In the Core  pane, expand Approvals  and drag the activity Approval - User  onto the arrow 
between Begin  and End.
This activity generates an approval from the manager of the person requesting the laptop.

b. Complete the form with the following information.

▪ Name: Manager Approval

▪ Stage: Waiting for Approval

▪ User: Click the lock icon in the Approvers section, and then click the select fields icon. 
Expand Requested  > Requested For, and then select Manager.

c. Click Submit.

2. Complete the following steps to add an action for when the approver rejects the request.

a. Expand Utilities  in the Core  pane and drag the activity Set Values  to the space below the 
approval.

b. Complete the form with the following information.

▪ Name: Rejected

▪ Stage: Completed

▪ Values  condition builder: [Approval] [Rejected]

c. Click Submit.

d. Drag from the yellow box beside Rejected  on the Approval - User  activity to the new Set 
Values  activity.

e. Drag again from the yellow box beside Always  on the Set Values  activity to End.
This activity marks the request as rejected if the manager rejects the request and then ends 
the workflow

3. Complete the following steps to add an action for when the approver approves the request.

a. Drag the activity Set Values  onto the arrow between Approval - User  and End.

b. Complete the form with the following information.
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▪ Name: Approved

▪ Stage: Fulfillment

▪ Values  condition builder: [Approval] [Approved]
This activity marks the request as approved once a manager approves it.

c. Click Submit.

4. Expand Tasks  and drag the activity Create Task  onto the arrow between Approval - User  and 
End, add the following information, and click Submit.

◦ Name: Laptop Procurement

◦ Stage: Fulfillment

◦ Task Type: Catalog Task [sc_task]

◦ Priority: 3 - Moderate

◦ Fulfillment group: Procurement

◦ Short description: Procure a Laptop
This task tells Procurement to procure a laptop for the user.

5. Expand Notifcations  and drag the activity Notification  onto the arrow between Laptop 
Procurement  and End, add the following information, and click Submit.

◦ Name: Procurement

◦ Stage: Fulfillment

◦ To: Click the lock icon in the Addressee(s) section, and then click the select fields icon. 
Expand Requested  and select Requested For.

◦ Subject: Your laptop has been procured.
This activity marks the request as approved if a manager approves it.

6. Drag the activity Create Task  onto the arrow between Procurement  and End, and then fill in 
the form.

Option Description

Name Set Up Laptop

Stage Fulfillment

Task Type Catalog Task

Priority 3 - Moderate

Fulfillment Group Hardware

Short Description Set up laptop.

This task tells Hardware to configure the laptop and prepare it for use.

7. Drag the activity Create Task  onto the arrow between Set Up Laptop  and End, add the 
following information, and click Submit.

◦ Name: Pickup Laptop

◦ Stage: Delivery

◦ Task Type: Catalog Task [sc_task]
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◦ Priority: 3 - Moderate

◦ Assigned to: Leave the field blank, as the script in the Advanced  field assigns this task to 
the requester.

◦ Short description: Pick up laptop.

◦ Advanced: Select the check box and set the Advanced Script  value to: 
task.assigned_to=current.requested_for;

This task informs the requester to come pick up the laptop.

8. Drag the activity Log Message  onto the arrow between Pick Up Laptop  and End, add the 
following information, and click Submit.

◦ Name: Delivered

◦ Stage: Completed

◦ Message: The laptop delivery workflow is complete.
Leaves a message in the log to record the successful completion of the workflow.

Publish a catalog workflow

Publish the catalog workflow to make it available for use in the system.

Before you begin
Role required: workflow_creator, workflow_admin, workflow_publisher, or admin

About this task
After adding activities to your workflow, publish it to make it available for use.
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Procedure

1. Open the workflow actions menu on the left beside the workflow name.

2. Click Publish  to publish the workflow.

Execution Plans

An execution plan describes how a catalog item is procured, configured, and installed.

Execution plans enable you to describe simple, linear processes. Each execution plan contains 
one or more tasks. For example, an organization could create an execution plan for delivering a 
corporate standard PC that contains these tasks:

1. Procure the PC from a supplier.

2. Configure the PC according to requester specifications.

3. Deliver the PC to the requester.

An execution plan is not specific to any one catalog item. There could be many different models 
of PC that a user can order, all using the same execution plan. It is not necessary to create a new 
execution plan for each individual catalog item in a mature service catalog.
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Note: 
Execution plans are not as powerful or flexible as workflows, and cannot be designed 
using a graphical editor. Execution plans are useful in some circumstances, for example, 
if you want to build your processes programmatically or through imports. ServiceNow 
recommends using workflows for request fulfillment processes.

Create an execution plan

Administrators and catalog administrators can create and manage execution plans and the 
associated variable tasks.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Service Catalog  > Catalog Administration  > Execution Plans.

2. Click New.

New execution plan

3. Enter a Name  and Short description  for the execution plan.

4. Specify delivery information  in the Total delivery time  and On Calendar  fields.

5. Click Submit.

Add catalog item variables to a task

You can add variables of a catalog item to a task to specify information about the requested 
catalog item.

Before you begin
Role required: admin

About this task
For example, when a user requests a laptop, the fulfillment group can need to know what screen 
size and how much memory to order.

Each catalog item can contain one or more variables for gathering information from the user 
who requests the item. Assuming that the relevant catalog items have been associated to the 
execution plan, you can associate these variables to the specific created tasks that need the 
information.
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Procedure

1. Navigate to All  > Service Catalog  > Catalog Administration  > Execution Plans.

2. Open an execution plan.

3. In the Execution Plan Tasks  related list, open a task.
Ensure that the form shows the Plan view. If not, right-click the header bar and select View  > 
Plan.

4. Go to the Available Variables  related list and click Edit.

5. Use the slushbucket to select the variables that are appropriate for the task.

Consider all the types of catalog items that could use this execution plan, and select all the 
variables that can be assigned to them.

6. Click Save  to associate these variables to the execution plan task, making them accessible.

Execution plan tasks

An execution plan contains one or more execution plan tasks, such as for obtaining approval. 
Execution plan tasks are assigned to a fulfillment group.

Each task represents work to be completed by a specific group as part of the overall request 
fulfillment process.

Administrators create templates for tasks as part of defining an execution plan. The catalog 
tasks themselves are then created when the relevant item is requested, based on these task 
templates.

Set up an execution plan approval task

Approval tasks are specific types of tasks within execution plans.

Before you begin
Role required: admin

About this task
If an approval task is rejected, the execution plan can roll back to a previous task, but the 
approval record does not roll back.

To set up an approval task including a rollback action:

Procedure

1. Navigate to All  > Service Catalog  > Execution Plans.

2. Select an execution plan.

3. From the Execution Plan Tasks related list, select New Approval  to create the approval task.

4. Fill in the fields for that approval task.
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Upon Reject

5. Use the Upon reject  field to define the action to take if the task is rejected:

◦ Cancel all future Tasks: [default] cancels all future tasks in the execution plan and also 
cancels the parent request item.

◦ Go to a previous Task: displays the Rejection goto  field where you can select which task this 
execution plan rolls back to.

6. Save  the task, then scroll down to the Approved By  list and select one or more approvers for 
the tasks.

You can also use an Approval script to select approvers.

7. Select Update  to add the task to the execution plan.

This example shows how the process works in practice, using a request to order a Blackberry 
phone.

First, the request is ordered:

Rollback 1

Next, complete the first two steps, which leads to the approval task.
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Rollback 2

Reject the request to roll back the execution plan to a previous task, and reset any 
intermediate tasks to pending:

Rollback 3

After a plan has been rolled back, ServiceNow  adds to the rolled-back task a note indicating 
that it was rolled back and why.

Note: 
Rolling back reverts all intermediate tasks within the execution plan. Other plans within 
the same request are not rolled back, however.

Set up a fulfillment group

Fulfillment groups perform the tasks related to fulfilling an order.

Before you begin
Role required: admin

About this task
This group setting can include approving an order based on characteristics such as content 
and price, or any direct action required to complete the order. For example, loading software or 
installing hardware. Any existing user group (in User Administration  > Groups) can be assigned 
fulfillment tasks.
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To create a group specifically for order fulfillment:

Procedure

1. Navigate to Service Catalog  > Catalog Policy  > Fulfillment Groups.

2. Click New.

3. Fill in the Group form as described under creating groups.
These groups have the type catalog  and are assigned the catalog and itil roles, but are 
otherwise normal groups.

Delivery information for tasks

When managing execution plans, catalog administrators can specify the delivery information to 
provide an estimated date of delivery based on the execution plan.

Use the Total delivery time  field to specify an estimated delivery time for each task in your 
execution plan. This estimate is calculated based on the combined total of times for the tasks  in 
that execution plan.

By default, time estimates do not use a "working days" calendar system, but are based on simple 
elapsed time. For example, for a 5-day execution plan, if you submit the request on a Friday, the 
delivery date is Wednesday of the following week. This estimate means five elapsed days later, 
even if your organization does not work on weekends.

Setting the calendar to Monday through Friday (9-5) defines each day as being eight hours long, 
but the task delivery time day is 24 hours. If you create a task that takes one day (24 hours), the 
plan calculates the task as needing three work days (which are eight hours each) for the total 
delivery time. Similarly, if a task takes two days (48 hours), the plan calculates eight days of total 
delivery time. This total breaks down as six work days of eight hours each and, because six days 
are longer than the five-day work week, two weekend days. When assigning delivery times, keep 
this calculation process in mind.

Use the On Calendar  field to specify a calendar system to apply to the execution plan, to help 
estimate more accurate delivery times.

If using this calendar system for estimated delivery time, ensure that estimates are expressed 
in working hours and days. For example, a task which is supposed to take one day on a 9-5 
calendar is assumed to take 24 working hours. This process takes three working days.

Note: 
This calendar system is used to help provide delivery estimates only, and is not linked to 
any SLAs you have set on execution tasks.

Skipped tasks

If a task is skipped, the request fulfillment process moves on to the next task.

If the last task in an execution plan is skipped, the process is finished and the appropriate 
request item is closed as complete. Skipped tasks have their state set to Closed Skipped  and 
display as gray boxes on a requested items list.

Creating execution plan tasks

An execution plan contains one or more task templates. Each task template defines work that 
can be completed by a specific fulfillment group.

Execution plans are associated with catalog items. When the relevant catalog item is requested, 
these task templates are used to generate tasks. That is, tasks to be performed as part of the 
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request fulfillment process for that requested item. Each generated task within that requested 
item is assigned a catalog task number.

Example

The execution plan for an executive desktop computer catalog item could define the following 
task templates in the execution plan:

• Obtain managerial approval

• Order hardware

• Install standard corporate applications

• Deliver computer to requester

When this catalog item is ordered, the following request, requested item, and tasks are then 
created:

Request REQ0002 -- 1 PC

Requested Item ITEM0004 -- 1 X executive desktop

• Catalog Task0001 -- Obtain managerial approval

• Catalog Task0002 -- Order hardware

• Catalog Task0003 -- Install standard corporate application

• Catalog Task0004 -- Deliver computer to requester

Define task templates

Each execution plan contains one or more task templates that define actions that must be taken 
to fulfill a request.

Before you begin
Role required: admin

About this task
After creating the execution plan, define these task templates.

When the relevant catalog item is ordered, request tasks are generated for that requested item, 
based on this information.

To define an execution plan task template:

Procedure

1. Navigate to All  > Service Catalog  > Catalog Policy  > Execution Plans.

2. Open an execution plan.

3. In the Execution Plan Tasks  related list, click New.

4. Fill in the fields on the Execution Plan Task form (see table).

5. Click Submit.
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Cat DP Task1

Defining Task Templates

Field Description

Name Name of the task. This name becomes the created task name.

Fulfillment 
group

The group that performs the task. Whenever a user requests a catalog item 
associated with this execution plan, the task is automatically assigned to 
the fulfillment group. Leave blank if automatic assignment to a group is not 
required.

Assigned 
to

The individual who performs the task. Leave blank if automatic assignment to a 
user is not required.

SLA The service level agreement that applies to catalog items associated with this 
execution plan.

Note: 
This field is normally left blank, as the functionality was superseded by the 
service level management functionality.
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Field Description

Delivery 
plan

The parent execution plan for this task.

Order A number representing the task sequence in the execution plan. It is good 
practice to "leave gaps" between order numbers (for example, 100, 200, 300). 
That way you can insert new tasks without changing the order number of 
existing tasks.

(If the order for several execution plan tasks is the same, each of these tasks 
starts at the same time.)

Delivery 
time

Amount of time the task is expected to take. This value becomes a component 
of the overall time to complete the execution plan.

Condition Condition under which the task is performed (if the condition is not met, the 
task is skipped).

Short 
description

Brief description of the task activity. This information populates the created task 
short description field.

Instructions Details of the activities to be performed for the task. This information populates 
the created task description field.

Work notes A journal field for entering comments about the task template. Note: this 
information is separate from the created task work notes field.

Conditions to run execution plan tasks

Administrators and catalog administrators can define conditions under which a particular 
execution plan task runs, or is skipped, when the relevant item is requested.

For example, an execution plan can contain the following tasks:

1. Order hardware

2. Receive hardware

3. Configure hardware

4. Deliver hardware

If the hardware requested is already on-site, it does not need to be ordered. The first task in the 
list can be skipped.

Note: 
Skipped task records are still created, but are marked as skipped, and are not processed 
within the execution plan.

Conditional Tasks

To make an execution plan task conditional, defining the conditions under which the task runs.

1. Navigate to Service Catalog  > Execution Plans.

2. Open an execution plan, and then open a task within that plan.

3. Use the condition  field to select the condition under which the task runs.

If no conditions are set, the task runs every time a user orders an item associated with this 
execution plan.

Here is an example of conditional task for an IT lab based in Atlanta:
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Applying Conditions to Execution Plan Tasks

In this example, the Deliver to IT Labs  step does not run if the request itself is in Atlanta. There is 
no need to deliver something to the IT lab if it is already there.

Condition scripts to run tasks

Administrators can use a condition script in addition to or instead of any condition to determine 
whether a task runs.

Note: 
If you are using both a condition (via the condition field) and a condition script, both must 
be true before the task runs.

To use a script, you must configure the Execution Plan Task form to add the "Condition script" 
field. If the script returns true, the task runs. If the script returns false, the task does not run.

Ensure that you add the variable used in the script to the execution plan task.
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Use Condition Scripts

Service catalog execution plans

Service catalog enables you to associate execution plans with catalog items.

Once you have created the execution plan record, you can associate it with catalog items, create 
task templates, and associate any catalog item variables to tasks, if required.

You can also:

• Apply conditions to tasks

• Create approval tasks, enabling you to step back to a previous step if the approver rejects the 
request.

Associate execution plan with items

After you submit the execution plan record, you select a catalog item to use the execution plan.

Before you begin
Role required: admin

About this task
This association can be done later, but doing it at this stage enables you to access relevant 
catalog item variables in the execution plan.
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Procedure

1. Navigate to All  > Service Catalog  > Catalog Definition  > Maintain Items.

2. Select a catalog item.

3. In the Execution Plan  field, select the new execution plan.

4. Click Update.

Service Catalog checkout models

The service catalog defaults to one-step checkout model, but also allows two-step checkout. 
Administrators and users with the catalog_admin role can enable and configure the two-step 
checkout model and control how the delivery address is populated.

The service catalog defaults to a one-step checkout model. When a user clicks Proceed to 
checkout  or Order now, items in the shopping cart are ordered and the order summary or status 
screen appears. The one-step checkout model runs in the following order:

Press Checkout  > Order Summary

The service catalog also supports a two-step checkout model. Under this model, when a user 
clicks Proceed to checkout  or Order now, an order confirmation screen appears. You can edit 
the order, choose a delivery location, or upload an attachment before submitting the order. The 
two-step checkout model runs in the following order:

Press Checkout Order  > Confirmation Screen  > Submit Order  > Order Summary.

Access check for a catalog item is performed during its checkout. This check is also applicable in 
scripts and APIs.

Enable the two-step checkout process

You can enable the two-step checkout to specify a recipient, delivery address, and special 
instructions for an order.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Service Catalog  > Catalog Administration  > Properties.

2. Locate the property Use the two step catalog checkout model (default false).

3. Select the Yes  check box to enable the two-step process.

4. Locate the property Show the 'Back to Catalog' button on the two step checkout screen.

5. Select the Yes  check box to provide a button that navigates back to the catalog from the order 
confirmation screen (default).
Clear the check box to hide the button.

Specify requester location

Administrators can control how the delivery address is populated. By default the delivery 
address is defined by the client script called set location.
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Requested for

When the two-step checkout process is enabled, the set location  script retrieves the 
address of the user and enters formatted details in the Deliver to  field.

Create a catalog request from another flow

You can create a catalog request to join the Service Catalog flow from a different flow. For 
example, from an incident flow, you can create a request, and associate the request with the 
incident. It helps you in tracking the requests associated with an incident and vice versa.

Before you begin
Role required: itil

• To associate a request with any parent table record, the corresponding mapping configuration 
should be available in the Catalog Administration  > Request Parent Mapping  submodule.

• To associate a record producer request with the parent table record, retrieve the 
sysparm_parent_sys_id  and sysparm_parent_table  parameters from the URL 
using the RP.getParameterValue() method in the Script  field of the record producer.

Note: 
If you set the Use the sc_layout driven cart macros (default true) 
(glide.sc.use_cart_layouts) property to false  and create a request from a parent 
table record, the request is not associated with the parent table record.

Procedure

1. Navigate to the required table and select a parent record.

2. Click the additional actions menu icon  and select Create Request.
The Catalogs home page is displayed with all active catalogs that you can access.

Note: 
If there is only one active catalog, then that catalog page is displayed with available 
categories.
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3. Select the required catalog and navigate through its categories and items.

4. Check out the required catalog item, order guide, or record producer.
For information on checkout models, see .
For a catalog item or order guide, a request is created and displayed under the Requests 
tab of the parent table record. For a record producer, the corresponding task is created and 
displayed under the Problems  tab of the parent table record, for example, an incident.

Note: 

◦ The associated incident is specified in the annotation message throughout the request 
process.

◦ Both for the one-step and two-step checkout, the caller of the incident is automatically 
set as the Requested For  user for the request. If the two-step checkout is enabled, the 
fulfiller can change the Requested For.

Note: 
For delegated request experience, the caller of the incident is populated in the 
Requested For variable. For information on delegated request experience, see 
Delegated request experience.

◦ You cannot add items to the wish list, or save a record producer in this flow.

Configure a parent mapping for a request

You can configure a mapping that specifies the association between the parent record and the 
request record.

Before you begin
Role required: admin or catalog_admin

Procedure

1. Navigate to All  > Catalog Administration  > Request Parent Mapping.

Note: 
The Incident request configuration that creates a mapping between the incident table 
and the request table is available by default.

2. Click New  and specify the field information.

Request Parent mapping fields

Field Description

Name Name of the mapping configuration for a request.

Parent 
table

Table from which the request is created.

Request 
Parent

Request table field that specifies the association with the parent table.

Parent 
requestor

User reference field on the parent table that is specified as the requestor of the 
request.
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Field Description

Note: 
For delegated request experience, the user from the parent table record 
is populated in the Requested For variable. For information on delegated 
request experience, see Delegated request experience.

3. Click Submit.

State closure in the request fulfillment execution plan

The state closure in the request fulfillment process of a catalog item depends on the status of the 
associated catalog tasks, request items, and the request. It is applicable only for execution flows.

State closure dependency between a catalog task and RITM

• If all catalog tasks are closed as Closed Complete, the RITM is closed as Closed Complete.

• If there is at least one catalog task closed as Closed Incomplete, the RITM is closed as Closed 
Incomplete.

• If all catalog tasks are closed as Closed Skipped, the RITM is closed as Closed Skipped.

State closure dependency between a RITM and request

• If all RITMs are closed as Closed Complete, the request is closed as Closed Complete.

• If there is at least one RITM closed as Closed Incomplete, the request is closed as Closed 
Incomplete.

• If all RITMs are closed as Closed Skipped, the request is closed as Closed Skipped.

View request notifications

View request notifications that are sent during specific events in a catalog request life cycle. 
These notifications are sent to various recipients including the Employee Center and ITIL users.

Before you begin
Role required: admin

About this task
Use the email notification layout and template that is shipped with the Employee Experience 
Foundation (com.snc.sn_ex_emp_fd) plugin to deliver notifications that are consistent and built 
with industries best practices layout. Applying the layout to email notifications elevates the look 
and feel, and also helps to deliver branded notifications. For more information, see Use email 
notification layout .

Procedure

1. Navigate to All > System Notification > Email > Notifications.

2. View the notifications related to request by filtering the Table  field by sc_requestand 
sc_req_item.

3. Click the notification name to view the details.

Note: 
To receive these notifications, the end user must enable notifications. For more 
information, see Subscription-based notifications .
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Service Catalog  security

Service Catalog  enables you to set the security for catalog with user criteria.

Set security for items and categories

An administrator can control access to content in the service catalog by creating and applying 
user criteria records.

Catalog managers and catalog editors can apply existing user criteria for items and categories 
to which they are assigned. Catalog managers and catalog editors cannot create or edit user 
criteria directly.

You can create user criteria records  that define conditions for user information and then apply 
these criteria records to catalog items and categories. In this way you can control access to these 
items and categories.

For example, create a USA Sales  user criteria record matching users who are both in the sales 
team and based in the USA. Then apply this record to the USA IT Hardware  catalog category, so 
only users matching the record can access that category.

The feature is active by default in new Fuji instances and upgraded instances that do not use 
entitlement-based  access controls. If you upgrade an instance that uses entitlements, you can 
migrate to user criteria  to take advantage of the improved control, flexibility, and reuse.

Access controls allow you to:

• Manage access to multiple items and categories in one user criteria record. For example, 
create a single UK Employees  user criteria record and apply it to multiple items and categories 
that are available to employees in the UK.

• Allow access if one condition matches, or if all conditions match. For example, define that only 
users who are both in a specific location and who belong to a specific department can have 
access.

• Use Available For  and Not Available For  lists to allow or prohibit access to users matching 
the conditions in a criteria record. For example, specify that a US-based catalog category is 
available for the users located in the USA but is not available for users belonging to the Sales 
department (whether in the US or not).

• Extend matching  to create conditions matching additional fields in the User [sys_user] table, 
without having to use a script. For example, you can add a condition to match items against the 
Cost center  field in user records.

Important: 
After making user criteria additions or changes, you may need to log out and log back in to 
clear the prior configuration.

Related topics

Debug user criteria of a catalog item

Create a user criteria record in Service Catalog

Create a user criteria record to define conditions that are evaluated against user records.

Before you begin
Role required: admin, catalog_admin

About this task
You can apply several user criteria records to a single catalog item or category. In this situation, 
users match only one of these criteria records to have access.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4046



Procedure

1. Navigate to All  > Service Catalog  > Catalog Definition  > User Criteria  and create a record.

2. Fill in the fields on the form, as appropriate.

User criteria fields

Field Description

Name The name of the criteria record.

Users The individual user records to match.

Groups The group records to match.

Roles The roles to match.

Note: 

◦ The evaluation of a role is cached in the session, so any change in the 
role requires you to logout and login, similar to roles in ACL (Access 
Control List).

◦ User Criteria is not applicable for elevated privilege roles.

Advanced A check box to display or hide the Script  field.

Script A script  to define any additional criteria, and return true  or false. This field is 
available only if Advanced  is selected.

Note: 

◦ The script is evaluated in the scope that the user criteria is created in.

◦ The evaluation of the script is cached in the session, so any change in 
the evaluation requires you to logout and login, similar to roles in ACL.

◦ Do not use gs.getUser()  or other session APIs since they cause 
conflict when used in diagnostic tools. Use the pre-defined user_id 
variable available in the script to get the user id of the user being used 
to evaluate the script.

◦ Because scripts are evaluated dynamically, including scripts in user 
criteria records can decrease performance.

◦ Because answer is a pre-reserved keyword, do not use a function with 
its name as answer, that is, answer().

Active A check box to activate or deactivate this criteria record.

Companies The companies to match.

Locations The locations to match.

Departments The departments to match.

Match All A check box to determine whether all elements from each populated criteria 
field must match. If selected, only users who match all criteria are given 
access. If cleared, the user must meet one or more of the set criteria to be 
given access.

By default, this check box is cleared so that any condition met provides a 
match.
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Field Description

For example, consider a user criteria record for the following:

◦ Locations A or B

◦ Company C or D
With Match All  selected, only users meeting all these conditions are matched. 
For example, a user with a location A and a company C.

With Match All  cleared, users meeting any of these conditions are matched. 
For example, a user with a location B.

Note: 
If you select Match All, ensure that you do not create contradictory 
conditions which can never be met. For example, if all users in location 
A work for company G, then the conditions in this example can never be 
met.

Implementing user criteria

When creating user criteria for your system, consider the following recommendations.

• Design Criteria for Reuse:

Ensure that you design user criteria for maximum reuse. Create user criteria records with 
common sets of conditions matching your organization requirements. Allow them to be shared 
across as many items and categories as possible, rather than creating multiple similar criteria 
records for individual items and categories.

• Naming conventions: Give each user criteria record a meaningful name, to help you determine 
the function for that record. For example,

◦ Users in company Cloud Dimensions AND in Madrid

◦ Users in company Cloud Dimensions OR in Madrid

◦ Users belonging to the Group Development, IT, or Sales

◦ Users with role itil, asset_manager, or catalog_admin

• Test user criteria on a development or test instance, and then transfer the records from the 
user criteria tables and catalog records to your production instance using update sets .

Apply user criteria to items and categories

Apply a user criteria record to items and categories, either from the item or category form or from 
the user criteria form.

Before you begin
Role required: admin

About this task
The user criteria restriction applies only within Service Catalog  for the specific item it is applied 
for. However, the user criteria restriction is not applied outside the Service Catalog  where the 
user has access to the item via the table.

To apply criteria directly to an item or category, use the Available For or Not Available For related 
lists in the Item or Category form.
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Note: 

• When a change is made to the end-user profile, such as location, and it affects their 
ability to view items, those changes do not take effect until the end user has relaunched 
the session.

• The user criteria restrictions of a category do not automatically apply to the catalog items 
within the category. If required, you should apply the user criteria restrictions to the 
individual catalog items.

To apply criteria directly from the User Criteria form, add items to the Available For Catalog 
Items and Not Available For Catalog Items related lists, and add categories to the Available For 
Categories and Not Available For Categories related lists. You can configure the User Criteria 
form to add these lists.

Note: 

The Not Available For  settings override Available For  settings. A user on the Not Available 
For  list for an item cannot access that item, even if that user is also on the Available For  list 
for that item.

Apply user criteria to items

Apply user criteria to an item to define which users can and cannot access that item.

Before you begin
Role required: admin

About this task
You can apply user criteria to all types of catalog item, including order guides, content items, and 
record producers.

Note: 
The user criteria restriction applies only within Service Catalog  for the specific item it is 
applied for. However, the user criteria restriction is not applied outside the Service Catalog 
where the user has access to the item via the table.

Procedure

1. In an item record, navigate to the Available For or Not Available For related lists.

2. Click Edit  to add an existing user criteria record, or click New  to create a new one.

3. Save the record to associate the user criteria record with the item.

Note: 
The Not Available For  settings override Available For  settings. A user on the Not 
Available For  list for an item cannot access that item, even if that user is also on the 
Available For  list for that item.

Apply user criteria to categories

Apply user criteria to a category to define which users can and cannot access a category.

Before you begin
Role required: admin
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Procedure

1. In a category record, navigate to the Available For or Not Available For related lists.

2. Click Edit  to add an existing user criteria record, or click New  to create a new one.

3. Save the record to associate the user criteria record with the category.

Note: 

◦ The Not Available For  settings override Available For  settings. A user on the Not 
Available For  list for a category cannot access that category, even if that user is also on 
the Available For  list for that category.

◦ The user criteria restrictions of a category do not automatically apply to the catalog 
items within the category. If required, you should apply the user criteria restrictions to 
the individual catalog items.

Extend user criteria

Extend the user criteria table when the available user criteria fields are not sufficient. User 
criteria references various user fields (fields from the User [sys_user] table), such as department, 
company, and groups. You can extend user criteria with a custom field to include any other user 
reference field (field from the User [sys_user] table) of interest.

Before you begin
Role required: admin

About this task
For example, you can extend user criteria to include the user's cost center, and then restrict 
certain catalog items only to members of that cost center.
Meet the following rules to extend the user criteria table.

• The field to add must be a reference field in the user record.

• The field added to the user criteria table must be List  type.

• The fields must have matching names. For example, cost_center  [sys_user] and u_cost_center 
("u" prefix is added to custom fields in a table) are considered to be matching.

This example demonstrates how to extend the current user criteria record to include Cost center 
as an option.

User criteria record before extending Cost center
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Procedure

1. Navigate to All  > System Definition  > Tables.

2. Open the User Criteria  record.

3. In the Table Columns  related list, click New.

4. Set the type to List, and then enter Cost center  as the column label.
The Column name  field populates with u_cost_center.

5. In the Reference Specification form section, select Cost Center  for the reference field.

6. Add any conditions or additional information to the dictionary entry as desired.

7. Click Submit.

8. Navigate to Service Catalog > Catalog Definition > User Criteria.

9. Select or create a user criteria record, and see that you can now use the new field.

What to do next
Test the user criteria record by navigating to Service Catalog  > Catalog Definition  > User 
Criteria, and opening any record. Verify that the extended field is available.

User criteria with cost center

You can extend the User [sys_user] table if there are fields in other tables that you want 
considered in user criteria. After extending the User table, follow the steps in this procedure to 
extend it to user criteria.

User criteria migration

Service catalog user criteria records provide access control for service catalog items and 
categories.

You can migrate your access controls to use user criteria. The user criteria feature is 
automatically enabled for new instances. If you upgrade your instance, a script runs to determine 
current access control usage.

• If your instance does not use entitlement-based  access controls, the user criteria feature is 
automatically enabled.

• If your instance does use entitlements, the user criteria feature is not enabled. If you want to 
use user criteria, use the procedure described on this page to migrate your access controls 
from entitlements to user criteria.
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Migrate to user criteria to provide more reuse, control, and flexibility compared to entitlements.

For example, you can use a single criteria record to make multiple catalog items available to only 
users who meet all these requirements:

• Are located in EMEA or APAC

• Belong to ACER

• Are in the Training department

Migrate to Service Catalog  user criteria

Service Catalog  enables you to maintain the required access controls to your service catalog 
while migrating from entitlements to user criteria.

Before you begin
Role required: admin

About this task

Procedure

1. Navigate to All  > Service Catalog  > Catalog Administration  > Properties  and verify that the 
user criteria feature is not already enabled on your system.

◦ If the property Use "User Criteria" to define access to catalog items and categories 
(glide.sc.use_user_criteria) is set to true, you can skip the following steps. The 
user criteria feature is automatically enabled because entitlements were not used in your old 
system.

◦ If this property is set to false, continue with the following steps. The user criteria feature has 
not been enabled yet on your system.

2. To preview the user criteria feature, set the service catalog property Enable both "User 
Criteria" and "Entitlement" related lists for catalog items and categories when migrating 
from entitlements  (glide.sc.user_criteria_migration) to true.
This option lets you compare user criteria records and entitlements before you fully switch to 
user criteria.

3. Inspect your service catalog items and categories to identify access control sets that you can 
configure user criteria records for.
Review your current entitlements and record your current design for access controls. Focus on 
identifying patterns where multiple items have the same combination of location, group, and 
so on. Each combination is a possible access control set.

4. Create a user criteria record  for each access control set that you identified from your 
inspection of the service catalog.
You have a step with a list, note, and image.

5. Apply these user criteria records  to the items and categories identified, replacing the 
equivalent entitlements.

6. Enable user criteria on your system by setting the service catalog property  Use "User Criteria" 
to define access to catalog items and categories  (glide.sc.use_user_criteria) to 
true.
When this property is set to true, any remaining entitlements are no longer used.

Note: 
Scripts in user criteria cannot reference the category or catalog item as current  as 
entitlement scripts do. For scripts in user criteria, use the user_id  available for the user 
currently being evaluated against the category or catalog item.
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Data structure differences

There are significant data structure differences between entitlements and user criteria, which 
you must be aware of while migrating.

Using entitlements, the following tables are loaded into memory and evaluated before rendering.

For catalog items:

Entitlements Data Structure - Catalog Items

For categories:

Entitlements Data Structure - Categories

The user criteria architecture collects all user attributes in the User Criteria [user_criteria] table.

User criteria records can link to items and categories, as follows.

For catalog items:

• Catalog Item Available for [sc_cat_item_user_criteria_mtom]

• Catalog Item Not Available for [sc_cat_item_user_criteria_no_mtom]

User Criteria Data Structure - Catalog Items

For categories:

• Category Available for [sc_category_user_criteria_mtom]

• Category Not Available for [sc_category_user_criteria_no_mtom]
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User Criteria Data Structure - Categories

Legacy service catalog access controls

Service catalog supports several ways to control access to a catalog item or category. These 
controls are also known as catalog entitlements.

Instead of access controls, use user criteria that is the supported security model for catalog item 
and category. For information about user criteria, see Apply user criteria to items and categories.

A service catalog item with no specific access controls is available to all users. If access controls 
are specified, only users who meet all conditions have access.

The following entitlements  are available:

• Role

• Custom script

• Company, Department, Group, User, or Location

Access controls are checked in the following order: roles, then scripts, then Company, 
Department, Group, User, or Location.

Note: 
The functionality described here is superseded by access controls using user criteria. 
Migrate to user criteria for a more flexible and reusable way to define access controls.

Service Catalog  administration

Service Catalog  enables an administrator to configure the service catalog.

Before you begin
Role required: admin

About this task

Procedure

1. Navigate to All  > Service Catalog  > Maintain Items  or Service Catalog  > Maintain Categories.

2. Open an item or category, and then configure the related lists in the form to add Available for 
Department and Available for Company.

3. Click Update  to save the form layout.

4. Open the item or category you wish to secure and add companies and departments to related 
lists.

The item or category is available only for the companies and departments listed. If no 
companies or departments are listed, then the item or category is available to all companies or 
departments.
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Restrict access

Service Catalog  enables an administrator to grant or deny access to a service catalog item or 
category by company, department, group, user, or location.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Service Catalog  > Maintain Items  or Service Catalog  > Maintain Categories.

2. Open the relevant catalog item or category.

3. Configure the form  to add the appropriate Available  or Not available  lists.

Access Control

4. Add the companies, departments, groups, users, or locations to the appropriate list.

5. Click Update.

Restrict access by role

By default, individual catalog items and categories do not have access restrictions.

Before you begin
Role required: admin

About this task
Administrators can grant or deny access to a service catalog item or category based on role.

Procedure

1. Navigate to All  > Service Catalog  > Maintain Items  or Service Catalog  > Maintain Categories.

2. Open the relevant catalog item or category.

3. Add the required roles to the Roles  field.
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You can, if needed, Configure the form  or change to Default View  to see the Roles  field.

Roles Granted

Restrict access by a script

Service Catalog  enables you to control access to a service catalog item or category with a 
custom script.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Service Catalog  > Maintain Items  or Service Catalog  > Maintain Categories.

2. Open the relevant catalog item or category.

3. Configure the form  to add the Entitlement Script  field.

Entitlement Script

4. In the Entitlement Script  field, enter the access control script.

Sample Scripts:

The following example script grants access to a catalog item named French Blackberry to 
users with a language of Fr (French):
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gs.log ( 'Running Entitlement script for French Blackberry' ) ;
 
 if (gs. getUser ( ). getLanguage ( ) == 'fr' )
    answer = true ; else
    answer = false ;
 
answer ;

The following example script could be used to distinguish between two categories of users 
(one with full access and one with restricted access) on the catalog of services:

var userid  = gs. getUserID ( ) ; var now_GR  = new GlideRecord 
 ( 'sys_user' ) ;
now_GR. get ( 'sys_id' , userid ) ;
 
 if (now_GR. source )
    answer = true ; else
    answer = false ;
 
answer ;

Overriding Entitlement Scripts by Role

a. Navigate to Service Catalog  > Properties.

b. Enter the roles for which to override the entitlement script (grant access) in the property 
List of roles (comma-separated) that can override normal entitlement checking inside the 
catalog. An itil role of "itil" means that the itil role can order any catalog item, even one 
protected by entitlement restrictions.

Creating a Service Catalog  Wizard

Service Catalog  wizards help you to create wizard like, multi-step experiences.

Before you begin
Service Catalog  wizards are especially useful when the input required is huge and complex since 
the wizard offers a step-by-step experience for the requester and also provides a side panel to 
provide contextual help. A visa application is a good example where Service Catalog  wizards 
could be used as the data needs to be presented in steps such as Personal details, Education 
details, and so on.

Pre-requisites for creating Service Catalog  wizards:

• Ensure that you have either a composite record producer, or a record producer set up. For 
more information, see Create a record producer.

• The Save options  field must have the value Save in destination  in the composite record 
producer or record producer to enable the wizard to create records.

• The Allow edit  option should be selected on the composite record producer or record 
producer form so that records are editable in the wizard.

Role required: wizard_admin, or admin

About this task
The Service Catalog  Wizard is available as a component in UI Builder (UIB). You can use it to 
create guided experiences backed by composite record producers or record producers. You can 
create multi-step wizard experiences using Service Catalog  Wizard.

Service Catalog  Wizards are used in these modes:
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• Normal  mode: To create records in the table configured in the record producer, or the 
composite record producer associated with the wizard.

• Template  mode: To create a template where admins can predefine some data and provide 
guardrails to fine-tune and personalize the creation of records.

Procedure

1. Navigate to Service Catalog Wizards  > Maintain Wizards, and click New  to create a new 
wizard.

2. On the form, fill in the fields.

Service Catalog  Wizard form

Field Description

Name Name of the wizard.

Type The wizard uses a composite record 
producer, or record producer.

Producer Reference of the composite record producer, 
or record producer.

Has feedback panel Option to specify if the wizard has a feedback 
panel.

Layout[Stacked/Tabbed] The rendering of wizard steps can be either 
stacked or tabbed layout mode.

Title Title of the wizard.

Note: 
The title can also dynamically refer 
to the composite record producer, 
or record producer variables using 
${variable} syntax.

Enable Save Auto-save the wizard on each step change.

Show review step The Review and submit step is displayed to 
summarize the wizard steps, and field values.

Show Submit on last step If true, the Submit  button is displayed in the 
last step.

Review step label Label of the Review and submit step.

For more information on fields, steps, sections, or questions on Service Catalog  wizard, see 
the following:

◦ Add a step, section, or question to a catalog item wizard

◦ Catalog Wizard form
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After you set up the field values, the resulting wizard with the steps, layout, labels, and other 
elements appear as follows:

Elements of a Service Catalog Wizard

3. Set up the Catalog Wizard component properties using the UI Builder (UIB) components, for 
more information see Customize UI Builder pages using components .

a. Select Wizard: Select the wizard that you're creating the experience for (you can choose the 
wizard you created in the previous step).

b. Wizard mode: Select the mode for this experience.

c. Field space: Specify the spacing that should appear between fields in the wizard. The 
possible values are Small, Medium, Large, and Extra Large.
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d. Sys_id of the record: In Normal mode, the sys_id of the record being edited or created by 
the wizard. In Template mode, the sys_id of the template that is being edited.

e. Select template: Select the template that must be applied to the wizard. The Select 
Template  option is applicable only in Normal mode.

f. Make template mandatory: If true, providing a template is mandatory for creating records, 
and is applicable only in Normal mode.

g. Home button icon: Select an icon that appears in place of the Home button icon.

h. Hide home button: If true, the Home  button is hidden in the wizard.

i. Hide step navigator Back button: If true, hides the Back  button in the footer of the wizard.

j. Hide step navigator Forward button: If true, hides the Forward  or Continue  button in the 
footer of the wizard.

k. Step navigator forward button type: Specify the button type for the Forward  button in the 
wizard footer. The possible values are Primary  or Secondary.

For more information, see Next Experience Components  in the developer documentation 
site.

Create declarative actions for Service Catalog  Wizards

Create and configure declarative actions to enable administrators to configure buttons (wizard 
actions) in Service Catalog  Wizards.

Before you begin
There are two types of declarative actions for catalog wizards:

• UXF Client Action: Create declarative actions and map an action to a UIB page level event 
handler. Use this if you need to handle events at the UIB level such as opening a dialog box, or 
opening another catalog wizard, and so on.

• Client Script: Use a client script that executes on a button click. Use this if you need to 
manipulate g_form fields of the composite record producer that are linked to the catalog 
wizard.

The Catalog Wizard model is the declarative action model for catalog wizard which has the model 
fields that define the properties of the wizard. Use these fields to define what the payload can 
contain (for UXF Client Action type), or define conditions for button display on the wizard. Every 
wizard must use the Catalog Wizard model to create declarative actions.

Role required: wizard_admin, admin

Procedure

1. Navigate to Service Catalog Wizards > Catalog Wizard Declarative Actions.

Important: 
Use this navigation path only to create declarative actions. This path sets the fields 
correctly when the declarative action form is loaded.

2. Click New  to create a new declarative action.

3. Specify Catalog Wizard Action Model Fields  to create payloads.
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The action model fields are available by default for catalog wizard declarative 
actions, and appear on the Action Model Fields  tab in the Action Assignment  form. 

Action Model Fields tab

Field Description

Current Step Order Order of the current selected step.

Target Table Target table of the record producer or 
composite record producer used by the 
wizard.

Record Producer Sys_id of the record producer or composite 
record producer used by the wizard.

Wizard Id Sys_id of the wizard.

Enable Save Value of the Enable Save  field on the wizard 
record.

Variables Object containing name and value 
for composite record producer variables 
associated with the wizard.

Is New Record The value is True  when creating a new record 
using the wizard.

Template Id Sys_id of the template applied on the wizard.

Has Review Step The value of the Has  Review Step  field on 
wizard record.

Is Last Step Indicates if it's the last step of the wizard. The 
last step is not dependent on order, and could 
change dynamically based on client scripting 
or UI policies of the wizard.

Form Dirty The value is True  if the wizard has unsaved 
changes.

Submitting The value is True  if a submission of the wizard 
is in progress.
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Field Description

Mode Mode in which the wizard is operating 
(Template or Normal mode).

Target Record Data Not Applicable (this field is no used).

Record Id Sys_id of the record being created or edited by 
the wizard.

4. Click the Action label  link for an action (such as Insert, or Delete). 

Action Assignment form

Field Description

Action label Display label for the button on the wizard.

Action name Identifier for the action.

Implemented as UXF Client Action or Client Script for wizard 
declarative actions.

Specify client action The payload definition if Implemented as  is 
the UXF Client Action.

Client Script If the Implemented asfield value is Client 
Script, this value must be specified.

Important:
You can only use the variables on the 
CRP that are linked to the wizard.

Tooltip Tooltip for the button.

Button type Possible values are Primary  or Secondary.

Order Sequence that the button appears in.

Group By Option that must be selected if the button is 
part of a group.
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Field Description

Group The group the button belongs to, for the Group 
By  option. Grouped buttons are displayed as 
a split button in the wizard.

Scripted client conditions The conditions to be evaluated 
during button display. For example: 
mode==‘template’&&variables.var==‘xxxx’.

Note:
This field does not appear on the form by 
default.

5. Click Submit  to create the Wizard action.

6. Navigate to Service Catalog Wizards  > Catalog Wizard Actions Configurations  and click 
New.
Create a Wizard Action Configuration record so you can use the declarative action in a wizard. 
Enter the following fields in the form.

Wizard Action Configuration record

Field Description

Name Identifier of the wizard action configuration 
record.

Declarative action Select a declarative action that was created 
using the Catalog Wizard model.

Applies to The wizard mode in which this action 
should appear. The values are Normal mode, 
Template mode, or All  (both modes).

Global This action configuration applies to all wizards, 
regardless of whether it's mapped to a 
particular wizard or not.

Note:
The global actions Save  and Submit  are 
available by default.

Overflow The button is displayed as part of overflow 
menu.

Force Save Saves the wizard if any field values have been 
updated in the wizard before triggering the 
action.

Label override Enter a label to override the label specified in 
the declarative action.

Button type override The button type specified by the declarative 
action is overridden.

7. Navigate to Catalog Wizard  > Maintain Wizards.
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To display a declarative action as a button on the wizard, map the Wizard Action Configuration 
with the Catalog Wizard.

Open the wizard that you want to add the declarative action to. Use the related list Wizard 
Actions Configurations  to create a mapping record between the wizard and the wizard action 
configuration.

a. Click New  to create a new configuration directly.

b. Click Edit  to attach an existing configuration to create a mapping record between the wizard 
and the configuration. The mapping record also has a toggle to hide a specific action.

c. Toggle the Hide action  field to True to hide a specific action.

Tip: 
Buttons with global configurations are available on the wizard by default. To hide a 
global action in a wizard, map the global configuration to the wizard and set the Hide 
Action  to true.

For more information on Catalog Wizards, see Creating a Service Catalog Wizard.

8. Use the Configure declarative actions event mappings  action on the Config  tab of UI Builder.
Configure declarative actions event mappings is applicable only to UXF Client Action type of 
declarative action. Create a page level event handler, then map the declarative action to the 
page level event handler and specify the payload. For more information on binding events to 
declarative actions in UI Builder, see Bind an event to a declarative action .

Integrating Service Catalog

You can integrate Service Catalog  with other applications, such as Service Portal  and Employee 
Center.

Integrate Service Catalog

• Submit requests for service and product offerings using catalog items from the Employee 
Center.

• Configure an improved version of catalog. Customize Service Portal  where your customers can 
request catalog items such as service and product offerings.

• Use a mobile and track request and approval flows of Service Catalog.

• Configure a catalog item or record producer to create a universal request when a request is 
submitted.

• Design a topic conversation in Virtual Agent  by including reusable topic blocks to perform 
request submission tasks.

Service Catalog  in Employee Center  portal

Employees can submit requests for service and product offerings using catalog items from the 
Employee Center  portal.

ServiceNow®  Employee Center  provides a single and unified portal experience for employees 
to find information and request services across various departments, including HR, IT, Legal, 
Workplace, and Procurement. Using the Content Taxonomy framework, you can modify the 
default IT taxonomy to include your catalog items as content in the topics or child topics.

To enable Service Catalog  on the Employee Center  portal, ensure you've the following 
ServiceNow  applications and plugins installed:
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• Employee Center  plugin (sn_ex_sp)

• Employee Experience Taxonomy plugin (sn_ect)

IT taxonomy on Employee Center

The base system taxonomy—Employee—is installed when you install the Employee Experience 
Taxonomy plugin. To provide catalog items, the following IT taxonomy structure is available by 
default under the IT taxonomy:​

1. Hardware 

2. Software

3. Network

4. Browse IT

Associate a catalog item with a taxonomy topic in Employee Center

Associate your existing and new catalog items, knowledge base articles, and quick links to the 
appropriate taxonomy topics so that the catalog items are available in the Employee Center  as 
content in the topics or child topics.

Before you begin
Role required: admin

About this task
You must associate your catalog items that you want to display in the Employee Center  with a 
taxonomy topic.

By default, Employee Center  application ships employee-centric taxonomy and taxonomy topics 
for IT, HR, Workplace, Legal, and Procurement. You can use the default IT taxonomy to associate 
your catalog items or you can clone a taxonomy to make your own additions or modifications 
to the default topic structure that matches your requirements. To clone a taxonomy, refer to the 
steps mentioned in the Clone taxonomy for employee content  topic.

You can associate your existing or new catalog items with a taxonomy topic directly from the 
Content Taxonomy also. To associate your existing or new catalog items with a taxonomy topic, 
refer to the steps mentioned in the Associate connected content to a topic  topic.

For more information about Unified taxonomy, see Unified taxonomy for Employee Center .

To associate a catalog item from the Service Catalog:

Procedure

1. Navigate to All  > Service Catalog  > Catalog Definition  > Maintain Items.

2. Select the item that you want to associate with a taxonomy topic.

3. In the Assigned Topics related list, click Add.

4. Select the base taxonomy from the Taxonomy  list.

5. Select the appropriate topic, for example IT.

6. Select the appropriate child topic from the topic list.
For example, to add a laptop, select Hardware, and then Computers.

7. Click OK.
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Result
The catalog item is associated with the selected taxonomy topic and appears on the Employee 
Center.

Enable Shopping Cart and Add to Wish List options in Employee Center

Modify the Main Menu configuration of the Employee Center  to provide the Shopping Cart and 
Add to Wish List options while requesting catalog items.

Before you begin
Enable the wish list feature for catalog. For information about enabling the wish list, see Saving 
catalog items to a wish list.

Role required: admin

About this task
The Shopping Cart and Add to Wish List menu options that are available by default on the 
Service Portal  are not available in the Employee Center. You must enable these options in the 
Employee Center  to allow employees to add catalog items to the Shopping Cart and Wish List.

If these features are not required, then consider disabling these options in Service Catalog  for a 
seamless experience in the Employee Center. To enable or disable the shopping cart option in 
Service Catalog  follow the first three steps mentioned in the Enable the Shopping Cart Widget
topic and for information on enabling or disabling the Wish list option in Service Catalog, see 
Saving catalog items to a wish list  topic.

Procedure

1. Navigate to All  > Service Portal  > Portals.

2. Search for and select Employee Center.

3. If you are prompted with the message To edit this record click here, then click 
here.

4. Open the Main menu  by clicking the preview this record icon ( ).

5. Change the values for enable_cart  and enable_wishlist  to True.

{
 "enable_cart":{
  "displayValue":"true",
  "value":true
 },
 "auto_update_cart":{
  "displayValue":"true",
  "value":true
 },
 "exclude_search_on_homepage":{
  "displayValue":"true",
  "value":true
 },
 "enable_wishlist":{
  "displayValue":"true",
"value":true

6. Click Update.

Result
The Shopping Cart and Add to Wish List options appear on the Employee Center.
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Add an item to the wish list in Employee Center

Add catalog items or record producers to the wish list to review them when required.

Before you begin
Role required: requester

Procedure

1. Navigate to All  > Employee Center  > IT.

2. Select a topic to view the catalog items and then select catalog item or record producer from 
the Catalog.

3. Click the Add to Wish List icon ( ) in the Ordering widget.

Note: 

When you edit an item that is added to the wish list, the Update Wish List icon ( ) is 
displayed in the corresponding Ordering widget.

4. Click View Wish List  from the confirmation message or the Wish List  menu option on the main 
navigation bar.
The wish list details page is displayed.

5. If required, perform any of these actions.

Option Description

Remove Item
To remove an item from the wish list, click the 

Remove Item icon ( ).

Clear Wish List To clear the wish list, click Clear Wish List.

View the Catalog
To navigate to the Service Catalog landing 
page, click View the Catalog.

6. To navigate to any wish list item page, click the image or name of the item in the wish list 
details page.

Note: 
This does not open a new instance of the item, but the instance that is in the wish list, 
where you can edit the details.

Add a catalog item to the shopping cart in Employee Center

Add a catalog item or order guide to the shopping cart to store at one place and checkout.

Before you begin
Role required: requester

Procedure

1. Navigate to All  > Employee Center  > IT.

2. Select a topic to view the catalog items and then select catalog item or record producer from 
the Catalog.

3. Click Add to Cart  in the Ordering widget.
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Note: 

◦ You can add the same item to the cart multiple times. Every time you add an item to the 
cart, a new instance of the item is created.

◦ The cart information is automatically updated.

4. Click View Cart  from the confirmation message or the Cart  option on the main navigation bar.
The cart details page is displayed.

5. To navigate to any cart item page, click the image or name of an item in the cart details page.

Note: 
This step doesn’t open a new instance of the item, but the instance that is in the cart, 
where you can edit the details.

6. Optional:  If necessary, edit the quantity of items.

7. Optional:  To remove an item from the cart, click the Remove Item icon ( ).

8. Optional:  To make changes to this item, select it, and then select Save as Draft.

(Optional) The item is removed from the cart. You can access the saved drafts from the My 
Request widget in the Drafts  tab.

9. To navigate to the Service Catalog landing page, click Continue Shopping.

10. Optional:  To clear all the items from your cart, click Clear Cart.

11. Optional:  To create a bundle from the cart:

a. Click Save as Bundle.

b. In the Create New Bundle window, specify the Bundle Name  and select the items that you 
want to include.

c. Click Save.

Note: 
When you create a bundle from the cart, which includes an order guide, the association 
of the items to the order guide is lost.

12. Optional:  To add a saved bundle to the cart, open the bundle from the My Saved Bundles 
section and click Add to Cart.

13. Optional:  To replace the cart items with a saved bundle, open the bundle from the My Saved 
Bundles  section and click Replace Cart.

14. Click Proceed to Checkout.
The Order Confirmation window is displayed.

15. Optional:  Specify the Delivery Information  and Special instructions.

16. Optional:  To add one or more attachments for the cart, click the add attachment icon ( ).

(Optional) You can browse and choose the files, drag the files, or copy and paste them in the 
Add attachments window.

17. Click Checkout.

The corresponding request is displayed in the My Requests page with the request number, 
estimated delivery date for the entire order, price, and the order status of individual ordered 
items.
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Related topics

Save a draft of a catalog item

Request a catalog item from Employee Center

Use the SC Catalog Item widget in Employee Center  to request a catalog item.

Before you begin
Role required: requester

Procedure

1. Navigate to All  > Employee Center  > IT.

2. Select a topic to view the catalog items and then select catalog item or record producer from 
the Catalog.

3. Enter the required information in the catalog item form.

4. Enter the number of items in the Quantity  field.

5. If required, perform any of these actions.

Option Description

Add attachments

To add one or more attachments to the cata­

log item, click the add attachments icon ( ).

You can browse and choose the files, drag 
the files, or copy and paste them in the Add at­
tachments window.

Add to Cart
To add the catalog item to the shopping cart, 
click Add to Cart.

Add to Wish List
To add the catalog item to the wish list, click 

the Add to Wish List icon ( ).

6. Click Order Now.
The Order Confirmation window is displayed.

7. From the Request for  list, select the user for whom you are requesting.

Note: 
By default, the user who is logged in is selected in this list.

8. If required, specify the Delivery Information  and Special instructions.

9. Click Checkout.
The corresponding request is displayed in the My Requests page with the request number, 
estimated delivery date for the order, price, and the order status.

Request an order guide from Employee Center

Request multiple catalog items together as an order guide from the Employee Center  for a 
specific purpose.

Before you begin
Role required: requester
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About this task
An order guide submits a single service catalog request that contains several catalog items so 
that you don't have to request each item manually. For more information, see Order guides.

For example, a New Employee Hire order guide can contain several items that new employees 
commonly need, such as business cards, computer, and cell phone. After selecting this order 
guide, the customer can then provide information about the new employee, including location 
and job title. The order guide then submits an order for catalog items like business cards, based 
on the details provided.

Procedure

1. Navigate to All  > Employee Center  > IT.

2. Select an order guide from the Catalog.

3. In the Describe Needs  section, enter the required information and click Next.

Note: 
The Next  button is disabled until you fill all mandatory fields on the form.

4. In the Choose Options  section, enter the requirements for catalog items and click Next.

Note: 

◦ If a catalog item has fields that need user inputs, Options  is displayed on the 
accordion.

◦ If the fields are mandatory, a red asterisk is displayed beside Options.

a. To expand or collapse the catalog item information, click the accordion.

b. To include or exclude the catalog item from the order guide request, set the toggle switch to 
off on the accordion.

Note: 
When the item is excluded from the order guide request, the item is not editable and 
the corresponding mandatory field restrictions are ignored.

c. To add an attachment for the catalog item, click the Add attachments icon ( ) and select 
the required attachment.

d. Click Previous  to navigate to the Describe Needs  section.

5. In the Summary  section, review the order guide summary.

6. Optional:  To add the order guide to the shopping cart, click Add to Cart.

Note: 
When you add an order guide to the cart, you can only edit the order guide instance in 
the cart.

7. Optional:  To go to the Choose Options  section and edit the order guide items, click Edit 
Options.

8. Click Order Now.
The Order Confirmation window is displayed.

9. From the Request for  list, select the user for whom you are requesting.
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Note: 
By default, the user who is logged in is selected in this list.

10. Optional:  If required, specify the Delivery Information  and Special instructions.

11. Optional:  To add one or more attachments for the cart, click the add attachment icon ( ).

(Optional) You can browse and choose the files, drag the files, or copy and paste them in the 
Add attachments window.

12. Click Checkout.
The corresponding request is displayed in the My Requests page with the request number, 
estimated delivery date for the entire order, price, and the order status of individual ordered 
items.

Related topics

Request an order guide

Create an order guide

Save a draft of a catalog item

Save a draft of a catalog item while requesting it on the Employee Center, Service Portal, and 
Now Mobile.

Before you begin
Role required: requester

About this task
If enabled, save the draft if you don't want to discard the form and edit it later. For example, this 
procedure explains how you can save a draft in Employee Center.

For information about enabling Save as Draft, see Catalog Item form.

Procedure

1. Navigate to All  > Employee Center  > IT.

2. Select the item that you want to request and start filling the form.

3. If you want more information to fill the form and want to save it, select Save as Draft.

Your draft is saved. You can access the saved drafts from the My Request widget in the Drafts 
tab.

If you open a new but the same item to request, and the draft of the item is already saved, you 
get a message stating that the draft of this item exists. If you want to save the draft of this new 
item as well, you must give a unique name to this item in the Save as draft  field, and select 
Save.

The Drafts  tab shows all the draft items related to the same item name.

4. Open a draft item that you want to edit, and if you still don't want to submit it, select Update 
draft  or if you want to submit it, select Submit.

Related topics

Add a catalog item to the shopping cart in Employee Center
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Service Catalog in Service Portal

Use Service Portal to configure an improved version of Catalog. You can customize Service Portal 
where your customers can request catalog items such as service and product offerings. You can 
use the Service Catalog widgets to build a catalog for your portal.

Note: 
If you’re an existing customer using Service Portal we recommend that you migrate to the 
Employee Center for a better experience. For more information on Employee Center, see 
Employee Center

The Catalog landing page provides an interface from where you can access the catalog items, 
requests, approvals, popular items, recent items, and saved bundles. This page is available by 
default for zBoot users.

Note: 
Upgrade users need to activate the Service Portal - Service Catalog v2 plugin 
(com.glideapp.servicecatalog.portal).

Overview of configurable options in the Service Catalog on the Service Portal and explains how 
to perform those configurations.

You can access the Catalog landing page in Service Portal  using the Catalog  option from the 
main menu header of Service Portal.

The landing page has:

• A search bar to search within all configured catalogs in Service Portal. When you search for a 
specific item, the search results page displays results based on the configured catalogs and 
categories.

Only the items associated with a catalog and category are searchable. The primary category 
of the item is displayed under the Category  filter. The catalog where the primary category is 
defined for the item is displayed under the Catalog  filter.

• The Browse by Categories  option to navigate to the list of categories in Service Catalog  and 
the items within. Click this option to navigate to the categories landing page.

• The Requests and Approvals widget to display the list of requests and approvals associated 
with the user. The list is based on the configurations available in the My Request Filter  module 
in Platform. For information about the My Request Filter  module, see Define filters for My 
Requests.

• The My Saved Bundles widget to display the saved bundles associated with the user. You can 
remove a bundle, or open a bundle to add or replace the cart with the items in the bundle.

• The My Recent Items widget to display catalog items, record producers, or order guides that 
are most recently viewed or requested by the user. An instance option on the widget allows 
you to display either the viewed or requested items. This widget is not displayed when it has 
no data.

• The Popular Items widget to display the most popular catalog items ordered across the 
organization by other users. These items are displayed based on the Top Requests  dynamic 
category. This widget is not displayed when there is no data.
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Note: 

• In the order status page of a request, stage renderer displays the current stage in a 
collapsed view. You can expand this view for all stages.

• These pages have dynamic titles to display the name of the selected entity.

◦ Catalog Item [sc_cat_item]

◦ Catalog Categories [sc_category]

◦ Order Guide [sc_cat_item_guide]

Related topics

Service Catalog widgets

Content Management and Service Portal

Access Service Catalog categories in Service Portal

Access Service Catalog  categories to access the catalog items within.

Before you begin
Role required: requester

Procedure

1. Navigate to All  > Service Portal  > Service Portal Home.
The Service Portal homepage is displayed.

2. Click any of the following:

◦ The Request Something  link from the Service Portal  landing page.

◦ The Catalog  option from the main menu header of Service Portal  and then the Browse by 
Categories  option.

The popular items from all categories are displayed.

3. In the Catalogs  section, select the required catalog from the list.
For information on how you can configure a catalog, see Configure a catalog in Service Portal .

Note: 

◦ The Catalogs  section is available only when you have multiple catalogs and have 
access to items of multiple catalogs.

◦ The list contains all catalogs configured for Service Portal.

The following information is displayed:

◦ Categories of the selected catalog in the Categories  section.

◦ Popular items of the selected catalog.

4. In the Categories  section, click the required category.
The category details and the items within are displayed.

Note: 

◦ You can click the category count or anywhere in the row to view the category details.

◦ For a category with a long name, additional text is displayed as ellipses. Point to the 
category name to view the additional text.
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5. To change the display of category items, click the card view icon ( ) or the grid view icon 

( ).

Note: 
When you access a catalog item from the Catalog landing page or type ahead search 
results, the breadcrumb of the item displays the path based on the primary category 
configured on that item. When you access the item from a specific category, the 
breadcrumb of the item displays the path based on that category.

Related topics

SC Categories widget

Add an item to the wish list in Service Portal

Add catalog items or record producers to the wish list to review them when required.

Before you begin
Role required: requester

Procedure

1. Navigate to All  > Service Portal  > Service Portal Home.
The Service Portal homepage is displayed.

2. Select a catalog item or record producer from Service Catalog.

3. Click the Add to Wish List icon ( ) in the Ordering widget.

Note: 

When you edit an item that is added to the wish list, the Update Wish List icon ( ) is 
displayed in the corresponding Ordering widget.

4. Click View Wish List  from the confirmation message or the Wish List  menu option on the main 
navigation bar.
The wish list details page is displayed.

5. If required, perform any of these actions.

Option Description

Remove Item
To remove an item from the wish list, click the 

Remove Item icon ( ).

Clear Wish List To clear the wish list, click Clear Wish List.

View the Catalog
To navigate to the Service Catalog landing 
page, click View the Catalog.

6. To navigate to any wish list item page, click the image or name of the item in the wish list 
details page.

Note: 
This does not open a new instance of the item, but the instance that is in the wish list, 
where you can edit the details.
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Related topics

SC Wish List Cart widget

Add a catalog item to the shopping cart

Add a catalog item or order guide to the shopping cart to store at one place and checkout.

Before you begin
Role required: requester

Procedure

1. Navigate to All  > Service Portal  > Service Portal Home.
The Service Portal homepage is displayed.

2. Select a catalog item or order guide from Service Catalog.

3. Click the Add to Cart icon ( ) in the Ordering widget.

Note: 

◦ You can add the same item to the cart multiple times. Every time you add an item to the 
cart, a new instance of the item is created.

◦ The cart information is automatically updated in all open tabs or windows.

4. Click View Cart  from the confirmation message or the Cart  menu option on the main 
navigation bar.
The cart details page is displayed.

5. To navigate to any cart item page, click the image or name of an item in the cart details page.

Note: 
This step does not open a new instance of the item, but the instance that is in the cart, 
where you can edit the details.

6. If required, edit the quantity of items.

7. To remove an item from the cart, click the Remove Item icon ( ).

8. To navigate to the Service Catalog landing page, click Continue Shopping.

9. To clear the cart, click Clear Cart.

10. To create a bundle from the cart:

a. Click Save as Bundle.

b. In the Create New Bundle window, specify the Bundle Name  and select the items that you 
want to include.

c. Click Save.

Note: 
When you create a bundle from the cart, which includes an order guide, the association 
of the items to the order guide is lost.

11. To add a saved bundle to the cart, open the bundle from the My Saved Bundles  section and 
click Add to Cart.

12. To replace the cart items with a saved bundle, open the bundle from the My Saved Bundles 
section and click Replace Cart.
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13. Click Proceed to Checkout.
The Order Confirmation window is displayed.

14. From the Request for  list, select the user for whom you are requesting.

Note: 

◦ By default, the user who is logged in is selected in this list.

◦ The User [sys_user] table columns specified in the Additional columns for the 
“request for” Service Catalog widget. Choose fields in the sys_user table. Must 
be semicolon separated  (glide.sc.request_for.columns) Service Catalog 
property are displayed in the Request for  list and you can search for a user by the 
specified columns.

◦ You can provide additional widget options to control the Request for  default value. For 
example:

"requested_for_id": {
"value": "62826bf03710200044e0bfc8bcbe5df1"
},
"requested_for_display": {
"value": "Abel Tuter"
}

15. If required, specify the Delivery Information  and Special instructions.

16. To add one or more attachments for the cart, click the add attachments icon ( ).

You can browse and choose the files, drag the files, or copy and paste them in the Add 
attachments window.

17. Click Checkout.

The corresponding request is displayed in the Order Status page with the request number, 
estimated delivery date for the entire order, price, and the order status of individual ordered 
items.

Note: 

◦ Use the instance options on the Order Status page to display the pre-defined columns.

◦ You can display either the RITM number or the name of the catalog item. By default, the 
name of the catalog item is displayed.

Related topics

SC Shopping Cart widget

Request a catalog item from Service Portal

Use the SC Catalog Item widget in Service Portal  to request a catalog item.

Before you begin
Role required: requester

Select the Allow Cloning  instance option on the Order Status page to display the Additional 
Actions  section after placing the request.

For information about the SC Catalog Item widget, see SC Catalog Item widget
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Procedure

1. Navigate to All  > Service Portal  > Service Portal Home.
The Service Portal  homepage is displayed.

2. Select a catalog item or record producer from Service Catalog.

3. Enter the required information in the catalog item form.

4. Enter the number of items in the Quantity  field.

5. If required, perform any of these actions.

Option Description

Add attachments

To add attachments to the catalog item, click 

the add attachments icon ( ).

You can browse and choose the files, drag 
the files, or copy and paste them in the Add at­
tachments window.

Add to Cart
To add the catalog item to the shopping cart, 

click the Add to Cart icon ( ).

Add to Wish List
To add the catalog item to the wish list, click 

the Add to Wish List icon ( ).

6. Click Order Now.
The Order Confirmation window is displayed.

Note: 
For a record producer, you can edit the label of the Submit  button by using the widget 
instance options.

For example, if you want to change the label to Request, press Ctrl+click on the catalog 
item widget, select Instance in Page Editor, and specify the following parameters in the 
Additional options, JSON format  field.

"record_producer_label":{
   "value" : "Request"
  }

7. From the Request for  list, select the user for whom you are requesting.
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Note: 

◦ By default, the user who is logged in is selected in this list.

◦ The User [sys_user] table columns specified in the Additional columns for the 
“request for” Service Catalog widget. Choose fields in the sys_user table. Must 
be semicolon separated  (glide.sc.request_for.columns) Service Catalog 
property are displayed in the Request for  list and you can search for a user by the 
specified columns.

◦ You can provide additional widget options to control the Request for  default value. For 
example:

"requested_for_id": {
"value": "62826bf03710200044e0bfc8bcbe5df1"
},
"requested_for_display": {
"value": "Abel Tuter"
}

8. If required, specify the Delivery Information  and Special instructions.

9. Click Checkout.
The corresponding request is displayed in the Order Status page with the request number, 
estimated delivery date for the order, price, and the order status.

Note: 

◦ Use the instance options on the Order Status page to display the pre-defined columns.

◦ You can display either the RITM number or the name of the catalog item. By default, the 
name of the catalog item is displayed.

◦ When a service catalog item is ordered from an existing record, a link is added between 
the order item request and the parent record.

10. Optional:  To clone a request for other users, perform the following steps.

a. In the Additional Actions  section, from the Also request for  list, select the required users 
and click Submit.

b. In the Cloning Requests window, click Ok.

Note: 

▪ The logged in user should be specified in the List of roles (comma-
separated) that can use bulk ordering functionality. Blank means all users 
(glide.sc.allow.clone.roles)) property.

▪ You can clone the request for multiple users.

▪ When you clone a request that contains a multi-row variable set, the information 
that is specified in the multi-row variable set is available in all cloned requests. All UI 
policies and client scripts on the multi-row variable set are also cloned.
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▪ A separate request is created for each specified user and that user is displayed in the 
Requested For  field of the request.

▪ The Opened By  field of the cloned requests is updated with the logged in user.

▪ Select the Requests  menu option or the My Requests widget on the catalog homepage to 
view the cloned request created for the user.

Related topics

Service Catalog request screens

Create a variable set and add it to an item

Request an order guide from Service Portal

Use the SC Order Guide widget on Service Portal to request an order guide with several catalog 
items for a specific purpose.

Before you begin
Role required: requester

Select the Allow Cloning  instance option on the Order Status page to display the Additional 
Actions  section after placing the request.

For information about the SC Order Guide widget, see SC Order Guide widget .

Procedure

1. Navigate to All  > Service Portal  > Service Portal Home.
The Service Portal homepage is displayed.

2. Select an order guide from Service Catalog.

3. In the Describe Needs  section, enter the required information and click Next.

Note: 
The Next  button is disabled until you fill all mandatory fields on the form.

4. In the Choose Options  section, enter the requirements for catalog items and click Next.

Note: 

◦ If a catalog item has fields that need user inputs, Options  is displayed on the 
accordion.

◦ If the fields are mandatory, a red asterisk is displayed beside Options.

◦ The ordered quantity value is displayed in the Quantity  field and can be modified only 
if the Show quantity  option is selected while creating an order guide rule base,

a. To expand or collapse the catalog item information, click the accordion.

b. To include or exclude the catalog item from the order guide request, click the toggle on the 
accordion.

Note: 
When the item is excluded from the order guide request, the item is not editable and 
the corresponding mandatory field restrictions are ignored.
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c. To add an attachment for the catalog item, click the Add attachments icon ( ) and select 
the required attachment.

d. Click Previous  to navigate to the Describe Needs  section.

5. In the Summary  section, review the order guide summary.

6. To add the order guide to the shopping cart, click the Add to Cart icon ( ).

Note: 
When you add an order guide to the cart, you can only edit the order guide instance in 
the cart.

7. To go to the Choose Options  section and edit the order guide items, click Edit Options.

8. Click Order Now.
The Order Confirmation window is displayed.

9. From the Request for  list, select the user for whom you are requesting.

Note: 

◦ By default, the user who is logged in is selected in this list.

◦ The User [sys_user] table columns specified in the Additional columns for the 
“request for” Service Catalog widget. Choose fields in the sys_user table. Must 
be semicolon separated  (glide.sc.request_for.columns) Service Catalog 
property are displayed in the Request for  list and you can search for a user by the 
specified columns.

◦ You can provide additional widget options to control the Request for  default value. For 
example:

"requested_for_id": {
"value": "62826bf03710200044e0bfc8bcbe5df1"
},
"requested_for_display": {
"value": "Abel Tuter"
}

10. If required, specify the Delivery Information  and Special instructions.

11. To add one or more attachments for the order guide, click the add attachments icon ( ).

You can browse and choose the files, drag the files, or copy and paste them in the Add 
attachments window.

12. Click Checkout.
The corresponding request is displayed in the Order Status page with the request number, 
estimated delivery date for the entire order, price, and the order status of individual ordered 
items.

Note: 

◦ Use the instance options on the Order Status page to display the pre-defined columns.

◦ You can display either the RITM number or the name of the catalog item. By default, the 
name of the catalog item is displayed.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4080



13. Optional:  To clone a request for other users, perform the following steps.

a. In the Additional Actions  section, from the Also request for  list, select the required users 
and click Submit.

b. In the Cloning Requests window, click Ok.

Note: 

▪ The logged in user should be specified in the List of roles (comma-
separated) that can use bulk ordering functionality. Blank means all users 
(glide.sc.allow.clone.roles)) property.

▪ You can clone the request for multiple users.

▪ If a record producer is included in the order guide, a request is created for all items 
other than the record producer.

▪ When you clone a request that contains a multi-row variable set, the information 
that is specified in the multi-row variable set is available in all cloned requests. All UI 
policies and client scripts on the multi-row variable set are also cloned.

▪ A separate request is created for each specified user and that user is displayed in the 
Requested For  field of the request.

▪ The Opened By  field of the cloned requests is updated with the logged in user.

▪ A user can view the cloned request created for the user from the Requests  menu option or 
the My Requests widget on the catalog homepage.

Related topics

Request an order guide

Create an order guide

Standard ticket page for a requested item

In Service Portal, you can configure the ticket page of a requested item to display the related 
information, while still having a consistent layout that is similar to other request types. This 
configuration ensures a consistent experience when viewing submitted requests in Service 
Portal.

In Service Portal, you can access the ticket page for a requested item by using the Requests 
option from the main menu header.

For new instances, the standard ticket page for a requested item is available by default. For 
upgraded instances, you need to activate the Standard Ticket Route page route map. For 
information about activating this page route map, see Activate the page route map for the 
standard ticket page .

Standard ticket page configuration for a requested item

The layout of the standard ticket page can be configured for a requested item. Navigate to 
Standard Ticket  > Standard Ticket Configurations  and edit the sc_req_item ticket configuration. 
For information about configuring the standard ticket page, see Configure the standard ticket 
page .

Related topics

Standard ticket page
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Service Catalog  in mobile

You can use a mobile and track request and approval flows of Service Catalog.

Fulfiller experience in Mobile Agent

Approve catalog requests, requested items, or change requests from anywhere using the ITSM 
ServiceNow Agent  application.

As an ITSM  agent or technician, you can use the mobile app when connected online to 
accomplish the following:

• Accept or reject the pending approval requests.

• View the completed approval requests.

Note: 

• The request experience is not available in this mobile app.

• On-load catalog UI policies (non-scripted) are supported for variables in record views, for 
example, requested item and incident.

◦ Only the visibility condition is considered.

◦ A variable with no value is not displayed.

◦ These policies are also applicable for container variables and a group of check boxes.

◦ Since the multi-row variable set is displayed with a message that it is not viewable, 
these policies can be used to display or hide that message.

Watch this three-minute video to learn how to manage approval requests in the mobile app. 
This video covers: Accessing the Approvals mobile app and viewing and approving or rejecting 
requests.

Activation information

This mobile application runs on the ServiceNow®  mobile platform. You should activate the ITSM 
Mobile Experience (com.sn_itsm_mobile) plugin that enables the ITSM  mobile application.

Get started with the mobile app for Approvals

Access the My Approvals application instance on your mobile app to manage approval requests 
using your mobile device.

Before you begin
Role required: business_stakeholder or approver_user

About this task
Download the ServiceNow®  mobile application on an iOS  platform from the Apple  App Store or 
on an Android platform from the Google  Play Store.

Procedure

1. Open the mobile app and tap the plus icon ( ).

2. Add a ServiceNow  instance.
For more information on adding the instance, refer to Add a ServiceNow instance .

3. Tap My Approvals  to start managing your requests.
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Related topics

Agent mobile app

Manage a catalog request approval

Manage your assigned catalog request or requested item by approving or rejecting it from 
anywhere using your mobile device.

Before you begin
Role required: business_stakeholder or approver_user

Procedure

1. Tap My Approvals  on your mobile app.

2. To approve or reject a pending approval request, perform the following steps.

a. Tap the Pending Approvals applet.
All approvals in the Requested state are displayed.

b. Swipe a request and tap Approve  or Reject.

Note: 
You should specify the reason while rejecting a request.

c. Optional:  To view the details of a pending approval request, tap it.

Note: 
To approve or reject a request, tap the menu icon ( ) and tap Approve  or Reject.

3. To view a completed approval request, perform the following steps.

a. Tap the Completed Approvals applet.
All approval requests that are either accepted or rejected are displayed.

b. To view the details of the request, tap it.

Request experience in Now Mobile

You can enable users to request for an item or service, and track or approve requests on mobile 
using the Now®  Mobile  app.

Activation of Now Mobile  for Service Catalog

If you have the admin role, activate the ServiceNow Mobile Request Native Application Screens 
and Applet Launcher plugin (com.glide.mobile-employee). See Now Mobile app . This plugin 
enables the Service Catalog  functionality by default.

For Me tab

When you log into Now Mobile, the following functionality related to Service Catalog  is available:

• My To-Dos: Displays approval records of requests and requested items assigned or delegated 
to the user.

• My Requests: Displays requests based on the filters defined for mobile in the My Requests 
Filter. By default, the Incident Mobile and Service Catalog Request Mobile filters are available. 
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For information about configuring filters, see Define filters for My Requests  and Configure My 
Requests .

Note: 
It is recommended to include only open requests.

Services tab

You can submit or track requests.

• Recent Services: Displays the items and services (10 items and services in the last 12 months) 
that were requested recently by the logged-in user.

• Popular Services: Displays the most requested items and services (10 items and services in 
the last 12 months) that are visible to the user. Displays the 10 recent items and services in the 
last 12 months.

• Browse Services: Displays the categories of items and services that you can browse through 
and order.

Note: 

◦ If a category contains both items and sub-categories, the items specific to the category 
are displayed under Others.

◦ The category listings do not display the catalog information for users who do not 
have the roles that have permissions to read the records in the sc_category table. For 
such users, an ACL can be added to provide read permission for the Title field of the 
sc_catalog table.

Note: 

• You cannot request these item types in the mobile app.

◦ Content items

◦ Wizard

◦ Standard change template

• All items hidden in Service Portal  are also hidden in the mobile app.

• In the RITM and record view, these variable types are not supported.

◦ HTML

◦ Custom

◦ Custom with Label

◦ UI Page

• In the RITM and request view, a multi-row variable set is not supported. A message is 
displayed in this view that this variable set is not viewable.

• On-load catalog UI policies (non-scripted) are supported for variables in record views, for 
example, requested item and incident.

◦ Only the visibility condition is considered.

◦ A variable with no value is not displayed.

◦ These policies are also applicable for container variables and a group of check boxes.

◦ Since the multi-row variable set is displayed with a message that it is not viewable, 
these policies can be used to display or hide that message.
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From Now Mobile, you can also perform the following tasks:

• Browse catalog items using the catalog hierarchy in addition to the category hierarchy. For 
information about its configuration, see Browse catalog items using the catalog hierarchy.

• Change the label of the Submit  button for a record producer. For information on editing the 
button label, see Edit the label of Submit button for a record producer.

• Use the mobile camera to scan bar codes for identifying a variable value of a catalog item. 
This is only applicable by using the barcode  attribute for the Single Line Text variable. For 
information about this variable attribute, see Service Catalog variable attributes.

Quick actions

You can provide easy access to a catalog item by creating a quick action. For information on 
creating a quick action in Now Mobile, see Create a quick action .

Siri shortcuts

iOS users can use Siri shortcuts to open the following pages in the mobile app.

• Browse items and services.

• Open my requests

See Siri shortcuts .

Now Mobile properties

You can define the following behavior for various catalog entities by configuring the Now Mobile 
properties. For information about configuring these properties, see Configure Now Mobile 
properties.

• Sort categories by the Order  field.

• Define the availability of a catalog item in one of the following ways:

◦ Include the catalog item with Availability  set to Desktop only  in Now Mobile.

◦ Specify catalog item types to exclude in Now Mobile.

• Define the non-availability behavior of a catalog item by making it discoverable but not 
viewable, or not available at all.

• Specify colors for buttons to match your mobile theme.

Related topics

Now Mobile app

Mobile plugins and upgrades

Configure catalogs

Enable your users to view and request their associated items in the Now Mobile  app. If no 
catalogs are selected, users can view and request items from all catalogs in the system. By 
default, the app uses Service Catalog.

Before you begin
Role required: admin

About this task
Demonstrates configuring service catalogs, knowledge bases, and My Requests in the Now 
Mobile App.
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Procedure

1. Navigate to All  > Now Mobile App  > Catalogs.

2. Optional:  In the portal catalogs [m2m_sp_portal_catalog] table, add a catalog in addition to 
the base system catalog, or change the catalog that is associated with the base system record:

a. Click New  or open the base system record.

b. On the form, fill in the fields.

Portal catalogs form

Field Description

Portal Portal that you select. Select Employee Center.

Catalog Catalog that you would like to associate with the app.

Order Number that indicates the order that the configurations should run. 
If there are multiple configurations on a portal, the system runs the 
configurations from the lowest to the highest order that you selected.

Result
Your users can view and request items from all added catalogs.

Browse catalog items using the catalog hierarchy

In addition to the category hierarchy, browse catalog items using the catalog hierarchy for proper 
context.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Mobile  > Now Mobile app  > Applet Launchers.

2. Select the Services  applet launcher.

3. Replace the Browse Services  applet launcher section with the Browse Catalog  applet 
launcher section.

a. On the Applet launcher form, navigate to the Body  section.

b. Under the Section  column, click Browse Services.

c. On the Item Section form, set Destination screen  as Browse Catalog.

d. Click Update.
After the Browse Catalog  applet launcher section is enabled, the catalog appears as the 
first level of browsing and then the categories.

Submit and track a request

Submit a request for an item or service and track the progress of your request with the Now 
Mobile  app.
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Before you begin
Role required: none

Procedure

1. In the navigation bar, tap Services.

2. Browse items and services, or search for an item.

3. Tap the item or service that you would like to request.

Note: 
If configured by your administrator, the related items and articles area provides 
alternatives and additional information.

4. Select ORDER NOW.

5. On the form, fill in the fields.

Field Description

Request for Change this field if ordering the item for someone else.

Delivery Information Confirm the shipping address for the item.

Special instructions 
(Optional)

Add any special instructions for the item.

6. Tap CHECKOUT.
The app displays a confirmation that your request is submitted.

7. To return to the list of items, tap Close.

8. In the navigation bar, tap For Me.

9. To view all your requests, tap My Requests.

10. To view the status of your request, tap the item that you ordered.

a. To view information about the request, use the Details  tab.

Note: 
You can add comments for an open incident.

b. To view field changes and comments about your request, use the Updates  tab.

c. Tap  to add comments and work notes, or to attach a file.
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Note: 
When you add comments for a resolved incident, you can reopen it.

Create a quick action in your mobile applications

Provide easy access to an important item by creating a quick action. For example, you can create 
a quick action that opens a Service Catalog  item.

Before you begin
Role required: admin

Procedure

1. Create a function for the quick action.

a. Navigate to System Mobile  > Functions.
The Function [sys_sg_button] table opens.

b. Click New.

c. On the form, fill in the fields.
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Button fields form

Field Description

Name Name of the function record.

Description Description to enable other users to easily understand the purpose 
of the function.

Type
Type of quick action that you want to create.

To create a quick action that opens a Service Catalog  item, select 
URL.

For more information about function types, see Configure a smart 
button .

Context Whether the function applies at the record or table level.

▪ Record: Action only applies at the record level. For example, 
updating a field.

▪ Global: Action that only applies at the table level. For example, 
creating or deleting a record.

For this example, select Global.

Link Label Label for the link. This value does not display in the user interface.

Link URL
Relative URL for the item that you want to open when the 
user clicks the function. For example, to open a Service 
Catalog  item in the Now Mobile  portal, enter /mesp?
id=sc_cat_item&sys_id=060f3afa3731300054b6a3549dbe5d3e.

This field only displays if the Type  field is URL.

Relative URL
Option that is selected to determine whether the URL is relative. For 
this example, choose Selected.

This field only displays if the Type  field is URL.

Condition

Table Table on which the condition runs.

Condition Condition that should be met for the action to be 
successful. For a catalog item, enter var item = new 
sn_sc.CatItem('3f1dd0320a0a0b99000a53f7604a2ef9'); 
answer = item.canView() && 
item.isVisibleServicePortal();  to display the quick 
action only when the end user has permissions to view the item.

Roles Roles that you want to user to have to view the quick action.

2. Add an instance of the function that you created to the page.

a. In the native UI, navigate to Now Mobile App  > Applet Launchers.

b. Open the applet launcher record that you would like to add the quick action to.
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c. Select the Body  tab.

d. Insert a new row in the Quick Actions Menu Maps related list.
If you're not able to insert a row, make sure that you're in the ServiceNow Now Mobile App 
Screens and Applet Launcher  application scope.

e. Click the magnifying glass to look up an item
The Function Instances [sys_sg_button_instance] table opens.

f. Click New.

g. On the form, fill in the fields.

Function instance form

Field Description

Name Name of the function instance.

Description Description to enable other users to easily understand the purpose of 
the function instance.

Parent Page on which you are adding the quick action. For example, select 
Applet Launcher: Homepage  to add the quick action to the home 
page. Select a value in the Parent table  field first.

Application Application scope.

Parent table Table that contains the record type where the button appears. For this 
example, select applet Launcher [sys_sg_applet_launcher]  to add 
the quick action to an applet launcher page.

Function Function record that you created earlier.

Label Label to help the user understand what the quick action opens. For 
example, Report an outage.

Location Location where the button appears in the UI. For this example, select 
Quick Action.

Icon Icon to display next to the label. For more details on mobile icons, see 
Mobile icons .

Note: 
Not all listed icons work with quick actions. To see a list of 
compatible icons, filter your list where the Icons  field contains 
now-mobile-icons-buttons.

Note: 
The Icons  field is not on the icon list by default. To add the Icon 
field to your list, right-click the list header and select Configure 
> List Layout. Then, add the Icon  field to the selected list. You 
should see the icon field on your reference field list.

Order Number that indicates the order that the functions are listed. If there 
are multiple instances in the same location, the app displays them 
from the lowest to the highest.
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h. Click Submit.

i. Save the applet launcher record.

Result

Your users can open the quick action by selecting the  icon on the applet launcher page.

Enable notifications in Now Mobile

Allow push notifications on your mobile device when there is an update for a request.

Before you begin
Role required: admin

Procedure

1. Tap Notifications  in the navigation bar.

2. Tap the Enable notifications  radio button.
You will receive a notification in any of the following scenarios.

◦ Request Completed (one RITM)

◦ Request Completed (multiple RITM)

◦ Request not Processed

◦ Approval Record Assigned - RITM

◦ Approval Record Assigned - Request

◦ Request Rejected

◦ Agent adds comment to Requested Item

Enable the cart in Now Mobile

Allow a requester to add or edit items in the cart. By default, the cart is disabled in Now Mobile.

Before you begin
Role required: admin

Procedure

1. Navigate to sys_properties.list.

2. For the glide.sc.cart.enabled  property, specify Value  as true.

3. Click Update.
The Cart icon is displayed at the top of the app and the Add to Cart  button is enabled for 
items.

Edit the label of Submit button for a record producer

For a record producer submission experience that you can relate to, edit the label of the Submit 
button.

Before you begin
Role required: admin

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4091



Procedure

1. Navigate to All  > Service Portal  > Widgets.

2. Select the SC Catalog Item (widget-sc-cat-item-v2) widget.

3. From the Instances related list, preview and open the instance for the ServiceNow NowMobile 
App – Catalog Screens and Applet Launcher application.

4. In the Additional options, JSON format  field, specify the record_producer_label 
parameter.

For example, if you want to change the label to Request, press Ctrl+click on the catalog item 
widget, select Instance in Page Editor, and specify the following parameters in the Additional 
options, JSON format  field.

"record_producer_label":{
   "value" : "Request"
  }

5. Click Update.

Configure Now Mobile properties

Define the behavior of various catalog entities in Now Mobile.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Service Catalog  > Catalog Administration  > Properties.

2. On the Service Catalog Configuration form, select the Mobile  section.

3. Configure the required properties.

Now Mobile properties

Property Description

Catalog category sort option in Now Mobile 
(glide.sc.mobile.category.order_by)

Sort option for categories in Now Mobile.

◦ Title: Categories are sorted by their title. By default, categories are 
sorted alphabetically by their title.

◦ Order: Categories are sorted by their order.

Include 'Desktop only' Items in Now Mobile 
(glide.sc.mobile.include_desktop_only_items)

Option to include the catalog item with Availability  set to Desktop 
only  in Now Mobile.

Catalog item classes not available in 
Now Mobile (comma separated list) 
(glide.sc.mobile.item_class_not_supported)

Catalog item types to exclude in Now Mobile. For example, 
sc_cat_item_content, sc_cat_item_producer

Experience for items not available in Now Mobile 
(glide.sc.mobile.unsupported_discover)

Option to define the non-availability behavior of a catalog item. 
Possible options:

◦ Discoverable-show message that item is not viewable in Now mobile: 
Item is discoverable in the search and browse experience but not 
viewable.

◦ Not discoverable-do not show in search and browse experience: 
Item is neither discoverable in the search and browse experience nor 
viewable.
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Property Description

Note: 

◦ If AI Search is enabled for Now Mobile, this property is not 
applicable.

◦ This property is supported only when one of the following 
properties are applicable:

▪ Include 'Desktop only' Items in NOW Mobile 
(glide.sc.mobile.include_desktop_only_items)

▪ Catalog item classes not available in 
Now Mobile (comma-separated list) 
(glide.sc.mobile.item_class_not_supported)

Primary color for buttons in the catalog request experience in 
Now Mobile (glide.sc.mobile.primary_color). If 
Next Experience  is turned on, the property will be ignored.

Color for buttons in the catalog request experience.
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Important: 
The following properties are interdependent.

◦ Include 'Desktop only' Items in NOW Mobile

◦ Catalog item classes not available in NOW Mobile (comma separated list)

◦ Experience for items not available in NOW Mobile

Dependency between the Include 'Desktop only' Items in NOW Mobile property and 
Experience for items not available in NOW Mobile property

Availability 
value of 
the catalog 
item

Include 
'Desktop only' 
Items in NOW 
Mobile (true)

Include 'Desktop only' Items in NOW Mobile (false) Desktop only

Desktop 
only

Viewable 
in search 
and browse 
experience

◦ If set as discoverable using the Experience for 
items not available in NOW Mobile 
property, viewable in search and browse experience, but 
not available when you click the item.

◦ If set as not discoverable, not viewable in search and 
browse experience

Desktop 
and 
Classic 
Mobile

Always 
viewable 
in search 
and browse 
experience

Always viewable in search and browse experience

Classic 
Mobile 
only

Not viewable 
in search 
and browse 
experience

Not viewable in search and browse experience

Dependency between the Experience for items not available in NOW Mobile property 
and Items excluded using the Catalog item classes not available in NOW Mobile 
(comma separated list) property

Experience for items not available in 
NOW Mobile property value

Items excluded using the Catalog item classes not 
available in NOW Mobile (comma separated list) 
property

Discoverable-show message that 
item is not viewable in the mobile

Item types are viewable in search and browse 
experience, but not available when you click them.

Not discoverable-do not show in 
search and browse experience)

Item types do not appear in search and browse 
experiences

4. Click Save.

Service Catalog  topic blocks in Virtual Agent  powered by NLU

You can design a topic conversation in NLU-powered Virtual Agent  by including reusable topic 
blocks to perform request submission tasks.
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Search Catalog Item

You can use this topic block to search for a catalog item based on the search criteria. If there are 
multiple search results, you can select one from a carousel view.

Input parameters

Parameter Description

query_term Keyword to search for a catalog item. For information on configuring keyword 
search for a catalog item, see Configure keyword search for catalog items.

catalogs Comma-separated list of catalogs where a catalog item should be searched for.

result_limit Number of search results that should be displayed. By default, this number is set 
to 5.

Output parameters

Parameter Description

catalog_item_id If a catalog item is selected, sys_id of the item is returned.

If no catalog item is selected, that is, None of these  option is selected, -1 is 
returned.

item_type sys_class_name of the catalog item that the user selected.

is_conversational Specifies if the catalog item can be requested in the conversation mode in 
Virtual Agent.

Request Catalog Item

You can use this topic block to request for a catalog item.

Input parameters

Parameter Description

catalog_item_id sys_id of the catalog item that should be requested.

execute_contextual_search Option to specify if the contextual search should be run for a 
record producer based on its configuration. For information on 
defining contextual search for a record producer, see Define 
contextual search for record producer .

confirm_catalog_item Option to specify whether the user must confirm the catalog 
item before continuing with the next step. If this is set to false, 
user can answer the catalog items questions by skipping the 
confirmation.

show_end_state_card Option to display the end state card information about the 
generated record to the user.

Output parameters

Parameter Description

record_id sys_id of the record that is generated after the item submission.
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Output parameters  (continued)

Parameter Description

If the catalog item is not supported in the conversation mode or if the user does 
not have access to the item, -1 is returned.

record_table Name of the table in which the record is generated.

variables Questions related to the catalog item.

Virtual Agent render type

A catalog item can be rendered in Virtual Agent as a conversation, window, or popup.

Requesting a catalog item in a conversation mode

A user can submit a request in the conversation mode (by answering the questions in line).
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The following conditions must be met when a user requests a catalog item in the conversation 
mode in Virtual Agent  powered by NLU.
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• A catalog item cannot have more than the number of questions specified in the 
glide.sc.conversational.request.question.limit  property. By default, this 
number is set to 10. For more information about this property, see Service Catalog properties.

• A catalog item can have non-scripted catalog UI policies. These UI policies should be defined 
such that variables are affected sequentially, that is, only a variable with the lower order affects 
a variable with the higher order.

• A catalog item cannot have catalog client scripts that are defined for Now Mobile or Service 
Portal.

• Only the following variables are supported:

◦ Attachment

◦ Check box (A group of check box variables isn't supported)

◦ Date

◦ Date/Time

◦ Email

◦ IP Address

◦ Label

◦ Lookup Multiple Choice (without pricing implications and advanced reference qualifier)

◦ Lookup Select Box (without pricing implications and advanced reference qualifier)

◦ Multiple Choice (without pricing implications)

◦ Multi Line Text

◦ Numeric Scale (without pricing implications)

◦ Reference (without pricing implications and advanced reference qualifier)

Note: 
Reference type variable that corresponds to a table that has more than 7000 records 
are not supported. The upper limit for the number of records can be specified in the 
glide.sc.va.reference_question_choices.limit  property. By default, it 
is set to 7000.

◦ Requested For (without pricing implications and advanced reference qualifier)

◦ Rich Text Label

◦ Select Box (without pricing implications)

◦ Single Line Text

◦ URL

◦ Wide Single Line Text

◦ Yes / No

◦ Container variables

• The following variable attributes are supported:

◦ ref_ac_order_by

◦ allowed_extensions

◦ max_file_size
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Note: 
All the other variable attributes are ignored in Virtual Agent.

• A catalog item can have a single-row variable set but not a multi-row variable set.

• If a catalog item has a default value configured for a question, the default value is displayed 
in VA, which enables the user to proceed with the default value without having to select it 
manually. The user can also choose a different value other than the default value.

• If a catalog item has a data lookup configured for a question, the setter value is displayed 
in VA, which enables the user to proceed with the setter value or choose a different value. 
A catalog item with data lookup is not supported as a conversational item when the setter 
question precedes the matcher question.

• User cannot skip the following type of questions for a catalog item:

◦ Lookup Multiple Choice

◦ Select Box

◦ Lookup Select Box

◦ Yes/No

◦ Numeric Scale (If Do not select first choice  configuration is not selected)

◦ Multiple Choice (If Do not select first choice  configuration is not selected, or Include none 
choice  configuration is selected)

• If the user is using VA in a different supported collaboration tool like MS Teams:

◦ Searching for a value using the search icon in choice type of fields is not supported.

Choice type fields in MS Teams
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Choice type fields in VA

◦ Searching for a value in reference type of fields is performed in the form of a question.
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Reference type fields in MS Teams

Reference type field in VA

Requesting a catalog item as a pop-up

A user can submit a catalog item request as a pop-up for items, which are not conversational. 
In a pop-up, Virtual Agent provides a link for the user to submit the request in a pop-up without 
navigating to a new tab. A non-conversational catalog item can be rendered as a pop-up only if it 
does not have any Custom, Custom with label, or UI Page variables.

Note: 
If you do not want to render your Virtual Agent conversation as a pop-up, set the 
glide.sc.va.render_type.legacy  property to true, which renders all non-
conversational catalog items in the configured portal in a new tab.
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Requesting a catalog item as a window

A user can submit a catalog item request in a window. In a window, Virtual Agent 
provides a link for the user to submit the request in the Service Portal defined in the 
sn_itsm_va.com.snc.itsm.virtualagent.portal_url  property. A non-
conversational item is rendered as a window if it has a Custom, Custom with label, or UI Page 
variable.

A catalog item is rendered as a window if it is of the following types:

• Content Item

• Order Guide

• Wizard Launcher

• Standard Change Template
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Related topics

Catalog builder preview topic conversation

Configure Now Assist in Conversational Catalog Request

Submit a request topic conversation

Users can submit a request in a Virtual Agent  conversation.

The Submit a request topic conversation uses the following topic blocks:

• Search Catalog Item

• Request Catalog Item

Using the Submit a request topic conversation, users can submit a request by choosing from all 
available options. For example, when a user is requesting an item, the Virtual Agent  prompts the 
user to enter a search keyword. After the user enters the keyword, the Virtual Agent  responds 
with available choices in a carousel view.

When the user selects the required item, the following scenarios are possible:

• A user can submit a request in the conversation mode (by answering the questions in line). 
After the request submission, a requested item card is displayed with the request number as a 

link to the request page.

Note: 
In Now®  Mobile, the URL opens the native screen.

• A user can submit a request in a popup or a window.
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◦ In case of a popup, Virtual Agent provides a link for the user to submit the request in a popup 
without navigating to a new tab. A non-conversational catalog item can be rendered as a 
popup only if it does not have any Custom, Custom with label, or UI Page variables. For more 
information, see Service Catalog topic blocks in Virtual Agent.

◦ In case of a window, Virtual Agent  provides a link for the user 
to submit the request in the Service Portal  defined in the 
sn_itsm_va.com.snc.itsm.virtualagent.portal_url  property. A non-
conversational item will be rendered as a window it has a Custom, Custom with label, or UI 
Page variable. For more information, see Service Catalog topic blocks in Virtual Agent.

Note: 
Now Mobile  opens the item in Mobile Employee Service Portal (mesp).

Related topics

Service Catalog topic blocks in Virtual Agent powered by NLU

Service Catalog  topic blocks in Virtual Agent  powered by LLM

You can design a topic conversation in LLM-powered Virtual Agent  by including reusable topic 
blocks to perform request submission tasks.

Request catalog item (LLM)

You can use this topic block to request for a catalog item through a conversational and 
streamlined experience based on generative AI. For information about configuring Now Assist  in 
conversational catalog request, see Configure Now Assist in Conversational Catalog Request.
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Input parameters

Parameter Description

catalog_item_id sys_id of the catalog item that should be requested.

context_json Context of the conversation in JSON format.

execute_contextual_search Option to specify if the contextual search should be run for a 
record producer based on its configuration. For information on 
defining contextual search for a record producer, see Define 
contextual search for record producer .

confirm_catalog_item Option to specify whether the user must confirm the catalog 
item before continuing with the next step. If this is set to false, 
user can answer the catalog items questions by skipping the 
confirmation.

show_end_state_card Option to display the end state card information about the 
generated record to the user.

Output parameters

Parameter Description

record_id sys_id of the record that is generated after the item submission.

If the catalog item is not supported in the conversation mode or if the user does 
not have access to the item, -1 is returned.

record_table Name of the table in which the record is generated.

status Status of the request. Possible options are success or error.

variables Questions related to the catalog item.

message Message that gives additional information in case of any failure.

used_LLM Option that indicates if LLM was used while requesting the item, that is, if slot 
filling was done for questions defined in a catalog item using generative AI.

Virtual Agent  render type

A catalog item can be rendered in Virtual Agent  as a conversation, window, or popup.

Requesting a catalog item in a conversation mode

A user can submit a request in the conversation mode (by answering the questions in line).
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The following conditions must be met when a user requests a catalog item in the conversation 
mode in Virtual Agent  powered by LLM.

• A catalog item cannot have more than the number of questions specified in the 
sn_now_assist_cr.llm.conversational.request.question.limit  property. 
By default, this number is set to 500. For more information about this property, see Service 
Catalog properties.
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• A catalog item can have scripted catalog UI policies. But when a catalog item has scripted 
UI policies containing unsupported methods or functions, the catalog item becomes non-
conversational.

• The following methods or classes are supported in the catalog client scripts or scripted UI 
policies for a catalog item to be conversational:

◦ moment

◦ window.location.href

◦ top.location.href

◦ top.window.open

◦ window.open

◦ open

◦ Array

◦ Boolean

◦ Date

◦ Error

◦ GlideAjax

◦ GlideRecord

◦ JSON

◦ Math

◦ Number

◦ Object

◦ RegExp

◦ String

◦ alert

◦ console.info

◦ console.error

◦ console.debug

◦ console.warn

◦ console.log

◦ console.clear

◦ console.count

◦ console.countReset

◦ console.dir

◦ console.dirxml

◦ console.table

◦ decodeURI

◦ decodeURIComponent

◦ encodeURI

◦ evalexec

◦ g_form.addErrorMessage
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◦ g_form.addInfoMessage

◦ g_form.addOption

◦ g_form.clearMessages

◦ g_form.clearOptions

◦ g_form.clearValue

◦ g_form.getActionName

◦ g_form.getDisplayValue

◦ g_form.getEditableFields

◦ g_form.getIntValue

◦ g_form.getReference

◦ g_form.getSysId

◦ g_form.getTableName

◦ g_form.getUniqueValue

◦ g_form.getValue

◦ g_form.hasField

◦ g_form.hideAllFieldMsgs

◦ g_form.hideErrorBox

◦ g_form.hideFieldMsg

◦ g_form.isMandatory

◦ g_form.isNewRecord

◦ g_form.isReadOnly

◦ g_form.isVisible

◦ g_form.removeOption

◦ g_form.save

◦ g_form.setDisabled

◦ g_form.setDisplay

◦ g_form.setLabel

◦ g_form.setLabelOf

◦ g_form.setMandatory

◦ g_form.setReadOnly

◦ g_form.setReadonly

◦ g_form.setValue

◦ g_form.setVariablesReadOnly

◦ g_form.setVisible

◦ g_form.showErrorBox

◦ g_form.showFieldMsg

◦ g_form.submit

◦ g_user

◦ ga.addParam
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◦ ga.getXML

◦ indexOf

◦ isLoading

◦ isNaN

◦ newValue

◦ oldValue

◦ onChange

◦ parseFloat

◦ parseInt

◦ this

◦ toFixed

◦ trim

◦ undefined

◦ escape

◦ unescape

• A catalog item can have catalog client scripts. But when a catalog item has catalog client 
scripts containing unsupported methods or functions, the catalog item becomes non-
conversational.

• Only the following variables are supported:

◦ Attachment

◦ Check box (A group of check box variables isn't supported)

◦ Date

◦ Date/Time

◦ Duration

◦ Email

◦ HTML

◦ IP Address

◦ Label

◦ Lookup Multiple Choice (without pricing implications)

◦ Lookup Select Box (without pricing implications)

◦ Masked

◦ Multiple Choice (without pricing implications)

◦ Multi Line Text

◦ Numeric Scale (without pricing implications)

◦ Reference (without pricing implications)

◦ Requested For (without pricing implications)

◦ Rich Text Label

◦ Select Box (without pricing implications)

◦ Single Line Text
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◦ URL

◦ Wide Single Line Text

◦ Yes / No

◦ Container variables

Note: 
The UI page variable type is ignored in Virtual Agent  like the UI page is ignored in Service 
Portal. For more information, see Types of service catalog variables.

• Advanced reference qualifiers are supported.

• Field messages are supported.

Note: 
The field messages aren't shown to the requester in the following scenarios:

◦ If the field message appears for the question that's already answered.

◦ if a question is not shown to the requester or the question isn't answered already.

• The following variable attributes are supported:

◦ ref_ac_order_by

◦ allowed_extensions

◦ max_file_size

Note: 
All the other variable attributes are ignored in Virtual Agent.

• A catalog item can have a single-row variable set but not a multi-row variable set.

• If a catalog item has a default value configured for a question, the default value is displayed in 
Virtual Agent, which enables the user to proceed with the default value without having to select 
it manually. The user can also choose a different value other than the default value.

• If a catalog item has a data lookup configured for a question, the setter value is displayed in 
Virtual Agent, which enables the user to proceed with the setter value or choose a different 
value. A catalog item with data lookup is not supported as a conversational item when the 
setter question precedes the matcher question.

• User can't skip the following type of questions for a catalog item:

◦ Lookup Multiple Choice

◦ Select Box

◦ Lookup Select Box

◦ Yes/No

◦ Numeric Scale (If Do not select first choice  configuration is not selected)

◦ Multiple Choice (If Do not select first choice  configuration is not selected, or Include none 
choice  configuration is selected)

• If the user is using Virtual Agent  in a different supported collaboration tool like Microsoft 
Teams:
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◦ Searching for a value using the search icon in choice type of fields is not supported.

Choice type fields in Microsoft Teams
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Choice type fields in Virtual Agent

◦ Searching for a value in reference type of fields is performed in the form of a question.
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Reference type fields in Microsoft Teams

Reference type field in Virtual Agent

Note: 
If you've installed the Now Assist  in Conversational Catalog Request application, these 
conditions corresponds to the catalog item's conversational mode in the Virtual Agent 
powered by LLM.

Requesting a catalog item as a pop-up

A user can submit a catalog item request as a pop-up for items, which are not conversational. 
In a pop-up, Virtual Agent provides a link for the user to submit the request in a pop-up without 
navigating to a new tab. A non-conversational catalog item can be rendered as a pop-up only if it 
does not have any Custom, Custom with label, or UI Page variables.

Note: 
If you do not want to render your Virtual Agent conversation as a pop-up, set the 
glide.sc.va.render_type.legacy  property to true, which renders all non-
conversational catalog items in the configured portal in a new tab.
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Requesting a catalog item as a window

A user can submit a catalog item request in a window. In a window, Virtual Agent 
provides a link for the user to submit the request in the Service Portal defined in the 
sn_itsm_va.com.snc.itsm.virtualagent.portal_url  property. A non-
conversational item is rendered as a window if it has a Custom, Custom with label, or UI Page 
variable.

A catalog item is rendered as a window if it is of the following types:

• Content Item

• Order Guide

• Wizard Launcher

• Standard Change Template
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Related topics

Configuring Now Assist in Virtual Agent

Catalog builder preview topic conversation

Now LLM Service updates

Service Catalog configuration for Universal Request

You can configure a catalog item or record producer to create a universal request when a request 
is submitted. The associated requested item (for catalog item) or task-based record (for record 
producer) becomes the primary ticket for that universal request.

Related topics

Create or edit a catalog item

Create a record producer

Configure a catalog item or record producer to create a universal request

Configure all catalog items or record producers to create a universal request

Reduce the implementation time by configuring all catalog items or all record producers at a time 
for universal request creation.

Before you begin
Role required: admin

About this task
For catalog items, RITM should be registered as a service in Universal Request.

For record producers, the target table should be registered as a service in Universal Request.

For information about service configurations, see Service Configuration form .

Procedure

1. Navigate to sys_properties.list.

2. Click New.
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3. To configure all catalog items to create a universal request:

a. On the form, fill in the fields.

System Property form

Field Description

Name Unique identifier of the property. 
Specifysn_uni_req.enable_ur_all_cat_items.

Type Type of the property. Specify boolean.

Value Option to specify if all catalog items can be configured at a time to create a 
universal request. Possible values are true  or false.

b. Click Submit.

4. To configure all record producers to create a universal request:

a. On the form, fill in the fields.

System Property form

Field Description

Name Unique identifier of the property. 
Specifysn_uni_req.enable_ur_all_rec_prod_items.

Type Type of the property. Specify boolean.

Value Option to specify if all record producers can be configured at a time to create a 
universal request. Possible values are true  or false.

b. Click Submit.

Service Catalog  Reference

Reference topics provide additional information about the lists and forms.

Service Catalog  properties

The Service Catalog  application contains properties used to configure various settings in the 
application.

To configure Service Catalog  system properties, navigate to Service Catalog  > Catalog 
Administration  > Properties. The properties are categorized into the following sections.

• Homepage: Configure settings for the Service Catalog  homepage, and control the behavior of 
the categories and the items displayed on the homepage.

• Catalog Items: Configure settings for catalog items and record producers.

• Order Guides  > General: Configure settings for the order guide.

• Order Guides  > Scriptable Order Guides: Configure settings for scriptable order guides.

• Cart: Control the behavior of the shopping cart and checkout screens.

• Request Fulfillment: Configure settings for request fulfillment processes.

• Search: Configure search settings for the Service Catalog  homepage.
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• Security: Configure security settings for the Service Catalog.

• Pricing: Configure settings for the pricing engine and pricing display.

• Portal: Configure settings for catalog portal widgets.

• Virtual Agent: Configure settings for request submission in Virtual Agent.

This section is visible only when you activate the Service Management Virtual Agent Topic 
Blocks
plugin (com.glideapp.cs.sm_topic_blocks)
.

• Mobile: Configure settings for Now Mobile.

• Other: Additional settings for the Service Catalog.

Service Catalog  properties

Name Description

Homepage

Number of Catalog Items/Categories to preview in a section (glide.sc.max_items) Number of catalog items or categories to preview in a section:

• Type:  integer

• Default value:  5

Show category descriptions in the category view page 
( com.glide.servicecatalog.view_includes_category_descriptions)

Show category descriptions in the category view page:

• Type:  yes | no

• Default value:  yes

In category view display subcategories in a panel 
( glide.sc.use_sub_cat_section)

In category view, display subcategories in a panel:

• Type:  true | false

• Default value:  true

Toggle whether the expand/collapse icon is rendered for category widgets on the 
service catalog homepage ( glide.sc.homepage.show.collapse)

Toggle whether the expand/collapse icon is rendered for category 
widgets on the service catalog homepage:

• Type:  true | false

• Default value:  false

When browsing a category use the pop-up icon to show item details 
( glide.sc.cat_view_use_popup_for_details)

When browsing for a category or a catalog item, use the info icon next 
to the category or catalog item to preview category or item details:

• Type:  true | false

• Default value:  false

Number of catalog items to expand in browsing and search when not using pop-up 
icons to view details ( glide.sc.auto_expand)

Number of catalog items to expand in browsing and search when not 
using pop-up icons to view details:

• Type:  integer

• Default value:  2
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Service Catalog  properties  (continued)

Name Description

Show the additional categories section when viewing a catalog item 
( glide.sc.show_additional_cats)

Show the additional categories section when viewing a catalog item:

• Type:  true | false

• Default value:  true

Limit descriptions in category and item listings to two rows in the Mobile UI 
( glide.sc.mobile.limit.description)

Limit descriptions in the category and item listings to two rows in the 
Classic Mobile UI:

• Type:  true | false

• Default value:  true

List of content types (comma-separated) to allow on the catalog homepage. Blank 
allows all content types. (glide.sc.home.filter)

List of content types (comma-separated) to allow on the catalog 
homepage. Blank indicates all content types.

Name of placeholder picture for items that don't have a picture defined 
( glide.sc.placeholder.image)

Name of the placeholder picture for items that don't have a picture 
defined. Applicable only to Classic Mobile and not Desktop.

By default, two images are available: sc_placeholder_image.png  and 
sc_placeholder_image-01.png. In addition, the default can be replaced 
with a custom image:

Default value:  sc_placeholder_image.png

Catalog Items

Specifies the default behavior of record producer after record generation 
(glide.sc.producer.redirect_url)

Default redirect behavior of the record producer after its generation.

Possible values:

• Generated Task record: Redirects to the task record created using 
the record producer.

• Catalog Homepage: Redirects to the service catalog where the order 
for the record producer is placed.

Override this behavior by editing the value of the Redirect To  field of 
the record producer or defining the redirect code in the Script  field of 
the record producer.

Enabling this makes sure that the attachments uploaded to the attachment variable 
are deleted from the system if and when they are replaced/deleted on the form 
(glide.sc.variable.attachment.delete.v2)

Automatically deletes a sys_attachment record from the system when 
you replace or delete an attachment from a catalog item attachment 
variable.

List of class names for catalog items that can't be added to an existing request 
( glide.sc.item.cannot_add_to_request)

List of class names for catalog items that can’t be added to an existing 
request:

• Type:  string

• Default value:  sc_cat_item_guide, sc_cat_item_producer, 
sc_cat_item_wizard

List of class names for catalog items that don’t use the default "Try It" UI action 
( glide.sc.item.cannot_try_it)

List of class names for catalog items that don't use the default "Try It" UI 
action:
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Service Catalog  properties  (continued)

Name Description

• Type:  string

• Default value:  sc_cat_item_guide, sc_cat_item_producer, 
sc_cat_item_wizard, sc_cat_item_service

List of class names for catalog items that don’t generate a normal cart item 
( glide.sc.item.not_normal_cart_item)

List of class names for catalog items that don't generate a normal cart 
item:

• Type:  string

• Default value:  sc_cat_item_guide, sc_cat_item_producer, 
sc_cat_item_wizard

Relationship tables which should be part of 'Copy Item' action. Table Name should be 
comma-separated ( glide.sc.item.copy.include_relationship)

Specify the tables in which the records having a reference to a catalog 
item are also copied when you copy the catalog item using the Copy  UI 
action:

Note: 
Table names should be comma-separated without any spaces.

Disables clickthrough via the info-icon on a reference variable. Set value to true to 
enable this functionality (glide.sc.variable.reference.clickthrough)

Disable clickthrough via the info icon on a reference variable. Set the 
value to true to enable this functionality.

Order Guides

General

List of class names for catalog items that can’t be included in an order guide 
(glide.sc.item.order_guide_exclusion)

Comma-separated list of class names for catalog items that can’t 
be included in an order guide. For example, sc_cat_item_guide and 
sc_cat_item_content.

Validate mandatory fields when switching tabs in 'Choose Options' section of Order 
Guides ( glide.sc.guide.tab.validate)

Validate mandatory fields when switching tabs in the Choose Options 
section of order guides:

• Type:  true | false

• Default value:  true

Render order guide on cart preview and order status page 
(glide.sc.render_order_guide_column)

Render the order guide on cart preview and order status page. If an 
item is part of an order guide, the order guide is listed next to the item. 
If a user attempts to delete an item belonging to an order guide, a 
confirmation message appears.

On an order guide, reset cascading or assigned variable values on an item when a user 
goes back using the "describe needs" button (glide.sc.reset_cascade).

Note: 
This property is supported in Platform only, not in the portal.

On an order guide, reset cascading variable values on an item when a 
user navigates by clicking Describe Needs.

On an order guide, reset all variables when cascading variables or assigned variable 
values are reset on an item after a user goes back using the "describe needs" button 
(glide.sc.reset_cascade_all)

In an order guide, reset the values of cascading variables and non-
cascading values on an item when a user navigates back and forth 
between the Described Needs  and Choose Options  screens. If set to 
false, only the values for the cascading variables are reset.
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Service Catalog  properties  (continued)

Name Description

Note: 
This property is supported in Platform only, not in the portal.

Scriptable Order Guides

During the processing of a scriptable order guide, create a failure record when the JSON 
payload is empty (glide.sc.sog.empty_payload)

If selected, creates a failure record when the JSON payload is empty 
during the processing of a scriptable order guide.

During the processing of a scriptable order guide, create a failure record when the order 
guide is inactive (glide.sc.sog.inactive_order_guide)

If selected, creates a failure record when the order guide is inactive 
during the processing of a scriptable order guide.

During the processing of a scriptable order guide, create a failure record when the order 
guide sys_id is invalid (glide.sc.sog.invalid_order_guide_id)

If selected, creates a failure record when the order guide sys_id is 
invalid during the processing of a scriptable order guide.

During the processing of a scriptable order guide, create a failure record when there is a 
general JSON parsing error (glide.sc.sog.json_parsing)

If selected, creates a failure record when there is a general JSON 
parsing error during the processing of a scriptable order guide.

During the processing of a scriptable order guide, create a failure record when JSON 
parameters are missing (glide.sc.sog.mandatory_json_parameters)

If selected, creates a failure record when JSON parameters are missing 
during the processing of a scriptable order guide.

Cart

Enable cloning requests during checkout. Deprecated by sc_layout; if sc_layout is 
enabled then this property is not used (glide.sc.allow.checkout.clone)

Enable cloning requests during checkout.

Note: 
This property is deprecated when cart layouts are enabled.

List of roles (comma-separated) that can use bulk ordering functionality. Blank means all 
users (glide.sc.allow.clone.roles)

Roles (comma-separated) that can clone requests for other users. 
Blank value indicates all users can clone requests.

Show the 'Back to Catalog' button on the two-step checkout screen 
(glide.sc.checkout.twostep.back)

Show the Back to Catalog  button on the two-step checkout screen.

Use the two-step catalog checkout model (default false) 
(glide.sc.checkout.twostep)

Use the two-step catalog checkout model.

Default value:  false

Condition under which users may cancel a request (previous property must also 
be true). For example, current.opened_by == gs.getUserID() || current.caller_id == 
gs.getUserID() (glide.sc.checkout.cancel.condition)

Condition under which users can cancel a request. Requires Allow ess 
users the option to cancel their requests from the checkout screen  to 
be True.

Allow ess users the option to cancel their requests from the checkout screen. In 
conjunction with sc_layout feature, if either is set to true the cancel button becomes 
visible (glide.sc.checkout.cancel)

Enable Employee Self-Service (ESS) portal users the option to cancel 
their requests from the checkout screen.

Use the two-step checkout model when placing a Catalog Order from a Wizard (default 
true) (glide.expert.checkout.twostep)

Use the two-step checkout model when placing a catalog order from a 
wizard:

Default value:  true

List of roles (comma-separated) that can update the "Requested for" widget in 
the service catalog. Blank means all users. If the user doesn't have privileges to 
change requested for, they will not have ability to get other user address details 
(glide.sc.req_for.roles)

List of users with the roles (comma-separated) provided 
here can request items for other users. If no role is 
specified, then the default behavior is defined by the 
glide.sc.req_for.roles.default  property. For information 
about configuring the glide.sc.req_for.roles.default 
property, see Configure the default behavior to request items for other 
users.
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Service Catalog  properties  (continued)

Name Description

Controls access to the Requested For  widget on the catalog 
homepage. Users with access to this widget can request items for 
another person. Users without access can place orders in their own 
name only.

Ordering of matches for the "request for" service catalog widget. Choose fields in the 
sys_user table (glide.sc.request_for.order_by)

Ordering of matches for the "request for" Service Catalog  widget. 
Choose fields in the user [sys_user]  table.

Show the request item number for each line item on the checkout screen (default 
false). Deprecated by sc_layout; if sc_layout is enabled then this property is not used 
(glide.sc.checkout.request.number)

Show the request item number for each line item on the checkout 
screen:

Default value:  false

Note: 
This property is deprecated when cart layouts are enabled.

Field name to use for the description column of the checkout form. If blank, the default 
(short_description) is used (glide.sc.ess.description)

Field name for the description column of the checkout form. If blank, 
the default is used:

Default value:  short_description

Additional columns for the "request for" service catalog widget. 
Choose fields in the sys_user table. Must be semicolon separated 
(glide.sc.request_for.columns)

Additional columns for the "request for" Service Catalog  widget. 
Choose fields in the user [sys_user]  table. Must be semicolon 
separated.

Automatically update the delivery address for catalog carts when the details of a users 
location changes ( glide.sc.auto.cart.address.reset)

Automatically update the delivery address for catalog carts when the 
user location details change.

If enabled, when changes are made to a user's address, and the 
user has an active cart, updates the user's address in the cart. If not 
enabled, the old address is retained in the cart:

• Type:  true | false

• Default value:  false

When determining the address of a user prioritize the details on an 
associated location record over the details on the user record itself 
(glide.sc.prioritise.user.location)

If selected, when determining the address of a user, prioritizes the 
details on an associated location record over the details on the user 
record itself.

Determines whether 'Order Now' button exhibits new or old behavior. If this property 
is true, clicking "Order Now" button in the service catalog, only orders the item 
currently selected, any items saved in user's shopping cart is left untouched for future 
ordering. Old 'Order Now' feature is deprecated, 'Order Item' button is deprecated too 
(glide.sc.enable_order_now)

Determines whether the Order Now  button exhibits new or old 
behavior. If this property is true, clicking Order Now  in the service 
catalog only orders the item currently selected. Any items saved in the 
shopping cart are left untouched for future ordering. The legacy Order 
Now feature and the Order Item  button are deprecated.

List of roles (comma-separated) that can use the quantity selector in the shopping cart. 
Blank means all users (glide.sc.allow.quantity)

List of roles (comma-separated) that can use the quantity selector in 
the shopping cart. Blank means all users.

Enable removal of inactive catalog items from cart 
( glide.sc.remove_inactive_cat_items_from_cart)

Enable removal of inactive catalog items from cart.

If enabled, automatically removes all deactivated catalog items from 
the shopping cart. Avoids users ordering items which are placed in the 
cart while active and are then made inactive:
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Service Catalog  properties  (continued)

Name Description

• Type:  true | false

• Default value:  false

Use the sc_layout driven cart macros (default: true) 
( glide.sc.use_cart_layouts)

Use the sc_layout driven cart macros.

Activates the new cart layout mechanism, which enables customization 
of cart and checkout-related widgets and pages without the need to 
own the UI macros or pages:

• Type:  true | false

• Default value:  true

Show tasks related to requests on the order status page (the screen 
you see in the service catalog after a successful order is placed) 
(glide.sc.checkout.task.display)

Show tasks related to requests on the Order Status page, the screen 
that you see in the service catalog after a successful order is placed.

Round all delivery plans > 1 day to the nearest day (true) or display the precise time 
(false) (glide.sc.round.delivery.times)

Round all delivery plans > 1 day to the nearest day (true) or display the 
precise time (false).

Request Fulfillment

Prevent changes to requested item quantity when approved (except for catalog_admin 
users) (glide.sc.restrict.quantity.changes)

Prevent changes to the requested item quantity (except for 
catalog_admin users).

Show the current pending approver's name in the stage widget mouseover 
(glide.sc.approval.hover)

Show the current pending approver's name in the stage widget 
mouseover.

Service catalog tasks approval engine (glide.approval_engine.sc_task) Service Catalog  Tasks approval engine.

Audit changes to service catalog variables (glide.sc.audit.variables) Audit changes to Service Catalog  variables.

Hide the border and background in variable editor ui 
(glide.sc.hide_variable_editor_background)

If selected, hides the border and background in variable editor UI. The 
default value is false.

Use delivery task name instead of short_description for the delivery 
plan summarizer field. Default is false (uses the short_description) 
(glide.sc.delivery_summary.name)

Use the delivery task name instead of the short description for the 
delivery plan summarizer field:

Default value:  false (uses the short description)

Render variables on a request item as they appear on the order panel, followed by 
the delivery plan variables (true), or merge the two based on their order values (false) 
(glide.sc.variable.snapshot)

Render variables on a request item as they appear on the order panel, 
followed by the delivery plan variables (true), or merge the two based 
on their order values (false).

Service Catalog Requests approval engine 
(glide.approval_engine.sc_request)

Service Catalog  requests approval engine.

Search

List of class names for catalog items that don't have the search field displayed 
( glide.sc.item.cannot_show_search)

List of class names for catalog items that don’t have the search field 
displayed:

• Type:  string

• Default value:  sc_cat_item_guide, sc_cat_item_producer, 
sc_cat_item_wizard
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Service Catalog  properties  (continued)

Name Description

Allow empty service catalog searches 
(glide.sc.search.allow_empty_search)

If selected, an empty query in the search bar displays all items. This 
query is performance-heavy.

List of roles (comma-separated) that can search the service catalog. Blank means all 
users (glide.sc.can_search)

List of roles (comma-separated) that can search the Service Catalog. 
Blank means all users.

Show breadcrumbs for the categories associated with items when they are displayed in 
browse and search listings (glide.sc.show_listing_breadcrumbs)

If selected, display breadcrumbs for the categories associated with 
items when they are displayed in browse and search results.

Service catalog searches return items in inactive categories 
( glide.sc.search.disabled_cats)

Service Catalog  searches return items in inactive categories.

Search results can include catalog items in non-accessible categories, 
as specified by the active flag or by security constraints:

• Type:  true | false

• Default value:  true

List of catalog sys_ids (comma-separated) that are excluded from catalog item search 
(glide.sc.search.exclude_catalogs)

List of catalog sys_ids (comma-separated) that are excluded from 
catalog item search.

Number of service catalog matches returned for global searches 
(glide.sc.search.rowcount)

Number of the service catalog matches returned for global searches. 
Limits the number of results returned by a catalog search to improve 
search performance.

Specify whether search suggestions should be enabled 
(glide.sc.search.suggestions)

Specify whether search suggestions are enabled:

• Type:  true | false

• Default value:  true

Security

Use "User Criteria" to define access to catalog items and categories 
( glide.sc.use_user_criteria)

Use user criteria to define access to catalog items and categories. 
Entitlements are not honored if set to true:

• Type:  true | false

• Default value:  true

Enable both "User Criteria" and "Entitlement" related lists for 
catalog items and categories when migrating from entitlements 
( glide.sc.user_criteria_migration)

Enable User Criteria related lists for catalog items and categories when 
migrating from entitlements.

Set to true  to display the user criteria related lists without needing to 
switch to user criteria functionality:

• Type:  true | false

• Default value:  false

List of roles (comma-separated) that can override normal entitlement checking inside 
the catalog. A role of "itil" means that the itil role can order any catalog item, even one 
protected by entitlement restrictions (glide.sc.entitlement.override)

List of roles (comma-separated) that can override normal entitlement 
checking inside the catalog. A role of "itil" means that the itil role can 
order any catalog item, even one protected by entitlement restrictions.

List of roles (comma-separated) that override entitlements so that they can view any 
category within the service catalog (glide.sc.category.canview.override)

List of roles (comma-separated) that override entitlements to enable 
viewing of any category within the Service Catalog.
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Service Catalog  properties  (continued)

Name Description

Default value:  admin and catalog_admin

Pricing

Append pricing information to option labels (glide.sc.enhance.labels) Append pricing information to option labels. This is also applicable in 
Service Portal.

List of class names for catalog items that don't show the price in listings 
(glide.sc.item.cannot_show_price)

List of class names for catalog items that do not show the price in 
listings.

When to show prices and sub-totals on the service catalog cart (overrides sc_layout 
record settings) (glide.sc.price.display)

When to show prices and sub-totals in the service catalog cart.

When set to true then the two script includes CatalogPriceCalculator and 
CatalogRecurringPriceCalculator are used generate prices (enabling custom 
functionality) (glide.sc.use_custom_pricegenerator)

When set to true, the script includes, CatalogPriceCalculator 
and CatalogRecurringPriceCalculatorare used to generate 
prices, which enables custom functionality.

To use your own price calculation logic, set this property to Yes. Then 
edit the calcPrice  method inside the CatalogPriceCalculator  and 
CatalogRecurringPriceCalculator  script includes, using your own 
price calculation algorithm:

• Type:  yes | no

• Default value:  no

Portal

Show order confirmation pop-up in checkout process (glide.sc.sp.twostep) If selected, displays the order confirmation window during the two-step 
checkout process inService Portal.

Use Cart V2 widget in Header Menu widget 
(glide.sc.portal.use_cart_v2_header)

If selected, the Cart V2 (SC Shopping Cart widget (ID: sc-shopping-
cart-v2)) widget is enabled in the Header Menu widget of Service 
Portal.

Virtual Agent

This section is visible only when you activate the Service Management Virtual Agent Topic Blocks
plugin (com.glideapp.cs.sm_topic_blocks)
.

Specifies the upper limit for the number of questions beyond which the item 
doesn’t support conversational requests, default value of the property is 10. 
(glide.sc.conversational.request.question.limit)

Maximum number of questions for a catalog item for it to be eligible for 
request submission in the conversation mode in Virtual Agent.

Specifies the upper limit for the number of questions beyond which the item 
doesn’t support conversational requests, default value of the property is 500. 
(sn_now_assist_cr.llm.conversational.request.question.limit)

Maximum number of questions for a catalog item for it to be eligible for 
request submission in the conversation mode in Virtual Agent  using 
LLM model type.

Mobile

Catalog category sort option in Now Mobile 
(glide.sc.mobile.category.order_by)

Sort option for categories in Now Mobile.

• Title: Categories are sorted by their title. By default, categories are 
sorted alphabetically by their title.

• Order: Categories are sorted by their order.
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Service Catalog  properties  (continued)

Name Description

Include 'Desktop only' Items in Now Mobile 
(glide.sc.mobile.include_desktop_only_items)

Option to include the catalog item with Availability  set to Desktop 
only  in Now Mobile.

Catalog item classes not available in Now Mobile (comma separated list) 
(glide.sc.mobile.item_class_not_supported)

Catalog item types to exclude in Now Mobile. For example, 
sc_cat_item_content, sc_cat_item_producer

Experience for items not available in Now Mobile 
(glide.sc.mobile.unsupported_discover)

Option to define the non-availability behavior of a catalog item. 
Possible options:

• Discoverable-show message that item is not viewable in Now mobile: 
Item is discoverable in the search and browse experience but not 
viewable.

• Not discoverable-do not show in search and browse experience: 
Item is neither discoverable in the search and browse experience nor 
viewable.

Note: 

• If AI Search is enabled for Now Mobile, this property is not 
applicable.

• This property is supported only when one of the following 
properties are applicable:

◦ Include 'Desktop only' Items in NOW Mobile 
(glide.sc.mobile.include_desktop_only_items)

◦ Catalog item classes not available in 
Now Mobile (comma-separated list) 
(glide.sc.mobile.item_class_not_supported)

Primary color for buttons in the catalog request experience in Now Mobile 
(glide.sc.mobile.primary_color). If Next Experience  is turned on, the 
property will be ignored.

Color for buttons in the catalog request experience.

Other

Log all client-side actions on variable ( glide.sc.log.variable_actions ) If set to true, captures the variable log in the Variable Action Logger 
window:

• Type:  true | false

• Default value:  false

Use links for breadcrumbs rendered in service catalog pages accessed via a CMS site 
( glide.sc.use_breadcrumb_links.cms)

Use links for breadcrumbs rendered in Service Catalog  pages 
accessed via a CMS site.

Enables users with the CMS administrator (content_admin) role to 
choose whether service catalog breadcrumbs are displayed with or 
without links for greater navigation control:

• Type:  true | false

• Default value:  false

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4125



Service Catalog  properties  (continued)

Name Description

Enable the ui policies related to variable set to be run first 
( glide.sc.ui_policy.variable_set_run_first)

Enable the UI policies related to the variable set to run first.

If enabled, UI policies related to the variable set are run first, then the UI 
policies on items:

• Type:  true | false

• Default value:  false

The maximum number of orphan sc_item_option records to delete when any 
sc_req_item record is deleted (sc_orphan_item_option_delete_limit)

Maximum number of orphan sc_item_option records to delete when 
any sc_req_item record is deleted.

Installed with Service Catalog

Several types of components are installed with the Service Catalog.

Script includes installed with Service Catalog

Script includes are added with activation of Service Catalog.

Service Catalog  adds the following script includes.

Script include Description

DemoSCCreateItem Demonstrates the use of service catalog scoped API.

Domain separation and Service Catalog

Domain separation is supported in Service Catalog. Domain separation enables you to separate 
data, processes, and administrative tasks into logical groupings called domains. You can control 
several aspects of this separation, including which users can see and access data.

Support level: Standard

• Includes all aspects of Basic  level support.

• Application properties are domain-aware as needed.

• Business logic: The service provider (SP) creates or modifies processes per customer. The use 
cases reflect proper use of the application by multiple SP customers in a single instance.

• The instance owner must configure the minimum viable product (MVP) business logic and data 
parameters per tenant as expected for the specific application.

Sample use case: An admin must be able to make comments required when a record closes for 
one tenant, but not for another.

For more information on support levels, see Application support for domain separation .

Activation information

You should activate the Service Catalog - Domain Separation plugin 
(com.glideapp.servicecatalog.domain_separation) to enable domain separation for Service 
Catalog. For information on how you can request for the plugin activation, see Request for 
domain separation in Service Catalog.

This plugin should only be activated if there is a need for the following scenarios:
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• Isolate items to requesters in a specific domain.

• Make items unavailable for request in any other domain irrespective of the domain hierarchy.

If Service Catalog has already been domain separated as a custom solution, activating this 
plugin may override the existing behavior to enforce the plugin-specific isolation.

How domain separation works in Service Catalog

Service providers supporting multiple customers in a single ServiceNow instance can ensure 
data privacy across domains using domain separation. Service providers can ensure that items 
created or published in a specific domain can only be requested by users in that domain without 
adding additional user criteria to the individual catalog items.

In Service Catalog, catalog items (catalog items, record producers, content items, and order 
guides) are domain-separated as data. Catalogs, categories, and variables are not domain-
separated, and belong to the global domain. Also, items that need to be shared across multiple 
domains must be published in the global domain and restricted by user criteria.

Domain separation in Service Catalog is applicable to all requester views in the ServiceNow 
AI Platform, Service Portal, Agent Workspace, mobile application, as well as to all API calls 
requesting for items.

Domain-separated tables

The Domain  (sys_domain) and Domain Path  (sys_domain_path) columns are added to the 
following tables that are domain-separated:

• sc_cat_item

• sc_item_option

• sc_multi_row_question_answer

• question_answer

Effective domain for a user

For users with visibility to a single domain, the effective domain is the user’s domain. For users 
with visibility to multiple domains, the effective domain is the domain selected in the domain 
picker.

Visibility of catalog items - Item creation and maintenance

A catalog item can be created or published in any domain in the hierarchy. For information on 
creating a catalog item, see Create or edit a catalog item.The item is created in the effective 
domain of the user. For information on enabling the domain picker, see Enable domain selection 
menus in Core UI . Once the item is created in a specific domain, all future edits to the item are 
done in that domain itself.

If a catalog item is published using Item Designer, the domain of the item is the domain selected 
in the domain picker while publishing the item. Once the item is published, it can only be 
modified and re-published in the domain it was originally published in.

Catalog items are domain separated as data. Only for maintenance and administration, the 
visibility of the catalog items follows the data domain hierarchy rules. For information on domain 
separation hierarchies, see Domain separation hierarchies .

User criteria associated with a catalog item must be visible in the domain of the catalog item. If 
not visible, catalog item is considered to be not associated with that user criteria.
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Visibility of catalog items - Item request flow

The catalog item created in a specific domain is available in the browse, search, and request 
experience only in that domain and not available in the peer domains, child domains, and parent 
domains irrespective of the hierarchy and visibility of the domains. So, requesters can only 
request for items in their domain as well as in the global domain.

For users with access to multiple domains (for example, IT fulfiller), the items are available for 
request based on the domain selected in the domain picker. To view or request an item of a 
specific domain, the user should switch to that domain. For information on enabling the domain 
picker, see Enable domain selection menus in Core UI .

When a requester submits a request using an order guide which has items from multiple 
domains, only the items in the effective domain and the global domain are ordered.

The target records such as requests, requested items, or records created by record producers 
are created in the effective domain.

Request fulfilment flow and reporting for a domain-separated catalog item

The target records such as requests, requested items, or records created by record producers 
can be accessed by a fulfiller who has visibility to the domain that the record has been 
generated in. For information on visibility in domain hierarchies, see Visibility domains and 
Contains domains . Even when the fulfiller modifies the requested item from a domain other 
than the requested item’s domain, the modifications are recorded in the target record’s domain. 
Since the target records are separated as data, the reports retrieve data based on the effective 
domain of the user requesting the report.

Request flow by a fulfiller from a different domain

When a fulfiller creates a request from a parent record such as an incident in Agent Workspace 
or in ServiceNow AI Platform, the fulfiller can only request for an item from the parent record’s 
domain or from the global domain. Also, the corresponding target records are created in the 
parent record’s domain.

Note: 
Items from multiple domains cannot be added to the cart.

Catalog client scripts and catalog UI policies

Since the catalog client scripts and catalog UI policies are domain-separated as processes, 
scripts and policies in the parent domain can be overridden in the child domains. However, 
these scripts and policies are applicable based on the domain of the catalog item or the domain 
of the target record.

For example, consider that A is the parent domain and B is its child domain. A catalog item in 
domain B is associated with a catalog client script defined in domain A. If this catalog client 
script is overridden in the child domain B, the overridden script in domain B is applicable while 
fulfilling the requested item in domain B. Even when a fulfiller from the parent domain A fulfills the 
requested item in the child domain B, the overridden script in domain B is applicable.

Note: 
It is recommended to not override catalog client scripts and catalog UI policies.

Catalog builder

An item can only be edited in the domain that it has been created. Catalog UI policies and 
actions added in catalog builder are created in the same domain as that of the item.
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Related topics

Domain separation for service providers

Request for domain separation in Service Catalog

Enable domain separation in Service Catalog by requesting for the activation of the Service 
Catalog - Domain Separation plugin (com.glideapp.servicecatalog.domain_separation).

Before you begin
Role required: admin

About this task
There are two ways to request a plugin:

• Access the Now Support  Service Catalog directly by selecting All  > Service Catalog  > Activate 
Plugin  on Now Support.

• Access the Now Support  Service Catalog through the All Applications page on your instance 
by following these steps.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. On the All Applications page, select Request Plugin  to open the Activate Plugin  form on Now 
Support.

3. On Now Support, select the link to access the Now Support  Service Portal  Service Catalog.

4. Select your instance.

5. Select Actions > Activate Plugin.

6. On the Activate Plugin  form, provide the following information.
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Activate Plugin form

Field Description

What is your target instance Instance on which to activate the plugin.

Which plugin would you like to activate Name of the plugin to activate.

Note: 
If the system does not list the plugin you 
want or if you are activating the plugin 
on an OEM or on-premise instance, 
select the Plugin I'm looking for is not 
listed  check box and then enter the 
name of the plugin.

Select Maintenance Date and Time The date and time to activate the plugin.

Note: 
Plugins are activated in two batches, 
once in the morning and once in the 
evening, on every business day in the 
US Pacific time zone. If the plugin must 
be activated at a specific time, enter the 
request in the Reason/Comments  field.

Example 

For example, see the following form to activate the CSM Workspace plugin on an instance 
named My Instance.

Activate Plugin form
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7. Select Submit.
For additional details about requesting a plugin, see Requesting a Plugin from the Service 
Catalog [KB0751715] article in the Now Support  Knowledge Base.

Sample ATF tests for Service Catalog  in Service Portal

Validate the continued functionality of Service Catalog  after any configuration change such as 
an upgrade or after developing an application. All test suites and tests should pass on a default 
implementation. To validate a custom implementation, copy the automated tests and configure 
them for your customizations.

Service Catalog  sample tests require activating the Service Catalog  - ATF Tests plugin 
(com.glideapp.servicecatalog.atf.test) along with the demo data. To run these tests using a 
suite, follow the procedure described in Run an automated test suite  by selecting the Service 
Catalog - ATF Tests  test suite. These sample tests are dependent on the demo data items.

Service Catalog Tests test suite

Test Description

Ordering an item with a multi-row variable set 
(SP)

Validate ordering an item in Service Portal  that 
needs data from a multi-row variable set

Ordering catalog items using an Order Guide 
(SP)

Validate ordering an item from an order guide 
in Service Portal

Request a catalog item (SP) Validate requesting a catalog in item in Service 
Portal

Search for items, add to cart and checkout 
(SP)

Validate using the cart in Service Portal

Submitting requests using a Record Producer 
(SP)

Validate using a record producer in Service 
Portal

Viewing and editing catalog item variables in 
the Catalog Task page

Validate catalog item variables from a catalog 
task

Viewing and editing catalog item variables in 
the Requested Item page

Validate catalog item variables from a 
requested item

Add comment on catalog item(s) request 
created by user

Add comments on a ticket page for a 
requested item or incident

Approving requests on different catalog item 
ordered from end-users

Approving a request for catalog items

Catalog item(s) ordering from multiple 
catalogs

Order catalog items from multiple catalogs

Filter for recent records from My Request filter Filter for recent open and closed records from 
the My Requests  menu

Ordering catalog item(s) from saved bundle Order catalog items from a saved bundle

Validate contents of 'My Recent Items' Validate contents of the My Recent Items 
widget

Validating Regex for Variables Validate variables using a regular expression

Validate Requested For variable flow for Cart 
Checkout

Validate the Requested For variable flows for 
cart checkout
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Service Catalog Tests test suite  (continued)

Test Description

Validate Requested For variable flow for Order 
Guide

Validate the Requested For variable flows for 
an order guide

Validate Requested For variable flow with 
Catalog Item access

Validate the Requested For variable flows 
based on the catalog item access

Variables to collect data for record producer fields

Use variables to collect data for record producer fields.

You can use the following variable types to collect data for the corresponding record producer 
fields.

Variables for record producer fields

Field type Recommended variable type

True/False Yes/No

Reference Reference

Date or Due Date Date

Date/Time Date/Time

Choice or any field with an associated choice list Select Box

Email address Email

URL URL

HTML HTML

List or UI Action List List Collector

String with length greater than 256 Multi-Line Text

String, Integer, Decimal, Floating Point Number Single-Line Text

File Attachment Attachment

All other field types Multi-Line Text

Note: 

• If the record producer variable is mapped to an encrypted field of another table, then this 
variable value is not stored in Question Answer [question_answer] table. So, it is also not 
available in the variable editor of the target record.

• If the record producer variable is masked and encrypted, and also mapped to an 
encrypted field of another table:

◦ The variable value is not stored in Question Answer [question_answer] table.

◦ The decrypted value of the variable is copied to the encrypted field of the target record.

Values Returned

When you construct a record producer, be aware of the return value.
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Most of these field types return a string. However, there are some exceptions. For example, a 
Reference  value returns the sys_id  of the target object, and a List  value returns a comma-
separated list of sys_ids.

Example 1: For a List  value, return an array which can be iterated to retrieve the individual values 
submitted by your user:

var sys_id_string  = producer.glide_list_field;
var sys_id_list = sys_id_string.split(',');

Example 2: For a Date  or Date/Time  value, return a date which GlideDate can evaluate.

var glideDateTime  = new GlideDateTime(producer.date_field);

Service catalog variables

Service catalog variables capture and pass on information about choices a customer makes 
when ordering a catalog item. Variables help define the structure of a catalog item form that is 
displayed to the customer.

For example, you can define a variable called Memory  to provide users with memory options at 
an extra cost for a PC catalog item. An Apple iPhone catalog item can use a variable called Color 
that allows customers to select the color when they order the phone from the catalog. You can 
define some variables to affect an item price, depending on the choices made.

Service Catalog  provides several types of variables, which are also referred to as questions. 
Variables can be stored, accessed from multiple places, and passed between tasks in a process 
when fulfilling a request. They can be displayed on the Requested Item and Catalog Task forms 
after an item has been ordered.

You can define service catalog variables with the catalog_admin role.

Related topics

Scriptable service catalog variables

Use service catalog variables in a report – Report Designer

Types of service catalog variables

Variables allow you to specify questions for a catalog item. Several types of service catalog 
variables are provided. Some variable types accept variable attributes.

See the following sections for more details on each variable type. For details on creating a 
variable, see Create a service catalog variable. You can also provide help text for any service 
catalog variable. For information on defining help information, see Define help information for a 
service catalog variable.

Support in various channels

Service Catalog variables are supported in various channels. For information on their availability, 
see Variable support in various channels.

Attachment

When submitting a catalog item request, this variable lets you upload an attachment for a 
question of the item. After you upload the attachment, you can also download, update, and 
delete it. Even when fulfilling the request, you can download, update, and delete the attachment 
in a requested item or catalog task. You can specify restrictions for file size and extensions using 
the max_file_size  and allowed_extensions  variable attributes. For information on 
these variable attributes, see Service Catalog variable attributes.
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Important: 

• You should specify only an integer value for the following:

◦ The max_file_size  variable attribute

◦ The  glide.sc.variable.attachment.default_max_size  system 
property (catalog-level). The default value is 20.

• If the max_file_size  variable attribute is not specified, the 
glide.sc.variable.attachment.default_max_size  system property value 
is considered as the upper limit for the attachment file size.

• Irrespective of the file size allowed in the variable, the attachment file size cannot exceed 
the size specified in com.glide.attachment.max_size  system property, which is 
applicable for attachments across ServiceNow AI Platform.

• The g_form.setValue()  API is supported in catalog client scripts.

Note: 
When you edit an attachment, the existing attachment is removed and a new attachment is 
uploaded.

When you upload an attachment to this variable, an entry is created in the Attachment 
[sys_attachment] table. The variable is not updated until you submit the item request, add 
it to the cart, or save the record while editing it (in fulfiller flows). If you delete or update the 
attachment before submitting the corresponding catalog item, the entry in the Attachment 
[sys_attachment] table is cleared.

The attachment uploaded for this variable is copied in the following scenarios:

• In an order guide, when the variable is cascaded to a catalog item in the rule base

Important: 
The individual variable attributes are not honored for the catalog items in the rule base. 
For example, let us consider that a variable in the Describe Needs  section allows a .pdf 
attachment and the variable of a catalog item in the rule base allows a .txt attachment. 
When you upload an attachment of .pdf type for a variable in the Describe Needs 
section, it is initially cascaded to the variable in the catalog item as well and the variable 
attributes specified in the catalog item are not honored. However, if you delete this 
initially cascaded attachment from an individual item and try to upload a new attachment, 
then the individual variable attributes of the catalog item are honored.

• In a record producer, when the variable is mapped to a task table field. This variable can be 
mapped only to the File Attachment field type of a task table.

Important: 
After an attachment is copied, the changes to the individual attachments are independent. 
For example, any change to an attachment in the order guide does not impact the same 
attachment cascaded to the catalog item in the rule base.

Warning: 
Since the attachments are copied, a larger size can lead to performance issues.

If the system-wide anti-virus check is enabled, the anti-virus check is performed on the 
attachment when you:

• Submit a request for the corresponding catalog item

• Add the catalog item to the cart or wish list
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Note: 

• This variable is not supported in a multi-row variable set.

• This variable is supported in flows and workflows.

• This variable is available in condition builder

• For this variable, item variable assignment is not supported in order guide.

Attachment variable

Break

The break variable displays a horizontal line across the form. This line is a formatting element 
that does not collect data.

Example: break variable

Check box

The check box variable lets you enable and disable options by selecting and clearing it.

To make a check box mandatory, select the Selection Required  option when you create the 
variable. For example, use this option to require users to select the I agree  check box for an 
agreement form. If users try to submit the agreement form without selecting the check box, an 
alert message is displayed to tell users that they must select the check box.

A group of check box variables is created when you create consecutive check box variables. 
These check box variables are sorted by their order within the group. If you want to define a 
custom label for the group of check boxes, create a label  variable at the start of the consecutive 
check box variables. The label is then considered a part of this group and acts a label of the 
group. If there is no custom label, check boxes are grouped under an Options  label by the 
application.

In a group of check box variables:

• If any check box variable in the group is mandatory, the entire group becomes mandatory 
irrespective of the visibility of the mandatory check box variable. An asterisk (*) is then 
displayed next to the group label and you must select at least one of these check boxes.

• Hiding the label hides the entire group.
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• If all other check box variables of a mandatory check box group are hidden and not selected, 
the following scenarios are applicable:

◦ The group remains mandatory as long as there is one check box in the group that is visible 
and not selected.

◦ The last check box of this group cannot be hidden if it is not selected.

In Service Portal, to make a group of check box variables mandatory, set at least one of the check 
box variables as mandatory. While defining the label for a group of check boxes, setting a label 
mandatory does not make the group of check box variables mandatory.

In catalog builder, the following scenarios are applicable:

• If there are two consecutive check boxes, then a virtual container is created for a group of 
check boxes. Only check box variable types can be added inside the group

• Even if a check box variable is added immediately after a group of check boxes, it is 
automatically added to the group.

Under the Type Specifications  tab, you can specify the price in different currency types. Also, 
you can configure the price in the following pricing models:

• Calculated

• Fixed

• Multiple

For information on the pricing models, see Price fields  .

Example: check box variable

Container start, container split, and container end

The container start, container split, and container end variables define a layout for a container 
that can hold more variables. Use the container start and container end variables to define 
the start and end points of a container layout. The container end must be used along with the 
container start to close a container.

A container layout can be split into two or three columns using the container split variable. By 
default, the split is calculated at the 50% mark.

A container is similar to a variable set. Unlike a variable set, containers can be used anywhere, 
including inside a variable set. Containers can also be nested inside each other.

For more help with selecting the appropriate container type, see the Determining if you are using 
the correct container variable [KB0539982]  article in the HI Knowledge Base.
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Note: 

• The container variables are not yet supported on mobile devices.

• Container start, container split, and container end variables are supported in Service 
Portal. However, if the settings are done on the top-level container, a maximum of two-
column layouts can be achieved.

• Variable sets are also considered as containers. So, a container start variable with a two-
column layout under a variable set is not supported in Service Portal.

To reproduce the container shown in the following figure, enter the following settings when 
creating a container start variable:

• Select a Layout  with 2 Columns Wide, alternating sides.

• Select the Display title  check box to use a collapsible title bar.

Example: container variable

Date

The date variable creates a widget with a field and calendar to select a date.

Example: date variable

Date and time

The date and time variable creates a widget with a calendar and fields to select a date and time. 
The time value is stored in Greenwich Mean Time (GMT) and displayed in your time zone.
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Example: date and time variable

Duration

Use the duration variable to specify the duration for which a catalog item is available.

For attributes supported by this variable, see variable attributes.

Note: 
Enter the duration in the DD HH:MM:SS format when setting the default value of the 
variable, and specifying in the g_form.getValue() and g_form.setValue() functions.

Example: duration variable

Email

The email variable creates a widget to enter and select an email address. The variable accepts 
only valid email expressions containing @ and domain information.

Note: 
Variable validation is not supported in Service Portal.

Example: email variable

HTML

The HTML variable lets you provide content with advanced formatting, including images, for a 
catalog item.
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Use the variable to create fields for user input. You can also use the variable for reusable content 
when put into a variable set, such as terms and conditions.

The variable is available in two modes: edit and read-only. In edit mode, a toolbar is available, 
and links do not work. In read-only mode, the toolbar is disabled, and links work. To switch 
between modes, use entitlements or create a UI policy to set the HTML field to read-only mode.

Note: 
HTML variables are not supported for display on the shopping cart summary or approval 
summary screens.

Example: HTML variable

IP Address

Use the IP address variable to specify the IPv4 and IPv6 data for a catalog item. Under the 
Validation Scripts  submodule, a validation script type associated with this variable is available.

Note: 

• Variable validation is not supported in Service Portal.

• When you set the default value for the IP Address  variable, or specify its value in the 
g_form.getValue() and g_form.setValue() functions, the delimiter is (.).

Example: IP address variable

Label

The label variable displays a label across the form. Labels are formatting elements. No data is 
collected.

You can use labels to arrange questions into sections. You can also use labels for questions with 
multiple options. For example, label check boxes  for the different options for a question.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4139



You cannot set a Label variable as mandatory. However, you can make mandatory, a group of 
check box variables preceded by a Label variable.

Example: label variable

List collector

The list collector variable creates an interface that lets you select and add multiple records from 
a table. For attributes supported by this variable, see variable attributes.

Example: list collector variable
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Note: 

• The Reference Qualifier and glide_list attribute applies to releases from Helsinki onward 
only. The attribute does not apply to Geneva.

• You can set a value for this variable using the g_form.setValue()  function in a 
catalog client script.

• When the glide_list attribute is not true, you can only set the value that is visible in 
the Available  list using the g_form.setValue()  function. This functionality is not 
applicable when the setValue()  function is called onLoad.

• Table with large data causes performance issues when loading the page. Use reference 
qualifiers to reduce data or use the glide_list attribute.

• The values in the referenced table do not appear if the user is not logged in.

• The list collector displays a maximum of 100 items in a list. After moving items to the 
Selected  list, you can click Run Filter  to refresh the Available  list. This action will add 
more available items to the list, to a maximum of 100 items.

Lookup multiple choice

The lookup multiple choice variable creates radio buttons using data from a table. Its 
functionality is similar to the lookup select box  variable, which creates a choice list from queried 
data. For attributes supported by this variable, see variable attributes.

Note: 

• Table with large data causes performance issues when loading the page. Use reference 
qualifiers to reduce data or use the reference type variable.

• You cannot add more than 10,000 choices.

Example: lookup multiple choice variable

Lookup select box

The lookup select box variable creates a choice list using data queried from a table. Its 
functionality is similar to the lookup multiple choice  variable, which creates radio buttons from 
queried data. For attributes supported by this variable, see variable attributes.
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To create the lookup select box, enter the following values when creating the variable:

• Lookup from table: Incident [incident]

• Lookup value field: Sys ID

• Lookup label field: number, category, priority

• Reference qual: caller_id=javascript:gs.getUserID()^active=true

Note: 

• Table with large data causes performance issues when loading the page. Use reference 
qualifiers to reduce data or use the reference type variable.

• You cannot add more than 10,000 choices.

Custom

This variable inserts a UI macro into the catalog item.

UI macros in the service catalog do not support the following glide_list functions: clickthrough, 
slushbucket editing, and email field.

• Use phase one  Jelly only for any UI macros added as variables. Phase two Jelly within the 
macro is not processed and appears on the page as standard content.

• This variable is not yet supported on Classic Mobile devices.

• This variable is supported in Service Portal through widgets. Create a widget with the same 
functionality as that of a macro and link the widget with the variable.

Example: Custom variable

Custom with label

This variable inserts a UI macro with a label.

• This variable is not yet supported on Classic Mobile devices.

• This variable is supported in Service Portal through widgets. Create a widget with the same 
functionality as that of a macro with label, and link it with the variable.

Example: Custom with label variable
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Masked

The masked variable inserts a field that masks the text entered. Each character entered is 
displayed as an asterisk (*). Use this variable to ask users for sensitive or confidential data such 
as passwords.

By selecting the Use encryption  check box, you can configure the variable to encrypt its value 
using various encryption algorithms before storing in the database. These values can only be 
decrypted by using now_GR.variables.var_name.getDecryptedValue() on RITM, Catalog Task, or 
any task extension record created using a record producer.

Note: 
By default, the Use encryption  field is set to true to ensure secure storage of information.

On the variable editor, you can also decrypt and encrypt the values of a masked variable using 
the Show  and Hide  buttons. These buttons are not available for a fulfiller (itil) without the 
catalog_view_masked role. You can only view the value that you specified while requesting.

Actions on an encrypted variable

RolesAction

Requester Fulfiller with the 
catalog_view_masked role

Fulfiller without the 
catalog_view_masked 
role

View or hide 
the encrypted 
value on 
catalog forms

Yes Not applicable Not applicable

Edit the 
encrypted 
value on 
catalog forms

Yes Not applicable Not applicable

View or hide 
the encrypted 
value on the 
variable editor

Yes Yes No

Edit the 
encrypted 
value on the 
variable editor

Yes

Note: 
If the masked 
variable is read-
only on the variable 
editor, the variable 
value is not editable

Yes

Note: 
If the masked 
variable is read-
only on the variable 
editor, the variable 
value is not editable

No

Example: masked variable
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Multi-line text

The multi-line text variable creates a field that lets you enter multiple lines of text.

Example: multi-line text variable

Multiple choice

The multiple choice variable creates radio buttons for question choices.

Example: multiple choice variable

Numeric scale

The numeric scale variable creates a set of radio buttons for a range of options, like a Likert scale.

Example: numeric scale variable

Reference

A reference variable references a record in another table. For example, a variable named 
point_of_contact references the User [sys_user] table. For attributes supported by this variable, 
see variable attributes.

Keep the following information in mind when you create a reference variable:

• Reference variables use the auto-complete feature  . To ensure that users have enough 
information to make the selection, configure the reference lookup list  .

• Reference variables store the sys_id of the selected record (like reference fields). To use the 
display value in a script, use the same methods as for a reference field.

current.variables.<variable name>.getDisplayValue()

Example: reference variable

Requested For

Before submitting a catalog item request, this variable helps you specify who this request can be 
submitted for. You should specify this information while answering catalog item questions.
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Important: 

• You can only specify users from the User [sys_user] table.

• If you don’t specify the default value for this variable, the current logged-in user 
requesting the item is considered as the default Requested For variable value.

• You can submit the request for a user based on access to a catalog item. The Access 
Type  field of the catalog item can be used to specify if a request can be submitted for a 
user who does not have access to the catalog item.

• For this variable, item variable assignment is not supported in the rule base of an 
order guide. If the order guide contains the Requested For variable, the value would be 
cascaded to the equivalent variable of items in the rule base as read-only.

Using the Enable also request for  field of the Requested For variable, you can request a catalog 
item for different users under one request.

For information about delegated request experience, see Delegated request experience.

Important: 

• You can add this variable to a catalog item or variable set. However, when submitting the 
request, a catalog item can have only one Requested For variable.

• You can add only one Requested For variable for a variable set.

• This variable is not supported in a multi-row variable set.

• After the request is submitted, this variable value is visible in the variable editor and 
variable summarizer.

Requested For variable

Rich Text Label

This variable displays a formatted label on a catalog item form. In the TinyMCE rich text editor, 
you can format the label and add images or links. This variable supports the HTML tags.
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Note: 

• You can make this variable visible using catalog client scripts and catalog UI policies.

• You cannot cascade this variable in an order guide.

• You cannot set this variable as mandatory.

• In the Automated Test Framework, this variable is only supported in the Variable State 
Validation step to check the visibility.

• This variable is not supported in the following:

◦ Variable summarizer

◦ Multi-row variable set

◦ Condition builders and reports

• You cannot specify the following for this variable:

◦ Help text and instructions

◦ Tool tip

◦ Permissions

◦ Variable width

◦ Example text

• The g_form.setValue(), g_form.setReadOnly(), and 
g_form.setMandatory()  APIs are not supported in catalog client scripts. Only the 
g_form.setVisible()  API is supported.

Rich Text Label variable

Select box

The select box variable creates a list from predefined question choices. For attributes supported 
by this variable, see variable attributes.

Example: select box variable

Single-line text

The single-line text variable creates a field to enter a single line of text. For attributes supported 
by this variable, see variable attributes.
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Example :single-line text variable

UI page

The UI page variable inserts a UI page into the catalog item.

• Use phase one Jelly only for any UI macros added as variables. Phase two Jelly within the 
macro is not processed and appears on the page as standard content.

• This variable is not yet supported on Classic Mobile devices and in Service Portal.

URL

The URL variable creates a widget for users to enter URLs. URLs are validated for the following 
protocols: HTTP, HTTPS, FTP.

Note: 

• Variable validation is not supported in Service Portal.

• This variable is not editable on Now Mobile.

Example: URL variable

Wide single-line text

The wide single-line text variable creates a field that spans the form, letting users enter longer 
lines of text. For attributes supported by this variable, seevariable attributes.

Example: wide single-line text variable

Yes/No

The Yes or No variable creates a choice list with Yes  and No  as options.

Example: Yes or No variable

Variable support in various channels

Service Catalog  variables are supported in various channels.
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Variable support

Variable
ServiceNow 
AI Platform

Service 
Portal

Now 
Mobile

Conversational 
interface in 
Virtual Agent 
powered by 
LLM

Conversational 
interface in Virtual 
Agent  powered by 
NLU

Variable editor in 
Workspace  and 
Catalog Item UIB 
component

Attachment Yes Yes Yes Yes Yes Yes

Break Yes Yes Yes Ignored or 
skipped

Ignored or 
skipped

Yes

CheckBox Yes Yes Yes No Single check box 
without the pricing 
implications is 
supported

Yes

Container 
End

Yes Yes Yes Yes Yes Yes

Container 
Split

Yes Yes Yes Yes Yes Yes

Container 
Start

Yes Yes Yes Yes Yes Yes

Date Yes Yes Yes Yes Yes Yes

Date/Time Yes Yes Yes Yes Yes Yes

Duration Yes Yes Yes No No Yes

Email Yes Yes Yes Yes Yes Yes

HTML Yes Yes Yes No No Yes

IP Address Yes Yes Yes Yes Yes Yes

Label Yes Yes Yes Yes Yes Yes

List 
Collector

Yes Yes Yes Yes No Yes

Lookup 
Multiple 
Choice

Yes Yes Yes Yes (Without 
pricing 
implications)

Yes (Without 
pricing 
implications 
and advanced 
reference 
qualifier)

Yes

Lookup 
Select Box

Yes Yes Yes Yes (Without 
pricing 
implications)

Yes (Without 
pricing 
implications 
and advanced 
reference 
qualifier)

Yes

Custom Yes Yes Yes No No No

Custom 
with Label

Yes Yes Yes No No No

Masked Yes Yes Yes Yes No Yes
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Variable support  (continued)

Variable
ServiceNow 
AI Platform

Service 
Portal

Now 
Mobile

Conversational 
interface in 
Virtual Agent 
powered by 
LLM

Conversational 
interface in Virtual 
Agent  powered by 
NLU

Variable editor in 
Workspace  and 
Catalog Item UIB 
component

Multi Line 
Text

Yes Yes Yes Yes Yes Yes

Multiple 
Choice

Yes Yes Yes Yes (Without 
pricing 
implications)

Yes (Without 
pricing 
implications)

Yes

Numeric 
Scale

Yes Yes Yes Yes (Without 
pricing 
implications)

Yes (Without 
pricing 
implications)

Yes

Reference Yes Yes Yes Yes (Without 
pricing 
implications)

Yes (Without 
pricing 
implications 
and advanced 
reference 
qualifier)

Yes

Requested 
For

Yes Yes Yes Yes (Without 
pricing 
implications)

Yes (Without 
pricing 
implications 
and advanced 
reference 
qualifier)

Yes

Rich Text 
Label

Yes Yes Yes Yes Yes Yes

Select Box Yes Yes Yes Yes (Without 
pricing 
implications)

Yes (Without 
pricing 
implications)

Yes

Single Line 
Text

Yes Yes Yes Yes Yes Yes

UI Page Yes No No Ignored or 
skipped

No No

URL Yes Yes Yes Yes Yes Yes

Wide 
Single Line 
Text

Yes Yes Yes Yes Yes Yes

Yes / No Yes Yes Yes Yes Yes Yes

Create a service catalog variable

Create service catalogs variables to gather information from users ordering a catalog item, for 
example, to ask users which options they want for the item.

Before you begin
Role required: admin
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Procedure

1. Navigate to All  > Service Catalog  > Catalog Definitions  > Maintain Items.

2. Select the catalog item that you want to create a variable for.

3. In the Variables  related list, click New.

4. Select the variable type.
Only the applicable fields for the variable type are then displayed.

5. In the form, fill the fields.

Variable form

Field Description

Application Read-only field that indicates which applications can use this variable.

Map to field Maps the variable to a specific field on the table for the record producer.

This field appears if the variable belongs to a record producer.

Type The variable type that you want to create. For more information, see Types of 
service catalog variables.

Catalog 
item

Catalog item using the variable.

Order Order that the variable is placed on the page for the catalog item. The 
variables are organized from top to bottom from least to greatest order value. 
For example, a variable with an order value of 1 is placed above other variables 
with higher-order values.

Active Check box to make the variable available for use

Mandatory Check box to make the variable mandatory as part of the ordering process.

Note: 
This behavior is applicable only on page load, and can be changed via 
client APIs.

Read only Option to make a variable read only or editable.

Hidden Option to hide a variable.

Unique Option to disallow duplicate values for this variable within a multi-row variable 
set.

Note: 

◦ This field appears only for a variable created in a multi-row variable set.

◦ This behavior is applicable only in ServiceNow AI Platform, Service 
Portal, and variable editor in Agent Workspace.

Selection 
Required Check box to require users to select the check box variable. For example, use 

this option to require users to select an I agree  check box for an agreement 
form. If users try to submit the agreement form without selecting the check box, 
an alert message is displayed to tell users that they must select the check box.
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Field Description

Global If selected, the variable is available for all catalog tasks within service catalog 
workflows or execution plans by default. If deselected, the variable must be 
associated with individual catalog tasks.

Field Field that the variable maps to.

This field appears if the variable belongs to a record producer.

Record 
producer 
table

Table that the record producer creates a record in.

This field appears if the variable belongs to a record producer.

Question

Question Question to ask users ordering the catalog item.

Name A name to identify the question.

Note: 
If this field is empty, its value is auto-populated based on the Question 
field for all variable types except break, container split, and container 
end.

Tooltip Tooltip text to display when users point to the variable. Enter a brief note to 
describe the purpose of the 'Question'.

Example 
text

Hint that is displayed in the question field before a user enters a value.

Applicable for the following variables:

◦ IP Address

◦ Email

◦ URL

◦ Single Line Text

◦ Wide Single Line Text

◦ Multi Line Text

◦ Date

◦ Date/Time

Rich Text Formatted label to be displayed on a catalog item form.

Applicable for the Rich Text Label variable.

Annotation

Show help If selected, displays the help text  and instructions for the variable.

Note: 

◦ It is not available for break and check box variables.

◦ Help text and instructions are not available for a variable set.

Always 
Expanded

If selected, the Help text  and Instructions  field value are expanded by default 
when the catalog item page loads.
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Field Description

This check box appears only when the Show help  check box is selected.

Note: 

◦ This field is also applicable in Service Portal.

◦ This field is not applicable in the variable editor in Workspace  and 
Catalog Item UIB component.

◦ If the Expand help for all questions  check box is selected at the 
catalog item level, then the Always Expanded  field setting at the 
variable level is overridden.

◦ If the Expand help for all questions  check box is deselected at the 
catalog item level, then the Always Expanded  field setting at the 
variable level is applicable.

Help tag If the Always Expanded  check box is deselected, click the value specified in 
this field to display the Help text  and Instructions  field values.

This field is not applicable in the variable editor in Workspace  and Catalog 
Item UIB component.

Help text Help information for a service catalog variable.

This field is applicable in ServiceNow AI Platform, Service Portal, and variable 
editor in Workspace, and Catalog Item UIB component.

However, in Workspace  and Catalog Item UIB component, you can view either 
help text or instructions. If both instructions and help text are available, you 
can view only the instructions.

This field is not applicable for Break, CheckBox, Container End, Container 
Split, Macro, and UI Page variables. In Workspace  and Catalog Item UIB 
component, this field is additionally not applicable for a Masked variable.

Instructions Information that requires rich text formatting or adding images to support help 
information.

This field is applicable in ServiceNow AI Platform, Service Portal, and variable 
editor in Workspace, and Catalog Item UIB component.

However, in Workspace  and Catalog Item UIB component, you can view either 
help text or instructions. If both instructions and help text are available, you 
can view only the instructions.

In Workspace  and Catalog Item UIB component, this field is additionally not 
applicable for a Masked variable.

Note: 
For HTML tables, use sizes that are within the width of the variable.

Type Specifications (The fields in this section vary for each variable type)

Variable 
Width

Width for the variable on the catalog item page, to specify what percentage of 
the screen size that it can span. For details, see Configure a default width for 
service catalog variables.
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Field Description

This field appears for all variable types except for break, container end, 
container start, container split, container layout, and label variables.

Enable also 
request for

Option to allow a catalog item request to be submitted for multiple users. 
After you select this option, the Also request for  field is displayed along with 
Requested For variable in a catalog item.

◦ This functionality is only applicable in Service Portal.

◦ This field is applicable only for the Requested For variable.
For information about delegated request experience, see Delegated request 
experience.

Roles to use 
also request 
for

Option to specify the roles that can submit a catalog item request for multiple 
users.

◦ This functionality is only applicable in Service Portal.

◦ This field is applicable only for the Requested For variable.

◦ This field appears only when the Enable also request for  check box is 
selected.

Note: 
If no role is specified, anyone who has access to the catalog item can 
submit the request.

For information about delegated request experience, see Delegated request 
experience.

Choice 
direction

The direction in which the choice list is arranged.

◦ Across: Arranges choices horizontally.

◦ Down: Arranges choices vertically.

This field appears for lookup multiple choice variables.

Note: 
The selected direction is also applicable in Service Portal.

Choice field Table field to populate options for the variable. If no choices are defined for a 
field, then the variable loads field-related distinct values from the table.

This field appears for select box variables.

Choice 
table

Table with values to populate in the Choice field.

This field appears for select box variables.

Do not 
select the 
first choice

Check box to leave all options for the variable cleared on the catalog item 
page.

If this check box is selected, the first choice for the variable selected by 
default.

This field appears for multiple choice and numeric scale variables.

Dynamic ref 
qual

Dynamic qualifier. Select a dynamic filter to run a query against the reference 
field.
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Field Description

This field appears for reference variables when Use reference qualifier  is set 
to Dynamic.

Include 
none

Check box to include the None  option in a list of choices.

This field appears for lookup multiple choice, lookup select box, multiple 
choice, and select box variables.

Layout Layout for a container, whether one or two columns.

This field appears for container start variables.

List table Table with the values for the list collector. The table should have a display 
column specified.

This field appears for list collector variables.

Lookup from 
table

Table from which values are obtained for users to select. The values from this 
table are populated in the Lookup value field.

This field appears for lookup multiple choice and lookup select box variables.

Lookup 
value field

Field in the lookup table that populates options for the variable.

This field appears for lookup multiple choice and lookup select box variables.

Lookup 
label field(s)

Comma-separated list of fields in the lookup table whose values are used to 
display options.

This field appears for lookup multiple choice and lookup select box variables.

Lookup 
price field

Field in the lookup table whose value is used to modify the price of the item 
being ordered.

This field appears for lookup multiple choice and lookup select box variables.

Lookup 
recurring 
price field

Field in the lookup table whose value is used to modify the recurring price of 
the item being ordered.

This field appears for lookup multiple choice and lookup select box variables.

Macro UI macro  to insert into the catalog item.

This field appears for macro, macro with label, and UI page variables.

Summary 
macro

Applicable only for Marco, and Macro with Label type variables.

Widget Applicable only for Marco, and Macro with Label type variables.

Price if 
checked

Price of the item.

This field appears for check box variables.

Recurring 
price if 
checked

Price that increments for the item, when the user requests more than one order 
of the item.
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Field Description

This field appears for check box variables. For more information about prices 
and recurring prices, see Using variables for price setup.

Reference Reference table for the variable. The table should have a display column 
specified.

This field appears for reference variables.

Reference 
qual

Qualifiers to restrict data that is available in the field.

Supports reference qualifiers and advance qualifiers. For more information, 
see Reference qualifiers .

Returns all matching results (no maximum).

Note: 
For security reasons, the use of scripts in the Reference qual  field is 
restricted to system administrators through the Allow javascript in 
Default Value  business rule.

This field appears for list collector, lookup multiple choice, lookup select box, 
reference and Requested For variables.

It appears for reference variables when Use reference qualifier  is set to 
Dynamic.

Reference 
qualifier 
condition

Options to build conditions.

This field appears for reference variables when Use reference qualifier  is set 
to Simple.

Scale max Highest value on the scale of available options for the variable.

This field appears for numeric scale variables.

Scale min Lowest value on the scale of available options for the variable.

This field appears for numeric scale variables.

Unique 
values only

Check box to require a unique value for the field. When this check box is 
selected, two records cannot have the same value for that field.

This field appears for lookup multiple choice, lookup select box, and select box 
variables.

Use 
confirmation

Check box to prompt users to reenter data to verify their entries.

This field appears for masked variables.

Use 
encryption

Check box to store the answer in encrypted format in the database. If not 
encrypted, the answer is stored in plain text format. Encryption uses Triple DES 
with system encryption.

This field appears for masked variables.
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Field Description

Use 
reference 
qualifier

Type of qualifier to use.

This field appears for reference variables.

Validation 
Regex

Regular expression that validates the variable value. This field is displayed only 
for Single Line Text and Wide Single Line Text variable types.

To define regular expressions, see Define a regular expression for a variable.

Note: 

◦ This field is also applicable in Service Portal.

◦ The max_length attribute value is valid even when the validation regex 
is set.

◦ You cannot add a catalog item with regex validation errors to the 
wishlist.

Variable 
attributes

Attributes that define the behavior and restrictions for a variable. For 
information on variable attributes, see Service catalog variable attribute.

Default Value

Default 
value

Default value for the variable.

Permission

If no role is specified in this tab for the read, write, or create actions, all users who can access 
the catalog item can perform these actions irrespective of their role. For example, if no role 
is specified for the Write roles  field, all users who can access the catalog item can edit the 
variable value in the variable editor.

A user with a role that does not match any of the following roles cannot set variable values 
even through scripting.

These roles are not available for Label, Break, Container Split, Container End, Macro, Macro 
with Label, and UI Page variables.

Read roles Roles that can view the variable before or after requesting the catalog item or 
record producer. Only a user with the roles specified in this field can view the 
variable.

Write roles Roles that can edit the variable in the variable editor after requesting the 
catalog item or record producer. If a user does not have the roles specified in 
this field, the variable is read-only in the variable editor.

Create roles Roles that can create values for the variable before requesting the catalog item 
or record producer. If a user does not have the specified role, the variable is 
read-only before requesting the catalog item or record producer.

Availability

Visible 
Elsewhere

If selected, the variable is visible in the item form before ordering the item, in 
VEditor after ordering the item, and in the cart view of the item.

Visible on 
Bundles

If selected, the variable is visible when the item is added to a bundle.
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Field Description

Visible on 
Guides

If selected, the variable is visible when it is added to an order guide, or when it 
is added to a catalog item that is included in the order guide.

Note: 
If an order guide has too many items and variables, consider clearing this 
check box on as many items as possible, to improve loading performance 
on order guides.

Visible on 
Summaries

If selected, the variable is visible on any variable summarizer of the catalog 
item.

In Service Portal, the variable is visible in the RITM ticket page and the 
Approval page.

In Now Mobile, the variable is visible in the RITM and the Approval records.

6. Click Submit.

Define help information for a service catalog variable

Enter help information for a variable to help users determine what info they must provide for a 
service catalog variable.

Before you begin
Role required: admin

About this task
Demonstrates these options to provide help text for service catalog item variables: tooltips, help 
text, instructions (HTML help text), and example text.

Procedure

1. Navigate to All  > Service Catalog  > Catalog Definitions  > Maintain Items  and click the catalog 
item with the variable that you want to provide help for.

2. In the Variables  related list, click the variable.

3. In the Annotation  section of the Variable form, select the Show help  check box.
The Help tag, Help text, and Instructions  fields appear.

4. In the Help tag  field, enter the short descriptive text that appears between the question and 
the responses.
For example, Click here for help  or Preview.

5. In the Help text  field, enter the help text that displays for users who clicks the Help tag  on the 
page for the catalog item.
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Note: 
The Help  and Help text  fields do not support HTML tags.

Example of help information

Service Catalog  variable attributes

There are a few Service Catalog  variables support specific attributes to define the behavior and 
restrictions for variables.

In the Catalog variable form, under the Type Specifications  tab, you can specify the variable 
attributes in the Variable attributes  field.

Note: 

• You can enter multiple attributes for a variable type by separating each with a comma.

• You can enter multiple values for an attribute by separating each with a semicolon.

• If you don't see the Variable attributes  field, enable the Show attributes when Type is 
One of Certain Values  UI policy.

• Pre-selected values are not cleared automatically when the dependent variable value 
changes when using an attribute or reference qualifier. Create a client script to clear the 
values based on your needs and the needs of your customer.

Variable attributes

allowed_extensions

Specifies a list of allowed file types. For example, 
allowed_extensions=txt;pdf.

Applicable variables: Attachment

barcode

Specifies if the barcode can be scanned using the mobile camera for identifying a 
variable value of a catalog item. For example, barcode=true.

Applicable variables: Single Line Text

max_file_size

Specifies the maximum file size in MB. For example, max_file_size=2.

Applicable variables: Attachment

glide_list

Changes the list collector interface from slushbucket to glide list.

Applicable variables: List collector
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Collapsed glide_list

Expanded glide_list

is_searchable_choice

If set to true, enables you to search for and select the required value for the 
variable. For example, is_searchable_choice=true.

Note: 

• For Lookup select box, a default value is available at the page load itself.

• This attribute is not applicable in Service Portal.

Applicable variables: Lookup select box, Select box

is_searchable_choice

max_length
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Sets the maximum number of characters allowed in the field. By default, the field 
accepts long strings of text, several thousand characters. Set the max_length 
attribute as appropriate for the information that the variable is collecting. For 
example, to allow for entry of an address, set max_length=200, or other 
appropriate length.

Applicable variables: Single-line text, Wide single-line text

max_unit

Sets the maximum unit of time for the duration. Possible values are 
max_unit=days,max_unit=hours,max_unit=minutes, and 
max_unit=seconds.

For example, if max_unit=minutes, the duration is displayed in minutes 
and seconds. In this case, a duration of 2 days 3 hours 5 minutes 15 seconds is 
displayed as 3065 minutes 15 seconds.

Applicable variables: Duration

no_filter

Hides the filter fields that appear above a list collector.

Applicable variables: List collector

no_filter

ref_ac_columns

Specifies the columns with display values that appear in an auto-completion list 
in addition to the name. Separate column names with a semicolon. For example, 
ref_ac_columns=user_name;email;sys_created_on  allows auto-
complete to match text from the user_name, email, and sys_created_on columns.

Applicable variables: Reference, Requested For.

ref_ac_order_by
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Specifies the column that is used to sort the auto-completion list. For example, 
ref_ac_order_by=name  sorts the auto-completion choices alphabetically by 
name.

Applicable variables: Reference

ref_auto_completer

Specifies the name of a JavaScript class (client-side) that creates the list for auto-
completion choices. Valid class values include:

• AJAXReferenceCompleter: Displays matching auto-complete choices as a drop-
down list. The list only displays the display value column of the reference table. If 
there is no other auto-completion class specified, reference fields automatically 
use this class.

• AJAXTableCompleter: Displays matching auto-complete choices as rows in a 
table. The table displays the display value column of the reference table and any 
columns listed in the ref_ac_columns attribute.

• AJAXReferenceChoice: Displays matching auto-complete choices as a drop-
down list. The list only displays the display value column of the reference table. 
The list only displays up to 25 matching choices. If there are more than 25 auto-
complete choices, the reference field instead displays the choices with the 
AJAXTableCompleter class.

Applicable variables: Reference

ref_qual_elements

A list of fields to be sent back to the server to get an updated reference.

Applicable variables: Lookup multiple choice, Lookup select box, List Collector.

Important: 
Attribute behavior is specific to the service catalog desktop.

Define a question choice for a variable

Define a question choice for a variable with service catalog.

Before you begin
Role required: admin

About this task
Some variable types present the user with a list of choices. For example, a multiple choice 
variable that asks how much memory you want in a computer requires you to define the available 
choices, such as 1 GB and 2 GB.

Procedure

1. Open the variable definition.

2. In the Question Choices  related list, click New.

3. Enter the question choice details in Question Choice  form and click Submit  to save the record.

◦ Price  and Recurring price: variables can affect the item price  and recurring price (if used).

◦ Order: the number defining the order in which the price appears when displayed.

◦ Question: the actual question being asked for that variable.

◦ Text: the choice presented to the user.
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◦ Value: the value stored in the database.

◦ Inactive: Option to make a question choice inactive.

4. Repeat the steps for each available choice to define the full set of choices for that variable.

Note: 
When you modify variable choices that are attached to a catalog item, the existing 
requested items (RITMs) are also affected. For example, if you add a variable choice for 
the catalog item, the value of that choice is also considered in the existing RITMs. If you 
delete a variable choice that is selected for a RITM, the value of that choice still persists 
in the RITM.

Service catalog data lookup

The Data Lookup and Record Matching Support for Service Catalog plugin offers similar features 
to the general Data Lookup and Record Matching Support plugin.

Use the plugin for service catalog to perform data lookups for variables. This lookup can be on 
service catalog item screens, on requested items, and on catalog tasks as a user fills out the 
values contained in variables.

Service Catalog  data lookup roles

Service Catalog  enables specific roles to participate in the process of creating and using Service 
Catalog  data lookups.

Service Catalog  data lookup roles

Role Description

catalog_lookup_admin Similar to data_lookup_admin. Can create, update, and delete 
catalog data lookup definitions, matcher variable definitions, and 
setter variable definitions.

catalog_lookup_manager Can read catalog data lookup definitions, matcher variable 
definitions, and setter variable definitions. The role can be 
granted to anyone using catalog data lookups so they can see the 
definitions for which they are creating rules. As required, grant 
create, read, write, or delete access to the individual data lookup 
rules tables created to delegate maintenance.

Create a catalog lookup definition

Create a catalog data lookup definition record.

Before you begin
Role required: admin or catalog_admin

About this task

Note: 
The Run on Insert  and Run on Update  options are not supported for catalog data lookups. 
Other options operate the same as for normal data lookup.

Procedure

1. Navigate to All  > System Policy  > Rules  > Data Lookup Definitions.

2. Click New.
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3. Select Catalog Data Lookup Rule.

4. Enter a Name.

5. In Applies to, select catalog item or variable set.

6. In Catalog item/Variable set, select a specific item or set.

7. Select a Matcher Table.

8. Select other options, as required.

9. Right-click the form header and click Save.

10. From the Catalog Matcher Variable Definitions  related list, click New.

11. Fill in the fields, as appropriate.

Catalog data lookup definitions fields

Field Description

Name Enter a unique name to identify the definition record.

Applies to Select what the data lookup rule applies to: a catalog item or a variable set.

Catalog 
item/
Variable 
Set

Select the catalog item or variable set to which the data lookup rule applies.

Matcher 
Table Any table within the current scope containing the lookup values.

Note: 
The list shows only tables and database views that are in the same scope 
as the catalog data lookup definition.

Active Select this check box to run this catalog data lookup rule. Clear the check box to 
ignore this catalog data lookup rule.

Run on 
form 
change

Select this check box to automatically look up values whenever a user changes a 
variable value on a catalog item or form. This option is the only supported method 
for catalog data lookup rules.

Note: 
This option does not include changes automatically made by other data 
lookup rules, such as the priority lookup rules.

12. Click Submit.

13. From the Catalog Setter Variable Definitions  related list, click New.

14. Fill in the fields as appropriate.

Setter variable definition fields

Field Description

Data 
Lookup

Displays the name of the parent data lookup definitions record.
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Field Description

Source 
variable 
field

Select the variable from the source item or variable set that the data lookup 
updates.

Matcher 
table field

Select the field from the matcher table that provides the new value for the update.

Always 
replace

Select this check box to replace any existing value with a value from the data 
lookup. Clear this check box to ignore the update if the field has an existing value.

15. Click Submit.

16. Click Update.

Add a data lookup value

The columns of a data lookup table contain both matcher and setter field data. Each data lookup 
is a query that searches for a row containing values that match the matcher fields.

Before you begin
Role required: catalog_lookup_admin

About this task
The data lookup then returns the value listed in the setter fields.

For example, you can define the matching settings for bronze, silver, and gold offerings as 
described previously.

Procedure

1. In the navigation filter, enter the name of the new custom lookup table.

2. Configure the list and create appropriate fields for the lookup table.

3. From the table list, click New  and enter appropriate matcher and setter field values.
For example:

Service Catalog  lookup 1

Note: 
Each row in a data lookup table must be unique.

Custom data lookup

You can create a custom table to store lookup data.

The custom table must extend the Data Lookup Matcher Rules [dl_matcher] table.
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For example, you can create a Server Offering Lookups table. It stores information about matcher 
offerings (bronze, silver, and gold) and associated setter values (memory and disk space) for 
each matcher offering.

Create a custom data lookup

Creating a catalog data lookup is similar to creating a normal, custom data lookup except when 
creating the catalog data lookup definition record.

1. Create a custom data lookup table. It must extend the Data Lookup Matcher Rules 
[dl_matcher]  table.

2. Add data lookup values to the data lookup table.

3. Create a catalog data lookup definition record.

4. (Optional) Create a data lookup module.

Troubleshooting

If the custom data lookup definition rules are not behaving as expected, check for certain 
conditions.

If the custom data lookup definition rules are not behaving as expected, check for the following 
conditions:

• Ensure that the matcher variable is not read-only. Since users cannot change read-only 
variables, there cannot be an on form change event for read-only variables.

• Ensure that the data in the matcher table is correct.

• If the lookup requires an exact match, verify that there is a matcher table row for each possible 
combination (including blank values). The lookup fails if it cannot find a matching value.

• If the variable is an option or check box, it always has a value, so you must select Always 
replace.

• Verify that you have not created a recursive rule, such as:

If Variable A = 1, then Variable B =2. If Variable B = 2, then Variable A = 2.

Audit service catalog variables

Audit the variables so that the audit history records all changes to the named variables.

Before you begin
Role required: admin

About this task
Auditing is enabled by default for service catalog variables.

These changes are displayed in:

• The requested item history for all variables associated with the item.

• The catalog task history for all variables that are used by the task.

This auditing allows service catalog administrators to view a full history of changes to variables 
that can affect the parent record, including their creation.

Note: 
Unnamed variables are not audited.
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Procedure

1. Navigate to All  > System Properties  > Service Catalog.

2. Locate the line Audit changes to Service Catalog Variables.

3. Select the Yes  check box to enable auditing.

Service Catalog variable editors

Variable editor displays variable values in fulfiller forms. A requester, while requesting the item, 
specifies these variable values in the catalog item questions.

Types of variable editors based on the catalog item type:

• For a catalog item, the VEditor (com.glideapp.servicecatalog.VEditor) displays 
the values of questions in the requested item and catalog task forms.

• For a record producer, the default variable editor 
(com.glideapp.questionset.DefaultQuestionEditor) displays the values of 
questions for records generated from a record producer for task-extended tables.

Warning: 
The variable editor depends on the Variables  column of the Task [task] table. By default, 
this column is inactive, and you should not make it active.

VEditor

The VEditor is applicable only for the requests created from catalog items.

In ServiceNow AI Platform, this editor is a formatter added on the requested item (RITM) form 
(Default View) and the catalog task form (Default View).

The VEditor is applicable only for RITMs and catalog tasks. It cannot be used for any other tables. 
To support catalog UI policies or catalog client scripts on the VEditor for the RITM and catalog 
task form, select the Applies on Requested Items  and Applies on Catalog Tasks  check boxes 
for the catalog UI policy or the catalog client script.

Note: 
The values in the VEditor are displayed from the Options [sc_item_option] table. This is an 
internal table and you should not add any business rules to this table.

To make the VEditor read-only in ServiceNow AI Platform, activate the onLoad client script, 
Variable Editor Readonly, for the following tables:

• Requested Item [sc_req_item]

• Catalog Task [sc_task]

Note: 
You can make the Variable Editor Readonly  scripts conditional, by adding 
conditions to them.
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VEditor

Default variable editor

The default variable editor is applicable only for record producers. This editor is a formatter 
added on records that are generated by a record producer for task-extended tables. This editor 
displays the values of questions specified in the record producer.

By default, this editor is applicable for the Incident and Change tables. For other tables, you can 
configure this editor.

Catalog UI policies, catalog client scripts, catalog data lookups, reference qualifiers, and 
dependent reference fields are supported on the default variable editor only for task-extended 
tables. To support a catalog UI policy or a catalog client script on this editor, select the Applies 
on the Target Record  check box for the catalog UI policy or the catalog client script.

Note: 
The values in the default variable editor are displayed in the Question Answer 
[question_answer] table. This is an internal table and you should not add any business 
rules to this table.

Default variable editor

Variable editor in Agent Workspace

In Agent Workspace, the following scenarios are possible:

• If the variable editor formatter is available in the Workspace view of the form, the variable 
editor is automatically added to the Variables  section in the Agent Workspace  UI.

• If the variable editor formatter is added inside a section in the Workspace view of the form, that 
section does not display the variable editor in the Agent Workspace  UI.

The following variable types are not displayed in the variable editor.

• Macro

• Macro With Label

• UI Pages
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The following variables are displayed as a select box in the variable editor:

• Multiple Choice

• Numeric Scale

• Lookup Multiple Choice

Variable editor in Service Portal

In the Service Portal  UI, the variable editor is available for forms with the variable editor formatter.

Note: 
Since Service Portal  is only for requester use cases, it is recommended to use the Agent 
Workspace  UI for the variable editor.

Making a variable editor read-only

The following options are available to make a variable editor read only, depending on application.

Service Catalog  variable editors in the core UI

The GlideForm  setVariablesReadOnly()  method is supported for ServiceNow AI 
Platform  and Agent Workspace  forms to make the variable editor read-only. This 
method is intended for requested item, target record, and catalog tasks.

Note: 
This method is not applicable in Service Portal  and is not recommended for 
catalog forms.

Service Portal  variable editors

To make the VEditor read-only in Service Portal, navigate to Service Portal  > 
Portals, select Service Portal, and specify the following code in the Quick start 
config  field.

"readonly_variable_editor": "true"

Note: 
The UI Page, Macro, and Macro with Label variables are rendered even when 
the variable editor is read-only.

Configure the default variable editor for a task-extended table

After you configure the default variable editor for a task-extended table, you can view and edit 
the values of questions specified by the requester in the record producer. Applicable only for 
records generated by a record producer.

Before you begin
Role required: admin

Procedure

1. Create a formatter for the task-extended table.

a. Navigate to System UI  > Formatters.

b. Click New.

c. On the form, fill the fields.
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Field Description

Name The name of the formatter that is displayed in the form of the task-extended 
table.

Formatter The file name of the formatter. In this case, specify 
com_glideapp_questionset_default_question_editor.

Table The table that uses the formatter.

Active Specifies if the formatter is active.

Type The type of the formatter. In this case, specify Formatter.

UI formatter

d. Click Submit.

2. Add the formatter to the form of the task-extended table.
The formatter is displayed on the form according to your selections.

a. From the Additional Actions   menu on the form, select Configure  > Form Layout.

b. Use the list to select the display order for the formatter field.
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Add a formatter to a form

c. Click Save.
The default variable editor is available on the form.

Default variable editor

Service catalog variable sets

Administrators and catalog administrators often define multiple catalog items that use the same 
group of service catalog variables. Catalog managers and catalog editors can attach a variable 
set for items to which they are assigned. However, catalog managers and catalog editors cannot 
create a variable set.

For example, a catalog administrator defines 10 catalog items for types of servers. The request 
process for all these items asks the same five questions, using the same variables.

Associating these variables individually per catalog item is repetitive, time-consuming, and error-
prone. Also, to make a single change to multiple catalog items involves manually changing each 
item. For example, to add a variable to 10 catalog items, you would need to manually associate 
the variable with each item.

Variable sets allow you to create a collection of variables that can be reused across multiple 
catalog items and order guides. Using variable sets saves time because you do not have to 
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create the same variables individually for many catalog items. Also, when variables should be 
modified, you can modify the variable set and the changes are reflected across all the catalog 
items that are associated with the variable set.

Variable sets also allow you to define catalog client scripts and UI policies that are applicable to 
the variables in the set.

Note: 
Variables in a set use the same rules as other variables to determine when the variables in 
a set appear on a task. For example, variables must either be global or be attached directly 
to an item.

A catalog administrator can provide read, write, and update roles to access a variable set. When 
you access variables of a variable set, a validation is first done at the variable set level, and then 
at the variable level. If the access is blocked at the variable set level, then the access settings on 
the variable are over-ridden. If the access is allowed at the variable set level, then access at the 
variable level is verified.

Note: 
Both single-row and multi-row variable sets are supported in ServiceNow AI Platform, 
Service Portal, Now Mobile, and in the Variable editor in Agent Workspace.

Single-row variable set

Use a single-row variable set to capture data from variables that are grouped together, while 
submitting a catalog item request for a single entity.

Multi-row variable set

Use a multi-row variable set (MRVS) to capture variable data in a grid layout while submitting 
a catalog item request for a group of entities. For example, for HR during the reorganization of 
employees, a single record producer should be able to capture the relevant information such 
as the department and manager for a group of employees. Also, when you request a catalog 
item to order virtual machines and servers, configuration options should be captured as a 
single request. In this case, a requester can define multiple hardware units as rows and their 
configuration options as columns of an MRVS.

You cannot include the following variable types in an MRVS:

• Attachment

• Break

• Container End

• Container Start

• Container Split

• HTML

• Label

• Macro

• Macro with label

• Rich Text Label

• UI Page
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Note: 

• You can configure an MRVS variable to disallow duplicate values. For information about 
the Unique  field, see Create a service catalog variable.

• You can hide a variable in the MRVS so that it does not appear when the dialog box is 
open.

• The Map to field  functionality is not supported for variables used in an MRVS.

• Only the glide list interface is supported for the List Collector variable.

• Cascading functionality for variables in an order guide is not supported in an MRVS.

• An MRVS is not displayed when added within a container.

• You cannot add variables with read roles in an MRVS.

• When you clone a request that contains an MRVS, the information that is specified in the 
MRVS is available in all cloned requests. All UI policies and client scripts on the MRVS are 
also cloned.

• Set a limit to the number of rows that you can add to an MRVS by using the max_rows 
attribute in the Variable Set attributes  field.

• In the RITM and request view in Now Mobile, an MRVS is not supported. A message is 
displayed in this view that this variable set is not viewable.

• An MRVS is supported in the variable summarizer only in Service Portal.

• You can include an MRVS in the GetCatalogVariables and CreateCatalogTask actions 
using Flow Designer.

• You can iterate through individual rows and access variables using the For Each flow 
logic.

• You can include MRVS while creating a catalog task using a workflow.

An MRVS form changes dynamically based on the data in the catalog item form that includes the 
following:

• Other rows of that MRVS

• Other variables outside of that MRVS on the catalog item form.

For information about accessing data in a multi-row variable set (MRVS) when a dialog box is 
open, see g_service_catalog - Client .

You can define catalog client scripts, catalog UI policies, and catalog data lookups for an MRVS. 
Visibility is honored just on the MRVS form and not in the list.

Note: 

• onSubmit  catalog client scripts are not supported for an MRVS.

• Catalog UI policies and catalog client scripts defined at the item level are not applicable 
for variables in an MRVS. Only those catalog UI policies and catalog client scripts defined 
within the MRVS are applicable for variables in the MRVS.

• Scripts that are not included in an MRVS cannot affect variables inside the MRVS. 
Similarly, the scripts included in the MRVS cannot affect the variables that are not 
included in the MRVS.

• Variables that are not included in an MRVS cannot be used in dependent reference 
qualifiers for variables in the MRVS. Similarly, the variables included in the MRVS cannot 
be used in dependent reference qualifiers for variables that are not in the MRVS. For a 
reference qualifier, the current row is the one that is being edited.
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You cannot set Global  as True  for any variable that belongs to an MRVS. So, an MRVS is not 
available in catalog tasks.

If the variables included in the MRVS have price implications for a catalog item, the price of the 
catalog item reflects the corresponding changes when a row is added, edited, or removed from 
this variable set.

Note: 
When you disable the glide.sc.use_cart_layouts  property, the Order Item Widget 
does not reflect the price changes of the item from the MRVS. However, when you add this 
item to the cart, these price changes are reflected.

You cannot select variables of an MRVS when defining the following for a catalog item:

• UI policy conditions

• Unsupported ATF step configurations. You can only validate if an MRVS is visible, mandatory, 
or read only.

• Reporting

Create a variable set and add it to an item

Create a set of variables and add them to multiple catalog items and order guides for reuse.

Before you begin
Role required: catalog_admin, admin, catalog_editor, or catalog_manager

About this task

• Variable sets within a catalog item cannot have the same internal name.

• Within a catalog item, the name of a variable cannot be the same as the title or internal name 
of a variable set.

• Any catalog client script or catalog UI policy script should refer to the internal name of a 
variable set instead of its name or title.

Procedure

1. Navigate to All  > Service Catalog  > Catalog Variables  > Variable Sets.

2. Click New.
The Variable Set Creation page is displayed.

3. Select any of the following.

4. Enter details.

Field Description

Title Title of a variable set. Appears if the Display title  check box is selected.

Internal 
name

Variable set name for internal use. For example, to access the variable set for 
the front-end (through the g_form  API) and server side scripting.

Order Order number for the variable set.

Type Type of the variable set. Possible choices are:
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Field Description

◦ Single Row

◦ Multi Row

Application Applications that can use this variable set.

Display 
title

If selected, adds a title and an expandable header to the right of the variable 
set.

Note: 
When a user requests the item, all check box  variables are grouped 
under a default title of Options. To use a custom title, insert a variable of 
type Label, with an Order  value that puts it directly above the check box 
variables.

Variable 
Set 
attributes

Attributes for configuring a multi-row variable set. Use the max_rows  attribute 
to set a limit to the number of rows that you can add to a multi-row variable set. 
For example, specify max_rows=1  as the field value.

Layout The layout display. Set to 1 Column Wide  or 2 Columns Wide, alternating sides 
or 2 Columns Wide, one side, then the other.

Description Description of the variable set.

5. Right-click and select Save.

6. Create the variables to use in that set.

a. In the Variables related list, click New.

b. Follow the steps for creating variables.

Note: 
For a multi-row variable set:

▪ The included variables are displayed as columns of a table.

▪ The column order is the order of variables defined in the variable set.

7. To create an associated catalog data lookup rule, perform the following steps.

a. In the Catalog Data Lookup Definitions related list, click New.

b. On the Catalog Data Lookup Definitions form, fill the fields.
For information on creating a data lookup rule, see Create a catalog lookup definition.

8. Click Submit.

Add a variable set to a catalog item or order guide

Service Catalog  enables you to add a variable set to one or more catalog items or order guides.

Before you begin
Role required: catalog_admin, admin, catalog_editor, or catalog_manager
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Procedure

1. Open a catalog item or an order guide.

2. In the Variable Sets  related list, click Edit.

You can configure the form to add the Variable Sets  related list.

3. Select and add a variable set.

Note: 
If the Cascade Variables  check box is selected for an order guide, multi-row variable set 
data should be cascaded to the included items.

4. Click Save.

5. Click Try.

Note: 
For a multi-row variable set:

◦ The associated variables are displayed as columns of a table on a catalog item or 
record producer. Each row corresponds to a set of data for all variables in the variable 
set.

◦ The column order is the order of variables defined in the variable set.

6. Optional:  Edit a multi-row variable set.

a. To add a row, click Add  within the variable set, specify the variable information in the Add 
Row  window, and click Add.

Note: 

▪ A maximum of 50 rows can be added.

▪ Unless default values are provided for variables or On Load scripts are used to pre-
populate data, you should add variable data for each row.

b. To edit a row, click the edit row icon  in the Actions  column, specify the variable 
information in the Edit Row window, and click Save.

Note: 
When you add or edit an existing row, all catalog UI policies and client scripts 
associated with the multi-row variable set should be honored.

c. To remove a row, click the remove row icon in the Actions  column and click Remove  in the 
confirmation window.

d. To remove all rows of the table, Click Remove All  within the variable set and click Remove  in 
the confirmation window.

Variable set layout

Variable sets can have one of many layouts. You can define the order of the variables for each 
item.
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• 1 column wide: Variables appear in a single vertical column, ordered from top to bottom. This 
column is a simple way to display information, but can result in empty space to the right of 
questions. This order is the default layout.

• 2 columns wide, alternating sides: Variables are laid out in two columns with variables placed 
alternately in the left and right columns.

• 2 columns wide, one side, then the other: The first half of the variable set is laid out 
sequentially in the left column and the second half is laid out sequentially in the right column.

Note: 
Variables with several possible choices defined, such as multiple choice  variables, are 
considered a single entity in layouts. All choices are displayed as a single, contiguous unit.

Variable set order

A variable set is a discrete unit with an order number by default. All variables within the set are 
included wherever the set is included.

For example, if you set the following order for some example variables and a variable set:

• Variable A (100)

• Variable B (200)

• Variable C (300)

• Variable Set 1 (250) - containing three variables (VS1, VS2, VS3) with incremental order values 
(150, 250, 350)

The variables are displayed in this order:

• Variable A (100)

• Variable B (200)

• Variable Set 1 (250): Variable VS1 (150)

• Variable Set 1 (250): Variable VS2 (250)

• Variable Set 1 (250): Variable VS3 (350)

• Variable C (300)

Additional layout options

For additional layout options, you can also add container variables  to a variable set.

For example, create the following variables and orders:

Order of variables

Variable Order

Alfa 100

Bravo
200

Charlie
300
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Order of variables  (continued)

Variable Order

Delta
400

Echo
500

Foxtrot
600

Order of variables in a layout

1 Column Wide 2 Columns Wide, alternating sides 2 Columns Wide, 1 side, then the other

Alfa

Bravo

Charlie

Delta

Echo

Foxtrot

Alfa Bravo

Charlie Delta

Echo Foxtrot

Alfa Delta

Bravo Echo

Charlie Foxtrot

Set an item-specific order

You can set the order value on a per item basis.

Before you begin
Role required: admin

About this task
When a variable set is used by more than one catalog item, you can define item-specific 
ordering to provide more flexibility in the layout. You do this using the catalog variable set record 
associated with the item.
Use the Order  field in this catalog variable set record to set this order value on a per-item basis, 
overriding the default value defined in the variable set.

Procedure

1. Navigate to All  > Service Catalog  > Catalog Definition  > Maintain Items.

2. Open the catalog item to edit.

3. Navigate to the Variable Sets related list.

4. Click the reference icon for the variable set.
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Catalog variable set

5. Set the order value as required.
The catalog variable set order is specific to the link between the item and the variable set. It 
overrides the default order defined on the variable set itself.

Variable set order

Examples of variable set orders

The following example demonstrates the layout of variables when variable sets and item 
variables are associated with an item under different scenarios.

The order for display of the variables and variable sets is specified using the Information icon in 
the Related Lists.
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Order of variables and variable sets

• In Layout 1, order values are specified for both Variable Set A and Variable Set B at the Related 
Lists level and those order values always takes precedence. Hence, the layout is organized 
based on the order value specified for the variable sets at the Related Lists level.

• In Layout 2, an order value is not specified for Variable Set A whereas an order value is 
specified for Variable Set B at the Related Lists level. In this case, the empty value for Variable 
Set A is considered as zero. Hence, the layout is organized based on the order value of 0 for 
Variable Set A and 300 for Variable Set B.

• In Layout 3, order values are not specified for both Variable Set A and Variable Set B at 
the Related Lists level. In this case, the order values specified within the variable sets are 
considered. Hence, the layout is organized based on the order value of 400 for Variable Set A 
and 150 for Variable Set B.

Service Catalog parameters

You can use the Service Catalog parameters to identify the parent mapping configuration for a 
request, and join the service catalog flow from any other flow. For example, from an incident flow, 
you can create a request, and associate the request with the incident.

These parameters are passed in the application URL.
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Service Catalog parameters

Name Description

sysparm_parent_sys_id sys_id of the source record that is passed to the target record generated from it.

Format is sysparm_parent_sys_id= <sys_id of the parent>. For example, 
sysparm_parent_sys_id=85071a1347c12200e0ef563dbb9a71c1.

sysparm_parent_table Name of the parent table from which the catalog request is created.

Format is sysparm_parent_table=<name of the parent table>. For example, 
sysparm_parent_table=incident.

sysparm_view Type of the catalog view.

Format is sysparm_view=<name of the catalog view>. For example, 
sysparm_view=catalog_default.

Note: 
This is only applicable in Platform.

sysparm_processing_hint Specifies a processing hint.

Format is  sysparm_processing_hint=setfield:request.parent=<incident sys_id>. 
For example, 
sysparm_processing_hint=setfield:request.parent=85071a1347c12200e0ef563dbb9a71c1.

Note: 
If specified, this parameter overrides the configuration in the Request Parent 
Mapping  sub-module.

Related topics

Create a request from an incident

Catalog Wizard form

Description of the fields for the Catalog Wizard Step, Catalog Wizard Section, Variable, and 
Catalog Wizard Question forms in Service Catalog  wizards.

Catalog Wizard Step

Field Description

Name Unique name of the step.

Wizard Wizard for which you are creating the step.

Hide on template Option to hide the step in the catalog item 
template.

Custom step Option to configure the step as a custom step.

Short description Brief description of the step.

Feedback Option to associate a feedback record with 
the step in the catalog item builder wizard or 
record producer builder wizard.
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Catalog Wizard Step  (continued)

Field Description

Template feedback Option to associate a feedback text with a step 
in the catalog item template.

Order Order where the step is placed in Catalog 
Builder.

Macroponent Reusable seismic building blocks in the Next 
Experience UI Framework  that can be used to 
create a custom step. This field appears only 
when the Custom step  check box is selected.

For more information, see https://
developer.servicenow.com/dev.do !/
reference/now-experience/sandiego/ui-
framework/getting-started/introduction

Catalog Wizard Section

Field Description

Name Unique name of the section.

Style Display style of the section.

Order Order in which the section appears inside a 
step.

Wizard step Step with which the section is associated.

Short description Brief description of the section.

Width Width of the section in Catalog Builder.

Variable

Field Description

Map to 
field

Maps the question to a specific field on the Catalog Item (sc_cat_item) table or 
Record Producer (sc_cat_item_producer) table.

Type The variable type that you want to create.

Catalog 
item

Catalog item associated with the question.

Active Option to make the variable available for use.

Mandatory Option to make the variable mandatory as part of the ordering process.

Hidden Option to hide the variable.

Read-only Option to make the variable read only or editable.

Question Question to ask catalog item creators in Catalog Builder.

Name Name to identify the question.

Tooltip Tooltip text to display when catalog item creators point to the variable in Catalog 
Builder. You can enter a brief note to describe the purpose of the question.
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Variable  (continued)

Field Description

Example 
Text

Hint that is displayed in the Question  field before a catalog item creator enters a 
value. Applicable for the following variables:

• IP Address

• Email

• URL

• Single Line Text

• Wide Single Line Text

• Multi Line Text

• Date

• Date/Time

Catalog Wizard Question

Field Description

Wizard section Section with which the question must be 
associated with.

Map to set Option to map the question to a question set. 
The Set  field is enabled only when this option 
is selected.

Order Order in which the question must appear 
inside a section.

Question Option to associate a question to the section.

Note: 
You can create a new variable to 
associate to a question or select an 
existing one.

For information on creating a new 
variable, see Add a step, section, or 
question to a catalog item wizard.

Set Option to associate a question set to the 
section if you have selected the Map to set 
option.

For information about adding a step, section, or question to a catalog item wizard, see Add a 
step, section, or question to a catalog item wizard.

Record Producer form

Description of the fields on the Record Producer form.
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Record Producers in the Service Catalog

Field Description

Name The descriptive name for the record producer.

Note: 
The list shows only tables and database views that meet the scope 
protections for field styles.

Table name The table in which the record producer creates records.

Active A check box for making the record producer active. Only active record producers 
are available to users if they meet the role criteria.

Preview 
Link

A link that opens a preview of the item.

Post insert 
script

Script that operates on the submitted record, after the record is inserted in the 
associated table.

Note: 
Post insert script overrides the target record values and record producer 
template values.

Accessibility

Catalogs The service catalog this record producer belongs to.

Category The service catalog category this record producer belongs to. When users 
perform catalog searches, only items that are assigned to a category appear in 
search results.

View The CMS view in which the item is visible.

Roles The roles required to use the record producer.

Availability The interface the record producer is available from: Desktop and Classic Mobile, 
Desktop Only, or Classic Mobile Only.

Can cancel A check box for displaying a Cancel  button on the record producer. Users can 
click Cancel  to cancel the record producer and return to the last-viewed screen

What it will contain

Short 
description

A short summary of the record producer.

Description The full description of the record producer.

You can embed videos, images, links to internal knowledge base (KB) articles, and 
links to external sources of information and instruction documentation.

The description appears under a More information  link on the record producer to 
give users any additional information they need.

Meta Comma-separated list of tags used to search for the record producer. See 
Configure keyword search for catalog items.

Hide on 
Service 
Portal

If selected, the record producer is not available on Service Portal.
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Record Producers in the Service Catalog  (continued)

Field Description

Redirect To Specifies the redirect behavior of the record producer after its generation.

Possible values are:

• Generated Task record: Redirects to the task record created using the record 
producer.

• Catalog Homepage: Redirects to the service catalog where the order for the 
record producer is placed.

The default value is based on the Specifies the default behavior of record 
producer after record generation  property in the Service Catalog  > Catalog 
Administration  > Properties  page.

Script Scripts that are run to dynamically assign values to specific fields on the created 
record.

Icon The small icon that appears on the list of service catalog items. Click the Click to 
add  link and upload the photo.

Picture The picture that appears at the top of the record producer form on the desktop 
view. Click the Click to add  link and upload the photo.

Classic 
Mobile 
picture

The small picture that appears on the list of service catalog items. Click the Click 
to add  link and upload the photo.

This field is available when you select the Classic Mobile  for the Classic Mobile 
picture type.

Classic 
Mobile 
picture 
type

The picture that the mobile interface uses on the list of service catalog items. 
Select one of the following:

• Desktop: Uses the icon specified in the Icon  field. Selecting this option hides 
the Classic Mobile picture  field.

• Classic Mobile: Uses the icon specified in the Classic Mobile picture  field.

• None: Does not use any picture on the mobile view. Selecting this option hides 
the Classic Mobile picture  field.

Generated Record Data

Template Static assignments for fields on the created record.

Portal Settings

Hide 
Attachment

If selected, the Add attachments  button is not displayed for the record producer.

Note: 

• Applicable for a catalog item and record producer.

• An order guide inherits this setting from the included catalog item.

Hide 'Save 
as Draft' If selected, the Save as Draft  button isn't displayed for the record producer on the 

portals.
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Record Producers in the Service Catalog  (continued)

Field Description

You can let requesters save a draft of a record producer while requesting it on the 
portals such as Employee Center  and Service Portal, and Now Mobile app. The 
requesters can access the saved drafts from the My Request widget in the Drafts 
tab on the portals and edit the drafts.

Mandatory 
Attachment

If selected, adding an attachment is mandatory for the record producer.

Note: 
Applicable for a catalog item and record producer.

Universal Request Config

This section is available only when the Universal Request plugin (com.snc.universal_request) 
is activated. For information about this configuration, see Service Catalog configuration for 
Universal Request.

UR 
certified/
enabled 
item

Option to specify that a universal request should also be created along with a 
task-based record.

In the universal request, a reference is created to the associated task-based 
record, which becomes the primary task of the universal request.

Requires 
Additional 
Review

Option to automatically select the Needs resolution review  check box on the 
corresponding universal request. For information about the universal request 
fields, see Universal Request form .

The Requires Additional Review  field appears only when the UR certified/
enabled item  check box is selected.

For information about creating record producers, see Create a record producer.

Order guide form

Description of the fields on the Order guide form.

Order guide form

Field Description

Name Order guide name that appears in the catalog.

Active Check box to indicate whether the order guide is active or not.

Category Category heading under which the order guide appears in the catalog.

Two step Check box to enable two step ordering instead of the default three-step ordering, 
omitting the final step. With two step ordering, selecting Check out  submits the 
request immediately, then displays the order confirmation screen. This is not 
applicable for Service Portal.

Icon A 16x16 pixel image to appear as an icon beside the order guide name in the 
catalog. If no image is uploaded, the default icon appears beside this order guide.

To use your own default icon, upload an image, overwriting the image stored in 
images/service_catalog/generic_small.gif.
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Order guide form  (continued)

Field Description

Cascade 
variables

Check box to select whether the variables used cascade, which passes their 
values to the ordered items. If this check box is cleared, variable information 
entered in the order guide is not passed on to ordered items.

Ordered 
Item Link

Link to more information about an ordered item. Select a predefined link item to 
appear on the ordered item screen. Customers can click the link to access more 
information. This is not applicable for Service Portal.

Roles Roles that users must have to access this order guide.

Short 
description

Summary of the order guide purpose.

Description Description that appears on the first page of the order guide. Apply formatting 
with the HTML editor.

Meta Comma-separated list of tags used to search for the order guide. See Configure 
keyword search for catalog items.

Hide on 
Service 
Portal

If selected, the order guide is not available on Service Portal.

Picture [Optional] Image of the item.

Order to 
cart

Check box allowing users to add order guides to their cart, then continue 
shopping rather than checking out immediately. This is not applicable for Service 
Portal.

Note: 
This setting only works when the Two step  check box is also set to true.

Portal Settings

Use these settings to configure the order guide behavior in Service Portal.

Request 
method

Setting that controls the label displayed for the Order Now  button and the order 
submission experience.

• Order:

◦ Button label: Order Now

◦ Confirmation dialog box: Displayed

◦ Delivery information: Editable

Note: 
This is the default setting.

• Request:

◦ Button label: Request

◦ Confirmation dialog box: Displayed

◦ Delivery information: Not displayed.

This setting can be used in scenarios such as a code access request where the 
delivery information is pre-determined.
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Order guide form  (continued)

Field Description

• Submit:

◦ Button label: Submit

◦ Confirmation dialog box: Not displayed

◦ Delivery information: Not displayed

This setting can be used in scenarios such as reset password request where no 
further request information is required.

Hide 'Add 
to Cart'

If selected, the Add to Cart  button is not displayed for the order guide. If the 
Show Add to Cart  instance option of the widget is set to false, then this setting is 
ignored.

This setting is selected by default if the Request method  is Request  or Submit.

For upgrade scenarios, if the No cart  field is selected in Platform, run the 
CatalogPortalSettingsMigration  script include to update this setting 
to the Hide 'Add to Cart'  field in the Portal Settings  tab.

Show 
Include 
Toggle

If selected, a toggle is displayed for each catalog item in the Choose Options 
section in Service Portal. You can click this toggle to include or exclude the 
catalog item from the order guide request.

For zBoot customers, this option is selected by default for existing order guides in 
the demo data and new order guides.

For upgrade customers, this option is selected by default only for new order 
guides.

For information about creating an order guide, see Create an order guide.

Catalog Item form

Description of the fields on the Catalog Item form.

Catalog Item form

Field Description

Name Name to appear in the catalog.

Catalogs Catalogs this item appears in.

Category Category for the item. Categories can only be selected after the Catalogs  field is 
populated.

Catalog searches find only items that are assigned to a category in the Service 
Portal.

For Employee Center, catalog searches find only items that are associated with 
a taxonomy topic. For more information, see Associate a catalog item with a 
taxonomy topic in Employee Center.
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Catalog Item form  (continued)

Field Description

Model Product model to which the item is linked. This field is visible by default only for 
items created by publishing models.

Click the reference icon to view the product model.

Active Check box to make the item active (available to be ordered).

Note: 
Inactive catalog items added to order guides do not appear in the order 
guide. Use Visible On Guide, Visible elsewhere  to hide the item and show 
only in the order guide.

Fulfillment 
automation 
level

Option to specify the level of fulfillment automation for catalog item requests. The 
available options are:

• Unspecified: Automation level of catalog item is not specified.

• Manual: Catalog item is not automated.

• Semi-automated: Catalog item is semi-automated.

• Fully automated: Catalog item is completely automated.

Access 
Type

Option to specify if a request can be submitted for a user who does not have 
access to the catalog item. Possible options are:

• Restricted: The request can only be submitted for users who have access to the 
catalog item.

• Delegated: The request can be submitted even for users who do not have 
access to the catalog item.

By default, this field is set to Restricted. For information about delegated 
request experience, see Delegated request experience.

Note: 
This functionality is only applicable when the catalog item has a Requested 
For variable.

Owner Owner of the catalog item who has edit access to it.

Template Template using which the item is created.

Preview 
Link

Click Preview Item  to preview in a new window how the current item definition 
would look in the catalog.

Ordered 
Item Link

Link to preview, as shown on the ordered item screen.

Hide on 
Service 
Portal

If selected, the catalog item is not available on Service Portal.

Availability Devices to display the item: Desktop and Classic Mobile, Desktop Only, or 
Classic Mobile Only.
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Catalog Item form  (continued)

Field Description

Note: 
Unsupported catalog item types are not displayed on Classic Mobile 
devices, even if Availability  is set to show an item of this type.

Item Details

Short 
Description

Text that appears on the service catalog homepage, search results, and the title 
bar of the order form.

Description Full description of the item. This description appears in the catalog when a user 
selects the item or clicks the associated Preview  link.

You can embed videos, images, links to internal knowledge base (KB) articles, and 
links to external sources of information and instruction documentation.

Meta Comma-separated list of tags used to search for the catalog item. Use commas 
between keywords for better results when searching. The Zing search engine 
removes common words from search queries that do not produce meaningful 
results.

See Configure keyword search for catalog items.

Process Engine

Note: 
You can specify a value for only one of these fields.

Flow Flow that defines how the item request is fulfilled.

Workflow Workflow that defines how the item request is fulfilled.

Execution 
plan

Execution plan (formerly named delivery plan) that defines how the item request 
is fulfilled.

Picture

Icon Image to appear as an icon beside the item name in the catalog. Upload a 
27x27 pixel image. If no image is uploaded, the default icon appears beside 
this item. To use your own default icon, upload an image. The uploaded image 
overwrites the default image stored in images/service_catalog/
generic_small.gif.

Picture Image of the item.

Classic Mobile

Classic 
Mobile 
Picture 
Type

Type of picture to display for the item on mobile devices. Set to Desktop  to use 
the standard desktop picture, Classic Mobile  to use a specific image for the 
mobile device using the Mobile picture  field, or None  to not use a picture.

Classic 
Mobile 
Picture

Image file for the mobile picture. The field appears if Classic Mobile picture type 
is set to Classic Mobile.

Hide Price 
(classic 

Check box to hide the item price on mobile devices. Clear the check box to 
display the price.
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Catalog Item form  (continued)

Field Description

mobile 
listings)

Pricing

Price Price for the item. Select the currency from the choice list.

Recurring 
Price

Price that occurs repeatedly at a regular interval. For example, a printer 
maintenance service could have a $100.00 monthly recurring price.

Recurring 
Price 
Frequency

Time frame for recurrence, such as Monthly  or Annually, only if the Recurring 
Price  field has an entry.

Omit Price 
in Cart

Check box to hide the item price in the cart and the catalog listing.

Portal Settings

Use these settings to configure the catalog item behavior in Service Portal.

Request 
method

Setting that controls the label displayed for the Order Now  button and the order 
submission experience.

• Order:

◦ Button label: Order Now

◦ Confirmation dialog box: Displayed

◦ Delivery information: Editable

Note: 
This is the default setting.

• Request:

◦ Button label: Request

◦ Confirmation dialog box: Displayed

◦ Delivery information: Not displayed.

This setting can be used in scenarios such as a code access request where the 
delivery information is pre-determined.

• Submit:

◦ Button label: Submit

◦ Confirmation dialog box: Not displayed

◦ Delivery information: Not displayed

This setting can be used in scenarios such as reset password request where no 
further request information is required.

Hide 'Add 
to Cart'

If selected, the Add to Cart  button is not displayed for the item. If the Show Add 
to Cart  instance option of the widget is set to false, then this setting is ignored.

This setting is selected by default if the Request method  is Request  or Submit.
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Catalog Item form  (continued)

Field Description

For upgrade scenarios, if the No cart  field is selected in Platform, run the 
CatalogPortalSettingsMigration  script include to update this setting 
to the Hide 'Add to Cart'  field in the Portal Settings  tab.

Note: 
Applicable for a catalog item and order guide.

Hide 'Save 
as draft' If selected, the Save as Draft  button isn't displayed for the item on the portals.

You can let requesters save a draft of a catalog item while requesting it on the 
portals such as Employee Center  and Service Portal, and Now Mobile app. The 
requesters can access the saved drafts from the My Request widget in the Drafts 
tab on the portals and edit the drafts.

Hide 
Quantity

If selected, the Quantity  list is not displayed for the catalog item.

This is selected by default if the Request method  is Request  or Submit.

For upgrade customers, if the No quantity  field is selected in Platform, run the 
CatalogPortalSettingsMigration  migration script to update this setting 
to the Hide Quantity  field in the Portal Settings  tab.

Note: 

• Applicable for a catalog item.

• An order guide inherits this setting from the included catalog item.

Hide 
Delivery 
time

If selected, the Delivery Time  field is not displayed for the catalog item.

This is selected by default if the Request method  is Submit.

Note: 

• Applicable for a catalog item.

• An order guide inherits this setting from the included catalog item.

Hide 'Add 
to Wish 
List'

If selected, the Add to wish list  button is not displayed for the catalog item. If the 
wish list is disabled for the catalog item or the portal widget instance option is set 
to false, then this setting is overridden for the item.

Note: 
Applicable for a catalog item and record producer.

Hide 
Attachment

If selected, the Add attachments  button is not displayed for the catalog item.

Note: 

• Applicable for a catalog item and record producer.

• An order guide inherits this setting from the included catalog item.
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Catalog Item form  (continued)

Field Description

Mandatory 
Attachment

If selected, adding an attachment is mandatory for the catalog item.

Note: 
Applicable for a catalog item and record producer.

Universal Request Config

This section is available only when the Universal Request plugin (com.snc.universal_request) 
is activated. For information about this configuration, see Service Catalog configuration for 
Universal Request.

UR 
certified/
enabled 
item

Option to specify that a universal request should also be created along with a 
requested item.

In the universal request, a reference is created to the associated requested item, 
which becomes the primary task of the universal request.

Requires 
Additional 
Review

Option to automatically select the Needs resolution review  check box on the 
corresponding universal request. For information about the universal request 
fields, see Universal Request form .

The Requires Additional Review  field appears only when the UR certified/
enabled item  check box is selected.

Fields that can be added by configuring the form

Expand 
help for all 
questions

Check box to expand and display help information  for all questions on loading the 
page.

Note: 

• This field is also applicable in Service Portal.

• If the Expand help for all questions  check box is selected at the catalog 
item level, then the Always Expanded  field setting at the variable level is 
overridden.

• If the Expand help for all questions  check box is deselected at the 
catalog item level, then the Always Expanded  field setting at the variable 
level is applicable.

Template Template to populate the generated record with predefined values. The field is 
available for Record Producer  items only.

No 
Quantity

Check box to hide the quantity selector for the item.

No Cart Check box to hide the shopping cart for the item.

No search Check box to prevent this item from being listed in search results and also in the 
Service Catalog widget on the Service Portal.

If this is selected:

• In Service Portal, you can neither browse nor search for the item.

• In Platform, you can browse to find the item.
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Catalog Item form  (continued)

Field Description

Order Controls the ordering of items in category lists.

Domain Domain in which the catalog item is created. Applicable when the domain 
separation is enabled in Service Catalog. For information about domain 
separation, see Domain separation and Service Catalog.

Domain 
Path

Series of three-character codes separated by a slash (/) delimiter to identify a 
domain. This path string is unique in the domain hierarchy. Applicable when the 
domain separation is enabled in Service Catalog.

Related Links

Item 
Diagnostic

Generates a diagnostic  report and score to identify possible issues within the 
Service Catalog  data and configuration.

Edit 
checked 
out item in 
advanced 
view

Allows you to edit the catalog item in the advanced view. To add a catalog client 
script to a checked out item in the Draft state, you can click this related link and 
add the catalog client script using the Catalog Client Scripts related list.

Note: 
This option is available only after you click Edit in Catalog Builder  to edit an 
item in catalog builder.

Related Lists

Variables Variables  for the item to provide options for ordering the item.

Variable 
Sets

Variable Set  linked to the item.

Link an existing variable set to the item to provide multiple options for ordering the 
item.

Approved 
By Group

Groups that must approve requests for this item.

Approved 
By

Users who must approve requests for this item.

Categories Additional categories  associated with this item.

Catalogs Additional catalogs  associated with this item.

Catalog 
Data 
Lookup 
Definitions

Catalog data lookup rules associated with the catalog item. For information on 
creating a data lookup rule, see Create a catalog lookup definition.

Catalog UI 
Policies

Catalog UI policies  associated with this item.

Catalog 
Client 
Scripts

Catalog client scripts  associated with this item.

Related 
Items

Related items for a catalog item to provide alternatives. These items are displayed 
in the catalog item page in Service Portal  and Now Mobile.

Related 
Articles

Related articles for a catalog item to provide additional information. These articles 
are displayed in the catalog item page in Service Portal  and Now Mobile.
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Catalog Item form  (continued)

Field Description

Service 
Fulfillment 
Steps

Associated service fulfillment steps.

Assigned 
Topics

Associate a catalog item to a taxonomy and topic. For information about how to 
add an item to a taxonomy, see Associate a catalog item with a taxonomy topic in 
Employee Center.

Note: 
This field becomes available when you activate the Employee Experience 
Taxonomy plugin (sn_ect).

For information about creating or editing a catalog item, see Create or edit a catalog item.

Debugging Service Catalog

Debug user criteria of catalog items, UI customizations for Service Catalog  pages, actions on 
catalog item variables, performance diagnostics of a catalog item, and so on.

Debug actions on catalog item variables

Analyze the client-side actions affecting the state and values of all variables. You can also get 
insights into the performance of each script working on the variables.

Before you begin
Role required: admin, catalog_admin, catalog_manager, or catalog_editor.

Note: 
You can perform this task with the catalog_manager or catalog_editor role only if you are 
assigned as the manager or editor of the catalog.

About this task
The variable action logger displays the chronology of actions that happen on all variables of 
a catalog item before it is submitted. These actions can happen due to catalog client scripts, 
catalog UI policies, or catalog data lookups. This client-side logger does not store any data in 
the database. Also, the information displayed is applicable only while you work on the catalog 
form.   Features available for debugging Service Catalog issues including UI macro customization 
debugging; variable action logger; variable watcher; item diagnostic report

Procedure

1. Navigate to All  > Service Catalog  > Catalog Administration  > Enable Variable Action Logger.
The UI Page Customization Diagnostics logger is enabled.

Note: 
Perform this step before you run the logger.

2. Navigate to Service Catalog  > Catalog Definitions  > Maintain Items.

3. In the Catalog Items list, select an item that you want to log .

4. On the Catalog Item form, click Try it.

5. On the catalog page for the item, right-click the header and select Show Variable Action 
Logger.
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Note: 
The variable logs are grouped by catalog UI policies, catalog client scripts, and data 
lookups.

The following information is displayed in the Variable Action Logger window:

◦ Order in which scripts and actions are executed. When a new action is triggered from an 
existing action, the order of the new action is tracked at a sublevel under the order of the 
existing action. For example, the order of a new action triggered from step 1.2 is 1.2.1.

◦ Source of the action taken on a variable and the variable name.

◦ Details of the action taken on the variable.

Variable Action Logger window

6. Review the results of the variable action logger.

Option Description

Search
To search for a variable or script, use the 
Search  field.

Collapse All
To collapse variable logs within a group, click 
Collapse All.

Expand All
To expand variable logs within a group, click 
Expand All.

Filter To filter variable logs, click the Filter icon ( ) 
and select the required options.

Clear Logs
To clear variable logs, click the Actions icon 

( ) and select Clear Logs.

Export to CSV
To export the variable logs to a .csv file, click 

the Actions icon ( ) and select Export to 
CSV.

Print Logs
To print variable logs, click the Actions icon 

( ) and select Print Logs.

Debug user criteria of a catalog item

Debug whether a user can access a catalog item based on the matched user criteria and fix any 
issues.
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Before you begin
Role required: catalog_manager, catalog_admin, or admin

About this task
You can only debug access issues based on user criteria, but not based on access control list 
rules (ACLs). For information about user criteria, see Set security for items and categories.

For any scripted user criteria that uses a session api such as gs.getUserID(), the session 
of the logged-in user is used. Edit the behavior of the scripted user criteria using the pre-defined 
user_id  variable in the Script  field of a user criteria. For information about the Script field, see 
Create a user criteria record in Service Catalog.

Procedure

1. Navigate to All  > Service Catalog  > Catalog Administration  > User Criteria Diagnostics.
The User Criteria Diagnostics form is displayed.

2. In the Select user  field, select the user whose access you want to debug.

3. In the Select catalog item  field, select the required catalog item.

4. Click Diagnose.

◦ The item hierarchy is displayed along with an indication of the user's access to each node 
(catalog, category, or catalog item) based on the user criteria associated with the node.

Note: 

▪ If the item is available in multiple catalogs or nested categories, the corresponding 
catalogs and categories are displayed as nodes in a tree format.

▪ If the user matches multiple user criteria associated with the node, then the user can 
access the node only if the following conditions are met:

▪ The user matches at least one of the user criteria in the Available For  list.

▪ The user does not match any user criteria in the Not Available For  list.
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◦ All user criteria defined for the item is displayed. For each user criteria, the following 
information is available:

User Match

 is displayed if the selected user matches the user criteria.

Association

Association of the node with the user criteria, that is, Available for  or Not 
Available for.

User Criteria

Name of the user criteria.

5. To verify if the user can view a node of the hierarchy, click the node.
User criteria defined at the node is displayed. For example, when you click a node representing 
a category, the user criteria defined for the category is displayed.

6. To edit the configuration of a user criteria, click its name under the User Criteria  column.

Debug UI customizations for a Service Catalog  page

Perform the health check of a Service Catalog  page. The UI Page Customization Diagnostics 
window displays the UI macros applicable for the Service Catalog page and their corresponding 
states. For issues on a Service Catalog page due to customized UI macros, you can identify the 
source of broken functionality.

Before you begin
Role required: admin or catalog_admin.
Watch this seven-minute video to learn more about UI customization debugging, variable action 
logger, variable watcher, and the Item Diagnostic report.   Features available for debugging 
Service Catalog issues including UI macro customization debugging; variable action logger; 
variable watcher; item diagnostic report

Procedure

1. Navigate to All  > Service Catalog  > Catalog Administration  > Debug UI Customization.
The UI Page Customization Diagnostics window is enabled.

2. Navigate to a Service Catalog  page that you want to debug.

3. Review the information in the UI Page Customization Diagnostics window at the bottom of the 
page.

To maximize the UI Page Customization Diagnostics window, click . The following 
information is displayed:

◦ Name of the current Service Catalog  page.

◦ State of the Service Catalog  page.

◦ All UI macros applicable for the Service Catalog  page.

◦ State of each UI macro. For details on possible states, click the Help icon ( ).

◦ Number of occurrences of each UI macro in the Service Catalog  page.
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Possible states for a UI macro and a Service Catalog  page

State
Color 
indicator

Description

Unchanged Green Created by ServiceNow  and one of the following scenarios is 
applicable:

◦ It has never been customized by the customer.

◦ It has been customized by the customer and then reverted to the 
latest ServiceNow  upgrade.

Skipped Red Created by ServiceNow  and then customized by the customer, and 
hence skipped the latest ServiceNow  upgrade. The customer should 
resolve a skipped update  after an upgrade.

Customized Orange Created by ServiceNow, and then customized by the customer 
after the latest ServiceNow  upgrade. The customer can revert a 
customization  to implement the latest ServiceNow  upgrade.

New Blue Created by the customer. The top element of the UI macro should 
have the following attribute:

data-sn-macro-sys-id="${jvar_macro_sys_id}"

Note: 
The top element can be a div, span, or table.

Note: 

◦ When you click the Service Catalog  page name or the UI macro name, the 
corresponding UI page or the macro page is displayed.

◦ When you point to a macro in the UI Page Customization Diagnostics window, the 
corresponding UI elements are displayed with a pink border.

◦ The state-based color indication is applicable only for UI macros that have a visible UI.
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UI Page Customization Diagnostics window

4. To minimize the UI Page Customization Diagnostics window, click .

Related topics

UI macros

Upgrade History module: Track every upgrade

Debug performance diagnostics of a catalog item

Analyze the impact of the variable setup in a catalog item on its runtime performance, and 
identify any issues. You can review the processing time of the catalog item and its variables 
based on the triggered SQL queries.

Before you begin
Role required: admin or catalog_admin

About this task
The variable SQL debugger is not applicable for the following variables:

• Container Start

• Container End

• Container Split

• Break
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Procedure

1. Enable the variable SQL debugger by navigating to Service Catalog  > Catalog Variables  > 
Enable Variable SQL Debugger.

Note: 

◦ The variable SQL debugger is applicable for catalog items and record producers.

◦ After you enable the variable SQL debugger, if you disable the display of the 
troubleshooting information on a catalog page by navigating to System Diagnostics  > 
Session Debug  > Disable All, the variable SQL debugger is still active.

◦ To disable the variable SQL debugger, navigate to Service Catalog  > Catalog Variables 
> Disable Variable SQL Debugger.

2. Navigate to Service Catalog  > Catalog Definitions  > Maintain Items, select a catalog item that 
you want to debug, and click Try It.

3. Click the more options icon ( ) and select Show Variable SQL Debugger.
The following information is displayed in the Variable SQL Debugger window:

◦ Number of variables included in the catalog item.

◦ Number of SQL queries triggered for the catalog item.

◦ Time taken to process and load the catalog item page.

◦ Time taken to run all SQL queries of the catalog item.

Variable SQL debugger fields

Field Description

Variable Catalog item variable for which the performance diagnostics are displayed.

Processing Time Time taken to process and load the variable.

SQL Count Number of SQL queries triggered for the variable.

SQL Time Time taken to run SQL queries for the variable.

SQLs Details of the SQL queries triggered for the variable.

4. To sort by any field, click the field name.

Note: 

◦ By default, variables are sorted in descending order by their processing time.

◦ Variables within a single-row or multi-row variable set are displayed in hierarchical 
order.

5. To view the configuration of a variable, click the variable name.

6. To view a detailed summary of all SQL queries triggered for a variable, click View Details  in the 
SQLs  field of the variable.

7. To change the sort order, Use the Sort By  list.

Note: 
By default, triggered SQLs are sorted in descending order by their execution order.
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Debug a Service Catalog  variable

Monitor changes in the state and the value of a Service Catalog  variable due to catalog client 
scripts, catalog UI policies, and catalog data lookups. You can diagnose and resolve issues 
related to such changes, and track client-side scripting errors on this tab.

Before you begin
Role required: admin or catalog_admin   Features available for debugging Service Catalog issues 
including UI macro customization debugging; variable action logger; variable watcher; item 
diagnostic report

Procedure

1. Enable the JavaScript log and field watcher..

a. In the banner, click the settings icon ( ).

b. In the System Settings window, click the Developer  tab.

c. Enable the JavaScript Log and Field Watcher  option.
The JavaScript Log  and Field Watcher  tabs are displayed in a pane at the bottom of the 
page. For information about JavaScript logs and fields watcher, see JavaScript log  and 
Field Watcher  .

d. Close the System Settings window.

2. Navigate to Service Catalog  > Catalog Definitions  > Maintain Items.

3. In the Catalog Items list, select a catalog item to debug its variables, and click Try it.

4. On the form, right-click a variable field label and select Watch Variable.

The debug icon ( ) is displayed next to the variable, and the Field Watcher  tab in the bottom 
pane is replaced with the Variable Watcher  tab.

5. Edit the fields on the Variable Watcher  tab.

Field Description

Item Current catalog item.

Variable Variable that is being watched.

Type Type  of the variable.

Create 
roles

User type that can create values for the variable.

Write roles User type that can edit values for the variable.

Read roles User type that can read values for the variable.

Reference Reference table for the variable. Applicable for reference variables.

Reference 
Qual

Qualifiers to restrict data that is available in the field. Applicable for list collector, 
lookup multiple choice, lookup select box, and reference variables.

Attributes Attributes of the variable.
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Field Description

Delete 
roles

User type that can delete values for the variable.

All If selected, displays the action log of the variable due to catalog client scripts, 
data lookups, and catalog UI policies.

Catalog 
Client 
Script

If selected, displays the action log of the variable due to catalog client scripts.

Data 
lookup

If selected, displays the action log of the variable due to data lookups.

Catalog UI 
Policy

If selected, displays the action log of the variable due to catalog UI policies.

Variable Watcher tab

6. To watch another variable, right-click that variable and select Watch Variable.

Note: 
You can watch only one variable at a time.

7. To stop watching a variable, right-click the variable and select Unwatch Variable.

8. To clear the logs, click the Clear log icon (  ).

9. To resize the pane, click Small, Medium, or Large.

10. To close the pane, click the Close icon (  ).
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Item diagnostic report

For a catalog item data and configuration, you can identify possible violations from the 
ServiceNow  recommended practices.

The item diagnostic report includes a score that measures the health of the item, and a list of 
diagnostic result entries. These entries consist of a rule, a document (record that violates the 
rule), and a count (the number of violations in the record).

Correct violations for best performance and to maintain expected behavior.

The lower the score, the better (0 is ideal). A higher score means that an item 
has more violations from the ServiceNow  recommended practices. Each rule has 
a different weight and level of importance. For example, a violation of duplicate 
variables is more likely to result in user issues. An AJAX usage violation is 
less likely to cause issues since the result could simply cause a delay in the 

UI.

Default diagnostic rules

These diagnostic rules are designed as per ServiceNow  recommended practices.

Default diagnostic rules

Rule Description

checkUserCriteriaUsage Identifies if the item is using entitlements 
instead of user criteria
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Default diagnostic rules  (continued)

Rule Description

checkBalancedContainers Checks if the Container Start and Container 
End variables are balanced.

checkDuplicateVariables Identifies variables with the same name 
associated to a catalog item (or an associated 
variable set).

checkDOMManipulation Identifies any DOM violation in catalog client 
scripts. The DOM is not guaranteed to be the 
same between releases and can affect catalog 
client scripts during upgrades. Therefore, it 
is not recommended for customers to do any 
kind of DOM manipulation.

You can view detailed information for each 
client script by clicking the information icon.

checkLookupVariableRowCount Checks if the Lookup variable is run on tables 
with many records as it can lead to slower load 
times.

checkAJAX Identifies all AJAX calls in catalog client 
scripts because, although AJAX calls in 
catalog client scripts are allowed, they must 
be asynchronous. All AJAX calls are listed 
because even asynchronous calls can cause 
some delay.

You can view detailed information for each 
client script by clicking the information icon.

checkSelectBoxUnique Identifies Select Box type variables that have 
the attribute enabled to show only unique 
entries in the select box.

checkOrderGuideRuleBaseCount Checks for high number of active rule bases in 
an order guide as higher number of rule bases 
can lead to slower load times

checkFormatterVariablesUsage Checks if the item has the following variable 
types:

• Macro

• Macro with label

• UI Page

For information on the variable availability 
across various channels, see Variable support 
in various channels.
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Run the Item Diagnostic Results report

Identify the catalog items that are not designed per ServiceNow  recommended practices to run 
your catalog efficiently.

Before you begin
Role required: admin or catalog_admin

About this task
This report runs every weekend on all catalog items of all types.

Procedure

1. Navigate to All  > Service Catalog  > Catalog Administration  > Request Reports.

2. Select the [Catalog] Item Diagnostics Results report.
A report is displayed with all active catalog items with a non-zero score. These catalog items 
are grouped by score and each score has a different color.

3. Click the score to diagnose the associated catalog items.

Note: 

◦ Any item with a score greater than zero indicates a recommended practice rule 
violation.

◦ The higher the score, the more is the catalog item deviating from ServiceNow 
recommended practices.

4. Click the score of the required catalog item.
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Diagnostic results are displayed for the catalog item with violated rules. For information on 
default diagnostic rules per ServiceNow  recommended practices, see Item diagnostic report.

5. To understand details of each violated rule, click the Count  value for that rule.

Service catalog UI policy

UI policies can be used to define custom process flows for tasks.

Catalog UI policies control the behavior of catalog item forms when presented to your users. 
Catalog UI policies can be applied to a catalog item or a variable set.

UI policies  are useful when applied to service catalog items. Keep the following points in mind 
when creating service catalog UI policies:

• A catalog UI policy applies to either a specific catalog item or any item that uses a specific 
variable set.

• A catalog UI policy can only contain and reference variables that are defined for the catalog 
item or variable set.

• Like UI policy conditions, the variables in a service catalog UI policy condition must be visible 
(even if hidden by UI policy or read-only) on the form for the condition to be tested. Also, 
ensure that the variables have names. For more information, see Create a catalog client 
script .

• Limited UI policy functionality applies to following variables:

◦ The Mandatory and Read Only policy do not apply to the following variable types: Break, 
Container Split, Container End, UI Macro, UI Macro with Label, Label, UI Page.

◦ The Set visible policy does not apply to the following variable types: Break, Container Split, 
Container End.

• Service catalog UI policies are applied to variables and variable sets of catalog items ordered 
in the service catalog. Policies can also be applied when the variables are present in a 
Requested Item or Catalog Task form.

Note: 
The Clear the variable value  UI policy action is not applicable on variable sets and 
containers.

• Catalog UI policy actions can be applied on a variable set. The actions on a variable set are 
applied on all variables within the variable set. If different catalog UI policy actions are applied 
on a variable or a variable set, the action with the lowest order is considered.

• The priority order for UI actions types is:

1. Mandatory (highest)

2. ReadOnly/Display

If a variable is set to mandatory and does not have value, readonly or hide do not work on 
that variable. If a variable is hidden or readonly, and then set to mandatory, the variable field 
becomes visible or editable.

This priority order is also applicable for variable sets and containers. If a variable set or 
container has a mandatory variable without any value, then the container or variable set 
cannot be hidden.
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• Catalog UI policies are supported for catalog items viewed in a service catalog wizard.

Note: 
The UI policy for catalog items always takes precedence over UI 
policy for variable sets. You can change this behavior by editing the 
glide.sc.ui_policy.variable_set_run_first  property.

Create a UI policy for catalog items

You can apply UI policies for catalog items ordered in the service catalog.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Service Catalog  > Catalog Administration  > Catalog UI Policies.

2. Select New.

3. In the Applies to  field, select A Catalog Item.

4. Fill in the remaining fields.

Field Description

Applies to Select the type of item this UI policy applies to:

◦ A Catalog Item: enables the Catalog item  field.

◦ A Variable Set: enables the Variable set  field.

Catalog 
Item or 
Variable 
Set

Select the catalog item or a variable set this UI policy applies to. The field name 
and options available depend on the Applies toselection.

Short 
description

Enter a brief description (example, Out-of-state move).

Active Select the check box to enable the UI policy. Clear the check box to disable it.

When to Apply

Catalog 
Conditions

Create conditions for the UI policy using catalog item variables. The policy is 
applied if the conditions evaluate to be true. For example, a catalog item of 
Schedule a Move  may have a condition of move_from > is > San Diego. The UI 
policy is applied when an employee schedules a move from San Diego to any 
other company location.

Note: 
The label of a variable associated with a variable set reflects the variable 
set name. The format is variable_set_name » variable_name.

Applies on 
a Catalog 
Item view

Select the check box to apply the UI policy to catalog items within the order 
screen. Available in the requester view.

Applies on 
Catalog 
Tasks

Select the check box to apply the UI policy on a Catalog Task form. Available in 
the fulfiller view. See VEditor.
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Field Description

Applies on 
Requested 
Items

Select the check box to apply the UI policy on a Requested Item form. Available 
in the fulfiller view. See VEditor.

Applies on 
the Target 
Record

Select the check box to support the catalog UI policy on a record created for 
task-extended tables via record producers. See Default variable editor.

On load Select the check box to apply the UI policy when the form is loaded. Clear the 
check box to apply the policy only when the form is changed.

Reverse if 
false

Select the check box to reverse the UI policy if the Catalog Conditions 
statement evaluates to false.

Script

Run scripts Select the check box to use the Execute if true  and Execute if false  scripting 
fields. Scripts are necessary to apply a UI policy other than Read Only, 
Mandatory, or Visible. For example, you must create a script to apply a UI policy 
to a specific role.

Other fields

Order Enter the sequence in which this UI policy is evaluated if more than one 
matching UI policy exists. The order is evaluated from the lowest value to the 
highest value.

Global This field isn’t used for the service catalog.

Inherit This field isn’t used for the service catalog.

Catalog UI Policy Actions

Variable 
name

Select the variable or variable set that belongs to the catalog item.

When you apply catalog UI policy actions on a variable set, the actions are 
applied on all variables within the variable set. If different catalog UI policy 
actions are applied on a variable or a variable set, the action with the lowest 
order is considered.

Note: 

◦ The set value UI policy action isn't applicable for the attachment and 
masked variables.

Use the Clear the variable value  option to clear the value for the 
attachment and masked variables.

◦ For multi-row variable set, you can apply a UI policy action on the 
complete variable set but not on individual variables inside it.

◦ The label of variables associated with a variable set reflects the 
variable set name. The format is variable_set_name » 
variable_name.

Order Sequence in which the UI policy action is evaluated. The order is evaluated from 
the lowest value to the highest value. This is also applicable in Service Portal.

Mandatory Choice list for specifying how the UI policy affects the mandatory state of the 
field. Choices are:
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Field Description

◦ Leave alone

◦ True

◦ False

Visible Choice list for specifying how the UI policy affects the visible state of the field. 
Choices are:

◦ Leave alone

◦ True

◦ False

Read Only Choice list for specifying how the UI policy affects the read-only state of the 
field. Choices are:

◦ Leave alone

◦ True

◦ False

Value 
action

Choice list for specifying whether to set a value for the question, clear the value, 
or set nothing for the question. Here are the choices.

◦ Leave alone

◦ Set value: Option to set a value for the question in the catalog item.

◦ Clear value: Option to clear the variable value.

Value
Enter a value for the question.

This field appears only when you select Set value  from the Value action list.

Field 
message 
type

Select any of the message types that you want to show for the question.

◦ Info

◦ Warning

◦ Error

Note: 
If you don’t want any message, select None.

Field 
message Enter a message that you want to show for the question when a specified 

condition is met.

This field appears only when you select a value from the Field message type list.

5. Select Submit.

Note: 
Configure the variable form to display all fields.

Service Catalog  UI policy examples

The following is an example of how Service Catalog  UI policies work.
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The following UI policy makes it mandatory for any department to specify the name of the 
department if Department  is selected for the question Department or group?.

Catalog UI policy

Catalog Builder

You can create or edit a catalog item (catalog item or record producer) using a visual and guided 
experience along with specified restrictions. The catalog builder experience enables you to 
delegate the creation and maintenance of the catalog.

You can also create a template that can be used to create catalog items. While creating the 
template, you can specify values or restrictions for items created using the template, for example, 
restrictions to catalogs, categories, variable types, and portal settings.

From the home page of the catalog builder, you can do the following:

• Create a catalog item

• Create a catalog item template

• View the available catalog items

• View the available catalog item templates

• View catalog items that are recently updated

• View the configured content that describes the catalog building process in your organization
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How does the catalog builder work

Catalog administrator creates templates for a business or service group. The business owner or 
service owner gathers catalog requirements and creates catalog items from these templates. All 
advanced capabilities are added by catalog administrators or developers.

Catalog builder overview

Catalog item creation process

Catalog item states

A catalog item goes through various states during the item creation and maintenance process.

Catalog item states

State Description

Draft A catalog item is in the Draft state in one of these scenarios:

• A new item is being created in catalog builder.

• An existing published item has been checked out for editing in catalog builder. 
When the item is being edited, catalog builder checks out the item and creates a 
copy of the item and its associated records(variables, UI policies, client scripts). 
The item copy is in the Draft state. The published item remains in the Published 
state and the Checked out  field is set to True. Once the editing is done and 
the item is submitted, the edits to the draft item are merged with the associated 
published item and the draft item is deleted.
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Catalog item states  (continued)

State Description

Note: 

• You can only edit a draft item but not a published item that has been 
checked out.

• A draft item is always inactive and does not show up in the search or 
browse experience.

• You cannot modify the Active  flag of a draft item.

• Any changes to the draft item are not available until it is submitted.

Publishing A catalog item is in this transient state for a while just after its submission and 
before its state changes to Published. You cannot check out an item in the 
Publishing state.

Published When a new item is submitted, the item finally moves to the Published state. 
This state indicates that it is the item version being used by the application and 
available in the catalog.

When you edit a published item, it is checked out in catalog builder and the item’s 
draft copy is created.

Limitations

Catalog builder is designed to support the most common and simple use cases so that it can 
easily be used by business users, while the complex functionality can be added to the item in 
ServiceNow AI Platform  by catalog administrators.

When creating a record producer in a specific scope, you can select tables in that scope 
and tables in other scope if the objects from the other application scope are given read and 
create access for selecting a record submission table. For more information on making a table 
accessible to other applications, see Table design and runtime settings .

Catalog builder does not allow creation and editing of the following entities, but they can be set 
in ServiceNow AI Platform  either for a draft item or a published item that has not been checked 
out.

• Catalog item

◦ Meta tags

◦ Execution plans. If an item is assigned an execution plan, the process engine cannot be 
changed in the catalog builder.

◦ Price settings

• Variable settings

◦ Tool tips

◦ Advanced and dynamic reference qualifiers. If a variable has advanced or dynamic 
reference qualifiers, then the reference qualifier cannot be edited in the catalog builder.

◦ Attributes

◦ Permissions

◦ Availability
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◦ Lookup label field (defaults to lookup value field)

◦ Lookup price fields

◦ Unique values only

◦ Always expanded help

◦ Help text

◦ Advanced reference qualifiers

• Question types. The following questions are supported in catalog builder, and they are 
grouped into types and subtypes. For the unsupported question types, you can view the 
questions but not edit them:

◦ Text

▪ Single-line. This is the Single-line text variable type in ServiceNow AI Platform.

▪ Multi-line. This is the Multi-line text variable type in ServiceNow AI Platform.

▪ Rich text. This is the HTML variable type in ServiceNow AI Platform

◦ Option

▪ Check box. This is the Check box variable type in ServiceNow AI Platform.

▪ Yes/No. This is the Yes/No variable type in ServiceNow AI Platform.

◦ Choice

▪ Dropdown (fixed values). This is the Select Box variable type in ServiceNow AI Platform.

▪ Dropdown (values from a table). This is the Lookup Select Box variable type in ServiceNow 
AI Platform.

▪ Record reference. This is the Reference variable type in ServiceNow AI Platform.

▪ Radio. This is the Multiple Choice variable type in ServiceNow AI Platform.

▪ Multi-select. This is the List Collector variable type in ServiceNow AI Platform.

◦ Date/Time

▪ Date. This is the Date variable type in ServiceNow AI Platform.

▪ Date &Time. This is the Date and time variable type in ServiceNow AI Platform.

◦ Display label

▪ Plain text. This is the Label variable type in ServiceNow AI Platform.

▪ Rich text. This is the Rich Text Label variable type in ServiceNow AI Platform

• Catalog UI policy

◦ On Load  field (defaults to true)

◦ Script  field. When a catalog UI policy has a script, it does not show up in the question's 
behavior settings list in the catalog builder.

◦ Reverse if false  field. By default, it is set to true.

◦ Multiple actions. When a catalog UI policy has multiple actions, it does not show up in the 
question's behavior settings list in the catalog builder.

• For a catalog item, the questions cannot be viewed and edited in the catalog builder in the 
following scenarios:

◦ It has more than two levels of containers.

◦ It has a two-column question set or two-column container within a container.
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• Catalog client scripts

• Data lookup rules

Related topics

Set up a service catalog

Setting up the Catalog Builder

Set up the catalog item building process.

Before you begin
Role required: admin

Procedure

1. To direct users from the Catalog Builder homepage to your organization-specific catalog 
building process documentation, perform the following steps.

a. Navigate to sys_properties.list.

b. Select the glide.sc.builder.content_url property.

c. On the System Property form, in the Value  field, specify the URL for the documentation of 
your choice.

You can include both absolute and relative URLs. Following are the examples:

▪ Absolute URL: https://www.youtube.com

▪ Relative URL: sp?id=kb_article&sysparm_article=KBXXXXXX

d. Click Update.

2. Optional:  To preview a catalog item in a specific portal, perform the following steps.

a. Navigate to sys_properties.list.

b. Select the glide.sc.builder.preview_portal_id.

c. On the System Property form, in the Value  field, specify the portal name.

(Optional) The default value is swp.

d. Click Update.

3. Create or duplicate catalog item templates.

For information on creating a template, see Creating or editing catalog item template.

4. Optional:  To allow users with access to a catalog item template to edit all items created using 
that template, perform the following steps.

a. Navigate to sys_properties.list.

b. Select the glide.sc.builder.template_access.
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c. On the System Property form, in the Value  field, set the value to true.

(Optional) The default value is false.

d. Click Update.

5. Optional:  Define and configure a pre-publish subflow that is triggered after submitting the 
catalog item in Catalog Builder.

(Optional) This subflow is run after the catalog item has been submitted but before it gets 
published. For example, an approval flow after submitting the edited catalog item in Catalog 
Builder.

a. Create a pre-publish subflow by specifying the following input and output parameters.

(Optional) You can also copy the Template: Catalog Builder - Item review subflow and then 
define your subflow. For information about subflows, see Subflows .

Template: Catalog Builder - Item review subflow input parameters

Parameter Type Description

catalog_item String sys_id of the draft version of the catalog item.

Template: Catalog Builder - Item review subflow output parameters

Parameter Type Description

state String State of the pre-publish subflow. Possible values are:

▪ completed: Publishing process is triggered for the item in the In 
review  state.

▪ failed: Reverts the state of the item from In review  to Draft.

Note: 
The completed  and failed  values are case sensitive and must be 
selected the same way.

For information about subflow field types, see Field types .

b. Create the glide.sc.builder.item_review_flow  property.

i. Navigate to sys_properties.list.

ii. Click New.

iii. On the form, fill in the fields.

System Property form

Field Description

Name Unique identifier of the property. 
Specifyglide.sc.builder.item_review_flow.

Type Type of the property. Specify string.
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Field Description

Value sys_id of the review subflow.

iv. Click Submit.

6. Optional:  To modify the content in feedback panels for Catalog Builder steps, perform the 
following steps.

a. Navigate to sc_wizard_feedback.list.

b. From the list of catalog wizard feedbacks, select the feedback panel content that you want to 
edit.

c. On the Catalog Wizard Feedback form, in the Content  field, edit the content.

d. Click Update.

7. Optional:  To determine which users can view and edit catalog items, specify a value in the 
glide.sc.builder.item_filter_mode  property.

a. Navigate to sys_properties.list.

b. Select the glide.sc.builder.item_filter_mode  property.

c. On the System Property form, in the Value  field, specify one of the following values:

▪ default: All the catalog items for which the user has read access will be displayed. When 
set to default, the user cannot edit a catalog item unless the user has write access for that 
item.

▪ catalog_editor: All the items where the user is the catalog editor or catalog manager are 
displayed and can be edited.

▪ owner_only: All the items for which the user is the owner are displayed and can be edited.

Note: 
If the user has the catalog_admin role, the user can view and edit all catalog items 
irrespective of what is selected in the property.

Configure a step-based service fulfillment flow

Define service fulfillment steps while creating a catalog item in Catalog Builder.

Before you begin
Role required: admin, catalog_builder_editor, or catalog_admin

About this task
In the base system, the Step-based request fulfillment flow is available. It includes the Service 
Fulfillment Steps base flow subflow that runs all steps defined in the service fulfillment flow. 
Following are the input and output parameters of the subflow.

Service Fulfillment Steps base flow input parameters

Parameter Type Description

task Reference RITM record
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Service Fulfillment Steps base flow output parameters

Parameter Type Description

state String State of the subflow. Possible values are:

• completed: All steps are complete.

• failed: At least one step failed because of invalid configurations such as 
missing subflow or step configurations.

For information about subflow field types, see Field types .

If your organization has processes to be run before or after the service fulfillment steps, create a 
flow and ensure that it is configured as a step-based service fulfillment flow.

Procedure

1. Create a Flow Designer  flow (With the trigger type as Service Catalog).
Ensure that the Service Fulfillment Steps base flow subflow is called from this flow.

For information about creating a flow with Service Catalog trigger type, see Create a flow with a 
Service Catalog trigger .

2. Register the flow as service fulfillment flow.

a. Navigate to Service Catalog  > Catalog Administration  > Service Fulfillment Steps Registry.

b. Click New.

c. On the form, fill in the fields.

Service Fulfillment Flow Registry form

Field Description

Service Fulfillment Flow 
Registry

Flow Designer  flow for which you want to enable service 
fulfillment steps.

Application Application scope in which the flow is supported for service 
fulfillment.

Active Option to enable the service fulfillment support for the flow.

d. Click Submit.

Create a service fulfillment step type

Expand the coverage of service fulfillment use cases beyond those supported by step types in 
base system. Using a service fulfillment step type, catalog item owners can define multiple steps 
that are part of the request fulfilment process.

Before you begin
Role required: admin

About this task
The following step types are available in the base system.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4217

https://www.webstg.servicenow.com/docs/access?context=r_FieldTypes&version=washingtondc&pubname=washingtondc-platform-administration&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=r_FieldTypes&version=washingtondc&pubname=washingtondc-platform-administration&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=r_FieldTypes&version=washingtondc&pubname=washingtondc-platform-administration&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=create-sc-flow&version=washingtondc&pubname=washingtondc-build-workflows&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=create-sc-flow&version=washingtondc&pubname=washingtondc-build-workflows&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=create-sc-flow&version=washingtondc&pubname=washingtondc-build-workflows&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=create-sc-flow&version=washingtondc&pubname=washingtondc-build-workflows&ft:locale=en-US


• Task

• Custom approval

• Manager approval

Procedure

1. Set up a data store to store information needed for running the step.
This information is provided by a catalog item owner while defining the request fulfillment 
process. Do one of the following.

2. Create a record producer to store the values provided by the catalog item owner to the data 
store (base table or extended table) of that step.
For information about creating a record producer, see Create a record producer.

Note: 

◦ The Service Fulfillment Steps - Properties set variable set is automatically added to the 
record producer and it should not be removed from the record producer.

◦ All additional columns defined in the extended table should have corresponding 
variables mapped in the record producer.

◦ Configure the Record Producer form to display the Allow edit  option and Save Options 
field. Also, select the Allow edit  option and set the value of the Save Options  field to 
Save in Destination.

◦ Ensure that the record producer is not restricted for the users with 
catalog_builder_editor role.

3. Create a subflow to perform a sequence of actions by copying the Template: Service 
Fulfillment Steps subflow and then defining your subflow.
For information about subflows, see Subflows .

Template: Service Fulfillment Steps subflow input parameters

Parameter Type Description

requested_item Reference RITM record

service_fulfillment_step_data Reference Step data record. Update the state to one of the 
following values before ending the subflow:

◦ canceled

◦ failed

◦ completed

service_fulfillment_step Reference Step defined on a catalog item. It must refer to a 
table in which the record producer defined in the 
step configuration inserts a record.

Do not update the step record.

For information about subflow field types, see Field types .

4. Create a step configuration to define the behavior and display of a service fulfillment step type.
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a. Navigate to Service Catalog  > Catalog Administration  > Service Fulfillment Step 
Configurations.

b. Click New.

c. On the form, fill in the fields.

Service Fulfillment Step Configuration form

Field Description

Name Name of the step configuration.

Application Application scope in which the step configuration is supported.

Active Option to enable the service fulfillment support for the flow.

Order Order of the step configuration.

Based on the order of step configurations, the corresponding service 
fulfillment step types are displayed in the list in the Steps  region of the 
Fulfillment  step.

The step type corresponding to the step configuration with the least order is 
displayed beside the list and step types for all other step configurations are 
included in the list based on their order.

Order of service fulfillment step types

Hide Hides the step type corresponding to this step configuration in the list in the 
Steps  region of the Fulfillment  step. No impact on existing steps.

Short 
description

Description of the step configuration.

Producer Record producer that creates an instance of the step type in the step’s data 
store.

Service 
fulfillment 
subflow

Subflow triggered during the request fulfillment process.

Dynamic 
title

Text that should be displayed for the corresponding service fulfillment step 
in the Steps  region of the Fulfillment  step. If you don’t provide any value, the 
step configuration name is displayed.
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Field Description

To display dynamic text, you can include the field name from the step's 
data store (base table or the extended table) where the associated record 
producer creates a record.

For example, in the base system, the Dynamic title  field for the Custom 
approval step configuration contains the following value:Approval from 
${approval_title}

Here, approval_title  is the field from the Service Fulfillment Approval 
Step [sc_service_fulfillment_approval_step] table where the associated 
record producer, Add custom approval, creates a record.

d. Click Submit.

Add a step, section, or question to a catalog item wizard

Add a step, section, or question to a catalog item wizard so catalog item editors can enter custom 
details while creating catalog items.

Before you begin
Role required: catalog_admin

About this task
This video shows you how to add a step, section, or question to a catalog item wizard.  This video 
demonstrates how to add a step, section, or question to a catalog item wizard.

Procedure

1. Navigate to All  > Service Catalog Wizards  > Maintain Wizards.

2. Indicate the wizard you want to modify by selecting either Create catalog item  or Create 
record producer.

3. Add steps, sections, or questions to the Catalog Builder wizard.

For more information about the fields and their descriptions of the Catalog Wizard form, see 
Catalog Wizard form.

Now Assist  in Catalog Builder

Use ServiceNow®  Now Assist  in Catalog Builder to create catalog items of your choice in Catalog 
Builder by giving text inputs.
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Get started

Explore

Learn about catalog 
generation by Now Assist.

Configure

Learn how to configure 
catalog item generation.

Generate

Learn how to create a catalog 
item using Now Assist.

Reference

Get details about form 
fields, roles, and more.

Troubleshoot and get help

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support

AI limitations

This application uses artificial intelligence (AI) and machine learning, which are rapidly evolving fields of study that generate predictions based on patterns in 

data. As a result, this application may not always produce accurate, complete, or appropriate information. Further, there is no guarantee that this application has 

been fully trained or tested for your use case. To mitigate these issues, it is your responsibility to test and evaluate your use of this application for accuracy, harm, 

and appropriateness for your use case, employ human oversight of output, and refrain from relying solely on AI-generated outputs for decision-making purposes. 

This is especially important if you choose to deploy this application in areas with consequential impacts such as healthcare, finance, legal, employment, security, 

or infrastructure. You agree to abide by ServiceNow’s AI Acceptable Use Policy , which may be updated by ServiceNow.

Data processing

This application requires data to be transferred from ServiceNow  customers' individual instances to a centralized ServiceNow  environment, which may be located 

in a different data center region from the one where your instance is, and potentially to a third-party cloud provider, such as Microsoft Azure. This data is handled 

per ServiceNow's internal policies and procedures, including our policies available through our CORE Compliance Portal .

Data collection

ServiceNow  collects and uses the inputs, outputs, and edits to outputs of this application to develop and improve ServiceNow  technologies including ServiceNow 

models and AI products. Customers can opt out of future data collection at any time, as described in the Now Assist  Opt-Out page .

Exploring Now Assist  in Catalog Builder

Learn how the Now Assist  in Catalog Builder application helps you to create catalog items by 
simply describing them. Now Assist  generates catalog items with more detailed descriptions and 
question labels.
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Now Assist  in Catalog Builder overview

In Catalog Builder, you can describe the catalog item you want, and Now Assist  generates the 
catalog item for you.

The application uses the Catalog item generation skill to create catalog items. For more 
information about the skill, see Catalog item generation .

Note: 
You must be assigned the catalog_builder_editor and now.assist.creator roles to create the 
items using Now Assist.

Now Assist  in Catalog Builder benefits

Benefit Feature Roles

• Catalog items of your choice: Describe your 
item, and it's generated for you by Now 
Assist.

• Tailored catalog items: Provide specific 
details, and Now Assist  tailors catalog items 
to your needs. It's customizable, so you can 
ensure every items fits the specifications 
you need.

• Professional descriptions: Get descriptions 
and question labels automatically. Now 
Assist  crafts compelling narratives, 
enhancing your catalog's professionalism.

Create catalog items 
using Now Assist

catalog_builder_editor 
and now.assist.creator

Related topics

Configuring Now Assist settings and features

Catalog item generation

Configuring Now Assist  in Catalog Builder

Install and configure Now Assist  in Catalog Builder.

Configuration overview

Along with the installation of Now Assist  in Catalog Builder application, you must activate the 
Catalog item generation skill.

Related topics

Install Now Assist plugins

Activate a Now Assist skill

Install Now Assist  in Catalog Builder

Install the Now Assist for Creator  application from the ServiceNow®  Store  to get Now Assist  in 
Catalog Builder.
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Before you begin

• Review the Now Assist for Creator  application listing in the ServiceNow Store  for 
information on dependencies, licensing or subscription requirements, and release 
compatibility. Now Assist for Creator  installs the Now Assist  for catalog generation application 
(com.snc.text2catalog).

• Role required: admin

About this task
Now Assist  in Catalog Builder is a capability within the Now Assist for Creator  application and to 
start using this capability, you must to first install the application.

Procedure

1. From the Now Assist for Creator  application page on the ServiceNow Store, select Request 
App.

2. After approval has been granted, on your instance, navigate to All  > System Applications  > All 
Available Applications  > All.

3. Using the search bar, search for the Now Assist for Creator  application (sn_now_creator).

4. Select Install.

5. Verify that Now Assist for Creator  is installed:

a. Navigate to All  > Now Assist Admin  > Features.

b. In the workflow list, select Creator.

c. On the Service Catalog  card, verify that the Catalog item generation skill is active.
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Note: 
If the skill isn’t active, select View details. Then on the Service Catalog  page, turn on 
the Catalog item generation skill.

For more information about Now Assist Admin, see Now Assist .

What to do next
Grant the catalog_builder_editor and now.assist.creator roles to enable users to create catalog 
items using Now Assist.

Creating a catalog item using Now Assist

Create a catalog item by using Now Assist  and make the item available in Service Catalog  for 
catalog item requests.

Before you begin
Role required: catalog_builder_editor and now.assist.creator
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Procedure

1. Navigate to All  > Service Catalog  > Catalog Builder.

2. Select the Dashboard  tab and select Create a new catalog item.

3. Review the steps involved in the creation process and select Continue.

4. Select a template from the list and select Use this item template.

5. In the Now Assist  step, describe the catalog item you want.

For more information about describing your catalog item, see How to describe a catalog item.

6. Select Generate with Now Assist.
Now Assist  generates content for the Details and Questions steps of the catalog item.

7. Verify the content in the Details and Questions steps before you submit the item.

Note: 
The AI sparkle ( ) icon displayed for these steps and their fields denotes that the 
content in the fields is AI-generated. If you change the content, the sparkle is removed.

Related topics

How to describe a catalog item

Catalog item generation reference

Reference topics provide additional information about configuration properties, roles, and more.

How to describe a catalog item

Now Assist  uses the description that you write to generate a catalog item for you. If you're using 
Now Assist  for creating a catalog item, use these points to describe your catalog item.

• Provide the necessary details of the catalog item that you want to build. For example, you can 
start with entering the following text:

Create a travel visa request form.

• If you want, you can add details of one or more questions that you want to include in the 
catalog item. For accurate results, describe all aspects of the question, including type, 
properties such as mandatory, choices, and default value.

• Specify the exact table name for reference questions.

• For a record producer, provide the exact field name to which you want to map the question.

For example, you can write the following text:

Create a travel visa request form

It must include a drop down menu offering three travel types: 
Internal, External, and Customer visit (with Customer visit as 
the default option). Add mandatory fields for the travel start 
date, country of birth, and country traveling to (these must 
be reference fields from the core_country table). Include an 
optional field for trip duration and a section prompting the 
user to provide a business justification.
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Catalog Conversational Coverage

ServiceNow®  Catalog Conversational Coverage provides a dashboard to view a high-level 
overview of the conversational and non-conversational catalog items.

You can view this information in the Conversational catalog overview dashboard. The dashboard 
displays a graphical representation of various reports, such as the number of conversational and 
non-conversational catalog items, reasons that make the items non-conversational, and popular 
request channels. It also shows a list of the catalog items, their conversational status, and other 
details.

Drilling down the catalog items, you can view the details, for example, whether they’re 
conversational or non-conversational and why the items are non-conversational. Explore 
the potential suggestions for non-conversational items that might help you make the items 
conversational.

If you have any of the following roles, you can view the dashboard:

• Catalog administrator [catalog_admin]

• Catalog manager [catalog_manager]

• Catalog editor [catalog_editor]

To access and view the dashboard, you must install and activate the Catalog Conversational 
Experience plugin (sn_catalog_con_cov). You can find the plugin in the ServiceNow®  Store.

Note: 
If you've installed Now Assist  for conversation request submission plugin, you get the 
Catalog Conversational Experience plugin (sn_catalog_con_cov) by default.

The Update catalog items conversational status  scheduled job pulls conversational data of 
catalog items. This scheduled job updates the reasons for the catalog items. The scheduled 
job runs once in three days automatically. But to get the latest data when you need, run this job 
manually.

Related topics

Configure Now Assist in Conversational Catalog Request

View the conversational catalog overview dashboard using Catalog Builder

Conversational catalog overview dashboard

The dashboard shows the information that you need in graphs and a table.

You can view the data of only those catalog items you have edit access to.

In the graphical representation of reports, you can view the following information:

Graphical 
representation of 
reports

Description

Conversational and 
non-conversational 
item count

The number of catalog items that are conversational and non- 
conversational.

Reasons that 
make items non-
conversational

Reasons for catalog items to be non-conversational. For example, 
having unsupported questions or scripted UI policies make the item 
non-conversational.
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Graphical 
representation of 
reports

Description

Popular request 
channels - last 6 
months

The channel distribution of catalog item requests that have been 
submitted in the last six months.

The Catalog items section shows the following information:

Column name Description

Catalog item
Name of the catalog item.

You can select the name to open the catalog item details page.

Conversational 
status

Conversational or non-conversational status of the catalog item.

VA render type Type of catalog item rendering. Based on the configuration of the catalog item, 
the render type is determined to be conversation, window, or popup.

Number of 
reasons The number of the reasons that are causing the item to be non-conversational.

You can select the name of the non-conversational catalog item to view the 
reasons.

Number of 
requests

Number of requests that corresponds to the requests submitted in the last six 
months.

State The status of the catalog item.

Owner Name of the owner of the catalog item.

Updated Date and time when the catalog item was last edited.

Related topics

View the conversational catalog overview dashboard using Catalog Builder

View the conversational catalog overview dashboard using the ServiceNow AI Platform

Catalog item conversational details page overview

Catalog Conversational Coverage

Catalog item conversational details page overview

View the details page for your catalog item. If your item is non-conversational, view why your 
catalog item isn’t conversational and review the suggestions to know what you can do to make 
the item conversational.

You can view this page only if you have any of the following roles:

• Catalog administrator [catalog_admin]

• Catalog manager [catalog_manager]

• Catalog editor [catalog_editor]

• Catalog builder editor [catalog_builder_editor]
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Note: 
The catalog manager, catalog editor, and catalog builder editor can view the details page 
only if they have edit access to the catalog item.

The page displays the following information related to conversational or non-conversational 
catalog items:

• Name of the catalog item

• Conversational status and render type

• Date and time when the catalog item was last updated

• The Reasons and suggestions  and Item details  tabs

The Reasons and suggestions  tab shows one or more reasons for the item being non-
conversational and suggestions that might make the item conversational. If there’s more than 
one reason, you can select each reason to view the suggestions for that particular reason.

The Item details  tab shows the details, such as a short description, description, and image of 
the item if available.

After going over the reasons and suggestions for the non-conversational items, select Edit in 
advanced view  if you want to make changes. The catalog item opens in the ServiceNow AI 
Platform  for editing.

Note: 

• Only the catalog admin, catalog manager, and catalog editor can view the Edit in 
advanced view  button.

• If you're viewing a catalog item that's in checked out state, you view its data that 
corresponds to the published version of the item. Any changes to the draft of the catalog 
item won’t be reflected here until it’s published.

Related topics

Conversational catalog overview dashboard

View the conversational catalog overview dashboard using Catalog Builder

View the conversational catalog overview dashboard using the ServiceNow AI Platform

Catalog Conversational Coverage

View the conversational catalog overview dashboard using the ServiceNow AI Platform

Use the ServiceNow AI Platform  to view the dashboard that shows the catalog items that are 
conversational or non-conversational. Understand why catalog items aren't conversational, and 
explore the potential suggestions that might help make the items conversational.

Before you begin
Verify that you’ve installed the Catalog Conversational Experience plugin (sn_catalog_con_cov).

Role required: catalog_admin, catalog_manager, and catalog_editor

Procedure

1. Navigate to All  > Service Catalog  > Catalog Definitions  > Maintain Items.

2. On the Catalog Items list page, select Conversational Overview.
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The Conversational catalog overview dashboard opens, and you can view only those catalog 
items you own or can edit.

Note: 

◦ To view the dashboard, you can also navigate to All  > Service Catalog  > Catalog 
Administration  > Conversational catalog overview.

◦ On a specific catalog item page, select View conversational details  to open the 
catalog item’s details page, which shows the reasons and suggestions.

Related topics

Catalog Conversational Coverage

Conversational catalog overview dashboard

Catalog item conversational details page overview

View the conversational catalog overview dashboard using Catalog Builder

Use Catalog Builder to view the dashboard that shows the catalog items that are conversational 
or non-conversational. Understand why catalog items aren’t conversational, and explore the 
potential suggestions that might help make the items conversational.

Before you begin
Verify that you’ve installed the Catalog Conversational Experience plugin (sn_catalog_con_cov).

Role required: catalog_admin

Procedure

1. Navigate to All  > Service Catalog  > Catalog Builder.

2. Select the Dashboard  tab.

3. In the Conversational Coverage in VA section, select View conversational coverage.

The Conversational catalog overview dashboard opens. To view the conversational details 
page for a specific catalog item, on the dashboard, select the catalog item name. The details 
page opens.

Note: 
You can also open a catalog item details page to view its conversational details. To do 
so, select the Catalog items  tab, select an item that you want to view the details for, and 
select View conversational details.

Related topics

Catalog Conversational Coverage

Conversational catalog overview dashboard

Catalog item conversational details page overview

Edit a catalog item in Catalog Builder

Creating or editing catalog item template

Pre-specify values or provide restrictions for attributes such as catalogs, categories, variable 
types, and portal settings, which are applicable during the catalog item creation or editing 
process. You can create a template for a catalog item or record producer.
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Before you begin
Role required: admin or catalog_admin

Create a catalog item template in catalog builder

Procedure

1. Navigate to All  > Service Catalog  > Catalog Builder.

2. Select the Dashboard  tab and select Create a catalog item template.

3. Select any of the following options.

◦ Standard  for a catalog item.

◦ Record Producer  for a record producer

4. In the wizard, specify the information for each step.

Catalog item template creation wizard

Step Description

Template 
Details

◦ Basic info: Contains the template name, short description, and an option to 
use the template scope for creating records. If you select the Use template 
scope for creating records  check box, the record producers or catalog items 
created using this template would be created in the scope of the template.

◦ Template Available for: Specifies the user criteria for users who can use the 
template. Users matching the criteria must have the catalog_builder_editor 
role.

Note: 
You can add up to a maximum of 50 user criteria.

Details ◦ Basic info: Suggestions for the item name and short description.

◦ Item details: Suggestions for the description of the item.

Destination
Destination table in which a record producer creates records.

Note: 
This step is available for a record producer template.

Location
Catalogs, categories, and topics that the item can be associated with.

Configure catalogs and categories to make the catalog item discoverable on 
the Service Portal. In the Topics card, select the taxonomy and its associated 
topics for a catalog item to make the catalog item discoverable on the Employee 
Center.

Note: 
You can add up to a maximum of 50 catalogs or categories.

Questions Question sets (variable sets) that should be included in the item.

You can also restrict question types that can be used for items using the 

template by selecting the define owner permissions icon ( ).
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Step Description

Settings
Settings to configure the catalog item behavior in portals, such as Employee 
Center  and Service Portal.

Determine whether to display the following buttons or options on the portals:

◦ Add to cart

◦ Save as draft

◦ Quantity selector

◦ Delivery time

◦ Attachment

◦ Make the attachment mandatory
For example, if you don't want to display the Save as draft  button on the portal 
for the catalog item, select the Hide 'Save as draft'  option.

Access User criteria to specify users for whom the item is available or not available.

Fulfilment Flow or workflow that you want to associate with the item using this template.

Overrides Restrictions that apply while creating the catalog item.

◦ Can Edit: Only the attributes specified here can be edited.

◦ Must specify: Editable attributes that should be answered. The following 
attributes must be made mandatory:

▪ Item name

▪ Record submission table

◦ Restricted selections: For the attributes that enable selection of multiple 
values (for example, catalogs, categories, Available For, Not Available For), the 
user creating the item can only select or deselect the options from within the 
values specified in the template.

Review 
and submit

Review the template information and submit it.

Note: 
For each step, you can review the information in the feedback panel to know more about 
that step.

5. Select Submit.

6. To edit the catalog item template, select the Catalog item templates  tab, select the required 
template, and perform any of these actions.
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a. To edit the item, make the necessary changes, and select Save.

Note: 

▪ The changes to the template don’t automatically apply to existing items.

▪ While editing an existing catalog item, the new values in the template aren’t 
automatically updated in the item but the new restrictions apply. For example, if a 
new category is added to the template, that category isn’t automatically added to the 
catalog item. However, the restrictions to the categories apply.

▪ When question sets are added to the template, they don’t have any impact on the 
existing catalog items using the template.

b. To duplicate the catalog item template, select Duplicate.

Note: 
You can’t delete a catalog item template in the catalog builder, but it can be deleted in 
ServiceNow AI Platform. After a template is deleted, it’s disassociated from all catalog 
items using the template and the restrictions no longer apply to those items.

Create a catalog item using a template

Make an item available in service catalog for catalog item requests.

Before you begin
Role required: catalog_builder_editor, catalog_admin, or admin

About this task
You must create a catalog item using one of the available catalog item templates.

Demonstrates how business owners can create catalog items in Catalog Builder.

Procedure

1. Navigate to All  > Service Catalog  > Catalog Builder.

2. Select the Dashboard  tab and click Create a new catalog item.

3. Review the steps involved in the creation process and click Continue.

4. Select a template from the list and click Use this item template.

Note: 

◦ After you select the template, the preview of this template is available.

◦ You can only view templates assigned to you.

◦ Based on the template configuration, during the item creation or editing, few attributes 
have pre-specified values, are not editable, have limited options to select, and are 
mandatory.

◦ When selecting a record submission table for record producers, you can only select 
tables in that scope.

5. Based on how each step is defined in the template, specify the required information.
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Catalog builder steps

Step Description

Details ◦ Basic info: Item name and short description.

◦ Item details: Description of the item.

Destination Destination table in which a record producer creates records.

Note: 
This step is available when using a record producer template.

Location
Catalogs, categories, and topics that the item can belong to.

You can only view the catalogs, categories, and topics specified in the template.

Configure catalogs and categories to make the catalog item discoverable on the 
Service Portal.

In the Topics card, select taxonomy and its associated topics for a catalog item 
to make the catalog item discoverable on the Employee Center.

Questions Question sets (variable sets) or questions for the item. By default, the question 
sets included in the template are added and cannot be removed.

Available question types are restricted to those specified in the template.

From the Insert new question  list, you can include additional question sets, 
questions, deactivated questions, single-column container, two-column 
container, and line break. For information on creating a question and supported 
question types, see Create a question for a catalog item in Catalog Builder.

You can also add dynamic form behavior for a question. For information on 
adding dynamic form behavior, see Edit a question in Catalog Builder.

Note: 

◦ The questions within a question set cannot be edited. The question sets 
can be reordered by dragging and dropping them.

◦ Question sets specified in the template cannot be removed, while the 
ones added by the user can be removed.

◦ Removal of question sets simply removes the association with the item 
and does not delete the question set.

◦ A single-column question set can be added to a single-column or a 
two-column container. Two-column question set cannot be added to a 
container.

◦ The questions for a catalog item are available as options on which a 
condition can be applied for a step when you create service fulfillment 
steps for that catalog item.

Settings
Settings to configure the catalog item behavior in portals, such as Employee 
Center  and Service Portal  based on the request method.
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Step Description

For example, you can determine whether to display buttons or options for 
adding attachments, making them mandatory, or saving the draft of the items 
while requesting them.

Access User criteria to specify users for whom the item is available or not available.

Note: 
You can add up to a maximum of 50 user criteria.

Fulfilment Flow or workflow that you want to associate with this item. It defines how this 
catalog item can be fulfilled.

When a catalog item is associated with a Flow Designer  flow that supports 
service fulfillment steps, the catalog item owner creating the item can configure 
steps within the flow.

By default, the Step based request fulfillment flow is available in the base 
system.

For information about defining service fulfillment steps, see Define a service 
fulfillment step.

For information about Flow Designer  flows, see Flows .

Review 
and submit

Review the item and submit it.

Note: 
A dot beside the step name indicates it has a mandatory field.

6. To save your changes in each step, click Save.
All edits to the item attributes are automatically saved when you navigate to the next step.

7. To preview a catalog item in Portal, Now Mobile, or a Virtual Agent  conversation, click Preview.

Note: 
When you preview an item, you can interact with it but not submit it.

a. To preview the item in Portal, select Portal  for the View within  field.

Note: 
Portal preview is based on portal URL configured for the catalog builder.

b. To view an item representation in Now Mobile, select Now Mobile  for the View within  field.

c. To preview a catalog item in a Virtual Agent  conversation, select Virtual Agent  for the View 
within  field.

The Service Management Virtual Agent Topic Blocks plugin 
(com.glideapp.cs.sm_topic_blocks) and one of these plugins must be installed.

▪ Glide Virtual Agent (com.glide.cs.chatbot)

▪ Glide Virtual Agent Lite (com.glide.cs.chatbot.lite)
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A Virtual Agent conversation whose sys_id is specified in the 
glide.sc.builder.va_preview_topic_id  property is opened. By default, the 
property has the sys_id of the base system Catalog builder preview topic. For information 
about this topic, see Catalog builder preview topic conversation. If the base system topic is 
used, the following scenarios are possible:

▪ If the item is supported in the conversation mode, you can preview the item in the Virtual 
Agent conversation by answering the questions but cannot submit a request for the item. 
For information about when a catalog item is supported in the conversation mode, Service 
Catalog topic blocks in Virtual Agent powered by NLU.

▪ If the item is not supported in the conversation mode, a link is provided for the portal 
preview of the item.

▪ When the required plugins are not installed, an illustration displaying a sample 
conversational experience for the catalog item submission appears.

d. To open the preview in a new tab, click Open preview in a new tab.

Note: 
When you make any changes to the item and save it, the preview is dynamically 
refreshed in the opened tab.

8. To delete an unpublished draft item, click Delete.

Note: 
You cannot delete a published item but can make it inactive.

9. Click Submit.

Note: 
Until you submit the item, it is in the Draft state and is not available in the catalog.

Define a service fulfillment step

Define how a catalog item request should be fulfilled by creating simple service fulfillment steps.

Before you begin
Role required: catalog_builder_editor or catalog_admin or admin

About this task
To configure fulfillment steps while creating a catalog item, associate it with a Flow Designer  flow 
that supports service fulfillment steps.

Fulfillment process can contain multiple steps. These steps can run sequentially or can be 
grouped to run in parallel.

The following video demonstrates how business owners can define the fulfillment process of 
catalog items using service fulfillment steps.

Demonstrates how business owners can define the fulfillment process of catalog items using 
service fulfillment steps.

Procedure

1. In the Fulfillment  step of creating a catalog item, for the Selected flow  field, select a flow that 
supports service fulfillment steps.

2. In the Steps  region, perform one of the following:
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a. To create a task, click Add task.

i. On the form, fill in the fields.

Task form

Field Description

Task

Short 
description

Brief description of the task. It appears in the Steps  region.

Description Detailed description of the task.

Assignment 
group

User group that the task should be assigned to.

Assigned to User for which the task is assigned.

Priority Priority of the task.

When to run

Sequence
Sequence of this step relative to the previous step. Possible options are:

▪ With previous step: This step is grouped with the previous step or group. 
All grouped steps run simultaneously.

▪ After previous step: This step is placed after the previous step

Note: 
This field is not editable if it is the first step.

Condition Condition that defines whether the step must run. The options on which 
a condition can be applied are the questions that are available on the 
catalog item for which you’re creating the service fulfillment steps. For 
information on questions, see the Create a catalog item using a template 
topic.

ii. Click Add.

b. To create a custom approval and define who can approve the step, perform the following:

i. From the list beside Add task, click Custom approval.

ii. On the form, fill in the fields.

Custom approval form

Field Description

Custom approval

Users Users that can approve this step.

Groups User groups that can approve this step.

Approval 
type

Type of the required approval.
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Field Description

▪ All approve: The step is approved only when all assigned users and user 
groups approve.

▪ Anyone approves: The step is approved when any of the assigned users or 
any user from the assigned user groups approve.

When to run

Sequence
Sequence of this step relative to the previous step. Possible options are:

▪ With previous step: This step is grouped with the previous step or group. 
All grouped steps run simultaneously.

▪ After previous step: This step is placed after the previous step

Note: 
This field is not editable if it is the first step.

Condition Condition that defines whether the step must run. The options on which a 
condition can be applied are the questions that are available on the catalog 
item for which you’re creating the service fulfillment steps. For information on 
questions, see the Create a catalog item using a template  topic.

iii. Click Add.

c. To create a manager approval and define who can approve this step, perform the following:

i. From the list beside Add task, click Manager approval.

ii. On the form, fill in the fields.

Manager approval form

Field Description

When to run

Sequence
Sequence of this step relative to the previous step. Possible options are:

▪ With previous step: This step is grouped with the previous step or group. 
All grouped steps run simultaneously.

▪ After previous step: This step is placed after the previous step

Note: 
This field is not editable if it is the first step.

Condition Condition that defines whether the step must run. The options on which a 
condition can be applied are the questions that are available on the catalog 
item for which you’re creating the service fulfillment steps. For information on 
questions, see the Create a catalog item using a template  topic.

iii. Click Add.
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Service fulfillment steps

3. In the Estimated time to deliver  region, for the Days  field, specify the time by which the RITM 
should be fulfilled.

The due date is calculated based on when the service fulfillment flow is triggered.

4. Optional:  To edit a step, click the edit icon ( ).

5. Optional:  To delete a step, click the delete icon ( ).

6. Optional:  To rearrange steps, drag the steps.

7. Optional:  To group steps together, perform one of the following tasks.

◦ Drag a step and drop it on another step or group of steps.

◦ To group this step with the previous step or group, click the merge icon ( ).

Merged service fulfillment steps

8. Optional:  To separate a step from a group of steps, perform one of the following tasks.

◦ Click the separate icon ( ). The step is placed after the group.

◦ Drag a step out of the group and drop it at a location of your choice.

Catalog builder preview topic conversation

From the catalog builder, a user can preview a catalog item in a Virtual Agent  conversation.

This conversation uses the Request Catalog Item topic block. For information on this topic block, 
see Service Catalog topic blocks in Virtual Agent powered by NLU.

The Service Management Virtual Agent Topic Blocks plugin (com.glideapp.cs.sm_topic_blocks) 
and one of these plugins should be installed.

• Glide Virtual Agent (com.glide.cs.chatbot)

• Glide Virtual Agent Lite (com.glide.cs.chatbot.lite)
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In catalog builder, when the user selects the required item and navigates to preview it, the 
following scenarios are possible:

• If the item is supported in the conversation mode, you can preview the item in the Virtual 
Agent conversation by answering the questions but cannot submit a request for the item. For 
information about when a catalog item is supported in the conversation mode, see Service 
Catalog topic blocks in Virtual Agent powered by NLU.

• If the item is not supported in the conversation mode, a link is provided for the portal preview 
of the item.

• When the required plugins are not installed, an illustration displaying a sample conversational 
experience for the catalog item submission appears.

Related topics

Service Catalog topic blocks in Virtual Agent powered by NLU

Create a question for a catalog item in Catalog Builder

Specify a question that the requester should answer before submitting the catalog item.

Before you begin
Role required: catalog_builder_editor, catalog_admin, or admin

About this task
If allowed in the template by the template owner (catalog_admin) while configuring the template, 
the following question types can be used in the item creation process in the catalog builder. 
These question types are grouped into types and subtypes:

• Text

◦ Single-line. Single-line text variable type in ServiceNow AI Platform.

◦ Multi-line. Multi-line text variable type in ServiceNow AI Platform.

◦ Rich text. HTML variable type in ServiceNow AI Platform.

• Option

◦ Check box. Check box variable type in ServiceNow AI Platform.

◦ Yes/No. Yes/No variable type in ServiceNow AI Platform.

• Choice

◦ Drop down (fixed values). Select Box variable type in ServiceNow AI Platform.

◦ Drop down (values from a table). Lookup Select Box variable type in ServiceNow AI Platform.

◦ Record reference. Reference variable type in ServiceNow AI Platform.

◦ Radio. Multiple Choice variable type in ServiceNow AI Platform.

◦ Multi-select. List Collector variable type in ServiceNow AI Platform.

• Date/Time

◦ Date. Date variable type in ServiceNow AI Platform.

◦ Date &Time. Date and time variable type in ServiceNow AI Platform.

• Display label

◦ Plain text. Label variable type in ServiceNow AI Platform.

◦ Rich text. Rich Text Label variable type in ServiceNow AI Platform.

For detailed information about these question types, see Types of service catalog variables.
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Procedure

1. Navigate to Catalog Builder  > Create a new catalog item  > Question  and click Insert new 
question.

2. On the Create question form, specify the required details.

Note: 

◦ The fields on the form vary based on the question type and subtype.

◦ While you configure each question, its preview is available.

◦ The question preview doesn't show interactions for the following questions types until 
the question is saved and then edited.

▪ Record reference

▪ Multi-select

▪ Drop down (values from a table)

◦ The question preview doesn't show annotations.

a. Specify the details on the Question  tab.

Question tab

Field Description

Type

Question 
type

Group under which the question type is categorized.

Question 
subtype

Subtype of the question.

Only the question types allowed in the template are available.

Details

Map to field Maps the question to a specific field on the table for the record producer.

Question 
label

Question for a requester while ordering the catalog item.

For the Rich text question subtype, you can specify a formatted label to be 
displayed on a catalog item form.

Name Internal name to identify the question.

The name should not contain spaces or special characters. Only the 
underscore character is allowed.

Mandatory Option to specify if the question is mandatory.

Hidden Option to specify if the question is hidden.

Read-only Option to specify if the question is read-only.

b. Specify the details on the Annotation  tab.

This tab is available for the following question subtypes:
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▪ Single-line

▪ Multi-line

▪ Rich text

▪ Yes/No

▪ Drop down (fixed values)

▪ Drop down (values from a table)

▪ Record reference

▪ Radio

▪ Date

▪ Date &Time

▪ Multi-select

Annotation tab

Field Description

Instructions

Show instructions Option to specify if instructions should be displayed for the question.

Instructions label Instruction for the requester while ordering the catalog item.

Instructions Detailed instruction content.

c. Specify the details on the Additional Details  tab.

This tab is available for the following question subtypes:

▪ Single-line

▪ Drop down (values from a table)

▪ Record reference

▪ Multi-select

Additional Details tab

Field Description

Validation

Available for the Single-line question type

Text 
validation Option to validate the specified text value based on the regular expression 

validations that have been set up in the system.

Source

Available for the Dropdown (values from a table), Record reference, and Multi-select 
question subtypes

Table Table from which the choices are retrieved.

Field Field that should be displayed as a choice. This field is not available for the 
Record reference and Multi-select subtypes.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4241



Field Description

Filter 
conditions

Conditions to filter the choices.

d. Specify the details on the Choices  tab.

This tab is available for the following question subtypes:

▪ Drop down (fixed values)

▪ Drop down (values from a table)

▪ Yes/No

▪ Radio

Choices tab

Field Description

Settings

Include none 
choice

Option to include None  as a choice for the question.

Choice direction Direction in which the choices should be displayed. Possible options 
are Down  and Across.

This option is available only for the Radio question subtype.

Do not select first 
choice

Option to ignore the first choice.

This option is available only for the Radio question subtype.

Available Choices

Available for the Drop down (fixed values) and Radio question subtypes. You can add a 
name-value pair for each choice.

Display name Label for a choice.

Value Value of the choice.

e. Specify the details in the Default Value  tab.

The default value specified here is pre-selected as the answer for the question when a 
requester opens the catalog item form for the item. This tab is available for the following 
question subtypes:

▪ Single-line

▪ Multi-line

▪ Yes/No

▪ Radio

▪ Date

▪ Date &Time

▪ Multi-select
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f. Specify the question details on the Auto-populate  tab.

For more information about configuring auto-populate value, see Configure an auto-populate 
value for a question in Catalog Builder.

3. Click Insert Question  to add the question to the item.

Note: 

◦ If there are two consecutive check boxes, then a virtual container is created for a group 
of check boxes. Only check box variable types can then be added inside that group.

◦ Even if a check box variable is added immediately after a group of check boxes, it's 
automatically added to the group.

Configure an auto-populate value for a question in Catalog Builder

Configure the value of a question to populate automatically whenever the value of another 
question of the reference type changes.

Before you begin
Role required: catalog_builder_editor, catalog_admin, or admin

About this task
In a catalog item, for example, you can set up the value of the “Name of the manager” question to 
auto-populate whenever the value of the “Select the requester” question changes.

Procedure

1. Navigate to All  > Service Catalog  > Catalog Builder.

2. Select the Catalog items  tab.

3. Select a catalog item and navigate to the Questions  tab.

4. Select Insert new question.

5. On the Questions  tab, do the following:

a. In the Question type  field, select Choice.

b. In the Question subtype  field, select Record reference.

c. In the Question label  field, enter Name of the manager.

d. Optional:  Select the Read-only  option.

6. On the Additional details  tab, in the Source table field, search for and select User 
(sys_user).

7. On the Auto-populate  tab, do the following:

a. In the Select the question this depends on  field, select the reference question that this 
question depends on.

For example, select Select the requester.

The list displays all the Reference and Requested For question types that belong to the 
current catalog item and the associated single-row variable sets.

b. To select the field that contains the value that you want to set, select the Select the lookup 

field icon ( ).
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The list shows all the values in the sys_user table.

c. From the list, select Manager.

Note: 
To search any value, enter what you're looking for, for example, manager  or dot-walk to 
get the required value.

For more information about dot-walking, see Dot-walking to data in related tables .

8. Select Insert question.

Edit a question in Catalog Builder

Edit an existing question if you want to improve it by adding dynamic form behavior.

Before you begin
Role required: catalog_builder_editor, catalog_admin, or admin

About this task
Set values for the fields and condition-based field messages. Make the question mandatory, 
visible, or read-only based on your requirements. You can also deactivate the question.

You can’t edit the questions that belong to single-row and multi-row variable sets.

• If the question is used in a published catalog item, you can’t delete it but you can mark it as 
inactive. You can include such questions again in the catalog item by using the Insert De-
activated questions  option.

• Removing a new question that has never been published deletes the question.

• You can’t remove questions of types that aren't allowed in the template or supported in the 
Catalog Builder.

Procedure

1. Navigate to All  > Service Catalog  > Catalog Builder.

2. Select the Catalog items  tab.

3. Select a catalog item and navigate to the Questions  tab.

4. Deactivate a question.

a. Point to the question and select the deactivate icon ( ).

b. In the dialog box, select Deactivate.

5. Edit a question.

a. Point to the question and select the edit icon ( ).

b. Make the required changes and select Save.

6. Add dynamic form behavior to a question.

a. Point to the question and select the UI policies icon ( ) for defining dynamic behavior.

b. In the Dynamic behavior dialog box, select Define new behavior.

c. On the Actions  tab, fill in the required information.
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Actions tab

Field Description

Outcome

Specify the behavior of this question when the trigger conditions are met

Make the 
question 
mandatory

Specifies how the dynamic behavior setting affects the mandatory state of the 
field. Available options:

▪ No action

▪ Yes

▪ No

Make the 
question 
visible

Specifies how the dynamic behavior setting affects the visible state of the 
field. Available options:

▪ No action

▪ Yes

▪ No

Make the 
question 
read-only

Specifies how the dynamic behavior setting affects the read-only state of the 
field. Available options:

▪ No action

▪ Yes

▪ No

Value

Specify the value that should be set for this question when the condition is met.

Do this 
action Select any of the actions that you want to set for this question.

▪ No action.

▪ Clear value: Option to clear the question value.

▪ Set value: Option to set a value for the question.

Set this 
value 
to the 
question

Option to set a value for the question. For example, if you have a question 
related to storage with the question type Choice, and you set the available 
choices of storage as 1 TB, 256 GB, and 512 GB, then this field shows these 
values. You can select any one of these values for the question.

This field appears only when you select Set value  from the Do this action list.

Field message

Specify the type and message that should be shown under this question when the 
condition is met.

Set this 
field Select any of these field message types.
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Field Description

message 
type

▪ Info

▪ Warning

▪ Error

Note: 
If you don’t want a message, select None.

Set this 
message 
under the 
field

Option to set a message that you want to show when the condition is met.

d. On the Conditions  tab, add conditions that trigger the action on this question.

e. On the Settings  tab, fill in the required information.

Settings tab

Field Description

Applicability

Scenarios where this dynamic behavior applies

Applies when the item is being 
requested

Option to specify if the dynamic behavior applies 
when the item is being requested.

Applies while viewing the catalog 
tasks after the request is submitted

Option to specify if the dynamic behavior applies 
while viewing the catalog tasks after the request is 
submitted.

Applies while viewing the requested 
item record after the request is 
submitted

Option to specify if the dynamic behavior applies 
while viewing the submitted record.

f. Select Add behavior.

Note: 
When dynamic behavior is added, a catalog UI policy and action is created and a short 
description is automatically generated.

Edit a catalog item in Catalog Builder

Make changes to an existing catalog item if you have permissions to edit the item.

Before you begin

• You can edit a catalog item if you are a catalog admin.

• If you have the catalog_builder_editor role and you are the owner of the catalog item, you can 
edit it. If the template access property, glide.sc.builder.template_access, is set to 
true  (which is false  by default), any user with the catalog_builder_editor role with access to the 
template used for creating the catalog item can edit the item.

• Role required: catalog_builder_editor, catalog_admin, or admin
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About this task
When you edit a published item in the catalog builder, the system creates a draft copy of the item 
and its associated records such as variables, UI policies, and client scripts. The draft version is 
inactive until published. The published item remains in the published state and the Checked out 
field is set to True.

After you edit the item and submit it, the following scenarios are possible:

When a pre-publish subflow isn't configured

• The edits to the draft version are merged with the associated published item.

• The draft item and the associated records are deleted.

• The Checked out  field of the published item is set to False.

When a pre-publish subflow is configured

• The state of the draft item is changed to In review.

• If the state  variable of the subflow output returns Completed:

◦ The state of the draft item is changed to Reviewed  and edits made to the draft 
version are merged with the associated published item.

◦ The state of the published item changes to Publishing, then to Published, and 
the Checked out  field of the published item is set to False. The state change 
from Publishing  to Published  may not happen instantaneously.

◦ The reviewed draft item and the associated records are deleted.

• If the state  variable of the subflow output returns Failed, the state of the draft 
item is reverted to Draft, and the item is ready for editing.

For information about configuring a review subflow, see Setting up the Catalog Builder.

Procedure

1. Navigate to All  > Service Catalog  > Catalog Builder.

2. Select the Catalog items  tab.

Note: 
In the catalog item list view of the catalog builder, you can view items based on the value 
set in the glide.sc.builder.item_filter_mode  property.

3. Select the item that you want to edit and select Edit.

Note: 

◦ To edit an item in the In review  state, you must cancel the review. After you cancel the 
review, the state of the item is reverted to Draft.

◦ To view the conversational details of the catalog item, select View conversational 
details.

To edit an item in the In review  state, you must cancel the review. After you cancel the 
review, the state of the item is reverted to Draft.

4. Make the required changes and select Save.

For information on editing a question and catalog item fields, see Edit a question in Catalog 
Builder  and Create a catalog item using a template.
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5. To make an item inactive, clear the Item is active  check box in the Basic info  section of the 
Details  step.

6. To publish the modified item, navigate to the Review and submit  step and select Submit.

Related topics

View the conversational catalog overview dashboard using Catalog Builder

Add advanced capabilities to a catalog item

Add advanced capabilities, such as catalog client scripts, data lookup rules, and advanced 
reference qualifiers to a catalog item.

Before you begin
Role required: catalog_admin or admin

Procedure

1. Add advanced capabilities to a catalog item using any of these methods.

◦ Using the Edit in advanced view  button.

a. Navigate to All  > Service Catalog  > Catalog Builder.

b. Select the Catalog items  tab.

c. Select the catalog item for which you want to add advanced capabilities or features.

d. Select Edit in advanced view.

Note: 
If you have the catalog item wizard open, and you want to edit it in advanced view, 

select the more actions icon ( ) on the wizard, and select Edit in advanced view.

◦ Using the Edit checked out item in advanced view  related link.

a. Navigate to All  > Service Catalog  > Catalog Definitions  > Maintain Items.

Note: 

▪ The checked out item icon ( ) for the checked out item beside a catalog item 
indicates that it's the published version of the item that has been checked out for 
editing in the catalog builder.

▪ A draft item icon ( ) for the draft item mark beside the item indicates that it's the 
draft version of the item that can be directly edited in ServiceNow AI Platform.

b. Open the published item that you want to edit.

c. Select the Edit checked out item in advanced view  related link.

Note: 

▪ When a published item is checked out for editing, you can't edit the published 
version of the item in ServiceNow AI Platform, unless you cancel the checkout in 
ServiceNow AI Platform. Canceling the checkout cancels all changes made after 
the item was checked out.

▪ To edit an item in the In review  state, you must cancel the review. After you cancel 
the review, the state of the item is reverted to Draft.
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2. Make the required changes and select Update.

3. To edit the same item in the catalog builder, select Edit in Catalog Builder.
If the item has not already been checked out, this step checks out the item.

Discard a catalog item

Discard a catalog item that’s in the Draft state in Catalog Builder.

Before you begin
Role required: catalog_builder_editor, catalog_admin, or admin

About this task
If you no longer want a draft item, you can discard it in Catalog Builder. When you discard a 
draft item that doesn’t have a published item associated with it, that draft item is deleted. If a 
draft item has a published item associated with it, the draft item is deleted while the published 
item remains intact. The data of the catalog item is reverted to the state that it was in before you 
started editing it.

Procedure

1. Navigate to All  > Service Catalog  > Catalog Builder.

2. Select the Catalog items  tab.

3. Select the catalog item that you want to discard.

Note: 
You can discard only those catalog items that are in the Draft  state. After you select any 
draft item, the Discard draft  button becomes active.

4. Select Discard draft.

Note: 
If a catalog item wizard is already open for editing, and you want to discard it, select the 

more actions icon ( ) on the wizard, and select Discard draft.

Transfer catalog items using update sets

Transfer catalog items published through Catalog Builder from one instance to another easily 
by using update sets automatically created for the catalog item. For example, you can transfer 
catalog items created by a business user from a non-production to production instance.

Before you begin
You can access update sets for a catalog item only if it is created or modified in Catalog Builder.

For information on creating a catalog item in Catalog Builder, see Create a catalog item using a 
template.

For information on editing a catalog item in Catalog Builder, see Edit a catalog item in Catalog 
Builder.

Role required: catalog_admin, catalog_builder_editor
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Procedure

1. Access an update set for a catalog item by navigating to All > System Update Sets > Local 
Update Sets.

2. Search for the update set by the name, CB_<Template Name>_<Catalog Item 
Name>_<Date and Time Stamp>.

Note: 
If a catalog item contains related records such as Variables, Variable Sets, Available For, 
or Not Available For in a scope other than the current item scope, then such items are 
transferred in a batch where the related record update set's parent field is set as the 
update set of the parent catalog item. For more information, see Update set batching .

3. Transfer the completed update sets from the source instance to the target instance.
For more information, see Update set transfers .

Localization Framework  integration with Catalog Builder

The Translation Status  tab in the Catalog items tab on the Catalog Builder dashboard enables 
you to view the translation status of catalog items, and translate catalog items on the fly using 
manual or machine translation methods.

Ensure that the following plugins are installed before you start using Localization Framework  in 
Catalog Builder:

1. Localization Framework  Installer plugin for Service Catalog: The plugin enables the 
Localization Framework  capabilities in Service Catalog  and Catalog Builder.

2. Dynamic Translation plugin: Enables on-the-fly machine translation capabilities.

Translate catalog items information using one of the following modes:

• Request Translation mode

• Self-translation (ad hoc) mode

Request translation mode for new catalog items

Set the glide.sc.catalog_builder.localization.enable_request_translation_mode property to True, 
to enable the Request translations mode.

When you create a new item, the Request translations  step appears in the wizard steps region. 
Click Browse  to view and select the languages you want to translate the catalog item information 
to.
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Request translations step

For more information, see Request translations for Service Catalog items .

Request translation mode for existing items

Set the glide.sc.catalog_builder.localization.enable_request_translation_mode property to True, 
to enable the Request translations mode is enabled.

On the Catalog Items  tab, click the existing item that you want translated, then click the 
Translation status  tab on the right pane (next to the Item details  tab). You would see the list of 
languages configured in the system along with the state of that language for the catalog item and 
a Request translations  link to request for a translation.

Translation status tab

Click the Request translations  link below the language you want the translations for. A dialog 
appears prompting you to confirm the translation request. When you confirm the translation 
request on the Translation status  tab, a localization task gets generated and its corresponding 
Localization item record ("LRITMXXXXXXX") shows up in place of the Request translations  link. 
The state for that specific language changes to Translations requested.
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When the localization task completes in Localization Framework, the Request translations 
link comes back which you can use to request for translations again. The state changes to 
Translated, Partially translated, or Not translated  on the Translation status  tab, depending on 
whether the translations occur for all fields, some fields, or no fields in the table.

For more information, see Request translations for Service Catalog items .

Self-translation (ad hoc) mode

Translation status tab with self-translation mode

Set the glide.sc.catalog_builder.localization.enable_request_translation_mode property to False 
to enable self-translation mode. The default value for this property is False.

In the Catalog Items  tab, click the existing item you want translated, then click the Translation 
status  tab on the right pane (next to the Item Details  tab). The list of languages configured in 
the system is displayed, along with the state of that language for the catalog item and an Edit 
translations  link to edit the translation.

Click the Edit translations  link to open another tab that contains two comparison UI regions: The 
left region is the source language, and the right region is the target or translated language. You 
can compare the language translation side by side in the page, and make changes if required.

For more information, see Request ad hoc translation for Service Catalog items .
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Self-translation

Translation States

Translation states for both modes

State Mode Description

Not available Request translation and Self-
translation

If the Localization Framework 
Insights record  is not 
available, the translation state 
displayed by the system is 
Not Available, and the state 
appears near the language 
name.

Not translated Request translation and Self-
translation

If there are no translations in 
the system for that specific 
catalog item for that language, 
the state Not Translated 
appears near the language 
name.

Translations requested Request translation If there is an active LRTIM 
associated with a language 
for the item, the state 
Translations requested 
appears near the language 
name.

Partially translated Request translation and Self-
translation

If there are partial translations 
in the system for that specific 
catalog item for that language, 
the state Partially Translated 
appears near the language 
name.

Translated Request translation and Self-
translation

If all translations for that 
specific catalog item for that 
language exist in the system, 
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Exploring Hermes Messaging Service

Learn about the Hermes Messaging Service  and how it helps you manage the flow of data 
between your Kafka environment and your instance.

Hermes Messaging Service  overview

Apache Kafka  is an open-source data streaming platform that provides a single integration point 
for exchanging data across business systems in your organization. The Hermes Messaging 
Service  enables you to integrate your Apache Kafka  environment with your ServiceNow® 

instance to exchange data with these business systems.

The Hermes Messaging Service  is a multi-tenant, multi-cluster, data transport, and queuing 
service built on Apache Kafka  that enables your instance to produce and consume large volumes 
of Kafka events.

• Simplify and standardize asynchronous data transport between your Kafka environment and 
your ServiceNow  instance.

• Publish and process Kafka events at scale. Publish events to your Kafka environment from your 
ServiceNow  instance and consume Kafka events from your external systems at a high volume 
with low latency.

• Effectively process spikes and bursts in message volume to minimize performance impacts on 
your instance.

• Manage the health and performance of message delivery using Hermes  diagnostic tools.

Hermes Messaging Service  users

Users

User Description

Hermes  administrator The Hermes  admin defines namespaces for each Kafka cluster 
or domain and creates topic records in the instance or through 
the command-line interface (CLI). The Hermes  admin monitors 
topics and views the payload of a message in a Hermes  topic 
using the Hermes Messaging Service  topic inspector.

Hermes Messaging Service  workflow

1. In a domain-separated instance, the Hermes  admin creates namespace records for different 
domains.

2. The Hermes  admin creates topic records in the instance or through the CLI.

3. The Hermes  admin updates or rescans topic records as needed in the instance.

4. The Hermes  admin monitors topics and views message payloads using the Hermes Messaging 
Service  topic inspector.

Benefits

Different integration points and applications in the ServiceNow  platform can use the Hermes 
Messaging Service  to publish and ingest events.

The Hermes Messaging Service  is a ServiceNow AI Platform  capability that is available as part of 
Stream Connect, Log Export Service  (LES), and Instance Data Replication  (IDR).
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Benefit Application Users

Export data from your ServiceNow  instance 
to an external application using the Hermes 
Messaging Service  with Flow Designer.

Flow Designer Administrator

Export log data securely from your instance to 
your external data lake for reporting, auditing, 
or regulatory purposes by using the Hermes 
Messaging Service  with the Log Export 
Service.

Log Export Service 
(LES)

Administrator

Trigger flows from incoming Kafka events 
and trigger outgoing messages to your Kafka 
environment using the Hermes Messaging 
Service  with Stream Connect.

Using Stream Connect 
for Apache Kafka

Administrator

Improve the performance and processing 
efficiency of Instance Data Replication  (IDR) 
by upgrading replication sets that you created 
prior to the Utah release to use the Hermes 
Messaging Service.

Instance Data 
Replication

Administrator

Limitations

• Maximum message size: 2 MB

• Maximum message size per second: 2 MB (produced or consumed)

• Number of topics: 30 topics per instance

• Maximum number of partitions: 32 partitions per topic

• Retention policy: 36 hours

• Supported compression types for producing messages to Hermes: GZIP, LZ4, and NONE.

What to explore next

To learn more about configuring and using the Hermes Messaging Service, see:

• Configuring Hermes Messaging Service

• Exchanging data using the Hermes Messaging Service

• Managing namespaces and topics in Hermes

• Hermes Messaging Service administration

• Hermes Messaging Service reference

Configuring Hermes Messaging Service

Learn how the Hermes Messaging Service  is activated. Set up a secure connection to the 
Hermes Messaging Service.

Hermes Messaging Service  activation

The Hermes Messaging Service  is enabled when the Glide Hermes Message Queue plugin 
(com.glide.hermes) is activated.

This plugin isn't activated directly. Instead, the plugin is activated by any of the following actions:
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• Activation of the Stream Connect  plugins: (com.glide.hub.flow_trigger.kafka or 
com.glide.hub.action_step.kafka)

• Installation of the Log Export Service  application.

• Activation of the IDR  plugin (com.glide.idr) in Utah  or higher

• Activation of the IDR  plugin (com.glide.idr), and then a subsequent upgrade to Utah  or higher

Note: 
Stream Connect  requires an Automation Engine  subscription and a Stream Connect 
subscription. For more information, see https://www.servicenow.com/products/automation-
engine.html .

Set up a secure connection to the Hermes Messaging Service

Secure your Kafka topics by generating a ServiceNow®  instance-signed certificate.

Before you begin
Setting up the Hermes Messaging Service  requires coordination with your network administrator 
and with your Kafka administrator. Work with your network administrator to obtain required 
security certificates and open the required ports. Work with your Kafka administrator to ensure 
that your Kafka environment is configured correctly and that your applications can connect to the 
Hermes Messaging Service  using the standard Kafka protocol.

Make sure the following setup is in place:

• The Hermes Messaging Service  is activated. See Hermes Messaging Service activation.

• The Key Management Framework plugin (com.glide.kmf.global) is activated.

• The Certificates [sys_kmf_certificate] table contains a ServiceNow  instance root CA certificate.

• The instance isn't configured with a Custom URL. Custom URLs are not supported with the 
Instance PKI Certificate Generator.

Role required: hermes_admin, sn_kmf.cryptographic_manager, or admin

For details on assigning KMF roles, see Roles installed with Key Management Framework .

Procedure

1. Navigate to All  > Certificate Generator  > Instance PKI Certificate Generator.

2. Optional:  Control access to topics by configuring Access Control Lists (ACLs) at the 
namespace or topic-level.
The bearer of the certificate is granted read or read/write access to the topics in the 
namespace or the existing topic that you selected.

3. Set up security for the Hermes Messaging Service.

a. Navigate back to the Instance PKI Certificate Generator page.

b. Enter a keystore password in the Certificate Password  field.

c. Select Generate.
The system generates an instance-signed certificate in the Certificates [sys_kmf_certificate] 
table, creates a keystore, and creates a truststore.

If Restricted Caller Access isn't approved for the IPKI Certificate Generator, a cross scope 
access error appears. Contact Customer Service and Support  for assistance with approving 
Restricted Caller Access.
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4. Save a copy of the keystore by selecting Download Keystore.

5. Save a copy of the truststore by selecting Download Truststore.

6. Copy the keystore and truststore files to each producer and consumer client that will connect 
to the Hermes Messaging Service.

Result
You can now create a secure connection to the Hermes Messaging Service.

Note: 
You must use the keystore that you generated using the Instance PKI Certificate Generator 
to connect to Hermes. Custom-generated keystores that aren't created according to the 
ServiceNow  documentation aren't supported.

What to do next

• Review the guidance in Exchanging data using the Hermes Messaging Service.

• Prepare your Apache Kafka client environment

• Configure the SSL connection to Hermes  in the producer and consumer properties files using 
the truststore and keystore files that you generated. For more information, refer to the following 
topics:

◦ Create a test topic in Hermes using the Kafka client

◦ Produce test messages to a Hermes topic using the Kafka client

◦ Consume test messages from a Hermes topic using the Kafka client

Revoke a Hermes Messaging Service  certificate

Revoke a ServiceNow®  instance-signed certificate so that it can't be used in secure connections 
to the Hermes Messaging Service.

Before you begin
Role required: hermes_admin or sn_kmf.cryptographic_manager

Procedure

1. Navigate to All  > Certificate Generator  > Instance PKI Certificate Generator.

2. Select Manage Certificates.

3. In the Hermes IPKI Certificates  dialog box, select one or more certificates that you want to 
revoke.

4. Select Revoke.

5. Select a reason for the revocation and then select OK.

Result
The certificates are revoked and can no longer be used in secure connections to Hermes. 
You can view the revocation date and the reason it was revoked in the Certificates 
[sys_kmf_certificate] table.

Exchanging data using the Hermes Messaging Service

You can produce and consume Kafka messages in your ServiceNow  instance using the Hermes 
Messaging Service.
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There are several methods for exchanging data between your ServiceNow  instance and your 
Kafka environment using the Hermes Messaging Service. In all cases, data is produced from one 
entity and consumed by another.

• Using Stream Connect, you can produce messages from your ServiceNow  instance using a 
Producer step from a flow action or the Producer API, and then consume the messages in your 
external application.

You can also produce messages from an external application and then consume the messages 
in your ServiceNow  instance via any of the following methods:

◦ Kafka flow trigger

◦ RTE consumer

◦ Transform map consumer

◦ Script consumer

See Stream Connect for Apache Kafka  for more information.

• Using the Log Export Service, you can produce logs from your ServiceNow  instance, and then 
consume the logs in your external application. For details on producing and consuming logs 
for Log Export Service, see Log Export Service (LES) .

• Using the Kafka standard protocol, you can exchange messages with any application that 
produces messages. For example, you can produce messages from a Java application using 
the standard Kafka protocol and then consume them in your ServiceNow  instance and vice 
versa.

Producing and consuming messages

To start exchanging messages, create a topic in the Hermes  Kafka cluster. After you successfully 
create the topic, you create a total of three processes to communicate with the Hermes  Kafka 
cluster.

• One process is required to produce messages to Hermes.

• Two processes are required to consume messages from Hermes. Two processes are required 
because Hermes  uses a pair of Kafka clusters for failover purposes. If one cluster goes down, 
data is produced to the other Hermes  Kafka cluster.

Important: 
You must configure two distinct consumer bootstrap addresses, one for each consumer 
client.

When using the list  command to view a list of topics, a list of current topics are returned from 
one or both clusters. Topics might be returned from only one cluster, depending on when the last 
synchronization occurred. Topics created for failover purposes are differentiated by a three-letter 
cluster identification prefix.

When accessing the Hermes clusters using the CLI, internal topics appear in addition to any 
topics you've created. For details, see KB1705399 .

You can't delete a topic from both Kafka clusters using a single command in the command-line 
interface (CLI). However, you can delete the topic from both clusters by deleting the topic record 
in your instance. See Delete a topic in Hermes.
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Required port ranges

Work with your network administrator to ensure that the following port ranges are open before 
you begin exchanging messages using Hermes:

• Producer: 4000-4050

• Consumer1: 4100-4150

• Consumer2: 4200-4250

Bootstrap addresses

Use the following port mappings to connect producers and consumers to the Kafka cluster 
bootstrap addresses. All Application Delivery Controllers used by Hermes  follow this same 
convention.

Important: 
The following Hermes  bootstrap address examples use ports 4000-4003, 4100-4103, and 
4200-4203. However, you must open the following port ranges to ensure connectivity as 
additional clusters are added to the Hermes Messaging Service.

• Producer: 4000-4050

• Consumer1: 4100-4150

• Consumer2: 4200-4250

Producer clients use ports ranging from 4000 to 4050. For example:

Producers 
 = "<instance_name>.service-now.com:4000,<instance_name>.service-now.com:4001,<inst
ance_name>.service-now.com:4002,<instance_name>.service-now.com:4003"

Because Hermes  uses a pair of Kafka clusters, you must configure two consumer clients with 
separate consumer bootstrap addresses.

Important: 
You must configure two distinct consumer bootstrap addresses, one for each consumer 
client.

• The first consumer client uses ports ranging from 4100 to 4150. For example:

Consumer A 
 = "<instance_name>.service-now.com:4100,<instance_name>.service-now.com:4101,<ins
tance_name>.service-now.com:4102,<instance_name>.service-now.com:4103"

• The second consumer client uses ports ranging from 4200 to 4250. For example:

Consumer B 
 = "<instance_name>.service-now.com:4200,<instance_name>.service-now.com:4201,<in
stance_name>.service-now.com:4202,<instance_name>.service-now.com:4203"

When you configure producer and consumer properties for your own Kafka client, use this string 
pattern.

Prepare your Apache Kafka  client environment

Install the Apache Kafka  binaries on your Unix or Windows client machine.
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Before you begin
Confirm that you have Java 11.0 or higher installed by running the following command:

java --version

Role required: admin

Procedure

1. Download and install Apache Kafka.

a. Download the Apache Kafka  binaries.
Ensure that you download the binaries, not the source code, from the Apache Kafka  website.

b. Unzip the Apache Kafka  package.
For example:

tar -zxvf kafka_2.13-3.2.0.tgz

2. Navigate to the parent directory where you extracted the Apache Kafka  package.

◦ For example, on Unix:

cd /home/user/Software

◦ For example, on Windows:

cd C:\Software

3. Simplify the Apache Kafka  directory name by renaming it to kafka.

◦ For example, on Unix:

mv kafka_2.13-3.2.0 kafka

◦ For example, on Windows:

rename kafka_2.13-3.2.0 kafka

Result
The Apache Kafka  client is installed in a simplified directory on your local machine.

What to do next
Create a test topic in Hermes using the Kafka client

Create a test topic in Hermes  using the Kafka client

Create a topic for sending and receiving test messages in the Hermes  Kafka cluster.

Before you begin

• Secure your Kafka topics by generating a ServiceNow®  instance-signed certificate and 
keystore. You must provide truststore and keystore details when you configure a producer to 
create a topic in Hermes. See Set up a secure connection to the Hermes Messaging Service.

• Download and install Apache Kafka. See Prepare your Apache Kafka client environment.

Role required: admin

About this task
The full Hermes  Kafka topic name is composed of the following elements:
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snc.<instance_name>.<namespace>.<app_id>.<topic_name>

where:

• <instance_name>  is the name of your instance

• <namespace>  is the namespace of the domain your Kafka topic belongs to (optional)

• <app_id>  is your application ID

The topic you create belongs to this application. Specify either of the following:

◦ sn_logstoanalytics  for Log Export Service  topics

◦ sn_streamconnect  for Stream Connect  topics

• <topic_name>  is the unique name for your topic

Note: 
The full topic name is case-sensitive and limited to 200 characters.

Procedure

1. Navigate to the config  directory where you extracted Kafka.

◦ For example, on Unix:

cd /home/user/Software/kafka/config

◦ For example, on Windows:

cd C:\Software\kafka\config

2. Configure a producer.

a. Open the producer.properties  file.

b. Configure the following SSL properties:

security.protocol=SSL
 
ssl.truststore.password=<truststore password>
 
ssl.truststore.location=<path to truststore.p12>
 
ssl.truststore.type=PKCS12
 
ssl.keystore.password=<keystore password>
 
ssl.keystore.location=<path to keystore.p12>
 
ssl.keystore.type=PKCS12
 
ssl.key.password=<keystore password>

Replace the following placeholder variables:

▪ <truststore password>  with your truststore password

▪ <path to truststore.p12>  with the path to your truststore file
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▪ <keystore password>  with your keystore password

▪ <path to keystore.p12>  with the path to your keystore file

c. Save your changes in plain text.

3. Navigate to your Kafka directory.

4. Create a test topic by running the following command:

◦ Unix:

./bin/kafka-topics.sh --create --topic 
 snc.<instance_name>.<namespace>.sn_<app_id>.<topic_name> 
 --command-config ./config/producer.properties 
 --bootstrap-server 
 <instance_name>.service-now.com:4000,<instance_name>.service
-now.com:4001,<instance_name>.service-now.com:4002,<instance_
name>.service-now.com:4003

◦ Windows:

bin/windows/kafka-topics.bat --create --topic 
 snc.<instance_name>.<namespace>.sn_<app_id>.<topic_name> 
 --command-config config/producer.properties 
 --bootstrap-server 
 <instance_name>.service-now.com:4000,<instance_name>.service
-now.com:4001,<instance_name>.service-now.com:4002,<instance_
name>.service-now.com:4003

Replace the following placeholder variables:

◦ <instance_name>  with your instance name (case-sensitive)

◦ <namespace>  with the namespace of the domain your Kafka topic belongs to (optional)

◦ <app_id>  with the application ID (case-sensitive)

◦ <topic_name>  with the unique topic name you want to use (case-sensitive)

Result
A test topic is created in the Hermes  Kafka cluster.

What to do next
Produce test messages to a Hermes topic using the Kafka client

Produce test messages to a Hermes  topic using the Kafka client

Produce test messages to a Hermes  topic by configuring a producer client.

Before you begin

• Secure your Kafka topics by generating a ServiceNow®  instance-signed certificate and 
keystore. You must provide truststore and keystore details when you configure the Hermes 
producer. See Set up a secure connection to the Hermes Messaging Service.

• Download and install Apache Kafka. See Prepare your Apache Kafka client environment.

• Create a test topic to store the test messages that you produce. For details, see Create a test 
topic in Hermes using the Kafka client.

Role required: admin
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About this task
The following steps describe how to configure a producer client and send test messages to the 
Hermes  Kafka cluster. Refer to these steps when you're ready to produce messages to Hermes 
for business or production purposes.

Procedure

1. Navigate to the config  directory where you extracted Kafka.

◦ For example, on Unix:

cd /home/user/Software/kafka/config

◦ For example, on Windows:

cd C:\Software\kafka\config

2. Configure a producer.

a. Open the producer.properties  file.

b. Configure the following SSL properties:

security.protocol=SSL
 
ssl.truststore.password=<truststore password>
 
ssl.truststore.location=<path to truststore.p12>
 
ssl.truststore.type=PKCS12
 
ssl.keystore.password=<keystore password>
 
ssl.keystore.location=<path to keystore.p12>
 
ssl.keystore.type=PKCS12
 
ssl.key.password=<keystore password>

Replace the following placeholder variables:

▪ <truststore password>  with your truststore password

▪ <path to truststore.p12>  with the path to your truststore file

▪ <keystore password>  with your keystore password

▪ <path to keystore.p12>  with the path to your keystore file

c. Save your changes in plain text.

3. Produce a test topic.

a. Navigate to the Kafka directory.

b. Run the following command:
Unix:

./bin/kafka-console-producer.sh --topic 
 snc.<instance_name>.<namespace>.sn_<app_id>.<topic_name> 
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 --producer.config ./config/producer.properties 
 --bootstrap-server 
 <instance_name>.service-now.com:4000,<instance_name>.service
-now.com:4001,<instance_name>.service-now.com:4002,<instance_
name>.service-now.com:4003

Windows:

bin/windows/kafka-console-producer.bat --topic 
 snc.<instance_name>.<namespace>.sn_<app_id>.<topic_name> 
 --producer.config config/producer.properties 
 --bootstrap-server 
 <instance_name>.service-now.com:4000,<instance_name>.service
-now.com:4001,<instance_name>.service-now.com:4002,<instance_
name>.service-now.com:4003

Replace the following placeholder variables:

▪ <instance_name>  with your instance name

▪ <namespace>  with the namespace of the domain your Kafka topic belongs to (optional)

▪ <app_id>  with the application ID

▪ <topic_name>  with a unique test topic name

Note: 
Each part of the topic name is case-sensitive.

c. Send test messages to the test topic.
For example:

test1
test2
test3

Result
Test messages are produced to the test topic in the Hermes  Kafka cluster.

What to do next
Consume test messages from a Hermes topic using the Kafka client

Consume test messages from a Hermes  topic using the Kafka client

Consume test messages from a Hermes  topic by configuring two consumer clients.

Before you begin

• Secure your Kafka topics by generating a ServiceNow®  instance-signed certificate and 
keystore. You must provide truststore and keystore details when you configure the Hermes 
consumers. See Set up a secure connection to the Hermes Messaging Service.

• Download and install Apache Kafka. See Prepare your Apache Kafka client environment.

• Create a topic and produce test messages in the Hermes  Kafka cluster before you can 
consume messages. For details, see Create a test topic in Hermes using the Kafka client  and 
Produce test messages to a Hermes topic using the Kafka client.

Role required: admin
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About this task
The following steps describe how to configure two consumer clients and receive test messages 
from the Hermes  Kafka cluster. Because Hermes  uses a pair of Kafka clusters, you must configure 
two consumer clients with separate consumer bootstrap addresses. This ensures messages are 
consumed from both clusters without dropping any messages.

Important: 
You must configure two distinct consumer bootstrap addresses, one for each consumer 
client.

Refer to these steps when you are ready to consume messages from Hermes  for business or 
production purposes.

Procedure

1. Navigate to the config  directory where you extracted Kafka.

◦ For example, on Unix:

cd /home/user/Software/kafka/config

◦ For example, on Windows:

cd C:\Software\kafka\config

2. Configure the consumers.

a. Open the consumer.properties  file.

b. Configure the following SSL properties:

security.protocol=SSL
 
ssl.truststore.password=<truststore password>
 
ssl.truststore.location=<path to truststore.p12>
 
ssl.truststore.type=PKCS12
 
ssl.keystore.password=<keystore password>
 
ssl.keystore.location=<path to keystore.p12>
 
ssl.keystore.type=PKCS12
 
ssl.key.password=<keystore password>

Replace the following placeholder variables:

▪ <truststore password>  with your truststore password

▪ <path to truststore.p12>  with the path to your truststore file

▪ <keystore password>  with your keystore password

▪ <path to keystore.p12>  with the path to your keystore file

c. Save your changes in plain text.

3. Consume a message using each consumer.
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a. Run the following command for the first consumer client:
Unix:

./bin/kafka-console-consumer.sh 
 --consumer.config ./config/consumer.properties --topic 
 snc.<instance_name>.<namespace>.sn_<app_id>.<topic_name> 
 --group snc.<instance_name>.<consumer_group_id> 
 --from-beginning --bootstrap-server 
 <instance_name>.service-now.com:4100,<instance_name>.service
-now.com:4101,<instance_name>.service-now.com:4102,<instance_
name>.service-now.com:4103

Windows:

bin/windows/kafka-console-consumer.bat 
 --consumer.config config/consumer.properties --topic 
 snc.<instance_name>.<namespace>.sn_<app_id>.<topic_name> 
 --group snc.<instance_name>.<consumer_group_id> 
 --from-beginning --bootstrap-server 
 <instance_name>.service-now.com:4100,<instance_name>.service
-now.com:4101,<instance_name>.service-now.com:4102,<instance_
name>.service-now.com:4103

Replace the following placeholder variables:

▪ <instance_name>  with your instance name

▪ <namespace>  with the namespace of the domain your Kafka topic belongs to (optional)

▪ <app_id>  with the application ID

▪ <topic_name>  with a test topic name

▪ <consumer_group_id>  with a label of your choice for the group that the consumer 
belongs to

Note: 
Each part of the topic name is case-sensitive.

b. Open a new terminal window.

c. Navigate to the Kafka directory.

d. Run the following command for the second consumer client:
Unix:

./bin/kafka-console-consumer.sh 
 --consumer.config ./config/consumer.properties 
 --topic snc.<instance_name>.<namespace>.<topic_name> 
 --group snc.<instance_name>.<consumer_group_id> 
 --from-beginning --bootstrap-server 
 <instance_name>.service-now.com:4200,<instance_name>.service
-now.com:4201,<instance_name>.service-now.com:4202,<instance_
name>.service-now.com:4203

Windows:

bin/windows/kafka-console-consumer.bat 
 --consumer.config config/consumer.properties 
 --topic snc.<instance_name>.<namespace>.<topic_name> 
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 --group snc.<instance_name>.<consumer_group_id> 
 --from-beginning --bootstrap-server 
 <instance_name>.service-now.com:4200,<instance_name>.service
-now.com:4201,<instance_name>.service-now.com:4202,<instance_
name>.service-now.com:4203

Replace the following placeholder variables:

▪ <instance_name>  with your instance name

▪ <namespace>  with the namespace of the domain your Kafka topic belongs to (optional)

▪ <topic_name>  with a test topic name

▪ <consumer_group_id>  with a label of your choice for the group that the consumer 
belongs to

Note: 
Each part of the topic name is case-sensitive.

Result
Test messages are consumed from the Hermes  Kafka cluster.

Managing namespaces and topics in Hermes

Organize and manage namespaces and topics in the Hermes  Kafka cluster using the Hermes 
Messaging Service.

Managing namespaces in Hermes

Group Kafka topics together for simplified topic management and access control specification 
using namespaces.

In ServiceNow, all Kafka topics link to a namespace. You can use namespaces to organize topics 
in logical ways. For example, you can group topics together based on their Kafka cluster. You 
can also use namespaces to configure which domains can access which topics on a domain-
separated instance. You assign topics to ServiceNow domains using the topic's namespace.

Namespace records

Namespace records are stored in the Kafka Namespaces [sys_kafka_namespace] table. 
This table shows a list of namespace records with each namespace's related topic prefix. An 
administrator with the kafka_namespace_admin role creates namespace records in the Kafka 
Namespaces [sys_kafka_namespace] table.

Namespaces and topic prefixes

A topic is assigned to a namespace based on the topic name's prefix. A scheduled job regularly 
checks Hermes  for new topics. When it finds one, it creates a ServiceNow  topic record for the 
topic and links the topic to a namespace. The prefix assigned to the topic is the basis for its 
namespace assignment in ServiceNow.

This image shows an example of using the Kafka cluster name prefix to organize topics into 
different namespaces in ServiceNow.
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Kafka prefixes and topic namespaces

In this example:

1. An instance administrator with the kafka_namespace_admin role creates namespace records 
for the Log Analysis group, the Fulfillment group, and another subsidiary in the ServiceNow 
instance.

2. The instance administrator works with the Kafka administrator to replicate topics to Hermes 
using the Kafka cluster name as the namespace prefix.

3. The Kafka cluster for the fulfillment group has a topic named material_orders. The topic 
is replicated to Hermes  using fulfillment  as the namespace prefix. A new topic is created 
in Hermes  called fulfillment.material_orders.

4. A scheduled job finds the fulfillment.material_orders  topic in Hermes, creates a 
topic record, and assigns the record to the Fulfillment namespace to match its prefix.

Prefix matching rules

Topic name prefixes are matched to namespaces according to the following rules.

• The namespace is selected based on the longest matching namespace prefix. If there's a 
matching namespace, the topic record is assigned to that namespace and that namespace's 
domain.

• If there isn't a longer namespace prefix that matches, the zero-length prefix of the Default 
Namespace will match. The topic record is assigned to the Default Namespace in the global 
domain.

• If the Default Namespace has been deleted or modified, so there’s no matching namespace at 
all, then no topic record is created.

Namespace design considerations

Plan how want to organize your namespaces and topics before you start creating them. Once you 
add a topic to a namespace, you can't delete the namespace without deleting the topics that are 
associated with it.

Have a namespace for each domain on a domain-separated instance

Create one namespace per ServiceNow  domain.
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Use namespaces to organize topics by domain and Kafka installation

Use namespaces to separate both topics that belong in separate ServiceNow 
domains and topics from separate Kafka installations.

After you've configured your namespaces, consider deleting or deactivating the Default 
Namespace

Keeping the Default Namespace could lead to configuration issues, such as a 
mismatched topic prefix. This mismatch could result in a topic that should have 
been created in one domain being created in the global domain.

You can enforce tighter constraints on where topics are created by deleting the 
Default Namespace. For example, if you decide that all topics must have a prefix that 
matches a namespace, deleting the Default Namespace ensures that topics without 
a matching prefix aren't created.

For details on using domain separation with namespaces in Hermes, see Hermes Messaging 
Service domain separation.

Create a namespace in Hermes

Organize your Kafka topics by creating a namespace.

Before you begin
Role required: hermes_admin or kafka_namespace_admin

About this task
Use namespaces to organize Kafka topics in logical ways. For example:

• Create namespace records for each Kafka cluster that replicates messages to Hermes.

• Create namespace records for each domain in a domain-separated instance. For more 
information, see Hermes Messaging Service domain separation.

Procedure

1. Navigate to All  > Hermes Messaging Service  > Namespaces.

2. Select New.

3. On the form, fill in the fields.

Kafka namespace form

Field Description

Name Name of the namespace.

Topic Prefix Prefix assigned to all topics in this 
namespace.

Topics are assigned to namespaces based 
on the topic prefix. A scheduled job checks 
for new topics in Hermes. When it finds one, 
it creates a topic record and links the topic to 
the namespace.
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Field Description

Warning: 
To avoid conflicts between the app ID 
and the namespace that could result in 
unexpected behavior, don't specify a 
topic prefix beginning with sn_  when 
creating a namespace record.

Allowed Application Scopes List of application scopes that have access to 
this namespace.

4. Select Submit.

Result
A namespace record is created in the Kafka Namespace [sys_kafka_namespace] table. Topics 
created in or replicated to Hermes  are assigned to the namespace based on the topic prefix.

What to do next

• Organize topics yourself by creating one or more topic records and linking them to this 
namespace. See Create a topic in Hermes.

• Manage access to Kafka topics in the Hermes  Kafka cluster by configuring Access Control Lists 
(ACLs) for this namespace in the certificate generator. See Set up a secure connection to the 
Hermes Messaging Service.

Delete a namespace in Hermes

Prevent topics from being added to a namespace by deleting the namespace in Hermes.

Before you begin
Role required: hermes_admin or kafka_namespace_admin

About this task
You can't delete a namespace if any active topics belong to it. You must delete or deactivate the 
topics in a namespace before you can delete the namespace.

Procedure

1. Navigate to All  > Hermes Messaging Service  > Namespaces.

2. Select a namespace that you want to delete.

3. Select Delete.

Result
The namespace record is deleted from the Kafka Namespace [sys_kafka_namespace] table.

Managing topics in Hermes

Manage topic records in your instance and Kafka topics in the Hermes  Kafka cluster using the 
Hermes Messaging Service.

Topic records

Messages are organized and stored in Kafka topics in the Hermes  Kafka cluster. Topic records 
are stored in the Kafka Topics [sys_kafka_topic] table in your instance. This table shows a list of 

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4271



topics records with a reference to each topic's namespace. Each topic record has a field for the 
topic's name, related namespace, and whether the topic is active.

Values in the Name column of the Kafka Topics [sys_kafka_topic] table aren't inherently unique. 
For example, topic records might have the same Name value when they belong to different 
namespaces or exist in different clusters. However, values in the Full Name column are always 
unique.

A scheduled job runs regularly to synchronize topic records with the topics found in Hermes. This 
job performs the following functions:

• Creates topic records for any discovered topics, assigning them to the appropriate namespace 
based on the prefix for the topic name.

• Synchronizes topics created from external sources, such as the Kafka command-line interface 
(CLI). For example, when a topic is created from an external source on the near cluster, the job 
runs and creates the topic on the far cluster as well.

• Logs a warning message if a topic can't be matched to any namespace. If a topic can't be 
matched to any namespace, the topic record isn't created. There's a default, prefix-less 
namespace called the Default Namespace that matches all topics. The only time a topic 
doesn't match any namespace is when the Default Namespace has been deleted or modified.

• Marks topics as inactive if no Kafka topic was found for them.

You can monitor and view topics in the Hermes  Kafka cluster using the topic inspector. For more 
information, see Monitoring topics in the Hermes Kafka cluster.

Kafka topics are specific to a particular instance. This means you can't migrate a topic record 
from the Kafka Topics [sys_kafka_topic] table to another instance using an update set. Instead, 
you must manually create the topic in the target instance.

Creating topics

You can create topics in the Hermes  Kafka cluster using either of the following methods:

• Create the topic from your instance. This creates a record the Kafka Topics [sys_kafka_topic] 
table and creates a Kafka topic in the Hermes  Kafka cluster. See Create a topic in Hermes.

• Create the topic externally. For example, create the topic using the Kafka command-line 
interface (CLI).

Note: 
To avoid syncing issues between the cluster and your instance, include 
the application ID when creating topics externally. For example, 
without the application ID, a topic created from the CLI with a name like 
snc.instancename.fulfillment.topicname  is created in the default 
namespace instead of the fulfillment  namespace. To ensure the topic is created in 
the fulfillment  namespace, include the application ID in the name using the format 
snc.instancename.fulfillment.app_id.topicname. Replace app_id  with 
the application ID of your choice.

If, for some reason, a topic can't be created in the Hermes  Kafka cluster, it won't be created in the 
Kafka Topics [sys_kafka_topic] table either.

Updating topics

If necessary, you can change the number of partitions in a topic. Note that you can only increase 
the number of partitions in a topic. For more information, see Update a topic in Hermes.
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After it's created, the namespace assigned to a topic record is permanent. If you create a 
namespace record and want to move existing topics to it, you must delete the topics and 
recreate them in the Hermes  Kafka cluster with the new namespace prefix. If the topics weren't 
created through the instance, new topic records will be created and assigned to the matching 
namespace record after a rescan.

Deleting topics

You can delete topics from the Hermes  Kafka cluster using either of the following methods:

• Delete the topic directly from the Kafka Topics [sys_kafka_topic] table in your instance. This 
method automatically deletes the topic from all the Hermes  Kafka clusters in one action. See 
Delete a topic in Hermes

• Delete the topic externally. For example, delete the topic using the Kafka command-line 
interface (CLI).

Important: 
Deleting the topic externally requires that you delete the topic from both Hermes  clusters 
manually by specifying each set of ports (410x and 420x). If possible, delete the topic 
through the instance instead.

You can't delete a topic if it has subscriptions in Stream Connect.

Rescanning topics

Rescanning creates topic records for any topics in the Hermes  Kafka cluster that don't already 
have corresponding topic records. For example, if you create topics in Hermes  using the CLI, 
you can rescan to create corresponding topic records in the Kafka Topics [sys_kafka_topic] table 
immediately instead of waiting for the scheduled job to create them.

• The rescan occurs automatically every ten minutes.

• Created topic records are assigned to existing namespaces based on prefix matching rules.

Sometimes topic records in your instance don't match what's in Hermes. This situation can 
happen in the following cases:

• When the ServiceNow  Integration Hub  Kafka Consumer (com.glide.hub.kafka_consumer) 
plugin is enabled after there are already topics in Hermes.

• When topic records are deleted accidentally.

• When namespace definitions are changed, and you want to assign existing topics to the new 
namespaces.

Create a topic in Hermes

Create a topic from within ServiceNow. Creating a topic from your instance adds a topic record to 
the Kafka Topics [sys_kafka_topic] table and adds a Kafka topic to Hermes.

Before you begin
Role required: kafka_admin

Procedure

1. Navigate to All  > Hermes Messaging Service  > Topics.

2. Select New.

3. On the form, fill in the fields.
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Kafka Topic Form

Field Description

Name Name of the topic.

The string that you enter is combined with the 
application ID and namespace to create the 
full Kafka topic name.

Note: 
Don't include the 
snc.<instance_name>  prefix with 
the topic name.

Application ID Application associated with the topic. Default 
is Stream Connect.

Namespace
Namespace associated with the topic.

You can either select a namespace created 
by the Kafka namespace administrator or 
select the Default Namespace if separate 
namespaces aren't configured for your 
instance.

In ServiceNow, all Kafka topics link to a 
namespace. Namespaces are used to 
organize topics and, on a domain-separated 
instance, for domain separation. When 
a namespace is assigned to a particular 
domain, all the topics created in that 
namespace have the same domain.

Partitions
Number of partitions to create for the topic.

◦ Minimum value: 1

◦ Maximum value: 32

◦ Default value: 1

Active Option to activate the topic.

4. Select Submit.

Result
The topic appears in both the Kafka Topics [sys_kafka_topic] table and in Hermes. If, for 
some reason, a topic can't be created in Hermes, it won't be created in the Kafka Topics 
[sys_kafka_topic] table either.

Update a topic in Hermes

Update a Kafka topic in Hermes  by modifying the topic record.

Before you begin
Role required: kafka_admin
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Procedure

1. Navigate to All  > Hermes Messaging Service  > Topics.

2. Select the topic record that you want to update.

3. Optional:  Change the number of partitions in the topic.
Note the following restrictions:

◦ You can only increase the number of partitions.

◦ A topic can have up to 32 partitions.

4. Optional:  Change the topic's activation status.

5. Select Update.

Result
The topic record and the Kafka topic in the Hermes  Kafka cluster are updated.

If an error occurs when updating the partition count, you can synchronize the topic's partition 
count across Hermes  Kafka clusters by selecting Synchronize Partition Count.

Delete a topic in Hermes

Remove a topic and its messages by deleting it from Hermes. Deleting a topic record deletes it 
from your instance and from the Hermes  Kafka cluster.

Before you begin
Role required: kafka_admin

Procedure

1. Navigate to All  > Hermes Messaging Service  > Topics.

2. Select the topic that you want to delete.

3. Select Delete.

Result
The topic record is deleted from the Kafka Topics [sys_kafka_topic] table. The corresponding 
Kafka topic is deleted from the Hermes  Kafka cluster.

Rescan topics in Hermes

Synchronize topic records in your instance with topics in the Hermes  Kafka cluster by 
rescanning.

Before you begin
Role required: kafka_admin

Procedure

1. Navigate to All  > Hermes Messaging Service  > Rescan Topics.

2. Synchronize topics by selecting Confirm.

3. Optional:  After the rescan finishes, view the script execution history.

Result
Topic records are added to the Kafka Topics [sys_kafka_topic] table for each topic discovered 
in the Hermes  Kafka cluster. The topic refresh date and time that appears in All  > Hermes 
Messaging Service  > Topics  is updated.
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Monitoring topics in the Hermes  Kafka cluster

Monitor message processing and view topics in the Hermes  Kafka cluster that belong to you 
using the Hermes Messaging Service  topic inspector.

Tracking messages in partitions

You can track messages in the Hermes  Kafka cluster by viewing partition information.

• Determine whether your messages are reaching the Hermes  Kafka cluster by checking 
whether the end offset value changes when you produce messages to a topic.

• Determine whether messages have expired by noting the beginning offset value, which 
increases as messages expire. If you send messages to a topic but the beginning offset is 
higher than you expect, some of the messages have already expired. Messages expire in the 
Hermes  Kafka cluster after 36 hours.

Tracking consumer progress

You can track the progress of processing messages for each consumer by viewing consumer 
information.

• View the consumers for each partition in a topic, including the group ID and consumer ID for 
each consumer.

• Determine which message a consumer is processing by viewing the Current Offset  column.

• Determine whether the consumer is delayed by checking the Lag  column. The lag is the 
difference between the current offset and the end offset that indicates how many messages 
remain.

Inspecting message details

You can detect problems with consuming messages using the topic inspector. For example, if a 
message that you produced isn't consumed from the Hermes  Kafka cluster, you can validate the 
payload and message key by inspecting the topic. You can also download the full payload and 
save it as a file on your local machine.

You can view messages as binary data in base-64 encoding instead of UTF8 strings by adding a 
system property. See Hermes Messaging Service properties.

View a message in a Hermes  topic

View the payload of a message in a Hermes  topic using the Hermes Messaging Service  topic 
inspector.

Before you begin
Role required: hermes_admin, kafka_namespace_admin, or admin

Important: 
Administrators with the kafka_namespace_admin role can view message data across 
different domains.

About this task

Note: 
Messages expire after 36 hours.
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Procedure

1. Navigate to All  > Hermes Messaging Service  > Topic inspector.

2. Optional:  View topics from a specific cluster by selecting a datacenter in the Select 
Datacenter  drop-down list.
The near cluster, the far cluster, and the number of topics on the instance are listed above the 
table of topics.

3. Optional:  View messages in a specific partition.

a. Select Load Partition Info.

b. In the Read from Partition  drop-down list, select a partition.

4. Retrieve messages from a topic that you want to inspect.

a. Select Inspect Topic.

b. Select a topic in the table.

c. Select the number of messages that you want to view in the Number of messages  list.

d. Enter a date in the past to use a starting point for retrieving messages in the Message start 
date (UTC)  field.

5. View the message details and payload.

Note: 
To view headers, keys, or messages that are greater than 20 characters, select the View 
link or download the data.

Message details

Field Description

Offset The Hermes  Kafka cluster's datacenter 
identifier and the position of the message in 
the partition.

Partition Partition of the topic where the message is 
stored.

Timestamp Date and time when the message was 
created.

Headers Message header.

Key Message key.

Payload Message body contents. Note the following 
information about the message payload:

◦ The topic inspector automatically replaces 
some characters with escape characters in 
message payload text data.

◦ The message size that is displayed is the 
size of the payload as viewed in the topic 
inspector and not necessarily the size of 
the message as it exists in the Hermes 
Kafka cluster.

Hermes Messaging Service  administration

Monitor the Hermes Messaging Service  by viewing diagnostics and inspecting topics.
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Check the status of and connection to the Hermes  Kafka cluster

Check the status of and test the connection to the Hermes  Kafka cluster by sending and 
receiving test messages.

Before you begin
Role required: admin or hermes_admin

Procedure

1. Navigate to All  > Hermes Messaging Service  > Diagnostics.
The dashboard loads and Hermes  diagnostic tests are run automatically verifying instance 
public key infrastructure (PKI) configuration, external port status, and Glide Hermes Message 
Queue plugin (com.glide.hermes) activation.

If any of the tests fail, contact Customer Service and Support.

2. View the producer and consumer bootstrap addresses that you can use to connect to Hermes 
in the Setup Information section.
Use these port mappings to connect producer and consumer clients to the Kafka cluster 
bootstrap addresses, as described in Exchanging data using the Hermes Messaging Service.

Note: 
When configuring consumer clients, you must configure two clients using ports in 
separate ranges: one in 4100-4150 and another in 4200-4250.

3. Verify that the instance can act as an issuer in an x.509 trust hierarchy.

a. Expand the Instance PKI  container.

b. View the configuration status.

c. View additional instance PKI details on the Key Management Framework Health page by 
selecting View more.

The instance PKI configuration status is displayed. If the configuration is valid, you can secure 
connections to Hermes by following the steps in Set up a secure connection to the Hermes 
Messaging Service. If the configuration is invalid, contact Customer Service and Support.

4. Confirm availability of the external ports used to connect to the Hermes  Kafka cluster.

a. Expand the Bootstrap Connectivity  container.

b. Select Run Test.

In the range of ports required for Hermes, the following ports are checked:

◦ 4000, 4001, 4002, 4003 producer client ports

◦ 4100, 4102, 4102, and 4103 consumer client ports

◦ 4200, 4201, 4202, and 4203 consumer client ports

If the ports aren't open, contact Customer Service and Support.

5. Confirm that the instance is able to send messages to and receive messages from the Hermes 
Kafka cluster.

a. Expand the Instance Connectivity  container.

b. Select Run Test.
Test Message Send and Test Message Receive results are displayed including the elapsed 
time, datacenter, and bootstrap information for each operation. If the tests fail, contact 
Customer Service and Support.

6. Verify the timestamp of the most recent message from a topic in the Hermes  Kafka cluster.
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a. Expand the View Topics  container.

b. View the timestamp for an external topic's last known message by selecting the topic name 
in the External Topics  column.

c. View the timestamp for an internal topic's last known message by selecting the topic name in 
the Internal Topics  column.

The message's timestamp is displayed. To view full details for a topic, use the Hermes  Topic 
Inspector. See Monitoring topics in the Hermes Kafka cluster.

Tracking Hermes Messaging Service  Message usage

Message usage through the Hermes Messaging Service  is tracked for monitoring and 
management purposes through the Kafka topic name.

You access the Hermes Messaging Service  exclusively through integrations with other 
applications, such as Stream Connect  and Log Export Service.

You can access Kafka topics in your namespace using the following naming convention:

snc.<instance_name>.<namespace>.sn_<app_id>.<topic_name>

where:

• snc.<instance_name>  is your namespace prefix

• <namespace>  is the namespace of the domain your Kafka topic belongs to (optional)

• sn_<app_id>  is your application ID

• <topic_name>  is your unique topic name

Note: 
The full topic name is case-sensitive and limited to 200 characters.

Kafka message usage and licensing impact vary by application. License usage is tracked at the 
application level.

Cloning with Hermes Messaging Service  enabled

To clone your database from one instance to another successfully with Hermes  enabled, you 
must ensure that certain Hermes  tables are preserved and excluded. The list of tables in the 
preserve list should match those in the exclude list and vice versa.

Before you request a clone, verify the Hermes  tables in the preserve and exclude lists. For 
example, make sure the sys_kafka_topic table is in the preserve list to maintain the current 
Hermes  topics in the target instance. If the sys_kafka_topic table is not preserved, it is 
overwritten when the clone operation occurs.

The following sections assume that Hermes  is installed on both the source and target instances 
before the clone. For example, if Hermes  is not installed on the target instance, there are no 
Hermes  tables to preserve.
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Important: 
If you clone an instance without Hermes  installed to an instance with Hermes  installed, the 
Hermes  tables in the target instance are removed.

To avoid losing this data, capture the data in the following Hermes  tables using an update 
set:

• hermes_cluster_config

• hermes_topics_state

• hermes_topic_location

• hermes_topics_metrics

• hermes_metrics

You must ensure the hermes_cluster_config and hermes_topic_location tables are 
preserved to ensure the Hermes Messaging Service  is functional.

Hermes  tables to preserve

Add the following Hermes  tables to the Clone Data Preservers list if they're missing. Remove any 
Hermes  tables that aren't in this list.

• hermes_cluster_config

• hermes_metrics

• hermes_topics_metrics

• hermes_topics_state

• hermes_topic_location

• sys_kafka_namespace

• sys_kafka_topic

Hermes  tables to exclude

Add the following Hermes  tables to the Clone Exclude Tables list if they're missing. Remove any 
Hermes  tables that aren't in this list.

• hermes_cluster_config

• hermes_metrics

• hermes_topics_metrics

• hermes_topics_state

• hermes_topic_location

• sys_kafka_namespace

• sys_kafka_topic

View Hermes Messaging Service  log messages

Review Hermes  event details by viewing log messages.

Before you begin
Role required: admin
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Procedure

1. Navigate to All  > System Log  > All.
The Log [syslog] table displays all system log messages.

2. View logs only related to Hermes  by adding a filter.

a. Select the filter icon ( ).

b. Set a condition with a field, operator, and search string.

Example 
For example, [Source] [contains] [Hermes].

c. Select Run.

Result
The Log [syslog] table displays only the Hermes Messaging Service  log messages.

Hermes Messaging Service  reference

Reference topics provide details on the Hermes Messaging Service  components and the 
security model.

Hermes Messaging Service  components

The Hermes Messaging Service  architecture is built on the following components.

Hermes Messaging Service  components

Component Description

Hermes  Message Queue A dedicated multi-tenant message queue 
in the ServiceNow  Hermes  Kafka cluster 
for managing the flow of data to and from 
the instance. The message queue uses 
certificate-based authentication that supports 
bi-directional traffic. The Hermes  Message 
Queue is available to ServiceNow  applications 
via the Hermes  Glide API.

Hermes  Gateway Part of the ServiceNow  datacenter that 
enables you to connect to a ServiceNow 
endpoint to read and write data to the Hermes 
Message Queue.

Hermes  Glide connector Connector that integrates instance 
functionality (for example, flows, data export, 
and data replication) with the Hermes 
Message Queue via the API.

Hermes Messaging Service  security model

The Hermes Messaging Service  security model relies on the following capabilities.
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Hermes Messaging Service  security model

Capability Description

Namespaces and data isolation All Kafka topics are namespaced per 
customer. You can only view topics that belong 
to you and your topics aren't visible to anyone 
else.

Authentication and authorization The Hermes Messaging Service  requires 
certificate-based authentication using mTLS 
endpoint authentication with trusted identities 
and authorization based on identity.

Domain separation Domain separation is supported with the 
Hermes Messaging Service. See Hermes 
Messaging Service domain separation.

High-availability Failover is provided by multiple Kafka clusters 
running in separate ServiceNow  datacenters.

Hermes Messaging Service  properties

These system properties control the behavior of the Hermes Messaging Service.

To set Hermes Messaging Service  system properties, navigate to the System Properties 
[sys_properties] table and add the property.

System properties

Encoding format for message payload in the 
Hermes Messaging Service  topic inspector

glide.hermes.topic.inspector.payload.format

By default, messages in the Payload  column 
are displayed as strings in UTF8. You can 
display binary data using base-64 encoding 
by adding this system property and setting the 
value to binary.

• string: display message payload in UTF8

• binary: display message payload in base64

Encoding format for message keys in the 
Hermes Messaging Service  topic inspector

glide.hermes.topic.inspector.key.format

By default, identifiers in the Keys  column are 
displayed as strings in UTF8. You can display 
binary data using base-64 encoding by adding 
this system property and setting the value to 
binary.

• string: display keys in UTF8

• binary: display keys in base64

Hermes Messaging Service  roles

Hermes Messaging Service  is installed with these roles.

To learn more about managing subscriptions, see Managing per-user subscriptions in 
Subscription Management  and contact your account representative.
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Hermes Messaging Service  administrator  [hermes_admin]

Enables users to access the Hermes Messaging Service  Topic Inspector.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

Note: 
Avoid granting an admin role when more specialized roles are available.

Kafka administrator  [kafka_admin]

Enables users to manage the integration with Apache Kafka, including topics and settings related 
to Kafka subscriptions.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

Note: 
Avoid granting an admin role when more specialized roles are available.

Kafka namespace administrator  [kafka_namespace_admin]

Enables users to manage Kafka namespace definitions.

Contains Roles

List of roles contained within the role: kafka_admin.

Groups

List of groups this role is assigned to by default.

None.
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Special considerations

Stream Connect  administrators with the kafka_namespace_admin role can view message data 
across different domains.

For example, in a Managed Service Provider (MSP) instance with Kafka integrations in multiple 
domains, managing namespace definitions properly is important to maintain separation between 
domains, so don't grant this role to administrators within a single domain.

Hermes Messaging Service  domain separation

Domain separation is supported for the Hermes Messaging Service. Domain separation enables 
you to separate data, processes, and administrative tasks into logical groupings called domains. 
You can control several aspects of this separation, including which users can see and access 
data.

Support level: Basic

• Business logic: Ensure that data goes into the proper domain for the application’s service 
provider use cases.

• The application supports domain separation at run time. The domain separation includes 
separation from the user interface, cache keys, reporting, rollups, and aggregations.

• The owner of the instance must set up the application to function across multiple tenants.

Sample use case: When a service provider (SP) uses chat to respond to a tenant-customer’s 
message, the customer must be able to see the SP's response.

For more information on support levels, see Application support for domain separation .

Overview

On a domain-separated instance, you can use namespaces to configure which domains can 
access specific topics in the Hermes  Kafka cluster. You assign topics to ServiceNow  domains 
using the topic record's namespace.

How domain separation works with the Hermes Messaging Service

On a domain-separated instance, a user with the kafka_namespace_admin role can assign 
namespaces to specific ServiceNow  domains. When the Kafka namespace admin assigns a 
namespace to a particular domain, all the topics created in that namespace will have the same 
domain. Users can only see and interact with the topics and namespaces they have access 
to, based on domain visibility and access control lists (ACLs). Topics created with the Default 
Namespace are created in the global domain.

Both the Kafka Topics [sys_kafka_topic] table and the Kafka Namespaces 
[sys_kafka_namespace] table are domain-separated tables. Domain separation rules filter which 
records are available in each domain. In addition to being domain-separated, these tables can 
also be protected with ACLs, just like any other table.

All domain support features require the Domain Support - Domain Extensions Installer 
(com.glide.domain.msp_extensions.installer) plugin.

Related topics

Domain separation for service providers
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Password Reset
The ServiceNow®  Password Reset  application enforces strong and secure passwords by 
enabling end users to reset or change their passwords either by using the self-service process or 
by requesting the assistance of a service desk agent.

Password Reset  for Virtual Agent

Augment an end-user experience with Password Reset  for ServiceNow®  Virtual Agent  that 
handles common support issues, using pre-built conversations.

Password Reset Windows Application

The Password Reset Windows Application  enables a user, who forgets the password or is locked 
out of a Windows  computer, to reset the password directly from the Windows  login screen.

Watch this video to get an overview of the Password Reset  application.

Overview of the ServiceNow  Password Reset  application, as well as the Password Reset  for 
Virtual Agent, Password Reset Windows Application, and Password Reset  Interactive voice 
response (IVR).

Get started

Explore

Learn about Password Reset
concepts and features.

Set up and configure

Set up and configure 
Password Reset for your users.

Enroll for Password Reset

Enroll for Password Reset.

Reference

Get details about components 
like fields and properties.

Exploring Password Reset

Get an overview of Password Reset, Password Reset Windows Application, and Password Reset 
for Virtual Agent.

Understand how to set up, configure, and use Password Reset  and Password Reset Windows 
Application  for your organization.
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Password Reset  The Password Reset  application enforces strong and secure passwords by 
enabling end users to reset or change their passwords either by using the self-service process or 
by requesting the assistance of a service desk agent.

Password Reset for Virtual Agent  Augment an end-user experience with Password Reset  for 
Virtual Agent  that handles common support issues, using pre-built conversations.

Password Reset Windows Application  The Password Reset Windows Application  enables a user, 
who forgets the password or is locked out of a Windows  computer, to reset the password directly 
from the Windows  login screen.

Related topics

Installed with Password Reset

Domain separation and the Password Reset application

Password Reset

The Password Reset  application enforces strong and secure passwords by enabling end users 
to reset or change their passwords either by using the self-service process or by requesting the 
assistance of a service desk agent.

Password Reset  application features

Manage enrollment

Automatically enrolls end users or allows manual enrollment.

Verification types

Validates user authenticity with the help various verifications.

Integrated plugins

Resets passwords directly from the Windows  application and Microsoft  Azure  active 
directory (AD).

Enrollment types

Enables end users to enroll in different password reset programs at their 
convenience.

Homepages with a dashboard view

Password Reset  has a new, modernized look and feel. For more information, see 
Next Experience UI .

Password Reset  processes
Users with the password_reset_admin role configure how the process of resetting a password 
works for an end user.

• Self-service process:

Users reset passwords over the internet using a browser on any supported interface, including 
mobile devices.

• Service Desk  assisted process:

Users request the assistance of a service desk agent, over the phone or in person. In this 
process, users don't reset passwords.

For more information, see Configuring Password Reset  and Plan your Password Reset processes.
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Self-service and Service Desk  - assisted processes

In addition to configuring the connections, user groups, and verifications, you can specify one of 
the following operational methods for the organization:

Self-service process

End users reset passwords using a browser on any supported interface, including 
mobile devices. They can provide the identifying information and answer questions 
or submit a securely delivered code number. The following example shows the 
default self-service process Password Reset  flow:

1. If a user doesn't remember their password, the user clicks Forgot Password  on 
the Login page.

2. The Password Reset  application starts. On the Identify page, the user enters their 
identifying information (generally the user name or email address). The example 
includes the default CAPTCHA security feature. The user provides identification 
by entering a user name and CAPTCHA, and clicks Next.

Note: 
Users can hear characters displayed in CAPTCHA by clicking the Speak the 

CAPTCHA icon ( ) displayed in the pop-up window for the Identify step.
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3. On the Verify  tab, the user provides personal data associated with their user 
name. For example, the user can either enter the email address associated 
with the user profile or answer the security question that an administrator has 
configured. This information is specified while enrolling in the Password Reset 
process. The administrator can configure a different verification method. For 
example, a personal question that only the user can answer.

Note: 
Other possible verifications require the user to enter a code number that 
was sent to a mobile device by SMS text, through the Google  Authenticator 
app, or by email.

4. The Reset page tells the user to check email for instructions.

5. The user opens the email and clicks the link in the email to reset the password. 
The link is valid for a period of time that an administrator specifies by using the 
password_reset.request.expiry  property.

6. The Reset Password page guides the user to reset the password.

7. The system checks the credential store to verify the identity and then displays the 
new password on the Reset page.

Service desk-assisted process

An end user requests the assistance of a Service Desk  agent, over the phone or 
in person. The agent processes the request. Each Service Desk  agent has the 
Password Reset  admin Service Desk  role. The Reset request form that the agent 
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contains a Select user  field and a Select process  field. On the form, the agent can 
view all processes in the end user’s domain.

Next steps

Based on your role, do these steps:

• If you're an administrator, start configuring Password Reset  for your users.

• If you're an end user who wants to reset a password, start enrolling to reset your password.

Password Reset  for Virtual Agent

Augment an end-user experience with Password Reset  for Virtual Agent  that handles common 
support issues, using pre-built conversations.

For more information about the Virtual Agent, see Virtual Agent.

Your end users can perform the following actions through the Virtual Agent  conversations:

• Reset a password

• Change a password

• Unlock an account

• Enroll to reset passwords

The end users can reset passwords and unlock accounts even if they aren’t logged in. When the 
users are logged in, they can do all the actions including changing passwords. After changing or 
resetting a password, the users can’t change or reset the password for the next 24 hours.

Related topics

Password management topics for ITSM Virtual Agent

Password Reset Windows Application

The Password Reset Windows Application  enables a user, who forgets the password or is locked 
out of a Windows  computer, to reset the password directly from the Windows  login screen.

How the Password Reset Windows Application  works

Administrators download and run an EXE or MSI file to install or distribute the application to user 
computers. The application installs a link on the Windows  login screen. The user clicks the link 
(Forgot Password  as depicted in the examples on various Windows  versions) and is then guided 
through the process of resetting the password.

If your user is using Windows, 8.1, 10, or 11 operating system on the computer, a pop-up window 
opens after the user clicks the Forgot Password  link. On the pop-up window, the user enters the 
user name. For the multi-identification type, the user enters a user name and email address and 
enters the displayed CAPTCHA if enabled for the process. If the CAPTCHA is incorrect, the user 
gets an error message.
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This is an identification step, which takes the user to the verification step after clicking next  on 
the pop-up window.

In the Verify step, the users can verify themselves using one of the following configured 
verification types for security:

• Personal data: The user enters a user name or email. The personal data verifications compare 
the user’s answers with the available details. For example, the email address entered by the 
user must match with the available registered email address.

• Authenticator app: The user enters the code generated by an authenticator app.

• Security Questions: The user enters the answers to the security questions.
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• SMS: The user enters the verification code sent to the registered mobile number.

• Email: The user enters the verification code sent to the registered email address.

• Soft PIN: The user enters a soft PIN.

For example, the following images show verification using email.

After the successful verification, the users go to the Reset step. Based on the status of the user 
account and email provided, the reset step contains various types.
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• If the user account isn’t locked, the user enters a new password, enters the same password 
again in the Retype password  field, and clicks Reset Password.

• If the user account is locked, the user gets a message stating the account is locked, and if 
enabled, the user can view an option to unlock the account, or the user can continue resetting 
the password. For example, the following image shows both the Unlock Account  and Reset 
Password  buttons.

• After the reset password process is complete, based on the configured type, the user 
either gets the auto-generated password on the pop-up window or an email containing the 
instructions to reset the password is sent to the user.

Setting up Password Reset

The Password Reset  application is active by default and includes example verifications. The 
base system  enables connections only to the local ServiceNow  instance credential store types.

Requirements

Role required: admin

Note: 
The Password Reset  application is not available during an upgrade.

Active and available plugins

• To enable connections to Active Directory (AD) and Remote (SOAP) ServiceNow  Instance 
credential store types, activate the Password Reset  Windows  App (Password Reset 
Orchestration) (com.glideapp.password_reset_desktop) plugin and Microsoft  AD for Password 
Reset  store app. No other components are installed. Orchestration  is available as a separate 
subscription. See Request the Password Reset Windows App plugin.

• To enable connections to Microsoft  Entra ID Integration for Password Reset, Integrate 
Microsoft Entra ID Integration with Password Reset  and Configure the connection to Microsoft 
Entra ID Credential Store.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4292



Next steps

Plan and configure the Password Reset  processes for your organization. See the Configuring 
Password Reset.

Set up Microsoft  Entra ID for Password Reset

Set up Microsoft  Entra ID for Password Reset  by activating the plugin and configuring the 
Microsoft  Entra ID instance. The Microsoft  Entra ID plugin is activated with the help of this plugin. 
Microsoft  Entra ID for Password Reset  is also available in the ServiceNow  store.

Related topics

Request the Microsoft Entra ID Integration for Password Reset app

Request the Microsoft  Entra ID Integration for Password Reset  app

Microsoft  Entra ID users can reset passwords with the Microsoft  Entra ID Integration for Password 
Reset  app.

Before you begin
Role required: admin

About this task
You can request the plugin from Now Support  (HI) or from your instance.

In Now Support, navigate to Service Catalog  Activate Plugin.

Or you can complete the following procedure.

Procedure

1. In your instance, navigate to System Applications  > All Available Applications  > All.

2. On the All Applications page, select Request Plugin  to open the request form on Now Support.

3. On Now Support, select to be redirected to the HI Service Portal Service Catalog.

4. On the Activate Plugin request form, fill in the fields.

Field Description

Target Instance Instance on which to activate the plugin.

Plugin Name Name of the plugin to activate.

Specify the date and time you would like this 
plugin to be enabled The date and time must be at least two 

business days from the current date.

Note: 
By default, plugins are activated in two 
batches each business day: once in 
the morning and once in the evening, 
Pacific (U.S.) time. If you need your 
plugin activated at a specific time, 
enter a request for this in the Reason/
Comments field.

Reason/Comments Information that would be helpful for 
ServiceNow  personnel who will activate the 
plugin. For example, if you need the plugin 
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Field Description

activated on a specific day or time instead of 
during one of the default activation windows, 
specify it in the comments.

5. Click Submit.
The Microsoft  Entra ID Integration for Password Reset  app is activated.

What to do next
Plan, create, and customize  the Password Reset  process for your organization.

Set up Microsoft Active Directory  for Password Reset

Enable connections to Active Directory (AD) by activating the Password Reset  Windows  App and 
Microsoft  AD for Password Reset  available in the ServiceNow Store.

Set up Password Reset  integration with Okta

Enables end users to reset or change their Okta  passwords using Password Reset  and Okta 
spoke.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Integration Hub  subscription

This application requires an Integration Hub  or Automation Engine  subscription. For more 
information, see Legal schedules - Integration Hub overview .

Application version

Password Reset  integration with Okta  1.1.2 is the latest version.

Dependencies

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

• Okta spoke v 4.1.3

• ServiceNow IntegrationHub Action Template - Data Stream 
(com.glide.hub.action_type.datastream)

• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)

• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)

Note: 
Some of these plugins are licensable features and require appropriate licenses, if used 
outside the application implementation.

Subflows

The Password Reset integration with Okta  application provides these subflows that automate the 
Password Reset  tasks:
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Subflow Description

Password Change Changes password of the required Okta  user.

Password Connection 
Test

Tests connection to Okta.

Password Lock State Checks the lock status of the specified user account in Okta.

Password Reset Resets the password of the specified Okta  user.

Password Unlock Unlocks the required user account in Okta.

Send Email After 
Change Password

Sends a password change notification email to the user. This subflow is 
used in the Password Change subflow.

Actions

The Password Reset  integration with Okta  provides the Get Configuration Variables for Okta 
Reset Process action to retrieve the user name of the required Okta  user and the details of all 
variables.

Set up the Password Reset  integration with Okta

Customize the default credential store records and password reset processes to integrate 
Password Reset  with Okta.

Before you begin

• Request Integration Hub  subscription.

• Activate Password Reset

• Activate and set up the Okta  spoke.

• Activate Password Reset  integration with Okta.

• Role required: admin

Procedure

1. Navigate to Password Reset  > Credential Stores.

2. Open the record for Password Reset  integration with Okta.
For example, Sample Okta Credential Store

3. Customize the default record as per your requirement.
For more information, see Configure the connection to a credential store for the Password 
Reset processes.

4. Navigate to Password Reset  > Processes.

5. Customize the default records, Service-Desk Process for Okta  and Employee Self-Service 
Process for Okta , as per your requirement..

Note: 
The User must reset password  check box isn't supported in this integration. That is, you 
can't enforce users to reset their password upon first login after they reset password 
using the auto-generated password.

For more information, see Configure your Password Reset process.
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Set up Password Reset  integration with  Google  Directory

Enables end users to reset their Google  passwords using Password Reset  and  Google  Directory 
spoke.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Integration Hub  subscription

This application requires an Integration Hub  or Automation Engine  subscription. For more 
information, see Legal schedules - Integration Hub overview .

Application version

Password Reset  integration with  Google  Directory  1.0.3 is the latest version.

Dependencies

If you’re having trouble installing the app, ensure that these dependent plugins are installed:

• Google  Directory spoke  v 1.3.1 or higher

• ServiceNow IntegrationHub Action Template - Data Stream 
(com.glide.hub.action_type.datastream)

• ServiceNow IntegrationHub Action Step - REST (com.glide.hub.action_step.rest)

• ServiceNow IntegrationHub Runtime (com.glide.hub.integration.runtime)

Note: 
Some of these plugins are licensable features and require appropriate licenses, if used 
outside the application implementation.

Subflows

The Password Reset integration with  Google  Directory   application provides these subflows that 
automate the Password Reset  tasks:

Subflow Description

Password Connection 
Test

Tests connection to  Google  Directory.

Password Lock State Checks the lock status of the specified user account in  Google 
Directory.

Password Reset Resets the password of the specified  Google  Directory  user.

Password Unlock Unlocks the required user account in  Google  Directory.

Actions

The Password Reset integration with  Google  Directory   provides the Get Configuration Variables 
for  Google  Directory  Reset Process action to retrieve the user name of the required  Google 
Directory  user and the details of all variables.
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Set up the Password Reset  integration with Google  Directory

Customize the default credential store records and password reset processes to integrate 
Password Reset  with  Google  Directory.

Before you begin

• Request Integration Hub  subscription.

• Activate Password Reset

• Activate and set up the Google  Directory spoke .

• Activate Password Reset  integration with  Google  Directory.

• Role required: admin

Procedure

1. Navigate to Password Reset  > Credential Stores.

2. Open the record for Password Reset  integration with  Google  Directory.
For example, Sample Google Directory Credential Store .

3. Customize the default record as per your requirement.
For more information, see Configure the connection to a credential store for the Password 
Reset processes.

4. Navigate to Password Reset  > Processes.

5. Customize the default records, Sample Service-Desk Process for Google Directory  and 
Sample Employee Self-Service Process for Google Directory, as per your requirement.
For more information, see Configure your Password Reset process.

Note: 
Google  Directory  doesn't support password change. Hence, the Password change  check 
box on the process records isn’t supported in this integration.

Configuring Password Reset

The Password Reset  application enables an end user to reset or change a password using a self-
service process. Alternatively, your organization can implement a process that requires a service 
desk agent to reset passwords for end users.

Watch the video: Introducing Password Reset (video)

Elements of the Password Reset  process

You configure the following elements of the process for your organization:

• A connection to the credential store for your organization where user credentials, like user 
name and password, are securely stored.

• One or more user groups on the ServiceNow  instance that can use the password reset 
process.

• The type of identification  that users must enter to identify themselves (generally user name or 
email address).

• One or more verifications  — Methods to verify the identity of the user. Here are some examples 
of the verifications:
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◦ Question and answer: Answer a question that only the user knows (based on the Security 
Question verification  type).

◦ Email: Enter a code number that was emailed to the user.

◦ SMS: Enter a code number that was texted to a mobile device.

◦ Authenticator app: Enter a code that is displayed on your Authenticator app on a mobile 
device.

Note: 
Password Reset  supports the following authenticator apps:

▪ Google  Authenticator

▪ Microsoft  Authenticator

▪ Cisco  Duo

Implementing a Password Reset  process

1. Plan your implementation: Consider all applicable organizational guidelines, security policies, 
and areas of the organization.

2. Set up the elements of the password reset and password change processes according to the 
plan:

◦ Connection to the credential store.

◦ User groups that use the password reset process.

◦ Identification type to use.

◦ Verifications to use.

3. In the service desk-assisted model, assign service desk agents to monitor and reset 
passwords as needed.

4. Monitor password reset activity to identify security threats and to ensure compliance with the 
password policy requirements of your organization.

Password Reset Windows Application

If a user forgets the password or gets locked out of a Windows  computer, the user can reset the 
password directly from the Windows  login screen. The user clicks the Forgot Password?  link and 
is then guided through the process of resetting the password. To learn more, see Password Reset 
Windows Application.

Password Change application
The Password Change application extends the Password Reset  application by letting admins 
define how users change their passwords. Users can change their passwords by using a self-
service process.

1. The user logs in to the instance and then selects the All  > Password Reset  > Change 
Password  module or link from the user profile record. The user can also use the Password 
Change application on mobile devices.

Note: 
By default, the dark theme doesn't apply to the Change Password form. Users can 
change the theme to the dark theme. For more information about the dark theme, see 
Exploring themes in Next Experience .
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2. On the Change Password form, the user selects a Password Reset  process related to a 
credential store for which the user wants to change the password.

3. The user enters the old password and the new password.

Note: 

As the user enters a password, the New Password  field shows a message indicating 
whether the characters entered in the field are correct or not. For example, if a user 
enters a character that doesn't fit the password policy, the New Password  field shows an 
error message. The strength bar also shows the strength of the new password that the 
user has entered.

The password policy (granular password complexity) helps create a correct, strong 
password on the Change Password form in the Next Experience  and the Core UI.

4. After all the password rules are met, the workflows validate the old password, and then 
implement the new one.

5. The user types the new password again in the Retype password  field, and selects Change 
Password.

6. The system notifies the user that the password was changed.

Plan your Password Reset  processes

To ensure security and efficiency, take the time to plan your Password Reset  implementation.

Before you begin
Role required: password_reset_admin or admin

Procedure

1. Decide on the password reset process:

◦ Self-service process:  Users reset their password over the Internet using a browser on any 
supported interface, including mobile devices. To make the Password Reset  application with 
Orchestration available to all users publicly, create a new Password Reset  process only for 
this purpose and make it accessible to all users by setting the Public access  property. See 
Example: The default self-service Password Reset  process .

◦ Service desk-assisted process:  Users reset passwords by requesting the assistance 
of a service desk agent, over the phone or in person. Only service desk agents with the 
password_reset_service_desk role can reset user passwords. Watch the videos: Resetting 
User Passwords (Video)  and How to Set Up a Service Desk-Assisted Password Reset 
Process (Video) .

2. Decide how groups and roles differ in access and security needs.
Analyze and assess how members of each group in your organization access the system. For 
example, if members of the sales group primarily access the system remotely, consider using a 
stronger method or multiple methods to verify the identity of each user.

Identify user roles that have access to critical information and resources. For example, stronger 
verifications might be required for roles that have access to employee data, accounting 
information, or network configurations.

Based on your analysis of groups and roles, determine the number and variety of verifications 
needed for the different Password Reset  processes.

3. Decide how to manage credentials.
Determine whether single sign-on is enabled with the type of directory service or other 
credential store used. If the directory service is configured for single sign-on, consider 
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increasing the level of security by using multiple methods to verify identity of a user. A 
compromised user name and password can easily allow access to associated systems in a 
single sign-on environment.

4. Decide how to implement enrollment in the Password Reset  program.
For example, will enrollment be optional  or required? Will users be auto-enrolled? How will 
users be notified to enroll in the program? The answers to these questions will help you 
determine the appropriate verification types to use.

5. Decide which Password Reset  options to offer to users.

◦ If your organization uses single sign-on, how will users reset their password if they are 
unable to log on?

◦ What options are available to users working off-site?

Related topics

Configure your Password Reset process

Configure your Password Reset  process

To implement the process, you configure credentials, verification methods and settings, and 
enrollment settings. You also specify to which users the process applies.

Before you begin
Role required: password_reset_admin or admin

1. Be sure to Plan your Password Reset processes.

2. Create the credential store record for user names and passwords that are managed.

Note: 
For LDAP integrations: If the Active Directory settings require users to reset the password 
when logging in, the results depend on the installed Password Reset  plugin.

◦ The Password Reset  plugin cannot change an AD password. End users will not be able 
to log in to the instance.

◦ The Self Service Password Reset  plugin depends on the Password Reset  Basic plugin. 
Self service is intended for password reset only on the local ServiceNow  instance and 
cannot change an AD password. In order to change AD password, you must install the 
Microsoft AD spoke for Password Reset.

◦ The Password Reset  Windows  App (com.glideapp.password_reset_desktop) plugin 
supports changing the AD password.

3. Define the verifications that the process can use.

4. Configure Password Reset  to auto-enroll users or to enable users to enroll for the program. 
See Configure your Password Reset process to auto-enroll users  and Enable users to enroll for 
Password Reset.

About this task
A Password Reset  process consists of the following elements:

• The credential store that contains user login credentials.

• Optionally, the user groups that are authorized to use the Password Reset  process.

• The verifications that verify the identity of the requesting user and that enable the service desk 
agents to authorize reset of the password. (Verifications are implemented by script includes.)

• Process strength configuration that helps view the security score of the process. You see 
the score in digits and colors based on the verification methods you select for the process. If 
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enabled, notifications can be sent for potential configuration improvements to the process. If 
there are any deviations between the maximum attainable and current scores, an email with an 
actionable list of recommendations to improve the configuration is sent.

Procedure

1. Navigate to All  > Password Reset  > Processes.

2. Click New  and then specify a meaningful Name  and Description  for the process.

3. Select the Credential store  that contains the user credentials that the process applies to.

4. Specify the process that you are defining: Select the Password reset  check box, the 
Password change  check box, or both check boxes.

5. Specify the Apply to all users  setting.
For more information about the fields on the Password Reset Process form, see Password 
Reset Process form.

6. For Password Reset, configure settings on the Password Reset Details  tab.
For information about the settings and fields on the Password Reset Details  tab, see 
Description of the fields on the Password Reset Details  tab.

7. For Password Reset, configure settings of interest on the Advanced  tab.
For information about the fields on the Advanced  tab, see Description of the fields on the 
Advanced  tab.

8. For Password Reset, fill in any fields of interest on the Enrollment Reminder  tab.

9. Save your changes on the Password Reset  Process form.
The form refreshes, and additional related lists appear.

10. From the Password Reset Process Verifications  related list, select one or more verifications.

11. Optional:  From the Password Reset Process Groups  related list, select the user groups that 
use the process that you are defining.
The Password Reset Process Groups  related list appears only if the Apply to all users  check 
box is not selected.

12. Save the record and then select the Active  check box to enable the Password Reset  process 
that you configured.
The check box is available only after the record has been saved.

13. Click Update.

14. Navigate to Password Reset  > Properties  to set the properties that configure the Password 
Reset  experience for end users.

Related topics

Plan your Password Reset processes

Configure the required strength for passwords

Calculating the security score for password reset process

The security score of the password reset process is a critical metric for the password reset 
administrators to assess the strength and configuration of the password reset process.

Password reset calculation

The password reset process score provides a quantitative measure of how well the process is 
configured to protect against unauthorized access and confirm that only legitimate users can 
reset their passwords. The score is based on the following categories:
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• Identification score (Max: 20 points)

• Verification score (Max: 40 points)

• Configuration score (Max: 20 points)

• Password policy score (Max: 20 points)

Identification score

To increase your identification score, you must enable multiple identification methods. If you’re 
currently using only one method, such as a username, adding another method like an email can 
increase your score by approximately five points. Additionally, enabling CAPTCHA adds 10 points 
to your score and help to prevent the bots from exploiting the password reset flow.

Verification score

To achieve a high score, you must use at least two verification methods with medium or high 
security levels. Each method adds up to 15 points (medium) or 25 points (high).

For the custom verification types, you must assign the security level. By default the custom 
verification is set as low.

Configuration score

To optimize your score, enable either the Email/SMS Password Reset URL or auto-generate 
passwords. If neither is enabled, the score is set at 10 points. Enabling either of these options 
fetches 20 points.

Password Policy Score

To maximize your Password Policy Score, enable the Password Policy on the Credential Store 
if it isn’t active. Implement the Enforce History Policy to prevent users from reusing their last 
five passwords as defined in the password_history_limit  property. Use a High  strength 
password policy and enable the following settings:

Send password reset process security score notification  is a weekly job 
that send reminders to the password admin about the score and recommendations to improve 
the score. An email notification is sent to the Process Owners of all the active processes if 
Enable security score notification  option is selected in Password Reset Process form.

Configure password expiration reminder

You can configure the password reset expiration reminder feature to send notifications to change 
or reset a user’s password whenever it is going to expire.

Before you begin
You must enable the pwd_reset.enable.password_expiration_reminder  property 
to configure password expiration reminder. By default, this property is turned off.

Role required: admin

About this task
Configure password expiration reminder for any credential stores, such as Microsoft Active 
Directory, Windows  Active Directory, and Okta  Active Directory.

Note: 
Password expiration reminder doesn’t support the local ServiceNow  credential store.
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After configuring password expiration reminder, notifications are sent to users by different 
channels, such as emails, text messages, or actionable virtual agent notifications. Users get an 
option to reset or change the password through notifications, such as a link that users can select 
to reset or change the password.

Procedure

1. Navigate to All  > Password Reset  > Processes.

2. On the Password Reset  Process page, select the process for which you want to configure 
password expiration.

3. On the form for the selected process, select the Password Expiration Configuration  tab.

4. Select the Send expiration reminder  option.

5. On the form, fill in the fields.

For information about the fields on the Password Expiration Configuration form, see Password 
Expiration Configuration form.

6. Save the form.

After enabling password expiration reminder for a process, a sync expiration data scheduled 
job runs after an hour. The scheduled job creates records in the password expiration table for 
every user entitled for that process. The schedule job creates records for the process for which 
you configured password expiration and users who belong to this process.

If you find that the data in the password expiration table is not in sync, select Sync Expiration 
data  to sync the data. Otherwise, the sync is an automated process.

Note: 
After you select Sync Expiration data, the scheduled job runs after an hour. The 
Sync Expiration data  button appears only for those processes that are active and the 
processes for which the Send expiration reminder  option is selected.

Related topics

System properties for password expiration

View scheduled jobs

You can view scheduled jobs for the process that you configured password expiration for. When 
you configure password expiration for a process, two scheduled jobs are created automatically.

Before you begin
Role required: admin

About this task
One scheduled job creates a record in the password expiration table, which has the prefix as 
Sync password expiration records for pwd_process_  followed by a sys_id.

Note: 
This job runs only once. This scheduled job only creates a record in the password 
expiration table. It doesn’t fetch information about each user’s password expiration by 
calling the external credential store. For example, the values for the Last Password Reset 
Date  or Password Expiration Date  field remain empty. The expiration reminder scheduled 
job retrieves the dates for all the expiration records with empty dates before sending the 
expiration notifications.
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The second scheduled job runs periodically based on configuration. The scheduled job that 
has a prefix as pwd_expiration_reminder_  followed by a sys_id does the following two 
actions:

• Fetches the latest information about the user’s password expiration.

• Sends a notification when the user’s password is going to expire.

Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

The Scheduled Jobs page shows the scheduled jobs, which are created after you configure 
the password expiration.

2. Select any of the scheduled jobs with the following prefixes:

◦ Sync password expiration records for pwd_process_

◦ pwd_expiration_reminder_

These prefixes are followed by the sys_id of the password reset process.

View a password expiration table

You can view a password expiration table and validate whether a record is created in it.

Before you begin
Role required: admin

About this task
This table contains the password expiration information of an individual user in each process 
that the user is entitled to. The expiration framework uses this table information to send the 
expiration notification reminders across the credential stores. You can also view details of the 
record, such as if there are any errors, error logs, or password expiration dates.

Procedure

1. Select All  and then enter pwd_expiration.list  in the navigation filter.

The Password Expirations page shows the table with the generated records.

2. View the various columns that you want to use in the table and validate the information.

Password expiration table

Column 
Name

Description

Users Shows the reference to the sys_user table.

Password 
Reset 
Process

Shows the reference to the password reset process table. The process that a 
user belongs to and for which you have configured password expiration.

Last 
Password 
Reset Date

Shows the last date when the user reset the password.

Password 
Expiration 
Date

Shows the date that indicates when the password is going to expire.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4304



Column 
Name

Description

Send 
Notification

Shows whether password expiration notifications are to be sent or not.

Active Shows the status of the password expiration record. For example, suppose 
that a user is no longer associated with the process. In that case, the record 
shows the value as false. It means that the record is inactive and the scheduled 
process does not fetch the data for that user. The true  value indicates that the 
record is active.

Error 
Count

Shows whether there is any error while getting information about the user 
password expiration. For example, when getting information about a user’s 
password expiration while calling an external credential store, an error might 
occur.

Last 
Refresh 
Date

Shows the last date when the record was refreshed from an external system.

Last Error 
Log

Shows the last error log if there is any error while getting information about the 
user’s password expiration.

Note: 
The password expiration table stores the password expiration information of different 
users for different password reset processes because both the tables are data domain 
separated. The password expiration table is also data domain separated. For more 
information about domain separation, see Domain separation and the Password Reset 
application.

Credential stores for Password Reset

Credential stores hold user information such as user names and passwords that can be used as 
login credentials. Examples include the User table [sys_user] or an Active Directory server.

Users with the password_reset_admin or password_reset_credential_manager role can create 
and modify connections to credential stores.

Credential store types installed with the base system

A credential store type is a set of workflows that specify how to connect to a credential store. 
Navigate to Password Reset  > Credential Store Types  to view the list of example credential 
stores that are based on the base-system  types. The base system  includes the following 
credential store types:

Name Description

Local ServiceNow  Instance Represents the current (local) ServiceNow  instance.

Credential store types included in Store apps

Name Description

Microsoft  AD 
Credential Store

Represents a Microsoft Active Directory  credential store. See Set up 
Microsoft Active Directory for Password Reset.
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Name Description

Microsoft  Entra ID 
Credential Store

Represents a Microsoft  Entra ID credential store.

Okta credential store Represents an Okta  credential store.

Google credential 
store

Represents a Google Directory credential store.

Connection subflows for credential store types

A credential store type workflow requires a subflow that defines how to connect to the store, and 
can include an optional subflow that defines how to test the connection. Use the Pwd reset – AD 
and Pwd Reset - Local  subflows as models for your custom connection workflows.

Pwd Reset Local sub workflow

Pwd connection test local SN sub workflow

Creating a custom credential store type

You can use a credential store type as a model to create a custom type. See Create a credential 
store type for Password Reset.
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Configure the connection to a credential store for the Password Reset  processes

You create a Password Reset  credential store record to configure access to your credential 
store server while a user is changing or resetting a password. In addition to host connection 
information, you can specify the password hints that users should see, restrictions on password 
reuse, the allowed number of failed reset attempts, and other settings.

Before you begin
Role required: none

About this task

• For an AD credential store, skip this procedure and instead follow the instructions in Integrate 
Password Reset with your Active Directory service. The Password Reset Windows Application 
supports only AD credential stores.

• Configuration for multiple connections using a child alias. You can configure a connection 
credential alias with multiple child connections and map the child connection to a password 
reset credential store. The connections are used during the run time in the password reset 
flows. With this configuration password reset flows can support multiple Active Directory server 
credentials in Flow Designer.

Procedure

1. Navigate to All  > Password Reset  > Credential Stores.

2. Select the following sample credential store.

Local ServiceNow Instance  credential store

3. Enter a unique and meaningful Name  and Description, and then on the Password Reset 
Credential Store form, fill in the fields.
For information about the fields on the Password Reset  Credential Store form, see Password 
Reset Credential Store form.

4. Click Submit.

5. If you use the Local ServiceNow  Instance credential store and you selected the Enforce 
history policy  check box, then follow these steps:

a. Open the Password Reset  process that is associated with the credential store: Password 
Reset  > Processes.

b. On the Password Reset Details  tab of the Password Reset  Process form, clear the Auto-
generate password  check box and then save the process definition.

6. Select Enable password policies on your instance

7. Test the connection to the credential store.

Related topics

Configure the required strength for passwords

Credentials Store for Password Reset  for Active Directory

A credential store type is a set of workflows that specify how to connect to a credential store. You 
can connect to Password Reset  Credential Stores  to view the list of example credential stores 
that are based on the base-system  types.
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Overview

Navigate to Password Reset  > Credential Stores  to view the list of example credential stores 
that are based on the base-system  types. You can also use subflows and integration hub 
IntegrationHub .

Related topics

Integrate Password Reset with your Active Directory service

Configure the connection to an AD credential store

Integrate Password Reset  with your Active Directory service

The Password Reset  application can change passwords on an Active Directory credential 
store. The application changes passwords by referencing an Active Directory user role with the 
appropriate password change privileges.

Before you begin
Role required: admin
Active Directory must have a user role with the following privileges:

Descendent User objects:

• Reset password

• Read/Write pwdlastset

• Read/Write UserAccountcontrol

• Write Account Restrictions

• Read/Write lockouttime

• Read MemberOf

Descendent Group objects:

• Read Members

• Read MemberOf

Procedure

1. Install a MID Server  on a Windows  computer that can connect to Active Directory.

2. Configure the MID Server.

3. If using the Workflow  and Orchestration  add-ons, in the ServiceNow  instance, navigate to 
Orchestration  > Credentials.

4. Click New, complete the form with the following values for the AD credential, and then click 
Submit.

Field Description

Type Select Windows.

User name Enter your Active Directory domain user. For example, domain
\admin.

Password Enter your Active Directory domain user password.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4308

https://www.webstg.servicenow.com/docs/access?context=integrationhub&version=washingtondc&pubname=washingtondc-integrate-applications&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=integrationhub&version=washingtondc&pubname=washingtondc-integrate-applications&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=integrationhub&version=washingtondc&pubname=washingtondc-integrate-applications&ft:locale=en-US


Field Description

Applies to Select the MID Server that you use to access the Active Directory 
server.

Note: 
If you are using Integration Hub, from the Microsoft  AD Credential store, click Microsoft 
AD Connection Alias  to create a new connection. To learn more, see Set up the Microsoft 
AD v2 spoke .

What to do next
Create a connection to the credential store as described in Configure the connection to an AD 
credential store.

Configure the connection to an AD credential store

You can create a Password Reset  credential store record to configure access to your Active 
Directory server while a user is changing or resetting a password. In addition to host connection 
information, you can specify the password hints that users should see, restrictions on password 
reuse, the allowed number of failed reset attempts, and other settings.

Before you begin
Role required: none

About this task
The Microsoft  AD Spoke for Password Reset  add-on installs the AD Credential store type. The 
Password Reset Windows Application  supports only Microsoft AD Credential Store.

Procedure

1. Navigate to All  > Password Reset  > Credential Stores  and select Sample Microsoft AD 
Credential Store  to use as a template.

2. Enter a unique and meaningful Name  and Description  and then fill in the form.

Type Select Microsoft AD Credential Store type. A ServiceNow  credential 
store type is a template that provides the required set of capabilities for a 
particular type of credential store. Credential stores inherit the functionality 
of the credential store type.

Auto-generate 
password

Specify a script include that generates a temporary password for use 
during the reset process.

Note: 
If you select the Enforce history policy  check box, then you must 
specify a value for Auto-generate password  that is compliant with the 
password policy. There are several options to choose from:

◦ An auto-generated password that is compliant with the policy you 
selected.

◦ An auto-generated password that is Crypto-secure.

◦ A default auto-generated password.

Enforce history 
policy

Appears only if you select a Microsoft AD Credential Store type  or Local 
ServiceNow Instance  credential store type.
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The Microsoft  AD Credential Store type supports history check. The 
Enforce history policy  option appears only when the Supports history 
check  option is selected for the Microsoft AD Credential Store type.

For information on configuring the setting for credential store types 
other than AD, see Configure the connection to a credential store for the 
Password Reset processes.

Select the Enforce history policy  check box to enforce the history policy 
(password reuse).

History policy (password reuse): Active Directory domains can be 
configured to include a history policy that ensures that users don't 
reuse passwords. For example, the history policy might be configured 
to not allow the user to reuse any of the previous 10 passwords when 
resetting a password. This history policy limit is managed by the 
password_history_limit verification parameter.

Hostname Specify the URL or IP address of the credential store.

User account 
lookup

Specify the script include that maps the user ServiceNow  platform ID to the 
user credential store ID.

The default script, PwdDefaultUserAccountLookup, returns the user 
ServiceNow  platform user name.

Password rule 
hint

Specify the text that appears on the password reset page to help the user 
to create a password that meets all requirements. The Password rule  script 
enforces the requirements.

Note: 
The Password Reset Windows Application  supports newline 
characters in the hint. Other formatting is not supported (bold, 
underline, hyperlink, and so on).

Password rule Specify the client script that validates the new password that the user 
enters. The script is invoked when the user enters a new password and 
clicks Password Reset. You can use the script to enforce password 
strength/complexity requirements.

Enable 
Password 
Strength

Select the check box to:

◦ Display the text box for the Strength rule  script so you can update the 
script.

◦ Display the graphical Password Strength  bar to the user while the user 
changes or resets the password.

Note: 
The Password Reset Windows Application  does not support Password 
Strength.

Strength rule This text box appears only if you select Enable Password Strength.

Specify the client script that calculates the strength/complexity of the 
password that the user enters. The script is invoked when the user begins 
to enter a new password during the reset process.

Default settings:
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◦ Selected for local ServiceNow  credential stores

◦ Not selected for other credential stores

Note: 

◦ To guide the user during the reset process, the system displays a 
graphical bar labeled Password Strength  under the New password 
field.

◦ The Password Reset Windows Application  does not support 
Password Strength.

3. Click Submit.

4. On the domain controller, set Password Aging  (MIN_PASSWORD_AGE) to zero.

5. To enforce the history policy that is configured for the AD credential store, follow these steps:

a. Open the Password Reset  process that is associated with the credential store: Password 
Reset  > Processes.

b. On the Password Reset Details  tab of the Password Reset  Process form, clear the Auto-
generate password  check box and then save the process definition.

6. To enforce the maximum number of attempts to reset the password, in the Password Reset 
Credential Store Parameters related list, set the value of the max_reset_attempts 
parameter to the number of allowed failed attempts.

The default value of 0 (zero) enables an unlimited number of reset attempts.

Note: 
The max_reset_attempts  setting applies only to Password Reset  processes that 
use AD credential stores.

7. Click Submit.

8. Set up the Microsoft AD v2 spoke

9. Test the connection to the credential store.

Related topics

Configure the required strength for passwords

Credential Store for Password Reset  for Microsoft  Entra ID

A credential store type is the set of flows to manage password and account of Microsoft  Entra 
ID user. Navigate to Password Reset  > Credential Stores  to view the list of example credential 
stores that are based on the base-system types.

Related topics

Integrate Password Reset with your Microsoft Entra ID

Configure the connection to the Microsoft Entra ID Credential Store
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Integrate Password Reset  with your Microsoft  Entra ID

When the Microsoft  Entra ID Integration for Password Reset  store app is activated, the Password 
Reset  application can manage passwords of a Microsoft Entra ID application. The application 
manages passwords by referencing a Microsoft  Entra ID user with appropriate roles and 
password change privileges.

Before you begin
Role required: admin

Procedure

To integrate Password Reset  with your Microsoft  Entra ID, you must set up the Microsoft  Entra ID 
spoke.
For more information about setting it up, see Set up Microsoft Entra ID spoke .
The Microsoft  Entra ID Integration for Password Reset  is integrated.

What to do next
Create a connection to the credential store as described in Configure the connection to an AD 
credential store.

Configure the connection to the Microsoft  Entra ID Credential Store

Create a Password Reset  credential store record to configure access to your Microsoft  Entra 
ID server while a user is changing or resetting a password. In addition to host connection 
information, you can specify the password hints that users should see and other settings.

Before you begin
Role required: none

About this task
The Microsoft  Entra ID Integration for Password Reset  installs the Microsoft  Entra ID Credential 
Store type. The Microsoft  Entra ID application supports only the Microsoft Entra ID Credential 
Store.

Procedure

1. Navigate to All  > Password Reset  > Credential Stores  and select Sample Microsoft 
Credential Store  that you can use out of the box or as a template.

2. Enter a unique Name  and Description  and then complete the form.

Type Select Sample Microsoft Entra ID Credential Store. A ServiceNow 
credential store type is a template that provides the required set of 
capabilities for a particular type of credential store. Credential stores inherit 
the functionality of the credential store type.

Auto generate 
password

Specify a script include that generates a temporary password for use 
during the reset process.

Hostname Specify the domain name of the Entra ID application in this column.

User account 
lookup

Specify the script include that maps the user ServiceNow  platform ID to the 
user credential store ID.

The default script, PwdDefaultUserAccountLookup, returns the user 
ServiceNow  platform user name.
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Password rule 
hint

Specify the text that appears on the password reset page to help the user 
to create a password that meets all requirements. The Password rule  script 
enforces the requirements.

Password rule Specify the client script that validates the new password entered by the 
user. The script is invoked when the user enters a new password and 
selects Password Reset.

Enable 
Password 
Strength

Select the check box to:

◦ Display the text box for the Strength rule  script so you can update the 
script.

◦ Display the graphical Password Strength  bar to the user while the user 
changes or resets the password.

Strength rule This text box appears only if you select Enable Password Strength.

Specify the client script that calculates the strength/complexity of the 
password that the user enters. The script is invoked when the user begins 
to enter a new password during the reset process.

Default settings:

◦ Selected for local ServiceNow  credential stores

◦ Not selected for other credential stores

Note: 

To guide the user during the reset process, the system displays a 
graphical bar labeled Password Strength  under the New password 
field.

Enable 
password 
policy

Check this option to select either a default password policy or one you 
created yourself previously.

3. Click Submit.
Password Reset  Credential store record to access your Microsoft Entra ID server is configured.

Note: 

◦ The Enable Password Policy  option was added in the Quebec release. Checking the 
option displays your password policy choices right from your instance. To learn more, 
see Enable password policies on your instance .

◦ Since the Microsoft  Entra ID doesn't support the history policy, the Enforce history 
policy  option is hidden.

Test the connection to a credential store

You should test the connection to a credential store after you configure a new credential store or 
when users experience problems that might involve the connection.

Before you begin
Role required: admin
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Procedure

1. Navigate to All  > Password Reset  > Credential Stores  and then open the credential store 
record.

2. In the header bar, click Save and Test Connection.
A progress page displays the result of the test.

Delete a connection to a credential store for Password Reset

Important: Before you delete the connection to a credential store, check all Password Reset 
processes to ensure that the credential store is not in use. If the credential store is being used by 
a process, update the process before deleting the credential store.

Before you begin
Role required: password_reset_admin or password_reset_credential_manager

Procedure

1. Navigate to All  > Password Reset  > Credential Stores  and then select the check box for the 
credential store.

2. In the Actions  choice list, select Delete.

Password Reset  verifications

Each verification  specifies the method and process for verifying the identity of the user that is 
requesting a password reset.

Verifications included with Password Reset

The Password Reset  application includes the following verifications in the base system. You can 
create a verification based on either a base-system  verification or a verification type (a template).

Note: 
The Password Reset Windows Application  doesn’t support custom verifications.

Password Reset  verifications

QA verification Implements a self-service Password Reset  model with questions 
that are included with the base system  or custom questions 
that the admin defines. While enrolling for the process, the user 
decides which questions to provide answers for. Questions are 
presented in the language that the user requested during login.

When a user requests a password reset, the system poses a 
specified number of the questions that the user selected during 
enrollment. The user must answer all questions correctly to verify 
their identity.
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Password Reset  verifications  (continued)

QA verification on the Verify page

For information on the user enrollment experience, see Enroll for 
the Password Reset program using questions and answers.

This verification is based on the Security Questions  verification 
type.

Email verification This verification relies on auto-generated code numbers. You 
typically implement email verification as a self-service Password 
Reset  model.

When a user requests a password reset, the system sends a 
verification code to an email address that the user authorized 
during enrollment. To verify identity, the user then submits the 
code on the Password Reset  Verify page.

For information on the user enrollment experience, see Enroll for 
the Password Reset program using emailed codes.

The Password Reset Windows Application  supports email 
verification.

This verification is based on the Email Code  verification type.

By default, a six-digit email verification code is sent to the user 
through email. The code expires in 10 minutes. Users can attempt 
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Password Reset  verifications  (continued)

to send another code after two minutes. A maximum of 10 email 
verification codes can be sent to a user in one day.

SMS verification Implements a self-service or service desk-assisted Password 
Reset  model that relies on auto-generated code numbers.

When a user requests a password reset, the system sends a 
code to an SMS-capable device that the user has authorized. To 
verify identity, the user then submits the code on the Password 
Reset  Verify page.

You can use the ServiceNow  Notify  feature to send the codes.

For information on the user enrollment experience, see Enroll for 
the Password Reset program using SMS codes.

This verification is based on the SMS Code  verification type.

When users enroll for email or SMS verification on the Password 
Reset  Enrollment page, they get a code to verify their email 
address or device. After the users enter the code and select 
Verify, an associated record is automatically created in the 
Password Reset  Enrollment for Verifications [pwd_enrollment] 
table even before they select Submit.

By default, a six-digit verification code is sent to the user's mobile 
device. The code expires in five minutes. Users can attempt 
to send another SMS verification code to the device after two 
minutes. A maximum of 10 codes can be sent to a particular 
device in one day.

Note: 
While the record is created automatically in the Password 
Reset  Enrollment for Verifications [pwd_enrollment] table 
for the email or SMS verification, the associated enrollment 
check script doesn’t get processed unless users select 
Submit.

Authenticator verification Password Reset  model that relies on auto-generated code 
numbers. Users typically implement authenticator verification as 
a self-service Password Reset  model.

When a user requests a password reset, the user reads a 
code from the authenticator app on a device that the user has 
paired. To verify identity, the user then submits the code on the 
Password Reset  Verify page.

For information on the user enrollment experience, see Enroll for 
the Password Reset program using an authenticator.

The Password Reset Windows Application  supports Google 
Authenticator verification.

This verification is based on the authenticator verification type.
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Password Reset  verifications  (continued)

Personal Data — Confirm 
Email Address

Implements a self-service Password Reset  model that relies 
on user information that is available in the user profile on the 
instance.

This verification is based on the Personal Data Confirmation 
verification type.

Note: 
Users can't configure this verification for the processes with 
the active public access.

Personal Data — Enter User 
Name

Implements a self-service Password Reset  model that relies 
on user information that is available in the user profile on the 
instance.

This verification is based on the Personal Data  verification type.

Soft PIN Verification Implements a self-service Password Reset  model that relies on a 
Soft PIN that's a six-digit number. Users can enroll for the Soft PIN 
verification for a process and reset the Soft PIN. ServiceNow® 

Virtual Agent  supports the Soft PIN verification method.

Related topics

Create a custom Password Reset verification

Create a Password Reset verification from an existing verification

Personal data identification types and confirmation type verifications

Personal data verifications allow users to verify their identity by providing answers to questions 
that are generated from personal information stored in the User table [sys_user].

User experience

For an example of how a user might enroll for Personal data verification, see Enroll for the 
Password Reset program using questions and answers.

Personal data identification types

The Password Reset  application provides the email and username identification types. You can 
use either type as provided or as a model to create a custom identification type.

Name Description

Email Identification Identifies users by their email addresses.

Username Identification Identifies users by their user names.

Personal data confirmation verifications

• Personal data verification:  If users are associated with a Password Reset  process that uses a 
personal data verification, the users are typically not required to enroll for Password Reset.

• Personal data confirmation verifications  allow employees with the 
password_reset_service_desk role to access personal data from the sys_user table when 
assisting a user with a password reset request.
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To configure personal data and personal data confirmation verifications, you specify parameters 
as name/value pairs that correspond to a particular piece of user information. For example, to 
verify users by their email address:

1. Set the label  parameter (the text that the end user should see) to Email  (that is, 
label=Email).

2. Set the column  parameter (the column in the table that holds the verification data) to email 
(that is, column=email).

Note: 
You can use only one set of name/value pair parameters per verification. Additional 
parameters are ignored.

To use multiple pieces of personal information for user verification, create more personal data or 
personal data confirmation verifications and add the verifications to the related Password Reset 
process.

Personal data and personal data confirmation type verifications

Parameter 
Name

Description

label Text to display as a label for the field that the user fills in during the password 
reset request.

Data Type: string

Default Value: n/a

column Column of the sys_user table that provides the data that is used to verify the 
identity of the user.

Data Type: string

Default Value: n/a

Related topics

Create a custom identification type for Password Reset

SMS Code Verification type for Password Reset

Using the Simple Message Service (SMS) Code Verification type, a user can verify identity with 
the help of any SMS-enabled device, like a cell phone that accepts text messages. When a user 
requests password reset, the system sends a numerical code to the device and the user then 
enters the code on the Password Reset  Verification page.

You can change the default behavior of an SMS code verification using either of the following 
methods:

• Set parameter values, as shown in the table.

• Update property settings for the Password Reset  application.

Note: 
The system allows only one instance of each SMS code parameter.
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SMS Code Verification type parameters

Parameter 
name

Description

expiry Number of minutes the verification code is valid.

Data Type: integer (any positive integer)

Default Value: 5

complexity Number of digits in the numerical verification code.

Data Type: integer (any positive integer)

Default Value: 6

pause_window Number of minutes before the user can request another SMS code for 
verification.

Data Type: integer (any positive integer)

Default Value: 2

max_per_day Maximum number of codes sent for verification in one day.

Data Type: integer (any positive integer)

Default Value: 10

User experience

For information on how users enroll for SMS verification, see Enroll for the Password Reset 
program using SMS codes.

Use Notify  to send SMS codes for enrollment and verification

You can configure the Password Reset  application to send SMS codes for enrollment and 
verification using the ServiceNow  Notify  application (via the Twilio  SMS Messaging system). 
Notify  is tightly integrated with the workflow engine and business rules and delivers a highly 
configurable and trusted way to deliver SMS messages.

Before you begin
Role required: admin

About this task
Notify  requires a separate contract with Twilio.

Procedure

1. Enroll for a Twilio  account and telephone number at https://www.twilio.com/

2. Activate the Notify  plugin.

3. Associate the Twilio  account with Notify.

Result
No other configuration is required. Users who request password change or password reset 
receive SMS codes through Notify.
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Related topics

Activate a plugin

Specify the number of required security questions

When designing a Security Questions verification for Password Reset, you can specify the 
number of questions to display when users enroll. You can also specify the number to display 
when a user is verifying identity while resetting the password.

Before you begin
Role required: password_reset_admin or admin

Procedure

1. Navigate to All  > Password Reset  > Verifications  and then open a verification that uses the 
Security Questions Verification Type.

2. Configure the parameters in the Password Reset Verification Parameters  related list.

Parameters for Security Questions Verification

Parameter 
Name

Description

num_enroll
Number of questions that a user must provide answers to while enrolling for the 
Password Reset  process.

The value that you specify here overrides the setting of the Number of security 
questions required during enrollment  property. See Configuring Password 
Reset properties.

Data Type: Positive integer that does not exceed the number of questions in the 
security questions list (Password Reset  > Security Questions).

Default Value: 5

num_reset Number of security questions that are displayed on the Verify page while a 
user is attempting to reset the password. The user must answer all questions 
correctly to verify identity. The questions are selected at random and are 
presented in random order.

The value that you specify here overrides the setting of the Number of 
security questions required during the password reset request  property. See 
Configuring Password Reset properties.

Data Type: Positive integer that does not exceed the value of the num_enroll 
parameter

Default Value: 3

3. Click Update.

Related topics

Add a custom question to the Security Questions verification
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Configure your Password Reset  process to auto-enroll users

To simplify management, many organizations auto-enroll users in the Password Reset  program. 
Every base-system  verification type enables you to specify automatic enrollment for your 
process.

Before you begin
Role required: password_reset_admin or admin

About this task
To enable automatic enrollment, you configure settings for the verification type that your 
Password Reset  process is based on.

Procedure

1. Navigate to All  > Password Reset  > Extensions  > Verification Types.

2. Click the verification type for the verification that your Password Reset  process uses.
The verification type for each base-system  verification is identified in Password Reset 
verifications.

3. On the Verification Types  page, specify the following settings:

Field Description

Enrollment check Script that determines whether a user is enrolled for 
verification.

Note: 
For automatic enrollment to work, the Enrollment check 
script must return true. This may require additional setup 
by the admin to ensure that the preconditions are met. 
For example, for the SMS Code  verification type, records 
must be populated in particular tables.

If no script is specified when Automatic Enrollment  is 
selected, a default script is provided.

Automatic enrollment Select the check box to auto-enroll users.

Note: 
If Automatic enrollment  is not selected, then you 
must provide an enrollment UI macro and enrollment 
processor script as described in Create a custom 
Password Reset verification type.

4. Repeat the procedure for all verifications that your Password Reset  process uses.

Enable users to enroll for Password Reset

To enable users to enroll for the Password Reset  program, you specify a UI macro that takes the 
user through the enrollment process and a script that processes the enrollment data that the 
user entered. The base system  includes a functioning macro and script.

Before you begin
Role required: password_reset_admin or admin
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About this task
To enable users to enroll, you configure settings for the verification type that your Password 
Reset  process is based on.

Procedure

1. Navigate to All  > Password Reset  > Extensions  > Verification Types.

2. Click the verification type for the verification that your Password Reset  process uses.
The verification type for each base-system  verification is identified in Password Reset 
verifications.

3. On the Verification Types  page, specify the following settings:

Field Description

Automatic enrollment Clear the check box to disable automatic enrollment.

Enrollment UI Enrollment UI macro that takes the user through the 
enrollment process.

Enrollment processor Enrollment processor script that processes enrollment data.

4. Repeat the procedure for all verifications that your Password Reset  process uses.

Example: Enabling user enrollment

This example verification type uses the pwd_enroll_sms_ui  enrollment UI macro and the 
PwdEnrollSMSProcessor  enrollment processor script.

Verification type

A verification type must also define a verification UI macro and a corresponding verification 
processor script. The example uses the pwd_verify_sms_uiverification UI macro and the 
PwdVerifySMSProcessor  verification processor script.
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Verification UI macro
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Verification processor script

Configuring Password Reset  properties

You can specify properties that configure the Password Reset  experience for end users.

Before you begin
Role required: password_reset_admin

About this task
While there are no range limits for the values you can enter for properties, consider using only 
positive integer values starting at 1. When you determine the limit for the upper range of a 
property, consider the task that the user is performing.

For example, you would not want to allow 100 attempts for users to verify their identity. A more 
common value is 3 attempts. Similarly, you may not want to force users who are completing the 
enrollment process to spend time selecting and answering 30 security questions. The more 
commonly used number of security questions is between 5 and 7.

Procedure

1. Navigate to All  > Password Reset  > Properties.
For information about the Password Reset  properties, see Password Reset  global properties.

2. Update settings as needed and then click Save.
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Send email to remind users to enroll for Password Reset

You can automatically send messages that remind users to enrolled in the Password Reset 
process. You specify the text of the message and can configure the messages to repeat at 
intervals.

Before you begin
Role required: password_reset_admin

About this task
The default email content is:

• Subject: Reminder: Enroll in the Password Reset  program

• Body: Click here to enroll in the Password Reset  program.

To customize the email, see Customize the Password Reset enrollment reminder email.

Procedure

1. Navigate to All  > Password Reset  > Processes  and select your process.

2. Click the Enrollment Reminder  tab, configure the following settings, and then click Update.

Note: 
The tab appears only when the Password reset  check box is selected.

Field Value

Send 
reminder

Select the check box to send reminder emails to users (either all users or users 
in the specified groups, as you configured). Clear the check box to send no 
reminders.

Sender 
alias

Enter a non-functional email alias that should appear in both the To  and From 
fields of the message. For example, do-not-reply@myCompany.com. Users 
will not be able to respond to the alias.

The alias is required by the email system to use the bcc  field for all of the users 
who receive the message. The intent is that the users should not see the other 
addressees.

Default: do-not-reply@ServiceNow.com

Send, 
Day, and 
Time

Specify a schedule of one message each month or one message each week.

◦ If you set Send  to Monthly, then enter the day of the month and optionally the 
time of day when the message should be sent.

◦ If you set Send  to Weekly, then enter the day of the week and optionally the time 
of day when the message should be sent.

Default: Weekly message at 00:00 on Monday

Starting
Date and time to send the first message. Click the calendar button to specify the 
setting.

Default: [Now]
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Customize the Password Reset  enrollment reminder email

The email message that reminds users to enroll for the Password Reset  process is based on 
an email template. To customize the message, you can modify the default template or create a 
custom template.

Before you begin
Role required: password_reset_admin

About this task
The default email content is:

• Subject: Reminder: Enroll in the Password Reset  program

• Body: Click here to enroll in the Password Reset  program.

Procedure

1. To modify the email subject text:

a. Navigate to System Policy  > Email  > Templates.

b. Open the Password reset enrollment reminder  template.

c. Update the Subject  field as needed.

d. In the Message HTML  text box, you can add code as needed, but do not modify the default 
text.

2. To modify the email body content:

a. Navigate to System Notifications  > Email  > Notification Email Scripts.

b. Open the pwd.enrollment_reminder  script.

c. Modify only the indicated portion of the script.
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3. To create a custom email template:

a. Make a copy of the Password reset enrollment reminder  template and edit as 
described above.

b. Navigate to Password Reset  > Properties  and enter the template name in the Email 
template for enrollment reminder emails  field.

Configure the required strength for passwords

The password that a user defines must meet certain requirements — for example, it must contain 
at least 12 characters, it must include a numeral, and so on. You can configure the requirements 
as needed for your organization.

Before you begin
Role required: password_reset_admin

About this task
The base system  includes example credential stores with various password requirements. You 
can modify password requirements and provide users with hints for creating a password. The 
default requirements are:
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• At least eight characters

• At least one uppercase and one lower case letter

• At least one numeral

Note: 
In addition to configuring password strength requirements, you can configure several other 
settings for the credential store, as described in Configure the connection to a credential 
store for the Password Reset processes.

Procedure

1. Navigate to All  > Password Reset  > Credential Stores.

2. Select the credential store in the list and then configure the following settings:

Field Description

Password rule 
hint

Specify the text that appears on the password reset page to help the user 
to create a password that meets all requirements. The Password rule  script 
enforces the requirements.

Note: 
The Password Reset Windows Application  supports newline 
characters in the hint. Other formatting is not supported (bold, 
underline, hyperlink, and so on).

Password rule Specify the client script that validates the new password that the user 
enters. The script is invoked when the user enters a new password and 
clicks Password Reset. You can use the script to enforce password 
strength/complexity requirements.

Enable 
Password 
Strength

Select the check box to:

◦ Display the text box for the Strength rule  script so you can update the 
script.

◦ Display the graphical Password Strength  bar to the user while the user 
changes or resets the password.

Note: 
The Password Reset Windows Application  does not support 
Password Strength.

Strength rule This text box appears only if you select Enable Password Strength.

Specify the client script that calculates the strength/complexity of the 
password that the user enters. The script is invoked when the user begins 
to enter a new password during the reset process.

Default settings:

◦ Selected for local ServiceNow  credential stores

◦ Not selected for other credential stores
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Field Description

Note: 

◦ To guide the user during the reset process, the system displays a 
graphical bar labeled Password Strength  under the New password 
field.

◦ The Password Reset Windows Application  does not support 
Password Strength.

3. Click Submit.
You should test the connection to a credential store after you configure a new credential store 
or when users experience problems that might involve the connection.

4. Navigate to Password Reset  > Credential Stores  and then open the credential store.

5. In the header bar, click Save and Test Connection.
A progress page displays the result of the test.

Specify lockout for failed login attempts

The system provides inactive script actions that enable you to specify the number of failed login 
attempts before a user account is locked and to reset the count after a successful login.

Before you begin
Role required: admin

Procedure

Navigate to All  > System Policy  > Script Actions  to view or activate the scripts.

Note: 
Starting with the Kingston  release, following a zBoot, the script actions SNC User Lockout 
Check with Auto Unlock  and SNC User Clear  are activated.

To learn more about properties that affect failed login attempts, see Managing failed login 
attempts (instance security hardening)  in the Instance Security Hardening Settings.

Script action Description

SNC User Lockout Check with 
Auto Unlock

• Uses the value of the 
glide.user.max_unlock_attempts  property to set 
the limit for failed login attempts.

• Unlocks the user account after the 
time period that is specified for the 
glide.user.unlock_timeout_in_mins  property. 
If no value is specified, then the system unlocks the user 
account after the default period of 15 minutes.
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Script action Description

SNC User Lockout Check Tracks the number of failed login attempts and locks the user 
account after a specified number of failed login attempts 
(default: 5).

SNC User Clear Updates the user record after a successful login: Resets the 
number of failed login attempts and updates the date of the 
last login.

What to do next
Each time a user attempts to log in, the action is recorded in an event log. You can view a log of 
failed login attempts.

1. Navigate to System Policy  > Event Logs.

2. Filter for login.failed  in the Name  field. You can view the attempted login name, date, and IP 
address logged for the attempt.

Configure Google reCAPTCHA  for the password reset process

To use the Google reCAPTCHA  service, instances that are running on a domain other than 
service-now.com  require an API key pair from Google.

Before you begin
Role required: admin

About this task

• The procedure described in this topic is optional for instances that are running on the 
service-now.com  domain.

• Because on-premises instances do not have access to the Internet, they cannot use the 
Google reCAPTCHA  service. Do not follow the procedure described in this topic. Instead, 
set the password_reset.captcha.google.enabled  system property to false. This 
setting enables the CAPTCHA service that is provided with the base system.

• The Password Reset Windows Application  uses the base-system  CAPTCHA service even if the 
Password Reset  application is configured to use Google reCAPTCHA.

Procedure

1. Request an API key pair (a site key and a secret) from Google  at https://www.google.com/
recaptcha .

2. Set the following system properties:

Property Value

password_reset.captcha.google.enabledSet to true.

Type: string

Default: true

google.captcha.site_key Set to the site key that Google  provided.

Type: string
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Property Value

Default: A site key that Google  provided to 
ServiceNow

google.captcha.secret Set to the secret that Google  provided.

Type: password2

Default: An encrypted secret that Google 
provided to ServiceNow

Note: 

Select reCAPTCHA v2, I'm not a robot 
option. (reCAPTCHA v3 is not currently 
supported).

Customizing Password Reset  processes

Password Reset  scripts enable you to customize Password Reset  by creating your own credential 
store, verification, and identification types, and extend them by defining extension scripts. You 
can also create a custom credential store type, custom verification type, or verification.

Legacy

Password Reset  scripting is available to users with the password_reset_admin role. The easiest 
way to customize Password Reset  is:

1. Create custom types and scripts as described in Password Reset extension script categories.

Extension scripts are example script includes that enable you to extend functionality in a 
password reset process. The extension script category  refers to the specific types of behavior 
for an extension script (for example, credential store, verification, identification type, or as a 
post-processor).

2. Follow the configuration steps described in Configure your Password Reset process.

3. Select the new types that you created. You can customize the following components:

◦ Credential store types: Define new types for how to connect to your credential stores by 
creating custom workflows for connection and testing. See Create a credential store type for 
Password Reset.

◦ Verification types: Define new types for how users are verified. See Create a custom 
Password Reset verification type.

◦ Identification types: Define new types for how users can identify themselves. See Create a 
custom identification type for Password Reset.
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Advanced password reset configuration

You can customize the Password Reset and Password Change applications to meet your 
organization's needs. See Password Reset and Password Change applications  for more 
information. Also see Configuring Password Reset properties  for a list of properties that control 
several aspects of password reset.

Customize password reset processes and integrate third-party credential services

To customize password reset processes or to integrate them with third-party credential services 
such as Okta  or Microsoft  Entra ID, use Integration Hub  capabilities. Use Action Designer  to 
create or modify actions like user unlock, change password, and get user status. Use Flow 
Designer  to create or modify subflows that perform the actions.

Before you begin
Role required: admin, password_reset_admin, or password_reset_credential_manager

About this task

• The base system  provides actions, subflows, and credential store types for the "Local 
ServiceNow  Instance" identity provider.

• For Microsoft  Active Directory, the subflows are available when you activate the Microsoft  AD 
Spoke for Password Reset  app.

• To use any other identity provider such as Okta, you must use Integration Hub  to create the 
required actions, subflows, and custom credential store types.

• For Microsoft  Entra ID, the subflows are available when you activate the Microsoft  Entra ID 
Integration for Password Reset  app.

Procedure

1. Use Action Designer  to create password reset actions like user unlock, change password, and 
get user status.
For more information about Action Designer, see Action Designer .

2. Use Flow Designer  to create the following subflows.

Use the specified names, inputs, and outputs for the subflows. For more information about the 
subflows, see Subflows .

Subflow name Input Input type Output
Output 
type

Error 
Message

String<Provider Name> 
Password Unlock

Password 
Reset 
Request

Record.Password Reset 
Request

Status Choice

Password Password (2 Way Encrypted) Status Choice<Provider Name> 
Password Reset

Password 
Reset 
Request

Record.Password Reset 
Request

Error 
Message

String

Password 
Reset 
Request

Record.Password Reset 
Request

Status Choice<Provider Name> 
Password Change

Current 
Password

Password (2 Way Encrypted) Error 
Message

String
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Subflow name Input Input type Output
Output 
type

Note: 
Name  under 
Advanced options  is 
old_password.

New 
Password

Password (2 Way Encrypted)

Note: 
Name  under 
Advanced options  is 
new_password.

Error 
Message

String

Locked Choice

<Provider Name> 
Password Lock State

Password 
Reset 
Request

Record.Password Reset 
Request

Status Choice

Error 
Message

String<Provider Name> 
Password Connection 
Test

Not 
Applicable

Not Applicable

Status Choice

3. For third party providers, create a credential store type.

a. Select the Use Flow  check box.

b. Select the password reset subflows that you created for the provider.
See Password Reset application  for more information.

4. Create password reset credential store.

5. Create a password reset process.

6. Select the credential store type created for the provider.

Result
The password reset mechanism for the required third-party application is set up.

Add a custom question to the Security Questions verification

To enroll for the 'Security Questions' verification, the user selects several questions and supplies 
confidential answers that only the user knows. You can add a custom question to the set of 
questions that are included with the base system.

Before you begin
Role required: password_reset_admin or admin

About this task
The base system  provides a large set of default questions in all supported languages. Questions 
are presented to each user in the language that the user requested during login. Creating a 
custom English language question is a one-step process. To create a custom question in a non-
English language, you can use either of the following options:
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• Create a custom question in the non-English language.

• Create a custom English language question plus one or more translations of the question into 
other languages.

Procedure

1. Navigate to All  > Password Reset  > Security Questions.

Note: 
Each question in the list is presented to users when they enroll for the Password Reset 
process. The user selects each question to use by providing a confidential answer to the 
question.

2. Follow this procedure to create a custom question in a single language.

Note: 
To enter non-English question text, you must request the language when logging in.

a. On the Password Reset  Questions page, click New.

b. Enter the text in the Question (Translated field)  field and then click Submit.
The question is added to the list of questions that is presented to users when they enroll. No 
additional steps are needed and you can skip the remaining steps.

3. Follow this procedure to create a custom question in English and the same question in one or 
more other languages:

a. Click New, enter English language text in the Question (Translated field)  field, and then 
click Submit.

b. Create a record in the sys_translated  table for the non-English language question.

Details appear at Translated Name / Field table  and Languages table .

Field Description

Label (translate) Non-English equivalent of the English text in 
the Value  field.

Element Name of the field in the Password 
Reset Question [pwd_question] table: 
question_translated

ID ISO 639.2  code for the language.

Table Table that you are adding the translated 
question to: the Password Reset Question 
[pwd_question]  table.

Language Language code for this translated text.

Value English-language question that you added 
in the Security Questions table.

c. Repeat the process for each language that users might request.
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Add a custom header or footer to the user pages for Password Reset

You can specify UI macros that add a header or footer to the pages that end users work in while 
resetting a password (the Identify, Verify, and Reset pages).

Before you begin
Role required: password_reset_admin

About this task
Example custom header and footer on the password reset pages

Procedure

1. Configure a UI macro for the header or footer: Navigate to All  > System UI  > UI Macros, click 
New, and then enter a meaningful Name  and Description.

2. In the XML  text box, enter the macro text.

The example macro adds the text "Trust Acme to Deliver!" to the footer of the page that users 
work in while resetting a password.
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3. Select the Active  check box and then click Submit.

4. Navigate to Password Reset  > Processes  and select the process to update.

5. On the Advanced  tab, click ( ) for the Header UI macro  or Footer UI macro  and select the 
macro that you created.

6. Click Save.

7. Verify the appearance of the end-user pages.

Option Description

If the reset pages are Public Access
On the Password Reset Details  tab, click the 
Public URL.

If the reset pages are not Public Access
Log in as an end user and request password 
reset.

Create a Password Reset  verification from an existing verification

The Password Reset  application includes several example verifications that you can use as they 
are or as the basis for a custom verification. If the verification types in the base system  do not 
meet your needs, you can create a custom verification type.

Before you begin
Role required: password_reset_admin

About this task
Note: 
The Password Reset Windows Application  does not support custom verifications.
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Procedure

1. Navigate to All  > Password Reset  > Verifications  and select a verification.

2. If needed, modify the parameters on the Password Reset Verification Parameters  tab.
The parameters are described in the instructions for the type of verification that you are 
working on.

3. Click Submit.

Note: 
Each verification type has properties that control the user experience. Review the 
property settings and update as needed.

Create a custom Password Reset  verification type

Each verification in Password Reset  is based on the settings for a verification type. If the 
verification types in the base system  do not meet your needs, you can create a custom 
verification type.

Before you begin
Role required: password_reset_admin or admin
Review the verification types that are provided in the base system  to determine whether to 
create a custom verification type. Then review the verification type components to develop. For 
more information about verification types in the base system, see Verification types in the base 
system.

Procedure

1. Navigate to All  > Password Reset  > Extensions  > Verification Types.

2. Click New, enter a unique and meaningful Name  and Description, and then fill in the form.
For information about the fields on the Password Reset  Verification Type form, see Password 
Reset Verification Type form.

3. Click Submit.

Related topics

Password Reset script includes

Password Reset extension script categories

Installed with Password Reset

Create a custom Password Reset  verification

Use a verification type in the base system  as a template to design a custom verification. The 
Password Reset Windows Application  does not support custom verifications.

Before you begin
Role required: password_reset_admin

Review the verification types that are provided in the base system  to determine whether to 
create a custom verification type. Then review the verification type components to develop. For 
more information about verification types in the base system, see Verification types in the base 
system.

Procedure

1. Navigate to All  > Password Reset  > Verifications.

2. Click New, enter a unique and meaningful Name  and Description, and then fill in the form.
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For information about the fields on the Password Reset  Verification form, see Password Reset 
Verification form.

3. Click Submit.

Note: 
Each verification type has properties that control the user experience. Review the 
property settings and update as needed.

Create a custom identification type for Password Reset

A custom identification type enables the user to enter alternative verification information such as 
an employee ID while resetting the password.

Before you begin
Role required: password_reset_admin or admin

About this task

Procedure

1. Navigate to All  > Password Reset  > Extensions  > Identification Types.

2. Click New, enter a unique and meaningful Name  and Description, and then fill in the form.

Identification field label Text to display as a label for the Identification 
field.

Identification processor Identification processor script. Choose an 
existing script or create your own using 
the Identification form processor category 
(extension script).

3. Click Submit.

Related topics

Create a Password Reset extension script

Configure a credential store type to support third-party password auto-generation

Enable the subflows in credential store type to support third-party password auto-generation.

Before you begin
Role required: password_reset_credential_manager, password_reset_admin, or admin

About this task
Users can easily reset their passwords for the credential stores that don't have REST APIs 
to reset the password. For example, the password reset subflows support Robotic Process 
Automation. The Password Reset  process can be automated with a Robotic Process Automation 
robot to reset the password of an application that does not have an API to reset the password.

For more information about Robotic Process Automation, see Robotic Process Automation (RPA) 
Hub .

Procedure

1. Navigate to All  > Password Reset  > Extensions  > Credential Store Types.

2. Open the credential store type.
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3. To use password reset subflows in the Integration Hub, leave the Use Flow  check box 
selected.

4. In the Password reset flow  field, enter a required value for the password reset subflow.

5. From the Password Delivery Mechanism  list, select Reset flow doesn’t accept password as 
input.

6. If you want your users to change the password immediately after signing in post password 
reset, select the Supports Force Password Change On First Log In  check box.

Note: 
Ensure that the User must reset password  check box is selected on the Password Reset 
Process form of the associated process. But these settings of changing passwords after 
first sign-in post reset work only if the credential store you are configuring supports the 
settings.

7. Click Update  or save the changes.

Asynchronous password reset subflow

When a user requests a password reset, based on the application for which the password reset 
is requested, the process works either synchronously or asynchronously.

When a user requests a password reset for a credential store for which the REST APIs are 
available to reset the password, the password is reset immediately. This process is synchronous.

In the asynchronous process, when a user requests a password reset for credential stores that 
don't provide REST APIs, you can configure such credential stores to reset passwords using an 
external system, such as Robotic Process Automation.

For more information about Robotic Process Automation, see Robotic Process Automation (RPA) 
Hub .

When a user requests a password reset, the password doesn't get reset immediately. The user 
receives a message that shows the request has been submitted, and the request status is 
displayed as Pending With External System  on the Password Reset  Requests page for that 
request.

When the process completes, the password is reset. The user receives an appropriate message 
based on the success or failure of the password reset action from the external system, which 
resets a password for the user. If the password reset is successful, the user receives an email 
containing the new password from the external system if the credential store doesn’t accept the 
password.

If a credential store processes a password reset request asynchronously, then to update the 
corresponding password reset request status from pending to either Completed With Success 
or Completed With Failure, the process must use the Update Password Reset Request  subflow 
as a callback.

Note: 
To open the Update Password Reset Request Status  subflow, navigate to All  > Process 
Automation  > Flow Designer, and click the Subflows  tab. Then search for and select the 
Update Password Reset Request Status  subflow.
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Update Password Reset Request Status subflow input parameters

Input Parameters Description

Password Reset 
Request

Glide record of the password reset request.

Request Status Determines which choices are available as input. For example, Completed 
With Success  or Completed With Failure.

When this subflow is used, the input parameters are considered in this subflow to set the 
corresponding password reset status.

Update Password Reset Request Status subflow

Create a credential store type for Password Reset

Create a custom credential store type when the base-system  types do not meet your needs.

Before you begin
Role required: password_reset_credential_manager

About this task
You can also configure a credential store type to work independently with the password reset, 
password change, and unlock password actions.

Procedure

1. Navigate to All  > Password Reset  > Extensions  > Credential Store Types.

2. Click New.

3. In the Name  field, enter the name for the credential store type.

4. In the Description  field, enter the description for the credential store type.

5. To use password reset subflows in Integration Hub, leave the Use Flow  check box selected.

Note: 
See Customize password reset processes and integrate third-party credential services 
for information on creating provider-specific subflows.
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6. Select the Supports history check  check box to determine whether the credential store 
supports the history policy capability.

If selected, only then the password_reser_admin can disable or enable this feature through a 
credential store record.

7. Select the subflows created for the third-party application.

Note: 
See Customize password reset processes and integrate third-party credential services 
for information on creating provider-specific subflows.

Subflow Description

Base Alias
A connection and credential alias that is used in the subflows of this credential 
store type.

This is the default alias used by the subflows while making an external call.

Note: 
If you want to override the default alias, use the child alias property of the 
credential store.

Password 
change 
flow

Changes the password of an authenticated and unlocked user account to 
the provided new password. Verifies that the new password conforms to 
the password format and history policies. Displays an error if the user is not 
authenticated or is locked out.

Use the Password Reset flow to unlock a locked user account and require a 
password change.

Unlock 
user flow Defines the process to unlock a user.

If a credential store supports the unlock user flow, the Get user lock state flow 
field becomes a required field. But when a credential store doesn’t support the 
unlock user flow, you can still set up the user lock state flow.

Get user 
lock state 
flow

Retrieves the lock status of an account specific to the credential store.

Connection 
test flow

Defines how to test the connection.

Password 
reset flow Unlocks the specified user account. Expires the current password and changes 

the password to the provided new password if it conforms to the password 
format and history policies. If it doesn't conform, a warning is displayed.

Note: 
In the case of an Robotic Process Automation  setup, the subflow doesn’t 
reset the password immediately but only pushes the request into the 
Robotic Process Automation  queue and the status is displayed as 
Pending.
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Subflow Description

Password 
Delivery 
Mechanism

Sets the mechanism such as whether to accept the password as input or not. 
For example, in the case of the credential store for which Robotic Process 
Automation  functionality is required, Robotic Process Automation  can’t accept 
the password from the Password Reset  application for security purposes. 
So, for Robotic Process Automation  subflows, the Reset flow doesn't accept 
password as input  value must be selected. That means, while users create a 
reset password request, they are not asked to enter passwords of their choice.

Note: 
This feature is applicable only to the password reset action. If for a 
credential store, the reset flow doesn’t accept a password, which is 
configured through the password delivery mechanism, then all the fields 
for password policy and password generation are hidden on the related 
credential store form. For example, Enable password policy, Password 
policy, Enable Password Strength, Strength rule, and Auto-generate 
password.

Supports 
Force 
Password 
Change On 
First Log In

When selected, notifies the user to change the password when the user signs 
in for the first time with the new password that the user receives after the 
password reset action is completed.

Note: 
Based on this setting, the fields on the Password Reset Process form 
change. For example, when a password reset administrator selects the 
Auto-generate password  check box on the Password Reset Process form, 
the form displays the User must reset password  field. So, it depends on 
the password reset administrator whether to prompt users to change their 
auto-generated password or not even if the Supports Force Password 
Change On First Log In  check box is selected.

8. If you want to use workflows, clear the Use Flow  check box to use the password reset 
workflows in Orchestration.

Note: 

◦ The workflows have been deprecated. Use the subflows by leaving the Use Flow  check 
box selected.

◦ The workflows are available only if you have upgraded from the previous releases.

Field Description

Password 
Reset 
workflow

Defines the credential store processing. Password Reset  workflows are 
available to use as a model. Provide scripts for each of the activities defined for 
the subflow. For more information about how to create a workflow, see Create a 
workflow. For installed workflows, see Installed with Password Reset.

Connection 
test 
workflow

Defines how to test the connection. Connection test workflows are available to 
use as a model. If you create a connection test subflow, provide scripts for each 
of the activities defined for the subflow. For installed workflows, see Installed 
with Password Reset.

Get user 
lock state 
workflow

Defines how to get the user lock state. Get user lock state workflows are 
available to use as a model. Provide scripts for each of the activities defined for 
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Field Description

the subflow. For more on how to create a workflow, see Create a workflow. For 
installed workflows, see Installed with Password Reset.

Unlock 
user 
workflow

Defines how to unlock a user. Unlock user workflows are available to use as a 
model. If you create a connection test subflow, provide scripts for each of the 
activities defined for the subflow. For installed workflows, see Installed with 
Password Reset.

9. Click Submit.

Reset a password or unlock a user account with service desk assistance

Reset a password or unlock a user account by requesting the assistance of a service desk agent.

Before you begin
Watch this video example of service desk agents resetting passwords: Resetting User Passwords 
(Video) .

Note: 

• You must clear the Public access  property to enable the service desk-assisted process. 
See Configure your Password Reset process.

• You can perform this activity on a mobile device.

• You can change the theme of the service desk page to the dark theme. For more 
information about the dark theme, see Exploring themes in Next Experience .

Role required: password_reset_admin or password_reset_service_desk

About this task
In a service desk-assisted Password Reset  process, only the service desk agents with the 
password_reset_service_desk role can reset user passwords. Users can’t reset passwords.

Procedure

1. Navigate to All  > Password Reset  > Service Desk.

2. Select a user and the Password Reset  process to use.

3. Click Verify Identity.

4. On the Verify Identity form, enter the answers provided by the user, and then click Continue.
If the user's identity is verified, the Reset Password form displays the identity verification and 
status of the account lock.

5. Perform one of the following actions.

◦ If the user isn’t locked, the form displays the Reset password  button. Enter the new 
password and click Reset password.

◦ If the user's account is locked, the form displays the Reset password  and Unlock account 
buttons. You can enter a new password and click Reset password  to reset the password 
and unlock the account. If the Enable account unlock  option is selected for the password 
process, you can unlock the account without resetting the password by clicking Unlock 
account.

6. To reset the password for a different user, you must first navigate away from the Service Desk 
and then navigate to Password Reset  > Service Desk.
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View user requests for password reset

The Reset Requests  module displays the status of each password reset request from the 
Password Reset  Request table [pwd_reset_request].

Before you begin
Role required: password_reset_admin or password_reset_service_desk

Procedure

Navigate to All  > Password Reset  > Reset Requests.

Password Reset  request fields

Field Description

User User whose password is being reset or changed.

Process Process that implements this password reset request.

Type
Type of Password Reset  request:

• Change Password: Request to change a password.

• Help Desk: Request opened on behalf of the requesting user by a service desk 
agent.

• Self Service: Requesting user opened the reset request.

Action 
Type Corrective action performed during the Password Reset  request.

• Change Password: Update the credential store with the new password.

• Reset and Unlock Account: Generate a new password for the user and unlock the 
user account.

• Reset Password: Generate a new password for the user.

• Unlock Account: Unlock the user account.

Status
Result of the Password Reset  request:

• Completed With Failure: User completed all steps in the Password Reset  process, 
but the password was not reset in the credential store.

• Completed With Success: User completed all steps in the Password Reset  process 
and the password was reset in the credential store.

• Expired: User did not complete all steps in the Password Reset  process in the time 
allowed.

• In Progress: User is working through the steps to reset the password.

• Max Number of Attempts: User failed to answer the security questions correctly 
during the identity verification step and has exceeded the maximum number of 
attempts allowed.

• Verified: User has completed the identity verification step and is verified. The user 
can move to the Password Reset  step.

Active Whether the request is open or closed.

Retry Total number of times the user has attempted to complete a password reset request.
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Unblock a Password Reset  user

If a user is manually banned or is flagged as exceeding max attempts, the user can be blocked 
(not allowed to use the Password Reset  application). You can unblock a blocked user.

Before you begin
Role required: password_reset_admin or password_reset_service_desk

About this task
Blocking events include:

• The user exceeded the limit for the number of failed password attempts.

• The most recent password reset occurred before the wait time required until the next reset.

• The user failed to provide the correct information while attempting to reset the password.

If the number of blocked or locked users exceeds the limit within a defined time 
interval, it triggers a system log event. You can configure the number of blocked 
or locked users and the time interval required to generate the log event by setting 
the password_reset.activity_monitor.incident_threshold  and 
password_reset.activity_monitor.incident_window  properties.

Procedure

1. To view the list of blocked users, navigate to Password Reset  > Blocked Users.

2. To unblock a self-service user:

a. Navigate to Password Reset  > Blocked Users.

b. Select a user from the list.

c. Select Delete  on the Actions on selected rows  list.

3. To unblock a user whose password was reset by a service desk agent:
If a user is manually banned or flagged as exceeding max attempts, the user can be blocked 
(not allowed to use the Password Reset  application). When the password reset request is 
made through self-service, the user is unblocked when the password is successfully reset.

In contrast, service desk agents are allowed any number of retries. The 
max_attempt_reached  limit does not apply and the Blocked  status for the user is not 
reset after the password is reset. As a result, after you successfully reset a user password, you 
must unblock the user manually.

If the user is not unblocked manually, then the system resets the blocked state only when the 
max_attempt_window  time period elapses and the user tries to reset the password using 
self-service.

a. After you successfully reset a user password, navigate to Password Reset  > Blocked Users.

b. Change the Blocked  setting for the user from true to false.

Related topics

Configuring Password Reset properties

Password Reset and Password Change reports and logs

Integrate Password Reset  with a Service Portal  widget

You can enable a Password Reset  process in a Service Portal  page by adding a widget that 
opens the password reset pages inside the portal.

Before you begin
Role required: admin or sp_admin
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Procedure

1. On the Service Portal Designer for the portal, create a new page — the page where the user will 
perform the password reset process.

2. On the Widget  tab, under Layouts, select the 12-column layout and drop it onto the page.

3. Drop the Pwd reset  widget into the 12-column layout and then save the page.
The three tabs of the password reset process appear in the layout.

4. In the Reset my password  link on the login page for the portal, specify the URL of the new 
password reset page.
The URL must include one required parameter  and may contain one optional parameter:

◦ Required: sysparm_show_custom_header_footer=false. This parameter 
disables the native header and footer feature of the password reset page.

◦ sysparm_redirect_url=<portalName>?id=<pageName>. This parameter 
specifies the page to go to after a successful reset — typically the login page for the portal.

For example, https://server.acme.com/acme_community?
id=password_reset_page& 
sysparm_show_custom_header_footer=false&sysparm_redirect_url=acme_community?
id=communities_login

Integrate Password Reset  with a CMS integration

You can configure a site in the ServiceNow  content management (CMS) application to define a 
single-site access point that includes the Password Reset  service. For example, you can create 
an employee self-service site that provides Password Reset  service.

Before you begin
Role required: content_admin

About this task
Each Password Reset  process requires a separate CMS page.

Procedure

1. Navigate to All  > Content Management  > Specialty Content  > iFrames  and create an iFrame 
record.

2. Go to Content Management  > Sites  and create a site that has no login page.
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3. Go to Content Management  > Pages  and create a password reset page.

4. Enter the name of the site that you created in the Content site  field (Password Reset self-
service  in the example).

5. Right-click the form header and click Save.

6. Click the Edit Page  related link and then click Add content.

7. In the Content Blocks  section, select the iFrame that you created and add more content as 
needed.

8. Click Update.

Installing and configuring Password Reset Windows Application

Request the Password Reset  Windows  App (Password Reset  Orchestration) 
(com.glideapp.password_reset_desktop) plugin that enables connections to the Active Directory 
(AD) credential store types.

Administrators download and run an EXE or MSI file to install or distribute the application to user 
computers. The application installs a link on the Windows  login screen.

Password Reset Windows Application  installation requirements

Activate the Password Reset  Windows  App (Password Reset  Orchestration) 
(com.glideapp.password_reset_desktop) plugin and activate the Microsoft AD for Password 
Reset  store app to use the Password Reset Windows Application.

Requirement Description

Required ServiceNow 
release

Password Reset Windows Application  version 5.0 is supported on the 
San Diego, Tokyo, and Utah  releases.

Required hardware • 1 GHz or faster processor

• 512 MB of RAM
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Requirement Description

• 10 MB of available hard disk space (x86)

• 10 MB of available hard disk space (x64)

Required software

• Version of Password Reset Windows Application: 5.0

• Microsoft .NET Framework: 4.7.1 and newer

• Microsoft Visual C++: Redistributable Visual Studio 2017

Supported operating 
systems

• Windows  8.1

• Windows  10 Enterprise

• Windows  10 Pro

• Windows  11

Supported processor 
architecture

• X86

• X64

Supported network 
architecture

• Password Reset Windows Application  clients must have direct 
access to both the internet and the ServiceNow  instance where the 
Password Reset Windows Application  is configured

• For Password Reset Windows Application  versions that use an SHA 
certificate, the corporate network must not block the SHA certificate.

• To reset an AD password, the client must be on the corporate 
network.

Request the Password Reset  Windows  App plugin

Request the Password Reset  Windows  App (Password Reset  Orchestration) 
(com.glideapp.password_reset_desktop) plugin that enables connections to the Active Directory 
(AD) credential store types. No other components are installed.

Before you begin
Role required: admin

About this task
There are two ways to request a plugin:

• Access the Now Support  Service Catalog directly by selecting All  > Service Catalog  > Activate 
Plugin  on Now Support. For more information about the list of plugins, see List of Plugins .

• Access the Now Support  Service Catalog through the All Applications page on your instance 
by following these steps.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. On the All Applications page, select Request Plugin  to open the Request form on HI.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4348

https://www.webstg.servicenow.com/docs/access?context=list-of-plugins&version=washingtondc&pubname=washingtondc-platform-administration&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=list-of-plugins&version=washingtondc&pubname=washingtondc-platform-administration&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=list-of-plugins&version=washingtondc&pubname=washingtondc-platform-administration&ft:locale=en-US


3. On Now Support, select the redirect link to access the Now Support  Service Portal Service 
Catalog.

4. Select your instance.

5. Select Actions > Activate Plugin.

6. On the form, fill in the fields.

Activate Plugin request form

Field Description

Target Instance Instance on which to activate the plugin.

Plugin Name Name of the plugin to activate.

Specify the date and time you would like this 
plugin to be enabled

The date and time must be at least two 
business days from the current time.

Note: 
Plugins are activated in two batches, 
in the morning and in the evening, 
on every business day in the US 
Pacific time zone. If the plugin must be 
activated at a specific time, enter the 
request in the Reason/Comments  field.

Reason/Comments Information that would be helpful for the 
ServiceNow  personnel who are activating the 
plugin. For example, if you need the plugin 
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Field Description

activated at a specific time instead of during 
one of the default activation windows, specify 
that in the comments.

7. Select Submit.

Download the Password Reset Windows Application  installer

Download the Password Reset Windows Application  installer.

Before you begin
Role required: any user

Procedure

1. Log in to the ServiceNow Store  Publisher Portal.

2. Click your user menu and select Store.

3. Set the filter for the Ancillary Software  app type.

4. Click Password Reset Windows Application.
The application download location appears.

5. Click Download.

Install Password Reset Windows Application

Install Password Reset Windows Application  using different available methods.
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Use an EXE file from the command line

As an alternative to command-line installation, you can use a wizard.

Before you begin
Role required: security_admin elevated privilege
Privilege required: Windows  local administrator

Procedure

1. Ensure that the user with the ServiceNow  security_admin role configures the security 
properties.
For more information about the security properties, see Configure security settings for the 
Password Reset Windows Application

2. Copy the following command into a text editor as one line with no breaks.

PasswordResetWinAppInstall.exe /VERYSILENT /
PasswordResetLinkURL 
 https://<YourServerName>/$pwd_reset.do?sysparm_url=default /
PasswordResetLinkName "Forgot password?"

3. Add arguments and replace the default parameter values with the correct values for your 
organization.

Argument Example Description

/Log /Log=c:\temp
\PwdResetInstallLog.log

Optional. To generate a log 
file, you must first create 
the directory that the file is 
written to. In this example, 
you would create the c:
\temp directory before 
running the installation.

/NORESTART /NORESTART Optional. Include /
NORESTART  to prompt the 
user to restart the computer 
after installation.

Parameter Default Description

PasswordResetLinkURL https://
<YourServerName>/
$pwd_reset.do?
sysparm_url=default

URL of the page that users 
access when resetting a 
password.

Be sure to substitute your 
ServiceNow  server name and 
the URL suffix for the desired 
Password Reset  process.

PasswordResetLinkName "Forgot password?" Text to display for the 
Password Reset  link on the 
Windows login page. Update 
the text as needed.

You must enclose the text 
in double-quote characters 
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Parameter Default Description

as shown. To ensure that 
the correct characters are 
used, do not copy/paste 
the example text. Instead, 
type the characters at the 
command line.

CredentialProviderGUID Most installations do 
not need to specify this 
parameter value. Provide 
this value only if you use 
a customized credential 
provider and can provide 
a valid credential provider 
GUID.

4. Navigate to the directory that holds the PasswordResetWinAppInstall.exe  file.

5. Run the updated command at the command line.

6. After installation and depending on the setting for the /NORESTART  argument, you might 
need to restart the computer.
See Install Password Reset Windows Application  using a wizard.

Use an MSI file from the command line

Use the MSI file to install the Password Reset Windows Application  on multiple computers over a 
network. As an alternative to MSI installation, you can also install from the command line.

Before you begin
Role required: Windows  local administrator

Procedure

1. Ensure that the user with the ServiceNow  security_admin role configures the security 
properties.
For more information about security properties, see Configure security settings for the 
Password Reset Windows Application.

2. Copy the following command into a text editor as one line with no breaks.

msiexec.exe /i PasswordResetWinAppInstall.msi /quiet 
 WRAPPED_ARGUMENTS="/SUPPRESSMSGBOXES /VERYSILENT /NORESTART /
PasswordResetLinkURL 
 https://<YourServerName>/$pwd_reset.do?sysparm_url=default /
PasswordResetLinkName ""Forgot password?"""

3. Add arguments and replace the default parameter values with the correct values for your 
organization.

Argument Example Description

/Log /Log=c:\temp
\PwdResetInstallLog.log

Optional. To generate a log 
file, you must first create 
the directory that the file is 
written to. In this example, 
you would create the c:
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Argument Example Description

\temp directory before 
running the installation.

/NORESTART /NORESTART Optional. By default, 
MSI installations restart 
the computers. Include 
/NORESTART  not to 
restart the computers after 
installation.

You might want to 
communicate with end users 
that they must restart their 
computer to enable the 
Password Reset Windows 
Application.

Parameter Default value to replace Description

PasswordResetLinkURL https://
<YourServerName>/
$pwd_reset.do?
sysparm_url=default

URL of the page that users 
access when resetting a 
password.

Be sure to substitute your 
ServiceNow  server name and 
the URL suffix for the desired 
Password Reset  process.

PasswordResetLinkName ""Forgot password?"" Text to display for the 
Password Reset  link on the 
Windows login page.

You must enclose the text in 
two double-quote characters 
as shown. To ensure that 
the correct characters are 
used, do not copy/paste 
the example text. Instead, 
type the characters at the 
command line.

Optional: 
CredentialProviderGUID

Most installations do 
not need to specify this 
parameter value. Provide 
this value only if you use 
a customized credential 
provider and can provide 
a valid credential provider 
GUID.

4. Navigate to the directory that holds the PasswordResetWinAppInstall.msi  file.

5. Run the updated command at the command line.
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6. After installation and depending on the setting for the /NORESTART  argument, you might 
need to restart computers.
See Install Password Reset Windows Application  using a wizard  and Install the Password 
Reset Windows Application  using an EXE file from the command line.

Use a wizard

As an alternative to wizard installation, you can run commands directly at the command line.

Before you begin
Role required: Windows  local administrator

Procedure

1. Ensure that the user with the ServiceNow  security_admin role configures the security 
properties.
For more information about the security properties, see Configure security settings for the 
Password Reset Windows Application.

2. Right-click the PasswordResetWinAppInstall.exe  installation file that you 
downloaded and select Run as administrator.

3. On the Configure Password Reset Web page and credential provider  page, configure the 
following settings and then click Next:

Field Description Default

URL of the Password Reset 
page

URL of the page on your 
ServiceNow  instance that 
users access when resetting 
a password.

Be sure to substitute your 
ServiceNow  server name and 
the URL suffix for the desired 
Password Reset  process.

https://
<YourServerName>/
$pwd_reset.do?
sysparm_url=default

Text to display for the 
Password Reset  link

Text to display for the 
Password Reset  link on the 
Windows login page. Update 
the text as needed.

Forgot password?

GUID of the credential 
provider

Most installations do 
not need to specify this 
parameter value. Provide 
this value only if you use 
a customized credential 
provider and can provide 
a valid credential provider 
GUID.

[Accept the default.]

4. For the remaining pages, perform the following actions:

Page title Action

License Agreement Select I accept the agreement.
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Page title Action

Select Destination Location Accept the default installation location.

Select Start Menu Folder Accept the default "ServiceNow".

Ready to Install Click Install.

5. Restart the computer.
See Use an EXE file from the command line.

Configure security settings for the Password Reset Windows Application

Configuring security settings for the Password Reset Windows Application.

Security settings

• The glide.security.use_csrf_token  property setting allows the Password Reset 
Windows Application  to retrieve a token for a secure communication with the datacenter 
instance.

• The CheckCertificateRevocationList  registry key default setting of true  causes 
the Password Reset Windows Application  to validate the server certificate before every 
communication. See Customize the Password Reset Windows Application  for details.

• The ServiceNowCertPublicKey  registry key contains the public key for the app. See 
Customize the Password Reset Windows Application  for details.

Configure the glide.security.use_csrf_token property

To configure the glide.security.use_csrf_token  property, a security_admin elevated 
privilege is required.

Set the glide.security.use_csrf_token  property to true (Yes). See the topic titled 
"High Security Settings" in https://servicenow.com/docs .

The Windows  local administrator performs the remainder of the installation procedure.

Configure the Password Reset Windows Application  to use a proxy server

The Password Reset Windows Application  supports the use of a proxy server. There are three 
options for configuring the proxy server.

Before you begin
Role required: Windows  system administrator

Procedure

Use any one of the following configuration options to enable the Password Reset Windows 
Application  to use a proxy server.

Configure an exception policy on your proxy server

You can configure an exception policy on your proxy server to allow unauthenticated access to 
the service-now.com  domain.

Before you begin
Role required: Windows  system administrator
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Procedure

1. On a machine in the network, back up the following registry key: HKEY_USERS\.DEFAULT
\Software\Microsoft\Windows\CurrentVersion\Internet Settings

2. Download and install the Sysinternals Suite from https://technet.microsoft.com/
en-us/sysinternals/bb842062.aspx

3. At the command prompt, navigate to the extracted sysinternals  folder.

4. Run the following command to launch Internet Explorer:
psexec -s -i "C:\Program Files\Internet Explorer\iexplore.exe"

5. On the Internet Explorer Tools  menu, select Internet options.

6. On the Connections  tab, click LAN settings.

7. In the Proxy server  section, select Use a proxy server for your LAN  and then fill in the 
Address  field using the following format: <proxy_server>:<port>

8. Click OK  to close the LAN Settings  page and then click OK  to close Internet options.

9. Export the following registry key to all clients that use the Password Reset Windows 
Application:HKEY_USERS\.DEFAULT\Software\Microsoft\Windows
\CurrentVersion\Internet Settings

Configure a proxy server using client credentials method

If you cannot configure an exception policy, you must configure all Windows  clients that use the 
Password Reset Windows Application  to pass valid credentials to the proxy server.

Before you begin
Role required: Windows  system administrator

About this task
If you choose not to use the method described in this topic, there are other methods to configure 
a proxy server:

• Configure registry keys. See Configure registry keys on your proxy server.

• Configure an exception policy on your proxy server to allow unauthenticated access to the 
service-now.com  domain. See Configure an exception policy on your proxy server.

Procedure

1. On a machine in the network, back up the following registry key: HKEY_USERS\.DEFAULT
\Software\Microsoft\Windows\CurrentVersion\Internet Settings

2. Download and install the Sysinternals Suite from https://technet.microsoft.com/
en-us/sysinternals/bb842062.aspx

3. At the command prompt, navigate to the extracted sysinternals  folder.

4. Run the following command to launch Internet Explorer:
psexec -s -i "C:\Program Files\Internet Explorer\iexplore.exe"

5. On the Internet Explorer Tools  menu, select Internet options.

6. On the Connections  tab, click LAN settings.

7. In the Proxy server  section, select Use a proxy server for your LAN 
and then fill in the Address  field using the following format: http://
<userID>:<password>@<proxy_server>:<port>
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8. Click OK  to close the LAN Settings  page and then click OK  to close Internet options.

9. Export the following registry key to all clients that use the Password Reset Windows 
Application:HKEY_USERS\.DEFAULT\Software\Microsoft\Windows
\CurrentVersion\Internet Settings

Configure registry keys on your proxy server

You can configure registry keys to enable the Password Reset Windows Application  to use a 
proxy server.

Before you begin
Role required: Windows  system administrator

About this task
If you choose not to use the method described in this topic, there are other methods to configure 
a proxy server:

• Configure an exception policy on your proxy server to allow unauthenticated access to the 
service-now.com  domain. See Configure an exception policy on your proxy server.

• Configure all Windows clients that use the Password Reset Windows Application  to pass valid 
credentials to the proxy server. See Configure a proxy server using client credentials method.

Procedure

1. Open the Registry Editor on your Windows  computer.

2. Go to Computer  > HKEY_LOCAL_MACHINE  > SOFTWARE  > Microsoft  > Windows  > 
CurrentVersion  > Authentication  > Credential Providers  > 0780AF60-65C2-4718-942D-
E0C56E89EF9B.

3. Set the following registry keys:

Note: 
You can modify any of the listed string values.

"ProxyServer"="<YourProxyName>:<PortNumber>"
"ProxyEnable"="true"
"ProxyUser"="<YourProxyUserName>"
"ProxyPassword"="<YourProxyPassword>"
"ProxyDomainName"="<YourProxyDomainName>"
"ByPassProxyOnLocal"="false"

◦ ProxyServer: Set the proxy server name or IP address with port

◦ ProxyUser: User name associated with the credentials, in case proxy is enabled with basic 
authentication

◦ ProxyPassword: Password for the user name associated with the credentials

◦ ProxyDomainName: Domain name that verifies the credentials

◦ ByPassProxyOnLocal: Set to true if you want to bypass a proxy server for local calls.

Configure a proxy server using PAC file (automatic configuration script method)

Configure the Proxy Auto-Configuration (PAC) file or Windows  proxy auto detection (WPAD) using 
the Internet Explorer (IE) settings.

Before you begin
Role required: Windows  system administrator
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About this task
The Password Reset Windows Application  internal classes automatically pick the configuration 
that is done using Use automatic configuration script  at the Internet Explorer level. If you 
configure the proxy at Internet Explorer, level all the changes done at a remote proxy level are 
applicable in the Password Reset Windows Application  as well.

Procedure

1. On the Internet Explorer Tools menu, select Internet options.

2. On the Connections  tab, click LAN settings.

3. Select the Use automatic configuration script  check box.
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4. In the Address  field, enter the PAC file location on the network.

5. Click OK.

PAC file with registry setting

In this proxy configuration, the Proxy Auto-Configuration (PAC) file can be configured in Password 
Reset Windows Application  registry settings.

The name of the registry setting enables the proxy via PAC file is 
UseProxyAutoConfigScript. The PAC script location (URL) can be provided in the 
ProxyServer  setting. The reference configuration is provided as shown in the following 

image:

Registry setting to configure proxy via PAC

• ProxyEnable – <true>

Enables the proxy on application level.

• ProxyServer – <PAC file URL>

Initialize the PAC file location here.

• UseProxyAutoConfigScript – <true>

If set to true, it indicates that the address provided in the ProxyServer  registry setting is 
PAC script.

How it works

The PAC file provided in the ProxyServer  registry setting is used to get the actual target 
proxy server address for a URL (In this case, the ServiceNow  instance) based on the PAC file 
script configuration. The PAC file script must return a valid Proxy server address for a provided 
ServiceNow  URL to make the application work.

The target proxy address is cached for a URL in the machine. The caching behavior is applicable 
for the browsers as well. The ServiceNow®  Password Reset Windows Application  behaves the 
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same as the Internet Explorer browser. That is, if the URL is accessible via a browser, then it's 
accessible via the app as well.

Note: 
It is not necessary to configure the proxy setting in Internet Explorer as the APP is reading 
the PAC file script via a registry.

Enable the Password Reset Windows Application  to set the display language for the session

When the Password Reset Windows Application  starts, the application passes the Windows 
language code to the instance. The instance then dynamically sets the language for the guest 
user session.

Before you begin
Role required: admin

Procedure

1. On the Windows computer: Set the Welcome screen display language  property to the 
preferred language.

2. On the instance:

a. Activate the plugin for the preferred language.

b. Ensure that no record in the [sys_user_preference] table specifies a particular user.language 
for guest  user.
You clear the setting for a guest  user to enable the instance to dynamically set the 
language during the session.

Integrate McAfee disk encryption with the Password Reset Windows Application

You use ePolicy Orchestrator (ePO) to enable McAfee MDE 7.2 on a Windows desktop computer 
to support the Password Reset Windows Application.

Before you begin

• Role required: admin

• Required: MDE version 7.2x

Procedure

1. Log in to ePO.

2. On the Policy Catalog, select Product  > Drive Encryption 7.2.0  and select Category  > Product 
Settings
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3. Click the Name  of your policy catalog (My Default  in the example).

4. On the Log On  tab, select the V7.2 Onwards  tab and then select the Allow integrated third-
party credential providers ...  check box.

5. Click Save  and then log out of ePO.

6. On the end-user computer, create the following registry keys (client-side ePO setting):

 
Windows Registry Editor Version 5.00
[HKEY_LOCAL_MACHINE\SOFTWARE\McAfee EndPoint 
 Encryption\IntegratedCredentialProviders\{0780AF60-65C2-4718-9
42D-E0C56E89EF9B}]
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"Vendor"="ServiceNow, Inc"
"Product"="ServiceNow PasswordReset WinApp"
"Version"="<PasswordReset WinApp version>" (for example, 
 "Version"="4.5")
"BuiltAgainst"="<MDE version>" (for example, 
 "BuiltAgainst"="7.2.3.28")

7. Restart the computer.

Customize the Password Reset Windows Application

You can customize the appearance and other aspects of the application.

Before you begin
Role required: Windows  system administrator

Procedure

1. Open the Registry Editor on your Windows  computer.

2. Go to Computer  > HKEY_LOCAL_MACHINE  > SOFTWARE  > Microsoft  > Windows  > 
CurrentVersion  > Authentication  > Credential Providers  > 0780AF60-65C2-4718-942D-
E0C56E89EF9B.

3. Modify any of the listed string values:

Note: 
Registry keys that begin with the text "proxy"  enable use of a proxy server. 
SeeConfigure registry keys on your proxy server.

Registry configuration options

File name Description Default string

AppDir Directory that holds the 
Password Reset Windows 
Application  application files.

C:\Program Files
\ServiceNow

AppFormIconFile Icon that is associated 
with the Password Reset 
application.

C:\Program Files
\ServiceNow\bin
\ServicenowLogo.png

You can change the icon 
that's associated with your 
company. Replace the 
ServicenowLogo.png 
with your company 
logo and change the 
AppFormIconFile  path 
in the registry.

AppFormTitle Displayed name of the 
application.

Password Reset Windows 
Application

CheckCertificateRevocationList By default, before every 
communication, the 
Password Reset Windows 
Application  validates that 
the server certificate has not 
been revoked by checking 

Default: "true"

◦ true: When a user 
requests reset, the 
application first checks 
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File name Description Default string

the Certificate Revocation 
List (CRL).

If the Password Reset 
Windows Application  is slow 
to load after a user requests 
reset, you can choose to skip 
checking the CRL.

the CRL to validate the 
certificate. The application 
does not proceed without 
a valid certificate.

◦ false: The application 
starts immediately and 
does not validate the 
certificate.

CredentialProviderGUID GUID of the credential 
provider that is in use.

”"="{6f45dc1e-5384-457a-
bc13-2cd81b0d28ed}”

DebugFlag Write entries in the 
ServiceNowPwdReset event 
log.

”0”

PasswordResetLinkName Text to display for the 
Password Reset  link on the 
Windows login page.

"Forgot password?"

PasswordResetLinkURL URL of the Password 
Reset  application on your 
ServiceNow  instance.

https://<YourServerName>/
$pwd_reset.do?
sysparm_url=default

Proxy Keys that configure proxy 
settings

Registry keys that begin with 
the text "proxy"  enable 
use of a proxy server. See 
Configure registry keys on 
your proxy server.

ServiceNowCertPublicKey By default, before every 
communication, the 
Password Reset Windows 
Application  validates the 
server certificate.

Copy the certificate public 
key from the browser. See 
the example that follows the 
table. Paste the whole public 
key into the registry key text 
box.

You can add multiple public 
keys in the text box (each on 
a new line).

ServiceNowServerVersion Version of your production 
instance.

"<YourInstanceVersion>" (For 
example, "Kingston")

ServiceNowWinAppVersion Version of the Password 
Reset Windows Application.

"<YourWindowsAppVersion>" (For 
example, "4.5")

UserAccountPictureLoc Image that appears on the 
Login screen.

%programdata%
\Microsoft\User 
Account Pictures
\user.bmp

WorkingDir Directory that holds the 
library files.

C:\Program Files
\ServiceNow\bin
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Copy the public key from the browser

Example registry settings

Windows Registry Editor Version 5.00
 
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\A
uthentication\Credential 
 Providers\{0780AF60-65C2-4718-942D-E0C56E89EF9B}]
@="PasswordResetCredentialProvider"
"AppFormTitle"="Password Reset Windows Application"
"PasswordResetLinkName"="Forgot password?"
"CredentialProviderGUID"="{60b78e88-ead8-445c-9cfd-0b87f74ea6c
d}"
"AppFormIconFile"="C:\\Program 
 Files\\ServiceNow\\bin\\servicenow.ico"
"UserAccountPictureLoc"="%programdata%\\Microsoft\\User Account 
 Pictures\\user.bmp"
"DebugFlag"="0"
"CheckCertificateRevocationList"="true"
"ProxyServer"="YourServerName:PortNo"
"ProxyEnable"="false"
"ProxyUser"="YourProxyUser"
"ProxyPassword"="YourProxyPassword"
"ProxyDomainName"="YourProxyDomainName"
"ByPassProxyOnLocal"="false"
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"ServiceNowCertPublicKey"="EC 3F 18 BB D3 9A D7 8D A7 7E 99 77 
 E0 E6 73 5E 38 30 3F 8C E1 8A EF 23 CC 56 D8 FD B1 54 B5 0E 54 
 81 42 86 B1 D5 E4 47
"AppDir"="C:\\Program Files\\ServiceNow"
"ServiceNowServerVersion"="Kingston"
"ServiceNowWinAppVersion"="4.5"
"WorkingDir"="c:\program files\servicenow\bin"
"PasswordResetLinkURL"="https://
yourserver.service-now.com/$pwd_reset.do?sysparm_url=demo1"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\A
uthentication\Credential 
 Providers\{0780AF60-65C2-4718-942D-E0C56E89EF9B}\HideGUIDs]

Windows Registry Editor Version 5.00
 
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\A
uthentication\Credential 
 Providers\{0780AF60-65C2-4718-942D-E0C56E89EF9B}]
@="PasswordResetCredentialProvider"
"AppFormTitle"="Password Reset Windows Application"
"PasswordResetLinkName"="Forgot password?"
"CredentialProviderGUID"="{60b78e88-ead8-445c-9cfd-0b87f74ea6c
d}"
"AppFormIconFile"="C:\\Program 
 Files\\ServiceNow\\bin\\servicenow.ico"
"UserAccountPictureLoc"="%programdata%\\Microsoft\\User Account 
 Pictures\\user.bmp"
"DebugFlag"="0"
"CheckCertificateRevocationList"="true"
"ProxyServer"="YourServerName:PortNo"
"ProxyEnable"="false"
"ProxyUser"="YourProxyUser"
"ProxyPassword"="YourProxyPassword"
"ProxyDomainName"="YourProxyDomainName"
"ByPassProxyOnLocal"="false"
"ServiceNowCertPublicKey"="EC 3F 18 BB D3 9A D7 8D A7 7E 99 77 
 E0 E6 73 5E 38 30 3F 8C E1 8A EF 23 CC 56 D8 FD B1 54 B5 0E 54 
 81 42 86 B1 D5 E4 47
"AppDir"="C:\\Program Files\\ServiceNow"
"ServiceNowServerVersion"="Kingston"
"ServiceNowWinAppVersion"="4.5"
"WorkingDir"="c:\program files\servicenow\bin"
"PasswordResetLinkURL"="https://
yourserver.service-now.com/$pwd_reset.do?sysparm_url=demo1"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\A
uthentication\Credential 
 Providers\{0780AF60-65C2-4718-942D-E0C56E89EF9B}\HideGUIDs]

Limitations of the Password Reset Windows Application

The Password Reset Windows Application  has a few limitations.

• The Password Reset Windows Application  doesn't support custom verifications.

• The Password Reset Windows Application  uses the base-system  CAPTCHA service even if the 
Password Reset  application is configured to use Google reCAPTCHA  with the web interface.

• The Password strength indicator is not supported.
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• For some verification types, you can use only one verification. Custom verifications are not 
supported. For more information, see Password Reset verifications.

• Custom UI macros configured on the Process  > Advanced  page are not supported (for 
example, entry, success, or failure macros). The system displays only the default success and 
failure messages.

• The Password Reset Windows Application  supports newline characters in the Password 
rule hint  text. Other formatting is not supported (bold, underline, and hyperlink). For more 
information, see Configure the connection to a credential store for the Password Reset 
processes.

Uninstall the Password Reset Windows Application

You can run either an EXE or an MSI file to uninstall the application.

Before you begin
Role required: Windows  Local Administrator

Procedure

Follow either procedure.

Option Description

Use an EXE file from the command line

a. Navigate to the uninstall directory that you 
created during installation, for example:

C:\Program 
 Files\ServiceNow\uninstall\

b. Double-click the unins000.exe  file.

Use an MSI file from the command line

a. Navigate to the directory that holds the 
PasswordResetWinAppInstall.msi 
file.

b. Run the following command at the command 
line:

msiexec.exe /x 
 PasswordResetWinAppInstall.m
si /quiet

Enrolling in the Password Reset  application to reset your password

The self-service process is a typical process that you might follow to reset your password. Your 
experience might differ.
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Example experience of the self-service process

1. On the Login page, click the Forgot Password  link to start the process.

Login page

2. On the Identify page, enter your identifying information (generally your user name or email 
address). The example includes the CAPTCHA security feature.

Identify page

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4367



3. On the Verify page, verify your identity by providing your verification information. The admin 
configured the method of verification and can require multiple verifications. In the following 
example, the admin has configured the Security Questions verification. You must answer 
questions to prove your identity. (Earlier, while enrolling for the password reset process, you 
selected these questions and provided secure, private answers.) Other possible verifications 
require you to enter a code that was sent to a mobile device by SMS text, through the 
authenticator app, or by email.

Verify page
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4. The system checks the credential store to verify your identity and then displays the new 
password on the Reset page.

Reset page

Enroll in the Password Reset  program

Some organizations auto-enroll users in a Password Reset  program. Your organization could offer 
end users the option to enroll for one or more methods of verifying your identity when resetting 
the password. End users can enroll for most Password Reset  programs on a mobile device.

Note: 
By default, the dark theme doesn't apply to the Password Reset  Enrollment form. Users 
can change the theme to the dark theme. For more information about the dark theme, see 
Exploring themes in Next Experience .

End users might enroll for any combination of the following methods:

Verify your identity using an authenticator app

• You enroll on a computer that you normally use to access the instance (you use 
an authenticator app to reset your password, but can’t use an authenticator to 
enroll for Password Reset Windows Application.). After you’ve enrolled, you install 
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an authenticator app on one or more devices and then authorize the devices for 
authenticator verification.

• Later, when you want to reset your password, read the authenticator code on your 
device and then enter the code on the web page to verify your identity.

Verify your identity using an SMS code (SMS verification)

• To enroll, you authorize a mobile device for SMS verification.

• Later, when you want to reset your password, you get a code on the device and 
enter the code on the web page to verify your identity.

Verify your identity using an emailed code

• To enroll, you authorize one or more email addresses.

• Later, when you want to reset your password, the system sends a code to the 
email address. You then enter the code on the web page to verify your identity.

Verify your identity using security questions verification

• To enroll, you choose multiple questions that only you can answer (like the name 
of your first pet) and then supply answers. The system stores your answers 
securely.

• Later, when you want to reset your password, the system presents one or more of 
the questions. You answer the questions to verify your identity.

Enroll for the Password Reset  program using an authenticator

Verify your identity while resetting your password by enrolling for the Password Reset program 
using a third-party authenticator app.

Before you begin
Role required: none

About this task
To verify your identity while resetting your password, you get a code from an authenticator app 
on your mobile device and then enter the code on the Password Reset  web page.

Password Reset  supports the following authenticator apps:

• Google  Authenticator

• Microsoft  Authenticator

• Cisco  Duo

• Okta  Verify

Procedure

1. Navigate to All  > Password Reset  > Enroll.

2. Click the Authenticator App Verification  tab.

Note: 
If your organization requires you to enroll for the Password Reset  Authenticator 
verification method, the tab is marked with an asterisk (*).

3. Download the authenticator app to your device.
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4. Open the app and then use the device to scan the QR code on the tab.

5. When the device generates a code, enter the code in the text box, and then click Pair Device.

6. Select Submit.

7. Optional:  If the system displays a success message, select Submit.

8. Optional:  If the system displays a failure message, enter the code again, click Pair Device, 
and then select Submit.

When you submit the enrollment, the tab displays the following options:

Option Description

Generate New QR Code Enables you to pair a device with a new 
code. This option is useful if you have a new 
device. New data replaces the existing secure 
verification data.

Disable Multi-factor Authentication Deletes existing secure verification data. The 
Google  Authenticator verification is no longer 
available.

9. Optional:  Enroll for an additional identity verification using any of the other methods that your 
organization offers.
For more information about enrolling using different methods, see the following topics:

◦ Enroll for the Password Reset program using questions and answers

◦ Enroll for the Password Reset program using SMS codes

◦ Enroll for the Password Reset program using emailed codes

Enroll for the Password Reset  program using SMS codes

To verify your identity while resetting your password, you can use a code (the SMS code) that 
was delivered to your mobile phone or device. You can enroll on a mobile device.

Before you begin
Role required: none

Procedure

1. Navigate to All  > Password Reset  > Enroll  and then click the SMS Verification  tab.
If your organization requires you to enroll for the SMS verification method, then the tab is 
marked with an asterisk (*).

2. To add and verify a device, click Add Device  and then follow the instructions.

Note: 
If you had previously added an SMS-enabled device to your Password Reset  profile, the 
device is listed.

3. Provide a meaningful name for each device, and if you want to add multiple devices, then 
repeat the process.

4. After you verify each device, select the Authorized  check box for each device that you expect 
to use to change or reset your password.
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Note: 
You can deauthorize a device at any time by clearing the Authorized  check box.

5. Select Submit.

6. Optional:  Enroll for an additional identity verification using any of the other methods that your 
organization offers.

(Optional) For more information about enrolling in the Password Reset  program, see the 
following topics:

◦ Enroll for the Password Reset program using questions and answers

◦ Enroll for the Password Reset program using an authenticator

◦ Enroll for the Password Reset program using emailed codes

Enroll for the Password Reset  program using emailed codes

To verify your identity while resetting your password, you enter a code that was sent to your email 
address. You can enroll for this program on a mobile device.

Before you begin
Role required: none

About this task
During this enrollment process, you add the email address, the system sends you a code so you 
can verify the address, and then you authorize the address to be used for the Password Reset 
process. By default, the system sends the code to the email address that is associated with your 
ServiceNow  profile. You can send the code to additional email addresses.

Procedure

1. Navigate to All  > Password Reset  > Enroll  and then click the Email Verification  tab.
If your organization requires you to enroll for the Email verification method, then the tab is 
marked with an asterisk (*). Email addresses that were added previously are listed on the tab.

2. Click Add Email, enter the email address and a meaningful email name to associate with the 
address and then click Add Email.
Repeat the process for as many email addresses as you need.

3. On the Email Verification  tab, for each email that should receive Password Reset  codes, click 
Verify.
The system sends an email message with a code and then displays the Verify the Email 
Address  pop-up.

4. On the Verify the Email Address  pop-up, enter the code and click Verify.

Note: 
If this process fails, click Send a New Code  to send a different code and try again.

5. After you verify each email address, select the Authorized  check box for each address that 
you expect to use to change or reset your password.

Note: 
To deauthorize an email address so that it does not receive Password Reset  codes, clear 
the Authorized  check box.

6. Click Submit.
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7. Optional:  Enroll for an additional identity verification using any of the other methods that your 
organization offers.
For more information about enrolling using different methods, see the following topics:

◦ Enroll for the Password Reset program using questions and answers

◦ Enroll for the Password Reset program using SMS codes

◦ Enroll for the Password Reset program using an authenticator

Enroll for the Password Reset  program using questions and answers

Your organization might ask you to select the questions to use when resetting your password. 
You select the questions and provide answers that only you know. At another time, when you 
reset your password, your answers verify your identity. You can enroll on a mobile device.

Before you begin
Role required: none

About this task
The list of questions is presented in the language that you requested while logging in.

Procedure

1. Navigate to All  > Password Reset  > Enroll  and then click the QA Verification  tab.
If you are required to enroll for the QA verification method, then the tab is marked with an 
asterisk (*).

2. For each Question  field, select a question from the list and then enter the answer in the 
Answer  field.
Repeat the process until the required number of Question  and Answer  fields are filled in.

3. Click Submit.

4. Optional:  Enroll for an extra identity verification using any of the other methods that your 
organization offers.
For more information about enrolling using different methods, see the following topics:

◦ Enroll for the Password Reset program using SMS codes

◦ Enroll for the Password Reset program using an authenticator

◦ Enroll for the Password Reset program using emailed codes

Enroll for the Password Reset  program using Soft PIN

Verify your identity while resetting your password by using a Soft PIN. To use it, you must enroll 
for the verification using a Soft PIN.

Before you begin
Role required: none

Procedure

1. Navigate to All  > Password Reset  > Enroll.

2. Select the Soft PIN Verification  tab.

Note: 

If your organization requires you to enroll for the Soft PIN verification, then the tab is 
marked with an asterisk (*).
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3. In the Enter the Soft PIN  field, enter a six-digit number of your choice.

Make sure that you follow these rules while enrolling for the Soft PIN verification.

◦ The length of the Soft PIN must be six digits.

◦ The soft PIN repetition threshold is two.

◦ The soft PIN sequence threshold is two.

◦ You can't use your previous five Soft PINs.

Note: 
Based on the configuration set by your admin, these rules might change.

4. Select Submit.
You're enrolled for the Soft PIN verification.

Reset your password on Windows  systems

If your organization uses the Password Reset Windows Application, you can reset your password 
directly from your Windows  login screen.

Before you begin
Role required: none

Procedure

1. Start your computer or press Ctrl+Alt+Delete  to go to the Windows  login screen.

2. Click the Forgot Password?  link.

Note: 
Your administrator may configure different text for the link.

3. On the Identify  page, enter the requested information and then click Next.

4. On the Verify  page, enter the requested information, and then click Next.

Note: 
You might be given the option to choose the method used to verify your identity.

If your identity is verified, the Reset  page displays whether you were successfully verified and 
the state of your account (either locked or unlocked).

5. Based on your locked/unlocked state, perform one of the following actions:

◦ If your account is not locked, the page displays the Reset Password  button. Enter and 
reenter the new password and then click Reset Password.

◦ If your account is locked, the page displays the Reset Password  and Unlock Account 
buttons.

▪ You can enter a new password and click Reset password  to reset the password and 
unlock the account.

▪ If your administrator has selected Enable account unlock  for the password process, you 
can unlock the account without resetting the password by clicking Unlock account.

Password Reset  reference

Reference topics provide additional information about the lists and forms that you use to 
configure and administer Password Reset.
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To view reference information, check the next topics, such as Installed with Password Reset.

Installed with Password Reset

Tables, roles, business rules, scripts, and workflows are installed with the Password Reset 
application.

Password Reset  tables

Table name Description

Password Reset Active Answer

[pwd_active_answer]

Security questions and associated answers, in an 
encrypted state, that users selected while going through 
the enrollment process.

Password Reset Active Question

[pwd_active_question]

Security questions that users selected while going 
through the enrollment process.

Password Reset Activity Log

[pwd_reset_activity]

All Password Reset  requests.

Password Reset Activity Monitor

[pwd_activity_monitor]

Password Reset  lockout activity.

Password Reset Credential Store

[pwd_cred_store]

Password Reset  credential stores that are available.

Password Reset Credential Store 
Parameters

[pwd_cred_store_param]

User-created credential store parameters.

Password Reset Credential Store 
Types

[pwd_cred_store_type]

Password Reset  credential store types that are available.

Password Reset Desktop Access 
Control

[pwd_access_control]

Password Reset Windows Application  access control.

Password Reset Desktop Access 
Log

[pwd_access_log]

Password Reset Windows Application  access logs.

Password Reset Device Enrollment 
Code

[pwd_dvc_enrollment_code]

Device enrollment codes that were sent to users during 
SMS code enrollment.

Password Reset Devices

[pwd_device]

User SMS devices that are in a state of verified.
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Table name Description

Password Reset Email Verification 
Code

[pwd_email_code]

Verification codes that were sent to users via email for 
password reset or email address enrollment.

Password Reset Enrollment for 
Verification

[pwd_enrollment]

Information about user enrollment by verification.

Password Reset Enrollment 
Snapshot

[pwd_enrollment_snapshot]

Snapshot of user enrollment by verification.

This table is used for the reporting purpose.

The Sync Password Reset Enrollment Snapshot Data 
Monthly scheduled job runs once a month to generate 
or sync snapshot data in this table. The data, such as 
sys_user creation or deletion, verification to process 
creation or deletion, and so on, is synchronized.

Password Reset  DB listener is used to create or 
update the data in this table which is managed by the 
pwd_reset.enable.dbListener  property with 
default value as true.

If you’re an admin and want to manually sync the data 
in this table related to an active process, select Sync 
Enrollment Snapshot Data  on that Password Reset 
process.

You can turn off the data synchronization 
in this table through the DB listener or 
the monthly scheduled job by setting the 
pwd_reset.enable.enrollment_snapshot 
property to false.

Note: 
Initially, an inactive record is created by the DB 
listener for a user-verification pair. When the users 
enrol themselves on the Password Reset Enrolment 
page, the record becomes active in this table.

Password Reset Extension Type

[pwd_extension_type]

Extension types that are available.

Password Reset History

[pwd_history]

History of passwords that users reset.

Password Reset Identification Type

[pwd_identification_type]

Password Reset  identification types that are available.

Password Reset Process Password Reset  processes that are available.
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Table name Description

[pwd_process]

Password Reset Process 
Credential Store

[pwd_map_proc_to_cred_store]

Credential stores and the associated Password Reset 
processes that the application is using.

Password Reset Process User 
Group

[pwd_map_proc_to_group]

Groups and the associated Password Reset  processes 
that the application is using.

Password Reset Process 
Verification

[pwd_map_proc_to_verification]

Verifications and the associated Password Reset 
processes that the application is using.

Password Reset Question

[pwd_question]

Questions that the application uses for security question 
verifications.

Password Reset Request

[pwd_reset_request]

Information about Password Reset  requests.

Password Reset Request 
Verification

[pwd_map_request_to_verification]

Password reset requests and the associated verification 
that the application is using.

Password Reset SMS Verification 
Code

[pwd_sms_code]

SMS verification codes that were sent to users for a 
password reset.

Password Reset User Lockout

[pwd_user_lockout]

Users that are locked out of Password Reset.

Password Reset Verification

[pwd_verification]

Verifications that are available.

Password Reset Verification Param

[pwd_verification_param]

User-created verification parameters.

Password Reset Verification Type

[pwd_verification_type]

Password Reset  verification types that are available.
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Password Reset  roles

Role Description

password reset administrator 

[password_reset_admin]

Configures and maintains Password Reset  and 
Password Change.

service desk agent 

[password_reset_service_desk]

Resets passwords on behalf of users, tracks password 
reset requests, and views logs.

credentials manager 

[password_reset_credential_manager]

Determines which credential stores are valid for use 
with Password Reset.

Password Reset  business rules

Business rule Table Description

Abort if password history limit 
exceeds

Password Reset Credential 
Store Parameters

[pwd_cred_store_param]

Prevents setting password history 
limit that exceeds the value of the 
password_reset.history.limit 
property.

You can set a password 
reset history value in the 
password_reset.history.limit 
property. This system property checks 
the history of previous passwords based 
on the specified value. By default, the 
value is 10. But you can set it based on 
your organizational needs.

Note: 
Currently, this property is 
applicable only to the ServiceNow 
credential store.

Add default parameters QA 
verification

Password Reset  Verification

[pwd_verification]

If no parameters for Security Question 
verifications are specified, generates 
parameters.

Add default parameters SMS 
verification

Password Reset  Verification

[pwd_verification]

If there are no parameters specified, 
generates SMS code verifications 
parameters.

Add params personal confirm 
verification

Password Reset  Verification

[pwd_verification]

If there are no parameters specified, 
generates personal data confirmation 
verifications parameters.

Add params personal 
verification

Password Reset  Verification

[pwd_verification]

If there are no parameters specified, 
generates parameters for personal data 
verification.
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Business rule Table Description

Check unique verifications Password Reset  Process 
Verification

[pwd_map_proc_to_verification]

Prevents a verification from being 
assigned multiple times to a specific 
Password Reset  process.

Clear parameters for Mock 
verification

Password Reset Verification

[pwd_verification]

Clears parameters for the Mock 
verification.

Deactivate process with no 
group

Password Reset  Process User 
Group

[pwd_map_proc_to_group]

Deactivates the process if it does 
not apply to all users or if the groups 
associated with it are removed.

Deactivate process with no 
min ver

Password Reset Process 
Verification

[pwd_map_proc_to_verification]

Deactivates the process if the 
verifications associated with the process 
are less than the minimum value for the 
process.

Deactivate process with no 
verification

Password Reset  Process 
Verification

[pwd_map_proc_to_verification]

Deactivates the process if the 
verifications associated with it are 
removed.

Delete history passwords if 
needed

Password Reset Credential 
Store

[pwd_cred_store]

Deletes history passwords if needed.

Enforce password history 
message

Password Reset Credential 
Store

[pwd_cred_store]

Passes enforce password history related 
messages to the client side.

Google Auth Enabled Check Password Reset Process

[pwd_process]

Deactivates the process with Google 
Authenticator verification if the Google 
authenticator is disabled.

GoogleAuthSysPropertyCheck Password Reset Process 
Verification

[pwd_map_proc_to_verification]

Deactivates the process with the Google 
Authenticator verification if the Google 
authenticator is disabled.

Handle req_enroll validation/
default val

Password Reset Process 
Verification

[pwd_map_proc_to_verification]

Handles requires_enrollment and 
auto_enroll values for the process.

Insert/update scheduled job 
for reminder

Password Reset Process

[pwd_process]

Inserts/updates the scheduled job for 
enrollment reminder.

Order must be unique Password Reset Desktop 
Access Control

[pwd_access_control]

Enforces order to be unique.
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Business rule Table Description

Parameter Names Cannot Be 
Updated

Password Reset  Verification 
Param

[pwd_verification_param]

Prevents parameter name changes.

Password Reset  Activity 
Monitor

Password Reset  User Lockout

[pwd_user_lockout]

Creates an event when the number of 
users locked out of Password Reset 
during a specific interval exceeds the 
threshold value.

Password Reset  Validate Auto-
generate

Password Reset  Process

[pwd_process]

Checks that either Email/SMS 
password  or Display password  is 
selected when the Auto-generate 
password  check box is selected.

Personal Data Confirm Param 
Validation

Password Reset  Verification 
Param

[pwd_verification_param]

Checks that a column exists in the 
sys_user table for the parameter used in 
a personal data confirmation verification.

Personal Data Param 
Validation

Password Reset  Verification 
Param

[pwd_verification_param]

Checks that a column exists in the 
sys_user table for the parameter used in 
a personal data verification.

Prevent against deletion Password Reset  Credential 
Store

[pwd_cred_store]

Checks whether the credential store is 
part of an active process before allowing 
deletion.

Prevent against deletion Password Reset  Identification 
Type

[pwd_identification_type]

If an identification type is part of 
an active process, prevents the 
identification type from being deleted.

Prevent against deletion Password Reset  Verification

[pwd_verification]

If the verification is part of an active 
process, prevents it from being deleted.

Prevent against deletion when 
in use

Password Reset Credential 
Store Types

[pwd_cred_store_type]

Prevents deletion when the type is in 
use.

Prevent against deletion when 
in use

Password Reset Verification 
Type

[pwd_verification_type]

Prevents deletion when the type is in 
use.

Queue event if history limit 
decreases

Password Reset Credential 
Store Parameters

[pwd_cred_store_param]

Queues the 
pwd.credStore.history.limit.decrease 
event if history limit decreases.

Security Questions Param 
Validation

Password Reset  Verification 
Param

Checks for valid parameters in security 
question verifications.
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Business rule Table Description

[pwd_verification_param]

Send SMS code Password Reset  Device 
Enrollment Code

[pwd_dvc_enrollment_code]

Sends an enrollment code to a device.

Set new record flag Password Reset  Process

[pwd_process]

Sets a new record flag for the client to 
take appropriate action.

Send SMS Verification Code 
Via Notify Password Reset SMS 

Verification Code

[pwd_sms_code]

Sends out SMS authentication code via 
Notify if the Notify plugin is active.

Single credential store per 
process

Password Reset  Process 
Credential Store

[pwd_map_proc_to_cred_store]

Prevents having more than one 
credential store per process.

SMS Code Param Validation Password Reset  Verification 
Param

[pwd_verification_param]

Checks for valid parameters in SMS 
code verifications.

Update action based on 
access conditions

Password Reset Desktop 
Access Log

[pwd_access_log]

Updates the “action” field of this log 
record based on the access control 
conditions.

Update proc_to_cred_store Password Reset  Process

[pwd_process]

Enforces a one-to-one relation between 
a Password Reset  process and a 
credential store.

Validate Process Password Reset  Process

[pwd_process]

Verifies that a Password Reset  process is 
configured correctly.

Validate Pwd Cred Store Name Password Reset Credential 
Store

[pwd_cred_store]

Enforces the name to be unique.

Validate Pwd Cred Store Type 
Name

Password Reset Credential 
Store Types

[pwd_cred_store_type]

Enforces the name to be unique.

Validate Pwd Extension Type 
Name

Password Reset Extension Type

[pwd_extension_type]

Enforces the name to be unique.

Validate Pwd Identification 
Type Name

Password Reset Identification 
Type

[pwd_identification_type]

Enforces the name to be unique and not 
empty.
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Business rule Table Description

Validate Pwd Process Name Password Reset Process

[pwd_process]

Enforces the name to be unique.

Validate Pwd Verification 
Name

Password Reset Verification

[pwd_verification]

Enforces the name to be unique.

Validate Pwd Verification Type 
Name

Password Reset Verification 
Type

[pwd_verification_type]

Enforces the name to be unique.

Validate Security Question Password Reset  Question

[pwd_question]

Validates rules for security questions 
such as no duplicates or empty 
questions.

Verify Account Lookup Script Password Reset  Credential 
Store

[pwd_cred_store]

Checks whether the account lookup 
script has the correctly named function.

VerifyAutoEnroll Password Reset  Verification 
Type

[pwd_verification_type]

Checks whether auto-enroll is selected 
and ensures that an enrollment check 
script is provided.

Password Reset  UI pages

Name Description

$pwd_reset First page of self-service reset process (asks for user ID).

$pwd_reset_serviceDesk First page of service desk assisted reset process (asks for 
user ID).

$pwd_verify Second page of reset process (asks user to verify identity).

$pwd_new Last page of password change process (asks for new 
password).

$pwd_success Page that appears when password is reset successfully.

$pwd_error Page that appears on error during reset process.

$pwd_confirm For processes configured to email or SMS password 
reset URL: After successful verification, this page displays 
message about sending link to user.

$pwd_change Page for changing password.

$pwd_change_success Page that appears when password is changed successfully.

$pwd_change_error Page that appears on error during password change 
process.

$pwd_enrollment_form_container Enrollment page for all verifications.

$pwd_enrollment_success Page that appears when enrollment is successful.
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Name Description

$pwd_enroll_error Page that appears when any error happens during 
enrollment.

$pwd_unlock_success Page that appears when locked user is successfully 
unlocked.

$pwd_reset_downloads_ui Page for downloading Password Reset Windows 
Application.

Password Reset  UI macros

Name Description

$pwd_csrf_validation CSRF validation for Password Reset Application. 
If violation is detected, the page will be 
redirected to the error page.

$pwd_display_password Displays a temporary password on the success 
page if the process is configured to auto-
generate.

$pwd_enroll_email_ui and 
$pwd_verify_email_ui

UI for email enrollment and verification.

$pwd_enroll_google_auth_ui and 
$pwd_verify_google_auth_ui

UI for Google Authentication enrollment and 
verification.

$pwd_enroll_questions_ui UI for question and answer security validation 
enrollment.

$pwd_enroll_questions_ui_js JavaScript code that requires server-side data for 
security question and answer enrollment.

$pwd_enroll_sample_ui Sample UI macro for enrollment for Mock 
Verification Type.

$pwd_enroll_sms_ui and 
$pwd_verify_sms_ui

UI for SMS enrollment and verification.

$pwd_enrollment_form_title Jelly macro function that prints the title for the 
enrollment form. A verification ID is mandatory.

$pwd_error_message UI for displaying error messages.

$pwd_process_flow UI for indicating current stage.

$pwd_process_footer JavaScript code to get the footer macro name.

$pwd_reset_stylesheet JavaScript code to get the default CSS file ID.

$pwd_verify_personal_data_ui and 
$pwd_verify_personal_data_confirmation_ui

UI for verifying personal data and for confirming 
personal data.

$pwd_verify_questions_ui UI for verifying questions.

$pwd_verify_simple_ui Input section for a simple verification method. 
This field is a single input field.

UI scripts installed with Password Reset
You can create a UI script and reference the script from a UI macro or UI page 
by using a <g:include_script>  Jelly tag. The following example shows 
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how the $pwd_enroll_questions_ui  UI macro can reference the 
$pwd_enroll_questions_ui  script. In the example, [UI Script Name]+".jsdbx" 
is the name of the script:

<g:include_script src="$pwd_enroll_questions_ui.jsdbx" />

By referencing an external script, you can maintain separation between client JavaScript code 
and Jelly code, which simplifies maintenance. You can use the following installed scripts with 
Password Reset  UI macros:

Name Description

$pwd_csrf_common_ui_script Common UI script for handling a Cross-site Request Forgery 
(CSRF).

$pwd_enroll_email_ui JavaScript code for the $pwd_enroll_questions_ui UI macro.

$pwd_enroll_google_auth_ui JavaScript code for the $pwd_enroll_google_auth_ui UI 
macro.

$pwd_enroll_questions_ui JavaScript code for the $pwd_enroll_questions_ui 
UI macro.

$pwd_enroll_sample_ui Included sample client JavaScript for the 
$pwd_enroll_sample_ui  UI macro.

$pwd_enroll_sms_ui SMS enrollment UI script.

$pwd_enrollment_submit_event UI script for an enrollment submission event.

$pwd_util Utilities for password reset UI pages and UI macros.

$pwdWfManager Helper class to handle workflow activities and post-
processing.

Password Reset  workflows
The Password Reset  plugin adds workflows that you can use as examples to create custom 
workflows for Password Reset  processes.

Workflows that connect to a credential stores

Workflow Description

Pwd Reset - AD Connects to an AD server.

Pwd Reset - Local 
ServiceNow

Current (local) instance.

Pwd Reset - Master Password Reset  primary workflow.

Pwd Reset - Mock Fatal Example workflow to use in Password Reset  testing to simulate a 
fatal error. No retries.

Pwd Reset - Mock Non 
Fatal

Example workflow to use in Password Reset  testing to simulate a 
non-fatal error.

Pwd Reset - Mock 
Success

Example workflow to use in Password Reset  testing to simulate a 
successful completion.

Pwd Reset - Remote 
ServiceNow

Connects to a remote(SOAP) ServiceNow  instance.
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Workflows that test the connection to a credential store

Workflow Description

Pwd Connection Test - AD Tests connection to an AD server.

Pwd Connection Test - Local 
SN

Tests connection to local instance.

Pwd Connection Test - 
Master

Master workflow to test credential store connectivity.

Pwd Connection Test - Mock 
Failure

Example credential store connection test that simulates a failed 
connection.

Pwd Connection Test - Mock 
Success

Example credential store connection test that simulates a 
successful connection.

Pwd Connection Test - 
Remote SN

Tests connection to a remote(SOAP) ServiceNow  instance.

Workflows that determine the lock state of a user account

Workflow Description

Pwd Get Lock State - AD Gets a user account lock state for the AD server.

Pwd Get Lock State - Local 
SN

Workflow to get a user account lock state for the local instance.

Pwd Get Lock State - Master Primary workflow to get a user account lock state.

Pwd Get Lock State - 
Remote SN

Gets a user account lock state for the remote(SOAP) ServiceNow 
instance.

Workflows that unlock a user account

Workflow Description

Pwd Unlock Account – AD Unlocks a user account for a local instance.

Pwd Unlock Account - Local SN Workflow to unlock a user account for a local instance.

Pwd Unlock Account - Master Master workflow to unlock a user account.

Pwd Unlock Account – Remote 
SN

Unlocks a user account for a remote(SOAP) ServiceNow 
instance.

Workflows that change a password

Workflow Description

Pwd Change - Master Password change primary workflow.

Pwd Change – Local 
ServiceNow

Connects to a local instance to change a password.

Pwd Change – AD Connects to an AD server to change a password.

Pwd Change – Remote 
ServiceNow

Connects to a remote(SOAP) ServiceNow  instance to change a 
password.
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Password Reset  notifications

Name Fired by event name Description

Password 
Reset – Send 
SMS Code

pwd.send_sms_code.trigger Sends out SMS authentication code for 
verification.

[K] Password 
Reset – Send 
Email Code

pwd.send_email_code.trigger Sends out authentication code via Email for 
verification.

Password 
Reset - 
Enrollment 
Reminder

pwd.enrollment_reminder.trigger Sends emails to remind users to enroll in the 
required verifications.

Password 
Reset - New 
Password 
Confirmation

pwd.email.trigger For the Email/SMS Password process, 
sends an email or SMS (if configured) that 
includes the new password.

Password 
Reset - Send 
Verify Code

pwd.send_verify_code.trigger Sends authentication code to users 
using email or SMS for password reset or 
enrollment.

Note: 
If the Notify plugin is active, SMS code 
is sent via Twilio instead of ServiceNow 
Notification.

Password 
Reset URL

password.reset.url For the Email/SMS Password Reset URL 
process: Sends email or SMS (if configured) 
that includes a link to the password reset 
URL.

Note: 
Check the following items if the 
instance does not send the email 
notification to the user:

• Check the System Event [sys_event] 
table to see if the email was sent.

• Verify that the user is subscribed to 
the notification.

• Verify that the Default Self Service 
password reset process and 
password reset properties are 
configured correctly.
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SOAP messages for Password Reset

SOAP 
Message

Description

Change 
Password

When the Orchestration Add-on plugin is active, the system can use the SOAP 
protocol to change passwords on remote credential stores such as a remote 
ServiceNow  instance.

Password 
Reset 
Request

When the Orchestration Add-on plugin is active, the system can use the SOAP 
protocol to reset passwords on remote credential stores such as a remote 
ServiceNow  instance.

REST API

• Name: Pwd Reset

• API ID: pwd_reset

• Base API path: /api/now/pwd_reset

Resources (Version v1)

Name Resource path
API 
Version

Description

pwd_init /api/now/
v1/pwd_reset/init

v1 Initial request to establish session, write logs, 
and fetch UI messages.

pwd_identify /api/now/
v1/pwd_reset/identify

v1 Get identification page components.

pwd_verify /api/now/
v1/pwd_reset/verify

v1 Get verification page components.

pwd_new /api/now/
v1/pwd_reset/reset

v1 Get resetting password page components.

pwd_success /api/now/
v1/pwd_reset/
success

v1 Get success page components.

pwd_failure /api/now/
v1/pwd_reset/failure

v1 Get failure page components.

Resources (Version v2)

Name Resource path
API 
Version

Description

pwd_init /api/now/
v2/pwd_reset/init

v2 Initial request to establish session, write logs, 
and fetch UI messages.

pwd_identify /api/now/
v2/pwd_reset/identify

v2 Get identification page components.

pwd_verify /api/now/
v2/pwd_reset/verify

v2 Get verification page components.
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Resources (Version v2)  (continued)

Name Resource path
API 
Version

Description

pwd_new /api/now/
v2/pwd_reset/reset

v2 Get reset password page components.

pwd_success /api/now/
v2/pwd_reset/
success

v2 Get success page components.

pwd_failure /api/now/
v2/pwd_reset/failure

v2 Get failure page components.

Domain separation and the Password Reset  application

Domain separation is supported in the Password Reset  application. A password reset process 
that you define in any domain is isolated from a process that you create in any other domain. 
Domain separation enables you to separate data, processes, and administrative tasks into 
logical groupings called domains. You can control several aspects of this separation, including 
which users can see and access data.

Support level: Standard

• Includes all aspects of Basic  level support.

• Application properties are domain-aware as needed.

• Business logic: The service provider (SP) creates or modifies processes per customer. The use 
cases reflect proper use of the application by multiple SP customers in a single instance.

• The instance owner must configure the minimum viable product (MVP) business logic and data 
parameters per tenant as expected for the specific application.

Sample use case: An admin must be able to make comments required when a record closes for 
one tenant, but not for another.

For more information on support levels, see Application support for domain separation .

How domain separation works in Password Reset

Domain separation for Password Reset  is applied at the process level. The admin configures the 
following elements to define a password reset process: A connection to a credential store, user 
groups that can use the process, method of identification, and verifications to use during the 
process.

• A connection to the credential store where user credentials (like username/password) 
are securely stored. Each connection inherits the domain setting from a template called a 
connection type. Each connection type is tied to a domain (the connection type record has a 
domain field). There are uniqueness constraints on connection names within a domain.

• One or more user groups on the ServiceNow instance that can use the password reset 
process. User accounts are members of one or more domains — they use the standard 
ServiceNow  domain separation. When a user enrolls to use one of the password reset 
processes that is configured for the organization, the user is allowed to choose only from the 
processes in the user’s domain.

• The identification — the method that the end user employs to claim identity for the public 
password reset or password change process. Each identification inherits the domain setting 
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from a template called an identification type. Each identification type is tied to a domain 
(the identification type record has a domain field). There are uniqueness constraints on 
identification names within a domain.

• One or more verifications — methods to verify the identity of the person who is attempting 
to reset the password. Each verification inherits the domain setting from a template called a 
verification type. Each verification type is tied to a domain (the verification type record has a 
domain field). There are uniqueness constraints on verification names within a domain.

• All Password Reset  tables have a domain column.

• Password Reset  process tables include a sys-overrides  column on business rules, UI 
actions, and so on.

• The Password Reset  application is built using Orchestration. Orchestration  supports "Data 
only" domain separation — the data security model of separating visibility of data from one 
domain to another.

Password Change process

The Password Change application extends the Password Reset  application by letting admins 
define how users change their passwords. A service desk-assisted process is not supported. An 
admin must publish the URL for the self-service password change form.

The Password Change application enables an end user to change a password over the Internet 
using a browser on any supported interface, including mobile devices. The end user can select 
from any configured process in the end user’s domain (or child domain of an end user’s domain).

A password change process uses the same elements as a password reset process (connections, 
user groups, identifications, and verifications), with the same domain-separation features.

Related topics

Domain separation for service providers

Password Reset  Process form

Description of the fields on the Password Reset  Process form.

Fields in the Process Strength Configuration section on the Password Reset Process form

Field Description

Security score View the security score in digits. As the security score changes, the color of 
the field changes.

The following are three ranges of the security score:

• 0 to 40: The color is red and the security is low.

• 40 to 75: The color is orange and the security is medium.

• 76 to 100: The color is green and the security is high.

Enable 
security score 
notification

Send security score notifications to process owners.

If this field is selected, a weekly scheduled job sends emails containing the 
security score for all the active public processes.

Note: 
The email notifications aren't sent for the service-desk processes and 
the processes for which only Change Password is configured.
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Fields in the Process Strength Configuration section on the Password Reset Process form 
(continued)

Field Description

Process owner Designate one or more users as owners for the process you're creating. You 
can add only the users with the password reset admin role to this field.

If you select Enable security score notification, the Process owner field 
becomes a required field.

Note: 
The Process Strength Configuration section is displayed only when you select the Public 
access  check box in the Password Reset Details tab.

Description of the fields on the Password Reset Details tab

Field Value

Public 
access The check box is available only when Password reset  is selected.

• Select the check box to enable a self-service process with public user access 
to the Password Reset  or Password Change form through a URL.

• Clear the check box to define a Service desk-assisted process in which only 
service desk agents can reset a password at the request of a user.

Public URL
The field is available only when Public access  is selected.

URL of the page where users go to reset or change the password. The value from 
the URL suffix field is appended to the URL when you tab out of the URL suffix 
field. For the Default self-service Password Reset  process, this value must be /
$pwd_reset.do?sysparm_url=ss_default.

URL suffix
The field is available only when Public access  is selected.

Suffix used to create a unique URL for the Password Reset  or Password Change 
form.

Display 
CAPTCHA The check box is available only when Public access  is selected.

Select the check box to display a CAPTCHA on the user identification page.

The Password Reset  application uses Google reCAPTCHA as the default 
CAPTCHA service. See Configure Google reCAPTCHA for the password reset 
process.

Note: 
The Password Reset Windows Application  uses the base-system 
CAPTCHA service even if the Password Reset  application is configured to 
use Google reCAPTCHA.

Because on-premises instances do not have access to the internet, 
the instances cannot use the Google reCAPTCHA service. Set the 

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4390



Description of the fields on the Password Reset Details tab  (continued)

Field Value

password_reset.captcha.google.enabled  system property to false 
for on-premises instances.

To use the base system CAPTCHA, change the 
password_reset.captcha.google.enabled  system property to false.

Identification 
type

Method that the user employs to claim identity for the public Password Reset 
or Password Change process. Any selection overrides the default identification 
that is associated with the process.

The base system  includes the Email and Username Identification identification 
types. You can create a custom identification type (some knowledge of 
JavaScript is recommended).

See Personal data identification types and confirmation type verifications.

Redirect URL URL to go to after a successfully resetting a password — typically, the URL of the 
original login page.

Enter a complete path, including the protocol (for example, https://
myDomain.myURL.com). If the path is under the same domain as the Public URL, 
then start the path with the / character.

Minimum 
verifications

Number of verifications that a user must successfully submit to reset the 
password.

If the number exceeds the number of required verifications, then the user must 
submit enough additional optional verifications to meet the number specified for 
Minimum verifications.

Note: 
Each user must submit all mandatory verifications regardless of the 
number specified.

By default, during the password reset process, the system presents optional 
verifications to the user based on the Order  values for the verifications. If you 
selected Allow user to choose from optional verifications, then the Verification 
page presents all optional verifications to the user. The user then selects the 
appropriate number of verifications. In this example, the Minimum verifications 
value is 1. Because no mandatory verifications are configured, the user can 
choose an optional verification.

Also, see Allow user to choose from optional verifications.

Allow user to 
choose from 
optional 
verifications

Select the check box to enable a user, on the Verifications page during the 
process of resetting the password, to select which optional verifications to use. 
The choice of optional verifications appears only if the Minimum verifications 
setting is greater than the number of mandatory verifications.

The number that you specify for Minimum verifications  determines how many 
optional verifications that the user is allowed to select.
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Description of the fields on the Password Reset Details tab  (continued)

Field Value

In the example, the Minimum verifications  setting is 2  and there are no 
mandatory verifications. The user has selected two optional verifications, so 

cannot select a third verification.

Email/SMS 
Password 
Reset  URL

Select the check box to enable users to reset the password by clicking a link 
in an email that the instance sends to them. This is the secured method of 
resetting a password. If configured, the instance also sends the URL to the users 
through SMS on mobile devices. By default, the self-service Password Reset 
processes enable this option.

When you select this option, the Auto-generate password  check box is not 
available. See Example: The default self-service Password Reset  process  for 
an outline of the process that is enabled by default.

If you don’t select the Email/SMS Password Reset URL  option and try to save 
the record, you get a message that suggests you select the verification options 
to configure with secure verification.

You can’t set the QA verification as the only verification for this process 
as the process becomes less secure. You must either enable the Email/
SMS Password Reset URL  option or configure this process with multi-factor 
authentication. Also, you can’t configure the process only with personal data 
and QA verifications. You must configure any other verification along with these 
two.

If you still don’t select the Email/SMS Password Reset URL  option with a weak 
security verification configuration, it might allow unauthenticated users to reset 
any user’s password using any user ID or email address.

Enable 
account 
unlock

This check box is available only when Password reset  is selected.

Select the check box to allow user accounts on credential stores to be unlocked 
without resetting the password.

Note: 
Not supported by the default self-service Password Reset  process.

Unlock user 
account

Select the check box to unlock user accounts on credential stores after a 
password reset.
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Description of the fields on the Password Reset Details tab  (continued)

Field Value

Auto-
generate 
password

Select the check box to auto-generate a new password for the user. When this 
check box is selected, you must select the Email/SMS password  or Display 
password  check box, or both. This setting is useful for Service Desk  assisted 
processes.

This check box is available only when:

• The Password reset  check box is selected.

• The Email/SMS Password Reset URL  check box is cleared.

Note: 
If you use the credential store on your local ServiceNow  instance or 
an Active Directory credential store: Clear the check box to enable the 
Enforce history policy  option for a credential store. See Configure the 
connection to a credential store for the Password Reset processes.

User must 
reset 
password

This check box is available only when Auto-generate password  is selected.

Select the check box to require users to reset their password immediately after 
logging in with the auto-generated password.

Note: 
Users whose credentials are held in the local ServiceNow  instance 
credential store are prompted to change their password the first time 
that they log in. Users whose credentials are held in an Active Directory 
credential store are not prompted to change their passwords in the 
instance. Such users must change their passwords from a computer on the 
domain.

Display 
password This check box is available only when Auto-generate password  is selected.

Select the check box to display the new password on the screen. In a self-
service process, the password appears on the user screen. In a service desk-
assisted process, the password appears on the service desk agent screen.

Email/SMS 
password This check box is available only when Auto-generate password  is selected.

Select the check box to email or SMS the new password to the user. The setting 
is useful in both self-service and Service Desk  assisted processes. The setting 
can add a layer of security by requiring that users access their email or SMS 
to view the password. In a Service Desk  assisted process, sending password 
through email or SMS to users ensures that only the user requesting the 
password reset can view the password.

Related lists on the Password Reset Details tab

List Description

Verifications One or more verifications that the Password Reset  process uses. See Password 
Reset verifications.
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Related lists on the Password Reset Details tab  (continued)

List Description

The Verifications related list is available only after the record has been saved.

Groups ServiceNow  user groups to associate with the Password Reset  process.

The Groups related list is available only after the record has been saved and if 
the Apply to all users  check box is cleared.

Description of the fields on the Advanced tab

Field Description

Entry UI macro UI macro that displays a customized message to users when they 
access the initial Password Reset  screen.

Success UI macro UI macro that displays a customized message to users on the 
final Password Reset  screen when their password is successfully 
reset.

Failure UI macro UI macro that displays a customized message to users on the 
final Password Reset  screen when their password reset fails.

Post reset script Script include that performs actions after the Password Reset 
process completes whether the outcome is success or failure. 
For more information on customizing post processor scripts, see 
the Post reset  script category as described in Password Reset 
extension script categories.

Header UI macro or Footer 
UI macro

Macros that add a header or footer to customize the appearance 
of the pages that end users work in while resetting a password 
(the Identify, Verify, and Reset pages. See Add a custom header 
or footer to the user pages for Password Reset.

Related topics

Configure your Password Reset process

Password Expiration Configuration form

Description of the fields on the Password Expiration Configuration form.

Password Expiration Configuration form

Field Description

Days 
password 
is valid

The number of days that you want a password to be set as valid.

The default value is 90.

Days prior 
to start 
reminders

The number of days required to send notifications before password expiration. 
For example, if you set it to 5 days, a notification is sent 5 days prior to password 
expiration.

The default value is 10.
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Password Expiration Configuration form  (continued)

Field Description

Schedule 
Frequency Frequency to send reminders, such as daily or periodically. The default value is 

Daily.

If you select Periodically, then notifications are sent based on the period, for 
example, alternate days or once in three days.

Time zone The time zone to send reminders.

Time The time when you want reminder notifications to be sent.

Repeat 
Interval The days and the time that you want to use to send reminders with a specific 

interval. For example, when you enter 2 days and time, the notification is sent 
alternate days on the time you specified.

This field appears only when Periodically  is selected from the Schedule 
Frequency  field.

Start time The time when you want a notification reminder to be started.

Related topics

Password Expiration Configuration form

System properties for password expiration

You can configure the system properties that support operations in password expiration.

To navigate to the system properties, you can select All  and then enter 
sys_properties.list  in the navigation filter.

Properties for password expiration

Property Description

pwd_reset.enable.password_expiration_reminder Use this property to enable or turn off a 
password expiration feature. By default, the 
value of this property is false, which means 
that password expiration is turned off by 
default.

pwd_reset.enable.dbListener
Use this property to enable or turn off the 
password reset DB listener (to raise events). 
The default value is true, which means that 
the property is enabled by default.
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Properties for password expiration  (continued)

Property Description

Note: 
If this property is enabled, the 
password expiration records are 
managed automatically while inserting 
or deleting user data. While importing 
bulk data, for each sys_user or 
sys_user_grmember insertion or 
deletion, password expiration records 
are inserted or updated for each 
password reset process that users 
are entitled to. Even if updating the 
expiration data is an asynchronous 
activity, this activity might impact 
the performance, if the number of 
users is high. In that case, disable the 
pwd_reset.enable.dbListener 
property by setting it to false 
so that there is not an event on 
insertion or deletion of sys_user or 
sys_user_grmember.

pwd_reset.password_expiration.error_count
Number of maximum attempts (if there is 
failure) while retrieving the expiration details 
from the external credential store for a user.

The default value is 5. The expiration record 
is deactivated if the error count exceeds the 
value of this property.

This property is not available by default. To 
use the property, you must create it.

pwd_reset.refresh_expiration_data.duration
Duration, in days, to refresh the expiration 
details for a user whose password never 
expires. The default value is 30 days.

This property is not available by default. To 
use the property, you must create it.

Related topics

Configure password expiration reminder

Password Reset  Credential Store form

Description of the fields on the Password Reset  Credential Store form.

Type Type of credential store that you are connecting to. A ServiceNow  credential 
store type is a template that provides the required set of capabilities for a 
particular kind of credential store. Credential stores inherit the functionality of 
the credential store type.
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Note: 
For an AD credential store, skip this procedure and see Integrate 
Password Reset with your Active Directory service. The Password Reset 
Windows Application  supports only AD credential stores.

Auto generate 
password

Script include that generates a temporary password for use during the reset 
process.

If you select the Enforce history policy  check box, then you must specify 
a value for Auto-generate password  that is compliant with the password 
policy.

Enforce history 
policy

Appears only if you select a credential store Type  of AD Credential Store  or 
Local ServiceNow Instance. For information on configuring the setting for an 
AD credential store, see Configure the connection to an AD credential store.

Select the Enforce history policy  check box to ensure that users do not 
reuse passwords. For example, you might configure the history policy to 
not allow the user to reuse any of the previous 10 passwords.  Follow this 
procedure:

1. Select the Enforce history policy  check box.

2. In the Password Reset Credential Store Parameters related list, create a 
password_history_limit  parameter.

3. Set the value of the parameter to the number of previous passwords that 
cannot be used (maximum 10). The default value of 0 (zero) enables use of 
any previous password.

Child Alias Child aliases are associated with the base alias. After creating a connection 
and credential alias, you can create a child alias to configure multiple 
connections for a password reset credential store. When a password reset 
request is made, the flow checks whether there are child alias connections at 
the process level. If the child alias is configured at the credential store level, 
the flow picks the aliases connections and proceeds with the request.

Enable 
password policy

See Enable password policies on your instance

Password policy You can use the default policy or define your own.

Hostname URL or IP address of the credential store.

User account 
lookup

Script include that maps the user ServiceNow  platform ID to the user 
credential store ID. A default script, PwdDefaultUserAccountLookup, 
returns the user ServiceNow  platform user name.

Password rule 
hint

Specify the text that appears on the password reset page to help the user 
to create a password that meets all requirements. The Password rule  script 
enforces the requirements.

Note: 
The Password Reset Windows Application  supports newline characters 
in the hint. Other formatting is not supported (bold, underline, hyperlink, 
and so on).

Password rule Specify the client script that validates the new password that the user enters. 
The script is invoked when the user enters a new password and clicks 
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Password Reset. You can use the script to enforce password strength/
complexity requirements.

Enable 
Password 
Strength

Select the check box to:

• Display the text box for the Strength rule  script so you can update the 
script.

• Display the graphical Password Strength  bar to the user while the user 
changes or resets the password.

Note: 
The Password Reset Windows Application  does not support Password 
Strength.

Strength rule This text box appears only if you select Enable Password Strength.

Specify the client script that calculates the strength/complexity of the 
password that the user enters. The script is invoked when the user begins to 
enter a new password during the reset process.

Default settings:

• Selected for local ServiceNow  credential stores

• Not selected for other credential stores

Note: 

• To guide the user during the reset process, the system displays a 
graphical bar labeled Password Strength  under the New password 
field.

• The Password Reset Windows Application  does not support 
Password Strength.

Related topics

Configure the connection to a credential store for the Password Reset processes

Password Reset  global properties

You can configure the Password Reset  global properties.

Password Reset  properties

Property Label Property Name Description

Password Reset  Global Properties

Email template for 
enrollment reminder 
emails

password_reset.enroll 
_reminder.email_template The instance can send 

email reminders to users 
who are not yet enrolled 
in the Password Reset 
process.
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Password Reset  properties  (continued)

Property Label Property Name Description

Template to use for the 
email messages that 
remind users to enroll 
for the password reset 
process. See Send email to 
remind users to enroll for 
Password Reset.

Workflow polling 
frequency

password_reset.wf.refresh_rate
Time period in milliseconds 
between checks on status 
of the Password Reset 
workflow.

• Type: integer

• Default value: 500

Workflow expiration password_reset.wf.timeout Maximum wait time in 
milliseconds for the 
workflow to complete. 
The workflow is triggered 
during the password reset 
request when the user 
clicks Submit.

• Type: integer

• Default value: 90000

Disable CAPTCHA 
validation functionality

password_reset.captcha.ignore Enables or disables 
CAPTCHA functionality.

• Type: true|false

• Default value: false

The Password Reset 
application uses Google 
re-CAPTCHA as the default 
CAPTCHA service.  To 
use the base system 
CAPTCHA, change the 
password_reset.captcha.google.enabled 
system property to false.

See Configure Google 
reCAPTCHA

Password Reset  Request Properties

Number of 
unsuccessful attempts 
allowed to resetting/
changing password

password_reset.request.max_attempt Number of password 
reset attempts a user is 
allowed before they are 
locked out for a period 
determined by the value in 
max_attempt_window.
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Password Reset  properties  (continued)

Property Label Property Name Description

• Type: integer

• Default value: 3 
(attempts)

Number of minutes 
a user needs to 
wait for resetting/
changing password 
after exceeding the 
maximum allowed 
unsuccessful attempts

password_reset.request.max_attempt_windowTime period that users are 
blocked or prevented from 
changing their passwords 
after trying the maximum 
number of times.

• Type: integer

• Default value: 1440 
(minutes)

Number of minutes 
a user needs to wait 
to reset/change 
password after the 
last successful reset/
change

password_reset.request.success_window Time period that a user 
must wait after successfully 
resetting the password to 
reset the password again.

• Type: integer

• Default value: 1440 
(minutes)

Number of minutes 
a user needs to 
wait to start a reset 
request after the last 
successful unlock 
account.

password_reset.request.unlock_window Time period that a 
user must wait after 
a successful unlock 
operation before starting a 
new request.

• Type: integer

• Default value: 1440 
(minutes)

Number of minutes 
before a password 
reset request expires

password_reset.request.expiry Time period during which 
a user must perform the 
Password Reset  process.

• Type: integer

• Default value: 10 
(minutes)

Number of hours 
before the password 
reset one time token 
validity expires

glide.pwd_reset.onetime.token.validity Time period during which 
a user must perform the 
Password Reset  process 
using the email link.

• Type: integer

• Default value: 12 (hours)
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Password Reset  properties  (continued)

Property Label Property Name Description

Note: 
The setting for the 
glide.pwd_reset.onetime.token.validity 
property takes 
precedence over 
the setting for 
password_reset.request.expiry 
when the Email 
Password Reset 
URL  check box on 
the process record is 
selected.

Maximum number 
of times that a user 
can receive "Reset 
Password" link via 
email, in a span of 24 
hours. The upper limit 
is 5.

password_reset.request.max_email Maximum number of 
times a user can receive 
emails containing a link 
for resetting a password 
in a duration of 24 hours. 
For example, when you set 
the maximum number to 
3, users would receive 3 
emails in the duration of 
24 hours. The maximum 
number you can set is 5.

Password Reset  Security Question Properties

Number of security 
questions required 
during the password 
reset request

password_reset.qa.num_reset
Number of security 
questions that are 
displayed on the Verify 
page while a user is 
attempting to reset the 
password. The user must 
answer all questions 
correctly to verify identity. 
The questions are selected 
at random and are 
presented in random order.

• Type: integer

• Default value: 3 
(questions)

• Possible values: Integers 
that are less than the 
number specified 
for the Number of 
security questions 
required during 
enrollment  property 
(the num_enroll 
parameter).
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Password Reset  properties  (continued)

Property Label Property Name Description

Note: 
You can override 
this property setting 
for a Password 
Reset  process 
by configuring 
the num_reset 
parameter. See 
Specify the number 
of required security 
questions.

Number of security 
questions required 
during enrollment

password_reset.qa.num_enroll
Number of questions that a 
user must provide answers 
to while enrolling for the 
Password Reset  process.

• Type: integer

• Default value: 5

• Possible values: Integers 
that are greater than 
or equal to the number 
specified for the Number 
of security questions 
required during 
enrollment  property (the 
num_reset  parameter).
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Password Reset  properties  (continued)

Property Label Property Name Description

Note: 

• While attempting 
to verify identity, 
if a user answers 
a question 
incorrectly, the 
application 
refreshes with 
a random set 
of the specified 
questions in 
random order. You 
should, therefore, 
require more 
questions than 
specified for the 
Number of security 
questions required 
during enrollment 
property (the 
num_reset 
parameter).

• You can override 
this property 
setting for a 
Password Reset 
process by 
configuring the 
num_enroll 
parameter. See 
Specify the number 
of required security 
questions.

Minimum length 
requirement for 
security answers

password_reset.qa.ans_min_len Minimum number of 
alphanumeric characters 
that the user must enter in 
the answer text box for any 
security question.

Default value: 3 characters

Password Reset  SMS Code Properties

Maximum number of 
SMS codes sent for 
verification per day

password_reset.sms.max_per_day
Maximum number of SMS 
codes that are sent to a 
user within one 24-hour 
period. The 24-hour period 
begins when a user clicks 
Send Code.
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Password Reset  properties  (continued)

Property Label Property Name Description

• Type: integer

• Default value: 10 (per 
day)

Note: 
You can override 
this SMS code 
property by adding 
the max_per_day 
parameter in the SMS 
code verification.

Number of minutes 
before the user can 
attempt to send 
another SMS code for 
verification

password_reset.sms.pause_window
Time that must pass before 
another SMS code can be 
sent to a user.

• Type: integer

• Default value: 2 (minutes)

Note: 
You can override 
this SMS code 
property by adding 
the pause_window 
parameter in the SMS 
code verification.

Number of digits in the 
SMS code sent to the 
user

password_reset.sms.default_complexity
Number of characters 
required for a user to reset 
their password.

• Type: integer

• Default value: 4 (digits)

You can override this 
SMS code property by 
adding the complexity 
parameter in the SMS code 
verification.

Number of minutes 
before the SMS code 
expires

password_reset.sms.expiry
Time, in minutes, until the 
SMS code sent to the user 
expires.

• Type: integer

• Default value: 5 
(minutes)
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Password Reset  properties  (continued)

Property Label Property Name Description

Note: 
You can override this 
SMS code property 
by the expiry 
parameter in the SMS 
code verification.

Use Notify  for SMS 
code notification 
for enrollment and 
verification

password_reset.sms.use_notify Support for SMS channel 
used for notifying users for 
password reset enrollment 
and verification. If selected, 
the users would receive 
notifications through Notify.

• Type: Yes|No

• Default value: Yes

Note: 
To use Notify, 
you must activate 
the Notify  plugin 
(com.snc.notify).

Password Reset  Soft PIN Properties

Enable Soft PIN 
expiration

password_reset.softpin.expiration_enabled
Enables or turns off Soft 
PIN expiration for users.

• Type: Yes|No

• Default value: Yes

Use this property when you 
want to let users know that 
their Soft PIN is expiring. 
You can enable sending 
reminders for Soft PIN 
expiration.

If the users are resetting 
Soft PIN using the Virtual 
Agent,they view the 
corresponding messages 
with the number of days 
when the Soft PIN is going 
to expire.

The number of days 
after which the Soft 
PIN expires

password_reset.softpin.expiration_day
Number of days after which 
the Soft PIN expires. For 
example, if you set the 
number to 90, the Soft PIN 
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Password Reset  properties  (continued)

Property Label Property Name Description

will expire after 90 days are 
completed. The minimum 
limit is 30 days.

Default value: 90

Enable Soft PIN 
expiration reminder

password_reset.softpin.expiration_reminder_enabled
Enables or turns off 
the Soft PIN expiration 
reminders. If selected, the 
users will not get any email 
notifications stating that 
their Soft PIN is expiring.

• Type: Yes|No

• Default value: Yes

The time at which the 
Soft PIN expiration 
reminder is sent. 
Format: HH:MM

password_reset.softpin.expiration_reminder_time
The time at which you want 
the users to receive the 
reminders.

You must enter the value in 
the HH:MM format.

Default value is 00:00 at 
system time zone.

The number of days 
that specify when 
to send a reminder 
before the Soft PIN 
expires

password_reset.softpin.expiration_reminder_warn_days
Number of days that 
specify when to send a 
reminder before the Soft 
PIN expires. For example, 
if you set the value to 
5, users would get the 
reminder 5 days before 
their Soft PIN expires.

Default value: 10

The number that 
sets a history limit on 
reusing previously 
used Soft PINs for the 
enrollment. Use any 
value from 1 to 30

password_reset.softpin.history_limit
Number of previous Soft 
PINs which can’t be reused 
for the enrollment. For 
example,if you set the 
number to 3, the users 
won't be able to use the 
same Soft PIN that's used 
in the previous 3 Soft PINs.

You must use the number 
between 1 and 30.

Default value: 5
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Password Reset  properties  (continued)

Property Label Property Name Description

Password Reset  Monitoring and Reporting Properties

Time interval, in 
minutes, for counting 
blocked users

password_reset.activity_monitor.incident_windowTime window to count the 
number of blocked users.

• Type: integer

• Default value: 60 
(minutes)

Number of blocked 
users, in the defined 
time interval, that 
triggers a system log 
event

password_reset.activity_monitor.incident_thresholdNumber of blocked (or 
locked) users, within the 
specified time window, that 
triggers a system log event.

• Type: integer

• Default value: 10 
(blocked users)

Password Reset  Style Sheet

Style sheet to apply to 
end-user pages during 
the password reset 
process.

password_reset.stylesheet Name of a custom CSS 
style sheet in the Style 
Sheet [content_css] table. 
You can use the default 
style sheet as a template 
for the custom style sheet. 
You cannot add element 
definitions to the style 
sheet.

• Type: string

• Default value: 
css_pwd_reset_default
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Note: 
Several components in the Self Service Password Reset (com.snc.password_reset) 
plugin and the Password Reset (com.glideapp.password_reset) plugin control the 
password reset flow. The following properties affect Password Reset, but do not appear on 
the Password Reset  > Properties  page:

You can add the glide.pwd_reset.onetime.token.validity  property to the 
System Properties [sys_properties] table to specify the number of hours that the Password 
Reset  token should be valid. Default: 12.

Note: 
The setting for the glide.pwd_reset.onetime.token.validity  property 
takes precedence over the setting for password_reset.request.expiry 
when the Email Password Reset URL  checkbox on the process record is selected.

Properties accessible from the System Properties [sys_properties] table:

• For Password Reset  on mobile devices, you can specify the URL that the 
user is taken to when user taps the Forgot password?  button. See the 
glide.security.password_reset.uri  property in High Security Settings  . 
Default: /$pwd_reset.do?sysparm_url=ss_default

• If glide.security.forgot_password.display.link  is set to true, displays 
the Forgot Password?  link on the login page.

Related topics

Configuring Password Reset properties

Verification types in the base system

Use a verification type in the base system  as a template to design a custom verification.

Verification types in the base system

Verification type Description

Personal Data 
Confirmation

Verifies user identity using data from the User [sys_user] table. The 
user data is displayed to a service desk agent. The agent verifies 
the data.

Enrollment is not required for this type.

Recommended for service desk-assisted processes.

Note: 
The Password Reset Windows Application  does not support 
the Personal Data Confirmation Verification type.

See Personal data identification types and confirmation type 
verifications.

Personal Data Verifies user identity using data from the User [sys_user] table. The 
user is required to answer questions.

Enrollment is not required for this type.

Note: 
The Password Reset Windows Application  allows you to 
define and use multiple verifications of the Personal Data type.
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Verification types in the base system  (continued)

Verification type Description

See Personal data identification types and confirmation type 
verifications.

Email Code When a user requests password reset, the system sends a 
verification code to the email address in the user profile or to an 
email address that the user authorized during enrollment. To verify 
identity, the user then submits the code on the Password Reset 
Verify  page.

Note: 
The Password Reset Windows Application  allows you to 
define and use multiple verifications of the Email Code type.

See Personal data identification types and confirmation type 
verifications.

Google Authenticator While requesting password reset, the user reads a code from the 
Google Authenticator app on a device that the user has paired. 
To verify identity, the user then submits the code on the Password 
Reset  Verify  page.

Note: 
The Password Reset  and Password Reset Windows 
Application  support only a single verification of the SMS Code 
type.

Security Questions Verifies user identity by presenting personal security questions that 
the user must answer correctly.

Note: 
The Password Reset  and Password Reset Windows 
Application  support only a single verification of the Security 
Questions type.

See Add a custom question to the Security Questions verification.

SMS Code When a user requests password reset, the system sends a code 
to an SMS-capable device that the user has authorized. To verify 
identity, the user then enters the code on the Password Reset  web 
page.

Note: 
The Password Reset  and Password Reset Windows 
Application  support only a single verification of the SMS Code 
type.

See SMS Code Verification type for Password Reset.

Mock Not a functional identity verification. Demonstrates how to add a 
verification type in a Password Reset  process.

Note: 
The Password Reset Windows Application  does not support 
the Mock verification type.
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Verification types in the base system  (continued)

Verification type Description

• The enrollment UI macro for this verification gets the user input 
and returns the entered value in the enrollment processor.

• The Password Reset  UI macro for this verification gets input from 
the user and returns the entered value through the verification 
processor.

Related topics

Create a custom Password Reset verification

Create a custom Password Reset verification type

Password Reset  Verification Type form

Description of the fields on the Password Reset  Verification Type form.

Field Description

Enrollment check Script that determines whether a user is enrolled for 
verification. Automatic enrollment requires an enrollment 
check. If no script is specified when Automatic Enrollment  is 
selected, a default script is provided.

Automatic enrollment Select the check box to auto-enroll users. If Automatic 
enrollment  is not selected, then you must provide an 
enrollment UI macro and enrollment processor script.

For SMS and email verification, if the Automatic enrollment 
check box is selected and the user's mobile number and email 
address already appear in the sys_user table record, the user is 
enrolled for the corresponding verification.

If the user’s mobile number and email address aren’t 
mentioned in the sys_user table, the user is not enrolled.

Note: 
If the Automatic enrollment  check box isn’t selected, 
then even if the user's mobile number and email address 
appear in the sys_user table record, the user is not 
enrolled. The user must enroll manually by using the 
password reset enrollment process.

Enrollment UI Enrollment UI macro that provides the UI for the enrollment.

Enrollment processor Enrollment processor script that processes the enrollment.

Verification UI Verification UI macro that provides the UI for the verification.

Verification processor Verification processor script (extension scripts) that processes 
the verification.

Related topics

Create a custom Password Reset verification type
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Password Reset  Verification form

Description of the fields on the Password Reset  Verification form.

Field Description

Type Create verifications based on one of the verification types in the base 
system.

Password Reset  supports the following types. You can create multiple 
instances of any type.

• Personal Data Confirmation Verification

• Personal Data Verification

• Security Question Verification

• SMS Code Verification

The Password Reset Windows Application  supports the following types:

• Personal Data Verification. You can create only a single instance.

• Security Question Verification. You can create multiple instances.

• SMS Code Verification. You can create only a single instance.

Order Position of the verification as it appears on the Enrollment form and 
Password Reset  form.

Password Reset 
Verification 
Parameters

Parameters used by a verification to configure specific behaviors, like 
number of questions required to enroll, request expiration time, and 
columns used. Set parameters for any behavior that should be different 
from the value that is specified in the Password Reset  properties.

The available parameters are described separately for each verification 
type.

Related topics

Create a custom Password Reset verification

Password Reset  script includes

The Password Reset  plugin installs script includes that implement password reset processes. To 
enable you to extend functionality, each base-system  script include provides extension points 
that you can use to invoke "extension scripts" that you customized.

The extension script category  refers to the specific types of behavior for an extension script (for 
example, credential store, verification, identification type, or as a post-processor).

'Enrollment check' script includes

All enrollment check script includes take the following parameters and return a boolean 
indicating whether the user is enrolled for Password Reset.

• params.userId: The sys_id of the user being checked (table: [sys_user]).

• params.verificationId: The sys_id of the verification being checked (table: 
[pwd_verification]).
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Name Description

PwdAlwaysEnrolled Default check of whether a user is enrolled that always 
returns true.

PwdMockIsEnrolled Default check of whether a user is enrolled that always 
returns true.

PwdQuestionsEnrollmentCheck Determines whether a user has enrolled for Password Reset 
using security question verification.

PwdSMSEnrollmentCheck Determines whether a user has enrolled for Password Reset 
using SMS verification.

'Identification form processor' script includes

Identification form processor script includes provide functionality for extending identification 
processing.

All identification form processor script includes take the following parameters, and return the 
sys_id of the user that corresponds to the requested input. If the user was not identified, it 
returns null.

• params.processId: The sys_id of the calling Password Reset  process (table: 
[pwd_process]).

• param request: The form request object. Fields in the form can be accessed with 
request.getParameter('<element-id>'). The supported request parameter is 
sysparm_user_id, the user identifier value entered in the form.

Name Description

PwdIdentifyViaEmail Verifies a user's identity by checking the email address.

PwdIdentifyViaUsername Verifies a user's identity by checking the user name.

'Enrollment form processor' script includes

Enrollment form processor script includes provide functionality for extending enrollment form 
processing.

All enrollment form processor script includes take the following parameters, and return a boolean 
indicating whether the user was successfully enrolled.

• params.userId: The sys_id of the user trying to enroll (table: [sys_user]).

• params.verificationId: The sys_id of the verification used to enroll (table: 
[pwd_verification]).

• params.enrollmentId: The sys_id of this enrollment process.

• request: The form request object. Fields in the form can be accessed with 
request.getParameter('<element-id>').

You should add the following information to the state of the enrollment process:
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• gs.getSession().putProperty("result.status",status): Whether the user 
was successfully enrolled.

• gs.getSession().putProperty("result.message",message): An associated 
message to be returned to the UI, such as a detailed error message.

• gs.getSession().putProperty("result.value",value): A custom value 
associated with the enrollment.

Name Description

PwdEnrollQuestionsProcessor Handles questions and answers for verification.

PwdEnrollSampleProcessor Provides an enrollment processor for sample verification.

PwdEnrollSMSProcessor Provides an enrollment processor for SMS verification.

'User account lookup' script includes

User account lookup script includes return the credential store account_id for a given user.

The following parameter returns the credential store account_id for a given user. 
params.userId: The sys_id of the user being checked (table: [sys_user]).

Name Description

PwdDefaultUserAccountLookup Provides a default script for user account lookup from a 
user_id to the account in a credential store. The default 
mapping is to use the user name as the account name.

'Password generator' script includes

Password generator script includes take the following parameter, and return an auto-generated 
string password.

params.credentialStoreId: The sys_id of the calling Password Reset  process (table: 
[pwd_process]).

Name Description

PwdDefaultAutoGenPassword Generates a password from a random word and 4 digits.

'Verification processor' script includes

If the user identity is verified, the verification processor script includes return true.

Verification processor script includes take the following parameters:

• params.resetRequestId: The sys_id of the current Password Reset  request (table: 
[pwd_reset_request]).

• params.userId: The sys_id of the user to be verified (table: [sys_user]).

• params.verificationId: The sys_id of the verification (table: [pwd_verification]).

• request: The form request object. Access the fields in the form with 
request.getParameter('<element-id>').
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Name Description

PwdVerifyPersonalDataConfirmationProcess Verifies that the user accepts the answer.

PwdVerifyPersonalDataProcessor Verifies that the user's answers match the 
expected data in the system.

PwdVerifyQuestionsProcessor Provides question and answer verification of 
user input on the second page of the verification 
form.

PwdVerifySimpleProcessor Provides simple verification of user input on the 
second page of the verification form.

PwdVerifySMSProcessor Provides SMS verification of user input on the 
second page of the verification form.

'Post processor' script includes

Post processor script includes execute custom actions after the Password Reset  process has 
completed.

All post processor script includes take the following parameters.

• params.resetRequestId: The sys_id of the current Password Reset  request (table: 
[pwd_reset_request]).

• params.wfSuccess: A flag indicating whether the workflow completed successfully: True if, 
and only if, successful.

Name Description

PwdPostProcessor Executes actions after the process completes for success, failure, or both 
conditions.

Related topics

Using extension points to extend application functionality

Using scripted extension points in server-side scripts

Using UI extension points in server-side UI macros

Using client extension points in client-side UI scripting

Example custom scripts for Password Reset

The example scripts perform a user account lookup and processes an identification form, define 
a credential store, and create an identification type.

Perform a user account lookup and process an identification form
The main script calls two extension scripts, one to perform the user account lookup, and the 
other to process the identification form.

// User account lookup
var lookupExtensionSysId = 
 getExtensionScriptSysId('SampleUserAccountLookupExtension', 
 'user_account_lookup');
var lookupExtension = new 
 SNC.PwdExtensionPoint(lookupExtensionSysId);
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// Setup parameters required for this extension type - userId
var params = new SNC.PwdExtensionPointParameter() ;
params.userId= 'joe.employee';
 
// Invoke the extension
var answer = lookupExtension.process(params);
gs.print('user: ' + answer);
 
//Form processor sample - Identification form processor
var identExtensionSysId = 
 getExtensionScriptSysId('SampleIdentificationProcessorExtensio
n', 'identification_form_processor');
var identificationExtension = new 
 SNC.PwdExtensionPoint(identExtensionSysId);
 
// Setup parameters required for this extension type - processId
var params = new SNC.PwdExtensionPointParameter() ;
params.processId = 'pwdreq1234';
 
// Simulate the posted form parameter for the indentification 
 processor
var request = new SNC.PwdExtensionPointParameter() ; // A real 
 life case will inject it's own request object
request.setParameter('sysparm_user_id', 'joe.employee');
 
var userIdentity = identificationExtension.processForm(params, 
 request);
gs.print('identity: ' + userIdentity);
 
// Simple helper to return the sys-id for a given extension 
 script
function getExtensionScriptSysId(scriptName, category) {
   var result;
   var now_GR = new GlideRecord('sys_script_include');
   gr.addQuery('name', scriptName);
   gr.addQuery('script', 'CONTAINS', 'category: 
 \'password_reset.extension.' + category + '\'');
   gr.query();
 
   if (gr.next() ) {
     result = gr.getValue('sys_id');
   }
   return result;
}

Define a credential store

The following is an example of an extended process function in the User Account Lookup 
category used to define a credential store. To create this extension script, go to Password 
Reset  > Extensions  > New extension script  and create a new script as described in Create an 
Extension Script. To configure the User Lookup in a Password Reset  process, see Credential 
Stores.

 
<?xml version="1.0" encoding="UTF-8"?>
<record_update table="sys_script_include">
  <sys_script_include action="INSERT_OR_UPDATE">
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    <active>true</active>
    <client_callable>false</client_callable>
    <description>Simple account lookup that returns the supplied 
 user id</description>
    <name>SampleUserAccountLookupExtension</name>
    <script><![CDATA[var SampleUserAccountLookupExtension = 
 Class.create();
SampleUserAccountLookupExtension.prototype = {
  category: 'password_reset.extension.user_account_lookup', // 
 DO NOT REMOVE THIS LINE!
 
  /**********
   * Returns the credential-store account id for a given user
   *
   * @param params.userId  The sys-id of the user being checked 
 (table: sys_user)
   * @return               The credential-store account-id 
 (string) for a given user
   **********/
  process: function(params) {
    return params.userId;
  },
 
  type: 'SampleUserAccountLookupExtension'
 
};]]></script>
    <sys_created_by>admin</sys_created_by>
    <sys_created_on>2013-07-30 16:44:55</sys_created_on>
    <sys_id>2df5a103d73201002bb9af728e610333</sys_id>
    <sys_mod_count>1</sys_mod_count>
    <sys_updated_by>admin</sys_updated_by>
    <sys_updated_on>2013-07-30 16:46:00</sys_updated_on>
  </sys_script_include>
  <sys_app_file action="INSERT_OR_UPDATE">
    <customer_update>false</customer_update>
    <publish_override/>
    <replace_on_upgrade>false</replace_on_upgrade>
    <restore/>
    <sys_app/>
    <sys_code>!!1W4/</sys_code>
    <sys_created_by>admin</sys_created_by>
    <sys_created_on>2013-07-30 16:44:55</sys_created_on>
    <sys_id>8306e143d73201002bb9af728e6103d3</sys_id>
    <sys_mod_count>0</sys_mod_count>
    <sys_name>SampleUserAccountLookupExtension</sys_name>
    <sys_parent/>
    <sys_path>!!1W4/</sys_path>
    <sys_policy/>
    <sys_source_deleted>false</sys_source_deleted>
   
 <sys_source_id>2df5a103d73201002bb9af728e610333</sys_source_id>
    <sys_source_table>sys_script_include</sys_source_table>
    <sys_type>code</sys_type>
   
 <sys_update_name>sys_script_include_2df5a103d73201002bb9af728e6
10333</sys_update_name>
    <sys_updated_by>admin</sys_updated_by>
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    <sys_updated_on>2013-07-30 16:46:00</sys_updated_on>
  </sys_app_file>
</record_update>
      

Create an identification type

The following is an example of an extended processForm function in the Identification Form 
Processor category that can be used to create an identification type. To create this extension 
script, go to Password Reset  > Extensions  > New extension script  and create a new script as 
described in Create an Extension Script.

<?xml version="1.0" encoding="UTF-8"?>
<record_update table="sys_script_include">
  <sys_script_include action="INSERT_OR_UPDATE">
    <active>true</active>
    <client_callable>false</client_callable>
    <description>Script that processes an identification 
 form.& 13;
Returns the sys-id of the user that corresponds to the requested 
 input; if no user was found, null should be returned.& 13;
</description>
    <name>SampleIdentificationProcessorExtension</name>
    <script><![CDATA[var SampleIdentificationProcessorExtension 
 = Class.create();
SampleIdentificationProcessorExtension.prototype = {
  category: 
 'password_reset.extension.identification_form_processor', // DO 
 NOT REMOVE THIS LINE!
 
  /**********
   * Process the identification form request, and returns the 
 user's sys_id.  if user was not identified return null.
   *
   * @param params.processId   The sys-id of the calling 
 password-reset process (table: pwd_process)
   * @param request            The form request 
 object. fields in the form can be accessed using: 
 request.getParameter('<element-id>')
   *                           Supported request paramters:
   *                               sysparm_user_id - the user 
 identifier value entered in the form.
   * @return The sys-id of the user that corresponds to the 
 requested input; if no user was found, null should be returned.
   **********/
  processForm: function(params, request) {
    return request.getParameter('sysparm_user_id') + '_' + 
 params.processId;
  },
 
  type: 'SampleIdentificationProcessorExtension'
 
};]]></script>
    <sys_created_by>admin</sys_created_by>
    <sys_created_on>2013-07-30 17:00:28</sys_created_on>
    <sys_id>3a79a503d73201002bb9af728e610349</sys_id>
    <sys_mod_count>1</sys_mod_count>
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    <sys_updated_by>admin</sys_updated_by>
    <sys_updated_on>2013-07-30 17:08:41</sys_updated_on>
  </sys_script_include>
  <sys_app_file action="INSERT_OR_UPDATE">
    <customer_update>false</customer_update>
    <publish_override/>
    <replace_on_upgrade>false</replace_on_upgrade>
    <restore/>
    <sys_app/>
    <sys_code>!!1W5/</sys_code>
    <sys_created_by>admin</sys_created_by>
    <sys_created_on>2013-07-30 17:00:28</sys_created_on>
    <sys_id>4799ed03d73201002bb9af728e610333</sys_id>
    <sys_mod_count>0</sys_mod_count>
    <sys_name>SampleIdentificationProcessorExtension</sys_name>
    <sys_parent/>
    <sys_path>!!1W5/</sys_path>
    <sys_policy/>
    <sys_source_deleted>false</sys_source_deleted>
   
 <sys_source_id>3a79a503d73201002bb9af728e610349</sys_source_id>
    <sys_source_table>sys_script_include</sys_source_table>
    <sys_type>code</sys_type>
   
 <sys_update_name>sys_script_include_3a79a503d73201002bb9af728e6
10349</sys_update_name>
    <sys_updated_by>admin</sys_updated_by>
    <sys_updated_on>2013-07-30 17:08:41</sys_updated_on>
  </sys_app_file>
</record_update>

Use the process and processForm extensions

This example shows a script that uses two sample extensions, one process  extension and one 
processForm  extension.

// User account lookup
var lookupExtensionSysId = 
 getExtensionScriptSysId('SampleUserAccountLookupExtension','use
r_account_lookup');
var lookupExtension =new 
 SNC.PwdExtensionPoint(lookupExtensionSysId);
 
// Setup parameters required for this extension type - userId
var params =new SNC.PwdExtensionPointParameter();
params.userId='joe.employee';
 
// Invoke the extension
var answer = lookupExtension.process(params);
gs.print('user: '+ answer);
 
 
//Form processor sample - Identification form processor
var identExtensionSysId = 
 getExtensionScriptSysId('SampleIdentificationProcessorExtension
','identification_form_processor');
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var identificationExtension =new 
 SNC.PwdExtensionPoint(identExtensionSysId);
 
// Setup parameters required for this extension type - processId
var params =new SNC.PwdExtensionPointParameter();
params.processId='pwdreq1234';
 
// Simulate the posted form parameter for the indentification 
 processor
var request =new SNC.PwdExtensionPointParameter();// A real life 
 case will inject it's own request object
request.setParameter('sysparm_user_id','joe.employee');
 
var userIdentity = identificationExtension.processForm(params, 
 request);
gs.print('identity: '+ userIdentity);
 
// Simple helper to return the sys-id for a given extension 
 scriptfunction
getExtensionScriptSysId(scriptName, category){
var result;
var now_GR =new GlideRecord('sys_script_include');
   gr.addQuery('name', scriptName);
   gr.addQuery('script','CONTAINS','category: 
 \'password_reset.extension.'+ category +'\'');
   gr.query();
 
   if(gr.next()){
     result = gr.getValue('sys_id');}return result;}

process  function:

<?xml version="1.0" encoding="UTF-8"?><record_update 
 table="sys_script_include"><sys_script_include 
 action="INSERT_OR_UPDATE"><active>true</active><client_callable
>false</client_callable><description>Simple 
 account lookup that returns the supplied user 
 id</description><name>SampleUserAccountLookupExtension</name><s
cript><![CDATA[var SampleUserAccountLookupExtension 
 =Class.create();
SampleUserAccountLookupExtension.prototype={
  category:'password_reset.extension.user_account_lookup',// DO 
 NOT REMOVE THIS LINE!
 
  /**********
   * Returns the credential-store account id for a given user
   *
   * @param params.userId  The sys-id of the user being checked 
 (table: sys_user)
   * @return               The credential-store account-id 
 (string) for a given user
   **********/
  process:function(params){return params.userId;},
 
  type:'SampleUserAccountLookupExtension'
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};]]></script><sys_created_by>admin</sys_created_by><sys_created
_on>2013-07-3016:44:55</sys_created_on><sys_id>2df5a103d73201002
bb9af728e610333</sys_id><sys_mod_count>1</sys_mod_count><sys_upd
ated_by>admin</sys_updated_by><sys_updated_on>2013-07-3016:46:0
0</sys_updated_on></sys_script_include><sys_app_file 
 action="INSERT_OR_UPDATE"><customer_update>false</customer_upda
te><publish_override/><replace_on_upgrade>false</replace_on_upgr
ade><restore/><sys_app/><sys_code>!!1W4/</sys_code><sys_created_
by>admin</sys_created_by><sys_created_on>2013-07-3016:44:55</sys
_created_on><sys_id>8306e143d73201002bb9af728e6103d3</sys_id><sy
s_mod_count>0</sys_mod_count><sys_name>SampleUserAccountLookupEx
tension</sys_name><sys_parent/><sys_path>!!1W4/</sys_path><sys_p
olicy/><sys_source_deleted>false</sys_source_deleted><sys_source
_id>2df5a103d73201002bb9af728e610333</sys_source_id><sys_source_
table>sys_script_include</sys_source_table><sys_type>code</sys_t
ype><sys_update_name>sys_script_include_2df5a103d73201002bb9af72
8e610333</sys_update_name><sys_updated_by>admin</sys_updated_by>
<sys_updated_on>2013-07-3016:46:00</sys_updated_on></sys_app_fil
e></record_update>

processForm  function:

<?xml version="1.0" encoding="UTF-8"?><record_update 
 table="sys_script_include"><sys_script_include 
 action="INSERT_OR_UPDATE"><active>true</active><client_callable
>false</client_callable><description>Script that processes an 
 identification form.& 13;
Returns the sys-id of the user that corresponds to the 
 requested input;if no user was found,null should be 
 returned.& 13;</description><name>SampleIdentificationProcessor
Extension</name><script><![CDATA[var 
 SampleIdentificationProcessorExtension =Class.create();
SampleIdentificationProcessorExtension.prototype={
 
 category:'password_reset.extension.identification_form_processo
r',// DO NOT REMOVE THIS LINE!
 
  /**********
   * Process the identification form request, and returns the 
 user's sys_id.  if user was not identified return null.
   *
   * @param params.processId   The sys-id of the calling 
 password-reset process (table: pwd_process)
   * @param request            The form request 
 object. fields in the form can be accessed using: 
 request.getParameter('<element-id>')
   *                           Supported request paramters:
   *                               sysparm_user_id - the user 
 identifier value entered in the form.
   * @return The sys-id of the user that corresponds to the 
 requested input; if no user was found, null should be returned.
   **********/
  processForm:function(params, request){return 
 request.getParameter('sysparm_user_id')+'_'+ 
 params.processId;},
 
  type:'SampleIdentificationProcessorExtension'
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};]]></script><sys_created_by>admin</sys_created_by><sys_created
_on>2013-07-3017:00:28</sys_created_on><sys_id>3a79a503d73201002
bb9af728e610349</sys_id><sys_mod_count>1</sys_mod_count><sys_upd
ated_by>admin</sys_updated_by><sys_updated_on>2013-07-3017:08:4
1</sys_updated_on></sys_script_include><sys_app_file 
 action="INSERT_OR_UPDATE"><customer_update>false</customer_upda
te><publish_override/><replace_on_upgrade>false</replace_on_upgr
ade><restore/><sys_app/><sys_code>!!1W5/</sys_code><sys_created_
by>admin</sys_created_by><sys_created_on>2013-07-3017:00:28</sys
_created_on><sys_id>4799ed03d73201002bb9af728e610333</sys_id><sy
s_mod_count>0</sys_mod_count><sys_name>SampleIdentificationProce
ssorExtension</sys_name><sys_parent/><sys_path>!!1W5/</sys_path>
<sys_policy/><sys_source_deleted>false</sys_source_deleted><sys_
source_id>3a79a503d73201002bb9af728e610349</sys_source_id><sys_s
ource_table>sys_script_include</sys_source_table><sys_type>cod
e</sys_type><sys_update_name>sys_script_include_3a79a503d7320100
2bb9af728e610349</sys_update_name><sys_updated_by>admin</sys_upd
ated_by><sys_updated_on>2013-07-3017:08:41</sys_updated_on></sys
_app_file></record_update>

Password Reset  extension script categories

You can use a custom extension script to extend Password Reset  functionality for credential 
store, verification, or identification types.

Note: 
To use a script include as an extension script, you must set it to Active  status.

Password Reset  extension script categories

Extension scripts must specify a category that indicates which script include is being extended, 
for example, category: 'password_reset.extension.enrollment_check'. 
The ServiceNow  platform installs several scripts in each category. A script in the Enrollment 
check  category can perform the enrollment check for a verification. Detailed information on each 
extension script appears in Password Reset extension scripts.

Extension 
script 
category

Description

Enrollment 
check

Defines how to check that a user is enrolled in the Password Reset  process. 
Scripts of this category are available in the Enrollment check  field when you 
define a verification type (Password Reset  Verification Type form).

Enrollment 
form 
processor

Defines how an enrollment form is processed (if automatic enrollment is not 
configured). Scripts of this category are available in the Enrollment form 
processor  field when you define a verification type (Password Reset  Verification 
Type form).

Identification 
form 
processor

Defines how a user identification is processed. Scripts of this category are 
available in the Identification processor  field when you define a verification 
type (Password Reset  Identification Type form).

Password 
generator

Defines how to generate a password. Scripts of this category are available in the 
Auto generate password  field when you configure a credential store (Password 
Reset  Credential Store Type form).
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Extension 
script 
category

Description

Post reset 
script

Executes at the end of a Password Reset  process. Scripts of this category are 
available in the Post reset script  field when you configure a process (Password 
Reset  Process form).

User 
account 
lookup

Defines how to look up a user account. Scripts of this category are available in 
the User account lookup  field when you configure a credential store (Password 
Reset  Credential Store form).

Verification 
form 
processor

Defines how a verification form is processed. Scripts of this category are 
available in the Verification processor  field when you define a verification type 
(Password Reset  Verification Type form).

Related topics

Password Reset extension scripts

Password Reset  extension scripts

Extension scripts allow you to extend Password Reset  functionality in credential store, 
verification, or identification types.

Password Reset  extension script includes

Each script include is associated with a specific category, which is available in the appropriate 
field of a Password Reset  form.

Note: 
Create extension scripts only from the Password Reset  Extension Script form (Password 
Reset  > Extensions  > New extension script). Extension scripts are special purpose script 
includes that are not created in the System Definition  > Script Includes  interface. To use a 
script include as an extension script, you must set it to Active  status.

'Enrollment Check' script include category

Script 
include 
category

Description Method signature Input fields Output fields

Enrollment 
Check

Checks 
whether 
a user is 
enrolled 
for a given 
verification.

process(params) Parameters:

• params.userId  - The 
sys_id of the user to check 
(table: sys_user).

• params.verificationId 
- The sys_id of the 
verification to check (table: 
pwd_verification).

Returns: 
(boolean) true, 
if the user is 
enrolled in 
the specified 
verification; 
otherwise, false.

This Enrollment Check example signals that the user is enrolled if both expected parameters 
are supplied. The code would be contained in the Script  field of an extension script named 
SampleEnrollmentCheck:

var SampleEnrollmentCheck = Class.create ();
SampleEnrollmentCheck. prototype = {
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  category:'password_reset.extension.enrollment_check', // DO 
 NOT REMOVE THIS LINE!
 
   /**********
   * Returns boolean telling whether the user is enrolled.
   * This sample returns true if both parameters are supplied, 
 false otherwise
   *
   * @param params.userId         The sys-id of the user being 
 checked (table: sys_user)
   * @param params.verificationId The sys-id of the verification 
 being checked (table: pwd_verification)
   * @return Boolean indicating whether the user is enrolled 
 into the specified verification
   **********/
  process:function (params) {return (params.userId && 
 params.verificationId)? true:false; },
 
  type:'SampleEnrollmentCheck'};

'Enrollment Form Processor' script include category

Script 
include 
category

Description Method signature Input fields
Output 
fields

Enrollment 
Form 
Processor

Checks 
whether all 
necessary 
information 
has been 
collected 
from the 
user. 
Stores the 
information 
so it can 
be used for 
verification 
when 
the user 
resets their 
password.

process(params) Parameters:

• params.resetRequestId  - The sys_id 
of the current Password Reset  request (table: 
pwd_reset_request).

• params.userId  - The sys_id of the user to be 
verified (table: sys_user).

• params.verificationId  - The sys_id of the 
verification to be processed (table: pwd_verification).

• request  - The form request object. Fields in the form 
can be accessed with request.getParameter('<element-
id>').

The following information should be added to the state of 
the enrollment process:

• gs.getSession().putProperty("result.status",status) - 
Whether the user was successfully enrolled.

• gs.getSession().putProperty("result.message",message) 
- An associated message to be returned to the UI, such 
as a detailed error message.

• gs.getSession().putProperty("result.value",value) - A 
custom value associated with the enrollment.

Returns: 
(boolean) 
true, if the 
user is 
enrolled 
in the 
specified 
verification; 
otherwise, 
false.

This example processes an enrollment form submission successfully if the user-submitted 
response was success. The code would be contained in the Script  field of an extension script 
named SampleEnrollmentProcessor:
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var SampleEnrollmentProcessor = Class.create ();
SampleEnrollmentProcessor.prototype = {
    category: 
 'password_reset.extension.enrollment_form_processor', // DO NOT 
 REMOVE THIS LINE!
 
     /**********
    * Process the enrollment form request, and return whether 
 the user was successfully enrolled.
    *
    * @param params.userId         The sys_id of the user trying 
 to enroll (table: sys_user)
    * @param params.verificationId The sys_id of the 
 verification to be enrolled into (table: pwd_verification)
    * @param params.enrollmentId   The sys_id of this enrollment 
 process
    * @param request               The form request object. 
 Felds in the form can be accessed with
    *                                          
 request.getParameter('<element-id>')
    * @return boolean telling whether the user was successfully 
 enrolled
    * The following information should be added to the state of 
 the enrollment process
    *     gs.getSession().putProperty("result.status",status) - 
 whether the user was successfully enrolled
    *     gs.getSession().putProperty("result.message",message) 
 - an associated message to be returned
    *             to the UI. Eg. a detailed error message
    *     gs.getSession().putProperty("result.value",value) - 
 custom value associated with the enrollment
    **********/
    processForm:function (params, request) {var verificationId = 
 params.verificationId; var sampleInput = request.getParameter 
 ('sample_input');
 
  if (gs.nil (verificationId) || (sampleInput!= 'success')) 
 { return false; }
 
  var now_GR = new GlideRecord ('sys_user');
 now_GR.get (params. userId);
 now_GR.print ('User:' + now_GR.getValue ('user_name') + ' 
 successfully enrolled'); return true; },
    type: 'SampleEnrollmentProcessor' };

'Identification Form Processor' script include category

Script include 
category

Description Method signature Input fields Output fields

Identification 
Form 
Processor

Processes 
an 
identification 
form 
request.

processForm(params, 
request)

Parameters:

• params.processId  - The sys_id of the calling 
Password Reset  process (table: pwd_process).

• request  - The form request object. 
Fields in the form can be accessed with 

Returns: the 
sys_id of the 
user that 
corresponds 
to the 
requested 

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4424



Script include 
category

Description Method signature Input fields Output fields

request.getParameter('<element-id>'). 
Use 
request.getParameter('sysparm_user_id') 
to get the user ID that was entered into the form.

input. 
Returns null, 
if no user 
was found.

This example attempts to identify the user within the sys_user table given a user name submitted 
from the identification form. The code would be contained in the Script  field of an extension 
script named PwdIdentifyViaUsername:

var PwdIdentifyViaUsername = Class.create ();
PwdIdentifyViaUsername. prototype = {
    category: 
 'password_reset.extension.identification_form_processor', // DO 
 NOT REMOVE THIS LINE!
 
    initialize: function () { },
 
   /**********
   * Process the identification form request, and returns the 
 user's sys_id. If user was not identified return null.
   *
   * @param params.processId   The sys_id of the calling Password 
 Reset  process (table: pwd_process)
   * @param request            The form request object. fields 
 in the form can be accessed with
   *  request.getParameter('<element-id>')
   *  Supported request parameters: sysparm_user_id - the user 
 identifier value entered in the form
   * @return The sys_id of the user that corresponds to the 
 requested input;
   *  if no user was found, null should be returned
   **********/
   processForm: function (params, request) {var processId = 
 params. processId; var sysparm_user_id = request.getParameter 
 ('sysparm_user_id');
      now_GR = new GlideRecord ('sys_user') ;
      now_GR.addQuery ('user_name', sysparm_user_id) ;
      now_GR.query (); if (!now_GR.next ()) {return null; } 
 return now_GR.sys_id;},
 
    type:'PwdIdentifyViaUsername' }

'Password Generator' script include category

Script 
include 
category

Description Method signature Input fields Output fields

Password 
Generator

Returns 
an auto-
generated 
password.

process(params) Parameters:params.processId 
- The sys_id of the calling 
Password Reset  process (table: 
pwd_process).

Returns: 
(String) 
an auto-

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4425



Script 
include 
category

Description Method signature Input fields Output fields

generated 
password.

This example randomly generates a password from a base word and numbers. The base word is 
selected depending on the credential store. The code would be contained in the Script  field of 
an extension script named SamplePasswordGenerator:

var SamplePasswordGenerator = Class.create ();
SamplePasswordGenerator. prototype = {
  category: 'password_reset.extension.password_generator', // DO 
 NOT REMOVE THIS LINE!
 
   /**********
   * Returns an auto-generated string password.
   * This sample randomly generates 4 digits to add to the 
 password.
   *
   * @param params.credentialStoreId The sys_id of the 
 target Password Reset  credential store to generate
   *  a password for (table: pwd_cred_store)
   * @return An auto-generated string password
   **********/
  process:function (params) { var basePassword ;
 
  var now_GR = new GlideRecord ('pwd_cred_store');
 now_GR.addQuery ('name', 'Local ServiceNow Instance');
 now_GR.query (); if (now_GR.next ()) { if 
 (params.credentialStoreId = now_GR.getValue ('sys_id'))
   basePassword = "Password"; else
   basePassword = "Dorwssap"; } return this. generateSimple 
 (basePassword); },
 
  generateSimple:function (base) {var pwd = base; var numbers = 
 '0123456789'; var length = 4;
 
     for (var i  = 0 , n  = numbers. length ; i  < length ; i 
 ++) {
        pwd += numbers.charAt (Math.floor (Math.random () * n) + 
 1); } return pwd;},
 
  type:'SamplePasswordGenerator'} ;

'Post Reset' script include category

Script 
include 
category

Description Method signature Input fields
Output 
fields

Post 
Reset

Performs additional 
operations after the 
completion of the 

process(params) Parameters: Returns: 
void
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Script 
include 
category

Description Method signature Input fields
Output 
fields

Password Reset 
process.

• params.resetRequestId 
- The sys_id of the calling 
Password Reset  process 
(table: pwd_process).

• params.wfSuccess  - 
A flag indicating whether 
the workflow completed 
successfully. True if, and only if, 
successful.

This example adds failed reset requests to the system log. The code would be contained in the 
Script  field for an extension script named PwdPostProcessor':

var PwdPostProcessor = Class.create ();
 
PwdPostProcessor. prototype = {
    category: 'password_reset.extension.post_reset_script', // 
 DO NOT REMOVE THIS LINE!
 
    initialize:function () { },
 
     /**********
     * Execute custom actions after the Password Reset  process has 
 completed.
    *
    * @param params.resetRequestId The sys_id of the 
 current Password Reset  request (table: pwd_reset_request)
    * @param params.wfSuccess      A flag indicating if the 
 workflow completed sucessfully.
    *  True if (and only if) successful.
    * @return no return value
    **********/
    process: function (params) {if (!params. wfSuccess) {
           now_GS.log ('[PwdPostProcessor.process] failure post 
 processing for request [' + params. resetRequestId + ']'); }
 
         // We could place actions here that we always want 
 executed return; },
 
    type:'PwdPostProcessor' }

'User Account Lookup' script include category

Script 
include 
category

Description Method signature Input fields Output fields

User 
Account 
Lookup

Gets the 
credential store 
account ID for a 
given user.

process(params) Parameters:params.userId 
- The sys_id of the user 
being checked (table: 
sys_user).

Returns: (String) 
the credential store 
account ID for the 
given user.
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This example gets the credential store account for a user. This code would be contained in the 
Script  field of an extension script named SampleUserAccountLookupExtension:

var SampleUserAccountLookupExtension = Class.create ();
SampleUserAccountLookupExtension. prototype = {
  category:'password_reset.extension.user_account_lookup', // DO 
 NOT REMOVE THIS LINE!
 
   /**********
  * Returns the credential store account id for a given user.
  * This sample echoes the user_id supplied as the credential 
 store account id for that user.
  *
  * @param params.userId  The sys_id of the user being checked 
 (table: sys_user)
  * @return               The credential store account id 
 (string) for a given user
  **********/
  process:function (params) {return params.userId;},
 
  type:'SampleUserAccountLookupExtension' }

'Verification Form Processor' script include category

Script 
include 
category

Description Method signature Input fields
Output 
fields

Verification 
Form 
Processor

Processes 
a 
verification 
form 
request 
and 
indicates 
whether 
the user 
was 
verified or 
not.

processForm(params, 
request)

Parameters:

• params.resetRequestId 
- The sys_id of the current 
Password Reset  request (table: 
pwd_reset_request).

• params.userId  - The sys_id 
of the user to be verified (table: 
sys_user).

• params.verificationId 
- The sys_id of the verification 
to be processed (table: 
pwd_verification).

• request  - The form request 
object. Fields in the form 
can be accessed with 
request.getParameter('<element-
id>').

Returns: 
(boolean) 
true, if the 
user is 
verified; 
otherwise, 
false.

This example shows a verification processor that returns true only if the user sent ok  in the 
input field; otherwise, it returns false. The code would be contained in the Script  field of an 
extension script named SampleVerificationFormProcessor:

var SampleVerificationFormProcessor = Class.create ();
SampleVerificationFormProcessor.prototype = {
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 category:'password_reset.extension.verification_form_processor'
, // DO NOT REMOVE THIS LINE!
 
   /**********
   * Process the verification form request, and return whether 
 the user was successfully verified.
   * This is a sample verification processor returns true only 
 if the user sent "ok" in the input field;
   * otherwise, it returns false.
   *
   * @param params.resetRequestId The sys_id of the 
 current Password Reset  request (table: pwd_reset_request)
   * @param params.userId         The sys_id of the user trying 
 to be verified (table: sys_user)
   * @param params.verificationId The sys_id of the verification 
 to be processed (table: pwd_verification)
   * @param request               The form request object. 
 Fields in the form can be accessed with
   * request.getParameter('<element-id>')
   * @return Boolean indicating whether the user is successfully 
 verified
   **********/
  processForm:function (params, request) {if 
 (request.getParameter ("sysparm_simple_input") == "ok") return 
 true; else return false; },
 
  type:'SampleVerificationFormProcessor'};

Related topics

Extension points

Create a Password Reset  extension script

Create extension scripts only from the Password Reset  Extension Script form. Do not create 
extension scripts in the System Definition  > Script Includes  interface.

Before you begin
Role required: password_reset_admin or admin

Note: 
To use a script include as an extension script, you must set it to Active  status.

Procedure

1. Navigate to Password Reset  > Extensions  > New extension script.

2. Enter a name in the Extension script name  field.
Use CamelCase to construct a name without spaces, for example, PwdEnrollmentCustom.

3. Select an Extension script category.

◦ Enrollment check

◦ Enrollment form processor

◦ Identification form processor

◦ Password generator
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◦ User account lookup

◦ Verification form processor

4. Click Submit.
A new instance of the script include for the selected category opens.

5. Edit the script by providing an implementation in the body of the process or processForm 
function, depending on the script category.
You can add additional functions as long as the process or processForm  function accepts 
the defined parameters and returns the expected results.

Note: 
Do not edit or delete the Category  declaration.

6. Click Update.

Password Reset  and Password Change reports and logs

The Password Reset  application provides several tools for monitoring and troubleshooting 
password reset activities.

Users with the password_reset_credential_manager or password_reset_admin role can view the 
status of password reset activities, identify potential security threats, and monitor for compliance 
with password security policies.

The Reset Requests, Activity Log, and Blocked Users  modules are useful for monitoring 
password reset activities and for troubleshooting password reset issues. They also provide 
access to more detailed information than is provided on the Overview module.

To make room for new data, the system periodically purges the data that is used for password 
reset monitoring and reporting.

Password Reset  Overview module

The Password Reset  > Overview  module displays reports on password reset and password 
change activities. Users with the password_reset_admin role can customize the layout of the 
reports that appear in the Overview module.
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Password Reset reports

Title Description

Password 
Requests 
(last 7 days)

Number of password reset requests by type during the last 7 days.

Blocked 
Users (last 7 
days)

Number of users blocked over the last 7 days.

Password 
Reset 
Request 
Status (last 
7 days)

Status of all password reset requests by process.

Password 
Reset 
Request by 
Action (last 
30 days)

Number of password reset requests by action type: Reset Password, Unlock 
Account, or Reset and Unlock.

Password 
Reset  Top 
Users (last 
30 days)

Number of password reset requests per user. Many password reset requests 
from a single user could indicate a security issue.

Password 
Reset 
Failed 
Verifications 
(last 7 days)

Number of failed verification attempts, by verification instance. A failed 
verification occurs when a user attempts to reset the password, but fails for one 
reason or another, during the identity verification step. Many failed verification 
attempts for a specific type of verification could indicate that the process is too 
complicated or unclear.

Password 
Reset 
Enrollment 
By 
Verification

Number of users by verification type who enrolled and did not enroll in the 
password reset program. A large number for users who did not enrolled could 
indicate a compliance or communication issue within the organization.

Password 
Change Top 
Users (last 
30 days)

Number of password change requests per user. Many password change requests 
from a single user could indicate a security issue.

Password Reset  activity log

The activity log (Password Reset  > Activity Log) provides detailed information that you can use 
to troubleshoot and to generate reports on password reset metrics. Information contained in the 
activity log is stored in the Password Reset  activity log [pwd_reset_activity] table.

You must have the password_reset_credential_manager or password_reset_admin role to view 
the log.

Password Reset  event log

The event log is a valuable resource for troubleshooting. On the Start  menu, click Programs (or 
All Programs)  > Administrative Tools  > Event Viewer.
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If the log does not appear, then, on the Windows Logs  menu, click Applications  > Service Logs.

You must have the admin role to view the log.

To write to the Password Reset  event log

Edit the DebugFlag  registry key entry at: Computer > HKEY_LOCAL_MACHINE > 
SOFTWARE > Microsoft > Windows > CurrentVersion > Authentication 
> Credential Providers > {B6EFF27D-C1C4-481F-B81B-F3547C47D58A}

By default, the key is set to 0. Set the key to 1 to write log entries to the ServiceNowPwdReset 
event log.

You must have the password_reset_credential_manager or password_reset_admin role to write 
to the log.

Password Reset  blocked user notification

You can receive email notifications when the number of users that are blocked or locked exceeds 
the password blocked threshold. Notifications can alert you to suspicious activities. The default 
threshold is 10.

To subscribe: Add an email notification device or modify an existing device and then subscribe 
to the Password Reset-Activity Monitor Lockout  notification.

You must have the password_reset_credential_manager or password_reset_admin role to 
subscribe.

Schedule for purging Password Reset  data

To make room for new data, the system periodically purges the data that is used for password 
reset monitoring and reporting. Information contained in reports and monitoring tools could 
change dramatically immediately after a data purge.

Users with the password_reset_credential_manager or password_reset_admin role can follow 
this procedure to modify the purge interval:

1. On a non-production instance: Navigate to Automated Test Framework  > Administration  > 
Table Cleanup.

2. Modify the designated tables.

3. Test all changes on the non-production instance.

4. Modify the tables on your production instance and test.

Alternatively, contact ServiceNow  Technical Support to modify the purge interval.

Purge intervals for Password Reset  tables

Table name Purge interval

[pwd_reset_request] 90 days (7,776,000 seconds).

Depending on your organizational data monitoring requirements, 
you could configure the rule to:

• Purge successful requests after 90 days

• Keep failed requests for 120 days

[pwd_user_lockout] 90 days (7,776,000 seconds).
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Purge intervals for Password Reset  tables  (continued)

Table name Purge interval

Depending on your organizational data monitoring requirements, 
you could configure the rule to:

• Purge successful requests after 90 days

• Keep failed requests for 120 days

[pwd_reset_activity] 90 days (7,776,000 seconds).

[pwd_activity_monitor] 90 days (7,776,000 seconds).

[pwd_dvc_enrollment_code] 1 day (86,400 seconds).

[pwd_sms_code] 1 day (86,400 seconds).

Related topics

View user requests for password reset

Unblock a Password Reset user

Actions in Password Reset  for Virtual Agent

The actions in the Virtual Agent  use plugins.

• Password Reset  (com.glideapp.password_reset): This plugin is active by default.

• Password Reset  for Virtual Agent  (com.snc.password_reset.virtual_agent): You must install this 
plugin to use Password Reset  for Virtual Agent.

For more information about creating your password reset process, see Password Reset.

End users can initiate a password reset conversation with Virtual Agent  by entering specific 
keywords. For example, when a user enters the keyword Reset, the Virtual Agent  shows the 
Reset Password  action. The users can select the action to initiate the password reset.
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Keyword in the Virtual Agent
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Virtual Agent  displaying topics

Enrollment in Password Reset  for Virtual Agent

You can let end users enroll for Password Reset  verifications using the Virtual Agent. The Virtual 
Agent  includes an enrollment topic and its topic blocks for each verification, such as SMS, email, 
security question, Soft PIN, or a third-party authenticator app. Users can select any of the topic 
blocks to enroll for verification.

You can modify the enrollment topic, but you must duplicate the default enrollment topic and 
then modify the duplicated topic.

Here's the enrollment flow in Virtual Agent:

1. Users select the enrollment topic in Virtual Agent.

2. Users select any one of these verification types:

Security questions

◦ If users aren't enrolled, Virtual Agent  displays the questions, and users need to 
select questions and give answers to them.

◦ If users are already enrolled, Virtual Agent  shows options to the users to:

▪ Change answers to the existing questions

▪ Re-enroll

Soft PIN
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◦ If the user isn't enrolled, Virtual Agent  displays rules that are followed by a Soft 
PIN question. Users enter a valid Soft PIN and complete the enrollment.

◦ If users are already enrolled, they get a message asking whether to update 
existing Soft PIN enrollment.

If users select Yes, Virtual Agent  displays rules that are followed by a Soft PIN 
question.

Users must enter a valid Soft PIN to complete the enrollment.

Note: 
When users change the existing Soft PIN, they must use a new Soft PIN 
that must differ from the previously existing Soft PIN.

Third-party authenticator app

◦ If users aren't enrolled, they get a QR code and an alphanumeric code. Users 
can scan the QR code or enter the alphanumeric code in the authenticator app.

◦ If users are already enrolled, they get two options:

▪ Generate a new QR code and an alphanumeric code

▪ Disable multi-factor authentication

If users select an option to generate a new QR, the new enrollment flow starts. 
If users select the other option, the multi-factor authentication gets disabled. 
If the multi-factor authentication is disabled, to re-enroll, users must enable it 
again.

Password Reset supports the following third-party authenticator apps:

◦ Google  Authenticator

◦ Microsoft  Authenticator

◦ Cisco  Duo

Email and SMS

◦ If users aren’t enrolled, they can add new mobile devices for SMS verification or 
can add an email address for email verification.

◦ If users are already enrolled, they can view the list of enrolled mobile devices 
for SMS verification, or they can view an email address. For SMS, the users can 
verify, remove, or authorize mobile devices. For email, the users can verify or 
authorize the email address.

3. Users complete the enrollment.

Verification options for Password Reset  for Virtual Agent  conversations

The following verification options are supported in Virtual Agent  conversations. Custom 
verifications are not supported in Virtual Agent.

• Personal data: The user provides specific pieces of personal data.

• Authenticator app: The user enters the generated code from the an authenticator app on a 
mobile device.

• SMS:The user enters the code received on a mobile phone.
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• Email:The user enters the code received in an email.

• Security question verification: The user enters the answers for the security question.

Soft PIN expiration framework for Password Reset

Virtual Agent supports expiration framework to account for Soft PIN verification during Password 
reset. As an end-user, you can use the existing Virtual Agent topic to enroll for Soft PIN 
enrollment to:

• Re-enroll when your Soft PIN has expires.

• Inform you of the number of days from the time you setup a new Soft PIN after which your token 
expires.

• Reset Soft PIN to account for history policies.

• Configure the topic to ask for password before proceeding to reset your Soft PIN.

Reset password conversation flow for Virtual Agent

1. Virtual Agent  sends identity verification information to the end users based on the password 
reset process configuration.

2. Virtual Agent  provides the reset steps if users successfully verify themselves with the given 
inputs.

3. Virtual Agent  displays the password rules.

4. The user enters a new password, adhering to the password rules.

5. Virtual Agent  prompts the user to reenter the password if the password does not meet the 
criteria.

6. Once the password meets the criteria, the Virtual Agent  resets the password.

7. Users then log in using the new password.

Password reset flow using interactive voice response (IVR)

A user can reset a password using interactive voice response (IVR). For example, by using a 
phone call. A user gets the instructions for verification on a phone call. Once the verification is 
complete, the user receives an auto-generated password or an email containing a URL, which the 
user can use to reset the password based on the configuration of the process.

After resetting your password, the newly auto-generated password is spoken over IVR. If the 
Password Reset  process is configured with an email or SMS, the password is also sent to the 
registered email and SMS.

The following verification types are supported over IVR:

• Authenticator app

• SMS

• Email

You can use the sn_pwdreset_va.supported_channels  system property to enable the 
IVR or Microsoft Teams  or both.

Note: 
By default, the minimum character length is 8 characters. The maximum length in the 
password policy must be modified for a better experience over IVR.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4437



Change password conversation flow for Virtual Agent

1. The user initiates the Change Password action. The user selects the password reset process, 
or if only one process is available, the process is selected automatically.

2. Virtual Agent  prompts the password guidelines or rules.

3. The user enters the old password, enters the new password, confirms the new password, and 
submits the request.

4. Virtual Agent  shows the request status whether the password is changed or not.

5. If the password is changed, the users can use the new password to log in.

Unlock account conversation flow for Virtual Agent

When a user account is locked, the user can't log in to the account. But using the Virtual Agent, 
the user can unlock the account and log in.

1. Virtual Agent  sends identity verification information to the end user based on the password 
reset process configuration.

2. Virtual Agent  provides the verification information if the user successfully verifies their identity 
with the given inputs.

3. Once the user has been identified and verified, the Virtual Agent  unlocks the user's account.

Note: 
Users can also use the Microsoft Teams  channel to unlock accounts and reset passwords.

Notify
Notify  provides support for SMS and voice channels on the ServiceNow  platform for 
communicating internally with team members and externally with customers and contractors. 
The plug-in also provides APIs and workflow activities to achieve the above. Some customers 
directly make use of the APIs in their products, and others via products like Major Incident 
Management, On-Call and CTI Softphone.

Explore

• Notify Twilio Direct driver

• Notify Zoom connector

• Notify voice and SMS capabilities

• Notify Cisco Webex Connector

• Notify connector for Microsoft Teams

Configure

• Activate Notify

• Configure Notify with Twilio

• Configure Notify Zoom connector in Notify

• Configure a provider in Notify

• Configure SMS opt-out preferences

• Configure Notify Cisco Webex Connector

• Install Notify connector for Microsoft 
Teams

Use Reference
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(continued)

• Using Notify with SMS

• Using Notify for making conference calls

• Using Notify with tasks

• Using Notify with Incident Communications 
Management

• Using Notify with On-Call Scheduling

• Using the Notify Cisco Webex Connector 
with a major incident

• Use Notify connector for Microsoft Teams

• Differences between Notify-Twilio and Notify-
Twilio Direct

• Notify workflow activities

• Components installed with Notify

• Developer training

• Developer documentation

Exploring Notify

Use and integrate Notify  with the third-party service providers as a communication channel to 
meet with the stakeholders to resolve the incidents.

Notify Twilio Direct driver

The Notify-Twilio integration with the Notify-Twilio Direct driver provides APIs and workflow 
activities for applications to handle various notification features.

The Notify-Twilio Direct driver provides the following notification features:

• Start and manage a conference

• Send and receive SMS messages

• Send and receive calls

Notify  automatically creates a TwiML application in the Twilio account and configures the 
application to use the instance as an endpoint.

Phone numbers associated with the Twilio account are imported to Notify. To manage phone 
numbers per instance, set up one Twilio account for each instance and configure all relevant 
phone numbers for the instance under that account.

Note: 
Only one Twilio account (or subaccount) can be configured on a given Notify  driver at 
a time. Both the old and new driver can be used simultaneously because they can be 
configured with different accounts.

The Notify-Twilio direct driver supports the use of API Keys and API Secret to make outbound 
REST API calls to Twilio. For more details, see API Key Resource .

To enhance the security, another set of user credentials are added in the system for the 
credentials in the form of Twilio API keys. The record contains the generated API key and the API 
secret as the username and password respectively.

Note: 
Twilio Direct creates the Standard type API keys.

If the instance is connected to Twilio and you upgrade to Washington DC, the Twilio will not be 
disconnected from your instance and continues to use the Account SID and Auth key. However, 
if the administrator disconnects Twilio from the instance and re-connect the Twilio service, the 
additional record will be created to enhance the security.
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Activation Information

For new customers, only the Notify-Twilio Direct driver is available by default. For customers 
upgrading to the latest version, both the Notify-Twilio Direct and Notify-Twilio drivers are 
available.

The Notify  plugin must be active to access Notify.

Related topics

Configure Notify with Twilio

Notify  Zoom connector

The Notify  Zoom Connector expands the Notify  communication channel by managing and 
initiating a Zoom meeting directly from any task record such as an incident or a change.

Compatibility

New York and later.

Key Features

• Start and end Zoom meeting directly from any task record such as incident, or a change or 
even from the Major incident Workbench.

• Manage a Zoom meeting by adding or removing participants.

• Track and report meeting details such as meeting duration and attendees for further analysis.

System Requirements

• Install and activate the Notify  plugin (com.snc.notify) before you install the application.

• Ensure that the system has Zoom spoke, version 1.0.2, for ServiceNow  Integration Hub  plugin 
(sn_zoom_spoke) installed and the necessary Integration Hub  license to use Zoom for meeting 
management.

Plugins

• ServiceNow IntegrationHub Installer  (com.glide.hub.integrations): Suite of plugins necessary 
to design integration flows in the Flow Designer  application.

• The Zoom spoke, version 1.0.2 (com.sn.zoom.spoke) for ServiceNow  Integration Hub  provides 
actions that allow user to create and manage the conference meetings.

Notify voice and SMS capabilities

Notify  provides support for SMS and voice channels for communicating internally with team 
members and externally with customers and contractors.

Notify  provides a way for applications to start and manage a conference, send/receive SMS, 
send/receive calls and present them with IVR like system.

How Notify  processes incoming calls

Notify  processes incoming calls using workflow activities.

Any Notify activity that manages incoming phone calls creates a record on the Notify Workflow 
Activity [notify_wf_activity] table. Each notify_wf_activity record is associated with a single call. 
These records store JSON data detailing the actions to send to the telephony provider.
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Notify  processes incoming calls in the following way:

1. A person calls a Notify phone number.

2. Notify  launches the incoming call workflow associated with that Notify phone number.

3. The workflow reaches a Notify activity and invokes the activity onExecute()  function.

4. The activity creates a new notify_wf_activity record detailing any actions to take, with a State 
value of execute.

5. Notify  sends the specified actions to the telephony provider.

6. The notify_wf_activity record State  changes to processed.

7. The telephony provider sends a response.

8. Response arguments, such as user input or recording info, are stored as JSON data in the 
notify_wf_activity response_args  field.

9. The notify_wf_activity State  changes to complete.

10. The JSON data from the notify_wf_activity record is copied to the Last action  field in the Notify 
call record that triggered the workflow.

11. The workflow invokes the onUpdate()  function in executing activities.

12. The activity confirms that the associated notify_wf_activity record has completed, and changes 
the activity state to finished.

13. The workflow transitions to the next activity.

Notify  Cisco  Webex Connector

Notify  Cisco  Webex Connector enables you to manage and initiate a Webex meeting directly 
from an incident.

Key Features

• Start and end Cisco Webex meetings directly from the major incident workbench.

• Manage a Cisco Webex meeting by adding or removing participants.

System Requirements

Install and activate the Notify plugin (com.snc.notify) before you install the application.

Install the ServiceNow IntegrationHub Installer (com.glide.hub.integrations) plugin to design 
the integration flows in the Flow Designer application. For more information, see Request 
IntegrationHub .

Configuring Notify

Configure and use Notify  application with the third-party applications in your environment to 
resolve the incidents.

Activate Notify

You can activate the Notify  (com.snc.notify) plugin if you are an administrator. This plugin 
includes demo data and activates related plugins if they are not already active.

Before you begin
Role required: admin

About this task
Notify  activates these related plugins if they are not already active.
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Plugins for Notify

Plugin Description

E164 Compliant Phone Number

[com.glide.phone_number]

Provides E-164 compliant phone number support.

SMS Preferences

[com.snc.sms_pref]

Provides ability to set SMS preferences for receiving 
messages from different providers.

Note: 
If you are upgrading from an earlier version of Notify, the Notify-Twilio driver remains active.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.

Note: 
When domain separation and delegated admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .

Related topics

List of plugins

E.164 phone number field configuration

Differences between Notify and Legacy Notify

Describes the differences between the Notify and Legacy Notify applications, including 
architecture, workflows, Twilio support, and task-initiated conference calls.

Legacy Notify (com.snc.notifynow) Notify (com.snc.notify)

Is deprecated. Supported only telephony 
services.

Supports pure conferencing solutions such as 
Zoom in addition to the Telephony providers 
like Twilio.

Manage a single number from a Twilio account 
per instance.

Provides support for multiple numbers per 
Twilio account, especially cross-geographical 
scenarios.
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(continued)

Legacy Notify (com.snc.notifynow) Notify (com.snc.notify)

Does not include support for customizable 
workflows for Voice and SMS incoming or 
outgoing scenarios.

Workflow-driven approach for handling 
incoming and outgoing Voice and SMS events, 
making the integration easy to customize.

Hard-coded join conference SMS and IVR 
prompts for joining a conference call.

Includes a configurable workflow for handling 
SMS and Voice IVR prompts.

Support for SMS-based answers. Notify On Task support for sending SMS and 
initiating conference calls from any task.

Migrating from Legacy Notify

When migrating to Notify  from the Legacy Notify functionality, several changes are made to the 
instance.

If the Legacy Notify functionality is already enabled, several automatic changes occur when you 
activate Notify:

• The Legacy Notify menu is removed from the application navigator.

• Two separators are added to the new Notify menu: Legacy Notify  and Legacy Notify Admin. 
New modules that replace the Legacy Notify modules are added to these sections.

Note: 
The added modules are not the same modules that were in the Legacy Notify menu. Any 
customizations made to the Legacy Notify modules are not preserved.

• The notify_admin role allows access to Notify modules.

• The notifynow_admin role allows access to Legacy Notify modules.

• All workflow activities from the Legacy Notify application are moved to the Legacy Notify 
group.

Configure Notify  with Twilio

Configure Notify  to use the Twilio telephony service.

Before you begin
You must have an SID and authentication token for an active Twilio account (https://
www.twilio.com/). You must have a separate contract with Twilio.

You must exclusively use a Twilio account to connect your ServiceNow instance.

Important: 
Ensure that each instance on which you configure Notify  uses a different Twilio account. 
Each account specifies a unique account SID, authentication token, telephone numbers, 
and endpoint. Using the same account across multiple instances may cause your Twilio 
service configuration to be overwritten.

Account and sub-account are Twilio categorizations, and both act the same for a 
ServiceNow  instance.

Role required: notify_admin
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Procedure

1. Navigate to All  > Notify  > Administration  > Twilio Direct Configuration.

2. On the Twilio Account Properties page, enter your Account SID.

3. Enter your Auth Token.

4. Click Connect.
If the account is not associated with an instance and the connection is successful, a read-only 
list of E.164 and short code phone numbers associated with this Twilio account appears. This 
list displays the phone number, supported capabilities such as voice or SMS, the country for 
each Twilio number, and the Notify number group to which the number belongs.

If the account is already associated with an instance, the system displays an error message. To 
connect to this account,

◦ Disconnect the account from the instance.

◦ Delete the TwiML apps in the Twilio account.

Note: 
If you buy or release numbers on the Twilio account, open the configuration page again 
to refresh the list of numbers. Numbers removed from the Twilio service remain as Notify 
Number records, but with the Active  field set to false. Use only active phone numbers for 
inbound or outbound communication.

What to do next
Phone numbers and short codes are provided by Twilio once the account is successfully 
connected and are stored on the Notify Phone Numbers [notify_number] table. Assign each 
number to a number group. Number groups allow you to control which workflows run when using 
the phone numbers in each number group.

Twilio-Direct callback testing

Make an outgoing call or send an SMS using Twilio and trigger callbacks to ServiceNow  to test 
whether Twilio can reach the instance. You can also view when the last callback test was run, its 
status, and the test logs.

Before you begin
Role required: admin, notify_admin

Procedure

1. Navigate to All  > Notify  > Administration  > Twilio Direct Configuration.

2. Click Test Callbacks.

3. Select the SMS option and click Initiate SMS.

4. Select the call option and click Initiate Test Call.

Note: 
The callbacks can be tested only after a connection is established with Twilio.

Advanced configuration for SMS

Use the Twilio co-pilot features to improve SMS delivery with phone number like using multiple 
numbers to send high-volume messages and content intelligence to automatically format every 
message without writing custom code. Reach large lists of users with one API request.

Before you begin
Role required: notify_admin
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About this task
The Twilio co-pilot features are enabled in your instance once configured. An example of 
a copilot feature is that you can configure which identity (phone number, shortcode, or 
alpha sender ID) to use to send a message. You can also spread the messaging traffic over 
several phone numbers or prioritize an alpha sender ID when sending messages to countries 
where alpha senders are commonly used. To know more about these features, visit https://
www.twilio.com/copilot .

Important: 
All the Twilio numbers must be part of the same messaging service for which you have 
enabled the Advance SMS Features  feature.

The Twilio Notify bulk SMS feature is used to send SMS in bulk to customers. Use the 
passthrough sendBulkSMS  API to reach large number of users across using a single API 
request. For more information on these features visit https://www.twilio.com/notify

Procedure

1. Navigate to All  > Notify  > Administration  > Twilio Direct Configuration.

2. On the Twilio Account Properties page, enter your Account SID.

3. Enter your Auth Token.

4. Click Connect.

5. On the Advance SMS Features  tab, check the Intelligent SMS Handling  box.

Note: 
To setup Alpha Sender ID, users need to go to Twilio console.

When you enable Intelligent SMS Handling, the "Messaging Service SID" is used to send the 
SMS even if a Twilio number is used in Notify.sendSMS API.

6. On the Advance SMS Features  tab, check the Twilio Notify Bulk SMS  box.

Note: 
This feature uses Twilio Notify feature and might have an associated cost. Contact Twilio 
Support for more details.

Related topics

Using Notify with SMS

Advanced configuration for voice

Configure Answering Machine Detection (AMD) to determine if a human has picked up the call or 
not.

Before you begin
Role required: notify_admin

Procedure

1. Navigate to All  > Notify  > Administration  > Twilio Direct Configuration.

2. On the Twilio Account Properties page, enter your Account SID.

3. Enter your Auth Token.

4. Click Connect.
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5. On the Advance Voice Features  tab, check the Detect answering machinebox.

6. On the Advance Voice Features  tab, enter the number of seconds in the Machine detection 
timeoutfield to set a timeout value.

Disconnect from a Twilio account

If a Twilio account is already associated with a different system, disconnect the account from the 
other system before connecting to the current instance.

Before you begin
Role required: notify_admin

Procedure

1. Navigate to All  > Notify  > Administration  > Twilio Direct Configuration.

2. On the Twilio Account Properties page, click Disconnect.

3. In the Disconnecting Twilio account pop-up window, click OK.

The account is disconnected from the instance. The system clears the Account SID  and Auth 
Token  fields and deactivates the list of associated phone numbers.

Configure Amazon Polly as default voice tone for text to speech

You can configure Amazon Polly as the default voice by overriding the default voice tone for text 
to speech.

Before you begin
Role required: notify_admin

Procedure

1. Navigate to All  > Notify  > Administration  > Twilio Direct Additional Properties.

2. In the Twilio Direct driver property field, enter the preferred voice tone.

For example: "Polly.Joanne". The ServiceNow®  instance passes Polly.Joanne value to the 
Twilio service and renders the voice in Joanne’s tone.

If you have a new San Diego  or a higher version instance, the voice property will not be 
defined by default and the voice settings at Twilio will be considered. For more information on 
Amazon Polly voice, see Twilio Text-to-speech . However, if you are upgrading to San Diego 
or a higher release version, the default voice property will be "alice".

Note: 
If you are defining the property in your ServiceNow®  instance, the Twilio voice settings 
are overridden.

Configure Notify Zoom connector in Notify

Configure Notify to receive the event information from Zoom. An event is usually any action that is 
related to a meeting.
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Before you begin
Role required: admin

Procedure

1. Navigate to All  > Notify  > Zoom  > Configuration.

2. Paste the verification token that you recorded on Zoom Event Subscription screen in the 
Webhook validation token  field.

3. Save the record.

What to do next
Configure and use Zoom as a conference provider from any of the task records.

Note: 
The person creating a conference is the host of the conference and must have their email 
set in their ServiceNow profile and use the same email for the Zoom account.

You must be signed in to the browser in order to direct to the Zoom client. However, if you are not 
signed in, you must provide your registration details.

Related topics

Configure a provider in Notify

Start a conference call

Set up Notify Zoom connector in Zoom

Use the Notify  Zoom connector to expand the Notify  communication channel by managing and 
initiating a Zoom meeting directly from any task record such as an incident or a change.

Before you begin
Role required: admin, Zoom admin

1. Ensure that you have Zoom spoke installed on your instance.

2. Make sure you have the required credentials and connections to Zoom on your instance.

3. Configure the Notify Zoom connector with the same Zoom account with which you created the 
OAuth app for Zoom spoke.

Procedure

1. On your Zoom OAuth app, navigate to Feature  > Add Feature  > Event Subscription.

2. Use the toggle button to enable the event subscription feature.

3. In the form that appears, fill in the URL using the following URL format:  https://
yourinstancename.com/api/sn_notify_zoom/notify_zoom/ZoomEvent .
The URL is used to post information about events in Zoom to your instance.

4. Use the Add Events  button to list all the events which Zoom is informing Notify about.

5. In the categories that appear, select Meeting  and select all the meeting-related events from 
the list and click Done.

6. Under Recording, select All Recordings have completed  and Recording Transcript files have 
completed  from the list and click Done.

7. Click Saveon the Add feature screen.
A Verification Token  appears on the Add Feature screen.

8. Record the token by clicking Copy.
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What to do next
Configure Notify with the verification token from Zoom.

Related topics

Configure Notify Zoom connector in Notify

Disable Zoom meeting password

Disable Zoom meeting password so that you can join a Zoom meeting without any meeting 
password.

Before you begin
Role required: notify_admin or admin

Procedure

1. Navigate to Notify  > Zoom  > Configuration.

2. Select Do not set password.

3. Click Update.

Configure a provider in Notify

Configure a conference provider or a phone number to be used as choices for initiating a 
conference call. For sending SMS, configure preferences for phone numbers.

Before you begin
Role required: notify_admin

About this task

Procedure

1. Navigate to All  > Notify  > Provider Selector.

2. Click New.

3. On the form, fill in the fields.

Provider selector fields

Field Description

Name Name of the provider you are adding.

Order Order in which the provider appears when 
multiple providers are configured.

Source table The table to which this provider needs to be 
added.

Condition Conditions on the source table based on 
which provider selectors is applied.

Active Indicates whether the provider is active.

Catch-all Selects this provider if no other Provider 
Selector matches.

Manual selection Disables the automatic selection of this 
provider, for example, if in a communication 
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Field Description

plan you want to use this provider only as a 
forced communication channel.

4. Click Submit.

5. In the Provider Selector Choices section, click New.

6. Search for the conference provider or the Notify group that contains the phone numbers for 
initiating a conference.
For sending SMS, search for the Notify group that contains the phone numbers.

7. Click Submit.

Configure SMS opt-out preferences

Allow recipients to opt out of receiving text messages.

Before you begin
Role required: admin, notify_admin

About this task
According to regulations in the CTIA Short Code Monitoring Handbook, recipients must be 
allowed to opt out of receiving text messages. The opt-out functionality is applicable only to 
Notify. When the user sends an SMS message with an opt-out keyword to any Notify number, the 
user is opted out of receiving messages from only the Notify number to which the message has 
been sent, not from all Notify numbers on that instance.

Important: 
The Advanced opt-out feature is automatically enabled for short code and long code 
numbers associated with a Messaging Service. For more information, refer Getting Started 
with Advanced Opt-Out for Messaging Services . As this feature is a duplicate of the 
Twilio's new Advanced Opt-out feature, you should not activate the feature for numbers 
that are part of Messaging Service. For long code numbers that are not part of a Messaging 
service, Twilio handles the opt-out for default stop keywords listed at Twilio support for opt-
out keywords .

This feature is disabled by default and holds significance for short-code and long codes 
that are not part of Messaging Service. To enable this feature, the Notify admin.

Procedure

1. Navigate to All  > Notify  > Administration  > SMS Preference Configuration.

2. Click New  in the SMS Preference Configuration window.

3. Fill in the form fields.

SMS configuration preference fields

Field Description

Provider Select the provider for which you are 
configuring the SMS preferences.

Name A user-friendly name for the configuration.

Order Order in which the preference configurations 
apply. If you have multiple configurations, 
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Field Description

this field indicates which configuration to 
consider first.

Default preference The default preference for the configuration. 
The two options are:

◦ Opt-in: Users by default will receive SMS 
messages.

◦ Opt-out: Users by default will not receive 
SMS messages. They can start receiving 
SMS messages from a specific Notify 
number after sending a message with an 
opt-in keyword like START or BEGIN.

Enable for long code Option that enables the opt-out feature for 
long code or toll-free numbers.

Enable for short code Enables the opt-out feature for short codes 
only.

Opt-out keywords Keyword replies that prevent a customer 
from receiving new messages from the 
phone number they're responding to. You 
can configure standard keywords such as 
STOP, STOPALL, END, CANCEL, QUIT, and 
UNSUBSCRIBE.

Opt-out confirmation message Customized confirmation message to send 
to customers when they opt out of receiving 
SMS messages.

Opt-in keywords Customized confirmation responses that 
enable customers to receive the messages 
coming from a phone number. You can 
configure standard keywords such as START, 
UNSTOP, and YES.

Opt-in confirmation message A customized confirmation message to send 
to customers when they opt in to receiving 
SMS messages.

4. Click Submit.

Configure Notify  Cisco  Webex Connector

Configure the Notify  Cisco  Webex Connector in your environment to be able to use Cisco  Webex 
application for making conference calls.

Install Notify  Cisco  Webex Connector

You can install the Notify  Cisco  Webex Connector application (sn_notify_webex) if you have 
the admin role.The application includes demo data and installs related ServiceNow®  Store 
applications and plugins if they are not already installed.

Before you begin

• Ensure that the application and all of its associated ServiceNow Store  applications have valid 
ServiceNow  entitlements. For more information, see Get entitlement for a ServiceNow  product 
or application .
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Role required: admin

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the Notify  Cisco  Webex Connector application (sn_notify_webex) using the filter criteria 
and search bar.

You can search for the application by its name or ID. If you cannot find the application, you 
might have to request it from the ServiceNow Store.

In the list next to the Install  button, the versions that are available to you are displayed.

3. Select a version from the list and select Install.

In the Install dialog box that is displayed, any dependencies that are installed along with your 
application are listed.

4. If you're prompted, follow the links to the ServiceNow Store  to get any additional entitlements 
for dependencies.

5. Optional:  If demo data is available and you want to install it, select the Load demo data  check 
box.
Demo data comprises the sample records that describe application features for the common 
use cases. Load the demo data when you first install the application on a development or test 
instance.

Important: 
If you don't load the demo data during installation, it's unavailable to load later.

6. Select Install.

Create a Cisco  Webex app

Create an app in Cisco  portal to make outbound calls from an incident using Webex.

Before you begin
Role required: Cisco admin

Procedure

1. Log in to Cisco  admin portal.

2. Navigate to Start Building Apps  > Start Building Apps  > Create a New App  > Create an 
Integration.

3. On the form, fill the details for the integration app.

a. Will this integration use a mobile SDK: Select No.

b. Integration name: Option to provide the name for the Notify with Cisco  Webex app.

c. Icon: Option to choose an icon for the app.
Select upload to select an icon for the Cisco  Webex app.

d. Description: A brief description of the app.

e. Redirect URI(s): URL of your ServiceNow instance.
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The URL should be of the format: "http://<instance_url>/oauth_redirect.do" where 
<instance_url> is your instance URL.

f. Scopes: Option to select the scopes that are required for conference calls.
Select meeting:admin_participants_read, meeting:admin_schedule_read, 
meeting:admin_schedule_write, and spark:all.

g. Select Add Integration.

The app is successfully created. Save the Client ID  and Client Secret  by clicking on the 
Copy  button in a notepad.

You must update the Client ID  and Client Secret  values in your ServiceNow instance.

Configure OAuth entity for Notify  Cisco  Webex

Configure the Cisco  Webex as an OAuth provider and allow the ServiceNow instance to request 
OAuth 2.0 tokens.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System OAuth  > Application Registry.

2. Select Cisco Webex Teams spoke.

3. Update the following values in the application registry.

◦ Client ID: Paste the client ID generated while creating the Cisco  integration app.

◦ Client Secret: Paste the client secret generated while creating the Cisco  integration app.

◦ Redirect URL: Provide your instance details of your ServiceNow instance. The URL should be 
of the format "http://<instance_url>/oauth_redirect.do" where <instance_url> is your instance 
URL.

4. Select Update.

5. Select OAuth Entity Scopes  tab.

The following scopes are available by default:

◦ meeting:admin_participants_read

◦ meeting:admin_schedule_read

◦ meeting:admin_schedule_write

◦ spark:all

Create an OAuth credential record for Notify  with Cisco  Webex

Create a credential record for the Notify  with Cisco  Webex account.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Connections & Credentials  > Credentials.

2. Click New.
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The system displays this message: What type of Credentials would you like 
to create?

3. Select OAuth 2.0 Credentials.

4. On the form, fill these values.

OAuth 2.0 Credentials form

Field Description

Name Name to uniquely identify the record. For example, Cisco 
Webex Teams Cred.

Active Option to actively use the credential record.

OAuth Entity Profile OAuth profile created during the registration of Cisco Webex 
Teams as an OAuth provider. For example, Cisco Webex 
Teams OAuth Profile.

Applies to
Option to specify if the credential applies to all MID Servers 
in your network, or to one or more Specific MID servers. 
Specify the MID Servers that should use this credential in the 
MID servers  field.

Order Order to apply this credential. For example, 100.

Credential alias Credential alias associated with the spoke.

5. Right-click the form header and click Submit.

6. Select the Get OAuth Token  related link.

You must log in to Cisco  Webex account to retrieve the token details.

Enter the email address of the Cisco  account that connects your ServiceNow instance with 
Cisco  Webex portal. This email address should be unique and can’t be assigned to any user. 
Ex: cisco_servicenow@webex.com.

On successful authentication, a confirmation message is displayed on the header.

Create a connection and credential alias for Notify  connector for Cisco  Webex Spoke

Create a credential record for the Notify  connector for Cisco  Webex account. The Notify 
connector for Cisco  Webex Spoke connection and credential alias uses these credentials to 
authorize actions.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Connections & Credentials  > Credentials.

2. Select the CiscoWebexTeams  record.

3. Select New  under Connections  tab.

4. On the form, fill these values.
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Connection & Credential for Cisco Webex Teams

Field Description

Name Name for the HTTPS connection record for Cisco Webex 
Teams spoke

Credentials
Name of the credential created for Cisco Webex Teams 
spoke

Provide the value created in “Create a OAuth credential 
record for the Cisco Webex Teams spoke”.

Connection URL
Option to provide the connection URL.

Provide the value as https://webexapis.com

5. Right-click the form header and click Submit.

Make Notify  Cisco  Webex Connector as default communication channel

Make Notify  Cisco  Webex Connector as a default communication channel to initiate a meeting to 
resolve the major incidents.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Notify  > Provider Selector.

2. Select New.

3. On the form, fill in the fields.

Provider Selector

Field Description

Name Name of the provider you are adding.

For Example, Notify  Cisco  Webex.

Order Order in which this provider appears when multiple providers 
are configured.

Source table The table to which Notify  Cisco  Webex must be added.

For Example: incident.

Active Option for indicating whether Notify  Cisco  Webex as a 
provider is active.

Default
Option for making Notify  Cisco  Webex the default provider if 
other notify providers like Zoom or Twilio are configured.

Enable the default option.
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4. Select Submit.

5. Select the newly created service provider.

6. In the Provider Selector Choices  section, select New.

a. Select Webex  as the conference provider.

7. Select Submit.

Manage Notify  properties

Manage the Notify  Webex Connector application properties to configure the meeting 
capabilities.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Notify  > Administration  > Notify Properties.

2. On the form, fill the fields.

Notify properties

Field Description

Enable Notify integration for Task table and 
extensions Option to enable Notify integration for Task 

table and extensions.

Select the check box.

Enable Notify integration for Incident 
Communications Management. 
Entering phone number in 
'com.snc.iam.notify_number' property is 
equivalent to setting this to true.

Option to use Notify Webex Connector for 
incident and major incident-related records.

Select the check box.

3. Select Save.

Using Notify

Use the service providers to schedule the conference calls with the stake holders to resolve the 
incidents.

Using Notify  with SMS

Send and receive SMS messages using Notify.

Notify  stores inbound and outbound SMS messages in the Notify Messages [notify_message] 
table.

Notify  supports sending concatenated SMS messages. Messages that exceed 160 characters, or 
70 unicode characters, are split into multiple messages. This may affect your total telephony cost 
because each message can incur a cost. Some mobile carriers, such as Sprint, do not support 
concatenated SMS messages.

To send SMS messages to an individual recipient, use the Notify API sendSMS  method. This 
method takes one recipient as an input parameter. You can also use the send SMS  workflow 
activity.
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To send SMS messages to one or more recipients, use the Notify API sendBulkSMS  method. 
This method takes a list as an input parameter and uses one API call to send multiple messages. 
Include the list of phone numbers in an array in the API call. This method improves performance 
by streamlining platform checks and Notify number validation.

Note: 
When using SNC.Notify.sendBulkSMS  API, instead of simply iterating over the 
numbers, all the given numbers are sent for SMS to Twilio in one API call. This happens only 
when Twilio Direct driver is active and Twilio Notify bulk SMS is enabled for the number in 
Advanced SMS features.

The Notify-Twilio integration provides programmable SMS outbound message status tracking 
with Status Callbacks. These callbacks can be helpful to see if a message has been delivered, 
failed, or ran into some other delivery issues.

SMS Statuses

Every Twilio SMS message request has a status value which describes the current state of the 
message. Use this information for troubleshooting SMS related incidents/ issues. Here are few 
descriptions of possible statuses of SMS sent from Notify  through Twilio REST API.

Outbound message status progression

Status Description

queued The message has been queued by the provider to be sent to 
the carrier network.

accepted The message is being processed by the provider before 
sending it to the carrier network.

sending The message is being forwarded to the carrier network.

sent The message has been successfully forwarded to the carrier 
network.

receiving The provider has received an incoming message from the 
carrier network and is processing it.

received ServiceNow  has received the incoming message from the 
provider.

delivered The message has been delivered to the target device.

Note: 
A provider may not be able to report this status if the 
upstream carrier does not report this.

undelivered The message could not be delivered to the target device.

Note: 
A provider may not be able to report this status if the 
upstream carrier does not report this.

failed The message failed to be forwarded to the carrier network.

unknown The driver does not support the status
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Send an SMS with Zoom meeting invite

Send an SMS with Zoom meeting invite to ensure that the meeting participants or any newly 
added participant is updated with the meeting details when the meeting host starts the 
conference or adds a participant to the conference.

Before you begin
Role required: notify_view, notify_admin or admin

Note: 
You need a telephony provider like Twilio or Nexmo.

Procedure

1. Navigate to All  > Notify  > Zoom  > Configuration.

2. In the Run Workflow on conference change  field, enter Notify Zoom: Send SMS on 
Conference Change.
The Notify Zoom: Send SMS on Conference Change workflow is available with the demo data 
of the Notify Zoom Connector plugin (sn_notify_zoom).

3. Click Update.

Outbound communication requirements

Outbound communications initiated through Notify, such as phone calls and SMS messages, 
must satisfy recipient number requirements.

Recipient number requirements

These requirements apply to any number that receives a Notify  phone call or message.

• The number must be E.164 compliant.

• The number must be different than the phone number used to initiate the call or message.

These requirements apply to all outbound communication initiated through Notify, such as by 
using Notify  workflow activities or the Notify JavaScript API.

Invalid numbers prevent Notify workflows from running and cause an error to be logged. Set the 
glide.notify.debug  property to true to create detailed error logs.

Using Notify for making conference calls

Notify administrators, major incident managers, or communications managers can manage 
conference calls.

Conference call records are stored on the Notify Conference Calls [notify_conference_call] 
table. Conference call participant records are stored on the Notify Conference Call Participants 
[notify_participant] table.

Conference call and participant records are created automatically when starting and connecting 
to a conference call. Most fields, such as the Duration  of a call, are set automatically using 
business rules.

Note: 
If a participant attempts to join a conference call using an invalid phone number, the caller 
is added to the participant list and the phone number is marked with a status of Invalid.

Notify administrators, major incident managers, or communications managers can manage 
conference call participants.
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Several conference call workflows are available by default. These workflows can be used for 
incoming and outgoing calls and incoming SMS messages. Conference call workflows are:

• Notify: (Re)join Conference Call

• Notify: Join Conference Call Via SMS

• Notify: (Re)join Conference Call with muting

Note: 
Notify: (Re)join Conference Call with muting is available only with demo data.

The number groups Conference Call Group and Notify On Task Group use these conference call 
workflows by default.

Start a conference call

Start a conference call from a task or an incident communication plan by inviting one or more 
users to join a call. The conference will not start until at least two participants join.

Before you begin
Role required: notify_view, incident.manager

About this task
Call participants can include:

• Users who have been assigned specific responsibilities

• Ad-hoc user contacts

• Other involved parties who are not recorded as users, such as third-party contacts

Procedure

1. Navigate to All  > Incident Communications Management  > Open.

2. Open the relevant incident communication plan.

3. Click the Initiate Conference Call  related link.

4. From the dialog box that appears, choose the Conference Bridge  that you want to dial from.

5. Select the participants for the conference.
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Initiate a conference call

The dialog box displays the Recommended and Selected participants for the conference. All 
users from the User Contactslist in the incident communication plan are in the Recommended 
section by default. The user who initiates the conference call is added to the selected list of 
participants.

If a shift exists for the group contacts, the primary and secondary on-call resources are shown 
in the Recommended  list.

Calls are placed to the number in the Mobile  phone field on the user record. If that information 
is blank, the user cannot be contacted through Notify. The mobile phone number has to be an 
E.164 compliant phone number. If the phone number is a local number, without the + prefix, the 
number will be retrieved based on the user's location and, if possible, converted into a valid 
E.164 number.

6. To select ad-hoc participants,
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Option Description

Click the reference lookup icon, and select 
the relevant user.

Click Add to selected.

Enter the participant's phone number Click Add to selected.

7. After the participant list is finalized, click Start Call.
The conference call starts and a Conference call initiated  message is displayed at the top of 
the incident communication plan form. Each user is called and can accept the call to join the 
conference.

8. Click the Conference call initiated  message to see details of that conference call.
When the final participant leaves the conference, the conference call closes.

Note: 
VoIP phone systems, which do not use touch tone phones, may encounter issues with 
recognizing key presses. To avoid problems, ensure that conference call users use 
touch tone phones, or configure your VoIP system settings to recognize key presses, as 
described in your VoIP system documentation.

Add participants to a conference call

Add a participant to a conference call using Notify.

Before you begin
Role required: notify_view, notify_admin, major_incident_manager, or communication_manager

About this task
You can add the following participants:

• Users who have been assigned specific responsibilities

• Required ad-hoc user contacts

• Other involved parties who are not recorded as users, such as third-party contacts

Procedure

1. Navigate to All  > Notify  > Conference Calls.

2. Open the conference call that you want to add a participant to.

3. Click the Add Participant  related link.

4. In the dialog box that appears, select the participants you want to add to the conference.
You can add a single participant, a group of participants, or a phone number.
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5. You can send a message for the participant who you want to add in the Include a brief 
message for participants  field.

6. Click Add Participant.
The selected user, group, or phone number is added to the selected conference call.

Related topics

Mute or remove a conference call participant

Mute or unmute all participants

As a communications manager or a conference call host, mute/unmute all the conference 
participants from the workbench.

Before you begin
Role required: notify_view, notify_admin, major_incident_manager, or communications_manager
Before starting this procedure, ensure there is an active conference call with one or more 
participants.
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Procedure

1. Navigate to All  > Major Incident Management  in the application filters.

2. Select the incident that you are trying to resolve.

3. On the incident, click View Workbench

4. In the Conferences  tab, select a conference

Option Description

Mute All
Click this button to mute all the participants in 
the conference

Unmute All
Click this button to unmute all the participants 
in the conference
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Mute All

Unmute All
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Mute or remove a conference call participant

As a communications manager, you can mute or kick conference call participants.

Before you begin
Role required: notify_view, notify_admin, major_incident_manager, or communication_manager
Before starting this procedure, ensure there is an active conference call with one or more 
participants.

Note: 
Any participant with the host flag set to active, can mute or kick a participant from a 
conference call.

Procedure

1. Navigate to All  > Notify  > Conference Calls.

2. Select a conference call.

3. In the Notify Conference Call Participants  related list, select a participant.

4. Click Mute  or Kick.

Note: 
You can unmute a muted participant. A kicked participant may rejoin the conference call 
by calling in again.

Send a message to conference call participants

Send a brief message as a text or voice message to the participants of a conference call to set a 
context to the call.

Before you begin
Role required: notify_view, or major incident manager

About this task
You must configure a telephony provider like Twilio so that you can use one of the Notify numbers 
to send SMS to the conference call participants.

Procedure

1. Navigate to All  > Major Incident Management  > View Workbench.

2. In the Conference  tab, select the type of the call and click Start Call.

3. In the Include a brief message for participants  field, type the message that you want to send 
to the conference call participants and click Start Call.
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Initiate a conference call

Note: 
Upon clicking Start Call  the message text entered will be stored as description on the 
conference call record. If the OOB workflow is not modified, then the workflow takes care 
of sending this message text as SMS to the user. This is applicable if you have configured 
a telephony provider.

Viewing conference call information

Conference calls are listed as system activities in the Activity  section of the Incident 
Communication Plan form and also are listed in the Conference Calls  related list.
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View conference call information

List of Notify calls

If you are a Notify  administrator, you can view a list of calls and the status of a call made to or 
from Notify. The call records help in reporting and analytics.

To view a list of calls, navigate to Notify  > Calls.

Call records are generated automatically when a user calls a Notify  number or when a user 
makes an outbound call through Notify. You cannot create call records manually.

Note: 
Although you can delete a call record, doing so may result in cascade deletion of related 
records.

For Notify  calls where the source is specified, such as a task number, the source is added to the 
Notify  Calls [notify_call] table in the Source  column. For Notify  conference calls where the source 
is specified, the source is added to the records for each of the calls in the conference.

Call status Description

initiated The number has just been dialed

ringing The call is currently ringing.

in_progress The call was answered and is currently in 
progress.

no_answer The call was not answered.

completed The call was answered and has ended 
normally.

busy The caller received a busy signal.

failed The call could not be completed as dialed, 
most likely because the phone number was 
non-existent.

invalid The call could not be connected since input is 
invalid.
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Call status Description

unknown The driver does not support the status

Using Notify  with tasks

Notify  allows you to initiate conference calls and send SMS alerts from task records.

This functionality is available for all tables that extend the Task table, such as incident, problem, 
or change request. All calls and messages made from tasks are initiated using a single Notify 
phone number (E.164 or short code). You can configure which phone number is used by setting 
the property glide.notify.task.phone_number.

Start a conference call from a task

Use Notify  to start conference calls from a task record.

Before you begin
Role required: notify_view, or itil
Notify  must be set up before you can use Notify  on task. Ensure there are Notify  phone numbers 
(E.164 or short code) in number groups with phone call workflow.

Use glide.enable.notify_on_task  property to enable Notify integration for Task table and its 
extensions. Entering phone number in glide.notify.task.phone_number  property is equivalent to 
setting glide.enable.notify_on_task  to true.

Procedure

1. Navigate to any task record, such as an incident or change request.

2. Click the Start conference call  related link.

3. Select one or more Recipients  to participate in the conference call.

4. Click Start.
Any conference call records created from a task are associated with that task. You can view 
associated conference calls from the task record in the Conference calls  related list. You may 
need to configure the form to add the related list.

Manage conference calls on task

Add and manage multiple participants on the conference including self-joining in to the 
conference call and end the conference call when the discussion is over.

Before you begin

• Role required: notify_view, itil, itil_admin, or admin

• A conference call is already initiated.

About this task
The Manage Conference Calls  UI action is available for any table that extends the Task [task] 
table. If at least one conference call is active on a task record, the link appears on the related 
links section of the form. Out of the tables that extend the task table, the Manage Conference 
Calls  UI action is intentionally hidden for Incident Communication Plan [incident_alert] table 
and Communication Task [comm_task] table. For these two tables, the functionality is already 
available as Join conference call  and End conference call  UI actions.

Procedure

1. Navigate to any task record such as Incident, Problem, or Change Request.

2. Open the record on which the conference all is active.
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3. In the related links, click Manage Conference Calls.

4. In the Manage Conferences window, you can perform the following activities:

Options Description

Join Conference Call If the logged in user is not already a part of 
the conference call, the user can join the 
conference.

Add Participants Add participants to the conference who can 
contribute to the discussion.

End Conference Call End the conference when the discussion is 
over.

5. Optional:  In the Manage Conferences window, click the conference call number to know the 
details of the conference.

Send an SMS alert from a task

Use Notify  to send information related to a call through SMS alerts from a task record.

Before you begin
Role required: notify_view, or itil

About this task
Ensure that there are Notify  phone numbers (E.164 or short code) in number groups with SMS 
workflows.

Use glide.enable.notify_on_task  property to enable Notify integration for Task table and its 
extensions. Entering phone number in glide.notify.task.phone_number  property is equivalent to 
setting glide.enable.notify_on_task  to true.

Procedure

1. Navigate to any task record such as an incident or a change request.

2. Click the Send SMS  related link.

3. In the From  choice list, select the phone number from which you want to send the SMS 
message.

4. Select and add the participants to whom you want to send the SMS message.
All users from the User Contacts  list in the incident communication plan are in the 
Recommended section by default.

The dialog box displays the Recommended and Selected participants you selected to send an 
SMS message.

5. To select ad-hoc participants, choose one of the following actions.

Option Description

Click the reference lookup icon and select 
the relevant user

Click Add to selected.
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Option Description

Enter the participant's phone number Click Add to selected.

6. After the participant list is finalized, type the message you want to send to the participants in 
the Message  field and click Send SMS.

Result
Any SMS records created from a task are associated with that task. You can view associated SMS 
messages from the task record in the SMS Messages  related list. You might need to configure 
the form to add this related list.

Using Notify  with Incident Communications Management

Use Notify  with incident communication plan to send SMS messages or start conference calls.

Certain configuration steps are required to use Notify  with an incident communication plan.

• Both Notify  and Incident Communications Management must be active.

• Notify  must be configured and able to initiate and receive phone calls and SMS messages.

• The property com.snc.iam.notify_number  must be set to an active Notify  number with 
outgoing voice and SMS capability.

• This Notify  number must belong to a number group configured with inbound and outbound 
conference call workflows.

Note: 
The Conference Call Group number group is configured with conference call workflows by 
default.

Related topics

Incident Communications Management

Numbers and number groups

Using Notify for making conference calls

Initiate a conference call from incident communication plan

Use Notify  to initiate a conference call from an incident communication plan by inviting one or 
more users.

Before you begin
Role required: notify_view, or admin

Procedure

1. Navigate to Incident Communications Management  > All.

2. Open the relevant incident communication plan.

3. Click the Conference  tab.

4. For the relevant incident communications task, under Actions, click Start Conference Call.

5. Select the conference bridge and the participants for the conference call.
Available options in the conference bridge depend on the conference providers configured. 
For more information, refer Configure a provider in Notify.
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Join and end a conference call from incident communications management

After a conference call is initiated, join the call to participate in the discussion or end the call 
when the conference is no longer required.

Before you begin
Role required: notify_view, ia_admin or admin

Procedure

1. Navigate to Incident Communications Management  > All.

2. Open the relevant incident communication plan.

3. Click the Conference  tab.

4. For the relevant incident communications task, under Actions, perform one of the following 
actions.

Send communication updates for an incident communications plan

Update users on the latest communication on an incident through selected communication 
channels.

Before you begin

• Role required: notify_view, or admin

• Activate the Notify plugin (com.snc.notify) if you want to send communication through SMS.

• Set at least one communication channel for a communication task as SMS or email.

Procedure

1. Navigate to Incident Communications Management  > All.

2. Open an incident communication plan record.

3. From the Incident Communication Tasks related list, open the incident communication task for 
which you want to send updates.

4. In the related links, click Start Updates.

5. Fill the required information and click Send.
For sending an SMS communication, in the From  choice list, select a number from which you 
want to send the communication.

6. Click Send.

Related topics

Incident Communications Management

Using Notify  with On-Call Scheduling

When using both Notify  and On-Call Scheduling, you can send On-call escalation notifications 
as SMS messages, in addition to emails.

Configure the following items to use Notify  with On-Call Scheduling:
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• You must add at least one Notify  phone number to the On-Call Group number group. This 
group is configured by default to handle inbound SMS responses (via On-Call: Check 
Assignment Response) that accepts or rejects an on-call assignment and to handle outbound 
voice calls (via On-Call: Assign by Acknowledgement Voice) to accept or reject assignments.

• You must configure workflows, such as the On-Call: Assign by Acknowledgement to drive 
escalations via SMS and Voice.

Set up Notify  with On-Call Scheduling

You can configure on-call scheduling to use Notify functionality to send SMS alerts and assign 
users to tasks based on the SMS responses.

Before you begin
Ensure that the Notify  and On-Call Scheduling  plugins on your instance are activated.

Role required: notify_view, or admin

About this task
Set up Notify  with On-Call Scheduling  for the first time or migrate from On-Call Scheduling  with 
NotifyNow.

Procedure

1. Navigate to All  > Notify  > Numbers.

2. Select the phone number you want to use to send and receive on-call scheduling messages.

3. In the Notify group  field, select the On-Call Group.
The On-Call Group is configured with the on-call workflows: On-Call: Check Assignment 
Responseand On-Call: Assign by Acknowledgement Voice  by default.

4. Navigate to Workflow  > Workflow Editor.

5. Select the On-Call: Assign by Acknowledgement  workflow.

6. Click the workflow menu icon in the title bar and select Copy  to copy the On-Call: Assign by 
Acknowledgement per rota  workflow.

Save the copied workflow under a different name than what it is named by default.

Note: 
You must avoid modifying default workflows and instead choose to copy and then modify 
the required workflow.

7. Select a Send SMS  activity.

8. In the To (script)  field, modify the getRecipientsAndNumberToSendFrom()  to use the 
correct value from getNotifyNumber()  notify number's sys ID.

9. Close the Workflow Editor

10. Navigate to On-Call Scheduling  > Trigger Rules.

11. Select a trigger rule that launches an assignment workflow

12. In the Trigger action  field, select Workflow.

13. In the Trigger workflow  field, select the On-call: Assign by Acknowledgement workflow.

14. Click Update.

15. Repeat the previous 3 steps for each assignment trigger rule.
Each time the conditions for one of these trigger rules is met, the On-call: Assign by 
Acknowledgement workflow runs.
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Related topics

Workflow editor title bar

Controlling the on-call communication channel with Notify

Configure On-Call Scheduling  with Notify  to always use a user's preferred communication 
channel.

If Force communication channel  is specified in the Escalation settings  for rosters, the preferred 
user device is used: SMS, voice, or email.

For example, if the preferred device is SMS and the on-call member does not have an SMS 
device defined, the user is not contacted even if the user has an email address. When forcing 
a communication channel on an escalation level does not succeed, no further communication 
attempts are made. The fact that the user could not be reached is logged.

Related topics

Subscription-based notifications

On-Call Assign by Acknowledgement workflow

The On-Call: Assign by Acknowledgement  workflow is provided with Notify.

The workflow uses data from the escalation settings, including overlapping shifts and custom 
escalation settings, of shifts and rosters. Depending on these escalation settings, the workflow 
iterates through the defined escalation chain and sends notifications by SMS, email, or voice to 
users asking them for incident assignment. The workflow respects time-off as specified in the 
rosters. People who have time-off are not included in the escalation chain and no notifications 
are sent to them.

When you install both On-Call Scheduling  and Notify, the message_number column is added to 
the Notify Messages [notify_messages] table to track responses to on-call assignment requests. 
This column indicates if the contacted user accepted or rejected the assignment. Before you can 
send notifications, you must define trigger rules. Trigger rules determine the conditions that must 
be met before a notification is sent and what action must be taken.

Call a user from the WebRTC UI

Make outbound calls and receive a voice call in the browser through the WebRTC interface from 
On-Call Schedules landing page, Roster and Escalation Details dialog box and on-call calendar.

Before you begin
Role required: notify_view, or itil

Procedure

1. Navigate to All  > On Call scheduling  > On Call calendars.

2. In the calendar that opens, click the name of the user you want to call.
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3. Choose Call  to call the user.

Key differences between on-call scheduling with NotifyNow and with Notify

There are key differences between on-call scheduling with NotifyNow and on-call scheduling 
with Notify.

Tracking responses to questions

The On call:Assign by Acknowledgement workflow no longer uses the Notify Question 
tables to track assignment responses. When you install On-Call Scheduling  with Notify, the 
message_number column is added to the Notify Messages [notify_messages] table to track 
responses to on-call assignment requests. This column indicates if the contacted user accepted 
or rejected the assignment.

Using the Notify  Cisco  Webex Connector with a major incident

Initiate a conference call from the major incident workbench by inviting one or more users to join 
a call.

Notify administrators, major incident managers, or communications managers can manage 
conference calls.

Create a collaborative communication task from MIM workbench

Create a communication plan or add a new communication task to an existing communication 
plan to resolve a major incident from the major incident management workbench.

Before you begin
Role required: notify_view, or admin

Procedure

1. Navigate to All  > Incident  > Major Incidents  > Open.

2. Open the relevant major incident.
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3. Select View Workbench.

4. Select Collaborate  tab.

5. Select Add  that appears in the Communication Tasks  section.

6. On the form, fill the fields.

Collaborative Task

Field Description

Task Short description
Option to provide a short description for the communication 
task.

Channels
Option to choose the channel for communication.

Select Conference.

Frequency
Option to select the frequency at which the task must be 
executed.

A task can be executed only once or on specific durations.

Due in (Minutes)
Time span by when the task must be executed after the task 
initiates.

7. Select Next.

8. In the Manage Recipients  tab, add the users required to be involved in the major incident 
communication plan.

9. Select Add.

Initiate Notify  Cisco  Webex conference from MIM workbench

Initiate a Webex conference from the MIM workbench to work towards the resolution of the major 
incident.

Before you begin
Role required: notify_view, or major_incident_manager

Procedure

1. Navigate to All  > Incident  > Major Incidents  > Open.

2. Open the relevant major incident.

3. Select View Workbench.

4. Select Collaborate  tab.

5. Select Initiate  button.

6. On the form, fill the fields.
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Initiate task dialog box table

Field Description

Conference Bridge
Option to select the conference bridge for the meeting.

The Conference Bridge will be selected as Webex only 
Webex is the default provider selector.

Add Participants
Option to add the users and the stakeholders to work 
towards the resolution of the ticket.

◦ Users: Enter the name of the user to include in the call.

◦ Group: Enter the group of users to be included in the call.

◦ Email: Enter a valid email of the participant to be included 
in the call.

After adding the required stakeholders, click Add to selected.

Title The default title is the ticket number appended with the short 
description.

Include a brief message for 
participants

Option to provide an opening message to the user before 
beginning the interaction.

7. Select Start.

8. Select Open Link  in the dialog box that appears.

You can also click the link from the workbench to begin the Webex conference call.

Add participants to a conference call

Add a participant to a conference call to participate in the discussion to resolve the major 
incident.

Before you begin
Role required: notify_admin, major_incident_manager, or communication_manager

Procedure

1. Navigate to All  > Incident  > Major Incidents  > Open.

2. Open the relevant major incident.

3. Select View Workbench.

4. Select Collaborate  tab.

5. Select (+) Participants under Active Participants.

6. On the form, fill the fields.

Add participants

Field Description

Add Participants
Option to add the users and the stakeholders to work 
towards the resolution of the ticket.
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Field Description

◦ Users: Enter the name of the user to include in the call.

◦ Group: Enter the group of users to be included in the call.

◦ Email: Enter a valid email of the participant to be included 
in the call.

After adding the required stakeholders, click Add to selected.

Title The default title is the ticket number appended with the short 
description.

Include a brief message for 
participants

Option to provide an opening message to the user before 
beginning the interaction.

7. Select Add Participants.

You can view the participants status in an active conference call.

Join a conference call

You can join an active conference call from an incident to discuss about the resolution of an 
incident.

Before you begin
Role required: notify_view, notify_admin, major_incident_manager, or communication_manager

Procedure

1. Navigate to All  > Incident  > Major Incidents  > Open.

2. Open the relevant major incident.

3. Select View Workbench.

4. Select Collaborate  tab.

5. Select Join Call.

Notify  reference

View the additional information about Notify  application in this section.

Differences between Notify-Twilio and Notify-Twilio Direct

Describes the differences between the Notify-Twilio and Notify-Twilio Direct drivers, including 
architecture, workflows, Twilio support, and task-initiated conference calls.

Differences between Notify-Twilio and Notify-Twilio Direct

Notify-Twilio (com.snc.notify.twilio) Notify-Twilio Direct (com.snc.notify.twilio_direct)

This plugin is deprecated. Notify - Twilio Direct 
Driver now replaces this plugin.

Provides next generation integration with 
Twilio and Notify.

Uses Java SDK based integration with Twilio. It is a JavaScript based driver which uses 
platform provided outbound REST APIs to 
connect to Twilio.
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Differences between Notify-Twilio and Notify-Twilio Direct  (continued)

Notify-Twilio (com.snc.notify.twilio) Notify-Twilio Direct (com.snc.notify.twilio_direct)

NA Adds support for various advanced SMS 
features such as Co-pilot messaging, Twilio 
Notify bulk SMS.

NA Adds support for various functionalities in 
conference calls such as view the participant 
who is speaking on the conference call, 
disable beep when someone enters/exits 
a conference, advanced call features like 
machine detection and so on.

Migrate to Notify-Twilio Direct driver

Migrating to Notify-Twilio Direct driver provides next-generation integration with Twilio and Notify.

Before you begin
You must be connected to Twilio using the Notify Twilio driver.

Role required: notify_admin

Procedure

1. Navigate to Notify  > Administration  > Twilio Configuration (Legacy).

2. Click Migrate Now.

3. Click Ok  on the confirmation dialog.
A disconnection of the Twilio driver is initiated and the Account SID and Auth Token are copied 
to Twilio Direct's configuration page. Twilio Direct is then autoconnected to that account, and 
you are redirected to the driver's configuration page.

Public URLs

On-premise customers should ensure that the URLs are accessible from the Internet for the 
Notify-Twilio driver to work correctly.

The Notify-Twilio drivers (both new and old) require that specific URLs on the instance be 
accessible from the Internet by the Twilio server without authentication. If the instance is within a 
private network, you need to either port forward or set up a reverse proxy.

For the Notify-Twilio driver, the URLs are:

• /NotifyTwilioCallProcessor.do

• /NotifyTwilioCallStatusProcessor.do

• /NotifyTwilioSMSProcessor.do

• /NotifyTwilioDialStatusProcessor.do

• /NotifyTwilioEventProcessor.do

• /NotifyTwilioDialProcessor.do

• /NotifyTwilioRecordingProcessor.do

For the Notify-Twilio Direct driver, the URLs are:
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• /api/sn_twilio_direct/twilio_callbacks/process/twiml/{callback_name}

• /api/sn_twilio_direct/twilio_callbacks/process/xml/{callback_name}

Note: 
The glide.notify.endpoint property needs to be set to an Internet visible name 
because the instance name inside a private network can be different from the Internet 
domain.

Components installed with Twilio Direct driver

Several types of components are installed with the Twilio Direct driver for integration with Notify.

Business rules installed with Twilio Direct driver

Twilio installs the following business rules.

Business rule Table Description

Account 
Connected 
Disconnected 
Message

[sn_twilio_direct_twilio_config] Verifies if Twilio is completely configured and 
displays an info message.

Calculate test 
duration

[sn_twilio_direct_callback_test] Sets the duration for Twilio Callback tests.

Machine 
detection 
timeout range 
check

[sn_twilio_direct_twilio_config] Verifies the timeout values for detecting the 
answering machine if the Detect answering 
machineis enabled. The valid range of the 
timeout is 3-120 seconds.

Move 
credentials

[sn_twilio_direct_twilio_config] Moves the account credentials to 
[sn_twilio_direct_basic_auth]

Populate 
Credentials

[sn_twilio_direct_twilio_config] Populates the current SID and Auth token 
from the [sn_twilio_direct_basic_auth] table to 
display them.

Set outbound 
calculated 
fields & auth

[sn_twilio_direct_twilio_config] Sets the account credentials in the basic auth 
profile

Set Reset 
JWT Key

[sn_twilio_direct_basic_auth] Copies the auth token from 
[sn_twilio_direct_basic_auth] to signing key 
password in [jwt_keystore_aliases].

Validate & 
set inbound 
calculated 
fields

[sn_twilio_direct_twilio_config] Populates the callback_endpoint field based 
on the inbound rest field value. Displays an 
error message if the endpoint URLs are not in 
the correct format.

Validate Fast 
Bulk SMS 
option

[sn_twilio_direct_twilio_config] When Twilio Notify bulk SMS  is enabled, 
validates the Twilio messaging and Notify 
service id.

Validate 
Intelligent 
SMS option

[sn_twilio_direct_twilio_config] When Intelligent SMS handling  is enabled, 
validates the Twilio messaging service id.
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Tables installed with Twilio Direct driver

The tables installed with Twilio Direct driver are described below.

Tables installed with Twilio Direct driver

Table Description

[sn_twilio_direct_callback_processor] Extends the application file. Contains scripts 
which process callback payloads from Twilio 
and generate appropriate response XML or 
TwiML document.

Note: 
Use caution when editing, deleting 
or adding new Callback Processor 
scripts as they are one of the key core 
components of the driver.

[sn_twilio_direct_twilio_config] Extends the application file. Contains 
configuration option values for the driver.

[sn_twilio_direct_basic_auth] Extends the basic auth credentials. The 
Account SID and Auth token are stored in this 
table.

[sn_twilio_direct_callback_test] Stores the history of callback test runs.

Numbers and number groups

Number groups allow you to group Notify  phone numbers and share workflows across grouped 
numbers.

Each phone number within Notify  has an associated number group. Numbers within a group use 
the same workflows for handling incoming and outgoing calls and SMS messages.

Numbers associated with a group appear on the Notify Phone Numbers  related list on the Notify 
Phone Number Group form.

If the number group workflows have incorrect conditions, a warning appears.

Create a number group

Group Notify  phone numbers and share workflows across grouped numbers.

Before you begin
Role required: notify_admin

About this task
Each phone number within Notify  has an associated number group. Numbers within a group use 
the same workflows for handling incoming and outgoing calls and SMS messages.

Numbers associated with a group appear on the Notify Phone Numbers  related list on the Notify 
Phone Number Group form.
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Procedure

1. Navigate to All  > Notify  > Number Groups.

2. Click New.

3. Enter a Name, and select Notify: (Re)join Conference Call  for the Incoming call workflow 
field.

Note: 
Ensure not to configure a workflow, which sends an outbound SMS itself, 
resulting in recursive calling of the workflow.

Field Description

Name Unique name for the number group.
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Field Description

Incoming call workflow Workflow to run when there is an incoming 
phone call for this group.

Incoming SMS workflow Workflow to run when there is an incoming 
SMS message for this group.

Outgoing call workflow Workflow to run when there is an outgoing 
phone call for this group.

Outgoing SMS workflow Workflow to run when there is an outgoing 
SMS message for this group.

Note: 
The Out of the Box workflow "Notify: 
Join Conference Call Via SMS" should 
not be populated for "Outgoing SMS 
workflow". Populating a workflow that 
sends an SMS under Outgoing SMS 
Workflow will trigger the same workflow 
thus causing recursive loop.

Incoming call workflows must run on the Notify Call [notify_call] table. Incoming and outgoing 
SMS workflows must run on the Notify Message [notify_message] or Global [global] tables.

Short codes can only be associated with SMS workflow groups. You cannot add an incoming or 
outgoing call to a short code group.

4. Click Submit.

What to do next
Associate a number to a number group

After creating a number group, associate numbers with that group to use the selected workflows.

Note: 
Each phone number can only be associated with one number group.

You can create multiple number groups and configure with different Twilio numbers. You 
can then the associate the number groups with the various workflows based on your 
requirement.

Associate a number to a number group

Associate a Notify number to a number group to use inbound and outbound workflows.

Before you begin
Role required: notify_admin
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Procedure

1. Navigate to All  > Notify  > Numbers.

2. Click the listed phone number and assign it to a Number Group, as appropriate.

Note: 
Each phone number can only be associated with one number group.

Field Description

Number Number for the entry.

Phone number E.164 phone number, if applicable.

Notify group (Optional) Group to which this number is 
assigned.

Number owner Service provider of the number.

Short Code Short code number, if applicable.

Active Check box that indicates whether the number 
is active or not.

3. Click Update.

Notify workflow activities

Notify  workflow activities manage calls and SMS messages in Notify.
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All Notify  workflows that manage a phone call must run on the notify_call table. Call-related Notify 
activities can be added only to workflows where the Table  field value is Notify Call [notify_call].

You can identify if an outbound call was answered by a human or by an answering machine 
from within a Notify  workflow by evaluating the current.is_human  variable, such as with 
an If  workflow activity. This variable is set by the telephony provider when an outbound call is 
answered. This variable is always true for inbound calls.

Note: 
Do not add a Timer  activity between multiple Notify  activities that interact with active phone 
calls.

Important: 
When creating a Notify  workflow, set the workflow If condition matches  field to -- None --. 
Notify  controls which workflow to run based on the configured number groups.

Related topics

Using variables in Notify workflow activities

Join conference call workflow  activity

The Join Conference Call  activity connects an incoming or outgoing call to a Notify  conference 
call.

Notify  includes the workflows Notify: (Re)join Conference Call and Notify: Join Conference Call 
Via SMS to demonstrate how to use the join conference call  activity to connect inbound and 
outbound calls, and inbound SMS messages to a conference call.

Input variables

Input variables determine the initial behavior of the activity.

Input variables

Variable Description

Record Select this check box to record the conference call.

Advanced Select this check box to display advanced configuration options.

Script Specify advanced configuration options using JavaScript, such as if the new 
participant should be muted upon joining the conference call. You can access 
values from the workflow scratchpad.

Conditions

The conditions determine which transition comes after this activity. The join conference call 
activity does not specify any conditions by default.

You can add an error condition to this activity. The activity transitions through the error condition 
if the confernece_call scratchpad variable is not set.

Scratchpad entries

The activity uses the workflow scratchpad to read persistent values.
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Values read from scratchpad

Scratchpad variable Description

workflow.scratchpad.conference_call A GlideRecord for a single conference call record. A call 
processed by this activity is added to this conference 
call. If this value is not specified, the join conference call 
activity will log an error.

When initiating an outgoing call workflow using the 
Notify API call(String notifyPhoneNumber, 
String toPhoneNumber, GlideRecord 
conferenceCall)  method, this scratchpad value 
is set automatically to the conference call GlideRecord. 
For incoming call workflows, or workflows initiated 
using a different mechanism, you must explicitly set this 
scratchpad value.

Enable different attributes available with Join Conference Call activity

System administrators can enable any or all of the below attributes and use them in the Join 
Conference Call workflow activity.

Attribute Description

hangupOnStar When hangupOnStar is enabled (set to true), 
participants in a conference call can press the 
* button to disconnect from the call. Control is 
returned to the workflow, which can be used to 
trigger customer-defined actions.

muted When muted is enabled (set to true), the 
participant will join the conference in a muted 
state.

beepOnEnter When beepOnEnter is enabled (set to true), a 
notification beep is played when a user joins 
the conference.

beepOnExit When beepOnExit is enabled (set to true), a 
notification beep is played when a user leaves 
the conference.

enableImmediateInput When enableImmediateInput is enabled 
(set to true), it allows input of a single 
digit immediately after the conference 
ends for this user and sets that in 
workflow.scratchpad.confDigits. This option 
will be ignored if hangupOnStar is false.

To enable any of the above attributes, perform the following steps:

1. Navigate to Workflow  > Administration  > Workflow Versions.

2. Open the Notify: (Re)join Conference Call workflow.

3. Click the Show Workflow  related link.

4. To modify the workflow, click the WorkFlow Actions icon and click Checkout.
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5. Open the Join Conference Call workflow activity.

6. Enable the Advanced  check box to display the Script  field.

7. Set the hangupOnStar  attribute to true in the config  variable in the script. The default 
setting is false.

8. Click Update.

9. Click the WorkFlow Actions icon and click Publish  to save the changes.

Similarly, you can enable the other attributes.

Call workflow  activity

The Call  activity makes outbound phone calls using a Notify workflow. This workflow activity can 
be added to any table.

Input variables

Input variables determine the initial behavior of the activity.

Input variables

Variable Description

Notify 
Number

The Notify phone number to make the call from. When you initiate a call, the 
outgoing call workflow for the number group associated with this number runs.

Phone 
number 
to call

The E.164-compliant phone number to call.

Advanced Select this check box to use a script to determine number to call, and the Notify 
number to call from instead of using the Phone number to call  and Notify Number 
variables.

Script Define a script that controls which number to call. This script should return a string 
listing the Notify number sys_id, as well as the phone number to call, such as 
{notify_number: 'sys_id', phone_number: '+316...'}

Conditions

The conditions determine which transition comes after this activity. The call  activity does not 
specify any conditions by default.

You can add an error condition to this activity. The activity transitions through the error condition 
if the call could not be set up due to invalid data returned by the advanced script.

Send SMS workflow  activity

The send SMS  workflow  activity to send short text messages using Notify to users' phones. This 
workflow activity can be added to any table.

Notify  requirements

To send SMS messages, you must add and configure a provider in Notify. For more information 
about configuring a provider, see Configure a provider in Notify.
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Input variables

Input variables determine the initial behavior of the activity.

Input variables

Variable Description

From Select the Notify phone number to use to send the SMS message.

Advanced Select this check box to use JavaScript to determine which numbers to send the 
message to, and the Notify number to use to send the message.

To Select any number of users to send the message to. The user record must have 
a E.164-compliant phone number or notification device configured for SMS 
messages.

To 
(groups)

Select any number of groups to send the message to. All members of that group 
with an E.164-compliant phone number or SMS notification device receive the 
message.

Message Enter the message to send. You can add field values from the current record 
by using the Select variables  box. You can also add values from the workflow 
scratchpad. If a field and a scratchpad variable have the same name, the field value 
is used.

Because you can use variables in this message, it is not possible to determine 
the length of the message at design time. If the activity sends a message that is 
longer than supported by the telephony provider, the message is truncated and the 
instance logs a warning.

To (script) Enter a script to determine which numbers to send the message to, and the Notify 
number to use to send the message.

The script should return a JavaScript object with the format {notify_number: 
\'...sys_id...\', users: [...], groups: [...], numbers: 
[...]}. Specify the users or groups to send the message to as an array of sys_id 
values. Specify other numbers as an array of E.164-compliant phone numbers.

This field appears only if Advanced  is selected.

Conditions

The conditions determine which transition comes after this activity. This activity does not specify 
any conditions by default.

You can add an error condition to this activity. The activity transitions through the error condition 
if the Notify number used to make the call is not configured correctly or unable to send SMS 
messages, or if an error occurs while sending the SMS.

Forward call workflow  activity

The Forward Call  activity forwards a Notify call to an E.164-compliant phone number.

If the person receiving a forwarded call hangs up, the forward call  activity completes and 
transitions to the next activity. Any further Notify activities in the workflow run for the caller only.

Input variables

Input variables determine the initial behavior of the activity.
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Input variables

Variable Description

Phone number to 
call

Enter the phone number to forward the call to.

Timeout (in 
seconds)

Enter the amount of time to wait for the call to be answered before 
hanging up.

Record Select this check box to record the conversation.

Conditions

The conditions determine which transition comes after this activity.The forward call  activity does 
not specify any conditions by default.

You can add an error condition to this activity. The activity transitions through the error condition 
if the phone number to call is invalid.

Input workflow  activity

The Input  activity creates a phone menu by presenting a list of options on a Notify call.

Input Variables

Input variables determine the initial behavior of the activity.

Input Variables

Variable Description

Number 
of digits

Specify the maximum number of digits the caller can enter. A caller can enter fewer 
digits than the maximum and press the Finish key  to complete the entry.

Finish key Specify the key a caller can press on their phone when finished selecting a menu 
option.

Timeout 
(in 
seconds)

Specify the amount of time to wait before closing the menu automatically when the 
caller does not select a menu option.

Advanced Select this check box to use a script to build the phone menu, instead of using the 
activity conditions.

Script Define the script to build the phone menu. The script must specify an answer 
variable as a JavaScript object with the following format:

 answer = {
  “1": {
      “play”: “https://some_url.com/options/one.mp3“,
      “myCustomData”: “some data here”
  },
  “2”: {
      “play”: “https://some_url.com/options/two.mp3”,
      “myCustomData”: “some other data here”
  },
“3”: {
      “speak”: “type 3 to speak to a representative”,
      “language”: “en-US”,
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Input Variables  (continued)

Variable Description

      “myCustomData”: “some more data here”
  }
};

The script may specify either a text-to-speech string and language code using the 
speak  attribute or URL of the music to be played using the play  attribute. You can 
also add optional attributes to store related information, such as myCustomData 
in the example above.

Note: 
The script object continues to support say  attribute for backward 
compatibility.

Conditions

The conditions determine the transition that comes after this activity.

The input  activity does not specify any conditions by default. You must define conditions to build 
the phone menu. Each condition is one option on the phone menu. Notify reads the text from 
each condition Name  to the caller, up to 100 characters per condition.

You can specify a language for each condition by prefixing the message with the language 
code, in the format xx-XX:<Message>. For example, add fr-CA:  for Canadian French. Available 
languages are stored on the Notify Language [notify_language] table.

The condition that the activity transitions through depends on the digits entered by the caller. Set 
the condition Condition  value to parseInt(workflow.scratchpad.digits) == <expected digits>. 
For example, to transition through a condition when the caller presses the number 3, set the 
Condition  to parseInt(workflow.scratchpad.digits) == 3.

You can add an error condition to this activity. The activity transitions through the error condition 
if the advanced script returns an invalid value, or if the text to say for a condition is empty.

Scratchpad Entries

The activity uses the workflow scratchpad to write persistent values.

Values written to scratchpad

Entry Description

workflow.scratchpad.digits The digits entered by the caller, as a string.

workflow.scratchpad.menu<activity 
name>

The entire answer  variable, if using the advanced script 
option. You can access this menu from other activities 
after this activity successfully executes.

For example, if the activity name is choices, you can 
access values from the menu using

var previousActivity = "choices";
var choicesMenu = 
 workflow.scratchpad.menu[previousActi
vity];
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Values written to scratchpad  (continued)

Entry Description

var menuItem = 
 choicesMenu[workflow.scratchpad.digit
s];  // Selects the menu item based on 
 the caller's input.
var selectedValue = 
 menuItem.myCustomData; //get the 
 custom data for the selected menu 
 item. 

Hangup workflow activity

The Hangup  activity disconnects an active Notify phone call.

You can use the hangup  activity to disconnect only calls that have been answered. Use the 
reject  activity to disconnect calls that have not been answered.

Play workflow  activity

The Play  activity plays a sound file on a Notify call.

Input Variables

Input variables determine the initial behavior of the activity.

Input Variables

Variable Description

URL Enter the URL of a sound file to play. If the URL is inaccessible, or if the audio file mime 
type is not supported by the telephony provider, the play  activity is skipped.

Loop Enter the number of times the sound file should play.

Conditions

The conditions determine which transition comes after this activity. The play  activity does not 
specify any conditions by default.

You can create an error condition to handle errors with the sound file. The activity transitions 
through the error condition if the specified sound file is not available, or has an unsupported 
mime type. Supported mime types are listed on the Notify Audio MIME Types [notify_mime_type] 
table.

Record workflow  activity

The Record  workflow activity records audio from a user on a Notify call.

Note: 
The Record workflow activity records Notify  call but not the Notify conference call. To record 
the Notify  conference call, you can set the Record  activity variable on the Join Conference 
Call  workflow activity.

Input Variables

Input variables determine the initial behavior of the activity.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4489



Input Variables

Variable Description

Max duration (in 
seconds)

Enter the maximum duration, in seconds, allowed for a recording.

Timeout (in 
seconds)

Enter the amount of time to wait before ending a recording automatically 
when the caller is silent.

Finish Key Specify the key a caller can press on their phone to end the recording.

Scratchpad Entries

The activity uses the workflow scratchpad to store persistent values.

The record  activity adds the recording  variable to the workflow scratchpad. This variable 
stores metadata about the recording, such as URl, ID, and duration. You can access the following 
values from this variable.

Values written to scratchpad

Value Description

recording.recordingDuration The duration of the recording, in seconds.

recording.from_number The caller's phone number, including country code.

recording.notify_number The Notify phone number used to respond to the call, including 
country code.

recording.recordingID The ID used by the telephony provider to identify the recording.

recording.recordingURL The URL from the telephony provider to access the recording.

Reject workflow

The Reject  workflow activity rejects an incoming Notify call.

You can use the reject  activity to disconnect only calls that have not yet been answered. Use the 
hang up  activity to disconnect calls that have been answered.

Input variables

Input variables determine the initial behavior of the activity.

Input variables

Variable Description

reason Select a reason for rejecting the call, such as busy.

Say workflow  activity

The say  workflow activity allows you to play a message, using text to speech, on a Notify call.

Input variables

Input variables determine the initial behavior of the activity.
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Input variables

Variable Description

Text to 
say

Specify the text to read.

Language Select the language and locale to use when reading text.

Advanced Select this check box to use a script to define the language and message, instead 
of using the Text to say  and Language  values.

Script Define a script to set what text is read on the call. The script must return a string 
that defines the language and the text to read. For example, to play an English-
language message, return {language: 'en-US', text: 'Text to read'}.

Forward to notify client workflow  activity

The forward to notify client  workflow  activity connects a phone call to a Notify WebRTC client.

Input variables

Input variables determine the initial behavior of the activity.

Input variables

Variable Description

User Select the user to connect the call to.

Advanced Select this check box to use a script to determine which client to connect to, 
instead of using the User  variable.

Script Define a script that controls which client to connect to. This script should return a 
GlideRecord for a single User [sys_user] record.

Timeout (in 
seconds)

Enter the amount of time to wait for the call to be connected before hanging up.

Record Select this check box to record the call.

Conditions

The conditions determine which transition comes after this activity. The Forward to Notify Client 
activity does not specify any conditions by default.

You can add an error condition to this activity. The activity transitions through the error condition 
if there is an issue with the Notify client.

Queue workflow  activity

The Queue  activity places an active Notify call in a queue.

Add the Queue  activity to a workflow on the Notify Call [notify_call] table to put the current call on 
hold. This activity does not specify any input variables.

The queue that the call is added to is given a random ID.

Notify activity event handlers

Notify workflow activities provide JavaScript functions that are invoked automatically when your 
telephony provider broadcasts certain events.
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When the telephony provider broadcasts an event related to a Notify call, such as the caller 
hanging up, the event is processed by the workflow associated with that Notify call. All currently-
executing Notify activities in that workflow invoke a JavaScript function associated with that 
event.

Not all activities that support an event provide a default event handler implementation. You can 
provide an implementation for those event handlers when creating custom Notify activities.

Related topics

Creating Notify activities

Available Notify activity event handlers

Creating Notify activities

Default Notify workflow generally performs a single action, such as initiating a phone call. You 
can create custom Notify workflow activities to implement more complex functionality.

Use event handler functions in each Notify activity definition to design your own activity behavior. 
For example, you can set the activity result if the caller hangs up by using the onCompleted 
function.

onCompleted: function() {
activity.result = 'call_ended';
},

When creating a new Notify workflow activity, follow these design principles.

• Within onExecute  event handler function, create a new NotifyAction object. Use this object 
to create a simple or complex action, then serialize the object to the notify_wf_activity table.

• Within the onUpdate  event handler function, deserialize the NotifyAction object from the 
notify_wf_activity table and use this object to perform any other operations.

• Use the other event handler functions and the Notify as needed to implement the desired 
activity behavior.

Related topics

NotifyAction - Global  

Notify languages

Notify  supports multiple languages when using text-to-speech.

For example, when using the input  or say  workflow activities, you can specify which language to 
use when reading the text.

The list of available languages is stored on the Notify  Languages [notify_language] table. By 
default, languages supported by all Notify  telephony providers are available. You can add 
additional languages if they are supported by your specific telephony provider.

Available Notify activity event handlers

When creating Notify workflow activities, you can use event-handler functions to respond to 
events from a telephony provider.

Not all activities or telephony providers support all events. For example, the Reject  activity ends 
the call before the caller connects so the onNoAnswer  function is never invoked from this 
activity.
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Note: 
When configuring an activity to respond to an event, ensure that your telephony provider 
supports that event.

The following table describes available event handlers and lists the Notify workflow activities that 
can invoke each handler.

Event handlers

Handler Description Activities

onExecute Runs when the activity first runs. All call-related activities

onUpdate Runs when the call record associated 
with the workflow is updated.

All call-related activities

onCompleted Runs when a call ends. All call-related activities

onRinging Runs when a call starts ringing. Forward call, call, join conference 
call, forward to notify client

onInProgress Runs when both parties are connected 
on a call.

Forward call, call, join conference 
call, forward to notify client

onNoAnswer Runs when a call is not answered. Forward call, call, join conference 
call, forward to notify client

onBusy Runs when a called number is busy. Forward call, call, join conference 
call, forward to notify client

onFailed Runs when an error occurs. All call-related activities

Components installed with Notify

Several types of components are installed with the Notify  application.

Roles installed with Notify

Notify  adds the following roles.

To learn more about managing subscriptions, see Managing per-user subscriptions in 
Subscription Management  and contact your account representative.

Notify administrator [notify_admin]

Administrator with privileges for Notify 2 functionality.

Contains Roles

List of roles contained within the role.

• workflow_admin

• workflow_creator

• workflow_publisher

Groups

List of groups this role is assigned to by default.

None.
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Special considerations

Important: 
Avoid granting an admin role when more specialized roles are available.

Notify viewer [notify_view]

Assign to users who need to view notify content.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations
This role has read-only access to the Notify Conference Calls table [notify_conference_call] and 
the Notify Conference Call Participants table [notify_participant].

The itil role inherits the notify_view role when the Incident Communications Management  and 
the Notify plugins are activated.

Tables installed with Notify

Notify  adds the following tables.

Tables

Table Description

Notify Conference Calls

[notify_conference_call]
A list of conference calls started using Notify

Notify Calls

[notify_call]
A list of calls started using Notify

Notify Call Queue

[notify_queue]

A list of calls that are in queue

Notify Call Status

[notify_call_status]

List of possible statuses of calls, such as; 
initiated, ringing, etc.

Notify Client Connected Sessions

[notify_client_session]

List of the connected sessions

Notify Conference Call Participants

[notify_participant]

List of the participants in a conference call
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Tables  (continued)

Table Description

Notify Conference Call Participant Sessions

[notify_participant_session]

List of the associations of a call record and 
Notify participant record

Notify Messages

[notify_message]
List of messages sent from/to Notify

Notify Phone Numbers

[notify_number]
List of phone numbers used by Notify  to make 
calls and send messages

Notify Phone Number Groups

[notify_group]

List of phone number groups used by Notify to 
make calls and send messages

Notify Languages

[notify_language]

List of the languages that Notify supports 
when using text-to-speech workflow activities.

Notify Recordings

[notify_recording]

List of conference call recordings

Notify Workflow Activity

[notify_wf_activity]
List of Notify  workflow activities

Notify Audio MIME Types

[notify_mime_type]

List of audio file formats

Temporary Serialized Notify Action Cache

[notify_action]
List of serialized Notify  actions waiting to be 
processed

Notify SMS Template

[notify_sms_template]

Contains the templates which are used while 
sending a Notify SMS.
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Notify call sequence

Properties installed with Notify

Notify  adds the following properties.

Properties for Notify

Property Description

sn_twilio_driver.max_conference_participants Twilio maximum limit for number of 
participants in the conference call.

com.snc.iam.notify_number The Notify number to use for conference 
calls.

Note: 
This number must have a group 
configured with conference call 
workflows.

glide.notify.sms.max_characters Maximum number of characters allowed to 
send SMS messages.

glide.enable.notify_on_task Use this property to enable Notify 
integration for Task table and its 
extensions. Entering phone number in 
'glide.notify.task.phone_number' property is 
equivalent to setting this to true.

glide.notify.endpoint If the instance is accessible on public 
internet using some other name, which can 
happen if the instance is within a private 
network and is accessible via a reverse 
proxy from outside. In that case the public 
name needs to be provided here. e.g. https://
some_public_domain.com

glide.notify.sms.save_confirmation_in_db Check Yesif you want track the confirmation 
of opt-in/out requests SMS. The 
confirmations are saved in notify_message 
table.
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Properties for Notify  (continued)

Property Description

com.snc.iam.enable_notify Use this property to enable Notify 
integration for Incident Communications 
Management. Entering phone number in 
'com.snc.iam.notify_number' property is 
equivalent to setting this to true.

com.snc.iam.notify_number The Notify number to use for conference 
calls. Note that this number needs to have 
a group configured with conference call 
workflows.

com.snc.on_call_rotation.notify_webrtc_number Specify a valid Notify number with voice 
capability. This will enable On-Call integration 
with Notify which allows On-Call users to 
directly call people on rosters from the 
browser.

sn_major_inc_mgmt.notify_webrtc_number Specify a valid Notify Number with voice 
capability. This will enable a specific Major 
Incident Management integration with Notify 
which allows Workbench users to directly call 
people from the browser.

Business rules installed with Notify

Notify  adds the following business rules.

Business 
rule

Table Description

No Call 
Workflows 
for 
Shortcodes

[notify_group] Checks and displays an error if the call is being 
triggered by a short code.

Update 
Participant 
Duration

[notify_participant] Updates participant duration when it becomes 
inactive.

Check if 
Notify call 
exists and 
active

[notify_participant_session] Checks if Notify call has valid reference record 
and updates it if the call is inactive currently.

Update Last 
Active On

[notify_participant] Sets the last active before insertion/update of 
Notify participant.

Show info 
msg about 
selection in 
choice

[notify_group_selector_choice] Displays a message if either Notify group or 
conference provider is not selected.

Validate 
values in 
the choice

[notify_group_selector_choice] Checks if either of Notify group or conference 
provider is filled.
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Business 
rule

Table Description

Set 
scratchpad 
values

[notify_group_selector_choice] Checks if conference provider is available by 
iterating through service provider list.

Show 
message 
for empty 
choices

[notify_group_selector] Displays an info message if there are no choices 
for the provider selector.

Clear fields 
when 
Manual 
Selection is 
set

[notify_group_selector] Clears out some fields when manual selection is 
set in Notify group selector table.

Update 
Participant 
Duration

[notify_participant_session] Calculates the duration of participant on 
conference call.

Update 
session 
muted state

[notify_participant] Sets the value of mute and expelled to true 
once the conference call participant becomes 
inactive.

Update 
conference 
call

[notify_participant] Sets the state of conference call based on the 
participant leaving or joining the call.

Validate 
Order field 
value

[notify_group_selector] Validates order field value to be unique amongst 
all provider selectors.

Restrict 
Workflows 
For only 
Voice Nums

[notify_number] Restricts association of voice only capable 
number with number group having inbound/
outbound SMS workflows.

Restrict 
Workflows 
For only 
SMS 
Numbers

[notify_number] Restricts association of SMS only capable 
number with number group having inbound/
outbound voice workflows.

Validations 
on default 
record

[notify_group_selector] Validates that source table and order field are 
mandatory in case of default set to false and 
both fields empty in case of default set to true.

Clearing 
fields when 
Default is 
true

[notify_group_selector] Clears out some fields when default is set to true.

No Default 
selector set

[notify_group_selector] Ensures one active provider selector is set as 
default.

Check 
active 
default 
selector is 
unique

[notify_group_selector] Ensures only one provider selector is set as 
default.
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Business 
rule

Table Description

Process 
SMS 
preferences 
for 
incoming 
SMS

[notify_message] When an SMS preference configuration defined 
for a particular telephony provider, then apply it 
for every incoming SMS.

Check 
default 
notify group 
is unique

[notify_group] Validates that not more than one group is set as 
default Notify group.

Trigger 
conference 
end

[notify_conference_call] When a conference call ends, triggers the 
notify.conference.end event

Update Call 
Active State

[notify_call_status] Updates the status of the call in notify_call_status 
with the status received from Twilio.

Update 
Conference 
Call Active 
State

[notify_participant Updates the active flag in notify_participant 
table. Also calculates the duration when the call 
is ended by a participant.

Update 
Participant 
Active State

[notify_participant_session] Updates the active flag for the participant 
(notify_participant), and calculates the total time 
on the call upon disconnecting from the call.

Update 
Participant 
Session 
Active State

[notify_call] Synchronizes the state of the call between 
notify_call and notify_participant_session. 
Upon disconnecting from the call, updates 
notify_participant_session with the duration of 
the call.

Warn for 
incorrectly 
configured 
workflow

[notify_group] Checks notify_group table and displays an error 
if the a workflow is not configured correctly

Manage people and work capabilities
Use these applications to help streamline communications, manage work assignments and 
interactions, and assess employee skills.
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Advanced Work 
Assignment

Handle team assignments, 
route workflow, and 

provide user assistance.

Skills Management

Assess skills in 
individuals and teams.

Omnichannel Callback

Connect users and 
agents with callback 

service options.

E-signature

Manage signatures for 
documents or knowledge 

articles on any device.

Interaction Management

Centralize all 
communications on the 

platform for improved 
service call handling.

Password Reset

Provide secured password 
reset, user verification 

options, and more.

ServiceNow  Voice

Manage third-party call 
systems and improve the 
service call experience 

for users and agents.

Advanced Work Assignment  (AWA)

Maintain and improve your business workflow on the ServiceNow AI Platform. Advanced Work 
Assignment  has options to assign tasks to teams and individual personnel based on availability 
and demand, as well as their skill levels. Give users the best service possible, with service 
messaging and role management handled on-the-fly for each task or assignment.

Skills Management

Track the skills that your teams use and need the most, associate skills with groups or 
individuals, and improve your training and hiring all with this module. Skills Management 
helps you manage data on various defined proficiencies or sets thereof. Create efficient skill 
assessments and associate them with teams or single personnel for improved task assignment, 
find and address knowledge gaps in your organization, and tailor your hiring and training plans.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4500



Omnichannel Callback

Expand your service contact opportunities with Omnichannel Callback. This module lets agents 
contact users back when they make calls for help or service requests during high-activity 
periods. Display or announce callback options in other apps on the ServiceNow AI Platform, 
configure callback options to route users to live or virtual agents, and more.

E-signature

Handle electronic signatures and acknowledgments with E-signature. Use desktop or mobile 
interfaces to sign documents and knowledge base articles. Tailor roles related to handling 
signing, and give users the option to provide typed or drawn signatures, credentials, or 
acknowledgments.

Interaction Management

Handle all your service interactions in one place with this highly flexible, extensible system. 
Calls, chats, and other contacts are routed and queued through a centralized location with the 
Interaction Management  System (IMS), enabling every product to use the same framework for 
communication.

ServiceNow  Voice

Keep your service call system working efficiently with Voice. This module integrates easily with 
third-party phone systems, and reduces navigation through multiple networks for more efficient 
call center interactions. Added metrics and analytics let managers review call data all in one 
place.

Advanced Work Assignment
Advanced Work Assignment  (AWA) automatically assigns work items to your agents, based on 
their availability, capacity, and optionally, skills. AWA  pushes work to qualified agents using work 
item queues, routing conditions, and assignment criteria that you define.

Get started

Explore

Learn about Advanced 
Work Assignment (AWA) 
concepts and features.

Configure

Install Advanced Work 
Assignment (AWA) 

and activate relevant 
plugins. Set up AWA to 

automatically assign work 
items to qualified agents 
using defined work item 

queues, routing conditions, 
and assignment criteria.

Use

Use Advanced Work 
Assignment (AWA) 

to compose SMS 
conversations, check work 

items and AWA events, 
and enable logging.
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Analytics & 
Reporting Solutions

Work with dashboards, 
like Platform Analytics 

Solutions, to 
analyze information.

Reference

Get Advanced Work 
Assignment (AWA) 
details for domain 

separation, components, 
and properties.

Exploring Advanced Work Assignment

Use Advanced Work Assignment  (AWA) to automatically assign work items to your agents, based 
on their availability, capacity, and optionally, skills. AWA  pushes work to qualified agents using 
work item queues, routing conditions, and assignment criteria that you define. Agents see their 
assignments in their Agent Workspace  inbox.

Overview of how AWA  works

Customers use different channels to request service, for example, chats, cases, or incidents. 
Requests from customers create task or interaction records that store information about these 
objects, called work items. AWA  automatically routes work items to queues that focus on certain 
types of support using criteria (such as priority or customer status) that you provide.

Queues can be defined based on need or type, for example product or critical cases. You also 
identify the agent groups responsible for work in the queue. AWA  then applies assignment rules 
that you set and uses agent availability, capacity, skills (if defined), and shifts (if defined) to 
assign work to the most qualified agent.

Workflow

See the following diagram to learn more about the Advanced Work Assignment  process flow.
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Navigate to Advanced Work Assignment  > Home  to start exploring AWA  features.

Benefits

Advanced Work Assignment  provides the following benefits.

Benefit Feature User

By automating the assignment 
of work tasks, AWA eliminates 
manual efforts involved 
in distributing workloads. 
Work items are conveniently 
pushed to the agent’s inbox, 
so that the agent can focus 
on doing the work, rather than 
looking for work.

Work assignments awa_admin or admin

AWA helps organizations 
make the best use of available 
resources by matching the 
right skills and expertise with 
specific tasks. This leads to 
reduced idle time and better 
allocation of talent across the 
organization.

Configure agent assignment 
rules

awa_admin or admin

AWA ensures a fair and 
balanced distribution of work 
tasks among resources. It 
takes into consideration 
factors like workload, 
capacity, and availability 
to avoid overloading 
certain individuals while 
underutilizing others.

Agent Inbox controls awa_admin or admin

Advanced Work Assignment  components

Service channels

A means of providing customer service. AWA  offers base system channels for chats, 
cases, incidents, and walk-up centers. For each channel, you can set attributes 
such as agent capacity and utilization conditions to control the work handled in the 
channel.

Work items

A single piece of work handled by an agent from start to completion. For example, 
one chat or one case is an object that is routed and assigned to agents.

Work item queues

A queue stores a specific type of work item for a service channel. AWA  admins can 
create queues that focus on certain types of support within the channel, such as 
VIP customers or critical cases. AWA  routes work items to queues based on specific 
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conditions or requirements that you define, such as customer status, or region. 
Groups assigned to each queue handle the incoming work items. After work items 
are placed in a queue, AWA  can then assign items to available agents based on 
assignment rules and agent availability and capacity.

Assignment groups

Agents belong to specific groups organized by the type of work assigned to them. 
You provide details about an assignment group including the name and description, 
manager, and group email. You can also set up roles, groups and group members, 
queues, and agent capacity overrides for agents in an assignment group.

Assignment rule

Criteria that determines how work items are pushed to the appropriate agent within 
a qualified assignment group.

Agent capacity

The maximum number of work items on a particular service channel that an agent 
may actively work on at one time. If you want to set a maximum capacity for an agent 
across all service channels, define the maximum universal capacity for that agent. 
For information on configuring the maximum universal capacity, see Configure an 
agent's maximum universal capacity. Messaging Interactions in an On Hold state 
aren’t calculated as part of an agent's capacity.

Agent availability

States that indicate agent presence and whether the agent is available for work or is 
busy or offline. AWA  uses the agent availability state to determine if an agent is able 
to receive work.

Inbox layout

A configuration tied to a service channel that defines which fields of a record 
representing a work item are shown in agent inboxes. A layout defines what the 
agent sees in Agent Workspace.

Reassigning messaging conversations

If you want messaging conversations to be automatically reassigned if the current Assigned To 
agent on the conversation isn’t available, set the glide.messaging.reassign.enabled 
system property to true. The system property only affects messaging conversations and the 
Assigned To agent is considered not available if the AWA  Inbox status isn’t set to "Available."

Configuring Advanced Work Assignment

Quickly install the required and popular plugins through the plugin page after selecting any Get 
[plugin]  button on the Advanced Work Assignment  home page. Plan and configure Advanced 
Work Assignment  (AWA).

Before you begin
The AWA  home page appears after you have installed and updated the Omni-Experience 
Standard Feature Set to the latest version through the ServiceNow Store .

Role required: admin

About this task
After installing the Advanced Work Assignment  plugin and any relevant org-specific plugins, the 
following list outlines the basic planning and configuration steps that you must determine for 
AWA:

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4504

https://store.servicenow.com/sn_appstore_store.do#!/store/home
https://store.servicenow.com/sn_appstore_store.do#!/store/home
https://store.servicenow.com/sn_appstore_store.do#!/store/home


• Determine what to route – Configure the base service channels to be used.

• Determine where to route – Define the work item queues and the routing rules, execution order, 
work item sort order, and strategy.

• Determine how to assign work items – Define the assignment rules that determine the work 
items pushed to agents.

• Determine what the agent sees – Set the inbox card layouts and presence (availability) states 
that agents use in their Agent Workspace  inbox.

Procedure

1. Navigate to Advanced Work Assignment  > Home, and then select the Get Advanced Work 
Assignment plugin  button from the First, install a required plugin section.

Note: 
Only users with the sys_admin role can install a plugin from the Advanced Work 
Assignment  home page. For example, if a user with the awa_admin role tried to install the 
Advanced Work Assignment  plugin, they're prompted to contact their administrator for 
installation. After the Advanced Work Assignment  plugin is installed, all AWA  home page 
options are available in the application navigator for users with the admin and awa_admin 
roles.

The All Applications page opens in a new window or tab.

2. In the All Applications page, select Install  and complete the installation prompts.
The AWA  home page experience refreshes and the Get targeted routing capabilities section 
appears.

3. Optional:  Install org-specific AWA  plugins through the Get plugin  button for ServiceNow® 

IT Service Management  (ITSM), ServiceNow®  Customer Service Management, and/or 
ServiceNow®  HR Service Delivery  (HRSD) plugins.
The AWA  home page experience refreshes and the Get the most popular plugins section 
appears.

4. Optional:  Install popular plugins, such as Agent Chat, Walk-up Experience, and/or 
Performance Analytics, to boost your AWA  experience.

5. In the Essential settings section, select Set up service channels  to configure the service 
channels  that you activated.

a. Create or change an inbox layout.

b. Override agent capacity, as needed.

6. In the Essential settings section, select Set up queues  to create work item queues  for your 
service channels.

a. Set the sort order for work items  in the queue.

7. In the Essential settings section, select Set up assignment rules  to configure the work 
assignment rules  used to push work to the appropriate agents.

8. Optional:  In the Additional settings section, consider configuring the following parameters to 
improve your AWA  functionality.

a. Select Set up presence states  to configure availability states  states that agents use to 
indicate whether they can receive work or are offline or away.

b. Select Set up reject reasons  to define the reject reasons  that agents can use to decline work 
assignments that they receive in their Agent Workspace inbox.
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c. Select Set up universal capacity  to configure your team's maximum universal capacity  to 
prevent an agent from being assigned too many work items.

d. Select Set up groups  to create groups of user sets  who share a common purpose.

9. Optional:  In the Advanced settings section, consider configuring the following parameters to 
improve your AWA  functionality.

Note: 
Advanced settings cards appear conditionally after installing their respective plugin.

a. Select Set up Agent Affinity  to create or change the Agent Affinity  rules  that route work 
items in Advanced Work Assignment.

b. Select Set up Shift-based Assignment  to assign work items to agents based on shifts.

Advanced Work Assignment  home page

Explore, implement, and maintain ServiceNow®  Advanced Work Assignment  using a home-page 
experience. Discover AWA, install relevant plugins, and configure settings for AWA  through the 
Advanced Work Assignment  home page available to admins.

Advanced Work Assignment  home page advantages

The Advanced Work Assignment  home page makes it easy for you to get started and work 
toward achieving positive outcomes with your implementation. The Advanced Work Assignment 
home is ideal for first-time users who have never installed or configured Advanced Work 
Assignment  (AWA), to experienced users looking to expand capabilities and maintain existing 
implementations.

AWA  home provides the following features:

• Cards that guide you through the order of essential settings, like creating service channels, 
configuring queues, and adding assignment rules. Cards that redirect you to additional 
and advanced settings, such as configuring presence states, setting up reject reasons, 
determining universal capacity, setting up agent affinity, and establishing shift-based 
assignments.

• Lists of installed and available plugins.

• Quickly install plugins through the plugin page. The plugin page appears in either a new 
window or tab after selecting any Get [plugin]  button. The plugin page opened dialog box 
appears on the home page, where you can select Not Now  to continue with your current home 
page experience or Done  to refresh the home page after your plugin's installation.

• Access to helpful resources and videos to help you learn more about configuring and 
managing AWA.

Navigate to Advanced Work Assignment  > Home  to start exploring AWA  features.

Important: 
The AWA  home page appears after you have installed and updated the Omni-Experience 
Standard Feature Set to the latest version through the ServiceNow Store. Existing 
customers don't need to install it from the store. However, subsequent updates are 
available there. Visit the ServiceNow Store  website to view all the available apps and 
for information about submitting requests to the store. For cumulative release notes 
information for all released apps, see the ServiceNow Store  version history release notes .
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Planning, installing, and exploring AWA

If you've never installed AWA, the Advanced Work Assignment  home page prompts you to do 
so first. Before implementing AWA, take some time to reflect on a few important questions in the 
Think through these questions with your team Think through these questions with your team list. 
These questions are meant to help you envision the AWA  experience that you need and want for 
your business. Expand the available questions to explore more thoughtful considerations, such 
as what queues would work best for your team and what skills does your team have.

The layout of the home page may vary, depending on which features you've installed and 
configured.

First, install the required plugin

Install the Advanced Work Assignment  plugin to begin. Select Get Advanced Work 
Assignment plugin  to install it.

Note: 
Only users with the sys_admin role can install a plugin from the Advanced 
Work Assignment  home page. For example, if a user with the awa_admin 
role tried to install the Advanced Work Assignment  plugin, they're prompted 
to contact their administrator for installation. After the Advanced Work 
Assignment  plugin is installed, all AWA  home page options are available in the 
application navigator for users with the admin and awa_admin roles.

Get targeted routing capabilities

Activate org-specific AWA  plugins through the Get plugin  button to route work items 
to the right agents for ServiceNow®  IT Service Management  (ITSM), ServiceNow® 

Customer Service Management, and ServiceNow®  HR Service Delivery  (HRSD) 
plugins. These plugins enable org-specific service channels in AWA  including 
configured data and demo data.
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Get the most popular plugins

After installing any of the targeted routing capabilities plugins, install these popular 
plugins to boost your AWA  experience.

• Agent Chat: The Agent Chat  plugin enables the Chat service channel in AWA  and 
chat monitoring in Agent Workspace.

• Walk-up Experience: The Walk-up Experience  plugin activates the walk-up contact 
service channel for pre-built technology lounges.

• Performance Analytics: The Performance Analytics  plugin activates the 
Performance Analytics  Content Pack for AWA.

Watch and learn

Watch the embedded AWA  implementation guide for more information about 
installing and implementing AWA  directly from the right side of the home page.
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Helpful Resources

Explore the helpful AWA  resources such as release notes, product documentation, 
and ServiceNow Community  forums and content directly from the right side of the 
home page. These resources give you information to understand the configuration 
process and the benefits of setting up AWA  features.

Installed Plugins

View a list of installed plugins. Admin role users can select a plugin's link to have 
that application's plugins page appear in a separate window or tab.

Available Plugins

View a list of available plugins that help save time setting up AWA. Admin role users 
can select a plugin's link to have that application's plugins page or ServiceNow 
Store  site appear in a separate window or tab. Awa_admin role users can view a 
store app's plugin page to learn about the plugin, but only admin role users can 
install plugins.

Configuring essential AWA  settings

Follow the order of the guided configuration setup to establish your AWA  settings in the most 
logical order.

Essential settings cards

Card Feature Description

Create 
Service 
Channels

Give customer support by 
automatically routing incoming 
work to agents through service 
channels. Service channels 
assign a specific type and scope 
of work to agents.
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Essential settings cards  (continued)

Card Feature Description

Configure 
work item 
queues

Determine routing conditions and 
destinations for queues.

Add 
assignment 
rules

Establish assignment criteria to 
agents who either have gone the 
longest without being assigned 
a work item, have the most work 
availability, or have the needed 
skills.

Configuring additional and advanced AWA  settings

The additional card settings expand your organization's ability to maximize productivity with 
AWA.
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Additional settings cards

Card Feature Description

Customize 
presence 
states

Configure availability states that 
agents use to indicate whether 
they can receive work or are 
offline or away.

Configure 
reasons for 
rejections

Define the reasons that agents 
can use to decline work 
assignments that they receive in 
their Agent Workspace  inbox.
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Additional settings cards  (continued)

Card Feature Description

Determine 
agent 
capacity

Configure your team's maximum 
universal capacity to prevent an 
agent from being assigned too 
many work items. If the agent's 
maximum universal capacity 
has been reached, additional 
work items aren't assigned to the 
agent.

Select See More  to view this card.
Define 
assignment 
groups

Create groups of user sets who 
share a common purpose.

Advanced settings cards appear conditionally after installing their respective plugin.
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Advanced settings cards

Card Feature Description

Set up 
Agent 
Affinity

Install the Agent Affinity  plugin for 
this card to conditionally appear. 
Create or change the Agent 
Affinity  rules that route work items 
in Advanced Work Assignment.

Set up 
shift-based 
assignment

Install either one or both of the 
following plugins for this card to 
conditionally appear:

• Workforce Optimization for 
Customer Service

• Workforce Optimization for 
ITSM

Assign work items to agents 
based on shifts.

Get started with Advanced Work Assignment

To implement Advanced Work Assignment, complete these initial configuration and setup steps.

Before you begin
Role required: awa_admin and admin
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Procedure

1. Navigate to All  > Advanced Work Assignment  > Home.

2. Select Get Advanced Work Assignment plugin  to install the Advanced Work Assignment 
plugin for your instance.
The All Applications page opens in a new window or tab.

3. In the All Applications page, select Install  and complete the installation prompts.

4. Go back to the Advanced Work Assignment  (AWA) home page, and then select Done  on the 
Plugin page opened dialog box.
The AWA  home page experience refreshes and the Get targeted routing capabilities section 
appears.

5. Select Get plugin  to activate org-specific IT Service Management  (ITSM), Customer Service 
Management, and HR Service Delivery  (HRSD) plugins.
The All Applications page opens in a new window or tab.

6. In the All Applications page, select Install  and complete the installation prompts.

7. Go back to the Advanced Work Assignment  (AWA) home page, and then select Done  on the 
Plugin page opened dialog box.
The AWA  home page experience refreshes and the Get the most popular plugins section 
appears.

8. Optional:  Install additional plugins through various ways.

◦ Select Get plugin  to install popular plugins.

◦ Select the plugin name from the Available Plugins sections.
The All Applications page opens in a new window or tab.

9. Optional:  In the All Applications page, select Install  and complete the installation prompts.

10. Optional:  Go back to the Advanced Work Assignment  (AWA) home page, and then select 
Done  on the Plugin page opened dialog box.

(Optional) The plugin page opened dialog box only appears when you install plugins from the 
Get the most popular plugins section.

The AWA  home page experience refreshes and either the Get the most popular plugins 
section refreshes with the installed plugin or the plugin appears under the Installed Plugins 
section.

11. In the Essential settings section, select Set up service channels  to configure the service 
channels that you activated.

a. Create or change an inbox layout.

b. Override agent capacity, as needed.

12. In the Essential settings section, select Set up queues  to create work item queues for your 
service channels.
Set the sort order for work items in the queue.

13. In the Essential settings section, select Set up assignment rules  to configure the work 
assignment rules used to push work to the appropriate agents.

14. Optional:  In the Additional settings section, consider configuring the following parameters to 
improve your AWA  functionality.

a. Select Set up presence states  to configure availability states that agents use to indicate 
whether they can receive work or are offline or away.

b. Select Set up reject reasons  to define the reasons that agents can use to decline work 
assignments that they receive in their Agent Workspace inbox.
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c. Select Set up universal capacity  to configure your team's maximum universal capacity to 
prevent an agent from being assigned too many work items.

d. Select Set up groups  to create groups of user sets who share a common purpose.

15. Optional:  In the Advanced settings section, consider configuring the following parameters to 
improve your AWA  functionality.

Note: 
Advanced settings cards appear conditionally after installing their respective plugin.

a. Select Set up Agent Affinity  to create or change the Agent Affinity  rules that route work 
items in Advanced Work Assignment.

b. Select Set up Shift-based Assignment  to assign work items to agents based on shifts.

Activate Advanced Work Assignment

You can activate the Advanced Work Assignment  plugin (com.glide.awa) if you have the admin 
role.

Before you begin
Role required: admin

About this task
Advanced Work Assignment  activates the Skills Management plugin 
(com.snc.skills_management) to implement user and group skills.

Plugins for Skills Management

Plugin Description

Skills Management

[com.snc.skills_management]

Implements user and user group skills. Based on the same 
principles of roles management, which uses inheritance 
between user groups.

Procedure

1. Navigate to All  > Advanced Work Assignment  > Home.

2. Select Get Advanced Work Assignment plugin  to install the Advanced Work Assignment 
plugin for your instance.
The All Applications page opens in a new window or tab. If you don’t see the Get Advanced 
Work Assignment plugin  button, you either don’t have the permissions to install the plugin, or 
the plugin has already been installed.

3. In the All Applications page, select Install  and complete the installation prompts.

4. In the Advanced Work Assignment  (AWA) Home experience's Plugin page opened dialog box, 
select Done.
The AWA  Home experience refreshes, the Get targeted routing capabilities section appears, 
and AWA  is installed.

What to do next
Activate the targeted routing capabilities plugins and other popular AWA  plugins to enable 
the appropriate service channels and the Platform Analytics Solutions  for Advanced Work 
Assignment.
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Activate related plugins for Advanced Work Assignment

After activating the Advanced Work Assignment  plugin, activate related AWA  plugins to enable 
other base system service channels and the Performance Analytics  Solutions dashboard for 
AWA.

You must have the admin role to activate these additional plugins for AWA.

Targeted routing capabilities plugins

Install the following plugins from the AWA  Home experience's Get targeted routing capabilities 
section or the Available Plugins section. If you'd rather search for each plugin individually, see 
Activate a plugin .

Plugin Description

Advanced Work Assignment  for Incidents

[com.snc.incident.awa]

Enables the Incident service channel in AWA. 
Includes a default configuration to support 
AWA for incidents.

Advanced Work Assignment  for CSM

[com.sn_csm.awa]

Enables the Case service channel in AWA. 
Includes configuration data supporting 
routing, queuing, and assignment of CSM 
cases.

Advanced Work Assignment  for HRSD

[com.sn_hr_awa]

Enables base system configuration data 
supporting routing, queuing, and assignment 
of HRSM cases, chats, and calls to agents.

Popular plugins

Install the following plugins from the AWA  Home experience's Get the most popular plugins 
section or the Available Plugins section. If you'd rather search for each plugin individually, see 
Activate a plugin .

Plugin Description

Agent Chat

[com.glide.interaction.awa]

Enables the Chat service channel in AWA and 
chat messaging in Agent Workspace. Includes 
default configuration data for chats, including 
demo data.

Walk-up Experience

[com.snc.walkup]

Activates the walk-up contact service channel 
for prebuilt tech lounges. Enables an IT 
organization to support online and off-site 
checkin.

Performance Analytics Content Pack – 
Advanced Work Assignment

[com.snc.pa.awa]

Activates the Performance Analytics Content 
Pack for AWA. Provides base system KPIs.

Move from Connect Support  to Advanced Work Assignment  and Agent Chat

Move from ServiceNow®  Connect Support  to Agent Chat  (live chat), which is the messaging 
system that agents use in Agent Workspace  to interact with customers. Moving from Connect 
Support  also involves using Advanced Work Assignment  (AWA) to create the chat queues for 
routing chat work items to agents.
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Before you begin
Role required: admin

Important: 

As of Utah, Connect Support  is deprecated. For similar capabilities, please move to 
Advanced Work Assignment  and Agent Chat.

About this task
Moving to modern applications such as Advanced Work Assignment  and Agent Chat  offers 
features and benefits that are not available in Connect Support. These new capabilities include:

• Automatic assignment of chats and work items to agents  based on criteria that you define, 
such as agent availability, capacity, skills, Agent Affinity, and variable work item sizing.

• Automatic queue overflow handling

• Chat timeout reassignment

• Native Chat surveys

• Supervisor features, such as Agent Whisper, that enable managers to join ongoing public 
customer chats with agents or send private messages to agents.

• Agent features, such as workspace inbox controls  for viewing, accepting, or rejecting incoming 
chats.

If you are currently using Connect Support  APIs, see AWA Routing API  for information on AWA 
APIs.

Procedure

1. Navigate to All  > Advanced Work Assignment  > Home.

2. Activate the Advanced Work Assignment  and Agent Chat  plugins if they are not currently 
active.

3. If needed, review your existing Connect Support  chat queues and determine whether you want 
to create a similar set of queues for the Chat service channel in AWA.

Note: 
You cannot use your Connect Support  chat queues in AWA. Chat queues for Connect 
Support  are stored in the Chat Queue [chat_queue] table. Chat queues for AWA  are 
stored in the AWA Queue [awa_queue] table.

4. In the AWA  Home page, configure the Chat service channel, create the associated chat 
queues, and establish agent work assignments.

5. In Agent Chat settings, access the Chat Setup form to specify Agent Workspace  as the fulfiller 
interface for live chat and enable other live chat features.

6. Activate the chat client on your end user Service Portal.

Trouble? 

Troubleshooting suggestions include these common problems and solutions:

Problem: While using AWA, the chat remains in routing and is not offered to an available agent.

Solution: This problem may happen if AWA  attempts to route the chat to a Connect Support 
queue. In this case, the interaction remains assigned to the Virtual Agent  user and no 
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awa_work_item record is created. A common cause of this problem is the Chat Setup entry for 
the chat’s application still being set to Connect.

Problem: When trying to route to a live agent, the requester is incorrectly told that no live agents 
are available.

Solution: This problem may be caused by one of these situations:

• Queue conditions that depend on checking interaction fields or context were created on the 
interaction too late for routing.

• Chat service channel is not associated with the Available presence state. A common cause of 
this problem is deactivating and reactivating the Chat channel.

Debugging suggestions include these questions to consider:

Here are a few questions to ask and places to look if agents are not receiving chats:

• Does an awa_work_item record exist for the interaction? If it does not, is the Assigned to  field 
for the interaction empty or is it set to Virtual Agent? If the Assigned to  field is set to Virtual 
Agent, it is probably trying to use Connect Support.

• In the Chat setup, are the fulfillers set appropriately for each application?

• In the interaction_json_blob referenced by the interaction.context_document  field, is the 
Liveagent_application  variable set to the expected value?

Install Conversational SMS service channel

You can install the Conversational SMS service channel  application (sn_awa_sms_int) if you 
have the admin role. The application installs related ServiceNow®  Store  applications and plugins 
if they are not already installed.

Before you begin

• Ensure that the application and all of its associated store applications have valid ServiceNow 
entitlements. For more information, see Get entitlement for a ServiceNow  product or 
application .

• The Conversational Messaging plugin (com.glide.messaging.awa) must be installed.

For more information on activating plugins, see Activate a plugin .

Role required: admin

About this task
Note: 
The Conversational SMS service channel  is automatically installed with an application 
that implements an SMS provider, such as the Conversational SMS Integration with Twilio 
(sn_va_sms_twilio) application. For more information, see Install Conversational SMS 
Integration with Twilio.

Procedure

1. Navigate to All  > Advanced Work Assignment  > Home.

2. In the Available Plugins section, select Conversational SMS.
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Note: 
If you cannot find the application, you may have to request it from the ServiceNow Store. 
Visit the ServiceNow Store  website to view all the available apps and for information 
about submitting requests to the store. For cumulative release notes information for all 
released apps, see the ServiceNow Store  version history release notes .

3. Select Install, and then in the Install dialog box, select Install.

What to do next
Set up the Conversational SMS service channel

Activate Agent Affinity

You can activate the Agent Affinity  plugin (com.glide.awa.agent_affinity) if you have the admin 
role.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Advanced Work Assignment  > Home.

2. In the Available Plugins section, select Agent Affinity.

Note: 
If the plugin doesn’t appear in the Available Plugins section, try searching for the plugin 
using the search bar. You can search for the plugin by its name or ID. If you can’t find a 
plugin, you might have to request it from ServiceNow  personnel.

3. Select Install/Update All, and then in the Install dialog box, select Install.

Note: 
When domain separation and delegated admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

Activate Conversational Messaging

You can activate the Conversational Messaging plugin (com.glide.messaging.awa) if you have the 
admin role.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Advanced Work Assignment  > Home.

2. In the Available Plugins section, select Conversational Messaging.

Note: 
If the plugin doesn’t appear in the Available Plugins section, try searching for the plugin 
using the search bar. You can search for the plugin by its name or ID. If you can’t find a 
plugin, you might have to request it from ServiceNow  personnel.
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3. Select Install/Update All, and then in the Install dialog box, select Install.

Note: 
When domain separation and delegated admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

Service channels

Provide customer support by automatically routing incoming work to agents through service 
channels.

A service channel  is a means of assigning a specific type and scope of work to agents. You 
can configure base system service channels to set the context and attributes that define work 
handled in the channel, or create your own custom service channel.

Advanced Work Assignment  provides several service channels from which work items originate. 
These channels are:

Service channel Description Plugin

Case Routes and assigns customer 
service cases.

Included with Customer 
Service

Chat Routes and assigns chat 
interactions.

Included with the 
Agent Chat  plugin 
(com.glide.interaction.awa).

Chat - Asynchronous Routes long-running 
conversations that use 
multiple service channels.

Included with the 
Conversational 
Messaging plugin 
(com.glide.messaging.awa).

Facebook Messenger Routes requests from the 
Facebook Messenger  chat 
conversations.

Included with the 
Conversational Integration 
with Facebook Messenger 
store application.

Incident Routes and assigns incidents. Included with the Advanced 
Work Assignment  for incidents 
plugin (com.snc.incident.awa).

Line Routes requests from LINE 
chat conversations.

Included with the 
Conversational Integration 
with LINE  store application.

SMS Routes long-running 
SMS conversations and 
conversations that use 
multiple service channels.

Included with the Install 
Conversational SMS service 
channel  application.
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Service channel Description Plugin

Walk-up Routes requests from walk-up 
contact channels.

Included with the Walk-
up Experience plugin 
(com.snc.walkup).

WhatsApp Routes requests from the 
WhatsApp  chat conversations.

Included with the 
Conversational Integration 
with WhatsApp (powered by 
Twilio)  store application.

You can also set up a custom service channel to address work that is not supported in the base 
system channels. For more information, see Set up a custom service channel.

For each service channel, you set attributes such as:

• Agent capacity: Amount of work that can be handled by the agents supporting the channel.

• Filters: Conditions that filter the type of work handled in the channel.

• Utilization: Conditions that determine when work items are generated.

For each service channel, you also:

• Create the agent inbox card layout used in Agent Workspace.

• Set capacity overrides for specific agents.

• Review and modify associated work item queues. For the Chat service channel, you can create 
queues using the Queues  related list.

Service channel capacity and utilization

In Advanced Work Assignment, capacity is the number of work items automatically assigned 
to agents supporting a service channel. Utilization is the condition that identifies the work item 
states supported in the channel.

Agents have an assigned capacity for each service channel. This capacity is based on the 
default capacity set for the channel. The agent capacity for one service channel (for example, 
chat) does not interfere with the capacity on other service channels (for example, case or 
incident). Admins can set the Default capacity  for a channel on the Service Channel form. This 
setting applies to all agents supporting the channel.

Managers can override the default capacity for:

• Individual agents, by using the Agent Capacity Override  related list on the Service Channel 
form.

• Groups of agents, by using the Agent Capacity Override  related list on the Group form.

If an agent already has a capacity override, setting the override again updates the existing 
capacity for that agent. Override capacity is stored in the Agent Capacity (awa_agent_capacity) 
table.

Create or configure a service channel

Create or configure a service channel that is used in Advanced Work Assignment  (AWA).

Before you begin
Role required: awa_admin or admin
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About this task
You can specify additional conditions to filter the work items that are handled in the channel, 
change the agent capacity (workload) for the channel, set the inbox layouts that your agents use 
in Workspace, and view associated work item queues.

If you activate the corresponding plugins or install the corresponding store applications, AWA 
provides base system channels for these services:

• Cases plugin (com.snc_csm.awa)

• Chats plugin (com.glide.interaction.awa)

• Chats - Asynchronous plugin (com.glide.interaction.awa)

• Conversational Integration with Facebook Messenger  application (sn_va_fb_messenger)

• Incidents plugin (com.snc.incident.awa)

• Conversational Integration with LINE  application (sn_va_line)

• Walk-up interactions plugin (com.snc.walkup)

• Conversational Integration with WhatsApp (powered by Twilio)  application 
(sn_va_whatsapp_twi)

For each channel, you can change certain default settings, such as the default capacity 
(workload) for agents. You can also use the related lists to review associated queues, define the 
associated inbox layouts (work item cards) that are displayed in Workspace, and override the 
agent capacity value.

You can also create a service channel record from the Service Channel module, but you must 
create a queue, assignment rule, and eligible assignment pool  to route work through the service 
channel. For more information, see Set up a custom service channel.

Procedure

1. Navigate to the service channel settings through one of the following navigation paths:

◦ All  > Advanced Work Assignment  > Home.

In the Essential settings section, select Set up service channels.

◦ All  > Advanced Work Assignment  > Service Channels.

2. Choose a situation.

◦ To create a service channel, select New.

◦ To update a service channel, select the service channel record that you want to update.

3. On the form, fill in the fields.

Service Channel form

Field Definition

Name Name of the selected base system service 
channel to be configured:

◦ Chat

◦ Chat - Asynchronous

◦ Case

◦ Facebook Messenger
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Field Definition

◦ Incident

◦ Line

◦ Walk-up

◦ WhatsApp

Inbox order Order in which channel items appear in the 
agent inbox.

Application Name of the application.

◦ Chat: Global

◦ Chat - Asynchronous: Global

◦ Case: Advanced Work Assignment  for CSM

◦ Facebook Messenger: Conversational 
Integration with Facebook Messenger

◦ Incident: Advanced Work Assignment  for 
Incidents

◦ Line: Conversational Integration with LINE

◦ Walk-up: Walk-up Experience

◦ WhatsApp: Conversational Integration with 
WhatsApp (powered by Twilio)

Active Option for activating the service channel. 
When you select this option, the associated 
queues for the service channel can start 
accepting work items.

Short description Brief description of the service channel:

◦ Chat: Live Agent  Chat Interactions

◦ Chat - Asynchronous: Asynchronous Live 
Agent  Chat Interactions

◦ Case: Cases for Agents

◦ Facebook Messenger: Live Agent 
Facebook Messenger  Interactions

◦ Incident: Incidents for Agents

◦ Line: Live Agent  LINE Interactions

◦ Walk-up: Walk-up interactions for agents to 
work on

◦ WhatsApp: Live Agent  WhatsApp 
Interactions

Table Table that stores the service channel records.

Advanced condition If enabled, the advanced conditions that 
apply to the channel. For example:

◦ Chat: [Type] [is] [Chat]

◦ Chat - Asynchronous: [Subtype] [is] 
[mweb], [Type] [is] [Messaging]
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Field Definition

◦ Facebook Messenger: [Subtype] [is] 
[Facebook Messenger]

◦ Line: [Subtype] [is] [Line]

◦ Walk-up: [Type] [is] [Walk-up]

◦ WhatsApp: [Subtype] [is] [WhatsApp]

Assign to field Field that references the user assigned to 
the item. In both Case and Interaction (and 
most other tables), this field is the Assigned 
to  (assigned_to) field.

Assignment group field Field that references the assignment group 
assigned to the item. In most tables, this field 
is the Assignment group  field.

Type Indicator of whether a communication service 
channel is handled as a synchronous or 
asynchronous conversation channel. This 
field appears when you select Interaction  in 
the Table  field.

◦ Chat

◦ Phone

◦ Messaging

◦ Other

Log level
Amount of information recorded when AWA 
events are logged.

◦ None: No information is logged.

◦ Basic: Only basic information is logged.

◦ Verbose: Detailed information, including 
record details and event details, is logged.

This field appears if Enable logging  is 
enabled.

Inbox Alert Audio Audible alert that sounds when a new item 
arrives in your inbox for this service channel. 
If you don’t specify an audio file, the default 
audio file sounds.

Message Alert Audio Audible alert that sounds when a new 
message arrives in your conversation for this 
service channel. If you don’t specify an audio 
file, the default audio file sounds.

Capacity and Utilization

Default work item size Amount of an agent's capacity that is used 
when this work item is assigned. The default 
is 1.

Default capacity Number of items automatically assigned to 
agents (pending overrides).
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Field Definition

◦ Case: The default is 2.

◦ Chat: The default is 4.

◦ Chat: Asynchronous: The default is 4.

◦ Facebook Messenger: The default is 4.

◦ Incident: The default is 2.

◦ Line: The default is 4.

◦ Walk-up: The default is 1.

◦ WhatsApp: The default is 4.

Utilization condition Condition that determines what constitutes 
an active item that counts toward agent 
workload/capacity. For example, the record 
state is New, Open, or Awaiting Info.

◦ For chat: The state is not Closed Complete 
or Closed Abandoned

◦ For Chat - Asynchronous: The state is 
Closed Complete or Closed Abandoned

◦ For case: The state is New or Open

◦ For Facebook Messenger: The state is New 
or Work in Progress

◦ For incident: The state is New, In Progress, 
or On Hold

◦ For Line: The state is New or Work in 
Progress

◦ For walk-up: The state is not On Hold, 
Closed Complete, or Closed Abandoned

◦ For WhatsApp: The state is New or Work in 
Progress

Logging

Enable logging Option to record information in the 
syslog_awa table when AWA  events are 
logged. Specify the level of detail to be 
recorded in the Log level  field on this screen.

Stop logging at Date and time that logging should stop.

This field appears if Enable logging  is 
enabled.

4. Select Submit  or Update.
The channel is added to or updated in the Service Channels [awa_service_channel] table.

What to do next

• Override the agent capacity  for selected agents or groups.

• Create or modify an inbox layout  for the service channel.
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• Configure agent assignment rules  for the channel.

• Define agent pools eligible for assignment.

• Create or modify a work item queue  for the channel.

• Create or modify a work item size override  for the channel.

Conversational SMS service channel

Using the Conversational SMS service channel app on the ServiceNow  Store, workspace agents 
can provide support for long-running SMS conversations and conversations that use multiple 
service channels.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Overview

Requesters can initiate support conversations through SMS. Since these support conversations 
can be long-running, workspace agents need the ability to track ongoing conversations while 
also addressing requesters on other service channels. With the Conversational SMS service 
channel store app, workspace agents can initiate or continue SMS conversations and also 
accept SMS work items from the Workspace Inbox. Requesters in SMS conversations see a 
limited subset of system messages. This minimizes the number of system messages in case the 
conversation is long-running.

Messaging profiles

Messaging profiles provide a way to match an incoming phone number to a requester:

If Then

New SMS is received from a requester who 
is associated to a phone number on the User 
[sys_user] table but has no messaging profile 
match

• A messaging profile record is generated to 
match the number to the User table.

• An interaction record is associated to the 
matching User table.

New message received from a requester who 
does not have a phone number match in the 
User table but does have messaging profile 
match​

• An interaction record is associated to the 
matching messaging profile user.

• The User table record is not associated to 
the phone number. The agent can manually 
verify.

New message received from a requester who 
does not have a phone number match in the 
User table or messaging profiles​

• An interaction record is associated to the 
guest user (Virtual agent or live agent can 
manually verify).

• A messaging profile record is generated for 
the phone number but not associated to a 
user.
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If Then

New SMS from a requester that conflicts with 
an existing User table or messaging profile​

• An interaction is associated with the 
messaging profile/user currently associated 
with the number.

• Virtual agent or live agent can verify the user 
and reassociate the interaction/profile with 
the correct user.

Messaging actions

Messaging actions provide a way to trigger actions based on messaging activity on a 
conversation.

Messaging action parameters Description

Event​

1. Requester message without agent response​

2. Agent message without requester response

Sending of a message from a requester or 
agent starts a timer that can trigger an action

Duration Time set to trigger an action based on the 
Event parameter being set​

Filter conditions Condition needed on the Interaction record 
for a messaging action to be triggered (for 
example, State is "On Hold")​

Action Possible actions include:

• Prompt agent – Sent Workspace notification 
to agent​

• Prompt requester – Sent system message in 
messaging conversation to requester​

• Reassign – Remove assigned agent from 
interaction​

• Set state – Set Interaction state to desired 
state​

Ongoing conversations

The Agent Inbox displays new SMS messages and agents can locate currently assigned SMS 
conversations in the Ongoing tab. The tab indicator and record highlight indicate when an SMS 
conversation has a new message. Unlike chat conversations, SMS conversations can be long-
running. Completed SMS conversations do not display in the Ongoing tab.
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Requester initiated SMS conversations

When a requester initiates a support conversation, a virtual agent or a live agent addresses the 
conversation. Like other service channels, Advanced Work Assignment  handles the routing 
of SMS conversations to live agents. This is how requester-initiated SMS conversations are 
handled:

If Then

There is no active SMS interaction • Create a new SMS interaction

• Assign the interaction to a virtual agent or a 
live agent

There is an active interaction involving a live 
agent

• Inject the message into an existing 
conversation

• Continue with agent in current conversation

• Track using the same interaction record
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If Then

There is an active interaction involving a virtual 
agent

• Inject the message into existing 
conversation

• Continue with existing virtual agent topic

• Track using the same interaction record

An active SMS interaction represents an ongoing conversation between a requester's phone 
number and a company's phone number.

Agent initiated SMS conversations

To initiate an SMS conversation with a requester, agents can select a provider number for 
an outbound service or manually enter a provider number. If there is a current ongoing SMS 
conversation, it automatically appears. When an agent initiates an SMS conversation:

If Then

There is no active SMS interaction​ • Create a new SMS interaction​

• Assign interaction to agent​

There is an active interaction involving an 
agent​

• Inject the message into existing 
conversation​

• Add agent to live group profile​

• No reassignment​

There is an active interaction involving VA​ • Close existing interaction​

• Create a new interaction and assign to agent​

There is an active interaction involving a 
different contact/consumer/user​

• Close existing interaction​

• Create a new channel user profile and 
deactivate the existing channel user profile​

• Create a new interaction and assign to agent​

An active SMS interaction represents an ongoing conversation between a requester’s phone 
number and a company’s phone number.

Set up the Conversational SMS service channel

Configure the Conversational SMS service channel store app.

Before you begin
Role required: admin
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Procedure

1. Navigate to the service channel settings through one of the following navigation paths.

◦ All  > Advanced Work Assignment  > Home.

In the Essential settings section, select Set up service channels.

◦ All  > Advanced Work Assignment  > Service Channels.

2. Select the SMS service channel.

3. On the Service Channel - SMS screen, select the Active  check box to activate the service 
channel.

4. Because the SMS group has no users by default, manually add users to the SMS group.

5. Navigate to All  > Advanced Work Assignment  > Home.

6. In the Additional settings section, select Set up presence states.

7. In the Name column, click Available.

8. On the Presence State - Available screen, select SMS  in the Available column.

9. Select the right-pointing arrow to move SMS from the Available column to the Selected column.

10. Select Update.

Set up a custom service channel

Set up a custom service channel to expand the type and scope of work that is routed 
automatically to your agents.

Before you begin

• Select the table that you want to use to route work to agents automatically. Only Task [task] and 
Interaction [interaction] tables are supported.

• Ensure that the form layout for the selected table is configured for the workspace view. 
Record types without a workspace view appear as read-only in Agent Workspace. For more 
information, see Set up forms in legacy workspace.

• If you want to open a record in AWA  for a table that extends another table that has a service 
channel defined, ensure that the workspace view for that table has already been defined.

• Assign the awa_agent and workspace_agent roles to whichever agents are receiving work 
items in Agent Workspace  from your custom service channel.
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Role required: awa_admin or admin

About this task
You can create a service channel record from the Service Channel module, but you must create 
a work item queue, assignment rule, and eligible assignment pool to route work through the 
service channel. You also must configure the custom service channel to make it available in an 
agent's inbox in Agent Workspace.

Procedure

1. Navigate to the service channel settings through one of the following navigation paths:

◦ All  > Advanced Work Assignment  > Home.

In the Essential settings section, select Set up service channels.

◦ All  > Advanced Work Assignment  > Service Channels.

2. Select New.

3. Complete the service channel fields, and then select Submit.
For more information, see Create or configure a service channel.

4. Create an assignment rule.
For more information, see Configure agent assignment rules.

5. Create a work item queue for your service channel.

For more information, see Create a work item queue.

6. On the form for the work item queue that you created, go to the Assignment Eligibility  related 
link and create an eligible assignment pool.

Make sure to associate your assignment rule to the eligible assignment pool.

For more information, see Define agent pools eligible for assignment.

7. Make your service channel available in Agent Workspace.

a. Navigate to All  > Advanced Work Assignment  > Home.

b. In the Additional settings section, select Set up presence states, and then open Available.

c. On the form, move your custom service channel to the Selected  list.

d. Select Active  option (if not already selected).

e. Select Update.

8. Optional:  Create or change the inbox card layout to show the most important information from 
a work item.
For more information, see Create or change an inbox layout.

Result
Your custom service channel routes work to agents. In Agent Workspace, the service channel 
appears as an available service channel in the agent inbox.

Tutorial: Set up a custom service channel for change requests

Learn how to configure Advanced Work Assignment  to automatically assign change requests 
to agents. Use this tutorial as a guideline to help you understand how service channel records, 
queues, and assignment rules work together to create a custom service channel.

In this tutorial, you learn how to set up a custom channel that:
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• Assigns new change requests to whichever Change Management agent has the most capacity

• Populates the assignee's agent inbox in Agent Workspace  with change requests from the 
queue

• Displays the change request number, short description, and type on the inbox card

• Enables the agent to accept or reject change requests

For information on setting up custom service channels, see Set up a custom service channel.

Before you begin:

• Ensure that the form layout for the Change Request table is configured for the workspace view; 
otherwise, work items from the Change Request service channel appear as read-only in Agent 
Workspace. For more information, see Set up forms in legacy workspace.

• Assign the awa_agent and workspace_agent roles to the Change Management group so that 
members can open work items in Agent Workspace.

Create a service channel to route requests

Create a service channel in Advanced Work Assignment  so that you can route change requests 
to agents.

Before you begin
Role required: awa_admin or admin

Procedure

1. Navigate to the service channel settings through one of the following navigation paths:

◦ All  > Advanced Work Assignment  > Home.

In the Essential settings section, select Set up service channels.

◦ All  > Advanced Work Assignment  > Service Channels.

2. Select New.

3. On the form, fill in the fields.

◦ Name: Change Request

◦ Inbox Order: 100

◦ Table: Change Request [change_request]

◦ Active: Selected

◦ Utilization condition: [Active] [is] [true]

4. Select Submit.

Create an assignment rule for change requests

Create an assignment rule in Advanced Work Assignment  that assigns change requests to 
agents who are available to do the tasks.

Before you begin
Role required: awa_admin or admin
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Procedure

1. Navigate to the assignment rules settings through one of the following navigation paths:

◦ All  > Advanced Work Assignment  > Home.

In the Essential settings section, select Set up assignment rules.

◦ All  > Advanced Work Assignment  > Assignment Rules.

2. Select New.

3. On the form, fill in the fields.

◦ Name: Change Request Assignment Rule

◦ Assign by: Most Capacity

◦ Allow agents to reject: Selected

4. Select Submit.

Create a queue to route new change requests

Create a work item queue in Advanced Work Assignment  that routes new change requests 
through the service channel that handles change requests.

Before you begin
Role required: awa_admin or admin

Procedure

1. Navigate to the queue settings through one of the following navigation paths:

◦ All  > Advanced Work Assignment  > Home.

In the Essential settings section, select Set up queues.

◦ All  > Advanced Work Assignment  > Queues.

2. Select New.

3. On the form, fill in the fields.

◦ Name: Change Management

◦ Service channel: Change Request

◦ Condition mode: Simple

◦ Work item routing condition: [State] [is] [New]

4. From the form context menu, select Save.

Create an assignment pool of agents

Create an eligible assignment pool in Advanced Work Assignment  that receives overflow work 
items, just in case you need more help from other agents to handle change requests.

Before you begin
Role required: awa_admin or admin
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Procedure

1. Navigate to the queue settings through one of the following navigation paths:

◦ All  > Advanced Work Assignment  > Home.

In the Essential settings section, select Set up queues.

◦ All  > Advanced Work Assignment  > Queues.

2. Open the Change Management queue.

3. On the form, go to the Assignment Eligibility  related list and select New.

4. On the form, fill in the fields.

◦ Agent assignment rule: Change Request Assignment Rule

◦ Groups: Change Management

5. Select Submit.

Make your service channel available in Agent Workspace

Make your service channel available in Agent Workspace  so that agents can receive change 
requests in their inbox.

Before you begin
Role required: awa_admin or admin

Procedure

1. Navigate to the presence states settings through one of the following navigation paths:

◦ All  > Advanced Work Assignment  > Home.

In the Additional settings section, select Set up presence states.

◦ All  > Advanced Work Assignment  > Presence States.

2. Open Available.

3. On the form, move Change Request  to the Selected  list.

4. Select Active  (if not already selected).

5. Select Update.

Customize how change requests appear in an agent inbox

Customize how change requests appear in an agent inbox so that agents receive enough 
information to decide whether to accept or reject the work item.

Before you begin
Role required: awa_admin or admin

Procedure

1. Navigate to the service channel settings through one of the following navigation paths:

◦ All  > Advanced Work Assignment  > Home.

In the Essential settings section, select Set up service channels.

◦ All  > Advanced Work Assignment  > Service Channels.

2. Select the Change Request  service channel record.
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3. On the Change Request service channel form, go to the Inbox Layouts  related list and open 
Default Change Request layout.

4. On the form, fill in the fields.

◦ Field 1: Number

◦ Field 2: Short description

◦ Field 3: Type

5. Click Update.

Result
When you create a change request, the item is routed through the Change Request service 
channel and assigned to the agent in the Change Management assignment group who is 
available to receive the change request. When the assignee checks their agent inbox, the 
change request appears with the option for the agent to either reject or accept the work item.

Change request in an agent inbox

Inbox layout

The inbox layout determines the information shown on work item cards displayed in an agent's 
inbox.

The AWA admin (awa_admin) can configure layouts that represent items in an agent inbox. The 
configuration allows agents to see the most important attributes by service channel work items. 
The fields specified on the inbox layout determine the information displayed for a work item.

Each base system service channel provides preconfigured inbox layouts for work items. The 
AWA admin can view and edit these layouts and also create new layouts.

Up to five fields can be shown in the card layout.

• Fields can be added from the table that the service channel points to.

• Fields are dot-walkable.

• The first field added to the layout becomes the title field on the card.

Layout example

For chats that do not have either a contact or consumer, the layout includes only the chat 
subject. You control the display of the Time to accept  count (timer) and the Reject  button 
through the agent assignment rules.
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See Create or change an inbox layout  for more information on accessing and modifying an inbox 
layout.

Create or change an inbox layout

Create or change the card layout for inbox items for a given service channel. Card layouts are 
displayed in the agent inbox view of Agent Workspace.

Before you begin
Role required: awa_admin or admin. Users with the awa_manager or agent role can review inbox 
layouts.

About this task
Cards represent work items in an agent's inbox in Agent Workspace. Each channel has a default 
layout for these cards, which can display up to five fields from the related table record. Use 
the Inbox Layout form to change a default layout, such as the name, short description, and the 
specific fields displayed on the card, for example channel and contact or consumer name. You 
can also specify certain conditions that determine when the card layout is used.

Procedure

1. Navigate to the service channel settings through one of the following navigation paths:

◦ All  > Advanced Work Assignment  > Home.

In the Essential settings section, select Set up service channels.

◦ All  > Advanced Work Assignment  > Service Channels.

2. Select the service channel to be updated.

3. In the Service Channel form, select the Inbox Layouts  related link.

◦ To create a layout, select New.

◦ To change a layout, select the layout to be updated.

4. On the form, fill in the fields.

Field Definition

Name The name of the inbox layout.
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Field Definition

Service channel
The name of the selected service channel.

Short description
The description of the inbox layout.

Order
The order in which the layouts appear in the 
agent inbox.

Condition
A condition that determines when this layout 
is used. Use the condition builder to specify a 
condition that must evaluate to true to apply 
the layout.

Card layout
Example card layout.

Field 1
The field from the table for the channel, for 
example the Interaction [interaction] table for 
the chat service channel. Select the field or 
select None  to remove an existing field.

Field 2 The field from the table for the channel, for 
example the Interaction [interaction] table for 
the chat service channel. Select the field or 
select None  to remove an existing field.

Field 3 The field from the table for the channel, for 
example the Interaction [interaction] table for 
the chat service channel. Select the field or 
select None  to remove it.

Field 4 The field from the table for the channel, for 
example the Interaction [interaction] table for 
the chat service channel. Select the field or 
select None  to remove it.

Field 5 The field from the table for the channel. For 
example, the Interaction [interaction] table for 
the Chat service channel. Select the field or 
select None  to remove it.

5. Select Submit  for a new layout or Update  to modify a layout.
The layout is added to or updated in the Inbox Layout [awa_inbox_layout] table.

What to do next
As needed:

• Override the agent capacity  value for selected agents or groups.

• Create or change a work item queue  for the channel.

Override agent capacity for selected agents

Change the default number of work items that an agent can handle for a service channel.

Before you begin
Role required: awa_admin or admin
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About this task
To change the capacity for selected agents, use the Agent Capacity Override  related list for the 
service channel. To change the capacity for one or more members of a selected group, use the 
Agent Capacity Override  related list for the group (Advanced Work Assignment  > Groups).

Procedure

1. Navigate to the service channel settings through one of the following navigation paths:

◦ All  > Advanced Work Assignment  > Home.

In the Essential settings section, select Set up service channels.

◦ All  > Advanced Work Assignment  > Service Channels.

2. Select the service channel.

3. In the Agent Capacity Override  related list, select New.

4. On the form, fill in the fields.

Field Definition

Service Channel Name of the selected channel.

Override Capacity Number of work items that the selected 
agents can handle.

Users Agents to which this override applies. Move 
the agent names from the Available  list to the 
Selected  list.

You can use the filter to identify conditions 
that restrict the list of agents.

Note: 
The filter shows only users or groups 
that have AWA roles (awa_agent, 
awa_manager, awa_admin, admin).

5. Select Submit.
The selected agents and their associated capacity values are listed in the Agent Capacities 
table.

What to do next
If you’re configuring a service channel, you can create or change an inbox layout  for the channel.

Create or change a work item size override

Create a work item size override if you want Agent Affinity  to calculate an agent's workload using 
a work item size other than the default.

Before you begin
Role required: awa_admin or admin
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Procedure

1. Navigate to the service channel settings through one of the following navigation paths:

◦ All  > Advanced Work Assignment  > Home.

In the Essential settings section, select Set up service channels.

◦ All  > Advanced Work Assignment  > Service Channels.

2. Select the service channel.

3. On the form, select the Work Item Size Override  list.

◦ To create an override, select New.

◦ To change an existing override, select the override that you want to update.

4. On the form, fill in the fields.

Change work item size form

Field Definition

Name Name of the override.

Service Channel Service channel that is assigned to the 
override.

Override Size Size to use instead of the default.

Order Order in which Advanced Work Assignment 
considers this size override.

Condition mode Type of condition for routing work items using 
this size override:

◦ Simple: Specify a routine condition using 
the condition builder.

◦ Advanced: Specify a JavaScript scripted 
condition.

Conditions Condition that applies to the override work 
item sizes. This field appears when you select 
Simple  in the Condition mode  field.

Script JavaScript condition statement that specifies 
the override work item size. The condition 
must evaluate to true. This field appears 
when you select Advanced  in the Condition 
mode  field.

5. Select Submit  to create the override or Update  to change the override.
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Work items

View Advanced Work Assignment  work items using the Work Items menu options.

Work items are a single piece of work handled by an agent from start to finish. For example, 
one chat or one case is an object that is routed and assigned to agents. Only users with 
awa_manager privileges can access the Management menu options.

Work item queues

In Advanced Work Assignment, queues store a specific type of work item for a service channel.

AWA  administrators can create or modify queues based on customer need. As part of creating or 
modifying a queue, the awa_admin identifies some information about the queue, including the 
service channel to which the queue belongs and which agent groups handle the incoming work 
items.

The awa_admin can select a schedule that defines when the queue is available and identify a 
time limit within which an agent should accept a work item in the queue. If the selected service 
channel is Chat, the awa_admin creates the chat messages that are displayed to users.

Routing conditions identify the work items that are routed to a queue. Create routing conditions 
in one of two ways:

• Simple: use a condition builder to select routing conditions. The fields available for selection 
are based on the selected service channel.

• Advanced: use a JavaScript script to identify routing conditions.

The awa_admin can also create a queue without routing conditions so that work items are not 
routed to that queue automatically. Customers can manually assign work items to the queue or 
assign work items using assignment tools such as matching rules or Flow Designer.

When a case in a queue is assigned manually, the case is removed from the queue. The state of 
the work item is set to Canceled  and the cancellation reason is set to Manually assigned.

Note: 
New work items may not be assigned if they are routed to queues containing more than 
10,000 work items in the queued state.

Configure routing rules that use chat context variables

You can specify queue routing rules that use chat context variables in the condition builder. 
For details on creating chat context variables, see Configure context variables for storing chat-
related information. These variables can store contextual information that can be used in routing 
conditions to control where chat work items are routed.

For example, you can define chat context variables to store user responses from pre-chat 
surveys  that you create. If you store these responses in chat context variables, such as a user's 
department or a product name, you can specify the context variables in queue routing conditions 
to direct where the live chat is routed. When you specify a routing condition using the condition 
builder, you can dot walk to the Context fields. In the fields menu, select Show Related Fields 
and open the fields menu again to select Context → Interaction Context fields.
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You can then select from the available 
chat context variables in the condition builder. For example, choosing csp_category  becomes 
Context.csp_category.

Assign pools of agents eligible to work on a queue

Assign one or more agent groups to a queue using the Eligibility Assignment  related list. These 
groups are eligible to receive work items from the queue, which allows work to get prioritized to 
eligible agents.

Select an agent assignment rule and any eligibility time constraints for each group. The eligibility 
time constraints are used to determine when the next pool of agents is eligible for assignment. 
For example, you can assign one group to handle work items immediately and a second group to 
handle the overflow from the first group after work items sit in the queue for a specified amount of 
time.

Note: 
If no groups are assigned to a queue, work items can be routed to the queue but Advanced 
Work Assignment  does not assign them.

Create a sort order for a queue

Use the Work Item Sort Order related list to create one or more sort conditions for work items in 
a queue. For each sort condition, specify a field from the selected service channel table and the 
direction to sort, either ascending or descending. Items in the queue are sorted and assigned to 
agents based on these conditions.

Create a work item queue

Define or change a queue so that you can determine which work items are routed automatically 
to agents through a given service channel.

Before you begin
Role required: awa_admin or admin

About this task
Depending on the service channel, additional configuration options are available. For example, 
in the chat channel you define the standard messages displayed during a chat session with a 
user.
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Procedure

1. Navigate to the queue settings through one of the following navigation paths:

◦ All  > Advanced Work Assignment  > Home.

In the Essential settings section, select Set up queues.

◦ All  > Advanced Work Assignment  > Queues.

2. Choose a situation.

◦ To create a queue, select New.

◦ To change a queue, select the queue record to be updated.

3. On the form, fill in the fields.

Field Definition

Name
Name of the queue. A default queue may 
be available for the service channel you 
activated through the plugins related to AWA.

Number Base number for the table.

For more information, see Record 
numbering .

Service channel Channel to which the queue belongs.

For the chat channel, define the standard 
messages displayed to chat users in the Chat 
Messages section.

Active Option indicating whether the queue is 
enabled.

Application Type of scoped application.

Schedule Support schedule that defines when the 
queue is available.

Order
During routing, the order in which AWA 
considers the routing condition for this work 
item queue, in comparison to other queues.

Short description Brief explanation of the queue.

Routing Condition

Define condition here Option that indicates a routing condition is to 
be applied to the queue. If checked, define 
the Condition mode  and Work item routing 
condition.

Condition mode Type of condition for routing work items in the 
queue.
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Field Definition

◦ Simple: Specify a routing condition using 
the condition builder.

◦ Advanced: Specify a JavaScript scripted 
condition.

Work item routing condition
Condition that applies to routing work items 
to this queue.

Use the condition builder to select routing 
conditions. The fields available for selection 
are based on the selected service channel. 
For the chat service channel, you can specify 
chat context variables in the condition builder 
by dot-walking  to related context fields.

For example, if you defined chat context 
variables that store pre-chat routing 
information, you can dot-walk to those chat 
context variables in the condition builder. You 
can use the variables in routing conditions to 
specify where chats are routed.

Script JavaScript condition statement that specifies 
the work items to be routed to the queue. The 
condition must evaluate to true.

This field appears only when Advanced  is 
selected from Condition mode.

Initial agent response Message that users see when an agent 
accepts a chat. For example: Thank you 
for contacting support. I am 
looking into your question now 
and will be with you shortly.

Max wait time message Message that users see when a chat ends 
because the Max Wait Time has elapsed.

This field is required if the Max Wait Time  is 
greater than 0.

Target wait time Estimated time (Days or Hours, minutes, 
seconds) allotted for an agent to accept an 
item in the queue.

Max Wait Time Maximum amount of time that all available 
agents have to accept or reject a chat 
request. After time runs out, the requester 
receives the value in either the Max wait 
time message  field or the No Agents 
Available Message  field defined in Agent 
Chat settings.
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Field Definition

Note: 
The Max Wait Time  field is available 
after you associate the queue to the 
chat service channel.

4. Select Submit  for a new queue or Update  to change the queue.
The queue is added to or updated in the Queues [awa_queue_list] table.

What to do next

• Define the Assignment Eligibility.

• Optionally, define the Work Item Sort Order.

• Optionally, define the Queue Triggers.

• Optionally, define the Set Agent Affinity rules.

Define agent pools eligible for assignment

Specify pools of agents eligible to receive overflow work assignments for a queue. An eligible 
assignment pool can consist of one or more groups of agents available to work on items in the 
queue. This feature enables Advanced Work Assignment  to find a qualified agent from a wider 
pool of agents.

Before you begin
Role required: admin

About this task
Use the Assignment Eligibility  related link to expand the pool of agents eligible to work on 
items in the queue when other agents are busy or unavailable. For each agent pool, select 
the assignment rule that determines the assignment eligibility. If you don’t define an eligible 
assignment pool for a queue, work items are routed to the queue but AWA  doesn't assign them.

Procedure

1. Navigate to the queue settings through one of the following navigation paths:

◦ All  > Advanced Work Assignment  > Home.

In the Essential settings section, select Set up queues.

◦ All  > Advanced Work Assignment  > Queues.

2. Select the queue.

3. To create an assignment pool, go to the Assignment Eligibility  related link.

◦ To create a new eligible assignment pool, select New.

◦ To change the assignment eligibility for a pool of agents, select the pool to be updated.

4. On the form, fill in the fields.
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Field Definition

Agent assignment rule
The name of the rule that determines how 
work items are to be assigned. Select an 
assignment rule from the list.

Eligible at
The length of time in seconds before 
AWA  considers the next set of agents for 
assignment.

Groups The set of groups eligible for assignment.

◦ Click the lock icon to unlock it and select 
the agent groups in the eligible assignment 
pool.

◦ Click the lock icon to lock it.

5. Select Submit  to create the eligible or Update  if modifying an eligible assignment pool.
The Queues [awa_queues] table is updated with the eligible assignment pool.

Set work item sort order

Specify the order in which work items in a queue are sorted.

Before you begin
Role required: awa_admin or admin

About this task
The Work Item Sort Order  field only determines the order that AWA assigns the work item and 
doesn’t affect the order of work items in the agent's inbox card. Work items in the inbox card are 
displayed based on the time that they arrive. The Work Item Sort Order  field assigns a set of 
pending work items to agents designed by the defined work item sort order. For example, if two 
work items are pending when an agent becomes available, the Work Item Sort Order  decides 
which work item is assigned first to an agent via AWA.

Procedure

1. Navigate to the queue settings through one of the following navigation paths:

◦ All  > Advanced Work Assignment  > Home.

In the Essential settings section, select Set up queues.

◦ All  > Advanced Work Assignment  > Queues.

2. Select the queue.

3. Select the Work Item Sort Order  related list and select New.

4. In the Work Item Sort Order form, select:
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◦ Field: The field to be used for the sort. The fields are from the table for the associated 
channel. For example, the fields available for the chat service channel are from the 
Interaction table.

◦ Sort Direction: The order in which work items are sorted. Select either Ascending (smallest 
to largest or oldest to newest) or Descending (largest to smallest or newest to oldest).

◦ Order: The value of the Order  value relative to other items in the queue.

5. Select Submit.

Create and manage queue triggers

Create and manage queue triggers to set off multiple actions during customer wait times for a 
particular queue.

Before you begin
Role required: awa_admin or admin

Procedure

1. Navigate to the queue settings through one of the following navigation paths:

◦ All  > Advanced Work Assignment  > Home.

In the Essential settings section, select Set up queues.

◦ All  > Advanced Work Assignment  > Queues.

2. Select the queue.

3. Select the Queue Triggers related list.

◦ To create a queue trigger, select New.

◦ To change a queue trigger, select the queue trigger record to be updated.

4. On the form, fill in the fields.

Queue Trigger form

Field Description

Queue Work items that belong to a service channel.

Message
Message that users see because the Trigger 
Time  has elapsed.

If the Trigger Type  field value is Max Wait, 
this field becomes read-only and displays the 
value entered in the Queue form's Max wait 
time message  field. When the Max wait time 
message  appears to users, they’re prompted 
to select a Virtual Agent  topic and if they 
select a topic, they don’t return to the live 
agent's queue.

Trigger Type Type of configurable trigger: Wait  or Max 
Wait. The Wait  trigger defines the actions 
that happen when users are waiting in the 
queue and the Max Wait Time  hasn't been 
met. The Max Wait  trigger defines the actions 
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Field Description

that happen when users are waiting in the 
queue and the Max Wait Time  is met.

Trigger Time Time (days or hours, minutes, seconds) 
allotted for the Trigger Type.

If the Trigger Type  field value is Max Wait, 
this field becomes read-only and displays the 
value entered in the Queue form's Max Wait 
Time  field.

Flow Name of the flow or subflow.

Note: 
Flow Designer  subflows must have 
a string input parameter named 
conversation_id  for AWA  queue 
triggers to detect the appropriate 
subflow. Ensure that the subflow you 
want to use has a string input parameter 
named conversation_id  through 
the Execution  tab in Flow Designer.

Virtual Agent  topic Name of the existing Virtual Agent  topic that 
appears to the users when the max wait time 
is met.

5. Select Submit  for a new queue or Update  to change the queue.
The queue triggers are added to or updated in the Queue Triggers related list.

External routing overview

External routing enables work to be routed to a queue based on the service channel and queue 
conditions, then uses an external solution to assign the queued work item to an agent.

Process flow

This is how the work items are processed when using external routing:

1. Work items are routed to the queue in a queued state but are unassigned. Work items will 
expire if the Max timeout is set.

2. External solution lookups work items in queue state by Work Item Table API.

3. External solution lookups agent availability in AWA  Agent API before assigning to agent.

4. External solution uses AWA  Assignment API to assign work item to the agent.

5. The agent will see an inbox card with an accept button (pending accept state) with no rejection 
options.

When Advanced Work Assignment  is configured to use external routing:

• Queues do not need to have Assignment Eligibility Groups defined.

• Work items remain in the queue with a "queued" status until the external system routes the 
work item or the maximum wait time elapses.

• Related lists do not display at the bottom of the Queues screen.
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These APIs are required for external routing:

• REST API to support the external routing system. For information on REST API, see AWA 
Assignment API  .

• Work item table API (awa_work_item) to look up the queued work items waiting for assignment. 
For information on table API, see Table API .

• AWA  Agent API if the external solution requires validation of agent availability within 
Workspace  before assignment. For information on AWA  Agent API, see AWA Agent API .

Functionality of AWA  components

When external routing is enabled, this is the functionality of AWA  components:

Agent

• Components utilized

◦ Accept button

◦ Agent capacity in use (Service channel capacity) increases but is not utilized against the 
max capacity of service channel

◦ Agent universal capacity in use increases but is not utilized against the max universal 
capacity

• Components not utilized

◦ Agent availability

◦ Reject button with rejection reasons

◦ Max agent capacity

◦ Max universal capacity

Service channel

• Components utilized

◦ Channel advanced condition

◦ Inbox layouts

◦ Queue order

• Components not utilized

◦ Assign to and assignment group fields

◦ Capacity and utilization features

◦ Agent capacity overrides

◦ Work item override

Queue

• Components utilized

◦ Max wait time will expire work items if set on queue

◦ Work item routing conditions

◦ Queue order

• Components not utilized
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◦ Queue agents' presence checks

◦ Work items remain in the queue with a status of "queued" until the external system routes the 
work item

◦ Queue schedules

◦ The following related lists are hidden on the queue since they are not utilized:

▪ Assignment eligibility and rules

▪ Work item sort order

▪ Agent Affinity

▪ Agent assignments

▪ Group queue priorities

▪ Work items

Use external routing for queues

Configure Advanced Work Assignment  to route work items in the queues using external routing.

Before you begin
Be sure that you've reviewed the functionality of external routing and configured the necessary 
APIs. For more information, see External routing overview.

Role required: awa_admin or admin

About this task

Procedure

1. Navigate to the queue settings through one of the following navigation paths:

◦ All  > Advanced Work Assignment  > Home.

In the Essential settings section, select Set up queues.

◦ All  > Advanced Work Assignment  > Queues.

2. If the External  field doesn't appear, select the update personalized list icon ( ) and add the 
External  field to the screen.

3. Set the External  field to true  to use external routing.
If you don't want to use external routing, set the External  field to false.

Tutorial: Route interactions by context

Learn how you can configure Advanced Work Assignment  to route conversations to agents 
according to the context of the conversation.

Before you begin
Activate the Customer Service Management Demo Data (com.snc.customerservice.demo) plugin.

A basic understanding of context variables is required. For more information on context 
variables, see Virtual Agent  scripts.

Role required: awa_admin or admin
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About this task
The What can we help you with?  record producer is available by default with the Customer 
Service Management Demo Data (com.snc.customerservice.demo) plugin. In the record 
producer, chat requesters can specify one of three issue categories that they need help with:

• Product

• Billing

• Order

Whichever category they select passes a value through the liveagent_csp_category 
context variable. Learn how to create queues that route conversations to agents according to the 
values passed through this context variable.

Create a queue for product issues

Create a queue for the Chat service channel that routes product issues.

Before you begin
Role required: awa_admin or admin

Procedure

1. Navigate to the queue settings through one of the following navigation paths:

◦ All  > Advanced Work Assignment  > Home.

In the Essential settings section, select Set up queues.

◦ All  > Advanced Work Assignment  > Queues.

2. Select New.

3. Enter the following information in the fields listed:

◦ Name: Product Support

◦ Service channel: Chat

◦ Condition mode: Advanced

4. In the Script  field, enter this script:

(function executeCondition(/* glide record */ current) {
 var contextTable = current.getValue('context_table');
 var interactionBlobRecord = new GlideRecord(contextTable);
 interactionBlobRecord.addQuery('sys_id',current.getValue('cont
ext_document'));
 interactionBlobRecord.query();
 
 if(interactionBlobRecord.next()){
  var jsonBlob = 
 JSON.parse(interactionBlobRecord.getValue('value'));
  if(jsonBlob.liveagent_csp_category == 'product')
   return true;
 }
 return false;
})(current);

5. Click Submit.
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Create a queue for billing issues

Create a queue for the Chat service channel that routes billing issues.

Before you begin
Role required: awa_admin or admin

Procedure

1. From the Queues list view, click New.

2. Enter the following information in the fields listed:

◦ Name: Billing Support

◦ Service channel: Chat

◦ Condition mode: Advanced

3. In the Script  field, enter this script:

(function executeCondition(/* glide record */ current) {
 var contextTable = current.getValue('context_table');
 var interactionBlobRecord = new GlideRecord(contextTable);
 interactionBlobRecord.addQuery('sys_id',current.getValue('cont
ext_document'));
 interactionBlobRecord.query();
 
 if(interactionBlobRecord.next()){
  var jsonBlob = 
 JSON.parse(interactionBlobRecord.getValue('value'));
  if(jsonBlob.liveagent_csp_category == 'billing')
   return true;
 }
 return false;
})(current);

4. Click Submit.

Create a queue for order issues

Create a queue for the Chat service channel that routes order issues.

Before you begin
Role required: awa_admin or admin

Procedure

1. From the Queues list view, click New.

2. Enter the following information in the fields listed:

◦ Name: Order Support

◦ Service channel: Chat

◦ Condition mode: Advanced

3. In the Script  field, enter this script:

(function executeCondition(/* glide record */ current) {
 var contextTable = current.getValue('context_table');
 var interactionBlobRecord = new GlideRecord(contextTable);
 interactionBlobRecord.addQuery('sys_id',current.getValue('cont
ext_document'));
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 interactionBlobRecord.query();
 
 if(interactionBlobRecord.next()){
  var jsonBlob = 
 JSON.parse(interactionBlobRecord.getValue('value'));
  if(jsonBlob.liveagent_csp_category == 'order')
   return true;
 }
 return false;
})(current);

4. Click Submit.

Work assignments

After routing work items to the appropriate queues and corresponding agent groups, Advanced 
Work Assignment  (AWA) pushes work to the most qualified agent using the assignment criteria 
that you specify. Assignment criteria revolve around the type of assignment rule (most capacity 
or last assigned) and whether skills are defined.

Administrators can choose to push work items to agents based on one of these assignment 
rules:

• Most capacity: This option pushes work to agents that have the most capacity (availability for 
work) for a given channel. For example, suppose that two available agents, Agent 1 and Agent 2 
have different capacities. Agent 1 has capacity for three chats, but Agent 2 has capacity for two 
chats and is currently working on one chat. AWA  assigns the next work item to Agent 1 with the 
most capacity.

• Last assigned: This option pushes work to the agent who has gone the longest without a work 
assignment in the service channel. If more than one agent has the same spare capacity in a 
service channel, AWA  creates and assigns the next work item to the agent who has gone the 
longest without work in the service channel.

In addition to selecting the assignment rule, AWA  admins can also determine whether:

• Agents can reject work items.

• Agents automatically accept chat interactions.

• A timer is used to set a timeout period (the length of time that an agent has to reject or accept a 
work item).

• Agent skills are to be considered during assignment.

Assignment process

When an agent is available, AWA:

• Checks the queue priority and gets an item from the queue with the highest priority. AWA  also 
reviews items that have timed out or have been rejected by agents.

• Identifies the eligible assignment pool. The eligibility assignment pool widens the group of 
agents who are eligible to work on an item.

• Determines the available agents based on their presence state, the assignment rule selected 
(most capacity or last assigned), and also skills, if defined. Agents have spare capacity when 
they decline, transfer, or complete a work item. For example, after an agent transfers a chat, the 
agent has additional capacity.
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• Pushes the item to the inbox of the most qualified agent (the timer begins).

• Accepts work items automatically when Enable auto-assign work items  is selected. Agents 
are unable to manually Accept  or Reject  work items.

Skill-based work assignment

In AWA, you can enable skill-based assignment and if needed, evaluate skill levels and make 
skill assignment mandatory (required). The basic process for setting up skills involves the 
following steps:

1. Identify agents that have specific skills (for example, a foreign language or expertise in a 
certain area such as network routers), and then assign the skills to those agents using the 
Skills Management feature.

2. Make the agents members of the assignment groups for the work item queues involving those 
skills.

3. Create an assignment rule in AWA  that enables skill handling for the specific skills.

If you chose to select the Evaluate skill level  option while creating the assignment rule, 
AWA  also reviews agents' skill levels prior to assigning the work item to the most qualified 
agent. If multiple agents have the same number of matching skills, agents with more skills at 
the sufficient skill level are prioritized over agents with fewer skills at the sufficient level. For 
example, a chat comes through listing three skills at a high skill level. Agent A and Agent B 
both have the three skills. Agent A has three skills with the following skill levels: two high and 
one low. Agent B has three skills with the following skill levels: one high and two low. In this 
example, Agent A would be the first assignee of the work item because they have more skills 
with the sufficient skill level than Agent B. Agent B would only be assigned this work item if 
Agent A rejected the work.

AWA  also prioritizes the number of matching skills over the number of skills with the sufficient 
skill level. For example, a chat comes through listing two skills and their sufficient skill levels: 
Both the English skill and the Databases skill are associated with an advanced skill level. Agent 
1 has both skills but only at the beginner skill level. Agent 2 has only the English skill at the 
sufficient advanced skill level but doesn’t have the Databases skill. In this example, the chat is 
routed to Agent 1 because this agent has both skills even though they aren’t at the sufficient 
skill level.

If you also chose to select the Enforce mandatory skills  option while creating the assignment 
rule, AWA  only assigns the work item to agents that have the mandatory skills at the sufficient 
skill level. For example, a work item with two high-level associated mandatory skills and one 
optional skill is ready for assignment. Agent C has all three skills but only one of the mandatory 
skills at the sufficient high skill level. Agent D has only the two mandatory skills, but both skills 
are at the sufficient high skill level. In this example, Agent D would be the only applicable work 
item assignee because they are the only agent with both mandatory skills at a high enough 
level.

4. Create the work item queue with a routing condition that includes the specific skill, and include 
the appropriate group in the eligible assignment pool.

5. Create a scripted business rule that includes the skill in the table associated with the relevant 
service channel (for example, the Case table).

During work assignment, AWA  routes and assigns work items to the Agent Workspace inbox of 
the most qualified agent based on the agents skills and if applicable, skill level and mandatory 
skill settings.
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Configure agent assignment rules

Set the Advanced Work Assignment  criteria for assigning work items to agents. Choose the 
assignment rule that considers the agent with the most capacity or the agent who has gone the 
longest without work. Establish the settings for the auto-assign handling, reject handling, and 
skill handling related lists.

Before you begin

• A basic understanding of the Skills Management  feature is recommended.

• If you want agent skills to be considered when work is routed to the appropriate agents, 
define the skills for your agents or groups. When you enable the skill handling options on 
the Assignment Rules form, AWA  assigns the users in groups with the appropriate skills to 
corresponding work items.

• You can use rules to identify skills and assign them to work items. For more information on 
defining and assigning skills for work items, see Routing work items to agents based on skills.

Role required: awa_admin or admin

Procedure

1. Navigate to the assignment rules settings through one of the following navigation paths:

◦ All  > Advanced Work Assignment  > Home.

In the Essential settings section, select Set up assignment rules.

◦ All  > Advanced Work Assignment  > Assignment Rules.

2. Choose a situation.

◦ To create a rule, select New.

◦ To change a rule, select the rule to be updated.

3. On the Assignment Rule form, fill in the fields.
For a description of the field values, see Assignment Rule form.

4. Select Submit  for a new rule or Update  if you're changing the rule.
The assignment rule is added to or updated in the Assignment Rules [awa_assignment_rule] 
table.

Tutorial: Automatically assign work to agents by skill

Learn how you can configure Advanced Work Assignment  to automatically route cases to agents 
who speak German. Use this tutorial as a guideline to help you understand how you can route 
work items to agents according to their designated skills.

Before you begin:

• Activate the Skills Management (com.snc.skills_management) plugin.

• A basic understanding of the Skills Management  feature is required.

• To have skills automatically assigned to cases, consider activating the Skill Determination 
(com.snc.skill_determination) plugin.

• Create a group of users who work in customer support.

• Assign the awa_agent and workspace_agent roles to the customer support group.

 Advanced Work Assignment (AWA) Tutorial: Automatically assign work to agents by skill
Watch this video for a visual representation of the following tutorial example.
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Create a skill

Create a "German" skill.

Before you begin
Role required: skill_admin or admin

Procedure

1. Navigate to All  > Skills  > All Skills, and then click New.

2. Enter the following information in the fields listed:

◦ Name: German

◦ Active: Selected

3. Select Submit.

Create an assignment rule that auto assigns agents' work

Create an assignment rule that routes cases according to skills.

Before you begin
Role required: awa_admin or admin

Procedure

1. Navigate to the assignment rules settings through one of the following navigation paths:

◦ All  > Advanced Work Assignment  > Home.

In the Essential settings section, select Set up assignment rules.

◦ All  > Advanced Work Assignment  > Assignment Rules.

2. Select New.

3. Enter the following information in the fields listed:

◦ Name: Case Assignment Rule with Skills

◦ Assign by: Most Capacity

◦ Enable auto-assign work items: Selected

Note: 
Selecting this option automatically accepts chat interactions on behalf of agents. The 
Display options  field appears and you can select either Inbox card  or Inbox card and 
workspace tab.

◦ Enable skills: Selected

◦ Evaluate skill level: Cleared

◦ Enforce mandatory skills: Selected

4. Select Submit.

Create a queue

Create a queue where you can route work to agents who have the German skill.

Before you begin
Role required: awa_admin or admin
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Procedure

1. Navigate to the queue settings through one of the following navigation paths:

◦ All  > Advanced Work Assignment  > Home.

In the Essential settings section, select Set up queues.

◦ All  > Advanced Work Assignment  > Queues.

2. Select New.

3. Enter the following information in the fields listed:

◦ Name: German Case Queue

◦ Service channel: Case

4. Select Submit.

Define assignment eligibility

Define who is eligible to receive cases from the German Cases queue.

Before you begin
Role required: awa_admin or admin

Procedure

1. Navigate to the queue settings through one of the following navigation paths:

◦ All  > Advanced Work Assignment  > Home.

In the Essential settings section, select Set up queues.

◦ All  > Advanced Work Assignment  > Queues.

2. Select the German Cases queue.

3. On the form, go to the Assignment Eligibility related link and select New.

4. In the Agent assignment rule  field, select Case Assignment Rule with Skills.

5. In the Groups  field, select your customer support group.

6. Select Submit.

Enable skill determination

Activate the skill determination business rule to tag skills for your work items.

Before you begin
Role required: awa_admin or admin

Procedure

1. Navigate to All  > System Definitions  > Business Rules.

2. Select the Skill determination for cases  record.

3. On the form, select the Active  field.

4. Select Update.

Define a skill determination rule

Create a skill determination rule to tag the German skill to incoming cases from German 
speakers.
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Before you begin
Role required: awa_admin or admin

Procedure

1. Navigate to All  > Skills  > Skill Determination Rules, and then select New.

2. Enter the following information in the fields listed:

◦ Name: Skill determination for German cases

◦ Active: true

◦ Source table: Case [sn_customerservice_case]

◦ Condition: Opened by.language is German

Note: 
Search for the Show related fields  option when defining the conditions to get 
the Opened by.language option.

◦ Skills: German

3. Select Submit.

Result
Cases that need German speakers are routed to users in Customer Service and Support  who 
have the German skill.

Using Agent Affinity

Agent Affinity  is an Advanced Work Assignment  feature that lets you assign work items by an 
agent's work history, related task, or account team affinity.

Advanced Work Assignment  assigns work items to agents by their availability, capacity, and 
skills. You can use Agent Affinity  to customize this AWA  assignment process and identify the 
agent best suited for the work item. Agent Affinity  ensures that the same agent is assigned to a 
similar work item instead of orienting a new agent every time.

Note: 
Agent Affinity  rules do not override assignment eligibility or constraints that are specified 
on AWA  assignment rules.

The types of affinities are:

Historical

Identifies the best agent based on the agent's history of serving the same customer.

Related task

Identifies the best agent based on the agent's past assignments of related tasks.

Account team

Identifies the best agent based on the agent's responsibility or role in the account 
team.

Note: 
Account team affinity is available only to Customer Service Management  customers.

Affinity rules are associated with AWA  queues. Up to three rules can be associated with each 
queue. The affinity order determines how the assignment engine ranks the agents. The agent 
with the higher order affinity rule is considered as the best agent first.
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The following example shows how AWA  uses Agent Affinity  to determine the best agent for a 
work item. In this example, AWA  is configured to use all three affinities in this order: related task 
affinity, account team affinity, and historical affinity. George Warren, who is a customer at the 
Boxeo company, has a router problem. George previously contacted support to report an issue. 
That case was assigned to agent Ned. The primary support agent for Boxeo is agent John. Within 
the past seven days, another agent, agent Beth, addressed a chat with Boxeo.

The next time George initiates a customer service chat from the case page, the case is 
automatically added as a related task to the chat interaction. Agent Affinity  uses the related task 
affinity to look for an agent who has fulfilled past assignments for a related task. Because agent 
Ned was assigned to a related task on the record, AWA  assigns the work item to agent Ned if 
available with capacity.

Example of related task affinity

If agent Ned is unavailable or doesn't have the capacity, AWA  uses the account team affinity. 
AWA  looks for another agent based on an agent's responsibility or role in the account team. 
Because agent John is the primary support agent for the Boxeo company, AWA  assigns the work 
item to Agent John if available with capacity.

Example of account team affinity

If agent John is not available, AWA  uses the historical affinity and looks for an agent that has 
recently interacted with the company. This information is stored on the Agent Affinity  screen. 
Because agent Beth addressed a chat with Boxeo within the past seven days, AWA  assigns the 
work item to agent Beth if available with capacity.
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Example of historical affinity

Configure Agent Affinity  rules

Create or change the Agent Affinity  rules that route work items in Advanced Work Assignment.

Before you begin
Role required: awa_admin or admin

Procedure

1. Navigate to the agent affinity settings through one of the following navigation paths:

◦ All  > Advanced Work Assignment  > Home.

In the Advanced settings section, select Set up Agent Affinity.

◦ All  > Advanced Work Assignment  > Agent Affinity Rules.

2. Choose a situation.

◦ To create an affinity rule, select New.

◦ To update an existing affinity rule, select the affinity rule.

3. On the form, fill in the fields.

Field Definition

Name Name of the affinity rule.

Service channel Service channel that the rule applies to.

Application Name of the application.

Affinity based on Type of affinity. Only affinity types 
corresponding to your selection appear.

◦ History

◦ Related Tasks

◦ Account Team Responsibility

Agent's affinity to Account level or contact level. This field 
appears when you select History  in the 
Affinity based on  field.

Number of days Past number of days during which the agent 
has worked with the customer. The maximum 
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Field Definition

number of days is 30. This field appears 
when you select History  in the Affinity 
based on  field.

Responsibility Agent who is part of the account team. This 
field appears when you select Account Team 
Responsibility  in the Affinity based on  field.

4. Click Submit  for a new affinity rule or Update  to modify an existing affinity rule.

Set Agent Affinity  rules

Specify the Agent Affinity  rules to determine the order in which work items in a queue are sorted.

Before you begin
Role required: awa_admin or admin

Procedure

1. Navigate to the queue settings through one of the following navigation paths:

◦ All  > Advanced Work Assignment  > Home.

In the Essential settings section, select Set up queues.

◦ All  > Advanced Work Assignment  > Queues.

2. Select the queue.

3. Select the Agent Affinity  related list.

◦ To create a Agent Affinity  rule mapping, select New.

◦ To change an existing Agent Affinity  rule mapping, select the mapping to be updated.

4. On the form, fill in the fields.

Agent Affinity  Rule Mapping form

Field Definition

Agent Affinity  Rule Agent Affinity  rule to be used for the sort.

Order Value of this rule relative to the other rules 
in the queue. Rules are ordered from lowest 
to highest so a rule with an order of 100 is 
considered before a rule with an order of 200.

5. Select Submit.
You can specify a maximum of three Agent Affinity  rules per queue.

Deactivate Agent Affinity

Deactivate Agent Affinity  if you do not want Agent Affinity  to assign work assignments to agents.

Before you begin
Role required: awa_admin or admin
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Procedure

1. In the navigation filter, enter sys_properties.list.
The entire list of properties in the System Properties [sys_properties] table appears.

2. In the Search  field, enter glide.awa.agent_affinity.enabled.

3. Click glide.awa.agent_affinity.enabled.

4. On the system property screen, change Value  from true  to false  and click Update.
Agent Affinity is now deactivated.

Agent Inbox controls

Control certain elements of the agent experience in Agent Workspace. Define the agent 
presence (availability) states and the work item rejection reasons used by agents to decline work 
assignments in their Agent Workspace  inbox.

Agent presence states

Agent availability in Agent Workspace  Inbox

AWA  admins can define the presence states that agents choose in their inbox to indicate their 
availability. The default states are

• Available: Solid green bubble indicates that the agent is available to receive work.

• Away: Solid yellow bubble indicates that the agent is not available to receive work.

• Offline: Solid grey bubble indicates that the agent is not available to receive work.

AWA  developers with the awa_integration_user role can also use JavaScript or REST APIs to get 
or set agent presence and agent channel availability. For more information, see

• Agent Presence API (REST APIs)

• Agent - Global (JavaScript APIs)

Agent rejection controls

AWA  admins can give agents the option to reject work assignments and specify the reason for 
rejecting it. The Reject  button displays on work assignment cards. When an agent rejects an 
assignment, a pop-up window enables the agent to select a reason for declining the work item.
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Configure agent presence states

Create or modify the availability states that agents use to indicate whether they can receive work 
or are offline or away. Agents set these states in their Workspace  Inbox.

Before you begin
Role required: awa_admin or admin. Users with the awa_manager and awa_agent roles can 
review the presence states.

About this task
The default presence states are Available, Away, and Offline. For the Available state, be sure to 
enable it (using the Active check box) so that AWA can route work to agents.

Procedure

1. Navigate to the presence states settings through one of the following navigation paths:

◦ All  > Advanced Work Assignment  > Home.

In the Additional settings section, select Set up presence states.

◦ All  > Advanced Work Assignment  > Presence States.

2. Choose a situation.

◦ To create a presence state, select New.

◦ To update a presence state, select the presence record you want to update.

3. On the form, fill in the fields.

Field Definition

Name
Name of the presence state, for example: 
Out of office. The default presence states are 
Available, Away, or Offline.

Active Enables this presence state for agents.

Note: 
For the default Available state, be 
sure to enable this Active  check 
box so that work items are routed to 
available agents. If the Active  state is 
not enabled, AWA does not route work 
items to agents.

Available to receive work items Indicates that agents can handle work items 
in this presence state. If the presence state is 
Away or Offline, this box is not selected.

Service channels Service channels that can use this presence 
state. To select a service channel, move the 
channel name from the Available  list to the 
Selected  list.

Description Brief description of the state.

Order Order in which this state is displayed in the 
agent inbox.
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Field Definition

Show channels Enables you to restrict the service channels 
in which agents can update their presence 
using this state. When you select this field, 
the Restrict agent update  field is displayed.

Disable agent inactivity check If this check box is selected, the agent's 
presence will not be automatically set to 
"offline" based on inactivity and it must be 
manually set by the AWA Agent API . You 
may need to configure the form to add this 
field.

Restrict agent updates Service channels in which agents cannot use 
this state to update their presence. Select 
the lock icon and select the appropriate 
channels. When you complete your 
selections, select the lock icon to lock the 
field. You may need to configure the form to 
add this field.

Apply to all groups Indicates all groups can use this presence 
state. To specify only certain groups that can 
use this presence state, unselect this check 
box to display the Apply to groups  list. You 
may need to configure the form to add this 
field.

Apply to groups Selected groups that can use this presence 
state. To select a group, move the group 
name from the Available  list to the Selected 
list. You may need to configure the form to 
add this field.

4. Select Submit  for a new presence state or Update  if modifying an existing presence state.
The presence state is added to or updated in the Presence States [awa_presence_state] table. 
The presence state is also listed in the Availability section of the Agent Workspace Inbox for 
the agents belonging to the groups and channels that use this state.

Configure reasons for rejecting work items

Define the reasons that agents can use to decline work assignments that they receive in their 
Agent Workspace inbox. A reject reason can apply to all service channels or a single channel 
that you specify.

Before you begin
Role required: awa_admin or admin

Procedure

1. Navigate to the reject reasons settings through one of the following navigation paths:

◦ All  > Advanced Work Assignment  > Home.

In the Additional settings section, select Set up reject reasons.

◦ All  > Advanced Work Assignment  > Reject Reasons.

2. Choose a situation.
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◦ To create a rejection reason, select New.

◦ To update an existing rejection reason, select the reason record.

3. On the form, fill in the fields.

Field Definition

Reason Name of the reason for rejecting work items.

Agent selectable Indicates that the reject reason is selectable 
by agents in their Agent Workspace Inbox.

Order Order in which the reject reasons are listed in 
the agent inbox.

Apply to all service channels Indicates that the reject reason applies to 
all service channels. To make the reason 
available to a single channel, unselect this 
check box and in the Service channel  field, 
select the appropriate channel.

Service channel Service channel that the rule applies to. This 
field is displayed when Apply to all service 
channels  isn’t enabled.

Reassignable Indicates if the work item can be reassigned 
to the agent who rejected it.

4. Select Submit  for a new reason, or if changing an existing reason, select Update.
The rejection reason is added to or updated in the Reject Reasons [awa_reject_reason] table.

Configure reassignable settings

Configure whether an agent who rejected a work item is eligible to be offered the same work 
item.

Before you begin
Role required: admin

Procedure

1. Navigate to the reject reasons settings through one of the following navigation paths:

◦ All  > Advanced Work Assignment  > Home.

In the Additional settings section, select Set up reject reasons.

◦ All  > Advanced Work Assignment  > Reject Reasons.

2. Select the reason record that you want to change.

3. On the form, configure the Reassignable  field:

◦ If you want to have an agent who rejected a work item be eligible to be offered the same 
work item, select the Reassignable  field.

◦ If you don’t want to have an agent who rejected a work item be eligible to be offered the 
same work item, unselect the Reassignable  field.

Management

Configure Advanced Work Assignment  properties using the Management menu options.
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Only users with awa_manager privileges can access the Management menu options.

Configure an agent's maximum universal capacity

Prevent an agent from being assigned too many work items by configuring the agent's maximum 
universal capacity. If the agent's maximum universal capacity has been reached, additional work 
items won’t be assigned to the agent.

Before you begin
Role required: admin

Procedure

1. Navigate to the universal capacity settings through one of the following navigation paths:

◦ All  > Advanced Work Assignment  > Home.

In the Additional settings section, select Set up universal capacity.

◦ All  > Advanced Work Assignment  > Universal Capacity.

2. Choose a situation.

◦ To create a new maximum universal capacity for an agent, select New:

Field Definition

Max Universal Capacity Maximum capacity for an agent across 
all service channels. If an agent's current 
capacity equals the maximum universal 
capacity, additional work items won’t be 
assigned to the agent.

Users The max universal capacity is assigned 
to the users (agents) in the Selected list. 
Select agents in the Available list and then 
select the right-pointing arrow to add them 
to the Selected list. To filter the agents in the 
Available list, create a filter by selecting Add 
Filter  or run an existing filter by selecting 
Run Filter.

◦ To update an existing maximum universal capacity for an agent, select the maximum 
universal capacity to update:

Field Definition

Max Universal Capacity Maximum capacity for an agent across 
all service channels. If an agent's current 
capacity equals the maximum universal 
capacity, additional work items won’t be 
assigned to the agent.

Universal Capacity In Use Current workload for an agent across all 
service channels.

Agent Name of the agent.

3. Select Submit  for a new universal capacity or Update  for an existing universal capacity.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4565



Create or change groups for Advanced Work Assignment  queues

Create or manage groups that have associated Advanced Work Assignment  queues.

Before you begin
Role required: awa_manager or admin

About this task
Groups are sets of users who share a common purpose. By creating these groups, information 
that is displayed in AWA  is limited to only users that are in AWA  groups. The assignment group 
can be configured so that work items are assigned using the group queue priority. Each round 
of assignment can include multiple passes through the work items, each with an increasingly 
inclusive set of groups. This process ensures that agents in each group are offered items 
according to their group's queue priority order.

Procedure

1. Navigate to All  > Advanced Work Assignment  > Home  > Management  > Groups

2. Choose a situation:

◦ To create a group, select New

◦ To change a group, select the group you want to update.

3. On the Group screen, fill in the fields.

Field Description

Name Name of the group.

Manager Group manager or lead.

Group email Group email distribution list or the email address of the point of 
contact, such as the group manager.

Parent Other group of which this group is a member. If a group has a 
parent, the child group inherits the roles of the parent group. The 
members of the child group aren’t members of the parent group. 
For example, if an incident is assigned to the parent group and 
you select the Assigned to look up icon, only the members in the 
parent group are available. The members of the child group aren’t 
available.

Description Helpful information about the group.

4. Select Submit.

5. If you want to configure the queue priority order for the group, follow these steps:

a. Select the group name on the list.

b. Select the Queues related list at the bottom of the screen.

c. Double-click in the order number field that you want to change.

d. On the pop-up Order dialog, enter the new order number.

e. Select the green check mark to save the change.

AWA  post work item subflow

Configure the base system AWA  post work item subflow by defining the input in flow designer.
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Before you begin
Role required: admin

Procedure

1. Navigate to All  > Process Automation  > Flow Designer.

2. On the Flow Designer screen, select Subflows.

3. In the Name column, enter Template: AWA post work item.

This searches for the Template: AWA post work item.

4. Select Template: AWA post work item.

5. In the subflow header, select the more actions icon ( ) and then Copy subflow.

6. On the Create a copy of this subflow dialog, enter a unique and descriptive name for the 
copied subflow in the New subflow name  field.

7. Select Copy.
The new subflow is created and displays as a tab in the subflow designer editor.

8. You can customize the subflow by doing one of the following:

◦ Integrate with a third-party system by adding an action with a spoke from the Integration Hub 
(for more information, see Spokes )

◦ Use a REST action step and call the external endpoint (for more information, see REST 
step ).

◦ Call a REST message in the subflow itself (for more information, see Outbound REST Web 
Service ).

Configure messaging actions

Create or modify messaging actions that are performed when an event occurs. These actions 
apply only to messaging.

Before you begin
Activate the Conversational Messaging plugin (com.glide.messaging.awa). For information on 
activating this plugin, see Activate Messaging Actions.

Role required: admin

About this task

• For the Requester Message without Agent Response event, the default length of time that 
elapses before an agent is sent a reminder is 30 minutes.

• For the Agent Message without Requester Response event, the default length of time that 
elapses before the conversation is set to the Closed Abandoned state is 2 days.

If you're using both Virtual Agent and Live Agent, the system closes an abandoned live 
conversation based on the lowest timeout value for closing conversations. Be aware that 
other conversation timeout behavior can affect idle live chat timeouts, regardless of the 
Duration  and Action  that you specify. For details, see Closing Virtual Agent and Agent Chat 
conversations.
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Procedure

1. Navigate to All  > Conversational Interfaces  > Messaging  > Actions.

◦ To create a new messaging action, click New.

◦ To update an existing messaging action, click the messaging action.

2. On the form, fill in the fields.

Messaging Action form

Field Definition

Name Name of the messaging action.

Event Event that starts the timer:

◦ Requester Message without Agent 
Response - message from a requester that 
has not been responded to by an agent.

◦ Agent Message without Requester 
Response - message from an agent that 
has not been responded to by a requester.

Duration Length of time that elapses after the event 
before the action runs.

Active Option to track the timers and perform 
actions.

Filter Conditions Condition the timer is evaluated for.

Action Action to perform after the duration of time 
has elapsed:

◦ Prompt Agent - prompt the agent using a 
Workspace notification.

◦ Prompt Requester - display system 
message with prompt to requester.

◦ Reassign - clear the Assigned to  field of 
the interaction so that it can be rerouted to 
another agent.

◦ Set State - set the interaction to the given 
state.

Prompt Message displayed to requester. This field 
appears when you select Prompt Agent  in 
the Action  field.

State State of the interaction. This field appears 
when you select State  in the Action  field.

3. Click Submit  for a new messaging action or Update  to modify an existing messaging action.

Enable logging for Advanced Work Assignment

Enable logging to monitor AWA  routing and assignment.

Before you begin
Role required: maint
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Procedure

1. In the navigation filter, enter sys_logger_configuration.list.

2. On the Logger Configurations screen, select New.

3. On the New record screen, fill out the fields:

Field Description

Logger Name Name of logger that this configuration applies to. This 
should be set to com.snc.awa.

Application This field defaults to Global  and cannot be changed.

Active Option to activate logging.

Additive Option to use the new logging in addition to any existing 
logging. This should be set to false.

Level Type of errors that should be logged:

◦ FATAL - errors that cause the service to shut down 
(status 0).

◦ ERROR - non-fatal service error messages.

◦ WARN - warning messages indicating potential issues.

◦ INFO - informational messages representing service 
actions.

◦ DEBUG - detailed service operation messages which 
help troubleshoot issues.

◦ TRACE - very detailed service operation messages 
which help troubleshoot issues.

◦ ALL - all errors should be logged.
This should be set to INFO.

Filters Enter any filters and their values that you want applied to 
the results.

Destination Where the format log is sent. This should be set to 
Database.

Layout Layout format that should be applied to the logs.

4. Select Submit.
Logging for the AWA  assignment engine is enabled in the syslog table.

5. To view the system log, navigate to System Logs  > System Log  > All.

Using Advanced Work Assignment

The following sections detail how awa_manager or awa_agent roles can use Advanced Work 
Assignment  (AWA) to complete various tasks such as checking an agent's presence and 
capacity, checking unassigned work items, and creating SMS conversations.

Check for an agent's presence and capacity

View a list of agents in Advanced Work Assignment, their presence status, and capacity for each 
of the agent's service channels to see which agent can handle a case. This list is filtered across 
different teams, channels in teams, and channels dashboards.
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Before you begin
Role required: awa_admin or admin

Procedure

1. Navigate to All  > Advanced Work Assignment  > Management  > Agent Presence & Capacity.

2. In the list, check which agent is available to handle a case:

AWA Agent Presence and Capacities form

Field Definition

Agent Name of the agent.

Current presence state Presence state that is currently assigned to 
the agent.

Updated Date and time that this agent was last 
updated.

Channel Service channel that is assigned to the agent.

Capacity in use Current workload of agent.

Capacity Maximum capacity that the agent can handle.

Check unassigned interactions

View a list of unassigned interactions in Advanced Work Assignment  from chat and phone that 
are currently waiting in the queue and are not assigned to any agents. You can use this list to 
debug, implement advanced work assignments, or determine why certain work items are not 
being assigned.

Before you begin
Role required: awa_manager or admin

Procedure

1. Navigate to All  > Advanced Work Assignment  > Management  > Unassigned interactions.

2. In the list, check the unassigned interactions:

Field Description

Number Interaction number.

Type How the interaction began (for example, chat, phone, or walk-up).

Created Date that the interaction was created.

Opened for Name of the user starting the interaction.

Account Name of the company that is associated with the interaction.

Assigned to User that is assigned to the interaction.

State Status of the interaction.

Queue Queue that is assigned to the interaction.

Offered on Date that the interaction was first offered to an agent.

Rejected Interaction that was rejected by the agent.
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Field Description

Timed Out Interaction that has exceeded the timeout specified in assignment 
rule.

Exceeded Queue Target 
Wait Time

Interaction that has waited longer than the target wait time of the 
queue.

Check unassigned task work items

View a list of unassigned task work items in Advanced Work Assignment, such as cases and 
incidents, that are currently waiting in the queue and are not assigned to any agents. You can 
use this list to debug, implement advanced work assignments, or determine why certain work 
items are unassigned.

Before you begin
Role required: awa_manager or admin

Procedure

1. Navigate to All  > Advanced Work Assignment  > Management  > Unassigned Task Work 
Items.

◦ To create a task, click New.

◦ To modify an existing task, select the task to be updated.

2. On the form, fill in the fields.

Work Item form

Field Description

Active Whether the task is still being worked on or is complete.

Display Name Task name.

Offered on Date that the task was first offered to an agent.

State
List that shows the status of the task:

◦ Accepted

◦ Cancelled

◦ Pending Accept

◦ Queued

Assignment rule Rule that assigns cases that meet the matching rule criteria to a 
customer service agent.

Exceeded Queue Target 
Wait Time

Task that has waited longer than the target wait time of the queue.

Rejected Task that was rejected by the agent.

Timed Out Task that has exceeded the timeout specified in the assignment 
rule.

Assigned to User that is assigned to the task.

Document ID Document ID that is assigned to the task.

Previous Work Item Reference to a previous work item for the same Document ID.
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Field Description

State changed on Date that the task state was most recently changed.

Cancelled reason
Reason that the task was canceled:

◦ Disqualified from service channel

◦ Manually assigned

◦ Time out

◦ Transfer was cancelled or rejected

Is Dismissed Whether the task has been dismissed.

Work Item Size Amount of an agent's capacity that is used if this task is assigned.

Wait time Length of time the task has waited in the queue before being 
assigned.

Assignment group Group that is assigned to the task.

Document table Document table that is assigned to the task.

Queue Queue that is assigned to the task.

3. Click Submit  to create the task or Update  to modify the task.

Check work items and AWA  events

View a list of work items and AWA  events.

Before you begin
Role required: awa_admin or admin

Procedure

1. Navigate to Advanced Work Assignment  > Work Item  > All.
A list of the work items appears.

2. Select the preview button ( ) for the work item you want to view.

3. On the Work Item dialog box, select Open Record.

Work Item form

Field Definition

Exceeded Queue Target Wait Time Indicator that the interaction has waited 
longer than the target wait time of the queue.

Queue Queue assigned to the task.

Assigned to User assigned to the task.

Document ID Document ID assigned to the task.

State
Status of the task:

◦ Accepted

◦ Canceled
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Field Definition

◦ Pending Accept

◦ Queued

Active Indicator of whether the task is still being 
worked on (active) or is complete.

Canceled reason Reason the task was canceled:

◦ Disqualified from service channel

◦ Manually assigned

◦ Time out

◦ Transfer was canceled or rejected

Note: 
Work items may be canceled if all 
agents remain at full capacity for the 
entire interaction.

Is Dismissed Indicator of whether the task was dismissed.

Rejected Task that was rejected by the agent.

Timed Out Task that has exceeded the timeout specified 
in the assignment rule.

Assignment group Group assigned to the task.

Document table Document table assigned to the task.

Previous Work Item Reference to a previous work item for the 
same Document ID.

State changed on Date that the task state was most recently 
changed.

Allocated by User who assigned the work item.

Display Name Task name.

Offered on Date the task was first offered to an agent.

Work Item Size Amount of an agent's capacity used when 
this task is assigned to the agent.

Wait time Length of time the task waited in the queue 
before being assigned.

Assignment rule Rule that assigns cases that meet the 
matching rule criteria to a customer service 
agent.

Offer Count Number of times the work item was offered to 
agents.

4. Scroll to the bottom of the Work Item form to view the list of the AWA  Events.

5. Select the preview button  for the AWA  event you want to view.

6. On the AWA  Event dialog box, select Open Record.
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AWA  Event form

Field Definition

Caused By User who triggered the AWA  event.

Record ID Interaction record ID.

Type Type of AWA  event:

◦ Assignment

◦ Manual Assignment

◦ Routing

◦ Acceptance

◦ Rejection

◦ Cancellation

Name Name of the corresponding interaction.

Channel Service channel used for the AWA  event.

Record table Table name of document being logged.

Record Details Details of the work item record.

Timestamp Date and time the AWA  event occurred.

Event Details
Details about the AWA  event:

◦ Routing event - details of the queue that 
was selected.

◦ Assignment event - details about which 
agent was selected and which eligibility 
pools were considered. These details 
include a listing of all candidate agents 
that were considered from each pool and a 
summary of which agents were filtered from 
consideration.

◦ Rejection events - details about the user 
who rejected the item and the reason.

◦ Manual assignments - details about the 
manager making the assignment, the 
previous and new agents, and the previous 
work item (if there is one).

◦ Cancellation events - no additional details.

Summary Event summary.

The AWA  Event form appears.

Agent initiated SMS conversation

Customer Service Management supports additional messaging channel such as SMS which 
tracks interactions between the agent and customer.
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Requirements

At least one provider configuration for messaging type channel must be available to view the 
Compose SMS  option in the agent interaction screen. For more information about provider 
sys_cs_provider_application.list, see Create a channel identifier.

Phone number validation
REST endpoint /api/now/initiate_message/validate_phone_number  is used to 
validate if the phone number is in the E.164 format. If the number of a known consumer is not in 
the E.164 format, the system converts it to the E.164 format based on for example, the location of 
the consumer. If the location is not found, it will by default convert the number to an E.164 format. 
For more information about E.164 formats and validation, see Phone number field type .

Customer profile validation

REST endpoint /api/now/initiate_message/validate_profile  is used to validate 
the channel user profile. When you send an SMS in reply to an interaction of type phone, the 
message is sent to a consumer originally associated with the interaction. If the same phone 
number is associated to a different consumer, and you send an SMS, you will get a message that 
the phone number is currently associated to another consumer and sending the new message 
will associate the phone number to the current user.

A phone number is associated to consumer A and an interaction has occurred after which the 
phone number was disconnected for consumer A. There is a new interaction with consumer 
B and you select the same phone number that was associated with consumer A. A message 
appears that the phone number is currently associated to consumer A, and sending a new 
message will associate consumer A's phone number to consumer B who is the current user.

Agent initiated SMS conversations

To initiate an SMS conversation with a requester, agents can select a provider number for 
an outbound service or manually enter a provider number. If there is a current ongoing SMS 
conversation, it automatically appears. When an agent initiates an SMS conversation:

If Then

There is no active SMS interaction​ • Create a new SMS interaction​

• Assign interaction to agent​

There is an active interaction involving an 
agent​

• Inject the message into existing 
conversation​

• Add agent to live group profile​

• No reassignment​

There is an active interaction involving VA​ • Close existing interaction​

• Create a new interaction and assign to agent​
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If Then

There is an active interaction involving a 
different contact/consumer/user​

• Close existing interaction​

• Create a new channel user profile and 
deactivate the existing channel user profile​

• Create a new interaction and assign to agent​

Customize the behaviour of send from and to numbers

The AgentInitiatedConversationUtil extension point is added to implement a customers' 
logic to change the default behaviour of the Send from  and Send to  fields. For more 
information, see Associating user profiles on messaging interactions. For this store application, 
AgentInitiatedMessagingUtilExtPointImpl extension point is configured for fetching the from and 
to numbers.

Compose an SMS conversation

An agent can compose an SMS to interact with a customer for resolving various issues. If the 
interaction is not messaging type, you see the Compose SMS  option.

Before you begin
Role required: agent_workspace_user
A provider is configured for SMS messaging type channel.

About this task
As an agent, you can compose and send an SMS to an ongoing interaction which is not 
messaging type.

Procedure

1. Click Compose SMS.
The Send via SMS screen is displayed.

2. Select a phone number from the Send from:  drop-down list.

◦ If there is only one provider phone number this field is pre-populated with the number.

◦ If there are multiple provider profiles available for SMS channels, you can choose from the 
drop-down list.

3. Select a phone number from the Send to:  drop-down list.

◦ The phone numbers are pre-populated from the consumer or contact records.

◦ If both are not populated, the system looks for the number from the opened for record in the 
sys_user table.

◦ If there is already a channel user profile associated with a consumer or contact, the phone 
number is pre-populated.

a. Choose Other  and select a phone number in the drop-down list.

Note: 
All phone numbers must be in the E.164 format. For more information, about phone 
number and channel user profile validation, see Phone number validation.

If there is already an ongoing SMS type of interaction with the same or different consumer, 
you can view the interaction card in the same screen. The interaction card for the consumer 
number you have selected contains interaction number, message type, last updated time, 
consumer, and assigned to information.
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4. Enter your message in the Message  field.

5. Click Attach file, browse, select the file and attach.

Note: 
You can attach only image files to the message. For more information about the REST API 
for uploading attachments, see Attachment - POST /now/attachment/upload .

6. Click Send.
For more information, see Agent initiated SMS conversations.

Analytics & Reporting Solutions

The following sections review advanced analytics and Platform Analytics Solutions. Advanced 
analytics equips you to view cards that represent the Advanced Work Assignment  dashboards 
that you can access.

Using Advanced analytics to access AWA  dashboards

Advanced analytics enable you to view cards that represent the Advanced Work Assignment 
dashboards that you have access to. You can also see a dashboard picker, which lets you view 
the cards for all the dashboards in a group. You can then search and choose a dashboard from a 
list.

Navigate to Advanced Work Assignment  > Management  > Advanced Analytics.

The advanced analytics for the dashboards lets you see the dashboards in one of these 
categories: by default, the Recent category is selected when you visit the advanced analytics for 
the dashboards.

• Recent  shows up to nine dashboards that you have visited recently. The most recent are 
shown first.

• Owned by me  shows the dashboards that you have created and those dashboards to which 
you have been assigned ownership.

• Shared with me  shows the dashboards which have been shared with you as a user, or 
member of a group or role.

• All  shows all the dashboards that you have access to.

Note: 
The category that you choose limits the dashboard groups and individual dashboards 
that you see when you choose from the Groups list and the Dashboard Picker  field. If no 
dashboards in the incident group have been shared with you, and you select Incident from 
the Groups list, then the overview displays a note that no dashboards match your search.

All tabs except for the Recent tab are sorted in ascending order by:

1. Dashboard group — Order

The owner of the dashboard can specify an order number in the dashboard group's form. This 
field is optional.

2. Dashboard group — Name

3. Dashboard — Order
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The owner of the dashboard can specify an order number in the dashboard's form. This field is 
optional.

4. Dashboard — Name

Using Advanced Analytics tiles

Tiles on Advanced Analytics show thumbnails of the widgets on the dashboard, 
the dashboard group, your level of access on the dashboard, the name of the 
dashboard, and the owner of the dashboard. Dashboard access levels are Owner, 
Editor, and Viewer. For more information, see Share a responsive dashboard . 

Note: 
If you can't view a dashboard widget, you will see a message that prompts you to contact 
the administrator. You may not be able to view a dashboard widget because of wrong 
configuration settings, access restrictions, or because there is no data to display.

Using the Advanced Analytics Groups list

The advanced analytics screen defaults to showing only the dashboards 
related to AWA. You can see other dashboards by changing the 
Groups list to show only those dashboards in another single group. 

Click New  to Create or configure a responsive dashboard .

Operations dashboard

Enable managers to monitor work items across all service channels so that their agents can 
better support customer needs.

This dashboard is available in the Advanced Work Assignment  content pack. For information on 
activating the content pack, see Platform Analytics Solution for Advanced Work Assignment.
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Advanced Work Assignment  dashboard for Operations

End users and roles

End user and goal Required role

AWA administrator: Configures Advanced 
Work Assignment  to best fit the business 
needs of customer service.

awa_admin

AWA manager: Identifies the areas of concern 
for routing and assignment of work items 
across service channels.

awa_manager

Agent manager: Manages agents or agent 
groups. The agent manager wants to know 
what agents are working on to make sure that 
customer needs are being met.

sn_customerservice_manager

Performance Analytics  administrator: Ensures 
that business managers are making the best 
use of Performance Analytics  solutions.

pa_admin or pa_viewer

Use case

This dashboard provides support managers with an overview of incoming work items and the 
availability of agents to handle them. Managers can monitor these daily trends to determine if 
adjustments should be made to the routing criteria, agent capacity values, and other settings 
that determine how work is pushed to agents.

Indicators

Indicator Description

New Work Items Total number of interaction work items that 
were created today. The goal for this indicator 
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Indicator Description

is to minimize the number of interaction work 
items that agents receive.

Accepted Work Items Percentage of interaction work items that 
agents have accepted.

Exceeding Target Work Items Percentage of interaction work items that have 
exceeded the target wait time.

Rejected Work Items Percentage of interaction work items that 
agents have rejected.

Timed Out Work Items Percentage of interaction work items that 
timed out.

Weekly Trends Number of work items in each of the following 
states for the past week:

• New

• Exceeding Target

• Abandoned

• Rejected

• Timed Out

Breakdowns

To analyze data according to different categories, select a breakdown from the dashboard menu:

• Service Channel

• Queue

• Assignment Group

For more information on analyzing data with breakdowns, see Using breakdowns on 
dashboards .

Reports

Title Type Description

Accepted Work Items - Last 
Hour

Single 

Score

Number of interaction work 
items that agents have 
accepted in the past hour.
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Title Type Description

Abandoned Work Items - Last 
Hour

Single 

Score

Number of interaction work 
items that agents have 
abandoned in the past hour.

Average Wait Time - Last Hour Single 

Score

Average amount of time that 
customers have spent waiting 
for an agent response in the 
past hour.

Platform Analytics Solution  for Advanced Work Assignment

This Platform Analytics Solution  contains preconfigured dashboards. These dashboards contain 
actionable data visualizations that help you improve your business processes and practices.

Enabling Platform Analytics Solutions

Use the Performance Analytics  widgets on the dashboard to visualize data over time, analyze 
your business processes, and identify areas of improvement. With solutions, you can get value 
from Performance Analytics  for your application with minimal setup.

Note: 
Solutions include some dashboards that are inactive by default. You can activate these 
dashboards to make them visible to end users according to your business needs.

For unlimited access to all features of this Platform Analytics Solution, purchase a 
Performance Analytics  subscription. For more information, see Activating your Performance 
Analytics subscription .

To enable a solution for Advanced Work Assignment, an admin navigates to System Definitions 
> Plugins  and activates the Performance Analytics - Content Pack - Advanced Work Assignment 
plugin.

 Virtual Agent Academy: Using analytics to optimize Advanced Work Assignment  Watch this 
video for more information about the Platform Analytics Solution for Advanced Work Assignment.

Related topics

Platform Analytics Solutions  

Activate your Performance Analytics subscription

Advanced Work Assignment  dashboard for interactions

Enable managers to monitor Interaction [interaction] work items so that their agents can better 
support customer needs.

This dashboard is available in the Performance Analytics - Content Pack - Advanced Work 
Assignment plugin. For information on activating the content pack, see Platform Analytics 
Solution for Advanced Work Assignment.
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AWA  dashboard for Interactions

End users and roles

End user and goal Required role

AWA  administrator: Configures Advanced 
Work Assignment  to best fit the business 
needs of customer service.

awa_admin

AWA  manager: Identifies the areas of concern 
for routing and assignment of work items 
across service channels.

awa_manager

Agent manager: Manages agents or agent 
groups. The agent manager needs to know 
what agents are working on to make sure 
customer needs are being met.

sn_customerservice_manager

Performance Analytics  administrator: Ensures 
that business managers are making the best 
use of Performance Analytics  solutions.

pa_admin or pa_viewer

Use case

This dashboard provides support managers with an overview of incoming work items and the 
availability of agents to handle them. Managers can monitor these daily trends to determine if 
adjustments should be made to the routing criteria, agent capacity values, and other settings 
that determine how work is pushed to agents.

Indicators

Indicators define a performance measurement taken at regular intervals of a business service, an 
activity, or organizational behavior.
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Indicator Description

New Work Items Total number of work items that were created 
today. The goal for this indicator is to minimize 
the number of interaction work items that 
agents receive.

Accepted Work Items Percentage of all interaction work items that 
agents have accepted in the past hour.

Exceeding Target Work Items Percentage of all interaction work items that 
have exceeded the target wait time.

Rejected Work Items Percentage of all interaction work items that 
agents have rejected.

Timed Out Work Items Percentage of all interaction work items that 
timed out.

Auto-Assigned Work Items Percentage of all interaction work items that 
were automatically assigned.

Weekly Trends Number of work items in each of the following 
states for the past week:

• New

• Exceeding Target

• Abandoned

• Rejected

• Timed Out

• Auto-Assigned

Breakdowns

To analyze data according to different categories, select a breakdown from the dashboard menu:

• Service Channel

• Queue

For more information on analyzing data with breakdowns, see Using breakdowns on 
dashboards .

Data visualizations

Title Type Description

Accepted Work Items 
- Last Hour

Single Score

Number of interaction 
work items that 
agents have accepted 
in the past hour.
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Title Type Description

Abandoned Work 
Items - Last Hour

Single Score

Number of interaction 
work items that 
agents have 
abandoned in the 
past hour.

Average Wait Time - 
Last Hour

Single Score

Average amount of 
time that customers 
have spent waiting for 
an agent response in 
the past hour.

Advanced Work Assignment  dashboard for operations

Enable managers to monitor work items across all service channels so that their agents can 
better support customer needs.

This dashboard is available in the Performance Analytics - Content Pack - Advanced Work 
Assignment plugin. For information on activating the content pack, see Platform Analytics 
Solution for Advanced Work Assignment.

AWA  dashboard for Operations - Overview

The Overview tab of the Operations dashboard displays information across all 
queues, teams, and channels.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4584



AWA  dashboard for Operations - Queue Manager

The Queue Manager tab of the Operations dashboard displays overall queue 
information. You can select the queue you want to look at from the left-hand panel.

AWA  dashboard for Operations - Team Manager

The Team Manager tab of the Operations dashboard displays information at a group 
level. You can select the group you want to look at from the left-hand panel.
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AWA  dashboard for Operations - Channel Owner

The Channel Owner tab of the Operations dashboard displays overall channel data, 
depending on the service channel you select from the drop-down list.

End users and roles

End user and goal Required role

AWA  administrator: Configures AWA  to best fit 
the business needs of customer service.

awa_admin

AWA  manager: Identifies the areas of concern 
for routing and assignment of work items 
across service channels.

awa_manager

Agent manager: Manages agents or agent 
groups. The agent manager wants to know 
what agents are working on to make sure that 
customer needs are being met.

sn_customerservice_manager

Performance Analytics  administrator: Ensures 
that business managers are making the best 
use of Performance Analytics  solutions.

pa_admin or pa_viewer

Use case

This dashboard provides support managers with an overview of incoming work items and the 
availability of agents to handle them. Managers can monitor these daily trends to determine if 
adjustments should be made to the routing criteria, agent capacity values, and other settings 
that determine how work is pushed to agents.

Breakdowns

Breakdowns divide information into different categories. To analyze data according to different 
categories, select a breakdown from the dashboard menu:
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• Service Channel

• Queue

For more information on analyzing data with breakdowns, see Using breakdowns on 
dashboards .

Data visualizations

Title Type Description

Work Items Waiting Single 

Score

Work items that are pending 
accept or queued.

Available Agents Single 

Score

Number of agents that are 
available.

Accepted Work Items (Today) Single 

Score

Number of operation work 
items that agents accepted 
today. This includes auto-
assigned work items that are 
accepted.

Average Wait Time (Today) Single 

Score

Average time it takes for an 
agent to accept a chat in the 
queue today.

Timed out Work Items (Today) Single 

Score

Work items that have timed 
out today.
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Title Type Description

Rejected Work Items (Today) Single 

Score

Work items that were rejected 
but not timed out.

Presence State of Agents Distribution of agents across 
different presence states.

Agent Presence & Capacity Count and list of agents in 
an assignment group with 
their current presence state, 
time since the user entered 
in the current presence state, 
and capacity in use for each 
channel.

• Agent

• Current presence state

• Updated

• Channel

• Capacity in use

• Applied Max Capacity

• Universal Capacity In Use

• Max Universal Capacity

Advanced Work Assignment  dashboard for tasks

Enable managers to monitor Task [task] work items so that their agents can better support 
customer needs.

This dashboard is available in the Performance Analytics - Content Pack - Advanced Work 
Assignment plugin. For information on activating the content pack, see Platform Analytics 
Solution for Advanced Work Assignment.
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AWA  dashboard for Tasks

End users and roles

End user and goal Required role

AWA  administrator: Configures Advanced 
Work Assignment  to best fit the business 
needs of customer service.

awa_admin

AWA  manager: Identifies the areas of concern 
for routing and assignment of work items 
across service channels.

awa_manager

Agent manager: Manages agents or agent 
groups. The agent manager needs to know 
what agents are working on in order to make 
sure customer needs are being met.

sn_customerservice_manager

Performance Analytics  administrator: Ensures 
that business managers are making the best 
use of Performance Analytics  solutions.

pa_admin or pa_viewer

Use case

This dashboard provides support managers with an overview of incoming work items and the 
availability of agents to handle them. Managers can monitor these daily trends to determine if 
adjustments should be made to the routing criteria, agent capacity values, and other settings 
that determine how work is pushed to agents.

Indicators

Indicators define a performance measurement taken at regular intervals of a business service, an 
activity, or organizational behavior.
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Indicator Description

New Work Items Total number of task work items that were 
created today. The goal for this indicator is to 
minimize the amount of task work items that 
agents receive.

Accepted Work Items Percentage of all task work items that agents 
have accepted.

Auto-Assigned Work Items Percentage of all task work items that were 
automatically assigned.

Exceeding Target Work Items Percentage of all interaction work items that 
have exceeded the target wait time.

Timed Out Work Items Percentage of all interaction work items that 
timed out.

Rejected Work Items Percentage of all interaction work items that 
agents have rejected.

Weekly Trends Number of work items in each of the following 
states for the past week:

• New

• Exceeding Target

• Abandoned

• Rejected

• Timed Out

• Auto-Assigned

Breakdowns

To analyze data according to different categories, select a breakdown from the dashboard menu:

• Service Channel

• Queue

For more information on analyzing data with breakdowns, see Using breakdowns on 
dashboards .

Data visualizations

Title Type Description

Average Task Wait Time - Last 
Hour

Single 

Score

Average amount of time in the 
past hour that customers have 
spent waiting for an agent 
response.
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Advanced Work Assignment  dashboard for messaging

Enable managers to monitor Conversation [interaction] work items so that their agents can better 
support customer needs.

This dashboard is available in the Performance Analytics - Content Pack - Advanced Work 
Assignment plugin. For information on activating the content pack, see Platform Analytics 
Solution for Advanced Work Assignment.

AWA  dashboard for Messaging

End users and roles

End user and goal Required role

AWA  administrator: Configures Advanced 
Work Assignment  to best fit the business 
needs of customer service.

awa_admin

AWA  manager: Identifies the areas of concern 
for routing and assignment of work items 
across service channels.

awa_manager

Agent manager: Manages agents or agent 
groups. The agent manager needs to know 

sn_customerservice_manager
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End user and goal Required role

what agents are working on to make sure 
customer needs are being met.

Performance Analytics  administrator: Ensures 
that business managers are making the best 
use of Performance Analytics  solutions.

pa_admin or pa_viewer

Use case

This dashboard provides support managers with an overview of incoming work items and the 
availability of agents to handle them. Managers can monitor these daily trends to determine if 
adjustments should be made to the routing criteria, agent capacity values, and other settings 
that determine how work is pushed to agents.

Indicators

Indicators define a performance measurement taken at regular intervals of a business service, an 
activity, or organizational behavior.

Indicator Description

Abandon Rate Percentage of conversations that have been 
abandoned by the requestor.

Data visualizations

Title Type Description

Active Conversations Single 

Score

Agent Chat messaging 
conversations that are not 
Closed Complete or Closed 
Abandoned and are not 
cancelled.

Unassigned Conversations Single 

Score

Agent Chat messaging 
conversation that is in a 
pending accept or queued 
state.

In Progress Conversations Single 

Score

Agent Chat messaging 
conversation that is on hold, 
new, or work in progress.
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Title Type Description

Average Wait Time - Last 24 
Hours

Single 

Score

Average time it takes for an 
agent to accept a chat in the 
queue today.

Consumer Average Response 
Time - Past Month

Single 

Score

Messaging conversation that 
is Closed Complete or Closed 
Abandoned and is assigned 
and the requester average 
response time is not empty 
and it was created after one 
month.

Time To First Response - Last 
24 Hours

Single 

Score

Inbound messaging 
conversation where the first 
response wait time is not 
empty and it was created after 
24 hours.

Customer Satisfaction - Past 
Month

Single 

Score

Customer satisfaction score 
over the past month

Service Level Single 

Score

• Type

• Service Channel

• Queue

• Service Level

Agent Presence & Capacity • Agent

• Current presence state

• Updated

• Channel

• Capacity in use

• Applied Max Capacity

• Universal Capacity In Use

• Max Universal Capacity
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Title Type Description

Average Handling Time - Last 
24 Hours

Single 

Score

Average time of the 
interactions handling duration 
in the last 24 hours.

Agent Average Response 
Time - Last 24 Hours

Single 

Score

Average agent response time 
in the last 24 hours.

Advanced Work Assignment  reference

The following sections detail the installed components and properties for Advanced Work 
Assignment  (AWA), along with domain separation and performance statistics information.

Assignment Rule form

When creating or changing an Advanced Work Assignment  assignment rule, the Assignment 
Rule form contains the following fields.

Assignment Rule form

Field Definition

Name Name of the assignment rule.

Application Name of the application to which this 
assignment rule belongs. The default 
application is Global.

Short description Brief description of the assignment rule.

Assign by Type of assignment. Select one of the 
following values:

• Last Assigned: Routes a work item to the 
agent who has gone the longest without 
being assigned work.

• Most Capacity: Routes a work item to the 
agent who has the greatest availability for 
handling the work.

Auto-assign handling Work items are automatically accepted without 
agents having to select Accept  or Reject.

• Enable auto-assign work items: Select this 
option to have work items automatically 
accepted on behalf of agents. Agents are 
unable to manually Accept  or Reject  work 
items.
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Assignment Rule form  (continued)

Field Definition

• Display options: Select one of the following 
values:

◦ Select Inbox card  to accept the chat 
interactions and add them to the agent 
inbox. Agents can open the accepted 
interaction from the inbox.

◦ Select Inbox card and workspace tab  to 
accept chat interactions and open a tab 
for each accepted interaction.

Rejection handling Work items are rejected and handled.

• Allow agents to reject: Enable agents to 
reject work items in their inbox.

• Reassign on timeout: Enable reassignment 
of work items not accepted or rejected by 
agents within the specified timeout period:

◦ Timeout value (Days and Hours, Minutes, 
Seconds): Length of time allowed for 
an agent to accept or reject a work item 
before the assignment times out (ends) 
and is reassigned to another agent.

◦ Timeout presence state: Agent availability 
state after the timeout occurs: Available, 
Away, or Offline.

This tab isn't available when auto-assign 
handling is activated.

Skill handling Skill-based work assignments.

• Enable skills: Route work items to agents 
with the appropriate skills. When selected, 
the Evaluate skill level  and Enforce 
mandatory skills  check boxes appear 
cleared.

• Evaluate skill level: Route work items to the 
most qualified agents based on their skill 
level.

• Enforce mandatory skills: Route work items 
to agents with required skills.

Shift handling Work items are assigned to agents based on 
shifts.
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Assignment Rule form  (continued)

Field Definition

• Enable-shift based assignment: Assign work 
items to agents based on time available in 
their shifts.

• Add time constraints: Add the time required 
to complete work items in shifts and whether 
agents should be continuously available for 
the required time period.

This field appears only when the Enable 
shift-based assignment  option is selected.

• Agent criteria: Select an agent based on the 
time left in the agent's shift.

This field appears only when the Enable 
shift-based assignment  option is selected.

Available options:

◦ Least time left in shift: Assign a work item 
to an agent from a group of available 
agents based on the least amount of time 
available in their shifts.

◦ Most time left in shift: Assign a work item 
to an agent from a group of available 
agents based on the maximum time 
available in their shifts.

• Time required: Time required to complete a 
work item.

• Available continuously for the required 
time: Assign work items to agents who are 
continuously available for the required time 
period without any breaks in a shift. Agents 
who don’t have the minimum time required 
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Assignment Rule form  (continued)

Field Definition

in their shifts aren’t considered for work item 
assignments.

Note: 
The Shift handling  field is available 
only if the Advanced Work Assignment 
plugin (com.glide.awa) is activated 
and the Workforce Optimization 
for Customer Service plugin 
(com.snc.wfo.csm) or the Workforce 
Optimization for ITSM plugin 
(com.snc.wfo_itsm) plugin, or both, 
is activated. As a manager, you 
must have planned schedules for 
agents to assign them shifts. For 
more information, seeScheduling in 
Workforce Optimization for Customer 
Service  andScheduling in Workforce 
Optimization for ITSM .

This field appears only when the Add time 
constraints  option is selected.

Domain separation and Advanced Work Assignment

Domain separation is supported in the Advanced Work Assignment  feature. Domain separation 
enables you to separate data, processes, and administrative tasks into logical groupings called 
domains. You can control several aspects of this separation, including which users can see and 
access data.

Support level: Standard

• Includes all aspects of Basic  level support.

• Application properties are domain-aware as needed.

• Business logic: The service provider (SP) creates or modifies processes per customer. The use 
cases reflect proper use of the application by multiple SP customers in a single instance.

• The instance owner must configure the minimum viable product (MVP) business logic and data 
parameters per tenant as expected for the specific application.

Sample use case: An admin must be able to make comments required when a record closes for 
one tenant, but not for another.

For more information on support levels, see Application support for domain separation .

Overview

Advanced Work Assignment  enables the automatic assignment of work items to qualified agents 
using work item queues defined for specific service channels. Managed Service Providers can 
create domain-specific queues by specifying a particular domain as a queue routing condition.
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How domain separation works in Advanced Work Assignment

When an instance has a domain hierarchy where users and groups belong to different domains, 
you may need to restrict the visibility of work items to certain agents in a domain. You may also 
need to ensure that work items are routed to agents in the proper domain. AWA  admins can 
configure service channels and associated work item queues to:

Route work by domains

To push work items to agents in domains where only certain tasks or interactions are 
visible to them, use a routing condition that routes those items to the appropriate 
queues. For example:

• To restrict a queue to only items that match exactly to a particular domain X, 
specify this condition: [Domain] [is] [X]

• To route all work items in domain X and its child domains to a queue, use the 
Domain Path  field and specify a condition such as: [Domain Path] [starts with] 
[!!!/!!#/]

Assign work to agents in the appropriate domain

To assign work items to agents in the appropriate domain, ensure that the 
assignment groups specified in the queue Eligibility Assignment pools  have agents 
that belong to the domains where they can see the work items routed to the queue.

If a mismatch occurs, and agents in an eligible assignment group cannot see a work 
item in a queue, AWA  may temporarily assign an item to an agent. However, before 
the item is moved to the agent's inbox, AWA  automatically rejects the assignment 
with the reason No access. AWA  reassigns the work item to a different agent who 
might have access. If none of the available agents can see the work item, the item 
could be rejected multiple times.

Warning: 
The item can get stuck in the queue until the AWA  admin corrects the eligible 
assignment configuration.

Related topics

Domain separation for service providers

Components installed with Advanced Work Assignment

Several types of components are installed with activation of the Advanced Work Assignment 
plugin, including tables, user roles, and scheduled jobs.

Note: 
The Application Files table lists the components that are installed with this application. 
For instructions on how to access this table, see Find components installed with an 
application .

Demo data is available for this feature.

Roles installed
AWA  adds the following roles for users who configure, manage, and receive work assignments.

Role title [name] Description Contains roles

Advanced Work 
Assignment 
administrator

Admin role for the AWA  feature. Configures and 
manages AWA.

awa_manager
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Role title [name] Description Contains roles

[awa_admin]

Advanced Work 
Assignment  developer

[awa_integration_user]

Developer role for the AWA  feature. Uses the AWA 
integration APIs.

None

Advanced Work 
Assignment  agent

[awa_agent]

Agent role for the AWA  feature. Handles customer 
interactions and manages workload across multiple 
service channels.

None

Advanced Work 
Assignment  manager

[awa_manager]

Manager role for the AWA  feature. Monitors 
performance of agents across all service channels.

None

Scheduled jobs installed

Scheduled job Description

AWA WorkItem TimeOut Job

AWA Cleanup Job

Tables installed

Table Description

AWA Agent Capacity

[awa_agent_capacity]

Stores capacity override records for agents on individual 
channels.

AWA Agent Channel Availability

[awa_agent_channel_availability]

Store the records that determine the agents available in the 
channel.

AWA Agent Presence

[awa_agent_presence]

Stores the records that define the agent availability state.

AWA Agent Presence History

[awa_agent_presence_history]

Stores records on agent presence state changes.

AWA Assignment Rule

[awa_assignment_rule]

Stores the assignment rule records used to determine the 
work items pushed to agents.

AWA Eligibility Pool

[awa_eligibility_pool]

Stores the records that define grouping of agents eligible to 
receive work items in the queue when the items have been 
rejected by agents or agents are unavailable.

AWA Group Queue Priority Stores the priority values for queues assigned to groups.
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Table Description

[awa_group_queue_priority]

AWA Inbox Layout

[awa_inbox_layout]

Defines the fields that appear on a work item card in the 
Agent Workspace  inbox.

AWA Offer Details

[awa_offer_details]

Stores whether a work item was assigned using Agent 
Affinity  and how the assignment was completed.

AWA Presence State

[awa_presence_state]

Defines presence states.

AWA Queue

[awa_queue]

Stores the work item queue records.

AWA Queue Item Sorting

[awa_queue_item_sorting]

Defines which fields in a work item for a queue you can sort 
on.

AWA Reject Reason

[awa_reject_reason]

Stores the records that define the reasons that agents use 
to decline work items assigned to them.

AWA Service Channel

[awa_service_channel]

Defines the communication channel for which work items 
may be queued.

AWA Work Item

[awa_work_item]

Stores items of work, for example, chats, cases, or incidents, 
that are routed from service channels to queues and then to 
agents.

AWA Work Item Rejection

[awa_work_item_rejection]

Stores the rejection history records for each work item.

Properties installed

Property Description

glide.awa.enabled Enables the auto assignment of work items for Advanced Work 
Assignment.

• Type: true | false

• Default value: true

• Location: System Property [sys_properties] table

com.snc.awa.cache.enabled Enables the Advanced Work Assignment cache.
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Property Description

• Type: true | false

• Default value: true

• Location: System Property [sys_properties] table

Properties for Advanced Work Assignment

The Advanced Work Assignment  Properties page provides configuration options for AWA.

If you have the admin role, you can create or change these properties by navigating to System 
Properties  > All Properties.

Properties for AWA

Property Description

AWA  Routing Look-Back Time

com.glide.awa.routinglookback

AWA  defaults to routing work items created 
within the last 10 minutes. If a work item is 
created after 10 minutes has passed, it isn’t 
considered for AWA  routing. For work items 
that are created outside of the default 10-
minute window, create this system property 
to expand the AWA  routing look-back time:

• Name: 
com.glide.awa.routinglookback

• Type: Integer

• Value: Number of seconds

For example, set the property Value  to 
86400 (24 hours) to cover a full shift for 
any missed work items.

• Description: Number of seconds 
AWA  looks back for routing 
once the work items are 
eligible for AWA.

Note: 
This property affects all service 
channels in the system.

Disable Query business rules

glide.awa.query_br_disable

If the property is enabled, AWA  disables 
before query business rules during its 
execution. For example, if enabled, an 
instance can have a custom before-query 
business rule on the interaction table 
without affecting how AWA  routes or assigns 
interactions.
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Properties for AWA  (continued)

Property Description

• Type: true | false

• Default value: true

• Location: System Properties  > All 
Properties

Bypass AWA  Queue Max Wait Time

glide.awa.bypass_max_wait_time.enabled

This property overrides the queue's max 
wait time value with the assignment rule's 
timeout value to help prevent work items 
from disappearing prematurely in an agent's 
inbox.

Enable/disable execution of subflows

glide.awa.enable_routing_subflow

Enables/disables the execution of subflows 
defined on the AWA  queues when work 
items are routed.

• Type: true | false

• Default value: false

For information on adding a system property, see Add a system property .

Advanced Work Assignment  monitoring page

Administrators (admin or awa_admin) can monitor Advanced Work Assignment  activity by 
reviewing information on the Advanced Work Assignment  Stats page.

The Advanced Work Assignment  Stats page displays AWA  performance statistics. Administrators 
can access the Advanced Work Assignment  Stats page by entering <instance_url>/
awa_stats.do  where instance_url is the base of the ServiceNow URL.

Note: 
The mean, median, max, and min statistics are representative of the particular node you are 
viewing.

Total Agent Summary

Field Description

Agent Status Overview of agent status for all assigned 
agents

Channel Summaries

Work Items

Field Description

Number Queued Number of work items currently queued

Number Pending Acceptance Number of work items currently pending 
acceptance
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Work Items  (continued)

Field Description

Number of Duplicates Number of duplicate work items (meaning 
same document id, usually from transfers)

Number Rejected Number of work items rejected

Current Number Meeting Channel Condition Number of work items with the channel 
condition met

Current Number Meeting Utilization Condition Number of work items with the current 
utilization condition met

Current Number Meeting Channel & Utilization 
Condition

Number of work items meeting both channel 
and utilization condition

Total Work Item Count Total number of work items for the given 
channel

Query Performance

Field Description

Max Query Response Time Maximum amount of time for the response of 
querying all the active and unassigned work 
items of a given channel

Min Query Response Time Minimum amount of time for the response of 
querying all the active and unassigned work 
items of a given channel

Mean Query Response Time Mean amount of time for the response of 
querying all the active and unassigned work 
items of a given channel

Median Query Response Time Median amount of time for the response of 
querying all the active and unassigned work 
items of a given channel

Total Query Count Total number of times the query for inactive/
unassigned work items has been made for the 
given channel

Record Watchers

Field Description

Record Watcher Entries Present True if the required record watchers for the 
channel exist (channel eligibility responder, 
work item responder, workload responder).

Number of Entries Triggered Number of times onEntry has been called on 
this node for the given record watcher

Number of Exits Triggered Number of times onExit has been called on 
this node for the given record watcher

Number of Changes Triggered Number of times onChange has been called 
on this node for the given record watcher
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Queues

Field Description

Total Number of Queues Total number of active queues for a given 
channel

Number of Queues in Schedule Number of queues for a given channel that are 
currently in schedule

Number of Queues Out of Schedule Number of queues for a given service channel 
that are currently out of schedule

Number of Inactive Queues Number of queues that are not marked as 
active

Agents

Field Description

Agent status overview for the given channel Number of agents with this status

Channel Breakdown

Queues

Field Description

In Schedule True if the queue is in schedule, false 
otherwise

Agents Available True if the given queue has agents available, 
false otherwise

Number of Agents Available Number of agents marked as available for the 
given queue

Number of Work Items Queued Number of work items queued for the given 
queue

Number of Work Items Pending Acceptance Number of work items pending acceptance for 
the given queue

Max Routing Time for Work Items Maximum routing time of creating a work 
item for a given record and assigning it to the 
queue

Min Routing Time for Work Items Minimum routing time of creating a work item 
for a given record and assigning it to the 
queue

Mean Routing Time for Work Items Mean routing time of creating a work item for a 
given record and assigning it to the queue

Median Routing Time for Work Items Median routing time of creating a work item for 
a given record and assigning it to the queue

Total Routing Count of Work Items Total number of work items routed to the 
queue from created records
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Advanced Work Assignment  roles

Advanced Work Assignment  (AWA) is installed with these roles.

To learn more about managing subscriptions, see Managing per-user subscriptions in 
Subscription Management  and contact your account representative.

AWA administrator [awa_admin]

The AWA  administrator configures and manages AWA.

Contains Roles

List of roles contained within the role.

• chat_survey_admin

• interaction_agent

• quickactions_user

• sn_ace.ace_user

• sn_ci_gs_content.ci_guided_setup_admin

Groups

List of groups this role is assigned to by default.

None.

Special considerations

Note: 
Avoid granting an admin role when more specialized roles are available.

AWA agent [awa_agent]

The AWA  agent handles customer interactions and manages workload across multiple service 
channels.

Contains Roles

List of roles contained within the role.

• quickactions_user

• sn_templated_snip.template_snippet_reader

Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

AWA integration user [awa_integration_user]

The AWA  integration user uses the AWA  integration APIs.
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Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

AWA manager [awa_manager]

The AWA  manager monitors the performance of agents across all service channels.

Contains Roles

List of roles contained within the role.

• interaction_agent

• quickactions_user

Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

Skills Management
Use Skills Management  to associate skills with individual users or groups and assign them to 
tasks or projects. You can also assess the skills needed for your organization, identify gaps, and 
implement effective plans for hiring or training of your teams.
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Overview

Get started

Explore

Learn how you can implement and 
manage skills for individuals or teams.

Configure

Plan and configure your implementation.

Integrate

Implement skills across your organization.

Reference

Get details about roles and extension 
points in Skills Management.

Troubleshoot and get help

• ServiceNow Community

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support
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Exploring Skills Management

Use Skills Management  to associate skills with individual users or groups and assign them to 
tasks or projects. You can also assess the skills needed for your organization, identify gaps, and 
implement effective plans for hiring or training of your teams.

Important: 
Using the Skills Management  application, you can create skills and skill categories 
manually, and also assign them manually to users. Skills Intelligence  uses Artificial 
Intelligence (AI) to help your organization leverage skills data for talent management and 
employee development. When you activate the Skills Intelligence  plugin (com.sn_skills_int), 
it also activates the Skills Management  plugin (com.snc.skills_management). For 
information on Skills Intelligence, see Skills Intelligence .

Skills can contain other skills. For example, if you define network as a skill, you can add router as 
the skill it contains. A user assigned to a parent skill grants access to a child skill. Once a skill is 
assigned to a group, all members of the group inherit that skill and any others contained within it. 
Skills management works similar to ServiceNow  platform Create a role .

Using this application, you can:

• Manage skills for agents and your employees from a central location.

• Use a standard way to identify skills for your organization and keep them up to date.

• Group skills into categories and define skill levels to track the expertise of your resources at a 
granular level.

• Reduce task or project reassignments by assigning tasks to agents and projects to teams that 
have the right skills to work on those items.

• Identify skill gaps and resolve them by implementing effective plans for coaching and training 
of resources.

• Manage the effectiveness of your team by evaluating the skills your team has and determining 
the skills you need for on your projects.

Integration with ServiceNow®  applications

A skill is an ability to do something that comes from training, experience, and practice. As a 
system administrator, you can define skills for your organization and assign it to users and groups 
from a central location. As an application manager, you can assign users to tasks based on these 
skills. For example, if you are an IT manager, you can use the Skills Management application to 
define skills and assign them to users and groups, which facilitates the routing of incidents to 
agents with relevant skills.

Group skills into categories and define skill levels to standardize skill implementation across your 
organization.

Use skills from the centralized location in the following applications:

• IT service management  - As an IT manager, reduce your time and costs while resolving 
incidents by assigning work items to the right agent. Assess the skill gaps that agents have in 
your team and coach  or train agents based on those needs. Identify and define a standard 
way to keep skill categories and levels consistent within your team.

• Customer service management  -  As a customer service manager, identify agent skills and 
automatically route tasks to agents who have the required skill to work on those tasks. Manage 
your team's effectiveness by understanding what type of skills your employees need to get 
hired or get trained to take on other roles.
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• Field service management -  As a field service or customer service manager, use rules to 
identify skills and skill levels that agents require to resolve work items such as cases, work 
order tasks, and agent interactions. Automate skill assignment to reduce a manager's work 
load. Automatically assign tasks to agents using Field Service dynamic scheduling.

• Human resources management  -  As an HR manager, identify the types of skills your 
organization needs and make hiring decisions based on those needs. Manage your team's 
effectiveness by understanding what type of skills your employees need to get hired or get 
trained to take on other roles.

• Project portfolio management  -  As a project and portfolio manager, standardize how you 
categorize skills, define skill level types, and add skill levels for your team. Set up skills for 
your team in a central location and make them available within your team. Prevent project 
reassignments by assigning projects to the team members who have the right skills to work on 
them.

Roles used in Skills Management

Role Description

Skill administrator 
[skill_admin]

• Inherits the skill manager [skill_manager] and skill user 
[skill_user] roles.

• Can perform create, read, update, and delete (CRUD) 
operations on skills, skill levels, skill level types, skill 
categories, and sub categories.

Skill manager 
[skill_manager]

• Inherits the skill user [skill_user] role.

• Can perform read operations on skills, skill levels, skill level 
types, skill categories, and sub categories.

• Can assign skills to users and groups.

Skill user [skill_user] Can perform read operations on skills, skill levels, and skill level 
types.

Activating Skills Management

The Skills Management application is activated when you enable the Skills Management 
(com.snc.skills_management) plugin.

Configuring Skills Management

Create skills, identify the type of skill level it belongs to and associate skill levels for each type to 
define skills for your users consistently across your organization and be able to assign resources 
accordingly. For example, you can add French as a skill, language as the skill level type, and 
familiar, proficient, and expert as the skill levels.

Identify all skills you currently have and would need across your organization to begin 
implementing skills. For example, if you are in Customer Service, you might have agents who 
have Java as a technical skill and you might need agents who have experience in network 
administration. If you are in Human Resources, you may have employees who have coaching as a 
skill and you might need employees who can get new hires on board.
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Associate each skill you have identified with a skill level type. For example, you could associate 
Java with programming as the skill level type and coaching with leadership as the skill level type.

Define skill levels for each type you have identified. As an example, you could use familiar, 
proficient, and expert as skill levels for the Java skill level type and beginner, intermediate, and 
advanced as the skill levels for the coaching skill level type.

Define the skill taxonomy

Organize related skills into categories and subcategories so that you can manage skills and 
create reports quickly and efficiently.

Before you begin
Role required: skill_admin

About this task
A skill category can contain parent and child categories that together create a category 
hierarchy. You can add skills to the lowest category in the hierarchy.
You can build your skill taxonomy from scratch or use the sample data provided with your 
application.

Skill Taxonomy

Procedure

1. Navigate to All  > Skills  > Skill Taxonomy.

2. In the Skills Categories  list, click New.

3. In the Name  field, enter a unique name for the category.

4. Optional:  In the Parent  field, select a parent category.

5. Right-click the form header and click Save.
The category is added to the Category Hierarchy.
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6. Add sub-categories or skills.

7. Click Submit.

Create skill categories using sample data

Onboard your team quickly using the skill taxonomy framework provided with your application.

Before you begin
Role required: skill_admin

About this task
The sample data provides 150 records that you can use to get started building your skill 
taxonomy.

Procedure

1. Activate  the Skills Library Data for Skills Management 
(com.snc.skills_management.seed_data) plugin.

2. Navigate to Skills  > Skill Taxonomy.

3. In the Skill Categories  list, review each category and set the Add skills  field to true  for all skill 
categories you want to add to your application.

Define a skill level type

Define skill levels (for example, beginner, intermediate, advanced) for different skill level types 
(for example, a language or an IT certification) so you can associate skill levels to users and 
define skill levels and types required for tasks.

Before you begin
Role required: skill_admin or admin

Procedure

1. Identify skill level types.

You can group skills that belong to the same category into a skill level type. For example, you 
could use language as the skill level type if Japanese and French are defined as skills. Take an 
inventory of every type of skill your organization needs.

2. Add skill level types, define skill levels, and associate them with a skill level type.
After you add a skill level type, you can define different levels for that type of skill. For example, 
if you add language as a type of skill, you can associate familiar, proficient, and expert as skill 
levels. When you select French, for example, as a skill for a user, you will be able to define the 
user's skill level for French as either familiar, proficient, or expert.

a. Navigate to Skills  > Skill Level Types.

b. Click New.

c. Enter a name and description for the skill level type, and then right-click the form and click 
Save.

d. Associate skill levels with this skill type.
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By default, skill level types are associated with the Default  skill level and have a value of 1. 
You can change the name and value for this default skill level. The value is used to measure 
skill gaps. For example, if you give a value of 10 for a skill level defined as proficient and a 
value of 25 for a skill level defined as expert, when you create a skill report to measure gaps, 
you will see a value of 15 as a measure for the skill gap.

3. Click Submit.

Example:
This example shows a system administrator creating the skill level type Language, adding the 
skill level Proficient to that type, and associating a value for the level.

Add a skill

Create skills to specify the competencies of your users and associate them with users, and 
configuration items.

Before you begin
Role required: skill_admin or admin

Procedure

1. Identify skills.

Take an inventory of all skills you currently have and would need across your organization. 
For example, if you are using Customer Service, you may have agents who have Java as a 
technical skill and you may need agents who have experience in network administration. If you 
are using Human Resources, you may have employees who have coaching as a skill and you 
may need employees who can get new hires on board.

2. Add skills.

You can associate each skill with other skills, users, or configuration items. You can assign 
users to tasks or projects, or identify employees with specific skills using these associations.

a. Navigate to Skills  > All Skills.

b. Click New.
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c. Enter a name and description for the skill and then right-click the form and click Save.

d. If you want to associate subskills with the skill, click the Contains Skills  tab and create a new 
skill or add an existing skill as a subskill.
The subskill is automatically inherited by the user or group that contains the associated skill.

e. Specify skills for users by clicking the Users  tab and creating a new user for the skill or 
adding existing users.

f. Associate the skill with configuration items by clicking the Model  tab and adding one or 
more configuration items.

3. Click Update.

Using Skills Management

Use the Skills Management dashboard to analyze trends in assessing skill gaps in your 
organization and plan for coaching or training of your employees based on needs. Identify users 
and teams who have the right skills to work on tasks and projects.

The Skills Management dashboard provides comprehensive reports on skill competencies 
of users, the tasks that require those skills, and skill gaps you can address to fulfill your 
organizational needs.

You can access the dashboard by navigating to Skills  > Dashboard.

Overview and Skill Matrix tab
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Skill Taxonomy

You can filter these reports based on the skill category and view reports for each 
category.

End user and roles

End user and goal Required role

As a s skills manager, you can:

• Build your teams based on the skills set your 
organization needs.

• Have visibility into skill competencies of 
employees.

• Analyze skill gaps and plan for coaching or 
training of your employees based on the 
needs.

• Identify users who have a specific skill or 
belong to specific skill categories.

• Track skill proficiencies of users over time.

• Identify key skills being used in solving your 
business needs and the users with those 
skills.

• Build learning programs based on skill 
strengths, weaknesses, preferences, gaps, 
and risks identified for your organization.

• Build teams based on skills you need to 
complete projects.

• Evaluate how effectively users solve 
business needs using their skill 

skill_manager
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End user and goal Required role

competencies and provide feedback to 
implement improvements.

• Review how efficiently work assignments are 
made based on skill levels.

• Match user skills with skills needed to 
complete work items and assign projects to 
teams based on those skills.

Data visualizations

Title Type Description

Skills Matrix

Multi-level pivot table

• View competencies for all 
users in a particular group.

• View the competency of all 
users for a particular skill in 
a group.

Top 10 skills used in the last 
six months

Bar chart

Identify the top 10 skills that 
are in use and which users 
have those skills.

Tasks associated with skills

Bar chart

View the number of tasks that 
have skills assigned to them. 
The example report shows 
data for the last six months.

Users with Skills

Bar chart

View the total number of users 
with skills assigned in each 
skill category.
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Title Type Description

Skills in Category

Bar chart

View the total number of skills 
in the selected category.

List of user skills

List of skills 
with total count of users for 
each skill

View number of users 
available for each skill.

Assigning and Managing skills

Manage skill assignment efficiently by assigning skills to users and analyze the skill coverage of 
your teams.

Note: 
The Manage skills  page uses the Next Experience  user interface. For more information on 
Next Experience, see Next Experience UI .

You can analyze your teams' skills based on a department. For example, if you select Finance 
as the department, the page displays all skills that contain Finance skill. When you select a 
department, the page displays all users from that department. You can also display all users and 
their skills based on the groups you manage.

If you want to add your own custom group types, your administrator can configure Skills 
Management extension points  to add them.

The skill matrix displays the skill coverage and skill proficiency of all users within a team. If a 
skill hasn’t been added to the user, the skill matrix displays an Add  button. You can select this 
button, add the skill, and associate a skill proficiency for the user. If a skill doesn’t have the 
proficiency defined, it displays the skill as acquired. For information on adding skills, see Assign 
skill proficiency levels for skills.

For each team, the skill coverage bar displays the number of users that have that skill and the 
number of users in each proficiency. If the skill proficiency isn’t defined, it displays the number of 
users with or without the skill.

You can select the filter icon and narrow down the display of the skill matrix using the Users, 
Skills, and Location filters.

Assign skill proficiency levels for skills

Add a skill and assign skill levels to users to facilitate the automatic assignment of skill-based 
tasks to agents.

Before you begin
Role required: skill_manager or skill_admin

About this task
Only skill administrators can create or edit skills. Skill managers can assign skills to users.
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Procedure

1. Navigate to All  > Skills  > Manage IT Skills.

2. Assign a skill level to a user or add a skill along with the skill level.

Associating skills with work items

Assign skills to tasks manually or use rules to associate them automatically to work items such as 
cases, tasks, or chat interactions.

The video below shows an overview of how skills are automatically added to work items.

Skill-based routing

Assign skills to tasks

Add skills and the level required for each skill to tasks. Identify whether the skill is mandatory to 
perform the task.

Before you begin
Role required: admin

Procedure

1. Navigate to incident, problem, change request or any task record to which you want to 
associate skills.

2. In the related list, select the Tasks Skills  tab.

Note: 
You must configure the related list and add Task Skill->Taskto the Selected  column to 
display this tab.

3. In the Task Skills table, do the following:

a. In the Skill  field, click the lookup icon and select a skill.

b. In the Skill level  field, select a level for the selected skill.

c. In the Mandatory  field, select true  if the skill is mandatory for the selected task.

4. Click Submit.
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Example:
The image below shows an administrator configuring skills for an incident 
task and adding the IT skill as mandatory for agents working on that task. 

Routing work items to agents based on skills

Use rules to automatically route work items to agents.

For more information on routing agents to work items, see Advanced work assignments

Learn how Skill Determination works

Use Skill Determination to add skills to incoming work items so that agents with those skills can 
work on it.

Skill Determination uses two rules:

• Skill Determination rule—set what skills you want to add to incoming work items.

• Business rule for Skill determination—set criteria on when a business rule must execute.

When executed, it runs on the source table defined in the Skill Determination rule, triggers the 
corresponding Skill Determination rule, and adds the skills that are in the Skill Determination 
rule record to the incoming work item.

The flow chart shows a visual representation of the Skill Determination flow.
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Step Skill Determination Flow

1.
A user has an issue with their VPN connection and has created an 
incident with the short description 'VPN not working'.

The incident needs agents with Router and Switch  as well as Network 
skills to work on the task.

2. A business rule has been created on the incident table that's set to 
trigger when an incident is created.

3. The business rule looks up all Skill Determination rules where the 
incident table is set as the source table. The business rule then triggers 
the Skill Determination rule that has one of the conditions set as 
the[Short description] [contains] [VPN].
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Step Skill Determination Flow

The Skill Determination rule has the skills Router and Switch  as well as 
Network  skills in the Skills related list. When triggered, these skills are 
added to the incident with the short description 'VPN not working'.

Add a business rule for skill determination

Create business rules to enable agents to work on cases, work order tasks, and chat interactions. 
These rules will trigger Skill Determination rules, which will add the necessary skills to the 
respective work items. This ensures that agents have the appropriate skills to handle these tasks 
effectively.

Before you begin
Role required: admin

Enable the Skill Determination [com.snc.skill_determination] plugin.

Procedure

1. Navigate to All  > System Definition  > Business Rules.

Note: 
If you want to use the skill determination rules available by default, make sure the 
Active  field for that rule is set to true. For example, if you want to use the Skill 
determination for interaction  business rule, make sure the rule is active.

2. Select New.

3. Add details for the business rule.

Field Description

Name Descriptive name for the business rule.

Table Select the table on which you want to run this business rule for skill 
determination.

Advanced a. Enable the Advanced  check box.

b. Select the Advanced  tab.

c. In the Script  field, enter the following code:

(function executeRule(current, 
 previous /*null when async*/ ) {
    var skillUtils = new 
 sn_skill_rule.SkillDeterminationUtils();
    var skills = 
 skillUtils.determineWorkItemSkills(curren
t);
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Field Description

   
 skillUtils.assignSkillsToWorkItem(skills, 
 current);
})(current, previous);

d. In the When to run  tab, set when you want the business rule to 
execute. For more information, see Create a business rule .

4. Select Submit.

Create Skill Determination rules to assign skills to work items

Create Skill Determination rules to identify skills required by agents to work on work items and 
automatically associate them to those work items.

Before you begin
Role required: skill_admin or admin

About this task
You can automatically add a skill to a case based on the product associated with the case 
if you enable the Product to Skill mapping table (Skill Required for Model Maintenance 
[cmn_m2m_skill_model]).

A skill determination rule is created for every new skill required for a work item.

• If a skill is no longer required for a work item, deactivate or remove the rule applied for the work 
item.

• If two rules have the same skill associated with one work item and one rule evaluates the skill 
as mandatory and the other rule evaluates it as optional, then the rule that evaluates the skill 
as mandatory is always used.

The table describes the types of Skill Determination rules you could create.

Skill Determination Rule Types

Rule Type Description

Simple
Adds skills to work items based on a set of conditions 
used to evaluate the source table.

Lookup
Adds skills to work items based on selections from two 
different tables connected using one or more reference 
fields.

Advanced
Adds skills to work items using a script.

Procedure

1. Navigate to All  > Skills  > Skill Determination Rules.

2. Click New.

3. In the Name  field, enter a name for the rule.
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4. Select the Active  check box to enable the rule to assign skills to work items.

5. From the Source table  drop-down menu, select the work item source table for this rule.

6. Using the condition builder, select the conditions to evaluate the work item.

7. Create the rule.

8. Click Submit.

Qualify and rank users based on skills and skill levels

Rank users so that you can select the right users based on skills needed to complete tasks. 
Qualify users to work on tasks such as case, work order task, or chat interaction based on the 
number of skills and skill levels required to work on those tasks.

Before you begin
Role required: skill_admin

About this task
Use the UserSkillAnalyzer API  to analyze the skills and skill levels of users and the 
UserSkillRanking API  to rank and assign them to tasks. For example, when you use the Field 
Service Management application to assign agents to tasks, you can analyze and rank them 
based on their skills and skill levels using these APIs and use dynamic scheduling to assign 
them to tasks.

Note: 
You must add the Matching Skill Level Gap for Dynamic Scheduling criterion to the task 
filter to rank agents assessed based on skill gaps. For more information on adding this 
criterion, see Create a task filter

Procedure

1. Analyze the skills and skill levels users have to complete work items using the 
UserSkillAnalyzer API.

The API performs the following verification to check if users are qualified to be assigned to the 
work items:

a. If the user has all mandatory skills required to complete the work item, but does not have the 
skill level, the agent is not qualified to work on the task if the skill level is mandatory to work 
on the task.

b. If the user does not have all mandatory skills required to complete the task, the agent is not 
qualified to work on the task.

c. If the user has all skills and the skill levels required to complete the task, the agent is 
qualified to work on the task.

d. If the user has all skills required, but not mandatory to complete the task, the agent is 
qualified to work on the task.

If the user is qualified to work on the task, the API performs the following verification to analyze 
gaps in skill level and the total number of skills the users have to execute tasks based on the 
skill requirements for the work item:

a. Verifies if a work item requires a skill that does not have a level type defined.

b. Verifies if a work item requires a skill that has a level type defined but does not have the skill 
level defined.
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c. Verifies if a work item requires a skill that has the skill level defined, but the agent does not 
have the skill level defined. If the skill level is mandatory to complete the task, the user who 
does not have those skill levels will not be assigned to those tasks.

d. Verifies whether a user has all skill levels that are mandatory, but not optional, to perform a 
task.

2. Rank users qualified to complete work items using UserSkillRanking API .
The API retrieves a list of qualified users based on matching and mandatory skills and skill 
levels.

Related topics

Dynamic scheduling

Reference for Skills Management

Validate that Skills Management  still works after you make any configuration change such as 
apply an upgrade or develop an application. Copy and customize these quick start tests to pass 
when using your instance-specific data.

Skills Management  quick start tests require activating the Skills Management plugin 
(com.snc.skills_management).

Skills Management test suite

Test Description Release version

Skills MGMT: User skill level 
inheritance when user is part 
of multiple groups

Verify that the user is assigned 
the highest skill level when the 
user belongs to multiple groups 
that have been assigned the 
same skills with different skill 
levels.

New York

Skills MGMT: Add skills to 
lowest level category

Verify that skills can be added 
to the lowest level category.

New York

Skills MGMT: Create a child 
category under a parent 
category

Verify that a lower-level category 
can be created when the flag for 
Add skills  is unchecked in the 
parent category.

New York

Skills MGMT: Create a skill 
category

Verify that a skill category can 
be created on the skill category 
form.

New York

Skills MGMT: Create skill 
level type and skill levels

Define the skill level type and 
different skill levels for the type.

New York

Skill MGMT: Skill level 
inheritance from group to 
user

Verify that skill levels can be 
inherited from a group to the 
users of the group and that 
the Inherited  and Skill level 
inherited  fields are set to true.

New York

Skills MGMT: Create a skill 
from Manage IT Skills user 
interface.

Verify that you can create a skill 
from the Manage IT Skills user 
interface.

Orlando
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Skills Management test suite  (continued)

Test Description Release version

Skills MGMT: Add skills 
and skill levels to users in 
the Manage IT Skills user 
interface.

Verify that you can add skills 
and associated skill levels to 
users in the Manage IT Skills 
user interface.

Orlando

Skills MGMT: Select a skill 
and add users to the skill in 
the Manage IT Skills user 
interface.

Verify that you can select a 
skill and add the skill and 
associated skill levels to one 
or more users in the Manage IT 
Skills user interface.

Orlando

Skills MGMT: Select a skill 
that does not have a skill 
level and add users to that 
skill in the Manage IT Skills 
user interface.

Verify that you can select a skill 
that does not have a skill level 
and add the skill to one or more 
users in the Manage IT skills 
user interface.

Orlando

Domain separation and Skills Management

Domain separation is supported in the Skills Management app, and configured to apply to all 
features of the application. Separation of data is configured along with separation of logic and 
process.

Domain separation enables you to separate data, processes, and administrative tasks into 
logical groupings called domains. You can then control several aspects of this separation, 
including which users can see and access data.

Support level: Basic

• Business logic: Ensure that data goes into the proper domain for the application’s service 
provider use cases.

• The application supports domain separation at run time. The domain separation includes 
separation from the user interface, cache keys, reporting, rollups, and aggregations.

• The owner of the instance must set up the application to function across multiple tenants.

Sample use case: When a service provider (SP) uses chat to respond to a tenant-customer’s 
message, the customer must be able to see the SP's response.

For more information on support levels, see Application support for domain separation .

How domain separation works in Skills Management

Domain separation is supported in Skill Management with no explicit setup or configuration 
requirements. Skills, skill categories, skills levels can be created in separate domains, including 
the global domain. When domain separation is implemented, people with skill app roles can view 
skill information only in the domain assigned. Domain  and Domain Path  columns are available 
for all Skill tables provided with the base system. The Domain  column contains the name of the 
domain to which the event or alert belongs, and the Domain Path  column contains the unique 
domain identifier.
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Table name Description

sys_user_has_skill User skill information

cmn_skill Main skill table

cmn_skill_category Define skill categories

cmn_skill_level_type Define skill level type

cmn_skill_level Define skill level

sys_group_has_skill Group skills

cmn_skill_contains Define skills contained within skills

task_m2m_skill Task skill information

Note: 
If the domain column is not shown, click the Update Personalized List  icon and add the 
required column. You can also add the domain path column, if desired.

Use cases:

• A Skill Manager that belongs to the Acme domain creates a skill and wants to view and 
associate it to user in the Acme domain. A user must belong to the Acme domain, its parent 
domain, or the global domain to view the skill record.

• A Skill Manager that belongs to a parent domain tries to view a skill in a child domain. The user 
of a parent domain can view a skill record of the parent as well as all child domains of that 
parent.

• A Skill Manager that belongs to a parent domain wants to create/associate a skill on behalf 
of another user in the Acme domain. A user must belong to the same domain as the user for 
which the skill record is created.

• A Skill Manager wants to associate a record for an integrated application in the Acme domain. 
A user must belong to the domain of the integrated application from which a record is 
associated.

• A Skill Manager has access to multiple domains but wants to update a record with content 
within a specific domain. The domain specified for the current record drives the functionality of 
that record and reference fields.

Quick start tests for Skills Management

Validate that Skills Management  still works after you make any configuration change such as 
apply an upgrade or develop an application. Copy and customize these quick start tests to pass 
when using your instance-specific data.

Skills Management  quick start tests require activating the Skills Management plugin 
(com.snc.skills_management).

Skills Management test suite

Test Description Release version

Skills MGMT: User skill level 
inheritance when user is part 
of multiple groups

Verify that the user is assigned 
the highest skill level when the 
user belongs to multiple groups 
that have been assigned the 

New York

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4625



Skills Management test suite  (continued)

Test Description Release version

same skills with different skill 
levels.

Skills MGMT: Add skills to 
lowest level category

Verify that skills can be added 
to the lowest level category.

New York

Skills MGMT: Create a child 
category under a parent 
category

Verify that a lower-level category 
can be created when the flag for 
Add skills  is unchecked in the 
parent category.

New York

Skills MGMT: Create a skill 
category

Verify that a skill category can 
be created on the skill category 
form.

New York

Skills MGMT: Create skill 
level type and skill levels

Define the skill level type and 
different skill levels for the type.

New York

Skill MGMT: Skill level 
inheritance from group to 
user

Verify that skill levels can be 
inherited from a group to the 
users of the group and that 
the Inherited  and Skill level 
inherited  fields are set to true.

New York

Skills MGMT: Create a skill 
from Manage IT Skills user 
interface.

Verify that you can create a skill 
from the Manage IT Skills user 
interface.

Orlando

Skills MGMT: Add skills 
and skill levels to users in 
the Manage IT Skills user 
interface.

Verify that you can add skills 
and associated skill levels to 
users in the Manage IT Skills 
user interface.

Orlando

Skills MGMT: Select a skill 
and add users to the skill in 
the Manage IT Skills user 
interface.

Verify that you can select a 
skill and add the skill and 
associated skill levels to one 
or more users in the Manage IT 
Skills user interface.

Orlando

Skills MGMT: Select a skill 
that does not have a skill 
level and add users to that 
skill in the Manage IT Skills 
user interface.

Verify that you can select a skill 
that does not have a skill level 
and add the skill to one or more 
users in the Manage IT skills 
user interface.

Orlando

Related topics

Quick start tests

Extension points in Skills Management

Use extension points to calls scripts to add custom group types to manage skills.

To see a list of extension points that you can use for Workforce Optimization for ITSM, navigate 
to System Extension Points  > Scripted Extension Points. In the Extension Points list, open the 
sn_skill_cfg_page.ManageSkillsExtnPt  extension point.
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Use scripted extension points to integrate customizations without altering the core components 
in the application code. When customizing a base application, you implement the scripted 
extension points by creating the custom script includes and registering them against the 
scripted extension points.

Extension points for event types

Extension point name Description

sn_skill_cfg_page.ManageSkillsExtnPtImplement this extension point to customize the 
logic of creating users by groups for the Manage 
IT skills page.

Important: 
You can configure additional groups using the 
sn_skill_cfg_page.ManageSkillsConstants  script include. For information on 
script includes see, Script includes .

Omnichannel Callback
ServiceNow®  Omnichannel Callback  app enables other ServiceNow®  apps to display or 
announce callback options to users. The Omnichannel Callback  app is available through the 
ServiceNow®  Store.

Get started with Omnichannel Callback

Select a tile to get started with Omnichannel Callback.

Explore

Learn more about Omnichannel 
Callback and review its benefits

Configure

Configure features and 
components required to support 

agents with callback requests

Work on callback records

Learn how to work on callback records

Reference

Get additional information to configure 
and administer Omnichannel Callback

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4627

https://www.webstg.servicenow.com/docs/access?context=c_ScriptIncludes&version=washingtondc&pubname=washingtondc-api-reference&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=c_ScriptIncludes&version=washingtondc&pubname=washingtondc-api-reference&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=c_ScriptIncludes&version=washingtondc&pubname=washingtondc-api-reference&ft:locale=en-US


Troubleshoot and get help

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support

Exploring Omnichannel Callback

Learn more about Omnichannel Callback  and review its benefits.

Omnichannel Callback  overview

The Omnichannel Callback  app is a ServiceNow AI Platform®  capability that offers enhanced 
user experience by providing an option for agents to call users back rather than waiting in the 
queue for an available agent. For example, you can use the callback functionality to call users 
back when the agent wait time is long or when there are no agents available.

Callbacks are a well-received addition to any interactive voice response (IVR). You can invoke 
callbacks on any supported conversational integration channels.

Omnichannel Callback  workflow

In this workflow:

1. Users seeking help from a live agent request for a callback when the live agent is either 
unavailable or the wait time to get to a live agent is long.

2. Omnichannel Callback  determines the availability of agents via ServiceNow®  Advanced Work 
Assignment  (AWA) and places a callback work item for an available agent.

3. AWA  picks up the callback task and places it in the callback queue.

4. The agent receives a Callback  accept card. If the agent decides to close the interaction or 
requeue the callback manually, the agent can do so from the workspace.

Omnichannel Callback  benefits

Benefit Feature Users

Omnichannel Callback  creates callback work 
items for available agents via AWA  based on 
the pre-configured recurring intervals.

Recurring Callback Agents

The agent can directly call the end user.

Note: 
When an agent dials the end user 
through Click to Call, the auto-scheduled 
callback logic does not count the attempt 
toward the remaining callback attempts.

Click to Call Agents

Users requesting a callback can schedule 
by date and time based on the available 
time slots. Omnichannel Callback  provides 
the framework for the scheduled callback. 
Consumer use cases for scheduled callback 
are currently supported via Customer Service 
Management (CSM)  application only.

Scheduled callback Customers
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Benefit Feature Users

The user can request for a video callback at 
an appointed time. Currently, video callback 
is supported only via the Zoom  service and 
requires the Zoom extension for Omnichannel 
Callback  Store app. For more information, see 
Zoom extension for Omnichannel Callback.

Video callback Customers

Configuring Omnichannel Callback

Configure the Omnichannel Callback  features and components that you need to support agents 
with callback requests.

Configuration overview

Admins can enable the callback feature and configure one or more callback channels by 
navigating to Conversational Interfaces  > Settings  > General  > Omnichannel Callback  and 
clicking Manage. The callback behavior per channel can be set by configuring the following 
callback parameters: Topic, Maximum callback attempts, and the callback timeout threshold. For 
more information on how to configure the callback behavior, see Configure callback behavior for 
a channel.

The Omnichannel Callback  app includes the default Callback-Phone and Callback-General 
topics. The Callback-Phone and Callback-General topics are triggered when agents are not 
available or the agent wait time is longer than the callback threshold time, which is the average 
of the most recent AWA  queue time. You can customize the default callback topics as per your 
requirements. For more information on how to customize the callback topics, see Customize a 
default callback topic.

1. Get started with Omnichannel Callback

Review this information before you start setting up Omnichannel Callback.

2. Install Omnichannel Callback

You can install Omnichannel Callback  if you have the admin role.

3. Configure callback behavior for a channel

Configure callback behavior for a channel using the callback parameters.

4. Customize a default callback topic

Customize the default callback topic as per your requirements.

Get started with Omnichannel Callback

Review the following information before you start setting up Omnichannel Callback.

Checklist

Setup task Description

Verify that the ServiceNow  core applications 
or plugins that are required to support 
Omnichannel Callback  are installed and 
activated.

Verify that the following applications or 
plugins are installed and activated from 
the ServiceNow Store. When you activate 
the first plugin, its dependant plugins are 
activated automatically. If not installed, 

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4629



Checklist  (continued)

Setup task Description

install and activate one application at a time 
in the following order to ensure a smooth 
implementation.

• com.glide.cs

• com.glide.interaction.awa

• com.glide.cs.custom.adapter

• com.snc.appointment_booking

For more information, see Install Omnichannel 
Callback.

Verify that you have assigned the required 
ServiceNow AI Platform  roles.

The following roles are used across the 
Omnichannel Callback  features:

• The administrator (admin) installs the 
application from the ServiceNow Store  and 
assigns the roles.

• sn_omni_callback.callback_api

Install Omnichannel Callback

You can install the Omnichannel Callback  application (sn_omni_callback) if you have the admin 
role.The application includes demo data and installs related ServiceNow®  Store  applications and 
plugins if they are not already installed.

Before you begin

• Ensure that the application and all of its associated ServiceNow Store  applications have valid 
ServiceNow  entitlements. For more information, see Get entitlement for a ServiceNow  product 
or application .

• Review the Omnichannel Callback  application listing in the ServiceNow Store  for information 
on dependencies, licensing or subscription requirements, and release compatibility.

Role required: admin

About this task
The following items are installed with Omnichannel Callback:

• Roles

• Scheduled jobs

• Tables

For more information, see Components installed with Omnichannel Callback.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the Omnichannel Callback  application (sn_omni_callback) using the filter criteria and 
search bar.
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You can search for the application by its name or ID. If you cannot find the application, you 
might have to request it from the ServiceNow Store.

In the list next to the Install  button, the versions that are available to you are displayed.

3. Select a version from the list and select Install.

In the Install dialog box that is displayed, any dependencies that are installed along with your 
application are listed.

4. Optional:  If demo data is available and you want to install it, select the Load demo data  check 
box.
Demo data comprises the sample records that describe application features for the common 
use cases. Load the demo data when you first install the application on a development or test 
instance.

Important: 
If you don't load the demo data during installation, it's unavailable to load later.

5. If you're prompted, follow the links to the ServiceNow Store  to get any additional entitlements 
for dependencies.

6. Select Install.

Configure callback behavior for a channel

Configure callback behavior for a channel using the callback parameters. You can create a 
separate callback configuration for each supported conversational integration channel.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings  > General.

2. On the Callback configuration form, swipe the Activate  toggle switch to the right, enter the wait 
time threshold, and select Save.

Note: 
Ensure that the application scope of your ServiceNow  instance is set to global before 
editing the Callback configuration form.

3. Select a channel that you want to configure callback for from the Channel drop-down list.

4. Select a callback topic from the Callback Topic drop-down list.
Select Callback-Phone  for voice channels and Callback-General  for messaging or chat 
channels. These default callback topics are triggered when there are no agents available to 
take the call or when the average wait time in the queue is over the predefined threshold. You 
can also use a custom callback topic based on your requirements. For more information on 
how to customize a callback topic, see Customize a default callback topic.

5. Provide the Max callback attempts.
After the maximum number of callback attempts is reached, the callback task is closed and no 
further callback attempts are made.

6. Provide the Callback timeout (threshold (in hours).
When the callback timeout is reached, no further callback attempts are made and the callback 
task is closed.
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Customize a default callback topic

Customize the default callback topics as per your requirements.

Before you begin
Role required: admin

About this task
You can customize one of the following default callback topics: Callback-Phone for voice 
channels and Callback-General for messaging or chat channels. The following procedure 
explains how to customize the Callback-Phone topic.

Procedure

1. Duplicate the Callback-Phone topic from the Virtual Agent Designer.
For more information on how to duplicate a topic, see Duplicate a Virtual Agent topic.

2. In the Advanced properties section of the Properties  tab, select the voice channel that you 
want to associate with the custom callback topic.

3. On the Flow  tab, modify the default callback flow and set the following properties in the Script 
action utility, if required.

a. Set Global Callback Executed (vaVars.global_callback_executed) to true.

b. Set No Agent Available (vaVars.global_show_no_agent_available_msg) to false.

c. Set the following properties in the Create Callback Task node.

▪ Set Global Callback Executed (vaVars.global_callback_executed) to true.

▪ Set No Agent Available (vaVars.global_show_no_agent_available_msg) to false.

▪ Callback Number (callback_number): Required field to be populated with the number on 
which the user requested a callback. This number may be the number that the user is 
calling from or the dialed number.

▪ Short description (short_description): User issue description.

▪ Initial Interaction (initial_interaction): Interaction detail from which the callback task has 
been initiated.

▪ Max Retry Attempts (max_retry_Attempts): Maximum retry attempts after which the 
callback task is closed.

▪ Expire Time (expire_time): Callback timeout after which the callback task is closed.

▪ Messaging Channel (messaging_channel): Messaging channels configured for use. If not 
provided, the default callback channel is used.

▪ Scheduled (scheduled): Set to true  to make the callback task eligible for auto callback.

4. Save and publish your custom callback topic by clicking Save  and Publish.

5. Map the custom callback topic to the voice service provider.

a. Fetch the sys_id of your custom callback topic from the Topics [sys_cs_topic] table.

b. Select your voice service provider from the Provider Channel Identities 
[sys_cs_provider_application] table.

c. On the Provider Identity Properties  tab, update the value of the callback_topic_id  property 
with the sys_id of your custom callback topic and click Update.
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Working on callback records

Use Workspace  to work on callback records originating from Omnichannel Callback.

Agents can work on the records for the following callback scenarios.

• Recurring callback: AWA  routes a callback work item to an available agent based on the 
predefined callback attempt interval. The agent then receives a Callback  work item. When 
the agent accepts the callback work item, auto-dial initiates a call to the user. Based on the 
resolution, the agent can either close the interaction or requeue the callback.

• Click to call: The agent can directly call the end user using the phone icon in the interaction 
record if auto-dial is not enabled or the initial call did not succeed.

• Scheduled voice callback: When a user requests a voice callback at their preferred 
date and time, an interaction record with callback details is created a minute before 
the scheduled call time and an agent receives the callback work item. When the agent 
accepts the callback work item, auto-dial initiates a call to the user. Based on the 
outcome, the agent can either close the interaction as Closed Complete  or Closed 

Abandoned.

• Scheduled video callback: When a user requests a video callback at their 
preferred date and time, an interaction record with callback details is created 
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which includes a URL to initiate the video call. Based on the outcome, 
the agent can either close the interaction as Closed Complete  or Closed 

Abandoned.

Omnichannel Callback reference

Reference topics provide additional information that you can use to configure and administer 
Omnichannel Callback.

Components installed with Omnichannel Callback

Several types of components are installed with activation of the Omnichannel Callback  plugin, 
including user roles, scheduled jobs, and tables.

Scheduled jobs installed

Scheduled job Description

Callback Scheduler - 
Scheduled Executes the callback task of type Scheduled a minute before the 

scheduled start time.

Callback Scheduler - 
Recurring Executes the callback task of type Recurring after creation of the 

callback task or at the next retry attempt.

Omnichannel 
Callback  Close 
expired tasks

Marks the callback tasks as Closed Abandoned in the following 
scenarios.

• Recurring callback: If the current time is past the expiry time or the 
number of callback attempts exceeds the maximum retry attempts.

• Scheduled callback: When the callback task is not closed one hour 
after the scheduled end time.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4634



Tables installed

Table Description

Callback Properties

[sn_omni_callback_st_callback_properties]

Lists the callback properties that determine the 
callback behavior.

Callback

[sys_cs_callback]

Lists the callback tasks of type Scheduled and 
Recurring.

Roles installed
To learn more about managing subscriptions, see Managing per-user subscriptions in 
Subscription Management  and contact your account representative.

Callback API [sn_omni_callback.callback_api]

Read/write from the [sys_cs_callback] table and access all the APIs provided by the 
Omnichannel Callback  app.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

Domain separation and Omnichannel Callback

Domain separation is supported for Omnichannel Callback. Domain separation enables you to 
separate data, processes, and administrative tasks into logical groupings called domains. You 
can control several aspects of this separation, including which users can see and access data.

Support level: Standard

• Includes all aspects of Basic  level support.

• Application properties are domain-aware as needed.

• Business logic: The service provider (SP) creates or modifies processes per customer. The use 
cases reflect proper use of the application by multiple SP customers in a single instance.

• The instance owner must configure the minimum viable product (MVP) business logic and data 
parameters per tenant as expected for the specific application.

Sample use case: An admin must be able to make comments required when a record closes for 
one tenant, but not for another.
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For more information on support levels, see Application support for domain separation .

Overview

Domain separation enables you to partition your organization's data and administrative control 
into separate domains. This lets you isolate data and control access to it, which is particularly 
important in environments where multiple tenants share a common platform.

How domain separation works in Omnichannel Callback

Domain separation in Omnichannel Callback  works by routing callback requests to domain-
specific available agents.

When using domain separation for Omnichannel Callback, keep the following points in mind.

• Domain separation applies to both the agent and the customer requesting for a callback. This 
means that agents will only be able to access interactions records that are created under the 
domain of the user requesting the callback.

• The agent should be in the same domain as the user to receive a callback request in the 
workspace.

• No configuration is required for domain separation for Omnichannel Callback.

Domain separated tables

The sys_cs_callback table is domain separated.

Use cases

When domain separation is used, a callback request from guest users is routed to the agent 
with the same domain as the guest user. For custom chat channels, the domain of the provider 
application is used as a reference to route the callback to the domain-specific agent.

Related topics

Domain separation for service providers

Zoom extension for Omnichannel Callback
The ServiceNow®  Zoom extension for Omnichannel Callback  application enables other 
ServiceNow®  applications to display a Zoom  callback option to users. The Zoom extension for 
Omnichannel Callback  application is available through the ServiceNow®  Store.

Overview

The Zoom extension for Omnichannel Callback  app is a ServiceNow AI Platform®  capability that 
enables users to request a callback over Zoom  when the agent wait time is long, or agents are 
unavailable. Agents and users can collaborate over a Zoom  meeting at a date and time requested 
by users.

Features

Zoom extension for Omnichannel Callback  offers the following capabilities:

• Allows users to request a video callback from omnichannels such as Virtual Agent, 
Engagement Messenger, portals, and chats.

• Enables agents and users to collaborate to resolve an issue.
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• Enables agents to join a Zoom  meeting from an interaction record.

• Imports the Zoom  meeting transcript to the interaction record. The inserted transcripts are not 
sentiment analyzed.

• Imports the Zoom  meeting recording URL to the interaction record.

• Displays the names of participants who attended the meeting.

• Marks the interaction Close complete when the following conditions are met:

◦ Both the participants joined the meeting.

◦ The Zoom  meeting has ended.

Install Zoom extension for Omnichannel Callback

You can install the Zoom extension for Omnichannel Callback  application 
(com.sn.zoom.callback) if you have the admin role.

Before you begin

• Ensure that the application and all of its associated ServiceNow Store  applications have valid 
ServiceNow  entitlements. For more information, see Get entitlement for a ServiceNow  product 
or application .

• Review the Zoom Extension for Omnichannel Callback  application listing in the ServiceNow 
Store  for information on dependencies, licensing or subscription requirements, and release 
compatibility.

Role required: admin

About this task
The following items are installed with Zoom extension for Omnichannel Callback:

• Script includes

• Business rules

For more information, see Components installed with Zoom extension for Omnichannel Callback.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the Zoom extension for Omnichannel Callback  application (com.sn.zoom.callback) using 
the filter criteria and search bar.

You can search for the application by its name or ID. If you cannot find the application, you 
might have to request it from the ServiceNow Store.

In the list next to the Install  button, the versions that are available to you are displayed.

3. Select a version from the list and select Install.

In the Install dialog box that is displayed, any dependencies that are installed along with your 
application are listed.

4. If you're prompted, follow the links to the ServiceNow Store  to get any additional entitlements 
for dependencies.

5. Optional:  If demo data is available and you want to install it, select the Load demo data  check 
box.
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Demo data comprises the sample records that describe application features for the common 
use cases. Load the demo data when you first install the application on a development or test 
instance.

Important: 
If you don't load the demo data during installation, it's unavailable to load later.

6. Select Install.

Components installed with Zoom extension for Omnichannel Callback

Several types of components are installed with the Zoom extension for Omnichannel Callback 
application.

Script includes

Zoom extension for Omnichannel Callback  script includes

Script include Description

ZoomCallDatabase Contains database-related functions.

ZoomCallDriver Implements extension point for 
sn_omni_callback.VideoCallDriver.

ZoomCallEventHandler Overrides the functions of ZoomCallEventHandlerSNC.

ZoomCallEventHandlerSNC Contains utility functions for handling the transcript completed 
events.

ZoomCallTranscriptProcessor Contains utility functions to process the Zoom  transcript.

ZoomCallUtils Overrides the functions of ZoomCallUtilsSNC.

ZoomCallUtilsSNC Contains the utility functions for Zoom  callback.

Business rules

Zoom extension for Omnichannel Callback  business rules

Close 
interaction 
(Zoom Callback)

Notify Conference Call

[notify_conference_call]

Closes the interaction after the Zoom  meetings 
ends. Both the agent and the requester must join 
the call to close the interaction.

Create Notify 
Conference call 
record

Callback

[sys_cs_callback]

Creates a notify conference call record when the 
Zoom  callback is created.

Recording 
Completed 
(Zoom Callback)

Notify Recording

[notify_recording]

Stores the recording URL in the interaction when 
the recording is completed.

Update Zoom 
Host when 
agent is 
assigned

Interaction

[interaction]

Makes the agent the host when the interaction is 
accepted by the agent.
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Setting up Zoom extension for Omnichannel Callback

Enable your users to request a callback over Zoom  by integrating your  Zoom  account with the 
ServiceNow  instance. You can also enable the account to authenticate requests from your 
instance by creating a custom OAuth application in the account.

The configuration process consists of the tasks listed in the following table.

Task Description

Setting up the Zoom spoke for Zoom 
extension for Omnichannel Callback

Integrate your organization's Zoom  account with your 
ServiceNow  instance using the Zoom  spoke to create 
Zoom  meetings.

Setting up Notify Zoom connector 
for Zoom extension for Omnichannel 
Callback

Set up the Notify  Zoom  connector in Zoom  to receive the 
event information from Zoom.

Configure a Zoom webhook for 
Zoom extension for Omnichannel 
Callback

Configure a Zoom  webhook in ServiceNow  to notify the 
Zoom Extension app when certain events occur in Zoom.

Configure the Zoom channel for 
callbacks over Zoom

Enable the Zoom  callback channel and specify the host 
email address for a callback over Zoom.

Setting up the Zoom  spoke for Zoom extension for Omnichannel Callback

Enable the Zoom  spoke to perform various actions such as creating meetings, rescheduling 
meetings, deleting a meeting, or fetching the participant details from your Zoom  account by 
integrating your Zoom  account with your ServiceNow  instance.

Create a connected app in Zoom

Create a connected app in your Zoom  account to enable OAuth 2.0 authentication with the Zoom 
spoke.

Before you begin

• Ensure that you have an Integration Hub  subscription.

• Ensure that Omnichannel Callback  is installed on your instance.

• Ensure that the Zoom  spoke is activated. For more information, see Zoom spoke

Role required: Zoom  admin

Procedure

1. Log in to Zoom marketplace .

2. In the Develop  drop-down list, select Build App.

3. Choose the OAuth  card from the available cards.

4. Disable the Would you like to publish this app on Zoom App Marketplace?  option.

5. Select Create.

6. Provide a name for the app in the Name  field.

7. Set the app type to Account-level app.
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Note: 
Account-level apps must be installed by a Zoom  admin, who manage the app for all 
account users in the account.

8. Configure the redirect URLs for authentication.

a. In the App credentials section, enter the ServiceNow  instance redirect URL in the Redirect 
URL for OAuth  field in the following format:
https://<instance name>.com/oauth_redirect.do

b. In the OAuth allow list section, add the ServiceNow  instance redirect URL in the following 
format:
https://<instance name>.com/oauth_redirect.do

c. Record the values of the Client ID  and Client Secret  fields to use them for the application 
registry.

9. In the left panel, select Scopes.

10. In the Add Scopes section, select Add Scopes.

11. On the Add Scopes  dialog box, select the scope type.

12. Select the Meeting  scope type.

13. Select the following scopes:

◦ View all user meetings

◦ View and manage all user meetings

14. Select the Recording  scope type.

15. Select the following scopes:

◦ View all user recordings

◦ View and manage all user recordings

16. Select the User  scope type.

17. Select the View all user information  scope.

18. Select Done.

Result
The actions under the selected scopes become available to the Zoom  spoke.

Configure a Zoom connection in ServiceNow  instance

Use the information generated during Zoom  account configuration to register the Zoom  spoke as 
an OAuth provider and allow the instance to request OAuth 2.0 tokens.

Before you begin
Role required: admin

Procedure

1. From your ServiceNow  instance, navigate to Process Automation  > Flow Designer.

2. In the Flow Designer, select the Connections  tab.

3. Search for the Zoom  connection and select View Details.
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4. On the Zoom connection card, select Edit.

5. On the form, fill in the fields.

Field Description

Connection Name Name to identify the connection record.

Connection URL Base URL to connect to your Zoom instance: 
https://api.zoom.us.

OAuth Entity Name Name to identify the application registry 
record.

OAuth Client ID Client ID created during application 
registration.

OAuth Client Secret Client secret created during application 
registration.

OAuth Redirect URL OAuth callback endpoint: https://
instance name.service-now.com/
oauth_redirect.do.

6. Select Edit and Get OAuth Token.
A confirmation message is displayed that the token is available.

Setting up Notify  Zoom  connector for Zoom extension for Omnichannel Callback

Setting up the Notify  Zoom  connector in Zoom  and then in your ServiceNow  instance enables 
your instance to receive the event information from Zoom. An event is usually any action that is 
related to a meeting.

Note: 
Currently, only the Zoom  recording URL without passcode is stored in the interaction. You 
can configure the Zoom  account to disable the passcode option.

Configure the Notify  Zoom  connector in Zoom

Configure the Notify  Zoom  connector in Zoom  to receive event information in your ServiceNow 
instance from Zoom.

Before you begin

• Ensure that Notify  Zoom  Connector and Omnichannel Callback  are installed on your instance.

• Ensure that you have the Zoom spoke  installed on your instance.

• Make sure you have the required credentials for and connections to Zoom  on your instance.

• The Notify  Zoom  connector must have been configured with the same Zoom  account with 
which you created the OAuth app for the Zoom  spoke.

Role required: admin, Zoom admin

Procedure

1. On your Zoom  OAuth app, navigate to Feature  > Add Feature  > Event Subscription.

2. Enable the event subscription feature.

3. Select Add Event Subscription  to add the first event subscription.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4641



4. Enter the URL to be used to post information about events in Zoom  to your instance:
https://<instance name>.com/api/sn_notify_zoom/notify_zoom/
ZoomEvent

5. Select the Add Events  button.

6. Select Meeting  and then select the following meetings from the list:

◦ Start Meeting

◦ End Meeting

◦ Participant/Host joined meeting

◦ Participant/Host left meeting

7. Select Recording  and then select All Recordings have completed  from the list.

8. Select Done.

9. On the Add feature screen, select Save  to save the event subscription configuration.

10. Select Add Event Subscription  to add a second event subscription.

11. In the form, enter the URL used to post information about events in Zoom  to your instance:
https://<instance name>.com/api/sn_zoom_spoke/
zoom_webhook_endpoint/webhook

12. Select the Add Events  button.

13. Select Recording  and then select Recording Transcript files have completed  from the list.

14. Select Done.

15. In the Add feature section, select Save  to save the event subscription configuration.

16. In the Token section, select Copy  to record the verification token to be used during 
configuration of the Notify  Zoom  connector.

Configure the Notify  Zoom  connector in ServiceNow

Configure Notify  in your ServiceNow  instance to receive event information from Zoom.

Before you begin
You must have copied the verification token displayed during the configuration of the Notify 
Zoom  connector in Zoom.

Role required: admin

Procedure

1. Navigate to All  > Notify  > Zoom  > Configuration.

2. Paste the verification token in the Webhook validation token  field.

3. Select Update.

What to do next
Configure a Zoom webhook for Zoom extension for Omnichannel Callback

Configure a Zoom  webhook for Zoom extension for Omnichannel Callback

Configure a Zoom  webhook in ServiceNow  to notify the Zoom extension for Omnichannel 
Callback  app when certain events occur in Zoom.

Before you begin
You must have copied the verification token displayed during the configuration of the Notify 
Zoom  connector in Zoom.
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Role required: admin

Procedure

1. Navigate to All  > Zoom Spoke  > Zoom Webhook Registries.

2. Select Zoom Callback Transcript completed  from the list.

3. Paste the verification token for validating event notifications in the Token  field.

4. Select Update.

Configure the Zoom  channel for callbacks over Zoom

Allow agents to call users back over Zoom  by enabling the Zoom  callback channel and specifying 
the host email address.

Before you begin
Role required: admin

Procedure

1. Navigate to All, and then enter sys_cs_channel.list  in the navigation filter.

2. On the Messaging Channels form, select the Zoom  channel.

3. If you are prompted in a message at the top of the form to switch applications to be able to edit 
the record, select the word here.

4. In the Channel Properties section, configure the channel properties.

◦ Set the enabled  property to true.

◦ In the host_email  property, enter the email with which the meetings should be created.

5. Select Update.

Proactive Triggers
Proactive Triggers  supports end users by providing helpful platform actions, using real-time data. 
Admin users can customize rules and actions to present rich text pop-up messages to specific 
users.

Overview

For an introduction to Proactive Triggers  and to get familiar with the product, watch this video. 
Proactive Triggers high-level overview of the product

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .
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Get started

Explore

Learn about Proactive Triggers
concepts and process flows.

Install

Activate the Proactive Triggers feature.

Configure

Manage and set up rules and actions 
for Proactive Triggers to determine 

when the triggered messages display to 

end users on the ServiceNow®  portal.

Reference

Get component details 
for Proactive Triggers.

Exploring Proactive Triggers

Proactive Triggers  is a ServiceNow®  Store application that is available to all Virtual Agent  web 
client and Agent Chat  customers by default. Proactive Triggers  can increase adoption of Virtual 
Agent  by proactively sending context-specific messages to end users.

Proactive Triggers  overview

The Proactive Triggers  rich text pop-up messages provide users with actions according to real-
time Proactive Triggers  data. When end users engage with the Proactive Triggers  message, the 
Virtual Agent  opens. If there’s a Virtual Agent  topic, associated with the action, the topic runs. 
If buttons are presented to end users (a maximum of three), they can select the most relevant 
button to run the associated Virtual Agent  topic. Proactive Triggers  can be used with LLM topics 
if Now Assist  in Virtual Agent  is set up. Proactive Triggers  can also be used with Agent Chat  to 
connect customers to a live agent in configurations without Virtual Agent. For more information 
about the Proactive Triggers  process, see How Proactive Triggers work.

Proactive Triggers  admins use Proactive Triggers  rules to define when, where, and how to engage 
with customers. Proactive Triggers  actions define what the rule does, using several key fields. 
Admins customize these rules and actions based on when and how their customers are most 
likely in need of help. For example, customers may need help when ordering equipment, opening 
an incident/case, or viewing information in a Knowledge Base  article. Proactive Triggers  rules can 
be applied to any defined URL, including any portal URL, catalog item, or external site. Proactive 
Triggers  rules can be applied to the Proactive Triggers  API after the Proactive Trigger on Search 
business rule and related trigger type, rule, and action are enabled. For additional information 
and an example of the Proactive Triggers  API script, see ProactiveTriggerAPI - Scoped .
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Proactive Triggers  examples

The Proactive Triggers  feature uses rules and related actions based on those rules to present 
messages to end users. These rules and actions are context-specific and are based on real-time 
data gathered as end users navigate across portal pages or through the Proactive Triggers  API 
call.

By default, the Proactive Triggers  feature includes these sample rules: Virtual Agent  greeting and 
Chat welcome message when a live agent is available.

See the following table for information about action type examples.

Note: 
Depending on the plugins installed, you may only see one of these rules or you may see 
other rules as well.

Default sample rules

Default sample rules Description Example

Virtual Agent  greeting This rule gives a sample 
welcome message to end 
users on a portal page. This 
message introduces the 
Virtual Agent  to both internal 
and external end users.

Chat welcome message when 
a live agent is available

This rule gives a sample 
welcome message to end 
users when the web client 
is configured for Live Agent 
only. This message introduces 
Agent Chat  to end users.

Note: 
This message appears 
only if you have the 
Advanced Work 
Assignment  (AWA) 
plugin (agent chat) 
installed.

After a rule is created, the admin creates one or more actions that are triggered by the rule. 
Actions define the messages that end users see based on the rule and the next steps available 
for the end users to take. These messages are displayed differently depending on the selected 
action type.

See the following table for information about action type examples.
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Action types

Action type Description Example

Message only End users see an HTML pop-
up message.

Message that launches a 
virtual agent topic

End users see an HTML pop-
up message that directs them 
to an available Virtual Agent 
topic.

Message that launches a 
selection of virtual agent 
topics

End users see an HTML pop-
up message with up to three 
suggested action buttons 
that direct them to a relevant 
Virtual Agent  topic.
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You can customize the appearance of the Proactive Triggers  message. For example, you can 
change the side bar color of the message. For more information about customization, see 
Configure Agent Chat in a portal .

How Proactive Triggers  work

Explore example use cases and how information flows through the Proactive Triggers  process.

Proactive Triggers  use cases

Proactive Triggers  are useful in various scenarios. Explore the following example use cases to 
determine how to use Proactive Triggers  effectively for your organization.

• An admin creates a Proactive Triggers  rule that runs when a user views a Knowledge  article 
containing the keyword “VPN” (or any other keyword that has a matching Virtual Agent  topic). 
The admin configures the rule to run the VPN Connectivity Virtual Agent  conversation, which 
proactively helps the user resolve the VPN issues.

• An admin creates a Proactive Triggers  rule that runs when a user views any catalog item with a 
short description that includes a specific keyword, such as “laptop.” The admin configures the 
rule to connect the user to a live agent, using the Live Agent Support topic, which proactively 
helps the user get assistance in ordering a laptop.

You can also use Proactive Triggers  to engage with customers in more complex scenarios. Admin 
users can create multiple rules using different delay times and different user criteria to create a 
customized user experience. For more information about configuring more complex scenarios, 
see Multiple Proactive Triggers rules and actions.

Proactive Triggers  process

1. Whenever an end user navigates to a Proactive Triggers  enabled page, Proactive Triggers 
reads the page URL or called API to determine if any Proactive Triggers  rules should run.

2. During this analysis, Proactive Triggers  determines the Trigger Type source.

Web browsing (client side) Trigger type

Knowledge Base  pages Knowledge

Service Catalog  pages Catalog Item

Portal home pages Portal Home

All other portal pages URL

System API (server side) Trigger type

Search event on portal pages Search Event

3. Next, Proactive Triggers  evaluates all the Proactive Triggers  rules for that Trigger Type one by 
one until a matching rule is found.

Note: 
Rules are created with the required fields Delay Time  and Order. During the rule 
matching process, rules are analyzed in ascending Order, according to the order number 
assigned. If the Delay Time is reached before the order number, the Delay Time takes 
precedent.
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4. After a Proactive rule has been matched, the rule's actions are evaluated one by one. This 
evaluation proceeds in ascending order, according to the Order  field in the associated 
Proactive actions. As part of this process, the Applies To  field is compared with the user 
visiting the page to determine if the action applies to this user.

5. After Proactive Triggers  identifies at least one rule and action that apply to the visiting user 
and the Delay Time has been met, a pop-up message appears directly on the web page. The 
contents of this message are configured by the admin for the matched action.

6. If the user selects the pop-up message, the chat widget opens. If the matched action is of the 
type Virtual Agent Topic, the chat widget also runs the topic configured in that action.

Installing Proactive Triggers

Enable Proactive Triggers  so that you can begin working with the feature.

Before you begin
The Proactive Triggers  feature [sn_pt] is available as an app and must be installed from the 
ServiceNow Store .  This feature is only available after you've installed and updated the Omni-
Experience Standard Feature Set to the latest version through the ServiceNow Store .

Role required: admin

About this task
The following steps provide a high-level overview of how to enable Proactive Triggers.

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings  > General.

2. Under Proactive triggers, select the Enable Proactive Triggers  field toggle switch to enable the 
feature.

3. Set the com.glide.cs.advanced-chat-popover system property to True.

Enable Proactive Triggers

Use Proactive Triggers  to create and view context-specific messages and use relevant actions on 
the web client.

Before you begin

Note: 
The Proactive Triggers  feature [sn_pt] is available as an app and must be installed from 
the ServiceNow Store. This feature is only available after you've installed and updated 
the Omni-Experience Standard Feature Set to the latest version through the ServiceNow 
Store. Subsequent updates are also available there. Visit the ServiceNow Store  website 
to view all the available apps and for information about submitting requests to the store. 
For cumulative release notes information for all released apps, see the ServiceNow Store 
version history release notes .

For conceptual information about Proactive Triggers, see Exploring Proactive Triggers.

The Proactive Triggers  feature can be used with Domain Separation. For more information about 
Domain Separation, see Domain separation explained .

Role required: admin

About this task
An admin first enables and then creates rules and actions as separate tasks.
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Procedure

1. In the navigation filter, enter sys_properties.list.
The entire list of properties in the System Properties [sys_properties] table appears.

2. Search for the com.glide.cs.advanced-chat-popover  system property, and then 
change the value from False  (default) to True.
This system property enables the smart chat component on the Service Portal.

3. Navigate to Conversational Interfaces  > Settings.
You must be in the Proactive Triggers  scope to enable this feature.

4. Under Proactive triggers, select the more info icon ( ) next to the Enable proactive triggers 
field toggle switch to view the Proactive Triggers  scope reminder.

For more information about scopes and how to change them, see Application scopes.

5. Under Proactive triggers, select the Enable proactive triggers  field toggle switch to enable 
the feature.

By default, the Proactive Triggers  feature is inactive.

6. Next to Rules, select View all.
The default sample rules included with Proactive Triggers  appear.

7. Navigate back to the Conversational Interfaces  > Settings  page and next to Trigger types, 
select View all.
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The default trigger types appear. All trigger types default to Active is true  except the 
Search Event trigger type. To turn on the Search Event trigger type, proceed to the next 

step.

8. Optional:  Turn on the Search Event trigger.

(Optional) The Search Event triggers a pop-up message on the Service Portal  Default Search 
Profile whenever a search result yields no result. The Search Event trigger is an inactive default 
trigger type that uses the System API source rather than the web browsing source. Because 
this trigger type defaults to inactive, an admin must turn on the related business rule, trigger 
type, Proactive Triggers  rule, and action prior to using this trigger.

a. Navigate to System Definition  > Business rules.

b. Search for Proactive Trigger on Search  in the Business Rules  field, and then 
select the business rule.

c. Select the Active  option to turn on the business rule.

d. Optional:  Adjust any settings, as needed.

Note: 
Your organization may want to update the Filter Conditions  on the When to Run 
related tab. For example, if your organization doesn’t use the Service Portal, update the 
default values in the Filter Conditions section to reflect your organization's preferred 
portal or site. Your organization may also want to adjust the Proactive Triggers  API script 
in the Advanced  related tab. For additional information on the Proactive Triggers  API 
script, see ProactiveTriggerAPI - Scoped .

e. Select Update.

f. Navigate to Conversational Interfaces  > Settings  and under Proactive Triggers, select 
View All  next to Trigger Types.

g. Select Search Event.

h. In the Proactive Trigger Type form for Search Event, select the Active  option to turn on the 
trigger type and adjust any settings, as needed.

i. Select Update.

j. Select Search - No Search Result  from the Proactive Rules related list.

k. In the Proactive Rule form for Search - No Search Result, select the Active  option to turn on 
the rule and adjust any settings, as needed.
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l. Select Update.

m. Select No Search Result Message  from the Proactive Actions related list.

n. In the Proactive Action form for No Search Result Message, select the Active  option to turn 
on the action and adjust any settings, as needed.

o. Select Submit.

The Search Event trigger type is turned on.

Result
The Proactive Triggers  feature is enabled and you know where to create rules, actions, and 
custom trigger types.

What to do next
Create rules and actions for Proactive Triggers. For more information, see Create rules and 
actions for Proactive Triggers.

Create custom trigger types. For more information, see Create custom trigger types.

Related topics

Enable message preview on the web client

Application scopes

To upload and distribute custom applications on the ServiceNow Store, you need to create a 
private scope for your applications.

All applications have an application scope that determines which of its resources are available 
to other parts of the system. Application scoping ensures that one application does not impact 
another application. You specify what parts of an application other applications can access by 
setting application access controls.

For example, if you create a conference room booking application in its own application scope, 
by default, the application can access and change its own tables and business logic, but 
other applications such as Incident Management cannot make changes to it without explicit 
permission.

An application scope ensures that:

• The conference room booking application does not interrupt core business services.

• Other applications do not interfere with its normal functioning.

Application scope is available for new and upgraded instances starting with the Fuji release.

Configuring Proactive Triggers

Plan, configure, and review your Proactive Triggers.

Before you begin
Activate  the Proactive Triggers  feature.
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Note: 
For new customers onboarding from Vancouver onward, the web client is only accessible 
to authenticated users by default. To allow unauthenticated users to access the web client, 
you must enable the $sn-va-web-client-app and sn_va_web_client_app_embed pages for 
public access. For more information, see Make UI pages public or private .

Role required: admin

About this task
The following steps provide a high-level overview of the Proactive Triggers  configuration process.

Procedure

1. Navigate to Conversational Interfaces  > Settings  > General, and then select the View All 
button next to Proactive Triggers's Rules.

2. Select New  to create rules and define actions  that are triggered by those rules.

3. Optional:  Navigate to Conversational Interfaces  > Settings  > General, and then select the 
View All  button next to Proactive Triggers's Trigger types.

4. Optional:  Select New  to create custom trigger types.

5. Optional:  Create multiple rules  related to the same trigger type, if needed.

What to do next
Review execution logging tables and explore common issues and their resolutions  to ensure that 
your Proactive Triggers  feature is working as expected.

Create rules and actions for Proactive Triggers

Create rules and related actions for Proactive Triggers. These rules and their related actions 
determine the messages that end users see on the ServiceNow  portal.

Before you begin
Enable the Proactive Triggers  feature, and review the list of default rules included with Proactive 
Triggers.

Role required: sn_pt.proactive_admin or admin

About this task
Select a default rule in the Proactive Triggers  rules list to see how the default rule is defined. 
Admins or proactive admins can use these rules, change them, or create rules. After a rule is 
created, the admin creates one or more actions that are triggered by the rule. Actions define the 
messages that end users see based on the rule and the next steps available for the end users to 
take. For examples of default rules and action types, see Exploring Proactive Triggers.

Procedure

1. Navigate to Conversational Interfaces  > Settings  > General, and then select View All  next to 
Proactive Triggers  Rules.
The list of default rules included with Proactive Triggers  is displayed.

2. Select New  to display the Proactive Rule form.

3. On the Proactive Rule form, fill in the fields.
For a description of the field values, see Proactive Rule form.

4. Select Submit.
The rule is created and is displayed in the list of available rules.

5. Select the newly created rule, and then go to the Proactive Actions related list.
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6. Select New  and, when prompted, choose the action type for the rule.

Action types

Action type Description

Message only End users see an HTML pop-up message.

Message that launches a virtual agent topic End users see an HTML pop-up message 
that directs them to an available Virtual Agent 
topic.

Message that launches a selection of virtual 
agent topics

End users see an HTML pop-up message 
with up to three suggested action buttons 
that direct them to a relevant Virtual Agent 
topic.

Note: 
If you've created Live Agent rules, you can only select Message action types for those 
rules.

7. On the Proactive Action form, fill in the fields.
For a description of the field values, see Proactive Action form.

8. Optional:  If you select the Message that launches a selection of virtual agent topics  action 
type, work with the following default list columns on the Proactive Action Virtual Agent Topic 
Controls related list to determine the button display order:

Proactive Action Virtual Agent Topic Controls related list

Column Description

Label The button label that appears to end users. 
Double-click (or use the keyboard shortcut) 
the value to enter a button label up to a 
maximum of 40 characters. Leave this value 
empty if you want to have the label auto-
populate with the topic title.

Topic The Virtual Agent  topic that end users 
interact with after they’ve selected the button. 
Double-click (or use the keyboard shortcut) 
the value to enter or search for a Virtual Agent 
topic.

Active The active status of the rule action. A rule 
needs at least one active action for the 
rule to be triggered. Double-click (or use 
the keyboard shortcut) to select either true 
or false. Leave this value empty to auto-
populate this value to true.

Order The button order that is displayed on end 
users’ screens. Double-click (or use the 
keyboard shortcut) to enter the button 
preference order. Leave this value empty 
if you want to auto-populate with the next 
available order number that increments by 
one.
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Note: 
Up to three buttons can appear in the proactive message.

9. Select Submit.
The Proactive action  is created.

You can create additional rules and actions as needed. For information about using multiple 
rules and actions, see Multiple Proactive Triggers rules and actions.

You can localize the language for end users by making entries to the Translated Text table. For 
more information about making entries to the Translated Text table, see Translating text fields .

Result
The triggering rules and actions are ready for you to validate and test.

Create custom trigger types

Create your own trigger type during the rule creation process that is specific to your organization 
for improved Proactive Triggers  usage.

Before you begin
Role required: sn_pt.proactive_admin or admin

About this task
For a more advanced configuration, create your own custom trigger types. You can create custom 
trigger types through two different paths.

1. Through the View All  button next to the Trigger types  field in Conversational Interfaces  > 
Settings  > General  > Proactive triggers.

2. Through the rule creation process.

Procedure

1. Navigate to Conversational Interfaces  > Settings  > General, and then select View All  next to 
the Rules  field in Proactive Triggers.

2. Select New  to display the Proactive Rule form.

3. Next to the Trigger type  field, select the create new trigger type icon ( ).

4. On the form, fill in the fields.

Proactive Triggers  Create Trigger Type form

Field Description

Name Name of the custom trigger type.

ID System-generated, read-only ID required 
for API calls. This ID is only displayed after 
you've submitted the new trigger type and 
you view the trigger record.

Description Trigger type description.

Order Trigger run order whenever two rules conflict 
in the same time frame. The lowest number 
is evaluated first when multiple triggers are 
running at the same time.
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Field Description

Active Option to activate the trigger type so that it’s 
available as a trigger type when creating a 
rule.

Trigger table The table referenced in the rule condition 
builder. Only one trigger type can exist for 
the same referenced table. For example, if 
you try to create a trigger type referencing 
the Knowledge [kb_knowledge] table with a 
Web browsing source, an error appears when 
saving the trigger type. This error appears 
because the default Knowledge trigger 
already uses this same table and source.

Source The trigger initiation is either System API  or 
Web browsing.

◦ System API: Calls the Proactive Triggers 
API. For example, a business rule on the 
trigger table calls the API that initiates the 
trigger.

Note: 
Trigger types with the System 
API  source only work for internal 
ServiceNow  sites and not external 
sites.

◦ Web browsing: Calls to a URL. The default 
active trigger types are associated with the 
web browsing source.

Applicable portal The trigger type is only applicable to select 
pages on a particular portal.

Example of a custom trigger type

5. Select Submit.
The new, custom trigger type appears as the Trigger Type  field value.

What to do next
After creating the custom trigger type, the Create new trigger type  button updates to the 

Preview this record  button ( ). Select Preview this record  to preview the new trigger type that 
you created and view the system-generated ID. To make edits to this trigger type, select Open 
Record  to manage the parameters of the custom trigger type.
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Also, you can make edits to this new trigger type by selecting View All  next to the Trigger types 
field in Conversational Interfaces  > Settings  > General  > Proactive triggers.

Multiple Proactive Triggers  rules and actions

The Proactive Triggers  feature uses rules and actions to trigger context-specific Virtual Agent 
conversations with end users on the web client.

An admin enables the Proactive Triggers  feature.

An admin then creates rules and defines actions that are triggered by those rules. Admins can 
create multiple rules and actions. They also specify the end user that the rules and actions apply 
to.

Multiple rules can be defined with the same trigger type references (for example, catalog item, 
knowledge, portal home, URL) as long as the Order  and Delay time  settings are different. 
Multiple rules defined on the same trigger type references let you layer messages based on how 
long the end user is on the page.

A rule can include more than one action, but ensure that you apply the action to different users in 
the Applies to  fields.

If you have errors when you create a rule, check the following fields to see if there's a conflict:

Tip: 
The error message that appears includes a link that you can select to help you identify the 
conflicts.

Error message example

• Trigger type

• Delay time

• Order

It may be necessary to clear the rule's history for the rule to function as anticipated. When you 
set your rule's Frequency  field to Once per user  and you want to run the rule again, you must 
clear the history. Clearing the history lets you apply the rule again for that user. To clear the rule's 
history, select Clear History  on the rule's Proactive Rule form. After the history clears, an admin 
must reactivate the rule.

Clear History example

Related topics

Manage Proactive Triggers

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4656



Manage Proactive Triggers

After admins have installed Proactive Triggers  and created related actions and rules, admins can 
check that the Proactive Triggers  feature is performing as expected. For example, admins can 
view the Proactive Execution History table and the Proactive Daily Report table.

This topic includes information admins can use to see if the Proactive Triggers  feature is 
performing as expected. For example, admins can review the Proactive Triggers  history tables to 
make sure that the rules and actions are working as intended.

This topic also includes common issues that admins may encounter when they're creating rules 
and actions, along with the proposed solutions.

View Proactive Triggers  history and report tables

To see if the Proactive Triggers  feature is running as intended, admins can review these two 
tables' data:

• Proactive Execution History  (sys_cs_ptrigger_execution) table

◦ Real-time execution history of Proactive Triggers  events.

Tip: 
The Notes column provides a brief rule execution status. For additional information 
about why Proactive Triggers  didn't run successfully, select the execution event from 
the Created column, and then view the Details  field under the Others  section.

◦ The data from this table is removed every seven days.

• Proactive Daily Report (sys_cs_ptrigger_report_daily) table

◦ Aggregated execution data by user, rule, and action per day.

◦ Execution data is processed every hour and updates this table.

◦ The data from this table is removed every 35 days.

Common issues and resolutions

The following table lists issues that you may encounter when you're creating rules and actions, 
and the suggested resolutions.

Issue Resolution

If a trigger type is defined as a URL in the 
rule, when the page is actually a catalog item, 
knowledge, or portal, the rule won't run.

Admin must fix the rule to match the page 
type.

The Frequency  is set to run once per user but 
the rules don't run.

Clear the rule history at the rule level. For 
details on clearing the rule history, see 
Multiple Proactive Triggers rules and actions.

Rule doesn't run for some end users, and the 
action  type selected is virtual agent topic.

End users may not have access to the Virtual 
Agent  topic defined on the action. Check the 
access to the topic in Virtual Agent Designer.

The Proactive Triggers  rule doesn't run. Close any active conversations in the Virtual 
Agent  web client.
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Proactive Triggers  reference

The following section details the installed components for Proactive Triggers.

Components installed with the Proactive Triggers  feature

When the Proactive Triggers  feature is installed, the feature includes required components, such 
as specific roles and tables. Admins can review these roles and tables to make sure that the 
feature has been installed correctly.

Note: 
The Application Files table lists the components that are installed with this application. For 
instructions on how to access this table, see Find components installed with an application 
Find components installed with an application .

Roles installed with the Proactive Triggers  feature

Role title [name] Description Contains roles

Proactive_admin 
[sn_pt.proactive_admin]

Allows users to create 
proactive rules and have 
access to related tables and 
related records

• user_criteria_admin

• sp_admin

Tables installed with the Proactive Triggers  feature

Table Description

Proactive Custom Trigger Types 
[sys_cs_ptrigger_trigger_type_list]

Create and view custom trigger types

Proactive Rules [sys_cs_ptrigger_rule] Stores all Proactive Triggers  rules

Proactive Actions [sys_cs_ptrigger_action] Parent action table

Proactive Virtual Agent  Topic 
Action[sys_cs_ptrigger_va_topic_action]

Extended table from action for Virtual Agent 
action

Proactive Execution History
  [sys_cs_ptrigger_execution]

Execution history for the last 7 days

Proactive Daily Report 
[sys_cs_ptrigger_report_daily]

Aggregated execution data by user, rule, or 
action per day

Proactive Triggers roles

Proactive Triggers  adds the Proactive Triggers admin role.

To learn more about managing subscriptions, see Managing per-user subscriptions in 
Subscription Management  and contact your account representative.
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Installed roles

Role title 
[name]

Description Contains Roles Groups Elevated Considerations

Proactive 
Triggers 
admin

[sn-
pt.proactive_admin]

Users who 
create 
proactive 
rules and 
have access 
to related 
tables and 
related 
records.

• User 
Criteria 
Administrator 
[user_critera_admin]

• Service 
Portal 
administrator 
[sp_admin]

None. No
Users assigned 
this role can 
access any 
related tables and 
records including 
potentially 
protected 
information, as well 
as proactive rules.

Note: 

Simplify user administration by creating groups that contain all the roles necessary for 
specific personas rather than to individual users. You can then assign individual users 
to those groups. When users transition to new roles, you can then re-assign their group 
memberships, and avoid scenarios where users retain unexpected roles.

For details on the administration of users, groups, and roles, see User Administration .

Proactive Triggers admin [sn-pt.proactive_admin]

Users who create proactive rules and have access to related tables and related records.

Contains Roles

List of roles contained within the role.

• User Criteria Administrator [user_critera_admin]

• Service Portal administrator [sp_admin]

Groups

List of groups this role is assigned to by default.

None.

Special considerations

Important: 
Avoid granting an admin role when more specialized roles are available.

Domain separation and Proactive Triggers

Domain separation is supported for Proactive Triggers. Domain separation enables you to 
separate data, processes, and administrative tasks into logical groupings called domains. You 
can control several aspects of this separation, including which users can see and access data. 
Domain separation enables you to separate data, processes, and administrative tasks into 
logical groupings called domains. You can control several aspects of this separation, including 
which users can see and access data.
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Support level: Basic

• Business logic: Ensure that data goes into the proper domain for the application’s service 
provider use cases.

• The application supports domain separation at run time. The domain separation includes 
separation from the user interface, cache keys, reporting, rollups, and aggregations.

• The owner of the instance must set up the application to function across multiple tenants.

Sample use case: When a service provider (SP) uses chat to respond to a tenant-customer’s 
message, the customer must be able to see the SP's response.

For more information on support levels, see Application support for domain separation .

Overview

The Proactive Triggers  rich text pop-up messages provide users with actions according to real-
time Proactive Triggers  data. Domain separation is enabled and supported at the basic level.

How domain separation works in Proactive Triggers

Each domain has its own set of rules and trigger types that are evaluated independently of other 
domains.

Related topics

Domain separation explained

Domain separation for service providers

Proactive Rule form

When creating a Proactive Triggers  rule, the Proactive Rule form includes the following fields.

Proactive Rule form

Field Description

Name Name of the new rule that you want to create.

Type Proactive Triggers  conversation type for end 
users. Choices are:

• Virtual Agent

Rules are triggered when the Virtual Agent  is 
available.

• Live Agent only

Rules are triggered when the web client 
is configured to live agent only. You can 
configure the web client to live agent only 
from the Service Portal. For instructions, see 
Configure Agent Chat in a portal .

Description Rule description.
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Proactive Rule form  (continued)

Field Description

Order Order of when a Proactive Triggers  rule is to be 
applied. If there’s more than one rule, the rules 
with lower numbers for a particular delay time 
are applied first.

Active Option to activate the rule.

When to run the trigger

Frequency How often the rule should be applied. Choices 
are:

• Every time: Every time an end user visits the 
page.

• Once per visit: Every time an end user visits 
a page per user log in.

• Once per user: Applies the rule only the 
first time that an end user visits the page. 
With this frequency setting, you must clear 
the rule's history if you want to run this 
rule again for a user. For more information 
about clearing the rule history, see Multiple 
Proactive Triggers rules and actions.

Delay time Time to wait before the rule is applied. Choices 
are:

• None

• 10 seconds

• 20 seconds

• 30 seconds

• 1 minute

• 3 minutes

What initiates the trigger

Trigger type
System API or web browsing URL for the type 

of trigger. Select the lookup list icon ( ) to 
view your default choices.

If enabled, your default system API choice is 
Search Event. This trigger type triggers an 
action when no search results are found on 
the Service Portal  or Employee Service Center.
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Proactive Rule form  (continued)

Field Description

Tip: 
Ensure that your Proactive Trigger 
business rule (Proactive Trigger on 
Search), trigger type (Search Event), 
rule (Search - No Search Result), and 
action (No Search Result Message) have 
the Active  option turned on so that this 
rule runs effectively. These parameters 
default to inactive.

Your default web browsing URL choices are:

• Catalog item: Triggers an action based on 
the catalog item's reference fields.

• Knowledge: Triggers an action based on the 
knowledge article's reference fields.

• Portal home: Triggers an action based on 
the portal home page's reference fields.

• URL: Triggers an action based on the 
defined URL.

Define the URL components as shown in this 
example.

Important: 

◦ If you're using the Virtual Agent  web 
client outside of the ServiceNow 
instance (for example, as part of a 
third-party website), use the URL 
trigger type. Don't use any of the 
other trigger types.

◦ The URL trigger type applies only 
if no other available trigger types 
match the URL.

If you don’t see the trigger type that you 

need using the lookup list icon ( ), you can 
create your own custom trigger type. For more 
information about custom trigger types, see 
Create custom trigger types.

Conditions Conditions that must be met for the trigger 
type to run as defined by the admin. 
Conditions vary by trigger type. Specify the 
Proactive Triggers  conditions that you want to 
use.
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Proactive Rule form  (continued)

Field Description

For more information about using conditions, 
see Condition builder .

Note: 
Rule conditions are case-sensitive and 
must match. For example, if you want to 
use the name of a catalog item, such as 
the iPhone condition, entering "iphone" 
doesn't give you the results that you 
want.

Note: 
When specifying the conditions that 
must be met for a trigger type, be careful 
not to specify conflicting trigger types 
and conditions. Conflicting URL trigger 
types and conditions can cause errors. 
For more information, see Manage 
Proactive Triggers.

Advanced conditions Option for using scripts to define the 
condition.

Find available agent Option to check for any available live agents.

Proactive Action form

When creating a Proactive Triggers  rule, the Proactive Action form includes the following fields.

Proactive Action form

Field Description

Name Name of the action that you want to associate 
with a rule.

Description Description of the action to be applied.

Applies to The set of end users to which this action 
applies. For example, you can apply an action 
to any Any Users  or Guest Users  user criteria. 

Use the lookup using list icon ( ) to select 
the user. The Applies to  settings must be 
unique for the actions for each rule.
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Proactive Action form  (continued)

Field Description

To create a user criteria record, see Create a 
user criteria record for Service Portal .

Note: 
If you don't specify a user, this rule is 
applied to all users.

Model Type Topic type, either an LLM  or NLU/Keyword 
value, that is associated with the Proactive 
Triggers  action. This field is only applicable if 
Now Assist  is installed and enabled.

Topic List of Virtual Agent  topics available. The 
selected topic runs when end users open the 
Proactive Triggers  message.

Note: 
Only the topics that are active and 
published appear in the list. System 
topics aren't included in the topics list.

(For Message that launches a virtual agent 
topic  actions only.)

Active Option to activate the action.

Order Order of when a Proactive Triggers  action is to 
be applied. If there's more than one action, the 
actions with lower numbers are applied first.

Rule Rule to which this action applies.

Select variables from Option for choosing from a list of variables to 
use in the message. Choices are:

• Trigger Type: References the trigger type 
table selected for the rule.

• User: References the user table. Uses the 
attributes in the user table for the Proactive 
Triggers  message.

Message Text that the end users see when the action is 
applied. To enter the text, you can:

• Use the tools and options of the HTML 
editor.

Note: 
Support for using the link button may 
be included in future releases.

• Use variables (Trigger Type or User).
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Proactive Action form  (continued)

Field Description

Tagline Text that the end users see above the buttons 
that you've created. The default tagline text is 
Suggested for you.

(For Message that launches a selection of 
virtual agent topics  actions only.)

Interaction Management
Interactions provide a centralized location for all communication channels in the platform. Each 
interaction represents a request for assistance through a given channel, for example, a call or a 
chat.

Overview

The ServiceNow AI Platform  offers several forms of queueing and communication management, 
but each system is tightly coupled to the specific area. Interactions offer an alternative, flexible, 
and more extensible option so that each product area can use the same framework.

Get started

Activate

Activate Interaction Management.

Configure

Configure interaction components, 
determine which actions occur depending 

on the state of the interaction, and 
configure States determine the behavior 

for interactions. For each state of the 
interaction life cycle, you determine 

which routine actions to perform.

Use

Manually create interactions or 
associate records with an interaction.

Reference

Learn about the components installed 
with Interaction Management.
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Troubleshoot and get help

• Virtual Agent interaction records

• ServiceNow Community forums

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support

Activating the Interaction Management  system

An administrator can activate the Interaction Logging, Routing, and Queueing plugin 
(com.glide.interaction) to access the functionality.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the Interaction Logging, Routing, and Queueing plugin plugin (com.glide.interaction) using 
the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.

Note: 
When domain separation and delegated admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .

Configuring Interaction Management

You can configure the behavior of an interaction and the types of information that is stored with 
the record. You can also use interaction wrap up to provide agents with a brief wrap-up period at 
the end of customer conversations.

Interaction states

Configure the behavior of an interaction by determining the routine behavior for each state that 
the interaction goes through during the life cycle.

Interaction framework

Configure each of the following interaction components to determine the behavior and life cycle.

• Lists: Configure the interaction list view. You can also extend the interaction table.

• Forms: Configure the form view to tailor interactions for each application.
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Interaction states

States determine the behavior for interactions. For each state of the interaction life cycle, you 
determine which routine actions to perform. For example, the On Created  state would have a 
script that creates an interaction and then adds the end user as the 'opened for'. The script then 
sends a message to the end user to let them know that the interaction has been opened.

Interaction states

State Description

New An interaction is inserted into the interaction table.

On Hold The interaction is waiting for assignment.

Work In 
Progress

An agent accepts an unassigned interaction.

Wrap Up
This state indicates that the agent has completed a conversation with a customer 
and is wrapping up the interaction.

This state is available if an interaction wrap up configuration has been created for 
the specific type of interaction and that configuration is active.

For more information, see Interaction wrap up.

Closed 
Complete

The interaction timed out or the agent or consumer intentionally closed the 
interaction.

Closed 
Abandoned

The interaction is closed because the consumer disconnects or is unresponsive.

Interaction context and channel metadata

Context and channel metadata are document ID fields included as part of interactions. Both 
types of records store information about the interaction.

Context

Context for an interaction tracks the information for an interaction, such as the initial question, 
asset tagging, or device location. Context records are stored on the interaction_json_blob table 
by default, however you can use any table to store a context record.

Channel metadata

Channel metadata contains the information needed to interact with the channel on which 
communication is happening on, for example, the chat or phone channels. Channel metadata 
can be free-form JSON or a reference to another record.

Interaction wrap up

Interaction wrap up provides agents with a brief wrap-up period at the end of customer 
conversations. Agents can use this time to complete their work before moving on to assist other 
customers.

Interaction wrap up is a feature available for all types of interactions. When enabled, an 
interaction record moves from the Work In Progress to the Wrap Up state at the end of a 
customer conversation. This brief, configurable period enables agents to complete tasks such as 
posting work notes and updating record information before moving on to other work items.
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While in the Wrap Up state, an agent’s capacity is not reduced until the state of the interaction 
moves to Closed Complete.

Note: 
The interaction wrap up feature works with multiple types of communication channels. This 
feature supports a chat and messaging interactions base system.

Configuring interaction wrap up

Users with the system administrator role create an interaction wrap up configuration  for the 
desired communication channel. Creating a configuration automatically enables the feature and 
the Wrap Up state for interactions that match the configuration settings.

The interaction wrap up configuration includes the following information:

• The selected communication channel.

• Additional conditions that apply to the interaction records included in the configuration.

• Whether wrap up is automatically ended by the system and, if automatically ended the 
duration of the wrap up period.

• Whether a countdown timer that displays the wrap up duration is shown to agents in CSM 
Configurable Workspace.

The interaction wrap up configuration adds the Wrap Up state to the State  field on the Interaction 
record. For more information about the wrap up state, see Interaction states.

Starting wrap up

The wrap up period begins when either the agent or the customer ends a conversation. The 
system then does the following:

• Moves the state of the interaction from Work in Progress to Wrap Up.

• Starts a countdown timer for the wrap up duration period.

Manually ending wrap up

Ending the wrap up period can be performed manually by the agent or automatically by the 
system.

Agents can end the wrap up by clicking End Wrap Up  on the Interaction record, which moves the 
interaction from Wrap Up to Closed Complete.

Agents can also end the wrap up period by closing the interaction record tab.

• If the interaction is in the Wrap Up state, closing the tab ends the wrap up period and moves 
the interaction to Closed Complete. The system displays a message to the user about ending 
the wrap up period.

• If the interaction is in the Work in Progress state, closing the tab skips the wrap up period and 
moves the interaction to Closed Complete.

Automatically ending wrap up

If an agent has not already ended wrap up, the system can automatically end the wrap up 
period after a set period of time. Automatic wrap up must be enabled in the interaction wrap up 
configuration.
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• The system starts the wrap up duration timer when the wrap up period starts.

• When the wrap up duration timer reaches zero, the system ends wrap up and changes the 
state from Wrap Up to Closed Complete.

• The system sets the System wrap up  field on the Interaction record to True.

Note: 
Agents can manually end the wrap up period even if automatic wrap up is enabled.

Interaction form

The Interaction form displays information about a customer interaction.

The interaction form includes the following fields.

Field Description

Number The automatically assigned interaction 
number.

Type The type of customer interaction, such as a 
chat or phone call.

Account The name of the customer contact's company. 
This field is filled in automatically if the 
information is available in the contact record.

Contact The name of the customer contact.

Consumer The name of the consumer.

State The current state of the interaction. For more 
information, see Interaction states.

Assigned to The name of the assigned user.

Short description A brief description of the customer issue.

Work notes Records information about the interaction and 
the work being done to resolve the customer 
issue.

Wrap up duration
If using the Interaction wrap up feature, 
the system administrator can configure 
the Interaction form and add the Wrap up 
duration  field.

This field records the length of time that the 
Interaction record spends in the Wrap Up 
state. This is a read-only field. If a duration is 
not calculated, this field is set to 0.

Duration is calculated as the time an 
interaction is in the Wrap Up state before 
moving to either Closed Complete or Closed 
Abandoned.
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Field Description

Note: 
If an agent closes the tab and ends 
the interaction, the wrap up duration is 
recorded as 0 seconds.

System wrap up
If using the Interaction wrap up feature, 
the system administrator can configure the 
Interaction form and add the System wrap up 
field.

The system determines if the interaction wrap 
up was performed manually by an agent (by 
clicking End Wrap Up) or automatically by the 
system and sets this field accordingly.

• Set to True  when automatic wrap up 
is enabled and the system moves an 
interaction from the Wrap Up state to either 
Closed Complete or Closed Abandoned at 
the end of the wrap up duration.

• Set to False  when an agent manually wraps 
up an interaction.

The default value for this field is false.

Interaction wrap up timer

The interaction wrap up timer displays a countdown of the wrap up duration period in CSM 
Configurable Workspace.

The system administrator can configure the display of the wrap up timer by enabling the Show 
duration to agent  field on the Interaction Wrap Up Configuration form.

The read-only timer appears in an interaction record's secondary values. Depending on the 
configuration of the secondary values, these values can be displayed either in the form header 
or in the contextual side panel.

Note: 
The interaction wrap up timer works in both CSM Configurable Workspace  and CSM Agent 
Workspace  but the timer display is only available in CSM Configurable Workspace.

The timer counts down the amount of time specified in the Duration in seconds  field on the 
Interaction Wrap Up Configuration form. The background color of the timer changes as it counts 
down the duration.

Timer color Description

Green Time remaining is between 100% to 50% of duration.

Yellow Time remaining is between 50% and 25% of duration.

Orange Time remaining is between 25% and 0% of duration.

Red When the timer reaches 0.00, the display turns red and then 
disappears. The system updates the state of the interaction record to 
Closed Complete.
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Interaction wrap up scheduled job

The interaction wrap up feature includes a scheduled job to close any interactions in the Wrap 
Up state that were not closed either manually by an agent or automatically by the system.

Ending the wrap up period is typically performed in the following ways:

• Manually by the agent.

• Automatically by the system, if the Enforce wrap up duration  setting is enabled in the 
interaction wrap up configuration.

• By closing the workspace tab.

While most interaction records are automatically closed when the configured wrap up period 
ends, the interaction wrap up feature also includes a scheduled job to close any remaining 
records. For example, if the Enforce wrap up duration  setting is not enabled in the configuration 
and agents close interactions by closing the browser, these interactions can remain in the Wrap 
Up state.

The Fallback Timeout for Interactions in Wrap Up  scheduled job functions as a fail-safe method 
for closing interaction records that remain in the Wrap Up state. This scheduled job:

• Evaluates interaction records in the Wrap Up state.

• Closes those records that have been in the Wrap Up state longer than the time specified in the 
Max Wrap Up system property.

The Max Wrap Up system property (com.glide.interaction.max_wrapup_duration) defines the 
length of time that an interaction record can be in the Wrap Up state. The default value for this 
property is 15 minutes.

The time value set in the Max Wrap Up system property must be greater than the time value set in 
the Enforce wrap up duration  field on the Interaction Wrap Up Configuration form.

The default run interval for this scheduled job is five minutes. The system administrator can 
configure this time interval.

Note: 
This scheduled job is inactive by default.

Create an interaction wrap up configuration

Create a configuration for each type of interaction that uses the interaction wrap up feature.

Before you begin
Role required: admin

About this task
Creating a configuration automatically enables the interaction wrap up feature and adds the 
Wrap Up state for interactions that match the configuration settings.

The Interaction  > Wrap Up  module includes a list of wrap up configuration 
records. These configurations are stored in the Interaction Wrap Up Configuration 
(interaction_wrap_up_configuration) table.

Procedure

1. Navigate to Interaction  > Wrap Up.

2. Click New.

3. Fill in the fields on the Interaction Wrap Up Configuration form.
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Field Description

Name The name of the interaction wrap up 
configuration.

Active Indicates whether the configuration is active. 
The default value is true.

Table Read only. The table that stores the 
interaction records to which this configuration 
applies.

Conditions Use the condition builder to select the 
conditions that apply to the interaction 
records included in this configuration.

Enforce wrap up duration
Enables the system to automatically end the 
wrap up period. The default value is false.

If enabled, the system automatically ends 
the wrap up period at the end of the wrap up 
duration (set in the Duration in seconds  field) 
and moves the state of the interaction record 
from Wrap Up to Closed Complete.

Duration in seconds The duration of the wrap up period.

◦ The default value is 60 seconds.

◦ The value must be greater than 0.

The system displays this field when you 
enable the Enforce wrap up duration  field.

Show duration to agent Enables a duration countdown timer for the 
agent. The default value is false.

The system displays this field when you 
enable the Enforce wrap up duration  field.

Note: 
The interaction wrap up timer works 
in both CSM Configurable Workspace 
and CSM Agent Workspace  but the 
timer display is only available in CSM 
Configurable Workspace.

Order The order of the configuration, which is 
used in evaluation processing of wrap up 
configuration records. If there are multiple 
records, the lower order number takes 
precedence over higher numbers. The 
default value is 100.

4. Click Submit.
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Using Interaction Management

Other applications use Interaction Management  to control channels, but you can work manually 
with interactions as well.

Create an interaction

Most interaction creation takes place in other applications as interactions are merely a method 
of controlling channels. However, if needed you can create an interaction from the Interaction 
application.

Before you begin
Role required: interaction_agent

Procedure

1. Navigate to All  > Interaction  > All.

2. Click New.

3. In the Type field, enter the way the interaction began.
For example, chat, phone, or walk-up.

4. In the Opened for field, type the name of the user starting the interaction.

5. Include any additional information in the short description and the work notes fields.

6. Click Submit.

What to do next
View any incidents opened by the same user by clicking the Use the Incidents by Same Caller 
related list.

Associate a record with an interaction

As an agent, you might need to create a record on another table to work on an interaction. You 
can associate the record with the interaction.

Before you begin
Role required: interaction_agent

Procedure

1. Navigate to All  > Interaction  > Assigned to me.

2. Open the interaction you want to associate with another record.

3. In the form header, click Associate Record.

4. In the ID of related record field, click the search icon.

5. From the Document Table list, select the table you want to associate a record from.

6. From the Document field, click the search icon.

7. Select an existing record from the list, or click New  to create a record.

8. Click OK.

9. Click Submit.

Result
The associated record appears in the Related Tasks related list for the interaction.
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Interaction Management  reference

Learn about the components installed with Interaction Management.

Components installed with Interaction Management

Several types of components are installed with activation of the Interaction Logging, Routing, and 
Queueing plugin, including tables and user roles.

Note: 
The Application Files table lists the components that are installed with this application. 
For instructions on how to access this table, see Find components installed with an 
application .

Roles installed

Role title [name] Description Contains roles

Interaction 
Administrator

[interaction_admin]

Configure interactions for users. interaction_agent

Interaction Agent

[interaction_agent]

Create and edit interactions. Transfer interactions to 
different agents or queues.

None

Tables installed

Table Description

Interaction

[interaction]

Table for all interaction records.

Interaction JSON blob

[interaction_json_blob]

List of records that store context information for each interaction.

Interaction related record

[interaction_related_record]

List of related records that have been associated with an 
interaction.

Live Feed Core UI
Live Feed is a social IT application that provides a place to post and share content in a 
ServiceNow®  instance.

Important: 

Core UI  is required to use Live Feed. Live Feed is not supported in Next Experience. If you 
turn on Next Experience, Live Feed will no longer work. See Next Experience UI  for more 
information.
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Get started

Explore

Learn about Live Feed 
concepts and features.

Activate

Activate Live Feed 
on your instance.

Administer

Administer document 
feeds, record feeds, 

and notifications.

Use

Post in Live Feed and 
use feeds, teams, 

hashtags, and records.

Reference

Get details about 
domain separation and 
components, such as 

tables, user roles, business 
rules, and script includes.

Troubleshoot and get help

• Live Feed discussions in the ServiceNow Community

• Contact Customer Service and Support

Exploring Live Feed Core UI

Live Feed content forms a searchable knowledge source for sharing information within an 
organization.

Live Feed overview

Important: 

Core UI  is required to use Live Feed. Live Feed is not supported in Next Experience. If you 
turn on Next Experience, Live Feed will no longer work. See Next Experience UI  for more 
information.

Live Feed content forms a searchable knowledge source for sharing information within an 
organization. Main features include the following:

• Users can post, reply to, and rate messages, including links and images.

• Administrators can set up automatic messages that are generated when specific records are 
updated throughout the system.
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• Users can subscribe to receive email notifications when new messages are posted.

• Users who take advantage of the accessibility options in the platform can tab through a Live 
Feed to navigate.

Live Feed includes different types of feeds, including company feeds, group feeds, individual 
feeds, and record feeds.

My Feeds

Note: 
Live Feed v2 is active for all new instances by default. If you are upgrading from an earlier 
version of ServiceNow®, you need to activate Live Feed v2 to use these features.

Live feed can be domain separated at the data level only. For more information on Live Feed and 
domain separation, see Domain separation in Live Feed.

Live Feed users

Users

User Description

Admins Admins activate and administer Live feed in the following 
ways:

• Add and configure document feeds

• Activate and configure record feeds

• Set up notifications

• Manage Live Feed security

Users Users can subscribe to feeds, post content, work on records, 
and use hashtags.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4676



Live Feed  benefits

Live Feed benefits

Benefit Feature Users

Document feeds allow users to work on tasks 
and other records through the Live Feed 
interface. Users can post messages in Live 
Feed that are automatically maintained as 
comments or work notes on the record, if the 
record has these journal fields.

Document feeds Configuration: Admins

Users: anyone

Record feeds allow users to work on tasks and 
other records through the Live Feed interface. 
Users can post messages in Live Feed that 
are automatically maintained as comments 
or work notes on the record if the record has 
these journal fields.

Record feeds Configuration: Admins

Users: anyone

When a record is inserted or updated on 
a specific task table and the notification 
conditions are met, a message is generated 
and posted to the specified group or to the 
company feed.

Live Feed table 
notifications

Configuration: Admins

Users: anyone

Users can be combined into teams for the 
purpose of subscribing to specifically-focused 
feeds.

Teams in Live Feed Configuration: Admins

Users: anyone

Hashtags are words marked with a hash 
symbol ( ) in messages. Hashtags are a way 
to categorize messages by keyword or topic 
for improved search results.

Hashtags in Live Feed Anyone

What to explore next

To learn more about configuring and using Live Feed, see:

• Activating Live Feed

• Administering Live Feed

• Using Live Feed

• Live Feed reference

Live Feed browser support

The Live Feed v2 plugin does not support Internet Explorer 7 through 9.

Important: 

Core UI  is required to use Live Feed. Live Feed is not supported in Next Experience. If you 
turn on Next Experience, Live Feed will no longer work. See Next Experience UI  for more 
information.

Users who access the instance from those browser versions can use Live Feed v1 functionality. 
Users who access the instance from browsers that are compatible with HTML5 can use Live Feed 
v2 functionality.
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Activating Live Feed

Live Feed is active for all instances. An administrator can activate the Live Feed plugin if it is not 
already active.

Before you begin
Role required: admin

Important: 

Core UI  is required to use Live Feed. Live Feed is not supported in Next Experience. If you 
turn on Next Experience, Live Feed will no longer work. See Next Experience UI  for more 
information.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.

Note: 
When domain separation and delegated admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .

Administering Live Feed

Administrators and users with the live_feed_admin role can configure Live Feed security and 
provide access to Live Feed from content management pages. Administrators can also set up 
Live Feed table notifications.

Important: 

Core UI  is required to use Live Feed. Live Feed is not supported in Next Experience. If you 
turn on Next Experience, Live Feed will no longer work. See Next Experience UI  for more 
information.

Document feeds

A document feed is a Live Feed group that is associated with a record, such as an incident or 
change.

Document feeds allow users to work on tasks and other records through the Live Feed interface. 
Users can post messages in Live Feed that are automatically maintained as comments or work 
notes on the record, if the record has these journal fields.

The benefits of using document feeds include the following.

• Improving communication between users working on the same record.

• Improving visibility into progress for end users.
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• Providing a single place to see updates on multiple records.

• Saving conversation history in the record so that knowledge is not lost in an email chain.

To use document feeds, activate the Live Feed Document plugin, which is active by default in 
new instances. See Use Live Feed to work on records  to learn how to use this feature.

The system automatically creates a document group for the feed when a user follows or shows 
a record on Live Feed. The system also creates a document group when a user creates a new 
record on a table that has Live Feed enabled.

The following list describes features of the document feed group.

• Is unlisted; it does not appear when users view all groups on Live Feed.

• Automatically approves membership for every user who can access the record.

• Uses the record number as the group name.

• Uses the record short description as a group description.

• Maintains all messages posted to Live Feed on the record, if the record has a journal field for 
comments. If the record has a standard text field for comments, each live post overwrites the 
field value.

• Maintains all messages posted on the record in Live Feed if the record has a journal field for 
comments. When the group is created, existing messages are added to the document feed.

A user who participates in Live Feed becomes a member of the group.

Related topics

Activate a plugin

Add a Live Feed UI action on a table

You can add UI actions on a table to allow users to follow records in live feed.

Before you begin
Role required: ui_action_admin or admin

Procedure

1. Navigate to System Definition  > UI Actions.

2. Open one of the Live Feed UI actions, for example, the Follow on Live Feed  list UI 
action.

3. In the Table  field, select the table name.

4. Right-click the header and select Insert  to create a copy of the UI action for the desired table.

5. Repeat steps 1 – 4 for all Live Feed UI actions.

Configure document feeds

You can configure a table to support document feeds.

Before you begin
Role required: personalize_dictionary or admin
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Procedure

1. Add Live Feed to a form header.

2. Add Follow on Live Feed  and Show Live Feed  as list and form UI actions.

Security configuration for document feeds

Document feeds honor the access control rules (ACLs) for the associated record. Users can only 
view messages on the document feed if they have access to the same information on the record.

Consider the following examples:

• If an ACL allows a user to read and create comments on an incident, then the user can view 
and add messages posted as comments on the incident feed.

• If an ACL restricts a user from reading work notes, then the user cannot view messages posted 
as work notes on the incident feed.

Note: 
Access control rules are only checked when a user first accesses the document feed. After 
users view the feed, an administrator must remove them manually to change their access.

Disable a record feed

You can disable Live Feed functionality from the form of any table.

Before you begin
Role required: personalize_dictionary or admin

Procedure

1. Navigate to System Definition  > Dictionary.

2. Open the dictionary entry for the table.

3. Add live_feed=false  in the Attributes  field.

4. Click Update.

Note: 
If the Collaboration feature is activated, you can remove the show Live Feed icon ( ) 
from all form headers. Set the glide.live_feed.task_header_button  property 
to collaboration.

Disable a document feed

You can disable a document feed from the form of any table.

Before you begin
Role required: personalize_dictionary or admin

Procedure

1. Navigate to System Definition  > Tables.

2. Open the table record.

3. Clear the Live feed  check box.

4. Click Update.
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Business rule installed with Live Feed Document

This business rule is installed with Live Feed Document. There are no tables, roles, or 
notifications installed with it.

Business rule Description

Live Feed 
integration

Writes journal comments to the Live Feed if there is a group for this 
record.

Record feeds

A record feed is a Live Feed group that is associated with a record, such as an incident or 
change.

Record feeds allow users to work on tasks and other records through the Live Feed interface. 
Users can post messages in Live Feed that are automatically maintained as comments or work 
notes on the record if the record has these journal fields.

You can use record feeds to do the following:

• Improve communication between users working on the same record.

• Improve visibility into progress for end users.

• Provide a single place to see updates on multiple records.

• Save feed history in the record so that knowledge is not lost in an email chain.

Live Feed document

Note: 
Many of these features are part of Live Feed v2.

Activate the Live Feed Document plugin

The Live Feed Document plugin is active by default.

Before you begin
Role required: admin
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About this task
Administrators can enable record feeds in an instance by activating the Live Feed Document 
plugin, which activates the Live Feed plugin if it is not active. For upgrades, administrators must 
activate the plugin.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.

Note: 
When domain separation and delegated admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .

Configure record feeds

Configure a table to support record feeds. You can add the Show Live Feed button in the form 
header and add the UI actions Follow on Live Feed and Show Live Feed as List and Form.

By default, the Show Live Feed icon appears on the form header for all tables that extend task, 
including the Incident, Change Request, and Problem tables, and in the list and form context 
menus for all task tables.

Add Live Feed to a form header

Add the Live Feed  button in the form header for a table.

Before you begin
Role required: admin

Procedure

1. Type sys_properties.list  in the Application Navigator.

2. Open the record for glide.live_feed.task_header_button.

3. In the Value  field, change the value to both.

Note: 
By default, the value is collaboration  so that the property is supported in the 
Collaboration (com.glide.collaboration) plugin. Changing the value to both  allows the 
system property to be supported in Collaboration and Live Feed.

4. Click Update.

5. Navigate to System Definition  > Tables.

6. Open the table record.

7. If the Live feed  check box does not appear on the form, configure the form layout  to add the 
Live feed  field.
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8. On the form, select the Live feed  check box.

9. Click Update.
Alternatively, you can add live_feed=true  to the Attributes  field in the dictionary entry for the 
table.

Result
The Live Feed  button appears on the overflow menu of the form header.

Add Live Feed to a context menu

Add Live Feed UI actions on a table.

Before you begin
Role required: admin

Procedure

1. Navigate to System Definition  > UI Actions.

2. Open one of the Live Feed UI action, for example, Follow on Live Feed.

3. In the Table  field, select the table name.

4. Right-click the header and select Insert  to create a copy of the UI action for the desired table.

5. Repeat steps 1 – 4 for all Live Feed UI actions.

Disable a record feed

You can disable Live Feed functionality from the form of any table.

Before you begin
Role required: personalize_dictionary or admin

Procedure

1. Navigate to System Definition  > Dictionary.

2. Open the dictionary entry for the table.

3. Add live_feed=false  in the Attributes  field.
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4. Click Update.

Note: 
If the Collaboration feature is activated, you can remove the show Live Feed icon ( ) 
from all form headers. Set the glide.live_feed.task_header_button  property 
to collaboration.

Configure security

Record feeds honor the access control rules (ACLs) for the associated record.

Users can only view messages on the record feed if they have access to the same information on 
the record. For example:

• If an ACL allows a user to read and create comments on an incident, then the user can view 
and add messages posted as comments on the incident feed.

• If an ACL restricts a user from reading work notes, then the user cannot view messages posted 
as work notes on the incident feed.

Note: 
Access control rules are only checked when a user first accesses the record feed. After 
users view the feed, an administrator must remove them manually to change their access.

Live Feed table notifications

Live feed table notifications generate automatic Live Feed messages. The Live Feed plugin must 
be activated to use table notifications.

When a record is inserted or updated on a specific task table and the notification conditions are 
met, a message is generated and posted to the specified group or to the company feed. Table 
notifications are supported for all task tables and all task types by default.

Administrators and users with the live_feed_admin or chat_admin roles can set up table 
notifications for any table in an instance.

Set up table notifications for task tables

You can set up a table notification for a task table to enable automatic Live Feed messages.

Before you begin
Role required: live_feed_admin or chat_admin

Procedure

1. Navigate to Live Feed  > Feed Administration  > Table Notifications.

2. Click New  or select a notification to open it.

3. Complete the form.

Live Table Notification fields

Field Description

Table
Select the table for which notifications are generated.

Note: 
The list shows only tables and database views that are in the same scope 
as the table notification.
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Field Description

Post to 
chat rooms

Select the check box to generate the notification in chat rooms that are 
associated with the record, This applies to task records only and requires that 
the Chat plugin is active.

Post to Live 
Feed

Select the check box to generate the notification on Live Feed.

If record feeds are not set up and the Feed group  field is blank, the notification 
is posted to the company feed.

Record 
Feeds

Select the fields to post for record feeds.

This field is available only if Post to live feed  is selected.

Application Select the application that contains this record.

Active Select the check box to enable the notification.

Insert Select the check box to generate the notification when a record is inserted into 
the database.

Update Select the check box to generate the notification when a record is updated.

Feed Select the Live Feed team to which you want to post messages. This field is 
available only if Post to Live Feed  is selected.

Clear the field to post notifications on the company feed.

Conditions Create the condition that must be met to generate the notification.

If you add a condition statement, the system evaluates the condition first and 
parses the Before scriptfield only if the condition is met. You may choose to 
leave this field blank and include conditions in the script.

Description Enter a description of the table notification.

Message Construct the automatic message you want to generate. You can include field 
values as variables and a link to the record.

To add a variable, position the cursor in the text and then click the field name 
in the Select variables  field. To add a link to the record, enter ${URI}  in the 
message text as shown in the following example.

High priority incident opened: ${URI}
 Short description: ${short_description}

Note: 
For security reasons, any HTML code is automatically stripped out of a 
message before it is posted.

Before 
script

Create a script that runs before a notification is generated. The script runs 
only if the condition evaluates to true or is empty. The following variables are 
available in the script.

◦ current: the GlideRecord object that triggered the notification.

◦ changedFields: an ArrayList of fields changed on submit. Use 
changedFields.contains('fieldname') to check for change.

◦ answer: set answer to false to cancel the notification.
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Field Description

◦ profileSource: set to a valid GlideRecord object to define the profile that 
is posting the message.

◦ profileID: set to a live_profile sys_id to define the profile that is posting 
the message; by default it is the current record. Overrides profileSource if 
both are specified.

Any custom variable created in the script is also exposed to the message in the 
form of ${myVariableName}.

4. Click Submit  or Update.

Set up table notifications for non-task tables

Table notifications are supported for all task tables by default, and you can set up a table 
notification for any other table.

Before you begin
Role required: live_feed_admin or chat_admin

Procedure

1. Navigate to System Definition  > Business Rules.

2. Open the Live Feed events  business rule.

3. In the Advanced section,select and copy the text in the Script  field.

4. Click the back arrow on the top, left to exit the record and return to the Business Rules list.

5. Click New.

6. Enter the following values at the top of the form.

◦ Name: Enter a name, such as Live Feed events for my table.

◦ Table: Select the table for which you are setting up a notification.

◦ Active  and Advanced: Select these check boxes.

7. In the When to run  section, enter the following values.

◦ When: Select before.

◦ Insert, Update, and Delete: Select the check boxes.

8. In the Advanced  section, paste the script from the Live Feed events  business rule into 
the script box.

9. Click Submit.
The Live Feed events  business rule runs on the non-task table. It fires the 
live_feed.update  event, which is associated with the Live Feed Update  script 
action. The script action sets up variables and processes the table notifications.

What to do next
After saving the business rule, create a Live Feed table notification record  for the new table as 
you would for a task table.

Live Feed table notification examples

The following examples demonstrate how to set up different types of table notifications that are 
useful for Live Feed.
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Workaround posted

This example demonstrates a table notification that generates an automatic message on Live 
Feed whenever a workaround is added to an open problem.

• Table: Problem [problem]

• Active: Select the check box.

• Update: Select the check box.

• Post to Live Feed: Select the check box.

• Conditions: [State] [is] [Open]

• Description: Workaround Posted

• Message:

${sys_updated_by} posted a workaround for ${URI}.
Short description: ${short_description}

• Before script:

// only post to Live Feed when the Workaround field changes
answer  = changedFields. contains ( "work_around" ) ;

Example workaround message

Related topics

Live Feed table notifications

Problem resolved (advanced)

This advanced example demonstrates a table notification that generates an automatic message 
on Live Feed whenever a problem is closed.

It also adds a message about the assigned user and posts the message from the assignment 
group profile instead of the problem record.

• Table: Problem [problem]

• Active: Select the check box.

• Update: Select the check box.

• Post to Live Feed: Select the check box.
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• Conditions: [Problem State] [is] [Closed/Resolved]

• Description: Problem Resolved

• Message:

Problem ${number} - ${short_description} has been resolved. 
 ${fixedByMsg}

• Before script:

//cancel if we didn't just change the problem state if 
 ( !changedFields. contains ( "problem_state" ) )
answer  = false ;
 
 //if we have an assigned_to value add a comment about who it 
 was //create a new variable fixedByMsg that we can access from 
 the message
fixedByMsg  = "" ; if ( !current. assigned_to. nil ( ) )
fixedByMsg  = " Thank you " + current. assigned_to. 
 getDisplayValue ( ) ;
 
 //make the message appear to come from the assignment group if 
 we have one if ( !current. assignment_group. nil ( ) )
profileSource  = current. assignment_group. getRefRecord 
 ( ) ; //need GlideRecord object

Example problem resolved message

Related topics

Live Feed table notifications
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Opportunity won (non-task)

This example demonstrates a table notification on a non-task table. It generates an automatic 
message on Live Feed whenever a sales opportunity is won, if you have activated the Sales 
Force Automation plugin.

Create a business rule  on the Opportunity [sales_opportunity] table that matches the Live Feed 
events  business rule on the task table.

Create a table notification with the following values:

• Table: Opportunity [sales_opportunity]

• Active: Select the check box.

• Update: Select the check box.

• Post to Live Feed: Select the check box.

• Conditions: [State] [is] [Closed Won]

• Description: Opportunity won

• Message:

${owner} closed a sale with ${account}!

• Before script:

//make the message appear to come from the assigned salesperson 
 if there is one if ( !current. owner. nil ( ) )
profileSource  = current. owner. getRefRecord ( ) ; //need 
 GlideRecord object

Example opportunity won message

Related topics

Live Feed table notifications

Related feeds table notification

This example demonstrates table notifications to be sent out to related feeds.

For this example, whenever the status of a story changes to Complete, a table notification 
message is sent to the related sprint, release, or epic. Messages are posted only if the related 
feed already exists; this notification does not create a new feed.
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• Table: Story [rm_story]

• Active: Select the check box.

• Update: Select the check box.

• Post to Live Feed: Select the check box.

• Record feeds: Move Sprint, Release, and Epic  to the Selected  column.

• Conditions: [State] [changes to] [Complete]

• Description: Story is done; message to Epic, Release, and Sprint

• Message:

${URI} status changed to ${state}

Live Feed security and table access

By default, administrators and users with the live_feed_admin role can configure live feed 
security and view all Live Feed tables.

You can also modify the following Live Feed tables:

• Live Table Notification [live_table_notification]: Set up automatic messages that are generated 
when specific records are updated throughout the system.

• Live Feed Message [live_message]: Modify only if necessary, such as to delete an 
inappropriate message or restore a message that a user accidentally deleted. This table is 
typically managed by system functionality.

Extending or modifying data in any Live Feed chat table is not recommended.

Limit Live Feed access by role

All active users in the instance have access to Live Feed by default.

Before you begin
Role required: live_feed_admin and admin

Procedure

1. Complete the following steps to define the roles that allow users to see the Live Feed module.

a. Perform the appropriate action for your version of the UI:

▪ Core UI: Navigate to System Definition  > Application Menus, and then select Live Feed.

▪ UI15: Right-click the icon beside the Live Feed module and select Edit Module.

b. Enter the roles that have access in the Roles  field.

c. Click Update.

2. Complete the following steps to define the roles that allow users to see live feed from a mobile 
device.

a. Navigate to System Definition  > Applications (Mobile).

b. Click Live Feed.

c. Enter the roles that have access in the Roles  field.

d. Click Update.
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3. Use the following settings in the Access Control form to create access control rules to limit who 
can view the live_feed pages.

◦ Type: ui page

◦ Operation: read

◦ Name: create one access control rule record for each of the following pages

▪ live_feed

▪ live_feed_small

▪ $live_feed

▪ $live_feed_small

◦ Requires role: in this related list, add roles to define who can access the Live Feed pages. 
Users who do not have these roles cannot access Live Feed.

Manage Live Feed message content

Users can remove their own messages from feeds. If necessary, administrators can remove 
inappropriate messages that are posted by any user.

Before you begin
Role required: live_feed_admin and admin

About this task
For security reasons, any HTML code is automatically stripped out of a message before it is 
posted. This measure ensures that users cannot modify any page settings by posting a message.

Procedure

1. Navigate to Live Feed  > Feed Administration  > Messages.

2. Open the message to be removed.

3. In the State  field, select deleted.
You may need to configure the form to add this field.

4. Click Update.

Live Feed team security

You can restrict who can create teams by modifying an access control rule.

Modify the following access control rule:

• Table: Live Group Profile [live_group_profile]

• Operation: create

Restrict hashtag renaming

You can restrict who can rename hashtags.

You restrict hashtag rename by modifying the following access control rule:

• Table: Live Tag [live_tag]

• Operation: write

Provide access to Live Feed from CMS pages

You can provide access to Live Feed from pages built in the Content Management System (CMS). 
For example, allow an end user to access your company feed via the ESS portal.
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Before you begin
Role required: content_admin or admin

About this task
The ESS Portal template includes the Portal - Live page  and Live Feed  dynamic blocks. To 
provide access to Live Feed from CMS pages, add the Live Feed dynamic block to a CMS page 
or include Portal - Live page  in a site.

Procedure

1. Navigate to Content Management  > iFrames.

2. Click New.

3. Enter the iFrame block details.

iFrame block fields

Field Description

Name Enter a unique name such as Live Frame.

Frame 
Name

Enter a frame name, such as live_frame.

URL
https://INSTANCE/live_feed.do?sysparm_doctype=true

where INSTANCE is your instance URL (example, [instance name] .service-
now.com)

Application Displays scoping information.

Sizing Select Fixed Size  and enter height and width pixel dimensions according to the 
page where you plan to display the feed (for example, width of 1024 and height 
of 768).

4. Click Submit.

5. Add the block to a page.

Related topics

Administering Live Feed

Content Management System

Using Live Feed

Live Feed provides many methods you can use to share content with others in your organization.

Important: 

Core UI  is required to use Live Feed. Live Feed is not supported in Next Experience. If you 
turn on Next Experience, Live Feed will no longer work. See Next Experience UI  for more 
information.

Depending on your role, there are several different types of feeds you can access, teams you can 
join and share information with, and hashtags you can use for categorizing messages.
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Example image

Note: 
Live Feed v2 is active for all new instances by default. If you are upgrading from an earlier 
version of ServiceNow, you need to activate Live Feed v2 to use these features.

Use hashtags in Live Feed

Hashtags are words marked with a hash symbol ( ) in messages. Hashtags are a way to 
categorize messages by keyword or topic for improved search results.

For example, to identify messages associated with VPN questions, add the hashtag  VPN in the 
message text.

Note: 
Many of these features are part of Live Feed v2. If you are using Live Feed v1, or have not 
activated Live Feed v2, see Legacy Live Feed.

Tag messages

To tag a keyword or topic in a message, enter a   symbol before the word. A link to the hashtag is 
added beneath the message and all feed users can search and filter by the hashtag to find the 
message.

Follow these tips for using hashtags effectively:

• Limit the number of hashtags per message (no more than 3 is a good guideline).

• Use hashtags only in messages that are relevant to the tagged topic.

• Write a message first, and then add hashtags only if they add value. Answer the question, 
"What are you working on?", rather than "What hashtags apply to what you are working on?"

• Use camel case to create a hashtag that is more than one word long. For camel case, remove 
the space and use an uppercase letter to start each word. For example, to create a topic about 
the service desk, use  ServiceDesk.
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Example hashtags

View an available hashtag

View a hashtag from any feed.

Before you begin
Role required: none

Procedure

1. Navigate to Live Feed  > Live Feed.

2. Click Hashtags  in the sidebar.
Any hashtags already defined are displayed. Up to 36 hashtags can be displayed, and options 
are available for searching and sorting the hashtags. When searching, you do not need to 
include the hash symbol ( ).

Tags sidebar
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3. Click a hashtag to view all messages containing that hashtag.

Tags multiple messages

Change a hashtag name and merge a hashtag

Over time, users may create many hashtags with similar names, such as competitive, competitor, 
and competition. To combine hashtags for better searching and filtering, change the names of 
similar hashtags to a standard name.

Before you begin
Role required: admin

About this task
Administrators can restrict who can rename hashtags.

Procedure

1. Navigate to Live Feed  > Live Feed.

2. Click Hashtags  in the sidebar to reveal the currently defined hashtags.

3. Turn off the filter to show all hashtags.

4. Point to the hashtag you want to change.

If you have the rights to edit hashtags, an edit tag ( ) appears.

5. Click the edit tag icon.

Edit tag

6. Enter a new hashtag name.

7. Press Enter.
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◦ If the new name is different than the other hashtags, the new hashtag name replaces the old 
hashtag name on the list and in the text of any messages that include the hashtag.

◦ If the name is the same as one of the existing hashtags, the hashtags will be merged. 
For example, if you have two hashtags called Competitive  and Competitors, and you 
change the name of Competitors  to Competitive, all of the messages previously tagged 
Competitors  are changed to Competitive  and the Competitors  hashtag is removed.

Note: 
If a hashtag is removed from the message, renaming that hashtag does not change the 
message text.

Add an image to a hashtag

You can add an image at the domain level of already defined hashtags if you have the admin role.

Before you begin
Role required: admin

Procedure

1. Click Hashtags  in the sidebar.

2. Select the appropriate hashtag.

Tag with image icon

3. Do one of the following:

◦ Locate the image in your file system, and then drag-and-drop the image onto the add an 

image icon ( ).

◦ Click the add an image icon ( ), select the image file, and click Open.

4. To change the image, simply drag-and-drop a new image onto the old one, or click on the 
existing one and select a new image.

When you view a message that contains a hashtag with an image, that image appears in the 
hashtag heading bar.

Message with tag icon

Follow and unfollow a hashtag

You can view all postings assigned a specific hashtag by following the hashtag. You can also 
unfollow the hashtag if you no longer want to view those postings.

Before you begin
Role required: admin

Procedure

1. Navigate to Live Feed  > Live Feed.

2. Click Hashtags  in the sidebar.

3. Select the hashtag you want to follow.

4. Click Follow.
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Follow tag

A confirmation message appears.

5. Click X  to dismiss the message.
To unfollow a hashtag, repeat the same steps and click Unfollow.

Remove a hashtag from a posted message

As a participant in a conversation, you can remove hashtags from messages that have already 
been posted.

Before you begin
Role required: admin

Procedure

1. Navigate to the posted message.

2. Click Hashtags  in the message posting.

Hashtag in post

The hashtags associated with the message are displayed, along with the removal icon.

Remove tag

3. Click the removal icon.

Use teams in Live Feed

Users can be combined into teams for the purpose of subscribing to specifically-focused feeds.
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Teams can be created based on any criteria that makes sense for your organization. For example, 
you can create a team called IT Developers and subscribe the team to feeds such as Coding 
Standards, AngularJS Development, and ServiceNow Customization Best Practices. When a new 
developer is added to the IT Developers team, that user automatically has rights to participate in 
all of the feeds followed by the team.

Automatic team creation

If you create a record on a table that has Live Feed enabled, such as the Incident table, and click 
Follow/Show Live Feed for the record, a record feed is created for the record.

The record feed name is based on the table name.

Reply to email notifications using email

After receiving an email about a posted message or a reply, you can post your reply to Live Feed 
by responding to the email.

The body of the email reply is posted as a response to the Live Feed message. Any attachments 
that you include in your reply email are also posted in the Live Feed reply.

Create a Live Feed team

When you create a team, you become the team administrator.

Before you begin
Role required: admin

About this task
As team administrator, you can do the following:

• Modify team properties

• Accept or reject membership requests

• Remove members from the team

• Delete the team

Procedure

1. Navigate to Live Feed  > Teams.

2. In the sidebar, click your profile picture, then select the Teams  tab.

3. Click Create Team.
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Teams tab

4. Enter a Name  to appear at the top of the feed and in messages posted to the team.

Create Team form

This name links to the team feed.

5. Enter a Description  to appear at the top of the feed and under the team name in the list of all 
teams.

6. Select the access level for the team:

◦ Public Team: In the list of all teams, any user can see the name of this team. Any user can 
also see the feed and join the team. Messages in a public team appear in the Company Feed 
with a link to the team feed.

◦ Private Team: In the list of all teams, any user can see the name of this team, but not the 
feed. Messages in private teams do not appear on the Company Feed.

When Private Team  is selected, the Show this team for anyone to find and request to join 
check box is displayed. Select this check box to allow any user to search for this team and 
request to join it. Clear the check box to allow only invited users to see the feed and join the 
team.

7. Click Create.
The team is created with you as the team administrator.
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Note: 
A team administrator can create one or more group feeds specifically for the members 
of this team by clicking the Group Feeds  tab and Create Group Feed. Additionally, the 
team can be invited to join a feed. Having multiple feeds for the team facilitates focused 
discussions on topics of interest to the team and allows the team to selectively invite 
other teams and members to collaborate on specific feeds.

Join a team

You can join a public team, accept an invitation, or request access to a team.

Before you begin
Role required: admin

About this task
As a team member, you can:

• View messages  posted to the team (team feed). Non-members can also view the feed for a 
public team.

• View a list of team members.

• Invite another team  to join the team.

• Subscribe to team email notifications.

• Leave  the team.

Procedure

1. Navigate to Live Feed  > Live Feed.

2. Click Teams  and click All Teams.

◦ If you received an invitation, click Accept. You can Decline  the invitation if you do not want to 
join the team.

◦ If the team is public, click Join.

◦ If the team is private, click Request. The team administrator receives an email notification 
and must accept your request before you can join the team.
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View a team feed

View a team feed to see messages belonging to that team.

Before you begin
Role required: admin

Procedure

1. Navigate to Live Feed  > Live Feed.

2. In the sidebar, click your profile picture, then select the Teams  tab.

◦ To view a team you belong to, select the team name.

◦ To view a public team you do not belong to, select All Teams  and then click the team name.

You must be a member to view the feed for a private team.

View a team member

View a list of members belonging to a Live Feed team.

Before you begin
Role required: admin

Procedure

1. Navigate to Live Feed  > Live Feed.

2. In the sidebar, click your profile picture, then select the Teams  tab.

3. From the team list, select the team name.
You must be a member of the team to view the members.

4. Click Members.
The list of team members appears, organized by team administrators and team members.

Invite a new member

You can invite another user to join a team.

Before you begin
Role required: admin

Procedure

1. Navigate to Live Feed  > Live Feed.

2. In the sidebar, click your profile picture, then select the Teams  tab.

3. From the team list, select the team name.

4. Click the Pending members  tab.

5. In the Add User  field, enter the name of the user you want to invite.
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The invited member's picture appears.

Remove a member

If you are team administrator, you can remove any member from the team.

Before you begin
Role required: admin

Procedure

1. Navigate to Live Feed  > Live Feed.

2. In the sidebar, click your profile picture, then select the Teams  tab.

3. From the team list, select the team name.

4. Click the Members  tab.

5. Click Remove  below the member name.
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6. Click Remove  again in the confirmation box that opens.

Note: 
You can remove members regardless of their current state. That is, you can remove 
members who have already joined the team or whose membership is pending.

Subscribe to team and email notification

Users can subscribe and unsubscribe to receive email notifications generated by feeds the team 
participates in.

Before you begin
Role required: none

About this task
Email notifications are generated whenever actions such as posting messages, replies, likes, 
polls, and @mentions are performed.

All notifications related to a top-level message, such as replies, mentions, and likes, are sent out 
with the same subject. The subject line defaults to Live Feed  followed by the beginning of the 
subject line from the top-level message. For example, if the subject of the feed is IT Support, the 
email notification's subject will be Live Feed IT Support.

Procedure

1. Navigate to Live Feed  > Live Feed.

2. Click Teams  and select the team name.

3. Click the subscribe icon ( ).

You can click the unsubscribe icon ( ) to stop receiving email notifications.

Subscribe a team to feed notification

A team administrator can subscribe a team to specific feeds so the members of the team receive 
email notifications.

Before you begin
Role required: none

Procedure

1. Navigate to Live Feed  > Live Feed.

2. Click Teams  and select the team name.
You can use the advanced search to locate team of which you are the administrator.

3. Click Feeds.

4. Click the subscribe icon ( ) beside the feed name.

You can click the unsubscribe icon ( ) to stop receiving email notifications.

Leave a team

You can give up membership to a team by leaving that team.

Before you begin
Role required: none
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Procedure

1. Navigate to Live Feed  > Live Feed.

2. In the sidebar, click your profile picture, then select the Teams  tab.

3. Click Leave  beside the team name.

Modify a team

If you are team administrator, you can modify an existing team.

Before you begin
Role required: admin

Procedure

1. Navigate to Live Feed  > Live Feed.

2. In the sidebar, click your profile picture, then select the Teams  tab.

3. From the team list, select the team name.

4. Click the edit icon ( ).

5. Modify the team properties as needed.

6. Click Save.

Manage a membership request

When a user requests membership to a private team, the team administrator receives an email.

Before you begin
Role required: admin

About this task
If you are the team administrator, you can manage membership requests.

Procedure

1. Navigate to Live Feed  > Live Feed.

2. Click Teams  and select the team name.
If one or more users have been invited to the team, the Pending members  tab shows the 
number of invitations sent.
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Pending members

3. Click Pending members.

This shows the users who have received invitations, but who have not yet accepted.

Invited members

4. You can cancel a user's invitation by clicking Remove.

5. You can invite another user to the team by entering their name in the Add user  field and 

clicking the Invite member ( ) button.
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Delete a team

If you are the team administrator, you can delete a team.

Before you begin
Role required: admin

Procedure

1. Navigate to Live Feed  > Live Feed.

2. In the sidebar, click your profile picture, then select the Teams  tab.

3. From the team list, select the team name.

4. Click the edit icon ( ).

5. Click Delete.

6. Click Yes  to confirm deletion.
The team is deleted from Live Feed. Messages posted to a private team are deleted; messages 
posted to a public team remain on the company feed without a team link.

If you delete a team that is associated with an active record, such as an incident that has 
not yet been closed, the team becomes active again when any user modifies that record or 
follows the record on Live Feed. The first user who modifies the record becomes the team 
administrator. The previous messages that existed as part of the record feed are not deleted.

Use Live Feed to work on records

A record feed is associated with a record, such as an incident or change.

Record feeds help users collaborate on records by providing a place for anyone who can access 
the record to share messages and post attachments specific to that record.

With record feeds, users can:

• Follow record feeds and post messages in Live Feed. These messages can also be 
automatically maintained in the comments or work notes journal fields on records.

• View Live Feed from records.

• Work on multiple records from My Feed.

• Access Live Feed team functions, such as sending invitations and subscribing to email 
notifications.

Any users with access to the record can also use the record feed. By default, record feeds are 
available on the incident, change, and problem tables. Administrators can configure record feeds 
for additional tables.
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Live Feed Document

How Document Feeds Work

The Live Feed application creates a document group for each document feed. The document 
group:

• Automatically approves membership for every user who can access the record.

• Uses the record number as the group name.

• Uses the record short description as a group description.

• Maintains all messages posted on the record in Live Feed (if the record has a journal field for 
comments). When the group is created, existing messages are added to the document feed.

• Lists the group when users select View all groups  on their Live Feed interface, unless the 
record associated with the document feed has been closed. When the state of the record is 
closed, the Live Feed group becomes inactive and unlisted.

• Automatically adds users to the document group when they view the record.

Document Group Creation

When a user follows or shows a record on Live Feed, a Live Feed group is automatically created 
and associated to the record (if one does not already exist). The user becomes a member of the 
group and can use Live Feed to work on the record. If the user can access work notes on the 
record, the user also becomes a group administrator.

A Live Feed group is also automatically created when a user creates a record on a table that 
uses document feeds, such as the Incident table. The user who creates the record becomes the 
administrator of the group, and any other user who modifies the same record automatically joins 
the group.

Add Live Feed to a homepage

Add Live Feed to a homepage so it is the first thing you see when you log in.

Before you begin
Role required: admin
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Procedure

1. Click Add  content at the top of the homepage.

2. Select Live Feed  in the left panel.

3. On the bottom of the window, click Add here  in the appropriate layout position, then close the 
window.

Note: 
Administrators can add Live Feed to a global homepage to make it available for all 
homepage users by default. By default, users with any role can add Live Feed to their 
homepage. Administrators can restrict this ability.

Live Feed Homepage

Modifying and deleting document feeds

The user who creates a record feed becomes the group administrator, which allows the user to 
modify the following record feed properties.

• Name: Default value is the record number.

• Description: Default value is the record short description.

• Picture: Default value is a thumbnail image of the record.

Feed administrators can also delete the feed. When deleted, the feed is removed from Live Feed 
but messages remain in the journal field of the associated record.

Viewing Live Feed from records

Interact with the record feed in any form that has Live Feed enabled.
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The record feed appears in a pop-up window. The record feed also appears on the record 
form's activity formatter if the administrator enables the record feed system property 
(glide.ui.show_live_feed_activity).

To access a record feed from the form, do one of the following:

• Click the Show Live Feed  button  in the form header. This displays the Live Feed pop-up.

• Right-click the form header and select Show Live Feed. This also displays the Live Feed pop-
up.

• Scroll down to the activity formatter area on the form. Click one of the following tabs:

◦ Live Feed: click to show a text box to type in the feed.

◦ Activity: click to show the activity summary. The activity filter determines the content in the 
activity summary.

Live Feed Popup

If the activity formatter or the Live Feed  and Activity  tabs are not visible, administrators can do 
the following:

• Configure the form layout and add Activities (filtered)  to the form. This adds the activity 
formatter.

• Personalize the form layout and add Activities (filtered)  to the form. This adds the activity 
formatter.
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• Go to System Definition  > Tables, access the table associated with the record, and verify that 
the live_feed dictionary attribute is set to true on the form. This adds Live Feed to the activity 
formatter.

• Go to Live Feed  > Feed Administration  > Properties  and enable the following property:Toggle 
the display of the Live Feed tab in the activity formatter

Working with record feeds

When a user follows a record, the user becomes a member of a private group for the record.

Team members can do the following:

• View the record feed from Live Feed.

• View a list of group members (other users who are following the record).

• Invite another user to join the group. Only users who have access to the record have access to 
the record feed.

• Subscribe to email notifications.

• Leave the team to stop following the record.

Follow a record feed from a form

You can follow records that have a record feed associated with them from within the record form.

Before you begin
Role required: none

Procedure

1. Navigate to the record in a list or form.

2. Click the Show on Live Feed  icon in the header.

Follow Task

Follow a record feed from a list

You can follow records that have a record feed associated with them when viewing a list of 
records. This method allows you to select multiple records to follow.
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Before you begin
Role required: none

Procedure

1. Navigate to a list of records (for example, Assigned to me).

2. Select the Action  check box beside each record to follow.

3. In the Actions  choice list, select Follow on Live Feed.

Follow My Tasks

Post a message to a record feed

Use Live Feed to post a message to a record feed.

Before you begin
Role required: none

Procedure

1. Open the record feed in one of the following ways:

◦ From your homepage (must already be following the record)

◦ As a team in Live Feed (must already be following the record)

◦ From My Live Feed (must already be following the record)

◦ From the Live Feed  pop-up window

◦ From the Live Feed  tab on the activity formatter

◦ Click the Show Live Feed  button ( ) in the form header.

2. Compose the message and add images and links.

3. In the To list, select the record where you want to post the message.

Note: 
Applies to Live Feed only.
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4. Optional:  Select the Work Notes  check box to post the message as a work note.
Only users with access to work notes on the record can post and see work notes. This option is 
only available for records that have a journal field.

5. Click Post.

Note: 
If the record has journal fields for comments or work notes, your message is automatically 
added to the appropriate field on the record. If the record has a standard text field for 
comments on the activity formatter, each live post overwrites the field value. Comments 
added through Live Feed start with  LiveFeed on the activity formatter.

Use feeds in Live Feed

Feeds allow users to create focused discussions in Live Feed.

Live feed includes different types of feeds. The user who creates a group or record feed 
becomes the feed administrator. This user configures the access level for the feed:

• Public: any user can see the name on the list of all feeds, view the feed, and join it. Messages 
appear on the company feed with a link to the public feed.

• Private: any user can see the name on the list of all feeds, but only invited members can view 
the feed and join. Messages do not appear on the company feed.

Note: 
The concept of groups changed in Live Feed v2.

Create a group feed

Group feeds are created by users so that members with similar interests can find that information 
in one place. Individual users or teams can join group feeds.

Before you begin
Role required: admin

Procedure

1. Navigate to Live Feed  > Live Feed.

2. Click Group Feeds  and click All Feeds.

3. Click Create Group Feed.

Create group feed
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4. Enter the feed name and description.
These will appear in the list of group feeds.

5. Indicate how members can join the feed:

◦ Public Feed: Select this to allow anyone to view and join the group feed.

◦ Private Feed: Select this to restrict membership to only members invited by the 
administrator.

When Private Feed  is selected, the Show this feed for anyone to find and request to join 
check box is displayed. If it is selected, any user can search for this group feed and join it. If 
the check box is not selected, only users who are invited can see the feed and join the group 
feed.

6. Click Create.

Create record feeds

When a user views a record on a table that has Live Feed enabled, such as the Incident 
[incident]  table, the user can click the Show Live Feed  button at the top of the form to 
automatically create a record feed.

When a user who has write access to a record's work_notes  journal field clicks the Show Live 
Feed  button, that user becomes the record feed administrator. If, for example, a customer calls 
technical support to report an incident and the customer clicks Show Live Feed  on a record, a 
record feed is created, but the customer is not the record feed administrator. When a support 
representative later opens the incident and participates in the record feed, the user becomes the 
feed administrator.

Record feeds are, by default, private unlisted. That is, only invited members can see the name 
of the record feed in the list of feeds, and join it. Record feed administrators, however, have the 
ability to change the access level at any time. This can be helpful if, for example, a user is working 
on a sales opportunity and wants customers to be able to participate in a record feed without 
granting them access to the records.

Control how Live Feed is enabled for records

A property called glide.ui.show_live-feed_activity  controls whether Live Feed is 
automatically enabled for all records.

This glide record is disabled by default. If the property is enabled, a record feed is automatically 
created whenever a record is viewed, and you become a member of that feed.

A second property, glide.live-feed.auto_join_document_group, enables 
automatic membership to a record feed whenever the associated document is visited and the 
user clicks Show Live Feed.

View the activity stream in record feeds

When you view record feeds, Live Feed displays the activity stream for the document.

For example, for an incident feed, the screen displays recent activity for the incident. The activity 
stream is updated whenever anything is changed in the associated record.
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Live feed activity stream

Note: 
The information in the activity stream is subject to the same ACL rules as those for viewing 
the underlying document.

Participate in a feed

When you join a feed, you become a feed member.

Before you begin
Role required: none

About this task
Feed members can do the following:

• View messages  posted to the feed. Non-members can also view the messages for a public 
feed.

• View a list of feed members.

• Invite another user to join the feed.

• Subscribe to feed email notifications.

• Leave the feed.

Procedure

1. Navigate to Live Feed  > Live Feed.

2. Click either Group Feeds  or Record Feeds, and then click All Feeds.
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All feeds

◦ If you received an invitation, click Accept. You can Decline  the invitation if you do not want to 
join the feed.

◦ If the feed is public, click Join.

◦ If the feed is private, click Request. The feed administrator receives an email notification and 
must accept your request before you can join the feed.

Mark a feed as a favorite

Top-level messages in feeds can be marked as favorites on a per user basis only.

Before you begin
Role required: none

About this task
You can also search for messages marked as favorites, and remove the favorite designation as 
needed.

Procedure

1. Navigate to Live Feed  > Live Feed.

2. Click either Group Feeds  or Record Feeds, and then click All Feeds.

3. In the list of feeds, click the star icon ( ) adjacent to the feed name you want to mark as a 
favorite.

To unfavorite a message, click the star icon ( ) of a message that is already a favorite.

View a feed

You have several options for viewing a feed.
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Before you begin
Role required: none

Procedure

1. Navigate to Live Feed  > Live Feed.

2. Click either Group Feeds  or Record Feeds.
This displays a list of feeds you belong to and an option to view all feeds.

◦ To view a feed you belong to, select the feed name.

◦ To view a public feed you do not belong to, select Show All  and then click the feed name. 
You must be a member to view the feed for a private feed.

Note: 
If you navigate away from the Live Feed application and then back again, the system 
displays the feed you last visited if you are a member of it.

View a feed member

View a specific member of a group feed.

Before you begin
Role required: none

Procedure

1. Navigate to Live Feed  > Live Feed.

2. Click either Group Feeds  or Record Feeds.
This displays a list of feeds you belong to and an option to view all feeds.

3. Click the feed name.
The list of feed members appears, organized by feed administrators and members.

Invite a new member to a group feed

The feed administrator can invite another user or a group to join a feed.

Before you begin
Role required: none

About this task
When a team is added to a feed, all members of the team also indirectly become members of the 
feed. Only users, and not teams, can be the feed administrators. A team member who is following 
a feed can become administrator by directly inviting another user to the feed.

Procedure

1. Navigate to Live Feed  > Live Feed.

2. Click either Group Feeds  or Record Feeds, and then select the feed name.

3. Click the Pending members  tab.

4. In the Add user or team  field, begin entering a user or team name and select a user or team 
from the suggestion list.
The invited user or team members receive an email notification.

Invite a new member to a record feed

The feed administrator can invite another user or a team to join a record feed.
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Before you begin
Role required: none

About this task
When a team is added, each of the individual members of the team become members of 
the feed. That is, if Team ABC is added to a feed, the feed does not show that Team ABC is a 
member. Instead, the feed shows each of the individual members of Team ABC as members of 
the feed.

When users are invited, their membership state is initially Invited. When they accept the 
invitation, the system checks their access to the work_notes  journal field. If they have write 
access, they become administrator members; otherwise, they become active members.

Procedure

1. Navigate to Live Feed  > Live Feed.

2. Click Record Feeds  and select the record feed name.

3. Click the Pending members  tab.

4. In the Add user or team  field, begin entering a user or team name and select a user or team 
from the suggestion list.

If you invite a team, the individual members of the team are invited.

The invited users receive an email notification.

Remove a member from a feed

The feed administrator can remove any member from the feed.

Before you begin
Role required: none

Procedure

1. Navigate to Live Feed  > Live Feed.

2. Click either Group Feeds  or Record Feeds, and then select the feed name.

3. Click the Members  tab.

4. Locate the member you want to remove and click Remove.
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Remove member

Note: 
You can remove members regardless of their current state. That is, you can remove 
members who have already joined the feed or whose membership is pending.

Subscribe to a feed

Direct members of a feed can subscribe and unsubscribe to the feed in order to receive email 
notifications whenever any activity in the feed occurs, such as new messages being posted, 
replies, likes, polls, and @mentions.

Before you begin
Role required: none

About this task
Individual indirect members—that is, members of a team that is participating in a feed—cannot 
subscribe or unsubscribe from a feed directly. If the team administrator subscribes the team to a 
feed, the individual members receive an email notification for activities in the feed such as new 
messages being posted, replies, likes, polls and @mentions.

All notifications related to a top-level message, such as replies, mentions, and likes, are sent out 
with the same subject. The subject line defaults to Live Feed  followed by the beginning of the 
subject line from the top-level message. For example, if the subject of the feed is IT Support, the 
email notification's subject will be Live Feed IT Support.

Procedure

1. Navigate to Live Feed  > Live Feed.

2. Click either Group Feeds  or Record Feeds, and then select the feed name.

3. Click the subscribe icon ( ).

You can click the unsubscribe icon ( ) to stop receiving email notifications.

Note: 
If a team is subscribed to receive email notifications for a feed, but a member of the team 
did not subscribe to the team, that member does not receive the email notifications.
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Navigate between Live Feed and other modules

If you are participating in a feed and navigate to another module, when you return to Live Feed it 
displays the feed you were previously viewing if it is public or if it is a private feed that you are a 
member of.

For example, assume you are viewing a public feed and then navigate to a particular incident 
record. Upon returning to Live Feed, the feed you were previously viewing opens. If you were last 
viewing a private feed that you are not a member of, returning to Live Feed opens the Company 
Feed.

Leave a feed

Members can choose to leave a group feed.

Before you begin
Role required: none

Procedure

1. Navigate to Live Feed  > Live Feed.

2. Click either Group Feeds  or Record Feeds, and then select the feed name.

3. Click Leave.

Note: 
If you leave a feed  associated with a record, such as an incident, you automatically rejoin 
that feed if you modify the associated record again.

Delete a feed

If you are a feed administrator, you can delete the feed.

Before you begin
Role required: none

Procedure

1. Navigate to Live Feed  > Live Feed.

2. Click either Group Feeds  or Record Feeds, and then select the feed name.

3. Click Delete.

4. Click Yes  to confirm deletion.
The feed is deleted from Live Feed. Messages posted to a private feed are deleted. Messages 
posted to a public feed remain on the Company Feed without a feed link.

Live Feed UI overview

The Live Feed user interface provides many methods you can use to share content with others in 
your organization.

Important: 

Core UI  is required to use Live Feed. Live Feed is not supported in Next Experience. If you 
turn on Next Experience, Live Feed will no longer work. See Next Experience UI  for more 
information.
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Update your Live Feed profile

Your profile information includes a photo or image, and tabs for different types of information 
including messages, feeds, teams, followers, and those who are following you. You can update 
your profile information and picture at any time.

Before you begin

Important: 

Core UI  is required to use Live Feed. Live Feed is not supported in Next Experience. If you 
turn on Next Experience, Live Feed will no longer work. See Next Experience UI  for more 
information.

Role required: none

About this task
You can provide details about yourself, such as your role in your organization. You can also 
update your profile picture. However, only admins can delete a profile picture.

Note: 
The functionality described here applies to HTML5-compliant browsers, such as Chrome, 
Firefox, Safari, and IE10 and above.

Procedure

1. Navigate to Live Feed  > Live Feed.

2. Click your name or title displayed with your picture.

Profile

The profile record opens.
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Profile record

3. Click the pencil icon next to About Me  and type a short description about yourself that you 
want to share with others who view your profile.
This is text that you might not necessarily want to change on a regular basis.

4. You can change your profile photo using either of the following two methods:

◦ Hover over the existing picture (or tap the photo in the case of the smartphone or tablet 
interface) to display the Upload a picture  link. Select the link, navigate to the location of the 
photo you want to use, and then select Open.

◦ Locate the photo file you want to use on your computer, and then drag-and-drop it over the 
existing photo.

Upload a picture link

Note: 
Your profile picture is used by the Connect and legacy chat features as well, if they are 
activated.

Work with Live Feed messages

This portion of the UI gives the user access to various types of messages and tools for grouping 
and categorizing messages. Also included are methods for identifying which user feeds you are 
following and which users are following you.
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Tools for working with Live Feed messages

Menu section Description

• My Live Feeds: These are custom feeds that allow you 
to customize Live Feed to view the content that is most 
important to you.

• Company Feed: This feed displays all posts, except those 
posted to private or unlisted groups.

• Group Feeds: These feeds are created by users. Record 
Feeds: These feeds are associated with a record, such as an 
incident or change.

• Record feeds: These feeds help users collaborate on records 
by providing a place for anyone who can access the record to 
share messages and post attachments specific to that record.

• People: This option displays people who are following the 
current user and people the current user is following.

• Teams: This option is used to combine users into groups 
for the purpose of subscribing to specifically-focused 
conversations.

• Hashtags: Hashtags are words marked with a hash ( ) symbol 
in messages. Hashtags are used to categorize messages 
by keyword or topic for improved search results messages 
filtered from all conversations that include specific hashtags.

View another Live Feed user

When a requester user, one that has no ServiceNow role, is viewing a feed and points to 
another user's picture, information for the user appears from the Business Card view of the User 
[sys_user] table.

Before you begin
Role required: none

About this task
Admins can change the amount of information that is displayed for users with different roles.

Procedure

1. Select a profile picture in your feed.

A user summary appears.
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View profile

2. Select the profile picture to view the full profile.
Use the tabs to view different types of information about the user.

Profile tabs

Follow other Live Feed users

As you use Live Feed, you can follow the message threads of other users.

Before you begin
Role required: none
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Procedure

1. Navigate to a thread that the user you want to follow is engaged in.

2. Click that user's name or point to the user's picture.
A Follow  link appears in the user's profile.

Profile with Follow link

3. Click Follow.

4. To stop following the user, navigate to People  > Following.

Unfollow

5. Click Unfollow.

6. To view people who are following you, navigate to People  > Followers.
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Select feeds

A feed is a stream of related messages. You can use the feed selector to switch between feed 
types and to view specific group feeds and record feeds.

Before you begin
Role required: none

Procedure

1. Use the Search  field to locate any type of feed.
As you type in the Search  field, the results are dynamically displayed. For example, if you type 
INC, records that are incidents are forced to the top of the results list.

Feed selector

2. You can also select the following types of feed information.

Feeds types

Feed Description

My Live Feeds Displays the following posts:

◦ messages from users you follow

◦ messages with hashtags you follow

Company Feed Displays all posts, except those posted to private or unlisted groups.

Add Group Feed Allows you to add a group feed.
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Follow feeds

You can view users who are following you or other users you are following.

Before you begin
Role required: none

Procedure

1. Click People  in the sidebar.

The system shows 10 most recent followers or users you are following.

People

2. Click the Show More link if either list contains more than 10 users.

Note: 
If you are following a particular user whose profile changes, that user moves to the front 
of the Following list. This alerts you to changes in the profile of a user you are following.

Bookmark feeds and hashtags

The Live Feed interface uses the standard bookmarking functionality for feeds and hashtags.

Before you begin
Role required: none

Procedure

Drag-and-drop group feeds and hashtags from the Feed Summary section to the Edge for quick 
access.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4726



Bookmark a hashtag

Add Live Feed to your homepage

You can add Live Feed to your own homepage or to a global homepage.

Before you begin
Role required: none

Procedure

1. Navigate to a homepage.

2. Click the add content icon ( ) in top left corner of the homepage.

3. Select Live Feed in the left panel.

4. On the bottom of the window, click Add here  in the appropriate layout position, then close the 
window.
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Homepage

Note: 
Administrators can add Live Feed to a global homepage to make it available for all 
homepage users by default. Users with any role can add Live Feed to their homepage; 
however, administrators can restrict this ability.

Post content in Live Feed

In Live Feed, you can post new messages and replies to existing messages for all users in the 
feed. You can also send a reply message to a team or record.

Important: 

Core UI  is required to use Live Feed. Live Feed is not supported in Next Experience. If you 
turn on Next Experience, Live Feed will no longer work. See Next Experience UI  for more 
information.

Attachments in feeds

In addition to entering text, you can attach files, such as images, documents, and spreadsheet 
files in any ServiceNow  supported file type to Live Feed messages.

Administrators can manage attachment file settings, such as supported file types and maximum 
attachment file size, by editing system properties .

You can also include links to user-defined URLs and knowledge articles contained in your 
instance's knowledge base.
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Note: 
The functionality described here applies to HTML5-compliant browsers, such as Chrome, 
Firefox, Safari, and Internet Explorer 10 and above. Significant differences while using 
different browsers are highlighted.

Post a Live Feed message

You can post a message to open a new feed.

Before you begin
Role required: none

Procedure

1. Navigate to Live Feed  > Live Feed.

2. Click the feed to which you want to post your message, for example My Live Feed, Company 
Feed, and so on.

3. Enter a message in the Share your thoughts  field.
Use hashtags, if you want.

4. As needed, click , , or  to add a poll, attachment, or screenshot image, respectively.

5. Click Post.

Reply to a Live Feed message

To participate in an existing thread of a feed, you can compose and submit a reply message. By 
default, the message is visible to all members of the feed.

Before you begin
Role required: none

Procedure

1. Navigate to Live Feed  > Live Feed.

2. Locate the message you want to reply to.

3. Type your reply in the message box and click Reply.
As needed, you can add hashtags, attachments, links, or knowledge base articles.

4. To limit who can view the reply to a single individual, select a user from the To  choice list.

5. Click Reply.

6. To view additional replies, click Show all replies.
By default, 7 replies are visible for each message. Any reply to a reply includes a Threads  link.
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7. Click Threads  to view all of the replies within the selected reply in reverse chronological order 
within the Message Thread  pop-up window, similar to an email thread.

Message thread

Attach a file to a post or reply

You can attach files to a post by dragging a file into a post or pasting an image from the clipboard.

Before you begin
Role required: none

About this task
Use the paperclip icon ( ) to drag files into a post. Additionally, you can paste images into a post 
or reply from the clipboard.

Procedure

1. Do one of the following:

◦ While composing a post or reply (see Reply to a Message), locate one or more images or 
other supported types of files, and drag them into the message box.

◦ Click the paperclip icon ( ) in the message box, navigate to the location of the files you want 
to attach, select them, and click Open.

2. To add more files, drag-and-drop additional files into the text box below the displayed files or 
images, or click the plus sign.
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Attaching files

3. If you want to delete an attachment before posting the message, click the trashcan icon 
adjacent to the attachment.

4. Enter a comment to share your thoughts about the image.

Note: 
The Post  button is enabled only after you add the comment.

5. Click Post  or Reply.

6. If you added files that do not contain previews and then posted the message, they will be listed 
in the message box with a Download  link.

7. Click the link to download the files.

Copy an image from the clipboard

In addition to adding files to a message, you can also copy images to the clipboard and paste 
them into a message or reply.

Before you begin
Role required: none
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Procedure

1. Click into the Comment  box and add a comment.

Copy paste

2. Click the Add an image  button.
The Screenshots  dialog box opens.

3. Right-click the Paste an image here  box and select Paste  to paste the image from the 
clipboard.

Copy pasted

4. To add another image, repeat the previous steps.

5. When you finish pasting images into the message, click Done.

6. To change the link text, click Pasted Image  and enter a new label.

7. When you finish, click Post  or Reply.

8. To remove an image, click the trash can icon adjacent to the link.
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9. To make changes to an existing image, click the edit icon ( ).

Note: 
The copy/paste functionality is supported in Chrome, Firefox, and Internet Explorer 11.

Add a link to a post or reply

Add or modify a link to a Live Feed post.

Before you begin
Role required: none

Procedure

1. Click into the Comment  box.
The Add a link  button appears.

2. Click the Add a link  button.
The URL  and Link text  fields appear.

Add a URL

3. Enter the URL and the text you want to appear as the link.

4. To add another link, click the link icon under the URL  field.

5. When you have finished entering your message, click Post  or Reply.

URL Saved

To remove a link, click the trash can icon adjacent to the link. To make changes to an existing 

link, click the edit ( ) icon.
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Add a knowledge article link to a post or reply

Use the ID of a knowledge article to post it as a reply to a Live Feed conversation.

Before you begin
Role required: none

Procedure

1. While composing a post or reply, type the ID of the knowledge article you want to link to.
You do not need to identify the knowledge article ID as a hyperlink. Live feed recognizes it as 
such and automatically converts it into a link when the message is posted.

2. When you are finished entering your message, click Post  or Reply.

KB link

Add a poll to a message

When you are posting a message, you have the option of creating a poll in order to record your 
viewers' opinions. As users take the poll, their feedback statistics are displayed within the feed.

Before you begin
Role required: admin

Procedure

1. Open the feed where you want to create a message with a poll.

2. Enter the message with an invitation to take the poll in the Share your thoughts  box.

3. Click the poll ( ) icon.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4734



Poll

4. In the Question  field, enter the question on which you are soliciting opinions.

5. In the Option  fields, enter possible responses to the query.

6. To add more response options, click Add more options.

7. Click Post.
After the poll is posted, users who view the message can vote. After they vote, their pictures 
appear next to their response, with others who have voted for the same option.

An email notification with the poll result is sent to all participants of the poll informing them that 
the poll is closed.

Add mentions to a message

An @mention is any posted update that contains @username anywhere in the body of the 
message.

Before you begin
Role required: none

About this task
The user's name, with a link to that user's feed, is inserted into the message. Additionally, the 
mentioned user receives an email notification about the mention. This is a great way of bringing 
attention to other members in a conversation. All @mentions are included in the logged-in user's 
My Feed.

Note: 
If an @mention is used by a member of a team, only members of that team appear in the 
auto-suggest list.
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Procedure

1. While entering a message or reply in a conversation, type @username  anywhere in the 
message.
As you type, an auto-suggest list appears with names and pictures of users that match your 
entries. For example, if you type @t, the auto-suggest list shows the pictures and names of all 
users with names that start with T.

2. Click the user you want to add.
That user's name is inserted into the @mention in the body of the message.

Note: 
My Feed displays @mentions of you and the teams you are a member of. Profile feeds for 
another user display only @mentions of that user.

Like a message

Like a message to provide feedback to the author.

Before you begin
Role required: none

Procedure

1. Navigate to All  > Live Feed  > Live Feed.

2. Click Feeds.

3. Locate the feed that contains the message you want to like.

4. Under the message title, click Like.
If the message has previously been liked, the number of likes for a message displays next to 
the Like link.

For a top-level message, the profile pictures of the first 5 users who liked a message are 
displayed. Any additional users who liked the message can be viewed by hovering over the 
# more  link. If the logged-in user has liked the message, that user's image will appear first, 
followed by the image of the user who last liked the message.
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For a reply, you must hover your mouse pointer over the count  link to view the users who liked 
the message.

Note: 
After a message has been liked, it cannot be unliked.

Delete a message

Users can delete any of their own posts or replies. A conversation administrator can also delete 
messages.

Before you begin
Role required: none

Procedure

1. Hover over the message you want to delete.

2. Click the trash can icon in the upper-right-hand corner of the message box.

3. Click Delete  in the confirmation box.
The message disappears from the feed.

Live Feed reference

Topics in this section describe domain separation in Live Feed, as well as the various 
components that are installed with it.

Important: 

Core UI  is required to use Live Feed. Live Feed is not supported in Next Experience. If you 
turn on Next Experience, Live Feed will no longer work. See Next Experience UI  for more 
information.

Domain separation in Live Feed

This is an overview of domain separation and Live Feed. Domain separation enables you to 
separate data, processes, and administrative tasks into logical groupings called domains. You 
can control several aspects of this separation, including which users can see and access data.

Overview

Support: Level 2

Parent and child domains define the Live Feed content that can be viewed and shared with other 
users.

• A user in a parent domain can see users and content within their domain and within all child 
domains that are lower in the domain hierarchy.

• A user in a child domain can see users and content within their domain but cannot see the 
parent domain or other child domains at the same level in the domain hierarchy.

Enable domain separation for Live Feed

Domain separation for the Live Feed application is available starting with the Eureka release. For 
users upgrading to Eureka, a sys_domain column is added to existing live feed-related database 
tables. For existing database records, the value of the sys_domain field is set to empty (global). 
This allows the domain separation feature to work with existing Live Feed records.
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Show or hide the Live Feed application for a domain

The administrator can Live Feed visibility for a domain. This includes:

• Displaying Live Feed in the application navigator.

• Following a document feed for a record.

• Viewing Live Feed from a record.

Use Live Feed with domain separation

All of the Live Feed features are available to users within a domain and work the same way, with 
some exceptions to visibility.

• Posting and sharing content

◦ Users in a child domain can interact with other users in the same domain. This includes 
posting and replying to messages, deleting messages, attaching files and links, and rating 
content.

◦ Users in a parent domain can interact with other users in the same domain and with users in 
any child domains. Messages that are added to child threads by parent users are given the 
visibility of the child domain, not the parent domain.

• Viewing content

◦ Users in a child domain can view content that resides within their domain. This includes 
filtering by feed, sorting, searching, and viewing older messages.

◦ Users in a parent domain can view content that resides within their domain and within any 
child domains.

◦ My Feed shows messages, teams, and hashtags based on the user's domain. Showing 
another user's feed only shows posts visible in the current user's domain.

• Using hashtags

◦ Hashtags are separated by domain. Users in a child domain can use all of the hashtag 
functions within their domain. This includes tagging messages, viewing available hashtags, 
changing hashtag names, and searching and filtering by hashtag.

◦ Users in a parent domain can use all of the hashtag functions within their domain and can 
see hashtags in any child domains.

• Using teams

◦ Teams are separated across domains. Users in a child domain can join and follow teams 
within their domain, and can invite other users within their domain to join teams.

◦ Users in a parent domain can join and follow teams that belong to their domain or to any 
child domains.

• Exceptions to teams

◦ New teams are created in the user's domain. However, if the team has a record associated 
with it, the team is created in record's domain.

◦ New threads in an existing team are created in the domain of the existing team.

◦ When a user is creating a new team from a document, if the document domain is not empty 
or global, the team domain needs to be changed to be the document's domain.

◦ For a document-generated team, when the domain of the document changes, the domain of 
all related Live Feed records changes as well.

• Subscribing to email notifications

Users can subscribe to email notifications from users and teams within their domain only.
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Related topics

Live Feed security and table access

Limit Live Feed access by role

Manage Live Feed message content

Live Feed team security

Restrict hashtag renaming

Domain separation

Components installed with Live Feed

Several types of components are installed with Live Feed.

Demo data is available with Live Feed.

Tables installed with Live Feed

The Live Feed plugin includes the following tables.

Table Description

Link attachments

[live_link]

Stores links and attachments that are added to messages.

Live Favorite

[live_favorite]

Stores the favorite conversations, user groups, and messages.

Live Feed Searches

[live_feed_search]

Stores Live Feed text searches. Access at Live Feed  > Feed 
Administration  > Search Log.

Live Follows

[live_follow]

Maintains users' follow preferences for user feeds.

Live Group Profile 
[live_group_profile]

Stores conversation properties, including name, description, and 
public status. Also stored are user group properties, such as name, 
description, and public status.

Live Group Member 
[live_group_member]

Maintains the member lists for conversation and user group.

Live Mention

[live_mention]

Stores the profiles mentioned in a message. References sys_user 
table.

Live Message Tag

[live_message_tag]

Stores messages associated with user-created tags. Appears as a 
related list on Live Tag records.

Live Messages

[live_message]

Stores messages. References sys_user table. Access at Live Feed  > 
Feed Administration  > Messages.

Live Poll Stores a poll question.
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Table Description

[live_poll]

Live Poll Cast

[live_poll_cast]

Stores profiles of users who voted for a particular option in a poll.

Live Poll Options

[live_poll_option]

Stores poll options.

Live Profiles

[live_profile]

Stores user Live Feed profiles. References sys_user table. Access at 
Live Feed  > Feed Administration  > Profiles.

Live Table Notification

[live_table_notification]

Generates automatic table notifications, such as when a user reads 
Live Feed for the first time and when a high priority incident is opened. 
Access at Live Feed  > Feed Administration  > Table Notifications.

Live Tag

[live_tag]

Maintains user-created tags. Access at Live Feed  > Feed 
Administration  > Tags.

Live Tag Follows

[live_tag_follow]

Maintains users' follow preferences for tags.

Messages Liked by

[live_message_like]

Maintains like ratings for posts. Access at Live Feed  > Feed 
Administration  > Likes.

User roles installed with Live Feed

The Live Feed plugin includes the following user roles.

To learn more about managing subscriptions, see Managing per-user subscriptions in 
Subscription Management  and contact your account representative.

live_feed_admin

Can manage Live Feed functions. Users with the live_feed_admin role can set up table 
notifications for non-task tables, limit Live Feed access by role, and manage Live Feed message 
content.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.
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Special considerations

Note: 
Avoid granting an admin role when more specialized roles are available.

chat_admin

Can manage chat functions (if the Chat plugin is activated). Users with the chat_admin role can 
change chat room message read access and define chat room access rights.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

Note: 
Avoid granting an admin role when more specialized roles are available.

Script includes installed with Live Feed

The Live Feed plugin installs the following script includes.

Name Description

LiveMsgUtil Provides helper functions for working with live_message records.

LiveFeedFilter Queries filters for working with live_feed records.

LiveFeedUtil Provides helper functions for working with live_feed records.

Business rules installed with Live Feed

The Live Feed plugin includes the following business rules.

Business rule Table Description

Feed Group 
Creator 
Becomes 
Admin

Live Group Profile

[live_group_profile]

Designates the group creator as the group 
administrator.

Live Feed 
events

Task

[task]

Runs on task insert, update, and delete. Triggers 
event associated with the Live Feed Update Script 
action that processes Live Table Notifications to 
auto-generate Live Feed messages.

Live feed 
member 
update 
events

Live Group Member

[live_group_member]

Generates a notification event when member state 
changes (invited, accepted, declined, left, rejected, 
request, request_accepted).
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Business rule Table Description

Live feed 
integration

Journal Entry

[sys_journal_field]

Writes journal comments to the Live Feed if there is a 
group for this record.

Live feed 
new 
member 
events

Live Group Member

[live_group_member]

Generates a notification event when new members 
are added.

Live Feed 
profile 
events

Live Profile

[live_profile]

Runs on live_profile insert/update/delete, triggers 
event associated with the Live Feed Update script 
action that processes Live Table Notifications to 
auto-generate Live Feed messages.

Live Feed 
message 
events

Live Feed Message

[live_message]

Runs on live_message, notification event trigger for 
new live messages.

Live 
message 
like events

Message Liked by

[live_message_like]

Runs on live_message_like, notification event trigger 
for new like records.

LiveFeed 
Group 
Member 
Visibility 2.0

Live Group Member

[live_group_member]

Ensures users can only see the members list for 
public groups and groups they belong to.

LiveFeed 
Group 
Profile 
Validation

Live Group Profile

[live_group_profile]

Ensures that a public group is visible.

LiveFeed 
Group 
Profile 
Visibility 2.0

Live Group Profile

[live_group_profile]

Ensures that the list of all groups only displays public 
groups, private groups that are visible, and groups 
the user belongs to.

LiveFeed 
Membership 
Changes

Live Group Member

[live_group_member]

Enforces that only the group administrator and users 
with live_feed_admin role can manage membership 
for a group.

LiveFeed 
Single 
Group 
Membership

Live Group Member

[live_group_member]

Ensures that a user is not added multiple times to 
the same group.

Live 
Message 
Likes

Live Message Like

[live_message_like]

Updates the number of likes for a message.

LiveFeed 
Join Group 
Check

Live Group Member

[live_group_member]

Ensures that users can not automatically join private 
visible groups.

Update 
Follow/
Follower 
Counts

Live Follow

[live_follow]

Updates the following/followers counts.
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Business rule Table Description

Live Feed 
Group

Assessable Record

[asmt_assessable_record]

Creates/Deletes a Live Feed group for an 
assessable record

Live Feed 
Message 
Visibility

Live Feed Message

[live_message]

Ensures user's access to Live Feed messages

Email notifications installed with Live Feed

The Live Feed plugin includes the following email notifications.

Email notification Description

Live Feed Feed Member 
Accepted

Sends an email to the administrator when a user has accepted to 
join the feed.

Live Feed Feed Member 
Declined

Sends an email to the administrator when a user has declined to 
join the feed.

Live Feed Feed Member 
Invited

Sends an email to a user when they have been invited to join a 
feed.

Live Feed Feed Member 
Left

Sends an email to the administrators when a user has left the 
feed.

Live Feed Feed Member 
Removed

Sends an email to user when they have been removed from the 
feed.

Live Feed Feed Member 
Request

Sends an email to administrators when an user requests to join a 
feed.

Live Feed Feed Member 
Request Accepted

Sends an email to the user when their request to join a feed is 
accepted.

Live Feed Feed Request 
Rejected

Sends an email to the user when their request to join a feed has 
been rejected by an administrator.

Live Feed MsgReply 
Subscription

Sends an email when a reply or reply_to_reply message is 
inserted into the thread of a message in a feed.

Live Feed Team Member 
Accepted

Sends an email to administrators when a user accepts an 
invitation to join a team.

Live Feed Team Member 
Declined

Sends an email to administrators when a user declines an 
invitation to join a team.

Live Feed Team Member 
Invited

Sends an email when a user is invited to join a team.

Live Feed Team Member 
Left

Sends an email when a user leaves a team.

Live Feed Team Member 
Removed

Sends an email when an administrator has removed a user from a 
team

Live Feed Team Member 
Request

Sends an email when a user requests to join a team.

Live Feed Team Member 
Request Accepted

Sends an email when a user's request to join a team is accepted.
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Email notification Description

Live Team Member 
Request Rejected

Sends an email when a user's request to join a team is rejected.

Live Message All 
Subscription

Sends an email to subscribed users when any message (new or 
reply) is posted.

Live Message Feed 
Subscription

Sends an email when a new message is inserted into a feed.

Live Message Liked Sends an email to the creator of a message when another user 
likes the message.

Live Message Mention Sends an email to a user when that user is mentioned in a 
message.

Live Message New Posts 
Subscription

Sends an email to subscribed users when a new (not reply) 
message is posted.

Live Message Reply Sends an email to all users in a feed thread when a user posts a 
reply (live_message.replied event).

E-signature
Sign electronic documents from any desktop or mobile device with e-signature. E-signature is a 
scoped application that enables users to sign managed documents or knowledge articles with 
their typed or drawn e-signature, credentials, or as an acknowledgment.

Get started

Activate

Activate e-signature.

Use

Create or modify e-
signature templates.

Reference

Learn about the 
components installed 

with e-signature.

Troubleshoot and get help

• ServiceNow Community forums

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support

Activating e-signature

You can activate the e-signature plugin (com.snc.esign) if you have the admin role. This plugin 
includes demo data and activates related plugins if they are not already active.

Before you begin
Role required: admin
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About this task
E-signature activates these related plugins if they are not already active.

Plugins for E-signature

Plugin Description

ServiceNow document viewer

[com.snc.documentviewer]

Document viewer is a platform feature that will enable 
users to view enterprise class documents inline within the 
platform attachment instead of downloading it to the local 
device and then opening the documents with a locally 
installed viewer.

Managed documents

[com.snc.document_management]

Managed Documents application. To enable the ability to 
publish to the knowledge base, activate the knowledge 
document plugin.

Signature pad

[com.snc.signaturepad]

Provides a tool to allow a digital signature in a .pdf 
document. The Human Resources application uses this 
with various documents.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.

Note: 
When domain separation and delegated admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .

Using e-signature

Users with the assigned e-signature roles can create templates for documents that require an 
electronic signature.

Role assignment

Before you begin using e-signature, you must assign the e-signature roles to the appropriate 
roles, groups, or users in your application. See Components installed with e-signature  for more 
information.

How to use e-signature templates

Users with the e-signature administrator [sn_esign.admin] or manager 
[sn_esign.config_manager] role can create e-signature templates. Each e-signature template 
pairs a document type to sign (managed document or knowledge article) with a signature type 
(signature, credential, or acknowledgment). For example, you could create an e-signature 
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template for a non-disclosure agreement that requires a typed or drawn signature. For more 
information, see Create or modify an e-signature template.

You can then use the e-signature template in task forms to request electronic signatures from 
users. In the HR Service Delivery  application, for example, you can add HR tasks to HR cases 
or configure HR task templates to request electronic signatures per the selected e-signature 
template. See E-signature for HR  for HR-specific examples.

Create or modify an e-signature template

Create or modify an e-signature template to define an electronic document and signature 
configuration for use in task forms.

Before you begin
Role required: sn_esign.admin or sn_esign.config_manager

Each template is associated with a document type such as a managed document or knowledge 
article, and you can configure the template so that the signatory is required to sign the document 
with their typed or drawn signature, credentials, or as an acknowledgment.

Procedure

1. Navigate to All  > E-signature  > E-signature template.

2. Click New  or open a record.

3. Fill in the fields on the form.

E-signature template form

Field Description

Name Name of the e-signature template.

Task table Task table that the e-signature template is associated with.

Document type Document type of the e-signature template. Select one of the 
following:

◦ HR document template: Make sure that the Task table  field is set 
to HR Task [sn_hr_core_task].

The HR document template that the signatory will sign is selected 
on the HR case form. See Select an HR document template for an 
e-signature task  for more information.

◦ Knowledge article: In the Knowledge article  field, select the 
knowledge article that the signatory will sign.

◦ Managed document: In the Managed document  field, select the 
managed document that the signatory will sign.

Signature type Signature type of the e-signature template. Select one of the 
following:

◦ Acknowledgment: The signatory acknowledges the document by 
accepting and completing the task.

Note: 
This option is not available for HR document templates.

◦ Credential: The signatory signs the document with their 
credentials.
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Field Description

Note: 
This option is not available for HR document templates.

◦ Signature: The signatory signs the document with their typed or 
drawn signature.

Acknowledgment text Adds a check box with accompanying acknowledgment text that the 
user must select before the signing is completed. This option can be 
used with any signature type.

Note: 
Acknowledgment text is limited to 1,000 characters.

4. Click Submit  or Update.

What to do next
You can use the e-signature template in task forms to request electronic signatures from users.

E-signature reference

Activating the e-signature plugin installs additional roles and tables.

Components installed with e-signature

Several types of components are installed with activation of e-signature, including tables and 
user roles.

Note: 
The Application Files table lists the components that are installed with this application. 
For instructions on how to access this table, see Find components installed with an 
application .

Demo data is available for this feature.

Roles installed

Role title [name] Description Contains roles

E-signature administrator

[sn_esign.admin]

Can manage the e-signature module. sn_esign.config_manager

E-signature manager

[sn_esign.config_manager]

Can manage the e-signature 
configurations.

None

You can assign these roles to the appropriate roles, groups, or users in your application.

• To assign a role to another role, see Add a role to an existing role .

• To assign a role to a group, see Assign a role to a group .

• To assign a role to a user, see Assign a role to a user .
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For further information on user administration and how to manage users, see User 
administration .

Tables installed

Table Description

E-Signature Configuration

[sn_esign_configuration]

E-signature configuration table.

E-Signature Acknowledgement

[sn_esign_acknowledgement]

E-signature acknowledgment table.

For further information on table administration and how to manage data, see Table 
administration .

ServiceNow  Voice
Integrate a third-party phone system with your ServiceNow®  Voice  instance to drive the 
efficiency of your call center without having to navigate through multiple systems while attending 
a call. Help managers analyze the calls and view call metrics at one place.

ServiceNow  Voice  in action

Here's an overview on how ServiceNow Voice is integrated with Amazon Connect.  ServiceNow 
Voice with Amazon Connect

Explore

Learn about how 
customers, agents, 
and managers use 
ServiceNow Voice.

Set up

Set up ServiceNow Voice.

Integrate

Extend ServiceNow Voice
capabilities by integrating 

with other applications.
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Use

Receive inbound calls, 
place outbound calls, 

and monitor calls.

Reference

Get details about 
components such as 
roles, contact flows, 

and operation handlers.

Additional resources

Voice  API on the ServiceNow®  Developer Site

Exploring ServiceNow  Voice

Use ServiceNow  Voice  to facilitate inbound and outbound telephone calls by integrating your 
ServiceNow  instance with a third-party phone system such as Amazon Connect.

Key features

Integrate a third-party phone system with Voice  in the ServiceNow  instance

Provide a seamless inbound and outbound voice call experience for your callers 
and agents using third-party systems. See the ServiceNow Store  for a full list of 
integrations.

Integrate third-party phone system

Display relevant data for an agent at the right time

Display relevant data in an interaction for an agent to help a customer during a call.
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Route calls to agents

Analyze recording and call metrics of interactions

Within your ServiceNow  instance, access recordings, call metrics, and call 
transcripts of agents to analyze interactions.

Review and analyze call transcripts

As an admin, you can:

• Use pre-built instructions and templates to integrate your ServiceNow  instance with a third-
party phone system such as Amazon Connect.

• Use pre-built operation handlers that invoke interactions to fulfill requests between a third-
party phone system and Voice.

As a manager, you can:
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• View the call transcript and recording for coaching.

• View call metrics (for example, agent call time) for reporting.

• Analyze agent conversations and provide feedback for quality assurance.

As an agent, you can:

• Get calls routed to your assigned queues and accept or reject the calls via the integrated 
softphone from within the ServiceNow  instance.

• Transfer a call to another agent or to a queue using Quick connect.

• Get the context of caller information before accepting a call.

• View real-time transcripts of calls while interacting with a customer. For more information about 
real-time transcripts, see

• Collaborate with managers who can analyze your conversations and provide feedback for 
quality assurance.

• Manage presence states within the ServiceNow  instance. For information about the presence 
states of an agent, see Agent Inbox controls.

• Access and use your softphone directly from within the ServiceNow  interface using the 
OpenFrame integration. For information about OpenFrame, see OpenFrame overview .

As a caller, you can:

• Create a task using voice-based interactions. For example, create an incident or a case, or 
unlock your account.

• Get your requests fulfilled within the integrated ServiceNow  instance through bot interactions 
using the voice or dual-tone multi-frequency (DTMF) inputs. These bot interactions are defined 
in contact flows in the third-party phone system.

• Speak to an agent who can help fulfill a request.

Inbound call workflow for the integration of Voice  with Amazon Connect

When a caller contacts the call center, using the voice or dual-tone multi-frequency (DTMF) 
inputs from a caller, a contact flow is invoked in the Amazon Connect  instance based on the 
caller context such as language. An interaction record is created for this call.

• The caller request will invoke an operation handler in the ServiceNow  instance.

• The request can be resolved by an automated interaction with a bot. If the caller request is not 
resolved by an automated interaction with bot, then the call is queued for the next available 
agent. An agent then receives the call and interaction, and resolves the request.

Here is an example workflow.
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Amazon Connect Integration
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Setting up ServiceNow  Voice

Enable ServiceNow  Voice  and integrate it with a third-party phone system such as Amazon 
Connect.

When you set up a third-party phone system and integrate it with the ServiceNow  instance, an 
agent can accept an incoming call or make an outbound call from the ServiceNow  instance using 
the integrated softphone. This experience is based on the configurations made within the third-
party phone system.

Here's an overview of setting up Voice:  Video that provides an overview of setting up ServiceNow 
Voice on Amazon Connect.

Get started with Voice

1. Procure a license for a ServiceNow  application, such as ITSM or CSM, which includes 
ServiceNow  Voice.

2. Install the ServiceNow  Voice  applications in ServiceNow®  Store. For information about this 
installation, see Install ServiceNow Voice applications.

3. Sign up and create an account with a third-party phone system. By default, Amazon Connect 
is supported. For information about creating an Amazon Web Services  (AWS) account, see the 
Amazon documentation .

4. Configure the framework for the third-party phone system within the ServiceNow  instance. 
By default, the framework is supported for Amazon Connect. For information about this 
configuration, see Integrate ServiceNow Voice with Amazon Connect.

Install ServiceNow  Voice  applications

You can install the ServiceNow  Voice  applications if you have the admin role. The application 
includes demo data and installs related ServiceNow®  Store  applications and plugins if they are 
not already installed.

Before you begin

• Ensure that the application and all of its associated ServiceNow Store  applications have valid 
ServiceNow  entitlements. For more information, see Get entitlement for a ServiceNow  product 
or application .

• Your organization must have purchased a license for a ServiceNow  application, such as ITSM 
or CSM, which includes the ServiceNow  Voice  SKU.

• You should install at least one content pack, for example, CSM or ITSM.

Role required: admin

About this task
The following ServiceNow  Voice  applications should be installed.

ServiceNow  Voice  applications

Application Description Components installed

ServiceNow Voice

[sn_cti_core]

Provides the framework that 
supports the integration with your 
third-party phone system.

For information about the 
components installed 
with this application, see 
Components installed with 
ServiceNow Voice Core.
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ServiceNow  Voice  applications  (continued)

Application Description Components installed

ServiceNow Voice with 
Amazon Connect

[sn_cti_amzn_cct]

Integrates Amazon Connect with 
ServiceNow  Voice  Core.

For information about the 
components installed 
with this application, see 
Components installed with 
Amazon Connect Integration 
with ServiceNow Voice.

ServiceNow Voice UI 
Components

[sn_cti_ux]

Enables call recording, 
transcription, and sentiment 
analysis for ServiceNow  Voice  with 
Workspace experience.

None

ServiceNow Real Time 
Transcription

[sn_cti_amzn_cct]

(Available for ServiceNow 
Voice  for Customer Service 
Management  only.)

Enables real-time call transcription 
so that the agent can see the call 
transcript while on a call with the 
customer.

[sn_cti_csm_cnt.enable_ims_update]

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find these applications using the filter criteria and search bar.

◦ ServiceNow  Voice  (sn_cti_core)

◦ ServiceNow Voice with Amazon Connect (sn_cti_amzn_cct)

◦ ServiceNow Voice UI Components (sn_cti_ux)

You can search for the application by its name or ID. If you cannot find the application, you 
might have to request it from the ServiceNow Store.

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released 
apps, see the ServiceNow Store  version history release notes .

3. In the Application installation dialog box, review the application dependencies.

Dependent plugins and applications are listed if they will be installed, are currently installed, or 
need to be installed. If any plugins or applications need to be installed, you must install them 
before you can install the Voice  applications.

◦ ServiceNow Voice (sn_cti_core)

◦ ServiceNow Voice with Amazon Connect (sn_cti_amzn_cct)

◦ ServiceNow Voice UI Components (sn_cti_ux)

For the complete Voice  experience, install ServiceNow  Voice  for ITSM or ServiceNow  Voice  for 
CSM applications. For information about these installations, see Install ServiceNow Voice for 
ITSM  and Install ServiceNow Voice for CSM.

4. Optional:  If demo data is available and you want to install it, select the Load demo data  check 
box.
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Demo data comprises the sample records that describe application features for the common 
use cases. Load the demo data when you first install the application on a development or test 
instance.

Important: 
If you don't load the demo data during installation, it's unavailable to load later.

5. Select Install.

Domain separation and ServiceNow  Voice

Domain separation is supported for ServiceNow  Voice. Domain separation enables you to 
separate data, processes, and administrative tasks into logical groupings called domains. You 
can control several aspects of this separation, including which users can see and access data.

Support level: Basic

• Business logic: Ensure that data goes into the proper domain for the application’s service 
provider use cases.

• The application supports domain separation at run time. The domain separation includes 
separation from the user interface, cache keys, reporting, rollups, and aggregations.

• The owner of the instance must set up the application to function across multiple tenants.

Sample use case: When a service provider (SP) uses chat to respond to a tenant-customer’s 
message, the customer must be able to see the SP's response.

For more information on support levels, see Application support for domain separation .

Domain-separated tables

• CTI Instance [sn_cti_instance]

• CTI Component Logging Configuration [sn_cti_log_cfg]

• Operation Handler [sn_cti_operation_handler]

• Provider Component [sn_cti_provider_component]

• Provider Configuration [sn_cti_provider_config]

• Provider Message Transformer [sn_cti_provider_msg_transformer]

• CTI user [sn_cti_user]

• AWS Resource [sn_cti_aws_resource]

• Amazon Connect Instance [sn_cti_connect_instance]

Related topics

Domain separation for service providers

Configuring a phone PIN

You can set up or reset a phone PIN that can be used for caller authentication during a call with 
an agent.

If the Require authentication  field is set to true  for an operation handler, the corresponding 
operation is invoked only after the caller enters the PIN.
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Important: 
It is applicable for both  Voice  for ITSM and  ServiceNow  Voice  for CSM applications.

Reset the phone PIN for a caller

Reset the phone PIN for a caller if the caller's account is locked.

Before you begin
Role required: sn_cti_core.user_manager

About this task

Procedure

1. Navigate to All  > ServiceNow Voice - Core  > User Pin Reset.

2. For the required CTI user, Click the preview icon and open the record to reset the PIN.

a. In the PIN  field, enter the new PIN.

b. Clear the Disabled  check box.

c. Click Update.

Set or reset the phone PIN

Set up or reset your phone PIN that can be used for caller authentication when you call an agent.

Before you begin
Role required: none

Procedure

1. Navigate to All  > ServiceNow Voice - Core  > My Phone PIN.

2. On the Request Phone PIN form, enter the PIN and re-enter it.

3. Click Submit.

Configure the E.164 format for a consumer phone number

Ensure that all the necessary information for a phone number is included and properly formatted 
to successfully route an international call over a territory's public telephone network. Provide the 
E.164-compliant formatting and validation for phone number.

Before you begin
Role required: admin

About this task
An E.164 phone number field displays the following field types:

• A list for the phone number territory

• An input box for entering phone numbers

The E.164 format that does not contain any dashes or spaces and must include the + sign. For 
example, +14152223456.

Procedure

1. Navigate to All  > Customer Service  > Consumers.

2. Select the required consumer record.
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3. On the Consumer form, right-click any phone field and select Configure Dictionary.

4. On the Dictionary Entry form, for the Type  field, select Phone Number (E164).

5. Click Update.

Result
After this configuration, when entering the consumer phone number in the phone field, select 
the territory and enter the corresponding phone number. The same format is reflected in Agent 
Workspace.

Configuring CTI component logging

Configure CTI component logging to enable component logging to the system logs.

Before you begin
Role required: admin

About this task
You can create logs for the following components:

• Operation handler

• Provider component

• Provider configuration

• Provider message transformer

Note: 
Do not leave the log configurations on in a production instance, since this can impact 
performance.

Procedure

1. Navigate to All  > ServiceNow Voice Core  > Log Configuration  > New.

2. Select the component, component table, and log level you want to configure.

3. Choose the log level option.
Options include the following:

◦ Off

◦ Error

◦ Warn

◦ Info

◦ Debug

4. Click Submit.

5. Create a separate record for each type of component table you want to log.
If there are multiple logging configurations, the final log level is the selected component's log 
level, based on the following prioritization:

a. Operation handler

b. Provider message transformer

c. Provider component

d. Provider configuration
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6. To view the logs, navigate to All  > System Logs  > System Log  > All.
You can see the logs from the invoked sn_cti  modules, including the date created, log level, 
log message, and source. In the system logs, the message log level is always info. For basic 
logs from sn_cti_core  without any logging configuration, the log level varies.

For an entry on sn_cti_log_cfg.list  for an operation handler with warn  log level logger 
located in the operation handler, the code is as follows:

var log= ctx.getLogger();
log.warn("CTX Logger Demo from Operation Handler");

Sample output:

cti_core:: 
 P:c4bae70xxxxf6a9a|C:bxxxx44|T:793cxxxx7b|O:6fb1xxxx4006dabb45v
c::CTX Logger Demo from Operation Handler

• P: Provider

• C: Component

• T: Transformer

• O: Operation handler

Configure Real Time Transcription for ServiceNow  Voice  Customer Service Management

Configure settings in your Amazon Connect  instance, and in your ServiceNow  instance to allow 
agents to see a real time transcription of voice calls with customers.

Before you begin

• An Amazon Connect  instance set up using the guided setup.

• Real Time Transcription is only available for ServiceNow  Voice  for Customer Service 
Management

• Role required: admin

About this task
For new deployments, the Real-Time Transcription feature is enabled during the guided setup for 
Voice  for Customer Service Management.

If you have already deployed Voice  for CSM  and are upgrading, go through all of the steps for 
Setting up ServiceNow Voice, and Set up Real-Time Transcription for ServiceNow Voice  before 
completing the setup on Amazon Connect.

Procedure

1. Go to your Amazon Connect  instance.

2. Enable Contact Lens in the Amazon Connect  instance.
See the Amazon  documentation  for full instructions. Also refer to the Contact Lens 
documentation  for more information about Contact Lens for Amazon Connect.

a. On the "Set recording and analytics behavior block", enable Contact Lens.

b. Enable speech analytics with real-time and post-call analytics.

3. Go to the Setup Guide  for Amazon Connect.

4. Complete the instructions in the Real Time Transcription section.
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Set up Real-Time Transcription for ServiceNow  Voice

Set up the properties in the Amazon Connect  integration in order to enable Real-Time 
Transcription.

Before you begin
Role required: admin

About this task
For new deployments, the Real-Time Transcription feature is enabled during the guided setup for 
ServiceNow  Voice.

If you have already deployed ServiceNow  Voice  and are upgrading, go through all of the steps for 
Setting up ServiceNow Voice, and the steps in this procedure, before completing the setup on 
Amazon Connect.

Procedure

1. Add the system property sn_cti_csm_cnt.enable_ims_update  and set it to true.
For more information on adding a new system property, see Add a system property .

2. Navigate to All  > Amazon Connect integration  > View instances.

3. Choose your instance, and click on the Setup guide  related link.

4. Select the checkbox at the top of the setup guide to enable Real Time Transcription setup.
Once you select the Real Time Transcription checkbox, agents can see the conversation panel 
in their workpace.

5. Proceed through the setup guide.
Even if you have already set up your Amazon Connect  integration, you must complete the 
setup tasks again, due to changes in the Lambda Cloudformation Template and contact flow.

6. In the Setup Authentication  step, create a user with "Web Service Only access".
This user is intended only for communication between ServiceNow  and Amazon Connect.

a. Go to the Roles  related list.

b. Edit the user, and add the role interaction_integration_user.

c. Click OK.

What to do next
Proceed with the setup tasks on your Amazon Connect  instance detailed in the setup guide.

Scripting for operation handlers

You can use the APIs in the ServiceNow  Voice  framework to create a seamless voice call 
experience for your callers and agents.

The CTIOperationRequest  API provides methods to set and get data on the current 
CTIOperationRequest object. For information on this API, see CTIOperationRequest - Scoped, 
Global .

The CTIOperationResponse  API provides methods to set and get data on the current 
CTIOperationResponse object. For information on this API, see CTIOperationResponse - 
Scoped, Global .

The CTI API  provides REST resources that enable Computer Telephony Integration (CTI) 
providers to interact with the Voice  framework. For information about this API, see CTI API .
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Provider configuration in Voice

For both inbound and outbound calls, a provider configuration contains settings about the 
involved components and message transformers for a specific third-party phone system 
provider. Any request from that phone system provider is handled within ServiceNow  based on 
these settings.

To view the available provider configurations, navigate to ServiceNow Voice - Core  > Provider 
Configurations.

Any request from a third-party phone system is passed into a ServiceNow  instance through 
the CTI Operation  endpoint of the CTI API. For information about this API, see CTI 
API . Based on the provider and the component specified in the endpoint, the corresponding 
message transformers are invoked to perform the following:

• Transform the request from the third-party phone system before passing the request to an 
operation handler.

• Transform the response from the operation handler before passing it on to the third-party 
phone system.

Provider component

For each component or node available in the third-party phone system, a provider configuration 
contains a provider component. It contains a mapping between the component and a message 
transformer.

To view the available provider components, navigate to ServiceNow Voice - Core  > Provider 
Components.

Message transformer

A message transformer defines how a request and response can be transformed between a 
third-party phone system and the ServiceNow  instance.

• The Input Transformer  field has a script that defines how a request from a third-party phone 
system should be transformed within the ServiceNow  instance before passing the request to 
an operation handler.

• The Output Transformer  field has a script that defines how the response from the operation 
handler should be transformed before passing it on to the third-party phone system.

To view the available message transformers, navigate to ServiceNow Voice - Core  > Provider 
Message Transformers.

Provider configuration for the integration of Voice  with Amazon Connect

For the ServiceNow Voice  integration with the ServiceNow  Voice  with Amazon Connect 
application, the AWS Connect Default Handler  provider component is available by 
default.

Note: 
The ServiceNow  Voice  with Amazon Connect integration with ServiceNow  application 
[sn_cti_amzn_cct] must be installed from the ServiceNow®  Store. For information on 
installing this application, see Install ServiceNow Voice applications.

For each node that can be used an integration point between Amazon services and the 
ServiceNow  instance, the following provider components and the corresponding message 
transformers are available.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4760

https://www.webstg.servicenow.com/docs/access?context=cti-api&version=washingtondc&pubname=washingtondc-api-reference&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=cti-api&version=washingtondc&pubname=washingtondc-api-reference&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=cti-api&version=washingtondc&pubname=washingtondc-api-reference&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=cti-api&version=washingtondc&pubname=washingtondc-api-reference&ft:locale=en-US


Provider components and message transformers

Node Provider component Message transformer

Get Customer 
Input

sn_aws_connect_lex_intent_processor_component AWS - Lex - Intent - 
Message Transformer 
(SN Proxy)

Invoke AWS 
Lambda 
Function

sn_aws_connect_lambda_proxy_component AWS - Connect - Lambda 
- Message Transformer

When a customer dials using a phone number, a call is placed through the Amazon Connect 
's phone system. Using one of its components, Amazon Connect  provides the request to the 
ServiceNow  instance through the CTI Operation  endpoint of the CTI API. For information 
about this API, see CTI API . Based on the provider and the component specified here, the 
corresponding message transformers are invoked to perform the following:

• Transform the request from Amazon Connect  before passing the request to an operation 
handler.

• Transform the response from the operation handler before passing it on to Amazon Connect.

Extension points in Voice

Using extension points, you can call the custom scripts to extend the functionality of ServiceNow 
Voice. While integrating a third-party phone system with ServiceNow  Voice, you can invoke 
extension points using the CTI API  to handle events in ServiceNow  Voice.

By using extension points, you can easily integrate customizations without having to alter the 
base code. You can extend standard base functionality using customized scripts. For more 
information, see Using extension points to extend application functionality .

To view the extension points that are available by default, navigate to System Extension Points  > 
Scripted Extension Points  and group by the ServiceNow  Voice  application.

Note: 
You should install the ServiceNow  Voice, ServiceNow  Voice  for ITSM,  ServiceNow  Voice 
for CSM, and ServiceNow  Voice  with Amazon Connect  applications from the ServiceNow® 

Store. For information about these installations, see Install ServiceNow Voice applications, 
Install ServiceNow Voice for ITSM, and Install ServiceNow Voice for CSM.

Extension points in Voice

Extension point Description

sn_cti_core.clickToCallContextMap Enables the copying of application-specific field values 
to interaction records for ServiceNow  Voice  outbound 
calls.

sn_cti_core.CTICallAnalysisExtractor Defines how the transcription and the recording data 
is retrieved for an interaction based on the third-party 
phone system integrated with ServiceNow  Voice.

sn_cti_core.SoftPhoneEventSink Defines if the third-party phone system can handle an 
event. Maps events from the Softphone interface to 
back-end events.
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Using Voice

Agents can use ServiceNow  Voice  to receive inbound calls and make outbound calls with a 
seamless voice call experience. Managers can use this application to monitor and analyze calls.

Receiving inbound calls in ServiceNow  Voice

An agent can receive inbound calls using the Agent Softphone interface to handle a caller's 
request.

As an agent, you should have any of the following roles to receive an inbound call:

• sn_openframe.user and interaction_agent

• If the Advanced Work Assignment plugin (com.glide.awa) is installed, awa_agent & 
awa_integration_user.

After a customer dials in, the corresponding contact flow is invoked in Amazon Connect. Through 
the configured nodes, the request is forwarded to an operation handler in the ServiceNow 
instance.

If an agent is available, the agent can receive the call and handle the request using Agent 
Softphone interface. For information about the presence states of an agent, see Agent Inbox 
controls.

Interaction record states

If Then the interaction

The interaction has just been created, is 
currently in a call tree being deflected by 
an IVR flow, or has not yet been routed 
and assigned to an agent

Is in New  state.

The Lex Bot deflects the call or the user 
disconnects the call any time before the 
call enters the queue

Moves to Closed Complete  state.

The interaction gets assigned to an agent Moves to Work in Progress  state.

The user disconnects the call while 
waiting in the queue

Moves to Closed Abandoned  state.

Initiating outbound calls with ServiceNow  Voice

Improve your productivity as an agent by initiating outbound calls to connect with customers 
using the click-to-call feature in the ServiceNow  Voice  application.

As an agent, you can initiate outbound calls using the click-to-call feature when accessing 
the phone number of a user. The phone number of a user, if available, is displayed on the 
ServiceNow  application UIs. Example application UIs include the contact details on a Case form, 
the user record on an Incident form, the Consumer form, the Contact form, and other application 
UIs.

Note: 

• If not available, you can add the Caller  field to an incident form.

• The phone number of a user should be in the E.164 format. For information about 
configuring a phone number in this format, see Configure the E.164 format for a consumer 
phone number.
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You should have any of the following roles to initiate an outbound call:

• sn_openframe.user and interaction_agent

• If the Advanced Work Assignment plugin (com.glide.awa) is installed, awa_agent & 
awa_integration_user.

You can click the link to the user's phone number displayed on the application UI. The user 
record must have the mobile phone, business phone, or both. The Agent Softphone pop-up 
window is displayed letting you know that the call will be recorded, and then the user's number 
is connected. An interaction record of type Phone is created for the call and is in the Work in 
Progress  state.

For ServiceNow  Voice  Core, if the createConversation  flag is set to true, a conversation 
record is created for an outgoing call.

For ServiceNow  Voice  with Customer Service Management, if the 
sn_cti_csm_cnt.enable_ims_update  flag is set to true, a conversation record is 
created for an outgoing call.

The following agent presence states are configured by default for the Voice  application and are 
displayed in your Agent Workspace  Inbox.

Agent Workspace  Inbox statuses

Status Description

CallingCustomer Indicates that you are in the process of connecting with a customer.

After the call is connected, the status appears as Busy.

Busy Indicates that you are on the call.

AfterCallWork Indicates that you ended the call and right now working on updating the 
task such as case details.

The status is displayed after you click End call  in the Agent Softphone 
pop-up window.

Available Indicates that you are available to accept another task such as a case.

The status is displayed after you click Clear contact  in the Agent 
Softphone pop-up window.

FailedConnectAgent Indicates that you were unable to connect with the customer.

After the call doesn't go through, the status appears as Available.

Note: 
The Agent Workspace  Inbox statuses are synchronized with your Advanced Work 
Assignment  (AWA) activity.

The activity stream of the associated interaction record is populated with your status details, the 
URL to the call recording, contact trace record, and call transcript.

[store-future: BEGIN review]

Monitoring calls in  Voice

A manager can monitor analyze calls to provide feedback and coach agents.
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As a manager, you can:

• View the call transcript and recording for coaching.

• View call metrics (for example, agent call time) for reporting.

• Analyse agent conversations and provide feedback for quality assurance.

In Agent Workspace, ITSM Manager Workspace, and CSM Manager Workspace, you can use the 
Call Analysis  tab in an interaction to analyze transcripts, recordings, and sentiments.

[End]

Transferring a call to an agent or queue

When on a call with a customer, an agent can transfer the call to another agent or to a queue to 
get more assistance for the customer.

This feature is available for ServiceNow  Voice  for Customer Service Management. See 
Integrating ServiceNow Voice with CSM  for more information.

Example of a transfer flow

1. Navigate to All  > Workspace Experience  > CSM/FSM Configurable Workspace.

2. Ned uses the Agent Softphone to accept an incoming call from a customer.

3. To transfer the call, Ned clicks Quick connects  and choose either another agent or a queue 
(for example "Billing queue"). The transfer begins, and INTERNAL-TRANSFER  displays on the 
softphone. The customer is placed on hold until the next agent accepts the call.

4. Once the next agent (Beth) selects Join, and joins the call, the first agent (Ned) can either 
remain on the call or leave the call.

5. When the Ned leaves the call, the call is reassigned to the Beth on the interaction record.

Integrating Voice  with other applications

You can extend the capabilities of ServiceNow  Voice  for inbound and outbound calls by 
integrating with other applications.

Integrate ServiceNow  Voice  with Amazon Connect

Connect ServiceNow  Voice  of your ServiceNow  instance with the Amazon Connect  instance to 
provide a seamless inbound and outbound voice call experience for your callers and agents.
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Before you begin

• Procure an Amazon Web Services  (AWS) account with the administrative access to complete 
the integration setup between Amazon Connect  and ServiceNow. For information about 
creating the AWS account, see the Amazon documentation .

• Create a service account in your ServiceNow  instance to allow communication from your AWS 
account to your ServiceNow  instance. If you do not have the permissions to create service 
accounts on your instance, contact your ServiceNow  administrator for creating this service 
account.

Role required: sn_cti_amzn_cct.admin

Watch the video below to learn more about integrating an Amazon Connect  instance.  This video 
covers: Deploying Amazon resources and the Lex Bot, setting up the Amazon Connect instance 
and the contact flow, authentication and roles, and User ID and password parameters

Procedure

1. Log in to your Amazon Web Services (AWS) account and setup an Amazon Connect  instance.
For instructions on setting up this instance, see the Amazon Connect documentation .

2. Integrate the Amazon Connect  with your ServiceNow  instance.

a. Log in to your ServiceNow  instance.

b. Navigate to Amazon Connect Integration  > Setup Instance.

c. On the form, fill in the fields.

Amazon Connect  Instance form

Field Description

Name
Name of the Amazon Connect  instance.

AWS ARN
Amazon resource name of the Amazon Connect  instance. 
For information on AWS ARN, see the Amazon Connect
documentation.

Active Option that indicates if the record is active.

Override Params
Option to edit the domain for Amazon Connect instance 
parameters. You should select this option only when 
you want to integrate the ServiceNow instance with an 
Amazon Connect instance created before introducing 
the new domain for the Amazon Connect console. For 
information about this new domain, see the Amazon 
Connect  documentation .

Instance Params Auto-generated parameters based on the name of the 
Amazon Connect instance.

For example, here are the Amazon Connect instance 
parameters before and after introducing the new domain 
for the Amazon Connect console.
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Field Description

▪ Before introducing the new domain

{"ccpHost":"acmesupport.awsapps.com",
"ccpUrl":"https://
acmesupport.awsapps.com/connect/ccp-v
2","audioRecordingUrlPrefix":"http
s://
acmesupport.awsapps.com/connect/get-r
ecording?format=wav&callLegId="}

▪ After introducing the new domain

{"ccpHost":"acmesupport.my.connect.aw
s","ccpUrl":"https://
acmesupport.my.connect.aws/ccp-v2","a
udioRecordingUrlPrefix":"https://
acmesupport.my.connect.aws/get-record
ing?format=wav&callLegId="}

3. Configure the Amazon Connect  components in your ServiceNow  instance.

a. Navigate to Amazon Connect Integration  > View Instances.

b. Select the instance you want to configure.

c. Click the Setup Guide  related link.

d. Complete the instructions for components specified in each section.

Steps to configure Amazon Connect  components

Step Description

Select 
Application

Select an application for which you want to configure the Amazon Connect 
components.

Setup S3 
Bucket

Host content that can be deployed by Amazon CloudFormation. For more 
information on creating an S3 bucket, see the Amazon documentation

Deploy Stack Set up a collection of the required Amazon Web Services (AWS) resources. 
For more information on stacks, see the Amazon documentation .

You can deploy the AWS stack using AWS CloudFormation templates.

▪ Use AWS Cloud Formation template to describe AWS resources and 
properties

▪ Use AWS Cloud Formation stack to provision the resources described in 
the template

Note: 
If you are upgrading from a previous release, point your existing 
deployment of Lambda function running on Node.js 10.x to point it to 
Node.js 14.x. For more information, see the Amazon  documentation .
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Step Description

Deploy Lex 
Bot

Build voice-based conversational interfaces for your users. For more 
information on Lex Bot, see the Amazon documentation

Connect 
Setup Integrate with your ServiceNow  instance with AWS services

Import 
Contact Flows ▪ To enable Advanced Work Assignment  (AWA) Voice Routing, check the 

checkbox under the AWA Voice Routing  heading. Complete the steps 
specified in the setup guide:

▪ Complete AWS  Lambda  and Oauth credential setup.

▪ Download the recommended hold music using the link in the setup 
guide (you can choose your own hold music, but it cannot be longer 
than 5 seconds).

▪ Upload the hold music. See the AWS  documentation .

▪ Define a call tree for inbound and outbound calls between Amazon 
Connect and your ServiceNow instance. For more information on 
contact flows, see the Amazon documentation .

▪ Based on your subscription, you have default inbound and outbound 
contact flows. For example, for the integration of ServiceNow  Voice  with 
ITSM applications, see Components installed with ServiceNow Voice for 
ITSM.

▪ For an inbound contact flow, create queues to route contacts from AWS 
queues to ServiceNow queues. For information on creating queues in 
AWS, see the Amazon documentation .

▪ Set up call transfer flows through Amazon Connect  using Transfer to 
Agent Flow and Transfer to Queue Flow. The transfer flows are reusable 
and can also be applied to ServiceNow  Voice  for ITSM.

▪ Amazon Connect (Phone) is a placeholder phone channel for Amazon 
Connect  integration. For queues that you implement in your Amazon 
Connect  instance, you can use this channel to create corresponding 
Advanced Work Assignment  queues. For an example implementation, 
see Associate Amazon Connect queues for ITSM to a ServiceNow 
instance  or Associate Amazon Connect queues for CSM to a 
ServiceNow instance .

Setup 
Real Time 
Transcription

Set up the properties in the Amazon Connect  integration in order to 
enable Real-Time Transcription. Refer to Configure Real Time Transcription 
for ServiceNow Voice Customer Service Management  for configuration 
instructions.

Call Recording 
Events Send recording events to the ServiceNow  instance by enabling call 

recording on your Amazon Connect  instance. For more information on 
recording behavior, see the Amazon documentation
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Step Description

Setup 
Authentication Integrate your Amazon Connect instance with your ServiceNow  account by 

creating a service account

Additional 
Configuration Launch the Amazon Connect  softphone interface within ServiceNow  UI 

by configuring Openframe. The Openframe configuration created in your 
ServiceNow  instance enables agents to launch the softphone from within 
the ServiceNow  interface. You can also configure user groups to restrict 
this configuration to specific agent user groups.

Note: 
Agents should log in to the softphone interface in a separate browser 
tab using the Amazon Connect  credentials or SSO credentials (if 
configured). Once logged in, the softphone can be launched and 
used within the ServiceNow  interface.

Configure a contact flow for an automated caller interaction

Invoke an automated caller interaction with bots to fulfill the caller's request within the 
ServiceNow  instance.

Before you begin
Role required: sn_cti_core.admin

About this task
When a caller contacts the call center, using the voice or dual-tone multi frequency (DTMF) 
inputs from caller, a contact flow is invoked in the Amazon Connect  instance based on the 
caller context. The contact flow contains nodes that act as integration points between Amazon 
services and the ServiceNow  instance. Based on the nodes defined in the contact flow, the 
corresponding operation handlers are triggered in the ServiceNow  instance. The caller then gets 
the response that is defined in the operation handler. For information about contact flows, see 
the Amazon documentation .

In the ServiceNow  base system, a few operation handlers are available by default. For 
information on operation handlers, see ServiceNow Voice reference.

Procedure

1. Optional:  If you do not want to use a default operation handler, create and configure an 
operation handler in the ServiceNow  instance.

a. Navigate to ServiceNow Voice - Core  > Operation Handlers.

b. Click New.

c. On the form, fill in the fields.

Operation Handler form

Field Description

Operation 
Name

Name of the operation that you want to automate.

Type Type that specifies how the operation is implemented.
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Field Description

▪ Script: Implementation is included in a script.

▪ Forward to Handler: Request is forwarded to an operation handler, 
which is invoked by lookup on the sys_id of that handler. This scenario 
is possible when you have different intents for similar operations, for 
example, Create an HR incident and Create incident.

▪ Forward to Operation: Request is forwarded to an operation handler, 
which is invoked by lookup on the name of the handler and then name 
resolution to find the handler.

▪ Integration Hub - Action: Calls an Integration Hub  action.

▪ Integration Hub - Subflow: Calls an Integration Hub  flow or subflow.

Application Application associated with the operation handler.

Domain Domain associated with the operation handler.

Active Option to activate the operation handler.

Require 
Authentication

Option to enable authentication for the operation handler.

Note: 
If this option is selected, the corresponding operation is invoked 
only when a valid authentication token is passed in the request. It is 
supported by an authentication operation handler that supports pin-
based authentication, which can be leveraged in your contact flows. 
For information about configuring the PIN, see Configuring a phone 
PIN.

Description Summary about the operation handler.

Script Script that contains the operation implementation and the response for 
the caller. This field appears when Script  is selected for Type.

Forward To Operation handler to which you want to forward the request. This field 
appears when Forward to Handler  or Forward to Operation  is selected 
for Type.

Integration 
Hub - Action (Optional) Integration Hub  action that you want to call to complete the 

request. This field appears when Integration Hub - Action  is selected for 
Type.

Integration 
Hub - Flow/
SubFlow

(Optional) Integration Hub  flow or subflow that you want to call to complete 
the request. This field appears when Integration Hub - Subflow  is 
selected for Type.

d. Click Submit.

2. Create a contact flow in Amazon Connect  to define an end-to-end customer experience.

For information about creating a contact flow, see the Amazon documentation .

When building a contact flow within Amazon Connect, use any of these nodes to trigger 
operation handlers defined in the ServiceNow  instance. These nodes act as integration points 
between Amazon services and the ServiceNow  instance.
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Nodes in contact flows

Node Description Configuration

Get 
Customer 
Input

Invokes a Lex Bot. The 
operation handler that 
is triggered is based on 
the name of the intent 
associated with the Lex 
Bot. For information about 
this node, see the Amazon 
documentation .

Note: 
This node can be used 
when the integration is 
between Amazon Lex 
and the ServiceNow 
instance.

a. Create an intent for the required Lex Bot in your 
Amazon Connect  instance. For information 
about creating an intent, see the Amazon 
documentation .

b. Specify the following information in the intent.

▪ Intent name: Name of the intent.

Note: 
This intent name should match an 
operation handler in the ServiceNow 
instance with the same name, or name 
+ ‘_<suffix>’ where suffix can contain 
any five uppercase alpha characters.

▪ Sample utterances: Caller utterances that 
trigger the operation handler.

▪ Lambda initialization and validation: If the 
operation handler being invoked requires 
authentication, select the Initialization and 
validation code hook  check box and select 
the deployed AWS Lambda function.

▪ Lambda function: Deployed AWS Lambda 
function that is invoked.

c. Save, build, and publish the intent.

d. Open the required contact flow in the contact 
flow designer in your Amazon Connect 
instance.

e. Click the Get Customer Input node and specify 
the Lex Bot details in the Amazon Lex  section.

f. Click Save.

Invoke 
AWS 
Lambda 
Function

Invokes an AWS 
Lambda function. The 
operation handler that is 
triggered is based on the 
sn_operation  parameter 
set on the node in the contact 
flow. For information about 
this node, see the Amazon 
documentation .

a. Open the required contact flow in the contact 
flow designer in your Amazon Connect 
instance.

b. Click the Invoke AWS Lambda Function node 
and specify the following input parameters.

▪ Destination key: sn_component, Value: 
Component from where the Lambda 
function is invoked. For example, 
sn_aws_connect_lambda_proxy_component.
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Node Description Configuration

Note: 
This node can be used 
to for data dips (for 
example, authorizing 
a caller) where the 
integration is between 
the call center and 
the ServiceNow 
instance. The data 
dip configuration 
allows a caller to enter 
information, such as 
an account number, to 
route calls to a particular 
queue. Using this 
number, you can look 
up the first name of the 
caller and create an 
interaction record after 
the call is initiated. Also, 
you can customize the 
greeting with the caller 
name later in the flow.

▪ Destination key: sn_operation, Value: Name 
of the operation handler that you want to 
invoke. For example, interactionEvent.

▪ (optional) Destination key: queueName, 
Value: Name of the queue that you want to 
transfer the flow to.

Note: 
This parameter is used to invoke the 
workItemEvent operation handler.

▪ (optional) Destination key: queueId, Value: 
ARN of the queue that you want to transfer 
the flow to.

Note: 
This parameter is used to invoke the 
workItemEvent operation handler.

▪ (optional) Destination key: authToken, Value: 
AuthToken received via authentication call. 
This parameter is required for invoking 
an operation handler that requires 
authentication.

▪ (optional) Destination key: interactionId, 
Value: Interaction ID received via 
interactionEvent call.

c. Click Save.

3. Ensure that a caller’s phone number is associated with the contact flow after it is created and 
published.

This process ensures that each time the caller calls, the corresponding contact flow is invoked. 
For information about associating a phone number with a contact flow, see the Amazon 
documentation .

Note: 
For a sample implementation of invoking operation handlers in a contact flow, you 
can refer to the default contact flows. For information on default contact flows, see 
Components installed with ServiceNow Voice for ITSM  and Components installed with 
ServiceNow Voice for CSM.

Integrating ServiceNow  Voice  with ITSM

Route calls coming through the ServiceNow  Voice  to specific phone queues based on user 
preference, utterances, or any other ServiceNow  data to optimize incident resolution.

Sample ITSM contact flow

Use the inbound (ServiceNow ITSM Inbound Demo Flow)  and outbound (ServiceNow ITSM 
Outbound Demo Flow)  Amazon Connect  ITSM sample contact flows that come with the Voice 
integration to get you up and running quickly. The sample flow allows you to deflect voice calls 
or route them based on the caller context to different queues. When a call comes through the 
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ServiceNow  Voice, the Amazon Connect  application uses data dips to identify the caller and 
then deflect the call or route it to the right agent. For more information on integrating ServiceNow 
Voice  with Amazon Connect  see, Integrate ServiceNow Voice with Amazon Connect.

Callers can access status updates or make updates to their records when they are 
authenticated.

PIN-based authentication

Callers can use PIN-based authentication to access the phone channel. Managers can set or 
reset the PIN for the users who can also set or reset their phone PIN. For more information, see 
Configure a phone PIN.

Workforce Optimization for ITSM

Integrate Voice  with Workforce Optimization for ITSM  to visualize call metrics from Amazon 
Connect. The Voice  uses Advanced Work Assignment  to display the call metrics and active calls 
along with all other Channel metrics in the Manager Workspace.

Amazon Connect Phone Workforce Optimization for ITSM

Install ServiceNow  Voice  for ITSM

You can install the ServiceNow  Voice  for ITSM application (sn_cti_itsm_cnt) if you have the admin 
role. This plugin installs the ITSM content for integration between ServiceNow  Voice  and a third-
party phone system.

Before you begin

• Ensure that the application and all of its associated ServiceNow Store  applications have valid 
ServiceNow  entitlements. For more information, see Get entitlement for a ServiceNow  product 
or application .

• Your organization must have purchased ITSM Pro subscription, which includes the ServiceNow 
Voice  SKU.

• ServiceNow  Voice  for ITSM requires the following ServiceNow Store  application. Ensure that 
this application is installed before you install ServiceNow  Voice  for ITSM.

Required ServiceNow Store  applications
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Amazon Connect Integration with ServiceNow  Voice  (sn_cti_amzn_cct)

Integrates the ServiceNow  instance with the Amazon Connect  server.

Role required: admin

About this task
The following items are installed with ServiceNow  Voice  for ITSM application (sn_cti_itsm_cnt):

• Contact flows

• Operation handlers

For more information, see Components installed with ServiceNow Voice for ITSM.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the ServiceNow  Voice  for ITSM application (sn_cti_itsm_cnt) using the filter criteria and 
search bar.

You can search for the application by its name or ID. If you cannot find the application, you 
might have to request it from the ServiceNow Store.

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released 
apps, see the ServiceNow Store  version history release notes .

3. In the Application installation dialog box, review the application dependencies.

Dependent plugins and applications are listed if they will be installed, are currently installed, or 
need to be installed. If any plugins or applications need to be installed, you must install them 
before you can install ServiceNow  Voice  for ITSM application (sn_cti_itsm_cnt).

4. Optional:  If demo data is available and you want to install it, select the Load demo data  check 
box.
Demo data comprises the sample records that describe application features for the common 
use cases. Load the demo data when you first install the application on a development or test 
instance.

Important: 
If you don't load the demo data during installation, it's unavailable to load later.

5. Select Install.

Integrating ServiceNow  Voice  with CSM

Access the CSM  -specific contact flows and operation handlers when you integrate the 
ServiceNow  Voice  application with the Customer Service Management  application.

The ServiceNow  Voice  for CSM application provides seamless interactive voice response (IVR) 
and calling experiences for your customers and agents by integrating a cloud contact center 
provider with the robust capabilities of the Customer Service Management  application.

Overview

The ServiceNow  Voice  for CSM application provides the following Customer Service  capabilities 
for the integration with a cloud call center provider such as the Amazon Connect  service:
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• A bot building framework to automate interactions with consumers and customer contacts.

• An inbound contact flow to define the customer experience in an IVR.

• An outbound contact flow to connect with consumers and customer contacts from the phone 
number field displayed in any of the ServiceNow  application UIs.

• Operation handlers to configure automated interactions for customer service cases.

• A phone PIN setup option for consumers and customer contacts.

• Amazon Connect  phone queues for the Workforce Optimization for Customer Service 
application.

To get started with the ServiceNow  Voice  for CSM application, see Install ServiceNow Voice for 
CSM.

Key features

Customer experience

Engage via voice-based interactions using a natural language process to do the 
following:

• Create a case

• Update and check case status

• Speak with an agent

• Request a call back from an agent

Agent experience

• Preview caller information displayed in Agent Workspace  before accepting an 
inbound call.

• Indicate your presence in the Agent Workspace  Inbox with voice as a service 
channel when the Agent Workspace  Inbox is integrated with the Agent softphone.

• View real-time transcripts of calls while interacting with a customer. For more 
information about real-time transcripts, see Real time transcriptions for 
ServiceNow Voice for Customer Service Management

• Transfer calls to another agent or to a queue, and include transcripts and 
interaction history with the transfer.

• Make outbound calls to connect with a customer and automatically capture 
interaction details to simplify data entry.

Manager experience

• Review call transcripts, sentiments, and recordings to explore coaching 
opportunities for agents.

• Use call metrics, such as the agent call time, to report on agents.

• Monitor real-time phone metrics captured in a unified dashboard by using the 
Workforce Optimization for Customer Service  application.

Note: 
This feature is available when the Workforce Optimization for Customer 
Service  application is enabled for the Customer Service Management 
application.
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ServiceNow  Voice  for CSM user roles

The users with the roles listed in the following table can use the ServiceNow  Voice  for CSM 
application.

Roles required for ServiceNow  Voice  for CSM

Roles Tasks

agent_workspace_user Initiate or accept voice calls to understand 
customer issues and resolve issues.

sn_customerservice_manager View details of voice calls using the interaction 
record of the Phone type.

sn_customerservice.consumer, 
sn_customerservice.customer

Initiate or accept voice calls to create and 
track one's own customer service cases.

Example workflow

The following example workflow shows the use of the ServiceNow  Voice  for CSM application in 
resolving a customer issue:

1. A customer is in an IVR call using the ServiceNow  Voice  for CSM application.

2. The ServiceNow  Voice  for CSM application identifies the customer and starts an interaction.

3. A welcome message is read out to the customer including announcements, if any.

4. Based on customer identification, the Cloud Call Center for CSM  application addresses the 
call.

◦ If the caller is identified as an existing customer who has a customer contact or consumer 
record with the phone number details available in the Customer Service Management 
application, a personal greeting is read to the caller and the automated interactions are 
made available.

◦ If the caller is not identified, the call is routed to a live agent.

5. The ServiceNow  Voice  for CSM application identifies the customer intent using automated 
interactions, and then based on the interaction responses, either creates or updates a case.

Note: 
This step in the flow applies only when the caller is an existing customer.

Workforce Optimization for Customer Service

Integrate Voice  with Workforce Optimization for Customer Service  to visualize call metrics from 
the Amazon Connect  service. Voice  uses the Advanced Work Assignment  feature to display the 
call metrics and active calls along with all other Channel metrics in the Manager Workspace. For 
more information, see Using Voice with Workforce Optimization for Customer Service .
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Amazon Connect phone queues in Workforce Optimization for Customer Service

Related topics

Setting up ServiceNow Voice

Using Voice

Components installed with ServiceNow Voice for CSM

Install ServiceNow  Voice  for CSM

You can install the ServiceNow  Voice  for CSM application (sn_cti_csm_cnt) if you have the admin 
role. The application installs related ServiceNow®  Store  applications if they are not already 
installed.

Before you begin

• Ensure that the application and all of its associated ServiceNow Store  applications have valid 
ServiceNow  entitlements. For more information, see Get entitlement for a ServiceNow  product 
or application .

• Your organization must have purchased CSM Pro subscription, which includes the ServiceNow 
Voice  SKU.

• ServiceNow  Voice  for CSM requires the following ServiceNow Store  applications. Ensure that 
this application is installed before you install ServiceNow  Voice  for CSM.

Required ServiceNow Store  applications

Amazon Connect Integration with ServiceNow  Voice  (sn_cti_amzn_cct)

Integrates the ServiceNow  instance with the Amazon Connect  server.

Role required: admin

About this task
The following items are installed with ServiceNow  Voice  for CSM:

• Contact flows

• Operation handlers
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For more information, see Components installed with ServiceNow Voice for CSM.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the ServiceNow  Voice  for CSM application (sn_cti_csm_cnt) using the filter criteria and 
search bar.

You can search for the application by its name or ID. If you cannot find the application, you may 
have to request it from the ServiceNow Store.

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released 
apps, see the ServiceNow Store  version history release notes .

3. In the Application installation dialog box, review the application dependencies.

Dependent plugins and applications are listed if they will be installed, are currently installed, or 
need to be installed. If there are any plugins or applications that need to be installed, you must 
install them before you can install ServiceNow  Voice  for CSM.

4. Optional:  If demo data is available and you want to install it, select the Load demo data  check 
box.
Demo data comprises the sample records that describe application features for the common 
use cases. Load the demo data when you first install the application on a development or test 
instance.

Important: 
If you don't load the demo data during installation, it's unavailable to load later.

5. Select Install.

What to do next
To set up Voice  for CSM, see Setting up ServiceNow Voice

Configuring the phone PIN settings for ServiceNow  Voice

Use a  PIN-based authentication mechanism for enabling a customer contact or consumer to 
connect with the ServiceNow  Voice  for CSM  application.

An authentication mechanism for inbound  dialing  enables protecting the details of  customer 
contacts and consumers from unauthorized users. When using the  ServiceNow  Voice  for CSM 
application, you as an administrator can configure the PIN-based authentication mechanism 
available within the  ServiceNow  Voice  for CSM application or set up a custom authentication 
mechanism.

The PIN-based authentication mechanism available within the  ServiceNow  Voice  for CSM 
application enables  customer contacts  and  consumers  to use a custom phone PIN for 
accessing details related to their customer service cases during inbound  dialing.

By default, the  My Phone PIN   link in the Additional Configuration section of the setup guide 
for configuring the Amazon Connect  components enables the PIN-based authentication 
mechanism. For more information about the setup guide, see Integrate ServiceNow Voice with 
Amazon Connect .

Note: 
The My Phone PIN  link for customer contacts and consumers is available only with the 
sample CSM  -specific contact flows.
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To enable a PIN-based authentication mechanism, the  My Phone PIN   link in the setup guide 
uses the predefined  Setup PIN  record producer that is configured by default for consumers and 
customer contacts. As an administrator, you can edit the Setup PIN  record producer to add any 
additional  ServiceNow  roles, include the record producer in a service  catalog, and display the 
service  catalog  as a module on a customer-facing portal. Customers can then use the module 
to configure and reset their phone PIN. For more information, see Record Producer  and Set up a 
service catalog .

Real time transcriptions for ServiceNow  Voice  for Customer Service Management

Agents can see a transcript of voice calls while interacting with customers. Real time 
transcription allows agents to better understand customer issues, and allows managers to gain 
insights into customer trends and agent training gaps.

Inbound call example flow for customers and agents

The below examples illustrate common scenarios for using real-time transcriptions for inbound 
calls. The customer calls in and requests to speak to an agent. As soon as the call begins, the 
agent can see the transcript of the call in chat panel as they work with the customer. The real 
time transcript is not visible to the customer, however, the transcript can help the agent better 
understand the customer issue and refer back to the conversation for clarification.

Personas:

• Customer Service Agent

• Customer

Example Customer Flow for inbound calls.

1. Customer dials an Amazon Connect  customer service number.

2. Confirm the approval for recording (press 1 ).

3. Give instruction: “Speak to a live agent”.

4. Provide a subject for the customer service agent: “Router Issue”.

5. Confirm the subject and wait for the agent to pick up the call.

Example Agent Flow for inbound calls.

1. Log in to your ServiceNow  instance and open the Configurable Workspace

2. Log in to Amazon Connect.

3. Set status to Online.

4. Wait for a call alert and answer the call.

5. A new interaction with the subject and chat panel opens with the real time transcript.

Outbound call example flow for agents

The below example illustrates a common scenario for using real-time transcriptions in outbound 
calls. The agent contacts the customer, and as soon as the call starts, the agent can see the 
transcript of the call in chat panel as they work with the customer. The real time transcript is 
not visible to the customer, however, the transcript can help the agent better understand the 
customer issue and refer back to the conversation for clarification.

Persona: Customer Service Agent.

1. Log in and open the Configurable Workspace.

2. Log in to Amazon Connect.
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3. Set status to Online.

4. Open a contact record and click the phone icon next to the customer’s phone number.

Note: 
The real time transcription only works when you place the call using the "click to call" 
button.

An interaction is created with the subject “outbound call to <customer name>”, and a chat 
panel opens with the transcript.

Integrating ServiceNow®  Voice  with Virtual Agent

ServiceNow®  Voice  with Virtual Agent  allows you to use the ServiceNow  Virtual Agent 
conversation as an IVR (Interactive Voice Response) in phone and to use the existing 
ServiceNow  Advanced Work Assignment  to find an agent in case of an escalation and allows 
agents to work in ServiceNow  Workspace  to manage the incoming cases on the queue.

The ServiceNow  Voice  for Virtual Agent  application provides seamless interactive voice 
response (IVR) and calling experiences for your customers and agents when integrated with 
a Contact Center In Washington DC  release, we have Amazon Connect, a pre-built adapter 
integrating the ServiceNow Voice with Virtual Agent to provide the robust capabilities of the 
Virtual Agent  application.

To use our pre-built adapter connector with ServiceNow  Voice  with Virtual Agent, install the 
Virtual Agent API  (sn_va_as_service) plugin.

Key features

User experience

• Have Virtual Agent  answer calls and interact with end users for automated 
deflection on the phone channel.

• Complete workflow including case lookup, interaction, and task management 
using Virtual Agent.

• Enable agents to interact with users on the phone on workspace in case of any 
escalations.

• Receive calls in inbox that are routed via the Advanced Work Assignment  rules.

Calling and routing

• Make outbound calls via click to call or via auto-connecting the Omnichannel 
Callback feature.

For more information, see Configure Conversational IVR with Amazon Connect.

• Transfer to external phone number using the Amazon Connect  Softphone.

• Skills-based call assignment using the Advanced Work Assignment.

Artificial intelligence

• Match intent and entity using ServiceNow  Virtual Agent.

• Analyze sentiments of the utterances.

• Real-time transcription and storage of the recording.

User benefits
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• Account log in using voice to receive enterprise service.

• Callback options.

Example workflow

The following example workflow shows the use of ServiceNow  Voice  for Virtual Agent  application 
in resolving a customer issue.

• A customer is in an IVR call using the ServiceNow  Voice  for Virtual Agent  application.

• The ServiceNow  Voice  for Virtual Agent  application identifies the customer and starts an 
interaction.

• A welcome message is read out to the customer including announcements if any.

• Based on customer identification, the ServiceNow  Voice  for Virtual Agent  application 
addresses the call.

◦ If the caller is identified as an existing customer who has a customer contact or consumer 
record with the phone number details available in the ServiceNow  Voice  for Virtual Agent 
application, a personal greeting is read to the caller and the automated interactions with 
Virtual Agent  conversations are made available.

◦ If the caller is not identified, the caller is presented with the guest topics and the live agent 
topic. The caller can select the live agent topic to route themselves to a live agent.

• The ServiceNow  Voice  for Virtual Agent  application identifies the customer intent using 
automated interactions, and the Virtual Agent conversations guide customers to complete the 
workflow, including changing records, passwords or hearing about a case status.

Note: 
This step in the flow applies only when the caller is an existing customer.

Related topics

Conversational IVR with Amazon Connect

Integrate Advanced Work Assignment Voice Routing

Provide customers the ability to use AWA as the routing engine for ServiceNow®  Voice on 
Amazon Connect.

Before you begin
Role required: sn_cti_amzn_cct.admin

Procedure

1. Navigate to Amazon Connect Integration  > View Instances.

2. Select the instance you want to configure.

3. Click the Setup Guide  related link.

4. Go to the Import Contact Flows  section of the setup guide.

5. To enable Advanced Work Assignment  (AWA) Voice Routing, check the checkbox under the 
AWA Voice Routing  heading.
Complete the steps specified in the setup guide:

a. Complete AWS  Lambda  and Oauth credential setup.

b. Download the recommended hold music using the link in the setup guide (you can choose 
your own hold music, but it cannot be longer than 5 seconds).

c. See the AWS  documentation  to upload the hold music.
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What to do next
For more information about integrating ServiceNow®  Voice with Amazon Connect, see Integrate 
ServiceNow Voice with Amazon Connect.

Integrating ServiceNow  Voice  for HR

The ServiceNow  Voice  for HR Agent Workspace provides seamless interactive voice response 
(IVR) and calling experiences for your employees and agents by integrating a cloud contact 
center provider with the robust capabilities of the Agent Workspace for HR Case Management.

The ServiceNow  Voice  for HR provides the following capabilities:

• An inbound contact flow to define the employee experience in an IVR.

• An outbound contact flow to connect with employee contacts from the phone number field 
displayed in any of the ServiceNow  application interfaces.

• Operation handlers to configure automated interactions for employee service cases.

Employee experience with ServiceNow  Voice  for HR

The following example provides an overview of how an employee uses ServiceNow  Voice  for HR 
to resolve their HR requests and issues.

An employee calls the general HR phone number with a request. The employee provides 
information via the interactive voice response (IVR). Using the provided information, ServiceNow 
Voice  for HR tries to identify the caller.

If the caller is identified as an existing employee in HR Agent Workspace, Voice  reads a 
personal greeting to the employee and offers automated interactions to enable the employee to 
independently address their request. If the employee cannot resolve their request using the IVR, 
the system routes the call to a live agent.

If the caller is not identified, the call is routed to a live agent.

Agent experience with ServiceNow  Voice  for HR

Once installed, ServiceNow  Voice  appears as a pop-up in the HR Agent Workspace where 
agents can do the following:
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• Indicate availability to receive calls on the agent softphone

• Preview caller information before accepting an inbound call.
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• View the call transcript, hear the recording, and review the call analysis in the interaction 
related list.

• Make outbound calls to connect with a employee and automatically capture interaction details 
to simplify data entry

Configuration

ServiceNow  Voice  for HR (sn_cti_hr_cnt) is activated from the store and requires the following 
dependency applications:

Application Description

ServiceNow Voice with Amazon Connect

[sn_cti_amzn_cct]

Integrates the ServiceNow instance with the 
Amazon Connect server. For information about 
the components installed with this application, 
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Application Description

see Components installed with Amazon Connect 
Integration with ServiceNow Voice

Agent Workspace for HR Case 
Management

[sn_hr_agent_ws]

Enables call recording, transcription, and 
sentiment analysis for ServiceNow  Voice  with 
Workspace experience.

ServiceNow Voice for HR Agent 
Workspace

[sn_cti_hr_cnt]

Provides the framework that supports the 
integration with your third-party phone system.

You must install the dependency applications first, then install ServiceNow  Voice  for HR. For 
more information, see Install ServiceNow Voice for HR.

ServiceNow  Voice for HR creates an interaction record for every call between an employee and 
an HR agent with the IMS prefix. These records contain related lists of details relating to the 
employee and interaction. To maximize the full feature capability, add the Interaction record to 
the HR Agent workspace. For more information, see Add Interaction Related Records to HR Agent 
workspace.

Install ServiceNow  Voice  for HR

You can install ServiceNow  Voice  for HR if you have the admin role. The application includes 
demo data and installs related ServiceNow®  Store  applications and plugins if they are not 
already installed.

Before you begin

• Ensure that the application and all of its associated ServiceNow®  Store  applications have valid 
ServiceNow  entitlements. For more information, see Get entitlement for a ServiceNow product 
or application .

• Your organization must have purchased the Agent Workspace for HR Case Management 
(sn_hr_agent_ws) subscription.

• Ensure that Amazon Connect Integration with ServiceNow Voice (sn_cti_amzn_cct) is installed. 
For more information, see Install ServiceNow Voice applications.

Role required: admin

About this task
Follow the steps below to install these applications to use ServiceNow  Voice  for HR.

The following items are installed with ServiceNow  Voice  for HR:

• Contact flows

• Operation handlers

For more information, see Components installed with ServiceNow Voice for HR Agent 
Workspace.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the ServiceNow  Voice  for HR Agent Workspace (sn_cti_hr_cnt) using the filter criteria and 
search bar.
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You can search for the application by its name or ID. If you cannot find the application, you may 
have to request it from the ServiceNow Store.

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released 
apps, see the ServiceNow Store  version history release notes .

3. In the Application installation dialog box, review the application dependencies.

Dependent plugins and applications are listed if they will be installed, are currently installed, or 
need to be installed.

4. Optional:  If demo data is available and you want to install it, select the Load demo data  check 
box.
Demo data comprises the sample records that describe application features for the common 
use cases. Load the demo data when you first install the application on a development or test 
instance.

Important: 
If you don't load the demo data during installation, it's unavailable to load later.

5. Select Install.

What to do next
Follow these steps to Integrate ServiceNow Voice with Amazon Connect.

Add Interaction Related Records to HR Agent workspace

ServiceNow  Voice for HR creates an interaction record for every call between an employee and 
an HR agent, which contain related lists of details relating to the employee and interaction. To 
maximize the full feature capability, add the Interaction record to the HR Agent workspace.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Interaction  > All.

2. Open any IMS record.
If there are no records, create a dummy record.

3. Click Additional actions  > Configure  > Related lists.

4. Select the HR Workspace  view.

5. Locate the Interaction Related Record -> Interaction  option and add it to the Selected  list.
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6. Click Save.

ServiceNow  Voice  reference

Reference topics provide additional information about components installed with ServiceNow 
Voice.

Components installed with ServiceNow  Voice  Core

Several types of components are installed with activation of the ServiceNow  Voice  Core 
application (sn_cti_core), including user roles, plugins, and operation handlers.

Note: 
The Application Files table lists the components that are installed with this application. 
For instructions on how to access this table, see Find components installed with an 
application .

Roles installed

Role title [name] Description Contains roles

CTI service account

[sn_cti_core.service]

Allows communication between the 
third-party phone system instance and 
the ServiceNow  instance.

sn_openframe_api_user

CTI admin

[sn_cti_core.admin]

Creates the framework for integration 
with a third-party phone system.

None

CTI user manager

[sn_cti_core.user_manager]

• Can access the Call Analysis tab and 
interaction to analyze transcripts, 
recordings, and sentiments.

• Can manage the CTI-enabled user 
PIN.

None
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Plugins installed

Plugin Description

Interaction Management 
(com.glide.interaction)

Enables interaction logging, routing, and queueing

Openframe (com.sn_openframe) Provides an interface to integrate a communication frame to 
place and receive calls.

Operation handlers installed

Operation handlers are defined in the ServiceNow instance to run a script based on the intent of 
the caller and provide response to the caller.

Plugin Description

$transcript Saves the call transcript

$query2ssml Securely queries tables and returns the response as ssml

workItemEvent If the Advanced Work Assignment plugin (com.glide.awa) is installed, 
creates a work item on Advanced Work Assignment table before routing 
the call to agent, and associates an interaction with the work item.

Note: 
In a contact flow, invoke this operation handler in the Invoke AWS 
Lambda Function node just before transferring the flow to a queue

interactionEvent Defines the life cycle of the an Amazon Web Services  (AWS) interaction 
event, such as initiating an interaction and associating an agent and 
caller to the interaction

authenticate Authenticates a user based on the PIN. For information on PIN 
configuration, see Configuring a phone PIN.

fetchVoiceInteraction Fetches interaction and processes createConversation flag for creating 
conversation.

Components installed with Amazon Connect  Integration with ServiceNow  Voice

Several types of components are installed with installation of the Amazon Connect  Integration 
with Voice  application (sn_cti_amzn_cct), including user roles, plugins, and operation handlers.

Note: 
The Application Files table lists the components that are installed with this application. 
For instructions on how to access this table, see Find components installed with an 
application .

Roles installed

Role title [name] Description Contains roles

Amazon Connect 
administrator

Configures the integration with the Amazon 
Connect  instance.

sn_cti_core.admin
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Role title [name] Description Contains roles

[sn_cti_amzn_cct.admin]

Plugins installed

Plugin Description

ServiceNow  Voice  - Core 
(sn_cti_core)

Provides the framework that supports the integration with your 
third-party phone system.

Openframe 
(com.sn_openframe)

Provides an interface to integrate a communication frame to 
place and receive calls.

Operation handlers installed

Operation handlers are defined in the ServiceNow  instance to run a script based on the intent of 
the caller and provide response to the caller.

Plugin Description

$connect.kinesis.event Receives and processes the call trace record that is created by 
Amazon Connect  in the Amazon Kinesis stream.

$connect.s3.event Receives and processes JSON events from the S3 buckets where 
the call recording, transcript and analysis data is created and stored. 
Associates this information with an interaction and Openframe call log 
records.

createPhoneLog Creates a PhoneLog for each call transfer and links the Phone Log to 
the Interaction Related Record

Components installed with ServiceNow  Voice  for ITSM

Several contact flows and operation handlers are installed with activation of the ServiceNow 
Voice  for ITSM application (sn_cti_itsm_cnt).

Contact flows installed

Contact flow Description

ServiceNow 
ITSM 
Inbound 
Demo Flow

Contains the call tree for inbound calls. When a caller contacts the call center, 
using the voice or dual-tone multi frequency (DTMF) inputs from caller, the 
contact flow is invoked in the Amazon Connect  instance based on the caller 
context. This contact flow contains nodes that act as integration points between 
Amazon services and the ServiceNow  instance. Based on the nodes defined 
in the contact flow, the corresponding operation handlers are triggered in the 
ServiceNow  instance. The caller then gets the response that is defined in the 
operation handler.

ServiceNow 
ITSM 
Outbound 
Demo Flow

Contains the call tree for outbound calls. It specifies the whisper message that a 
caller hears before getting connecting to an agent.
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Operation handlers installed

Operation handler Description

sn_FallbackIntent Captures the user input

manageIncident Manages an existing incident

unlockAccount Unlocks a user account

announcements Makes announcement for a caller

manageIncident.DialogCodeHook Initializes the Amazon Connect instance and validates 
incoming calls

createIncident Creates an incident

Components installed with ServiceNow  Voice  for CSM

Several contact flows and operation handlers are installed with Cloud Call Center for CSM 
application (sn_cti_csm_cnt).

Contact flows installed

Contact flow Description

ServiceNow 
CSM 
Inbound 
Demo Flow

Contains the call tree for inbound calls. When a caller contacts the call center, 
using the voice or dual-tone multi frequency (DTMF) inputs from caller, the 
contact flow is invoked in the Amazon Connect  instance based on the caller 
context. This contact flow contains nodes that act as integration points between 
Amazon services and the ServiceNow  instance. Based on the nodes defined 
in the contact flow, the corresponding operation handlers are triggered in the 
ServiceNow  instance. The caller then gets the response that is defined in the 
operation handler.

ServiceNow 
CSM 
Outbound 
Demo Flow

Contains the call tree for outbound calls. It specifies the whisper message that a 
caller hears before getting connecting to an agent.

ServiceNow 
CSM 
Transfer to 
Agent Flow

The call is relocated to another persona using call transfer functionality. A 
new PhoneLog is created with each transfer. The PhoneLog also includes any 
attachments associated with the interaction. Call transfers can be done with 
either incoming and outgoing calls.

ServiceNow 
CSM 
Transfer 
to Queue 
Flow

The inbound call is relocated to a queue using call transfer functionality. A 
new PhoneLog is created with each transfer. The PhoneLog also includes any 
attachments associated with the interaction. Call transfers can be done with 
either incoming and outgoing calls.

Operation handlers installed

Operation handler Description

$csm.connect.s3.event Receives and processes events from S3 buckets where connect 
audio, transcript and analysis data is created and stored and 
tries to associate with interaction and openframe call log records. 
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Operation handler Description

This is CSM operation handler for the new data model with 
conversation as metadata

$csm.connect.kinesis.event Handler to process CTR events from Kinesis stream for CSM 
integration with VA Conversations

speakToCSMAgent Enables customer contacts and consumers to speak with a live 
agent.

createCSMCase Enables customer contacts and consumers to create a customer 
service case.

manageCSMCase Enables customer contacts and consumers to update an existing 
case.

csmAnnouncements Makes announcements for a caller.

createCSMInteraction Creates an interaction record in the ServiceNow  instance for the 
incoming calls.

updateCSMInteraction Updates an existing interaction record in the ServiceNow 
instance for the incoming calls.

fetchCSMInteraction Fetches interaction and processes 
sn_cti_csm_cnt.enable_ims_update sys property for creating 
conversation.

Components installed with ServiceNow  Voice  for HR Agent Workspace

Several contact flows and operation handlers are installed with ServiceNow  Voice  for HR Agent 
Workspace.

Contact flows installed

Contact flow Description

ServiceNow 
HR 
Inbound 
Demo Flow

Contains the call tree for inbound calls. When a caller contacts the call center, 
using the voice or dual-tone multi frequency (DTMF) inputs from caller, the 
contact flow is invoked in the Amazon Connect  instance based on the caller 
context. This contact flow contains nodes that act as integration points between 
Amazon services and the ServiceNow  instance. Based on the nodes defined 
in the contact flow, the corresponding operation handlers are triggered in the 
ServiceNow  instance. The caller then gets the response that is defined in the 
operation handler.

ServiceNow 
HR 
Outbound 
Demo Flow

Contains the call tree for outbound calls. It specifies the whisper message that a 
caller hears before getting connecting to an agent.

Operation handlers installed

Operation handlers are reusable code components that get executed on the ServiceNow 
instance. They work on the request/response message exchange pattern.
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Operation handler Description

createHRInteraction Creates an interaction record in the ServiceNow instance for the 
incoming calls.

fetchHRInteraction Fetches interaction and processes sn_cti_hr_cnt.enable_ims_update sys 
property for creating conversation.

ServiceNow AI Platform  Legacy Capabilities
Explore ServiceNow  Legacy  options for past releases and versions of the ServiceNow AI 
Platform.

Legacy Chat

Enable chat between users 
and with live agent support.

Legacy Notify

Communicate and handle 
notifications through Twilio.

Orchestration

Extend automation 
capabilities to 

external services.

Task Communications 
Management

Create communications 
plans for any event.

Workflow

Legacy  chat

Provide communication resources with ServiceNow  legacy  chat app. Create one-on-one or 
group conversations with instant messaging or chat rooms, link to task records to enable live 
collaboration, and connect users to live support from help desk agents.

Legacy  Notify

Keep users in touch with each other using Notify. This application connects to your business's 
Twilio  account and provides multiple communication formats. Set up conference calls to 
coordinate between multiple teams or individuals, and create notifications to send to specific 
contacts. Implemented by default with Incident Communications Management, Notify  is 
available for use with various other ServiceNow  applications.
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Orchestration

Take the power of ServiceNow  beyond the ServiceNow AI Platform. Orchestration extends the 
platform’s automation capabilities to external instances, with activity packs to automate IT and 
business processes. Create more activities and packs using Activity Designer and Scoped 
Applications, and track data flow through your external activities with Databus.

Task Communications Management

Define and implement communications plans based on any event you choose. The Task 
Communications Management  app assists event-based communication through Slack, SMS, 
and email. Define plans, connect plans with task tables, and ensure easy collaboration and issue 
resolution.

Workflow

Create clear action plans and automate your business step-by-step with Workflow. This app 
offers a graphical user interface with easy drag-and-drop action, easily handling the design of 
multi-step processes. There are various activities, such as records generation, user notification, 
script actions, and so on. These activities fit into a custom flowchart, giving users a clear picture 
of the working processes for your enterprise.

Connect
ServiceNow®  Connect is a real-time messaging platform that connects you to your coworkers, 
bypassing email and static documents.

Connect integrates with other features within the system, such as Visual Task Boards, Human 
Resources Management, and Customer Service Management. The Connect interface overlays 
the standard interface, which allows users to participate in conversations while they work.

Connect contains the following features:

• Connect Chat: Enables users to chat with individuals and groups, quickly share files, and 
collaborate on any record by connecting with the right people instantly.

• Connect Support: Enables support agents to provide real-time assistance to end users, using 
queues. Requires the Connect Support plugin.

Core UI  is required to use Connect.

Important: 
Connect is not supported in Next Experience. If you turn on Next Experience, Connect 
functionality will no longer work. See Next Experience .

Note: 
Connect does not replace legacy chat but offers some of the same functionality. Do not use 
these features concurrently

Explore Set up Administer
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• Upgrade to New York

• Connect interface

• Connect Chat

• Connect Support

• Activate Connect

• Activate Connect Support

• Supported browsers for 
Connect Chat

• Properties for Connect

• Connect actions

• Configure the fields on a 
record card in Connect

• Properties for Connect 
Support

Use

• Start a direct or group 
conversation

• Follow a record in Connect
•

Develop

• Developer training

• Developer documentation

Troubleshoot and get help

• Ask or answer questions in 
the Connect community

• Search the Known Error 
Portal for known error 
articles

• Contact Customer Service 
and Support

Supported browsers for Connect Chat

The system supports Connect Chat  on most modern browsers.

Important: 

Core UI  is required to use Connect Chat. Connect Chat  is not supported in Next Experience. 
If you turn on Next Experience, Connect Chat  will no longer work. See Next Experience UI
for more information.

• The latest public release of Firefox or Firefox ESR

• The latest public release of Chrome

• Safari version 9.1 and later

• Microsoft Edge version 90

• Internet Explorer version 11

◦ Edge mode is supported.

◦ Compatibility mode is not supported.

◦ Setting Security Mode to High (via the Internet Options  > Security  tab) is not supported.

◦ Internet Explorer 11 is susceptible to memory leaks, which may impact performance, 
especially in Windows 7.

Activate Connect

Connect  is active by default on new instances. For upgraded instances, you can activate the 
Connect plugin (com.glide.connect) if you have the admin role.

Before you begin
Role required: admin

About this task
If you used Collaboration in the Fuji release, the Connect plugin is activated automatically.
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Important: 
Connect is not supported in Next Experience. If you turn on Next Experience, Connect 
functionality will no longer work. See Next Experience .

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.

Note: 
When domain separation and delegated admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .

Related topics

List of plugins

Properties installed with Connect

Properties are added with activation of Connect.

Note: 
To open the System Property [sys_properties] table, enter sys_properties.list  in 
the navigation filter.

Name Description

collaboration.email_interval Sets the number of minutes the system waits before 
sending a Connect  notification email to an inactive 
user.

• Type: integer

• Default value: 3

• Location: Collaborate  > Administration  > Properties

• Learn more: Configure the email notification interval

collaboration.frameset Determines whether the Connect  overlay is visible 
(enabled). This property also impacts Connect 
Support.

• Type: true | false

• Default value: true

• Location: Collaborate  > Administration  > Properties

• Learn more: Disable the Connect overlay
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Name Description

collaboration.polling_interval Sets the number of seconds the system waits between 
polling for new Connect  messages. This property also 
impacts Connect  Support.

• Type: integer

• Default value: 10

• Location: System Property [sys_properties] table

connect.notification.audio_alert Specifies the audio file to play to notify users of 
new messages, support conversation transfers, and 
@mentions in Connect. This property's value must 
point to the Name  field of a record in the Audio File 
[db_audio] table. This property also impacts Connect 
Support.

• Type: string

• Default value: connect_alert.mp3

• Location: Collaborate  > Administration  > Properties

• Learn more: Customize the Connect audio 
notification sound

connect.retrieve_external_link_content Enables Connect  to render URLs for external sites as 
links. When this property is disabled, URLs that point 
anywhere outside the instance appear as plain text. 
This property also impacts Connect  Support.

• Type: true | false

• Default value: true

• Location: Collaborate  > Administration  > Properties

connect.roles Determines which user roles are required to access 
Connect. When the value is blank, no role is required. 
This property also impacts Connect  Support.

Note: 
If you choose to restrict Connect  access to 
specific roles, consider updating the role 
requirements for Connect  modules and other 
access points.

• Type : string

• Default value: <empty>

• Location: Collaborate  > Administration  > Properties

glide.connect.enabled Hides the Create or Join Chat Room  related link, 
which appears on the Incident form when legacy chat 
is enabled. Legacy chat and Connect  Chat should not 
be used concurrently and this property should not be 
modified.
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Name Description

• Type: true | false

• Default value: true

• Location: Collaborate  > Administration  > Properties

glide.connect.chat.disabled Disables and hides all UI elements related to Connect.

• Type: true | false

• Default value: false

• Location: System Property [sys_properties] table

glide.live_feed.task_header_button Determines whether the show live feed icon ( ) 
and Follow  button are available in the form header of 
tables that have the live_feed=true  dictionary 
attribute.

• Type: choice list

• Default value: collaboration

• Other possible values:

◦ both: enables both the show live feed icon and the 
Follow  button.

◦ live_feed: enables the show live feed icon.

◦ none: disables both the show live feed icon and 
the Follow  button.

• Location: Collaborate  > Administration  > Properties

• Learn more: Configure record conversations

Activate Connect Support

The Connect Support plugin (com.glide.connect.support) is no longer available.

Before you begin

Important: 

This plugin is no longer available. In Paris and future releases, Connect Support no longer 
receives enhancements or non-priority bug fixes. Consider migrating to ServiceNow® 

Advanced Work Assignment  and Agent Chat  in workspace to automatically assign chat 
requests and other work items to agents. For details, see Migrate from Connect Support to 
Advanced Work Assignment and Agent Chat.

If you are currently using the legacy chat feature to provide help desk support, close any open 
help desk chats before activating Connect Support. Legacy chat and Connect Support should 
not be used concurrently. When you activate Connect Support, the system automatically sets 
the state of all Chat Queue Entry [chat_queue_entry] records to Closed Complete. This ends any 
open help desk chats. For more information, see Migrate from legacy chat to Connect Support.

Role required: admin
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Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.

Note: 
When domain separation and delegated admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .

Properties installed with Connect  Support

Properties are added with activation of Connect  Support.

Name Description

connect.support.conversation_limit Determines how many support conversations 
an individual agent can have at one time. 
When the value is set to -1, an agent can 
participate in an unlimited number of 
conversations.

• Type: integer

• Default value: -1

• Location: Collaborate  > Support 
Administration  > Properties

connect.support.idle.delay Determines how many seconds a user must 
be inactive in a support conversation before 
an idle countdown timer appears.

• Type: integer

• Default value: 120

• Location: Collaborate  > Support 
Administration  > Properties

connect.support.idle.count_down Determines how many seconds the idle 
countdown timer remains open after it 
appears. If the idle user does not dismiss the 
timer before the countdown completes, the 
system closes the support session.
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Name Description

• Type: integer

• Default value: 60

• Location: Collaborate  > Support 
Administration  > Properties

connect.support.show_agent_avatar Determines whether an agent's avatar is 
shown in a support conversation (enabled). 
When the property is disabled, users see the 
agent's name only.

• Type: true | false

• Default value: true

• Location: Collaborate  > Support 
Administration  > Properties

connect.support.user.closed.conversation_limit Determines how many closed conversations 
appear in a user's support conversation 
history. When the value is set to 0, all 
previous conversations appear in the history.

• Type: integer

• Default value: 0

• Location: Collaborate  > Support 
Administration  > Properties

glide.connect.support.enabled Disables or enables Connect  Support. When 
the property is enabled, the Service Desk 
Chat  button in the Employee Self-Service 
portal opens the conversation in Connect 
Support, rather than legacy chat. Additionally, 
the Support tab appears in the Connect 
sidebar.

• Type: true | false

• Default value: true

• Location: Collaborate  > Support 
Administration  > Properties

glide.connect.support.reflect_system_messages Controls whether Connect  Support reflects 
system messages in records created from a 
support chat, for example, transfer notices, 
automated queue messages, etc.

• Type: true | false

• Default value: false

• Location: System Property [sys_properties] 
table
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Additional plugins for Connect Support

Additional plugins are available for Connect  Support. These plugins integrate Connect  Support 
with other features and provide capabilities to track performance metrics.

You must have the admin role to activate these additional plugins. For details, see Activate a 
plugin  .

Additional plugins for Connect Support

Plugin Description

Connect Support and Service Portal 
Integration

[com.glide.connect.support.service-portal]

Adds Connect  Support components for use in 
the Service Portal.

Connect Support Manager's Dashboard

[com.glide.connect.managers_dashboard]

Provides a homepage for Connect  Support, 
and all required configuration records. Though 
the plugin name contains the term dashboard, 
the plugin does not provide functionality 
related to Performance Analytics  dashboards. 
Homepages are similar to dashboards, but do 
not require Performance Analytics  roles to view.

Note: 
The Connect Support Manager's 
Dashboard plugin does not activate 
Connect  Support automatically. You must 
activate Connect  Support to collect data 
for the homepage.

Human Resources Application: HR Connect

[com.snc.hr.hr_connect]

Sets up a human resources (HR) chat queue 
and makes it available on the HR Service Portal.

Note: 
This plugin does not appear in the 
System Definition>Plugins  list. Contact 
ServiceNow personnel to activate it.

If not already active, the Human Resources 
Application: HR Connect plugin activates 
the Human Resources Application: Core 
[com.snc.hr.core] plugin that provides basic HR 
features.

Performance Analytics - Content Pack - 
Service Desk Chat

[com.snc.pa.chat]

Provides the Service Desk Chat Monitor 
dashboard, which analyzes key Connect 
Support metrics and indicators.

The Performance Analytics - Content Pack 
- Service Desk Chat plugin activates the 
Connect Support Manager's Dashboard 
[com.glide.connect.managers_dashboard].

Performance Analytics - Context Sensitive 
Analytics for Chat

Provides in-form analytics for Connect  Support. 
These analytics are available as a related link 
on the Chat Queue Entry [chat_queue_entry] 
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Additional plugins for Connect Support  (continued)

Plugin Description

[com.snc.pa.chat.context_sensitive_analytics]
form, and also as the Context Sensitive 
Analytics - Chat  dashboard.

The Performance Analytics - Context Sensitive 
Analytics for Chat plugin activates the 
Performance Analytics - Content Pack - Service 
Desk Chat [com.snc.pa.chat] plugin if it is not 
already active.

Connect interface

Users can work in a compact view of Connect, which overlays the standard user interface, or in a 
full-screen workspace.

Connect Chat and Connect Support share the same interface, so support agents can keep track 
of all their conversations in one place.

Connect overlay

The Connect overlay appears over the standard user interface. It consists of the Connect 
sidebar, which is the primary interface for Connect Chat and Connect Support, and any Connect 
mini windows that are open. Each mini window contains a header, a conversation area, and a 
message field.

Connect overlay

Note: 
An administrator can disable  the Connect overlay so users can only use the Connect 
workspace, a full-screen interface with additional Connect tools.

Connect sidebar

The Connect sidebar is the primary interface for Connect Chat and Connect Support. It lists your 
conversations and provides access to create conversations.
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The sidebar is collapsed by default. Click the toggle Connect sidebar icon ( ) in the banner 
frame to expand or collapse the sidebar, which appears on the right edge of the interface.

Connect Chat

The chat view of the sidebar is available to all users. If Connect Support is enabled, users must 
click the chat tab of the sidebar, which is represented by a speech bubble icon. If Connect 
Support is not enabled, there are no tabs in the sidebar and the chat view displays by default.

The chat view of the sidebar lists all your current Connect Chat conversations. It also contains a 
filter tool and a button to create conversations.

Chat view of the Connect sidebar

If you have unread messages in a conversation, a number appears by the conversation in the 
sidebar. Point to a conversation and click the x  icon to remove the conversation from the sidebar.

Connect Support

The support view of the sidebar is available when Connect Support is activated. The support 
view is visible only to users who are agents for at least one support queue. Users must click the 
support tab of the sidebar, which is represented by a headset icon.

The support view displays Queues  to which you belong. It also displays your open support 
conversations under Cases.
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Support view of the Connect sidebar

If you have unread messages in a conversation, a number appears by the 
conversation in the sidebar.

Connect mini windows

When you open a Connect Chat or Connect Support conversation in the Connect overlay, it 
opens in a Connect mini window. Each mini window contains a header, a conversation area, and 
a message field.

Several icons appear in the mini window header and by the message field.

Note: 
The icons you see for each conversation depend on the conversation type and other 
conditions.

Chat mini window icons

Icon Name Description

Add user Add a user to the conversation. This icon is visible for group and record 
conversations only. Administrators can enable this icon for Connect 
Support conversations.

View 
document

View the record associated with the conversation. This icon is visible for 
record and support conversations only.

New window Open the conversation in the Connect workspace, a full-screen window 
with additional Connect tools.

Collapse/
Expand 
conversation

Hide or show the conversation. Alternatively, click anywhere in the mini 
window header to the left of the icons.
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Chat mini window icons  (continued)

Icon Name Description

Close 
window

Close the mini window. The conversation remains in the Connect sidebar 
and the history is preserved when you reopen the conversation. You can 
also close a mini window by pressing the Escape key.

Connect 
actions

Open the Connect actions menu, which contains options like Transfer 
and Create Incident. This icon is visible only when Connect actions are 
available for the conversation. By default, this icon is visible for support 
conversations only. Administrators can add options to this menu by 
creating Connect actions.

Message 
type

Choose whether messages are added to the associated record as 
comments or work notes. This icon is visible only for record and support 
conversations.

Attach file Attach and send a file. Select one or more files and click Open. You 
can also add an attachment by dragging and dropping it directly in the 
conversation.

Connect workspace

The Connect workspace is a full-screen view of all your Connect Chat and Connect Support 
conversations in one place. It contains the conversation pane, which displays the conversation 
header and an expanded version of the mini window, and the conversation tools area.

To open the Connect workspace, navigate to Collaborate  > Connect Chat  or click the new 

window icon ( ) in a Connect mini window. If you do not have any recent conversations, a 
screen appears with helpful information about Connect.

The Connect workspace is composed of the following elements.

Connect workspace elements

Element Description

Sidebar Provides access to conversations. The Connect sidebar behaves the same 
way in the workspace as it does in the Connect overlay. The only difference is 
that the sidebar appears on the left edge of the Connect workspace. For more 
information about using the sidebar, see Connect sidebar.

Conversation 
pane

Displays the currently selected conversation.

Conversation 
tools

Provides quick access to key information, conversation members, attachments, 
and notification preferences for the currently selected conversation. Some of 
the conversation tools vary depending on the type of conversation.
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Connect workspace

Conversation pane

The conversation pane of the Connect workspace displays the conversation header and an 
expanded version of the mini window.

The header displays basic conversation details like the avatar and name. You can edit these 
details  for group or record conversations.

Below the header, messages appear in chronological order. You can enter messages in the text 
entry field at the bottom of the window.

Connect conversation tools

The conversation tools area in the Connect workspace contains several tabs, each represented 
by an icon.

Click an icon to open the tab. Click the same icon again to hide the tab. The tabs you see for 
each conversation depend on the conversation type and other conditions.

Conversation tool tabs

Tab icon Tab name Description

Info Contains the following sections, each of which appears only if it 
contains information.

• Record: Lists details about the record the current 
conversation follows, such as record number, state, assignee, 
and short description. The fields displayed in this section vary 
by the type of record. This section is available only for record 
conversations.
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Conversation tool tabs  (continued)

Tab icon Tab name Description

• Related Records: Lists Visual Task Boards and task records 
that have been referenced in the conversation, such as 
incidents, problems, or changes. When you send a record 
number as a message or drag a record in a conversation, it 
appears as a link. The list displays the short description for 
each task. Click a task to open the record in a new browser 
tab. Only conversation members who have rights to view the 
tasks can access them.

• Links: Lists URLs that have been referenced in the 
conversation. Click a link to open the destination page in a 
new browser tab.

This tab is not available for support conversations.

Record Displays a compact form view of a record created from the 
current conversation, such as an incident. If more than one 
record has been created from the conversation, there is a 
separate record tab for each one. These tabs are available only 
for support conversations.

Knowledge 
Base

Displays a compact view of the knowledge homepage. For 
more information, see Share knowledge in a Connect Support 
conversation.

Members Lists all members of the current conversation. You can add 
or remove conversation members for group and record 
conversations.

Attachments Lists all attachments in the conversation. Click an attachment to 
open it. Click Add Attachment  to upload an attachment.

Notification 
preferences

Contains settings to control which notifications you receive for 
the current conversation. For more information, see Edit which 
notifications you receive for a conversation.

Enable or disable Connect notifications globally

You can edit your Connect  notification settings globally to enable or disable mobile, desktop, 
email, or audio notifications for all your Connect  Chat and Connect  Support conversations.

Before you begin
Role required: none

About this task
By default, Connect  mobile, email, and audio notifications are enabled globally. You must enable 
desktop notifications.

An administrator can customize the sound  used for audio notifications.

Note: 
You receive mobile notifications only if you have installed the ServiceNow  mobile app.
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Procedure

1. In the banner frame, click the gear icon ( ) to open the system settings.

2. In the system settings window, click the Notifications  tab.

3. In Notifications by Category, navigate to Connect.

4. Enable or disable Connect  mobile, desktop, email, or audio notifications.

5. Optional:  Configure the following system notifications.
For more information on how to configure system notifications, see Apply notification 
conditions .

Notification Description

Activity Stream @Mention Email Sends an email alert to a user anytime they 
get @mentioned in an activity stream

Collaboration Offline Group Message(s) Sends email to offline users who are 
members of a group conversation after a 
certain number of minutes determined by 
the collaboration.email_interval 
property to limit spam.

Note: 
It takes 90 seconds after a user logs 
out for the system to register that the 
user is offline. If a message is sent to the 
user within 90 seconds of them logging 
out, then the user does not receive the 
notification.

Collaboration Offline Message Bundle Sends email to offline users after a certain 
number of minutes determined by the 
collaboration.email_interval 
property to limit spam.

Note: 
It takes 90 seconds after a user logs 
out for the system to register that the 
user is offline. If a message is sent to the 
user within 90 seconds of them logging 
out, then the user does not receive the 
notification.

ConnectMessagePushNotification Uses a push notification to inform users when 
there are new messages in a conversation

ConnectNotificationPushNotification Uses a push notification to inform a user 
when they have been @Mentioned in a 
record

What to do next
Edit which notifications you receive for a specific conversation.
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Connect notification browser support

The following browsers support Connect chat notifications.

Connect chat browser support

Browser Enable notification steps

Chrome 1. From a Chrome window, click the Chrome 
menu in the upper right corner.

2. Go to Settings  > Show advanced settings... 
> Privacy  > Content settings.

3. In the Content settings window, from the 
notifications section, select your notification 
settings.

Mozilla Firefox (starting with version 44) Manage browser notification settings using 
the information icon next to the URL.

Safari (starting with OS X Mavericks) 1. From a Safari window, open Preferences.

2. Select the notifications tab.

3. Select Allow  or Deny  to control which 
websites have access to notifications.

Microsoft Edge Notifications are enabled by default on 
Windows 10 PCs and tablets starting with 
EdgeHTML 14. For more information, see 
https://blogs.windows.com/msedgedev/2016/
05/16/web-notifications-microsoft-edge/
 pVkwubg7uvROayyI.97 .

Note: 
Internet Explorer does not support Connect notifications out of box.

Edit which notifications you receive for a conversation

You can control which types of Connect notifications you receive for each conversation and 
when you receive them.

Before you begin
Role required: none

About this task
Connect can send mobile, desktop, email, and audio notifications to inform you of messages 
and other activity, when you are not actively viewing Connect. You can edit your notification 
preferences in each conversation to control which notifications you receive for the conversation 
and under what circumstances. For example, if you are a member of a large group conversation, 
you might want to receive mobile, desktop, and email notifications for all activity, and audio 
notifications only when someone mentions  you. You might also want to disable a certain type of 
notification entirely for a conversation.

By default, you receive mobile, email, and audio notifications for all activity in every conversation 
you belong to. You must enable desktop notifications manually. Not all browsers allow desktop 
notifications. For more information, see Enable or disable Connect notifications globally.
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An administrator can customize the sound  used for audio notifications.

Note: 
You receive mobile notifications only if you have installed the ServiceNow  mobile app.

Procedure

1. Open a conversation in the Connect workspace.

2. In the conversation tools to the right of the conversation, click the notification settings tab 

( ).

3. Edit the following settings according to your preferences.

Note: 
If a notification type is disabled globally, a link to enable that type appears. You must click 
the link before you can edit conversation-specific notification settings.

Notification type disabled globally

Mobile Notification Settings Choose to receive push notifications:

◦ For all activity

◦ Only when @ mentioned (this option is not 
available for direct conversations)

◦ Never

Desktop Notification Settings Choose to receive desktop notifications:

◦ For all activity

◦ Only when @ mentioned (this option is not 
available for direct conversations)

◦ Never

Email Settings Choose to receive email notifications:

◦ For all activity

◦ Only when @ mentioned (this option is not 
available for direct conversations)

◦ Never

Audio Notification Settings Choose to receive audio notifications:

◦ For all activity

◦ Only when @ mentioned (this option is not 
available for direct conversations)

◦ Never

System Message Notifications Enable or disable system message 
notifications, which are automatically 
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generated by events like conversation 
membership changes and Visual Task Board 
updates. This option is not available for direct 
conversations.

Upload a profile picture

You can upload a profile picture in your Live Feed profile to use as an avatar in Connect  Chat and 
Connect  Support conversations.

Before you begin
Role required: none

About this task
Users who do not have profile pictures are represented by an avatar with their initials. 
Administrators can upload a profile picture in a user record which displays if there is no Live 
Feed photo.

Procedure

1. Navigate to All  > Collaborate  > Live Feed.

2. Click the tile with your picture or initials and title.

3. Use one of the following actions to add your photo.

◦ Locate the photo file you want to use and drag it over the existing photo.

◦ Point to the existing picture (or tap the photo in the smartphone or tablet interface) to display 
the Upload a picture  link. Click the link, navigate to the location of the photo you want to use, 
and click Open.

Related topics

Update your Live Feed profile

Drag a file into a Connect conversation

Drag and drop functionality in Connect Chat and Connect Support provides an easy way to share 
external attachments and links or items from within your instance.

Before you begin
Role required: none
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About this task
You can drag several things from within an instance, including items from the application 
navigator, records or breadcrumbs from lists, and Visual Task Boards from the My Task Boards 
page.

Procedure

Drag an item in a Connect mini window.

To drag a record from a list, drag the reference icon ( ), the record number, or a reference 
column value.

Connect accepts the same file extensions as the platform. For more information, see Add and 
manage attachments .

Share a Visual Task Board in a Connect conversation

You can share a Visual Task Board in a Connect Chat  or Connect Support conversation.

Before you begin
Role required: none

Procedure

1. Navigate to All  > Self-Service  > Visual Task Boards.

2. Drag a task board to a Connect mini window.
A link to the task board appears in the conversation. The task board is also listed in the 
conversation tools, which are visible in the Connect workspace. Only conversation members 
who are members of the board can access it. If you share a task board in a Follow a record in 
Connect, it appears as a URL in the record activity stream.

Related topics

Connect

Visual Task Boards

Mention a user in a Connect conversation

You can get someone's attention in a group conversation by mentioning them.

Before you begin
Role required: none

About this task
Users can set their notification preferences so they receive notifications only when they are 
mentioned. Mentioning a user creates a shortcut to view their basic information and send them a 
direct message.
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Procedure

1. Open a Connect group conversation.

2. In the message field, type the @  character.
A suggestion menu appears with the names of the conversation members.

3. Select the person you want to mention and send the message.

Connect administration

Administrators can configure various performance settings and features that impact both 
Connect Chat and Connect Support.

Note: 
There are also administrative options specifically for Connect Chat or Connect Support. For 
more information, see Connect Chat administration  and Connect Support administration.

Properties for Connect

The Connect Properties page provides several configuration options for Connect.

Important: 

Core UI  is required to use Connect Chat. Connect Chat is not supported in Next Experience. 
If you turn on Next Experience, Connect Chat will no longer work. See Next Experience UI
for more information.

Users with the admin role can access these properties by navigating to Connect  > 
Administration  > Properties.

Note: 
Many of the properties also impact Connect Support.
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Properties for Connect

Property Description

Disable Presence

glide.ui.presence.disabled

Turns off user presence globally when enabled. 
Enabling this property turns off user presence 
throughout the platform, not just in Connect.

• Type: true | false

• Default value: false

• Location: Connect  > Administration  > 
Properties

• Learn more: User presence

Enable Connect in the frameset

collaboration.frameset

Determines whether the Connect  overlay is 
visible (enabled). This property also impacts 
Connect  Support.

• Type: true | false

• Default value: true

• Location: Collaborate  > Administration  > 
Properties

• Learn more: Disable the Connect overlay

Enable Connect to retrieve external link 
metadata in order to render richer content 
in messages with links to YouTube, news 
articles, images, etc.

glide.ui.url.external, 
glide.ui.url.external.content

Enables Connect  to render URLs for external 
sites as links. When this property is disabled, 
URLs that point anywhere outside the instance 
appear as plain text. This property also impacts 
Connect  Support.

• Type: true | false

• Default value: true

• Location: Collaborate  > Administration  > 
Properties

Number of minutes to wait before collecting 
unread messages and sending an email to 
offline users.

collaboration.email_interval

Sets the number of minutes the system waits 
before sending a Connect  notification email to 
an inactive user.

• Type: integer

• Default value: 3

• Location: Collaborate  > Administration  > 
Properties

• Learn more: Configure the email notification 
interval

Maximum number of latest conversations to 
show during search. (Default = 50)

Sets the number of results that appear 
when you search conversations in 
Connect. In the System Properties 
[sys_properties] table, this property appears as 
connect.search.conversation_limit.
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Properties for Connect  (continued)

Property Description

• Type: integer

• Default value: 50

Audio file to play to notify users of new 
messages, support conversation transfers 
and @mentions in Connect. This property's 
value should point to the 'name' field of an 
audio file in the db_audio table.

connect.notification.audio_alert

Specifies the audio file to play to notify users of 
new messages, support conversation transfers, 
and @mentions in Connect. This property's 
value must point to the Name  field of a record 
in the Audio File [db_audio] table. This property 
also impacts Connect  Support.

• Type: string

• Default value: connect_alert.mp3

• Location: Collaborate  > Administration  > 
Properties

• Learn more: Customize the Connect audio 
notification sound

Comma separated allow list of roles able to 
access Connect. Empty allows all roles.

connect.roles

Determines which user roles are required to 
access Connect. When the value is blank, no 
role is required. This property also impacts 
Connect  Support.

Note: 
If you choose to restrict Connect  access to 
specific roles, consider updating the role 
requirements for Connect  modules and 
other access points.

• Type : string

• Default value: <empty>

• Location: Collaborate  > Administration  > 
Properties

Determine whether or not a button is shown 
in task forms to view the Collaboration 
document conversation or Live Feed 
Record Feed related to the task. Note: The 
Collaboration button will only be enabled 
if the frameset view is also enabled with 
collaboration.frameset = true

glide.live_feed.task_header_button

Determines whether the show live feed 

icon ( ) and Follow  button are available 
in the form header of tables that have the 
live_feed=true  dictionary attribute.

• Type: choice list

• Default value: collaboration

• Other possible values:

◦ both: enables both the show live feed icon 
and the Follow  button.

◦ live_feed: enables the show live feed icon.

◦ none: disables both the show live feed icon 
and the Follow  button.
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Properties for Connect  (continued)

Property Description

• Location: Collaborate  > Administration  > 
Properties

• Learn more: Configure record conversations

Disable the legacy chat "Create or Join Chat 
Room" link on the Incident form (Must have 
Chat plugin enabled to see link)

glide.connect.enabled

Hides the Create or Join Chat Room  related 
link, which appears on the Incident form 
when legacy chat is enabled. Legacy chat and 
Connect  Chat should not be used concurrently 
and this property should not be modified.

• Type: true | false

• Default value: true

• Location: Collaborate  > Administration  > 
Properties

Configure the polling interval

The polling interval determines how frequently the system polls for new Connect messages.

Before you begin
Role required: admin

About this task
The default interval is 10 seconds. You can change this value. The shorter the polling interval, 
the more frequently the system checks for new messages and the greater the impact on 
performance.

Note: 
This setting impacts Connect Chat and Connect Support.

Procedure

1. Navigate to sys_properties.list.

2. Locate the collaboration.polling_interval  property.

3. Set the Value  to a different number of seconds.
Setting the polling interval to a value smaller than 2 is likely to tax the system too heavily, while 
a value greater than 10 is likely to result in a poor user experience.

Disable the Connect overlay

The Connect overlay is enabled by default and is integrated with the standard user interface. You 
can disable the Connect overlay.

Before you begin
Role required: admin

About this task
To disable the Connect overlay and remove the toggle Connect sidebar icon from the banner 
frame, set the collaboration.frameset  property to false.
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Procedure

1. Navigate to All  > Connect  > Administration  > Properties.

2. Locate the property called Enable Connect in the frameset  (collaboration.frameset) 
and clear the check box.

3. Click Save.

Result
When the frameset is disabled, any Connect chats open in the Connect workspace. For more 
information on completely disabling Connect Chat, see Disable Connect Chat.

Customize the Connect audio notification sound

You can replace the default Connect audio notification sound with an audio file of your choice.

Before you begin
Role required: admin

Upload the audio file  you want to use as the notification sound.

Role required: admin

About this task
The audio notification sound is used for all Connect conversation types, including Connect 
Support conversations.

Procedure

1. Navigate to All  > System UI  > Audio Files.

2. Locate the audio file you want to use as the notification sound and copy the Name  value.

3. Navigate to Connect  > Administration  > Properties.

4. Locate the property called Audio file to play to notify users of new 
messages, support conversation transfers and @mentions in Connect 
(connect.notification.audio_alert) and replace the default value with the name 
of the audio file.

5. Click Save.

Result
End users receive audio notifications when sending and receiving support chats. Support agents 
only receive audio notifications for inbound chats when the chat window is not in focus.

Administer Connect actions

You can create or modify Connect actions to provide custom functionality in Connect Chat or 
Connect Support conversations.

Before you begin

Important: 

Core UI  is required to use Connect Chat. Connect Chat is not supported in Next Experience. 
If you turn on Next Experience, Connect Chat will no longer work. See Next Experience UI
for more information.

If you want to customize the icon for a Connect action, navigate to Collaborate  > Administration 
> Action Icons  to view the available icons and their class names. Note the class name of the icon 
you want to use.
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Role required: admin

About this task
The Connect action menu appears by the message entry field when one or more Connect 
actions are available for a conversation, based on defined conditions. When a user selects a 
Connect action, the system runs the script defined for that action.

Procedure

1. Navigate to Connect  > Administration  > Actions.

2. Click New  or open an existing record to edit a table.

3. On the form, fill in the fields.

Connect Action form

Field Description

Condition JavaScript condition statement that must return true for the action to be 
available in a conversation. For example, to show the action in Connect Support 
conversations only, enter conversation.type === "support"  or 
conversation.table === 'chat_queue_entry'.

For information about the conversation  object, see the GlideConversation
API reference documentation.

Hint This field is not used.

Icon 
Class 
Name

Class name of the icon to use.

To view all available icons and their class names, navigate to Collaborate  > 
Administration  > Action Icons.

Order Order of the action relative to other items in the Connect action menu.

Script Script to execute when the action is run. For example, to create a new incident 
that is based on the conversation, enter the following code:

response.newRecord("incident",{
    short_description: 
 conversation.document.short_description ||"",
    caller_id: conversation.document.opened_by
});

For information about the response  object, see the ConnectActionResponse
API reference documentation.

Note: 
You can only create a Connect action that is based on a task table.

Shortcut Text that triggers the action when entered after the "/" character in a 
conversation.

Title Text that appears in the Connect action menu. The title for each Connect action 
should be unique.
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Result
Connect Actions form

Configure the fields on a record card in Connect

When a record is either linked to or created from a Connect Chat  conversation, the details of the 
record display as a card in the chat window.

Before you begin
Role required: admin

About this task
The card view only applies to the full Connect Chat  page and the end-user view of Connect 
Support conversations.
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Procedure

1. Select the menu icon ( ) on any of the column names of the incident list view.

2. Right-click on the column name and select Configure  > List 

Layout.

3. On the Configuring Incidents List screen, select New  from the View name 

list.

4. In the Create New View dialog, enter Connect  in the View name field. 

.
For more information on creating a form view, see Create and delete views  .
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You cannot remove the Author or the Updated fields from the card regardless of whether they 
are on the view or not. The card always shows the Short Description field in the top even if it is 
in a different order in the list.

5. Choose the fields that you want to display on the Connect  card and select 

Save.

6. Validate that the card displays the fields in a Connect Chat  conversation.

Disable specific URLs for Connect

Prevent users from accessing certain websites by disabling linking to specific Top-Level Domains 
(TLDs).

Before you begin
Role required: admin

Procedure

1. In the navigation filter, type sys_properties.list.

2. Search for the glide.ui.url.external.top_level_domains  system property.

3. In the value field, remove any TLDs that you do not want your users to have access to.
For example, remove any TLDs that are commonly used for restricted websites, such as xxx  or 
adult.

The list of TLDs is based on the top 200 most common domains .

Result
Any TLD not included in the value field becomes unclickable in Connect.
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Connect Chat

Connect Chat is a real-time messaging tool that enables users to chat with individuals and 
groups, quickly share files, and collaborate on any record by connecting with the right people 
instantly.

Important: 

Connect Chat  is not available in Next Experience. Starting with Washington DC, certain 
Connect Chat  functions are available in Next Experience  by using Sidebar. See KB1123615 – 
Moving from Connect Chat to Sidebar  or Next Experience  for more information about the 
differences between Connect Chat  and Sidebar.

Connect Chat animates communication around records, Visual Task Boards, topics of interest, or 
groups of people.

Features include:

• Direct conversations between two users.

• Group conversations between three or more users.

• Conversations linked to records. Comments and work notes appear in conversations in real 
time and users can update the record directly from the conversation.

• Drag-and-drop sharing of links, files, and records.

Core UI  is required to use Connect Chat.

This video demonstrates how to use Connect Chat.

How to use Connect Chat

This video demonstrates how to use Connect Support.

How to use Connect Support

Note: 
Connect Chat does not replace legacy chat but offers some of the same functionality. The 
features should not be used concurrently.

Connect Chat use

All users have access to Connect Chat, a convenient way to stay updated on all the people and 
documents you work with in a familiar chat interface.

You can start using Connect Chat  right away with virtually no setup. Connect Chat  supports a few 
different types of conversations so you can use it as a social tool or a quick way to follow specific 
records.

Start a direct or group conversation

You can start a conversation with one or more users in Connect Chat.

Before you begin

Important: 

Core UI  is required to use Connect Chat. Connect Chat is not supported in Next Experience. 
If you turn on Next Experience, Connect Chat will no longer work. See Next Experience UI
for more information.

Role required: none
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About this task
A conversation between two users is called a direct conversation. A conversation between three 
or more users is called a group conversation.

Procedure

1. In the chat view of the Connect sidebar, click the plus icon (+) by the filter.
A Connect mini window appears.

2. In the To  field, enter the name of the user you want to chat with.
Suggestions appear as you type.

3. Optional:  Enter additional names to create a group conversation.
You can add or remove group conversation members later. You cannot add members to a 
direct conversation after you create it.

4. Press the Enter key to shift focus to the message field.

5. Send a message to create the conversation.
The conversation is added to the Connect sidebar for quick access.

Follow a record in Connect

You can follow a record in Connect Chat to track activity as it happens, in a familiar chat interface. 
When you follow a record, you become a member of a record conversation.

Before you begin

Important: 

Core UI  is required to use Connect Chat. Connect Chat is not supported in Next Experience. 
If you turn on Next Experience, Connect Chat will no longer work. See Next Experience UI
for more information.

Role required: whichever role is required to access the record you want to follow in Connect

About this task
You must first activate the Connect (com.glide.connect) plugin to complete this task.

Any record conversation you create in Connect becomes a record feed in live feed, and vice 
versa. Unlike direct or group conversations, all messages in record conversations are comments 
or work notes.

Note: 
By default, record conversations are enabled for all tables that extend Task [task]. 
Administrators can enable record conversations for additional tables or disable them if 
desired.

Procedure

1. Navigate to a task record.

2. Do one of the following actions.

Option Description

Follow the record
In the form header, click Follow.

The system adds you as a member of the 
record conversation, but does not open the 
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Option Description

conversation. You can open the conversation 
from the Connect sidebar.

Follow the record and open a chat mini win­
dow

a. In the form header, click the down arrow in 
the Follow  button.

b. Select Open Connect Mini.

The system adds you as a member of the 
record conversation and opens it in a Con­
nect mini window.

Follow the record and open the Connect 
workspace

a. In the form header, click the down arrow in 
the Follow  button.

b. Select Open Connect Full.

The system adds you as a member of the 
record conversation and opens it in the Con­
nect workspace, the full-screen view.

The Follow  button is relabeled Following.

3. Add comments or work notes to the record directly from Connect.
Any comments or work notes added to the record appear in the record conversation. Likewise, 
comments and work notes you add to the conversation appear on the record.

a. In the record conversation, by the text entry field, click the message type icon ( ).

b. Select Comment  or Work Note.

c. Enter a message.
By default, record conversation messages are added as work notes.

Note: 
If you add an attachment to a record conversation, it is attached to the underlying record 
as well.

What to do next
Edit your notification settings  for the record conversation.

Related topics

Live Feed Core UI

Edit basic conversation details

In Connect Chat, you can customize the avatar, name, and description for a group or record 
conversation.

Before you begin
Role required: none

About this task
These details are not editable for direct conversations.
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Note: 
The name and description for a record conversation default to the record name and short 
description. However, editing the name or description for a record conversation does not 
change anything on the underlying record.

Procedure

1. Open the a group or record conversation in the Connect workspace.

2. Click anywhere in the conversation header to the left of the icons.
A pop-up appears to edit conversation details.

3. Edit the conversation image, name, and description as needed.

4. Click Save.

Add or remove conversation members

In Connect Chat, any member of a group or record conversation can add or remove other 
conversation members. In a direct conversation with only two people, you cannot add members 
to the conversation after you create it.

Before you begin
Role required: none

Procedure

1. Open a group or record conversation in the Connect workspace.

2. In the conversation tools to the right of the conversation pane, click the member list tab ( ).

3. Do one of the following actions.

Option Description

Add a member
a. Click Add Member to Group.

b. Use the search field to find and select a 
user.

Remove a member
a. Point to a member name.

b. Click the minus icon (-).

Create a Connect conversation from a Visual Task Board

Create a Connect Chat conversation from a Visual Task Board to collaborate with board members 
and keep track of activity as it happens.

Before you begin
Role required: none

About this task
When you create a conversation from a task board, all the board members become members of 
the conversation. The members are synchronized between the task board and the conversation. 
For example, if you remove a user from the conversation, the system automatically removes the 
user from the board as well.
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Procedure

1. Navigate to All  > Self-Service  > Visual Task Boards.

2. Open a task board.

3. In the board header, click the connect with board members icon ( ).
The system automatically opens a record conversation for the board. Each board member 
becomes a member of the conversation.

Related topics

Connect Chat

Visual Task Boards

Connect Chat administration

Administrators can configure various performance settings and features of Connect Chat.

Note: 
There are also settings that apply to both Connect Chat  and Connect Support. For more 
information, see Connect administration.

Configure the email notification interval

The email notification interval determines how long the system waits before sending a Connect 
Chat email notification to an inactive user.

Before you begin
Role required: admin

About this task
The default interval is 3 minutes. You can change this value.

Procedure

1. Navigate to All  > Connect  > Administration  > Properties.

2. Locate the property called Number of minutes to wait before collecting unread messages 
and sending an email to offline users.  (collaboration.email_interval) and set the 
value to a different number of minutes.

3. Click Save.

Result
When an offline user is sent a Connect message, the collaboration.new_offline_message event 
fires. The system waits the amount of time provided in the collaboration.email_interval property, 
then triggers the collaboration.notify_offline_user and collaboration.notify_offline_user.group 
events (depending on if the conversation was peer to peer or a group conversation).The 
sysevent_email_action record listens for collaboration.notify_offline_user(.group) then builds an 
email notification containing all the messages from the last collaboration.email_interval minutes 
that the user has received in that conversation.

Enable record conversations for a table

Record conversations are enabled for all tables that extend Task [task] by default. You can 
configure record conversations for additional tables that extend Task.

Before you begin
Role required: admin
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About this task
To create record conversations, users must have access to the Follow  button in the form header. 
To show the button and thus enable record conversations for a table, the following conditions 
must be true.

• The live_feed  dictionary attribute must be set to true  for the table. By default, 
live_feed=true  for all tables that extend Task [task].

• The glide.live_feed.task_header_button  property must be set to both  or 
collaboration. By default, glide.live_feed.task_header_button  is set to 
collaboration.

Procedure

1. Navigate to the list view of a table for which you want to enable record conversations.

2. Perform the appropriate action for the list version.
The list of dictionary entries for the table appears.

3. Open the dictionary entry that has Type  set to Collection.
The Dictionary Entry form appears.

4. In the Attributes  related list, click New.
The Dictionary Attribute form appears.

5. In the Attribute  field, enter Live feed.

6. In the Value  field, enter true.

7. Click Submit.

8. Navigate to Collaborate  > Administration  > Properties.

9. Locate the property called Determine whether or not a button is shown in task forms to view 
the Collaboration document conversation or Live Feed Record Feed related to the task 
(glide.live_feed.task_header_button).

10. Ensure the property is set to both  or collaboration.
The glide.live_feed.task_header_button  property also controls whether the 

show live feed icon ( ) appears. If the property is set to collaboration, the show live feed 
icon does not appear on form headers.

Related topics

Dictionary attributes

Prevent users from following records in Connect for all tables

Users can follow records in Connect for any table that extends Task [task] by default. You can 
disable this functionality for all tables.

Before you begin
Role required: admin

About this task
To disable record conversations for all tables, prevent the Follow  button from appearing in all 
form headers by editing the glide.live_feed.task_header_button  property.
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Procedure

1. Navigate to sys_properties.list.

2. Locate the glide.live_feed.task_header_button  property.

3. Set the Value  to live_feed.

Prevent users from following records in Connect for a specific table

Users can follow records in Connect for any table that extends Task [task] by default. You can 
disable this functionality for a specific table.

Before you begin
Role required: admin

About this task
To disable record conversations for a specific table, prevent the Follow  button from appearing 
in form headers for the table. To do so, set the live_feed  dictionary attribute to false  for the 
table.

Procedure

1. Navigate to the list view of a table for which you want to disable record conversations.

2. Perform the appropriate action for the list version.
The list of dictionary entries for the table appears.

3. Open the dictionary entry that has Type  set to Collection.
The Dictionary Entry form appears.

4. In the Attributes  related list, locate the Live feed  dictionary attribute.

5. Set the Value  to false.

Setting the dictionary attribute to false  also removes the show live feed icon ( ) for the table.

Related topics

Dictionary attributes

Disable Connect Chat

You can disable Connect Chat  to prevent users from being able to chat within the platform.

Before you begin
Role required: admin

About this task
Disabling Connect Chat  hides the Connect Chat  sidebar icon. Users who try to access Connect 
Chat  from the navigation pane receive a message that says Connect has been disabled.

Procedure

1. In the navigation filter, type sys_properties.list  and press Enter.

2. Search for the glide.connect.chat.disabled  property.

3. Set the property value to true.

Connect Support

Connect Support  is a real-time messaging tool that enables support agents to easily track their 
support cases, find solutions, and resolve problems quickly.
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Important: 

Starting in Utah, Connect Support  has been deprecated and is no longer supported or 
available for new activation. For similar capabilities, please move to Advanced Work 
Assignment  and Agent Chat. For details, see Move from Connect Support to Advanced 
Work Assignment and Agent Chat.

Connect Support  builds on the messaging platform provided with Connect. For general 
information about the Connect  interface, setup, and administration, see Connect. When Connect 
Support  is enabled, users designated as support agents can access the support tab of the 
Connect  sidebar.

Using Connect Support:

• Administrators can create chat queues and enable users to access live support.

• Support agents can monitor the queues to provide instant support.

• Users can share links, files, and records using drag-and-drop.

Core UI  is required to use Connect Support.

Note: 
Connect Support  does not replace legacy chat but offers some of the same functionality. 
Do not use the features concurrently.

Monitor incoming Connect Support conversations

In the support tab of the Connect sidebar, you can monitor the queues for which you are an 
agent and accept incoming conversations.

Before you begin
Role required: none

About this task
Note: 
The support tab is visible only if you are an agent for one or more queues.

Procedure

1. Navigate to All  > Connect  > Connect Support.
The Connect workspace opens in a new tab.

2. Click the support tab of the Connect sidebar, indicated by a headset icon ( ).
The support tab displays Queues  to which you belong. It also displays your open support 
conversations under Cases. When a user starts a support conversation or an agent transfers 
a conversation to a queue, any agent who belongs to the associated queue can accept the 
conversation. An agent can also request to transfer a conversation  directly to you.
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Support tab of Connect sidebar

3. Accept a conversation in one of the following ways.

Option Description

Accept a conversation from a queue

Under Queues, click Accept  by the queue.

The conversation opens in the conversation 
pane and an entry appears in the Cases  sec­
tion of the sidebar.

Accept a transfer request

Under Cases, click Accept  by a transfer re­
quest.

Transfer request

The conversation opens in the conversation 
pane. The agent who transferred the conver­
sation can stay in the conversation.

4. Respond to the user and help resolve the issue.
By default, your messages are added to the conversation record as comments and are visible 
to the user.
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5. Optional:  Initiate a Zoom  meeting to help resolve customer issues faster.
For more information, see Initiate Zoom meetings from chats .

Related topics

Configure a survey in the Connect chat support

Share knowledge in a Connect Support conversation

The support view of the Connect workspace has a built-in knowledge tool that makes it easy to 
search for knowledge articles and share them in a conversation.

Before you begin
Role required: none

About this task
Use the knowledge tool to research user questions and provide solutions quickly and easily.

Procedure

1. Open a support conversation in the Connect workspace.
The knowledge tool is not available in Connect mini windows.

2. In the conversation tools area to the right of the conversation pane, click the knowledge base 
tab, which is represented by an open book icon.

The knowledge homepage appears in the conversation tools pane.

3. Search for articles related to the user's issue.
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For more information about finding knowledge, see Search using Knowledge Management v3.

4. To share an article in the conversation, drag a knowledge article link to the conversation pane 
and drop it anywhere in the drop zone that appears.

Transfer a Connect Support conversation to a different agent or queue

You can transfer a Connect Support conversation to a different agent in the queue or to a 
different queue.

Before you begin
Role required: none

Procedure

1. Open a Connect Support conversation.

2. At the bottom of the conversation, click the menu icon ( ) to open the Connect actions 
menu.

3. In the Connect actions menu, select Transfer.
A transfer dialog box opens.

4. Do one of the following actions.

Option Description

Transfer the conversation to an agent

a. To start the transfer request, click Transfer 
by an agent's name.

Be sure to choose an agent who is online. 
A green dot on their avatar indicates that a 
user is online.

You can cancel the transfer any time before 
it is accepted.
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Option Description

b. When the transfer is accepted, select one 
of the following options in the dialog box 
that appears.

▪ Stay: Remain in the conversation, which 
is also known as a warm transfer. This 
option is ideal if you want to provide the 
new agent with background information 
or introduce the user to the new agent.

▪ Leave: Exit the conversation, which is al­
so known as a cold transfer.

Transfer the conversation to a queue

Click Transfer  by a queue.

The system automatically removes you from 
the conversation and the conversation enters 
the queue you selected.

Add a user to a Connect Support  conversation

You can add additional users to a Connect Support  conversation.

Before you begin
An administrator must enable the glide.connect.support.add_members  property 
before users can be added to conversations.

Role required: none

Procedure

1. Open a group or record conversation in the Connect  workspace.

2. In the conversation tools to the right of the conversation pane, click the member list tab ( ).

3. Do one of the following actions.

Option Description

Add a member
a. Click Add Member to Group.

b. Use the search field to find and select a 
user.

Remove a member
a. Point to a member name.

b. Click the minus icon (-).
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Option Description

The assigned support agent cannot be re­
moved from a Connect Support conversation.

Note: 
Only the assigned support agent can create an incident from the Connect Support 
conversation.

Escalate a Connect Support conversation

If an escalation path is defined for a Connect Support conversation, you can use a shortcut to 
escalate a Connect Support conversation to a different queue.

Before you begin
Define an escalation path for the queue, using the Escalate to  field on the Chat Queue 
[chat_queue] table. For more information, see Administer Connect Support queues.

Procedure

1. Open a Connect Support conversation.

2. At the bottom of the conversation, click the menu icon ( ) to open the Connect actions 
menu.

3. In the Connect actions menu, select Escalate.
A confirmation dialog box appears.

4. In the dialog box, click Escalate.
The system automatically removes you from the conversation and the conversation enters the 
escalated queue.

Connect Support chat states

Connect Support chats move through specific states.
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Connect Support states diagram

Connect Support chat states

Composite state State Definition

Active Waiting • Requester/end user enters a queue by sending a 
message. Agent has not yet accepted it.

• Requester/end user rejoins a session that is in a 
Reopenable state.
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Connect Support chat states  (continued)

Composite state State Definition

Work in 
Progress

• Agent accepts a chat from a queue. Both requester and 
agent engage in a chat session.

• Requester/end user temporarily leaves an ongoing 
conversation; requester or agent does not end the 
session; requester rejoins session.

Reopenable Closed 
Abandoned

Requester/end user clicks End Chat  button before agent 
accepts the request.

Permanently 
closed

Closed by 
Client

• Requester/end user clicks End Chat  button after agent 
accepts the request.

• Requester/end user times out.

Closed 
Escalated

Agent escalates an ongoing conversation by performing the 
Escalate action from the menu icon.

Closed 
Complete

• Agent ends the session.

• During a chat, if an agent creates an incident or case and 
closes it, the chat session closes automatically.

Connect Support administration

Administrators can configure various performance settings and features of Connect Support.

Note: 
There are also settings that apply to both Connect Chat and Connect Support. For more 
information, see Connect administration.

Migrate from legacy chat to Connect Support

Connect Support  is an extension of Connect. Users designated as support agents have access 
to the support tab of the connect sidebar. Do not use Connect Support  concurrently with legacy 
chat.

Before you begin
Role required: admin

Before you activate Connect Support, inform your support agents to close out any existing chats.

Legacy chat uses a different field to determine which state a help desk chat is in. A fix script is 
included in the Connect Support  plugin that circumvents this issue by closing out any existing 
help desk chat sessions. Manually closing out any existing chats before allowing this script to 
run helps prevent any loss of chat information.

If you do not close out existing help desk chats, your metrics and chat queue will not work 
accurately.
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Procedure

1. Activate the Connect Support  plugin.
When you activate the Connect Support  plugin, the glide.connect.support.enabled 
property redirects the legacy chat URL to Connect Support.

For more information, see Activate Connect Support.

2. Hide the Social IT application.
Activating Connect Support  does not completely eliminate the legacy chat module. To prevent 
users from using the legacy chat, hide the Social IT application menu. For more information, 
see Enable or disable an application menu or module  .

Properties for Connect Support

The Connect Support Properties page provides several configuration options specifically for 
Connect Support.

Important: 

Starting with Utah, Connect Support has been deprecated. For similar capabilities, please 
move to Advanced Work Assignment  and Agent Chat. For details, see Move from Connect 
Support to Advanced Work Assignment and Agent Chat.

These properties are available for Connect Support.

Properties for Connect Support

Users with the admin role can access these properties by navigating to 
Connect  > Support Administration  > Properties.

Note: 
The Connect Properties page  contains many general Connect 
properties that impact Connect Support.

Property Description

Should Connect be used for handling chat 
queue entries

glide.connect.support.enabled

Disables or enables Connect  Support. When 
the property is enabled, the Service Desk 
Chat  button in the Employee Self-Service 
portal opens the conversation in Connect 
Support, rather than legacy chat. Additionally, 
the Support tab appears in the Connect 
sidebar.

• Type: true | false

• Default value: true

• Location: Collaborate  > Support 
Administration  > Properties

Number of support conversations an individual 
agent can have at one time (-1 is unlimited)

connect.support.conversation_limit

Determines how many support conversations 
an individual agent can have at one time. 
When the value is set to -1, an agent can 
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Properties for Connect Support

Users with the admin role can access these properties by navigating to 
Connect  > Support Administration  > Properties.

Note: 
The Connect Properties page  contains many general Connect 
properties that impact Connect Support.

(continued)

Property Description

participate in an unlimited number of 
conversations.

• Type: integer

• Default value: -1

• Location: Collaborate  > Support 
Administration  > Properties

Show agent avatar in Connect Support 
conversations.

connect.support.show_agent_avatar

Determines whether an agent's avatar is 
shown in a support conversation (enabled). 
When the property is disabled, users see the 
agent's name only.

• Type: true | false

• Default value: true

• Location: Collaborate  > Support 
Administration  > Properties

Number of seconds to wait (without user 
interaction), before presenting end users with 
an idle countdown timer

connect.support.idle.delay

Determines how many seconds a user must 
be inactive in a support conversation before 
an idle countdown timer appears.

• Type: integer

• Default value: 120

• Location: Collaborate  > Support 
Administration  > Properties

Number of seconds to count down from before 
marking end user as having left their support 
session

connect.support.idle.count_down

Determines how many seconds the idle 
countdown timer remains open after it 
appears. If the idle user does not dismiss the 
timer before the countdown completes, the 
system closes the support session.

• Type: integer

• Default value: 60

• Location: Collaborate  > Support 
Administration  > Properties
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Properties for Connect Support

Users with the admin role can access these properties by navigating to 
Connect  > Support Administration  > Properties.

Note: 
The Connect Properties page  contains many general Connect 
properties that impact Connect Support.

(continued)

Property Description

Limits the number of closed conversations that 
the support user can see. (0 = unlimited)

connect.support.user.closed.conversation_limit

Determines how many closed conversations 
appear in a user's support conversation 
history. When the value is set to 0, all previous 
conversations appear in the history.

• Type: integer

• Default value: 0

• Location: Collaborate  > Support 
Administration  > Properties

Administer Connect Support queues

You can define the support agents, default messages, schedule, and escalation path for each 
Connect Support queue.

Before you begin
Role required: admin

About this task

Note: 
Both Connect Support queues and legacy chat queues are stored on the Chat Queue 
[chat_queue] table. Do not use Connect and legacy chat concurrently.

Procedure

1. Navigate to All  > Connect  > Queues.

2. Click New  or open an existing queue from the list.

3. Complete the Chat Queue form, as appropriate.

Chat Queue form

Field Description

Name Name of the queue.

Active Not used in Connect.

Assignment 
group

User group that contains the support staff for the queue. Any user in the group 
can view the queue in the Connect sidebar and accept chats. No other users 
can access the queue. This field must be populated.
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Field Description

Average 
wait time

Average time it takes for an agent to accept a chat in the queue. This value is 
automatically calculated. Do not manually edit.

Confirm 
problem

Not used in Connect.

Escalate to Different queue to which an agent can escalate a chat. For example, there is 
a queue for high priority support chats. When a queue is defined in this field, 
agents can access the Escalate  option in conversations.

Initial agent 
response

Message that users see when an agent accepts their chat. For example, Thank 
you for contacting support. We are looking into your question now and will be 
with you shortly.

Not 
available

Message that users see when they attempt to start a chat outside the defined 
queue Schedule. You can use HTML to format the message and include links or 
media.

Question Initial phrase that users see when they start a new chat in the queue. For 
example, How can I help you?

Schedule Schedule that defines when the queue is available. Leave the field blank to 
make the queue available all the time. Users cannot start a new conversation in 
the queue outside the schedule hours.

4. Manage the HR chat queue

Make a Connect Support queue accessible to end users

To make a Connect Support queue accessible to end users, use the accepted URL format.

Before you begin
Create a queue. Create agents for the queue by assigning users to the assignment group 
associated with the queue.
Role required: admin

About this task
For example, you might create a module or add a link to a portal. The accepted URL format 
is https://<instancename>.service-now.com/$chat_support.do?
queueID=<sys_id>.

Procedure

1. Navigate to All  > Connect  > Administration  > Queues.

2. Right-click the name of the queue to which you want to link.

3. In the context menu, select Copy sys_id.

4. Follow browser instructions to copy the sys_id if browser security measures restrict this 
function.

5. Preview the support queue by navigating to https://<instancename>.service-
now.com/$chat_support.do?queueID=<sys_id>.

6. Create a module or other link to the queue using the URL.
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Add a scripted extension point for Connect Support  chats

Implement the ConversationServerInteractionService  extension point, which 
enables you to create custom scripts that use context variables from pre-chat surveys presented 
to requesters in the Agent Chat  client.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Extension Points  > Scripted Extension Points  and select the 
ConversationServerInteractionService  scripted extension point.

2. Click the Create implementation  related link to create a new custom script include.

3. In the Script Include form, create the code that uses the pre-chat context variables to route 
chats to the appropriate Connect Support  queue.

4. Click Update.

Result
The custom script is created and registered against the 
ConversationServerInteractionService  scripted extension point.

Connect Support metrics

Optional plugins provide a homepage and Performance Analytics  dashboards, which contain 
helpful Connect Support metrics.

The reporting homepage is ideal for support managers who want a simple solution to track the 
recent performance of the support organization. The Performance Analytics  dashboards provide 
a more full-featured solution for support managers who want to analyze trends over time.

Users with the admin role can activate the following plugins to use these features.

Connect Support homepage and dashboard plugins

Plugin Description

Connect Support Manager's Dashboard

[com.glide.connect.managers_dashboard]

Provides a homepage for Connect  Support, 
and all required configuration records. Though 
the plugin name contains the term dashboard, 
the plugin does not provide functionality 
related to Performance Analytics  dashboards. 
Homepages are similar to dashboards, but do 
not require Performance Analytics  roles to view.

Performance Analytics - Content Pack - 
Service Desk Chat

[com.snc.pa.chat]

Provides the Service Desk Chat Monitor 
dashboard, which analyzes key Connect 
Support metrics and indicators.

Performance Analytics - Context Sensitive 
Analytics for Chat

[com.snc.pa.chat.context_sensitive_analytics]

Provides in-form analytics for Connect  Support. 
These analytics are available as a related link 
on the Chat Queue Entry [chat_queue_entry] 
form, and also as the Context Sensitive 
Analytics - Chat  dashboard.
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Note: 
For more information about these plugins, including which other plugins they activate, see 
Additional plugins for Connect Support.

Related topics

Performance Analytics  concepts

Use the Connect Support homepage

Use the Connect Support homepage to view key indicators and metrics related to support 
conversations, queues, and agents.

Before you begin
Activate the Connect Support Manager's Dashboard plugin 
(com.glide.connect.managers_dashboard) to view this homepage.
Role required: chat_admin

About this task
The homepage is called Service Desk - Chat.

Procedure

1. Navigate to All  > Connect  > Support Administration  > Reporting Dashboard.

Note: 
Though the module name contains the term dashboard, the module does not provide 
functionality related to Performance Analytics  dashboards. Homepages are similar to 
dashboards, but do not require Performance Analytics  roles to view.

The Connect Support homepage, which is called Service Desk - Chat, opens.

2. Click a widget to drill down into its data.

Use the Connect Support dashboards

Use the Connect Support dashboards in Performance Analytics  to understand trends in your 
support organization's performance over time.

Before you begin
Activate one or both of the following plugins, according to your analytics needs:

• Performance Analytics - Content Pack - Service Desk Chat (com.snc.pa.chat)

• Performance Analytics - Context Sensitive Analytics for Chat 
(com.snc.pa.chat.context_sensitive_analytics)

Role required: both chat_admin and pa_viewer

About this task
The Performance Analytics - Content Pack - Service Desk Chat plugin (com.snc.pa.chat) includes 
the Service Desk Chat Monitor  dashboard, which contains the following tabs:

• Chat Monitor By State: Contains metrics related to closed support conversations.

• Overview: Contains several metrics related to support conversations, queues, and agents.

• KPI Process: Contains metrics that are key performance indicators (KPIs) of the Connect 
Support process, including the average queue response time, the average duration of support 
conversations, and the number of new support conversations per day.
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The Performance Analytics - Context Sensitive Analytics for Chat plugin 
(com.snc.pa.chat.context_sensitive_analytics) includes the Context Sensitive Analytics - Chat 
dashboard. The dashboard contains additional metrics related to support queues, including the 
number of support conversations closed.

Note: 
You must license Performance Analytics to collect scores for the indicators on the 
dashboards. Without Performance Analytics premium, the dashboards display the 
indicators with no data.

Procedure

1. Navigate to All  > Performance Analytics  > Dashboards.
The last dashboard you viewed opens.

2. In the dashboard picker, under the Connect Chat  group, select the dashboard you want to 
view.

3. View the indicators.

Related topics

Performance Analytics  concepts

Configure the add support users property

To enable support agents to add users to a Connect Support conversation, add the 
glide.connect.support.add_members  property.

Before you begin
Role required: admin

Warning: 
Enabling the glide.connect.support.add_members  property can negatively 
impact instance performance if there are large numbers of users logged in to the instance.

About this task
When the glide.connect.support.add_members  property is added and enabled, 
support agents can add users to a support conversation. Any added user can also add other 
users. Only the assigned agent can create an incident from the chat. When non-support agents 
are added to a chat, the chat appears in their chat tab.

Note: 
Make sure you are in the Global scope when adding this property.

Procedure

1. Enter sys_properties.list  in the navigation filter.
The entire list of properties in the System Properties [sys_properties] table appears.

2. Verify that the property does not exist by searching for the property name.
If the property does exist, update the property with the information in the following table.

3. Select New.

4. Complete the form.

Service Desk Chat  Platform Analytics Solutions

Platform Analytics Solutions  contain preconfigured dashboards. These dashboards contain 
actionable data visualizations that help you improve your business processes and practices.
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Platform Analytics  data visualizations use Performance Analytics  indicator data to show you data 
over time, helping you analyze your business processes and identify areas of improvement. With 
Platform Analytics Solutions, you can get value from Performance Analytics  for your application 
with minimal setup. You can always create your own objects as well.

Important: 
Set up and test Platform Analytics Solutions  on a non-production instance before enabling 
them in production.

To enable the solution for Service Desk Chat, an admin can navigate to Performance Analytics 
> Guided Setup. Click Get Started  then scroll to the section for Service Desk Chat. The guided 
setup takes you through the entire setup and configuration process.

Related topics

Platform Analytics Solutions  

Activate your Performance Analytics subscription

Connect Support and Service Portal

Use Connect Support  in your portal to allow your users to ask questions or submit requests to 
support agents. You configure the instance options to control the appearance of your widget and 
how it functions.

The Connect Support  and Service Portal  integration creates a Connect Support  widget that you 
can add to a page in the Service Portal.

Configure Connect Support widget instance options

You can control the appearance of your widget and how it functions by configuring the instance 
options.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Service Portal  > Service Portal Configuration  and open the Service Portal 
Designer.

2. From the Service Portal Designer, select the page you added the Connect Support widget to.
If you have not yet added the widget to a page, see Create and edit a page using the Service 
Portal  Designer  for more information.

3. Click the edit icon in the corner of the widget to open the instance options menu.

4. Complete the fields using the following table.
Depending on the functionality you want to add, you may not need to add all these fields.

Connect Support widget instance options

Field Description

Bootstrap 
color

Select a color for your widget from a list of common bootstrap colors. Themes 
control the overall color of a widget, but if you want your widget to be a specific 
color, you can select it from the list.

Queue 
URL

The URL for the Connect Support chat queue that you want questions 
to be directed to. For example, htts://<instancename.service-now.com/
$chat_support.do?queueID=<sys_id>
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Field Description

Queue 
Name

The name of the queue you want the questions to be directed to. You can find a 
list of queue names in Collaborate  > Connect Support  > Queues.

Queue ID The sys_id of the queue you want questions to be directed to. You can find this ID 
by going to the support queue and either copying the queue ID from the support 
link, or by selecting Copy sys_id  from the context menu.

Message The text for the button in the Connect Support widget

Window Use this option to open the chat in another tab rather than in a new window.

Title The name in the widget header

Classic Orchestration
ServiceNow®  Orchestration extends the workflow engine to manage processes and to automate 
things outside of a ServiceNow  instance.

Orchestration is available as a separate subscription from the rest of the ServiceNow  platform. 
See Activate Orchestration  for details.

Explore

• Introduction to 
Orchestration

• Orchestration applications

• Orchestration ROI

• Orchestration examples

• Domain separation and 
Orchestration

Set up

• Activate Orchestration

• MID Servers for 
Orchestration

• Available activity packs

• Setup Client Software 
Distribution

Administer

• List of Orchestration plugins

• Orchestration Runtime 
plugin

Use

• Orchestration activity packs

• Password Reset

• Client Software Distribution

Develop

• Orchestration activity 
designer

• Orchestration custom 
activity templates

• Client software distribution 
extension framework

• Developer training

Troubleshoot and get help

• Ask or answer questions 
in the Orchestration
community

• Search the Known Error 
Portal for known error 
articles

• Contact Customer Service 
and Support

Introduction to Orchestration

Orchestration automates simple or complex multi-system tasks on remote services, servers, 
applications, and hardware.

An Orchestration process can cross all management disciplines and interact with hosted 
services and all types of infrastructure elements. These capabilities provide a powerful system 
for managing IT and Business processes quickly and reliably.
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Orchestrated solutions aide collaboration among teams by providing reusable data and 
versioning for both the workflows and the activities within them. Subject matter experts can 
create activities that are reusable to numerous workflow developers. When an activity requires a 
change, developers can see the downstream implication of the change immediately by knowing 
which workflows use the activity. Well-designed orchestrations never fail and apply human tasks 
to address errors as they arise.

Orchestration tools

Orchestration can make calls outside of a ServiceNow  instance, directly to web services or 
through a MID Server to systems within corporate firewall. Orchestration also enables the 
creation reusable activities that wrapper Java Script functions for manipulating things inside the 
platform. Orchestration extends the Workflow editor  by providing these features:

• Activity packs  containing ready-to-use activities.

• Activity Designer, which enables developers to create custom activities without an over 
dependence to create scripts to orchestrate to third-party systems.

• Ability to create activity packs using Scoped Applications.

• A Databus  for following the flow of data across orchestration activities.

Orchestration  Core provides entitlements to use specific applications:

Client Software Distribution

An application that automates software delivery from the Service Catalog. Provides 
OOB support for SCCM. Partner solutions support Macs using JAMF. Other third-
party solutions provide support through the extension framework.

Configuring Password Reset

An application for users to reset their password in Active Directory. It can expand to 
communicate with other third-party systems.

Orchestration ROI

Enables users to evaluate estimated costs and actual costs for tasks, automate 
these tasks, and track the ROI of these tasks.

Systems that Orchestration can automate

Orchestration can automate tasks such as employee onboarding, user access rights, server 
management, managed file transfers, and Security Operations Orchestration activities  . For 
example, you might use the Active Directory and Exchange activities provided in the base 
Orchestration system to set up network accounts and mailboxes for new employees.

If Orchestration does not provide the activities you need for an integration, create the necessary 
activities using the templates in the Orchestration Activity Designer. The external systems that 
Orchestration can automate for:

• Any system exposing web services (SOAP,  REST)

• Any system accessible from the command line (such as a UNIX system accessible through 
SSH, a Windows system enabled for PowerShell  remoting or WMI)

• Numerous proprietary services: Windows  Active Directory, Microsoft Exchange  mail servers, 
InfoBlox, and F5 Networks.

Note: 
For a full list of Activity Pack service offerings, see Orchestration Core Activity Packs.

• Any filesystem accessible by SFTP
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• Any database with a compliant JDBC  driver

• Additional Activity Packs are also available with other ServiceNow  products, such as Security 
Operations

Orchestration capabilities

Orchestration workflow

When an Orchestration activity starts within a workflow, Orchestration launches a Discovery 
probes and sensors  and writes a probe record to the ECC Queue. The workflow pauses as 
the MID Server picks up the request and executes the probe. When the probe reports back, the 
workflow resumes as the results are analyzed. The workflow can exit or continue at this point.

Orchestration workflow

Domain separation and Orchestration

Domain separation is supported in Orchestration. Domain separation enables you to separate 
data, processes, and administrative tasks into logical groupings called domains. You can control 
several aspects of this separation, including which users can see and access data.
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Support level: Standard*

• Includes Basic  level

• Business logic: Processes can be created or modified per customer by the service provider. 
The use cases reflect proper use of the application by multiple service provider customers in a 
single instance.

• The owner of the instance needs to be able to configure MVP business logic and data 
parameters per tenant as expected for the specific application.

Use case: As an admin, I need the ability to make comments mandatory on close of a record for 
one tenant, but not for another.

Related topics

Domain separation for service providers

Activate Orchestration

The Orchestration (com.snc.runbook_automation) plugin is available within a separate 
subscription from the rest of the ServiceNow  platform.

Before you begin
To purchase a subscription, contact your ServiceNow  account manager. The account manager 
can arrange to have the plugin activated on your organization's production and subproduction 
instances, generally within a few days.

If you don't have an account manager, decide to delay activation after purchase, or want to 
evaluate the product on a subproduction instance without charge, follow these steps.

Role required: none

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. On the All Applications page, select Request Plugin  to open the Activate Plugin  form on Now 
Support.
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3. On Now Support, select the link to access the Now Support  Service Portal  Service Catalog.

4. Select your instance.

5. Select Actions > Activate Plugin.

6. On the Activate Plugin  form, provide the following information.

Activate Plugin form

Field Description

What is your target instance Instance on which to activate the plugin.

Which plugin would you like to activate Name of the plugin to activate.

Note: 
If the system does not list the plugin you 
want or if you are activating the plugin 
on an OEM or on-premise instance, 
select the Plugin I'm looking for is not 
listed  check box and then enter the 
name of the plugin.

Select Maintenance Date and Time The date and time to activate the plugin.

Note: 
Plugins are activated in two batches, 
once in the morning and once in the 
evening, on every business day in the 
US Pacific time zone. If the plugin must 
be activated at a specific time, enter the 
request in the Reason/Comments  field.

Example 

For example, see the following form to activate the CSM Workspace plugin on an instance 
named My Instance.
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Activate Plugin form

7. Select Submit.
For additional details about requesting a plugin, see Requesting a Plugin from the Service 
Catalog [KB0751715] article in the Now Support  Knowledge Base.

List of Orchestration plugins

This table lists all plugins available for Orchestration and their dependencies.

These Orchestration plugins are available for purchase or can be requested as part of your 
Orchestration subscription. Contact your account representative for details.

Name Description Dependencies

Orchestration 
[com.snc.runbook_automation]

Main plugin for the Orchestration 
feature. This plugin extends Workflow 
to automate operations with external 
systems. Use this plugin to orchestrate 
business services, applications, and 
infrastructure.This plugin automates 
operations such as deployments, 
configurations, and information 
gathering. Orchestration can automate 
Web Services and uses MID Servers to 
execute commands on devices inside an 
enterprise's network.

• Orchestration - 
ROI

• Orchestration - 
Runtime

Orchestration - 
Active Directory 
[com.snc.orchestration.ad]

Installs the Active Directory  activity 
pack. These activities create, delete, 
and manage objects in Windows Active 
Directory.

Orchestration

Orchestration - Asset 
Lease Management 
[com.snc.orchestration.asset_lease_management]

Provides the software lease functionality 
for Client Software Distribution. Allows 
users to select the start and end dates 
of software leases and to request an 
extension of a lease.

None
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Name Description Dependencies

Note: 
This plugin is not automatically 
enabled when Orchestration is 
active.

Orchestration - Azure 
Active Directory 
[com.snc.orchestration.azure.ad]

Installs the Azure AD  activity pack. 
These activities automate employee 
onboarding and offboarding functions 
on Azure Active Directory and manage 
Office 365 licensing.

Orchestration

Orchestration - Client 
Software Distribution 
[com.snc.orchestration.client_sf_distribution]

Allows the distribution of software  from 
the service catalog using third party 
management systems, such as Microsoft 
System Center Configuration Manager 
(SCCM)

Note: 
This plugin is not automatically 
enabled when Orchestration is 
active.

• Orchestration - 
System Center 
Configuration 
Manager

• Orchestration 
- Asset Lease 
Management

• Service Catalog 
Scoped API

• Software Asset 
Management

Orchestration - Exchange 
[com.snc.orchestration.exchange]

Installs the Exchange  activity pack. 
These activities manage Microsoft 
Exchange mail systems.

Orchestration

Orchestration - F5 
network management 
[com.snc.orchestration.f5]

Installs the F5 Network Management 
activity pack. These activities configure 
elements of an F5 load balancer, 
including pools, pool members, and the 
virtual servers contained in the pool.

Orchestration

Orchestration - Infoblox 
DDI Activity Pack 
[com.snc.orchestration.infoblox]

Installs the Infoblox DDI  activity pack. 
These activities support Infoblox DDI 
management.

Orchestration

Orchestration - PowerShell 
[com.snc.orchestration.powershell]

Installs the PowerShell  activity pack. 
These activities control and automate the 
administration of Windows machines and 
applications, using the Windows .NET 
Framework.

Orchestration

Orchestration - Probe 
[com.snc.orchestration.probe]

Installs the Probe  activity pack. These 
activities run ServiceNow®probes 
on target hosts to return specific 
information.

Orchestration

Orchestration - ROI 
[com.snc.runbook_automation.roi]

Installs an Orchestration application 
that estimates savings resulting from 
automated tasks in an instance and 
computes actual savings. Orchestration 
- ROI  is activated automatically with a 
base Orchestration subscription.

• Performance 
Analytics

• Cost 
Management
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Name Description Dependencies

Orchestration - ROI Premium 
[com.snc.runbook_automation.roi_premium]

Installs a premium dashboard that 
displays detailed reports on calculated 
savings for automated tasks over time. 
The Orchestration - ROI Premium  plugin 
requires purchase and activation of the 
Performance Analytics - Premium plugin 
to display its reports.

Note: 
This plugin is not automatically 
enabled when Orchestration is 
active.

• Orchestration - 
ROI

• Performance 
Analytics - 
Premium

Orchestration - Runtime 
[com.snc.runbook_automation.runtime]

Enables other applications on the 
ServiceNow®  platform to distribute 
and use orchestration content without 
requiring an Orchestration subscription. 
The Orchestration - Runtime  plugin 
displays the Orchestration activities 
shipped with these applications in the 
Workflow Editor and allows customers to 
modify the activities without requiring an 
Orchestration license.

• Workflow 
Runtime Engine

• Core Automation

Orchestration - SFTP 
[com.snc.orchestration.sftp]

Installs the SFTP File Transfer  activity 
pack. These activities manage files and 
directories on an SFTP server and move 
files from one SFTP server to another.

Orchestration

Orchestration - SSH 
[com.snc.orchestration.ssh]

Installs the SSH  activity pack. These 
activities read, write, and copy files, 
and reset user passwords on Linux 
computers.

Orchestration

Orchestration - System Center 
Configuration Manager 
[com.snc.orchestration.sccm_mgnt]

Installs the System Center Configuration 
Manager (SCCM)  activity pack. These 
activities manage software deployments 
and collections on an SCCM server.

Orchestration

Orchestration Runtime plugin

The Orchestration – Runtime plugin enables other applications on the ServiceNow®  platform to 
automate tasks, without requiring an Orchestration subscription.

The Orchestration – Runtime plugin can be activated as part of another plugin or application. It 
is used by strategic technology partners and ServiceNow applications to distribute activity packs 
to customers who may not own Orchestration. For example, the Security Incident Response 
Management (SIRM) application provides orchestration content, which includes activities that 
are available from the Packs  tab in the Workflow Editor. Customers who purchase SIRM can 
consume and modify the activities that SIRM ships without having to purchase an Orchestration 
license.

Included with the plugin

The Orchestration – Runtime plugin provides access to the Packs  and Data  tabs in the Workflow 
Editor. This plugin gives users access to custom activities for their applications and enables them 
to reuse data from the Databus. This plugin does not provide access to custom Orchestration 
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activity packs  or to the activity designer. The Custom  tab in the Workflow Editor is not available 
without an Orchestration subscription.

Orchestration plugin relationships

Dependencies

The Orchestration – Runtime plugin activates these application plugins:

• Security Incident Response Orchestration

• Service Release Automation

.

Access to activities
Custom activities shipped with ServiceNow®  applications are available in the Packs  tab of the 
Workflow Editor for use in workflows. To edit these activities, navigate to Orchestration  > Activity 
Designer Activities  and select the activity you want to modify. For information about the provider 
templates used to create these activities, see Orchestration custom activity templates.

List of Orchestration activities

Use Orchestration  activities in a Workflow  to integrate with third-party systems.

Several Orchestration activities have been rewritten as Application scope  activities using the 
activity designer  and grouped into activity packs. Other non-scoped activities are deprecated 
and may or may not appear in the Workflow Editor. However, all deprecated activities still function 
in existing workflows that use them.

Global activities

These activities run in the global scope only. Any activities you create in the global scope are 
organized in the Global category in the Packs  and Custom  tabs in the Workflow Editor.
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Activity Description

Test Server Alive Runs a command (including shell scripts) on 
a Linux  or UNIX  computer via SSH to validate 
whether the target system is alive.

Active Directory (AD) activities

All AD Orchestration activities were rewritten in the Geneva  release as scoped activities and are 
available in the Active Directory activity pack. All previous version AD activities that were built on 
activity definitions are deprecated and are unavailable for use in new workflows.

Activity Description

Create AD Object Creates a user account in Windows Active Directory when a user account is 
created in a ServiceNow  instance.

Disable AD User 
Account

Marks a Windows Active Directory user account disabled, making it 
inactive.

Enable AD User 
Account

Enables a Windows Active Directory user account, making it active.

Query AD Retrieves entries from the Windows Active Directory based on a search 
filter.

Remove AD 
Object

Deletes a user account from Windows Active Directory.

Reset AD User 
Password

Resets the password of a user account in Windows Active Directory.

Change AD User 
Password

Changes the password of a user account in Windows Active Directory.

Update AD Object Updates a user account in Windows Active Directory.

Is AD Account 
Locked

Determines if an Active Directory user account is locked.

Unlock AD 
Account

Unlocks a locked Active Directory user account.

Azure AD

All these activities are scoped and part of the Azure AD activity pack. They do not have legacy 
versions.

Activity Description

Add User to Group Adds a user to an existing security group in 
Azure Active Directory.

Assign User License Assigns an extra Office 365 software license to 
the named user.

Create User Creates a user for the Azure Active Directory 
tenant.
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Activity Description

Delete User Deletes the named user's account from the 
Azure Active Directory tenant.

Get User Info Returns the named user's information from the 
Azure Active Directory.

Remove User from Group Removes an existing user from a security 
group in Azure Active Directory.

Remove User License Revokes the specified Office 365 software 
license for the named user.

Reset User Password Changes the named user's Azure Active 
Directory password.

F5 Network Management activities

All these activities are scoped and part of the F5 Network Management activity pack. They do not 
have legacy versions.

Activity Description

Add F5 Pool Creates the load balancer pool.

Check F5 Pool Checks the status of a pool to validate whether it is available to 
accept traffic.

Delete F5 Pool Deletes an F5 pool.

Add F5 Pool Member Adds a member to an F5 pool.

Get F5 Pool Member Returns the pool members and verifies the pool status.

Delete F5 Pool Member Deletes an F5 pool member.

Add F5 Virtual Server Adds a virtual server.

Modify F5 Virtual Server Configures a virtual server assigned to an F5 pool with irules 
and a vlan.

Delete F5 Virtual Server Deletes a virtual server from an F5 pool.

Add F5 Profile to Virtual Server Adds a profile to a virtual server assigned to an F5 pool.

Infoblox activities

All these activities are scoped and part of the Infoblox DDI activity pack. They do not have legacy 
versions.

Activity Description

DHCP Reserve IP v4 
Address Range

Reserves an IP address range for DHCP use.

DHCP Delete IP Reservation Deletes IP reservations in DHCP using either an IPv4 or IPv6 
address range.

DHCP List IP Reservations Generates a list of all the DHCP range reservations on a specific 
Infoblox server.
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Activity Description

List DNS C-records Retrieves all canonical (CNAME) records from a specified 
Infoblox server.

Register DNS A-record Creates a DNS A record on a specified Infoblox server.

Register DNS C-Record Creates a DNS canonical (CNAME) record on a specified 
Infoblox server.

List DNS Record Generates a list of all the DNS entries on a specific Infoblox 
server.

DNS Delete Deletes DNS records of any type from in Infoblox server, such as 
C and A records.

IPAM Register IP Address Registers an IP address in a network using Infoblox IPAM.

IPAM Reserve IP Address Reserves an IP address in a network using Infoblox IPAM.

IPAM List IP Reservations Returns an array of all IP Address within the named Infoblox 
Server.

IPAM Delete Deletes an IP Address within a named Infoblox server.

Create Network Creates networks on a specified Infoblox server.

Get Network Details Retrieves the information about a specific network on an 
Infoblox server.

Delete Network Deletes a network from an Infoblox server.

List Registered Networks Retrieves all the networks associated with an Infoblox server.

Microsoft Exchange activities

All Exchange Orchestration activities were rewritten in the Geneva  release as scoped activities 
and are available in the Exchange activity pack. All previous version Exchange activities that 
were built on activity definitions are deprecated and are unavailable for use in new workflows.

Activity Description

Create Address List Creates an address list that acts as an alias 
for emailing all users in the group. This alias 
cannot be used to manage user permissions.

Delete Address List Removes an existing address list from an 
Exchange server.

Get Address List Retrieves all attributes from the specified 
Exchange address list.

Move Address List Moves an Exchange address list to another 
location in the address hierarchy.

Set Address List Modifies an Exchange address list.

Update Address List Adds or removes users from the specified 
address list and immediately applies any 
cached address list changes to the server.

Create Mailbox If a user does not exist, creates a new Active 
Directory user and associated Exchange 
mailbox.
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Activity Description

Delete Mailbox Deletes the Exchange mailbox of an Active 
Directory user.

Disable Mailbox Disables the mailbox associated with a 
specified Active Directory account.

Enable Mailbox Creates a mailbox for an existing Active 
Directory user.

Get Mailbox Gets the mailbox for the specified user or all 
mailboxes on an Exchange server.

Set Mailbox Modifies the settings of an existing Exchange 
mailbox.

PowerShell activities

These PowerShell activities were rewritten as scoped activities and are available in the 
PowerShell activity pack. All previous version PowerShell activities that were built on activity 
definitions are deprecated and are unavailable for use in new workflows.

Activity Description

Install Windows App Installs an application on a Windows target machine.

Join Domain Joins a Windows machine to a domain.

Restart Windows Server Restarts a Windows server using PowerShell.

Uninstall Windows App Uninstalls an application from a Windows target machine.

Change Service State Starts or stops a Windows  service on a remote system.

Probe activities

These probe activities were rewritten as scoped activities and are available in the Probe 
activity pack. All previous versions of these activities that were built on activity definitions are 
deprecated and are unavailable for use in new workflows.

Activity Description

Resolve DNS Name Resolves an IP address or a fully qualified 
domain name (FQDN) into one or more IP 
addresses.

SNMP Query Queries an SNMP device.

SCCM activities

All these activities are scoped and part of the SCCM activity pack. They do not have legacy 
versions.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4855



Activity Description

Add to Device Collection Adds a device to a Microsoft System Center 
Configuration Manager (SCCM) device 
collection.

Add to User Collection Adds a user to a Microsoft System Center 
Configuration Manager (SCCM) user 
collection.

Get Applications Returns a list of all the applications available 
on a Microsoft System Center Configuration 
Manager (SCCM) server.

Get Deployments Returns the list of deployments performed 
by Orchestration using a Microsoft System 
Center Configuration Manager (SCCM) server.

Get Device Collections Returns the list of available device collections 
on a Microsoft System Center Configuration 
Manager (SCCM) host.

Get User Collections Returns the list of available user collections 
on a Microsoft System Center Configuration 
Manager (SCCM) host.

Remove from Device Collection Removes a device from a Microsoft System 
Center Configuration Manager (SCCM) device 
collection.

Remove from User Collection Removes a user from a Microsoft System 
Center Configuration Manager (SCCM) user 
collection.

SSH activities

These SSH activities were rewritten as scoped activities and are available in the SSH activity 
pack. The SSH activities not converted to scoped activities were moved to the Orchestration - 
Deprecated category, but are still available for all workflows.

Activity Description

File Copy Copies a file on a Linux or 
Unix computer, via SSH.

File Read Reads a file on a Linux or 
Unix computer, via SSH.

File Write Writes a file on a Linux  or 
UNIX  computer.

File Replace String Finds and replaces a 
string in a file on a Linux  or 
UNIX  computer.

Files Compare Compares two files on a 
Linux or Unix computer, 
via SSH.
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Activity Description

Reset Linux User Password Resets the password for 
a given user on a Linux 
computer.

Secure Copy Copies a file from one 
host to another, without 
storing the copied file on 
the MID Server.

SFTP activities

All these activities are scoped and part of the SFTP File Transfer activity pack. They do not have 
legacy versions.

Activity Description

Copy File Copies a file from an SFTP server (source host) to another SFTP server 
(target host).

Create Directory Creates a directory on an SFTP server.

Get File List Returns a list of files from a given directory and its subdirectories on an 
SFTP server (source host).

Remove File or 
Directory

Removes a file or a directory on an SFTP server, including 
subdirectories, when configured.

Rename File or 
Directory

Renames a file or directory to a new name on an SFTP server.

Set File Attributes Sets common file attributes, such as timestamps, size, permissions, 
and UID/GID, for a file or directory on an SFTP server.

Deprecated activities

These activities have been removed from the Workflow Editor and are not available for 
new workflows, but continue to work normally in existing workflows. You can reactivate the 
deprecated activity  or duplicate the functionality of a deprecated activity as a scoped activity by 
recreating it using the activity designer.

Activity Description

Run Probe Launches a MID Server probe on behalf of a document.

SOAP Request Executes a SOAP request on a target server. The SOAP Message 
activity replaces this activity.

Run Command Runs a command (including shell scripts) on a Linux or UNIX computer.

Run SCP Uses Secure Copy Protocol (SCP) to copy a file from one computer to 
another, including the directory in which the file resides. The Secure 
Copy  activity replaces the Run SCP activity.

Run Powershell Executes Windows  PowerShell commands on a MID Server.

Available activity packs

Activity packs are available with your subscription to Orchestration.
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Before you begin
Role required: admin

About this task
The following activity packs are available and active with your Orchestration subscription:

• Orchestration - Active Directory  (com.snc.orchestration.ad)

• Orchestration - Azure Active Directory  (com.snc.orchestration.azure.ad)

• Orchestration - Exchange  (com.snc.orchestration.exchange)

• Orchestration - SFTP  (com.snc.orchestration.sftp)

• Orchestration - Infoblox DDI Activity Pack  (com.snc.orchestration.infoblox)

• F5 Network Management activity pack  (com.snc.orchestration.f5)

• Orchestration - SSH  (com.snc.orchestration.ssh)

• Orchestration - PowerShell  (com.snc.orchestration.powershell)

• Orchestration - System Center Configuration Manager  (com.snc.orchestration.sccm_mgnt)

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. On the All Applications page, select Request Plugin  to open the Activate Plugin  form on Now 
Support.

3. On Now Support, select the link to access the Now Support  Service Portal  Service Catalog.

4. Select your instance.

5. Select Actions > Activate Plugin.
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6. On the Activate Plugin  form, provide the following information.

Activate Plugin form

Field Description

What is your target instance Instance on which to activate the plugin.

Which plugin would you like to activate Name of the plugin to activate.

Note: 
If the system does not list the plugin you 
want or if you are activating the plugin 
on an OEM or on-premise instance, 
select the Plugin I'm looking for is not 
listed  check box and then enter the 
name of the plugin.

Select Maintenance Date and Time The date and time to activate the plugin.

Note: 
Plugins are activated in two batches, 
once in the morning and once in the 
evening, on every business day in the 
US Pacific time zone. If the plugin must 
be activated at a specific time, enter the 
request in the Reason/Comments  field.

Example 

For example, see the following form to activate the CSM Workspace plugin on an instance 
named My Instance.

Activate Plugin form
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7. Select Submit.
For additional details about requesting a plugin, see Requesting a Plugin from the Service 
Catalog [KB0751715] article in the Now Support  Knowledge Base.

Deprecated Orchestration activities

These Orchestration activities have been deprecated.

Run Probe

The Run Probe activity launches a MID Server probe on behalf of a document. All Orchestration 
activities that launch a probe on a target machine are based on the Run Probe activity. Your 
ServiceNow  instance must have access to a MID Server configured to use SSH to run this activity.

Important: 
This activity is deprecated and is unavailable for new workflows. To replace the functionality 
of this probe, use the Probe activity template  to create a custom activity. Workflows from a 
previous release that use the Run Probe activity can continue to do so.

Run Probe input variables

Field Description

Probe Select a MID Server probe from the list. This is the name of the probe as it appears in 
the discovery_probes  table.

Source 
for 
probe

Enter the IP address of the host system against which the probe runs (the probe's 
target).

Sensor 
script

The script to run using the results of the probe. The output from the probe is contained 
in a variable called output. Any error from the probe is contained in a variable called 
error.

SOAP Request

The SOAP Request activity executes a SOAP request on a target server.

Important: 
This activity is deprecated and is replaced by the SOAP Message workflow activity  activity. 
Workflows from a previous release that use the SOAP Request activity can continue to do 
so. However, this activity is not available for new workflows.

SOAP Request input variables

Field Description

SOAP URL The SOAP endpoint.

Username User name for basic authentication credentials.

Password Password for basic authentication credentials.

Envelope 
Script

Script for setting up parameters for the web service.

Sensor Script The script to execute after the request has been made and a response has 
been received.
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Reactivate a deprecated activity

Orchestration activities that were converted to activity packs are deprecated for upgraded and 
new instances but can be reactivated for use in new workflows.

Before you begin
Role required: workflow_admin, admin

Note: 
Reactivation of deprecated activities for use in new workflows is discouraged. Legacy 
activities cannot use the unique features of the scoped applications, such as reuse of data 
from the databus  and input variable testing.

Procedure

1. Navigate to All  > Workflow  > Administration  > Activity Definitions.

2. In the list of activities, clear the condition Category !=deprecated  from the filter.

3. Open the definition record for the activity you want to reactivate.

4. Select the What to Display  tab.

5. In the Category  field, replace the value deprecated  with another category.
This can be an arbitrary string.

6. Click Update.
The system creates a new category using the value provided and reactivates the activity, which 
becomes available in the Core  tab of the Workflow Editor.

SOAP Message workflow  activity

The SOAP Message  activity uses SOAP messages defined in the System Web Services plugin 
and can call the messages using a MID Server.

Your instance must have access to a MID Server configured to use SOAP.

Input variables

SOAP Message activity input variables

Field Parameter Description

SOAP 
Message

soap_message The SOAP Message defined under the System 
Web Services plugin's Outbound SOAP Message 
[sys_soap_message] table. (System Web Services  > 
Outbound  > SOAP Message)

SOAP 
Message 
Function

soap_message_function The function to call that is defined in the SOAP Message. 
Functions are listed in the SOAP Message Functions 
related list in each SOAP Message record.

SOAP 
Endpoint

soap_endpoint Endpoint to use instead of the SOAP endpoint  value 
in the SOAP Message Function record. Leave this field 
blank to use the defined endpoint in the SOAP Message 
Function record.
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SOAP Message activity input variables  (continued)

Field Parameter Description

Variables variables Variables to substitute into the SOAP Envelope  defined 
in the SOAP Message Function record. Use this format for 
the string:

name1=value1, name2=value2, . . .

If either the name or value contains a comma or equal 
sign, escape these characters with a backslash.

Use MID 
Server

use_midserver Check box for using a MID Server to send the SOAP 
message. A MID Server might be necessary to reach an 
endpoint within a firewall or a sub-network that is not 
visible from the instance. If this check box is selected 
(true), but no MID Server is defined in the MID Server 
field, workflow automatically attempts to find a MID Server.

MID 
Server

midserver Name of the MID Server to use. This field appears 
when you select the Use MID Server  check box. The 
workflow ignores this parameter if the use_midserver 
parameter is disabled.

Note: 
You can only select a specific MID Server in the 
legacy SOAP message activity and REST messages. 
These legacy activities do not use the MID Server 
selection  available starting with the Istanbul release.

Sensor 
Script

sensor_script The script to execute after the request has been made 
and a response has been received. You can access the 
full XML response body from the activity.output 
object.

Probes used by Orchestration

Certain probes, controlled by MID Servers, perform Orchestration tasks on remote computers, 
such as restarting a server or creating virtual machines from templates.

How Orchestration probes work

When a Workflow executes an Orchestration activity, that activity launches a probe, which writes 
an output  record to the ECC Queue. The MID Server selected for the activity checks the ECC 
Queue for assignments, and then executes the appropriate probe to do the work on the target 
machine. The information about the activity (machine restarted, files copied, etc.) that is returned 
from the target machine by the probe is written to the ECC Queue as an input  record. This 
information is then sent from the ECC Queue to a sensor that is built into the Workflow activity. 
The Workflow is updated, and the next activity is executed.

Note: 
The probe parameters are set by the activities that launch the probe.
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How Orchestration uses probes

Probe List

The base system includes the following Orchestration probes (Orchestration  > Definition  > 
Probes).

Probe List

Probe Name ECC Queue Topic
ECC Queue 
Name

Description

Command Command A probe that runs a local command on 
the MID server.

DNS Name 
Resolver

DNSNameResolver A probe that resolves a fully qualified 
domain name (FQDN) into an IP 
address. The probe executes MID 
Server queries in parallel. It utilizes DNS 
lookup by the MID Server host OS to 
make use of the OS maintained DNS 
cache. It also leverages the hosts file 
on the OS.

SCPCommand SCPCommand A probe that copies files securely from 
one machine to another. The copy 
function is performed using the MID 
Server as a tunnel.

Shazzam Shazzam A probe that identifies active devices.

SNMPProbe SNMP SNMP 
Query

This is a generic SNMP probe.

SOAPProbe SOAPProbe A probe that sends a SOAP request to 
target machine.

SSHCommand SSHCommand A probe that executes shell scripts from 
a command line after logging in to a 
target machine via SSH.

SSHCommandLong SSHCommandLong A probe that executes long running 
shell scripts from a command line after 
logging in to a target machine via SSH.

VMWare VMWareProbe A generic VMware probe that executes 
the MID Server script include in the 
ECC queue name  that is set by a 
VMware Orchestration activity. This 
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Probe List  (continued)

Probe Name ECC Queue Topic
ECC Queue 
Name

Description

probe can run any MID Server script 
include.

Windows  - 
PowerShell

PowerShell Windows  - 
PowerShell

A probe that runs a Windows 
PowerShell script on the MID Server. 
The PowerShell script is provided as 
the value of a parameter with name 
ending in .ps1. Two variables are 
available to the script:

• $computer: The computer pointed 
to as the source  for this probe

• $cred: A PowerShell credential, 
using a user name and password 
from the Credentials table, that logs 
into $computer  successfully.

PowerShell activities

PowerShell is built on the Windows .NET Framework and is designed to control and automate the 
administration of Windows  machines and applications.

PowerShell must be installed on any MID Server that uses these activities. MID Servers using 
PowerShell must be installed on a supported Windows  operating system.  ServiceNow  supports 
PowerShell 3.0 to 5.1.

The ServiceNow  Orchestration  plugin adds these basic PowerShell activities to workflows. For 
instructions on using activities from the PowerShell activity pack, see PowerShell activity pack

Legacy Run PowerShell activity

The Run PowerShell activity executes Windows  PowerShell commands on a MID Server.

Important: 
This activity is deprecated and is unavailable for new workflows. To replace the functionality 
of this activity, use the Powershell activity template  to create a custom, scoped activity. 
Workflows from a previous release that use the Run PowerShell activity can continue to do 
so.

Result Values

The workflow designer can assign a result value using activity.result from within a script field of 
the activity. By default, the success or failure of the PowerShell commands used determines the 
result value of the Run PowerShell activity. Possible result values are:

• Success

• Failure

Scratchpad Entries

Information written to stdout  by the executing script is captured and returned to the activity in 
the  activity.output  variable. This information can be parsed, processed, or saved (to a 
scratchpad variable, for example) for future processing in the activity’s sensor script.
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An example would be to run the get-date command to get the MID Server’s current time. This 
sensor script saves the full output received, but we can process it to return and save only the 
time.

PowerShell activity

Note: 
This is an over-simplified example. In most cases, the script operates against some remote 
Windows  computer. However, the principal is the same – whatever is written to stdout  is 
returned in activity.output  and available to process.

Input Variables

Input Variables

Field Description

Hostname IP address of the target Windows  machine. This value is mapped to the 
$computer  variable for use in commands (see the example in the Command 
field). A PowerShell credential variable called $cred  that is based on information 
in the ServiceNow  Credentials table will authenticate on the computer pointed to 
by Hostname.

Command Enter the PowerShell command to run. For example, to execute a simple WMI 
query against a remote machine pointed to by the hostname  variable, the 
command is:

get-wmiobject <class> -computer $computer -credential 
 $cred

If no credentials authenticate on the computer, the command runs in the context 
of the MID Server user.

You cannot run both a command and a script file. Specifying a command hides the 
Script file  variable.

Sensor 
script

The script to run using the results of the probe. The output from the probe is 
contained in a variable called output. Any error from the probe is contained in a 
variable called error.

Script file The Enable script file synchronization for Windows  enhanced security. You cannot 
run both a script file and a command. Selecting a script file hides the Command 
variable.

PowerShell 
script 
variables

Additional parameters, in JSON format, used by the specified script file.
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States

The activity state tells the workflow engine what to do with the activity.

States

State Description

Executing The workflow engine knows to start the onExecute function of the activity.

Finished The activity finished running. See the result value for the outcome of the activity.

Cancelled This activity, or the workflow that contains this activty, was cancelled.

Example: Adding Workflow Variables for Command Line: Syntax and Examples

Add workflow variables for the command line using the normal workflow variable syntax. In the 
example above, if the <class> was in a workflow input variable called myclass, the command 
would look like:

get-wmiobject $ {workflow. inputs. myclass } -computer $computer 
 –credential $cred
Similarly  if the variable  is a scratchpad variable named 
 myclass , the command would look like :
get -wmiobject $ {workflow. scratchpad. myclass } -computer 
 $computer –credential $cred

HResult codes

When a PowerShell script encounters an error, the Windows machine may return an HResult 
code as part of the error message.

PowerShell activities can read and interpret this code. Not all PowerShell errors include an 
HResult code. In the event of a failed PowerShell script, you can use the HResult code to move 
the workflow through a specific condition.

For example, when resetting an Active Directory password to a password that does not meet 
policy requirements, such as minimum length or complexity, the PowerShell script returns the 
HResult code -2146022651. To use this code, create an activity condition with the Condition 
value of activity.hresult = -2146022651. If the PowerShell script returns this code 
when the activity runs, the workflow transitions through this new condition.

SSH activities

SSH activities allow workflows to perform operations on Linux  and Unix computers.

Your ServiceNow  instance must have access to a MID Server configured to use SSH to run these 
Orchestration activities.

Run Command activity

The Run Command  activity runs a command (including shell scripts) on a Linux or UNIX 
computer.

Important: 
The Run Command activity is deprecated in this release. If you have a workflow created in 
a previous version that uses this activity, your workflow will continue to work normally after 
upgrading to Helsinki. However, to use this functionality in a new workflow, you must create 
a custom activity using the SSH activity template  in the ServiceNow®  activity designer.
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Input variables

Run command input variables

Field Description

Long 
running

Select this check box to disable the SSH connection timeout if you think the 
command will take longer to run than the default 60 seconds. Orchestration 
periodically checks the running process to determine its status until it is finished.

Hostname Hostname or IP address of destination server for SSH activity.

Directory Name of the working directory.

Command The command to run from this activity.

Sudo Select this check box to use sudo  to run the command on the host machine.

Sensor 
script

The script to run using the results of the probe. The output from the probe is 
contained in a variable called output. Any error from the probe is contained in a 
variable called error.

Run SCP activity

The Run SCP activity uses Secure Copy Protocol (SCP) to copy a file from one computer to 
another, including the directory in which the file resides.

Note: 
This activity is deprecated in the Geneva release and is not available for use in new 
workflows. If you have a workflow created in a previous version that uses this activity, your 
workflow will continue to work normally after upgrading. The custom Secure Copy activity 
replaces the Run SCP activity in the Geneva release.

Input variables

Run SCP input variables

Field Description

From 
Host

Hostname or IP address of the source computer.

From 
File

Absolute path to the file to copy. This value can be a directory.

To Host Hostname or IP address of the target computer.

To File Path to the target file. This path can be absolute or relative to the logged in user's 
home directory. The specified directory must already exist on the target computer.

Copy 
Directory

Check box to copy a directory defined in the From File  variable and all files 
contained in that directory.

Orchestration applications

Orchestration provides several applications with your subscription.

Orchestration ROI

The Orchestration ROI application allows you to estimate and compute cost savings for tasks in 
your system that could be automated with Orchestration.
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After you automate the tasks, you can track cost savings by associating Orchestration workflows 
with corresponding task areas. Configuration in the application allows you to select the 
hourly rate for performing the task manually, the rules the system uses to select tasks for 
evaluation, and the time period of the evaluation. Orchestration ROI estimates your savings by 
multiplying the cost of performing repetitive tasks manually by the estimated number of times the 
system performs those tasks automatically during a specific date/time range. The system also 
calculates the actual savings of your automations. Orchestration ROI is included with the base 
Orchestration subscription.

Orchestration ROI reports offer a number of views of the comparative data and allow you to 
access the associated records directly from the reports. The standard reports  included with 
the Orchestration - ROI plugin provide summaries, estimated costs, and calculated costs for 
automated processes. The ROI premium dashboard  uses Performance Analytics to provide 
detailed reports on calculated savings over time. Performance Analytics requires a different 
plugin and subscription.

Note: 
When Orchestration ROI is activated as a dependent plugin of Orchestration, demo data 
is not installed. If you want to use demo data as a template for your own ROI evaluation, 
submit a request  to ServiceNow®  technical support for an Orchestration ROI plugin 
upgrade with demo data selected.

To set up Orchestration ROI, complete the configuration tasks in the order shown here.

Create Orchestration ROI labor rate cards

Before calculating your Orchestration ROI, you must create labor rate cards for the manual work 
that would be required to complete the tasks correlated to the ROI calculations.

Before you begin
Role required: orchestration_manager

About this task
The hourly rates defined in the rate cards are used to determine the savings from your 
orchestrated tasks.

Procedure

1. Navigate to All  > Orchestration  > ROI  > Labor Rate Cards.

2. Complete the fields in the form using the descriptions in Manage a labor rate card .

3. Click Submit.

4. Create additional rate cards as needed.

Create an Orchestration ROI automation entry record

The ROI automation entry record couples the cost of performing a task with the specific workflow 
that automates the task, for the purpose of calculating the resulting savings.

Before you begin
Role required: orchestration_manager
Before starting this procedure, verify that the appropriate labor rate cards  were created.

About this task
Use this record to apply a manual hourly rate to a task that is performed automatically by your 
instance. To determine the savings realized from orchestrating a task, the system can evaluate 
whether those savings were estimated or calculated.
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• Estimated savings: Uses the labor rate, the time estimates for completion of the task, and the 
number of automations that have been run to determine savings.

• Calculated savings: Uses the labor rate, the time calculated for completion of the task, based 
on the configured evaluation period, and the number of automations that have been run to 
determine savings.

Procedure

1. Navigate to All  > Orchestration  > ROI  > Automation Entry Form.

2. Fill in the fields on the form, as appropriate.

Automation Entry Form

Field Description

Category Category of the selected workflow automation. The following categories 
are provided in the base Orchestration - ROI system:

◦ Access & Identity Management

◦ Datacenter Automation

◦ IT Service Management

◦ Other

Note: 
To create a category, open the dictionary record for the 
Automation Entry Form [automation_entry_form] table and add an 
option to the choice list.

Item Unique name for the specific task within the category. This value 
represents the work to which the labor rate card applies, such as 
Password Reset.

Resource Labor rate card to apply to this automation entry. You must have IT Cost 
Management active on the instance for this field to appear.

Associated 
Workflows

Workflow automations created to automate this manual task. The 
system uses this field to identify the number of automations that have 
been run.

Estimated Duration 
(min) per Task

Estimated time to perform this task manually.

Estimated Volume 
per Month

Estimated number of times needed to perform this task manually per 
month.

Read-only fields

Start time Start time for the evaluation period. Configure this value in the Time 
Range for Calculated Averages module.

End time End time of the evaluation period. Configure this value in the Time 
Range for Calculated Averages module.

Calculated average 
duration per task 
(min)

Actual time required to perform this task manually.
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Field Description

Calculated average 
volume per month

Actual average number of times this task is performed manually per 
month.

3. Select one of these submission options:

◦ Submit: Saves the record to the table without running any calculations.

◦ Submit and process now: Saves the record and calculates the savings based on the hourly 
rate and the number of workflow contexts for this automation entry.

Create an Orchestration ROI correlated task rule

The correlated task rule applies configurable conditions to fields in a selected table that tell the 
instance which manual tasks correspond to an automation entry record.

Before you begin
Role required: orchestration_manager
Before starting this procedure, make sure you have created labor rate cards  and the appropriate 
automation entry records  for the automated tasks you want to evaluate.

About this task
Create conditions that the system can use to correlate manual tasks to the automation entry. For 
example, a rule on the Incident [incident] table uses these conditions to correlate the employee 
on-boarding task to values configured in the Employee OnBoarding automation entry record:

• [Subcategory] [is] [Employee OnBoarding]

• [Sort description] [contains] [new employee]

When a new employee opens an incident to request services or assets which are typically 
handled manually, Orchestration applies the usual labor rate for the manual work to the potential 
automated solution, and then computes the actual savings.

Procedure

1. Navigate to All  > Orchestration  > ROI Task Correlation  > Correlated Tasks Rules.

2. Click New.

3. Fill in the fields on the form, as appropriate.

Automation entry form

Field Description

Automation 
entry

Automation entry record that correlates to the manual task defined by these 
conditions. The entry record names the workflow used to automate the task and 
defines the labor rate used to calculate the cost of the task.

Table Table to filter, using these conditions. The rule selects records from this table 
that match the conditions. Information from these records is used to calculate 
the actual time to perform a manual task and the actual volume for that manual 
task.

Condition Condition builder to use to filter records for this table. Use these conditions to 
identify all manual tasks correlated to this automation entry.

Read-only fields
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Field Description

Processed 
on

Date and time that the system performs the matching records lookup. 
The system automatically searches for new manual tasks matching these 
conditions.

4. Select one of these submission options:

◦ Submit: Saves the record to the table without running any calculations.

◦ Submit and process now: Saves the record, looks up all matching tasks, and saves 
matching record information to the Correlated Tasks [manual_mapping_records] table.

5. To view a rule, select the link in the Table  column of the Correlated Tasks Rules  related list for 
the automation entry you want to see.

6. To view the list of tasks that match all correlated rules in the system, navigate to Orchestration 
> ROI Task Correlation  > Correlated Tasks.

7. To view the list of tasks that match this rule in the system, click Correlated Tasks  under 
Related Links  in this form

Configure the time range for Orchestration ROI calculations

Select a date range to calculate the average number of tasks and the duration per month for the 
correlated tasks.

Before you begin
Role required: orchestration_manager

About this task
By default, the system creates a range ending at the current date and time and extending back 
over the previous month. You can change this range at any time and recalculate the ROI instantly.

Procedure

1. Navigate to All  > Orchestration  > ROI Task Correlation  > Time Range for Calculated 
Averages.

2. Enter a new start or end date and time or click the icon to select a date using the calendar.

3. Click Calculate  to recalculate the ROI based on the new time range and to save your settings.

Installed with Orchestration ROI

Several types of components are installed with the Orchestration - ROI plugin 
(com.snc.runbook_automation.roi).

Tables installed with Orchestration ROI

Tables are added with activation of Orchestration ROI.

Table Description

Expense and Savings

[run_rate_predicted_savings]

Contains the data for the reports in Orchestration  > ROI 
Reports  > Predicted Savings.

Savings Report

[savings_report]

Contains the number of automations that have been run before 
the date specified in the Processed On  column, based on:
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Table Description

• Each automation entry’s associated workflows

• Estimated savings based on the estimated duration per task.

• Calculated savings based on calculated duration.

Detailed Savings Report

[detailed_savings_report]

Contains a detailed list for the Savings Report [savings_report] 
table. This list contains each automation’s run date and 
savings for that automation.

Automation Entries

[automation_entry_form]

Contains automation entries that couple labor resources to 
specific manual tasks. You can specify the estimated duration 
to perform a task manually and the estimated number of 
times that a task is performed per month. If this automation 
entry already has workflow automations implemented, you 
can specify the associated workflows. The system calculates 
the savings, based on the labor rate card and the number of 
workflow automations that have been performed.

Roadmap Planning

[roadmap_planning]

Contains roadmap planning for each automation entry to be 
implemented. You can provide estimated hours to implement 
a workflow automation, the automation percentage anticipated 
by the end of the year, and the starting month to implement the 
workflow.

Correlated Tasks

[manual_mapping_records]

Contains all matching manual tasks for each automation entry. 
Each tasks’s information is stored in this table for the system 
to use to calculate the actual duration and volume for each 
manual task.

Correlated Tasks Rules

[manual_mapping_conditions]

Contains the correlated task rules the system uses to look up 
manual tasks corresponding to each automation entry.

Plugins installed with Orchestration ROI

Plugins are installed with activation of Orchestration ROI, if they are not already active.

Plugin Description

Cost Management

[com.snc.cost_management]

Provides the labor rate cards Orchestration ROI uses to 
determine the savings for each automated task. See Cost 
Management  for more information.

Roles installed with Orchestration ROI

Roles are added with activation of Orchestration ROI.

Role title [name] Description Contains Roles

Orchestration manager

[orchestration_manager]

Manages all activities in the Orchestration ROI 
module.

• pa_admin

• report_admin
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UI actions installed with Orchestration ROI

UI actions are added with activation of Orchestration ROI.

UI actions for Orchestration - ROI

UI action Table Description

Savings 
Report

Automation Entry Form

[automation_entry_form]

Displays the savings report specific to this 
automation entry, if the associated workflows are 
not empty.

Estimated 
and 
Projected 
Savings

Automation Entry Form

[automation_entry_form]

Displays the estimated savings, based on the 
estimated duration of the task, and calculated 
savings, based on the calculated duration of the 
task.

Show 
Workflow 
Context

Detailed Savings Report

[detailed_savings_report]

Shows the related workflow context.

Submit 
AND 
process 
now

Automation Entry Form

[automation_entry_form]

Processes this new entry

Correlated 
Tasks

Correlated Tasks Rules

[manual_mapping_conditions]

Displays all matching tasks from the Correlated 
Tasks [manual_mapping_records] table.

Detailed 
Savings 
Report

Automation Entry Form

[automation_entry_form]

Displays the list of automations that have been 
run, based on associated workflows.

Task Correlated Tasks

[manual_mapping_records]

Displays the task record.

Submit 
AND 
process 
now

Correlated Tasks Rules

[manual_mapping_conditions]

Processes a correlated task rule. This action 
performs matching on the specified table and the 
filter conditions.

Script includes installed with Orchestration ROI

Script includes are added with activation of Orchestration ROI.

Script include Description

OrchestrationROIAjax Script that calculates the actual duration and volume of a task.

OrchestrationROI Script that calculates the number of workflow contexts, looks up all 
matching tasks, calculates savings, and other functions used in the UI 
actions.

ROIDemoDataUtil Script that updates demo data timestamps.

Client scripts installed with Orchestration ROI

Client scripts are added with activation of Orchestration ROI.
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Client 
script

Table Description

Display 
info for 
processing 
rules

Correlated Tasks Rules

[manual_mapping_conditions]

Displays annotation on the Correlated Task 
Rule form advising that new task rules are not 
evaluated until the time specified in the ROI 
schedule.

Business rules installed with Orchestration ROI

Business rules are added with activation of Orchestration ROI.

Business rule Table Description

Delete 
corresponding 
records

Automation Entry Form

[automation_entry_form]

When a record is deleted from the Automation Entry 
Form [automation_entry_form] table, this business 
rule deletes all records in other ROI tables that 
reference this entry.

Insert into 
Run Rate & 
Savings

Automation Entry Form

[automation_entry_form]

When a new automation entry is provided, this 
business rule calculates the estimated savings, 
based on the estimated duration of a task and its 
associated labor rate card.

Insert into 
Savings 
Reports

Automation Entry Form

[automation_entry_form]

When a new automation entry is provided, 
this business rule inserts a new record into 
the Savings Report [savings_report] table with 
theautomations_run  field set to 0.

Orchestration ROI reports

Orchestration ROI provides a collection of standard and premium reports to help you calculate 
savings from automating services in your organization.

The ROI standard reports are included with Orchestration ROI. The premium reports provide 
enhanced views generated with Performance Analytics and require the Orchestration - ROI 
Premium  plugin.

Orchestration ROI standard reports

The dashboard of standard ROI reports provides summaries, estimated costs, and calculated 
costs for automated processes. To access the ROI standard dashboard, navigate to 
Orchestration  > ROI Reports  > Dashboard.

Summary tab

The Summary tab contains four reports on automation categories.
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ROI summary report sample

Standard ROI summaries by category

Report Description

Manual Tasks by 
Category Over Time

Trend of manual tasks by category over time. For example, if you use 
automations to perform a portion of the necessary tasks, the report 
shows the number of tasks still executed manually, decreasing over 
time.

• Type: Line chart

• Table: Detailed Savings Report [detailed_savings_report]

Automations by 
Category Over Time

Trend of automated tasks by category over time. For example, this 
chart can show the increase in the number of automated tasks as a 
workflow automation rolls out slowly over time.

• Type: Line chart

• Table: Detailed Savings Report [detailed_savings_report]

Automation Savings 
by Category Over 

Amount of savings from automated tasks over time, based on the 
estimated duration of the task, the number of automations performed, 
and the cost from the labor rate card.
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Standard ROI summaries by category  (continued)

Report Description

Time (Uses Estimated 
Duration) • Type: Line chart

• Table: Detailed Savings Report [detailed_savings_report]

Automation Savings 
by Category Over 
Time (Uses Calculated 
Duration)

Amount of savings from automated tasks over time, based on the 
calculated duration of the task, the number of automations performed, 
and the cost from the labor rate card.

• Type: Line chart

• Table: Detailed Savings Report [detailed_savings_report]

Estimated Costs tab

The Estimated Costs tab contains eight reports on estimated time and expense for automations.

ROI estimated time and expense report samples
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Standard ROI time and expense estimates

Report Description

Estimated Time Spent by 
Task Category

Total estimated time spent, in minutes, on all tasks by task 
category.

• Type: Pie chart

• Table: Automation Entry Form [automation_entry_form]

Estimated Volume of 
Manual Tasks per Month by 
Category

Total estimated volume of all tasks per month by task category.

• Type: Pie chart

• Table: Automation Entry Form [automation_entry_form]

Predicted Hours Spent 
Monthly by Category (Uses 
Estimated Duration & 
Volume)

Total predicted hours spent monthly on all manual tasks by 
category, using the estimated duration of each task and the 
estimated volume of each task per month.

• Type: Bar chart

• Table: Expense and Savings [run_rate_predicted_savings]

Predicted Monthly 
Expense by Category 
(Uses Estimated Duration & 
Volume)

Total predicted monthly expense for all manual tasks by category, 
using the estimated duration of each task, estimated volume of 
each task per month, and the cost from the labor rate card.

Note: 
This report uses negative numbers to express an expense.

• Type: Bar chart

• Table: Expense and Savings [run_rate_predicted_savings]

Predicted Hours Spent 
Quarterly by Category 
(Uses Estimated Duration & 
Volume)

Total predicted hours spent quarterly on all manual tasks by 
category, using the estimated duration of each task and the 
estimated volume of each task per month.

• Type: Bar chart

• Table: Expense and Savings [run_rate_predicted_savings]

Predicted Quarterly 
Expense by Category 
(Uses Estimated Duration & 
Volume)

Total predicted quarterly expense for all manual tasks by 
category, using the estimated duration of each task, estimated 
volume of each task per month, and the cost from the labor rate 
card.

Note: 
This report uses negative numbers to express an expense.

• Type: Bar chart

• Table: Expense and Savings [run_rate_predicted_savings]

Predicted Hours Spent 
Annually by Category 
(Uses Estimated Duration & 
Volume)

Total predicted hours spent annually on all manual tasks by 
category, using the estimated duration of each task and the 
estimated volume of each task per month.
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Standard ROI time and expense estimates  (continued)

Report Description

• Type: Bar chart

• Table: Expense and Savings [run_rate_predicted_savings]

Predicted Annual Expense 
by Category (Uses 
Estimated Duration & 
Volume)

Total predicted annual expense for all manual tasks by category, 
using the estimated duration of each task, estimated volume of 
each task per month, and the cost from the labor rate card.

Note: 
This report uses negative numbers to express an expense.

• Type: Bar chart

• Table: Expense and Savings [run_rate_predicted_savings]

Costs from Correlated Tasks tab

The Costs from Correlated Tasks tab contains eight reports on time and expense for automations 
based on actual calculations.

ROI calculated time and expense report samples
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Standard ROI calculated time and expense of automations

Report Description

Time Spent by Task 
Category

Total actual time spent, in minutes, on all tasks by task category.

• Type: Pie chart

• Table: Automation Entry Form [automation_entry_form]

Volume of Manual Tasks 
per Month by Category

Total actual volume of all tasks per month by task category.

• Type: Pie chart

• Table: Automation Entry Form [automation_entry_form]

Projected Hours Spent 
Monthly by Category (Uses 
Calculated Duration & 
Volume)

Total projected hours spent monthly on all manual tasks by 
category, using the calculated duration of each task and the 
calculated volume of each task per month.

• Type: Bar chart

• Table: Expense and Savings [run_rate_predicted_savings]

Projected Monthly 
Expense by Category (Uses 
Calculated Duration & 
Volume)

Total projected monthly expense for all manual tasks by category 
using the calculated duration of each task, the calculated volume 
of each task per month, and the cost from the labor rate card.

Note: 
This report uses negative numbers to express an expense.

• Type: Bar chart

• Table: Expense and Savings [run_rate_predicted_savings]

Projected Hours Spent 
Quarterly by Category 
(Uses Calculated Duration 
& Volume)

Total projected hours spent quarterly on all manual tasks by 
category, using the calculated duration of each task and the 
calculated volume of each task per month.

• Type: Bar chart

• Table: Expense and Savings [run_rate_predicted_savings]

Projected Quarterly 
Expense by Category (Uses 
Calculated Duration & 
Volume)

Total projected quarterly expense for all manual tasks by category 
using the calculated duration of each task, the calculated volume 
of each task per month, and the cost from the labor rate card.

Note: 
This report uses negative numbers to express an expense.

• Type: Bar chart

• Table: Expense and Savings [run_rate_predicted_savings]

Projected Hours Spent 
Annually by Category (Uses 
Calculated Duration & 
Volume)

Total projected hours spent annually on all manual tasks by 
category, using the calculated duration of each task and the 
calculated volume of each task per month.

• Type: Bar chart

• Table: Expense and Savings [run_rate_predicted_savings]
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Standard ROI calculated time and expense of automations  (continued)

Report Description

Projected Annual Expense 
by Category (Uses 
Calculated Duration & 
Volume)

Total projected annual expense for all manual tasks by category 
using the calculated duration of each task, the calculated volume 
of each task per month, and the cost from the labor rate card.

Note: 
This report uses negative numbers to express an expense.

• Type: Bar chart

• Table: Expense and Savings [run_rate_predicted_savings]

Schedule Orchestration ROI calculations for standard reports

The scheduled job that calculates Orchestration ROI standard reports is active by default and 
controlled by system properties.

Before you begin
Role required: orchestration_manager, admin

About this task
The system provides a default scheduled job called Processing ROI Schedule that allows 
you to configure when Orchestration calculates the ROI for standard reports. This schedule 
allows scripting for advanced conditions. To modify the schedule or write a script to run, open 
Processing ROI Schedule from System Scheduler  > Scheduled Jobs  > Scheduled Jobs  and 
click Configure Job Definition. To execute the schedule directly from the job definition, click 
Execute Now

To control the running of the schedule job with the Orchestration properties.

Procedure

1. Navigate to Orchestration ROI  > Properties.

2. Configure the following properties:

ROI schedule properties

Property Description

roi.processing.active Activate scheduled job for ROI processing. 
This property activates the Processing ROI 
Schedule scheduled job.

◦ Type: true | false

◦ Default: true

roi.processing.interval Scheduled ROI processing interval (hours). 
This property sets the repeat interval for the 
scheduled job that processes savings reports 
and correlated tasks.

◦ Type: integer

◦ Default: 24

3. Click Save  to save your changes.
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Orchestration ROI premium reports

The premium dashboard provides detailed reports on calculated savings over time.

The ROI premium reports require the Orchestration - ROI Premium plugin and are built using 
Performance Analytics . The Orchestration - ROI Premium plugin is dependent on the 
Performance Analytics - Premium  plugin which requires a separate subscription.

Important: 
You must activate the Performance Analytics scheduled collection job  before Orchestration 
ROI premium can display data.

To access the ROI premium dashboard, navigate to Orchestration  > ROI Reports  > Premium 
Dashboard.

ROI By Category tab

The ROI By Category tab contains three reports showing the calculated savings over time by 
category.

Calculated savings monthly by category

Premium reports for calculated savings over time by category

Report Description

ROI - Monthly By 
Category

Shows the calculated savings each month by category. The chart displays 
the total calculated savings against the calculated savings for each 
category.

• Type: Column chart

• Table: Detailed Savings Report [detailed_savings_report]

ROI - By 
Category

Shows the trend of calculated savings by category.

• Type: Spline chart

• Table: Detailed Savings Report [detailed_savings_report]

ROI - Running 
Sum 12 month 
period

Shows the running sum of calculated savings for all categories in the last 12 
months.

• Type: Area chart

• Table: Detailed Savings Report [detailed_savings_report]
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ROI By Automation Entry

The ROI By Automation Entry tab contains two reports showing the calculated savings over time 
by automation entry.

Calculated savings for the current month by automation entry

Calculated savings over time by automation entry

Report Description

ROI By Automation Entry Shows the current month’s calculated savings for each automation 
entry.

• Type: Column

• Table: Detailed Savings Report [detailed_savings_report]

ROI - By Automation 
Entry Top 10 List

Shows the top 10 automation entries that have the most calculated 
savings in the current month.

• Type: Scorecard

• Table: Detailed Savings Report [detailed_savings_report]

Request Orchestration ROI premium reports

To view the Orchestration ROI premium reports, you must request activation of the Orchestration 
- ROI Premium (com.snc.runbook_automation.roi_premium) plugin. The Orchestration - ROI 
Premium plugin is included with an Orchestration subscription, but must be activated by request.

Before you begin
The Orchestration - ROI Premium plugin requires the Performance Analytics - Premium  plugin, 
which must be purchased separately.

Role required: admin

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. On the All Applications page, select Request Plugin  to open the Activate Plugin  form on Now 
Support.
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3. On Now Support, select the link to access the Now Support  Service Portal  Service Catalog.

4. Select your instance.

5. Select Actions > Activate Plugin.

6. On the Activate Plugin  form, provide the following information.

Activate Plugin form

Field Description

What is your target instance Instance on which to activate the plugin.

Which plugin would you like to activate Name of the plugin to activate.

Note: 
If the system does not list the plugin you 
want or if you are activating the plugin 
on an OEM or on-premise instance, 
select the Plugin I'm looking for is not 
listed  check box and then enter the 
name of the plugin.

Select Maintenance Date and Time The date and time to activate the plugin.
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Field Description

Note: 
Plugins are activated in two batches, 
once in the morning and once in the 
evening, on every business day in the 
US Pacific time zone. If the plugin must 
be activated at a specific time, enter the 
request in the Reason/Comments  field.

Example 

For example, see the following form to activate the CSM Workspace plugin on an instance 
named My Instance.

Activate Plugin form

7. Select Submit.
For additional details about requesting a plugin, see Requesting a Plugin from the Service 
Catalog [KB0751715] article in the Now Support  Knowledge Base.

Schedule Orchestration ROI calculations for premium reports

Orchestration ROI premium reports use a Performance Analytics job that must be activated 
before premium reports can be generated.

Before you begin
Role required: orchestration_manager, admin

About this task
The scheduled job required to calculate premium ROI reports is called [PA ROI] 
Historic Data Collection and is installed with the Orchestration - ROI Premium 
[com.snc.runbook_automation.roi_premium] plugin. This job is not active by default.

Procedure

1. Navigate to All  > Performance Analytics  > Data Collector  > Jobs.

2. Search for the [PA ROI] Historic Data Collection job.
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3. Select the Active  check box.

4. The scheduling options appear for the value selected in the Run  field.
For instructions on creating a schedule, see Create or schedule a data collection job .

5. To execute the schedule directly from the job definition, click Execute Now.

6. Click Update.

Client Software Distribution

The Client Software Distribution (CSD) application allows administrators to distribute software 
from the service catalog using third-party management systems.

CSD allows an administrator to create all the records necessary to deploy software from 
service catalog requests, including software models and catalog items. You can use the CSD 
application to automate the deployment and revocation  of software from an SCCM host using 
the custom SCCM activity pack. You can define lease periods for software distributed from the 
Service Catalog and allow lease extensions in some cases, pending approvals. Deployment is 
accomplished using Orchestration activities and workflows.

CSD also integrates with Software Asset Management  to manage license counts for deployed 
software.

CSD process flow using SCCM

Request client software distribution

Client software distribution requires the Orchestration - Client Software Distribution plugin 
(com.snc.orchestration.client_sf_distribution), which is available by request with a subscription to 
Orchestration.

Before you begin
Role required: admin

About this task
The Orchestration - Client Software Distribution plugin activates the Orchestration - System 
Center Configuration Manager  plugin that contains the custom SCCM activities used to deploy 
or revoke software using an SCCM server. For additional plugin dependencies, see Plugins 
installed with client software distribution.

Note: 
The Orchestration - Client Software Distribution plugin runs in its own application scope.
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Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. On the All Applications page, select Request Plugin  to open the Activate Plugin  form on Now 
Support.

3. On Now Support, select the link to access the Now Support  Service Portal  Service Catalog.

4. Select your instance.

5. Select Actions > Activate Plugin.

6. On the Activate Plugin  form, provide the following information.

Activate Plugin form

Field Description

What is your target instance Instance on which to activate the plugin.

Which plugin would you like to activate Name of the plugin to activate.

Note: 
If the system does not list the plugin you 
want or if you are activating the plugin 
on an OEM or on-premise instance, 
select the Plugin I'm looking for is not 
listed  check box and then enter the 
name of the plugin.
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Field Description

Select Maintenance Date and Time The date and time to activate the plugin.

Note: 
Plugins are activated in two batches, 
once in the morning and once in the 
evening, on every business day in the 
US Pacific time zone. If the plugin must 
be activated at a specific time, enter the 
request in the Reason/Comments  field.

Example 

For example, see the following form to activate the CSM Workspace plugin on an instance 
named My Instance.

Activate Plugin form

7. Select Submit.
For additional details about requesting a plugin, see Requesting a Plugin from the Service 
Catalog [KB0751715] article in the Now Support  Knowledge Base.

Installed with client software distribution

Several types of components are installed with client software distribution (CSD).

Tables installed with client software distribution

These tables are installed with the Orchestration - Client Software Distribution plugin 
(com.snc.orchestration.client_sf_distribution).
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Client software distribution tables

Table Description

Client Software Distribution Catalog Item 
[sn_client_sf_dist_cat_item]

Contains all catalog items created for client software 
distribution. This table extends the Catalog Item 
[sc_cat_item] table.

Client Software Distribution Software 
Request [sn_client_sf_dist_req_software]

Contains all requested software, and their statuses.

Client Software Distribution Application 
[sn_client_sf_dist_application]

Contains all discovered CSD applications.

Client Software Distribution Provider 
[sn_client_sf_dist_provider]

Contains all software distribution providers.

Client Software Distribution Extension 
Key [sn_client_sf_dist_extension_key]

Contains the predefined CSD extension keys.

Client Software Distribution Extension 
Point [sn_client_sf_dist_extension_point]

Contains the customization script for the extension 
keys.

Client Software Distribution 
Software Configuration 
[sn_client_sf_dist_software_config]

Base table for all software provider configurations.

SCCM Server Instance 
[sn_client_sf_dist_cmdb_ci_sccm_server]

Contains all SCCM server instances. This table 
extends the Configuration Item [cmdb_ci] table.

SCCM Application 
[sn_client_sf_dist_sccm_application]

Contains all discovered SCCM applications. This 
table extends the Client Software Distribution 
Application [sn_client_sf_dist_application] table.

SCCM Application Catalog Item 
[sn_client_sf_dist_sccm_app_cat_item]

Contains all catalog items created for 
SCCM applications. This table extends the 
Client Software Distribution Catalog Item 
[sn_client_sf_dist_cat_item] table.

SCCM Collection 
[sn_client_sf_dist_sccm_collection]

Contains all discovered SCCM collections. Contains 
all discovered SCCM collections.

SCCM Deployment 
[sn_client_sf_dist_sccm_deployment]

Contains all discovered SCCM deployments. 
Contains all discovered SCCM deployments.

SCCM Configuration 
[sn_client_sf_dist_sccm_sf_config]

Contains the SCCM application, install and uninstall 
collections, and Discovery  model. This table 
extends the Client Software Distribution Software 
Configuration [sn_client_sf_dist_software_config]

Plugins installed with client software distribution

These plugins are installed with the Orchestration - Client Software Distribution plugin, if they are 
not already active.

For instructions on requesting activation of Client Software Distribution (CSD) see Request client 
software distribution.
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Plugins for Orchestration - Client Software Distribution

Plugin Description

Orchestration - System Center Configuration 
Manager

[com.snc.orchestration.sccm_mgnt]

Installs the custom SCCM Orchestration 
activities that do work on the SCCM target 
host.

Orchestration - Asset Lease Management 
[com.snc.orchestration.asset_lease_management]

Installs the lease functionality  for software 
distributed through the Service Catalog. 
This includes starting, stopping, and 
extending leases.

Service Catalog Scoped API

[com.glideapp.servicecatalog.scoped.api]

Installs the API to support application 
creation in the Service Catalog.

Software Asset Management

[com.snc.software_asset_management]

Provides the ability to manage software 
assets, including the reconciliation of 
entitlements to licenses for named users, 
workstation, and enterprise software 
agreements.

Roles installed with client software distribution

These roles are installed with the Orchestration - Client Software Distribution plugin.

Roles for Orchestration - Client Software Distribution

Role title [name] Description Contains Roles

Client software distribution 
admin

[sn_client_sf_dist.csd_admin]

Administrator role for managing client 
software distribution application.

• sam

• agent_admin

• report_admin

• catalog_admin

• itil

• workflow_admin

Script includes installed with client software distribution

These script includes are installed with the Orchestration - Client Software Distribution plugin

Script includes for Orchestration - Client Software Distribution

Script include Description

CSDExtensionPoint
Execute the CSD provider’s specific code

CSDUtil Utility functions for the CSD application.
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Script includes for Orchestration - Client Software Distribution  (continued)

Script include Description

RefQualsCSD Reference qualifier filter. This script provides the filter functrions for 
the CSD providers, devices, SCCM application, install collections, 
and uninstall collections.

SCCMCatItemHandler Sets the field values of specific SCCM catalog items. These values 
are the SCCM catalog item table name, catalog item name, SCCM 
provider, and SCCM software configuration.

SoftwareCatItemCreator Creates software catalog items

CSDCatItemHandler Base class for CSD catalog item creation. This script is used by the 
Create Catalog Item UI action to create and application catalog.

CSDDemoDataUtil Populates demo data.

CSDDemoDataUtilAjax Populates demo data.

Properties installed with client software distribution

Properties for client software distribution (CSD) manage the installation status of requested 
software deployments and configure scheduled Discoveries.

To access CSD properties, navigate to Client Software Distribution  > Properties. The following 
properties are available:

Client software distribution properties

Property Name Description

Status 
check 
expiration 
interval 
(days)

sn_client_sf_dist.softwareInstallExpDays Controls how many days the system 
waits before ignoring the software 
installation status. The default 
time limit for installing software is 
30 days before the system stops 
checking the installation status of a 
deployment.

Installation statuses are:

• Not installed: User has not 
installed requested software prior 
to the expiration of the configured 
time limit.

• Installed: Software was installed 
within the configured time limit.

• Status check expired: Time 
limit has expired for the user to 
install the requested software. 
The system no longer checks the 
status of this deployment.

• Revoked: Software was revoked 
by the administrator.
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Client software distribution properties  (continued)

Property Name Description

• Type: integer

• Default value: 30

Reconcile 
software 
installation 
status 
interval 
(hours)

sn_client_sf_dist.softwareInstallIntervalHour Determines when the scheduled job 
runs that determines the installation 
status. By default, the system checks 
the installation status every hour.

• Type: integer

• Default value: 24

Set 
scheduled 
application 
Discovery 
interval 
(days).

sn_client_sf_dist.discoveryExeDay Sets the repeat interval for the 
scheduled job that runs application 
Discovery. By default, Discovery runs 
at midnight on the day set with this 
value.

• Type: integer

• Default value: 5

Set lease 
execution 
schedule 
job interval 
(minutes)

sn_client_sf_dist.lease_execution_interval Interval in which the CSD Lease 
Schedule scheduled job checks for 
requested software leases to start, 
stop, or extend.

• Type: integer

• Default value: 1

Set time 
prior to 
lease end 
to notify 
requester 
(days)

sn_client_sf_dist.lease_end_notification Determines how many days prior 
to the end of a software lease 
to notify the requester. If lease 
extensions are allowed, ensure that 
this period provides enough time for 
the approval process to complete 
before the lease expires.

• Type: integer

• Default value: 5

Workflows installed with client software distribution

These workflows are installed with the Orchestration - Client Software Distribution plugin

Workflows installed with client software distribution

Workflow Description

Discover 
SCCM

Retrieves lists of applications, collections, and deployments from SCCM servers 
using custom CSD orchestration activities. An administrator runs this workflow 
from a UI action in a SCCM Server Instance record.
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Workflows installed with client software distribution  (continued)

Workflow Description

Order 
Client 
Software

Runs automatically when a user orders software from the service catalog.

Deploy 
SCCM 
Application

Triggered by the Order Client Software workflow to deploy software through SCCM 
server. This workflow adds either the user or the device into the SCCM collection.

Revoke 
Client 
Software

Begins the software revocation process for software deployed by an external 
provider. Administrators run this workflow from a UI action on the Requested 
Software record and the Installed Software Not Entitled record. This workflow 
triggers the appropriate provider workflow that performs the actual recovation. 
For example, this workflow triggers the Revoke SCCM Application workflow for 
applications in SCCM uninstall collections.

Revoke 
SCCM 
Application

Revokes SCCM applications that are members of an uninstall collection. The 
Revoke Client Software workflow triggers this workflow to revoke software 
deployed by an SCCM server. This workflow moves either the user or the device 
from the SCCM collection into the appropriate uninstall collection.

Related topics

Using extension points to extend application functionality

Using scripted extension points in server-side scripts

Using UI extension points in server-side UI macros

Using client extension points in client-side UI scripting

Create licenses and counters for distributed software

Licenses and software counters are associated with the software model and must be created if 
you want to track the license for software deployed by client software distribution (CSD).

Before you begin
Role required: sam or admin
You can create software licenses and counters in Software Asset Management for software 
items deployed from the service catalog by CSD. CSD depends on the software counter result to 
determine if the license is available for the requested software. If the license Valuation  is greater 
than 0, and the license type is Not allocated, CSD assumes that the license is available for the 
software.

Procedure

1. Navigate to All  > Software Asset  > Software Licenses.

2. Add a new software license for the software model you used in CSD.

3. Navigate to Software Asset  > Reconciliation  > Software Counters.

4. Create a software counter for the software model you created.

5. Run the counter to retrieve the software license information.

Client software distribution ordering process

Software deployed by Client Software Distribution (CSD) can be ordered from the service catalog 
by individual users or by approved users on behalf of others.
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Client Software Distribution catalog items have different options, depending on how ordering is 
configured.

Lease start and end dates

All software deployed by CSD requires users to specify the beginning date for the lease. This is 
enforced by the Orchestration - Asset Lease Management plugin that is activated automatically 
with CSD. The system prepopulates the Lease start  field with the current date and time.

If the catalog item is configured for revocation (uninstall), the form displays the Lease end  field, 
which allows the requester to define an end date and time for the lease. The system validates 
user input in these fields to ensure that the dates selected define a future window. The Lease 
end  field is not mandatory and can be left blank to order software with no end date.

Note: 
For systems deploying software from Microsoft System Center Configuration Management 
(SCCM), the Lease end  field is only available if the SCCM configuration  specifies an 
uninstall collection.

Software offered only to the logged in user

If the software catalog item  is configured with the Order on behalf of  check box cleared, the 
User  field does not appear on the order form. The logged in user selects the device on which 
to deploy the software from the Device to install this software on  field. Only those devices 
assigned to the logged in user appear in the list.

In this example, a user has logged into the service catalog to order Firefox for a computer that is 
assigned to the user. User selects the machine from a list of owned devices and selects the date 
and time the lease should begin. This software is deployed through Microsoft System Center 
Configuration Management (SCCM), but does not have an uninstall collection configured and 
cannot be revoked automatically by the system. As a result, the Lease end  field is not available.

Ordering software as the logged in user
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Software ordered on behalf of another user

If the software catalog item is configured with the Order on behalf of  check box selected, the 
User  field appears on the form. The logged in user can select any user from this field. The 
Device to install this software on  field only lists the devices assigned to the user selected in the 
User  field. If an approval is required for software ordered on behalf of another user, the system 
automatically sends an approval request to the manager of the user receiving the software. The 
approval is skipped if the requester is the named user's manager.

In this example, a manager is ordering Google Chrome for a contractor. The manager selects the 
contractor from the User  field and then chooses a computer from the list of devices assigned 
to the contractor. This software has an SCCM uninstall collection configured, which allows the 
manager to select an end date for the lease that coincides with the end of the user's contract. 
When the lease expires, SCCM automatically uninstalls the software from the device.

Defining software lease window

Extend a software lease

Users of software deployed by Client Software Distribution (CSD) can request the extension of a 
lease window, if the software is revocable by a software distribution system.

Before you begin
Role required: Any system user

About this task
If your software has a lease end date defined, and the software status is Installed, you can 
request an extension of the lease, pending any approvals your organization requires.

Procedure

1. Navigate to All  > Service Catalog  > My Requested Software.
The list shows only the software you have requested from the service catalog.

2. Select the record for the installed software whose lease you want to extend.
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3. Under Related Links  click Extend Lease.

Requested Software form

4. In the dialog box that appears, select a new lease end date in the calendar and click OK.
You must select a date later than the current date.

If the lease extension is subject to manager approval, you are notified of the decision. If the 
request is approved, a notification shows the new lease end date. If the new end date is within 
5 days (the default notification period) of the date when you made the request, CSD sends an 
immediate end-of-lease notification.

Important: 
If lease extensions in your organization require approval, make sure the approver is 
available and has enough time to process your extension request. If the extension cannot 
be approved before the original end date expires, the software is revoked.

Client software distribution from SCCM

You can use Client Software Distribution (CSD) to deploy and revoke software deployments 
from Microsoft System Center Configuration Management (SCCM) and manage distributions on 
SCCM hosts.

The SCCM activity pack  contains Orchestration activities that CSD uses to deploy software 
from a service catalog request and manage user and device collections on SCCM servers. In 
addition, CSD can manage license counts for deployed software using ServiceNow  Software 
Asset Management, revoke software deployed by SCCM without user interaction, and manage 
lease periods.

Configuring SCCM

Follow the SCCM configuration procedures in the order shown.

Configure the Application Administrator role on the SCCM server

To deploy software using ServiceNow®  Client Software Distribution (CSD), ensure that an SCCM 
administrative user has the correct permissions to deploy software and that PowerShell is 
properly configured.
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Before you begin
SCCM role required: Application Administrator

About this task
These instructions are for Microsoft 2012 R2 Server.

Procedure

1. In the System Center Configuration Manager console, navigate to Administration  > Security  > 
Administrative Users.

2. Right-click the user to whom you want to grant the Application Administrator role.

3. Select Properties  from the drop-down menu.

4. In the Properties dialog box, select the Security Roles  tab.

5. Ensure that the user has the Application Administrator role.

6. If the user does not already have this role, click Add, select this role from the list, and click OK.

Granting the Application Administrator role on the SCCM server

7. Log into SCCM as the user with the Application Administrator role.

8. Open the menu from the upper left corner of the console and select Connect via Windows 
PowerShell.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4896



Connect to PowerShell

9. Ensure that the user can access the CM console.
This action establishes the environment path to PowerShell for the logged in Application 
Administrator user.

Update the SCCM cmdlet libraries

Ensure that the System Center Configuration Manager SCCM Cmdlet Library is up-to-date.

Before you begin
Role required: Either current user or system administrator, depending on settings.

About this task
The System Center Configuration Manager SCCM Cmdlet Library installs and updates the 
Windows PowerShell module for SCCM. SCCM checks for library updates on a daily basis. Out-
of-date libraries can cause Discovery of the SCCM server to fail, because the system cannot 
parse the SCCM activity output. This warning message appears in the ECC queue input records 
for the SCCM GET activities:

WARNING: An update to the System Center 2012 Configuration 
 Manager Cmdlet
Library is available. Please go to
'http://go.microsoft.com/fwlink/?LinkId=528947' to download the 
 latest version.
Running cmdlet version: 5.0.8231.1004 Latest cmdlet version: 
 5.0.8328.1155

Download the latest version of the cmdlet library from Microsoft. For installation instructions, see 
https://technet.microsoft.com/en-us/library/dn958404(v=sc.20).aspx .

If you elect to use an earlier version library, use this procedure to disable the CM update check, 
which allows Discovery to prodeed without issues.
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Procedure

1. Log into the SCCM console as an adminstrator.

2. Open the menu from the upper left corner of the console.

3. Select Connect via Windows PowerShell.

4. Run one of these commands to disable the update check:

◦ Per-user: Set-CMCmdletUpdateCheck -CurrentUser 
-IsUpdateCheckEnabled 0

◦ Per-system: Set-CMCmdletUpdateCheck -System -IsUpdateCheckEnabled 
0

Important: 
The per-system cmdlet must run in an elevated Windows PowerShell session.

5. Run the Get-CMCmdletUpdateCheck  command to refresh the console and check the 
settings.

6. Ensure that the value of the IsEnabled  configuration variable has changed to False.
This indicates that the warning for an out of date cmdlet library is disabled for the users 
specified.

7. To re-enable the update check, run the -IsUpdateCheckEnabled 1  command for either 
the current user or for the system.

Configure the MID Server for SCCM activities

To use a MID Server with Microsoft System Center Configuration Management (SCCM) activities, 
configure it to communicate with the SCCM server.

Before you begin
Role required: admin

Procedure

1. In the navigation filter, enter cmdb_ci_dns_name.list.

2. Click New.

3. Enter the fully-qualified domain name (FQDN) of the SCCM server in the Name  field.

4. Right-click in the form header and select Save.

5. In the IP Address  related list, click New.

6. In the IP Address  field, enter the IP address of the SCCM server.

7. In the Nic  field, select eth0  or your preferred network interface controller.

8. Leave the Netmask  field blank.

9. Click Submit.

Create Windows credentials for SCCM deployments

Microsoft System Center Configuration Manager (SCCM) requires the appropriate credentials to 
deploy applications using the Client Software Distribution application.

Before you begin
Role required: sn_client_sf_dist.csd_admin or admin
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About this task
Client software distribution requires Windows credentials that have administrative rights on the 
SCCM server.

Procedure

1. Navigate to All  > Orchestration  > Credentials.

2. Click New.

3. In the list of credential types, select Windows Credentials.

4. Provide a user name and password with administrative rights on the SCCM server.

Important: 
Ensure the following:

◦ This user must have the Application Administrator role on the SCCM server.

◦ Use the credentials to log into the SCCM Server and connect via Windows PowerShell 
from the System Center Configuration Manager console at least once to set the path 
variable for that credential.

5. Fill in the other fields on the form, as appropriate.

For details, see Windows credentials .

6. Click Submit.

Retrieve SCCM data for client software distribution

Retrieve the collections and the list of applications available for deployment from your SCCM 
servers.

Before you begin
Role required: sn_client_sf_dist.csd_admin or admin

Before starting this procedure:

• Set up your Microsoft System Center Configuration Manager (SCCM) server, create the 
applications and collections, and configure the deployments you need. For information, see 
your SCCM documentation.

• Configure a user  with the Application Deployment Manager role on the SCCM server.

• Set up the MID Server to communicate with the SCCM server.

• Add Powershell credentials to the ServiceNow  Credentials [discovery_credentials] table for the 
SCCM user who has the Application Deployment Manager role.

About this task
To populate the Client Software Distribution application with SCCM data:

Procedure

1. Navigate to All  > Client Software Distribution  > SCCM  > SCCM Server Instance.

2. Click New.

3. In the SCCM Server Instance form, identify the server by name and provide the fully qualified 
domain name.

4. Click Submit.
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The new SCCM server appears in the list.

5. Open the new SCCM record and click Discover now  under Related links.

The system runs the Discover SCCM workflow that retrieves the application, collection, and 
deployment data from the SCCM server.

Retrieving SCCM data with Discovery

SCCM server Discovery for client software distribution

A Discovery workflow populates ServiceNow tables with collection, application, and deployment 
data retrieved from SCCM servers.

Users run the Discover SCCM  workflow from an SCCM Server Instance record  to populate the 
following ServiceNow  tables:

SCCM data populated in ServiceNow tables

Table Fields

SCCM Application [sn_client_sf_dist_sccm_application] • name

• publisher

• version

• model

• sccm_server

SCCM Collection [sn_client_sf_dist_sccm_collection] • name

• type

• sccm_server

SCCM Deployment [sn_client_sf_dist_sccm_deployment] • application

• collection

• type

Note: 
For details about the custom activities used in this workflow to extract data from an SCCM 
server, see Orchestration SCCM activity pack.
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Set up a software model for an SCCM application

Using the applications discovered on the SCCM server, set up a software model used by the 
Software Asset Management application to manage licenses.

Before you begin
Role required: sn_client_sf_dist.csd_admin or admin
Before creating software models, you must discover the applications available for deployment on 
the SCCM server. See Retrieve SCCM data for client software distribution  for details.

About this task
You can link an SCCM application to an existing software model or create a new model.

Procedure

1. Navigate to All  > Client Software Distribution  > SCCM  > SCCM Applications.
A list of applications discovered on the SCCM server appears.

2. Open an SCCM application record.

3. To link to an existing model, click the magnifying glass icon in the Model  field and select a 
model from the list.

SCCM application record

4. To create a model, click Create Software Model  under Related Links.

a. Complete the software model fields.
See for details.

b. Click Submit.
The view returns to the SCCM Applications form.

Define an SCCM configuration

To create catalog items for SCCM software deployment or to configure your instance to revoke 
software through SCCM, you must first associate that software with a collection through an 
SCCM configuration.

Before you begin
Before you create an SCCM configuration record, make sure you have discovered the SCCM 
applications, collections, and deployments and set up the necessary software models.

Role required: sn_client_sf_dist.csd_admin or admin

About this task
The SCCM configuration process associates software with SCCM collections. To deploy software 
from an SCCM server, the user or device must be a member of an SCCM collection associated 
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with an install  deployment. Client Software Distribution (CSD) allows you to revoke unentitled 
software  using an SCCM server when that software can be removed using an uninstall 
collection. Users requesting revokable software from the Service Catalog also have the ability to 
define lease start and stop dates and request lease extensions.

SCCM table references

Procedure

1. Navigate to All  > Client Software Distribution  > SCCM  > SCCM Applications.

2. Open an application that has a configured software model.

3. Under Related Links, click Create Software Configuration.

4. Complete the form, using the fields in the table.

SCCM configuration form
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SCCM configuration fields

Field Description

Name Recognizable name for this SCCM software 
configuration.

SCCM application Name of an application hosted on the SCCM 
server.

SCCM collection Name of the collection associated with 
the install  deployment for the selected 
application on the SCCM server. Only those 
collections associated with the application 
are available for selection.

SCCM uninstall collection Name of the collection associated with 
the uninstall  deployment for the selected 
application on the SCCM server. You must 
specify an uninstall collection to:

◦ Define a lease end date for deployed 
software.

◦ Allow lease extensions.

◦ Revoke software from a user's machine.

Discovery model Discovery model that links the unentitled 
software installation with the SCCM 
configuration. From the SCCM configuration 
record, Client Software Distribution can 
determine which collection to use to revoke 
the software. Unentitled software is software 
found on the user's machine that the user is 
not entitled to use.

Create a catalog item for an SCCM application

Using the applications discovered on the SCCM server, create a catalog item for an application 
you want to offer for distribution from the service catalog.

Before you begin
Role required: sn_client_sf_dist.csd_admin or admin
Before creating a catalog item, you must link the application to a software model and create at 
least one software configuration.

Procedure

1. Navigate to All  > Client Software Distribution  > SCCM  > SCCM Applications.
A list of applications discovered on the SCCM server appears.

2. Open a record for an SCCM application.

3. Under Related Links, click Create Catalog Item.
A new SCCM Application Catalog Item record appears with preconfigured information. .
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SCCM application catalog item

4. Add price information and complete the following fields added to the Client Software 
Distribution Catalog Item [sn_client_sf_dist_cat_item] table by the Orchestration - Client 
Software Distribution plugin:

SCCM fields in the catalog item form

Field Description

Skip approval 
(skip_approval)

Check box that allows skipping approval for this item by the 
requester's manager when a user orders it from the service 
catalog. Use this field in conjunction with the Order on behalf 
of  field to ensure that software ordered by a logged in user on 
behalf of another user is subject to approval. By default, this 
check box is cleared, requiring manager approval for all new 
catalog items.

Note: 
There are two levels of approval possible. By default, all 
category items require group approval for items in excess 
of $1000. If that approval is given or skipped, the system 
evaluates the Skip approval  check box to determine if 
the software item requires approval by the requester's 
manager.

Check license compliance 
(check_license_compliance)

Check box that forces the system to determine if deploying 
this item is allowed under the current license.

Order on behalf of Check box that allows the logged-in user to order this software 
from the service catalog for another user. This permits service 
desk personnel to order SCCM deployments for other users 
in the system. By default, this feature is enabled. To prevent 
unauthorized users from ordering software, ensure that 
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Field Description

approvals are required for this type of deployment by clearing 
the Skip approval  check box.

If an approval is required for software ordered on behalf of a 
user, the system automatically sends an approval request to 
the manager of the user receiving the software. The approval is 
skipped if the requestor is the named user's manager.

Software items requested from the service catalog on behalf of 
a different user require the following information:

◦ User: User selected for deployment. This field is 
automatically populated with the name of the logged in user. 
You can select another user from the list.

◦ Device to install this sofware on: Device belonging to the 
selected user on which to deploy the software. Only devices 
belonging to that user appear in the choice list.

◦ Lease start: Date and time to deploy the software. This is the 
start time for the lease. A lease can be open-ended or have 
a lease end time.

SCCM configuration Name of the SCCM configuration record  for this application. 
This record defines the collection and uninstall collection 
for this application. This configuration is required for all 
deployments, revocations, and leases performed by the SCCM 
server.

5. If the catalog item requires approval because of cost, be sure to configure an approval group in 
theApproved By Group  related list.
By default, the Service Catalog Request workflow runs when an item costing more than $1000 
is ordered and looks for an appropriate approval group. If no approval group is configured 
for the item, this workflow skips approval altogether and ends. The system then runs the 
Order Client Software workflow, which evaluates the Skip approval  check box to determine if 
approval by the requester's manager is required.

6. Click Update.
The view returns to the SCCM Applications list.

7. To see all client software distribution (CSD) catalog items, navigate to Client Software 
Distribution  > Maintain Items  > Software Items.

SCCM deployment

Ordering an SCCM application from a client software distribution (CSD) catalog item in the 
service catalog triggers the Order Client Software workflow.

This process deploys an SCCM application to a user or device through a service catalog order:

1. If the Skip approval  check box is cleared in the software catalog item, the Order Client 
Software workflow sends the catalog request to the requesting user's manager for approval.

2. If the Check license compliance  check box is selected in the software catalog item, the 
workflow performs a software license check. If there is no license available, the workflow 
creates a catalog task to procure more licenses and assigns the task to the Client Software 
Distribution  Administrators group.
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3. The Order Client Software workflow triggers the Deploy SCCM Application workflow as a 
subflow. This workflow adds either the user or the device to the SCCM collection using the Add 
to User Collection  or Add to Device Collection  SCCM activity.

4. If the software configuration specifies SCCM uninstall collection in the software catalog item, 
the Deploy SCCM Application workflow checks if the user or device exists in the uninstall 
collection. The workflow uses the Is Device in Collection or Is User in Collection SCCM activity. 
If the user or device exists in the uninstall collection, the workflow removes the device or user. 
The workflow uses the Remove from Device Collection or Remove from User Collection SCCM 
activity before adding it to the SCCM install collection.

Client software distribution validation process

After SCCM deploys software to a target computer, client software distribution (CSD) detects the 
installation and validates its status.

Client software distribution uses the following methods for detecting software installed on the 
target machine:

• Discovery: CSD is configured to leverage Discovery  to detect software installations. You can 
run Discovery manually at any time, or by a scheduled job.

• Microsoft SCCM Integration: You can import SCCM data into the CMDB using the features in 
the Integration - Microsoft SCCM plugin if Discovery is not active on the instance.

The instance uses the data gathered by Discovery or the SCCM integration plugin to populate 
the Software Installation [cmdb_sam_sw_install] table. To validate installations using this data, 
CSD runs a scheduled job called Reconcile Requested Software that uses Properties installed
settings. This process reconciles the software installation data accumulated in the CMDB and 
makes these status updates:

• Not installed  to Installed: The user has installed the requested software within the time limit 
configured in the sn_client_sf_dist.softwareInstallExpDays  property.

• Not installed  to Status check expired: The time limit has expired for the user to install the 
requested software. The system stops checking for installation when the time limit expires.

SCCM software revocation

An administrator can revoke software without any user interaction using Microsoft System 
Center Configuration Manager (SCCM) if the software configuration specifies an SCCM uninstall 
collection, even if the software was installed by some other process or user.

Revoke software deployed through the service catalog

Software deployed by SCCM can be revoked, but only when the software's status is Installed 
and the application associated with the software configuration has an uninstall collection 
configured.

Before you begin

• Create an SCCM configuration record  for the application that names an appropriate uninstall 
collection.

• Associate the CSD catalog item  for the application with the SCCM configuration that specifies 
the uninstall collection.

Role required: sn_client_sf_dist.csd_admin or admin

A workflow called Revoke SCCM Application  moves either the user or the device from its 
respective collection and adds it to the appropriate uninstall collection. When SCCM performs 
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an internal policy check and finds the user or device in the uninstall collection, SCCM removes 
the related software package from the client computer.

Procedure

1. Navigate to All  > Client Software Distribution  > Reports  > Requested Software.

2. Open the record for the SCCM software package you want to revoke.
The package must have a Status  of Installed  to be revocable.

3. Under Related Links, click Revoke software.

This action runs the Revoke Client Software workflow, which triggers the Revoke SCCM 
Application subflow that moves the user or device from the install collection to the uninstall 
collection. When SCCM performs an internal policy check and finds the user or device in the 
uninstall collection, SCCM removes the related software package from the client computer.

Revoke unentitled software

An administrator can revoke software using Microsoft System Center Configuration Manager 
(SCCM) that a user is not entitled to use even if the software was installed by some other process 
or user.

Before you begin
To revoke software using SCCM, you must create an SCCM configuration record  for the 
application, in which the appropriate software Discovery model is defined. See Software 
discovery models .

Role required: sn_client_sf_dist.csd_admin or admin

Client Software Distribution (CSD) uses Software Asset Management  to identify unentitled 
software installations. Discovery detects the software on the user's machine, and SAM 
determines if the user or device is entitled to use that software. This might include software that 
was not installed through a catalog request or software that the user installed without approval. 
If the software installation's Discovery model is associated with an SCCM software configuration 
that has an uninstall collection defined, then an administrator can use CSD to revoke that 
software from the user's machine without involving the user.

Procedure

1. Navigate to All  > Client Software Distribution  > Reports  > Installed Software Not Entitled.

2. Select the record for the installation that has unentitled users.

3. Under Related Links, click Revoke software.

This action runs the Revoke Client Software workflow, which triggers the Revoke SCCM 
Application subflow that moves the user or device from the install collection to the uninstall 
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collection. When SCCM performs an internal policy check and finds the user or device in the 
uninstall collection, SCCM removes the related software package from the client computer.

Revoking a software installation

SCCM software revocation workflow

The Revoke SCCM Application workflow moves a user or device from an install collection to an 
uninstall collection to revoke software installed from Microsoft System Center Configuration 
Manager (SCCM).

For the revocation workflow to run, the software package must have a status of Installed  and 
must be pre-configured for an appropriate uninstall collection. See Revoke software deployed 
through the service catalog  for configuration instructions. When an administrator initiates the 
revocation process, the system launches the Revoke SCCM Application workflow to move 
the user or device collection associated with installation to the appropriate SCCM uninstall 
collection. When the SCCM server performs a policy check, it finds the additions to the user or 
device uninstall collection and revokes the software package associated with that collection.

The workflow employs two custom activities, Remove from User Collection  and Remove from 
Device Collection, to remove either the user or the device from its original collection. The 
workflow then adds the user or device to the appropriate uninstall collection on the SCCM server 
with the Add to User Collection  or Add to Device Collection  activity.

Note: 
This workflow is triggered by the Revoke Client Software workflow as a subflow.

Client software distribution dashboard

The CSD dashboard provides a collection of visual reports for the Client Software Distribution 
application.

CSD dashboard

To access the CSD dashboard, navigate to Client Software Distribution  > Requested Software  > 
Dashboard.
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Sample report from CSD dashboard

Client software distribution reports

Report Description

Open Tasks Displays all open tasks grouped by the requested item's stage value.

• Type: Create a basic list report

• Table:  Catalog Task [sc_task]

Top 10 
Applications 
Installed

Displays the top 10 applications installed by request count.

• Type: Create a bar report

• Table: Requested Software [sn_client_sf_dist_req_software]

Total 
Software 
Request 
Item Over 
Time

Displays the total software items requested each month.

• Type: Line reports

• Table: Requested Software [sn_client_sf_dist_req_software]

Requests 
Completed 
Report

Displays the total of software requests completed each month.

• Type: Line reports

• Table: Requested Software [sn_client_sf_dist_req_software]

Installed 
Software Not 
Entitled

Displays installed software that users or devices are not entitled to use. This can 
be software deployed through CSD or by another process that does not comply 
with licensing. This report is on a Software Asset Management table.

• Type: Create a basic list report

• Table: Software Installation [cmdb_sam_sw_install]

Software 
Installation 
Status

Displays the count of requested software, grouped by installation status, for 
each month.
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Client software distribution reports  (continued)

Report Description

• Type: Line reports

• Table: Requested Software [sn_client_sf_dist_req_software]

Software 
Requested 
Item Stage 
Report

Displays the sum of all requested items, grouped by the requested item’s stage, 
for each month.

• Type: Line reports

• Table: Requested Software [sn_client_sf_dist_req_software]

License 
Counts 
Available

Displays the license counts for all available applications.

• Type: Create a basic list report

• Table: SCCM Application Catalog Item [sn_client_sf_dist_sccm_app_cat_item]

Usage Overview dashboard

Navigate to Client Software Distribution  > Usage Overview  to view the current transaction 
count for your instance.

Client software distribution extension framework

Client software distribution (CSD) provides built-in extension points for integrating a ServiceNow 
instance with client software distribution providers, such as Casper, Altiris, or LANDesk.

Important: 
The use of CSD extension points is an advanced procedure intended for use by 
experienced ServiceNow AI Platform  developers only. Instructions for customizing your 
instance to deploy and revoke software from a software distribution provider can be found 
in the CSD Extension Implementation Guide.

Configure client software distribution providers

Identify the provider and specify the workflows and extension points for a customized software 
distribution process.

Before you begin
Perform the development tasks described in the CSD Extension Implementation Guide before 
attempting this procedure.

Role required: sn_client_sf_dist.csd_admin, admin

Procedure

1. Navigate to All  > Client Software Distribution  > Extensions  > Providers.

2. Click New.

3. Complete the form using the fields in the table.
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Client software distribution provider fields

Field Description

Name Descriptive name of the provider.

Provider server table Table name of the provider server. You 
must create this table as an extension 
of the Configuration Item [cmdb_ci] 
table. For example, you might call 
your table Casper Server Instance 
[cmdb_ci_casper_server_instance].

Discovery flow Flow that discovers the provider server and 
returns the data from that server back to 
the instance. This is the flow you create with 
custom activities that query the provider 
server.

Software configuration table Table name of the software configuration 
for this provider. You create this table 
as an extension of the Client Software 
Distribution Software Configuration 
[sn_client_sf_dist_software_config] table. 
For example, you might create a table 
called Casper Software Configuration 
[sn_client_sf_dist_casper_sf_config].

Deployment extension key The SetDeploymentData  key provided 
with CSD. This key sets up the data for the 
software ordering and deployment workflow.

Deployment flow Flow that deploys software from the provider 
server. This is the flow you created with 
custom activities that tells the provider where 
to deploy an application requested from the 
service catalog.

Revocation extension key The SetRevocationData  key provided with 
CSD. This key sets up the data for installation 
revocation.

Revocation flow Flow that revokes an installation from a 
provider server. This is the flow you created 
with custom activities that tells the provider 
which application to remove from a device.

Use Flow Option to use Integration Hub  flows for client 
software distribution. When this option isn't 

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4911



Field Description

selected, Orchestration  workflows are used 
for client software distribution.

Note: 

Client software distribution extension keys

Client software distribution (CSD) extension keys allow you to customize the deployment and 
revocation of software from distribution providers.

These pre-defined keys allow you to generate input variables for workflows that deploy and 
revoke software from external distribution providers:

• SetDeploymentData: Sets the software order information and generates the input variables for 
the deployment workflow.

• SetRevocationData: Generates the input variables for the revocation workflow.

• CheckRevocable: Specifies the conditions that determine if an installation can be revoked. 
If the software configuration associated with the installed software allows uninstallation, the 
installed software can be revoked.

Client software distribution extension points

The client software distribution (CSD) extension points create the customization code for the 
specific provider and the extension keys.

The purpose of the extension points is to associate extension keys with a specific provider, 
and then create a script that sets input variables for your custom deployment and revocation 
workflows. Another extension point script tells CSD if the provider has the capability to revoke 
software. If this is the case, CSD enables the UI action that triggers revocation from the provider.

SetDeploymentData

The script associated with this extension key must set the csdExtensionResult  object with 
these attributes:

• deploymentWorkflowInputs: Object that specifies the deployment workflow input 
variables.

• softwareModel: Software model sys_id.

• deploymentType: An integer. Use 1  for deployment to a user and 2  for deployment to a 
device.

• softwareApplication: Software application sys_id.

CheckRevocable

The script associated with this extension key gets the input parameter 
csdExtensionInputs.softwareConfiguration, which is a Client Software 
Distribution record in the Software Configuration [sn_client_sf_dist_software_config] table. All 
providers' software configurations are extended from this table, but may have different attributes.

This script must set the csdExtensionResult  object to true  or false, depending on whether 
the software configuration specifies uninstallation.
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SetRevocationData

The script associated with this extension key gets the input parameter 
csdExtensionInputs.softwareConfiguration, which is a Client Software 
Distribution record in the Software Configuration [sn_client_sf_dist_software_config] table. All 
providers' software configurations are extended from this table, but may have different attributes.

The script must set the csdExtensionResult  object with these attributes:

• revocationWorkflowInput: Object that specifies the revocation workflow input 
variables.

• softwareModel: Software model sys_id.

• deploymentType: An integer. Use 1  for deployment to a user and 2  for deployment to a 
device.

Related topics

Using extension points to extend application functionality

Using scripted extension points in server-side scripts

Using UI extension points in server-side UI macros

Using client extension points in client-side UI scripting

Orchestration examples

These examples demonstrate how Orchestration can be used to automate common tasks.

Active Directory automation example

A set of six Orchestration Active Directory activities enables organizations to automate their on-
boarding/off-boarding processes with auditable, self-documenting workflows that save time and 
eliminate mistakes.

The activities in the Active Directory activity pack  are designed to manage user accounts and 
reset user passwords. The following activities cover the most common use cases administrators 
encounter when managing Active Directory user accounts:

• Create AD User Account

• Update AD User Account

• Remove AD User Account

• Disable AD User Account

• Query AD

• Reset AD User Password.

These activities share a common design, have complementary functionality, and share a 
common set of parameters. They can be used singly or together to create consistent workflows 
for provisioning and de-provisioning user accounts.

Update Active Directory with Orchestration

An organization plans to make their ServiceNow  instance the single system of record for user 
account data and wants to update Active Directory with the latest changes.

About this task
The solution is to create an Orchestration workflow that pushes changes from the ServiceNow 
user record down to the Active Directory to create a new user record or update an existing 
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record. This is accomplished by creating an Orchestration workflow that can create and update 
records in Active Directory based on the data in the ServiceNow  User [sys_user] table.

Note: 
This example workflow assumes that ServiceNow  is configured for LDAP and an 
LDAP server is configured to accept the new user accounts. The Active Directory user 
management activities are not dependent on LDAP, but the presence of LDAP makes this 
example workflow much easier. You must provide the domain controller's IP address to the 
workflow, either by hardcoding it, adding another workflow input, or using a script to look it 
up from the CMDB.

Procedure

1. Navigate to All  > Workflow  > Workflow Editor.

2. In the Workflow  tab, click the +  icon to create a new workflow using these variables:

◦ Name: Sync AD User

◦ Table: Global [global]

3. Click Submit.
A basic workflow with a Begin and End point appears on the canvas.

4. Click the menu icon in the upper left corner of the canvas and select Edit Inputs  from the 
context menu.

Editing workflow inputs

5. In the Workflow Inputs form, click New  in the Variables  record list, and create a new variable, 
using the fields in the table.
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Field Value

Type Reference

Label User

Column name u_user

Reference Specification > Reference User (sys_user)

6. Click Submit.

7. In the Custom  tab, expand Custom Activities  > Active Directory.

8. Drag and drop the Update AD Object activity onto the transition line between the Begin and 
End points of the new workflow.
This action automatically links the activity with the end point and opens the Workflow Activity 
property form.

9. Complete the form using the fields in the table.

Field Value

Name Enter a logical name such as Update user data.

Domain 
controller

The ServiceNow  LDAP integration adds a reference to the LDAP server to which 
the user's account is linked. To identify the LDAP server, enter the following 
statement:

${workflow.inputs.u_user.ldap_server.server_url}

Type Type of AD object. In this case, the type is User, which is the default.

Object 
name

This example assumes that the ServiceNow  user name matches the Active 
Directory sAMAccountName. Enter the following:

${workflow.inputs.u_user.user_name}

Object 
data

Updates the user's account in Active Directory, if the user exists. In this example, 
the user's title is updated:

{"title" : "QA"}

10. Click Submit.
The workflow looks like this:
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Updating an AD user

11. Attach both activity outcomes (Success and Failure) to the end point.
At this point, the workflow takes a ServiceNow  user record as input and updates the First 
Name, Last Name, and Title of the corresponding Active Directory account. If the account does 
not exist in Active Directory, the workflow fails.

Note: 
In a normal workflow, some type of alternate action is desirable upon failure. For example, 
you might send an Email and SMS notifications  if the workflow failed to update the 
record.

12. To prevent the workflow from failing, add a Create AD Object activity to the transition lines 
between Begin and the Update AD Object activity.

13. Complete the Workflow Activity property form using the fields in the table.

Field Value

Name Enter a logical name such as Create user data.

Domain 
controller

Same as for the update activity. 
${workflow.inputs.u_user.ldap_server.server_url}

Ou The organizational unit to which this object belongs. For the purpose of this 
example, you can enter OU=HQ,OU=Managed Objects

Object 
name

Same as for the update activity. 
${workflow.inputs.u_user.user_name}

Object 
data

Creates an account with only the user name in it. For the 
purpose of this example, you can enter {"givenName" : 
"${workflow.inputs.u_user.first_name}", "SN" : 
"${workflow.inputs.u_user.last_name}" }

14. Click Submit.

15. Connect the Failure outcome of the Create AD Object activity to End.
For this example, we are ignoring errors. The workflow now looks like this:
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Creating an AD user

This procedure builds a simple workflow that creates a bare-bones Active Directory account 
consisting of a user name only. The workflow then updates that account with additional 
information provided by the ServiceNow  User [sys_user] table. However, we do not want to 
execute the Create AD Object activity if the user account already exists. The workflow needs to 
query Active Directory for matching user records and then branch the workflow based on the 
results of the query. If an account already exists, then the workflow should update the account. 
If the account does not exist, then the workflow should create the account in Active Directory.

16. Drag and drop the Query AD activity onto the transition between Begin and Create AD Object.

17. Complete the Workflow Activity property form using the fields in the table.

Field Definition

Name Enter a logical name such as Search for existing account.

Domain 
controller

${workflow.inputs.u_user.ldap_server.server_url}

Properties A comma-separated list of Active Directory properties to return. For example, 
givenName, SN, title. If the parameter field is blank, then all properties are 
returned. In this workflow, we leave the field blank.

Search 
filter

An LDAP filter string that defines the search parameters. Use any valid LDAP 
filtering criteria. To find user accounts matching the input record, we use:

(samaccountname=${workflow.inputs.u_user.user_name})

18. Click Submit.

19. Connect the Failure outcome for the query activity to the End point.
Remember that we are ignoring errors in this workflow.

20. Connect the Success outcome of the query activity to the Update AD Object activity.
The workflow now looks like this:
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Querying AD for user accounts

The Query AD activity returns its results as a JSON string in the workflow data bus. This JSON 
string is always an array of objects. Each object corresponds to an Active Directory entry that 
matched the query. Our workflow should branch, whether that array is empty or not.

21. Drag a standard If  activity from the Conditions  folder in the Core  tab and drop it onto the 
transition between Query AD and Update AD Object.

22. Complete the Workflow Activity properties form using the fields in the table.

Field Value

Name Enter a logical name such as Account exists.

Advanced Select this check box to open the Script  field.

Script For the If activity to work correctly, we must return a yes  or no  in the answer 
variable (var) which corresponds to the Yes and No outcomes of the query 
activity. Line 1 converts the Query AD results from a JSON string into a Javascript 
array called queryResults. Line 2 checks the length of that array. If the array is 
more than 0, a match to the account was found, and we set our answer to yes. 
Otherwise, the answer is no.

var queryResults=new JSON().decode(data.get(5).output);

answer = ( queryResults.length>0 ? 'yes' : 'no' );

Note: 
The expression data.get(5)  in this script identifies the Query AD output in the 
Databus by order number, since it was the fifth activity added to the workflow.

Query AD outputs in the Databus

23. Click Submit.
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24. In the canvas, create a transition from the Yes outcome of the If activity to the Update AD 
Object activity.

25. Create a transition from the No outcome of the If activity to the Create AD Object activity.
This is the final step. This workflow will query Active Directory to determine if an account 
already exists. If an account exists, the workflow updates that account. If an account does 
not exist, the workflow creates the account and then updates the Active Directory with the 
configured user data set.

Creating the conditional paths

Orchestration activity packs

The base Orchestration system includes packs of custom activities you can use to automate 
typical IT and business processes in your network.

Activity packs allow you to automate several common business processes, such as managing 
Active Directory accounts and Exchange server mailboxes. Activity packs can also automate 
IT functions such as starting and stopping Windows servers, joining domains, assigning IP 
addresses, and configuring load balancers.

Use an activity pack

The Packs  tab of the Workflow Editor contains any activity packs downloaded from the 
ServiceNow Store and any activity packs that you create.

Before you begin
Roles required: admin, activity_admin, activity_creator

About this task
You can organize custom activities into packs and upload them to the ServiceNow  Store. Your 
custom packs do not appear in the tree until at least one activity in the pack is published. 
Activities added to an existing pack are not displayed until they are published. Activity packs 
from any Application scope  can appear in the Packs  tab, regardless of the current scope 
setting for the instance.

Procedure

1. In the Workflow Editor palette, select the Packs  tab.

2. Click the download icon.
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The hierarchy in the tab organizes packs by vendor, scope, category, and activity.

Active Directory activity pack

The Active Directory (AD) activity pack enables an administrator to create, delete, and manage 
objects in Windows Active Directory, such as users, groups, and computers, using a ServiceNow 
Orchestration workflow.

Activities in this pack can reset a password automatically from a user request or manage any 
user account in Active Directory, whether or not it was created by a Orchestration workflow.

Domain controllers are identified by the IP address of the host machine. To use the hostname of 
the domain controller, add the Resolve DNS Name activity to resolve the hostname into an IP, and 
then pass the IP into the Active Directory activity.

Your instance must have access to a MID Server configured to use PowerShell to run these 
activities.

Note: 
All Active Directory activities pass through error messages returned from Active Directory. 
To view these error messages, point to the failed activity in the workflow canvas or select 
the Workflow Log tab in a Workflow Context  record.

Custom Active Directory activities

Orchestration provides custom Active Directory activities that were created with the 
Orchestration Create a PowerShell activity, starting with the Geneva  release. These activities 
perform the same functions as AD activities by the same name from previous releases and 
replace those activities for all new workflows. Existing workflows from earlier versions that were 
created with legacy AD activities continue to function normally after an upgrade to Istanbul. 
However, all new workflows must use these custom AD activities. The Powershell activity 
template gives workflow administrators the ability to store input and output variables from the 
Query AD  activity in the Databus.
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Note: 
To use the Active Directory custom activities, you must request activation  of the 
Orchestration - Active Directory plugin.

Active Directory credentials with LDAP

If you are using an LDAP Server with MID Servers, note that Orchestration and Active Directory 
activities do not use the user name and password configured on LDAP Servers. You must create 
a Windows type orchestration credential record  Windows credentials . The username and 
password in the credentials record is used for LDAP queries that Orchestration and workflow 
activities perform.

Connection port used by AD Orchestration activities

All Active Directory activities use port 389 for LDAP access. If you are using AD activities with 
Oracle Virtual Directory (OVD) as a proxy, set up pass-through on port 389 only.

Add User to Group AD activity

The Add User to Group activity adds a user to a group in Windows Active Directory.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Active Directory.

Input variables

Add User to Group input variables

Variable Description

DomainController IP address of the domain controller machine.

UserName Name of the user to add to the group.

GroupName Name of the group to which this user is added.

Output variables

Add User to Group output variables

Variable Description

result Either success  or failure.

errorMessage The 
executionResult.errorMessages 
from the Activity designer parsing sources.

Conditions

Add User to Group conditions

Condition Description

Success User was successfully added to group.
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Add User to Group conditions  (continued)

Condition Description

Failure An error occurred while attempting to add the 
user to the group. Additional details may be 
available in the workflow log.

Change AD User Password activity

The Change AD User Password activity changes the password for an Active Directory user 
account.

This activity requires the user's current password to run, unlike the Reset AD User Password 
activity. If the new password violates any Active Directory password requirements, such as length 
or character combinations, the activity fails and returns the appropriate error message. This 
error message appears in the ECC queue and in hint text when a user points to the activity in the 
Workflow Editor.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Active Directory.

Note: 
This activity replaces an AD activity by the same name available in prior releases. If you 
have a workflow that uses the deprecated activity, your workflow will continue to work 
normally after upgrading to Instanbul. However, all new workflows must use the custom 
version of this activity, which was built with the PowerShell activity designer.

Input variables

Change AD User Password input variables

Variable Description

DomainController IP address of the domain controller machine.

User The sAMAccountName of the Active Directory user account.

New_password The new password to assign this user.

Old_password The user's current password.

Output variables

Change AD User Password output variables

Variable Description

result One of the following outcomes:

• failure

• success

• Policy Failure

• Incorrect old password

errorMessage The executionResult.errorMessages  from the Activity designer 
parsing sources.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4922



Change AD User Password output variables  (continued)

Variable Description

hresult Powershell command result.

Conditions

The activity provides the following conditions:

Change AD User Password conditions

Condition Description

Success Password successfully reset.

Policy Failure Password does not comply with the organization's Active Directory 
requirements.

Incorrect old 
password

Password being changed was not entered correctly.

Failure An error occurred while attempting to change the password. Additional details 
may be available in the workflow log.

Active Directory credentials with LDAP

If you are using an LDAP Server with MID Servers, note that Orchestration and Active Directory 
activities do not use the user name and password configured on LDAP Servers. You must create 
a Windows type orchestration credential record  Windows credentials . The username and 
password in the credentials record is used for LDAP queries that Orchestration and workflow 
activities perform.

Create AD Object activity

The Create AD Object activity creates an object in Windows Active Directory.

This activity fails if it finds an existing object with matching input variables.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Active Directory.

Note: 
This activity replaces an AD activity by the same name available in prior releases. If you 
have a workflow that uses the deprecated activity, your workflow will continue to work 
normally after upgrading to Instanbul. However, all new workflows must use the custom 
version of this activity, which was built with the PowerShell activity designer.

Input variables

Create AD Object input variables

Variable Description

DomainController IP address of the domain controller machine.

Type The object type to create: user, group, or computer.

OU The organizational unit to which this object belongs.
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Create AD Object input variables  (continued)

Variable Description

ObjectName The sAMAccountName of the Active Directory object. Object name  is also 
used for the name  attribute in Active Directory. This behavior is available in 
ActiveDirectory.psm1. Whatever is passed as the Object name  becomes 
both the samAccountName  and the name  of the new user in Active 
Directory.

ObjectData A JSON object containing Active Directory property names and their 
corresponding values. For example:

{
  "givenName" : "John",
  "SN" : "Doe",
  "title" : "Sr. Account Specialist",
  "allowLogin" : true
}

This example sets the first name (givenName), last name (SN), and title on 
the Active Directory user account and allows that user to log in (allowLogin). 
This field allows expression evaluation via the ${} variable substitution 
syntax.

Output variables

Create AD Object output variables

Variable Description

result Either success  or failure.

errorMessage The executionResult.errorMessages  from the Activity designer 
parsing sources.

Conditions

Create AD Object conditions

Condition Description

Success A Windows Active Directory object was created successfully.

Failure An error occurred while attempting to create the AD object. Additional details may 
be available in the workflow log.

Disable AD User Account activity

The Disable AD User Account activity disables a Windows Active Directory user account, making 
it inactive.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Active Directory.
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Note: 
This activity replaces an AD activity by the same name available in prior releases. If you 
have a workflow that uses the deprecated activity, your workflow will continue to work 
normally after upgrading to Instanbul. However, all new workflows must use the custom 
version of this activity, which was built with the PowerShell activity designer.

Input variables

Disable AD User Account input variables

Variable Description

DomainController IP address of the domain controller machine.

User The sAMAccountName of the Active Directory user account.

Output variables

Disable AD User Account output variables

Variable Description

result Either success  or failure.

errorMessage The executionResult.errorMessages  from the Activity designer 
parsing sources.

Conditions

Disable AD User Account conditions

Condition Description

Success AD user account was successfully disabled.

Failure An error occurred while attempting to disable the account. Additional details may be 
available in the workflow log.

Enable AD User Account activity

The Enable AD User Account activity enables a Windows Active Directory user account, making it 
active.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Active Directory.

Note: 
This activity replaces an AD activity by the same name available in prior releases. If you 
have a workflow that uses the deprecated activity, your workflow will continue to work 
normally after upgrading to Instanbul. However, all new workflows must use the custom 
version of this activity, which was built with the PowerShell activity designer.
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Input variables

Enable AD User Account input variables

Variable Description

User The sAMAccountName of the Active Directory user account.

DomainController IP address of the domain controller machine.

Output variables

Enable AD User Account output variables

Variable Description

result Either success  or failure.

errorMessage The executionResult.errorMessages  from the Activity designer 
parsing sources.

Conditions

Enable AD User Account conditions

Condition Description

Success AD user account was successfully enabled.

Failure An error occurred while attempting to enable the AD user account. Additional details 
may be available in the workflow log.

Is AD Account Locked activity

The Is AD Account Locked activity determines whether an Active Directory user account is 
locked.

An account may be locked automatically if a user enters an incorrect password more times than 
allowed by the Active Directory security policy. You can unlock an account using the Unlock AD 
User Account  activity.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Active Directory.

Note: 
This activity replaces an AD activity by the same name available in prior releases. If you 
have a workflow that uses the deprecated activity, your workflow will continue to work 
normally after upgrading to Instanbul. However, all new workflows must use the custom 
version of this activity, which was built with the PowerShell activity designer.

Input variables

Is AD Account Locked input variables

Variable Description

DomainController IP address of the domain controller machine.
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Is AD Account Locked input variables  (continued)

Variable Description

User The sAMAccountName of the Active Directory user account.

Output variables

Is AD Account Locked output variables

Variable Description

result Either success  or failure.

errorMessage The executionResult.errorMessages  from the Activity designer 
parsing sources.

output The query result.

Conditions

Is AD Account Locked conditions

Condition Description

Locked The AD account is locked.

Unlocked The AD account is unlocked.

Failure An error occurred while processing the query. Additional details may be available in 
the workflow log.

Query AD activity

The Query AD activity retrieves entries from the Windows Active Directory based on an LDAP 
search filter and stores the results as a JSON string that can be used in the data bus.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Active Directory  > .

Note: 
This activity replaces an AD activity by the same name available in releases prior to 
Geneva. If you have a workflow that uses the deprecated activity, your workflow will 
continue to work normally after upgrading to Instanbul and will continue to save query 
results to the scratchpad. However, all new workflows must use the custom version of this 
activity. This activity was built with the Create a PowerShell activity, which stores input and 
output variables in the databus  instead of the scratchpad.

Input variables

Query AD input variables

Variable Description

DomainController IP address of the domain controller machine.
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Query AD input variables  (continued)

Variable Description

Properties A comma-separated list of Active Directory properties to return. For 
example, givenName,SN,title. If this field is blank, then all properties 
are returned.

SearchFilter An LDAP filter string that defines the search parameters. Use any valid 
LDAP filtering criteria. For example, to find user accounts matching the 
ServiceNow  input record, use:

(samaccountname=${workflow.inputs.u_user.user_nam
e})

Output variables

Query AD output variables

Variable Description

result Either success  or failure.

errorMessage The executionResult.errorMessages  from the Activity designer 
parsing sources.

output The query result.

Conditions

Query AD conditions

Condition Description

Success The query completed as expected.

Failure An error occurred while processing the query. Additional details may be available in 
the workflow log.

Remove AD Object activity

The Remove AD Object activity deletes an object from Windows Active Directory.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Active Directory.

Note: 
This activity replaces an AD activity by the same name available in prior releases. If you 
have a workflow that uses the deprecated activity, your workflow will continue to work 
normally after upgrading to Instanbul. However, all new workflows must use the custom 
version of this activity, which was built with the PowerShell activity designer.
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Input variables

Remove AD Object input variables

Variable Description

DomainController IP address of the domain controller machine.

ObjectName The sAMAccountName of the Active Directory object.

Type The object type to remove:

• user

• group

• computer

Output variables

Remove AD Object output variables

Variable Description

result Either success  or failure.

errorMessage The executionResult.errorMessages  from the Activity designer 
parsing sources.

Conditions

Remove AD Object conditions

Condition Description

Success AD object was successfully removed.

Failure An error occurred while attempting to remove the AD object. Additional details may 
be available in the workflow log.

Remove User from Group AD activity

The Remove User from Group activity removes a user from a group in Windows Active Directory.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Active Directory.

Input variables

Remove User from Group input variables

Variable Description

DomainController IP address of the domain controller machine.

UserName Name of the user to remove from the group.

GroupName Name of the group from which this user is 
removed.
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Output variables

Remove User from Group output variables

Variable Description

result Either success  or failure.

errorMessage The 
executionResult.errorMessages 
from the Activity designer parsing sources.

Conditions

Remove User from Group conditions

Condition Description

Success User was successfully removed from the 
group.

Failure An error occurred while attempting to remove 
the user from the group. Additional details may 
be available in the workflow log.

Reset AD User Password activity

The Reset AD User Password activity resets the password of a user account in Windows Active 
Directory.

If the new password violates any Active Directory password requirements, such as length or 
character combinations, the reset activity fails and returns the appropriate error message. This 
error appears in the ECC Queue and when you point to the activity in the Workflow Editor.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Active Directory.

Note: 
This activity replaces an AD activity by the same name available in prior releases. If you 
have a workflow that uses the deprecated activity, your workflow will continue to work 
normally after upgrading to Instanbul. However, all new workflows must use the custom 
version of this activity, which was built with the PowerShell activity designer.

Input variables

Reset AD User Password input variables

Variable Description

DomainController IP address of the domain controller machine.

User The sAMAccountName of the Active Directory user account.

Password The new password for the user. This password must comply with the 
organization's Active Directory requirements.

ForceChange Makes this password temporary by forcing the user to change it at the next 
login.
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Reset AD User Password input variables  (continued)

Variable Description

Unlock Unlock the account if the account is locked.

Output variables

Reset AD User Password output variables

Variable Description

result One of the following outcomes:

• failure

• success

• Policy Failure

errorMessage The executionResult.errorMessages  from the Activity designer 
parsing sources.

hresult Powershell command result.

Conditions

Reset AD User Password conditions

Condition Description

Success Password was successfully reset.

Policy 
Failure

New password does not comply with the organization's Active Directory 
requirements.

Failure An error occurred while attempting to reset the password. Additional details may be 
available in the workflow log.

Unlock AD Account activity

The Unlock AD Account activity unlocks a locked Active Directory user account.

You can use the Is AD Account Locked activity  activity to determine if an account is locked.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Active Directory.

Note: 
This activity replaces an AD activity by the same name available in prior releases. If you 
have a workflow that uses the deprecated activity, your workflow will continue to work 
normally after upgrading to Instanbul. However, all new workflows must use the custom 
version of this activity, which was built with the PowerShell activity designer.
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Input variables

Unlock AD Account input variables

Variable Description

DomainController IP address of the domain controller machine.

User The sAMAccountName of the Active Directory user account.

Output variables

Unlock AD Account output variables

Variable Description

result Either success  or failure.

errorMessage The executionResult.errorMessages  from the Activity designer 
parsing sources.

Conditions

Unlock AD Account conditions

Condition Description

Success The account was successfully unlocked.

Failure An error occurred while attempting to unlock the account. Additional details may be 
available in the workflow log.

Update AD Object activity

The Update AD Object activity updates an object in Windows Active Directory.

This activity only replaces existing values with new values. It cannot add new values to AD 
records such as adding a new group member to an AD group. For complex AD operations, use 
the Run PowerShell activity  instead. The activity fails if it cannot find an existing account with 
matching object name and data.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Active Directory.

Note: 
This activity replaces an AD activity by the same name available in prior releases. If you 
have a workflow that uses the deprecated activity, your workflow will continue to work 
normally after upgrading to Instanbul. However, all new workflows must use the custom 
version of this activity, which was built with the PowerShell activity designer.

Input variables

Update AD Object input variables

Variable Description

DomainController IP address of the domain controller machine.
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Update AD Object input variables  (continued)

Variable Description

ObjectName The sAMAccountName of the Active Directory object.

ObjectData A JSON object containing Active Directory properties and their values. For 
example, to set the first name, last name, and title of a user, clear the user's 
manager, and set the VIP flag to true, the Object Data specifies:

{ "givenName" : "John", "SN" : "Doe", "title" : 
 "Sr. Account Specialist", "manager" : null, 
 "msTSAllowLogon" : false }

Type The object type to update: user, group, or computer.

Output variables

Update AD Object output variables

Variable Description

result Either success  or failure.

errorMessage The executionResult.errorMessages  from the Activity designer 
parsing sources.

Conditions

Update AD Object conditions

Condition Description

Success AD object was successfully updated.

Failure An error occurred while attempting to update an AD object. Additional details may 
be available in the workflow log.

Azure AD activity pack

The Azure AD activity pack enables an administrator to automate employee onboarding and 
offboarding functions on Azure AD and manage Office 365 licensing.

Use the Azure AD activities to add and remove users to Azure Active Directory, manage security 
group membership, and assign or remove Office 365 licenses for individual users.

The Azure AD activities were created with the Orchestration REST Web Service activity template.

Add User to Group Azure AD activity

The Add User to Group activity adds a user to an existing security group in Azure Active Directory.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Azure AD. This activity was built with the REST web service activity 
template.

Important: 
The REST message used for this activity must be configured to use OAuth 2.0 .
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Input variables

Add User to Group input variables

Variable Description

user_id Object ID (GUID) of the member to be added.

group_id Object ID (GUID) of the target group.

Output variables

Add User to Group output variables

Variable Description

error Returns the error string from the REST 
message. If there are no errors, this variable 
returns a null value.

body Contains a string value representing the 
output from the REST message.

status_code Contains the status code returned from the 
Web service.

Conditions

Add User to Group conditions

Condition Description

Success Activity successfully added the object ID to 
the security group.

Failure Activity failed to update the group's 
membership, or the activity failed to connect 
to Azure AD.

Assign User License Azure AD activity

The Assign User License activity assigns an additional Office 365 software license to the named 
user.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Azure AD. This activity was built with the REST web service activity 
template.

Important: 
The REST message used for this activity must be configured to use OAuth 2.0 .
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Input variables

Assign User License input variables

Variable Description

user_id The object ID (GUID) or the user 
principal name of the target user. An 
example of a user principal name is 
someuser@a830edad9050849NDA1.onmicrosoft.com.

sku_id Subscription SKU ID associated with the 
tenant's enterprise agreement.

Output variables

Assign User License output variables

Variable Description

error Returns the error string from the REST 
message. If there are no errors, this variable 
returns a null value.

body Contains a string value representing the 
output from the REST message.

status_code Contains the status code returned from the 
Web service.

Conditions

Assign User License conditions

Condition Description

Success Activity successfully assigned an Office 365 
license to a user.

Failure Activity failed to assigned an Office 365 
license to a user, or the activity failed to 
connect to Azure AD.

Create User Azure AD activity

The Create User activity creates a user for the Azure Active Directory tenant.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Azure AD. This activity was built with the REST web service activity 
template.

Important: 
The REST message used for this activity must be configured to use OAuth 2.0 .
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Input variables

Create User input variables

Variable Description

display_name Name of the Azure AD user in the accepted 
display format, such as jacinto.gawron.

user_principal_name User principal name (UPN) in an email 
format. For example, you might enter 
jacinto.gawron@khitomer.com.

mail_nickname User's email alias that redirects to the user's 
full address.

password User's Azure AD password. This password 
must be passed as a workflow input with a 
type of Password (2 Way Encrypted)  and 
must meet the password policy set in Azure 
AD.

change_password Control that requires the user to change their 
password at the next login, if set to true.

account_enabled Control that sets the user's account is 
enabled, if set to true.

given_name First name of the user.

surname Last name of the user.

other_mails List of additional email addresses 
for the user. For example, you 
might enter ["jac@home.com", 
"jgawron@fabrikam.com"].

country The country or region in which the user is 
located. For example, you might enter US  or 
UK. The default value is set toUS.

city City in which the user is located.

department Name of the department in which the user 
works.

mobile User's primary cell phone number.

job_title User's job title.

physical_delivery_office_name Office location in the user place of business.

postal_code Postal code of the user's address.

preferred_language Language in which the user prefers to 
communicate. This value must follow the ISO 
639-1 Code. For example, you might enter en-
US. The default value is set to en-US.

state State or province for the user's address.

street_address Street address of the user's place of business.

telephone_number Primary telephone number of the user's place 
of business.
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Create User input variables  (continued)

Variable Description

usage_location Two letter country code that is required for 
users who are assigned Office 365 licenses. 
The default value is US.

Output variables

Create User output variables

Variable Description

error Returns the error string from the REST 
message. If there are no errors, this variable 
returns a null value.

status_code Contains the status code returned from the 
Web service.

user_exists Output variable mapped to the JSON message 
that contains the User already exists 
error.

user_info The user_info  array contains attributes 
that can be leveraged by other activities as 
inputs. For example, the user objectid 
output (GUID) can be passed to the Add User 
to Group activity as the user_id  input.

• objectid: User's Azure AD identifier.

• accountEnabled: Boolean variable 
indicating whether the user's account is 
active or inactive.

• displayName: Users display name, such 
as jacinto.gawron.

• userPrincipalName: User's 
name in email format, such as 
jacinto.gawron@wammo.com.

• mailNickname: User's email alias.

Conditions

Create User conditions

Conditions Description

Created user Activity successfully created the user.

User already exists User already exists in the tenant domain.

Failure Activity failed to connect to Azure AD, or an 
input value was invalid.
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Delete User Azure AD activity

The Delete User activity deletes the named user's account from the Azure Active Directory 
tenant.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Azure AD. This activity was built with the REST web service activity 
template.

Important: 
The REST message used for this activity must be configured to use OAuth 2.0 .

Input variables

Delete User input variables

Variable Description

user_id The object ID (GUID) or the user 
principal name of the target user. An 
example of a user principal name is 
someuser@a830edad9050849NDA1.onmicrosoft.com.

Output variables

Delete User output variables

Variables Description

error Returns the error string from the REST 
message. If there are no errors, this variable 
returns a null value.

body Contains a string value representing the 
output from the REST message.

status_code Contains the status code returned from the 
Web service.

Conditions

Delete User conditions

Condition Description

Deleted user Activity deleted the specified user.

User does not exist Specified user does not have an account in 
the tenant domain.

Failure Activity failed to connect to Azure AD.

Get User Info Azure AD activity

The Get User Info activity returns the named user's information from the Azure Active Directory.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Azure AD. This activity was built with the REST web service activity 
template.
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Important: 
The REST message used for this activity must be configured to use OAuth 2.0 .

Input variables

Check If User Exists input variables

Variable Description

user_id The object ID (GUID) or the user 
principal name of the target user. An 
example of a user principal name is 
someuser@a830edad9050849NDA1.onmicrosoft.com

Note: 
Version 2 of this activity enforces 
input validation. If empty, the following 
message appears: "Mandatory input 
'user_id' is empty"

.

Output variables

Check If User Exists output variables

Variable Description

error Returns the error string from the REST 
message. If there are no errors, this variable 
returns a null value.

body Contains a string value representing the 
output from the REST message.

status_code Contains the status code returned from the 
Web service.

user_info The user_info  array contains attributes 
that can be leveraged by other activities as 
inputs. For example, the user objectid 
output (GUID) can be passed to the Add User 
to Group activity as the user_id  input.

• objectid: User's Azure AD identifier.

• accountEnabled: Boolean variable 
indicating whether the user's account is 
active or inactive.

• displayName: Users display name, such 
as jacinto.gawron.

• userPrincipalName: User's 
name in email format, such as 
jacinto.gawron@wammo.com.

• mailNickname: User's email alias.
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Conditions

Check If User Exists conditions

Condition Description

User exists Activity found the named user.

User does not exist Activity was unable to find the named user in 
the customer tenant domain.

Failure Activity failed to connect to Azure AD.

Remove User from Group Azure AD activity

The Remove User from Group activity removes an existing user from a security group in Azure 
Active Directory.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Azure AD. This activity was built with the REST web service activity 
template.

Important: 
The REST message used for this activity must be configured to use OAuth 2.0 .

Input variables

Remove User from Group input variables

Variable Description

user_id Object ID (GUID) of the user to be removed.

group_id Object ID (GUID) of the target group.

Output variables

Remove User from Group output variables

Variable Description

error Returns the error string from the REST 
message. If there are no errors, this variable 
returns a null value.

body Contains a string value representing the 
output from the REST message.

status_code Contains the status code returned from the 
Web service.
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Conditions

Remove User from Group conditions

Variable Description

Success Activity removed the object ID from the 
security group.

Failure Activity failed to update the group's 
membership, or the activity failed to connect 
to Azure AD.

Remove User License Azure AD activity

The Remove User License activity revokes the specified Office 365 software license for the 
named user.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Azure AD. This activity was built with the REST web service activity 
template.

Important: 
The REST message used for this activity must be configured to use OAuth 2.0 .

Input variables

Remove User License input variables

Variable Description

user_id The object ID (GUID) or the user 
principal name of the target user. An 
example of a user principal name is 
someuser@a830edad9050849NDA1.onmicrosoft.com.

sku_id Subscription SKU ID associated with the 
tenant's enterprise agreement.

Output variables

Remove User License output variables

Variable Description

error Returns the error string from the REST 
message. If there are no errors, this variable 
returns a null value.

body Contains a string value representing the 
output from the REST message.

status_code Contains the status code returned from the 
Web service.
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Conditions

Remove User License conditions

Condition Description

Success Activity removed an Office 365 license from 
the named user.

Failure Activity failed to remove an Office 365 from a 
user, or the activity failed to connect to Azure 
AD.

Reset User Password Azure AD activity

The Reset User Password activity changes the named user's Azure Active Directory password.

The Azure password policy imposes constraints on the complexity, length, and re-use of a 
password.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Azure AD. This activity was built with the REST web service activity 
template.

Important: 
The REST message used for this activity must be configured to use OAuth 2.0 .

Input variables

Reset User Password input variables

Variable Description

user_id The object ID (GUID) or the user 
principal name of the target user. An 
example of a user principal name is 
someuser@a830edad9050849NDA1.onmicrosoft.com.

password User's Azure AD password. This password 
must be passed as a workflow input with a 
type of Password (2 Way Encrypted)  and 
must meet the password policy set in Azure 
AD.

change_password Control that requires the user to change their 
password at the next login, if set to true.

Output variables

Reset User Password output variables

Variable Description

error Returns the error string from the REST 
message. If there are no errors, this variable 
returns a null value.
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Reset User Password output variables  (continued)

Variable Description

body Contains a string value representing the 
output from the REST message.

status_code Contains the status code returned from the 
Web service.

Conditions

Reset User Password conditions

Condition Description

Success Activity reset the named user's password.

Failure Activity failed to reset the named user's 
password, or the activity failed to connect to 
Azure AD.

Exchange activity pack

The Exchange activity pack allows workflows to manage Microsoft  Exchange mail systems.

The use of Orchestration Exchange activities requires the following:

• Microsoft  Exchange 2010, 2013, or 2016.

• A MID Server configured to run Powershell 2.0

• A target Exchange server in the same Active Directory domain as the instance.

• Powershell Remoting enabled on the target Exchange server.

Note: 
These activities cannot be used to interact with Microsoft  Exchange Online.

Orchestration provides custom Exchange activities that were created with the Orchestration 
activity designer template. These activities perform the same functions as Exchange activities 
by the same name from previous releases and replace those activities for all new workflows. The 
custom Exchange activities were built with a Powershell activity template, which gives workflow 
administrators the ability to store input and output variables in the databus.

Note: 
Existing workflows from earlier versions that were created with legacy Exchange activities 
continue to function normally after an upgrade to Geneva. However, all new workflows must 
use these custom Exchange activities.

To use the Microsoft  Exchange custom activities, you must request activation  of the 
Orchestration - Exchange plugin. The custom Exchange activities are available in the Workflow 
Editor on the Custom  tab. Expand the Custom Activities  tree and select the Exchange  category 
for the activity you want to use.
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Accessing custom Exchange activities

Configure MID Server for Exchange

Configure a MID Server with defined IP ranges to use Exchange.

Before you begin
Role required: admin

About this task
If the MID Server manages resources within defined IP ranges, instead of all computers on your 
network, you must perform additional configuration steps to run Exchange activities. You do not 
need to perform these steps if your MID Server uses the default configuration.

Procedure

1. In the navigation filter, enter cmdb_ci_dns_name.list.

2. Click New.

3. Enter the fully-qualified domain name (FQDN) of your Exchange server in the Name  field.

4. Right-click the form header and select Save.
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5. In the IP Address  related list, click New.

6. In the IP Address  field, enter the IP address of your Exchange server.

7. In the Nic  field, select eth0  or your preferred network interface controller.

8. Leave the Netmask  field blank.

9. Click Submit.

Pass multivalued properties with an Exchange activity

To set a multivalued property using an Exchange activity, you must use a specific parameter 
format.

About this task
The Optional parameters shared input variable allows you to set multivalued properties .

Procedure

• To set a multivalued property, replacing any existing values, use this format: 
"PropertyName":"(value1, value2, value3)"

• To add values, use this format: "PropertyName":"+(value1, value2, value3);"

• To remove values, use this format: "PropertyName":"-(value1, value2, value3);"

• To both add and remove values, use this format: "PropertyName":"-(value1, value2, 
value3);+(value1, value2, value3);"

Create Address List activity

The Create Address List activity creates a new address list that acts as an alias for emailing all 
users in the group.

This alias cannot be used to manage user permissions. This activity implements the Microsoft 
Exchange New-AddressList  command.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Exchange  > Address List.

Note: 
This activity replaces an Exchange activity by the same name available in releases prior 
to Geneva. If you have a workflow created in a previous version that uses the deprecated 
activity, your workflow will continue to work normally after upgrading to Geneva. However, 
all new workflows must use the custom version of this activity. This activity was built with the 
PowerShell activity designer, which gives workflow administrators the ability to store input 
and output variables in the databus.

Input variables

Create Address List input variables

Variable Description

hostname The hostname of the Exchange server with which the activity interacts. Do not 
enter an IP address in this variable.

domain The name of the Exchange server's assigned domain.

name Name of the new address list to create.
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Create Address List input variables  (continued)

Variable Description

parameters Optional parameters to pass to the Exchange server written in JavaScript Object 
Notation (JSON). Exchange activities cannot pass parameters that reference an 
object, such as a PSCredential object. Plain text is automatically converted to 
SecureString objects for parameters that require that data type.

Attempting to save an activity that specifies duplicate parameters, including 
parameters from activity variables, or incorrectly formatted JSON causes a 
warning message to appear.

Note: 
When passing a switch parameter, such as ForceUpgrade, you must use the 
format "parameter":"true".

Output variables

Create Address List output variables

Variable Description

result Either success  or failure.

error Error message if the operation fails.

output Raw XML payload from the Exchange server. This data includes all Exchange 
attributes.

Conditions

Create Address List conditions

Condition Description

Success The activity succeeded in creating a new address list.

Failure The activity failed to create a new address list.

Delete Address List activity

The Delete Address List activity removes an existing address list from an Exchange server.

This activity implements the Microsoft  Exchange Remove-AddressList  command.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Exchange  > Address List.

Note: 
This activity replaces an Exchange activity by the same name available in releases prior 
to Geneva. If you have a workflow created in a previous version that uses the deprecated 
activity, your workflow will continue to work normally after upgrading to Geneva. However, 
all new workflows must use the custom version of this activity. This activity was built with the 
PowerShell activity designer, which gives workflow administrators the ability to store input 
and output variables in the databus.
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Input variables

Delete Address List input variables

Variable Description

hostname The hostname of the Exchange server with which the activity interacts. Do 
not enter an IP address in this variable.

domain The name of the Exchange server's assigned domain.

identity Name of the address list to remove.

domainController Fully-qualified domain name (FQDN) of the domain controller that writes to 
Active Directory.

recursive Check box that indicates if the activity should delete Active Directory 
elements that are children of the specified address list.

whatif Check box that indicates if the activity should stage the changes without 
applying them. Use this variable to test your activity settings before using 
the activity in a live workflow. When this variable is selected, the Exchange 
server does not make any changes but indicates if the command would 
succeed or fail. You can review any messages from the Exchange server 
using the ECC queue.

Output variables

Delete Address List output variables

Variable Description

result Either success  or failure.

error Error message if the operation fails.

Conditions

Delete Address List conditions

Condition Description

Success The activity succeeded in removing the address list from the Exchange server.

Failure The activity failed to remove the address list from the Exchange server.

Get Address List activity

The Get AddressList activity retrieves all attributes from the specified Exchange address list.

This activity implements the Microsoft  Exchange Get-AddressList  command.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Exchange  > Address List.
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Note: 
This activity replaces an Exchange activity by the same name available in releases prior 
to Geneva. If you have a workflow created in a previous version that uses the deprecated 
activity, your workflow will continue to work normally after upgrading to Geneva. However, 
all new workflows must use the custom version of this activity. This activity was built with the 
PowerShell activity designer, which gives workflow administrators the ability to store input 
and output variables in the databus.

Input variables

Get Address List input variables

Variables Description

hostname The hostname of the Exchange server with which the activity interacts. Do 
not enter an IP address in this variable.

domain The name of the Exchange server's assigned domain.

domainController Fully-qualified domain name (FQDN) of the domain controller that writes to 
Active Directory.

identity Name of the address list to get attributes from. If you enter a value in this 
variable, leave the container  and searchText  variables blank.

organization Organization to which the specified address list belongs.

searchText Filter text that causes the activity to return only results that contain this text. 
This variable can only be used with Exchange 2013 servers. If you enter a 
value in this variable, leave the container  and identity  variables blank.

container Parent address list of the address list from which you want to retrieve 
attributes. If you enter a value in this variable, leave the identity  and 
searchText  variables blank

Output variables

Get Address List output variables

Variables Descriptions

result Either success  or failure.

error Error message if the operation fails.

output Raw XML payload from the Exchange server. This data includes all Exchange 
attributes.

Conditions

Get Address List conditions

Condition Description

Success The activity succeeded in retrieving the attributes from the address list.

Failure The activity failed to retrieve the attributes from the address list.
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Move Address List activity

The Move Address List activity moves a Microsoft  Exchange address list to another location in 
the address hierarchy.

This activity implements the Microsoft  Exchange Move-AddressList  command.

The Exchange server caches the changes from this activity but does not immediately apply 
them. Use the Update Address List  activity after this activity to apply the changes or wait for the 
Exchange server to automatically apply cached changes.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Exchange  > Address List.

Note: 
This activity replaces an Exchange activity by the same name available in releases prior 
to Geneva. If you have a workflow created in a previous version that uses the deprecated 
activity, your workflow will continue to work normally after upgrading to Geneva. However, 
all new workflows must use the custom version of this activity. This activity was built with the 
PowerShell activity designer, which gives workflow administrators the ability to store input 
and output variables in the databus.

Input variables

Move Address List input variables

Variables Description

hostname The hostname of the Exchange server with which the activity interacts. Do 
not enter an IP address in this variable.

domain The name of the Exchange server's assigned domain.

identity Name of the address list to move.

target Path to the address list's new location.

domainController Fully-qualified domain name (FQDN) of the domain controller that writes to 
Active Directory.

whatif Check box that indicates if the activity should stage the changes without 
applying them. Use this variable to test your activity settings before using 
the activity in a live workflow. When this variable is selected, the Exchange 
server does not make any changes but indicates if the command would 
succeed or fail. You can review any messages from the Exchange server 
using the ECC queue.

Output variables

Move Address List output variables

Variable Description

result Either success  or failure.

error Error message if the operation fails.
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Conditions

Move Address List conditions

Condition Description

Success The activity succeeded in moving the address list to another location.

Failure The activity failed to move the address list to another location.

Set Address List activity

The Set Address List activity modifies a Microsoft  Exchange address list.

Use the Optional parameters variable to pass specific values to the Microsoft Exchange server. 
This activity implements the Microsoft  Exchange Set-AddressList  command.

The Exchange server caches the changes from this activity but does not immediately apply 
them. Use the Update Address List  after this activity to apply the changes or wait for the 
Exchange server to automatically apply cached changes.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Exchange  > Address List.

Note: 
This activity replaces an Exchange activity by the same name available in releases prior 
to Geneva. If you have a workflow created in a previous version that uses the deprecated 
activity, your workflow will continue to work normally after upgrading to Geneva. However, 
all new workflows must use the custom version of this activity. This activity was built with the 
PowerShell activity designer, which gives workflow administrators the ability to store input 
and output variables in the databus.

Input variables

Set Address List input variables

Variables Description

hostname The hostname of the Exchange server with which the activity interacts. Do not 
enter an IP address in this variable.

domain The name of the Exchange server's assigned domain.

identity Name of the address list to modify.

parameters Optional parameters to pass to the Exchange server written in JavaScript Object 
Notation (JSON). Exchange activities cannot pass parameters that reference an 
object, such as a PSCredential object. Plain text is automatically converted to 
SecureString objects for parameters that require that data type.

Attempting to save an activity that specifies duplicate parameters, including 
parameters from activity variables, or incorrectly formatted JSON causes a 
warning message to appear.

Note: 
When passing a switch parameter, such as ForceUpgrade, you must use the 
format "parameter":"true".
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Output variables

Set Address List output variables

Variable Description

result Either success  or failure.

error Error message if the operation fails.

Conditions

Set Address List conditions

Variable Description

Success The activity succeeded in modifying the specified address list.

Failure The activity failed to modify the specified address list.

Update Address List activity

The Update Address List activity adds or removes users from the specified address list and 
immediately applies any cached address list changes to the server.

Use the optional parameters variable to specify which users to add or remove. This activity 
implements the Microsoft  Exchange Update-AddressList  command.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Exchange  > Address List.

Note: 
This activity replaces an Exchange activity by the same name available in releases prior 
to Geneva. If you have a workflow created in a previous version that uses the deprecated 
activity, your workflow will continue to work normally after upgrading to Geneva. However, 
all new workflows must use the custom version of this activity. This activity was built with the 
PowerShell activity designer, which gives workflow administrators the ability to store input 
and output variables in the databus.

Input variables

Update Address List input variables

Variable Description

hostname The hostname of the Exchange server with which the activity interacts. Do 
not enter an IP address in this variable.

domain The name of the Exchange server's assigned domain.

identity Name of the address list to update.

domainController Fully-qualified domain name (FQDN) of the domain controller that writes to 
Active Directory.

whatif A check box that indicates if the activity should stage the changes without 
applying them. Use this variable to test your activity settings before using 
the activity in a live workflow. When this variable is selected, the Exchange 
server does not make any changes but indicates if the command would 
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Update Address List input variables  (continued)

Variable Description

succeed or fail. You can review any messages from the Exchange server 
using the ECC queue.

Output variables

Update Address List output variables

Variable Description

result Either Success  or Failure.

error Error message if the operation fails.

Conditions

Update Address List conditions

Condition Description

Success The activity succeeded in adding or removing users from the specified address list.

Failure The activity failed to add or remove users from the specified address list.

Create Mailbox activity

The Create Mailbox activity creates a new Active Directory user, if that user does not already 
exist, and a Microsoft  Exchange mailbox for that user.

This activity implements the Microsoft  Exchange New-Mailbox  command.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Exchange  > Mailbox.

Note: 
This activity replaces an Exchange activity by the same name available in releases prior 
to Geneva. If you have a workflow created in a previous version that uses the deprecated 
activity, your workflow will continue to work normally after upgrading to Geneva. However, 
all new workflows must use the custom version of this activity. This activity was built with the 
PowerShell activity designer, which gives workflow administrators the ability to store input 
and output variables in the databus.

Input variables

Create Mailbox input variables

Variable Description

hostname The hostname of the Exchange server with which the activity interacts. Do not 
enter an IP address in this variable.

domain The name of the Exchange server's assigned domain.
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Create Mailbox input variables  (continued)

Variable Description

Important: 
The MID Server must be in the same domain as the Exchange server.

first_name First name of the user.

middle_initial Middle initial of the user.

last_name Last name of the user.

alias The display name for the mailbox address, the part of the email address to the 
left of the @ symbol. If no alias is specified, the activity uses First name.Last 
name as the alias. The alias is also used as the user's principal name (UPN) if 
none is specified in the optional parameters.

password Password to use for the new mailbox. The password is encrypted when it is sent 
to the target host.

parameters Optional parameters to pass to the Exchange server written in JavaScript Object 
Notation (JSON). Exchange activities cannot pass parameters that reference an 
object, such as a PSCredential object. Plain text is automatically converted to 
SecureString objects for parameters that require that data type.

Attempting to save an activity that specifies duplicate parameters, including 
parameters from activity variables, or incorrectly formatted JSON causes a 
warning message to appear.

Note: 
When passing a switch parameter, such as ForceUpgrade, you must use 
the format "parameter":"true".

Output variables

Create Mailbox output variables

Variable Description

result Either success  or failure.

error Error message if the operation fails.

output Raw XML payload from the Exchange server. This data includes all Exchange 
attributes.

Conditions

Create Mailbox conditions

Condition Description

Success The activity succeeded in creating a new mailbox for the specified user. If no Active 
Diectory account existed for that user, this activity succeeded in creating a new 
account.
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Create Mailbox conditions  (continued)

Condition Description

Failure The activity failed to create a new mailbox or an Active Directory account for the 
specified user.

Delete Mailbox activity

The Delete Mailbox activity deletes the Microsoft  Exchange mailbox of an Active Directory user.

Optional parameters determine how the Exchange server handles the mailbox after deleting the 
user. This activity implements the Microsoft  Exchange Remove-Mailbox  command.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Exchange  > Mailbox.

Note: 
This activity replaces an Exchange activity by the same name available in releases prior 
to Geneva. If you have a workflow created in a previous version that uses the deprecated 
activity, your workflow will continue to work normally after upgrading to Geneva. However, 
all new workflows must use the custom version of this activity. This activity was built with the 
PowerShell activity designer, which gives workflow administrators the ability to store input 
and output variables in the databus.

Input variables

Delete Mailbox input variables

Variable Description

hostname The hostname of the Exchange server with which the activity interacts. Do not 
enter an IP address in this variable.

domain The name of the Exchange server's assigned domain.

user Active Directory user to delete. The activity passes this value to Exchange as the 
Identity Exchange variable.

parameters Optional parameters to pass to the Exchange server written in JavaScript Object 
Notation (JSON). Exchange activities cannot pass parameters that reference an 
object, such as a PSCredential object. Plain text is automatically converted to 
SecureString objects for parameters that require that data type.

Attempting to save an activity that specifies duplicate parameters, including 
parameters from activity variables, or incorrectly formatted JSON causes a 
warning message to appear.

Note: 
When passing a switch parameter, such as ForceUpgrade, you must use the 
format "parameter":"true".
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Output variables

Delete Mailbox output variables

Variable Description

result Either success  or failure.

error Error message if the operation fails.

Conditions

Delete Mailbox conditions

Condition Description

Success The activity succeeded in deleting the specified user's mailbox.

Failure The activity failed to delete the specified user's mailbox.

Disable Mailbox activity

The Disable Mailbox activity disables the mailbox associated with a specified Active Directory 
account.

This activity implements the Microsoft  Exchange Disable-Mailbox  command.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Exchange  > Mailbox.

Note: 
This activity replaces an Exchange activity by the same name available in releases prior 
to Geneva. If you have a workflow created in a previous version that uses the deprecated 
activity, your workflow will continue to work normally after upgrading to Geneva. However, 
all new workflows must use the custom version of this activity. This activity was built with the 
PowerShell activity designer, which gives workflow administrators the ability to store input 
and output variables in the databus.

Input variables

Disable Mailbox input variables

Variable Description

hostname The hostname of the Exchange server with which the activity interacts. Do not 
enter an IP address in this variable.

domain The name of the Exchange server's assigned domain.

user Active Directory user who's mailbox should be disabled. The activity passes this 
value to Exchange as the Identity Exchange variable.

parameters Optional parameters to pass to the Exchange server written in JavaScript Object 
Notation (JSON). Exchange activities cannot pass parameters that reference an 
object, such as a PSCredential object. Plain text is automatically converted to 
SecureString objects for parameters that require that data type.
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Disable Mailbox input variables  (continued)

Variable Description

Attempting to save an activity that specifies duplicate parameters, including 
parameters from activity variables, or incorrectly formatted JSON causes a 
warning message to appear.

Note: 
When passing a switch parameter, such as ForceUpgrade, you must use the 
format "parameter":"true".

Output variables

Disable Mailbox output variables

Variable Description

result Either success  or failure.

error Error message if the operation fails.

Conditions

Disable Mailbox conditions

Condition Description

Success The activity succeeded in disabling the specified mailbox.

Failure The activity failed to disable the specified mailbox.

Enable Mailbox activity

The Enable Mailbox activity creates a new mailbox for an existing Active Directory user.

This activity implements the Microsoft  Exchange Enable-Mailbox  command.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Exchange  > Mailbox.

Note: 
This activity replaces an Exchange activity by the same name available in releases prior 
to Geneva. If you have a workflow created in a previous version that uses the deprecated 
activity, your workflow will continue to work normally after upgrading to Geneva. However, 
all new workflows must use the custom version of this activity. This activity was built with the 
PowerShell activity designer, which gives workflow administrators the ability to store input 
and output variables in the databus.

Input variables

Enable Mailbox input variables

Variable Description

hostname The hostname of the Exchange server with which the activity interacts. Do not 
enter an IP address in this variable.
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Enable Mailbox input variables  (continued)

Variable Description

domain The name of the Exchange server's assigned domain.

user Active Directory user who's mailbox should be enabled. The activity passes this 
value to Exchange as the Identity Exchange variable.

parameters Optional parameters to pass to the Exchange server written in JavaScript Object 
Notation (JSON). Exchange activities cannot pass parameters that reference an 
object, such as a PSCredential object. Plain text is automatically converted to 
SecureString objects for parameters that require that data type.

Attempting to save an activity that specifies duplicate parameters, including 
parameters from activity variables, or incorrectly formatted JSON causes a 
warning message to appear.

Note: 
When passing a switch parameter, such as ForceUpgrade, you must use the 
format "parameter":"true".

Output variables

Enable Mailbox output variables

Variable Description

result Either success  or failure.

error Error message if the operation fails.

Conditions

Enable Mailbox conditions

Condition Description

Success The activity succeeded in creating a new mailbox for the specified user.

Failure The activity failed to create a new mailbox for the specified user.

Get Mailbox activity

The Get Mailbox activity gets the mailbox for the specified user or all mailboxes on a Microsoft 
Exchange server.

This activity implements the Microsoft  Exchange Get-Mailbox  command.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Exchange  > Mailbox.

Note: 
This activity replaces an Exchange activity by the same name available in releases prior 
to Geneva. If you have a workflow created in a previous version that uses the deprecated 
activity, your workflow will continue to work normally after upgrading to Geneva. However, 
all new workflows must use the custom version of this activity. This activity was built with the 
PowerShell activity designer, which gives workflow administrators the ability to store input 
and output variables in the databus.
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Input variables

Get Mailbox input variables

Variable Description

hostname The hostname of the Exchange server with which the activity interacts. Do not 
enter an IP address in this variable.

domain The name of the Exchange server's assigned domain.

user User whose mailbox this activity should retrieve. If no user is specified, the activity 
gets all mailboxes on the Exchange server. The activity passes this value to 
Exchange as the Identity Exchange variable.

parameters Optional parameters to pass to the Exchange server written in JavaScript Object 
Notation (JSON). Exchange activities cannot pass parameters that reference an 
object, such as a PSCredential object. Plain text is automatically converted to 
SecureString objects for parameters that require that data type.

Attempting to save an activity that specifies duplicate parameters, including 
parameters from activity variables, or incorrectly formatted JSON causes a 
warning message to appear.

Note: 
When passing a switch parameter, such as ForceUpgrade, you must use the 
format "parameter":"true".

Output variables

Get Mailbox output variables

Variable Description

result Either success  or failure.

error Error message if the operation fails.

output Raw XML payload from the Exchange server. This data includes all Exchange 
attributes.

Conditions

Get Mailbox conditions

Condition Description

Success The activity succeeded in retrieving the attributes of the specified mailbox.

Failure The activity failed to retrieve the attributes of the specified mailbox.

Set Mailbox activity

The Set Mailbox activity modifies the settings of an existing Microsoft  Exchange mailbox.

Use the optional parameters variable to pass specific values to the Exchange server. This activity 
implements the Microsoft  Exchange Set-Mailbox  command.
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To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Exchange  > Mailbox.

Note: 
This activity replaces an Exchange activity by the same name available in releases prior 
to Geneva. If you have a workflow created in a previous version that uses the deprecated 
activity, your workflow will continue to work normally after upgrading to Geneva. However, 
all new workflows must use the custom version of this activity. This activity was built with the 
PowerShell activity designer, which gives workflow administrators the ability to store input 
and output variables in the databus.

Input variables

Set Mailbox input variables

Variable Description

hostname The hostname of the Exchange server with which the activity interacts. Do not 
enter an IP address in this variable.

domain The name of the Exchange server's assigned domain.

user Active Directory user whose mailbox you want to modify. The activity passes this 
value to Exchange as the Identity Exchange variable.

parameters Optional parameters to pass to the Exchange server written in JavaScript Object 
Notation (JSON). Exchange activities cannot pass parameters that reference an 
object, such as a PSCredential object. Plain text is automatically converted to 
SecureString objects for parameters that require that data type.

Attempting to save an activity that specifies duplicate parameters, including 
parameters from activity variables, or incorrectly formatted JSON causes a 
warning message to appear.

Note: 
When passing a switch parameter, such as ForceUpgrade, you must use the 
format "parameter":"true".

Output variables

Set Mailbox output variables

Variable Description

result Either success  or failure.

error Error message if the operation fails.

Conditions

Set Mailbox conditions

Conditions Description

Success The activity succeeded in modifying the settings of the specified mailbox.

Failure The activity failed to modify the settings of the specified mailbox.
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F5 Network Management activity pack

Orchestration provides custom activities for configuring elements of an F5 load balancer, 
including pools, pool members, and the virtual servers contained in the pool.

All F5 custom activities are in the F5 Network Management Application Application scope  and 
are activated by the Orchestration - F5 network management plugin, which must be activated by 
request.

ServiceNow  provides custom F5 activities, built from the REST web service activity template, that 
you can use to perform the following tasks:

• Add, delete, or verify pools.

• Add, delete, or identify pool members.

• Add or delete virtual servers.

• Add a profile to a virtual server.

• Configure the virtual server for vlans, irules, pool, and persistence.

Add F5 Pool Member activity

The Add F5 Pool Member activity adds a member to an F5 load balancer pool.

This activity was built using the REST web service activity template. To access the activity in 
the Workflow Editor, select the Custom  tab, and then navigate to Custom Activities  > Active 
Directory.

REST settings

• REST message: F5 POOL Membership Management

• REST function: post

Input variables

Add F5 Pool Member input variables

Variable Description

PoolName Name of this pool, such as testPool.

F5IPAddress IP address of the F5 console.

MemberName Pool member IP address and port, such as 
192.168.2.19:80.

Output variables

Add F5 Pool Member output variables

Variable Description

result Success or failure.

status_code The HTTP status code.

error The REST error.

output The REST output.
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Conditions

Add F5 Pool Member conditions

Condition Description

Success Activity successfully added an F5 load 
balancer pool member.

Failure Activity failed to add an F5 load balancer pool 
member.

Get F5 Pool Member activity

The Get F5 Pool Member activity returns the pool members and verifies the pool's status.

Use this activity to verify that a pool member was created properly.

This activity was built using the REST web service activity template. To access the activity in 
the Workflow Editor, select the Custom  tab, and then navigate to Custom Activities  > Active 
Directory.

REST settings

• REST message: F5 POOL Membership Management

• REST function: get

Input variables

Get F5 Pool Member input variables

Variable Description

PoolName Name of this pool, such as testPool.

F5IPAddress IP address of the F5 console.

Output variables

Get F5 Pool Member output variables

Variable Description

MembersArray Array for the returned pool member IP address 
and port, such as 192.168.2.19:80.

status_code The HTTP status code.

error The REST error.

result Success or failure.

output The REST output.
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Conditions

Get F5 Pool Member conditions

Condition Description

Success Activity successfully returned the F5 load 
balancer pool members.

Failure Activity failed to return the F5 load balancer 
pool members

Delete F5 Virtual Server activity

The Delete F5 Virtual Server activity deletes a virtual server from an F5 load balancer pool.

This activity was built using the REST web service activity template. To access the activity in 
the Workflow Editor, select the Custom  tab, and then navigate to Custom Activities  > Active 
Directory.

REST settings

• REST message: F5 VIP Management

• REST function: delete

Input variables

Delete F5 Virtual Server input variables

Variable Description

F5IPAddress IP address of the F5 console.

name The virtual server's name, such as testVIP.

Output variables

Delete F5 Virtual Server output variables

Variable Description

result Success or failure.

status_code The HTTP status code.

Conditions

Delete F5 Virtual Server conditions

Condition Description

Success Activity successfully deleted the virtual server 
from the F5 load balancer pool.

Failure Activity failed to delete the virtual server from 
the F5 load balancer pool.
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Check F5 Pool activity

The Check F5 Pool activity checks the status of a pool to determine if it is available to accept 
traffic.

Use this activity to determine if a pool you just created is up and running with the proper 
configuration.

This activity was built using the REST web service activity template. To access the activity in 
the Workflow Editor, select the Custom  tab, and then navigate to Custom Activities  > Active 
Directory.

REST settings

• REST message: F5 POOL Management

• REST function: get

Input variables

Check F5 Pool input variables

Variable Description

F5IPAddress IP address of the F5 console.

PoolName Name of this pool, such as testPool.

Output variables

Check F5 Pool output variables

Variable Description

result Success or failure.

status_code The HTTP status code.

error The REST error.

Conditions

Check F5 Pool conditions

Condition Description

Success Activity successfully returned the status of the 
F5 load balancer pool.

Failure Activity failed to return the status of the F5 
load balancer pool.

Add F5 Profile to Virtual Server activity

The Add F5 Profile to Virtual Server activity adds a profile to a virtual server assigned to an F5 
load balancer pool.
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This activity was built using the REST web service activity template. To access the activity in 
the Workflow Editor, select the Custom  tab, and then navigate to Custom Activities  > Active 
Directory.

REST settings

• REST message: F5 VIP Profile Management

• REST function: post

Input variables

Add F5 Profile to Virtual Server input variables

Variable Description

name The virtual server's name, such as testVIP

F5IPAddress IP address of the F5 console.

VirtualServerName Name of the virtual server, such as testVIP.

Output variables

Add F5 Profile to Virtual Server output variables

Variable Description

result Success or failure.

output The REST output.

status_code The HTTP status code.

Condtions

Add F5 Profile to Virtual Server conditions

Condition Description

Success Activity successfully added the F5 load 
balancer profile to the virtual server.

Failure Activity failed to add the F5 load balancer 
profile to the virtual server.

Modify F5 Virtual Server activity

The Modify F5 Virtual Server activity configures a virtual server assigned to an F5 load balancer 
pool with irules and a vlan.

This activity was built using the REST web service activity template. To access the activity in 
the Workflow Editor, select the Custom  tab, and then navigate to Custom Activities  > Active 
Directory.
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REST settings

• REST message: F5 VIP Management

• REST function: put

Input variables

Modify F5 Virtual Server input variables

Variable Description

name The virtual server's name, such as testVIP.

F5IPAddress IP address of the F5 console.

irules The irules for the virtual server, such as 
_sys_https_redirect.

• pool: Name of the pool for the virtual server, 
such as testPool.

• persistent: Persistent profile for the virtual 
server, such as cookie.

vlans Vlans for the virtual server, such as 
internal.

Output variables

Modify F5 Virtual Server output variables

Variable Description

result Success or failure.

status_code The HTTP status code.

output The REST output.

Conditions

Modify F5 Virtual Server conditions

Condition Description

Success Activity successfully configured a virtual 
server assigned to an F5 load balancer pool.

Failure Activity failed to configure a virtual server 
assigned to an F5 load balancer pool.

Add F5 Virtual Server activity

The Add F5 Virtual Server activity adds a virtual server.

This activity was built using the REST web service activity template. To access the activity in 
the Workflow Editor, select the Custom  tab, and then navigate to Custom Activities  > Active 
Directory.
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REST settings

• REST message: F5 POOL Membership Management

• REST function: post

Input variables

Add F5 Virtual Server input variables

Variable Description

name The virtual server's name, such as testVIP.

description Description of this virtual server.

ipProtocol Protocol used for this virtual server, such as 
tcp.

destination Virtual server IP address and port number, 
such as 192.168.4.20:80.

mask Subnet mask for this virtual server, such as 
255.255.255.255.

F5IPAddress IP address of the F5 console.

sourceAddressTranslation Source address translation mode.

Output variables

Add F5 Virtual Server output variables

Variable Description

result Success or failure.

status_code The HTTP status code.

error The REST error.

output The REST output.

Conditions

Add F5 Virtual Server conditions

Condition Decription

Success Acitivty successfully added a virtual server.

Failure Activity failed to add a virtual server.

Delete F5 Pool Member activity

The Delete F5 Pool Member activity deletes an F5 load balancer pool member.

This activity was built using the REST web service activity template. To access the activity in 
the Workflow Editor, select the Custom  tab, and then navigate to Custom Activities  > Active 
Directory.
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REST settings

• REST message: F5 POOL Membership Management

• REST function: delete

Input variables

Delete F5 Pool Member input variables

Variable Description

PoolName Name of this pool, such as testPool.

F5IPAddress IP address of the F5 console.

MemberName Pool member IP address and port, such as 
192.168.2.19:80.

Output variables

Delete F5 Pool Member output variables

Variable Description

result Success or failure.

status_code The HTTP status code.

error The REST error.

Conditions

Delete F5 Pool Member output variables

Condition Description

Success Acivity succeeded in deleting an F5 load 
balancer pool member.

Failure Acivity failed to delete an F5 load balancer 
pool member.

Delete F5 Pool activity

The Delete F5 Pool activity deletes an F5 load balancer pool.

This activity was built using the REST web service activity template. To access the activity in 
the Workflow Editor, select the Custom  tab, and then navigate to Custom Activities  > Active 
Directory.

REST settings

• REST message: F5 POOL Management

• REST function: delete
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Input variables

Delete F5 Pool input variables

Variable Description

F5IPAddress IP address of the F5 console.

PoolName Name of this pool, such as testPool.

Output variables

Delete F5 Pool output variables

Variable Description

result Success or failure.

error The REST error.

status_code The HTTP status code.

Conditions

Delete F5 Pool conditions

Condition Description

Success Activity successfully deleted the F5 load 
balancer pool.

Failure Activity failed to delete the F5 load balancer 
pool.

Add F5 Pool activity

The Add F5 Pool activity creates the F5 load balancer pool.

Use this activity to verify that a pool member was created properly.

This activity was built using the REST web service activity template. To access the activity in 
the Workflow Editor, select the Custom  tab, and then navigate to Custom Activities  > Active 
Directory.

REST settings

• REST message: F5 POOL Management

• REST function: post

Input variables

Add F5 Pool input variables

Variable Description

PoolName Name of this pool, such as testPool.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

4968



Add F5 Pool input variables  (continued)

Variable Description

F5IPAddress IP address of the F5 console.

MemberName Pool member IP address and port, such as 
192.168.2.19:80.

Output variables

Add F5 Pool output variables

Variable Description

result Success or failure.

status_code The HTTP status code.

error The REST error.

output The REST output.

Conditions

Add F5 Pool conditions

Condition Description

Success Activity succeeded in creating the F5 load 
balancer pool.

Failure Activity failed to create the F5 load balancer 
pool.

Infoblox DDI activity pack

This activity pack supports Infoblox DDI management through ServiceNow  Orchestration.

The Infoblox DDI activity pack manages the IP addresses used in a network by integrating DNS 
and DHCP. Custom Orchestration activities use Infoblox Web API (WAPI) REST web services to 
access the Infoblox GRID server.

Important: 
Managing IP addresses through the Infoblox server requires a fully functional MID Server.

Starting with the Jakarta release, the Infoblox activity pack updates to version 2. This update 
supports Infoblox network views, which can restrict the visibility of network data. The view 
parameter can be passed as a query parameter or payload content, to do operations in a specific 
view. Version 2 also supports specifying the version of WAPI to use in integration endpoints.

Supported for Infoblox:

• WAPI version 2.0 for REST messages

• NIOS appliance version 7.0

Note: 
To use the Infoblox DDI activities and workflow, you must request activation  of the 
Orchestration - Infoblox DDI Activty Pack plugin.
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Create a REST credential for Infoblox activities

All Infoblox activities require a REST credential to manage IP addresses from the Infoblox DDI 
server.

Before you begin
Before starting this procedure, make sure you have the following:

• A properly configured and running Infoblox DDI Grid Server.

• REST credentials defined on the Infoblox DDI server.

Role required: admin

About this task
You must create a REST credential record on the ServiceNow  instance that each Infoblox activity 
can use to access management features on the Infoblox server.

Procedure

1. Navigate to All  > Orchestration  > Credentials  and click New.

2. In the list of credential types, select Basic Auth Credentials.

3. Create the credential record with a logical name, such as InfobloxCred.

4. Right-click in the header bar of your new credential record and select Copy sys_id  from the 
context menu.
Follow browser instructions to copy the sys_id if browser security measures restrict this 
function.

5. Paste the sys_id into the restCredentials  input field of each activity you use.

Infoblox workflows

The Infobox DDI activity pack includes two default workflows, one that reserves and registers IP 
addresses and another that releases IP addresses.

To access these workflows, navigate to Workflow  > Workflow Editor  and select the Workflows 
tab. Click on a workflow to open it, and then click the information icon in the workflow header to 
display the properties dialog box.

Infoblox Reserve/Register IP in IPAM

Use this workflow to register IPv4 addresses or request the next available IP address on IPAM. 
Optionally, you can use it to register IP addresses on DNS. The custom Infoblox activities used in 
this workflow are:

• IPAM Register IP Address

• IPAM Reserve IP Address

• Register DNS A-Record

• Get Network Details

Infoblox Reserve/Register IP input variables

Field Description

Infoblox Server IP address of the Infoblox DDI server.

Network Network containing the target IP address.
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Infoblox Reserve/Register IP input variables  (continued)

Field Description

Zone The DNS zone for the IP address being registered.

Rest 
Credentials

The sys_id of the REST credentials from the ServiceNow  instance.

DNS Host Name Name of the DNS server machine on which the IP address is being 
registered.

IPv4 Address IP address being reserved or registered.

Infoblox Release IPAM Reservations

Use this workflow to release (delete) all the IPAM reservations associated with an IPv4 address. 
The custom Infoblox activities used in this workflow are:

• IPAM List IP Reservations

• List DNS Record

• DNS Delete

• IPAM Delete

Infoblox Release IPAM Reservations input variables

Field Description

Rest Credentials The sys_id of the REST credentials from the ServiceNowinstance.

IP to Delete IP address to release.

Infoblox Server IP address of the Infoblox DDI server.

Infoblox roles and permissions

Define the roles and permissions that the Infoblox activities need to access the various 
resources on the Infoblox server.

Admin groups

There are three types of admin groups on an Infoblox server:

• Superuser

• Default

• Limited Access

To perform specific operations on the Infoblox server, the Limited Access user must have a 
minimum set of privileges for the desired resources, using either the user interface or an API. 
These privileges are based on read and read/write access. For more information, refer to the 
"About Admin Groups" section in the Infoblox NIOS Administrator Guide.
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Permission hierarchy

1. User: A user can be part of multiple groups.

2. Group: A group can have many roles.

3. Role: Each role consistes of specific resource permissions.

Required permissions

The ServiceNow Infoblox activity pack requires appropriate read and read/write privileges for 
these resources:

• Network

• DHCP

• DNS

• IPAM

This example shows a default DHCP admin role, its resources, and the related permissions for 
each.

Infoblox permissions

Infoblox DHCP activities

The Infoblox DHCP activities manage the IP addresses reserved for DHCP in your network.

Use these activities to reserve, list, or delete IP addresses that are used for DHCP assignment in 
your network.

DHCP Reserve IP v4 Address Range activity

The DHCP Reserve IP v4 Address Range activity reserves an IP address range for DHCP use.

The DHCP activities use the REST web service activity template  to manage IP addresses using 
an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST 
capabilities.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Infoblox DDI  > DHCP.
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Input variables

DHCP Reserve IP v4 Address Range input variables

Variable Description

InfobloxServer Name of the Infoblox DDI Grid Server.

startIpAddress Beginning IPv4 address of the range to reserve.

endIpAddress Ending IPv4 address of the range to reserve.

restCredentials The sys_id of the REST credentials from the ServiceNow  instance.

api_version Defines the version of WAPI to use for the integration endpoints. The default 
value is 2.0.

Note: 
This field is mandatory. If the field is empty, the orchestration activity will 
fail.

view Name of the Infoblox network view. The default value is default.

Note: 
If the field is empty, the operation is treated as happening in the default 
view.

Output variables

DHCP Reserve IP v4 Address Range output variables

Variable Description

DHCPIpAddressRange Range of reserved IPv4 addresses.

error Displays the message for any REST error encountered.

Conditions

DHCP Reserve IP v4 Address Range conditions

Variable Description

Success Activity successfully reserved the specified IPv4 address range.

Failure Activity failed to reserve the specified IPv4 address range.

DHCP Delete IP Reservation activity

The DHCP Delete IP Reservation activity deletes IP reservations in DHCP using either an IPv4 or 
IPv6 address range.

An automation can obtain an Infoblox DHCP object to delete from either of these activities:

• DHCP List IP Reservations

• DHCP Reserve IPv4 Address Range
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The DHCP activities use the REST web service activity template  to manage IP addresses using 
an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST 
capabilities.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Infoblox DDI  > DHCP.

Input variables

DHCP Delete IP Reservation input variables

Variable Description

InfobloxServer Name of the Infoblox DDI Grid Server.

ipToDelete IP address range to delete, in the form:

range/<encrypted code>:<start range>/<end range>/
default

restCredentials The sys_id of the REST credentials from the ServiceNow  instance.

api_version Defines the version of WAPI to use for the integration endpoints. The default 
value is 2.0.

Note: 
This field is mandatory. If the field is empty, the orchestration activity will 
fail.

Output variables

DHCP Delete IP Reservation output variables

Variable Description

DHCPDeletedIpRange Range of deleted IP addresses.

error Displays the message for any REST error encountered.

Conditions

DHCP Delete IP Reservation conditions

Variable Description

Success Activity successfully deleted the specified IP address range.

Failure Activity failed to delete the specified IP address range.

DHCP List IP Reservations activity

The DHCP List IP Reservations activity generates a list of all the DHCP range reservations on a 
specific InfoBlox server.

The DHCP activities use the REST web service activity template  to manage IP addresses using 
an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST 
capabilities.
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To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Infoblox DDI  > DHCP.

Input variables

DHCP List IP Reservations input variables

Variable Description

InfobloxServer Name of the Infoblox DDI Grid Server.

restCredentials The sys_id of the REST credentials from the ServiceNow  instance.

api_version Defines the version of WAPI to use for the integration endpoints. The default 
value is 2.0.

Note: 
This field is mandatory. If field is empty, the orchestration activity will fail.

view Name of the Infoblox network view. The default value is default.

Note: 
If the field is empty, the operation is treated as happening with no view 
and returns the values with data from all views.

Output variables

DHCP List IP Reservations output variables

Variable Description

reference Reference value for an array of DHCP address ranges in this format: range/
<encrypted code>:<start range>/<end range>/default

network Address of the network containing the IP address range.

network_view Routing doman associated with the network returned.

Conditions

DHCP List IP Reservations conditions

Variables Description

Success Activity successfully returned an array of DHCP IP address ranges.

Failure Activity failed to return an array of DHCP IP address ranges.

Infoblox DNS activities

The Infoblox DNS activities manage DNS records in your network using an Infoblox DDI Grid 
Server.

Use these activities to register, list, or delete DNS records managed on an Infoblox server.
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List DNS C-records activity

The List DNS C-records activity retrieves all canonical (CNAME) records from a specified Infoblox 
server.

The DNS activities use the REST web service activity  template to manage DNS records using 
an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST 
capabilities.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Infoblox DDI  > DNS.

Input variables

List DNS C-records input variables

Variable Description

InfobloxServer Name of the Infoblox DDI Grid Server.

restCredentials The sys_id of the REST credentials from the ServiceNow  instance.

api_version Defines the version of WAPI to use for the integration endpoints. The default 
value is 2.0.

Note: 
This field is mandatory. If field is empty, the orchestration activity will fail.

view Name of the Infoblox network view. The default value is default.

Note: 
If the field is empty, the operation is treated as happening with no view 
and returns the values with data from all views.

Output variables

List DNS C-records output variables

Variable Description

error Displays the message for any REST error encountered.

reference Reference value for a DNS CNAME record, such as: record:cname/
ZG5zLmJpbmRfY25hbWUkLl9kZWZhdWx0LmNvbS50ZXN0LmNuYW1l:cname.test.com/
default

cannonicalName CNAME record.

name Name of the network option returned, such as domain-name-server.

view The assigned view of the DNS data. A given zone can have multiple views, which are accessed 
depending on the IP address of the source of the query. The default  view of DNS data for this 
activity is the network view.
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Conditions

List DNS C-records conditions

Variable Description

Success Activity successfully listed the DNS C records.

Failure Activity failed to list the DNS C records.

Register DNS A-record activity

The Register DNS A-record activity creates a DNS A record on a specified Infoblox server.

The DNS activities use the REST web service activity  template to manage DNS records using 
an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST 
capabilities.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Infoblox DDI  > DNS.

Input variables

Register DNS A-record input variables

Variable Description

InfobloxServer Name of the Infoblox DDI Grid Server.

network Address of the network containing the IP address to register in the record.

hostName Name of the actual server machine associate with the IP address in this 
record.

zone The DNS zone associated with the record being created.

ipAddress Specific IP address registered in this record.

restCredentials The sys_id of the REST credentials from the ServiceNow  instance.

api_version Defines the version of WAPI to use for the integration endpoints. The default 
value is 2.0.

Note: 
This field is mandatory. If the field is empty, the orchestration activity will 
fail.

view Name of the Infoblox network view. The default value is default.

Note: 
If the field is empty, the operation is treated as happening in the default 
view.
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Output variables

Register DNS A-record output variables

Variable Description

error Displays the message for any REST error encountered.

DNSARecord Name of the record registered, expressed in the format: record:host/
<encrypted code>:<network name>/default.

Conditions

Register DNS A-record conditions

Variable Description

Success Activity successfully created the DNS A record.

Failure Activity failed to create the DNS A record.

Register DNS C-Record activity

The Register DNS C-Record activity creates a DNS canonical (CNAME) record on a specified 
Infoblox server.

The DNS activities use the REST web service activity  template to manage DNS records using 
an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST 
capabilities.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Infoblox DDI  > DNS.

Input variables

Register DNS C-Record input variables

Variable Description

InfobloxServer Name of the Infoblox DDI Grid Server.

cname The DNS cannonical record to create, as expressed by the c_name  value.

recordName Name of the record to create.

zone The DNS zone containing the cannonical record to create.

restCredentials The sys_id of the REST credentials from the ServiceNow  instance.

api_version Defines the version of WAPI to use for the integration endpoints. The default 
value is 2.0.

Note: 
This field is mandatory. If the field is empty, the orchestration activity will 
fail.

view Name of the Infoblox network view. The default value is default.
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Register DNS C-Record input variables  (continued)

Variable Description

Note: 
If the field is empty, the operation is treated as happening in the default 
view.

Output variables

Register DNS C-Record output variables

Variable Desctiption

error Displays the message for any REST error encountered.

DNSCRecord Name of the CNAME record registered, expressed in the format: 
record:cname/<encrypted code>:<network name>/default.

Conditions

Register DNS C-Record conditions

Variable Description

Success Activity successfully created the cannonical DNS record.

Failure Activity failed to create the cannonical DNS record.

List DNS Record activity

The List DNS Record activity generates a list of all the DNS entries on a specific InfoBlox server.

The DNS activities use the REST web service activity  template to manage DNS records using 
an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST 
capabilities.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Infoblox DDI  > DNS.

Input variables

List DNS Record input variables

Variable Description

InfobloxServer Name of the Infoblox DDI Grid Server.

restCredentials The sys_id of the REST credentials from the ServiceNow  instance.

api_version Defines the version of WAPI to use for the integration endpoints. The default 
value is 2.0.

Note: 
This field is mandatory. If field is empty, the orchestration activity will fail.

view Name of the Infoblox network view. The default value is default.
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List DNS Record input variables  (continued)

Variable Description

Note: 
If the field is empty, the operation is treated as happening with no view 
and returns the values with data from all views.

Output variables

List DNS Record output variables

Variable Description

reference Reference value for a DNS record, such as: record:cname/
ZG5zLmJpbmRfY25hbWUkLl9kZWZhdWx0LmNvbS50ZXN0LmNuYW1l:cname.test.com/
default

configure_for_dhcp Returns the status of a DHCP fixed address object.

host Host machine with which the DNS record is associated.

ipv4addr The reserved IPv4 address associated with a DNS record.

name Name of the network option returned. For example, the name of the DNS record object from the 
reference  example is cname.test.com.

view The assigned view of the DNS data. A given zone can have multiple views, which are accessed 
depending on the IP address of the source of the query. The default  view of DNS data for this 
activity is the network view.

error Displays the message for any REST error encountered.

Conditions

List DNS Record conditions

Variable Description

Success Activity successfully listed all the available DNS record.

Failure Activity failed to list the available DNS record.

DNS Delete activity

The DNS Delete activity deletes DNS records of any type from in Infoblox server, such as C and A 
records.

The DNS activities use the REST web service activity  template to manage DNS records using 
an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST 
capabilities.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Infoblox DDI  > DNS.

Note: 
It is faster to create a new record than recover one that has been deleted.
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Input variables

DNS Delete input variables

Variable Description

InfobloxServer Name of the Infoblox DDI Grid Server.

RecordToDelete Name of the DNS record to delete. The record is expressed in this format:

record:cname/
ZG5zLmJpbmRfY25hbWUkLl9kZWZhdWx0LmNvbS50ZXN0LmNuYW1l:cname.test.com/
default

restCredentials The sys_id of the REST credentials from the ServiceNow  instance.

api_version Defines the version of WAPI to use for the integration endpoints. The default value is 2.0.

Note: 
This field is mandatory. If the field is empty, the orchestration activity will fail.

Output variables

DNS Delete output variables

Variable Description

DeletedRecord Name of the deleted DNS record.

error Displays the message for any REST error encountered.

Conditions

DNS Delete conditions

Variable Description

Success Activity successfully deleted the specified DNS record.

Failure Activity failed to delete the specified DNS record.

Infoblox IPAM activities

The Infoblox IPAM activities manage IP addresses in your network using an Infoblox DDI Grid 
Server.

Use these activities to register, reserve, list, or delete IP addresses.

IPAM Register IP Address activity

The IPAM Register IP Address activity registers an IP address in a network using Infoblox IPAM.

The output of this activity produces an InfoBlox IP address record that can be used for other 
IPAM functions in the format fixedaddress/<encrypted key>:<reserved ip 
address>/<view>.

The IPAM activities use the REST web service activity template  to manage IP addresses using 
an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST 
capabilities.
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To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Infoblox DDI  > IPAM.

Input variables

IPAM Register IP Address input variables

Variable Description

InfobloxServer Name of the Infoblox DDI Grid Server.

macAddress Mac address of the computer for which this IP address is registered.

ipAddress Specific IP address to register.

network Address of the network containing the registered IP address.

restCredentials The sys_id of the REST credentials from the ServiceNow  instance.

api_version Defines the version of WAPI to use for the integration endpoints. The default 
value is 2.0.

Note: 
This field is mandatory. If the field is empty, the orchestration activity will 
fail.

view Name of the Infoblox network view. The default value is default.

Note: 
If the field is empty, the operation is treated as happening in the default 
view.

Output variables

IPAM Register IP Address output variables

Variable Description

error Displays the message for any REST error encountered.

IPAddressRecord IPAM record of the registered IP address.

Conditions

IPAM Register IP Address conditions

Variable Description

Success Activity successfully registered the specified IP address.

Failure Activity failed to register the specified IP address.

IPAM Reserve IP Address activity

The IPAM Reserve IP Address activity reserves an IP address in a network using Infoblox IPAM.
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The output of this activity produces an InfoBlox IP address record that can be used for other 
IPAM functions in the format fixedaddress/<encrypted key>:<reserved ip 
address>/<view>.

The IPAM activities use the REST web service activity template  to manage IP addresses using 
an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST 
capabilities.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Infoblox DDI  > IPAM.

Input variables

IPAM Reserve IP Address input variables

Variable Description

InfobloxServer Name of the Infoblox DDI Grid Server.

macAddress Mac address of the computer for which this IP address is reserved.

network Address of the network containing the reserved IP address. The Infoblox 
server reserves the next available IP address from this network.

restCredentials The sys_id of the REST credentials from the ServiceNow  instance.

api_version Defines the version of WAPI to use for the integration endpoints. The default 
value is 2.0.

Note: 
This field is mandatory. If the field is empty, the orchestration activity will 
fail.

view Name of the Infoblox network view. The default value is default.

Note: 
If the field is empty, the operation is treated as happening in the default 
view.

Output variables

IPAM Reserve IP Address output variables

Variable Description

error Displays the message for any REST error encountered.

IPAddressRecord IPAM record of the reserved IP address.

IPAddress Selected IP address to reserve.
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Conditions

IPAM Reserve IP Address conditions

Variable Description

Success Activity successfully reserved the specified IP address.

Failure Activity failed to reserve the specified IP address.

IPAM List IP Reservations activity

The IPAM List IP Reservations activity returns an array of all IP Address within the named InfoBlox 
Server.

The IPAM activities use the REST web service activity template  to manage IP addresses using 
an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST 
capabilities.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Infoblox DDI  > IPAM.

Input variables

IPAM List IP Reservations input variables

Variable Description

InfobloxServer Name of the Infoblox DDI Grid Server.

restCredentials The sys_id of the REST credentials from the ServiceNow  instance.

api_version Defines the version of WAPI to use for the integration endpoints. The default 
value is 2.0.

Note: 
This field is mandatory. If field is empty, the orchestration activity will fail.

view Name of the Infoblox network view. The default value is default.

Note: 
If the field is empty, the operation is treated as happening with no view 
and returns the values with data from all views.

Output variables

The output of this activity produces an array of reserved IP addresses in the format 
fixedaddress/<encrypted key>:<reserved ip address>/<view>.

IPAM List IP Reservations output variables

Variable Description

reference Reference value of a reserved IP address contained 
in an array of addresses, such as fixedaddress/
ZG5zLmZpeGVkX2FkZHJlc3MkMTAuMC4xMDMuMTEuMC4u:0.0.0.11/
default" ipv4addr: "0.0.0.11"
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IPAM List IP Reservations output variables  (continued)

Variable Description

ipv4addr The reserved IPv4 address.

network_view Routing domain associated with the network returned.

error Displays the message for any REST error encountered.

Conditions

IPAM List IP Reservations conditions

Variable Description

Success Activity successfully retrieved the list of reserved IP addresses from the Infoblox 
server.

Failure Activity failed to retrieve the list of reserved IP addresses from the Infoblox server.

IPAM Delete activity

The IPAM Delete activity deletes an IP Address within a named InfoBlox server.

The IPAM activities use the REST web service activity template  to manage IP addresses using 
an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST 
capabilities.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Infoblox DDI  > IPAM.

Input variables

IPAM Delete input variables

Variable Description

InfobloxServer Name of the Infoblox DDI Grid Server.

itemToDelete The IP address to delete, in the format fixedaddress/<encrypted 
key>:<reserved ip address>/<view>.

restCredentials The sys_id of the REST credentials from the ServiceNow  instance.

api_version Defines the version of WAPI to use for the integration endpoints. The default 
value is 2.0.

Note: 
This field is mandatory. If the field is empty, the orchestration activity will 
fail.
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Output variables

IPAM Delete output variables

Variable Description

DeletedRecord IPAM record of the deleted IP address.

error Displays the message for any REST error encountered.

Conditions

IPAM Delete conditions

Variable Description

Success Activity successfully deleted the specified IP address.

Failure Activity failed to delete the specified IP address.

Infoblox network activities

The Infoblox network activities manage networks using an Infoblox DDI Grid Server.

Use these activities to create, list, or delete networks on an Infoblox server.

Create Network activity

The Create Network activity creates new networks on a specified Infoblox server.

The network activities use the REST web service activity template  to manage network addresses 
using an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST 
capabilities.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Infoblox DDI  > Network.

Input variables

Create Network input variables

Variable Description

InfobloxServer Name of the Infoblox DDI Grid Server.

network Address of the network to create.

restCredentials The sys_id of the REST credentials from the ServiceNow  instance.

api_version Defines the version of WAPI to use for the integration endpoints. The default 
value is 2.0.

Note: 
This field is mandatory. If the field is empty, the orchestration activity will 
fail.

view Name of the Infoblox network view. The default value is default.
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Create Network input variables  (continued)

Variable Description

Note: 
If the field is empty, the operation is treated as happening in the default 
view.

Output variables

Create Network output variables

Variable Description

NetworkCreated Address of the network created.

error Displays the message for any REST error encountered.

Conditions

Create Network conditions

Variable Description

Success Activity successfully created the network.

Failure Activity failed to create the network.

Get Network Details activity

The Get Network Details activity retrieves the information about a specific network on an Infoblox 
server.

The network activities use the REST web service activity template  to manage network addresses 
using an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST 
capabilities.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Infoblox DDI  > Network.

Input variables

Get Network Details input variables

Variable Description

InfobloxServer Name of the Infoblox DDI Grid Server.

network Address of the network whose details you want to see.

restCredentials The sys_id of the REST credentials from the ServiceNow  instance.

api_version Defines the version of WAPI to use for the integration endpoints. The default 
value is 2.0.
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Get Network Details input variables  (continued)

Variable Description

Note: 
This field is mandatory. If the field is empty, the orchestration activity will 
fail.

view Name of the Infoblox network view. The default value is default.

Note: 
If the field is empty, the operation is treated as happening in the default 
view.

Output variables

The output variables from this activity are objects on the Infoblox server used to identify network 
details. For more information, refer to the Infoblox documentation.

Get Network Details output variables

Variable Description

error Displays the message for any REST error encountered.

NetworkOptions The NetworkOptions  array contains these attributes:

• reference: Reference value for the network 
requested. This value is in the form of network/
ZG5zLm5ldHdvcmskMTAuMS4wLjAvMTYvMA:10.1.0.0%2F1

• options: The options  array contains these attributes:

◦ name: Name of the network option returned, such as domain-name-
server.

◦ num: Index number of the option. For example, the index for domain-
name-server  is 6.

◦ use_option: Indicates whether a DHCP option is used at that level in 
the network heirarchy. Set this value to True  to override the Grid Level 
DHCP option with this option at the network level.

◦ value: Value to use for this option. For example, the value for the 
domain-name-server  option is the IP address of the server 
machine.

◦ vendor_class: The class of the network object. The options are 
DHCP, DNS, or IPAM.

Conditions

Get Network Details conditions

Variable Description

Success Activity successfully retrieved network details from the Infoblox server.
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Get Network Details conditions  (continued)

Variable Description

Failure Activity failed to retrieve network details from the Infoblox server.

Delete Network activity

The Delete Network activity deletes a network from an Infoblox server.

The network activities use the REST web service activity template  to manage network addresses 
using an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST 
capabilities.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Infoblox DDI  > Network.

Input variables

Delete Network input variables

Variable Description

InfobloxServer Name of the Infoblox DDI Grid Server.

networkToDelete Reference number of the network to delete from the Infoblox 
server. You can obtain this value either by using the List Registered 
Networks activity or when creating a network with the Create Network 
activity. An example of the network reference value is: network/
ZG5zLm5ldHdvcmskMTUuMC40NS4wLzI0LzA:15.0.45.0/
24/default.

restCredentials The sys_id of the REST credentials from the ServiceNow  instance.

api_version Defines the version of WAPI to use for the integration endpoints. The default 
value is 2.0.

Note: 
This field is mandatory. If the field is empty, the orchestration activity 
will fail.

Output variables

Delete Network output variables

Variable Description

DeletedNetwork Reference number of the deleted network from the Infoblox server.

error Displays the message for any REST error encountered.
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Conditions

Delete Network conditions

Variable Description

Success Activity successfully deleted the network.

Failure Activity failed to delete the network.

List Registered Networks activity

The List Registered Networks activity retrieves all the networks associated with an Infoblox 
server.

The network activities use the REST web service activity template  to manage network addresses 
using an Infoblox DDI Grid Server. These activities are configured to use a MID Server with REST 
capabilities.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Infoblox DDI  > Network.

Input variables

Activity input variables

Variable Description

InfobloxServer Name of the Infoblox DDI Grid Server.

restCredentials The sys_id of the REST credentials from the ServiceNow  instance.

api_version Defines the version of WAPI to use for the integration endpoints. The default 
value is 2.0.

Note: 
This field is mandatory. If field is empty, the orchestration activity will fail.

view Name of the Infoblox network view. The default value is default.

Note: 
If the field is empty, the operation is treated as happening with no view 
and returns the values with data from all views.

Output variables

Activity output variables

Variable Description

reference Reference value of a registered network.

network Network address.

network_view Routing doman associated with the network returned.

error Displays the message for any REST error encountered.
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Conditions

Activity conditions

Variable Description

Success Activity successfully retrieved the list of registered networks available on the Infoblox 
server.

Failure Activity failed to retrieve the list of registered networks available on the Infoblox 
server.

PowerShell activity pack

PowerShell is built on the Windows .NET Framework and is designed to control and automate the 
administration of Windows  machines and applications.

Orchestration provides custom PowerShell activities that were created with the PowerShell 
activity designer template. These activities perform the same functions as PowerShell activities 
by the same name from previous releases and replace those activities for all new workflows. 
These custom activities give workflow administrators the ability to store input and output 
variables in the databus.

Note: 
Existing workflows from earlier versions that were created with legacy PowerShell activities 
continue to function normally after an upgrade to Geneva. However, all new workflows must 
use these custom PowerShell activities.

Starting with the Washington DC  release, there are the following updates to the PowerShell 
activity pack:

• A new PowerShell probe (V2), which takes advantage of Integration Hub  functionality

• The ability to insert debug statements in the PowerShell scripts and produce the resulting 
messages at runtime

To use the PowerShell custom activities, you must request activation  of the Orchestration - 
PowerShell plugin. These activities are available in the Workflow Editor on the Custom  tab. 
Expand the Custom Activities  tree and select the PowerShell category for the activity you want 
to use.

ServiceNow  supports PowerShell 3.0 to 5.1.

PowerShell activity designer

PowerShell activities are configured to return data to a workflow from a host using Microsoft 
PowerShell.

You must purchase Classic Orchestration  to use this template. For specific information about 
using the tools in the activity designer, refer to these resources:

• Orchestration activity designer

• Create input variables

• Create a parsing rule

ServiceNow  supports PowerShell 3.0 to 5.1.
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PowerShell protocols and troubleshooting

PowerShell uses the Windows Management Instrumentation (WMI) and Windows Remote 
Management (WinRM) protocols to enable Orchestration activities to run commands on remote 
Windows  hosts.

Windows Management Instrumentation (WMI)

WMI provides a uniform interface for any local or remote applications or scripts that obtain 
management data from a computer system, a network, or an enterprise. WMI contains these 
components:

• Managed objects and WMI providers: A WMI provider is a COM object that monitors one 
or more managed objects for WMI. A managed object is a logical or physical enterprise 
component, such as a hard disk drive, network adapter, database system, operating system, 
process, or service.

• WMI infrastructure: The WMI infrastructure is a Microsoft Windows operating system 
component know as the WMI service (winmgmt). The WMI infrastructure is composed of the 
WMI Core and the WMI repository. The WMI repository is organized by WMI namespaces. 
The WMI service creates namespaces, such as root\default, root\cimv2, 
and root\subscription, at system startup and preinstalls a default set of class 
definitions, including the Win32 Classes, the WMI System Classes, and others. The remaining 
namespaces found on your system are created by providers for other parts of the operating 
system or products.

• WMI consumers: A WMI consumer is a management application or script that interacts with 
the WMI infrastructure. A management application can query, enumerate data, run provider 
methods, or subscribe to events by calling either the COM API or the Scripting API for WMI.

WMI installation and configuration

For the MID Server to successfully make a remote connection to the target host, TCP port 135 
must be open. The Windows  firewall automatically creates an inbound rule for WMI connectivity 
called Windows Management Instrumentation (DCOM-In).

Windows Remote Management (WinRM)

WinRM is the Microsoft implementation of WS-Management Protocol, a standard Simple Object 
Access Protocol (SOAP) protocol that allows hardware and operating systems from different 
vendors to interoperate.

WinRM contains these components:

• WinRM Scripting API: This scripting API enables Orchestration to obtain data from remote 
computers, using scripts that perform WS-Management protocol operations.

• WMI Service: The WMI service continues to run side-by-side with WinRM and provides 
requested data or control through the WMI plug-in. You can continue to obtain data from 
standard WMI classes, such as as Win32_Process.

WinRM configuration

WinRM is automatically installed on Windows  2008 R2 and above operating systems, but must 
be configured before use.

1. In a command prompt, enter winrm quickconfig. This command is not case sensitive.

2. When the console displays Make these changes [y/n]?, enter y.

The winrm quickconfig  command performs the following operations:
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◦ Starts the WinRM service, and sets the service startup type to auto start.

◦ Configures a listener for the ports that send and receive WS-Management protocol, using 
either HTTP or HTTPS on any IP address.

◦ Creates a firewall exception for the current user profile.

MID Server PowerShell files

PowerShell functions are stored in script files (*.ps1) that use a PowerShell Script module (*.psm1) 
file name extension.

The PowerShell functions are used by the PowerShell MID Server script files included in these 
activity packs:

• Active Directory

• Exchange

• SCCM

• PowerShell

PSScript.ps1

This script performs a few tasks, such as credential testing, password encryption, and the 
execution of scripts configured in the Orchestration Activity Designer or in MID Script Files. 
However, this document focuses on how PSScript.ps1 uses the credential.psm1  module for 
testing access to remote hosts.

The PowerShell variables are generally used directly in the PowerShell execution command  or as 
arguments in the MID Server script file you specify. There are special variables that are passed to 
PSScript.ps1, such as credType.

Using credType in execution parameters
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PowerShell credTypes

The PowerShell credential types:

Type Description

WMI testCredentialWMI

Exchange testCredentilExchange

AD testCredentilAD

SCCM testCredentilSCCM

If no credential type is passed to the PSScrip.ps1 script, the MID Server defaults to the WMI test 
function to test access to the target host. If there is a credential type used, the MID Server runs 
the corresponding test function for that credential type.

Exit codes

These exit codes are returned from the PSScript.ps1 script and logged in the MID Server log file.

PSScript.ps1 exit codes

Type Test function

0 PowerShell command/script ran successfully.

1 Test finished successfully, but the command/
script failed to execute.

2 Incorrect syntax passed to script.

3 All credentials including MID Server service 
account failed to execute the command/script.

4 Passed test and executed the activity, but an 
error was returned. Example user cannot be 
found.

DiagnosticsUtil.psm1

The MID Server uses this module file to perform PowerShell logging that assists debugging 
any Orchestration activity using PowerShell scripting. You can also add debugging statements 
directly to custom scripts.

PowerShell diagnostic utilities

Utility Description

SNCLog-DebugInfo Log a debug message for a PowerShell 
script or PowerShell Orchestration activity. 
Examples:

• SNCLog-DebugInfo -message "My 
debug message..."

• SNCLog-DebugInfo "My debug 
message"
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PowerShell diagnostic utilities  (continued)

Utility Description

SNCLog-ParameterInfo Log a function parameter 
value. For "function 
getHostName{ param( [String] 
$target )", the first value to the 
PowerShell hashtable is a string to indicate 
which function executes, and the values for 
each of the function parameters. Examples:

• Function with single parameter: SNCLog-
ParameterInfo @("Running 
getHostName", $target)

Note: 
The debug message shows, 'Running 
getHostName $target:
[actual value of $target]'.

• Function with multiple parameters: 
SNCLog-ParameterInfo 
@("Running functionName", 
$param1, $param2, $param3)

SNCObfuscate-Value Use this utility to encrypt values for 
security purposes. The function displays 
"$variableName":***, where *** is the 
obfuscated value. Example:

SNCObfuscate-Value $password

Note: 
The debug message reads: 
"$password : ***".

Credentials.psm1

The MID Server uses this module file to test access to a target host. The MID Server loops 
through all Windows  credentials stored in its credentials table using the following access 
type functions, unless the PowerShell activity has a credential type (credType) defined. All 
ServiceNow®  authored PowerShell activities are hard-coded to use a specific credential type. As 
a result, the MID Server only tests credential access against the designated function.

PowerShell test functions

Function Description

testCredentialWMI Tests the given user and password on the 
target host using the Get-WMI  object.

testCredentilAD Tests the given user and password 
on the target host using the built-in 
DirectoryEntry  object.
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PowerShell test functions  (continued)

Function Description

testCredentialExchange Tests the given user and password to create 
a session on an Exchange host. This test 
uses the built-in PowerShell remoting feature 
on a remote host. WinRM is configured on 
Exchange servers by default.

testCredentialSCCM Tests the given user and password to create 
a session on an SCCM server. This test uses 
the built-in PowerShell remoting feature on a 
remote host. This test requires WinRM to be 
configured.

testNoCredentialAccessWMI Tests the given user and password on the 
target host, using the Get-WMI  object. This 
test is used when no credType  is used.

Note: 
If the test passes using one of these functions, that credential is used to run the PowerShell 
script/command. If the tests fail to access the target host using these functions, the MID 
Server runs the PowerShell script/command under the account of the MID Server service.

This diagram illustrates the dependency of the credential selection behavior on the host being 
targeted by the PowerShell activity. If the target host is the IP address or host name of the MID 
Server, the MID Server bypasses all credentials in the Credentials table and uses the account of 
the MID Server service. If the target host is not the MID Server, then all Windows  credentials are 
used first. If all credentials in the Credentials table are unsuccessful in running the PowerShell 
activity, then the MID Server uses the MID Server service account.
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PowerShell credential selection criteria

ActiveDirectory.psm1

This module file stores the functions used by the PowerShell scripts shipped with the Active 
Directory  activity pack.

Exchange.psm1

This module file stores the functions used by the PowerShell scripts shipped with the Exchange 
activity pack.

SCCM.psm1

This module file stores the functions used by the PowerShell scripts shipped with the SCCM 
activity pack.

PowerShell troubleshooting

Authentication and access denied errors can prevent PowerShell activities from running a 
command on a target host.

Use these procedures for troubleshooting authentication failures with Orchestration PowerShell 
activities and when the Remote Procedure Call (RPC) server is unavailable or when access is 
denied. The authentication failure error displays when all credentials, including those of the local 
MID Server service account, do not have the correct permissions to run the Powershell script/
command. The same error displays when the target host is unreachable.
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Authentication error message

Authentication failure in an Active Directory activity

This example uses the Create AD Object activity to illustrate troubleshooting authentication 
failure in PowerShell.

Before you begin
Role required: Permissions to access and create accounts on Active Directory

About this task
Validate that the account you are using has the proper permissions to run the activity.

Procedure

1. Log on to the target machine using the account under which you want to run the activity.
Active Directory tools must be installed on this machine.

2. Launch the Active Directory Users and Computers application.

3. Navigate to the OU under which you want to create the Active Directory object.

4. Attempt to create the object.

If this procedure is successful under the specified user, the following might be the cause of the 
authentication failure:
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◦ User name is invalid.

◦ Password entered incorrectly.

◦ Domain controller is unreachable.

Note: 
The majority of the return codes listed in the MID Server log for this error are 1s and 3s. 
This is because the Active Directory activities use the ADSI provider and not WMI or 
WinRM. An error code of 1  means the account was able to connect with the test account, 
but running the script failed.

An error code of 3  means that the MID Server attempted to run the PowerShell activity 
under the MID Server service account but failed.

Authentication failure in an Exchange activity

This example uses the Create Mailbox activity to illustrate troubleshooting authentication failure 
in PowerShell.

Before you begin
Role required: Permissions to access and create mailboxes on the Exchange server

Procedure

1. Validate that the account you are using has the proper permissions to run the PowerShell 
activity.

2. Log on to a machine that has the Exchange Management Shell (EMS) installed.

3. Create a user using the New-mailbox  Exchange commandlet.

Creating a new user in Exchange
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If this procedure is successful under the specified credential, the following is the likely cause 
of the failure:

◦ User name is invalid.

◦ Password entered incorrectly.

◦ Exchange server is unreachable.

4. If the Exchange server is unreachable, examine the MID Server logs.
Because the Exchange activities use WinRM to access the Exchange server, the logs can 
provide more troubleshooting information.

Note: 
Ensure that the error is NOT WinRM cannot process the request.

Remote Procedure Call (RPC) server unavailable or access denied

Typically, this error is logged when running a PowerShell script/command that uses WinRM or 
WMI.

Possible causes of error

The target host might have one of these issues:

• WinRM isn’t configured.

• Firewall is blocking access to the host over TCP port 135 (WMI) or HTTP/HTTPs and TCP port 
5985 (WinRM).

• Kerberos issue, caused by hopping to multiple hosts using WMI.

Example WinRM error

The Create Mailbox activity from the Exchange activity pack has generated an error in the ECC 
queue involving authentication using the MID Server service credential. This occurred because 
the MID Server credential is the last to be used if the targeted host is not the MID Server.

Authentication failure error message

The MID Server log shows that the MID Server tried to run the activity under specific credentials, 
but wasn’t successful and received an exit code of 1.
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MID Server error code

Join Domain activity

The Join Domain activity joins a Windows  computer to a domain.

If the computer is already a member of a domain, this activity completes without modifying the 
computer. Joining a domain requires a username and password. This user must have domain 
administration privileges or privileges to join a computer to the domain.

Note: 
This activity replaces a Powershell activity by the same name available in releases prior 
to Geneva. If you have a workflow created in a previous version that uses the deprecated 
activity, your workflow will continue to work normally after upgrading to Geneva. However, 
all new workflows must use the custom version of this activity. This activity was built with the 
PowerShell activity designer, which gives workflow administrators the ability to store input 
and output variables in the databus.

Input variables

Join Domain input variables

Variables Description

Hostname Hostname or IP address of the Windows  server that is joining the 
domain.

Domain Name of the domain to join.

Domain_user The name of a user who has domain administration privileges or 
privileges to join a computer to the domain.

Domain_user_password The password for the user who has domain administration privileges 
or privileges to join a computer to the domain.

Output variables

Join Domain output variables

Variables Description

result Either success  or failure.

errorMessage The executionResult.errorMessages  from the Activity designer 
parsing sources. If this variable is not null, the operation has failed.
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Conditions

Join Domain conditions

Condition Description

Success The activity succeeded in joining the computer to the domain.

Failure The activity failed to join the computer to the domain.

Install Windows App activity

The Install Windows  App activity installs an application from an MSI package on a Windows 
target machine.

Note: 
This activity replaces a Powershell activity by the same name available in releases prior 
to Geneva. If you have a workflow created in a previous version that uses the deprecated 
activity, your workflow will continue to work normally after upgrading to Geneva. However, 
all new workflows must use the custom version of this activity. This activity was built with the 
PowerShell activity designer, which gives workflow administrators the ability to store input 
and output variables in the databus.

Input variables

Install Windows App input variables

Variable Description

hostname Hostname or IP address of the target Windows  machine on which the service is 
installed. Use the Resolve DNS MID Server capabilities  to resolve hostnames into 
IP addresses.

installerpath Path to the installer. The installer can be on any machine that is visible to both 
the MID Server and the target machine (local drive, UNC path, mapped drive, 
etc.).

installer Name of the installer file, such as winzip150.msi. The installer must be an 
MSI package.

arguments The parameter that contains the command line arguments to the MSI 
package. These are name=value pairs, separated by a space. For example, 
the argument might appear as: INSTALLDIR=c:\myinstallfolder 
ADDDESKTOPICON=0. These arguments are dependent on the what the actual 
MSI being installed defines. If there are no arguments, leave the field empty.

Output variables

Install Windows App output variables

Variable Description

result Either success  or failure.

errorMessage The executionResult.errorMessages  from the Activity designer 
parsing sources.
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Conditions

The activity state tells the workflow engine what to do with the activity.

Install Windows App conditions

Name Description

Success The Windows application was successfully installed on the target machine.

Failure The Windows application failed to install on the target machine

Enable WMI Windows Installer provider

To install software on Windows  machines using the Install Windows App activity, enable WMI 
Windows Installer provider on all target machines.

Before you begin

• It is recommended that the MID Server, the target machine, and the installer source machine 
be on the same Active Directory domain. However, if these computers are on separate 
domains, those domains must have a trust relationship  established between them.

• If the installer path is a UNC file sharing  machine, the Active Directory account of the target 
computer must be trusted for delegation. For instructions on this configuration, see the posting 
on the community for installing and uninstalling Windows applications .

About this task

Note: 
See WMI Providers  for a list of Windows  operating systems that provide this tool by 
default.

Procedure

1. Open the Control Panel.

2. Go to Add or Remove Programs.

3. Select Add/Remove Windows Components.

4. Double-click Management and Monitoring Tools.

This action opens a secondary window displaying additional selections.

5. Select WMI Windows Installer Provider  check box.

6. Click OK  to return to the Windows  Components Wizard window.

7. Click Next.
You might be asked for the Windows  installation CD to complete this process.

Change Service State activity

The Change Service State activity starts or stops a Windows  service on a remote system.

This activity replaces a Powershell activity by the same name available in releases prior to 
Istanbul. If you have a workflow created in a previous version that uses the deprecated activity, 
your workflow will continue to work normally after upgrading to Istanbul. However, all new 
workflows must use the custom version of this activity. This activity was built with the Powershell 
activity template, which gives workflow administrators the ability to store input and output 
variables in the databus.
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Input Variables

Change Service State input variables

Variable Description

hostname Hostname or IP address of the target Windows  machine on which the service is 
installed. Use the Resolve DNS activity to resolve hostnames into IP addresses.

service Name of the Windows  service to start or stop. The service  parameter is the 
service name, not the display name of the service affected.

state There are two actions to select for a service state change: StartService  or 
StopService.

Output variables

Change Service State output variables

Variable Description

errorMessage The 
executionResult.errorMessages 
from the Activity designer parsing sources. If 
there is no error, this value is null.

Conditions

Change Service State conditions

Condition Description

Success The target service was successfully started or 
stopped.

Failure The update to the target service was 
unsuccessful, or the service was not found on 
the target system.

Restart Windows Server activity

The Restart Windows Server activity stops and then restarts a Windows  server using Powershell.

Note: 
This activity replaces a Powershell activity by the same name available in releases prior 
to Geneva. If you have a workflow created in a previous version that uses the deprecated 
activity, your workflow will continue to work normally after upgrading to Geneva. However, 
all new workflows must use the custom version of this activity. This activity was built with the 
Powershell activity template, which gives workflow administrators the ability to store input 
and output variables in the databus.
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Input variables

Restart Windows Server input variables

Variable Description

Hostname Hostname or IP address of the Windows  server to restart.

Output variables

Restart Windows Server output variables

Variable Description

result Either success  or failure.

errorMessage The executionResult.errorMessages  from the Activity designer 
parsing sources. If this variable is not null, the operation has failed.

Conditions

Restart Windows Server conditions

Condition Description

Success The activity succeeded in restarting the Windows server.

Failure The activity failed to restart the Windows server.

Uninstall Windows App activity

The Uninstall Windows  App activity uninstalls an application from a Windows  target machine.

The only applications that can be uninstalled using this activity are those that were installed by a 
Windows  Installer.

Note: 
This activity replaces a Powershell activity by the same name available in releases prior 
to Geneva. If you have a workflow created in a previous version that uses the deprecated 
activity, your workflow will continue to work normally after upgrading to Geneva. However, 
all new workflows must use the custom version of this activity. This activity was built with the 
Powershell activity template, which gives workflow administrators the ability to store input 
and output variables in the databus.

Input variables

Uninstall Windows App input variables

Variable Description

hostname Hostname or IP address of the Windows  target machine on which to uninstall an 
application.

product The name of the application to uninstall exactly as it appears in the Windows  Add/
Remove Programs list.
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Output variables

Uninstall Windows App output variables

Variable Description

result Either success  or failure.

errorMessage The executionResult.errorMessages  from the Activity designer 
parsing sources. If this variable is not null, the operation has failed.

Conditions

Uninstall Windows App conditions

Condition Description

Success The activity succeeded in unistalling the application from the Windows server.

Failure The activity failed to uninstall the application from the Windows server.

Probe activity pack

Orchestration provides an activity pack customized using the ServiceNow  activity designer that 
runs probes on target hosts to return specific information.

These custom activities were built with the Create a probe activity, which gives workflow 
administrators the ability to store input and output variables in the databus.

To use the custom probe activities, you must request activation  of the Orchestration - Probe 
plugin.

Resolve DNS Name activity

The Resolve DNS Name activity takes an IP address or a fully qualified domain name (FQDN), 
which it resolves into one or more IP addresses.

The domain name is sent through the MID Server to the domain name system (DNS) to resolve 
the name. If a single IP address is returned, it is stored in two variables:resolved_ip  and 
resolved_ips. If multiple IP addresses are returned, the first IP address is stored in the 
resolved_ip  variable, and all the addresses are stored in the resolved_ips  variable. If an 
IP address is provided instead of an FQDN, this address is output directly to both variables. Your 
ServiceNow  instance must have access to a MID Server configured to use Resolve DNS to run 
this activity.

This activity replaces an activity by the same name available in releases prior to Istanbul. If you 
have a workflow created in a previous version that uses the deprecated activity, your workflow 
will continue to work normally after upgrading to Istanbul. However, all new workflows must use 
the custom version of this activity. This activity was built with the Probe activity template, which 
gives workflow administrators the ability to store input and output variables in the databus.

Input variables

Resolve DNS Name input variables

Variable Description

FQDN The fully qualified domain name to resolve or an IP address.
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Output variables

Resolve DNS Name output variables

Variable Desctiption

ip The first IP address of the resolved DNS name.

ips Comma separated list of resolved IP 
addresses.

result One of the following:

• resolved: Able to resolve the sprcified DNS 
name.

• unresolved: Unable to resolve the specified 
DNS name.

Conditions

Resolve DNS Name conditions

Condition Description

Success Activity successfully resolved the DNS name.

Failure Activity failed to resolve the DNS name.

SNMP Query activity

The SNMP Query activity queries an SNMP device.

Your ServiceNow  instance must have access to a MID Server configured to use SNMP to run this 
activity.

This activity replaces an activity by the same name available in releases prior to Istanbul. If you 
have a workflow created in a previous version that uses the deprecated activity, your workflow 
will continue to work normally after upgrading to Istanbul. However, all new workflows must use 
the custom version of this activity. This activity was built with the Probe activity template, which 
gives workflow administrators the ability to store input and output variables in the databus.

Input variables

SNMP Query input variables

Variable Description

hostname Hostname or IP address of the SNMP device being queried.

oids A list of unique object identifiers used to identify SNMP devices.
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Output variables

SNMP Query output variables

Variable Description

description Description of the SNMP object.

timeout Boolean value indicating whether or not the 
query timed out.

error Indicates any error that occurred. If no error 
occurred, this value is null.

oid_data An array of data objects for all unique object 
identifiers.

Conditions

SNMP Query conditions

Condition Description

Success Activity successfully ran the query on the 
target device.

Failure Activity failed to run the query on the target 
device. Failure could be caused by invalid 
credentials or a device that is not accessible.

SCCM activity pack

The Microsoft System Center Configuration Management (SCCM) activity pack provides 
Orchestration activities you can use to manage software deployments and collections on an 
SCCM server.

You can use SCCM Orchestration activities to deploy and revoke software from an SCCM server 
or manage user and device collections. The system manages software on an SCCM server using 
Orchestration activities and workflows.

Client software distribution requires:

• SCCM 2012 R2 and later.

• Powershell 3.x.

• Powershell Remoting enabled.

• The Windows PowerShell x86 execution policy must be set to unrestricted mode.

• Latest version of the SCCM cmdlet  library installed on the SCCM server.

• Use the credentials to log onto the SCCM Server and connect via Windows PowerShell from 
the System Center Configuration Manager console at least once to set the path variable for 
that credential.

Request SCCM activities

The Orchestration - System Center Configuration Manager plugin installs the SCCM activity pack 
that deploys software from an SCCM host and manages user and device collections.

Before you begin
Role required: admin
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About this task
The SCCM plugin is activated automatically when the Orchestration - Client Software Distribution 
[com.snc.orchestration.sccm_mgnt] plugin is activated, but can be activated separately.

Note: 
The activities in the SCCM plugin run in the System Center Configuration Manager scope.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. On the All Applications page, select Request Plugin  to open the Activate Plugin  form on Now 
Support.

3. On Now Support, select the link to access the Now Support  Service Portal  Service Catalog.

4. Select your instance.

5. Select Actions > Activate Plugin.

6. On the Activate Plugin  form, provide the following information.

Activate Plugin form

Field Description

What is your target instance Instance on which to activate the plugin.

Which plugin would you like to activate Name of the plugin to activate.
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Field Description

Note: 
If the system does not list the plugin you 
want or if you are activating the plugin 
on an OEM or on-premise instance, 
select the Plugin I'm looking for is not 
listed  check box and then enter the 
name of the plugin.

Select Maintenance Date and Time The date and time to activate the plugin.

Note: 
Plugins are activated in two batches, 
once in the morning and once in the 
evening, on every business day in the 
US Pacific time zone. If the plugin must 
be activated at a specific time, enter the 
request in the Reason/Comments  field.

Example 

For example, see the following form to activate the CSM Workspace plugin on an instance 
named My Instance.

Activate Plugin form

7. Select Submit.
For additional details about requesting a plugin, see Requesting a Plugin from the Service 
Catalog [KB0751715] article in the Now Support  Knowledge Base.

Configure the MID Server for SCCM activities

To use a MID Server with Microsoft System Center Configuration Management (SCCM) activities, 
configure it to communicate with the SCCM server.
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Before you begin
Role required: admin

Procedure

1. In the navigation filter, enter cmdb_ci_dns_name.list.

2. Click New.

3. Enter the fully-qualified domain name (FQDN) of the SCCM server in the Name  field.

4. Right-click in the form header and select Save.

5. In the IP Address  related list, click New.

6. In the IP Address  field, enter the IP address of the SCCM server.

7. In the Nic  field, select eth0  or your preferred network interface controller.

8. Leave the Netmask  field blank.

9. Click Submit.

Add to Device Collection activity

The Add to Device Collection activity adds the specified device into a Microsoft System Center 
Configuration Manager (SCCM) device collection.

The Add to Device Collection activity uses the Powershell activity template  to add 
a specified device to an SCCM device collection. The activity is configured to use 
a MID Server with Powershell capabilities and to run a MID Server script called 
AddToDeviceCollection.ps1  to edit the collection.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > System Center Configuration Manager (SCCM).

Note: 
The Add to Device Collection activity does not use pre-processing or post processing 
scripts.

Input variables

Add to Device Collection input variables

Variable Description

sccmServer The fully qualified domain name (FQDN) of the SCCM server.

collection Name of the device collection.

device Name of the device to add to the collection.

Output variables

Add to Device Collection output variables

Variable Description

output Variable that contains a value that is passed to other activities in the workflow.

error Variable that contains the activity output error message.
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Conditions

Add to Device Collection conditions

Condition Description

Success Activity successfully added the device to the SCCM device collection.

Failure Activity failed to add the device to the SCCM device collection.

Add to User Collection activity

The Add to User Collection activity adds a user to a Microsoft System Center Configuration 
Manager (SCCM) user collection.

The Add to User Collection activity uses the Powershell activity template  to access the SCCM 
server. The activity is configured to use a MID Server with Powershell capabilities and to run a 
MID Server script called AddToUserCollection.ps1  to edit the collection.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > System Center Configuration Manager (SCCM).

Note: 
The Add to User Collection activity does not use pre-processing or post processing scripts.

Input variables

Add to User Collection input variables

Variable Description

sccmServer The fully qualified domain name (FQDN) of the SCCM server.

collection Name of the user collection.

user Name of the user to add to the collection.

Output variable

Add to User Collection output variables

Variable Description

output Variable that contains a value that is passed to other activities in the workflow.

error Variable that contains the activity output error message.

Conditions

Add to User Collection conditions

Success Activity successfully added a user to the SCCM user collection.

Failure Activity failed to add a user to the SCCM user collection.
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Get Applications activity

The Get Applications activity returns a list of all the applications available on a Microsoft System 
Center Configuration Manager (SCCM) server.

The Get Applications activity uses the Powershell activity template  to access the applications 
on the SCCM server. The activity is configured to use a MID Server with Powershell capabilities 
and to run a MID Server script called GetApplications.ps1. This script filters the results 
of the GET, so that only specific attributes are returned for the applications on the SCCM server. 
Filtering the results in this manner controls the size of the payload, while providing the most 
desirable application data. The list of available applications is returned as an array in a JSON 
object.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > System Center Configuration Manager (SCCM).

Note: 
The Get Applications activity does not use a pre-processing script.

Input variables

Get Applications input variables

Variable Description

sccmServer The fully qualified domain name (FQDN) of the SCCM server.

Output variables

The output variables for the Get Applications activity contain an array of objects called 
applications  and an error message. Each object in the array contains the attributes in this 
table.

Get Applications output variables

Variables Description

applications The applications  array contains these attributes:

• id: Primary key of the SCCM application.

• ciUniqueId: Unique ID of the SCCM application.

• name: Name of the application.

• manufacturer: Manufacturer of the application.

• version: Version of the application.

• isDeployable: True/false value indicating if this application is deployable.

• isDeployed: True/false value indicating if this application is already 
deployed.

• numberOfUsersWithApp: Count of users with this application installed.
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Get Applications output variables  (continued)

Variables Description

• numberOfDevicesWithApp: Count of devices on which this application is 
installed.

• application: Object containing the data set listed above for this 
application. Use the script to parse additional data from this set that you might 
need.

error Variable that contains the activity output error message.

Conditions

Get Applications conditions

Variables Description

Success Activity successfully retrieved the list of applications available on the SCCM host.

Failure Activity failed to retrieve the list of applications available on the SCCM host.

Get Deployments activity

The Get Deployments activity returns the list of deployments performed by Orchestration using a 
Microsoft System Center Configuration Manager (SCCM) server.

The Get Deployments activity uses the Powershell activity template  to access the deployments 
on the SCCM server. The activity is configured to use a MID Server with Powershell capabilities 
and to run a MID Server script called GetDeployments.ps1  that returns the deployments on 
the host. This script filters the results of the GET, so that only specific attributes are returned for 
the deployments on the SCCM server. Filtering the results in this manner controls the size of the 
payload, while providing the most desirable deployment data. The list of available deployments 
is returned as an array in a JSON object.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > System Center Configuration Manager (SCCM).

Note: 
The Get Deployments activity does not use pre-processing scripts.

Input variables

Get Deployments input variables

Variable Description

sccmServer The fully qualified domain name (FQDN) of the SCCM server.

Output variables

Get Deployments output variables

Variable Description

deployments The deployments  array contains these attributes:
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Get Deployments output variables  (continued)

Variable Description

• id: Primary key of the SCCM application.

• applicationId: Primary key of the SCCM application.

• softwareName: Name of the software that will be deployed.

• collectionId: Primary key of the SCCM collection.

• collectionName: Name of the SCCM collection.

• desiredConfigType: Possible values are: Install  (1) and Uninstall 
(2).

• deploymentIntent: Intended purpose of the deployment. Possible values 
are: Available  (1) and Required  (2) .

• numberSuccess: Number of clients that successfully installed the 
deployment.

• numberErrors: Number of clients with an error when installing the 
deployment.

• deployment: Object containing the data set of attributes listed here for this 
deployment. Use the post-processing script to parse additional data from this 
set that you might need..

error Variable that contains the activity output error message.

Conditions

Get Deployments conditions

Condition Description

Success Activity successfully retrieved the list of deployments performed by Orchestration 
using an SCCM host.

Failure Activity failed to retrieve the list of deployments performed by Orchestration using 
an SCCM host.

Get Device Collections activity

The Get Device Collections activity returns the list of available device collections on a Microsoft 
System Center Configuration Manager (SCCM) host.

The Get Device Collections activity uses the Powershell activity template  to access the 
collections on the SCCM server. The activity is configured to use a MID Server with Powershell 
capabilities and to run a MID Server script called GetDeviceCollections.ps1  that returns 
the device collections on the server. This script filters the results of the GET, so that only specific 
attributes are returned for the device collections on the SCCM server. Filtering the results in this 
manner controls the size of the payload, while providing the most desirable device collection 
data. The list of available collections is returned as an array in a JSON object.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > System Center Configuration Manager (SCCM).
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Note: 
The Get Device Collections activity does not use pre-processing scripts.

Input variables

Get Device Collections input variables

Variable Description

sccmServer The fully qualified domain name (FQDN) of the SCCM server..

Output variables

Get Device Collections output variables

Variable Description

deviceCollections The deviceCollections  array contains these attributes:

• id: Primary key of the SCCM device collection.

• name: Name of the SCCM device collection.

• collectionType: Type of SCCM collection. In this case, the value is 
device.

• localMemberCount: Count of device collection members visible at 
the local SCCM site.

• memberCount: Count of all device collection members.

• deviceCollection: Object containing the data set of attributes 
listed here for this device collection. Use the post-processing script to 
parse additional data from this set to use.

error Variable that contains the activity output error message.

Conditions

Get Device Collections conditions

Condition Description

Success Activity successfully retrieved a list of device collections available on the SCCM 
host.

Failure Activity failed to retrieve a list of device collections available on the SCCM host.

Get User Collections activity

The Get User Collections activity returns the list of available user collections on a Microsoft 
System Center Configuration Manager (SCCM) server.

The Get User Collections activity uses the Powershell activity template  to access the user 
collections on the SCCM server. The activity is configured to use a MID Server with Powershell 
capabilities and to run a MID Server script called GetUserCollections.ps1  that returns 
the user collections on the host. This script filters the results of the GET, so that only specific 
attributes are returned for the user collections on the SCCM server. Filtering the results in this 
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manner controls the size of the payload, while providing the most desirable user collection data. 
The list of available collections is returned as an array in a JSON object.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > System Center Configuration Manager (SCCM).

Note: 
The Get User Collections activity does not use pre-processing scripts.

Input variables

Get User Collections input variables

Variable Description

sccmServer The fully qualified domain name (FQDN) of the SCCM server.

Output variables

Get User Collections output variables

Variable Description

userCollections The userCollections  array contains these attributes:

• id: Primary key of the SCCM user collection.

• name: Name of the SCCM user collection.

• collectionType: Type of SCCM collection. In this case, the value is 
user.

• localMemberCount: Count of user collection members visible at the 
local SCCM site.

• memberCount: Count of all user collection members.

• userCollection: Object containing the data set of attributes listed here 
for this user collection. Use the post-processing script to parse additional 
data from this set to use.

error Variable that contains the activity output error message.

Conditions

Get User Collections conditions

Condition Description

Success Activity successfully retrieved the list of available user collections on an SCCM host.

Failure Activity failed to retrieve the list of available user collections on an SCCM host.

Is Device in Collection activity

This activity verifies if a device exists in an SCCM device collection.

The Is Device in Collection activity uses the PowerShell activity template  to verify if a specific 
device exists in an SCCM device collection. The activity is configured to use a MID Server with 
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PowerShell capabilities and to run a MID Server script called IsDeviceInCollection.ps1 
to perform the test.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > System Center Configuration Manager (SCCM).

Input variables

Is Device in Collection input variables

Variable Description

sccmServer The fully qualified domain name (FQDN) of the SCCM server.

collection Name of the device collection.

device Name of the device to verify is in the collection.

Output variables

Is Device in Collection output variables

Variable Description

output Variable that contains the test result: True/False

errorMessage Variable that contains the activity output error message.

Conditions

Is Device in Collection conditions

Condition Description

Exist The device exists in the collection.

Not exist The device does not exist in the collection.

Failure Activity failed.

Is User in Collection activity

This activity verifies if a user exists in an SCCM user collection.

The Is User in Collection activity uses the PowerShell activity template  to verify if a specific user 
exists in an SCCM user collection. The activity is configured to use a MID Server with PowerShell 
capabilities and to run a MID Server script called IsUserInCollection.ps1  to perform the 
test.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > System Center Configuration Manager (SCCM).

Input variables

Is User in Collection input variables

Variable Description

sccmServer The fully qualified domain name (FQDN) of the SCCM server.
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Is User in Collection input variables  (continued)

Variable Description

collection Name of the user collection.

user Name of the user to verify is in the collection.

Output variables

Is User in Collection output variables

Variable Description

output Variable that contains the test result: True/False

errorMessage Variable that contains the activity output error message.

Conditions

Is User in Collection conditions

Condition Description

Exist The user exists in the collection.

Not exist The user does not exist in the collection.

Failure Activity failed.

Remove from Device Collection activity

The Remove from Device Collection activity removes a device from a Microsoft System Center 
Configuration Manager (SCCM) device collection.

The Remove from Device Collection activity uses the Powershell activity template  to remove 
a device from a device collection on a Microsoft SCCM server. The activity is configured 
to use a MID Server with Powershell capabilites and to run a MID Server script called 
RemoveFromUserCollection.ps1  to edit the collection.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > System Center Configuration Manager (SCCM).

Input variables

Remove from Device Collection input variables

Variable Description

sccmServer The fully qualified domain name (FQDN) of the SCCM server.

collection Name of the device collection.

device Name of the device to add to the collection.
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Output variables

Remove from Device Collection output variables

Variable Description

output Variable that contains a value that is passed to other activities in the workflow

error Variable that contains the activity output error message.

Conditions

Remove from Device Collection conditions

Condition Description

Success Activity successfully removed the device from the SCCM device collection.

Failure Activity failed to remove the device from the SCCM device collection.

Remove from User Collection activity

The Remove from User Collection activity removes a user from a Microsoft System Center 
Configuration Manager (SCCM) user collection.

The Remove from User Collection activity uses the Powershell activity designer template 
to access a user collection on a Microsoft SCCM target host. The activity is configured 
to use a MID Server with Powershell capabilites and to run a MID Server script called 
RemoveFromUserCollection.ps1  to edit the collection.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > System Center Configuration Manager (SCCM).

Input variables

Remove from User Collection input variables

Variable Description

sccmServer The fully qualified domain name (FQDN) of the SCCM server.

collection Name of the user collection.

user Name of the user to add to the collection.

Output variables

Remove from User Collection output variables

Variable Description

output Variable that contains a value that is passed to other activities in the workflow.

error Variable that contains the activity output error message.
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Conditions

Remove from User Collection conditions

Condition Description

Success Activity successfully removed the user from the SCCM user collection.

Failure Activity failed to remove the user from the SCCM user collection.

SFTP File Transfer activity pack

Use the SFTP File Transfer activities to manage files and directories on an SFTP server and to 
move files from one SFTP server to another.

The SFTP activity pack includes scoped activities for common file transfer tasks and a ready-to-
use workflow that includes these activities. Use the SFTP workflow to control which files are going 
to be moved, what conditions the files need to meet, the order in which the files are moved, and 
which overwrite options are executed.

Note: 
To use the SFTP File Transfer activities and workflow, you must request activation  of the 
Orchestration - SFTP plugin.

SFTP File Transfer workflow

The SFTP File Transfer activity pack includes a scoped workflow that uses multiple activities to 
manage files on SFTP servers.

The maximum activity count for the SFTP File Transfer workflow is set to 10,000. This allows the 
workflow to move up to 1000 files from one server to another.

Accessing the workflow

• Navigate to Workflow  > Workflow Editor  and select the Workflows  tab.

• Click on the SFTP File Transfer workflow to open it.

• Click the information icon in the workflow header to display the properties dialog box.

Input variables

SFTP File Transfer workflow input variables

Variable Description
Default 
value

Source 
host

Name or IP address of the server containing the files you want to move.

Source 
port

Port number to use to communicate with the source server. 22

Source 
directory

Full path to the directory where the source files are located.

Source 
files

Names of specific source files to move. Separate the file names in 
this list with semi-colons. This field supports the use of wild cards. For 
information about how the values in this field are affected by options in 
other fields, see the section below the table.
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SFTP File Transfer workflow input variables  (continued)

Variable Description
Default 
value

Excluded 
files

Names of specific source files to exclude from the move. The system 
moves all other files found in the source directory or subfolders. 
Separate the file names in this list with semi-colons. This field supports 
the use of wild cards. For information about how the values in this field 
are affected by options in other fields, see the section below the table.

Target 
host

Name or IP address of the server to which the files are being moved.

Target 
port

Port number to use to communicate with the target host. 22

Datetime 
format

Timestamp format to apply when the $[DateTime]  variable is used 
in the Target directory  or Target files  field. The system uses the current 
time from the instance to create timestamp values.

yyyy-
MM-dd

Target 
directory

Path to the directory in the target host where the files are being moved. 
You can specify a target directory whose name includes the timestamp 
by adding the $[DateTime]  variable to the directory name. For 
example, you might enter this path to a target directory: /user/
jacinto.gawron/documents/projects_$[DateTime]. This 
produces the projects_20150505  directory. When the timestamp 
variable is used, the system uses the format specified in the Datetime 
format  field.

Target file Format to use for target file names when a timestamp is added. You can 
configure the system to add the timestamp as a prefix to the file name or 
insert the timestamp into the name, using these variables:

• $[DateTime]: Current timestamp, using the format defined in the 
Datetime format  field.

• $[SourceFile]: Complete file name.

• $[SourceFile:Base]: Base file name without the extension.

• $[SourceFile:Ext]: File extension only.

A target file name with the timestamp added as a prefix is expressed 
as: $[DateTime]_$[SourceFile]. This produces a file name that 
looks like this: 20150505_file1.txt

A target file name with the timestamp inserted into the 
name is expressed as: $[SourceFile:Base]_
$[DateTime]$[SourceFile:Ext]. This produces a file name 
that looks like this: file1_20150505.txt

Apply 
move 
conditions

Check box to apply conditions to the file transfer. If this check box is 
selected, additional fields appear for setting conditions.

false

Minimum 
file size, in 
bytes

Condition that defines a target file's minimum size requirement. This 
setting can help determine if the file is valid. This field appears when the 
Apply move conditions  check box is selected.

0
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SFTP File Transfer workflow input variables  (continued)

Variable Description
Default 
value

Maximum 
file size, in 
bytes

Condition that defines a target file's maximum size requirement. This 
field appears when the Apply move conditions  check box is selected.

-1

File is not 
older than

Condition that sets the earliest acceptable date for this file's age range. 
The range starts at 00:00 (midnight) on the date specified. This field 
appears when the Apply move conditions  check box is selected.

File is not 
newer 
than

Condition that sets the latest acceptable date for this file's age range. 
The range ends at 23:59 on the date specified. This field appears when 
the Apply move conditions  check box is selected.

Include 
subfolders

Check box to move the files from subfolders in the source directory. For 
information about how your selection affects other fields in the form, see 
the section below the table.

Move 
order

Order in which the files are moved from the source to the target. The 
possible options are:

• None  (same order as files in the source directory)

• By timestamp

• By file name

• By file size

Sort order Order in which the files are sorted in the target directory, using the 
option selected in the Move order  field. Sorting options are Ascending 
and Descending.

desc

Maximum 
number of 
retries

Number of attempts the activity can make to connect to the target host 
or to move a file before timing out. When the retry limit to move a file 
or to connect to the host is exceeded, the system logs a failure. If the 
maximum number of failures is not exceeded, the system attempts to 
connect again or to move the next file named.

2

Time 
between 
retries, in 
seconds

Time, in seconds, between repeat attempts to connect to the target or to 
begin moving a file.

10

Maximum 
number of 
failures

Acceptable number of times the system can fail to connect to the target 
host or to move a file before it quits trying. A failure occurs when the 
number of configured retries is exceeded. Using the default settings, 
failure occurs when the system cannot connect to the target or move a 
file after two retries.

0

Duplicate 
file action

Action to take if a file being moved already exists in the target directory. 
The choices are:

• Overwrite if file exists  (default)

• Rename with index

• Do not move

overwrite

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

5023



SFTP File Transfer workflow input variables  (continued)

Variable Description
Default 
value

Preserve 
file 
attributes

Check box to use the time stamp and mode information from the source 
files for the copied files. If this check box is cleared, the copied files 
have a current time stamp and mode.

Note: 
This timestamp is a file attribute and is not appended to the file 
name.

false

Upon 
success, 
remove 
files from 
source

Check box to delete original files from the source directory when they 
are copied to the new location. Clear this check box to keep the source 
files in their current location in the source host.

false

Upon 
failure, 
keep 
moved 
files on 
target

Check box to keep any files on the target that were moved successfully, 
even if the entire file transfer operation ended in failure. If this check box 
is cleared, the system removes all successfully transfered files from the 
target when general failure occurs.

true

Credential 
tag for 
source

Specific Credential aliases for Orchestration activities  this activity 
must use to run SSH commands on the source host.

Credential 
tag for 
target

Specific credential tag this activity must use to run SSH commands on 
the target host.

File selection logic

When selecting the files to move from the source host, the system uses this logic:

• If the Source files  and Excluded files  fields are empty, the system moves all the files in the 
source directory.

• When the Include subfolders  check box is selected, the following dependencies exist:

◦ If no files are specified in the Source files  and Exclude files  fields, the system moves all files 
in the source directory and all files in all subfolders of the source directory.

◦ If the Source files  field contains file names, the system moves those files from their location 
on either the source directory or any of its subfolders.

◦ If the Exclude files  field contains file names, the system moves all the files from the source 
directory and its subfolders except those excluded files.

• When the Include subfolders  check box is cleared, the system looks only in the source 
directory for files to move or exclude.

Copy File activity

The Copy File activity copies a file from an SFTP server (source host) to another SFTP server 
(target host).
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Input variables

Copy File input variables

Variable Description

sourceHost Name or IP address of the server containing the files you want to 
transfer.

sourcePort Port number to use to communicate with the source server. The default 
port number is 22.

sourceFilePath Full path to the file to copy from the source host.

targetHost Name or IP address of the server to which you want to move the files.

targetPort Port number to use to communicate with the target server. The default 
port number is 22.

targetFilePath Full path to the copied file on the target host.

tempFileSuffix Temporary suffix to use when moving a file. If this field contains a 
value, the activity deletes the duplicate target file, if it exists, and then 
copies the source file to a temporary file using targetFilePath 
+ tempFileSuffix  as the name. Upon completion, the activity 
renames the file to the actual target file name. If this field is blank, the 
activity copies the source file directly to the target file and overwrites it, if 
it already exists.

sourceCredentialTag Specific Credential aliases for Orchestration activities  this activity must 
use to run SSH commands on the source host.

targetCredentialTag Specific credential tag this activity must use to run SSH commands on 
the target host.

Output variables

Copy File output variables

Variable Description

errorMessages The executionResult.errorMessages  from the Activity designer 
parsing sources. If this variable is not null, the operation has failed.

result Text message advising that the command was executed successfully.

Conditions

Copy File conditions

Condition Description

Success The activity succeeded in copying the file.

Failure The activity failed to copy the file.

Create Directory activity

The Create Directory activity creates a new directory on an SFTP server.
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Input variables

Create Directory input variables

Variable Description

sourceHost Name or IP address of the server containing the files you want to move.

sourcePort Port number to use to communicate with the source server. The default 
port number is 22.

sourceDirectory Path to the target directory to create.

sourceCredentialTag Specific Credential aliases for Orchestration activities  this activity must 
use to run SSH commands on the host.

Output variables

Create Directory output variables

Variable Description

errorMessage The executionResult.errorMessages  from the Activity designer 
parsing sources. If this variable is not null, the operation has failed.

result Text message advising that the command was executed successfully.

Conditions

Create Directory conditions

Variable Description

Success The activity succeeded in creating the directory.

Failure The activity failed to create the directory.

Get File List activity

The Get File List activity returns a list of files from a given directory and its subdirectories on an 
SFTP server (source host).

Input variables

Get File List input variables

Variable Description

sourceHost Name or IP address of the server containing the files you want to list.

sourcePort Port number to use to communicate with the target server. The default 
port number is 22.

sourceDirectory Path to the target directory containing the files to list.

sourceFiles List of target files to return. This is a comma separated list that accepts 
wildcards, such as *.txt.

excludedFiles List of target files to exclude. This is a comma separated list that accepts 
wildcards, such as *.txt.
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Get File List input variables  (continued)

Variable Description

includeSubfolders True/false variable that determines if files from subfolders are included 
in the list. The default value for this variable is false.

sourceCredentialTag Specific Credential aliases for Orchestration activities  this activity must 
use to run SSH commands on the host.

Output variables

Get File List output variables

Variable Description

errorMessage The executionResult.errorMessages  from the Activity designer 
parsing sources. If this variable is not null, the operation has failed. An activity 
can examine the error message to customize a condition. For example, if the 
error message contains NO_SUCH_FILE, the activity can be considered 
successful, depending on circumstances.

result List of requested files, returned as a JSON string.

Conditions

Get File List conditions

Condition Description

Success The activity succeeded in listing the requested files.

Failure The activity failed to list the requested files.

Remove File or Directory activity

The Remove File or Directory activity removes a file or a directory on an SFTP server, including 
subdirectories, when configured.

Input variables

Remove File or Directory input variables

Variable Description

sourceHost Name or IP address of the server containing the files you want to remove.

sourcePort Port number to use to communicate with the target server. The default 
port number is 22.

sourceFilePath Full path to the file or directory to remove. To remove multiple files or 
directories using a single activity, enter a semicolon-separated list of 
paths in this field.

isDirectory True/false variable that determines if the specified file path is a directory. 
The default value for this variable is false.

includeSubfolders True/false variable that determines if the given directory and all of its 
subfolders should be removed. The default value for this variable is 
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Remove File or Directory input variables  (continued)

Variable Description

false. If the value for this field is false, then the activity can only remove 
an empty directory. This field appears when the isDirectory  checkbox is 
selected.

sourceCredentialTag Specific Credential aliases for Orchestration activities  this activity must 
use to run SSH commands on the host.

Output variables

Remove File or Directory output variables

Variable Description

errorMessage The executionResult.errorMessages  from the Activity designer 
parsing sources. If this variable is not null, the operation has failed.

result Either success  or failure.

deletionResults The deletionResults  array contains these attributes:

• fullPath: Full path to the file or directory targeted.

• status: Either succeeded  or failed.

• reason: Text message describing the cause of a failure.

Conditions

Remove File or Directory conditions

Condition Description

Success The activity succeeded in removing the file or directory specified.

Failure The activity failed to remove the file or directory specified.

Rename File or Directory activity

The Rename File or Directory activity renames a file or directory to a new name on an SFTP 
server.

Input variables

Rename File or Directory input variables

Variable Description

sourceHost Name or IP address of the server containing the file or directory you want 
to rename.

sourcePort Port number to use to communicate with the target server. The default 
port number is 22.

sourceFilePath Full path to the file or directory to rename.

targetFilePath Full path to the renamed file or directory.
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Rename File or Directory input variables  (continued)

Variable Description

sourceCredentialTag Specific Credential aliases for Orchestration activities  this activity must 
use to run SSH commands on the host.

Output variables

Rename File or Directory output variables

Variable Description

errorMessages The executionResult.errorMessages  from the Activity designer 
parsing sources. If this variable is not null, the operation has failed.

result A message saying that the operation has been successful. For example, 
you might see: Rename /tmp/sftp_test/subdir1 to /tmp/
sftp_test/subdir2 complete.

Conditions

Rename File or Directory conditions

Condition Description

Success The activity succeeded in renaming the file or directory.

Failure The activity failed to rename the file or directory.

Set File Attributes activity

The Set File Attributes activity sets common file attributes, such as timestamps, size, 
permissions, and UID/GID, for a file or directory on an SFTP server.

A good practice is to use the Get File List activity to return a list of files and their attributes first. 
Then, when you moved a file from a source host to a target host, use the Set File Attributes 
activity to set the source file attributes on the target file. This is demonstrated in the SFTP File 
Transferworkflow.

Input variables

Set File Attributes input variables

Variable Description

sourceHost Name or IP address of the server containing the file or directory 
whose attributes you want to change.

sourcePort Port number to use to communicate with the target server. The default 
port number is 22.

sourceFilePath Full path to the file or directory whose attributes you want to change.

userID User ID attribute to apply to the file or directory. The UID and GUID 
variables must be set together as a pair.

groupID Group ID attribute to apply to the file or directory. The UID and GUID 
variables must be set together as a pair.
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Set File Attributes input variables  (continued)

Variable Description

permissions File or directory permissions to set for the user and group specified. 
This value must be expressed as an integer, such as 16877, which 
defines these permissions: rwxr-xr-x.

Note: 
The permissions number is an internal value returned by the Get 
File List activity.

accessTimestamp Override the timestamp when the file or directory was last accessed. 
The access and modification timestamps must be set together as a 
pair.

modificationTimestamp Override the timestamp when the file or directory was last modified. 
The access and modification timestamps must be set together as a 
pair.

sizeInBytes Size of the file or directory, expressed in bytes.

sourceCredentialTag Specific Credential aliases for Orchestration activities  this activity 
must use to run SSH commands on the host.

Output variables

Set File Attributes output variables

Variable Description

errorMessage The executionResult.errorMessages  from the Activity designer 
parsing sources. If this variable is not null, the operation has failed.

result Text message advising that the command was executed successfully.

Conditions

Set File Attributes conditions

Condition Description

Success The activity succeeded in changing the attributes of the specified file or directory.

Failure The activity failed to change the attributes of the specified file or directory.

SSH activity pack

Orchestration provides an activity pack of SSH activities that were customized using the 
ServiceNow  activity designer.

These activities perform the same functions as SSH activities by the same name from previous 
releases and replace those activities for all new workflows. The custom SSH activities were built 
with the Create an SSH activity, which gives workflow administrators the ability to store input and 
output variables in the databus.
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Note: 
Existing workflows from earlier versions that were created with legacy SSH activities 
continue to function normally after an upgrade to Geneva. However, all new workflows must 
use these custom SSH activities.

To use the SSH custom activities, you must request activation  of the Orchestration - SSH plugin.

Secure Copy activity

The Secure Copy activity copies a file from one host to another, without storing the copied file on 
the MID Server.

This activity replaces an SSH activity by the same name available in releases prior to Geneva. 
If you have a workflow created in a previous version that uses the deprecated activity, your 
workflow will continue to work normally after upgrading to Geneva. However, all new workflows 
must use the custom version of this activity. This activity was built with the SSH activity designer 
template, which gives workflow administrators the ability to store input and output variables in 
the databus.

Input variables

Secure Copy input variables

Input variable Description

from_host Host name or IP address of the source machine.

from_scp_file Name of the file to copy, including the absolute path.

to_host Host name or IP address of the target machine.

to_scp_file Path to the target file. This path can be absolute or relative to the logged in 
user's home directory.

debug_mid Check box that enables debug logging when selected.

debug_ssh Check box that enables J2SSH debug logging when selected.

Output variables

Secure Copy output variables

Output 
variable

Description

payload The executionResult.payload  from the Activity designer parsing 
sources.

output The executionResult.output  from the parsing sources.

Conditions

Secure Copy conditions

Condition Description

Success Activity successfully copied the file from one host to another.

Failure Activity failed to copy the file from one host to another.
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Files Compare activity

The Files Compare activity compares two files on a Linux or UNIX computer.

This activity replaces an SSH activity by the same name available in releases prior to Geneva. 
If you have a workflow created in a previous version that uses the deprecated activity, your 
workflow will continue to work normally after upgrading to Geneva. However, all new workflows 
must use the custom version of this activity. This activity was built with the SSH activity designer 
template, which gives workflow administrators the ability to store input and output variables in 
the databus.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Global  > Orchestration - SSH.

Input variables

Files Compare input variables

Input variable Description

Hostname Hostname or IP address of the destination server for SSH activity.

Directory Name of the working directory.

OldFile Name of the first file to compare.

NewFile Name of the second file to compare.

Output variables

Files Compare output variables

Output 
variable

Description

contents File comparison result. This is the difference of the two compared files.

result Either success  or failure.

return-code Either 0, if the two files are the same, or 1, if the two files are different.

errorMessage The executionResult.errorMessages  from the Activity designer 
parsing sources.

Conditions

Files Compare conditions

Condition Description

Success Activity successfully compared the specified files.

Failure Activity could not complare the specified files.

File Read activity

The File Read activity reads a file on a Linux  or UNIX  computer.

This activity replaces an SSH activity by the same name available in releases prior to Geneva. 
If you have a workflow created in a previous version that uses the deprecated activity, your 
workflow will continue to work normally after upgrading to Geneva. However, all new workflows 

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

5032



must use the custom version of this activity. This activity was built with the SSH activity designer 
template, which gives workflow administrators the ability to store input and output variables in 
the databus.

To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Global  > Orchestration - SSH.

Input variables

File read input variables

Input variable Description

Hostname Hostname or IP address of the destination server for SSH activity.

Directory Name of the working directory.

File The name of the file to read.

Output variables

File read output variables

Output 
variable

Description

contents Content of the file to read.

result Either success  or failure.

errorMessage The executionResult.errorMessages  from the Activity designer 
parsing sources.

Conditions

File Read conditions

Condition Description

Success Activity successfully read the contents of the specified file.

Failure Activity could not read the contents of the specified file.

File Write activity

The File Write activity writes a file on a Linux  or UNIX  computer.

The source file can be an absolute or relative path from the Directory. If an absolute path is used, 
then no value is required in the Directory  field.

This activity replaces an SSH activity by the same name available in releases prior to Istanbul. 
If you have a workflow created in a previous version that uses the deprecated activity, your 
workflow will continue to work normally after upgrading to Istanbul. However, all new workflows 
must use the custom version of this activity. This activity was built with the SSH activity template, 
which gives workflow administrators the ability to store input and output variables in the databus.
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Input variables

File Write input variables

Field Description

hostname Hostname or IP address of destination server for SSH activity.

directory Name of the working (target) directory.

file Name of the file to be written.

behavior Select one of the following:

• overwrite: Creates the file if it does not exist and overwrites the file if it does 
exist.

• append: Creates the file if it does not exist and appends the new content to an 
existing file.

• create only: Creates the file if it does not exist and fails if the file does exist.

contents What to write or append (depending on the behavior) to the file

Output variables

File Write output variables

Variable Description

return_code Indicates whether or not the file write 
operation was successful.

error_message Message that indicates if an error has 
occurred. Any value other than 0  indicates a 
failure.

Conditions

File Write conditions

Condition Description

Success The activity wrote a file in the target directory.

Failure The activity failed to write a file in the target 
directory.

File Copy activity

The custom File Copy activity copies a file on a Linux or UNIX computer.

This activity replaces an SSH activity by the same name available in releases prior to Geneva. 
If you have a workflow created in a previous version that uses the deprecated activity, your 
workflow will continue to work normally after upgrading to Geneva. However, all new workflows 
must use the custom version of this activity. This activity was built with the SSH activity designer 
template, which gives workflow administrators the ability to store input and output variables in 
the databus.
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To access this activity in the Workflow Editor, select the Custom  tab, and then navigate to 
Custom Activities  > Global  > Orchestration - SSH.

Input variables

File Copy input variables

Input variable Description

hostname Hostname or IP address of destination server for SSH activity.

directory Name of the working directory.

src_file Name of the source file.

dst_file The name of the destination file.

Output variables

File Copy output variables

Output variable Description

result Either success  or failure.

Conditions

File Copy conditions

Condition Description

Success Activity successfully copied the file on the specified host.

Failure Activity failed to copy the file on the specified host.

File Replace String activity

The File Replace String activity finds and replaces a string in a file on a Linux  or UNIX  computer.

This activity replaces an SSH activity by the same name available in releases prior to Istanbul. 
If you have a workflow created in a previous version that uses the deprecated activity, your 
workflow will continue to work normally after upgrading to Istanbul. However, all new workflows 
must use the custom version of this activity. This activity was built with the SSH activity template, 
which gives workflow administrators the ability to store input and output variables in the databus.

Input variables

File Replace String input variables

Variable Description

hostname Hostname or IP address of destination server for SSH activity.

directory Name of the working (target) directory.

file Name of the file in which the string is to be replaced.

find_pattern A regular expression of the text to replace.
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File Replace String input variables  (continued)

Variable Description

replace_string The replacement string for the text found by the expression in the 
find_pattern  variable.

options Replacement options:

• first: Replaces the first occurence of the pattern.

• all: Replaces all occurrences of the pattern.

Output variables

File Replace String output variables

Variable Description

return_code Indicates whether or not the string was 
replaced successfully in the target file.

error_message Message that indicates if an error has 
occurred. Any value other than 0  indicates a 
failure.

Conditions

File Replace String conditions

Condition Description

Success The activity has successfully replaced the 
string in the file.

Failure The activity has failed to replaced the string in 
the file.

Reset Linux User Password activity

The Reset Linux User Password  activity resets the password for a given user on a Linux 
computer.

This activity requires that the user executing the command be able to run the chpasswd 
command and, if expiring the password immediately, to run chage  with MID Server privileged 
commands.

This activity replaces an SSH activity by the same name available in releases prior to Istanbul. 
If you have a workflow created in a previous version that uses the deprecated activity, your 
workflow will continue to work normally after upgrading to Istanbul. However, all new workflows 
must use the custom version of this activity. This activity was built with the SSH activity template, 
which gives workflow administrators the ability to store input and output variables in the databus.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

5036



Input variables

Reset Linux User Password input variables

Variable Description

hostname IP address of the target Linux machine.

user Name of the user whose password is being reset.

password New password set for this user. The password is a workflow variable that is 
encrypted either as a password2  field or by calling the encryption method of a 
Packages.com.glide.util.Encrypter  object.

force_change Indicates if this password is temporary and to force the named user to change 
the password at login.

Output variables

Reset Linux User Password output variables

Variable Description

return_code Indicates whether or not the user password 
reset action was successful.

error_message Describes any error that occurred during 
password reset. If no error occurred, this value 
is null.

Conditions

Reset Linux User Password conditions

Variable Description

Success Activity successfully changed specified user's 
password

Failure Activity failed to change specified user's 
password.

Global activities

Global activities are Orchestration activities created in the global scope.

Any activities you create in the global scope are listed in the Global category in the Packs  and 
Custom  tabs of the Workflow Editor.
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Global activities

Test Server Alive activity

The Test Server Alive activity determines if a target system is alive by its response to a particular 
protocol.

This activity replaces an activity by the same name available in releases prior to Istanbul. If you 
have a workflow created in a previous version that uses the deprecated activity, your workflow 
will continue to work normally after upgrading to Istanbul. However, all new workflows must use 
the custom version of this activity. This activity was built with the Probe activity template, which 
gives workflow administrators the ability to store input and output variables in the databus.

Input variables

Test Server Alive input variables

Variable Description

port_probes A comma separated list of protocols to use to check 
for signs of activity on the target machine (example: 
wmi,wins,https,ssh,http,https,snmp,dns)

hostname Hostname or IP address of the target system to check.
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Output variables

Test Server Alive output variables

Variable Description

alive Code that indicates whether or not the server 
is alive. If any value but '1'  is returned, the 
server is not alive.

Conditions

Test Server Alive conditions

Condition Description

Success Activity determined that the device is running.

Failure Activity failed to determine if the target 
device is running. Failure could be caused 
by a missing protocol or a device that is not 
accessible.

Orchestration activity designer

The Orchestration activity designer enables a user with either the workflow_admin or 
activity_creator and workflow_creator roles to construct reusable activities that suit an 
organization's business needs.

Activities created by the activity designer offer the following advantages over core activities 
offered in previous releases:

• Reuse custom activities  in multiple workflows.

• Upload and download custom activities from the ServiceNow  Store.

• Parse data from standard input formats.

• Test input variables against a target host or endpoint and inspect the payload.

• Automatically map values from a test payload to an activity's output variables.

• Share data between activities.

• View previous versions of an activity.

Access to the activity designer requires activation of ServiceNow  Orchestration. For instructions 
about managing transitions and conditions for all activities, see Workflow activities .

Orchestration provides numerous pre-defined activities, which are reusable components that 
can be used in numerous workflows without having to understand the complexities of the 
underlying system. These activities are grouped into activity packs, which address specific 
business needs, such as: Active Directory, Azure AD, Exchange, Infoblox DDI, and PowerShell. 
There are other ServiceNow  applications which provide and maintain their own separate activity 
packs, such as Security Incident Response, Cloud Management, or Release Automation.

Customers can also build their own activities and activity packs. You can construct custom 
activities with a specified template through the Orchestration Activity Designer. Custom-built 
activities built with the Activity Designer are referred to as activity elements. Activity elements 
provide optimal operations, enable code reuse, and minimize the need to write code. They also 
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enable you to follow the flow of data within a given workflow across orchestration activities. 
Incorporating activity elements limits the dependency on the scratchpad which reduces 
problems in complex workflows. Limit the use of core activities, like ‘Run Script’, unless you 
need direct access the scratchpad, for example, for a counter. Activity elements do not have 
direct access to the scratchpad. You can, however, pass scratchpad variables as inputs into your 
activities.

Orchestration activities created by the activity designer:

• Can be uploaded and shared in the ServiceNow  App Store

• Use the databus, which allows the activity to have well-defined inputs and outputs

• Share data across activities within a workflow

• Use versioning

• Provide a consistent approach for activity development regardless protocol

Note: 
Prior to the Fujirelease, activities were built with Activity Definitions . In Fuji, a new 
architecture was introduced using the Activity Designer. Orchestration  Core activities, 
built originally as Activity Definitions, have been converted to use the new template 
format (Activity Elements) and the databus offered with the activity designer. Workflows in 
upgraded instances that use legacy activities continue to work normally.

For instructions on using activities to construct a workflow, see Add an activity to a workflow .

Introduction to credentials, connections, and aliases for Orchestration

All application integrations in Orchestration require connection information, credentials, and 
connection and credential aliases to their respective applications to access resources.

Before you can execute an application integration in Orchestration, you must create and 
configure the corresponding connection information and credentials. The Connections pertains 
to an integration with a system, such as an IP address or endpoint with protocols. It contains 
specific details, such as database particulars, when integrating with a database. The associated 
Credentials are the authentication data required to make the connection.

Connection information and credentials can vary between QA/Development/Production 
environments for the same integration. The tight coupling between this data and application 
metadata, such as workflow or job scheduling, make application metadata obsolete when 
you change environments. To alleviate this problem, the concept of an alias is introduced, for 
connections and credentials, to decouple this data from application metadata. These aliases 
allow customers to design their application metadata to couple to an alias, which during runtime 
resolves to connection and credential data.

There are two types of aliases, a connection and credential alias and a credential alias. There 
are business rules that enforce certain constraints on these aliases. Names should contain 
alphabets, numbers, and underscores but cannot have special characters. The alias must be 
unique in a scope. If you choose to have multiple active connections, you can have more than 
one active connection in the same domain. If you do not choose this option, you can have only 
one active connection in per domain.

Note: 
If you enable multiple active connections, when the connection records resolve, your 
application picks one connection based on an established order. The order of the 
connections depends on the API you use to retrieve connection data.
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You can add additional connection attributes to an alias, which are available in connection data 
during run time. Variables overridden by connection administration during run time should not 
affect the alias.

The credential alias resolves only credential data. Along with alias data model, you can use a 
scriptable API which can get connection and credential data during runtime.

Using Connection and Credential Alias with Orchestration

Define an alias to label a credential or connection record.

The Credential and Connection Alias defines an alias that labels a credential or connection 
record. It is extended from the sys_metadata table. It requires the admin role. The 
credential_admin and connection_admin have read access to sys_alias. A connection alias 
contains:

Name

Name of the alias.

ID

This field is based on the format "scope name.alias name" Unique index on ID to 
ensure unique record based on scope name + name. If the scope is global, the ID is 
the alias name.

Type

You can select either 'Credential' or 'Connection and Credential'. The default is 
Connection and Credential.

Connection type

This field is applicable when the alias type is set to Connection and Credential. 
There are three connection types: HTTP, JDBC, JMS. The default is HTTP.

If you create a workday alias in global scope, the ID is set to workday

If you create a workday alias in hr app scope, the ID is set to x_hr_app.workday

• Name can only contain alphabets, numbers and underscore.

• During the upgrade, the tag in credential record will be migrated to connection alias. If the 
tag in previous release’s credential record contains special characters other than alphabets, 
numbers and underscore, the tag data will be preserved during the upgrade. The user still can 
use these connection alias, but the user cannot update these alias, unless he removes these 
special characters when do the update.

Using credentials with Orchestration

Orchestration requires credentials to access resources.

Credential table

The credential table (discovery_credential) defines credentials that can be used for integration. 
In the previous release, the Credential table contains a string-type tag field, which labels a 
credential and the tag is used in orchestration activities. In the madrid release, we rename tag to 
credential alias, and change the type from string to GlideList, which is a reference to connection 
alias table.

Credential types

The following credential types are provided:
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Credential type Description
Supports Test 
Credential 
option

Applicative 
credentials

The credentials to explore the applications on a 
device or computer. Discovery patterns used by ITOM 
Visibility  often need applicative credentials.

No

Amazon Web Service 
credentials

The Amazon Web Services (AWS) master account, 
access key ID, and secret access key.

Note: 
You cannot test AWS credentials through the Test

No

Azure Service 
Principal and 
Enterprise Agreement 
credentials

The Azure service principals required for an Azure 
subscription.

No

Basic authentication 
credentials

A user name and password. No

CIM credentials The user name and password required to access a 
CIMOM - Common Information Model Object Manager 
(CIM) server, which obtains information about VMware 
ESX servers.

No

Cloud credentials Credentials that Orchestration uses to access cloud 
resources.

No

JDBC credentials A user name and password to access a Java Database 
Connectivity (JDBC) connection.

Yes

JMS credentials A user name and password to access to a Java 
Message Service (JMS).

Yes

OAuth 2.0 
credentials

OAuth 2.0 credentials enable ServiceNow to obtain 
access to user accounts on an HTTP service.

SNMP community 
credentials

The community string to access devices via SNMP. Yes

SNMPv3 credentials The user name and keys required to access devices on 
your SNMP v3 network.

Yes

SSH credentials The user name and password to access Linux and Unix 
devices.

Yes

SSH credentials The private key credentials to access Linux and Unix 
devices.

Note: 
For better security, SSH private key credentials 
are recommended over SSH password 
credentials.

Yes

VMware credentials Credentials to access vCenter resources. These 
credentials are required for any work that is performed 
on vCenter, such as cloning a virtual machine.

Yes
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Credential type Description
Supports Test 
Credential 
option

Windows 
credentials

The user name and password required to access 
Windows computers. Several Windows credentials
must be met to use Windows credentials.

Yes

How MID Servers use credentials

By default, Windows MID Servers use the login credentials of the MID Server service on the 
host machine to discover Windows  devices in the network. You should Configure Windows MID 
Server service credentials  so that they have domain or local administrator privileges. For Linux 
and UNIX  machines and network devices, the MID Server uses the SSH and SNMP credentials 
configured in the instance in Discovery  > Credentials.

MID Servers that Orchestration  uses must have access to the necessary credentials to execute 
commands on computers in the network as specified by the Workflow activities . Orchestration 
can use the same SSH and SNMP credentials as Discovery, but has two additional credentials 
designed for specific Workflow activities: Windows  (for PowerShell) and VMware.

Encryption and decryption

The platform stores credentials in an encrypted field on the Credentials [discovery_credentials] 
table. Once they are entered, they cannot be viewed.

When credentials are requested by the MID Server, the platform decrypts the credentials using 
the following process:

1. The credentials are decrypted on the instance with the password2 fixed key.

2. The credentials are re-encrypted on the instance with the MID Server's public key.

3. The credentials are encrypted on the load balancer with SSL.

4. The credentials are decrypted on the MID Server with SSL.

5. The credentials are decrypted on the MID Server with the MID Server's private key.

Note: 
The platform does not have separate encryption keys for multi-tenant instances.

Credential order

Credentials can be assigned an order value in the Credentials form  , which forces the 
application to try all the credentials at their disposal in a certain sequence. If you do not specify 
an order value, the application tries the credentials in the Credentials [discovery_credential] 
table randomly, until it finds one that works, such as when Orchestration attempts to run a 
command on an SSH server (such as a Linux or UNIX machine), or when Discovery attempts to 
query an SNMP device (such as a printer, router, or UPS).

After identifying the credentials for a device, Discovery  and Orchestration create 
an affinity between the credentials and the device using the Credential Affinity 
[dscy_credentials_affinity]  table. All subsequent discoveries or Orchestration 
activities attempt to match the credentials in this table with a device for which an affinity exists. 
If credentials for a device change, Discovery  and Orchestration try all available credentials again 
until they create a new affinity.
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Note: 
If Orchestration and Discovery  are installed, and credential alias is enabled, multiple 
affinities can exist. In this case, the platform looks up credentials for each affinity and 
inserts the credential for the affinity with the lowest order into the probe.

Ordering credentials is useful in the following situations:

• The credentials table contains many credentials, with some used more frequently than others. 
For example, if the table contains 150 SSH credentials, and 5 of those are used to log into 90% 
of the devices, it is good practice to configure those five with low order numbers, which places 
them at the top of the execution list. Discovery  and Orchestration will work faster if they try 
these common credentials first. After the first successful connection, the system knows which 
credentials to use the next time for each device.

• The system has aggressive login security. For example, if the Solaris database servers in the 
network only allow three failed login attempts before they lock out the MID Server, configure 
the database credentials with a low order value.

Credential alias

Credential alias allows flow and workflow creators to:

• Assign individual credentials to any activity in an Orchestration workflow

• Assign individual credentials to any action in Flow Designer

• Assign different credentials to each occurrence of the same activity type in an Orchestration 
workflow.

• Assign different credentials to each occurrence of the same action in designer flow.

Credential alias also works with credential affinities.

External credential stores

If you do not want credentials stored in your instance, you can use external credential 
repositories. External credential stores save the credentials in an external site that your instance 
can access. Only CyberArk  is supported.

Connections with Orchestration

Use the connections table to setup a JMS, JDBC, or HTTP(s) connection to a target host.

Connection Table

The Connection table (sys_connection) is the base table for all connection tables. You can setup 
connections for the following protocols:

• JDBC

• JMS

• HTTP(s)

The connection table references the connection alias table, which couples the connection alias 
to connection information. Every connection records the following information:
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Base connection properties

Field Description

Name Name of the connection. This field must be 
unique on the table.

Credential Specify the credential to use with this 
connection. This is optional.

Connection alias The connection alias resolves your connection 
and credentials at run time. Only one 
connection is active per Connection alias at 
any one time.

Active Check to make the current connection active.

Domain Domain to which the connection belongs.

Credential is unique across active connections, if not empty.

Upgrading connection information

The JDBC connection (jdbc_connection) and JMS connection (orch_jms_ds) tables are existing 
Orchestration connection tables. In madrid, we re-parent them to extend from Connection 
(sys_connection) table. They move from Orchestration run time plugins to Credentials & 
Connections plugins. They are originally extended from sys_metadata. The sys_metadata related 
data will be removed. JDBC field name changes:

• JDBC server is renamed to host

• Database port is renamed to port

Create custom activities using custom activity designer templates

You can create and update different types of custom activities in the Workflow Editor using a 
custom template.

Before you begin
Roles required: workflow_admin or activity_creator

About this task
The Activity Designer contains common steps which are applicable to all the activities that you 
create. This procedure guides you through the common steps and the order they should be set 
up. You specify an activity template before you create a custom activity.

Procedure

1. Navigate to All  > Orchestration  > Workflow Editor.
The Welcome  tab of the Workflow Editor opens.

2. On the Custom  tab in the palette, click +  to create a new activity select the appropriate 
template  from the list.
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The Activity Designer form appears, with a stage indicator at the top. All new activities start at 
the General  stage. The current stage shows with a blue underscore.

Activity designer stage indicator

3. Add the general properties .
This information is standard for each custom activity, include a name, description, and other 
related information.

4. Create the template Create input variables  for the template.
Create the variables to pass into the activity in the Inputs form of the activity designer.

5. Optional:  Add a pre-processing script.
For input validation or transforming input data, you might need a pre-processing script.

Note: 
This step is not included in the Run Script activity.

6. Click Continue  to open the Execution Command form, then fill out the Execution Command 
step based on the corresponding execution templates:

◦ Create a SOAP web service activity

◦ Create a JDBC activity

◦ Create a JavaScript Probe activity

◦ Create a PowerShell activity

◦ Create a REST web service activity

◦ Create a Probe activity

◦ Create an SFTP activity
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◦ Create a Run Script activity

◦ Create an SSH activity

◦ Create a JMS activity

7. Optional:  Test your inputs.

8. Optional:  In the Outputs form, define local and/or output variables.
Local variables can be used for temporary storage when cascading parsing rules. For example, 
you might extract an XML payload from within a JSON payload. A local variable can access 
the XML document and use that as a source for another parsing rule. The graphic shows a 
Local1  variable source to parse data for Output2.

Define local variable

9. Use one of the options to assign values to Outputs.

Option Description

Parsing rule

You can create a parsing rule and map them 
to the output fields by dragging and dropping 
the variables into the parsing rules  structure. 
The REST, SOAP, and JDBC templates pro­
vide auto-mapping to create the parsing rules 
automatically. If available from the test inputs 
form, auto-mapping should be used when 
possible.

Post-processing

Post-processing scripts allow you to code 
your own output data validation, output pars­
ing code, and related tasks. Post-process­
ing executes after the execution command 
results have been returned and before the 
parsing rules and conditions are run. Click Go 
to Post-Processing (Advanced)  to create a 
post-processing script.

Note: 
If you create a script, this step reflects 
as a stage in the indicator.

10. Click Continue  to open the Conditions  form to create exit condition rules for your activity and 
then click Save.

General properties for activity designer templates

The following General Property fields are common to all activity designer templates.
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General Property fields common to all activity designer templates

Fields Description

Name Descriptive name of the activity. Select a unique name that makes the activity 
easily identifiable in the palette. If you do not name the activity, it is identified in 
the Data  tab of the Workflow Editor with an index number when it is added to a 
workflow. This index reflects the order in which the custom activity was added to 
the workflow. Only custom activities and their output variables appear in the Data 
tab.

Short 
description

Brief description of what the activity does.

Image Icon that identifies an activity of this type in the workflow palette.

Execution 
template

Predefined template selected for this activity.

Application Current Application scope  set on the instance. To view the scope, click the gear 
icon on the right side of the title bar in any record or list and look at the value in 
the Application  field. The activity runs in this scope within a workflow. You cannot 
view or change the scope for the instance in the Workflow Editor.

Accessible 
from

Accessibility setting for this activity, by scope. The following options are available:

• All application scopes: This activity is available to all application scopes.

• This application scope only: Use of this activity is restricted to the scope 
named in the Application  field.

Category Category for this activity in the Custom  and Packs  tabs. All categories are listed 
under their scope in the collapsible hierarchy.

Description Detailed description of the activity.

Create input variables

Create the variables to pass into the activity in the Inputs  form of the activity designer.

Before you begin
You must name your activity in the General  form before you can advance to the Inputs  stage.

Roles required: workflow_admin or activity_creator

Note: 
Variable strings in the Inputs  form have a 255 character limit.

Procedure

1. Click the +  icon to create a new input variable.

The designer creates a default variable called Input1.
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2. Type your new variable name in the field.

3. To change the name of a variable or any of its attributes, double-click the value and then select 
or enter a new value in the field that appears.

4. Configure your variable using these fields:

Variable configuration

Field Description

Type Data type for this variable. Double-click on 
the field to display the choice list. In addition 
to the usual data types, you can create input 
arrays and encrypt individual variables that 
contain sensitive data. Encrypted variables 
are passed to the ECC Queue and then 
decrypted by the MID Server when they run 
on the target host. Sensitive data returned 
from running these variables on the host can 
then be passed to another activity through 
encrypted output variables.

Mandatory Marks an input variable as mandatory. 
Variables marked as mandatory are required 
fields in the properties form for the activity in 
the workflow. The input testing feature allows 
you to filter on mandatory variables.

Default Default value for this input variable. Default 
values are prepopulated for variables in 
the properties form for the activity in the 
workflow. You can override this value when 
you test the variables.

5. To reorder the variable list, select a row and then drag the row to its new location.

When you select a row to move it, the pointer icon changes to an up/down arrow icon ( ).

6. To delete a variable, click the delete icon ( ) in the row.

7. Click Continue  to advance to the Execution Command  stage or click Go to Pre-Processing 
(Advanced)  to create a script that runs before the activity executes.
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Map an input variable

After you create the input variables, map them to the fields in the Execution Command form.

Before you begin
Role required: activity_admin, activity_creator

About this task
These fields contain values required by the target host or endpoint to authenticate and query for 
data. Included in this example are fields for a command to run on the target and the MID Server 
to use, if one is required.

Procedure

To map a variable, drag it into the appropriate field.

The designer automatically expresses the variable in the syntax the system requires.

Configure the PowerShell execution command

Use the input variables you created to configure the command that Orchestration executes on 
the Windows target machine.

Before you begin
Create the input variables you need in the Inputs  form before you can advance to the Execution 
Command  stage.

Role required: activity_creator, admin

Note: 
You can test the PowerShell connection between the MID Server and the target computer 
without having to run the acvitity in a workflow context. For details, see test template 
outputs.

Procedure

1. Drag variables from the list of inputs and drop them into command fields.
The system formats the variable in the proper syntax for the command.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

5050



PowerShell execution command

2. Complete the fields shown in the table.

Powershell command fields

Field Description

Input Input variable builder. Create variables  to map  to available fields.

Target host Host name or IP address of the target server for this PowerShell activity.

Script type Type of script to run on the PowerShell host. Available options are:

◦ Custom Powershell command

◦ MID Server script file

MID Server 
script file

MID Server script file to run. This field is available when the Script type  selected 
is MID Server script file.

Command Command that this activity runs on the target host. This field is available when 
the Script type  selected is Custom Powershell command. You can drag and 
drop input variables from the variable builder into this field to create your 
command.

Powershell 
variables

Name-value pairs to pass to the host with Powershell. You can create these 
variables manually, or drag input variables into the Value  field. Encrypted input 
variables retain their encryption, regardless of the data type settings in this 
field. If you type in a value and select the Encrypted  data type, your value 
appears in plain text in this field and is only encrypted when it passes to the 
ECC Queue.

Use MID 
service 
account

Forces this activity to authenticate on the target host using the credentials of 
the MID Server service account only, without trying any other credentials. When 
this check box is selected, the Credential tag  field is not available.

Credential 
tag

Specific Credential aliases for Orchestration activities  this activity must use to 
run Powershell commands on the host. If this field is left blank, the MID Server 
tries all the available credentials until it finds a valid one, ending with the MID 
Server service account. If a credential alias is defined, the MID Server tries the 
credentials for that alias only and does not try the MID Server service account. 
This field is not available when the Use MID service account  check box is 
selected.
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Field Description

Required 
MID Server 
capabilities

MID Server to use for querying Powershell, by capabilities. By default, the 
system selects a Powershell MID Server.

3. Click Save.

4. Click Continue  to advance to the Outputs  stage.

Test activity template inputs

You can test the input parameters of a custom activity during its development without having to 
run the activity in a workflow context.

Before you begin
Create input variables and map them to fields in the Execution Command  form or provide actual 
values for these fields.

Role required: web_service_admin, activity_admin, activity_creator

About this task
An input test executes only the input parameters against an endpoint and not the pre-processing 
or post-processing scripts. You need to use a workflow to test a pre-processing or post-
processing scritp. You do not need to check out the activity to test it, and you can test input 
variables from any stage in the activity designer, if your activity is properly configured. Typically, 
the Execution Command  stage is the point at which your inputs are ready for testing.

Note: 
If you intend to use auto-mapping, you must test your input variables.

Procedure

1. Click Test Inputs.
The list of input source variables appears. If you added default values for these variables, 
those values appear in the Substitute Value  column. Mandatory variables are marked with a 
red star. In this example, a SOAP endpoint returns a value for a stock quote variable.

2. Filter the variable list with these controls:
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◦ All Inputs: Displays all input variables. This is the default view.

◦ Mandatory Inputs: Displays only mandatory input variables.

◦ Inputs Without Defaults: Shows input variables that do not have assigned default values.

3. Reset values as needed.

◦ Reset default values: Replaces any test values set in this form with the default values, if they 
are present.

◦ Clear values: Clears all values in the input variable list, even if default values exist.

4. When your test values are configured correctly, click OK.
The system runs the values for all the inputs configured against the specified target and 
returns the resulting payload. The buttons in the Response form display different views of the 
payload. The entire payload appears in the Raw Output  window.

Response payload from inputs test

5. To map appropriate parameter values in the payload to variables in the Outputs  stage 
automatically, select an auto-mapping option.

6. Alternately, you can click Save for parsing rules  to copy the entire payload to the parsing rules.
This allows you to manually select values for the output variables directly from the payload. 
This action completely overwrites any previous payload that existed in the parsing rules.

7. Click the X  in the upper right corner of the window to close it.

Data encryption for activity variables

You can protect sensitive data passed from Orchestration activities by encrypting input and 
output variables.

The system never stores encrypted variables as clear text. If the MID Server is used to fulfill 
the activity, the corresponding ECC Queue's input payload is encrypted if an encrypted output 
variable  is defined in the template. Output variables passed to a downstream activity as input 
variables maintain their encryption throughout processing.

Inputs that require data encryption come from one of these sources:
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• Workflows: These inputs are provided through the Workflow Editor and must be in the 
password2 format for two-way encryption.

• Service catalog requests: These input values are provided to an activity as encrypted variables 
from a service catalog item.

• GlideRecord: These are variables attached to any ServiceNow  table. The source column in the 
table must be a password2 type variable.

• Activity outputs: These are variables passed as outputs from one activity to a downstream 
activity as inputs, through the data bus.

• Empty string: The system allows you to define encrypted input variables but never pass a value 
into the variable.

Activity designer template pre-processing fields

Use the Pre Processing  form of the activity designer to define a script to run before the activity 
executes.

Pre-processing fields

Field Description

Input 
process 
script

Script to run before the activity executes.

Variables Input variables that are available to use as building blocks in the input process 
script. Click the arrow above the field to open the variables list. Click an item in the 
tree to add it to your script in the appropriate syntax. The list displays execution 
parameters and input variables you passed into the activity on the Inputs  form. 
All activity variables added in the Inputs  form are read-only and are expressed 
in the pre-processing script with this syntax: activityInput.variable. 
Before the activity executes and makes a call to the service or host, you can 
override the effective execution value of this variable by assigning values to the 
executionParam.variable_name  execution parameter. Refer to the specific 
execution parameters for your template.

Logging

Activity designers can add logging to the pre-processing using the ActivityLogger  API, 
which works for scoped or global applications. Logged data from the script appears in the 
Workflow Log  related list in the context records for any workflow that uses the activity. The 
Source  for these messages in the workflow log is ACTIVITY.

Important: 
To display the debug messages in the workflow log, set the 
glide.workflow.log.debug  property to true.

The supported messages are:

• ActivityLogger.debug("Pre Processing Log Message");

• ActivityLogger.info ("Pre Processing Log Message");

• ActivityLogger.warn ("Pre Processing Log Message");

• ActivityLogger.error("Pre Processing Log Message");
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ActivityLogger API

Template post-processing fields

From the Post Processing  form in the activity designer you can define a script to run after the 
activity executes.

Post-processing fields

To use the results returned by the activity, append the executionResult.  prefix to these 
parameters.

Field Description

Output 
process 
script

Script to run after the activity executes.

Variables Input variables that are available to use as building blocks in the output process 
script. Click the arrow above the field to open the variables list. Click an item in the 
tree to add it to your script in the appropriate syntax. The list displays execution 
results and the variables you passed into the activity on the Inputs  form. All activity 
variables added in the Inputs  form are read-only and are expressed in the post-
processing script with this syntax: activityInput.variable. For parameter 
descriptions, refer to the table in the post-processing parameters topic for this 
activity.

Logging

Activity designers can add logging to the post-processing script using the ActivityLogger 
API, which works for scoped or global applications. Logged data from the script appears in the 
Workflow Log  related list in the context records for any workflow that uses the activity. The 
Source  for these messages in the workflow log is ACTIVITY.

Important: 
To display the debug messages in the workflow log, set the 
glide.workflow.log.debug  property to true.

The supported messages are:

• ActivityLogger.debug("Post Processing Log Message");

• ActivityLogger.info ("Post Processing Log Message");

• ActivityLogger.warn ("Post Processing Log Message");

• ActivityLogger.error("Post Processing Log Message");
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ActivityLogger API

Auto-map activity output variables

You can map parameter values in a test payload to variables in the Outputs  tab automatically.

Before you begin
Role required: admin

Procedure

1. From the Execution Command in the template, select the Inputs  tab.

2. Click Test Inputs  to test the input parameters.
If you added actual values for the parameters and fields, the system runs those values against 
the specified target and returns the resulting payload. If you mapped input variables to fields 
and parameters, the system displays a dialog box for assigning test values to those variables.

3. Provide test values, if requested, and click OK  to display the payload.
The entire payload appears in the Raw Output  tab of the Response form.

4. Select an auto-mapping option.

Option Description

Auto-Map to Local

Translates the entire payload into a JSON 
object and places it in the data bus. This al­
lows for post-processing manipulation in 
JavaScript. This selection causes the entire 
data field on the right to disappear and the 
inputs structure to be auto-populated with 
these default variables:

◦ output

◦ totalRows

◦ errorMessage

◦ eccSysId
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Option Description

Auto-Map to Output
Automatically populates the output variables 
in the activity with the same default variables 
used as inputs for the local variable.

Note: 
No parsing rules are available with auto-mapping selections.

Create an output variable

The Outputs  form in the designer contains a variable builder for creating data structures of 
objects and arrays.

Before you begin
Roles required: activity_admin, activity_creator

About this task
Elements in this structure are mapped with Create a parsing rule  to specific data contained in 
payloads returned from an endpoint or host. These variables and their values are then made 
available locally or for reuse in other activities.

Procedure

1. Click the +  icon in the Outputs  column to create a local or output variable.

Local variables are only available within an activity and are not visible in the data structures 
displayed in the Custom  tab. Output variables are available for reuse in other activities, either 
individually or as an entire data structure. When you create a new variable of either type, the 
designer provides a default name of Local1  or Output1.

2. Type your new variable name in the field and select a data type.

Variable names must be unique within an array or an object. You can assign a data type of 
Encrypted  to output variables that contain sensitive data. Data protected by encryption is 
passed to other activities or processes encrypted and is never displayed in plain text.

3. To change the name of a variable or any of its attributes, double-click the value, type a new 
value in the editing field, and then press Enter.

The icon to the left of the name reflects the data type of the variable.

4. To reorder the variable list, select a row and then drag the row to its new location.

When you select a row to move it, the pointer icon changes to an up/down arrow icon ( ).

5. Drag the row into another location.

6. Choose from the following options.

◦ To reuse a variable from another activity, drag it from the Custom  tab in the palette to the 
Local  or Output  heading at the top of the variable list.

◦ To copy an entire data structure, drag the parent object or array into the variable list header.
The designer duplicates the copied data structure in the outputs variable builder.
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Reuse of data structures

7. To delete a variable, click the delete icon ( ) in the row.

Activity designer template outputs

Output variables contain messages returned from a destination that are available to other 
activities in a workflow or internally to the activity.

Activity designer output fields

Field Description

Variable 
name

Name of a variable, either Local  or Output, that this activity passes.

Local Variable that contains a value used within an activity. For example, use a local 
variable to identify metadata that is processed within an activity before the final value 
is exported to an output variable.

Output Variable that contains a value that is passed to other activities in the workflow.

Map an output field

Mapping is configured with parsing rules that allow you to build expressions in the appropriate 
data format for the selected payload.

Before you begin
Role required: activity_admin, activity_creator

About this task
When you are finished creating the output data structure, map each variable to the specific data 
you want to extract from the target host.

Procedure

To map a variable, drag it from the Outputs  variable builder and drop it into an empty Variable 
name  field in the Parsing rules section.

See create a parsing rule  for instructions on configuring parsing for output variables.
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Create a parsing rule

Populate output variables defined in a custom activity with payload data returned from an inputs 
test on an external host or endpoint.

Before you begin
Roles required: activity_admin, activity_creator

About this task

Procedure

1. Navigate to All  > Workflow  > Workflow Editor.

2. From the Custom  tab in the palette, open a custom activity.

3. In the Activity Designer form, advance to the Output  stage.

4. Drag an output variable from the data structure builder into the Variable name  field in the 
Parsing rules  builder.

Mapping variables to parsing rules

The parsing rules form appears for the selected variable. By default, the parsing type is set 
to Direct, which populates the variable with all the data from the selected payload, without 
parsing the contents. Each template has a specific default parsing source.

5. Complete the form using the fields in the table.
In this example, the parsing type selected is XML, which allows you to select specific 
parameters from the payload to parse.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

5059



Parsing rules fields

Field Description

Parsing 
source

Source of the data returned from the target host or endpoint. Each template 
opens to a specific, default payload. Available choices depend on the execution 
template selected for the activity. You can also use local variables as a parsing 
source if a parsing rule has previously been defined for them. For a list of the 
available payloads for each template, see Activity designer parsing sources.

Expression Expression used to extract specific data from the selected parsing source. This 
expression is created from clickable data  in the sample payload and appears in 
the format selected in the Parsing type  field. When testing, the expression can 
return multiple results. Discern which choice gives reliable or predictable results 
before choosing your expression.

Note: 
The system cannot generate clickable RegEx  expressions from sample 
data. You must write all regular expressions manually.

Variable 
name

Revised variable name as it is used in the final output expression. The system 
adds the activityOutput  or activityLocal  prefix to the variable you specify.

Parsing 
type

The language to use for querying the target host's payload. The selections are:

◦ Direct: Maps to the entire content of the payload selected in the Parsing 
source  field, without any parsing. This is the default parsing type.

◦ XML: XPath query used for selecting nodes from an XML payload.
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Field Description

◦ JSON: JSONPath query for selecting parts of a JSON payload.

◦ RegEx: Parsing method that uses a regular expression to extract data from a 
payload. The RegEx parsing type does not support multi-line parsing and is 
not case sensitive.

Short 
description

Brief description of this parsing rule.

Sample 
payload 
data

Sample data from the source containing the data requested. This field is not 
available for Direct  parsing types. After you click Parse sample data, the data 
in this field cannot be edited, but becomes clickable for the purpose of creating 
expressions. Click Edit sample data  to make the field editable again.

Parsing 
results

Displays the data returned from the source by the selected expression. This 
field is not available for Direct  parsing types.

6. To retest the inputs, click Get sample payload from test.
This action reopens the test form, allowing you to substitute different test values and create a 
different payload.

7. Click Save  to have the parsing rules overwrite the previous payload with the one you just 
created.

8. To create an expression for the parsing rule, click the specific parameter you want to see in the 
sample payload.
The value for that parameter appears in the Parsing result  field, and the system creates the 
appropriate expression in the Expression  field.

9. Click Submit  to save the parsing rule for that variable.

Activity designer parsing sources

This table lists the parsing sources available with each execution template.

Parsing sources

Template Source

SOAP Web Service • executionResult.body (Default)

• executionResult.status_code

• executionResult.header

• executionResult.error

JDBC • executionResult.output (Default)

• executionResult.errorMessages

• executionResult.probeCompletedEccId

• executionResult.totalRows

JavaScript Probe • executionResult.payload (Default)

• executionResult.output
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Parsing sources  (continued)

Template Source

• executionResult.eccSysId

• executionResult.errorMessages

Powershell • executionResult.output (Default)

• executionResult.tags

• executionResult.hresult

• executionResult.eccSysId

• executionResult.errorMessages

REST Web Service • executionResult.body (Default)

• executionResult.status_code

• executionResult.header

• executionResult.error

SFTP • executionResult.output (Default)

• executionResult.eccSysId

• executionResult.errorMessages

• executionResult.tags

Probe • executionResult.output (Default)

• executionResult.payload

• executionResult.eccSysId

SSH • executionResult.output (Default)

• executionResult.eccSysId

• executionResult.errorMessages

• executionResult.tags

JMS • executionResult.status

• executionResult.standardHeaders

• executionResult.customHeaders

• executionResult.messagePayload

• executionResult.eccSysId

• executionResult.errorMessages
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Activity designer parsing rule example

In this example, the parsing rule is configured to populate the activityOutput.ipv4  variable with 
the value for the IP address from a domain server, using PowerShell.

Before you begin
Role required: activity_creator, activity_admin

About this task
To generate the sample data, the administrator must actually run the command on the host and 
then paste the data returned into the Sample payload data  field when creating the parsing rule. 
The administrator can then create an expression that returns IP addresses from that sample in 
two formats: ipv4  and ipv6. In this example, the system produces two expressions to use for 
the parsing rule.

Procedure

1. Navigate to All  > Workflow  > Workflow Editor  and open the activity that runs on the host.

2. Click the Inputs  tab, and note the Command.

Parsing rule PowerShell inputs command

3. In a PowerShell console, run the Command  on the host to extract the XML sample that 
contains the values you need.

4. Copy the data that is returned to the clipboard.

5. In the activity designer, click the Outputs  tab and paste the returned data into the Sample 
payload data  field.

In this example, the data includes IP addresses in two different formats and the domain name.

6. Select the parsing type for the source.

Example 
In the following example, you would select XML.
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7. Click Parse sample data.

The system displays the XML in the proper format, and it becomes clickable. In this view, the 
system can translate clicked data from the sample into an expression.

8. To create the expression, click the elements in the data sample you want to map to the 
variable.

Based on the sample data you clicked, the system creates two expressions.
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9. Select an expression from the list.

The desired result is the IP address that has a type  attribute of ipv4. The system populates the 
Expression  field with this choice.

10. Click Test expression.

The system parses the payload using the selected expression and returns the requested data 
in the Parsing result  field.
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11. Click Submit.

The view returns to the Outputs  tab of the activity designer. The new parsing rule is listed, and 
a blank row is available for another rule.

Activity conditions

Create the exit conditions for your activity in the Condition  column and set the order for each..

The system evaluates the condition with the lowest order number first and stops when it finds 
the first true condition. The system delays evaluation of conditions with an Else  value set to true 
until all conditions with an Else  value set to false  are evaluated. If the system does not find a true 
condition, it looks for a default condition in which the value for Else  is true  and takes this exit. You 
must have at least one default exit condition, or the activity hangs when the workflow runs.

The following are possible conditions you might create for an activity:

Sample activity conditions

Condition Evaluation

Success Tests for a success condition. Else  is set to false  and the Order  is set to 100. If this 
condition is true, the activity takes the Success  exit. If this condition is false, the 
system evaluates the next condition in order.
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Sample activity conditions  (continued)

Condition Evaluation

Retry Tests for a condition that runs the activity again. Else  is set to false. If this condition 
is true, the activity runs again. If this condition is false, the system takes the default 
Failure  exit.

Failure Default condition that allows the workflow to continue if the other conditions in the 
activity are false. Else  is set to true.

Orchestration custom activity templates

Orchestration provides customizable activity templates to create and manage custom activities 
in the Workflow Editor.

You create and update different types of Orchestration  activities with the Activity Designer using 
activity templates for SSH, PowerShell, REST, SOAP, JMS, SFTP, JDBC, JavaScript Probes, and 
Probes.

Hundreds of workflows can share these activities simultaneously. Before you change an activity, 

you should check the workflows that they are part of by clicking the form menu icon ( ) and 
selecting Used In. Any central change to a versioned activity automatically updates across 
workflows unless you have pinned that activity .

All the Orchestration  Core activities are built using the Activity Designer in scoped applications. 
Custom activities can be developed in the global scope or their own application scope even if 
that scope is different from the scope of the workflow. Use Activity scoping  when build your own 
activity packs.

Create a JDBC activity

Create a custom JDBC activity to automate SQL commands and stored procedure calls to 
relational databases from workflow.

Before you begin
Role required: activity_admin, activity_creator

About this task
The JDBC activity template allows you to execute ANSI SQL statements or stored procedures 
on a target database. Support for stored procedures with IN, OUT, and INOUT parameters 
are available in Washington DC. To learn how to set up these parameters, see JDBC stored 
procedure parameters.
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Note: 
If you are transferring bulk data into a ServiceNow  instance from an external data source, 
use Import sets key concepts . The JDBC activities allow you to transfer data between 
external data sources and ServiceNow  within a workflow. It is not intended to replace the 
bulk import features of data sources.

Procedure

1. Create or verify your JDBC credential .
Your JDBC credentials must have permission for the target database and proper configuration 
for the corresponding JDBC connection. Credentials must be set up before you can create a 
JDBC activity.

2. Create or verify your JDBC connection.
Your JDBC connection must be configured with valid JDBC credentials set up before you can 
create a JDBC activity.

3. Create a custom activity .
This action creates a custom activity using a template.

4. After setting up general properties  and creating input variables, configure the JDBC Execution 
Command.

Option Description

JDBC Connection

Configure or reference the appropriate JDBC 
Connection for the database. The connection 
selected provides the activity with the follow­
ing information:

◦ Target database information (server and 
database names)

◦ Connection URL

◦ Target database port (if different from stan­
dard port number)

◦ Database instance name

Credential
JDBC credential to use for your JDBC connec­
tion.

SQL statement

Input the ANSI SQL to execute on the JDBC 
target database.

Note: 
This field is hidden when the Stored Pro­
cedure check box is selected.

You can map the input variables  you created 
to configure the SQL statements. By default, 
you can run the following SQL statements.

◦ select

◦ insert

◦ update

◦ delete

◦ show
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Option Description

◦ create

◦ describe
For added security measure, a MID Server 
property controls the operations that this JD­
BCOrchestrationProbe executes, which re­
stricts the SQL commands used. This prop­
erty protects against potentially destructive 
commands, such as drop database. The 
mid.property.jdbc_operations contains the 
MID Server property controls.

Note: 
You cannot run multiple statements of 
different types. For example, you cannot 
run a select statement and an update 
statement together, but you can run two 
insert statements. However, you cannot 
run multiple select statements in this ac­
tivity.

Maximum rows
Maximum number of records to retrieve from 
database. The default is 1000.

Maximum payload size (KB)
You can set a limit on the maximum payload 
size of data retrieved from the database. The 
default is 64 kilobytes.

Connection timeout

How long the activity waits to make the con­
nection. This field is populated automatically 
from the data source, but can be changed for 
this activity.

Query timeout

Elapsed time to wait after running the query 
until the data is returned. This field is popu­
lated automatically from the data source, but 
can be changed for this activity.

Required MID Server capabilities
MID Server to use for querying JDBC, by capa­
bilities. By default, the system selects a MID 
Server that has JDBC capability.

Use stored procedure

If checked, you can run a stored procedure 
on MySQL, Oracle, or SQL Server databases 
by entering the procedure name and parame­
ters. See JDBC stored procedure parameters.

Note: 
You can map parameter values in a test payload to variables in the Outputs  tab 
automatically. See automap output variables.
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What to do next

• Test JDBC activity inputs

• Use auto-mapping  to generate outputs and parsing rules (recommended for JDBC)

• If you do not use auto-mapping, you can manually create output variables  and create parsing 
rules

Related topics

Create custom activities using custom activity designer templates

Create a JDBC connection for an Orchestration  activity

The JDBC Connection [jdbc_connection] table provides the information custom JDBC 
Orchestration activities use to connect to various target databases.

Before you begin
You must have an appropriate JAR file, whether it is supplied with the instance or a custom JAR 
file.

Note: 
The ServiceNow  instance supplies mysql-connector-java-5.1.21.jar, sql-
server-jdbc-4.0.jar, and ojdbc6.jar  files as part of the current release, which 
supports MySQL, SQLServer, and Oracle databases. Other databases, such as Sybase or 
DB2 Universal, must use a custom JAR file that must be uploaded to the instance before 
setting the JDBC connection.

Role required: activity_admin, activity_creator

About this task
JDBC credentials  JDBC credentials  are retrieved separately by the activity designer template 
and support external credential storage, such as CyberArk .

Procedure

1. Navigate to All  > Orchestration  > Credentials & Connections  > JDBC Connections  and click 
New.

2. Complete the form using the fields in the table.
The database selection in the Format  field determines which fields are available.

JDBC connection fields

Field Database Format Description

Name All Unique name of this JDBC connection. For example, 
you might enter JDBC MySQLProd.

Query timeout All Maximum elapsed time the JDBC query is allowed to 
run without a response.

Connection 
timeout

All Maximum elapsed time for the JDBC activity to wait 
while attempting to connect to the target database.

Application All Scope for this table. By default, the JDBC Connection 
[jdbc_connection] table runs in the Global  scope.

Domain All Domain for this table. By default, the JDBC Connection 
[jdbc_connection] table runs in the global  domain.

Format All Database type for this connection. The default choices 
are:
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Field Database Format Description

◦ MySQL

◦ Oracle

◦ SQLServer

◦ None
You can add Sybase  or DB2 Universal  to the choice 
list by uploading the appropriate JDBC driver JAR file 
to the instance. Orchestration automatically recognizes 
these drivers when they are loaded into the system 
and adds them to this list.

Server Oracle, MySQL, 
SQLServer

Host name or IP address of the database server.

Oracle sid Oracle The Oracle database site identifier. The default value is 
orcl.

Oracle port Oracle Port that the Oracle database is using. The default 
value is 1521.

Database name MySQL, 
SQLServer

Name of the database.

Database port My SQL, 
SQLServer

Port that the selected database is using.

Instance name SQLServer Instance name for the selected SQLServer

Connection URL All URL that the MID Server uses to connect to the 
specified database. The URL is created automatically 
when you save the form, and is read-only for the 
default databases.

Note: 
If the format selected is not one of the default 
databases, you must create the connection URL 
manually so that the MID Server knows how to 
create the connection.

JDBC driver None, DB2 
Universal, 
Sybase

The JDBC driver to use for this connection when it is 
not a default database.

Note: 
If you add a Sybase or DB2 Universal database, 
you must enter the driver name in this field and 
upload the driver JAR file to the instance.
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JDBC connection to Oracle example

3. Click Submit.

Related topics

JDBC credentials

Auto-map JDBC activity output variables

The ServiceNow  activity designer allows you to map parameter values in a JDBC test payload to 
variables in the Outputs  tab automatically.

Before you begin
Role required: admin

Procedure

1. In the JDBC provider template form, select the Inputs  tab.

2. Click Test Activity  to test the input parameters.
If you added actual values for the parameters and fields, the system runs those values against 
the specified target and returns the resulting payload. If you mapped input variables to fields 
and parameters, the system displays a dialog box for assigning test values to those variables.

3. Provide test values, if requested, and click OK  to display the payload.
The entire payload appears in the Raw Output  tab of the Response form.

4. Select one of these auto-mapping options.

◦ Auto-Map to Local: Directly maps values to a local variable for use within the activity.

◦ Auto-Map to Output: Directly maps values to the output variable to pass to other activities in 
the workflow. Auto-mapping to an output variable creates an array of objects, each of which 
contains the column names from the query result.
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JDBC stored procedure parameters

You can use Orchestration to run a stored procedure on MySQL, Oracle DB, and MS-SQL 
databases.

There is support of multiple data types, with the following limitations:

• Only one result-set is returned.

• The order of input and output data types in the stored procedure parameters must match the 
activity definition.

• Binary, Blob, Varbinary, and LongBinary should be base64 encoded.

• Date, Time, and Timestamp have a specific format:

Date format: yyyy-mm-dd

yyyy-mm-dd is the supported format.

Time format: hh:mm:ss[.sss]

hh:mm:ss[.sss] is the supported format. Precision is in milliseconds only, 
microseconds or nanoseconds cannot be handled.

Note: 
10:30:59  and 10:30:59.999000  are correct, but 10:30:59.  is 
incorrect.

Timestamp format: yyyy-mm-dd hh:mm:ss[.ffffff]

yyyy-mm-dd hh:mm:ss[.ffffff] is the supported format. Precision is to 
microseconds.

• ResultSet is the first result set coming back from database server.

• MS-SQL does not support INOUT parameters. If you use INOUT parameters, the Activity 
Template transparently maps them to OUT parameters.

Note: 
If you do not want to do a validation of data types in stored procedure parameters, like the 
legacy behavior, you set the glide.stored_proc.data_type.validation as false. See MID Server 
properties  for more information.

Stored procedure parameters

Field Description

Mode Type of stored procedure parameter. 
Supported parameters:

• IN

• OUT

• INOUT

Sql Type A SQL data type. Supported data types:

• ARRAY

• BIGINT

• BINARY

• BIT
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Stored procedure parameters  (continued)

Field Description

• BLOB

• CHAR

• CLOB

• DATE

• DECIMAL

• DISTINCT

• DOUBLE

• FLOAT

• INT

• INTEGER

• JAVA_OBJECT

• LONGVARBINARY

• LONGVARCHAR

• NULL

• NUMERIC

• OTHER

• REAL

• REF

• REF_CURSOR

• SMALLINT

• STRUCT

• TIME

• TIMESTAMP

• TINYINT

• VARBINARY

• VARCHAR

Name/Value Name-value pairs to pass to the host. You can 
create these parameters manually, or drag and 
drop input variables into the parameter fields 
and assign a value.

Note: 
Not all database providers support the entire realm of JDBC data types. Reference your 
database reference manual to understand the supported datatypes for your installation.

Test JDBC activity template inputs

You can test the input parameters of a custom JDBC activity during its development without 
having to run the activity in a workflow context.
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Before you begin
Create input variables and map them to fields in the Execution Command form or provide actual 
values for these fields. Role required: web_service_admin, activity_admin, activity_creator

About this task
This test executes only the input parameters against an endpoint and not the pre-processing or 
post-processing scripts. It is not necessary to check out the activity to test it.

Note: 
If you provide enough information for Orchestration to contact the endpoint or host and 
return data, you can test the input variables. You can test from any stage in the activity 
designer. Typically, the Execution Command stage is the point at which your inputs are 
ready for testing.

Procedure

1. From the JDBC Execution Command, click Test Inputs.
The list of input source variables appears. If you added default values for these variables, 
those values appear in the Substitute Value  column. Mandatory variables are marked with a 
red star.

Note: 
The test fails if the MID Server cannot be found or if it cannot connect to the target.

JDBC input test values

2. Filter the variable list with these controls:

◦ All Inputs: Displays all input variables. This control is the default view.

◦ Mandatory Inputs: Displays only mandatory variables.

◦ Inputs Without Defaults: Shows input variables that do not have assigned default values.

3. Reset values as needed.
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◦ Reset default values: If values are present, this control replaces any test values set in this 
form with the default values.

◦ Clear values: Clears all values in the input variable list, even if default values exist.

4. When your test values are configured correctly, click OK.
The system runs the values for all the inputs configured against the specified target and 
returns the resulting payload. The buttons in the Response form display different views of the 
payload. The entire payload appears in the Raw Output  window.

Response payload from inputs test

5. To map appropriate parameter values in the payload to variables in the Outputs  stage 
automatically, select an auto-mapping option.

6. Click the X  in the upper right corner of the window to close it.

Create a SOAP web service activity

Use this template to create a custom SOAP activity.

Before you begin
Role required: web_service_admin, activity_admin, activity_creator

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

5076



About this task
For instructions on using the activity template process flow, see create custom activities.

Procedure

1. Create a custom activity .
This action creates a custom activity using a template.

2. After setting up general properties  and creating input variables, configure the SOAP web 
service Execution Command.

Option Description

Map the input variables
Use the variables you created to configure 
the command that Orchestration executes on 
the SOAP web service.

Web service message

Specify the SOAP web service message to 
use for this activity. If you need information 
on SOAP web services messages, see SOAP 

.

Web service message function
Specify the SOAP message function available 
in conjunction with the SOAP web service.

Endpoint

If you enter an endpoint in this field, it over­
rides the endpoint URL configured in the 
SOAP message web service. Click the lock 
icon to open the input field and add the end­
point.

SOAP message parameters

Name-value pairs to pass to the SOAP end­
point. You can create these parameters man­
ually, or drag input variables into the parame­
ter fields and then assign a value. Parameters 
defined in the SOAP message that use ${} 
can be assigned data from this activity tem­
plate. Use the Additional attribute  column to 
configure the system to not escape the text. 
By default, text sent to the SOAP message is 
escaped. The Name  column is auto-populat­
ed if the users have provided variables using 
Variable substitution in outbound REST mes­

 in the SOAP message.

Use MID Server

Check box that determines if a MID Server 
must be used to invoke the SOAP web ser­
vice. If the SOAP web service message func­
tion defines a MID Server, that MID Server is 
used instead of the one selected here.

Required MID Server capabilities

MID Server with the appropriate MID Server 
capabilities  for connecting to the SOAP end­
point. By default, the system selects a MID 
Server with SOAP capabilities. This field is 
available when the Use MID Server  check 
box is selected.
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Option Description

Timeout
Allowed duration of the SOAP web service re­
quest before it times out, in seconds. The de­
fault is 10.

Authentication

Determines what type of authentication is re­
quired for the endpoint. The options are:

◦ Use existing credentials in SOAP mes­
sage: Uses credential definitions from the 
SOAP message definition.

◦ Override with Basic Authentication cre­
dentials:  Uses |Enable basic authentica­

 credentials. Over­
rides the credentials in the SOAP message 
definition. Basic authentication credentials 
must be provisioned before they are avail­
able for selection.

◦ Override with Certificate Authentication 
credentials: Overrides the credentials in 
the SOAP message definition with certifi­
cate authentication credentials.

◦ Override with Both Basic and Certificate 
Authentication credentials: Overrides the 
credentials in the SOAP message definition 
with both basic authentication or certificate 
authentication credentials.

◦ Override with WS-Security Username 
profile: Overrides the credentials in the 
SOAP message definition with credentials 
defined a .

Credentials

Required REST endpoint basic authentica­
tion credentials. This field is available when 
Override with Basic Authentication creden­
tials  is selected in the Authentication  field. 
Only basic authentication credentials appear 
in the selection list, which includes creden­
tials stored on the instance and credential IDs 
from an external storage system. If you are us­
ing credentials stored in a CyberArk safe, you 
can override the default safe defined in the 
MID Server configuration file by adding the 
name of a different safe as a prefix to the cre­
dential ID, separated by a colon. For example, 
newsafe:orch-test-f5. See Configure 

 for details.

Protocol Profile

Outbound web services mutual authentica­
 to use for authentication. This field is 

available when the authentication type is ei­
ther Override with Certificate Authentica­
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Option Description

tion credentials  or Override with Both Basic 
and Certificate Authentication credentials.

Note: 
You can map parameter values in a test payload to variables in the Outputs  tab 
automatically. See automap output variables.

What to do next

• Use auto-mapping  to generate outputs and parsing rules (recommended for JDBC)

• If you do not use auto-mapping, you can manually create output variables  and create parsing 
rules

Auto-map SOAP activity output variables

The ServiceNow  activity designer allows you to map parameter values in a SOAP test payload to 
variables in the Outputs  stage automatically.

Before you begin
Role required: web_service_admin, activity_admin, activity_creator

About this task
Note: 
You can test input variables from any stage in the activity designer if you have provided 
enough information for Orchestration to contact the endpoint and return data. Typically, the 
Execution Command  stage is the point at which your inputs are ready for testing.

Procedure

1. In the activity designer, proceed to the Execution Command  stage.

2. Define an appropriate MID Server, if requested.
The test fails if the MID Server cannot be found or if it cannot connect to the target.

3. Click Test Activity  to test the input parameters.
If you added actual values for the parameters and fields, the system runs those values against 
the specified target and returns the resulting payload. If you mapped input variables to fields 
and parameters, the system displays a dialog box for assigning test values to those variables.

4. Provide test values, if requested, and click OK  to display the payload.
The entire payload appears in the Raw Output  tab of the Response form.

5. Select one of these auto-mapping options.

◦ Auto-Map to Local: Directly maps values to a local variable for use within the activity.

◦ Auto-Map to Output: Directly maps values to the output variable to pass to other activities in 
the workflow. Auto-mapping to an output variable creates an array of objects, each of which 
contains the column names from the query result.
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Provide credentials to access a SOAP message WSDL

If the SOAP WSDL you are requesting in a test payload requires authentication, you must provide 
basic auth credentials in either the SOAP message or the SOAP activity.

Before you begin
Role required: web_service_admin, activity_admin, activity_creator

The ServiceNow  instance only supports basic auth credentials for accessing a WSDL. If the 
SOAP function or the SOAP message does not provide these credentials, you must configure 
them in the SOAP activity template. Orchestration uses these priorities for deciding which basic 
authentication credentials to use:

• SOAP message: Credentials for a SOAP message are used if no other credentials are defined.

• SOAP function: Credentials for a SOAP function override the credentials configured for the 
SOAP message.

• SOAP activity template: Credentials for a SOAP activity template override both the SOAP 
function and SOAP message credentials.

Procedure

1. Navigate to All  > System Web Services  > Outbound  > SOAP Message.

2. Select the SOAP message you want the activity to use.

3. In the SOAP Message record, select the Download WSDL  check box.

4. In the Authentication type  field, select Basic.
The Basic auth profile  field appears.

5. Select the basic auth profile to use with this SOAP message.

Basic authentication for a SOAP message

6. Alternately, you can configure basic authentication credentials in Configure the SOAP 
execution command.

a. In the Authentication  field, select Override with Basic Authentication credentials.
The Credentials  field appears.

b. Select the basic auth credentials to use to access the WSDL.
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This setting overrides any credentials configured in the SOAP message.

Override basic auth credentials

Configure the SOAP execution command

Use the input variables you created to configure the command that Orchestration executes on 
the SOAP endpoint.

Before you begin
Create the input variables you need in the Inputs  form before you can advance to the Execution 
Command  stage.

Role required: web_service_admin, activity_admin, activity_creator

Note: 
You can test the SOAP connection between the MID Server and the endpoint without 
having to run the acvitity in a workflow context. For details, see test template outputs.

Procedure

1. Drag variables from the list of inputs and drop them into command fields.
The system formats the variable in the proper syntax for the command.
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SOAP execution command

2. Complete the fields shown in the table.

SOAP template execution command fields

Field Description

Input Input variable builder. Create input variables  to map  to available fields.

Web service 
message

SOAP message  to use for this activity. Users must have the 
web_service_admin role to configure this field.

Web service 
message 
function

SOAP message SOAP message functions  to use for this activity. Users 
must have the web_service_admin role to configure this field.

Endpoint Endpoint URL for the SOAP web service this activity uses. Enter an endpoint 
in this field to override the endpoint configured in the SOAP message. Click 
the lock icon to open the input field.

SOAP 
message 
parameters

Name-value pairs to pass to the SOAP endpoint. You can create these 
parameters manually, or drag input variables into the parameter fields and 
then assign a value. Parameters defined in the SOAP message that use 
${}  can be assigned data from this activity template. Use the Additional 
attribute  column to configure the system to not escape the text. By default, 
text sent to the SOAP message is escaped. The Name  column is auto-
populated if the users have provided variables using Variable substitution in 
outbound REST messages  in the SOAP message.

Use MID 
Server

Check box that determines if a MID Server must be used to invoke the SOAP 
web service.

Note: 
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Field Description

If the SOAP web service message function defines a MID Server, that MID 
Server is used instead of the one selected here.

Required 
MID Server 
capabilities

MID Server with the appropriate MID Server capabilities  for connecting to 
the SOAP endpoint. By default, the system selects a MID Server with SOAP 
capabilities. This field is available when the Use MID Server  check box is 
selected.

Timeout Allowed duration of the SOAP web service request before it times out, in 
seconds. The default is 10.

Authentication Determines what type of authentication is required for the endpoint. The 
options are:

◦ Use existing credentials in SOAP message: Uses credential definitions 
from the SOAP message definition.

◦ Override with Basic Authentication credentials:  Uses |Enable basic 
authentication for outbound SOAP  credentials. Overrides the credentials 
in the SOAP message definition. Basic authentication credentials must be 
provisioned before they are available for selection.

◦ Override with Certificate Authentication credentials: Overrides the 
credentials in the SOAP message definition with certificate authentication 
credentials.

◦ Override with Both Basic and Certificate Authentication credentials: 
Overrides the credentials in the SOAP message definition with both basic 
authentication or certificate authentication credentials.

◦ Override with WS-Security Username profile: Overrides the credentials 
in the SOAP message definition with credentials defined a WS-Security .

Credentials Required REST endpoint basic authentication credentials. This field is 
available when Override with Basic Authentication credentials  is selected 
in the Authentication  field. Only basic authentication credentials appear 
in the selection list, which includes credentials stored on the instance and 
credential IDs from an external storage system. If you are using credentials 
stored in a CyberArk safe, you can override the Configure the MID Server for 
CyberArk  defined in the MID Server configuration file by adding the name 
of a different safe as a prefix to the credential ID, separated by a colon. For 
example, newsafe:orch-test-f5.

Protocol 
Profile

Outbound web services mutual authentication  to use for authentication. 
This field is available when the authentication type is either Override with 
Certificate Authentication credentials  or Override with Both Basic and 
Certificate Authentication credentials.

3. Click Save.

4. Click Continue  to advance to the Outputs  stage.

SOAP template execution parameters

You use execution parameters to create the input process script in the Pre processing  form of 
the activity designer.

For descriptions of the SOAP web service command fields, see the table in Configure the SOAP 
execution command.
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Note: 
You must use the executionParam.  prefix with all variables in this table.

SOAP execution parameters

Name Variable Type Usage

Web service 
message

web_service_message Reference The sys_id of the corresponding SOAP 
message.

Web service 
message 
function

web-
service_message_function

Reference The sys_id of the SOAP message 
function.

Web service 
endpoint

web_service_endpoint String URL of the SOAP endpoint.

Parameters parameters Array of 
JavaScript 
objects

Array of JavaScript objects, expressed 
with the executionParam. prefix. 
For instructions on creating arrays 
using this parameter, see Create a 
JavaScript array in a SOAP template.

Use mid server use_mid_server Boolean When true, indicates that a MID Server 
is used.

MidCapabilities midCapabilities String 
(comma 
separated)

List of references to required MID 
Server capabilities.

Time out time_out String Allowed duration of the SOAP web 
service request before it times out, in 
seconds. The default is 10.

ValueCapabilities valueCapabilities Array of 
hashmap

Capability values used to select the 
MID Server. For more information, 
see MID Server capabilities. Use 
this example to customize the MID 
Server selection if there are additional 
capabilities that are assigned by value:

var valueCapability = 
 {'NEW_MID_CAPABIILTY':'N
EW_MID_CAPABILITY_VALUE
'}; 
 executionParam.valueCapa
bilities.push(valueCapabi
lity);

Auth Type auth_type Boolean Type of credentials to use. The choices 
are:

• basic_auth_pick_credentials

• use_existing_credentials

Credentials credentials Reference Credentials to use for this SOAP 
message when the auth_type  is 
basic_auth_pick_credentials.
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Create a JavaScript array in a SOAP template

These are instructions for creating JavaScript arrays using SOAP execution parameters.

Before you begin
Role required: web_service_admin, activity_admin, activity_creator

About this task
To add more name-value pairs to the parameter's array, append the values to the existing array.

Procedure

1. Create a JavaScript object with the following syntax, and add it to the 
executionParam.parameter  array:

var newParameter = 
 {"name":"parameterName","value":"parameterValue","additional_a
ttribute":"none"};
executionParam.parameters.push(newParameter);

By adding the new parameter JavaScript object to the array, you ensure that any elements 
already available in the array are not impacted.

2. Make sure to set the value in the Additional attribute  column in the SOAP message 
parameters  input field to Do not escape text.

In this case, the system does not escape the value specified for the value  attribute. An 
example of this is:

var newParameter = 
 {"name":"parameterName","value":"parameterValue","additional_a
ttribute":"do_not_escape_text"};
executionParam.parameters.push(newParameter);

Note: 
If the value for the additional_attribute  field is None, then the system escapes the value 
specified by the value  attribute. In the first example, parameterValue  is escaped.

SOAP template post-processing parameters

Use these parameters to create a post-processing script.

Activity designer post-processing parameters

Name Variable Type Usage

Status 
code

status_code Integer Contains the status code returned from the web service.

Header header Hashmap 
of 
JavaScript 
object

Contains the key value paired hashmap 
associated with the header values passed into 
the web service. You can access each value with 
executionResult.header[keyName].

Body body String Contains a string value representing the output from the 
SOAP message

Error error String Returns the error string from the SOAP web service, unless 
there are no errors, in which case it returnsnull.
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Create a JavaScript Probe activity

Create a JavaScript Probe activity to instruct a MID server to execute server-side javascript.

Before you begin
Role required: activity_creator or workflow_admin

About this task
The JavascriptProbe activity has the same functionality as making ‘Packages’ calls into standard 
Java libraries. It allows you to have more control over the Java libraries on the MID Server. You 
can load your own JAR files on the MID Server and have the JavascriptProbe make Package calls 
into those java files.

Procedure

1. Create a custom activity .
This action creates a custom activity using a template.

2. After setting up general properties  and creating input variables, configure the JavaScript probe 
activity Execution Command.

Option Description

Map the input variables
Use the variables you created to configure 
the command that Orchestration executes on 
the MID server.

Script type

Select the type of script to include. Available 
options are:

◦ Custom JavaScript

◦ MID Server script include

Script

Custom JavaScript to run with this probe.

Note: 
This field is available when the Script 
type  selected is Custom JavaScript.

MID Server script include

Script for the MID Server to run with this 
probe.

Note: 
This field is available when the Script 
type  selected is MID Server script in­
clude.

Select MID Server by host MID Server on which the probe runs.

Required MID Server capabilities MID Server to use, by capabilities.

Parameters

Name-value pairs to pass to the host with this 
probe. You can create these parameters man­
ually, or drag input variables into the Parame­
ters  fields and assign a value.

Note: 
You can map parameter values in a test payload to variables in the Outputs  tab 
automatically. See automap output variables.
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What to do next
Finish creating your JavaScript probe activity by creating output variables, creating a parsing 
rule, or Conditions . Refer to the create custom activities  topic to know your template options.

JavaScript probe template execution parameters

You use execution parameters to create the input process script in the Preprocessing  form of the 
activity designer.

For descriptions of the JavaScript Probe command fields, see the table in Configure the 
JavaScript Probe execution command.

Note: 
You must use the executionParam.  prefix with all variables in this table.

JavaScript template execution parameters

Name Variable Type Usage

Script Type script_type Enumerated Type of script to run. The possible types 
are:

• custom_javascript_typ

• mid_script_include_type

Script script String Script that runs custom JavaScript 
when the script_type  is 
custom_javascript_type.

Mid script 
include

mid_script_include Reference The sys_id reference associated 
with the MID Server script include 
to call, when the script_type  is 
mid_script_include_type.

Source source String Target host on which to run the script.

MidCapabilities midCapabilities String 
(comma 
separated)

List of required MID Server capabilities.

Parameters parameters Array of 
JavaScript 
object

Array of JavaScript objects, expressed 
with the executionParam.  prefix. 
To add more name-value pairs to the 
parameters  array, append them to the 
existing array. Create a JavaScript object 
with the following syntax, and add it to 
the executionParam.parameter 
array. This assigns additional parameters 
to the message:

var newParameter = 
 {"name":"parameterName","
value":"parameterValue"};
executionParam.parameters.
push(newParameter);

ValueCapabilities valueCapabilities Array of 
hashmap

Capability values used to select the MID 
Server. For more information, see MID 
Server capabilities. If there are additional 
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JavaScript template execution parameters  (continued)

Name Variable Type Usage

capabilities that are assigned by value, 
use this example to customize the MID 
Server selection:

var valueCapability = 
 {'NEW_MID_CAPABIILTY':'NE
W_MID_CAPABILITY_VALUE'};
executionParam.valueCapabi
lities.push(valueCapabilit
y);

JavaScript probe template post-processing parameters

Use these parameters to create a post-processing script.

JavaScript probe post-processing parameters

Name Variable Type Usage

Payload payload String Contains raw payload returned from the JavaScript Probe.

Output output String Contains output data returned from the JavaScript Probe.

EccSysId eccSysId String Contains the reference ID associated with the ECC Queue 
input message.

Error 
Messages

errorMessages String Contains the error messages returned from the JavaScript 
probe. If no error messages are returned, this value is null.

Configure the JavaScript Probe execution command

Use the input variables you created to configure the command that Orchestration executes on 
the JavaScript Probe target host.

Before you begin
Create the input variables you need in the Inputs  form before you can advance to the Execution 
Command  stage.

Role required: activity_creator, admin

Note: 
You can test the JavaScript Probe connection between the MID Server and the target 
without having to run the acvitity in a workflow context. For details, see test template 
outputs.

Procedure

1. Drag variables from the list of inputs and drop them into command fields.
The system formats the variable in the proper syntax for the command.
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JavaScript Probe execution command

2. Complete the fields shown in the table.

JavaScript Probe execution command fields

Field Description

Input Input variable builder. Create input variables  to map  to available fields.

Script type Select the type of script to include. Available options are:

◦ Custom JavaScript

◦ MID Server script include

Script Custom JavaScript to run with this probe. This field is available when the 
Script type  selected is Custom JavaScript.

MID Server 
script include

Script for the MID Server to run with this probe. This field is available when 
the Script type  selected is MID Server script include.

Select MID 
Server by host

MID Server on which the probe runs.

Required 
MID Server 
capabilities

MID Server to use, by capabilities.

Parameters Name-value pairs to pass to the host with this probe. You can create these 
parameters manually, or drag input variables into the Parameters  fields and 
assign a value.
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3. Click Save.

4. Click Continue  to advance to the Outputs  stage.

Create a PowerShell activity

Create a custom PowerShell activity return data to a workflow from a host using Microsoft 
PowerShell.

Before you begin
Role required: activity_creator or workflow_admin

About this task
ServiceNow  supports PowerShell 3.0 to 5.1.

Procedure

1. Create a custom activity .
This action creates a custom activity using a template.

2. After setting up general properties  and creating input variables, configure the PowerShell 
Execution Command.

Option Description

Map the input variables
Use the variables you created to configure 
the command that Orchestration executes on 
the MID Server.

Target host
Host name or IP address of the target server 
for this PowerShell activity.

Script type

Type of PowerShell script to run on the Power­
Shell host. Available options are:

◦ Custom PowerShell command

◦ MID Server script file

MID Server script file
The MID Server script file contains the Power­
Shell scripts. This field is available when the 
Script type  selected is MID Server script file.

Command

PowerShell command the activity executes. 
This field is available when the Script type  se­
lected is Custom PowerShell command. You 
can create your commands by dragging and 
dropping input variables from the variable 
builder into this field.

PowerShell variables

Name-value pairs to pass to the host with Pow­
erShell. You can create these variables man­
ually, or drag input variables into the Value 
field. Encrypted input variables retain their en­
cryption, regardless of the data type settings 
in this field. If you type in a value and select 
the Encrypted  data type, your value appears 
in plain text. It is only encrypted when it pass­
es to the ECC Queue.

Use MID Service Account
If checked, this activity authenticates on the 
target host using the credentials of the MID 
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Option Description

Server service account only, without trying 
any other credentials.

Note: 
The Credential tag  field is not available.

Credential tag

Credential tag this activity must use to run 
PowerShell commands on the host. If this 
field is left blank, the MID Server tries all the 
available credentials until it finds a valid one, 
ending with the MID Server service account. 
If a credential tag is defined, the MID Server 
tries the credentials with that tag specified on­
ly and does not try the MID Server service ac­
count.

Note: 
This field is not available when the Use 
MID service account  check box is se­
lected.

Required MID Server capabilities
MID Server to use for querying PowerShell, by 
capabilities. By default, the system selects a 
PowerShell MID Server.

Note: 
You can map parameter values in a test payload to variables in the Outputs  tab 
automatically. See automap output variables.

What to do next
Finish creating your PowerShell activity by creating output variables, creating a parsing rule, or 
Conditions . Refer to the create custom activities  topic to know your template options.

PowerShell template execution parameters

You use execution parameters to create the input process script in the Pre Processing  form of 
the activity designer.

For descriptions of the Powershell command fields, see the table in Configure the PowerShell 
execution command.

Note: 
You must use the executionParam.  prefix with all variables in this table.

Powershell execution parameters

Name Variable Type Usage

Source source String Target host on which to execute the 
command.

Script type script_type Enumeration Type of script to run. The possible 
types are:

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

5091

https://www.webstg.servicenow.com/docs/access?context=conditions&version=washingtondc&pubname=washingtondc-integrate-applications&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=conditions&version=washingtondc&pubname=washingtondc-integrate-applications&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=conditions&version=washingtondc&pubname=washingtondc-integrate-applications&ft:locale=en-US


Powershell execution parameters  (continued)

Name Variable Type Usage

• command:  Custom PowerShell 
command.

• file:  Identifies the MID Server 
script file to run.

Command command String Command sent to the MID Server for 
it to run on the target host.

MidScriptFile midScriptFile Reference Reference sys_id of the MID Server 
script file to execute, when the 
script_type  is file.

PowershellVariables powershellVariables Array of 
hashmap

Hashmap of JavaScript objects with 
name, value, and type  for each 
object. The type  of each object 
can be one of plain, encrypted, 
boolean, or null, corresponding 
to the PowerShell variable type 
selected in the inputs tab. For 
example, you might enter:

var newParameter = 
 {"name":"parameterName
","value":"parameterVal
ue", "type": "plain" };
executionParam.powershe
llVariables.push(newPar
ameter);

Credential tag credential_tag String Specific credential tag this activity 
must use to run PowerShell 
commands on the host.

MidCapabilities midCapabilities String 
(comma 
separated)

List of required MID Server 
capabilities.

ValueCapabilities valueCapabilities Array of 
hashmap

Capability values used to select the 
MID Server. For more information, 
see MID Server capabilities. If 
there are additional capabilities 
that are assigned by value, use 
this example to customize the MID 
Server selection:

var valueCapability = 
 {'NEW_MID_CAPABIILTY':
'NEW_MID_CAPABILITY_VAL
UE'};
executionParam.valueCap
abilities.push(valueCap
ability);
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Powershell post-processing parameters and payload parsing

Use these parameters to create a post-processing script, payload parsing, and tagging.

Powershell post-processing parameters

Name Variable Type Usage

Tags tags Hashmap of 
tag values 
to return 
from the 
PowerShell 
command.

Contains the tags used to extract output using 
the PowerShell commands. The tag output is 
delimited by double percentage signs, as in %
%tagname%% … %%. Set up the command 
using the format in this example:

Write-Host %%tagname1%%
output1 line 1
output1 line 2
…
Write-Host%%
 
Write-Host %%tagname2%%
output2 line 1
output2 line 2
…
Write-Host%%

The tags returned are JavaScript hashmap 
objects in which each key is prefixed with tag 
appended with the tagname.

{"__text__": "",
"tagtagname1":"output1 
 line1\noutput1 line2\n",
"tagtagname2":"output2 
 line1\noutput2 line2\n"}

Hresult hresult String Contains any hresult  returned from the 
PowerShell command. If no hresult  is returned, 
this parameter is null.

Output output String Contains the raw output from the PowerShell 
command.

EccSysID eccSysID String Contains the reference ID associated with the 
ECC Queue input message returned by the 
activity.

ErrorMessages errorMessages String Contains any error messages retrieved from 
the PowerShell command. This value is null  if 
there are no error messages.

Create a REST web service activity

Use this procedure to create a custom REST web service Orchestration  activity.

Before you begin
Role required: web_service_admin, activity_admin, activity_creator

About this task
To create and use a REST web service workflow activity:
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• Create a Create a REST message  if an appropriate one is not already configured.

• Assign the web_service_admin role to any user who must create or edit a custom REST activity.

• Determine an application, or Application scope , for this activity.

• Determine the Create a REST message  to use for the activity. Use this value to override the 
endpoint configured in the REST message.

• Optionally, create basic authentication credentials . Use this value to override the credentials 
configured in the SOAP message.

Procedure

1. Create a custom activity .
This action creates a custom activity using a template.

2. After setting up general properties  and creating input variables, configure the REST web 
service Execution Command.

Option Description

Map the input variables
Use the variables you created to configure 
the command that Orchestration executes.

REST message
Name of an existing REST message to use in 
this activity.

REST message function REST message function to use for this activity.

Endpoint

Endpoint URL for the REST web service this 
activity uses. Enter an endpoint in this field 
to override the endpoint configured in the 
REST message. Click the lock to open the in­
put field.

Variable substitutions

Name-value pairs to pass to the REST end­
point. You can create these parameters manu­
ally, or drag input variables into the parameter 
fields, and then assign a value. Parameters 
defined in the REST message that use ${}  can 
be assigned data from this activity template. 
Use the Additional attribute  column to config­
ure the system to not escape the text. By de­
fault the text sent to the REST message is es­
caped. If the users have provided variables 
using Variable substitution in outbound REST 

 in the REST message, then the 
Name  column is automatically populated.

Additional Headers

Additional HTTP header parameters for the 
REST message selected. You can also use 
these values to override parameters inherited 
from the REST message.

Additional Query Parameters

Additional query parameters for the REST 
message selected. You can also use these val­
ues to override parameters inherited from the 
REST message.
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Option Description

Use MID Server

Check box that determines if a MID Server 
should be used to invoke the REST web ser­
vice.

Note: 
If the REST web service message func­
tion defines a MID Server, that MID Serv­
er is used instead of the one selected 
here.

Required MID Server capabilities

MID Server with the appropriate MID Server 
capabilities  for connecting to the REST end­
point. By default, the system selects a MID 
Server with REST capabilities. This field is 
available when the Use MID Server  check 
box is selected.

Timeout
Allowed duration of the REST web service re­
quest before it times out, in seconds. The de­
fault is 10.

Authentication

Determines what type of authentication is re­
quired for the endpoint. The options are:

◦ Use existing credentials in REST message: 
Uses credential definitions from the REST 
message definition.

◦ Override with Basic Authentication cre­
dentials: Uses Enable basic authentication 

 credentials to over­
ride the credentials in the REST message 
definition. Basic authentication credentials 
must be provisioned before they are avail­
able for selection.

◦ Override with Certificate Authentication 
credentials: Uses a certificate, such as a pri­
vate key, to override the credentials in the 
REST message definition.

◦ Override with Both Basic and Certificate 
Authentication credentials: Uses both ba­
sic authentication and certificate authen­
tication to override the credentials in the 
REST message definition.

◦ Override with OAuth Authentication cre­
dentials: Uses OAuth 2.0  credentials to 
override the credentials in the REST mes­
sage definition. The REST message select­
ed for this activity must have its OAuth 

 set 
to OAuth 2.0  and its OAuth profiles and 

 configured appropriately.

Credentials
Required REST endpoint basic authentica­
tion credentials. This field is available when 
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Option Description

Override with Basic Authentication creden­
tials  is selected in the Authentication  field. 
Only basic authentication credentials appear 
in the selection list, which includes creden­
tials stored on the instance and credential IDs 
from an external storage system. If you are us­
ing credentials stored in a CyberArk safe, you 
can override the default safe defined in the 
MID Server configuration file. See Configure 

 for details. Add 
the name of a different safe as a prefix to the 
credential ID, separated by a colon. For exam­
ple, newsafe:orch-test-f5.

Protocol Profile

Certificate authentication to use. This field is 
available when the selections in the Authen­
tication  are either Override with Certificate 
Authentication credentials  or Override with 
Both Basic and Certificate Authentication 
credentials.

OAuth profile
Profile for the OAuth provider for this REST 
message. See  for 
more information.

Note: 
You can map parameter values in a test payload to variables in the Outputs  tab 
automatically. See automap output variables.

What to do next
Finish creating your Rest web service activity by creating output variables, creating a parsing 
rule, or Conditions . Refer to the create custom activities  topic to know your template options.

Auto-map REST activity output variables

The ServiceNow  activity designer allows you to map parameter values in a REST test payload to 
variables in the Outputs  stage automatically.

Before you begin
Role required: web_service_admin, activity_admin, activity_creator

About this task
Note: 
You can test input variables from any stage in the activity designer if you have provided 
enough information for Orchestration to contact the endpoint and return data. Typically, the 
Execution Command  stage is the point at which your inputs are ready for testing.

Procedure

1. In the activity designer, proceed to the Execution Command  stage.

2. Define an appropriate MID Server, if requested.
The test fails if the MID Server cannot be found or if it cannot connect to the target.

3. Click Test Activity  to test the input parameters.
If you added actual values for the parameters and fields, the system runs those values against 
the specified target and returns the resulting payload. If you mapped input variables to fields 
and parameters, the system displays a dialog box for assigning test values to those variables.
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4. Provide test values, if requested, and click OK  to display the payload.
The entire payload appears in the Raw Output  tab of the Response form.

5. Select one of these auto-mapping options.

◦ Auto-Map to Local: Directly maps values to a local variable for use within the activity.

◦ Auto-Map to Output: Directly maps values to the output variable to pass to other activities in 
the workflow. Auto-mapping to an output variable creates an array of objects, each of which 
contains the column names from the query result.

REST template execution parameters

You use execution parameters to create the input process script in the Pre Processing  form of 
the activity designer.

For descriptions of the REST web service command fields, see Configure the REST execution 
command.

Note: 
You must use the executionParam.  prefix with all variables in this table.

REST template execution parameters

Name Variable Type Usage

Web service 
message

web_service_message Reference The sys_id of the 
corresponding web service 
message.

Web service 
message 
function

web_service_message_function Reference The sys_id of the REST 
message function.

Web service 
endpoint

web_service_endpoint String URL of the REST endpoint.

Parameters parameters Array of 
JavaScript 
objects

Array of JavaScript objects, 
expressed with the 
executionParam.  prefix. 
For instructions on creating 
arrays using this parameter 
see Create a JavaScript array 
in a REST template.

Use mid server use_mid_server Boolean Selects whether or not to use 
the MID Server. A value of true 
uses the MID Server, and a 
value of false  does not use the 
MID Server.

MidCapabilities midCapabilities String 
(comma 
separated)

List of references to required 
MID Server capabilities.
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REST template execution parameters  (continued)

Name Variable Type Usage

Time out time-out String Allowable time out duration, 
expressed in seconds.

ValueCapabilities valueCapabilities Array of 
hashmap

Capability values used to 
select the MID Server. For 
more information, see MID 
Server capabilities. Use this 
example to customize the MID 
Server selection if there are 
additional capabilities that are 
assigned by value:

var 
 valueCapability = 
 {'NEW_MID_CAPABIIL
TY':'NEW_MID_CAPABI
LITY_VALUE'}; 
 executionParam.val
ueCapabilities.push
(valueCapability);

Auth Type auth-type Boolean Type of credentials to use. The 
choices are:

• basic_auth_pick_credentials

• use_existing_credentials

Credentials credentials Reference Contains the credentials 
to use for this REST 
message when the 
auth_type  selected is 
basic_auth_pick_credentials.

Create a JavaScript array in a REST template

These are instructions for creating JavaScript arrays using REST execution parameters.

Before you begin
Role required: web_service_admin, activity_admin, activity_creator

About this task
To add more name-value pairs to the parameter's array, append the values to the existing array.

Procedure

1. Create a JavaScript object with the following syntax, and add it to the 
executionParam.parameter  array:

var newParameter = 
 {"name":"parameterName","value":"parameterValue","additional_a
ttribute":"none"};
executionParam.parameters.push(newParameter);
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By adding the new parameter JavaScript object to the array, you ensure that any elements 
already available in the array are not impacted.

2. Make sure to set the value in the Additional attribute  column in the REST message 
parameters  input field to Do not escape text.

In this case, the system does not escape the value specified for the value  attribute. An 
example of this is:

var newParameter = 
 {"name":"parameterName","value":"parameterValue","additional_a
ttribute":"do_not_escape_text"};
executionParam.parameters.push(newParameter);

Note: 
If the value for the additional_attribute  field is None, then the system escapes the value 
specified by the value  attribute. In the first example, parameterValue  is escaped.

REST template post-processing parameters

Use these parameters to create a post-processing script.

Activity designer post-processing parameters

Name Variable Type Usage

Status 
code

status_code Integer Contains the status code returned from the REST web 
service.

Header header Hashmap 
of 
JavaScript 
object

Hashmap of key value pairs associated with the header 
values passed into the web service. You can access each 
value with executionResult.header[keyName].

Body body String Contains a string value representing the output from the 
REST message

Error error String Returns the error string from the REST web service, unless 
there are no errors, in which case it returnsnull.

Configure the REST execution command

Use the input variables you created to configure the command that Orchestration executes on 
the REST endpoint.

Before you begin
Create the input variables you need in the Inputs  form before you can advance to the Execution 
Command  stage.

Role required: web_service_admin, activity_admin, activity_creator

Note: 
You can test the REST connection between the MID Server and the endpoint without having 
to run the acvitity in a workflow context. For details, see test template outputs.

Procedure

1. Drag variables from the list of inputs and drop them into command fields.
The system formats the variable in the proper syntax for the command.
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REST execution command

2. Complete the fields shown in the table.

REST execution command fields

Field Description

Input Input variable builder. Create input variables  to map to available fields.

REST 
message

Name of an existing REST message to use in this activity. Users must have 
the web_service_admin role to configure this field.

REST 
message 
function

REST message function to use for this activity. Users must have the 
web_service_admin role to configure this field.

Endpoint Endpoint URL for the REST web service this activity uses. Enter an endpoint 
in this field to override the endpoint configured in the REST message. Click 
the lock to open the input field.

Variable 
substitutions

Name-value pairs to pass to the REST endpoint. You can create these 
parameters manually, or drag and drop input variables into the parameter 
fields, and then assign a value. Parameters defined in the REST message 
that use ${}  can be assigned data from this activity template. Use the 
Additional attribute  column to configure the system to not escape the 
text. By default the text sent to the REST message is escaped. The Name 
column is automatically populated if the users have provided variables using 
Variable substitution in outbound REST messages  in the REST message.

Additional 
Headers

Additional HTTP header parameters for the REST message selected. You 
can also use these values to override parameters inherited from the REST 
message.
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Field Description

Additional 
Query 
Parameters

Additional query parameters for the REST message selected. You can also 
use these values to override parameters inherited from the REST message.

Use MID 
Server

Check box that determines if a MID Server should be used to invoke the 
REST web service.

Note: 
If the REST web service message function defines a MID Server, that 
MID Server is used instead of the one selected here.

Required 
MID Server 
capabilities

MID Server with the appropriate MID Server capabilities  for connecting to 
the REST endpoint. By default, the system selects a MID Server with REST 
capabilities. This field is available when the Use MID Server  check box is 
selected.

Timeout Allowed duration of the REST web service request before it times out, in 
seconds. The default is 10.

Authentication Determines what type of authentication is required for the endpoint. The 
options are:

◦ Use existing credentials in REST message: Uses credential definitions 
from the REST message definition.

◦ Override with Basic Authentication credentials: Uses Enable basic 
authentication for outbound SOAP  credentials to override the 
credentials in the REST message definition. Basic authentication 
credentials must be provisioned before they are available for selection.

◦ Override with Certificate Authentication credentials: Uses a certificate, 
such as a private key, to override the credentials in the REST message 
definition.

◦ Override with Both Basic and Certificate Authentication credentials: 
Uses both basic authentication and certificate authentication to override 
the credentials in the REST message definition.

◦ Override with OAuth Authentication credentials: Uses OAuth 2.0
credentials to override the credentials in the REST message definition. The 
REST message selected for this activity must have its OAuth 2.0 tutorial 
- create a REST message  set to OAuth 2.0  and its OAuth profiles and 
scopes  configured appropriately.

Credentials Required REST endpoint basic authentication credentials. This field is 
available when Override with Basic Authentication credentials  is selected 
in the Authentication  field. Only basic authentication credentials appear 
in the selection list, which includes credentials stored on the instance and 
credential IDs from an external storage system. If you are using credentials 
stored in a CyberArk safe, you can override the Configure the MID Server for 
CyberArk  defined in the MID Server configuration file by adding the name 
of a different safe as a prefix to the credential ID, separated by a colon. For 
example, newsafe:orch-test-f5.

Protocol 
Profile

Certificate authentication to use. This field is available when the 
selections in the Authentication  field is either Override with Certificate 
Authentication credentials  or Override with Both Basic and Certificate 
Authentication credentials.
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Field Description

OAuth profile Profile for the OAuth provider for this REST message. See Specify an OAuth 
profile  for more information.

3. Click Save.

4. Click Continue  to advance to the Outputs  stage.

Create an SFTP activity

Create an activity that executes basic SFTP commands on a remote server.

Before you begin
Roles required: activity_creator or workflow_admin

About this task
You can create a custom activity that manages files and directories on a target host or copies a 
file from one SFTP server to another. The file content is streamed through a MID Server, which 
avoids having to store the data on the hard drive of the MID Server host machine.

Note: 
This activity requires the credentials of a user who can execute SFTP commands on 
the source host. The Copy File  activity, provided in the activity pack, requires separate 
credentials to access the target host.

Procedure

1. Create a custom activity .
This action creates a custom activity using a template.

2. After setting up general properties  and creating input variables, configure the SFTP Execution 
Command.

Option Description

Command

Type of activity to create. The choices are:

◦ Copy file

◦ Create directory

◦ Get file list

◦ Remove file or directory

◦ Rename file or directory

◦ Set file attributes

Note: 
The fields that display on the form de­
pend on the command you select.

Source host
Name or IP address of the server containing 
the files targeted by the activity.

Source port
Port number to use to communicate with the 
source server. The default port number is 22.

Source file path
Full path to a file (/temp/test_data_­
file.txt) or directory (/temp/test_­
dir) on a source host depending on the se­
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Option Description

lected command. Field available on following 
commands:

◦ Copy file

◦ Remove file or directory

◦ Set file attributes

Source directory

Path to the directory where the source files 
are located. Field available on following com­
mands:

◦ Create directory

◦ Get file list

Source files

Names of specific source files to include in 
the file transfer. Separate the file names with 
semi-colons. This field supports a semi-colon 
separated list of wild-card patterns. For ex­
ample: *.txt; a?cd.pdf.  If this field is 
blank, all files are included. Field available on 
following command: Get file list

Note: 
For information about how the values in 
this field affect options in other fields, 
see the logic explanation which follows.

Is a directory
If checked, specifies the file path is a directo­
ry. Field available on following command: Re­
move file or directory

Credential tag for source
Specific credential tag this activity must use 
to run SFTP commands on the source host.

Credential tag for target

Specific credential tag this activity must use 
to run SFTP commands on the target host. 
Field available on following command: Copy 
file

Excluded files

Names of specific source files to exclude from 
the file transfer. The activity acts on all other 
files found in the source directory or subfold­
ers. Separate the file names with commas. 
This field supports comma-separated list of 
wild-card patterns. For example: *.txt, a?
cd.pdf.. Field available on following com­
mand: Get file list

Note: 
For information about how the values in 
this field affect options in other fields, 
see the logic explanation which follows.

Include subfolders
If checked, includes the files from subfolders 
in the source directory. Field available on fol­
lowing command: Get file list
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Option Description

Note: 
For information about how your selec­
tion affects other fields in the form, see 
the logic explanation which follows.

Target host
Name or IP address of the server to which the 
files are being transferred. Field available on 
following command: Copy file

Target port

Port number to use to communicate with the 
target host. The default port number is 22. 
Field available on following command: Copy 
file

Target file path

Full path to a file on a target host. Field avail­
able on following commands:

◦ Copy file

◦ Rename file or directory

Suffix for temporary file

If a file exists on a target host, this command 
enables a temporary suffix to use for a file 
name. If this field contains a value, the activity 
first copies the source file to a temporary file 
on the target host using targetFilePath 
+ tempFileSuffix  as the name. Up­
on completion, the activity renames the file 
to the actual target file name. If this field is 
blank, the activity copies the source file direct­
ly to the target file and overwrites it, if it exists. 
Field available on following command: Copy 
file

UID

User ID attribute to apply to a file or directory. 
The UID and GID values must be set together 
as a pair or they are ignored. The UID and GID 
numbers are internal values returned by the 
Get File List activity. Typically, you first use 
the Get File List activity to return a list of files 
and their attributes. Then you can move a file 
from a source host to a target host and set the 
source file attributes on the target file. This 
flow is demonstrated in the SFTP File Trans­
fer workflow. Field available on following com­
mand: Set file attributes

GID

Group ID attribute to apply to a file or direc­
tory. The UID and GID values must be set to­
gether as a pair or they are ignored. The UID 
and GID numbers are internal values returned 
by the Get File List activity. Typically, you first 
use the Get File List activity to return a list of 
files and their attributes. Then you can move 
a file from a source host to a target host and 
set the source file attributes on the target file. 
This flow is demonstrated in the SFTP File 
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Option Description

Transfer workflow. Field available on following 
command: Set file attributes

Permissions

File or directory permissions to set for the 
user and group specified. This value must 
be expressed as an integer, such as 16877, 
which defines these permissions: rwxr-xr-
x. The permissions numbers are internal val­
ues returned by the Get File List activity. Typ­
ically, you first use the Get File List activity to 
return a list of files and their attributes. Then 
you can move a file from a source host to a tar­
get host and set the source file attributes on 
the target file. This flow is demonstrated in the 
SFTP File Transfer workflow. Field available 
on following command: Set file attributes

Access timestamp

Override the timestamp when the file or direc­
tory was last accessed. The access and mod­
ification timestamps must be set together as 
a pair. Field available on following command: 
Set file attributes

Modification timestamp

Override the timestamp when the file or direc­
tory was last modified. The access and modi­
fication timestamps must be set together as 
a pair. Field available on following command: 
Set file attributes

Size in bytes
Size of a file, expressed in bytes. Field avail­
able on following command: Set file attributes

Required MID Server capabilities
MID Server with the appropriate MID Server 
capabilities  for connecting to the source and 
target servers.

The system uses this logic to determine which files to move from the source host:

◦ If the Source files field is empty, the system selects all the files in the source directory. 
Otherwise, it only selects those files whose names match one of the file name patterns given 
in the field.

◦ If the Excluded files field is empty, the system excludes nothing. Otherwise, it excludes those 
files whose names match one of the file name patterns given in the field.

◦ The exclude rule has a higher preference than the include rule. If a file name matches one of 
the file name patterns in the Excluded files field, it does not get into the selection regardless 
of the include rule.

◦ When the Include subfolders check box is cleared, the system looks only in the source 
directory for files to include or exclude. Otherwise, it looks in the source directory and any of 
its subfolders for files to include or exclude.

Note: 
You can map parameter values in a test payload to variables in the Outputs  tab 
automatically. See automap output variables.
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What to do next

• Use auto-mapping  to generate outputs and parsing rules (recommended for JDBC)

• If you do not use auto-mapping, you can manually create output variables  and create parsing 
rules

SFTP template execution parameters

You use execution parameters to create the input process script in the Preprocessing  form.

For descriptions of the command fields, see Configure the SFTP execution command.

Note: 
You must use the executionParam.  prefix with all variables in this table.

SFTP execution parameters

Name Variable Type Usage

Command command String Identifies the function of this activity. 
The possible commands are:

• Copy file

• Create directory

• Get file list

• Remove file or directory

• Rename file or directory

• Set file attributes

Source source String Identifies the source host.

Source port source_port Integer Identifies the port used to 
communicate with the source host.

Source 
directory

source_directory String Path to the source directory of the 
files to be moved.

Source files source_files String Names of the files on the source to be 
moved.

Excluded files excluded_files String Lists the files excluded from the 
operation.

Source file path source_file_path String Path to the source files to be moved.

Target host target_host String Identifies the target host.

Target port target_port Integer Identifies the port used to 
communicate with the target host.

Target directory target_directory String Full path to the target directory on the 
target host.

Target file path target_file_path String Full path to a file or directory on the 
source host or on the target host. For 
example, this value is used in the 
Rename File or Directory  activity in 
the activity pack.
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SFTP execution parameters  (continued)

Name Variable Type Usage

Temp file 
postfix

temp_file_postfix String
Temporary file name extension 
used by the Copy File activity 
when moving a file. If this field 
contains an extension, the source 
file is copied to a temporary file 
using target file name + 
temp_file_postfix, before 
being renamed to the actual target 
file. If this field is blank, the source file 
is copied directly to the target file.

Is directory is_directory Boolean Indicates whether the given file path 
is a directory.

Include 
subfolders

include_subfolders Boolean Indicates whether the system looks 
into subfolders of the source directory 
for files to include and exclude.

File attribute 
uid

file_attribute_uid Integer User ID associated with a file or 
directory.

File attribute 
gid

file_attribute_gid Integer Group ID associated with a file or 
directory.

File attribute 
permissions

file_attribute_permissions Integer File or directory permissions for the 
user and group specified.

File attribute 
atime

file_attribute_atime Integer Access time stamp from the file 
attributes.

File attribute 
mtime

file_attribute_mtime Integer Modification time stamp from the file 
attributes.

File attribute 
size

file_attribute_size Integer Size of the file, in bytes.

Source 
credential tag

source_credential_tag String Credential aliases for Orchestration 
activities  used to run the command 
on the source host.

Target 
credential tag

target_credential_tag String Credential tag used to run the 
command on the target host.

MidCapabilities midCapabilities String 
(comma 
separated)

List of required MID Server 
capabilities.

SFTP post-processing parameters and payload parsing

Use these parameters to create a post-processing script, payload parsing, and tagging.

SFTP post-processing parameters

Name Variable Type Usage

Output output String Contains output data returned by the query.
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SFTP post-processing parameters  (continued)

Name Variable Type Usage

EccSysId eccSysId String Contains the Reference ID associated with the 
ECC Queue input message.

ErrorMessages errorMessages String Contains the error messages returned from the 
query. If no error messages are returned, this 
value is null.

Tags tags Hashmap of 
tag values 
returned 
from 
the SSH 
command

Contains the tags used to extract output using 
the SSH commands. The tag output is delimited 
by double percentage signs, as in %%tagname
%% … %%. Set up the command using the 
following format:

%%tagname1%%
output1 line 1
output1 line 2
…
%%
 
%%tagname2%%
output2 line 1
output2 line 2
…
%%

The tags returned are JavaScript hashmap 
objects in which each key is prefixed with tag 
appended with the tagname.

{"__text__": "",
"tagtagname1":"output1 
 line1\noutput1 line2\n",
"tagtagname2":"output2 
 line1\noutput2 line2\n"}

Configure the SFTP execution command

Use the input variables you created to configure the command that Orchestration executes on 
the SFTP target.

Before you begin
Create the input variables you need in the Inputs  form before you can advance to the Execution 
Command  stage.

Role required: activity_creator, admin

Note: 
You can test the JDBC connection between the MID Server and the target without having to 
run the activity in a workflow context. For details, see test template outputs.

Procedure

1. Drag variables from the list of inputs and drop them into command fields.
The system formats the variable in the proper syntax for the command.
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SFTP execution command

2. Complete the fields shown in the table.

SFTP command fields

Field Description Command

Command Type of activity to create. The choices are:

◦ Copy file

◦ Create directory

◦ Get file list

◦ Remove file or directory

◦ Rename file or directory

◦ Set file attributes

Note: 
The fields displayed on the form depend on the command 
selected.

All

Source host Name or IP address of the server containing the files targeted by 
the activity.

All

Source port Port number to use to communicate with the source server. The 
default port number is 22.

All

Source file 
path

Full path to a file on a source host. ◦ Copy file

◦ Remove 
file or 
directory

◦ Set file 
attributes

Source 
directory

Path to the directory where the source files are located. ◦ Create 
directory

◦ Get file 
list
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Field Description Command

Source files Names of specific source files to include in the management 
action. Separate the file names in this list with semi-colons. This 
field supports the use of wild cards. If this field is blank, all files 
are included. For information about how the values in this field 
are affected by options in other fields, see the section below the 
table.

Get file list

Is a 
directory

Check box that determines if the specified file path is a directory. Remove file 
or directory

Credential 
tag for 
source

Specific Credential aliases for Orchestration activities  this 
activity must use to run SFTP commands on the source host.

All

Credential 
tag for 
target

Specific credential tag this activity must use to run SFTP 
commands on the target host.

Copy file

Excluded 
files

Names of specific source files to exclude from the management 
action. The activity acts on all other files found in the source 
directory or subfolders. Separate the file names in this list 
with semi-colons. This field supports the use of wild cards. For 
information about how the values in this field are affected by 
options in other fields, see the section below the table.

Get file list

Include 
subfolders

Check box to manage the files from subfolders in the source 
directory. For information about how your selection affects other 
fields in the form, see the section below the table.

Get file list

Target host Name or IP address of the server to which the files are being 
transferred.

Copy file

Target port Port number to use to communicate with the target host. The 
default port number is 22.

Copy file

Target file 
path

Full path to a file on a target host. ◦ Copy file

◦ Rename 
file or 
directory

Suffix for 
temporary 
file

Temporary suffix to use for a file name if the file already exists 
on a target host. If this field contains a value, the activity 
deletes the duplicate target file if it exists, and then copies the 
source file to a temporary file using targetFilePath + 
tempFileSuffix  as the name. Upon completion, the activity 
renames the file to the actual target file name. If this field is blank, 
the activity copies the source file directly to the target file and 
overwrites it, if it already exists.

Copy file

UID User ID attribute to apply to a file or directory. The UID and GID 
values must be set together as a pair or they are ignored.

Set file 
attributes

GID Group ID attribute to apply to a file or directory. The UID and GID 
values must be set together as a pair or they are ignored.

Set file 
attributes

Permissions File or directory permissions to set for the user and group 
specified. This value must be expressed as an integer, such as 
16877, which defines these permissions: rwxr-xr-x. The 
permissions number is an internal value returned by the Get 

Set file 
attributes
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Field Description Command

File List activity. Typically, you first use the Get File List activity 
to return a list of files and their attributes. Then you can move 
a file from a source host to a target host and set the source file 
attributes on the target file. This is demonstrated in the SFTP File 
Transfer workflow.

Access 
timestamp

Override the timestamp when the file or directory was last 
accessed. The access and modification timestamps must be set 
together as a pair.

Set file 
attributes

Modification 
timestamp

Override the timestamp when the file or directory was last 
modified. The access and modification timestamps must be set 
together as a pair.

Set file 
attributes

Size in 
bytes

Size of a file, expressed in bytes. Set file 
attributes

Required 
MID Server 
capabilities

MID Server with the appropriate MID Server capabilities  for 
connecting to the source and target servers. By default, the 
system selects an SSH MID Server.

All

The system uses this logic to determine which files to move from the source host:

◦ If the Source files  field is empty, the system select all the files in the source directory. 
Otherwise, it only selects those files whose names match one of the file name patterns given 
in the field.

◦ If the Excluded files  field is empty, the system excludes nothing. Otherwise, it excludes 
those files whose names match one of the file name patterns given in the field.

◦ The exclude rule has a higher preference than the include rule. A file whose name matches 
one of the file name patterns in the Excluded files  field does not get into the selection, even 
though it would be selected by the include rule.

◦ When the Include subfolders  check box is cleared, the system looks only in the source 
directory for files to include or exclude. Otherwise, it looks in the source directory and any of 
its subfolders for files to include or exclude.

3. Click Save.

4. Click Continue  to advance to the Outputs  stage.

Create a probe activity

Create an activity that runs a probe on the target host that is configured to return specific 
information..

Before you begin
Role required: activity_creator or workflow_admin

About this task
For instructions on using the activity template process flow, see create custom activities.

Procedure

1. Create a custom activity .
This action creates a custom activity using a template.

2. After setting up general properties  and creating input variables, configure the Probe Execution 
Command.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

5111

https://www.webstg.servicenow.com/docs/access?context=create-custom-activities&version=washingtondc&pubname=washingtondc-integrate-applications&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=create-custom-activities&version=washingtondc&pubname=washingtondc-integrate-applications&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=create-custom-activities&version=washingtondc&pubname=washingtondc-integrate-applications&ft:locale=en-US


Option Description

Map the input variables
Use the variables you created to configure 
the command that Orchestration executes.

Probe
Probe to run with this activity, from the list of 
probes in the system

Target host
Host name or IP address of the target server 
for this activity.

Parameters MID Server to use, by capabilities.

Required MID Server capabilities

Name-value pairs to pass to the host with this 
probe. You can create these parameters man­
ually, or drag and drop input variables into the 
parameter fields and assign a value.

Note: 
You can map parameter values in a test payload to variables in the Outputs  tab 
automatically. See automap output variables.

What to do next

• Use auto-mapping  to generate outputs and parsing rules

• If you do not use auto-mapping, you can manually create output variables  and create parsing 
rules

Probe template execution parameters

You use execution parameters to create the input process script in the Pre Processing  form.

For descriptions of the command fields, see Configure the Probe execution command.

Note: 
You must use the executionParam.  prefix with all variables in this table.

Probe activity execution parameters

Name Variable Type Usage

Probe probe Reference The sys_id of the MID Server probe.

Source source String Intended target host

Parameters parameters Array of JS 
object

Array of JavaScript objects, expressed 
with the executionParam.  prefix. 
To add more name-value pairs to the 
parameters  array, append them to the 
existing array. Create a JavaScript object 
with the following syntax, and add it to the 
executionParam.parameter  array. 
This assigns additional parameters to the 
message:

var newParameter = 
 {"name":"parameterName","val
ue":"parameterValue"}; 
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Probe activity execution parameters  (continued)

Name Variable Type Usage

 executionParam.parameters.pu
sh(newParameter);

MidCapabilities midCapabilities String 
(comma 
separated)

List of required MID server capabilities.

ValueCapabilities valueCapabilities Array of 
hashmap

Capability values used to select the MID 
Server. For more information, see MID 
Server capabilities. If there are additional 
capabilities that are assigned by value, use 
this example to customize the MID Server 
selection:

var valueCapability = 
 {'NEW_MID_CAPABIILTY':'NEW_M
ID_CAPABILITY_VALUE'}; 
 executionParam.valueCapabili
ties.push(valueCapability);

Probe template post-processing parameters

Use these parameters to create a post-processing script.

Probe post-processing parameters

Name Variable Type Usage

Payload payload String Contains raw payload returned from the probe.

Output output String Contains output data returned from the probe.

EccSysId eccSysId String Contains the reference ID associated with the ECC Queue input 
message.

Configure the Probe execution command

Use the input variables you created to configure the command that Orchestration executes on 
the target.

Before you begin
Create the input variables you need in the Inputs  form before you can advance to the Execution 
Command  stage.

Role required: activity_creator, admin

Note: 
You can test the activity connection between the MID Server and the target without having 
to run the acvitity in a workflow context. For details, see test template outputs.

Procedure

1. Drag variables from the list of inputs and drop them into command fields.
The system formats the variable in the proper syntax for the command.
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Probe execution command

2. Complete the fields shown in the table.

Probe execution command fields

Field Description

Input Input variable builder. Create input variables  to map to available fields.

Probe Probe to run with this activity, from the list of probes in the system.

Target host Host name or IP address of the target server for this activity.

Required 
MID Server 
capabilities

MID Server to use, by capabilities.

Parameters Name-value pairs to pass to the host with this probe. You can create these 
parameters manually, or drag and drop input variables into the parameter 
fields and assign a value.

3. Click Save.

4. Click Continue  to advance to the Outputs  stage.

Create an SSH activity

Create an activity that extracts data from a target host that uses the SSH network protocol.

Before you begin
Role required: activity_creator or workflow_admin

About this task
For instructions on using the activity template process flow, see create custom activities.
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Procedure

1. Create a custom activity .
This action creates a custom activity using a template.

2. After setting up general properties  and creating input variables, configure the SSH Execution 
Command.

Option Description

Map the input variables
Use the variables you created to configure 
the command that Orchestration executes.

Target host
Host name or IP address of the target server 
for this activity.

Command

Command this activity runs on the target 
host. You can invoke a MID Server script from 
this field using any script type that the SSH 
command line supports. For more informa­
tion, see Advanced SSH script options  be­
low the table.

Directory
Directory on the target host where the com­
mand is run.

Credential tag
The Orchestration credential tag to use when 
running the command.

Required MID Server capabilities

MID Server with the appropriate capabilities 
for connecting to the host. By default, the sys­
tem selects a MID Server with SSH capabili­
ties.

Long running

If checked, disables the SSH connection time­
out for commands that might take longer to 
run than the default 60 seconds. Orchestra­
tion periodically checks the running process 
to determine its status until it is finished.

Must Sudo If checked, enables the use of  to run 
commands.

Note: 
You can map parameter values in a test payload to variables in the Outputs  tab 
automatically. See automap output variables.

Example: Advanced SSH script options

To run a MID Server  script on the target host, specify the script type and pass the name of the 
script into the ${syncFile()}  parameter. The system uses this parameter to locate the 
named script in the MID Server Script File [ecc_agent_script_file] table and run it on the target 
host. For example, a bash script can be expressed as:

bash ${syncFile("<MID script name>")} argument1 argument2 
 argument3

A base script (main_script.bash) can reference another script (my_include.bash) 
as well as a separate file (.my_profile) located on the target host. Both scripts and the 
file referenced must be synced to the MID Server, using the ${syncFile()}  parameter, to 
execute properly.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

5115

https://www.webstg.servicenow.com/docs/access?context=create-custom-activities&version=washingtondc&pubname=washingtondc-integrate-applications&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=create-custom-activities&version=washingtondc&pubname=washingtondc-integrate-applications&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=create-custom-activities&version=washingtondc&pubname=washingtondc-integrate-applications&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=r_SSHCredentialsForm&version=washingtondc&pubname=washingtondc-platform-security&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=r_SSHCredentialsForm&version=washingtondc&pubname=washingtondc-platform-security&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=r_SSHCredentialsForm&version=washingtondc&pubname=washingtondc-platform-security&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=r_SSHCredentialsForm&version=washingtondc&pubname=washingtondc-platform-security&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=r_SSHCredentialsForm&version=washingtondc&pubname=washingtondc-platform-security&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=r_SSHCredentialsForm&version=washingtondc&pubname=washingtondc-platform-security&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=r_SSHCredentialsForm&version=washingtondc&pubname=washingtondc-platform-security&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=r_SSHCredentialsForm&version=washingtondc&pubname=washingtondc-platform-security&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=r_SSHCredentialsForm&version=washingtondc&pubname=washingtondc-platform-security&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=r_SSHCredentialsForm&version=washingtondc&pubname=washingtondc-platform-security&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=r_SSHCredentialsForm&version=washingtondc&pubname=washingtondc-platform-security&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=r_SSHCredentialsForm&version=washingtondc&pubname=washingtondc-platform-security&ft:locale=en-US


source ${syncFile(".my_profile")}
cp ${syncFile("my_include.bash")} /usr/ssmith/my_include.bash
bash ${syncFile("main_script.bash")} one two three four five six
rm /usr/ssmith/my_include.bash

A Python example with inline comments might look like this:

set $LIB_DIR=/usr/bin;.
  Sync a file that is referenced inside myF5CreateLBPool.py
cp ${syncFile("specialFunctions.py")} ~/specialFunctions.py
  set up environment variables
source ${syncFile(".python_profile")}
  call script that sets up dependencies on the box from remote 
 package repos
python ${syncFile("setupPythonDependencies.py")} pycontrol
  call a script that requires functions from the package as well 
 as a function from myIncludedFile
python ${syncFile("myF5CreateLBPool.py")} snow_pool 
 myActualValue
  user is responsible for their own cleanup
rm ~/specialFunctions.py 

What to do next

• Use auto-mapping  to generate outputs and parsing rules

• If you do not use auto-mapping, you can manually create output variables  and create parsing 
rules

SSH template execution parameters

Use execution parameters to create the input process script in the Pre Processing  form of the 
activity designer.

For descriptions of the command fields, see Configure the SSH execution command.

Note: 
You must use the executionParam.  prefix with all variables in this table.

SSH execution parameters

Name Variable Type Usage

Source source String Intended target or host.

Command command String Comment to run on the host.

Directory directory String Directory on the host in which to run the 
command.

Credential tag credential_tag String Orchestration credential tag to use when 
running the command.

MidCapabilities midCapabilities String 
(comma 
separated)

List of required MID Server capabilities.

ValueCapabilities valueCapabilities Array of 
hashmap

Capability values used to select the MID 
Server. For more information, see MID 
Server capabilities. If there are additional 
capabilities that are assigned by value, use 

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

5116



SSH execution parameters  (continued)

Name Variable Type Usage

this example to customize the MID Server 
selection:

var valueCapability = 
 {'NEW_MID_CAPABIILTY':'NEW_M
ID_CAPABILITY_VALUE'};
executionParam.valueCapabilit
ies.push(valueCapability);

Long running long_running Boolean Indicates whether or not the command is 
long running. A value of true indicates that 
the command is long running.

Must sudo must_sudo Boolean Indicates whether or not this activity must 
use sudo to run root commands. A value of 
true indicates that sudo  SSH credentials
must be used.

SSH post-processing parameters and payload parsing

Use these parameters to create a post-processing script, payload parsing, and tagging.

SSH post-processing parameters

Name Variable Type Usage

Output output String Contains the output returned from the SSH 
command.

EccSysID eccSysID String Contains the reference ID associated with the 
ECC Queue input message returned by the 
activity.

ErrorMessages errorMessages String Contains the error messages retrieved from the 
SSH command. This value is null  if there are no 
error messages.

Tags tags Hashmap of 
tag values 
returned 
from 
the SSH 
command

Contains the tags used to extract output using 
the SSH commands. The tag output is delimited 
by double percentage signs, as in %%tagname
%% … %%. Set up the command using the 
following format:

%%tagname1%%
output1 line 1
output1 line 2
…
%%
 
%%tagname2%%
output2 line 1
output2 line 2
…
%%
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SSH post-processing parameters  (continued)

Name Variable Type Usage

The tags returned are JavaScript hashmap 
objects in which each key is prefixed with tag 
appended with the tagname.

{"__text__": "",
"tagtagname1":"output1 
 line1\noutput1 line2\n",
"tagtagname2":"output2 
 line1\noutput2 line2\n"}

Configure the SSH execution command

Use the input variables you created to configure the command that Orchestration executes on 
the host target.

Before you begin
Create the input variables you need in the Inputs  form before you advance to the Execution 
Command  stage.

Role required: activity_creator, admin

Note: 
You can test the SSH connection between the MID Server and the target without having to 
run the acvitity in a workflow context. For details, see test template outputs.

Procedure

1. Drag variables from the list of inputs and drop them into command fields.
The system formats the variable in the proper syntax for the command.

SSH execution command

2. Complete the fields shown in the table.
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SSH activity inputs

Field Description

Input Input variable builder. Create input variables  to map to available fields.

Target host Host name or IP address of the target server for this activity.

Command Command this activity runs on the target host.

You can invoke a MID Server script from this field using any script type that is 
supported by the SSH command line. For more information, see Advanced SSH 
script options  below the table.

Directory Directory on the target host where the command is run.

Credential 
tag

The Credential aliases for Orchestration activities  to use when running the 
command.

Select MID 
Server by 
capabilities

MID Server with the appropriate capabilities for connecting to the host. By 
default, the system selects a MID Server with SSH capabilities

Long 
running

Check box to disable the SSH connection timeout for commands that might 
take longer to run than the default 60 seconds. Orchestration periodically 
checks the running process to determine its status until it is finished.

Must Sudo Check box to allow the use of SSH credentials  to run commands.

3. Click Save.

4. Click Continue  to advance to the Outputs  stage.

Create a run script activity

Create an activity that runs any script.

Before you begin
Role required: activity_creator or workflow_admin

Procedure

1. Create a custom activity .
This action creates a custom activity using a template.

2. After setting up general properties  and creating input variables, configure the Run Script 
Execution Command:
Create a script for this activity to execute.

Note: 
You can map parameter values in a test payload to variables in the Outputs  tab 
automatically. See automap output variables.

What to do next

• Use auto-mapping  to generate outputs and parsing rules

• If you do not use auto-mapping, you can manually create output variables  and create parsing 
rules
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Run Script template processing script

Use the Run Script custom template Script form to enter a script to call and use with other 
activities.

Run Script processing script

Field Description

Processing 
script

Script that the activity runs.

Variables Input variables that are available to use as building blocks in the input process 
script. Click the arrow above the field to open the variables list. Click an item in 
the tree to add it to your script in the appropriate syntax. The list displays input 
variables you passed into the activity on the Inputs  form. All activity variables 
added in the Inputs  form are read-only and are expressed in the processing script 
with this syntax: activityInput.variable.

Create a JMS activity

Create a custom JMS activity to retrieve or send messages to external systems using the Java 
Messaging Service.

Before you begin
Role required: activity_creator or workflow_admin

About this task
The JMS activity supports third party JMS providers whose JMS client application is written with 
a typical Java EE pattern and can support these operations:

• Using JNDI to find a ConnectionFactory object.

• Using JNDI to find one or more destination objects.

• Using the ConnectionFactory to create a JMS connection object.

• Using the JMS connection to create one or more JMS session objects.

• Using a JMS session and the destinations to create the MessageProducer and 
MessageConsumer objects.

• Starting the JMS connection to enable delivery or consumption of messages.

Note: 
The JMS activity designer has been tested with the JMS providers ActiveMQ and Tibco 
EMS. When connecting to a JMS provider, refer to your third party user documentation.

Procedure

1. Create or verify your JMS credential  .
Your JMS credentials must have permission for the target database and proper configuration 
for the corresponding JMS connection. Credentials must be set up before you can create a 
JMS activity.

2. Create or verify your JMS connection .
Your JMS connection must be configured with valid JMS credentials set up before you can 
create a JMS activity.

3. Create a custom activity .
This action creates a custom activity using a template.
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4. After setting up general properties  and creating input variables, configure the JMS Execution 
Command.

Option Description

Configure your credential
Fill in the fields necessary for your database 
connection.

Connection Factory

Name of the JMS Connection Factory. You 
should create or verify your JMS connection. 
This configuration links the name of the Ini­
tial Context Factory with the URL of the JMS 
provider.

Destination Type

Type of destination used for this message:

◦ Queue: Message is queued for point-to-
point communications.

Note: 
The GET  operation is only supported 
for the Queue destination type.

◦ Topic: Message is used for publish and sub­
scribe communication.

Destination Name
Name of the queue or topic destination that is 
configured on the JMS provider.

Message Type

The JMS message type value. Only the Text 
Message  type is supported. The queue or top­
ic destination must be configured to receive 
or send only Text Message. Other message 
types are dropped, since the JMS Activity can­
not process them.

Operation
The programmatic operation to perform on 
the destination. The choices are PUT  or GET.

Timeout (Secs)
Allowed time to wait for a message in the mes­
sage queue before it times out, in seconds. 
The default is 30.

Custom message headers

The custom header values in a name/value 
pair format, that is available on the JMS desti­
nation.

Note: 
This is only supported for a PUT  opera­
tion.

Message payload

Actual message content or payload that is 
sent to the JMS destination.

Note: 
This is only supported for a PUT  opera­
tion.
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Option Description

Credential tag
A tag for an individual credential for a JMS ac­
tivity in an Orchestration workflow.

Required MID Server capabilities MID Server to use, by capabilities.

What to do next

• Use auto-mapping  to generate outputs and parsing rules

• If you do not use auto-mapping, you can manually create output variables  and create parsing 
rules

Create a JMS connection for an Orchestration  activity

Configure your system to use Java Messaging Service (JMS) with a custom Orchestration JMS 
activity.

Before you begin
Role required: admin

About this task
The MID Server must have the correct JMS connection factories for your organization. Configure 
those values in the mid.property.jms.command.allowed_factory_names  property, 
found in MID Server  > Properties. The default values for this property can be changed to any 
value or comma-separated list of values that the third-party JMS provider advertises.

Procedure

1. Navigate to MID Server  > JAR Files.

2. Click New  and add.

Option Description

Name
A unique and descriptive name for identifying 
the file in the instance.

Version
A version number for the file, if one is avail­
able.

Source
Location of the JAR file for reference purpos­
es. Source information is not used by the sys­
tem.

Description
Short description of the JAR file and its pur­
pose in the instance.

3. Click the paper clip icon in the banner and attach the JMS driver jar file.
The JMS driver jar file should be available as part of JMS provider installation. Few JMS 
vendors make them available as a separate product. Refer to the JMS provider documentation 
to determine which JMS client driver jar files require the client applications to connect to the 
JMS provider. For example, if you are trying to connect to ActiveMQ V5.10 (JMS provider), you 
need the activemq-all-5.10.1.jar  file.

4. Navigate to Orchestration  > Credentials & Connections  > JMS Connection Factory.

5. Click New, add the following, and click Submit.
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Option Description

Name Unique name of this connection factory.

Initial Context Factory

Name of the JNDI class that is used to create 
the InitialContext.

Note: 
For example, to connect to Active­
MQ V5.10 (JMS Provider), the value is 
org.apache.activemq.jndi.Ac­
tiveMQInitialContextFactory.

Provider URL

Location of the running JMS provider installa­
tion.

Note: 
For example, to connect to ActiveMQ 
V5.1: tcp://ipAddressOrHost­
Name:61616.

6. Navigate to Orchestration  > Credentials.

7. Click New, select JMS Credentials, and provide the user name and password the MID should 
use to communicate with the JMS provider.
For more information, see JMS credentials  JMS credentials .

8. Click Submit.
You are ready to create a custom JMS activity.

JMS template execution parameters

You use execution parameters to create the input process script in the Preprocessing  form.

You must use the executionParam.  prefix with all variables in this table.

JDBC execution parameters

Name Variable Type Usage

Jms ds jms_ds Reference Selected JMS data source.

Destination type destination_type Enumerated

Destination 
name

destination_name String

Message type message_type Enumerated

Operation operation Enumerated

Time out time_out Integer Length of time to wait for the query to 
return results.

Custom headers custom_headers Array of 
JavaScript 
objects
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JDBC execution parameters  (continued)

Name Variable Type Usage

Message 
payload

message_payload String

Credential tag credential_tag String List of required MID Server capabilities.

MidCapabilities midCapabilities String 
(comma 
separated)

ValueCapabilities valueCapabilities Array of 
hashmap

Capability values used to select the MID 
Server. For more information, see MID 
Server capabilities. If there are additional 
capabilities that are assigned by value, 
use this example to customize the MID 
Server selection:

var valueCapability = 
 {'NEW_MID_CAPABIILTY':'NEW
_MID_CAPABILITY_VALUE'};
executionParam.valueCapabil
ities.push(valueCapabilit
y);

JMS template post-processing parameters

Use these parameters to create a post-processing script.

JMS post-processing parameters

Name Variable Type Usage

Status status String Status of the operation (Put or Get) on the JMS 
destination.

StandardHeaders standardHeaders String All the standard headers, as specified by JMS, 
that are obtained as part of the JMS message 
during a Get operation. This field is applicable 
only for Get operations.

CustomHeaders customHeaders String All custom headers added by a producer or 
publisher application that are obtained as part 
of the JMS message during a Get operation. This 
field is applicable only for Get operations.

MessagePayload messagePayload String Message payload that is obtained as part of the 
JMS message during a Get operation. This field 
is applicable only for Get operations.

EccSysID eccSysID String Contains the reference ID associated with the 
ECC Queue input message returned by the 
activity.

ErrorMessages errorMessages String Contains any error messages retrieved from the 
JMS command. This value is null  if there are no 
error messages.
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Activity scoping

Custom activities run in their own scope, even if it is different from that of the workflow.

Any script that runs inside a custom activity with a scope can only access outside artifacts 
that are within the scope of that activity or artifacts that are configured to run in any scope. 
Conversely, an outside artifact can only access the script inside that private activity if the outside 
artifact is running in the same scope. Activities with public scopes can interact with outside 
artifacts in any application scope.

You can use private activities as part of a workflow that has a public application scope. These 
activities are protected from reaching outside of the workflow or from being reached from outside 
the workflow. For details about setting application scoping for custom activities, see the field 
description table for the appropriate activity template .

Note: 
Custom activities uploaded to the ServiceNow  Store must be configured as accessible to all 
application scopes.

Publish a custom activity

When a user creates a custom activity and saves or submits it, that activity appears in the 
Custom  and Packs  tabs of the designer palette, but is visible only to the user who created it.

Before you begin
Roles required: admin, activity_admin, activity_creator

Procedure

1. When you finish configuring the activity, click Publish.

This makes the activity accessible to other users on the instance with the workflow_admin or 
activity_creator role. Published activities are available for upload to the ServiceNow  Store, can 
be added to workflows, and can be edited by any user with the proper roles.

2. To edit a published activity, click Checkout.

When an activity is checked out by a user, only that user can modify it. The fields of a checked 
out activity are read-only for all other users.

3. When you are finished editing the checked out activity, publish it again.

The system adds a new version of this activity to the Custom  tab in the Workflow Editor palette.

Note: 
Activities you create and publish are visible in the Packs  tab only if they were created in 
the current application scope.

Return a locked activity to a published state

Problems can arise if an activity version is checked out by a user and not checked back in. An 
activity in this state cannot be checked out for update.

Before you begin
Role required: admin, activity_admin, activity_creator

About this task
An administrator can return a locked activity to a published state.
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Procedure

1. Open the Workflow Editor.

2. From the Custom  tab, open the activity that is locked.

3. Click the menu icon in the title bar and select Versions  from the context menu.

A list of all the versions of that activity appears. The locked version displays the user who 
checked it out.

4. Select the checked out version.

The system opens the record in the activity designer.

5. Click the menu icon again and select Force Checkout  from the context menu.

The activity fields become editable.

6. Click Publish.

The activity becomes available to users with the appropriate roles.

Copy a custom activity

You can copy activities for reuse from the Custom  tab in the global scope.

Before you begin
Role required: admin, activity_admin, activity_creator

About this task
Note: 
You cannot copy an activity in a private scope.

Procedure

1. To reuse an activity in the global scope, expand the parent category to display the activities.

2. Right-click the activity you want to copy and select one of these options:
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◦ Copy into global scope as new activity: Copies the activity with the new name you provide, 
uses the same version number as the original activity, and moves it to the global scope in the 
Custom  tab.

Naming an activity copy

◦ Copy into global scope as new version: Copies the activity using the same name, 
increments the version number, and moves it to the global scope in the Custom  tab. The 
system automatically adds the parent category to the Custom  tab if it does not already exist. 
This action will overwrite another activity with the same name and version number.

Creating a new activity version

Note: 
If the activity is in any other scope but global, the system displays this message: Cannot 
copy privately scoped activity.

Orchestration databus

The databus allows workflow designers to track the flow of data through an Orchestration 
workflow and provides access to output data that can be consumed by other custom activities.

Data is made available in a workflow when you use activities created with the Orchestration 
activity designer. The activity designer provides the ability to specify well defined inputs and 
outputs for your activities. When you use those activities on the workflow canvas, the outputs 
appear in the Data  tab and are available for use as inputs in subsequent activities.

Note: 
Orchestration does not filter the data you are given for reuse in the Data  tab. You must 
make sure an activity in the workflow canvas has executed before you consume its output 
data.

When you drop a custom activity onto the workflow canvas, the system assigns it an index. If you 
delete an activity from the canvas and add a new one, the indexes are not reused. This ensures 
that you don’t accidentally start subscribing to data you did not intend to use. If you update an 
activity in the activity designer, the system automatically updates the activity on the canvas to 
ensure the data you are subscribing to downstream is not affected.

Reuse data in the activity designer

The Data  tab in the Workflow Editor lists all custom activities used in the current workflow that 
produce data and displays that data for reuse in other custom activities.

Before you begin
Roles required: workflow_creator
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About this task
Activities are categorized by application in this tab and are available for use as data sources 
for other activities. The Data  tab is a graphical representation of the workflow Databus, which 
manages all the temporary data used by the current workflow.

Procedure

1. Drag output variables from an activity in this tab into the inputs of another activity on the 
workflow canvas to link the activities together.

You can use any of the outputs in the structure, regardless of the application to which they 
belong. An index number in parenthesis after the activity name provides a unique identifier 
for the parameters that you use as input data in other activities. If you do not name a custom 
activity, the only identifier for that activity in the Data  tab is the index number. Index numbers 
indicate the sequence in which custom activities were added to the workflow and are not 
reused. When you drag a custom activity onto the workflow canvas, the system adds that 
activity and its output data to the structure. Conversely, if you remove a custom activity from 
the canvas, that activity and its outputs disappear from the data list.

2. Point to an activity to display information about it in a pop-up window.

Any output data reused by the activity is listed in the Databus Output  field of the pop-up 
window.

MID Servers for Orchestration

Orchestration automatically selects an appropriate MID Server based on the capabilities that you 
configure in activities, the IP addresses of target devices, and the application that the MID Server 
is allowed to use.
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To allow a MID Server to work with Orchestration, it must have the Orchestration  application or 
the ALL  application assigned to it. See Configure a default MID Server for each application  for 
instructions.

You can have MID Servers focus on different capabilities and separate sections of your network. 
See:

• MID Server capabilities

• Map an IP address to a DNS name

You can also specify a default MID Server to use if no MID Servers meet the capability and IP 
range criteria for an activity. SeeSelect the default MID Server for Orchestration.

Related topics

MID Server capabilities

MID Server capabilities

MID Server capabilities define the specific functions of a MID Server within an IP address range.

Nmap capability

The Nmap  capability is only assigned to MID Servers for which the Network Mapper (Nmap) 
scanner has been installed for credential-less Discovery . This capability cannot be added to or 
removed from any MID Server manually. For instructions on installing or uninstalling Nmap, see 
Install and uninstall Nmap on a MID Server

MID Server capability values

Capabilities provided in the base system do not have a defined value string. The capability 
value can be blank, a single value, or a * (wildcard). A MID Server configured to use a capability 
that has no value can locate any device using that capability's protocol. If a capability has a 
defined value, the MID Server using that capability finds only those devices using that protocol 
that match the value string exactly. The exception to this is the Resolve DNS capability, which 
is configured to resolve any DNS name into an IP address using a partial string match. The * 
(wildcard) will match a request capability specifying any non-blank value.

Starting with the Madrid release, the [capability name]:[value]  combination appears in the 
slushbucket when you add a capability to a MID Server. This combination allows you to see all 
the capabilities that have different values, even if the capability name is the same. For example, 
if you are using the Cloud Management capability, and you use the value field to specify the us-
west logical datacenter on one of the capability records, you can see the combination in the 
Collection  list.
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MID Server selection

The MID Server is selected using an algorithm based on the capabilities available. The selector 
produces a list of suitable MIDs using filters in the following order: server status  > applications  > 
IP range  > capabilities. The algorithm searches the capabilities in the following sequence and, if 
a step finds at least one MID server, the remaining steps are skipped:

1. Exact value match:  Find each MID Server containing capabilities with name/value pairs with 
an exact match to all requested capability name/value pairs. Blank is a valid value. * (wildcard) 
values are ignored.

2. Wildcard value match:  The same as an exact value match, but also allows a non-blank request 
value to match MID server capability records containing value *.

3. Special capability name ALL:  Find each MID Server containing the special capability name 
ALL, ignoring capability's value field.

Note: 
If the requested capability name does not exist in the ecc_agent_capability table, 
BadArgumentException  is thrown rather than falling back to the ALL capability.

Scripted MID Server capability value matching

You can use value tests to create capabilities that find devices using values without requiring 
exact string matching. Action on these values is controlled by a user-defined script.

The Resolve DNS capability is provided in the base system and is configured to resolve DNS 
names into IP addresses for devices whose names end with a specified domain name. The 
capability Value  entered is automatically prefaced with a dot during processing to match domain 
syntax. This value can contain one or more sub-domains, but must include the end of the 
domain string. Matching devices must end with the identical syntax. The script for the Resolve 
DNS capability determines if a device name matches the criteria defined by Value. If a match 
exists, the platform performs the address resolution automatically. For example, if the value for 
the Resolve DNS capability is service-now.com, the MID Server with this capability finds 
lnxlab01.sandiego.service-now.com  and dbsrv101.sanjose.service-
now.com. If the value is changed to sandiego.service-now.com, then the MID Server 
finds only lnxlab01.
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Note: 
If Value  in the Resolve DNS capability is blank, then all domains match.

To view the script for evaluating this capability, navigate to MID Server  > Capability Value Tests 
and select Resolve DNS  from the list.

Configure MID Server capabilities

MID Server capabilities define the specific functions of a MID Server within an IP address range, 
allowing an application to select the most appropriate MID Server. Configure capabilities on MID 
Servers for applications like Orchestration, Cloud Management, and Service Mapping.

Before you begin
Role required: admin or sm_admin

About this task
Several applications use capabilities, IP ranges, and MID Server selection  to narrow the pool of 
MID Servers the applications need.

Note: 
At least one capability is required for each MID Server used by Orchestration. See MID 
Servers for Orchestration  for more information.

The following capabilities are available by default with Discovery:

All IBM Resolve DNS

Ansible JDBC REST

AWS NetApp SNMP

Azure Nmap SOAP

Chef OpenStack SSH

Cloud Management PowerShell VMware

Google RCA WMI
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Procedure

1. Navigate to All  > MID Server  > Capabilities.

2. Select an existing capability or select ALL  to include all capabilities.

Note: 
Ensure that each IP address range has MID Servers with the necessary capabilities to 
complete the Orchestration activities on that network segment.

3. Create a new capability:

a. Select New.

b. Configure the value for a custom capability.

Example 
An example is a capability for DOMAIN, with a value of service-now.

c. Select Submit.

4. Select Edit  in the MID Servers related list to add MID Servers to the capability.

5. Select one or more MID Servers for this capability from the Available  list.

6. Select Save.

The capability defined here also appears in the primary record for this MID Server.

Select the default MID Server for Orchestration

Orchestration uses the default MID Server if it cannot find a MID Server with the correct IP range 
and capability.

Specify the default MID Server in either of these locations:

• The Default MID Server  field on the Orchestration application record. See Configure a default 
MID Server for each application  for instructions.

• The Default MID Server to use for Orchestration Activities  property. Navigate to 
Orchestration  > MID Server Properties  to set this value.

These two values are automatically kept in synch. You can change the default MID Server in 
either location.

PowerShell probe version 2 system property

View detailed PowerShell credential information and view extended logging information.

Starting with the madrid release, there is a new system property for the PowerShell probe which 
enables the version 2 of the probe. This new version enables you to view detailed credential 
information on why PowerShell credentials fail or succeed. You can also view logging information 
for an ECC Queue payload and Workflow Context log.

mid.server.rba_powershell_v2

Enables the PowerShell probe version 2 for use with all PowerShell activities. The default value 
is true. If you choose false, the legacy PowerShell probe is used. Unless there are issues, use 
version 2, as the legacy version is going to be deprecated.
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Note: 
This property only applies to Orchestration activities. Discovery  probes are not affected.

You can access the property by selecting the MID Server Properties link in the navigation pane:

PowerShell log property

Enable debug messages to display from PowerShell.

This property enables control of when and where to display debug messages generated by 
debug statements embedded in the PowerShell scripts.

mid.property.powershell.log_info

The new MID Server PowerShell log property:

• Displays logging information.

Note: 
Once logging is enabled, OOB PowerShell scripts log information.

• Adds logging information to your developed PowerShell scripts and PowerShell activities.

Note: 
Logging information is only available when property is enabled.

• Logging is not enabled by default.

If the property is set to true, debug messages display from the workflow context or from the 
Response popup after you test inputs. The ecc_queue entry payload for each of the PowerShell 
activities is going to show all the debug messages that were logged.
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Enable the PowerShell log property for each MID Server. If the MID Server field is empty, the 
property applies to all MID Servers. There are separate credential debug messages that always 
come back regardless of this setting. The credential debug messages show which credentials 
have been used and other related information.

Note: 
All the debug messages that come back to the instance are also saved to the MID Server 
log file. The log file might have additional debug messages generated from Java code, 
which might help the debug process.

Use the Orchestration Usage dashboard

This dashboard shows an overview of Orchestration usage metrics to show customers how their 
organization uses Orchestration and to support license compliance.

Before you begin
Role required: orchestration_manager

Procedure

1. To view the dashboard, navigate to Orchestration  > Operations & Troubleshooting  > 
Orchestration Usage Dashboard.
The Orchestration Usage dashboard is displayed. The tabs on the dashboard include 
Licensable Usage and Orchestration Usage. Reports on these tabs include:

Orchestration Usage Metrics

Metric Description

Transaction Summary Last 12 months A running transaction count of all 
Orchestration transactions over the last 12 
months. Includes:

◦ The count of orchestration transactions 
associated with the HR Application

◦ The count of Orchestration transactions 
associated with the Security Operations 
Application

Transaction Summary YTD Cumulative count of all transactions since the 
time the Orchestration plugin was activated 
or the customer upgraded to Geneva.

365 day Running Average of Server The running average over the last 365 days 
for cmdb_ci_computer - cmdb_ci_server. This 
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Metric Description

includes all physical and virtual client nodes 
and excludes server nodes from the count.

365 day Running Average of Client The running average over the last 365 days 
for cmdb_ci_server. This includes all physical 
and virtual server nodes.

Orchestration Transactions by Month for Last 
12 Months

Average Client Nodes Orchestrated Last 365 
Days

Average Server Nodes Orchestrated Last 365 
Days

Number of Orchestration Activities 
Developed Last 365 Days

The aggregate number of activity definitions 
you have developed and OOB activity 
definitions you have modified. This number 
includes activity elements (Activities 
build with the Activity Designer) you have 
developed and OOB activity definitions you 
have modified.

Note: 
his number excludes activity elements 
that are shipped with ServiceNow 
Applications that use the Orchestration 
Runtime e.g. ServiceNow Security 
Operations and Human Resources 
Apps.

Cumulative Client Nodes Orchestrated by 
Month

Cumulative Server Nodes Orchestrated by 
Month

Usage by Provider Last 12 Months Breaks down emphasis by provider, such as 
PowerShell, JDBC, SSH, etc.

Top 10 Orchestration Activities

2. Optional:  You can add more widgets to the dashboard by clicking the Add Content  icon ( ) 
in the upper right corner of the dashboard.

Note: 
You should not modify the first tab in this Dashboard. If you want a different dashboard 
experience, add a tab and customize that with your usage reports.

Legacy: Chat
Chat is deprecated in the Istanbul release.
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Note: 
The Connect  feature provides an updated instant messaging platform, which is activated 
by default for new instances. The legacy chat and Connect features should not be used 
concurrently. There is no migration path from legacy chat to Connect.

Chat provides real-time communication via instant messaging between users in a ServiceNow 
instance. Features include:

• One-to-one chats (instant messaging) between users.

• Chat rooms for conversations with multiple users. Chat rooms may be public (any user can 
join) or private (only invited users can join).

• Chat rooms linked to task records. Users can work together to solve issues, and conversation 
history can be shared by everyone who needs to reference it.

• Help desk chat. End users can access live support via instant messaging. Service desk staff 
can resolve basic issues in real-time or create incidents directly from chat requests for more 
extensive issues.

Chat Desktop

Legacy: Get started with Chat

Get started with legacy chat.

Before you begin
Role required: admin
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Procedure

1. Establish use guidelines.
Social media can improve communication and aid productivity. To get the most out of these 
tools, establish clear and simple social media guidelines that foster information sharing and a 
comfortable work environment.

2. Activate the Chat  plugin to enable the legacy chat and legacy Help Desk Chat features.

3. Configure security settings.
Users must log in to use the legacy chat features in the base system. The standard system 
security settings and Social IT-specific security settings are available. To learn more about 
setting up these features, refer to the plugin activation pages.

◦ Chat rooms may be Public (any user can join) or Private (only invited users can join).

◦ Administrators can limit who can read chat messages on tasks and who can create chat 
rooms.

Legacy: Installed with Chat

What components are installed with legacy chat.

Demo data is available for legacy chat. The demo data creates a chat queue called Help Desk 
Chat that is supported by the assignment group Chat Support. Additionally, the Help Desk Chat 
link is added to the header of the Employee Self-Service portal. To learn more, see Set Up Chat 
Queues for Help Desk Chat.

Other:

• Event: A new event called chat.invite  is registered to trigger an email notification when users 
are invited into a chat room.

• Email Notification: An email notification called Chat Room Invite is added to send when users 
are invited to a chat room.

Legacy: Fields installed with legacy chat

Legacy chat adds fields.

Display name [Table name] Description

Header

[content_block_header]

Adds the Help Desk Chat link to the ESS portal page.

Legacy: Properties installed with legacy chat

Legacy chat adds properties.

Name Description

glide.chat.invite_fields Comma-separated list of fields used to generate 
the invites when creating a chat room from a task. 
The user is presented with check boxes for each of 
the specified fields to select the invites for the chat 
room. The fields should be references or glide_lists 
of sys_user or sys_user_group.
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Name Description

• Type: string

• Default value: assignment_group,watch_list

• Location: Social IT  > Chat Administration  > 
Properties

glide.chat.show_emoticons Setting that determines whether to display 
emoticons in conversations.

• Type: true | false

• Default value: true

• Location: Social IT  > Chat Administration  > 
Properties

glide.chat.sound.message_received.mp3 Sound played when a message is received in chat 
(mp3).

• Type: string

• Default value: media/rcvmsg.mp3x

• Location: Social IT  > Chat Administration  > 
Properties

glide.chat.sound.message_received.ogg Sound played when a message is received in chat 
(ogg).

• Type: string

• Default value: media/rcvmsg.oggx

• Location: Social IT  > Chat Administration  > 
Properties

glide.chat.sound.queue_beep.mp3 Sound played when a new user enters the 
chat queue (mp3). Both this property and 
glide.chat.sound.queue_beep.ogg  must 
be defined for either property to work.

• Type: string

• Default value: media/button_toggle_on.mp3x

• Location: Social IT  > Chat Administration  > 
Properties

glide.chat.sound.queue_beep.ogg Sound played when a new user enters the chat 
queue (ogg).

• Type: string

• Default value: media/button_toggle_on.oggx

• Location: Social IT  > Chat Administration  > 
Properties
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Name Description

glide.chat_room.create_roles Comma-separated list of roles that are allowed to 
create chat rooms.

• Type: string

• Default value: itil

• Location: Social IT  > Chat Administration  > 
Properties

glide.short_poll_delay Short polling delay for XMPP requests. Enter a value 
in milliseconds. The minimum value is 250. With 
short polling, the browser sends a request to the 
server in fixed intervals defined by the property. To 
minimize performance impact, it is recommended 
that this value is set greater than or equal to the 
default value.

• Type: integer

• Default value: 1000 (one second)

• Location: Social IT  > Chat Administration  > 
Properties

Legacy: Script includes installed with legacy chat

Legacy chat adds script includes.

Name Description

ChatUtils Provides utilities for chat conversations.

Legacy: Tables installed with legacy chat

Legacy chat adds tables.

Table Description

Chat Actions

[chat_actions]

Defines additional chat window menu items. Access at Social IT  > 
Chat Administration  > Actions  (administrator and chat_admin).

Chat Channel

[chat_channel]

Stores chat channels, which are chats between members. This table 
is extended by Chat thread [chat_thread] (a one-to-one chat) and 
chat_room (a multi-user chat). Extending or modifying data in this 
table is not recommended.

Chat Channel Member

[chat_channel_member]

Relationship table that associates channels and members. 
Extending or modifying data in this table is not recommended.

Chat Message

[chat_message]

Stores instant messages sent from any chat window. Extending or 
modifying data in this table is not recommended.

Chat Presence Stores presence (status) information for a user. Extending or 
modifying data in this table is not recommended.
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Table Description

[chat_presence]

Chat Queue

[chat_queue]

Stores the groups and schedules for providing support via instant 
message. Defined at Social IT  > Chat Administration  > Queues 
(administrator and chat_admin).

Chat Queue Entry

[chat_queue_entry]

Stores user requests for live support. Extends Task [task]. On a 
chat queue record, the Chat queue entries related list displays 
the entries that are associated with that chat queue. Extending or 
modifying data in this table is not recommended.

Chat Room

[chat_room]

Stores chat rooms (multi-user chat). Extends Chat channel 
[chat_channel]. Can be modified if necessary (such as to change 
a chat room from public to private), but should almost always be 
managed by system functionality.

Chat Roster

[chat_roster]

Maintains users that are associated with a user's My Friends list. 
Extending or modifying data in this table is not recommended.

Chat Roster Member

[chat_roster_member]

Tracks users that are members of a chat room. Extending or 
modifying data in this table is not recommended.

Chat Thread

[chat_thread]

Stores one-to-one chats. Extends Chat channel [chat_channel]. 
Extending or modifying data in this table is not recommended.

Live Headline

[live_headline]

Sends system messages. For example, the system may send a 
message when a user enters or leaves a chat room. Extending or 
modifying data in this table is not recommended.

Live Poll Message

[sys_live_message]

System table that stores and manages chat messages. Extending or 
modifying data in this table is not recommended.

Live User

[sys_live_user]

System table that stores and maintains chat users. Extending or 
modifying data in this table is not recommended.

Stores the last live 
sequence number

[sys_live_last_sequence]

Stores the last sequence ID. Extending or modifying data in this 
table is not recommended.

Legacy: Business rules installed with legacy chat

Legacy chat adds business rules.

Name Table Description

Chat Queue 
[Task.active] 
Updater

Chat Queue Entry

[chat_queue_entry]

Sets the chat queue entry Action field to Waiting when 
the action changes.
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Name Table Description

SNC - Chat 
Queue Average 
Wait Time

Chat Queue Entry

[chat_queue_entry]

When a chat queue entry is accepted, calculates the 
average wait time for the queue by averaging the last 20 
chat queue entries.

Legacy: Chat use

Legacy chat allows you to interact and collaborate through real-time instant messages with other 
users in an instance.

Use legacy chat to:

• Initiate or participate in chat conversations with one or multiple users.

• Initiate or participate in chat conversations that are attached to task records (such as an 
incident).

• See when other users are available to chat.

To open the chat desktop, navigate to Social IT  > Chat.

Note: 
Service desk staff may also provide live support to other users via help desk chat.

Chat desktop

Legacy: Update your profile

Your profile identifies your contributions to legacy chat conversations.

Before you begin
Role required: agent
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About this task
Your profile identifies your contributions to conversations. It is created automatically the first time 
you use chat and consists of:

Profile

Title Description

Name From your user account in ServiceNow. Your name appears on your messages and in 
the member list of any chat room you join.

Picture Select any picture. Your picture appears beside your name in other users' favorites list 
and at the top of your favorites list.

To update your profile picture:

Procedure

1. Click your picture in the top of the favorites list.

2. Browse to the desired picture file and click Open.

Note: 
Changes to your profile picture affect legacy chat and live feed if the Live Feed plugin is 
activated).

Chat profile picture

Legacy: Update your status

In legacy chat, your status lets other users know whether you are available to chat.

Before you begin
Role required: agent

About this task
Your status lets other users know whether you are available to chat. Your current status is 
indicated by the color of the icon in the upper right of your favorites list, beside your name. View 
the status of other users in your favorites list.

To change your status:
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Procedure

1. Click the status icon beside your name.

2. Select a status (see table).

Change status

Change status

Status Description Appears to others

Online Indicates that you are available to 
chat. Green icon:

Chat available

Away Indicates that you are not available 
because you are away. Red icon:

Chat away

Away 
with a 
message

Indicates that you are not available 
and gives a reason:

◦ In a meeting

◦ On the phone

◦ Out to lunch

You cannot create a custom message 
from the chat desktop.

Red icon and message:

Chat away msg

Invisible Indicates that you are not available. 
You can send and receive messages 
when your status is Invisible. You 
appear as Offline  to other users.

Black icon:

Chat offline

Offline Indicates that you are not available. 
You cannot send or receive messages 
when your status is Offline. Users that 
are not logged in appear as Offline.

Black icon:

Chat offline
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Legacy: Use your favorites list

In legacy chat, your favorites list appears on your chat desktop and provides certain functions.

Favorites list

My stuff • Users:

◦ Add another user  in the system to your 
favorites list.

◦ See if your favorite users are available to 
chat. Users are organized alphabetically and 
in sections by status.

◦ Start a conversation by double-clicking a 
name.

◦ Expand or collapse a section by clicking 
Online  or Offline.

• Rooms:

◦ See the list of your favorite chat rooms.

◦ Join a chat room by double-clicking its name.

• Favorites list toolbar:

◦ Options (

Chat window menu

): access a menu with options to add a 
favorite user, view online users, create a chat 
room, and view chat rooms.

◦ Add User (

Add friend

): add a favorite user.

◦ Create Room (

Add room

): create a chat room.

◦ Invitations (

Chat invitation

): respond to invitations to join chat rooms.

To expand or collapse a section in the favorites list, click the section header or click the arrows 
( ) on the section header.
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Legacy: Add a favorite user

How to add a user to your favorite users list in legacy chat.

Before you begin
Role required: admin

Procedure

1. Click the Add User  button.

Add friend

2. Begin typing a user name and select a user from the list, or click the reference lookup and 
select a user from the table.

Search icon

3. Click OK.

Legacy: Remove a favorite user

How to remove a favorite user in legacy chat.

Before you begin
Role required: admin

Procedure

To remove a user from your favorite users list, right-click the user's name and select Remove 
From List.

Legacy: View an online user

How to view a list of all users who are available to chat (status of Online) in legacy chat.

Before you begin
Role required: admin

Procedure

1. Right-click the Users section header or click Options  on the toolbar.

Chat window menu

2. Select Show Online Users.
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◦ Start a one-to-one chat with a user on the list by double-clicking a name.

◦ Send Message  or Add To Friend List  by right-clicking a name.

Online users

Legacy: View a room

How to view a list of all public chat rooms in legacy chat.

Before you begin
Role required: admin

Procedure

1. Right-click the Rooms  section header or click Options  on the toolbar.

Chat window menu

2. Select Public Rooms.

To join a room, double-click a name or right-click and select Join Room. See Joining Chat 
Rooms.

Rooms
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Legacy: Start a one-to-one chat

How to start a one-to-one chat in legacy chat.

Before you begin
Role required: agent

Procedure

• To start a chat with one user in your favorites list, double-click the user's name or right-click 
and select Send Message.

• To start a chat with one available user, double-click the user's name on the online users list.
See Viewing Online Users.

Send a message  to start a conversation.

Legacy: Create a chat room

How to start a chat with multiple users from the legacy chat desktop.

Before you begin
Role required: agent

About this task
To start a chat with multiple users from the chat desktop (requires zaccess rights):

Procedure

1. Click Create Room  on the favorites list toolbar.

Add room

2. Enter the room details (see table).

3. Click Create Room.
An invitation appears in the favorites list of all invited users and a new chat window opens on 
your chat desktop.
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Chat task create

Chat task create

Field Value

Room 
name

Enter a name to appear on the chat window header or click the Generate a 
unique room name  button (

Room name generator

) to use a system-generated name. The default name for a room created from a 
task is Chat Room for <Task Number>.

Description Enter a room description that appears under the name in the rooms list. The 
default description for a room created from a task is <Short Description>.

Password Enter a password, if desired. If a password is specified, only users with the 
password can join the chat room.

Room 
avatar

Upload an image that appears beside the room name in the list of rooms. Click 
the picture and browse to the desired image file.

Features Select all applicable check boxes:

◦ Public  if all users can see the room in the rooms lists.

◦ Members Only  if only invited users can join the room.

◦ Temporary  if the room is not saved once all participants have left. This feature 
is not available for rooms created from tasks; task chat rooms are always 
available on the task record.
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Field Value

Invite Add invited users by using the Add users to a watch list . For a room created 
from a task, you can also select all applicable check boxes:

◦ Assignment group: invite all users in the assignment group for the task.

◦ Watch list: invite all users on the watch list for the task.

Legacy: Create a chat room for a task

How to start a legacy chat with multiple users from a task record.

Before you begin
Role required: agent

About this task
Note: 
This procedure is not possible if the Connect  feature is enabled.

Procedure

1. Open the record (example, an incident on which you are working).

Chat task link

2. Click the Create or Join Chat Room  related link.

3. If a chat room already exists, click a name to join the existing chat room.
If no chat room exists, continue to the next step to create a new room.

Chat task open
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4. Click the create  link at the bottom of the window.

5. Enter the room details as you would for a chat room.

6. Click Create Room.
An email notification is sent and appears in the favorites list for all invited users (the 
assignment group and the watch list, if selected, and additional invited users).

7. In the New Room Created  message, click Join Room.

◦ A new chat window opens on your chat desktop.

◦ All invited users are listed in the chat member list. Invited users that are not currently 
participating in the chat are listed in gray.

Legacy: Join one-to-one chats

In legacy chat, when another user starts a chat by sending a message to you, a chat window 
opens on your chat desktop. To join the chat, click the window.

Legacy: Join a chat room

How to join a chat room in legacy chat.

Before you begin
Role required: agent

Procedure

1. If another user invites you to join a chat room, an invitation appears in your favorites list.

Chat invitation

2. To respond, click the invitation.

A window opens that displays the room name, room description, and the name of the user who 
invited you.

◦ To join the chat, click Join. When the chat window opens on your chat desktop, click the 
window.

◦ To ignore the invitation, click Decline.

View invitations

To rejoin a favorite chat room that you have left, click the chat room name in the Rooms section 
of the favorites list.

To join a public chat room without an invitation, right-click the Rooms section header and 
select Public Rooms. Double-click a room name on the list.
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Legacy: Join a chat room for a task

In legacy chat, if another user invites you to join a chat room from a task record, you receive an 
email notification.

Before you begin
Role required: agent

Procedure

1. Click the link in the email notification.

2. If a prompt for a password appears, enter the password listed in the email notification.

3. When the chat window opens on your chat desktop, click the window.

Legacy: Join a chat room from a task record without an invitation

How to join a chat room in legacy chat without an invitation.

Before you begin
Role required: agent

About this task
Note: 
This procedure is not possible if the Connect  feature is enabled.

Procedure

1. Open the task record.

2. Click the Create or Join Chat Room  related link.

3. Click a chat room name.

4. If a prompt for a password appears, contact the person who created the chat room for the 
password.

If a chat room has a password, only users with the password can join the chat.

5. When the chat window opens on your chat desktop, click the window.

Legacy: Chat windows

In legacy chat, a chat window appears on your chat desktop for each chat conversation that you 
start or join.
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Chat window

Legacy: Send messages in legacy chat

How to send messages in legacy chat.

To chat with other users that have joined the conversation, enter your message in the text field 
at the bottom of the window and press Enter. The message appears in the other users' chat 
windows.

To send a link, type the full URL (example, http://www.service-now.com). When the message is 
sent, the text appears blue and any user in the conversation can click it to follow the link.

To send a smiley face, type a colon followed by a close parentheses (:)). When the message is 

sent, a smiley face ( ) appears in place of the text. For more emoticons, see Sending Emoticons 
in Messages (Smileys).

Chat activity is indicated with the following alerts:

• When a new message is posted to an inactive browser tab, the tab name blinks.

• When a new message is posted to an inactive chat window, the window header appears in 
yellow and blinks.

• When a user joins or leaves a room, a message appears in the other room members' chat 
windows.

Legacy: Send emoticons in legacy chat messages (smileys)

How to send emoticons (smileys) in legacy chat.

To send an emoticon (smiley), type text from the following table. When your message is sent, the 
emoticon appears in place of the text. For example, enter colon followed by a close parentheses 

(:)) and a smiley face ( ) appears in your message.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

5152



Emoticons

Text Image

:) :-)
Smiley

B) B-) BD B-D
Shades

:D :-D
Big smile

:* :-*
Kiss

:( :-(
Frown

<3
Heart

;) ;-)
Wink

:P :-P
Playful

:O :-O
Surprise

X( X-(
Angry

:") :">
Blush

:(( :-((
Crying

(A)
Halo

:? :-?
Undecided
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Legacy: Change the display

How to change the display of legacy chat.

To view the chat window menu, click the gear button (

Chat window menu

) in the bottom left.

• To show or hide timestamps, select Show Timestamps  from the chat window menu or press 
F2.

• To show or hide the chat member list, select Show Members  from the chat window menu or 
press F4.

To resize the window, point to the lower corner (left or right). When the pointer changes shape, 
drag the window to the desired size.

To move the window, point to the header. When the pointer changes shape, drag the window 
anywhere on your chat desktop.

To close a chat window, click the X  in the upper right corner.

Legacy: Invite a user into a chat

How to invite another user into a chat in legacy chat.

Before you begin
Role required: agent

Procedure

1. Select Invite User  from the chat window menu.

Chat window menu

2. Begin typing a user name and select a user from the list, or click the reference lookup and 
select a user from the table.

Search icon

3. Click OK.

An invitation is sent to the selected user. One-to-one chats are automatically converted into 
temporary chat rooms.

Legacy: Add a favorite room

How to add a favorite room in legacy chat.

Before you begin
Role required: agent
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Procedure

To add a room to your favorites, click the chat window and select Add To Favorites  from the chat 
window menu.

Chat window menu

Legacy: Remove a favorite room

How to remove a favorite room in legacy chat.

Before you begin
Role required: agent

Procedure

To remove a room from your favorites, right-click the room name and select Remove From List.

Legacy: Set your chat preferences

Use the Chat Window Preferences to set audio notifications and default chat window display 
options in legacy chat.

Use the Chat Window Preferences  to set audio notifications and default chat window display 
options. The default display options control how a chat window looks when you first open it. 
You can still control the display options for an individual window as described in Changing the 
Display.

To view your chat preferences, click your name in the upper left corner of the chat desktop and 
select Chat Preferences.

Chat preferences

To set your preferences, select or clear the check boxes next to the options, then click Update.

Preferences

Title Description

Audio Turn audio notifications on or off.

Conversation 
Windows

Set default options for showing timestamps and members in one-to-one 
chats.
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Preferences  (continued)

Title Description

Group Chat 
Windows

Set default options for showing timestamps members in chat rooms.

Legacy: Delete a chat room

You can delete chat rooms in legacy chat.

Before you begin
Role required: chat_admin

About this task
Note that when you delete a chat room, the system also deletes the records for any chat 
members and messages.

Procedure

1. In the application navigator filter, enter chat_room.list.

2. Delete multiple chat rooms from the list or open a chat room record and click Delete.

Legacy chat administration

Users with the chat_admin role can administer various aspects of legacy chat.

Define chat room access rights

Control the access rights for creating a chat room so that not all users can create a chat room.

Before you begin
Role required: chat_admin

About this task
To define the access rights for creating chat rooms:

Procedure

1. Navigate to All  > Social IT  > Chat Administration  > Properties.

2. Locate the property Comma-separated list of roles that are allowed to create chat rooms.

3. Enter user roles.
A user must have one of the specified roles to create a chat room.

Change chat room message read access

In legacy chat, you can associate a chat room with a record, such as an incident, and add the 
chat messages to a Chat Activity  journal field on the form.

Before you begin
Role required: chat_admin

About this task
By default, a user can read the chat messages for a room if either of the following is true:

• The room is public

• The user is a member of the room
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To change chat room message read access:

Procedure

Modify the Chat message access control rule or create a new rule.

Read access to the messages displayed is handled by the access control list security operation 
chat_messages_read  on the Chat room [chat_room] table.

View a legacy chat message as a journal field

You can view all chat messages in one place by viewing them as a journal field.

Before you begin
Role required: agent

About this task
Chat rooms can be linked to any task record in the following ways:

• Create a room from the record.

• Create a record from a chat room, such as creating an incident from a Help Desk Chat.

To view the chat messages as a journal field:

Procedure

Configure the task record form to select the Chat Activity  field.
The maximum number of chat messages that are displayed by this field is 1000.

Example:

Chat Activity

Chat actions

Chat actions are additional items that appear in the chat window menu (requires the Chat 
plugin). Administrators and users with the chat_admin role can define chat actions.
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Chat actions

Add actions to the legacy chat window menu

You can create new actions and add them to the chat window menu.

Before you begin
Role required: chat_admin

Procedure

1. Navigate to Social IT > Chat Administration > Actions.

2. Select an action to edit or click New.

3. Enter the chat action details and click Update  or Submit.

Example:
The following example demonstrates how to add a chat action that appears only on windows 
where the user is a Help Desk Agent. The action appears on the menu as Show User Type  and 
opens a popup window that indicates a current user of queue_agent.

• Action Name: Show User Type

• Active: Select the check box.

• Order: 100

• Client Show Condition:

answer = g_chat.getChatType() == 'queue_agent';

• OnClick Action Script:

alert('The current user is: ' + g_chat.getChatType());
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Chat action details

You can define a chat action name and the script that runs when the action is selected.

Chat action details

Field Description

Action 
Name

Enter a label for the action as it appears in the menu.

Active Select the check box to activate or clear the check box to deactivate the action. 
Only active actions may appear in the menu.

Order Enter the order in which the action appears in the menu. Standard menu items 
(such as Show Timestamps) always appear at the top of the chat menu, followed 
by chat actions in order.
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Field Description

Client 
Show 
Condition

Define the conditions under which this menu option appears. The show condition 
must set the pre-defined answer  variable to a boolean value.

OnClick 
Action 
Script

Enter the JavaScript code that runs when the menu item is selected.

Available methods associated with the g_chat variable

The g_chat variable is a legacy chat window object that is available in the Client Show Condition 
and OnClick Action Script  of a chat action definition.

Method Summary

The following table defines the available methods associated with this object.

Return 
Object

Details

Array getActiveUsers()

Returns the active users.

Returns:

Array - Returns the active users.

String getChannelJID()

Returns the channel JID, which is a sys_id  for a record chat_channel table.

Returns:

String - Returns the channel JID.

String getChatType()

Determines the chat window type.

Returns:

String - Returns one of the following values that specifies the type of user:

• queue_agent: Help Desk Chat support agent

• queue_user: Help Desk Chat end user

• group_chat: The individual is a member of a chat room (multiple users)

• conversation: The individual is a member in a private chat with another user

String getChatQueueAgent()

Returns the sys_id  for agent that is administering this thread.

Returns:

String - Returns the sys_id  of the chat queue agent.
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Return 
Object

Details

String getChatQueueUser()

Returns the sys_id  for end user of the chat queue.

Returns:

String - Returns the sys_id  of the chat queue user.

String getThreadID()

Returns the thread ID. This returns the same value as 
g_chat.getChannelJID().getID().

Returns:

String - Returns the thread ID.

Legacy: Help desk chat

Communicate with service desk staff using instant messaging.

Note: 
The Connect Support  feature provides an updated messaging platform similar to help desk 
chat. The help desk chat and Connect Support features should not be used concurrently. 
There is no migration path from help desk chat to Connect Support.

Users can communicate directly with service desk staff using instant messaging in a ServiceNow 
instance (requires the Chat plugin.)

• Users access live support from the Employee Self-Service portal.

• Service desk staff provide support from the chat desktop.

Legacy: Use help desk chat to get support

You can contact service desk staff.

Before you begin
Role required: agent

Procedure

1. Open the Employee Self-Service Portal (https://<instance web address>/ess).

2. Log in to your ServiceNow account.
Only logged in users can use chat.

3. In the upper right, click the Service Desk Chat  button.
A chat window opens.

4. Enter your question in the text field at the bottom of the window and press Enter.

a. A message confirms that you have entered the chat queue and indicates your position and 
estimated wait time.

b. When a service desk staff member accepts your chat and begins working on your question, 
another message appears.
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5. Chat with your service desk agent via instant messaging.

service desk staff may lead you through troubleshooting, ask clarifying questions, or create an 
incident record to address your question.

Result
Note: 
Administrators can configure Service Desk Chat to be accessible on content management 
(CMS) pages.

Service Desk Chat Window

Legacy: Use help desk chat to provide support

Staff who are assigned to chat support can provide live support via instant messaging. 
Administrators and users with the chat_admin role can assign chat support staff (see Set Up 
Chat Queues for Help Desk Chat).

Before you begin
Role required: agent

Procedure

1. Navigate to All  > Social IT  > Chat  to open your chat desktop.

◦ A chat queue agent window appears on your chat desktop for each chat queue you are 
assigned to. If no agent windows appear, ask an administrator to add you as a member of the 
Assignment group  for a chat queue.

◦ The chat queue agent window displays the number of users in the queue and how long they 
have been waiting.

◦ Every member of the assignment group sees the associated chat queue agent window.

2. Click Answer Next User  to answer the next user or click Answer  beside a specific user in the 
queue.
A chat window opens. Only the agent and the user can see the chat window.

Result
Provide support via instant messaging. Chat queue agents can access additional support 
functions in the chat window menu:
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• Invite User:  invite another expert to assist with a support chat. An invitation appears in the 
favorites list of an invited user.

• Create Incident from Chat:  create a new incident record with the initial question as the short 
description and the support chat as a linked chat room (accessible from the Create or Join 
Chat Room  related link on the Incident form).

Note: 
Administrators can edit this action or add additional actions to the chat window menu.

Chat Queue Agent

Legacy: Set up chat queues for help desk chat

Help desk chat allows users to communicate directly with Service Desk staff via instant 
messaging in an instance.

Chat queues define the schedules, staff, and system messages for help desk chat. 
Administrators and users with the chat_admin role can set up chat queues.

Define a chat queue for legacy chat

How to define a chat queue for legacy chat.

Before you begin
Role required: admin

About this task
Note: 
The Chat Queue [chat_queue] table is also used by Connect Support. Legacy chat and 
Connect Support should not be used concurrently.

Procedure

1. Navigate to All  > Social IT  > Chat Administration  > Queues.

2. Select a chat queue to edit or click New.

3. Enter the chat queue details and click Update  or Submit.
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Chat queue details

Field Description

Name Enter the name that end users see as a title for the queue.

Active Select the check box to activate or clear the check box to deactivate the chat 
queue.

Assignment 
group

Select the group that contains the support staff for the chat queue. Every agent 
sees the chat queue on their chat desktop and can answer any user that is 
waiting in the queue. To assign staff members to the group, see Assign Service 
Desk Staff to a Chat Queue.

Schedule Select a schedule that defines when a queue is available (see Creating and 
using schedules ). If the queue is always available, clear the field.

Question Enter the initial question that end users see when they open a new Help Desk 
Chat. For example, How can I help you?

Confirm 
problem

(Optional) Enter the confirmation message that end users see when they 
enter an initial question. For example, Thank you for contacting support. Your 
problem has been submitted and an agent will be with you shortly.

Initial agent 
response

(Optional) Enter the message that end users see when an agent accepts their 
chat. For example, Thank you for waiting. I am looking into your question now 
and will be with you shortly.

Not 
available

Enter the message that end users see when a Help Desk Chat request is not 
accepted because the queue is outside its scheduled availability (defined by 
the Schedule field).

Assign service desk staff to a chat queue

Chat queue agents are Service Desk staff that are members of a chat queue's assignment group.

Before you begin
Role required: chat_admin

About this task
To assign agents to a chat queue:

Procedure

1. Navigate to All  > User Administration  > Groups.

2. Select an existing assignment group or click New.

3. Enter or modify the group details (see Create a Group  ).

4. Right-click the header and select Save.

5. In the Group members  related list, click Edit.

6. Using the slushbucket , add support staff to the group.

7. Navigate to Social IT  > Chat Administration  > Queues.

8. Select the chat queue for which the group provides support.
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9. In the Assignment Group  field, select the group.

Chat queue group

Make help desk chat accessible to an end user

Users access live support from the Employee Self-Service Portal (ESS Portal).

Before you begin
Role required: admin

About this task
Users access live support from the Employee Self-Service Portal (ESS Portal). To make a Help 
Desk Chat queue accessible to end users, add a link to the ESS Portal (requires the Content 
Management Plugin).

To change the default link in the ESS header:

Procedure

1. Navigate to All  > Content Management  > Headers.

2. Open Portal - Header.

3. In the Chat queue  field, enter the chat queue that users access by clicking the link in the ESS 
header.

4. Clear the field to remove the chat queue link.
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5. Click Update.

Chat queue link

Add a custom link elsewhere on the ESS portal

How to add a custom help desk chat link on the ESS portal.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Content Management  > Static HTML.

2. Click New.

3. Enter a Name.

4. In the Static content  field, click Toggle HTML Source  to edit the field in HTML source mode.

HTML editor button

5. Create a link to the desired Help Desk Chat queue (see Link Syntax).

6. Click Submit.

7. Add the new content block to the desired location on the portal (see Add content to a page ).

Link syntax

To open a Help Desk Chat queue from a custom link on the ESS Portal, you must call the 
CustomEvent.fire method using appropriate arguments.

To open a Help Desk Chat queue from a custom link on the ESS Portal, you must call the 
CustomEvent.fire method using appropriate arguments. Details of the API call and an example 
that generates an anchor link are provided below.

API Call:

CustomEvent.fire(LiveEvents.LIVE_EVENT, 
 LiveEvents.LIVE_WINDOW_JOIN_QUEUE_QUERY, CHAT_QUEUE_SYS_ID, 
 CHAT_QUEUE_SYS_NAME);

where the variables are:
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• CHAT_QUEUE_SYS_ID: Specifies the sys_id for the chat queue.

• CHAT_QUEUE_SYS_NAME: Specifies the name of the chat queue (must match the value the 
Name field of the chat queue record).

Example: This example creates an anchor link that opens the Help Desk Chat queue.

<a href=" " onclick="CustomEvent.fire(LiveEvents.LIVE_EVENT,
                                     
 LiveEvents.LIVE_WINDOW_JOIN_QUEUE_QUERY,
                                     
 'c54f0abf0a0a0b452db84664f409c79c',
                                      'Help Desk Chat'); return 
 false;">
  Help Desk Chat
</a>

Monitor chat queues

Chat queues can yield useful Key Performance Indicators (KPI) for evaluating support 
effectiveness.

• Queue Wait Time: amount of time a user waits in the queue before a help desk agent accepts 
the request.

• Percentage of Chats Abandoned: users that exit the queue before an agent responds (user 
stopped waiting).

• Percentage of Chats Accepted: requests that are answered by an agent.

Note: 
This information is not calculated automatically. Administrators may calculate these values 
based on data collected by chat queues.

Monitor help desk chat tasks

Help Desk Chat requests are tracked in the Chat queue entries table, which appears as a related 
list on the associated chat queue record.

Help Desk Chat requests are tracked in the Chat queue entries table, which appears as a 
related list on the associated chat queue record. Because this table extends the Task table, 
administrators can take advantage of core task functionality. For example, administrators can 
attach Service Level Agreements (SLAs) to chat queue entries to evaluate the response time of 
Help Desk Chat support.

Legacy Notify
Legacy Notify enables organizations with a Twilio account to send notifications using text and 
voice messages.

Note: 
This content applies only to the Legacy Notify application, available prior to the Geneva 
release. For information about the Notify application available starting with Geneva, see 
Notify.

Legacy Notify also allows conference calls between ServiceNow  users to enable quick 
communications.
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When Legacy Notify is active, you can configure ServiceNow  to automatically generate and send 
notifications to selected contacts, for instance when a new incident communication plan is 
raised in the incident communications management process.

Users with the notifynow_admin role can set properties and monitor message and conference 
call activities.

Legacy Notify has been implemented for use within Incident Communications Management. 
Refer to the Notify API documentation for details on how to implement Legacy Notify for use 
within other ServiceNow  applications.

Working with Legacy Notify

Follow this process to enable and use Notify.

Before you begin
Role required: notifynow_admin

About this task
This content applies only to the Legacy Notify application, available prior to the Geneva release. 
For information about the Notify application available starting with Geneva, see Notify.

Procedure

1. Set up a Twilio account to provide phone connectivity for Notify.

2. Activate Notify.

3. Configure Notify to use Twilio.

4. Begin using Notify immediately within Incident Communications Management.

5. Use the Notify API with other ServiceNow  applications to provide SMS, voicemail, email, and 
conference calls for those applications.

View a Legacy Notify question

Questions contain a response action and a set of response choices. Use these questions to 
simplify communications. Then, you can monitor the resulting communication thread.

Before you begin
Role required: notifynow_admin

About this task
This content applies only to the Legacy Notify application, available prior to the Geneva release. 
For information about the Notify application available starting with Geneva, see Notify.

For example, the process can be used to ask members of a specific on-call group to 
acknowledge or reject an incident. Depending on the answer from the first team member, the 
incident is assigned to that person or an SMS question is sent to the next on-call member. In this 
example, the questions are used as part of a workflow.

To see a list of predefined questions both Notify and On-Call Scheduling need to be active.

Procedure

1. Navigate to All  > Notify  > Questions.

2. Click the question On-Call responsibility Accept/Reject  to see the question details.
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Notify Question

3. Click the Notify Response Choices  related list to view or edit the choices.
The person who receives the SMS question can either choose to accept or reject the 
assignment. If the assignment is accepted, the Response action  can be that the incident 
is actually assigned to that person. The response action is a script that you can modify or 
replace. If the assignment is rejected, an SMS question may be sent to the next person in the 
escalation chain, and so on. You can combine questions with a workflow to automate a process 
like on-call scheduling escalation.

Create a question in Legacy Notify

Define a question that can be sent to users.

Before you begin
Role required: notifynow_admin

About this task
This content applies only to the Legacy Notify application, available prior to the Geneva release. 
For information about the Notify application available starting with Geneva, see Notify.

Procedure

1. Navigate to All  > Notify  > Questions.

2. Click New.

3. Fill in the fields, as appropriate.

Notify New Question form

Field Description

Name Enter a description of the question.

Question Enter the question you want to send. You can enter variables in the question 
with the { }  tags, for example, {0}. When using more than one variable, use 
consecutive numbering. When using multiple variables, reference them by 
specifying their position in the parameter list, starting from {0}. The variable is 
picked up by the script and translated into, for example, an incident or a problem 
number.

Params Enter parameters which map to the fields on the record that the workflow 
was triggered for. This enables the message to show dynamic data. Multiple 
parameters should be separated by a comma. For example, number, shows the 
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Field Description

incident number in case the workflow was triggered from an incident. A second 
parameter could be, for example short_description.

Response 
Action

Select the action that must be taken. This is a script that can be modified, or you 
can create a new script by clicking the search button and selecting New. Several 
examples of scripts are shown. Write your own script and click Submit.

4. Click Submit.

Create a new response choice in Legacy Notify

Create a new response choice to allow users to select that response for a Notify question.

Before you begin
Role required: notifynow_admin

About this task
This content applies only to the Legacy Notify application, available prior to the Geneva release. 
For information about the Notify application available starting with Geneva, see Notify.

Procedure

1. Navigate to All  > Notify  > Questions.

2. Open the notify question you have just created.

3. Click New to create a new notify response choice.

4. Fill in the fields, as appropriate.

Notify New Response Choice form

Field Description

Code The abbreviation for the response choice in the text message. For example, ACC  for 
accept or REJ  for reject.

Text The text displayed for this response choice.

Order A number indicating the order in the list of response choices. Choices with lower 
order numbers are listed before choices with higher order numbers.

5. Click Submit.

View Legacy Notify messages

Applications implementing Notify, such as Incident Communications Management, can send 
Short Message Service (SMS) text messages to relevant contacts under predefined conditions, 
such as when a new incident communication plan has been created.

Before you begin
Role required: notifynow_admin

About this task
This content applies only to the Legacy Notify application, available prior to the Geneva release. 
For information about the Notify application available starting with Geneva, see Notify.
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Procedure

1. Navigate to All  > Notify  > Messages.

2. Click a message to see the message details.

SMS Outbox Details

View Legacy Notify conversations

The Notify Conversation [notifynow_conversation] table tracks bi-directional communications 
and adds the ability to have more than one active conversation with the same phone number at 
the same time.

Before you begin
Role required: notifynow_admin

About this task
This content applies only to the Legacy Notify application, available prior to the Geneva release. 
For information about the Notify application available starting with Geneva, see Notify.

The thread number is combined with the phone number to link the SMS or email response to the 
correct conversation. Conversations remain active until a response is received or until they are 
automatically deactivated after the thread release time runs out. The default thread release time 
is 10 days. To change this value, add the nn.thread.release.age  property.

Procedure

1. Navigate to All  > Notify  > Conversations.

2. Click a conversation record to see the conversation details.

Notify Conversation Details

The State of the conversation can have one of the following values:

Notify Conversation State Descriptions

Value Description

Ended The conversation has been completed.

Failed The conversation has failed.
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Value Description

Pending The SMS or email is waiting to be sent.

Sent The SMS or email has been sent.

Unanswered The SMS or email has not been answered.

Note: 
The mode of conversation cannot be changed during one conversation thread. For 
example, you cannot switch between SMS and email during one conversation.

View Legacy Notify conference calls

Applications that use Notify, such as Incident Communications Management, can launch and 
maintain conference calls between involved parties.

Before you begin
Role required: notifynow_admin

About this task
This content applies only to the Legacy Notify application, available prior to the Geneva release. 
For information about the Notify application available starting with Geneva, see Notify.

Procedure

1. Navigate to All  > Notify  > Conference Calls.
You can also access conference call information from the relevant record, such as the 
Conference Calls  related list in an incident communication plan record.

2. Click a conference call in the list to view details.

Notify Conference Call Details

3. Click the arrow beside the check box to expand a Participant  entry.
This shows participant session information, including details of the conference calls that the 
participant has been involved in.
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4. Click a Participant  name to see more detailed information about that participant.

Notify Conference Call Participant Details

Related topics

Manage Legacy Notify conference call participants

Legacy public conference calls

A Notify conference call can be public.

Note: 
This content applies only to the Legacy Notify application, available prior to the Geneva 
release. For information about the Notify application available starting with Geneva, see 
Notify.

The Private  field on the conference call record indicates if a call is private (selected) or public 
(not selected). By default, all calls created automatically, such as those created through Incident 
Communications Management, are public. You can create private calls using the Notify API 
initiateConferenceCall method.

When created, public conference calls generate an associated Code  which is sent via SMS 
to all invited participants. These participants can distribute the code to allow other users to 
join the public call. An administrator can control the format of the code using the property 
glide.notifynow.conference_call.code.pattern. Anyone with the code can connect to a public 
conference call using one of these methods:

• By calling the Twilio phone number and entering the code for that conference call.

• By sending the code in an SMS message to the Twilio phone number. Participants that join a 
public call this way are considered ad-hoc participants, indicated on the participant record.

Administering Legacy Notify

An administrator can set up Notify, manage Notify properties and conference call participants.

Note: 
This content applies only to the Legacy Notify application, available prior to the Geneva 
release. For information about the Notify application available starting with Geneva, see 
Notify.

Configuring legacy Notify to use the Twilio service

Each ServiceNow  instance using Notify requires a valid Twilio account and telephone number. 
Refer to the Twilio documentation for detailed instructions.
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Note: 
This content applies only to the Legacy Notify application, available prior to the Geneva 
release. For information about the Notify application available starting with Geneva, see 
Notify.

After the Twilio account is set up, perform the following to use that account with Notify:

• Associate the account with Notify

• Configure Twilio with ServiceNow endpoints

Associate a Twilio account with Legacy Notify

Associate a Twilio account with your instance to use that account for legacy Notify.

Before you begin
Role required: notifynow_admin

About this task
This content applies only to the Legacy Notify application, available prior to the Geneva release. 
For information about the Notify application available starting with Geneva, see Notify.

Procedure

1. Navigate to All  > Notify  > Administration  > Properties.

Notify Properties

2. Enter the AccountSID, AuthToken  and phone number  values.
These values can be obtained from the Twilio dashboard:
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Twilio Dashboard

When the Twilio account details are entered in the Notify Properties page, the account status is 
updated.

3. Optional:  To use Notify on multiple ServiceNow  instances, activate Notify on each instance 
and create a separate Twilio account and telephone number for each instance.

Note: 
Some telephone numbers are voice capable, but not SMS capable. This is shown in 
the Notify properties with relevant messages. Two methods are available to check this: 
isSMSCapable  and isVoiceCapable.

Configuring the Twilio service with endpoints in legacy Notify

In order for the Twilio service to receive Notify commands, the Request URL  field value for every 
Twilio telephone number must point to the ServiceNow  instance that uses Notify with that Twilio 
telephone number.

Note: 
This content applies only to the Legacy Notify application, available prior to the Geneva 
release. For information about the Notify application available starting with Geneva, see 
Notify.

To set these values, do one of the following:

• Define them manually in the Twilio service dashboard.

• Ensure the fields are blank in the Twilio service dashboard, then open the Notify Properties 
page. Notify automatically configures the correct endpoints if the Request URL  fields are blank.

Set these values from within the Twilio service dashboard.
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Twilio Numbers Dashboard

The notifyusa  values underlined in the image should be replaced with your ServiceNow 
instance name, for:

• Voice Request URL: https://notifyusa.service-now.com/
NotifyNowCallProcessor.do

• Status Callback URL: https://notifyusa.service-now.com/
NotifyNowCallStatusProcessor.do

• Messaging Request URL: https://notifyusa.service-now.com/
NotifyNowSmsProcessor.do

View and edit legacy Notify properties

You can view and edit Notify properties.

Before you begin
Role required: notifynow_admin

About this task
This content applies only to the Legacy Notify application, available prior to the Geneva release. 
For information about the Notify application available starting with Geneva, see Notify.
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Procedure

1. Navigate to All  > Notify  > Administration  > Properties.

Notify Properties form

2. Fill in the fields.

Notify Properties form

Field Description

Account Status Information showing the status of the associated Twilio account.

Twilio AccountSID The Twilio account AccountSID, acting as the user name for that 
account.

Twilio AuthToken The Twilio account AuthToken, acting as the password for that account. 
See Associating a Twilio Account.

Twilio SMS and 
voice enabled 
phone number

The Twilio number that Notify will use. Telephone numbers must be 
entered in the E.164 format and need to exist under the Twilio account. 
See Associating a Twilio Account.

Number of 
frequent 
conference call 
participants to be 
displayed

The number of people to display in the frequently called list.
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Field Description

Voice The voice used for Notify communications. Select woman  or man  to 
provide female or male voice support for English, Spanish, French, 
German, and Italian. Select alice  to provide female voice support for a 
wider range of languages.

3. Click Submit.

Legacy Notify account status messages

Account status messages are visible on the Notify Properties page.

Account Status Message Descriptions

Message Description

Your account is ready for use Notify is correctly configured and ready for use.

Your Twilio AccountSID or AuthToken 
are not valid

An incorrect value has been entered in the AccountSID 
or AuthToken fields in the Notify properties.

Your Twilio phone number is not valid Incorrect telephone number information is defined in 
the Notify properties.

Your Twilio phone number does not 
have properly configured endpoints

The Request URL endpoint settings have not been 
properly configured.

Your Twilio account is not configured 
properly

One or more of your Twilio account settings is incorrect. 
Open the Twilio dashboard and check the settings.

Manage Legacy Notify conference call participants

As a Notify administrator, you can mute, unmute, and kick participants on a conference call.

Before you begin
Role required: notifynow_admin

About this task
This content applies only to the Legacy Notify application, available prior to the Geneva release. 
For information about the Notify application available starting with Geneva, see Notify.

Muting a participant prevents that person from speaking on the conference call but does not 
notify any participants, including the muted participant. Kicking a participant removes that 
person from the conference call and sets the Response  field for the participant session to 
kicked.

Procedure

1. Navigate to All  > Notify  > Conference Calls.

2. Select an active conference call.

3. In the Notify Conference Call Participants  related list, select a participant.

4. Click the button for the action you want to perform, such as Mute  to mute the participant.

You can perform these actions for multiple participants as a single operation using the Actions 
on selected rows  choice list on the Notify Conference Call Participants  related list.
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Related topics

View Legacy Notify conference calls

Installed with Legacy Notify

Activating the Notify plugin adds or modifies tables, user roles, script includes, and other 
components.

Note: 
This content applies only to the Legacy Notify application, available prior to the Geneva 
release. For information about the Notify application available starting with Geneva, see 
Notify.

Tables

Notify adds or modifies the following tables.

Tables

Display Name [Table Name] Description

Answer [notifynow_answer] Information for possible answers to the SMS 
question sent.

Conversation 
[notifynow_conversation]

Information for the conversation thread.

NotifyNow Conference Call 
[notifynow_conference_call]

Information for conference call records.

NotifyNow Participant Session 
[notifynow_participant_session]

Information regarding conference call sessions 
for individual conference call participants.

Participant [notifynow_participant] Information regarding individual conference call 
participants.

Question [notifynow_question] Information for the possible questions in the 
SMS.

Response_action 
[notifynow_response_action]

Information for the notify response action 
associated with the question.

Response_choice 
[notifynow_response_choice]

Information for the notify response choice 
associated with the question.

SMS Messages [notifynow_message] Information for the actual SMS messages sent.

Properties

Notify adds the following system properties.

Properties

Property Description

glide.notifynow.frequent_participant_count The number of frequent conference call 
participants to be displayed.

glide.notifynow.voice The voice used for Notify 
communications.
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Properties  (continued)

Property Description

glide.notifynow.twilio.accountsid The Twilio account AccountSID.

glide.notifynow.twilio.token The Twilio account AuthToken.

glide.notifynow.twilio.phonenumber The Twilio number that Notify will use.

glide.notifynow.twilio.answering_machine_detection A boolean flag to enable or disable 
answering machine detection. Set to true 
to use answering machine detection. Set 
to false to continue the call.

nn.thread.release.age The number of days after which the 
conversation thread release time runs 
out. Defaults to 10 days.

glide.notifynow.conference_call.code.pattern The pattern used to generate a 
conference call code for public 
conference calls. Number signs ( ) in 
the pattern are replaced with random 
numbers when a code is generated.

glide.notifynow.fix_invalid_phone_number A boolean flag to enable or disable 
automatic correction of invalid phone 
numbers. Twilio might incorrectly prefix 
non-US phone numbers with 1. When 
this property is true, the instance 
automatically removes the 1 for non-US 
calls. When this property is false, you 
might be incorrectly identified when 
reconnecting to a callusing SMS.

User Roles

Notify adds the following user roles.

User Roles

Role Contains Roles Description

notifynow_admin None Administrator with privileges for Notify functionality.

UI Actions

Notify adds the following UI actions.

UI Actions

UI Action Table Description

Initiate 
Conference 
Call

Incident Communication Plan 
[incident_alert]

Adds a link to the Incident 
Communication Plan form, if that plugin 
is activated, which displays a dialog 
box for starting a conference call with 
selected participants.
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UI Actions  (continued)

UI Action Table Description

Invite to 
Conference 
Call

NotifyNow Conference Call 
[notifynow_conference_call]

Adds a link to the Notify Conference 
Call form which displays a dialog box 
for adding more users to an active 
conference call.

Script Includes

Notify adds the following script includes.

Script Includes

Name Description

IncidentAlertConferenceCall A utility JavaScript Prototype class allowing users to initiate 
the conference call and add other users to the conference call. 
Should be used in conjunction with the slushbucket UI page 
(notifynow_participant).

Business Rules

Notify adds the following business rules.

Business Rules

Business Rule 
Name

Table Description

SMS on new 
Incident 
Communication 
Plan

Incident Communication Plan 
[incident_alert]

Sends an SMS to any default 
contacts added when an incident 
communication plan record is 
created.

Conference 
Call Allowed

Incident Communication Plan 
[incident_alert]

Displays or hides the initiate 
conference call  UI action by storing 
true  or false  in

g_scratchpad.conference
CallAllowed

.

Update 
Conference 
Call Started IA 
Activity

NotifyNow Conference Call 
[notifynow_conference_call]

Logs when a conference call 
started by writing to an incident 
communication plan's comment 
field if the source record is from the 
incident_alert table.

Update 
Conference 
Call Finished IA 
Activity

NotifyNow Conference Call 
[notifynow_conference_call]

Logs when a conference call ended 
and what actions the conference 
call participants took by writing to 
an incident communication plan's 
comment field if the source record is 
from the incident_alert table.
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Workflow Activities

Notify adds the following workflow activities.

Workflow Activities

Activity 
Name

Activity 
Category

Description

Send 
Notify 
SMS

Notify Sends an SMS message (maximum 1600 Characters) to an E.164 
compliant mobile phone number of the selected recipients and/or groups.

Send 
Notify 
SMS 
Question

Notify Sends predefined SMS Question message (maximum 1600 Characters) to 
an E.164 compliant mobile phone number of the selected recipients and/
or groups. This is one of two main activities for workflow On-Call Assign 
by Acknowledgement. In a predefined message, the recipient is asked 
to assign himself to a newly created incident. The same message also 
contains predefined answers.

Send 
Email 
Question

Notify Sends email generated from email template containing notification 
that recipient is the current On-call resource for a newly created task. 
This is one of two main activities for the workflow On-Call Assign by 
Acknowledgement. In a predefined message, the recipient is asked to 
assign himself to a newly created incident. The email contains two links 
that enable the user to accept or reject assignment.

NotifyNow (Legacy) - Global

The legacy NotifyNow  API provides functionality for sending emails, sending SMS messages, 
and setting up conference calls.

Use this when you want to use Notify functionality with applications on your system.

Note: 
This API is included with the legacy Notify functionality. For APIs included in the current 
Notify feature, see the Notify, NotifyAction, NotifyPhoneNumber, and 
NotifyClient  APIs.

NotifyNow - getReadyState()

Indicates whether Notify is set up correctly or not.

This method can only be accessed by administrators or users with the notifynow_admin role. 
Users with all other roles get the message False when trying to run the function in a script.

Parameters

Name Type Description

None

Returns

Type Description

Boolean True if Notify is set up correctly, otherwise false.
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var nn = new SNC.NotifyNow();
gs.log(((nn.getReadyState()) ? "OK" :  "NOT OK"));

NotifyNow - getStatus()

Returns the current status of Notify configuration.

This method can only be accessed by administrators or users with the notifynow_admin role. 
Users with all other roles get the message Unauthorized when trying to run the function in a 
script.

Parameters

Name Type Description

None

Returns

Type Description

String One of the possible status messages.

Status Description

NO_NUMBER_MESSAGE The account does not have a telephone number set up. Ensure that you set up the telephone number for the account.

NO_ENDPOINTS_MESSAGE The account does not have its endpoints set up correctly. Ensure that you set up the endpoints for the account.

ACCOUNT_OK_MESSAGE The account is active and ready for use.

ACCOUNT_NO_AUTH The Twilio AuthToken is not valid.

ACCOUNT_NOT_CONFIGURED The Twilio AccountSID or AuthToken is not valid.

var nn = new SNC.NotifyNow();
gs.log(nn.getStatus());

NotifyNow - initiateConferenceCall(String[] conferenceCallParticipants, String 
conferenceCallTitle)

Initiate a new conference call.

Parameters

Name Type Description

conferenceCallParticipants String One or more users, conference call participants, identified 
by the sys_ids from the sys_user table or E.164-compliant 
phone numbers.

conferenceCallTitle String Title of the conference call. This parameter has a maximum 
length of 40 characters.
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Returns

Type Description

GlideRecord The conference call record, or null if there was an error.

This initiates a conference call with E.164-compliant phone numbers for participants, without the 
optional source record parameter and and does not send any conference call details via SMS or 
email.

var participants = ['+31205655548', '+31205655552', 
 '+31652825393'];
// set up conference call
var nn = new SNC.NotifyNow();
var conferenceCall = nn.initiateConferenceCall(participants, 
 "testing12");
gs.log('started conference call: ' + 
 conferenceCall.getUniqueValue());

NotifyNow - initiateConferenceCall(String[] conferenceCallParticipants, String 
conferenceCallTitle, GlideRecord sourceRecord, Boolean private)

Initiate a new conference call.

Parameters

Name Type Description

conferenceCallParticipants String One or more users, conference call participants, 
identified by the sys_ids from the sys_user table or 
E.164-compliant phone numbers.

conferenceCallTitle String Title of the conference call. This parameter has a 
maximum length of 40 characters.

sourceRecord GlideRecord Source record to associate to the conference call 
such as an incident or problem number.

private Boolean Value to control if a conference call is private. This 
value defaults to false.

Returns

Type Description

GlideRecord The conference call record, or null if there was an error.

This initiates a conference call with participants that have a E.164-compliant phone number and 
participants from the sys_user table and sends conference call details via SMS and email to all 
participants.

// define phone number participants
var participants = ['+31205655548', '+31205655552', 
 '+31652825393'];
 
// we also want to add two Dutch sys_user participants
var user = new GlideRecord('sys_user');
user.addNotNullQuery('mobile_phone');
user.addQuery('mobile_phone', 'STARTSWITH', '+316');
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user.setLimit(2);
user.query();
 
// add users to the participant array
while (user.hasNext() && user.next()) {
 gs.log('adding user ' + user.getValue('name') + ' with phone 
 number ' +
             user.getValue('mobile_phone') + ' to the 
 participant array');
 participants.push(user.getUniqueValue());
}
 
// define a source record to associate with the conference call
var source = new GlideRecord("cmdb_ci");
source.query("asset_tag", "P1000167");
if (source.hasNext() && source.next()) {
 // set up conference call
 var nn = new SNC.NotifyNow();
 var conferenceCall = nn.initiateConferenceCall(participants, 
 "testing 1 2", source);
 
 // check if the conference call was successfully created
 if (conferenceCall != null) {
  gs.log('started conference call: ' + 
 conferenceCall.getUniqueValue());
 } else {
  gs.log('could not start the conference call :(');
 }
}

NotifyNow - isCallable(String participant)

Determines whether a user is callable or not.

A user must have a valid phone number to be callable. A user who is already in an active session 
is not callable.

Parameters

Name Type Description

participant String or 
GlideRecord

A sys_user or notifynow_participant record, or an E.164-
compliant phone number.

Returns

Type Description

boolean Whether this participant can be called or not.

var nn = new SNC.NotifyNow();
gs.log('by number: ' + nn.isCallable('+31612345678'));
 
var user = GlideRecord('sys_user');
user.query('sys_id', '13d39544eb5201003cf587b9d106fea9');
if (user.hasNext() && user.next())
  gs.log('by user: ' + nn.isCallable(user));
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var participant = GlideRecord('notifynow_participant');
participant.query('sys_id', '33b11430eb1201003cf587b9d106feb9');
if (participant.hasNext() && participant.next())
  gs.log('by participant: ' + nn.isCallable(participant));

NotifyNow - isSMSCapable()

Checks if the telephone number associated with the Twilio account is capable of sending SMS 
messages.

Parameters

Name Type Description

None

Returns

Type Description

Boolean Whether the telephone number associated with the Twilio account is capable of 
sending SMS messages.

gs.log('The twilio number is SMS capable: ' + ((new 
 SNC.NotifyNow().isSMSCapable()) ? 'yes' : 'no'));

NotifyNow - isSMSCapable(String userID)

Checks if a user is able to send SMS messages.

Parameters

Name Type Description

userID String The sys_id of the user you want to check for an SMS-capable phone number.

Returns

Type Description

Boolean If the user can send SMS messages.

gs.log('the user is able to send SMS messages (e.g. has a 
 SMS device): ' + ((new SNC.NotifyNow().isSMSCapable('<user 
 sys_id>')) ?
     'yes' : 'no'));

NotifyNow - isVoiceCapable()

Checks if the telephone number associated with the Twilio account is capable of setting up 
phone calls.
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Parameters

Name Type Description

None

Returns

Type Description

Boolean Whether the telephone number associated with the Twilio account is capable of 
setting up phone calls.

gs.log('the Twilio number is Voice capable: ' + ((new 
 SNC.NotifyNow().isVoiceCapable()) ? 'yes' : 'no'));

NotifyNow - isVoiceCapable(String userID)

Checks if a user is able to make voice calls.

Parameters

Name Type Description

userID String The sys_id of the user you want to check for a voice-call capable phone 
number.

Returns

Type Description

boolean Whether the user has a voice-call capable phone number.

gs.log('the user is able to send SMS messages (e.g. has a SMS 
 device): ' +
     ((new SNC.NotifyNow().isVoiceCapable('someuserid')) ? 
 'yes' : 'no'));

NotifyNow - kick(GlideRecord participant)

Removes a participant from a conference call.

Parameters

Name Type Description

participant GlideRecord The conference call participant to remove from the call.

Returns

Type Description

Boolean True if the participant was removed, otherwise false.

var participantId = "<participant sys_id>";
var participant = new GlideRecord('notifynow_participant');
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participant.get(participantId);
if (participant.isValid()) {
     // kick participant
     result = new SNC.NotifyNow().kick(participant);
     gs.log('participant kicked: ' + result);
}

NotifyNow - mute(GlideRecord participant)

Mutes a participant on a conference call.

Parameters

Name Type Description

participant GlideRecord The conference call participant to mute.

Returns

Type Description

Boolean True if the participant was muted, otherwise false.

var participantId = "<participant sys_id>";
var participant = new GlideRecord('notifynow_participant');
participant.get(participantId);
if (participant.isValid()) {
     // mute participant
     result = new SNC.NotifyNow().mute(participant);
     gs.log('participant muted: ' + result);
}

NotifyNow - umute(GlideRecord participant)

Unmutes a participant on a conference call.

Parameters

Name Type Description

participant GlideRecord The muted conference call participant to unmute.

Returns

Type Description

Boolean True if the participant was unmuted, otherwise false.

var participantId = "<participant sys_id>";
var participant = new GlideRecord('notifynow_participant');
participant.get(participantId);
if (participant.isValid()) {
     // unmute participant
     result = new SNC.NotifyNow().unmute(participant);
     gs.log('participant unmuted: ' + result);
}
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NotifyNow - sendEmailQuestion(String emailAddress, String question, GlideRecord 
sourceRecord, String emailSubject)

Send an email question to an email address.

The sendEmailQuestion method produces a question body and requires users to click a link to 
indicate their choice.

Parameters

Name Type Description

emailAddress String Email address to send the question to.

question String or 
GlideRecord

The question record to send or the sys_id of a question 
record.

sourceRecord GlideRecord An optional source record to associate to the SMS question, 
such as an incident.

emailSubject String Optional text to override the default email subject.

Returns

Type Description

String The conversation sys_id.

This example demonstrates using the default email subject.

var user = GlideRecord("sys_user");
user.get("email", "someone@somedomain.com");
 
new SNC.NotifyNow().sendEmailQuestion(user.getValue('email'), 
 "b6b34500bf3111003cf585ce2c0739ce", user);

This example uses dot-walking and specifies a source record and email subject.

new SNC.NotifyNow().sendEmailQuestion("someone@somedomain.com", 
 "b6071733bf1111003cf585ce2c07390f", current,
        "Please answer this question");

This example uses dot-walking and specifies an email subject but no source record.

new SNC.NotifyNow().sendEmailQuestion("someone@somedomain.com", 
 "b6071733bf1111003cf585ce2c07390f",
        "Please answer this question");

NotifyNow - sendSMS(String phoneNumber, String smsBody)

Sends an SMS message to an E.164-compliant mobile phone number.

Notify supports international numbers. Using this method with a number that does not support 
sending SMS messages results in an error being logged.

Parameters

Name Type Description

phoneNumber String The E.164-compliant phone number to send the message to.
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Parameters  (continued)

Name Type Description

smsBody String The message to send, maximum 1600 characters.

Returns

Type Description

void

new SNC.NotifyNow().sendSMS("+31612345678", "This is a message 
 without source record");

NotifyNow - sendSMS(String phoneNumber, String smsBody, GlideRecord source)

Sends an SMS message to an E.164-compliant mobile phone number.

Notify supports international numbers. Using this method with a number that does not support 
sending SMS messages results in an error being logged.

See also: Advanced configuration for SMS.

Parameters

Name Type Description

phoneNumber String The E.164-compliant phone number to send the message to.

smsBody String The message to send, maximum 1600 characters.

source GlideRecord The source record to associate with this SMS message.

Returns

Type Description

void

var source = new GlideRecord("my_table");
source.query("my_field", "my_value");
 
if (source.hasNext() && source.next()) {
    // send a text message
    var nn = new SNC.NotifyNow();
    var message = "this is just a test";
    var number = "+31612345678";
    nn.sendSMS(number, message, source);
}

This example uses dot-walking and the current record as the source record.

new SNC.NotifyNow().sendSMS("+31612345678", "this is a test", 
 current);
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NotifyNow - sendSMSQuestion(String phoneNumber, String question, GlideRecord 
sourceRecord)

Sends an SMS question.

Parameters

Name Type Description

phoneNumber An E.164-compliant phone number to send the message to.

question String or 
GlideRecord

The question record to send or the sys_id of a question 
record.

sourceRecord An optional source record to associate to the SMS question, 
such as an incident.

Returns

Type Description

String The conversation sys_id, or null if the SMS was not sent successfully.

var question = new GlideRecord("notifynow_question");
question.query();
 
// get the first question
if (question.hasNext() && question.next()) {
 // send the sms question
        var number = "+31612345678";
 var nn = new SNC.NotifyNow();
 nn.sendSMSQuestion(number, question.getUniqueValue(), current);
}

NotifyNow - addConferenceCallParticipant(String conferenceCall, String participant)

Adds ad-hoc users to an ongoing conference call.

When the method is called with a phone number for the participant parameter and there is 
exactly one sys_user record that matches the phone number, that sys_user record will be related 
to the participant. The participant's phone number field will be left blank because the phone 
number is in the sys_user record. If there are several sys_user records that match the phone 
number, or if there are no results, the participant's phone number field will be filled in, and there 
will be no stored reference to sys_user because the user is not known.

Parameters

Name Type Description

conferenceCall String or 
GlideRecord

The sys_id or GlideRecord of an active conference call.

participant String or 
GlideRecord

The sys_id or GlideRecord of a user with an E.164-compliant 
phone number, or an E.164-compliant phone number.
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Returns

Type Description

GlideRecord The participant record of the new participant that was added to the conference 
call.

// add a new participant by conference call sys_id (string) and 
 phone number (string)
var nn = new SNC.NotifyNow();
gs.log(nn.addConferenceCallParticipant('d193b242eb020100a04d4910
f206fe39', '+31612345678'));

// add a new participant by conference call sys_id (string) and 
 user record (GlideRecord)
var user = new GlideRecord('sys_user');
user.query('user_name', 'myUserName');
if (user.hasNext() && user.next()) {
    var nn = new SNC.NotifyNow();
   
 gs.log(nn.addConferenceCallParticipant('d193b242eb020100a04d491
0f206fe39', user));
 
    // you could have added the user by sys_id as well:
    // 
 nn.addConferenceCallParticipant('d193b242eb020100a04d4910f206fe
39', user.getValue('sys_id'));
} else {
    gs.log('no such user');
}

// add a new participant by conference call record (GlideRecord) 
 and phone number (string)
var conferenceCall = new 
 GlideRecord('notifynow_conference_call');
conferenceCall.query('title', 'IA0001001');
if (conferenceCall.hasNext() && conferenceCall.next()) {
    var nn = new SNC.NotifyNow();
    gs.log(nn.addConferenceCallParticipant(conferenceCall, 
 '+31612345678'));
} else {
    gs.log('no such conference call');
}

NotifyNow - convertLocalPhoneNumberToE164(String userID, String phoneNumber)

Converts a local phone number to an E.164-compliant phone number based on a user's location.

Parameters

Name Type Description

userID String The sys_id of a sys_user record to get location information from.

phoneNumber String The phone number.
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Returns

Type Description

String The E.164-compliant phone number.

var localPhoneNumber = '01784 221600';
var userName = 'Heath Vanalphen';
 
var user = new GlideRecord('sys_user');
user.get('name',userName);
var E164Number = new 
 SNC.NotifyNow().convertLocalPhoneNumberToE164(user.getUniqueVal
ue(), localPhoneNumber);
gs.log('converted: ' + localPhoneNumber + ' to ' + E164Number + 
 ' based on ' + user.getValue('name') +
     '\'s location (' + user.getValue('location') + ')');

NotifyNow - getConferenceCallParticipants(String conferenceCallId, Boolean isCallable)

Returns all participants for a conference call.

Parameters

Name Type Description

conferenceCallId String The ID of the conference call.

isCallable Boolean An optional flag to return either only the users you can call (true) 
or those you cannot call (false).

Returns

Type Description

GlideRecord The participants

var nn = new SNC.NotifyNow();
var user = 
 nn.getConferenceCallParticipants('c2e91710eb120100f34087b9d106f
e37');
 
while (user.hasNext() && user.next()) {
    if (user.getValue('participant')) {
        gs.log('user: ' + user.getValue('sys_id'));
    } else {
        gs.log('phone number: ' + 
 user.getValue('phone_number'));
    }
}

var nn = new SNC.NotifyNow();
var user = 
 nn.getConferenceCallParticipants('c2e91710eb120100f34087b9d106f
e37', true);
 
while (user.hasNext() && user.next()) {
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    if (user.getValue('participant')) {
        gs.log('user: ' + user.getValue('sys_id'));
    } else {
        gs.log('phone number: ' + 
 user.getValue('phone_number'));
    }
}

var conferenceCallId = '32b11430eb1201003cf587b9d106feb8';
 
// get all participants
gs.log('all conference call participants:');
var nn = new SNC.NotifyNow();
var user = nn.getConferenceCallParticipants(conferenceCallId);
gs.log(user);
 
// get all callable participants
gs.log('all conference call participants we can call:');
user = nn.getConferenceCallParticipants(conferenceCallId, true);
gs.log(user);
 
// get all un callable participants
gs.log('all conference call participants that are already in an 
 active session and whom we cannot call:');
user = nn.getConferenceCallParticipants(conferenceCallId, 
 false);
gs.log(user);

NotifyNow - getFrequentlyCalledUsers(Number limit)

Returns a number of frequently-called users, up to the limit parameter, in alphabetical order.

Parameters

Name Type Description

limit Number The maximum number of results.

Returns

Type Description

GlideRecord The frequently called users in alphabetical order.

var nn = new SNC.NotifyNow();
var fc = nn.getFrequentlyCalledUsers(10);
 
while (fc.hasNext() && fc.next()) {
    gs.log("got user " + fc.getValue('name') + ' - ' + 
 fc.getValue('sys_id'));
}

NotifyNow - getPreferredE164VoiceNumber(GlideRecord user)

Returns a user's preferred E.164-compliant phone number for voice calls.
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Parameters

Name Type Description

user GlideRecord or 
String

The user record or the sys_id of a user to get the E.164-compliant 
phone number from.

Returns

Type Description

String The E.164-compliant phone number or null.

var userID = "<user sys_id>";
var E164Number = new 
 SNC.NotifyNow().getPreferredE164VoiceNumber(userID);
gs.log('the preferred phone number for setting up voice calls is 
 ' + E164Number + ' for user with id: ' + userID);

NotifyNow - getPreferredE164SMSNumber(GlideRecord user)

Returns a user's preferred E.164-compliant phone number for SMS messages.

Parameters

Name Type Description

user GlideRecord or 
String

The user record or the sys_id of a user to get the E.164-compliant 
phone number from.

Returns

Type Description

String The E.164-compliant phone number or null.

var userID = "<user sys_id>";
var E164Number = new 
 SNC.NotifyNow().getPreferredE164SMSNumber(userID);
gs.log('the preferred phone number for sending SMS notifications 
 is ' + E164Number + ' for user with id: ' + userID);

NotifyNow - getPreferredEmailAddress(GlideRecord user)

Returns a user's preferred email address

Parameters

Name Type Description

user GlideRecord or 
String

The user record or the sys_id of a user to get the email address 
from.
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Returns

Type Description

String The email address or null.

var userID = "some user sys id";
var email = new 
 SNC.NotifyNow().getPreferredEmailAddress(userID);
gs.log('the preferred email address for sending email 
 notifications is ' + email + ' for user with id: ' + userID);

Task Communications Management
Task Communications Management  (TCM) provides a framework for defining and managing a 
communication process for any entity that extends the task table.

Explore

• Task Communications 
Management process

• Slack Communication

Set up

Activate Task Communications 
Management

Administer

Working with Task 
Communications 
Management

Use

NA

Develop

• Developer training

• Developer documentation

Integrate

NA

Troubleshoot and get help

• Ask or answer questions in 
the Incident Management 
community

• Search the Known Error 
Portal for known error 
articles

• Contact Customer Service 
and Support

Task Communications Management  process

Task Communications Management  helps you to streamline the process by creating designated 
communication plans for effective communication during an event. The communication plan, 
with its defined tasks, helps you to focus on resolving the current issue instead of deciding when 
to send a communication, what information to share, and whom to inform.
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Task Communications Management  basic components

How Task Communications Management  works

With Task Communications Management, you can predefine a communication plan for an event 
such as major incident, planned maintenance, and release. Each plan generally involves a series 
of tasks that define different communication and collaboration activities along with frequency 
and method of communication. For each task, you must specify the communication channel for 
contacting the stakeholders. You can also define templates for email and SMS messages.

After defining the task and channel for communication, you can define the contacts or the target 
audience to be contacted for each task.

After a communication plan is defined, the plan gets associated with the appropriate task 
table based on the conditions defined. Thereafter, the tasks defined in the plan get executed 
sequentially and stakeholders are contacted as defined in the plan. The communication plan 
makes communication and collaboration process smoother and brings a quicker resolution of 
the issue.

Example: Task Communications Management flow in major incident 
management
Assume that you want an incident communication plan generated for a high-priority major 
incident.

• As the major incident manager, you can predefine a communication plan and the conditions 
that drive its attachment. In this case, the conditions are: Priority = High and Major Incident 
state = Accepted. Consider that the target audience is the technical stakeholders of the 
incident and the communication plan definition is named Technical Communications.

• The plan definition can have multiple communication task definitions such as:

◦ Initiate Technical Communications

◦ Technical Status Update

• Each communication task definition also specifies the channel of communication and the 
communication frequency (one time or recurring).

◦ Initiate Technical Communications uses email as a channel of communication and 
communication frequency is one time.

◦ Technical Status Update uses email and SMS as channel of communication and the 
communication frequency is recurring.

• The target audience for in the communications is defined as communication contact 
definitions on the plan definition. In this case, consider Service owners of the affected 
configuration items (CIs) related to the incident as technical stakeholders.
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• When an incident meets these conditions, an incident communication plan together with its 
tasks gets attached to the incident record.

• As the major incident manager, you can effectively carry out the communication without any 
delay in the resolution of the major incident.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Task Communications Management  plugins

The Task Communications Management  plugins is activated in the base system. The plugin 
includes demo data.

Activate Task Communications Management

The Task Communications Management  plugin (com.snc.task_communication_management) 
is activated when you activate the Incident Communications Management  plugin (com.snc.iam) 
or the Incident Management - Major Incident Management plugin (com.snc.incident.mim). This 
plugin includes demo data and activates related plugins if they are not already active.

Before you begin
Role required: admin

About this task
Task Communications Management  activates these related plugins if they are not already active.

Plugins for Task Communications Management

Plugin Description

Contact Management

[com.snc.contact_management]

The Contact Management plugin manages the connections 
between users or groups and other resources in the system.

Targeted Communications

[com.sn_publications]

The Targeted Communications plugin provides a way to 
publish and send out newsletter like articles to targeted 
internal or external customers.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.
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Note: 
When domain separation and delegated admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .

Related topics

List of plugins (Washington DC)

Components installed with Task Communications Management

Several types of components are installed with the Task Communications Management  plugin, 
including tables and user roles.

Note: 
The Application Files table lists the components that are installed with this application. 
For instructions on how to access this table, see Find components installed with an 
application .

Demo data is available for this feature.

Tables installed

Table Description

Communication Plan Type Lookup

[comm_plan_type_lookup]

Stores the communication plan types.

Communication Task Type Lookup

[comm_task_type_lookup]

Stores the communication task types.

Communication Plan Definition

[comm_plan_definition]

The definition table for the 
communication plan entity.

Communication Task Definition

[comm_task_definition]

The definition table for the 
communication task entity.

Communication Channel Definition

[comm_channel_definition]

Main table for channel definitions.

Communication Channel Definition — Email

[comm_channel_def_email]

Defines email as a channel.

Communication Channel Definition — SMS Defines SMS as a channel.
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Table Description

[comm_channel_def_sms] Note: 
This table is available only when 
you install the Notify plugin 
(com.snc.notify).

Communication Channel Definition — Conference

[comm_channel_def_conference]

Defines Conference as a channel.

Note: 
This table is available only when 
the Notify plugin (com.snc.notify) is 
installed.

Communication Contact Definition

[comm_contact_definition]

Defines the contacts for sending out 
communications. Contacts can be 
users, groups, or recipient lists.

Communication Channel Configuration

[comm_channel_config]
Lists all available channels for an 
instance.

Note: 
Configuration script for each 
channel is a script include.

Communication Plan

[comm_plan]

Stores the communication plan that 
outlines the communication activity 
during an event.

Communication Task

[comm_task]

Stores the task to be carried out 
to communicate with the involved 
contacts.

Communication Channel

[comm_channel]

Main table for channel instances.

Communication Channel — Email

[comm_channel_email]

Stores record that indicate email is 
used as a communication channel for a 
communication task.

Communication Channel — SMS

[comm_channel_sms]

Stores record that indicate SMS is 
used as a communication channel for a 
communication task.

Communication Channel — Conference

[comm_channel_conference]

Stores record that indicate conference 
is used as a communication channel for 
a communication task.

Communication Task Handler

[comm_task_handler]

Lists specific handlers for various 
task types. Example: For incident, 
CommunicationManagementIncidentHandler.

Note: 
Users with the admin role cannot 
delete this table.
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Roles installed
To learn more about managing subscriptions, see Managing per-user subscriptions in 
Subscription Management  and contact your account representative.

Communication Plan Admin [sn_comm_management.comm_plan_admin]

Provides overall accountability of Task Communications Management.

Contains Roles

List of roles contained within the role.

• Notifications administrator [notify_admin]

• Publications recipients list user 
[sn_publications_recipients_list_user]

Groups

List of groups this role is assigned to by default.

None.

Special considerations

Important: 
Avoid granting an admin role when more specialized roles are available.

This role has create and edit access to Task Communications Management  tables including 
Communication Plan Definitions and other related records.

Communication Plan Viewer [sn_comm_management.comm_plan_viewer]

This role has read access to Task Communications Management  tables.

Contains Roles

List of roles contained within the role.

• Notification viewer [notify_view]

• Publications recipients list user 
[sn_publications_recipients_list_user]

Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

Communication Plan Manager [sn_comm_management.comm_plan_manager]

This role has create and edit access to Task Communications Management  instance tables 
such as Communication Plans, Communication Tasks. Users with this role can send impromptu 
communications.
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Contains Roles

The Communication Plan Manager [sn_comm_management.comm_plan_manager] role contains 
the Communication Plan Viewer [sn_comm_management.comm_plan_viewer] 
role.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

Install Collaboration Services for Task Communications Management

Install the Collaboration Services for Task Communications Management plugin 
(sn_tcm_collab_hook) from ServiceNow Store to get the Slack functionality.

Before you begin
Role required: admin

About this task

Procedure

1. Navigate to ServiceNow Store.

2. Find the Collaboration Services for Task Communications Management store application.

3. Click the Collaboration Services for Task Communications Management store application and 
then click Request App.

Related topics

List of plugins (Washington DC)

Configure Slack workspace

Components installed with Collaboration Services for Task Communications Management

Several types of components are installed with the Collaboration Services for Task 
Communications Management (sn_tcm_collab_hook) plugin, including tables.

Note: 
The Application Files table lists the components that are installed with this application. 
For instructions on how to access this table, see Find components installed with an 
application .

Tables installed

Table Description

Communication Channel 
Definition – Slack

[comm_channel_def_slack]

The table extends the Communication Channel Definition 
[comm_channel_definition] table.
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Table Description

Communication Channel – Slack

[comm_channel_slack]

The table extends the Communication Channel 
[comm_channel] table.

Communication Plan — 
Collaboration Service Data

[comm_plan_collab_data]

Stores Collaboration Service related data.

Related topics

Configure Slack workspace

Working with Task Communications Management

The section covers topics that help you with a variety of technical concepts related to Task 
Communications Management  such as creating communication plan definition, task definition, 
channel definition, and contact definition.

Define a communication plan

Define a communication plan for a task record to specify communication task and contact 
definitions. When specified conditions for the plan definition are met, the communication plan 
and its associated records are automatically attached to the task record, eliminating manual 
effort.

Before you begin
Role required: sn_comm_management.comm_plan_admin or admin

Procedure

1. Navigate to All  > Task Communications Management  > Plan Definitions, and click New.

2. On the form, fill in the fields.

Communication Plan Definition form

Field Description

Name Unique name for the communication plan.

Table Table that the plan is attached to when the conditions 
are met.

Type Type of communication plan such as Technical, 
Internal, External, Customer.

Order Order in which the communication plans must be 
associated to the table.

Condition based Option to define whether the plan is attached to a 
table based on the conditions. For example, if you 
want to attach a communication plan to an incident 
of priority = 2, you can mention the condition in the 
Condition  field.

Active Option to define whether the plan definition is active.

Description Detailed description of the plan definition.
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Field Description

Condition Condition under which a communication plan gets 
attached to a table.

3. Click Submit.
The communication plan is submitted. The following related lists appear in the communication 
plan definition:

◦ Communication Task Definitions

◦ Communication Contact Definitions

What to do next
Define a communication task for the plan.

Define a communication task

Define a communication task for a communication plan. When a plan gets attached to a table, 
the tasks related to the plan need to be executed to resolve the issue. You can associate multiple 
tasks with a communication plan.

Before you begin
Role required: sn_comm_management.comm_plan_admin or admin

You have defined a communication plan.

Procedure

1. Navigate to All  > Task Communications Management  > Plan Definitions.

2. Click the communication plan for which you want to define a communication task.

3. Click the Communication Task Definitions related list and then click New.

4. On the form, fill in the fields.

Communication Task Definition form

Field Description

Communication plan definition Unique name of the communication plan definition that 
you are defining the task for.

Name Unique name for the communication task definition.

Type Type of task, such as internal communication, that is 
applicable globally or to a particular table.

Note: 
The value in the Type  field helps you to filter a task 
by its type. The value also helps to generate a report 
of a particular task type or to create SLAs on any 
communication task.

Application Application scope of the task definition. The task 
definition is available for all applications or for scoped 
applications.
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Field Description

Order Order that the communication tasks appear in the plan. 
This field indicates which communication task to execute 
first.

Active Option to define whether the task is active or not.

Description Detailed description of the task definition.

Communication frequency Frequency of the communication task execution. You 
can send the notification once or the notification can be 
repeated.

Duration Time by which you want to send a notification.

For example, if the communication frequency is One 
time  and the Duration  is 15 minutes, then the notification 
is sent only once in 15 minutes. If the communication 
frequency is Recurring, then the notification is sent every 
15 minutes.

5. Click Update.
The communication task is defined for the communication plan.

What to do next
Define communication channel for the task.

Define a communication channel

Define a communication channel for each communication task to determine which mode of 
communication to use for the task when a plan is attached to a table.

Before you begin
Role required: sn_comm_management.comm_plan_admin or admin

You have defined a communication plan and its related tasks.

About this task

• The modes of communication available are: email, SMS, conference, and Slack.

• For the incident table, the functionality for SMS and conference appears only if you activate 
the Notify plugin (com.snc.notify) and the com.snc.iam.notify_number  property value 
is set to the registered notify number. The notify number is registered while configuring the 
Twilio account.

• For the incident table, the functionality for Slack appears only if you activate the Collaboration 
Services for Task Communications Management plugin (sn_tcm_collab_hook). To activate the 
Collaboration Services for Task Communications Management plugin, navigate to ServiceNow 
Store  and install the Collaboration Services for Task Communications Management 
application. For more information, refer Collaboration services for Task Communications 
Management .

Note: 
For information on how to configure Slack, refer to Configure Slack workspace  .

• Add Channel – Conference  is mutually exclusive to Add Channel – SMS  and Add Channel 
– Email. If you select Add Channel – Conference, you cannot select Add Channel – Email  or 
Add Channel – SMS.
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Procedure

1. Navigate to All  > Task Communications Management  > Plan Definitions.

2. Click a communication plan.

3. Click the Communication Task Definitions related list and then click the task for which you want 
to define the communication channel.

4. On the Communication Task Definition form, click any one of the following related links based 
on your requirement:

◦ Add Channel – Conference

◦ Add Channel – Email

◦ Add Channel – SMS

◦ Add Channel – Slack

5. On the form, fill in the fields.

Communication Channel Definition form

Field Description

Add Channel – Conference

Communication task definition Communication task definition that the channel 
definition is associated with.

Notify provider selector Lookup icon ( ) to select the selector from the 
Provider Selector [notify_group_selector] table.

Note: 
The selector can be associated with notify 
number group or conference provider. Each 
notify number group can have one or more 
Notify numbers that can be used to make 
conference calls.

Add Channel – Email

Communication task definition Communication task definition that this channel 
definition is associated with.

Email client template Lookup icon ( ) to select the email client template 
used to send emails to the targeted audience.

Note: 
This email template must be defined in the 
Communication task table.

Recipient field List to select where you want the recipients list 
to be populated. Options include To, CC, and 
BCC. The default value is populated based on 
what you define in the Default recipient location 
of emails for Communication Tasks  property 
(sn_comm_management.default_email_recipient_field).

Add Channel – SMS
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Field Description

Communication task definition Communication task definition this channel 
definition is associated with.

Notify SMS template Lookup icon  to select the notify SMS template 
used to send an SMS to the targeted audience.

Note: 
This SMS template must be defined in the 
Communication task table.

Notify provider selector Lookup icon ( ) to select the selector from the 
Provider Selector [notify_group_selector] table.

Note: 
The selector can be associated with notify 
number group or conference provider. Each 
notify number group can have one or more 
Notify numbers that can be used to send SMS.

Add Channel – Slack

Communication task definition Communication task definition this channel 
definition is associated with.

Channel Type Channel type is Slack.

6. Click Submit.
A communication channel is defined for the communication task.

What to do next
After creating communication tasks and communication channels for those tasks, define 
contacts for the communication plan.

Define a communication contact

Define the recipients of a particular plan to determine the target audience involved in each 
communication task and the responsibilities the recipients are expected to handle. A notification 
for a task is sent to all individuals specified for that task.

Before you begin
Role required: sn_comm_management.communication_plan_admin or admin

You have defined a communication plan.

About this task
You can add or remove any particular communication contact manually.

Procedure

1. Navigate to All  > Task Communications Management  > Plan Definitions.

2. Click the communication plan that you want to define the contacts for.

3. Click the Communication Contact Definitions  related list and then click New.

4. On the form, fill in the fields.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

5207



Communication Contact Definition form

Field Description

Type Type of contact such as user, group, or recipient list 
that you want to involve in the plan. The contact type is 
assigned dynamically at the time of the table execution. 
For information on recipient lists, refer Define a recipient 
list for communication contact.

Responsibility Responsibility that the user, group, or individuals in the 
recipient list are expected to handle.

User Name of the user, group, or recipient list to be added to 
the contact list.

Note: 
You can use the recipient list to specify dynamic 
criteria for fetching the list of users for a particular 
communication plan.

5. Click Submit.
A communication contact is defined for the communication plan.

Define a recipient list for communication contact

A recipient list lets you specify a filter to fetch a list of users. Use the recipient list as the contact 
for a particular communication plan.

Before you begin
Role required: sn_comm_management.comm_plan_admin or admin

About this task
Sometimes, the contacts that you want to include in a plan can only be known dynamically. For 
example, you might want the support group associated with a particular business service in an 
incident to be involved in the communication plan. The support group might change depending 
on the business service that you select. In such a case, a recipient list provides the flexibility to 
add recipients dynamically.

Procedure

1. Navigate to All  > Task Communications Management  > Administration  > Recipients Lists.

2. Click New  to create a new recipient list.

3. On the form, fill in the fields.

Recipients Lists form

Field Description

Name Name of the recipient list.

Type Type of recipient.

State [Read only] The state of the recipient list.

Setup

Method The method used to generate the recipient list.
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Field Description

◦ Upload File: Upload an Excel file with the recipient 
information to create a recipient list. This list is static.

◦ Dynamic Condition: Use scripts or conditions to receive 
recipient information.

4. Click Submit.
A recipient list is defined for the contact.

What to do next
Define a communication contact for the task.

Create a plan type

Create the communication plan type and specify whether the plan type is applicable globally 
or to a particular table. When you create the communication plan type, it is referenced in the 
communication plan definition. The type of the communication plan helps you to filter the plan by 
its type, generate a report of a particular plan type, or create SLAs for any communication plan.

Before you begin
Role required: sn_comm_management.comm_plan_admin or admin

Procedure

1. Navigate to All  > Task Communication Management  > Administration  > Plan Types, and click 
New.

2. On the form, fill in the fields.

Communication Plan Type Lookup form

Field Description

Name Unique name of the communication plan type.

Global Option to determine whether the plan type is available 
for all tables or for a specific table. If the check box is not 
selected, the Table  field appears where you can select the 
table for which the plan type appears.

Application Application scope of the plan type. The plan type is 
available for all applications or for scoped applications.

Active Option to define whether the plan type is active.

Description Detailed description of the plan type.

3. Click Submit.
A communication plan type is created.

What to do next
Define a communication plan.

Create a task type

Create the communication task type and specify whether the task is applicable to a particular 
table or is globally applicable. The communication task type helps you to filter a task by its type, 
generate a report of a particular task type, or create SLAs for any communication task.
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Before you begin
Role required: sn_comm_management.comm_plan_admin

Procedure

1. Navigate to All  > Task Communication Management  > Administration  > Task Types, and click 
New.

2. On the form, fill in the fields.

Communication Task Type Lookup form

Field Description

Name Unique name of the communication task type.

Global Option to determine whether the task type is available 
for all tables or for a specific table. If the check box is not 
selected, the Table  field appears where you can select the 
table the task type appears for.

Application Application scope of the task type. The task type is 
available for all applications or for scoped applications.

Active Option to define whether the task type is active or not.

Description Detailed description regarding the type of the task.

3. Click Submit.
A communication task type is created.

What to do next
Define a communication task.

Define contact responsibilities

Define the different contacts or target audience involved in the communication process and their 
responsibility to understand the expectations from those contacts throughout the process.

Before you begin
Role required: sn_comm_management.comm_plan_admin or admin

Procedure

1. Navigate to All  > Task Communication Management  > Administration  > Contact 
Responsibilities, and click New.

2. On the form, fill in the fields.

Contact Responsibility form

Field Description

Global Option to determine whether the contact responsibility is 
available for all tables or for a specific table. If the check 
box is not selected, the Table  field appears where you 
can select the table that you are defining the contact 
responsibility for.
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Field Description

Name Unique name of the contact, such as Business Director or 
Communication Manager, involved in the communication 
process.

Type Type of contact such as user, group, or recipient list.

Table Table that the contact is activated on when a 
communication plan is attached.

3. Click Submit.
Contact responsibilities are defined.

What to do next
Define a communication contact for the task.

View communication channel configuration

View the configuration of different communication channels that are used to contact the target 
audience in the communication process. By default, the communication channels available are 
email, SMS, Slack, and conference.

Before you begin
Role required: sn_comm_management.comm_plan_admin or admin

Procedure

1. Navigate to All  > Task Communication Management  > Administration  > Channel 
Configuration.

2. Open any communication channel record.

3. On the form, view the fields.

Communication Channel Configuration form

Field Description

Type [Read only] Mode of channel.

Configuration script [Read only] Lookup icon ( ) to select the script that 
defines the channel configuration.

Active [Read only] Option to define whether the 
communication channel is active or not.

Classification [Read only] Internally used to group the channels 
between conference or major incident management 
workbench.

Configure Slack for a communication task

Configure Slack as a mode of communication for a communication task to send direct message 
to the users.

Before you begin
Role required: sn_comm_management.comm_plan_admin or admin

Install the Collaboration Services for Task Communications Management plugin 
(sn_tcm_collab_hook) from ServiceNow Store.
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Procedure

1. Navigate to All  > Incident  > Communication Plan Definitions.

2. Open the communication plan where you want to add Slack as a communication channel for a 
communication task.

3. Open the communication task definition for which you want to add Slack as the mode of 
communication.

4. Click the Add Channel – Slack  related links.

5. Click Submit.
Slack gets added as a communication channel for the communication task.

Classic Workflow
Workflow provides a drag-and-drop interface for automating multi-step processes across 
the platform. Each workflow consists of a sequence of activities, such as generating records, 
notifying users of pending approvals, or running scripts. The graphical Workflow Editor 
represents workflows visually as a type of flowchart. It shows activities as boxes labeled with 
information about that activity and transitions from one activity to the next as lines connecting 
the boxes.

Note: 
As of the New York release, Workflow is a legacy product. Use Flow Designer  for any 
new process automation. As many organizations have workflows in production, use this 
Workflow documentation to learn how to work with existing workflows.

Explore

• Washington DC

• Workflow movement with 
update sets

• Workflow activity pinning

• Domain separation and 
Workflow

• Workflow training on the 

ServiceNow®  Developer 
Site

Set up

Getting started with workflows

Administer

• Workflow roles

• Administering workflow 
contexts

Use

• Workflow editor

• Create a workflow

• Workflow activities

Develop

• Developer training

• Developer documentation

• Workflow API reference

• Using variables in a workflow

Troubleshoot and get help

• Ask or answer questions in 
the Developer Community

• Troubleshoot workflows

• Search the Known Error 
Portal for known error 
articles

• Contact Customer Service 
and Support
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Getting started with workflows

The graphical Workflow Editor provides a drag-and-drop interface for automating multi-step 
processes across the platform.

Parts of a workflow

Workflows consist of these parts.

Properties

Specify configuration settings such as the workflow name, the table whose records 
the workflow acts on, and the conditions under which to run it.

Activities

Specify the sequence of operations the workflow performs such as generating 
records, notifying users of pending approvals, or running scripts.

Transitions

Specify the conditions under which to run an activity.

Exit conditions

Specify the conditions under which to run a transition.

Contexts

Store historical runtime information about a specific workflow run in a Workflow 
Context record.

Versions

Store historical design information about a specific workflow in a Workflow version 
record.

Workflow life cycle

A workflow starts when a triggering event occurs. Common triggers include a record being 
inserted into a specific table, or a particular field in a table being set to a specified value. For 
example, you might create a workflow that runs whenever a user requests approval for an item 
they want to order from the catalog. You can also schedule workflows to run periodically or call 
them from scripts such as business rules.

When an activity completes, the workflow transitions to the next activity. An activity might have 
several different possible transitions to various activities, depending on the outcome of the 
activity. Continuing the example above, if the user's request is approved, the activity might 
transition to an activity that notifies someone to order the item. If the user's request is denied, the 
activity might transition to notifying the user that their request has been denied.

The graphical Workflow Editor represents workflows visually as a type of flowchart. It shows 
activities as boxes labelled with information about that activity and transitions from one activity to 
the next as lines connecting the boxes.

At each step in a workflow:

1. An activity is processed and an action defined by that activity occurs.

2. At the completion of an action by an activity, the workflow checks the activity's conditions.

3. For each matching condition, the workflow follows the transition to the next activity.

When the workflow runs out of activities, the workflow is complete. The Workflow Context  stores 
the execution history of the activities and transitions run. The Workflow Version  stores the design 
history of the activities, transitions, and exit conditions available to run.
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Workflow properties

The workflow properties specify when to run a workflow and what records it acts on. For more 
information about workflow properties, see Workflow properties.

Workflow activities

A workflow activity contains instructions that are processed by the workflow.

Activities can include running scripts, manipulating records, waiting for a set period of time, 
or logging an event. Workflow conditions determine whether or not the activity is performed. 
Activities can be added, removed, or rearranged. Transitions can be drawn between activities.

This is an activity that triggers a notification:

Sample activity

Workflow runs activities as the user session that starts them. Workflows started from record 
operations will run activities as the user session that performed the record operation. Workflows 
started from schedules or restarted from timers run activities as the System user. Workflows 
started from script calls run activities as the user session that started the script.

For more information on available activities and their behaviors, see Workflow activities.

Transitions

After the workflow condition is evaluated, the workflow transition determines which activity is 
performed when the workflow condition is met.

This is a transition that always leads from the Change Approved  script to the Change Task 
activity:

Sample transition

Exit conditions

After a workflow activity is performed, the workflow condition is evaluated to determine which 
transition is activated.

The condition determines behavior based on a change being approved or rejected:
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Sample exit conditions

Workflow example

During workflow editing or while an unpublished workflow is running, only the person who 
checked out the workflow can view the changes.

After a workflow is published, it is available to other users. The workflow moves through the 
process as defined in the Workflow Editor. The entire workflow is represented in one screen. For 
example, this is the Standard Change workflow:

Sample change workflow

Workflow editor

The Workflow Editor is an interface for creating and modifying workflows by arranging and 
connecting activities to drive processes.

You can manage multiple workflows in the same screen, create custom workflow activities, and 
use existing activities as data sources. Users with the workflow_creator role can create workflows. 
Users with the workflow_admin role can create, modify, delete, and publish workflows.

To open the Workflow Editor, navigate to Workflow  > Workflow Editor. For information about 
using the editor, see Create a workflow.

Welcome screen
The editor opens with the Welcome  page, which displays a list of active, published workflows. 
From this tab, you can open existing workflows, create new workflows, and open help resources 
related to workflow.
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List display filters

Published: Click to view list of published workflows

Checked Out: Click to view list of workflows checked out to current user

Help: Click to view links to help resources for workflow

New Workflow button

Click to create a new workflow

Palette tabs

Workflows: Workflow activities and workflows you can use as subflows.

Core: Available workflow activities appropriate for the selected workflow. Contents 
can include activities provided by the base system and those purchased with 
orchestration.

Packs: Orchestration activity packs downloaded from the ServiceNow®  App Store, 
organized by vendor and scope. Custom activities and workflows that you scope 
also appear as packs. Only visible if the orchestration plugin is installed.

Custom: Orchestration custom activities available. Only visible if the orchestration 
plugin is installed.

Data: Activities in the current workflow that output data. You can use these activities 
as data sources for other activities. Only visible if the orchestration plugin is 
installed.
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Note: 
If your workflow welcome page does not look like this example, you may have customized 
the workflow welcome page before upgrading to Washington DC. You can update the 
workflow welcome page to the latest version by editing the UI pages  .

Navigate to System UI  > UI Pages  > Workflow Editor welcome. In the UI page record for 
workflow_editor_welcome, scroll to the Versions  related list. Select the row for the version 
corresponding to the upgrade to Washington DC, right-click and select Revert to this 
version.

Workflow canvas

After you open or create a new workflow, the system displays the workflow canvas. On the 
canvas you interact with the Workflow Editor through several different elements: the canvas itself, 
the canvas tabs, the title bar, the palette, and the palette tabs.

The drawing canvas is where you add activities and configure transitions for checked out 
workflows. Add an activity by dragging it from the palette to the workflow in the canvas. For more 
information, see Create a workflow.

• Canvas tabs: Contains tabs for accessing workflows being edited or created.

• Title bar:  Displays the workflow name and status. Provides a menu and controls for 
configuring, testing, and validating workflows.

• Canvas: Provides the working surface for creating new workflows or editing existing ones.

• Palette tabs: Contains tabs for accessing activities being edited or created.

• Palette: Contains all available workflow activities and existing workflows you can use as 
subflows. Drag activities and subflows to the canvas to create new workflows or edit existing 
ones.

Workflow user interface

Workflow palette

The default workflow palette contains workflow activities and existing workflows you can use as 
subflows.

The basic workflow palette contains these tabs:
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• Workflows: Displays existing workflows and provides controls for creating new ones.

• Core: Displays baseline workflow activities available to all systems and Orchestration activities 
(when Orchestration is activated).

Workflows tab

The Workflows  tab lists existing workflows that you can edit or use as subflows in other 
workflows. Double-click a workflow to open it in the canvas. To add a workflow as a subflow, drag 
it to another workflow in the canvas. Click the +  icon to create a new workflow.

Workflows tab in the palette

Core tab

The Core  tab contains the standard activities available by default to all workflows and any 
activities purchased with Orchestration, organized by category. Click the arrow icons to expand 
or collapse the activity lists under each category. To add an activity to a workflow, drag it to the 
canvas. For more information, see Add an activity to a workflow.
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Core tab in the palette

Workflow editor title bar

When a workflow is opened in the canvas, the title bar displays the workflow title and the 
workflow status in italics. Possible states are Checked out by <name>  and Published.

Workflow editor title bar

Controls on the right side of the title bar manage the workflow.

• Workflow Properties  : Opens the current workflow's properties form.

• Start  : Runs the workflow. This control is only available for workflows running on the Global 
table that are accessible from all application scopes. To test workflows that are on other tables, 
insert a record into that table that meets the condition of the workflow.

• Validate  : Tests the workflow prior to publication. Validation detects potential problems that 
can prevent the workflow from publishing or cause the workflow to fail. For more information, 
see Workflow Validation.

• Help  : Opens documentation to help you create the workflow.
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Workflow menu

Click the menu icon in the title bar for additional options to configure the workflow.

Accessing the workflow menu

These menu options are available:

Workflow menu options

Option Description

New 
Workflow

Creates a new workflow.

Open 
Existing

Opens another existing workflow.

Copy Creates a duplicate of the workflow. Give the copy a different name.

Publish Makes the personal workflow version public, overwriting the current published 
workflow version. This option is only available for checked out workflows.

Checkout Creates a personal version of the workflow for you, which you can edit. This option 
is only available for published workflows.

Delete Deletes the workflow. You cannot delete workflows that have contexts associated 
with them.

Set 
Inactive

Inactivates the workflow so that it cannot be used.

Expand 
Transitions

Redraws the transitions so that they do not overlap when they leave the activity 
condition.
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Workflow menu options  (continued)

Option Description

Start 
Workflow

Starts a test run of the current workflow.

Validate 
Workflow

Runs validation tests on your workflow prior to publication. Use this validation to 
detect potential problems that can prevent the workflow from publishing or cause 
the workflow to fail. For more information, see Work on workflows.

Collapse 
Transitions

Redraws the transitions so they overlap when they leave the activity condition.

Show 
Contexts

Displays all the contexts  for the current workflow. You can use this option to 
troubleshoot a workflow.

Properties Opens the Workflow Properties form, which defines the workflow's attributes.

Edit Inputs Opens the Workflow Inputs list of variables that the workflow can accept when 
used as a subflow. For more information, see Pass a variable from a workflow to a 
subflow.

Edit 
Stages

Opens the Workflow Stages list. For more information, see Workflow stages. For 
tables with a column of Type = Workflow.

Workflow editor keyboard navigation

The platform includes accessibility features that support Web Content Accessibility Guidelines 
(WCAG) 2.0 level A  and make the interface accessible to users with disabilities.

These features improve the user experience when accessing platform functions with Using 
accessibility features . In general, you use the following set of standard keyboard navigation 
functions:

• Press Tab  to navigate major groupings in a pre-defined sequence. This usually includes 
moving between standard interface controls (fields and lists) in a module, or between records 
within a tab.

Press Shift  Tab  to move backwards in a pre-defined sequence.

• Use arrow keys (left, right, up, down) to navigate between individual elements within a group. 
This usually includes moving between tabs, or between available selections within a specific 
control (for example, within a list).

• Press Enter  to select a control or tab, or enter text within a control.

The Workflow Editor is constructed in a unique manner. It includes a series of main (left) panel 
tabs, a series of side (right) panel tabs, and a drawing canvas for workflow creation or editing. As 
such, it has its own unique set of keyboard accessibility functions and commands.

Welcome page keyboard commands

Use keyboard commands to navigate and operate the Workflow Editor Welcome page.
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Task or Action Keyboard Commands

Navigate to main content (left) panel, and 
select a workflow

1. After accessing the Workflow Editor from a 

menu, press Tab.  appears 
in the upper left corner.

2. Press Enter  to position the cursor in the first 
record displayed in the Published  tab.

3. Press Tab  to navigate down the listing of 
workflow records.

Press Enter  to select and open a workflow 
record in the Workflow drawing canvas.

Select a checked out workflow or a help 
function in main content panel

1. After accessing the Workflow Editor from a 
menu, press Tab  until the Published  tab is 
highlighted.

Note: 

Do not select  or 

.
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Task or Action Keyboard Commands

2. Press the right or left arrow keys to navigate 
between the Published, Checked Out, or Help 
tabs.

3. Press Tab  to navigate across the columns 
and down the listing of checked out workflow 
records or help selections.

Press Enter  to select and open a checked 
out workflow record in the Workflow drawing 
canvas, or open a help selection (work 
or orchestration videos, documentation, 
community discussions, knowledge base, or 
live feed).

Create a workflow 1. After accessing the Workflow Editor from a 

menu, press Tab  until  is 
highlighted.

2. Press Enter  to open New Workflow

Jump to Top After tabbing through the displayed records in 
a tab in the main panel (for example, within the 

Published  tab), appears at the 
bottom of the listing. Press Enter  to return to the 
Welcome tab at the top of the Workflow Editor.

Navigate to page selection controls 1. After tabbing through the displayed records 
in a tab in the main panel (for example, within 

the Published  tab), including , 
press Tab  to access the page selection 
controls. Continue to press Tab  until you 
access the desired one.

2. Press Enter  to operate the selected page 
control.

Navigate directly to side (right) panel to 
open help, create a new workflow, or open 
an existing one

1. After accessing the Workflow Editor from a 
menu, press Tab  two times. Do not select 

. 
appears in the upper left corner.

2. Press Enter  to position the cursor in the 
Workflows  tab in the side panel.

3. To open help, press Tab  to navigate to . 
Press Enter  to open help, or press Tab  to skip.
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Task or Action Keyboard Commands

4. To create a new workflow, press Tab  to 

navigate to . Press Enter  to open New 
Workflow, or press Tab  to skip.

5. To open an existing workflow:

◦ As needed, stop at the filter field to filter 
workflows.

◦ Press Tab  to navigate down the workflow list.

◦ Press Enter  to select and open a workflow 
record in the Workflow drawing canvas,

Add a core activity to a checked out 
workflow in the Workflow drawing canvas

If a checked out workflow is open in the Workflow 
drawing canvas, core activity records display in 
the Core  tab. To select a core activity and place it 
in the checked out workflow:

Note: 
Core activity records only display when 
a checked out workflow is open in 
the Workflow drawing canvas. Other 
tabs display in the side panel only if 
Orchestration functions are enabled.

1. In the Workflow drawing canvas, press Shift 

Tab  until  appears in 
the upper left corner.

2. Press Enter  to position the cursor in the 
Workflows  tab in the side panel.

3. Press the right arrow key to navigate to the 
Core  tab.

4. Press Tab  or the down arrow key to navigate 
down the listing of core activities.

◦ To open a core activities folder (for example, 
Approvals), press the right arrow key.

◦ To navigate up the list, press the left or up 
arrow keys.

5. Press Tab  to select a core activity and open 
the New Activity dialog to specify properties for 
it.

6. After creating the activity, remember to link it 
to another activity in the workflow. See Create 
a connection from a condition on one activity 
to the next activity that follows in Workflow 
drawing canvas keyboard commands.

Workflow drawing canvas keyboard commands

Use keyboard commands to navigate and operate the Workflow Editor canvas.
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Task or Action Keyboard Commands

Select Workflow 
Actions menu 
command (for 
example, Validate 
Workflow  or Publish 
Workflow)

1. Press Tab  until the context menu ( ) is highlighted.

2. Press Enter  to open the context menu.

3. Use the down arrow key to move to the command, then press Enter  to 
select it.

Set general workflow 
properties 1. Press Tab  until  is highlighted.

2. Press Enter  to open Workflow Properties.

Navigate from activity 
box to activity box.

Simply press Tab  or use the arrow keys (right, left, up and down) to 
navigate from activity to activity within the workflow.

Note: 
Depending on the complexity and number of activity boxes in the 
workflow, the sequence of navigation is not always predictable. 
Depending on how you are navigating within the workflow, the 
navigation sequence is generally (but not always) row-by-row, and 
focus is usually placed on the nearest activity box.

Modify a selected 
activity.

1. Navigate to the activity box, then press Enter  to select it and place it in 
Edit mode. When you select an activity box, it appears as highlighted.

2. Once in Edit mode, use Tab  to move around within the activity box to 
change or access elements such as:

◦ Activity Properties ( )

◦ Title

◦ Node context menu

◦ Delete Node ( )
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Task or Action Keyboard Commands

◦ Condition Properties ( )

◦ Node conditional context menu ( )

◦ Node conditional port options ( )

Note: 
All elements in a selected activity are only accessible when 
working with a checked out workflow. When working with a 
published workflow, you can only access its activity properties 
and title,

3. Press Enter  to select an element, or press Esc  to escape an element 
without making changes.

Add a condition to an 
activity.

1. Within an activity box, select  to access Condition Properties.

2. In Condition Properties, specify the conditions for the activity.

Create a connection 
from a condition on 
one activity to the 
next activity that 
follows

1. Within an activity box, select Node conditional context menu  ( ).

2. Select Link to...  to create a connection to the next activity box that 
follows, or select Delete  to delete an existing connection.

Add a core or custom 
activity

1. Within an activity box, select Node conditional port options  ( ).

2. Select Add Core Activity  to access Workflow Activity Definitions 
to add a new core activity, or select Add Custom Activity  to add a 
custom activity to the workflow.

Move an activity box 1. Press Tab  to navigate to the activity box, enter press Enter  to select it.

2. Use the arrow keys to move the activity box. To move the activity box 
one pixel at a time, press Shift  while using the arrow keys.

Validate a workflow
1. Press Tab  until  is highlighted.

2. Press Enter  to validate the workflow.

You can also select Validate  from the Workflow Actions menu.

Run a workflow
1. Press Tab  until  is highlighted.

2. Press Enter  to run the workflow.

Note: 
If the workflow is tied to a database table, this function is disabled. 
The workflow runs when the proper table conditions are activated 
(for example, insertion of a new record into the table).
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Task or Action Keyboard Commands

Close workflow 
drawing canvas 1. Press Tab  until  (on the right side of the tab that contains the name 

of the workflow) appears.

2. Press Enter  to close the canvas.

Publish a workflow
1. Press Tab  until the context menu ( ) is highlighted.

2. Press Enter  to open the context menu.

3. Use the down arrow key to move to the Publish  command, then press 
Enter  to select it.

Jump to Top

After tabbing through the entire workflow,  appears at 
the bottom of the listing. Press Enter  to jump to the top of the Workflow 
drawing canvas.

Workflow management

Create, edit, validate, and publish workflows to automate multi-step processes across the 
platform. Understand workflow activities and variables and how to use them effectively. Take a 
deeper look at how workflows are constructed, validated, and used.

Create a workflow

Automate a multi-step process by creating a workflow with the Workflow Editor.

Before you begin
Role required:

• You must have the workflow_admin or workflow_creator role to use the Workflow Editor.

• If you’re designing the workflow as part of an update set process, see Workflow movement with 
update sets  before creating the workflow.

Procedure

1. Navigate to All  > Workflow  > Workflow Editor.
The Welcome  tab of the Workflow Editor opens.

2. On the Workflows  tab in the palette, select New Workflow.
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A simplified version of the New Workflow form opens.

3. Fill in the Name  and Table  fields.

4. Optional:  Add a Description.

5. Optional:  Do one of the following:

a. If the Conditions  UI section is displayed, specify a Condition  if needed and edit the fields.
The Conditions  UI section shows only if the selected table supports conditions for launching 
workflows. For example, if you select the sc_req_item table, conditions are not applicable 
and the Conditions  UI section isn’t displayed.

b. If the Stages  UI section is displayed, verify that the State rendering  and Stage order  fields 
contain the correct information.
The Stages  UI section shows only if the selected table supports stages. For example, if you 
select the sc_req_item table, the Stages  UI section is displayed.

6. Select Submit.

The new workflow is created with the Begin  and End  activities connected by a single transition.

7. Finish creating the workflow by adding activities, validating, and publishing so the workflow is 
available to other users.
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For more information, see Work on workflows.

8. To change advanced settings for the workflow, select the Properties  icon , and if you make 
changes, select Update.

Workflow properties

In the properties of a workflow, you can configure settings such as its application scope, start 
conditions, schedule, inputs, stages, and run time metrics. You can also view information such as 
the workflow author, version, and history.

When you create a new workflow, the following fields are available in the dialog box:

• Name

• Table

• Description

• If condition matches

• Condition

If you click Diagrammer view, in Related Lists, the following UI sections are available in the 
dialog box:

• General

• Conditions

• Inputs

• Activities

• Application

• Schedule

• Stages

• Estimated Runtime

General

Field Description

Name A name to identify the workflow.

Table The table for the workflow to run on. Workflows that run on specific tables can still 
interact with other tables. Select Global [global]  to run the workflow on all tables.

Note: 
The list shows only tables and database views that are in the same scope as 
the workflow. Also, all users who edit the workflow must have access to the 
necessary tables and domains.

Checked 
out

[Read-only] When the workflow was checked out. Automatically set by the 
Checkout  action in the workflow menu.

Checked 
out by

[Read-only] The user who has this workflow checked out. This value is 
automatically set by the Checkout  action in the workflow menu.

Published [Read-only] Check box to indicate whether the workflow has been published. 
Automatically set by the Publish  action in the workflow menu.
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Field Description

Description The purpose of the workflow.

Conditions

Create conditions to trigger the workflow. The Conditions section does not appear if you select a 
table, such as sc_req_item, that does not require a condition.

Field Description

If 
condition 
matches

When the condition evaluates to true, the workflow launches an active context:

• None: The workflow is not automatically started by the workflow engine. To run 
this workflow, write a script to start the workflow.

• Run the Workflow: The default value. The workflow engine starts the workflow if 
the information in the Condition  field matches a record that is inserting into the 
table.

• Run if no other workflows match yet (deprecated): The workflow only runs if no 
other workflows are running on the execution thread that started this workflow. 
Avoid using.

• Run if no other workflows matched: The workflow only runs if no other workflows 
are running on a specific record. For example, there are four workflows inserted 
into the Incident table, which have a condition such as short_desc  contains 
test. A new workflow, which has If condition matches  is set to Run if no other 
workflows match yet, only runs if none of the four workflows have started 
running on the Incident record.

Condition A condition builder for specifying workflow conditions that trigger the behavior 
selected from the If condition matches list.

Order Numeric value that determines the order of the workflow, relative to other workflows. 
Workflows are evaluated in order from the lowest order number to the highest. A 
workflow runs if it is the first to match conditions.

Inputs

The Inputs section lists all the activities in the current workflow that input data, the data type, 
and the default value. The Inputs section is only available after a workflow has been created. To 
create a variable, click New.

Field Description

Label Displayed column label. Localized depending on user locale.

Reference Input field from another table.

Type Data type. For example, integer or string.

Default value Value used if you do not provide a value.

Activities

The Activities section enables you to set activity pinning and maximum activity count.
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Field Description

Activity 
pinning

List of options that control updates to custom activities at the workflow level. Pinning 
protects custom activities from being updated automatically when downloaded 
from the ServiceNow Store. For more information, see Workflow activity pinning. The 
possible options are:

• Set by activity: Allows all activities in the workflow to use their own pinning settings. 
This is the default pinning option.

• Pin all activities: Pins all activities in the workflow to their current version.

• Unpin all activities: Allows all activities in the workflow to be updated.

Max 
activity 
count

The maximum number of activities performed by the workflow. This value is used to 
prevent infinite loops and is set to 100  by default. When the stated maximum count is 
reached, the workflow is canceled. If this field is blank, the maximum count is set to -1, 
and the workflow is canceled.

Application

The Application section enables you to see application scope and scope restrictions.

Field Description

Application [Read-only] Scope of this activity. For more information, see Application Scope.

Accessible 
from

Scope restrictions for this workflow. Possible settings are:

• All application scopes: Workflow is accessible to all application scopes.

• This application scope only: Workflow access is limited to the scope named in 
the Application  field.

For more information see Workflow scope.

Schedule

Use the Schedule section to create a schedule for this workflow using the schedule builder.

Field Description

Delivery 
based on The schedule type for this workflow. Possible types are:

• User-specified duration: Duration based on a user-specified value. This is 
the default schedule type.

• Relative duration: Duration calculated from a preconfigured schedule, such 
as 8-5 weekdays.

Expected 
time

User-defined interval. This field is visible when the schedule type is User-
specified duration.

Schedule Preconfigured schedule that determines when this workflow runs.

Timezone Time zone for this instance.
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Stages

The Stages section appears if you select a table with Type  = Workflow.

Field Description

Stage Displays the workflow stage progress on the selected table. Optionally, select Stage 
rendering  and Stage order  schemes to customize the appearance of the stage 
field. The default values cover typical scenarios.

Stage 
rendering

The renderer to use when displaying stage icons on a form or list view. For more 
information about renderers, see Workflow stage renderers.

Stage 
order

The order of workflow stages when you view a workflow field in a list. Select 
Computed  to let the workflow engine compute the stage order from the order of 
execution in the workflow. Select User Specified  to use the Order  field from that 
Workflow stages.

Name The name of the stage as it appears in workflow fields..

Duration Time allocated for the specific stage.

Order The order of workflow stages when you view a workflow field in a list. Select 
Computed  to let the workflow engine compute the stage order from the order of 
execution in the workflow. Select User Specified  to use the Order  field from that 
Workflow stages.

Value The value of the stage when it is referenced from elsewhere in the system, such as 
in a script.

Estimated Runtime

The Estimated Runtime  section opens the controls for configuring the ERT  for the workflow. 
Core workflows included in the base system are not configured for estimated run time by default. 
All new workflows are configured with default ERT values automatically. You can edit existing run 
time estimates or configure new ones for any existing workflow. For details about how estimated 
run times are configured and calculated, see Workflow run time metrics.

Field Description

Requires ERT Check box to indicate that this workflow requires an estimated runtime 
configuration.

You can use the ERT calculations to determine if workflows are running longer 
or shorter than expected and to identify errors in workflow processing. By 
default, new workflows require an ERT.

Estimated 
Run Time

The initial estimate for the workflow's run time.

Number of 
data points

[Read only] The number of times the system has compared the estimated run 
time to an actual run time result.

Outlier 
Percentage 
Threshold for 
ERT

[Required] The percentage deviation from the estimated run time that identifies 
an outlier workflow run time. The system uses a default value of 20. For more 
information, see Outlying workflow run times.
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Create a workflow from a table

Automate a multi-step process by creating a workflow from the list view of any table that supports 
workflows.

Before you begin
If you’re designing the workflow as part of an update set process, see Workflow movement with 
update sets  before creating the workflow.

Procedure

1. Open a table, such as Incident or Problem, in the list view.
For example, navigate to Incident > Open.

2. Select and hold (or right-click) in the column header and select Configure > Workflows.

The Workflow Versions  on that table appears in a list.

3. SelectNew.
The Workflow Version  opens in New Workflow  view. The Table  field is filled in with the table 
that you selected in step 1 and is read-only.

4. Enter Name.

5. Optional:  Enter Description.

6. Optional:  Edit conditions fields as necessary.

7. Select Submit.
The new workflow is added to the Workflow Versions  list.

8. Select the workflow Name.
The new workflow is created with the Begin  and End  activities connected by a single transition.
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9. Finish creating the workflow by adding activities, validating, and publishing so the workflow is 
available to other users.
For more information, see Work on workflows.

10. Optional:  To change advanced settings for the workflow, select the Properties  icon , and if 
you make changes, select Update.

Create a workflow for a new service catalog item

When you create a new service catalog item, you can create a new corresponding workflow at 
the same time.

Before you begin

• If you are designing the workflow as part of an update set process, see Workflow movement 
with update sets  before creating the workflow.

Procedure

1. Navigate to All  > Service Catalog  > Catalog Definitions  > Maintain Items.

2. At the top of the form, next to Catalog Items, click New  .
The Catalog Item form opens.

3. Add a Name.

4. Select the Process Engine  tab.

5. Next to the Workflow  field, click the lookup icon .

6. Next to Workflow at the top, click New.
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The Workflow version dialog opens in the New Workflow View. The Table  field is set to 
Requested Item (sc_req_item)  and is read-only.

7. Add a Name.

8. [Optional]Add a Description.

9. [Optional] Change the stage information as necessary.

10. Click Submit.
The new workflow is created with the Begin  and Endactivities connected by a single transition. 

11. Finish creating the workflow by adding activities, validating, and publishing so the workflow is 
available to other users.
For more information, see Work on workflows.

12. To change advanced settings for the workflow, click the Properties  icon.

13. Click Update.
If you close the Workflow Editor, you can see the Catalog Item record. Note that the workflow 
is added to the Workflow field. The Show Workflow and Information icons appear next to the 
Workflow  field. Hover over the information icon to view a read-only summary of the workflow.

Create a workflow for an SLA Definition

Automate a multi-step process by creating a workflow from an SLA definition.
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Before you begin
If you’re designing the workflow as part of an update set process, see Workflow movement with 
update sets  before creating the workflow.

Procedure

1. Open a list of SLA definitions.
For example, Facilities > SLA Definitions  or Service Level Management > SLA Definitions.

2. At the top of the form, next to SLA Definitions, select New  .

3. Select Contract SLA  or Service Offering SLA.
The SLA Definition or Service Offering SLA form opens.

4. Next to the Workflow  field, select the lookup icon.

5. Next to Workflow  at the top, select New.

The Workflow Version dialog shows in the New Workflow view. The Table  field is set to SLA 
Definition (contract_sla)  or Service Offering SLA (service_offering_sla)  and is read-only.

6. Enter Name.

7. Optional:  Enter Description

8. Optional:  Edit conditions fields as necessary.

9. Select Submit.
The new workflow is created with the Begin  and End  activities connected by a single transition.
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10. Finish creating the workflow by adding activities, validating, and publishing so the workflow is 
available to other users.
For more information, see Work on workflows.

11. Optional:  To change advanced settings for the workflow, select the Properties  icon .
If you make changes, select Update.

Ending workflows with multiple branches

A workflow is complete when it reaches the End  activity, even if there are still active branches 
of the workflow in progress. To ensure that both branches are completed, add a Join  activity to 
resolve the branches.

For example, the following figure shows a workflow with two branches that execute 
independently. When Task 1 and Task 2 of Branch B are completed, the workflow is marked 
complete even if the Branch A tasks are not completed.

Workflow with uncompleted branch

For both branches to complete, add a Join  activity to resolve the branches. When one branch 
reaches the join, the workflow waits for the other branch. When both branches are complete, the 
workflow reaches the end. The Incomplete  condition of the a Join  activity is met only if one of 
the branches cannot be completed.

Workflow with completed branches

Work on workflows

To complete a workflow, you add workflow activities, validate the workflow, and publish it.

Before you begin
Role required: None.
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Add a workflow activity

Activities determine the functionality of the workflow.

Before you begin
Role required: workflow_admin, workflow_creator, or admin

About this task
When they are created, all workflows contain Start  and End  activities.

For more information, see Workflow activities.

Procedure

1. Open a workflow.

2. Check out the workflow.

3. Drag a workflow activity  from the Activities menu into the workflow body.

4. Populate the Workflow Activity form that appears.

Validate a workflow

You can manually validate a workflow from the Workflow Editor. You can generate a workflow 
validation report from the Workflow Version form.

Before you begin
Role required: workflow_admin, workflow_creator, workflow_publisher, or admin

About this task
Running a workflow on a new node automatically attempts to validate the workflow. If validation 
is successful, the system updates the workflow version record to indicate the workflow has been 
validated and marks the record as updated by the user who ran the workflow.

Procedure

1. Open the workflow to validate in the Workflow Editor.

When the workflow is loaded, the workflow validator icon appears in the toolbar.

2. Click the validator icon to run a series of validation tests on the current workflow version and 
generate a report.
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3. Complete the following steps to generate a workflow validation report from the Workflow 
Version form

a. Navigate to Workflow  > Administration  > Workflow Versions, and select a workflow to 
validate.

b. Under Related Links, click Validate Workflow.

Publish a workflow

When a workflow is complete, publish the workflow so that it is available to all users.

Before you begin
Before you publish a workflow, validate it to test it for issues that might cause it to fail, such as 
missing subflows or disconnected transitions. For more information, see Workflow validation.

Role required: workflow_admin, workflow_creator, workflow_publisher, or admin

About this task
To publish a workflow:

Procedure

1. Navigate to All  > Workflow  > Workflow Editor.

2. Open the workflow that you want to publish.

3. In the title bar, click the menu icon and select Publish.

Result
If you published a new version of workflow, the changes are not applied to running workflow 
contexts. Any currently running workflow context continues using the workflow version that was 
available when the workflow started. The next time the workflow runs, it uses the new version.
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Determine whether a workflow can run

A workflow can run only if a checked out version is available to the user who has it checked out, 
and a valid, published version is available for all users with permission to run it.

Before you begin
Role required: workflow_admin, workflow_creator, or admin

Procedure

1. In the navigation filter, enter wf_workflow.list, and then open one of the workflows.

2. In the Versions  related list, check for the following conditions:

◦ There’s only one workflow version in a state of Checked out  and Checked out by.

◦ There’s only one version and it isn’t checked out. This version must be both Active  and 
Published. You may need to personalize the list and add the Active  column.

◦ If there are multiple versions, only one is Published.

These checks determine the only two conditions under which a workflow can run:

◦ A checked out version of a workflow is available for the user who has it checked out.

◦ A valid, published version of a workflow is available for all users who have permission to run 
the workflow.

Main flows containing subflows that don’t meet one of these two conditions aren’t permitted to 
execute against a current record transaction. Instead, a critical log entry detailing the subflow 
state is added to the Workflow Context record.

To enable the workflow to execute on the next appropriate transaction, remove the subflow 
from the main flow or modify the published and active states of the subflow.

Edit a published workflow

You can edit a published workflow after you check it out.

Before you begin
Role required: workflow_admin, workflow_creator, workflow_publisher, or admin

About this task

Note: 
You cannot check out or delete workflows that are associated with a read-only application 
file.

To check out a workflow:

Procedure

1. Navigate to All  > Workflow  > Workflow Editor.

2. Open the workflow that you want to edit.

3. In the title bar, click the menu icon and select Checkout.

A new version of the workflow  is created and assigned to you.

If you are in a different domain than the published workflow, the new workflow version is 
created in your domain.
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What to do next
After you finish editing the workflow, validate and publish the workflow to make the new version 
available to other users.

Copy a workflow between two application scopes

Application scoping protects applications by identifying and restricting access to application 
files and data. You can copy a workflow created in one application scope (for example, Test) to 
another (Production) as needed.

Before you begin
Role required: admin

Procedure

1. On the Home page, select , located next to the logged in user name.

2. In the Developer  tab, in the Application  field, select the application scope (for example, Test) 
in which you want to operate the ServiceNow  platform.

3. Close the System Settings page.

4. Navigate to Workflow  > Workflow Editor.

5. Create a workflow in the Workflow Editor.
For more details, see Create a workflow.

6. In the Workflow Editor, select .

7. In the Application  tab, Application  is set to the current application scope selected in System 
Settings.

8. In Accessible from, select All application scopes  if the workflow is available to all application 
scopes, or select This application scope only  if it is only available to, and accessible in the 
current application scope only.
Only those workflows that are accessible from all application scopes can be copied to another 
application scope.

9. Go back to the Homepage, select .

10. In the Developer  tab, in the Application  field, select the application scope (for example, 
Production) to which you want to copy the workflow.

11. Navigate to Workflow  > Workflow Editor.

12. Refresh the page, then open the same workflow you created.
An Out of scope workflow, workflow belongs to <scope name> scope  message appears, 
where <scope name> is the application scope in which the workflow was originally created.

13. In the Workflow Editor, select .

14. Select Copy.
The Workflow Name  dialog appears:
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a. In Workflow Name, type the new name for the copied workflow.

b. Select OK.
The system creates a workflow in the current application scope.

15. In the Workflow Editor, select .

16. In the Application  tab, Application  is set to the current application scope.

17. In Accessible from, select This application scope only  if to make the newly copied workflow a 
private one that cannot be accessed from outside current scope.

18. Select Update.

Result
A new workflow record is created in the selected application scope and marked as private if 
designated as one in the Workflow Editor.

Workflows used as subflows

A workflow can launch another workflow as an activity.

The parent workflow triggers the subflow and then waits for the subflow to complete before 
continuing. Run the workflow validation tool prior to publishing to detect missing subflows and 
other dependency problems, such as those involving update sets.

The Workflows  tab in the Workflow Editor contains a list of the workflows available for use as 
subflows.

Workflows available to use as subflows

Make sure that the selected subflow is active. If the subflow is inactive, the main workflow will 
hang with a Loading  message. If you place an inactive subflow into a workflow, the subflow 
appears with a red banner, indicating that it cannot run. An active subflow is highlighted in blue 
when selected.
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Workflow with active subflows

Subflows and the Create Task activity

If a workflow contains a Create Task  activity that has executed on the current record, additional 
task activities in the workflow might not execute as expected.

This can happen when the same subflow containing a Create Task activity runs more than once 
in a parent flow. When the subflow reruns and attempts to execute the Create Task  activity again, 
the system reopens the first task activity instead and does not create an additional task.

Note: 
An alternative to creating duplicate subflows that use the Create Task  activity is to add a 
Run Script  activity to the workflow that creates a task with a script.

The same create task activity runs twice in a workflow

In this configuration, the workflow does not run the same subflow containing a Create Task 
activity more than once. This allows the workflow to create additional tasks.
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Running different subflows containing the Create Task activity

Pass a variable from a workflow to a subflow

Use this process to pass variables from a parent workflow to a subflow.

Before you begin
Role required: workflow_admin, workflow_creator, or admin

About this task

Note: 
You can also use the Return Value  activity in the subflow to return values to the parent 
workflow. Make sure to have a Return Value  on every ending transition path.

Procedure

1. Prepare the subflow to accept variables from the parent workflow by defining the inputs.

2. Include the subflow in the parent workflow and connect the inputs to the parent workflow 
variables.

Note: 
You cannot pass variables to a subflow that runs on the Requested Item [sc_req_item] 
table.

Define inputs for a subflow

Define the input variables for a workflow to request from parent workflows when it is launched as 
a subflow.

About this task
All inputs are stored in the Variables [var_dictionary] table.

Procedure

1. In the editor, open and check out the workflow.

2. In the title bar, click the menu icon and select Edit Inputs.

3. In the Workflow Inputs window, click New.

4. Populate the record with the definition of the variable, including the column name, the label 
that is displayed to the user, and the type of field.

5. Click Submit.

Invoke a subflow in a workflow

Use this procedure to add a subflow to a workflow.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

5244



Procedure

1. In the Workflow Editor, open and check out the parent workflow.

2. Drag the subflow from the Workflows  tab to the parent workflow.

3. In the New Activity dialog box, define the variables defined by the subflow's Inputs.

These fields can accept both static values or variables in the following format:

${variable_name}

4. Click Submit.

The workflow triggers the subflow at the appropriate time and passes the variables as 
indicated by the Inputs  definition.

Prepare a subflow

Review the process of preparing a subflow for use in a parent workflow, and for preparing the 
parent workflow to use a subflow.

Procedure

1. In the editor, open and check out the workflow that you want to use as a subflow.

2. In the title bar, click the menu icon and select Edit Inputs.

3. In the Workflow Inputs window, click New  in the Variables  list.

4. Add a new variable depending on the type of values that it is going to store.

The following example sets up a string value.
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5. Click Submit.

6. Close the Workflows Inputs  dialog.

7. Create a Run Script  activity on the subflow.

◦ Set the value from the parameter to a field on the current form. This is important because the 
Notification  activity can only pull values from the current variable and not from the newly 
added variable. The following example sets the value in the Description  field.

current.description = workflow.inputs.bluesubvariable;

◦ Create a new field on the request form but do not display the field. This serves as temporary 
storage.

8. Create a Notification  activity on the subflow and use ${description}  in the subject to 
return the value from the field.
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This is what the subflow would look like:

Prepare a workflow to use a subflow

After you create a subflow, use this procedure to prepare the parent workflow.

Procedure

1. On the parent workflow, create a variable similar to what you did on the subflow, but name it 
something different.

In the following example, the variable is named Blue Main Variable.
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2. Click Submit.

3. Insert a Run Script  activity to return the value from a field to the newly created variable.

In this example, the value of the Short Description  field is returned and given to the newly 
created variable.

workflow.scratchpad.bluemainvariable = 
current.short_description;

4. Click Submit.

5. In the subflow activity, set the Blue Sub Variable  to pass the bluemainvariable  to the 
bluesubvariable.

${workflow.scratchpad.bluemainvariable}

This is what the main workflow looks like:

Using variables in a workflow

Within workflow there are several different types of variables that are available.

Some variables define, describe, or compose the pieces of the workflow (such as workflow 
activities). Some variables are available specifically to facilitate the execution of a workflow (such 
as scratchpad variables). Some variables define, describe, or compose the data records being 
manipulated by the workflow process (for example, the elements of a Glide Record that are 
defined in a dictionary.xml file describing a record, such as an incident).

Activity variables

Activity variables are properties specifically associated with a workflow activity.
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Before you begin
Role required: admin

About this task
These are the inputs that appear on the activity definition when a specific activity is dragged 
onto the workflow canvas. These variables are properties that define, compose or describe the 
workflow activity, or the work it is designed to perform.

Activity variables are declared in a related list within the Workflow Activity Definition.

To add, view, or modify a variable:

Procedure

1. Navigate to All  > Workflow  > Activity Definitions.

2. Select a workflow activity, such as Approval - User.

3. In the Activity Variables  section or tab, add, view, or modify the variables.
Activity variables are defined using the same fields as System dictionary .

Note: 
If defining a new activity variable that is dependent on another activity variable, put the 
prefix "vars." before the name of the parent activity variable. For example, if the child field 
is dependent on a field named parent, put the value vars.parent  in the Dependent 
field.

To control the visibility of an activity variable on the workflow canvas after the activity has been 
dragged to the canvas, use a UI policy on the wf_activity table.

To access the variables or assign values to these variables within the workflow activity, use the 
vars  variable of the workflow activity.

 activity.vars.variable_name = new_variable_value 

Workflow input variables

Workflow variables are external values that are passed into and referenced by a workflow during 
its execution.

Before you begin
Role required: admin

About this task
Workflow variables can be declared externally in a script and passed into a main workflow or they 
can be declared within a main workflow and passed as inputs to a subflow.

Note: 
There is a specific kind of input variable for any workflow that is declared against the table 
Requested Item [sc_request_item]. To understand the use of these variables see Workflow 
catalog variables.

Workflow variables are declared in a form available from the Workflow Editor gear menu.

To add, view, or modify a variable:

Procedure

1. Navigate to All  > Workflow  > Workflow Editor.

2. Edit and checkout a workflow.
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3. Select the Workflow Activities menu and select Edit Inputs.

4. Select an existing variable or click New.

Note the Column name  field. Use this value when accessing the variable from a script.

Workflow variables do not appear on the workflow canvas, they are only available for view from 
the Workflow Activity menu.

The input variables are available to use in scripts. To access an input variable from a script:

var input  = workflow. variables. variableName //get the workflow 
 variable identified by column name.

Assigning values to variables from outside of workflow

After being declared in a workflow, values can be assigned to the variables from where the 
workflow is kicked off.

The following example demonstrates how a workflow variable's value can be set in a script 
include, business rule, or UI action:

 
//Declare an instance  of workflow.js
var wf  = new Workflow ( ) //Get the workflow id
var  wfId  = wf. getWorkflowFromName ( "Workflow Name" ) ;
//Start workflow, passing along name : value pair(s) for mapping 
 to variable
//where input_var_name is the name of the variable declared in 
 gear menu
//and input_var_value is whatever that value should be for this 
 execution of
//workflow
wf. startFlow (wfId , null , "Workflow Name" , {input_var_name : 
 input_var_value } ) ;

Another example that demonstrates a more readable way of passing multiple variables involves 
declaring an object, adding the names/values to the object, and passing it:

//Declare an instance  of workflow.js
var wf  = new Workflow ( )
//Get the workflow id
var  wfId  = wf. getWorkflowFromName ( "Workflow Name" ) ;
//Start workflow, passing along object containing name/value 
 pairs mapping to inputs expected by the workflow
var vars  = { } ;
vars. input_var_name1 = input_var_value1 ;
vars. input_var_name2 = input_var_value2 ;
// add as many variables as your workflow is expecting, then 
 pass the object
wf. startFlow (wfId , null , "Workflow Name" , vars ) ;

Assigning Values for Subflow Inputs from inside of a Main Workflow

If a workflow that accepts inputs is called from within another workflow, those input values can be 
set from the workflow canvas within the UI of the workflow activity. Each input variable declared 
for a subflow will have a text box input area displayed on the activity. Within these text boxes, the 
variables can be set with any value either from the scratchpad or from within the current record.

For more information, see Workflows used as subflows.
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Reading the Value of a Workflow Input Variable

The value of a Workflow input variable is accessible anywhere within the workflow that accepts 
javascript by dot walking the current workflow object:

var readValue = workflow.inputs.variable_name;

Workflow scratchpad variables

Store and share string-based variables as name-value pairs between workflow activities.

The scratchpad is global to the instance of the running workflow and as such, is available equally 
to all activities.

Declaration

The scratchpad itself is automatically available to an executing workflow and requires no specific 
declaration. Variables are declared and stored in the scratchpad simultaneously by referencing 
it. For example:

workflow.scratchpad.variableName = variableValue;

Display

View activity scratchpad values from the Workflow Activity History Scratchpad 
[wf_history_scratchpad] table. Workflow Activity History Scratchpad is also an embedded list in 
Worfklow Activity History records.

Sample Workflow Activity History Scratchpad records

Access and Assignment

Use standard JavaScript object notation to access or assign scratchpad values. For example, use 
this format to assign a particular scratchpad variable value.

workflow.scratchpad.variableName = variableValue;
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Use this format to assign a JavaScript variable to a scratchpad variable.

var myValue = workflow.scratchpad.variableName;

Current variables

Current is the database GlideRecord that kicked off the workflow, either by association to the 
table in the Workflow properties table or by being associated with a catalog item.

Declaration

Variables in current are the columns that are defined in the dictionary.xml  file that support 
the database record. There is no way at runtime to add variables to the current record.

Display

Variables of a current record are displayed on the Glide Forms and Lists throughout the 
applications that use them.

Access and Assignment

To access the variables or assign values to the variables within the workflow activity, get the 
value from the current record by referencing the Glide Element.

var myVarValue = current.getElement(nameOfTheField);

or

var myVarValue = current.fieldName;

or

current.variableName.setValue( "A Variable Value");

Workflow catalog variables

Workflows that are associated with the Requested Item [sc_req_item] table have a specific type 
of workflow input.

The inputs into this workflow are essentially question:answer pairings that, when associated with 
a specific catalog task, become options on the task form. These options are generated by that 
catalog task activity within a workflow.

Scope

For the purposes of Service Catalog and workflow, a variable’s scope determines its availability 
to a catalog task activity within a workflow. You can define variables as global or catalog item-
specific. When a variable is associated to a catalog item and the workflow generating the 
catalog task is associated to the catalog item, the variable scope determines which variables are 
available for mapping within the catalog task activity in a workflow. If a workflow is associated 
with Requested Item [sc_request_item], and is not specifically associated with a catalog item, 
any catalog variable with a blank Cat Item field value is available to all catalog task activities 
within the workflow.

Declaration

You can declare requested item catalog variables at the catalog item level or at a global level.

About this task
You can declare global catalog variables using the Workflow Editor context menu.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

5252



Also see, Global variable declaration option 2.

Procedure

1. Navigate to All  > Workflow  > Workflow Editor.

2. Open and check out a workflow that runs against the Requested Item [sc_req_item] table.

3. Click the menu icon and select Edit Catalog Variables.

4. Click New  to create a new variable or select an existing variable.

5. Select the Global  check box.

6. Click Submit.

Global variable declaration option 2

You can declare global catalog variables using the Service Catalog.

Procedure

1. Navigate to All  > Service Catalog  > Item Variables.

2. The list of variables that appears in the workspace has a default filter of Cat Item != <blank>. 
Change the filter  to Cat Item = <blank>  and run the query.

The catalog variables that appear are available to any catalog task that is initiated from within a 
workflow.

3. Click New  to create a new variable.

4. Leave the Cat Item  field blank.

5. Select the Global  check box.

6. Click Submit.
Also see, Global variable declaration option 1.

Catalog item specific variable declaration option 1

You can declare a catalog item-specific variable.

About this task
These variables are only available to the catalog item referenced in the Cat Item  field on the 
variable record.

Procedure

1. Navigate to All  > Service Catalog  > Catalog Variables  > Item Variables.
Note the list of variables that appears in the workspace has a default filter of Cat Item != 
<blank>.

2. Enter or select a catalog item in the Cat Item  reference field.
Selecting a Cat Item  restricts the scope and availability of the catalog variable to that specific 
catalog item.

3. Click Submit.
Also see, Catalog item specific variable declaration option 2.

Catalog item specific variable declaration option 2

You can declare a catalog item-specific variable directly from a catalog item record.
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About this task
Creating a catalog variable in this way automatically sets the Cat Item  reference to the catalog 
item selected.

Procedure

1. Navigate to All  > Service Catalog  > Catalog Definitions  > Maintain Items.

2. Select or create an a catalog item.
Note the Variables  related list. All variables declared using this related list have a Cat Item 
reference value of the current catalog item.

3. From the Variables  related list, click New.

4. Ensure that the Cat Item  field correctly references the catalog item previously selected or 
created.

5. Go to or open the Question  section or tab.

6. Add a Question.

7. Add a Name.
Variable names should not include white space and cannot begin with a number.

8. Click Submit.
Also see, Catalog item specific variable declaration option 1.

Display

Catalog specific item variables are visible in several places depending on where in the process 
the variable is viewed.

Declaration can happen and variables can be seen from within the menu, inside both the 
Maintain Items  module and in the Item Variable  modules of the Service Catalog.

Within a workflow, the Catalog Specific Item variables are available to the Catalog Task  activity 
in the form of a slushbucket at the bottom of the Catalog Task  activity. Item variables that are 
selected, are the question and answer pairs that will appear on the task that is generated by that 
instance of Catalog Task  when executing that workflow.

If a workflow is associated with a specific catalog item, the association acts as a filter for item 
variables that appear in the slushbucket of the Catalog Task  activity.

The last place the variables are seen is in the task form that is generated by the Catalog Task 
Item. The variables selected in the slushbucket are the question and answer pairs that appear to 
the user on the task form.

Access and assignment

The Catalog Item Variables are available and assigned to a specific Catalog Task  activity 
(thereby to a specific task) using the slushbucket entry of a catalog task.

The user working the task enters the values of the variables.

To access the values of a Catalog Item Variable inside a script:

var now_GR  = current ; // or create and query a new GlideRecord
var itemVariable  = now_GR. variables [ variableName 
  ] ; //access the service catalog variable identified by the 
 variable name.
var itemVariableValue  = itemVariable. getValue ( ) ;
var itemVariableName  = itemVariable. getName ( ) ;
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var itemQuestion  = itemVariable. getQuestion ( ); //All 
 GlideappQuestion API are accessible on itemQuestion

Workflow events

The system employs two types of events: registered platform events and workflow events.

Registered platform events

Registered events are created in business rules and are used for such tasks as sending email 
notifications when records are inserted into the database. Workflow events are registered within 
workflows only and are not used anywhere else in the platform. Registered platform events can 
be triggered by a workflow for external use, but cannot be used within a workflow.

Workflow events

Workflow events follow different rules than platform events that are registered using the event 
registry. Platform events are entered into the Event Registration [sysevent_register] table 
and are available for platform processes to use. Workflow events are triggered exclusively 
for the workflow engine and are used only to direct the work of executing workflow contexts. 
When an event is registered in a workflow, it is attached to a currently executing activity in the 
registered_events  column of the Workflow Executing Activity [wf_executing] table.

Workflow events also can be broadcast to a workflow from any scripting source that has access 
to the workflow context, such as a script include or a Run Script  activity. In this case, the event, 
such as cancel, is passed to all records in the Workflow Executing [wf_executing] table for a 
specific context.

Whether by registry or by broadcast, an event is handled by the activity definition associated 
with the currently executing activity. Each activity definition comes with a set of handlers. 
For example, most activities come with onExecute, onCancel, and onUpdate  event 
handlers. As an example of a more specific event, the Approval - User  activity also comes with 
onDetermineApprovalState, which is specific to the work of the approval activity.

Multiple parallel events

A single workflow can have multiple event threads running concurrently, such as when a 
workflow has timers that overlap on separate workflow branches. If any additional thread 
completes before the first thread, the system stores event information from the additional thread 
on the Workflow Queued Commands [wf_command] table. After the first thread completes, 
the system retrieves the information stored by the additional thread and proceeds through the 
workflow with the event information from each thread.

Workflow events in the base system

Several workflow events are available in the base system.

Workflow events in the base system

Event Description Purpose To use Source Thread Listeners

activityComplete String value used by 
activity definitions 
to respond to the 
onActivityComplete 
event handler.

Informs records 
in the Workflow 
Executing Activity 
[wf_executing] table 
about the completion 
of other activities in 

If the activity is allowed to 
set the boolean value for 
wf_executing.notify_termination, 
then set the value to true 
(activity.notify_termination = 
true)  during the onExecute  event.

Workflow 
Engine, 
Process 
Terminations

Current 
thread, 
current 
mutex

Join  activity
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Workflow events in the base system  (continued)

Event Description Purpose To use Source Thread Listeners

the same workflow 
context.

otherEvent String value used by the 
Join  activity to respond to 
an otherEvent.

Informs records 
in the Workflow 
Executing Activity 
[wf_executing] table 
about an otherEvent 
that has completed.

The Join  activity transitions from n  number of 
preceding activities. These preceding activities 
all create a wf_executing record, which causes 
a check to see if the record already exists. If the 
Join  already exists, then the Join  created by 
the executing transition sets the wf_executing 
record for deletion.

Join  activity Current 
thread, 
current 
mutex

Join  activity, onOtherEvent 
event handler

timer String value used by 
workflow activities to 
respond to a Timer 
activity that has expired.

Allows wf_executing 
records to be 
informed about a 
timer activity that has 
completed and has 
fired the timer event.

The Timer  activity schedules a job that calls a 
script. The script calls fireEvent (wf_executing, 
timer).

Timer 
activity via a 
scheduled 
job

Worker 
thread, 
private 
mutex

Timer  activity, onTimer  event 
handler

execute String value used by 
workflow activities to 
respond to a Timer 
activity that has expired.

Informs a record in 
the wf_executing 
table with the initial 
state of Executing 
to proceed with its 
primary work.

The workflow engine, for each transition 
executed, creates an executing record with a 
state of Executing. Once created, the executing 
record is put in a queue for processing. For 
each item in the queue, the Rhino globals are 
established, the activity definition that drives 
the executing record is instantiated, and the 
run()  function is called. When the state of a 
record is Executing, this function always calls 
onExecute.

Workflow 
engine, 
via the 
WFActivity 
Handler

Current 
thread, 
current 
mutex

All activities, onExecute  event 
handler

execute (specific to 
Lock)

String value used by the 
Lock  activity to respond 
to a waiting lock that is 
ready to make another 
attempt to obtain a 
specific lock. This execute 
is different than the 
previous execute because 
it is called on a separate 
thread, at specified 
intervals, and is treated as 
an outside event.

Informs a 
wf_executing record 
waiting to execute 
that the specified wait 
interval has passed 
and that it should 
attempt to get the 
lock again.

Lock  activity schedules a job with a script 
that uses the workflow script include's 
fireEvent(wf_executing, 
'execute')  method.

Lock 
activity via a 
scheduled 
job

Worker 
thread, 
private 
mutex

Lock  activity, onExecute  event 
handler

determineApprovalState String value used by 
approval activities to 
respond to a change in 
the overall approval status 
of the current record.

Informs wf_executing 
records for approval 
activities about 
an approval that 
completed and 
triggered the timer 
event.

Approval Coordinator  both registers for 
the event and triggers the event. The child 
approvals have listeners that determine their 
approval state.

Approval 
Coordinator 
triggers 
the event 
during its 
onExecute

Current 
thread, 
current 
mutex

Approval Coordinator, 
Approval - User, and 
Approval - Group  all have 
onDetermineApprovalState 
event handlers. If the state is 
anything but Requested, the 
activity is considered finished, 
and the approval state (Approved, 
Rejected, Cancelled) is set to the 
wf_executing.result  column

cancel (from within 
activity definitions)

String value used by 
workflow activities to 

Informs all 
wf_executing records 

The End  activity uses the global 
workflow.broadcastEvent('cancel') 

End  activity Current 
thread, 

All activities, onCancel  event 
handler
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Workflow events in the base system  (continued)

Event Description Purpose To use Source Thread Listeners

respond to a request for 
cancellation.

in a context that the 
workflow is being 
canceled.

to interrupt the currently running wf_executing 
records. This changes the state of those records 
to Cancelled.

current 
mutex

cancel (outside current 
context)

String value used by 
workflow activities to 
respond to a request for 
cancellation.

This event is 
the same as the 
cancel event above 
and handled the 
same. However, 
the management 
of this event is 
subtly different. 
This event informs 
all wf_executing 
records in a context 
that the workflow is 
being canceled. The 
event is managed 
via the onCancel 
event handler of 
each executing 
activity definition, 
but the event is 
called differently. 
In particular, the 
call to cancel from 
outside an activity 
definition is blocked 
by the current mutex. 
This is a significant 
difference in that 
the event does not 
interrupt a currently 
executing activity 
that is still operating 
within the parameters 
of the current mutex.

Any script can call cancel on a known executing 
context via the workflow script include. For 
example,  var w = new Workflow(); 
w.cancel(context); //where context 
is a GlideRecord of the context to be canceled.

Any script 
include, 
scheduled 
job, UI 
action, or 
other source

Current 
thread, 
private 
mutex

All activities, onCancel  event 
handler

stop (see End  activity) The End  activity checks 
for this event.

If the stop event is 
the current event, 
then the cancel 
operation of the End 
activity is bypassed.

Only in the End  activity. Any script 
can trigger 
or broadcast 
the stop 
event via 
a script 
include or 
workflow 
Run Script 
activity

Current 
thread, 
current 
mutex

This event is used by the End 
activity to exclude the Cancel 
activity and allow a workflow to 
end, even if canceled.

listener String value that the 
workflow (subflow) activity 
triggers as an event.

When a main 
workflow calls a 
subflow, the workflow 
keeps the ID of the 
subflow's context 

The listener event is passed to the parent 
context on completion of a subflow and is 
managed by the onListener action of the 
workflow activity.

Business 
rule that is 
triggered 
by the 
update of 

Current 
thread, 
current 
mutex

This event is used by a subflow 
to inform it's parent flow that it is 
complete. The parent workflow will 
react to this event and continue.
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Workflow events in the base system  (continued)

Event Description Purpose To use Source Thread Listeners

in the scratchpad. 
When the subflow is 
complete, it triggers 
the listener event via 
a business rule.

a workflow 
that has a 
parent

probe_complete String value triggered 
in the workflow by an 
Orchestration activity 
indicating that the MID 
Server has completed a 
task.

The probe_complete 
event is triggered 
from Orchestration 
sensor processors 
via the workflow 
helper function 
handleEventById.

The onProbe_complete  event handler is in 
the WebServiceActivityHandler  and is 
used by most Orchestration activities.

Event used 
to restate 
a workflow 
that is 
waiting for 
the MID 
Server to 
process 
a task or 
activity

Worker 
thread, 
private 
mutex

Orchestration activities

pause String value sent to a 
workflow from an SLA to 
pause the Timer  activity.

When an SLA is 
paused, the SLA 
workflows must be 
paused if there is a 
timer running.

Use is exclusive to the SLA timer SLA Business 
rule 
thread, 
private 
mutex

Timer  activity

resume String value used by the 
Timer  activity to resume a 
paused timer (see pause).

When an SLA is 
resumed, the SLA 
workflows must be 
resumed as well.

Use is exclusive to the SLA timer. SLA Business 
rule 
thread, 
private 
mutex

Timer  activity

Glide events relative to workflows

Workflow uses several Glide events.

Workflow Glide events

Event Description Purpose To Use Source Thread Listeners

Insert Global 
event set 
upon the 
insert of a 
GlideRecord 
that causes 
the script 
engine, and 
through 
that the 
workflow 
engine, to 
wake up.

Starts 
workflows that 
are associated 
with the current 
GlideRecord 
either by 
reference, as in 
request items 
and SLA timers, 
or by conditions 
associated 
with the 
GlideRecord's 
table.

There is no explicit 
customer-facing 
use for this in 
a workflow. It 
is part of the 
Glide engine, 
and with this 
event, the only 
thing workflows 
can do is start. 
Workflows can 
also be started 
manually using a 
script.

Workflow 
Engine, 
RunEngine

Current 
thread, 
current 
mutex

User action 
of insert

Update Global 
event set 
upon the 

Looks to the 
Workflow 
Context 

There is no explicit 
customer-facing 
use for this in 

Workflow 
Engine, 
RunEngine

Current 
thread, 

User 
action of 
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Workflow Glide events  (continued)

Event Description Purpose To Use Source Thread Listeners

update of a 
GlideRecord 
that causes 
the script 
engine, and 
through 
that the 
workflow 
engine, to 
wake up.

[wf_context] 
table to find 
running 
workflows that 
are associated 
with the current 
GlideRecord by 
document ID.

a workflow. It is 
part of the Glide 
engine, and 
with this event, 
the only thing 
workflows can 
do is advance 
through the next 
set of transitions.

current 
mutex

update of a 
GlideRecord

Delete Global 
event set 
upon the 
delete of a 
GlideRecord 
that causes 
the script 
engine, and 
through 
that the 
workflow 
engine, to 
wake up.

Looks to the 
Workflow 
Context 
[wf_context] 
table to find 
running 
workflows that 
are associated 
with the current 
GlideRecord by 
document ID.

There is no explicit 
customer-facing 
use for this in 
a workflow. It is 
part of the Glide 
engine, and 
with this event, 
the only thing 
workflows can 
do is advance 
through the next 
set of transitions.

Workflow 
Engine, 
RunEngine

Current 
thread, 
current 
mutex

User 
action of 
delete of a 
GlideRecord

Query Global 
event set 
upon the 
query of 
the Glide 
database 
that causes 
the script 
engine, and 
through 
that the 
workflow 
engine, to 
wake up.

Looks to the 
Workflow 
Context 
[wf_context] 
table to find 
running 
workflows that 
are associated 
with the current 
GlideRecord by 
document ID.

There is no explicit 
customer-facing 
use for this in 
a workflow. It is 
part of the Glide 
engine, and 
with this event, 
the only thing 
workflows can 
do is advance 
through the next 
set of transitions.

Workflow 
Engine, 
RunEngine

Current 
thread, 
current 
mutex

User action 
of query of a 
GlideRecord

Workflow event-specific functions

There are several functions that relate specifically to workflow events.

Workflow event-specific functions

Function Description Purpose Use Thread Source

registerForEvent 
(eventName)

Function in the workflow environment that 
writes events represented as strings to the 
wf_executing.registered_events 
field.

The workflow events are just strings. 
When an activity that has registered for 
an event executes, a comma delimited 
set of events is stored with the Workflow 
Executing Activity [wf_executing] record. 
When the event is triggered in the workflow 

The global variable workflow that is available 
to all Workflow Activity [wf_activity] records is 
the source of the call. For example, from inside 
a Run Script  activity, a designer can write: 
workflow.registerForEvent('myEventName');

Current 
thread, 
current 
mutex

Global 
variable 
workflow
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Workflow event-specific functions  (continued)

Function Description Purpose Use Thread Source

context, the wf_executing table looks for 
all executing records that contain the 
string that represents the event in the 
wf_executing.registered_events 
field

unRegisterForEvent 
(eventName)

Function in the workflow environment 
that removes a string value representing 
an event that has been written to the 
wf_executing.registered_events 
field.

The workflow events are just 
strings that are written to the 
wf_executing.registered_events 
field. When an activity unRegisters for an 
event, the comma delimited set of events 
stored with the Workflow Executing Activity 
[wf_executing] record is searched, and if 
that string is found, it is removed.

The global variable workflow that is available 
to all Workflow Activity [wf_activity] records is 
the source of the call. For example, from inside 
a Run Script  activity, a designer can write: 
workflow.unRegisterForEvent('myEventName');

Current 
thread, 
current 
mutex

Global 
variable 
workflow

fireEvent 
(eventName)

Function in the workflow environment 
that examines the contents of the 
wf_executing.registered_events 
field, comparing its contents to the 
eventName  passed in.

The workflow events are just 
strings that are written to the 
wf_executing.registered_events 
field. When fireEvent(eventName)  is 
called by a workflow activity, the workflow 
engine queues up any executing records 
that contain the string in the registered 
field.

The global variable workflow that is available to all Workflow 
Activity [wf_activity] records is the source of the call. For 
example, from inside a Run Script  activity, a designer can 
write: workflow.fireEvent('myEventName');

Current 
thread, 
current 
mutex

Global 
variable 
workflow

fireEvent 
(eventRecord, 
eventName)

Function in the workflow environment that 
sends an event to a specific Workflow 
Executing Activity [wf_executing] record. 
The eventRecord  is a GlideRecord of the 
type wf_executing.

This event call expects an onMyEvent 
event handler in the activity represented 
in the event record (Workflow Executing 
Activity [wf_executing] table). When 
fireEvent(eventRecord, 
eventName)  is called by a workflow 
activity, the workflow engine queues up 
the specific executing record with that 
event and passes the event into the activity 
definition for the on<eventName> handler 
to manage. This event is queued up in its 
own mutex, so the current queue completes 
before this event is processed.

The workflow script include contains the call for 
this. For example, from inside a Run Script  activity, a 
designer can write: var w = new Workflow(); 
w.fireEvent(executing, eventName);

Current 
thread, 
current 
mutex

Workflow 
script 
include

fireEvent 
(eventRecordSysId, 
eventName)

Function in the workflow environment that 
sends an event to a specific Workflow 
Executing Activity [wf_executing] record. 
The eventRecordSysId  is the sys_id of 
a GlideRecord of the type wf_executing.

This is the same as the fireEvent  above, 
except that it accepts an ID and returns the 
Workflow Executing Activity [wf_executing] 
record.

The Workflow  script include contains the call for 
this. For example, from inside a Run Script  activity, a 
designer can write: var w = new Workflow(); 
w.fireEvent(executing, eventName);

Current 
thread, 
current 
mutex

Workflow 
script 
include

fireEvent 
(eventRecordSysId, 
eventName, 
optionalJSONObject)

Function in the workflow environment that 
sends an event to a specific Workflow 
Executing Activity [wf_executing] record. 
The eventRecordSysId  is the sys_id of 
a GlideRecord of the type wf_executing.

This is the same as the fireEvent  above, 
except that it accepts a JSON object as a 
third parameter. This object can specify 
any data expressible as JSON. You can 
also specify additional functionality when 
creating a workflow activity.

The Workflow  script include contains the call for 
this. For example, from inside a Run Script  activity, a 
designer can write: var w = new Workflow(); 
w.fireEvent(executing, eventName, 
JSONObject);

Current 
thread, 
current 
mutex

Workflow 
script 
include

broadcastEvent 
(contextId, 
eventName)

Function in the workflow environment that 
sends an event to all currently running 
Workflow Executing Activity [wf_executing] 

This is the same as the fireEvent  above, 
except that it accepts an ID and returns the 
Workflow Executing Activity [wf_executing] 
record.

The Workflow  script include contains the call for 
this. For example, from inside a Run Script  activity, a 
designer can write: var w = new Workflow(); 
w.broadcastEvent(contextId, eventName);

Current 
thread, 
current 
mutex

Workflow 
script 
include

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

5260



Workflow event-specific functions  (continued)

Function Description Purpose Use Thread Source

records in a specified context, regardless of 
their state.

broadcastEvent 
(eventName)

Function in the workflow environment that 
sends an event to all currently running 
Workflow Executing Activity [wf_executing] 
records in the current context, regardless of 
their state.

This should not be confused with 
broadcastEvent  above. This event is 
only available to current Workflow Executing 
Activity [wf_executing] records.

This is available only through the global workflow variable 
of the current context. The following is an example 
of its use from within an activity definition's script: 
workflow.broadcastEvent(eventName)

Current 
thread, 
current 
mutex

Global 
variable 
workflow

Event-specific workflow activities

The following workflow activities trigger events.

Event-specific workflow activities

Activity 
Name

Description Purpose To Use Source Thread Listeners

Create 
Event

Requires an 
event from 
the event 
registry 
rather than 
a workflow 
event. This 
activity is 
located 
in the 
Notification 
category 
of the 
workflow 
tree.

Fires the 
notification 
event 
specified 
in the 
Workflow 
Activity 
[wf_activity] 
table.

1. Navigate to 
System Policy 
> Events  > 
Registry

2. Create an event.

3. Navigate to 
System Policy  > 
Templates  and 
create an Email 
templates .

4. Navigate to 
System Policy 
> Email  > 
Notifications.

5. Create an email 
notification
that is triggered 
by the event 
you created 
and sends the 
template you 
created.

6. On the workflow 
canvas, drag 
the Create 
Event  activity 
onto the canvas 
and associate it 
with the newly 
registered 
event.

Event Registry Triggered in 
the current 
thread and 
handled on 
the worker 
thread in 
notifications. 
Never 
processed 
by a 
workflow

On the notification 
thread, outside of 
workflow
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Event-specific workflow activities  (continued)

Activity 
Name

Description Purpose To Use Source Thread Listeners

When the 
workflow 
executes, the 
event is created 
and the email 
associated with 
the event is sent.

Wait 
for WF 
Event

Listens for 
workflow 
events, as 
described 
in the 
Workflow 
Events in 
the Base 
System 
table, and 
only within 
the current 
context. 
This activity 
is located 
in the 
Conditions 
category 
of the 
workflow 
tree.

Waits for 
another 
transition 
branch of 
the current 
context to 
trigger an 
event.

Takes an event 
name as input. 
When the activity 
is executed, the 
specified event 
name is added 
to a string array 
stored in the 
registered_events 
column. The 
values in this 
column are in a 
list of all events 
the activity waits 
for when it is 
executing.

The Wait for WF Event 
activity has a generic 
onUnhandledEvent 
that tests the current 
event against the value 
that was passed to the 
variable. If they match, 
the Wait for WF Event 
moves the workflow 
forward.

Triggered in 
the current 
thread or 
from a script 
include

The 
onUnhandledEvent 
of the Wait for WF 
Event  activity

Workflow stages

Workflows can indicate workflow progress by updating any field designated as a stage field.

For example, the Incident [incident] table has an Incident state  field that indicates progress, but 
the service catalog uses the Stage  field.

To indicate the workflow's progress through the possible stage values, the interface updates the 
Stage field  selected in the workflow properties. Available fields depend on the table used by the 
workflow. If the field provides a choice list, then the choices are available as stage values for the 
workflow. If the field is a workflow field, it displays an icon to indicate the workflow's progress, as 
with the Service Catalog's Stage  field.
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Service Catalog Stage field with icons

After stages are added to the workflow, they can be assigned to each workflow activity. If an 
activity with an assigned stage is encountered when the workflow runs, the workflow engine 
assigns the stage to the record associated with the workflow context.

For workflows that use the Requested Item [sc_req_item] table, the stage field is automatically 
set to the Stage  field of the table and cannot be changed. The stage state displayed for a 
workflow running on the Requested Item table is based on the state of the workflow activities.

• If an activity is active, then the stage is shown with the state of In progress.

• If an activity is in the Pending  or Completed  state, the stage reflects this state.

• If an activity is canceled, Request Cancelled  appears in the Stage  field. The "Cancelled" label 
set in the wf_stage table is a reserved word, and does not display in the Stage  field.

How stage values are derived

Stage values are derived from various sources in the interface.

Note: 
An updated method for managing workflow stages as a set is also available. For information 
about grouping and reusing stages, see Workflow stage sets.

Stage values are derived from the following sources:

• Choices for Stage column: Choices defined for the column selected as the Stage  column for 
the workflow.

• Default stages for table: Stages defined in the Stage Default [wf_stage_default] table for the 
table selected.

• Workflow-specific stages: Applied only to the workflow for which they were defined in the 
Workflow Stage [wf_stage] table.

• Stage values in existing records: Values from the designated Stage  column in the table 
assigned to the workflow are inherited from existing records.

If the stage field for a workflow is the table column named Stage, then the progress of the 
workflow appears in any list view containing the Stage  column.
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Stages in a list

Stage values shown in the list views are accompanied by the state, based on the workflow 
activities being executed. If an activity has a stage specified for it, and the activity is currently 
active in the workflow, then the stage is shown with a state of In progress. Similarly, if the activity 
is in the Pending  or Completed  state, the stage reflects this state.

Example

If the workflow table is Request Item [sc_req_item], then the stage field is automatically set to the 
Stage  column of that table and cannot be changed. The following stage values for the request 
item are displayed in a choice list from the Dictionary Entry [sys_dictionary] table:

• Waiting for Approval

• Fulfillment

• Delivery

In addition, the Request Item table has the following default stages:

• Request Cancelled

• Completed

Note: 
If an activity is cancelled, Request Cancelled appears in the Stage  field. The "Cancelled" 
label set in the wf_stage table is a reserved word, and does not display in the Stage  field.

When you edit available activity stages in the Workflow Editor, the list displays the following stage 
values:

• Waiting for Approval

• Fulfillment

• Delivery

• Request Cancelled

• Completed

The following diagram depicts the process used to gather stage values from the Request Item 
table to populate the Stages  list in workflow activities.
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Note: 
If you are creating a workflow with a table other than Request Item [sc_req_item], you must 
select a Stage field  in the workflow properties for the workflow to have stages.

Use workflow stages

You can add or modify workflow stages.

Before you begin
Role required: workflow_admin, workflow_creator, or admin

Procedure

1. Navigate to All  > Workflow  > Workflow Editor.

2. Create a new workflow by clicking New  or open an existing workflow.

3. In the Workflow Properties form, if the table is not the Requested Item [sc_req_item] table, 
select a field to display stages in the Stage  field property.

Available fields  depend on the table selected for the workflow.

4. After assigning a list of stages to the workflow, you can set a stage value in any of the workflow 
activities that provide a Stage  field in their dialog box.

Setting a stage value in a workflow activity tells the workflow engine to assign that stage to the 
record associated with the workflow context when the activity is encountered during a run.

When an activity starts with a specified stage, the platform updates the Stage  field with 
the current value. In workflows run against the Requested Item [sc_req_item] table, the 
sc_req_item.stage  field is defined as a workflow type field.
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When displaying the stages for a workflow on the Requested Item [sc_req_item] table, the 
stage state is based on the state of the workflow activities. If an activity has a stage specified 
for it, and the activity is currently active in the workflow, then the stage is shown with an In 
progress  state. Similarly, if the activity is in the Pending  or Completed  state, the stage reflects 
this state.

5. To edit the workflow-specific stages for an existing workflow, click the gear icon in the header 
bar and select Edit Stages.
Again, these stage values are combined with the choices, defaults, and existing values.

Example: Workflow stages

To optimize the use of stages, you can assign a stage to multiple activities in a workflow. For 
example, if your workflow uses the following activities to create tasks:

1. Get approval

2. Order equipment

3. Receive equipment

4. Add equipment to CMDB

5. Set up equipment

6. Install software

7. Configure software

8. Deliver to user

The following stages might be used:

• Approval

• Order
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• Configure

• Deliver

A good practice is to assign stages to the activities as follows:

Examples of stages added to workflow activities

Activity Assigned stage

Get approval Approval

Order equipment Order

Receive equipment Order

Add equipment to CMDB Order

Set up equipment Configure

Install software Configure

Configure software Configure

Deliver to user Deliver

When the Order equipment, Receive equipment, or Add equipment to CMDB  activity is active, 
the Stage  display shows that the Order  stage is In progress.

Add and translate stages

You can add default stages to use for a table, and stages to existing workflow

Add default stages for a table

You can assign a stage set as a default set to any number of tables.

About this task
The stages in the assigned stage set pre-fill the workflow version stages when you create a new 
workflow for the associated table.

Procedure

1. Navigate to All  > Workflow  > Default Stages (by table).

2. Click New.

3. Select a stage Set.
You can create a new set by clicking New, typing a name, and clicking Submit.

4. Select a corresponding Table.

5. Click Submit.

The stages in the selected stage set are automatically added to any new workflows that use 
the corresponding table.

Add a stage to an existing workflow

If a stage required for a workflow has not been imported or is not in the stage set assigned to the 
workflow table, you can add it to the workflow manually.
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Procedure

1. Navigate to All  > Workflow  > Workflow Editor.

2. Open and check out the workflow.

3. In the title bar, click the menu icon and select Edit Stages.

4. In the Workflow Stages list, click New.

5. On the Workflow Stage form, fill in the fields as appropriate.

Do not use a Name  or Value  field value that already exists in the base system.

Workflow stage fields

Field Description

Name The name of the stage as it appears in workflow fields.

Value The value of the stage when it is referenced from elsewhere in the system, such as 
in a script.

Duration The default duration for the stage. Currently not used.

6. Click Submit.

7. Publish the workflow.

Add a stage to a workflow activity

After stages are added to a workflow, you can assign them to the workflow activities.

Procedure

1. Navigate to All  > Workflow  > Workflow Editor.

2. Open and check out the workflow.

3. Double-click the activity.

4. In the Stage  field on the Activity Properties form, find and select the stage to display when the 
workflow reaches the activity.

5. Click Update.

Translate workflow stages

You can provide translations for workflow stage names so the names appear in the language 
selected for the instance.

Before you begin
The instance must already have language internationalization plugins installed. For more 
information, see Activate a language .

About this task
Language-specific text appears in Field types  displayed in a list, workflow stage sets, and 
the Workflow Editor for users with that language selected. Language-specific text does not 
automatically appear when displaying stages on a form. To translate stages on a form, add 
translated text to the workflow field choices.

You can add translated text for any language enabled on the instance. For example, to translate 
workflow stages into French:
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Procedure

1. Set the interface language to French.

2. Navigate to Workflow  > Workflow Editor.

3. Open and check out a workflow.

4. In the title bar, click the menu icon and select Edit Stages.

5. Edit the Name  field for each stage and enter the text to display to French users.

Do not change the Value  field.

6. Confirm that the workflow stages display the French text.

Result
Alternatively, to translate stages for multiple workflows at once, you can directly edit the Workflow 
Stages [wf_stage] table. For example, to translate workflow stages from multiple workflows into 
French:

1. Set the interface language to French.

2. In the application navigation filter, enter wf_stage.list.

3. Edit the Name  field for each stage and enter the text to display to French users. Do not change 
the Value  field.

Workflow stage sets

Stage sets are named groups of workflow stages commonly used together. Create a stage set 
and assign it as a default set to any number of tables. You can import the choice list values of a 
workflow field as stages for a workflow, and export a stage set to create a new one.

A single stage set usually represents a process, such as the stages required to display the 
progress of a service catalog request. You can also assign a stage set as the default set for 
workflows on specific tables.

In an active context, workflow stages provide summary-level feedback about the progress of a 
workflow. Stage icons display the status of each activity as it is being driven by a workflow. The 
system updates a Stage  field, defined in the workflow properties, to indicate the progress of the 
workflow through the possible stage values.

Updates to workflow stage values

During an upgrade, the system makes changes to the Value  field of records in the Workflow 
Stage [wf_stage] table.

• All entries are made lowercase.

• All spaces and special characters are replaced with underscores.

These changes support System Localization  and enable workflows to display translated text in 
the Stage  field.

Create a new stage set

You can create a new stage set by creating a stage set record and adding stage set entries 
manually.

About this task
Create a stage set record only when you want additional stages that are not available on the 
table by default.
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Procedure

1. Navigate to All  > Workflow  > Stage Sets.

2. Click New.

3. Enter a Name  that indicates the purpose of the stage set.

Example 
For example, you can create a Requested Item stage set to hold the stages commonly used by 
inventory tracking workflows or service catalog fulfillment workflows.

4. Click Submit.

5. Open the new stage set record.

6. In the Stage Set Entries  related list, click New.
Each stage set entry can be used as the Stage  for an activity in a workflow that uses this stage 
set.

7. Enter a Name  that indicates the stage name to appear in workflow fields.

8. Enter a Value  to use when referencing the entry, such as in a script.

9. Click Submit.

10. In the Stage Set Entries  related list, ensure that each entry has a unique Order  value.
Enter a low value for stages that should appear early in the workflow and a higher value for 
later stages.

What to do next
The stage set can be added to a workflow or assigned as the default stage set for workflows that 
are created for a specific table.

Use a default stage set

You can assign a stage set as a default set to any number of tables.

About this task
The stages in the assigned stage set pre-fill the workflow version stages when you create a new 
workflow for the associated table.
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Procedure

1. Navigate to All  > Workflow  > Default Stages (by table).

2. Click New.

3. Select a Table.

4. Select the Set  you want to assign to the selected table.

5. Click Submit.

Import stages from a choice list

You can import the choice list values of a workflow field as stages for a workflow.

Before you begin
Create a choice list as follows:

• Add a custom field of Type Workflow  to the table.

• Configure the custom field to use a choice list.

• If you are creating a new field, set the Choice List type  to Display without --None--  and create 
the choices for the newly created field.

For more information, see Create a workflow stage field.

Procedure

1. Navigate to All  > Workflow  > Workflow Editor.

2. Open and check out the workflow.

3. In the title bar, click the menu icon and select Properties

4. In the Workflow Properties dialog box, click the Stages  tab.

5. From the Stage field  list, verify that the correct workflow field is selected.

6. In the Related Links section, click Import Stages from Choice List.

7. In the dialog box asking you to confirm that you want to import the choice list, click OK.

8. Click Update.

What to do next
The stage set can be added to a workflow or assigned as the default set for workflows that are 
created for a specific table.

Export a stage set from a workflow

You can create a new stage set by exporting the stages from an existing workflow as a set, 
instead of manually adding stage set entries to a stage set record.

Procedure

1. Navigate to All  > Workflow  > Workflow Editor.

2. Open and check out the workflow containing stages that you want to export as a new stage set.

3. In the title bar, click the menu icon and select Edit Stages  to open the Workflow Stages dialog 
box.

4. In the Related Links section, click Export to Stage Set.

5. Enter a unique Name  for the new stage set.

6. Click OK.
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What to do next
The stage set can be added to a workflow or assigned as the default set for workflows that are 
created for a specific table.

Add a stage set to a workflow

You can add any number of stage sets to an existing workflow.

About this task
When multiple stage sets have stage set entries with the same Value, the stage appears on the 
workflow only once.

Procedure

1. Navigate to All  > Workflow  > Workflow Editor.

2. Open and check out the workflow.

3. In the title bar, click the menu icon and select Edit Stages  to open the Workflow Stages dialog 
box.

4. In the Related Links section, click Import from Stage Set.

5. Select the stage set.

6. Click Ok.

7. Import additional stage sets as needed for the workflow.

What to do next
After you add all necessary stage sets to the workflow, you can add them to the workflow 
activities. For more information, see Add a stage to a workflow activity.

Create a workflow stage field

Workflows can provide a summary of workflow progress by updating any field of the Workflow 
type. If the field is a workflow field, it displays an icon to indicate the workflow stage progress.

Before you begin
Role required: admin

About this task
In a form, the workflow field displays the current stage as a choice list value.

In a list, the workflow field displays stage icons that represent the series of states, stages, 
phases, or tasks within a workflow. The stage icons are populated using the activity stages from 
the associated workflow. For more information, see Workflow stages.

To create a workflow stage field:
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Procedure

1. Navigate to All  > Workflow  > Default Stages (by table).

2. Right-click near a column header and select Configure  > List Layout.

3. Create a new field in lower right.

4. On the form view of the table used by the workflow, create a field with the Type  set to 
Workflow.
For detailed steps, see Add and customize a field in a table .

5. Click Save.

6. Right-click the field label and select Configure Dictionary.

7. Open a dictionary entry.

8. In the Choice List Specification section of the Dictionary Entries form, select Dropdown with --
None--  from the Choice  list.

9. Click Update.

10. To ensure that the workflow field properly displays stages on the form, define a choice for each 
workflow stage.

◦ To create workflow stages using a choice list that already has choices, you can import the 
stages from the choice list. A stage is created for each choice defined for the Stage field 
selected in the workflow properties. For detailed steps about importing a choice list, see 
Import stages from a choice list.

◦ The Value  of each choice must match the Value  of the corresponding workflow stage.

◦ Do not use spaces in the Value  field for either choices or stages. Use underscores in place 
of spaces.

◦ Make the choice list read-only. If a user changes the stage value for a record from the choice 
list rather than allowing the workflow to control the value, the workflow-driven, legacy, and 
linear renders may not work as intended. You can also use business rules or events to 
ensure the workflow progresses accordingly.

For detailed steps on defining choice lists, see Define an option for a choice list .

11. To see workflow stages as icons, add the field to the list layout of the workflow table.
For detailed steps, see Configure the list layout .

What to do next
After you create or update the workflow field:

• Unless the workflow uses the Requested Item [sc_req_item] table, ensure that the workflow 
field is selected from the Stage field  list in the workflow properties. For detailed steps, see 
Select a stage field. If a workflow uses the Requested Item table, the stage field is automatically 
set to the Stage  field of the table and cannot be changed.

• Work through the workflow. Any other updates made to the workflow field, such as updates 
from business rules or other scripts, can interfere with displaying workflow stages.

Select a stage field

A Stage field  allows the workflow context to show additional workflow information, such as the 
stage name and the estimated completion time for an activity.

Before you begin
Ensure that the workflow field you want to use as the stage field is configured to properly display 
stages. For detailed steps, see Create a workflow stage field.
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About this task
Unless the workflow uses the Requested Item [sc_req_item] table, you can specify which 
field from the workflow table is the stage field. For workflows that use the Requested Item 
[sc_req_item] table, the stage field is automatically set to the Stage  field of the table and cannot 
be changed.

To add or edit a workflow stage field:

Procedure

1. Navigate to Workflow > Workflow Editor.

2. Create or check out the workflow.

3. In the title bar, click the menu icon and select Properties.

4. In the Workflow Properties dialog box, click the General  tab.

5. In the Table  list, verify that the table containing the workflow field is selected.

6. Click the Stages  tab.

7. From the Stage field  list, select the workflow field.

8. Click Update.

Display approvers in workflow stage fields

Enable workflow stage fields to display approvers, change the number of approvers to display, or 
disable displaying approvers.

Before you begin
Role required: admin

About this task
By default, only workflow stage fields that use the Workflow-driven renderer can display a list of 
approvers. Only these workflow stage renderer  types support displaying approvers.

• Linear renderer

• Main flow renderer

• Workflow-driven renderer

Procedure

1. Navigate to All  > Workflow  > Administration  > Properties.
The system displays the Workflow Properties page.

2. Set the following properties.

Property Description

Number of approvers to show if approvers are 
displayed for workflow stages. Only valid for 
supported list v2 renderers.

glide.workflow.renderer.show_approver_limit

Sets the maximum number of approvers to 
display within a workflow stage field. The 
system displays an ellipsis character when 
there are more approvers than the display 
limit allows.

◦ Type: integer

◦ Default value: 5

Show approvers when displaying workflow 
stages with the Linear renderer.

Enables (true) or disables (false) the Linear 
renderer to display approvers.
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Property Description

glide.workflow.renderer.linear.show_approver ◦ Type: true | false

◦ Default value: false

Show approvers when displaying workflow 
stages with the Main flow renderer.

glide.workflow.renderer.mainflow.show_approver

Enables (true) or disables (false) the Main 
flow renderer to display approvers.

◦ Type: true | false

◦ Default value: false

Show approvers when displaying workflow 
stages with the Workflow-driven renderer.

glide.workflow.renderer.workflowdriven.show_approver

Enables (true) or disables (false) the 
Workflow-driven renderer to display 
approvers.

◦ Type: true | false

◦ Default value: true

3. Click Save.

4. Add stages to workflows that have associated workflow stage fields.

Note: 
If you add stages to a subflow, the parent workflow must also have stages.

5. For each approval activity you want to display approvers, select a Stage  value.

Example 
For example, the sample workflow Service Catalog Item Request  has two approval activities. 
The first Approval - User  activity has a Stage  value of Dept. Head Approval. The second 
Approval - User  activity has a Stage  value of CIO Approval.

Result
The workflow stage field renderers you enabled display approvers up to the approver display 
limit. For example, a Workflow-driven stage field displays up to five approvers when the workflow 
reaches an approval stage.

Workflow stage field icons and tooltips

A workflow stage field displays icons to indicate the workflow stage.

Based on the stage renderer selected for the workflow, these icons may display a tooltip with 
additional information.

Workflow field icons

Icon Workflow stage

Current active step

Approval pending

Approval rejected

Complete

Late (Change/Request) or Canceled (Catalog)
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Workflow field icons  (continued)

Icon Workflow stage

Skipped (Catalog only)

Stage tooltips

Based on the stage renderer selected for a workflow, workflow stage icons may display tooltips 
with detailed information about a stage.

Stage renderers and tooltip behavior

Renderer Tooltip behavior

Legacy
When a user points to a stage, the tooltip displays the name of the stage. In the 
expanded view, the activity status appears in parentheses next to the stage.

Other 
renderers When a user points to a stage, the tooltip displays the name of the stage. If the 

stage is a gated approval, the tooltip also shows the name of the approver. In the 
expanded view, the activity status appears in parentheses next to the stage.

If you do not want the approver's name included in the tooltip, navigate to System Properties  > 
Service Catalog  and clear the Show the current pending approver's name in the stage widget 
mouseover  check box.

Property for displaying pending approver's name
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Workflow stage renderers

Workflow stage renderers determine how a workflow displays stages in a workflow field.

There are multiple renderers available.

Note: 
Most workflows should use the workflow-driven renderer. This renderer is used by default 
for all workflows. Use a different stage renderer only after careful consideration and to 
satisfy specific requirements for how the stages appear.

Workflow-driven

Use the workflow-driven renderer as much as possible. This renderer displays icons for stages 
using the stage state controlled by the workflow. Icons are displayed in a way that is meaningful 
for many situations. This renderer can display stages from a main workflow and subflows. The 
order of the icons is determined by the expected path of the executing workflow. As the workflow 
progresses, stages on paths that the workflow did not take are removed from the display. Stages 
from paths other than the expected path are not included unless the workflow follows that path.

The Stage order  field on the Stages  tab has two options:

• Computed  uses the actual workflow path in order

• User-specified  uses the order specified in the Order  column on the Workflow Stages record

Note: 
If the workflow context for a request item has been deleted, the stages for that request item 
can no longer be rendered. This stage history is stored on the workflow context.

Main flow
The main flow renderer displays icons for stages defined in the main workflow only. Use this 
renderer when you do not want to expose the details of the subflows. For example, a single 
main workflow may run several subflows to handle implementation details. The stages in these 
subflows do not provide useful information for the user who starts the workflow, but are useful 
when editing the subflow. In this scenario, using the main flow renderer leads to the best user 
experience. The stage field displays the high-level process of the workflow without exposing 
unnecessary details.

The Stage order  field on the Stages  tab has two options:

• Computed  uses the actual workflow path in order

• User-specified  uses the order specified in the Order  column on the Workflow Stages record

Linear

Linear rendering displays all stage icons from the main workflow and all subflows within a single 
workflow field on a list or form. It displays icons in a linear sequence regardless of the paths the 
workflow follows as it executes. This renderer uses stages defined in both the main workflow and 
any subflows that the main flow launches. The icons appear in the user-specified order. Skipped 
stages do not appear.

Use this renderer when the workflow stages must display in a consistent order and the actual 
details of how the workflow runs are less important. For example, a workflow may revisit or revert 
to previous stages based on one or more Condition Workflow activities. Displaying these loops 
in the stage field does not provide useful information to the user. In this scenario, using the linear 
renderer leads to the best user experience. The stage field displays the predefined process, 
including stages from subflows, in a consistent order.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

5277



For example, you can create a service catalog workflow that uses a subflow to complete delivery 
of the requested item. The following images illustrate the main flow and subflow for ordering 
corporate-branded supplies.

Linear main flow

Linear subflow

The linear renderer displays all these stages in one workflow field. The parent workflow specifies 
the Waiting for approval, Fulfillment, and Completed  stages. The subflow specifies the Delivery 
and Waiting for Task, and Delivery OK  stages.

Progress bar

The progress bar renderer displays a single progress bar instead of a sequence of stage icons. 
This renderer is particularly useful when you want to display the general progress of the workflow 
as a percent. Each stage in the workflow controls an equal percentage of the progress bar. For 
example, if a workflow has 10 stages, reaching each stage causes the workflow field to display an 
additional 10% of the progress bar. Stage names do not appear in the progress bar.

The progress bar renderer provides a way to display the status of a workflow that has a large 
number of stages. Other rendering options may provide a better user experience when 
rendering fewer than four stages in a single workflow.

The Stage order  field on the Stages  tab has two options:

• Computed  uses the actual workflow path in order

• User-specified  uses the order specified in the Order  column on the Workflow Stages record

Workflow field progress bar
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Legacy

The legacy renderer displays stages in the same way as releases prior to Dublin. When an 
instance is upgraded from a release prior to Dublin, all existing workflows are set to use the 
legacy renderer. Whenever possible, use a different stage renderer instead. If you want your 
workflow to maintain pre-Dublin behavior, use the Legacy option. The legacy renderer sometimes 
assigns incorrect data to and/or reports incorrect data from the workflow stage field. If possible, 
we recommend all workflows use the Workflow-driven renderer.

With the legacy renderer, you can create and reference a custom workflow field icon set by 
setting the icons attribute to a new script include. For example, to use the WorkflowIconsSCR 
script include to define which icons to use, add the attribute icons=WorkflowIconsSCR  to 
the Attributes  field of the dictionary entry for the workflow field. To use the default icon display 
behavior, use the attribute icons=WorkflowIconsStages.

The legacy renderer works with all tables except the Requested item [sc_req_item] table. In this 
case, use the requested item renderer instead.

Requested item

The requested item renderer functions the same way as the legacy renderer, but is for use with 
the Requested item [sc_req_item] table.

Only in Now Mobile, default stage renderer is used.

Select a stage renderer

In most cases, the default workflow-driven renderer should be used. If you have specific 
requirements for displaying stages, you can select a different stage renderer.

Before you begin
Consider the following when selecting a stage renderer:

• Use the workflow-driven renderer if possible. This is the default renderer that should be used in 
most cases.

• Use the legacy renderer only if your instance was upgraded from a release prior to Dublin and 
you want your workflow to maintain pre-Dublin behavior.

To use linear, main flow, or progress bar rendering, satisfy the following requirements.

Linear and progress bar renderer requirements

Renderer Requirements

Linear • The parent workflow and all subflows must modify the same current record.

• In the properties for all subflows, the Stage field  value for all subflows must match 
that of the parent workflow.

• The parent flow and all subflows must contain the same stages. Use a stage set to 
ensure the parent flow and all subflows have the same stages.

• On the workflow canvas, each workflow needs only the stages used directly by 
that workflow. It is not necessary to add stages from subflows to activities on the 
parent flow, or stages from the parent flow to activities on the subflows.
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Linear and progress bar renderer requirements  (continued)

Renderer Requirements

Main 
flow

• The workflow contains subflows.

• You do not want or need to reveal the details about the subflows.

Progress 
bar

• The workflow properties must have a Stage ordering  value of User-defined

• There must be workflow stages within the workflow.

• Because stage names do not appear in a workflow field when using the progress 
bar renderer, you can simplify stage names to represent a percentage of the 
workflow. For example, if a process has four main steps, name the workflow stages 
as 25%, 50%, 75%, and 100%. Enter the numerical value of each stage, such as 25, 
in the Value  and Order  fields.

About this task
To select a stage renderer:

Procedure

1. Navigate to All  > Workflow  > Workflow Editor.

2. Open and check out the workflow.

3. In the title bar, click the menu icon and select Properties.

4. In the Workflow Properties dialog box, click the Stages  tab.

5. From the Stage rendering  list, select a stage renderer.

◦ If you are using two workflows to update two unique workflow fields on a single record, both 
workflows must use a non-legacy renderer. You can select a different stage renderer for each 
workflow but do not select Legacy  for either one.

◦ If you want to use the linear renderer, make sure you select Linear  in the properties for the 
parent workflow and all subflows.

6. Click Update.

Workflow fields with deleted records

Workflow fields may indicate when a record required by the workflow is deleted.

After a referenced record is deleted, the reference in the primary record is no longer valid. If the 
stage renderer detects a reference that is no longer valid, the stage field displays a message 
about the deleted record.

Administrators can restore deleted records. For more information, see Use the Deleted Records 
module to restore a deleted record .
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Workflows with missing records

The image shows a list with two workflows. The top request does not have an associated 
request item. The bottom request has an associated request item, but the item does not have an 
associated workflow context.

Workflow validation

Workflow validation examines different characteristics of a workflow to locate issues that might 
prevent the workflow from being published or cause it to fail. The validation report summarizes 
the results of each separate workflow validation.

Validation prevents workflows with critical flaws from executing and resulting in an unstable 
or incomplete state. There are a number of validators in the base system that notify workflow 
designers of potential problems. For example, multiple End  activities, disconnected transitions, 
incorrect table references, missing subflows, and dependencies affected by update sets. 
A workflow validation report displays the results from each validator, including a message 
explaining what was found. The system automatically validates a workflow when you publish it. 
You can also run validation on a workflow directly from controls in the Workflow Editor.

Highlighting critical errors

The graphical Workflow Editor highlights critical errors when a workflow is loaded. In this 
example, a subflow is missing and is not available to the parent workflow for the current user. 
The graphical Workflow Editor indicates the error when the parent workflow loads by highlighting 
(in red) the activity that calls the subflow. To correct the error in the parent workflow, click the 
validate icon in the header bar and inspect the error description in the validation report.

Validate missing subflow

Validations at publishing

If you attempt to publish an invalid workflow or a workflow with potential problems, the system 
displays an error message and blocks the operation, if necessary. When validation error 
messages appear, click the validate icon in the graphical Workflow Editor to see the error report.

Validation warning
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A validation warning notifies you that a potential problem exists in a workflow but 
permits you to publish the workflow. Validation warnings appear when:

• You edit and then attempt to publish a workflow that is included as a subflow in 
another workflow. The system cannot determine how your changes will affect the 
parent workflow and alerts you of the relationship.

• A workflow activity uses a different table than the table assigned to the workflow. 
The system alerts you of the potential conflict.

Validation warning

Validation failure

A validation failure notifies you that a critical error has occurred in the workflow that 
prevents you from publishing the workflow. An example of a critical error is a missing 
subflow.

Validation failure

Workflow validation report

Validators display three notification levels: CRITICAL, WARN, and INFO. The designer can publish 
a workflow that returns WARN or INFO level validation, but not a workflow that returns an overall 
validation level of CRITICAL.
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Workflow validation report

Header summary

The header of the validation report summarizes the entire validation run against the 
specified workflow.

• Validate Summary:  The overall score reflects the most severe notification level 
encountered during the validation.

• Total checks performed:  The total number of validations run is also broken down 
to show the number at each notification level.

Report columns

The body of the report displays the results of each individual validation check that 
was performed. The columns are Type, Level, and Message. You can sort and filter 
these columns as you would any list.

Workflow termination and external dependencies levels

Name Implication

Info Provides information about the current workflow version. An example 
of an information level message is one that names the lowest common 
table in the workflow. Workflows at this validation level are considered 
valid and publishable.

Warning Alerts the user that the validator detected anomalies in the workflow 
that might compromise its ability to execute. An example of a warning 
level message is one that alerts you to a missing activity input transition. 
Workflows at this validation level are considered valid and publishable.

Critical Names a workflow element containing a critical error that prevents the 
workflow from executing successfully. Examples of this are missing or 
invalid subflows and missing transitions. Workflows at this validation 
level cannot be published or run in production.
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Message

The validation message provides a detailed description of the results, including 
table names, update sets, and other specifics.

For the procedure to validate a workflow and generate a validation report, see Validate a workflow

Workflow validator

ServiceNow  offers several workflow validators for workflow designers to test their workflows.

This page lists all available workflow validators. See Workflow validation  for information on using 
workflow validators and the workflow validation report to see the type of information that is 
returned.

Hanging workflows and update sets

Hanging Workflows Update Sets

Identify workflow design decisions that can result 
in a hanging workflow

Identify related artifacts being moved in 
different update sets

ValidateTransitionOut ValidateUpdateSetDependencies

ValidateTransitionIn ValidateUpdateSetParentDependencies

ValidateDanglingTransition ValidateInputVarUpdateSetDependencies

ValidateSubflows

ValidateScriptForCurrentDotUpdate

Workflow termination and external dependencies

Unexpected Workflow Termination External Dependencies

Identify workflows that can end 
unexpectedly

Identify external artifacts that have potential workflow 
dependencies

ValidateSingleEnd ValidateParentFlow

Workflow conflicts

Workflow Properties Conflicts

Identify workflow design decisions that conflict with workflow properties

ValidateLowestCommonTable

ValidateTableChange

ValidateTransitionOut

The ValidateTransitionOut  validator finds activity conditions with no exit transitions.

Validation summary

• Risk: Activity conditions might not transition to the next activity, which could cause the 
workflow to hang.

• Severity Level: Warning

• Valid Result: Valid
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• Valid Message: All conditions have transitions.

• Invalid Result: Invalid

• Invalid Message: This workflow contains <condition count> activity conditions without an 
output transition.

• Suggested Action: If this is a conscious design decision, there is no corrective action. 
Otherwise, find the condition cited in the validator and add an appropriate transition to the 
next activity.

• Publishable: Yes

• Runnable: Yes

• Related Information: None

Troubleshooting

Design choices made when creating a workflow on the canvas might legitimately use an activity 
without an exit condition. In the first example, the Notification  and Timer  activities both execute 
at the start of the workflow. The Timer  is the entity that decides when the workflow ends. In this 
situation, executing the Notification, but not transitioning away, keeps the design simple and 
adds no risk. The validator finds and reports the missing transition from the Notification  activity 
as a Warning  that the designer can ignore.

Condition with no valid transition

In the second example, the Notification  activity has no exit transition. The designer missed this 
because of the layout. The transition from the Timer  activity passes behind the Notification 
activity and appears to connect the exit from the Notification  activity to the End. In workflows 
with more than 10 or 15 activities, it might be difficult to see all the transitions clearly. This 
workflow's designer intended for the Notification  activity to transition to the End.

No condition out

This validator directs the designer to the specific activity and condition that does not have an exit 
transition. The designer then makes the decision whether or not to respond to the warning.
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ValidateTransitionIn

The ValidateTransitionIn  validator finds activities that do not have inbound transitions and 
cannot execute in the workflow.

Validation summary

• Risk:Activities that do not have inbound transitions have no means of being executed in the 
workflow. If other logic builds from these activities, the workflow could hang, with no means of 
moving forward.

• Purpose:  Find activities that do not have inbound transitions.

• Severity Level:  Warning.

• Valid Result:Valid.

• Valid Message:  All activities in this workflow have at least one inbound transition.

• Invalid Result:  Invalid.

• Invalid Message:This workflow contains <activity count> activity conditions without an input 
transition.

• Suggested Action:Either remove the activities to reduce confusion and make the workflow 
easier to understand or provide the appropriate inbound transition.

• Publishable:Yes

• Runnable:Yes

• Related Information:None

Troubleshooting

Although the activities detected in this validator do no harm to the execution of the workflow, 
the designer needs to know that there are activities on the canvas that cannot execute and 
serve no purpose, particularly in a production system. This error is typically caused by a visual 
misinterpretation of the drawing.

This example workflow appears to be perfectly valid. Under closer inspection, however, we 
see that the transition from Set Values  does not stop at Approval - User  (there is no arrow 
end). Instead, that transition goes directly to End. As a result, Approval - User  cannot execute. 
Because there is an activity in the workflow based on the approval's condition routing, it appears 
that the designer intended for the approval to execute and that a correction is needed.

TransitionIn invalid
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This validator directs the designer to the specific activity and condition that has no inbound 
transition. The designer should establish a transition or remove the activity.

ValidateDanglingTransition

The ValidateDanglingTransition  validator finds and reports any transitions that do not terminate 
on an activity.

Note: 
These transitions are not drawn on the workflow canvas, but are still present in the 
database.

Warning: 
This is a critical error that prevents a workflow from running.

Validation summary

• Risk: A workflow with dangling transitions will silently hang a workflow with no recovery options.

• Severity Level: Critical

• Valid Result: Valid

• Valid Message: Valid

• Invalid Result: Invalid

• Invalid Message: Invalid

• Suggested Action: Remove or connect the offending transition. Get the source activity name 
from the validation report details and resolve the issue. Then, run the validation again to test 
your changes.

• Publishable: No

• Runnable: No

• Related Information: None

Troubleshooting

On rare occasions, the destination of a workflow transition becomes null. The workflow canvas 
shows no evidence of the transition, but at run time, the workflow hangs when it encounters one 
of these dangling transitions. If the ValidateDanglingTransition  validator reports this condition 
at publishing time, it blocks the publication action until the issue is resolved. If this condition is 
detected on a runtime check, the workflow is not allowed to execute against a current record's 
transaction. Instead, the system adds a critical log entry detailing the activity with the faulted 
transition to the current record's workflow context. To enable the workflow to execute on the next 
appropriate transaction, remove the faulted transition from the workflow model.

To find and remove the faulted transition:

1. Make note of the workflow version and activity that contains the faulted transition as indicated 
in the validator details.

2. Navigate to Workflow  > Administration  > Workflow Version.

3. In the list of workflow versions, select the workflow that has the faulted transition.

4. On Workflow Version form, add the workflow activities related list. Click the menu icon, select 
Configure > Related Lists, move Workflow Activity-->Workflow Version  from the Available 
list to the Selected  list, and click Save.

5. In the Workflow Activities  related list, select the activity cited in the validator.
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6. In the Workflow Activity form, view the Workflow Transitions  section or tab and identify the 
transition in that list that has no value or a null value in the To  column.

7. Delete this transition.

8. Return to the workflow version and re-run the validation check.

The Critical  warning should disappear. The workflow should execute as expected on the next 
appropriate transaction.

ValidateSubflows

The ValidateSubflows  validator detects any workflows included as subflows that are either 
inactive, deleted, or not available as a published workflow for the current user.

Any of these conditions cause the workflow to hang when the workflow activity in the main flow is 
encountered.

Warning: 
This is a critical error that prevents a workflow from running.

Validation summary

• Risk: A parent workflow that transitions to a deleted subflow hangs indefinitely, with no 
recovery options.

• Severity Level: Critical

• Valid Result: Valid

• Valid Message: This workflow contains <count> valid subflows.

• Invalid Result: Invalid

• Invalid Message: This workflow contains <invalid count> invalid subflow(s) of <total subflow 
count> total subflows.

• Suggested Action: Remove the link in the parent workflow to the questionable subflow, 
examine the subflow to ensure that it is valid and published, or that it is checked out to the 
current user. After making the correction to the state of the subflow, run the validation again to 
test your changes.

• Publishable: No

• Runnable: No

• Related Information: Workflows used as subflows

Troubleshooting

When a workflow runs, regardless of whether it is a subflow or a main flow, the script engine 
determines which version of a workflow should execute, given the current user and workflow 
conditions. When a workflow is checked out by the same user who is running the workflow, the 
checked out version is the version that executes. If the user is not the same person who has the 
workflow checked out, the published version of the workflow executes. If there is no published 
workflow, no workflow runs.

One scenario addressed by the ValidateSubflows  validator is when a workflow:

• Is checked out to User A.

• Is a subflow in a parent workflow being run by User B.

• Has no published alternative to the subflow being run by User B.
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When this occurs, the parent workflow runs to the execution of the unpublished subflow and 
then hangs at that activity, with no means to transition forward. Main flows that encounter this 
condition in a subflow are not permitted to execute against a current record's transaction. 
Instead, a critical log entry detailing the subflow's state is added to the current workflow's 
Workflow Context record. To correct the problem, remove the subflow from the main flow, or 
publish the subflow so it is available to User B. This allows the workflow to execute on the next 
appropriate transaction.

Another scenario addressed by the ValidateSubflow  validator is when a workflow:

• Is a subflow in a parent workflow being run by any user.

• Has no published alternative to the subflow, because the workflow has been deleted or all 
versions of the workflow are unpublished or inactive.

Note: 
You cannot delete a from a list or form workflow that is a subflow. However, you can 
create one of these unstable conditions with advanced scripting, SQL options, or 
incomplete update sets that contain main flows, but not the referenced subflows. When 
troubleshooting a workflow that triggered this validator, consider the history of the subflow 
while assessing the error condition.

ValidateScriptForCurrentDotUpdate

The ValidateScriptForCurrentDotUpdate  validator finds workflow activities with scripts that use 
the current.update()  function.

Calling current.update()  causes significant performance delays in transaction processing 
and might cause an instance to hang.

Validation summary

• Risk: At best, a workflow that uses current.update()  in scripts experiences degraded 
performance. In the worst case, the workflow enters an infinite, recursive loop that crashes the 
server.

• Severity Level: Warning

• Valid Result: Valid

• Valid Message: The JavaScript in this workflow has no instances of 'current.update()'.

• Invalid Result: Invalid

• Invalid Message: This workflow uses 'current.update()' in <count of current.update references> 
JavaScript statements.

• Suggested Action: Remove current.update()  from the activity scripts cited by this 
validator. Workflows execute within a transaction, and current is updated, or possibly inserted, 
at the end of the transaction, as appropriate. There is no need to explicitly update the record 
during the transaction.

• Publishable: Yes

• Runnable: Yes

Problems with current.update()  in workflow scripts

A workflow initiates execution in one of these ways:
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• Script Engine: If a workflow is assigned to a specific table, and given a run condition, the 
workflow runs on INSERT.

• Script: Any business rule, script include, background script, or client script can initiate a 
workflow using the workflow script include and calling startFlow().

The workflow engine initiates a workflow based on the matched criteria of the current record 
being inserted. The transaction for current is managed by the script engine and not the workflow. 
Workflows that progress on the update()  of the current record are not invoked via the workflow 
engine, but as a call from either a client script or business rule. In either case, the script engine is 
invoked, and the current record is put in memory. Edits and modifications to any current fields are 
made and are available to other activities and scripts that are executed in the same transaction.

When appropriate, other engines that run in sequence with the workflow engine, such as 
the business rule engine or field normalization, are invoked against the same current record 
transaction. Any changes made to current through these scripts and activities modify the record 
in memory. These changing values are available for reference in any other transactions called 
from activities and scripts in the same INSERT transaction. When all expected changes are 
executed, the current record is inserted.

When one of these scripts calls current.update()  on a record that has yet to be inserted, 
the action forces an unnecessary and error-prone database transaction. If a record is not yet in 
the database, it cannot be updated. Business rules that trigger on update()  on a record that 
is in the process of being inserted can cause a very unstable and potentially infinite looping 
condition.

Troubleshooting

This validator detects the use of current.update()  in any of the editable script fields. 
Do not call current.update()  from within a workflow script. In the event of an INSERT or 
UPDATE of current, the changes made to current are available to all scripts executing in the 
same transaction, and the script engine stores all changes in the database. Leave the update of 
current to the engine. Use the scripts only for setting and referencing the current field values.

ValidateLowestCommonTable

The ValidateLowestCommonTable  validator reports the lowest table in the Glide hierarchy that 
the workflow uses.

For example, the Requested Item [sc_req_item] table is the lowest table in a workflow containing 
a Catalog Task  activity. This information is significant to a designer who wants to change the 
table against which an existing workflow runs after adding activities to the canvas.

Note: 
This validator provides information only. It does not indicate an error or warning condition.

Validation summary

• Risk: This validator informs only and has no risk associated with it.

• Severity Level: Data/Information

• Valid Result: Valid

• Valid Message: The lowest common table in this workflow is <<table_name>.

• Invalid Result: N/A (informational only)

• Invalid Message: N/A (informational only)

• Suggested Action: None
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• Publishable: Yes

• Runnable: Yes

• Related Information: Workflow activities

ValidateTableChange

The ValidateTableChange  validator reports any activities in the workflow that are invalid given 
the table associated with the workflow version.

For example, a workflow version that is associated with the Change Request [change_request] 
table but has a Catalog Request  activity on the canvas is invalid, since the activity is not 
compatible with the selected table.

Validation summary

• Risk: If the current record at runtime does not originate from the table specified by the lowest 
common table, the activities for the lowest common table cannot set specific values.

• Severity Level: Warning if the table that is associated with a workflow is higher in the table 
hierarchy than the lowest common table required for the workflow activities.

• Valid Result: Valid

• Valid Message: All activities are valid for the newly selected table

• Invalid Result: Invalid Activity

• Invalid Message: This workflow contains <count of invalid activities> invalid activities for the 
newly selected table.

• Suggested Action: Make one of these changes:

◦ Change the workflow to not require the activities associated with the lowest table reported.

◦ Modify the workflow to use a table that contains the lowest common table in its hierarchy.

◦ Ensure that the current record meets the requirements of the at-risk activities.

• Publishable: Yes

• Runnable: Yes

• Related Information: Workflow activities

Troubleshooting

Navigate to Workflow  > Administration  > Activity Definitions. Note the Table  column in the list. 
Each activity that is not global is associated with a table.

When you select a table in the Workflow Properties form, the activity menu presents only 
activities that are compatible with the selected table. Associating a table with a workflow activity 
enables the system to make certain decisions about the activity that affect value comparison, 
condition routing, or the setting and getting of field values in the current record.

When a workflow is set to the Global [global] table, it is possible that the process executing the 
workflow ensures that the current record meets the requirements of the activities identified 
by this validator. In that case, the activity still works as expected. If that assurance cannot be 
guaranteed by the user process, do not use the activity identified by the validator without 
assigning a table that meets the requirements of all the activities on the canvas.

This validation check ensures that the table specified by all the activities in a particular workflow 
is included in the hierarchy of the table selected for the workflow.
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ValidateParentFlow

The ValidateParentFlow  validator reports any workflows that use the workflow as a subflow.

Validation summary

• Risk:  There is no risk in a workflow being a subflow. This is only a warning that other workflows 
are at risk from dramatic changes to a subflow.

• Severity Level:Warning

• Valid Result:  Valid

• Valid Message:  Currently <workflow version name> is not a subflow.

• Invalid Result:  None

• Warning Message:This workflow version (<workflow version name>) is required as a subflow in 
<workflow version count> other workflows.

• Suggested Action:  Exercise caution when modifying things like input parameters and return 
values to assure that parent workflows are not adversely affected.

• Publishable:  Yes

• Runnable:Yes

• Related Information:  Workflows used as subflows

Troubleshooting

The system warns the workflow designer at publishing time and during validation that a workflow 
is a subflow. This warning reminds the designer that changes to the current workflow have the 
potential to affect workflows cited in the validation report or other workflows already running in 
production. Regardless of how simple the change to a workflow that is a subflow, thoroughly test 
all parent flows cited in this validation report before publication.

When a workflow is a subflow, changes that can cause it to become invalid include:

• Changing the data types of input variables. Verify that all parent workflows cited in this 
validation report can pass the correct value type.

• Adding input variables. Verify that all parent workflows cited in this validation report are able to 
pass all variable values into the subflow.

• Changing or removing the return value of a workflow. Verify that any changes to the return 
value of a workflow are compatible with the requirements of all the parent flows.

• Changing the table on which the workflow runs. Verify that the table selection is compatible 
with all parent flows.

Note: 
To delete a workflow that is a subflow, first remove the dependency by removing the 
subflow from all parent flows cited in this validation report. After the dependencies are 
cleared, a user with the proper role can delete the subflow.

ValidateSingleEnd

The ValidateSingleEnd  validator finds and identifies multiple End  activities in a single workflow.

Multiple End  activities in a workflow might be intentional and have no affect on the workflow, or 
might be a mistake that the designer needs to correct.
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Validation summary

• Risk: If the execution paths to the End  activities are not mutually exclusive, then the first End 
encountered completes the workflow and cancels all other executing activities.

• Severity Level: Warning

• Valid Result: Valid

• Valid Message: This workflow contains 1 End activity.

• Invalid Result: Invalid Activity

• Invalid Message: This workflow contains <count of ends> End activities.

• Suggested Action: Remove extraneous End  activities that are not intended as part of the 
design.

• Publishable: Yes

• Runnable: Yes

• Related Information: None

Troubleshooting

As soon as an End  activity is encountered in the workflow, the workflow completes even if there 
are other viable execution paths leading to a second End  activity that is still executing. Those 
executing activities are canceled as part of the End  activity's clean up actions. Therefore, the 
results of designing workflows with multiple Ends  must be carefully considered.

In the case of large workflows, it is often more intuitive to read the workflow when there are 
multiple End  activities. In the following example, the paths to the two Ends  are mutually exclusive 
execution paths. If this was a large workflow, with many activities between Branch  and the 
second End, the value of the multiple ends becomes apparent. Tracing a No  response from User 
is invalid  to a single End  behind 33 other activities would be significantly more difficult. There 
is no risk in this workflow design because there is no reason for other activities to execute if the 
End  after the Notification  activity terminates the workflow.

Mutually exclusive execution paths

The next example has multiple End  activities in execution paths that are not mutually exclusive. 
A Yes  response from User is valid  causes the Set Values  activity to finish immediately. By 
reaching its End  activity first, this execution path cancels the Approval for Apps  and the DB 
Task  activities, which might not be the desired outcome. If the paths are all expected to complete 
before End, the activities should come to a Join  (as in the previous example) that transitions to a 
single End.
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Mutually inexclusive execution paths

Note: 
To add the second End, right-click to copy the original End  activity and paste it onto the 
canvas. In most cases, a single End  is the best and most reliable way to ensure that all 
activities expected to execute prior to workflow completion, do so successfully.

ValidateUpdateSetDependencies

The ValidateUpdateSetDependencies  validator identifies all the subflows called in the current 
workflow and determines if any of those subflows are being edited in a different (in progress) 
update set.

This warning informs the user that this workflow and one or more of its dependencies are being 
actively modified in a way that will not deploy concurrently to another instance without additional 
effort.

For information about update sets, see Create and select an update set .

Validation summary

• Risk: If a parent workflow is edited in one update set and its dependent subflow is edited 
in another, the two workflows might not be compatible when moved to a different instance. 
Making independent changes, such as to common or expected values, can make the two 
workflows incompatible.

• Severity Level: Warning

• Valid Result: Valid

• Valid Message: There were no Update Set dependency issues found.

• Invalid Result: Invalid

• Invalid Message: This workflow has dependent workflows that are in a different update set.

• Suggested Action: Modify and deploy both workflows in the same update set. If you must 
modify dependencies in separate update sets, use one of these methods:

◦ Ensure that all update sets migrate concurrently.

◦ Prior to deploying the main flow update set, merge the dependencies into one update set 
before completing that update set.

• Publishable: Yes
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• Runnable: Yes

• Related Information: Workflow movement with update sets

Troubleshooting

A workflow is added to an update set only when the workflow is published. This validator issues a 
warning when either of the following conditions exist:

• A published subflow is in a different update set than the parent workflow and that update set is 
In progress.

• A subflow is checked out by another user, who is working in a different update set than the 
current user.

Note: 
This validator does not look for update sets that have been closed. It looks only at update 
sets that are In progress or at the update sets of all subflows being used by the current 
workflow that are checked out to users who are working in a different update set.

Example

Following is an example of an at-risk development scenario in which two users create 
dependencies between workflows in different update sets.

User A:

1. Sets Update Set A to the current update set.

2. Checks out Workflow A.

3. Changes the return value of the String  type in Workflow A to a Reference/User  type.

4. Publishes Workflow A, causing an entry into Update Set A.

User B:

1. Sets Update Set B to the current update set.

2. Checks out Workflow B.

3. Includes Workflow A as a subflow.

4. Uses the user reference return value from Workflow A as an approval assignment.

5. Publishes Workflow B, causing an entry into Update Set B.

Risks

• User B moves Update Set B to a different instance that has an older version of Workflow A. The 
return value is not a user reference, which causes the outcome of Workflow B to be different 
than it was when tested in development.

• User B moves Update Set B to a new instance that does not have a version of Workflow A. 
Workflow B experiences a validation failure at runtime and cannot execute. A log entry is 
added to the workflow log of the current record.

Possible solutions

Solution 1
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Migrate the parent workflow and all dependent workflows to a new instance together using the 
same update set.

1. Set the update set to the one you want to migrate to new instances.

2. Check out and republish the workflows that need to be included, this action forces an entry 
into the current update set.

3. Complete the update set with all dependencies.

4. Follow standard procedures for migrating update sets to local instances.

Solution 2

Move dependent workflows between update sets.

1. Identify the update set containing the main workflow to be migrated.

2. Navigate to System Update Sets > Local Update Sets.

3. Find and select the update set that contains the dependencies to the main workflow.

4. In the Customer Updates  related list, select the workflow version of the subflow you want to 
move.

5. Select the update set containing the parent workflow in the Update set  field. If this field is not 
on the Customer Update form, configure the form and add the field.

6. Click Update  and the base system moves the dependent subflow to the update set selected.

7. Repeat steps 4-6 to add additional dependent subflows to the parent flow update set.

ValidateUpdateSetParentDependencies

The ValidateUpdateSetParentDependencies  validator identifies all the workflows that call the 
current workflow as a subflow and determines if any of those parent workflows are being edited 
in a different update set that is in progress.

This warning informs the user that this workflow and one or more workflows that depend on 
this workflow are being actively modified in a way that will not deploy concurrently to another 
instance without additional effort.

Validation summary

• Risk: If a parent workflow is edited in one update set and its dependent subflow is edited 
in another, the two workflows might not be compatible when moved to a different instance. 
Making independent changes, such as editing common or expected values, can make the two 
workflows incompatible.

• Severity Level: Warning

• Valid Result: Valid

• Valid Message: There were no Update Set dependency issues found.

• Invalid Result: Invalid

• Invalid Message: This workflow has dependent workflows that are in a different update set.

• Suggested Action: Modify and deploy both workflows in the same update set. If you must 
modify dependencies in separate update sets, use one of these methods:

◦ Ensure that all update sets migrate concurrently.

◦ Prior to deploying the main flow update set, merge the dependencies into one update set 
before setting that update set to complete.

• Publishable: Yes
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• Runnable: Yes

• Related Information: Workflow movement with update sets

Troubleshooting

A workflow is added to an update set only when the workflow is published. This validator issues a 
warning when either of the following conditions exist:

• A published subflow is in a different update set than the parent workflow and that update set is 
In progress.

• A subflow is checked out by another user, who is working in a different update set than the 
current user.

Note: 
This validator does not look for update sets that have been closed. It looks only at update 
sets that are In progress or at the update sets of all parent workflows that call the current 
workflow and are checked out to users who are working in a different update set.

Example

Following is an example of an at-risk development scenario in which two users create 
dependencies between workflows in different update sets.

User A:

1. Sets Update Set A to the current update set.

2. Checks out Workflow A.

3. Changes the return value of the String  type in Workflow A to a Reference/User  type.

4. Publishes Workflow A, causing an entry into Update Set A.

User B:

1. Sets Update Set B to the current update set.

2. Checks out Workflow B.

3. Includes Workflow A as a subflow.

4. Uses the user reference return value from Workflow A as an approval assignment.

5. Publishes Workflow B, causing an entry into Update Set B.

Risks

• User B moves Update Set B to a different instance that has an older version of Workflow A. The 
return value is not a user reference, which causes the outcome of Workflow B to be different 
than it was when tested in development.

• User B moves Update Set B to a new instance that does not have a version of Workflow A. 
Workflow B experiences a validation failure at runtime and cannot execute. A log entry is 
added to the workflow log of the current record.

Possible solutions

Solution 1
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Migrate the parent workflow and all dependent workflows to a new instance together using the 
same update set.

1. Set the update set to the one you want to migrate to new instances.

2. Check out and republish the workflows that need to be included.

Note: 
This action forces an entry into the current update set.

3. Complete the update set with all dependencies.

4. Follow standard procedures for migrating update sets to local instances. For information about 
update sets, see System update sets .

Solution 2

Move dependent workflows between update sets.

1. Identify the update set containing the main workflow to be migrated.

2. Navigate to System Update Sets  > Local Update Sets.

3. Find and select the update set that contains the dependencies to the main workflow.

4. In the Customer Updates  related list, select the workflow version of the subflow you want to 
move.

5. Select the update set containing the parent workflow in the Update set  field. If this field is not 
on the Customer Update form, configure the form and add the field.

6. Click Update. The base system moves the dependent subflow to the update set selected.

7. Repeat steps 4-6 to add additional dependent subflows to the parent flow update set.

ValidateInputVarUpdateSetDependencies

The ValidateInputVarUpdateSetDependencies  validator examines update sets to ensure that 
workflow input variables for a given workflow have not been deleted in different update sets than 
those currently In progress.

Validation summary

• Risk: Workflows and their input variables are not moved together in a single update set. The 
deletion of input variables is captured in a different update entry. If these two entries are not in 
the same update set, the workflow execution can be unstable.

• Purpose: Determine whether input variables that belonged to this workflow were deleted in a 
different update set.

• Severity Level: Warning

• Valid Result: Valid

• Valid Message: There were no Input Variable Update Set dependency issues found.

• Invalid Result: Invalid

• Invalid Message: There are input variables that have been deleted and logged in a different 
update set.

• Suggested Action: If the deletion is not intended to be separate from the workflow, ensure that 
both update sets are committed concurrently to the new instance, or merge both payloads into 
a single update set.

• Publishable: Yes
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• Runnable: Yes

• Related Information: Workflow movement with update sets

Troubleshooting

Workflow input variables get individual entries in the Customer Update  related list in the 
current user's update set. This validator reports to the user when workflow input deletions have 
happened in an update set other than the current user's update set.

Follow the instructions for Input variable removal  when the validator issues this warning.

ValidateWorkflowEndStages

The ValidateWorkflowEndStages  validator checks that in workflows with stages, the end activity 
of the workflow has a stage named Complete or Completed.

If the workflow has stages associated with it, but does not have the completed stage on the end 
activity, then the stage indicator will not show that the workflow completed.

Validation summary

• Risk: The stage indicator will not show the workflow is completed.

• Severity Level: Warning

• Valid Result: Valid

• Valid Message: Workflow end stages are valid.

• Invalid Result: invalid

• Invalid Message: End activity A found with invalid stage "S."

• Suggested Action: If this is not by design, make the appropriate changes.

• Publishable: Yes

• Runnable: Yes

• Related Information: Workflow activities

Troubleshooting

Check the workflow for an end activity. Ensure that this activity assigns a stage named Complete 
or Completed.

ValidateWorkflowStageColumn

The ValidateWorkflowStageColumn  validator detects and reports when the stage field (stage 
column) for a workflow is not correct or is unusable.

Validation summary

• Risk: The stage indicators may not display appropriate information.

• Severity Level: Warning

• Valid Result: Valid

• Valid Message:Workflow stage values are valid.

• Invalid Result: Warning

• Info Summary: Stage warnings found.

• Invalid Messages:
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◦ Table T does not have a column named C.

◦ Workflow for table T has stages, but no stage column.

◦ Table T has a stage column "C," but no stages are set by activities.

◦ Workflow on table T has stage column "C" that is not type=workflow.

• Suggested Action: If this is not by design, make the appropriate changes.

• Publishable: Yes

• Runnable: Yes

• Related Information: Workflow activities, Workflow stages

Troubleshooting

To check the stage column:

1. Open and check out a workflow.

2. Open the workflow version properties dialog by clicking the menu icon and selecting 
Properties.

3. View the Stages  tab or section.

4. Check that the assigned stage column is actually a column in the table to which the workflow is 
associated.

5. Check that the column is type=workflow.

Tip: Stage columns should not be choice lists. If they are, the list appears read-only in form 
views, since changing that column value outside the workflow engine does not ensure safe 
tracking of stage states.

ValidateWorkflowStateValues

The ValidateWorkflowStateValues  validator checks a number of stage aspects in workflow 
activities for correctness.

This validator has multiple possible error messages.

Validation summary

• Risk:  The stage indicators may not display appropriate information.

• Severity Level:  Warning

• Valid Result:  Valid

• Valid Message:  Workflow stage values are valid.

• Invalid Result:  invalid

• Warning summary:  Stage warnings found.

• Invalid Messages:

◦ Stage with empty name is not allowed.

◦ Stage with empty value is not allowed.

◦ Cannot have more than one stage with the same name: x.

◦ Cannot have more than one stage with the same value: y

• Suggested Action:  If this is not by design, make the appropriate changes.

• Publishable:  Yes
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• Runnable:  Yes

• Related Information:  Workflow activities

Troubleshooting

Use the following procedure to troubleshoot this validator:

1. Open and check out a workflow.

2. Open the list of stages for the workflow by clicking the menu icon and selecting Edit Stages.

3. Check the names and values.

Ensure that the names and values are unique and are not empty.

4. If the same stage name or value apprears more than once, remove one of the rows. It is then 
very important to go through the workflow and reassign stages in the activities that used the 
removed stage.

Validate Workflow State Values

Tip: Make a list of which activities assign which stages.

Workflow concepts

You can do many things using the Workflow Editor.

• Modify core activities  and exit conditions.

• Create custom activities and reuse the data for other workflows.

See Orchestration activity designer.

• Download activity packs from the ServiceNow  Store and create packs for upload.

• Edit workflows  graphically.
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• Define transitions  between workflow activities.

• For the table that corresponds to the workflow, customize business rules.

• Summarize workflow progress through stages.

• Validate workflows  to identify potential problems.

• Publish workflows  for other users.

• Edit multiple tables  without needing to directly modify them.

Workflow versions

To prevent users from making changes to a workflow that affect other users of the system, 
workflows must be checked out before they can be edited.

Only one user can check out a workflow at a time. When a workflow is checked out, changes 
apply only to the user who has the workflow checked out. Other users can continue to use the 
published workflow. After the changes are complete, the workflow can be published so that it is 
available to all users.

Note: 
Because each workflow has a unique sys_id, different workflows can have the same name. 
This is typically expected in a domain-separated environment where users in different 
companies cannot see each other's workflows because they are in different domains. 
However, this can lead to confusion in other environments. In general, give each workflow a 
unique name to prevent workflow designers from making changes to the wrong workflow.

When a new version of an existing workflow is published, the changes are not applied to running 
workflow contexts. Any currently running workflow context continues using the workflow version 
that was available when the workflow started. The next time the workflow runs, it uses the 
updated, published version.

Workflow scope

Workflow application scope determines the access that an application has to the information in a 
workflow, specifically to the data contained in the activities in that workflow.

When a workflow is created, it inherits the application scope from the gear menu for the logged in 
user. This scope cannot be changed in the Workflow Editor. When the workflow executes, it runs 
in this scope and can only be called from a different application if the workflow’s accessibility 
setting permits access to all scopes (public). Otherwise, the workflow’s application scope is 
private to the application.

Note: 
Any script that is created in the Workflow Editor, such as an advanced script in an If  activity, 
runs in the scope of the workflow. All core activities provided in the base system or for 
Orchestration run in the scope of the workflow.

Custom activities run in their own scope, even if it is different from that of the workflow. The 
scope of a custom activity can be private or public. Any script that runs inside a custom activity 
with a scope can only access outside artifacts that are within the scope of that activity or artifacts 
that are configured to run in any scope. Conversely, an outside artifact can only access the script 
inside that private activity if the outside artifact is running in the same scope. Activities with 
public scopes can interact with outside artifacts in any application scope.

You can use private activities as part of a workflow that has a public application scope. These 
activities are protected from reaching outside of the workflow or from being reached from outside 
the workflow. For details about setting application scoping for custom activities, see the field 
description table for the appropriate activity template.
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Note: 
Custom activities uploaded to the ServiceNow  Store must be configured as accessible to all 
application scopes.

Workflow scope restrictions

There are some restrictions to public and private application scopes.

During runtime, publicly scoped workflows can access other application resources, as long as 
these resources are set to be accessible to all application scopes. Privately scoped workflows in 
a private application scope can only access resources private to its scope. Due to scope access 
boundaries, any privately scoped workflows that make calls out to other scoped resources fail 
with either an exception or a hung activity while waiting for returned results. This occurs when 
making calls to these common global resources:

• ECC queues

• Tasks

• Approvals

• Events

• SLA timers

• Timers

• Script includes

• Business rules

• Workflow APIs

As you design workflows, validate the visibility and accessibility of all resources prior to 
deployment.

See Application scope .

For information on how to configure the scope for a workflow, see Workflow properties.

Domain separation and Workflow

Domain separation is supported in the Workflow  application. Domain separation enables you to 
separate data, processes, and administrative tasks into logical groupings called domains. You 
can control several aspects of this separation, including which users can see and access data.

Support level: Standard*

• Includes Basic  level

• Business logic: Processes can be created or modified per customer by the service provider. 
The use cases reflect proper use of the application by multiple service provider customers in a 
single instance.

• The owner of the instance needs to be able to configure MVP business logic and data 
parameters per tenant as expected for the specific application.

Use case: As an admin, I need the ability to make comments mandatory on close of a record for 
one tenant, but not for another.

Overview

When domain separation is enabled, workflows and workflow activities inherit the domain of the 
user who publishes or creates them.
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How domain separation works in the Workflow  application

While workflows are managed by multiple tables, only the following tables are used for domain 
separation features:

• Workflow [wf_workflow]  and Workflow Version [wf_workflow_version]: used for Process 
administration  or process separation.

• Workflow Context [wf_context]: used for Understanding domain separation .

Note: 
The Workflow Version table [wf_workflow_version] table does not contain a domain field; 
Workflow Version records inherit their domain from the parent Workflow record.

The Workflow Editor displays a workflow's domain in the title bar after the workflow name.

Workflow editor domain

Related topics

Domain separation for service providers

Workflows and delegated administration

Delegated administration allows child domains to inherit workflows from higher up the domain 
hierarchy and to override them with domain-specific versions if necessary.
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Workflow and delegated administration

Workflow records in the Workflow [wf_workflow] and Workflow Version [wf_workflow_version] 
tables are considered processes. A user in a child domain may check out but not copy a 
workflow from a parent domain. When a user in a child domain checks out a workflow from a 
parent domain, the system creates a version of the workflow in that user's domain. This new 
version is a unique record in the Workflow [wf_workflow] table. After the user publishes this new 
workflow, other users in the child domain use the new workflow, which overrides the workflow 
from the parent domain. The original workflow in the parent domain is no longer visible to users 
in the child domain.

For example, a managed service provider (MSP) hosts ITSM services for several companies, 
including ACME and Initech, on a single instance. As administrators, the MSP creates a Change 
Request - Emergency workflow that applies to all domains because it was created in the TOP 
domain, which is the highest domain in the domain hierarchy. This workflow overrides the global 
Change Request - Emergency workflow and specifies that emergency change requests require 
approval from the CAB approval group. Because of delegated administration, every domain in 
the hierarchy sees and uses this workflow. Now suppose the ACME domain requires a different 
approval policy where emergency change requests require approval from the emergency CAB 
approval group. The MSP creates another version of the Change Request - Emergency workflow 
in the ACME domain. This workflow overrides the version in the TOP domain and only applies to 
users in the ACME domain.

Workflow permissions

When a user starts a new workflow, the workflow runs with that user's domain and credentials.

The workflow preserves a user's domain and credentials until an activity causes the workflow to 
wait, such as an approval activity waiting for approval or rejection. When the stopped workflow 
resumes, such as when a user approves a request, the workflow uses the credentials of the 
approving user, but continues to run within the domain of the original user.
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Workflows and data separation

Data separation restricts workflow contexts to users who are either in the same domain of the 
workflow or are members of a parent domain.

Workflow and data separation

Workflow records in the Workflow Contexts [wf_contexts] table are considered data. Data 
separation restricts workflow contexts to users who are either in the same domain of the 
workflow or are members of a parent domain. While a user in a parent domain can see running 
workflows in a child domain, a user in a child domain cannot see running workflows in a parent 
domain. If necessary, administrators can use visibility or contains domains to expand who can 
see domain-specific data.

For example, when an ACME user requests something from the service catalog, a Service 
Catalog Request workflow context is created in the ACME domain. Similarly, a service catalog 
request from an Initech user creates a workflow context in the Initech domain. An MSP user in 
the TOP domain can see both workflow contexts because it is the parent domain for both the 
ACME and Initech domains. However when an ACME or Initech user logs in, data separation 
prevents them from seeing each other's service catalog requests. This is expected behavior 
because each workflow context contains data specific to that domain, such as the item 
requested and the request's approval history.

Workflow engine operation order

The workflow engine runs in a predefined order relative to business rules and database 
operations. It caches commonly-used published workflows to improve performance.

The Run after bus. rules run  workflow property defines if a workflow is Default  or Deferred.

The diagram below shows the workflow engine order of operations and when Default and 
Deferred flows are executed. For a more general overview of engine operation order, see 
Execution order of scripts and engines .

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

5306

https://www.webstg.servicenow.com/docs/access?context=r_ExecutionOrderScriptsAndEngines&version=washingtondc&pubname=washingtondc-application-development&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=r_ExecutionOrderScriptsAndEngines&version=washingtondc&pubname=washingtondc-application-development&ft:locale=en-US
https://www.webstg.servicenow.com/docs/access?context=r_ExecutionOrderScriptsAndEngines&version=washingtondc&pubname=washingtondc-application-development&ft:locale=en-US


Workflow engine order diagram

Workflow caching

The workflow engine caches commonly-used published workflows to improve performance.
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Caching significantly reduces the number of database queries per workflow. By default, the 
engine caches up to 300 unique workflow versions. Caching very large workflows may reduce 
this number as the cache size cannot exceed the Java Virtual Machine (JVM) heap size.

To change the maximum number of cached workflow versions, navigate to Workflow  > 
Administration  > Properties  and modify the value of the The max number of models that will be 
concurrently held in the LRU cache  (glide.workflow.model.cache.max) property. You 
must restart the instance to apply this change.

Workflow tables

For full flexibility, workflows store information over a number of different tables.

Usually tables containing workflow information are not edited one-by-one. Instead, use the 
Workflow Editor to edit workflows. The following lists are provided for reference purposes.

Workflow tables

Table Description

Workflows

Column Renderer 
[column_renderer]

A renderer widget for a stage column. Stage renderers are 
written in Jelly as a UI Macro. The default is Workflow-Driven; it 
covers most workflow related stage scenarios.

Version [wf_versionable] Tracks different versions of element definitions 
[wf_element_activity].

Workflow [wf_workflow] The primary records of workflows.

Workflow Binding 
[wf_workflow_binding]

History of workflows run and the triggering record. Workflow 
Binding records prevent the system from running workflows 
again when the associated Workflow Context record has been 
deleted.

Workflow Context [wf_context] Individual instances of a workflow being used.

Workflow Execution 
[wf_workflow_execution]

Synthetic "current" records for workflows that run on Global.

Workflow Instance 
[wf_workflow_instance]

Connections of workflows to subflows.

Workflow Version 
[wf_workflow_version]

Particular versions of a workflow, either published versions or 
versions that have been checked out.

Activities

Activity Designer 
[wf_element_activity]

Custom activity definitions.

Activity Variables 
[wf_activity_variable]

Variables for activities.

Workflow Activity [wf_activity] Activities as they are being used in workflows.

Workflow Activity Definition 
[wf_activity_definition]

Definitions of activities that can be used in a workflow.

Workflow Executing Activity 
[wf_executing]

Individual instances of activities being performed in active 
contexts.

Workflow components
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Workflow tables  (continued)

Table Description

Element Provider 
[wf_element_provider]

Template definitions for custom activities.

Group approval 
[sysapproval_group]

Group-level approvals.

Variable [item_option_new]

Workflow Condition 
[wf_condition]

All of the defined conditions in workflows.

Workflow Element Definition 
[wf_element_definition]

Parent table for activity definitions.

Workflow Estimated 
Runtime Configuration 
[wf_estimated_runtime_config]

Runtime performance data for completed workflows.

Workflow Queued Command 
[wf_command]

Temporary internal storage for workflows that are currently 
executing.

Workflow SC Variable 
[wf_variable]

The Service Catalog variables for a workflow.

Workflow Schedule 
[wf_workflow_schedule]

Definitions of the times to run specific workflows.

Workflow Timing 
[wf_workflow_timing]

Timing performance data for workflows.

Workflow Transition 
[wf_transition]

All of the defined transitions in workflows.

History

Workflow Activity History 
[wf_history]

The history of executed activities.

Workflow Log Entry [wf_log] All of the events and history of the workflow.

Workflow Transition History 
[wf_transition_history]

The history of executed transitions.

Stages

Stage Default 
[wf_stage_default]

Definitions of default stage fields for tables to use.

Stage Set [stage_set] A named set of stages that can be used to populate workflow 
stages for multiple workflows.

Stage Set Entry 
[stage_set_entry]

The stages that belong to a named stage set.

Stage Set for Table 
[stage_set_table]

Defines a relationship of a stage set to a table so that the stage 
set can be used as the default stages when a new workflow is 
created for the table. This replaces the wf_default_stage table 
and is the view that shows when you click Default Stages (by 
table)  in the menu.

Workflow Stage [wf_stage] Definitions of stages used by workflows.
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Workflow administration

Tailor workflows exactly the way you want them.

Workflow roles

Certain roles are required to use workflows.

To learn more about managing subscriptions, see Managing per-user subscriptions in 
Subscription Management  and contact your account representative.

Workflow roles

Role title [name] Description

Activity creator

[activity_creator]

Creates and edits custom workflow activities, reuses custom activity 
data, and manages activity packs downloaded from the ServiceNow 
Store.

Web service 
administrator

[web_service_admin]

Accesses and uses REST and SOAP messages in the Orchestration 
activity designer. Creates and edits custom activities that use the REST 
web service and SOAP web service templates.

Workflow 
administrator

[workflow_admin]

Checks out, creates, edits, publishes, and deletes graphical workflows.

Warning: 
Granting this role to a user is equivalent to giving the user the 
admin role, because workflow Script activities bypass access 
controls and grant access to all tables and database operations. 
Script activities do not bypass application scope settings.

Workflow creator

[workflow_creator]

Checks out, creates, edits, and deletes graphical workflows.

Warning: 
Granting this role to a user is equivalent to giving the user the 
admin role, because workflow Script activities bypass access 
controls and grant access to all tables and database operations. 
Script activities do not bypass application scope settings.

Workflow publisher

[workflow_publisher]

Checks out with force checkout option, validates, publishes, and deletes 
graphical workflows.

Administering workflow contexts

The workflow context performs the activities and transitions defined in the workflow with the new 
record as current.

Workflow in ServiceNow names a running workflow a Workflow Context. The Workflow Context 
maintains the state of the overall process in the Workflow Context record. The Workflow Context 
maintains the state of the individual activities as they execute in a series of related lists. These 
lists maintain the state of currently executing activities, the result of finished activities, and the 
execution path the workflow took through the process model.
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The Workflow Context canvas provides a visual representation of the execution path the 
workflow took through the process model. The state of each activity (finished, executing, 
cancelled, error) is represented using the color palette. The executed paths are represented 
in the color blue; the non-executed paths are represented in grey. Active and historic workflow 
contexts, as well as the activities within them, can be viewed using the Live Workflows section of 
the Workflow application menu.

Viewing a workflow context

Workflow contexts can be found in two places:

• From the Workflow Context  related link on the form of the task being powered by the workflow.

• By navigating to Workflow  > All Contexts  and selecting an active context.

Displaying workflow progress

Two related links on the Workflow Context form allow you to view the progress of a workflow in 
different formats.

• Show Timeline  displays the workflow context as a timeline.

• Show Workflow  displays the workflow context in the graphical Workflow Editor.

Graphical interface

To view the workflow context in the graphical Workflow Editor interface, click the Show Workflow 
link from either the workflow context record or the current record.

Show workflow

In the top right hand corner are two controls:

Refreshes the workflow context.
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(continued)

Displays a key of the colors used in the 
workflow to denote the state of activities and 
transitions:

Execution order

View tooltip text in the workflow context graphical view to see the execution order of individual 
activities.

In Workflow  > Live Workflows  > Active Contexts  or All Contexts, Open the context you want to 
examine. Click Show Workflow, and point to a finished or executing activity. The tooltip shows 
error data, execution time, and the order in which the activity executed in the workflow. Use this 
data to help troubleshoot activities in an error state.
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Execution order workflow

Cancel a workflow

Canceling a workflow stops the workflow from executing and sets the workflow context State  to 
Canceled. To cancel an executing workflow, you can use the cancelContext(context) 
script. You can define an onCancel script to clean up unresolved workflow activities.

Before you begin
Role required: admin or workflow_admin

About this task
Canceling a workflow attempts to stop the workflow gracefully by injecting a cancel command 
into the workflow engine.

Procedure

1. Navigate to All  > Workflow  > Active Contexts.

2. Select a workflow context record.

3. Configure form layout to add On-cancel script  field to form.
For detailed information about configuring form layout, see Configuring the form layout .

4. Select the Cancel  related link.
A confirmation appears.
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5. Click OK.
The workflow engine attempts to cancel the workflow gracefully.

If the workflow does not respond to the cancel command, the Force Cancel option appears.

6. Click Force cancel  to interrupt the thread the workflow is actively executing or click Continue 
waiting  to continue waiting for the workflow to cancel gracefully.

Warning: 
Whenever possible, allow a workflow to cancel gracefully. Forcing a workflow to cancel 
can leave related workflows and scripts in an unresolved state. You can use an on-cancel 
script to clean up unresolved artifacts from a cancelled workflow.

Cancel a workflow with the cancelContext(context)  script

To cancel an executing workflow, you can use the cancelContext(context)  script. This 
script can be useful in cases where a workflow must be canceled in response to an event or 
where a user must manually cancel a workflow.

Before you begin
Role required: admin
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About this task
For more information, see the Workflow - cancelContext(GlideRecord context) .

Define an on-cancel script

Canceling a workflow can leave records or scripts in an unresolved state. For example, canceling 
a service catalog workflow may leave catalog items in the requesting user's cart. An administrator 
can specify an On-cancel script that runs when the workflow transitions to the Canceled 
state. This script can notify users, log information, or resolve the state of any scripts run within 
a workflow activity. The sys_id of the workflow context is available in this script using the 
context_sys_id variable.

About this task
On-cancel scripts run asynchronously from the global scope. Your instance workload determines 
when the system schedules and runs the on-cancel script.

Important: 
Since the system runs on-cancel scripts from the global scope, they cannot call or run 
scoped script includes.

Procedure

1. Navigate to All  > Workflow  > Workflow Versions.

2. Select a workflow version that you have checked out.
Workflow versions that are not checked out are not editable.

3. Edit the On-cancel script  field.
You may need to configure the form to add this field.

4. Click Update.

Example:
This example script adds a comment to a Requested Item [sc_req_item] record indicating the 
workflow for that request has been canceled.

var grContext = new GlideRecord("wf_context");
grContext.get(context_sys_id);
var grReq = new GlideRecord("sc_req_item");
 
// The current record may not exist, make sure it exists before 
 modifying it.
if (grReq.get(grContext.id)) {
    grReq.comments = "The workflow processing this item was 
 Canceled. Contact your system administrator for further 
 information.";
    grReq.update();
}

Scheduling a workflow

In addition to being run based on conditions, workflows can also be scheduled to perform at a 
particular time, similar to a scheduled job.

Scheduled workflows do not have a defined current record and do not run on specific records 
within a table. Due to this behavior, certain activities that depend on a current record, such as 
Create Task  or Catalog Task  are unavailable on scheduled workflows. If your workflow requires 
one of these activities, consider using a scheduled job that inserts a record to start the workflow 
instead of using a scheduled workflow.
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To schedule a workflow, navigate to Workflow  > Scheduled Workflows  and click New. Populate 
the following fields:

Field Description

Name
A unique name for the scheduled workflow.

Workflow
Select an existing published workflow to 
be triggered at the specified date, time, or 
interval.

Active
If selected, the scheduled workflow will be 
triggered at the appropriate time.

Application Specifies the type of application, such as 
Global.

Run
A choice list to determine when the workflow 
should be triggered. Options are:

• Daily:  At a particular hour every day.

• Weekly:  On a particular day of the week.

• Monthly:  On a particular day of the month

• Periodically:  After every set duration.

• Once:  At one specific date and time.

Time
For daily/weekly/monthly scheduled 
workflows, the time of day to run the workflow.

Day
For weekly scheduled workflow, the day of 
the week to run the workflow. For monthly 
scheduled workflows, the day of the month to 
run the workflow.

Repeat Interval For periodical workflows, the interval between 
workflows, beginning from the Starting  date 
and time.

Starting
For periodical workflows, the first date and 
time to run the workflow. For scheduled 
workflows run once, the date and time to run 
the workflow.

Related topics

Create a scheduled job
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Workflow movement with update sets

The system tracks workflows in update sets differently than other records because workflow 
information is stored across multiple tables.

Changes made to a workflow version are not added to the update set until the workflow is 
published, at which point the entire workflow is added into the update set. Update sets store 
workflows as a single Workflow [wf_workflow] record and only retain the latest version with the 
update type of Workflow.

For information about update sets, see System update sets .

Workflow update set migration use case - simple

Create a new workflow with no dependencies and then migrate the workflow in an update set.

1. User A selects Update Set A.

2. User A creates a new workflow called Workflow A.

3. User A publishes Workflow A.

A customer update set record is added to Update Set A containing an XML payload, including 
the published Workflow A and all activity dependencies. The XML payload also contains the 
workflow input variables associated with the workflow.

4. User A completes Update Set A and migrates it to the production instance.

5. Update Set A commits successfully.

6. Workflow A works as expected.

Workflow update set migration use case - subflow dependency (success)

Successfully edit and migrate an existing workflow and its dependent subflow.

1. User A selects Update Set B.

2. User A checks out Workflow A.

3. User A adds a subflow called Workflow B to Workflow A.

Assume that Workflow B was previously published and migrated to the production instance.

4. User A publishes Workflow A.

A customer update set record is added to Update Set B containing an XML payload, including 
the published Workflow A and all activity dependencies. The XML payload also contains the 
workflow input variables associated with the workflow.

5. User A completes Update Set B and migrates it to the production instance.

6. Update Set B commits successfully.

7. Workflow A works as expected with Workflow B as a subflow.

Workflow update set migration use case - subflow dependency (failure)

Edit and migrate an existing workflow from a test instance to a production instance that fails to 
run on the production instance because of a missing dependent subflow.

1. User A selects Update Set C.

2. User A checks out Workflow A.
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3. User A adds a subflow called Workflow B to Workflow A.

Assume that Workflow B was previously published, but has not been migrated to the 
production instance.

4. User A publishes Workflow A.

A customer update set record is added to Update Set C containing an XML payload, including 
the published Workflow A and all activity dependencies. The XML payload also contains the 
workflow input variables associated with the workflow.

Notably absent from Update Set C is the subflow called Workflow B. Workflow B was published 
before User A selected Update Set C.

5. User A completes Update Set C and migrates it to the production instance.

6. Update Set C commits with warnings.

7. Workflow A is invoked on the production instance with the following results:

Workflow A fails the runtime validation check and is prevented from running on the production 
system. The system adds to the workflow context a workflow log entry detailing the cause of 
the failure, notably the absence of a dependent workflow.

To learn more about the validation checks on workflow dependencies and update sets see 
ValidateUpdateSetDependencies.

Workflow update set migration use case - subflow dependency (risk)

Multiple users migrate a workflow from a test instance to a production instance without 
proper coordination. This use case can succeed, but only when each user understands the 
dependencies and properly migrates the dependent parts of the workflow to the new instance.

This example does not represent an update set failure, although update sets are most often 
blamed in this use case. Validation increases the visibility of workflow dependencies across 
multiple update sets and provides designers with better information. In most cases, the warnings 
do not prevent an action, but only identify risk. The designer is responsible for taking action on 
advice given in the validation checks.

1. User A selects Update Set C.

2. User A checks out Workflow A.

3. User A adds a subflow called Workflow B that returns a User ID.

Note: 
Assume that Workflow B was previously published and migrated to the production 
instance.

4. User A uses the return value of Workflow B to generate approvals.

5. User B selects Update Set D.

6. User B checks out Workflow B (the subflow in Workflow A).

7. User B modifies the return value of the workflow by changing it from a User ID  to a String 
Message.

8. User A publishes Workflow A.
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Note: 
A dialog box displays warnings associated with Workflow A and encourages User A to 
validate the workflow before publishing.

9. User A cancels publishing and validates  Workflow A.

10. User A is warned that Workflow B was modified by a user in a different update set.

11. User A ignores this warning and publishes Workflow A.

Note: 
A customer update set record is added to Update Set C containing an XML payload, 
including the published Workflow A and all activity dependencies.The XML payload also 
contains the workflow input variables associated with the workflow.

12. User A completes Update Set C and migrates it to the production instance.

13. Workflow A is invoked on the production instance and runs successfully using the older 
version of Workflow B already on the system.

14. User B publishes Workflow B.

Note: 
User B is not warned of the Update Set C dependency, because the update set is no 
longer In progress. However, User B is informed via a dialog box that there are warnings 
associated with the workflow version and is instructed to validate Workflow B. If User B 
cancels publication and validates the workflow, User B is warned that there are workflows 
that use Workflow B as a subflow. Knowing the return value was changed, User B should 
test those workflows as well. See ValidateUpdateSetDependencies  to understand the 
parameters of update set warnings.

15. User B finally publishes Workflow B.

Note: 
A customer update set record is added to Update Set D containing an XML payload, 
including the published Workflow B and all activity dependencies.

16. User B completes Update Set D and migrates it to the production instance.

17. Update Set D commits without warnings.

18. Workflow A is invoked on the production instance and fails to run successfully, because the 
return value of Workflow B no longer generates a User ID.

Input variable movement

You can add input variables to existing workflows and add them to update sets.

When you submit the new variables, an entry is made into the current update set that reflects the 
addition of a variable to the Variables [var_dictionary] table. Unlike the workflow version that only 
writes to the update set when the workflow is published, the variables write individual update 
entries into the currently selected update set immediately upon submission.

Input variable movement use case - two input variables

An existing workflow already contains two input variables.

1. User A checks out the workflow.

2. User A adds two input variables.
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ServiceNow  adds to the current update set one customer update record for each new variable.

The current workflow now has 4 input variables: the two that were present prior to check out 
and the two new ones.

3. User A publishes the workflow.

There are now three related customer update records: two for new variables, and one for the 
published workflow. The XML payload of the new workflow version now includes all input 
variable database entries. So while the two original input variables do not have individual 
customer update records, all four variables are migrated to the local instance with the payload 
of the newly published workflow version.

4. Verify variables included in a specific workflow.

5. User A completes the update set.

6. Adding Input Variables - Success

User A migrates and commits the update set to a local instance where the original workflow 
version had previously been committed.

◦ The two existing input variables are already present because of the earlier version.

◦ The system adds the two new input variables when the user commits the update set.

◦ The system preserves the two legacy input variables on the instance receiving the update 
set. The update set does not overwrite these variables.

◦ The new published workflow version uses all four variables.

◦ The user tests the new workflow version and it runs as expected.

Verify variables included in a specific workflow

You can verify the variables that are included in a specific workflow.

Procedure

1. Navigate to All  > System Update Sets  > Local Update Sets.

2. Select the active update set.

3. Select the customer update entry for the workflow.

4. View the XML Payload.

5. Search for the name of one of the columns or search for var_dictionary.

There is one var_dictionary entry for each input variable.

Input variable removal

Deleting workflow input variables, like insert and update actions, creates a customer update 
record in a user's current update set.

These deletions migrate to a new instance with the update set, regardless of whether the 
workflow that owns the input variables is published in the same update set. Plan carefully and 
use caution when editing a workflow and selecting update sets.

Input variable removal risk

An existing workflow already contains two input variables.
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1. The workflow was migrated to a production instance with the two variables.

2. On a development instance, User A selects Update Set A and checks out the workflow.

3. User A removes one input variable and all references to it in the workflow.

The system enters into Update Set A one customer update record reflecting the deletion of the 
input variable. No record is added for the new workflow version which no longer depends on 
the input. This does not happen until the workflow is published.

4. User A continues working on other features in Update Set A that need to be moved to 
production.

5. User A completes Update Set A and migrates it to the production instance without publishing 
the workflow.

The update set entry that deletes the workflow input variable now applies to the production 
instance. The prior version of the workflow is running on this instance and still references the 
missing variable.

Input variable removal solution

When editing workflows, particularly when deleting input variables, be sure to use a single 
update set for all variable editing and workflow publishing.

If necessary, merge the update set into a more general set targeted for deployment after the 
workflow is published. For information about update sets, see System update sets .

Note: 
If a workflow version is already running on a production system and input variables are 
deleted from a newer version, those deletions could affect transactions already running 
against the earlier version. Use extreme caution when deleting workflow input variables and 
plan the migration carefully.

Input variable removal prevention

Prior to publishing a workflow version, the system validates the workflow model to assist the 
designer in planning for deployment.

This validation warns of critical errors that can prevent a workflow from running successfully, but 
also warns of dependencies and conflicts in update sets. See ValidateUpdateSetDependencies 
for more details.

Avoiding duplicate workflows

Update sets manage the published state of all versions of a workflow prior to committing the 
workflow version on a local instance.

The last version of a workflow committed as an Insert or Update using an update set becomes 
the currently published version, regardless of the publishing sequence for the workflow versions.

Commit a workflow in an update set

Follow the steps in this page to commit a workflow in an update set.

Procedure

1. Workflow A - Version 1 is created and published in Update Set A.

2. Update Set A is completed and migrated to a local instance.

3. When the update set is committed, the system sets all prior versions of Workflow A to 
published = false.
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In the first migration, there are no prior versions.

4. Workflow A - Version 1 becomes the only published version of the workflow.

Update set migration example

It is not possible to have multiple published versions as a result of update set commits. However, 
this does not eliminate risk, and care should be taken when migrating update sets.

Consider this example:

1. Workflow A - Version 1 is migrated and committed to the production instance.

2. Update Set B is created.

3. Update Set C is created.

4. Workflow A - Version 2 is published in Update Set B.

A customer update record is added to Update Set B with the Version 2 payload.

A customer update record is added to Update Set B with the Version 1 workflow left 
unpublished.

5. Update Set B is completed.

6. Workflow A - Version 3 is published in Update Set C.

A customer update record is added to Update Set C with the Version 3 payload.

A customer update record is added to Update Set C with the Version 2 workflow left 
unpublished.

7. Update Set C is completed.

8. Update Set C is migrated and committed to the production instance.

Workflow A - Version 1 is set to unpublished.

Workflow A - Version 2 update is skipped since Update Set B, which contains Version 2, was 
never migrated.

Workflow A - Version 3 is committed and becomes the only published version of the workflow.

Update set migration risk

Update Set B is migrated and committed to the production instance.

1. Workflow A - Version 3 is set to unpublished.

2. Workflow A - Version 1 remains unpublished.

3. Workflow A - Version 2 is committed and becomes the only published version of the workflow.

The workflow has gone back a version, perhaps unintentionally. The regressed version 
becomes the currently published version.

Workflow timelines

The system provides a timeline view of history activities associated with a workflow context.

Timelines display a linear calendar of activities, such as tasks and approvals, defined by their 
start and end dates. Each activity on the timeline is represented by a span, which is displayed as 
a horizontal, colored bar. Each span has a label and a tooltip that contains additional information 
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about the activity. The left pane displays all the activities in the context (or contexts) in an 
expandable hierarchy. You can change the timeline's perspective for a more granular view of the 
data.

Note: 
Workflow timelines reflect context history only and are not real-time gauges of workflow 
activity.

Use a timeline

By default, the timeline displays all activities and transitions requested when first opened.

About this task
Collapse any part of the hierarchy in the activity pane and the timeline adjusts automatically. 
Date/time and duration controls enable you to scale the timeline to view all the elements at once. 
To display a timeline, click a UI action within a Workflow Context record.

Procedure

1. Navigate toAll  > Workflow  > Live Workflows  > Active Contexts.

2. Select a context.

3. In Related Links, click Show Timeline  to display the timeline for the entire context.

The timeline opens with all activities expanded and the view set to Max, which displays the 
entire timeline at the width of the pane. The title of the timeline is in the form Workflow context: 
<context name>, Requested Item: <requested item number>.

4. Use the Range Selectors at the top of the timeline to change the perspective.

The increments go from one day to one year. To limit the timeline to an increment between the 
start date of the first span and the end date of the last span, click Max.

5. Use the starting and ending calendar fields to select the timeline perspective.

These fields control the same perspective as the slider at the bottom of the timeline.
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6. Use the pink slider at the bottom of the timeline to change the perspective.

a. Move the slider from right to left to view all the spans on a long timeline.

b. Adjust the end points of the slider to make arbitrary changes to the magnification.

A narrow slider zooms in on the spans and provides a more detailed view of complex 
timelines. A wide slider pulls the view out and makes more of the timeline visible on the 
screen.

7. To focus the timeline view on selected activities, expand or collapse the activity tree.

Spans not visible in the activity tree are not shown in the timeline pane.

8. Hover over an activity span to display a tooltip with information about the activity.

This action highlights the activity in the activity pane.

9. Hover over the transition between two activities to highlight the activity and the predecessor 
activity in the activity pane.
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10. Double-click a span to display a history record for that activity.

History records shows information such as the State  and the starting and ending times.

Timeline for a selected activity

You can display a partial workflow timeline.

Procedure

1. Navigate toAll  > Workflow  > Live Workflows  > Active Contexts.

2. Open a Workflow Context record.

3. On the Workflow Activity History  related list, select one or more individual activities.

4. Click Show Timeline  from the action menu.

The resulting view is a snapshot of the timeline, showing only the selected activities and their 
transitions, if any.

5. Collapse the tree to confine the view even further.

6. To view a timeline displaying activities from different contexts:
You might use this feature to display a subflow's context with the parent workflow context.
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a. Navigate to Workflow  > Live Workflows  > History.

b. Select individual history items from the list.

c. Select the Show Timeline  option from the actions menu.

History items are arranged in a hierarchy in the activities pane under their contexts. The 
timeline title is Multiple Contexts. The timeline draws only the activities and relationships of 
the history items selected.

View subflows in a workflow timeline

In a workflow timeline, subflow spans appear as a different color than the activities of the main 
workflow.

Workflow timeline subflow

Workflow error handling

The personalized JavaScript that users create in workflow activity variables is vulnerable to 
run-time syntax errors. Available error information is available in a tooltip when you point to a 
workflow activity in an error state.

In the base system, workflow activities do not provide condition routing on the error state. As a 
result, the workflow progresses based on the state of the current record. For example, a workflow 
contains an Approval - User  activity that uses an advanced script to add additional approvers. A 
syntax error in the script results in no approvers being added. Because a state of no approvers 
is a valid return, even without the syntax error, the approval activity is skipped and the workflow 
progresses along a positive path. However, this might not be a valid response for the workflow 
designer who does not want the workflow to progress along the positive path without approvers.

Workflow error handling detects and logs syntax errors and provides a state that the workflow 
designer can use to add error conditions to the workflow. Use error handling to locate syntax 
errors in advanced script fields for these workflow activities:

• Approval - User

• Approval - Group

• Catalog Task

• Create Task

• If
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• Run Script

• Notification

Available error information

This table shows which activities support error exits.

Available error information

Activity
Workflow 
log

Red error 
indicator

Activity 
state

Activity 
result

Fault 
description

Reroute on 
error

Approval - 
User

Approval - 
Group

Yes Yes Error Skipped Yes Yes

Catalog Task

Create Task

Yes No Finished none No No

If Yes Yes Error none Yes Yes

Run Script No Yes Error error Yes Yes

Notification Yes Yes Error error Yes Yes

Workflow error tracking features

Error handling provides visual cues within the workflow, such as error descriptions for activities in 
pop-ups, and detailed log records.

Banners

Look for an activity with a red banner, indicating that a syntax error has occurred in a script field. 
All activities that provide error handling, with the exception of Catalog Task  and Create Task, 
display a red banner for this error.

Tooltips

Point to the activity displaying a red banner to view information about the error. A tooltip shows 
the State  and Result  of the activity and provides a brief Fault Description  (except for task 
activities). Note that this approval continued as skipped despite the error given in the fault 
description. See Workflow error handling  for the information available to each activity.
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Execution order

Tooltip text in the Workflow Context graphical view displays the execution order of individual 
activities, which assists in troubleshooting.

To view the order in which a workflow activity was executed:

1. Navigate to Workflow  > Live Workflows  > Active Contexts  or All Contexts.

2. Open the context you want to examine.

3. Click Show Workflow.

4. Hover the cursor over a finished or executing activity.

A tooltip appears showing error data, execution time, and the order in which that activity 
executed in the workflow. You can use this data to help troubleshoot activities in an error state.

Activity execution order
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Workflow log

View the log in the Workflow Context form for more information about the syntax error in the 
activity. Since task activities do not display a red banner when a syntax error has occurred, you 
must view the log if you suspect the workflow has not run properly. Examine the error description 
in the log, and then inspect the script in the activity named in the log.

To view the activity by name, navigate to Workflow  > Administration  > Properties  and enable 
the Log workflow debug messages  property.

In this example, an SSH activity named File Read specifies an invalid MID Server.

Error handling log

If the credentials used by an activity in the workflow fail, and the activity cannot authenticate 
on the target, a message describing the failure appears in the Workflow Log  related list. The 
message displays the target IP address and the credential details.

Credential debugging in the workflow log

Create an error condition exit

An administrator can reroute the workflow when a script error occurs by creating an error 
condition exit for specific activities within the workflow. This allows the workflow to process script 
errors in a predictable way and not create undesirable results.

Procedure

1. Open and check out a workflow.

2. Right-click in the top portion of the activity for which you want to create an error exit.

3. Select Add condition  from the context menu.
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4. Add a condition exit with the following values:

◦ Name: Error

◦ Condition: activity.state=='faulted'

5. Click Submit.

The Error  exit appears on the activity.

6. Connect the Error  exit to another activity for handling the error state, such as Notification  or 
Log Message.

Reconfigure an approval condition

Approval activities react differently to script errors than the other activities.

About this task
Approval activity script errors can prevent an approval from being processed successfully. This, 
in turn, can cause the approval to complete as Skipped, which can appear to be an Approved 
state. To prevent this from happening, reconfigure the Approved  exit as follows:

Procedure

1. Open an approval workflow and make sure it is checked out.

2. On an approval activity, double-click the Approved  exit.

3. Add the following script to the Condition  field:

&& activity.state != 'faulted'

This prevents the activity from continuing down the normal path in an error state and ensures 
that Skipped  or Approved  is the desired state.

4. Click Update.

Workflow run time metrics

You can enable the collection of workflow run time metrics to determine whether workflows are 
performing as expected or consuming additional resources.

Outlying run times for a workflow are identified by comparing actual run times to an outlier range 
calculated with the outlier threshold and estimated run time defined in the workflow properties.
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You can monitor the results of these metrics on the Workflow Operations Dashboard and custom 
homepages with workflow gauges.

Important: 

The functionality found in homepages, arranging information from your instance to tell a 
story about your data, is found in dashboards on new instances. On upgraded instances 
with Next Experience  enabled, users can view existing homepages if they have a direct 
URL, but they can't create or edit them. Responsive dashboards and Analytics Center 
dashboards take over homepage functionality.

Use the Homepage deprecation help tool  to convert the homepages on your instance to 
responsive dashboards.

For more information, see:

• Dashboards in the Analytics Center .

• Working with responsive dashboards .

Enable workflow run time metrics

Provide an estimated run time that can be compared to actual workflow run times.

About this task
For baseline workflows, you must also manually enable the collection of run time metrics. The 
system automatically enables the collection of run time metrics for new workflows.

Procedure

1. Navigate to All  > Workflow  > Workflow Editor.

2. Open and check out the workflow.

3. In the title bar, click the menu icon and select Properties.

4. In the Workflow Properties dialog box, click the Estimated Runtime  tab.

5. To enable the collection of run time metrics, check that the Requires ERT  option is selected.

6. Open a configuration from the Estimated Run Time  column.

7. In Estimated Run Time, enter an initial estimate for the workflow's run time.
The system compares this initial estimate to actual run time results to create outlier reports. 
The system can automatically update this field in certain circumstances. Workflow designers 
can also manually update this field.

8. In the Outlier Percentage Threshold for ERT  field, enter the percentage deviation from the 
estimated run time that identifies an outlier workflow run time.
The system uses a default value of 20.

9. Click Update.

Outlying workflow run times

Workflow run times are identified as outliers when they are longer or shorter than the outlier 
range that is computed for the workflow.

The outlier range is automatically computed with the Estimated Run Time  and Outlier 
Percentage Threshold for ERT  values in the workflow properties. These values are used in the 
following formulas.
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Formulas for computing workflow outlier ranges

Value 
computed

Computation used Example

Outlier 
Value

Estimated Run Time  * (Outlier Percentage 
Threshold for ERT / 100)

10 seconds * (20 / 100)

10 seconds * 0.2 = 2 seconds

Outlier 
Range

(Estimated Run Time  - Outlier Value) to 
(Estimated Run Time  + Outlier Value)

(10 seconds - 2 seconds) to (10 
seconds + 2 seconds) = 8 to 12 
seconds

When a workflow runs within the outlier range, its estimated run time is automatically updated.

If a workflow has an outlying run time, it appears in any outlier workflow gauges on the Workflow 
Operations Dashboard and custom home pages.

Workflow estimated run time updates

When a workflow runs within the outlier range, its estimated run time is automatically updated.

The estimated run time is updated with the cumulative moving average of the latest run time 
value in relation to previous run times. The computed value is rounded to the nearest second 
and stored as a GlideDateTime .

For example:

Data 
point

Latest value
Cumulative running average 
(CRA)

CRA after rounding to the nearest 
second

1 10 
seconds

10 seconds 10 seconds

2 12 seconds 11 seconds 11 seconds

3 9 seconds 10.333 seconds 10 seconds

Note: 
Because the system rounds to the nearest second, the calculation is less precise with short 
durations.

You can also manually update the estimated run time in the workflow properties.

Workflow pause utility

Workflow Pause Utility provides functionality you can use to pause or resume all workflow 
contexts, a subset of qualified workflow contexts, or individual workflow contexts. You designate 
the data and time of day at which the paused workflows should resume, and can manually 
resume individual workflows as needed.

Once activated, the Workflow Pause Utility plugin (com.glideapp.workflow.pause) updates several 
tables when you pause or resume workflows. Each table stores specific data related to each 
paused or resumed workflow.

wf_pause_request

Records every workflow pause request. The system automatically updates and 
inserts records in this table whenever you pause workflow contexts. It tracks user-
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specified resume time, whether the pause request is still active, and the total 
number of workflow activities that paused or resumed.

wf_pause_status

Records the status of each workflow context you pause. When you pause workflow 
contexts, the plugin waits until the current executing activity finishes, and pauses 
it before the next activity starts. It tracks the specific activity on which the workflow 
context was paused and whether it has resumed. If the workflow is paused, it tracks 
the time at which it is scheduled to resume.

wf_pause_group_request

Pauses the specific set of workflow contexts you designate using filtering in Group 
Pause Requests. You can manually pause all currently active workflows by clicking 
the Pause All  check box.

wf_pause_snapshot

Before pausing and after resuming a workflow, the table records a snapshot of 
the current state of the workflow context. The table also records the state of the 
currently executing activity on the paused workflow context.

Use examples

When you take down an instance for maintenance, you can pause all or selected active workflow 
contexts, and then resume them after you complete the maintenance.

You have an integration workflow context that hits an internal service that is down for 
maintenance. You can pause all instances of that workflow context from progressing to the next 
activity, allowing time for the internal service to be restored. Then, the paused workflow contexts 
can be resumed.

Request workflow pause utility

You can request the Workflow Pause Utility plugin (com.glideapp.workflow.pause) if you have 
the admin role. This plugin may include demo data and activates related plugins if they are not 
already active.

Before you begin
Role required: admin

About this task
There are two ways to request a plugin:

• Access the Now Support  Service Catalog directly by selecting All  > Service Catalog  > Activate 
Plugin  on Now Support.

• Access the Now Support  Service Catalog through the All Applications page on your instance 
by following these steps.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. On the All Applications page, select Request Plugin  to open the Activate Plugin  form on Now 
Support.
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3. On Now Support, select the link to access the Now Support  Service Portal  Service Catalog.

4. Select your instance.

5. Select Actions > Activate Plugin.

6. On the Activate Plugin  form, provide the following information.

Activate Plugin form

Field Description

What is your target instance Instance on which to activate the plugin.

Which plugin would you like to activate Name of the plugin to activate.

Note: 
If the system does not list the plugin you 
want or if you are activating the plugin 
on an OEM or on-premise instance, 
select the Plugin I'm looking for is not 
listed  check box and then enter the 
name of the plugin.

Select Maintenance Date and Time The date and time to activate the plugin.
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Field Description

Note: 
Plugins are activated in two batches, 
once in the morning and once in the 
evening, on every business day in the 
US Pacific time zone. If the plugin must 
be activated at a specific time, enter the 
request in the Reason/Comments  field.

Example 

For example, see the following form to activate the CSM Workspace plugin on an instance 
named My Instance.

Activate Plugin form

7. Select Submit.
For additional details about requesting a plugin, see Requesting a Plugin from the Service 
Catalog [KB0751715] article in the Now Support  Knowledge Base.

Pause and resume individual workflows

To pause individual workflow contexts, specify the date and time when the workflow context 
should resume. When a workflow context is paused, the system saves basic information about 
the pause request, such as the resume date and time, in the wf_pause_request table. A workflow 
context automatically resumes at a specified date and time of day, but a paused workflow context 
can be manually resumed as needed.

Before you begin
Role required: workflow_publisher, workflow_creator, or workflow_admin
Activate the Workflow Pause Utility plugin.

Procedure

1. Navigate to All  > Workflow  > Live Workflows  > Active Contexts.

2. Select the individual workflow context that you’re pausing.
Workflow Context  appears.
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3. In Related Links, select Pause.
A Workflow Pause Inputs  dialog appears.

4. In the Workflow Pause Inputs  dialog:

a. Select the calendar icon  to choose the date, and enter the time when the workflow 
should resume.
You can select the current date or future date, but you must enter a time of day in the future.

The time should be entered in hours, minutes, and seconds. For example, to pause the 
workflow context at 13:30:00 (1:30 pm), select the date from the calendar, and then enter 13, 
30, and 00  into the respective Time:  fields.

b. Select the green check mark icon  when finished.

c. The selected date and time of day appear in the Resume At  field.

d. Select OK  to return to Workflow Contexts.
The selected workflow is now paused. Use Workflow pause request  to monitor its status.

5. Manually resume a currently paused workflow context.
Paused workflows resume on the date and time specified in the Resume At  field.

a. Navigate to Workflow  > Live Workflows  > Active Contexts.

b. Select the individual workflow context you are pausing.
Workflow Context  appears.

c. In Related Links, select Resume.

Pause and resume all or multiple workflows

Use Workflow Pause Group Requests to pause, or resume, groups of workflows, or all active 
workflows. If pausing a group of workflows, use filtering functions to select the workflows. If 
pausing all active workflows, select the Pause All check box to indicate that all currently active 
workflows should be paused.

Before you begin
Role required: workflow_publisher, workflow_creator, or workflow_admin
Activate the Workflow Pause Utility plugin.

Procedure

1. Navigate to All  > Workflow  > Operations  > Group Pause Requests.
Workflow Pause Group Requests  appears and displays existing workflow pause group 
requests.

2. Select New.
Workflow Pause Group Request  appears, and assigns a workflow pause group request ID.

3. To pause all active workflows, select Pause All, then select Update, but if you want to pause a 
filtered group of active workflow contexts, skip this step.
All currently active workflow contexts in the instance are paused until you resume them. Use 
Workflow pause request  to monitor their status.
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4. To pause a filtered group of active workflow contexts, use the Filter  field, specify the conditions 
for the search, then select Update.
Workflow Pause Group Requests  appears, and displays the results of the workflow group 
search. It assigns a workflow pause group request ID and indicates if the group is active (true = 
paused) or inactive (not yet paused).

5. To update, resume or delete a specific workflow pause group request, select it.
Workflow Pause Group Request  appears, and displays the selected workflow pause group 
request.

6. If the selected workflow pause group request is active (paused), and you don’t want to pause 
it, select Do Not Pause Incoming Workflows.

7. If the selected workflow pause group request is inactive (not yet paused), select Pause  to 
pause it.

8. For the paused workflow group request, use the Resume At  field to specify the date and time 
of day at which the paused workflow contexts should resume.

a. Select the calendar icon  to choose the date, and enter the time when the workflow 
contexts should resume.
You can select the current date or future date, but you must enter a time of day in the future.

The time should be entered in hours, minutes, and seconds. For example, to pause the 
workflow context group at 13:30:00 (1:30 pm), select the date from the calendar, and then 
enter 13, 30, and 00  into the respective Time:  fields.

b. Select the green check mark icon  when finished.

c. The selected date and time of day appear in the Resume At  field.

d. Select OK  to return to Workflow Pause Group Request.

9. Select Submit.

10. Manually resume currently paused workflow contexts.
Paused workflow contexts automatically resume on the date and time of day specified in the 
Resume At  field.

a. Navigate to Workflow Pause Group Requests.

b. Select the workflow pause group request to resume.
Workflow Pause Group Request  appears.

c. Select Resume, and then select Update.

11. Workflow Group Pause Request also contains the following information fields.

Workflow group pause request form

Field Description

Active Indicates if workflow group is paused.

Completed 
Resume 

Number of resumed workflow context activities that are completed.
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Field Description

Activity 
Count

Filter Standard filtering fields used to specify the conditions for selection of a group 
of workflow contexts.

Log Activity work notes generated by the group pause request.

Not 
Transitioned 
Workflow 
Count

Number of workflow contexts that weren’t transitioned when the group pause 
request was placed. When a group pause request is placed, the affected 
workflow contexts are paused before the start of the next activity.

Resume Act 
Count

Number of workflow context activities resumed after the group pause 
completed.

Pause Act 
Count

Number of paused workflow context activities.

Requester 
Name

Name of the person requesting the workflow context pause.

Pause 
percentage

Total percentage of workflow contexts that are paused.

Resume 
Percentage

Total percentage of workflow contexts that have resumed.

Total 
Workflow 
Count

Total number of workflows matching the specified filter conditions that are 
being paused.

Paused 
Workflow 
Count

Number of current paused workflow contexts.

Monitor workflow pause requests

You can monitor the status of workflow pause requests using Workflow Pause Request.

Before you begin
Role required: Workflow_admin or workflow_publisher, workflow_creator
You must install and activate the Workflow Pause Utility plugin.

Procedure

1. Navigate to All  > Workflow  > Operations  > Pause Requests.
Workflow Pause Requests  appears and displays existing workflow pause requests.

2. Select the workflow pause request.
Workflow Pause Request  appears, and displays the selected workflow pause request.

Workflow pause request fields

Field Description

Req Number Unique assigned pause request number.

Completed Resume 
Activity Count

Number of workflow context activities resumed after the pause 
completed.
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Field Description

Pause Active Selected indicates the workflow context is currently paused. Cleared 
indicates it is not.

Transitioned During 
Pause

Number of workflow contexts that transitioned when the pause request 
was placed. When a pause request is placed, the affected workflow 
contexts are paused before start of the next activity.

Workflow Context Reference number for the paused workflow context.

Log Activity work notes generated by the group pause request.

Paused Act Count Date and time of day (h:m:s) at which the paused workflow context is 
resuming.

Requester Name Name of the person who requested the workflow pause.

Resume Act Count Number of workflow context activities resumed after the pause 
completed.

Resume At Date and time of day (h:ms:s) at which the workflow contents are 
scheduled to resume.

Table Related record table name.

Application Application in which the workflow context is executing.

Exec Act Count Number of activities executing when the workflow context was paused.

Group Pause 
Request

Reference number for the associated group pause request, if any. 
Appears only if pause request was the result of a group pause request.

Is Workflow 
Complete

Selected indicates the workflow context is complete. Cleared indicates 
it is not.

Is Workflow Stuck Selected indicates the workflow context is stuck. Cleared indicates it is 
not.

State Current state of the workflow context - Paused or Resumed.

Stuck Activities 
Count

The number of workflow context activities that are stuck.

Stuck Act Count To 
be subtracted for 
Pause Percentage

Writer to whom the documentation request is assigned.

Encrypted workflow scratchpad

The Encrypted Workflow Scratchpad plugin (com.snc.encrypted.scratchpad) provides encrypted 
scratchpad support for workflow context and workflow executing activities.

The platform supports encryption on most fields, and workflows can execute on tables with 
encrypted fields. Encrypted data is typically stored in the workflow scratch pad for workflows that 
execute using encrypted fields and must access this data after processing an approval, timer, or 
create task activity.

Data in the workflow scratchpad is not encrypted by default. The Workflow engine supports 
scratchpad encryption and executing activity records only when the Encrypted Workflow 
Scratchpad plugin is activated. Once activated, data stored in the wf_context and wf_executing 
scratchpads is protected by a private workflow engine encryption module, and is prevented from 
being stored in plain text.
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Incompatibility with domain separation

The Encrypted Workflow Scratchpad plugin is incompatible with domain separation. Activating 
the Encrypted Workflow Scratchpad plugin on a domain separated instance can produce 
encryption errors when running some workflows. Consider using a Workflow Studio  flow instead.

Request encrypted workflow scratchpad activation

Request activation of the Encrypted Workflow Scratchpad plugin 
(com.snc.encrypted.scratchpad) from ServiceNow  personnel

Before you begin
Role required: admin
The Encrypted Workflow Scratchpad plugin must be activated via a Customer Service and 
Support  request. You should activate and thoroughly test the plugin in a non-production 
instance. Only after you satisfied with the results should you request activation in a production 
instance.

When requesting activation in a production instance, you should schedule a low transactional 
volume time to do so. Prior to its activation, first activate the Workflow Pause Utility 
(com.glideapp.workflow.pause), and then pause all active workflows. Refer to Workflow pause 
utility. After activation of the Encrypted Workflow Scratchpad plugin, resume all paused 
workflows.

About this task
There are two ways to request a plugin:

• Access the Now Support  Service Catalog directly by selecting All  > Service Catalog  > Activate 
Plugin  on Now Support.

• Access the Now Support  Service Catalog through the All Applications page on your instance 
by following these steps.

Encrypted Workflow Scratchpad activates these related plugins if they are not already active.

Plugins for Encrypted Workflow Scratchpad

Plugin Description

Encryption Support

[com.glide.encryption]

Allows text fields and attached files to be encrypted.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. On the All Applications page, select Request Plugin  to open the Activate Plugin  form on Now 
Support.
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3. On Now Support, select the link to access the Now Support  Service Portal  Service Catalog.

4. Select your instance.

5. Select Actions > Activate Plugin.

6. On the Activate Plugin  form, provide the following information.

Activate Plugin form

Field Description

What is your target instance Instance on which to activate the plugin.

Which plugin would you like to activate Name of the plugin to activate.

Note: 
If the system does not list the plugin you 
want or if you are activating the plugin 
on an OEM or on-premise instance, 
select the Plugin I'm looking for is not 
listed  check box and then enter the 
name of the plugin.

Select Maintenance Date and Time The date and time to activate the plugin.
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Field Description

Note: 
Plugins are activated in two batches, 
once in the morning and once in the 
evening, on every business day in the 
US Pacific time zone. If the plugin must 
be activated at a specific time, enter the 
request in the Reason/Comments  field.

Example 

For example, see the following form to activate the CSM Workspace plugin on an instance 
named My Instance.

Activate Plugin form

7. Select Submit.
For additional details about requesting a plugin, see Requesting a Plugin from the Service 
Catalog [KB0751715] article in the Now Support  Knowledge Base.

What to do next
After plugin activation, resume all paused workflows. Refer to Pause and resume all or multiple 
workflows.

Related topics

List of plugins

Troubleshoot workflows

Troubleshooting tools for workflows enable administrators to isolate execution paths, compare 
contexts, and track incomplete activities.

The workflow timeline provides a visual representation of the workflow, including transitions and 
the elapsed time for each activity. A troubleshooting tool for highlighting execution paths helps 
users perform forensics on a workflow. The highlighting feature can group multiple execution 
paths in various colors and can isolate rollback  processing. Use the workflow highlighter to 
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isolate incomplete tasks and approvals. You can also enable a workflow performance timing 
feature to troubleshoot slow workflows.

Execution path troubleshooting in timelines

Use the controls in a workflow timeline to isolate specific execution paths or compare multiple 
execution paths over time.

Timelines show how the activities in the workflow progressed in relation to one another over 
time. Isolate execution paths and follow transition lines between subflows and the main flow. 
Processing times provide a view of the workflow that you cannot get from the workflow diagram. 
Tooltips give precise information about each activity, such as duration.

Workflow timeline troubleshooting

Execution history table

Highlight execution paths and rollbacks to locate activities that may have been left in an 
unresolved state.

About this task
Rollbacks, cancels, and deletions during the execution of a workflow can prevent some activities 
from fully completing. Use highlighting in the execution history table to determine which activities 
in the workflow were left in an unresolved state.

Procedure

1. Run the workflow.

2. Navigate to Workflow  > All Contexts.

3. Select a context to troubleshoot.

4. In the Workflow Context form, select the Workflow Activity History  related list.

5. Right-click an activity and select Workflow Debug  > Toggle Execution Path Highlighting  from 
the context menu.

All activities in that execution path are highlighted in a color selected by the platform. The 
debug path shows all activities that completed successfully during the workflow.
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6. Right-click a rollback activity and select Workflow Debug  > Toggle Rollback Highlighting  from 
the context menu.

The platform highlights the rollback path (restarted activities) in a different color. Each color 
represents a group of activities that were part of the same rollback execution. The highlighting 
includes the activity that initiated the rollback. If you right-click an activity that was not part of a 
rollback, no rows are highlighted.

Note: 
The rollback activity itself appears in both execution path and rollback highlighting.

7. To remove highlighting, right-click in the list and select an option to clear execution path or 
rollback highlighting.

You can clear individual rollback paths or all rollback highlighting.

Use the Workflow Operations Dashboard

On the Workflow Operations Dashboard, view and add widgets to help you monitor workflows. 
Review the performance of workflows and determine which workflows must be improved.

Before you begin
Role required: workflow_admin
The different levels of access are:

• View: View the dashboard and refresh report widgets.

• Customize: Refresh, add, delete, and rearrange widgets.
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About this task
On the Workflow Operations Dashboard, you can click widget elements to view the records they 
represent. You can also add new report widgets that are not displayed by default.

Procedure

1. To view the Workflow Operations Dashboard, navigate to Workflow  > Operations  > Workflow 
Operations Dashboard.

The default reports on the dashboard include:

◦ Workflow contexts providing run time metrics

◦ Active workflows started during a specified time period

◦ Workflows run between yesterday and today

◦ Workflows by state for the current month

◦ Aged workflow contexts for the past month

2. To find and add more widgets, click the Add Content  icon ( ) in the upper left corner of the 
dashboard.

What to do next
If a workflow consistently appears as an outlier and there is no error causing the run time values, 
you can use its historical run time values to calculate a new estimated run time value. Then 
update the estimated run time in the workflow properties.

Workflow gauges

Multiple gauges are available to help you review the performance of workflows. You can add 
these gauges to the Workflow Operations Dashboard or custom homepages.

Important: 

The functionality found in homepages, arranging information from your instance to tell a 
story about your data, is found in dashboards on new instances. On upgraded instances 
with Next Experience  enabled, users can view existing homepages if they have a direct 
URL, but they can't create or edit them. Responsive dashboards and Analytics Center 
dashboards take over homepage functionality.

Use the Homepage deprecation help tool  to convert the homepages on your instance to 
responsive dashboards.

For more information, see:

• Dashboards in the Analytics Center .

• Working with responsive dashboards .

Workflow gauges

Content Description

ERT Dashboard Controls  >

Outlier Finished 
Workflows for ERT 
(Percentage Outlier)

Identifies workflows that finished, but did not finish within estimated 
runtime (ERT) values. Enter an outlier percentage to see workflows 
that ran outside the specified runtime range.
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Workflow gauges  (continued)

Content Description

Outlier Long Running 
Workflows for ERT 
(Percentage Outlier)

Displays workflows running longer than the configured runtime 
threshold.

Workflow Dashboard  >

Workflows Without 
Current Record

Displays workflow contexts that do not have an associated current 
record.

Gauges  > Workflow Context

Number of Active 
Workflows Started 
Hourly Over Time 
(Yesterday)

Displays the total number of running workflows per hour over a given 
time period. By default, it displays the number of workflows that ran 
per hour over the previous day (yesterday).

Outlier Finished 
Workflows Not 
Cumulated to ERT

Displays workflow contexts that are finished outside the estimated 
runtime outlier value and not cumulated to estimated run time value.

Running Workflow 
Contexts

Displays the total number of running workflows.

Successfully Finished 
Workflows Cumulated 
to ERT

Displays the total number of successfully completed workflows 
whose running duration is cumulated to the estimated run time value.

Workflows by State 
(This Month)

Displays the total number of workflows run in a month grouped by the 
current state.

Aged Workflow 
Contexts (Running 
Since Last Month)

Displays the total number of workflow contexts running for a given 
period of time by workflow name. By default, it displays the total 
number of workflow contexts running over the last month.

Workflows Run 
Between Yesterday and 
Today (by Table)

Displays workflows that have run in the last day grouped by table 
name.

Workflow performance timing

The workflow engine can generate detailed performance timing data that is useful for 
troubleshooting slow workflows.

An administrator must enable this functionality.

When workflow performance timing is enabled, the workflow engine tracks key performance 
data, including various execution speed metrics. The Workflow Timing [wf_workflow_timing] table 
stores the data, with a record for each workflow context. The workflow timing record is updated 
when the workflow engine completes the workflow, waits for an activity to complete, or otherwise 
exits the workflow execution.

Workflow estimated run time properties

Administrators can enable the collection of workflow run time metrics by setting Estimated Run 
Time (ERT) properties.
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Administrators can use ERT metrics to determine if workflows are running longer or shorter than 
expected and to identify errors in workflow processing. The system displays run time metrics on 
the Workflow Operations Dashboard.

Enable workflow performance timing

Workflow performance timing is disabled by default. You can create a system property to enable 
it.

Before you begin
Role required: admin

Procedure

Add a system property with the following specifications.

Field Value

Name glide.workflow.show_timing

Type true | false

Value true

Workflow activities

Workflow activity properties reference

Each activity performs a different task, such as running a script, sending notifications, or 
requesting approvals. Activities can succeed or fail, which can result in actions performed by 
other activities.

For information about configuring different types of activities, click an activity name in the list 
below or see Workflow activities reference.

Core activities provided in the base system

• Approval and rollback workflow activities

• Condition Workflow activities

• Notification workflow activity

• Notify workflow activites

• Subflow activities

• Task workflow activities

• Timer workflow activities

• Utility workflow activities

Activities provided with Orchestration

The following activities are included with Orchestration.

• Active Directory activity pack

• Orchestration activities
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• PowerShell activities

• Puppet activities

Templates provided for creating custom activities

If Orchestration is active on your system, users with the proper roles can create custom activities 
using the ServiceNow Orchestration activity designer. For information about the templates 
Orchestration provides for creating custom activities that you can upload to the ServiceNow 
Store, see Activity designer components.

Workflow  activities reference

Workflow activity reference, organized by category.

Each activity performs a different task, such as running a script, sending notifications, or 
requesting approvals.

Workflow runs activities as the user session that starts or advances them. Workflows started from 
record operations will run activities as the user session that performed the record operation. 
Workflows started from schedules or restarted from timers run activities as the System user. 
Workflows started from script calls run activities as the user session that started the script.

Approval and rollback activities

Approval and rollback activities generate and manage approvals.  Not all workflows can include 
approval activities. For more information, read Approval and rollback workflow activities.

Note: 
Approval activities run as the user whose actions match the approve or reject conditions 
the workflow was waiting for and advances the workflow.

Approval and rollback activities

Activity Description

Approval Action 
workflow activity

The Approval Action  activity performs an approval action on the 
current task.

Approval Coordinator 
workflow activity

The Approval Coordinator  activity creates an approval whose 
outcome depends on the outcome of one or more child activities, 
including one or more Approval - User, Approval - Group, and/or 
Manual Approval  activities.

Approval - Group 
workflow activity

The Approval - Group  activity creates approval records for each 
member of a specified group.

Approval - User 
workflow activity

The Approval - User  activity creates one or more individual user 
approvals.

Generate workflow 
activity

The Generate  activity immediately creates task or approval records 
from any task or approval activities placed after the Generate  activity 
in the workflow path. These pre-generated tasks and approvals 
start when the task and approval activities are reached during flow 
execution. This allows a task to have a set of associated pre-generated 
sequential tasks or approvals, but still require them to be completed in 
order.
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Approval and rollback activities  (continued)

Activity Description

Manual Approvals 
workflow activity

The Manual Approvals  activity watches and manages any approvals 
that users add manually outside of the workflow process. This activity 
only selects approvals that are in the Not requested state.

Rollback To workflow 
activity

The Rollback To  activity transitions directly to the activity specified by 
the outgoing transition line arrow.

Condition activities

Condition activities provide conditional branching and logical operation functionality for 
workflows.

Note: 
Condition activities run as the user whose actions match the conditions the workflow was 
waiting for and advances the workflow.

Condition activities

Activity Description

If workflow activity The If  activity checks a condition or script to determine if a Yes  or No 
transition should be taken.

Switch workflow 
activity

The Switch  activity checks if the value of a passed field or variable is 
equivalent to one of several case values.

Wait for condition 
workflow activity

The Wait for condition  activity causes the workflow to wait at this 
activity until the current record matches the specified condition.

Wait for WF Event 
workflow activity

The Wait for WF Event  activity causes the workflow to wait at this 
activity until the specified event is fired.

Notify activities

Notify  workflow activities manage calls and SMS messages in Notify.

Notify activities

Activity Description

Forward call workflow 
activity

The Forward Call  activity forwards a Notify call to an E.164-compliant 
phone number.

Input workflow activity The Input  activity creates a phone menu by presenting a list of options 
on a Notify call.

Hangup workflow 
activity

The Hangup  activity disconnects an active Notify phone call.

Play workflow activity The Play  activity plays a sound file on a Notify call.

Record workflow 
activity

The Record  workflow activity records audio from a user on a Notify call.

Reject workflow The Reject  workflow activity rejects an incoming Notify call.
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Notify activities  (continued)

Activity Description

Say workflow activity The say  workflow activity allows you to play a message, using text to 
speech, on a Notify call.

Forward to notify 
client workflow activity

The forward to notify client  workflow  activity connects a phone call to 
a Notify WebRTC client.

Call workflow activity The Call  activity makes outbound phone calls using a Notify workflow. 
This workflow activity can be added to any table.

Join conference call 
workflow activity

The Join Conference Call  activity connects an incoming or outgoing 
call to a Notify  conference call.

Send SMS workflow 
activity

The send SMS  workflow  activity to send short text messages using 
Notify to users' phones. This workflow activity can be added to any 
table.

Queue workflow 
activity

The Queue  activity places an active Notify call in a queue.

Notification activities

Notification workflow activities notify users of events that occur during the workflow.

Notification activities

Activity Description

Create Event workflow 
activity

The Create Event  activity adds an event to the event queue, but does 
not immediately fire the event.

Notification workflow 
activity

The Notification  activity sends an email or SMS message to specified 
users or groups.

Subflow activities

Subflow activities run and manage workflows from a parent workflow.

Subflow activities

Activity Description

Parallel Flow Launcher 
workflow activity

The Parallel Flow Launcher  activity launches multiple subflows in 
parallel.

Task activities

Task activities create and modify workflow tasks.

Note: 
Task activities run as the user whose actions complete the task the workflow was waiting for 
and advances the workflow.
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Task activities

Activity Description

Add Worknote 
workflow activity

The Add Worknote  activity adds text to the Worknotes  field of the 
current incident record.

Attachment Note 
workflow activity

The Attachment Note  activity adds an attachment to the current 
record.

Catalog Task workflow 
activity

The Catalog Task  activity creates a service catalog task record.

Create Task workflow 
activity

The Create Task  activity generates a record on any of the tables that 
extend Task [task].

Timer activities

Timer activities pause workflows for set periods of time.

Note: 
Timer activities run as the System user because the system scheduler advances the 
workflow.

Timer activities

Activity Description

SLA Percentage Timer 
workflow activity

The SLA Percentage Timer  activity pauses the workflow for a duration 
equal to a percentage of an SLA.

Timer workflow 
activity

The Timer  activity pauses the workflow for a specified period of time.

Utility activities

Utility activities provide controls over the path of the workflow, and other useful tools.

Utility activities

Activity Description

Branch workflow 
activity

The Branch  activity splits the workflow into multiple transition paths 
from a single activity.

Join workflow activity The Join  activity unites multiple execution paths into one transition.

Lock workflow activity The Lock  activity prevents other instances of this workflow from 
continuing past this activity until the lock is released.

Log Message 
workflow activity

The Log Message  activity writes a message to the workflow log.

Log Trace Message 
workflow activity

The Log Trace Message  activity writes a trace message to the 
workflow log.

REST Message legacy 
workflow activity

The legacy  REST Message  activity enables an administrator to 
override the REST endpoint or supply the variables configured in the 
REST Message module.
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Utility activities  (continued)

Activity Description

Return Value workflow 
activity

The Return Value  activity returns a value to a parent workflow, when 
run from a subflow.

Run Script workflow 
activity

The Run Script  activity runs the specified script in the scope of the 
workflow version.

Set Values workflow 
activity

The Set Values  activity sets values on the current record when the 
workflow quiesces or ends.

SOAP Message 
legacy workflow 
activity

The legacy  SOAP Message  activity uses SOAP messages defined in 
the System Web Services plugin and can call the messages using a 
MID Server.

Turnstile workflow 
activity

The Turnstile  activity limits how many times a workflow can pass 
through the same point.

Unlock workflow 
activity

The Unlock  activity releases a lock that was previously placed by the 
Lock  activity.

Activities provided with Orchestration

The following activities are included with Orchestration.

• Active Directory activity pack

• Orchestration activities

• PowerShell activities

• Puppet activities

Templates provided for creating custom activities

If Orchestration is active on your system, users with the proper roles can create custom activities 
using the ServiceNow  Orchestration activity designer . For information about the templates 
Orchestration provides for creating custom activities that you can upload to the ServiceNow 
Store, see Orchestration custom activity templates

Approval and rollback workflow  activities

Approval and rollback activities generate and manage approvals.

Approval and rollback activities are not available in some workflows.

• With two exceptions, approval and rollback activities are only available when the workflow runs 
on a table that extends Task. The exceptions are the Approval - User  and Approval Action 
activities, which are available globally.

• Approval and rollback activities are available only if approval engines are turned off for the 
table on which the workflow runs. If approval engines are enabled for the table, approval 
activities appear greyed out and cannot be selected. To learn more about how workflow and 
approval engines interact, read Approval workflow activities and approval engines.

Approval Action workflow activity

The Approval Action  activity performs an approval action on the current task.

Use this activity to mark the current task record as approved or rejected.
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Note: 
When an Approval Action  activity is used to mark a task approved, the activity marks 
all pending approvals as No Longer Required. This activity behaves differently from Set 
Values  or Run Script  when used to set the Approval  field's value.

Results

The result value of the activity is the final approval disposition selected by the approver. The 
result value can be Approved  or Rejected. A workflow designer can assign a result value using 
the activity.result  variable from within a script field of the activity.

Input variables

Input variables determine the initial behavior of the activity.

Approval Action activity input variables

Field Description

Action The action to perform on the task. Options are:

• Mark task approved

• Mark task rejected

• Mark task requested

• Disregard pending approvals: the system sets approval records to no longer 
required  and marks the activity as approved.

Conditions

The conditions determine which transition runs after this activity.

Note: 
Approval activities run as the user whose actions match the approve or reject conditions 
the workflow was waiting for and advances the workflow.

Approval Action activity conditions

Condition Description

Always The event or condition that causes the approval to move to the next workflow step.

Error The event or condition that generates an error.

Skipped The event or condition that allows a skipped approval.

States

The activity state tells the workflow engine what to do with the activity.

Approval Action activity states

State Description

Executing The workflow engine starts the execute  function of the activity.
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Approval Action activity states  (continued)

State Description

Waiting The workflow engine ignores the activity until a specific event to restart the activity 
is fired.

Finished The activity finished running. See the result value for the outcome of the activity.

Cancelled This activity, or the workflow that contains this activity, was canceled.

Error A JavaScript error occurred. Review the logs for error details.

Approval Coordinator workflow activity

The Approval Coordinator  activity creates an approval whose outcome depends on the 
outcome of one or more child activities, including one or more Approval - User, Approval - 
Group, and/or Manual Approval  activities.

Note: 
This activity is only available when the workflow runs on a table that extends Task.

To create an Approval Coordinator  activity, first drag the activity onto the workflow canvas, 
causing the activity form to display. On the activity form, fill in the appropriate fields, then click 
Submit.

After you click Submit, the activity appears on the workflow canvas. From there, specify the child 
activities by clicking the links that appear on the body of the activity.

When the Approval Coordinator  activity completes, all pending approvals that were created by 
any of the Approval Coordinator  approval activities are immediately set to No Longer Required. 
If a single user is called as an approver twice by the same workflow, such as when a single user is 
both a product approver and an executive approver, any approvals for that user after the first are 
skipped.

Results

The result value of the Approval Coordinator  activity depends on the approval actions taken by 
the approvers and the approval conditions specified in the Wait for  field. Possible result values 
are:

• Approved

• Rejected

• Deleted

• Cancelled

Input variables

Input variables determine the initial behavior of the activity.

Approval Coordinator activity input variables

Field Description

Wait for
Indicate what to wait for to indicate that the approval activity is 
approved or rejected. Options are:
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Approval Coordinator activity input variables  (continued)

Field Description

• Any child activity to be approved:  Any child activity (User, Group, or 
Manual Approval) that completes with a result of approved  causes 
the Approval Coordinator  activity to complete with a result of 
approved.

• All child activities to be approved:  All child activities of the 
Approval Coordinator  activity must complete with a a result of 
approved  to cause the Approval Coordinator  activity to complete 
with a result of approved.

• The first approval or rejection from any child activity:  The first child 
activity that completes with a result of approved  or rejected  causes 
the Approval Coordinator  activity to complete with the same result.

• Condition based on script:Call a script to determine how to manage 
an approval or rejection.

When a rejection 
occurs

Only appears if 
Wait for  is set to All 
child activities to 
be approved  or Any 
child activity to be 
approved.

Specify what the coordinator should do when it sees a rejection from 
any one of the child activities. Options are:

• Reject the approval:  Immediately complete the Approval 
Coordinator  activity with a result of rejected.

• Wait for other responses before deciding:  Wait until we get other 
responses from other child activities before making an approval or 
rejection decision.

This allows users to change their minds until a decision is made.

In addition, if Wait for  is set to Any child activity to approve  then 
a single child activity completion with a result of approved  will 
cause the Approval Coordinator  activity to complete with a result of 
approved  even if other child activities have completed with a result 
of rejected.

Approval script

Only appears if Wait 
for  is set to Condition 
based on script.

If the Wait for  variable is set to Condition based on script  this script is 
called to determine how to handle an approval or rejection. The script 
needs to set the variable answer  to , approved or rejected to indicate 
the overall approval status for this approval. When called, the following 
variable is available to the script:

counts.total = total number of child approval 
 activities that are part of this approval
      counts.approved =   of child approval 
 activities that approved so far
      counts.rejected =   of child approval 
 activities that rejected so far
      counts.requested =   of child approval 
 activities that are pending approval

Conditions

The conditions determine which transition runs after this activity.
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Note: 
Approval activities run as the user whose actions match the approve or reject conditions 
the workflow was waiting for and advances the workflow.

Approval Coordinator activity conditions

Condition Description

Approved The users from the groups have approved the request based on the Wait for  rules.

Rejected The users from the groups have rejected the request based on the Wait for  rules.

States

The activity state tells the workflow engine what to do with the activity.

Approval Coordinator activity states

State Description

Executing The workflow engine starts the execute  function of the activity.

Waiting The workflow engine ignores the activity until a specific event to restart the activity 
is fired.

Finished The activity finished running. See the result value for the outcome of the activity.

Cancelled This activity, or the workflow that contains this activity, was canceled.

Error A JavaScript error occurred. Review the logs for error details.

Approval - Group workflow activity

The Approval - Group  activity creates approval records for each member of a specified group.

Note: 
This activity is only available when the workflow runs on a table that extends Task.

The group approval is approved or rejected based on the user approvals, according to the logic 
specified in the Wait For  field.

Results

The workflow designer can assign a result value using activity.result from within a script field of 
the activity. By default, the result value is the final approval disposition. This disposition depends 
on the approval actions take by the approvers and the approval conditions specified in the Wait 
for  or When Anyone Rejects  fields. Possible result values are:

• Approved

• Rejected

• Deleted

• Cancelled

Input variables

Input variables determine the initial behavior of the activity.
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Approval - Group activity input variables

Field Description

Approval - Group When

Specify when this activity generates a group approval record.

Condition Conditions which, if met, cause the group approval to be generated. If the 
conditions are not met, the approval is skipped.

Approval - Group Approvers

Specify the groups whose approval will be requested.

Groups The groups whose approval will be requested.

To edit this field, click the lock icon. To select specific groups by name, 
use the lookup list. To select groups from field values on the current 
record at runtime, click the tree icon.

Each member of the group will be assigned an individual approval record.

If no group is selected, the activity automatically sets the approval to 
Approved.

Approval - Group Condition

Specify how the activity decides to approve or reject the group approval, based on the 
responses from individual members of the group.

Wait for
A choice between different approval logics to determine which individual 
approvals or rejections result in approval or rejection of the activity's 
approval. Options are:

• An approval from each group:  Any user from each group can approve 
and the first approval from each group causes the activity to complete 
with a result of approved  (see below for how a rejection is handled).

• An approval from any group:  Any user from any group can approve 
and the first approval from any group causes the activity to complete 
with a result of approved.

• An approval from everyone from all groups:  All users from all groups 
must approve to cause the activity to complete with a result of 
approved  (see below for how a rejection is handled).

• First response from each group:  The first approval or rejection from 
any user in each group is used to indicate the state of the group 
approval (see below for how a rejection is handled).

Indicate what happens when any user rejects their approval request. 
Options are:

• Reject the approval:  Immediately complete the activity with a result of 
rejected.
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Approval - Group activity input variables  (continued)

Field Description

• First response from any group:  The first approval or rejection from 
any user in any group causes the activity to complete with a result of 
approved  or rejected.

• Condition based on script:  Each time a user approves or rejects, the 
Approval script  is called to determine if the activity should complete.

Approval script

Only appears when 
Wait for  is set 
to Condition 
based on 
script.

If the Wait for  variable is set to Condition based on script  this script is 
called to determine how to handle an approval or rejection. The script 
needs to set the variable answer  to approved or rejected to indicate the 
overall status for this approval.

This script is responsible for setting the approval state for each group 
that is part of this approval activity before returning the overall approval 
state for all of the groups.

When called, the following variables are available to the script for all the 
groups that are part of this approval activity:

counts.total = total number of groups that are 
 part of this approval
                  counts.approved =   of groups 
 that approved so far
                  counts.rejected =   of groups 
 that rejected so far
                  counts.requested =   of groups 
 that are pending approval
                  counts.not_requested =   of 
 groups that are not pending approval
                  counts.not_required =   of 
 groups that approval is not required

And for each group:

groups[group_id].total = total number of users 
 that are part of this group's approval
                    groups[group_id].approved = 
   of users that approved so far
                    groups[group_id].rejected = 
   of users that rejected so far
                    groups[group_id].requested = 
   of users that are pending approval
                   
 groups[group_id].not_requested =   of users 
 that are not pending approval
                   
 groups[group_id].not_required =   of users that 
 approval is not required
                   
 groups[group_id].approvalIDs[state] = array 
 of user ids that are at the specified approval 
 state

Note: Iterate the groups using:
© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

5358



Approval - Group activity input variables  (continued)

Field Description

for (var id in groups) {
                    var group = groups[id];
                    ... group.total ...
                    }

Note: Get group object using the following code (to get things like the 
group name being iterated on):

var objGroup = fncGetGroupObj(id);
                    var strGroupName = 
 objGroup.name;
 
                    function 
 fncGetGroupObj(sidGroupApproval)
                    {
                    var objGroupApproval = new 
 GlideRecord('sysapproval_group');
                   
 objGroupApproval.get(sidGroupApproval);
 
                    var objGroup = new 
 GlideRecord('sys_user_group');
                   
 objGroup.get(objGroupApproval.assignment_group.
sys_id);
 
                    return objGroup;
                    }

Approval scripts also allow computations. For example, if only half of the 
approvals are required:

if (counts.approved/counts.total > .49) {
                    answer = 'approved';
                    }
                    else if 
 (counts.rejected/counts.total > .50) {
                    answer = 'rejected';
                    }

When anyone 
rejects A choice between different approval logics to determine which individual 

rejections result in rejection of the activity's approval. Options are:

• Reject the approval:  Immediately complete the activity with a result of 
rejected.

• Wait for other responses before deciding:  Wait until we get other 
responses before making an approval or rejection decision. This allows 
users to change their mind until a decision is made.
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Approval - Group activity input variables  (continued)

Field Description

Note: 
If Wait for  is set to Anyone to approve, then a single approval 
causes the activity to complete with a result of approved, even if 
one or more users reject.

Approval - Group Schedule

Specify how workflow calculates the approval record's expected start date and due date. Once 
you've made a selection for 'Due date based on', and 'Schedule based on', the appropriate 
fields will display.

Due date based on Select how workflow determines the task's duration, due date, and 
schedule.

• A user specified duration:  The duration is based on a user specified 
value.

• A relative duration:  The duration is calculated from a relative duration 
(such as End of Next Business Day).

• A date/time or duration field:  The duration is based on the value of a 
field on the current record.

• Script:  The duration is returned by a script.

Duration

Only appears when 
Due date based on 
is set to A user 
specified 
duration

The specific number of days and hours.

Relative duration

Only appears 
when Due date 
based on  is set 
to A relative 
duration

The general number and length of business days.

Due date field

Only appears 
when Due date 
based on  is set to 
A date/time 
or duration 
field

The date/time or duration field.

Due date script

Only appears when 
Due date based on 
is set to  Script

The script that sets 'answer' to the number of seconds for the duration.
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Approval - Group activity input variables  (continued)

Field Description

Schedule based on The basic schedule the timer uses to count working hours. If a schedule 
is specified, the duration will only be considered for times that are 
specified on the schedule. For example, if the duration is 2 hours and the 
workflow begins at 4:00pm on a schedule that is 8am - 5pm, then it ends 
at 9:00am the next day. The options are:

• This workflow's schedule:  The schedule uses workflow context date, 
time, and an optional Time zone based on  value.

• A specific schedule:  The schedule uses a pre-defined Schedule  and 
an optional Time zone based on  value.

• A schedule field:  The schedule uses a value from a table and an 
optional Time zone based on  value.

Schedule

Only appears 
when Schedule 
based on  is set 
to  A specific 
schedule

The predefined Schedule  from a list.

Schedule field

Only appears 
when Schedule 
based on  is set 
to  A schedule 
field.

A date and time or duration field for the schedule, that is associated with 
the table. Valid fields appear in blue on the Select the element from a tree 
dialog.

Time zone based 
on

The time zone for calculating the duration. The time zone may be based 
on:

• No time zone:  Default. Workflow uses the GMT time zone.

• A specific time zone:  A specific Time zone  that you choose from a 
choice list.

• A time zone field:  A Time zone field  to track time duration from a field 
on the form.

Time zone

Only appears when 
Time zone based 
on  is set to  A 
specific time 
zone

.

Select the time zone you want from the choice list.

Time zone field

Only appears 
when Time zone 
based on  is set to 

A date and time or duration field for the schedule, that is associated with 
the table. Valid fields appear in blue on the Select the element from a tree 
dialog.
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Approval - Group activity input variables  (continued)

Field Description

A time zone 
field.

Approval - Advanced

If desired, write a script for determining additional users to request approvals from.

Advanced Select this check box to write a script for determining additional users to 
request approvals from. Use the Additional groups script  to customize 
group approvals.

Additional groups 
script If the Advanced  check box is selected, this script is called to determine 

any additional group approvals to be created. The script needs to set the 
variable answer  to a comma-separated list of group ids or an array of 
group ids to add as approver groups. For example:

answer = [];
       answer.push('id1');
       answer.push('id2');

Conditions

The following conditions determine which transition runs after this activity.

Note: 
Approval activities run as the user whose actions match the approve or reject conditions 
the workflow was waiting for and advances the workflow.

Approval - Group activity conditions

Condition Description

Approved The users from the groups have approved the request based on the Wait for  rules.

Rejected The users from the groups have rejected the request based on the Wait for  rules.

Error The event or condition that generates an error.

Skipped The event or condition that allows a skipped approval.

States

The activity state tells the workflow engine what to do with the activity.

Approval - Group activity states

State Description

Executing The workflow engine starts the execute  function of the activity.

Waiting The workflow engine ignores the activity until a specific event to restart the activity 
is fired.

Finished The activity finished running. See the result value for the outcome of the activity.
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Approval - Group activity states  (continued)

State Description

Cancelled This activity, or the workflow that contains this activity, was canceled.

Error A JavaScript error occurred. Review the logs for error details.

Approval - User workflow activity

The Approval - User  activity creates one or more individual user approvals.

Results

The result value is the final approval disposition. This disposition depends on the approval 
actions take by the approvers and the approval conditions specified in the Wait for  or When 
Anyone Rejects  fields. Possible result values are:

• Approved

• Rejected

• Deleted

• Cancelled

Input variables

Approval - User activity input variables

Field Description

Approval - User When

Specify when this activity generates a user approval record.

Condition Conditions which, if met, cause the individual approval to be generated. If 
the conditions are not met, the approval is skipped.

Approval - User Approvers

Specify the users whose approval will be requested.

Users The users for the approval. Use the tree icon to select user 
reference fields from the current record to create approvals, such as 
${assigned_to}. If no user is selected, the activity automatically sets 
the approval to Approved.

Note: 
Workflow only manages approval records generated by the 
Approval User activity. After starting the workflow, newly added 
approvals do not affect the workflow context.

Groups Groups whose members should also receive approvals. Note that this 
is different than the Approval - Group  activity, which creates a group 
approval in addition to the individual approvals. The tree icon can be 
used to select group reference fields from the current record to create 
approvals, such as ${assignment_group}.

Approval - User Condition
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Approval - User activity input variables  (continued)

Field Description

Specify how the activity decides to approve or reject the approval, based on the responses 
from individual approvers.

Wait for A choice between different approval logics to determine which individual 
approvals result in approval of the activity's approval. Options are:

• Anyone to approve:  Any user can approve and the first approval 
causes the activity to complete with a result of approved.

• Everyone to approve:  All users must approve (see below for how a 
rejection is handled).

• First response from anyone:  The first approval or rejection from any 
user causes the activity to complete.

• Condition based on script:  Each time a user approves or rejects, the 
Approval script  is called to determine if the activity should complete.

When anyone 
rejects A choice between different approval logics to determine which individual 

rejections result in rejection of the activity's approval. Options are:

• Reject the approval:  Immediately complete the activity with a result of 
rejected.

• Wait for other responses before deciding:  Wait until we get other 
responses before making an approval or rejection decision. This allows 
users to change their mind until a decision is made.

Note: 
Note that if Wait for  is set to Anyone to approve  then a single 
approval will cause the activity to complete with a result of 
approved  even if one or more users reject.

Approval Column
A string field for the name of the approval field on the table the workflow 
is running on. The default value is approval, which is the field on the Task 
table.

Note: 
Use the field's name, not its label.

If using any custom approval column fields and approval column 
journals, use Set Value activities in the workflow to set the custom 
Approval column fields.

Approval Journal 
Column

Approval Script
If the Wait for  variable is set to Condition based on script  this script is 
called to determine how to handle an approval or rejection. The script 
needs to set the variable answer  to approved or rejected to indicate the 
approval status for this approval. When called, the following information is 
available:
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Approval - User activity input variables  (continued)

Field Description

 counts.total = total number of users that are 
 part of this approval
                    counts.approved =   of users 
 that approved so far
                    counts.rejected =   of users 
 that rejected so far
                    counts.requested =   of 
 users that are pending approval
                    counts.not_requested =   of 
 users that are not pending approval
                    counts.not_required =   of 
 users that approval is not required

Approval - User Schedule

Specify how workflow calculates the approval record's expected start date and due date. Once 
you've made a selection for 'Due date based on', and 'Schedule based on', the appropriate 
fields will display.

Due date based on Select how workflow determines the task's duration, due date, and 
schedule.

• A user specified duration:  The duration is based on a user specified 
value.

• A relative duration:  The duration is calculated from a relative duration 
(such as End of Next Business Day).

• A date/time or duration field:  The duration is based on the value of a 
field on the current record.

• Script:  The duration is returned by a script.

Duration

Only appears when 
Due date based on 
is set to A user 
specified 
duration

The specific number of days and hours.

Relative duration

Only appears 
when Due date 
based on  is set 
to A relative 
duration

The general number and length of business days.

Due date field

Only appears 
when Due date 
based on  is set to 
A date/time 

The date/time or duration field.
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Approval - User activity input variables  (continued)

Field Description

or duration 
field

Due date script

Only appears when 
Due date based on 
is set to  Script

The script that sets 'answer' to the number of seconds for the duration.

Schedule based on The basic schedule the timer uses to count working hours. If a schedule 
is specified, the duration will only be considered for times that are 
specified on the schedule. For example, if the duration is 2 hours and the 
workflow begins at 4:00pm on a schedule that is 8am - 5pm, then it ends 
at 9:00am the next day. The options are:

• This workflow's schedule:  The schedule uses workflow context date, 
time, and an optional Time zone based on  value.

• A specific schedule:  The schedule uses a pre-defined Schedule  and 
an optional Time zone based on  value.

• A schedule field:  The schedule uses a value from a table and an 
optional Time zone based on  value.

Schedule

Only appears 
when Schedule 
based on  is set 
to  A specific 
schedule

The predefined Schedule  from a list.

Schedule field

Only appears 
when Schedule 
based on  is set 
to  A schedule 
field.

A date and time or duration field for the schedule, that is associated with 
the table. Valid fields appear in blue on the Select the element from a tree 
dialog.

Time zone based 
on

The time zone for calculating the duration. The time zone may be based 
on:

• No time zone:  Default. Workflow uses the GMT time zone.

• A specific time zone:  A specific Time zone  that you choose from a 
choice list.

• A time zone field:  A Time zone field  to track time duration from a field 
on the form.

Time zone

Only appears when 
Time zone based 
on  is set to  A 

Select the time zone you want from the choice list.
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Approval - User activity input variables  (continued)

Field Description

specific time 
zone

.

Time zone field

Only appears 
when Time zone 
based on  is set to 
A time zone 
field.

A date and time or duration field for the schedule, that is associated with 
the table. Valid fields appear in blue on the Select the element from a tree 
dialog.

Approval - Advanced

If desired, write a script for determining additional users to request approvals from.

Advanced Select this check box to write a script for determining additional users to 
request approvals from.

Additional 
approvers script If the Advanced  check box is selected, this script is called to determine 

any additional user approvals to be created. The script needs to set the 
variable answer  to a comma-separated list of user ids and group ids or 
an array of user and group ids to add as approvers. For example:

answer = [];
       answer.push('id1');
       answer.push('id2');

Conditions

The following conditions determine which transition runs after this activity.

Note: 
Approval activities run as the user whose actions match the approve or reject conditions 
the workflow was waiting for and advances the workflow.

Approval - User activity conditions

Condition Description

Approved The users approved the request based on the Wait for  rules.

Rejected The users rejected the request based on the Wait for  rules.

Error The event or condition that generates an error.

Skipped The event or condition that allows a skipped approval.

States

The activity state tells the workflow engine what to do with the activity.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

5367



Approval - User activity states

State Description

Executing The workflow engine starts the execute  function of the activity.

Waiting The workflow engine ignores the activity until a specific event to restart the activity 
is fired.

Finished The activity finished running. See the result value for the outcome of the activity.

Cancelled This activity, or the workflow that contains this activity, was canceled.

Error A JavaScript error occurred. Review the logs for error details.

Generate workflow activity

The Generate  activity immediately creates task or approval records from any task or approval 
activities placed after the Generate  activity in the workflow path. These pre-generated tasks and 
approvals start when the task and approval activities are reached during flow execution. This 
allows a task to have a set of associated pre-generated sequential tasks or approvals, but still 
require them to be completed in order.

Note: 
This activity is only available when the workflow runs on a table that extends Task.

By default, the workflow does not create any tasks or approvals until it reaches them in the 
workflow.

The Generate  activity follows all transitions through the workflow to each activity. For each 
activity:

• If it is a task activity, creates the task and sets:

◦ The State  to Pending

◦ The Expected Start Date

◦ The Due Date

Note: 
Task activities run as the user whose actions complete the task the workflow was waiting 
for and advances the workflow.

• If it is an approval activity, creates the approvals and sets:

◦ The approval State  to Not Requested

◦ The Expected Start Date

◦ The Due Date

Note: 
Approval activities run as the user whose actions match the approve or reject conditions 
the workflow was waiting for and advances the workflow.

Expected start dates and due dates are calculated based on the Expected Duration  of all of the 
tasks and approvals between the Generate  activity and the activity being updated. In the case 
of a branched path (between a Branch  and Join  activity), the longer duration will be used for any 
post-branch activities.

The Generate  activity can be used more than once, and any tasks or approvals will be refreshed 
with updated information. This is useful in situations where the list of approvers or other 
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important information is still editable while the workflow is in process and it may be necessary to 
update or correct the generated approvals or tasks.

To exclude a set of activities from the Generate  activity, select the Skip during generate  check 
box on any condition and its transitions will not be followed during the generate process. By 
default, the following conditions have the Skip during generate  check box selected:

• Rejected  (for any of the approval activities)

• No  condition of If  activity

• Continue  condition of Turnstile  activity

• Incomplete  condition of Join  activity

Input variables

Input variables determine the initial behavior of the activity.

Generate activity input variables

Field Description

Generate 
approvals

If selected, approvals are created when running the Generate  activity. If cleared, 
the approvals are used to compute their estimated duration, but no approvals are 
created.

Generate 
tasks

If selected, tasks are created when running the Generate  activity. If cleared, the 
tasks are used to compute their estimated duration, but no tasks are created.

States

The activity state tells the workflow engine what to do with the activity.

Generate activity states

State Description

Executing The activity is executing.

Finished The activity finished running. See the result value for the outcome of the activity.

Cancelled This activity, or the workflow that contains this activity, was canceled.
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Example

Generate workflow

In this example, the following approvals are generated:

• Approval-2

• Approval-3

Approval-4 is skipped since the Rejected  condition of Approval-3 has Skip during generate 
selected.

Here is an example of using the Generate  activity that describes the expected start and due 
dates:

Generate workflow start and due date

In this example, if the Generate  activity is run on Jan 1, 2016, the following expected start dates 
and due dates would be set for the generated tasks.

Task Expected Start Date Reason Due Date

Task 1 (1 day) Jan. 1, 2016 Jan. 2, 2016

Task 2 (1 day) Jan. 2, 2016 Task 1 is 1 day Jan. 3, 2016

Task 3 (2 days) Jan. 1, 2016 Jan. 3, 2016

Task 4 (1 day) Jan. 3, 2016 Task 3 is 2 days Jan. 4, 2016
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Task Expected Start Date Reason Due Date

Task 5 (1 day) Jan. 4, 2016 Task 4 ends the latest before the Join Jan. 5, 2016

Notice that Task 5 starts on Jan. 4, 2016 since the longest path (based on due dates) to the Join 
is Task 3/Task 4.

Manual Approvals workflow activity

The Manual Approvals  activity watches and manages any approvals that users add manually 
outside of the workflow process. This activity only selects approvals that are in the Not requested 
state.

Note: 
This activity is only available when the workflow runs on a table that extends Task.

If there are no pending manual approvals when this activity executes, the activity immediately 
completes with a result of approved. This activity does not create approval records. Use 
this activity to pause the workflow when a user adds a manual approval to a record with an 
associated workflow, and it is in the Not requested state. The workflow waits for the approval to 
be closed before proceeding.

Results

The workflow designer can assign a result value using activity.result  from within a script 
field of the activity. By default, the result value of the activity is the final approval disposition 
determined by the approval actions take by the approvers. Possible result values are:

• Approved

• Rejected

• Deleted

• Cancelled

• Error

Input variables

Input variables determine the initial behavior of the activity.

Manual Approvals activity input variables

Field Description

Wait for
Indicate what to wait for to indicate that the approval activity is approved or rejected. 
Options are:

• Any manual user or group approval:  Any user can approve and the first approval 
causes the activity to complete with a result of approved.

• All manual user or group approvals:  All users must approve (see below for how a 
rejection is handled).

• The first response from any manual approval:  The first approval or rejection from 
any user causes the activity to complete.

When 
anyone 
rejects

Indicate what happens when any user rejects their approval request. Options are:

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

5371



Manual Approvals activity input variables  (continued)

Field Description

• Reject the approval:  Immediately complete the activity with a result of rejected.

• Wait for other responses before deciding:  Wait until we get other responses 
before making an approval or rejection decision. This allows users to change their 
mind until a decision is made.

In addition, if Wait for  is set to Anyone to approve  then a single approval will cause 
the activity to complete with a result of approved  even if one or more users reject.

Conditions

The conditions determine which transition runs after this activity.

Note: 
Approval activities run as the user whose actions match the approve or reject conditions 
the workflow was waiting for and advances the workflow.

Manual Approvals activity conditions

Condition Description

Approved The users from the groups have approved the request based on the Wait for  rules.

Rejected The users from the groups have rejected the request based on the Wait for  rules.

States

The activity state tells the workflow engine what to do with the activity.

Manual Approvals activity states

State Description

Executing The workflow engine starts the execute  function of the activity.

Waiting The workflow engine ignores the activity until a specific event to restart the activity 
is fired.

Finished The activity finished running. See the result value for the outcome of the activity.

Cancelled This activity, or the workflow that contains this activity, was canceled.

Error A JavaScript error occurred. Review the logs for error details.

Rollback To workflow activity

The Rollback To  activity transitions directly to the activity specified by the outgoing transition line 
arrow.

Note: 
This activity is only available when the workflow runs on a table that extends Task.

Rollback To  determines which activities to reset based on the actual workflow sequence 
(transition line attachments) of activities between itself and the transitioned to activity, not the 
execution order. Rollback To  then marks all the approvals that have transitioned between the 
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rollback and the transitioned to activity as Not Yet Requested  and the tasks as either Open  or 
Pending.

Use the Rollback To  activity for all workflows in which multiple rollbacks are required. Rollback 
To  has no variables.

Conditions

The conditions determine which transition runs after this activity.

Rollback To activity conditions

Condition Description

Always The event or condition that causes the approval to revert to the previous workflow 
step.

Error The event or condition that generates an error.

Skipped The event or condition that allows a skipped approval.

States

The activity state tells the workflow engine what to do with the activity.

Rollback To activity states

State Description

Executing The workflow engine starts the execute  function of the activity.

Waiting The workflow engine ignores the activity until a specific event to restart the activity 
is fired.

Finished The activity finished running. See the result value for the outcome of the activity.

Cancelled This activity, or the workflow that contains this activity, was canceled.

Error A JavaScript error occurred. Review the logs for error details.

Rollback To behavior

The Rollback To  activity transitions directly to the activity specified by the transition line arrow.

Use the Rollback To  activity for all workflows that use multiple or nested rollbacks. Rollback To 
resets the targeted task (the direct transition) to Open. All tasks that have executed between the 
Rollback To  activity and the targeted task (rolled back task) are set to Pending.

(0) Begin

(1) Log Message

(2) Task 1

(3) Task 3

(4) Task 2

(5) Timer

(6) Approval 1
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(7) Roll back to first task

(8) Task 1

(9) Task 2

(10) Approval 1

(11) Log approval

(12) Join

(14) Send email

(15) End

Rollback to workflow

Transition history

The state of (3) Task 3 does not change, since this activity does not directly transition from the 
rollback target activity. To see what activities were rolled back, select the Workflow Transition 
History  related list and look at the Rolled back  column.

The Rollback To  activity (7) updates the following activities:

(8) Task 1: reset to Open

(9) Task 2: reset to Pending

(10) Approval 1: reset to Not Yet Requested
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Rollback To workflow transition

Rollback To activity

When conditions in a workflow trigger a Rollback To  activity, the workflow moves processing 
backward to a specified activity in the workflow and resets certain activities that have already 
executed back to their original state. This is useful when handling an unexpected failure or as 
part of a programmed logical flow.

When an activity is reset during a workflow rollback, the following happens:

• Approvals are reset to Not Requested.

• Tasks are reset to either Open  or Pending. A rollback workflow path cannot create new tasks.

Activities that perform external system operations, such as deleting a file or sending an email, are 
not rolled back. Only approval and task activity states are reset.

A workflow can contain a single rollback, multiple rollbacks, or nested rollbacks in more complex 
workflows. The Rollback To  activity resets activities based on the actual workflow sequence 
(transition line attachments) of activities between itself and the transitioned to activity, rather 
than using the execution order to determine where processing should restart.

Condition Workflow  activities

Condition activities provide conditional branching and logical operation functionality for 
workflows.

If workflow activity

The If  activity checks a condition or script to determine if a Yes  or No  transition should be taken.

If the workflow creator specifies both the Condition  and the Advanced  script, both must evaluate 
successfully for activity to take the Yes  transition.

Results

The workflow designer can assign a result value using activity.result from within the Script  field 
on the activity record. By default, the result value of the activity is the final result of the condition 
or script specified. Possible result values are:

• Yes

• No
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Input variables

The following variables determine the behavior of the activity.

Note: 
Condition activities run as the user whose actions match the conditions the workflow was 
waiting for and advances the workflow.

If activity input variables

Field Description

Condition If specified and the current record matches the condition, the Yes  transition is 
taken.

Advanced 
and 
Script

To specify a script, select the Advanced  check box. You may then enter a script 
that is evaluated. If your script sets the variable answer to yes, then the Yes 
transition is taken. Otherwise, the No  transition is taken.

Conditions

The following conditions determine which transition comes after the activity.

If activity conditions

Condition

Yes Taken when the condition, if specified, matches and the Advanced  script, if 
specified, returns yes.

No Taken when either the condition does not match or the Advanced  script, if specified, 
returns no.

States

The activity state tells the workflow engine what to do with the activity.

If activity states

State Description

Executing The workflow engine knows to start the onExecute  function of the activity.

Waiting The workflow engine ignores the activity until a specific event to restart the activity 
is fired.

Finished The activity finished running. See the result value for the outcome of the activity.

Cancelled This activity, or the workflow that contains this activty, was canceled.

Error A JavaScript error occurred. Review the logs for error details.

Switch workflow activity

The Switch  activity checks if the value of a passed field or variable is equivalent to one of several 
case values.

The switch activity behavior is similar to a switch statement in Java.
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When creating a switch activity, select a Variable  or Field  to check against activity conditions for 
a matching field value. When the value passed in this variable or field matches the value defined 
in the Condition  field of the activity condition, the workflow progresses through that activity 
condition.

Note: 
Condition activities run as the user whose actions match the conditions the workflow was 
waiting for and advances the workflow.

Results

The variable or field selected in the Variable  or Field  activity variable determines the possible 
result values.

Input variables

The following variables determine the behavior of the activity.

Switch activity input variables

Field Description

Type Select Variable  or Field  as the type of value to check against available conditions. 
This selection sets the label and available options for the other field.

Variable 
or Field Select the source of the value compared against the switch activity conditions. The 

field label and available options depend on the Type  selection.

• Variable:  select any service catalog variable.

• Field:  select any field from the Table  defined in the workflow properties.

States

The activity state tells the workflow engine what to do with the activity.

Switch activity states

State Description

Executing The workflow engine knows to start the onExecute  function of the activity.

Waiting The workflow engine ignores the activity until a specific event to restart the activity 
is fired.

Finished The activity finished running. See the result value for the outcome of the activity.

Cancelled This activity, or the workflow that contains this activity, was canceled.

Error A JavaScript error occurred. Review the logs for error details.

Example

You can create a switch activity that sets different field values on an incident based on the 
Assignment group of the incident record.
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Switch activity example

The Field  selected is the incident Assigned to  field.

Switch activity Field

If the value of the Assigned to  field of the workflow-triggering incident is Service Desk  or 
Field Services, the workflow populates values on the incident record before continuing. If the 
Assigned to  value is Hardware, the workflow continues without populating any field values.

Condition type (Standard, Else, or Error) is used. For more information, see Manage workflow 
activity conditions.
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Hardware group condition

Wait for condition workflow activity

The Wait for condition  activity causes the workflow to wait at this activity until the current record 
matches the specified condition.

The workflow evaluates the Wait for condition  activity each time the current record is updated. 
Use this activity to pause a workflow indefinitely until a particular criteria is met by a record 
update. To pause a workflow for a timed duration see Timer workflow activities.

For workflow to consider the condition met, all conditions specified – whether in the builder or in 
a script – must be true.

Note: 
A Wait for condition activity  should only be used to wait for an external event such as a 
record update, and not one from a workflow setting a value. If you have a workflow setting 
a value and want to wait for that same field to be seen as 'changed,' try inserting a one-
second timer.

Results

The workflow designer can assign a result value using activity.result  from within a script 
field of the activity. The activity transitions when the result value is true.

Input variables

The following variables determine the behavior of the activity.

Note: 
Condition activities run as the user whose actions match the conditions the workflow was 
waiting for and advances the workflow.
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Wait for condition activity input variables

Field Description

Condition The workflow is paused at this activity until this condition matches the current 
record.

Condition 
script

If specified, the workflow is paused at this activity until this script sets the 
answer  variable to true.

States

The activity state tells the workflow engine what to do with the activity.

Wait for condition activity states

State Description

Executing The workflow engine knows to start the onExecute  function of the activity.

Waiting The workflow engine ignores the activity until a specific event to restart the activity 
is fired.

Finished The activity finished running. See the result value for the outcome of the activity.

Cancelled This activity, or the workflow that contains this activty, was canceled.

Error A JavaScript error occurred. Review the logs for error details.

Wait for WF Event workflow activity

The Wait for WF Event  activity causes the workflow to wait at this activity until the specified 
event is fired.

Use this activity to wait for another activity to fire an event. Events from other activities are fired in 
a script using the workflow.fireEvent('eventName') API call.

Results

The workflow designer can assign a result value using activity.result  from within a script 
field of the activity. This activity transitions when the specified event fires.

Input variables

The following variables determine the behavior of the activity.

Note: 
Condition activities run as the user whose actions match the conditions the workflow was 
waiting for and advances the workflow.

Wait For WF Event activity input variables

Field Description

Wait for Event An event name to trigger the workflow.

States

The activity state tells the workflow engine what to do with the activity.
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Wait For WF Event activity states

State Description

Executing The workflow engine knows to start the onExecute  function of the activity.

Waiting The workflow engine ignores the activity until a specific event to restart the activity 
is fired.

Finished The activity finished running. See the result value for the outcome of the activity.

Cancelled This activity, or the workflow that contains this activity, was canceled.

Error A JavaScript error occurred. Review the logs for error details.

Notify workflow activities

Notify  workflow activities manage calls and SMS messages in Notify.

All Notify  workflows that manage a phone call must run on the notify_call table. Call-related Notify 
activities can be added only to workflows where the Table  field value is Notify Call [notify_call].

You can identify if an outbound call was answered by a human or by an answering machine 
from within a Notify  workflow by evaluating the current.is_human  variable, such as with 
an If  workflow activity. This variable is set by the telephony provider when an outbound call is 
answered. This variable is always true for inbound calls.

Note: 
Do not add a Timer  activity between multiple Notify  activities that interact with active phone 
calls.

Important: 
When creating a Notify  workflow, set the workflow If condition matches  field to -- None --. 
Notify  controls which workflow to run based on the configured number groups.

Related topics

Using variables in Notify workflow activities

Forward call workflow  activity

The Forward Call  activity forwards a Notify call to an E.164-compliant phone number.

If the person receiving a forwarded call hangs up, the forward call  activity completes and 
transitions to the next activity. Any further Notify activities in the workflow run for the caller only.

Input variables

Input variables determine the initial behavior of the activity.

Input variables

Variable Description

Phone number to 
call

Enter the phone number to forward the call to.

Timeout (in 
seconds)

Enter the amount of time to wait for the call to be answered before 
hanging up.

Record Select this check box to record the conversation.
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Conditions

The conditions determine which transition comes after this activity.The forward call  activity does 
not specify any conditions by default.

You can add an error condition to this activity. The activity transitions through the error condition 
if the phone number to call is invalid.

Input workflow  activity

The Input  activity creates a phone menu by presenting a list of options on a Notify call.

Input Variables

Input variables determine the initial behavior of the activity.

Input Variables

Variable Description

Number 
of digits

Specify the maximum number of digits the caller can enter. A caller can enter fewer 
digits than the maximum and press the Finish key  to complete the entry.

Finish key Specify the key a caller can press on their phone when finished selecting a menu 
option.

Timeout 
(in 
seconds)

Specify the amount of time to wait before closing the menu automatically when the 
caller does not select a menu option.

Advanced Select this check box to use a script to build the phone menu, instead of using the 
activity conditions.

Script Define the script to build the phone menu. The script must specify an answer 
variable as a JavaScript object with the following format:

 answer = {
  “1": {
      “play”: “https://some_url.com/options/one.mp3“,
      “myCustomData”: “some data here”
  },
  “2”: {
      “play”: “https://some_url.com/options/two.mp3”,
      “myCustomData”: “some other data here”
  },
“3”: {
      “speak”: “type 3 to speak to a representative”,
      “language”: “en-US”,
      “myCustomData”: “some more data here”
  }
};

The script may specify either a text-to-speech string and language code using the 
speak  attribute or URL of the music to be played using the play  attribute. You can 
also add optional attributes to store related information, such as myCustomData 
in the example above.
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Input Variables  (continued)

Variable Description

Note: 
The script object continues to support say  attribute for backward 
compatibility.

Conditions

The conditions determine the transition that comes after this activity.

The input  activity does not specify any conditions by default. You must define conditions to build 
the phone menu. Each condition is one option on the phone menu. Notify reads the text from 
each condition Name  to the caller, up to 100 characters per condition.

You can specify a language for each condition by prefixing the message with the language 
code, in the format xx-XX:<Message>. For example, add fr-CA:  for Canadian French. Available 
languages are stored on the Notify Language [notify_language] table.

The condition that the activity transitions through depends on the digits entered by the caller. Set 
the condition Condition  value to parseInt(workflow.scratchpad.digits) == <expected digits>. 
For example, to transition through a condition when the caller presses the number 3, set the 
Condition  to parseInt(workflow.scratchpad.digits) == 3.

You can add an error condition to this activity. The activity transitions through the error condition 
if the advanced script returns an invalid value, or if the text to say for a condition is empty.

Scratchpad Entries

The activity uses the workflow scratchpad to write persistent values.

Values written to scratchpad

Entry Description

workflow.scratchpad.digits The digits entered by the caller, as a string.

workflow.scratchpad.menu<activity 
name>

The entire answer  variable, if using the advanced script 
option. You can access this menu from other activities 
after this activity successfully executes.

For example, if the activity name is choices, you can 
access values from the menu using

var previousActivity = "choices";
var choicesMenu = 
 workflow.scratchpad.menu[previousActi
vity];
var menuItem = 
 choicesMenu[workflow.scratchpad.digit
s];  // Selects the menu item based on 
 the caller's input.
var selectedValue = 
 menuItem.myCustomData; //get the 
 custom data for the selected menu 
 item. 
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Hangup workflow activity

The Hangup  activity disconnects an active Notify phone call.

You can use the hangup  activity to disconnect only calls that have been answered. Use the 
reject  activity to disconnect calls that have not been answered.

Play workflow  activity

The Play  activity plays a sound file on a Notify call.

Input Variables

Input variables determine the initial behavior of the activity.

Input Variables

Variable Description

URL Enter the URL of a sound file to play. If the URL is inaccessible, or if the audio file mime 
type is not supported by the telephony provider, the play  activity is skipped.

Loop Enter the number of times the sound file should play.

Conditions

The conditions determine which transition comes after this activity. The play  activity does not 
specify any conditions by default.

You can create an error condition to handle errors with the sound file. The activity transitions 
through the error condition if the specified sound file is not available, or has an unsupported 
mime type. Supported mime types are listed on the Notify Audio MIME Types [notify_mime_type] 
table.

Record workflow  activity

The Record  workflow activity records audio from a user on a Notify call.

Note: 
The Record workflow activity records Notify  call but not the Notify conference call. To record 
the Notify  conference call, you can set the Record  activity variable on the Join Conference 
Call  workflow activity.

Input Variables

Input variables determine the initial behavior of the activity.

Input Variables

Variable Description

Max duration (in 
seconds)

Enter the maximum duration, in seconds, allowed for a recording.

Timeout (in 
seconds)

Enter the amount of time to wait before ending a recording automatically 
when the caller is silent.

Finish Key Specify the key a caller can press on their phone to end the recording.
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Scratchpad Entries

The activity uses the workflow scratchpad to store persistent values.

The record  activity adds the recording  variable to the workflow scratchpad. This variable 
stores metadata about the recording, such as URl, ID, and duration. You can access the following 
values from this variable.

Values written to scratchpad

Value Description

recording.recordingDuration The duration of the recording, in seconds.

recording.from_number The caller's phone number, including country code.

recording.notify_number The Notify phone number used to respond to the call, including 
country code.

recording.recordingID The ID used by the telephony provider to identify the recording.

recording.recordingURL The URL from the telephony provider to access the recording.

Reject workflow

The Reject  workflow activity rejects an incoming Notify call.

You can use the reject  activity to disconnect only calls that have not yet been answered. Use the 
hang up  activity to disconnect calls that have been answered.

Input variables

Input variables determine the initial behavior of the activity.

Input variables

Variable Description

reason Select a reason for rejecting the call, such as busy.

Say workflow  activity

The say  workflow activity allows you to play a message, using text to speech, on a Notify call.

Input variables

Input variables determine the initial behavior of the activity.

Input variables

Variable Description

Text to 
say

Specify the text to read.

Language Select the language and locale to use when reading text.

Advanced Select this check box to use a script to define the language and message, instead 
of using the Text to say  and Language  values.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

5385



Input variables  (continued)

Variable Description

Script Define a script to set what text is read on the call. The script must return a string 
that defines the language and the text to read. For example, to play an English-
language message, return {language: 'en-US', text: 'Text to read'}.

Forward to notify client workflow  activity

The forward to notify client  workflow  activity connects a phone call to a Notify WebRTC client.

Input variables

Input variables determine the initial behavior of the activity.

Input variables

Variable Description

User Select the user to connect the call to.

Advanced Select this check box to use a script to determine which client to connect to, 
instead of using the User  variable.

Script Define a script that controls which client to connect to. This script should return a 
GlideRecord for a single User [sys_user] record.

Timeout (in 
seconds)

Enter the amount of time to wait for the call to be connected before hanging up.

Record Select this check box to record the call.

Conditions

The conditions determine which transition comes after this activity. The Forward to Notify Client 
activity does not specify any conditions by default.

You can add an error condition to this activity. The activity transitions through the error condition 
if there is an issue with the Notify client.

Call workflow  activity

The Call  activity makes outbound phone calls using a Notify workflow. This workflow activity can 
be added to any table.

Input variables

Input variables determine the initial behavior of the activity.

Input variables

Variable Description

Notify 
Number

The Notify phone number to make the call from. When you initiate a call, the 
outgoing call workflow for the number group associated with this number runs.

Phone 
number 
to call

The E.164-compliant phone number to call.
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Input variables  (continued)

Variable Description

Advanced Select this check box to use a script to determine number to call, and the Notify 
number to call from instead of using the Phone number to call  and Notify Number 
variables.

Script Define a script that controls which number to call. This script should return a string 
listing the Notify number sys_id, as well as the phone number to call, such as 
{notify_number: 'sys_id', phone_number: '+316...'}

Conditions

The conditions determine which transition comes after this activity. The call  activity does not 
specify any conditions by default.

You can add an error condition to this activity. The activity transitions through the error condition 
if the call could not be set up due to invalid data returned by the advanced script.

Join conference call workflow  activity

The Join Conference Call  activity connects an incoming or outgoing call to a Notify  conference 
call.

Notify  includes the workflows Notify: (Re)join Conference Call and Notify: Join Conference Call 
Via SMS to demonstrate how to use the join conference call  activity to connect inbound and 
outbound calls, and inbound SMS messages to a conference call.

Input variables

Input variables determine the initial behavior of the activity.

Input variables

Variable Description

Record Select this check box to record the conference call.

Advanced Select this check box to display advanced configuration options.

Script Specify advanced configuration options using JavaScript, such as if the new 
participant should be muted upon joining the conference call. You can access 
values from the workflow scratchpad.

Conditions

The conditions determine which transition comes after this activity. The join conference call 
activity does not specify any conditions by default.

You can add an error condition to this activity. The activity transitions through the error condition 
if the confernece_call scratchpad variable is not set.

Scratchpad entries

The activity uses the workflow scratchpad to read persistent values.
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Values read from scratchpad

Scratchpad variable Description

workflow.scratchpad.conference_call A GlideRecord for a single conference call record. A call 
processed by this activity is added to this conference 
call. If this value is not specified, the join conference call 
activity will log an error.

When initiating an outgoing call workflow using the 
Notify API call(String notifyPhoneNumber, 
String toPhoneNumber, GlideRecord 
conferenceCall)  method, this scratchpad value 
is set automatically to the conference call GlideRecord. 
For incoming call workflows, or workflows initiated 
using a different mechanism, you must explicitly set this 
scratchpad value.

Enable different attributes available with Join Conference Call activity

System administrators can enable any or all of the below attributes and use them in the Join 
Conference Call workflow activity.

Attribute Description

hangupOnStar When hangupOnStar is enabled (set to true), 
participants in a conference call can press the 
* button to disconnect from the call. Control is 
returned to the workflow, which can be used to 
trigger customer-defined actions.

muted When muted is enabled (set to true), the 
participant will join the conference in a muted 
state.

beepOnEnter When beepOnEnter is enabled (set to true), a 
notification beep is played when a user joins 
the conference.

beepOnExit When beepOnExit is enabled (set to true), a 
notification beep is played when a user leaves 
the conference.

enableImmediateInput When enableImmediateInput is enabled 
(set to true), it allows input of a single 
digit immediately after the conference 
ends for this user and sets that in 
workflow.scratchpad.confDigits. This option 
will be ignored if hangupOnStar is false.

To enable any of the above attributes, perform the following steps:

1. Navigate to Workflow  > Administration  > Workflow Versions.

2. Open the Notify: (Re)join Conference Call workflow.

3. Click the Show Workflow  related link.

4. To modify the workflow, click the WorkFlow Actions icon and click Checkout.
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5. Open the Join Conference Call workflow activity.

6. Enable the Advanced  check box to display the Script  field.

7. Set the hangupOnStar  attribute to true in the config  variable in the script. The default 
setting is false.

8. Click Update.

9. Click the WorkFlow Actions icon and click Publish  to save the changes.

Similarly, you can enable the other attributes.

Send SMS workflow  activity

The send SMS  workflow  activity to send short text messages using Notify to users' phones. This 
workflow activity can be added to any table.

Notify  requirements

To send SMS messages, you must add and configure a provider in Notify. For more information 
about configuring a provider, see Configure a provider in Notify.

Input variables

Input variables determine the initial behavior of the activity.

Input variables

Variable Description

From Select the Notify phone number to use to send the SMS message.

Advanced Select this check box to use JavaScript to determine which numbers to send the 
message to, and the Notify number to use to send the message.

To Select any number of users to send the message to. The user record must have 
a E.164-compliant phone number or notification device configured for SMS 
messages.

To 
(groups)

Select any number of groups to send the message to. All members of that group 
with an E.164-compliant phone number or SMS notification device receive the 
message.

Message Enter the message to send. You can add field values from the current record 
by using the Select variables  box. You can also add values from the workflow 
scratchpad. If a field and a scratchpad variable have the same name, the field value 
is used.

Because you can use variables in this message, it is not possible to determine 
the length of the message at design time. If the activity sends a message that is 
longer than supported by the telephony provider, the message is truncated and the 
instance logs a warning.

To (script) Enter a script to determine which numbers to send the message to, and the Notify 
number to use to send the message.

The script should return a JavaScript object with the format {notify_number: 
\'...sys_id...\', users: [...], groups: [...], numbers: 
[...]}. Specify the users or groups to send the message to as an array of sys_id 
values. Specify other numbers as an array of E.164-compliant phone numbers.
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Input variables  (continued)

Variable Description

This field appears only if Advanced  is selected.

Conditions

The conditions determine which transition comes after this activity. This activity does not specify 
any conditions by default.

You can add an error condition to this activity. The activity transitions through the error condition 
if the Notify number used to make the call is not configured correctly or unable to send SMS 
messages, or if an error occurs while sending the SMS.

Queue workflow  activity

The Queue  activity places an active Notify call in a queue.

Add the Queue  activity to a workflow on the Notify Call [notify_call] table to put the current call on 
hold. This activity does not specify any input variables.

The queue that the call is added to is given a random ID.

Workflow  notification activities

Notification workflow activities notify users of events that occur during the workflow.

Create Event workflow  activity

The Create Event  activity adds an event to the event queue, but does not immediately fire the 
event.

The event processor typically processes the event within one minute. This activity triggers any 
business rules or email notifications that would normally be triggered by the event.

For more information about creating and using system events, see System Events .

Results

Finished:  the activity added the event to the event queue.

Input variables

Create Event activity input variables

Field Description

Event 
name

The name of the event to create. From the Event Name lookup list, select the 
event to add to the queue. If the event requires parameters, specify them in the 
Parameter script field.

Parameter 
1 The first parameter of the event.

Note: 
If this parameter is a string value, it must be within quotes (" ").

Parameter 
2 The second event parameter.
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Create Event activity input variables  (continued)

Field Description

Note: 
If this parameter is a string value, it must be within quotes (" ").

Notification workflow  activity

The Notification  activity sends an email or SMS message to specified users or groups.

Input variables

Update the recipients list or delete the activity from the flow if you want to stop the notifications.

Notification activity input variables

Field Description

Addressees

To The users who will be recipients of the email.

To 
(groups)

The members of the groups that will be recipients of the email.

Advanced If selected, the script in the To (script)  field is called to specify additional recipients 
of the email.

To (script) If Advanced  is selected, this script is called and should set the variable answer  to 
a comma-separated list of user or group sys_ids that you want to add as recipients 
of the email.

Message

Subject The subject line of the email.

Message The email body that is sent.

To include the value of a field in the message body, place the cursor at the point 
in the text where you want the field's value inserted. Then click the + icon next to 
Fields  and select the field you want.

States

The activity state tells the workflow engine what to do with the activity.

Notification activity states

Field Description

Executing The workflow engine knows to start the run  function of the activity.

Finished The activity finished running. See the result value for the outcome of the activity.

Cancelled This activity, or the workflow that contains this activity, was canceled.

Timer workflow  activities

Timer activities pause workflows for set periods of time.
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Related topics

Use multiple timer activities in one workflow

SLA Percentage Timer workflow activity

The SLA Percentage Timer  activity pauses the workflow for a duration equal to a percentage of 
an SLA.

A workflow must run on the Task SLA table to use this activity.

Note: 
Timer activities run as the System user because the system scheduler advances the 
workflow.

Results

SLA Percentage Timer activity results

Result Description

Complete The activity successfully reached the specified duration

Cancelled The activity or workflow was canceled before the timer reached the specified 
duration

Input variables

Input variables determine the initial behavior of the activity.

SLA Percentage Timer activity input variables

Field Description

Percentage The duration to pause the workflow for, as a percentage of the current SLA

States

The activity state tells the workflow engine what to do with the activity.

SLA Percentage Timer states

State Description

Executing The activity is in this state very briefly while initializing, after which it immediately 
changes to Waiting.

Waiting The workflow engine waits until the SLA reaches the specified percentage. The 
engine then transitions the workflow to the next activity.

Finished The activity finished running. See the result value for the outcome of the activity.

Cancelled This activity, or the workflow that contains this activity, was canceled.

Error A JavaScript error occurred. Review the logs for error details.

Timer workflow activity

The Timer  activity pauses the workflow for a specified period of time.
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This duration can be an absolute time value or a relative value based on a defined Creating 
and using schedules . It is best to adjust the Duration  so the workflow can progress in a timely 
manner. To pause a workflow indefinitely until a condition is met, see wait for condition.

Note: 
Timer activities run as the System user because the system scheduler advances the 
workflow.

Results

Timer activity results

Result Description

Complete The activity successfully reached the specified duration.

Cancelled The activity or workflow was canceled before the timer reached the specified 
duration.

Input variables

Input variables determine the initial behavior of the activity.

Timer activity input variables

Field Description

Timer Information

Timer based on How the timer duration is computed. The options are:

• A user specified duration:  The duration is based on the Duration 
fields, such as days and hours.

• A relative duration:  The duration is based on the Relative 
duration  (such as End of Next Business Day) and Wait  fields.

• A date/time or duration field:  The duration is based on the Field 
value and the Wait  field.

• Script:  The duration is based on a script that returns the number 
of seconds.

Duration

Appears only when 
Timer based on  is A 
user specified duration.

The specific number of days and hours to wait before proceeding to 
the next activity in the workflow.

Relative duration

Appears only when 
Timer based on  is A 
relative duration

The general number and length of business days to wait before 
progressing to the next workflow activity. .

Wait An additional timer adjustment when Timer based on  is A relative 
duration  or A date/time or duration field. The options are:
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Timer activity input variables  (continued)

Field Description

Appears only when 
Timer based on  is A 
relative duration  or A 
date/time or duration 
field.

• The full duration:  No modification of the calculated duration.

• A % of the duration:  The duration is adjusted by multiplying the 
number of seconds by the (Percentage / 100).

• Some time before:  The duration is shortened by the Time before 
days and hours.

• Some time after:  The duration is lengthened by the Time after 
days and hours.

Percentage

Appears only when 
Timer based on  is A 
relative duration  or A 
date/time or duration 
field.

The Wait  percentage value when Timer based on  is A relative 
duration  or A date/time or duration field.

Time before

Appears only when 
Timer based on  is A 
relative duration  or A 
date/time or duration 
field  and Wait  is Some 
time before.

The modifier time value when Wait  is Some time before.

Time after

Appears only when 
Timer based on  is A 
relative duration  or A 
date/time or duration 
field  and Wait  is Some 
time after.

The modifier time value when Wait  is Some time after.

Field

Appears only when 
Timer based on  is A 
date/time or duration 
field.

The date/time or duration field that contains the elapsed wait-time 
before moving to the next workflow activity.

Script

Appears only when 
Timer based on  is 
Script

The script that sets 'answer' to the number of seconds for the 
duration.

Timer Schedule

Schedule based on The basic schedule the timer uses to count working hours. If a 
schedule is specified, the duration will only be considered for times 
that are specified on the schedule. For example, if the duration is 2 
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Timer activity input variables  (continued)

Field Description

hours and the workflow begins at 4:00pm on a schedule that is 8am 
- 5pm, then it ends at 9:00am the next day. The options are:

• This workflow's schedule:  The schedule uses workflow context 
date, time, and an optional Time zone based on  value.

• A specific schedule:  The schedule uses a pre-defined Schedule 
and an optional Time zone based on  value.

• A schedule field:  The schedule uses a value from a table and an 
optional Time zone based on  value.

Schedule

Appears only when 
Schedule based on  is A 
specific schedule.

The pre-defined Schedule  from a list.

Schedule field

Appears only when 
Schedule based on  is A 
schedule field.

A date and time or duration field for the schedule, that is associated 
with the table. Valid fields appear in blue on the Select the element 
from a tree dialog.

Timer Time Zone

Time zone based on The time zone for calculating the duration. The time zone may be 
based on:

• No time zone:  Default. Workflow uses the GMT time zone.

• A specific time zone:  A predefined Time zone.

• A time zone field:  A Time zone field  to track time duration from a 
field on the form.

Time zone

Appears only when 
Time zone based on  is A 
specific time zone.

The predefined time zone.

Time zone field

Appears only when 
Time zone based on  is A 
time zone field.

A date and time or duration field for the schedule, that is associated 
with the table. Valid fields appear in blue on the Select the element 
from a tree dialog.

States

The activity state tells the workflow engine what to do with the activity.
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Timer activity states

State Description

Executing The Timer  activity is in this state very briefly while initializing, after which it 
immediately changes to Waiting.

Waiting The workflow engine waits until the timer reaches the specified duration. The 
engine then transitions the workflow to the next activity.

Finished The activity finished running. See the result value for the outcome of the activity.

Cancelled This activity, or the workflow that contains this activity, was canceled.

Error A JavaScript error occurred. Review the logs for error details.

Example

You can use a Timer  activity to pause the workflow until the end of the business day.

Timer example

In this example, the script evaluates the time between the now  variable and the eod  variable. 
The eod  variable is defined, in 24 hour time, as 4:00 PM. The script then sets the answer 
variable to the difference between these variables, in seconds, and logs a message.

// get now and calc end of day (4:00pm)
 
var now =new Date();
 
var eod =new Date();
eod.setHours(16);
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eod.setMinutes(0);
eod.setSeconds(0);
 
answer =(eod.getTime()- now.getTime())/1000;
 
workflow.debug('Timer will fire @: '+ eod +'  '+(answer/60)+' 
 minutes from now');

Task workflow activities

Task activities create and modify workflow tasks.

Task activities are only available when the workflow runs on a table that extends Task.

Add Worknote workflow  activity

The Add Worknote  activity adds text to the Worknotes  field of the current incident record.

A workflow must run on the Incident table to use this activity.

Note: 
Task activities run as the user whose actions complete the task the workflow was waiting for 
and advances the workflow.

Input variables

Add Worknote activity input variables

Field Description

Work Note The text to add to the incident record.

Attachment Note workflow  activity

The Attachment Note  activity adds an attachment to the current record.

Note: 
This activity is only available when the workflow runs on a table that extends Task.

This activity allows the use of irregular HTML tags to reference attachments, specifically 
the [code]  tag. Entries in a journal field that use irregular HTML do not work if the 
glide.ui.allow_deep_html_validation  property is true. This property is set to false 
by default.

Note: 
Task activities run as the user whose actions complete the task the workflow was waiting for 
and advances the workflow.

Results

Finished:  the activity added the attachment to the record.

Input variables

The following variables determine the behavior of the activity.
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Attachment Note activity input variables

Field Description

General

Field When this activity runs, it makes a note on the current record that a file has been 
attached. Specify the field on the current record in which you want this note to 
appear. The options are:

• none  (defaults to Work Notes)

• Additional Comments

• Work notes

Attachment note information

Attachment 
Name

When this activity runs, it creates a .txt file with the name you specify in this field.

Attachment 
Data

The content of the .txt file attachment. It can be in plain text or use variables to 
extract specific data from a table.

Catalog Task workflow  activity

The Catalog Task  activity creates a service catalog task record.

Note: 
This activity is only available when the workflow runs on a table that extends Task.

A user must complete the catalog task. This activity is available only for workflows running on the 
Catalog Request Item [sc_req_item] table.

Note: 
Task activities run as the user whose actions complete the task the workflow was waiting for 
and advances the workflow.

Results

You can assign a result value using activity.result  from within a script field of the activity. 
The final State  value of the catalog task record determines the result value for the Create Task 
activity. Possible result values are:

• Closed complete

• Closed incomplete

• Closed skipped

• Deleted

• Cancelled

Input fields

The values you enter in the following fields determine the behavior of the activity.
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Catalog task activity information

Field Description

Catalog Task Activity Settings

The following fields specify the behavior of the Catalog Task Activity.

Task Table The table on which this activity runs. In most cases, leave set to the 
default value: [sc_req_item].

Priority The value you want assigned to the Priority  field for the new task.

Wait for completion If selected, the workflow activity waits for the task to complete before 
continuing. If cleared, the task is created but the workflow proceeds.

Catalog Task Record Settings

The following fields specify the field values that this activity sets for the catalog task it creates.

Task value from Specify how you want to populate fields on the new task.

• Fields:  a predefined set of fields including Fulfillment group, Assigned 
to, Short description  and Instructions.

• Template:  an existing template for the selected task table.

• Values:  values that you specify using a Set Values widget.

After you select a value for Task value from, additional fields specific to 
that value appear on the form.

Fulfillment group

Only appears when 
Task value from  is 
set to Fields

The group that is responsible for completing the task. Populates the 
Assignment group  field on the new task.

Assigned to

Only appears when 
Task value from  is 
set to Fields

The user who is responsible for completing the task. Populates the 
Assignment to  field on the new task.

Short description

Only appears when 
Task value from  is 
set to Fields

A short description for the task. Populates the Short description  field on 
the new task.

Instructions

Only appears when 
Task value from  is 
set to Fields

The task instructions for the user to complete prior to closing the task. 
Populates the Description  field on the new task.

Template The values in the task will be populated from the values in the template 
you select.
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Catalog task activity information  (continued)

Field Description

Only appears when 
Task value from  is 
set to Template.

SetValues

Only appears when 
Task value from  is 
set to Values.

Select any field on the task record to a value you specify here.

Advanced Check Advanced  if you want to use a script to assign values on the 
catalog task. When you check Advanced,  a text box appears where you 
can enter your script.

Advanced Script

Only appears when 
the Advanced  field 
is checked.

Set additional values for the task in this script. This script is run after 
the task values are set using the Fields, Template  or Values  you have 
specified.

Use the variable task  when setting additional values, for example:

task.short_description = 
current.short_description;

Catalog Task Variables

Variables on Task 
Form

Specify optional catalog variables to include on the Catalog task form. 
The variables you select here will be displayed in a field called Variable 
Editor. If you select no variables here, the Variable Editor  field in the 
Catalog Task form will not be visible.

Catalog Task Schedule

Due date based on Select how workflow determines the task's duration, due date, and 
schedule.

• A user specified duration:  The duration is based on a user specified 
value.

• A relative duration:  The duration is calculated from a relative duration 
(such as End of Next Business Day).

• A date/time or duration field:  The duration is based on the value of a 
field on the current record.

• Script:  The duration is returned by a script.

Duration

Only appears when 
Due date based on 
is set to A user 
specified 
duration

The specific number of days and hours.

Relative duration The general number and length of business days.
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Catalog task activity information  (continued)

Field Description

Only appears 
when Due date 
based on  is set 
to A relative 
duration

Due date field

Only appears 
when Due date 
based on  is set to 
A date/time 
or duration 
field

The date/time or duration field.

Due date script

Only appears when 
Due date based on 
is set to  Script

The script that sets 'answer' to the number of seconds for the duration.

Schedule based on The basic schedule the timer uses to count working hours. If a schedule 
is specified, the duration will only be considered for times that are 
specified on the schedule. For example, if the duration is 2 hours and the 
workflow begins at 4:00pm on a schedule that is 8am - 5pm, then it ends 
at 9:00am the next day. The options are:

• This workflow's schedule:  The schedule uses workflow context date, 
time, and an optional Time zone based on  value.

• A specific schedule:  The schedule uses a pre-defined Schedule  and 
an optional Time zone based on  value.

• A schedule field:  The schedule uses a value from a table and an 
optional Time zone based on  value.

Schedule

Only appears 
when Schedule 
based on  is set 
to  A specific 
schedule

The predefined Schedule  from a list.

Schedule field

Only appears 
when Schedule 
based on  is set 
to  A schedule 
field.

A date and time or duration field for the schedule, that is associated with 
the table. Valid fields appear in blue on the Select the element from a tree 
dialog.

Time zone based 
on

The time zone for calculating the duration. The time zone may be based 
on:
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Catalog task activity information  (continued)

Field Description

• No time zone:  Default. Workflow uses the GMT time zone.

• A specific time zone:  A specific Time zone  that you choose from a 
choice list.

• A time zone field:  A Time zone field  to track time duration from a field 
on the form.

Time zone

Only appears when 
Time zone based 
on  is set to  A 
specific time 
zone

.

Select the time zone you want from the choice list.

Time zone field

Only appears 
when Time zone 
based on  is set to 
A time zone 
field.

A date and time or duration field for the schedule, that is associated with 
the table. Valid fields appear in blue on the Select the element from a tree 
dialog.

States

The activity state tells the workflow engine what to do with the activity.

Catalog Task activity states

State Description

Executing The workflow engine knows to start the onExecute  function of the activity.

Waiting The workflow engine ignores the activity until a specific event to restart the activity 
is fired.

Finished The activity finished running. See the result value for the outcome of the activity.

Cancelled This activity, or the workflow that contains this activity, was canceled.

Error A JavaScript error occurred. Review the logs for error details.

Create Task workflow  activity

The Create Task  activity generates a record on any of the tables that extend Task [task].

Note: 
This activity is only available when the workflow runs on a table that extends Task.

If the Wait for completion  check box is selected, the workflow context waits for a user action on 
the task, such as Complete or Incomplete, and then progresses based on the user action.
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Note: 
Task activities run as the user whose actions complete the task the workflow was waiting for 
and advances the workflow.

Results

You can assign a result value using activity.result  from within a script field of the activity. 
By default, the final State  value of the task record determines the result value for the Create Task 
activity. Possible result values are:

• Closed complete

• Closed incomplete

• Closed skipped

• Deleted

• Cancelled

Input variables

The following variables determine the behavior of the activity.

Create Task activity input variables

Field Description

Create Task Activity Settings

The following fields specify the behavior of the Create Task Activity.

Task type The type of task to create. Select from the corresponding task table for 
the workflow.

Priority The default priority assigned to the task. If you also set the Task priority 
in the Task values from  section, the Task value overrides the default 
priority.

Wait for completion If selected, the workflow activity waits for the task to complete before 
continuing. If cleared, the task is created but the workflow proceeds.

Create Task Record Settings

The following fields specify the field values that this activity sets for the task it creates.

Task values from The values used to create the task may either come from:

• Fields:  a predefined set of fields including Fulfillment group, Assigned 
to, Short description  and Instructions.

• Template:  an existing template for the selected task table.

• Values:  values that you specify using a Set Values widget.

Note: 
Any Task priority you set here overrides the default priority set by 
the Priority  field.

Fulfillment group The group that is responsible for completing the task. Populates the 
Assignment group  field on the new task.
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Create Task activity input variables  (continued)

Field Description

Only appears when 
Task value from  is 
set to Fields

Assigned to

Only appears when 
Task value from  is 
set to Fields

The user who is responsible for completing the task. Populates the 
Assignment to  field on the new task.

Short description

Only appears when 
Task value from  is 
set to Fields

A short description for the task. Populates the Short description  field on 
the new task.

Instructions

Only appears when 
Task value from  is 
set to Fields

The task instructions for the user to complete prior to closing the task. 
Populates the Description  field on the new task.

Task template

Only appears when 
Task values from  is 
set to Template.

A template that is used to fill in values for the task.

Set values

Only appears when 
Task values from  is 
set to Values.

A widget that is used to specify values for any fields of the task.

Advanced

Advanced Check Advanced  if you want to use a script to assign values on the 
catalog task. When you check Advanced,  a text box appears where you 
can enter your script.

Advanced Script

Only appears when 
the Advanced  field 
is checked.

Set additional values for the task in this script. This script is run after 
the task values are set using the Fields, Template  or Values  you have 
specified.

Use the variable task  when setting additional values, for example:

task.short_description = 
current.short_description;

Task Schedule

Due date based on Select how workflow determines the task's duration, due date, and 
schedule.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

5404



Create Task activity input variables  (continued)

Field Description

• A user specified duration:  The duration is based on a user specified 
value.

• A relative duration:  The duration is calculated from a relative duration 
(such as End of Next Business Day).

• A date/time or duration field:  The duration is based on the value of a 
field on the current record.

• Script:  The duration is returned by a script.

Duration

Only appears when 
Due date based on 
is set to A user 
specified 
duration

The specific number of days and hours.

Relative duration

Only appears 
when Due date 
based on  is set 
to A relative 
duration

The general number and length of business days.

Due date field

Only appears 
when Due date 
based on  is set to 
A date/time 
or duration 
field

The date/time or duration field.

Due date script

Only appears when 
Due date based on 
is set to  Script

The script that sets 'answer' to the number of seconds for the duration.

Schedule based on The basic schedule the timer uses to count working hours. If a schedule 
is specified, the duration will only be considered for times that are 
specified on the schedule. For example, if the duration is 2 hours and the 
workflow begins at 4:00pm on a schedule that is 8am - 5pm, then it ends 
at 9:00am the next day. The options are:
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Create Task activity input variables  (continued)

Field Description

• This workflow's schedule:  The schedule uses workflow context date, 
time, and an optional Time zone based on  value.

• A specific schedule:  The schedule uses a pre-defined Schedule  and 
an optional Time zone based on  value.

• A schedule field:  The schedule uses a value from a table and an 
optional Time zone based on  value.

Schedule

Only appears 
when Schedule 
based on  is set 
to  A specific 
schedule

The predefined Schedule  from a list.

Schedule field

Only appears 
when Schedule 
based on  is set 
to  A schedule 
field.

A date and time or duration field for the schedule, that is associated with 
the table. Valid fields appear in blue on the Select the element from a tree 
dialog.

Time zone based 
on

The time zone for calculating the duration. The time zone may be based 
on:

• No time zone:  Default. Workflow uses the GMT time zone.

• A specific time zone:  A specific Time zone  that you choose from a 
choice list.

• A time zone field:  A Time zone field  to track time duration from a field 
on the form.

Time zone

Only appears when 
Time zone based 
on  is set to  A 
specific time 
zone

.

Select the time zone you want from the choice list.

Time zone field

Only appears 
when Time zone 
based on  is set to 
A time zone 
field.

A date and time or duration field for the schedule, that is associated with 
the table. Valid fields appear in blue on the Select the element from a tree 
dialog.
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States

The activity state tells the workflow engine what to do with the activity.

Create Task activity states

State Description

Executing The workflow engine knows to start the onExecute  function of the activity.

Waiting The workflow engine ignores the activity until a specific event to restart the activity 
is fired.

Finished The activity finished running. See the result value for the outcome of the activity.

Cancelled This activity, or the workflow that contains this activity, was canceled.

Error A JavaScript error occurred. Review the logs for error details.

Utility workflow  activities

Utility activities provide controls over the path of the workflow, and other useful tools.

Branch workflow  activity

The Branch  activity splits the workflow into multiple transition paths from a single activity.

To add a transition path, drag the Branch  activity onto the canvas. When the Branch activity 
properties form displays, click Submit  to add the activity to the canvas. Once the activity is on 
the canvas, right click in the activity body, then click Add Condition.

All transitions from this activity execute concurrently. This activity provides a single Always 
condition. You can draw any number of transitions from this condition. Using this activity is 
equivalent to drawing multiple transitions from a single condition of another activity.

Branching can affect the behavior of rollback activities. See Rollback To activity  for more 
information.

Join workflow  activity

The Join  activity unites multiple execution paths into one transition.

Use this activity to cause a workflow to wait for all activities in multiple paths to finish before 
continuing. If multiple concurrent workflow paths meet without a Join  activity, any subsequent 
activities execute twice.

To add Join to the canvas, click Submit. On the canvas, connect incoming transitions from each 
activity you want to act as a predecessor to the Join activity. Then connect outgoing transitions to 
the two exit conditions: Complete and Incomplete.

Results

Provide an Incomplete transition out of a Join  whenever it is possible for any predecessor 
activities to follow a transition path that does not lead to the Join  activity.

Join activity results

Result Description

Complete Join  exits along the Complete path when the system has determined that all 
predecessor activities have completed and transitioned to the Join.
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Join activity results  (continued)

Result Description

Incomplete Join  exits along the Incomplete path when the system determines that at least 
one predecessor activity completed but transitioned along a path that bypassed 
the Join  activity.

Lock workflow  activity

The Lock  activity prevents other instances of this workflow from continuing past this activity until 
the lock is released.

Several instances of the same workflow may run concurrently. For example, if a workflow triggers 
when a record is added to a particular table. That workflow triggers multiple times if multiple 
records are added one after the other, once by each record insertion. You can use the lock 
activity to ensure that this instance of the workflow has finished one or more activities before any 
other instance of the workflow can proceed.

A workflow can explicitly release a lock with the Unlock  activity. The lock may also be released 
when the Max duration  is reached.

When an instance of the workflow reaches the Lock  activity, it attempts to obtain a lock using the 
key specified in the lock activity. If another instance has already obtained the lock and has not 
yet released it, this lock attempt fails. The instance continues trying to obtain the lock until Max 
attempts  has been reached.
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Note: 

We recommend placing a one-second timer activity before the lock activity. This helps 
prevent a rare condition in which the lock activity may not be able to distinguish one 
workflow instance from another. This condition can occur because the entity owning the 
lock is not the specific workflow instance, but rather the code-execution thread in which 
that instance is running. In most cases, each workflow instance runs on a different thread. 
Adding a timer activity ensures that this is the case.

Example of Lock Activity Preceded by Timer Activity

Since a Lock  activity can only temporarily prevent processing of other workflow instances, do 
not add activities that cause the workflow to wait between a Lock  and Unlock  activity block. This 
may cause the Unlock  activity to be unable to acquire the lock to release it and instead take 60 
seconds to complete. Restricted wait activities include:

• Approval activities

• Task activities

• Timer activities

• Wait for condition activity
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• Wait for WF Event activity

• MID server activities such as a PowerShell script

Results

Lock activity results

Result Description

Success The activity successfully obtained a lock. This instance of the workflow can proceed 
past this point, but other instances cannot proceed until the lock is released.

Failure After attempting to obtain the lock Max attempts  times, the activity could not obtain 
the lock.

Input variables

Input variables determine the initial behavior of the activity.

Lock activity input variables

Field Description

Key A unique mutex key. The Unlock activity  activity uses this key to release the lock.

Duration

Max. 
duration

The maximum time the lock persists. The lock is released after it reaches this 
duration. Releasing a lock this way is equivalent to running the Unlock  activity.

Lock attempts

Specify how the activity behaves if the lock attempt is denied. If the final lock attempt fails, the 
activity state is set to 'timeout' and the activity result is set to 'failed'.

Max. 
attempts

Specify the maximum number of times the activity may attempt to obtain the lock.

Delay 
between 
attempts

The amount of time required after a failed lock attempt before another lock 
attempt is allowed.

States

The activity state tells the workflow engine what to do with the activity.

Lock activity states

State Description

Waiting The workflow engine is waiting to obtain a lock.

Finished The activity successfully obtained the lock.

Timeout The activity could not obtain a lock within the number of attempts specified by the 
Max. attempts  input variable.
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Log Message workflow  activity

The Log Message  activity writes a message to the workflow log.

Use this activity to add entries to the workflow's log for debugging or tracing purposes.

Input variables

Input variables determine the initial behavior of the activity.

Log Message activity input variables

Field Description

Message The message to log. This variable can be a string or a JavaScript expression that 
evaluates to a string.

Log Trace Message workflow  activity

The Log Trace Message  activity writes a trace message to the workflow log.

The trace message includes the activity name, the event that invoked the workflow, and the 
table of the current record. There are no variables or conditions. To log other data, use the Log 
Message workflow activity  activity.

REST Message legacy workflow activity

The legacy  REST Message  activity enables an administrator to override the REST endpoint or 
supply the variables configured in the REST Message module.

This activity is deprecated in the Washington DC  release and no longer shows up in the Workflow 
canvas for new workflow development. New workflows should use the Orchestration   REST 
Activity templates instead.

Existing workflows using it will continue to work as designed. To edit this activity in an existing 
workflow, you must re-activate the activity.

The REST Message  activity executes a dead link REST function (POST, PUT, GET, or DELETE) on 
an endpoint using values defined in the function record.

Note: 
If you want to use a MID Server to send the REST message, the MID Server must be 
accessible by the instance and configured to use SSH.

Input variables

REST Message activity input variables

Field Description

Rest Message

REST 
Message

Name of the Create a REST message  to run. This is a reference field to the REST 
Message [sys_rest_message] table (System Web Services  > Outbound  > REST 
Message).

REST 
Message 
Function

Function to call that is defined in a REST message function. This is a reference 
field to the HTTP Method [sys_rest_message_fn] table (System Web Services  > 
Outbound  > REST Message).
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REST Message activity input variables  (continued)

Field Description

Available functions are put, post, get, or delete. You can edit functions in the HTTP 
Methods  related list in each REST Message record.

REST 
Endpoint

REST endpoint to use instead of the Endpoint  defined in the HTTP Method record. 
Leave this field blank to use the defined endpoint in the REST Message Function 
record.

Rest Message Variables

Variables Values to use for Variable substitution in outbound REST messages  defined in the 
HTTP Method record.

Use the following format for the string:

name1=value1, name2=value2, . . .

For example, use name=${nameValue}, id=${idValue}  where name  and 
id  are function variables. If either the variable name or value contains a comma or 
equal sign, escape those characters with a backslash.

Rest Message MID Server

Use MID 
Server

Check this box if you want to use a MID Server to send the REST message. A MID 
Server might be necessary to reach an endpoint within a firewall or a subnetwork 
that is not visible from the instance. If this check box is selected, but no MID Server 
is defined in the MID Server  field, the workflow automatically attempts to find a MID 
Server based on IP range and the REST capability.

MID 
Server

Name of the MID Server to use. This field is available when Use MID Server  is 
selected. The workflow ignores this parameter if the use_midserver  parameter is 
disabled.

Rest Message Script

Sensor 
Script

The script to execute after the request has been made and a response has been 
received. You can access the full response body from the activity.output 
variable.

Return Value workflow  activity

The Return Value  activity returns a value to a parent workflow, when run from a subflow.

This activity has no variables or conditions. For more information, see Workflows used as 
subflows.

Use this activity within a subflow to store data that the parent flow can access. The Return Value 
activity adds the data from the subflow's value  variable to the parent workflow's scratchpad.

Scratchpad entries

The activity uses the workflow scratchpad to read and write persistent values.

Return Value activity scratchpad entries

Variable Description

value The activity writes the value from the subflow value  variable to the parent 
scratchpad. The parent workflow activity that runs the subflow includes a Map 
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Return Value activity scratchpad entries  (continued)

Variable Description

return value to  variable that defines where the parent workflow stores 
the returned data. This data can be scalar, a stringifiable JavaScript object, or an 
expression that evaluates to a stringifiable JavaScript object.

Related topics

Workflow scratchpad variables

Using variables in a workflow

Run Script workflow  activity

The Run Script  activity runs the specified script in the scope of the workflow version.

Note: 
All changes to current  are automatically updated. There is no need to call 
current.update()

Input variables

Input variables determine the initial behavior of the activity.

Run Script activity input variables

Field Description

Script Script to execute.

Set Values workflow  activity

The Set Values  activity sets values on the current record when the workflow quiesces or ends.

Input Fields
The values you enter in the following fields determine the behavior of the activity.

Set Values Activity Input Fields

Field Description

Set 
these 
values

From the list on the left, select the field on the current record whose value you want to 
set when the workflow quiesces or ends. In the user-input field to the right, select or 
enter the value to which you want that field set.

Note: 
Avoid setting the same fields from different Set Value  activities. The workflow only 
sets the value specified by the last Set Values  activity run before quiescing or 
ending.

Note: 
Using the Set Values  activity to set the Approval  field on a task does not cancel pending 
approvals. To approve a task in a workflow, use the Approval Action  activity instead.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

5413



SOAP Message legacy workflow activity

The legacy  SOAP Message  activity uses SOAP messages defined in the System Web Services 
plugin and can call the messages using a MID Server.

This activity is deprecated in the Washington DC  release and no longer shows up in the Workflow 
canvas for new workflow development. New workflows should use the Orchestration   SOAP 
Activity templates instead.

Existing workflows using it will continue to work as designed. To edit this activity in an existing 
workflow, you must re-activate the activity.

Input variables

SOAP Message activity input variables

Field Parameter Description

SOAP 
Message

soap_message The SOAP Message defined under the System 
Web Services plugin's Outbound SOAP Message 
[sys_soap_message] table. (System Web Services  > 
Outbound  > SOAP Message)

SOAP 
Message 
Function

soap_message_function The function to call that is defined in the SOAP Message. 
Functions are listed in the SOAP Message Functions 
related list in each SOAP Message record.

SOAP 
Endpoint

soap_endpoint Endpoint to use instead of the SOAP endpoint  value 
in the SOAP Message Function record. Leave this field 
blank to use the defined endpoint in the SOAP Message 
Function record.

Variables variables Variables to substitute into the SOAP Envelope  defined 
in the SOAP Message Function record. Use this format for 
the string:

name1=value1, name2=value2, . . .

If either the name or value contains a comma or equal 
sign, escape these characters with a backslash.

Use MID 
Server

use_midserver Check box for using a MID Server to send the SOAP 
message. A MID Server might be necessary to reach an 
endpoint within a firewall or a sub-network that is not 
visible from the instance. If this check box is selected 
(true), but no MID Server is defined in the MID Server 
field, Workflow automatically attempts to find a MID 
Server.

MID 
Server

midserver Name of the MID Server to use. This field appears 
when you select the Use MID Server  check box. The 
workflow ignores this parameter if the use_midserver 
parameter is disabled.

Sensor 
Script

sensor_script The script to execute after the request has been made 
and a response has been received. You can access the 
full XML response body from the activity.output 
object.
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Turnstile workflow  activity

The Turnstile  activity limits how many times a workflow can pass through the same point.

Use this activity to prevent infinite loops. This activity is useful alongside the Rollback To 
workflow activity  activity.

Results

You can assign a result value using the activity.result  variable from within a script field 
of the activity. By default, the activity script evaluates if the activity should continue to iterate or 
stop.

Turnstile activity results

Result Description

Continue The Allowed iterations  value is greater than the number of times the workflow 
accessed this activity.

Cancel The workflow accessed this activity more times than the Allowed iterations  value.

Input variables

Input variables determine the initial behavior of the activity.

Turnstile activity input variables

Field Description

Allowed 
iterations

Number of times the workflow can pass through this activity before the 
turnstile ends the loop.

Conditions

The conditions determine which transition comes after this activity.

Turnstile activity conditions

Field Description

Continue If the workflow has returned to this point an amount of times less than the allowed 
iteration.

Cancel If the workflow has returned to this point an amount of times more than the allowed 
iteration.

States

The activity state tells the workflow engine what to do with the activity.

Turnstile activity states

State Description

Executing The workflow engine knows to start the onExecute  function of the activity.
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Turnstile activity states  (continued)

State Description

Waiting The workflow engine ignores the activity until a specific event to restart the activity 
is triggered.

Finished The activity finished running. See the result value for the outcome of the activity.

Cancelled This activity, or the workflow that contains this activity, was canceled.

Error A JavaScript error occurred. Review the logs for error details.

Unlock workflow  activity

The Unlock  activity releases a lock that was previously placed by the Lock  activity.

To release a lock, specify the same lock key that was specified in the Lock  activity. If the Lock 
activity had a Duration  specified, and that duration has already passed, the lock will already be 
released.

Input variables

Input variables determine the initial behavior of the activity.

Unlock activity input variables

Field Description

Lock 
key

The Mutex key that releases the lock. This key must match the key specified by a Lock 
activity. For more information, see Lock activity.

States

The activity state tells the workflow engine what to do with the activity.

Unlock activity states

State Description

Finished The activity successfully released the lock.

Subflow activities in workflow

Subflow activities run and manage workflows from a parent workflow.

The Parallel Flow Launchersubflow activity is available.

Parallel Flow Launcher workflow activity

The Parallel Flow Launcher  activity launches multiple subflows in parallel.

Workflows running in parallel execute simultaneously and may complete in any order. The activity 
can launch a single subflow or multiple subflows as needed. You can manage the input values 
and values returned for each subflow.
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Note: 
The Parallel Flow Launcher activity waits until all subflows are completed before 
proceeding. If any subflow does not finish, the activity waits indefinitely.

Do not launch a large number of subflows with the Parallel Flow Launcher activity. If 
overused, this activity can overburden the instance. For launching very large numbers of 
subflows, consider putting the Parallel Flow Launcher inside a loop controlled by a turnstile 
or other conditional activity and having it do batches.

Activity variables

Activity variables determine the initial behavior of the activity.

Parallel Flow Launcher activity input variables

Field Description

Parallel Flow Launcher configuration

Name A unique name for the activity.

Stage The stage to display when the workflow reaches the activity.

Inputs Inputs to the subflows to run. Specify an array of name: value pairs for each 
input defined in the workflow being launched. The name and data type of each 
input variable entered must match those used by the subflow that this activity 
launches. For a detailed example, see Parallel Flow Launcher Example.

Parallel Flow Launcher selection

Workflow The workflow to run.

Advanced Check Advanced, to enter a script that uses a WorkflowCoordinator object to 
manage the subflows. When you check Advanced, a text box appears where 
you can enter a script that specifies a unique workflow for each set of input 
variables. See WorkflowCoordinator object  for more information.

Parallel Flow Launcher iteration

Specify parameters to tune the performance of batched workflows.

Count If not specified by an input set, Count  determines the number of subflows 
executed in parallel from this activity. If the Advanced  option is not selected, 
ensure that this field is populated with a valid number.

Max flows The maximum number of workflows this activity can launch. If this 
value is a positive integer, it overrides the max parameter used in the 
WorkflowCoordinator constructor.

Max 
simultaneous

The maximum number of parallel workflows this activity can run at one time. If 
this value is a positive integer, it overrides the poolsize parameter used in the 
WorkflowCoordinator constructor.

Parallel Flow Launcher Process

Process flow 
complete

To specify a script that runs after each subflow completes, check Process flow 
complete. If you check this field, a text box labelled Flow complete  appears, 
where you can enter the script to run.

Flow 
complete

The script that runs each time a subflow finishes. This field is available when the 
Process flow complete  option is selected.
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Parallel Flow Launcher activity input variables  (continued)

Field Description

The same script functions and variables available in other workflow scripts, 
such as those in the Run Script activity, are available here. For more information, 
see Completed subflow values in scripts.

The variable "flow" is available to this script. It is an object that contains the 
following information about the flow that is finishing:

flow.output (String): The value that the subflow returns to the parent if it 
executed a Return Value activity before ending.

flow.index (Number): The zero-relative index of the subflow that finished.

flow.contextId (String): The sys_id of the workflow context for the completed 
subflow.

flow.inputs (Object): The inputs that were passed to the subflow when its 
context was created and started.

flow.status (String): The final state of the context. This corresponds to the state 
column in the subflow context record, which has possible values of executing, 
finished, cancelled, or faulted. (Since the flow is completed, it cannot be 
executing  at this point.)

Parallel Flow Launcher Split

Process 
finished

To specify a script that runs after all subflows have finished, check Process 
finished. If you check this field, a text box labelled Finished Scriptappears 
where you can enter the script to run. The ‘coordinator’ variable is made 
available to this script and is an object that allows access to any of the finished 
subflows using the getFlow(index) method. For example:

for (var i = 0; i < coordinator.getNumFlows(); i++) 

writeFlowResultsToTable( i, coordinator.getFlow(i) );

Finished 
script

The script that runs after all subflows launched by the activity are complete. You 
can use variables that contain completed flow information in this script.

The ‘coordinator’ variable is made available to this script and is an object that 
allows access to any of the finished subflows using the getFlow(index) method. 
For example:

for (var i = 0; i < coordinator.getNumFlows(); i++) 

writeFlowResultsToTable( i, coordinator.getFlow(i) );

This field is available when Process finished  is selected.

States

The activity state tells the workflow engine what to do with the activity. To view an activity's state, 
point to the activity. A pop-up window shows the State  and Result  of the activity. If the activity is 
in an error state, the pop-up window provides a brief Fault Description.
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Parallel Flow Launcher activity states

State Description

Waiting The activity is waiting for all subflows to finish. All subflows have started and some 
may have finished.

Finished The activity successfully completed all of the subflows.

Error The activity encountered an error.

WorkflowCoordinator object

A WorkflowCoordinator object specifies which subflows to run and the input variables to pass to 
those subflows.

When using a WorkflowCoordinator object, you can create a Parallel Flow Launcher  activity that 
launches multiple subflows. When using the activity without a WorkflowCoordinator object, you 
can only launch a single subflow multiple times. Use one of the following methods to specify 
a WorkflowCoordinator object for the activity when the Advanced  activity input variable is 
selected.

• Reference a workflow scratchpad variable that contains an existing WorkflowCoordinator 
object. To save a WorkflowCoordinator object to the scratchpad, call the 
save(variableName)  function on the WorkflowCoordinator object. You can reference 
the object using the value passed in the variableName  parameter. For example, you 
can create a WorkflowCoordinator object in a Run Script  activity, save the object using 
<object>.save('coord'), and then call this object by entering coord  in the Workflow 
activity variable of a subsequent Parallel Flow Launcher  activity.

• Define the WorkflowCoordinator within the Workflow  activity variable. Add the 
javascript:  identifier at the beginning of the script. The Parallel Flow Launcher example 
shows how to use a WorkflowCoordinator object in this way.

• Create a factory class to define the WorkflowCoordinator object. The system does not provide 
a factory class for WorkflowCoordinator by default.

Completed subflow values in scripts

The Parallel Flow Launcher  activity exposes additional variables you can use in scripts.

Additional variables

Variable Description

coordinator The WorkflowCoordinator used when running the subflows. You 
can use this variable in the Finished script  to perform any final 
operations. Additionally, you can use the WorkflowCoordinator in a 
later workflow activity by passing the activity name or sys_id to the 
WorkflowCoordinator.load('<Activity>')  function. For 
example, to load the WorkflowCoordinator object from a Parallel Flow 
Launcher  activity called Launch Subflows, enter var coord = 
WorkflowCoordinator.load('Launch Subflows');  in a later activity.

flow The subflow launched by the activity that completed most recently. You can 
use this variable in the Flow complete  script to perform any post-processing 
operations on each subflow. To get a complete subflow from a coordinator object, 
use var flow = coord.getFlow(I);  where I is the numeric index of the 
subflow based on the order it was launched.

These values are available from the completed subflow:
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Additional variables  (continued)

Variable Description

• index: the numerical index of this subflow based on the order it was launched

• workflow: the sys_id or name, depending on which you passed to the 
WorkflowCoordinator constructor, of the workflow used for this subflow

• inputs: any input values provided to the launched subflow

• status: status of the subflow context

• output: the value returned by the subflow

• contextId: the sys_id of the workflow context for the subflow

Parallel Flow Launcher example

This example shows how to use the Parallel Flow Launcheractivity with an array of input values 
and with a WorkflowCoordinator object.

Sample workflow

This example shows a SQL-based web server with four application nodes. A single subflow runs 
to provision the database, and multiple parallel subflows each configure an application node. 
Finally, a separate set of parallel subflows configures the nodes to use a load balancer and sets 
up the server DNS.

Parallel flow launcher business case

Provision the application nodes

The first Parallel Flow Launcheractivity launches the Provision Node  subflow four times. The 
activity passes a unique IP address to each subflow from an array in the Inputs  variable. The 
scripts defined in the Flow complete  and Finished script  variables write log messages regarding 
the status of the subflows.
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Parallel flow launcher activity properties

Add nodes to the load balancer

The second Parallel Flow Launcher  activity uses WorkflowCoordinator objects to specify which 
subflows to run. The coordinator  variable stores the completed flow information from the 
previous Provision Nodes  activity. The script then retrieves the IP address and port for each 
node that was provisioned. The coord2  WorkflowCoordinator object runs the Add Node to Load 
Balancer subflow once for each node, using the retrieved IP address and port information as 
input variables. Finally, the coord2  WorkflowCoordinator object runs the SetupDNS  subflow 
once to configure the load balancer.
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Specifying which subflows to run

View workflow  activity descriptions

Tooltips are available for workflow activities to help you understand how to use each activity.

Before you begin
Role required: admin
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About this task

Procedure

1. To view an activity description in the Workflow Editor, point to the icon for the activity in the 
palette.

2. To modify activity descriptions, navigate to Workflow  > Administration  > Activity Definitions 
and edit the Description  field.

Note: 
To view more information about an activity, double-click the activity on the canvas and 
then click the help icon in the title bar of the Activity Properties window.

Elements in workflow activity definitions

Each activity can specify a number of elements that control the behavior of the activity or are 
controlled by the activity.

Not all activities specify all possible elements. See Workflow activities  for links to the activities 
provided by default. Each activity description includes a detailed explanation of the specific 
elements offered by that activity.
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Workflow activity elements

Element Description

Results The possible activity.results  value. The activity result usually determines which 
condition the activity transitions through.

Scratchpad 
entries Scratchpad variables the activity depends on to run, or variables the activity 

writes to the scratchpad.

Input 
variables

Values that control the behavior of the activity. Fields to set these values appear 
on the Activity Properties form when a new activity is added to a workflow. See 
Activity variables  for more information.

Conditions Determines which transition the activity follows after completing. See Manage 
workflow activity conditions  for more information.

States Determines how the workflow handles the record being executed.

Add an activity to a workflow

Available activities are displayed in the Core, Packs, and Custom  tabs in the Workflow Editor 
palette.

Before you begin
Role required: admin

Procedure

1. In the Workflow Editor, check out a workflow.

2. To add a workflow activity, drag it from the Core, Packs, or Custom  tab to the canvas and drop 
it on a transition line in the workflow body.

The transition turns blue when it is connected to the new activity. The designer adds the 
activity to the flow at that point and displays the property form for the new activity.

If an activity is greyed out, approval engines  are enabled for the table on which the workflow 
runs. To use the activity, turn approval engines off for the table.
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Unavailable activities and approval engines

3. Create any additional conditions needed for the activity and ensure that all exits are 
connected.

4. Run the workflow validation  tool prior to publishing to detect missing or disconnected 
transitions that can cause a workflow to hang.
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Note: 
All activity descriptions  have a Table  value. If this value is Global, the activity is available 
for use with any workflow regardless of the table selected in the workflow properties. 
Activities that identify a specific table appear in the palette only if the table configured for 
the workflow matches or extends the table identified in the activity.

Adding an activity to a workflow

Duplicate a workflow  activity

You can duplicate an activity used in a workflow, including all the configured properties.

Procedure

1. Right-click the activity and select Copy Activity  from the context menu.

The system automatically duplicates the activity, but does not create transitions.

2. Double-click the copy and configure the properties appropriately.

3. Drag the activity to a location in the workflow.

4. Add transitions.

Manage transitions between workflow activities

Transitions define the processing path of the workflow, depending on conditions defined in each 
activity.

Before you begin
Role required: admin

About this task
All conditions in an activity must have a transition and all transitions must have a connection to 
another activity or to the End  activity.

Note: 
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Run the workflow validation  tool prior to publishing to detect missing or disconnected transitions 
that could cause a workflow to hang.

Procedure

1. Add transitions to the workflow using either of these methods:

◦ Drag and drop an activity directly onto a transition line to connect it to the adjacent activities. 
The transition line turns blue when the connection is made. The system updates the 
transitions automatically to reflect the new sequence.

◦ Drag the activity to an open area in the canvas and create the transitions manually. Click 
the yellow square on the right side of the activity condition and drag a connector to the next 
task.
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2. You can draw multiple transitions from the same activity condition if the activity executes 
concurrently.

3. To remove a transition, click to highlight it, and then press Delete.

Custom activity transitions

Controls on the Approval - User  activity enable an administrator to add additional workflow 
transitions to the activity other than the default transitions of Approved  or Rejected.

Transitions defined using this method do not become a permanent feature of the Approval - 
User  activity. After a new transition is configured, that transition must be applied manually to 
subsequent instances of the activity, where desired.

Manage workflow  activity conditions

Activities contain default conditions that determine which transitions are followed.

Before you begin
Role required: admin

About this task
For example, the Approval - User  activity has two conditions, Approved  and Rejected.

Example of activity conditions

You can use a JavaScript condition check to create custom conditions on Core workflow 
activities. Custom activities do not support this feature.

Procedure

1. Right-click the activity and select Add Condition  from the context menu.

2. In the New Workflow Condition dialog box, fill in the fields as appropriate (see table).

New Workflow Conditions form

Field Description

Name The label that is displayed on the workflow.

Activity Name of the activity for which this condition is submitted. This value is 
populated automatically by the system.

Short 
description

Brief description of this condition.

Condition A JavaScript condition check. The following variables are available:

◦ current: Current record that the workflow is running against.

◦ activity.result: Result value set by the activity upon completion.
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Field Description

◦ activity: Workflow Executing Activity (wf_executing) record. Used for 
advanced condition checks.

◦ activity.vars: Variables associated with the Workflow Executing Activity 
record. Used for advanced condition checks.

Skip during 
generate

If selected, the Generate  activity  does not follow this transition to generate 
approvals or tasks.

3. Click Submit.

4. To change the order in which conditions appear on the workflow activity, right-click the activity 
and select Reorder Conditions.

A dialog box appears, with a list of the available conditions.

List of conditions in the current activity

5. Drag the conditions to a new position in the list.

6. Click OK.

Activity result value

The result  value specified by an activity controls the condition through which the activity 
transitions.

Use the result  value as part of the Condition  field in the activity. For example, if the Condition 
field of an Approval - User  activity contains activity.result == 'rejected', the 
activity transitions through that condition when a rejection is received from the approver. Result 
values are set in the Script  field of the activity definition.

Edit the workflow activity properties form

Customize which workflow variables appear on an activity properties form and how the variables 
are arranged on the form.

Before you begin
Role required: admin
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Procedure

1. Navigate to Workflow  > Administration  > Activity Definitions.

2. Scroll to the activity that you want to work with and click the activity name.

3. On the Workflow Activity Definition form, click the Edit Variables Layout  related link.

4. On the Form Design page for the Activity Properties form, add and remove activity variables.
The activity variables appear as separate items that you can rearrange on the form.

For more details on using the form design interface, see Using the form designer .

Using workflow approval activities and rolling back workflows

When you work with approvals, you need to understand how approval activities interact with 
approval engines, how to correct a skipped approval workflow activity, and how rollbacks work.

Related topics

Rollback To workflow activity

Approval workflow activities and approval engines

Approvals can be managed by approval activities or approval engines, but not both. Approval 
activities can be used if approval engines are not turned on for the table associated with the 
workflow.

Approvals can be managed by approval activities or approval engines, but not both. Trying to use 
both can cause a range of issues. Approval activites are not available (greyed out) in the palette 
if approval engines are used on the specified table. If you hover over a greyed out approval 
activity in the palette, a comment with more information is provided. For more information about 
approvals and approval engines, see Classic approvals.

Unavailable approval activities

To turn approval engines off for the table, navigate to the System Properties > Approval Engines 
and change the setting for the table to Turn engines off.
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Turn off approval engines

Related topics

Approval and rollback workflow activities

Classic approvals

Correct a skipped workflow  approval activity

While a workflow is in an active context, an approval activity can skip to the next activity.

Before you begin
Role required: admin

About this task
An approval activity might skip for the following reasons:

• The approval user or group is missing or invalid (for example, sys_id).

• The approval user or group became inactive after the approval record was created.

• The activity is a Dot-walking to data in related tables  field, such as 
current.opened_by.department.manager, and it has a missing or invalid approval 
user or group.

• The business rule on the table that is associated with the workflow is invalid.

To correct a missed approval activity:

Procedure

1. Navigate to All  > Workflow  > Live Workflows  > All Contexts.

2. Select the date and time in the Started  column for the workflow that is incorrectly processing 
approval activities.

3. In Related Links, select Show Workflow.

4. Review the portion of the workflow that executed, and then do one or more of the following:
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◦ Verify that after approval, the workflow progressed to the next activity. If a workflow failed to 
progress, check the business rules. For more information, see Debugging business rules .

◦ Point to each processed approval activity to find activities where the State  is Finished  and 
Result  is Skipped.

5. Navigate to Workflow  > Workflow Editor  and open the workflow.

6. Double-click the skipped approval activity.

7. Select Users  or Groups.

8. Assign an active user or group for the approval activity.
For more information, see Workflow error handling.

Using variables in Notify workflow  activities

Certain Notify workflow  activities support variable substitution for reading text to callers.

Certain Notify workflow activities allow you to use variables, such as those from the workflow 
scratchpad, to determine the activity behavior. Each activity supports a maximum of 20 variables. 
The following activities allow variable substitution:

Activity Notes

Say Supports variable substition in the Text  field only.

Input Supports variable substition in the Text  field only.

Play Supports variable substitution in the URL  field only.

Forward call Supports variable substitution in the Phone number  field only.

Scratchpad variables

You can call variables from the workflow scratchpad or the activity scratchpad using 
the syntax ${variable_name}. You do not need to include either workflow.scratchpad 
or activity.scratchpad before the variable name. For example, to use the variable 
activity.scratchpad.langCode = ‘en-US’, call ${langCode} within the activity. If 
the scratchpad does not contain the specified variable, the variable evaluates to an empty value.

You can get values from objects on the scratchpad using the format ${object.value}. For 
example, you can get the name of a user object, such as workflow.scratchpad.user = 
{name:'john.smith'}  by calling ${user.name}.

The digit variable

The Input  activity exposes the ${digit} variable. Use this variable in each condition presented 
by the activity. The number read to the user is determined automatically by each condition. The 
caller can press that number to cause the activity to transition through that condition.

Use multiple timer activities in one workflow

Workflow timer activities store data independently of each other in an activity-specific 
scratchpad.

Previously, all timer activities in a workflow accessed a single, shared scratchpad, which could 
lead to conflicts when adding multiple timer activities to one workflow.

Timer scratchpads entries hold these values:
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• workflow.scratchpad.endTime

• workflow.scratchpad.realStartTime

• workflow.scratchpad.retroactiveSecsLeft

Related topics

Timer workflow activities

Publish a custom workflow  activity

When a user creates a custom activity and saves or submits it, that activity appears in the 
Custom  and Packs  tabs of the designer palette, but is only visible to the user who created it.

When configuration is complete, the user clicks Publish, which makes the activity accessible to 
other users on the instance with the workflow_admin or activity_creator role. Published activities 
are available for upload to the ServiceNow  Store, can be added to workflows, and can be edited 
by any user with the proper roles.

To edit a published activity, click Checkout. When an activity is checked out by a user, only that 
user can modify it. The fields of a checked out activity are read-only for all other users. When 
the checked out activity has been modified successfully, the user publishes it again. The system 
adds a new version of this activity to the Custom tab in the Workflow Editor palette.

Note: 
Activities you create and publish are only visible in the Packs  tab if they were created in the 
current application scope.

Locked versions

Problems can arise if an activity version is checked out by a user and not checked back in, 
for example, when the user is sick or leaves the company. An activity in this state cannot be 
checked out for update.

A user with the admin role can return a locked activity to a published state. The administrator 
opens the locked activity from the Custom  tab of the Workflow Editor, selects the checked-out 
version, and selects Force Checkout, and then Publish.

Workflow  activity pinning

Workflow administrators can pin  a custom activity to prevent the system from automatically 
updating that activity when a new version is downloaded from the ServiceNow  Store.

You can pin or unpin individual activities or set pinning within workflow properties that controls 
the versions used for all the activities in that workflow. This can result in two workflows using 
different versions of the same activity.

Note: 
Activity pinning and unpinning applies to the custom activities downloaded from the 
ServiceNow  Store only, and does not apply to newly published activity definitions made 
locally on your instance. To make use of these locally updated custom activities, you must 
check out your workflow and manually add the activities.

ATF Test Generator and Cloud Runner
ATF Test Generator and Cloud Runner  is a tool that enables you to leverage ServiceNow’s ability 
to intelligently generate regression tests for a specific instance.
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The test generator intelligently creates tests by analyzing instance behavior and workflows. The 
ATF Test Generator integrates with the existing ATF framework providing you with a seamless 
user experience. You also have the option to execute these tests using ServiceNow’s Cloud 
Runner which runs ATF tests on a headless browser hosted by ServiceNow.

Note: 
Check that your instance is using an ADCv2 load balancer. For more information, see the 
ADCv2 Migration knowledge article . If your instance is not using the ADCv2 load balancer, 
contact Now Support. Notice that mLTS is activated automatically and causes a rolling 
restart of the application nodes. See KB1639216  for more information.

ATF Test Generator and Cloud Runner overview

Get started

Explore

Learn about ATF 
Test Generator 

and Cloud Runner

Configure

Set up the cloud user

Operate

Generate the tests

Use

Execute the test 
using Cloud Runner

Reference

Learn about miscellaneous 
information about the app

ATF Test Generator and Cloud Runner  overview
Use the ATF Test Generator and Cloud Runner  application to generate tests depending on the 
instance behavior and workflows. You can also execute the generated tests using the Cloud 
Runner option.

These are the main modules in the application.
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• Select Cloud User: Setting up credentials for cloud runner 

user.

• Generate tests: Auto-generating tests and test suites to be executed on cloud 

runner.

• Executing tests: Executing the generated tests using the Cloud Runner 

option.

Note: 
This dialog box is visible when you try executing an ATF test or suite. See Scheduling test 
execution  for more information.
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Setting up cloud user
Set the credentials for the cloud user to be able to generate and run tests. This is a one time 
setup after the admin user installs the application.

Before you begin
Role required: admin

Note: 
The cloud runner works as expected, even if you have Multi-factor authentication (MFA)
set up for your cloud user.

Procedure

1. Navigate to All  > Automated Test Framework (ATF)  > Administration  > Select Cloud User.

Note: 
The Select Cloud User  module is visible only to the admins. Even an ATF test admin can't 
access the Select Cloud User  module.

2. Select an admin user from the list.

Note: 
Even if you are an admin, it is recommended to select a dedicated admin user.

3. Click Submit.

If the admin user is selected successfully, the following message shows 

up:

If the selected user is not an admin, an error message shows up. 
The following message is an example of one of the possible error 
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messages. The error messages vary depending on the reason of the 

error.

The selection of a cloud user can fail for the following reasons:

◦ User wasn't found

◦ User is inactive

◦ User is locked out

◦ User needs a password reset

◦ User doesn't have an admin role

◦ User has read-only access

◦ User has web services only access

Note: 
Selecting an admin user might take some time because it tries spinning a cloud browser 
and then log in to the selected user.

Generating the tests
Generate tests automatically by leveraging ServiceNow Test Generation and Cloud Runner 
application. You can also run these tests with the click of a button.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Automated Test Framework (ATF)  > Administration  > Test Generator.
If you are on the Select Cloud User  module and have setup the admin user, click Click here to 
navigate to test generator page.

Note: 
The Generate Tests  module is visible only to the admins. Even an ATF test admin can't 
access the Select Cloud User  module.
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If you already have a test generation running, you will see the following 

message.

Note: 
You can't start more than one test generation process simultaneously, but it will queue up 
for later execution.

2. Optional:  If you want to see the currently running test and the queue, navigate to Automated 
Test Framework (ATF)  > Administration  > Browser Orchestration Queue.
The Browser Orchestration Queues list shows up.

Note: 
You can see the progress and state of each of the test generation and test run in the list.

3. Select one of the two ways to generate 

tests.

◦ Not selecting Advanced: Generates tests on every table by default

◦ Selecting Advanced: Option to specify a specific table to generate tests

▪ Maximum Test Count: Upper bound on the number of generated tests. The default value is 
2000.

▪ Maximum test count per table: Upper bound on the test count for each table. The default 
value is 5.

▪ Maximum test count per catalog item: Maximum number of generated tests per service 
catalog item, defaulting to maximum 2. You can modify the number of generated tests per 
service catalog item

▪ Create separate update sets per scope: Option to create a separate update set for each 
scope
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▪ Scope for generating tests: Ability to have the tables in separate update sets for different 
scopes. For example, the generator gathers information about the scope of the tables and 
then saves the tests in a separate update set for each scope

Note: 
This field is visible only if the Create separate update sets per scope  field is not 
selected. You can then select the scope for the generated tests. The default scope is 
Global.

▪ Email: Email address of the user to receive notifications about test generation summary

▪ Presets: Number of user-control generated tests per service catalog item. The maximum 
default number is 10.

Note: 
Since the test generation process is time consuming, check your provided email address 
regularly to receive the notification about the test generation.

4. Optional:  Select Save preset  to implement the preset filter conditions.
You can also delete a preset by selecting Delete preset. All admins who can access the 
Generate Tests  module can view the update on the Presets  field.

Note: 
You can't overwrite or delete the default None  preset. If you try to save the default None 
preset value, you will see the following message. Some example presets have been 
provided which can be edited.
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If you overwrite an existing preset, the following confirmation dialog box shows up.

Depending on the query created by the preset values, the following tabs return certain data.

◦ Users

◦ Tables

◦ Service Catalog
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Note: 
You can create new condition sets to filter the required information in tabs.

(Optional)

5. Select Start Test Generation.
The Test Generation Started page shows up.

If you run a test or a suite when the test generation is in progress, one of the following 
messages shows up.

◦ For test run
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◦ For suite run

6. Go to Suites to see the generated tests.
A list of test suites shows up.

Note: 
The tests start appearing as they are being generated. It is recommended not to run the 
generated tests or test suite when the test generation is still in progress.

7. Select the ATF Generated Suite  suite.

Note: 
It supports only the basic forms and server test steps.

You can now set the 
sn_atf_tg.generation.create_separate_update_set  property to False 
if you don’t want an updated suite every time you run a test generation. The updated 
records created during tests generation are captured in the suite the user currently has 
selected. Its default value is set to True and it generates an updated suite after every test 
generation.

A list of tests within the selected suite shows up. Only the successful tests show up in this 
suite.

8. Optional:  Select the generated suite and scroll down to the Tests related list, if you want to 
view the generated automated tests using either Record Producer or Service Catalog.
From the automated tests created, you can view all the users who have used that record or 
incident. Although the tests steps here are similar to the other test steps, the initial validation 
is done for the fields on the form. Also, for every mandatory field, a value is set based on the 
sample data. It also validates after every mandatory step. Once you submit, it does a final 
record validation.

Executing the tests using Cloud Runner
Execute the generated tests suite using the Cloud Runner browser option.

Before you begin

Note: 
ATF test data will temporarily be in the browser session which are stored in our ServiceNow 
data center. Test data will be removed after all test executions have been completed.

Role required: admin
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Procedure

1. Navigate to All  > Automated Test Framework (ATF)  > Suites  > ATF Generated Suite.

Note: 
You can also execute an individual test. Navigate to All  > Automated Test Framework 
(ATF)  > Tests.

2. Select Run Test Suite  to execute the selected suite.

Note: 
You can also execute an individual test using the cloud runner browser option.

The Pick a Browser dialog box shows up.

3. Select one of the two available options to run the test 

suite.

◦ Start a new test runner: Runs the test by starting a new tab

◦ Cloud Runner: Runs the test in the cloud

Note: 
As an admin user, you can hide the Cloud Runner option on the Pick a browser dialog 
box by setting the atf_cloud_runner.radio_visible to false. The property is set to true by 
default.

Note: 
If you run a test suite using the cloud runner, all the tests within the suite run in parallel. 
See Parallel testing using Cloud Runner  for more information. The order in which the tests 
in a suite run is random. The parallel suites ignore the execution order and ignore abort 
on failure.

4. Select Run Test Suite  on the dialog box after selecting the browser.

Note: 
The number of cloud runners that can be used simultaneously is two by default. You also 
have the option of buying five more cloud runners.

The execution of the tests continues at the background even if you close the progress bar.

5. Optional:  Select Go to Result  if you want to review the tests execution results.

Parallel testing using Cloud Runner

Parallel testing using the Cloud Runner involves execution of tests within a suite in parallel.
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Parallel testing of the tests within a single suite starts as soon as you run the suite. When you run 
a suite using the Cloud Runner, all the tests within the suite run in parallel ignoring the execution 
order and abort on failure. Parallel testing using Cloud Runner is different from parallel testing 
without Cloud Runner.

Note: 
Parallel testing without Cloud Runner involves running of more than 1 suites in parallel.

Scheduling test execution
Use schedules and nightly runs to execute tests and test suites in ServiceNow’s cloud 
infrastructure allowing you to fully automate ATF test executions.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Automated Test Framework (ATF)  > Schedules.
The Suite Schedules page shows up.

2. Select New  to create a new schedule run.
The Suite Schedule record shows up.

3. On the form, fill in the fields.

Fields Description

Name Name of the schedule run.

Active Option to activate the scheduled run.

Application Application that has the schedule run.

Run Frequency at which the scheduled run 
should execute

Time Exact time at which the test run has been 
scheduled to execute

Run in cloud Option to execute the scheduled run on 
cloud runner. The default value is True for 
new schedules.

Note: 
The value is False for any existing 
schedule runs.

4. Select Save.

5. Optional:  Add any child tests if needed.

Note: 
If you change the browser name for the child test, it will still run on the cloud runner.

6. Select Execute Now  to execute the suite.
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ATF Test Generator and Cloud Runner  reference
Reference information for the ATF Test Generator and Cloud Runner.

Log entries in the BOQ form

Debug errors or track any critical transactions during the execution of the test suites, setting up 
the Cloud Runner or generating the tests by viewing the log entries in the BOQ form.

You can now view important log entries in the BOQ form. When you go to the BOQ table, you will 
see the list of jobs. On entering one of the jobs, you will see some specific job log entries.

The following are some of the examples for log entries in the BOQ form for test execution.

• Successful test 

run

Note: 
Select See generated tests related link to view the automated tests. The 
list of generated tests shows up and is not editable. You can also view the 
state and the reasons of failure of the tests on the list. The See generated 
tests related link is visible for all the log entries in the BOQ form examples. 
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• Test run got cancelled by user via root 

tracker

• If BOQ and BOS can be reached on an instance, but login is 

redirected.

Note: 
This might happen when the ADCv2 load balancer of the instance is misconfigured and 
you have a customization that redirects traffic via a client side script.

(the ADCv2 load balancer of the instance is misconfigured, the customer has a customization 
that redirects traffic via a client side script, etc…)
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• If you have deleted an API key before the job is sent to BOS/

BOQ

• If the BOS is unable to login to an instance due to some client side 
script, API key being deleted after request has been sent to BOS/BOQ, 

etc.

ATF Test Generator and Cloud Runner  roles

ATF Test Generator and Cloud Runner  is installed with these roles.

To learn more about managing subscriptions, see Managing per-user subscriptions in 
Subscription Management  and contact your account representative.

System Administrator  [admin]

The admin role is required to access and use the ATF Test Generator and Cloud Runner  store 
application.

Contains Roles

Note: 
The modules in the store application is only visible to the admins. Even an ATF test admin 
can't access them. It is recommended to select a dedicated admin user.

List of roles contained within the role.

None.
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Groups

List of groups this role is assigned to by default.

None.

Special considerations

Note: 
Avoid granting an admin role when more specialized roles are available.

It is recommended to select a dedicated admin user who meets the following conditions:

• is not Locked out

• is Active

• is not Web services access only

• is not an Internal Integration User

HTTP Response Headers
A response header is a simple name-value pair used in an HTTP response to provide additional 
information about page content or how the client should process it.

You can configure HTTP response headers for all, or specific types of pages, which include 
Service Portal, UI Page, or UX applications. The ability to configure and pass response headers 
enables special handling of the page content by a client, most typically a browser.

To learn more about what an HTTP header is, and about configuring the name-value pair for 
specific HTTP response headers, see:https://developer.mozilla.org/en-US/docs/Web/HTTP/
Headers

When configuring response headers, you must look at the definition for the HTTP header to 
determine how the client would handle the page content.

• For example, you configure an HTTP header for a specific page or all the pages with a Content-
Security-Policy: frame-ancestors 'self' https://www.servicenow.com.

• When you invoke the page in a browser such as Chrome, you can review it in the Response 
Headers section of Chrome Developer Tools.
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To learn more about how browsers handle a page with frame-ancestors, see https://
developer.mozilla.org/en-US/docs/Web/HTTP/Headers/Content-Security-Policy/frame-
ancestors .

Warning: 
When using URLs with custom name-value pairs, proceed with caution because there is a 
potential security risk when doing so. The signed security amendment to the ServiceNow AI 
Platform  contract has implied security. You may potentially or accidentally override it when 
you use custom name-value pairs in the resulting URLs.

• If you want to entirely disable HTTP response header configuration functions, set the 
glide.http.headers_config.enabled  property to false.

• Once you set it to false, ServiceNow AI Platform  does not use any of the header 
configurations you defined in the sys_response_header table.

Special handling of the Content-Security-Policy: frame-ancestor header

Normally, the ServiceNow AI Platform  automatically includes the X-Frame-Options: SAMEORIGIN 
header.

• It supports use of this header in all types of browsers, based on the setting of the 
glide.set_x_frame_options  global property, which is enabled by default.

• When you configure a page with a Content-Security-Policy: frame-ancestor 'self' URL1 URL2 
header, the ServiceNow AI Platform  does not automatically include the X-Frame-Options: 
SAMEORIGIN header. Excluding it prevents the browser from being confused, because 
Content-Security-Policy: frame-ancestor 'self' already has a similar effect.

Special handling of Content-Security-Policy: frame-ancestor header for Internet 
Explorer

Using the Content-Security-Policy: frame-ancestor 'self' URL1 URL2 header enables you to 
configure multiple URL sources to include the page from within an iFrame rendered from a third-
party site. However, Internet Explorer does not support this type of header.

• Instead, the Internet Explorer only supports the X-Frame-Options: ALLOW-FROM URL (ALLOW-
FROM) directive in this header, although the restriction is for a single host URL.

• If you configure the frame-ancestor 'self' URL1 URL2 header, and Internet Explorer is in use, the 
ServiceNow AI Platform  automatically uses the X-Frame-Options: ALLOW-FROM URL (ALLOW-
FROM) header instead.

If the Internet Explorer request includes the referrer URL header:

• It attempts to match it with the host URLs (full or wildcard http://*.example.com type URL format 
only) configured in the Content-Security-Policy: frame-ancestor 'self' URL1 URL2 header.

• If there is a match, include the matched URL as X-Frame-Options: ALLOW-FROM URL1.

• If there is no referrer header, it uses the first non-wildcard based host URLs configured in the 
Content-Security-Policy: frame-ancestor 'self' URL1 URL2 header.
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Note: 
When configuring URLs, do not include a forward slash at the end of the URL.

• This example of an incorrect configuration that may not work properly with this special 
handling:

◦ Name: Content-Security-Policy

◦ Value: frame-ancestors 'self' https://microsoft.com/

• Use this correct syntax instead:

◦ Name: Content-Security-Policy

◦ Value: frame-ancestors 'self' https://microsoft.com

Related topics

Control request and response content type

Cache-Control HTTP header value

Content-Security-Policy: frame-ancestor 'self' URL1 URL2

X-Frame-Options: SAMEORIGIN

X-Frame-Options: ALLOW-FROM URL

Configure HTTP response headers
Configure standard name-value pairs for HTTP response headers. You designate if the 
configuration applies to all pages, or to specific types (Service Portal, UI Page, or UX application 
record).

Before you begin
Role required: An elevated access security_admin role is required to configure an All Pages  type 
header. An admin role is required to configure a Specific Type  header.

Procedure

1. In the Navigator pane, type sys_response_header.list.

2. Click New.

3. Fill in the fields on the form.

HTTP Response Header

Field Description

Active Check box that designates that this HTTP 
response header configuration is active.

Application Application scope for this record.

Applies to Type of record the HTTP response header 
configuration applies to.

Specific Type

HTTP response header 
configuration is for the specific 
type and record you select in the 
Type  and Record  fields.

All Pages
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Field Description

HTTP response header 
configuration is for all pages and 
record types.

Note: 
Only users with an 
elevated access privilege 
security_admin role can 
configure HTTP response 
headers for the All Pages 
type header.

Type Type of record the HTTP response header 
configuration applies to.

Service Portal  [sp_portal]

Records related to the Service 
Portal.

UI Page [sys_ui_page]

Standard UI pages in the 
ServiceNow AI Platform.

UX Application [sys_ux_page_registry]

Standard UX applications in the 
ServiceNow AI Platform.

Record Specific record the HTTP response header 
configuration applies to. To select a record:

a. Click the Search ( ) icon to access the 
Select the document form.

b. In the Table name  field, the default is the 
type you selected in the Type  field. Do not 
change it.

c. In the Document  field, select the record 
from the table.

For example, if you selected Service Portal 
[sp_portal], you select a specific Service 
Portal-related record in that table.

d. Click OK.

You can only access this field if you selected 
Specific Type  in the Applies to  field.

Name Name you want to assign to the name-value 
pair for the HTTP response header.

Value Value you want to assign to the name-value 
pair for the HTTP response header.
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Field Description

Description Detailed description for the HTTP response 
header.

4. Click Submit.

HTTP header configuration for advanced users

The HTTP response header table (sys_response_header) in the List view contains two additional 
columns - Add by  and Order.

Column Description

Order Adds a default integer order value to a header 
configuration regardless of the type of header 
(All Pages  or a Specific page).

• When a specific page request takes place, 
both of the header types are interleaved 
based on the Order.

• The net headers, regardless of the type, are 
sorted first, based on the Order  and added 
to the response based on the ordered 
header list.

Add By Contains the following values:

Append

(Default value) This option 
is relevant when multiple 
headers with the same name are 
configured. In this case, they are 
both added to the HTTP response 
header.

Overwrite

This option is relevant when the 
same header (a header with the 
same name) is attempting to add 
twice in the ordered header list 
(see Order  description). The 
header with the higher order 
and with an Overwrite  selection 
in Add By  overwrites the same 
header trying to be set with a 
lower order.

You may have situations where a couple of similar All Pages  type header configurations 
could overwrite a Specific Type  type header configuration. An example of a Specific Type 
configuration would be one for a specific UI page. You can remedy this situation by adjusting the 
Add by  and Order  columns, as in the following examples.
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Append example

The ServiceNow AI Platform  is trying to set headers in the following 
order, and Append  is the default value for each in the Add By  column. 

In this example, the second (Header 2) and third (Header 3) response header configurations 
have the same name (Content-Security-Policy). In this case, Header 3 is appended to Header 2. 
If a request is made for a specific page you configured with a Header 3 response, the net HTTP 
response headers are both Header 2 and Header 3.

Overwrite

The ServiceNow AI Platform  is trying to set headers in the following order, 
and you've selected Overwrite  in the Add By  column for the third header. 

In this example, the second (Header 2) and third (Header 3) response header configurations 
have the same name (Content-Security-Policy). In this case, Header 3 overwrites Header 2. If 
a request is made for a specific page you configured with a Header 3 response, the net HTTP 
response header is only Header 3.
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Response templates
Resolve cases or support issues faster and more efficiently with response templates. Response 
templates (formerly known as templated snippets) are reusable messages that can be copied 
to case or task forms to provide quick and consistent messages to users, or to display standard 
chat response messages to requesters in Agent Chat.

Note: 
Response templates are available only for existing records.

Assign response template roles

The following roles are installed when you activate the response templates plugin.

Response template role Description

Response template administrator

[sn_templated_snip.template_snippet_admin]

Grants access to scoped administration of the 
response templates feature.

Response template writer

[sn_templated_snip.template_snippet_writer]

Grants access to create, read, update, and 
delete (CRUD) response template content.

Response template reader

[sn_templated_snip.template_snippet_reader]

Grants access to read response template 
content.

System Administrator

[admin]

Response template administrator

[sn_templated_snip.template_snippet_admin]
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Response template role Description

Note: 
Admin inherits this role by default. 
When the Templated Responses 
[com.sn_templated_snip] plugin is 
activated without activating related HR 
applications, you can still use response 
templates.

• Admin can reassign this role to other 
users.

• Admin can also remove the Contained 
Role [sys_user_role_contains] table so 
Admin users do not inherit this role by 
default. Or:

1. Enter sys_store_app_list.do 
in the Filter navigator search 
bar of an instance, or 
https://YOUR_INSTANCE/
sys_store_app_list.do  from a web 
browser.

2. Search for and select Templated 
Snippets.

3. Scroll down to Related Links.

4. Click Remove from the role 
contained by admin.

Before you begin using response templates, you must assign these roles to the appropriate 
roles, groups, or users in your application.

• To assign a role to another role, see Add a role to an existing role .

• To assign a role to a group, see Assign a role to a group .

• To assign a role to a user, see Assign a role to a user .

For example,

• In the HR Service Delivery  application, users with the HR administrator role are assigned 
the response template administrator role, users with the HR manager role are assigned 
the response template writer role, and users with the HR case writer role are assigned the 
response template reader role.

• In the Customer Service Management  application, users with the customer service manager 
role (sn_customerservice_manager) inherit the response template writer role. Users with the 
customer service agent role (sn_customerservice_agent) inherit the response template reader 
role and can access response templates assigned to all groups to which they belong.

How to use response templates

Users with the response template writer [sn_templated_snip.template_snippet_writer] role can 
create response templates. Each template is associated with a table that is an extension of 
the Task [task] or Interaction [interaction] table. Response templates include a short name for 
specifying a shortcut that can be used to identify the message. For chat response templates 
used in Agent Workspace, agents use the slash command with a short name to present the 
standard message during a chat. You can also configure the template to
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• Include variables pulled from a table

• Specify a condition builder to specify the conditions that must be met for the template to be 
available for use, such as for a specific HR service

For more information, see Create or modify a response template.

Users with the response template reader [sn_templated_snip.template_snippet_reader] role 
can then copy response template content and use it in their responses to users when working 
on case or task forms that meet the specified conditions. For example, a response template for 
payroll discrepancy cases enables HR agents to use a standardized message when responding 
to that case type. See Copy a response template to an HR case  for an HR-specific example.

Example: Response template to escalate payroll discrepancy cases

You are part of an enterprise HR organization using the HR Service Delivery  application. You want 
your HR agents to respond to and, when necessary, escalate payroll discrepancy cases quickly 
and consistently. Create a response template so that HR agents have a reusable message to use 
when responding to employees about that case type.

One of your HR managers with the response template writer role is responsible for creating the 
template to escalate payroll discrepancy cases. The template is associated with the HR Payroll 
Case [sn_hr_core_case_payroll] table, and a condition filters on cases that match the appropriate 
HR service called Payroll Discrepancy. In the template body, the response text appears with 
variables, such as the subject person name in the salutation.

HR case writers with the response template reader role can copy the response template content 
and use it in their responses to employees when working on cases. Response templates provide 
a faster and efficient way to resolve cases.

Activation information

To use response templates in your application, you must activate response templates. For 
information on what components are installed with the feature, see Components installed with 
response templates.

Activate response templates
You can activate response templates (formerly known as templated snippets) 
[com.sn_templated_snip] if you have the admin role. This plugin includes demo data and 
activates related plugins if they are not already active.

Before you begin
Role required: admin

Note: 
If you are using Agent Chat, the Agent Chat  (com.glide.interaction.awa) plugin automatically 
activates response templates.

About this task
Response templates activate these related plugins if they are not already active.

Plugins for response templates

Plugin Description

Scoped Application Restricted Caller 
Access

Allows scoped applications to restrict access to 
public tables and script includes.
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Plugins for response templates  (continued)

Plugin Description

[com.glide.scope.access.restricted_caller]

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.

Note: 
When domain separation and delegated admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .

Related topics

List of plugins (Madrid)

Components installed with response templates

Several types of components are installed with activation of the Templated Responses 
(com.sn_templated_snip) plugin, including tables and user roles.

Note: 
The Application Files table lists the components that are installed with this application. 
For instructions on how to access this table, see Find components installed with an 
application .

Demo data is available for this feature.

Roles installed

By default, the following HR roles contain the following response template roles.

Note: 
The Templated Responses [com.sn_templated_snip] plugin activates the 
sn_templated_snip.min_admin_count system property [sys_properties.list]. This property 
prevents you from deleting your only Response Template admin user by requiring a 
minimum number (default is two) of active users with this role.

Roles installed with response templates

Role title [name] Description Contains roles

Response templates administrator Grants 
access to 

sn_templated_snip.template_snippet_writer
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Roles installed with response templates  (continued)

Role title [name] Description Contains roles

[sn_templated_snip.template_snippet_admin]
scoped 
administration 
of the 
response 
templates 
feature.

Response templates writer

[sn_templated_snip.template_snippet_writer]

Grants 
access to 
create, read, 
update, and 
delete (CRUD) 
response 
template 
content.

sn_templated_snip.template_snippet_reader

Response templates reader

[sn_templated_snip.template_snippet_reader]

Grants 
access 
to read 
response 
template 
content.

None

You can assign these roles to the appropriate roles, groups, or users in your application.

• To assign a role to another role, see Add a role to an existing role .

• To assign a role to a group, see Assign a role to a group .

• To assign a role to a user, see Assign a role to a user .

For further information on user administration and how to manage users, see User 
administration .

Tables installed

Tables installed with response templates

Table Description

Response Template

[sn_templated_snip_note_template]

Stores response template information. Response 
templates are reusable messages that can be copied 
to case or task forms. Response templates provide 
quick and consistent messages to users, or display 
standard chat response messages to requesters in 
Agent Chat.

M2M Response Template to Channel

[m2m_response_template_to_channel]

Maps channels to response templates.

Response Template Channel

[sn_templated_snip_channel]

Stores information about response template channels.
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Tables installed with response templates  (continued)

Table Description

Note Template for Table

[sn_m2m_note_template_for_table]

Maps notes to response templates.

For further information on table administration and how to manage data, see Table 
administration .

Create or modify a response template
Create or modify a response template (formerly known as a templated snippet) to define a 
reusable message that can be copied to case or task forms or used in Agent Chat  sessions to 
provide quick and consistent messages to users.

Before you begin
Role required: sn_templated_snip.template_snippet_writer

About this task
Each response template is associated with a table that is an extension of the Task [task] table 
or, if using Agent Workspace, the Interaction [interaction] table. The template can be configured 
to include variables pulled from that table. You can also use a condition builder to specify the 
conditions that a case must meet for the template to be available for use, such as for a specific 
HR service or for chat. For chat response templates, you specify a short name (shortcut) that is 
used with the slash command as a quick way to present the response message to a user.

Procedure

1. Navigate to All  > System Definition  > Response template configuration.

2. Select New  to create a response template.
Or, select an existing response template to modify from the list.

3. Fill in the fields on the form.

Response template form

Field Description

Name Name of the response template.

Short Name Short description that identifies the 
response template when using chat in Agent 
Workspace.

Use the short name with a quick command 
(/) to show the text from the template body 
of the response template while in chat. This 
feature provides a fast and consistent way to 
populate text while in chat.

For example, the short name gm  identifies the 
chat response template for a Good Morning 
greeting. Enter /gm  in a chat window to show 
the text from this response template.

Table Name of the table that the response template 
is associated with.
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Field Description

If you are creating a response template for 
Agent Workspace chat, the associated table 
is the Interaction [interaction] table. For other 
response templates, the table must be an 
extension of the Task [task] table.

Note: 
Creating custom COE tables do not 
allow you to add the Copy to Clipboard 
UI action. Users can still use the copy 
and paste function.

Condition Conditions that determine when the 
response template is available for use.

When defining conditions like case sensitivity 
or null values, see APIGlideFilter - Scoped, 
Global .

Note: 
The conditions available depend on 
the table you select. For chat response 
templates, specify the condition: [Type] 
[is] [Chat]

Application The application that created the response 
template.

Group visibility Indicates what groups have access to the 
response template.

Adding groups filters who can view the 
response template.

Note: 
Leaving this field empty makes the 
response template available to all 
groups.

Template body Text of the response template providing 
instructions to the agent on how to respond 
to a specific case or task.

You can reference field values by selecting 
variables from the variables list based on the 
table you select.

You can manually enter custom variable 
references:

◦ Current user: ${current_user}

◦ Current date: ${Date}

Or, place your mouse where you want the 
custom variable reference to appear and 
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Field Description

select the Insert Current User  or Insert 
Current Date  buttons.

Note: 
Response templates do not support rich 
text.

Select variables Variables you can add to the template body. 
For example, if you choose the HR Case 
(sn_hr_core_case) table, you can select the 
Subject person variable to appear in the 
Template body and it will replace the variable 
with the actual name of the subject person 
when the response template is used.

Note: 
The variables available depend on the 
table you select.

Example 

The following GIF shows an example of an HR manager in the HR Service Delivery  application 
creating a response template to escalate payroll discrepancy cases. The template is 
associated with the HR Payroll Case [sn_hr_core_case_payroll] table, and a condition is set to 
filter on cases that match the Payroll Discrepancy HR service. The template text is pasted into 
the body, and then a variable for the subject person is added to the salutation.
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4. Click Submit  or Update.
Channels limit the response template to only the channels you add. If you leave this blank, 
the response template is available to no channels. This feature allows you to have different 
messages for chats, emails, or form. For more information, see Create a response template 
channel .
The Channels related list appears.

What to do next
You can copy response template content to any field on a form that meets the specified 
conditions.

The following GIF shows an example of an HR case writer in the HR Service Delivery  application 
opening a payroll discrepancy case and copying a payroll discrepancy escalation template to 
the comments field in the HR case form for the employee to read.
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Policy as Code Engine  (PaCE)
You can administrate the full life cycle of policies using PaCE  in applications by searching, 
reviewing, and updating existing policies, and creating policies as required. Policies in the 
applications  are powered by PaCE.

Understanding PaCE
PaCE  enables you to manage, administer, and audit policies from a centralized location.

A PaCE  policy is a set of pre-defined rules and logic that determines the desired behavior of 
an application or a service. When invoked, the rules in the policy are applied on the provided 
input, and a decision is reached. This decision-making is the main function of PaCE  and helps 
determine if a policy is compliant or non-compliant. The decision is then relayed to the software 
calling service or application, so that it can act on it to enforce a desired behavior.

PaCE  provides the following capabilities:

• Full life cycle management of policies

• Policy reuse

• Audit and compliance

• Testing and validation of policies

• Central automation of compliance and regulatory processes

PaCE  can be used to:

• Identify posture drifts from a desired state in the current application.

• Make decisions (compliant or non-compliant) based on a change in the application or service 
and enforce the decision to prevent a drift.

• Automate execution of policies and eliminate dependency on humans.
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• Standardize policies so that they can be shared and reused within a service and across 
services.

• Increase change velocity while including guardrails with automated workflows to provide 
preventive controls.

• Collect evidence and proof of compliance for audit purposes. This feature can be used by 
internal auditors to automate the process of collecting evidence for governance and risk 
requirements.

• Provide business context to PaCE  policies by using control objectives to connect PaCE  with 
the Integrated Risk Management  and Policy and Compliance Management  workspace.

PaCE  enables policy developers to view and understand an existing policy, make and assess 
changes, and decide if a policy can be used as a baseline for another policy. They can also use 
PaCE  before debugging to understand how the policy should work and why it is not working as 
expected.

PaCE  provides a centralized platform for storing, managing, and using policies. By using PaCE, 
policies can be:

• Well documented and all the requirements clearly defined.

• Reused across the organization.

• Tracked and new versions can be created when a policy is changed.

• Tested and validated before deployment.

Policies are also containers for all the elements that make up a policy. These elements include 
meta-data related to the policy, the policy versions (including policy scripts and inputs), mapping 
information, and policy execution history.

You can define any number of policies within PaCE.

Key user personas and roles

This section describes different user personas and roles in PaCE. These personas are defined 
with the application where PaCE  is being used.

All roles except the super administrator role must be assigned to a calling service or application 
where PaCE  is being used. The assigned calling service defines the scope for the user role.

Role High-level Permissions Persona

sn_pace.execution_reader A read-only user with view-
only access. This user can 
view policies, categories, and 
executions.

Policy user, internal auditor.

sn_pace.code_reader
Can review PaCE  versions, policy 
code, and run tests.

Internal auditor

sn_pace.code_editor

This user has all the 
sn_pace_code_reader permissions 
plus the ability to create PaCE 
policy versions.

Policy developer

sn_pace.policy_reader
This user has all the 
sn_pace_code_reader permissions 

Policy user, internal auditor

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

5464



Role High-level Permissions Persona

plus the ability to review policy 
details and mapping information.

sn_pace.policy_editor

This user has all the 
sn_pace_policy_reader and 
sn_pace.code_editor permissions 
plus the ability to create policies 
and mappings.

Policy developer

sn_pace.mapping_admin This user can map policies and 
edit config parameters for policy 
mappings.

Mapping admin

sn_pace.admin This user has the permissions of 
all the other roles plus the ability 
to create categories, policies, 
mappings, and code.

Policy admin

sn_pace.super_admin This user has all the 
sn_pace.admin role permissions 
across all calling services.

Not applicable

Maint role Internal user who can create 
default content.

Not applicable

PaCE  administration life cycle

This checklist lists the tasks involved in administering PaCE  policies.

Task Description

Set up and install PaCE.
PaCE  is installed as part of the application you 
want to create policies in.

Create a policy. See Create a PaCE policy.

Create a new policy version See:

• Create a new variable for a policy version  (if 
required).

• Define mappings for a PaCE policy.

• Edit a PaCE policy script

Test a policy version Use the Test Playground for PaCE policies

Publish a new policy version See Publish a PaCE policy version.

Activate a published policy See Activate or deactivate a PaCE policy.

Use the policy. See Execute policies.

Install PaCE
Install PaCE.

PaCE  is automatically bundled with the application you want to use PaCE  with. PaCE  is 
automatically installed in the following applications:
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• DevOps Config

• Digital Product Release  (DPR)

• Cloud Account Management  (CAM)

• SecOps Software Bill of Materials  (SBOM)

• Social Benefits Playbook

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Administer PaCE  policies
Use PaCE  to manage the life cycle of a policy and create, update, review, and execute policies.

In addition, you can:

• Evaluate any changes to ensure they meet your organization's policy management 
requirements.

• Create a policy, modify policy information, copy a policy and its version to a new policy.

• Create a new policy version by copying an existing policy version and modifying it.

• View and define mapping information for any policy.

• Review executed policy activity and execution history for policies and policy versions.

• Use tags and categories to manage your policies more efficiently.

Note: 
You can create any number of policies, which can be updated, activated, or deactivated as 
required.

Manage PaCE  policies

You can define and manage your PaCE  policies in a single management console.

Policies are containers for all the elements that make up a policy. These elements include 
metadata related to the policy, the policy versions (including policy scripts and inputs), mapping 
information, and policy execution history.

You can easily create policies, and search and review existing policies. In addition, you can:

• Assess and implement changes to each policy.

• Determine if a policy should be used as the template for another policy.

• Understand why a policy may not be working as expected.

You can create any number of policies, which can be updated as required.

View existing PaCE  policies

You can view a list of all PaCE  policies created by you and other policy administrators. The PaCE 
management console is your gateway to viewing and updating policies, and managing policy 
versions.

Before you begin
Role required: sn_pace.admin
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Procedure

1. Navigate to All  > Policies  > My Policies.

Note: 
To view all policies generated by admin/other users, navigate to Policies  > All Policies. 
These policies are viewable to all logged in users.

On this page, you can do the following:

◦ Create a PaCE policy

◦ Edit a PaCE policy

◦ Delete a PaCE policy

The My Policies list displays the following columns.

Column Description

Policy name The name of the policy as defined by the 
user.

Owner The owner of the policy.

State The current state of the policy:

◦ Active: The policy is Active  and can be 
used. For details on how to activate a 
policy, see Activate or deactivate a PaCE 
policy

◦ Inactive: The policy is Inactive, and must 
be activated before it can be used.

Note: 
Each policy can only have one Current 
(published) policy version. Only policies 
that have a Current version can be 
activated.
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Column Description

See Manage PaCE policy versions  for details.

Category The category assigned to the policy. Only one 
category can be assigned to a policy. See 
Managing categories in PaCE  for details

Content source
The source used to create the policy:

◦ User: This policy was created or copied by 
a user.

◦ ServiceNow: This policy was shipped as 
part of the PaCE  content pack.

2. Optional:  Use the ServiceNow AI Platform  filter controls to filter the displayed list.

3. To view the details of a policy, click the required row in the Policy Name  column.

Note: 
Alternatively, click the information icon to see a quick glance view of the policy.

Create a PaCE  policy

Create a PaCE  policy to determine if changes to a software service or application comply with a 
set of pre-defined rules.

Before you begin
Role required: sn_pace.admin

About this task
After you create a PaCE  policy, a decision is then made about these changes, and if they are 
compliant, non-compliant, or compliant-exception according to these pre-defined rules. The 
policy must be mapped correctly to the relevant object (table and document ID) to invoke the 
policy when any changes are made to the object.

Note: 
Policies are only used if they have active mapping records, and if there was a request to 
validate an object (tables and document IDs) mapped to the policy. For further information, 
see Map PaCE policies.

Procedure

1. Navigate to All  > Policies  > My Policies.

Note: 
To view all policies generated by admin/other users, navigate to Policies  > All Policies.

2. Click New.
The New policy page appears.

3. Select the New blank policy tile or an existing policy template, then Create.
Templates can be filtered by most used, alphabetically, state, and type. By default, inactive 
templates are hidden.

4. In the Create New Policy form, fill in the fields.
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Create New Policy form

Field Description

Policy name The policy name.

Note: 
The policy name must be unique, and is 
used as the identifier of the policy.

Document type Select a document type for the table of items 
for the policy to be applied to.

Category Categories enable you to group and manage 
policies more efficiently. See Managing 
categories in PaCE  for details.

Calling service The name of the calling service the policy 
was created in.

Description Additional details for this policy.

Comments Comments about the policy.

Note: 
You can add additional comments in the Compose text box, that will show up in the 
Activity stream.

5. Click Save.
The form is refreshed to display the newly created 

policy.

6. Optional:  Add tags by selecting the tag icon  alongside the policy name to add tags.
For more information about defining tags, Add tags to PaCE policies.

Result
The newly created policy contains the following tabs.
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Tab name Description

Details The details of the policy including the policy 
name, category, date on which it was created, 
and a description is displayed.

Policy builder When you create a policy, by default a draft 
policy version is created. Each policy version 
contains version meta-data, a policy script, 
and variable input definitions, which you 
can modify according to your requirements. 
Click the Policy builder  tab to view the Policy 
builder page. You can:

• Edit a policy version.

Note: 
You can edit a policy version only if it is 
a Draft state.

• View version details

• Create a new version

• Switch from low-code to the code editor

• Save the policy as a template

• Compare versions

• Duplicate policy versions

For more details, see Manage PaCE policy 
versions.

Note: 
You must publish the (See Publish a 
PaCE policy version) policy version to 
make it Current  before it can be used.

Version management The Version management tab lists out the 
previous versions of the policy. You can also 
create a new version of the policy.

Mappings The Mappings  tab enables you to define the 
object (table and document ID) to which the 
policy is to be mapped. For more information, 
see Map PaCE policies.

Executions The Executions tab enables you to review the 
execution activity for the policy.

What to do next
You can perform the following actions:

• Delete a policy that is in an inactive state. See Delete a PaCE policy.

• Duplicate or create a copy of an existing policy.

• Write and test custom PaCE  policies. See How to write and test custom PaCE policies.
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Activate or deactivate a PaCE  policy

You can activate or deactivate any PaCE  policy. Only activated policies can validate object 
(tables and document IDs) changes. Deactivated policies are not executed, even if the policy is 
mapped. Deactivating a policy enables you to place the policy into a maintenance-like mode.

Before you begin
Role required: sn_pace.admin

About this task
You can deactivate or activate any policy at any time.

For activated policies:

• The policy must include a Current (published) version. For more information, see Manage 
PaCE policy versions.

• The policy is auto-validated when you activate it (if the policy has mapping inputs defined). 
Validation verifies the validity of mapping inputs, and checks that all required inputs were set. 
For more information, see the Validate mapping inputs section.

Deactivating a policy enables you to place the policy into a maintenance-like mode. You can 
make changes, safe in the knowledge that no one is using the policy. While deactivated, the 
policy mappings are kept, but the policy cannot be executed. After you are done with any 
changes, you can reactivate the policy and any existing mappings are reused.

Note: 
The activation or deactivation of a policy is audited for tracking purposes. This audit 
information is included in the standard ServiceNow AI Platform  auditing records.

Procedure

1. Navigate to All  > Policies  > My Policies.

Note: 
To view all policies generated by admin/other users, navigate to Policies  > All Policies.

2. Select the check box next to the policy that you want to activate or deactivate.

Note: 
To activate a policy, its current state must be . To deactivate a policy, its current 

state must be . You can select multiple policies, as required.

3. Activate or deactivate the selected policy.

What to do next
If you did not publish your policies, you can publish multiple policies. Select the check box next 
to the Policy names that you want to publish or select the Select All  box next to the Policy name 
list. Select the Activate  drop-down menu then Publish latest.

Note: 
This only works with content-based policies and not user-based policies.

Duplicate a PaCE  policy

Create a duplicate of an existing policy.
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Before you begin
Role required: sn_pace_admin

Procedure

1. Navigate to All  > Policies  > My Policies.

Note: 
To view all policies generated by admin/other users, navigate to Policies  > All Policies.

2. Click the Policy name  link for the policy that you want to duplicate.

3. In the Details page, click the More Actions  icon and select Duplicate.

4. In the Duplicate Policy window, select the version of the policy you want to copy and click 
Duplicate.
A new policy with the same parameters as the selected policy is created in an Inactive  state. 
You must publish a version of the new policy before you can activate it.

Edit a PaCE  policy

You can update any existing PaCE  policies, whether they are activated or deactivated.

Before you begin
Role required: sn_pace.admin

Procedure

1. Navigate to All  > Policies  > My Policies.

Note: 
To view all policies generated by admin/other users, navigate to Policies  > All Policies.

2. Click the information icon located to the left of the policy name to see a quick glance view of 
the policy.
The policy details display to the right of the My Policies list and can be edited. You can also 
review the Activity  stream to see a list of all changes made to the policy. This list can be 
filtered as required.

3. Edit the relevant details for the selected policy, and click Save.

4. Click the Policy name  link on the All Policies page to update existing versions or add a new 
version.

5. Click the Policy builder  tab, create a copy of the version in which you want to make changes, 
and make the relevant changes in the new version.
You can select different versions of the policy in the Version drop-down menu.  For more 
information about creating and managing versions, see Manage PaCE policy versions.

Note: 
You can't update API Variables and Config Parameters  for an existing policy version that 
is Current (published) or archived. To modify a Current version, create a copy of that 
version, as described in the Create a copy of a policy version section.

6. Select the overflow menu icon  and choose from the following options:

◦ Version details

◦ Create a new version

◦ Switch to code editor
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◦ Save as Template

◦ Compare versions

◦ Duplicate

◦ Delete

7. When you're finished, click Publish.

8. Click the Mappings  tab and make the relevant changes.
For more information about defining caller and mapping inputs, see Map PaCE policies.

Delete a PaCE  policy

You can delete a PaCE  policy at any time. All related versions for that policy are also deleted. 
However, for auditing reasons you cannot delete policies that were or are currently in use.

Before you begin
Role required: sn_pace.admin

About this task
Policies and their related versions can be deleted. However, policies that are in use, or were used 
can't be deleted, including:

• Policies that are mapped to an object.

• Policies that were activated and executed in Standard mode. These policies, and their policy 
versions, include execution data critical for auditing purposes, and therefore cannot be 
deleted.

• Policies that have a version in either Current  or Archived  state.

Procedure

1. Navigate to All  > Policies  > My Policies.

Note: 
To view all policies generated by admin/other users, navigate to Policies  > All Policies.

2. Click the Policy name  link for the policy that you want to delete.

Note: 
You can only delete individual policies. However, you can select multiple policies to 
activate or deactivate. For further information, see the Activate or deactivate a policy 
section.

3. In the displayed policy form, click Delete.

4. Click Delete  to confirm.
The policy versions that are to be deleted are displayed.

Map PaCE  policies

For a policy to be invoked correctly, it must be mapped to an object (table or document ID). The 
defined mapping settings are automatically verified when the policy is invoked.

Mapping a policy to an object enables you to verify updates on that object, whenever a change 
in the provided inputs occurs.
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Define mappings for a PaCE  policy

You can map a policy to any number of objects. When you map a policy, validate the inputs, and 
execute the policy, a compliant, non-compliant, or compliant-exception decision is returned.

Before you begin
Role required: sn_pace.admin

Procedure

1. Navigate to All  > Policies  > My Policies.

Note: 
To view all policies generated by admin/other users, navigate to Policies  > All Policies.

2. Click the Policy name  link for the policy that you want to update.

3. Click the Mappings  tab.
If there are any existing mappings for the selected policy, they are displayed.

4. To add a new mapping input, click Add.
Any objects that are available for mapping are displayed.

5. Select the check box to the left of each object that you want to map the policy to, and click 
Map Policy.
The new mapping input is added to the list of policy mappings. In addition, an alert message 
indicates whether the mapping is valid and active. For information about editing existing 
mapping inputs, see Edit mapping inputs.

Edit mapping inputs

You can edit the mapping settings that map a policy to an object.

Before you begin
Role required: sn_pace.admin
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Procedure

1. Navigate to All  > Policies  > My Policies.

Note: 
To view all policies generated by admin/other users, navigate to Policies  > All Policies.

2. Click the Policy name  link for the policy that you want to update.

3. Click the Mappings  tab, and click the Mapping ID link in the Input field.

4. Click the mapping input that you want to update.
In the displayed mapping input form, edit the details as required, and click Save.

PaCE  Static and Dynamic Mapping

Static Mapping enables you to map a set of policies to a record or object such as an incident or 
deployable. Dynamic Mapping enables you to map a set of policies on a dynamic set of records 
or objects such as a set of incidents or a set of deployables.

Static Mappings

Static Mapping enables you to map multiple policies that you want to validate against a specific 
deployable or incident. For example, if you need to map a policy to multiple deployables, you’ll 
need to map it multiple times to each deployable.

Dynamic Mappings

Dynamic Mapping enables you to map multiple policies that you want to validate against 
specified conditions. You can configure the conditions set to a specific table, each condition 
can return multiple records or objects. The condition is applied at a runtime where the set of 
policies will be mapped to the set of returned records by the condition. Multiple conditions can 
be defined in the condition fields in the Conditions tab.

Map PaCE  policies using Static Mapping

Use Static Mapping to map multiple PaCE  policies against a record such as a change request.
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Before you begin
Role required: sn_pace.admin

Procedure

1. Navigate to Mappings  > Static Mappings.

2. Select Add.

3. Select a document type in the Document Type  field.

4. Select a policy in the Policy  field or you can select the Search icon  to view and select 
multiple policies, then select Map.

5. When you're finished, select Done.

Result
The map will show up in the Static Mappings list. You can delete a map on the list by selecting 
the box next to the Input, then select Delete.

Map PaCE  policies using Dynamic Mapping

Use Dynamic Mapping to map multiple PaCE  policies against specified conditions.

Before you begin
If you don’t have a condition created, do the following steps.

1. Navigate to Mappings  > Conditions.

2. Select New.

3. Fill in the Short description  and Table  field, then add the conditions of the deployables you 
want to map.

4. Select Run  to preview the existing deployables that will be mapped in the condition.

Note: 
The results are capped at 10,000 records.

5. Select Save  or Continue to mapping  to navigate to the Dynamic Mapping page.

Note: 
When you select Continue to mapping, the condition is pre-selected based on the 
condition you created, additionally you can edit or delete the condition by selecting the 
short description.

Role required: sn_pace.admin

Procedure

1. Navigate to Mappings  > Dynamic Mappings.

2. Select Add.

3. Select a document type in the Document Type  field, then a condition in the Condition  field.

4. Select a policy in the Policy  field or you can select the Search icon  to view and select 
multiple policies, then select Map.

5. When you're finished, select Done.
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Result
The map will show up in the Dynamic Mappings list. You can delete a map on the list by selecting 
the box next to the Input, then select Delete.

Request an exception for Dynamic Mapping

Request an exception on policies that are dynamically mapped to conditions.

Before you begin
You need to have the Governance, Risk, and Compliance  (GRC) application installed to have the 
Request Exception button to show up on the mappings list. If you don't have the GRC  application, 
see the Download a GRC application from the ServiceNow Store for the first time  topic.

Role required: sn_pace.admin, sn_pace.mapping_admin, or sn_pace.execution_reader

Procedure

1. Navigate to  > Mappings  > Dynamic Mappings.

2. Select the check box of the mapped policy you want to request an exception for.

3. Click Request exception.

4. In the Request policy exception form, fill in the fields.

Request policy exception

Field Description

Deployable Select the name of the deployable you want 
to request an exception for.
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Field Description

Note: 
The list of deployables is not filtered 
and all possible deployables will 
be available to be selected without 
filtering based on the dynamic mapping 
condition.

Reason for exception Select a reason type why the exception is 
being requested.

Policy Name of the policy.

Business justification Explanation why the exception is being 
requested.

Requested start date Select the date when this exception is 
submitted.

Requested end date Select a date when you want this exception to 
be approved by.

5. Click Request.

Create a PaCE  policy template

Create PaCE  templates for the PaCE  policy forms that you use frequently.

Before you begin
Role required: sn_pace.admin

Procedure

1. Navigate to Templates  > All Templates.

2. Select New.

3. In the Create New Template form, fill in the fields.

Create New Template form

Field Description

Name Name of the policy template.

Document type Select a document type for the table of items 
for the template to be applied to.

Template type Template type organized by category. 
Template types enable you to select a 
category, if you have multiple types of policy 
templates. You can create a template type by 
following these steps:

a. Navigate to Templates  > Template Type.

b. Select New.

c. Fill in the Name  and Description  field.

d. Select Save.
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Field Description

The type can be selected from the Template 
type  field.

Description Additional details for this template.

Is low code Select this check box if the policy template 
will be written in low-code.

Note: 
You can switch to the code editor 
from low-code when you create the 
conditions, but you’ll be unable to 
switch back to low-code.

4. Select Save.
By default, when you create a template it’s inactive and it will be filtered out on the New policy 
page. You can select the inactive filter box on the New policy page to see the inactive template.

5. Select the Template Builder  tab and fill in the conditions in the Policy logic section, then Save.
For more information about the parameters and condition fields, see the Passing parameters to 
PaCE policies  and Policy logic condition fields  topic.

What to do next
Before you activate your template, you can create a policy to test the template.

1. Navigate to Policies  > My Policies.

2. Select New.

3. Select Preview  on the template that you created to see if the information is correct.

4. Select Save.

5. Select the template that you want to create a policy with, then Create.

6. Fill in the fields, then select Save.

7. Select the new draft of the policy and select the Test Playground  tab to test the policy.

8. When you're finished, navigate back to Templates  > All Templates. Select the template that 
you tested, then Activate.

If you make any updates to a template, it won’t affect previous policies that you created using the 
template.

Manage PaCE  policy versions

PaCE  policy versions contain the actual policy script, as well as API Variable and Config 
Parameter  definitions used for validating policies. Each policy can have many versions, each of 
which can be easily managed.
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You can create a new policy version, search and review existing versions, and test changes to 
the policy script before it is deployed in a production environment. You can also compare policy 
versions, copy a policy, and modify it as required.

Note: 
To activate a policy, a policy version must be created, and published to be in the Current 
state.

PaCE  policy version states

A PaCE  policy version can be in one of four states: Draft, Current, Archived, and Now-Content. 
The policy version state also defines the version numbering.

Only one policy version in each policy can be Current at any one time. There is no limit to the 
number of Draft or Archived policy versions.

Policy version states

State Description

Draft When a version is created, its initial state is Draft. The new Draft version can be 
saved as a Draft for later use, or published to become the Current version. The draft 
versions cannot be used until they are published.

Current Draft versions can be published to Current, which means the former draft version 
becomes the default published version used for policy execution.

Note: 
When publishing the version, if mapping exists, verification is performed to 
confirm that all required inputs for mapping inputs were provided. If you update 
the mapping inputs, you must update the inputs in the Mapping screen. If you 
updated caller inputs, you must update the PaCE  API call to ensure that the 
policy is executed.

Archived A published Current version becomes Archived when a different version is 
published. Only Current versions can be Archived. If necessary, you can also 
republish an Archived version.

Note: 
When a version is published, it becomes the Current version irrespective of its 
previous states.

Ready The Ready state is assigned to optional policies available when an application 
content pack is installed. These policies cannot be modified. If you want to modify a 
policy, create a copy and make the required changes.

Policy version numbering

There are three identifiers for each version: Version name, Version, and Revision number. These 
identifiers are shown as three separate columns in the Versions  tab.

Identifier Description

Version 
name For Draft versions, the version name uses Draft-V{Revision number}.

For Current (published) or Archived versions, V{Version} is used for the name.
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Identifier Description

Version The Version number is assigned only when you publish a version. The number is 
automatically created according to the existing version number. For the first Current 
(published) version, the number is 1.0 and for subsequent current versions, the 
number increases by +1.0. For example, 2.0, 3.0, 4.0, and so on.

Current versions that have been Archived retain the original version number.

Draft versions are not assigned a version number.

Revision 
number

The Revision number is derived from the version that it was created from. If an empty 
new policy is created, the initial draft version is assigned 0.1. Each subsequent draft 
version is assigned 0.2, 0.3, 0.4, and so on.

If the version was created from a published (Current or Archived) version, it inherits 
the Version number. For example, you can create a draft version from the Current 
(published) version 2.0. The draft version is assigned the revision number 2.1.

The following image illustrates the different states and their version numbering.

As shown in the preceding image, the first draft policy version created was automatically 
assigned the Revision number 0.1. Each subsequent draft is assigned V0.2, V0.3, and so on. Draft 
version 0.2 (as indicated in the Revision number column) was published and became the Current 
version, with the Version name of V1.0.

A draft version of this Current version was created, with the Revision number 1.1. That draft 
was published to become the Current version and was assigned the Revision number 1.1. The 
previously Current version is now Archived, but retains the Revision number 0.2.

Create new PaCE  policy versions

You can create new versions for any of your existing policies.

After you have created a policy, a draft policy version is automatically created. This policy 
version contains the actual policy script, and may also contain mapping inputs and caller input 
definitions.

You can create a policy version from scratch, using low-code,  or copy an existing policy version 
and use that as the basis for a new version. The version can include input definitions for mapping 
or caller variables. These parameters are used with the logic of the policy to determine whether 
the policy is in compliance.

For example, for a travel expense policy you can create several policy versions. Each version 
can include different mapping inputs, for example, limiting the different types of expenses. In 
one version, the breakfast expense limit could be $25, and the dinner expense limit could be 
$50. Each time the policy (and the relevant Current version) is invoked, the various expenses are 
validated by the policy to ensure they are in compliance.
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Create a PaCE  policy version

Create a version from scratch at any time for any of your existing PaCE  policies.

Before you begin
Role required: sn_pace.admin

About this task
Note: 
Your administrator may have pre-configured policy versions that contain default caller and 
mapping inputs. You may not be able to edit these input variables, but you can add new 
inputs, as required.

Procedure

1. Navigate to All  > Policies  > My Policies.

Note: 
To view all policies generated by admin/other users, navigate to Policies  > All Policies.

2. Click the policy name for the policy that you want to add a new version to.

3. In the Policy Details page, click the Versions  tab.

4. Click New.
The New version page appears.

5. Select the New blank version tile or an existing policy template, then Create.
Templates can be filtered by most used, alphabetically, state, and type. By default, inactive 
templates are hidden.

6. Clear the Is low code  check box.

7. Optional:  In the Create New Policy Version form, add a description in the Description  field. 

Note: 
The Description  field is the only editable field in the form. The version and revision 
numbering cannot be modified and are automatically assigned.

8. Click Save.

What to do next
The policy version is saved and the version is assigned a number according to policy numbering. 
You can:
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• Define API Variables, Config Parameters, and Record References.

See Passing parameters to PaCE policies.

• Modify the policy script.

See Edit a PaCE policy script.

• Test your policy version to ensure it is compliant.

See Use the Test Playground for PaCE policies  for details.

• Publish the policy version.

See Publish a PaCE policy version.

• Review execution activity for the version.

See Review executed policy activity.

• Delete the version.

See Delete a PaCE policy version.

Create a PaCE  policy version using low-code

Create a policy version using low-code for any of your existing PaCE  policies.

Before you begin
Role required: sn_dev_ops_config.admin

About this task
The low-code function enables you to write policies using simple UI elements by defining 
conditions for the policy to determine if it’s compliant or non-compliant. If the Is low code  check 
box is selected when you create a policy version, the Policy Builder  and Test Playground  tabs 
will automatically have the Policy logic page set to low-code.

You can switch to the Policy Script to create a policy using JavaScript by selecting the Switch to 
code editor  button, but you’ll be unable to switch back to low-code. For more information on how 
to write PaCE  policies using JavaScript, see How to write and test PaCE policies.

Note: 
Policy Builder works best in Google Chrome  and Firefox.

Procedure

1. Navigate to Policies  > My Policies.

2. Select the policy name for the policy that you want to add a new version to.

3. In the Policy Details page, select the Versions  tab.

4. Select New.
The New version page appears.

5. Select the New blank version tile or an existing policy template, then Create.
Templates can be filtered by most used, alphabetically, state, and type. By default, inactive 
templates are hidden.

6. Fill in the Description  field.
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Note: 
By default, the Is low code  check box is automatically selected.

7. Select Save.

Result
The policy version is saved with an assigned number according to the policy numbering and will 
enable you to set the conditions using low-code.

Policy logic condition fields

Policy logic is a set of conditions that is used for determining whether a policy is compliant or 
non-compliant. You can use the condition builder to specify conditions for the policy.

Policy logic page

Select the or  and and  button to add multiple rules in the condition set. Select the minus icon 
to delete a condition.

You can add a condition set by selecting the New condition set  button.

If and else if statement fields

Field Description

Condition description Description of the field.

Source Variable of the source for the condition.
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If and else if statement fields  (continued)

Field Description

Operator List of operators to filter the source for the 
condition. The list changes depending on the 
source selected.

Value Value to enter text. Select the Data picker icon 

 to concatenate multiple text strings with 
multiple data pills to select a variable for the 
log.

Note: 
If your Source is choice, the Data pill 
picker icon is inactive.

The else if  statement enables you to specify a new condition if the first condition is false. The 
else  statement enables you to specify a new condition if it does not apply to the if  statement.

You can add a dependent condition by selecting or  or and  next to the condition.

Then and else statement fields

Field Description

Logic type Select the logic type of the policy:

• Decision: Determines if the policy is 
Compliant  or Non-compliant.

• Run policy: For nested policies, the parent 
policy will return the decision of the child 
policy that has been selected in the builder.

Note: 
PaCE  supports nesting policies 
for decision-making and up to two 
levels are supported, a child and a 
grandchild.

Log level Level of the log.

Log message Log message field to enter text or select the 

Data picker icon  to concatenate multiple 
text strings with multiple data pills to select a 
variable for the log.

Output type Output type of the log. You can select the plus 

icon  to add multiple output types or the 

minus icon  to delete the output type.

Data Data field to enter text. Select the Data picker 

icon  to concatenate multiple text strings 
with multiple data pills to select a variable for 
the log.
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The following images show you are able to use the data pill picker to concatenate data in the 
fields:

You can see a list of the data sources under the Data source 

tab.
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You can calculate fields using numeric operators and use these variables to calculate the desired 
value in a policy logic.

Note: 
This only supports numeric fields.

Calculated fields

Operator Description

Plus (+) Add variables and constants. For example, 
"Var1 + Var2..."

Minus (-) Subtract variables and constants. For 
example, "Var1 - Var2..."

Multiplication (*) Multiple variables and constants. For example, 
"Var1 * Var2..."

Division (/) Divide variables and constants. For example, 
"Var1 / Var2..."

Parentheses () Use parentheses to support the order of 
operators.

calc[] Use the brackets to evaluate an expression.

You can mix and match between the operators. For example, "Var1 +Var2*Var3 / Var4".

Create a copy of a PaCE  policy version

You can create a copy of an existing policy version. All the settings and mappings from the 
existing version are copied over to the new one.

Before you begin
Role required: sn_pace.admin

About this task
When you create a new policy version from an existing one, the input definitions and the policy 
script from the original version are copied to the new version. The version is assigned a number 
according to policy numbering.

Note: 
The new policy version is initially created as a draft, with a revision number based on the 
original policy version. For further details about version states and numbering, see PaCE 
policy version states.

Procedure

1. Navigate to All  > Policies  > My Policies.

Note: 
To view all policies generated by admin/other users, navigate to Policies  > All Policies.

2. Click the name of the policy for which a version is to be created.

3. In the Policy Details page, click the Versions  tab.

4. Click the Version name  link of the policy version that you want to copy.

5. Click Create New Draft.
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A new copy of this policy version is created.

6. Enter a description for the new version and click Save.

Duplicate PaCE  policy versions

You can create a duplicate policy from a policy version or multiple versions from two or more 
policy versions. If you want to use a locked policy, you must first create a duplicate version and 
then modify the policy version as required.

Duplicate a single policy version

To create a duplicate policy from a policy version, follow these steps:

1. Navigate to All Policies  > My Policies.

Note: 
To view all policies generated by admin/other users, navigate to Policies  > All Policies.

2. Select the name of the policy that you want to duplicate.

3. In the Policy Details page, click the Versions  tab and select the version you want to duplicate.

4. Click the More Actions  icon and select Duplicate.

5. Select an option in the Duplicate version  form.

◦ To new policy:

a. Select this option to create a duplicate policy from this version.

b. Enter the policy name, category, and description.

c. Click Duplicate.

The newly created policy is a duplicate copy and contains the same parameters and 
mappings of the selected policy version.

◦ To existing policy:

a. Select this option to create a duplicate version for an existing policy.

b. In the Duplicate Version form, select the policy to which the version is to be duplicated.
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c. Click Duplicate.

The newly created duplicate version is displayed in the Versions page of the selected 
policy.

Duplicate multiple policy versions

1. Navigate to All Policies  > My Policies.

Note: 
To view all policies generated by admin/other users, navigate to Policies  > All Policies.

2. Select the name of the policy that you want to duplicate.

3. In the Policy Details page, click the Versions  tab.

4. Select the policies that you want to duplicate and from the drop-down list, select Duplicate 
versions.

5. Select an option in the Duplicate version  form and follow the remaining steps as listed in 
Duplicate a single policy version.

Edit a PaCE  policy script

Edit the PaCE  policy script to apply any changes to the policy logic.

Before you begin
Role required: sn_pace.admin

About this task
Important: 
For further information about testing your policy script, see Use the Test Playground for 
PaCE policies.

Procedure

1. Navigate to All  > Policies  > My Policies.

Note: 
To view all policies generated by admin/other users, navigate to Policies  > All Policies.

2. Select the policy for which you want to update the script.

3. In the Details form of the relevant policy, click the Versions  tab and select the version you want 
to edit.

4. In the policy version page, click the Policy Builder  tab.
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The following image shows a sample policy 

script.

Note: 
The script is editable for policy versions in Draft state only. For policy versions in Current 
or Archived state, the script is read-only.

5. Apply any changes to the policy script, as required.

6. Click Save.

Publish a PaCE  policy version

You can publish a policy version at any time. When the policy is published, a compliant, non-
compliant, or compliant-exception decision is made for objects (tables or document IDs) 
mapped to the policy.

Before you begin
Role required: sn_pace.admin

Procedure

1. Navigate to All  > Policies  > My Policies.

Note: 
To view all policies generated by admin/other users, navigate to Policies  > All Policies.

2. Click the policy name for the policy that includes the version you want to publish.

3. In the Details page, click the Policy builder  tab.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

5490



Typically you would publish a Draft policy, but you can also republish an Archived version.

4. Click Publish.
The following screen is displayed.

5. Select the Activate this policy  check box to activate the policy when it is published.

6. In the displayed confirmation message, click Publish.

The policy version becomes the Current version and is used the next time the policy is 
invoked.

Note: 
If the policy has an existing mapping to document IDs, when you publish a new version 
it verifies that all mandatory inputs for mapping inputs are provided. If you changed a 
mapping input, it must be updated. If you changed a caller input, you must update the 
PaCE  API call to ensure that the policy is executed. If there is no mapping associated with 
the policy, or the policy is in an Inactive state, the mapping inputs are not verified.

Edit a draft PaCE  policy version

You can edit a Draft PaCE  policy version at any time. The Draft version can be published to 
become the Current version. You can also create multiple different Draft versions from different 
Archived versions.
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Before you begin
Role required: sn_pace.admin

Procedure

1. Navigate to All  > Policies  > My Policies.

Note: 
To view all policies generated by admin/other users, navigate to Policies  > All Policies.

2. Click the Policy name  for the policy that includes the version you want to edit.

3. In the Policy Details page, click the Versions  tab.

4. Click the Version name  that you want to edit.

5. Edit the information and inputs in the Details  and Policy Builder  tabs.

6. Perform one of the following actions.

Edit a current or archived PaCE  policy version

To edit a Current (published) or Archived PaCE  policy version, you must create a copy of that 
version, which can then be updated as required.

Before you begin
Role required: sn_pace.admin

Procedure

1. Navigate to All  > Policies  > My Policies.

Note: 
To view all policies generated by admin/other users, navigate to Policies  > All Policies.

2. Click the Policy name  for the policy that includes the version you want to edit.

3. In the Policy Details page, click the Versions  tab.

4. Click the Version name  that you want to edit.
As you can't update a policy version that is Current (published) or Archived, the displayed 
fields are read-only.

5. Click Create New Version.
In the Version page, define the details of the new version. For further information, see the 
Create a new version of a policy section. In addition, you can create multiple Draft versions 
from an Archived or Current (published) version and work on them in parallel.

Compare PaCE  policy versions

You can compare two versions of a PaCE  policy, whatever their state. Any differences between 
the two selected versions are highlighted for quick analysis.

Before you begin
Role required: sn_pace.admin
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Procedure

1. Navigate to All  > Policies  > My Policies.

Note: 
To view all policies generated by admin/other users, navigate to Policies  > All Policies.

2. Click the Policy name  for the policy that includes the versions you want to compare.

3. In the Policy Details page, click the Versions  tab.

4. Select the relevant two versions to compare, and click Compare.
The Compare Versions  tab displays several container sections that highlight any differences 
between the two versions.

◦ The Details  container highlights differences between the details of the two versions. For 
example, differences between the state, version name and numbering, and the number of 
test or standard runs.

◦ The Script  container highlights any differences in the policy script of the two versions.

◦ The Mapping Inputs  container also lists any differences between the two versions.

5. To make any changes based on your analysis of the two compared versions, return to the 
Versions  tab, select the relevant version, and modify and test as required.

Delete a PaCE  policy version

You can delete a policy version at any time. However, only versions that have never been 
published can be deleted. Published versions are stored for auditing purposes.

Before you begin
Role required: sn_pace.admin

About this task

• Policy versions in Draft state can be deleted. When a version is deleted, all defined caller/
mapping inputs and policy metadata associated with the version are also deleted.

• Policy versions that cannot be deleted include:

◦ Policy versions in Current or Archived state.

◦ Policy versions that have been executed in a Standard run.

Procedure

1. Navigate to All  > Policies  > My Policies.

Note: 
To view all policies generated by admin/other users, navigate to Policies  > All Policies.
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2. Click the Policy name  for the policy that includes the version you want to delete.

3. In the Policy Details page, click the Versions  tab.

4. Select the relevant version, click Delete  and OK  to confirm.

Passing parameters to PaCE  policies

Parameters can be passed to a PaCE  policy to validate updates to an object (tables and 
document IDs). These variables apply to authoring in both low-code or JavaScript. Policy 
versions include three types of parameter inputs: API Variables, Config Parameters, and Record 
References.

API Variables

Previously known as Caller Inputs, the API Variables is passed to the PaCE  API at the time of 
invocation by a developer. The API Variable is a variable that enables you to pass the value to the 
policy whenever the policy is invoked. Specify a value for this API Variable when calling the API, 
otherwise the policy is not executed and no decision is reached. In the code editor, the variable 
name is apiVars.

For each PaCE  policy, there is only one pre-defined API Variable called SnapshotId. This API 
Variable is Immutable and cannot be modified or deleted. You cannot define any additional API 
Variables for a policy.

Config Parameters

Previously known as Mapped Inputs, the Config Parameters can be passed when mapping 
policies to an object (tables and document IDs). When you define a Config Parameter, you 
are creating a parameter that enables you to pass values to the policy whenever the policy 
is mapped. If you define mandatory inputs, you must specify values for these inputs when 
mapping the policy. If the inputs you define are not mandatory, the policy is not executed (the 
status is set to inactive) and no decision is reached. In the code editor, the variable name is 
configParams.

For example, for a travel expenses policy you can add variables to define the limits of different 
types of expenses. The limits are specified when mapping the policy, and set the limits on the 
expense when the policy is invoked on this object. The breakfast expense limit for one group 
of employees could be $25, and for a different group of employees the limit could be $50. Each 
time the policy is invoked, the expenses are validated by the policy according to the limits 
specified in the mapping.

Record References

Record references define queries to extract data from any ServiceNow®  tables and use the data 
to configure the policy logic. This feature enables you to retrieve additional data that may be 
required while defining the policy. You can define a query to perform aggregate functions for a 
record reference. In the code editor, the variable name is recordRefs.

Data Collectors

The data collectors function collects input process data from ServiceNow  or an external data 
source to provide an output. The output can be used in the policy logic to make a decision. You 
can define and manage data collectors by creating, editing, updating, and activating them to your 
policy builder.

Data collectors can be accessed by using the dataCollectors  object in JavaScript.
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Note: 
Auto-completion lists all possible outputs and data collectors that are available to use.

While editing a policy in low-code, an output of the configured data collectors is available under 
the drop-down menu.

Create a new variable for a policy version

Create an API Variable, Config Parameter, or Record Reference for the policy version in the 
Define Variables section of the  Policy Builder.

Before you begin
If you want to create a variable that will apply to all of your policies, then do the following:

1. Go to the Variable Definition section on the main page.

2. Select the variable section that you want to create.

3. Select Add.

When you save the variable, it will show up in the Define Variables section on the  Policy Builder 
of the policy.

Role required: sn_pace.admin

Procedure

1. In the Policy builder  tab, select the version of the policy you want to add a new variable to, 

then the Data sources icon .

2. Select the variable tab that you want to create a variable from then select Add.
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A pop-up window appears titled with the variable you want to create.

3. On the form, fill in the fields as needed.
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Create a new variable form

Field Description

Label Label name of the variable.

Name Name of the variable.

Type Drop-down list of input types:

◦ Basic Date/Time

◦ Basic Time

◦ Choice

◦ Data Array

◦ Data Object

◦ Decimal

◦ Email

◦ Integer

◦ IP Address

◦ JSON

◦ Other Date

◦ Reference

◦ String

◦ Sys ID (GUID)

◦ True/False

Depending on the input you choose, the 
Advanced Options provides different fields 
for some inputs. For more information, see 
the Data type descriptions  topic.

Note: 
The list only shows the most common 
used data types.

Mandatory Option to make this variable mandatory.

When the variable is mandatory, a value 
must be provided when mapping the policy. 
Otherwise the policy can’t be executed.

Description Description of the variable.

Note: 
When you add a description for a Config 
Parameter variable, it will show up 

under the tool tip icon  in the Test 
Parameters tab.

Default Value Default value for the variable.
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Field Description

Note: 
When you create a record reference, 
select a reference in the Table field, this 
field enables you to select a dependent 
document from the reference.

Function (Optional) Functions to aggregate your condition. 
Choices are as follows:

◦ Average: Average value of the condition.

◦ Count: Count of the number of non-null 
values.

◦ Maximum: Largest or maximum value.

◦ Minimum: Minimum value.

◦ Standard deviation: Population of standard 
deviation.

◦ Sum: Sum of all values.

Note: 
This field will only show up in the 
Record Reference variable form with the 
qualifier condition fields.

Match criteria A match criteria for your record reference. 
Choices are as follows.

◦ Select first match

◦ Error on multiple

When you create a Record Reference, it 
will query multiple answers. The match 
criteria enables you to filter out the match by 
selecting the first match or return an error if 
there are multiple answers.

Note: 
This field will only show up in the 
Record Reference variable form with 
the qualifier condition fields. For more 
information about condition fields, see 
Policy logic condition fields.

4. Select Save.

Result
You can add your variables into the Policy Builder as needed. Additionally, you can delete a 
variable by selecting it and selecting the Delete  button.

Data type descriptions

The following is a list of the most common data types for creating a variable.
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Data types

Data type Description

Basic Date/Time Day and time of day, which can be selected 
with a calendar widget.

Basic Time Specific time.

Choice Script that returns an array of choices that 
will be displayed for selection in a drop-down 
menu. If you select the Multi select  check box, 
then multiple options can be selected from the 
drop-down. If it’s unselected, then only one 
option can be selected.

Data Array Data Array structure represented as a String.

Data Object The Data Object input enables you to select 

the plus icon  to add a new property to the 

data object or the minus icon  to delete it.

Additionally, you can select the Star icon 
that will search for a name if you don't know 
the structure of the JSON format property. A 
JSON path and match criteria field will appear 
and enable you to search for a key in the JSON 
structure.

Decimal Number with up to two digits after the decimal 
points.

Email Email represented as a String.

Integer Number with zero decimal points.

IP Address Variable character field that stores IPv4 and 
IPv6 addresses.

JSON JavaScript Object Notation represented as a 
String.

Other Date Date, which can be selected with a calendar 
widget.

Reference Query that displays records from another 
table. The data type includes a match criteria 
field and qualifier conditions that you can set.

String For 255 characters or less, the string field is a 
single-line text field.

Sys ID (GUID) Field that contains a unique identifier for each 
record.

True/False Boolean field that appears as a one-digit 
integer.

Create a data collector for a policy version

Create a data collector for a policy version in the Define Variables section of the Policy Builder.
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Before you begin
Role required: sn_pace.code_editor

Procedure

1. Navigate to All  > Variable Definition  > Data Collectors.

2. Select 

New.

3. On the form, fill in the fields as needed.

Create New Data Collector

Field Description

Name Name of the data collector.

Category Category of the data collector. See Managing 
categories in PaCE  for details.

Description Additional details of the data collector.

Created Date and time when the data collector was 
created.

Created by Name of the user who created the data 
collector.

Updated Date and time when the data collector was 
updated.

Updated by Name of the user who updated the data 
collector.

4. Click Save.

What to do next

• Activate and build data collectors

• Test a data collector for a policy version

• Add data collectors to a policy version

Structure of a data collector

This section describes the structure of a PaCE  data collector.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

5500



When you create a data collector, you can add inputs and outputs in the Javascript code. In 
the Data sources tab, select Add  to create the inputs and outputs you want to add to your data 
collector. The following images show the pop-up window that will show up when you select Add 
under the Input or Output tab.

The following image shows a sample data collector:
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To debug the data collector script, select the Debugger script icon . For more information, see 
Script Debugger API .

The following table lists the data collector function parameters and how they can be used in the 
script.

Variable name Description

Input Inputs are used as parameters that help 
collect the correct data to be used in the 
policy.

Output The parameter is used to pass the output of 
the data collector. Outputs are used to specify 
output variables that can be used in the policy 
logic.

Refer to the Data type descriptions  topic to see a list of the supported data types for the inputs 
and outputs.

Activate and build data collectors

Activate and build data collectors to add to a policy.

Before you begin
Role required: sn_pace.code_editor

Procedure

1. Select the Versions  tab, then the data collector draft name.

2. Select the Build  tab.

3. In the Data sources section, select the variable tab you want to define.
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a. Click Add.

b. On the Add new input form, fill in the fields.

Add new input

Field Description

Label (Optional) Label of the input or output.

Name Enter a name of the input or output.

Type Select the type of the input or output.

Mandatory Select this check box if the input is 
mandatory.

Description Description of the input or output.

Default value Specify a default value.

Note: 
Inputs are used as parameters that help collect the correct data to be used in the 
policy. Outputs are used to specify output variables that can be used in the policy logic.

c. Click Save.

d. Repeat the steps to create the inputs and outputs as needed.

4. Enter your inputs or outputs and write your code in the Data collector script, as needed.

5. Optional:  Add an exception error in your data collector by entering the following script: throw 
new PaCEExecutionError.
When you execute the policy with the data collector exception, the error message will appear 
under the Output tab in the Execution errors section.

6. Click Save.

7. When you're finished, select Publish.
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8. In the Publish draft window, select the Activate this data collector  check box, then Publish.

Note: 
When the data collector has been activated, you will be unable to make changes to the 
inputs or outputs.

Test a data collector for a policy version

Test a data collector for a policy version in the Test Playground.

Before you begin
Make sure you created a data collector in the policy. For more information, see Create a data 
collector for a policy version.

Role required: sn_pace.code_editor

Procedure

1. Navigate to All  > Variable Definition  > Data Collectors.

2. Select the data collector you want to test.

3. Select the Versions  tab, then the data collector name.

4. Select the Build  tab.

5. In the contextual sidebar, select the Test playground icon .

6. Add the parameters in the inputs you want to test in the data collector, then select Run test.
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The results will appear in the Output tab.

7. In the Publish draft window, select the Activate this data collector  check box, then Publish.

Add data collectors to a policy version

After testing the activated data collectors, add them to a policy in the Policy Builder.

Before you begin
Role required: sn_pace.code_editor

Procedure

1. In the Policy Builder tab, select the version of the policy you want to add the new data collector 

to, then the Data sources icon .

2. Select the data collector from the list of possible data collectors in the system, then click 

Next.

3. In the Add data collector page in the Details tab, give the data collector a label and variable 
name.
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Note: 
If you're using the same data collector multiple times, it should have a different variable 

name.

4. Provide inputs to complete the configuration of the data collector in the Input tab.

Note: 
The input can be user-specified or selected from the data picker icon.

5. Click Save.
After the data collector is added and configured, you can access the data collector in the 
script editor using the data picker in low-code. Additionally, you can delete a data collector by 
selecting it and selecting the Delete  button

Add nested policies in a policy

Add existing policies to a policy's conditions to define the order a policy's execution and the 
conditions is executed.

Before you begin

Note: 
You must create a policy before adding it to another policy. For more information, see 
Create a PaCE policy.

You can add a policy multiple times with different names and parameters. The policies must 
be configured and mapped to a document, and API variables and Config parameters may be 
required and mapped to be configured. For more information on how to add variables, see 
Create a new variable for a policy version.

Role required: sn_pace.admin
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Procedure

1. Navigate to Policies  > My Policies.

2. Select the policy you want to nest the policies in.

3. In the Data sources  section, select the Policies  tab.

4. Select Add.

5. In the Add policy window, search and select the policy you want to add as a data source, then 
select Next.

6. On the Details tab, enter the Label  field and Variable name  field and other configuration inputs 
as needed for the policy.

7. In the Configure Inputs tab, under the Document section, select the 
value of the document type that depends on the integration for the 

policy.

8. Pick a variable to pass for in the API variable and Config parameter sections you created in the 
beginning of this task.

Note: 
You can specify the value in the fields as needed.
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9. Select Save.

Result
The policies now appear on the Policies tab and can be added in the condition section or the 
Then section of the Policy builder. For more information on how to add the policies in the builder, 
see Policy logic condition fields.

Use the Test Playground for PaCE  policies

The Test Playground enables you to test updates to a PaCE  policy at any time, without the need 
to test or evaluate them in a Production environment.

You can update API Variables, Config Parameters, and Record References, and modify the policy 
script. After completing your changes, evaluate the updates in the Test Playground and review 
the execution output to ensure that the policy is compliant. Use the Test Playground to fine-tune 
your policy administration. Updates to a policy can be made on-the-fly, and tested in real time in 
a test environment. In addition, use the Test Playground to:

• Set execution parameters.

• Set and modify variables.

• Edit the policy script and policy logic.

• Use previously evaluated variables  from a previous evaluation run.

• Review the execution output and the decision of compliance (compliant or non-compliant).

• Review a log of executions.
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Test updates to a PaCE  policy version

Use the Test Playground to test updates to a PaCE  policy script. You can evaluate changes to the 
policy script in real time, enabling you to determine if the changes that are applied render the 
policy compliant or non-compliant.

Before you begin
Role required: sn_pace.admin

About this task
The Test Playground enables you to apply changes to the policy script, and see the impact of 
those changes in real time. After the changes have been evaluated, save the script to ensure that 
the changes are implemented when the policy is next invoked.

Procedure

1. In the Policy builder  tab, select the Test playground icon  in the right-hand menu.

2. In the Test parameters tab, fill in the forms as needed.

Test options fields

Field Description

Document The document that you want to test the policy 
version with.

Note: 
This field will change depending on 
which application PaCE  is being used.

Log level Level of the log.

Timeout Timeout to determine the execution threshold 
of the test.

Execution log Execution tag for the policy version.

Verbose Option to make the test display in a verbose 
format.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

5509



3. Under the API parameters  and Config parameters  tabs, select the variables you want to test 
with the policy version.

4. When you are done modifying your policy script, click Run Test.
A decision is reached regarding the compliance or non-compliance of the policy, based on 
the changes you made to the script. In the Test Parameters section, either Compliant  or Non-
compliant  is displayed, along with additional output on any warnings or failures, and how long 
the evaluation took.
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Note: 
A decision with Compliant with exception will not work with a custom decision.

Review execution output and decision

After evaluating any changes made to the PaCE  policy script, you can review the execution 
output and compliance decision reached. You can review this output immediately after 
evaluating any policy script changes.

Before you begin
Role required: sn_pace.admin

Procedure

1. In the Policy builder  tab, click the policy version you want to evaluate.

2. Select the Test playground icon .

3. After modifying the policy script according to your requirements, click Run Test
The Output  tab is displayed automatically, and shows the output and the decision reached.
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4. Review the execution output in the Output  tab:

Output tab 
section

Description

Compliance 
decision

The decision can be:

◦ Compliant: The changes you applied to the policy script are compliant with 
the policy logic. When you click Save Script, the changes are saved, and the 
changes implemented the next time the policy is invoked.

◦ Non-compliant: The changes you applied to the policy script are not 
compliant with the policy logic.

◦ Compliant-exception: In this case, if a policy exception has been approved, 
any policies that are non-compliant are set to the compliant-exception state.

◦ Name of a custom decision: In this case, the decision is pre-defined by the 
admin for decisions other than complaint or non-complaint.

Note: 
There could be multiple custom decisions depending on the type of 
application you're integrating with PaCE.

Warnings/
Failures

Lists the number of warnings or failures generated during the execution.

Evaluation 
time

Shows how long the evaluation took, in milliseconds.
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Output tab 
section

Description

Execution 
output

Shows the execution output in JSON format. You can integrate this output with 
other applications and services and present it in your required format.

Custom Shows the custom output of the custom decision.

Note: 
This tab will only show up if you are testing a custom decision.

If required, modify the policy script to resolve any issues that arose during the evaluation. You 
can also review policy execution logs for further analysis.

Review execution log

After evaluating any changes made to the PaCE  policy script, you can review the execution log 
generated.

Before you begin
Role required: sn_pace.admin

Procedure

1. In the Policy builder  tab, click the policy version you want to review/evaluate.

2. Select the Test playground icon .

3. Click the Logs  tab to view the execution logs generated.
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The displayed logs include all execution data generated during the evaluation. To filter logs, 

select the filter icon  .

Execute policies

Execute a policy to determine if the policy is compliant or non-compliant. Executions can be 
run as part of your policy evaluation process, or in real time when mapped to an object (table or 
document ID).

Before you publish a policy version, you can run a test evaluation of the version to determine if 
it is compliant, non-compliant, compliant-exception, or other. Evaluating a policy enables you 
to test repeatedly and apply any required changes to the policy version, before moving it to a 
production environment. For further information about testing your policy version, see Use the 
Test Playground for PaCE policies.

When the version is ready to be moved into the production environment, make sure that all 
policy mappings are in place and verified. When the policy is invoked by the relevant object, its 
execution output is stored for review. For further information, see Review executed policy activity.

Review executed policy activity

You can review the execution activity of any policy at any time. Recorded execution activity 
includes the time taken to execute, decisions of compliance, execution types, and the outcome 
of the execution.

Before you begin
Role required: sn_pace.admin
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Procedure

1. Navigate to All  > Policies  > My Policies.

Note: 
To view all policies generated by admin/other users, navigate to Policies  > All Policies.

2. Click Executions  to display the execution activity for the selected policy.

3. Review the execution information in the following columns.

Column Description

Number The automatically generated execution 
number. Click the link to review the following 
execution information:

◦ Caller and mapping inputs used in the 
execution.

◦ The JSON output generated on execution.

◦ The execution log.

◦ The policy script used in the execution.

Version The policy version used in the execution. 
Click the link to review the version details.

Type The type of execution performed:

◦ Test

◦ Standard

Start time The time and date the execution was 
initiated.

Processing time (ms) The execution processing time, in 
milliseconds.

Decision The decision reached on execution:

◦ Compliant

◦ Non-compliant

◦ Compliant-exception
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Column Description

State The state of the execution.

CDM application The name of the relevant application. Click 
the link to review and update the application 
details.

Name The name of the object. Click the link to 
review and update the object details.

Manage PaCE  policy categories and tags

Use categories and tags to manage and group your PaCE  policies more efficiently. As the policy 
administrator, you can create and edit any number of categories and tags.

You must have the sn_pace.admin role to manage categories and tags.

Policy categories and how to use them

Policy categories enable you to categorize your policies into relevant groups or sections.

You can create any number of categories, but only one category can be assigned at any one 
time to a policy. Categories can include product or industry-specific terms, such as PCI, HIPAA, 
or FedRAMP. If a PCI or HIPAA-specific update must be applied to a policy, select the relevant 
category to locate and update the policies under that category.

When creating or updating the policy with a category, the category must be pre-defined.

Policy tags and how to use them

Policy tags enable you to define a policy with relevant reference tags. These tags can be defined 
according to your requirements, providing an element of flexibility to your policy management. 
For example, if a group of users have access to some policies, you can create a meaningful tag or 
a set of tags only for those policies.

You can add any number of tags to a policy, and also configure who can view the tags. You can 
also add tags on-the-fly as you view or edit policies.

Tags can be especially useful in collaboration efforts, in turn making the entire policy life-cycle 
easier to manage.

Managing categories in PaCE

Use the Categories option to group your PaCE  policies more efficiently. As the policy 
administrator, you can create and edit any number of categories.

Categories are especially useful for grouping your policies into relevant sections. You can create 
and edit categories as required, but only one category can be assigned at any one time to a 
policy.

In addition, when creating a policy, the category must be pre-defined to ensure it can be 
assigned to the policy.

Create a category

Create PaCE  policy categories to assign to a policy when creating or updating a policy. 
Categories enable you to categorize and manage policies more efficiently.

Before you begin
Role required: sn_pace.admin
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Procedure

1. Navigate to Categories  > All Categories.

2. Click New.

3. In the Create New Category form, define a name and description for the category.

4. Click Save.
The new category is added to the All Categories form.

Edit categories

Update categories for a PaCE  policy as required. You can also update categories for Active 
policies.

Before you begin
Role required: sn_pace.admin

Procedure

1. Navigate to Categories  > All Categories.

2. Click the name of the category that you want to edit.

3. In the Details form for the selected category, edit the category Name  and Description  fields, as 
required.
When updating a category name, the update is applied to all policies assigned with that 
category, whatever their state.

4. Click Save.
The edited category is updated in the All Categories form.

Note: 
You can also delete a category, as long as the category is not assigned to an Active 
policy. To delete a category, in the Details form for the selected category, click Delete.

View PaCE  policies associated with a category

You can view the PaCE  policies that have been assigned to a specific category. All the categories 
created, together with their associated policies, can be viewed in the All Categories table.

Before you begin
Role required: sn_pace.admin

Procedure

1. Navigate to Categories  > All Categories.

2. In the All Categories table, click the relevant category name.

3. In the displayed Details form, click the Policies  tab.
The policies associated with the selected category are displayed.
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4. Click a policy name to view the policy and its settings.

Managing tags in PaCE

Use tags to manage your PaCE  policies more efficiently. As the policy administrator, you can 
create and edit any number of tags.

Policy tags enable you to add any number of reference tags to a policy. Tags can be especially 
useful in collaboration efforts, and can easily be viewed and edited. They can also be used to 
group policies based on any number of tags.

Add tags to PaCE  policies

Add or create policy tags on-the-fly for any PaCE  policy, including currently Active policies. Tags 
enable you to manage policies more efficiently.

Before you begin
Role required: sn_pace.admin

Procedure

1. Navigate to Policies  > My Policies.

Note: 
To view all policies generated by admin/other users, navigate to Policies  > All Policies.

2. Click the policy name for the policy that you want to add a tag to.

3. In the Policy Details page, click the tag icon.

Note: 
Unlike categories, you do not have to pre-define a tag before adding it to a policy.

4. In the Add Tag  field, enter the required tag.

5. Press Enter  to add the tag.
The tag is added to the Tags  dialog.
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Note: 
By default, the added tags are viewable to you only. Edit the tag to modify who can view 
the tag.

6. Repeat as required for additional tags.

Note: 

◦ Tags are not case-sensitive, you cannot create tags using different capitalization.

◦ Tags are automatically assigned to the policy when added in the Tags  dialog, you don't 
need to save the policy to save the assigned tags.

Edit PaCE  policy tags

Edit and remove tags from a PaCE  policy as required. When editing a tag, you can also define 
who can view the tag.

Before you begin
Role required: sn_pace.admin

Procedure

1. Navigate to Policies  > My Policies.

Note: 
To view all policies generated by admin/other users, navigate to Policies  > All Policies.

2. Click the policy name for the policy that you want to edit or remove tags from.

3. In the Policy Details page, click the tag icon.

4. To edit a tag:

a. Click the tag.

b. In the Edit Tag dialog, edit the tag name.

c. In the Viewable by list, select from Me, Groups and Users, or Everyone. By default, Me  is 
selected when initially creating a tag.
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Note: 
When you select Groups and Users, you are prompted to choose the ServiceNow AI 
Platform  groups and users who can view the tag.

d. Click Save.

5. To remove a tag, click the x on the tag itself.
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The tag is removed from the policy.

View PaCE  policies associated with a tag

You can view the PaCE  policies that have been assigned to a specific tag. All tags together with 
their associated policies can be viewed in the All Tags table.

Before you begin
Role required: sn_pace.admin

Procedure

1. Navigate to Tags  > All Tags.

2. In the All Tags table, click the name of the relevant tag.

3. In the displayed Details form, click the Policies  tab.
The policies associated with the selected tag are displayed.

4. Click a policy name to view the policy and its settings.

How to write and test custom PaCE  policies
This section provides guidelines on how to write and test PaCE  policies.

You can write PaCE  policies using JavaScript and create the policy record within your instance 
application scope. PaCE  policies can be executed within the scope in which they are created 
and all functions available in this scope are available to the policy.

When a policy is invoked, a default set of parameters is passed and these parameters can be 
used in the policy logic as required. A decision indicating whether the policy is compliant, non-
compliant, or compliant-exception and additional information is returned using the decision 
object.

Structure of a PaCE  policy script

This section describes the structure of a PaCE  policy script.
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When a policy is executed, a set of parameters is passed and the policy developer can use these 
parameters in this policy script to make a decision whether it is compliant, non-compliant, or 
compliant-exception and return this decision back to the calling service. The following image 
shows a sample script:

Sample policy script

To debug the script, select the Debugger script icon . For more information, see Script 
Debugger API .

The following table lists the policy function parameters and how can they be used in your policy 
script.

Variable 
Name

Description

logger Logger  is an object that the policy coder can use to log messages. The log 
messages are stored in the sn_pace_execution_log  table. You can review 
these log messages for debugging, tracking, or monitoring purposes. The log 
messages can be logged with one of the following levels:

• 1: info

• 2: debug

• 3: warning

• 4: error

When a policy is invoked through the API, you can specify the desired log level. For 
example:The format is as follows:

logger.info("** snapshotId is: "+snapshotId);

current

Record

currentRecord  is an object of the current version of the policy that is executed 
when the policy is used. To view the currentRecord  details, navigate to the 
Versions  tab on the Policy Home page and locate the policy whose version state is 
set to Current.

In the image below, you can see that the current active version of the policy 
highlighted. It shows the following details:

• version number

• last update date

• the name of the user who updated the version
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Variable 
Name

Description

• the number of times it was executed by the calling application

• the number of times it was run in the test environment

The policy script can access this data during policy execution time by interacting 
with the currentRecord  object passed to the policy.

This example shows how a policy developer can access the properties of the policy 
version record:

(function(logger, currentRecord, documentRecord, 
 apiVars, configParams, recordRefs, dataCollectors, 
 childrenOutputs, output) {
     //retrieve the input values
     logger.info(currentRecord.getValue('name'));
  }
 )(logger, currentRecord, documentRecord, apiVars, 
 configParams, recordRefs, dataCollectors, 
 childrenOutputs, output);

document

Record

The  documentRecord   is used to map the policy to the relevant object (table 
and documentID) that is being validated. The documentRecord  is a combination 
of the table_name and sysID. Based on the properties of the object, the policy logic 
is used to manage and interact with the object being validated to determine the 
right decision.

For example: In the DevOps Config  environment, a policy can be mapped to 
the deployable. When the API is invoked, a query is initiated on the document 
(deployable) table and the Sys ID of the deployable.

{
           "table": "sn_cdm_deployable",
           "sysId": "d1be8f5e87d80110eec7dbdd3fbb357d"
  }

This example shows how the documentRecord can be used in a policy script:

(function(logger, currentRecord, documentRecord, 
 apiVars, configParams, recordRefs, dataCollectors, 
 childrenOutputs, output)
{
//assuming that associated document has state field
  var documentState = documentRecord.getValue(“state”);
if (documentState == “new”)
   …
else
   …
}
)(logger, currentRecord, documentRecord, apiVars, 
 configParams, recordRefs, dataCollectors, 
 childrenOutputs, output);
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Variable 
Name

Description

apiVars The apiVars  is passed to the PaCE  API when it is invoked. It includes all the API 
variables defined in the policy version. See <Defining Caller Inputs> section for 
details

The Sample policy script  shows how policies can be used to validate configuration 
data in the DevOps environment. In the sample script, the apiVars  variable is 
defined as

var snapshotId = apiVars.snapshotId;

where the specified snapshotId  is mapped to the corresponding snapshotId 
of the DevOps Config deployable being validated based on specified criteria.

The policy developer can define logic in the policy script to use the apiVars  values 
passed when the API is invoked to determine the decision. For example, the 
SnapshotID passed is used to identify key-values related to the specific snapshotID 
for a deployable passed in the documentRecord object.

configParams
Config Parameters  are variables are passed when mapping the policy and includes 
all the Config Parameters  variables defined for a specific version of the policy.

The configParams  variable is defined as follows in the Sample policy script.

var dbPort = configParams.dbPort;

The policy developer can define the logic in the policy script to use the values 
passed at mapping to determine the decision. For example, the dbPort  number 
must be less than 30000, otherwise the policy is considered to be non_compliant.

recordRefs Record references define queries to extract data from any ServiceNow®  tables and 
use the data to configure the policy logic. There is an auto-completion function that 
can select the record reference in the Javascript editor.

dataCollectorsThe data collectors function collects input process data from ServiceNow  or an 
external data source to provide an output.

children

Outputs

Not supported in this version.

output

This parameter is used to pass the output of the policy execution that includes the decision 
back to the calling service. It provides a decision related to this policy, with additional 
information such as errors, warnings, and result details.

This example shows a sample output with compliant and non_compliant decisions:

 
{
    "decision": "compliant",
    "results": [],
    "warnings": [],
    "failures": [],
    "state": "complete"
}
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Variable 
Name

Description

 
{
    "decision": "non_compliant",
    "results": [],
    "warnings": [],
    "failures": [“Failed to validate key”],
    "state": "complete"
}

output.

decision

The decision property can be set to:

• Compliant: Determines that the policy complies with requirements.

• Non-compliant: Determines that the policy does not comply with the 
requirements.

• Compliant-exception: Determines that an exception to the policy has been 
approved and any policies that are non-compliant are set to the compliant-
exception state.

The decision is returned in a JSON format back to the calling service.

Note: 
If a value is not specified in the output.decision  field in the script, when 
the policy is executed, by default this field is set to compliant  if there are no 
failures.

output.

results
The results  property can be used to pass data back to the calling service on 
decisions made during the policy validation phase. A list object with a list of results 
can be passed back to the calling service.

output.

warnings
The warnings  property can be used to pass data back to the calling service on 
any warnings that occurred during the policy validation phase.

output.

failures
The failures  property can be used to pass data back to the calling service on 
any errors that occurred during the policy validation phase.

Note: 
The following fields are automatically filled in when the PaCE  policy script is executed.

output.

name

The name (current version) of the policy being executed.

output.

state

It indicates the state of the policy invocation.

• Complete: The invocation was completed successfully.

• Pending: Indicates that the policy could not be successfully executed and is an 
incomplete state.

© 2025 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

5525



Note: 

• Auto-complete suggestions are available in the policy script editor for the logger, 
callerInput  and mappedInput  parameter.

• To view additional information for a parameter, enter the parameter name and select one 
of the options as follows:

Policy invocation API

When a PaCE  policy is invoked, the calling service passes the relevant object (tables and 
document IDs) that is being validated by providing the documentRecord  object. A calling 
service is a service or product that uses the PaCE  API. PaCE  determines which policies must be 
executed by using the mapping table and the documentRecord.

All selected policies are executed concurrently. When all the policies have been executed, a final 
single decision is returned (in JSON format) with information on all executed policies and policy-
level decisions. The final decision can be:

• compliant: Indicates that all the selected policies comply with the requirements and have 
returned a compliant decision.

• non_compliant: Indicates that one or more of the selected policies do not comply with the 
requirements and have returned a non_compliant decision.

• complaint-exception: Indicates that a policy exception has been approved and any policies 
that are non-compliant are set to the compliant-exception state.

• other: Indicates decisions that are not complaint, non_compliant, or complaint-exception.

Policy invocations can be in one of the following states:

• new

• in_progress

• complete

• canceled

• error

• timeout

Sample API

The following is a sample invocation request when the PaCE API is executed.

var request = {"documentIds":
        
 [{"table":"sn_cdm_deployable","sysId":"d1be8f5e87d80110eec7dbdd
3fbb357d"}],"service":"CDM","category":"CDM","data":{"snapshotId
":"2bcec7de87d80110eec7dbdd3fbb3529"},"options":{"verboseRespons
e":true,"logLevel":"debug","type":"standard","failFast":false, 
 "executionTag":"cdm"}}
 
 
         try {
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            var api = new sn_pace.InvocationAPI();
 
 
 
            var execResponse = api.execute(request);
 
 
 
            gs.info(" Got execution response:\n " + 
 JSON.stringify(execResponse,null,4));
 
 
 
         } catch (err) {
 
 
 
            //var errJSON = JSON.parse(err);
 
 
 
            //gs.info(errJSON.code);
 
 
 
            gs.info(" Error message is:" + err + "\n stack:" + 
 err.stack);
 
 
 
            // gs.info(" Error is:" + err);
 
 
 
         }

PaCE  API invocation parameters

This table describes the properties that can be configured when the PaCE  API is invoked. 
These properties can be set whenever the API is invoked or when you test a policy in the Test 
Playground.

Property name Required Default value Description

service yes The calling service that is invoking the 
API.

category no The category type.

type no standard Can be standard  or test.

documentIds yes (array of 
table, sysID)

The documentIds is an array of the 
table and sysID (of the deployable).
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Property name Required Default value Description

Note: 
The properties shown in the preceding table cannot be configured in the Test Playground. 
They can only be used when the PaCE  API is invoked.

data yes The policy-specific data that includes 
all possible caller inputs.

executionTag no Can be used to tag one or more policy 
executions records resulting from this 
invocation. It can be used to retrieve 
execution details of the policy based 
on the executionTag.

verboseResponse no false Default value is false. If set to true, 
additional debug information (in this 
case the ids of the mapped policies) 
is returned.

A sample invocation response with 
options.verboseResponse:true is 
shown here:

// Sample execution 
 response
{
  "rootExecutionId": 
 "50202b3ec37b101017e06c
576e40dd81",
  "mappedPolicies": [
    {
      "policyId": 
 "3d1de0a8c363101017e06c
576e40dde4",
      "policyName": 
 "Production Database 
 Policy",
     
 "shortDescription": 
 "Policy to check 
 database passwords",
      "versonId": 
 "4ed08520c3a3101017e06c
576e40ddcb",
      "versonTyep": 
 "4f2cb75473331010ce6c39
282bf6a753",
      "versionState": 
 "published",
      "versionApproval": 
 "approved"
    },
    {
      "policyId": 
 "addd2ca8c363101017e06c
576e40dd12",
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Property name Required Default value Description

      "policyName": "API 
 Policy",
     
 "shortDescription": 
 "Policy to check API 
 policies",
      "versonId": 
 "a6418920c3a3101017e06c
576e40dd57",
      "versonTyep": 
 "4f2cb75473331010ce6c39
282bf6a753",
      "versionState": 
 "published",
      "versionApproval": 
 "approved"
    }
  ],
  "logs": []
}

If 
options.verboseResponse:false, 
the mapped policies are not included 
in the response.

failFast no false The default value is false. If this 
property is set to true, the first failed 
policy stops the execution of all the 
mapped policies.

logLevel no info This parameter can be used to specify 
how the log messages should be 
displayed.

• info

• debug

• warn

• error

timeout no 3600 The timeout period in seconds. The 
default value is 3600.

waitForResult no 3600 The waitForResult period in seconds.

Note: 
This parameter is available only 
in the Test Playground.

About policy exceptions
By integrating Policy as Code Engine  with Integrated Risk Management  and Policy and 
Compliance Management  workspace, the Compliance administrator can manage an 
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organization's overall compliance posture and provide a business and regulatory context for 
codified policies.

The Compliance administrator can associate PaCE  policies with control objectives and map 
policies to other  deployables. It enables preventive controls and ensures that no risky or 
non-compliant changes are introduced in the production environment. If required, you can 
also grant and monitor exceptions on these policies. This provides real-time risk visibility of 
control objectives and exception management to accelerate the pipeline process. Refer to 
the Governance, Risk, and Compliance  documentation for more information on the exception 
management process.

Enable exceptions for a policy

Enable exceptions for a PaCE  policy and associate it with a control objective in GRC.

Before you begin

• Role required: sn_pace.admin

• Governance, Risk, and Compliance  14.1 or later

Procedure

1. Navigate to Policies  > My Policies.

Note: 
To view all policies generated by admin/other users, navigate to Policies  > All Policies.

2. Click the policy for which you want to enable exceptions.
The Details page is displayed.

As you can see in this image, the Exception status is Disabled.

3. Click the More Actions  icon and select Enable exceptions.
The Exception status is changed to Enabled.

Note: 
After an exception has been enabled, the policy must be configured in the Policy and 
Compliance Management  workspace and connected to a control objective. See Policy as 
Code Engine for Preventive compliance management  for details.
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Result
After the policy has been configured in Policy and Compliance Management  workspace, the 
Exception status for the policy is updated to Enabled and Configured. The sn_pace.admin can 
then request exceptions to this policy.

Disable exceptions for a policy

You can disable exceptions for a policy for which exceptions have been granted. When this 
option is selected, you can no longer request exceptions and control objectives can no longer be 
associated with the policy.

Before you begin

• Role required: sn_pace.admin

Procedure

1. Navigate to Policies  > My Policies.

Note: 
To view all policies generated by admin/other users, navigate to Policies  > All Policies.

2. Click the policy for which an exception has already been granted.
The Details page is displayed.

3. Click the More Actions  icon and select Disable exceptions.
The Exception status is changed to Disabled  You can no longer request exceptions for this 
policy.

Request exception for a policy

After a policy has been enabled and configured for exceptions, you can map a policy to a 
deployable and request an exception.

Before you begin
Role required: sn_pace.admin

Procedure

1. Navigate to the Mappings page.

2. Select a mapping from the list and click Request exception..

3. In the Request policy exception window, specify the following:

◦ Reason for exception: Select a reason for the exception from the drop-down list. Refer to the 
Governance, Risk, and Compliance  for details.

◦ Business justification: Enter a business justification for the exception.
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◦ Start and End Date: Specify the period for which the exception should be valid. The 
default validity period is 30 days. The default period can be modified by the Compliance 
administrator (sn_compliance.admin).

Note: 

▪ You can also specify a Start Date that is in the future.

▪ When the request is approved, the sn_compliance.admin can override the requested 
dates.

4. Click Request  and navigate to the Exceptions  tab to view the requested exceptions.

You can see that the exception status is Pending. The Compliance Manager assesses this 
exception request and can choose to approve or reject the request. See Policy as Code Engine 
for Preventive compliance management  for details. For each exception request, the following 
details are displayed:

◦ Exception ID: Click the Exception ID to view detailed information about the exception 
request.

◦ Deployable: Click the link to view the details of the deployable mapped to the policy.

◦ Exception active: If the exception has been granted, the status is set to Yes.

Note: 
If the exception has been granted for a future date, the status is set to No  until the 
effective Start Date.

◦ Status: The status of the request:

▪ Pending: An exception request has been created but has not been approved.

▪ Granted: The exception request has been approved.

▪ Extension Pending: An extension request for a granted exception has been created.

▪ Extension Granted: The extension request has been approved.

▪ Declined: The exception request was not approved.

▪ Extension Declined: The request to extend a granted exception was declined.

▪ Expired: The period for which the exception was granted has expired.

▪ Withdrawn: The granted exception request is withdrawn.

◦ Expires in: The number of days after which the exception request expires.

5. After the request is approved, navigate to the Exceptions  tab.
You can see that the exception request status has changed to Granted. You can also see the 
number of days and minutes for which the exception is valid.

6. After an exception has been granted, you can request an extension before the end of the 
validity period.

7. Select a request with a Granted  status and click Extend.

Note: 
You can request an extension for only one policy at a time.

8. In the Request extension window, specify a business justification, an end date for the request 
and click Request.

9. Navigate to the Exceptions  tab.
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The exception status has changed to Extension Pending. The sn_compliance.admin assesses 
this extension request and can choose to approve or reject the request. See Governance, Risk, 
and Compliance  for details.

10. After the request is approved, navigate to the Exceptions  tab.
You can see that the exception request status has changed to Extension Granted. You can 
also see the number of days for which the extension is valid.

Note: 
When you execute a policy with exceptions, it is validated and returns a Compliant-
exception  result.

Withdraw an exception request

If an exception is no longer required, you can withdraw a granted exception request for a policy.

Before you begin
Role required: sn_pace.admin

Procedure

1. Navigate to Policies  > My Policies.

2. Navigate to the policy that has been enabled and configured for exceptions and click the 
Exceptions  tab.

3. Select the granted exception request and click Withdraw.
A confirmation message appears.

4. Click Withdraw  to withdraw the exception request.
The request status is changed to Withdrawn.

Integrating PaCE  with other applications
Extend the capabilities of Policy as Code Engine  (PaCE) by creating policies with other 
applications.

PaCE  provides integrations with the applications listed in the following table:

PaCE Integrations

Integration Description

Digital Product Release  (DPR) Define policies in Digital Product Release, see 
the Define policies in Digital Product Release
topic.

Software Bill of Materials  (SBOM) Starting with version 4.0 of SBOM  Response, 
an application that is part of the Security 
Operations  suite of applications, you can 
view components that are identified as stale or 
abandoned as ‘Non-compliant’ in the Policy as 
Code Engine (PaCE) interface that is available 
in the Software Bill of Materials  Workspace.

• Determine if components are stale 
or abandoned with the Run PaCE 
policies for SBOM Response 
scheduled job. This scheduled job is 
deactivated by default.
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PaCE Integrations  (continued)

Integration Description

• View components that are identified as stale 
or abandoned as Non-compliant in the PaCE 
interface that is available and viewed in the 
SBOM  Workspace.

See Configuring the Deps.dev, OSV.dev, 
and PaCE integrations for Software Bill of 
Materials  for more information.
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